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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

indicates that minor personal injury can result if proper precautions are not taken.
 

 
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY
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Copyright © Siemens AG 2013.
All rights reserved



Table of contents

1 System overview of STEP 7 and WinCC....................................................................................................29
 1.1 Scaling of STEP 7 and WinCC....................................................................................................29
 1.2 Options for STEP 7 Engineering System....................................................................................31
 1.3 Options for WinCC Engineering and Runtime systems...............................................................32

2 Readme......................................................................................................................................................35
 2.1 General notes..............................................................................................................................35
 2.1.1 General notes..............................................................................................................................35
 2.1.2 Notes on the installation..............................................................................................................39
 2.2 STEP 7 Basic..............................................................................................................................41
 2.2.1 Security information.....................................................................................................................41
 2.2.2 Notes on use...............................................................................................................................42
 2.2.3 Editing devices and networks......................................................................................................44
 2.2.3.1 General information on devices and networks............................................................................44
 2.2.3.2 Use of modules on the S7-1200..................................................................................................44
 2.2.3.3 Replacing ET 200S positioning modules.....................................................................................45
 2.2.3.4 CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX......................................................46
 2.2.3.5 Notes on online and diagnostics..................................................................................................46
 2.2.3.6 Network components...................................................................................................................47
 2.2.4 Programming a PLC....................................................................................................................48
 2.2.4.1 General notes on PLC programming...........................................................................................48
 2.2.4.2 Instructions..................................................................................................................................49
 2.2.4.3 Testing the user program............................................................................................................50
 2.2.5 Technological functions...............................................................................................................51
 2.2.5.1 Notes on technological functions.................................................................................................51
 2.3 WinCC Advanced........................................................................................................................52
 2.3.1 Security information.....................................................................................................................52
 2.3.2 Notes on use...............................................................................................................................55
 2.3.3 Migration......................................................................................................................................57
 2.3.4 Special considerations for Windows 7.........................................................................................60
 2.3.5 Engineering System....................................................................................................................61
 2.3.5.1 Screens and Screen Objects.......................................................................................................61
 2.3.5.2 Tags and connections.................................................................................................................66
 2.3.5.3 Alarm system and alarm displays................................................................................................68
 2.3.5.4 System functions and scripts.......................................................................................................68
 2.3.5.5 Recipes........................................................................................................................................70
 2.3.5.6 User administration......................................................................................................................71
 2.3.5.7 Communication............................................................................................................................71
 2.3.6 Compiling and loading.................................................................................................................75
 2.3.7 Runtime.......................................................................................................................................77
 2.3.7.1 Notes on operation in Runtime....................................................................................................77
 2.3.7.2 Notes on operation of panels in Runtime....................................................................................78
 2.3.7.3 Notes on operation of Runtime Advanced...................................................................................79
 2.3.8 HMI devices.................................................................................................................................79

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3



 2.3.8.1 Notes on HMI devices.................................................................................................................79

3 Installation...................................................................................................................................................83
 3.1 System requirements for installation...........................................................................................83
 3.1.1 Notes on licenses........................................................................................................................83
 3.1.2 Notes on the system requirements..............................................................................................84
 3.1.3 System requirements STEP 7 Basic...........................................................................................85
 3.1.3.1 Licensing of STEP 7....................................................................................................................85
 3.1.3.2 Handling licenses and license keys.............................................................................................86
 3.1.3.3 Software and hardware requirements STEP 7............................................................................88
 3.1.4 System requirement for WinCC Advanced..................................................................................91
 3.1.4.1 Software and hardware requirements.........................................................................................91
 3.1.4.2 Parallel installation.......................................................................................................................95
 3.1.4.3 Add-ons.......................................................................................................................................96
 3.1.4.4 Licenses and Powerpacks...........................................................................................................98
 3.2 Installation log............................................................................................................................106
 3.3 Starting installation....................................................................................................................107
 3.4 Installing Support Packages......................................................................................................109
 3.5 Displaying the installed software...............................................................................................110
 3.6 Modifying or updating installed products...................................................................................111
 3.7 Repairing installed products......................................................................................................113
 3.8 Starting to uninstall....................................................................................................................115
 3.9 Installing and uninstalling the migration tool..............................................................................117
 3.9.1 System requirements.................................................................................................................117
 3.9.2 Installing the migration tool........................................................................................................117
 3.9.3 Uninstalling the migration tool...................................................................................................118

4 Migrating projects and programs..............................................................................................................119
 4.1 Migrating projects in a TIA portal project...................................................................................119
 4.1.1 Migration of projects with the TIA Portal....................................................................................119
 4.1.2 Preparing projects with the migration tool.................................................................................120
 4.1.2.1 Migrating projects with the migration tool..................................................................................120
 4.1.2.2 Calling the migration tool...........................................................................................................122
 4.1.2.3 Creating a migration file.............................................................................................................122
 4.1.3 Migrating projects......................................................................................................................123
 4.1.4 Displaying the history of the migration.......................................................................................124
 4.1.5 Display migration log.................................................................................................................125
 4.1.6 Migrating WinCC flexible projects (Advanced)..........................................................................126
 4.1.6.1 Principles (WinCC flexible)........................................................................................................126
 4.1.6.2 Migrating engineering data (WinCC flexible).............................................................................132
 4.1.6.3 Migrating runtime data (WinCC flexible)....................................................................................153
 4.1.6.4 Migrating integrated projects (WinCC flexible)..........................................................................156
 4.1.6.5 Reference (WinCC flexible).......................................................................................................159
 4.1.7 Migrating integrated projects.....................................................................................................175
 4.1.7.1 Migrating an integrated project..................................................................................................175
 4.1.7.2 Post-editing integrated projects.................................................................................................176
 4.1.7.3 Converting unspecified CPUs into specified CPUs...................................................................178
 4.1.7.4 Creating an integrated HMI connection.....................................................................................179

Table of contents

WinCC Comfort/Advanced V12.0 SP1
4 System Manual, 07/2013,  



 4.1.7.5 Re-linking HMI tags...................................................................................................................181
 4.1.7.6 Deleting an unspecified connection...........................................................................................182
 4.2 Programming recommendations...............................................................................................183
 4.2.1 The new S7-1500 CPU functions at a glance............................................................................183
 4.2.2 Symbolic addressing.................................................................................................................185
 4.2.3 Using IEC timers and counters..................................................................................................187
 4.2.4 Flexibly using enable output ENO.............................................................................................188
 4.2.5 Using MOVE instructions in STL...............................................................................................190
 4.2.6 Implementing array access with a variable index......................................................................192
 4.2.7 Using PLC data types (UDT).....................................................................................................194

5 First steps.................................................................................................................................................197
 5.1 Getting Started Documentation.................................................................................................197

6 Introduction to the TIA Portal....................................................................................................................199
 6.1 User interface and operation.....................................................................................................199
 6.1.1  Starting, setting and exiting the TIA Portal...............................................................................199
 6.1.1.1 Starting and exiting the TIA Portal.............................................................................................199
 6.1.1.2 Overview of the program settings..............................................................................................199
 6.1.1.3 Overview of the script and text editor settings...........................................................................201
 6.1.1.4 Overview of the print settings....................................................................................................202
 6.1.1.5 Changing the settings................................................................................................................203
 6.1.2 Layout of the user interface.......................................................................................................203
 6.1.2.1 Views.........................................................................................................................................203
 6.1.2.2 Portal view.................................................................................................................................204
 6.1.2.3 Project view...............................................................................................................................205
 6.1.2.4 Library view...............................................................................................................................207
 6.1.2.5 Project tree................................................................................................................................208
 6.1.2.6 Work area..................................................................................................................................211
 6.1.2.7 Inspector window.......................................................................................................................219
 6.1.2.8 Task cards.................................................................................................................................221
 6.1.2.9 Reference projects....................................................................................................................223
 6.1.2.10 Details view...............................................................................................................................225
 6.1.2.11 Overview window.......................................................................................................................226
 6.1.2.12 User interface layout..................................................................................................................230
 6.1.3 Keyboard operation in the TIA Portal........................................................................................234
 6.1.3.1 Operating the TIA Portal with the keyboard...............................................................................234
 6.1.3.2 Displaying an overview of all keyboard shortcuts......................................................................234
 6.1.3.3 Basic functions of the TIA Portal...............................................................................................234
 6.1.3.4 Using project-related functions..................................................................................................236
 6.1.3.5 Arranging windows....................................................................................................................236
 6.1.3.6 Navigating through the program interface.................................................................................237
 6.1.3.7 Customizing editors...................................................................................................................238
 6.1.3.8 Editing objects...........................................................................................................................240
 6.1.3.9 Text editing................................................................................................................................241
 6.1.3.10 Editing tables.............................................................................................................................242
 6.1.3.11 Using online functions...............................................................................................................243
 6.1.3.12 Using the on-screen keyboard...................................................................................................244
 6.1.4 Special features specific to the operating system.....................................................................244
 6.1.4.1 Influence of user rights..............................................................................................................244
 6.1.4.2 Expanding user rights................................................................................................................245

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5



 6.2 Help on the information system.................................................................................................247
 6.2.1 General remarks on the information system..............................................................................247
 6.2.2 Opening the Help system..........................................................................................................250
 6.2.3 Searching the Help system for keywords..................................................................................250
 6.2.4 Full-text searches......................................................................................................................250
 6.2.5 Using favorites...........................................................................................................................251
 6.2.6 Printing help topics....................................................................................................................252
 6.2.7 Configuring the display of tooltips and tooltip cascades............................................................253
 6.2.8 Safety Guidelines......................................................................................................................253
 6.2.9 Assembling customized documentation....................................................................................255

7 Editing projects.........................................................................................................................................257
 7.1 The basics of projects................................................................................................................257
 7.2 Using logs..................................................................................................................................258
 7.3 Creating and managing projects................................................................................................259
 7.3.1 Creating a new project...............................................................................................................259
 7.3.2 Opening projects.......................................................................................................................259
 7.3.3 Notes on compatibility...............................................................................................................260
 7.3.4 Upgrading projects....................................................................................................................262
 7.3.5 Displaying properties of the project...........................................................................................263
 7.3.6 Saving projects..........................................................................................................................264
 7.3.7 Closing projects.........................................................................................................................265
 7.3.8 Deleting projects........................................................................................................................265
 7.3.9 Working with multi-language projects........................................................................................266
 7.3.9.1 Project text basics.....................................................................................................................266
 7.3.9.2 Select project languages...........................................................................................................268
 7.3.9.3 Setting the editing language......................................................................................................268
 7.3.9.4 Translating all project texts in tabular form................................................................................269
 7.3.9.5 Translating text associated with individual objects....................................................................269
 7.3.9.6 Translating texts using reference texts......................................................................................270
 7.3.9.7 Exporting and importing project texts........................................................................................271
 7.3.9.8 Application examples for multilanguage projects......................................................................273
 7.3.10 Archiving and retrieving projects...............................................................................................274
 7.3.10.1 Working with project archives....................................................................................................274
 7.3.10.2 Archiving projects......................................................................................................................275
 7.3.10.3 Retrieving projects.....................................................................................................................276
 7.4 Using reference projects............................................................................................................277
 7.4.1 Basics of reference projects......................................................................................................277
 7.4.2 Opening and closing a reference project...................................................................................277
 7.4.3 Comparing reference projects...................................................................................................278
 7.5 Editing project data....................................................................................................................280
 7.5.1 Compiling and loading project data...........................................................................................280
 7.5.1.1 Compiling project data...............................................................................................................280
 7.5.1.2 Downloading project data..........................................................................................................281
 7.5.2 Comparing project data.............................................................................................................286
 7.5.2.1 Basics of project data comparison.............................................................................................286
 7.5.2.2 Carrying out an online/offline comparison.................................................................................287
 7.5.2.3 Carrying out offline/offline comparisons....................................................................................287
 7.5.2.4 Using the comparison editor .....................................................................................................288
 7.5.3 Protecting project data...............................................................................................................298

Table of contents

WinCC Comfort/Advanced V12.0 SP1
6 System Manual, 07/2013,  



 7.5.3.1 Protection concept for project data............................................................................................298
 7.5.3.2 Revoking access rights for devices...........................................................................................299
 7.5.4 Printing project contents............................................................................................................299
 7.5.4.1 Printing project documentation..................................................................................................299
 7.5.4.2 Printing module labels...............................................................................................................319
 7.6 Undoing and redoing actions.....................................................................................................324
 7.6.1 Basics of undoing and redoing actions......................................................................................324
 7.6.2 Undoing an action......................................................................................................................325
 7.6.3 Redoing an action......................................................................................................................326
 7.7 Finding and replacing in projects...............................................................................................328
 7.7.1 Information on the search function............................................................................................328
 7.7.2 Search and replace...................................................................................................................328
 7.8 Working with text lists................................................................................................................331
 7.8.1 Text lists....................................................................................................................................331
 7.8.2 Creating user-defined text lists..................................................................................................332
 7.8.3 Editing user-defined text lists.....................................................................................................333
 7.8.4 Editing system-defined text lists................................................................................................333
 7.9 Using memory cards..................................................................................................................335
 7.9.1 Basics about memory cards......................................................................................................335
 7.9.2 Adding a user-defined card reader............................................................................................335
 7.9.3 Accessing memory cards..........................................................................................................336
 7.9.4 Displaying properties of memory cards.....................................................................................337
 7.10 Using libraries............................................................................................................................338
 7.10.1 Library basics............................................................................................................................338
 7.10.2 Using the "Libraries" task card..................................................................................................339
 7.10.2.1 Overview of the "Libraries" task card.........................................................................................339
 7.10.2.2 Using the element view.............................................................................................................342
 7.10.3 Using the library view................................................................................................................343
 7.10.3.1 Overview of the library view.......................................................................................................343
 7.10.3.2 Opening and closing the library view.........................................................................................345
 7.10.4 Using library management.........................................................................................................346
 7.10.4.1 Overview of the library management.........................................................................................346
 7.10.4.2 Opening library management....................................................................................................348
 7.10.5 Using global libraries.................................................................................................................348
 7.10.5.1 Creating a global library.............................................................................................................348
 7.10.5.2 Opening a global library.............................................................................................................349
 7.10.5.3 Upgrading libraries from older versions.....................................................................................350
 7.10.5.4 Displaying properties of global libraries.....................................................................................351
 7.10.5.5 Displaying logs of global libraries..............................................................................................352
 7.10.5.6 Saving a global library...............................................................................................................352
 7.10.5.7 Closing a global library..............................................................................................................353
 7.10.5.8 Deleting a global library.............................................................................................................354
 7.10.5.9 Archiving and disabling global libraries.....................................................................................354
 7.10.6 Creating folders in a library........................................................................................................357
 7.10.7 Using master copies..................................................................................................................357
 7.10.7.1 Basics on master copies............................................................................................................357
 7.10.7.2 Adding master copies................................................................................................................358
 7.10.7.3 Filtering master copies..............................................................................................................359
 7.10.7.4 Using master copies..................................................................................................................360
 7.10.8 Using types and their versions..................................................................................................361

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  7



 7.10.8.1 Basics on types.........................................................................................................................361
 7.10.8.2 State of type versions................................................................................................................362
 7.10.8.3 Displaying a released type version............................................................................................363
 7.10.8.4 Displaying properties of a type or version.................................................................................364
 7.10.8.5 Working with types in the project library....................................................................................365
 7.10.8.6 Working with types in global libraries........................................................................................376
 7.10.9 Editing library elements.............................................................................................................380
 7.10.10 Updating a library with the contents of another library..............................................................381
 7.10.11 Harmonizing names and path structure.....................................................................................383
 7.10.12 Clean up library.........................................................................................................................384
 7.10.13 Comparing library elements.......................................................................................................385
 7.11 Using cross-references..............................................................................................................387
 7.11.1 Using cross-references..............................................................................................................387
 7.12 Simulating devices.....................................................................................................................388
 7.12.1 Simulation of devices.................................................................................................................388
 7.12.2 Starting the simulation...............................................................................................................388

8 Editing devices and networks...................................................................................................................389
 8.1 Configuring devices and networks.............................................................................................389
 8.1.1 Hardware and network editor....................................................................................................389
 8.1.1.1 Overview of hardware and network editor.................................................................................389
 8.1.1.2 Network view.............................................................................................................................391
 8.1.1.3 Device view...............................................................................................................................393
 8.1.1.4 Topology view............................................................................................................................396
 8.1.1.5 Printing hardware and network configurations..........................................................................399
 8.1.1.6 Activating the page break preview for printout..........................................................................400
 8.1.1.7 Changing the print options.........................................................................................................401
 8.1.1.8 Inspector window ......................................................................................................................401
 8.1.1.9 Hardware catalog......................................................................................................................403
 8.1.1.10 Information on hardware components.......................................................................................404
 8.1.1.11 Enabling product support...........................................................................................................405
 8.1.1.12 Keyboard operation: Navigation in the editor............................................................................406
 8.1.1.13 Keyboard operation: Editing objects..........................................................................................407
 8.1.2 Configuring devices...................................................................................................................408
 8.1.2.1 Basics........................................................................................................................................408
 8.1.2.2 Configuring individual devices...................................................................................................417
 8.1.3 Configure networks....................................................................................................................432
 8.1.3.1 Networking devices...................................................................................................................432
 8.1.3.2 Communication via connections................................................................................................450
 8.1.3.3 Displaying and configuring topology..........................................................................................509
 8.1.3.4 Industrial Ethernet Security.......................................................................................................525
 8.1.4 Creating configurations..............................................................................................................635
 8.1.4.1 Information about the web server..............................................................................................635
 8.1.4.2 Things you should know about PROFIBUS DP operating modes.............................................636
 8.1.4.3 Configuring automation systems...............................................................................................637
 8.1.4.4 S7-1200 CM/CP........................................................................................................................674
 8.1.4.5 IPv6 protocol..............................................................................................................................687
 8.1.4.6 SCALANCE X, W and M...........................................................................................................687
 8.1.4.7 Configuring PROFIBUS DP.......................................................................................................771
 8.1.4.8 Configurations for PROFINET IO..............................................................................................795
 8.1.4.9 Bus coupling with PN/PN coupler..............................................................................................823

Table of contents

WinCC Comfort/Advanced V12.0 SP1
8 System Manual, 07/2013,  



 8.1.4.10 Integrating external tools...........................................................................................................824
 8.1.4.11 Loading a configuration.............................................................................................................826
 8.1.5 Displaying alarms......................................................................................................................829
 8.1.5.1 Overview of the alarm display...................................................................................................829
 8.1.5.2 Archive view..............................................................................................................................830
 8.1.5.3 Layout of the alarms in the archive view...................................................................................830
 8.1.5.4 Receiving alarms.......................................................................................................................830
 8.1.5.5 Export archive............................................................................................................................831
 8.1.5.6 Clear archive.............................................................................................................................831
 8.1.5.7 "Active alarms" view..................................................................................................................832
 8.1.5.8 Layout of the alarms in the "Active alarms" view.......................................................................832
 8.1.5.9 Status of the alarms...................................................................................................................832
 8.1.5.10 Acknowledging alarms...............................................................................................................833
 8.1.5.11 Ignoring alarms..........................................................................................................................833
 8.1.5.12 Keyboard commands in the alarm display.................................................................................834
 8.1.6 Additional information on configurations....................................................................................834
 8.1.6.1 Functional description of S7-1200 CPUs...................................................................................834
 8.1.6.2 Distributed I/O............................................................................................................................906
 8.2 Device and network diagnostics................................................................................................960
 8.2.1 Hardware diagnostics................................................................................................................960
 8.2.1.1 Overview of hardware diagnostics.............................................................................................960
 8.2.1.2 Showing non-editable and current values of configurable module properties...........................970
 8.2.1.3 Showing the current values of dynamic modules properties.....................................................977
 8.2.1.4 Checking a module for defects..................................................................................................981
 8.2.1.5 Changing the properties of a module or the programming device/PC......................................988
 8.2.1.6 Diagnostics in STOP mode.....................................................................................................1003
 8.2.1.7 Online accesses in the Online and Diagnostics view..............................................................1006
 8.2.1.8 Checking PROFIBUS DP subnets for faults............................................................................1009
 8.2.2 Connection diagnostics...........................................................................................................1012
 8.2.2.1 Overview of connection diagnostics........................................................................................1012
 8.2.2.2 Displaying the connection status using icons..........................................................................1013
 8.2.2.3 Detailed connection diagnostics..............................................................................................1014

9 Programming the PLC............................................................................................................................1019
 9.1 Creating a user program..........................................................................................................1019
 9.1.1 Programming basics................................................................................................................1019
 9.1.1.1 Operating system and user program.......................................................................................1019
 9.1.1.2 Blocks in the user program......................................................................................................1020
 9.1.1.3 Block calls................................................................................................................................1032
 9.1.1.4 Using and addressing operands..............................................................................................1049
 9.1.1.5 Data types...............................................................................................................................1077
 9.1.1.6 Program flow control................................................................................................................1167
 9.1.2 Declaring PLC tags..................................................................................................................1172
 9.1.2.1 Overview of PLC tag tables.....................................................................................................1172
 9.1.2.2 Structure of the PLC tag tables...............................................................................................1173
 9.1.2.3 Rules for PLC tags..................................................................................................................1175
 9.1.2.4 Creating and managing PLC tag tables...................................................................................1178
 9.1.2.5 Declaring PLC tags..................................................................................................................1180
 9.1.2.6 Grouping PLC tags for inputs and outputs in structures..........................................................1184
 9.1.2.7 Declaring symbolic constants..................................................................................................1187
 9.1.2.8 Editing properties.....................................................................................................................1189
 9.1.2.9 Monitoring of PLC tags............................................................................................................1192

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  9



 9.1.2.10 Editing PLC tag tables.............................................................................................................1192
 9.1.3 Creating and managing blocks................................................................................................1196
 9.1.3.1 Creating blocks........................................................................................................................1196
 9.1.3.2 Specifying block properties......................................................................................................1208
 9.1.3.3 Managing blocks......................................................................................................................1214
 9.1.4 Programming blocks................................................................................................................1219
 9.1.4.1 Program editor.........................................................................................................................1219
 9.1.4.2 Programming code blocks.......................................................................................................1239
 9.1.4.3 Programming data blocks........................................................................................................1382
 9.1.4.4 Programming PLC data types.................................................................................................1409
 9.1.4.5 Using external source files......................................................................................................1418
 9.1.5 Comparing PLC programs.......................................................................................................1423
 9.1.5.1 Basic information on comparing PLC programs......................................................................1423
 9.1.5.2 Comparing blocks....................................................................................................................1427
 9.1.5.3 Comparing PLC tags...............................................................................................................1435
 9.1.5.4 Comparing PLC data types.....................................................................................................1436
 9.1.6 Compiling and downloading blocks.........................................................................................1438
 9.1.6.1 Compiling blocks.....................................................................................................................1438
 9.1.6.2 Downloading blocks.................................................................................................................1442
 9.1.7 Protecting blocks.....................................................................................................................1453
 9.1.7.1 Protecting blocks.....................................................................................................................1453
 9.1.7.2 Setting up and removing block copy protection.......................................................................1455
 9.1.7.3 Setting up block know-how protection.....................................................................................1456
 9.1.7.4 Opening know-how protected blocks.......................................................................................1457
 9.1.7.5 Printing know-how protected blocks........................................................................................1457
 9.1.7.6 Changing a password..............................................................................................................1459
 9.1.7.7 Removing block know-how protection.....................................................................................1459
 9.2 Displaying program information...............................................................................................1461
 9.2.1 Overview of available program information.............................................................................1461
 9.2.2 Displaying an assignment list..................................................................................................1462
 9.2.2.1 Introduction to the assignment list...........................................................................................1462
 9.2.2.2 Layout of the assignment list...................................................................................................1463
 9.2.2.3 Symbols in the assignment list................................................................................................1464
 9.2.2.4 Displaying an assignment list..................................................................................................1465
 9.2.2.5 Setting the view options for the assignment list.......................................................................1465
 9.2.2.6 Filter options in the assignment list.........................................................................................1466
 9.2.2.7 Defining filters for assignment list............................................................................................1467
 9.2.2.8 Filtering an assignment list......................................................................................................1468
 9.2.2.9 Defining retentive memory areas for bit memories..................................................................1469
 9.2.2.10 Enabling the display of retentive bit memories........................................................................1469
 9.2.3 Displaying the call structure.....................................................................................................1470
 9.2.3.1 Introduction to the call structure..............................................................................................1470
 9.2.3.2 Symbols in the call structure....................................................................................................1472
 9.2.3.3 Layout of the call structure......................................................................................................1473
 9.2.3.4 Displaying the call structure.....................................................................................................1473
 9.2.3.5 Setting the view options for the call structure..........................................................................1474
 9.2.3.6 Introducing the consistency check in the call structure...........................................................1475
 9.2.3.7 Checking block consistency in the call structure.....................................................................1475
 9.2.4 Displaying the dependency structure......................................................................................1476
 9.2.4.1 Introduction to the dependency structure................................................................................1476
 9.2.4.2 Layout of the dependency structure........................................................................................1477
 9.2.4.3 Symbols in the dependency structure.....................................................................................1478

Table of contents

WinCC Comfort/Advanced V12.0 SP1
10 System Manual, 07/2013,  



 9.2.4.4 Displaying the dependency structure......................................................................................1479
 9.2.4.5 Setting the view options for the dependency structure............................................................1479
 9.2.4.6 Introducing the consistency check in the dependency structure.............................................1480
 9.2.4.7 Checking block consistency in the dependency structure.......................................................1481
 9.2.5 Displaying CPU resources.......................................................................................................1481
 9.2.5.1 Introducing resources..............................................................................................................1481
 9.2.5.2 Layout of the "Resources" tab.................................................................................................1483
 9.2.5.3 Displaying resources...............................................................................................................1484
 9.2.5.4 Selecting the maximum load memory available......................................................................1485
 9.3 Displaying cross-references....................................................................................................1486
 9.3.1 General information about cross references...........................................................................1486
 9.3.2 Structure of the cross-reference list.........................................................................................1486
 9.3.3 Displaying the cross-reference list...........................................................................................1488
 9.3.4 Displaying cross-references in the Inspector window..............................................................1489
 9.4 Testing the user program........................................................................................................1491
 9.4.1 Basics of testing the user program..........................................................................................1491
 9.4.2 Testing with program status....................................................................................................1492
 9.4.2.1 Introduction to testing with program status..............................................................................1492
 9.4.2.2 Switching test with program status on/off................................................................................1493
 9.4.2.3 Editing blocks during the program test....................................................................................1494
 9.4.2.4 Modifying tags in the program status.......................................................................................1495
 9.4.2.5 Switching display formats in the program status.....................................................................1495
 9.4.2.6 Examples of program status display........................................................................................1496
 9.4.3 Testing with the watch table....................................................................................................1499
 9.4.3.1 Introduction to testing with the watch table..............................................................................1499
 9.4.3.2 Layout of the watch table.........................................................................................................1500
 9.4.3.3 Basic mode and expanded mode in the watch table...............................................................1501
 9.4.3.4 Icons in the watch table...........................................................................................................1502
 9.4.3.5 Creating and editing watch tables...........................................................................................1503
 9.4.3.6 Entering tags in the watch table..............................................................................................1505
 9.4.3.7 Monitoring tags in the watch table...........................................................................................1512
 9.4.3.8 Modifying tags in the watch table............................................................................................1517
 9.4.4 Testing with the force table......................................................................................................1524
 9.4.4.1 Introduction for testing with the force table..............................................................................1524
 9.4.4.2 Safety precautions when forcing tags......................................................................................1526
 9.4.4.3 Layout of the force table..........................................................................................................1526
 9.4.4.4 Basic mode and expanded mode in the force table................................................................1527
 9.4.4.5 Icons in the force table............................................................................................................1528
 9.4.4.6 Open and edit force table........................................................................................................1529
 9.4.4.7 Entering tags in the force table................................................................................................1530
 9.4.4.8 Monitoring tags in the force table............................................................................................1536
 9.4.4.9 Forcing tags in the force table.................................................................................................1539
 9.4.4.10 Stop forcing tags......................................................................................................................1546
 9.5 Using global project functions..................................................................................................1549
 9.5.1 Importing and exporting...........................................................................................................1549
 9.5.1.1 Basics for importing and exporting..........................................................................................1549
 9.5.1.2 Format of the export file...........................................................................................................1549
 9.5.1.3 Exporting PLC tags..................................................................................................................1550
 9.5.1.4 Importing PLC tags..................................................................................................................1551
 9.6 Programming examples...........................................................................................................1552

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  11



 9.6.1 LAD programming examples...................................................................................................1552
 9.6.1.1 Example of controlling a conveyor belt ...................................................................................1552
 9.6.1.2 Example of detecting the direction of a conveyor belt.............................................................1553
 9.6.1.3 Example of detecting the fill level of a storage area ...............................................................1554
 9.6.1.4 Example of controlling room temperature................................................................................1557
 9.6.2 FBD programming examples...................................................................................................1559
 9.6.2.1 Example of controlling a conveyor belt ...................................................................................1559
 9.6.2.2 Example of detecting the direction of a conveyor belt.............................................................1560
 9.6.2.3 Example of detecting the fill level of a storage area ...............................................................1561
 9.6.2.4 Example of controlling room temperature................................................................................1564
 9.6.3 STL programming examples...................................................................................................1566
 9.6.3.1 Example: Bit logic instructions.................................................................................................1566
 9.6.3.2 Example of detecting the direction of a conveyor belt.............................................................1568
 9.6.3.3 Example of detecting the fill level of a storage area ...............................................................1569
 9.6.3.4 Example of calculating an equation.........................................................................................1571
 9.6.3.5 Example: Word logic instructions............................................................................................1572
 9.6.3.6 Example of a step sequence...................................................................................................1574
 9.6.4 SCL programming examples...................................................................................................1576
 9.6.4.1 Example: Bit logic instructions.................................................................................................1576
 9.6.4.2 Example of detecting the direction of a conveyor belt.............................................................1578
 9.6.4.3 Example of detecting the fill level of a storage area ...............................................................1579
 9.7 References..............................................................................................................................1582
 9.7.1 General parameters of the instructions...................................................................................1582
 9.7.1.1 Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous instructions.......1582
 9.7.1.2 Evaluating errors with output parameter RET_VAL.................................................................1584
 9.7.2 Basic instructions.....................................................................................................................1588
 9.7.2.1 LAD..........................................................................................................................................1588
 9.7.2.2 FBD.........................................................................................................................................1835
 9.7.2.3 SCL..........................................................................................................................................2093
 9.7.3 Extended instructions..............................................................................................................2281
 9.7.3.1 Date and time-of-day...............................................................................................................2281
 9.7.3.2 String + Char...........................................................................................................................2294
 9.7.3.3 Process image.........................................................................................................................2315
 9.7.3.4 Distributed I/O..........................................................................................................................2321
 9.7.3.5 PROFIenergy...........................................................................................................................2391
 9.7.3.6 Module parameter assignment................................................................................................2431
 9.7.3.7 Interrupts.................................................................................................................................2441
 9.7.3.8 Alarms.....................................................................................................................................2470
 9.7.3.9 Diagnostics..............................................................................................................................2475
 9.7.3.10 Pulse........................................................................................................................................2506
 9.7.3.11 Recipes and data logging........................................................................................................2507
 9.7.3.12 Data block functions................................................................................................................2533
 9.7.3.13 Addressing...............................................................................................................................2542
 9.7.4 Technology..............................................................................................................................2556
 9.7.4.1 S7-1200 Motion Control...........................................................................................................2556
 9.7.4.2 High-speed counters...............................................................................................................2588
 9.7.4.3 PID Control..............................................................................................................................2591
 9.7.5 Communication........................................................................................................................2699
 9.7.5.1 Communications processor.....................................................................................................2699
 9.7.5.2 S7 communication...................................................................................................................2826
 9.7.5.3 Open User Communication.....................................................................................................2843
 9.7.5.4 Web server..............................................................................................................................2920

Table of contents

WinCC Comfort/Advanced V12.0 SP1
12 System Manual, 07/2013,  



 9.7.5.5 TeleService..............................................................................................................................2922

10 Visualizing processes (Comfort/Advanced)............................................................................................2931
 10.1 Creating screens.....................................................................................................................2931
 10.1.1 Basics......................................................................................................................................2931
 10.1.1.1 Screen basics..........................................................................................................................2931
 10.1.1.2 Device-specific functional scope of screens............................................................................2933
 10.1.1.3 Elements and basic settings....................................................................................................2935
 10.1.1.4 Working with screens..............................................................................................................2937
 10.1.1.5 Working with templates...........................................................................................................2941
 10.1.2 Working with objects................................................................................................................2947
 10.1.2.1 Overview of objects.................................................................................................................2947
 10.1.2.2 Overview of objects.................................................................................................................2950
 10.1.2.3 Options for Editing Objects......................................................................................................2953
 10.1.2.4 Inserting an object...................................................................................................................2954
 10.1.2.5 Deleting an Object...................................................................................................................2956
 10.1.2.6 Positioning an object...............................................................................................................2957
 10.1.2.7 Resizing an object...................................................................................................................2958
 10.1.2.8 Aligning objects.......................................................................................................................2960
 10.1.2.9 Moving an object forward or backward....................................................................................2962
 10.1.2.10 Show objects outside the screen area...............................................................................2963
 10.1.2.11 Rotating objects..................................................................................................................2963
 10.1.2.12 Flipping objects..................................................................................................................2965
 10.1.2.13 Flashing..............................................................................................................................2966
 10.1.2.14 Designing an object............................................................................................................2966
 10.1.2.15 Inserting multiple objects of the same type (stamping tool)...............................................2967
 10.1.2.16 Selecting multiple objects ..................................................................................................2969
 10.1.2.17 Repositioning and resizing multiple objects.......................................................................2971
 10.1.2.18 Managing My Controls.......................................................................................................2972
 10.1.2.19 External graphics ...............................................................................................................2974
 10.1.2.20 Managing external graphics...............................................................................................2975
 10.1.2.21 Storing an external image in the graphics library...............................................................2977
 10.1.2.22 Working with object groups................................................................................................2979
 10.1.2.23 Configuring the keyboard access.......................................................................................2985
 10.1.2.24 Examples............................................................................................................................2988
 10.1.3 Working with text lists and graphics lists.................................................................................2991
 10.1.3.1 Working with text lists..............................................................................................................2991
 10.1.3.2 Working with graphics lists......................................................................................................2999
 10.1.4 Dynamizing screens................................................................................................................3007
 10.1.4.1 Basics on dynamizing screens................................................................................................3007
 10.1.4.2 Basics on dynamizing screens................................................................................................3007
 10.1.4.3 Dynamization in the inspector window....................................................................................3008
 10.1.4.4 Dynamization in the inspector window....................................................................................3010
 10.1.4.5 Dynamization with animations.................................................................................................3012
 10.1.4.6 Dynamization in the property list.............................................................................................3024
 10.1.4.7 Dynamize with system functions.............................................................................................3028
 10.1.5 Working with function keys......................................................................................................3030
 10.1.5.1 Working with function keys .....................................................................................................3030
 10.1.5.2 Assigning function keys globally..............................................................................................3032
 10.1.5.3 Local assignment of function keys...........................................................................................3033
 10.1.5.4 Assigning a function key to a function.....................................................................................3035
 10.1.5.5 Assigning operator authorization for a function key.................................................................3036

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  13



 10.1.5.6 Assigning a function key to a graphic......................................................................................3037
 10.1.5.7 Configuring LED tags..............................................................................................................3039
 10.1.5.8 Example: Using function keys for screen navigation...............................................................3041
 10.1.6 Working with layers.................................................................................................................3042
 10.1.6.1 Basics on working with layers..................................................................................................3042
 10.1.6.2 Moving objects between layers...............................................................................................3044
 10.1.6.3 Setting the active layer............................................................................................................3044
 10.1.6.4 Show and hide layers..............................................................................................................3046
 10.1.6.5 Renaming layers......................................................................................................................3047
 10.1.7 Working with faceplates...........................................................................................................3049
 10.1.7.1 Basics on faceplates................................................................................................................3049
 10.1.7.2 Faceplate editor.......................................................................................................................3051
 10.1.7.3 Creating and managing faceplates..........................................................................................3054
 10.1.7.4 Dynamizing faceplates............................................................................................................3069
 10.1.7.5 Examples of faceplates...........................................................................................................3070
 10.1.8 Indicator and control objects....................................................................................................3077
 10.1.8.1 Device-Specific Nature of the Objects.....................................................................................3077
 10.1.8.2 Objects....................................................................................................................................3086
 10.1.9 Configuring screen navigation.................................................................................................3162
 10.1.9.1 Basics on screen navigation....................................................................................................3162
 10.1.9.2 Assigning button with screen change......................................................................................3163
 10.1.9.3 Assigning screen change to function key................................................................................3164
 10.2 Working with Tags...................................................................................................................3166
 10.2.1 Basics......................................................................................................................................3166
 10.2.1.1 Basics of tags..........................................................................................................................3166
 10.2.1.2 Overview of HMI tag tables.....................................................................................................3167
 10.2.1.3 External tags............................................................................................................................3169
 10.2.1.4 Addressing external tags.........................................................................................................3170
 10.2.1.5 Internal Tags............................................................................................................................3172
 10.2.2 Working with Tags...................................................................................................................3173
 10.2.2.1 Creating tags...........................................................................................................................3173
 10.2.2.2 Editing tags..............................................................................................................................3177
 10.2.2.3 Configuring Tags.....................................................................................................................3183
 10.2.3 Working with arrays.................................................................................................................3201
 10.2.3.1 Basics on arrays......................................................................................................................3201
 10.2.3.2 Creating array tags..................................................................................................................3203
 10.2.3.3 Examples of arrays..................................................................................................................3204
 10.2.4 Working with user data types..................................................................................................3204
 10.2.4.1 Basics on user data types.......................................................................................................3204
 10.2.4.2 Creating a user data type........................................................................................................3206
 10.2.4.3 Creating user data type elements............................................................................................3208
 10.2.4.4 Managing versions of user data types.....................................................................................3209
 10.2.4.5 Creating tags with a user data type data type.........................................................................3210
 10.2.5 Working with cycles.................................................................................................................3212
 10.2.5.1 Cycle basics............................................................................................................................3212
 10.2.5.2 Defining cycles........................................................................................................................3213
 10.2.6 Logging tags............................................................................................................................3214
 10.2.6.1 Basic principles for data logging..............................................................................................3214
 10.2.6.2 Data logging in Runtime Advanced and Panels......................................................................3215
 10.2.7 Displaying Tags.......................................................................................................................3235
 10.2.7.1 Displaying tags with Basic Panels...........................................................................................3235
 10.2.7.2 Displaying tags with Runtime Advanced and Panels..............................................................3237

Table of contents

WinCC Comfort/Advanced V12.0 SP1
14 System Manual, 07/2013,  



 10.3 Working with alarms................................................................................................................3245
 10.3.1 Basics......................................................................................................................................3245
 10.3.1.1 Alarm Logging in WinCC.........................................................................................................3245
 10.3.1.2 Alarm Logging in WinCC.........................................................................................................3246
 10.3.1.3 Alarm Procedures....................................................................................................................3247
 10.3.1.4 Alarm states.............................................................................................................................3252
 10.3.1.5 Alarm classes..........................................................................................................................3253
 10.3.1.6 Acknowledgement...................................................................................................................3256
 10.3.1.7 Alarm groups...........................................................................................................................3259
 10.3.1.8 Alarm number..........................................................................................................................3259
 10.3.2 Working with Alarms ...............................................................................................................3260
 10.3.2.1 Alarm components and properties...........................................................................................3260
 10.3.2.2 Configuring Alarms..................................................................................................................3261
 10.3.2.3 Configuring the Outputting of Alarms......................................................................................3283
 10.3.2.4 Acknowledging alarms.............................................................................................................3300
 10.3.2.5 Configuring alarm buffer overflow............................................................................................3303
 10.3.3 Logging Alarms........................................................................................................................3304
 10.3.3.1 Alarm Logging Basics..............................................................................................................3304
 10.3.3.2 Storage locations for log files..................................................................................................3306
 10.3.3.3 Creating an alarm log..............................................................................................................3308
 10.3.3.4 Logging Alarms........................................................................................................................3312
 10.3.3.5 Configuring an alarm view for logged alarms..........................................................................3313
 10.3.3.6 Direct access to the ODBC log database................................................................................3314
 10.3.3.7 Setting up the ODBC data source...........................................................................................3315
 10.3.3.8 Configuring a checksum for a log............................................................................................3315
 10.3.3.9 Evaluating the checksum of log data.......................................................................................3317
 10.3.3.10 Log response to language switching in runtime.................................................................3318
 10.3.3.11 Managing logging behavior when Runtime starts..............................................................3319
 10.3.3.12 Controlling the Logging in relation to the Fill Level.............................................................3320
 10.3.4 Using Alarms in Runtime.........................................................................................................3321
 10.3.4.1 Alarms in Runtime...................................................................................................................3321
 10.3.4.2 Alarms in Runtime...................................................................................................................3323
 10.3.4.3 Using the Alarm Window or Alarm View..................................................................................3325
 10.3.4.4 Using the Simple Alarm Window, Alarm View.........................................................................3328
 10.3.4.5 Using the Alarm Indicator........................................................................................................3331
 10.3.4.6 Acknowledging alarms.............................................................................................................3332
 10.3.4.7 Filtering Alarms .......................................................................................................................3333
 10.3.5 Reference................................................................................................................................3334
 10.3.5.1 System functions for alarms....................................................................................................3334
 10.3.5.2 Alarm events............................................................................................................................3335
 10.3.5.3 System functions for logs........................................................................................................3336
 10.3.5.4 Structure of *.csv files that contain alarms..............................................................................3336
 10.3.5.5 System events.........................................................................................................................3338
 10.3.6 Configuring system diagnostics...............................................................................................3371
 10.3.6.1 System diagnostics basics......................................................................................................3371
 10.3.6.2 System diagnostics views........................................................................................................3372
 10.3.6.3 Basic Panel basics..................................................................................................................3376
 10.3.6.4 Configuring system diagnostics objects..................................................................................3379
 10.4 Working with logs....................................................................................................................3388
 10.4.1 Working with logs for Runtime Advanced and Panels.............................................................3388
 10.4.1.1 Log Basics...............................................................................................................................3388

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  15



 10.4.1.2 Properties of Logs...................................................................................................................3388
 10.5 Working with recipes...............................................................................................................3391
 10.5.1 Basics......................................................................................................................................3391
 10.5.1.1 Definition and applications.......................................................................................................3391
 10.5.1.2 Examples for using recipes.....................................................................................................3393
 10.5.1.3 Recipe structure......................................................................................................................3393
 10.5.1.4 Display of recipes....................................................................................................................3395
 10.5.1.5 Transferring recipe data records.............................................................................................3397
 10.5.1.6 Configuration of recipes...........................................................................................................3400
 10.5.1.7 Special features of some devices............................................................................................3401
 10.5.1.8 Synchronization of recipe data records with the PLC..............................................................3403
 10.5.1.9 "Recipes" editor.......................................................................................................................3404
 10.5.2 Displaying and Editing Recipes in Runtime.............................................................................3407
 10.5.2.1 Recipe screen and recipe view................................................................................................3407
 10.5.2.2 Simple recipe view...................................................................................................................3407
 10.5.2.3 Configuration options of the simple recipe view......................................................................3409
 10.5.2.4 Advanced recipe view..............................................................................................................3412
 10.5.2.5 Configuration options of the advanced recipe view.................................................................3413
 10.5.2.6 Response of the recipe view in Runtime.................................................................................3415
 10.5.2.7 Basics on the recipe screen....................................................................................................3416
 10.5.3 Configuring Recipes................................................................................................................3418
 10.5.3.1 General configuration procedure.............................................................................................3418
 10.5.3.2 Creating and Editing Recipes..................................................................................................3419
 10.5.3.3 Configuring the display of recipes...........................................................................................3427
 10.5.3.4 Importing recipes into the configuration and exporting them...................................................3433
 10.5.4 Using Recipes in Runtime.......................................................................................................3436
 10.5.4.1 Simple recipe view...................................................................................................................3436
 10.5.4.2 Advanced recipe view..............................................................................................................3442
 10.5.4.3 Exporting and importing recipe data records...........................................................................3449
 10.5.4.4 Reactions to modifications of the recipe structure...................................................................3450
 10.5.5 Examples.................................................................................................................................3451
 10.5.5.1 Example of creating a recipe...................................................................................................3451
 10.5.5.2 Example of configuring a recipe screen..................................................................................3453
 10.5.5.3 Scenario for Entering Recipe Data Records in Runtime.........................................................3455
 10.5.5.4 Scenario for a manual production sequence...........................................................................3456
 10.5.5.5 Scenario for an Automatic Production Sequence....................................................................3458
 10.6 Working with reports................................................................................................................3460
 10.6.1 Basics......................................................................................................................................3460
 10.6.1.1 Reports....................................................................................................................................3460
 10.6.1.2 Structure of reports..................................................................................................................3461
 10.6.2 Working with reports................................................................................................................3463
 10.6.2.1 Creating reports.......................................................................................................................3463
 10.6.2.2 Printing reports........................................................................................................................3468
 10.6.2.3 Working with objects................................................................................................................3469
 10.6.3 Operation in Runtime...............................................................................................................3484
 10.6.3.1 Printing reports........................................................................................................................3484
 10.6.4 Objects in reports....................................................................................................................3484
 10.6.4.1 Audit report..............................................................................................................................3484
 10.6.4.2 Date/time field..........................................................................................................................3485
 10.6.4.3 I/O field....................................................................................................................................3486
 10.6.4.4 Graphic view............................................................................................................................3488

Table of contents

WinCC Comfort/Advanced V12.0 SP1
16 System Manual, 07/2013,  



 10.6.4.5 Graphic I/O field.......................................................................................................................3489
 10.6.4.6 Alarm report.............................................................................................................................3489
 10.6.4.7 Recipe report...........................................................................................................................3492
 10.6.4.8 Page number...........................................................................................................................3493
 10.6.4.9 Symbolic I/O field.....................................................................................................................3494
 10.6.4.10 Text field.............................................................................................................................3494
 10.7 Configuring user administration...............................................................................................3496
 10.7.1 Field of application of the user administration.........................................................................3496
 10.7.2 Form of the user administration...............................................................................................3496
 10.7.3 Basics......................................................................................................................................3497
 10.7.3.1 Users.......................................................................................................................................3497
 10.7.3.2 Users work area......................................................................................................................3498
 10.7.3.3 User groups.............................................................................................................................3499
 10.7.3.4 User groups work area............................................................................................................3499
 10.7.3.5 Settings for the user administration.........................................................................................3500
 10.7.3.6 Settings for the user administration.........................................................................................3502
 10.7.4 Building up and structuring a user administration....................................................................3504
 10.7.4.1 Basics of user administration...................................................................................................3504
 10.7.4.2 Administering users for Runtime ............................................................................................3505
 10.7.4.3 Managing users on the server.................................................................................................3511
 10.7.4.4 Administering users in Runtime...............................................................................................3516
 10.7.4.5 Configuring access protection.................................................................................................3528
 10.7.5 Reference................................................................................................................................3529
 10.7.5.1 Objects with access protection................................................................................................3529
 10.7.5.2 Objects with access protection................................................................................................3530
 10.7.5.3 Default user groups and authorizations...................................................................................3530
 10.7.6 Examples.................................................................................................................................3531
 10.7.6.1 Example: Configuring a button with logon dialog box.............................................................3531
 10.7.6.2 Example: Logging the logon and logoff events.......................................................................3532
 10.7.6.3 Example of a user administration............................................................................................3533
 10.8 Working with system functions and Runtime scripting............................................................3541
 10.8.1 Basics......................................................................................................................................3541
 10.8.1.1 Runtime scripting.....................................................................................................................3541
 10.8.1.2 System functions.....................................................................................................................3542
 10.8.1.3 User-defined functions.............................................................................................................3544
 10.8.2 Working with function lists.......................................................................................................3545
 10.8.2.1 Basics of the function list.........................................................................................................3545
 10.8.2.2 Properties of a function list......................................................................................................3546
 10.8.2.3 Configuring a function list........................................................................................................3547
 10.8.2.4 Editing a function list................................................................................................................3549
 10.8.3 Working with user-defined VB functions..................................................................................3550
 10.8.3.1 "Scripts" editor.........................................................................................................................3550
 10.8.3.2 Access to HMI tags..................................................................................................................3552
 10.8.3.3 Access to objects.....................................................................................................................3553
 10.8.3.4 Calling system functions..........................................................................................................3554
 10.8.3.5 Calling user-defined VB functions...........................................................................................3555
 10.8.3.6 Transfer and return of values in VBS......................................................................................3557
 10.8.3.7 Create customized VB functions.............................................................................................3558
 10.8.3.8 Testing the syntax of customized functions.............................................................................3560
 10.8.3.9 Renaming customized VB functions........................................................................................3561
 10.8.3.10 Executing customized VB functions...................................................................................3561

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  17



 10.8.3.11 Protecting user-defined functions.......................................................................................3562
 10.8.4 Debugging user-defined VB functions.....................................................................................3564
 10.8.4.1 Debugging user-defined VB functions.....................................................................................3564
 10.8.4.2 Integrating the Debugger.........................................................................................................3567
 10.8.4.3 Starting and stopping the debugger........................................................................................3572
 10.8.5 Runtime behavior in Runtime..................................................................................................3573
 10.8.5.1 Executing a function list in Runtime.........................................................................................3573
 10.8.5.2 Executing user-defined functions in Runtime..........................................................................3573
 10.8.5.3 Processing sequence for user-defined functions and system functions..................................3574
 10.8.5.4 Making object properties dynamic in Runtime.........................................................................3576
 10.8.6 Examples.................................................................................................................................3577
 10.8.6.1 Example: Converting Fahrenheit into degrees Celsius...........................................................3577
 10.8.6.2 Example: Converting inches into meters.................................................................................3579
 10.8.6.3 Example: Changing the operating mode on the HMI device with the current display.............3581
 10.8.7 Reference................................................................................................................................3583
 10.8.7.1 Function list.............................................................................................................................3583
 10.8.7.2 Events......................................................................................................................................3775
 10.8.7.3 VB scripts................................................................................................................................3798
 10.9 Mobile Wireless.......................................................................................................................4864
 10.9.1 Field of application of the Mobile Panel Wireless....................................................................4864
 10.9.2 How does the transponder system work?...............................................................................4865
 10.9.3 How does the RFID system work?..........................................................................................4867
 10.9.4 Configuring the Mobile Panel V2 for fail-safe operation..........................................................4869
 10.9.4.1 Configuration overview............................................................................................................4869
 10.9.4.2 Creating PLC for fail-safe operation........................................................................................4870
 10.9.4.3 Installing a general station description (GSD).........................................................................4871
 10.9.4.4 Creating a module from the GSD file.......................................................................................4871
 10.9.4.5 Creating a connection between a module and the PLC..........................................................4874
 10.9.4.6 Creating Mobile Panel.............................................................................................................4875
 10.9.5 Basics......................................................................................................................................4876
 10.9.5.1 Zones.......................................................................................................................................4876
 10.9.5.2 Zones working area.................................................................................................................4876
 10.9.5.3 Effective ranges.......................................................................................................................4877
 10.9.5.4 Effective ranges working area.................................................................................................4878
 10.9.5.5 Effective ranges (RFID)...........................................................................................................4880
 10.9.5.6 Work area for effective ranges (RFID).....................................................................................4880
 10.9.6 Working with zones.................................................................................................................4882
 10.9.6.1 Configuring a zone..................................................................................................................4882
 10.9.6.2 Displaying the screen on entering a zone...............................................................................4883
 10.9.6.3 Displaying an object in relation to the zone.............................................................................4884
 10.9.7 Working with effective ranges..................................................................................................4885
 10.9.7.1 Overview..................................................................................................................................4885
 10.9.7.2 Configure effective range........................................................................................................4886
 10.9.7.3 Configuring the effective range name......................................................................................4887
 10.9.7.4 Configuring additional Mobile Wireless objects.......................................................................4888
 10.9.8 Working with effective ranges (RFID)......................................................................................4888
 10.9.8.1 Overview..................................................................................................................................4888
 10.9.8.2 Configuring effective range (RFID)..........................................................................................4889
 10.9.8.3 Configuring the effective range name (RFID)..........................................................................4890
 10.9.9 Reference................................................................................................................................4891
 10.9.9.1 PROFIsafe address.................................................................................................................4891
 10.9.9.2 Power Management................................................................................................................4892

Table of contents

WinCC Comfort/Advanced V12.0 SP1
18 System Manual, 07/2013,  



 10.9.9.3 Zone ID / connection point ID..................................................................................................4893
 10.10 Planning tasks.........................................................................................................................4894
 10.10.1 Field of application of the Scheduler.......................................................................................4894
 10.10.2 Working with tasks and triggers...............................................................................................4895
 10.10.3 Basics......................................................................................................................................4896
 10.10.3.1 Work area of the "Scheduler" editor...................................................................................4896
 10.10.3.2 Function list........................................................................................................................4897
 10.10.3.3 Function list........................................................................................................................4897
 10.10.3.4 Triggers..............................................................................................................................4898
 10.10.4 Planning jobs...........................................................................................................................4900
 10.10.4.1 Planning tasks with acyclic triggers....................................................................................4900
 10.10.4.2 Planning tasks with cyclic triggers .....................................................................................4902
 10.10.4.3 Planning tasks with event triggers .....................................................................................4903
 10.10.4.4 Administer task...................................................................................................................4904
 10.10.5 Examples.................................................................................................................................4904
 10.10.5.1 Example: Terminating Runtime every day.........................................................................4904
 10.10.5.2 Example: Update user following change of user................................................................4905
 10.10.5.3 Example: Changing the starting point of a job in Runtime.................................................4906
 10.11 Communicating with PLCs......................................................................................................4911
 10.11.1 Basics of communication.........................................................................................................4911
 10.11.1.1 Communication between devices.......................................................................................4911
 10.11.1.2 Devices and networks in the automation system...............................................................4912
 10.11.1.3 Data exchange using tags..................................................................................................4917
 10.11.1.4 Data exchange using area pointers....................................................................................4918
 10.11.1.5 Communication drivers.......................................................................................................4918
 10.11.2 Editors for communication.......................................................................................................4919
 10.11.2.1 "Devices & networks" editor...............................................................................................4919
 10.11.2.2 Network view......................................................................................................................4920
 10.11.2.3 Network data......................................................................................................................4923
 10.11.2.4 Diagnostics of online connections......................................................................................4925
 10.11.2.5 Device view........................................................................................................................4926
 10.11.2.6 Topology view....................................................................................................................4928
 10.11.2.7 Inspector window ...............................................................................................................4930
 10.11.2.8 Hardware catalog ..............................................................................................................4932
 10.11.2.9 Information on hardware components................................................................................4934
 10.11.3 Networks and connections......................................................................................................4935
 10.11.3.1 SIMATIC communication networks....................................................................................4935
 10.11.3.2 Configuring networks and connections..............................................................................4940
 10.11.4 Data exchange........................................................................................................................4948
 10.11.4.1 Data exchange using tags..................................................................................................4948
 10.11.4.2 Data exchange using area pointers....................................................................................4954
 10.11.5 Device dependency.................................................................................................................4960
 10.11.5.1 Basic Panel........................................................................................................................4960
 10.11.5.2 Panel..................................................................................................................................4963
 10.11.5.3 Comfort Panel....................................................................................................................4967
 10.11.5.4 Multi Panel..........................................................................................................................4971
 10.11.5.5 Mobile Panel.......................................................................................................................4973
 10.11.5.6 PC systems........................................................................................................................4977
 10.11.5.7 Parallel communication .....................................................................................................4979
 10.11.6 Communicating with SIMATIC S7 1500..................................................................................4980
 10.11.6.1 Communication with SIMATIC S7 1500.............................................................................4980

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  19



 10.11.6.2 Communication via PROFINET..........................................................................................4981
 10.11.6.3 Communication via PROFIBUS.........................................................................................4999
 10.11.6.4 Data exchange...................................................................................................................5011
 10.11.6.5 Performance features of communication............................................................................5031
 10.11.6.6 Configuring connections in the "Connections" editor.........................................................5032
 10.11.6.7 Configuring connections in the "Connections" editor.........................................................5039
 10.11.6.8 Configuring time synchronization.......................................................................................5044
 10.11.7 Communicating with SIMATIC S7 1200..................................................................................5047
 10.11.7.1 Communication with SIMATIC S7 1200.............................................................................5047
 10.11.7.2 Communication via PROFINET..........................................................................................5048
 10.11.7.3 Communication via PROFIBUS.........................................................................................5069
 10.11.7.4 Data exchange...................................................................................................................5084
 10.11.7.5 Performance features of communication............................................................................5106
 10.11.7.6 Creating connections in the "Connections" editor..............................................................5108
 10.11.7.7 Time synchronization.........................................................................................................5117
 10.11.8 Communicating with SIMATIC S7 300/400.............................................................................5120
 10.11.8.1 Communication with SIMATIC S7 300/400........................................................................5120
 10.11.8.2 Communication via PROFINET..........................................................................................5121
 10.11.8.3 Communication via PROFIBUS.........................................................................................5141
 10.11.8.4 Communication via MPI.....................................................................................................5155
 10.11.8.5 Data exchange...................................................................................................................5167
 10.11.8.6 Performance features of communication............................................................................5187
 10.11.8.7 Creating connections in the "Connections" editor..............................................................5188
 10.11.9 Communicating with SIMATIC S7 200....................................................................................5200
 10.11.9.1 Communication with SIMATIC S7 200...............................................................................5200
 10.11.9.2 Creating a connection to SIMATIC S7 200........................................................................5200
 10.11.9.3 Parameters for the connection...........................................................................................5202
 10.11.9.4 Data exchange...................................................................................................................5210
 10.11.9.5 Performance features of communication............................................................................5229
 10.11.10 Communicating with SIMATIC LOGO!....................................................................................5230
 10.11.10.1 Communication with SIMATIC LOGO!...............................................................................5230
 10.11.10.2 Creating a connection to SIMATIC LOGO!........................................................................5231
 10.11.10.3 Connection parameters......................................................................................................5232
 10.11.10.4 Data exchange...................................................................................................................5236
 10.11.10.5 Performance features of communication............................................................................5241
 10.11.11 Configuring direct keys............................................................................................................5241
 10.11.11.1 Direct keys..........................................................................................................................5241
 10.11.11.2 Changing the operating mode of the HMI device...............................................................5242
 10.11.11.3 Configuring direct keys.......................................................................................................5243
 10.11.11.4 PROFINET IO direct keys..................................................................................................5245
 10.11.11.5 PROFIBUS DP direct keys.................................................................................................5262
 10.11.12 Communication via SIMATIC HMI HTTP................................................................................5280
 10.11.12.1 Basic information on SIMATIC HMI HTTP.........................................................................5280
 10.11.12.2 Configuring a connection via SIMATIC HMI HTTP............................................................5282
 10.11.12.3 Performance features of communication............................................................................5295
 10.11.13 Communication via OPC.........................................................................................................5296
 10.11.13.1 Communication via OPC....................................................................................................5296
 10.11.13.2 Configuring a connection via OPC.....................................................................................5296
 10.11.13.3 Performance features of communication............................................................................5298
 10.11.14 Communication via routing......................................................................................................5300
 10.11.14.1 Communication via routing.................................................................................................5300
 10.11.14.2 Example for communication via routing.............................................................................5302

Table of contents

WinCC Comfort/Advanced V12.0 SP1
20 System Manual, 07/2013,  



 10.11.14.3 Configuring communication via routing..............................................................................5304
 10.11.15 PROFINET IO and IRT............................................................................................................5305
 10.11.15.1 PROFINET IO....................................................................................................................5305
 10.11.15.2 IRT communication............................................................................................................5307
 10.11.15.3 Configuring the HMI device as IO device...........................................................................5310
 10.11.15.4 Parameters for PROFINET IO and IRT..............................................................................5311
 10.11.15.5 Performance characteristics of PROFINET IO and IRT.....................................................5313
 10.11.16 Media redundancy...................................................................................................................5314
 10.11.16.1 Restrictions with media redundancy...................................................................................5314
 10.11.16.2 Media redundancy..............................................................................................................5315
 10.11.16.3 Media Redundancy Protocol (MRP)...................................................................................5316
 10.11.16.4 Configuring media redundancy for HMI devices ...............................................................5317
 10.11.16.5 Parameters for media redundancy.....................................................................................5319
 10.11.16.6 Managing MRP domains....................................................................................................5320
 10.11.17 Communication with other PLCs.............................................................................................5322
 10.11.17.1 Communication with other PLCs........................................................................................5322
 10.11.17.2 Distinctive features when configuring.................................................................................5323
 10.11.17.3 Parallel communication .....................................................................................................5323
 10.11.17.4 Communication drivers.......................................................................................................5325
 10.11.17.5 Data exchange using area pointers....................................................................................5446
 10.11.18 Special features of WinAC MP................................................................................................5461
 10.11.18.1 WinAC MP basics...............................................................................................................5461
 10.11.18.2 Communication options with WinAC MP............................................................................5463
 10.11.18.3 Standard procedure for communication with WinAC MP...................................................5467
 10.11.18.4 Configuring the WinAC MP communications driver...........................................................5468
 10.11.18.5 Transferring WinAC MP to the HMI device........................................................................5479
 10.11.18.6 Transferring authorization to the HMI device.....................................................................5484
 10.11.18.7 WinAC MP system library...................................................................................................5485
 10.12 Using global functions.............................................................................................................5486
 10.12.1 HMI device wizard basics........................................................................................................5486
 10.12.2 HMI device wizard basics........................................................................................................5487
 10.12.3 Working with libraries..............................................................................................................5488
 10.12.3.1 Basics on libraries..............................................................................................................5488
 10.12.3.2 Overview of the library view...............................................................................................5490
 10.12.3.3 Copy templates and types..................................................................................................5492
 10.12.3.4 Libraries in WinCC.............................................................................................................5493
 10.12.3.5 Managing libraries..............................................................................................................5494
 10.12.3.6 Managing objects in a library..............................................................................................5499
 10.12.3.7 Using types and their versions...........................................................................................5503
 10.12.4 Importing and exporting project data.......................................................................................5506
 10.12.4.1 Importing and exporting project data..................................................................................5506
 10.12.4.2 Importing and exporting recipes.........................................................................................5508
 10.12.4.3 Importing and exporting alarms..........................................................................................5512
 10.12.4.4 Importing and exporting tags..............................................................................................5519
 10.12.4.5 Importing and exporting text lists........................................................................................5525
 10.12.5 Using cross-references............................................................................................................5529
 10.12.5.1 General information about cross references......................................................................5529
 10.12.5.2 Displaying the cross-reference list.....................................................................................5529
 10.12.5.3 Structure of the cross-reference list...................................................................................5530
 10.12.5.4 Displaying cross-references in the Inspector window........................................................5531
 10.12.6 Managing languages...............................................................................................................5533
 10.12.6.1 Languages in WinCC.........................................................................................................5533

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  21



 10.12.6.2 Language settings in the operating system........................................................................5534
 10.12.6.3 Operating system settings for Asian languages.................................................................5535
 10.12.6.4 Setting project languages...................................................................................................5536
 10.12.6.5 Creating one project in multiple languages........................................................................5539
 10.12.6.6 Using language-specific graphics.......................................................................................5547
 10.12.6.7 Languages in runtime.........................................................................................................5551
 10.12.6.8 Example of multilingual configuration.................................................................................5558
 10.12.7 Replacing devices...................................................................................................................5561
 10.12.7.1 Basics.................................................................................................................................5561
 10.12.7.2 Device-specific functions....................................................................................................5562
 10.12.7.3 Adjust screens to the new device.......................................................................................5567
 10.12.7.4 Example: Replacing devices..............................................................................................5572
 10.12.8 Copying between devices and editors.....................................................................................5576
 10.12.8.1 Basics.................................................................................................................................5576
 10.12.8.2 Copy and paste..................................................................................................................5579
 10.12.8.3 Copying between different RT and ES versions.................................................................5583
 10.12.9 Using WinCC version compatibility..........................................................................................5585
 10.12.9.1 Basics on version compatibility..........................................................................................5585
 10.12.9.2 Editing projects of a previous WinCC version....................................................................5587
 10.12.9.3 Upgrading projects.............................................................................................................5588
 10.12.9.4 Changing between device versions....................................................................................5589
 10.12.9.5 Changing the device version..............................................................................................5590
 10.12.10 Viewing memory card data......................................................................................................5591
 10.12.10.1 Basics.................................................................................................................................5591
 10.12.10.2 Working with backups........................................................................................................5591
 10.12.10.3 Working with HMI device images.......................................................................................5594
 10.13 Compiling and loading.............................................................................................................5599
 10.13.1 Compiling and loading projects...............................................................................................5599
 10.13.1.1 Overview of compiling and loading projects.......................................................................5599
 10.13.1.2 Compiling a project.............................................................................................................5601
 10.13.1.3 Loading projects.................................................................................................................5602
 10.13.1.4 Runtime start......................................................................................................................5615
 10.13.2 Simulating projects..................................................................................................................5617
 10.13.2.1 Simulation basics...............................................................................................................5617
 10.13.2.2 WinCC Runtime Advanced simulation...............................................................................5618
 10.13.2.3 Simulating a project............................................................................................................5619
 10.13.2.4 Simulating a screen............................................................................................................5621
 10.13.2.5 Working with the tag simulator...........................................................................................5621
 10.13.2.6 Simulation restrictions........................................................................................................5623
 10.13.2.7 Start debugger....................................................................................................................5623
 10.13.3 Servicing the HMI device.........................................................................................................5624
 10.13.3.1 Overview of HMI device maintenance (Basic Panels)........................................................5624
 10.13.3.2 Overview of HMI device maintenance tasks (Basic Panels)..............................................5625
 10.13.3.3 ProSave..............................................................................................................................5626
 10.13.3.4 Backup of HMI data............................................................................................................5626
 10.13.3.5 Backing up and restoring data of the HMI device...............................................................5628
 10.13.3.6 Updating the operating system...........................................................................................5629
 10.13.3.7 Updating the operating system on the HMI device.............................................................5630
 10.13.3.8 Transferring license keys...................................................................................................5632
 10.13.3.9 Managing licenses..............................................................................................................5632
 10.13.3.10 Installing and uninstalling an option...................................................................................5634
 10.13.4 Reference................................................................................................................................5635

Table of contents

WinCC Comfort/Advanced V12.0 SP1
22 System Manual, 07/2013,  



 10.13.4.1 Error messages during the download of projects...............................................................5635
 10.13.4.2 Adapting the project for another HMI device......................................................................5636
 10.13.4.3 Establishing a connection to the HMI device......................................................................5638
 10.14 Operating in Runtime...............................................................................................................5639
 10.14.1 Basics......................................................................................................................................5639
 10.14.1.1 Overview............................................................................................................................5639
 10.14.1.2 System behavior.................................................................................................................5640
 10.14.2 Commissioning projects..........................................................................................................5644
 10.14.2.1 Runtime Advanced and Panels..........................................................................................5644
 10.14.2.2 Settings for Runtime Advanced and Panels.......................................................................5644
 10.14.2.3 Loading a project................................................................................................................5647
 10.14.2.4 Testing a project.................................................................................................................5648
 10.14.2.5 Backup and restoring projects............................................................................................5649
 10.14.2.6 Starting the project.............................................................................................................5651
 10.14.3 Operating projects...................................................................................................................5651
 10.14.3.1 Setting the project language...............................................................................................5651
 10.14.3.2 Operating recipes...............................................................................................................5652
 10.14.3.3 Operating alarms................................................................................................................5681
 10.14.3.4 Basics.................................................................................................................................5691
 10.14.3.5 Project security...................................................................................................................5708
 10.15 Performance features..............................................................................................................5727
 10.15.1 Engineering system.................................................................................................................5727
 10.15.2 Basic Panel..............................................................................................................................5729
 10.15.3 Panel.......................................................................................................................................5732
 10.15.4 Mobile Panel............................................................................................................................5736
 10.15.5 Multi Panel...............................................................................................................................5740
 10.15.6 Comfort Panel..........................................................................................................................5744
 10.15.7 WinCC Runtime Advanced......................................................................................................5749
 10.15.8 General technical specifications..............................................................................................5752
 10.15.8.1 Recommended printers......................................................................................................5752
 10.15.8.2 Printing via print server.......................................................................................................5753
 10.15.8.3 Memory requirement of recipes..........................................................................................5754
 10.15.8.4 Memory requirements of recipes for Basic Panels, OP 77A, and TP 177A.......................5755
 10.16 Options....................................................................................................................................5757
 10.16.1 Following GMP with Audit........................................................................................................5757
 10.16.1.1 Basics.................................................................................................................................5757
 10.16.1.2 Enabling GMP compliant configuration..............................................................................5761
 10.16.1.3 Using the Audit trail............................................................................................................5763
 10.16.1.4 Configuring audit functions.................................................................................................5784
 10.16.1.5 Performance features of GMP relevant configuration........................................................5798
 10.16.2 Sm@rt Options........................................................................................................................5799
 10.16.2.1 Basics.................................................................................................................................5799
 10.16.2.2 Remote control via Sm@rtServer.......................................................................................5829
 10.16.2.3 E-mail notification from runtime..........................................................................................5840
 10.16.2.4 Display integrated Service-Pages......................................................................................5844
 10.16.2.5 Access via SIMATIC HMI HTTP Protocol..........................................................................5856
 10.16.2.6 Connection to the Office-world...........................................................................................5864
 10.17 Interfaces.................................................................................................................................5869
 10.17.1 Customer controls...................................................................................................................5869
 10.17.1.1 Overview............................................................................................................................5869

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  23



 10.17.1.2 Interfaces............................................................................................................................5871
 10.17.1.3 Demo project......................................................................................................................5873
 10.17.1.4 Creating and testing customer controls..............................................................................5874
 10.17.1.5 Reference...........................................................................................................................5883
 10.17.2 OPC.........................................................................................................................................5892
 10.17.2.1 Basics.................................................................................................................................5892
 10.17.2.2 Configuring an OPC server................................................................................................5895
 10.17.2.3 Configuring an OPC client..................................................................................................5897
 10.17.2.4 Reference...........................................................................................................................5902
 10.18 Migration to WinCC V12..........................................................................................................5905
 10.18.1 Overview of migration to WinCC V12......................................................................................5905
 10.18.2 WinCC flexible.........................................................................................................................5905
 10.18.2.1 Libraries..............................................................................................................................5905
 10.18.2.2 Screens and templates.......................................................................................................5907
 10.18.2.3 Scripts in faceplates...........................................................................................................5909
 10.18.2.4 Synchronization of recipes.................................................................................................5910

11 Using technology functions.....................................................................................................................5913
 11.1 PID control...............................................................................................................................5913
 11.1.1 Principles for control................................................................................................................5913
 11.1.1.1 Controlled system and actuators.............................................................................................5913
 11.1.1.2 Controlled systems..................................................................................................................5914
 11.1.1.3 Characteristic values of the control section.............................................................................5916
 11.1.1.4 Pulse controller........................................................................................................................5918
 11.1.1.5 Response to setpoint changes and disturbances....................................................................5922
 11.1.1.6 Control Response at Different Feedback Structures...............................................................5923
 11.1.1.7 Selection of the controller structure for specified controlled systems......................................5931
 11.1.1.8 PID parameter settings............................................................................................................5932
 11.1.2 Configuring a software controller.............................................................................................5932
 11.1.2.1 Overview of software controller...............................................................................................5932
 11.1.2.2 Steps for the configuration of a software controller.................................................................5934
 11.1.2.3 Add technology objects...........................................................................................................5934
 11.1.2.4 Configure technology objects..................................................................................................5935
 11.1.2.5 Call instruction in the user program.........................................................................................5936
 11.1.2.6 Downloading technology objects to device..............................................................................5937
 11.1.2.7 Commissioning software controller..........................................................................................5938
 11.1.2.8 Save optimized PID parameter in the project..........................................................................5939
 11.1.2.9 Comparing values....................................................................................................................5939
 11.1.2.10 Display instance DB of a technology object.......................................................................5942
 11.1.3 Using PID_Compact................................................................................................................5942
 11.1.3.1 Technology object PID_Compact............................................................................................5942
 11.1.3.2 PID_Compact V2.....................................................................................................................5943
 11.1.3.3 PID_Compact V1.....................................................................................................................5959
 11.1.4 Using PID_3Step.....................................................................................................................5974
 11.1.4.1 Technology object PID_3Step.................................................................................................5974
 11.1.4.2 PID_3Step V2..........................................................................................................................5975
 11.1.4.3 PID_3Step V1..........................................................................................................................5991
 11.2 Using S7-1200 Motion Control................................................................................................6008
 11.2.1 Introduction..............................................................................................................................6008
 11.2.1.1 Motion functionality of the CPU S7-1200.................................................................................6008
 11.2.1.2 Hardware components for motion control................................................................................6009

Table of contents

WinCC Comfort/Advanced V12.0 SP1
24 System Manual, 07/2013,  



 11.2.2 Basics for working with S7-1200 Motion Control.....................................................................6012
 11.2.2.1 CPU outputs relevant for motion control..................................................................................6012
 11.2.2.2 How the pulse interface works.................................................................................................6013
 11.2.2.3 Relationship between the travel direction and voltage level at the direction output................6015
 11.2.2.4 Hardware and software limit switches.....................................................................................6016
 11.2.2.5 Jerk limit..................................................................................................................................6017
 11.2.2.6 Homing....................................................................................................................................6018
 11.2.3 Guidelines on use of motion control........................................................................................6019
 11.2.4 Overview of versions...............................................................................................................6019
 11.2.5 Techology object axis..............................................................................................................6022
 11.2.5.1 Integration of the axis technology object.................................................................................6022
 11.2.5.2 Tools of the axis technology object.........................................................................................6024
 11.2.5.3 Add technological object Axis..................................................................................................6026
 11.2.5.4 Configuring the axis technoloogy object..................................................................................6027
 11.2.6 Technology object command table..........................................................................................6050
 11.2.6.1 Use of the command table technology object..........................................................................6050
 11.2.6.2 Command table technology object tools..................................................................................6050
 11.2.6.3 Adding the technological object command table.....................................................................6051
 11.2.6.4 Configuring the command table technology object..................................................................6052
 11.2.7 Download to CPU....................................................................................................................6068
 11.2.8 Commissioning the axis - Axis control panel...........................................................................6069
 11.2.9 Programming...........................................................................................................................6072
 11.2.9.1 Overview of the Motion Control statements.............................................................................6072
 11.2.9.2 Creating a user program..........................................................................................................6073
 11.2.9.3 Programming notes.................................................................................................................6076
 11.2.9.4 Behavior of the Motion Control commands after POWER OFF and restart............................6078
 11.2.9.5 Monitoring active commands...................................................................................................6078
 11.2.9.6 Error displays of the Motion Control statements......................................................................6090
 11.2.10 Axis - Diagnostics....................................................................................................................6091
 11.2.10.1 Status and error bits...........................................................................................................6091
 11.2.10.2 Motion status......................................................................................................................6093
 11.2.10.3 Dynamics settings..............................................................................................................6094
 11.2.11 Working with watch tables.......................................................................................................6094
 11.2.12 Appendix..................................................................................................................................6095
 11.2.12.1 Using multiple axes with the same PTO.............................................................................6095
 11.2.12.2 Using multiple drives with the same PTO...........................................................................6099
 11.2.12.3 Tracking jobs from higher priority classes (execution levels).............................................6100
 11.2.12.4 Special cases for use of software limit switches................................................................6102
 11.2.12.5 Reducing velocity for a short positioning duration..............................................................6109
 11.2.12.6 Dynamic adjustment of start/stop velocity..........................................................................6109
 11.2.12.7 List of ErrorIDs and ErrorInfos (technology objects as of V2.0).........................................6109
 11.2.12.8 Tag of the Axis technology object......................................................................................6118
 11.2.12.9 Command table technology object tag...............................................................................6133
 11.2.12.10 Documentation for functions from previous versions.........................................................6134

12 Using online and diagnostics functions...................................................................................................6143
 12.1 Displaying accessible devices.................................................................................................6143
 12.2 Changing the device configuration online................................................................................6145
 12.3 Connecting devices online.......................................................................................................6146
 12.3.1 General information about online mode..................................................................................6146
 12.3.2 View in online mode................................................................................................................6147

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  25



 12.3.3 Establishing and canceling an online connection....................................................................6148
 12.3.4 Connecting online with several devices...................................................................................6150
 12.3.5 Disconnecting online connections of multiple devices.............................................................6151
 12.4 Backing up the software and hardware configuration of a device...........................................6152
 12.4.1 Creating a backup of a device.................................................................................................6152
 12.4.2 Backing up a device configuration...........................................................................................6153
 12.4.3 Restoring the software and hardware configuration of a device.............................................6153
 12.5 Configuring the PG/PC interface.............................................................................................6155
 12.5.1 Online access..........................................................................................................................6155
 12.5.2 Basics of assigning parameters for the PG/PC interface........................................................6157
 12.5.3 Displaying and modifying interface properties.........................................................................6157
 12.5.4 Adding interfaces.....................................................................................................................6158
 12.5.5 Setting parameters for the Ethernet interface..........................................................................6158
 12.5.5.1 Setting parameters for the Industrial Ethernet interface..........................................................6158
 12.5.5.2 Displaying operating system parameters................................................................................6159
 12.5.5.3 Connecting the PG/PC interface to a subnet...........................................................................6160
 12.5.5.4 Setting parameters for the Ethernet interface..........................................................................6160
 12.5.5.5 Assigning a temporary IP address...........................................................................................6161
 12.5.5.6 Managing temporary IP addresses..........................................................................................6162
 12.5.5.7 Resetting the TCP/IP configuration.........................................................................................6162
 12.5.6 Setting parameters for the MPI and PROFIBUS interfaces.....................................................6163
 12.5.6.1 Setting parameters for the MPI and PROFIBUS interfaces.....................................................6163
 12.5.6.2 Setting MPI or PROFIBUS interface parameters automatically..............................................6164
 12.5.6.3 Setting parameters for the MPI interface.................................................................................6164
 12.5.6.4 Setting parameters for the PROFIBUS interface.....................................................................6166
 12.5.6.5 Overview of the bus parameters for PROFIBUS.....................................................................6169
 12.5.6.6 Resetting the MPI or PROFIBUS configuration.......................................................................6170
 12.6 Using the trace and logic analyzer function.............................................................................6171
 Preface....................................................................................................................................6171
 12.6.1 Description...............................................................................................................................6172
 12.6.1.1 Supported hardware................................................................................................................6172
 12.6.1.2 Recording of measured values with the trace function............................................................6172
 12.6.1.3 Trace configuration, recording and measurement...................................................................6173
 12.6.1.4 Data storage............................................................................................................................6174
 12.6.2 Software user interface............................................................................................................6175
 12.6.2.1 Project navigator......................................................................................................................6177
 12.6.2.2 Working area...........................................................................................................................6177
 12.6.2.3 Device-specific area................................................................................................................6185
 12.6.3 Operation.................................................................................................................................6185
 12.6.3.1 Quick start...............................................................................................................................6185
 12.6.3.2 Using the trace function - overview.........................................................................................6190
 12.6.3.3 Calling the trace editor.............................................................................................................6190
 12.6.3.4 Trace handling.........................................................................................................................6191
 12.6.3.5 Signal table..............................................................................................................................6195
 12.6.3.6 Curve diagram.........................................................................................................................6196
 12.6.4 Devices....................................................................................................................................6197
 12.6.4.1 S7-1200/1500 CPUs................................................................................................................6197
 12.7 Establishing a remote connection with TeleService................................................................6211
 12.7.1 Basics of working with TeleService.........................................................................................6211
 12.7.1.1 Introduction to TeleService......................................................................................................6211

Table of contents

WinCC Comfort/Advanced V12.0 SP1
26 System Manual, 07/2013,  



 12.7.1.2 TeleService functionality..........................................................................................................6212
 12.7.1.3 Telephone book at TeleService...............................................................................................6212
 12.7.2 Working with the phone book..................................................................................................6213
 12.7.2.1 Basics on working with the phone book..................................................................................6213
 12.7.2.2 Structure of the phone book....................................................................................................6214
 12.7.2.3 Symbols in the phone book.....................................................................................................6215
 12.7.2.4 Manage phone book................................................................................................................6215
 12.7.3 Remote connections as dial-up connections...........................................................................6221
 12.7.3.1 Basics for establishing a dial-up connection............................................................................6221
 12.7.3.2 Telephone networks and modems..........................................................................................6222
 12.7.3.3 Access protection for dial-up connections...............................................................................6225
 12.7.3.4 TS adapter MPI.......................................................................................................................6230
 12.7.3.5 TS adapter IE..........................................................................................................................6237
 12.7.3.6 Establishing a dial-up connection to a remote system............................................................6243
 12.7.4 Remote VPN connections.......................................................................................................6245
 12.7.4.1 Basics for establishing a VPN connection...............................................................................6245
 12.7.4.2 Basics of CA certificates..........................................................................................................6246
 12.7.4.3 Installing CA certificates for VPN connections........................................................................6248
 12.7.4.4 Deleting CA certificates for VPN connections.........................................................................6251
 12.7.4.5 Establishing a VPN connection to a remote system................................................................6251
 12.7.4.6 TS Adapter IE Advanced.........................................................................................................6253
 12.7.5 CPU controlled TeleService remote connections ...................................................................6258
 12.7.5.1 Overview of CPU controlled remote connections....................................................................6258
 12.7.5.2 Establishing a connection from and to remote systens (PG-AS-remote coupling)..................6259
 12.7.5.3 Data exchange between remote systems (AS-AS-remote coupling)......................................6260
 12.7.5.4 Send SMS from a system........................................................................................................6262
 12.7.5.5 Send an email from a system..................................................................................................6263
 12.7.6 Notes on troubleshooting.........................................................................................................6266
 12.7.6.1 General information on troubleshooting for modem problems................................................6266
 12.7.6.2 Recording a log file for the modem..........................................................................................6266
 12.7.6.3 Dial-up connection to the TS Adapter is not established.........................................................6267
 12.7.6.4 Dial-up connection from the TS Adapter is not established.....................................................6268
 12.7.6.5 Modem connection is interrupted............................................................................................6269
 12.7.6.6 Checklist for troubleshooting the modem................................................................................6270
 12.7.6.7 Modem alarms.........................................................................................................................6270
 12.7.6.8 Possible error messages with VPN connections.....................................................................6271

13 Hardware documentation........................................................................................................................6273
 13.1 General information on the hardware documentation.............................................................6273
 13.2 HMI..........................................................................................................................................6274
 13.2.1 Basic Panels............................................................................................................................6274
 13.2.1.1 Basic Panels............................................................................................................................6274
 13.2.2 Panels......................................................................................................................................6274
 13.2.2.1 Panels of the 70 series............................................................................................................6274
 13.2.2.2 Panels of the 170 series..........................................................................................................6274
 13.2.2.3 Panels of the 270 series..........................................................................................................6274
 13.2.3 Comfort Panels........................................................................................................................6274
 13.2.3.1 Comfort Panels........................................................................................................................6274
 13.2.4 Multi Panels.............................................................................................................................6275
 13.2.4.1 170 series................................................................................................................................6275
 13.2.4.2 270 series................................................................................................................................6275
 13.2.4.3 370 series................................................................................................................................6275

Table of contents

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  27



 13.2.5 Mobile Panels..........................................................................................................................6275
 13.2.5.1 170 series................................................................................................................................6275
 13.2.5.2 270 series................................................................................................................................6275
 13.2.6 Key Panels..............................................................................................................................6275
 13.2.6.1 Key Panels..............................................................................................................................6275
 13.2.6.2 Push Button Panels.................................................................................................................6276
 13.2.7 WinAC for Multi Panels............................................................................................................6276
 13.2.7.1 WinAC for Multi Panels............................................................................................................6276
 13.3 PLC..........................................................................................................................................6277
 13.3.1 SIMATIC S7-1200...................................................................................................................6277
 13.3.1.1 CPU.........................................................................................................................................6277
 13.3.1.2 Signal boards (6ES7 2xx-xxx30-0XB0)...................................................................................6278
 13.3.1.3 CB 1241 (6ES7 241-1CH30-1XB0).........................................................................................6278
 13.3.1.4 BB 1297 (6ES7 297-0AX30-0XA0)..........................................................................................6278
 13.3.1.5 Digital input modules (6ES7 221-1Bx30-0XB0).......................................................................6279
 13.3.1.6 Digital output modules (6ES7 222-1xx30-0XB0).....................................................................6279
 13.3.1.7 Digital input and output modules (6ES7 223-1xx30-0XB0).....................................................6279
 13.3.1.8 Analog input modules (6ES7 231-xxx30-0XB0)......................................................................6280
 13.3.1.9 Analog output modules (6ES7 234-4Hx30-0XB0)...................................................................6280
 13.3.1.10 Analog input and output module (6ES7 234-4HE30-0XB0)...............................................6280
 13.3.1.11 Communications modules..................................................................................................6281
 13.3.1.12 Technology modules..........................................................................................................6283
 13.4 Distributed I/O..........................................................................................................................6284
 13.4.1 ET 200MP................................................................................................................................6284
 13.4.1.1 Interface modules....................................................................................................................6284
 13.4.2 ET 200SP................................................................................................................................6284
 13.4.2.1 Interface modules....................................................................................................................6284
 13.4.2.2 Digital input modules...............................................................................................................6287
 13.4.2.3 Digital output modules.............................................................................................................6288
 13.4.2.4 Analog input modules..............................................................................................................6289
 13.4.2.5 Analog output modules............................................................................................................6290
 13.4.2.6 Communication modules.........................................................................................................6291
 13.4.2.7 Special modules......................................................................................................................6291
 13.4.2.8 Technology modules...............................................................................................................6291

 Index.......................................................................................................................................................6293

Table of contents

WinCC Comfort/Advanced V12.0 SP1
28 System Manual, 07/2013,  



System overview of STEP 7 and WinCC 1
1.1 Scaling of STEP 7 and WinCC

Scope of performance of the products
The following graphic shows the scope of performance of the individual products of STEP 7 
and WinCC:

* Only with Professional for S7-300/400/WinAC and S7-1500

**  Only with Professional for S7-300/400/WinAC

***  With installed optional package "STEP 7 Safety"

STEP 7
STEP 7 (TIA Portal) is the engineering software for configuring the SIMATIC S7-1200, 
S7-1500, S7-300/400 and WinAC controller families. STEP 7 (TIA Portal) is available in two 
editions, depending on the configurable controller families:

● STEP 7 Basic for configuring the S7-1200

● STEP 7 Professional for configuring S7-1200, S7-1500, S7-300/400 and WinAC
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WinCC
WinCC (TIA Portal) is an engineering software for configuring SIMATIC Panels, SIMATIC 
Industrial PCs, and Standard PCs with the WinCC Runtime Advanced or the SCADA System 
WinCC Runtime Professional visualization software.

WinCC (TIA Portal) is available in four editions, depending on the configurable operator control 
systems:

● WinCC Basic for configuring Basic Panels
WinCC Basic is included with every STEP 7 Basic and STEP 7 Professional product.

● WinCC Comfort for configuring all panels (including Comfort Panels, Mobile Panels)

● WinCC Advanced for configuring all panels and PCs with the WinCC Runtime Advanced 
visualization software
WinCC Runtime Advanced is a visualization software for PC-based single-station systems. 
WinCC Runtime Advanced can be purchased with licenses for 128, 512, 2k, 4k as well as 
8k PowerTags (tags with a process interface).

● WinCC Professional for configuring panels and PCs with WinCC Runtime Advanced or 
SCADA System WinCC Runtime Professional. WinCC Professional is available in the 
following editions: WinCC Professional for 512 and 4096 PowerTags as well as "WinCC 
Professional max. PowerTags".
WinCC Runtime Professional is a SCADA system for structuring a configuration ranging 
from single-station systems to multi-station systems including standard clients or web 
clients. WinCC Runtime Professional can be purchased with licenses for 128, 512, 2k, 4k, 
8k, and 64k PowerTags (tags with a process interface).

With WinCC (TIA Portal), it is also possible to configure a SINUMERIK PC with WinCC Runtime 
Advanced or WinCC Runtime Professional and HMI devices with SINUMERIK HMI Pro sl RT 
or SINUMERIK Operate WinCC RT Basic.

System overview of STEP 7 and WinCC
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1.2 Options for STEP 7 Engineering System

Additional STEP 7 products
For applications with increased safety requirements, STEP 7 Professional can be extended 
with the STEP 7 Safety option.

When using the STEP 7 Safety option, you can configure failsafe I/O and safety programs for 
F-CPUs in LAD and FBD.

System overview of STEP 7 and WinCC
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1.3 Options for WinCC Engineering and Runtime systems
SIMATIC Panels as well as WinCC Runtime Advanced and WinCC Runtime Professional 
contain all essential functions for operator control and monitoring of machines or plants. 
Additional options allow you to extend the functionality in some cases to increase the range 
of available tasks.

Options for Comfort Panels, Mobile Panels, Multi Panels
The following possible extensions are available for Comfort Panels, Mobile Panels, and Multi 
Panels:

● WinCC SmartServer (remote operation)

● WinCC Audit (audit trail and electronic signature for regulated applications)
 

 Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, WinCC 
flexible /Sm@rtAccess options as well as the WinCC flexible /OPC Server option are 
incorporated into the basic functionality.

 

Options for WinCC Runtime Advanced
The following possible extensions are available for WinCC Runtime Advanced:

● WinCC SmartServer (remote operation)

● WinCC Recipes (recipe system)

● WinCC Logging (logging of process values and alarms)

● WinCC Audit (audit trail for regulated applications)
 

 Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, WinCC 
flexible /Sm@rtAccess options as well as the WinCC flexible /OPC Server option are 
incorporated into the basic functionality.

 

Options for WinCC Runtime Professional
The following possible extensions are available for WinCC Runtime Professional:

● WinCC Client (standard client for structuring multi-station systems)

● WinCC Server (supplements WinCC Runtime to include server functionality)

● WinCC Recipes (recipe system, formerly WinCC /UserArchives)

● WinCC WebNavigator (Web-based operator control and monitoring)

● WinCC DataMonitor (display and evaluation of process states and historical data)

System overview of STEP 7 and WinCC
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 Note

In contrast to WinCC V7, functions from the WinCC /OPC-Server and WinCC /
ConnectivityPack options are incorporated into the basic functionality. Likewise, the basic 
functionality includes the Runtime API from WinCC /ODK.

 

Beyond the Runtime options, WinCC Runtime Advanced and WinCC Runtime Professional 
can be enhanced with customer-specific controls. To develop controls, the WinCC 
ControlDevelopment option is required.
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1.3 Options for WinCC Engineering and Runtime systems

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  33





Readme 2
2.1 General notes

2.1.1 General notes
The information in this readme file supersedes statements made in other documents.

Read the following notes carefully because they include important information for installation 
and use. Read these notes prior to installation.

Functions for S7-1200 as of firmware version V4
In the information system for the TIA Portal V12 SP1, functions are documented for S7-1200 
as of firmware version V4 which are not yet available in the software.

Online operation in hibernate mode
We recommend that you do not use the two options "Hibernate" and "Sleep" in online operation; 
if you do, communication problems could occur. If necessary, adapt the computer's energy 
options.

Opening a project for the first time in TIA Portal V12 SP1
If you are opening your project for the first time in TIA Portal V12 SP1, right-click on the CPUs 
used in the project view and then select "Compile > Software (rebuild all blocks)" from the 
shortcut menu.

Installing new .Net versions or .Net service packs
● Close the TIA Portal before installing a new .Net version or a new .Net service pack on your 

programming device/PC.

● Restart the TIA Portal only after successful installation of the new .Net version or the 
new .Net service pack.

Opening a project in TIA Portal V11
When you open a version V11 project in TIA Portal version 12, you can add components that 
were subsequently supplied for the version V11 within the context of a Hardware Support 
Package (HSP) to the project. The project is then still compatible with TIA Portal version 11. 
If you now open this project in TIA Portal version 11, but this TIA Portal application has not 
been upgraded with the corresponding HSP, the respective component will not be supported 
in the project.
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Notes on handling
● If a project in the list of projects last used is located on a network drive that is not connected, 

you may experience delays when opening the "Project" menu.

● When you insert a CPU, you may need to wait for some time if the project editor is open at 
the same time. This generally takes longer when you insert the first CPU in a newly created 
project. To be able to continue working more quickly, you should close the project editor 
before inserting a CPU.

● The alarm "Application is not responding" may appear in Windows 7 with functions that 
take a long time to run (loading the CPU for example). If this occurs, wait until the function 
has correctly finished.

● If you have installed a Microsoft mouse with IntelliPoint, you may find that it superimposes 
components over the buttons of the title bar. If this is the case, uninstall the IntelliPoint 
software from Microsoft.

● Enabling the "Virtual Desktop" options with NVIDIA graphics cards can cause problems. In 
this case, disable the "nView virtual desktop manager" of your NVIDIA graphics driver.

Using the TIA Portal via a remote desktop
In principle, it is possible to use the TIA Portal via a remote desktop connection. During 
configuration, you should, however, avoid disconnecting the connection to the desktop client. 
In rare cases, this can lead to the software user interface being blocked.

If you experience this blockage, follow these steps on the desktop client.

1. Open the Windows Task-Manager and close the "rdpclip.exe" process.

2. Type in "rdpclip.exe" in the command prompt to restart the process.

Note that the current content of the clipboard will be lost. You can, however, then continue 
configuration as usual. To be on the safe side, you should restart the TIA Portal at the next 
opportunity.

Opening the TIA Portal multiple times
If you are running several applications of the TIA Portal and they continually become active in 
turn, you can briefly switch to another application or use the key combination <ALT+Tab> to 
solve the problem.

Note on SD cards
The SD cards have been formatted and set up by Siemens for use with S7-1200 and S7-1500 
modules. This format must not be overwritten; otherwise, the card will no longer be accepted 
by the modules. Formatting with Windows tools is therefore not permitted.

Behavior in case of open force job
Note that active force jobs is retained even after you have loaded a new project to the SD card. 
This means you should first delete the active force job before you remove an SD card from 
the CPU and before you overwrite the card in the PC with a new project. If you use an SD card 
with unknown content, you should format the SD card before the next download.
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Warnings on memory space with Windows XP (32-bit)
When you work with Windows XP (32-bit) for a long time, a memory space warning may appear 
which prompts you to save the current project and restart the TIA Portal. This can occur 
frequently in the case of an operating system with integrated graphics hardware. Disabling the 
graphics hardware acceleration may reduce the number of warnings. You can find the setting 
for this by clicking on the desktop and selecting "Properties > Settings > Advanced > 
Troubleshoot" by means of the right mouse button. In this dialog, move the "Hardware 
acceleration" slider to the far left (setting "None") and apply this setting.

Problems while shutting down Windows XP
If you experience problems shutting down the computer, make sure that the TIA Portal has 
closed completely.

1. In the shortcut menu, select the Task Manager from the shortcut menu on the Taskbar.

2. If you see the process "Siemens.Automation.ObjectFrame.FileStorage.Server.exe" in the 
"Processes" tab, wait until this process has closed.

3. Then you can shut down the computer.

Subnet addressing for CP 1613 and CP 1623 
CP 1613 and CP 1623 are communication modules with microprocessor. To ensure secure 
management of communication links, these are processed on the module. The protocol stack 
in your PC is used for diagnostic purposes (SNMP, DCP). To allow both protocol stacks (i.e. 
CP 1613/23 Firmware and CP 1613/23 NDIS access) access to the same partners, is 
recommended to place both stacks of a module in the same subnet.

Editing a device IP address
Do not use the address range from 192.168.x.241 to 192.168.x.250 when editing a device IP 
address. If necessary, this address range is automatically assigned by the system to a 
programming device. Depending on the subnet mask, this applies also for all network classes.

Migrating projects with the TIA Portal
After the migration of hardware configurations and program blocks from earlier automation 
solutions, first check the functionality of the migrated project before you use it in productive 
operation.

Working with TeleService
The TS Adapter IE Advanced is not available yet at the start of delivery of the TIA Portal V12 
SP1. Remote connections can only be configured as VPN connections with the TIA Portal V12 
SP1 after the start of delivery of the TS Adapter IE Advanced.
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Working with automatically synchronized network drives
Automatic synchronization after a network interruption can result in current (local) project data 
being stored as a "backup" on the network drive through user interactions. This could cause 
outdated project data to be loaded from the network drive when opening the project. For this 
reason, we do not recommend that you store TIA Portal projects on synchronized network 
drives. 

If, however, you do work on synchronized drives, you can continue working locally in the event 
of a network interruption. In this case, you must always ensure that the TIA Portal application 
is closed while data is synchronized. The synchronization itself must be implemented in such 
a way that the current (local) project data replaces the project data on the network drive. 

Entry of decimal places
With certain Windows language settings, it may occur that the entry of values with a comma 
as decimal place is not recognized (entering "1,23" leads to an error). Instead, use the 
international format ("1.23").

Access protection for memory cards in USB card readers
By improving the security mechanisms for online access and engineering of S7-1500 CPUs, 
the data storage on memory cards has been changed. For this reason, this version of STEP 
7 cannot evaluate the passwords of the configured protection level when reading project data 
from memory cards that is accessed via a USB card reader. The changed behavior affects the 
memory cards for CPUs of the S7-1200/1500 series. Therefore, use physical safeguards to 
protect critical project data on memory cards for these devices.

 

 Note

This restriction is not related to online access to devices or the know-how protection of 
program blocks.

 

Screen display
After long periods of work, it can happen in the case of certain computer configurations with 
Windows XP that parts of the TIA Portal interface are no longer updated. Reducing the graphic 
hardware acceleration can correct this problem. You can find the setting for this by clicking on 
the desktop and selecting "Properties > Settings > Advanced > Troubleshoot" by means of the 
right mouse button. In this dialog, move the "Hardware acceleration" slider to the far left (setting 
"None") and apply this setting.

Information on the TIA Portal in online support
Overview of the most relevant technical information and solutions for the TIA Portal in the 
industry online support.

Internet link: Auto-Hotspot

All information on service and support in the industry online support:

Internet link: Auto-Hotspot
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Here, you can also subscribe to the newsletter that provides you with latest information relating 
to your products.

Starting the TIA Portal
When you start the TIA Portal, Windows attempts to update the Certificate Revocation List 
(CRL) of "windowsupdate.com".

If no Internet connection is available and there are multiple DNS servers, a timeout may occur 
during the start of the TIA Portal.

FAQs on the TIA Portal
FAQs on the TIA Portal are available at http://support.automation.siemens.com. 

2.1.2 Notes on the installation

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Using the same versions of TIA Portal products
The TIA Portal products STEP 7 (incl. PLCSIM), WinCC and Startdrive must be upgraded to 
the same version (V12 SP1). If the versions are different, you will no longer be able to start 
the TIA Portal. Even uninstalling a product will not restore an operational status. Please ensure 
that you have the service packs for these products to hand before you start the installation. 
You can download the service packs from the Internet under http://
support.automation.siemens.com (http://support.automation.siemens.com/WW/llisapi.dll?
aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002).

Target directory of the installation
Do not use any UNICODE characters (for example, Chinese characters) in the installation path.

Use of antivirus programs
During the installation, read and write access to already installed files is necessary. Some 
antivirus programs block this access. We therefore recommend that you disable antivirus 
programs during the installation of the TIA Portal and enable them again afterwards.
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Installation of STEP 7 Basic V12 and STEP 7 Professional V12 under Windows XP with Turkish regional 
and language options

Installation of STEP 7 Basic V12 and STEP 7 Professional V12 under Windows XP may be 
aborted if the regional and language options are set to Turkish. In this case change the regional 
and language options from Turkish to English or German.

1. Open the Control Panel under Windows with one of the following commands:

– "Start > Control Panel" (Start menu under Windows XP)

– "Start > Settings > Control Panel" (classic start menu)

2. Open the "Regional and Language Options".

3. Select the "Regional Options" tab.

4. Under "Standards and formats" select "German" or "English" in the drop-down list.

5. Click "Apply" and confirm with OK.

6. Restart your PC for the setting to become active. Now you can continue with the installation 
of STEP 7 Basic V12 and STEP 7 Professional V12.

7. After installation, you can revert the regional and language settings (as described in steps 
1 to 4) to Turkish.

Compatibility with V11
An empty V11.0.2.5 project with the name "TIA_Portal_Project_V11.0.2.5.ap11" is installed in 
the installation directory under ..\Portal V12\SampleProjects in order to allow TIA Portal V12 
to be opened in compatibility mode V11. This project must be copied to a local directory with 
full access before it can be used. For more information on this, refer to FAQ ID 66027369.

Installation of Startdrive V12
A prerequisite for the installation of Startdrive V12 is that STEP 7 V12 is installed beforehand.

Installation of the SIMATIC USB driver under Windows server 2003 R2 StdE SP2
An operating system alarm relating to the SIMATIC USB driver is issued on the operating 
system Windows Server 2003 R2 StdE SP2. This alarm must be acknowledged with "Yes" as 
soon as possible after the alarm has been issued. The alarm may be in the background and 
therefore may not be immediately visible. After a certain period of time, the setup continues 
with the next component. The SIMATIC USB drivers are then not installed and cannot be used.
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2.2 STEP 7 Basic

2.2.1 Security information

Upgrades and updates
Siemens provides automation and drive products with industrial security functions that support 
the secure operation of plants or machines. They are an important component in a holistic 
industrial security concept. With this in mind, our products undergo continuous development. 
We therefore recommend that you keep yourself informed with respect to our product updates. 
Please find further information and newsletters on this subject at:

http://support.automation.siemens.com (http://support.automation.siemens.com/WW/
llisapi.dll?aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002)

To ensure the secure operation of a plant or machine it is also necessary to take suitable 
preventive action (e.g. cell protection concept) and to integrate the automation and drive 
components into a state-of-the-art holistic industrial security concept for the entire plant or 
machine. Any third-party products that may be in use must also be taken into account. Please 
find further information at:

http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)

Network settings
The following tables show the network settings of each product you need to analyze the 
network security and to configure external firewalls:

STEP 7 Basic
Name Port number Transport 

protocol
Direction Function Description

ALM 4410* TCP Inbound/
outbound

License 
service

This service provides the complete 
functionality for software licenses and is 
used by both the Automation License 
Manager as well as all license-related 
software products.

RFC 1006 102 TCP Outbound S7 
communicatio
n

Communication to the S7 controller via 
Ethernet/PROFINET for programming and 
diagnostic purposes.

DCP --- Ethernet Outbound PROFINET The DCP protocol (Discovery and Basic 
Configuration Protocol) is used by 
PROFINET and provides the basic 
functionality for locating and configuring 
PROFINET devices.
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STEP 7 Basic
SNMP 161 UDP Outbound PROFINET The SNMP client functionality is used by 

STEP 7 to read status information from 
PROFINET devices.

* Default port that can be changed by user configuration

 

WinCC ES Basic (without simulation)
Name Port number Transport 

protocol
Direction Function Description

ALM 4410* TCP Inbound/
outbound

License 
service

This service provides the complete 
functionality for software licenses and is 
used by both the Automation License 
Manager as well as all license-related 
software products.

HMI Load 1033 TCP Outbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

* Default port that can be changed by user configuration

 

Simulation RT Basic
Name Port number Transport 

protocol
Direction Function Description

HMI Load 1033 TCP Inbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

Ethernet/
IP
 

44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

2222 UDP Inbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Modbus 
TCP

502 TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

RFC 1006 102 TCP Outbound S7 channel Communication to the S7 controller via 
Ethernet/PROFINET

Mitsubishi 
MC

5002 TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for 
connections to Mitsubishi PLCs.

2.2.2 Notes on use

Contents
Information that could not be included in the online help and important information about 
product characteristics.
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Online operation
The simultaneous online operation of STEP 7 V5.5 or earlier and STEP 7 Basic V12 has not 
been approved.

Simultaneous online connections on an S7-1200 CPU
It is not possible to establish an online connection from multiple TIA Portal instances 
simultaneously to the same S7-1200 CPU.

Configuring and assigning module parameters
You will find an overview of the modules that can be configured and assigned parameters with 
STEP 7 Basic V12 at http://support.automation.siemens.com (http://
support.automation.siemens.com/WW/view/en/28919804/133000).

Removing/inserting the memory card
After removing or inserting a memory card, always perform a memory reset on the CPU in 
order to restore the CPU to a functional condition.

Removing and inserting Ethernet modules
If Ethernet modules are removed and re-inserted during operation, you must boot the PC; 
otherwise, the "Accessible devices" functionality in STEP 7 or NCM PC will not display all 
devices. While the PC boots, Ethernet modules must be activated.

Notes on the information system
The following function has already been described in the information system, but is not 
available in STEP 7 Basic V12 SP1:

● Loading hardware configurations from the target system to the PG/PC.

Comparing project data
The comparison functions (online/offline, offline/offline) currently do not take hardware into 
consideration.

Loading project data with TIA Portal V11 and V12 (S7-1200) 
If you load the project data of an S7-1200 CPU with the TIA Portal V12, you can no longer use 
TIA Portal V11 to access this data. To do this, first restore the factory settings of the CPU. 
Read the additional information on this in the online help under "How to reset a CPU to factory 
settings".
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Activating ENO enable output
As of STEP 7 TIA Portal V12.0, the ENO enable output is disabled by default in the 
programming languages LAD and FBD and the ENO parameter is shown grayed out. If needed, 
you can activate the enable output and thereby specifically control the instructions for which 
you want to have error evaluation.

To activate the ENO enable output of an instruction, follow these steps:

1. In your program, right-click the instruction for which you want to activate the ENO enable 
output.

2. Select the "Generate ENO" command from the shortcut menu.
The ENO value is generated for the instruction and the color of the ENO parameter changes 
from gray to black.
Additional instructions are inserted with the enable output.

Compatibility
The device configuration and program of an S7-1200 CPU must always be configured with the 
same STEP 7 version. Usually, the TIA Portal makes sure that no version conflicts occur by 
outputting appropriate notifications during loading to the device.

This automatic verification is not possible with S7-1200 CPUs with firmware version V1.x. In 
this case, users themselves must ensure that no version conflicts occur.

2.2.3 Editing devices and networks

2.2.3.1 General information on devices and networks

Contents 
Currently, there is no general information available on devices and networks.

2.2.3.2 Use of modules on the S7-1200

Contents
Information that could not be included in the online help and important information about 
product characteristics.
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Use of modules on the S7-1200
The modules listed below are not supported on the S7-1200.

Family Module Order number
S7-300 FMs SM 338 6ES7 338-4BC01-0AB0

FM 350-1 6ES7 350-1AH03-0AE0
FM 350-2 6ES7 350-2AH00-0AE0, 6ES7 350-2AH01-0AE0
FM 351 6ES7 351-1AH01-0AE0, 6ES7 351-1AH02-0AE0
FM 352 6ES7 352-1AH02-0AE0
FM 355 S 6ES7 355-1VH10-0AE0
FM 355 C 6ES7 355-0VH10-0AE0
FM 355-2 C 6ES7 355-2CH00-0AE0
FM 355-2 S 6ES7 355-2SH00-0AE0

S7-300 PtP-CP CP 340 6ES7 340-1AH02-0AE0, 6ES7 340-1BH02-0AE0, 6ES7 
340-1CH02-0AE0

CP 341 6ES7 341-1AH01-0AE0, 6ES7 341-1AH02-0AE0, 6ES7 
341-1BH01-0AE0, 6ES7 341-1BH02-0AE0, 6ES7 
341-1CH01-0AE0, 6ES7 341-1CH02-0AE0

Network component Diagnostics repeater 6ES7 972-0AB01-0XA0
ET 200S 1 Count 24 V 6ES7 138-4DA04-0AB0

1 Count 5 V 6ES7 138-4DE02-0AB0
1 Step 5 V 6ES7 138-4DC00-0AB0, 6ES7 138-4DC01-0AB0
2 pulses 6ES7 138-4DD00-0AB0, 6ES7 138-4DD01-0AB0
1 SI 6ES7 138-4DF01-0AB0
1 SI Modbus 6ES7 138-4DF11-0AB0
1 SSI 6ES7 138-4DB02-0AB0, 6ES7 138-4DB03-0AB0
1 Pos Universal 6ES7 138-4DL00-0AB0
SIWAREX 7MH4910-0AA01, 7MH4912-0AA01, 7MH4920-0AA01

ET 200M SIWAREX 7MH4 900-2AA01, 7MH4 900-3AA01, 7MH4 950-1AA01, 
7MH4 950-2AA01

2.2.3.3 Replacing ET 200S positioning modules

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Replacing ET 200S positioning modules
This information relates to the positioning module "1 Step 5V" (6ES7 138-4DC00-0AB0) from 
a project which was created with TIA Portal V11.0. When replacing these modules from the 
TIA Portal V11.0 with a new version of these modules, the parameter settings are reset to the 
default values.

Readme
2.2 STEP 7 Basic

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  45



This is the case with one of the following procedures:

● Replace the positioning module 6ES7 138-4DC00-0AB0 with its successor module 6ES7 
138-4DC01-0AB0 by means of a device exchange.

● Updating the module version using the appropriate button in the device properties in the 
Inspector window.

2.2.3.4 CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX

Contents
Information that could not be included in the online help and important information about 
product characteristics.

CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX
The module AS-Interface CP 343-2 (order no.: 6GK7 343-2AH01) can be inserted in an 
expansion rack of the SIMATIC S7 Embedded Controller EC31-RTX (order no.: 6ES7 
677-1DDxx-0BB0), but the CP 343-2 cannot be operated with the EC31-RTX.

2.2.3.5 Notes on online and diagnostics

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Hardware detection followed by online connection
When the "Online > Hardware detection" command is performed for an unspecified CPU, the 
online configuration is not loaded from the CPU. If you do not load the configuration resulting 
from the hardware detection to the CPU, the device and network views will always show a 
difference between the offline and online configurations. It will appear that there are different 
configurations in the online and diagnostic views, although the MLFBs are identical in the actual 
CPU and the offline CPU.
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2.2.3.6 Network components

Network components

CP 1242-7

Copying the CP 1242-7 into another project
If you copy a CP 1242-7 from one project into another project, the following parameters in the 
parameter group "CP identification" are changed on the target station:

● Project number of the CP

● Station number of the CP

Download to device
Only use the "Download to device" function with the CP 1242‑7 via a TeleService connection 
as follows:

1. Select the CP in STEP 7.

2. Select the "Online" > "Download to device" menu.

3. In the "Extended download" dialog that appears, select the TeleService interface.

4. Download the project data from the "Extended download" dialog.

Upload from device
The function "Upload from device" is not supported by the CP 1242‑7.

SCALANCE X

SCALANCE XR500 as IO device: "Compile" and "Download to device"
With a SCALANCE XR500 configured as a PROFINET IO device and assigned to an IO 
controller, the functions "Compile" and "Download to device" only download the data to the 
switch that can also be configured in Web Based Management (WBM) (layer 2, layer 3, system, 
security).

If you want to use the "Compile" or "Download to device" functions for the PROFINET IO device 
data of the XR500, first select the assigned IO controller.
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Using a link aggregation in an MSTP instance
If you want to use a link aggregation in an MSTP instance, follow the steps below during 
configuration:

1. Create a link aggregation in "Layer 2" > "Link Aggregation".

2. Create an MSTP instance in in "Layer 2" > "MSTP" > "MST General".

3. Configure the link aggregation in "Layer 2" > "MSTP" > "MST Port".

Automatic activation of MRP in redundant topologies
If you connect SCALANCE X switches with redundant network structures in the topology view, 
MRP is activated automatically on the switches involved.

If there is an existing configuration with other redundancy mechanisms, such as MSTP, this 
is automatically deactivated.

2.2.4 Programming a PLC

2.2.4.1 General notes on PLC programming

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Loading inconsistent programs to a device
In TIA Portal, it is not possible to download inconsistent programs to a device without a 
consistency check. During the loading process, all blocks of the program are implicitly checked 
and are compiled again in the event of inconsistencies. If, however, there are programs on 
your CPU which were loaded with earlier versions of STEP 7, these programs could 
demonstrate inconsistencies. 

In this case, note the following:

If you load an inconsistent program from a device, you will not be able to load the program 
unchanged to the device afterwards, because a consistency check always takes place during 
the loading process and existing inconsistencies are corrected.

Process image of PTO/PWM outputs
Do not use PTO/PWM outputs in the process image (for example, for access in the user 
program, for online functions or in HMI). The update rate of the process image is much slower 
than the rate of the signal changes. The display in the process image therefore does not reflect 
the signal flow.
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Monitoring blocks in LAD and FBD
If the start of the current path is outside the visible range, it may not be possible to determine 
the input value. In this case, the current path is shown grayed out.

Avoid using PLC data types generated by the system in libraries
Some instructions generate their own PLC data types during instancing which are saved in 
the "PLC data types" project folder. However, you should not use these system-generated 
PLC data types in any library, because they may be recreated by the system at any time and 
may result in an unfavorable system behavior. 

Using global data blocks in assignments
It is not possible to assign the contents of a global data block to a structurally identical data 
block, e.g. using a move box.

Conversion of know-how protected blocks from V10.5
The program must be compiled after conversion from previous STEP 7 versions (e.g., STEP 
7 V10.5). If you are using know-how protected blocks, you are prompted to enter the password.

2.2.4.2 Instructions

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Use of instructions (S7-1200)
If a parameter-specific error occurs with instructions which represent a system function (SFC) 
or system function block (SFB), no error code is output at parameter RET_VAL. RET_VAL is 
invalid in this case. You have a number of different options for responding to these errors, 
depending on the CPU used.

Instruction "TRCV_C: Receive data via Ethernet" 
Contrary to the information provided in the online help, the communication connection is 
terminated immediately, and not after sending data, when the CONT parameter is set to the 
value "0".

Instruction "T_CONFIG: Configure interface" 
The CPU is restarted after you have executed the "Configure interface" instruction in order to 
change an IP parameter. The CPU goes to STOP mode, a warm restart is carried out and the 
CPU starts up again (RUN mode). Make sure that the control process is in a secure operating 
mode after the CPU has been restarted following execution of the "Configure interface" 
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instruction. Uncontrolled operation can result in serious material damage or personal injury 
due to malfunctions or programming errors, for example. Non-retentive data could be lost.

Parameters ERROR and STATUS

ERROR STATUS
(DW#16#..)

ERR_LOC Explanation

0 00000000 0 After the instruction has been 
executed successfully, the 
STATUS parameter 
"00000000" does not return 
any value.

Instruction "GET_DIAG: Read diagnostics information"
MODE 3 at the MODE parameter is not supported by the S7-1200 CPU.

Using instructions with parameters of type VARIANT in code blocks with different access types 
(S7-1200)

Code blocks (FBs/FCs) and data blocks (DBs) can be created with different access types 
("standard" and "optimized"). In code blocks, you can call any instructions. Certain instructions 
(for example, "WRIT_DBL" and "READ_DBL") use pointers of type VARIANT at input and 
output parameters to address data blocks.

Ensure that you do not use these instructions in programs in which code blocks of different 
access types are called reciprocally. This could cause the following to occur:

● A structure from a standard data block is directly or indirectly passed to an optimized code 
block, which forwards this structure directly or indirectly to one of the blocks mentioned 
above.

● The reverse scenario, whereby a structure from an optimized code block is directly or 
indirectly passed to a standard data block, which forwards this structure directly or indirectly 
to one of the blocks mentioned above.

2.2.4.3 Testing the user program

Testing with the watch table

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Multiple access to the same CPU
Access to a CPU from a PG/PC is permitted only when a TIA Portal is open. Multiple access 
to the same CPU is not permitted and can lead to errors.
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Loading data blocks during an active control job
 

 Note

Loading changed data blocks during an active control job can result in unforeseen operating 
states. The control job continues to control the specified address, although the address 
allocation may have changed in the data block. Complete active control jobs before loading 
data blocks.

 

Testing programs converted from STEP 7 V10.5.
To monitor and test a program converted from STEP 7 V10.5, you have to first compile and 
load with STEP 7 V11.0.

"Enable peripheral outputs" function
In TIA Portal V12.0, the function "Enable peripheral outputs" is not available for CPUs from 
the S7-1500 series.
This function can only be carried out with an S7-300, S7-400 or S7-1200 CPU in TIA Portal 
V12.0. 

Testing with the force table

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Forcing tags for direct I/O access
If you use direct I/O access for an S7-300 CPU in your user program, forcing this I/O address 
is not permitted.

Example
If I/O access to the address "IB0:P" takes place in the user program, it is not permitted to force 
the following I/O address areas: I0.0:P, IB0:P, IW0:P and ID0:P.

2.2.5 Technological functions

2.2.5.1 Notes on technological functions
There are no notes about the technology functions.
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2.3 WinCC Advanced

2.3.1 Security information

Security information
Siemens provides automation and drive products with industrial security functions that support 
the secure operation of plants or machines. They are an important component in a holistic 
industrial security concept. With this in mind, our products undergo continuous development. 
We therefore recommend that you keep yourself informed with respect to our product updates. 
Please find further information and newsletters on this subject at:

http://support.automation.siemens.com (http://support.automation.siemens.com)

To ensure the secure operation of a plant or machine it is also necessary to take suitable 
preventive action (e.g. cell protection concept) and to integrate the automation and drive 
components into a state-of-the-art holistic industrial security concept for the entire plant or 
machine. Any third-party products that may be in use must also be taken into account. Please 
find further information at:

http://www.siemens.com/industrialsecurity (http://support.automation.siemens.com) 

Passwords
Various passwords are set by default in WinCC. For security reasons, you should change 
these passwords.

● The default password for the Sm@rtServer and for the integrated Web server is "100".

● For the user "Administrator", the default password is "administrator".

Integrated Web server
It is always possible on a PC to access HTML pages in Runtime, even though the option"HTML 
pages" is disabled. Setup always installs the standard pages of the Web Server on the PC. 
Assign an administrator password to prevent unauthorized access to the pages.

Communication via Ethernet
In Ethernet-based communication, end users themselves are responsible for the security of 
their data network. The proper functioning of the device cannot be guaranteed in all 
circumstances; targeted attacks, for example, can lead to overload of the device.

Ending Runtime automatically
If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.
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After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.

Network settings
The following tables show the network settings of each product which you need in order to 
analyze the network security and for the configuration of external firewalls:

WinCC Advanced (without simulation)
Name Port 

number
Transport 
protocol

Direction Function Description

ALM 4410* TCP Inbound, 
Outbound

License service This service provides the complete 
functionality for software licenses and is used 
by both the Automation License Manager as 
well as all license-related software products.

HMI Load 1033 TCP Outbound HMI Load 
(RT Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

HMI Load 2308 TCP Outbound HMI Load 
(RT Advanced)

This service is used to transmit images and 
configuration data to Panels.

* Default port that can be changed by user configuration

 

WinCC Simulation for Basic Panels
Name Port 

number
Transport 
protocol

Direction Function Description

HMI Load 1033 TCP Inbound HMI Load 
(RT Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

EtherNet/IP 44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

2222 UDP Inbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Modbus TCP 502 TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET

Mitsubishi MC 5002 TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for connections 
to Mitsubishi PLCs.
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WinCC Simulation for Panels and Runtime Advanced
Name Port 

number
Transport 
protocol

Direction Function Description

DCP --- Ethernet Outbound PROFINET The DCP protocol (Discovery and Basic 
Configuration Protocol) is used by PROFINET 
and provides the basic functionality for locating 
and configuring PROFINET devices.

LLDP --- Ethernet Inbound, 
Outbound

PROFINET The LLDP protocol (Link Layer Discover 
Protocol) is used by PROFINET for topology 
detection.

SMTP 25 TCP Outbound SMTP 
Communication

This service is used by WinCC Runtime 
Advanced to send e-mails.

HTTP 80* TCP Inbound Sm@rtServer The Web server is only available when 
Sm@rtService is activated. The used port may 
differ depending on automatically selected 
settings.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET

NTP 123 UDP Outbound Time-of-day 
synchronization

The NTP protocol (Network Time Protocol) is 
used for time-of-day synchronization in IP-
based networks.

SNMP 161 UDP Outbound PROFINET The SNMP client functionality is used by STEP 
7 to read status information from PROFINET 
devices.

HMI Load 2308 TCP Outbound HMI Load 
(RT Advanced)

This service is used to transmit images and 
configuration data to Panels.

HTTPS 443* TCP Inbound Sm@rtServer The Web server with HTTPS protocol is only 
available when Sm@rtService is activated. 
The used port may differ depending on 
automatically selected settings.

VNC server 5900* TCP Inbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

5800* TCP Inbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

VNC client 5500 TCP Outbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

* Default port that can be changed by user configuration

See also
http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)
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2.3.2 Notes on use

Contents
Information that could not be included in the online help and important information about 
product features.

Copying HMI devices with HMI connections
If you copy an HMI device with HMI connections to a PLC, the HMI connection in the new HMI 
device is not automatically connected to an existing PLC with the same name. This applies to 
copying within a project as well as copying across projects.     

To access the PLC tag via HMI tag in the new HMI device, you have to complete the HMI 
configuration immediately after copying. Proceed as follows:

1. Open the "Devices & Networks" editor.

2. Connect the new HMI device to the desired network.

3. Open the connection table.

4. Select the HMI connection of the new HMI device.

5. Select the desired PLC under "Partner".

If you compile the new HMI device or connect additional PLC tags in between copying the HMI 
device and completing the connection, there may be some instances in which an additional 
HMI connection to the same PLC is created. This is especially true if you connect HMI tags 
with DB array elements.

Device replacement
After an HMI device has been replaced, you should check the appearance of the configured 
screens. Changing the size of the display may result in changes to the position and appearance 
of screen objects, e.g. recipe view and alarm view.

Device replacement - communication
If an HMI device is replaced, error messages of the type "... is not supported in the new 
configuration and will therefore be removed" may be generated. These alarms refer to 
configured connections of the device and are triggered, for example, if the HMI devices have 
a different number of interfaces. These connections are marked red after a device replacement. 
If you would like to continue to use these connections, you have change the configuration of 
the connection. Proceed as follows:   

1. Open the "Devices and Networks" editor.

2. Click "Network" in the toolbar of the network view.

3. Network the interface of the HMI device with the interface of the CPU.

4. Click in the table area of the network view on the "Connections" table.
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5. Select the connection marked red.

6. Enter the new interface under "Properties > General > Interface" in the Inspector window.

Specifying the time of modification in the overview window
The times of modification displayed in the overview window only refer to changes to the object 
itself. Changes to subordinate objects, e.g. screen objects in a screen, do not cause the time 
of the last change to the screen to change in the overview window.   

HMI device wizard
When you create a device with a color display using the HMI device wizard, the graphics of 
the navigation buttons may be displayed in black and white. This error only occurs, however, 
if the new device is created with the same name as a device with a monochrome display which 
has been deleted in the meantime.

You can avoid this error by always deleting the associated graphics in the Graphics collection 
whenever you delete a device from the project.

Objects with object references in the project library
Two copying methods can be used in WinCC flexible.   

● With "simple copy" a WinCC flexible screen including an IO field, for example is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. With regard to tags, it functions like 
"simple copy" in WinCC flexible. With regard to graphics, graphics lists and text lists, it functions 
like "copy" in WinCC flexible.

If you stored objects with references to tags in a library in WinCC flexible, you must reconfigure 
the referenced objects when using them in WinCC.

Reports with Asian character sets on Windows CE devices
If Asian characters sets are displayed in an illegible manner in a report on a Windows CE 
device, you must change the character sets for the objects in the report. it is sufficient to change 
to a different character set and then reset the original character set.

License transfer via S7USB
You always need to run WinCC to transfer a license to a panel via S7USB.
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Transferring licenses to a panel on 64-bit operating systems
If you are running a 64-bit operating system and the "Edit > Connect target systems > Connect 
HMI device" menu command is not available in Automation License Manager, open command 
line input and run the following command with administrator rights:

"%WINDIR%\system32\RegSvr32.exe" "%CommonProgramFiles%\siemens\AlmPanelPlugin
\ALMPanelParam.dll"

Installation sequence for Startdrive
When you install Startdrive on a PC, adhere to the following installation sequence:

● Install STEP7 V12.0.

● Install Startdrive.

SIMOTION
SIMOTION is not supported with WinCC V12 SP1.

Security settings during installation
When you install WinCC V12, security settings are changed in your operating system. 

The security settings in question are listed during the installation. 

You must confirm the changes to the security settings.

If you make changes to your operating system after the installation, the changes to the security 
settings made by the installation of the TIA Portal could be changed.

You can restore the changes to the security settings made by the installation of the TIA Portal:

"Start > All Programs > Siemens Automation > Security Controller > Restore settings"

SQL instance of WinCC V12
If you have installed a WinCC V11 product and you wish to install a WinCC V12 product, you 
must uninstall all WinCC V11 products and the WinCC instance of SQL Server 2005 one after 
the other before the installation.

A new WinCC SQL 2008 instance is installed with the installation of WinCC V12.

2.3.3 Migration

Contents
Information that could not be included in the online help and important information about 
product features.
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Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:

WinCC flexible WinCC
Error Errors
System System
Warnings Warnings

The display names of the alarm classes can be changed as necessary after migration.

Project languages in WinCC
WinCC V12 does not support all project languages that were available in WinCC flexible, such 
as Arabic. If you receive an empty project as the result of your migration, you may want to 
check the set editing language. Do not set the project languages that are not supported as 
editing language in the source project. Proceed as follows:

1. Open the project with WinCC flexible.

2. Change the editing language to English, for example.

3. Save the project.

4. Restart the migration.

Objects with object references in the project library
Two copying methods can be used in WinCC flexible. 

● With "simple copy", a WinCC flexible screen including an IO field, for example, is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. It functions like "simple copy" in 
WinCC flexible.

If you have stored objects with references to other objects in a library in WinCC flexible, you 
must reconfigure the referenced objects when using them in WinCC.

Migrating an integrated project with ProTool objects
The "PROTOOL option package(s) missing in STEP 7" error message output during migration 
of a WinCC flexible project that is integrated in STEP 7 indicates that WinCC flexible 2008 
SP3 is installed on your system. Moreover, the project still contains objects that were 
configured using ProTool. Do not open the project with WinCC flexible 2008 SP3! Proceed as 
follows to migrate the project:
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1. Copy the project to a computer on which WinCC flexible 2008 SP2 and STEP 7 are installed.

2. Open the project in the SIMATIC Manager.

3. Remove all ProTool objects from the project.

4. Execute the "Save as" command in the "File" menu.

5. Activate the option "With reorganization" in the "Save project as" dialog.

6. Click OK.

7. Copy the project back to the original computer.

8. Restart the migration.

Migrating a WinCC V7 project with "Chinese (Taiwan)" Runtime language
If your WinCC is installed with support for the "Chinese" user interface language, the texts and 
report layouts of the "Chinese (Taiwan)" Runtime language will not be included when you 
migrate WinCC V7 projects. Migrate such projects using the Migration Tool, or a PC that 
contains a WinCC setup without "Chinese" user interface language.

Progress bar
As long as the progress bar still shows a value of 100 %, the software is still busy running 
remaining tasks such as the closing of references. The software will not respond to user input 
while this status is given.

Principle
When you open a V11 project with a V12 version, it will no longer be possible to open this 
project with an older version afterwards.

Managing third-party ActiveX controls
The migration also supports third-party ActiveX controls. However, the controls must be 
registered in the operating system. If an ActiveX control is not registered, migration is canceled.

If you save a project with the migration tool and perform the migration yourself on another PC, 
the controls must also be registered on this PC.

Language switching in RT
Upgrading the project from V11 to V12 and migration of WinCC V7.0 SP3 to V12: 

If you have used a script to program a language change to Chinese (PRC) in V11 or V7.0 SP3 
with LCID, language switching to Chinese (PRC) in runtime no longer works after upgrading 
or migrating.

Change the LCID in script from "1028" to "2052".
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Migrating integrated projects with alarm views 
An alarm view is enabled with all alarm classes in an integrated project. The alarm classes are 
disabled during migration of the project.
Once the migration of the project is completed, check the settings in the alarm view. 
Enable the require alarm classes in the Inspector window of the alarm view if needed under 
"Properties > General".

Migrating projects from WinCC V7
We recommend a 64-bit operating system for the migration of extensive projects from WinCC 
V7.0 SP3.

See also
Object support during migration

2.3.4 Special considerations for Windows 7

Contents 
Information that could not be included in the online help and important information about 
product characteristics.

Permission for the starting Runtime
To start WinCC Runtime Professional or WinCC Runtime Advanced, a user must be a member 
of the automatically created group, "Siemens TIA Engineer". 

Working with standard user rights 
If you are working with standard user rights in Windows 7, "User Account Control (UAC)" cannot 
be disabled.

The "User Account Control" is enabled in Windows 7 by default.

For more information on the "User Account Control, refer to the online help for Windows 7.

Slow response from the screen keyboard and SmartServer
The following programs may start and respond very slowly under Windows 7 and Windows 
2008 servers:

● Microsoft OSK screen keyboard and HMI TouchInputPC

● SmartServer: <Ctrl+Alt+Del> shortcut in the logon dialog

The delay is caused by the callback for the Internet certificate validation.

Remedy:
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You can find the following files
on the product DVD under:
Support\Windows7\CRL_Check or CD_RT\ Support\Windows7\CRL_Check\:

● DisableCRLCheck_LocalSystem.cmd

● DisableCRLCheck_CurrentUser.cmd

1. Run the "DisableCRLCheck_LocalSystem.cmd" file with administrator rights. Select the 
command "Run as administrator" from the shortcut menu of the file.

2. Reboot the PC.

If the problem persists, follow these steps:

1. Double-click the file and run the "DisableCRLCheck_CurrentUser.cmd" file with user rights.

2. Reboot the PC.
 

  Note

The callback for the certificate validation is disabled for all users or PCs. To restore the 
original state, perform the following files:
● RestoreDefaults_LocalSystem.cmd
● RestoreDefaults_CurrentUser.cmd

You can find the files in the following directory of product DVD:
● Support\Windows7\CRL_Check or CD_RT\Support\Windows7\CRL_Check\

 

On-screen keyboard
Once you have opened the TIA Portal, you can no longer call the on-screen keyboard.

To call the on-screen keyboard in Windows, use the following command: "Start > All Programs 
> Accessories > Ease of access > On-screen keyboard".

2.3.5 Engineering System

2.3.5.1 Screens and Screen Objects

Contents
Information that could not be included in the online help and important information about 
product features.

Text format of output fields in alarm text
It is not possible to underline tags and text list entries.
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Copying display objects between two projects or two devices
In Project_1 configure an alarm window in the Global Screen, for example. You copy the alarm 
window and paste it in the Global Screen in Project_2.             

The enabled alarm classes are partly not enabled in the alarm window after pasting.

This behavior applies to the following display objects:

● Alarm window

● Alarm indicator

● Alarm view

Representation of the cross-references in the Inspector window
The Inspector window displays objects used by a screen object in the "About > Cross-
reference" tab.

A screen is open and an object selected. You are using an HMI tag at the object as process 
tag.

The object and the linked HMI tag are displayed in the cross-references. All locations of use 
of the object and the HMI tags are listed.

If the HMI tag is interconnected with a PLC tag or a DB tag, then the locations of use of the 
interconnected PLC tag or DB tag will be displayed.     

Event names in case of alarms in the "Info" tab of the Inspector window
In some alarms of the Inspector window the event names in the "Info" tab will deviate from the 
names in the "Properties" tab.       

Name in the "Properties" tab of the Inspector 
window

Name in the "Info" tab of the Inspector window

Cleared ClearScreen
Loaded GenerateScreen
Enable Activate
Change Change
When a dialog is opened ONMODALBEGIN
When a dialog is closed ONMODALEND
User change PASSWORD
Screen change SCREEN
Disable Deactivate
Press Press
Outgoing Going
Incoming Coming
Limit "high limit error" violated AboveUpperLimit
Limit "low limit error" violated BelowLowerLimit
Click Click
Loop-In-Alarm LoopInAlarm
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Name in the "Properties" tab of the Inspector 
window

Name in the "Info" tab of the Inspector window

Release Release
Alarm buffer overflow OVERFLOW
Acknowledge Acknowledgement
Runtime stop Shutdown
Press key KeyDown
Release key KeyUp
Switch ON SwitchOn
Switch OFF SwitchOff
Value change Change value

Dynamization of object properties in a group
The dynamization of properties for all objects of the group which have these properties is not 
possible in a group. In WinCC V12, the properties of the objects belong to a group can only 
be dynamized for each object itself. 

Illegible characters in Runtime Professional
With Runtime Professional, only characters belonging to the language area which is defined 
with the operating system setting "Language for non-Unicode programs" can be displayed on 
the target system. Texts with characters from other language areas can, however, also be 
configured in the project.

Illegible characters may occur in the Engineering System with the objects text field, symbolic 
I/O field, gauge and slider if the settings in the operating system relating to "Language for non-
Unicode programs" do not match the selected editing language and the objects are displayed 
in a different design than "WinCC Classic". The characters are displayed correctly in the 
Inspector window and the "Project texts" editor.

Therefore, first check in the Control Panel under "Regional and Language Options > Advanced" 
whether the setting for "Language for non-Unicode programs" is the same as the editing 
language. Otherwise, you can check or change the correct texts in the Inspector window or 
the "Project texts" editor.

Faceplates
Faceplates cannot be rotated or mirrored.

Persistence with display objects in WinCC Runtime Professional
The objects f(t)-trend view, f(x)-trend view, alarm view, recipe view, table view and value table 
have settings for the persistence of online configurations. If you have configured "Persistence" 
for "Online configuration" and "Keep changes" for "Reaction to screen change", you can make 
changes to the configuration dialogs in runtime which will be retained after a screen change 
and after runtime is exited.
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However, online configurations for the settings mentioned cause changes to the configuration 
of the objects in the Engineering System to only be applied in Runtime if you recompile the 
device with the command "Compile > Software (rebuild all)".

Basic Panels, OP73, OP77A and TP177A: Displaying texts in runtime 
The default font selected in the "Runtime settings > Languages & font" editor has an effect on 
the display of texts in runtime. 

Text entries may be truncated if you selected an unfavorable font size or style.

This setting possibly has an effect on the following text entries:

● Tooltips

● long alarm text

● text in the dialogs

Tab sequence in screens with faceplates
If you configured a tab sequence in screens with faceplates in WinCC V12 or WinCC V12 SP1, 
you should check the tab sequence of these screens in WinCC V12 SP2. The tab sequence 
may have been changed in both the screen and the faceplate.

Tag prefix of a screen window in WinCC Runtime Professional
The objects of the "Controls" palette do not support the tag prefix that can be configured for a 
screen window.

I/O field with "decimal" display format and format pattern without "s" prefix
You have linked a process tag to an I/O field. The I/O field is assigned the "decimal" display 
format.     

You may select a signed or an unsigned display format.

A "Format pattern" setting without "s", e.g. "999" has the following effects:

1. You cannot set negative values using the I/O field in Runtime.

2. If the tag assumes a negative value, the I/O field generates a two's complement and a 
corrupted positive value is output.

Trend view on Basic Panels
The trend view buttons are not displayed on Basic Panels. You can operate the trend view 
using the function keys of the HMI device that are assigned corresponding system functions.

Displaying controls in protocols
A project with WinCC V11 SP2 with Update 4 or earlier is upgraded to WinCC V12.

In this process, it may happen that archive data is not displayed in controls for protocols.
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The following controls are affected:

● f(t) trend view

● f(x) trend view

● Table view

Remedial measures for f(t) trend view and f(x) trend view

1. In the control, select "Properties > Properties > General > Display > Online". 

2. Recompile your project.

3. Load the project onto your HMI device.

Remedial measures for Table view:

1. In the control, select "Properties > Properties > General > Upon opening screen > Start 
update". 

2. Recompile your project.

3. Load the project onto your HMI device.

Grouping of screen objects
When you group screen objects in WinCC, performance problems can arise in WinCC in the 
case of large nesting depths.

Status/Force
The "Status/Force" screen object is enabled for the following controllers:

● SIMATIC S7-300

● SIMATIC S7-400

ActiveX and .NET controls
ActiveX and .NET controls are always positioned in the foreground in runtime. 

The configuration of ActiveX and .NET controls on levels is not supported.

Frame line of rectangles
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1" 
and "Draw insider border = yes".

You then migrate the WinCC V7 project to WinCC V12.  To have the rectangle displayed 
correctly, proceed as follows. 

1. Open the Inspector window of the rectangle.

2. Open the property list.

3. Disable "Widen border line inwards".
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Graphics in faceplates
You have added a graphic display in a faceplate and defined the "Graphic" property as the 
interface of the faceplate. The "Graphic" property can now be made dynamic using the interface 
of the faceplate instance.
Use the following notation to address the property with a screen via a script:
"..\\..\\screen name".

Assigning dynamic properties to instances of a faceplate type in a group
You can assign dynamic properties to instances of a faceplate type in an object group. The 
properties of an instance are also displayed as properties of a group. The individual 
dynamization processes with tags, scripts or animations of a group are not displayed in 
Runtime.

System diagnostics indicator for RT Advanced
You can find the library object "Diagnostics indicator" in the library "Buttons and Switches > 
DiagnosticsButtons (Comfort Panels)". The object can also be used for devices with RT 
Advanced.

Preview in screen window
You use your own designs with shadow for screen objects. The can display the screen objects 
in a screen window.
The shadows of the screen objects are not displayed in the preview of the screen window. The 
response occurs only in the Engineering System. It is displayed correctly in Runtime.

2.3.5.2 Tags and connections

Contents
Information that could not be included in the online help and important information about 
product features.

Tag names
HMI tag names may not start with the character @.

Display of deleted array elements at location of use of HMI tags
The locations of use of HMI tags, such as the process value of IO fields, are usually indicated 
by the tag name. If the element of an array tag is used, then the tag name will be extended by 
the index of the array element indicated in brackets.

If a used tag is no longer included in the project, then the tag name will still be displayed at the 
location of use. The field will be displayed with a red background to indicate the missing tag. 
If a used array element or the array tag is no longer present, then only the index of the array 
element will be displayed in brackets. The tag name will not be displayed. The field is 
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highlighted in red. You can no longer identify the name of the associated array tag based on 
the location of use in this instance.

If you do not know which array tag was linked to this location of use, then it may be necessary 
to link the array element once again.

If a tag or array tag was created based on a reference, then the selected reference will be 
closed automatically.

If an HMI tag is connected with an array element of a PLC tag and the PLC tag does no longer 
exist in the project, then the same behavior will take place in the "HMI tags" editor.       

Array tags as list entry of multiplex tags
You can use the array tags of the Char data type just like the tags of the String data type.       

The use of an array tag of the Char data type as list entry of a multiplex tag in the "HMI 
tags" editor is not supported. 

Multiplexing tags on a Basic Panel
If you multiplex a tag with an external tag on a Basic Panel, the address is read from the PLC 
in runtime during the first read cycle. The value of the address read is not available until the 
second read cycle.

Runtime Advanced and Panels: Importing array elements and structure elements
Array tags and structure tags are always imported in full with all elements. The elements of 
the array tags and structure tags are not filled further during import.

A new tag is created if the name of a tag corresponds to the name of an array or structure 
element in the import file.

Example:

The import file contains an array tag called "Otto" with 10 array elements. The array elements 
are then called Otto[1], Otto[2], for example.

If the import file contains a tag called "Otto[1]", the first element of the array tag will not be 
filled. Instead, a new tag will be created in the Engineering System.

Local ID of HMI connections
You cannot edit the "Local ID" value in the HMI connection properties. You need the local ID, 
for example, for communication by way of AR_SEND. To enable usage of the "Local ID" for 
communication, proceed as follows:

1. Open the network view in the "Devices & Networks" editor.

2. Click "Connections".

3. Select an S7 connection.

4. Select the "Add new connection" command in the shortcut menu of the PLC.

5. Click on the interface.
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6. Specify the "Local ID (hex)".

7. Click "Add" and then "Close".

8. Select "Properties > General" from the partner area of the Inspector window and enter the 
IP address of the HMI device for the new connection.

9. Configure the necessary raw data tags for communication in the HMI device.

Tags with the DTL data type
Tags that use the "DTL" data type element by element, can only be used as read-only.

2.3.5.3 Alarm system and alarm displays

Contents
Information that could not be included in the online help and important information about 
product properties.

Displaying special characters in alarm texts
When configuring alarm texts, a fixed character set is used in the Engineering System. This 
character set allows you to use numerous special characters in alarm texts.     

Language-dependent fonts are used in runtime to display the texts, for example MS PGothic, 
SimSun. The fonts used in runtime do not support all special characters. As a result, some 
special characters are not displayed in runtime.

Use of multiplex tags in output boxes with alarm texts
It is also possible to use multiplex tags in the output boxes of alarm texts in the engineering 
system. During runtime, this leads to an incorrect display of the alarm, because the use of 
multiplex tags is not supported by the basic panels.     

Parameters in user alarms
Contrary to the information in the online help, it is not possible to configure parameters for user 
alarms.
The menu command "Properties > Properties > Alarm parameters" is not available in the 
Inspector window.

2.3.5.4 System functions and scripts

Contents
Information that could not be included in the online help and important information about 
product features.
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SmartTag object in user-defined VB functions for Runtime Professional
With the "SmartTags reads values from the cache" setting, values are read from the process 
image (cache) instead of directly from the controller. 

The SmartTag object can also read values directly from the controller. However, you can then 
expect a substantially higher communication load between the HMI device and the controller.

Runtime error on startup on TP 277 and OP 277
At the start of the runtime on a TP 277 or OP 277, the error "Global unknown error with VBScript: 
'Expected statement' in script ..." can be reported.

This error is triggered on devices with the Windows CE 3.0 operating system by user functions 
of the following type:

 
Sub VBFunction_1()
With HmiRuntime.Screens("Screen_1").ScreenItems("Button_1")
    .backcolor = vbred
    .visible = not .visible
End With
End Sub

If the error occurs, you need to re-program the user function as follows:

 
Sub VBFunction_1()
    HmiRuntime.Screens("Screen_1").ScreenItems("Button_1").backcolor = vbred
    HmiRuntime.Screens("Screen_1").ScreenItems("Button_1").visible = not .visible
End Sub

Hiding warnings for scripts
Activate "Runtime settings > General > Settings > Also start with faulty scripts". 

As a result, Runtime is started irrespective of faulty scripts. In addition, script warnings will not 
be displayed during a complete compilation

System function "GetPLCMode"
Contrary to the information in the online help, the following description applies to the system 
function "GetPLCMode".

Description
Evaluates the current mode of the connected PLC. 

The system function "GetPLCMode" can only be configured for the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500
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Use in the function list
GetPLCMode (connection, mode)

Use in user-defined functions
GetPLCMode (connection, mode)

Parameter

Connection
Connection of PLC and HMI device.

Mode
Evaluates the mode of the connected PLC.
8: RUN = The PLC program is being executed.
4: STOP = The PLC program has been interrupted.
Select a suitable user variable for the evaluation.

Scripts for service projects
Since no interactive user is usually logged in service projects, C scripts and VB scripts lead to 
problems in the following cases:

● When the scripts require interaction, for example, operator input.

● When the scripts show message boxes.

There is no common data area for C scripting in service mode. Thus, for example, no global 
C variables can be exchanged between the "Scheduler" and "Screens".

2.3.5.5 Recipes

Contents
Information that could not be included in the online help and important information about 
product features.

Arrays in recipe elements
If you have configured both an array as well as the elements of this array for recipe elements 
of a recipe, the loading of data records aborts with the following error message: "290055: Import 
of data records aborted with error"

Use either the array or just the array elements for recipe elements of a single recipe.
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2.3.5.6 User administration

Contents
Information that could not be included in the online help and important information about 
product characteristics.

SIMATIC Logon for WinCC Runtime Advanced and Panels
When you use SIMATIC Logon to manage access to a panel or a device with WinCC Runtime 
Advanced, you must note that the characters [/] and [\] cannot be used in the names of Windows 
user groups or Windows users.

2.3.5.7 Communication

Contents
Information that could not be included in the online help and important information about 
product features.

Connection interruptions with Mitsubishi PLCs
After multiple connection interruptions, a situation may arise where all the connection 
resources of the Mitsubishi PLC are in use and the connection can no longer be established. 
It is recommended to check these connection resources in the PLC program of the PLC and 
also to enable them again.   

Area pointer "Date/time" or "Date/time PLC"
If you use the area pointer "Date/time" or "Date/time PLC" in communication with an S7-1200, 
you must use "DTL" data type in the configuration of the PLC.     

Accuracy of the "DTL" data type
The "DTL" data type supports time information down to the nanosecond range. Because panels 
only support time information down to the millisecond, you may encounter the following 
restrictions when using the area pointers:   

● Area pointer "Date/time"
For the transmission of time information from a panel to the PLC, the smallest unit of time 
is 1 millisecond. The value range from microseconds to nanoseconds of the "DTL" data 
type is filled with zeros.

● Area pointer "Date/time PLC"
For the transmission of time information from a PLC to a panel, the range from 
microseconds to nanoseconds is ignored. The time information is processed on the panel 
down to milliseconds.
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Limited number of possible HMI connections
An error message is displayed during compilation of a device indicating that the configuration 
of the HMI connection in the "Devices & Networks" editor is invalid. The reason may be that 
the maximum number of possible connections of the HMI device or PLC has been exceeded.

Check the maximum number of available connections. Consult the device manuals of the 
devices you are using.

Routed communication with S7 300/400
Communication from connection partners in various different subnets can be routed via the 
following connections: PROFINET, PROFIBUS, MPI.

Using PROFINET IO with panel HMI devices
When using PROFINET IO to connect the direct keys and LEDs of HMI devices to the PLC, 
you can define an offset for the address area of the inputs and outputs during configuration in 
HW Config.

The following restriction applies when you use a PROFINET IO-capable CPU of the 400 series 
with one of the HMI devices listed below:

The offset for the start of the address area of the inputs cannot be bigger than the offset for 
the start of the address area of the outputs.

The restriction applies to the following HMI devices:

● OP 177B

● OP 277

● Mobile Panel 177

For the configuration of the address parameters, open the PLC with the CPU of the 400 series 
in HW Config. Select the HMI device connected via PROFINET IO in the station window of 
HW Config. A table with the properties of the HMI device is displayed at the bottom of the 
station window in the detail view. Select the line containing the addresses of the HMI device 
in the table and open the object properties using the shortcut menu.

Select the "Addresses" tab in the "Object properties" dialog. Configure the offset for the inputs 
under "Inputs > Start". Configure the offset for the outputs under "Outputs > Start".

Exceeding value ranges with Mitsubishi MC and Mitsubishi FX
With some data types, the Mitsubishi MC and Mitsubishi FX communication drivers do not 
check whether the value of a recipe tag exceeds the value range of the PLC tags. The data 
types affected are:

● 4-bit block

● 12-bit block

● 20-bit block

● 24-bit block

● 28-bit block
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Coordination area pointer in an OPC connection
In principle, the coordination area pointer can be used eight times in an OPC connection. If 
you have configured an OPC connection and automatically create another OPC connection 
using "Add", the coordination area pointer is only displayed once in the newly created 
connection. In this case, you should change the communication driver of the connection. If you 
then set OPC again as the communication driver, the area pointer coordination can again be 
used eight times.

Communication resources: SIMATIC S7 1200         
The SIMATIC S7 1200 controller provides six communication resources for HMI 
communication.

The number of HMI connections that you can actually configure depends on the HMI devices 
that you connect with the SIMATIC S7 1200. 

● One HMI Panel occupies one communication resource per connection.

● One RT Advanced occupies one communication resource per connection.

RT Advanced communication via Station Manager (SIMATIC NET) with an S7 1200
For routed communication of a SIMATIC S7 1200 with a PC with WinCC RT Advanced, the 
following restrictions apply for the PC:

● Windows 7: Only with installed SIMATIC NET 8.1

● Windows XP: Communication via Station Manager (SIMATIC NET) is not supported

These restrictions also apply if you are using WinAC MP or Station Manager. Connections with 
the help of the Station Manager of Runtime Advanced are always treated as routed 
connections.

Readme
2.3 WinCC Advanced

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  73



Communication between S7-1200 and a multi panel
Communication between an S7-1200 and a multi panel with the "WinAC MP" option installed 
via ProSave is not possible. The HMI devices affected are:

● SIMATIC MP 177 6" Touch

● SIMATIC MP 277 8" Touch

● SIMATIC MP 277 8" Key

● SIMATIC MP 277 10" Touch

● SIMATIC MP 277 10" Key

● SIMATIC MP 377 12" Touch

● SIMATIC MP 377 12" Key

● SIMATIC MP 377 15" Touch

● SIMATIC MP 377 19" Touch

HMI connections in WinCC V12
HMI connections to SIMATIC S7-1200 PLCs with firmware version lower than V2.0 cannot be 
made in WinCC V12.

Connections via PROFIBUS DP
When a connection between a PLC and an HMI device via PROFIBUS DP is interrupted and 
then re-established, sporadically all other PROFIBUS DP connections in the communication 
network are interrupted and re-established.

De-energize the disconnected station before reconnecting it.

"Set the IP suite (address) of the PLC in the Control Panel" with SIMATIC S7-1200 V1
The function "Set the IP suite (address) of the PLC in the Control Panel" has not been approved 
for the following PLCs:

● SIMATIC S7-1200 V1

Switching a connection
A connection may be interrupted when it is switched from a HMI device control panel to a 
SIMATIC S7-300/400, SIMATIC S7-1500 or SIMATIC S7-1200.

Note the following settings in the SIMATIC S7 1500 or SIMATIC S7 1200 controllers: 

● Absolute addressing of tags

● The "Disable PUT-GET communication" option must be selected

● The "Complete protection" protection level may not be set
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2.3.6 Compiling and loading

Contents
Information that could not be included in the online help and important information about 
product features.

Compiling and loading
If internal errors or warnings occur during compiling, compile the complete project using the 
command "Compile > Software (rebuild all)" in the shortcut menu of the HMI device.

Before you start productive operation with your project, compile the entire project using the 
"Compile > Software (rebuild all)" command from the shortcut menu of the HMI device.

If you are using HMI tags that are connected to the control tags in your project, compile all 
modified blocks with the command "Compile > Software" in the shortcut menu before you 
compile the HMI device.

Saving the WinCC project
If you save a project in WinCC using the "Save As…" command, this has no effect on the name 
of the Runtime projects generated for the devices. If you do not adapt the destination path of 
the devices in the "Extended download to device" dialog, the Runtime projects on the target 
devices will be overwritten.

Settings for update of operating system
If you select the command "Online > HMI device maintenance > Update operating system" 
from WinCC, you cannot change the settings such as the type of PG/PC interface or baud 
rate. The settings used during the last download are always used.

To make changes to the settings, open the "Extended download" dialog using the "Online > 
Extended download to device" command and change the settings. When you click the "Load" 
button the changed settings are saved.

Alternatively, you can perform an update of the operating system with changed settings with 
ProSave. You start ProSave via the Windows Start menu "Siemens Automation > Options and 
Tools > HMI Tools > SIMATIC ProSave".

Incorrect installation of ProSave
If you receive an error message during installation of ProSave when loading data to a target 
device or maintenance of an HMI device, then you cannot remedy this error using the repair 
function of setup. Remove ProSave via the Control Panel. Then start setup and install the 
"ProSave" component again.     

Checking the address parameters
During compilation of an HMI device in the project tree with the command "Compile > Software" 
in the shortcut menu, the address parameters of the HMI device, such as the IP address, will 
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not be checked. If you want to ensure that the address parameters are checked as well, you 
will have to compile the HMI device in the "Devices & Networks" editor of the toolbar.   

Error message when downloading data to the PLC
A panel and a PLC are connected and communicating with other. 

If a tag is accessed while downloading data from the panel to the PLC, an error message is 
displayed on the panel.     

Delayed reaction in the "Extended download to device" dialog
If the settings in the "Extended download to device" dialog for "Type of the PG/PC interface" 
and "PG/PC interface" do not match the settings on the HMI device, this can result in the 
application not responding for up to a minute.

     

Extended download with an S7-1200 and a Comfort Panel
An S7-1200 PLC and a Comfort Panel are located in the same physical network as the PG/
PC. You open the "Extended download to device" dialog for the Comfort Panel. 

If you activate the option "Show all accessible devices", it may occur that the application stops 
responding.   

OP77A, OP73, TP177A: Loading projects
When loading a project to an HMI device, it can happen that Runtime is not automatically 
ended, even though "Remote Transfers" is activated in the Panel.

If this happens, stop Runtime and manually set the transfer mode on the HMI device.       

Loading a SIMATIC HMI application to a PC station
The following circumstances ca n lead to an error message during the first load of a SIMATIC 
PC station:

● A SIMATIC HMI application is configured in a PC station in the project

– WinCC Runtime Advanced

– WinCC Runtime Professional

– WinCC Standby

– or WinCC Client

● The property "S7RTM is installed" is activated.

Before you load a SIMATIC PC station for the first time, select the configured device HMI_RT 
(WinCC...) in the project tree. Open the "Extended download to device" dialog and select the 
appropriate interface and parameter settings. Click "Load".

You then load the PC station as normal.     
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Project transfer via USB
If you have connected more than one HMI device via USB to your configuration PC, project 
transfer is only possible to the last connected device.

Delta download capability
If you make changes to a UDT, is the capability to perform a delta download of the Runtime 
Professional project lost. 

Compile the full project again.

Opening project files
When you run "HmiIRTm.exe", a dialog opens asking if you want to open the project file (.fwc). 

The following options are available to you: 

● "Yes": A dialog opens allowing you to select a project file (.fwc).

● "No": The dialog closes.

2.3.7 Runtime

2.3.7.1 Notes on operation in Runtime

Contents
Information that could not be included in the online help and important information about 
product features.

Special characters in the user view
Special characters, such as / " § $ % & ' ?, are not permitted when entering a name or the 
password in the user view.     

Language behavior - Layout of on-screen keyboard
The layout of the on-screen keyboard is not switched when the runtime language changes.     

Tag values exceed the maximum length     
You enter a character string in a string tag via an I/O field. If the character string exceeds the 
configured number of tags, the character string will be shortened to the configured length.

Empty message texts
Runtime is running with a project. The project is saved on a network drive.
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In the event of interruptions to the network drive connection, Runtime may attempt to load 
message texts from the network drive.

In the event of disconnection, the alarm window or the alarm view remains empty.

To avoid this, copy the project to a local drive before the starting the project in Runtime.

Complete download in Service mode
If you need to perform a "complete download" to the OS in Service mode from the engineering 
station, Runtime automatically stops and then starts again. 

The project is then no longer in Service mode.

In this state, the power supply is interrupted and WinCC Runtime no longer starts automatically 
on the OS.

Remedy: 

1. Switch the project manually to Service mode after you have performed the "complete 
download". 

2. Close the project manually.

3. Activate Service mode.

4. Start Runtime again using the surrogate icon in the taskbar.

2.3.7.2 Notes on operation of panels in Runtime

Contents
Information that could not be included in the online help and important information about 
product features.

Using the mouse wheel in Runtime
The use of the mouse wheel in Runtime is not supported on all panels.   

Basic Panels: Connections to S7-1200 and S7-1500 with Backup/Restore
If you use the "Backup/Restore" function, a maximum of two connections from Basic Panels 
to the controllers are possible at any given time.

● SIMATIC S7-1200

● SIMATIC S7-1500

Basic Panels: Backup on the memory card of the PLC
Create the backup file "A.psb" on the memory card of the PLC. An error, for example a 
connection break, occurs when creating the backup.
This will create a corrupt file on the memory card of the PLC. Such a file has "~$" as prefix. 
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Delete the file with the prefix "~$" if you want to save a backup again under the same name 
"A.psb".

Basic Panels: Panel Data Storage and S7-1500F
The "Panel Data Storage" PDS function cannot be used on Basic Panels in conjunction with 
S7-1500F when the password for the protection level "Full access incl. fail-safe" is used.

Upgrading Basic Panels to WinCC V12
Before you upgrade Basic Panels from version V11 to version V12, transfer the image of the 
V11 SP2 Update 5 or higher to the devices.
In the "SIMATIC ProSave [OS Update]" dialog, select the setting "Reset to factory settings". 
In this way, you always start a functional update of the image.
Affected devices:

● KP300 Basic mono PN, 

● KP400 Basic color PN 

● and KTP400 Basic color PN.

2.3.7.3 Notes on operation of Runtime Advanced

Contents
Information that could not be included in the online help and important information about 
product characteristics.

.Net-Controls in Runtime
If you have incorporated a .Net Control in your project as "Specific .Net-Control", you have to 
copy the files belonging to these controls to the installation directory of WinCC Runtime, e.g. 
"C:\ProgramFiles\Siemens\Automation\WinCC RT Advanced". Otherwise, the control cannot 
be loaded in Runtime.

2.3.8 HMI devices

2.3.8.1 Notes on HMI devices

Contents
Information that could not be included in the online help and important information about 
product characteristics.

If the PC goes into standby or hibernate mode while the transfer is in progress, the panel status 
after interruption of the transfer is not defined.
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Multi-key operation
Unintentional actions can be triggered by multi-key operation:         

● When you are using a key device, you cannot press more than two function keys at the 
same time.

● When you are using a touch device, a standard PC or a panel PC, you can only press one 
function key or button at the same time.

TS Adapter with Ethernet interface
If an HMI device is connected via Ethernet and a TS adapter, it can not be reset to factory 
settings.   

Simulation of the Basic Panels
Use an output field in an alarm text to output an external tag. The content of the output field 
will always be displayed with "0" during simulation.   

Simulation with real PLC connection
The access point used by the simulation is independent from the settings of the Engineering 
System and can only be altered in the Control Panel with the "Setting PG/PC Interface" tool. 
If the PLC connection is terminated right after the start of the simulation with alarm 140001, 
you should check the access point used by the simulation with "Setting PG/PC Interface".

1. Double-click "Setting PG/PC Interface" in the Control Panel. A dialog opens.

2. Select" "S7ONLINE" in the "Access point of application" field as standard for HMI.

3. Select the interface in the "Interface Parameter Assignment Used" area.

4. Exit the dialog "Setting PG/PC Interface" with OK 

Loading of projects without recipe data records
You are using recipes in a project. You transfer the project to a Basic Panel without recipe 
data records. 

You may encounter inconsistencies if you have altered the structure of the recipe in the 
Engineering System and the device already held recipe data records.

Check the consistency of the data records in this case. The device will not issue a note for all 
structural changes.       

Floating point numbers on MP 277, MP 377, TP 177B 4'' and CP4
Only floating point numbers in the range from 10-293 ... 10+307 are displayed correctly on the 
HMI devices MP 277, MP 377, TP 177B 4'' and CP4. If the tag value is outside this range, it 
is displayed as 0.
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USB device driver under Windows XP
If a configuration PC with Windows XP and a Comfort Panel are connected via USB, the S7-
USB driver may be reinstalled when the HMI device is restarted. The device settings may in 
this case not be restored.

Mobile Panels V2
If you use Mobile Panels V2 in a project, it is not possible to open the project with WinCC V11 
SP1. This affects projects with the following devices:

● Mobile Panel 277F IWLAN (RFID Tag)

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277 IWLAN V2

"Zone ID/Connection point ID" tag of a Mobile Panel 277 IWLAN V2
The tag used for the "Zone ID/Connection point ID" must be of data type INT for Mobile Panel 
277 IWLAN V2 devices. Adapt this data type if necessary when migrating a project.

HMI devices with operating system Windows CE 5.0 or higher
Owing to a modified client-server communication security setting, the time difference between 
the HMI device (client) and PC (server) must not exceed 1 day. If you back up recipe data from 
the HMI device on a network drive, for example, make sure that the time is set correctly on the 
PC (server) and the HMI device (client).

HMI devices with high communication load
S7 Diagnostics should be enabled if a Panel is assigned many connections to PLCs or other 
HMI devices. Otherwise, you will risk overload on the Panel.

Device replacement in the Engineering System
In the Engineering System, you replace a device with configured LED keys with a device 
without LED keys. Runtime start fails after you have transferred the project data to the device. 

For this reason, delete the LED key configuration before you replace the device.

Restrictions for the HMI device, MP 377 15" Touch daylight readable
The following functions are not supported in WinCC V12 for the MP 377 15" Touch daylight 
readable HMI device:

● Option: Sm@rtServer

● System function: SetAndGetBrightness

● Direct keys
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Upgrading Basic Panels to WinCC V12
Before you upgrade Basic Panels from version V11 to version V12, transfer the image of the 
V11 SP2 Update 5 or higher to the devices.
In the "SIMATIC ProSave [OS Update]" dialog, select the setting "Reset to factory settings". 

In this way, you always start a functional update of the image.

Affected devices:

● KP300 Basic mono PN 

● KP400 Basic color PN

● KTP400 Basic color PN

Connection switch in the Control Panel with Basic Panels
If you use the "Override protected connection information" function, the following restriction 
applies:

You cannot perform a connection switch in the Control Panel of a Basic Panel from a PLC 
without a protection level to a PLC with a "Complete protection" level.
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Installation 3
3.1 System requirements for installation

3.1.1 Notes on licenses

Availability of licenses     
The licenses for the products of the TIA Portal are usually supplied on the installation data 
medium and installed automatically by the Automation Licence Manager  during the installation 
process of the TIA Portal. 

Before you uninstall the TIA Portal, you must transfer and back up the licenses still required. 
Use the Automation License Manager for this purpose. 

Provision of the Automation License Manager
The Automation License Manager  is supplied on the installation data medium and is 
transferred automatically during the installation process. 

If you remove the TIA Portal, the Automation License Manager  remains installed on your 
system.

Working with the Automation License Manager
The Automation License Manager is a product of Siemens AG, which is used for handling 
license keys (technical representatives of licenses). 

Software products that require license keys for operation, such as the TIA-Portal, register the 
required license key automatically with the Automation License Manager . If the Automation 
License Manager finds a valid license key for this software, the software can be used according 
to the license usage terms associated with this license key.

 
 

 Note

For additional information on how to manage your licenses with the Automation License 
Manager , refer to the documentation supplied with the Automation License Manager .
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See also
Notes on the system requirements (Page 84)

Starting installation (Page 107)

Displaying the installed software (Page 110)

Modifying or updating installed products (Page 111)

Repairing installed products (Page 113)

Starting to uninstall (Page 115)

Installation log (Page 106)

3.1.2 Notes on the system requirements

System requirements for individual products  
The system requirements may differ depending on the products you want to install. You should 
therefore check the individual system requirements of your products.

If you want to install several products, make sure that your system meets the demands of the 
product with the highest requirements.

Displaying PDF files
To be able to read the supplied PDF files, you require a PDF reader that is compatible with 
PDF 1.7 e.g. Adobe (R) Reader version 9.

Displaying the Welcome Tour
You require the Adobe (R) Reader as of version 9 to start the Welcome Tour for the TIA portal.

 

See also
Notes on licenses (Page 83)

Starting installation (Page 107)

Displaying the installed software (Page 110)

Modifying or updating installed products (Page 111)

Repairing installed products (Page 113)

Starting to uninstall (Page 115)
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3.1.3 System requirements STEP 7 Basic

3.1.3.1 Licensing of STEP 7

Introduction
You require a  License Key to license the following STEP 7 editions:

● STEP 7 Basic

● STEP 7 Professional

You can install the corresponding  License Key when you are installing STEP 7 or transfer it 
using the Automation License Manager after the installation has been completed.

Licenses for STEP 7
The following licenses with the corresponding license keys are available:

● STEP 7 Basic

● STEP 7 Professional

● STEP 7 Professional Combo

Validity of license keys for older versions of STEP 7
With a valid License Key for V12.x of STEP 7 Professional and STEP 7 Professional Combo, 
you can also operate older versions of STEP 7 without restrictions. The following table provides 
more detailed information about this: 

Edition License Valid for
STEP 7 Basic V12.x STEP 7 Basic ● STEP 7 Basic V12.x
STEP 7 Professional 
V12.x

STEP 7 Professional ● STEP 7 Basic V10.5
● STEP 7 Basic V11.0
● STEP 7 Professional V11.0

STEP 7 Professional 
V12.x

STEP 7 Professional Combo ● STEP 7 Basic V10.5
● STEP 7 Basic V11.0
● STEP 7 Professional V11.0

 

Starting without a valid license key     
If you start an edition of STEP 7 without a valid License Key , the system alerts you that you 
are working in non-licensed mode. You have the one-time option of activating a Trial License. 
However, this license is valid for a limited period only and expires after 21 days.

When the Trial License expires, the following scenarios can occur:

Installation
3.1 System requirements for installation

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  85



● STEP 7 has never been licensed on the PC in question:

– Operations requiring a license can no longer be performed in STEP 7.

● STEP 7 was already licensed on the PC in question:

– A window requiring acknowledgment presents an alert for non-licensed mode every 10 
minutes and for every action requiring a license.

License requirements for simulation
You do not require additional licenses when you use the menu command "Online > Simulation" 
to start the simulation in STEP 7. 

If the following conditions are met, the appropriate licenses for the edition of STEP 7 you have 
installed are also required for the simulation.

● The engineering station is connected to a PLC.

● The connection to the PLC is configured and active.

See also
Handling licenses and license keys (Page 86)

3.1.3.2 Handling licenses and license keys

Introduction
In each case, you require a valid License Key to use STEP 7 Basic and STEP 7 Professional.

Installing license keys   
When you install STEP 7 Basic, the License Key is installed automatically during setup. When 
you install STEP 7 Professional you will be prompted at the end of the setup to transfer the 
license from the supplied storage medium to your PC.

If you want to install additional License Keys, you have to use the Automation License Manager 
to do this.

When you install a license, the associated license key is removed from the license key storage 
location.

 

 NOTICE

Destruction of license keys by copying   

It is not possible to copy a License Key. The copy protection prevents the license keys from 
being copied. If you attempt to copy a License Key this will be destroyed.
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Uninstalling license keys   
License keys are always uninstalled using the Automation License Manager. You uninstall a 
License Key in the following cases:

● When backing up data.

● If you no longer require the license.

You can then use a valid license on another PC or HMI device.     

Data backup
When backing up data on the HMI device or creating a backup during device replacement, 
remove the License Keys on the HMI device. To do this, open the Automation License Manager 
and back up the uninstalled license key to another storage location.

 

 NOTICE

Destruction of license keys on PCs

Start by removing all license keys in the following situations:
● Before you format the hard disk.
● Before you compress the hard disk.
● Before you restore the hard disk.
● Before you start an optimization program that moves fixed blocks.
● Before you install a new operating system.

Read the description of Automation License Manager ("Start > Siemens Automation > 
Documentation"). Observe all warnings and notices.

 

On PC-based HMI devices and on non-PC-based HMI devices where Automation License 
Manager is used, the license key storage location may contain multiple license keys. This 
capability means you can store multiple licenses of the same type at one location. Save all 
license keys of an HMI device to the same storage location.

 

 NOTICE

Always keep the original storage location of the license keys.
 

Invalid license after time zone change   
The installed license no longer functions in the following case.

● If you change the time zone on a PC as follows:
From a time based on a complete hour to a time not based on a complete hour.
Example: You change the time zone from GMT +3:00 to GMT +3:30.

To avoid this inconvenience, uninstall the license key using the Automation License Manager 
under the time zone setting that was set when the license key was installed.

This behavior does not apply to the Trial License.
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Defective license       
A license is defective in the following cases:

● If the license key is no longer accessible at the storage location.

● If the license key disappears during its transfer to the destination drive.

You can use the Automation License Manager to repair the defective license. To do this, use 
the "Restore" function or the "Restore wizard" of the Automation License Manager. To perform 
this restore operation you must contact Customer Support. 

You can find more detailed information on the Internet: http://support.automation.siemens.com 
(http://support.automation.siemens.com/WW/llisapi.dll?aktprim=99&lang=en&referer=
%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002) 

See also
Licensing of STEP 7 (Page 85)

3.1.3.3 Software and hardware requirements STEP 7

System requirements for installation
The following table shows the minimum software and hardware requirements for installation 
of the "SIMATIC STEP 7 Basic" software package:

Hardware/software Requirement
Processor 2.0 GHZ CORE 2 DUO
RAM 1 GB (Windows XP)

2 GB (Windows 7)
Free hard disk space 2 GB on system drive "C:"
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Hardware/software Requirement
Operating systems * Windows XP (32-bit)

● Windows XP Home SP3
● Windows XP Professional SP3
Windows 7 (32-bit)
● Windows 7 Home Premium
● Windows 7 Home Premium SP1
● Windows 7 Professional
● Windows 7 Professional SP1
● Windows 7 Enterprise
● Windows 7 Enterprise SP1
● Windows 7 Ultimate
● Windows 7 Ultimate SP1
Windows 7 (64-bit)
● Windows 7 Home Premium
● Windows 7 Home Premium SP1
● Windows 7 Professional
● Windows 7 Professional SP1
● Windows 7 Enterprise
● Windows 7 Enterprise SP1
● Windows 7 Ultimate
● Windows 7 Ultimate SP1

Graphics card 32 MB RAM 
24-bit color depth

Screen resolution 1024 x 768
Network 10Mbit/s Ethernet or faster
Optical drive DVD-ROM

* For more detailed information on operating systems, refer to the help on Microsoft Windows 
or the Microsoft homepage. 

Recommended hardware
The following table shows the recommended hardware for the operation of STEP 7.

Hardware Requirement
Computer SIMATIC FIELD PG M2 PREMIUM (or similar PC)
Processor 2.2 GHZ CORE 2 DUO (T7500)
RAM 1X2GB DDR2 RAM
Hard disk 250GB S-ATA HDD
Monitor 15" SXGA+ DISPLAY (1400 X 1050)
Optical drive DL MULTISTANDARD DVD RW
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Supported virtualization platforms
You can install the "SIMATIC STEP 7 Basic" software package on a virtual machine. To do 
this, use one of the following virtualization platforms:

● VMware vSphere Hypervisor (ESXi) 5

● VMware Workstation 8

● VMware Player 4

● Microsoft Windows Server 2008 R2 SP1 Hyper-V

These virtualization platforms can use the following operating systems as host operating 
system:

● Windows 7 Professional/Ultimate/Enterprise (32-bit)

● Windows 7 Professional/Ultimate/Enterprise (32-bit)

● Windows Server 2008 R2 (64-bit)

You can use the following host operating systems to install "SIMATIC STEP 7 Basic" within 
the selected virtualization platform:

● Windows 7 Professional/Ultimate/Enterprise (32-bit)

● Windows 7 Professional/Ultimate/Enterprise (64-bit)
 

 Note
● The same hardware requirements apply to the host operating system as for the respective 

TIA products. 
● The plant operator must ensure that sufficient system resources are available for the host 

operating systems.
● The hardware certified by the manufacturers is recommended for the use of HyperV server 

and ESXi.
● When you use Microsoft Hyper-V, accessible stations cannot be displayed.

 

Supported security programs
The following security programs are compatible with "SIMATIC STEP 7 Basic":

● Antivirus programs:

– Symantec Endpoint Protection 12.1 

– Trend Micro Office Scan Corporate Edition 10.6 

– McAfee VirusScan Enterprise 8.8

● Encryption software:

– Microsoft Bitlocker

– Utimaco SafeGuard Easy 4.2

● Host-based Intrusion Detection System:

– McAfee Application Control 6.0
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3.1.4 System requirement for WinCC Advanced

3.1.4.1 Software and hardware requirements

Introduction
Specific requirements for the operating system and software configuration must be met for the 
installation.

 

 Note

WinCC is generally authorized for use in a domain or workgroup.

However, be aware that domain group policies and restrictions of the domain may hinder the 
installation. In this happens, remove the computer from the from the domain prior to installing 
Microsoft Message Queuing, Microsoft SQL Server and WinCC. Log onto the computer in 
question locally with administrative rights. Then perform the installation. After successful 
installation, you can enter the WinCC computer back into the domain. If the domain group 
policies and restrictions of the domain do not impede the installation, the computer need not 
be removed from the domain during the installation.

Be aware that domain group policies and restrictions of the domain may also hinder operation. 
If you cannot avoid these restrictions, run the WinCC computer in a workgroup.

Consult with the domain administrator if needed.
 

Installation requirements
The following table shows the minimum software and hardware requirements that have to be 
met for the installation of the "SIMATIC WinCC Advanced" software package:   

Hardware/software Requirement
Processor type 2.0 GHz Core 2 Duo processor
RAM 1 GB (Windows XP)

2 GB (Windows 7; Windows Server)
Free hard disk space 2 GB on system drive "C:"
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Hardware/software Requirement
Operating systems * Windows XP

● Windows XP Professional SP3
Windows 7 (32 bit)
● Windows 7 Professional
● Windows 7 Professional SP1
● Windows 7 Enterprise
● Windows 7 Enterprise SP1
● Windows 7 Ultimate
● Windows 7 Ultimate SP1
Windows 7 (64 bit)
● Windows 7 Professional
● Windows 7 Professional SP1
● Windows 7 Enterprise
● Windows 7 Enterprise SP1
● Windows 7 Ultimate SP1
Windows Server (32 bit)
● Windows Server 2003 R2 Standard Edition SP2
● Windows Server 2008 R2 Standard Edition SP2
Windows Server (64 bit)
● Windows Server 2008 R2 Standard Edition
● Windows Server 2008 R2 Standard Edition SP1

Graphics card 32 MB RAM 
24-bit color depth

Screen resolution 1024x768
Network Ethernet 10 Mbps or faster
Optical drive DVD-ROM
Software Microsoft .Net Framework 3.5 SP1

Microsoft Windows Message Queuing

* For additional information on operating systems, refer to the help on Microsoft Windows or 
the Microsoft homepage. 

Simultaneously opening multiple instances of WinCC on a configuration PC can also increase 
the hardware capacity required.

 

 Note
"Aero Glass Style" of Microsoft Windows 7

A powerful graphics card is required for "Aero Glass Style". It requires DirectX9 capabilities 
and 128 MB of dedicated graphics memory.

The performance of the architecture of the graphics system can significantly influence the 
performance of WinCC.
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Recommended hardware
The following table shows the recommended hardware for the operation of SIMATIC WinCC.

Hardware Requirement
Computer SIMATIC FIELD PG M2 PREMIUM
Processor 2.2 GHZ CORE 2 DUO (T7500)
RAM 1X2GB DDR2 RAM
Hard disk 250GB S-ATA HDD
Monitor 15" SXGA+ DISPLAY (1400 X 1050)
Optical drive DL MULTISTANDARD DVD RW

Supported virtualization platforms
You can install the "SIMATIC WinCC Comfort" and "SIMATIC WinCC Advanced" software 
package on a virtual machine. To do this, use one of the following virtualization platforms:

● VMware vSphere Hypervisor (ESXi) 5

● VMware Workstation 8

● VMware Player 4

● Microsoft Windows Server 2008 R2 SP1 Hyper-V

These virtualization platforms can use the following operating systems as the host operating 
system:

● Windows 7 Professional/Ultimate/Enterprise (32-bit)

● Windows 7 Professional/Ultimate/Enterprise (32-bit)

● Windows Server 2008 R2 (64-bit)

You can use the following host operating systems to install "SIMATIC STEP 7 Basic" in the 
selected virtualization platform:

● Windows 7 Professional/Ultimate/Enterprise (32-bit)

● Windows 7 Professional/Ultimate/Enterprise (64-bit)
 

 Note
● The same hardware requirements apply to the host operating system as to the respective 

TIA products. 
● The plant operator must ensure that sufficient system resources are available for the host 

operating systems.
● The hardware certified by the manufacturers is recommended for the use of HyperV server 

and ESXi.
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Supported security programs
The following security programs are compatible with "SIMATIC WinCC Comfort" and "SIMATIC 
WinCC Advanced".

● Antivirus programs:

– Symantec Endpoint Protection 12.1 

– Trend Micro Office Scan Corporate Edition 10.6 

– McAfee VirusScan Enterprise 8.8

● Encryption software:

– Microsoft Bitlocker

– Utimaco SafeGuard Easy 4.2

● Host-based Intrusion Detection System:

– McAfee Application Control 6.0

Installing Microsoft .Net Framework
.Net Framework 3.5 SP1 is included on the installation medium. The installation routine 
determines if .Net Framework is already installed at the beginning of the installation. If .Net 
Framework is not installed, you are prompted with a dialog to perform the installation. When 
you confirm the prompt for installation, .Net Framework is installed. You need to reboot the 
computer after installing .Net Framework. If you do not install .Net Framework, the installation 
of WinCC Runtime Professional is aborted.

Installing Microsoft Windows Message Queuing in Windows XP
You can install the Windows Message Queuing component from the Windows Control Panel. 

Click Start > Control Panel. Double-click "Add or remove software", the "Add or remove 
software" dialog opens. In the "Add or Remove Programs" dialog, click "Add or Remove 
Windows Components". The Windows Components Wizard opens. Select the "Message 
Queuing" component in the Windows Components Wizard. Click "Next", the "Message 
Queuing" component is installed.

Installing Microsoft Windows Message Queuing in Windows 7
You can install the Windows Message Queuing component from the Windows Control Panel. 

Click Start > Control Panel. Click "Programs" and the "Programs" dialog opens. Under the 
"Programs and Features" section, click "Turn Windows features on or off". The "Windows 
Features" dialog opens. In the "Windows Features" dialog, select the "Microsoft Message 
Queue Server" feature. Click "OK" to enable the "Microsoft Message Queue Server".
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Online help for Windows 7 / Windows Server 2008
Windows 7 and Windows Server 2008 no longer support all online help formats by default. 
With WinCC, these online help formats are used in the following cases:

● Calling WinCC Direct Help

● Calling the WinCC Information System from the WinCC editors or via the Direct Help links

To be able to continue opening WinCC Direct Help, the following components are installed 
during the installation of WinCC:

● Microsoft Help Engine

You can also call the WinCC Information System under Windows 7 and Windows Server 2008 
from the Windows Start menu or from the installation folder.

To call the WinCC Information System from the WinCC editors or via the Direct Help links, 
some changes have to be made to the operating system. You can find more information on 
this in the section "More information for advanced users" of Microsoft Support article "917607": 
http://support.microsoft.com/kb/917607 (http://support.microsoft.com/kb/917607) 

See also
Options for WinCC Engineering and Runtime systems (Page 96)

Licensing of WinCC Engineering System (Page 98)

3.1.4.2 Parallel installation

Parallel installations in TIA portal V12
You will be prevented from starting the TIA Portal if you perform a non-permitted parallel 
installation of STEP 7 and WinCC. The following parallel installations are permitted in the TIA 
portal:

● STEP 7 V12 and WinCC V12

 

A dialog opens during installation to inform you of any inconsistencies in your parallel 
installation. The following parallel installations are permitted:

● WinCC V12 and RT Advanced V12

● WinCC V12 and RT Professional V12

The Engineering System and Runtime must always be of the same version after an installation.

Parallel installation of WinCC V12 and other SIMATIC products
Parallel installation of WinCC V12 and versions of WinCC flexible prior to WinCC flexible 2008 
is not allowed.

Parallel installation of WinCC V12 with versions of WinCC prior to WinCC V7.0 SP2 is not 
allowed. Parallel installation of WinCC V12 with WinCC V7.0 SP2 or WinCC V7.0 SP3 is only 
allowed with:
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● WinCC V12 Basic

● WinCC V12 Runtime Advanced

Parallel use
If the term "Combo" appears in the name or license key of the software after installation, the 
use of the following products/versions is permitted in accordance with paragraph 1.6 of the 
General Terms and Conditions (see also setup text):

● With "WinCC V12 Comfort Combo" license: WinCC flexible 2008 Standard

● With "WinCC V12 Advanced Combo" license: WinCC flexible 2008 Advanced

3.1.4.3 Add-ons

Options for WinCC Engineering and Runtime systems
SIMATIC Panels as well as WinCC Runtime Advanced and WinCC Runtime Professional 
contain all essential functions for operator control and monitoring of machines or plants. 
Additional add-ons allow you to extend the functionality in some cases to increase the range 
of available tasks.

Add-ons for Comfort Panels, Mobile Panels, Multi Panels
The following add-ons are available for Comfort Panels, Mobile Panels, and Multi Panels:

● WinCC SmartServer (remote operation)

● WinCC Audit (audit trail and electronic signature for regulated applications)
 

  Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, 
WinCC flexible /Sm@rtAccess add-ons as well as the WinCC flexible /OPC Server add-
on are incorporated into the basic functionality.

 

Add-ons for WinCC Runtime Advanced
The following add-ons are available for WinCC Runtime Advanced:

● WinCC SmartServer (remote operation)

● WinCC Recipes (recipe system)
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● WinCC Logging (logging of process values and alarms)

● WinCC Audit (audit trail for regulated applications)
 

  Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, 
WinCC flexible /Sm@rtAccess add-ons as well as the WinCC flexible /OPC Server add-
on are incorporated into the basic functionality.

 

Add-ons for WinCC Runtime Professional
WinCC Runtime Professional contains the following components, which you can activate with 
the appropriate license:

● WinCC Server (supplements WinCC Runtime to include server functionality)

● WinCC Recipes (recipe system, formerly WinCC /UserArchives)

● WinCC Logging (logging system, previously WinCC/TagLogging)

You can select and install the following add-ons in the installation dialog:

● WinCC Client (standard client for building multiple-station systems)

● WinCC WebNavigator (Web-based operator control and monitoring)

● WinCC DataMonitor (display and evaluation of process states and historical data)
 

  Note

In contrast to WinCC V7, functions from the WinCC / OPC Server add-ons have been 
incorporated into the basic functionality. Likewise, the basic functionality includes the 
Runtime API from WinCC /ODK.

 

In addition to the Runtime add-ons, you can also expand WinCC Runtime Professional with 
custom controls. The WinCC ControlDevelopment add-on is required to develop controls.

See also
Software and hardware requirements (Page 91)

Installing and uninstalling options (Page 97)

Installing and uninstalling options

Introduction
Some add-ons are included in standard WinCC installation and are installed automatically.

During the installation of WinCC Engineering System, the following add-ons are available for 
you to select for installation:
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● Simulation for WinCC Runtime Advanced

During the installation of WinCC Runtime Advanced, the following add-ons are available for 
you to select for installation:

● OPC XML Gateway

● WinCC Audit Viewer

You must enable all the necessary add-ons for use.
 

 Note

Each add-on requires a license. You activate an add-on by installing the appropriate license 
key.

 

Add-ons for non-PC-based HMI devices
The required Runtime add-ons are installed on the HMI device as follows:       

● During the transfer of the project to the HMI device
Add-ons that are no longer required are removed automatically.

● With ProSave

Procedure - activating add-ons
To activate an add-on for use, install the appropriate license key using the Automation License 
Manager.

In order to backup the license key of an add-on or use it on a different configuration PC or HMI 
device, you must uninstall this license key using the Automation License Manager.

 

 Note

When no valid license key is installed on a PC with WinCC Runtime, Runtime runs in Demo 
mode.

 

See also
Options for WinCC Engineering and Runtime systems (Page 96)

3.1.4.4 Licenses and Powerpacks

Licensing of WinCC Engineering System
You require a license key for the following:

● WinCC Engineering System, for example, WinCC Professional

● Add-ons for WinCC Engineering System
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You can install the license key during the installation of WinCC. You transfer the licenses for 
WinCC add-ons after installation with the Automation License Manager.

Starting without a valid license key   
If you start WinCC without a valid license, the system alerts you that you are working in non-
licensed mode. You have the option of activating a one-time trial license. Trial licenses for 
Engineering editions WinCC Basic, Comfort, Advanced und Professional expire after 21 days.

When the trial license expires, the following scenarios can occur:

● WinCC was never licensed on the PC in question.

– Operations requiring a license can no longer be performed in WinCC.

● WinCC was already licensed on the PC in question.

– An alert for non-licensed mode is presented every 10 minutes and for every action 
requiring a license by a window requiring acknowledgment.

License requirements for simulation
When you want to start simulation in WinCC using the menu command "Online > Simulation> 
With tag simulator", you do not need licenses for WinCC Runtime or licensed-based add-ons.

If the following conditions are met, you also need the appropriate licenses for the simulation 
of WinCC Runtime and license-based add-ons:

● The engineering station is connected to a PLC.

● The connection to the PLC is configured and active.

You start the simulation with the "Online > Simulation > Start" menu command.

See also
Software and hardware requirements (Page 91)

Licensing WinCC Runtime on PC-based HMI devices (Page 99)

Licensing of HMI devices (Page 100)

Working with license keys (Page 101)

Powerpack (Page 104)

Installing a Powerpack (Page 105)

Licensing WinCC Runtime on PC-based HMI devices
With PC-based HMI devices, you require a license key for the following:

● WinCC Runtime with 128 tags, for example.

● WinCC add-ons
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You can install the license key for WinCC Runtime during the installation of WinCC. You 
transfer the licenses for WinCC add-ons after installation with the Automation License Manager.

 

 Note

Only the Certificate of License for WinCC Runtime V12 authorizes operation of WinCC 
Runtime V12.

 

The appropriate new license is required to license WinCC Runtime.

You can upgrade the runtime licenses of WinCC flexible 2008 and WinCC V7 with an upgrade 
to WinCC Runtime V12.

Productive operation of the software is only allowed with a valid Certificate of License that 
matches the version listed on it.

Non-licensed mode   
WinCC Runtime and the Runtime add-ons can be used freely without license. An alert for non-
licensed mode is presented every 10 minutes by a window requiring acknowledgment.

See also
Licensing of WinCC Engineering System (Page 98)

Licensing of HMI devices
Non-PC-based HMI devices are always equipped to maximum capacity. A license key is not 
required for runtime operation.   

A license is required for each add-on for non-PC-based HMI devices. The license key of the 
respective license always activates one instance for use.

License key
To be able to license non-PC-based HMI devices with license keys, you require the "SIMATIC 
HMI License Manager Panel Plug-in" add-on.  

WinCC Setup installs this add-on by default. You can open the License Manager Panel plug-
in in the Automation License Manager with the menu command "Edit > Connect Target System 
> Connect HMI Device".

If WinCC is not installed, an installation of ProSave 7.2 or higher is required.
 

 Note

Further information about handling the licenses can be found in the Automation License 
Manager help.
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 Note

Verify that the current release of the operating system is installed on the HMI device before 
you start licensing. If necessary, update the operating system using ProSave.

 

Data backup
 

 NOTICE

Destruction of license keys on non-PC-based HMI devices

Installed license keys and authorizations are destroyed by the backup/restore processes on 
the HMI devices listed below.   
● 270 series
● 370 series

Carry out the following before beginning restoring:
● Use the Automation License Manager and ProSave to check whether license keys are 

installed on the HMI device.
● Remove any license keys present on the HMI device.

After restoring has been carried out, re-install the license keys on the HMI device.
 

Non-licensed mode  
Runtime add-ons can also be used without a license without restriction. An alert for non-
licensed mode is presented every 10 minutes by a window requiring acknowledgment.

See also
Licensing of WinCC Engineering System (Page 98)

Working with license keys

Introduction
Install a license key in the following situations:

● To use the WinCC Engineering System

● To use add-ons for the WinCC Engineering System

● To operate WinCC Runtime

● To use add-ons for WinCC Runtime on PC-based HMI devices

● To use add-ons on non-PC-based HMI Devices

To uninstall a license key in the following cases:
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● When backing up data

● If you no longer require the license

You can then use this license on another PC or HMI device.   

When you install a license, the associated license key is removed from the license key storage 
location.

 

 Note

A license key cannot be copied. The copy protection employed prevents the license keys 
from being copied.

 

Data backup
Remove the license keys on the HMI device when backing up data on the HMI device and 
when creating a backup during device replacement. 

You use the Automation License Manager to back up license keys of a HMI device to the 
storage area of the license key.  

 

 NOTICE

Destruction of license keys on non-PC-based HMI devices

Installed license keys are destroyed by backup/restore processes on the HMI devices listed 
below.  
● 270 series
● 370 series

Carry out the following before beginning restoring:
● Use the Automation License Manager and ProSave to check whether license keys are on 

the HMI device.
● Remove any license keys present on the HMI device.

After restoring has been carried out, re-install the license keys on the HMI device.
 

 NOTICE

Destruction of license keys on PCs

Start by removing all license keys in the following situations:
● Before you format the hard disk
● Before you compress the hard disk
● Before you restore the hard disk
● Starting an optimization program that moves fixed blocks
● Installing a new operating system

Read the description of Automation License Manager ("Start > Simatic Automation > 
Documentation"). Observe all warnings and notices.
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The license key storage location on PC-based HMI devices and on non-PC-based HMI devices 
where Automation License Manager is used may contain multiple license keys. This capability 
means you can store multiple licenses of the same type at one location. Save all license keys 
of the HMI device to the same storage location.

 

 NOTICE

Always keep the original storage location of the license keys.
 

Invalid license after time zone change  
The installed license no longer functions in the following case.

● If you change the time zone on a WinCC PC as follows:

– From a time based on a complete hour to a time not based on a complete hour.
Example: You change the time zone from GMT +3:00 to GMT +3:30.

To avoid this inconvenience, uninstall the license key under the time zone setting that was set 
when the license key was installed.

Example: 

You have installed the license key with a time zone setting based on a full hour. Then also 
uninstall the license key with a time zone setting based on a full hour.

This behavior does not apply to the trial license.

Defective license   
A license is defective in the following cases:

● If the license key is no longer accessible at the storage area.

● If the license key disappears during its transfer to the destination drive.

You can use the Automation License Manager to repair the defective license. Use the "Restore" 
function or the "Restore Wizard" of the Automation License Manager for this purpose. Contact 
Customer Support in order to restore the license. For additional information see: http://
support.automation.siemens.com (http://support.automation.siemens.com)

 

 Note

The runtime software can also be operated without errors if the license is missing or defective. 
The system alerts you at brief intervals that you are working in non-licensed mode.
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 NOTICE

If you start WinCC Engineering System without a valid license key, the system alerts you that 
you are working in non-licensed mode. You have the one-time option of activating a trial 
license. The trial license expires after 21 days.

When the trial license expires, the following scenarios can occur:
● WinCC was never licensed on the PC in question.

WinCC can no longer be started.
● WinCC was already licensed on the PC in question.

WinCC cannot be started. An alert for non-licensed mode is presented every 10 minutes 
by a window requiring acknowledgment.

 

See also
Licensing of WinCC Engineering System (Page 98)

Powerpack

Introduction   
The following upgrades are possible with a Powerpack:

● From a smaller to a larger edition of WinCC Engineering System

● On a runtime system with greater quantity structure

A Powerpack also includes a special license using which you can at any time activate a higher 
level of WinCC for use. 

Engineering system   
You have WinCC Comfort, for example. You can use the "SIMATIC WinCC Advanced 
Powerpack WinCC Comfort -> WinCC Advanced V12" Powerpack to activate 
WinCC Advanced for use.

Runtime   
You own WinCC Runtime Advanced with 128 tags, for example. You can use the "SIMATIC 
WinCC Runtime Advanced Powerpack 128 PowerTags -> 512 PowerTags V12" Powerpack 
to increase the capacity from 128 to 512 tags.

You own WinCC Runtime Advanced with 128 tags, for example. You can use the "SIMATIC 
WinCC Runtime Professional Powerpack Runtime Advanced 128 PowerTags -> Runtime 
Professional 128 PowerTags V12" Powerpack to activate WinCC Runtime Professional with 
128 tags for use.

See also
Licensing of WinCC Engineering System (Page 98)
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Installing a Powerpack

Introduction
Install a Powerpack by transferring the corresponding license key. The Powerpack license key 
replaces the license key of an existing installation.       

Requirement
● The conditions described in the "System requirements" chapter must be fulfilled.

● WinCC has been installed.

● The license key for the license for which you have purchased a Powerpack is available on 
the PC.

Installing a Powerpack
1. Open the Automation License Manager.

2. Select the license key.

3. Select "License Key > Upgrade" in the menu.

Result
The Powerpack license key replaces the former license key. You cannot reverse this process.

See also
Licensing of WinCC Engineering System (Page 98)
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3.2 Installation log

Function of the installation log   
The progress during the following installation processes is logged in a file:

● Installing products

● Modifying or updating already installed products

● Repairing an existing installation

● Uninstalling products

If errors occur during the installation process or warnings are issued, these can be evaluated 
with the help of the log file. You can do this yourself or contact product support. 

Installation logs storage location
The log file is the most recent file with the file extension ".log" and the name of which that starts 
with "SIA".

The location of the log file is stored in the environment variable "%autinstlog%". You can enter 
this environment variable in the address bar of Windows Explorer to open the folder with the 
log files. Alternatively, you can navigate to the corresponding directory by entering "CD 
%autinstlog%" in the command line. 

The location depends on the operating system, e.g. "C:\Documents and Settings\All Users
\Application Data\Siemens\Automation\Logfiles\Setup" in the English version of Windows XP. 

Setup_Report (CAB file)
To make it easier to provide Product Support with all necessary files, an archive file that 
contains the installation log and all other required files is saved in CAB format. This archive 
can be found at "%autinstlog%\Reports\Setup_report.cab". Send this CAB file to Product 
Support if you need assistance with installation. With this information, Product Support can 
determine whether the installation was executed properly. CAB files that were generated 
during earlier installation processes are saved with a date ID in the "Reports" directory. 

See also
Notes on licenses (Page 83)

Starting installation (Page 107)

Installing Support Packages (Page 109)

Displaying the installed software (Page 110)

Modifying or updating installed products (Page 111)

Repairing installed products (Page 113)

Starting to uninstall (Page 115)
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3.3 Starting installation

Introduction
Software packages are installed automatically by the setup program. The setup program starts 
once the installation medium has been inserted in the drive. 

Requirement
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.

Procedure
To install the software packages, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the product languages opens.

6. Select the languages for the product user interface, and click the "Next" button.
 

  Note

"English" is always installed as the basic product language.
 

The dialog for selecting the product configuration opens.

7. Select the products you want to install:

– If you wish to install the program in a minimal configuration, click on the "Minimal" button.

– If you wish to install the program in a typical configuration, click on the "Typical" button.

– If you wish to personally select the products to be installed, click on the "User-defined" 
button. Then select the check boxes for the products you wish to install.

8. If you want to create a shortcut on the desktop, select the "Create desktop shortcut" check 
box.

9. Click the "Browse" button if you want to change the target directory for the installation. Note 
that the length of the installation path must not exceed 89 characters.
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10.Click the "Next" button.
The dialog for the license terms opens.

11.To continue the installation, read and accept all license agreements and click "Next".
If changes to the security and permissions settings are required in order to install the TIA 
Portal, the security settings dialog opens.

12.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.
The next dialog displays an overview of the installation settings.

13.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking on "Next".

14.Click the "Install" button.
Installation is started. 

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

Following installation, you will receive a message indicating whether the installation was 
successful.

 

15.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

16.If the computer does not reboot, click "Exit".

Result
The TIA Portal along with the products and licenses you have ordered and the Automation 
License Manager have been installed on your computer. 

See also
Installation log (Page 106)

Notes on the system requirements (Page 84)

Notes on licenses (Page 83)

Displaying the installed software (Page 110)

Modifying or updating installed products (Page 111)

Repairing installed products (Page 113)

Starting to uninstall (Page 115)
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3.4 Installing Support Packages
You can install subsequent support packages, for example, hardware support packages, in 
the TIA Portal.

 

 Note

Support packages for STEP7 V5.4 or V5.5 cannot be used.
 

Procedure     
To install a Support Package, follow these steps:

1. Click "Support packages" in the "Options" menu.
The "Detailed information" dialog opens. A table lists all support packages from the directory 
that you selected as the storage location for support packages in the settings.

2. If you want to install a support package that is not in the list, you have the following options:

– If the support package is already on your computer, you can add it to the list by selecting 
"Add from the file system".

– If you add a support package from the "Service & Support" page on the Internet, first 
you download it by selecting "Download from the Internet". Then you can add it from 
the file system.

3. Select the support package that you want to install.

4. Click "Install."

5. Close and then restart the TIA Portal.

See also
Installation log (Page 106)
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3.5 Displaying the installed software
You can find out which software is installed at any time. In addition, you can display more 
information on the installed software.

Procedure
To display an overview of the software installed, follow these steps:

1. Click "Installed software" in the "Help" menu.
The "Installed software" dialog opens. You will see the installed software products in the 
dialog. Expand the entries to see which version is installed in each case.

2. If you would like to display additional information on the installed automation software, click 
the link on the "Detailed information about installed software" dialog.
The "Detailed information" dialog opens.

3. Chose the topic you want more information about in the area navigation.

 

See also
Notes on the system requirements (Page 84)

Notes on licenses (Page 83)

Starting installation (Page 107)

Modifying or updating installed products (Page 111)

Repairing installed products (Page 113)

Starting to uninstall (Page 115)

Installation log (Page 106)
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3.6 Modifying or updating installed products
You have the option to modify installed products using the setup program or to update to a 
new version.

Requirement 
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.

Procedure
To modify or update installed products, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Modify/Upgrade" option button and click the "Next" button.
The dialog for selecting the product languages opens.

7. Select the check boxes of the product languages that you want to install. You can remove 
previously installed product languages by clearing the corresponding check boxes.

 

  Note

Note that the product language "English" cannot be removed.
 

8. Click the "Next" button.
The dialog for selecting the product configuration opens.

9. Select the check boxes of the components that you want to install. You can remove 
previously installed components by clearing the corresponding check boxes.
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10.Click the "Next" button.
 

  Note

Note that you cannot change the target directory because the existing installation is being 
modified.

 

If changes to the security and permissions settings are required in order to install the TIA 
Portal, the security settings dialog opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.
The next dialog displays an overview of the installation settings.

12.Click the "Modify" button.
This starts the installation of the additional components. 

 

  Note

Following installation, you will receive a message indicating whether the existing 
installation was successfully changed.

 

13.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

14.If the computer does not reboot, click "Exit".

Result
The existing installation has been modified on your computer. 

See also
Notes on the system requirements (Page 84)

Notes on licenses (Page 83)

Starting installation (Page 107)

Displaying the installed software (Page 110)

Repairing installed products (Page 113)

Starting to uninstall (Page 115)

Installation log (Page 106)
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3.7 Repairing installed products
You have the option to repair installed products by completely reinstalling them using the setup 
program.

Requirement
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.

Procedure
To repair installed products, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Repair" option button, and click the "Next" button.
The next dialog displays an overview of the installation settings.

7. Click the "Repair" button.
This starts the repair of the existing installation. 

 

  Note

Following installation, you will receive a message indicating whether the existing 
installation was successfully repaired.

 

8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".

Result
The installed products have been reinstalled. 
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See also
Notes on the system requirements (Page 84)

Notes on licenses (Page 83)

Starting installation (Page 107)

Displaying the installed software (Page 110)

Modifying or updating installed products (Page 111)

Starting to uninstall (Page 115)

Installation log (Page 106)
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3.8 Starting to uninstall

Introduction
Software packages are removed automatically by the setup program. Once started, the setup 
program guides you step-by-step through the entire removal procedure. 

You have two options for removing:

● Removing selected components via the Control Panel 

● Removing a product using the installation medium
 

 Note

The Automation License Manager will not be removed automatically when you remove the 
software packages, because it is used for the administration of several license keys for 
products supplied by Siemens AG. 

 

Removing selected components via the Control Panel
To remove selected software packages, follow these steps:

1. Open the Control Panel with "Start > Settings > Control Panel".

2. Double click on "Add or Remove Programs" in the control panel.
The "Add or Remove Programs" dialog opens.

3. Select the software package to be removed in the dialog "Add or Remove Programs", and 
click "Remove".
The dialog for selecting the setup language opens.

4. Select the language in which you want the dialogs of the setup program to be displayed 
and click "Next".
The dialog for selecting the products you want to remove opens.

5. Select the check boxes for the products that you want to remove and click "Next".
The next dialog displays an overview of the installation settings.

6. Check the list with the products to be removed. If you want to make any changes, click the 
"Back" button.

7. Click the "Uninstall" button.
Removal begins.

8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".
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Removing a product using the installation medium 
To remove all software packages, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click "Read product information" or 
"Read installation notes".
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Uninstall" option button and click the "Next" button.
The next dialog displays an overview of the installation settings.

7. Click the "Uninstall" button.
Removal begins.

8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".

See also
Installation log (Page 106)

Notes on the system requirements (Page 84)

Notes on licenses (Page 83)

Starting installation (Page 107)

Displaying the installed software (Page 110)

Modifying or updating installed products (Page 111)

Repairing installed products (Page 113)
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3.9 Installing and uninstalling the migration tool

3.9.1 System requirements

System requirements for the migration tool   
The following system requirements apply to the use of the migration tool:

● All products used to create the source project must be installed. The following products are 
supported:

– WinCC flexible 2008 SP2 and SP3

– WinCC V7.0 SP3

– STEP 7 V5.5

– Integrated projects from STEP 7 V5.5 and the WinCC products listed above

– SINUMERIK

– STARTER and Startdrives

– SIMOTION SCOUT V4.4
You need the SCOUT Migration Tool PlugIn V4.4 to migrate SIMOTION SCOUT V4.4 
projects.

● All optional packages needed to process the STEP 7 project are installed. For example, all 
HSPs for the devices used in the source project are required.

3.9.2 Installing the migration tool

Distribution of the migration tool   
You can find the migration tool in the "Support" directory on the installation DVD of the TIA 
Portal. Alternatively, it can be downloaded from the Service & Support area of the Siemens 
website. For some products, (such as SIMATIC Failsafe or SIMOTION) additional plug-ins are 
required for the migration tool. These plug-ins can also be downloaded from the Service & 
Support page or installed from the installation DVD of the specific products.

Normally, the migration tool is installed without the TIA Portal. Because the TIA Portal has its 
own integrated migration function, a separate installation of the migration tool is not necessary.
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Procedure
To install the migration tool, proceed as follows:

1. Download the installation DVD from the Service & Support area of the Siemens website or 
use the installation file from the "Support" directory of the installation DVD of the TIA portal 
to perform the installation.

2. Run the installation file.
The setup program for the migration tool will open.

3. First, select the language in which the setup should be displayed and click the "Next" button.
The page for selecting the software language is displayed.

4. Since the migration tool is provided exclusively in English, you cannot choose any other 
language for the installation. Therefore, click "Next" to proceed to the next step.
The page for selecting the product is displayed.

5. The migration tool consists solely of a software component. Therefore, the migration tool 
is already selected.
To create a Desktop icon for starting the migration tool, select the check box "Create 
Desktop icon". Then click the "Next" button.
The page for confirming the licensing terms is shown.

6. Click on an entry in the list of license terms to read the selected license term. If you agree 
with all license terms, select the check box "I accept the terms of the displayed license 
agreement". Then click the "Next" button.
An overview of the installation is displayed.

7. Click the "Install" button.
The installation is performed with the displayed settings.

3.9.3 Uninstalling the migration tool
The migration tool can be removed using the Control Panel.

Procedure  
To remove the migration tool, follow these steps:

1. Open the Control Panel.

2. Double click on "Add or Remove Programs" in the Control Panel.
The "Add or Remove Programs" dialog opens.

3. Select the entry for the migration tool in the "Add or Remove Programs" dialog, and click 
the "Remove" button.
A security prompt appears.

4. Click the "Uninstall" button to confirm this prompt.
The migration tool will be removed.
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Migrating projects and programs 4
4.1 Migrating projects in a TIA portal project

4.1.1 Migration of projects with the TIA Portal

Migration of existing projects   
You can migrate projects from earlier automation solutions to the TIA Portal. Each time you 
migrate, a new project is created for the migrated data with which you can then work. Any TIA 
Portal projects already open are closed first.

The migration is then displayed in the table of the project history. From there, you have access 
to the migration log that is created automatically for the migration.

Supported products for migration   
The chapter "System overview STEP 7 and WinCC" includes information on the products that 
are available for the TIA Portal. In principle, all products listed there are supported by the TIA 
Portal during migration.

Any additional requirements that must be met depend on the initial products that were used 
and the currently installed products. For more information on the migration options for your 
products, you can, for example, refer to the Service & Support Internet pages and the 
documentation of your software products.

See also: Scaling of STEP 7 and WinCC (Page 29) 

Procedure during migration   
The migration process is divided into the following basic steps:

1. Preparing the initial project
If the software for editing the initial project is not or not fully installed on the programming 
device/PC with the TIA Portal, or if the initial project is an integrated project, the initial project 
must first be converted into a migration file. To do this, install the migration tool on a 
programming device/PC on which the required software for editing the initial project is 
installed. Then, use the migration tool to convert the initial project, and copy the file to the 
programming device/PC on which the TIA Portal is installed. You can omit this step if the 
initial project and its associated software are on the same programming device/PC as the 
TIA Portal, and if the initial project is not an integrated project.

2. Performing migration
Perform the actual migration within the TIA Portal. For the migration, either specify as 
source the migration file which you have created with the migration tool or specify the initial 
project when all required software has been installed.
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3. Checking the migration log
A migration log is created for each migration. It contains information about modified project 
parts. You can call the log under "Shared files > Logs" in the project tree or in the project 
history.  After completion of the migration, the migration log will be displayed in the TIA 
Portal. Check the log following completion of the migration.
If the migration failed, an XML file is created as a log under "\Logs" in the project directory. 
You can use any XML editor to open this log and view the reasons why the migration failed.

4. Correcting the migrated project
Because the configurations of the initial project may not always be completely compatible 
with the TIA Portal, not all configurations are transferred in identical form in the migrated 
project. You should therefore work through the points in the migration log systematically. 
If you have not included the hardware configuration in the migration, you also have to 
convert the unspecified devices to the appropriate hardware.

 Including the hardware configuration in the migration   
By default, only the software parts of the project are included in the migration. An unspecified 
device is generated in the migrated project for the devices contained in the initial project. The 
hardware and network configurations and the connection are not migrated. You can convert 
the unspecified devices into suitable devices after the migration and create any network 
configurations and connections manually.

If you are certain that the hardware used in the initial project has a corresponding equivalent 
in the TIA Portal, you can include the hardware configuration in the migration. In this case, 
both the hardware configuration and the software are migrated.

See also
Display migration log (Page 125)

Scaling of STEP 7 and WinCC (Page 29)

4.1.2 Preparing projects with the migration tool

4.1.2.1 Migrating projects with the migration tool

Preparation for migration   
In many cases, a project that you wish to migrate will not be located on the same programming 
device/PC on which the latest version of the TIA Portal is installed. Therefore, the initial project 
must first be converted to a compatible format for the migration. The same applies to integrated 
projects.

After creation of the migration file, you copy the migration file to the programming device/PC 
on which the current version of the TIA Portal is installed. In the TIA Portal, enter the migration 
file as source for the migration. You can now create a project in the current file format of the 
TIA Portal.
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Procedure for migration with the migration tool
The following steps are necessary to prepare a migration with the migration tool:

1. Install the migration tool on the programming device/PC where the source project is located. 
To do this, download the installation file from the Service & Support area of the Siemens 
website or install the migration tool from the setup DVD of the TIA Portal.

2. Start the migration tool and use it to convert the source project into the migration file format 
with file extension ".am12".
For this step, make sure that all software needed to process the source project is installed 
on the programming device/PC. This also includes all necessary service packs, hardware 
support packages and all expansion software that is needed to process the initial project. 
If individual products are not installed it may not be possible to perform the migration or the 
migration may be incomplete.

3. Copy the migration file to the target system on which a current version of the TIA Portal is 
installed.
Note that the target system must have been installed with all software needed to configure 
the complete set of devices contained in the migration.

4. Perform the migration within the TIA Portal, and specify the migration file with the extension 
".am12" as the source.

5. Once migration is complete, check the migration log and systematically work through the 
information provided there for the newly created project. Read the information in the 
Inspector window with special care after the first compilation of the configuration.

Including the hardware configuration in the migration   
By default, only the software parts of the project are included in the migration. An unspecified 
device is generated in the migrated project for the devices contained in the initial project. The 
hardware and network configurations and the connection are not migrated. You can convert 
the unspecified devices into suitable devices after the migration and create any network 
configurations and connections manually.

If you are certain that the hardware used in the initial project has a corresponding equivalent 
in the TIA Portal, you can include the hardware configuration in the migration. In this case, 
both the hardware configuration and the software are migrated.

 

See also
Migration of projects with the TIA Portal (Page 119)

Migrating projects (Page 123)

Calling the migration tool (Page 122)

Creating a migration file (Page 122)
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4.1.2.2 Calling the migration tool

Starting the migration tool   
During the installation, a "Migration to TIA Portal V12" shortcut is created as standard in the 
Start menu under "Siemens Automation > Migration Tool". Click this shortcut.

Alternatively, you can call the migration tool directly in Windows Explorer. The migration tool 
is saved to the following default folder during installation: "C:\Program Files\Siemens
\Automation\Portal V12\bin". To start the migration tool, click the 
"Siemens.Automation.MigrationApplication.exe" file in this directory.

See also
Creating a migration file (Page 122)

4.1.2.3 Creating a migration file
The section below describes how you can use the migration tool to convert the initial project 
into a migration file that can be read by the TIA Portal. Following conversion, this file is 
transferred to the target system and migrated there.

You can specify whether the migration file should contain the entire project, including the 
complete hardware configuration and the associated software, or whether you want to migrate 
the software only.

Requirement
● The suitable, original software with a valid license is installed for all configurations used in 

the initial project.

● The initial project is not provided with access protection.

● The initial project must be consistent, otherwise problem-free migration cannot be assured.

Procedure   
To create the migration file, follow these steps:

1. Choose the path of the source file for the migration in the "Storage Location (Path)" field.

2. Specify which project parts are to be migrated:

– Select the "Include HW and Network data during the migration" check box to migrate 
not only the software but also the complete hardware parts and the network configuration 
of the project.

– Select the "Copy SCADA runtime data" check box if you also want to migrate the runtime 
data, such as alarm archives, tag archives and user archives, in addition to the data of 
the engineering system.

3. Choose the path and the file name for the migration file in the "Intermediate file".

4. Click the "Migrate" button.
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Result:
A migration file is created. Finally, copy this file to the target system and migrate this file in the 
TIA Portal.

See also
Migrating projects (Page 123)

Calling the migration tool (Page 122)

Migrating projects with the migration tool (Page 120)

4.1.3 Migrating projects

Requirement   
● A converted file in the format ".am12" is already available or the original software with a 

valid license is installed for all configurations used in the initial project.

● The initial project is not provided with access protection.

● The initial project must be consistent, otherwise problem-free migration cannot be assured.

Read the additional information on the requirements in the help for the respective products 
installed.

 

 Note
System hibernation during the migration

While a migration is running, the system should not be changed to the standby or hibernate 
mode. Otherwise the migration will be aborted.

 

Procedure   
To migrate a project, follow these steps:

1. Select the "Migrate project" command in the "Project" menu.
The "Migrate project" dialog opens.

2. Specify the path and the file name for the project to be migrated in the "Source path" field. 
Choose either a project in the ".am12" migration format or in the format of the initial project.

3. To include the hardware configuration in the migration, select the "Include hardware 
configuration" check box.
If you have selected a migration file that was created with the migration tool, the check box 
cannot be selected. In this case, you must specify if you wish to include the hardware 
configuration in the migration before the conversion with the migration tool .
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4. Select the "Copy WinCC Runtime Professional data" check box, if you also want to migrate 
the runtime data, such as alarm archives, tag archives and user archives, in addition to the 
data of the engineering system.
If you have selected a migration file that was created with the migration tool, the check box 
cannot be selected. In this case, you must specify if you wish to include the SCADA runtime 
data in the migration before the conversion with the migration tool .

5. Choose a name for the new project in the "Project name" box.

6. Choose a path in the "Target path" box where the new project will be created.

7. Enter your name or the name of another person responsible for the project in the "Author" 
field.

8. Enter a comment in the "Comment" box, if you require one.

9. Click "Migrate".

Result
The initial project is converted and a message appears after conversion is complete. The newly 
created project is then opened in the project view and the migration log is opened in the TIA 
Portal.

Even if the migration failed, a project directory is created and a migration log in the form of an 
XML file is generated in this directory. The completion message that appears after the migration 
contains a link to this XML file. Click the link to open the XML file. Alternatively, you can find 
the XML file in the project directory under "\Logs".

See also
Post-editing integrated projects (Page 176)

Display migration log (Page 125)

Using logs (Page 258)

Migrating projects with the migration tool (Page 120)

Creating a migration file (Page 122)

4.1.4 Displaying the history of the migration
If a project was created by migration, the migration will be listed in the table of the project 
history. You can open the migration log in the table. The time of the migration is also shown.
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Procedure   
To display the migration in an overview table, follow these steps:

1. Select the open project in the project tree.

2. Select "Properties" in the shortcut menu of the project.
The dialog with the properties of the project opens.

3. Select the "Project history" group in the area navigation.
The overview table is displayed.

See also
Displaying properties of the project (Page 263)

4.1.5 Display migration log
A log is created for each successful migration. The log contains the following information:

● Migrated objects

● Modifications to objects made during migration

● Errors that occurred during migration

● In certain cases a link to more help with specific events.
In this case, click the question mark to obtain more help.

Procedure   
To display the log file of the migration, follow these steps:

1. Open the "Common data > Logs" folder in the project tree.

2. Double-click the desired log in the list.
The contents of the log are displayed in the work area.

See also
Migration of projects with the TIA Portal (Page 119)

Using logs (Page 258)
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4.1.6 Migrating WinCC flexible projects (Advanced)

4.1.6.1 Principles (WinCC flexible)

Migration (WinCC flexible)

Introduction
You can continue to use projects in WinCC from WinCC flexible. The following versions of 
WinCC flexible are supported:

● WinCC flexible 2008 SP2

● WinCC flexible 2008 SP3

The following sections describe the HMI devices that are supported and the required basic 
conditions for a successful migration.

Projects from ProTool Pro and earlier WinCC flexible versions cannot be migrated directly to 
WinCC. If you want to continue using such projects in WinCC, you have to migrate these to a 
supported version of WinCC flexible first and change the HMI device type.   

If the project to be migrated contains components of a supported option package, the option 
package must be installed for successful migration to WinCC. If the option package is not 
installed, migration is canceled. This concerns the following option packages:

● SINUMERIK

The following option packages are not supported by the migration:

● ProAgent

● Open Platform Program - OPP

See also
Migrating projects from WinCC flexible (WinCC flexible) (Page 129)

Compiling and loading a migrated project (WinCC flexible) (Page 131)

Supported HMI devices (WinCC flexible) (Page 132)

Migration of connections (WinCC flexible) (Page 140)

Migration of tags (WinCC flexible) (Page 144)

Migration of runtime data (WinCC flexible) (Page 153)

Migration of integrated projects (WinCC flexible) (Page 156)
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Migration principles (WinCC flexible)

Introduction
In the migration the project data are converted from a WinCC flexible project into the new data 
format of WinCC. The data will not be evaluated to see if they are consistent in the project you 
want to migrate. If errors or warnings are output in a source project during compilation, these 
will not be resolved as part of the migration. This means you should be able to compile the 
project without errors prior to migration. Note the scope of a project during migration. The 
features of WinCC apply for migration. For additional information refer to the online help in 
chapter "Process visualization > Performance features > Engineering System".     

Unique object names
The objects are clearly identified by the folders in which they are contained in WinCC flexible. 
Screen objects in groups are clearly identified by the group name.       

In WinCC, an object name must be unique within an HMI device. The name of screen objects 
must be unique within a screen.

The uniqueness of the name is verified during migration. If a name is not unique according to 
the new rule, the object in question will be renamed. A renamed object will receive the suffix 
"#Mign", where "n" stands for a sequential number.

 

 Note
Changed OPC DA server name

If you have configured an OPC-DA server in the WinCC flexible project, the OPC-DA server 
is no longer available under the old name after migration. 

In the migrated project, change the name of the OPC-DA server to the following value for the 
OPC clients concerned: "OPC.SimaticHMI.CoRtHmiRTm". 

 

Points to note when renaming tags
If you have structured tags in folders in WinCC flexible, the name of the tag will be formed 
during migration from the folder name and the tag name. The names of the folders and tags 
are separated by the character \. The name of the tag after migration is then, for example: 
Plant1\Line3\Tag17.

If the name would otherwise be longer than 128 characters after migration, the name is formed 
by the character string #mig, a consecutive number, the character # and the tag name from 
WinCC flexible, for example #mig2#Tag17.

If you dynamically compose tag names in scripts, you must check the tags whose names were 
changed during migration with "#mig".
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Affected objects
The following objects are renamed if necessary:

● Screens

● Faceplates

● Screen objects

● Graphics

● Recipes

● Structures

● Structural elements

● Alarm logs

● Tags

● Data logs

● Connections

Cancelling migration
The migration is cancelled in the following cases:

● If the project to be migrated is opened in the engineering system or in Runtime.

● If not enough memory space is available on the hard disk to create a a copy for migration 
of the project.

● If the migration cannot address the project database due to problems with the installed SQL-
Server.

● If the migration cannot address the project database due to missing user authorization.

● If you select the "*.hmi" file for the migration in an integrated project. You must select the 
"*.s7" file for the migration in an integrated project.

● If the project was created with a version not supported by the migration.

Saving the project in the migration format 
You do not have to execute the migration of a WinCC flexible project completely on the PC on 
which the project is available. You can prepare the migration by saving the project in the 
migration format. The migration tool is available for saving a WinCC flexible project in the 
migration format. The migration tool exports the engineering data from the WinCC flexible 
project and saves the data in the migration format "*.AM11".   

For the actual migration, copy the data in the migration format to a PC on which the TIA-Portal 
is installed.

For more detailed information, please refer to the migration tool documentation.
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Migrating projects from WinCC flexible (WinCC flexible)

Introduction
When you migrate a project, data from a WinCC flexible project is loaded into a new project 
for WinCC. A new project is therefore created automatically for project migration. You cannot 
migrate to an existing project.

The migration can be started in both the Portal view and the Project view.

You should only migrate a project in a newly started TIA portal. 

Information on the migration of an integrated project can be found in the section Migration of 
integrated projects (WinCC flexible) (Page 156).

If you only want to save the project in migration format, you can use the migration tool. See 
Migration principles (WinCC flexible) (Page 127) for additional information.

Requirement
● A project from WinCC flexible is available.

● The project is not open in WinCC flexible.
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Procedure
Migrate a project in the Portal view as follows:       

1. Select the action "Start > Migrate Project".

2. In the "Source path" box, navigate to the project you want to migrate.

3. Select the WinCC flexible project file "*.hmi".

4. Change the information for the project to be created, if necessary. For example, change 
the project name or project path. The data to be migrated is created in the new project.

5. Click "Migrate".
A new project is created and migration of the data is started:

– The Project view opens.

– The progress of the migration is shown in a migration window.

– Warnings and errors about the migration process are displayed in the Inspector window 
under "Info > General".

– All information about the migration is saved in a log file.

– The project is saved and a message displayed upon completion of the migration. The 
message contains a link that you can use to open the log.

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Comfort/Advanced V12.0 SP1
130 System Manual, 07/2013,  



When migration is complete, you will find a newly created device for each migrated HMI device 
in the project tree. These devices contain the migrated data, such as screens, alarms and tags.

Opening the migration log at a later point in time
The migration log is saved together with the migrated project. You can view the log at a later 
point in time. Open the log as follows:

1. Open the "Common data > Logs" folder in the project tree. It contains the logs of all 
previously performed migrations.

2. Double-click the required migration log.
The log is opened.

See also
Migration (WinCC flexible) (Page 126)

Migration of integrated projects (WinCC flexible) (Page 156)

Migration principles (WinCC flexible) (Page 127)

Compiling and loading a migrated project (WinCC flexible)

Compiling a migrated project
Once you have successfully migrated a WinCC flexible project, you need to recompile it before 
loading it to the HMI device. The project will only compile successfully if it was capable of error-
free compiling prior to migration.

If errors occur during compilation of the migrated project, they have to be eliminated.

Once compiling is successfully completed, load the project to the HMI device.   

Settings for download to the HMI device
The settings for loading the HMI device are not included in the migration. Once you have 
migrated the project, you must configure the settings for loading.

Select the HMI device in the project tree and select "Loading in device > Software (complete 
loading)" from the shortcut menu.The dialog "Advanced Loading" is opened. Configure the 
required settings for the interface. Click the "Load" button. The project is recompiled and the 
dialog "Load preview" is opened.

Expand the "Overwrite" entry and verify the settings for the following options:

● Would you like to overwrite the existing user administration data from this device

● Would you like to overwrite the existing recipe data on HMI system

Configure the options as you want to use them in the project in the future. Subsequently, load 
the project to the HMI device.
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See also
Migration (WinCC flexible) (Page 126)

4.1.6.2 Migrating engineering data (WinCC flexible)

HMI devices (WinCC flexible)

Supported HMI devices (WinCC flexible)

Introduction
When migrating projects from WinCC flexible you must bear in mind that WinCC does not 
support all HMI devices. You have to distinguish between the following cases:

● HMI device is supported by WinCC.
The project is migrated 1:1 and gets the same HMI device after migration as before 
migration.

● The HMI device is replaced by a compatible successor model.
The project is migrated. The migration replaces the HMI device with a compatible successor 
model. See HMI device change as a result of migration (WinCC flexible) (Page 134) for 
additional information.

● HMI device is not supported.
If your WinCC flexible project contains an HMI device that is not supported by WinCC, the 
migration process is cancelled. To migrate the project, you must change the HMI device in 
WinCC flexible to a HMI device type supported by WinCC.

The following HMI device types are supported both by WinCC flexible and WinCC:

Basic Panels  
● KTP400 Basic mono PN

● KTP400 Basic mono PN Portrait

● KTP600 Basic DP

● KTP600 Basic DP Portrait

● KTP600 Basic PN

● KTP600 Basic PN Portrait

● KTP600 Basic mono PN

● KTP600 Basic mono PN Portrait

● KTP1000 Basic DP

● KTP1000 Basic PN

● TP1500 Basic PN
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Mobile Panels
● Mobile Panel 177 6'' DP

● Mobile Panel 177 6'' PN

● Mobile Panel 277 8''

● Mobile Panel 277 8'' IWLAN V2

● Mobile Panel 277F 8'' IWLAN V2

● Mobile Panel 277F 8'' IWLAN (RFID Tag)

● Mobile Panel 277 10''

Panels
● OP 73

● OP 77A

● OP 77B

● OP 177B 6'' mono

● OP 177B 6'' color PN/DP

● TP 177B 4'' color PN/DP

● TP 177A

● TP 177A Portrait

● TP 177B 6'' mono DP

● TP 177B 6'' color PN/DP

● OP 277 6''

● TP 277 6''

Multi Panels
● MP 177 6'' Touch

● MP 277 8'' Key

● MP 277 8'' Touch

● MP 277 10'' Key

● MP 277 10'' Touch

● MP 377 12'' Key

● MP 377 12'' Touch

● MP 377 15'' Touch

● MP 377 15" Touch daylight readable

● MP 377 19'' Touch

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  133



Sinumerik PC
● OP 010 Key

● OP 012 Key

● OP 015 Key

● OP 015A Key

● TP 015A Touch+Key

HMI applications
● WinCC flexible Runtime

WinCC only supports the functions provided by these HMI device types.

Other functions which are not migrated because of the restricted device selection are 
documented in the following sections.

Adaptations before migration
If the HMI device was changed to an HMI device with a different screen size in the project to 
be migrated, you must recompile and save the project in WinCC flexible before the migration. 
The compilation process will adjust the size of the screens and screen elements.   

See also
Migration (WinCC flexible) (Page 126)

HMI device change as a result of migration (WinCC flexible) (Page 134)

Configuration change after HMI device change (WinCC flexible) (Page 137)

Migration of connections (WinCC flexible) (Page 140)

HMI device change as a result of migration (WinCC flexible)

Introduction
WinCC flexible supports some HMI devices which are discontinued in the future. These HMI 
devices are no longer supported by WinCC. When migrating a WinCC flexible project, an HMI 
device that is not supported is replaced by a compatible successor device.

Only the HMI device type is changed during the migration. HMI device-specific data are not 
changed by the migration. 

Inconsistencies in the project may occur due to a change in the HMI device. In a project which 
was compilable before the migration, errors may occur in the project compilation after changing 
the HMI device. E.g. because the changed HMI device supports different memory media to 
the previous HMI device.
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HMI device change by the migration
The following table provides information about which successors replace the HMI devices that 
are not supported.

Unsupported HMI devices Successors
C7-635 6" Key MP 177 6“ Touch
C7-635 6" Touch MP 177 6“ Touch
C7-636 6" Key MP 177 6“ Touch
C7-636 10" Touch MP 277 10“ Touch
HT 8 PCU50.3 -C (resolution: 640*480)
Mobile Panel 170 6'' Mobile Panel 177 6'' DP
Mobile Panel 277 8'' IWLAN Mobile Panel 277 8'' IWLAN V2
Mobile Panel 277F 8'' IWLAN Mobile Panel 277F 8'' IWLAN V2
OP010 Key PCU50.3B -C (resolution: 640*480)
OP012 Key PCU50.3B -C (resolution: 800*600)
OP015 Key PCU50.3B -C (resolution: 1024*768)
OP 08T PCU50.3 -C (resolution: 640*480)
OP 73micro OP 73
OP 170B 6'' mono OP 177B 6'' color PN/DP
OP 270 6'' OP 277 6''
OP 270 10'' MP 277 10'' Key
TP015A Touch Key PCU50.3B (resolution: 1024*768)
TP 170A 6'' TP 177A 6''
TP 170B 6'' mono TP 177B 6'' color PN/DP
TP 170B 6'' color TP 177B 6'' color PN/DP
TP 170micro 6'' TP 177A
TP 177micro 6'' TP 177A
TP 270 6'' TP 277 6''
TP 270 10'' MP 277 10'' Touch
MP 270 6'' Touch TP 277 6''
MP 270 10'' Key MP 277 10'' Key
MP 270 10'' Touch MP 277 10'' Touch
MP 370 12'' Key MP 377 12'' Key
MP 370 12'' Touch MP 377 12'' Touch
MP 370 15'' Touch MP 377 15'' Touch
PC 477 12'' Key PC 477B 12'' Key PB
PC 477 12'' Touch PC 477B 12'' Touch PB
PC 477 15'' Key PC 477B 15'' Key PB
PC 477 15'' Touch PC 477B 15'' Touch PB
PC 477 19'' Touch PC 477B 19'' Touch PB
PC 577 12'' Key IPC 577C 12'' Key PB
PC 577 12'' Touch IPC 577C 12'' Touch PB
PC 577 15'' Key IPC 577C 15'' Key PB
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Unsupported HMI devices Successors
PC 577 15'' Touch IPC 577C 15'' Touch PB
PC 577 19'' Touch IPC 577C 19'' Touch PB
PC 670 10" Key HMI IPC677C 12" Key PB
PC 670 12'' Key PC 677B 12'' Key PB
PC 670 12'' Touch PC 677B 12'' Touch PB
PC 670 15'' Key PC 677B 15'' Key PB
PC 670 15'' Touch PC 677B 15'' Touch PB
PC 677 12'' Key PC 677B 12'' Key PB
PC 677 12'' Touch PC 677B 12'' Touch PB
PC 677 15'' Key PC 677B 15'' Key PB
PC 677 15'' Touch PC 677B 15'' Touch PB
PC 677 17'' Touch PC 677B 17'' Touch PB
PC 677 19'' Touch PC 677B 19'' Touch PB
PC 870 12" Key HMI IPC677C 12" Key PB
PC 870 15" Key HMI IPC677C 15" Key PB
PC 870 15" Touch HMI IPC677C 15" Touch PB
PC 877 12" Key HMI IPC677C 12" Key PB
PC 877 15" Key HMI IPC677C 15" Key PB
PC 877 15" Touch HMI IPC677C 15" Touch PB
PC 877 19" Touch HMI IPC677C 19" Touch PB
PC IL 70 12" Touch HMI IPC577C 12" Touch PB
PC IL 70 15" Touch HMI IPC577C 15" Touch PB
PC IL 77 12" Touch HMI IPC577C 12" Touch PB
PC IL 77 15" Touch HMI IPC577C 15" Touch PB
PC IL 77 19" Touch HMI IPC577C 19" Touch PB
PC IL 77 12" Key HMI IPC577C 12" Key PB
PC IL 77 15" Key HMI IPC577C 15" Key PB
P012T Touch IPC 677C 12'' Touch PB

(if a P350 is connected)
P012T Touch IPC 477C 12'' Touch PB 

(if a P320  is connected)

HMI device change by the user
If a project contains an HMI device that is not supported by WinCC and no compatible 
successor model exists, the migration is cancelled. If you want to migrate the project, you must 
change the HMI device to WinCC yourself before the migration. Use an HMI device which is 
supported both by WinCC flexible and WinCC for this.

See also
Supported HMI devices (WinCC flexible) (Page 132)
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Configuration change after HMI device change (WinCC flexible)
 

 Note

If you migrate a project with embedded screens, this can result in the project file becoming 
larger than the old project file. 

 

HMI device replacement by the migration
If the migration makes an HMI device replacement, it replaces the existing HMI device with a 
compatible successor model. The successor models are further developed and therefore more 
efficient than their predecessors. The new models therefore support all the properties of their 
predecessors. Therefore only a little rework is to be expected on the project due to the HMI 
device replacement.     

HMI device replacement by the user
if you change an HMI device yourself before the migration, you must ensure that the HMI 
device used supports all properties which are used in the project. Compile the project after the 
HMI device replacement in WinCC flexible. The project must be perfectly compilable before 
the migration. Then migrate the project to WinCC. 

See also
Supported HMI devices (WinCC flexible) (Page 132)

Object support during migration (WinCC flexible)

Introduction
When migrating projects from WinCC flexible, all configuration data involving an HMI device 
supported by WinCC will be migrated. Basically, all object types and functions that are available 
and can be mapped to the new project environment will be fully migrated.

Some global object types are not migrated, for example, dictionaries and global libraries.

Supported object types
The following object types are supported for migration:

● Animations

● Audit settings

● Audit reports

● Scheduler

● User administration

● Area pointer
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● Faceplates

● Screens

● Screen template

● Data types

● Function lists

● Graphics lists

● Display and operating elements
Migration supports all display and operating elements available on the supported HMI 
devices.

● Alarms

● Alarm classes

● Alarm groups

● Project library

● Project languages

● Reports

● Recipes

● Runtime languages

● Runtime scripting

● Sm@rtAccess/Sm@rtService

● Structures

● System events

● System functions

● Texts

● Text lists

● Tags

● Connections

● Effective ranges

● Zones

● Cycles

Unsupported object types
The following object types are not supported by migration:

● Global libraries

● Dictionaries

● Project versions

● Change log
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Mapping of the screen navigation
WinCC does not support the screen navigation from WinCC flexible. The data of the screen 
hierarchy from WinCC flexible are not migrated. To map the functionality of a screen navigation 
from WinCC flexible, the naivigation buttons are migrated to the button available in WinCC. 
The system functions migrated to the "ActivateScreen" system function are migrated to the 
"Click" event of the respective button. The following system functions used in WinCC flexible 
are not available for the screen navigation in WinCC:

● ActivateRootScreen

● ActivateLeftScreen

● ActivateRightScreen

● ActivateParentScreen

● ActivateFirstChildScreen

These system functions are migrated to the "ActivateScreen" system function. The "Screen 
name" parameter is taken from the data of the screen hierarchy. If one of the named system 
functions is called from a screen which is not contained in the screen hierarchy, the 
"ActivateScreen" function is created without parameters. You must configure the desired 
screen to this system function after the migration.

Tab sequence in pictures with faceplates
In pictures with faceplates, the tab sequence is changed in both the screen and the faceplate 
as a result of the migration.

Migration of the screen template
WinCC offers an extended concept for working with screen templates. WinCC offers a global 
screen and several templates for each device. During migration of a template from 
WinCC flexible, the objects contained there and the properties configured in the template are 
migrated to the extended concept of the screen templates of WinCC.

The following objects are migrated to the "global screen" of WinCC:

● Alarm window

● Alarm indicator

● Help indicator

● Function keys of HMI devices with function keys

All other objects and properties are migrated to a template of WinCC.

The connection of the objects and properties to the respective template is automatically 
adapted.

See also
Changes of values of object properties by the migration (WinCC flexible) (Page 140)
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Changes of values of object properties by the migration (WinCC flexible)

Introduction
The standardization of object properties from WinCC V7 and WinCC flexible requires changes 
to the object properties during the migration process. The migration calculates the changes in 
such a way that the representation of the objects after migration is the same as prior to 
migration. Changes made during migration result in different units of measurements and values 
in the configuration for some object properties. 

Migrating the font settings of an object
In WinCC V7 and WinCC flexible, the unit of measurement "point" is used to denote the size 
of the fonts used for an object. In WinCC, the unit of measurement "pixel" is used to denote 
the size of the fonts used for an object. During migration, the font size is converted accordingly 
to ensure that the representation of the font is the same size at zoom level 100%. The different 
units of measurement result in changes to the numerical values for the font sizes after 
migration.   

Example:

Font style before migration Font style after migration
Arial 10 points Arial 13 pixels
Arial 16 points Arial 21 pixels
Tahoma 10 points Tahoma 13 pixels
Tahoma 16 points Tahoma 21 pixels

Migration of object margins
In WinCC flexible, some objects permit the entry of values <0 and >127 for setup of the object 
margins for the configuration of the representation. In WinCC, the range of values for object 
margins is limited to values between 0 and 127. The migration changes values <0 to the value 
"0" and values >127 to the value "127".

See also
Object support during migration (WinCC flexible) (Page 137)

Connections (WinCC flexible)

Migration of connections (WinCC flexible)

Introduction
If you migrate a project in which a supported communication driver is used, this driver is used 
further in WinCC. Objects which communicate via this driver are migrated 1:1. No rework is 
necessary.
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Not all communication drivers which are available in WinCC flexible are supported in WinCC. 
If an unsupported driver is used in the project to be migrated, there are two possible scenarios:

1. A compatible spare driver is available for the used driver.

2. No compatible spare driver is available for the used driver.

Compatible spare driver is available
If a driver is available in WinCC which addresses the used PLC or a comptaible PLC, the driver 
is automatically replaced during the migration.

You get an appropriate warning if the used driver is replaced.

In this case, check whether all the external tags and area pointers are valid after the migration 
by means of the migration report.

If the used driver is replaced, all the connection parameters are reset to the standard values. 
The CPU type is adapted to the appropriate PLC. The properties of the connected tags and 
area pointers are not changed.

Compatible spare driver is not available
If no driver is available in WinCC which addresses the used PLC or a compatible PLC, the 
configured connection is not migrated. All external tags which were connected to the PLC by 
this driver are converted into internal tags. External tag properties are lost in the conversion, 
e.g. the address in the PLC. All changes to the tags are recorded in the migration report.

You must reconnect the tags with the PLC after the migration and configuring of a connection.

You get an appropriate warning if the driver is not migrated.

Converting the communication driver
The following tables show the mapping of communication drivers from WinCC flexible to 
WinCC.

Supported communication drivers

WinCC flexible WinCC
Allen Bradley DF1 Allen Bradley DF1
Mitsubishi FX Mitsubishi FX
Modicon MODBUS Modicon MODBUS RTU
Modicon MODBUS TCP/IP Modicon MODBUS TCP/IP
Omron Hostlink/Multilink Omron HostLink
OPC OPC
SIMATIC HMI HTTP Protocol SIMATIC HMI HTTP Protocol
SIMATIC S7 200 SIMATIC S7 200
SIMATIC S7 300/400 SIMATIC S7 300/400

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  141



Compatible communication drivers

WinCC flexible WinCC
Allen Bradley DH485 Allen Bradley DF1
Allen Bradley E/IP C.Logix Allen Bradley EtherNet/IP
Mitsubishi Protocol 4 Mitsubishi MC TCP/IP

Not supported communication drivers

WinCC flexible WinCC
GE Fanuc SNP Not supported
ISAC Not supported
LG GLOFA-GM Not supported
SIMATIC 500/505 DP Not supported
SIMATIC 500/505 serial Not supported
SIMATIC S5 AS511 Not supported
SIMATIC S5 DP Not supported
Telemecanique Uni-Telway Not supported

See also
Migration (WinCC flexible) (Page 126)

Supported HMI devices (WinCC flexible) (Page 132)

Adapting configuration for non-migrated connection (WinCC flexible) (Page 142)

Migration of area pointers (WinCC flexible) (Page 143)

Migration of tags (WinCC flexible) (Page 144)

Adapting configuration for non-migrated connection (WinCC flexible)

Introduction
If a connection cannot be migrated you have the following options:

● Change the configuration in WinCC flexible before the migration

● Change the configuration after the migration

Change a connection before the migration
If the communication driver selected for the connection is not supported by the migration, you 
must select a driver which is supported by the migration. The HMI device must also support 
the selected communication driver.   
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If no suitable driver is available for the used HMI device, you must use a suitable HMI device. 
Then adapt the configuration in WinCC flexible and recompile the project. Migrate the project 
after successful adaptation and compiling. The connection is then also migrated.

Changing a connection before the migration
If you migrate a WinCC flexible project in which the connection is not migrated, all external 
tags of this connection are mapped to internal tags. You receive an appropriate entry in the 
migration protocol for every tag concerned. 

You must configure a new connection after the migration. For this connection you select a 
communication driver which supports the used HMI device. If no suitable driver is available for 
the used HMI device, you must use a suitable HMI device.

If you have configured the new connection, you must reconnect all tags which were mapped 
to internal tags before the migration. Open the migration report to make reconfiguration easier. 
Reconfigure the tags according to the log entry.

If the project contained area pointers, you must also reconfigure these. You will also find 
corresponding entries for the area pointers in the migration log.

See the section Migrating projects from WinCC flexible (WinCC flexible) (Page 129) for further 
information about the migration log.

See also
Migrating projects from WinCC flexible (WinCC flexible) (Page 129)

Migration of connections (WinCC flexible) (Page 140)

Migration of area pointers (WinCC flexible)

Introduction
The migration of area pointers depends on the used communication driver. 

● If the used communication driver is supported by the migration, area pointers from WinCC 
flexible are taken over unchanged in the migration.

● if the used communication driver is not supported by the migration, area pointers are not 
migrated.  

Migration of the area pointers
If the connection used by the area pointers is fully migrated, the area pointers are also fully 
migrated. The parameters of the area pointers are taken over unchanged.

If you replace the communication driver of the connection before the migration, check whether 
all the parameters of the area pointers are still valid after the migration.

If the connection used by the area pointer is not migrated, the area pointers are not migrated 
either. See Adapting configuration for non-migrated connection (WinCC flexible) (Page 142) 
for additional information.
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See also
Adapting configuration for non-migrated connection (WinCC flexible) (Page 142)

Migration of connections (WinCC flexible) (Page 140)

Migration of tags (WinCC flexible)

Introduction
You need to make some special considerations when migrating tags. The following aspects 
should be distinguished:

● Migrating data types of tags

● Migrating internal tags

● Migrating external tags

● Tag names

● Tag limits

Migrating data types
WinCC features some other data types and uses different data type names than 
WinCC flexible. When migrating a relevant tag, the data type from WinCC flexible is mapped 
to the corresponding data type in WinCC. See Migration of data types (WinCC flexible) 
(Page 159) for additional information.

Migrating internal tags
Internal tags are always migrated completely. Only the data type names and tag names may 
change due to migration.

Migrating external tags
If the connection used by the external tags is migrated, the external tags are also fully migrated. 
The migration of external tags depends on whether the used communication driver is supported 
by the migration. See Migration of connections (WinCC flexible) (Page 140) for additional 
information.

If the connection used by the external tags is not migrated, the external tags are not migrated 
either. The external tags are then mapped to internal tags. You must configure a new 
connection and reconnect the tags with the tags of the PLC after the migration.

Migrating names of tags
In WinCC flexible, tags located in different folders can have the same name. In WinCC, the 
tag name must be unique on the configured HMI device. This means that tags with the same 
name from different folders will be renamed during migration. See Migration principles (WinCC 
flexible) (Page 127) for additional information.
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See also
Migration of data types (WinCC flexible) (Page 159)

Migration of connections (WinCC flexible) (Page 140)

Migration principles (WinCC flexible) (Page 127)

Migration (WinCC flexible) (Page 126)

Migration of alarm classes and alarm groups (WinCC flexible) (Page 146)

Migration of scripts (WinCC flexible) (Page 148)

Migration of language-specific content (WinCC flexible) (Page 150)

Migration of libraries (WinCC flexible) (Page 152)

Migration of structures
In WinCC V12, the "StringChar" data type is not supported in HMI user data types. 

If you have used this data type in a structure in a WinCC flexible project, an invalid element is 
created by the migration in the HMI user data type.

After migration , you must re-work this user data type in WinCC and enable the user data type. 

At the same time, check the offset of the following elements and any existing interconnections 
between a faceplate and the elements of the user data type. Adapt the elements if required.

Migration of logs

Storage location of logs
WinCC flexible allowed you to store logs in a database which was automatically set up upon 
WinCC flexible installation ("System-defined data source" setting). This option is not available 
in WinCC.

If you have used this setting in your WinCC flexible project, it will be changed to "User-defined 
name of data source" during migration. Before you can store logs in a database, you must 
configure an ODBC data source in the Windows control panel and configure the name of the 
user data source specified there as the "name of the data source" in the log in WinCC.
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Migration of alarm classes and alarm groups (WinCC flexible)

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:

WinCC flexible WinCC
Error Alarms
System System
Warnings Events

The names of the alarm classes can be changed as necessary after migration.

Migrating alarm groups
Migration will migrate only those alarm groups actually in use.   

Alarm groups with an ID from 1-31 will be migrated 1:1.

A corresponding alarm group is created in WinCC for each alarm class in the system. These 
alarm groups created by the system are assigned IDs beginning with the number 32 and 
consecutively incremented. The 4 pre-defined message classes in every WinCC project are 
automatically given IDs 32-35 by their alarm groups. Additionally created alarm group and an 
additional ID is assigned to each user-defined alarm class. Therefore, the IDs for alarms groups 
with IDs > 31 may be changed after migration. This step also changes the assignment of the 
alarm group names to the IDs. 

Example:

In the example, you can see the assignment of the IDs in WinCC for the migration. 

Alarm groups ID in WinCC flexible ID in WinCC  
Alarm group 1-16 1-16 1-16 Default for alarm groups from system 

alarms
Alarm group 17-31 17-31 17-31 Custom alarm groups
  32-35 Default in WinCC for alarm groups of 

predefined alarm classes.
Alarm group 32 32 36 Changed assignment of ID to alarm group 

in WinCC
Alarm group 33 33 37 Changed assignment of ID to alarm group 

in WinCC

Also note:

When migrating alarm groups that supposedly have the same group name, the migration 
adapts the name. This occurs, for example, when a group name contains a space at the end 
of the name. The migration deletes all existing spaces at the end of names. If two groups 
obtained the same group names due to this deletion, the migration adds the suffix "# Mign" to 
the group name of the following alarm groups, where "n" stands for a sequential number.
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Example:

The following alarm groups exist in WinCC flexible: 

"AlarmGroup_18"

"AlarmGroup_18 " - group name contains one space

"AlarmGroup_18 " - group name contains two spaces

"AlarmGroup_18" is the alarm group with the highest number. 

Result after migration:

"AlarmGroup_18"

"AlarmGroup_18#Mig1"

"AlarmGroup_18#Mig1.1"

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:   

WinCC flexible WinCC
Error Errors
System System
Warnings Warnings

The names of the alarm classes can be changed as necessary after migration.

Display of ALARM_S messages and SIMATIC SFM messages
In WinCC flexible you can activate the display classes for ALARM_S messages in integrated 
projects. In WinCC flexible, you activate the display of SIMATIC SFM messages via a separate 
setting. The separate setting for activating the display of SIMATIC SFM messages is not 
required in WinCC. You control the display of SIMATIC SFM messages, and also the display 
of ALARM_S messages in WinCC only by activating the corresponding display class.

The changed concept may cause the display of messages to change following migration.

If all the display classes for ALARM_S messages are activated and the display of 
SIMATIC SFM messages is deactivated in the WinCC flexible project , ALARM_S messages 
and SIMATIC SFM messages are displayed following migration.

To ensure that only ALARM_S messages are displayed following migration, you have to assign 
the SIMATIC SFM messages to an unused display class after migration to STEP 7. You then 
have to deactivate this display class in WinCC.

If all the display classes for ALARM_S messages are deactivated and the display of 
SIMATIC SFM messages is activated in the WinCC flexible project , ALARM_S messages and 
SIMATIC SFM messages are not displayed following migration.
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To ensure that only SIMATIC SFM messages are displayed following migration, you have to 
assign the SIMATIC SFM messages to an unused display class after migration to STEP 7. 
You then have to activate this display class in WinCC.

The display class is dependent on the settings in STEP 7. The default setting for SIMATIC SFM 
messages in Step 7 is the display class "0". To activate the display in WinCC, the display class 
"0" must be activated.

You activate the display class in WinCC in the Runtime settings of the respective HMI device 
in the "Messages" category.

See also
Migration of tags (WinCC flexible) (Page 144)

Migration of scripts (WinCC flexible)

Introduction
The migration supports VB-scripts which were created in WinCC flexible. For a VB-script to 
be migrated successfully it must be functionable in WinCC flexible first.
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 Note
Script errors

The most efficient way to locate scripting errors in the course of the initial test run after 
migration is to use an installed Script Debugger and the diagnostics controls.

 

Migration of a VB script
A script is analyzed in the migration and adapted to the system behavior of WinCC if necessary. 
The following is adapted:        

● System functions which have changed their names are renamed.
This concerns the following system functions:

Function name in WinCC flexible Function name in WinCC
IncreaseValue IncreaseTag
DecreaseValue DecreaseTag
SetValue SetTag

● The access to tags as parameters of system functions is adapted to the system behavior 
of WinCC. In WinCC scripts are no longer transfromed as in WinCC flexible. The scripts 
are executed directly as a source code. Therefore the stricter rules for the VBS syntax 
apply. A tag call is always migrated with inverted commas. If several parameter types are 
allowed for a system function, these are migrated with the keyword "SmartTags".
Example 1:
The value of the "temperature" tag should be incremented by the value "1".
Valid expressions in WinCC flexible:
IncreaseValue temperature, 1
IncreaseValue "temperature", 1
IncreaseValue SmartTags("temperature"), 1
Valid expression in WinCC:
IncreaseTag "temperature", 1
 
Example 2:
You use a system function on which several parameters are allowed. The value of the 
"temperature" tag should be incremented by the value of the "heatcontrol" tag.
Valid expression for WinCC flexible:
IncreaseValue "temperature", "heatcontrol"
Valid expression for WinCC:
IncreaseTag "temperature", SmartTags("heatcontrol")

● Objects renamed by the migration are also renamed in the script when using in a script. 
See the section Migration principles (WinCC flexible) for further information about the 
renaming objects. You only have to observe the following rules when renaming objects:
If you address objects whose names are dynamically generated by the script with the help 
of a script, the object names in the script can not be automatically changed by the migration. 
In such a case, you have to correct the generation of the object names in the script after 
migration. 
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See also
Migration of tags (WinCC flexible) (Page 144)

Migration of language-specific content (WinCC flexible)

Introduction
WinCC offers the same options for configuring projects in different languages as those 
available in WinCC flexible. All languages supported by WinCC are included in the migration 
of a project. 

Migrating language-dependent content
The following language-dependent content is migrated:       

● Project languages

● Project texts

● Fonts for display in runtime

● Language-dependent graphics

You need to consider the following when migrating language-dependent content:

● The operating system on the PC performing the migration must support the project 
languages used in the project.

● The fonts used for runtime display must be installed on the PC performing the migration.

● Dictionaries are not supported by the migration.

Editiing language of integrated projects following migration
During migration of an integrated project, the project components to be migrated from STEP 7 
and WinCC flexible also bring their respective settings for the editing language. In WinCC there 
is only one editing language for all project components. Migration activates for the mgrated 
project the editing language which was set in STEP 7 prior to migration. If this setting is not 
the same as the setting from WinCC flexible, the configured texts are no longer visible in 
WinCC. No text is displayed at the usage locations, or only the entry "Text" can be seen. To 
make the texts visible, you must change the editing language. Click the "Tasks" taskcard at 
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the right-hand edge of the TIA portal and select the correct editing language in the "Language 
& Resources" area.

Unsupported languages
The migration of language-dependent content depends on whether or not WinCC supports the 
respective language. 

If a project only contains project languages not supported by WinCC, the project will not be 
migrated.

If a project contains supported and unsupported project languages, only the supported 
languages will be migrated. The editing language and reference language are set to a 
supported language.

The following languages are not supported by WinCC:

● Arabic

● Hebrew

● Dhivehi

● Gujarati

● Kannada
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● Tamil

● Telugu

● Urdu

● Punjabi

● Persian

● Syrian

See also
Migration of tags (WinCC flexible) (Page 144)

Migration of libraries (WinCC flexible)

Introduction
You need to consider two different cases when migrating from libraries:

1. Migrating a project library

2. Migrating a global library

Migrating a project library
A project library is stored together with the project data in the project file. For this reason, a 
project library is migrated with the same restrictions as the project data.   

Migrating a global library
Global libraries are not supported by the migration. The library objects used in the project will 
be migrated, however. The library objects are copied when used in the project and then no 
longer have a connection to the library.

To migrate a global library, you must copy or move the objects contained in the library to the 
project library. The objects are then included in the migration. In WinCC, you move the migrated 
objects to a new global library that is created. You can copy or move both individual objects 
or entire library categories.   

See also
Migration of tags (WinCC flexible) (Page 144)
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4.1.6.3 Migrating runtime data (WinCC flexible)

Migration of runtime data (WinCC flexible)

Introduction
Only the configuration data are migrated by the migration when migrating a project. The runtime 
data are not affected. You need to update the runtime data following migration.

The runtime data consists of the following: 

● Runtime project
The runtime project contains the compiled project data.

● Recipe data and user administration
The recipe data and user administration are data that can be changed in runtime.

● Log data
The data of tag logs and alarm logs are acquired and logged in runtime.

Migrating recipe data and user administration
If the recipe data and user administration were changed in runtime, you need to back up this 
information from the HMI device before you load the migrated project.

Depending on the used HMI device, you have different options for saving the above data.

If the HMI device supports external memory media and the recipe data are saved there, the 
data remain on the memory medium. External memory media are for example StorageCard 
or a network drive. You use the data again after the migration. The user adminsitration is not 
saved on an external memory medium so you have to save these data, e.g. with ProSave.

If the recipe data are saved in the internal memory of the HMI device, save these data on an 
external memory medium. Use ProSave to save the recipe data. If you have already configured 
appropriate system functions in your project, use the system functions. The following system 
functions are available for the recipe data:

● "ExportDataRecords" for the backup

● "ImportDataRecords" for the restore

You update the runtime project by compiling the project in WinCC again and loading it to the 
HMI device.

After you have loaded the migrated project on the HMI device, restore the recipe data and the 
user administration to the HMI device.

See also
Migration (WinCC flexible) (Page 126)

Backing up recipe data and user administration (WinCC flexible) (Page 154)

Restoring recipe data and user administration (WinCC flexible) (Page 155)
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Backing up recipe data and user administration (WinCC flexible)

Introduction
To continue using the recipe data and user administration in a migrated project, you first need 
to back up this data from the HMI device. Then load the data into the migrated WinCC project. 
Use ProSave to back up the data. 

Requirement
● The WinCC flexible project is running on the HMI device in Runtime.

● The HMI device is connected to a PC on which ProSave is installed.

Procedure
Proceed as follows to back up the recipe data and user administration:

1. Start ProSave.

2. Select the device type and the connection parameters in the "General" tab.

3. Open the "Backup" tab.

4. Select the "Recipes from the device memory" entry in the "Data type" box.
Do not select "Complete backup" because otherwise you will not be able to select separately 
when restoring the recipe data.

5. Navigate to the desired location in the "Save as" box and click "Start Backup".
The recipe data are saved.

6. Select "User administration" in the "Data type" box and click "Start Backup".
The user administration is saved.

For additional information refer to the online help for ProSave.

Alternative procedure
ProSave is automatically installed with WinCC flexible. The entire functional range of ProSave 
is available on the configuration PC within WinCC flexible via the menu command "Project > 
Transfer".

Alternatively, you can back up the recipe data and user administration via the ProSave 
integrated in WinCC flexible. Start WinCC flexible and select the menu command "Project > 
Transfer > Backup". Back up the recipe data and user administration as described in steps 4-6.

See also
Migration of runtime data (WinCC flexible) (Page 153)
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Restoring recipe data and user administration (WinCC flexible)

Introduction
To continue using saved recipe data and user administration after the migration, you first need 
to compile the migrated project and load it to the HMI device. You can then transfer the saved 
data to the HMI device. Use ProSave to restore the data. 

Requirement
● The migrated project has been transferred to the HMI device and is running in runtime.

● The HMI device is connected to a PC on which ProSave is installed.

Procedure
Proceed as follows to load the saved recipe data and user administration to the HMI device:

1. Start ProSave.

2. Select the device type and the connection parameters in the "General" tab.

3. Open the "Restore" tab.

4. Navigate to the location of the saved recipe data in the "Opening..." box and select the file.

5. Click "Start Restore".
The recipe data will be transferred to the HMI device..

6. Repeat steps 4-5 to restore the user administration.
The user administration will be transferred to the HMI device.

For additional information refer to the online help for ProSave.

Alternative procedure
ProSave is automatically installed with WinCC. The entire functional range of ProSave is 
available on the configuration PC within WinCC flexible via the menu command "Project > 
Transfer".

You can also restore the recipe data and user administration via the ProSave integrated in 
WinCC. Start WinCC and select the menu command "Online > Device maintenance > 
Restore". Restore the recipe data and user administration as described in steps 4-6.

See also
Migration of runtime data (WinCC flexible) (Page 153)
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Backing up log data (WinCC flexible)

Introduction
If an HMI device supports external memory media and the log data are saved there, the data 
remain on the memory medium. External memory media are for example StorageCard or a 
network drive. If a log is saved on an external memory medium, the migrated project accesses 
this storage location again after the migration. In this case the log data must not be backed up.

Backing up log data
If you want to back up the log data externally before the migration, you have the following 
options:

● Backup with the "ArchiveLogFile".
If you have already configured the "ArchiveLogFile" function in the WinCC flexible project, 
use this function to back up the data.

● Copy the log files by Copy&Paste with the Windows Explorer to an external memory 
medium or network drive.

See also
Migration of runtime data (WinCC flexible) (Page 153)

4.1.6.4 Migrating integrated projects (WinCC flexible)

Migration of integrated projects (WinCC flexible)

Introduction
The controllers and HMI devices contained in a project integrated in STEP 7 are linked together 
by the configuration. The configuration data of WinCC flexible and STEP 7 are also connected. 
When an integrated project is migrated, the complete project will be migrated with components 
from WinCC flexible and STEP 7. The connections remain intact.

 
 

 Note

It is advisable to compile and save an integrated project in WinCC flexible before you migrate 
it. You can be sure that the data in WinCC flexible and STEP 7 is synchronized if compilation 
was completed without errors.

 

Migrating an integrated project
When migrating an integrated project, the same requirements apply for the WinCC flexible 
component as those for the migration of a non-integrated WinCC flexible project. The objects 
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and properties contained in the WinCC flexible component must be supported by WinCC, for 
example, the HMI device or the communication driver. The "Online" property must be activated 
on the configured connection. A connection with deactivated "Online" property is not migrated.

In addition to the requirements for the WinCC flexible component, there are also requirements 
for the STEP 7 component of the integrated project. The objects and properties contained in 
the STEP 7 V5.4 SP5 or V5.5 component must be supported in STEP 7. For detailed 
information, refer to the documentation for STEP 7.     

To fully migrate an integrated project and then edit it, the following components must be 
installed on the PC performing the migration:

● STEP 7 V5.4 SP5 or STEP 7 V5.5

● WinCC flexible 2008 SP2 or WinCC flexible 2008 SP3

● STEP 7

If you only want to save the project in migration format, you can use the migration tool. See 
Migration principles (WinCC flexible) (Page 127) for additional information.

An integrated project is always fully migrated. If you only want to migrate the WinCC flexible 
project it contains, you need to separate it from the STEP 7 project before the migration. To 
separate the project from the integrated form, open the project in STEP 7 V5.4 SP5 or V5.5. 
Open the WinCC flexible project in the SIMATIC Manager. The project is opened with 
WinCC flexible. In WinCC flexible, select the menu command "Project > Copy project from 
STEP 7". WinCC flexible saves a non-integrated copy of the project.

See also
Migration (WinCC flexible) (Page 126)

Migrating integrated project (WinCC flexible) (Page 157)

Migration principles (WinCC flexible) (Page 127)

Migrating integrated project (WinCC flexible)

Introduction
When migrating an integrated project, the components from both the WinCC flexible project 
and the STEP 7 project will be migrated. This means you need to select the project file with 
the file extension "*.s7p" for migration. During migration, the data is copied from the existing 
project and migrated to a new project. You cannot migrate to an existing project.

The migration can be started in both the Portal view and the Project view.

You should only migrate a project in a newly started TIA portal.

If you only want to save the project in migration format, you can use the migration tool. See 
Migration principles (WinCC flexible) (Page 127) for additional information.
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Requirement
● STEP 7 V5.4 SP5 or STEP 7 V5.5 and all add-on packages used are installed.

● STEP 7 and all add-on packages used are installed.

● The TIA portal is newly started.

● No project is open in WinCC.

● An integrated project is available.

● The integrated project is not open.

Procedure
Proceed as follows to migrate an integrated project in the Portal view:       

1. Select the action "Start > Migrate Project".

2. In the "Source path" box, navigate to the project you want to migrate.

3. Select the "*.s7p" project file.

4. Change the information for the project to be created, if necessary. For example, change 
the project name or project path. The data to be migrated is created in the new project.

5. To migrate the project without hardware configuration, activate "Exclude hardware 
configuration".
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6. Click "Migrate".
A new project is created and migration of the data is started:

– The Project view opens.

– The progress of the migration is shown in a migration window.

– Warnings and errors about the migration process are displayed in the Inspector window 
under "Info > General".

– All information about the migration is saved in a log file.

– A message is displayed upon completion of the migration. The message contains a link 
that you can use to open the log.

7. Once migration is completed, save the project.

Once the migration is complete, you will find a newly created device for each migrated HMI 
device and controller in the project tree. These devices include the migrated data.

Opening the migration log at a later point in time
The migration log is saved together with the migrated project. You can view the log at a later 
point in time. Open the log as follows:

1. Open "Shared data > Logs" in the project navigation.

2. Double-click the log file. The migration log opens.

See also
Migration of integrated projects (WinCC flexible) (Page 156)

Migration principles (WinCC flexible) (Page 127)

4.1.6.5 Reference (WinCC flexible)

Migration of data types (WinCC flexible)

Introduction
To harmonize the data types used by PLCs and HMI systems, some data types of the internal 
HMI tags are renamed. The naming takes place in accordance with IEC conventions. Because 
only the names change, there are no changes to the internal tags for the configuration. 

The following table describes the mapping of the internal data types from WinCC flexible to 
the data types in WinCC.
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Migrating internal data types
The internal data types are mapped as follows during migration:    

Internal data types WinCC flexible Internal data types WinCC
Bool Bool
Char SInt
Byte USInt
Int Int
UInt UInt
Long DInt
ULong UDInt
Float Real
Double LReal
String WString
DateTime DateTime

Migrating external data types
See the following pages for how to map the available communication drivers.
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See also
Migrating data types of Allen-Bradley DF1 (WinCC flexible) (Page 161)

Migrating data types of Allen-Bradley DF485 (WinCC flexible) (Page 162)

Migrating data types of Allen-Bradley Ethernet IP (WinCC flexible) (Page 162)

Migrating data types of GE Fanuc SNP (WinCC flexible) (Page 163)

Migrating data types of LG GLOFA GM (WinCC flexible) (Page 163)

Migrating data types of Mitsubishi FX (WinCC flexible) (Page 164)

Migrating data types of Mitsubishi Protocol 4 (WinCC flexible) (Page 165)

Migrating data types of Modicon Modbus (WinCC flexible) (Page 165)

Migrating data types of Modicon Modbus TCP/IP (WinCC flexible) (Page 166)

Migrating data types of Omron Hostlink/Multilink (WinCC flexible) (Page 166)

Migrating data types of OPC (WinCC flexible) (Page 167)

Migrating data types of SIMATIC 500/505 DP (WinCC flexible) (Page 168)

Migrating data types of SIMATIC 500/505 serial (WinCC flexible) (Page 168)

Migrating data types of SIMATIC HMI HTTP Protocol (WinCC flexible) (Page 169)

Migrating data types of SIMATIC S5 AS511 (WinCC flexible) (Page 169)

Migrating data types of SIMATIC S5 DP (WinCC flexible) (Page 170)

Migrating data types of SIMATIC S7 200 (WinCC flexible) (Page 171)

Migrating data types of SIMATIC S7 300/400 (WinCC flexible) (Page 171)

Migrating data types of Telemecanique Uni-Telway (WinCC flexible) (Page 174)

Migrating data types of Allen-Bradley DF1 (WinCC flexible)

Migrating data types Allen-Bradley DF1
The data types of the Allen-Bradley DF1 communication driver are mapped as follows in the 
migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
ASCII ASCII
BCD4 UInt
BCD8 UDInt
Bit Bool
Int Int
Long DInt
Real Real
UInt UInt
ULong UDInt
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See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of Allen-Bradley DF485 (WinCC flexible)

Migrating data types Allen-Bradley DH485
The Allen-Bradley DH485 communication driver is not supported by WinCC, it is replaced by 
the Allen-Bradley DF1 driver. The data types of the Allen-Bradley DH485 communication driver 
are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
ASCII ASCII
Bit Bool
Int Int
Long DInt
Real Real
UInt UInt
ULong UDInt

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of Allen-Bradley Ethernet IP (WinCC flexible)

Migrating data types Allen-Bradley Ethernet IP
The data types of the Allen-Bradley Ethernet IP communication driver are mapped as follows 
in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
DInt DInt
Int Int
Real Real
SInt SInt
String String
UDInt UDInt
UInt UInt
USInt USInt
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See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of GE Fanuc SNP (WinCC flexible)

Migrating data types GE Fanuc SNP
The GE Fanuc SNP communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the GE Fanuc SNP 
communication driver are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
BCD4 UInt
BCD8 UDInt
Bit Bool
Byte USInt
DInt DInt
Word UInt
Int Int
Real Real
UInt UInt
DWord UDInt

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of LG GLOFA GM (WinCC flexible)

Migrating data types LG GLOFA GM
The LG GLOFA GM communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the LG GLOFA GM 
communication driver are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte USInt
DInt DInt
DWord UDInt
Int Int
SInt SInt
String WString

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  163



Data type in WinCC flexible Data type in WinCC
Time UDInt
UDInt UDInt
UInt UInt
USInt USInt
Word UInt

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of Mitsubishi FX (WinCC flexible)

Migrating data types Mitsubishi FX
The data types of the Mitsubishi FX communication driver are mapped as follows in the 
migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
12 Bit Block 12-Bit Block
16 Bit Block 16-Bit Block
20 Bit Block 20-Bit Block
24 Bit Block 24-Bit Block
28 Bit Block 28-Bit Block
32 Bit Block 32-Bit Block
4 Bit Block 4-Bit Block
8 Bit Block 8-Bit Block
Bit Bool
Double DWord
IEEE-Float Real
String String
Word Word

See also
Migration of data types (WinCC flexible) (Page 159)
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Migrating data types of Mitsubishi Protocol 4 (WinCC flexible)

Migrating data types Mitsubishi Protocol 4
The Mitsubishi Protocol 4 communication driver is not supported by WinCC, it is replaced by 
the Mitsubishi MC TCP/IP driver. The data types of the Mitsubishi Protocol 4 communication 
driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
4 Bit Block 4-Bit Block
8 Bit Block 8-Bit Block
12 Bit Block 12-Bit Block
16 Bit Block 16-Bit Block
20 Bit Block 20-Bit Block
24 Bit Block 24-Bit Block
28 Bit Block 28-Bit Block
32 Bit Block 32-Bit Block
Bit Bool
DInt DInt
DWord DWord
Int Int
Real Real
String String
Word Word

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of Modicon Modbus (WinCC flexible)

Migrating data types Modicon Modbus
The Modicon Modbus communication driver is not supported by WinCC, it is replaced by the 
Modicon Modbus RTU driver. The data types of the Modicon Modbus communication driver 
are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
+/-Double  +/- Double
+/-Int  +/- Int
16 Bit Group 16 Bit Group
ASCII ASCII
Bit Bit
Double Double
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Data type in WinCC flexible Data type in WinCC
Float Float
Int Int

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of Modicon Modbus TCP/IP (WinCC flexible)

Migrating data types Modicon Modbus TCP/IP
The data types of the Modicon Modbus TCP/IP communication driver are mapped as follows 
in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double  +/- Double
+/-Int  +/- Int
16 Bit Group 16 Bit Group
ASCII ASCII
Bit Bit
Double Double
Float Float
Int Int

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of Omron Hostlink/Multilink (WinCC flexible)

Migrating data types Omron Hostlink/Multilink
The Omron Hostlink/Multilink communication driver is not supported by WinCC, it is replaced 
by the Omron Host Link driver. The data types of the Omron Hostlink/Multilink communication 
driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-DEC Int
+/-LDEC DInt
ASCII String
BIN Bool
BYTE Byte
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Data type in WinCC flexible Data type in WinCC
DEC UInt
IEEE Real
LDEC UDInt

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of OPC (WinCC flexible)

Migrating data types OPC
The data types of the OPC communication driver are mapped as follows in the migration to 
WinCC:   

Data type in WinCC flexible Data type in WinCC
Bool VT_BOOL
Byte VT_UI1
Char VT_I1
Date VT_DATE
Double VT_R8
DWord VT_UI4
Float VT_R4
Long VT_I4
Short VT_I2
String VT_BSTR
Word VT_UI2

See also
Migration of data types (WinCC flexible) (Page 159)
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Migrating data types of SIMATIC 500/505 DP (WinCC flexible)

Migrating data types SIMATIC 500/505 DP
The SIMATIC 500/505 DP communication driver is not supported by WinCC, the data types 
are mapped to the internal data types of WinCC. The data types of the SIMATIC 500/505 DP 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double DInt
+/-Int Int
ASCII WString
Bit Bool
Double UDInt
Int UInt
Real Real

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of SIMATIC 500/505 serial (WinCC flexible)

Migrating data types SIMATIC 500/505 seriell
The SIMATIC 500/505 seriell communication driver is not supported by WinCC, the data types 
are mapped to the internal data types of WinCC. The data types of the SIMATIC 500/505 seriell 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double DInt
+/-Int Int
ASCII WString
Bit Bool
Double UDInt
Int UInt
Real Real

See also
Migration of data types (WinCC flexible) (Page 159)
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Migrating data types of SIMATIC HMI HTTP Protocol (WinCC flexible)

Migrating data types SIMATIC HMI HTTP Protocol
The data types of the SIMATIC HMI HTTP Protocol communication driver are mapped as 
follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte USInt
Char SInt
DateTime DateTime
Double LReal
Float Real
Int Int
Long DInt
String WString
UInt UInt
ULong UDInt

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of SIMATIC S5 AS511 (WinCC flexible)

Migrating data types SIMATIC S5 AS511
The SIMATIC S5 AS511 communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the SIMATIC S5 AS511 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
Bit in D Bool
Bit in W Bool
DF DInt
DH UDInt
KC WString
KF Int
KG Real
KH UInt
KM UInt
KT UDInt
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Data type in WinCC flexible Data type in WinCC
KY UInt
KZ UInt

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of SIMATIC S5 DP (WinCC flexible)

Migrating data types SIMATIC S5 DP
The SIMATIC S5 DP communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the SIMATIC S5 DP 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
Bit in D Bool
Bit in W Bool
DF DInt
DH UDInt
KC WString
KF Int
KG Real
KH UInt
KM UInt
KT UDInt
KY UInt
KZ UInt

See also
Migration of data types (WinCC flexible) (Page 159)
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Migrating data types of SIMATIC S7 200 (WinCC flexible)

Migrating data types SIMATIC S7 200
The data types of the SIMATIC S7 200 communication driver are mapped as follows in the 
migration to WinCC:     

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte Byte
Char Char
DInt DInt
DWord DWord
Int Int
Real Real
StringChar StringChar
Timer Timer
Word Word

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of SIMATIC S7 300/400 (WinCC flexible)

Migrating data types SIMATIC S7 300/400
The data types of the SIMATIC S7 300/400 communication driver are mapped as follows in 
the migration to WinCC:     

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte Byte
Char see below
Counter see below
Date Date
Date and Time Date_And_Time
DInt DInt
DWord DWord
Int Int
Real Real
String String
StringChar see below
Time Time
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Data type in WinCC flexible Data type in WinCC
Time of Day Time_Of_Day
Timer see below
Word Word

Special considerations for some data types
There are special considerations to be made when migrating external tags that contain data 
types of a SIMATIC S7-300/400 PLC.

Mapping of the S7 data type "Char"
The S7 data type "Char" is a data type for mapping characters according to the specification. 
However, since this data type is often used for reading and writing numerical values, it is 
mapped in WinCC to the S7 data type "Byte". If this should be the case during migration, an 
alarm will appear in the output window.

If the S7 data type "Char" is used for numerical values and negative numbers were configured 
at the point of use, the result is an error in mapping to the S7 data type "Byte". The S7 data 
type "Byte" cannot map any negative numbers. You have to adapt the configuration accordingly 
to correct the error. Use a signed data type, such as the data type "Int", for processing positive 
and negative numerical values.

If the S7 data type "Char" is used for mapping characters, you must change the configuration 
after migration. To represent characters, use the data type "String".

When an integrated project is migrated, the data type "Char" in WinCC is also migrated to the 
data type "Byte". With a connected PLC tag, the data type "Char" remains "Char". As a result 
of changing the data type of the HMI tag, symbolic addressing of the tags in question is not 
migrated. After migration. the tags are interconnected by absolute addresses and continue to 
work. If you want to restore symbolic addressing, you have to change the configuration 
accordingly after the migration.

Mapping an array of the S7 data type "Char"
An array of the S7 data type "Char" is mapped to an array of the data type "Byte" during 
migration.

If an array of the S7 data type "Char" is used for numerical values and negative numbers were 
configured at the point of use, the result is an error in mapping to an array of the S7 data type 
"Byte". The S7 data type "Byte" cannot map any negative numbers. You have to adapt the 
configuration accordingly to correct the error. Use a signed data type, such as the data type 
"Int", for processing positive and negative numerical values.

Mapping of the S7 data type "Counter"
An external tag with the S7 data type "Counter" with counter address is mapped to the S7 data 
type "Counter". The address will be retained.

If an external tag with the S7 data type "Counter" addresses a data block or a bit memory 
address, it is is mapped to the S7 data type "Word". The address will be retained. The migration 
sets the coding to "SimaticBCDCounter".
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The S7 data type "Counter" has a value range of 0-999. When supplied by the S7 data type 
"Word" the value range may be exceeded on the PLC side. Ensure that you are observing the 
value range.

Example:

WinCC flexible

Tag S7 data type Address Comment
Counter_Actual_Value Counter C10 BCD coded counter value
Counter_Setpoint_Value Counter DB10.DBW200 BCD coded counter value
Counter_Setpoint_Value#2 Counter MW20 BCD coded counter value

WinCC

Tag S7 data 
type

Address Coding Comment

Counter_Actual_Value Counter %C10 <Standard> BCD coded counter 
value

Counter_Setpoint_Value Word %DB10.%DB
W200

SimaticBCDCounter BCD coded counter 
value

Counter_Setpoint_Value#2 Word %MW20 SimaticBCDCounter BCD coded counter 
value

Mapping of the data type "StringChar"
In WinCC there is no corresponding data type to which the "StringChar" data type can be 
mapped. Mapping in WinCC depends on the property "Length" of the S7 data type.

A tag of the "StringChar" data type with the "Length" property > 1 is migrated to an array of 
the S7 data type "Char". The length of the array corresponds to the length of the originally 
configured data type "StringChar".

If the property "Length" = 1, the data type in WinCC is migrated to an array of the S7 data type 
"Char" with length = 1. The expression for an array with an element is "Array[0 ..0] of Char".

Mapping of the S7 data type "Timer"
An external tag with the S7 data type "Timer" with timer address is mapped to the S7 data type 
"Timer". The address will be retained.

If an external tag with the S7 data type "Timer" addresses a data block or a bit memory address, 
it is is mapped to the S7 data type "S5 Time". The address will be retained.

Example:

WinCC flexible
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Tag S7 data type Address Comment
Timer_Actual_Value Timer T10 BCD coded timer value
Timer_Setpoint_Value Timer DB10.DBW200 BCD coded timer value
Timer_Setpoint_Value#2 Timer MW20 BCD coded timer value

WinCC

Tag S7 data type Address Comment
Timer_Actual_Value Timer %T10 BCD coded timer value
Timer_Setpoint_Value S5Time %DB10.%DBW200 BCD coded timer value
Timer_Setpoint_Value#2 S5Time %MW20 BCD coded timer value

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating data types of Telemecanique Uni-Telway (WinCC flexible)

Migrating data types Telemecanique Uni-Telway
The Telemecanique Uni-Telway communication driver is not supported by WinCC, the data 
types are mapped to the internal data types of WinCC. The data types of the Telemecanique 
Uni-Telway communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Int Int
+/-Long DInt
ASCII WString
Bool Bool
Float Real
Int UInt
Long UDInt

See also
Migration of data types (WinCC flexible) (Page 159)

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Comfort/Advanced V12.0 SP1
174 System Manual, 07/2013,  



4.1.7 Migrating integrated projects

4.1.7.1 Migrating an integrated project

Introduction
When an integrated project is migrated, the complete project will be migrated with components 
from WinCC and STEP 7. Configured connections between control and visualization remain 
intact.

Migrating an integrated project   
When migrating an integrated project, the same requirements apply for the STEP 7 component 
as those for migration of a non-integrated STEP 7 project. The objects and properties contained 
in the WinCC component must also be supported in WinCC (TIA Portal). For detailed 
information, refer to the documentation for WinCC.     

Also note that the initial project must be compiled before the migration.

To fully migrate an integrated project, the following components must be installed on the PG/
PC performing the migration:

● STEP 7 V5.4 SP5 or STEP 7 V5.5

● WinCC V7.0 SP3 or WinCC Flexible 2008 SP2 and SP3

To be able to fully post-edit an integrated project, the following components must be installed 
on the PC for post-editing:

● STEP 7 Professional V12 SP1

● WinCC Basic, WinCC Comfort/Advanced or WinCC Professional, depending on the 
components used

Using the migration tool
It is necessary to use the migration tool under the following circumstances:

● The initial project is not located on the same PG/PC as the installation of the TIA Portal.

● SCADA devices are included in the initial project. These can only be migrated with the 
migration tool.

● WinCC Professional V12 and STEP 7 with WinCC V7.0 SP3 cannot be installed on the 
same PG / PC. Therefore, integrated projects with WinCC V7.0 SP3 parts must be prepared 
for migration with the migration tool.

Migration of the STEP 7 part of an integrated project
An integrated project is always fully migrated. Individual components cannot be migrated on 
their own. You can only migrate the included STEP 7 project alone, if you have previously 
deleted all HMI stations in the SIMATIC stations in the SIMATIC Manager and then recompiled 
the project in NetPro.
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Alternatively, you can open the project in an installation of STEP 7 V5.4 SP5 or V5.5 without 
an installation of WinCC. Then, save the project again and select the "Reorganize" function 
during saving. The WinCC parts are then automatically removed when the copy is saved.

You can then migrate the STEP 7 project without the WinCC project.

Migration of an integrated project with the hardware configuration
In integrated projects, HMI devices are migrated even if the hardware configuration is not 
included in the migration. The STEP 7 part of the hardware configuration, including network 
configurations, and connections and interrupts, is migrated only if you include the hardware 
configuration in the migration. Otherwise, unspecified modules will be created for the STEP 7 
devices and you will need to convert them into suitable modules after the migration.

HMI modules that are plugged into a PC station are converted to a separate Station during the 
migration. If you perform the migration without including the hardware configuration, the 
migrated project then contains a non-specified SIMATIC PC Station and a SIMATIC PC Station 
with the HMI devices. References to HMI devices are not imported during migration. When the 
hardware configuration is included, the migrated project contains two separate stations: the 
HMI Station and the PC Station.

Storage location of an integrated WinCC project
If you migrate an integrated project, the HMI part of it must be on the same PG/PC as the 
STEP 7 part of the project. If the HMI part is on a different PG, then only the STEP 7 part will 
be migrated.

Unsupported objects
The following components are not supported for migration:

● STEP 7 multiproject
A STEP 7 multiproject cannot be migrated. Migration will be canceled.

● Central Archive Server - CAS
If a CAS is part of an integrated project, then the migration will be carried out but the CAS 
data will not be migrated.

See also
Post-editing integrated projects (Page 176)

4.1.7.2 Post-editing integrated projects
If you have migrated an integrated project without hardware configuration, unspecified CPUs 
are used instead of the CPUs of the original project. Since no connection can exist between 
an unspecified CPU and an HMI device, connections from the source project are also imported 
only unspecified. 

The following figure shows the state after a Migration without hardware configuration in an 
example project:
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1

2

① The original CPU 317-2 PN/DP was replaced with an unspecified CPU during migration.
② The link between the CPU and HMI device is also unspecified and must be renewed.

Procedure
To continue to use an integrated project after the migration, follow these steps:

1. Convert the unspecified devices into suitable devices again.

2. Restore the integrated HMI connection between the HMI device and the PLC.

3. Connect all HMI tags to the newly created integrated connection.

4. Restore the connection between HMI tags and PLC tags.

5. Delete the non-integrated HMI connection.

In the following chapters a sample project is used to describe the individual steps in more detail.

See also
Converting unspecified CPUs into specified CPUs (Page 178)

Creating an integrated HMI connection (Page 179)

Re-linking HMI tags (Page 181)

Deleting an unspecified connection (Page 182)
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4.1.7.3 Converting unspecified CPUs into specified CPUs
The first step after the migration without hardware configuration is the conversion of the 
unspecified CPUs into specified CPUs. Unspecified CPUs are placeholders for certain CPUs 
from the hardware catalog that are not currently known. You can define general parameters 
and home the CPUs already in the user program. However, the project is not fully functional 
until the unspecified CPU has been specified.

Specifying a CPU using module replacement    
To use module replacement to specify an unspecified CPU, follow these steps:

1. Select the unspecified CPU in the network or device view.

2. Select the "Replace device" command in the shortcut menu.
The "Replace device" dialog opens.

1

2
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3. Under "New device" in the tree structure, select the module with which you want to replace 
the unspecified CPU. (Area 1)
"Compatibility information" provides you with information on the extent to which the selected 
CPU is compatible with the configuration in source project. (Area 2)

4. Click "OK".

5. Perform the above-described steps for all unspecified CPUs.

See also
Creating an integrated HMI connection (Page 179)

4.1.7.4 Creating an integrated HMI connection
After you have specified the unspecified CPU, establish the connection to the HMI-device.

Procedure   
To create a connection graphically, follow these steps:

1. On the toolbar, click the "Connections" icon. This activates connection mode.

2. Select the connection type "HMI connection" in the adjacent drop-down list.
The network view highlights in color all CPUs and HMI devices that can be used for an HMI 
connection.

3. You can now have the connection path automatically determined, or explicitly select a 
connection path via specific interfaces:

– Allow connection path to be automatically determined
Select the source CPU for a connection. Drag the mouse to the target components. 
Confirm the connection endpoint with another mouse click.
Alternatively: While holding down the shift button, select the target components and with 
the right mouse button select the "Add new connection" command.

– Selecting an explicit connection path from interface to interface
Click on the subnet interface in the device for which you want to create a connection. 
Hold down the mouse button, drag the cursor to the relevant interface in the target device 
and then release the mouse button.
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Result
The following figure shows the state after the integrated connection has been created:

1

2

3

① An integrated HMI connection is created and highlighted in the network view.
② The connection is shown in the connection table of the components.
③ The connection can be edited in the connection properties.

 

See also
Re-linking HMI tags (Page 181)
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4.1.7.5 Re-linking HMI tags
When you have created a new HMI connection between the CPU and HMI device, you have 
to assign the existing HMI tags to the new connection. Perform the following steps for each 
line in the relevant tag table.

Procedure   
To re-link HMI tags, follow these steps:

1. In the project tree, navigate to the HMI tags and double-click the relevant tag table to show 
this in the work area.
The tag table opens.

2. Click the " ... " button in the "Connection" column.
A dialog box for selecting the connection opens.

3. Select the newly established HMI connection.

4. Click the "✓" button to apply the selected connection.

5. On the toolbar, click the "Re-connect PLC tag" button.
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See also
Deleting an unspecified connection (Page 182)

4.1.7.6 Deleting an unspecified connection
Finally, you can remove unspecified connections that still remain from the source project.

Procedure   
To delete unspecified connections, follow these steps:

1. In the project tree, open the HMI device and double-click the "Connections" entry.
The connection table opens.

2. Select the row with the old connection in the table.

3. Select the "Delete" command in the shortcut menu of the connection line.

4. Perform the above-described steps for all unspecified connections of the source project.
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4.2 Programming recommendations

4.2.1 The new S7-1500 CPU functions at a glance

Higher performance
The S7-1500 represents a CPU series that provides much higher performance than the CPUs 
of the S7-300/400 series. When programming with STEP 7 V5.x, you were probably used to 
working with programming methods such as absolute addressing to achieve higher 
performance from the CPU and leaner program code.

Due to the high performance that the S7-1500 provides, these programming methods are made 
obsolete.

In the paragraphs below we would like to introduce some new programming options of the 
S7-1500.

Universal symbolism
The S7-1500 allows you to use the symbolism throughout the entire project. Using the auto-
complete function, you are given context-dependent support for programming with symbols 
within the programming editors. The data elements, for example those in a data block, are 
assigned only a symbolic name in the declaration but no fixed address within the data block. 
This allows you to fully exploit the high performance of the S7-1500 when accessing these 
data elements. The absolute addresses of operands need not be known and access errors 
are avoided.

Your program code will be clearer due to the symbolism and you have to comment less. All 
points of use are automatically updated when a correction is made to the symbolism.

An example of the use of universal symbols is available at: Symbolic addressing (Page 185)

Optimized block access
With optimized block access, the declared data elements are arranged automatically in the 
available memory area of the block in a way that makes optimal use of its capacity. The data 
is structured and saved in way that is optimal for the CPU used. The storage is left to the 
system. The data elements are assigned only a symbolic name in the declaration by which the 
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tag within the block can be addressed. This allows you to increase the performance of the 
CPU. Access errors, from the HMI, for example, are not possible.

You can find additional information on blocks with optimized access under "See also".

New data types
The new data types LWORD, LINT, ULINT, LTIME, LTOD, LDT and the array (32-bit limit) 
offer much higher calculation accuracy when using mathematical functions. In the area of 
implicit and explicit data type conversion, you have more options in comparison to the CPUs 
of the S7-300/400 series.

You can find additional information on the new data types under "See also".

PLC data types
PLC data types (UDT) are data structures that you define and that can be used multiple times 
within the program. The structure of a PLC data type is made up of several components, each 
of which can contain different data types. You define the type of components in the declaration 
of the PLC data type.
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You can use the PLC data type as a base data type for defining tags and as a template for 
creating global data blocks. If you later make changes to the PLC data type, the changes are 
automatically updated at all points of use.

You can also symbolically access individual elements of an array within a PLC data type.

You can find additional information on the new data types under "See also".

You can find an example for using PLC data types under: Using PLC data types (UDT) 
(Page 194)

Uniform instructions in all programming languages
You are provided with a uniform set of instructions in all programming languages (LAD, FBD, 
STL, SCL, and GRAPH).

Slice access
Slice access gives you the option of specifically addressing areas within declared tags. You 
can implement symbolic access to a single bit up to the level of the tag. The single bit is then 
addressed absolutely.

You can find additional information on slice access under "See also".

Indirect addressing
Indirect addressing offers you the option of addressing operands whose address is not 
calculated until runtime. All programming languages provide general methods for indirect 
addressing, for example, via POINTER. In the SCL programming language, you can also use 
PEEK and POKE instructions.

You can find additional information on indirect addressing under "See also".

FAQs
You can find additional information on the programming recommendations under FAQ ID: 
67582299 (http://support.automation.siemens.com/WW/llisapi.dll?
aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&Datakey=47071380&extranet=standard&groupid=4000
002&viewreg=WW&nodeid0=29156492&objaction=csopen)

4.2.2 Symbolic addressing

Advantages of symbolic addressing
The use of universally applied and meaningful symbols in the overall project makes the 
program code easier to read and understand.

This gives you the following advantages:
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● You do not have to write detailed comments.

● Data access is faster.

● No errors occur when accessing data.

● You no longer have to work with absolute addresses.

● The assignment of the symbol to the memory address is monitored by STEP 7, which 
means all points of use are automatically updated when the name or the address of a tag 
changes.

Programming in STEP 7 V5.x
STEP 7 V5.x already gave you the option to write a program that is easier to read by using 
descriptive names for operands and blocks. You did this by assigning the symbolic operands 
to memory addresses and blocks in the symbol table. In order for a change in the symbolism 
to also have an affect on the program code in the programming editor, you had to use the 
"Operand priority" property to specify whether the symbol or the absolute value had priority.

The use of symbolic addressing allowed you to create a program with greater clarity. However, 
in some cases, such as when programming with user-defined data types (UDT), this could 
impair performance.

You could increase the performance by ignoring the symbolism in the UDT and using absolute 
addressing. This made in necessary, however, to know the data storage. Changes to the UDT 
were not automatically updated. Using absolute addressing, you could also access parts of a 
tag and edit these. The only drawback of absolute addressing, however, was that after a certain 
level the program code was cluttered and you had to insert additional comments for better 
orientation.

Procedure in STEP 7 TIA Portal
The S7-1500 CPU offers much higher performance than the S7-300/400 CPUs. To fully use 
this high performance, we recommend you enable optimized block access for all blocks and 
use symbolic addressing in the program code.

The programming editor helps you work with symbols through context-sensitive input help, for 
example, auto-complete. Using it, you can easily access existing tags or instructions during 
programming.
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Programming example
The following example shows you how to symbolically access individual elements:

You can use the tag names that you have defined in the block interface directly at the 
parameters of the TON instruction without knowing the absolute address of the tag.

4.2.3 Using IEC timers and counters

Advantages of IEC timers and counters
The universal use of IEC timers and counters makes your program code more efficient.

This gives you the following advantages:

● The blocks can be called multiple times with newly generated instance data blocks.

● The IEC counters have a large counting range.

● Compared to S5 timers, IEC timers have better performance and greater time accuracy.

Programming in STEP 7 V5.x
The S5 timers and counters in STEP 7 V5.x were addressed absolutely via a number. Due to 
this dependency on numbers, program blocks were not reusable with S5 timers and counters.

The value range of a timer was limited to 9990 seconds and that of a counter limited to a 
maximum of 999.

Migrating projects and programs
4.2 Programming recommendations

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  187



Procedure in STEP 7 TIA Portal
You declare IEC timers and counters in the program block where they are called or needed. 
The IEC timer is a structure of data type IEC_TIMER, IEC_LTIMER, or TON_TIME and 
TON_LTIME, for example, which you can also declare as a local tag in a block. The IEC counter 
is a structure of data type IEC_SCOUNTER, IEC_USCOUNTER, etc.

Programming example in the TIA Portal
The following example shows you how to declare an IEC timer and IEC counter as a local tag:

The data of the TON IEC timer and the CTU IEC counter is stored as a local tag (multi-instance) 
in the block interface.

4.2.4 Flexibly using enable output ENO

Advantages
You can to detect runtime errors and avoid program termination using the EN/ENO mechanism 
for each instruction and block call. Overflow, for example, is reported via the ENO enable 
output for mathematical functions.

In STEP 7 TIA Portal, the ENO enable output is disabled by default in the programming 
languages LAD and FBD. If needed, you can activate the enable output and thereby 
deliberately target the instructions for which you want to have error evaluation.

This gives you the following advantages:
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● The performance increases with ENO disabled.

● Runtime errors do not cause the CPU to go to STOP when ENO is enabled.

Procedure in STEP 7 TIA Portal
Proceed as follows to activate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to activate the EN/ENO 
mechanism.

2. Select the "Generate ENO" command from the shortcut menu.
The ENO value is generated for the instruction. Other instructions are inserted with the 
enable output.

The tables below list the instructions for which ENO enable output can be disabled:

Basic instructions
Math functions ADD, SUB, MUL, DIV, MOD, INC, DEC, ABS, NEG, SQR, SQRT, LN, 

EXP, SIN, COS, TAN, ASIN, ACOS, ATAN, FRAC, EXPT, MIN, MAX, 
LIMIT, CALCULATE

Move operations MOVE, SWAP, MOVE_BLK, UMOVE_BLK, FILL_BLK, UFILL_BLK, 
MOVE_BLK_VARIANT

Conversion operations CONVERT, ROUND, CEIL, TRUNC, FLOOR, NORM_X, SCALE_X
Word logic operations AND, OR, XOR, INV, DECO, ENCO
Shift and rotate SHR, SHL, ROR, ROL

 

Extended instructions
String + Char CONCAT, LEFT, RIGHT, MID, DELETE, INSERT, REPLACE, FIND, 

LEN, S_CONV
Date and time T_CONV

You can find additional information on the EN/ENO mechanism in each programming language 
under "See also".
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Programming example
The following example shows you how to use instructions with the ENO enable output enabled 
and disabled:

If you have activated the ENO enable output, for example with the SUB instruction, all 
subsequent instructions are also applied with an activated enable output. If an arithmetic error 
occurs during the execution of the SUB instruction, the ADD instruction is not executed. 

The ENO enable output is disabled for the DIV instruction in the second branch. If a runtime 
error occurs during execution, the MUL instruction is executed anyway.

4.2.5 Using MOVE instructions in STL

Possible applications
You can now program with MOVE instructions in STL on an S7-1500 CPU.

This gives you the following advantages:

● The program structure is easier to create.

● The performance of the CPU increases.

Programming in STEP 7 V5.x
In STEP 7 V5.x, you used the "BLKMOV: Move block" and "UBLKMOV: Move block 
uninterruptible" system functions to implement the MOVE functionality.
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Procedure in STEP 7 TIA Portal
The following new MOVE instructions are available in STEP 7 TIA Portal:

● MOVE: Move value

● MOVE_BLK: Move block

● MOVE_BLK_VARIANT: Move block

● UMOVE_BLK: Move block uninterruptible

You can find additional information on the new MOVE instructions under "See also".

Programming example
The following example shows you how the "MOVE_BLK instruction works: Move block". An 
array block is copied into another array block:
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Using the MOVE_BLK instruction, ten elements from "Array_1" of the "Data_DB" data block 
are copied into "Array_2" of the same data block.

4.2.6 Implementing array access with a variable index

Advantages of the variable index
For addressing the components of an array, you can specify tags of the integer data type as 
well as constants as the index. Integers with lengths up to 32 bits are allowed here. When tags 
are used, the index is calculated during runtime. You can, for example, use a different index 
for each cycle in program loops. You can also access an array within a PLC data type.

This gives you the following advantages:

● No need for addressing with address registers or a self-generated POINTER.

● More flexibility within your program.

● The variable index is available in all STEP 7 programming languages.

● It uses the existing names of data blocks and array tags. This improves readability of the 
program code.

● The start address of the array does not have to be known.

● The program code is easier to write.

● The compiler generates optimized program code.

Procedure in STEP 7 V5.x
In STEP 7 V5.x, you had to use an address register with the help of a self-configured POINTER 
for indexed addressing of array elements. The SCL programming language already supported 
indirect addressing with variable index.

Programming example in STEP 7 V5.x
The "Data_classic" data block is required for the following STL example. To address an 
element of the "Quantities" array, the following commands must be used:

STL Explanation
OPN "Data_classic" // The "Data_classic" data block is called.
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STL Explanation
L #index // The value of the local tag #index is loading in 

accumulator 1.
SLD 3 // Move bits 0 to 31 of accumulator 1 by 3 positions to 

the left.
// Fill the now empty bit places with zeros.

LAR1 // Load address register 1 with contents of accumulator 
1.

L DBW [AR1, P#10.0] // Load the array element addressed with #index into 
accumulator 1.
// P#10.0 = Start address of the array

You need to consider the following with this procedure, however:

● The array name is not used. This reduces the readability of the program code and makes 
it necessary to add a comment.

● The start address of the array (P#10.0) must be known to perform the addressing.

● The indexed addressing must involve the use of the address register.

Programming example in STEP 7 TIA Portal
The following syntax is used for indirect indexing of the "Quantities" array that was declared 
in the "Data_DB" data block:

  
"Data_DB".Quantities["i"] // One-dimensional array
"Data_DB".Quantities["i"].a // One-dimensional array of STRUCT
"Data_DB".Quantities["i","j"] // Multi-dimensional array
"Data_DB".Quantities["i","j"].a // Multi-dimensional array of STRUCT

Part Description
Data_DB Name of the data block in which the array is located
Quantitie
s

Tag of the Array data type

i, j PLC tags of the integer data type that are used as pointers
a Additional partial tag of the structure

The following example shows indirect indexing of an array component in STL.

You need another program line for addressing an array element:

Addressing in STL Explanation
L "Data_DB".Quantities[#index] // The value of the array element #index 

is loaded directly from the data block 
into accumulator 1.

Note the following to get the best performance:
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● Declare tags that are used as an array index as an integer of less than or equal to 32 bits.

● Store intermediate results and array indexes in the temporary local data area.

4.2.7 Using PLC data types (UDT)

Advantages of the PLC data types
PLC data types (UDT) are data structures that you define and that can be used multiple times 
within the program. The structure of a PLC data type is made up of several components, each 
of which can contain different data types. You define the type of components in the declaration 
of the PLC data type. By using PLC data types, you can optimally exploit the high performance 
of the S7-1500 CPU.

Many programs require contiguous data records that have to be processed by different 
locations in the program. They are optimized or replaced as the program runs. These are, for 
example:

● Data records for material tracking

● A parameter set for a motor setting

● Various recipes

This gives you the following advantages:

● PLC data type elements can also be addressed indirectly, which means the address is 
variable and is first calculated in runtime.

● Tags based on a PLC data type inherit all properties of the PLC data type.

● Modifying the PLC data type results in automatic adjustment of all tags derived from it.

● Using universal symbolism makes the program easier to read, because the names of the 
individual elements of a PLC data type are displayed in the program.

● Increased performance because optimized program code is generated.

● The PLC data type can be passed as a complete structure for a block call.

● Simplified calling interface due to fewer parameters that have to be supplied.

Procedure in STEP 7 V5.x
STEP 7 V5.x already gave you the option to create a data record as a structured tag using the 
STRUCT data type or a PLC data type (UDT). However, the performance was adversely 
affected by the use of symbolic addressing.

The declaration in the data blocks was mostly implemented as an anonymous structure. The 
blocks themselves were then programmed to pass the values of the structure as actual 
parameters and the calculated values were copied back into the structure. This enabled you 
to also pass the data block number and use absolute addressing in the block. The number of 
parameters that you had to supply was often very large. The actual data was stored in the data 
blocks and the calculated values were passed to other blocks. But no symbolism was available 
when passing the data block tags.
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Procedure in STEP 7 TIA Portal
If you work with PLC data types in your program, you can assign them to both a formal 
parameter and an actual parameter. This means you no longer have to declare each individual 
parameter. If a block has an input parameter that is based on a PLC data type, you must 
transfer a tag that has the same PLC data type as an actual parameter.

To use a PLC data type, follow these steps:

1. Declare the data records as PLC data type with a suitable name, for example, "Material 
tracking".

2. Use this data type to declare a data block or a DB tag.

3. Define the formal parameter as VAR_IN_OUT / VAR_IN or VAR_OUT tag in the block 
interface.

4. Assign the PLC data type to the formal parameter in the "Data type" column.

Programming example in the TIA portal
The following example shows the call and the parameter assignment of a function block (FB) 
with two formal parameters. The data type of the DB tag (Array [1 .. 10] of BOOL) and the PLC 
data type (UDT) are identical to the data types of the FB parameters.

 

Declare the "UserDataType" PLC data type in the project tree in the "PLC data types" folder. 
Then use it as a data type for the "UserData_Var" tag. You declare both tags "UserData_Var" 
and "Arr_Var" in the "Data_block_1" data block and use them to supply the parameters of the 
"FB_Module" block.
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First steps 5
5.1 Getting Started Documentation

Getting started with the TIA Portal
The Getting Started documentation is available to help you begin using the TIA portal.

The Getting Started documentation contains instructions which show you, step-by-step how 
to create a project in the TIA portal and give you the chance to get a quick overview of all the 
possibilities the TIA portal offers you.

Contents
The Getting Started documents describe the creation of a single, continuous project for STEP 7 
and WinCC that is extended with each chapter. You start with simple basic functions, and use 
more complex ones as you continue with the creation of the project.

In addition to the step-by-step instructions, the Getting Started documents also give you 
background information that explains the functions used and illustrate how they relate to each 
other.

Target audience
The Getting Started documents are intended for beginners, but are also useful for users 
migrating from a previous version of SIMATIC STEP 7 and WinCC.

Download
The documentation is available, free of charge at the Service&Support (https://
support.automation.siemens.com) portal in PDF form. 

You can download the documents here:

● STEP 7 Basic and WinCC Basic (V10.5) (http://support.automation.siemens.com/WW/
view/en/40263542/0/en)

● STEP 7 Professional and WinCC Advanced (V11) (http://support.automation.siemens.com/
WW/view/en/28919804/133300)

● STEP 7 Professional and WinCC Advanced (V12) (http://www.automation.siemens.com/
salesmaterial-as/interactive-manuals/getting-started_simatic-s7-1500/_content/EN/
content_en.html)
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Introduction to the TIA Portal 6
6.1 User interface and operation

6.1.1  Starting, setting and exiting the TIA Portal

6.1.1.1 Starting and exiting the TIA Portal

Starting the TIA Portal   
Follow the steps below to start the TIA Portal:

1. In Windows, select "Start > Programs > Siemens Automation > TIA Portal V12".
The TIA Portal opens with the last settings used.

Exiting the TIA Portal
Follow the steps below to exit the TIA Portal:

1. In the "Project" menu, select the "Exit" command.
If the project contains any changes that have not been saved, you will be asked if you wish 
to save them.

– Select "Yes" to save the changes in the current project and close the TIA Portal.

– Select "No" to close the TIA Portal without saving the most recent changes in the project.

– Select "Cancel" to cancel the closing procedure. The TIA Portal will remain open if you 
select this option.

6.1.1.2 Overview of the program settings

Overview     
The following table shows the application settings that you can make:

Group Setting Description
General settings User name The user name of the user. The user name is stored in the project 

properties when a new project is created.
User interface language Language for the program interface
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Group Setting Description
Mnemonic Specifies the mnemonics for programming: 

"German" uses the German mnemonics, for example, "E1.0".
"International" uses international mnemonics, for example, "I1.0".
For information on the differences in the mnemonics of the 
individual commands, refer to the description of the relevant 
programming language.

Show list of recently used 
projects

Number of entries in the list of recently used projects in the 
"Project" menu

Load most recent project 
during startup

The last opened project is opened automatically after the TIA 
Portal starts.

Displaying truncated text 
in full

Texts which are truncated due to their length are displayed in a 
tooltip.

Show tooltips (context-
sensitive help is available)

Tooltips are displayed and you get context-sensitive help. If this 
function is disabled, you can open the tooltip with <F1>.

Open cascade 
automatically in tooltips

After a brief time, the tooltips automatically expand to display a 
cascade containing additional help. If this option is cleared, the 
tooltips must be manually expanded.

Reset to default All application settings All changes that you made in the TIA Portal after installation are 
reversed.

Layout of the editors Resets the complete layout of the application to the factory state.
Show all message 
windows

All message windows whose appearance was manually 
suppressed are displayed again.

Start view Most recent view Starts the program in the last view that was used. This can be be 
either the portal view or the project view.

Portal view The TIA Portal will always be started in the portal view, 
irrespective of the last view you worked in.

Project view The TIA Portal will always be started in the project view, 
irrespective of the last view you worked in.

View for objects in overview Details When several views are available, the detail view opens by 
default, for example, in the overview window.

List When several views are available, the list view opens by default, 
for example, in the overview window.

Thumbnails When several views are available, the symbol view opens by 
default, for example, in the overview window.

Storage settings Recently used storage 
location

When a project is saved the first time, the most recently used file 
path is set by default.

Default storage location Enables the specification of file paths for:
● Projects
● Libraries

Data exchange Storage location for data 
import

Imported files are searched for at this storage path by default.

Storage location for data 
export

This is the default storage path for the data export.

Storage location for 
support packages

When support packages are downloaded, they are stored in the 
specified storage path and can be installed from there.

Storage location for log 
files

Log files are stored at the location specified here.
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See also
Starting and exiting the TIA Portal (Page 199)

Resetting the user interface layout (Page 233)

Changing the settings (Page 203)

Configuring the display of tooltips and tooltip cascades (Page 253)

6.1.1.3 Overview of the script and text editor settings

Overview     
The following table shows the available settings for script and text editors:

Group Setting Description
Font Font type and size Sets the font type and size for the text in text editors.
Font colors Color settings You can choose the colors for individual text elements from the 

respective drop-down lists in the text editors. Optional settings 
are available for the following text elements:
● Text
● Keywords
● Comments
● Translatable comments
● Instructions
● Scripts
● Standard functions
● System functions
● Constant strings
● Constant tags
● Tags
● Object models
● Formal parameters

Reset to default Resets all font colors in editors to their factory settings.
Tabs Tab width Sets the width of tabs.

Use tabs Enables the use of tabs.
Use spaces Specifies use of space characters instead of tabs.

Indent Indention at start of 
paragraph

Specifies whether the start of a new paragraph is to be indented. 
The following selection options are available:
● None

No indentation is used at the beginning of a paragraph in 
editors.

● Block
The first line of a paragraph in the editors is automatically 
indented.

● Smart
The program code is detected and the paragraphs are 
automatically indented to improve readability of the syntax.
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Group Setting Description
View Show line numbers Displays the line numbers on the left side of the text.

Show white spaces Shows control characters within a text.
STL (statement list) Font type and size Sets the font type and size for STL program code.
SCL (Structured Control 
Language)

Font type and size Sets the font type and size for SCL.
Tab width Sets the tab width in SCL programs.
Indentation Creates SCL programs automatically with syntactically correct 

indentation.
Show line numbers Shows the row numbers in SCL programs.

See also
Changing the settings (Page 203)

6.1.1.4 Overview of the print settings

Overview   
The following table shows the available settings for printing:

Group Setting Description
General Always print table data as 

pairs of values
Tables are printed as a list and not in tabular form. The corresponding 
values are listed for each column.
Enable this option, for example, if you want to print a table that is too 
large for the print area.

Always print data in tables All parameters of technology objects are printed in tabular format.
Print mask graphics if 
possible

If the utilized editor supports this function, the contents of the editor 
are printed not only as a table but rather as a complete graphic as it 
appears on the screen.

Hardware 
configuration

Active graphic view The graphics of network and device view are included in the printout.
Active table A table associated with an editor is included when printing with the 

editor.
PLC Programming Zoom factor Specifies the size in which blocks are to be printed out.

With interface The interfaces of blocks are included in the printout.
With comments Comments on blocks are included in the printout.
With line numbers The line numbers of the program code are printed for text-based 

programming languages.
HMI screens Show tab order In the printout you can specify the order in which the runtime objects 

can be selected with the TAB key.

See also
Changing the settings (Page 203)
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6.1.1.5 Changing the settings

Procedure 
To change the settings, proceed as follows:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group in the area navigation to change the settings described in the 
previous sections. Or click on one of the other entries in area navigation to make settings 
for your installed products.

3. Change the settings.

Result
The change will be adopted immediately, there is no need to save it explicitly.

See also
Overview of the program settings (Page 199)

Overview of the script and text editor settings (Page 201)

Overview of the print settings (Page 202)

6.1.2 Layout of the user interface

6.1.2.1 Views

Views 
Three different views are available for your automation project:

● The portal view is a task-oriented view of the project tasks.

● The project view is a view of the components of the project, as well as the relevant work 
areas and editors.

● The library view (Page 207) shows the elements of the project library and the open global 
libraries. 

You can change over between the two views using a link.
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6.1.2.2 Portal view

Purpose of the portal view 
The portal view provides you with a task-oriented view of the tools. Here, you can quickly 
decide what you want to do and call up the tool for the task in hand. If necessary, the view 
changes automatically to the project view (Page 205) for the selected task.

Layout of the portal view
The following figure shows an example of the components in the portal view:

① Portals for different tasks 
② Actions for the selected portal
③ Selection panel for the selected action
④ Change to the project view
⑤ Display of the project that is currently open
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Portals
The portals provide the basic functions for the individual task areas. The portals that are 
provided in the portal view depends on the products that have been installed.

Actions for the selected portal
Here, you will find the actions available to you in the portal you have selected. You can call up 
the help function in every portal on a context-sensitive basis.

Selection panel for the selected action
The selection panel is available in all portals. The content of the panel adapts to your current 
selection. 

Change to the project view
You can use the "Project view" link to change to the project view.

Display of the project that is currently open
Here, you can obtain information about which project is currently open.

See also
Project tree (Page 208)

Basics of the work area (Page 211)

Inspector window (Page 219)

Basics on task cards (Page 221)

Details view (Page 225)

6.1.2.3 Project view

Purpose of the project view
The project view is a structured view of all components of the project. 
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Layout of the project view
The following figure shows an example of the components of the project view:

① Title bar
② Menu bar
③ Toolbar
④ Project tree (Page 208) 
⑤ Reference projects (Page 223)  
⑥ Details view (Page 225) 
⑦ Work area (Page 221)
⑧ Dividers
⑨ Inspector window (Page 219)
⑩ Changing to the Portal view (Page 204)
⑪ Editor bar
⑫ Status bar with progress display
⑬ Task cards (Page 221)  
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Title bar
The name of the project is displayed in the title bar.

Menu bar
The menu bar contains all the commands that you require for your work.

Toolbar
The toolbar provides you with buttons for commands you will use frequently. This gives you 
faster access to these commands.

Dividers
Dividers separate individual components of the program interface. The arrows on the dividers 
allow you to display and hide the adjacent sections of the user interface.

Changing to the portal view
You can use the "Portal view" link to change to the portal view.

Editor bar
The Editor bar displays the open editors. If you have opened a lot of editors, they are shown 
grouped together. You can use the Editor bar to change quickly between the open elements.

Status bar with progress display
In the status bar, you will find the progress display for processes that are currently running in 
the background. This also includes a progress bar that shows the progress graphically. Hover 
the mouse pointer over the progress bar to display a tooltip providing additional information 
on the active background process. You can cancel the background processes by clicking the 
button next to the progress bar.

If no background processes are currently running, the status bar displays the last generated 
alarm.

See also
Basics of the work area (Page 211)

6.1.2.4 Library view

Function of the library view
The library view provides an overview of the elements in the project library and the open global 
libraries. You can switch to the library view using the "Libraries" task card.
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See also: Overview of the library view (Page 343)

6.1.2.5 Project tree

Function of the project tree     
Using the project tree features gives you access to all components and project data. You can 
perform the following tasks in the project tree:

● Add new components

● Edit existing components

● Scan and modify the properties of existing components

You can select the objects of the project tree either with the mouse or via the keyboard by 
typing the first letter of the desired object. If more than one object begins with the same letter, 
the next lower object is selected. The project tree must be the focused user interface element 
in order for you to select an object with its initial letter. 
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Layout of project tree
The following figure shows an example of the project tree components:
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① Title bar
② Toolbar
③ Project
④ Devices
⑤ Common data
⑥ Documentation settings
⑦ Languages & resources
⑧ Online access
⑨ Card Reader / USB memory

Title bar
The title bar of the project tree has a button for automatically and manually collapsing the 
project tree. Once it is collapsed manually, the button is "Reduced" to the left-hand margin. It 
changes from an arrow pointing left to one that is pointing right, and can now be used to reopen 
the project tree. You can use the "Reduce automatically" button collapse to project tree 
automatically when you do not need it. 

See also: Maximizing and minimizing the work area (Page 213) 

Toolbar
You can do the following tasks in the toolbar of the project tree:

● Create a new user folder; for example, in order to group blocks in the "Program blocks" 
folder.

● Navigate forward to the source of a link and back to the link itself.
There are two buttons for links in the project tree. You can use these to navigate from the 
link to the source and back.

● Show an overview of the selected object in the work area.
When the overview is displayed, the lower-level objects and actions of the elements in the 
project tree are hidden. 

Project
You will find all the objects and actions related to the project in the "Project" folder, e.g.:

● Devices

● Languages & resources

● Online access

Device
There is a separate folder for each device in the project, which has an internal project name. 
Objects and actions belonging to the device are arranged inside this folder.
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Common data
This folder contains data that you can use across more than one device, such as common 
message classes, logs, scripts and text lists.

Documentation settings
In this folder, you can specify the layout for project documentation to be printed at a later point.

Languages & resources
You can determine the project languages and texts in this folder. 

Online access
This folder contains all the interfaces of the programming device / PC, even if they are not 
used for communication with a module.

Card Reader / USB memory
This folder is used to manage all card readers an other USB storage media connected to the 
programming device / PC.

See also
Portal view (Page 204)

Project view (Page 205)

Basics of the work area (Page 211)

Inspector window (Page 219)

Basics on task cards (Page 221)

Details view (Page 225)

6.1.2.6 Work area

Basics of the work area

Function of the work area     
The objects that you can open for editing purposes are displayed in the work area. These 
objects include, for example:

● Editors and views

● Tables

You can open several objects. However, normally it is only possible to see one of these at a 
time in the work area. All other objects are displayed as tabs in the Editor bar. If, you would 
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like to view two objects at the same time when performing certain tasks, you can tile the work 
area either horizontally or vertically or undock elements of the work area. If no objects are 
open, the work area will be empty.

Layout of the work area
The following figure shows an example of a vertically split work area:

1

2

3

4

① Title bar of left-hand editor 
② Work area of left-hand editor
③ Title bar of right-hand editor
④ Work area of right-hand editor
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See also
Maximizing and minimizing the work area (Page 213)

Splitting the work area (Page 215)

Floating the work area elements (Page 215)

Using grouped elements of the work area (Page 216)

Minimizing and maximizing elements of the work area (Page 218)

Switching between the elements in the work area (Page 218)

Saving a layout of editors and tables (Page 232)

Save user interface layout (Page 230)

Maximizing and minimizing the work area
You have the option to adapt the work area to make it as large as possible. You can use the 
following function for this:

● Maximizing the work area
You can close the task cards, project tree and inspector window with a single click. This 
increases the size of the work area. You can minimize the work area again at any time in 
order to return to the previous view.

● Collapsing task cards, project tree, and Inspector window automatically
You can use the "Collapse automatically" option for the task cards, project tree, and 
Inspector window. This function causes these items to collapse automatically when you 
don't need them. 

Maximizing and minimizing the work area    
To maximize the work area, follow these steps:

1. Open an element such as an editor or a table.
The element appears in the work area.

2. Click the "Maximize" button in the title bar of the element.
The task cards, project tree and inspector window collapse, and the work area is shown 
with its maximum dimensions.

To minimize the work area again, follow these steps:
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1. Click the "Embed" button in the title bar of the displayed element.
This restores the view that existed before the work area was maximized. That is, if the task 
cards, project tree, or Inspector window were expanded before, they will be expanded 
again. 

Collapsing task cards, project tree, and Inspector window automatically   
To collapse the task cards automatically, follow these steps:

1. Click "Collapse automatically" in the title bar of the task cards.
The task cards collapse when you click anywhere outside the task cards. 

2. To use the task cards, click the collapsed task cards.

3. The task cards expand and are available for use. The "Collapse automatically" option 
remains enabled.

To collapse the project tree automatically, follow these steps:

1. Click "Collapse automatically" in the title bar of the project tree.
The project tree collapses when you click anywhere outside the project tree. 

2. To use the project tree, click the collapsed project tree.
The project tree expands and is available for use. The "Collapse automatically" option 
remains enabled.

To collapse the Inspector window automatically, follow these steps: 

1. Click "Collapse automatically" in the title bar of the Inspector window.
The Inspector window collapses when you click anywhere outside the Inspector window. 

2. To use the Inspector window, click the collapsed Inspector window.
The Inspector window expands and is available for use. The "Collapse automatically" option 
remains enabled.

To disable the automatic collapse option, follow these steps:

1. Click "Expand permanently" again in the relevant window.
The Collapse automatically" option is disabled, and the window remains expanded.

 

See also
Basics of the work area (Page 211)

Splitting the work area (Page 215)

Floating the work area elements (Page 215)

Using grouped elements of the work area (Page 216)

Minimizing and maximizing elements of the work area (Page 218)

Switching between the elements in the work area (Page 218)

Saving a layout of editors and tables (Page 232)
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Splitting the work area
You can split the work area vertically or horizontally.

Procedure
To split the work area vertically or horizontally, follow these steps:

1. In the "Window" menu, select the "Split editor space vertically" or "Split editor space 
horizontally" command.
The element you have clicked and the next element in the Editor bar will be displayed either 
next to one another or one above the other.

 

 Note

If no elements are open in the work area, the "Split editor space vertically" and "Split editor 
space horizontally" functions will not be available.

 

See also
Basics of the work area (Page 211)

Maximizing and minimizing the work area (Page 213)

Floating the work area elements (Page 215)

Using grouped elements of the work area (Page 216)

Minimizing and maximizing elements of the work area (Page 218)

Switching between the elements in the work area (Page 218)

Saving a layout of editors and tables (Page 232)

Floating the work area elements
You can float work area elements in their own separate window:

● Editors

● Tables

● Setting windows

● Task cards

● Inspector window

You can embed floating elements again in the work area at any time.
 

 Note
Properties of elements in a floating window

The properties of elements that you have selected in a floating window are only displayed in 
the Inspector window if the Inspector window is floating as well.
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Floating the work area elements    
To float work area elements, follow these steps:

1. Click the "Float" button in the title bar of the element.
The element will be released from the work area and displayed in its own window. You can 
now place the window wherever you wish. If you have minimized the window, you can 
restore it via the editor bar.

Embedding elements in the work area
To embed elements in the work area again, follow these steps:

1. Click the "Embed" button in the title bar of the element.
The element will appear in the work area again.

See also
Basics of the work area (Page 211)

Maximizing and minimizing the work area (Page 213)

Splitting the work area (Page 215)

Using grouped elements of the work area (Page 216)

Minimizing and maximizing elements of the work area (Page 218)

Switching between the elements in the work area (Page 218)

Saving a layout of editors and tables (Page 232)

Using grouped elements of the work area
If you open more than five elements of the same type, e.g., editors or tables, they are grouped 
in the editor bar. You can use these groups as follows:

● Displaying individual elements of a group

● Displaying all elements of a group in separate windows

● Embedding all displayed elements of a group in the work area

● Minimizing all displayed elements

● Closing all elements of a group

Displaying individual elements of a group  
To display individual elements of a group, follow these steps:

1. In the editor bar, click the group containing the element you want to display.
All list of all available elements of the group is displayed.

2. Click the element that you want to display.
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Displaying all elements of a group in separate windows
To display all elements of a group in separate windows, follow these steps:

1. In the editor bar, right-click the group whose elements you want to display.

2. Select "Restore group" in the shortcut menu.
All elements of the group are displayed in separate, overlapping windows. Move the 
windows in order to see the individual element, or choose an element via the group in the 
editor bar.

Embedding all displayed elements of a group in the work area
To embed all elements of a group displayed in separate windows in the work area again, follow 
these steps:

1. In the editor bar, right-click the group whose elements you want to embed.

2. Select "Embed group" in the shortcut menu.
All elements of the group are embedded in the work area again.

Minimizing all displayed elements
To minimize all elements of a group, follow these steps:

1. In the editor bar, right-click the group whose elements you want to minimize.

2. Select "Minimize group" in the shortcut menu.
All elements of the group are minimized. However, the minimized elements remain open 
and can be quickly maximized again via the group in the editor bar.

Closing all elements of a group
To close all elements of a group, follow these steps:

1. In the editor bar, right-click the group whose elements you want to close.

2. Select "Close group" in the shortcut menu.
All elements of the group are closed. The group is removed. 

See also
Basics of the work area (Page 211)

Maximizing and minimizing the work area (Page 213)

Splitting the work area (Page 215)

Floating the work area elements (Page 215)

Minimizing and maximizing elements of the work area (Page 218)

Switching between the elements in the work area (Page 218)

Saving a layout of editors and tables (Page 232)
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Minimizing and maximizing elements of the work area
You can minimize the elements that are open in the work area, such as editors or tables, as 
needed. However, an element remains open even if it has been minimized, and can quickly 
be maximized again using the editor bar.

Minimizing elements in the work area 
To minimize elements in the work area, follow these steps:

1. Click the "Minimize" button in the title bar of the element.
The element is minimized, but can still be accessed via the editor bar.

To minimize all elements at the same time, follow these steps:

1. In the "Window" menu, select the "Minimize all" command.

Maximizing elements in the work area 
To maximize elements in the work area again, follow these steps:

1. Click the required element in the editor bar.
The element is maximized and appears in the work area.

See also
Basics of the work area (Page 211)

Maximizing and minimizing the work area (Page 213)

Splitting the work area (Page 215)

Floating the work area elements (Page 215)

Using grouped elements of the work area (Page 216)

Switching between the elements in the work area (Page 218)

Saving a layout of editors and tables (Page 232)

Switching between the elements in the work area
You can switch between the elements in the work area at any time.
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Switching between the elements in the work area
To switch to the previous or next editor, follow these steps:

1. In the "Window" menu, select the "Next editor" or "Previous editor" command.
The next or previous editor will be displayed.

See also
Basics of the work area (Page 211)

Maximizing and minimizing the work area (Page 213)

Splitting the work area (Page 215)

Floating the work area elements (Page 215)

Using grouped elements of the work area (Page 216)

Minimizing and maximizing elements of the work area (Page 218)

Saving a layout of editors and tables (Page 232)

6.1.2.7 Inspector window

Function of the Inspector window  
Additional information on an object selected or on actions executed are displayed in the 
inspector window. 

Layout of the Inspector window
The following figures show the components of the Inspector window:
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① "Properties" tab
② "Info" tab
③ "Diagnostics" tab
④ Navigation within the tabs:

● Area navigation within the "Properties" tab
● Lower-level tabs in the "Info" and "Diagnostics" tabs

"Properties" tab
This tab displays the properties of the object selected. You can change editable properties 
here.

"Info" tab
This tab displays additional information on the object selected, as well as alarms on the actions 
executed (such as compiling). 

"Diagnostics" tab
This tab provides information on system diagnostics events, configured alarm events, and 
connection diagnostics.

Navigation within the tabs
You can use area navigation and the lower-level tabs to display the information you require 
within the tabs. 
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See also
Project tree (Page 208)

Basics of the work area (Page 211)

Portal view (Page 204)

Project view (Page 205)

Basics on task cards (Page 221)

Details view (Page 225)

6.1.2.8 Task cards

Basics on task cards

Function of task cards  
Depending on the edited or selected object, task cards that allow you perform additional actions 
are available. These actions include:

● Selecting objects from a library or from the hardware catalog

● Searching for and replacing objects in the project

● Dragging predefined objects to the work area

The task cards available can be found in a bar on the right-hand side of the screen. You can 
collapse and reopen them at any time. Which task cards are available depends on the products 
installed. More complex task cards are divided into panes that you can also collapse and 
reopen.

Introduction to the TIA Portal
6.1 User interface and operation

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  221



Layout of task cards
The following figure shows an example of the bar with the task cards:

① Task cards closed
② Task card open
③ Opened palette of a task card
④ Closed palette of a task card

See also
Changing the pane mode (Page 223)

Project tree (Page 208)

Basics of the work area (Page 211)

Inspector window (Page 219)

Portal view (Page 204)

Project view (Page 205)

Details view (Page 225)
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Changing the pane mode
You can choose between two pane modes:

● Single pane mode:
Only one pane is open at any given time. If you open another pane, the previously opened 
pane is closed automatically.

● Multi-pane mode:
You can open several panes at the same time.

Procedure   
To change the pane mode, follow these steps:

1. Click the "Change pane mode" button above the panes inside a task card.

See also
Basics on task cards (Page 221)

6.1.2.9 Reference projects

Function of reference projects
In the "Reference projects" palette, you can open other projects in addition to the current 
project. These reference projects are write-protected and cannot be edited. However, you can 
drag the objects of a reference project into your current project and further edit them there. 
You can also compare the objects of a reference project to the objects of your current project. 

Layout of the "Reference projects" palette
The following figure shows the layout of the "Reference projects" palette:
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1

2

3

① Title bar
② Toolbar
③ Opened reference projects

Title bar
The arrow for closing the palette is located in the title bar of the "Reference projects" palette. 
Once it is closed, the direction in which the arrow is pointing changes from downwards to right. 
It can now be used to reopen the palette.

Toolbar
The toolbar contains buttons for opening and closing reference projects.

Opened reference projects
Opened reference projects are displayed as read-only with their objects and their hierarchical 
structure.

See also
Basics of reference projects (Page 277)

Opening and closing a reference project (Page 277)
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6.1.2.10 Details view

Purpose of the details view 
The detail view shows certain content of the selected object is in the overview window or in 
the project tree. This might include text lists or tags.

The content of folders is not shown, however. To display the content of folders, use the project 
tree or the Inspector window.

Layout of the details view
The following figure shows an example of the details view:

① Title bar
② Content of the selected object

Title bar
The arrow for closing the details view is located in the title bar of the details view. After it has 
closed, the direction in which the arrow is pointing changes from left to right. It can now be 
used to reopen the details view.

Objects
The displayed content varies depending on the selected object. You can move the content of 
objects from the details view to the required location using drag-and-drop.
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See also
Project tree (Page 208)

Basics of the work area (Page 211)

Inspector window (Page 219)

Basics on task cards (Page 221)

Portal view (Page 204)

Project view (Page 205)

6.1.2.11 Overview window

Overview window

Functions of the Overview window
The Overview window supplements the project tree. The Overview window shows the contents 
of the folder currently selected in the project tree.

In addition, you can perform the following actions in the Overview window:

● Open objects

● Display and edit the properties of objects in the Inspector window

● Rename objects

● Call object-specific actions from the shortcut menu

● Compare objects side by side

● Perform various object operations, such as inserting objects from the library via drag-and-
drop and moving, copying, pasting, and deleting objects
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Layout of the Overview window
The following figure shows the components of the Overview window:

5 6 6

8

1

2 3 4

7

① Overview window
② Switch to the Details view
③ Switch to the List view
④ Switch to the Icon view
⑤ Move to higher level
⑥ Split the overview window in two. Either the right or left half of the overview window is synchronized. Clicking again 

cancels the split.
⑦ All blocks within the "Program blocks" folder are displayed even if these are located in lower-level groups. This 

option is only available in details view.
⑧ Contents of the object selected in the project tree.
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Display forms of the Overview window
The content of the Overview window can be displayed as follows:

● Details view
The objects are displayed in a list with additional information, such as the date of the last 
change.

● List view
The objects are displayed in a simple list.

● Icon view
The objects are displayed as icons according to category.

See also
Comparing objects in the overview window (Page 228)

Sorting the details view of the overview window (Page 229)

Overview of the library view (Page 343)

Comparing objects in the overview window
You can display the contents of two folders or objects side by side in the Overview window. 
The Overview window is split in half and you can display different contents on the left and right 
sides.

In addition, you can use a drag-and-drop operation to move objects between the split windows. 
Thus, for example, you can move contents from one window to the other.

Procedure  
To split the Overview window in half or cancel the split, follow these steps:

1. In the toolbar, click on the "Synchronize left side" or "Synchronize right side" icon to split 
the overview window. Either the left or the right side of the overview window synchronized 
with the contents of the selected object in the project tree.

2. To cancel the split, click again on the previously selected icon.

See also
Overview window (Page 226)
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Sorting the details view of the overview window
You have several options for adapting the display in the details view of the overview window:

● Adding additional columns
Some columns are hidden by default to increase clarity. You can display hidden columns 
if needed. The columns available depend on the selected object.

● Display of program blocks in flat hierarchy
Contents of the "Program blocks" folder can be displayed in a flat hierarchy. All blocks are 
displayed at once even if they are located in different groups.

● Sorting the table columns
You can sort individual columns of the table in ascending or descending order.

Showing or hiding columns  
To show or hide additional table columns, follow these steps:

1. Right-click the title bar of the table.

2. Select the "Show/Hide" command in the shortcut menu, and select the columns you want 
to display.

Displaying program blocks in flat hierarchy
To display the contents of the "Program blocks" folder in a flat hierarchy, follow these steps:

Select the "Program blocks" folder in the project tree.

Click the "Show subordinate elements" icon in the toolbar.

All blocks are displayed at once in the table even if they are located in lower-level groups.

Sorting a table in ascending or descending order
To sort the table by a column in ascending or descending order, follow the steps below:

1. Click the table header of a column if you want to sort the column in ascending order.

2. Click again on the same column of the table header to sort the column in descending order.

3. Click a third time on the table header of the same column to cancel the sorting.

See also
Overview window (Page 226)
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6.1.2.12 User interface layout

Save user interface layout

Options for saving the user interface layout  
When you make a change to the user interface, this is retained even after a restart of the TIA 
portal. A change to the user interface layout includes, for example, moving a window or 
adjusting the size of an editor.

In addition to the automatic saving of the user interface layout, you have the option of saving 
certain layouts:

● Saving the window layout 
You can save the layouts of the windows and editors of the TIA portal manually and restore 
these at a later time. It is possible to call five window layouts using a key combination.
Use this function, for example, if you are work with a notebook which you connect to an 
external monitor when necessary. You can create a window layout for mobile use on the 
notebook display and another layout for when you work at the office with an external monitor.

● Save the layout within editors   
With some editors, you can adjust the display. You can, for example, adjust the width of 
tables or show or hide individual table columns.

See also
Save window layout (Page 230)

Load window layout (Page 231)

Managing window layouts (Page 232)

Saving a layout of editors and tables (Page 232)

Resetting the user interface layout (Page 233)

Basics of the work area (Page 211)

Save window layout
You can save the current window layout in order to call it again in the same form at a later time.

Procedure   
To save a window layout, follow these steps:

1. Arrange all windows in the way in which you want to save them.

2. In the "Window" menu, select the "Save window layout as" command.
The "Save window layout" dialog box appears.

3. Enter a name for the window layout in the "Name" field.
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4. Enter a description of the window layout in the "Description" field in order to be able to 
identify the window layout more easily later.

5. Click "Save".

Result
The new window layout is saved in the last position after the existing saved window layouts. 
The first five window layouts can be called using a key combination.

See also
Save user interface layout (Page 230)

Load window layout
If you have already saved a window layout, you can load this, allowing you to quickly adjust 
your work environment to the respective conditions. You can load the first five window layouts 
using quick access via the "Window" menu or via a key combination.

If you load a window layout and then make changes to the arrangement of the window, you 
can restore the originally saved window layout.

Using quick access to load window layouts 1 to 5   
To load one of the first five saved window layouts, follow these steps:

1. In the "Window" menu, select a window layout or select the key combination <Alt+Shift+[1 ... 
5]>.

Loading additional window layouts   
To load a window layout that is not among the first five window layouts, follow these steps:

1. In the "Window" menu, select the "Additional window layouts" command.
The "Manage window layouts" dialog box appears.

2. Select the desired window layout.

3. Click "OK".

Restore window layout   
To go back to a saved window layout, follow these steps:

1. In the "Window" menu, select the "Restore window layout" command or select the key 
combination <Alt+Shift+0>.

See also
Save user interface layout (Page 230)
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Managing window layouts
You can carry out the following actions with existing window layouts:

● Changing the order of window layouts 
The order of the window layouts is important, as the first five window layouts can be called 
directly via the "Window" menu and via a key combination.

● Select a window layout
If a window layout is not one of the first five window layouts, you can call it using the "Manage 
window layouts" dialog box.

● Deleting window layouts 

Procedure
To manage the existing window layouts, follow these steps:

1. In the "Window" menu, select the "Manage window layouts" command.
The "Manage window layouts" dialog box appears.

2. Select the window layout which you want to modify.

3. Click the "Up" or "Down" symbol to move the window layout up or down.

4. Click the "Delete" symbol to delete the selected window layout.

5. Click "OK".
The selected window layout is activated.

See also
Save user interface layout (Page 230)

Saving a layout of editors and tables
You have the option of adapting editors and tables to meet your requirements. For example, 
you can hide columns in tables that you don't need. You can then save your customized view.

Procedure  
To save the layout of editors and tables in the work area, follow these steps:

1. Adapt the editor or table according to your requirements.

2. Click the "Remember Layout" button in the editor or table.

Result
The layout is saved. When you reopen the editor or table, this layout will be used.
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See also
Basics of the work area (Page 211)

Maximizing and minimizing the work area (Page 213)

Splitting the work area (Page 215)

Floating the work area elements (Page 215)

Using grouped elements of the work area (Page 216)

Minimizing and maximizing elements of the work area (Page 218)

Switching between the elements in the work area (Page 218)

Save user interface layout (Page 230)

Resetting the user interface layout
Every change you make to the layout of the user interface is saved. The changes are thus 
available even after a restart of the TIA Portal. For example, if you change the height and width 
of a text editor or the division of a table, your changes are retained so that you don't have to 
re-customize elements every time.

In some cases, however, it may be helpful to restore the original layout settings; for example, 
if another user prefers a different arrangement of the user interface.

Procedure   
To reset the user interface settings to the default, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group in the area navigation.

3. Click the "Reset to default" button under "Reset to default > Editor layout".

Result
The default settings for the user interface are restored.

See also
Overview of the program settings (Page 199)

Save user interface layout (Page 230)
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6.1.3 Keyboard operation in the TIA Portal

6.1.3.1 Operating the TIA Portal with the keyboard
You can navigate through the TIA Portal using the keyboard, for example if you do not have 
a mouse available at the given moment. Many functions are also accessible via keyboard 
shortcuts. You can find an overview of all keyboard shortcuts in the settings for the TIA Portal.

In the following sections, you will learn how to navigate in the TIA Portal using the keyboard, 
edit objects and customize the TIA Portal to your needs.

See also
Displaying an overview of all keyboard shortcuts (Page 234)

6.1.3.2 Displaying an overview of all keyboard shortcuts
You can display an overview of all keyboard shortcuts.

Procedure
To display an overview of all available keyboard shortcuts, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The settings of the TIA Portal are displayed.

2. Open the "Keyboard shortcuts" entry in the area navigation.
You can see an overview of all keyboard shortcuts, which are valid for the currently installed 
products.

6.1.3.3 Basic functions of the TIA Portal
Below, you will learn how you can use the basic functions of the TIA Portal using only your 
keyboard.

Operating basic functions of the TIA Portal with a keyboard  
The following table shows how you can access basic functions of the TIA Portal with keyboard 
shortcuts:

Function Keyboard shortcuts Menu command
Switch between the project view and the portal view <Alt+F7>  
Open the Help system
If you need help on the TIA Portal, press <F1>.

<F1> Help > Show help

Cancel the current action <Esc>  
Find <Ctrl+F>  
Replace an object <Ctrl+H>  

Introduction to the TIA Portal
6.1 User interface and operation

WinCC Comfort/Advanced V12.0 SP1
234 System Manual, 07/2013,  



Function Keyboard shortcuts Menu command
Find next
If you have started a search, you can jump to the next hit with <F3>

<F3>  

Print object <Ctrl+P> Project > Print

Operating menus
The following table shows how you can navigate through menus using the keyboard:

Function Keyboard shortcuts
Start keyboard operation in the menu
You can access the menu using the <Alt> key and then continue to navigate with the arrow keys 
to scroll through the menu. Confirm your selection of the menu command with <Return>.

<Alt>

Go directly to a specific menu
You can go directly to an individual menu command by holding down the <Alt> key. There is an 
underlined letter for each menu command. Press the <Alt> key along with the underlined letter.

<Alt+underlined letter in 
respective menu>

Open shortcut menu of an object
With the shortcut menu key (on Microsoft Windows compatible keyboards), you can open the 
shortcut menu of the selected object. Alternatively, you can use <Shift+F10> if you are not using 
a Microsoft Windows compatible keyboard. You can use the arrow keys to scroll through the 
shortcut menu and select a menu command with <Return>.

<Shortcut menu key>
Alternative: <Shift+F10>

Operating expandable elements
The following table shows how you can operate expandable elements using the keyboard:

Function Keyboard shortcuts
Expand a folder in a tree
With <Arrow right>, for example, you expand a folder in the project tree.

<Arrow right>

Close a folder in a tree
With <Arrow left>, for example, you collapse a folder in the project tree.

<Arrow left>

Open a drop-down list
You can open drop-down lists with <F4> and then navigate with the arrow keys to scroll through 
the drop-down list. Finally, press the <Return> key to confirm your selection.

<F4>

Open autocompletion <Ctrl+Space>
<Ctrl+I>

Show object selection <Ctrl+J>
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6.1.3.4 Using project-related functions

Editing a project   

Function Keyboard shortcuts Menu command
Open a project <Ctrl+O> Project > Open
Close a project <Ctrl+W> Project > Close
Save a project <Ctrl+S> Project > Save
Save a project under a different name <Ctrl+Shift+S> Project > Save as
Delete a project <Ctrl+E> Project > Delete project
Print project <Ctrl+P> Project > Print
Undo last action <Ctrl+Z> Edit > Undo
Redo last action <Ctrl+Y> Edit > Redo

Calling up the help function

Function Keyboard shortcuts Menu command
Calling up the help function <F1> or <Shift+F1> Help > Show help

6.1.3.5 Arranging windows
Below, you will learn how to open and close individual windows of the TIA Portal and save 
window layouts using the keyboard .

Opening and closing windows   
The following table shows how you can open and close windows with keyboard shortcuts:

Function Keyboard shortcuts Menu command
Open/close project tree <Ctrl+1> View > Project tree
Opening/closing the detailed view <Ctrl+4> View > Details view
Opening/closing the overview <Ctrl+2> View > Overview
Opening/closing a task card <Ctrl+3> View > Task card
Open libraries <Ctrl+Shift+L>  
Open hardware catalog
If you are in the device or network view, the hardware 
catalog opens.

<Ctrl+Shift+C>  

Open/close inspector window <Ctrl+5> View > Inspector window
Open the "Properties" tab in the inspector window <Ctrl+6>  
Open the "Info" tab in the Inspector window <Ctrl+7>  
Open the "Diagnostics" tab in the Inspector window <Ctrl+8>  
Display or hide reference projects <Ctrl+9>  
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Function Keyboard shortcuts Menu command
Display the on-screen keyboard
You can display a keyboard on the screen, for example, 
to operate with a touch screen.

<Ctrl+Shift+K>  

Close all editors <Ctrl+Shift+F4> Window > Close all

Using saved window layouts
You can save individual window arrangements and restore them at a later point in time. The 
following table shows how you to access saved window layouts with keyboard shortcuts:

Function Keyboard shortcuts Menu command
Restore active window layout
If you use a saved window layout and have made 
changes to the program interface in the meantime, you 
can restore the original state of the active window layout 
with <Alt+Shift+0>.

<Shift+Alt+0> Window > Restore window 
layout

Load window layout
You can use <Alt+Shift+[number of the window layout]> 
to activate the first of the five saved window layouts.

<Shift+Alt+[Number of the 
window layout]>

Window > Window layout 1 to 
5

6.1.3.6 Navigating through the program interface
The TIA Portal is divided into several interface areas, for example, individual windows, toolbars 
and editors. If you want to work with the keyboard within an interface area, you first have to 
place the focus on it. Below, you will learn how to place the focus on individual interface areas 
using the keyboard. You will also learn how to move within an interface area in the TIA Portal 
using the keyboard.

Switching between interface areas and editors  
The following table shows how to move between individual interface areas of the TIA Portal:

Function Keyboard shortcuts
Move clockwise between the interface areas
You can use the <F6> key to move clockwise between the various interface areas of the 
TIA Portal. The interface area currently in focus is highlighted with a blue title bar. If you 
are in the project tree, for example, and press the <F6> key, you jump to the currently 
open editor. If you press <F6> again, and the task cards are in focus.
If you press <Shift+F6>, on the other hand, you move counterclockwise between the work 
areas.

<F6>
 

Move counter-clockwise between the interface areas
With <Shift+F6> you move counter-clockwise between the interface areas of the TIA Portal.

<Shift+F6>

Go to the next open editor
With <Ctrl+Alt+Arrow right> you move to the next open editor. You can see the open editors 
in the editor toolbar.

<Ctrl+Alt+Arrow right>
Alternative: <Ctrl+F6>
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Function Keyboard shortcuts
Go to the previously open editor
With <Ctrl+Alt+Arrow left> you move to the most recently open editor.

<Ctrl+Alt+Arrow left>
Alternative: <Ctrl+Shift+F6>

Go to the next higher section of the interface area
With <Shift+Esc>, you move to the next higher section of the program interface. If, for 
example, you have selected a device in the project tree and you press <Shift+Esc>, the 
entire project navigation is put into focus.

<Shift+Esc>
Alternative: <Alt+Arrow up>

Go to the next lower section of the interface area
With <Return>, you place the focus on the next lower section of the program interface. For 
example, if you have just opened the properties of a device in the Inspector window in 
order to assign parameters to the device, press <Return> to go one level deeper in the 
program interface. You can then navigate to the desired parameter using the Tab key.

<Return>
Alternative: <Alt+Arrow down>

Navigation within interface areas and editors
The following table shows how you can navigate within an interface area using the keyboard:

Function Keyboard shortcuts
Jump to the next element within an interface area
You can use the Tab key to jump from one element to the next within a work area. If, for 
example, you have opened the properties of a device and want to jump from one field to 
the next, press the Tab key. Any changes you have made to the current text box are applied 
in this case.

<Tab>

Jump to the previous element within an interface area
With <Shift+Tab>, you can jump to the previous element in a work area, for example, a 
previous text box. Any changes you have made to the current text box are applied in this 
case.

<Shift+Tab>

Move to the next tab within an interface area
If an interface area is divided into separate tabs, you can move between the tabs with the 
shortcut keys <Ctrl+Tab>. If, for example, you are in the "Properties" tab of the Inspector 
window and you want to jump to the "Info" tab, press the shortcut keys <Ctrl+Tab>.

<Ctrl+Tab>

Go to the previous tab
With <Ctrl+Shift+Tab>, you move to the most recently open tab within an interface area.

<Ctrl+Shift+Tab>

Jumping to the toolbar of an editor
You can use the <Alt+F10> key to jump to the toolbar of an editor. For example, if you 
have opened the print preview and want to switch to the next page of the printout in the 
toolbar, press <Alt+F10>. Then, use the arrow keys to navigate to the appropriate icon in 
the toolbar and confirm the selection with <Return>.

<Alt+F10>

Use arrows on the divider to display or hide user interface components
The table in the work area can be minimized and maximized. First, navigate to the work 
area and use the Tab key to place the focus on one of the little arrows on the separator 
line above the table. The arrows have the focus as soon as they are highlighted in blue. 
Then, press the space bar to minimize or maximize the table.

<Space>

6.1.3.7 Customizing editors
Below, you will learn how to arrange editors using the keyboard. You will also learn how to 
select the display size and the area within a graphical editor.
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Arranging and customizing editors  
The following table shows how to arrange open editors above and below each other or side-
by-side, and how to close an open editor:

Function Keyboard shortcuts Menu command
Close active editor <Ctrl+F4>  
Split editor space vertically
If, for example, you have opened the overview window and the 
network view and want to display them side-by-side, press the 
<F12> key.

<F12> Window > Split editor space 
vertically

Split editor space horizontally
You can display two open editors in the work area above and below 
each other.

<Ctrl+F12> Window > Split editor space 
horizontally

Remove window split
If you have displayed two editors in the work area horizontally or 
vertically in split mode, you can remove the split with <Alt+Shift
+F12>.

<Alt+Shift+F12> Window > Unsplit editor space

Customizing the display in an editor
The following table shows how you how to zoom in and out in graphical editors and how to 
move the area selection in an editor:

Function Keyboard shortcuts
Zoom in step-by-step in an editor
With <Ctrl> and the <Plus> key on the numeric keypad of the keyboard, you can zoom in 
on the display of the editor.

<Ctrl+Plus>
Alternative: <Ctrl+mousewheel 
up>
 

Zoom out step-by-step in an editor
Use the <Ctrl> and the <Minus> key on the numeric keypad of the keyboard to zoom out 
of the display of the editor.

<Ctrl+Minus>
Alternative: <Ctrl+mousewheel 
down>

Set view in editor to 100%
You can zoom in or out of the display in a graphical editor to set the current view to 100% 
by pressing <Ctrl+0>.

<Ctrl+0>

Moving the area selection of the editor
If you hold down the spacebar, you can move the displayed section of an editor using the 
mouse.

<Space>
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6.1.3.8 Editing objects

Selecting objects  
The following table shows how to select individual objects, for example, devices in the project 
tree:

Function Keyboard shortcuts Menu command
Select an object located at the left, right, above or below <Arrow keys>  
Jump to the first object within the current interface area
The first object in the interface area currently in focus is selected. 
In the project tree, this would be the project node at the top, for 
example.

<Home>  

Jump to the last object within the current interface area
The last object in the interface area currently in focus is selected, 
for example, the last item in the project tree.

<End>  

Select all objects in an area
All objects in the work area currently in focus are selected.

<Ctrl+A> Edit > Select all

Select multiple objects
If you want to select several objects that are not located directly 
next to each other, you first have to move the focus (gray outline 
of an object) to the next desired object using <Ctrl+Arrow keys>. 
The current selection is maintained. Then, press the space bar to 
select the new focused object as well. Repeat this process until all 
desired objects are selected.

<Ctrl+Arrow keys> + 
<Space>

 

Editing objects  
The following table provides an overview of all the keyboard shortcuts required for editing 
objects:

Function Keyboard shortcuts Menu command
Insert new object
A new object is inserted depending on your current context. If, for 
example, you are in the device view, the "Add Device" dialog opens 
for creating a new device.

<Ctrl+N>  

Open object <Return>  
Rename an object <F2> Edit > Rename
Copy an object <Ctrl+C>

Alternative: <Ctrl+Ins>
Edit > Copy

Cut an object <Ctrl+X>
Alternative: <Shift+Del>

Edit > Cut

Paste an object <Ctrl+V>
Alternative: <Shift+Ins>

Edit > Paste

Delete an object <Del> Edit > Delete

Introduction to the TIA Portal
6.1 User interface and operation

WinCC Comfort/Advanced V12.0 SP1
240 System Manual, 07/2013,  



Function Keyboard shortcuts Menu command
Compile an object <Ctrl+B> Edit > Compile
Open properties of an object
Many objects in the TIA Portal have editable properties. Press the 
shortcut keys <Alt+Enter> to display the properties of an object.

<Alt+Return> -

6.1.3.9 Text editing
Below, you will learn how to operate text editing functions using only the keyboard.

Editing text   
The following table shows the basic editing functions for text:

Function Keyboard shortcuts
Switch to insert or overwrite mode <Insert>
Exit edit mode <Esc>
Delete <Del>
Delete characters <Backspace>
Confirm entry in a text box and leave the text box <Return>
Line break in a multiline text box
In a multiline text box, hold down the <Shift> button to create a line break.

<Shift+Return>

Reset input in a text box
If you are in an text box and press <Esc>, you exit the box and the changes are discarded.

<Esc>

Navigating within a text area
The following table shows how to navigate in a text area with the keyboard:

Function Keyboard shortcuts
Jump to start of line <Home>
Jump to end of line <End>
Jump to start of text <Ctrl+Home>
Jump to end of text <Ctrl+End>
Jump to the previous page <PgUp>
Jump to the next page <PgDn>
Confirm entry in a text box and leave the text box <Return>
Line break in a multiline text box <Shift+Return>
Reset input in a text box
If you are in an text box and press <Esc>, you exit the box and the changes are discarded.

<Esc>
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Selecting text
The following table shows how to select text with the keyboard:

Function Keyboard shortcuts
Expand selection to the word at the left or right
The text or current text selection is marked up to the end of word. If you are at the beginning or 
end of a word, the previous or next word is selected. 

<Ctrl+Shift+Arrow left or 
Arrow right>

Expand selection to beginning of line <Shift+Home>
Expand selection to end of line <Shift+End>
Expand selection to beginning of text
The text is selected up to the beginning or the end.

<Ctrl+Shift+Home>

Expand selection to end of text
The text is selected up to the beginning or the end.

<Ctrl+Shift+End>

6.1.3.10 Editing tables
Below, you will learn how to navigate with the keyboard in tables, edit individual fields, and 
select parts of tables.

General keyboard operation in tables   
The following table shows how you can edit tables using only the keyboard:

Function Keyboard shortcuts
Place a cell in edit mode <F2> or <Return>
Confirm entry and exit edit mode <Return>
Cancel editing and discard changes <Esc>
Open drop-down list in a cell
Open the drop-down list with <F4>. Use the arrow keys to 
select the desired entry and then confirm the selection with 
<Return>.

<F4>

Close drop-down list in a cell and discard changes <Esc>

Navigate in tables
The following table shows how you can navigate within a table using the keyboard:

Function Keyboard shortcuts
Go to the next cell <Arrow keys>
Go to the next editable cell on the right <Tab>
Go to the next editable cell on the left <Shift+Tab>
Move a screen upwards <PgUp>
Move a screen downwards <PgDn>
Go to the first cell in the row <Home>
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Function Keyboard shortcuts
Go to the last cell in the row <End>
Go to the first cell in the table <Ctrl+Home>
Go to the last cell in the table <Ctrl+End>
Go to the top cell in the column <Ctrl+Arrow up>
Go to the bottom cell in the column <Ctrl+Arrow down>

Selecting areas in tables
The following table shows how you can select areas within a table using the keyboard:

Function Keyboard shortcuts
Select column <Ctrl+Space>
Select line <Shift+Space>
Select all cells <Ctrl+A>
Expand selection by one cell <Shift+arrow keys>
Extend selection up one page <Shift+PgUp>
Extend selection down one page <Shift+PgDn>
Expand selection up to the first row <Ctrl+Shift+Arrow up>
Expand selection down to the last row <Ctrl+Shift+Arrow down>
Expand selection to the first cell in the row <Ctrl+Shift+Arrow left>
Expand selection to the last cell in the row <Ctrl+Shift+Arrow right>

6.1.3.11 Using online functions

Controlling online functions with the keyboard 
The following table provides an overview of the shortcut keys that you can use for the online 
functions of the TIA Portal:

Function Keyboard shortcuts Menu command
Establish an online connection <Ctrl+K> Online > Go online
Go offline <Ctrl+M> Online > Go offline
Download project data to the device <Ctrl+L> Online > Download to 

device
Show accessible devices
This opens a dialog showing all devices that are connected to the PG/
PC interface of the PG/PC.

<Ctrl+U> Online > Show 
accessible devices

Start CPU
The CPU is set to "RUN" mode. The CPU must be online for this.

<Ctrl+Shift+E> Online > Start CPU
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Function Keyboard shortcuts Menu command
Stop CPU
The CPU is set to "STOP" mode. The CPU must be online for this.

<Ctrl+Shift+Q> Online > Stop CPU

Start simulation
The hardware and software of the project can be tested in a simulated 
online environment, without the modules actually being online.

<Ctrl+Shift+X> Online > Simulation > 
Start

6.1.3.12 Using the on-screen keyboard

Introduction
When working with the TIA portal, you also have the Microsoft on-screen keyboard available. 

Displaying the on-screen keyboard
To display the on-screen keyboard, follow these steps:

1. In the "View" menu, select the "Screen keyboard" command.

 

Exiting the on-screen keyboard
To exit the on-screen keyboard, follow these steps:

1. In the "File" menu of the on-screen keyboard, select the "Exit" command.

6.1.4 Special features specific to the operating system

6.1.4.1 Influence of user rights

Restrictions when user rights are limited  
The software provides several functions that require direct access to the hardware of the 
programming device / PC and therefore also to the installed operating system. To make full 
use of the range of functions, the software must cooperate closely with the operating system. 
To ensure problem-free interaction, you should therefore be logged on to the operating system 
with adequate user rights.

In particular, you may not be able to use functions requiring an online connection or those that 
change the settings of interface cards if you work with limited user rights.
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Recognizing restricted functions  
You can recognize functions requiring special rights as follows:

● A shield icon is displayed beside the function.

The function can be used but is regulated by the user account control.

● A box is grayed out and cannot be accessed.
You require administrator privileges to access the box. In some operating system 
environments, you can obtain administrator privileges by entering an administrator 
password.

 

 Note

A box being grayed out does not necessarily mean a lack of rights. You should also check 
the additional information in the tooltip cascades to find out the conditions for editing the box.

 

6.1.4.2 Expanding user rights

Counteracting restrictions due to user rights 
Certain functions may not be available if you are not logged on to the operating system with 
adequate rights. You can counteract these restrictions in the following ways:

● Enabling of extended rights using Windows user account control

● Logging on to the operating system with administrator privileges

● Using temporary administrator rights

Enabling extended rights using the Windows user account control 
To be able to use a function indicated by the shield icon of the Windows user account control, 
follow these steps:

1. Click on the box or button with the shield icon.
The security prompt of the Windows user account control opens.

2. Follow the instructions of the Windows user account control and, when prompted enter an 
administrator password, if possible.

The function can now be used once without restrictions.

Logging on to the operating system with administrator privileges 
To be able to use a function that is disabled due to lack of user rights, follow these steps:

1. Close the software.

2. Log off from the operating system.

3. Log on to the operating system with administrator privileges.

4. Restart the software.
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Using temporary administrator rights
To obtain administrator privileges temporarily, follow these steps:

1. Click the "Change settings" button. You will find this button in dialogs that allow the 
temporary assignment of administrator privileges.
An operating system dialog box for entering an administrator password opens.

2. Enter an administrator password.

The settings can be temporarily changed. When you call the dialog again, the procedure must 
be repeated.

 

 Note

This function is not supported by all operating systems. If no "Change settings" button is 
present or the button is grayed out, you will need to log on to the operating system with 
administrator privileges instead.
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6.2 Help on the information system

6.2.1 General remarks on the information system

Quick answers to your questions  
A comprehensive Help system is available for solving your tasks. It describes basic concepts, 
instructions and functions. While working with the program, you also receive the following 
support:

● Roll-out for correct inputs in dialog boxes

● Tooltips for information on elements of the user interface, for example text boxes, buttons 
and icons. Some of the tooltips are supplemented by cascades containing more precise 
information.

● Help on the current context, on menu commands for example when you click on the keys 
<F1> or <Shift+F1>.

The following figure shows an example of a cascading tooltip (top) and a roll-out (bottom):

Help
The Help system describes concepts, instructions and functions. It also contains reference 
information and examples. The help opens in a separate window.

A navigation pane appears on the left side of the help window. You can also hide the navigation 
pane to make room on the screen. The navigation pane provides you with the following 
functions:

● Table of contents

● Search in the index

● Full text search of the entire Help

● Favorites
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Identification of the topics in the Help according to the type of information  
The help topics are identified by different symbols depending on the type of information they 
contain.

Symbol Information type Explanation
Operating instructions Describes the steps to follow in order to carry out a particular task.
Example Contains a concrete example to explain the task.
Factual information Contains background information that you need to know to carry 

out a task.
Reference Contains comprehensive reference information to refer back to.

Identification of the topics in the Help according to the target system
Depending on the products that are installed, the help system may contain sections that apply 
only to specific devices. To be able to recognize such sections at a glance, you will find a note 
in brackets in the table of contents. The search results in the full text search and in the index 
are marked in the same way if they only apply to a specific device.

Roll-out  
Certain text boxes offer information that rolls out and helps you to enter valid parameters and 
values. The roll-out informs you about permissible value ranges and data types of the text 
boxes.

The following figure shows a roll-out (yellow) and a roll-out error message (red), which indicates 
an invalid value:

Tooltip  
Interface elements offer you a tooltip for easier identification. 
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Tooltips, which have an arrow icon on the left, contain additional information in tooltip 
cascades. If you position the mouse pointer briefly over the tooltip or click the arrow icon, this 
information is displayed. The automatic display of tooltip cascades can be disabled.

If additional information is contained in the Help system, a link appears to the corresponding 
Help topic in the cascade. If you click on the link, the corresponding topic opens in Help.

The following figure shows a tooltip with opened cascade:

See also
Configuring the display of tooltips and tooltip cascades (Page 253)
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6.2.2 Opening the Help system

Opening the Help system  
You can open the Help system in the following ways: 

1. In the "Help" menu, select the "Show help" command or press <F1> to display the 
corresponding help for the current context.

Or

1. Click on the link in a tooltip cascade to go directly to an additional point in the Help system.

6.2.3 Searching the Help system for keywords

Searching for keywords in the help text  
To search the help topics for predefined keywords, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Index" tab.

3. Enter the search term in the input box or select the search term from the list of key words.

4. Click "Display".

6.2.4 Full-text searches

Full-text searches
To search the entire text for specific words, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Search" tab.

3. Type in your search term in the text box.

4. Refine your search if necessary using additional criteria:

– Select "Search previous results" to start an additional search operation of your last 
search results only.

– Select "Search for similar words" to find words that differ only slightly from your search 
term.

– Select "Search titles only" to obtain only results that contain your search term in the title. 
The contents of the Help topics are ignored during the search.

Introduction to the TIA Portal
6.2 Help on the information system

WinCC Comfort/Advanced V12.0 SP1
250 System Manual, 07/2013,  



5. Click on the arrow button to the right of the search field to use logic operations. The following 
logic operations are available:

– Combine two or more search terms using the "AND" operator to find only Help topics 
that contain all the search terms in the text.

– Combine two or more search terms using the "OR" operator to find only Help topics that 
contain one or more of the search terms in the text.

– Combine two or more search terms using the "NEAR" operator to find only Help topics 
that contain terms in close proximity to each other (eight words).

– Precede a word with the "NOT" operator to exclude Help topics from the search that 
contain this word.

6. Click on "List topics" to start the search.
The results are now listed with title, position and ranking. The "Position" column shows the 
section in which the Help topic found is located. Sorting according to ranking is based on 
the position of the Help topics found in the table of contents and based on the number of 
hits in the Help topics.

6.2.5 Using favorites

Using favorites
You can save individual help topics as favorites. This saves you searching for the help topic 
a second time.

Saving favorites: 
To save a page as a favorite, follow these steps:

1. Open the help topic or the chapter you want to save as a favorite.

2. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

3. Open the "Favorites" tab.

4. Click the "Add" button.
The help topic or chapter is saved as a favorite and is available the next time you open the 
help system.

Calling up favorites: 
To call up a page from the favorites, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Favorites" tab.
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3. Select the topic you want to open from the list.

4. Click the "Display" button.

Deleting favorites
To delete an entry from the favorites, proceed as follows:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Favorites" tab.

3. Select the topic you want to remove from the list.

4. Click the "Remove" button.

6.2.6 Printing help topics

Printing information
You can either print all the contents of the Help system or individual topics only.

Procedure
To select the topics you would like to print, follow these steps:

1. Click the "Display printing dialog" button.
The table of contents opens in a separate window.

2. Select the check boxes for the folders and help topics to be printed in the "Print help topics" 
dialog.

3. Click the "Print" button to print the selected information.
The "Print" dialog opens.

4. Select the printer on which you want print the help topics.

5. Click "Properties" if you want to make additional printer settings.

6. Confirm your entries with "OK".
The help topics are printed out on the selected printer.
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6.2.7 Configuring the display of tooltips and tooltip cascades

Configuration options for tooltips and tooltip cascade
You can customize the display of tooltips and tooltip cascades to suit your needs. You can 
make the following settings:

● Display or hide truncated text
Sometimes texts may be too long for a text field. The texts are then fully displayed in a 
tooltip when you hover your mouse over the text field. You can enable or disable this 
function.

● Enable or disable tooltips
Tooltips provide more detailed information about an element of the user interface. You can 
also have tooltips displayed in a cascade. If you disable the tooltips, the cascade with 
context-sensitive help is also no longer displayed. However, you have the option of 
manually displaying the tooltip for the currently active interface element by pressing <F1>.

● Enable or disable automatic opening of tooltip cascades
By keeping the mouse pointer over a tooltip for a brief time, any available cascades are 
displayed automatically. You can enable or disable the automatic display of cascades. 
When automatic display is disabled, you must open the cascade manually if necessary. To 
do this, click on the arrow icon in the tooltip.

Procedure   
To configure the display of tooltips and tooltip cascades, follow these steps:

1. Select the "Settings" command in the "Options" menu.

2. Select the "General" group in the area navigation.

3. Select or clear the individual check boxes in the "Tooltips" area to suit your needs. The 
"Open cascade automatically in tooltips" check box is only available if you have enabled 
the display of tooltips.

See also
General remarks on the information system (Page 247)

6.2.8 Safety Guidelines

Safety guidelines
This Help manual contains notices you have to observe in order to ensure your personal safety, 
as well as to prevent damage to property. The notices referring to your personal safety are 
highlighted in the manual by a safety alert symbol, notices referring only to property damage 
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have no safety alert symbol. These notices shown below are graded according to the degree 
of danger.

 

 DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions 
are not taken.

 

 NOTICE

without a safety alert symbol, indicates that property damage can result if proper precautions 
are not taken.

 

 Note

indicates that an unintended result or situation can occur if the corresponding information is 
not taken into account.

 

If more than one degree of danger is present, the warning notice representing the highest 
degree of danger will be used. A notice warning of injury to persons with a safety alert symbol 
may also include a warning relating to property damage.

Qualified Personnel
The device/system may only be set up and used in conjunction with this documentation. 
Commissioning and operation of a device/system may only be performed by qualified 
personnel. Within the context of the safety notes in this documentation qualified persons are 
defined as persons who are authorized to commission, ground and label devices, systems and 
circuits in accordance with established safety practices and standards.

Prescribed Usage
Note the following:

 

 WARNING

This device may only be used for the applications described in the catalog or the technical 
description and only in connection with devices or components from other manufacturers 
which have been approved or recommended by Siemens. Correct, reliable operation of the 
product requires proper transport, storage, positioning and assembly as well as careful 
operation and maintenance.
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Trademarks
All names identified by ® are registered trademarks of the Siemens AG. The remaining 
trademarks in this publication may be trademarks whose use by third parties for their own 
purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware 
and software described. Since variance cannot be precluded entirely, we cannot guarantee 
full consistency. However, the information in this publication is reviewed regularly and any 
necessary corrections are included in subsequent editions.

6.2.9 Assembling customized documentation

Customized documentation    
In the Service and Support section of the Siemens Website, you can assemble customized 
documentation that is tailored to your needs. All configurable manuals and operating 
instructions of the Service and Support section are available to you for this purpose. You can 
select the parts that are of interest to you and combine them into in a library to form personal 
documentation. You can organize the documentation using folders in the library. The folders 
will later become the individual chapters of your custom documentation.

You can open your personal library here (https://www.automation.siemens.com/mdm/?
guiLanguage=en).

Requirement
● The manuals or operating instructions used must be configurable. You can recognize 

configurable manuals by the suffix "configurable" in their name.

● In order to use all functions, you have to register in the Siemens Support Portal and log on.

Documentation in different languages
You can change the language of the assembled documentation to German, French, Spanish, 
Italian and Chinese. This gives you the possibility, for example, to gather relevant information 
for a specific project and make it available to colleagues who speak other languages.

Export function in the documentation
You can perform an export at any part of your library in various formats (PDF, XML, RTF).
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Help on creating documentation
You can find more help on creating and using custom documentation on the Service and 
Support Website (https://www.automation.siemens.com/mdm/_help/en/
mdm_reference_manual_de-DE.htm).
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Editing projects 7
7.1 The basics of projects

Introduction   
Projects are used to organize the storage of data and programs resulting from the creation of 
an automation solution. The data that makes up a project includes the following:

● Configuration data on the hardware structure and parameter assignment data for modules

● Project engineering data for communication over networks

● Project engineering data for the devices

● Logs for important events in the life cycle of the project

Project hierarchy
Data is stored in a project in the form of objects. Within the project, the objects are arranged 
in a tree structure (project hierarchy). 

The project hierarchy is based on the devices and stations along with the configuration data 
and programs belonging to them. 

Common data of the project and online access, for example, are also displayed in the project 
tree. 

See also
Creating a new project (Page 259)

Opening projects (Page 259)

Saving projects (Page 264)

Deleting projects (Page 265)

Using logs (Page 258)
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7.2 Using logs
For some operations within the TIA Portal, logs are created automatically in the background. 
These logs document changes in the project. Logs are created automatically, for example, 
when you migrate projects and programs or when you update instances from the library.

Logs are displayed in the "Common data" folder in the project tree. They are stored together 
with the project in the project folder and can therefore be read independently of the 
programming device/PC used as soon as you have opened the project. 

In addition to displaying them in the TIA Portal, logs can also be printed.

Opening logs
To open a log, follow these steps:

1. Open the "Common data > Logs" folder in the project tree.

2. Double-click the desired log in the list.
The contents of the log are displayed in the work area.

Deleting logs
To delete a log, follow these steps:

1. Select the log in the project tree.

2. Press <Del>.
The selected log is deleted from the project directory and removed from the project tree.
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7.3 Creating and managing projects

7.3.1 Creating a new project

Procedure
To create a new project, follow these steps:

1. Select the "New" command in the "Project" menu.
The "Create a new project" dialog opens.

2. Enter your project name and path or accept the proposed settings.

3. Click the "Create" button.

Result
The new project is created and displayed in the project tree.

See also
The basics of projects (Page 257)

Opening projects (Page 259)

Saving projects (Page 264)

Deleting projects (Page 265)

7.3.2 Opening projects
You can open all projects from the current and earlier versions in the TIA Portal.

Projects from TIA Portal V12 must first be upgraded to the current project format before they 
can be processed further in TIA Portal V12 SP1. You are prompted to upgrade the project 
when you open it. After upgrading the V12 project to the current product version, it can no 
longer be opened in TIA Portal V12. However, a copy of the original project is retained.

Projects from version V11.x can be opened as usual. However, the range of functions of the 
TIA Portal is limited to the functionality of TIA Portal V11.x in this case. You need to upgrade 
the project manually to continue working with the full range of functions from the current TIA 
Portal version.
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Procedure
To open an existing project, follow these steps:

1. Select the "Open" command in the "Project" menu.
The "Open project" dialog opens and includes the list of most recently used projects.

2. Select a project from the list and click "Open".

3. If the project you require is not included in the list, click the "Browse" button. Navigate to 
the desired project folder and open the project file.
Projects of the TIA Portal V12.x have the extension ".ap12". Older projects of the TIA Portal 
have the extension ".ap[version number]". For projects of the TIA Portal V11.x, for example, 
the extension is ".ap11".

Result
The project opens in the project view.

See also
Notes on compatibility (Page 260)

Upgrading projects (Page 262)

The basics of projects (Page 257)

Creating a new project (Page 259)

Saving projects (Page 264)

Deleting projects (Page 265)

7.3.3 Notes on compatibility
With the TIA Portal, you can open projects that were not created with the same version or that 
were created with another installation scope. In the following, you will learn what to consider 
in this case.
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Opening projects from older versions of the TIA Portal
You can open projects from previous versions of the TIA Portal. However, some peculiarities 
in projects from earlier versions of the TIA Portal must be taken into consideration:

● Projects from TIA Portal V10.0 and V10.5
You can open projects from versions V10.0 or V10.5. These are converted into the current 
project format.

● Projects from TIA Portal V11.x
Projects from version V11.x are opened and remain unchanged. The range of functions is 
limited to the capabilities of TIA Portal V11.x. Projects therefore remain backward 
compatible and can still be edited with the previous version of the TIA Portal. If you want 
to continue working on a project in TIA Portal V11 that you have saved once with the current 
version of the TIA Portal, the most recent version of TIA Portal V11 must be installed. This 
means all service packs and all other updates must be installed.
When you open a project from version TIA Portal V11 or older in the current version of the 
TIA Portal, you can add components that were subsequently provided for this older version 
within the context of a Hardware Support Package (HSP) to the project. This project then 
remains compatible with this older version of the TIA Portal. All you have to do is install the 
Hardware Support Package in the older version to continue working with the project in it.
If you want to use all the functions of the current version in a project from TIA Portal V11.x, 
you need to upgrade the project. The project is converted to the latest project format during 
the upgrade and the full range of functions of the current version become available.

Opening projects from newer versions of TIA Portal
If you want to open a project from a newer version, this is possible if the following conditions 
are met:

● The project was created with a version of the TIA Portal that is newer than V12 SP1, for 
example, with a newer service pack.

● The project does not contain any data that is incompatible with the current installation.

Compatibility of projects of the current TIA Portal version
Note that projects saved with TIA Portal V12 SP1 are not backward compatible due to the 
extended range of functions compared to the older versions. Projects saved with TIA Portal 
V12 SP1 can only be opened with TIA Portal V12 SP1 or later.
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Opening projects created with add-on products
If the project to be opened contains data that was created with optional software, but the 
corresponding software product is not installed, the following cases can occur:

● Software components are missing, but none of them are essential:
A dialog appears listing the missing software components. After the project is opened, its 
properties are displayed. You now have the opportunity to install the missing products. All 
the devices contained in the project are available even if you do not install the missing 
products. However, you can only work with the devices that are supported by the currently 
installed software.
If devices are not supported because software is missing, they are marked with the following 
symbol in the project tree:

● At least one software package is required in order to open the project:
A dialog appears listing the missing software components. The essential package(s) are 
marked. The project can only be opened if you install the missing components.

See also
Opening projects (Page 259)

Upgrading projects (Page 262)

7.3.4 Upgrading projects
You can open and edit projects from TIA Portal version V11.x in the current version. The range 
of functions remains limited to the capabilities of version V11.x, however. This ensures 
backward compatibility of the project and allows the project continue to work with the previous 
version of the TIA Portal.

If you want to use the full range of functions from the current version of the TIA Portal, you 
need to upgrade the project.

Projects from TIA Portal V12 must always be upgraded before they can be further processed 
in TIA Portal V12 SP1. You are prompted accordingly when you open a V12 project.

If you want to continue using global libraries of TIA Portal V11.x, you have to upgrade these 
as well. This does not happen automatically when you upgrade the project.

Procedure
To upgrade a project, follow these steps:

1. Open the project from an earlier version of the TIA Portal.

2. Select the "Upgrade" command in the "Project" menu.
A security prompt appears.

3. Click "Yes" to confirm.
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 Note
Upgrading know-how-protected blocks

The block is only upgraded and downloaded after it has been opened once with the password. 
This means you should open know-how-protected blocks once after upgrading the project to 
also upgrade the blocks. If you have protected numerous know-how-protected blocks with 
the same password, you can select and open all of them at once.

 

Result
The original project is closed and will remain stored in its original state. A new version is created 
from the original project. The new version of the project opens.

See also
Notes on compatibility (Page 260)

Opening projects (Page 259)

Upgrading libraries from older versions (Page 350)

7.3.5 Displaying properties of the project
You can display the properties of a project. Properties include the following:

● Metadata for the project
This includes the following information: creation time, author, file path, project size, 
copyright , project languages, etc. Many of the attributes can be changed.

● Project history
The project history contains an overview with important events in the project life cycle. Here, 
for example, you can see the version of the TIA Portal used to create a project and whether 
it has been converted into another version in the meantime. If a project was created during 
a migration, for example, this is also indicated in the project history table with the date and 
time of the migration. If a log was created for an event, you can also call the log directly.

● Support packages in the project
An overview of the add-on software needed to work with all devices in the project is 
displayed. In addition, installed GSD files are listed (device description files for other devices 
in the hardware catalog).

● Software products in the project
You can display an overview of all installed software products needed for the project.

Editing projects
7.3 Creating and managing projects

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  263



Procedure   
To display the project properties, follow these steps:

1. Select the open project in the project tree.

2. Select "Properties" in the shortcut menu of the project.
The dialog with the properties of the project opens.

3. Select the project properties in the area navigation that you want to have displayed.

7.3.6 Saving projects
You can save the project at any time either under the same or a different name. You can even 
save a project when it still contains elements with errors.

Saving a project  
To save a project, follow these steps:

1. Select the "Save" command in the "Project" menu.
All changes to the project are saved under the current project name. If you are editing a 
project from an earlier version of the TIA Portal, the file extension of the project is also 
retained and you can continue to edit the project in the earlier version of the TIA Portal.

Project Save as
To save a project under another name, follow these steps:

1. Select the "Save as" command in the "Project" menu.
The "Save current project as" dialog opens.

2. Select the project folder in the "Save in" box.

3. Enter the new project name in the "File name" box.

4. Confirm your entry with "Save".
The project is saved under the new name and opened.

See also
The basics of projects (Page 257)

Creating a new project (Page 259)

Opening projects (Page 259)

Deleting projects (Page 265)

Upgrading projects (Page 262)

Notes on compatibility (Page 260)
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7.3.7 Closing projects

Procedure
To close a project, follow these steps:

1. Select the "Close" command in the "Project" menu.
If you have made changes to the project since the last time you saved it, a message is 
displayed. 

2. Decide whether or not you want to save the changes.

7.3.8 Deleting projects
 

 Note

When you delete a project, the entire project data is removed from the storage medium.
 

Requirement
The project you want to delete is not open.

Procedure  
Follow the steps below to delete an existing project:

1. Select the "Delete project" command in the "Project" menu.
The "Delete project" dialog opens and includes the list of most recently used projects.

2. Select a project from the list.
If the project you require is not included in the list, click the "Browse" button. Navigate to 
the desired project folder, and open the project file.

3. Click the "Delete" button.

4. Click "Yes" to confirm. This starts the deletion of the project.

Result
The entire project folder is deleted from the file system. 

See also
The basics of projects (Page 257)

Creating a new project (Page 259)

Opening projects (Page 259)

Saving projects (Page 264)
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7.3.9 Working with multi-language projects

7.3.9.1 Project text basics

Texts in different languages in the project   
When you enter texts while working on a project, you would normally do this in your own 
language. If you then pass on the project to someone else who does not know this language, 
this person will require a translation of the relevant texts to a language they know. This is why 
all texts can be translated. In this way, you can ensure that anyone who is subsequently 
confronted with the texts sees the texts in his/her language of choice.

Project language 
Project languages are all languages in which a project will later be used. Based on the editing 
language, all the texts can be translated to the various project languages. You specify the 
languages that will be available in the project tree under "Languages & Resources > Project 
languages".   

Editing language 
Every project has an editing language. When you enter texts, these are always created in the 
editing language. You should therefore make sure that the editing language set is the language 
in which you enter the texts. This avoids problems if you translate the texts later.

The editing language does not depend on the language of the user interface. You could, for 
example, set English as the user interface language, but use Italian as the editing language. 
If you enter texts, these will be created in this case in the project language "Italian", although 
the user interface of the TIA Portal displays English.

You set the editing language in the project tree under "Languages & Resources > Project 
languages > Editing language".

Reference language 
The reference language is used as a template for translation. The text is displayed in the 
reference language for each text box in the "Tasks > Languages and resources" task card. 
You therefore know which text that belongs in a text box, even when no text is entered in the 
currently selected editing language.

User texts and system texts     
For clarification purposes, a distinction is made between user texts and system texts:

● User texts are texts that the user created.

● System texts are texts that are created automatically according to the configuration in the 
project.

You manage the project texts in the project tree under "Languages & Resources > Project 
texts".
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Examples of multilingual project texts
You can, for example, manage the following project texts in more than one language:

● Block titles and block comments

● Network titles and network comments

● Comments in tables

● Alarm texts

● Operator-relevant texts

● Text lists

● Labels of buttons

● Display names of recipes

Translating texts
There are three ways of translating texts.

● Translate all texts used in the project in tabular form
You can enter the translations for the individual project languages directly in the "Project 
texts" table. You will find this in the project tree under "Languages & Resources > Project 
texts".

● Specify text assigned to individual objects in the Inspector window
In the Inspector window, you can translate the texts that are assigned to the currently 
selected objects. Columns are displayed in a table for all available project languages. You 
can enter the translations for each text there.

● Translating texts using reference texts
You can change the editing language for shorter texts. All the text cells are filled again with 
the default values and can be filled in the current language. As orientation, you can display 
what you last entered in the box in the reference language. To do this, select the "Tasks" 
task card and open the "Languages & resources".

● Exporting texts and translating them externally
With larger volumes of text, you can export the texts to an Office Open XML file and translate 
them with a normal table calculation program. You then import the translated texts again 
into the TIA Portal.

 

 Note
Using Asian project languages

East Asian project languages are only displayed correctly in Windows XP, if the option "Install 
files for East Asian languages" is selected on the Languages tab of Regional and Language 
Options in the Control Panel of Windows XP Professional.
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See also
Overview of the program settings (Page 199)

Changing the settings (Page 203)

Application examples for multilanguage projects (Page 273)

7.3.9.2 Select project languages
All the texts can be displayed within a project in the same language that you selected for your 
software user interface. This means that all project texts must exist in the corresponding 
language. You can select the available project languages yourself.

Requirement
● You are in the project view.

● A project is open.

Procedure
To select the project languages, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The elements below this are displayed.

2. Double-click on "Project languages".
In the work area, you will see a list of languages that you can select.

3. Select the required languages.

Result
All texts can be displayed in the activated languages if there is already a translation for these 
languages.

7.3.9.3 Setting the editing language
All the texts in the project are created in the editing language when they are entered. If you 
change the editing language, all future text input will be stored in the new editing language.

Requirement
● You are in the project view.

● A project is open.
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Procedure
To change the editing language, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The lower-level elements are displayed.

2. Double-click on "Project languages".
The possible settings for the project languages are displayed in the work area.

3. Select the editing language in "General > Editing language".

7.3.9.4 Translating all project texts in tabular form
You can display and edit all project text used in the currently open project in a list. User and 
system texts are separated into two different lists for clarity. Both lists contain a separate 
column for each project language in which you can enter the translations for text.

Requirement
● You are in the project view.

● You have selected at least one further project language.

Procedure   
To translate text in the project-wide list, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The elements below this are displayed.

2. Double-click "Project texts".
A list with the user texts in the project is displayed in the work area.

3. Click on "System texts" if you you want to edit the list of system texts rather than the user 
texts.

4. You can improve the clarity of the lists if you have a lot of texts.

– To group identical texts and to translate them all at once, click the "Switch on/off 
grouping" button in the toolbar.

– To hide texts that do not have a translation, click the "Filter for empty texts on/off" button 
in the toolbar.

– To further limit the displayed project texts to certain devices, select the devices for which 
you want to display project texts in the drop-down list.

5. Enter the translation of the project texts in the relevant column.

7.3.9.5 Translating text associated with individual objects
If you want to edit the text of individual objects, it would be too difficult to locate the matching 
text in the table with all project texts. For this reason, there is a table in the Inspector window 
in which only the texts assigned to the currently selected objects are displayed. In the table, 
you can add missing translations for individual project languages or change existing texts.
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Requirement
Text must be entered in at least one project language for the texts to be translated.

Procedure   
To edit the text of the currently selected object, follow these steps:

1. Select the object whose text you want to edit.

2. Open the "Properties" tab in the Inspector window.

3. Open the lower-level "Texts" tab in the inspector window.
A table with all the texts that belong to the selected objects is displayed. It contains one 
column for the currently selected editing language and the reference language, as well as 
additional columns for the other project languages.

4. Add or change the entries in the table for each project language.

See also
Application examples for multilanguage projects (Page 273)

7.3.9.6 Translating texts using reference texts

Introduction   
After changing the editing language, all texts are shown in input boxes in the new editing 
language. If there is not yet a translation available for the newly set language, the input boxes 
are empty or filled with default values.

If you enter text in an input box, this is saved in the current editing language. Following this, 
the texts exist in two project languages for this input field, in the previous editing language and 
in the current editing language. This makes it possible to create texts in several project 
languages.

You can display existing translations for an input box in other project languages. These serve 
as a comparison for text input in the current editing language and they are known as the 
reference language.

 

 Note

The display of reference texts depends on the installed products and is not supported by 
every editor.

 

Requirement
There is at least one translation into a different project language for an input field.
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Procedure
To display the translation of an input cell in a reference language, follow these steps:

1. In the "Tasks" task card, select the "Languages & Resources" pane.

2. Select a reference language from the "Reference language" drop-down list.

Result
The reference language is preset. If you click in a text box, translations that already exist in 
other project languages are shown in the "Tasks > Languages & Resources" task card.

7.3.9.7 Exporting and importing project texts
You can export project texts for translation and then reimport them. The texts are exported to 
an Office Open XML file with the extension ".xlsx". This can be edited in Microsoft Excel or a 
number of other spreadsheet programs.

The following export options are available:

● Exporting individual project texts

● Exporting all user texts or system texts at once
In this case, the export can be additionally limited by categories.

 

 Note
Row limit in Microsoft Excel

Note that spreadsheet programs may be able to process only a certain number of rows. 
Microsoft Excel 2003 supports a maximum of 65536 rows, for example. Later versions of 
Microsoft Excel support significantly more rows.

 

Exporting individual project texts   
To export individual project texts, follow these steps:

1. Open the "Languages & Resources" folder in the project tree.
The lower-level elements are displayed.

2. Double-click "Project texts".
The project texts editor opens.

3. Choose the "User texts" or "System texts" tab in the editor, depending on which texts you 
want to export.

4. Select the project texts you want to export.

5. Click the "Export project texts" icon in the toolbar of the editor.
The "Export" dialog box opens.

6. Choose the language you want to translate from in the "Source language" drop-down list.
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7. Choose the language you want to translate to in the "Target language" drop-down list. The 
drop-down list contains the project languages you specified previously. If the required 
language is missing, you must first specify it in the project languages editor.

8. Specify a file path and a file name for the export file in the "Select file for export" input box.

9. Click "Export".

Exporting all system or user texts   
To export all project texts, follow these steps:

1. Select the "Export project texts" command in the "Tools" menu.
The "Export" dialog box opens.

2. Choose the language you want to translate from in the "Source language" drop-down list.

3. Choose the language you want to translate to in the "Target language" drop-down list. The 
drop-down list contains the project languages you specified previously. If the required 
language is missing, you must first specify it in the project languages editor.

4. In "Select content", select the check box "User texts" to export user texts. To export system 
texts, select "System texts". To export both user texts and system texts, select both check 
boxes.

5. In "Select content", select the required text categories for the user texts or the system texts.

6. In the "Export file" input field, specify a file name for the export file.

7. In the "Path" input field, select a path in the data system to which the export file is to be 
saved.

8. Click "Export".

Importing project texts   
To import a file containing project texts, follow these steps:

1. Select the "Import project texts" command in the "Tools" menu.
The "Import" dialog box opens.

2. Select the path and the file name of the import file from the "Select file for import" field.

3. Select the "Import base language" check box if you have made changes to the base 
language in the export file and you want to overwrite the entries in the project with the 
changes.

4. Click "Import".

See also
Application examples for multilanguage projects (Page 273)
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7.3.9.8 Application examples for multilanguage projects

Introduction 
Let us assume you are working in a team with colleagues some of whom speak English, some 
French and some German. You have created a project with the TIA Portal and have already 
created a functioning configuration.

To allow your other colleagues to be able to keep track of the project, you would like all devices 
being used to have comments in English and German. First, you would like to enter the 
comments in German. Following this, to save time and costs, you want to have the texts 
translated into English in a spreadsheet program by an external translation office.

In addition to this, you also want a single comment for a particular device in French so that 
your French-speaking colleague can continue working on this device.

The section below describes an example of how you can achieve this with the tools of the TIA 
Portal.

Translating the project into English
To enter the comments in German and to have them translated into English later, follow these 
steps:

1. Set the editing language to "German" and fill all the comment boxes with the relevant texts 
in German.
On the device selected from the French-speaking colleague, enter, for example "Unser 
neues Gerät" in German first.
All the comments are now stored in German.

2. Export all user texts to an Office Open XML file with the extension ".xlsx".

3. Have the user texts contained in the file translated into English in a spreadsheet program 
such as Microsoft Excel.

4. Import the file into the TIA Portal after it has been translated.
All texts are now available in German and English.

Translating a single comment field to French
To translate an individual comment field to French, follow these steps:

1. Open the comment box for the device on which the French-speaking colleague will be 
working.

2. Open the "Languages & Resources" pane in the "Tasks" task card.

3. Set "French" as the editing language in the "Languages & Resources" pane. As the 
reference language, set, for example, "English".
Since no translation has yet been installed in French, the comment box is empty. In the 
"Languages & Resources" pane, the English translation "Our new device" is displayed as 
a reference.

4. Orientating yourself on the English reference text enter "Notre nouvel appareil" in the 
comment box.
The comment for this device is now available in the languages German, English and French.
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See also
Project text basics (Page 266)

Exporting and importing project texts (Page 271)

Translating text associated with individual objects (Page 269)

7.3.10 Archiving and retrieving projects

7.3.10.1 Working with project archives

Archiving and transferring projects     
If you work for a long time with a project, large files may result, especially with extensive 
hardware configurations. Therefore, you may want to reduce the size of the project, for 
example, when you archive it to an external hard drive, or when you send it via e-mail and 
require a smaller file size.

Options for reducing the size of the project
There are two ways to reduce the size of the project:

● TIA Portal project archives
TIA Portal project archives are compressed files, each containing an entire project, 
including the entire folder structure of the project. Before the project directory is compressed 
into the archive file, all files are reduced to their essential components to further decrease 
the size of the project. Project archives are therefore well suited for sending via e-mail.
Project archives of a project that was created with TIA Portal V11.x have the file extension 
". zap11". Projects created with TIA Portal V12.x have the file extension ". zap12".
To open a project archive, you need to retrieve the project. Here, the archive file is extracted 
into the original project directory structure with the included project files to a location you 
have selected.

● Minimized TIA Portal project
You can skip additional compression in an archive file, and instead create a copy of the 
project directory. The included files are reduced to the essential elements of the project. 
This minimizes the required storage space. The full functionality of the project is maintained 
and you can open the project as usual.
A minimized TIA Portal project is especially well suited for archiving, for example, on an 
external medium.

See also
Retrieving projects (Page 276)

Archiving projects (Page 275)
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7.3.10.2 Archiving projects
You can reduce the storage space required for the currently open project by compressing the 
project into a file, or by reducing the project files to their essential components. You can do 
both of these with the archiving function of the TIA Portal.

 

 Note

The most recently saved state of the project is used for archiving. Therefore, save the project 
before using the archiving function. This will ensure that your most recent changes are 
included in the archived project.

 

Procedure 
To archive a project, follow these steps:

1. Select the "Archive" command in the "Project" menu.
The "Archive current project as..." dialog opens.

2. Select the directory where you want to save the archive file or the new project directory.

3. Select the file type from the "File type" drop-down list:

– TIA Portal project archive, if you want to create a compressed file of the project.

– Minimized TIA Portal project, if you only want to create a copy of the project directory 
with minimal storage space.

4. Enter a file name in the "File name" field if you are creating an archive file. If you are creating 
a minimized project directory instead, enter the name of the new project directory to be 
created in the "File name" box.

5. Click "Save".

Result
When you have created a project archive, a compressed file is generated with the extension 
".zap11" (for projects created with version V11.x of the TIA Portal) or ".zap12" (for projects 
created with version V12.x of the TIA Portal). The file contains the complete project directory. 
The individual files of the project are also reduced to the essential components in order to save 
space.

If you have created a minimized TIA Portal project, only a copy of the original project directory 
is created at the desired location. The files contained within it are reduced to their essential 
components in order to save space.

See also
Working with project archives (Page 274)

Retrieving projects (Page 276)
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7.3.10.3 Retrieving projects
You can unpack projects that have been compressed with the archiving function of the TIA 
Portal. This restores the project directory structure including all project files.

Requirement 
No project should be open.

Procedure
To unpack a project archive, follow these steps:

1. Select the "Restore from archive" command in the "Project" menu.
The "Retrieve archived project" dialog opens.

2. Select the project archive.

3. Click "Open".

4. The "Find folder" dialog opens.

5. Select the target directory to which the archived project should be extracted.

6. Click "OK".

Result
The project is extracted to the selected directory and opened immediately.

See also
Working with project archives (Page 274)
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7.4 Using reference projects

7.4.1 Basics of reference projects

Introduction
You can open other projects as a reference in addition to the current project. You can use 
these reference projects as follows:

● You can drag individual objects from a reference project into the current project and then 
edit them.

● You can open specific objects, for example, code blocks from a reference project as read-
only. But this is not possible for all elements.

● You can use an offline/offline comparison to compare devices of the reference project to 
devices from the current project. 

Note that reference projects are read-only. You cannot change the objects of a reference 
project.

See also
Comparing reference projects (Page 278)

Opening and closing a reference project (Page 277)

Reference projects (Page 223)

7.4.2 Opening and closing a reference project

Opening a reference project
To open a reference project, follow these steps:

1. In the "Reference projects" palette of the project tree, click on "Open reference project" in 
the toolbar.
The "Open reference project" dialog box opens.

2. Navigate to the desired project folder, and open the project file. TIA Portal V12.x projects 
have the extension ".ap12". Older projects of the TIA Portal have the extension ".ap[version 
number]".

3. Click "Open".
The selected project is opened as a read-only reference project.
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Closing a reference project
To close a reference project, follow these steps:

1. In the "Reference projects" palette of the project tree, select the reference project you want 
to close.

2. Click on "Close reference project" in the toolbar.
The selected reference project is closed.

See also
Basics of reference projects (Page 277)

Comparing reference projects (Page 278)

Reference projects (Page 223)

7.4.3 Comparing reference projects

Introduction
You can compare devices from reference projects with devices from both the current project 
as well as from the same or another reference project or from a library.  

 

 Note

Please note the following:
● You cannot specify actions for the comparison objects, since the reference projects are 

write-protected.
● You can perform a detailed comparison for the comparison objects, if the type of 

comparison object generally allows a detailed comparison.
● When comparing reference projects, you can always switch between automatic and 

manual comparison.
 

Procedure
To compare the objects of a reference project to the device data of the current project, follow 
these steps:

1. In the project tree, select the device whose data you want to compare to the data of a 
reference project and which allows offline/offline comparison.

2. Select "Compare > Offline/Offline" from the shortcut menu.
The compare editor opens with the selected device displayed in the left area.

3. Open the "Reference projects" palette in the project tree.
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4. Select the device of a reference project that you want to compare to the device data from 
the current project.

5. Drag the device from the reference project into the right drop area of the compare editor.
You can identify the status of the objects based on the symbols in the status and action 
area. When you select an object, the object's properties and the corresponding object of 
the associated device is clearly shown in the properties comparison.
You can drag a library or other devices from a reference project from the current project 
into drop areas at any time and thus start a new comparison. It does not matter which device 
you drag into the drop area.

See also
Basics of reference projects (Page 277)

Reference projects (Page 223)

Opening and closing a reference project (Page 277)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)
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7.5 Editing project data

7.5.1 Compiling and loading project data

7.5.1.1 Compiling project data

General information on compiling project data

Compiling project data
During compilation, project data is converted so that it can be read by the device. Hardware 
configuration data and program data can be compiled separately or together. You can compile 
the project data for one or more target systems at the same time.

The following project data must be compiled prior to loading:

● Hardware project data, for example, configuration data of the devices or networks and 
connections

● Software project data, for example, program blocks or process screens
 

 Note

While a device is being compiled, no additional compiling process can be started. Note in 
this regard that you can not only perform a compiling process manually, but you can also 
trigger it automatically for HMI devices.

 

Scope of the compilation
When you compile project data, you have the following options depending on the device 
involved:

● Hardware and software (only changes)

● Hardware (only changes)

● Software (only changes)

● Software (rebuild all blocks)

● Software (reset memory reserve)

See also
Compiling project data (Page 281)
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Compiling project data
The following section describes the general procedure for compiling project data in the project 
tree. You will find details of how certain objects are compiled and any special points to note in 
the online help of the product.

Procedure     
To compile project data, follow these steps:

1. In the project tree, select the devices whose project data you want to compile.

2. Select the option you require in "Compile" submenu of the shortcut menu.
 

  Note

Note that the options available to you depend on the selected device.
 

The project data is compiled. You can check whether or not the compilation was successful 
in the Inspector window with "Info > Compile".

 

See also
General information on compiling project data (Page 280)

7.5.1.2 Downloading project data

General information on loading

Introduction
In order to set up your automation system, you must download the project data you generated 
offline to the connected devices. This project data is generated, for example when configuring 
hardware, networks, and connections or when programming the user program or when 
creating recipes. The first time you download, the entire project data is downloaded. During 
later loading operations, only changes are downloaded. You can download the project data to 
devices and memory cards.

 

 Note

While a device is being compiled, no additional download process can be started. Note in 
this regard that you can not only perform a compiling process manually, but you can also 
trigger it automatically for HMI devices.

 

Depending on the object you want to download, you have the following options:
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● Hardware and software
Both hardware configuration as well as software are downloaded to the destination.

● Hardware configuration
Only the hardware configuration is downloaded to the destination.

● Software (only changes)
Only the objects that differ online and offline are downloaded to the destination.

● Load PLC program to device and reset
All the blocks are loaded to the destination and all values are reset to their initial state. Be 
aware that this also applies to retentive values.

You can also upload project data already contained in a device back to your project. You have 
the following options:

● Uploading a complete device
All relevant data of the device is uploaded to the project.

● Uploading blocks and parameters
Only the blocks and parameters from the device are uploaded to the project. 

In both cases all instances of library types are connected again with the corresponding version 
of the type in the project library during loading. If no suitable type is yet available for a loaded 
instance or the correct version of the type does not exist in the project library, the type or the 
version is added to the project library.

See also
Downloading project data to a device (Page 282)

Downloading project data to a memory card (Page 283)

Uploading project data from a device (Page 284)

Downloading project data to a device
The following section describes the general procedure for downloading project data to a device. 
You will find details of how certain objects are downloaded and any special points to note in 
the online help of the product.

Requirement     
● The project data is consistent.

● Each device to which you want to download is accessible via an online access.

Procedure
To download the project data to the selected devices, follow these steps:

1. Select one or more devices systems in the project tree.

2. Right-click on a selected element.
The shortcut menu opens.

Editing projects
7.5 Editing project data

WinCC Comfort/Advanced V12.0 SP1
282 System Manual, 07/2013,  



3. Select the option you require in the shortcut menu of the "Download to device" submenu.
 

  Note

Note that the options available to you depend on the selected device.
 

When necessary, the project data is compiled. 

– If you had previously established an online connection, the "Load preview" dialog opens. 
This dialog displays messages and proposes actions necessary for downloading.

– If you had not previously established an online connection, the "Extended download to 
device" dialog opens, and you must first select the interfaces via which you want to 
establish the online connection to the device.
See also: Auto-Hotspot 

4. Check the messages in the "Load preview" dialog, and select the actions in the "Action" 
column, if necessary.

 

  Note

Performing the proposed actions while the plant is in operation can cause serious bodily 
injury and property damage in the event of malfunctions or program errors.

Make sure that no dangerous situations can arise before you start the actions! 
 

As soon as loading becomes possible, the "Load" button is enabled.

5. Click the "Load" button.
The loading operation is performed. The "Load results" dialog then opens. In this dialog, 
you can check whether or not the loading operation was successful and take any further 
action that may be necessary.

6. Click the "Finish" button.

Result
The selected project data was downloaded to the devices. 

See also
General information on loading (Page 281)

Downloading project data to a memory card (Page 283)

Uploading project data from a device (Page 284)

Downloading project data to a memory card

Requirement   
The memory card is displayed.

See also: Accessing memory cards (Page 336)
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Procedure
To download project data to a memory card, follow these steps:

1. Use a drag-and-drop operation in the project tree to take the project data you want to 
download and move it to the memory card.
The "Load preview" dialog opens. This dialog displays messages and proposes actions 
necessary for downloading.

2. Check the messages, and select the actions in the "Action" column, if necessary.
As soon as loading becomes possible, the "Load" button is enabled.

3. Click the "Load" button.
The loading operation is performed. The "Load results" dialog then opens. In this dialog, 
you can check whether or not the loading operation was successful and take any further 
action that may be necessary.

4. Click the "Finish" button.

See also
General information on loading (Page 281)

Downloading project data to a device (Page 282)

Uploading project data from a device (Page 284)

Uploading project data from a device
The following section describes the general procedure for uploading project data from a device. 
Which project data you can upload from a device depends on the products installed.

You have the following basic options for uploading project data from a device to your project:

● Uploading a device to a programming device or PC
You can use this option to start with an empty project and upload existing project data 
directly from a device.

● Uploading from device
Only certain project data are uploaded from the device to the project. You will find the project 
data that can be downloaded in the online help of the product.

In both cases all instances of library types are connected again with the corresponding version 
of the type in the project library during loading. If no suitable type is yet available for a loaded 
instance or the correct version of the type does not exist in the project library, the type or the 
version is added to the project library.

Requirements     
● A project is open.

● The hardware configuration and software to be downloaded have to be compatible with the 
TIA Portal. If the data on the device was created with a previous program version or with 
a different configuration software, please make sure they are compatible.
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Uploading a device to a programming device or PC
To upload the complete device to your project, follow these steps:

1. Select the project name in the project tree.
The "Upload device to PG/PC" command in the "Online" menu is then enabled.

2. In the "Online" menu, select the "Upload device to PG/PC" command.
The "Upload device to PG/PC" dialog opens.

3. Select the type of interface you want to use for the load operation in the "Type of the PG/
PC interface" drop-down list.

4. Select the interface to be used from the "PG/PC interface" drop-down list.

5. Click the "Configure interface" button to the right of the "PG/PC interface" drop-down list to 
adapt the settings for the selected interface.
See also: Auto-Hotspot 

6. In the accessible devices table, select the device from which you want to upload project 
data.

7. Click on "Load".
Depending on the selected device, a dialog appears in which you have to enter additional 
information, such as the position of the module rack.
The project data of the device is uploaded to the project. You can edit it offline and then 
download it to the device again.

Uploading from device
To upload only certain project data from a device to your project, follow these steps:

1. Establish an online connection to the device from which you want to download the project 
data.
See also: Auto-Hotspot 

2. Select an element in the project tree that allows uploading of project data.
As a result, the "Upload from device" command in the "Online" menu becomes enabled.

3. Select the "Upload from device" command in the "Online" menu.
The "Upload preview" dialog box opens.

4. Check the messages in the "Upload preview" dialog, and select the necessary actions in 
the "Action" column.
As soon as uploading becomes possible, the "Upload from device" button is enabled.

5. Click the "Upload from device" button.
The loading operation is performed. 

See also
General information on loading (Page 281)

Downloading project data to a device (Page 282)

Downloading project data to a memory card (Page 283)

Editing projects
7.5 Editing project data

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  285



7.5.2 Comparing project data

7.5.2.1 Basics of project data comparison

Function
You can compare project data of the same type in order to determine possible differences. In 
principle, the following comparison methods are available:

● Online/offline comparison
With this type of comparison, the objects of a device are compared to the objects of a 
project. This is only possible when you establish an online connection to the device.

● Offline/offline comparison
With this type of comparison you can compare objects from projects or libraries. You can 
decide whether the comparison should be performed automatically for all objects or whether 
you want to compare individual objects manually.

● Detailed comparison
For some objects, for example, blocks, you can also perform a detailed comparison in 
addition to the online/offline and offline/offline comparison. This involves opening the blocks 
to be compared beside each other and highlighting the differences.

A simple online/offline comparison is performed as soon as you establish an online connection. 
During this process, comparable objects in the project tree are marked with icons that represent 
the result of the comparison. 

The normal online/offline and offline/offline comparison is performed in the compare editor. 
You can also select actions for non-identical objects in the comparison editor.

 

 Note
● Not all objects allow all types of comparison. Which comparison method you can use for 

which project data depends on the products installed.
● Compile your user program before you start a comparison or detailed comparison. After 

each change of the program during a comparison, repeat this step before you update the 
result of the comparison. This ensures that the comparison shows the current status.

 

See also
Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

Running a detailed comparison (Page 294)
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7.5.2.2 Carrying out an online/offline comparison

Requirement 
The project tree is open.

Procedure
To perform an online/offline comparison, follow these steps:

1. Select a device in the project tree that allows online/offline comparison.

2. Select the "Compare > Offline/online" command in the shortcut menu.

3. If you have not already established an online connection to this device, the "Go online" 
dialog opens. In this case, set all the necessary parameters for the connection and click 
"Connect". 
The online connection is established and compare editor opens.

Result
All objects that exist online and offline are displayed. The symbols in the comparison editor 
and in the project tree show you the status of the objects. In the compare editor, you can now 
define certain actions for the objects, depending on their status. 

See also
Basics of project data comparison (Page 286)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

Running a detailed comparison (Page 294)

7.5.2.3 Carrying out offline/offline comparisons
With an offline/offline comparison, you can compare project data of two devices within one 
project or from different projects or from the library. You can decide whether the comparison 
should be performed automatically for all objects or whether you want to compare individual 
objects manually. 

You can drag any other device to the drop area at any time to perform further comparisons.

Requirement
The project tree is open.
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Performing automatic offline/offline comparisons
To perform an automatic offline/offline comparison, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 
All existing objects of the selected devices are displayed depending on the settings of the 
compare editor. You can identify the status of the objects based on the symbols in the 
compare editor. You can define certain actions depending on the status of the objects. 

Performing manual offline/offline comparisons
To perform a manual offline/offline comparison, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library.

4. In the status and action area, click on the button for switching between automatic and 
manual comparison.

5. Select the objects that you want to compare.  
The properties comparison is displayed. You can identify the status of the objects based 
on the symbols. You can define certain actions depending on the status of the objects.

See also
Basics of project data comparison (Page 286)

Carrying out an online/offline comparison (Page 287)

Using the comparison editor  (Page 288)

Running a detailed comparison (Page 294)

7.5.2.4 Using the comparison editor 

Overview of the comparison editor

Function
The comparison editor gives an overview of the results of online/offline and offline/offline 
comparisons in a table. You can also define which actions are to be carried out for non-identical 
objects compared. 
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Components of the comparison editor
The following figure shows the components of the compare editor using a manual offline/offline 
comparison as an example:

① Compare editor toolbar

② Drop areas (offline/offline comparison only)

③ Left comparison table

④ Right comparison table

⑤ Status and action area

⑥ Button to switch between automatic and manual comparison (offline/offline comparison 
only)

⑦ Properties comparison
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Compare editor toolbar
With the toolbar, you can access the following compare editor functions: 

● Only show different objects
You can hide identical objects to make the comparison easier to follow.

● Show identical and different objects
You can display identical objects if you want to fully view the comparison.

● Scope of the comparison
You can define which objects are to be compared. 

● Start detailed comparison
You can start a detailed comparison for objects to show the individual differences. This 
function is, however, not available for every object. 

● Updating comparison results
After you have modified objects, you can update the comparison results using this function. 

● Synchronizing non-identical objects
You can synchronize non-identical objects using specific actions. 

● Changing the view
You can choose between a hierarchical and a flat view. In the hierarchical view, the devices 
are shown in their structure; in the flat view, the objects of the devices are listed without 
structure. 

Drop areas
In the case of an offline/offline comparison, you can drag the devices you want to compare 
into the drop areas. The devices to be compared can originate from a project, from reference 
projects, from the project library or from global libraries. However, note that you can only drop 
complete libraries into the right drop area.

Comparison tables
Comparison tables show the objects of the devices being compared to one another. 

The following table shows the meaning of the columns of the comparison table:

Column Description
Name Name of the compare object
Comment Comment on the compare object
Title Title of the compare object
Address Address of the compare object
Type Type ofcompare object
Language Programming language set for the compare object.
Time stamp interface Time of the last modification to the block interface 
Time stamp code Time of the last modification to the source code
Author Name of the author of the compare object
Version Version of the compare object
Family Name of the object family
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Column Description
Load memory Memory usage of the load memory of the compare object
Work memory Memory usage of the work memory of the compare object
Modified on Time of last modification
Program signature Program signature of the compare object (SIMATIC Safety)
Interface (checksum) Checksum of the block interface of the compare object (SIMATIC Safety)

Not all columns are shown in the default setting. However, as in all table editors, you can show 
or hide the columns as required and sort according to individual columns. 

Status and action area
The status and action area offers the following options:

● With an offline/offline comparison, you can switch between automatic and manual 
comparison.

● You can view the results of automatic comparison. The results are displayed with symbols.

● You can define actions for non-identical objects.

Status and action symbol 
The following table shows the comparison results symbols for an online/offline comparison:

Symbol Description
Folder contains objects whose online and offline versions differ

Comparison results are not known

Online and offline versions of the object are identical

Online and offline versions of the object are different 

Object only exists offline

Object only exists online

The following table shows the comparison results symbols for an offline/offline comparison:

Symbol Description
Actual program

Version compared

Folder contains objects of which the versions compared differ

Results of the offline/offline comparison are not known

The versions of the object compared are identical
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Symbol Description
The versions of the object compared differ

Object only exists in the output program

Object only exists in the version compared

The following table shows the symbols for possible actions:

Symbol Description
No action

Overwrite the object of the compared version with the object from the output 
program
Overwrite the object of the output program with the object from the compared 
version
Different actions for the compare objects in the folder

Properties comparison
The properties comparison compares the properties of the selectedcompare objects. The 
result is displayed with symbols. Only the properties comparison is made with a manual 
comparison so that the status and action area remains empty. With automatic comparison, 
you can perform the property comparison in addition to the comparison in the comparison 
tables.

See also
Basics of project data comparison (Page 286)

Changing the view (Page 297)

Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Filtering the comparison editor view (Page 293)

Updating the comparison results (Page 294)

Synchronizing non-identical objects (Page 295)
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Filtering the comparison editor view
You can improve the clarity of the compare editor using the following filters:

● Hiding identical comparison objects
You can hide comparison objects which have identical online/offline or offline/offline 
versions. Any such comparison objects you have hidden can also be shown again at any 
time.

● Displayed objects
You can define the objects for which comparison results are to be shown. 

 

Requirement   
The compare editor is open.

Hiding identical comparison objects
To hide identical objects, follow these steps:

1. Click on the "Show only objects with differences" button in the toolbar.
Only the elements that differ online and offline are displayed.

Showing identical comparison objects
To show identical objects again, follow these steps:

1. Click on the "Show identical and different objects" button in the toolbar.
All elements will be displayed.

Selecting displayed objects
To select the objects for which comparison results should be displayed, follow these steps:

1. Click on the arrow button in the drop-down list in the toolbar.

2. Select the desired object.

See also
Changing the view (Page 297)

Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Overview of the comparison editor (Page 288)

Updating the comparison results (Page 294)

Synchronizing non-identical objects (Page 295)
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Running a detailed comparison
 

 Note

Not all objects allow a detailed comparison. The project data for which you can perform a 
detailed comparison depends on the products installed.

 

Procedure
Proceed as follows to perform a detailed comparison:

1. First, perform an online/offline or an offline/offline comparison.
The compare editor opens.

 

  Note

You can only perform a detailed comparison for objects that are listed in the left as well 
as the right comparison table.  

 

2. In the compare editor, select the object for which you want to perform a detailed comparison. 

3. Click the "Start detailed comparison" button in the toolbar.

See also
Basics of project data comparison (Page 286)

Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Changing the view (Page 297)

Updating the comparison results
As soon as you change an object, the comparison results are no longer valid and must be 
updated. 

 

 Note

For online/offline comparisons, you should note that changes in the device may result in the 
system automatically updating the comparison editor if objects in the comparison are affected 
by the change. This can have the following results:
● Some of the actions you have defined may become invalid, for example if the device no 

longer contains the object in question. Objects with such invalid actions will be highlighted 
so you can define new, valid actions.

● The selection you made before the automatic update may also be cancelled.
 

Requirement   
The comparison editor is open.
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Procedure
To update the comparison results, follow these steps:

1. Click the "Refresh view" button in the toolbar.
The comparison results are updated.

 

  Note

Please note that the "Refresh view" button will not be available while the comparison editor 
is loading or synchronizing content. 

 

See also
Changing the view (Page 297)

Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Overview of the comparison editor (Page 288)

Filtering the comparison editor view (Page 293)

Synchronizing non-identical objects (Page 295)

Synchronizing non-identical objects

Specifying actions
If you have performed a comparison, you can specify the actions to be performed for non-
identical objects in the compare editor. You cannot select any actions for identical objects. 

In the case of an online/offline comparison, only synchronization actions in one direction are 
permitted, in order to retain program consistency. Thus, for example, you can load multiple 
blocks to a device or from a device, but you cannot perform a combination of loading actions 
in one synchronization action. In this case, the first action you set in the compare editor 
determines the synchronization direction. For example, if you specify for a block that the offline 
block is to be loaded to the device, then the other objects can also only be loaded to the device 
via a synchronization action. To load objects from the device again, first select the "No action" 
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option. You can then specify the action settings again as required. Or, you can perform a new 
comparison.

 

 Note

Please note the following CPU-specific aspects when defining actions:
● S7-300/400:

– You can define actions for the "Program blocks" folder, for folders you have created 
yourself or for individual blocks.

– Neither SCL nor GRAPH blocks can be loaded from the device to the offline project.
● S7-1200/1500:

– You can define actions for the "Program blocks" folder, for folders you have created 
yourself or for individual blocks. If you have performed an online/offline comparison 
and select download to the device as action, a consistent download is executed. If you 
upload the object from the device to the project, however, you can also upload 
individual blocks.

– SCL blocks cannot be loaded from the device to the offline project.
 

Requirement 
The compare editor is open. 

Procedure
To select an action for a non-identical object, follow these steps:

1. In the status and action area, double-click in the "Action" column on the cell of the object 
for which you want to define an action. 
The cell changes to a drop-down list.

2. Click on the drop-down list.

3. Select the action you want.
The action set will be carried out for the object in question the next time synchronization is 
performed. 
If you have accidentally changed the action you had selected, you can undo the change 
before the next synchronization. 

4. To restore the previous action selected, right-click on the object or folder.

5. Select the "Restore previous selection" command in the shortcut menu. 

See also
Overview of the comparison editor (Page 288)

Filtering the comparison editor view (Page 293)

Updating the comparison results (Page 294)

Synchronizing objects (Page 297)
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Synchronizing objects
Synchronization executes the actions you have specified for non-identical objects. Note, 
however, that in the case of an online/offline comparison you can only perform actions in one 
direction in one synchronization action.

Requirement
● The compare editor is open.

● The desired actions have been selected.

Procedure
To synchronize objects, follow these steps:

1. Click the "Execute actions" button in the toolbar.

Result
The actions you specified for the objects are performed. 

See also
Overview of the comparison editor (Page 288)

Filtering the comparison editor view (Page 293)

Updating the comparison results (Page 294)

Specifying actions (Page 295)

Changing the view
You can choose between a hierarchical and a flat view. In the hierarchical view, the devices 
are shown in their structure; in the flat view, the objects of the devices are listed without 
structure. 
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Setting the hierarchical view
To set the hierarchical view, follow these steps:

1. Click the "Display in hierarchical view" button in the toolbar of the comparison editor.

Setting the flat view
To set the flat view, follow these steps:

1. Click the "Display in flat view" button in the toolbar of the comparison editor.

See also
Basics of project data comparison (Page 286)

Overview of the comparison editor (Page 288)

Filtering the comparison editor view (Page 293)

Running a detailed comparison (Page 294)

Updating the comparison results (Page 294)

Synchronizing non-identical objects (Page 295)

7.5.3 Protecting project data

7.5.3.1 Protection concept for project data

Introduction     
You can protect your project data from unauthorized access. These include, for example:

● Access protection for devices

● Copy and display protection of objects

● Restrictions for printouts of know-how-protected objects

For objects with know-how protection, this protection is also retained after the object is pasted 
into a library. Note that every protection mechanism is not available for all objects. How to 
protect specific objects is described in the online help of the product. 

Revoking access rights for devices
If you want to execute a function that is password-protected by means of the device protection 
level, you are prompted to enter a password. When the password is entered correctly, you can 
execute the required function. You continue to have access rights on the device until you close 
the TIA Portal. 

If you want to reactivate password protection while the TIA Portal is open, you can explicitly 
revoke the access rights for a device. As a result, certain functions for the protected device 
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cannot be executed until the correct password is entered again. You specify the functions for 
which a password must be entered when you assign the device protection level. 

See also
Printing project data (Page 317)

7.5.3.2 Revoking access rights for devices

Requirement    
● A protection level has been set for the device.

● A protected function for the device has been enabled by entering the password.

Procedure
To revoke the access rights for the device, follow these steps:

1. Select the device for which you want to revoke access rights in the project tree.

2. Select the "Delete access rights" command in the "Online" menu.

Result
The access rights are revoked, and starting from now the user will be prompted to enter the 
password again to execute a password-protected function on the device. The function can only 
be executed if the correct password is entered. 

If the device has an online connection, it will be disconnected. 

See also
Protection concept for project data (Page 298)

7.5.4 Printing project contents

7.5.4.1 Printing project documentation

Documentation settings

Introduction 
Once a project is created, the contents can be printed in an easy-to-read format. You may print 
the entire project or individual objects within the project. A well-structured printout is helpful 
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when editing the project or performing service work. The printout can also be used for your 
customer presentations or as full system documentation.

You can prepare the project in the form of standardized circuit manuals and print it in a uniform 
layout. You can limit the scope of the printout. You have the option to print to the entire project, 
individual objects along with their properties, or a compact overview of the project. In addition, 
you can print the contents of an open editor.

Improving the printout with frames and cover pages 
You can design the appearance of the printed pages according to your own requirements, for 
example, to add your own company logo or the corporate design of your company in the project 
documentation. You can create any number of design variants as frames and cover pages. 
The frames and cover pages are stored in the project tree under the item "Documentation 
settings" and are part of the project. You can insert placeholders for data from previously 
entered document information within the frames and cover pages. These will be filled 
automatically with the appropriate metadata during printing.

If you want to avoid designing your own template, there are ready-made frames and covers 
pages available. These include templates complying with the ISO standard for technical 
documentation.

Modular structure of a printout 
An printout generally consists of the following components:

● Cover page (only when printing from the project tree)

● Table of contents (only when printing from the project tree)

● Name and path of an object within the project tree

● Object data

Printout of the cover page or the table of contents can be deactivated in the "Print" dialog.

See also
Creating frames (Page 306)

Creating a cover page (Page 306)

Editing cover pages and frames (Page 308)

Entering document information (Page 304)

Print function for module labels (Page 319)
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Printout of project contents

Availability of print function     
The following contents can be printed:

● An entire project in the project tree

● One or more project-related objects in the project tree

● Contents of an editor

● Tables

● Libraries

● Diagnostics view of the Inspector window

It is not possible to print in the following areas:

● Portal view

● Detailed view

● Overview window

● Compare editor

● All tabs of the Inspector window, except the diagnostics view

● All task cards, except the libraries

● Most of the dialogs

● Properties and devices of the programming device/PC not related to the project, for example 
online portals and connected card readers.

Scope of printout   
To be able to print, at least one printable element has to be selected.

If a selected object is printed, all subordinate objects are also printed. For example, if a device 
is selected in the project tree, all of its data is also printed. If you select the entire project in 
the project tree for printing, all project contents are printed with the exception of the graphical 
views. These have to be printed separately. Items in the project tree that are not part of the 
project cannot be printed. For example, this includes online portals and connected card readers 
and USB memory devices.

When table contents are printed, all lines in the table in which a cell is selected are printed. In 
order to print one or more table columns, the desired columns must be selected. If no individual 
cells or columns are selected, the entire table is printed.
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Limitations when printing   
In general, it is possible to print all objects that can be visualized on the user interface. 
Conversely, this means that you cannot print objects that you do not have access to. If a printout 
fails, possible reasons may include the following:

● A valid license does not exist for displaying an object.

● There is no device description for an object.

● A software component needed to display an object is not installed.

See also
Printing project data (Page 317)

Changing the print settings

Changing the print settings   
You can specify general print settings that are retained even after the TIA Portal is closed and 
re-opened. Some settings are dependent on the products installed. The following settings are 
possible in every case:

Always print table data as pairs of values
If this option is selected, tables are not printed in tabular format but rather as a pairs of key 
and value.

Example:

Object name Property 1 Property 2
Object A Value A1 Value A2
Object B Value B1 Value B2

In this case, the printout has the following appearance:

Object A

Property 1: Value A1

Property 2: Value A2

Object B

Property 1: Value B1

Property 2: Value B2
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Printing mask editors
● Always print data in tables

All parameters of technology objects are printed in tabular format.

● Print mask graphics if possible
If the utilized editor supports this function, the contents of the editor are not printed as a 
table but rather as a complete graphic as it appears on the screen.

Procedure
To change the print settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group.

3. Select the desired default settings in the "Print settings" area.
The changes are applied immediately and are retained for all projects, even after the TIA 
Portal is closed.

See also
Overview of the print settings (Page 202)

Specifying the print layout

Specifying the print layout     
If you do not want to rely on ready-made print templates, you can specify your own cover page 
or your own layout for the individual pages. Your designs are saved together with the respective 
project.

Your designs for the cover page and your templates for the page layout can be found in the 
project tree under the "Documentation information" group. You will also find metadata on the 
project there under the entry "Document information". For subsequent print operations, you 
can customize the appearance of the printout in the "Print" dialog using the saved cover pages 
and page layout templates and the available metadata.

Designing the cover page   
The cover page can be customized. You can insert a background graphic and provide 
placeholders for text on the page. The placeholders are automatically filled with data from a 
documentation information during printing.

Cover pages are located in the project tree under the "Documentation information > Cover 
pages" group.
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Designing the content page   
The regular pages of a printout can contain the following elements:

● Frame with static content, such as a company logo

● Place holders for text, such as the name of the project, the page number, and the time the 
printout was started
Several different values for the individual placeholders can be specified in the document 
information. Other values, such as the project name, are preassigned and are inserted 
automatically during printing.

● Footnote
The footnote is always output below the content area.

● Content area
You can specify an area where the printed content is to be embedded.

The design of the content pages is saved in Frames. The individual frames are located in the 
project tree under the "Documentation information > Frames" group.

Entering document information
You can enter metadata in the document information for every project. In addition, a print frame 
and a cover page are specified in the document information. You can create different 
information, if required, to enable you to quickly switch between different document information 
containing different information, frames, cover pages, page sizes, and page orientations when 
printing. For example, this is useful if you want to generate printouts in different languages and 
different document information is provided for each language.

In the documentation editor, you can specify placeholders on the cover page or in the frame 
of the regular pages. These placeholders can be automatically replaced with metadata from 
the documentation information during printing.

The various document information are therefore part of the printing function and specify the 
print layout and print content.

Procedure  
To add metadata, follow these steps:

1. To create new document information, double-click "Add new document information" under 
"Documentation information > Document information" in the project tree.
The new document information is created and opened immediately.

2. Enter a name for the set in the "Name" field.

3. Fill in the individual fields with the metadata for the project.
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Managing cover pages and frames

Using cover pages and frames

Uses for cover pages
You can give your plant documentation printouts a professional appearance by adding a cover 
page. You can design your own cover page or use ready-made cover pages. Ready-made 
cover pages can be adapted and stored again as a template.

Cover pages can be saved in global libraries where they are available for use across projects.

Cover pages are designed for use as a right printed page only.

Uses of frames  
You can embed the regular pages of your plant documentation inside a consistently uniform 
page frame. The frame can contain placeholders for project metadata, which is stored in the 
document information. It can also contain graphic elements that you design yourself.

You can create your own frames or rely on ready-made page frames. You can adapt a ready-
made page frame and then store it again as a new frame.

Like cover pages, frames can be saved in global libraries where they are available for use 
across projects.

Frames are designed for use on right printed pages only.

Cover pages and templates in the project tree  
Cover pages and frames associated with the project are stored in the project tree under the 
entry "Documentation information". There are separate folders here for frames and cover 
pages.

The following actions are available in the project tree for cover pages and frames.

● Creating your own subfolders

● Copying and pasting

● Inserting cover pages and frames from the "Documentation templates" system library

● Copying cover pages and templates to a global library

Cover pages and templates in libraries  
The "Documentation templates" system library contains a few cover pages and templates that 
are available in every project. The cover pages and templates can be moved from there to the 
project tree using a drag-and-drop operation. You can then adapt the cover pages and 
templates in the project tree according to the requirements of your project.

Cover pages and templates can be moved from the project tree to a global library. Afterwards, 
these are available in every project.

Editing projects
7.5 Editing project data

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  305



See also
Library basics (Page 338)

Overview of the "Libraries" task card (Page 339)

Designing cover pages and frames (Page 308)

Using ready-made frames and cover pages (Page 307)

Creating frames
You can create any number of frames for each project. The frames are stored in the project 
tree below the "Documentation information > Frames" group. You can assign a frame to all 
document information. When you select document information for printing, its associated frame 
is used.

Procedure  
To create a new frame, follow these steps:

1. Double-click the entry "Add new frame" below the "Documentation information > Frames" 
group in the project tree.
The "Creating frames" dialog opens.

2. Enter a name for the frame in the "Name" field.

3. Choose the paper size from the "Paper type" drop-down list.

4. Choose whether the page is to be created in portrait or landscape format in the "Orientation" 
drop-down list.

Click the "Add" button.

Result
A new frame is created. The frame is then opened automatically in the documentation editor 
where it can be edited.

See also
Editing cover pages and frames (Page 308)

Creating a cover page (Page 306)

Creating a cover page
You can create any number of cover pages for the printout for each project. The cover pages 
are stored in the project tree below the the "Documentation information > Cover pages" group. 
You can assign a cover page to all document information. When you select specific document 
information for printing, its associated cover page is used.
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Procedure  
To create a new cover page, follow these steps:

1. Double-click the entry "Add new cover page" below the "Documentation information > Cover 
pages" group in the project tree.
The "Add new cover page" dialog box opens.

2. Enter a name for the cover page in the "Name" field.

3. Choose the paper size from the "Paper type" drop-down list.

4. Choose whether the page is to be created in portrait or landscape format in the "Orientation" 
drop-down list.

Click the "Add" button.

Result
A new cover page is created. The cover page is then opened automatically in the 
documentation editor where it can be edited.

See also
Editing cover pages and frames (Page 308)

Creating frames (Page 306)

Using ready-made frames and cover pages
The TIA Portal comes with some ready-made frames and cover pages. These can change 
according to your wishes.

Procedure  
To create and edit the ready-made frames and cover pages, follow these steps:

1. Open the "Global libraries" pane in the "Libraries" task card.

2. In the "Templates" folder, open the "Cover Pages" or "Frames" folder.

3. Drag a cover page or a frame from one of the folders into the project tree and drop it into 
one of the following folders:

– For frames: "Document information > Frames"

– For cover pages: "Document information > Cover pages".

The ready-made frame or cover page can now be used in the project.

4. Double-click on the new entry in the project tree click to edit the frame or the cover page.

See also
Using cover pages and frames (Page 305)

Editing cover pages and frames (Page 308)
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Designing cover pages and frames

Editing cover pages and frames
The documentation editor is a graphical editor which allows you to design frames and cover 
pages for your plant documentation. You can place images or text elements on the frame and 
the cover pages in the document editor. The text elements are either static or they are 
automatically filled during printing with the data from the document information that you have 
selected in the print dialog.

Procedure     
To edit a cover page or a frame in the documentation editor, follow these steps:

1. In the project tree, double-click on the entry for an existing cover page or frame under the 
"Documentation information > Frames " or "Documentation information > Cover pages" 
group.
The documentation editor opens.

2. Design the cover page or frame as desired.

3. Close the documentation editor.
The changes to the cover page or frame are applied automatically.

See also
Creating a cover page (Page 306)

Creating frames (Page 306)

General operation of the documentation editor (Page 309)
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General operation of the documentation editor

Components of the documentation editor   
The following figure provides an overview of the components of the documentation editor:
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① Toolbar
The toolbar provides the following tools (from left to right):
● Arrow tool

Enables object selection.
● Navigation tool

Allows shifting of the partial page.
● Zoom-in button

Magnifies the page display incrementally.
● Zoom-out button

Reduces the page display incrementally.
● Selecting a zoom factor

Adapts the page size to the area selected with the lasso zoom tool.
● Dynamic zoom

Adapts the page width to the work area.
② Work area

You can design the cover page or frame in the work area.
③ "Toolbox" task card

The "Toolbox" task card contains various types of placeholders that you can use on 
the cover sheet or frame. The placeholders can be placed in the work place using 
a drag-and-drop operation.

④ Properties in the Inspector window
You can display and modify the properties of the currently selected object in the 
"Properties" tab of the Inspector window. For example, you can modify the properties 
of the page, format text, specify the position of objects on the page, etc.
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Operation in the documentation editor
The following basic functions are available in the documentation editor:

● Drag-and-drop functionality
The documentation editor is a graphic editor, which means you can place objects anywhere 
with the mouse. An image of the page is displayed in the work area. This image corresponds 
to the ultimate print layout.
If you want to select objects on the page in order to move them or modify their properties, 
the arrow tool must be activated in the toolbar.

● Zoom function
You can use the zoom function to change the size of the page display. You have two options 
for changing the page size:

– Via the buttons in the toolbar
Select the "Zoom in" or "Zoom out" magnifying glass button in the toolbar of the 
documentation editor. Then click on the page in order to magnify (zoom in) or reduce 
(zoom out) the page incrementally.
To zoom in on a particular area, select the "Select zoom factor" tool and use the mouse 
to drag an outline around the area you want to focus on.
To continuously zoom in or zoom out of the work area, use the "Dynamic zoom" tool. 
To magnify the page display, click anywhere on the work area, and then hold down the 
mouse button while dragging the mouse toward the top of the page. To reduce the page 
display, drag the mouse toward the bottom of the page.

– Via the zoom bar
You can also use the zoom bar (located in the bottom right corner of the work area) to 
change the display size. Choose a percentage value from the drop-down list or enter a 
percentage value. Alternatively, you control the display size using the slider.

● Navigation over the page
In addition to scrolling, you the option of changing the partial page with the navigation tool. 
To change the partial page with the navigation tool, select the Hand button in the toolbar. 
Then, click anywhere on the page and hold the mouse button down while moving the page 
to the desired position.

Using and adapting the positioning aids
You have various aids at your disposal to help you position elements on the page:

● Rulers
Rulers are affixed to the page margins in the work area.

● Page grid
A grid is placed underneath the page in the work area.

You can display, hide or adapt the positioning aids in the Inspector window under "Properties 
> Rulers and grid". You can make the following settings:

● Units:
Specify the unit of measurement for the grid and the rulers.

● Grid steps:
Specify the width of the grid.

● Show grid:
Specify whether the grid is to be displayed or hidden.
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● Snap to grid:
Specify whether objects are to be aligned automatically to the grid. If the option is selected, 
the grid lines function like a "magnet".

● Show rulers:
Specify whether the rulers are to be displayed.

See also
Editing cover pages and frames (Page 308)

Specifying the print area (Page 312)

Inserting placeholders for metadata (Page 312)

Specifying the print area
An area within the frame is provided for the actual printed contents. The project data is then 
always inserted inside this defined and uniformly consistent area within the frame. You can 
adjust the size of the print area.

Requirement  
A frame is open in the documentation editor.

Procedure
To define an area for the printed contents, follow these steps:

1. Click on the slightly darker area within the page display in the documentation editor to select 
the area for the print content.
This opens the properties of the area to be printed in the Inspector window.

2. Enter the position of the print area on the X and Y axes in the Inspector window.

3. Specify the width and height of the print area in cm in the Inspector window.

Alternatively, you can change the width and position of the print area in the graphic display of 
the page. To do so, use the mouse to drag the margins of the print area until the desired size 
and position are achieved.

See also
Creating frames (Page 306)

General operation of the documentation editor (Page 309)

Inserting placeholders for metadata
You can provide placeholders on the cover page and in a frame. The placeholders are 
automatically filled with metadata from documentation information during printing, if they are 
placeholders for text. Alternatively, you can add non-modifiable data, such as free text or an 
image.
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All elements are arranged in numbered Z-Orders. If objects overlap, you can determine in 
which sequence these are to be arranged.

Types of placeholders
The following types of placeholders are available to you:

● Text field
The text field stands as a placeholder for a text element from a document information. In 
the properties of the text field, you set which text from a document information should be 
automatically inserted during printing.

● Field for date and time
A date and time is inserted instead of the placeholder when printing. This can be the date 
of creation or the point in time when the last change was made to the project. In the 
properties of the Inspector window, you specify which date or time is printed.

● Page number
The correct page number is automatically applied when printing.

● Free text
You can enter freely selectable text in the properties of the text field. The text is static and 
is not influenced by the document information selected at the time of printing.

● Image
Select the image file in the properties of the placeholder in the Inspector window. Images 
in the formats BMP, JPEG, PNG, EMF or GIF are possible.

Requirement
An cover page or frame is open in the documentation editor.

Procedure     
To insert placeholders for metadata on the cover sheet or in a frame, follow these steps:

1. Drag a field from the "Toolbox > Elements" task card to the work area of the documentation 
editor.
The placeholder is inserted. The placeholder properties are shown in the Inspector window 
and can be edited there.

2. Select the metadata to be inserted during printing from the "Text" drop-down list in the 
Inspector window under "Properties > General > Text box". Alternatively, you have the 
option of entering free text or selecting an image depending on the type of placeholder.

3. In the Inspector window under "Properties > General > Position and size", specify the 
position of the placeholder on the X and Y axis and enter the width and height of the text 
box in cm. You specify the sequence of the objects in the "Z-Order" field, if these overlap. 
The smaller the value, the further down an object is located.

4. In the Inspector window, go to "Properties > View" and select the font formatting and the 
orientation of the text as well as the alignment of the text. You cannot make this setting for 
images.
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See also
General operation of the documentation editor (Page 309)

Displaying print preview

Creating a print preview

Creating a print preview   
You can create a preview of the printout. Document information can be chosen for this, in the 
same way as as for the actual printout. In this way, you preview the selected frame and, if 
applicable, the cover sheet. The settings are retained for later printing.

Procedure
To create a print preview and to set the scope of the later printout, follow these steps:

1. Select the "Print preview" command in the "Project" menu.
The "Print preview" dialog opens.

2. Select the frame layout you want to use for the printout.

– In the "Document information" drop-down list, select the documentation information you 
want to use later for the printout. 

– Select the "Print cover page" check box to print the cover page, which is specified in the 
selected document information.

– Select the "Print table of contents" check box to add a table of contents to the printout.

The check boxes for printing the cover page and the table of contents can only be selected 
if you have started the printout in the project tree.

3. Under "Print objects/area", select what is to be printed. The selection is only possible if you 
have started the printout from an editor that supports this function.

– Choose "All" to print out the entire content of the editor.

– Choose "Selection" to print only the objects currently selected in the editor.
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4. Select the print scope under "Properties".

– Choose "All" to print all configuration data of the selected objects.

– Choose "Visible" to print the information of an editor that is currently visible on the 
screen. This option can only be chosen if you have started the printout from an editor 
that supports this function.

– Choose "Compact" to print out an abbreviated version of the project data.

5. Click "Preview" to generate the preview.
A print preview is created in the work area.

 

  Note
Wait time for extensive documents

It can take several minutes to generate the print preview in the case of very extensive 
projects. You can continue working normally in the meantime on systems with adequate 
resources. The progress of the print preview is shown in the status bar.

 

See also
Operation within the print preview (Page 316)
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Operation within the print preview

Functions within the print preview
The print preview shows an exact image of the subsequent printout. You can use the buttons 
in the toolbar to modify the print preview display. The following functions are available (from 
left to right):

● Navigation mode
Allows shifting of the partial page.
To change the partial page with the navigation tool, select the arrow button in the toolbar. 
Then, click anywhere on the page and hold the mouse button down while moving the page 
to the desired position.

● Zoom function

– "Zoom in" and "Zoom out"
Magnifies or reduces the page display.
To zoom in or zoom out the display incrementally, select the corresponding button. Then 
click on the page in order to magnify (zoom in) or reduce (zoom out) the page 
incrementally.
To zoom in on a particular area, select the "Lasso zoom" button and use the mouse to 
drag an outline around the area you want to focus on.
To select an area to focus on, select the button "Zoom in / zoom out with rectangle". 
With the mouse, drag a border around the area to focus on it.
To zoom dynamically through the page, select the button "Zoom in / zoom out 
dynamically". With pressed mouse button, scroll down over the page to zoom in. Scroll 
up to zoom out.

– Percentage value in the drop-down list
Specifies the display size of the page in percent.
Enter a percentage value or select a percentage value from the drop-down list. 
Alternatively, choose the the "Fit to page" option from the drop-down list to adapt the 
page size to the work area. Or, choose "Fit to width" to adapt the page width to the work 
area.
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● "Forward" and "Backward":
Each change in the partial page, the page count, or the display size is saved in a history in 
the background. You can use the "Forward" or "Backward" button to return to the previous 
view or the next view.

● Page navigation

– "First page"
Jumps back to the first page.

– "Previous page"
Goes one page back.

– "Page number" input field
Shows the current page. To jump directly to a page, enter the page number of the page 
you want to view.

– "Next page"
Goes to the next page.

– "Last page"
Jumps to the last page.

See also
Creating a print preview (Page 314)

Printing project data
You have two options for printing out project data:

● Print immediately using default settings by means of the "Print" button in the toolbar.
The button is only active if a printable object is selected.

● Printout with additional setting options with the "Project > Print" menu command.
For example, you can choose a different printer or specific documentation information or 
you can specify whether a cover page and table of contents are to be printed. In addition, 
you can specify the print scope or display a print preview prior to printing.

Requirement 
● At least one printer is configured.

● The objects to be printed are not protected.
The print scope for protected objects is limited. Disable the know-how protection to print 
the objects in full.
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Printing project data   
To print out data from the current project or the entire project with additional setting options, 
follow these steps:

1. Select the entire project in the project tree in order to print out the entire project. To print 
only individual elements within a project, select them in the project tree.

2. Select the "Print" command in the "Project" menu.
The "Print" dialog opens.

3. Select the printer in the "Name" box.

4. Click "Advanced" to modify the Windows printer settings.

5. Select the frame layout you want to use for the printout.

– Select the documentation information in the "Document information" drop-down list.
The frame stored in the document information is used for the printout. All placeholders 
within the chosen frame are filled with the metadata from the selected document 
information.

– Select the "Print cover page" check box to print the cover page, which is stored in the 
selected document information.

– Select the "Print table of contents" check box to add a table of contents to the printout.

The check boxes for printing the cover page and the table of contents can only be selected 
if you have started the printout in the project tree.

6. Under "Print objects/area", select what is to be printed. The selection is only possible if you 
have started the printout from an editor that supports this function.

– Choose "All" to print out the entire content of the editor.

– Choose "Selection" to print only the objects currently selected in the editor.

7. Select the print scope under "Properties".

– Choose "All" to print all configuration data of the selected objects.

– Choose "Visible" to print the information of an editor that is currently visible on the 
screen. This option can only be chosen if you have started the printout from an editor.

– Choose "Compact" to print out an abbreviated version of the project data.

8. Click "Preview" to generate a print preview in advance.
A print preview is created in the work area.

9. Click "Print" to start the printout.
 

 Note
Scope of the "Print" dialog

The options available in the "Print" dialog vary depending on the elements to be printed.
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Result
The project data is prepared in the background for printing and then printed on the selected 
printer. The status bar shows the progress of the print operation. You can continue working 
normally while data is being prepared for printing.

The print results and any errors or warnings are listed in the Inspector window under "Info" at 
the conclusion of the print job.

Canceling a print job   
To cancel an active print job, follow these steps:

1. Click the red "X" in the status bar next to the progress display for the printout.
The printout is cancelled promptly.

See also
Protection concept for project data (Page 298)

Revoking access rights for devices (Page 299)

Printout of project contents (Page 301)

Designing cover pages and frames (Page 308)

7.5.4.2 Printing module labels

Print function for module labels

Printing of module labels for hardware modules
You can print labels for the modules in your project with the help of the TIA Portal. The labels 
are custom-fit to each module and can contain the following printed information:

● Symbolic name of the input or output

● Absolute address of the input or output

● Symbolic name and additionally the absolute address of the input or output. The order of 
the information can be specified.

The modules are displayed graphically in the device view. If you set the zoom level in the 
device view to at least 200%, the labels for the individual modules will be visible. The printout 
on the labels corresponds to the representation of the labeling in the device view.

The following figure shows an example of two modules in the device view on which the labeling 
of the inputs and outputs is visible:
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Export and further editing as Microsoft Word file
Before you can print them, the labels are first exported as a Microsoft Word file (.docx). This 
file can be further edited with commonly available word processing programs such as Microsoft 
Word 2010. The individual labels are represented as a table in the .docx file. You can format 
the text or the backgrounds of the individual cells as desired.

The character spacing of the text within the table is adapted by default, so that texts are not 
truncated. If you want to prevent this from stretching or compressing the text too much, change 
the character spacing of the text in the table cell properties.

Print media
You can print the labels either on ready-made print sheets or on standard DIN A4 paper. You 
can separate the individual labels from the ready-made print sheets and insert them in the 
designated labeling areas of your modules. If you print on standard paper, the individual labels 
must be cut out. Cut marks are automatically included on the printout and serve as aids.

Because the paper feeds of different printers differ slightly, the printout may be slightly offset 
on the paper. When the labels are printed on ready-made print sheets, printing that is accurate 
to the millimeter is important, because otherwise the text will not be custom-fit inside the 
stamped area. In addition, if the printing is imprecise, the labeling of an input or output may 
no longer be congruent with the channel status displays of the module. For this reason, you 
can enter an offset value for your printer in the TIA Portal to ensure precise printing. For 
information on how to determine the proper offset value for your printer, refer to Chapter 
"Determining the print area offset (Page 322)".
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See also
Printing labels (Page 321)

Determining the print area offset (Page 322)

Documentation settings (Page 299)

Printing labels
You can print labels for the modules in your project if provision has been made for attaching 
labels to the utilized modules. The labels are first exported to a Microsoft Word file (.docx). A 
separate .docx file is created for each module family (for example, for all selected S7-1500 
modules). You can then modify the labels according to your wishes. The labels are always 
printed from the word processing program.

If no provision has been made for printing labels, the corresponding shortcut menu command 
is inactive. If you have selected multiple modules for printing of labels and at least one of the 
modules does not support this, a message is shown on the "Info > General" tab of the Inspector 
window. The message lists all unsupported modules, and the export of the print file is continued 
for the supported modules.

Requirement
● The chosen modules must support the printing of labels.

● A word processing program that supports Microsoft Word .docx files must be installed, e.g., 
Microsoft Word 2010.

● You need the ready-made labels for your modules or commercially available DIN A4 paper.

Procedure
To print labels for hardware modules, follow these steps:

1. In the project tree, select the modules for which you want to print labels.

– You can select one or more stations in order to print out labels for all modules plugged 
into these stations.

– Or, select the desired modules below the stations in the "Local modules" folder.

2. Right-click on one of the devices, and select the "Export labels" command from the shortcut 
menu.
The "Export labels" dialog box opens.

3. In the "Content of label" area, select which data are to be printed on the label.

– Choose "Symbolic name" in order to print the symbolic name of the input or output 
(corresponds to the contents of the "Name" column in the IO tag table).

– Choose "Absolute address" in order to print the absolute address of the input or output 
(corresponds to the contents of the "Address" column in the IO tag table).

– Choose "Absolute and symbolic address" or "Symbolic and absolute address" in order 
to print both addresses. The print order corresponds to the indicated order.
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4. Select which paper you plan to print on in the "Paper type" area.

– Choose "Print on SIEMENS label sheet" if you want to print on a ready-made label sheet 
for your modules.

– Choose "Print on standard paper" if you want to print on standard DIN A4 paper.

5. In the "Offset print area" area, select correction values for your printer, if required, for proper 
orientation of the print area. This is only necessary if you are printing on ready-made labels.

– Enter a correction value, in millimeters, in the "Vertical offset" field. A negative value 
shifts the print area upward. A positive value shifts the print area downward.

– Enter a correction value, in millimeters, in the "Horizontal offset" field. A negative value 
shifts the print area to the left. A positive value shifts the print area to the right.

6. In the "Path" field, select the path to which the exported .docx files should be stored.

7. Click the "Export" button to start the export to a .docx file.
The .docx files are created.

8. Open the .docx files with a conventional word processing program, such as Microsoft Word 
2010, and change the design of the labels if necessary.

9. Print out the labels from your word processing program. To do so, use the paper that you 
specified in the Export dialog box.

10.If you are using ready-made sheets, separate the labels at the stamped lines provided for 
that purpose. When standard DIN A4 paper is used, you must cut out the labels.

See also
Determining the print area offset (Page 322)

Determining the print area offset
If you are using a ready-made label sheet, the printing on it must be applied precisely so that 
the text is properly oriented on the prestamped labels and will have the proper fit relative to 
the channel status displays of the module. However, the paper feeds vary slightly from one 
printer to another. For this reason, you must enter a suitable correction value for your printer 
in the TIA Portal, if necessary. The print area is then shifted in the exported .docx file in such 
a way that the printing fits precisely on the ready-made label sheet.

The settings for shifting the print area are stored for the specific Windows user. If you log on 
to Windows using a different user name, you have to enter the correction values again.

The procedure for determining the correction value for your printer is described below.

Requirement
● You require a ready-made label sheet.

● You must have access to the actual printer that you will use subsequently for the printout. 
The printer must be made ready for printing on standard DIN A4 paper.
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Procedure
To determine the correction value for your printer, follow these steps:

1. Print out a label sheet on standard DIN A4 paper, as described in Chapter "Printing labels 
(Page 321)".

2. Compare the printout on the DIN A4 paper with the ready-made label sheet.

3. If the print area is offset, you must use correction values.

– Using a ruler, measure the horizontal offset relative to the ready-made label sheet. This 
will be entered later in the "Horizontal offset" field of the Export dialog box for the printing. 
If the print area is offset to the right, a negative correction value must be entered. If the 
print area is offset to the left , a positive correction value must be entered.

– Using a ruler, measure the vertical offset relative to the ready-made label sheet. This 
will be entered later in the "Vertical offset" field of the Export dialog box for the printing. 
If the print area is offset downward, a negative correction value must be entered. If the 
print area is offset upward, a positive correction value must be entered.
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7.6 Undoing and redoing actions

7.6.1 Basics of undoing and redoing actions

Function     
You can undo performed actions at any time. For this purpose, every action you perform is 
saved in an action stack. When undoing actions, the stack is processed from top to bottom. In 
other words, if you undo an action that lies further down in the stack, all actions located above 
it in the stack will also be undone automatically. 

You can redo previously undone actions until you execute a new action. Once you execute a 
new action, it is no longer possible to redo previously undone actions.

Particularities for undoing
There are a few actions that empty the action stack. You cannot undo these actions or the 
actions performed before these actions. The following actions empty the action stack:

● Saving

● Project management (creating a new project, opening project, closing a project, deleting a 
project)

● Compiling

● Restoring blocks

● Establishing an online connection

● Loading

● Writing to memory cards

Displaying the action stack
The "Undo" button in the toolbar is enabled as soon as you perform an action that can be 
undone. This button is split; you can use the arrow down portion to open a drop-down list 
containing all actions of the action stack that you can undo. If you had performed actions in 
an editor other than the currently displayed editor, the corresponding editor is also displayed 
as a subheading. This allows you to always identify the point at which the undo operation will 
be applied. The subheadings are removed from the list when the editor responsible can no 
longer undo actions. 

Actions you have undone are entered in the action stack from where they can be redone. Here, 
you can redo actions you have undone. The display of actions you can redo it is analogous to 
the display of the actions that you can undo.
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Example of undoing actions
The figure below shows how actions performed in various editors and tables are undone:

In this example, you cannot undo actions 1 to 3 because the project was saved. You can undo 
actions 4 to 10 in the order indicated by the direction of the arrow. In other words, you must 
undo action 10 first. Once you have undone action 8, you cannot then undo action 5. You must 
first undo actions 7 and 6. As the final step in the sequence, you can then undo action 4. You 
also have the option of undoing several actions in a single step by undoing an action located 
further down in the action stack. All actions located above it in the stack will be undone 
automatically. 

The same principle also applies to redoing of actions. 

See also
Undoing an action (Page 325)

Redoing an action (Page 326)

7.6.2 Undoing an action
The following options are available for undoing actions:

● Undoing the last action only
Only the last action performed is undone.

● Undoing as many actions as required
Multiple actions in the action stack are undone in a single step.
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Undoing the last action only
To undo the last action performed, follow the steps below:

1. Click the "Undo" button in the toolbar.

– If the action was not performed in the currently displayed editor, a confirmation prompt 
appears.

– If the undo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

2. Click "Yes" to confirm.

3. Enter the password, if necessary.
The editor in which the action was performed is displayed and the action is undone.

Undoing as many actions as required
To undo multiple actions in the action stack in a single step, follow these steps:

1. Click the Down arrow next to the "Undo" button in the toolbar.
This opens a drop-down list containing all actions you can undo. Actions performed in other 
editors are identified by the editor name in the subheading.

2. Click the action you want to undo.
The chosen action and all actions in the stack located above the chosen action are undone. 
If the undo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

3. Enter the required passwords, if necessary.
The editors in which the actions were performed are displayed and the actions are undone. 

See also
Basics of undoing and redoing actions (Page 324)

Redoing an action (Page 326)

7.6.3 Redoing an action
You have the option of redoing an action that has been undone, so that you can return to the 
status present before "Undo" was performed. However, this is only possible until you perform 
a new action. The following options are available for redoing actions:

● Redoing the last undone action only
Only the last undone action is redone.

● Redoing as many undone actions as required
Multiple undone actions in the action stack are redone in a single step.
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Redoing the last undone action only 
To redo the last undone action, follow the steps below:

1. Click the "Redo" button in the toolbar.

– If the action is not being redone in the currently displayed editor, a confirmation prompt 
appears.

– If the redo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

2. Click "Yes" to confirm.

3. Enter the password, if necessary.
The editor in which the action was undone is displayed and the action is redone.

Redoing as many undone actions as required
To redo multiple undone actions in the action stack in a single step, follow these steps:

1. Click the Down arrow next to the "Redo" button in the toolbar.
This opens a drop-down list containing all actions you can redo. Actions performed in other 
editors are identified by the editor name in the subheading.

2. Click the action you want to redo.
The chosen action and all actions in the stack located above the chosen action are redone. 
If the redo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

3. Enter the required passwords, if necessary.
The editors in which the actions were undone are displayed and the actions are redone. 

See also
Basics of undoing and redoing actions (Page 324)

Undoing an action (Page 325)
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7.7 Finding and replacing in projects

7.7.1 Information on the search function

Find and replace   
You can search for texts in the editors. The search function finds all texts containing the search 
key in the currently opened editor. The results are selected in sequence in the opened editor.

You also have the following options:

● Narrowing down the search with additional options

● Replacing found texts

The additional options and the type of texts for which you can search depend on the installed 
products and the currently open editor.

See also
Search and replace (Page 328)

7.7.2 Search and replace

Using Find  
The "Find and replace" function enables you to search for or replace texts in an editor.

Additional options for searching
You can narrow down your search by selecting one of the following additional options:  

● Whole words only
Only whole words are found. Words that contain the search key as part of the word are 
ignored.

● Match case
Upper- and lowercase letters are taken into account in the search.

● Find in substructures
The search also includes texts contained in another object.
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● Find in hidden texts
Texts that are assigned to another text but that are currently hidden are also included in 
the search.

● Use wildcards
Enter an asterisk as the wildcard for any number of characters. Example: You want to 
search for all words starting with "Device". Type in "Device*" in the search key box.
Enter a question mark as the wildcard, however, if you only want to leave out a single 
character.

● Use regular expressions (for searching in scripts only)
A regular expression is a character string used to describe sets of values and for filtering. 
This allows you to create complex search patterns.

The additional options available depend on the installed products and the editor opened.

Start search  
Follow these steps to start the "Find and replace" function:

1. Select the "Find and replace" command in the "Edit" menu or open the "Find and replace" 
pane in the "Tasks" task card.
The "Find and replace" pane opens.

2. Enter a term in the "Find" drop-down list.
As an alternative, you can select the most recent search key from the drop-down list.

3. Select the options desired for the search.

4. Using the option buttons, select the starting point for the search and the search direction.

– Select "Whole document" if you want to search through the entire editor regardless of 
the current selection,

– Select "From current position" if you want to start the search at the current selection.

– Select "Selection" if you only want to search within the current selection.

– Select "Down" to search through the editor from top to bottom or from left to right.

– Select "Up" to search through the editor from bottom to top or from right to left.

5. Click "Find".
The first hit is marked in the editor.

6. Click "Find" again to display the next hit.
The next hit is marked in the editor. Repeat this process, as necessary, until you reach the 
last hit.

Replacing the search key  
You have the option of replacing hits individually or automatically replacing all the found texts, 
if the respective editor supports this function. Follow these steps to replace terms:

1. Enter a term in the "Find" drop-down list.
As an alternative, you can select the most recent search key from the drop-down list.

2. Select the options desired for the search.
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3. Click the "Find" button to start a search for the specified search key.
The first hit is displayed in the editor.

4. In the "Replace" drop-down list, enter the text you wish to use to replace the search key.
As an alternative, you can select the most recently text specified from the drop-down list.

5. Click the "Replace" button to replace the selected hit with the specified text.
The found text is replaced and the next hit is marked in the editor.
Repeat this process until you have replaced all the hits as wanted. To skip to the next hit 
without replacing the marked word, click the "Find" button instead of "Replace".

6. Click "Replace all" to automatically replace all hits at once.

See also
Information on the search function (Page 328)
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7.8 Working with text lists

7.8.1 Text lists

Introduction  
You can manage texts to be referenced in alarms centrally. All the texts are stored in text lists. 
Each text list has a unique name with which you can call up its content. A range of values is 
assigned to each text in a text list. If a value from a range of values occurs, the corresponding 
text is called up.

All the texts can be translated to all project languages. Here, you have two options available:

● You can enter the translation of the texts in a list. You will find the list in the project tree 
under "Languages & Resources > Project texts".

● You can export all texts to a file in Office Open XML format and enter the translation in a 
spreadsheet program. The translations can then be imported again.

The texts are translated into the other project languages within the framework of the project 
texts. In the text lists editor, you only have to manage the assignment of individual texts to a 
text list.

Each device in the project has its own text lists. For this reason, these lists are arranged under 
the devices in the project tree. In addition, there are text lists that apply to all devices. These 
can be found in the project tree under "Common data > Text lists".

User-defined and system-defined text lists
There are two types of text lists:

● User-defined text lists
You can create user-defined text lists yourself and fill them with texts; in other words, you 
can specify value ranges and the corresponding texts yourself. With user-defined text lists, 
the name of the text list begins with "USER" as default. You can change this name to any 
suitable name.

● System-defined text lists
System-defined text lists are created by the system. These always involve texts relating to 
devices. They are automatically created as soon as you insert a device in the project. With 
system alarms, the name of the text list begins with "SYSTEM". The name of the text list 
and the ranges of values it contains cannot be modified. You can only edit texts assigned 
to individual value ranges.

User-defined text lists System-defined text lists
A user-defined text list can only be assigned to one 
device.

System-defined text lists can be assigned both to 
a device as well as to the entire project.

You can create new text lists and delete existing 
text lists.

You cannot create new text lists or delete text lists.
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User-defined text lists System-defined text lists
You can add and delete value ranges in the text 
lists.

You cannot add or delete value ranges in the text 
lists.

You can specify both the value ranges as well as 
the associated texts.

You can only edit the text associated with one 
value range.

Device-specific and cross-device text lists
Device-specific text lists relate to only one device in the project and are therefore only valid 
for this device. For this reason, they are arranged under a device in the project tree. Device-
specific text lists can be used-defined or created by the system. 

If system-defined text lists are generally valid for several devices or not intended uniquely for 
one device, these are grouped together in the project tree under "Common data". These text 
lists are available for all devices. Cross-device text lists are always created by the system and 
are used solely for system diagnostics alarms. For this reason, you cannot store any user-
defined text lists under "Common data". 

See also
Exporting and importing project texts (Page 271)

7.8.2 Creating user-defined text lists

Creating text lists
You can create user-defined text lists for individual devices.

Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.

Procedure
To create user-defined text lists, follow these steps:

1. Click on the arrow to the left of a device in the project tree.
The elements arranged below the device are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device are displayed in the work area listed in a table.

3. Double-click on the first free row in the table.
A new user-defined text list is created.

4. Enter a name for your new text list in the "Name" column.
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5. From the drop-down list in the "Selection" column, select whether you want to specify the 
value ranges in decimal, binary or in bits. Depending on the device, there may be further 
options available at this point.

6. Enter a comment in the "Comment" column.
A new user-defined text list has been created and you can now enter the value ranges and 
texts.

7.8.3 Editing user-defined text lists

Editing user-defined text lists  
You can enter value ranges and the corresponding texts in user-defined text lists. User-defined 
text lists are always located below a device in the project tree.

Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.

Adding to user-defined text lists with value ranges and texts  
To add to user-defined text lists with value ranges and texts, follow these steps:

1. Click on the arrow to the left of a device in the project tree.
The elements arranged below are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device are displayed in the work area listed in a table.

3. Select a text list in the table.
The contents of the selected text list are displayed in the work area. There, you can enter 
a value range and assign texts to the individual value ranges.

4. Enter the value ranges you require in the "Range from" and " Range to" columns. The entry 
must be made in the numeric format selected for the text list.

5. Enter a text for each value range in the "Entry" column.

7.8.4 Editing system-defined text lists

Editing system-defined text lists  
In system-defined text lists, you can only modify the individual texts assigned to a value range. 

System-defined text lists are located in the project tree either below a device or under 
"Common data".
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Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.

Modifying texts in system-defined text lists  
To edit texts in system-defined text lists that are assigned to a value range, follow these steps:

1. Click on the arrow to the left of a device in the project tree or the "Common data" element.
The elements arranged below are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device or used in common are displayed in the work area 
listed in a table.

3. Select a text list in the table.
The contents of the selected text list are displayed in the work area. Here, you can add to 
or edit the texts assigned to a value range.

4. Enter a text for each value range in the "Entry" column.

Editing projects
7.8 Working with text lists

WinCC Comfort/Advanced V12.0 SP1
334 System Manual, 07/2013,  



7.9 Using memory cards

7.9.1 Basics about memory cards

Introduction 
Memory cards are plug-in cards that come in a variety of types and can be used for a variety 
of purposes. Depending on the device type or device family, memory cards can be used for 
purposes, such as: 

● Load memory of a CPU 

● Storage medium for projects, firmware backups, or any other files

● Storage medium for performing a firmware update

● Storage medium for the PROFINET device name 

For information regarding the technical variants of the respective memory cards and general 
information on their handling, refer to the respective documentation for the device. For 
information on handling memory cards in the TIA Portal, refer to the online help under keyword 
"Memory Card".

 

 NOTICE

Do not use memory cards for non-SIMATIC-related purposes, and do not use third-party 
devices or Windows tools to format them. This will irrevocably overwrite the internal structure 
of the memory card, rendering it unusable for SIMATIC devices!

 

 

See also
Adding a user-defined card reader (Page 335)

Accessing memory cards (Page 336)

Displaying properties of memory cards (Page 337)

7.9.2 Adding a user-defined card reader

Introduction
If your card reader is not detected automatically, you can add it manually.

Requirement   
The project view is open.
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Procedure
To add a card reader, follow these steps:

1. Open the project tree.

2. Select the "Card Reader / USB memory > Add user-defined Card Reader" command in the 
"Project" menu.
The "Add user-defined Card Reader" dialog opens.

3. In the drop-down list box, select the path for the card reader.

4. Confirm your entries with "OK".

See also
Basics about memory cards (Page 335)

Accessing memory cards (Page 336)

Displaying properties of memory cards (Page 337)

7.9.3 Accessing memory cards

Requirement   
● A memory card is inserted in the card reader.

● The project view is open.

Procedure
To access memory cards, follow these steps:

1. Open the project tree.

2. Select the "Card Reader / USB memory > Card Reader / Show USB memory" command 
in the "Project" menu.
The "Card reader / USB memory" folder is displayed in the project tree.

3. Open the "Card Reader / USB memory" folder.
You can now access the memory card. 

 

  Note

If data from a non-installed product is stored on the memory card, the folders that contain 
these data are shown in gray. You receive an error message when you attempt to access 
such a folder. Install the corresponding product if needed.
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See also
Basics about memory cards (Page 335)

Adding a user-defined card reader (Page 335)

Displaying properties of memory cards (Page 337)

7.9.4 Displaying properties of memory cards
You can display the properties for the utilized memory cards. Note that different memory cards 
with different properties must be used, depending on the device.

Requirement
● A memory card is inserted in the card reader.

● The project view is open.

Procedure
To display the properties of a memory card, follow these steps:

1. Right-click on the memory card for which you want to display the properties.

2. Select the "Properties" command in the shortcut menu.
The "Memory Card <name of the memory card>" dialog opens. The properties are displayed 
in this dialog.

 

See also
Basics about memory cards (Page 335)

Adding a user-defined card reader (Page 335)

Accessing memory cards (Page 336)
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7.10 Using libraries

7.10.1 Library basics

Introduction
You can store objects you want to reuse in libraries. For each project there is a project library 
that is connected to the project. In addition to the project library, you can create any number 
of global libraries that can be used over several projects. Since the libraries are compatible 
with each other, library elements can be copied and moved from one library to another. 
Libraries are used, for example, to create templates for blocks that you first paste into the 
project library and then further develop there. Finally, you copy the blocks from the project 
library to a global library. You make the global libraries available to other employees working 
on your project. They use the blocks and further adapt them to their individual requirements, 
where necessary.

Both the project library and global libraries distinguish between two different types of objects:

● Master copies
Almost every object can be saved as a master copy and pasted into the project again later. 
You can, for example, save entire devices with their contents or cover sheets for plant 
documentation as master copies.

● Types
Elements that are required to run user programs, for example, blocks, PLC data types, user-
defined data types or faceplates are suitable as types. Types can be versioned and 
therefore support professional further development. Projects using the types can be 
updated as soon as new versions of the types are available.

Project library
Each project has its own library, the project library. Here, you store the objects you want to 
use more than once in the project. This project library is always opened, saved, and closed 
together with the current project.

Global libraries
In addition to the project library, you create global libraries if you want to use these over several 
projects. Global libraries are independent of a specific project and can therefore be passed on 
to other users. Shared access to global libraries is also possible, for example on a network 
drive, if all users open the global library with write protection.

Siemens supplies global libraries for its own software products. These include off-the-peg 
functions and function blocks that you can use within your project. The supplied libraries cannot 
be changed.

Global libraries from TIA Portal V11.x can continued to be used. However, you have to upgrade 
them for use in the latest TIA Portal version.
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Comparing library objects
You can compare blocks and PLC data types with the objects of a device. This allows you to 
determine, for example, whether certain blocks or PLC data types have been used in a project 
and whether they have been modified. 

See also
Overview of the "Libraries" task card (Page 339)

Overview of the library view (Page 343)

Overview of the library management (Page 346)

Basics on master copies (Page 357)

Basics on types (Page 361)

7.10.2 Using the "Libraries" task card

7.10.2.1 Overview of the "Libraries" task card

Function of the "Libraries" task card 
The "Libraries" task card enables you to work efficiently with the project library and the global 
libraries.
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Layout of the "Libraries" task card
The "Libraries" task card consists of the following components:

① "Library view" button
② "Project library" palette
③ "Global libraries" palette
④ "Elements" palette
⑤ "Info" palette
⑥ "Types" folder
⑦ "Master copies" folder
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"Library view" button
The "Library view" button is used to change to the library view. The "Libraries" task card and 
the project tree are closed by this action.

See also: Using the library view (Page 343)

"Project library" palette
In the "Project library" palette, you can store the objects that you want to use more than once 
in the project. 

"Global libraries" palette
In the "Global libraries" palette, you can store objects you want to use over several projects. 

The "Global libraries" palette also lists libraries that were shipped together with the products 
you purchased. These libraries provide you with ready-made functions and function blocks, 
for example. The supplied global libraries cannot be edited. 

"Elements" palette
In this palette, you can display the contents of folders in the library. The "Elements" palette is 
not displayed by default. If you want to display the "Elements" palette, you have to enable it 
first. Three view modes are available in the "Elements" palette:

● Details mode
The properties of folders, master copies and types are shown in table form in details mode.

● List mode
In list mode, the contents of folders are listed.

● Overview mode
In overview mode, the contents of folders are displayed with large symbols.

See also: Using the element view (Page 342)

"Info" palette
You can display the contents of the library elements in the "Info" palette. The individual versions 
of types and the last revision date of the version are also displayed.

"Types" folder
In the "Types" directories, you can manage types and type versions of objects that you use as 
instances in the project.

See also: Using types (Page 361)

"Master copies" folder
In the "Master copies" directories, you can manage master copies of objects that you can use 
as copies in the project.
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See also: Using master copies (Page 357)

See also
Library basics (Page 338)

Comparing library elements (Page 385)

7.10.2.2 Using the element view

Introduction 
When you open the "Libraries" task card the first time, the "Project library" and "Global libraries" 
palettes are opened and the "Info" palette is closed. You can display the "Elements" palette if 
needed. 

The elements view shows the elements of the selected library. Three view modes are available 
in the elements view:

● Details
The properties of folders, master copies and types are shown in table form in details mode.

● List
In list mode, the contents of folders are listed.

● Overview
In overview mode, the contents of folders are displayed with large symbols.

The "Info" palette shows the contents of the selected library element. If you select a type in 
the elements view, for example, the type versions are displayed in the "Info" palette.

Requirement
The "Libraries" task card is displayed.

Procedure
To use the element view, follow these steps:

1. Click "Open or close the element view" in the "Project library" or "Global libraries" pane.

2. To change the view mode from the details view to the list mode or overview mode, click the 
corresponding icon on the toolbar.

See also
Library basics (Page 338)

Overview of the "Libraries" task card (Page 339)

Using global libraries (Page 348)

Comparing library elements (Page 385)
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7.10.3 Using the library view

7.10.3.1 Overview of the library view

Function of the library view
The library view combines the functionality of the "Libraries" task card and the overview 
window. In the library view, the elements of a library are displayed in various views. In the 
details view, for example, you see additional properties of the individual elements. You can 
also edit and version the types in the library view.
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Layout of the library view
The following figure shows the components of the library view:

① Library tree
② Library overview
③ "Library view" button
④ "Open or close library overview" button

Library tree
The library tree is similar to the "Libraries" task card, apart from a few minor differences. In 
contrast to the task card, there is no "Elements" palette, because the elements are displayed 
in the library overview. In addition, you can close the library view in the library tree, or open 
and close the library overview.

See also: "Libraries" task card (Page 339)
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Library overview
The library overview corresponds to the overview window and displays the elements of the 
currently selected object in the library tree. You can display the elements in three different 
views. In addition, you can perform the following actions in the library overview:

● Renaming elements

● Deleting elements

● Copying elements 

● Moving elements

● Editing type instances

● Versioning types

● WinCC only: Editing faceplates and HMI user data types

See also: Overview window (Page 226)

See also
Basics on master copies (Page 357)

Basics on types (Page 361)

Opening and closing the library view (Page 345)

Library basics (Page 338)

Comparing library elements (Page 385)

7.10.3.2 Opening and closing the library view
The library view is opened automatically in some cases, for example, when you edit the test 
instance of a type or when you edit faceplates and HMI user data types. You can also open 
the library view manually.

Opening the library view
To open the library view manually, follow these steps:

1. Open the "Libraries" task card.

2. Click the "Open library view" button in the "Libraries" task card.
The library tree opens. The "Library" task card and the project tree are closed.

3. If the library overview is not displayed, click "Open/close library overview" button in the 
library tree.
The library overview opens. 
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Exit library view
To exit the library view, follow these steps:

1. Click the "Close library view" button in the library tree.
The library tree closes. The "Libraries" task card and the project tree are opened.

See also
Overview of the library view (Page 343)

Library basics (Page 338)

Using the "Libraries" task card (Page 339)

Using global libraries (Page 348)

Comparing library elements (Page 385)

7.10.4 Using library management

7.10.4.1 Overview of the library management

Function of the library management
Library management offers an overview of the dependencies of a type to other library elements. 
If a type is referenced in other types or master copies, the correlations are displayed in the 
library management. Types with dependencies to other library elements are subject to some 
functional restrictions. They can, for example, not be deleted as long as dependencies still 
exist. This prevents other library elements from becoming useless. 
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Layout of the library management
The following figure shows the components of the library management:

① Toolbar of the library management

② "Types" area

② "Type use" area

Toolbar of the library management
You can perform the following tasks in the toolbar of the library management:

● Update view
If the project has changed, you can update the view of the library management.

● Clean up library
You can clean up the project library and global libraries. By cleaning up a library, you delete 
all types and type versions that are not linked to an instance in the project.

● Harmonize project
By harmonizing a project, you adapt the names and the path structures of type uses in the 
project to the corresponding names and path structures of the types within a library.

"Types" area
The "Types" area displays the contents of the folder that you have selected in the library view. 
You can open or close all types by using the buttons in the toolbar of the "Types" area.

"Type use" area
The "Type use" area gives you an overview of the points of use of the selected type.
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See also
Opening library management (Page 348)

Basics on master copies (Page 357)

Basics on types (Page 361)

Library basics (Page 338)

7.10.4.2 Opening library management

Procedure
To open the library management, follow these steps:

1. Open the library view.

2. Select a type or any folder that contains types.

3. Select the "Library management" command from the shortcut menu.

Result
The library management opens and the types are displayed with their versions.

See also
Overview of the library management (Page 346)

7.10.5 Using global libraries

7.10.5.1 Creating a global library

Requirement
The "Libraries" task card is displayed or the library view is open.

Procedure
To create a new global library, follow these steps:

1. Click the "Create new global library" icon in the toolbar of the "Global libraries" palette or 
select the command "Global libraries > Create new library" in the "Options" menu.
The "Create new global library" dialog opens.

2. Specify the name and the storage location for the new global library.

3. Confirm your entries with "Create".
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Result
The new global library is generated and pasted into the "Global libraries" palette. A folder with 
the name of the global library is created in the file system at the storage location of the global 
library. This actual library file is given the file name extension ".al12". 

See also
Library basics (Page 338)

Opening a global library (Page 349)

Displaying properties of global libraries (Page 351)

Saving a global library (Page 352)

Closing a global library (Page 353)

Deleting a global library (Page 354)

7.10.5.2 Opening a global library
Global libraries can be further developed centrally and used over several projects. Several 
persons can open a global library simultaneously from a central storage location, provided all 
users open the global library in write-protected mode.

Requirement
The "Libraries" task card is displayed or the library view is open.

Procedure
To open a global library, follow these steps: 

1. Click the "Open global library" icon in the toolbar of the "Global libraries" palette or select 
the command "Global libraries > Open library" in the "Options" menu.
The "Open global library" dialog box is displayed.

2. Select the global library you want to open. You identify the library file by its file extension 
".al12" or ".al11" (global libraries from TIA Portal V11.x).

3. Write protection is activated for the library. If you want to modify the global library, disable 
the "Open as read-only".

4. Click "Open".
The selected global library is opened and pasted into the "Global libraries" palette.

 

 Note
Using global libraries from earlier versions of the TIA Portal

If you want to continue using global libraries from earlier versions of the TIA Portal, you first 
have to upgrade them to the latest TIA Portal version. You are prompted accordingly when 
you open the global library.
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See also
Upgrading libraries from older versions (Page 350)

Retrieving global libraries (Page 356)

Library basics (Page 338)

Creating a global library (Page 348)

Displaying properties of global libraries (Page 351)

Saving a global library (Page 352)

Closing a global library (Page 353)

Deleting a global library (Page 354)

7.10.5.3 Upgrading libraries from older versions
If you want to use a global library that was created with an earlier version of the TIA Portal, 
you first have to upgrade the library. This step ensures that all used elements are compatible 
with the latest version of the TIA Portal. The original library will remain unchanged and a copy 
is created that can be used for the latest version of the TIA Portal. You are prompted 
automatically to upgrade libraries from TIA Portal V12. Note that global libraries saved with 
the latest version of the TIA Portal are not backward compatible.

An exception are those projects you created with TIA Portal V11.x and that have not yet been 
updated to the latest version of the TIA Portal. You can continue using global libraries from 
TIA Portal V11.x without restrictions in such a project and save them in the format of the earlier 
version.

Requirement
● You have loaded a global library that was created with TIA Portal V11.x.

● The library is not write-protected. The reasons for protecting a library can be, for example, 
a write-protected storage location or a simultaneous access to the library by another 
installation of the TIA Portal.

Procedure
To upgrade global libraries for use in the current TIA Portal version, follow these steps:

1. Right-click on the global library you want to upgrade.

2. Select the "Upgrade library" command in the shortcut menu.
The "Upgrade" dialog opens.

3. Confirm with "Yes".

Result
The library is upgraded and saved as copy. The old library is closed and the new library is 
uploaded.
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See also
Upgrading projects (Page 262)

Opening a global library (Page 349)

7.10.5.4 Displaying properties of global libraries
Global libraries contain properties for describing the respective library in more detail. Properties 
include the following:

● General information about the library
This includes the following information: creation time, author, file path, file size, copyright, 
etc. Many of the attributes can be changed.

● Library history
The library history contains an overview of the migrations performed. Here you can also 
call the log file for the migrations. The library history also contains information on updates 
of the global library.

● Support packages in the library
You can display an overview of the additional software needed to work with all devices in 
the project.

● Software products in the library
You can display an overview of all installed software products needed for the project.

Requirement
The "Libraries" task card is displayed or the library view is open.

Procedure
To display the properties of a global library, follow these steps:

1. Right-click the global library whose properties you want to display.

2. Select the "Properties" command in the shortcut menu.
A dialog containing the properties of the global libraries opens.

3. Select the properties in the area navigation that you want to have displayed.

 

See also
Opening a global library (Page 349)

Library basics (Page 338)

Creating a global library (Page 348)

Saving a global library (Page 352)

Closing a global library (Page 353)

Deleting a global library (Page 354)
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7.10.5.5 Displaying logs of global libraries
Logs listing all changes made to the global library are created when global libraries are 
updated. The logs are stored together with the global library and are always available once 
you have opened the global library.

Procedure
To open the logs of a global library, follow these steps:

1. Open the global library in the "Libraries" task card or in the library view.

2. Open "Common data > Logs" in the lower-level folder.

3. Double-click the required log.
The log opens in the work area.

See also
Updating a library with the contents of another library (Page 381)

7.10.5.6 Saving a global library
After you have changed a global library, you need to save it. You can save a global library 
under another name using the "Save library as" command.

 

 Note
Backward compatibility to older versions of the TIA Portal

Note that global libraries can no longer be opened in older versions of the TIA Portal once 
they have been saved in the newer version.

 

Requirement
The "Libraries" task card is displayed or the library view is open.

Saving changes
To save a global library, follow these steps:

1. Right-click on the global library you want to save.

2. Select the "Save library" command in the shortcut menu.

Saving a global library under another name
To save a global library under another name, follow these steps:

1. Right-click the global library that you want to save under a different name.

2. Select the "Save library as" command in the shortcut menu.
The "Save global library as" dialog opens.
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3. Select the storage location and enter the file name.

4. Confirm your entries with "Save".
The library is saved in the specified location under the new name. The original library is 
retained. 

See also
Working with archives of global libraries (Page 354)

Archiving global libraries (Page 355)

Library basics (Page 338)

Creating a global library (Page 348)

Opening a global library (Page 349)

Displaying properties of global libraries (Page 351)

Closing a global library (Page 353)

Deleting a global library (Page 354)

7.10.5.7 Closing a global library
Global libraries are independent of projects. This means that global libraries are not closed 
together with your project. You must therefore close global libraries explicitly. 

Requirement 
The "Libraries" task card is displayed or the library view is open.

Procedure
To close a global library, follow these steps:

1. Right-click on the global library you want to close.

2. Select the "Close library" command in the shortcut menu.
If you have made changes to the global library, select whether or not you want to save the 
changes.
The global library is closed.

See also
Creating a global library (Page 348)

Opening a global library (Page 349)

Displaying properties of global libraries (Page 351)

Saving a global library (Page 352)

Library basics (Page 338)

Deleting a global library (Page 354)
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7.10.5.8 Deleting a global library
If you no longer require a global library, you can delete it. Libraries supplied by Siemens cannot 
be deleted.

Requirement
The "Libraries" task card is displayed or the library view is open.

Procedure 
To delete a global library, follow these steps:

1. Right-click the global library you want to delete.

2. Select the "Delete" command in the shortcut menu.

3. Click "Yes" to confirm.

Result
The global library is removed from the "Global libraries" palette. The entire library for the global 
library is deleted from the file system. 

See also
Library basics (Page 338)

Creating a global library (Page 348)

Opening a global library (Page 349)

Displaying properties of global libraries (Page 351)

Saving a global library (Page 352)

Closing a global library (Page 353)

7.10.5.9 Archiving and disabling global libraries

Working with archives of global libraries
If you want to back up global libraries on an external hard drive or send them via e-mail, for 
example, use the archiving function to reduce the storage space of the library.
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Options for reducing the size of the project
There are two ways to reduce the storage space of global libraries:

● Compressed archives of global libraries
Archives of global libraries are compressed files, each containing an entire global library, 
including the entire folder structure of the library. Before the directory with the global library 
is compressed into the archive file, all files are reduced to their essential components to 
further decrease the storage space. Compressed archives of global libraries are therefore 
well suited for sending via e-mail.
Compressed archives of global libraries have the file extension ".zal12".
To open a compressed archive of a global library, you have to retrieve the archive. Here, 
the archive file is extracted to a location you have selected with the entire folder structure 
and all files.

● Minimized global libraries
You can skip additional compression in an archive file, and instead create a copy of the 
global library directory. The included files can be reduced to the essential elements. This 
minimizes the required storage space. The full functionality of the global library is retained 
and the global library can be loaded as usual.
Minimized global libraries are especially well suited for archiving, for example, on an 
external medium.

 

See also
Archiving global libraries (Page 355)

Retrieving global libraries (Page 356)

Archiving global libraries
You reduce the storage space of a global library by packing it into a compressed file. You can 
also reduce the storage space by saving the global library reduced to the essential elements. 
You can do both of these with the archiving function for global libraries.

Requirement
The global library must be loaded.

Procedure 
To archive a global library, follow these steps:

1. Select the global library that you want to archive.

2. Right-click the global library and select the "Archive" command from the shortcut menu.
The "Archive global library as..." dialog opens.

3. Select the directory where you want to save the archive file or the new directory of the global 
library.
The directory may not be located in a project directory of a project or within the directory of 
a global directory.
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4. Select the file type from the "File type" drop-down list:

– Global libraries archive, if you want to create a compressed file of the project.

– Minimized global library, if you only want to create a copy of the project directory with 
minimal storage space.

5. Enter a file name in the "File name" field if you are creating an archive file. If you are creating 
a minimized global library, enter the name of the new library directory to be created in the 
"File name" box.

6. Click "Save".

Result
When you have created an archive of a global library, a compressed file with the extension 
".zal12" is generated. The file includes the complete directory of the global library. The 
individual files of the global library are also reduced to the essential components in order to 
save space.

If you have minimized the global library, only a copy of the original directory of the global library 
is created at the required location. The files contained within it are reduced to their essential 
components in order to save space.

See also
Working with archives of global libraries (Page 354)

Retrieving global libraries (Page 356)

Retrieving global libraries
Before you can use an archived global library, you have to retrieve it. The global library is 
extracted and then opened in the TIA Portal.

Procedure
To extract the archive of a global library, follow these steps:

1. Select the "Global libraries > Retrieve library" command in the "Options" menu.
The "Retrieve archived global library" dialog opens.

2. Select the archive file.

3. Select the check box "Open read-only" if you want to load the global library write-protected.

4. Click "Open".

5. The "Find folder" dialog opens.

6. Select the target directory to which the archived global library should be extracted.

7. Click "OK".
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Result
The global library is extracted to the selected directory and opened immediately.

See also
Working with archives of global libraries (Page 354)

Archiving global libraries (Page 355)

Opening a global library (Page 349)

7.10.6 Creating folders in a library
The library elements are stored in the libraries according to their type in the "Types" and 
"Master copies" folders. Create additional folders below "Types" and "Master copies" to further 
organize master copies and types.

Requirements 
● The "Libraries" task card is displayed or the library view is open.

● If you want to create new folders within a global library, you have to open the global library 
with write permission.

Procedure
To create a new folder, follow these steps:

1. Right-click any folder within the library.

2.  Select "Add folder" from the shortcut menu.
A new folder is created.

3. Enter a name for the new folder. 

See also
Working with types in the project library (Page 365)

Filtering master copies (Page 359)

7.10.7 Using master copies

7.10.7.1 Basics on master copies

Master copies are used to create standardized copies of frequently used elements. You can 
create as many elements as needed and insert them into the project based on a master copy. 
The elements inherit the properties of the master copy.
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You store master copies either in the project library or in a global library. Master copies in the 
project library can only be used within the project. When you create the master copy in a global 
library, it can be used in different projects.

The following elements can be created as master copies in the library, for example:

● Devices with their device configuration

● Tag tables

● Instruction profiles

● Monitoring tables

● Elements from the documentation settings, for example, cover sheets and frames

In many cases, the objects you add as master copy contain additional elements. A CPU, for 
example, can contain blocks. If the included elements are uses of a type version, the used 
versions of the types are automatically created in the library. The elements contained therein 
are then used as an instance and linked to the type.

See also
Adding master copies (Page 358)

Using master copies (Page 360)

Basics on types (Page 361)

Filtering master copies (Page 359)

7.10.7.2 Adding master copies
If you want to use objects multiple times, copy them as master copies in the project library or 
in a global library. You can choose from the following methods for creating master copies:

● You can select one or more elements and generate a master copy from it

● You can select multiple elements and generate a master copy from each element

Requirement
● The "Libraries" task card is displayed.

● If you add a device as a master copy, this device meets the following requirements:

– The device is compiled and consistent.

– The device contains no test instance of a type.

● If you add the master copy to a global library, the global library is opened with write 
permission.
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Creating a master copy from one or more elements 
To create a master copy for one or more elements, follow these steps:

1. Open the library in the "Libraries" task card.

2. Drag one or more elements and drop them into the "Master copies" folder or any subfolder 
of "Master copies".
Alternative: Copy the elements to the clipboard and paste them at the required location.
The element is pasted into the library as a single master copy.

Creating a master copy for each element among multiple elements
To create a master copy for each element among multiple elements, follow these steps:

1. Open the library in the "Libraries" task card.

2. Copy to the clipboard the elements that you want to create as master copies.

3. Right-click on the "Master copies" folder or any of its subfolders in the library.

4. In the shortcut menu, select "Paste as separate master copies".
The elements are pasted into the library as separate master copies. In each case, a 
separate type is created automatically for any objects contained.

See also
Basics on master copies (Page 357)

Using master copies (Page 360)

Library basics (Page 338)

Adding types to the project library (Page 365)

7.10.7.3 Filtering master copies
To make it easier to keep track of a large number of master copies, you can filter the display 
according to the type of master copy.

Requirement   
The "Libraries" task card is displayed or the library view is open.

Procedure
To filter the view, follow these steps:

1. Open the "Master copies" folder in the project library or a global library.

2. In the drop-down list of the toolbar, select the type of objects you want to display under 
"Master copies".
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Result
Only the selected type of master copies is displayed. You can set the filter to "All" to return to 
an unfiltered view.

See also
Library basics (Page 338)

Creating folders in a library (Page 357)

Basics on master copies (Page 357)

Using master copies (Page 360)

Using the element view (Page 342)

7.10.7.4 Using master copies
Master copies are contained either in the project library or in a global library.

Requirement
The "Libraries" task card is displayed.

Procedure
To paste a master copy into the project, follow these steps:

1. Open the "Master copies" folder or any subfolder of "Master copies" in a library.

2. Drag-and-drop one or more master copies to the desired point of use.
A copy of the master copy is inserted.

Or:

1. Open the element view.

2. Drag the master copy from the "Elements" palette and drop it at the location where you 
want to use it.
A copy of the master copy is inserted.

See also
Basics on master copies (Page 357)

Adding master copies (Page 358)

Filtering master copies (Page 359)

Library basics (Page 338)

Using the element view (Page 342)
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7.10.8 Using types and their versions

7.10.8.1 Basics on types

Using types
Types are elements that are required for the execution of user programs. Types can be 
versioned and further developed from a central location.

The following elements can be stored as type in the project library or the global library:

● Functions (FCs)

● Function blocks (FBs)

● PLC data types

● User data types

● Faceplates

● Figures

● User-defined functions

Any number of instances can be derived from the versions of types in the project. The instances 
are then linked to the version of the type. If you are using types from a global library, the type 
is also created in the project library. If the type already exists in the project library, any missing 
type versions are added if necessary. The instance is then linked only to the respective type 
version in the project library.

Types and their instances are marked with a black triangle. The following figure shows an 
instance, marked with a black triangle, and an ordinary program block:

Basics on versioning types
Type versioning provides you with the means to develop types centrally and then roll out the 
most recent version to the individual projects as an update. In this way, error corrections and 
added functions can be easily integrated into existing projects. If you have created a new 
version of a global library, you can update existing projects in an automatic process. This 
minimizes errors and reduces the amount of maintenance work for large automation solutions 
that contain numerous individual projects.

Versioning allows you to trace the development process of individual types. Before you release 
a version, you can try it out in a test environment to determine whether changes made to a 
type integrate smoothly into an existing project. You only release a version for productive use 
after you have made sure that everything operates without errors. You can view the history of 
individual instances in the project at any time and determine the version from which the 
instance was derived.
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The TIA Portal also checks automatically if there are associated objects with individual versions 
of a type.  Associated objects can be, for example, PLC data types or other blocks referenced 
in a block. All associated objects are already taken into consideration during the creation of a 
type or during copying between libraries. Before being released, versions of types are checked 
for their consistency to ensure that no inconsistencies arise in the project.

Versions of types
Versions are assigned to each type. The version number is displayed in both the "Libraries" 
task card as well as the library view next to the respective type. The version number is also 
displayed in the project tree next to instances of types. This allows you to see at all times which 
version of an instance is used in the project.

The version number consists of three digits. You can randomly assign the first two digits. The 
third digit is the build number. It is automatically incremented by one when you edit an instance 
related to the version. The build number is reset to zero when you release the version (first 
digit of the version number).

The versions of types can have three states:

● In progress (faceplates and HMI user data types)

● In testing (all sorts of types except faceplates and HMI user data types)

● Released

The following figure shows a type with two versions. One version is "in testing" and one version 
is released:

See also
State of type versions (Page 362)

Basics on master copies (Page 357)

Adding types to the project library (Page 365)

Using types (Page 366)

7.10.8.2 State of type versions
The versions of types can be in three different states. The states can be determined from the 
instance or in the library.

"In progress" status
Only versions of faceplates and HMI user data types have the "in progress" state. If a version 
is in progress, "in progress" appears next to the version in the library.

When you create a new type or a new version of a released type, the type is assigned the 
status "in progress".
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Types with the status "in progress" can be edited in the library view. A reference to an instance 
in the project does not have to exist. Upon release, the compatibility of the type is tested by a 
consistency check.

"In testing" status
All types except for faceplates and HMI user data types can have the "in testing" status. If a 
version is in testing, "in testing" appears next to the instance and in the library. A version in 
the test state is linked to a test instance in the project. This allows you try out the effects of 
your changes in a test environment including all online functions before you release a type for 
use in actual operations.

"Released" status
The "released" status is available for all types, regardless of the point of use. If a version has 
been released, the symbol of the version is marked with a seal in the library:

Released versions can be opened with write protection in their instance. If you want to edit a 
released version, you must first create a new "in progress" or "in testing" version.

See also
Basics on types (Page 361)

Using types (Page 366)

Creating a test version of a type (Page 367)

Editing a test version of a type (Page 368)

Creating an editing version of a type (Page 369)

Performing a consistency check for a type version (Page 369)

Discarding a version of a type (Page 370)

Releasing a version of a type (Page 371)

Assigning a common version (Page 373)

Updating the project to the latest type versions (Page 374)

Remove the link between instance and type (Page 375)

7.10.8.3 Displaying a released type version
If you display a released version but do not want to edit it, open the instance with write 
protection. All types except faceplates and HMI user data types can be opened directly at the 
instance. Faceplates and HMI user data types can only be opened in the "Libraries" task card 
or in the library view.
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Requirement
If it is not a faceplate or an HMI user data type, the released version has an instance in the 
project.

Opening a type version at an instance
To open a released version of a type with write protection starting from an instance, follow 
these steps:

1. Select the released version at the instance in the project tree.

2. To do this, right-click the instance and select the "Open" command from the shortcut menu.
The instance is opened with write protection.

Opening a type version in the "Libraries" task card or library view
To open a released version of a type in the "Libraries" task card or in the library view, follow 
these steps:

1. Select the version.

2. To do this, right-click the version and select the "Open" command from the shortcut menu.
If it is a faceplate or HMI user data type, it is opened directly in the library view. In this case, 
skip the remaining steps. If it is any other type, the "Open type" dialog opens.

3. Select the instance with the version that you want to display from the list of instances.

4. Click "OK" to confirm.
The instance is opened with write protection.

7.10.8.4 Displaying properties of a type or version
The following properties can be viewed and changed in the properties of a type or its versions, 
if needed:

● Name of the type

● Version number (only visible in the case of a version)

● Version number (only visible in the case of a version)

● Data and time of the last change to the version (only visible in the case of a version)

● Author that created the type or the version

● Comments on the type or the version of the type
The comment can be changed.

● Original library (only visible in the case of a version)
Displayed is the project and the library from which the current version of the type was 
generated. This information is important, for example, for finding the original of the type 
after it has been copied from another library.

● ID of the type or the version of the type
This ID is used to uniquely identify the type or the version of the type, even if, for example, 
there are types or versions with an identical name within the project library or the global 
library. The ID cannot be changed and is assigned automatically.
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Procedure
To display the properties of a type or a version and to enter a comment, follow these steps:

1. Select a type or the version of a type in the "Libraries" task card or in the library view.

2. To do this, right-click on the type or one of its versions and select the "Properties" command 
from the shortcut menu.
The "Properties" dialog box opens.

3. If needed, enter a comment on the type in the "Comment" field or edit an existing comment.

7.10.8.5 Working with types in the project library

Adding types to the project library
Types for reuse in the project can be created in the project library for various elements. You 
can create the following elements as types, for example:

● Program blocks

● Faceplates

● PLC data types

● HMI user data type

If you add an element as a type to the project library and this element has dependencies to 
other elements, the dependent elements are automatically created as a type as well.

After a type has been added to the project library, the type is linked to the added element from 
the project.

Requirement
● The "Libraries" task card is displayed.

● The elements that you want to add as type are compiled.

● The elements are consistent.

Procedure
To add an existing element to the project library as a type, follow these steps:

1. Open the project library in the "Libraries" task card.

2. Drag-and-drop one or more elements into the "Types" folder or any subfolder of "Types".
Alternative: Copy the elements in the project tree to the clipboard and add the elements in 
the desired project library folder.
The "Generate type" dialog opens.
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3. Enter the properties of the new type:

– Enter a name for the new type in the "Name of the type" field.

– Enter a version number for the new type in the "Version" field.

– Enter the name of the editor who is responsible for the type in the "Author" field.

– Enter a comment on the type in the "Comment" field.

4. Click "OK" to confirm.
The new type is generated with a released version. The version is linked to the element 
that has been added.

See also
Basics on types (Page 361)

Library basics (Page 338)

Adding master copies (Page 358)

Using types
To use the version of a type, create an instance of the version at a suitable location in the 
project tree. You can also position faceplates and HMI user data types directly in the editor. 
The instance is then linked to the version of the respective type. If the type contains dependent 
elements such as a PLC data types referenced in a block, these are also created as instance 
at a suitable location. You can only assign a type in a specific version to a device once.

Requirement
● The "Libraries" task card is displayed.

● The version is released.

● A device which supports the sort of desired type is available in the project

● The device is not assigned to any further instances of the same type.

Procedure
To generate an instance from a version of a type, follow these steps:

1. In the project library, navigate to the version of the type that you want to use.

2. Drag the required version of the type from the project library and drop it at the location 
where you want to use it.
Alternative: To automatically use the most recent version, drag the type from the project 
library and drop it at the location where you want to use it.

Result
An instance is generated from the type and its dependent elements and pasted at the point of 
use. The instances are connected to the respective version of the type in the project library.
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See also
Basics on types (Page 361)

State of type versions (Page 362)

Library basics (Page 338)

Using master copies (Page 360)

Creating a test version of a type
Before you release a type for productive use, you need to test the type within a project and on 
the automation system. The test is conducted in a specific test environment. This test 
environment can be a CPU, for example.

Create a version with "in testing" status for the test. The creation of a version "in testing" is 
suitable for all sorts of types except for faceplates and HMI user data types. On the other hand, 
versions "in progress" can be created from faceplates and HMI user data types.

There are two ways to create a test version of a type and define the test environment:

● In the "Libraries" task card or library view
Generate the new version with "in testing" status in the "Libraries" task card or in the library 
view. You can generate the new version either directly from the type or from a specific 
version of the type.

● At an instance in the project tree
You can also create the test version directly at the instance in the project tree. Since the 
instance is always used in a specific version in the project, a new version of the type is 
generated from the version used at the instance.

You can also create test versions from several types at the same time.

The following rules apply to a version "in testing":

● You can set only one version to "in testing" for each type at a given time.

● A version in testing may only be linked to a single instance in the project. Therefore, it is 
not possible to copy an instance to the clipboard, to duplicate it or to create an additional 
type from the instance as long as it has "in testing" status.

Requirement
● There is at least one instance of the type within the project in a given version. 

● If you want to create the new version from a particular version of the type, the instance 
must be used in this version in the project.
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Procedure
To generate a new test version of a type or the version of a type, follow these steps:

1. Select the type, a version of the type, or the instance. 
When you create the test version directly at the instance, you can select several elements 
or folders with multiple selection. You can skip steps 3 and 4 because the test environment 
is already defined by the selected instance.

2. Right-click the selected element and select the "Edit type" command from the shortcut 
menu.
If you have started the editing in the "Libraries" task card or in the library view, the "Edit 
type" dialog opens. If you have started the editing at the instance in the project tree, the 
test instance is immediately opened for editing in the library view.

3. Select an instance of the type from the list in the project.
If you have started editing at the type itself, the following applies:

– The location at which the instance is used (for example, the CPU) is also used as test 
environment for the subsequent editing of the type. 

– Selecting the test instance also defines the version to be edited.

The following applies to editing a specific version:
If your starting point is a specific version, you can only select from the list instances that 
are used in the same version.

4. Click "OK" to confirm.

Result
A new version of the type is created. The new version is "in testing" and is identified as such 
in the user interface.

See also
Basics on types (Page 361)

State of type versions (Page 362)

Library basics (Page 338)

Editing a test version of a type
When you edit a version "in testing", a new version is not created. You can start the editing of 
the test version at the instance in the project tree, in the "Libraries" task card" or in the library 
view.

 
 

 Note
Deleting and renaming interface parameters

You can add new parameters. However, if you rename or delete existing parameters, these 
parameters will not be supplied when the block is called.
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Procedure
To edit the test version of a type, follow these steps:

1. Right-click the test version or the instance.

2. Select the "Edit type" command from the shortcut menu.
The test instance is opened in the library view and can be edited.

See also
Basics on types (Page 361)

State of type versions (Page 362)

Library basics (Page 338)

Performing a consistency check for a type version (Page 369)

Discarding a version of a type (Page 370)

Releasing a version of a type (Page 371)

Creating an editing version of a type
If you want to edit a type with faceplates or HMI user data types, create a new "in progress" 
version of the type. The new version is edited in the library view. To check the compatibility of 
the changes, a consistency check is automatically performed for the type prior to the release.

Requirement
The project library is opened in the "Libraries" task card or in the library view.

Procedure
To create a new version of a type in progress, follow these steps:

1. Right-click the type or the version of the type.

2. Select the "Edit type" command from the shortcut menu.
A new "in progress" version is created and opened for editing in the library view.

See also
Basics on types (Page 361)

State of type versions (Page 362)

Library basics (Page 338)

Performing a consistency check for a type version
A type version can unintentionally obtain an inconsistent state during editing. To notice errors 
in the development process in good time, you can regularly perform a consistency check. 
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However, the consistency check always takes place automatically as soon as you release a 
version.

Details of how to start the consistency check manually for the version of a type are provided 
below.

Requirement
● The project library is opened in the "Libraries" task card or in the library view.

● The version is "in progress" or "in testing".

Procedure
To perform a consistency check for the version of a type, follow these steps:

1. Right-click on the version that you want to check for consistency.

2. Select the "Consistency check" command in the shortcut menu.
The consistency check is carried out. You receive a message with the result of the 
consistency check.

See also
Releasing a version of a type (Page 371)

Discarding a version of a type (Page 370)

Editing a test version of a type (Page 368)

Basics on types (Page 361)

State of type versions (Page 362)

Library basics (Page 338)

Discarding a version of a type
Discard versions of a type "in testing" or "in progress" when you no longer need the version. 
All uses of the deleted version are reset to the last released status. You can also discard the 
versions for several types at the same time.

Requirement
The version that you want to discard is in the state "in testing" or "in progress".

Your are in the library view of the "Libraries" task card is open.
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Discarding a version of a single type
To discard the version of a single type, follow these steps:

1. Right-click the version.

2. Select the "Discard changes and delete version" command from the shortcut menu.
The version is deleted.

Alternative:

1. Click the "Discard version" button in the toolbar while a version is opened for editing.
The version is deleted.

Discarding versions of several types
To discard the version of several types, follow these steps:

1. Open the library view, library management or the "Libraries" task card.

2. Right-click any folder.

3. Select the "Discard changes and delete version" command from the shortcut menu.
The versions are deleted.

See also
Basics on types (Page 361)

State of type versions (Page 362)

Library basics (Page 338)

Performing a consistency check for a type version (Page 369)

Releasing a version of a type
When you are finished editing the version of a type, release the version for productive use. 
Assign a version number for the release. You can also enable several type versions at once.

Requirement
● The version that you want to release has "in testing" or "in progress" status.

● The version is consistent.
A consistency check is performed as soon as you start the release. If errors that prevent a 
release occur during the consistency check, a message is displayed indicating how you 
can correct the errors.

Releasing a version of a single type
To release a version of a type, follow these steps:

1. Right-click the version of the type.

2. Select the "Release version" command from the shortcut menu.
The "Release version" dialog box opens.
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3. If necessary, change the properties of the version:

– Enter a name for the type in the "Name" field.

– In the "Version" field, define a main and an intermediate version number for the version 
to be released.

– In the "Author" field, enter the editor of the version to be released.

– In the "Comment" field, enter a comment on the version to be released.

4. Select the options for the release:

– Select the "Update all instances of the affected type" check box to update all instances 
of the type used in the project with the same original version to the most recent version. 
Instances within master copies are not changed.

– Select the "Delete all unused versions of the affected type" to delete all versions of the 
same type from the library if these are not assigned any instance in the project and no 
other dependencies exist.

5. Click "OK" to confirm.

Alternative:

1. Click the "Release version" icon in the toolbar while a version is opened for editing.

2. Continue with steps 3 to 5 of the description above.

Releasing versions of several types
To release versions for several types simultaneously, follow these steps:

1. Open the library view, library management or the "Libraries" task card.

2. Select any folder.

3. Select the "Release version" command from the shortcut menu.
The "Release version" dialog box opens.

4. If necessary, change the properties of the version:

– In the "Author" field, enter the editor of the version to be released.

– In the "Comment" field, enter a comment on the version to be released.

You cannot change the "Number" and "Version" fields.

5. Select the options for the release:

– Select the "Update all instances of the affected type" check box to update all instances 
of the type used in the project with the same original version to the most recent version. 
Instances within master copies are not changed.

– Select the "Delete all unused versions of the affected type" to delete all versions of the 
same type from the library if these are not assigned any instance in the project and no 
other dependencies exist.

6. Click "OK" to confirm.
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Result
The properties are applied for the type itself, the version to be released, and for all future 
versions. Versions already released remain unaffected by the changes.

If needed, all instances with the same original version are updated to the most recent version 
and the unused versions of the type are deleted.

See also
Basics on types (Page 361)

State of type versions (Page 362)

Library basics (Page 338)

Performing a consistency check for a type version (Page 369)

Assigning a common version (Page 373)

Adding types to a global library (Page 376)

Updating the project to the latest type versions (Page 374)

Assigning a common version
When you are finished editing all types in the project library, create a new version of all types 
with a common version number.

Requirement
● The project library is opened in the "Libraries" task card or in the library view.

● The project library may not contain a version of a type with "in testing" or "in progress" 
status.

Procedure
To assign the same main version to all released types within the project library, follow these 
steps:

1. Right-click the project library.

2. Select the "Assign common version" command from the shortcut menu.
The "Assign common version" dialog box opens.

3. If necessary, change the properties of the version:

– In the "Version" field, determine the new version number. The version number must be 
higher than the highest version number of all types within the project library.

– In the "Author" field, enter the person responsible for the version to be released.

– In the "Comment" field, enter a comment on the version to be released.

Editing projects
7.10 Using libraries

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  373



4. Select the options for the release:

– Select the "Update all instances" check box to update all instances in the project to the 
new version. Types used in master copies are not updated.

– Select the "Delete all unused versions of the affected types" check box to delete all older 
versions of types from the library if these are not assigned to any instance in the project 
and if there are no dependencies to other types.

5. Click "OK" to confirm.

Result
The project library is changed as follows:

● A new version of all types is created within the project library with the specified version 
number. 

● The properties are applied to all types within the project library, the new version and for all 
future versions. Lower versions remain unaffected by the changes. If you make no changes 
to the properties, the properties of the last released version of each type are applied.

● If needed, all instances are updated to the most recent version and the unused versions of 
all types are deleted from the project library.

See also
Basics on types (Page 361)

State of type versions (Page 362)

Library basics (Page 338)

Releasing a version of a type (Page 371)

Adding types to a global library (Page 376)

Updating the project to the latest type versions
After you have updated several types in the project library, update all instances in the project 
to the most recent version of the types from the project library. If you do not want to apply the 
changes to the entire project, restrict the update to individual devices in the project.

Each of the following elements can be selected as source for the update:

● The entire project library

● Individual folders within the project library

● Individual types
You can select multiple types.

Requirement
Your are in the "Libraries" task card or in the library view.
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Procedure
To update instances in a project with the contents from the project library, follow these steps:

1. Select the entire project library or individual elements from it.

2. Right-click the required elements and select the "Update > Project" command from the 
shortcut menu.
The "Update project" dialog box opens.

3. Select either the entire project or individual devices for the update.

4. Select the options for the update process:

– The "Update all instances of the affected types" check box is always selected during 
this process.

– Select the "Delete all unused versions of affected types" check box to delete all older 
versions of the updated types from the project library.

5. Click "OK" to confirm.
The update is performed.

Result
The following changes were made to the project:

● All older versions were deleted from the project library as needed.

● All instances within the selected devices were updated to the most recent version of the 
linked types.

● You can find a log of the update process in the projection tree under "Common data".

See also
Updating the project to the latest type versions (Page 378)

Using logs (Page 258)

Updating a library with the contents of another library (Page 381)

Basics on types (Page 361)

Library basics (Page 338)

State of type versions (Page 362)

Remove the link between instance and type
Instances of types are always connected to the version of the corresponding types. They 
cannot be edited like an ordinary object. If you edit the instance, a new version of the type is 
created automatically in the library and the changes therefore affect the entire project.
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If you remove the link between the instance and its type, you then edit the object like an ordinary 
object in the project tree.

 

 Note
Link to the type cannot be restored

If you have removed the link between instance and type, this link cannot be re-established.
 

Requirements
The instance may not be "in testing".

Procedure
To remove the link between a type and the version of a type, follow these steps:

1. Select the instance in the project tree.

2. Right-click the instance and select the "Terminate connection to type" command from the 
shortcut menu.

3. The connection to the version of the corresponding type is removed.

See also
Basics on types (Page 361)

Library basics (Page 338)

State of type versions (Page 362)

7.10.8.6 Working with types in global libraries

Adding types to a global library
Global libraries are used as a central resource when working on multiple projects. Among the 
types, only the types in the project library can be edited directly. Therefore, use the project 
library if you want to work on types. When you are finished editing a type in the project library, 
you can add the type to a global library. Adding a type from the project library corresponds to 
a usual copy process from the project library. 

Requirement
● The "Libraries" task card is displayed or the library view is open.

● The global library to which you want to add a type is opened with write protection.
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Procedure
To add an existing element to a global library as a type, follow these steps:

1. Open the required folder in the global library in the "Libraries" task card or in the library 
view.

2. Drag a type from the project library to the "Types" folder or any subfolder of the global library.
The new type is created.

Alternative:

1. Copy the required type from the project library to the clipboard.

2. In the "Global library" palette of the "Libraries" task card, open the global library to which 
you want to add a type.

3. Right-click the "Types" folder or any of its subfolders.

4. Select the "Paste" command in the shortcut menu.
The new type is created.

Result
The type is inserted in the global library. Dependent types, such as types of HMI user data 
types or tags, are also copied to the global library, provided they do not already exist there. 
This ensures that all necessary elements for generating an instance are present in the global 
library.

If the type that you want to add to the global library is already present there, the described 
process corresponds to an update of the global library. In this case, the most recent released 
versions of the types are added to the global library.

See also
Basics on types (Page 361)

Releasing a version of a type (Page 371)

Assigning a common version (Page 373)

Updating the project to the latest type versions (Page 378)

Library basics (Page 338)

Using types
To use the version of a type from the global library, create an instance of the version at a 
suitable location in the project tree. You can also position faceplates and HMI user data types 
directly in the editor.

In the project, instances of types from a global library are not linked to the type in the global 
library. Instead, a copy of the type and its dependent elements is generated in the project 
library when an instance is pasted into the project. Dependent elements, for example, can be 
PLC data types that are referenced in a block. In each case, the copy of the type and the 
dependent elements in the project library contain the version that you link to the instance. If 
the type or a dependent element already exists in the project library, only the missing version 
is added when necessary to the type in the project library. 
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The instance is linked to the type in the project library. You can only assign a type to a device 
once irrespective of the version.

Requirement
● The "Libraries" task card is displayed.

● A device which supports the sort of desired type is available in the project.

● The device is not assigned to any further instances of the same type.

Procedure
To generate and use an instance from a type, follow these steps:

1. In the global library, navigate to the version of the type that you want to use.

2. Drag the required version of the type and drop it at the location where you want to use it.
Alternative: To automatically use the most recent version, drag the type to the location 
where you want to use it.

Result
Missing elements are added to the project library. An instance is generated from the type and 
its dependent elements and pasted at the location where you want to use it. The instances are 
connected to the respective version of the type in the project library.

See also
Basics on types (Page 361)

Updating the project to the latest type versions (Page 378)

Library basics (Page 338)

Using the element view (Page 342)

Updating the project to the latest type versions
In large enterprises with numerous automation projects. the global libraries are frequently 
edited from a central location. The updated global libraries of the individual projects are made 
available after the completion of a new version. If you have received a more recent version of 
a global library, replace the outdated instances in your project with the most recent version. If 
you do not want to apply the changes to the entire project, restrict the update to individual 
devices in the project.

The project library is also updated with the new versions of the types in the global library during 
the updating of the project or individual devices.

The following elements can be selected as source for the updating:
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● A global library

● Individual folders within a global library

● Individual types
You can select multiple types.

Requirement
● Your are in the "Libraries" task card or in the library view.

● The updated global library is open.

Procedure
To update instances in a project with the contents from a global library, follow these steps:

1. Select the updated global library or the individual elements from it.

2. Right-click the global library or the required elements and select the "Update > Project" 
command from the shortcut menu.
The "Update project" dialog box opens.

3. Select either the entire project or individual devices for the update.

4. Select the options for the update process:

– The "Update all instances of the affected types" check box is always selected during 
this process.

– Select the "Delete all unused versions of affected types" check box to delete all older 
versions of the updated types from the project library.

5. Click "OK" to confirm.
The update is performed.

Result
The following changes were made to the project:

● The most recent version of the select types is present in the project library. All older versions 
were deleted if necessary.

● All instances within the selected devices were updated to the most recent version of the 
linked types.

● You can find a log of the update process in the projection tree under "Common data".

Editing projects
7.10 Using libraries

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  379



See also
Updating the project to the latest type versions (Page 374)

Using logs (Page 258)

Updating a library with the contents of another library (Page 381)

Basics on types (Page 361)

Library basics (Page 338)

Adding types to a global library (Page 376)

7.10.9 Editing library elements
Types, master copies and folder can be cut, copied, pasted, moved, renamed or deleted in 
the usual way within the "Libraries" task card or the library view. Global libraries must be 
opened with write permission for each of the above-described processes.

Copying types
The following rules apply when you copy types to the clipboard:

● Types are always copied to the clipboard with all associated versions. However, only 
versions that have previously been released are copied.

● Types are always copied to the clipboard with all dependent elements.

● Master copies are always copied together with all types contained in them and all versions 
of the type.

Cutting elements
You can only paste previously cut library elements into the same library. In so doing, you can 
only paste master copies into the "Master copies" folder or any of its subfolders. Likewise, you 
can only paste types into the "Types" folder or any of its subfolders.

Pasting types 
Pasting types in a different library corresponds to updating the target library.

The following rules apply when you have pasted a type into a different library:

● A type is always pasted with all its versions.

● If the type already exists in the target library, all versions that are more recent than the 
existing versions are added to the corresponding types in the target library.

● If there is already a version with released status in the target library, this version is not 
pasted again.

● If the same version exists with in testing or in progress status in the target library, it is 
replaced by the released version.

● If a type needs other types, these are also added at the respective location.
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Pasting master copies
When you paste master copies, all types and their versions contained in these copies are also 
pasted. If the corresponding type already exists in the library, only the missing versions are 
added. If a type does not yet exist, it is pasted with all its versions at the highest level in the 
library.

Moving elements
When you move an element from one library to another, the element is copied and not moved. 
The same rules apply as described under "Pasting types" and "Pasting master copies".

Deleting of types and type versions
Note the following when you delete types or type versions:

● A type or a type version can only be deleted if there are dependencies to other types.

● When you delete a type, all versions of the type are deleted.

● If you delete all versions of a type, the type is also deleted.

● If you delete a version that has instances in the project, the instances are also deleted from 
the project.

Deleting instances
If you delete an instance that has dependencies to other instances, this instance is restored 
during the next compilation. The instance is then linked again to the original type version. This 
restores the consistency of the project.

See also
Library basics (Page 338)

Remove the link between instance and type (Page 375)

Updating a library with the contents of another library (Page 381)

7.10.10 Updating a library with the contents of another library
An existing library can be updated with the contents of another library. The following options 
are available for updating libraries:

● Updating a global library with types from another global library or from the project library

● Updating the project library with types from a global library

Each of the following elements can be selected as source for the update:
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● An entire library

● Individual folders within a library

● Individual types
You can select multiple types.

During the update, new versions are added to the types that already exist in the target library. 
Types that do not yet exist in the target library are copied together with all their versions to the 
target library.

Requirement
If you want to update a global library, you have to open it with write permission.

Procedure
To update a library with the contents of a different library, follow these steps:

1. Select a library or individual elements from a library as source for the update.

2. Right-click the source and select the "Update > Library" command from the shortcut menu.
The "Update library" dialog box opens.

3. Select the type of library you want to update:

– Select "Update the project library" to update the project library with types from a global 
library.

– Select "Update a global library" if you want to update a global library.

4. Optional: In the drop-down list, select the global library that you want to update, if you want 
to update a global library.

5. Select the options for the update:

– The "Update all instances of the affected types" option is always disabled during this 
process.

– Select the "Delete all unused versions of the affected types" check box to delete all older 
versions of types from the project library if these are not assigned to any instance in the 
project and if there are no dependencies to other types. This option cannot be selected 
for the update of a global library, since types of a global library never have a point of 
use in the project.

6. Click "OK" to confirm.
The update is performed.
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Result
The following changes were made to the target library:

● Types not yet available in the target library were copied together with all their versions. 
More recent versions were added to the types that already exist in the target library. If a 
more recent version of a type already existed in the target library, the latest version was 
nevertheless copied and automatically assigned a newer version number.

● If needed, all versions of types were deleted from the project library if these were not used 
in any instance in the project.

● A log listing all performed changes to the target library was created for the update process.
If you have updated the project library, you can find the log in the project tree under 
"Common data > Logs".
If you have updated a global library, you can find the log in the "Common data > Logs" 
folder in the level below the global library.

See also
Using logs (Page 258)

Updating the project to the latest type versions (Page 374)

Updating the project to the latest type versions (Page 378)

Displaying logs of global libraries (Page 352)

Library basics (Page 338)

7.10.11 Harmonizing names and path structure
You can harmonize the project with a library. This helps you correct the following items:

● Names of interfaces:
Instances can be created during the development phase of a library, the names of which 
are appended by "_1", "_2", etc. due to an automatic correction. This extension is used to 
prevent duplicate names in the project. During harmonization, the instances once again 
receive the names of their associated types.

● Path structure:
The original path structure can be lost due to parallel development or copying of dependent 
instances. This affects the clarity of the project. During harmonization, the path structure 
within the project is adapted to the path structure of the library.

Procedure
To harmonize the names and the path structure, follow these steps:

1. Open the library management.

2. Click "Harmonize project" in the toolbar.
The "Harmonize project" dialog box opens.

3. Select the device with which you wish to harmonize the library.
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4. Select the "Harmonize paths between project and library" check box if you want to restore 
the path structure.

5. Select the "Harmonize names between project and library" check box if you want to have 
the names corrected.

6. Confirm your entries with "OK".
Depending on your settings, the names and the path structure in the project are harmonized 
with the library.

See also
Library basics (Page 338)

Overview of the library view (Page 343)

Overview of the library management (Page 346)

7.10.12 Clean up library
You can clean up the project library or global libraries to remove types or versions when they 
are not connected to an instance in the project. This step provides more clarity within the 
libraries and decreases the size of the library.

Cleaning up the project library
To clean up the project library, follow these steps:

1. Open the library management.

2. Click on "Clean up library" in the toolbar.
The "Clean up project library" dialog box opens.

3. Select if you only want to delete unused type versions or complete types from the library.

4. Confirm your entry with "OK".
Depending on your selection, either unused type versions or types are removed from the 
project library.

Clean up global library
To clean up a global library, follow these steps:

1. Open the library management.

2. Click on "Clean up library" in the toolbar.
The "Clean up global library" dialog box opens. 

3. Click "Continue".
Unused type versions are deleted. The latest version of a type is always retained.
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See also
Library basics (Page 338)

Overview of the library view (Page 343)

Overview of the library management (Page 346)

7.10.13 Comparing library elements

Introduction
You can compare devices from libraries with devices from both the current project as well as 
from the same or another libraries or reference projects. Note, however, that reference projects 
are write-protected. You can also compare instances in a device with their type version in a 
library. Not all actions are available for the comparison with types. You cannot, for example, 
overwrite an instance of a newer version with an older type version from the library.

When comparing library elements, you can always switch between automatic and manual 
comparison.

Procedure
To compare library elements with the device data of a project, follow these steps:

1. In the project tree, select the device whose data you want to compare to a library element 
and which allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Open the "Libraries" task card.

4. Select the library element that you want to compare to the device data.

5. Drag the library element into the right drop area of the compare editor.
You can identify the status of the objects based on the symbols in the status and action 
area. When you select an object, the object properties and the corresponding object of the 
assigned device are clearly shown in the property comparison.
You can drag other devices into the drop areas from the current project, a library or from a 
reference point at any time to start a new comparison. It does not matter which device you 
drag into the drop area.
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See also
Using the comparison editor  (Page 288)

Carrying out offline/offline comparisons (Page 287)

Using the library view (Page 343)

Library basics (Page 338)

Overview of the "Libraries" task card (Page 339)

Overview of the library view (Page 343)

Using the element view (Page 342)

Using global libraries (Page 348)
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7.11 Using cross-references

7.11.1 Using cross-references

Introduction to cross-references
The cross-reference list provides an overview of the use of objects within the project. You can 
see which objects are interdependent and where the individual objects are located. Cross-
references are therefore part of the project documentation.

You can also jump directly to the point of use of an object.

Which objects you can display and localize in the cross-reference list depends on the installed 
products.

Editing projects
7.11 Using cross-references

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  387



7.12 Simulating devices

7.12.1 Simulation of devices

Introduction
You can use the TIA Portal to run and test the hardware and software of the project in a 
simulated environment. The simulation is performed directly on the programming device or 
PC. No additional hardware is required.

The simulation software provides a graphical user interface for monitoring and changing the 
configuration. It differs according to the currently selected device.

Integration in the TIA Portal
The simulation software is fully integrated in the TIA Portal but is only supported by certain 
devices. Therefore, the button for calling the simulation software is only active if the selected 
device supports simulation.

The simulation software for some devices requires its own virtual interface to communicate 
with the simulated devices. The virtual interface can be found in the project tree under the 
"Online access" entry next to the physical interfaces of the programming device/PC.

Once you have opened the software, additional help on the simulation software is available 
via a separate link.

See also
Starting the simulation (Page 388)

7.12.2 Starting the simulation
Some devices can be simulated with additional software. You therefore do not have to have 
the actual devices to perform comprehensive testing of your project. 

Procedure 
To start the simulation software, follow these steps:

1. Select the device you want to simulate, for example, in the project tree.

2. Select the "Simulation > Start" command in the "Online" menu.
This calls the simulation software.

See also
Simulation of devices (Page 388)
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Editing devices and networks 8
8.1 Configuring devices and networks

8.1.1 Hardware and network editor

8.1.1.1 Overview of hardware and network editor

Function of the hardware and network editor     
The hardware and network editor opens when you double-click on the "Devices and Networks" 
entry in the project tree. The hardware and network editor is the integrated development 
environment for configuring, networking and assigning parameters to devices and modules. It 
provides maximum support for the realization of the automation project.

Structure of the hardware and network editor     
The hardware and network editor consists of the following components:
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① Device view (Page 393), network view (Page 391), topology view (Page 396)
② Inspector window (Page 401) 
③ Hardware catalog (Page 403) 

The hardware and network editor provides you with three views of your project. You can switch 
between these three views at any time depending on whether you want to produce and edit 
individual devices and modules, entire networks and device configurations or the topological 
structure of your project.

The inspector window contains information on the object currently marked. Here you can 
change the settings for the object marked.

Drag the devices and modules you need for your automation system from the hardware catalog 
to the network, device ot topology view. 
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8.1.1.2 Network view

Introduction
The network view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Configuring and assign device parameters

● Networking devices with one another

Structure     
The following diagram shows the components of the network view:

① Changeover switch: device view / network view / topology view
② Toolbar of network view
③ Graphic area of network view
④ Overview navigation
⑤ Table area of network view

You can use your mouse to change the spacing between the graphic and table areas of the 
network view. To do this, click on the upper edge of the table view and expand or contract this 
by moving the mouse with the mouse button held down. The Speedy Splitter (the two small 
arrow keys) allows you to use a single click to minimize the table view, maximize the table view 
or restore the last selected split.
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Toolbar   
The toolbar provides the following functions:

Icon Meaning
Mode to network devices.

Mode to create connections.
You can use the adjacent drop-down list to set the connection type.
Mode to create relations.

Show interface addresses.

Adjust the zoom setting.
You can use the adjacent drop-down list to select or directly enter the zoom setting. You 
can also zoom in or zoom out the view in steps using the zoom symbol or draw a frame 
around an area to be zoomed in.
Show page breaks
Enables page break preview. Dotted lines are displayed at the positions where the pages 
break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table view 
is stored.

Graphic area
The graphic area of the network view displays any network-related devices, networks, 
connections and relations. In this area, you add devices from the hardware catalog, connect 
them with each other via their interfaces and configure the communication settings.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the network view includes various tables for the devices, connections and 
communication settings present:

● Network overview

● Connections

● I/O communication

You can use the shortcut menu of the title bar of the table to adjust the tabular display.
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See also
Adding a device to the hardware configuration (Page 419)

Layout of the user interface (Page 203)

Displaying diagnostics status and comparison status using icons (Page 962)

Networking devices in the network view (Page 433)

Tabular network overview (Page 436)

8.1.1.3 Device view

Introduction
The device view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Configuring and assign device parameters

● Configuring and assign module parameters

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  393



Structure     
The following diagram shows the components of the device view:

① Changeover switch: device view / network view / topology view
② Toolbar of device view
③ Graphic area of the device view
④ Overview navigation
⑤ Table area of device view

You can use your mouse to change the spacing between the graphic and table areas of the 
device view. To do this, click on the upper edge of the table view and expand or contract this 
by moving the mouse with the mouse button held down. The Speedy Splitter (the two small 
arrow keys) allows you to use a single click to minimize the table view, maximize the table view 
or restore the last selected split.
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Toolbar   
The toolbar provides the following functions:

Icon Meaning
Switches to the network view.
Note: The device view can switch between the existing devices using the drop-down 
list.
Show the area of unplugged modules.

Show module labels.
Adjust the zoom setting.
You can use the adjacent drop-down list to select or directly enter the zoom setting. 
You can use the Zoom icon to zoom in or out incrementally or to drag a frame around 
an area to be enlarged.
With signal modules, you can recognize the address labels from a zoom level of 200% 
or higher.
Show page breaks
Enables page break preview. Dotted lines are displayed at the positions where the 
pages break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the device view displays hardware components and if necessary the 
associated modules that are assigned to each other via one or more racks. In the case of 
devices with racks, you have the option of installing additional hardware objects from the 
hardware catalog into the slots on the racks.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the device view gives you an overview of the modules used and the most 
important technical and organizational data.

You can use the shortcut menu of the title bar of the table to adjust the tabular display.
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See also
Working with racks (Page 413)

Network view (Page 391)

Area for unplugged modules (Page 416)

Inserting a module into a rack (Page 422)

Objects in the device view (Page 414)

Layout of the user interface (Page 203)

Displaying diagnostics status and comparison status using icons (Page 962)

8.1.1.4 Topology view

Introduction
The topology view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Displaying the Ethernet topology

● Configuring the Ethernet topology

● Identifying and minimizing differences between the desired and actual topology
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Structure     
The following figure provides an overview of the topology view.

① Changeover switch: device view / network view / topology view
② Topology view toolbar
③ Graphic area of the topology view
④ Overview navigation
⑤ Table area of the topology view

You can use your mouse to change the spacing between the graphic and table areas of the 
topology view. To do this, click on the upper edge of the table view and expand or contract 
this by moving the mouse with the mouse button held down. The Speedy Splitter (the two small 
arrow keys) allows you to use a single click to minimize the table view, maximize the table view 
or restore the last selected split.
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Toolbar  
The toolbar provides the following functions:

Icon Meaning
Adjusting the zoom setting.
You can use the adjacent drop-down list to select or directly enter the zoom setting. 
You can also zoom in or zoom out the view in steps using the zoom symbol or draw 
a frame around an area to be zoomed in.
Show page breaks
Enables page break preview. Dotted lines are displayed at the positions where the 
pages break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the topology view displays Ethernet modules with their appropriate ports 
and port connections. Here you can add additional hardware objects with Ethernet interfaces. 
See: Adding a device to the hardware configuration (Page 419) 

Overview navigation    
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
This displays the Ethernet or PROFINET modules with their appropriate ports and port 
connections in a table. This table corresponds to the network overview table in the network 
view. 

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

See also
Layout of the user interface (Page 203)

Displaying diagnostics status and comparison status using icons (Page 962)
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8.1.1.5 Printing hardware and network configurations

Printout of hardware and network configurations  
You can print out the following elements of the hardware and network view as part of the project 
documentation:

● Graphic network view

● Network overview table

● Graphic device view

● The device overview table

● The parameters of the object currently selected in the editor

Printout of editor content
If you start a printout within an opened editor and no module is selected, the content of the 
editor is always printed. This includes a graphic representation of the editor as well as the table 
for the editor. You can adapt the scope of the printout. You can specify whether only the graphic 
view, the table or both together are to be printed. Read section "Changing the print options 
(Page 401)" for more on this.

If the graphic is larger than the page layout you have selected, the printout is continued on the 
next page. No content is lost this way. Alternatively, you can change the zoom level of the 
graphic representation to fit the printout on one page. The printout is always made in the 
currently selected zoom setting.

To check that all content fits on one page, you can either use the print preview or activate the 
page break preview. When page break preview is activated, dashed lines are displayed within 
the graphic editor at the location where the page break is later made.

Printing very large tables
If a table is larger than the print area and therefore cannot be fully printed, the content of the 
table is not printed as a table, but instead as pairs between value and key.

Example:

Object name Property 1 Property 2
Object A Value A1 Value A2
Object B Value B1 Value B2

In this case, the printout has the following appearance:

Object A

Property 1: Value A1

Property 2: Value A2

Object B

Property 1: Value B1
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Property 2: Value B2

You can also preset this as a template so that tables are always printed as pairs between the 
key and the value. Read section "Changing the print settings (Page 302)" for more on this.

Printing module parameters
Parameters of selected modules are printed out along with the current value settings in text 
form. All parameters from corresponding modules are also printed. For example, if you have 
selected a CPU, the parameters of an inserted signal board, if present, are printed as well.

You can determine the scope of the module parameters to be printed. In the "Print" dialog, 
select whether all properties and parameters of a module are to be printed or whether to use 
the compact printout. If you select the compact form, only the entries in the "General" area of 
the module properties are printed. Comments on modules, as well as the author and module 
description, are excluded. In compact mode, the following module parameters are therefore 
printed, for example:

● Module specifications
Name, module slot, short description, order number, firmware version

● Name of the PROFINET interface

● Subnet specifications
Name of the subnet, ID of the S7 subnet

See also
Changing the print options (Page 401)

Documentation settings (Page 299)

Creating a print preview (Page 314)

Printing project data (Page 317)

Activating the page break preview for printout (Page 400)

8.1.1.6 Activating the page break preview for printout
You can activate the page break preview for the printout in the graphic editor. If this option is 
activated, dashed lines are shown within the graphic editor at the locations where page breaks 
are later made during printout.

Procedure
Proceed as follows to activate the page break preview:

1. Select the graphic area of the corresponding view.

2. Click on the "Show page break" symbol in the toolbar of the graphic editor.
Dashed lines are displayed within the graphic editor at the location a page break is later 
made.
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3. To modify the frame layout, select the "Print" command in the "Project" menu.

4. To disable page break preview, click again on the "Show page break" symbol in the toolbar 
of the graphic editor. 

8.1.1.7 Changing the print options

Changing the scope of the printout
When printing from an editor, you can specify whether both graphics and tables are to be 
printed or just one of the two. Both are printed by default.

Procedure
To change the scope of the printout, proceed as follows:

1. In the "Options" menu, select the "Settings" command.

2. In the area navigation, open the "Print settings" parameter group under "General".

3. Scroll to the "Hardware configuration" group.

4. Select or clear the "Active graphic view" check box, depending on whether you want to print 
the graphics of the network and device view as well.

5. Select or clear the "Active table" check box, depending on whether you want to print the 
table for the editor as well.

See also
Printing hardware and network configurations (Page 399)

8.1.1.8 Inspector window 
The properties and parameters shown for the object selected can be edited in the inspector 
window.
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Structure     
The inspector window consists of the following components:

① Switch between various information and work areas
② Navigation between various pieces of information and parameters
③ Display showing the selected information and parameters

Function
The information and parameters in the inspector window are split into different types of 
information:

● Properties

● Info

● Diagnostics

To display the corresponding information and parameters, click in the relevant area. The 
"Properties" area is the most important one for configuring an automation system. This area 
is displayed by default and contains various tabs:

● General

● IO tags

● Text

The left pane of the inspector window is used for area navigation. Information and parameters 
are arranged there in groups. If you click on the arrow symbol to the left of the group name, 
you can expand the group if sub-groups are available. If you select a group or sub-group, the 
corresponding information and parameters are displayed in the right pane of the inspector 
window and can be edited there too.

See also
Editing properties and parameters (Page 428)

Overview of hardware and network editor (Page 389)

Translating text associated with individual objects (Page 269)
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8.1.1.9 Hardware catalog
The "Hardware catalog" task card gives you easy access to a wide range of hardware 
components.

Structure         
The "Hardware catalog" task card consists of the following panes:

① "Catalog" pane, search and filter function
② "Catalog" pane, component selection
③ "Information" pane

Search and filter function
The search and filter functions of the "Catalog" pane make it easy to search for particular 
hardware components. You can limit the display of the hardware components to certain criteria 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  403



using the filter function. For example, you can limit the display to objects that you can also 
place within the current context or which contain certain functions.

Objects that can be used in the current context include, for example, interconnectable objects 
in the network view or only modules compatible with the device in the device view.

Component selection
The component selection in the "Catalog" pane contains the installed hardware components 
in a tree structure. You can move the devices or modules you want from the catalog to the 
graphic work area of the device or network view.

Installed hardware components without a license are grayed out. You cannot use non-licensed 
hardware components.

Hardware components belonging to various components groups thematically are partially 
implemented as linked objects. When you click on such linked hardware components, a catalog 
tree opens in which you can find the appropriate hardware components.

Information
The "Information" pane contains detailed information on the object selected from the catalog:

● Schematic representation

● Name

● Order number

● Version number

● Description

See also
Browsing the hardware catalog  (Page 411)

Overview of hardware and network editor (Page 389)

Information on hardware components (Page 404)

8.1.1.10 Information on hardware components
In the hardware catalog, you can display information on selected hardware components in the 
"Information" pane. You can also display further information on the selected hardware 
components using the shortcut menu.
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Access to further information
If you select a hardware object in the hardware catalog and open the shortcut menu, you not 
only have the "Copy" function available but also three options for accessing information on 
Service & Support:

● Information regarding product support

● FAQs

● Manuals

The required information is displayed in the work area of the hardware and network editor.
 

 Note

You can only access Service & Support when you are connected to the Internet and the 
function is enabled. By default, the function is disabled. To enable the function, refer to the 
instructions in the section "Enabling product support (Page 405)".  

 

Information regarding product support  
Here, you have access to general information on hardware and software components. The 
order number of the selected hardware object is entered automatically in the search mask. 
You can, however, also search for other hardware and software components.

FAQs  
Here, you have access to "Frequently Asked Questions" (FAQs). You can view various entries 
on hardware and software questions. Using a detailed search mask, you can filter the required 
topics.

Manuals  
Here, you have access to the manuals of the various hardware components. This is particularly 
useful if the configuration, addressing or parameter assignment you are planning requires more 
detailed knowledge of the hardware you are using.

See also
Hardware catalog (Page 403)

Enabling product support (Page 405)

8.1.1.11 Enabling product support

Enabling Service & Support function
For each device in the hardware catalog, you have the option of displaying additional 
information that is stored in the Service & Support area of the Siemens website. By default, 
the function is disabled. Instructions for enabling the function are given below.
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Requirement
The software must have access to the Internet.

Procedure
To enable the Service & Support function, proceed as follows:

1. In the "Options" menu, select the "Settings" command.

2. Open the "Hardware configuration" group in the area navigation.

3. Select the "Via Internet" check box.

Result
You can now access product support, FAQs and manuals from the hardware catalog via the 
shortcut menu for the module.

See also
Information on hardware components (Page 404)

8.1.1.12 Keyboard operation: Navigation in the editor
You can use shortcut keys in the network and device view to navigate between the components 
of the hardware and network editor and its objects. 

Navigating between elements and functions

Function Shortcut keys
Switch to the next lower selection level
You can for example, use <Return> to switch from a selected rack to the lower selection 
level of the devices and modules that are snapped onto it. If a device is selected, you 
can use <Return> to switch to the lower selection level of the interfaces that are 
displayed on the device.

<Return>

Switch to the next higher selection level
You can use <Esc>, for example, to switch from a selected interface to the higher 
selection level of the devices and modules. If a device is selected, you can use <Esc> 
to switch to the higher selection level of the rack.

<Esc>

Navigation between objects in the current selection level
You can use the arrow keys to switch between the objects within a current selection 
level. To change the selection level, use the <Return> or <Esc> keys.

<Up arrow>
<Down arrow>
<Right arrow>
<Left arrow>

Switches to the device view <Ctrl+Shift+D>
Switches to the network view <Ctrl+Shift+N>
Switches to the topology view <Ctrl+Shift+T>

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
406 System Manual, 07/2013,  



Function Shortcut keys
Switch between editor elements
Use the <Tab> key to switch from one editor element to the next element. Use <Shift
+Tab> to switch to the previous element. You can switch, for example, between the 
graphical view, Speedy Splitter, table view or underlying tabs.

<Tab>
<Shift+Tab>

Switch between tabs
Use the <Ctrl+Tab> keys to switch from one tab to the next tab on the right. Use <Ctrl
+Shift+Tab> to switch to the next tab to the left. You can use these keys, for example, 
to switch between the device view, the network view and the topology view.

<Ctrl+Tab>
<Ctrl+Shift+Tab>

Opening elements and functions

Function Shortcut keys
Opening the online and diagnostics view
When a device is selected, <Ctrl+D> opens the online and diagnostics view for the 
selected device.

<Ctrl+D>

Opening the download to device dialog
When a device is selected, <Ctrl+L> opens the advanced download dialog.

<Ctrl+L>

Add new device
<Ctrl+N> opens the dialog for adding a new device.

<Ctrl+N>

Opens the "Hardware catalog" task card <Ctrl+Shift+C>
Opens "Online Tools" task card <Ctrl+Shift+O>

See also
Keyboard operation in the TIA Portal (Page 234)

8.1.1.13 Keyboard operation: Editing objects
You can execute some of the functions of the network and device view directly with a 
combination of keyboard and mouse in the hardware and network editor. The keyboard 
operation in tables (Page 234) corresponds to standard characteristics. Here you find the 
keyboard operation for the graphic work area of the network and device view. 

General keyboard operation        

Function Shortcut keys
Zoom in on view in frame
Drag a frame in the graphical view in order to correspondingly change the size of the 
view.

<Ctrl+Space> + pressed mouse 
button

Move view
Move the mouse pointer in order to move the view.

<Space> + pressed mouse button

Cancel current operation <Esc>
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Function Shortcut keys
Separate connection
Use <Esc> or a double-click to exit connection mode when dragging a connection.

<Esc> or double-click

Zoom in graphic view
The enlargement or reduction depends on the direction of rotation.

<Ctrl> + turn mouse wheel

Selected objects

Function Shortcut keys
Select object Mouse click
Cut an object
The selected object is copied to the clipboard and deleted from the graphical view.

<Ctrl+X>

Copy object
The selected object is copied to the clipboard. 

<Ctrl+C>

Paste object
The object from the clipboard is inserted into the selection.

<Ctrl+V>

Delete selected object <Del>
Select several objects 1
You can add several objects to the selected objects by clicking on them individually. 
Alternatively, you can use <Shift> + pressed mouse key to drag a frame around the 
objects that are to be selected.

<Shift> + click

Select several objects 2
You can add several objects to the selected objects by clicking on them individually. 
Alternatively, you can use <Shift> + pressed mouse key to drag a frame around the 
objects that are to be selected. When holding down the <Ctrl> key, you can use a 
mouse click to deselect selected objects.

<Ctrl> + click

Move selection
When the mouse button is pressed, you can drag devices or modules to allowed slots 
on a rack.

Mouse button pressed

Copy selection
Using <Ctrl> + pressed mouse button you can drag devices and modules to allowed 
slots on a rack. This copies the devices or modules.

<Ctrl> + pressed mouse button

8.1.2 Configuring devices

8.1.2.1 Basics

Introduction to configuring hardware
To set up an automation system, you will need to configure, assign parameters and interlink 
the individual hardware components. The work needed for this is undertaken in the device and 
network view.
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Configuring   
"Configuring" is understood to mean arranging, setting and networking devices and modules 
within the device or network view. Racks are represented symbolically. Just like "real" racks, 
they allow you to plug in a defined number of modules. 

An address is automatically assigned to each module. The addresses can be subsequently 
modified. 

When the automation system is started, the CPU compares the setpoint configuration 
produced by the software with the system's actual configuration. Possible errors can be 
detected and reported straight away.

Assigning parameters  
"Assigning parameters" is understood to mean setting the properties of the components used. 
Hardware components and settings for the exchange of data are assigned:

● Properties of modules with selectable parameters

● Settings for data exchange between components

The parameters are loaded into the CPU and transferred to the corresponding modules when 
the CPU starts up. Modules can be replaced with ease since the parameters set are 
automatically loaded into the new module during startup.

Adjusting the hardware to the project requirements
You need to configure hardware if you want to set up, expand or change an automation project. 
To do this, add hardware components to your structure, link these with existing components, 
and adapt the hardware properties to the tasks.

The properties of the automation systems and modules are preset such that in many cases 
they do not have to be parameterized again. Parameter assignment is however needed in the 
following cases:

● You want to change the default parameter settings of a module.

● You want to use special functions.

● You want to configure communication connections.

See also
Changing properties of the modules (Page 854)

Using existing configurations

Open existing projects
When opening existing projects, an automatic check is made to determine if the appropriate 
software is installed for all modules used within the project. If you try to open a project with 
modules that are not supported by the current scope of the installation of the TIA portal, a 
message appears on opening the project informing you of the missing software components. 
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If the software components are not absolutely required to open the project, the project can still 
be opened.

Reaction to missing software components
Projects that contain modules not supported by the current scope of the installation react as 
follows:

● Display the modules on the GUI

– The non-supported modules are displayed in the project navigation with all of their 
nested objects. However, the modules themselves cannot be processed in editors or in 
inspector windows. When possible, a replacement module is used that best matches 
the original module. Replacement modules are indicated by an exclamation mark.

– Display of properties in tables is limited. This applies in particular to the display of 
network parameters, such as the IP address.

● Functional limitations

– Non-supported modules cannot be printed out or compiled.

– An online connection cannot be established to the module. It is therefore also impossible 
to download.

– To change the device type, the device must first be deleted and then re-inserted. The 
"Change device type" function is not supported.

– Copying and inserting nested objects, such as modules, is possible although the device 
itself cannot be copied and inserted.

– The network configuration cannot be changed with replacement modules within the 
network view.

– Cross-references can be displayed. However, the cross-references only reflect the state 
last saved within the project because on online comparison to the original module cannot 
be made.

See also
Opening projects (Page 259)

General slot rules

Introduction  
Specific slot rules apply to each automation system and module.

If you select a module from the hardware catalog in the device view, all possible slots for the 
module selected are marked in the rack. You can only drag modules to marked slots.

If you insert, move or swap a module, the slot rules are also applied.
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Consistency  
Some slot rules depend on how the environment is configured. This means that you can 
sometimes plug modules into the rack although this would result in inconsistencies at the 
current time. If you change the configuration, for example by selecting different modules or 
module parameter settings, you can make the configuration consistent again.

In cases where inserting a module results in an inconsistency that can be corrected, this will 
be permitted. A consistency check is run when transferring the configuration. Inconsistencies 
are displayed as alarms in the inspector window under "Info". You can revise your configuration 
on the basis of the results of the consistency check and make it consistent again.

Rules for arranging modules  
As a rule of thumb, the following applies to modules in racks:

● You can only plug modules into a rack.

● You can only plug interface modules into a module.

● You can only use modules of the same product or system family in one rack.

There are also other special rules for some modules:

● Can only be inserted in certain slots

● Inertion depends on other modules, CPUs or settings

● Limitation of the number of times used in a rack

Browsing the hardware catalog 

Introduction  
Use the "Hardware catalog" task card to select the hardware components you want for a 
hardware configuration. Use the hardware catalog to select the interconnectable hardware 
components in the network and topology view and to select the modules you want in the device 
view.

Context filter   
You can use the "Filter" option of the hardware catalog to restrict the number of displayed 
hardware components and the number of hardware components that can be found by 
searching.

If you select the filter, only those components are displayed that can be selected currently in 
the hardware catalog. If the do not select the filter, the entire hardware catalog is displayed.

If you switch between the various views, the view of the filter objects is adapted to the current 
context.
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Search options  
You can use the search function to search for specific entries in the hardware catalog. Note 
the following rules when entering search terms:

● No distinction is made between upper and lower case text.

● Dashes and blanks are ignored during the search.

● The search function considers parts of a search term.

● Several search terms must be separated by a space

You start the search from an object highlighted in the hardware catalog and either search 
upwards or downwards.

Symbol Meaning
Downwards search
Upwards search

Browsing the hardware catalog 
If you want to browse the hardware catalog, proceed as follows:

1. Click in the entry field of the search function

2. Enter a search term. The search includes the following elements:

– Name of device or module

– Order number (MLFB)

– Description in "Information" pane

3. Click on either the "Downwards search" or "Upwards search" buttons.
 

  Note

To ensure the right search direction, note which point you have marked in the hardware 
catalog. To browse the entire catalog, click on the topmost object of the hardware catalog 
and start the search once you have entered the search term by clicking "Downwards 
search".

The first match with the search term found is displayed as the result. For more search 
results, again click on the "Downwards search" or "Upwards search" button.

Observe the context filter of the hardware catalog. If this is selected, the search in the 
hardware catalog is restricted to the displayed inserted hardware components.

 

See also
Hardware catalog (Page 403)

Information on hardware components (Page 404)
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Working with racks

Introduction   
To assign modules to a device, you need a rack, for example a mounting rail. Secure the 
modules on the rack and connect these via the backplane bus with the CPU, a power supply 
or other modules.

Creating a rack
If you insert a device in the network view, a station and a rack suitable for the device selected 
are created automatically. The rack and slots available are displayed in the device view. The 
number of slots available again depends on the type of device used.

Rack structure   
A rack always contains the device that has been inserted in the network view. The device is 
permanently assigned a slot which will depend on the type of device in question. There are 
additional slots on the right of the device and, if necessary, on left of the device; slot numbers 
are located above slots in which devices are plugged.

A corresponding short description is displayed above the plugged devices and modules. You 
show or hide this short description via the toolbar under "View" with the command "Display 
module titles" or the corresponding symbol in the toolbar of the device view (Page 393).

Symbol Meaning
Show module titles

When modules are selected in the hardware catalog, all the slots permitted for this module are 
marked. This allows you to see immediately the slot into which the selected module can be 
inserted.

In the following screenshot, a signal module has been selected in the hardware catalog for a 
partially filled S7-1200 rack:

Since slots 101-103 are reserved for communications modules, only the other free slots are 
shown as available slots.
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You can expand and collapse the front group of slots using an arrow symbol above the 
expandable slot. When the group of slots is collapsed, the first and last of the group's slot 
numbers are displayed.

The following figure shows the expanded slot group:

Groups of slots into which modules have already been plugged cannot be collapsed.

Multiple selection of modules and slots    
There are various ways of selecting several modules or slots:

● By pressing <Shift> or <Ctrl>, you can select several modules or slots at the same time.

● Click outside the rack and then hold the mouse button and drag a frame to include the 
modules or slots you want to select.

Objects in the device view
A graphic display of the rack and the devices plugged into it is shown in the upper section of 
the device view.

You can see the device overview in the bottom part of the device view. The device overview 
is a table showing you the most important information about the modules inserted in the rack.

Structure and content of device view
The offline configuration of the devices in the rack are displayed in the graphic device view. 
This is a symbolic representation of the configuration on the real rack.

The rack configuration is displayed as a table in the device view. Each line in the table contains 
the information for assigning a slot.

The following screenshot shows the device view with the configuration of a SIMATIC S7-1200 
CPU. 
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In the upper part, you can see the graphic view showing how the rack is occupied by various 
modules in slots 1 to 3 as well as 101. In the lower part you can see a tabular representation 
of the rack in the device overview.

Each line in the device overview represents one slot. The key information for each slot is 
displayed in the various columns:

Column Meaning
Module Name of module, can be edited in any way
Slot Slot number
I address Input address area, can be edited in any way
Q address Output address area, can be edited in any way
Type Catalog name of module
Order no. Module order number
Firmware Firmware version of module
Comments Optional comments

See also
Device view (Page 393)

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  415



Area for unplugged modules
In some cases, the modules for a hardware configuration are not assigned a slot for short 
periods. Such unplugged modules are moved to the area of unplugged modules, a special 
area in the device view.

Adding modules to the storage area       
The modules, which for example are to be assigned to a device using a copy action but for 
which the corresponding rack does not have a free compatible slot, are moved automatically 
into the area of unplugged modules.

Under the following conditions, modules are automatically added to the area of unplugged 
modules:

● In the network view, a module is moved to a device but the rack does not have a compatible 
free slot.

● In the device view, a module is moved from the rack, the hardware catalog or the project 
tree straight into the storage area.

CPs and FMs which occupy a network resource can be moved into the area for unplugged 
modules but will lose the network resources they have been assigned.

You can add modules to the area of unplugged modules by means of drag-and-drop, for 
example. To do this, the area must be opened.

Using the area of unplugged modules
Use the corresponding button to open the area of unplugged modules.

You can find the area of unplugged modules in the device view.

You open the area of unplugged modules with the respective symbol in the toolbar of the device 
view (Page 393).

Symbol Meaning
Open area of unplugged modules

 

 Note

To free up slots, move modules from your configuration into the storage area and plug the 
modules you want from the storage area into the freed up slots.

You can use this approach to temporarily move modules that have already been 
parameterized out of the configuration without deleting them.
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Treatment of modules in the storage area
The following rules apply to modules in the storage area:

● The modules appear in the project tree under the corresponding device in the "Local 
modules" folder.

● The modules retain all settings and parameters previously provided.

● The modules are not taken into account when downloading to a target system so a 
consistency check is not undertaken for modules in the area of unplugged modules.

● Using the context menu, the modules can be copied, pasted or deleted, for example.

8.1.2.2 Configuring individual devices

Selecting a CPU

Introduction
Select a CPU from the hardware catalog and place it, together with a rack, in the network view. 
On this device drag the desired modules from the hardware catalog; they are arranged 
automatically on the rack.

Selecting the components in the hardware catalog   
Each hardware component is displayed as a folder in the hardware catalog. When you open 
this folder you will see the different versions of the selected hardware component with its 
respective order numbers.

There will be an example of how to set up a CPU with a rack in network view.

Requirement
● The hardware catalog is open.

● You must be in the network view.

Procedure
To select a CPU from the hardware catalog, proceed as follows:

1. In the hardware catalog navigate to the folder with the desired CPUs.

2. Open the folder with the desired CPU type; you will see all order numbers for the selected 
CPU type.
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3. Click on a CPU order number to get information about the selected CPU under "Information" 
pane.

4. Set up the CPU and a rack. You have the following options:

– Use drag-and-drop to drag the CPU from the hardware catalog into network view.

– Use Copy & Paste to copy the CPU to the network view.

– Double-click the CPU entry in the hardware catalog.

See also
Browsing the hardware catalog  (Page 411)

Adding a device to the hardware configuration (Page 419)

Inserting a module into a rack (Page 422)

Working with racks (Page 413)

Creating an unspecified CPU (Page 420)

Information on hardware components (Page 404)
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Adding a device to the hardware configuration

Introduction   
There are various ways of adding a connectable device from the hardware configuration in the 
network view and the topology view:

● Command "Add new device" in the project tree

● Double-click device in hardware catalog

● Drag-and-drop from the hardware catalog in network view or in topology view:

– Text entry from the "Catalog" pane

– Preview graphic from the "Information" pane

● "Add > Device" command from menu bar in network view or topology view

● Shortcut menu of a device in the hardware catalog for copying and pasting

A suitable rack is created along with the new device. The selected device is inserted at the 
first permitted slot of the rack.

Regardless of the method selected, the added device is visible in the project tree and the 
network view of the hardware and network editor.

Adding device using the project tree  
To use the project tree to add a device to the hardware configuration, proceed as follows:

1. Click on the command "Add new device" in the project tree.
The "Add new device" dialog box opens.

2. Display the required device in the tree structure:

– Go to required device in the tree structure.

– Enter a device name in the entry field.

3. Select the required device from the tree.
More information about the device presently selected is displayed on the right-side of the 
dialog box.

4. If necessary, set the firmware version using the drop-down list in the dialog box.

5. Select the "Open device view" check box if you want to change to the device view 
immediately after adding the device.
There you can immediately continue with device configuration and equipping the rack.

6. Click on "OK" to add the device selected.
The dialog box closes.

Adding device from the hardware catalog    
To add a device to the hardware configuration using the hardware catalog, proceed as follows:

1. Open the network view or the topology view.

2. Open the hardware catalog.
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3. Go to the required device in the hardware catalog.

4. Click on the chosen device to select it.

5. If necessary, set the firmware version using the drop-down list in the hardware catalog.

6. Drag the device to the network view or the topology view.

You have now placed the device in the network view or in the topology view. The displayed 
rectangle (in other words "Station") symbolizes the plugged device together with its rack and 
any lower-level modules. Double-click on the device or station to open the device view and 
view the new rack and inserted device. In the next steps, you can configure the device in the 
device view and equip the rack with modules.

See also
Network view (Page 391)

Creating an unspecified CPU (Page 420)

Information on hardware components (Page 404)

Topology view (Page 396)

Creating an unspecified CPU

Introduction
If you have not yet selected a CPU but have already started programming or want to use an 
existing program, you have the option of using an unspecified CPU. You can also adjust some 
settings with unspecified CPUs. The setting options are restricted to parameters that all CPUs 
of the same CPU family have in common.

Creating an unspecified CPU in the portal view 
To create an unspecified CPU in the portal view, follow these steps:

1. Now, click one of the following options:

– "Devices & networks > Add new device"

– "PLC programming" > "Device" button

2. For a device family, select an unspecified CPU from the tree structure of the "Add new 
device" dialog.

3. Click on "Add".
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An unspecified CPU is created and the device view for this CPU appears.

Further options for creating unspecified CPUs
In the project view, you can create unspecified CPUs like specified CPUs:

● Using the "Add new device" button in the project tree

● In the "Hardware catalog" task card

You can also use these methods to create multiple unspecified CPUs.

Specifying unspecified CPUs
You have two options for specifying unspecified CPUs:

● Use drag-and-drop to assign an existing CPU from the hardware catalog to an unspecified 
CPU by means of module replacement (Page 427).

● Select a selected, unspecified CPU and then the menu command "Online > Hardware 
detection" and assign a CPU identified online. For this purpose, you assign an IP address 
using the "Add address for PG/PC" button.

 

  Note

If you want to go online after the hardware detection, you have to first download the 
detected configuration to your project; otherwise, an error may occur due to inconsistent 
configurations. After hardware detection, the order numbers of the CPU in the project and 
the actually existing CPU are identical, but their parameters are not. The parameters of 
the CPU in the project have the default values; the parameters of the actually existing 
CPU have the values set by you.

 

See also
Selecting a CPU (Page 417)

Adding a device to the hardware configuration (Page 419)
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Inserting a module into a rack

Introduction   
Once you have added devices from the hardware catalog to your configuration in network view, 
you can add modules to the devices. There are various ways of adding a module to a rack in 
the device view:

● If there is an available valid slot, double-click a module in the hardware catalog.

● Use drag-and-drop to move the module from the hardware catalog to an available valid slot 
in the graphic or table area:

– Text entry from the "Catalog" pane

– Preview graphic from the "Information" pane

● Select "Copy" in the shortcut menu for a module in the hardware catalog and then select 
"Paste" in the shortcut menu on an available valid slot in the graphic or table area.

To access the device view from the network view, double-click a device or station in the network 
view or select the Device view tab. The device view contains an illustration of the device 
selected within a rack. The graphic illustration of the rack in the software corresponds to the 
real structure, i.e. you can see the same number of slots as exist in the real structure.

 

 Note

You can also move a module to a rack in the network view. The filter function for the hardware 
catalog must be deactivated in this instance. The module is automatically plugged into a free 
and permitted slot. If there are no slots available, the module will be moved to the area of 
unplugged modules (Page 416).

 

Equipping a rack   
Arrange the modules on a rack according to the applicable slot rules.

After a module has been inserted in a rack with an already inserted CPU, the address areas 
are checked automatically so that addresses are not assigned twice. After it has been inserted, 
each module then has one valid address range. To do so, DP slaves and IO devices must be 
networked with a CPU via the corresponding DP master or IO system.

Requirements
● You are in the device view.

● The hardware catalog is open.
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Adding module from the hardware catalog 
How to insert a module from the hardware catalog into a rack is illustrated based on the 
example of a signal module. To do this, follow these steps:

1. Go to the required module board in the hardware catalog.
 

  Note

If you activate the filter function of the hardware catalog, only those modules which match 
the selected device type will be displayed.

 

2. Select the chosen module.

3. If necessary, set the firmware version using the drop-down list in the hardware catalog.

4. Drag the signal module to a free slot in the rack.

You have now inserted the digital signal module in a slot in the rack. Repeat these steps with 
the other modules.

The name of the module is displayed above the inserted modules. You can activate or 
deactivate module labeling in the menu bar with "View > Show module labels".

Inserting module  
You can also drag modules and drop them between modules that have already been inserted. 
To do this, drag a module above and between the two existing modules while holding down 
the mouse button.

A mouse pointer appears. When you release the mouse button, all modules plugged to the 
right of the pointer are moved one slot to the right. Any redundant modules are moved to the 
area of unplugged modules. The new module is plugged at the point of the freed up slot. 
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See also
Device view (Page 393)

Area for unplugged modules (Page 416)

Information on hardware components (Page 404)

General slot rules (Page 410)

Deleting a hardware component
There are various ways of deleting hardware components. Deleted hardware components are 
removed from the system and assigned addresses made available again.

Rules
● CPUs or modules from the rack and from the area of unplugged modules can be deleted.

● When a rack is deleted in the device view the plugged hardware components are moved 
to the area of unplugged modules.

Procedure     
Proceed as follows to delete a hardware component:

1. Select the hardware components you want to delete.

– Network view: Select devices or network relevant hardware components in the graphic 
view or in the network view.

– Device view: In the graphic view or device overview, select racks or modules in racks 
or in the area of unplugged components.

– Topology view: Select devices or hardware components with Ethernet interfaces in the 
graphic view or in the topology view.

– Project tree: Select devices or individual hardware components from the tree structure.

2. Select "Delete" from the shortcut menu or press <Del>.
If the "Delete" menu item is unavailable, your selection contains at least one component 
that cannot be deleted.

The selected hardware components are deleted.
 

 Note

Deleting hardware components may result in inconsistencies in the project, for example 
infringement of slot rules. Inconsistencies are reported during the consistency check. Correct 
the inconsistencies by taking appropriate action, for example, make sure that slot rules are 
kept to.

 

See also
Keyboard operation: Editing objects (Page 407)
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Copying a hardware component
You can copy hardware components in the device or network view. Copied hardware 
components are stored on a clipboard and can be pasted at another point from this clipboard. 
Copied stations are pasted as new stations in the network view. Copied devices and modules 
can be pasted into existing racks in the network and device view.

Rules
● Single objects as well as several objects can be copied at the same time.

● Modules inserted in the rack and in the area of unplugged modules can be copied.

● You can only copy devices and modules to free and valid slots in keeping with the slot rules.

● Racks with a CPU inserted cannot be copied individually, but only as complete units along 
with all inserted hardware components.

Procedure     
Proceed as follows to copy a hardware component:

1. Select the hardware components you want to copy.

– Device view: Select the module in a rack or put it in the area of unplugged modules.

– Network view: Select the station or the relevant hardware component from the network 
view.

– Project tree: Select the station or module.

2. Select "Copy" from the shortcut menu or press <Ctrl+C>.
If the "Copy" menu item is unavailable, your selection contains at least one component that 
cannot be copied.

3. Select the location at which the content of the clipboard is to be pasted.

– Device view: Select a free slot in the rack or area of unplugged modules.

– Network view: Select a station where you want to insert devices or modules or move 
the mouse pointer to a free location in the network view to paste a copied station or a 
hardware component relevant to the network view.

4. Select "Paste" from the shortcut menu or press <Ctrl+V>.
If the "Paste" menu item is unavailable, the clipboard is empty or contains at least one 
component that cannot be pasted at this point.

The selected object is pasted at the chosen point.
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Once you have selected a station where you want to insert a module in the network view, the 
module is inserted in the first free and valid slot. If no free, valid slots are available, the object 
is inserted in the area of unplugged modules.

 

 Note

You can also copy a module from one device to another:

To do so, copy a module in the hardware and network editor, select a different device in the 
network view or the drop down list of the device view and insert the module.

You can insert the copied object directly in a slot or place it in the area of unplugged modules 
in the device view. If you add the copied object in the network view of a device or a station, 
it will be inserted in the first available slot.

If there is no slot available for the object, it is automatically placed in the area of unplugged 
modules (Page 416).

 

 Note

You can use <Ctrl> and drag-and-drop to directly copy a selected hardware component.
 

See also
Keyboard operation: Editing objects (Page 407)

Moving a hardware component
You can move hardware components in the device or network view.

Rules
● You can move devices and modules from the rack and the area for unplugged modules 

taking the slot rules into consideration.

● CPs can be moved in the network view. The CP is plugged in a free and valid slot in the 
target device. If there are no free slots available, the CP to be inserted is moved to the area 
for unplugged modules.

● In the network view, CPU and slave head modules can be moved between the devices; 
depending on CPU type also within the rack.

 

 Note

Moved CPs are disconnected from their network but keep their network parameters and 
address. If you reconnect the CP to the network and its address has been assigned, use a 
dialog to assign a new unique address to the CP.
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Procedure 
Proceed as follows to move a hardware component:

1. Select the hardware component you want to move.

– Device view: Select the module in a rack or put it in the area of unplugged modules.

– Network view: Select the hardware component of relevance to the network view.

2. Select "Cut" from the shortcut menu or press <Ctrl+X>.
If the "Cut" menu item is unavailable, your selection contains at least one component that 
cannot be cut.

3. Select the location to which the cut object is to be moved.

– Device view: Select a free slot in the rack or area of unplugged modules.

– Network view: Select a station where you want to insert devices or modules.

4. Select "Paste" from the shortcut menu or press <Ctrl+V>.
If the "Paste" menu item is unavailable, the clipboard is empty or contains at least one 
component that cannot be pasted at this point.

The selected hardware component is moved to the target. If the hardware component being 
moved is a networked object, it is disconnected from the network.

 

 Note

You can use drag-and-drop to directly move a selected hardware component.
 

See also
Keyboard operation: Editing objects (Page 407)

Replacing a hardware component
You can replace hardware components with others. This, for example, allows you to replace 
unspecified CPUs (Page 420) with available CPUs from the hardware catalog.

Rules
You can only replace hardware components if they support module replacement and if the two 
components are compatible.

Procedure   
To replace one module with another, proceed as follows:

1. Select the module you want to replace.

2. Open the shortcut menu:

– If the "Replace device" entry is enabled, the module can be replaced.

– If the "Replace device" entry is disabled, a module cannot be replaced.
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3. Click on "Replace device" in the shortcut menu. ### The "Replace device" dialog box 
appears.

4. Under "New device" in the tree structure, select the module with which you want to replace 
your current module.

5. Click "OK".

The existing module is replaced by the new one.

As an alternative, you can take a module by dragging it from the hardware catalog to the module 
you are replacing. If the module can be replaced by the selected module, this is indicated by 
the mouse pointer symbol.

Editing properties and parameters
Once you have inserted hardware components in your rack, you can edit their default 
properties, for example parameters or addresses in the network or device view.

Requirement
You are in the device view.

 

 Note

You can also edit properties and parameters in the network view. In the graphic network view, 
you have access to the network-related hardware components and the station. You can 
access modules and hardware components not displayed in the graphic network view using 
the table network view.

 

Procedure         
To change the properties and parameters of the hardware components, proceed as follows:

1. In the graphic view, select the CPU, module, rack or interface you want to edit.

2. Edit the settings for the selected object:

– Use the table view to edit addresses and names, for example.

– In the Inspector window additional setting possibilities are available in "Properties".

Note that modules can only be fully parameterized if they are assigned to a CPU. Therefore, 
PROFIBUS or PROFINET interfaces modules must first be networked with the CPU or a 
centrally inserted communication module so that they form a master system or IO system. 
Only then is it possible, for example, to edit the addresses of the distributed components that 
are inserted. 
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Example of changing settings

① Selection of a module
② Editing option for addresses in the device overview
③ Selection options in the inspector window
④ Editing option for addresses in the inspector window

 

See also
Inspector window  (Page 401)
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Input and output addresses in the address overview

Introduction  
The currently used input and output addresses can be displayed in the address overview in a 
table form. The address overview can be found in the inspector window under "Properties" of 
the CPU.

Design of the address overview
With the different check boxes, you can set which objects should be displayed in the address 
overview:

● Inputs: Display of the input addresses

● Outputs: Display of the output addresses

● Address gaps: Display of open address spaces

● Slot: Display of the slot number

The following information is typically shown in the address overview:

Table header Meaning
Type Indicates whether the area is an input address area or an output address 

area.
Address from Start address in the address range.
Address to End address in the address range.
Module Modules using the address area.
PIP Number of the process image partition. Shows if the cyclical OB in the 

process image partition.
DP Number of the master system. You can use the number to determine which 

slaves are assigned to a master. The value in brackets specifies the 
PROFIBUS address of the hardware component.

PN Number of the IO system. The value in brackets stands for the device 
number of the hardware component.

Racks Rack number on which the hardware component is inserted.
Slot Slot number on the rack in which the hardware component is inserted.

See also
Specifying input and output addresses (Page 638)
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Update module version

Explanation of terms 
The terms "Module version" and "Firmware version" are explained in more detail in the 
following section.

● Module version: The specific version of the configuration software from which the module 
description stems.
Example: V11.0.0.0

● Firmware version: The version of the firmware of the offline configured module
Example: V2.0

Requirement
● You have created a device configuration.

● You have installed an update or an optional package at a later date. As a result of this 
installation, the module version of at least one module type was updated in the hardware 
catalog, whereby the new version is incompatible with the previous version.

● You have used such modules in your device configuration and want to use the modified or 
added properties.

Procedure
Perform the following step for each affected module type.

1. Select the affected module in the device view.

2. In the inspector window, go to "Properties > General > Catalog Information". Click the 
"Update module version" button there.

3. In the query that then appears, specify whether you want to update the module version only 
for the selected module or for all modules of this type in the current project.

Result
The selected modules are replaced by the same modules with updated module version in the 
the current project.

In which cases is it unnecessary to update the module version?
An updating of the module version is not necessary in the following cases:

● You do not want to used the modified or added properties of the modules.

● You open an existing project with a version of the configuration software that is more recent 
than the version with which you created the project and the system automatically performs 
a project conversion, for example, from V11 to V12. In this case, all older module versions 
are automatically adapted.
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8.1.3 Configure networks

8.1.3.1 Networking devices

Communication and networks

Communication between devices   
The basis of all types of communication is always a previously configured network. The network 
configuration provides the necessary requirements for communication:

● All the devices in a network are provided with a unique address

● Communication of the devices with consistent transmission properties

Network configuration   
The following steps are necessary when configuring networks:

● Connect devices to subnet

● Specify the properties/parameters for each subnet

● Specify the device properties for every networked module

● Download configuration data to the devices to supply interfaces with the settings resulting 
from the network configuration

● Document the network configuration

For Open User Communication, creating and configuring a subnet is supported by the 
assignment of connection parameters.

Relation between network configuration and project   
Within a project, subnets and their properties are managed. Properties result mainly from 
adjustable network parameters and the quantity and communication properties of the 
connected devices.

The devices to be networked must be in the same project.

Subnet name and subnet ID
Within the project, subnets are clearly identified by a subnet name and ID. The subnet ID is 
saved in all components along with interconnectable interfaces. Components can then be 
clearly assigned to a subnet even after uploading into a project.
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Networking options
In the project, you can create and network devices with components capable of 
communication. The following basic options are available for networking the devices:

● You link the interfaces of the components capable of communication with one another. A 
new subnet is created suitable for the type of interface.

● You connect the interface of the devices capable of communication with a new or existing 
subnet.

● You create an Open User Communication connection. When you assign parameters to the 
connection for Open User Communication, a subnet is created automatically between the 
communication partners.

● You use the graphic connection configuration to configure connections; missing networks 
are hereby recognized and are created either automatically or via dialog.

Due to the different tasks of the devices or the span of the plant, you may need to use several 
subnets. These subnets are managed in a project.

Networking devices in the network view

Options
In the graphic network view, you have an overview of the subnets of the entire system in the 
project. You can use the tabular network overview for additional support.

Depending on the starting situation, there are various ways of undertaking configuration to 
network the interface for a component capable of communication. The procedures are 
described in the following section:

● Creating an individual subnet

● Creating several subnets at one time

● Connecting two target devices via a new subnet

● Connecting devices to existing subnet

● Selecting an existing subnet from a list

● Automatic networking during the configuration of the connection;
See also: Auto-Hotspot

Possible starting situations are:

● A suitable subnet is not yet available.

● The subnet with which you want to connect the component already exists.

Procedure - creating a single subnet  
To create a subnet and to connect it to an interface, proceed as follows:

1. Select the interface of a CPU / a CP.

2. Select the "Create subnet" command in the shortcut menu of the interface.
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The selected interface is connected to a new subnet. Consistent address parameters are set 
automatically for the interface.

The following schematic shows an interface with outgoing line connecting to a subnet:

Procedure - creating several subnets at one time  
To create several subnets at one time, proceed as follows:

1. Select several interfaces by clicking on them while pressing the <Ctrl> button.

2. Select the "Create subnet" command in the shortcut menu of the interface.

Each selected interface is connected to a new subnet. Consistent address parameters are set 
automatically for the interface.

The following figure shows multiple subnets created by selecting multiple interfaces:

Procedure – Connecting two target devices via a new subnet
To connect an interface with another device via a subnet that does not yet exist, proceed as 
follows:

1. Position the mouse pointer over the interface for a component capable of communication 
requiring networking.

2. Click with the left mouse button and hold the button down.

3. Move the mouse pointer.
The pointer now uses the networking symbol to indicate "Networking" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear when the pointer is 
on a valid target.
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4. Now move the pointer onto the interface of the target device. You can either keep the mouse 
button pressed or release it.

5. Now release the left mouse button or press it again (depending on previous action).

A new subnet is created. The interfaces are now connected via the new subnet. Consistent 
address parameters are set automatically for the interface.

The following schematic shows two networked devices:

Procedure - Connecting devices to existing subnet  
To connect an interface to an existing subnet, proceed as follows:

1. Position the mouse pointer on the interface of a communications-compliant component you 
want to network or on the existing subnet.

2. Click with the left mouse button and hold the button down.

3. Move the mouse pointer.
The pointer now uses the networking symbol to indicate "Networking" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear once the pointer is 
moved to a valid target.

4. Now move the mouse pointer to the existing subnet or to the interface to be networked. 
You can either keep the mouse button pressed or release it.

5. Now release the left mouse button or press it again (depending on previous action).

Result:

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.
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Procedure - selecting an existing subnet from a list
To link an interface with a subnet that has already been created, proceed as follows:

1. Select the interface of a CPU.

2. Select the "Assign to new subnet" command in the shortcut menu of the interface.
A list box containing the available subnets appears.

3. Select a subnet from the list.

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.

Tabular network overview

Meaning
The tabular network overview adds the following functions to the graphic network view:

● You obtain detailed information on the structure and parameter settings of the devices.

● Using the "Subnet" column, you can connect components capable of communication with 
created subnets.

Basic functions for tables
The network overview supports the following basic functions for editing a table:

● Displaying and hiding table columns
 Note: The columns of relevance to configuration cannot be hidden. 

● Optimizing column width

● Sorting table

● Displaying the meaning of a column, a row or cell using tooltips.

Networking devices in the device view

Networking in the device view 
In the device view, you can check and set all the parameters of the components belonging to 
a device and the interfaces in detail. Here you can also assign the interfaces to the subnets 
created in the project.

Requirements
● The subnet with which you want to connect an interface has already been created.

● If the subnet has not yet been created, change to the network view and make the settings 
required for networking. 
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Procedure - connecting to an existing subnet 
To connect an interface to an existing subnet, proceed in the device view as follows:

1. Select the entire communications-compliant component or the interface to be networked.
The properties of the selected interface or component are displayed in the Inspector window.

2. In the Inspector window, select the parameter group for the selected interface; for example, 
the "Ethernet addresses" parameter group for a PROFINET interface.

3. Select the subnet to be connected from the "Interface connected with" drop-down list.

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.

Procedure - creating a new subnet 
To create a subnet and to connect it to the interface, proceed as follows in the device view:

1. Select the entire communications-compliant component or the interface to be networked.
The properties of the selected interface or component are displayed in the Inspector window.

2. In the Inspector window, select the parameter group for the selected interface; for example, 
the "Ethernet addresses" parameter group for a PROFINET interface.

3. In "Interface connected with", click the "Add new subnet" button.

The interface is connected to a new subnet of the appropriate subnet type. Consistent address 
parameters are set automatically for the interface.

Checking or changing network parameters and interface parameters

Introduction 
Communication between networked devices requires the following parameters to be 
configured:

● Network parameters
Network parameters identify the network within the system configuration, for example, using 
a name.

● Interface parameters
Interface parameters define specific properties of a component capable of communication. 
Addresses and transmission characteristics are set automatically and are consistent with 
the network parameters.

 

  Note

Network parameters and interface parameters are usually set during networking such that 
communication can take place for numerous applications without the parameters having 
to be changed.
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Procedure - checking or changing network parameters 
Proceed as follows to check or change network parameters:

1. Enter the network view.

2. Select the subnet from the network view.
You can see the network parameters in the "Properties" tab in the inspector window.

3. If necessary, check or modify the network parameters in the relevant group of parameters.

Procedure - checking or changing interface parameters 
You can check and modify interface parameters in the network and device view.

Proceed as follows to check or change interface parameters:

1. Enter the network view or device view.

2. Select the interface.
You can see the interface parameters in the "Properties" tab in the inspector window.

3. If necessary, check or modify the interface parameters in the relevant group of parameters.

 

Changing networkings

Introduction
You can cancel an interface's network connection or assign it to another subnet of the same 
subnet type.

Consequences
Depending on the version, a distinction should be made between:

● Canceling a network connection for an interface
The configured parameters for the interface remain unchanged.

● Assigning a network connection to another subnet
If the addresses in the assigned subnet are not unique, in other words, they already exist, 
they will be changed automatically to make them unique.
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Procedure - disconnecting from a network  
Proceed as follows to cancel the network connection for an interface:

1. Select the networked interface.

2. Select the "Disconnect from subnet" command in the shortcut menu of the interface.

The network connection is deleted, the interface addresses are, however, not changed.

Configured connections are retained; however these connections are marked red in the 
connection table because they are not networked. Specified connections remain specified.

See also
Networking devices in the network view (Page 433)

Copying, cutting or deleting subnets

Introduction
You can copy subnets as individual objects or copy them along with networked devices or 
other networks.

For example, you can create complex configurations to be used more than once in different 
variants within the project with no additional effort.

Effects on the copied subnet 
Properties that have to be assigned explicitly within a project are re-assigned appropriately 
when the copied objects are copied. 

For subnets, this means: The subnet ID and name are re-assigned to the copied subnet.

The configured properties are adopted in the copied subnet.

Procedure - copying a subnet
Proceed as follows to copy one or more subnets:

1. Select one or more subnets.

2. In the shortcut menu, select the "Copy" command.

3. Select the "Paste" command in the shortcut menu.

The copied subnets are shown as "orphaned" subnets in the top part of the network view.
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Procedure - copying a subnet with connected devices 
To copy one or more subnets with networked devices, proceed as follows:

1. Select one or more subnets with the connected devices, for example by drawing a lasso 
around them.

2. In the shortcut menu, select the "Copy" command.

3. Select the "Paste" command in the shortcut menu.

Complete copies of the subnets and connected devices are created.

Configured connections are adopted and remain within the copied devices. Connections to 
devices that have not been copied are interrupted and become unspecified.

MPI network configuration

Allocating MPI addresses 
Note the following for devices with an MPI interface: All devices of a subnet must have different 
device addresses. 

CPUs with MPI address ship with the default MPI address 2. Since you can only use this 
address once in the MPI subnet, you will have to change the default address in all other CPUs.

The following applies to devices with the order no. 6ES7 3xx-xxxxx-0AB0:

When planning the MPI addresses for several CPUs, you have to fill "MPI address gaps" for 
FMs and CPs with separate MPI addresses to prevent addresses being assigned twice. 

Only when all the modules in a subnet have different addresses and your actual structure 
matches that of the network configuration produced, should you load the settings across the 
network.

Rules for assigning the MPI address 
● Allocate the MPI addresses in ascending order.

● Reserve MPI address 0 for a programming device.

● You can link up to 126 (addressable) devices with one another in an MPI subnet; up to 8 
devices at a transfer speed of 19.2 KB/s.

● All MPI addresses in an MPI subnet must be different.
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You will find other rules relating to the structure of a network in the manuals for setting up 
automation systems.

PROFIBUS network configuration

PROFIBUS addresses

Rules for the network configuration  
All the devices in a subnet must have a different PROFIBUS address. 

Only when all the modules in a subnet have different addresses and your actual structure 
matches that of the network configuration produced, should you load the settings across the 
network.

You can connect devices to the PROFIBUS subnet that communicate via configured 
connections or that belong to a PROFIBUS DP master system.

You can find more information on configuring a DP master system in the following sections.

Requirements
The 121xC CPU is PROFIBUS compatible as of firmware version 2.0.

Rules for assigning PROFIBUS addresses
● Allocate the PROFIBUS addresses in ascending order.

● Reserve the PROFIBUS address "0" for a programming device.

● Allocate a unique PROFIBUS address between 0 and 126 for each device on the 
PROFIBUS network and/or for each DP master and each DP slave in the PROFIBUS 
network.

● There are modules with which the smallest address that can be set has to be greater than 
1.

● All PROFIBUS addresses of a PROFIBUS subnet must be different.

You will find additional rules relating to the structure of a network in the manuals for setting up 
automation systems, for example SIMATIC S7-1200.

 

 Note
PROFIBUS address "0"

Reserve PROFIBUS address "0" for a programming device that you will briefly connect up 
to the PROFIBUS network at a later date for servicing.

 

See also
What you need to know about PROFIBUS bus parameters (Page 442)
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What you need to know about PROFIBUS bus parameters

Matching parameters to one another  
The PROFIBUS subnet will only function without problem if the parameters for the bus profile 
are matched to one another. You should therefore only change the default values if you are 
familiar with how to configure the bus profile for PROFIBUS.

 

 Note

It may be possible for the bus parameters to be adjusted depending on the bus profile. If the 
bus parameters cannot be adjusted, they are grayed out. The offline values of the bus 
parameters are always shown even if you are online and linked to the target system.

 

The parameters shown apply to the entire PROFIBUS subnet and are briefly explained below.

Activating cyclic distribution of the bus parameters
If the "Enable cyclic distribution of the bus parameters" check box is selected under "Bus 
parameters" while PROFIBUS subnet is selected in the Inspector window, the bus parameters 
are transferred cyclically during operation by the modules that support this function. This allows 
a programming device, for example, to be easily connected to the PROFIBUS in runtime. 

You should deactivate this function:

● For a heterogeneous PROFIBUS subnet (or more accurately: when external devices are 
connected whose protocol uses the DSAP 63 for Multicast)

● When in constant bus cycle time mode (minimize bus cycle)

Bus parameters for the bus profile of PROFIBUS subnets  

Bus parameter Adjustable? Limit values
Tslot_Init Yes Max. Tsdr + 15 <= Tslot_init <= 16.383 t_bit
Max. Tsdr Yes 35 + 2*Tset + Tqui <= Max. Tsdr <= 1.023 t_bit
Min. Tsdr Yes 11 t_bit <= Min. Tsdr <= MIN(255 t_bit, ...

... Max. Tsdr - 1, 34 + 2*Tset + Tqui)
Tset Yes 1 t_bit <= Tset <= 494 t_bit
Tqui Yes 0 t_bit <= Tqui <= MIN(31 t_bit, Min. Tsdr - 1)
GAP factor Yes 1 <= GAP factor <= 100
Retry limit Yes 1 <= Retry limit <= 15
Tslot No ---
Tid2 No Tid2 = Max. Tsdr
Trdy No Trdy = Min. Tsdr
Tid1 No Tid1 = 35 + 2*Tset + Tqui
Ttr Yes 256 t_bit <= Ttr <= 16.777.960 t_bit

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
442 System Manual, 07/2013,  



Bus parameter Adjustable? Limit values
Ttr typical No This time is provided for information only and is not transferred to the 

nodes.
Response monitoring  10 ms <= response monitoring (watchdog) <= 650 s

If you want to create a customized bus profile, we recommend the following settings:

● Minimum target rotation time (Ttr) = 5000 x HSA (highest PROFIBUS address)

● Minimum response monitoring (watchdog) = 6250 x HSA

Recalculating
You can use the "Recalculate" button to recalculate the parameters. 

See also
PROFIBUS addresses (Page 441)

Description of the bus parameters (Page 443)

Description of the bus parameters

Detailed description of PROFIBUS bus parameters

Bus parameter Meaning
Tslot_Init The wait-for-reception (slot time) defines the maximum time the sender will wait 

to receive a response from the addressed partner. If the influence of the line 
components on message frame run times is entered in the "Cable Configuration" 
parameter group, these components must also be taken into account. The 
component is added to the specified Tslot_Init and the total used as Tslot.

Max. Tsdr The maximum protocol processing time defines the latest time by which the 
responding node should have replied.

Min. Tsdr The minimum protocol processing time defines the earliest time by which the 
responding node may reply.

Tset The trigger time is the time which may lapse between the reception of a data 
message frame and the response to it in the node.

Tqui The modulator quiet time is the time which a sending node needs after the end 
of the message frame to switch from sending to receiving.

GAP factor The GAP update factor defines the number of token rotations after which a newly 
added, active node can be added to the logical token ring.

Retry limit This parameter defines the maximum number of attempts (message frame 
repeats) made to reach a node.

Tslot The wait-for-reception time (slot time) defines the maximum time the sender will 
wait to receive a response from the addressed partner.
If the influence of the bus design components on message frame run times is 
entered in the "Cable Configuration" parameter group, these components must 
also be taken into account. The component is added to the specified Tslot_Init 
and the total used as Tslot.
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Bus parameter Meaning
Tid2 Idle time 2 defines the earliest time by which a sending node may send the next 

message frame after sending a message frame that has not been acknowledged.
Trdy The ready time specifies the earliest time by which a sending node may receive 

a response message frame.
Tid1 Idle time 1 defines the earliest time by which a sending node may send the next 

message frame after receiving a response.
Ttr The target rotation time is the maximum time made available for a token rotation. 

During this time, all active nodes (DP masters etc.) have the right to send (token) 
once. The difference between the target rotation time and the actual token holding 
time of a node determines how much time is left over for the other active nodes 
(programming device, other DP masters etc.) to send message frames.

Ttr typical The typical data cycle time is the average response time on the bus if all 
configured slaves are exchanging data with the DP master. None of the slaves 
report diagnostics and there is no extra message frame traffic with programming 
devices or other active nodes etc. on the bus.

Response monitoring The response monitoring time is only needed for PROFIBUS-DP bus systems. It 
defines the latest time by which a DP slave has to be addressed by its DP master 
with a new data message frame. If this does not happen, the DP slave assumes 
that the DP master has failed and resets its outputs to a secure mode.

See also
What you need to know about PROFIBUS bus parameters (Page 442)

Bus profiles with PROFIBUS

Introduction  
Depending on the device types connected and protocols used on the PROFIBUS, different 
profiles are available. The profiles differ in terms of the setting options and calculation of bus 
parameters. The profiles are explained below.   

Devices with different profiles on the same PROFIBUS subnet  
The PROFIBUS subnet only functions without problem if the bus parameters of all devices 
have the same values. For example, if both DP and FMS services are being used on a subnet, 
the "slower" sets of bus parameters must always be set for all devices, i.e. even the "Universal 
(DP/FMS)" profile for DP devices.  

Profiles and transmission rates  

Profiles Supported transmission speeds in Kbits/s
DP 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000 
Standard 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000
Universal (DP-FMS) 9.6 19.2 93.75 187.5 500 1500
Customized 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000
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Meaning of profiles  

Profile Meaning
DP Select the "DP" bus profile when the only devices connected to the PROFIBUS 

subnet are those which satisfy the requirements of standard EN 50170 Volume 
2/3, Part 8-2 PROFIBUS. The bus parameter setting is optimized on these 
devices. 
This includes devices with DP master and DP slave interfaces of the SIMATIC 
S7 and distributed I/Os of other manufacturers. 

Standard Compared to the "DP" profile, the "Standard" profile also offers scope for 
devices of another project or devices which have not been configured here to 
be taken into account when calculating the bus parameters. The bus 
parameters are then calculated following a simple, non-optimized algorithm. 

Universal (DP/FMS) Select the "Universal (DP/FMS)" bus profile when individual devices on the 
PROFIBUS subnet use the PROFIBUS-FMS service. 
This includes the following devices for example: 
● CP 343-5 (SIMATIC S7)
● PROFIBUS-FMS devices of other manufacturers
As with the "Standard" profile, this profile allows you to take other devices into 
account when calculating the bus parameters.

Customized The PROFIBUS subnet will only function without problem if the parameters for 
the bus profile are matched to one another. Select the "Customized" profile 
when none of the usual profiles "match" a PROFIBUS device and you need to 
adapt the bus parameters to your special structure. Information on this can be 
found in the documentation for the PROFIBUS device. 
You should only change the default values if you are familiar with how to 
configure the bus profile for PROFIBUS. 
Not all combinations that can be theoretically set can be used even with this 
bus profile. The PROFIBUS standard specifies several parameter limits that 
depend on other parameters. For example, a responder must not respond (Min 
Tsdr) before the initiator can receive the message frame (Trdy). These standard 
specifications are also checked in the "Customized" profile. 
Tip: The bus parameters last valid on the PROFIBUS subnet are always 
automatically set as customized. For example, if the "DP" bus profile was valid 
for the subnet, then the bus parameters for "DP" are set in the "Customized" 
bus profile. The parameters can be modified on this basis. 
The monitoring times are not automatically recalculated so that you do not put 
at risk the consistency of set values, for example with configurations in other 
configuration tools without realizing that you have done so.
You can also have the Ttr monitoring times and target rotation time calculated 
on the basis of parameters you have set: Click here on the "Recalculate" button.

 

 Note

Both mono-master mode and multi-master mode are possible with all PROFIBUS profiles. 
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What you need to know about PROFIBUS line configuration

Cable configuration and bus parameters
Information regarding the cable configuration can be taken into consideration when calculating 
the bus parameters. For this purpose, you must select the "Consider cable configuration" check 
box in the properties for the PROFIBUS subnet.

The remaining information then depends on the type of cable used; the following settings are 
available:

● Copper cable

● Fiber-optic cable/optical ring

PROFIBUS line configuration, optical ring
The calculation depends on the OLM types used. The selection is made by activating the check 
box (multiple activation is possible, at least one OLM type must be selected):

● OLM/P12

● OLM/G12

● OLM/G12-EEC

● OLM/G12-1300

The following bus parameter adjustments are made:

● Configuration of a node not present
 

  Note
The following restrictions apply to optical rings, even for passive nodes (DP slaves for 
example):

A maximum of HSA-1 nodes may be connected to the PROFIBUS network. With an HSA 
of 126, addresses 126 and 125 must not be used. A maximum of 125 nodes are possible 
on the bus (No. 0 to 124).

If an HSA is less than or equal to 125, the addresses HSA and greater may not be used. 
The address HSA-1 may not be used.

 

● Increase the retry value to 3

● Setting of minimum slot time needed for ring mode
 

  Note

Short slot time values are needed for OLM/P12, average ones for OLM/G12 and OLM/
G12-EEC and long ones for OLM/G12-1300. This results in high performance for small 
network lengths and average to low performance for average to large network lengths.
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PROFIBUS communication load

Communication load - allowing for additional network stations
The bus parameters depend on the volume of communication between the active network 
nodes. There are differences between cyclic communication (DP) and connection-based, 
acyclic communication (S7 communication, Send/Receive (FDL), FMS). Unlike DP, the volume 
and size of communication tasks (communication load) depends on the user program. For this 
reason, the communication load cannot always be calculated automatically. 

To calculate the bus times you can define a network configuration in the "Additional network 
stations" parameter group that differs from the network configuration.

Taking the profile into account
The network configuration can be defined for the "Standard", "Universal (DP/FMS)", and "User-
defined" profiles. Parameters cannot be entered in the "Additional network stations" parameter 
group for the "DP" profile.

Quantification of the communication load
The following settings are available in order to make allowance for the communication load.

● Information regarding the number of unconfigured network stations;

● Information on the communication load resulting from the user programs for FDL or S7 
communication. Here you can selected from the following settings:

– Low
Typically used for DP, no great data communication apart from DP.

– Medium
Typically used for mixed operations featuring DP and other communication services 
(such as for S7 communication), when DP has strict time requirements and for average 
acyclic volumes of communication.

– High
For mixed operations featuring DP and other communication services (such as for S7 
communication), when DP has loose time requirements and for high acyclic volumes of 
communication.

 

Configuring Industrial Ethernet

Rules for the network configuration  
The Ethernet interfaces of the devices have a default IP address that you can change.
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IP address  
The IP parameters are visible if the module capable of communication supports the TCP/IP 
protocol. This is usually the case for all Ethernet modules.

The IP address consists of 4 decimal figures in the range of 0 to 255. The decimal figures are 
separated from one another by a dot.

Example: 140.80.0.2 

The IP address consists of: 

● Address of the (sub) net

● Address of the node (generally also called host or network node)

Subnet mask  
The subnet mask splits these two addresses. It determines which part of the IP address 
addresses the network and which part of the IP address addresses the node. 

The set bits of the subnet mask determine the network part of the IP address.

Example:

Subnet mask: 255.255.0.0 = 11111111.11111111.00000000.00000000

In the example given for the above IP address, the subnet mask shown here has the following 
meaning: 

The first 2 bytes of the IP address identify the subnet - i.e. 140.80. The last two bytes address 
the node, thus 0.2. 

It is generally true that: 

● The network address results from AND linking the IP address and subnet mask.

● The device address results from AND NOT linking the IP address and subnet mask.

Relation between IP address and default subnet mask  
An agreement exists relating to the assignment of IP address ranges and so-called "Default 
subnet masks". The first decimal number (from the left) in the IP address determines the 
structure of the default subnet mask. It determines the number of "1" values (binary) as follows:

IP address (decimal) IP address (binary) Address class Default subnet mask
0 to 126 0xxxxxxx.xxxxxxxx.... A 255.0.0.0
128 to 191 10xxxxxx.xxxxxxxx... B 255.255.0.0
192 to 223 110xxxxx.xxxxxxxx... C 255.255.255.0

 

 Note
Range of values for the first decimal point

A value of between 224 and 255 is also possible for the first decimal number of the IP address 
(address class D etc). This is, however, not recommended because there is no address check 
for these values.
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Masking other subnets  
You can use the subnet mask to add further structures and form "private" subnets for a subnet 
that is assigned one of the address classes A, B or C. This is done by setting other lower points 
of the subnet mask to "1". For each bit set to "1", the number of "private" networks doubles 
and the number of nodes they contain is halved. Externally, the network functions like an 
individual network as it did previously. 

Example:

You have a subnet of address class B (for example IP address 129.80.xxx.xxx) and change 
the default subnet mask as follows: 

Masks Decimal Binary
Default subnet mask 255.255.0.0 11111111.11111111.00000000.

00000000
Subnet mask 255.255.128.0 11111111.11111111.10000000.

00000000

Result: 

All nodes with addresses between 129.80.001.xxx and 129.80.127.xxx are on one subnet, all 
nodes with addresses between 129.80.128.xxx and 129.80.255.xxx are on another subnet.

Router  
The task of the routers is to connect the subnets. If an IP datagram is to be sent to another 
network, it first has to be conveyed to a router. To make this possible, you have to enter the 
address of the router for each node in the subnet.

The IP address of a node in the subnet and the address of the router may only differ at the 
points at which there is a "0" in the subnet mask.

Network configuration of AS interface
AS-Interface consists of an AS-i master and AS-i slaves connected to each other over an AS-
i subnet.

Rules for AS interface network configuration
All the nodes in an AS-i subnet must have a different AS-i node address.

You should only load the settings over the network when all the modules in a subnet have 
different addresses and when the actual structure matches that of the network configuration 
you have created.

One AS-i master and up to 31 AS-i slaves can be operated on one AS-i subnet.

For more information on configuring an AS-Interface with an AS-i master and AS-i slaves, refer 
to the section on AS-Interface and the documentation of the AS-i master modules.
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8.1.3.2 Communication via connections

Working with connections

S7 connection

Introduction to configuring connections

Definition   
A connection defines a logical assignment of two communication partners in order to undertake 
communication services. A connection defines the following:

● Communication partner involved

● Type of connection (for example, S7 connection)

● Special properties (e.g., whether a connection is established permanently or whether it is 
established and terminated dynamically in the user program, and whether status messages 
are to be sent)

● Connection path

What you need to know about connection configuration
During connection configuration, a local connection name is assigned for an S7 connection as 
a unique local identification.

In the network view, a "Connections" tab is displayed in addition to the "Network overview" 
tab. This tab contains the connection table. A row in this connection table represents a 
configured connection from the viewpoint of the local communication partner with its properties, 
for example, between two S7-1200 CPUs.

What you need to know about using connection resources

Introduction  
Each connection requires connection resources for the end point and/or transition point on the 
devices involved. The number of connection resources is device-specific. 

If all the connection resources of a communication partner are assigned, no new connections 
can be established. This situation is apparent when a newly created connection in the 
connection table has a red background. The configuration is then inconsistent and cannot be 
compiled.
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S7 connections
In the case of S7 connections via the PN interface, one connection resource per S7 connection 
is assigned for the endpoint for the S7-1200 CPU. One connection resource is also required 
for the connection partner.

You can find an overview of available and assigned connection resources for selected S7-1200 
CPU in the Inspector window at "Properties > Connection Resources"
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Views containing information about the configured connections
The views described below will provide you with comprehensive access to all the information 
and functions regarding configuring and checking communication connections.

● Connection display in the network view

● Connection table

● "Properties" tab for a connection in the inspector window

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
452 System Manual, 07/2013,  



Benefits
The information shown in these views are always up-to-date in terms of the current user 
actions. This means:

● The connection table displays all connections created.

● If you have selected a connection in the connection table:

– When connection mode is enabled, the connection path is highlighted in the network 
view.

– The "Properties" tab in the Inspector window displays the parameters of this connection.

The connection table
The connection table offers the following functions:

● List of all connections in the project

● Selection of a connection and display of connections associated with it in the network view 
(when connection mode is enabled)

● Changing of connection partners

● Display showing status information

"Properties" tab for a connection in the inspector window
The properties dialog has the following meaning:

● Display for connection parameters

● Display of connection path

● Subsequent specification of connections using the "Find connection path" button

Creating a new connection

Creating a connection - alternatives
You have the following options for creating a connection in the network view:

● Graphic connection configuration

● Interactive connection configuration

You'll find the individual steps for this in the following chapters.

Requirement and result
In the network view, you have add devices between which the connections should be 
configured.
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Specifying a connection
If both partners for the connection type selected are networked on the same network, use the 
graphic or interactive selection of both communication partners to create a fully specified 
connection.

This connection is entered automatically in the connection table of the S7-1200 CPU. A local 
connection name is assigned for this connection.

The following schematic shows a configured connection with a networked device:

Creating a new connection graphically

Graphically configuring connections
In the case of graphic connection configuration, the connection path is automatically specified 
provided interfaces and resources are available. Select the devices to be connected in the 
current configuration.
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Automatically determining connection path
To create a connection graphically, follow these steps:

1. Click the "Connections" button.

This step activates the connection mode: You can now select the connection type you want. 
You will see this from the following:
The devices that can be used for the connection type selected in your project are color-
highlighted in the network view.

2. Hold down the mouse button and drag the mouse pointer from the device from which the 
connection will originate to the device at which the connection ends.

3. Release the mouse button over the destination device to create the connection between 
the two devices.

Result
● A specified connection is created.

● The connection path is highlighted.

● The connection is entered in the connection table.

Configuring a connection when there is no or no clear network assignment
Any networking not in place will if possible be created automatically when a connection is 
created. A query will be made upon completion of connection configuration if unique network 
assignment is not possible. You will be able to choose from the existing subnets.

Example below: A query is made upon creation of a connection between stations PLC_1 and 
PLC_2, which are not yet networked.
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Interactively creating a new connection

Interactively configuring connections
Define the local device and its connection partners.

Procedure
Proceed as follows to interactively create a connection:

1. Select the "Add new connection" command in the shortcut menu of a connection partner 
for which you want to create a connection.
The "Create new connection" dialog appears. 

2. Select the partner endpoint.
In the right pane of the dialog, a possible connection path fitting the selected endpoint is 
displayed, if available. Incomplete paths, for example, for a non-specified CPU, are marked 
by an exclamation mark on a red background. 

3. To accept the configured connection and to configure additional connections to other 
endpoints, click "Add".
To close the dialog, click "OK".

Working in the network view

Highlighting connection path and partner in the network view
To display the connection partners for all or certain connection types in the network view, 
proceed as follows:

1. Click the "Connections" button.

2. Select the S7-CPU for which you want to display the connection partners in the network 
view and then select the "Highlight connection partners" command in the shortcut menu.

3. Select "All connection partners" in the following menu.
The local device and the CPUs of the target devices are selected. The local connection 
partner shows an arrow pointing right and the remote connection partners show an arrow 
pointing left.

4. To open a list with information on the target devices, click the arrow of the local device. 
This additional function is useful in complex network configurations in which some devices 
are not visible.
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 Note

You can display one of the connection partners which cannot be seen in the current display 
range of the network view. Click on the communication partner in the list that appears. Result: 
The display is moved such that the connection partner becomes visible.

 

 

Working with the connection table

Basic functions for tables
The connection table supports the following basic functions for editing a table:

● Changing column width

● Displaying the meaning of a column, a row or cell using tooltips.

Changing column width
To adjust the width of a column to the content so that all texts in the lines are legible, follow 
these steps:

1. Position the cursor in the header of the connection table to the right of the column that you 
want to optimize until the cursor changes its shape to two parallel lines (as if you wanted 
to change the width of the column by dragging it with the cursor).

2. Double click on this point.

or

1. Open the shortcut menu on the header of the table.

2. Click on

– "Optimize column width" or

– "Optimize width of all columns".

For columns that are too narrow, the complete content of specific fields is shown when you 
pause with the cursor on the respective field.

Show / hide columns
You can use the shortcut menu of the header of the connection table to control the display of 
the various table columns. The shortcut menu entry "Show/hide columns" provides you with 
an overview of the available columns. Use the check box to control whether columns are shown 
or hidden.

If you want to store the layout, width and visibility of the table columns, click on the "Remember 
layout" function in the top right-hand of the network view.
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Symbol Meaning
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table view is 
stored.

Using cursor keys to move within the connection table 
You can use the UP and DOWN cursor keys to select a connection from the connection table; 
the selected connection is marked and is shown highlighted in the network view.

Changing properties of connection
You can directly edit some of the parameters displayed in the connection table. The name of 
the connection can, for example, only be changed in the connection table.

Changing connection partners
You can change the connection partner of a connection as follows:

1. Select the connection.

2. Select the new connection partner from the open drop-down list in the "Partner" column.

Deleting connections
You can delete configured connections using the network view or the connection table.

In the network view you can delete one highlighted connection per action. In the connection 
table you can delete one or several connections per action.

Procedure
To delete a connection, follow these steps:

1. Select the connection to be deleted:

– In the network view: Select the connection to be deleted.

– In the connection table: Select the rows of the connections to be deleted (multiple 
selection possible).

2. Open the shortcut menu with a right mouse click.

3. Select the "Delete" command.

Result
The selected connection is removed completely.
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Copying connections

Introduction
Connections are not copied singly but always in context along with the project or the device.

You can copy:

● Entire projects

● One or more devices within a project or from one project to another

Copying a project
When you copy a project all configured connections will also be copied. No settings whatsoever 
are required for the copied connections because the connections remain consistent.

Copying devices
If you copy devices for which connections have been configured, the connections are copied 
as well. To complete the connection path, you must still finalize the networking. 

An S7-1200 CPU with a V.10 firmware is merely a server for connections and has no 
connection configuration itself. Consequently, no connections are copied along with it when 
an S7-1200 CPU with a V1.0 firmware is copied. 

Inconsistent connections - connections without assignment
With an inconsistent connection the structure of the connection data is destroyed or the 
connection is not functional in the project context. 

Inconsistent connections cannot be compiled and loaded - operation is not possible with such 
a connection. 

In the connection table inconsistent connections are marked in red.

Possible causes for inconsistent connections
● Deletion or change of the hardware configuration.

● Missing interface network links in the project, which are necessary for a connection.

● Connection resources are exceeded

● Connections to an unspecified connection partner without partner address information.

Detailed information regarding the reasons for the inconsistency can be found in the "Compile" 
tab following compilation (Edit > Compile). 

Remedies
To assign a closed connection path to an existing open connection path, expand the device 
configuration in such a way that the interfaces required for the connection type are available 
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for both partners. At "Properties > General > Interface" in the Inspector window, you can use 
the "Find connection path" button to create a connection to an existing partner.

S7 connection - general settings

General connection parameters
General connection parameters are displayed in the "General" parameter group under the 
properties of the connection; these connection parameters identify the local connection end 
point.

Here, you can assign the connection path and specify all aspects of the connection partner.

Local ID
The local ID of the module from which the connection is viewed is displayed here (local partner). 
You can change the local ID. You may need to do this if you have already programmed 
communication function blocks, and you want to use the local ID specified in those function 
blocks for the connection.

Special connection properties
Display of connection properties (can be modified depending on the components used):

● One-way
One-way means that the connection partner functions as a server on this connection and 
cannot send or receive actively.

● Active connection establishment
In the case of one-way connection, for example with a S7-1200 CPU (firmware version 
V1.0), a connection partner can only be provided for the active connection establishment. 
In the case of a two-way connection you can set which connection partner will assume the 
active role.

● Sending operating mode messages
Indicates whether or not the local partner sends operating mode messages to the 
connection partner.

Address details
Displaying address details of the S7 connection. With an unspecified partner, the values for 
the rack and slot can be changed. All other values are obtained from the current configuration 
and cannot be changed.

S7 connection - address details

Meaning
The address details show the end points of the connection and can localize these via the 
specification of rack and slot.
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When a connection is established, the connection-specific resources of a module are assigned 
specifically to this connection. This assignment requires that the connection resource can be 
addressed. The TSAP (Transport Service Access Point) is, as it were, the address of the 
resource that is formed with the help of the connection resource or, in the case of  S7-1200 
CPUs (firmware V2.0 or higher) with the SIMATIC-ACC (SIMATIC Application Controlled 
Communication). 

Configuration of TSAP for S7-1200  
● For S7-1200 CPU (firmare V2.0 or higher):

"SIMATIC-ACC"<nnn><mm>
nnn = Local ID
mm = any value

● For S7-1200 CPU (firmare V1.0):
<xx>.<yz>
xx = Number of the connection resource
y = Rack number
z = Slot number

TSAP structure, dependent on partner
The configuration of the TSAP for S7-1200 CPUs is dependent on the respective firmware and 
on the remote connection partner. When a S7-1200 CPU is connected with a S7-300/400 CPU, 
a S7-1200 CPU also uses a TSAP configuration that includes the connection resource.

See the following examples for TSAPs of various connection configurations

● Connection between two S7-1200 CPUs (both with firmware V2.0):

– S7-1200 CPU "A" with firmware V2.0 and local ID 100:
TSAP: SIMATIC-ACC10001

– S7-1200 CPU "B" with firmware V2.0 and local ID 5AE:
TSAP: SIMATIC-ACC5AE01

● Connection between two S7-1200 CPUs (firmware V2.0 and V1.0):

– S7-1200 CPU with firmware V2.0 and local ID 1FF:
TSAP: SIMATIC-ACC1FF01

– S7-1200 CPU with firmware V1.0 (rack 0, slot 1, connection resource 03):
TSAP: 03.01

● Connection between S7-1200 CPUs (firmware V2.0) and S7-300/400 CPU:

– S7-1200 CPU with firmware V2.0 (rack 0, slot 1, connection resource 12):
TSAP: 12.01

– S7-300/400 CPU (rack 0, slot 2, connection resource 11):
TSAP: 11.02
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S7 connections via CM/CP

Introduction
S7-1200 CPUs with a firmware version of V2.0 or higher support one-way and two-way S7 
connections via CM/CP interfaces. This increases the number of Ethernet ports and networks 
that can be used for S7 connections. Even though the connection is then guided via the CM/
CP, the associated S7-1200 CPU is an end point of the connection. The other end point can 
be any other device in the case of two-way connections. This other device must also support 
S7 connections.

Data volumes and configuration limit
The number of communication connections which are supported by CM/CP can be found in 
the manual accompanying every CM/CP. The number of connections per device can be further 
increased by adding other CM/CPs.

If several CM/CPs are fitted in a device, an automatic switch is made to the next CM/CP when 
this limit is exceeded. Specifically assign the connections using the path selection as required.

 

 Note

Data transfer > 240 byte transfer is supported by the current CPs. 

CPs with an older product version support the transfer of data with a data length of up to 240 
bytes.

For more information, refer to the details provided in the Ethernet CP equipment manual.
 

Tasks of the Ethernet CM/CP in online mode
During data transfer via a connection, the Ethernet CM/CP takes on the following tasks:

● Receiving
Receiving data from the Ethernet and forwarding to the user data area in the CPU

● Sending
Transferring data from the user data area of the CPU and sending data via the Ethernet

The connection is established automatically as soon as the partner can be reached.
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HMI connection

Introduction to configuring connections

Definition    
A connection defines a logical assignment of two communication partners in order to undertake 
communication services. A connection defines the following:

● Communication partner involved

● Type of connection (e.g., HMI connection)

● Special properties (e.g., whether a connection is established permanently or whether it is 
established and terminated dynamically in the user program, and whether status messages 
are to be sent)

● Connection path

What you need to know about connection configuration
During connection configuration, a local connection name is assigned for an HMI connection 
as a unique local identification.

In the network view, a "Connections" tab is displayed in addition to the "Network overview" 
tab. This tab contains the connection table. A line in this connection table represents a 
configured connection, e.g., between an HMI device and PLC, along with its properties.

What you need to know about using connection resources

Introduction
Each connection requires connection resources for the end point and/or transition point on the 
devices involved. The number of connection resources is device-specific. 

If all the connection resources of a communication partner are assigned, no new connections 
can be established. This situation is apparent when a newly created connection in the 
connection table has a red background. The configuration is then inconsistent and cannot be 
compiled.

HMI connections
For HMI connections via the integrated PN interface, one connection resource for the endpoint 
per HMI connection is occupied for the HMI device. 

One connection resource is also required for the connection partner (PLC). 
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Views containing information about the configured connections
The views described below will provide you with comprehensive access to all the information 
and functions regarding configuring and checking communication connections.

● Connection display in the network view

● Connection table

● "Properties" tab for a connection in the inspector window
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Benefits
The information shown in these views are always up-to-date in terms of the current user 
actions. This means:

● The connection table displays all connections created.

● If you have selected a connection in the connection table:

– You will graphically see the connection path in the network view.

– The "Properties" tab in the Inspector window displays the parameters of this connection.

The connection table
The connection table offers the following functions:

● List of all connections in the project

● Selection of a connection and display of connections associated with it in the network view

● Changing of connection partners

● Display showing status information

"Properties" tab for a connection in the inspector window
The properties dialog has the following meaning:

● Display for connection parameters

● Display of connection path

● Subsequent specification of connections using the "Find connection path" button

Creating a new connection

Creating a connection - alternatives
You have the following options for creating a connection in the network view:

● Graphic connection configuration

● Interactive connection configuration

You'll find the individual steps for this in the following chapters.

Requirement and result
You have created the devices with CPUs and HMI devices between which you want to 
configure connections in the network view.
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Specifying a connection
If both partners for the connection type selected are networked on the same network, use the 
graphic or interactive selection of both communication partners to create a fully specified 
connection.

This connection is entered automatically into the connection table of the HMI device. A local 
connection name is assigned for this connection.

The following schematic shows a configured connection with a networked device:

Creating a new connection graphically

Graphically configuring connections
When using the graphic connection configuration, if necessary the system asks you to define 
the connection path. Select the devices to be connected in the current configuration.
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Automatically determining connection path
To create a connection graphically, follow these steps:

1. Click the "Connections" button.

The connection mode for the connection type you have selected is then activated.
You will see this from the following:
The devices that can be used for the connection type selected in your project are color-
highlighted in the network view.

2. Hold down the mouse button and drag the mouse pointer from the device from which the 
connection will originate to the device at which the connection ends.

3. Release the mouse button over the destination device to create the connection between 
the two devices.

Result
● A specified connection is created.

● The connection path is highlighted.

● The connection is entered in the connection table.

Interactively creating a new connection

Interactively configuring connections
Define the local device and its connection partners.
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Procedure
Proceed as follows to interactively create a connection:

1. Select the "Create new connection" command in the shortcut menu of a connection partner 
for which you want to create a connection.
The "Create new connection" dialog is opened. 

2. Select the partner endpoint.
In the right pane of the dialog, a possible connection path fitting the selected endpoint is 
displayed, if available. Incomplete paths, for example, for a non-specified CPU, are marked 
by an exclamation mark on a red background. 

3. To close the dialog, click "OK". 
To accept the configured connection and to configure additional connections to other 
endpoints, click "Apply".

Working in the network view

Highlighting connection path and partner in the network view
To display the connection partners for all or certain connection types in the network view, 
proceed as follows:

1. Click the "Connections" button.

2. Select the "Highlight connection partners" command in the shortcut menu for the HMI device 
whose connection partners you want to display in the network view.

3. Select "All connection partners" in the following menu.
The local device and the CPUs of the target devices are selected. The local connection 
partner shows an arrow pointing right and the remote connection partners show an arrow 
pointing left.

4. To open a list with information on the target devices, click the arrow of the local device. 
This additional function is useful in complex network configurations in which some devices 
are not visible.

 

 Note

You can display one of the connection partners which cannot be seen in the current display 
range of the network view. Click on the communication partner in the list that appears. Result: 
The display is moved such that the connection partner becomes visible.

 

 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
468 System Manual, 07/2013,  



See also
Creating a new connection graphically (Page 466)

Working with the connection table

Basic functions for tables
The connection table supports the following basic functions for editing a table:

● Changing column width

● Displaying the meaning of a column, a row or cell using tooltips.

Changing column width
To adjust the width of a column to the content so that all texts in the lines are legible, follow 
these steps:

1. Position the cursor in the header of the connection table to the right of the column that you 
want to optimize until the cursor changes its shape to two parallel lines (as if you wanted 
to change the width of the column by dragging it with the cursor).

2. Double click on this point.

or

1. Open the shortcut menu on the header of the table.

2. Click on

– "Optimize column width" or

– "Optimize width of all columns".

For columns that are too narrow, the complete content of specific fields is shown when you 
pause with the cursor on the respective field.

Show / hide columns
You can use the shortcut menu of the header of the connection table to control the display of 
the various table columns. The shortcut menu entry "Show/hide columns" provides you with 
an overview of the available columns. Use the check box to control whether columns are shown 
or hidden.

Using cursor keys to move within the connection table 
You can use the UP and DOWN cursor keys to select a connection from the connection table; 
the selected connection is marked and is shown highlighted in the network view.

Changing properties of connection
You can directly edit the parameters displayed in the connection table in some cases. To 
change the name of a connection, you do not have to navigate to the Inspector window. 
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Changing connection partners
You can change the connection partner of a connection as follows:

1. Select the connection.

2. Select the new connection partner from the open drop-down list in the "Partner" column.

Deleting connections
You can delete configured connections using the network view or the connection table.

In the network view you can delete one highlighted connection per action. In the connection 
table you can delete one or several connections per action.

Procedure
To delete a connection, follow these steps:

1. Select the connection to be deleted:

– In the network view: Select the connection to be deleted.

– In the connection table: Select the rows of the connections to be deleted (multiple 
selection possible).

2. Open the shortcut menu with a right mouse click.

3. Select the "Delete" command.

Result
The selected connection is removed completely.

Copying connections

Introduction
Connections are not copied singly but always in context along with the project or the device.

You can copy:

● Entire projects

● One or more devices within a project or from one project to another

Copying a project
When you copy a project all configured connections will also be copied. No settings whatsoever 
are required for the copied connections because the connections remain consistent.
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Copying devices
If you copy devices for which connections have been configured (HMI devices), the 
connections are copied as well. To complete the connection path, you must still finalize the 
networking. 

An S7-1200 CPU with a V.10 firmware is only a server for connections and has no connection 
configuration itself. Consequently, no connections are copied along with it when an S7-1200 
CPU with a V1.0 firmware is copied. 

Inconsistent connections - connections without assignment
With an inconsistent connection the structure of the connection data is destroyed or the 
connection is not functional in the project context. 

Inconsistent connections cannot be compiled and loaded - operation is not possible with such 
a connection. 

In the connection table inconsistent connections are marked in red.

Possible causes for inconsistent connections
● Deletion or change of the hardware configuration.

● Missing interface network links in the project, which are necessary for a connection.

● Connection resources are exceeded

● Errors when backing up data due to insufficient memory

● Connections to an unspecified connection partner without partner address information.

Detailed information regarding the reasons for the inconsistency can be found in the "Compile" 
tab following compilation (Edit > Compile). 

Remedies
If the connection cannot be repaired by opening the connection properties, changing them or 
undoing them in the configuration, then it may be necessary to delete the connection and re-
create it. 

HMI connection general settings

General connection parameters
General connection parameters are displayed in the "General" parameter group under the 
properties of the connection; these connection parameters identify the local connection end 
point.

Here, you can also assign the connection path and specify all aspects of the connection 
partner. 
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Special connection properties
Display of the connection properties (cannot be changed): 

● Active connection establishment
The connection establishment always starts from the HMI device. This option is selected 
by default if the address of the partner is specified.

● One-way
One-way means that the connection partner functions as a server on this connection and 
cannot send or receive actively.

● Sending operating mode messages
Not relevant for HMI devices. 

Address details
Displaying address details of the HMI connection. With an unspecified partner, the values for 
the rack and slot can be changed. All other values are obtained from the current configuration 
and cannot be changed. 

Miscellaneous
Display of the access points for the online connection between HMI device and connection 
partner. 

Using Open User Communication

Basics of Open User Communication

Introduction   
Open User Communication is the name given to a program-controlled communication process 
for communicating via the integrated PN/IE interface of the S7-1200/1500 and S7-300/400 
CPUs. Different connection types are available for this communication process.

The main feature of Open User Communication is its high degree of flexibility in terms of the 
data structures transferred. This allows open data exchange with any communicating devices 
providing they support the connection types available here. Since this communication is 
controlled solely by instructions in the user program, event-driven connection establishment 
and termination is possible. Connections can also be modified by the user program during 
runtime.

For CPUs with an integrated PN/IE interface, the TCP, UDP, and ISO-on-TCP connection 
types are available for Open User Communication. The communication partners can be two 
SIMATIC PLCs or a SIMATIC PLC and a suitable third-party device.
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Instructions for Open User Communication   
To create the connections, you have various instructions available after opening in the program 
editor in the "Instructions > Communication > Open User Communication" task card:

● Compact instructions for sending or receiving data via the integrated functions for 
establishing and terminating the connection (S7-1200/1500 only):

– TSEND_C (connection establishment/termination, sending)

– TRCV_C (connection establishment/termination, receiving)

● Individual instructions for sending and receiving data or for establishing or terminating 
connections:

– TCON (connection establishment)

– TDISCON (connection termination)

– TSEND (TCP or ISO-on-TCP: Sending)

– TRCV (TCP or ISO-on-TCP: Receiving)

– TUSEND (UDP: Sending)

– TURCV (UDP: Receiving)

Connection establishment   
For Open User Communication, instructions for establishing and terminating the connection 
must exist for both communication partners. One communication partner sends its data using 
TSEND, TUSEND or TSEND_C while the other communication partner receives the data using 
TRCV, TURCV or TRCV_C. 

One of the communication partners starts the connection establishment as the active partner. 
The other communication partner reacts by starting its connection establishment as the 
passive partner. If both communication partners have initiated their connection establishment, 
the communication connection is fully established.

Connection configuration     
You can specify establishment of the connection via a connection description DB with the 
TCON_Param, TCON_IP_v4, or TCON_IP_RFC structure by means of parameter assignment 
as follows:

● Manually create, assign parameters and write directly to the instruction.

● Supported by connection configuration.

Connection configuration supports the establishment of the connection and should, therefore, 
be given preference over the other methods.

You specify the following in the connection configuration:

● Connection partner

● Connection type

● Connection ID
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● Connection description DB

● Address details according to selected connection type

In addition, you specify here which communication partner activates the connection 
establishment and which partner establishes a connection passively in response to a request 
from its communication partner.

See also
Principle of operation of connection-oriented protocols (Page 486)

Connection configuration

Overview of connection configuration

Introduction
You can find the connection configuration in the inspector window of the program editor if you 
want to program Open User Communication with the communication instructions TSEND_C, 
TRCV_C or TCON.

Connection configuration supports the flexible functionality of communication programming: 
The parameters entered for the connection configuration are stored in an automatically 
generated global DB derived from the TCON_Param, TCON_IP_v4 or TCON_IP_RFC 
structure. You can modify the connection parameters in this connection description DB.
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Structure of the connection configuration     
The connection configuration is made up of the following components:
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① Communication instruction for TCON, TSEND_C or TRCV_C
② "Configuration" tab in the "Properties" tab
③ Area navigation of the "Configuration" tab
④ General properties of the connection parameters
⑤ Address details of the connection parameters (for selected connection DBs)

"Configuration" tab
Enter the desired connection parameters in the "Configuration" tab. The area navigation of the 
"Configuration" tab includes the "Connection parameters" group. This group contains the 
connection configuration. Here, you can enter the parameters for the connections and the 
address details with system support. Here, you also connect the CONNECT (TCON, 
TSEND_C, TRCV_C) or ID (TCON, TSEND, TRCV, TUSEND, TURCV) block parameters of 
the selected communication instructions.

When all the required parameters are assigned, a check mark is set in front of the "Connection 
parameters" group in the area navigation.

 

 Note

The connection parameter assignment does not check whether the connection IDs and port 
numbers (TCP, UDP) or TSAPs (ISO-on-TCP, ISO) are unique. When you configure Open 
User Communication, you should, therefore, make sure that the parameter settings are 
unique within a device.

 

See also
Connection parameters with structure according to TCON_Param (Page 488)

Connection parameters with structure according to TCON_IP_v4 (Page 491)

Connection parameters with structure according to TCON_IP_RFC (Page 492)
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Description of the connection parameters

Overview     
The following table shows the general connection parameters:

Parameter Description
End point The names of the local end point and the partner end point are shown.

The local end point is the CPU for which TCON, TSEND_C or TRCV_C is programmed. The 
local end point is, therefore, always known.
The partner end point is selected from the drop-down list. The drop-down list shows all 
available possible connection partners including unspecified connection partners for devices 
whose data is unknown in the project.
For S7-1500, broadcast can be selected as the partner end point (message to all subnet 
devices). For S7-1500 CPs/CMs, multicast can also be selected as the partner end point 
(message to a group within the subnet). The connection type is converted automatically to 
UDP in this case.
As long as no connection partner is set, all other parameters in the mask are disabled.

Interface The interface of the local end point is displayed. If multiple interfaces are available, e.g., by 
means of CPs or CMs, the interface can be selected from the drop-down list. To display or 
select the partner interface, a specified partner end point must first be selected.

Subnet The subnet of the local end point is displayed, provided this exists. The partner subnet is 
displayed only after the partner end point has been selected.
If at least one of the two connection partners is not connected with a subnet, the two 
connection partners are connected with each other.
A connection between partners in different subnets is only possible with IP routing. The 
routing settings can be edited in the relevant interface properties.

Address The IP address of the local end point is displayed. The IP address of the partner is displayed 
only after the partner end point has been selected.
If you have selected an unspecified connection partner, the input box is empty and has a red 
background. In this case, you need to specify a valid IP address.
Broadcast (S7-1500 only): If "Broadcast" is set as the partner end point, a non-editable IP 
address with host address 255 is entered automatically for the connection partner. The 
network allocation corresponds to that of the sender. Example: Local IP address 192.168.0.1, 
partner IP address 192.168.0.255.
Multicast (S7-1500 CPs/CMs only): If "Multicast" is set as the partner end point, the editable 
IP address 224.0.1.0 is entered automatically for the connection partner.

Connection type Select the connection type you want to use from the "Connection type" drop-down list:
● TCP
● ISO-on-TCP
● UDP
With the S7-1500, you can also select the ISO connection type at the configuration type of 
the configured connections for TSEND_C and TRCV_C.
The connection types can only be used for partners that support the corresponding protocol.
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Parameter Description
Connection type
(for S7-1500 only)

With the S7-1500, two different configuration types can be set for TSEND_C and TRCV_C:
● Programmed connections use program blocks for the connection description.
● Configured connections are created directly after the option selection, provided there is 

not already an appropriate connection. You can also use the configured connection to 
select the connection type ISO.

The specified configuration method depends on the selected connection type. If both 
configuration methods are possible, the programmed connection is preset.
The same configuration method must be set for both connection partners.

Connection ID Enter the connection ID in the input box. You can change the connection ID in the input boxes 
or enter it directly in TCON.
Ensure that the connection ID assigned is unique within the device.

Connection data The names of the connection description DBs for the connection description structured 
according to TCON_Param, TCON_IP_v4 or TCON_IP_RFC are displayed in the drop-down 
lists.
The drop-down list is still empty after selection of a connection partner. You can use the drop-
down list to generate a new data block or to select an existing data block. This data block is 
filled automatically with the values from the connection configuration. The name of the 
selected data blocks is entered automatically in the CONNECT block parameter of the 
selected TSEND_C, TRCV_C or TCON instruction.
From the drop-down list, you can also reference another valid data block. If a DB is referenced 
using the CONNECT input parameter of the TSEND_C, TRCV_C or TCON extended 
instruction and this does not correspond to the structure of a TCON_Param, TCON_IP_v4 or 
TCON_IP_RFC, the drop-down list is shown with no content on a red background.

Connection name
(for S7-1500 only)

If the connection type of the configured connections is set for TSEND_C and TRCV_C for the 
S7-1500, the "Connection data" parameter is replaced with the "Connection name" 
parameter. The name of the configured connection serves here as the connection data.
The drop-down list is still empty after selection of a connection partner. You can use the drop-
down list to generate a new connection or to select an existing connection. If needed, a data 
block is created and automatically filled with the values from the connection configuration. 
The name of the data block is entered automatically in the CONNECT block parameter of the 
TSEND_C or TRCV_C instruction.
You can also reference an existing connection from the drop-down list.

Active connection 
establishment

Use the "Active connection establishment" check box to specify the active partner of the Open 
User Communication (only with TCP and ISO-on-TCP).

Port
(only with TCP and UDP)

Address component for a TCP or UDP connection. The default after creating a new TCP 
connection is 2000.
You can change the port numbers. 
The port numbers must be unique on the device!

TSAP
(ISO-on-TCP only)

Address component for an ISO-on-TCP connection. The default value after creating a new 
ISO-on-TCP connection is E0.01.49.53.4F.6F.6E.54.43.50.2D.31 (S7-1200/1500) or 
E0.02.49.53.4F.6F.6E.54.43.50.2D.31 (S7-300/400). 
You can enter the TSAP-ID with an extension or as an ASCII TSAP. 
The TSAPs must be unique on the device!
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 Note
UDP connection for the "Broadcast" setting (S7-300/400/1200)

The parameters of the UDP connection for the "Broadcast" setting for the partner end point 
are stored in a connection description DB TCON_IP_v4 : With respect to UDP communication 
with TCON and TUSEND/TURCV , the TCON_IP_v4 is not filled with any partner parameters 
(value=0). However, the partner address and the partner port are necessary for sending the 
data and must be entered by the user in the TADDR_Param . The TADDR_Param for UDP 
communication is referenced by the TUSEND-/TURCV block parameter ADDR . The values 
for both parameters can be taken from the connection configuration.

The configuration must also be adapted for the other recipients of UDP communication. In 
order to receive broadcast frames, the partner port must be configured at the receiver end. 
For this purpose, the RemotePort parameter of the TADDR_Param must be filled at the ADDR 
block.

 

 Note
Communication via TSEND_C and TRCV_C (S7-1500)

When TSEND_C and TRCV_C are used, a separate TSEND_C and TRCV_C block pair with 
a configured connection is required for each communication. Multiple TSEND_C and 
TRCV_C block pairs cannot simultaneously use the same configured connection for 
communication.

Additional connections for a TSEND_C or TRCV_C instruction can be created in the inspector 
window for the connection parameters using the appropriate button next to the connection 
data.

The connections configured using TSEND_C and TRCV_C are displayed in a connection 
table in the inspector window under "Properties > Configuration > Overview of configured 
connections" when the TSEND_C or TRCV_C block is selected.

 

See also
Assignment of port numbers (Page 493)

TSAP structure (Page 496)

Examples of TSAP assignment (Page 498)

Ability to read back connection description parameters (Page 494)

Creating and assigning parameters to connections (Page 482)

Connection parameters with structure according to TCON_Param (Page 488)

Connection parameters with structure according to TCON_IP_v4 (Page 491)

Connection parameters with structure according to TCON_IP_RFC (Page 492)
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Starting connection parameter assignment
The connection configuration for Open User Communication is enabled as soon as a TCON, 
TSEND_C or TRCV_C instruction for communication is selected in a program block.

Requirement
● Your project must contain at least one S7-CPU.

● The program editor is open.

● A network is available.

Procedure     
To insert the extended instructions for Open User Communication, proceed as follows:

1. Open the task card, pane and folder "Instructions > Communication > Open User 
Communication".

2. Drag one of the following instructions to a network:

– TSEND_C

– TRCV_C

– TCON

The "Call options" dialog opens.

3. Edit the properties of the instance DB in the "Call properties" dialog. You have the following 
options:

– Change the default name.

– Select the "Manual" check box to assign your own number.

– You can also execute the DB as a multi-instance for function blocks.

4. Click "OK" to complete your entry.

Result
A corresponding instance DB is created at a single instance for the inserted instruction 
TSEND_C, TRCV_C or TCON. In the case of a multi-instance, the instance DB of the function 
block is used.

With TSEND_C, TRCV_C or TCON selected, you will see the "Configuration" tab under 
"Properties" in the Inspector window. The "Connection parameters" group in area navigation 
contains the connection parameter assignment that you can now make.

See also
Creating and assigning parameters to connections (Page 482)
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Creating and assigning parameters to connections
In the connection configuration for Open User Communication, you can create and configure 
connections of the TCP, UDP or ISO-on-TCP type.

Requirement
A CPU exists with a TCON, TSEND_C or TRCV_C communication instruction.

Procedure     
To create a connection for Open User Communication, follow these steps:

1. Select a TCON, TSEND_C or TRCV_C block of Open User Communication in the program 
editor.

2. Open the "Properties > Configuration" tab in the inspector window.

3. Select the "Connection parameters" group. Until you select a connection partner, only the 
empty drop-down list for the partner end point is enabled. All other input options are 
disabled.
The connection parameters already known are displayed:

– Name of the local end point

– Interface of the local end point

– IP address of the local end point

4. In the drop-down list box of the partner end point, select a connection partner. You can 
select an unspecified device or a CPU in the project as the communication partner. Certain 
connection parameters are then entered automatically.
The following parameters are set:

– Name of the partner end point

– Interface of the partner end point

– IP address of the partner end point

If the connection partners are networked, the name of the subnet is displayed.

5. With the S7-1500, in the "Configuration type" drop-down list, you choose between using 
program blocks or configured connections. 
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6. Select an existing connection description DB in the "Connection data" drop-down list or for 
configured connections select an existing connection under "Connection name". You can 
also create a new connection description DB or a new configured connection. Later, you 
can still select other connection description DBs or configured connections or change the 
names of the connection description DBs in order to create new data blocks:

– You can also see the selected data block at the interconnection of the CONNECT input 
parameter of the selected TCON, TSEND_C or TRCV_C instruction.

– If you have already specified a connection description DB for the connection partner 
using the CONNECT parameter of the TCON, TSEND_C or TRCV_C instruction, you 
can either use this DB or create a new DB.

– If you edit the name of the displayed data block in the drop-down list, a new data block 
with the changed name but with the same structure and content is generated and used 
for the connection.

– Changed names of a data block must be unique in the context of the communication 
partner.

– A connection description DB must have the structure TCON_Param, TCON_IP_v4 or 
TCON_IP_RFC, depending on CPU type and connection.

– A data block cannot be selected for an unspecified partner.

Additional values are determined and entered after the selection or creation of the 
connection description DB or configured connection. 
The following is valid for specified connection partners:

– ISO-on-TCP connection type

– Connection ID with default of 1

– Active connection establishment by local partner

– TSAP ID 
for S7-1200/1500: E0.01.49.53.4F.6F.6E.54.43.50.2D.31
for S7-300/400: E0.02.49.53.4F.6F.6E.54.43.50.2D.31

The following is valid for unspecified connection partners:

– TCP connection type

– Partner port 2000

The following applies for a configured connection with a specified connection partner:

– TCP connection type

– Connection ID with default of 257

– Active connection establishment by local partner

– Partner port 2000

The following applies for a configured connection with an unspecified connection partner:

– TCP connection type

– Local port 2000
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7. Enter a connection ID as needed for the connection partner. No connection ID can be 
assigned to an unspecified partner.

 

  Note

You must enter a unique value for the connection ID at a known connection partner. The 
uniqueness of the connection ID is not be checked by the connection parameter settings 
and there is no default value entered for the connection ID when you create a new 
connection.

 

8. Select the desired connection type in the relevant drop-down list. Default values are set for 
the address details depending on the connection type. You can choose between the 
following:

– TCP

– ISO-on-TCP 

– UDP

For configured connections with S7-1500, ISO applies in addition.

9. You can edit the input boxes in the address details. Depending on the selected protocol, 
you can edit the ports (for TCP and UDP) or the TSAPs (for ISO-on-TCP and ISO).

10.Use the "Active connection establishment" check box to set the connection establishment 
characteristics for TCP, ISO and ISO-on-TCP. You can decide which communication 
partner establishes the connection actively.

Changed values are checked immediately for input errors by the connection configuration and 
entered in the data block for the connection description.

 

 Note

Open User Communication between two communication partners can only work when the 
program section for the partner end point has been downloaded to the hardware. To achieve 
fully functional communication, make sure that you load not only the connection description 
of the local CPU on the device but also that of the partner CPU as well.

 

See also
Description of the connection parameters (Page 478)

Starting connection parameter assignment (Page 481)

TSAP structure (Page 496)

Assignment of port numbers (Page 493)

Connection parameters with structure according to TCON_Param (Page 488)

Connection parameters with structure according to TCON_IP_v4 (Page 491)

Connection parameters with structure according to TCON_IP_RFC (Page 492)
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Deleting connections

Introduction
The data of a created connection for Open User Communication is stored in a connection 
description DB. You can delete the connection by deleting the data block containing the 
connection description.

Requirement
You have created an Open User Communication connection.

Procedure     
To delete a connection, follow these steps:

1. Select a communication partner for Open User Communication in the project tree.

2. Open the "Program blocks > System blocks > Program resources" folder below the selected 
communication partner.

3. Select the "Delete" command from the shortcut menu of the data block with the connection 
parameter assignment.

 

 Note

If you are not certain which block to delete, open the extended instruction TCON, TSEND_C 
or TRCV_C. You will find the name of the data block as the CONNECT input parameter or 
in the connection parameter assignment as the "Connection data" parameter.

If you only delete the instance DBs of the extended instructions TCON, TSEND_C or 
TRCV_C, the assigned connections are not deleted as well.

 

 Note

If the connection DB is still being used by other blocks of the extended instructions, then the 
corresponding calls, their instance DBs, and, if present, the combination blocks TSEND_C 
and TRCV_C must also be deleted from the block folder, provided they are not used 
elsewhere.

This action prevents the program from being inconsistent.
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Result
You have deleted the connection.

 

 Note

Insert an extended instruction TCON, TSEND_C, or TRCV_C again in order to reference an 
existing connection description with the TCON_Param, TCON_IP_v4, or TCON_IP_RFC 
structure again via the "Connection data" parameter. 

 

How protocols work

Principle of operation of connection-oriented protocols

Introduction   
Connection-oriented protocols establish a logical connection to the communication partner 
before data transmission is started. After the data transmission is complete, they then terminate 
the connection, if necessary. Connection-oriented protocols are used especially when reliable 
data transmission is important. Several logical connections can exist over one physical line. 

Open User Communication supports the following connection types: 

● TCP

● ISO-on-TCP

● ISO (S7-1500 only)

● UDP

Both communication partners must support the same connection type for a connection. If a 
communication partner does not support a connection of the type ISO-on-TCP, for example, 
use the connection type TCP instead, if it is supported.

For communication partners that cannot be configured in the TIA Portal, such as third-party 
devices or PCs, enter "unspecified" for the partner end point during connection parameter 
assignment. The required connection type for unspecified devices is listed in the respective 
documentation.

 
 

 Note
Connections with ISO

For S7-1500 CPUs, configured connections of the type ISO can be created using the 
TSEND_C and TRCV_C instructions. For additional information on these connection types, 
refer to the general connection descriptions.
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Characteristics of TCP   
TCP is a streaming protocol in which the length of the data stream is transmitted to the receiver 
so that it can receive the data stream as individual TCP segments. This means no information 
about the start and end of a message is transmitted during data transmission via a TCP 
connection. The receiver cannot determine by the received segments of the data stream where 
one message in the data stream ends and the next one begins. It is therefore recommended 
that the number bytes to be received (parameter LEN, instruction TRCV/TRCV_C) be assigned 
the same value as the number of bytes to be sent (parameter LEN, instruction TSEND/
TSEND_C).

If the length of the sent data and the length of the expected data do not match, the following 
occurs:

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies the received data to the specified receive area (parameter DATA) 
only after the assigned length is reached. When the assigned length is reached, data of 
the subsequent job are already being received. As a result, the receive area contains data 
from two different send jobs. If you do not know the exact length of the first message, you 
are unable to recognize the end of the first message and the start of the second message.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies the number of bytes you specified in the LEN parameter to the 
receive data area (parameter DATA). Then, it sets the NDR status parameter to TRUE (job 
completed successfully) and assigns RCVD_LEN (amount of data actually received) the 
value of LEN. With each subsequent call, you receive a further block of the sent data.

A receive area with fixed data length can be specified in the TRCV/TRCV_C instructions with 
the protocol version of the Ad-hoc mode.

Characteristics of ISO-on-TCP   
 ISO-on-TCP is a message-oriented protocol which detects the end of the message at the 
receiver end and indicates the data that belongs to the message to the user. This does not 
depend on the specified reception length of the message. This means that information 
regarding the length and the end of a message is included during data transmission via an 
ISO-on-TCP connection.

If the length of the sent data and the length of the expected data do not match, the following 
occurs:

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies all the sent data to the receive data area (parameter DATA). Then, 
it sets the NDR status parameter to TRUE (job completed successfully) and assigns 
RCVD_LEN (amount of data actually received) the length of the data sent.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C does not copy any data to the receive data area (parameter DATA), but 
instead supplies the following error information: ERROR=1, STATUS=W#16#8088 
(destination buffer too small).
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Characteristics of UDP   
UDP is a message-oriented protocol which detects the end of the message at the receiver end 
and indicates the data that belongs to the message to the user. This does not depend on the 
specified reception length of the message. This means that information on the length and the 
end of a message is included during data transmission via a UDP connection.

If the length of the sent data and the length of the expected data do not match, the following 
occurs:

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TUSEND/TSEND_C):
TURCV/TRCV_C copies all the sent data to the receive data area (DATA parameter). Then, 
it sets the NDR status parameter to TRUE (job completed successfully) and assigns 
RCVD_LEN (amount of data actually received) the length of the data sent.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TUSEND/TSEND_C):
TRCV/TRCV_C copies as much data to the receive data area (parameter DATA) as the 
LEN parameter requests. No further error message is generated. In this case, the user has 
to call a T_URCV again in order to receive the remaining bytes.

See also
Basics of Open User Communication (Page 472)

Connection parameters with structure according to TCON_Param

Data block for connection description     
A connection description DB with a structure according to TCON_Param is used for some 
S7-1200 CPUs when it comes to the assignment of parameters for TCP, UDP and ISO-on-
TCP communication connections. The fixed data structure of the TCON_Param contains all 
the parameters that are needed to establish the connection. The connection description DB is 
automatically created for a new connection by the connection configuration for Open User 
Communication when the TSEND_C, TRCV_C or TCON instruction is used.

The CONNECT connection parameter of the instance DBs for TSEND_C, TRCV_C or TCON 
contains a reference to the data block used.

Structure of the connection description according to TCON_Param       

Byte Parameter Data type Start value Description
0 … 1 block_length UINT 64 Length: 64 bytes (fixed) 
2 … 3 id CONN_OUC 1 Reference to this connection (value range: 1 to 4095).

You must specify the value of this parameter for the 
TSEND_C, TRCV_C or TCON instruction under ID. 
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Byte Parameter Data type Start value Description
4 connection_type USINT 17 Connection type: 

● 17: TCP
● 18: ISO-on-TCP
● 19: UDP

5 active_est BOOL TRUE Identifier for the type of connection establishment: FALSE 
always applies to UDP, since data can be sent and received 
via local ID.
The following is valid for TCP and ISO-on-TCP:
● FALSE: Passive connection establishment
● TRUE: Active connection establishment

6 local_device_id USINT 1 ID for the local PN/IE interface.
7 local_tsap_id_len USINT 0 Length of parameter local_tsap_id used, in bytes; possible 

values: 
● 0 or 2, if connection type = 17 (TCP)

Only the value 0 is permissible for the active side. 
● 2 to 16, if connection type = 18 (ISO-on-TCP)
● 2, if connection type = 19 (UDP)

8 rem_subnet_id_len USINT 0 This parameter is not used.
9 rem_staddr_len USINT 4 Length of address of partner end point, in bytes: 

● 0: unspecified, in other words, parameter rem_staddr is 
irrelevant.

● 4: valid IP address in the parameter rem_staddr 
(TCP and ISO-on-TCP only)

10 rem_tsap_id_len USINT 2 Length of parameter rem_tsap_id used, in bytes; possible 
values: 
● 0 or 2, if connection type = 17 (TCP)

Only the value 0 is permissible for the passive side. 
● 2 to 16, if connection type = 18 (ISO-on-TCP)
● 0, if connection type = 19 (UDP)

11 next_staddr_len USINT 0 This parameter is not used.
12 … 
27

local_tsap_id ARRAY 
[1..16] of 
BYTE 

- Local address component of connection: 
● TCP and UDP: local port no. (possible values: 1...49151; 

recommended values: 2000...5000);
local_tsap_id[1] = high byte of port no. in hexadecimal 
notation;
local_tsap_id[2] = low byte of port no. in hexadecimal 
notation;
local_tsap_id[3-16] = irrelevant 

● ISO-on-TCP: local TSAP-ID:
local_tsap_id[1] = B#16#E0;
local_tsap_id[2] = rack and slot of local end points (bits 0 
to 4: Slot number, bits 5 to 7: rack number);

local_tsap_id[3-16] = TSAP extension, optional 
Note: Make sure that every value of local_tsap_id is unique 
within the CPU. 
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Byte Parameter Data type Start value Description
28 … 
33

rem_subnet_id ARRAY 
[1..6] of 
USINT

- This parameter is not used. 

34 … 
39

rem_staddr ARRAY 
[1..6] of 
USINT 

- TCP and ISO-on-TCP only: IP address of the partner end 
point, for example, for 192.168.002.003: 
● rem_staddr[1] = 192
● rem_staddr[2] = 168
● rem_staddr[3] = 002
● rem_staddr[4] = 003
● rem_staddr[5-6]= irrelevant

40 … 
55

rem_tsap_id ARRAY 
[1..16] of 
BYTE 

- Partner address component of connection
● TCP: partner port no. (possible values: 1...49151; 

recommended values: 2000...5000);
rem_tsap_id[1] = high byte of port no. in hexadecimal 
notation;
rem_tsap_id[2] = low byte of port no. in hexadecimal 
notation;
rem_tsap_id[3-16] = irrelevant

● ISO-on-TCP: partner TSAP-ID:
rem_tsap_id[1] = B#16#E0; 
rem_tsap_id[2] = rack and slot of partner end point (bits 0 
to 4: Slot number, bits 5 to 7: rack number);
rem_tsap_id[3-16] = TSAP extension, optional

● UDP: This parameter is not used.
56 … 
61

next_staddr ARRAY 
[1..6] of 
BYTE 

- This parameter is not used.

62 … 
63

spare WORD W#16#0000 Reserved. 

 
 

 Note
TCON_Param for S7-1500 CPU

The connection description DB with the structure according to TCON_Param is also 
supported by S7-1500 CPUs for migration reasons. However, we recommend that you use 
the new structures TCON_IP_v4 and TCON_IP_RFC.
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See also
Principle of operation of connection-oriented protocols (Page 486)

Description of the connection parameters (Page 478)

Ability to read back connection description parameters (Page 494)

Overview of connection configuration (Page 474)

TSAP structure (Page 496)

Assignment of port numbers (Page 493)

Connection parameters with structure according to TCON_IP_v4

Data block for connection description 
A connection description DB with a structure according to TCON_IP_v4 is used for CPUs of 
S7-1200 V4.0 and higher and S7-1500 to assign parameters for TCP and UDP communication 
connections. The fixed data structure of the TCON_IP_v4 contains all parameters that are 
required to establish the connection. The connection description DB is automatically created 
for a new connection by the connection configuration for Open User Communication when the 
TSEND_C, TRCV_C or TCON instruction is used.

The CONNECT connection parameter of the instance DBs for TSEND_C, TRCV_C or TCON 
contains a reference to the data block used.

Structure of the connection description according to TCON_IP_v4 

Byte Parameter Data type Start value Description
0 … 1 interface_id HW_ANY 64 Hardware identifier of the local interface (value range: 0 to 

65535).
 

2 … 3 id CONN_OUC 1 Reference to this connection (value range: 1 to 4095).
You must specify the value of this parameter for the 
TSEND_C, TRCV_C or TCON instruction under ID. 

4 connection_type BYTE 11 Connection type: 
● 11: TCP
● 13: UDP

5 active_established BOOL TRUE Identifier for the type of connection establishment:
● FALSE: Passive connection establishment
● TRUE: Active connection establishment

6 … 9 remote_address ARRAY 
[1..4] of 
BYTE

- IP address of the partner end point, for example, for 
192.168.0.1: 
● addr[1] = 192
● addr[2] = 168
● addr[3] = 0
● addr[4] = 1
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Byte Parameter Data type Start value Description
10 … 
11

remote_port UINT 2000 Port address of the remote connection partner (value range: 
1 to 49151).

12 … 
13

local_port UINT 2000 Port address of the local connection partner (value range: 1 
to 49151).

See also
Principle of operation of connection-oriented protocols (Page 486)

Description of the connection parameters (Page 478)

Ability to read back connection description parameters (Page 494)

Overview of connection configuration (Page 474)

Assignment of port numbers (Page 493)

Connection parameters with structure according to TCON_IP_RFC

Data block for connection description 
A connection description DB with a structure according to TCON_IP_RFC is used for CPUs of 
S7-1200 V4.0 and higher and S7-1500 to assign parameters to ISO-on-TCP communication 
connections. The fixed data structure of the TCON_IP_RFC contains all parameters that are 
required to establish the connection. The connection description DB is automatically created 
for a new connection by the connection configuration for Open User Communication when the 
TSEND_C, TRCV_C or TCON instruction is used.

The CONNECT connection parameter of the instance DBs for TSEND_C, TRCV_C or TCON 
contains a reference to the data block used.

Structure of the connection description according to TCON_IP_RFC 

Byte Parameter Data type Start value Description
0 … 1 interface_id HW_ANY 64 Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 id CONN_OUC 1 Reference to this connection (value range: 1 to 4095).

You must specify the value of this parameter for the 
TSEND_C, TRCV_C or TCON instruction under ID. 

4 connection_type BYTE 12 Connection type: ISO-on-TCP
5 active_established BOOL TRUE Identifier for the type of connection establishment:

● FALSE: Passive connection establishment
● TRUE: Active connection establishment
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Byte Parameter Data type Start value Description
8 … 
11

remote_address ARRAY 
[1..4] of 
BYTE

- IP address of the partner end point, for example, for 
192.168.0.1: 
● addr[1] = 192
● addr[2] = 168
● addr[3] = 0
● addr[4] = 1

12 … 
45

remote_tselector TSelector - TSelector of the remote connection partner:
● TSelLength = Value range 0 to 32 as UINT
● TSel[1-32] = Value range each 0 to 255 in bytes

46 … 
79

local_tselector TSelector - TSelector of the local connection partner:
● TSelLength = Value range 0 to 32 as UINT
● TSel[1-32] = Value range each 0 to 255 in bytes

See also
Principle of operation of connection-oriented protocols (Page 486)

Description of the connection parameters (Page 478)

Ability to read back connection description parameters (Page 494)

Overview of connection configuration (Page 474)

TSAP structure (Page 496)

Assignment of port numbers

Introduction
When an Open User Communication is created, the value 2000 is automatically assigned as 
the port number.

Permissible values for port numbers are 1 to 49151. You can assign any port number within 
this range. However, because some ports may already be used depending on the system, port 
numbers within the range from 2000 to 5000 are recommended.

 

 Note

Port numbers must be unique. The connection configuration or a corresponding block call is 
rejected with an error if the port numbers are assigned twice. 
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Overview of port numbers 
The following table summarizes the system reactions to various port numbers.

Port no. Description System reaction
2000 … 5000 Recommended range No warning, no error message on entry

Port number is permitted and accepted
1 … 1999, 5001 … 49151 Can be used, but is outside the 

recommended range
Warning message on entry
Port number is permitted and accepted

0, 20, 21, 25, 80, 102, 135, 161, 34962 
… 34964

Can be used conditionally*

53, 80, 102, 135, 161, 162, 443, 520, 
9001, 34962 … 34964

Can be used conditionally**

* Ports defined for specific functions:
0: ANY - Port number is automatically assigned by S7-1500 CPU as value (>49151)
20: FTP data transmission
21: FTP control
25: TMAIL_C (Simple Mail transfer protocol)
80: Web server
102: ISO-on-TCP (RFC1006)
135: DCE Endpoint Mapper for PROFINET
161: SNMP (Simple Network Management Protocol)
34962 ... 34964: PROFINET

 

 Note

The user usually specifies the value 0 for the local port on the active connection end point 
for UDP/TCP. In this case, the CPU operating system selects the next available port above 
49151. The partner port usually has the default 0 with the passive connection end point. The 
corresponding parameter is disabled in the connection configuration.

 

** These ports are disabled depending on the function scope of the CPU in use. The 
documentation of the respective CPUs provides the assignment of these ports.

See also
Description of the connection parameters (Page 478)

Creating and assigning parameters to connections (Page 482)

Ability to read back connection description parameters

Changing parameter values in the connection description   
The connection description for exactly one connection of the Open User Communication is 
entered from the connection configuration in the connection description DB.

You can change the parameter values of the connection description DB outside of the 
connection configuration in the user program. Connection description DBs containing values 
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you changed subsequently can be read back from the connection configuration. Under 
"Properties > Configuration > Connection parameters", the inspector window displays only the 
connection parameters stored in the connection description DB.

 

 Note

You can only change the values in the running user program if the instructions TCON, 
TSEND_C or TRCV_C are not being processed and the referenced connection is not 
established.

 

The connection configuration does not support nested entries of connection descriptions in 
DB types that can only be found via offset referencing (for example, Global-DB).

The structure of the connection description cannot be changed.

Ability to read back individual connection parameters   
For the "Address" parameter of the communication partner in a TCP or ISO-on-TCP 
connection, its IP address is displayed from the "rem_staddr" parameter of the connection 
description.

The following values can also be reloaded from the connection description:

● Connection type

● Local connection ID

● Active/passive connection establishment (only with UDP)

● Local TSAP (ISO-on-TCP only)

● Partner TSAP (ISO-on-TCP only)

● Local port (only with TCP and UDP)

● Partner port (only with TCP)

The values of the connection ID parameters of the communication partner, the connection 
data, as well as the connection establishment, are not included in the connection description 
in the local connection description DB. Consequently, these parameters cannot be displayed 
when the connection configuration is reopened. The connection establishment of the partner 
results from the local connection establishment and is therefore also displayed.

A new communication partner can be selected at any time in the "Partners" drop-down list box.

When a CPU recognized in the project is selected as a specified communication partner, the 
entry options for the connection ID and the connection data are shown again.

See also
Connection parameters with structure according to TCON_Param (Page 488)

Description of the connection parameters (Page 478)
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TSAP structure

Introduction   
For an ISO-on-TCP connection, Transport Service Access Points (TSAPs) must be assigned 
for both communication partners. TSAP IDs are assigned automatically after an ISO-on-TCP 
connection is created. To ensure the uniqueness of TSAP IDs within a device, you can change 
the preassigned TSAPs in the connection parameter assignment.

Structure of TSAPs     
You must comply with certain rules when assigning TSAPs. A TSAP must contain a certain 
number of bytes, which are able to be displayed and entered as hexadecimal values (TSAP-
ID) or as ASCII characters (ASCII-TSAP):

Entries or changes of the TSAP-ID or the ASCII-TSAP in the corresponding entry fields always 
take effect in the other display format as well.

If a TSAP contains no valid ASCII characters, the TSAP is displayed only as TSAP-ID and not 
as ASCII-TSAP. This is the case after a connection is created. The first two hex characters as 
TSAP-ID identify the communication type and the rack/slot. Because these characters are not 
valid ASCII characters for a CPU, the ASCII-TSAP is not displayed in this case.

In addition to the rules for length and structure of TSAPs, you must also ensure the uniqueness 
of the TSAP-ID. The assigned TSAPs are not automatically unique.
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Length and content of TSAPs
A TSAP is structured as follows:

● TSAP-ID with TSAP extension
Length = 2 to 16 bytes
x_tsap_id[0] = 0xE0 (Open User Communication)
x_tsap_id[1] (bits 0 to 4) = slot number of CPU
x_tsap_id[1] (bits 5 to 7) = rack number of CPU
x_tsap_id[2...15] = any characters (TSAP extension, optional)
(x = loc (local) or x = rem (partner))

● TSAP-ID as ASCII-TSAP
Length = 3 to 16 bytes
x_tsap_id[0 to 2] = 3 ASCII characters (0x20 to 0x7E)
x_tsap_id[3...15] = any characters (optional)
(x = loc (local) or x = rem (partner))

The following table shows the schematic structure of a TSAP-ID:

TSAP-ID tsap_id_len tsap_id[0] tsap_id[1] tsap_id[2..15] tsap_id[3..15]
...with extension 2...16 bytes 0xE0 0x01 or

0x02 or
0x00*

Extension
(optional)

Extension
(optional)

...as ASCII-TSAP 3...16 bytes 0x20...0x7E 0x20...0x7E 0x20...0x7 Any
(optional)

*An S7-1200/1500 CPU is normally inserted on rack 0 and slot 1, and an S7-300/400 CPU on 
rack 0 and slot 2. For this reason, hex value 01 or 02 is valid for the second position of the 
TSAP-ID with extension. If the connection partner is an unspecified CPU, for example, a third-
party device, the hex value 00 is also permissible for the slot address.

 

 Note

For unspecified communication partners, the local TSAP-ID and the partner TSAP-ID can 
have a length of 0 to 16 bytes, in which all hex values from 00 to FF are permitted.

 

ASCII code table for entry of ASCII TSAPs       
For entry of an ASCII-TSAP in the connection parameter assignment, only hexadecimal values 
from 20 to 7E are permitted:

Code ..0 ..1 ..2 ..3 ..4 ..5 ..6 ..7 ..8 ..9 ..A ..B ..C ..D ..E ..F
2..  ! " # $ % & ’ ( ) * + , - . /
3.. 0 1 2 3 4 5 6 7 8 9 : ; < = > ?
4.. @ A B C D E F G H I J K L M N O
5.. P Q R S T U V W X Y Z [ \ ] ^ _
6.. ` a b c d e f g h i j k l m n o
7.. p q r s t u v w x y z { | } ~  
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See also
Examples of TSAP assignment (Page 498)

Description of the connection parameters (Page 478)

Creating and assigning parameters to connections (Page 482)

Examples of TSAP assignment
The following examples show the processing of the TSAPs for CPUs of the S7-1200/1500 
(CPU on slot 1) under various points of view: 

● Example 1: Creating a new connection for PLC-PLC communication

● Example 2: Entry of a local ASCII-TSAP

● Example 3: Entry of a TSAP extension in the TSAP-ID

● Example 4: Incorrect editing of the TSAP-ID

● Example 5: Entry of an ASCII-TSAP via the "TSAP-ID" entry field

Example 1: Creating a new connection for PLC-PLC communication
Once you have created a new connection with two PLCs for the Open User Communication, 
the TSAP extension "ISOonTCP-1" is assigned automatically.

This TSAP extension produces the TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31, which is 
entered automatically in the connection description DB and in the entry fields of the local and 
the partner TSAP. The entry fields of the ASCII-TSAPs remain empty:

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

You can change the values in the entry fields of the TSAP-ID and the ASCII-TSAP at any time. 

The entry field of the TSAP-ID shows the complete TSAP stored in the data block of the 
connection description. The TSAP-ID with TSAP extension, which is limited to 16 characters, 
is not displayed in the "TSAP (ASCII)" entry field because the character E0 does not represent 
a valid character for the ASCII-TSAP.

If the displayed TSAP-ID is a valid ASCII-TSAP, it is displayed in the "TSAP (ASCII)" entry 
field.

Changes in the entry fields for TSAP-ID and ASCII-TSAP affect the other field.

Example 2: Entry of a local ASCII-TSAP
If you have created a new connection and assigned an ASCII value for the local TSAP in the 
"TSAP (ASCII)" entry field, for example, "ISOonTCP-1", the resulting TSAP-ID is created 
automatically.

When you exit the "TSAP (ASCII)" entry field, the number of ASCII characters is checked 
automatically for compliance with the limit (3 to 16 characters) and the resulting TSAP-ID is 
entered into the corresponding entry field:
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 Local TSAP Partner TSAP
TSAP (ASCII) ISOonTCP-1  
TSAP-ID 49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

Example 3: Entry of a TSAP extension in the TSAP-ID
If, following creation of a connection and entry of an ASCII-TSAP (see examples 1 and 2) in 
the entry field of the local TSAP-ID, you add the prefix "E0.01" to the TSAP value, the ASCII-
TSAP will no longer be displayed when the entry field is exited.

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

Once you have exited the entry field of the TSAP-ID, a check is performed automatically to 
determine whether the first character of the TSAP-ID is a valid ASCII character. Since the 
character "E0" now present in the TSAP-ID is not a valid character for the ASCII-TSAP, the 
"TSAP (ASCII)" entry field no longer displays an ASCII-TSAP.

If a valid ASCII character is used, the check for compliance with the length specification of 2 
to 16 characters follows.

Example 4: Incorrect editing of the TSAP-ID
If you remove the hex value "E0" from a TSAP-ID beginning with "E0.01", the TSAP-ID now 
begins with "01" and therefore no longer complies with the rules and is invalid:

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID 01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

After the entry field is exited, a message is output because the TSAP-ID is neither a valid ASCII-
TSAP (this would have to have a hex value in the range from 20 to 7E as the first value) or a 
valid TSAP-ID (this would have to have the identifier "E0" as the first value).

Example 5: Entry of an ASCII-TSAP via the "TSAP-ID" entry field
If you remove the value "01" in addition to the value "E0" from the incorrect TSAP-ID in example 
4, the TSAP-ID begins with the hex value 49. This value is within the permissible range for 
ASCII-TSAPs:

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID 49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

When you exit the entry field, the TSAP-ID is recognized as a valid ASCII-TSAP and the 
resulting ASCII-TSAP "ISOonTCP-1" is written to the "TSAP (ASCII)" entry field.
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See also
TSAP structure (Page 496)

Description of the connection parameters (Page 478)

Communication via PUT and GET instructions

Basic information on communication via the PUT/GET instruction

Basic information on PUT/GET instructions   
Use PUT and GET instructions to exchange data between two CPUs via an S7 connection.

The GET instruction is used to read data from a partner CPU. The PUT instruction is used to 
control the writing of tags by the communication partner via the user program. Apart from the 
PUT and GET instructions, no additional communication functions are provided for reading 
and writing tags.

To simplify the use of the two instructions, specify all required parameters for the connection 
and all block parameters in the Inspector window of the program editor.

Requirement   
To be able to use the PUT and GET instructions, the following requirements must be satisfied:

● At least one S7-1200/1500 CPU or S7-300/400 CPU must be created in the project. 
Firmware 2.0 or higher must be installed on an S7-1200 CPU. If you have not yet created 
a second CPU in the project, you can initially establish the connection to an unspecified 
partner.

● An S7 connection must exist between the two CPUs. If you have not yet established a 
connection between two CPUs, a connection is automatically established during the 
configuration of the instructions.

● For both instructions, an instance data block is required in which all data used by the 
instruction is stored. The instance data block is created automatically as soon as you drag 
a PUT or GET instruction to a network in the program editor. For the correct execution of 
the program, it is essential that the instance data blocks are not changed; consequently, 
these data blocks are know-how protected. You only have read access to the instance data 
blocks.

See also
Overview of connection configuration (Page 501)

Assigning parameters to start request (Page 506)

PUT: Set parameters for write and send area (Page 507)

GET: Set parameters for read and memory area (Page 508)
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Connection configuration

Overview of connection configuration

Introduction   
The connection parameters for the PUT and GET instructions are assigned in the inspector 
window of the program editor. All parameters are saved in the corresponding instance data 
block.
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Structure of the connection configuration
The connection configuration is made up of the following components:

① Communication instruction for PUT or GET
② Call of online and diagnostic functions
③ "Configuration" tab in the "Properties" tab
④ Area navigation of the "Configuration" tab
⑤ General properties of the connection parameters

Display of online and diagnostic functions
If you click the icon for starting the online and diagnostic functions, the associated CPU goes 
online automatically. The connection table in the network view is opened. In addition, the 
"Diagnostics" tab and the connection information are displayed in the inspector window.
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Entering the connection parameters
Enter the desired connection parameters in the "Configuration" tab. The area navigation of the 
"Configuration" tab includes the "Connection parameters" group. This group contains the 
connection configuration. Here, you can enter the parameters for the connections using system 
functions. When all the required parameters are assigned, a check mark is set behind the 
"Connection parameters" group in the area navigation.

See also
Assigning parameters to start request (Page 506)

PUT: Set parameters for write and send area (Page 507)

GET: Set parameters for read and memory area (Page 508)

Description of the connection parameters

Overview 
The following table shows the general connection parameters:

Parameter Description
End point The names of the local end point and the partner end point are shown.

● Local end point
The local end point is the CPU in which the PUT or GET instruction is programmed.

● Partner end point
The partner end point is selected from the drop-down list. The drop-down list shows all 
available possible connection partners including unspecified connection partners for 
devices whose data is unknown in the project.
As long as no connection partner is set, all other parameters in the mask are disabled.

Interface The interface of the partner CPU is displayed. The partner interface is not displayed until a 
specified partner CPU has been selected.

Interface type The type of interface via which communication is handled is displayed.
Subnet name The subnet of the local end point is displayed, provided this exists. The partner subnet is 

displayed only after the partner end point has been selected.
If at least one of the two connection partners is not connected with a subnet, the two 
connection partners are automatically connected with each other. The partner which is not 
connected to a network is hereby connected to the same subnet via which the other partner 
is already connected to a network.
A connection of connection partners to different subnets is only possible with IP or S7 routing. 
The IP routing settings can be edited in the relevant interface properties.

Address The IP address of the local end point is displayed. The IP address of the partner is displayed 
only after the partner end point has been selected.
If you have selected an unspecified connection partner, the input box is empty and has a red 
background. In this case, you will need to specify a valid IP address for the connection partner.

Connection ID The currently set connection ID is displayed. You can change the connection ID in the 
connection table in the network view. You can also directly access the connection table while 
you are setting the connection parameters. To do this, click the "Create new connection" icon.
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Parameter Description
Connection name The name of the connection which was automatically created when the PUT/GET instruction 

was inserted is displayed. You can change the name of the connection by entered a different 
name in the field. You can also create a new connection or edit existing connections by 
clicking the "Create new connection" icon.

Active connection 
establishment

Use the "Active connection establishment" option button to specify which partner starts the 
communication. When the connection is created, the local partner is initially specified by 
default for the establishment of the connection. If a device does not support active connection 
establishment, you have to activate active connection establishment on the other partner.

Configured at one end If this check box is selected, the connection partner is the server for this connection. It cannot 
actively send or receive. This corresponds to the behavior of the PUT/GET instructions. In 
this case, other instructions are not possible. If the check box is not selected, other 
instructions can also be used for the communication.

Starting connection parameter assignment
You can assign the connection parameters for PUT and GET in the inspector window as soon 
as you have inserted and selected a PUT or GET instruction in a program block.

Procedure     
To insert PUT/GET instructions, follow these steps:

1. Open the "Instructions" task card in the "Communication > S7 Communication" folder.

2. Drag a PUT or GET instruction to a network.
The "Call options" dialog opens.

3. Optional: Edit the properties of the instance DB in the "Call properties" dialog. You have 
the following options:

– Change the default name.

– Select the "Manual" check box to assign your own number.

4. Click "OK".

Result
A corresponding instance data block is created for the inserted PUT or GET instruction. For 
S7-300 CPUs, a function block is also created in the program resources.

When PUT or GET instruction is selected, you will see the "Configuration" tab under 
"Properties" in the inspector window. The "Connection parameters" group in area navigation 
contains the connection parameter assignment that you can now make.

See also
Creating and assigning parameters to connections (Page 505)

Deleting connections (Page 506)
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Creating and assigning parameters to connections
You can create S7 connections and assign the parameters for these in the connection 
parameter assignment of the PUT/GET instructions. Changed values are checked immediately 
by the connection parameter assignment for input errors.

Requirement
A CPU exists with a PUT or GET communication instruction.

Procedure  
To configure an S7 connection using PUT/GET instructions, follow these steps:

1. In the program editor, select the call of the PUT or GET instruction.

2. Open the "Properties > Configuration" tab in the inspector window.

3. Select the "Connection parameters" group. Until you select a connection partner, only the 
empty drop-down list for the partner end point is enabled. All other input options are 
disabled.
The connection parameters already known are displayed:

– Name of the local end point

– Interface of the local end point

– IP address of the local end point

4. In the drop-down list box of the partner end point, select a connection partner. You can 
select an unspecified device or a CPU in the project as the communications partner.
The following parameters are automatically entered as soon as you have selected the 
connection partner:

– Interface of the partner end point

– Interface of the partner end point. If several interfaces are available, you can change 
the interface as required.

– Interface type of the partner end point

– Subnet name of both end points

– IP address of the partner end point

– Name of the connection which is used for the communication. If no connection exists 
yet, it is automatically established.

5. If required, change the connection name in the "Connection name" input box. If you want 
to create a new connection or edit an existing connection, click on the "Create new 
connection" icon.

 

  Note

The PUT and GET instructions between two communication partners can only run if both 
the hardware configuration and the program part for the partner end point have been 
loaded into the hardware. To achieve fully functional communication, make sure that you 
load not only the connection description of the local CPU on the device but also that of 
the partner CPU as well.
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Deleting connections
A connection which was automatically created during the insertion of a PUT or GET instruction 
appears in the connection table of the network view like every standard connection. As a result, 
it can be deleted in the connection table. 

Procedure  
To delete a connection, follow these steps:

1. Open the connection table in the network view.

2. In the connection table, select the connection that you want to delete.

3. To do this, right-click the connection and select the "Delete" command from the shortcut 
menu.

Result
The connection is deleted. The PUT or GET instruction and the associated instance data blocks 
are retained and must be manually deleted if necessary.

To continue using the PUT or GET instruction, you must configure the connection again in the 
inspector window of the program editor, since all connection parameters were also deleted 
when the connection was deleted. In this case, specify a new communication partner and a 
suitable connection. 

Block parameter assignment

Assigning parameters to start request
To start communication via the PUT or GET instruction, you have to specify an event which 
activates the instruction. This event is referred to as control parameter (REQ). The 
communication job is activated as soon as there is a positive edge at the control parameter 
REQ.

Please note that the control parameter REQ is assigned the default FALSE at first call.

Requirement
● The program editor is open.

● You have already inserted a PUT or GET instruction.

● A connection has been established between two communication partners.

Procedure
To define the REQ control parameter, follow these steps:

1. Select the PUT or GET instruction in the program editor.

2. Open the "Configuration" tab in the inspector window.
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3. Select the "Block parameter assignment" entry in the area navigation.

4. In the "REQ" field, select a tag of the "BOOL" data type to initialize the execution of the 
instruction. Alternatively, you can also interconnect a previous instruction in the program 
editor.

See also
PUT: Set parameters for write and send area (Page 507)

GET: Set parameters for read and memory area (Page 508)

PUT: Set parameters for write and send area
For communication via the PUT instruction, you must specify the memory area of the partner 
CPU to which the data should be written. In addition, you must specify the memory area of the 
local CPU from which the data is to be read.

Requirement
● The program editor is open.

● You have already inserted a PUT instruction.

● A connection has been established between two communication partners.

Procedure
To specify the read and the memory area for the instruction, follow these steps:

1. Select the PUT instruction in the program editor.

2. Open the "Configuration" tab in the inspector window.

3. Select the "Block parameter assignment" entry in the area navigation.

4. In the "In/Outputs > Write area (ADDR_1) > Start" field, select a "REMOTE" data type 
pointer to the area of the partner CPU which is to be written.
Only absolute addressing is permitted.
Example: P#DB10.DBX5.0 Byte 10

5. In the "Length" field, enter the length of the write area and select the data type of the memory 
area from the drop-down list.

6. In the "In/Outputs > Send area (SD_1) > Start" field, select a pointer to the area in the local 
CPU which contains the data to be sent.

7. In the Length field, enter the length of the memory area to be read and select the data type 
from the drop-down list.
Only the data types BOOL (for a bit array, "0" must be used as address and an integer 
multiple of byte must be used as length), BYTE, CHAR, WORD, INT, DWORD, DINT, REAL, 
COUNTER, TIMER are permitted.
If the VARIANT pointer accesses a DB, the DB must always be specified (for example: 
P#DB10.DBX5.0 Byte 10).
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See also
GET: Set parameters for read and memory area (Page 508)

GET: Set parameters for read and memory area
For communication via the GET instruction, you must specify the memory area of the local 
CPU to which the data should be written. In addition, you must specify the memory area of the 
partner CPU from which the data is to be read.

Requirement
● The program editor is open.

● You have already inserted a GET instruction.

● A connection has been established between two communication partners.

Procedure
To specify the read and the memory area for the instruction, follow these steps:

1. Select the GET instruction in the program editor.

2. Open the "Configuration" tab in the inspector window.

3. Select the "Block parameter assignment" entry in the area navigation.

4. In the "In/Outputs > Read area (ADDR_1) > Start" field, select a "REMOTE" data type 
pointer to the area of the partner CPU which is to be read.
Only absolute addressing is permitted.
Example: P#DB10.DBX5.0 Byte 10

5. In the "Length" field, enter the length of the read area and select the data type of the memory 
area from the drop-down list.

6. In the "In/Outputs > Memory area (RD_1) > Start" field, select a pointer to the area in the 
local CPU in which the read data is to be stored.

7. In the Length field, enter the length of the memory area and select the data type from the 
drop-down list.
Only the data types BOOL (for a bit array, "0" must be used as address and an integer 
multiple of byte must be used as length), BYTE, CHAR, WORD, INT, DWORD, DINT, REAL, 
COUNTER, TIMER are permitted.

See also
PUT: Set parameters for write and send area (Page 507)

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
508 System Manual, 07/2013,  



8.1.3.3 Displaying and configuring topology

Overview of the topology view

Functions of the topology view   
The topology view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Displaying the Ethernet topology

– Displaying all the PROFINET devices and passive Ethernet components of the project 
along with their ports

– Displaying interconnections between the ports

– Displaying corresponding logical networks

– Display diagnostic information of all ports

● Configuring the Ethernet topology

– Creating, modifying and deleting interconnections of the ports

– Renaming stations, devices, interfaces or ports

– Adding PROFINET devices and passive Ethernet components to the project from the 
hardware catalog

● Identifying and minimizing differences between the desired and actual topology

– Running an offline/online comparison of Ethernet modules, ports and port 
interconnections

– Adopting existing online topology information in the offline project

Differences between network view and topology view   
● The network view shows all the logical subnets of the project.

The topology view shows all Ethernet components of the project. These include passive 
components such as switches, media converters and cables.

 

  Note

Stations with non-Ethernet components are also displayed if the station has a least one 
Ethernet component.

 

● The position of a device in the network view and its position in the topology view are not 
dependent on each other; in other words, the same device generally appears at different 
locations in the two views.

● If you open the hardware catalog in the topology view, you only see devices with an Ethernet 
interface.
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Structure of the topology view
The topology view (Page 396) essentially consists of a graphic area (called the graphic view 
below) and a table area (called the table view below).

Which functions are there in the graphic view and which functions are there in the table view?
● Displaying the Ethernet topology

Function Graphic view Table view
Displaying all the PROFINET devices and passive Ethernet 
components of the project along with their ports

yes yes

Display interconnections between the ports (including type of 
medium)

yes yes

Displaying corresponding logical networks no yes
Displaying properties of the cables between the ports no yes
Display diagnostic information of all ports yes yes

● Configuring the Ethernet topology

Function Graphic view Table view
Creating, modifying and deleting interconnections of the ports ● Create: yes

● Modify: no
● Delete: yes

● Create: yes
● Modify: yes
● Delete: yes

Renaming stations, devices, interfaces or ports no yes
Adding PROFINET devices and passive Ethernet components to 
the project from the hardware catalog

yes no

● Identifying and minimizing differences between the desired and actual topology

Function Graphic view Table view
Running an offline/online comparison of Ethernet modules, ports 
and port interconnections

no yes

Adopting existing online topology information in the offline project no yes

Starting the topology view

Requirement
The device or network view is open in the hardware and network editor.

Procedure
To start the topology view of your project, follow these steps:  

1. Click on the "Topology view" tab.

Or:
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1. Open the network view of the hardware editor.

2. Select a PROFINET device or a PROFINET module.

3. Select the "Go to topology view" command in the shortcut menu.

Result
The graphic view of the topology view is started. If you opened the topology view using the 
shortcut menu, the selected component remains selected after the change of view.

Displaying topology

Displaying the graphic view of the configured topology

What is shown?   
The graphic view of the configured topology shows the following:

● Configured PROFINET devices and passive Ethernet components along with their ports

● Configured stations with non-Ethernet components if there is at least one Ethernet 
component in the station

● Configured interconnections between the ports

Type of display
The way in which the graphic view of the topology view and the network view are displayed is 
very similar:

● Compared with the device view, components are shown in a simplified form.

● The interconnections between ports are shown as horizontal and vertical lines. These are 
dashed when an interconnection between a tool changer port and its possible partner ports 
is involved.
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Displaying the table view of the configured topology

What is shown?   
The table view of the configured topology shows exactly the same content as the graphic view 
except for the logical PROFINET subnets.

● All the configured PROFINET devices and passive Ethernet components along with their 
ports

● All the configured stations with non-Ethernet components if there is at least one Ethernet 
component in the station

● Configured interconnections between the ports
For each port with the "Alternating partner port" property, there are as many completed 
rows as there are potential partner ports plus one empty row.

Type of display
As the name implies, the table view of the topology view consists of a table, the topology 
overview table. It is structured like the network overview table. It consists of the following 
columns:

● Device / port
This is the most important column of the table. The entries in this column have a hierarchical 
structure with the PROFINET ports being the last element in the hierarchy. You can expand 
and collapse the hierarchical entries. For a CPU, for example, an entry consists of the 
following elements:

– Station name

– Device name

– Name of the PROFINET interface

– Names of the ports

Note: All the other columns only have entries in the rows containing the port names.

● Type (as default, this column is not displayed)
Shows what type of station, device or interface the table row relates to or whether it belongs 
to a port.

● Order no. (as default, this column is not displayed)
Order no. of device

● Subnet (as default, this column is not displayed)
Configured subnet to which the interface belongs

● Master / IO system (as default, this column is not displayed)
Shows whether or not the interface belongs to a PROFIBUS DP master system or a 
PROFINET IO system.

● Device address (as default, this column is not displayed)
Configured address of the interface in the subnet

● Partner station
Name of the station that contains the partner port
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● Partner device
Name of the device that contains the partner port

● Partner interface
Interface to which the partner port belongs

● Partner port

● Cable data
Contains the cable length and the signal delay of the cable connecting the ports

Basic functions for tables
The topology overview table supports the following basic functions for editing a table:

● Displaying and hiding table columns
Note: The columns that define the configuration cannot be hidden.

● Optimizing column width

● Displaying the meaning of a column, a row or cell using tooltips.

 

Displaying the diagnostics status of ports and cables in the graphic view

Requirements
The graphic view of the topology view is open.

Procedure  
To determine the diagnostics status of the port, follow these steps: 

1. Go online with the required component or components.

Result
The following icons are displayed:

● The corresponding diagnostics icon is displayed for each device.

● If there is an error in at least one lower-level component, the diagnostics icon "Error in lower-
level component" is also displayed in the left-hand lower corner of the diagnostics icon.

● The corresponding diagnostics icon is displayed for each port.

● Every cable between two ports that are online has the color that matches its diagnostics 
status.

You will find the possible diagnostics icons for ports and the color coding of Ethernet cables 
in the description of hardware diagnostics. See: Displaying diagnostics status and comparison 
status using icons (Page 962)
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Showing the diagnostics status of hardware components in the table view

Requirement
The table view of the topology view is open.

Procedure 
To obtain the diagnostics status of hardware components of the topology overview table, follow 
these steps: 

1. Go online with the required components.

Result
The following icons are displayed at the left-hand edge of the topology overview table in each 
row that belongs to the component involved:

● The diagnostics icon belonging to the hardware component is displayed.

● If the hardware component has lower-level components and if there is an error in at least 
one of the lower-level components, the diagnostics icon "Error in lower-level component" 
is also displayed in the left-hand lower corner of the diagnostics icon of the hardware 
component.

For the possible diagnostics icons for hardware components, refer to the description of 
hardware diagnostics. See: Displaying diagnostics status and comparison status using icons 
(Page 962)

 

 Note

The display of the diagnostics status of hardware components in the topology overview table 
and the network overview table is identical.

 

Running an offline/online comparison and displaying the results

Requirement
The topology view is open. There may be an online connection to one or more devices, but 
this is not actually necessary.
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Procedure   
To find the differences between the configured and the actual topology, follow these steps: 

1. Click the "Offline/online comparison" button in the toolbar of the topology overview.

Result
The "Partner station", "Partner interface" and "Cable data" columns in the topology overview 
table are removed.

Two additional groups of columns are added to the right-hand side of the table and these are 
initially empty:

● On the far right, columns for the topology to be identified online are added.

● Between the columns for the offline and the online topology, the "Status", "Action" and 
"Description" columns are added to show the result of the offline/online comparison.

 

  Note

As default, the "Description" column is not displayed.
 

The following buttons are enabled in the toolbar of the table:

Button Name Meaning
Update The detection of the existing online topology is started again.

Synchronize ● Adopting the port interconnections identified online in the 
project (Page 523)

● Adopt the devices identified online in the project 
(Page 524)

After the actual topology has been identified, the added columns are filled. These steps are 
described in more detail in the following section.

 

 Note

A difference between offline and online view is displayed for that port connected with the PG/
PC which is only available online. This is because the PG/PC cannot be configured offline.

 

Columns for the topology identified online
The following columns are displayed:

● "Device / port"

● "Type" (as default, this column is not displayed)

● "Order no." (as default, this column is not displayed)

● "IP address" (as default, this column is not displayed)

● "Partner device"
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● "Partner port"

● "Cable data"

Columns for the result of the offline/online comparison
The following columns are displayed:

● "Status"
The result of the offline/online comparison is shown here in the form of diagnostics icons. 
The following icons are possible:

Diagnostics icon Meaning
Differing topology information in at least one lower-level component 

Identical topology information

Topology information only available offline or device is disabled.

Topology information only exists online

Differing topology information

 If a device does not support topology functions, the "Status" column remains 
empty.

● "Action"
The possible actions are shown here in the form of icons. The following icons are possible:

Icon Meaning
No action possible

Adopt the interconnection found online

● "Description"
This column describes the selected action in words.

Configuring topology

Interconnecting ports

Overview

Interconnecting ports in the topology view 
In the topology view, you have the following options for interconnecting ports:

● in the graphic view (Page 517)

● in the graphic view of a tool changer (Page 519)
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● in the table view (Page 518)

● in the table view of a tool changer (Page 520)

● by adopting port interconnections identified online (Page 523)

What effects does the interconnection of ports have on the network view?
 

 Note

In the properties of a subnet in the network view, you can specify that this subnet is used 
when a port interconnection is created between two devices that are not networked.

 

When you create an interconnection between two ports, the following effects are possible in 
the network view:

● If the corresponding interfaces are not networked: If you have specified a default subnet, 
this is used. Otherwise a new subnet is created to connect the two interfaces.

● If one (and only one) of the two interfaces involved is networked: The non-networked 
interface is connected to the same subnet as the already networked interface.

● In all other cases: The corresponding interfaces are not connected to a logical subnet.

See also
Interconnecting ports (Page 813)

Interconnecting ports in the graphic view

Requirement
You are in the graphic view of the topology view.

Procedure – Creating a new interconnection between two ports   
To interconnect a port of a device with a port of another device, follow these steps:

1. Place the mouse cursor on the port you want to interconnect.

2. Click with the left mouse button and hold it down.

3. Move the mouse pointer.
The pointer now shows the networking symbol to indicate "Interconnect" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear when the pointer is 
on a valid target.

4. Now drag the mouse cursor to the target port. You can do this while holding down or after 
releasing the mouse button.

5. Now release the left mouse button or press it again (depending on your previous action).

Result: A new port interconnection is created.
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 Note
Creating a ring for S7-300, S7-400, and S7-1500 CPUs

If you create a ring using port interconnections for S7-300, S7-400, or S7-1500 CPUs, an 
MRP domain is created automatically.

 

Procedure – Changing an existing port interconnection without deleting it first
To do this, follow these steps:

1. Place the mouse cursor on the port of an existing interconnection that is to receive a new 
partner port.

2. Drag the port to the new partner port.

Result: The existing port interconnection is deleted. The new port interconnection is created.

Alternative procedure:

1. Place the mouse cursor on a port without an interconnection that is to be connected with 
an already interconnected port.

2. Drag the port to the already interconnected port.

Result: The existing port interconnection is deleted. The new port interconnection is created.

Procedure – Interconnecting two interconnected ports with each other without first deleting the two 
existing port interconnections

To do this, follow these steps:

1. Place the mouse cursor on the interconnected port that is to receive a new partner port.

2. Drag the port to the new partner port that is also interconnected already.

Result: The two existing port interconnections are deleted. The new port interconnection is 
created.

Interconnecting ports in the table view

Which actions are possible with port interconnections in the table view?
The following actions are possible with port interconnections in the table view:

● Creating a new port interconnection

● Changing an existing port interconnection

● Deleting an existing port interconnection
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Requirement
The row with the port whose interconnection you want to create, modify or delete is visible in 
the topology overview.

Procedure 
To create the interconnection of a port for the first time, to modify it or delete it, follow these 
steps:

1. Move the mouse pointer to the "Partner port" column in the row of the source port.

2. Click the drop-down list there.

3. Select the required partner port (when creating or changing a port interconnection) or the 
"Not interconnected" entry (when deleting a port interconnection).

Result
The required action is performed. The new partner port (after creating or modifying a port 
interconnection) or the "Select port" entry (after deleting a port interconnection) is displayed 
in the "Partner port" column.

Interconnecting a port with more than one partner port in the graphic view

Requirement
● You have configured a port of a PROFINET device with the "Alternative partners" property 

and have specified its possible partner ports.

● The graphic view of the topology view is open.

Procedure 
1. Interconnect this port (referred to hereafter as source port) with one of the partner ports 

you have specified (referred to hereafter as target port).

2. Interconnect the source port with an additional target port.
You can do this in several ways:

– Drag the mouse pointer from a partner port that is already interconnected to a target 
port.

– Drag the mouse pointer from an interconnection that has already been created to a 
target port.

– Drag the mouse pointer from a target port to a partner port that is already interconnected.

– Drag the mouse pointer from a target port to an already created interconnection.

3. If necessary, repeat the step above one or more times.
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Result
An interconnection is created between the source port and the alternative partner ports. This 
is indicated by a dashed line.

Interconnecting a port with more than one partner port in the table view

Which actions are possible with port interconnections to several partner ports in the table view?
When working with a tool changer, the following actions can be performed with port 
interconnections to multiple partner ports in the table view:

● Creating a new port interconnection

● Changing an existing port interconnection

● Deleting an existing port interconnection

Requirement
● You have configured a port of a PROFINET device with the "Alternative partners" property 

and have specified its possible partner ports.

● The row with the port whose interconnection you want to create, modify or delete is visible 
in the topology overview.

Procedure  
To create the interconnection of a port to one or more partner ports for the first time, to modify 
it, or to delete it, follow these steps:

1. Move the mouse pointer to the "Partner port" column in the row of the source port.

2. Click the drop-down list there.

3. Select the required partner port (when creating or changing a port interconnection) or the 
"Not interconnected" entry (when deleting a port interconnection).

Result
The required action is performed:

● If you are creating an interconnection, a new row is inserted in the topology overview table. 
The new partner port is displayed there in the "Partner port" column.

● If you change an interconnection, the new partner port is displayed in the "Partner port" 
column.

● If you delete an interconnection, the row with the previous port interconnection is deleted.
 

  Note

With a tool changer, there are normally several rows for a port with port interconnections 
to more than one partner port. The last row is always an empty row. The first row can be 
edited, all other rows are read-only.
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Renaming stations, devices, interfaces or ports

Rename a station, a device, an interface or a port

Requirement
The table view of the configured topology is open.

Procedure        
To rename a station, a device, an interface or a port, proceed as follows:

1. Click twice in the relevant field of the topology overview table (the second click starts the 
editing mode).

2. Enter the new name and then press the ENTER key (this closes editing mode).

Result
The object is renamed.

 

Offline/online comparison

Automatic assignment of devices by offline/online comparison

Overview  
During the offline/online comparison, the configured topology is compared with the actual 
existing topology. Devices identified online are automatically assigned to configured devices 
as far as this is possible.

Start of availability detection
You start the availability detection the first time by clicking the "Compare offline/online" button 
in the toolbar of the topology overview.

You restart availability detection by clicking the "Update" button.
 

 Note

The availability detection can take several seconds. During this time, no user input is possible.
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Automatic assignment
A device identified online is automatically assigned to a configured device if the following 
properties of the two devices match up:

● Device name

● Order number

● Number of ports

The following section describes the situations that can occur and what action you can take:

● Identical port interconnections
This is the ideal situation. No action is necessary here.

"Action" column Meaning
No action

● There are interconnections for the identified and configured device, there are however 
differences.
The following actions are possible:

– If it is possible to adopt the online configuration

"Action" column Meaning
Adopt online interconnection (Page 523)

No action

– If it is not possible to adopt the configuration

"Action" column Meaning
No action
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● The interconnection only exists online.
The following actions are possible:

– If it is possible to adopt the online configuration

"Action" column Meaning
Adopt online interconnection (Page 523)

No action

– If it is not possible to adopt the configuration

"Action" column Meaning
No action

● The interconnection only exists in the configuration.
The following actions are possible:

"Action" column Meaning
Adopt the online interconnection (Page 523), in other words, the 
interconnection in the configuration will be deleted
No action

No automatic assignment
In the following situations, no automatic assignment is possible:

● No device can be identified online to match a configured device. In this case the 
corresponding columns in the "Online topology" area of the topology overview table are 
empty.
In this case, you should add the already configured device to your system or delete the 
configured device from the configuration.

● A device identified online cannot be assigned to any configured device. In this case the 
corresponding columns in the "Offline topology" area of the topology overview table are 
empty.
In this case, you can adopt the device identified online in the project (Page 524).

Adopting the port interconnections identified online in the project

Requirement
You have run an offline/online comparison in the topology view. The result of this is that at 
least one device identified online was automatically assigned to a configured device, but that 
there are differences relating to the interconnection.
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Procedure   
To adopt one more port interconnections identified online in the project manually, follow these 
steps: 

1. Select the value "Adopt" in the "Action" column for a port of a configured device to which 
a device identified online was assigned.

2. Repeat the step if necessary for other ports of the same configured device.

3. Repeat the steps up to now if necessary for other configured devices to which devices 
identified online were assigned and for which there are differences relating to the 
interconnection.

4. Click the "Synchronize" button.

Result
The port interconnections identified online and the cable information for the corresponding 
devices are adopted in the project. Successful adoption is indicated by the diagnostics icon 
"Identical topology information" for each port.

 

 Note

If other port interconnections are recognized for a device identified online and these differ 
from those that exist in the project, adopting these in the project means that the port 
interconnections that were previously in the project are replaced by those identified online. 
If no port interconnections are detected for a device identified online, adopting in the project 
means that all the port interconnections of this device are deleted in the project.

 

Adopt the devices identified online in the project

Requirements
You have run an offline/online comparison in the topology view. The result of this is that at 
least one device identified online could not be assigned to any configured device.

Procedure  
To adopt one more devices identified online in the project manually, follow these steps: 

1. For a configured device without an online partner, move the mouse pointer to the "Device/
port" column of the online topology.

2. Select the device you want to assign to the configured device from the drop-down list of 
this box.

3. Repeat the previous steps if necessary for other configured devices without an online 
partner.
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Result
The selected device that was identified online is moved up from the end of the table. Following 
this, it is in the row of the configured device to which you have just assigned it.

8.1.3.4 Industrial Ethernet Security

Configuring security

General

Supported devices

Supported devices
Security functions can be configured for the following products:

● SCALANCE S: 

– S602 V2/V3

– S612 V2/V3

– S613 V2

– S623 V3
Note: SCALANCE S V3 devices can currently only be configured with those functions 
that are supported by SCALANCE S V2 devices. For the SCALANCE S623, the DMZ 
port is currently not configurable.

● SOFTNET Security Client:

– SOFTNET Security Client V4

● S7-CPs: CP 343-1 GX31 Advanced, CP 443-1 GX30 Advanced, CP 1543-1 
Note: The S7 CPs, CP 343-1 GX31 Advanced and CP 443-1 GX30 are now grouped 
together under "CP x43-1 Advanced".

● PC CP: CP 1628 

● SCALANCE M: SCALANCE M875 and MD741-1

General terminology "security module"   
In this section of the information system, the following products are grouped together under 
the term "security module": CP 343-1 GX31 Advanced, CP 443-1 GX30 Advanced, CP 1543-1, 
SCALANCE S602 / SCALANCE S612 / SCALANCE S613 / SCALANCE S623, CP 1628, 
SCALANCE M875/MD741-1.
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Structure of this section of the help system
Topics that are relevant to all security modules can be found in the "General" section. 
Information that is only relevant to certain module types can be found in the sections relating 
specifically to these modules.

Overview - Scope of performance and method of operation

General use of the term "STEP 7"
Configuration of security functions is supported as of STEP 7 V12. For this reason, in this 
section of the information system, the name "STEP 7" will be used for all versions of STEP 7 
V12 or higher.

Scope of performance
You can use the following security functions in STEP 7:

● Configuration of the security modules

● Creating configuration files for SOFTNET Security Client V4

● Creating the configuration data of the SCALANCE M875/MD741-1

● Diagnostics functions and status displays

Offline and online view       
The security functions are configured in two views:

● Offline configuration view
In the offline configuration view, you create the configuration data for the security modules 
and the SOFTNET Security Client. Prior to downloading, there must already be a 
connection to the security module.

● Online diagnostics view
The online diagnostics view is used for diagnostics of a security module and, among other 
things, allows you to run a firmware update.

How it works - security and consistency
● Access only for authorized users

The security functions of every project are protected from unauthorized access by assigning 
user names and passwords.

● Consistent project data
Consistency checks are running even while you make the entries in the dialogs. In addition, 
cross-dialog, project-wide consistency checks are carried out.
Only consistent project data can be downloaded to the security modules.

● Protecting project data by encryption 
The project and configuration data relevant to security are protected by encryption. 
Depending on the security module, data can be stored in the project and/or on the C-PLUG.
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User interface - layout and menu commands

User interface for security functions in STEP 7
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① Global security settings

The global security settings are located in the project navigation. These security settings can be configured 
independently of the module and subsequently assigned to individual security modules as required. If there are only 
CPs in the security configuration, the global security settings are shown only when the security functions have been 
enabled in the local security settings of a CP. The following main folders and entries are available in the global 
security settings:
● User login

For the security configuration within a project, there is a separate user management. Log in to the security 
configuration as an existing user using the "User login" entry. You can create a new user in the user management 
when creating a security configuration.

● User administration
In user administration, you can create users, define rights for roles and assign these roles to users.

● Certificate manager
In the certificate manager, you see an overview of all the certificates used in the project. You can, for example, 
import new certificates as well as export, modify or replace existing certificates.

● Firewall
In the "Firewall" entry, you can define global IP and MAC firewall rules and assign security modules. IP and MAC 
service definitions are used to define the IP and MAC firewall rules compactly and clearly.

● VPN groups
All created VPN groups are contained in this folder. You can create new VPN groups here and assign security 
modules to these VPN groups.

● NTP
Here, you can create NTP servers and assign them to one or more security modules. This ensures that time 
synchronization is performed through the assigned NTP server. Unsecured NTP servers can only be configured 
in the local security settings.

② Working area with security module

Detailed information about this object is shown in the "VPN" tab as well as in the inspector window under "Properties" 
> "General" when you select a security module in the working area.
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③ VPN tab

This tab displays information about all the VPN groups to which the security module that was selected in the working 
area belongs. Information about the respective participants of a VPN group can be displayed and hidden.

④ Local security settings

Local security settings are configured for a specific security module. After a security module has been selected in 
the working area, its local security settings are available in the inspector window under "Properties" > "General".
 
Note for CPs:
Before security settings can be configured for CPs, the local security settings must be enabled. To do this, log in to 
your security project and then in the Inspector window, select the "Activate security features" check box under 
"Properties" > General" > "Security". The local security settings are then displayed below the "Security" entry. When 
the check box is selected, the following settings (assuming they were enabled) are migrated automatically to the 
local security settings.
CP x43-1 Advanced:
● SNMP
● FTP configuration
● Time-of-day synchronization
● Web server
● Entries of IP access lists
 
CP 1543-1:
● SNMP
● FTP configuration
● Time-of-day synchronization
 
CP 1628:
● SNMP
● Time-of-day synchronization
 
In addition, firewall rules that enable a connection to be established are created automatically for configured 
connections. For unspecified connections, you need to configure the firewall rules in advanced firewall mode 
manually. Log settings are available to record blocked packets.
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Running a consistency check

Overview
The following consistency checks are available:

● Local consistency checks

● Project-wide consistency checks

In the individual dialog descriptions in this help system, the rules you need to take into account 
for your entries are listed under the keyword "Consistency check".

Local consistency checks   
A consistency check is local when it can be performed directly within a dialog. With the following 
actions, local consistency checks are made:

● After exiting a box

● After exiting a row in a table

● When you confirm a dialog with OK.

Project-wide consistency checks   
Project-wide consistency checks provide you with information indicating whether or not project 
data is correctly configured. With the following actions, there is a consistency check through 
the entire project:

● When compiling a configuration

● When downloading a configuration
 

 Note

You can only download configured data when the entire project is consistent.
 

Managing certificates

Overview of certificates

How do you manage certificates?
In the certificate manager, you have an overview of all the certificates, for example, CA 
certificates used in the project with information about the applicant, issuer, validity, use and 
the existence of a private key. 

The CA certificate is issued by a certificate authority from which the device certificates are 
derived. These include the SSL certificates required for authentication in secure 
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communication between a network node and a security module, as well as the VPN group 
certificates if the security module is a member of a VPN group. Certificate authorities can be:     

● STEP 7 itself. If the "applicant" and "issuer" are the same, this is a self-signed certificate; 
in other words, issued by STEP 7.

● A higher ranking (commercial) certificate authority. These third-party certificates are 
external to the project and are imported and stored in the certificate store of STEP 7.

Certificates created by one of the two certificate authorities always have a private key so that 
the device certificates can be derived from them. 

The following functions are also available in the certificate manager:

● Modification of existing certificates (for example, duration of validity).

● Import of new certificates and certificate authorities.    

● Import of SSL certificates (S7 CPs only), e.g. for FTP communication. 

● Export of the certificates and certificate authorities used in the project.

● Renewal of expired certificates and certificate authorities.

● Replacement of existing certificate authorities with others.

● Addition of trusted certificates and certificate authorities.

● Deleting manually imported certificates.
 

 Note
Downloading the configuration

After replacing or renewing certificates, the configuration must be downloaded to the relevant 
security modules. 

After replacing or renewing CA certificates, the configuration must be downloaded to all 
security modules.

 

 
 

 Note
Current date and current time of day on the security modules

When using secure communication (for example, HTTPS, VPN...), make sure that the 
security modules involved have the current time of day and the current date. Otherwise the 
certificates used are not evaluated as valid and the secure communication does not work.

 

How to access this function     
Double-click on the "Certificate manager" entry in the global security settings.

In the individual tabs, you have the following commands available in the shortcut menu:
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Command Meaning
Import / Export Import / export of device certificates or CA certificates. The 

certificates are transferred to the security module. The following 
formats are permitted:
*.cer (certificate only)
*.crt (certificate only)
*.pem (certificate only) 
*.p12 (certificate and corresponding private key)   

Displays Opens the certificate dialog of Windows where you see an overview 
of all certificate data.

Renew
(only in the "CA" and "Device 
certificates" tabs)

Opens the "Create new certificate" dialog in which you can import 
a certificate or have a new certificate created by STEP 7 when 
necessary, for example with compromised certificates.

Replace
(only in the "CA" tab)

Opens the "Change certificate authority (CA)" dialog in which you 
can replace an existing certificate authority with a new one.

Delete
(only with manually imported 
certificates)

Deletes a certificate in the "Trusted certificates and root certification 
authorities" tab.

Certificate authorities

"CA" tab
The certificates displayed here are created by a certificate authority.

● CA certificates of a project: When you create a new project, a CA certificate is generated 
for the project. The SSL certificates for the individual security modules are derived from 
this certificate.

● CA group certificates: When you create a new VPN group, a CA certificate is generated for 
the group.

Device certificates

"Device certificates" tab
Display of the device-specific certificates generated by STEP 7 for a security module. These 
include:

● SSL certificates: An SSL certificate that is derived from a CA certificate of the project is 
generated for each security module that you create. SSL certificates are used for 
authentication in secure communication between PGs/PCs and security modules when 
downloading the configuration to a SCALANCE-S module, as well as for logging.

● Group certificates: A group certificate is also generated for each security module for each 
VPN group in which it is located.
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Trusted certificates and root certification authorities

"Trusted root certification authorities" tab   
Display of the third-party certificates imported into STEP 7. For example, server certificates 
can be imported from external FTPS servers or project certificates from other projects that 
were created with STEP 7.

With CPs, the imported third-party certificate is transferred to all the CPs managed in the project 
and these check the certificate. If you classify the certificate sent to the security modules as 
trusted, a connection can be established, for example, to an FTPS server. The imported 
certificate is not used at any other point in STEP 7.

For SCALANCE S modules, the certificate authorities that are necessary for verification of the 
security modules by means of external services such as DynDNS are displayed in this tab.

Renewing certificates

Meaning   
In this dialog, you renew CA certificates and device certificates. If necessary, for example with 
compromised certificates, you can import a certificate or have a new certificate generated by 
STEP 7.

How to access this function
1. Right-click on a list entry in the certificate manager.

2. Select the "Renew" entry in the shortcut menu.

3. Decide whether or not the new certificate will be self-signed or signed by a certificate 
authority.    

4. If the certificate is to be signed by a certificate authority, select the certificate authority to 
be used with the "Select" button. Only certificate authorities stored in the certificate store 
of the current project can be selected.
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5. Depending on the certificate, enter the following values in the "Applicant" or "Alternative 
applicant name" input box:

Certificate to be renewed Parameter
Applicant Alternative applicant name

CA certificates of the project   Name of the CA certificate -
CA group certificate Name of the CA group 

certificate
-

SSL certificate for S7 CP   Name of the security module Comma-separated IP addresses of 
the Gigabit and PROFINET interface    

SSL certificate for PC CP Name of the security module IP address of the security module
SSL certificate for 
SCALANCE S, 
SCALANCE M, SOFTNET 
Security Client

Name of the security module -

Group certificate of the 
security module

Name of the group certificate Derived from the CA

6. Select a period during which the certificate is valid. As default, the current time is entered 
in the "Valid from:" box and the value of the current certificate in the "Valid to" box.

 

Replacing certificates

Meaning   
Open the "Change certification authority (CA)" to replace the existing CA certificate of the 
project or the CA group certificate with a new one.     

How to access this function
1. Right-click a list entry in the "CA" tab.

2. Select the "Replace" entry in the shortcut menu.

3. The "Change certification authority (CA)" dialog opens.

All certificates listed in the "Certificates involved" table are derived once again. This means 
that the CA group certificate of an already configured VPN group can be replaced in the project 
by the CA group certificate of a different project. The group certificates for the VPN group 
members are therefore derived from the same CA group certificate in both projects.   

After making changes in the certificate manager, download the configuration to all security 
modules affected.
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Which format can the certificate have?
Other certificates are derived from the imported certificate authority in STEP 7. For this reason, 
you can only select certificates with a private key.

● *.p12 

Managing users and roles

Rules for user names, roles and passwords

Which rules apply to user names, role names and passwords?
When creating or modifying a user, a role or a password, remember the following rules:

Table 8-1 Rules for user management

Permitted characters The following characters from the US-ASCII character set are 
permitted:

0123456789
A...Z a...z

!#$%&()*+,-./:;<=>?@ [\]_{|}~¦^`
Characters not allowed " '
Length of the user name 1 ... 32 characters
Length of the password 8 ... 32 characters
Length of the role name 1 ... 32 characters
Maximum number of users per 
project

128

Maximum number of users on one 
security module

32 + 1 administrator when creating the project

Maximum number of roles per 
project 

124 user-defined + 4 system-defined

Maximum number of roles on one 
security module

33 user-defined + 4 system-defined

 
 

 Note
User names and passwords

As vital measure under the aspect of maximizing security, always make sure that user names 
and passwords have a minimum length of 8 characters and that these contain special 
characters, uppercase/lowercase letters, number, etc..
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Create users

Meaning
The security functions configured in STEP 7 are protected from unauthorized access by a 
separate user management. Before you can access the global and local security settings of 
security modules, you need to log in in the security configuration as a user in the local security 
settings of a security module with the entry "Security properties".

Creating the first user in the project  
After creating the first security module in the project, you first need to create a user. To do this, 
in the local security settings of the created security module, click the "User login" button under 
the "Security properties" entry and enter the login data of the user you want to create. You will 
then be logged in as the created user and the user is assigned the system-defined 
"Administrator" role. This role includes all configuration and module rights.

Creating users in the user management
When you are logged in as a user in the security configuration, you can create further users 
or delete users with the "User management" entry in the global security settings.

 

 Note
Users with the "Administrator" role

There must always be at least one user with full configuration rights within a project. The 
administrator that is created automatically when you first enable the security functions in the 
project can only be deleted if at least one other user exists with the system-defined role 
"Administrator".

 

The following parameters are available in user management in the "User" tab:

Table 8-2 Information in the "User" tab

Parameter Meaning
User name   Name of the user to be created.

Click on the "Add new user" entry in the "User name" column to create a 
new user.

Password Password with which a user authenticates him/herself when logging on.
Role Selecting a system-defined or user-defined role.
Comment Entry of optional comments.

Creating roles

Overview   
You can assign a system-defined or a user-defined role to a user. Specify the module rights 
of a user-defined role for each security module. 
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System-defined roles     
The system-defined roles listed below are predefined. Certain rights are assigned to the roles 
that are the same on all modules and that the administrator can neither change nor delete.

● Administrator    
Default role when creating a security configuration.
Unlimited access rights to all configuration data and all security modules.

● Standard 
Role with restricted access rights, see section 
Managing rights (Page 538)

● Diagnose    
Default role when creating new user.

– Read access to configurations.

– Read access to the security module in the "Online" mode for testing and diagnostics.

● Remote-Access       
Can be used as a template when creating user-defined roles.

You will find a detailed list of the configuration and module rights assigned to the system-
defined roles "Administrator", "Standard" and "Diagnostics" in tables 1-3 to 1-7 of the section 
Managing rights (Page 538).

User-defined role     
In addition to the system-defined roles, you can create user-defined roles. For a user-defined 
role, select the configuration or module rights and specify the appropriate module rights for 
every security module used in the project. You manually assign the user-defined roles to the 
relevant user.

How to access this function
1. Double-click on the "User management" entry in the global security settings.

2. Select the "Roles" tab in User management.

Table 8-3 Information in the "Roles" tab

Parameter Meaning
Role   Freely selectable role name.

Double-click on the "Add new role" entry to create a new user-defined role.
You can then set the rights for the created role.

Description Specifying the system-defined role With user-defined roles, the "User-
defined role" character string is displayed.

Comment Entry of additional, optional comments.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  537



 

 Note
Deleting roles

A user-defined role can only be deleted when it is no longer assigned to any user. If necessary, 
assign the user a different role.

System-defined roles cannot be deleted.
 

Managing rights

How to access this function
1. Double-click on the "User management" entry in the global security settings.

2. Select the "Roles" tab in User management.

Creating and assigning a user-defined role   
1. Double-click on the "Add new role" entry.

2. Enter a role name.

3. If necessary, select the system-defined role whose rights will be used as the template for 
the user-defined role from the drop-down list labeled "<Copy rights from>". User-defined 
roles cannot be selected from the drop-down list.
Result: In the list of rights of the user roles, the rights are selected that are assigned to the 
selected system-defined role.

4. For each security module, enable or disable the rights to be assigned to the user-defined 
role.

5. Assign the role to a user in the "User" tab.

Configuration rights
Configuration rights are not module dependent and control the rights for configuration in STEP 
7.

Depending on the user type, the following configuration rights are available for selection:

Table 8-4 Configuration rights   

Configuration right Administrator Standard Diagnose
Diagnose security x x x
Configure security x x -
Managing users and roles x - -

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
538 System Manual, 07/2013,  



Module rights    
Module rights are configured per module. The "Service" column shows the service to which 
the particular right relates. With the "Copy rights" and "Paste rights" commands in the shortcut 
menu, you can transfer the rights from one module to another.

Depending on the user type, the following module rights are available for selection:

Table 8-5 Module rights CP x43-1 Advanced

Right within the service Administrator Standard Diagnose Service
Web: Format CP file system * x - - File system
FTP: Read files from the CP file system x x x
FTP: Write files to the CP file system x x -
FTP: Read files (DBs) from the S7 CPU **   x x x PLC
FTP: Write files (DBs) to the S7 CPU *** x x -
Applet: Read tags using configured symbols * x x -
Applet: Write tags using configured symbols *
Applet: Read tags using absolute addresses *   x x x
Applet: Write tags using absolute addresses * x x -
Applet: Read status of the modules in the rack * x x x
Applet: Query order numbers of the modules in the 
rack *

x x x

SNMP: Read MIB-II    x x x SNMP
SNMP: Write MIB-II x x -
SNMP: Read automation MIB x x x
SNMP: Read LLDP-MIB  x x x
SNMP: Read SNMPv2-MIB x x x
SNMP: Read MRP MIB x x x
SNMP: Write MRP MIB x x -
TIA Portal: Run diagnostics of the security module 
****

x x x Security

Web: Expand IP access control list *   x - - Web
Web: Access Web diagnostics and CP file system x x x
Web: Send test e-mails * x x x
Web: Update firmware * x x - Maintenance
Web: Load diagnostics texts later * x x -

Table 8-6 Module rights CP 1628

Right within the service Administrator Standard Diagnose Service
SNMP: Read MIB-II x x x SNMP
SNMP: Write MIB-II x x -
SNMP: Read automation MIB x x x
SNMP: Read SNMPv2-MIB x x x
TIA Portal: Run diagnostics of the security module **** x x x Security
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Table 8-7 Module rights SCALANCE S

Right within the service Administrator Standard Diagnose Service
Download the configuration files x x - Security
TIA Portal: Run diagnostics of the security module **** x x x

Table 8-8 Module rights CP 1543-1

Right within the service Administrator Standard Diagnose Service
FTP: Read files from the CP file system x x x File system
FTP: Write files to the CP file system x x -
TIA Portal: Run diagnostics of the security module **** x x x Security
SNMP: Read automation MIB x x x SNMP

 SNMP: Read IPv6 MIB x x x
SNMP: Read LLDP-MIB  x x x
SNMP: Read MIB-II x x x
SNMP: Write MIB-II x x -
SNMP: Read SNMPv2-MIB x x x
FTP: Read files (DBs) from the S7 CPU **  x x x PLC
FTP: Write files (DBs) to the S7 CPU *** x x -

* To be able to use the function, the module right "Web: Access Web diagnostics and CP 
file system" must be enabled as well.   

** To be able to use the function, the module right "FTP: Read files from CP file system" 
must be enabled as well.

*** To be able to use the function, the module right "FTP: Write files to CP file system" must 
be enabled as well.

**** To use the function, the configuration right "Security diagnostics" must also be enabled.

Setting module rights before and after creating the security modules
Within a user-defined role, the module rights for each security module are defined separately. 
If a security module was created before this role was added and module rights within a role 
need to be set, STEP 7 presets the module rights for the security module according to the 
selected rights template. The preset module rights can then be adapted when adding the role. 
If a security module was created after adding a role, no rights are preset for this security 
module. In this case, you will need to edit an existing role and set all the module rights yourself 
for the security module.

You can also transfer existing module rights to another module by copying and, if necessary, 
adapting them there. To do this, select a module in the shortcut menu in the module rights and 
select the "Copy rights" or "Paste rights" menu command.
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Generating configuration data for SCALANCE M modules

Context
You can generate the VPN information for the assignment of parameters to a SCALANCE M 
using STEP 7. For this to be possible, the module must be in at least one VPN group with a 
security module or a SOFTNET Security Client. With the generated files, you can then 
configure the SCALANCE M using the Web Based Management of the device.

Generated files
The following file types are generated:

● Export file with the configuration data

– File type: *.txt file in ASCII format

– Contains the exported configuration information for the SCALANCE M including 
information on the additionally generated certificates.

● Module certificate

– File type of the private key: *.p12 file

– The file contains the module certificate and the key material.

– Access is password protected.

● Group certificate

– File type: *.cer file

Figure 8-1 SCALANCE M configuration file
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 Note
No transfer to the security module

Configuration files are not transferred to the security module. An ASCII file is generated with 
which you can configure the SCALANCE M. To allow this, the SCALANCE M must be located 
in at least one VPN group with another security module.

 

Follow the steps below
1. Select the module of the type "SCALANCE M".

2. In the local security settings, select the entry "SCALANCE M configuration".

3. Select the "Generate SCALANCE M files" check box and select a storage location for the 
configuration files.

4. Compile the configuration of the SCALANCE M module.

5. In the dialog that follows, choose whether you want to create your own password for the 
created .p12 file.
If you select "Cancel", the project name is assigned as the password, not the project 
password.

Result: The files (.txt file and certificates) are stored in the folder you specify.

Configuring the mode and network parameters for SCALANCE S modules

Overview
You will find information on configuration of the mode and network parameters of SCALANCE 
S modules in Auto-Hotspot of the section "SCALANCE S".

The configuration of the network parameters of CPs is described sections dealing with the CPs.

Setting up a firewall

Overview of the firewall

Meaning
The firewall functionality of the security modules is intended to protect networks and stations 
from third-party influence and interference. This means that only certain, previously specified 
communications relations are permitted. The firewall discards invalid frames without sending 
a response.

To filter the data traffic, IP addresses, IP subnets, port numbers or MAC addresses can be 
used. You can also set a bandwidth limitation.

The firewall functionality can be configured for the following protocol levels:
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● IP firewall with stateful packet inspection (layer 3 and 4)    

● Firewall also for Ethernet "non-IP" frames according to IEEE 802.3 (layer 2)      

With security modules capable of VPN, the firewall can also be used for the encrypted data 
traffic (IPsec tunnel). With the SCALANCE S602 Security module, the firewall can only be used 
for unencrypted data traffic. 

Types of firewall rules   
Firewall rules describe which packets in which direction are permitted or forbidden. A distinction 
is made between IP packet filter rules and MAC packet filter rules.

Global and local firewall rules
● Global firewall rules can be assigned to several security modules at the same time. Global 

firewall rules are configured in the global security settings.

● Local firewall rules are configured in the local security settings of a security module.

Service definitions
With the aid of service definitions, you can also define firewall rules clearly in a compact form. 
Service definitions are configured in the global security settings and can be used both in the 
global and in the local firewall rules.

Automatically generated firewall rules for CP connections
For connections that were configured using CPs, STEP 7 automatically creates firewall rules 
that allow communication with the partner of the CP in the specified direction (CP active/
passive). The connection establishment directions are taken into account. To display these 
firewall rules, if the advanced firewall mode is enabled, the "Update connection rules" button 
needs to be clicked. The firewall rules are then displayed in advanced firewall mode.

Which firewall rules are generated automatically is described in the following sections.

● For S7-300 CPs/S7-400 CPs/PC CPs: Connection-related automatic firewall rules 
(Page 621) in the section "Security for S7-300 / S7-400 / PC CPs".

● For S7-1500 CPs: Connection-related automatic firewall rules (Page 632) in the section 
"Security for S7-1500 CPs".

Enabling the firewall
Firewall functionality for a specific security module is controlled in the local security settings 
using the "Enable firewall" check box. If the check box is enabled, the firewall can be configured 
and is effective following the download. For a security module that is a member of a VPN group, 
the "Enable firewall" check box is activated by default and cannot be deactivated. After 
switching to advanced firewall mode, it is not possible to switch back to standard mode. For 
more information about the standard and advanced firewall modes, refer to the section:

Overview of local firewall rules (Page 552).
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Global firewall rule sets
 

Application     
Global firewall rule sets are configured in the global security settings. A firewall rule set consists 
of one or more firewall rules and is assigned to the individual security modules.

In the global firewall rule sets, a distinction is made between the following:

● IP rule sets 

● MAC rule sets 

The following schematic illustrates the relationship between globally defined rule sets and 
locally used rule sets.

Configuring
When configuring global firewall rules, you can make detailed firewall settings. You can allow 
individual services for a single node or all services for the node for access to the station or 
network.
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When are global IP and MAC firewall rules useful?
Global firewall rules are useful if you want to define identical filter criteria for communication 
with several security modules.

 

 Note
Only assign rule sets that are supported by the security module

A bad module assignment can lead to undesirable results. You should therefore always check 
the module-specific local firewall rules in the result. An incorrect assignment of firewall rule 
sets is not detected during the automatic consistency check. Only firewall rule sets that are 
actually supported by the security module are adopted correctly. A global firewall rule set 
containing a firewall rule with the direction "From: external" or "To: any" cannot be correctly 
assigned to a CP 1628.

 

 

Global firewall rule sets - conventions

Global firewall rule sets are used locally
The following conventions apply when creating a global set of firewall rules and when assigning 
it to a module:

● Configuration view
Global firewall rule sets are configured in the global security settings.

● Priority
As default, locally defined rules have a higher priority than the global IP and MAC firewall 
rule sets. Newly assigned global IP and MAC firewall rule sets are therefore initially entered 
at the bottom of the local rule list.
The priority can be changed by changing the position in the rule list.

● Entering, changing or deleting rule sets
Global firewall rule sets cannot be edited in the local rule list of the firewall rules in the 
module properties. They can only be displayed there and positioned according to the 
required priority.
It is not possible to delete a single rule from an assigned rule set in the local security settings. 
Only the entire rule set can be removed from the local list of rules. The firewall rule sets in 
the global security settings remain unaffected.

Creating global firewall rule sets

How to access this function     
1. In the global security settings, select the entry "Firewall" > "Global firewall rule sets" > "IP 

rule sets" or "MAC rule sets".
Result: The previously created IP rule sets or MAC rule sets are displayed under the 
selected entry.

2. Double-click on the entry "Add new IP rule set" or "Add new MAC rule set".
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3. Enter the following data:

– Name: Project-wide, unique name of the rule set. The name appears in the local rule 
list of the security module after the rule set is assigned.

– Description (optional): Enter a description of the global rule set.

4. Enter the firewall rules one by one in the list.
Note the parameter description in the following sections:
For IP rule sets: Defining IP packet filter rules (Page 553) 
For MAC rule sets: Defining MAC packet filter rules (Page 556) 

Result
You have created the global firewall rule set and can now assign this to the required security 
modules.
Note the descriptions in the following section:

Assigning global firewall rule sets (Page 546) 

Assigning global firewall rule sets

Requirement
You have enabled the advanced firewall mode for the security modules you want to assign to 
a firewall rule set.

Procedure
1. In the global security settings, select the entry "Firewall" > "Global firewall rule sets" > 

"Assign module to a firewall rule set".

2. From the "Rule set" drop-down list, select the rule set to which you want to assign the 
security module.
In the right-hand table, you will see the security modules that you can assign to the selected 
firewall rule set. In the left-hand table, you will see the security modules already assigned 
to the selected firewall rule set.

3. In the "Available modules" area, select the security modules you want to assign to the 
selected rule set.

4. Click the  button to assign the selected modules to the selected rule set.

Result
The global rule set is used by the assigned security modules as a local rule set and appears 
automatically at the end of the list of firewall rules in the local security settings. 
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IP services

Defining IP services

How to access this function
In the global security settings, select the entry "Firewall" > "Services" > "Define services for IP 
rules".

Procedure
Using the definition of IP services, you can define succinct and clear firewall rules for specific 
services. You select a name and assign the service parameters to it.   

These services defined in this way can also be grouped together under a group name.   

When you configure the packet filter rules, you then use this name.

Parameters for IP services
You define the IP services using the following parameters:

Table 8-9 IP services: Parameter

Parameter Meaning/comment Available options / ranges of 
values

Name Name for the service that is used as identification in 
the rule definition or in the group. The names of 
predefined services cannot be changed.

● Name must start with a 
letter.

● Name must not contain any 
special characters.

● Name must not contain 
more than 20 characters.

● Name must not be 
redundant.

Protocol   Selection of the protocol type ● TCP   
● UDP   
● All

Source port The filtering is based on the specified port number; 
this defines the service access at the frame sender.

Examples: 
*: Port is not checked
20 or 21: FTP service

Destination 
port

The filtering is based on the specified port number; 
this defines the service access at the frame recipient.

Examples: 
*: Port is not checked     
TCP 80: Web HTTP service     
TCP 102: S7 protocol 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  547



Defining ICMP services

How to access this function
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

IP rules".

2. Select the "ICMP" tab. 

Procedure
Using the definition of ICMP services, you can define succinct and clear firewall rules for 
specific services. You select a name and assign the service parameters to it.

These services defined in this way can be grouped together under a group name.

When you configure the packet filter rules, you then use this name.

Parameters for ICMP services

Parameter Meaning/comment Available options / ranges of 
values

Name User-definable name for the service that is 
used as identification in the rule definition or 
in the group. The names of predefined 
ICMPv6 services cannot be modified.

● Name must start with a letter.
● Name must not contain any 

special characters.
● Name must not contain more 

than 20 characters.
● Name must not occur more 

than once
ICMPv6 If you enable this check box, the ICMP service 

is declared as an ICMPv6 service and you can 
select an ICMPv6-specific type and code for 
the service. An ICMPv6 service can only be 
used in the firewall rule of a security module 
that supports IPv6.

● Enabled
● Disabled (default)

Type Type of the ICMPv4 or ICMPv6 message. If the "ICMPv6" check box is 
deselected, ICMPv4-specific 
types can be selected. If the 
check box is selected, ICMPv6-
specific types can be selected.

Code Code of the ICMP type. Values depend on the selected 
type.
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Creating service groups

How to access this function   
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

IP rules".

2. Select the "Service groups" tab.

Forming service groups   
You can put several services together by creating service groups. This allows you set up more 
complex services that you can then use in the packet filter rules simply by selecting the name. 
IPv4 and IPv6 services can be collected in the same service group.

Create groups in the open "Service groups" tab. You can then assign services to a group in 
the "Group management" tab.

Follow the steps below
1. First, create groups in this tab with names to suit your requirements and add a description 

if required.

2. Select the "Group management" tab. You can assign the previously specified IP services 
to the groups defined in this tab.

Managing service groups

How to access this function   
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

IP rules".

2. Select the "Group management" tab.

Forming service groups
You can put several services together by creating service groups. This allows you set up more 
complex services that you can then use in the packet filter rules simply by selecting the name. 
IPv4 and IPv6 services can be collected in the same service group.

Use the "Group management" tab to assign services to a selected group you created previously 
in the "Service groups" tab.

Follow the steps below
1. Select a group created previously in the "Service groups" tab from the "Service groups" 

drop-down list in this tab.

2. Then assign the required services from the right-hand "Available services" list box to the 
group.
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MAC services

Define MAC services

How to access this function
In the global security settings, select the entry "Firewall" > "Services" > "Define services for 
MAC rules".

Meaning
Using the definition of MAC services, you can define succinct and clear firewall rules for specific 
services. You select a name and assign the service parameters to it.

These services defined in this way can be grouped together under a group name.

When you configure the global or local packet filter rules, you use this name.     

Parameters for MAC services 
A MAC service definition is formed using protocol-specific MAC parameters:

Table 8-10 MAC services - parameters

Parameter Meaning/comment Available options / ranges of values
Name User-definable name for the service that is used as 

identification in the rule definition or in the group.
● Name must start with a letter.
● Name must not contain any special 

characters.
● Name must not contain more than 20 

characters.
● Name must not be redundant.

Protocol Name of the protocol type:
● ISO

ISO identifies frames with the following properties:
Lengthfield <= 05DC (hex), 
DSAP= userdefined 
SSAP= userdefined 
CTRL= userdefined

● SNAP
SNAP identifies frames with the following properties:
Lengthfield <= 05DC (hex), 
DSAP=AA (hex),
SSAP=AA (hex), 
CTRL=03 (hex), 
OUI=userdefined, 
OUI-Type=userdefined

● PROFINET IO

● ISO
● SNAP
● PROFINET IO
● 0x (code entry)

DSAP Destination Service Access Point: LLC recipient address  
SSAP Source Service Access Point: LLC sender address  
CTRL LLC control field  

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
550 System Manual, 07/2013,  



Parameter Meaning/comment Available options / ranges of values
OUI Organizationally Unique Identifier

(the first 3 bytes of the MAC address = vendor ID)
 

OUI type Protocol type/identification  
*) The protocol entries 0800 (hex) and 0806 (hex) are not accepted since these values apply to IP or ARP frames.

 
 

 Note
Processing for S7-CPs

Only settings for ISO frames with DSAP=SSAP=FE (hex) are processed. Other frame types 
are not relevant for S7 CPs and are therefore discarded even before processing by the firewall.

 

Special settings for SIMATIC NET services
To filter special SIMATIC NET services, please use the following protocol settings:

● DCP (Primary Setup Tool):  
PROFINET

● SiClock :  
OUI= 08 00 06 (hex) , OUI-Type= 01 00 (hex)

Creating service groups

How to access this function   
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

MAC rules".

2. Select the "Service groups" tab.

Forming service groups   
You can put several services together by creating service groups. This allows you set up more 
complex services that you can then use in the packet filter rules simply by selecting the name.

Create groups in the open "Service groups" tab. You can then assign services to a group in 
the "Group management" tab.

Follow the steps below
1. First, create groups in this tab with names to suit your requirements and add a description 

if required.

2. Select the "Group management" tab. You can assign the previously specified MAC services 
to the groups defined in this tab.
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Managing service groups

How to access this function   
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

MAC rules".

2. Select the "Group management" tab.

Forming service groups
You can put several services together by creating service groups. This allows you set up more 
complex services that you can then use in the packet filter rules simply by selecting the name.

Use the "Group management" tab to assign services to a selected group you created previously 
in the "Service groups" tab.

Follow the steps below
1. Select a group created previously in the "Service groups" tab from the "Service groups" 

drop-down list in this tab.

2. Then assign the required services from the right-hand "Available services" list box to the 
group.

Overview of local firewall rules

Meaning
Local firewall rules are configured in the local security settings of a security module and apply 
only to this security module. After enabling the firewall functionality you can either use 
predefined firewall rules or define firewall rules in the advanced firewall mode.

Using predefined firewall rules
Here, you use simple, predefined rules. You can only enable service-specific rules. The 
enabled services are allowed for all nodes in the specified direction. You can find detailed 
information on the definition of firewall rules in this dialog in the following module-specific 
sections:

● For SCALANCE S: Auto-Hotspot 

● For S7-300 CPs/S7-400 CPs/PC CPs: Auto-Hotspot 

● For S7-1500 CPs: Auto-Hotspot 

Defining firewall rules in advanced firewall mode
In advanced firewall mode, you can make detailed firewall settings. You can allow individual 
services for a single node or all services for the node for access to the station or network. You 
enable the advanced firewall mode using the "Activate firewall in advanced mode" check box. 
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In the local security settings, the firewall rules can then be configured in "Firewall" > "IP rules" 
or "MAC rules". The configuration options available here are described individually in the 
following section:

For IP packet filter rules: Defining IP packet filter rules (Page 553) 

For MAC packet filter rules: Defining MAC packet filter rules (Page 556)
 

 Note
Deactivating the advanced firewall mode not possible

Once you have activated the advanced firewall mode, you can no longer deactivate it.
 

Quantity structure

Number of firewall rules (advanced firewall mode)
SCALANCE S Maximum of 256
S7 CPs Maximum of 256
CP 1628 Maximum of 256

Defining IP packet filter rules

Meaning
With IP packet filter rules, you filter according to IP frames, such as TCP, UDP and ICMP.       

Within a packet filter rule, you can also fall back on the definitions of the IP services.

Entering IP packet filter rules
Enter the firewall rules one by one in the list. Note the following parameter description.
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Table 8-11 IP rules: Parameter

Parameter Meaning/comment Available options / ranges of values
Action Allow/disallow (enable/block) ● Allow

Allow frames according to definition.
● Drop

Block frames according to definition.
For firewall rules generated automatically as result of configuring a connection 
and subsequently adapted manually:
● Allow*
● Drop*

If you change automatically created connection rules, when the "*" option 
is selected they are not recreated and overwritten by STEP 7.

From / To Selection of the 
communications directions 
for which the rule will apply.
 

Described in separate sections.
● For SCALANCE S modules: IP packet filter directions SCALANCE S 

(Page 603)
● For S7-300 CPs/S7-400 CPs/PC CPs: IP packet filter directions S7-300-/

S7-400-/PC-CPs (Page 619)
● For S7-1500 CPs: IP packet filter directions - CP 1543-1 (Page 631)

IPv6 (for the 
CP 1543-1 
only)

If this check box is selected, 
you can use a previously 
defined ICMPv6 service in 
the firewall rule. For the CP 
1543-1 V1.1, after selecting 
the check box you can enter 
additional IPv6 addresses in 
the "Source IP address" and 
"Destination IP address" 
input boxes. For the CP 
1543-1 V1.0, after enabling 
the check box you cannot 
enter any source IP address 
or any destination IP address 
for the firewall rule.

The check box can only be selected and deselected if there are no entries in 
the "Source IP address" and "Destination IP address" input boxes.
If IPv6 is disabled in the local settings of the CP 1543-1, you cannot select 
the "IPv6" check box in the local security settings of the CP and therefore 
cannot use ICMPv6 services or IPv6 addresses in firewall rules. Existing 
firewall rules that use IPv6 are shown grayed out if IPv6 is disabled.

Source IP 
address

The firewall rule is applied to 
the frames whose sender 
has the IP address specified 
here. If you do not specify an 
IP address, the firewall rule 
applies to all nodes in the 
communications direction 
you selected in the "From" 
column.

You can find additional information about IP addresses in the IP addresses 
in IP packet filter rules (Page 557) section.
 

Destination 
IP address

The firewall rule is applied to 
the frames whose recipient 
has the IP address specified 
here. If you do not specify an 
IP address, the firewall rules 
applies to all nodes in the 
communications direction 
you selected in the "To" 
column.
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Parameter Meaning/comment Available options / ranges of values
Service Name of the IP/ICMP service 

or service group used.
Here, you select one of the 
services you defined in the 
"IP services" dialog:
● IP services
or 
● ICMP services
Before you select an ICMPv6 
service, you need to select 
the "IPv6" check box.

The drop-down list box displays the services and service groups configured 
in the global security settings and you can select them.
No entry means: No service is checked, the rule applies to all services.

Bandwidth 
(Mbps)

Option for setting a 
bandwidth limitation
Can only be entered if the 
"Allow" action is selected.
A packet passes through the 
firewall if the allow rule 
matches and the permitted 
bandwidth for this rule has 
not yet been exceeded.

CP x43-1 and SCALANCE S < V3.0: 0.001 ... 100 Mbps
CP 1628 and SCALANCE S ≥ V3.0: 0.001 ... 1000 Mbps
For global and user-specific rules: 0.001 ... 100 Mbps

Logging Enable and disable logging 
for this rule

● Enabled
● Disabled (default)

No. Automatically assigned 
number for the rule

 

Comment Space for your own 
explanation of the rule

If a comment is marked with "AUTO", it was created for an automatic 
connection rule. For rules you have created, entry of a comment is optional.

Table 8-12 Meaning of the entries in the shortcut menu

Entry in the shortcut menu Meaning
Delete This deletes the selected rule or the selected global rule set.

Notes on removing a globally defined and locally assigned rule set:
if you delete a rule set here, this only cancels the assignment to the security 
module.

Save as global rule set (only for local 
firewall rules)

Copies the selected firewall rule and inserts it as a global firewall rule set in the 
global security settings. The firewall configuration currently configured for the 
security module remains unaffected by this procedure.

Move up Use this button to move the selected rule or selected global rule set up one position 
in the list. The rule / rule set you moved is therefore handled with higher priority.

Move down Use this button to move the selected rule or selected global rule set down one 
position in the list. The rule / rule set you moved is therefore handled with lower 
priority.

Define service for IP rules This opens the dialog in which you can manage the IP services and service groups.
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Defining MAC packet filter rules

Meaning
With the MAC packet filter rules, you filter according to MAC frames. 

Within a packet filter rule, you can also fall back on the definitions of the MAC services.

Entering MAC packet filter rules   
Enter the firewall rules one by one in the list. Note the following parameter description.

Table 8-13 MAC rules: Parameter

Parameter Meaning/comment Available options / ranges of values
Action Allow/disallow (enable/block) ● Allow

Allow frames according to definition.
● Drop

Block frames according to definition.
From / To Selection of the communications 

directions for which the rule will 
apply.

Described in separate sections.
● For SCALANCE S modules: MAC packet filter directions 

SCALANCE S (Page 604) 
● For S7-300 CPs/S7-400 CPs/PC CPs: MAC packet filter 

directions S7-300-/S7-400-/PC-CPs (Page 620) 
● For S7-1500 CPs: MAC packet filter directions CP 1543-1 

(Page 631) 
Source MAC 
address

The firewall rule is applied to the 
frames whose sender has the MAC 
address specified here. If you do not 
specify a MAC address, the firewall 
rule applies to all nodes in the 
communications direction you 
selected in the "From" column.

MAC address in the correct format

Destination 
MAC address

The firewall rule is applied to the 
frames whose recipient has the MAC 
address specified here. If you do not 
specify a MAC address, the firewall 
rule applies to all nodes in the 
communications direction you 
selected in the "To" column.

Service Name of the MAC service or service 
group used

The drop-down list box displays the configured services and service 
groups you can select.
If nothing is selected, no service is checked and the rule applies to 
all services.

Bandwidth 
(Mbps)

Option for setting a bandwidth 
limitation. Can only be entered if the 
"Allow" action is selected.
A packet passes through the firewall 
if the allow rule matches and the 
permitted bandwidth for this rule has 
not yet been exceeded.

CP x43-1 and SCALANCE S < V3.0: 0.001 ... 100 Mbps
CP 1628 and SCALANCE S ≥ V3.0: 0.001 ... 1000 Mbps
For global and user-specific rules: 0.001 ... 100 Mbps
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Parameter Meaning/comment Available options / ranges of values
Logging Enable and disable logging for this 

rule.
● Enabled
● Disabled (default)

No. Automatically assigned number for 
the rule

 

Comment Space for your own explanation of 
the rule

If a comment is marked with "AUTO", it was created for an automatic 
connection rule. For rules you have created, entry of a comment is 
optional.

Table 8-14 Meaning of the menu commands

Button Meaning
Delete This deletes the selected rule or the selected global rule set.

Notes on removing a globally defined and locally assigned rule set:
if you delete a rule set here, this only cancels the assignment to the security 
module.

Save as global rule set (only for local 
firewall rules)

Copies the selected firewall rule and inserts it as a global firewall rule set in the 
global security settings. The firewall configuration currently configured for the 
security module remains unaffected by this procedure.

Move up Use this button to move the selected rule or selected global rule set up one position 
in the list. The rule / rule set you moved is therefore handled with higher priority.

Move down Use this button to move the selected rule or selected global rule set down one 
position in the list. The rule / rule set you moved is therefore handled with lower 
priority.

Define service for MAC rules This opens the dialog in which you can manage the MAC services and service 
groups.

IP addresses in IP packet filter rules

Entering IP addresses in IP packet filter rules
In IP packet filter rules, you have the following options for entering IP addresses:

● Nothing specified
The rule applies to all IP addresses.

● An IP address
The rule applies specifically to the specified address.
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● Address range
The rule applies to all the IP addresses covered by the address range.
An address range is defined by specifying the number of valid bit places in the IP address 
in the format: [IP address]/[number of bits to be included]

– [IP address]/24 therefore means that only the most significant 24 bits of the IP address 
are included in the filter rule. These are the first three octets of the IP address.

– [IP address ]/25 means that only the first three octets and the highest bit of the fourth 
octet of the IP address are included in the filter rule.

● Address area
For the source IP address, an address range can be entered in the following format:
[Start IP address]-[End IP address]

IPv4 addresses  
An IPv4 address consists of 4 decimal numbers in the range from 0 to 255 separated from 
each other by a dot.

Table 8-15 Examples of address ranges in IPv4 addresses   

Source IP address or 
destination IP address

Address range Number of 
addresses*)

 from to  
192.168.0.0/16 192.168.0.0 192.168.255.255 65.536
192.168.10.0/24 192.168.10.0 192.168.10.255 256
192.168.10.0/25 192.168.10.0 192.168.10.127 128
192.168.10.0/26 192.168.10.0 192.168.10.63 64
192.168.10.0/27 192.168.10.0 192.168.10.31 32
192.168.10.0/28 192.168.10.0 192.168.10.15 16
192.168.10.0/29 192.168.10.0 192.168.10.7 8
192.168.10.0/30 192.168.10.0 192.168.10.3 4
*) Note: Note that the network address and the broadcast address are not available as IP addresses 
of network nodes in an address range.   

IPv6 addresses 
IPv6 addresses consist of 8 fields each with four hexadecimal numbers (128 bits in total). The 
fields are separated by a colon. IPv6 addresses can only be entered in IP packet filter rules 
for the CP 1543-1 V1.1.

Example: fd00:ffff:ffff:ffff:ffff:ffff:2f33:8f21

Rules / simplifications:
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● Leading zeros within a field can be omitted.
Example: Instead of 2001:0db8:2426:08d3:1457:8a2e:0070:7344 it is also possible to use 
the notation 2001:db8:2426:8d3:1457:8a2e:70:7344.

● If one or more fields have the value 0 (or 0000), a shortened notation is possible.
Example: Instead of 2001:0db8:0:0:0:0:1428:57ab it is also possible to use the notation 
2001:db8::1428:57ab.
To ensure uniqueness, this shortened form can only be used once within the entire address.

● Decimal notation with periods
The last 2 fields or 4 bytes can be written in the normal decimal notation with periods.
Example: The IPv6 address fd00::ffff.125.1.0.1 is equivalent to fd00::ffff:7d01:1.

● Address range notation in IP packet filter rules: In the same way as IPv4 addresses, IPv6 
addresses can also be noted in the form of address ranges.
Example: The entry "2001:0db8:85a3:08d3:1319:8a2e:0:0/96" covers all IPv6 addresses 
from 2001:0db8:85a3:08d3:1319:8a2e:0:0 to 2001:0db8:85a3:08d3:1319:8a2e:ffff:ffff.

Carrying out module-specific log settings

Log settings - overview

Log settings in the configuration
The log settings made here are loaded on the module with the configuration and take effect 
when the security module starts up.

You can restrict the configured packet filter log settings in the online functions if necessary. 
For example, you can use the online functions to specify that merely IP logging is displayed if 
you have configured IP and MAC logging.

Logging procedures and event classes
Here, you can specify which data should be logged. As a result, you enable logging as soon 
as you download the configuration to the security module.

During configuration, you also select one or both of the possible logging procedures:

● Local logging

● Network Syslog

In both logging procedures, the security module recognizes the three following types of events:

● Packet filter events

● Audit events

● System events
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Configuring local logging

How to access this function
1. Select the module to be edited.

2. Select the "Log settings" > "Local log memory" entry in the local security settings.

Configuring local logging

Table 8-16 Local logging - settings for log events

Log event Meaning Comments
Packet filter log (firewall) The packet filter log records certain packets 

of the data traffic. Only those data packets 
for which a configured packet filter rule 
(firewall) applies or to which the basic 
protection reacts (corrupt or invalid 
packets) are logged. This is only possible 
when logging is enabled for the packet filter 
rule.

Packet filter log data is not retentive
The data is stored in volatile memory on the 
security module and is therefore no longer 
available after the power supply has been 
turned off. For retentive storage, you can also 
save the log data displayed in the "Online & 
diagnostics" dialog in a file.

Audit log The logging of audit events is always 
enabled.
The logged information is always stored in 
the ring buffer.
The audit log automatically records 
security-relevant events, for example user 
actions such as activating or deactivating 
packet logging or downloading 
configurations to the security module.

Audit log data is retentive
The data is stored in a retentive memory of 
the security module and is therefore still 
available after turning off the power supply.
Note for CPs:
The audit log files are not retentive on CPs. 
You should therefore use a Syslog server to 
backup this data.

System log The system log automatically logs 
successive system events, for example the 
start of a process or the failed login attempt 
of a user.
Select the "Log settings" > "Configure 
system events" entry to configure the event 
filter and cable diagnostics functions.

System log data is not retentive
The data is stored in volatile memory on the 
security module and is therefore no longer 
available after the power supply has been 
turned off. For retentive storage, you can also 
save the log data displayed in the "Online & 
diagnostics" dialog in a file.

Table 8-17 Local logging - storage of recorded data

Storage Meaning
Ring buffer At the end of the buffer, the recording continues at the start of the buffer 

and overwrites the oldest entries.
One-shot buffer Recording stops when the buffer is full.
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Configuring system events

How to access this function
1. Select the module to be edited.

2. Select the "Log settings" > "Configure system events" entry in the local security settings.

Filtering of the system events
In this dialog, you set a filter level for the system events. As default, the following values are 
set:

● SCALANCE S: Level 3 (Error)

● CP: Level 3 (Error)

The priority of the selected filter level must be the same or lower than the severity set for the 
cable diagnostics; see the "Setting parameters for line diagnostics" table (not for CPs).

Recommendation: Select "Error" as the filter level or a higher value to exclude logging of 
general, uncritical events.

Note for CP
For CPs, select only level 3 or level 6 since only events of these levels are generated for CPs.

● Level 0 to level 3 error messages are output if level 3 is selected.

● If you select level 6, the error messages of levels 0 to 6 are output.

Properties of the system events - line diagnostics (not for CPs)
Line diagnostics generates a special system event. A system event is generated when a 
selectable percentage of bad frames is reached. This system event is assigned the severity 
and facility set in this dialog.

Table 8-18 Setting parameters for line diagnostics

Function / option / parameter Meaning
Enable Enabling and disabling logging
Limit Selectable percentage of faulty frames representing the limit at which 

a system event is triggered.
Facility Select a facility from the drop-down list that identifies the system event 

to be logged.
Severity Using the severity, you weight the system events of line diagnostics 

relative to the severity of the other system events.
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 Note
Severity of the system events of line diagnostics

Make sure that you do not assign a lower severity to the system events of line diagnostics 
than for the filter. At a lower severity, these events will not pass through the filter and will not 
be logged.

 

Configuring the network Syslog

How to access this function
1. Select the module to be edited.

2. Select the "Log settings" > "Network Syslog" entry in the local security settings.

Configuring the network Syslog

Table 8-19 Network Syslog - basic settings

Option / parameter  
Enable network Syslog Enables and disables the transfer of logging events to the Syslog server.
Syslog server Here, enter the IP address of the Syslog server.

The Syslog server must be accessible from the security module at the 
specified IP address and, if applicable, using the router configuration under 
the "Routing" entry of the local security settings. If the Syslog server cannot 
be accessed no Syslog messages are sent. You can recognize this 
operating state on the basis of corresponding system alarms. To activate 
the sending of the Syslog information again, you may have to update the 
routing information and initiate a restart of the security module.

Module name The security module uses the module name shown here as the host name 
for identification with the Syslog server. The module name cannot be 
changed at this point.
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Table 8-20 Network Syslog - settings for log events

Log event Configuring Comments
Packet filter events (firewall) The packet filter log records certain 

packets of the data traffic. Only those 
data packets for which a configured 
packet filter rule (firewall) applies or to 
which the basic protection reacts 
(corrupt or invalid packets) are logged. 
This is only possible if logging is 
activated for the packet filter rule.
Syslog alarms can be classified 
according to their origin and their 
severity level by setting Facility and 
Severity. This assignment is carried 
out with drop-down lists. The severity 
and facility that you set here is 
assigned to every event.   

The value you select here depends on the 
evaluation in the Syslog server.
If you retain the "default" value setting, the 
security module specifies the combination of 
facility and severity with which the event is 
displayed.

Audit events The audit log automatically records 
security-relevant events, for example 
user actions such as activating or 
deactivating packet logging or 
downloading configurations to the 
security module.
Assignment of the severity and facility 
is carried out with drop-down lists. The 
severity and facility that you set here 
is assigned to every event.

The value you select here for the severity and 
facility depends on the evaluation in the 
Syslog server.   
If you retain the "default" value setting, the 
security module specifies the combination of 
facility and severity with which the event is 
displayed.

System events The system log automatically logs 
successive system events, for 
example the start of a process or the 
failed login attempt of a user.

Select the "Log settings" > "Configure system 
events" entry in the local security settings to 
configure the event filter and cable 
diagnostics functions.

Security module as router

Overview of the routing settings

Meaning   
If you operate the security module in routing mode, the networks connected to the internal and 
external ports are transformed into separate subnets.

You have the following additional options:
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● Setting specific routes - can be set in the local security settings under "Routing" 
(SCALANCE S only), see Specifying routes (Page 604) in the section "SCALANCE S".

● Using a standard router - can be set in the local security settings with "External interface 
[P1] red" or Internal interface [P2] green" see subsection Configuring network parameters 
(Page 599) in the section "SCALANCE S".

● NAT/NAPT routing - can be set with "NAT / NAPT" (not for PC CPs and CP 1543-1) in the 
local security settings. To be able to use NAT/NAPT, the security module must be in routing 
mode.

Enabling routing mode (required for SCALANCE S modules only)
If you have enabled routing mode, frames intended for an existing IP address in the subnet 
(internal or external) are forwarded. The firewall rules for the direction of transmission also 
apply.

For this mode, you configure an internal IP address and an internal subnet mask for addressing 
the router in the internal subnet in the local security settings. All network requests that do not 
belong to a subnet are forwarded by the security module to a different subnet.

Note: In contrast to the bridge mode of the security module, VLAN tags are lost in routing mode.

1. Select the "Routing mode" option under "Mode" in the local security settings.

2. In the local security settings, enter an internal IP address and an internal subnet mask for 
addressing the router on the internal subnet in the input boxes under "Internal interface 
[P2] green" > Ethernet addresses".

Overview of NAT/NAPT

Module-specific function
This function is not available for PC CPs and S7-1500 CPs.

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "NAT / NAPT".

3. When required, enable address translation according to NAT(Network Address Translation) 
or NAPT (Network Address Port Translation).

4. Configure the address translation as shown in the following sections.

Address translation with NAT (Network Address Translation)
NAT is protocol for translating addresses between two address spaces. The main task is to 
translate private addresses into public addresses; in other words into IP addresses that are 
used and even routed in the Internet. As a result, the addresses of the internal network are 
not known to the outside in the external network. The internal nodes are only visible to the 
external network by means of external IP address that is specified in the address translation 
list (NAT table).
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If the external IP address is not the address of the security module and if the internal IP address 
is unique, this is known as 1:1 NAT. With 1:1 NAT, the internal address is translated to this 
external address without port translation. Otherwise, n:1 NAT is being used.

Address translation with NAPT (Network Address Port Translation)
The address translation with NAPT changes the target address and the target port to a 
communication relation.

Frames coming from the external network and intended for the external IP address of the 
security module are translated. If the destination port of the frame is identical to one of the 
values specified in the "External port" column, the security module forwards the request to the 
internal nod with the IP address specified in the "Internal IP address" column. As the destination 
port, the port specified in the "Internal port" is used. For the reply, as the source IP address 
and source port, the security module sets the values entered in the "External IP address" input 
box and the "External port" column.

The difference to NAT is that with NAPT ports can also be translated. There is no 1:1 
translation, but rather an n:1 translation of IP addresses. A public IP address is translated into 
a series of private IP addresses with port numbers added.

Consistency check - these rules must be adhered to
When assigning addresses, remember the following rules to obtain consistent entries:

Check / rule Check made
locally project-wide

The configured network ID of the internal subnet must be different from the network 
ID of the external subnet.

 x

The internal IP addresses must not be identical to the IP addresses of the module.  x
Use the part specified by the subnet mask for the IP addresses:
● The external IP address must be in the same subnet range as the configured 

external IP address of the security module.
● The internal IP address must be in the same subnet range as the configured 

internal IP address of the security module.

 x

An IP address used in the NAT/NAPT address conversion list must not be a multicast 
or broadcast address.     

 x

The external ports assigned for the NAPT translation are in the range > 0 and 
≤ 65535.
The ports 123 (NTP), 443 (HTTPS), 514 (Syslog), 500+4500 (IPsec) and 161 
(SNMP) are excluded.           

x  

The external IP address of the security module may only be used for the "to external" 
direction in the NAT table.

x  

The internal IP address of the security module may only be used in the NAT table 
and not in the NAPT table.

 x

Checking for duplicates in the NAT table
An external IP address used in the direction "Dst-NAT (from external)" or "Src-NAT 
+Dst-NAT (external)" may only occur once in the NAT table.

x  
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Check / rule Check made
locally project-wide

Checking for duplicates in the NAPT table
● An external port number may only be entered once.
● The port numbers or port ranges of the external ports must not overlap.

x  

Once the routing mode is activated, the address parameters for the internal interface 
(IP address/subnet) must be assigned to the security module.

x  

Internal NAPT ports can be in the range > 0 and ≤ 65535. x  

See also
Overview of the routing settings (Page 563)

NAT/NAPT routing

Enabling NAT
The input boxes for NAT are enabled. NAT address conversions only take effect with the option 
described below and with entries in the address conversion list. In addition, you must configure 
the firewall accordingly.

The IP address translation can take place via the following interfaces:

● External: The address translation takes place on the external interface

The IP address translation can take place in both directions:

● Destination NAT (Dst-NAT): The IP address translation takes place from external to internal. 
Frames coming from the external subnet are checked for the specified external IP address 
and forwarded with the specified internal IP address into the internal network. Access from 
external to internal via the external address is possible.

● Source NAT (Src-NAT): The IP address translation takes place from internal to external. 
Frames coming from the internal subnet are checked for the specified internal IP address 
and forwarded to the external network with the specified external IP address. Access from 
internal to external is possible. In the external network, the external address is effective.

● Source and Destination NAT (Src-NAT + Dst-NAT): The IP address translation can take 
place from internal or external. Access from internal and external is possible. In the external 
network, the external address is effective.

Possible entries for address translation on the external interface
If the address translation is to take place on the external interface, you have the following 
options.
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Translation type "Dst-NAT (from external)"

Box Possible entries Meaning
External IP address ● IP address in the external subnet

With dynamic address assignment, this 
type of translation does not work.

Destination IP address in the external network via 
which an IP address in the internal subnet will be 
accessed.
If the destination address in a frame matches the 
address entered, the address is replaced by the 
corresponding internal IP address.

Internal IP address ● IP address in the internal subnet The destination IP address is replaced by internal IP 
address. The address translation is from external to 
internal.

Translation type "Src-NAT (to external)"

Box Possible entries Meaning
External IP address ● IP address in the external subnet

● IP address of the security module if 
the option "Allow all internal nodes 
access to the outside" is not 
selected.

With dynamic address assignment, no 
entry is possible.

Entry of the IP address that will be used as the new 
source IP address.
If you enter an address that is not the IP address of the 
security module, it is translated into an alias address. 
This means that the specified address is also registered 
as an address on the external interface. Verify that no IP 
address conflict exists with this address.

Internal IP address ● IP address in the internal subnet The source IP address of the specified internal node is 
replaced by the specified external address.
The IP address translation is therefore from internal to 
external.

● Subnet or IP address range The source IP addresses from the specified subnet or IP 
address range are replaced by the external IP address. 
The source port is replaced.
The range is defined by the subnet address.

The following function can also be enabled:
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● Allow all internal nodes access to the outside
By selecting this option, the internal IP address is translated to the external module IP 
address for all frames sent from internal to external and an additional port number is 
assigned by the module. It is then no longer permitted to use the IP address of the external 
interface in the "External IP address" column. 
This action is illustrated based on the additionally displayed NAT table that can be displayed 
in the local security settings using the "Allow all internal nodes access to the outside" entry. 
The "*" symbol in the "internal IP address" column indicates that all frames transmitted in 
internal to external direction will be translated.

Translation type "Src-NAT + Dst-NAT (external)"

Box Possible entries Meaning
External IP address ● IP address in the external subnet

With dynamic address assignment, this 
type of translation does not work.

The address translation is from internal to external: 
See table "Src-NAT (to external)"
The address translation is from external to internal: 
See table "Dst-NAT (from external)"Internal IP address ● IP address in the internal subnet

Enabling NAPT
The input boxes for NAPT are enabled. NAPT translations only take effect with the option 
described below and with entries in the list. In addition, you must configure the firewall 
accordingly.

Box Possible entries Meaning
External port Port or port range

Example of entering a port range: 
2000:2005

A node in the external network can send a frame to a node in 
the internal subnet by using this port number.

Internal IP 
address

IP address in the internal subnet IP address of the addressed node in the internal subnet.

Internal port Port Port number of a node in the internal subnet.

Configuring time-of-day synchronization

Overview of time-of-day synchronization

Meaning
The date and time are maintained on the security module to verify the validity (time) of a 
certificate and for time stamping log entries. For CPs, time-of-day synchronization is active as 
default.

The following alternatives can be configured:
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● SIMATIC: If the security module receives MMS time-of-day messages, its local time is 
synchronized provided the NTP procedure was not configured (MMS = Manufacturing 
Message Specification).

● NTP: Automatic setting and cyclic synchronization of the time-of-day by means of Network 
Time Protocol server.

 

  Note

Time-of-day synchronization relates solely to the security module and cannot be used to 
synchronize devices in the internal network of the security module. S7 CPs can forward 
the time of day to other modules of the station.

 

  Note
Configuring the firewall for communication with NTP servers

If the NTP server cannot be reached by the security module, you will need to allow the 
frames from the NTP server explicitly in the firewall (UDP, port 123).     

 

Defining an NTP server

Creating NTP servers in the global security settings
In the global security settings only secure NTP servers can be created and assigned CPs. Non-
secure NTP servers for SCALANCE S modules and CPs therefore need to be created in the 
local security settings.

1. Double-click the "NTP" entry in the global security settings.

2. Double-click on the "Add new NTP server" entry.

3. Enter a name for the NTP server (secure).

4. Enter the IP address of the NTP server (secure).

5. Specify the encryption parameters for the NTP server (secure).

Property Meaning
Key ID Numeric value between 1 and 65534.
Authentication Select the authentication algorithm.
Hex/ASCII Select the format for the NTP key.
Key Enter the NTP key with the following lengths:

Hex: 22 ... 40 characters
ASCII: 11 ... 20 characters

6. Assign a CP to the NTP server (secure) you have created, see section:
Assigning the security module to an NTP server (secure) (Page 572).

Creating NTP servers in the local security settings
1. Select the module to be edited.

2. Select the "Time-of-day synchronization" entry in the local security settings.
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3. Select the required synchronization mode.

4. If you have selected the "NTP" synchronization mode, enter a name and the IP address of 
the NTP server.

5. If you have selected the "NTP (secure)" synchronization mode, select an NTP server 
(secure) that you created in the global security settings in the "Name" column.

Configuration limits for NTP servers
The following rules apply when creating NTP servers:

● You can create 32 NTP servers throughout the project.

● You can assign a maximum of 4 NTP servers to one security module.

Importing/exporting NTP servers (secure)
Using the "Import" or "Export" commands in the shortcut menu, you can export the key list of 
the currently selected NTP server (secure) and import the file into an NTP server (secure) or 
vice versa.   

Configuring time-of-day synchronization for a security module

How to access this function   
1. Select the module to be edited.

2. Select the "Time-of-day synchronization" entry in the local security settings.

3. Select the "Activate time-of-day synchronization" check box.

Alternatives for time-of-day synchronization
The following alternatives can be configured:

Table 8-21 Time synchronization for CPs

Possible selection Meaning / effect
SIMATIC If the security module receives MMS time-of-day 

messages, its local time is synchronized provided the 
NTP procedure was not configured (MMS = 
Manufacturing Message Specification).

NTP   Automatic setting and periodic synchronization of the 
time using an NTP server. 

NTP (secure)   Automatic setting and periodic synchronization of the 
time using an NTP server (secure).

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
570 System Manual, 07/2013,  



Table 8-22 Time synchronization for SCALANCE S

Possible selection Meaning / effect
SIMATIC If the security module receives MMS time-of-day 

messages, its local time is synchronized provided the 
NTP procedure was not configured (MMS = 
Manufacturing Message Specification).

NTP Automatic setting of the time using an NTP server.

Selecting the mode of time-of-day synchronization
Follow these steps:

1. Select the synchronization mode.

2. The following configuration options are available to you depending on the selected mode:
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● SIMATIC: For S7 CPs, select whether the S7 CP is to use or forward the time of day. The 
CP 1628 always forwards the time of day. For CPs you also the set direction for forwarding 
the time.
Available directions:

– Automatic (for S7 CPs only): The CP receives the time from the station or from the LAN 
and forwards it to the station or to the LAN. If multiple CPs are being operated in the 
station, this automatic setting can cause collisions. To avoid this, you can specifically 
define the forwarding direction.

– Form station (for S7 CPs only).

– From LAN.

If forwarding of the time of day is enabled, you can use the "Use corrected time" check box 
to specify whether or not a correction factor included in the time-of-day frame is used. For 
the CP 1628, this option is enabled as default and cannot be disabled.

● NTP:

– Time zone: In NTP mode, generally UTC (Universal Time Coordinated) is transmitted. 
This corresponds to GMT (Greenwich Mean Time). The time offset from UTC can be 
set by configuring the local time zone.

– Update interval in seconds: Defines the interval between the time queries in seconds.
 

  Note
Setting the update interval for CPs

If the "Enable security functions" check box is enabled in the local security settings of 
a CP, the setting for the update interval is transferred from the CP's local settings into 
the CP's local security settings.

 

– Time-of-day synchronization on the full minute (only for S7-300 /S7 -400 / PC CPs): 
With this option, you can decide whether or not the time of day is forwarded to the 
communications bus on the full minute. This option is required for certain special 
applications.

– Accept time of non-synchronized NTP servers (only for CPs): Here you can specify 
whether the security module also accepts the time-of-day from non-synchronized NTP 
servers.

– Forward time of day to station (only for S7-300 /S7 -400 / PC CPs): Disable this option 
if the CPU requests the time separately from an NTP server. This prevents the time on 
the CPU obtained directly from the NTP server from being overwritten by the time 
detected in the CP. The accuracy may be reduced slightly due to forwarding via the CP.

– NTP server: Creating NTP servers in the local security settings is described in the 
section Defining an NTP server (Page 569).

Assigning the security module to an NTP server (secure)

Module-specific function
Assigning security modules to globally created NTP servers (secure) is possible only for CPs.
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Requirement
● You have defined an NTP server (secure) in the global security settings.

● "NTP (secure)" is selected as the time-of-day synchronization mode in the local security 
settings of the security module that you want to assign to an NTP server (secure).

Procedure
1. Double-click the "NTP" entry in the global security settings.

2. Double-click the entry "Assign module to an NTP server".

3. From the "NTP Server" drop-down list, select the NTP server (secure) to which you want 
to assign a security module.

4. In the "Available modules" section, select the security module that you want to assign to 
the selected NTP server (secure).

5. Click the  button to assign the selected security module to the selected NTP 
server (secure).

Result
You have assigned the security module to the NTP server (secure). The NTP server (secure) 
is displayed automatically in the local security settings in the list of NTP servers.

Security module as DHCP server

Module-specific function
The use of the security module as a DHCP server is only possible with SCALANCE S modules, 
see subsection:
Auto-Hotspot in the section "SCALANCE S".

Configuring SNMP

Module-specific function
Configuration of SNMP is currently only available for CPs, see section below:

● For S7-300 CPs/S7-400 CPs/PC CPs: Auto-Hotspot

● For S7-1500 CPs: Auto-Hotspot
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Activate Web server on security module

Module-specific function
This function is only available for CP x43-1 Advanced, see subsection:
Activating the Web server on CP x43-1 Advanced (Page 625) in the section "Security for 
S7-300 / S7-400 / PC CPs".

IPsec tunnel: Creating and assigning VPN groups

How to create an IPsec tunnel with VPN groups

Module-specific function
This function is not available for SCALANCE S602 and CP 1543-1 V1.0. CP 1543-1 supports 
this function only as of firmware V1.1. 

Requirement
 

 Note
Current date and current time of day on the security modules

When using secure communication (for example, HTTPS, VPN...), make sure that the 
security modules involved have the current time of day and the current date. Otherwise the 
certificates used are not evaluated as valid and the secure communication does not work.

 

How to access this function   
1. Double-click on the entry "VPN groups" > "Add new VPN group" in the global security 

settings to create a VPN group.

2. Double-click on the entry "VPN groups" > "Assign module to a VPN group" in the global 
security settings and assign the security modules and SOFTNET security client modules 
to the VPN group between which VPN tunnels will be established. Here, note the rules for 
forming VPN groups. You will also find these rules in the section:
Modes of VPN groups (Page 579).
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Display of the VPN groups with their properties
If you select a security module that is in one or more VPN group(s), the properties of the VPN 
group(s) of which the security module is a member are shown in the "Network data" area.

The following properties of the VPN groups are displayed in columns in the "VPN" tab of the 
"Network data" area:

Property/column Meaning
VPN Names of the VPN groups of which the selected 

security module is member
Security module Names of the assigned security modules
Authentication Type of authentication: Preshared key or certificate
Group membership until Date and time up to which the VPN group 

certificate of the security module is valid
Type Model numbers of the assigned security modules
Comment Comment

Setting the life of certificates   
Open the dialog in which you can set the expiry date of the certificate as follows:

1. Select the VPN group you want to edit in the "VPN" tab.

2. In the "Properties" > "General" tab of the Inspector window, select the entry "Authentication".
 

  Note
Expiry of a certificate

Communication through the VPN tunnel continues after the certificate has expired until 
the tunnel is terminated or the SA lifetime expires. For more information on certificates, 
refer to section:
Auto-Hotspot.
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Quantity structure

Number of IPSec tunnels
SCALANCE S612 V2 Maximum of 64
SCALANCE S612 V3 Maximum of 128
SCALANCE S613 Maximum of 128
SCALANCE S623 Maximum of 128
CP x43-1 Advanced Maximum of 32
CP 1628 Maximum of 64
CP 1543-1 V1.1 Maximum of 16

Authentication methods

The following methods are available:   
The authentication method is specified per VPN group and decides the type of authentication 
used.

The following key-based or certificate-based authentication methods are supported:

● Preshared key 
Authentication is achieved using a previously specified character string that is distributed 
to all modules in the group. 
Enter a preshared key in the "Key" field under "Authentication" > "General" in the VPN 
group properties dialog.

● Certificate 
Certificate-based authentication "Certificate" is the default setting. The procedure is as 
follows:

– When a group is created, a CA certificate is generated as a root certificate.

– Each security module that is a member of the VPN group also receives a group certificate 
signed with the key of the CA certificate.

All certificates are based on the ITU standard X.509v3 (ITU, International 
Telecommunications Union).
The certificates are generated by a certificate authority contained in STEP 7. 

 

  Note
Restriction in VLAN operation     

No VLAN tagging is transmitted in IP frames via the VPN tunnel of the security module. 
The VLAN tags included in IP frames are lost when they pass through the security modules 
because IPsec is used to transfer the IP frames. 

As default, no IP broadcast or IP multicast frames can be transferred with IPsec through 
a layer 3 VPN tunnel. Through a layer 2 VPN tunnel of the security module, IP broadcast 
or IP multicast frames are packaged just like MAC packets including the Ethernet header 
in UDP and transferred. With these packets, the VLAN tagging is therefore retained.
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Group properties for selected VPN group

VPN group properties     
 

 Note
Knowledge of IPsec necessary

To be able to set these parameters, you require IPsec experience. If you do not make or 
modify any settings, the defaults apply.

 

The following settings can be configured in the properties of a VPN group:

● Authentication method (entry: "General") 

● IKE settings (entry: "Advanced settings phase 1")  

● IPsec settings (entry: "Advanced settings phase 2")  

How to access this function
1. In the "VPN" tab of the "Network data" area, select the VPN group you want to edit. 

2. In the "Properties" > "General" tab of the Inspector window, select the entry "Authentication".

3. Select whether to use a preshared key or certificate for authentication. For more detailed 
information, refer to section:
Authentication methods (Page 576).

Parameters for advanced settings phase 1 - IKE settings
Phase 1: Key exchange (IKE = Internet Key Exchange):

Here, you set the parameters for the protocol of the IPsec key management. Key exchange is 
handled by means of the standardized IKEv1 method for which you can set the following 
protocol parameters:   

Parameter Description
IKE mode Key exchange method:

● Main mode 
● Aggressive mode 
The difference between the main and aggressive mode is the "identity 
protection" used in the main mode. The identity is transferred encrypted 
in main mode but not in aggressive mode.

DH group phase 1 Diffie-Hellman key agreement:   
● Group 1
● Group 2
● Group 5
Diffie-Hellman groups (selectable cryptographic algorithms in the Oakley 
key exchange protocol).
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Parameter Description
SA lifetime type Phase 1 Security Association (SA):

● Time: Time limit in minutes
The lifetime of the current key material is limited in time. When the time 
expires, the key material is renegotiated.

SA lifetime Numeric value:
Range of values for time: 1440 ... 2500000 minutes (default: 2500000)

Encryption phase 1 Encryption algorithm:
● DES*: Data Encryption Standard (56 bit key length, mode CBC)
● 3DES-168: Triple DES (168-bit key length, mode CBC) 
● AES-128, 192, 256: Advanced Encryption Standard (128 bit, 192 bit 

or 256 bit key length, mode CBC)    
Authentication phase 1 Authentication algorithm:

● MD5: Message Digest Algorithm 5
● SHA1: Secure Hash Algorithm 1

*DES is an insecure encryption algorithm. It should only be used for reasons of down 
compatibility. DES is not supported by the CP 1543-1 V1.1.

Parameters for advanced settings phase 2 - IPsec settings
Phase 2: Data exchange (ESP = Encapsulating Security Payload)

Here, you set the parameters for the protocol of the IPsec data exchange. The data exchange 
is in "quick mode". The entire communication during this phase is encrypted using the 
standardized security protocol ESP for which you can set the following protocol parameters:   

Parameter Description
SA lifetime type Phase 2 Security Association (SA):

● Time: Time limit in minutes. The lifetime of the current key material is 
limited in time. When the time expires, the key material is renegotiated.

● Limit: Limitation of the data volume in MB
SA lifetime   Numeric value:

● Range of values for time: 60 ... 16666666 minutes (default: 2880)
● Range of values for limit: 2000 ... 500000 MB (default: 4000)

Encryption phase 2 Encryption algorithm:
● DES*: Data Encryption Standard (56 bit key length, mode CBC)    
● 3DES-168: Triple DES (168-bit key length, mode CBC)
● AES-128: Advanced Encryption Standard (128-bit key length, mode 

CBC)
Authentication phase 2 Authentication algorithm:

● MD5: Message Digest Algorithm 5 
● SHA1: Secure Hash Algorithm 1 

Perfect Forward Secrecy   Select whether or not before each time an IPsec-SA is renegotiated, the 
key is negotiated again using the Diffie-Hellman method. Perfect Forward 
Secrecy safely prevents the new key from being derived from keys 
generated previously.
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*DES is an insecure encryption algorithm. It should only be used for reasons of down 
compatibility. DES is not supported by the CP 1543-1 V1.1.

Modes of VPN groups

VPN modes
Depending on the mode of the security modules that were added to a VPN group, different 
modes of VPN groups are distinguished. The mode of a VPN group provides information about 
the security modules and their modes that can be added to the VPN group.

Rules for forming groups
Remember the following rules if you want to create VPN groups:

● For SCALANCE S612/S613/S623
The first module assigned in a VPN group decides which other modules can be added to 
it.
If the first SCALANCE S module added is in routing mode, you can only add other 
SCALANCE S modules that have routing mode enabled on them. If the first SCALANCE 
S module added is in bridge mode, you can only add other SCALANCE S modules in bridge 
mode. If you want to change the mode of a VPN group, you have to remove all the modules 
contained in the group and add them again. A CP can be added to a group with a 
SCALANCE S in bridge or routing mode.

● For CPs
If a CP is inserted as the first module in a VPN group, the next security module to be inserted 
decides the VPN group mode. A CP can be assigned to several VPN groups at the same 
time and use different modes. The CP is then operated in mixed mode.   

● It is not possible to add a SCALANCE M module to a VPN group that contains a module in 
bridge mode.

Refer to the following table to see which modules can grouped together in a VPN group:

Table 8-23 Security modules and VPN modes

Module Can be included in a VPN group in...
Bridge mode Routing mode

SCALANCE S612/S613/S623 in bridge mode x -
SCALANCE S612/S613/S623 in routing mode - x
CP x43-1 Adv. x x
CP 1543-1 V1.1 x x
CP 1628 x x
SOFTNET Security Client V4.0 x x
SCALANCE M875/MD741-1 - x
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Including security module in configured VPN group
The configured VPN group properties are adopted for security modules added to in an existing 
VPN group. 

Procedure after including a security module in a configured VPN group
Depending on whether or not you have changed the VPN group properties since the last 
download, you must make a distinction between the following:

● Case a: If you have not changed the VPN group properties and the module to be added 
actively establishes the connection to the configured modules:

1. Add the new security module to the VPN group.

2. Download the configuration to the new module.

● Case b:If you have changed the VPN group properties or the module being added does 
not actively establish the connection to the already configured modules:

1. Add the new security module to the VPN group.

2. Download the configuration to all modules that belong to the VPN group.

In case a, it is not necessary to reconfigure and load the already commissioned security 
modules. Active communication is not influenced or interrupted.

Settings for nodes with an unknown IP address   
Nodes whose IP address is unknown at the time of configuration (unknown peers) can be 
inserted in an existing VPN group. Since the nodes are usually mobile and obtain their IP 
addresses dynamically (for example a SOFTNET security client or SCALANCE M), the VPN 
tunnel can only be established if you set the parameters for Phase 1 according to one of the 
following tables (1-23 to 1-27). If you use other settings, you cannot establish a VPN tunnel to 
the end device.   

Table 8-24 Encryption parameter 1

Parameter Setting
Authentication method Certificate
DH group phase 1 Group 2
SA lifetime 1440 … 2500000 minutes
Encryption phase 1 AES-256
Authentication phase 1 SHA-1

Table 8-25 Encryption parameter 2

Parameter Setting
Authentication method Certificate
DH group phase 1 Group 2
SA lifetime 1440 … 2500000 minutes
Encryption phase 1 3DES-168
Authentication phase 1 SHA-1
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Table 8-26 Encryption parameter 3

Parameter Setting
Authentication method Certificate
DH group phase 1 Group 2
SA lifetime 1440 … 2500000 minutes
Encryption phase 1 DES
Authentication phase 1 MD5

Table 8-27 Encryption parameter 4

Parameter Setting
Authentication method Preshared key
DH group phase 1 Group 2
SA lifetime 1440 … 2500000 minutes
Encryption phase 1 3DES-168
Authentication phase 1 SHA1

Additional restrictions for the SOFTNET Security Client
For the SOFTNET security client, the following restrictions also apply:

Table 8-28 Encryption parameters for the SOFTNET Security Client

Parameter Setting / special feature
Encryption phase 1 AES-256 possible only with Windows 7
SA lifetime phase 1 1440 to 2879 minutes
SA lifetime type Must be selected identical for both phases
Encryption phase 2 No AES 128 possible
SA lifetime phase 2 1440 to 2879 minutes
Authentication phase 2 No MD5 possible

Procedure after removing an active member from a VPN group  
If you remove an active node from an existing VPN group, this can still establish a connection 
to the group members even if you have downloaded the project to all members of the VPN 
group again.

If you do not want the removed active node to be able to establish the connection any longer, 
renew the CA group certificate and download the project again to the members of the VPN 
group. The certificate can be renewed in the group properties of the VPN group or in the "CA" 
tab of Certificate Manager. 
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Configuring internal network nodes

Overview of configuring internal network nodes

Configuring internal network nodes   
Each security module must know the network nodes in the entire internal network to be able 
to recognize the authenticity of a frame.

The security module must know both its own internal nodes as well as the internal nodes of 
the security modules in the same VPN group. This information is used on a security module 
to decide which data packet will be transferred in which tunnel.

SCALANCE S modules allow network nodes to be learned automatically or configured 
statically. The mode of the security module also decides the options available for learning 
internal network nodes.  

SCALANCE S in bridge mode
In bridge mode, you can configure the internal IP/MAC nodes and the internal subnets or 
alternatively can allow automatic learning of internal nodes by the SCALANCE S.

SCALANCE S in routing mode
In routing mode there is no automatic learning mode available. Instead, enter entire subnets 
here that need to be released for tunnel communication.

CP x43-1 Advanced and CP 1628
● CP x43-1 Adv.

Decide whether or not tunnel communication to the CP (Gbit interface) and/or to the internal 
subnet (PROFINET subnet) is permitted for VPN connection partners in routing mode 
(SCALANCE S / M).

● CP 1628
Enter the NDIS nodes you want to be reachable through the tunnel of VPN connection 
partners in routing mode (SCALANCE S / M).

Automatic learning of internal network nodes

Module-specific function
SCALANCE S modules in bridge mode provide a learning mode with which the internal network 
nodes can be learned automatically during operation. For more detailed information, refer to 
subsection:
Using the learning mode to learn internal nodes (Page 608) in the section "SCALANCE S".
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Configuring IP network nodes manually for SCALANCE S

Module-specific function
How to configure IP network nodes for SCALANCE S modules manually is explained in:
Configuring IP network nodes manually (Page 610) in the section "SCALANCE S".

Configuring MAC network nodes manually for SCALANCE S

Module-specific function
How to configure MAC network nodes for SCALANCE S modules manually is explained in 
Configuring MAC network nodes manually (Page 610) in the section "SCALANCE S".

Configuring internal subnets for SCALANCE S manually

Module-specific function
How to configure the internal subnets for SCALANCE S modules is explained in 
Configuring internal subnets manually (Page 611) in the section "SCALANCE S".

Allow access to S7-300 / S7-400 CPs for VPN connection partners

Module-specific function
How to allow access to S7-300 / S7-400 CPs for VPN connection partners is explained in 
Allow access to S7-300 / S7-400 CPs for VPN connection partners (Page 626) in the section 
"Security for S7-300 /S7-400 /PC CPs".

Configuring NDIS nodes for PC CPs that can be reached through the tunnel

Module-specific function
How you configure NDIS nodes for PC CPs that can be reached through the tunnel is explained 
in 
Configuring NDIS nodes manually for PC CPs that can be reached through the tunnel 
(Page 626) in the section "Security for S7-300 / S7-400 / PC CPs".

Configuring module- and connection-specific VPN settings

Requirement
The module is a member of a VPN group.
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Module- and connection-specific settings
With module- and connection-specific settings, you can configure specific VPN settings. 
Module-specific settings are configured specifically for a security module while connection-
specific settings are configured specifically for a security module in a certain VPN group.

You can configure the following module-specific properties in the local security settings with 
the "VPN" entry:

● Dead peer detection

● Permission to initiate connection establishment

● Public IP address for communication via Internet gateways

If you select a security module in the list of VPN groups in the "Network data" area, the following 
connection-specific VPN settings can be seen and can be configured:

● Permission to initiate connection establishment

● Partner modules to which tunnel connections exist

● Type of transferred packets

● Selection of the local interface of the selected security module that will serve as the tunnel 
endpoint

● Selection of the partner interface that will serve as the tunnel endpoint

Dead peer detection (DPD)   
As default, DPD is enabled.

When DPD is enabled, the modules exchange additional messages at selectable intervals if 
no communication occurs at these points in time. This means that it is possible to recognize 
whether the IPsec connection is still valid or possibly needs to be re-established. If there is no 
longer a connection, the security associations (SA) of phase 2 are terminated prematurely. If 
DPD is disabled, the SA is ended only after the SA lifetime has expired. For information on 
setting the SA lifetime, see section 
Group properties for selected VPN group (Page 577).
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Permission to initiate connection establishment
You can restrict the permission for initiating the VPN connection establishment to certain 
modules in the VPN.

The decisive factor the setting of the parameter described is the assignment of the IP address 
for the gateway of the module you are configuring. If a static IP address is assigned, the module 
can be found by the partner. If the IP address is assigned dynamically and therefore changes 
constantly, the partner cannot establish a connection as things stand.

Mode Meaning
Start connection to partner (initiator/
responder) (default)

If this option is selected, the module is "active", in other 
words, it attempts to establish a connection to the partner 
with a fixed IP address.
This option is recommended when you obtain a dynamic IP 
address from the provider for the gateway of the security 
module you are configuring.
The partner is addressed over its external module IP 
address or its configured WAP IP address.

Wait for partner (responder) If this option is selected, the module is "passive", in other 
words, it waits for the partner to initiate the connection.
This option is recommended when you have been assigned 
a static IP address by the provider for the gateway of the 
security module you are configuring. It means attempts to 
establish a connection can only be initiated by the partner. 
This partner can, for example, have a dynamic WAN IP 
address.

 

 Note

Make sure that you do not set all the modules in a VPN group to "Wait for connection from 
remote VPN gateway" otherwise no connection is established.

 

WAN IP address - IP addresses of the modules and gateways in a VPN over Internet   
When operating a VPN with IPsec tunnel over the Internet, additional IP addresses are 
generally required for the Internet gateways such as DSL routers. The individual security or 
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SCALANCE M modules must know the external IP addresses of the partner modules in the 
VPN.

 

 Note

To use a WAN as an external public network, enter the IP address that you received from 
the provider as the external IP address, through which the security module is then reachable 
in the WAN (Internet). To allow the security module to send packets via the WAN, you need 
to enter your DSL router as "Standard router".

If you use a DSL router as Internet gateway, the following ports (at least) must be opened on 
it:
● Port 500 (ISAKMP)    
● Port 4500 (NAT-T)

 

To allow this, when you configure the module, you have the option of assigning an external IP 
address as a "WAN IP address". When you download the module configuration, the group 
members are then informed of the WAN IP addresses of the partner modules. If you do not 
enter a WAN IP address, the external IP address of the module is used. Whether the external 
IP address or the WAN IP address is used can be selected in module-specific VPN settings 
of the security module. In these settings, you can also specify the interface to be used for 
communication by the nodes of a VPN group and the security module that is authorized to set 
up connections.

WAN

① Internal IP address - of a module
② External IP address - of a module
③ IP address of an Internet gateway (for example, GPRS gateway)
④ IP address (WAN IP address) of an Internet gateway (for example, DSL router)
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See also
How to create an IPsec tunnel with VPN groups (Page 574)

Online functions - test / diagnostics and logging

Overview of diagnostics and logging in
For test and monitoring purposes, the security module has diagnostic and logging functions.     

● Diagnostic functions
These include various system and status functions that you can use for an existing network 
connection to the security module.

● Logging functions
This involves the logging of system and security events and data packets. 

Recording events with logging functions
You select the events to be logged in the log settings for the relevant security module.

You can configure the following variants for logging:

● Local logging 
In this variant, you log events in the local buffer of the security module. You can then access 
these logs, display them and archive them on the service station in the "Online & 
diagnostics" dialog. The evaluation of the buffer areas of the security module is only 
possible if there is a network connection to the selected security module.

● Network Syslog 
With Network Syslog, you use a Syslog server that exists in the network. This logs the 
events according to the configuration in the log settings for the relevant security module.   

Archiving log data and reading in from a file
You can save the logged events for archiving in a log file and open this later even without a 
network connection to the security module. For more detailed information, refer to section 
Auto-Hotspot.
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Overview of the functions in the online dialog

Functions of the "Online & diagnostics" dialog
In STEP 7, the security module provides the following functions in the "Online & diagnostics" 
dialog:

Entry in the online dialog Function
Status Display of status information about the selected security module, such as the 

current IP addresses of the interfaces and the current time and date.
System log Display of logged system events, starting and stopping logging (only if there is 

an online connection to SCALANCE S modules) and starting and stopping the 
reading out of log data from the local buffer of the security module.

Audit log Display of logged security events, starting and stopping reading out of log data 
from the local buffer of the security module.

Packet filter log Display of logged data packets, starting and stopping logging (only if there is 
an online connection to SCALANCE S modules) and starting and stopping the 
reading out of log data from the local buffer of the security module.

Communication status (not for SCALANCE 
S602 and CP 1543-1 V1.0)

Display of status information about VPN tunnel connections and members of 
VPN groups to which the selected security module belongs.

Internal nodes (not for SCALANCE S602 
and PC CPs)

Display of the learned or configured internal network nodes of the security 
module.

Dynamically updated firewall rules (only for 
S7 CPs)

Display of the IP addresses that were released dynamically over HTTP or 
HTTPS, or loaded by a user.

Date and time (SCALANCE S only) Date and time setting.

Requirements for access
The following requirements must be met to use the online functions of a security module:

● There is a network connection to the selected module

● The project with which the module was configured is open

● a user with the required rights must be logged in in the project

● an online connection to the security module using HTTPS exists

How to access this function
1. Right-click on the module to process.

2. Select the "Online & diagnostics" command from the shortcut menu. 
As soon as you select one of the entries for logging functions, you will see the current status 
of the logging function of the selected security module in the lower area:
Memory settings: Circular buffer / linear memory
The current logging status is derived from the loaded configuration or from the previous 
online diagnostics data.
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Online settings are not saved in the configuration
Settings that you make in online mode (for example settings for the logging memory) are not 
stored in the configuration on the security module. This is why the configuration settings are 
always applied at the restart of the module.

Functions of the online diagnostics

Status information of the security module - "Status" entry

Meaning
Display of the status of the security module selected in the project. 

Table 8-29 Online & diagnostics: - "Status" entry

System and status functions Meaning
Overview
Hardware type The type of the security module.
External IP address The external IP address of the security module.

For CP 1628: The IP address of the Industrial 
Ethernet interface.
For S7 CPs: The IP address of the Gbit interface.

Internal IP address The internal IP address of the security module.
For CP 1628: The IP address of the NDIS 
interface. If there is more than one NDIS address, 
only one is displayed.
For S7 CPs: The IP address of the PROFINET 
interface.

Serial number The serial number of the security module.
Order number The MLFB identifier of the security module that is 

used when ordering.
Firmware version The firmware version of the security module.
Operating mode Setting in for interface routing
External MAC address The external MAC address of the security module.

For CP 1628: The MAC address of the Industrial 
Ethernet interface.
For S7 CPs: The MAC address of the Gbit 
interface.

Internal MAC address The internal MAC address of the security module.
For CP 1628: The MAC address of the NDIS 
interface.
For S7 CPs: The MAC address of the PROFINET 
interface.

Hardware release The hardware product version of the security 
module.

C-PLUG Shows whether or not a C-PLUG is inserted.
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System and status functions Meaning
Local time
Current time Date and time that is displayed on the security 

module.
Format for "German" user interface language: 
dd.mm.yyyy (date) hh:mm:ss (time)
Format for "English" user interface language:
mm/dd/yyyy (date) hh:mm:ss AM/PM (time)
Format for "French" user interface language:
dd/mm/yyyy (date) hh:mm:ss (time)
Format for "Italian" user interface language:
dd/mm/yyyy (date) hh:mm:ss (time)
Format for "Spanish" user interface language:
dd/mm/yyyy (date) hh:mm:ss (time)
Note (not for CPs)
You set the local time on the SCALANCE S module 
in "Functions" > "Date and time".

Operating time Time since the last restart of the security module.
Format for "German" user interface language: 
dddd.hh:mm:ss
Format for "English" user interface language: 
dddd.hh:mm:ss
Format for "French" user interface language: 
dddd.hh:mm:ss
Format for "Italian" user interface language: 
dddd.hh.mm.ss
Format for "Spanish" user interface language: 
dddd.hh:mm:ss

Time-of-day source The source from which the date and time are 
obtained.

Configuration
Created
 

Date and time when the project was first created. 
Format for "German" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)
Format for "English" user interface language: 
dddd.hh:mm:ss hh:mm:ss AM/PM (time)
Format for "French" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)
Format for "Italian" user interface language: 
dddd.hh.mm.ss hh.mm.ss (time)
Format for "Spanish" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)

Name File name under which the project was last saved. 
The name is set by default by STEP 7 and is 
changed when you rename the project.

Author Name of the user who created the project. Is 
adopted from the project properties.
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System and status functions Meaning
Loaded Date and time when the project was last loaded 

on the security module. 
Format for "German" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)
Format for "English" user interface language: 
dddd.hh:mm:ss hh:mm:ss AM/PM (time)
Format for "French" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)
Format for "Italian" user interface language: 
dddd.hh.mm.ss hh.mm.ss (time)
Format for "Spanish" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)

Storage location Location entered from the project properties. The 
location is transmitted along with the configuration 
download to the security module.

File system (not for CPs)
RAM Graphic and percentage display of how much 

RAM and flash is occupied in the file system.Flash

VPN connections of the security module - "Communication status" entry

Module-specific function
This function is not available for SCALANCE S 602 modules.

Meaning   
Display of the communication status of the following network components:

● Other security modules of the VPN group to which the selected security module belongs

● Internal network nodes of these security modules
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Table 8-30 Online & diagnostics: "Communication Status" entry

System and status functions Meaning
Known security devices or modules Display of the nodes with which the selected 

security module is in a VPN group. This also 
shows whether the tunnel status is active or 
passive. To obtain additional information on one 
of the nodes, select this in the list. 
Note:
Configured, inactive tunnels are indicated for CPs 
only.

Endpoints Display of information on the internal network 
nodes of the security module that you selected in 
the "Known security devices or modules" table. 
For each internal network node, this shows 
whether it was learned or configured. It also shows 
the subnet in which the internal network node is 
located.
With SCALANCE S modules, the subnet of 
network nodes is only displayed in bridge mode.

Tunnel properties Display of properties of the VPN tunnel 
established to the security module that you 
selected in the "Known security devices or 
modules" table.

Found internal network nodes - "Internal nodes" entry

Module-specific function
This function is not available for SCALANCE S602 modules and CP 1543-1.

Meaning
Display of all learned and configured network nodes. This also displays whether or not the 
learning mode of the security module is enabled.   

Updated firewall rules - "Dynamically updated firewall rules" entry

Module-specific function
This function is only available for S7 CPs, see
Updated firewall rules - "Dynamically updated firewall rules" entry (Page 626) in the section 
"Security for S7-300 / S7-400 / PC CPs".
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Setting the date and time - "Date and Time" entry

Module-specific function
This function is available only for SCALANCE S modules, see section 
Setting the date and time - "Date and time" entry (Page 612).

Logging functions

Logging system events - "System log" entry

Meaning       
Display of logged system events and starting and stopping reading system events from the 
local memory of the security module.

The system log automatically logs successive system events, for example the start of a 
process. The logging can be scaled based on event classes.

System and status functions Meaning
Start/stop logging (not for CPs) Starts/stops recording of system events. The 

method and the event classes that are logged are 
configured in the local security settings.

Start/stop reading Starts/stops reading of system events from the 
local memory of the security module. If you select 
the "Save log file" check box, the recorded log data 
is also saved as file. Select the storage location 
and enter a file name.
Note
If you select the "Save log file" check box after 
starting reading, the data read out up to then can 
no longer be saved in a log file.

Clear display Deletes the log data shown in the table.

For more information on opening saved system events in log files, refer to section
Evaluating system events in offline mode - "System log" entry (offline view) (Page 595).

Logging security events - "Audit log" entry

Meaning       
Display of logged security events and starting and stopping reading of security events from 
the local memory of the security module.

The audit log automatically logs successive security-relevant events. This includes, for 
example, user actions such as enabling and disabling packet logging.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  593



System and status functions Meaning
Start/stop reading Starts/stops reading of security events from the 

local memory of the security module. If you select 
the "Save log file" check box, the recorded log data 
is also saved as file. Select the storage location 
and enter a file name.
Note
If you select the "Save log file" check box after 
starting reading, the data read out up to then can 
no longer be saved in a log file.

Clear display Deletes the log data shown in the table.

For more information on opening security events stored in log files, refer to section 
Evaluating security events in offline mode - "Audit log" entry (offline view) (Page 595).

Logging data packets - "Packet filter log" entry

Meaning     
Display of logged data packets and starting and stopping reading of packet filter events.

The packet filter log records certain packets of the data traffic. Data packets are only logged 
if they match a configured packet filter rule (firewall) or to which the basic protection reacts 
(corrupt or invalid packets). This is only possible when logging is enabled for the packet filter 
rule. 

For information about activation of the logging, refer to section 
Auto-Hotspot.

As well as reading the log data from the buffer and transferring it to the display, it can also be 
saved in a file for archiving.

System and status functions Meaning
Start/stop logging (not for CPs) Starts/stops logging of data packets. The method 

with which the data is logged is configured in the 
local security settings.

Start/stop reading Starts/stops reading out of logged data packets 
from the local memory of the security module. If 
you select the "Save log file" check box, the 
recorded log data is also saved as file. Select the 
storage location and enter a file name.
Note
If you select the "Save log file" check box after 
starting reading, the data read out up to then can 
no longer be saved in a log file.
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System and status functions Meaning
Clear display Deletes the log data shown in the table.
Log category Select the data packets for which the logging will 

be displayed. The selection depends on the 
settings you configured offline in the local security 
settings. Only the data packets for which logging 
was enabled are logged. If you select a category 
for which logging was not enabled, no data will be 
logged for this category.

For information on opening the stored packet filter log data, refer to section 
Evaluating packet filter events in offline mode - "Packet filter log" entry (offline view) 
(Page 596).

Evaluating log files in offline mode

Evaluating system events in offline mode - "System log" entry (offline view)

How to access this function
1. Right-click on the module to process.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. Select "Diagnostics" > "Log files (offline view)" > "System log".

Meaning       
Opens logged system events that you saved as a file in the online view.

For more information, refer to chapter Logging system events - "System log" entry (Page 593).

Evaluating security events in offline mode - "Audit log" entry (offline view)

How to access this function       
1. Right-click on the module to process.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. Select "Diagnostics" > "Log files (offline view)" > "Audit log".

Meaning
Opens logged security events that you saved as a file in the online view.

For more detailed information, refer to section Logging security events - "Audit log" entry 
(Page 593).
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Evaluating packet filter events in offline mode - "Packet filter log" entry (offline view)

How to access this function
1. Right-click on the module to process.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. Select "Diagnostics" > "Log files (offline view)" > "Packet filter log".

Meaning     
Opens logged data packets that you saved as a file in the online view.

For more detailed information, refer to section Logging data packets - "Packet filter log" entry 
(Page 594).

Download functions

Special features when downloading security configurations 
Security configurations can influence the reachability of the security module for the 
configuration PC. This, for example, is the case if there is a tunnel connection configured for 
one security module to another security module in a configuration and this configuration is 
downloaded from the configuration PC to the security module. After the download by the 
configuration PC, the security module can no longer be reached and the reachability test 
performed as default by STEP 7 following the download of the configuration fails. The error 
message output by STEP 7 relates solely to the reachability test; the actual download of the 
configuration is ensured if the project data is consistent and the IP address relationship 
between the security module and the configuration PC is correct.

Special features when downloading configurations and firmware to SCALANCE S modules 
are described in the following subsection of the section "SCALANCE S":
Auto-Hotspot

SOFTNET Security Client

Using the SOFTNET Security Client

Area of application - access over VPN   
With the SOFTNET Security Client (SSC) PC software, secure remote access is possible from 
PGs/PCs to automation systems protected by a security module via public networks. You 
require SOFTNET Security Client V4.0 HF1 for S7-300/S7-400 CPs and for the PC CP 1628. 
These CPs are not approved for operation with SOFTNET Security Client ≤ V4.0. The 
SOFTNET Security Client has not been released for the CP 1543-1.

With the SOFTNET Security Client, a PG/PC is configured automatically so that it can establish 
a secure IPsec tunnel communication in the VPN (Virtual Private Network) with one or more 
security modules.
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This IPsec tunnel communication makes it possible for PG/PC applications such as NCM 
diagnostics to securely access devices or networks that are located in an internal network 
protected by SCALANCE S.

How does the SOFTNET Security Client work?
The SOFTNET Security Client reads the configuration that was created by STEP 7 and 
determines from the file which certificates are to be imported.

The CA certificate and, when applicable, the private key are imported and stored on the local 
PG/PC. 

Following this, security settings are made based on the data from the configuration so that 
applications can access IP addresses downstream from the security modules.

If the learning mode is enabled for the internal nodes or programmable controllers, a security 
policy is first set for secure access to security modules. Then, the SOFTNET Security Client 
addresses the security modules in order to obtain the IP addresses of the relevant internal 
nodes.

The SOFTNET Security Client enters these IP addresses in special filter lists belonging to this 
security policy. Applications can then communicate with the programmable controllers via VPN.

Creating a configuration file in STEP 7

Configuring a SOFTNET Security Client module in the project     
The SOFTNET security client is created as a module in the project. In contrast to the other 
security modules, you do not need to configure any further properties.

Assign the SSC module to the VPN group or groups at which an IPsec tunnel to the PG/PC is 
to be set up.

 

 Note

Refer to the information on parameters in section 
Including security module in configured VPN group (Page 580).

 

 Note

If you create several SOFTNET Security Clients within a group, no tunnels are set up between 
these clients but only from the relevant client to the security modules.

 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  597



Configuration files for the SOFTNET Security Client   
The interface between STEP 7 as configuration tool and the SOFTNET Security Client is 
controlled by configuration files.

The configuration is stored in the following file types:

● *.dat 

● *.p12 

● *.cer 

Procedure
To generate the configuration files, perform the following steps in STEP 7:

1. In the "Devices & networks" view, select the "Topology view" or the "Network view" tab.

2. Insert a PC system of the type "SOFTNET Security Client" in the selected tab from the 
hardware catalog.

3. Assign the SOFTNET Security Client to the VPN groups in which the PG/PC will 
communicate over IPsec tunnels.

4. Make sure that the "Generate SSC files" check box is selected under the "Configuration of 
the SOFTNET Security Client" entry in the local security settings of the SOFTNET Security 
Client.

5. Select the storage location for the configuration files.

6. Compile the configuration of the SOFTNET Security client to export the configuration file.

7. If you selected certificate as the authentication method, specify a password for the 
certificate of the VPN configuration. If you do not assign a password, the project name (not 
the project password) is used as the password.
Result: Export of the configuration files is completed.

8. Adopt the files of the type *.dat, *.p12, *.cer on the PG/PC on which you want to operate 
the SOFTNET Security Client.
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SCALANCE S

Configuring the mode and network parameters for SCALANCE S modules 

Setting the operating mode

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "Mode".

Operating mode - possible selections
You can change the operating mode in this dialog if the security module is not included in a 
VPN group. The selection is valid for port 1 and for port 2.

If the security module is in a VPN group, the mode cannot be changed.

Bridge mode For operation in flat networks. External and internal port are 
in the same IP subnet. Only the external port can be 
configured.

Routing mode The external and internal port are operated on different IP 
subnets. If you have activated the routing mode, you must 
configure an internal IP address and subnet mask for the port 
of the security module.
Note
If you have enabled the routing mode for the SCALANCE S 
module, no MAC firewall rules can be defined.

Configuring network parameters

Meaning
Specify network parameters such as the IP address and subnet mask for the interface(s) of 
the security module.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  599



How to access this function
1. Select the module to be edited.

2. Select "External interface [P1] red" > "Ethernet addresses" in the local security settings.
 

  Note
Configuration of the internal interface in routing mode

If you have selected the "Routing" mode for the security module, you must also configure 
an internal IP address and subnet mask for the internal interface of the security module. 
You can access this function in the local security settings under "Internal interface [P2] 
green" > Ethernet addresses".

 

3. Complete the settings specified in the following table.

Parameter Meaning
IP address IP address for the external interface.

The IP address consists of four decimal numbers from 0 to 
255, with each number being separated by a period, for 
example, 141.80.0.16.

Subnet mask The subnet mask consists of four decimal numbers that are 
separated by period, for example, 255.255.0.0

Use router Select this check box if you want to use a standard router and 
enter its IP address in the "Router address" input box.

Port settings

Default "Autonegotiation" setting
The ports of the security modules are set to "Autonegotiation" by default. In "Autonegotiation" 
mode, the transmission speed and duplex mode are selected automatically. Moreover, the 
auto-crossing function is supported.

Setting up a firewall

Local firewall rules for SCALANCE S modules

Configuring a firewall with predefined firewall rules

Configuring a firewall using predefined firewall rules

How to access this function
1. Select the module to be edited.

2. Select the "Firewall" entry in the local security settings.
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Firewall enabled as default     
The "Enable firewall" check box is enabled by default. The firewall is therefore activated 
automatically and all internal to external access and vice versa is inhibited. By clicking the 
relevant check box, enable the firewall rules for the specific direction.

 

 Note
Detailed firewall settings in advanced firewall mode

In advanced firewall mode, you can restrict firewall rules to individual nodes. To change to 
advanced firewall mode, select the "Enable firewall in advanced mode" check box. For more 
detailed information about the advanced firewall mode, refer to the section 
Overview of local firewall rules (Page 552)

 

Firewall configuration with VPN     
If the security module is in a VPN group, the "Tunnel communication only" check box is enabled 
as default. This means that only encrypted IPsec data transfer is permitted via the external 
interface.

If you deselect the check box, tunneled communication and also the types of communication 
selected in the other boxes are permitted.

Table 8-31 Available firewall rules and directions

Service Internal 
to 

external

External 
to internal

Enabled ports Meaning

Allow IP 
communication

x x - IP communication for the selected communication 
directions is allowed. 

Allow S7 
protocol

x x TCP port 102 Communication of the nodes using the S7 protocol is 
allowed.

Allow FTP/
FTPS (explicit 
mode)

x x TCP port 20
TCP port 21

For file management and file access between server and 
client.

Allow HTTP x x TCP port 80 For communication with a Web server.
Allow HTTPS x x TCP port 443 For secure communication with a Web server, for example, 

for Web diagnostics.
Allow DNS x x TCP port 53

UDP port 53
Communication connection to a DNS server is allowed.

Allow SNMP x x TCP port 161/162 
UDP port 161/162

For monitoring nodes capable of SNMP. 

Allow SMTP x x TCP port 25 For sending e-mails via an SMTP server.
Allow NTP x x UDP port 123 For synchronization of the time of day.
Allow DHCP x x UDP port 67

UDP port 68
Communication connection with a DNS server is permitted.
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Table 8-32 Logging

Option Action when activated
Log tunneled packets Only active if the security module is a member of a VPN group. All IP packets transferred via 

the tunnel are logged.
Log blocked incoming 
packets

All incoming IP packets that are discarded are logged.

Log blocked outgoing 
packets

All outgoing IP packets that are discarded are logged.

You can view the logged packets at the "Packet filter log" entry in the "Online & Diagnostics" 
dialog. For more detailed information, refer to the section Logging data packets - "Packet filter 
log" entry (Page 594).

Configuring a firewall with predefined MAC rules

How to access this function
1. Select the module to be edited.

2. Select the "Firewall" entry in the local security settings.

Firewall enabled as default     
The "Enable firewall" check box is enabled by default. The firewall is therefore activated 
automatically and all external to internal access and vice versa is inhibited. By clicking the 
relevant check box, enable the firewall rules for the specific direction.

 

 Note
Detailed firewall settings in advanced firewall mode

In advanced firewall mode, you can restrict firewall rules to individual nodes. To change to 
advanced firewall mode, select the "Enable firewall in advanced mode" check box. For more 
detailed information about the advanced firewall mode, refer to the section Overview of local 
firewall rules (Page 552).

 

Firewall configuration with VPN     
If the security module is in a VPN group, the "Tunnel communication only" check box is enabled 
as default. This means that only encrypted IPsec data transfer is permitted via the external 
interface.

If you deselect the check box, tunneled communication and also the types of communication 
selected in the other boxes are permitted.
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Available MAC rules and directions

Service Internal to external External to internal Meaning
Allow MAC 
communication

x x The MAC traffic from internal to external and vice versa is 
allowed.

Allow ISO protocol x x The ISO traffic from internal to external and vice versa is 
allowed.

Allow SiClock x x SiClock time frames from internal to external nodes and 
vice versa are permitted.

Allow DCP x x Internal to external or external to internal DCP traffic for IP 
address assignment is permitted.

Table 8-33 Logging

Option Action when activated
Log tunneled packets Only active if the security module is a member of a VPN group. All 

MAC packets transferred via the tunnel are logged.
Log blocked incoming packets All incoming MAC packets that are discarded are logged.
Log blocked outgoing packets All outgoing MAC packets that are discarded are logged.

IP packet filter directions SCALANCE S

Meaning
Possible selections for the communication directions "From" and "To" in the IP rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of values Security module
From To S602 V2/V3 S612 V2/V3 S613 V2 S623 V3
Internal External x x x x

Tunnel - x x x
Any - x x x

External Internal x x x x
Any - - - -
Tunnel - - - -

Tunnel Internal - x x x
External - - - -
Any - - - -

Any Internal - x x x
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Available options / ranges of values Security module
External - - - -
Tunnel - - - -

x = communication direction is configurable
- = communication direction is not configurable

MAC packet filter directions SCALANCE S

Meaning
Possible selections for the communication directions "From" and "To" in the MAC rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of values Security module
From To S602 V2/V3 S612 V2/V3 S613 V2 S623 V3
Internal External x x x x

Tunnel - x x x
Any - x x x

External Internal x x x x
Any - - - -
Tunnel - - - -

Tunnel Internal - x x x
External - - - -
Any - - - -

Any Internal - x x x
External - - - -
Tunnel - - - -

x = communication direction is configurable
- = communication direction is not configurable

Specifying routes

Meaning
Specify routes for addressing subnets that cannot be reached directly via the security module.

How to access this function     
1. Select the module to be edited.

2. In the local security settings, select the "Routing" entry.
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3. Double-click "Add new" in the table to add a route.

4. Enter the following values:

Parameter Function Example of a value
Network ID   Requests to nodes of the subnet with the network ID and 

the subnet mask specified here are forwarded to the 
subnet via the specified router IP address.
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.
The specified network ID must not be located in the 
same subnet as the IP address of the security module.

192.168.11.0

Subnet mask The subnet mask determines the network structure. 
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.

255.255.255.0

Router IP address   IP address of the router that connects to the subnet.
The specified router IP address must be in the same 
subnet as the IP address of the security module.

192.168.10.2

Security module as DHCP server

Overview DHCP server

Overview
You can operate the SCALANCE S module as DHCP server (DHCP = Dynamic Host 
Configuration Protocol) on the internal network. This allows IP addresses to be assigned 
automatically to the devices connected to the internal network.   

The IP addresses are either distributed dynamically from an address range you have specified 
or you can select a specific IP address and assign it to a particular device.

Requirements
You configure the devices in the internal network so that they obtain the IP address from a 
DHCP server.

Depending on how the security module is configured, it informs the nodes in the subnet of the 
IP address of the standard router or you need to make the router IP address known to the 
nodes in the subnet.
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● Router IP address will be transferred
In the following situations, the DHCP protocol of the SCALANCE S module will inform the 
nodes of the router IP address:

– The SCALANCE S module is configured for router mode.
In this case, the SCALANCE S module sends its own IP address as the router IP address.

– The SCALANCE S module is not configured for router mode. However, a standard router 
is specified in the configuration of the SCALANCE S module.
In this case, the SCALANCE S module transmits the IP address of the standard router 
as the router IP address.

● Router IP address will not be transferred
Enter the router IP address manually at the nodes in the following situations:

– The SCALANCE S module is not configured for router mode and no standard router is 
specified in the configuration.

See also
Configuring a DHCP server (Page 606)

Configuring a DHCP server

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "DHCP server".

3. Select the interface for which you want to make the DHCP settings.

4. Make the address assignment. You have the following configuration options:

– Static address assignment
Devices with a specific MAC address or client ID are assigned the specified IP 
addresses. You specify these addresses by entering the devices in the address list in 
the "Static address assignment" group box.

– Dynamic address assignment
Devices whose MAC address or whose client ID was not specified specifically, are 
assigned a random IP address from a specified address range. For this purpose, activate 
the "Dynamic IP address pool" check box. Set the address range in the "Dynamic IP 
address pool" input area.
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 Note
Dynamic address assignment - reaction after interrupting the power supply

Please note that dynamically assigned IP addresses are not saved if the power supply is 
interrupted. On return of the power, you must therefore make sure that the nodes request an 
IP address again.

You should therefore only use dynamic address assignment for the following nodes:
● Nodes that are used temporarily in the subnet (such as service devices).
● Nodes that have been assigned an IP address and send this as the "preferred address" 

the next time they request an address from the DHCP server (for example PC stations).

For permanent nodes you should preferably use static address assignment by specifying a 
client ID or the MAC address.

 

Consistency check - these rules must be adhered to   
Remember the following rules when making the entries.

Check / rule Check made1)

locally Project-wide/
module-wide

The IP addresses assigned in the address list in the "Static address 
assignments" group box must not be in the range of the dynamic IP 
addresses.

 x

IP addresses, MAC addresses and client IDs may only occur once in 
the "Static address assignment" table (related to the security module).

 x

For the statically assigned IP addresses, you must specify either the 
MAC address or the client ID (computer name).

x  

The client ID is a string with a maximum of 63 characters. Only the 
following characters may be used: a-z, A-Z, 0-9 and - (dash).
Note
In SIMATIC S7, a client ID can be assigned to the devices on the 
Ethernet interface to allow them to obtain an IP address using DHCP.
With PCs, the procedure depends on the operating system being 
used; it is advisable to use the MAC address here for the assignment.

x  

For the statically assigned IP addresses, you must specify the IP 
address.

x  

The following IP addresses must not be in the range of the free IP 
address range (dynamic IP addresses):
● All router IP addresses in the "Routing" entry
● Syslog server
● Standard router
● Security module address(es)

 x
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Check / rule Check made1)

locally Project-wide/
module-wide

DHCP is supported by the security module on the interface to the 
internal subnet. The following additional requirements for IP 
addresses in the range of the free IP address range (dynamic IP 
addresses) result from operational behavior of the security module:
● Bridge mode

The free IP address range must be in the network defined by the 
security module.

● Routing mode
The free IP address range must be in the internal subnet defined 
by the security module.

 x

The free IP address range must be fully specified by entering the start 
address and the end address. This end address must be higher than 
the start address.

x  

The IP addresses you enter in the address list in the "Static address 
assignment" group box must be in the address range of the internal 
subnet of the security module.

 x

Legend:
1) Note the explanations in the section 
Running a consistency check (Page 530).

IPsec tunnel: Creating and assigning groups

Configuring internal network nodes

Using the learning mode to learn internal nodes

Finding nodes for tunnel communication automatically   
One great advantage when configuring and operating tunnel communication is that 
SCALANCE S modules in bridge mode can find the nodes on the internal interface 
automatically. New nodes are detected by the security module during operation. The detected 
nodes are signaled to the security modules belonging to the same group. This allows data 
exchange within the tunnels of a group in both directions at any time.
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Detectable nodes
The following nodes are detected:

● Network nodes with IP capability
Network nodes with IP capability are found when they transmit an ICMP response to the 
ICMP subnet broadcast. 
IP nodes downstream from routers can be found if the routers pass on ICMP broadcasts.

● ISO network nodes 
You can also teach-in network nodes without IP capability that can be addressed by means 
of ISO protocols.
This is only possible if they reply to XID or TEST packets. TEST and XID (Exchange 
Identification) are auxiliary protocols for exchanging information on layer 2. By sending 
these packets with a broadcast address, these network nodes can be located.

● PROFINET nodes
Using DCP (Discovery and basic Configuration Protocol), it is possible to find PROFINET 
nodes.

Network nodes that do not meet these conditions must be configured manually.

Subnets located on the other side of internal routers also need to be configured manually.

How to access the function
1. Select the module.

2. In the local security settings, select the entry "Node".

Enabling/disabling the learning mode
The learning function is enabled in the configuration as default for every security module.

Learning can also be disabled completely for SCALANCE S. In this case, you will need to 
configure all internal network nodes participating in the tunnel communication manually.

When is it useful to disable the automatic learning mode?
The default settings for the security module assume that internal networks are always secure; 
in other words, in a normal situation, no network node is connected to the internal network if 
it is not trustworthy.

Disabling the learning mode can be useful if the internal network is static; in other words, when 
the number of internal nodes and their addresses do not change.

If the learning mode is disabled, this reduces the load on the medium and the nodes in the 
internal network resulting from the learning packets. The performance of the security module 
is also slightly improved since it does not need to process the learning packets.
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Note: In the learning mode, all nodes in the internal network are detected. The information 
relating to VPN configuration limits relates only to nodes that communicate over VPN in the 
internal network.

 

 Note

If more than 128 internal nodes are being operated, the permitted configuration limits are 
exceeded and an illegal operating status results. Due to the dynamics in the network traffic, 
this causes internal nodes that have already been learned to be replaced by new previously 
unknown internal nodes. 

 

See also
Configuring internal subnets manually (Page 611)

Configuring IP network nodes manually

Meaning
As an alternative to the learning mode that you enable using the "Enable learning of internal 
nodes" check box and that allows the security module to learn the internal network nodes 
dynamically, you can enter the network nodes to be learned manually in the "Internal IP nodes" 
entry and in doing so enable them for VPN tunnel communication. The MAC address of a 
network node can be specified as an option.

Requirement
● The security module is in bridge mode.

● The security module is a member of a VPN group.

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "Node" > "Internal IP nodes".

Configuring MAC network nodes manually

Meaning
As an alternative to the learning mode that you enable using the "Enable learning of internal 
nodes" check box and that allows the security module to learn the internal network nodes 
dynamically, you can enter the network nodes to be learned manually in the "Internal MAC 
nodes" entry and in doing so enable them for VPN tunnel communication.
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Requirement
● The security module is in bridge mode.

● The security module is a member of a VPN group.

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "Node" > "Internal MAC nodes".

Configuring internal subnets manually

Requirement
● The security module is a member of a VPN group.

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "Node" > "Internal subnets".

Security module in bridge mode - "Internal subnets" entry
To be able to enable internal subnets for VPN tunnel communication manually, you need to 
enter the following address parameters:

Parameter Function Example of a value
Network ID Network ID of the subnet to be enabled for VPN tunnel 

communication.
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.
Must not be located in the same subnet as the IP 
address of the security module.

192.168.11.0

Subnet mask The subnet mask determines the network structure. 
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.

255.255.255.0

Router IP address IP address of the router via which the subnet you are 
allowing is reached.
Must be located in the same subnet as the IP address 
of the security module.

192.168.10.2
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Security module in routing mode - "Subnets reachable through tunnel" entry
In routing mode, entire subnets are always tunneled. To be able to enable internal subnets for 
VPN tunnel communication manually, you need to enter the following address parameters:

Parameter Function Example of a value
Network ID Network ID of the subnet to be enabled for VPN tunnel 

communication.
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.
Must not be located in the same subnet as the IP 
address of the security module.

192.168.11.0

Subnet mask The subnet mask determines the network structure. 
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.

255.255.255.0

Comment Entry of additional, optional comments.  

Online functions - testing / diagnostics and logging

Setting the date and time - "Date and time" entry

How to access this function
1. Select the security module whose time and date you want to check or set.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. In online diagnostics, select the "Functions" > "Date and time" entry.

Setting the local time on the security module
In this area, you can read out and set the time and date of the security module. When you click 
the "Apply" button, the security module is assigned the time and date currently entered in the 
"Date" and "Time" input boxes.

Setting the local time on PC
This area shows the current time and current date of the PC on which STEP 7 is installed. If 
you click the "Adopt for module" button, the security module is assigned the current time and 
current date of the PC.
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Download functions

Downloading a configuration

This needs to be taken into consideration before downloading a configuration
● IP address used for downloading configurations

Configurations are always downloaded to the security module using the IP address 
configured in the local security settings for the internal or external port. This IP address 
must match that of the security module.

● Ports
You can download the configuration data to the security module both via the external and 
the internal interface. 
Ideally, you should configure the modules of a VPN group via the common external network 
of these modules (device port 1). If the configuration computer is located on an internal 
network, you must enable the IP addresses of the other modules of the group explicitly in 
the firewall of this SCALANCE S module and first load this module.

 

  Note
Selecting a network adapter   

If you are using more than one network adapter in your PC/PG, first select the network 
adapter via which you can reach the SCALANCE S module in the "PG/PC Interface" drop-
down list of the "Extended download to device" dialog.

 

● Operating mode 
Configurations can be downloaded while the SCALANCE S devices are operating. Restart 
the SCALANCE S module to activate your configuration changes. 

 

  Note
Special characteristics
● As long as a module has not yet set IP parameters (in other words, prior to the first 

configuration), there must be no router between the module and the configuration 
computer.

● If you swap a PC from the internal to the external interface of the SCALANCE S, access 
from this PC to the SCALANCE S is blocked for approximately 20 minutes.

 
 

Transferring firmware

This needs to be taken into consideration before transferring new firmware
To transfer new firmware to a security module, the following conditions must be met:

● You have the rights required to transfer firmware; refer to section 
Auto-Hotspot.  

● The security module is configured with an IP address.
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The transfer is secure
The firmware is transferred over a secure connection and can therefore also be transferred 
from the unprotected network.

The firmware itself is signed and encrypted. This ensures that only authentic firmware can be 
downloaded to the SCALANCE S module.

The transfer can take place during operation
The firmware can be transferred while a SCALANCE S module is in operation. Newly 
downloaded firmware only becomes active after the SCALANCE S module has been restarted. 
If the transfer is disturbed and aborted, the module starts up again with the old firmware version.

Security for S7-300 /S7-400 / PC CPs

Setting up a firewall

Local firewall rules for S7-300 /S7-400 / PC CPs

Overview S7-300 CPs / S7-400 CPs /PC CPs

Enabling packet filter rules
If you enable the security function for the CPs in the local security settings, initially all access 
to and via the CP is permitted. To enable individual packet filter rules, select the "Activate 
firewall" check box. Then enable the required services. Firewall rules created automatically 
due to a connection configuration have priority over rules set manually.

 

 Note
Detailed firewall settings in advanced firewall mode

In advanced firewall mode, you can restrict firewall rules to individual nodes. To change to 
advanced firewall mode, select the "Activate firewall in advanced mode" check box.

 

Firewall configuration with VPN     
If the security module is added to a VPN group, the firewall is enabled by default. In addition, 
the "Tunnel communication only" check box is enabled. This means that only encrypted IPsec 
data transfer is permitted via the external interface. External data traffic is blocked.

If you deselect the check box, tunneled communication and also the types of communication 
selected in the other boxes are permitted.
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Updating connection rules
Changes to the connection configuration of CPs also change the connection-related firewall 
rules. To display the modified firewall rules, click the "Update connection rules" button. The 
modified firewall rules are then displayed in advanced firewall mode.

Configuring a firewall with predefined firewall rules - CP x43-1 Advanced

Configuring a firewall with predefined IP rules - CP x43-1 Advanced

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "Firewall" > "Predefined IP rules".

Table 8-34 Available services and directions

Service From station/
internal to 
external

External to 
internal

From external 
to station

Enabled ports Meaning

Allow 
IP 
communicatio
n

x x x All IP traffic for the selected communication 
directions is allowed. 

Allow S7 
protocol

x x x TCP port 102 Communication of the nodes using the S7 
protocol is allowed.

Allow FTP/
FTPS (explicit 
mode)

x x x TCP port 20
TCP port 21

For file management and file access 
between server and client.

Allow HTTP x x x TCP port 80 For communication with a Web server.
Allow HTTPS x x x TCP port 443 For secure communication with a Web 

server, for example, for Web diagnostics.
Allow DNS x x - TCP port 53 

UDP port 53
Communication connection to a DNS 
server is allowed.

Allow SNMP x x x TCP port 
161/162 
UDP port 
161/162

For monitoring nodes capable of SNMP.

Allow SMTP x x - TCP port 25 For sending e-mails via an SMTP server.
Allow NTP x x - UDP port 123 For synchronization of the time of day.
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Table 8-35 Logging

Option Action when activated Relevant firewall rule
IP log settings Action From To
Log tunneled packets Only active if the security module is 

a member of a VPN group. All IP 
packets transferred via the tunnel 
are logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming IP packets that are 
discarded are logged.

Drop External Station

 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

Configuring a firewall with predefined MAC rules - CP x43-1 Advanced

How to access this function
1. Select the module to be edited.

2. Select the entry "Firewall" > "Predefined MAC rules".

Table 8-36 Available services and directions

Service From station 
to external

From external to 
station

Meaning

Allow MAC 
communication

x x The MAC traffic from station to external and vice versa is 
allowed.

Allow ISO protocol x x The ISO traffic from station to external and vice versa is 
allowed.

 

Table 8-37 Logging

Option Action when activated Relevant firewall rule
MAC log settings Action From To
Log tunneled packets Only active if the 

security module is a 
member of a VPN 
group. All MAC 
packets transferred via 
the tunnel are logged.

Allow Station Tunnel
Allow Tunnel Station
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Option Action when activated Relevant firewall rule
MAC log settings Action From To
Log blocked incoming 
packets

All incoming MAC 
packets that are 
discarded are logged.

Drop External Station

Log blocked outgoing 
packets

All outgoing MAC 
packets that are 
discarded are logged.

Drop Station External

 
 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

Configuring a firewall with predefined firewall rules - CP 1628

Configuring a firewall with predefined IP rules - CP 1628

How to access this function
1. Select the module to be edited.

2. Select the "Security" > "Firewall" > "Predefined IP rules" entry.

Table 8-38 Available services and directions

Service From external to 
station

Enabled ports Meaning

Allow IP communication x All IP traffic from external to station is 
allowed.

Allow S7 protocol x TCP port 102 Communication of the nodes using the 
S7 protocol is allowed.

Allow FTP/FTPS (explicit 
mode)

x TCP port 20
TCP port 21

For file management and file access 
between server and client.

Allow HTTP x TCP port 80 For communication with a Web server.
Allow HTTPS x TCP port 443 For secure communication with a Web 

server, for example, for Web 
diagnostics.

Allow DNS x TCP port 53
UDP port 53 

Communication connection to a DNS 
server is allowed.
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Service From external to 
station

Enabled ports Meaning

Allow SNMP x TCP port 161/162
UDP port 161/162

For monitoring nodes capable of 
SNMP.

Allow SMTP x TCP port 25 For sending e-mails via an SMTP 
server.

Allow NTP x UDP port 123 For synchronization of the time of day.

Table 8-39 Logging

Option Action when activated Relevant firewall rule
IP log settings Action From To
Log tunneled packets Only active if the security 

module is a member of a 
VPN group. All IP packets 
transferred via the tunnel are 
logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming IP packets that 
are discarded are logged.

Drop External Station

 
 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

Configuring a firewall with predefined MAC rules - CP 1628

How to access this function
1. Select the module to be edited.

2. Select the entry "Security" > "Firewall" > "MAC rules".

Table 8-40 Available services and directions

Service From station to 
external

From external to 
station

Meaning

Allow MAC level communication x x The MAC traffic from external to the 
station and vice versa is allowed.

Allow ISO communication x x ISO traffic from external to the station and 
vice versa is allowed.

Allow SiClock x x SiClock time-of-day frames from external 
to the station and vice versa are allowed.
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Table 8-41 Logging

Option Action when activated Relevant firewall rule
MAC log settings Action From To
Log tunneled packets Only active if the security 

module is a member of a 
VPN group. All MAC packets 
transferred via the tunnel are 
logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming MAC packets 
that are discarded are logged.

Drop External Station

Log blocked outgoing packets All outgoing MAC packets 
that are discarded are logged.

Drop Station External

 
 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

IP packet filter directions S7-300-/S7-400-/PC-CPs

Meaning
Possible selections for the communication directions "From" and "To" in the IP rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges 
of values

Security module Meaning

From To CP x43-1 
Adv.

CP 1628  

Internal Station x - Access from the internal network to the station.
Any x - Access from internal to the external network, VPN tunnel partner 

and the station.
External Station x x Access from the external network to the station.

Any x - Access from external to the internal network and the station.
Station Internal x - Access from the station to the internal network.

External x x Access from the station to the external network.
Tunnel x x Access from the station to the VPN tunnel partner.

Tunnel Station x x Access via the VPN tunnel partner to the station.
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Available options / ranges 
of values

Security module Meaning

Any x - Access from VPN tunnel partners to the internal network and the 
station.

Any External x - Access from the internal network and the station to the external 
network.

MAC packet filter directions S7-300-/S7-400-/PC-CPs

Context
Possible selections for the communication directions "From" and "To" in the MAC rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of 
values

Security module Meaning

From To CP x43-1 Adv. CP 1628  
External Station x x Access from the external network to the station.
Station External x x Access from the station to the external network.

Tunnel x x Access from the station to the VPN tunnel 
partner.

Tunnel Station x x Access via the VPN tunnel partner to the 
station.

Configuring the access list

Module-specific function
This function is not available for the CP 1628.
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Meaning
You set access protection for certain IP addresses using the IP access lists. List entries that 
have already been created and the corresponding rights are displayed in the local settings of 
the CP in the entry "Firewall" > "IP rules" (advanced firewall mode). 

 

 Note
Changed behavior after activation of security
● Once you have activated the security function for a CP, access protection will only apply 

to the external interface. You can apply access protection to the internal interface as well, 
by configuring suitable firewall rules in advanced firewall mode.

● The CP also responds to ARP requests from IP addresses that have not been released 
(layer 2).

● If the IP access list of a CP contains no entries and you activate security for the CP, the 
firewall will be activated and prevent access to the CP from external locations. Configure 
the corresponding firewall rules in advanced firewall mode so that the CP can be reached.

 

Effect of IP access list entries at activation of security
If security is enabled in the local settings of a CP, the corresponding rules are created in the 
advanced firewall mode. A firewall rule "Allow" > "External" > "Station" is created for an IP 
address you specified in the address list. The IP address from the IP access list is used 
accordingly as source IP address. IP addresses from a defined IP address range are also 
integrated into corresponding firewall rules.

Requirements for editing
Before you can edit created firewall rules, the following condition must be met:

● for editing using STEP 7: "Configure security" configuration right

● for editing using a Web server: Module right "Web: Expand IP access control list"

The requirements for editing the IP access lists outside the local security settings are described 
in the sections on the specific CPs. 

Connection-related automatic firewall rules

Meaning   
For connections that were configured using CPs, STEP 7 automatically creates firewall rules 
that allow communication with the partner of the CP in the specified direction (CP active/
passive). The connection establishment directions are taken into account. To display these 
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firewall rules, if the advanced firewall mode is enabled, the "Update connection rules" button 
needs to be clicked. The firewall rules are then displayed in advanced firewall mode.

 

 Note
Enabling UDP multicast and UDP broadcast connections manually

No automatic firewall rules are created for UDP multicast and UDP broadcast connections. 
To enable the connections, add the relevant firewall rules manually in advanced firewall mode.

 

Depending on how the connection establishment is configured, the following level 3 firewall 
rules are created. If the security module is in a VPN group, the direction "External" changes 
to "Tunnel". This applies only to CPs that support VPN.

The IP address of the connection partner is entered in the "Source IP address" or "Destination 
IP address" column of these firewall rules.

CP->external Action From To
active Allow Station External

Drop External Station
passive Drop Station External

Allow External Station
active and passive Allow External Station

Allow Station External

CP->internal Action From To
active Allow Station Internal

Drop Internal Station
passive Drop Station Internal

Allow Internal Station
active and passive Allow Internal Station

Allow Station Internal

For level 2 connections, "Allow" rules are created for both directions. If the security module is 
in a VPN group, the direction "External" changes to "Tunnel". This applies only to CPs that 
support VPN.

The MAC address of the connection partner is entered in the "Source MAC address" or 
"Destination MAC address" column of these firewall rules.

CP->external Action From To
active, passive, active and passive Allow Station External

Allow External Station
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 Note
Changing the connection configuration

Changes to the connection configuration of CPs also change the connection-related firewall 
rules. To display the modified firewall rules, click the "Update connection rules" button.

 

Conventions for automatically created firewall rules
● Priority

The rules have highest priority and are therefore inserted at the top in the local rule list. 

● Deleting rules
The rules cannot be deleted. Logging can be enabled and services can be assigned. 
Moreover, you may insert a bandwidth and a comment. 

● Changing the action
If you set the action from "Allow" to "Drop" or vice versa, this is overwritten again during 
renewed system synchronization. Select "Allow*" or "Drop*" to retain your changes. In this 
case, only the IP address is synchronized and the action and direction remain as set. 
Settings for logging, service, bandwidth and comment are also retained after a renewed 
system synchronization even without changing the action to "Allow*" or "Drop*". If the 
configured connection is deleted, the corresponding rules are removed from the list.

Security module in VPN group
As default, the "Tunnel communication only" check box is enabled. If you deselect the check 
box, in addition to tunnel communication between tunnel partners, communication is also 
possible with network nodes to which there is no tunnel.

● Communication is untunneled if the partner address belongs to a station known in STEP 7 
for which no VPN tunnel is configured.

● Communication is through the tunnel if the partner address is a VPN endpoint.

● If it is not clear whether connection should bypass or run through the VPN tunnel, the 
connection is assigned to the VPN tunnel and a message to this effect is displayed. The 
assignment can be adapted in advanced firewall mode, for example, by changing the 
"From" direction "Tunnel" to "External". To avoid this adaptation being overwritten by the 
next system synchronization, the "Allow*" or "Drop*" action must be selected.

 

  Note

If you want to ensure that only communication through the tunnel is possible, you will need 
to create suitable firewall rules in advanced firewall mode, for example, for internal nodes 
or NDIS addresses.

To allow only tunneled communication for a CP, add a "Drop" > "Any" > "External" rule. 
For the CP 1628, add a "Drop" > "Station" > "External" rule.  In addition to this, you need 
to remove existing firewall rules that allow untunneled communication.
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Configuring SNMP

Overview of SNMP

What is SNMP?
The security module supports the transfer of management information using the Simple 
Network Management Protocol (SNMP). For this purpose, an SNMP agent that receives and 
responds to SNMP requests is installed on the security module. The information on the 
properties of SNMPcompliant devices is entered in MIB files (MIB = Management Information 
Base) for which the user must have the required rights.

In SNMPv1, the "community string" is also sent. The "community string" is like a password that 
is transmitted along with the SNMP request. If the community string is correct, the security 
module replies with the required information. If the string is incorrect, the security module 
discards the query and does not reply. The community string is transmitted via SNMPv1 without 
encryption.

SNMPv3 lets you transmit encrypted data.

Configuring SNMP - "SNMP" entry

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "SNMP".

3. Activate the "Activate SNMP" check box.
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4. Select one of the following SNMP protocol versions:
 

  Note
Encrypted data transmission with SNMPv3

You should use SNMPv3 to transmit data in encrypted form in order to enhance security.
 

– SNMPv1 
The security module uses the following default values for the community strings to 
control the access rights in the SNMP agent:
For read access: public
For read and write access: private
To enable write access using SNMP, select the "Allow write access" option. 

– SNMPv3 
Select either only an authentication algorithm or an authentication algorithm and an 
encryption algorithm.
Authentication algorithm: none, MD5, SHA-1 
Encryption algorithm: none, AES-128, DES   

 

  Note
Preventing the use of DES

DES is an insecure encryption algorithm. Therefore, it should only be used for reasons 
of down compatibility.

 

5. If SNMPv3 is to be used, assign a user a role with corresponding activated SNMP rights to 
enable access to the module via SNMP. An overview of SNMP rights is available in the 
section 
Managing rights (Page 538).

Activating the Web server on CP x43-1 Advanced

Module-specific function
This function is only available for CP x43-1.

Meaning
After activating the Web server, you have access to the Web pages of the module. In the local 
security settings, you can restrict access to these Web pages using the HTTPS protocol. This 
access is controlled using the "Allow access only using HTTPS" check box. In addition, you 
must configure the firewall accordingly.
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IPsec tunnel: Creating and assigning groups

Configuring internal network nodes - "Nodes" entry

Allow access to S7-300 / S7-400 CPs for VPN connection partners

Possible selections
Decide whether or not the VPN connection partner can have access to the CP and/or the 
internal subnet of the CP in routing mode (SCALANCE S / M).

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "Node".

3. Configure access for the VPN connection partner of the CP in routing mode (SCALANCE 
S / M):

– Allow connection to the CP (Gbit interface)

– Allow connection to the internal subnet (PROFINET subnet)

Configuring NDIS nodes manually for PC CPs that can be reached through the tunnel

Configuring NDIS nodes that can be reached through the tunnel
The internal nodes are learned and assigned to the routes dynamically. This concerns the 
NDIS IP addresses of the Windows PC.

Follow the steps below
1. Select the module to be edited.

2. In the local security settings, select the entry "Nodes" > "NDIS nodes reachable via tunnel".

3. Enter the NDIS IP addresses.

Online functions - Debug / Diagnostics and Logging

Updated firewall rules - "Dynamically updated firewall rules" entry

Meaning
Display of the IP addresses or IP address ranges that were enabled dynamically using HTTP 
or HTTPS, or loaded by a user. The rights assigned for accessing the S7 CP are displayed for 
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the enabled IP addresses. An update of the IP addresses in this tab can only be triggered by 
the following events:

● Extension/modification of the IP access control list

● Update of firewall rules

● Dynamic extensions transmitted to the CP at runtime, for example, PROFINET IO devices

Since only the dynamically updated firewall rules are displayed here, you also need to take 
into account the firewall rules that were configured offline and downloaded to the station for a 
full picture of the current firewall status of the module.

Security for S7-1500 CPs

Setting up a firewall

Local firewall rules for S7-1500 CPs

Overview of local firewall rules for S7-1500 CPs

Enabling packet filter rules
If you enable the security function for the CPs in the local security settings, initially all access 
to and via the CP is permitted. To enable individual packet filter rules, select the "Activate 
firewall" check box. Then enable the required services. Firewall rules created automatically 
due to a connection configuration have priority over rules set manually.

 

 Note
Detailed firewall settings in advanced firewall mode

In advanced firewall mode, you can restrict firewall rules to individual nodes. To change to 
advanced firewall mode, select the "Activate firewall in advanced mode" check box.

 

Updating connection rules
Changes to the connection configuration of CPs also change the connection-related firewall 
rules. To display the modified firewall rules, click the "Update connection rules" button. The 
modified firewall rules are then displayed in advanced firewall mode.
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Configuring a firewall with predefined firewall rules - CP 1543-1

Configuring a firewall with predefined IP rules - CP 1543-1

How to access this function 
1. Select the module to be edited.

2. In the local security settings, select the entry "Firewall" > "Predefined IP rules".

Table 8-42 Available services and directions

Service From 
external to 

station

Enabled ports Meaning

Allow IP 
communication

x All IP traffic from external to station is allowed.

Allow S7 protocol x TCP port 102 Communication of the nodes using the S7 protocol is allowed.
Allow FTP/FTPS 
(explicit mode)

x TCP port 20
TCP port 21

For file management and file access between server and client.

Allow HTTP x TCP port 80 For communication with a Web server.
Allow HTTPS x TCP port 443 For secure communication with a Web server, for example, for 

Web diagnostics.
Allow SNMP x TCP port 161/162 

UDP port 161/162
For monitoring nodes capable of SNMP.

Allow security 
diagnostics

x TCP port 8448 Allow/do not allow security diagnostics.

Table 8-43 Logging

Option Action when activated Relevant firewall rule
IP log settings Action From To
Log tunneled packets Only active if the security module is 

a member of a VPN group. All IP 
packets transferred via the tunnel 
are logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming IP packets that are 
discarded are logged.

Drop External Station

 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.
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Configure firewall with pre-defined IPv6 rules - CP1543-1

Meaning
With the predefined IPv6 rules, you have the option of configuring the firewall for services in 
which IPv6 is used. By enabling a predefined IPv6 rule in the local security settings of the CP 
1543-1 V1.1, the system-defined ICMPv6 services that can be seen in the global security 
settings in the "ICMP" tab in "Firewall" > "Services" > "Define services for IP rules"are also 
enabled in the firewall The firewall of the CP 1543-1 V1.0 allows ICMPv6 packets through even 
without enabling a predefined IPv6 rule.

How to access this function
1. Select the module to be edited.

2. Select the "Firewall" > "Pre-defined IPv6 rules" item in the local security settings.

Table 8-44 Available services and directions

Service From 
external to 

station

Enabled ports Meaning

Allow IP traffic x All IP traffic from external to station is allowed.
Allow S7 protocol x TCP port 102 Communication of the nodes using the S7 protocol is allowed.
Allow FTP/FTPS 
(explicit mode)

x TCP port 20
TCP port 21

For file management and file access between server and client.

Allow HTTP x TCP port 80 For communication with a Web server.
Allow HTTPS x TCP port 443 For secure communication with a Web server, for example, for 

Web diagnostics.
Allow SNMP x TCP port 161/162 

UDP port 161/162
For monitoring nodes capable of SNMP.

Allow security 
diagnostics

x TCP port 8448 Allow/do not allow security diagnostics via IPv6.

Table 8-45 Logging

Option Action when activated Relevant firewall rule
IP log settings Action From To
Log tunneled packets Only active if the security module is 

a member of a VPN group. All IP 
packets transferred via the tunnel 
are logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming IP packets that are 
discarded are logged.

Drop External Station
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 Note
Relationship between log settings in default mode and firewall rules

Log settings made in "Predefined IPv6 rules" have no effect on firewall rules that were 
automatically generated as a result of configuring a connection. This means, for example, 
that tunneled frames belonging to a configured connection cannot be logged. In advanced 
firewall mode, logging can be extended to the automatically generated firewall rules of 
connections.

 

Configuring a firewall with predefined MAC rules - CP 1543-1

How to access this function
1. Select the module to be edited.

2. Select the entry "Firewall" > "Predefined MAC rules".

Table 8-46 Available services and directions

Service From 
station to 
external

From 
external 

to 
station

Enabled 
ports

Meaning

Allow MAC 
communication

x x - The MAC traffic from external to the station and vice versa is 
allowed.

Allow ISO protocol x x - ISO traffic from external to the station and vice versa is allowed.
Allow SiCLOCK x x - SiCLOCK traffic from external to the station and vice versa is 

allowed.

 

Table 8-47 Logging

Option Action when 
activated

Relevant firewall rule

MAC log settings Action From To
Log blocked incoming 
packets

All incoming MAC 
packets that are 
discarded are 
logged.

Drop External Station

Log blocked outgoing 
packets

All outgoing MAC 
packets that are 
discarded are 
logged.

Drop Station External
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 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

IP packet filter directions - CP 1543-1

Meaning
Possible selections for the communication directions "From" and "To" in the IP rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of values Meaning
From To  
External Station Access from the external network to the station.
Station External Access from the station to the external network.

Tunnel Access from the station to VPN tunnel partners.*
Tunnel Station Access by VPN tunnel partners to the station.*

* Only for the CP 1543-1 V1.1.

MAC packet filter directions CP 1543-1

Meaning
Possible selections for the communication directions "From" and "To" in the MAC rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of values Meaning
From To  
External Station Access from the external network to the station.
Station External Access from the station to the external network.

Tunnel Access from the station to VPN tunnel partners.*
Tunnel Station Access by VPN tunnel partners to the station.*
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* Only for the CP 1543-1 V1.1.

Connection-related automatic firewall rules

Meaning   
For connections that were configured using CPs, STEP 7 automatically creates firewall rules 
that allow communication with the partner of the CP in the specified direction (CP active/
passive). The connection establishment directions are taken into account. To display these 
firewall rules, if the advanced firewall mode is enabled, the "Update connection rules" button 
needs to be clicked. The firewall rules are then displayed in advanced firewall mode.

 

 Note
Enabling UDP multicast and UDP broadcast connections manually

No automatic firewall rules are created for UDP multicast and UDP broadcast connections. 
To enable the connections, add the relevant firewall rules manually in advanced firewall mode.

 

Depending on how the connection establishment is configured, the following level 3 firewall 
rules are created. If the CP 1543-1 V1.1 is in a VPN group, the direction "External" changes 
to "Tunnel".

The IP address of the connection partner is entered in the "Source IP address" or "Destination 
IP address" column of these firewall rules.

CP->external Action From To
active Drop External Station

Allow Station External
passive Drop Station External

Allow External Station
active and passive Allow External Station

Allow Station External

 For level 2 connections, "Allow" rules are created for both directions. If the CP 1543-1 V1.1 
is in a VPN group, the direction "External" changes to "Tunnel".

The MAC address of the connection partner is entered in the "Source MAC address" or 
"Destination MAC address" column of these firewall rules.

CP->external Action From To
active, passive, active and passive Allow Station External

Allow External Station
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 Note
Changing the connection configuration

Changes to the connection configuration of CPs also change the connection-related firewall 
rules. To display the modified firewall rules, click the "Update connection rules" button.

 

Conventions for automatically created firewall rules
● Priority

The rules have highest priority and are therefore inserted at the top in the local rule list.

● Deleting rules
The rules cannot be deleted. Logging can be enabled and services can be assigned. 
Moreover, you may insert a bandwidth and a comment.

● Changing the action
If you set the action from "Allow" to "Drop" or vice versa, this is overwritten again during 
renewed system synchronization. Select "Allow*" or "Drop*" to retain your changes. In this 
case, only the IP address is synchronized and the action and direction remain as set. 
Settings for logging, service, bandwidth and comment are also retained after a renewed 
system synchronization even without changing the action to "Allow*" or "Drop*". If the 
configured connection is deleted, the corresponding rules are removed from the list.

Security module in VPN group
As default, the "Tunnel communication only" check box is enabled. If you deselect the check 
box, in addition to tunnel communication between tunnel partners, communication is also 
possible with devices to which there is no tunnel.

● Communication is untunneled if the partner address belongs to a station known in STEP 7 
for which no VPN tunnel is configured.

● Communication is through the tunnel if the partner address is a VPN endpoint.

● If it is not clear whether connection should bypass or run through the VPN tunnel, the 
connection is assigned to the VPN tunnel and a message to this effect is displayed. The 
assignment can be adapted in advanced firewall mode, for example, by changing the 
"From" direction "Tunnel" to "External". To avoid this adaptation being overwritten by the 
next system synchronization, the "Allow*" or "Drop*" action must be selected.

 

  Note

If you want to ensure that only communication through the tunnel is possible, you will need 
to create suitable firewall rules in advanced firewall mode.

To allow only tunneled communication for a CP, add a "Drop" > "Any" > "External" rule. 
In addition to this, you need to remove existing firewall rules that allow untunneled 
communication.
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Configuring SNMP

Overview of SNMP

What is SNMP?
The security module supports the transfer of management information using the Simple 
Network Management Protocol (SNMP). For this purpose, an SNMP agent that receives and 
responds to SNMP requests is installed on the security module. The information on the 
properties of SNMPcompliant devices is entered in MIB files (MIB = Management Information 
Base) for which the user must have the required rights.

In SNMPv1, the "community string" is also sent. The "community string" is like a password that 
is transmitted along with the SNMP request. If the community string is correct, the security 
module replies with the required information. If the string is incorrect, the security module 
discards the query and does not reply. The community string is transmitted via SNMPv1 without 
encryption.

SNMPv3 lets you transmit encrypted data.

Configuring SNMP - "SNMP" entry

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "SNMP".

3. Activate the "Activate SNMP" check box.
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4. Select one of the following SNMP protocol versions:
 

  Note
Encrypted data transmission with SNMPv3

You should use SNMPv3 to transmit data in encrypted form in order to enhance security.
 

– SNMPv1 
The security module uses the following default values for the community strings to 
control the access rights in the SNMP agent:
For read access: public
For read and write access: private
To enable write access using SNMP, select the "Allow write access" option. 

– SNMPv3 
Select either only an authentication algorithm or an authentication algorithm and an 
encryption algorithm.
Authentication algorithm: none, MD5, SHA-1 
Encryption algorithm: none, AES-128, DES   

 

  Note
Preventing the use of DES

DES is an insecure encryption algorithm. Therefore, it should only be used for reasons 
of down compatibility.

 

5. If SNMPv3 is to be used, assign a user a role with corresponding activated SNMP rights to 
enable access to the module via SNMP. An overview of SNMP rights is available in the 
section 
Managing rights (Page 538).

8.1.4 Creating configurations

8.1.4.1 Information about the web server

Introduction
The web server allows you to monitor the CPU via the Internet or the intranet of your company. 
This permits evaluation and diagnostics over long distances.

Alarms and status information are visualized on HTML pages.

Web browser   
You need a web browser to access the HTML pages of the CPU.

The following web browsers, for example, are suitable for communication with the CPU:
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● Internet Explorer (version 6.0 and higher)

● Mozilla Firefox (V1.5 and higher)

● Opera (version 9.0 and higher)

Web access to the CPU via PG/PC
Proceed as follows to access the web server:

1. Connect the client (PG/PC) to the CPU via the PROFINET interface.

2. Open the web browser.
Enter the IP address of the CPU in the "Address" field of the web browser in the format 
http://ww.xx.yy.zz (example: http://192.168.3.141).
The start page of the CPU opens. From the start page, you can navigate to further 
information. 

Additional information
Additional information about the web server of the various CPU families is available under the 
key word "Web server" in the information system.

Information on creating your own web pages for access to the CPU is available under the 
keyword "User-defined web pages" in the information system. 

8.1.4.2 Things you should know about PROFIBUS DP operating modes

Introduction
DP master systems that consist of a DP master and DP slaves which are connected via a bus 
and communicate with one another via the PROFIBUS DP protocol are referred to as 
distributed I/O.

Below, we refer to communication-capable modules with DP interface that can take on the role 
of DP master or DP slave. 

"DP master" and "DP slave" option   
Communication-capable modules, such as CPUs with DP interface and CPs or CMs with DP 
interface, have the area "Mode" in their module properties. 

For S7-300 CPUs with integrated DP interface, for example, you can set the mode "DP master" 
and "DP slave". A CPU or a CP that is configured as DP slave is also referred to as intelligent 
DP slave (I-slave). 

For S7-1500 CPUs with integrated DP interface, only the "DP master" mode is possible. To 
operate S7-1500 CPUs as I-slave, you have to insert the communication module CM 1542-5 
and configure it as DP slave. 

S7-1200 CPUs do not have integrated DP interfaces. To operate an S7-1200 as DP master 
or DP slave, you must insert a communication module CM 1243-5 (DP master only) or a 
communication module CM 1242-5 (DP slave only; I-slave). 
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Additional information
Additional information on distributed I/O is available under the key word "Distributed I/O" and 
"I-slave" in the information system.

8.1.4.3 Configuring automation systems

Addressing modules

Addressing modules

Introduction 
In the device overview, you see the addresses or address ranges of the modules in the I 
address and Q address columns. There are other addresses as well, which are explained 
below. 

I/O address   
I/O addresses (input/output addresses) are required to read inputs and set outputs in the user 
program. 

Input and output addresses are assigned automatically when modules are inserted in the rack. 
The address of the first channel is the start address of a module. The addresses of the other 
channels are derived from this start address. The address end is obtained from the module-
specific address length.

Device address (e.g., Ethernet address)
Device addresses are addresses of programmable modules (Industrial Ethernet addresses). 
They are required to address the different stations of a subnet, for example, to download a 
user program to a CPU.

Hardware identifier for identifying modules and submodules
In addition to the I addresses and Q addresses, a hardware identifier (HW ID) is assigned 
automatically and is used to address and identify the module. Submodules (units of a module), 
such as an integrated counter, also receive such a hardware identifier. 

The hardware identifier consists of an integer and is output by the system with diagnostics 
alarms to allow the faulty module or the faulty submodule to be localized. 

In addition, the hardware identifier is used for a number of instructions to address the 
corresponding module. 

The hardware identifier cannot be changed.

Example: Identifying high-speed counters of the S7-1200 CPU
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The hardware identifier is assigned automatically when components are inserted in the device 
or network view and in the PLC tags. A name is also assigned automatically for the hardware 
identifier. The system constants of the PLC tags cannot be changed either. 

See also
Specifying input and output addresses (Page 638)

Assigning addresses to a location in the program (Page 639)

Introduction to loading a configuration (Page 826)

Specifying input and output addresses
Default input and output addresses are set automatically. You can, however, change the 
address assignment later. 

All addresses of modules are located in the process image area. The process image is 
automatically updated cyclically. 

Requirement
You are in the device view. 

Procedure   
To change the preset address range proceed as follows:

1. In the device view, click on the module for which you want to set the start address.

2. Go to "I/O addresses" in "Properties" in the inspector window.

3. Under "Start address" enter the required start address.

4. Press <Return> or click on any object to accept a modified value.

If you have entered an invalid address, a message indicating the next available address is 
displayed.

 

 Note

You can also change the addresses directly in the device overview. 
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See also
Editing properties and parameters (Page 428)

Input and output addresses in the address overview (Page 430)

Assigning addresses to a location in the program
You can assign addresses of the I/O channels of modules directly to the points of use in the 
program or to a tag table.

Requirement
● The device view of the hardware and network editor is open.

● The zoom level in the device view must be set to at least 200% to allow you to see the 
individual I/O channels.

● The instruction window of the programming editor or a tag table is open.
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Procedure       
To assign I/O channels of modules to the points of use in the program or to a tag table, follow 
these steps:

1. In the device view, navigate to the module with the desired I/O channel.

2. Click and hold down the mouse button to drag the desired I/O address to the corresponding 
point of use of the block or to the tag table.
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The address of the module is assigned to the point of use in the program or entered as a tag 
in the tag table.

 

 Note

The tag for an input or output of a block can also be dragged to the input or output of a module 
in order to link the tag to the I/O channel of the module.

 

 

Signal board

Inserting a signal board in a CPU

Introduction 
Signal boards allows you to increase the number of the S7-1200 CPU's own inputs and outputs. 
Just like all other hardware components, you will find signal boards in the hardware catalog. 
However, you do not insert signal boards in the rack like other modules but directly in a slot of 
the CPU itself.

Note the following points when using a signal board:

● Each CPU can have only one signal board inserted in it.

● A signal board can only be inserted when the slot in the CPU is free.

There are various ways of inserting a signal board in a CPU:

● Double click on a signal board in the hardware catalog when there is a free slot in the CPU

● Drag from the hardware catalog to a free slot in the CPU

● Shortcut menu of a signal board in the hardware catalog for copying and pasting

Requirement
● The hardware catalog is open.

● The S7-1200 CPU has a free slot for the signal board.
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Inserting a signal board in a CPU 
To insert a signal board in a CPU, proceed as follows:

1. Go to the required signal board in the hardware catalog.

2. Select the signal board you want to use.

3. Drag the signal board to the free slot in the CPU.

You have now inserted a signal board in the slot of the CPU.

If you are in the network view, you can also drag a signal board to a device. If the CPU has a 
an empty slot for a signal board, the signal board is inserted automatically into this slot.

Configurations for Web server

Information about the web server

Introduction
The web server allows you to monitor the CPU via the Internet or the intranet of your company. 
This permits evaluation and diagnostics over long distances.

Alarms and status information are visualized on HTML pages.

Web browser   
You need a web browser to access the HTML pages of the CPU.

The following PC web browsers, for example, are suitable for communication with the CPU:

● Internet Explorer (Version 8.0, 9.0)

● Mozilla Firefox (Version 17.0.1 and higher)

● Google Chrome 23.0

● Apple Safari 5.1.7 (Windows)

● Apple Safari 6.0.2 (Mac)

The following Web browsers of mobile devices are also suitable:

● Internet Explorer 6.0 and lower, for HMI Panels

● Mobile Safari (iOS 5.0.1)
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● Mobile Android Browser 2.3.4

● Mobile Google Chrome 23.0

Reading information via the web server
The following information can be read from the CPU. The availability of the respective web 
pages depends on the CPU and its firmware version.

Page/information Description
Intro Entry page for the standard web pages
Start Page
Start page with general CPU information

The start page provides an overview of general 
information on the CPU, the name of the CPU, the 
type of CPU and basic information on the current 
operating state.

Identification
Identification information

Displays the static identification information such 
as serial number, order number and version 
numbers.

Diagnostic Buffer
Diagnostic information

Displays the content of the diagnostics buffer with 
the most recent entries first.

Module Information
Module information

Displays whether the centrally inserted 
components of a station are OK, whether there are 
maintenance requirements or components cannot 
be reached, for example.
As of firmware version 4 a firmware update is 
possible via this Web page.

Communication
Communication

Displays the communication connections during 
open communication (OUC); displays resources 
and address parameters.

Varable Status
Tags

Displays the status of operands of the user 
program to monitor and change the values.

Data Logs
(File Browser as of firmware version 4)

Data logs in CSV format to transfer to the hard disk 
of the programming device. The data logs are 
created with data log instructions in the user 
program and filled with data. 
As of firmware version 4 you have access to files 
of the internal load memory and of the external 
load memory (Memory Card), for example to the 
content of the directory "DataLogs" and "Recipes" 
via the Web page "File Browser".

User Pages
User pages (if user-defined web pages have been 
configured and loaded)

The user web pages deliver a list of web pages 
with customer-specific web applications.
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Web access to the CPU via PG/PC
Proceed as follows to access the web server:

1. Connect the client (PG/PC) to the CPU via the PROFINET interface.

2. Open the web browser.
Enter the IP address of the CPU in the "Address" field of the web browser in the format 
http://ww.xx.yy.zz (example: http://192.168.3.141).
The start page of the CPU opens. From the start page, you can navigate to further 
information. 

Standard web pages

Requirements for web access
The requirements for access to standard CPU web pages are explained in the following, as 
well as the effects of missing or existing configuration information.

Requirement   
The web server must be started.

The web server only starts when it has been activated in the properties of the CPU in the "Web 
server" section.

Note the following:

The web pages are normally transmitted via an non-secure connection and are not secured 
against hacker attacks. If you want to transfer the web pages in encrypted form to the browser, 
use the URL https://, followed by the IP address of the CPU.

Logon      
No logon is required to access the standard web pages read-only. A user must be logged on 
to execute certain actions like changing the operating mode of the CPU or for write access. 

For S7-1200 CPUs up to FW version V3: 

You must be logged on as "admin" for the actions listed above. The logon input boxes are on 
the top left of each standard web page.

If you log on as "admin", you must enter the user name and password there.

Name: admin.

Password: configured CPU password (for password-protected CPU).

For S7-1200 CPUs as of FW version 4: 

You can freely select the names of users and the passwords (CPU parameter "Web server", 
area "User management"). 
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You assign rights to the users, for example the right to query diagnostics or to update the 
firmware.

JavaScript and cookies
The standard web pages use JavaScript and cookies. You must enable both in your web 
browser.

If JavaScript is not enabled, the following limitations apply:

● Data from standard web pages is not automatically updated.

● You cannot log on as user.

● Fields cannot be sorted (module information)

If cookies are not enabled, you cannot log on.

See also
Access for HTTPS (Page 646)

Settings for operation

Settings for operation
To be able to use the web server of an S7-1200-CPU, you must select the CPU in the network 
view or the device view and make the following settings in the inspector window under 
"Properties > General > Web server":

● Enable the web server 

● Restricting access to the CPU to HTTPS transmission protocol (encrypted transmission)
Access via port 80 is then blocked. Communication is only possible via port 443.
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● Enabling automatic update of web pages 
The update interval is set by default and cannot be changed. The CPU updates web pages 
with changing content ( (for example, status information or diagnostics information) at 
regular intervals. 

● Creating and managing users
Users are exclusively entitled to options that are assigned to the access rights.
Depending on the CPU and firmware used, you can assign different user rights. Rights that 
your CPU does not support cannot be activated. A user called "Everybody" with minimal 
access rights, that you can, however, extend, is set by default in the user list. A user who 
uses the Web server without entering a password has "Everybody" user rights. 
You have the possibility of configuring further users with different access rights. These 
users have to log on with the configured user name and password.

 

 
 WARNING

Unauthorized access to the CPU by means of the Web server

Unauthorized access to the CPU or the changing of PLC variables to invalid values can 
result in interruptions of the processes controlled by the CPU and cause death, serious 
bodily harm or material damage!

Since the activation of the Web server allows authorized persons for example to change 
operating modes, to write-access CPU data or to update the firmware, we recommend 
that the following security measures be taken:
● If possible limit access to the HTTPS protocol.
● Create users with secure passwords. An example of a secure password is one which 

is only used for a single application, is more than 8 characters long, and consists of 
lower- and upper-case letters as well as symbols and numbers (?!+%$1234...). In 
addition, passwords based on common keyboard sequences or words from the 
dictionary should be avoided.
Change the password at regular intervals.

● Do not extend the rights of the "Everybody" user.
● Check the PLC variables in the user program and limit the range of values to 

permissible ranges since users can set invalid values via the Web server. 

 
 

Access for HTTPS

Access via HTTPS   
HTTPS is used for encrypting and authentication of communication between the browser and 
web server.

To transfer data between the browser and the CPU using the HTTPS protocol, enter the URL 
as https://ww.xx.yy.zz  in the address line of your browser, whereby ww.xx.yy.zz  stands for 
the IP address of the CPU. 

You require a valid, installed certificate for error-free HTTPS access to the CPU. 

If no certificate is installed a warning is displayed with a recommendation not to use this page. 
To view the page you must explicitly "Add exception".
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You can receive a valid certificate (Certification Authority) "SIMATIC CONTROLLER" as a 
download from the "Intro" web page under "Download certificate". The help function for your 
respective web browser provides information on how to install a certificate.

Accessing data of the CPU memory
You can access data in the internal or external CPU load memory by means of a standard web 
page.

● Use the web page "Data logs" for S7-1200 CPUs up to and including FW version 3. From 
this web page, you transfer the data logs from the CPU to a drive on your PC.

● Use the web page "File Browser" for S7-1200 CPUs as of FW version 4. From this web 
page, you transfer data from the folders "Data logs" or "Recipes", for example, to a drive 
on your PC. 

Depending on the file type and the access permissions you have configured for the web server 
user, you can download, delete, rename or upload the files. The actual directories can only be 
created, deleted or renamed.

Example: Data logs   
To open a data log, click on the link of the desired data log. You can then open the file (.csv), 
for example, in Microsoft Excel or in another program you choose or you can save the file.

Special note: Data logs are saved in U.S. American CSV format. You can only open the file 
directly using the U.S. version of Microsoft Excel. If you are using another national version of 
Microsoft Excel, you must import the file, selecting "comma" in the import assistant as the 
delimiter. 

Downloading a data log
To download a data log, click on the download icon of the desired data log. You can then open 
the file (.csv), for example, in Microsoft Excel or in another program you choose or you can 
save the file.

Downloading and clearing or deleting a data log
For a CPU with FW version up to V3.0: 

To download and delete the current entries of the data log, you must be logged on. To do this, 
click on the "Download and delete" icon of the required data log. You can then open the file 
(.csv), for example, in Microsoft Excel or in another program you choose or you can save the 
file. 

For a CPU as of FW version V4.0: 

To reset the data log, follow these steps: 

1. Open the CSV file, for example with Excel.

2. Delete the rows between the headline and the row with the entry "//END", if this row exists. 
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3. Save the file to a drive on your PC.

4. On the web page "File Browser", delete the data log (which means the CSV file) and upload 
the prepared CSV file to the CPU with the "Upload file" button of the "File Browser" web 
page. 

Additional information is available in the S7-1500 CPU system manual.

Create and download user-defined websites

What you need to know about user-defined web pages

Concept       
The concept of user-defined web pages allows you to access freely-designed web pages of 
the CPU from a web browser. The web server of the CPU provides this function.

You are not dependent on special tools for the design and functionality of the user-defined 
web pages. You can adapt the pages in the layout with CSS, provide dynamic content with 
JavaScript or use any framework to produce web pages.

The totality of files processed by the web server is also referred to as the "web application".

Web application and user program
Using HTML code in user-defined web pages, you can also transmit data via a web browser 
to the user program of the CPU for further processing and can display data from the operand 
area of the CPU in the web browser.

You can use script instructions (such as Javascript) to optimize your web pages, for example 
to dynamically change contents or validate user entries.

To synchronize between the user program and the web server, but also to initialize, you must 
call the WWW (SFC 99) instruction in the user program.

● If no interaction is required between the web application and the user program, for example, 
if a web page only provides static information, only initialization in the user program is 
required.

● If a simple data exchange is necessary between PLC tags and tags in web applications, to 
display the contents of PLC tags or write a value in a PLC tag for example, the syntax for 
reading and writing tags has to be observed. In this case only an initialization is required 
in the user program, for example in the startup OB. 

● If a further interaction is required between the web application and the user program, you 
must handle status and control information from the Web Control DB in addition to the 
synchronization between Web server and user program. This is the case, for example, 
when user entries are transmitted via the web browser to the web server for evaluation by 
the CPU. Unlike simple data exchange, the user program directly influences the time at 
which the requested web page is relayed back to the web browser. In this case, you must 
be acquainted with the concept of manual fragments and the structure of the Web Control 
DB.
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Initialization   
User-defined web pages are "packaged" in data blocks for processing by the CPU. You must 
generate appropriate data blocks from the source data (HTML files, images, JavaScript files, 
etc.) during configuration to be able to download the web application into the CPU. The Web 
Control DB takes on a special role (default: DB 333). It contains status and control information 
as well as links to additional data blocks with coded web pages. Data blocks that contain coded 
web pages are termed "Fragment DBs".

When the data block is downloaded into the CPU, the CPU does not "know" that user-defined 
web pages are coded inside it. The "WWW" (SFC 99) instruction, for example, in the Startup 
OB informs the CPU which DB is the Web Control DB. The user-defined web pages can be 
accessed via a web browser after this initialization.

Synchronization   
If the user program is to exchange data with the user-defined web pages, the WWW (SFC 99) 
instruction must be used in the cyclic program section.

Examples of interaction between user program and web page:

● Check received data

● Compiling and returning data for web browser making request

In this case, the status information must be able to be evaluated and control information must 
be transmitted to the web server, for example, to release a requested web page.

Procedural overview

Basic information
This section provides a step-by-step explanation of the basic procedure used to create and 
download custom web pages and to use them in the operating phase.

The following graphic provides a simplified representation of the process used in creating and 
displaying custom web pages:
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① Programming a web application (using suitable tools when required and AWP commands for 
dynamic pages when applicable).

② The web application is comprised of single source files, for example, *.html, *.gif, *.js, etc.
③ Using STEP 7:

● Generate the data blocks (Web Control DB and fragment DBs) from source files. The DBs 
contain meta information and the complete web application, including the images and the 
dynamic and static parts of the web application. The DBs are stored under "System blocks" 
in the project tree.

● Call the "WWW" instruction in the user program. This instruction initializes the web server 
of the CPU for a web application.

● If required, complete final programming for interaction between the web server and user 
program

④ Downloading the blocks to the CPU.
⑤ Call the web page in the browser. The web pages of the CPU are called by entering the IP 

address of the CPU.

Additional information
You can find additional information and examples relating to the S7-1200 web server on the 
Internet (http://support.automation.siemens.com/WW/view/en/36932465). 

Creating web pages
Web design tools from various companies can be used to create user-defined web pages. As 
a rule, the web pages should be programmed and designed compliant to the conventions of 
the W3C (World Wide Web Consortium). No check is made for compliance to W3C criteria in 
the web server of the CPU.
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Rules   
● The tool must be able to directly edit the HTML code so that the AWP command can be 

inserted into the HTML page.
Only the AWP commands are parsed in the CPU and, for example, replaced by values from 
the user program/process image of the CPU.

● Files containing AWP commands must be coded in UTF-8. In the metadata of the HTML 
page, therefore, set the attribute charset to UTF-8 and save the file UTF-8 coded.

● Files containing AWP commands must not contain the following sequence: ]]

● Files containing AWP commands must not contain the following sequence outside of the 
"Tag read ranges" (:=<Tag name>:): :=
Tip: Replace the first character of a prohibited sequence with its character coding; for the 
colon, for example, &#58;.

A small example for a custom web page should make clear the basic design.

Requirement
● The CPU must have a web server and the web server of the CPU must be activated.

● To be able to access PLC tags with write access as a user, you must be logged on as 
"admin".

● For the example below, PLC tags must be defined for those PLC tags that are to be shown 
on the web page. This is shown here for the first tab used, "Tank_below_max".

Creating user-defined web pages
The following code for an example web page reads values from the process image and 
provides them in a table.
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://www.w3.org/
TR/html4/strict.dtd">
<html>
  <head>
   <meta http-equiv="Content-Type" content="text/html; 
charset=utf-8">
   <title>Mix</title>
  </head>
   <body>
    <h1>Mix</h1>
    <h2> Actual State </h2>
    <table border="1">
     <tr>
      <th>Variable</th>
      <th>State</th>
     </tr>
     <tr>
      <td>Tank below max</td>
      <td>:="Tank_below_max":</td>
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     </tr>
     <tr>
      <td>Tank above min</td>
      <td>:="Tank_above_min":</td>
     </tr>
    </table>
   </body>
</html>

AWP commands
The interface between a freely-programmable web application for a CPU that has a web server 
and the CPU data is declared by the AWP command (Automation Web Programming). 

To develop web applications you are only subject to the restrictions of the web browser. In one 
of the programming languages of STEP 7, control with the user program which CPU data is 
displayed at what time in the web browser of the viewer. Use AWP commands, which you 
comment within the HTML files, to declare data to be used for intentional interaction between 
the web application and the user program.

AWP commands are inserted as HTML comments with a special syntax into HTML files; they 
declare the following features:

● Read PLC tags

● Write PLC tag

● Read special tags

● Write special tags

● Define enum types

● Assign tags to enum types

● Defining fragments

● Import fragments

Syntax of AWP commands     
An AWP command begins with "<!--AWP_" and ends with "-->". In JavaScript files, the 
commands should also be enclosed by JavaScript comments ("/*...*/").

Notation rules for PLC tag names within an AWP command   
The AWP commands "AWP_In_Variable" and "AWP_Out_Variable" contain a name attribute 
and optionally a use attribute. A PLC tag name is assigned to these attributes, by means of 
which the PLC tags in the browser are written or read. The following rules apply to handling 
PLC tag names in HTML code:

● PLC tags must be enclosed in quotation marks (" ... ").

● PLC tags used in AWP commands must also be enclosed by single quotation marks  ('" ... 
"') or with quotation marks masked by a backslash ("\" ... \"").
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● If the PLC tag name contains the character \ (backslash), this character must be designated 
with the escape sequence \\ as standard character of the PLC tag name.

● If the PLC tag name in the AWP command is also enclosed by single quotation marks and 
the single quotation mark (') occurs within the name, it must also be designed as normal 
character by the escape sequence \'.

● If an absolute address (input, output, bit memory) is used in AWP command, it is enclosed 
by single quotation marks.

PLC tag PLC tag in HTML code
"Velocity" <!-- AWP_In_Variable Name='"Velocity"' -->

<!-- AWP_In_Variable Name="\"Velocity\"" -->
"abc\de" <!-- AWP_In_Variable Name='"abc\\de"' -->
"abc'de" <!-- AWP_In_Variable Name='"abc\'de"' -->
"abc'de" <!-- AWP_In_Variable Name="abcde" Use'"abc\'de"' -->
"DB name".tag <!-- AWP_In_Variable Name='"DB name".tag' -->
"DB name"."ta.g" <!-- AWP_In_Variable Name='"DB name"."ta.g"' -->
- <!-- AWP_Out_Variable Name=’flag1’ Use='M0.0' -->

See also
Reading tags (Page 653)

Writing tags (Page 655)

Special tags (Page 656)

Reading tags
User-defined web pages can read PLC tags.

The PLC tag must be specified by a PLC tag name.

These OUT variables (direction of output as viewed from the controller) are inserted at any 
location within the HTML text with the syntax described in the following.

Syntax       
:=<varname>:
These references are replaced when the web server is in operation by the current values of 
the PLC tag in each case.

<varname> can be a simple, global CPU tag but also a complete tag path to a structure 
element.
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Notation rules for PLC tag names 
● PLC tags in HTML code are enclosed by quotation marks ("), if they are defined in the tag 

table. In the case of data block tags, the name of the data block is enclosed by quotation 
marks. If special characters are used in the structure elements of the data block, for example 
the dot (.) or blank, this part must also be enclosed by quotation marks.

● Quotation marks are not used for absolute addresses of inputs, outputs or bit memories.

PLC tag PLC tag in HTML code
"DB_name".var_name :="DB_name".var_name:
"DB_name".struct_name.var_name :="DB_name".struct_name.var_name:
"DB_name"."var.name" :="DB_name"."var.name":
"memory" :="memory":
- :=I0.0:

:=Q0.0:
:=MW100:
:=%MW100:

"My_Data_Block".flag1 <!-- AWP_Out_Variable Name='flag1' 
Use='"My_Data_Block".flag1' -->
...
:=flag1:

● If the PLC tag name contains the character : (colon) or \ (backslash), this character must 
be designated with the escape sequence \: or \\ as standard character of the PLC tag name.

 PLC tag PLC tag in HTML code
"abc:de" :="abc\:de":
"abc\de" :="abc\\de":

● Special characters "<, &, >"
Display problems can occur if these characters are contained in the tag name (for example, 
"a<b"). 
Avoid expressions such as :="a<b": in the HTML page. 
To prevent display problems from occurring, use e.g. an AWP command with a use 
expression according to the pattern depicted below. The use attribute defines the PLC tag 
with the problematic character, the name attribute defines the name without problematic 
character, as it is used in the HTML page. 

 PLC tag PLC tag in HTML code
"a<b" <!—AWP_Out_Variable Name='simplename' 

Use='"a<b"' -->
...
:=simplename:

See also
AWP commands (Page 652)
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Writing tags
Custom web pages can write data into the CPU. 

This requires an AWP command that identifies the PLC tag to be written.

The PLC tag must also be specified by a PLC tag name.

The IN tags (direction of input as viewed from the controller) are placed on the browser page. 
This can be done, for example, in a form.

The tags are either set in the HTTP header (by cookie or POST method) or in the URL (GET 
method) by the browser and are then written by the web server into the respective PLC tag.

Syntax       
To allow the IN tags to be written to the CPU, the tags must first be defined by an explicit AWP 
instruction:
<!-- AWP_In_Variable Name='<PLC_Varname1>' Name='<PLC_Varname2>' 
Name='<PLC_Varname3>' -->
Several tags can be defined in an instruction - such as that shown above.

The specific PLC tag name is hereby written in double quotation marks; for example 
<PLC_Varname1> = "myVar".

In cases where the name of the tag that you use for the web application is not identical to the 
name of the PLC tag, the "Use" parameter can be used to assign to a PLC tag.
<!-- AWP_In_Variable Name=’<Webapp_Varname>’ Use=’<PLC_Varname>’

Example
The "AWP_In_Variable" AWP command is indispensable when handling forms.
<form method='post' action='/awp/appl/x.html'>
 <p>
  <input name='"var1"' type='text'>
  <input value='set' name='Button1' type='submit'>
 </p>
</form>
In the form defined above, the HTTP request method "post" is used to transfer the tag "var1" 
to the web server. The user places the "var1" tag in the form field. The tag 'Button1' has the 
value 'set', but is not required for the CPU. To allow the "var1" tag to be written to the CPU, 
the following instruction must be included in the same fragment:
<!-- AWP_In_Variable Name='"var1"' -->
Since PLC tags are enclosed in double quotation marks ("), the name in the AWP command 
must be enclosed in single quotation marks (') or in masked quotation marks (\"). To avoid the 
numerous escape sequences, we recommend the use of single quotation marks.
<!-- AWP_In_Variable Name=’"Info".par1’ -->
<!-- AWP_In_Variable Name="\"Info".par1\"" -->
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Conditions for write access during operation 
The following requirements have to be met in order for a user to be able to write to PLC tags 
from a user-defined web page.

● The CPU is is password protected.

● The user is logged in as "admin".

This rules applies to all writing access to web pages on a CPU. 

See also
Requirements for web access (Page 644)

AWP commands (Page 652)

Special tags
Special tags are mainly HTTP tags set in the definition of the World Wide Web Consortium 
(W3C) . Special tags are also used for cookies and server tags.

The AWP command to read and write special tags differ only in that they have additional 
parameters than the AWP command used to read and write normal tags.

Reading a special tag     
The Web server can read PLC tags and transfer these to special tags in the HTTP Response 
Header. You can, for example, read a URL for a diversion to another web page and transfer 
to the special tag HEADER:Location using the special tag HEADER:Location. 

The following special tags can be read:

Name Description
COOKIE_VALUE:name Value of cookie with name: "name"
COOKIE_EXPIRES:name Execution time of cookie with name: "name" in 

seconds (must be set beforehand).
HEADER:Status HTTP status code (if no other value has been set, 

status code 302 is returned).
HEADER:Location Path for forwarding to another page. Status code 

302 must be set.
HEADER:Retry-After Anticipated time in which the service is not 

available. Status code 503 must be set.
HEADER: … All other header tags can also be forwarded in this 

way.

Use the AWP command "AWP_Out_Variable" to specify which PLC tags are to be transferred 
in the HTTP header to the web browser.

Basic structure:

 
<!-- AWP_Out_Variable Name="<Typ>:<Name>" [Use="<Varname>"] -->
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Parameter description
● Name: Type and name of special tag

● Use (optional parameter): In cases where the name of the special tag is not identical to the 
name of the PLC tag, parameter "Use" can be used to assign to a PLC tag.

Example:

 
<!-- AWP_Out_Variable Name="COOKIE_VALUE:siemens" Use='"info".language' -->

Writing a special tag
In principle, all HTTP tags written in the HTTP header by the web browser can be evaluated 
by the user program of the CPU. Examples of tag types:

Name Description
HEADER:Accept-Language Accepted or preferred language
HEADER:Authorization Proof of authorization for a requested resource
HEADER:Host Host and port of the requested resource
HEADER:User-Agent Information on the browser
HEADER: … All other header tags can also be forwarded in this 

way
  
SERVER:current_user_id Indicates whether a user is logged on 

(current_user_id=0: no user logged on)
SERVER:current_user_name User name of the user logged on
SERVER:GET Request method is GET
SERVER:POST Request method is POST
  
COOKIE_VALUE:name Value of cookie with name: "name"

The AWP command "AWP_In_Variable" is used to define which special tags are to be 
evaluated in the user program of the CPU. 

Basic structure:

 
<!-- AWP_In_Variable Name="<Typ>:<Name>" [Use="<Varname>"] -->
 

Parameter description:

Name: Type and name of special tag

Use (optional parameter): In cases where the name of the special tag is not identical to the 
name of the PLC tag, the parameter Use can be used to assign to a PLC tag.
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Examples:

 
<!-- AWP_In_Variable Name="COOKIE_VALUE:siemens" Use='"info".language' -->
 

The tag name in the HTTP header is replaced by the PLC tag name specified by Use . The 
cookie is written to the PLC tag "info".language . 

 
<!-- AWP_In_Variable Name='COOKIE_VALUE:siemens' Use='"info".language' -->
 

The tag name in the HTTP header is replaced by the PLC tag name specified by Use. The 
cookie is written to the PLC tag "info".language .

 
<!-- AWP_In_Variable Name='"COOKIE_VALUE:siemens"' -->
 

The HTTP-header variable is written in the same-name PLC variable.

See also
AWP commands (Page 652)

Enumeration types

Enumeration types (enums) 
Numerical values from the PLC program can be converted into text and vice versa using 
enums. The numerical values can also be assigned for several languages.

Creating enums 
Enter an AWP command using the following syntax at the start of the HTML file:
<!-- AWP_Enum_Def Name="<Name of the enum type>" 
Values='0:"<Text_1>", 1:"<Text_2>", ... , x:"<Text_x>"' -->
For example, for German values to be saved as an HTML file in the "de" folder of the HTML 
directory:

 
<!-- AWP_Enum_Def Name="Enum1" Values='0:"an", 1:"aus", 2:"Störung"' -->
 

For example, for English values, to be saved as an HTML file in the "en" folder of the HTML 
directory:
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<!-- AWP_Enum_Def Name="Enum1" Values='0:"on", 1:"off", 2:"error"' -->
 

Assigning enums 
Tags are assigned from the user program to the individual enum texts using a special AWP 
command:

 
<!-- AWP_Enum_Ref Name="<VarName>" Enum="<EnumTypeName>" -->
 

<VarName>  is thereby the symbolic name from the user program and <EnumTypeName> is 
the previously set name of the enum type.

 

 Note

In each fragment in which enum texts are referenced by a PLC tag, this PLC tag must be 
assigned by the appropriate AWP command of the enum type name.

Ensure that no AWP command for importing fragments is positioned between an enum 
assignment and enum usage because this import can result in the enum assignment lying in 
a different fragment than the enum usage.

 

Example
Enum type "state" is defined with values "0" and "1". "0" means "off", "1" means "on":

 
<!-- AWP_Enum_Def Name="state" Values='0:"off", 1:"on"' -->
 

The following code is contained in the HTML code of the web page to be output:

 
<!-- AWP_Enum_Ref Name="operating state" Enum="state" -->
:=operating state:
 

Depending on the value of the "operating state" tag, the ´result displayed  is no longer "0" or 
"1", but "off" or "on".

Simplified use of enumeration types
At S7-1200 CPUs as of firmware version 4 it is possible to use enumerations directly in AWP 
commands to read and write PLC variables. 
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You create enums as described in the previous section, and you can then utilize the values 
with user program read and write commands.   

Creating enums 
<!-- AWP_Enum_Def Name="<Name des Enum Typs>" Values='0:"<Text_1>", 
1:"<Text_2>", ... , x:"<Text_x>"' --> 

Utilizing enums in the user program read and write commands
<!-- AWP_In_Variable Name='<Varname>' Enum="<EnumType>" -->
<!-- AWP_Out_Variable Name='<Varname>' Enum="<EnumType>" -->

Example of reading PLC tags
<!-- AWP_Enum_Def Name='AlarmEnum' Values='0:"No alarms", 1:"Tank is 
full", 2:"Tank is empty"' --><!-- AWP_Out_Variable Name='"Alarm"' 
Enum="AlarmEnum" -->...<p>The current value of "Alarm" 
is :="Alarm":</p>
If the value of "Alarm" in the CPU is "2", the following text will be displayed on the HTML page:

'The current value of "Alarm" is Tank is empty' because the enum definition assigns the string 
"Tank is empty" to the numerical value 2.

Example of writing PLC tags
<!-- AWP_Enum_Def Name='AlarmEnum' Values='0:"No alarms", 1:"Tank is 
full", 2:"Tank is empty"' --><!-- AWP_In_Variable Name='"Alarm"' 
Enum='AlarmEnum' -->...
<form method="POST">
<p><input type="hidden" name='"Alarm"' value="Tank is full" /></p>
<p><input type="submit" value='Set Tank is full' /><p>
</form>
Because the enum definition assigns the string "Tank is full" to the numerical value "1", the 
value "1" is written to the PLC tag "Alarm". 

Definition of fragments

Fragments       
Fragments are "logical sections" of a web page to be processed by the CPU individually.

Fragments are usually complete pages but can also be individual elements such as files (for 
example, images) or complete documents.
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Defining fragments

 
<!-- AWP_Start_Fragment Name="<Name>" [Type="<Type>"] [ID="<Id>"] 
[Mode=<Mode>]-->
 

The start of a fragment is specified by this command. A fragment runs to the start of the next 
fragment or to the end of the file.

● <Name> Indicates the name of the fragment.
The name must start with a letter [a-zA-Z] or an underscore ( _ ). Letters, underscores or 
numbers [0-9] can follow after this first character.

● <Type> Indicates the type of the fragment.

– "manual" The user program is informed of the request for a fragment; the web page to 
be returned can be changed by the user program.

– "automatic" The page is automatically processed (default).

● <id> A numeric ID can be stipulated for the fragment. If no ID is assigned, the fragment is 
automatically assigned an ID. For manual pages (<Type>=manual) , the fragment can be 
addressed in the user program of the CPU by this ID.

 

  Note

Keep the ID low because the highest ID influences the size of the Web Control DB.
 

● <Mode> Fragments support the visible and hidden modes.

– "visible" The fragment is a part of the web page. This mode is preset and can also be 
omitted.

– "hidden" The fragment is not part of the web page. However, the fragment will be saved 
in the Web DB and is available to the user program for inserting in a requested web 
page. You use an exchange of the fragment ID (Web-Control-DB.fragment_index tag) 
to insert a "hidden" fragment in the requested web page.

The input document is completely divided into fragments by the "AWP_Start_Fragment" 
command. "AWP_End_Fragment" is therefore unnecessary.

Without a start fragment command, a file is mapped as a fragment; the fragment name is 
derived from the file name. If a file is divided into several fragments (by 
"AWP_Start_Fragment"), the file must begin with the "AWP_Start_Fragment" command.

Importing fragments
You can declare a fragment in an HTML page and import this fragment into other web pages.

Example
A company logo is to be displayed on all web pages of a web application.

There is only one instance of the HTML code for the fragment that displays the company logo. 
You can import the fragment as often and into as many HTML files as required.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  661



Syntax

 
<!-- AWP_Import_Fragment Name = "<name>"-->
 

● <name> is the name of the fragment to be imported.

Example
HTML code within a web page that declares a fragment:

 
<!-- AWP_Start_Fragment Name = "My_Company_Logo"-->
<p><img src = "compay_logo.jpg"></p>

Example
HTML code within another web page that imports the declared fragment:

 
<!-- AWP_Import_Fragment Name = "My_Company_Logo"-->
 

Creating and loading a data block

Requirement
● All source files required for the web application (*.html, *.js, *.png, ...) have been created.

● The source files are located in one folder, but only those source files that are required for 
the web application. No other files may be located in this folder.

 

 Note
Length of file names and tag names

If you have a comprehensive web application with many files and directories, the generation 
of the web data blocks may possibly fail. If this happens, the generation is aborted with the 
message "Text list overflow...". The cause is system-internal size limitations for management 
information saved in the web data block. 

Remedy: Use short file names and short tag names. 
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Procedure
To create data blocks from the source files for user-defined web pages in STEP 7, proceed 
as follows:

1. Select the CPU, for example, in the device configuration.

2. Select the properties for user-defined web pages in the inspector window under "Properties 
> General > Web server".

3. As "HTML source", select the folder that contains the source files for the web application.

4. Enter the HTMP page to be opened on starting the web application as the start HTML page.

5. Enter a name for the application if required.

6. You can supplement a range of file name extensions as "Files with dynamic content" if 
necessary. Only enter those file name extensions that also contain AWP commands.

7. The number for the Web Control DB and for the fragment DB start number can be kept as 
long as they are not already being used by your user program.

8. Click on the "Generate" button to create DBs from the source files.
The generated data blocks are saved in the project navigation in the "System block" folder 
(in the "Web server" subfolder).

9. In the CPU, select the network view to be loaded and then select the "Download to device" 
command in the "Online" menu to download the blocks. Compilation of the blocks is 
implicitly initiated before downloading.
If errors are reported during this process, you must correct these errors before you can 
download the configuration.

Structure of the PLC program
Your user program must call the " WWW" instruction to even allow the web application, for 
example, the user-defined web pages, to be available to the CPU on the standard web pages 
and to allow them to be called up there.   

The Web Control DB you have created from the source files is the input parameter (CTRL_DB) 
for the "WWW" instruction. The Web Control DB references the content of the user-defined 
web pages coded in the fragment DB and then receives status and control information.

Calling the "WWW" instruction in the startup program
If you do not want the user program to influence requested web pages, it is sufficient to only 
call the "WWW" instruction once in a startup OB. This instruction initializes communication 
between the web server and the CPU.

Calling the "WWW" instruction in the cyclic program
The "WWW" instruction can also be called in an OB processed in cycles (for example, OB 1). 
This has the advantage of being able to respond to web server requests from within the user 
program. Manual fragments must be used for this.

In this case, you must evaluate information from the Web Control DB in order to identify the 
requested web page or the requested fragment. On the other hand, you must set a bit in the 
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user program in order to explicitly release the web page to be returned by the web server after 
processing the web page request.

The structure of the Web Control DB is described in the following section.

Web Control DB
The Web Control DB (DB 333 by default) is created by STEP 7 and contains information on 
the structure of user pages, the status of communication and any errors that occur.

Additional fragment DBs are also created as well as the Web Control DB. These fragment DBs 
(there may also only be one fragment DB) are referenced in the Web Control DB. The fragment 
DBs contain the web pages and media data coded in fragments, for example, images. The 
content of the fragment DB cannot be changed by the user program. It is created automatically 
and is only for data management.

The status and control tags of the Web Control DB are accessed via symbols.

The following lists the tags of the Web Control DB required for status evaluation and to control 
interaction.

The Web Control DB provides two types of information:

● Global status information: Not bound to a concrete web page request.

● Request status and control information: Information about queued requests.

Global status information 

"WEB-Control_DB".commandstate.init Activates and initializes the web application.
"WEB-Control_DB".commandstate.deactivate Deactivates the web application.
"WEB-Control_DB".commandstate.inititializing The web application is initialized (read Web 

Control DB, etc.).
"WEB-Control_DB".commandstate.error Web application could not be initialized. The 

reason is coded  in "WEB-
Control_DB".commandstate.last_error .

"WEB-
Control_DB".commandstate.deactivating

The web application is closed.

"WEB-Control_DB".commandstate.initialized The web application has been initialized and is 
ready.

"WEB-Control_DB".commandstate.last_error Refer to the next table for a value table of 
possible errors.

Last_error Description
1 Fragment DB is inconsistent (does not match the Web Control DB).
2 A web application already exists with this name.
3 Memory problem initializing in the web server.
4 Inconsistent data in the Web Control DB.
5 A fragment DB is not available (not loaded).
6 No AWP ID for a fragment DB.
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Last_error Description
7 The enum fragment is not available (contains the texts and information on the enum 

types).
8 An action requested via the command flag in the Web Control DB is prohibited in the 

current state.
9 Web application is not initialized (if there is no reinitializing after disabling).
10 Web server is disabled.
... Last_error is reset once the web application has been successfully initialized.

Request status information
Request status information is bound to one of four possible requests, x = [1 … 4].

"WEB-Control_DB".requesttab[x].idle Nothing need be done.
"WEB-Control_DB".requesttab[x].waiting The user program must react to a request from 

a manual fragment and explicitly initiate further 
processing in the web browser.

"WEB-Control_DB".requesttab[x].sending The web server is occupied with processing the 
request/fragment.

"WEB-Control_DB".requesttab[x].aborting The TCP connection is closed by the web 
server.

Request control information
Request control information is bound to one of four possible requests, x = [1 … 4].

"WEB-Control_DB".requesttab[x].continue Releases the fragment being processed for 
transmission. Processing of the next fragment 
is initiated.

"WEB-Control_DB".requesttab[x].repeat Releases the fragment being processed for 
transmission. The fragment is then processed 
again.

"WEB-Control_DB".requesttab[x].abort Closes the TCP connection.
"WEB-Control_DB".requesttab[x].finish Releases the fragment being processed for 

transmission. Stops further processing of 
requests (terminates the request).

Example:
The tag for the DB is: "WEB-Control_DB". Whether errors have occurred during initialization 
of the web application can be determined by requesting bit "WEB-
Control_DB".commandstate.error in the user program.

If an error has occurred you can analyze it using the "WEB-
Control_DB".commandstate.last_error value.
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Interaction with the user program
Using manual fragments ensures that the user program reacts synchronously to the user 
program, thereby allowing the responding web page to be processed by the user program.

Fragment type     
To react to the received data in the user program the "manual" fragment type must be used 
for the fragment writing the data (for "manual pages"):
<!-- AWP_Start_Fragment Name="testfrag" ID="1" Type="manual" -->
The values are always transferred to the web server of the CPU for automatic and manual 
pages in the same way:

Example:
<form method="POST" action="">
<p>
<input type="submit" value="Set new value">
<input type="text" name='"Velocity"' size="20">
</p>
</form>

User program for manual fragments
When using manual pages, the "WWW" instruction must be called in cycles in the user program 
of the CPU.

To react to values entered in the browser, the request - which is made by the manual page to 
the web server - must first be evaluated in the user program. To do this, the Web Control DB 
(for example, DB 333) must be examined in cycles for queued requests. The array that 
manages four requests is contained in the "requesttab" section of the Web Control DB. Each 
element of the array thereby contains information on the respective request within a structure.

A simple programming example shows how queued requests are checked based on the tags 
of the Web Control DB.
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In cases where a request has been made, this program section writes the fragment ID in the 
#frag_index  tag and the request no. (value range 1-4) in the #req_index tag.

Using the information from this, the information transferred in the request can now be 
processed separately for each fragment ID in the program (for example, plausibility check).

Once processing of the request has been completed by the program, the request must be 
answered and the appropriate entry is once more reset under"requesttab" of the Web Control 
DB (for example, DB 333).

A simple programming example for replying to requests:
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Principle sequence of a browser request with interaction from the user program
The following figure shows the simplified, principle sequence of the web browser request on 
the effects of Web Control DB content and the actions required from the user program until 
the processed web page is returned (response).

Displaying custom web pages in the browser

Display web pages in browser 
Web pages are called from the standard web pages of the web browser. 
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In addition to the other links in the navigation bar, the standard web pages also have a link to 
"user pages". 

Click on the "user pages" link to open the web browser you have configured as the default 
HTML page. 

Creating custom web pages in several languages
You can make each of your custom web pages available in various languages.

Requirements
The language-dependent HTML; pages must be stored in a folder structure containing folders 
with the respective language abbreviations:

Specified language abbreviations  
Language abbreviations "de", "en", "fr", "es", "it" and "zh" are fixed. Additional language folders 
or other designated language folders are not supported.

Additional folders within the same folder hierarchy for other files can be created as required; 
for example, an "img" folder for images and a "script" folder for JavaScript files.

Language switching for custom web pages

Requirements
The HTML pages are contained in the predefined language folders, for example, HTML pages 
with German text are in the "de" folder, HTML pages with English text are in the "en" folder.

Language switching concept 
Language switching is based on a predefined cookie named "siemens_automation_language". 
If the cookie is set to value "de", at the next web page request or web page update, the web 
server switches to the web page from the  "de" folder.

Similarly, the web server switches to the web page from the "en" folder when the cookie is set 
to "en".
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Example of language switching
The example is structured as follows:

● The language-dependent HTML files with the same name, for example,  "langswitch.html" 
are located in both language folders "de" and "en". The text to be displayed within the two 
files are German or English, corresponding to the name of the folder.

● There is an additional "script" folder in the folder structure containing the JavaScript file 
"lang.js". Functions required for language switching are stored in this file .

Structure of the "langswitch.html" file ("de" folder)
Meta data "content language", charset and path to JavaScript file are set in the file header.
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta http-equiv="Content-Language" content="de">
<meta http-equiv="Content-Type" content="text/html; charset=utf-8">
<title>Switch language to German page</title>
<script type="text/javascript" src="script/lang.js" ></script>
<head>
Language selection is implemented in the body of the file by the "select" HTML element. The 
select element initiates a list box and contains the "de" option, labeled as "German" and "en", 
labeled as "English"; "de" is the default. 

The "DoLocalLanguageChange(this)" function is called using the "onchange" event handler. 
The "this" parameter transmits the select object with the selected option to this function. 
"onchange" calls the function each time the option is changed.
<!-- Language Selection -->
<table>
    <tr>
        <td align="right" valign="top" nowrap>
          <!-- change language immediately on change of the selection 
-->
          <select name="Language" 
onchange="DoLocalLanguageChange(this)" size="1">
                <option value="de" selected >Deutsch</option>
                <option value="en" >English</option>
            </select>
        </td>
     </tr>
</table>
<!-- Language Selection End-->

Structure of the "langswitch.html" file ("en" folder)
The header of the HTML file with English text is structured similarly to the HTML file with 
German text. 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta http-equiv="Content-Language" content="en">
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<meta http-equiv="Content-Type" content="text/html; charset=utf-8">
<title>Language switching english page</title>
<script type="text/javascript" src="script/lang.js" ></script>
Language selection is also implemented in the body of the file by the "select" HTML element. 
In contrast to the German HTML file, the English option is already selected as a default and 
the test or the labels are in English.
<!-- Language Selection -->
<table>
    <tr>
        <td align="right" valign="top" nowrap>
          <!-- change language immediately on change of the selection 
-->
          <select name="Language" 
onchange="DoLocalLanguageChange(this)" size="1">
                <option value="de" >German</option>
                <option value="en" selected >English</option>
            </select>
        </td>
     </tr>
</table>
<!-- Language Selection End-->

Structure of "lang.js" file (in the "script" folder)
The " DoLocalLanguageChange" function is defined in the Java script file and calls the 
"SetLangCookie" function with the language selection value. SetLangCookie combines the 
cookie name and cookie value and then sets the cookie by means of the corresponding 
document.cookie property. The web page must then be reloaded (top.window.location.reload) 
to allow the web server to react to the setting of the cookie by displaying the required language.

 
function DoLocalLanguageChange(oSelect) {
        SetLangCookie(oSelect.value);
        top.window.location.reload();
    }
 
 function SetLangCookie(value) {
        var strval = "siemens_automation_language=";
            // this is the cookie by which the web server
            // detects the desired language
            // this name is required by the web server
        strval = strval + value;
        strval = strval + "; path=/ ;";
            // set path to the application, since otherwise
            // path would be set to the requesting page 
            // would not get the cookie. 
            // The path for user defined applications follows this 
sample: 
            // path=/awp/<application name>/<pagename>
            // example: path=/awp/myapp/myappstartpage.htm 
            //(where myapp is the name of the web application 
            // entered in the web server properties of the cpu)
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            /*
            use expiration if this cookie should live longer
            than the current browser session
            var now      = new Date();
            var endttime = new Date(now.getTime() + expiration);
            strval = strval + "; expires=" + endttime.toGMTString() 
+ ";";
            */
        document.cookie = strval;
    }

Additional configurations

Configuring additional functions
The S7-1200 automation system has numerous additional functions that are useful as 
integrated CPU functions or available via plug-in modules (for example, communication 
modules). You can find the description via the following links.

See also
Overview of point-to-point communication (Page 867)

General information on high-speed counters (Page 863)

Configuring PID_Compact V1 (Page 5959)

Configuring PID_3Step V1 (Page 5991)

Motion functionality of the CPU S7-1200 (Page 6008)
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8.1.4.4 S7-1200 CM/CP

S7-1200 CM/CP

Telecontrol S7-1200

CP 1242-7

CP 1242-7 configuration

Modes of the GPRS-CP

Modes of the CP     
The CP 1242‑7 allows an S7‑1200 to communicate as a GPRS station with a central station 
or other remote networks via the GSM network. For communication using GPRS, the CP is 
set to one of the following operating modes:

● Telecontrol
This operating mode of the CP allows the GPRS station to exchange data with the following 
partners:

– Communication with the Telecontrol server
This CP mode allows the GPRS station to exchange data with a telecontrol server.
The Telecontrol server is a PC connected to the Internet with the "TELECONTROL 
SERVER BASIC" application. It is generally located in the master station and serves to 
monitor and control the remote GPRS stations. Data can be exchanged with the OPC 
client of a central control system via the integrated OPC interface.
The Telecontrol server PC is not configured in STEP 7. The "TELECONTROL SERVER 
BASIC" application has its own configuration user interface.

– Communication with another remote GPRS station
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The message frames are transmitted via the Telecontrol server.

– Communication with an engineering station (for TeleService)

Communication with the Telecontrol server is performed via the GSM network and the 
Internet.
This operating mode requires a SIM card with GPRS service enabled and a Telecontrol 
server that can be reached by the CP.

● GPRS direct
This operating mode of the CP is used for direct communication between remote stations 
via the GSM network. No Telecontrol server is required.
To allow network nodes in public wireless networks to be directly accessible, these need 
to be addressed using a fixed address. Here, SIM cards with a fixed IP address are used 
that allow the stations to address each other directly.
The possible communications services and security functions (for example VPN) depend 
on what is offered by the network provider.
Possible communications partners of the GPRS station with a CP 1242‑-7 in "GPRS direct" 
mode are:

– A subscriber that can be reached by the CP via an IP address (GPRS station with 
CP 1242‑7)

– An engineering station (for TeleService)

Establishing a connection using GPRS communication

Connection modes  
● "GPRS direct" mode

There are no different connection modes in the "GPRS direct" mode.

● "Telecontrol" mode
The CP can be configured for the following connection modes.

– "Permanent" connection mode  
There is a permanent TCP connection to the telecontrol server. Following connection 
establishment, there is a permanent TCP connection to the telecontrol server even if 
data is not transferred permanently.

– "Temporary" connection mode   
A connection is only established to the telecontrol server when required.

If a TCP connection is established, process data is sent as soon as the telecontrol instructions 
are called on the CPU.

A connection is always established by the CP. If a connection established by the CP is 
interrupted, the CP automatically attempts to re-establish the connection.

Triggering connection establishment for permanent stations ("Telecontrol" mode)
In the "Telecontrol" mode, the permanent connection to the telecontrol server is established 
when the station starts up. If there is an interruption on the connection, the establishment of 
the connection can be triggered by a wake-up SMS (see below).
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Triggering connection establishment for temporary stations ("Telecontrol" mode) 
With "temporary" stations, connection establishment can be triggered by the following events:

● Event on the local CPU that needs to be evaluated by the program.
In terms of the program, two situations need to be distinguished:

– Events that lead to a single connection establishment (for example alarms or commands 
from the operator).

– Expiry of an interval that leads to cyclic connection establishment (for example once 
daily for data transmission)

● Request by a communications partner (OPC client or S7 station)
The request from the communications partner leads to the connection being established.

● Request for TeleService by an engineering station
The request switched by the telecontrol server or TeleService gateway does not need to 
be evaluated in the program.

● Wake-up SMS of the telecontrol server
The wake-up SMS can be triggered spontaneously on the telecontrol server. It is also 
possible to configure cyclic sending on the telecontrol server.

● Telephone wake-up call
The wake-up call can be sent from a telephone that has a phone number authorized in the 
STEP 7 project. The telephone must support the CLIP function (transfer of its own call 
number).
The connection establishment with the (main) telecontrol server is triggered.

● Telephone wake-up SMS
The wake-up SMS can be sent from a telephone that has a phone number authorized in 
the STEP 7 project. The telephone must support the CLIP function (transmission of its own 
number) and sending of SMS.
The connection establishment with the telecontrol server specified in the SMS is triggered.

When a temporary station is woken up, all the data is transferred if this has changed since the 
last data transfer.

Triggering connection establishment in "GPRS direct" mode
In "GPRS direct" mode, a connection establishment is triggered by the following events:

● Event on the local CPU that is evaluated by the program.

● Request by a communications partner (not an engineering station)
The request in the frame received from the communications partner is evaluated in the 
program by calling the telecontrol instructions.

● Request for TeleService by an engineering station
The request switched by the telecontrol server or TeleService gateway does not need to 
be evaluated in the program.
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Right to wake-up by "authorized phone numbers"
The CP only accepts an SMS if the sending communication partner is authorized based on its 
phone number. These numbers are in configured for the CP in STEP 7 in the "authorized phone 
numbers" list. 

 

 Note
"Authorized phone numbers" in the STEP 7 project
● A phone number entered here gives the sender who transfers this phone number the right 

to trigger connection establishment.
● If an asterisk (*) is entered in the list, the CP accepts SMS messages from all senders.
● If the list is empty, the CP cannot be woken up for connection establishment.
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Wake-up SMS
Depending on the connection type and the triggering server or intermediary TeleService 
server, the following text must be transferred in the wake-up SMS:

● For telecontrol connections:

– Text for the wake-up SMS message for establishing a connection to the telecontrol 
server:
TELECONTROL

– Text for the wake-up SMS message for establishing a connection to the main telecontrol 
server:
TELECONTROL MAIN

– Text for the wake-up SMS message for establishing a connection to the substitute 
telecontrol server:
TELECONTROL BACKUP

The configuration of the telecontrol server for the GPRS CP is set in STEP 7 in "Telecontrol 
interface > Operating mode > main or substitute telecontrol server".

 

  Note
Wake-up with a mobile phone
● One of the texts listed above can be used in a wake-up SMS message.
● With a wake-up call, the station always connects to the main telecontrol server.

 

● For TeleService connections:

– Text for the wake-up SMS message for establishing a connection to the first configured 
TeleService server:
TELESERVICE
or
TELESERVICE 1

– Text for the wake-up SMS message for establishing a connection to the second 
configured TeleService server:
TELESERVICE 2

The configuration of the TeleService server for the GPRS CP is set in STEP 7 in "Telecontrol 
interface  > TeleService authorization > 1st or 2nd TeleService server".
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Preferred GSM networks

Selection of preferred GSM networks
The following options are provided to select the GSM networks that the CP 1242‑7 should 
preferably dial up:

● Automatic dialup
The CP dials with highest priority into the GSM network of the contracted network operator 
set on the SIM card. If a connection cannot be made within the contracted network, the CP 
dials up another GSM network with which the network operator has a roaming contract and 
whose access data is stored on the SIM card.

● Contract network only
The CP only dials up the GSM network of the contracted network operations whose SIM 
card is plugged into the CP. No roaming.

● Contracted network and alternative network
The CP dials up the contracted network with the highest priority. If dialup to the contracted 
network is unsuccessful, the CP dials up an alternative GSM network, in decreasing priority, 
as entered in the list of preferred network operators.
The alternative networks are entered in the list as "Public Land Mobile Network" (PLMN). 
PLMN is a construct of Mobile Country Code (MCC) and Mobile Network Code (MNC).
Example: 26276
This is the PLMN for the test network of Siemens AG with MCC = 262 and MNC = 76.

Time-of-day synchronization in NTP mode - parameter assignment

NTP mode (NTP: Network Time Protocol)
In NTP mode, the CP sends time-of-day queries at regular intervals to one or more NTP 
servers. From the responses of the servers, the CP selects the most accurate time of day.

The advantage of this mode is that it allows the time to be synchronized across subnets.

In NTP mode, it is generally UTC (Universal Time Coordinated) that is transferred. This 
corresponds to GMT (Greenwich Mean Time).

CP 1242-7 TeleService

TeleService via GPRS

Communication path for TeleService via GPRS  
With TeleService for remote S7 stations with the CP 1242‑7 via GPRS, the connection is 
always established via an intermediary between the engineering station and remote S7 station.

This intermediary can be either:
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● A telecontrol server (and possibly a substitute telecontrol server)
The telecontrol server can be a separate PC or installed on the engineering station in the 
form of the "TELECONTROL SERVER BASIC" application.

● A TeleService server
A TeleService server is used when no telecontrol server is available; in other words, when 
the CP operates in "GPRS direct" mode.

The telecontrol server or TeleService server can be connected to the engineering station via 
LAN or Internet and the TeleService function can be called from there.

Requirements for TeleService via GPRS
● A telecontrol server or a TeleService server

● The STEP 7 project with the required data for GPRS communication

Note on project engineering
The telecontrol server and TeleService server are not configured in STEP 7.

See also
Establishing a connection using GPRS communication (Page 675)

Modes of the GPRS-CP (Page 674)

Establishing a TeleService connection via GPRS

Establishing a connection for TeleService via GPRS
The request to establish a connection is triggered by the engineering station and transmitted 
by a wake-up SMS to the station. The CP 1242‑7 in the S7‑1200 station establishes a 
connection to the engineering station via the GSM network and the Internet.

Starting the TeleService via GPRS  
Start the TeleService via GPRS as follows:

1. In the project on the authorized engineering station, select the remote S7 station with which 
you want to establish a TeleService connection via GPRS.

2. Alternatively, open the "Connect online" dialog box as follows:

– "Connect online" button

– "Connect online" shortcut menu (right mouse button)

– "Online" > "Connect online" menu

The "Connect online" dialog box opens.

3. Choose interface type "TeleService GPRS" in the "Type of PG/PC interface" drop-down 
list.
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4. In the "PG/PC interface" drop-down list, select the "GPRS TeleService board" option if it is 
not automatically displayed.

5. Click on the "Connect" icon next to the "PG/PC interface" drop-down list.
The "Establish remote connection" dialog box opens.

6. Make the necessary settings in the "Establish remote connection" dialog.
Details of this are contained in the tooltip cascade of STEP 7.

The following details are required to successfully establish a connection:

Details required to establish a connection with the GPRS station
The following information is necessary in the Establish remote connection" dialog:

● IP address or DNS name of the telecontrol server

● TCP port number of the telecontrol server or the DSL router via which the connection 
between the engineering station and the remote GPRS station is running.

● Server password of the ES to authenticate the engineering station at the telecontrol server
Only required if a group-specific password has been configured in the "TELECONTROL 
SERVER BASIC" application.

● TeleService user name
See CP configuration in STEP 7.

● TeleService password
See CP configuration in STEP 7.

● Access ID of the CP
Only required when there are several CP 1242‑7s in the station. See CP configuration in 
STEP 7.

Status

Connection statuses of TeleService via GPRS
The following connection statuses can be displayed in the "Establish remote connection" dialog 
box:

● Not connected
There is no connection to the remote GPRS station. Connection establishment has not yet 
started.

 

If connection establishment was started by clicking the "Connect" button, the following statuses 
are displayed one after the other after the connection has been established:

● Connect to telecontrol server
The engineering station connects to the telecontrol server.

● Wait for S7 station
The wake-up SMS has been sent to the remote station. Wait for reply from station.
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● Authentication at S7 station
The S7 station has established an IP connection with the engineering station via GPRS 
and Internet and is checking the received logon and authentication data.

● Connected
The station has successfully established the connection to the engineering station.

 

The following states may be displayed if the connection cannot be successfully established:

● Telecontrol server not accessible
Possible causes:

– The connection between the engineering station and the telecontrol server has been 
interrupted.

– The telecontrol server is switched off.

● Wrong server password
Cause: The wrong server password for logging on and authentication was entered at the 
telecontrol server.

● S7 station not responding
Possible causes:

– Faulty GSM communication between the telecontrol server and the station.

– Faulty connection between the GSM network and the Internet.

– Faulty Internet connection.

– The telecontrol server could not send a wake-up SMS.

– The CP has not received a wake-up SMS.

– The sender of the SMS was not configured in the list of authorized wake-up call numbers.

● Wrong TeleService user name or TeleService password
Possible causes:

– An incorrect TeleService user name or incorrect TeleService password was entered in 
the authentication dialog for the CP 1242‑7.

– The TeleService user name or TeleService password was not configured in STEP 7.

● All TeleService access points are in use.

● The CP is not known to the telecontrol server.
Cause: The CP originates from a STEP 7 project that does not match the project of the 
telecontrol server.

● No resources available for TeleService on the CP: Please contact the hotline.

● Protocol error
Cause: Wrong frame or frame from wrong subscriber. Please contact the hotline.
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CP 1243-1

CPU scan cycle

Structure of the CPU scan cycle
The cycle with which the CP scans the memory area of the CPU is made up of the following 
phases:

● High-priority read jobs
For datapoints configured with the priority "high priority", the PLC tags are all read in every 
scan cycle.

● Unsolicited write jobs
In every cycle, the values of a certain number of unsolicited write jobs are written to the 
CPU. The number of tags written per cycle is specified with the "Max. number of write jobs" 
parameter. The tags that exceed this value and can therefore not be written in one cycle 
are then written in the next or one of the following cycles.

● PLC tags with change control
The values of PLC tags registered with the CPU for automatic change control are all read 
in every scan cycle.

● Low-priority read jobs - proportion
For datapoints configured with the priority "low priority", a proportion of the values of their 
PLC tags is read in every scan cycle. The number of tags read per cycle is specified with 
the "Max. number of read jobs" parameter. The tags that exceed this value and can 
therefore not be read in one cycle are then read in the next or one of the following cycles.

● System delay
This is the processing time of a scan cycle.

Duration of the CPU scan cycle
Since no fixed time can be configured for the cycle and since the individual phases cannot be 
assigned a fixed number of objects, the duration of the scan cycle is variable and can change 
dynamically.

A pause between cycles can also be configured to reserve adequate time for other processes 
that access the backplane bus of the station.

Datapoint types
During the configuration of the user data to be transferred by the CP 1243-1, each datapoint 
is assigned a protocol-specific datapoint type. The datapoint types supported by the CP along 
with the compatible S7 data types are listed below. They are grouped according to format and 
memory requirements.
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CP 1243‑1 (DNP3): Datapoint types and object groups
The DNP3 protocol specifies object groups that differ according to data type and send direction 
(out) or receive direction (in).

Table 8-48 Object groups and data types supported by the CP (DNP3)

Format (memory 
requirements)

Datapoint type (object group) Direction: in / out Compatible S7 data types

● Bit ● BOOL
 Binary Input (1) in  
 Binary Input Event (2) in  
 Binary Output (10) out  
 Binary Output Event (11) out  
 Binary Command (12) out  
● Byte
● Integer (16 bits)
● Integer (32 bits)

● BYTE, SINT, USINT
● INT, UINT, WORD
● DINT, UDINT, DWORD

 Counter Static (20) in  
 Frozen Counter (22) in  
 Counter Static Event (21) in  
 Frozen Counter Event (23) in  
 Analog Input (30) in  
 Analog Input Event (32) in  
 Analog Output Status (40) out  
 Analog Output (41) out  
 Analog Output Event (42) out  
 Octet String (110) * in  
 Octet String Event (111) * in  
 Octet String (110) * out  
● Floating-point number (32 bits)
● Floating-point number (64 bits)

● REAL
● LREAL

 Analog Input (30) in  
 Analog Input Event (32) in  
 Analog Output Status (40) out  
 Analog Output (41) out  
 Analog Output Event (42) out  
 Octet String (110) * in  
 Octet String Event (111) * in  
 Octet String (110) * out  

* Contiguous memory areas can be transferred up to size of 255 bytes via datapoint types of the object groups 110 (Octet 
String) and 111 (Octet String Event).
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Types of transmission and event classes

Types of transmission for datapoint values
The values of datapoints can be assigned to various types of transmission. The value of a 
datapoint is sent either after being requested by the communications partner or unsolicited as 
an event. The following event classes are possible:

● Transfer after call
The value of the datapoint is transferred only following a call by the communications partner.

● Every value triggered
Each individual changed value in the image memory of the CP is transferred.

● Event class ...
The value is transferred triggered as a class 1, 2 or 3 event.

● Current value triggered
Only the value of a datapoint stored in the image memory of the CP at the time of the trigger 
that triggers the transfer is transferred.

Analog value preprocessing
Some CPs have analog value preprocessing that, among other things, supports the functions 
described below.

Smoothing factor
Analog values that fluctuate quickly can be evened out using the smoothing function.

The smoothing factors are calculated according to the following formula as with S7 analog 
input modules.

1
y

x k y

k
n

n n
=

+ − −( )1

where
yn = smoothed value in the current cycle 
xn = value acquired in the current cycle n
k = smoothing factor

The following values can be configured for the module as the smoothing factor.

● 1 = No smoothing

● 4 = Weak smoothing

● 32 = Medium smoothing

● 64 = Strong smoothing

Fault suppression time
An analog value in the overflow range (32767 / 7FFFh) or underflow range (-32768 / 8000h) is 
not transferred for the duration of the fault suppression time. This also applies to live zero 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  685



inputs. The value in the overflow/underflow range is only sent after the fault suppression time 
has elapsed, if it is still pending.

If the value returns to the measuring range before the fault suppression time elapses, the 
current value is transferred immediately.

A typical use case for this parameter is the suppression of peak current values when starting 
up powerful motors that would otherwise be signaled to the control center as a disruption.

The suppression is adjusted to analog values that are acquired by the S7 analog input modules 
as raw values. These modules return the specified values for the overflow or underflow range 
for all input ranges (also for live zero inputs).

If the CPU makes preprocessed finished values available in the bit memory area or in a data 
block, fault suppression is only possible or useful if these values have the values listed above 
(32767 / 7FFFh) or (-32768 / 8000h) in the overflow or underflow range. If this is not the case, 
the parameter should not be enabled for preprocessed values.

Mean value generation
With this parameter, acquired analog values are transferred as mean values.

The current values of an analog datapoint are acquired cyclically and totaled. The number of 
acquired values per time unit depends on the read cycle of the CPU and the CPU scan cycle 
of the CP. The mean value is calculated from the accumulated values as soon as the transfer 
is triggered by a time trigger. Following this, the accumulation starts again so that the next 
mean value can be calculated.

The mean value can also be calculated if the transmission of the analog value message is 
triggered by a request from the communications partner. The duration of the mean value 
calculation period is then the time from the last transmission (for example triggered by the 
trigger) to the time of the request. Once again, the accumulation restarts so that the next mean 
value can be calculated.

If the acquired analog value in the overflow range (32767 / 7FFFh) or underflow range (-32768 / 
8000h), this value can either be taken into account immediately in the calculation of the mean 
value or it can be suppressed for a specific period for the calculation of the mean value. The 
required response can be decided with the Fault suppression time parameter:

● Fault suppression time = 0
Acquisition of a value in the overflow or underflow range results in the mean calculation 
being stopped immediately. The value 32767 / 7FFFh or -32768 / 8000h is saved as an 
invalid mean value for the current mean value calculation period and sent when the next 
analog value message is triggered. The calculation of a new mean value is then started. If 
the analog value remains in the overflow or underflow range, this new value is again saved 
immediately as an invalid mean value and sent when the next frame is triggered.

● Fault suppression time > 0
If the acquired analog value is in the overflow or underflow range, the bad values are 
excluded from the calculation of the mean value for a maximum time as defined by the Fault 
suppression time. If this time is exceeded, the value 32767 / 7FFFh or -32768 / 8000h is 
saved as an invalid mean value and sent when the next analog value frame is triggered. 
The procedure is identical in each new averaging period; in other words, bad values are 
again suppressed for the duration of the fault suppression time.

The duration of the fault suppression time also indirectly decides the proportion of invalid values 
per averaging period. If the mean value is formed, for example in a cycle of 15 minutes, and 
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the fault suppression time is set to 5 minutes, this means that the mean value is only transferred 
as invalid if more than 33% of the acquired analog values are in the overflow or underflow 
range in the current averaging period.

8.1.4.5 IPv6 protocol
The Internet Protocol version 6 - called IPv6 below - extends the Internet Protocol version 4 
(IPv4) that is used predominantly at the current time.

Address format IPv6: Notation
IPv6 addresses consist of 8 fields each with four-character hexadecimal numbers (128 bits in 
total). The fields are separated by a colon.

Example:

fd00:ffff:ffff:ffff:ffff:ffff:2f33:8f21

Rules / simplifications:

● Leading zeros within a field can be omitted.
Example: fd01:0:ffff::2d12:7d23

● If one or more fields have the value 0, a shortened notation is possible. 
The address fd00:0:0:0:0:0:0:0:8f21 can also be shortened and written as follows:
fd00::8f21
To ensure uniqueness, this shortened form can only be used once within the entire address.

● Decimal notation with periods
The last 2 fields or 4 bytes can be written in the normal decimal notation with periods.
Example: The IPv6 address fd00::ffff.125.1.0.1 is equivalent to fd00::ffff:7d01:1

Entry and appearance
The entry of IPv6 addresses is possible in the notations described above. IPv6 addresses are 
always shown in the same notation in which they were entered.

8.1.4.6 SCALANCE X, W and M

Legal notice

Qualified personnel
The product/system belonging to this documentation may only be handled by qualified 
personnel for the intended purpose taking into account the documentation relating to the 
intended purpose and, in particular, the safety and warning notices it contains. Due to training 
and experience, qualified personnel is capable of recognizing risks and avoiding possible 
dangers when handling these products/systems
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Editing properties and parameters

Editing options
You have the following options for editing properties and parameters:

● Hardware and network editor
Once you have inserted the network component, you can edit the properties and 
parameters, for example the device name. You will find more detailed information in 
"Hardware and network editor".

● Web Based Management (WBM) 
The parameters and properties are accessible using the supplied HTML pages (WBM 
pages). Each WBM page has its own help page that describes the properties and 
parameters. For further information, refer to the configuration manual "SCALANCE X500 
Web Based Management". You will find the MIB at Siemens Industry Automation and Drives 
Service & Support on the Internet under the entry ID 67428305 (http://
support.automation.siemens.com/WW/view/en/67428305).

● Command Line Interface
All the configuration settings for the device can be made using the CLI. The CLI provides 
the same options as Web Based Management (WBM). For further information, refer to the 
configuration manual "SCALANCE X500 Command Line Interface". You will find the MIB 
at Siemens Industry Automation and Drives Service & Support on the Internet under the 
entry ID 67430663 (http://support.automation.siemens.com/WW/view/en/67430663).

Requirement for WBM and CLI
● The device has an IP address

● There is a connection between the device and the client PC. With the ping command, you 
can check whether or not a connection exists.

● The integrated Web server is activated.

● Recommended Web browser:

– Microsoft Internet Explorer version 9.0

– Mozilla Firefox version ESR17

● JavaScript is activated in the Web browser.

● The Web browser must not be set so that it reloads the page from the server each time the 
page is accessed. The updating of the dynamic content of the page is ensured by other 
mechanisms. 
In the Internet Explorer, you can make the setting in the "Tools > Internet Options > General" 
menu in the section "Browsing history" with the "Settings" button. Under "Check for newer 
versions of stored pages:", select "Automatically".

● If a firewall is used, the relevant ports must be opened.

– For access using HTTP: Port 80

– For access using HTTPS: Port 443

Display of the WBM on mobile devices:

For mobile devices, the following minimum requirements must be met:
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Resolution Operating system Web browser
960 x 640 
pixels

Android as of version 
4.2.1
iOS as of version 
6.0.2

Chrome as of version 18 on Android
Safari as of version 6 on iOS

Tested with the following Web browsers for mobile devices

● Safari as of V6 on iOS 6 (iPad Mini, iPod Touch 4. Generation)

● Chrome 25 on Android (Galaxy Nexus 4, Galaxy Nexus 7)
 

 Note
Page display and working with the WBM on mobile devices

The display on the WBM pages and how you work with them on mobile devices may differ 
compared with the same pages on desktop devices. Some pages also have an optimized 
display for mobile devices.

 

Availability
The availability of the properties and parameters depends on the port type. The following types 
are possible:

● Switch port

● Router port

IP address assignment 

Configuration options
When shipped and after restoring to the factory settings, the device does not have an IP 
address.

The following options are available to assign an IP address to the device:

● DHCP (default setting)

● Primary Setup Tool
For further information, refer to the configuration manual "Primary Setup Tool". You will find 
the MIB at Siemens Industry Automation and Drives Service & Support on the Internet 
under the entry ID 19440762 (http://support.automation.siemens.com/WW/view/en/
19440762).

● STEP 7

● CLI via the serial interface
For further information, refer to the configuration manual "SCALANCE X500 Command 
Line Interface". You will find the MIB at Siemens Industry Automation and Drives Service 
& Support on the Internet under the entry ID 67430663 (http://
support.automation.siemens.com/WW/view/en/67430663).
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Requirement
● "Set IP address using a different method" is enabled in the properties of the device. You 

will find more detailed information in "Addressing PROFINET devices".

System

Configuration
On this page, you specify the services with which the device can be accessed. With some 
services, there are further configuration pages on which more detailed settings can be made.

Settings  
● Telnet-server

Enable or disable the "Telnet Server" service for unencrypted access to the CLI.

● SSH server
Enable or disable the "SSH Server" service for encrypted access to the CLI.

● HTTPS server only
Enable or disable access using HTTP.

● SMTP Client
Enable or disable the SMTP client. You can configure other settings in "System > SMTP 
Client".

● Syslog Client
Enable or disable the system event client. You can configure other settings in "System > 
Syslog client".

● DCP Server
Specify whether or not the device can be accessed with DCP (Discovery and Configuration 
Protocol): 

– "-" (disabled)
DCP is disabled. Device parameters can neither be read nor modified.

– Read/write
With DCP, device parameters can be both read and modified.

– Read only
With DCP, device parameters can be read but cannot be modified.
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● Time setting
Select the required setting. The following settings are possible: 

– Manual
The system time is set manually. 

– SNTP Client
The system time is set via an SNTP server. You can configure other settings in "System 
> System time > SNTP client".

– NTP Client
The system time is set via an NTP server. You can configure other settings in "System 
> System time > NTP client".

– SIMATIC Time
The system time is set using a SIMATIC time transmitter. You can configure other 
settings in "System > System Time > SIMATIC Time Client".

● SNMP
Select the required protocol. The following settings are possible: 

– "-" (SNMP disabled)
Access to device parameters using SNMP is not possible.

– SNMPv1/v2c/v3
Access to device parameters is possible with SNMP versions 1, 2c or 3. You can 
configure other settings in "System > SNMP > General".

– SNMPv3
Access to device parameters is possible with SNMP version 3. You can configure other 
settings in "System > SNMP > General".

● SNMPv1/v2c write protected
Enable or disable write access to SNMP variables with SNMPv1/v2c.

● SNMPv1 traps
Enable or disable the sending of SNMP traps (alarm frames). You can configure other 
settings in "System > SNMP > Traps".

● SINEMA configuration interface
Enable or disable the SINEMA configuration interface.

● Configuration mode 
Select the required mode. The following modes are possible:

– Automatic save
Automatic save mode. Approximately 1 minute after the last parameter change or when 
you restart the device, the configuration is automatically saved.

– Test
In Test mode, although changes are adopted, they are not saved in the configuration 
file (startup configuration). 
To save changes in the configuration file, use the "Write Startup Config" button. The 
button is displayed when you set test mode. The display area also shows the message 
"Trial mode active - Press "Write Startup Config" button to make your settings persistent" 
as soon as there are unsaved modifications. This message can be seen on every WBM 
page until the changes made have either been saved or the device has been restarted.
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General

Device
This page contains the general device information.

Settings  
● System Name

You can enter the name of the device. The entered name is displayed in the selection area. 
A maximum of 255 characters are possible. The system name is also displayed in the CLI 
input prompt. The number of characters in the CLI input prompt is limited. The system name 
is truncated after 16 characters.

● System Contact
You can enter the name of a contact person responsible for managing the device. 

● Location
You can enter the location of the device. The entered installation location is displayed in 
the selection area.  

 

  Note

The ASCII code 0x20 to 0x7e is used in the input boxes. 

At the start and end of the input boxes"System name", "System Contact" and "System 
Location", the characters "<", ">" and "space" are not permitted.

 

Coordinates
On this page, you configure the geographic coordinates (latitude, longitude and the height 
above the ellipsoid according to WGS84). These boxes are purely for information with a 
maximum length of 32 characters.

Getting the coordinates

Use suitable maps for obtaining the geographic coordinates of the device.

The geographic coordinates can also be obtained using a GPS receiver. The geographic 
coordinates of these devices are normally displayed directly and only need to be entered in 
the input boxes of this page.
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Settings 
● Latitude

Enter the north or south latitude for the location of the device.
For example, +49° 1´ 31.67" means that the device is located at 49 degrees, 1 arc minute 
and 31.67 arc seconds north latitude.
A south latitude is shown by a preceding minus character.
You can also append the letters N (north latitude) or S (south latitude) to the numeric 
information (49° 1´ 31.67" N).

● Longitude
Enter the value of the eastern or western longitude of the location of the device.
For example, +8° 20´ 58.73" means that the device is located at 8 degrees, 20 minutes and 
58.73 seconds east.
A western longitude is indicated by a preceding minus sign.
You can also add the letter E (eastern longitude) or W (western longitude) to the numeric 
information (8° 20´ 58.73" E).

● Height
Enter the value of the height above sea level in meters.
For example, 158 m means that the device is located at a height of 158 m above sea level.
Heights below sea level (for example the Dead Sea) are indicated by a preceding minus 
sign.

Load & save

Uploading and saving using TFTP

Loading and saving data via a TFTP server   
On this page, you can configure the TFTP server and the file names. The WBM also allows 
you to store device data in an external file on your client PC or to load such data from an 
external file from the PC to the devices. This means, for example, that you can also load new 
firmware from a file located on your client PC. 

 

 Note
Incompatibility with predecessor versions

During the installation of a previous version, the configuration data can be lost. In this case, 
the device starts up with the factory settings after the firmware has been installed.
Incompatibility with predecessor versions with inserted PLUG
During the installation of a previous version, the configuration data can be lost. In this case, 
the device starts up with the factory settings after the firmware has been installed. In this 
situation, if a PLUG is inserted in the device, following the restart, this has the status "Not 
Accepted" since the PLUG still has the configuration data of the previous more up-to-date 
firmware. This allows you to return to the previous, more up-to-date firmware without any loss 
of configuration data. If the original configuration on the PLUG is no longer required, the PLUG 
can be deleted or rewritten manually using "System > PLUG. 
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 Note
Configuration files and trial mode/automatic save mode

In "Automatic Save" configuration mode, the data is saved automatically before the 
configuration files (ConfigPack and Config) are transferred.
In Trial mode, although the changes are adopted, they are not saved in the configuration files 
(ConfigPack and Config). Use the "Write Startup Config" button on the "System > System 
Configuration" WBM page to save changes in the configuration files.

 

Settings
● TFTP Server IP Address

Here, enter the IP address of the TFTP server with which you exchange data.

● TFTP Server Port
Here, enter the port of the TFTP server via which data exchange will be handled. If 
necessary, you can change the default value 69 to your own requirements.

The table has the following columns:

● File type
Shows the file type.

● Description
Shows the short description of the file type.

● File name
Enter a file name.

Events

Configuration
On this page, you specify how the device reacts to events. 
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Settings
● Signaling Contact Method

Select the behavior of the signaling contact. The following reactions are possible:

– conventional
Default setting for the signaling contact. An error/fault is displayed by the fault LED and 
the signaling contact is opened. When the error/fault state no longer exists, the fault 
LED goes off and the signaling contact is closed.

– aligned
The way the signaling contact works does not depend on the error/fault that has 
occurred. The signaling contact can be opened or closed as required by user actions.

● Signaling Contact Status
Select the status of the signaling contact. The following statuses are possible:

– close
Signaling contact is closed.

– open
Signaling contact is opened.

Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● E-mail/Trap/Log Table/Syslog/Error
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Copy to Table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:
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● Event
The "Event" column contains the following values:

– Cold/Warm Start
The device was turned on or restarted by the user.

– Link Change
This event occurs only when the port status is monitored and has changed, see "System 
> Fault Monitoring > Link Change".

– Authentication Failure
This event occurs when attempting access with a bad password.

– Power Change
This event occurs only when power supply lines 1 and 2 are monitored. It indicates that 
there was a change to line 1 or line 2, see System > Fault monitoring > Power supply".

– Spanning Tree Change
The STP or RSTP or MSTP topology has changed.

– Fault State Change
The fault state has changed. The fault status can relate to the activated port monitoring, 
the response of the signaling contact or the power supply monitoring.

– RMON Alarm 
An alarm or event has occurred relating to the remote monitoring of the system.

– State Change VRRP (only with routing using VRRP) 
The status of the virtual router has changed

– Loop Detection
A loop was detected in the network segment.

– OSPF State Change
The status of OSPF has changed

● E-mail
The device sends an e-mail. This is only possible if the SMTP server is set up and the 
"SMTP client" function is enabled.

● Trap
The device sends an SNMP trap. This is only possible if "SNMPv1 traps" is enabled in 
"System > Configuration".

● Log Table
The device writes an entry in the log table.

● Syslog
The device writes an entry to the system log server. This is only possible if the system log 
server is set up and the "Syslog client" function is enabled.

● Fault
The device triggers a fault. The error LED lights up

Severity filter
On this page, set the threshold levels for sending system event notifications.
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Settings
The table has the following columns:

● Client Type
Select the client type for which you want to make settings:

– E-mail
Sending system event messages by e-mail

– Log Table
Entering system events in the log table.

– Syslog
Entering system events in the Syslog file

● Severity
Select the required level. The following settings are possible:

– Information
System events are processed as of the severity level "Information".

– Warning
System events are processed as of the severity level "Warning".

– Critical
System events are processed as of the severity level "Critical".

SMTP client
The device provides the option of automatically sending an e-mail if an alarm event occurs (for 
example to the network administrator). The e-mail contains the identification of the sending 
device, a description of the cause of the alarm in plain language, and a time stamp. This allows 
centralized network monitoring to be set up for networks with few nodes based on an E-mail 
system. When an e-mail event message is received, the WBM can be started by the browser 
using the identification of the sender to read out further diagnostics information.  

On this page, you can configure up to three SMTP servers and the corresponding e-mail 
addresses.

 

 Note

Depending on the properties and configuration of the SMTP server, it may be necessary to 
adapt the "From” input box for the e-mails. Check with the administrator of the SMTP server.

 

Settings
● SMTP Client

Enable or disable the SMTP client.

● 'From' Field

● Enter the name of the sender that will be included in the e-mail, for example the device 
name.
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● SMTP Port
Change the port if the SMTP server is not obtainable via port 25.

● SMTP Server IP Address
Enter the IP address of the SMTP server.

This table contains the following columns:

● SMTP Server IP Address
Shows the SMTP server IP address.

● Receiver E-mail Address
Enter the e-mail address to which the device sends an e-mail if a fault occurs. The e-mail 
address can be the address of a single person or a distribution list.

DHCP client
If the DHCP mode is activated, the DHCP client starts a DHCP request to a configured DHCP 
server and is assigned an IP address as the response. The server manages an address range 
from which it assigns IP addresses. It is also possible to configure the server so that the client 
always receives the same IP address in response to its request.

Settings
● DHCP Client

Enable or disable the DHCP client.

● DHCP client configuration file request (opt. 66, 67)
Select this option if you want the DHCP client to use options 66 and 67 to download and 
then enable a configuration file.

● DHCP Mode
Select the DHCP mode. The following modes are possible:

– via MAC Address
Identification is based on the MAC address.

– via DHCP Client ID
Identification is based on a freely defined DHCP client ID.

– via System Name
Identification is based on the device name. If the device name is 255 characters long, 
the last character is not used for identification.

SNMP

General
On this page, you make the basic settings for SNMP. Enable the functions you want to use. 
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Description
The following settings are possible:

● SNMP
Select the SNMP protocol. The following settings are possible:

– "-" (disabled)
SNMP is disabled.

– SNMPv1/v2c/v3
SNMPv1/v2c/v3 is supported.

– SNMPv3
Only SNMPv3 is supported.

● SNMPv1/v2 Read-Only
If you enable this option, SNMPv1/v2c can only read the SNMP variables.

 

  Note
Community String

For security reasons, do not use the standard values "public" or "private". Change the 
community strings following the initial installation.

 

● SNMPv1/v2c Read Community String
Enter the community string for read access of the SNMP protocol.

● SNMPv1/v2c Read/Write Community String
Enter the community string for read and write access of the SNMP protocol.

● SNMPv1 Traps
Enable or disable the sending of SNMP traps (alarm frames). On the "Trap" tab, specify 
the IP addresses of the devices to which SNMP traps will be sent.

● SNMPv1/v2c Trap Community String
Enter the community string for sending SNMPv1/v2 messages.

Traps
If an alarm event occurs, a device can send SNMP traps (alarm frames) to up to ten different 
management stations at the same time. Traps are only sent if events specified in "Events > 
Configuration" occur.

 

 Note

SNMP traps are sent only when the "SNMPv1 Traps" setting was selected in "SNMP > 
General".
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Introduction 
The following setting is possible:

● IP Address
Enter the IP address of the stations to which the device sends SNMP traps

The table has the following columns:

● IP Address
Shows the IP addresses of the stations to which the device sends SNMP traps. 

● Trap
Enable or disable the sending of SNMP traps. Stations that are entered but not selected 
do not receive SNMP traps.

v3 Groups

Security settings and assigning permissions
SNMP version 3 allows permissions to be assigned, authentication, and encryption at protocol 
level. The security levels and read/write permissions are assigned according to groups. The 
settings automatically apply to every member of a group.

Description
The following settings are possible:

● Group Name
Enter the name of the group. This name must have at least two characters, the maximum 
length is 32 characters.

● Security Level
Select the security level (authentication, encryption) valid for the selected group. In the 
security levels, the following options:   

– no Auth/no Priv
No authentication enabled / no encryption enabled.

– Auth/no Priv
Authentication enabled / no encryption enabled.

– Auth/Priv
Authentication enabled / encryption enabled.

The table has the following columns:
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● Group Name
Shows the defined group names.

 

  Note

Once a group name and the security level have been specified, they can no longer be 
modified after the group is created. If you want to change the group name or the security 
level , you will need to delete the group and recreate it and reconfigure it with the new 
name.

 

● Security Level
Shows the configured security level.

● Read
Enable or disable read access.

● Write
Enable or disable write access.

v3 users

User-specific security settings   
On the WBM page, you can create new SNMPv3 users and modify or delete existing users. 
The user-based security model works with the concept of the user name; in other words, a 
user ID is added to every frame. This user name and the applicable security settings are 
checked by both the sender and recipient.

Description 
The following settings are possible:

● User name
Enter a freely selectable user name. After you have entered the data, you can no longer 
modify the name. 

The table has the following columns:

● User name
Shows the created users.

● Group Name
Select the group to which the user will be assigned. 

● Authentication Protocol
Select the authentication protocol. Can only be enabled, if this group supports the function.
The following settings are available:

– None

– MD5

– SHA
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● Privacy Protocol
Specify whether or not the user uses the DES algorithm. Can only be enabled, if the group 
supports this function.

● Authentication Password
Enter the authentication password in the first input box. 

● Authentication Password Confirmation
Confirm the password by repeating the entry. 

● Privacy Password
Enter your encryption password. 

● Privacy Password Confirmation
Confirm the encryption password by repeating the entry.

System time

SNTP client
SNTP (Simple Network Time Protocol) is used for synchronizing the time in the network. The 
appropriate frames are sent by an SNTP server in the network.     

Settings
● SNTP Client

Enable or disable automatic time-of-day synchronization using SNTP.

● Time Zone
Enter the time zone you are using in the format "+/- HH:MM". The time zone relates to UTC 
standard world time. Settings for daylight-saving and standard time are taken into account 
in this box by specifying the time offset.

● SNTP Mode
Select the synchronization mode. The following types of synchronization are possible:

– Poll
If you select this protocol type, the input boxes "SNTP Server IP Address", "SNTP Server 
Port" and "Poll Interval" are displayed for further configuration. With this type of 
synchronization, the device is active and sends a time query to the SNTP server.

– Listen
With this type of synchronization, the device is passive and "listens" for SNTP frames 
that deliver the time of day.

● SNTP Server IP Address
Enter the IP address of the SNTP server.

● SNTP Server Port
Enter the port of the SNTP server. 

● Poll Interval [s]
Enter the interval in seconds between two time polls. 
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NTP client
If you require time-of-day synchronization using NTP, you can make the relevant settings here.

Settings
● NTP Client

Enable or disable automatic time-of-day synchronization using NTP.

● Time Zone
Enter the time zone you are using in the format "+/- HH:MM". The time zone relates to UTC 
standard world time. Settings for daylight-saving and standard time are taken into account 
in this box by specifying the time offset.

● NTP Server IP Address
Enter the IP address of the NTP server.

● NTP Server Port
Enter the port of the NTP server.

● Poll Interval [s]
Enter the interval in seconds between two time polls. 

SIMATIC time client
On this page, you configure the time-of-day synchronization via the SIMATIC time client.

Setting
● SIMATIC Time Client

Enable or disable the SIMATIC Time Client.

PTP Client
On this page, you configure time synchronization with PTP (Precision Time Protocol). 
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Setting
● PTP Client

Enable or disable time synchronization using PTP. You can configure other settings in 
"Layer 2 > PTP".

Auto logout
On this page, set the times after which there is an automatic logout from WBM or the CLI 
following user in activity.

 

 Note
No automatic logout from the CLI

If the connection is not terminated after the set time, check the setting of the "keepalive" 
mechanism on the Telnet client. 

If the interval is shorter than the configured time, the connection is kept alive although no 
user data is transferred. Example: you selected 300 seconds for the automatic logout and 
120 seconds is set for the keepalive function. In this case, a packet is sent every 120 seconds 
that keeps the connection up. 
● Disable the keepalive mechanism (interval time = 0)

or
● Set the interval high enough so that the underlying connection is terminated when there 

is inactivity.
 

Settings
● Web Based Management [s]

Enter the time in seconds for the automatic logout from WBM. If you enter the value 0, the 
automatic logout is disabled.

● CLI (TELNET, SSH, Serial) [s]
Enter the time in seconds for the automatic logout from the CLI. If you enter the value 0, 
the automatic logout is disabled.

Button
The "Select/set" button is used for the following:

● Changing the display mode,

● Activating the redundancy manager

● Resetting to factory defaults,

● Defining the fault mask and the LED display,

You will find a detailed description of the individual functions available with the buttons in the 
operating instructions of the specific device.
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Settings
● Restore Factory Defaults

Enables or disables the "Restore Factory Defaults" function for the Select/Set button.
 

 
 CAUTION

Button function "Restore Factory Defaults" active during startup

If you have disabled this function in your configuration, disabling is only valid during 
operation. When restarting, for example after power down, the function is active until the 
configuration is loaded so that the device can inadvertently be reset to the factory settings. 
This may cause unwanted disruption in network operation since the device needs to be 
reconfigured if this occurs. An inserted PLUG is also deleted and returned to the status 
as shipped

 

● Redundancy Manager
Enables or disables the redundancy manager function for the Select/Set button.

● Set Fault Mask
Enable or disable the function "Define fault mask via the LED display" with the Select/set 
button. This function only works in display mode D.

Syslog client
Syslog according to RFC 3164 is used for transferring short, unencrypted text messages over 
UDP in the IP network. This requires a system log server.

Requirements for sending log entries:
● The system log function is enabled on the device.

● The system log function is enabled for the relevant event.

● There is a system log server in your network that receives the log entries. Since this is a 
UDP connection, there is no acknowledgment to the sender.

● The IP address of the system log server is entered on the device.

Settings
● Syslog Client

Enable or disable the system log function.

● Syslog Server IP Address
Enter the IP address of the system log server.

This table contains the following columns

● Syslog Server IP Address
Shows the IP address of the system log server.

● Server Port
Enter the port of the Syslog server being used.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  705



Ports

Overview
The page shows the configuration for the data transfer for all ports of the device.

Settings
● Port

Shows the configurable ports. The port is made up of the port number and the slot number, 
for example port 0.1 is slot 0, port 1.

● Port name
Shows the name of the port.

● Negotiation
Shows whether the automatic configuration is enabled or disabled.  

● Flow Ctrl. Type
Shows whether flow control is enabled or disabled for the port.

● Flow Ctrl.
Shows whether or not flow control is working on this port.

● MTU
Shows the maximum packet size.

● Port Type (only with routing)
Shows the type of the port. The following types are possible:

– Switch port

– Router port

● Status
Shows whether the port is on or off. Data traffic is possible only over an enabled port.

Configuration
On this page, you configure the ports of the device 
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Settings
● Port

Select the port to be configured. The port is made up of the port number and the slot number, 
for example port 0.1 is slot 0, port 1.

● Status
Specify whether the port is enabled or disabled.

– enabled
The port is enabled. Data traffic is possible only over an enabled port.

– disabled
The port is disabled but the connection remains.

– Link down
The port is disabled and the connection to the partner device is terminated.

● Port name
Enter a name for the port.

● Mode Type
Shows the transmission speed and the transmission method of the port. You make the 
settings for "Autonegotiation" and "Transmission rate" in the port options.

 

  Note

Before the port and partner port can communicate with each other, the settings must match 
at both ends.

 

● Negotiation
Shows whether the automatic configuration of the connection to the partner port is enabled 
or disabled.

● Flow Ctrl. Type
Shows whether or not flow control is working on this port.

 

  Note
Turning flow control on/off with autonegotiation

Flow control can only be enabled or disabled if the "autonegotiation" function is turned off. 
The function cannot enabled again afterwards.

 

● Flow Ctrl.
Shows whether or not flow control is working on this port.

● MTU
Enter the packet size.

● Port Type (only with routing)
Select the type of the port.

– Switch port

– Router port
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Changing the port configuration     
 

 Note

Optical ports only work with the full duplex mode and at maximum transmission rate. As a 
result, the following settings cannot be made for optical ports:
● Automatic configuration
● Transmission speed
● Transmission technique

 

 Note

With various automatic functions, the device prevents or reduces the effect on other ports 
and priority classes (Class of Service) if a port is overloaded. This can mean that frames are 
discarded even when flow control is enabled.

Port overload occurs when the device receives more frames than it can send, for example 
as the result of different transmission speeds.

 

Fault monitoring

Power supply
Configure whether or not the power supply should be monitored by the messaging system. 
Depending on the hardware variant, there are one or two power connectors (Supply 1 / Supply 
2). With a redundant power supply, configure the monitoring separately for each individual 
feed-in line.   

If there is no power on one of the monitored lines (Supply 1 or Supply 2) or when the voltage 
is too low, a fault is signaled by the signaling system.

 

 Note

You will find the permitted operating voltage limits in the compact operating instructions of 
the device.

 

An error causes the fault LED to light up on the device. Depending on the configuration, the 
error may trigger a trap, an e-mail or an entry in the event log table.

Settings
● Line 1

Enable or disable the monitoring of power connector 1.

● Line 2
Enable or disable the monitoring of power connector 2.
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Link Change
On this page, you configure whether or not an error message is triggered if there is a status 
change on a network connection.   

If connection monitoring is enabled, an error is signaled 

● when there should be a link on a port and this is missing.

● or when there should not be a link on a port and a link is detected.

An error causes the signaling contact to trigger and the fault LED to light up on the device. 
Depending on the configuration, the error may trigger a trap, an e-mail or an entry in the event 
log table.

Settings
Table 1 has the following columns:

● 1st column 
Shows that the settings are valid for all ports.

● Setting
Select the setting from the drop-down list. You have the following options:

– "-" (disabled)

– Up

– Down

– No Change:
The setting in table 2 remains unchanged.

● Copy to Table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns

● Port
Shows the available ports.

● Setting
Select the setting. You have the following options:

– Up
Error handling is triggered when the port changes to the active status.
(From "Link down" to "Link up")

– Down
Error handling is triggered when the port changes to the inactive status.
(From "Link up" to "Link down")

– "-" (disabled)
The error handling is not triggered.

Redundancy
On this page, you configure whether or not an error message is triggered if there is a status 
change on a network connection.   
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Setting
● Redundancy loss (HSR only)

Enable or disable connection monitoring.  If the redundancy of the connection is lost, an 
error is signaled.

PoE

General
On this page, you specify the maximum power for the power sourcing equipment (PSE). If the 
power supply is redundant, the values of both power supplies are shown.

Setting
● PSE

Shows the number of the power supply.

● Usage Threshold [%]
When the power being used by the end devices exceeds the percentage shown here, an 
event is triggered.

Port

Settings for the ports
For each individual PoE port, you can specify whether or not the power will be supplied via 
Ethernet. You can also set a priority for each connected powered device (PD). Devices for 
which a high priority was set, take preference over other devices for the power supply.

Settings
The table has the following columns:

● Port
Shows the configurable PoE ports.
The port is made up of the port number and the slot number, for example port 0.1 is slot 0, 
port 1.

● Setting
Enable the PoE power supply for this port or interrupt it.
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● Priority
Select which priority this port will have for the power supply.
The following settings are possible, in ascending order of relevance:

– Low
low priority

– High
medium priority

– Critical
high priority

If the same priority is set for two ports, the port with the lower port number will be preferred 
when necessary.

● Type
Here, you can enter a string to describe the connected device in greater detail. 

Layer 2

Configuration
The functions of layer 2 are configured on this page. With some functions, there are further 
configuration pages on which more detailed settings can be made. You can also check the 
settings on the configuration pages.

Settings
● Protocol Based VLAN

Enable or disable protocol-based VLAN. You can configure other settings in "Layer 2 > 
VLAN".

● Subnet Based VLAN
Enable or disable subnet-based VLAN. You can configure other settings in "Layer 2 > 
VLAN".

● Dynamic MAC Aging
Enable or disable the "Aging" mechanism. You can configure other settings in "Layer 2 > 
Dynamic MAC Aging".

● Redundancy Type
The following settings are available:

– "-" (disabled)
The redundancy function is disabled.

– Ring
Enables ring redundancy. You can configure other settings in "Layer 2 > Ring 
Redundancy".

– STP
If you select this option, you specify the required redundancy mode in "Redundancy 
Mode".
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● Redundancy Mode
If you select "STP" for the "Redundancy Type", the following options are then available:

– STP
Enables Spanning Tree Protocol (STP). Typical reconfiguration times with spanning tree 
are between 20 and 30 seconds. You can configure other settings in "Layer 2 > MSTP".

– RSTP 
Enables Rapid Spanning Tree Protocol (RSTP). If a spanning tree frame is detected at 
a port, this port reverts from RSTP to spanning tree. You can configure other settings 
in "Layer 2 > MSTP".

 

  Note

When using RSTP (Rapid Spanning Tree Protocol), loops involving duplication of 
frames or frames being overtaken may occur briefly. If this is not acceptable in your 
particular application, use the slower standard spanning tree mechanism.

 

– MSTP
Enables Multiple Spanning Tree Protocol (MSTP). You can configure other settings in 
"Layer 2 > MSTP".

If you select "Ring" for the "Redundancy Type", the following options are then available:

– Automatic Redundancy Detection
Select this setting to create an automatic configuration of the ring redundancy mode. In 
this mode, the device automatically detects whether or not there is a device with the 
"HRP Manager" role in the ring. If this is the case, the device adopts the role of "HRP 
Client". If no HRP manager is found, all devices with the "Automatic Redundancy 
Detection" or "MRP Auto Manager" setting negotiate among themselves to establish 
which device adopts the role of "MRP manager". The device with the lowest MAC 
address will always become "MRP manager".  The other devices automatically set 
themselves to the "MRP client" redundancy mode.

– MRP Auto-Manager
Automatic media redundancy manager

– MRP Client
Media redundancy client

– HRP Client
High Speed Redundancy Protocol client

– HRP manager
High Speed Redundancy Protocol manager

● Standby
Enable or disable the "Standby redundancy" function. You can configure other settings in 
"Layer 2 > Ring Redundancy > Standby".

● Passive Listening
Enable or disable the "passive listening" function. 

● RMON
If you select this check box, Remote Monitoring (RMON) allows diagnostics data to be 
collected on the device, prepared and read out using SNMP by a network management 
station that also supports RMON. This diagnostic data, for example port-related load trends, 
allow problems in the network to be detected early and eliminated.
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● Dynamic Multicast
The following settings are possible:

– "-" (disabled)

– IGMP Snooping
Enables IGMP (Internet Group Management Protocol). You can configure other settings 
in "Layer 2 > Multicast > IGMP".

– GMRP
Enables GMRP (GARP Multicast Registration Protocol). You can configure other 
settings in "Layer 2 > Multicast > GMRP".

 

  Note

GMRP and IGMP cannot operate at the same time.
 

● GVRP
Enable or disable "GVRP" (GARP VLAN Registration Protocol). You can configure other 
settings in "Layer 2 > VLAN > GVRP".

● Mirroring
Enable or disable port mirroring. You can configure other settings in "Layer 2 > Mirroring > 
Port".

● Loop Detection
Enable or disable loop detection. You can configure other settings in "Layer 2 > Loop 
Detection".

● PTP
Specify how the device will process PTP messages. You can configure other settings in 
"Layer 2 > PTP".

– off
The device does not process any PTP messages. PTP messages are, however, 
forwarded according to the rules of the switch.

– transparent
The device adopts the function of a transparent clock and forwards PTP messages to 
other nodes while at the same time making entries in the correction field of the PTP 
message.

QoS

CoS map
On this page, CoS priorities are assigned to certain queues (Traffic Queues).
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Settings 
● CoS

Shows the CoS priority of the incoming packets.

● Queue
Select the forwarding queue (send priority) that is assigned the CoS priority. 
The higher the number of the queue, the higher the send priority. 

DSCP map
On this page, DSCP settings are assigned to various queues (Traffic Queues).

Settings
● DSCP

Shows the DSCP priority of the incoming packets.

● Queue
Select the forwarding queue (send priority) that is assigned the DSCP value. The higher 
the queue number, the higher the send priority.

Load limitation

Limiting the transfer rate of incoming and outgoing data
On this page, you configure the load limitation (maximum number of data packets per second) 
for the individual ports. You can specify the category of frame for which these limit values will 
apply. 

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports.

● Limit Ingress Unicast (DLF) / Limit Ingress Broadcast / Limit Ingress Multicast
Select the required setting.

– Enabled: Enables the function.

– Disabled: Disables the function

– No Change: The setting in table 2 remains unchanged

● Total Ingress Rate [pkts/s]
Specify the maximum number of incoming packets processed by the device. If "No Change" 
is entered, the entry in the table remains unchanged.
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● Egress Rate [Kb/s]
Specify the data rate for all outgoing frames. If "No Change" is entered, the entry in the 
table remains unchanged

● Copy to Table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the port to which the settings relate. 

● Limit Ingress Unicast (DLF) 
Enable or disable the data rate for limiting incoming unicast frames with an unresolvable 
address (Destination Lookup Failure).

● Limit Ingress Broadcast
Enable or disable the data rate for limiting incoming broadcast frames.

● Limit Ingress Multicast
Enable or disable the data rate for limiting incoming multicast frames.

● Total Ingress Rate [pkts/s]
Specify the maximum number of incoming packets processed by the device.

● Egress Rate [Kb/s]

● Specify the data rate for all outgoing frames.
 

  Note
Rounding of the values, deviation from desired value

When you enter the values for transmission rates, note that the WBM rounds to correct 
values.

If values are configured for total ingress transmission rate and egress transmission rate, 
the actual values in operation can exceed or fall below the set values by 10%.

 

VLAN

General
On this page, you define the VLAN and specify the use of the ports.

 

 Note
Changing the Agent VLAN ID

If the configuration PC is connected directly to the device via Ethernet and you change the 
agent VLAN ID, the device is no longer reachable via Ethernet following the change.
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Important rules for VLANs
Make sure you keep to the following rules when configuring and operating your VLANs:

● Frames with the VLAN ID "0" are handled as untagged frames but retain their priority value.

● As default, all ports on the device send frames without a VLAN tag to ensure that the end 
node can receive these frames. 

● With SCALANCE X devices, the VLAN ID 1 is the default on all ports.

● If an end node is connected to a port, outgoing frames should be sent without a tag (static 
access port). If, however, there is a further switch at this port, the frame should have a tag 
added (trunk port).

Settings
● VLAN ID

Enter the VLAN ID. 

The table has the following columns:

● VLAN ID
Shows the VLAN ID. The VLAN ID is assigned once when you create a new data record 
and can then no longer be changed. To make a change, the entire data record must be 
deleted and created again. 

● Name
Enter a name for the VLAN. The name only provides information and has no effect on the 
configuration. 
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● Status
Shows the status type of the entry in the port filter table. Here, static means that the address 
was entered as a static address by the user. The entry GVRP means that the configuration 
was registered by a GVRP frame. This is, however, only possible if GVRP was enabled for 
the device.

● List of ports
Specify the use of the port. The following options are available:

– "-"

– The port is not a member of the specified VLAN.
With a new definition, all ports have the identifier "-".

– M
The port is a member of the VLAN. Frames sent in this VLAN are forwarded with the 
corresponding VLAN tag.

– R
The port is a member of the VLAN. A GVRP frame is used for the registration.

– U (upper case)
The port is an untagged member of the VLAN. Frames sent in this VLAN are forwarded 
without the VLAN tag. Frames without a VLAN tag are sent from this port.

– u (lower case)
The port is an untagged member of the VLAN, but the VLAN is not configured as a port 
VLAN. Frames sent in this VLAN are forwarded without the VLAN tag.

– F
The port is not a member of the specified VLAN and it is not possible for the VLAN to 
be registered dynamically at this port using GVRP. You can configure other settings in 
"Layer 2 > VLAN > Port-based VLAN".

GVRP

Configuration of GVRP functionality
Using GVRP frame, a different device can register at the port of the device for a specific VID. 
A different device, can, for example be an end device or a switch. The device can also send 
GVRP frames via this port. 

Settings
● GVRP

Enable or disable the "GVRP" function.

Table 1 has the following columns:
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● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. You have the following setting options:

– Enabled
Enables the sending of GVRP frames.

– Disabled
Disables the sending of GVRP frames.

– No Change
No change in table 2.

● Copy to Table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports. 

● Setting
Enable or disable the sending GVRP frames.

Port-based VLAN

Processing received frames
On this page, you specify the configuration of the port properties for receiving frames.

Settings
Table 1 has the following columns:

● Port
Shows that the settings are valid for all ports.

● Priority / Port VID / Acceptable Frames / Ingress Filtering

● Select the setting. If "No Change" is selected, the entry in table 2 remains unchanged.

● Copy to Table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:
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● Port
Shows the available ports and link aggregations. The port is made up of the port number 
and the slot number, for example port 0.1 is slot 0, port 1.

● Priority
Select the priority assigned to untagged frames.    
The CoS priority (Class of Service) used in the VLAN tag. If a frame is received without a 
tag, it will be assigned this priority. This priority specifies how the frame is further processed 
compared with other frames.
There are a total of eight priorities with values 0 to 7, where 7 represents the highest priority 
(IEEE 802.1p Port Priority). 

● Port VID
Select the VLAN ID. Only VLAN IDs defined on the "VLAN > General" page can be selected.
If a received frame does not have a VLAN tag, it has a tag with the VLAN ID specified here 
added to it and is sent according to the rules at the port.  

● Acceptable Frames
Specify which types of frames will be accepted. The following alternatives are possible:

– Only tagged frames
The device discards all untagged frames. Otherwise, the forwarding rules apply 
according to the configuration.

– All
The device forwards all frames

● Ingress Filtering
Specify whether the VID of received frames is evaluated. 
The following options are available:

– Enabled
The VLAN ID of received frames decides whether they are forwarded: To forward a 
VLAN tagged frame, the receiving port must be a member in the same VLAN. Frames 
from unknown VLANs are discarded at the receiving port.

– Disabled
All frames are forwarded.

Protocol-based VLAN group
On this page, you specify groups to which a protocol will be assigned.
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Settings
● Protocol Based VLAN

Enable or disable the protocol-based VLAN assignment.

● Protocol Value
Enter the hexadecimal protocol value. 
A few examples are shown below:

– PROFINET: 88:92

– IP: 08:00

– Novell: 81:37

– netbios: f0:f0

– appletalk: 80:9b

● Group ID
Enter the ID of the group.

The table has the following columns:

● Protocol Value
Shows the file value.

● Group ID
Shows the group ID.

Protocol-based VLAN port
On this page, you specify which protocol and which VLAN is assigned to the individual port.

Settings
● Port

Select the required port. All available ports and the link aggregations can be selected.

● Group ID
Select the group ID from the drop-down list. Specify the ID in "Layer 2 > VLAN > Protocol 
Based VLAN Group".

The table has the following columns:

● Port
All available ports and the link aggregations are shown.

● Group ID
Shows the group ID assigned to the port.

● VLAN ID
Select the required VLAN ID to be assigned to the port.

IPv4 subnet-based VLAN
On this page, you specify which VLAN ID is assigned to the subnet.
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Settings
● Subnet Based VLAN

Enable or disable the subnet-based VLAN assignment

● Port
Select the port. All available ports and the link aggregations can be selected.

● Subnet
Enter the network address. 
Example: 192.168.10.0 for the network 192.168.10.x with nodes 192.168.10.1 to 
192.168.10.254.

The table has the following columns:

● Port
All available ports and the link aggregations are shown.

● Subnet
Shows the subnet assigned to the port.

● VLAN ID
Select the VLAN ID you want to assign to the port or the subnet.

Mirroring

General
On this page, you make the basic settings for port mirroring.

Settings
● Mirroring

Enable or disable mirroring of the data traffic.

● Monitor Barrier
Enable or disable the option to restrict communication via the monitor port.

 

  Note
Monitor Barrier

If you enable the monitor barrier, the data traffic on the destination port is automatically 
blocked (broadcast, multicast, unicast, DCP forwarding, LLDP) so that only the mirrored 
traffic is present. To be able to allow other data traffic again, you need to configure this. 
The previous statuses of these options are not restored after stopping the monitor barrier 
and must be reconfigured.

 

– Enabled
The monitor port is taken out of normal frame switching.

– Disabled
Communication via the monitor port is unrestricted.

This table has the following columns:
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● Session ID
Enable or disable listening in on incoming packets at the required port.

● Session Type
Specify which data traffic is mirrored. The following options are available:

– '-'
None

– Port based
Port-based mirroring You can configure other settings in "Layer 2 > Mirroring > Port".

– VLAN
VLAN-based mirroring. You can configure other settings in "Layer 2 > Mirroring > VLAN".

– MAC ACL
Mirroring of the MAC Access Control List. You can configure other settings in "Layer 2 
> Mirroring > MAC Flow".

– IP ACL
Mirroring of the IP Access Control List. You can configure other settings in "Layer 2 > 
Mirroring > IP Flow".

● Status
Shows whether or not mirroring is active.

● Dest. Port
Select the destination port to be mirrored to in this session.

Port

Mirroring ports
Mirroring a port means that the data traffic at a port (mirrored port) of the IE switch is copied 
to another port (monitor port). You can mirror one or more ports to a monitor port.   

If a protocol analyzer is connected to the monitor port, the data traffic at the mirrored port can 
be recorded without interrupting the connection. This means that the data traffic can be 
investigated without being affected. This is possible only if a free port is available on the same 
device as the monitor port. 

 

 Note

If the maximum data rate of the mirrored port is higher than that of the monitor port, data may 
be lost and the monitor port then no longer reflects all the data traffic at the mirrored port. 
Several ports can be mirrored to one monitor port at the same time. 

Mirroring a port does not work beyond switch core boundaries. 

Disable port mirroring if you want to connect a normal end device to the monitor port.
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Settings 
● Session ID

Select the session ID. Only session IDs of the session type "Port-based" are available. 

● Port
Shows the port to be monitored.

● Ingress Mirroring
Enable or disable mirroring of incoming packets at the required port.

● Egress Mirroring
Enable or disable mirroring of outgoing packets at the required port.

VLAN

VLAN sources of the port mirroring function
On this page, you specify the VLAN whose incoming data traffic will be mirrored to the monitor 
port.

Settings
● Session ID

Select the session ID. Only session IDs of the session type "VLAN" are available.

The table has the following columns:

● VLAN ID
Shows the VLAN ID. The VLAN ID can only be assigned once when you create a new data 
record and can then no longer be changed. To make a change, the entire data record must 
be deleted and created again.

● Ingress Mirroring
Enable or disable mirroring of incoming frames.

MAC Flow
The MAC ACL filter decides which data is available at the monitor port.

Settings
● Session ID

Select the session ID. Only session IDs of the session type "MAC ACL" are available.

● ACL Filter Number
Shows the number of the ACL filter. You configure the MAC ACL filter in "Security > Port 
ACL MAC".
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● Ingress Mirroring
Shows whether incoming packets are mirrored.

 

  Note
Rules

A rule selected for ingress mirroring only becomes active if it was configured as a port 
ingress rule on at least one port. You configure the port ingress rules in "Security > Port 
MAC IP > Port Ingress Rules".

 

● Source MAC
Shows the MAC address of the sender.

● Dest. MAC
Shows the MAC address of the recipient.

● Egress Port
Shows a list of all egress ports to which this rule applies.

● Ingress Port
Shows a list of all ingress ports to which this rule applies.

IP Flow
The IP ACL filter decides which data is mirrored to the monitor port.

Settings
● Session ID

Select the session ID. Only session IDs of the session type "IP ACL" are available.

● ACL Filter Number
Shows the number of the ACL filter. You configure the IP ACL filter in "Security > Port ACL 
IP".

● Ingress Mirroring
Shows whether incoming packets are mirrored.

 

  Note
Rules

A rule selected for ingress mirroring only becomes active if it was configured as a port 
ingress rule on at least one port. You configure the port ingress rules in "Security > Port 
ACL IP > Port Ingress Rules".

 

● Source IP
Shows the IP address of the sender.

● Source Subnet Mask
Shows the subnet mask of the sender.

● Dest. IP
Shows the IP address of the recipient.
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● Dest. Subnet Mask
Shows the subnet mask of the recipient.

● Egress Port
Shows a list of all egress ports to which this rule applies.

● Ingress Port
Shows a list of all ingress ports to which this rule applies.

Dynamic MAC aging
The device automatically learns the source addresses of the connected nodes.

This information is used to forward data frames to the nodes specifically involved. The network 
load for the other nodes is reduced.
If a device does not receive a frame whose source address matches a learnt address within 
a certain time, the learnt address is deleted. This mechanism is known as "Aging". Aging 
prevents frames being forwarded incorrectly, for example when an end device (for example a 
programming device) is connected to a different port. If the check box is not enabled, a device 
does not delete learned addresses automatically.

Settings
● Dynamic MAC Aging

Enable or disable the function for automatic aging of learned MAC addresses:

● Aging Time [s]
Enter the time in seconds. After this time, a learned address is deleted if the device does 
not receive any further frames from this sender address. 

Ring redundancy

Ring
On this page, you can select the required mode for fast ring redundancy. The "Automatic 
Redundancy Detection" ring redundancy mode is the default when the device ships.

 

 Note

 Ring redundancy cannot be enabled if a (M/R/S) Spanning Tree is enabled on the device.
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Settings
● Ring redundancy

Enable or disable the ring redundancy function.

● Ring Redundancy Mode
Specify the ring redundancy mode. The following options are available:

– "-" (disabled)
The redundancy function is disabled.

– Automatic Redundancy Detection
Select this setting to create an automatic configuration of the ring redundancy mode. In 
this mode, the device automatically detects whether or not there is a device with the 
"HRP Manager" role in the ring. If this is the case, the device adopts the role of "HRP 
Client". If no HRP manager is found, all devices with the "Automatic Redundancy 
Detection" or "MRP auto manager" setting negotiate among themselves to establish 
which device adopts the role of "MRP manager". The device with the lowest MAC 
address will always become "MRP manager".  The other devices automatically set 
themselves to the "MRP client" redundancy mode.

– MRP Auto Manager
Automatic media redundancy manager

– MRP Client
Media redundancy client.

– HRP Client
High Speed Redundancy Protocol client

– HRP Manager
High Speed Redundancy Protocol manager

Ring Ports
Specify the ports to be used as ring ports in media redundancy in ring topologies.

 

  Note

If you restore the factory defaults, the default redundancy mode "Automatic Redundancy 
Detection" becomes active. 

The ring port configuration is also reset to the factory default ports. If other ports were 
used previously as ring ports, with the appropriate attachment, a previously correctly 
configured device can cause circulating frames and therefore the failure of the data traffic.

 

Standby

Standby manager   
The standby manager allows the redundant linking of two HRP rings. To do this, two 
neighboring devices within a ring must be configured as standby partners. Enable the standby 
manager for both standby partners and select the port via which the device is connected to 
the ring you want to link to. For the "Standby Connection Name", a name unique within the 
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ring must be assigned for both partners. This identifies the two modules as standby partners 
that belong together. 

 

 Note

To be able to use the function, HRP must be activated.
 

Settings 
● Standby

Enable or disable the standby manager.
 

  Note

If two devices are linked by the standby function, the "Standby" function must be enabled 
on both devices.

 

  Note

The standby manager always requires an activated HRP client.
 

● Standby Connection Name
Enter the name for the standby connection. This name defines the master/slave device 
pair. Both must be located in the same ring. This is achieved by entering the same name 
on two devices in the ring.

 

  Note

Make sure that the standby name (for one pair of devices) is used only once in the network.
 

● Force device to standby master
When selected, the device is configured as standby master regardless of its MAC address. 

– If the setting is enabled for neither of the two devices for which the standby function is 
enabled, then assuming that no error has occurred, the device with the higher MAC 
address adopts the role of standby master.

– If the setting is enabled for both devices or if the setting is only supported by one device, 
the standby master is also selected based on the MAC address.  

This type of assignment is important in particular when a device is replaced. Depending on 
the MAC addresses, the previous device with the slave function can take over the role of 
the standby master.

This table has the following columns:
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● Port
Shows the port to which the setting relates.

● Setting
Here, you specify which ports are standby ports. The standby ports are involved in the 
redirection of data traffic. 
If there are no problems, only the standby ports of the master are enabled and handle to 
the data traffic into the connected HRP rings (buses). If the master or the Ethernet 
connection (link) of one of the standby ports of the master fails, all standby ports of the 
master will be disabled and the standby ports of the slave enabled. As a result, a functioning 
Ethernet connection to the connected network segments (HRP rings/linear buses) is 
restored.

MSTP

General

General settings of MSTP
On this page, you configure the settings for MSTP. As default, Rapid Spanning Tree is enabled 
that can be set to the MSTP, RSTP or STP compatible mode with a switch.

On the configuration pages of these functions, you can make detailed settings.

Depending on the compatibility mode, you can configure the corresponding function on the 
relevant configuration page.

Settings
● MSTP

Enable or disable MSTP.

● Protocol Compatibility
Select the compatibility mode of MSTP, for example if you select RSTP, MSTP behaves 
like RSTP.
The following settings are available:

– STP

– RSTP

– MSTP

CIST general
On this page, you configure CIST.
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Settings
● Bridge Priority

Which device becomes the root bridge is decided based on the bridge priority. The bridge 
with the highest priority becomes the root bridge. The lower the value, the higher the priority. 
If several devices in a network have the same priority, the device whose MAC address has 
the lowest numeric value will become the root bridge. Both parameters, bridge priority and 
MAC address together form the bridge identifier. Since the root bridge manages all path 
changes, it should be located as centrally as possible due to the delay of the frames. 

● Bridge Hello Time [s]
Each bridge regularly sends configuration frames (BPDUs). The interval between two such 
frames is the Hello time. The default for this parameter is 2 seconds.

● Bridge Forward Delay [s]
New configuration data is not used immediately by a bridge but only after the period 
specified in the parameter. This ensures that operation is only started with the new topology 
after all the bridges have the required information. 

● Bridge Max Age
Bridge Max Age defines the maximum "age" of a received BPDU for it to be accepted as 
valid by the switch.

● Bridge Max Hop Count
This parameter specifies how many MSTP nodes a BPDU may pass through. If an MSTP 
BPDU is received and has a hop count that exceeds the value configured here, it is 
discarded. 

● Region Name
Enter the name of the MSTP region to which this device belongs. As default, the MAC 
address of the device is entered here. This value must be the same on all devices that 
belong to the same MSTP region.

● Region Version
Enter the version number of the MSTP region in which the device is located. This value 
must be the same on all devices that belong to the same MSTP region.

CIST port

MSTP-CIST port configuration     
When the page is called, the table displays the current status of the configuration of the port 
parameters.

To configure them, click the relevant cells in the port table.
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Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● MSTP Status
Select the setting from the drop-down list. You have the following setting options:

– Enabled
Port is integrated in the spanning tree. 

– Disabled
Port is not integrated in the spanning tree.

– No change
Table 2 remains unchanged.

● Copy to Table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports. 

● MSTP Status
Specify whether or not the port is integrated in the spanning tree.

 

  Note

If you disable the "MSTP Status" option for a port, this may cause the formation of loops. 
The topology must be kept in mind.

 

● Priority
Enter the priority of the port. The priority is only evaluated when the path costs are the same.
The value must be divisible by 16. If the value that cannot be divided by 16, the value is 
automatically adapted.

● Cost calc
Enter the path cost calculation. If you enter the value "0" here, the automatically calculated 
value is displayed in the "Path costs" box.
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● Edge type
Specify the type of edge port. You have the following options:

– "-"
Edge port is disabled. The port is treated as a "no edge port".

– Admin
Select this option when there is always an end device on this port. Otherwise a 
reconfiguration of the network will be triggered each time a connection is changed.

– Auto
Select this option if you want a connected end device to be detected automatically at 
this port. When the connection is established the first time, the port is treated as a "no 
Edge Port".

– Admin/Auto
Select these options if you operate a combination of both on this port. When the 
connection is established the first time, the port is treated as an Edge Port.

● P.t.P. Type
Select the required option. The selection depends on the port that is set.

– "-"
Point to point is calculated automatically. If the port is set to half duplex, a point-to-point 
link is not assumed.

– P.t.P.

Even with half duplex, a point-to-point link is assumed.

–
Shared Media
Even with a full duplex connection, a point-to-point link is not assumed.

 

  Note

Point-to-point connection means a direct connection between two devices. A shared 
media connection is, for example, a connection to a hub.
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● P.t.P. Type
Select the required option from the drop-down list. The selection depends on the port that 
is set.

– "-"
Point to point is calculated automatically. If the port is set to half duplex, a point-to-point 
link is not assumed.

– P.t.P.

Even with half duplex, a point-to-point link is assumed.

–
Shared Media
Even with a full duplex connection, a point-to-point link is not assumed.

 

  Note

Point-to-point connection means a direct connection between two devices. A shared 
media connection is, for example, a connection to a hub.

 

● Hello Time 
Enter the interval after which the bridge sends configuration BPDUs

 

  Note

The port-specific setting of the Hello time is only possible in MSTP compatible mode.
 

MST General

Multiple Spanning Tree configuration
With MSTP, in addition to RSTP, several VLANs can be managed in a LAN with separate 
RSTP trees.     

Settings
● MSTP Instance ID

Enter the number of the MSTP instance.

The table has the following columns:

● MSTP Instance ID
Shows the number of the MSTP instance.

● Root Address
Shows the MAC address of the root bridge

● Root Priority
Shows the priority of the root bridge.
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● Bridge Priority
Enter the bridge priority. The value for the bridge priority is a whole multiple of 4096.

● VLAN ID 
Enter the VLAN ID. Here, you can also specify ranges with Start ID, "-", End ID. Several 
ranges or IDs are separated by ",". 

MST port

Configuration of the Multiple Spanning Tree port parameters   
On this page, you set the parameters for the ports of the configured multiple spanning tree 
instances.

Settings
● MSTP Instance ID

Select the ID of the MSTP instance.  

The table has the following columns:

● Port
Shows all available ports and link aggregations.

● MSTP Instance ID 
ID of the MSTP instance.  

● MSTP Status 
Enable or disable MSTP for this port.

● Priority
Enter the priority of the port. The priority is only evaluated when the path costs are the same.
The value must be divisible by 16. If the value that cannot be divided by 16, the value is 
automatically adapted.

● Cost calc
Enter the path cost calculation in the input box. If you enter the value "0" here, the 
automatically calculated value is displayed in the next box "Path Cost".

Expanded compatibility for passive listening

Enabling the function
On this page, you enable the expanded compatibility for passive listening.

Settings
● Expanded compatibility for passive listening

Enable or disable this function for the entire device.

Table 1 has the following columns:
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● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. You have the following setting options:

– Enabled
Enables the function for all ports of the device.

– Disabled
Disables the function for all ports of the device.

– No Change
No change in table 2.

● Copy to Table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Displays the port of the device.

● Setting
Enable or disable the function for this port.

Loop Detection
With the "Loop Detection" function, you specify the ports for which loop detection will be 
activated. The ports involved send special test frames - the loop detection frames. If these 
frames are sent back to the device, there is a Loop.

A Local Loop involving this device means that the frames are received again at a different port 
of the same device. If the sent frames are received again at the same port, there is a "Remote 
Loop" involving other network components.

 

 Note

A loop is an error in the network structure that needs to be eliminated. The loop detection 
can help to find the errors more quickly but does not eliminate them. The loop detection is 
not suitable for increasing network availability by deliberately including loops.

 

 Note

Note that loop detection is only possible at ports that were not configured as ring ports or 
standby ports.

 

Settings 
● Loop Detection

Enable or disable loop detection.

● VLAN Loop Detection
Enable or disable loop detection in a VLAN.

Table 1 has the following columns:
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● 1st column
Shows that the settings are valid for all ports of table 2

● Threshold / Remote Reaction / Local Reaction
Select the required settings.

● Copy to Table 
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports.

● Setting
Specify how the port handles loop detection frames. 

 

  Note

Test frames create additional network load. We recommend that you only configure 
individual switches, for example at branch points of the ring, as "sender" and the others 
as "forwarder".

 

– sender

– Loop detection frames are sent out and forwarded.

– forwarder
Loop detection frames from other devices are forwarded.

– blocked
The forwarding of loop detection frames is blocked.

● Threshold
Specify the number of received loop detection frames as of which a loop is assumed.

● Remote Reaction
Specify how the port will react if a remote loop occurs. Select one of the two options from 
the drop-down list:

– No action: A loop has no effect on the port.

– Disable: The port is blocked.

● Local Reaction
Specify how the port will react if a local loop occurs. Select one of the two options from the 
drop-down list:

– No action: A loop has no effect on the port.

– Disable: The port is blocked

Link aggregation

Bundling network connections for redundancy and higher bandwidth
Link aggregations according to IEEE 802.3ad allow several connections between neighboring 
devices to be bundled to achieve higher bandwidths and protection against failure.   
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Ports on both partner devices are included in link aggregations and the devices are then 
connected via these ports. To assign ports (in other words links) correctly to a partner device, 
the Link Aggregation Control Protocol (LACP) from the IEEE 802.3ad standard is used. 

Up to 8 link aggregations can be defined. A maximum of 8 ports can be assigned to each link 
aggregation.

Settings
The table has the following columns:

● Port
Shows the virtual port number of this link aggregation. This identifier is assigned internally 
by the firmware.

● Link Aggregation Name
Enter the name for the link aggregation. This name can be specified by the user during 
configuration. The name is not absolutely necessary but can be useful to distinguish 
between the various link aggregations.

● Status
Enable or disable link aggregation.

● MTU
Specify the packet size.

● LACP

– On
Enables the sending of LACP frames. 

– Off
Disables the sending of LACP frames.
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● Frame distribution
Set the type of distribution of packets on the individual links of an aggregation.

– Destination&Source Mac
The distribution is based on a combination of the destination and source MAC address.

– Destination&Source IP
The distribution is based on a combination of the destination and source IP address.

● Port
Shows the ports that belong to this link aggregation. The following values can be selected 
from the drop-down list:

– "-" (disabled)
Link aggregation is disabled.

– "a" (active)
The port sends LACP frames and is only involved in the link aggregation when LACP 
frames are received.

– "p" (passive) 
The port is only involved in the link aggregation when LACP frames are received.

– "o" (on) 
The port is involved in the link aggregation and does not send any LACP frames.

 

  Note

Within a "link aggregation", only ports with the following configuration are possible:
● all ports with "o"
● all ports with "a" or "p"

 

DCP forwarding

Applications
The DCP protocol is used by STEP 7 and the PST Tool for configuration and diagnostics. 
When shipped, DCP is enabled on all ports; in other words, DCP frames are forwarded at all 
ports. With this option, you can disable the sending of these frames for individual ports, for 
example to prevent individual parts of the network from being configured with the PST Tool or 
to divide the full network into smaller parts for configuration and diagnostics.       

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. If "No Change" is selected, the entry in table 2 remains unchanged.

● Copy to table 
If you click the button, the setting is adopted for all ports of table 2.
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Table 2 has the following columns:

● Port
Shows the available ports. 

● Setting
Specify whether the port should block or forward outgoing DCP frames. The following 
options are available:

– Forward
DCP frames are forwarded via this port.

– Block
No outgoing DCP frames are forwarded via this port. It is nevertheless still possible to 
receive via this port.

LLDP

Link Layer Discovery Protocol (LLDP)
PROFINET uses the LLDP protocol for topology diagnostics. 
In the factory settings, LLDP is activated on the interface, in other words LLDP frames are sent 
and received. LLDP is supported only by the Ethernet interface and by the SFP interface P1.

On this WBM page, you activate or deactivate the sending or receiving of LLDP frames on the 
interface.

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. If "No Change" is selected, the entry in table 2 remains unchanged.

● Copy to table 
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:
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● Port
Shows the port.

● Setting
Specify the LLDP functionality. The following options are available:

– Rx
This port can only receive LLDP frames.

– Tx
This port can only send LLDP frames.

– Rx & Tx
This port can receive and send LLDP frames.

– "-" (disabled)
This port can neither receive nor send LLDP frames.

Unicast

Filter

Address filtering
This page shows the current content of the unicast filter table. This table lists the source 
addresses of unicast address frames. Entries can be made either dynamically when a node 
sends a frame to a port or statically by the user setting parameters.

On this page, you also define the static unicast filters.

Settings
● VLAN ID

Select the VLAN ID in which you configure a new static MAC address. If nothing is set, 
"VLAN1" is set as the basic setting.

● MAC Address
Enter the MAC address here.

This table contains the following columns:

● 1st column
Select the check box in the row to be deleted.

● VLAN ID
Shows the VLAN-ID assigned to this MAC address.

● MAC Address
Shows the MAC address of the node that the device has learned or the user has configured.
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● Status
Shows the status of each address entry:

– Learnt
The specified address was learned by receiving a frame from this node and will be 
deleted when the aging time expires if no further packets are received from this node.

– Static
Configured by the user. Static addresses are stored permanently; in other words, they 
are not deleted when the aging time expires or when the switch is restarted.

– Invalid
These values are not evaluated.

● Port
Shows the port via which the node with the specified address can be reached. Frames 
received by the device whose destination address matches this address will be forwarded 
to this port.

 

  Note

You can only specify one port for unicast addresses.
 

Locked ports

Activating the access control
On this page, you can block individual ports for unknown nodes. 

If the Port Lock function is enabled, packets arriving at this port from unknown MAC addresses 
are discarded immediately. Packets from known nodes are accepted by the port. 
Since ports with the port lock function enabled cannot learn any MAC addresses, learned 
addresses on these ports are automatically deleted after the port lock function is enabled. 

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting from the drop-down list. You have the following setting options:

– Enabled
Enables the port lock function. 

– Disabled
Disables the port lock function.

– No change
Table 2 remains unchanged.

● Copy to table
If you click the button, the setting is adopted for all ports of table 2.
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Table 2 has the following columns:

● Port
Shows the available ports.

● Setting
Enable or disable access control for the port.

Blocking

Blocking the forwarding of unknown unicast frames
On this page, you can block the forwarding of unknown unicast frames for individual ports.

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. You have the following setting options:

– Enabled
Blocking of unicast frames is enabled.

– Disabled
Blocking of unicast frames is disabled.

– No change
Table 2 remains unchanged.

● Copy to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports.

● Setting
Enable or disable the blocking of unicast frames.

 

  Note
Ring redundancy / standby

If ring redundancy or standby is enabled, the ports configured for this are not included in 
the blocking.
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Multicast

Groups

Multicast applications
In the majority of cases, a frame is sent with a unicast address to a particular recipient. If an 
application sends the same data to several recipients, the amount of data can be reduced by 
sending the data using one multicast address. For some applications, there are fixed multicast 
addresses (NTP, IETF1 Audio, IETF1 Video etc.).     

Reducing network load
In contrast to unicast frames, multicast frames represent a higher load for the device. 
Generally, multicast frames are sent to all ports. There are three ways of reducing the load 
caused by multicast frames:

● Static entry of the addresses in the multicast filter table.

● Dynamic entry of the addresses by listening in on IGMP parameter assignment frames 
(IGMP Configuration).

● Active dynamic assignment of addresses by GMRP frames.

The result of all these methods is that multicast frames are sent only to ports for which an 
appropriate address is entered.

"Multicast" shows the multicast frames currently entered in the filter table and their destination 
ports. The entries can be dynamic (the device has learned them) or static (the user has set 
them).

Settings
● VLAN ID

Select the VLAN ID to be assigned to the MAC multicast address. 

● MAC Address
Here you enter a new MAC multicast address you want to configure.

The table has the following columns:
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● VLAN ID
Shows VLAN ID of the VLAN to which the MAC multicast address is assigned.

● MAC Address
Shows the MAC multicast address that the device has learned or the user has configured.

● Status
Shows the status of each address entry. The following information is possible:

– Static
The address was entered statically by the user. Static addresses are stored 
permanently; in other words, they are not deleted when the aging time expires or when 
the device is restarted. These must be deleted by the user.

– IGMP
The destination port for this address was obtained by IGMP configuration.

– GMRP
The destination port for this address was registered by a received GMRP frame.

IGMP

Specifying the IGMP snooping aging time
On this page, you can configure the aging time for IGMP configuration. When the time elapses, 
entries created by IGMP are deleted from the address table if they are not updated by a new 
IGMP frame. 

This applies to all ports; a port-specific configuration is not possible.     

IE switches support not only "IGMP snooping" but also the IGMP querier function. If "IGMP 
snooping" is enabled, IGMP frames are evaluated and the multicast filter table is updated with 
this information. If IGMP Query is also enabled, IE switches also send IGMP queries that trigger 
responses from IGMP-compliant nodes.

Settings
● IGMP snooping

Enable or disable IGMP (Internet Group Management Protocol). The function allows the 
assignment of IP addresses to multicast groups. If the check box is selected, IGMP entries 
are included in the table and IGMP frames are forwarded.

● IGMP Snooping Aging Time
Enter the value for the aging time in seconds in this box. 

● IGMP Querier
Enable or disable "IGMP Querier". The device sends IGMP queries.
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GMRP

Activating GMRP
By selecting the check box, you specify whether or not GMRP is used for each individual port. 
If "GMRP" is disabled for a port, no registrations are made for it and it cannot send GMRP 
frames.   

Settings
● GMRP

Enable or disable the GMRP function.

Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. You have the following setting options:

– Enabled
Enables the sending of GRMP frames.

– Disabled
Disables the sending of GRMP frames.

– No Change
Table 2 remains unchanged.

● Copy to Table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports and the link aggregations.

● Setting

● Enable or disable GMRP for the port or for the link aggregation.

Blocking
On this page, you can block the forwarding of unknown multicast frames for individual ports.
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Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. You have the following setting options:

– Enabled
Blocking of multicast frames is enabled.

– Disabled
Blocking of multicast frames is disabled.

– No change
Table 2 remains unchanged

● Copy to table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports.

● Setting
Enable or disable the blocking of multicast frames.

Broadcast

Blocking the forwarding of broadcast frames
On this page, you can block the forwarding of broadcast frames for individual ports.   

 

 Note

Some communication protocols work only with the support of broadcast. In these cases, 
blocking can lead to loss of data communication. Block broadcast only when you are sure 
that you do not need it.
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Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. You have the following setting options:

– Enabled
The blocking of broadcast frames is enabled.

– Disabled
The blocking of broadcast frames is disabled.

– No change
Table 2 remains unchanged.

● Copy to Table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
All available ports and the link aggregations are shown.

● Setting
Enable or disable the blocking of broadcast frames.

PTP

General
The Precision Time Protocol (PTP) complying with IEEE 1588v2 allows the time-of-day 
synchronization of devices connected to the ports of a device. These devices forward the 
synchronization frames through the network using the "Transparent Clock" (TC) mechanism. 
The connection mechanisms "end-to-end" and "peer-to-peer" are supported.

To use IEEE 1588v2, enable this function and configure every port that is on the 
synchronization path as well as ports that are blocked due to redundancy mechanisms. IEEE 
1588v2 can also be used with redundancy mechanisms in the ring such as HRP, standby 
linking of rings, MRP and RSTP.
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Setting
● 1588 Mode

You can make the following settings:

– off
The device does not process any PTP messages. PTP messages are, however, 
forwarded according to the rules of the device.

– transparent
The device adopts the function of a Transparent Clock and forwards PTP messages to 
other nodes while at the same time making entries in the correction field of the PTP 
message. 

TC general

1588 Transparent Clock
On this page, you specify the general settings for PTP. 

Settings
● Delay Mechanism

Specify the delay mechanism the device will work with:

– End-to-end(delay request response mechanism will be used)

– Peer-to-peer (peer delay mechanism will be used)

● Domain Number
Enter the identification number for the time domain. Synchronization is only for the devices 
within the domain. The device ignores PTP messages with a different domain number. A 
SCALANCE device can only be assigned to one synchronization domain.

TC port
On this page, you specify the ports that can process PTP messages.

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting / Transport Mechanism
Select the setting. If "No Change" is selected, the entry in table 2 remains unchanged.  

● Copy to Table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:
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● Port
Shows the available ports. 

● Setting
Enable or disable PTP. When enabled, the port processes PTP messages.

● Faulty Flag
Shows error status relating to PTP.

– true
An error occurred.

– false
No error has occurred on this port.

● Transport Mechanism
Specifies the protocol for transferring the PTP messages. This protocol must also be 
supported by the communications partner of the port

– Ethernet

– UDP IPv4

 

Layer 3

Configuration
The page contains the overview of the layer 3 functions of the device.  To use the "Routing", 
"VRRP" and "OSPF" functions, the device requires a KEY-PLUG.

Settings
● Routing (only available on layer 3)

Enable or disable the routing function.

● DHCP Relay Agent
Enable or disable the DHCP relay agent. You can configure other settings in "Layer 3 > 
DHCP Relay Agent".

● VRRP (only available on layer 3)
Enable or disable routing using VRRP. To use VRRP, first enable the "Routing" function. 
You can configure other settings in "Layer 3 > VRRP".

● OSPF (only available on layer 3)
Enable or disable routing using OSPF. To use OSPF, first enable the "Routing" function. 
You can configure other settings in "Layer 3 > OSPF".
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Subnets

Overview

Subnet
The page shows the subnets for the selected interface. If more than one subnet is available 
on an interface, the first entry of this interface is of the address type "Primary". All other subnets 
have the address type "Secondary". All other subnets are created on this page and in "Layer 
3 > Subnets > Configuration", you configure the settings. 

Settings
The following settings are possible for subnets of the "Secondary" address type:

● Interface 
Select the interface on which you want to configure another subnet.

The table has the following columns:

● Interface
Shows the interface.

● TIA Interface
Shows whether or not the entry is a TIA interface.

● Interface Name
Shows the name of the interface.

● IP Address
Shows the IP address of the subnet.

● Subnet Mask
Shows the subnet mask.

● Address Type
Shows the address type. The following values are possible:

– Primary
The first subnet of the interface. 

– Secondary
All other subnets of the interface.
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● IP Assignment Method
Shows how the IP address is assigned.

– Static
The IP address is static. You enter the IP settings in "IP Address" and "Subnet Mask".

– Dynamic (DHCP)
The device obtains a dynamic IP address from a DHCP server.

Configuration
On this page, you configure the subnet. You create the subnet in "Layer 3 > Subnets > 
Overview".

Settings
● Interface (Name) 

Select the required interface. 

● Interface Name
Enter the name of the interface, e.g. eth0; P3.

● DHCP
Enable or disable the DHCP client for this interface.

● IP Address
Enter the IP address of the subnet. The IP address must not be used more than once.

● Subnet Mask
Enter the subnet mask of the subnet you are creating. Subnets on different interfaces must 
not overlap.

● Address Type
Shows the address type. The following values are possible:

– Primary
The first subnet of the interface.

– Secondary 
All other subnets of the interface.

● TIA Interface
Enable or disable the setting. 

Routes

Static route
On this page, you create the static routes. During automatic adaptations, static routes are not 
taken into account and need to be adapted manually.
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Settings
● Destination Network

Enter the network address of the destination.

● Subnet Mask
Enter the corresponding subnet mask.

● Gateway
Enter the IP address of the next gateway.

The table has the following columns:

● Destination Network
Shows the network address of the destination.

● Subnet mask
Shows the corresponding subnet mask.

● Gateway
Shows the IP address of the next gateway.

● Metric
Enter the metric for the route. When creating the route, "not used" is entered automatically. 
The metric corresponds to the quality of a connection, for example speed, costs. If there 
are several equal routes, the route with the lowest metric value is used.

DHCP Relay Agent

General
If the DHCP server is in a different network, the device cannot reach the DHCP server. The 
DHCP relay agent intercedes between a DHCP server and the device. The DHCP relay agent 
forwards the port number of the device with the DHCP query to the DHCP server.  If a DHCP 
server is unreachable, the device can switch to a different DHCP server.

Settings 
● DHCP Relay Agent (opt. 82)

Enable or disable the DHCP relay agent.

● Server IP Address
Enter the IP address of the DHCP server.

The table has the following columns:
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● Server IP address
Shows the IP address of the DHCP server.

Option

Parameters of the DHCP relay agent
On this page, you can specify parameters for the DHCP server, for example the circuit ID.
The circuit ID describes the origin of the DHCP query, for example which port received the 
DHCP query.

You specify the DHCP server on the "General" tab.

Settings
● Circuit ID router index

When enabled, the router index is added to the generated circuit ID.

● Circuit ID recipient VLAN ID
When enabled, the VLAN ID is added to the generated circuit ID.

● Circuit ID Receive Port
When enabled, the receiving port is added to the generated circuit ID.

 

  Note

You need to select a least one option.
 

● Interface
Select the required interface.

The table has the following columns:

● Interface
Shows the interface.

● Remote ID type
Select the type of the device ID. You have the following options:

– IP Address
The IP address of the device is used as the device ID.

– MAC Address
The MAC address of the device is used as the device ID.

– Free Text
If you use "Free Text", you can enter the device name as the device identifier in "Remote 
ID".

● Remote ID
Enter the device name. The box can only be edited if you select the entry "Free Text" for 
"Remote ID Type".

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
752 System Manual, 07/2013,  



● Circuit ID Type
Select the type of circuit ID from the drop-down list. You have the following options:

– Default
The circuit ID is created automatically based on the router index, VLAN ID or port.

– Free Number
If you use "Free Number", you can enter the ID for "Circuit ID".

● Circuit ID
Enter the circuit ID. The box can only be edited if you select the "Free Number" entry for 
the "Circuit ID Type". 

VRRP

Router
On this page, you create virtual routers. You can configure other parameters in "Layer 3 > 
VRRP > Configuration".

 

 Note
● VRRP is available only on layer 3.
● VRRP can only be used in conjunction with VLAN interfaces. Router ports are not 

supported.
● Select "VRRP" to configure VRRP.

 

Settings   
The following settings are available:

● VRRP
Enable or disable routing using VRRP. 

● Reply to pings on virtual interfaces.
When enabled, the virtual IP addresses also reply to the ping.

● Interface
Select the interface operating as virtual router.

● VRID
Enter the ID of the virtual router in the input box. This ID defines the group of routers that 
form a virtual router (VR). In the group, this is the same. it can no longer be used for other 
groups.

The table has the following columns:

● Interface
Shows the Interface that functions as the virtual router.

● VRID
Shows the ID of the virtual router.
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● Primary IP Address
Shows the primary IP address in this VLAN. The entry 0.0.0.0 means that the "Primary" 
address on this VLAN is used. Otherwise all IP addresses configured in this VLAN in "Layer 
3 > Subnets" are valid values.

● Priority
Shows the priority of the virtual router. 
The current master router is automatically given 255. All other priorities can be distributed 
freely among the VRRP routers. The higher the priority, the earlier the VRRP router 
becomes "Master".

● Backbone
Shows the interval at which the master router sends VRRP packets.

● Preempt
Shows the precedence of a router when changing roles between backup and master.

– yes
This router has precedence when changing roles.

– no
This router does not have precedence when changing roles.

 

Configuration

Introduction
On this page, you configure the virtual router.  

 

 Note

VRRP is available only on layer 3.
 

Description of the displayed values
The page contains the following boxes:

● Interface / VRID
Select the ID of the virtual router to be configured.

● Status
Enable or disable the "Status" function.
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● Primary IP Address
Select the primary IP address. If the router becomes master router, the router uses this IP 
address.

 

  Note

If you only configure one subnet on this VLAN, no entry is necessary. The entry is 0.0.0.0. 
If you configure more than one subnet on the VLAN and you want a specific IP address 
to be used as the source address for VRRP packets, select the IP address from the drop-
down list. Otherwise, the IP address with priority will be used.

 

● Master
If this option is enabled, the primary IP address is entered for "Associated IP Address". This 
means that the highest priority IP address of the VRRP router is used as the virtual IP 
address of the virtual master router. The option must be disabled for the backup routers in 
this group and the IP address of the router in "Assigned IP address" must be used.

● Priority
Enter the priority of this virtual router. 
The current master router is always given 255. All other priorities can be distributed freely 
among the redundant routers. The higher the priority, the earlier the router becomes 
"Master".

● Advertisement Interval
Enter the interval in seconds after which a master router sends a VRRP packet again.

● Preempt lower priority master
Allow the precedence when changing roles between backup and master based on the 
selection process.

Address overview

Overview
This page shows which IP addresses the virtual router monitors. 

 

 Note

VRRP is available only on layer 3.
 

Settings
The table has the following columns:

● Interface
Shows the Interface that functions as the virtual router.

● VRID
Shows the ID of this virtual router.
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● Number of Addresses
Shows the number of IP addresses.

● Associated IP Address (1) ... Associated IP Address (4) 
Shows the router IP addresses monitored by this virtual router. If a router takes over the 
role of master, the routing function is taken over by this router for all these IP addresses.

Address configuration
 

 Note

VRRP is available only on layer 3.
 

Settings
The following settings are possible:

● Interface / VRID
Select the required virtual router.

● Associated IP Address
Enter the IP address that the virtual router will monitor. 

The table has the following columns:

● Associated IP Address
Shows the IP addresses that the virtual router monitors.

OSPFv2

Configuration

Introduction   
On this page, you configure routing with OSPF.

 

 Note

OSPF is available only on layer 3.
 

Settings
● OSPFv2

Enable or disable routing using OSPF.

● Router ID
Enter the name of one of the OSPF interfaces. The name is entered in the IP address format 
and does not need to match the local IP address.
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● External LSA Maximum
To limit the number of entries of external LSAs in the database, enter the maximum number 
of external LSAs.

● Exit Interval [s]
Enter the interval after which the OSPF router once again attempts to come out of the 
overflow status. A 0 means that the OSPF router attempts to exit the overflow status only 
following a restart.

● Redistribute Routes 
Specify which known routes are distributed using OSPF. 
The following types of route exist:

– Default

– Connected

– Static 
 

  Note

The settings can only be enabled on an AS border router. Enabling "Default" and "Static", 
in particular, can cause problems if they are enabled at too many points in the network, 
for example, forwarding loops.

 

● OSPFv2 RFC1583 Compatibility
Enable the option if you still have old OSPF routers in operation that are not compatible 
with RFC 2328.

● AS Border Router
Specify whether the router is an AS border router. An AS border router intercedes between 
multiple autonomous systems, for example if you have an additional RIP network. An AS 
border router is also necessary to add and to distribute static routes.

Areas

Overview
An autonomous system can be divided into smaller areas. 

On this page, you can view, create, modify or delete the areas of the router. 
 

 Note

OSPF is available only on layer 3.
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Settings
● Area ID

Enter the ID of the area. The database is synchronized for all routers of an area.
Input format: x.x.x.x 
x = 0 ... 255

This table contains the following columns:

● Area ID
Shows the ID of the area.

● Area Type
Select the area type from the drop-down list.

– Standard

– Stub

– NSSA

– Backbone

● Summary
Specify whether summary LSAs are generated for this area.

– Summary: Summary LSAs are sent to the area.

– No summary: Summary LSAs are not sent to the area.

● Metric
Displays the costs for the OSPF interface.

Area range

Creating a new OSPFv2 area range  
On this page, networks can be grouped together under one area ID. The method is used only 
with area border routers. This means that an area border router only propagates one route for 
each address area to the outside.

 

 Note

OSPF is available only on layer 3.
 

Settings
● Area ID

Select the area ID. You configure the ID in "Layer 3 > OSPF > Areas".

● Subnet Address
Enter the address of the network that will be grouped.

● Subnet Mask
Enter the subnet mask of the network that will be grouped.

This table contains the following columns:
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● Area ID
Shows the ID of the area.

● Subnet Address
Shows the address of the network that will be grouped with other networks.

● Subnet Mask
Shows the subnet mask of the network that will be grouped with other networks.

● Advertise
Enable this option to advertise the grouped network.

Interfaces

Overview
On this page, you can configure OSPF interfaces.

 

 Note

OSPF is available only on layer 3.
 

Settings 
● IP Address

Select the IP address of the OSPF interface.

This table contains the following columns:

● IP Address
Displays the IP address of the OSPF interface.

● Area ID
Select the area ID with which the OSPF interface is connected.

● OSPF Status
Specify whether or not OSPF is active on the interface.

– Enabled: OSPF is enabled on the interface.

– Disabled: OSPF is disabled on the interface

● Metric
Enter the costs for the OSPF interface.

● Priority
Enter the router priority. The priority is only relevant for selecting the designated router. 
This parameter can be selected differently on routers within the same subnet.

● Trans. Delay
Enter the required delay when sending a connection update.

● Retrans. Delay
Enter the time after which an OSPF packet is transferred again if no confirmation was 
received.
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● Hello Interval
Enter the interval between two Hello packets.

● Dead Interval
Enter the interval after which the neighbor router is marked as "failed" if no more Hello 
packets are received from it during this time.

Interface authentication

Configuring the interface login
On this page, you define the authentication of the interface.

 

 Note

OSPF is available only on layer 3.
 

Settings
● OSPF Interface

Select the OSPF interface for which you want to configure authentication.

● Authentication type
Select the authentication method of the OSPF interface. You have the following options:

– None: No authentication

– simple: Authentication using an unencrypted password  

– MD5: Authentication using MD5

● Password
Enter the password for "simple authentication".

● Confirmation
Confirm the entered password.

● Authentication Key ID 
Enter the ID for MD5 authentication with which the password will be used as a key. Since 
the key ID is transferred with the protocol, the same key must be stored under the same 
key ID on all neighboring routers.

The table has the following columns:

● Authentication Key ID
Can only be edited if you set the MD5 authentication method. It is only possible to use 
several keys there.

● MD5 Key
Enter the MD5 key. 

● MD5 Key Confirmation
Confirm the entered key.

● Youngest Key ID
Shows whether or not the MD5 key is the latest key ID.
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Virtual links

Overview  
Due to the protocol, each area border router must have access to the backbone area. If a 
router is not connected directly to the backbone area, a virtual link to it is created.

 

 Note

OSPF is available only on layer 3.
 

 Note

Note that when creating a virtual link both the transit area and the backbone area must already 
be configured.

the virtual link must be configured identically at both ends.
 

Settings
● Neighbor Router ID

Enter the ID of the neighbor router at the other end of the virtual connection.

● Transit Area ID
Select the ID of the area that connects the two routers.

This table contains the following columns:

● Transit Area ID
Shows the ID via which the two routers are connected.

● Neighbor Router ID
Shows the ID of the neighbor router at the other end of the virtual connection.

● Virt. Link Status
Specify the status of the virtual link. The following statuses are possible:

– down: The virtual link is inactive.

– Point-to-point: The virtual link is active.

● Trans. Delay
Enter the required delay when sending a link update packet.

● Retrans. Delay
Enter the time after which a packet is transferred again if no confirmation was received.

● Hello Interval
Enter the interval between two Hello packets.

● Dead Interval
Enter the interval after which the neighbor router counts as "failed" if no more Hello packets 
are received from it during this time. 
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Virtual Link Authentication

Configuring the virtual link login
On this page, you define the authentication for the virtual link.

 

 Note

OSPF is available only on layer 3.
 

Settings
● Virtual link (area/neighbor) 

Select the virtual link for which you want to configure authentication.

● Authentication type
Select the authentication method of the OSPF interface. You have the following options:

– None: No authentication

– simple: Authentication using an unencrypted password.  

– MD5: Authentication using MD5

● Password
Enter the password for "simple authentication".

● Confirmation
Confirm the entered password.

● Authentication Key ID
Enter the ID for MD5 authentication with which the password will be used as a key. Since 
the key ID is transferred with the protocol, the same key must be stored under the same 
key ID on all neighboring routers.

The table has the following columns:

● Authentication Key ID
Can only be edited if you set the MD5 authentication method. It is only possible to use 
several keys there.

● MD5 Key
Enter the MD5 key. 

● MD5 Key Confirmation
Confirm the entered key.

● Youngest Key ID
Shows whether or not the MD5 key is the latest key ID.
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Security

AAA

General
On this page, you configure the login.

Settings
● Login Authentication

Specify how the login is made: 

– Local
Login with local user name and password.

– Radius
Login using a RADIUS server.

● 802.1x Reauthentication
If you select this check box, an authenticated 802.1X supplicant is forced to reauthenticate 
cyclically. 

Radius client

Authentication over an external server
The concept of RADIUS is based on an external authentication server. An end device can only 
access the network after the device has verified the logon data of the device with the 
authentication server. Both the end device and the authentication server must support the EAP 
protocol (Extensive Authentication Protocol).   

Each column of the table contains access data for one server. In the search order, the primary 
server is queried first. If the primary server cannot be reached, secondary servers are queried 
in the order in which they are entered.

If no server responds, there is no authentication. The client has no access to the network 
although a link is indicated at the port.

Settings
The table has the following columns:

● Server IP Address
Enter the IP address of the RADIUS server. 

● Server Port
Here, enter the input port on the RADIUS server. As default, input port 1812 is set. 

● Shared Secret

● Enter your access ID.
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● Shared Secret Conf.
Enter your access ID again as confirmation.

● Max. number of attempts
Enter the maximum number of query attempts before another configured RADIUS server 
is queried or the login counts as having failed. As default, 3 is set.

● Primary Server
Specify whether or not this server is the primary server. You can select one of the options 
"yes" or "no".

● Status
Enable or disable the RADIUS server.

 

  Note

You can configure a maximum of two servers on this page.
 

802.1x authentication

Enabling authentication for individual ports
By selecting the check box, you specify whether or not network access protection according 
to IEEE 802.1x is enabled on this port.   

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. You have the following setting options:

– Enabled
Access protection is enabled.

– Disabled
Access protection is disabled.

– No change
Table 2 remains unchanged.

● Copy to Table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the port to which the setting relates.

● Setting
Enable or disable the authentication for the required port. If this configuration is not possible 
for a port, it is displayed grayed out and you cannot modify the settings.
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Port ACL MAC

Rule configuration
On this page, you specify the ACL rules for the MAC-based ACL. 

Settings
The table has the following columns:

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● Source MAC
Enter the unicast MAC address of the source.
Dest. MAC
Enter the unicast MAC address of the destination.

● Action
Select the action. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

● Egress Port
Shows a list of all egress ports to which this rule applies.

● Ingress Port
Shows a list of all ingress ports to which this rule applies.

 

 Note

If you enter the address "00:00:00:00:00:00" for the source and/or destination MAC address, 
the rule created in this way applies to all source or destination MAC addresses.

 

Port ingress rules
On this page, you specify the ACL rule according to which incoming frames are handled by 
the port. 

Settings
● Ports

Select the required port.

● Add Rule
Select the ACL rule to be assigned to the port. You specify the ACL rule on the "Rules 
Configuration" page.
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● Add
To permanently assign the ACL rule to the port, click the "Add". The configuration is shown 
in the table.

● Remove Rule
Select the ACL rule to be deleted.

● Remove
To remove the ACL rule from the port, click the "Remove" button.

The table has the following columns:

● Order
Shows the order of the ACL rules.

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● Source MAC
Shows the unicast MAC address of the source.

● Dest. MAC
Shows the unicast MAC address of the destination.

● Action
Select the action. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

 

Port egress rules
On this page, you specify the ACL rule according to which outgoing frames are handled by the 
port.

Description
● Ports

Select the required port.

● Add Rule
Select the ACL rule to be assigned to the port. You specify the ACL rule on the "Rules 
Configuration" page.

● Add
To permanently assign the ACL rule to the port, click the "Add" button. The configuration 
is shown in the table.

● Remove Rule
Select the ACL rule to be deleted.

● Remove
To remove the ACL rule from the port, click the "Remove" button.
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The table has the following columns:

● Order
Shows the order of the ACL rules.

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● Source MAC
Shows the unicast MAC address of the source.

● Dest. MAC
Shows the unicast MAC address of the destination.

● Action
Select the action. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

 

Port ACL IP

Rule configuration
On this page, you specify the rules for the IP-based ACL. 

Settings
The table has the following columns:

● Rule Number 
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● Source IP
Enter the IP address of the source.

● Source Subnet Mask
Enter the subnet mask in which the source is located.

● Dest. IP
Enter the IP address of the destination.

● Dest. Subnet Mask
Enter the subnet mask in which the destination is located.
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● Action
Select the action from the drop-down list. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

● Egress Port
Shows a list of all egress ports to which this rule applies.

● Ingress Port
Shows a list of all ingress ports to which this rule applies.

Port ingress rules
On this page, you specify the ACL rule according to which incoming frames are handled by 
the port.

Settings
● Ports

Select the required port.

● Add Rule
Select the ACL rule to be assigned to the port. You specify the ACL rule on the "Rules 
Configuration" page.

● Add
To permanently assign the ACL rule to the port, click the "Add". The configuration is shown 
in the table.

● Remove Rule
Select the ACL rule to be deleted.

● Remove
To remove the ACL rule from the port, click the "Remove" button.

The table has the following columns:

● Order
Shows the order of the ACL rules. 

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created. 

● Source IP
Shows the IP address of the source.

● Source Subnet Mask
Shows the subnet mask in which the source is located.

● Dest. IP
Enter the IP address of the destination.
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● Dest. Subnet Mask
Enter the subnet mask in which the destination is located.

● Action
Select the action. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

 

Port egress rules
On this page, you specify the ACL rule according to which outgoing frames are handled by the 
port. 

Settings
● Ports

Select the required port.

● Add Rule
Select the ACL rule to be assigned to the port. You specify the ACL rule on the "Rules 
Configuration" page.

● Add
To permanently assign the ACL rule to the port, click the "Add". The configuration is shown 
in the table.

● Remove Rule
Select the ACL rule to be deleted.

● Remove
To remove the ACL rule from the port, click the "Remove" button.

The table has the following columns:

● Order
Shows the order of the ACL rules. 

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created. 

● Source IP
Shows the IP address of the source.

● Source Subnet Mask
Shows the subnet mask in which the source is located.

● Dest. IP
Enter the IP address of the destination.
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● Dest. Subnet Mask
Enter the subnet mask in which the destination is located.

● Action
Select the action from the drop-down list. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

ACL management
On this page, you can increase the security of your device. To specify which station with which 
IP address is allowed to access your device, configure the IP address or an entire address 
range.

You can select the protocols and the ports of the station with which it is allowed to access the 
device. You define the VLAN in which the station may be located. This ensures that only certain 
stations within a VLAN have access to the device.

 

 Note

Note that a bad configuration may mean that you can no longer access the device.
 

Settings
● ACL management

Enable or disable the function.

● IP Address
Enter the IP address or the network address to which the rule will apply. If you use the IP 
address 0.0.0.0, the settings apply to all IP addresses.

● Subnet Mask
Enter the subnet mask. The subnet mask 255.255.255.255 is for a specific IP address. If 
you want to allow a subnet, for example a C subnet, enter 255.255.255.0. The subnet mask 
0.0.0.0 applies to all subnets.

The table has the following columns:

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● IP Address
Shows the IP address.

● Subnet Mask
Shows the subnet mask.

● VLANs Allowed 
Enter the number of the VLAN in which the device is located. The station can only access 
the device if it is located in this configured VLAN. If this input box remains empty, there is 
no restriction.
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● SNMP
Specify whether the station or the IP address can access the device using the SNMP 
protocol.

● TELNET
Specify whether the station or the IP address can access the device using the TELNET 
protocol.

● HTTP
Specify whether the station or the IP address can access the device using the HTTP 
protocol.

● HTTPS
Specify whether the station or the IP address can access the device using the HTTPS 
protocol.

● SSH
Specify whether the station or the IP address can access the device using the SSH protocol.

● Px.y
Specify whether the station or the IP address can access this device via this port.

8.1.4.7 Configuring PROFIBUS DP

The basics of configuring a DP master system

Distributed I/O  
DP master systems that consist of a DP master and DP slaves which are connected via a bus 
and communicate with one another via the PROFIBUS DP protocol are referred to as 
distributed I/O.

Firmware version of the S7‑1200 CPU
Use of the PROFIBUS functions with the S7‑1200, requires CPUs with firmware version 2.0 
or higher.

Configuring distributed I/O
Since DP masters and DP slaves are different devices, these instructions only provide a basic 
configuration procedure. However, the process for configuring distributed I/O is practically 
identical to that of non-distributed configuration.

Creating the DP master system in the network view  
After you have used dragged a DP master and a DP slave (for example, a CM 1243‑5 and a 
CM 1243‑5) from the hardware catalog to the network view, connect them both to a PROFIBUS 
subnet.
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Additional information
Observe additional information on the scope of functions in the manuals of the respective 
device.

DP slaves within the hardware catalog

DP slaves within the hardware catalog   
You will find the DP slaves in the "Distributed I/O" folder of the hardware catalog. Compact 
and modular DP slaves are located there:

● Compact DP slaves
Modules with integrated digital/analog inputs and outputs, for example, ET 200L

● Modular DP slaves
(Interface modules with S7 modules assigned, for example, ET 200M

The available DP master and the desired functionality will determine which DP slaves can be 
used.

I slaves within the hardware catalog  
The CM 1242-5 is, for example, an DP slave that can be configured as intelligent DP slave. 
You can find it in the hardware catalog at:

● CM 1242‑5
"PLC > SIMATIC S7 1200 > Communication module > PROFIBUS"

DP/DP coupler in the hardware catalog 

Introduction
A DP/DP coupler connects two PROFIBUS DP networks as a gateway so that the DP master 
from one network can transfer data to the DP master of the other network.

The maximum amount of data that can be transferred is 244 bytes input data and 244 bytes 
output data.

DP/DP coupler in the hardware catalog      
Details of a DP/DP coupler as gateway between two DM master systems are contained in the 
hardware catalog in the folder "Other field devices > PROFIBUS-DP > Gateways".

Configuring the DP/DP coupler
DP/DP couplers are configured in both PROFIBUS networks, each in their own master 
systems.
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The input and output areas of both networks must thereby be matched to one another. The 
output data from one end of the DP/DP coupler are accepted as input data at the other 
respective end and vice versa.

Configurations involving PROFIBUS DP

Configurations involving basic DP slaves

Communication between DP master and DP slave         
In the case of a configuration involving simple DP slaves, data is exchanged between the DP 
master and simple DP slaves, i.e. with I/O modules via the DP master. The DP master 
sequentially polls each DP slave configured within the DP master system and contained in its 
polling list. In doing so, it transfers the output data to the slaves and receives their input data 
in return.

Mono-master system   
The configuration with only one DP master is also described as mono-master system. A single 
DP master with its associated DP slaves is connected to a physical PROFIBUS DP subnet.

Configurations involving intelligent DP slaves

Definition     
DP slaves that feature their own preprocessing program are referred to as intelligent DP slaves 
(I-slaves).

CM 1242-5 is an intelligent DP slave.
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I-slave <> DP master data exchange     
A higher-level automation system processes the automation task, which is broken down into 
sub-tasks. The sub-tasks are processed in the lower-level automation systems. The necessary 
control tasks are processed separately and efficiently in the CPUs as preprocessing programs.

In the case of configurations involving intelligent DP slaves, the DP master only accesses the 
operand area of the I-slave's CPU, and not the I/O modules of the intelligent DP slave. The 
operand area must not be assigned to any actual I/O modules in the I-slave. The assignment 
must be made during I-slave configuration.

The addresses of the data to be exchanged between the master and slave are configured in 
the transfer area of the I-slave.

Configuring distributed I/O systems

Hint: Quick configuration of master systems
If the DP master system has several DP slaves, use drag-and-drop operation to assign to the 
master in one step all DP slaves that were placed.

Requirements   
DP master and DP slaves are placed in the network view.
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Assigning DP slaves to a DP master system
To do this, follow these steps:

1. Select an appropriate zoom factor so that you can see as many DP slaves as possible in 
the network view.

2. Arrange the DP slaves in a maximum of two rows.

3. Select all DP interfaces with the mouse cursor (not all devices!). This only works if you 
begin to drag the mouse cursor outside of the first DP slave and release the mouse button 
at the last DP slave (selection with the lasso).

4. Select the shortcut menu "Assign to new master" and select the corresponding DP interface 
for the DP master in the subsequent dialog.

5. The DP slaves are automatically networked with the DP master and combine with it to form 
a DP master system.

 

  Note

When a DP master system is highlighted, you can double-click on a DP slave in the 
hardware catalog and thereby quickly add additional DP slaves. This will result in the DP 
slave being added to the highlighted DP master system automatically.
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Creating a DP master system

Introduction   
To create a DP master system, you need to have one DP master and at least one DP slave. 
As soon as you connect a DP master to a DP slave, a master-slave link is established.

DP master   
You can use any of the following devices as a DP master:

● CM 1243‑5

Requirement
● You must be in the network view.

● The hardware catalog is open.

Procedure     
To create a DP master system, follow these steps:

1. Select a DP master from the hardware catalog.

2. Pull the DP master onto the free area within the network view.

3. Right-click on the DP master's DP interface.

4. Select "Create master system" from the shortcut menu.
A DP master system with one DP master will be created as a single node.

If you connect a DP slave's DP interface to that of the DP master, the DP slave will be added 
to the master system.
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Assuming that you have already placed both a DP master and a DP slave within the network 
view, you can drag-and-drop to connect the two and thereby create a DP master system. To 
do so, follow these steps:

1. Click on the DP interface of either the DP master or DP slave.

2. Hold down the mouse button and draw a connecting line between this DP interface and 
that of the desired communication partner.

This will create a subnet with one DP master system between the DP master and DP slave.
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DP master display on the DP slave     
When you connect a DP slave to a DP master, the name of the DP master is displayed on the 
DP slave as a hyperlink. Click the hyperlink to select the associated DP master.

Highlighting applied to the DP master system   
When you create a new DP master system, highlighting will be applied to it. This enables you 
to identify quickly which devices belong to the DP master system. You can also highlight a DP 
master system yourself by moving the mouse pointer over a subnet. This will result in the 
names of the available DP master systems being displayed. Click the required DP master 
system to highlight it.

There are various ways of removing the highlighting from a DP master system:

● Highlight a different master system.

● Click on the drawing pin with the name of the master system in the top right-hand corner 
of the network view.
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Editing DP master systems and interfaces

Introduction     
Once you have created a DP master system, you also have the option of disconnecting the 
DP master system from its components. This can result in subnets with DP slaves but without 
DP master. 

Generally, there is no need to edit the interfaces of a DP master.

You can change the name and number on the DP master system.

Disconnection of master or slaves from the DP master system
If you have configured a PROFIBUS CP as a DP master with master system, you can then 
disconnect the DP master system from the DP master. After this, the device will no longer be 
connected to the DP master system.

Disconnecting the subnet from a DP master effectively eliminates the master system in the 
sense that it is no longer assigned to a DP master. However, the individual DP slaves are still 
interconnected via the subnet.

If you delete the DP slaves or disconnect them from the master system, the master system is 
then retained on the DP master. 

Requirement
● You must be in the network view.

● There has to be a DP master system with one DP master and at least one DP slave.

Disconnecting the DP master from the DP master system   
To disconnect the DP master system, proceed as follows:

1. Right-click on the DP master's DP interface.

2. Select "Disconnect from master system" from the shortcut menu.

The selected DP master will be disconnected from the DP master system. A subnet with the 
DP slaves will be retained.

Adding a DP master to the DP master system   
To reassign a DP master to a subnet, proceed as follows:

1. Right-click on the DP master's DP interface.

2. Select "Create master system" from the shortcut menu.

3. Draw connecting lines between the new DP master system and the DP interfaces of the 
DP slaves.

The DP master combines with the DP slaves to recreate a DP master system.
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Editing the properties of a DP master system   
To edit the properties of a DP master system, proceed as follows:

1. Move the mouse pointer over a subnet with a DP master system.

2. A message will appear displaying the available DP master systems. Click the one you want 
to edit. The DP master system will now be color-highlighted.

3. Click on the highlighted DP master system.

4. In the inspector window, edit the DP master system attributes under "Properties > General".
 

  Note

If you click a subnet when no DP master system is highlighted, you will be able to edit the 
properties of the entire subnet under "Properties" in the inspector window. 

 

Adding DP slaves to the master system and configuring them
In the network view, you can add various DP slaves from the hardware catalog directly by 
using the drag-and-drop function or by double-clicking.

DP slaves  
For configuration purposes, DP slaves are broken down into the following categories:

● Compact DP slaves
(Modules with integrated digital/analog inputs and outputs, for example, ET 200L)

● Modular DP slaves
(interface modules with S5 or S7 modules assigned, for example ET 200M)

● Intelligent DP slaves (I slaves)
(CM 1242‑5 or ET 200S with IM 151-7 CPU)

Rules
● Your DP master system should only contain one DP master, but it may contain one or or 

more DP slaves.

● You may only configure as many DP slaves in a DP master system as are permitted for the 
specific DP master.

 

  Note

When configuring the DP master system, remember to observe the DP master technical 
data (max. number of nodes, max. number of slots, max. quantity of user data). User data 
restrictions may possibly prevent you from being able to use the maximum number of 
nodes that is theoretically possible.
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Requirements
● You must be in the network view.

● A DP master system must have been created.

Adding a DP slave to the DP master system  
To add a DP slave from the hardware catalog to the DP master system, follow these steps:

1. Select a DP slave from the hardware catalog.

2. Drag-and-drop the DP slave from the hardware catalog into the network view.

3. Draw a connecting line between the DP master's DP interface or a highlighted DP master 
system and the DP interface of the new DP slave.

A DP master system will be created and the DP slave will be connected to the DP master 
automatically.

 

 Note

When a DP master system is highlighted, you can double-click the required DP slave in the 
hardware catalog. This will result in the DP slave being added to the highlighted DP master 
system automatically.

 

Disconnecting a DP slave from the DP master system  
To disconnect a DP slave from the DP master system, follow these steps:

1. In the network view, right-click on the DP slave's DP interface.

2. From the shortcut menu, select the method for disconnecting from the DP master system:

– "Disconnect from subnet": The PROFIBUS connection is broken and the device is no 
longer connected to the DP master system or a subnet.

– "Disconnect from master system": The DP slave remains connected to the subnet, but 
is no longer assigned to the DP master system as a DP slave.

The selected DP slave will be disconnected from the DP master system.

Assigning a DP slave to a new DP master system 
To assign an existing DP slave to a new DP master system, follow these steps:

1. Right-click on the DP slave's DP interface.

2. From the shortcut menu, select "Assign to new master".
It does not matter whether the DP slave concerned is already assigned to another DP 
master system.

3. From the selection list, select the DP master whose DP master system is to have the DP 
slave connected to it.
The selected DP slave is now assigned to a new DP master system.
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The "Assign to new subnet" function works in a similar way in that it allows you to connect a 
DP slave to a new subnet. However, in this case, the DP slave will not be connected to an 
existing DP master system.

Configuring a DP slave  
To configure a DP slave, follow these steps:

1. Switch to the DP slave's device view.

2. Select the module you want.

3. Configure the DP slave in the Inspector window.

Configuring intelligent DP slaves

Adding an I-slave to a DP master system

Introduction       
One of the characteristics of an intelligent DP slave (I-slave) is that the DP master is not 
provided with I/O data directly by a real I/O, but by a preprocessing CPU. Together with the 
CP, this preprocessing CPU forms the I-slave.

Difference: DP slave v. intelligent DP slave
In the case of a DP slave, the DP master accesses the distributed I/O directly.

In the case of an intelligent DP slave, the DP master actually accesses a transfer area in the 
I/O address space of the preprocessing CPU instead of accessing the connected I/O of the 
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intelligent DP slave. The user program running on the preprocessing CPU is responsible for 
ensuring data exchange between the address area and I/O.

 

 Note

The I/O areas configured for data exchange between the DP master and DP slaves must not 
be used by I/O modules.

 

Applications
Configurations involving intelligent DP slaves: I-slave <> DP master data exchange

Procedure     
To add an I-slave to a DP master system, follow these steps:

1. In the network view, drag from the hardware catalog to a station one CM 1242-5  as an I-
slave and one CM 1243-5 as a DP master.

2. Draw a connecting line between the DP interfaces of both devices.
This way you connect the I-slave with a DP master in a DP master system.
Result: You have now set up a DP master system with one DP master and one I-slave.

Configuring access to I slave data

Data access   
The following applies to the CP 1242-5 in its function as I-slave: The addresses for the data 
transfer area and the address for the I/O modules in the I-slave differ. This means that the start 
address occupied by an I/O module can no longer be used for the transfer memory. If the 
higher-level DP master is to access the data of an I/O module in the I-slave, you must configure 
this data exchange between the I/O module and transfer area in the I-slave user program.
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Configuration of the transfer area for the CM 1242-5 (transfer area)
With CM 1242‑5, the transfer area for the cyclic PROFIBUS data exchange is configured as 
transfer area in the parameter group "PROFIBUS interface > Mode > I Slave Communication".

Direct data access from CPU to CPU
Direct data access from CPU to CPU via PROFIBUS is supported by the S7-1200 PROFIBUS 
CMs only via the PUT/GET services.

Configuring DP slaves as distributed I/O devices

Configuring an ET 200S

Slot rules for configuring an ET 200S   
The following rules apply when configuring an ET 200S:

● Do not leave any gaps when inserting the ET 200S modules.

● Slot 1: only for PM-E or PM-D Power Modules.

● To the left of an Electronics Module (EM): an EM or a Power Module (PM-E or PM-D) only.

● To the left of Motor Starter (MS): an MS, a PM-D, PM-D Fx (1..x..4) Power Module or a PM-
X Power Module only.

● To the left of a PM-X: a motor starter or a PM-D only

● Up to 63 modules and one IM Interface Module are permitted
 

  Note

Remember to ensure that the correct PM-E and EM voltage ranges are assigned.
 

Configuring reference junctions  
A reference junction is the connection of a thermocouple to a supply line (generally in the 
terminal box). The voltage that occurs due to the effects of temperature falsifies the 
temperature value measured by the module. 

On the ET 200S, one channel of the AI RTD module can be programmed as a reference 
junction. Other AI TC modules can correct their measured values using the temperature at the 
reference junction as measured by this module.
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① Configuring the AI TC:

→ Selection of the reference junction used
② Configuring of the AI RTD: 

→ Activation of the reference junction
→ Specifying the slot and channel of the AI RTD

 

Special characteristics to be noted when assigning parameters for reference junctions  
The process of assigning parameters for reference junctions will be explained based on the 
example of a resistance thermometer with a Pt 100 climatic range that is used for measuring 
the reference junction temperature.

To assign parameters for the reference junction, follow these steps: 

1. In the ET 200S device view, insert an analog electronics module, for example a 2AI RTD HF.

2. Select the module on the rack.

3. Under "Properties > Inputs" in the inspector window, set a channel for the reference 
junctions function to the "RTD-4L Pt 100 climatic range" measuring range.

4. Select the ET 200S.

5. Under "Properties > Module parameters > Reference junctions" in the inspector window, 
select the "Reference junction" check box and specify the slot and channel number of the 
relevant RTD module.

6. Insert the analog electronics module for measuring the temperature using a thermocouple 
(TC module) and parameterize it with the reference junction number of the RTD module.

Additional information
For additional information on the various types and uses of ET 200S modules, please refer to 
the operating instructions and the manual titled "ET 200S Distributed I/O System".

For additional information on analog value processing, please see the documentation for the 
ET 200S distributed I/O system.
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Packing addresses

Introduction 
DP slaves and I/O devices from the ET 200S family are configured in the same way as other 
modular DP slaves and I/O devices. As well as supporting all the standard modular DP slave 
and I/O device functions, the ET 200S also offers the "Pack addresses" function:

When digital electronics modules requiring an address space of 2 or 4 bits are inserted into 
the device view, they will initially be spread over a total area of 1 byte. However, the address 
area actually occupied can be compressed after configuration using the "Pack addresses" 
function. 

 Initial state After "Pack addresses"
Module I address I address
2DI (2-bit) Byte 10 10.0...10.1
4DI (4-bit) Byte 11 10.2...10.5

Requirements
● You are in the device view.

● An ET 200S, for example an IM 151-1, must be present.

● A pair of digital electronics modules, for example 2DI AC120V ST, must be inserted into 
the slots.

Packing addresses   
To pack addressed, follow these steps:

1. Select the electronics modules whose addresses are to be packed. The following options 
are available for selecting multiple electronics modules:

– Press and hold down <Shift> or <Ctrl> while clicking the relevant electronics modules.

– Click off the rack and select the required electronics modules by drawing round them 
with the mouse.

2. Click "Pack addresses" in the shortcut menu for the selected electronics modules.

The address areas for inputs, outputs and motor starters are packed separately. The packed 
addresses will be displayed in the I address and Q address columns of the device overview.
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How packed addresses are generated and structured  
If you make use of the "Pack addresses" function, the addresses of the selected electronics 
modules will be packed in accordance with the following rules:

● The start of the address area is determined by the lowest address of the selected electronics 
modules: X.0

● If the bit address is not "0", then the next (free) byte address as of which the selected area 
can be compacted will be selected automatically: (X+n).0

● If no coherent area exists, the addresses will be automatically packed into any available 
address gaps.

Electronics modules with packed addresses and the same byte address form a packing group.

Unpacking addresses  
To unpack addressed, follow these steps:

1. Select one or more electronics modules with packed addresses.

2. Click "Unpack addresses" in the shortcut menu for the selected electronics modules.

The packing groups of the selected electronics modules will be disbanded and the packed 
addresses for the relevant electronics modules unpacked.

The packing group will also be disbanded and the packed addresses unpacked in the following 
cases: if you delete electronics modules from a packing group, move electronics modules out 
of a packing group or insert electronics modules on a free slot within a packing group.

The start addresses of the unpacked electronics modules will be assigned to the next available 
byte addresses in each case.

Special characteristics of electronics modules with packed addresses
The following special characteristics apply to electronics modules with packed addresses:

● As far as the CPU is concerned, there is no way of assigning a slot for the electronics 
module. Consequently, the instruction GADR_LGC (SFC 5) outputs error information 
W#16#8099 "Slot not configured" for the actual slot of the electronic module.

● The instruction LGC_GADR (SFC 49) and SZL-ID W#16#xy91 "module status information" 
cannot be evaluated for an electronics module.

● The electronics module receives an additional diagnostics address via the DPV1 function, 
because otherwise the packed addresses would prevent interrupts from being assigned as 
far as the CPU is concerned.

● The "Insert/remove interrupt" is not possible. This is because the "Pack addresses" and 
"Insert/remove interrupt" functions are mutually exclusive. 

Configuring option handling with standby modules
You can use the option handling function to prepare the ET 200S with PROFIBUS interface 
for future expansions (options). This section describes option handling with standby modules. 
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You do this by assembling, wiring, configuring, and programming the maximum configuration 
envisaged for the ET 200S and by using cost-effective standby modules (138-4AA00 or 
138-4AA10) during assembly until it becomes time to replace them with the necessary 
electronics modules.

 

 Note

The ET 200S can be completely factory-wired with the master cabling, as no connection 
exists between a standby module and the terminals of the terminal module (and, in turn, to 
the process).

 

Requirement
● ET 200S interface module

– IM 151-1 STANDARD (6ES7 151-1AA03-0AB0 or higher)

– IM 151-1 FO STANDARD (6ES7 151-1AB02-0AB0 or higher)

● Power module with option handling

– PM-E DC24..48V

– PM-E DC24..48V/AC24..230V

Procedure  
To activate option handling, follow these steps:

1. Select the IM 151-1 in the device view and enable it in "Option handling" check box under 
"Properties > General >  Option handling" in the inspector window.

2. Select the numbered check boxes for the slots that are initially to accommodate the standby 
modules prior to the future electronics modules.

3. Select the power module in the device view and enable it in the "Option handling" check 
box under "Properties > Addresses" in the inspector window. Reserve the necessary 
address space for the control and check-back interface in the process image output (PIQ) 
and process image input (PII).

The assembled standby modules can be replaced with the configured modules at a later date 
without having to modify the configuration.

 

 Note

The addresses for these interfaces are reserved as soon as you activate option handling on 
the power module. The "Option handling" function must also be activated on the DP slave 
(IM 151-1 STANDARD Interface Module). If it is not activated, the addresses reserved for the 
control and check-back interface will be released again.

Note that activating and deactivating the option handling function repeatedly can change the 
address of the control and check-back interface.

Option handling may be activated for one PM-E DC24..48V or one PM-E DC24..48V/
AC24..230V Power Module only.
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Additional information
For additional information on the assignment and significance of bytes within the process 
image, option handling with PROFIBUS and the use of standby modules, please refer to the 
documentation for the ET 200S distributed I/O system.

How option handling works during startup
If "Startup when expected/actual config. differ" is not available, the ET 200S will still start up 
if a standby module is inserted instead of the configured electronics module and option 
handling has been activated for the slot concerned. 

How option handling works during operation
During operation, the option handling mode varies in accordance with the following:

● Option handling enabled for a slot: 
Either the standby module (option) or the configured electronics module can be plugged 
into this slot. If any other kind of module is present on this slot, diagnostics will be signaled 
(no module/incorrect module).

● Option handling disabled for a slot: 
Only the configured electronics module can be plugged into this slot. If any other kind of 
module is present, diagnostics will be signaled (no module/incorrect module).

Standby module substitute values  
● Substitute value for digital inputs: 0

● Substitute value for analog inputs: 0x7FFF

Control and evaluation in the user program
The ET 200S is equipped with a control and feedback interface for the "Option handling" 
function. 

The control interface is located in the process image output (PIQ). Each bit in this address 
area controls one of the slots from 2 to 63: 

● Bit value = 0: Option handling parameterized. Standby modules are permitted.

● Bit value = 1: Option handling canceled. Standby modules are not permitted on this slot.

The check-back interface is located in the process image input (PII). Each bit in this address 
area provides information about the modules that are actually plugged into slots 1 to 63: 

● Bit value = 0: This slot has the standby module, an incorrect module or no module plugged 
into it.

● Bit value = 1: The configured module is plugged into this slot.

See also
Which modules support option handling? (http://support.automation.siemens.com/WW/view/
en/22564754)
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Configuring option handling without standby modules
You can use the option handling function to prepare the ET 200S for future expansions 
(options) without installing standby modules. This section describes option handling without 
standby modules.

 

 Note
ET 200S with PROFINET interface

This description refers to the ET 200S with PROFIBUS interface. In principle, option handling 
for ET 200S with PROFINET interface functions as described here without standby modules. 
PN interface modules are to be used instead of the DP interface modules listed here. You 
can find additional information about option handling for ET 200S with PROFINET interface 
in the corresponding manuals.

 

Requirement
● ET 200S interface module 

– IM 151-1 HIGH FEATURE (6ES7151-1BA02 or higher)

– IM 151-1 STANDARD (6ES7 151-1AA05-0AB0 or higher)

● Power module with option handling

– PM-E DC24..48V

– PM-E DC24..48V/AC24..230V
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Procedure  
To activate option handling, follow these steps:

1. Select the IM 151-1 in the device view and enable it in "Option handling" check box under 
"Properties > General >  Option handling" in the inspector window.

2. Select the power module in the device view and enable it in the "Option handling" check 
box under "Properties > Addresses" in the inspector window. Reserve the necessary 
address space for the control and check-back interface in the process image output (PIQ) 
and process image input (PII).

3. Configure the slave's maximum configuration. The selection/clearing of options is controlled 
via the user program. 

 

  Note

The addresses for these interfaces are reserved as soon as you activate option handling 
on the power module. The "Option handling" function must also be activated on the DP 
slave (IM 151-1 interface module). If it is not activated, the addresses reserved for the 
control and check-back interface will be released again.

Note that activating and deactivating the option handling function repeatedly can change 
the address of the control and check-back interface.

Option handling may be activated for one PM-E DC24..48V or one PM-E DC24..48V/
AC24..230V Power Module only.

 

Additional information
For additional information on the assignment and significance of bytes within the process 
image, option handling with PROFIBUS and the use of standby modules, please refer to the 
documentation for the ET 200S distributed I/O system.

Control and evaluation in the user program
The ET 200S is equipped with a control and feedback interface for the "Option handling" 
function. 

The control interface is located in the process image output (PIQ). Each bit in this address 
area controls one of the slots from 1 to 63: 

● Bit value = 0: Slot is not available in the actual configuration.

● Bit value = 1: Slot is available in the actual configuration.

The check-back interface is located in the process image input (PII). Each bit in this address 
area provides information about the modules that are actually plugged into slots 1 to 63: 

● Bit value = 0: Slot belongs to an option that is not available or module status is faulty.

● Bit value = 1: The configured module is plugged into this slot.

See also
Sample applications for ET 200S, option handling without standby module (http://
support.automation.siemens.com/WW/view/en/29430270)
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Configuring the ET 200S in DPV1 mode
PROFIBUS DPV1 enables you to access extended PROFIBUS functions.

Requirement
● You must be in network view.

● A DP master with DPV1 functionality must be available.

● A master-slave connection must be established with PROFIBUS.

Procedure   
To switch the DP slave over to DPV1, follow these steps:

1. Select the DP slave.

2. Under "Properties > Module parameters" in the Inspector window, select "DPV1" mode 
from the "DP interrupt mode" drop-down list.

or

1. Select the DP master.

2. In the I/O communications table, select the row with the connection between the DP master 
and the desired DP slave.

3. Under "Properties > Module parameters" in the Inspector window, select "DPV1" mode 
from the "DP interrupt mode" drop-down list.

Special characteristics
The parameters are subject to interdependencies, which are outlined below: 

Parameter DPV0 mode DPV1 mode
Operation when target 
configuration does not match 
actual configuration

Fully available Fully available

Diagnostics interrupt (OB 82) Not available, not set Fully available
Hardware interrupt (OB 40 to 47) Not available, not set Fully available
Insert/remove interrupt (OB 83) Not available, not set Only available when addresses 

are not packed.
"Startup when target 
configuration does not match 
actual configuration" is activated 
automatically along with an 
insert/remove interrupt.

Interrupts in the case of modules with packed addresses  
If the module is capable of triggering interrupts and the bit address is not equal to 0 because 
of packed addresses, you will need to assign a diagnostics address in the ET 200S address 
dialog. 
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The diagnostics address is required for the purpose of assigning a DPV1 interrupt to the module 
as an interrupt trigger. The CPU will only be able to assign an interrupt correctly and store 
information on the interrupt in the interrupt OB start information/in the diagnostics buffer if the 
module concerned has this "unpacked" address. In this context, the CPU cannot make use of 
"packed" addresses. 

From the point of view of interrupt processing (interrupt OB), this means the module will have 
the assigned diagnostics address, but from the point of view of processing the input and output 
data in the user program, the module will have the packed addresses.

 

 Note

When the module addresses are packed, the insert/remove interrupt for the ET 200S is 
unavailable. 

 

Using GSD files

GSD revisions

What you need to know about GSD revisions   
The properties of DP slaves are made available to configuration tools by means of GSD files.

Functional enhancements in the area of the distributed I/O will have an effect on the GSD 
specification, for example, they will require the definition of new keywords.

This results in the versioning of the specification. In the case of GSD files, the version of the 
specification on which a GSD file is based is called a "GSD revision".

From GSD revision 1, the GSD revision must be included as a keyword "GSD_revision" in 
GSD files. GSD files without this keyword will therefore be interpreted by configuration tools 
as GSD revision "0".

GSD files can be interpreted up to GSD revision 5. This means that DP slaves that support 
the following functions, for example, will be supported: 

● Diagnostic alarms for interrupt blocks

● Isochronous mode and constant bus cycle time 

● SYNC/FREEZE

● Clock synchronization for DP slaves

Installing the GSD file

Introduction
A GSD file (device data file) contains all the DP slave properties. If you want to configure a DP 
slave that does not appear in the hardware catalog, you must install the GSD file provided by 
the manufacturer. DP slaves installed via GSD files are displayed in the hardware catalog and 
can then be selected and configured.
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Requirement
● The hardware and network editor is closed.

● You have access to the required GSD files in a directory on the hard disk.

Procedure  
To install a GSD file, proceed as follows:

1. In the "Options" menu, select the "Install device master data files" command.

2. In the "Install device master data files" dialog box, choose the folder in which you want to 
save the GSD files.

3. Choose one or more files from the list of displayed GSD files.

4. Click on the "Install" button.

5. To create a log file for the installation, click on the "Save log file" button.
Any problems during the installation can be tracked down using the log file.

You will find the new DP slave installed by means of the GSD file in a new folder in the hardware 
catalog.

 

 Note

Installation of GSD file cannot be undone.
 

Configuring GSD-based DP slave
DP slaves that you have inserted through installation of a GSD file can be selected as usual 
via the hardware catalog and inserted in the network view. If you want to insert the modules 
of the GSD-based DP slaves, you must take into account some particular details.

Requirements
● You have installed a DP slave using a GSD file.

● You have inserted the head module in the network view in the usual manner.

● The device overview opens in the device view.

● The hardware catalog is open.

Procedure         
To add the modules of a GSD-based DP slave, proceed as follows:

1. In the hardware catalog, navigate to the modules of the GSD-based DP slave.
GSD-based DP slaves, also referred to as DP standard slaves, can be found in the "Other 
field devices" folder of the hardware catalog.

2. Select the desired module.
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3. Use drag-and-drop to move the module to a free space in the device overview.

4. Select the module in the device overview to edit parameters.

You have now inserted the module in a free slot of the GSD-based DP slave and can edit its 
parameters.

 

 Note

You can see only the GSD-based DP slave in the graphic area of the device view. The added 
modules of GSD-based DP slaves are only found in the device overview.

 

Preset configuration
For modules with an adjustable preset configuration, you can change this configuration in the 
inspector window under "Properties > Preset configuration". 

8.1.4.8 Configurations for PROFINET IO

What you need to know about PROFINET IO

What is PROFINET IO?

PROFINET IO   
PROFINET is an Ethernet-based automation standard of PROFIBUS Nutzerorganisation e.V. 
(PNO) which defines a manufacturer-neutral communication, automation and engineering 
model.

Objective
The objective of PROFINET is:

● Integrated communication via field bus and Ethernet

● Open, distributed automation

● Use of open standards

Architecture
The PROFIBUS User Organisation e.V. (PNO) has designated the following aspects for 
PROFINET architecture:

● Communication between controllers as components within distributed systems.

● Communication between field devices, such as I/O devices and drives.
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Implementation by Siemens
The demand for "Communication between controllers as components within distributed 
systems" is implemented by "Component Based Automation" (CBA). Component Based 
Automation is used to create a distributed automation solution based on prefabricated 
components and partial solutions. 

The demand for "Communication between field devices" is implemented by Siemens with 
"PROFINET IO". Just as with PROFIBUS DP, the complete configuration and programming 
of the components involved is possible using the Totally Integrated Automation Portal. 

The following sections deal with the configuration of communication between field devices 
using PROFINET IO.

Overview of RT classes

RT classes in PROFINET IO   
PROFINET IO is a scalable, real-time communication system based on Ethernet technology. 
The scalable approach is reflected in several real-time classes:

● RT: Transmission of data in prioritized, non-isochronous Ethernet frames. The required 
bandwidth is within the free bandwidth area for TCP/IP communication.

● IRT: Isochronous transmission of data with high stability for time-critical applications (for 
example, motion control). The required bandwidth is from the area of bandwidth reserved 
for cyclic data.

Depending on the device, not all real-time classes are supported. 

Connecting existing bus systems

Connection of PROFINET and PROFIBUS  
PROFINET IO and PROFIBUS DP can be connected with each other as follows: 

● via Industrial Ethernet: 
To connect the two network types, Industrial Ethernet (control level) and PROFIBUS (cell 
level/field level), use e.g. the IE/PB link.

● via Industrial Wireless LAN: 
PROFIBUS devices, for example, can be connected to PROFINET IO via a wireless LAN/
PB link. This allows existing PROFIBUS configurations to be integrated into PROFINET.

AS interface devices can be connected by an IE/AS-i link PN IO to the interface of a PROFINET 
device. This allows the existing AS-i network to be integrated into PROFINET.

The following figure shows the connection of a PROFIBUS subnet via PROFINET device with 
proxy functions. 
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① PROFINET devices
② PROFINET device with proxy functions (for example, IE/PB link)
③ PROFIBUS devices

PROFINET device with proxy functions used as proxy for a PROFIBUS device
The PROFINET device with proxy functions is the proxy for a PROFIBUS device on the 
Ethernet. Proxy functionality allows a PROFIBUS device that can communicate with all devices 
on the PROFINET and not just with its master.

Using PROFINET, existing PROFIBUS systems can easily be integrated into PROFINET 
communication using the proxy functions.

If, for instance, you connect a PROFIBUS device via an IE/PB link to PROFINET, the IE/PB 
link acts as a proxy for the PROFIBUS components to establish communication via PROFINET.

Configuration using IE/PB link PN IO

Configuration using IE/PB link PN IO
Use the IE/PB link IO to connect PROFIBUS DP configurations to PROFINET IO. 

From the CPU perspective, the PROFIBUS DP slaves are connected to the same network as 
the IE/PB link PN IO. These slaves have the same device names and IP addresses as the IE/
PB link PN IO, but different device numbers. Furthermore, each also has a specific PROFIBUS 
address. 

In the properties of the IE/PB link, the PROFIBUS addresses of the connected DP slaves are 
displayed in addition to the PROFINET device numbers, as this device has two addressing 
schemes. 
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Handling device numbers and PROFIBUS addresses on the master system
During placement, the same number is assigned for the PROFINET device number and the 
PROFIBUS address. 

In the inspector window under "General Properties > PROFINET device number", you can find 
an overview of the device numbers used and the PROFIBUS addresses of an IE/PB link. The 
device number can also be changed here. You can also set that the device number and the 
PROFIBUS address should or should not always be identical. If the "PROFINET device 
number=PROFIBUS address" is activated, you do not have to track the device number when 
the PROFIBUS address changes. 

The PROFIBUS addresses can be changed in the properties of the PROFIBUS device.

Restrictions
The following restrictions apply to DP slaves configured as described above on the PROFIBUS 
subnet of an IE/PB link:

● No pluggable IE/PB link

● No pluggable DP/PA link

● No pluggable Y link

● Not CiR-compliant

● No pluggable redundant slaves

● No isochronous transmission / constant bus cycle time can be configured

● SYNC/FREEZE instructions ("DPSYC_FR") of a CPU on the the Ethernet subnet for DP 
slaves behind the IE/PB-Link are not supported.

Configuration using IWLAN/PN link

Maximum number of devices in a IWLAN segment
If an Ethernet subnet is set up as wireless network (IWLAN = Industrial Wireless LAN), cyclic 
data exchange between IO controllers and IO devices is possible via a wireless route. 

On one side of the wireless route there are fixed installed access points (for example, 
SCALANCE W 788) and on the other side mobile stations (with, for example IWLAN/PB links 
with PROFIBUS devices). 

If the action radius of the mobile stations is large, it may be necessary to install several access 
points (SCALANCE W 788). Since each access point forms a segment with its wireless range, 
the IWLAN is made up of a series of segments. 

The mobile devices "on the one side" of the wireless link with their IWLAN/PB links can move 
along the segments.
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Special feature
If several IWLAN/PB links are located within a segment, they have to share the bandwidth that 
is available for wireless transmission. This leads to a lengthening of the update time for these 
devices.

Example
In the following example there are two IO devices (IWLAN/PB link) with a segment. 

If no more than a maximum of two IWLAN/PB links are present in a IWLAN segment at the 
same time, enter a "2".

① Segment 1
② Segment 2
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Configure PROFINET IO 

Addressing PROFINET devices

Assigning addresses and names to PROFINET devices
In this chapter you will learn which address and naming conventions are valid for the 
PROFINET devices.

IP addresses       
All PROFINET devices work with the TCP/IP protocol and therefore require an IP address for 
Ethernet operation. 

You can set the IP addresses in the module properties. If the network is part of an existing 
company Ethernet network, ask your network administrator for this data.

The IP addresses of the IO devices are assigned automatically, usually at CPU startup. The 
IP addresses of the IO devices always have the same subnet mask as the IO controller and 
are assigned in ascending order, starting at the IP address of the IO controller.

Device names 
Before an IO device can be addressed by an IO controller, it must have a device name. This 
procedure was chosen for PROFINET because names are easier to administer than complex 
IP addresses. 

Both the IO controller as well as IO devices have a device name. When the "Generate 
PROFINET device name automatically" option is activated, the device name is automatically 
derived from the name configured for the device (CPU, CP or IM):

● The PROFINET device name is made up of the name of the device (for example, the CPU), 
the name of the interface (only with multiple PROFINET interfaces) and optionally the name 
of the IO system:
<CPU name>.<Name of the interface>.<IO system name>
You cannot change this name directly. You change the PROFINET device name indirectly, 
by changing the name of the affected CPU, CP or IM in the general properties of the module. 
This PROFINET device name is also displayed, for example, in the list of accessible 
devices. If you want to set the PROFINET device name independently of the module name, 
you have to deactivate the "Generate PROFINET device name automatically" option. 

● A "converted name" is generated from the PROFINET device name. This is the device 
name that is actually loaded into the device.
The PROFINET device name is only converted if it does not comply to the rules of IEC 
61158-6-10. You cannot change this name directly either. 
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Rules for the converted name
The rules for the converted name are listed in the following section. If the converted name is 
not different from the name of the module, the name of the module must comply with this rule. 

● The name consists of one or more labels , which are separated by a dot [.].

● Restricted to a total of 240 characters (lower case letters, numbers, dash, or dot)

● A name component within the device name, which means a character string between two 
dots, must not exceed 63 characters.

● A name component consists of the characters [a-z, 0-9].

● The device name must not begin or end with the "-" character.

● The device name must not begin with a number.

● The device name form n.n.n.n (n = 0, ... 999) is not permitted.

● The device name must not begin with the string "port-xyz" or "port-xyz-abcde" (a, b, c, d, 
e, x, y, z = 0, ... 9).

Example of device names
device-1.machine-1.plant-1.vendor
If you assign this name to a CPU, for example, STEP 7 will not convert it since it conforms to 
the rules described above.

Device number   
In addition to the device name, a device number is also automatically assigned when an IO 
device is plugged in. You can change this number. 

Devices in the PROFINET subnet
In a PROFINET subnet the maximum allowable number of devices is monitored during 
configuration. 

See also
Assigning the device name and IP address (Page 801)

Retentivity of IP address parameters and device names (Page 808)

Assigning the device name and IP address

Assigning an IP address and subnet mask for an IO controller the first time       
There are various options for this: During the configuration of PROFINET interface, you have 
to set the following:

● IP address is set in the project.

● IP address is set using a different method.
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Assign an IP address Comments
Option: Set IP address in the project:
Download with hardware configuration

When the hardware configuration is downloaded 
to the IO controller (e.g. CPU), the IP address and 
the device name are also downloaded. 

Option: Set IP address in the project: 
Assign online via PROFINET interface

Connect your programming device/PC to the 
same network as the relevant PROFINET device. 
The interface of the PD/PC must be set to TCP/IP 
(Auto) mode. Have a list of accessible devices 
displayed. Select the target device via its MAC 
address and then assign its configured IP address 
before you download the hardware configuration 
including the configured IP address (IP address is 
then saved retentively).

Option: Set IP address in the project: 
Assign online via MPI/PROFIBUS interface

If your PROFINET device has an MPI or 
PROFIBUS DP interface, connect your 
programming device/PC directly to the PROFINET 
device via the MPI or PROFIBUS DP interface. 
The configured IP address is applied during 
download of hardware configuration.

Option "Use different method to obtain IP address" 
● Assign online
● Assign via user program
● Higher-level IO controller (only with I devices)

If you have selected this option in the properties 
of the PROFINET interface, the IP address can be 
assigned by the online and diagnostics editor, by 
the primary setup tool or by the user program 
("IP_CONF" instruction)..
In case of an S7-1200-CPU, make sure that 
access to the CPU is not protected by a password. 
If the CPU is write-protected, no IP address and 
no device name can be assigned by any other 
method.

Commissioning a PROFINET interface 
Further details of how to commission a PROFINET interface can also be found in the operating 
instructions for the PROFINET devices from the SIMATIC family. 

Assigning device names for IO devices when the "Device replacement without removable media/PG" 
option is enabled   

For IO devices where the "Device replacement without removable media/PG" option is 
activated, it is not necessary to assign the device name in the case of a device replacement. 
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Assigning a device name and address for an IO device (exception in the case device exchange without 
media change/PG) 

The following graphic illustrates the process for assigning the device name and address.

① Each device receives a name; STEP 7 automatically assigns an IP address. 
② STEP 7 generates a PROFINET device name from the name. This is then assigned to an IP 

device online (MAC address) and is written into the device. 
③ The configuration is downloaded to the IO controller.
④ The IO controller assigns the appropriate IP address to the IO device with the assigned 

PROFINET device name during startup.

A device name is assigned to each IO device. You can change the name and IP address 
manually.

You have two options for downloading configured data to the PROFINET IO device:
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● Offline with a Micro Memory Card:
Place the configured data (device name: for example, turbo-3) for the IO device in the MMC 
in the PG/PC. Use the command "SIMATIC Card Reader > Save Device Name to Memory 
Card" in the "Project" menu for this.
Then insert the MMC into the IO device. The IO device automatically adopts the configured 
device name.

● Online with programming device/PC:
Connect the programming device/PC directly to the Ethernet subnetwork via the 
PROFINET interface. 
Select the subnet in the network view and then select the "Assign device name" shortcut 
command. 
In the "Assign PROFINET device name" dialog box, select the suitable PG/PC interface to 
connect to the Ethernet subnet.
All configured PROFINET device names are in the top drop-down list. Select a PROFINET 
device name from it and select the IO device to receive this device name from the table at 
the bottom. You can filter the display of devices in the table according to various criteria. 
You can easily identify the device using the "Flash LED" button. 
The IO controller recognizes the IO device by its device name and automatically assigns 
the configured IP address to it.

IP address assignment for special IO devices
Special IO devices, for example, SCALANCE X, S7-300 CPs, support the option of assigning 
the IP addresses not from the IO controller during startup. In this case, the IP address is 
assigned in a different way. For additional information, refer to the manual of the respective 
PROFINET device of the SIMATIC device family.

Requirement for additional procedures when assigning IP address and device name
If the IO device, as described above, should not obtain the IP address or device name from 
the IO controller, proceed as follows:

1. Select device or network view.

2. Open the properties for the respective PROFINET device.

3. Select the "Use different method to obtain IP address" option or "Different method for 
obtaining device name" option.

Rules 
If the "Different method for obtaining IP address / device name" option is used in a PROFINET 
device, note the following: 

● The subnet part of the IP address of the IO device must match the subnet part of the IP 
address of the IO controller.

● The corresponding PROFINET device cannot be used as a router.

See also
Starting the name assignment via "Accessible devices" (Page 998)
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Example of the assignment of the device name
In this example you assign device names to a PROFINET IO controller and a PROFINET IO 
device. To make assignment easier, the device names should also contain the names of the 
PROFINET IO system. 

Requirement
● You must be in the network view.

● A CPU 1214C (V2.0 or higher) must be available in the network view.

● An interface module IM 151-3PN exists.

● The PROFINET interfaces of both modules are networked.

Procedure         
To assign the names, follow these steps: 

1. Select the CPU.
Make sure that you have selected only the CPU and not the complete device! 

2. Assign the name "myController" in the Inspector window, under "General".

3. Select the interface module.
Ensure that you have selected only the interface module and not the complete ET 200S 
device.

4. Assign the name "Device_1" in the Inspector window, under "General".

5. Right-click on the PROFINET IO system and select the "Properties" command.
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6. Assign the name "Plant_section1" to the IO system and select the check box "Use name 
as extension for PROFINET device names".

7. You can find the automatically generated PROFINET device names at the selected device 
in the Inspector window, at "PROFINET interface".

The PROFINET device name corresponds to the name of the module (with the name of 
the IO system as extension) with the difference that only lower case text is used. 
Background: No distinction is made between upper and lower case ("case insensitive") for 
the storing of the name.
If you want to specify the device name independently of the module name, you have to 
deactivate the "Generate PROFINET device name automatically" option. The PROFINET 
device name can be edited in this case.
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The converted name is displayed below. This is the name that is automatically generated 
from the PROFINET device name and satisfies the DNS conventions. If you work with STEP 
7, you do not require this name. This name is displayed here as a check and corresponds 
to the name that is stored in the device. If you work with other tools that are able to record 
the data exchange and read the actual device names, then you find the converted names. 

Other special features
For PROFINET devices with multiple PROFINET interfaces, the name of the interface is 
attached to the name of the module, separated by a dot. 

Example: 

● Name of the module: myController

● Name of the interface: Interface_1

● PROFINET device name: mycontroller.interface_1

Assign device name via memory card

Introduction
You can configure the device names of PROFINET IO devices offline. To do this, store a 
configured device name on a memory card and then insert the card into the appropriate IO 
device. 

If an IO device has to be completely replaced due to a device defect, the IO controller 
automatically reconfigures the new device. Using the memory card, a device can be replaced 
without a programming device. 

Requirements
● The programming device has a card reader for memory cards.

● The IO device must support the assignment of the device name via memory card.

● The station and its PROFINET IO system is configured.

Procedure
To store a device name on a memory card, follow these steps:

1. Insert the memory card into the card reader.

2. Select the IO device whose device name is to be assigned by the memory card.

3. Select the "Card reader > Save Device Name to Memory Card" command in the "Project" 
menu.
If the memory card is not empty, a message will be issued informing you of this and you 
will have the option to delete the card.
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Retentivity of IP address parameters and device names
The retentivity of IP address parameters (IP address, subnet mask, router setting) and device 
name depends on how the address is assigned.           

The non-retentive, temporary assignment means:

● IP address parameters and device name remain valid for the following time period:

– Until the next POWER OFF

– Until the next bootstrap

– Until termination of the online connection (for example, after downloading the program)
After POWER OFF / POWER ON or a permanent deletion, the CPU can only be 
accessed via the MAC address.

If the IP address parameters are not retentive, communication can no longer take place after 
the above described events (for example, after POWER OFF/POWER ON) that are based on 
the IP protocol.

The assignment of a temporary IP address also deletes retentively saved IP address 
parameters.

IP address parameters and device name not assign retentively
IP address parameters and device name are not retentive in the following cases:

● A temporary IP address that is not retentive is implicitly assigned with the "Accessible 
devices" function, if the device (e.g. CPU) does not yet have an IP address.

● The device is a "normal" IO controller (i.e., not an I-device), and it is specified in the user 
program ("IP_Conf" instruction) that the IP address parameters/device name are not to be 
retentive.

Assign IP address parameters and device name retentively
IP address parameters and device name are retentive in the following cases: 

● In the properties of the PROFINET interface, it is specified that the IP address parameters 
are set in the project ("Set IP address in the project" option).

● The properties of the PROFINET interface have a setting specifying that the IP address is 
to be obtained by another method.

– Once the configuration is downloaded, the IP address parameters and the device name 
are assigned via STEP 7 or a setup tool such as PST (STEP 7: online and diagnostic 
function "Assign IP address"). The assigned IP address parameters are retentive.

– The device is a "normal" IO controller (i.e., not an I-device), and it is specified in the user 
program ("IP_Conf" instruction) that the IP address parameters/device name are to be 
retentive.
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Special features of the I-device
It is specified in the properties of the PROFINET interface of the I-device that the IP address 
parameters are to be obtained by a different method. The IP address parameters for the I-
device are assigned by the higher-level IO controller.

● If prioritized startup is set, the IP address parameters are retentive.

● If no prioritized startup is set, the IP address parameters are not retentive.

Recommendation
If possible, use the "Set IP address in project" and specify an appropriate IP address. In this 
case, the IP address is assigned retentively. 

Resetting the IP address parameters and device names 
Retentive IP address parameters and device names are reset via the online and diagnostic 
function "Reset to factory settings". 

 

 Note
Consequences of repeated assignment of IP address parameters on top of existing IP 
parameters
● Through the temporary assignment of IP address parameters / device names, a reset of 

retentively saved IP address parameters/device names occurs.
● With a fixed assignment of IP address parameters/device names, previously retentively 

saved parameters are replaced with the newly assigned parameters.
 

 Note
Reuse of devices 

Execute the "Reset to factory settings" before you install a device with retentive IP address 
parameters and device names in another subnet or system or before you place it in storage.

 

Creating a PROFINET IO system
A PROFINET IO system is comprised of a PROFINET IO controller and its assigned 
PROFINET IO devices. 

To create a PROFINET IO system you require an IO controller (for example, CPU 1214C) and 
one or more IO devices (for example, a head module from the distributed I/O family ET 200S). 

As soon as you connect an IO controller to an IO device, a controller-device link is established.
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Procedure  
To create a PROFINET IO system, proceed as follows:

1. Use drag-and-drop to pull an IO controller from the hardware catalog (for example, CPU 
1214C) into the free area of the network view.
The IO controller is created in the project.

2. Use drag-and-drop to move an IO device from the hardware catalog (for example, ET 200S) 
into the free area of the network view.

3. Click on the PROFINET interface of the IO controller or the IO device.

4. Hold down the mouse button and draw a connecting line between this selected interface 
and that of the partner device.
A subnet with an IO system between the IO controller and the IO device is created. 

5. If required, adapt the properties of the Ethernet subnet or the IO controller (for example, IP 
address) under "Properties" in the inspector window.

 

Handling PROFINET IO systems
Using shortcut menu commands, you can delete PROFINET IO systems, create new ones or 
even connect the interface to another subnet from within the network view. 

An existing PROFINET configuration can thereby be corrected in the network view. 

Create new PROFINET IO system for IO controller
To create a new PROFINET IO for an IO controller, proceed as follows: 

1. Make sure that no IO system is already assigned to the IO controller. If an IO system is 
already assigned to the IO controller, the "Assign IO system" shortcut menu command is 
disabled.

2. Select the PROFINET interface and then select the "Assign IO system" shortcut menu 
command.

A new PROFINET IO system is created at the IO controller and you can assign IO devices to 
this IO system. 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
810 System Manual, 07/2013,  



Disconnecting PROFINET IO devices from PROFINET IO system   
To disconnect an already networked PROFINET IO device from its PROFINET IO system, 
follow these steps:

1. Click on the PROFINET interface of an IO device.

2. Select the "Disconnect from IO system" shortcut menu command.
The IO device that was assigned to this IO system is then no longer assigned to it. 

You can create a new IO systems and can assign each of the non-assigned IO devices to an 
IO controller. 

Assign PROFINET IO devices to other IO controllers
Existing PROFINET IO systems can be easily reconfigured in the network view: 

1. Select the interface of an IO device and then select the shortcut menu. You have the 
following options here:

– Assign a new subnet to the IO device or disconnect it from the existing subnet

– Assign a new IO controller to the IO device

– Assign a new IO system to the IO device or disconnect it from the existing subnet

2. To assign another IO controller to the IO device, select the "Assign to new IO controller" 
shortcut menu command.
If there is no connection, a subnet is automatically created and the IO device is assigned 
to the IO system of the new IO controller. 

Tip: Quick configuration of IO systems
If the IO system has a lot of IO devices, assign all IO devices placed by drag-and-drop operation 
to an IO controller on one step.

Requirements   
IO controller and IO devices are placed in the network view.
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Assign IO devices to an IO system
To do this, follow these steps:

1. Select an appropriate zoom factor so that you can see as many IO devices as possible in 
the network view.

2. Arrange the IO devices in not more than of two rows.

3. Select all IO interfaces (not all devices) with the mouse cursor. This only works if you begin 
to drag the mouse cursor outside of the first IO device and release the mouse button at the 
last IO device (selection with the lasso).

4. Select the shortcut menu "Assign new IO controller" and select the corresponding IO 
interface of the IO controller in the subsequent dialog.

5. The IO devices are automatically networked with the IO controller and combine with it to 
form an IO system.

 

  Note

When an IO system is highlighted, you can double-click on an IO device in the hardware 
catalog and thereby quickly add additional IO devices. Result: The IO device is 
automatically added to the highlighted IO system.
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Interconnecting ports
If an IO device is assigned to an IO controller, this does not yet specify that the ports are 
connected to each other. 

Although a port interconnection is not required to use the PROFINET functions, it does offer 
the following advantages:

● A target topology is specified with the port interconnection. Based on an online-offline 
comparison, it is possible to conduct a target-actual comparison with all devices that support 
this function.

● Only with IRT communication: If a port interconnection is configured, STEP 7 can determine 
the required bandwidth more precisely. As a rule, this leads to a higher performance.

Make sure that no invalid ring structures occur through the interconnection of ports. 

Port interconnection is only advisable for devices that support the topology configuration. 

Interconnecting ports in the Inspector window  
To interconnect ports, follow these steps: 

1. Select the PROFINET device or the PROFINET interface.

2. Navigate to the port property "Port interconnection".
When the PROFINET interface is selected, you can find this setting in the Inspector window 
as follows: Properties > General > Advanced Options > Port [...] > Port Interconnection. 

3. In the "Local port" section, you can find the settings at the local port. In the case of fiber-
optic cable you can, for example, set the cable names here.
In the "Partner port" section, click on the black triangle in the "Partner port" box to display 
and select the available partner ports. 

4. If the port interconnection is a port interconnection with copper as medium and the devices 
support IRT communication, you can also set cable length and signal transit time.

If the PROFINET interface was not networked, it is automatically networked by this action. In 
the properties of the subnet you can set whether this subnet should or should not be used for 
the networking. 

See also
Overview (Page 516)

Setting the send clock

Requirements to change the send clock at the PROFINET device
No IRT (Isochronous Realtime) should be configured. In detail, this means: 

● No device must be configured at the IO system as a sync slave or sync master.

● All devices at the IO system must be unsynchronized.

If IRT is configured (in other words, if the IO controller is configured as sync master), the send 
clock can only be configured in the sync domain.
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Procedure
To set the send clock on the PROFINET device, follow these steps:

1. Select the PROFINET IO controller in the device or network view.

2. Change the value for the shortest possible update interval in the properties of the 
PROFINET interface under "PROFINET Interface > Advanced options > Real-time settings 
> IO communication > Send clock".

The send clock is valid for all PROFINET devices at the IO system. If the synchronization role 
is set to a value other than "Unsynchronized", you can only set the send clock in the sync 
domain, in other words, centrally at the PROFINET IO system. 

Setting the update time

Update time  
An IO device / IO controller in the PROFINET IO system is supplied with new data from the 
IO controller / IO device within this time period. The update time can be separately configured 
for each IO device and determines the time interval in which data is transmitted from the IO 
controller to the IO device (outputs) as well as data from the IO device to the IO controller 
(inputs).

STEP 7 calculates the update time automatically in the default setting for each IO device of 
the PROFINET IO system, taking into account the volume of data to be exchanged as well as 
the set send clock. 

Setting the update time
If you do not want to have the update time calculated automatically, you can change the setting.

To change the update time, proceed as follows:

1. Select the PROFINET interface of the IO device in the network or device view.

2. Change the update time in the interface properties under "Advanced options > Realtime 
settings > IO cycle".

– To have a suitable update time calculated automatically, select "Automatic".

– To set the update yourself, select "Can be set" and enter the required update time in 
ms.

3. To ensure consistency between the send clock and the update time, activate the "Adapt 
update time when send clock changes" option.
This option ensures that the update time is not set to less than the send clock. 

Non-automatic setting of the send clock may result in errors if the available bandwidth is 
insufficient or if other limits are exceeded (for example, too many devices are configured). 
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Setting the watchdog time

Watchdog time 
You can configure the watchdog time for PROFINET IO devices. 

If the IO device is not supplied with input or output data (IO data) by the IO controller within 
the watchdog time, it switches to the safe state. 

Do not enter the watchdog time directly, but as "Accepted number of update cycles when IO 
data is missing". This makes setting easier because the update time can be shorter or longer, 
depending on the power of the IO device or the setting. 

The resulting watchdog time is automatically calculated from the "Accepted number of update 
cycles when IO data is missing". 

Configuring the watchdog time
To specify the watchdog time, follow these steps:

1. Select the PROFINET interface of the IO device in the network or device view.

2. In the properties of the interface, navigate to "Advanced options > Realtime settings > IO 
cycle".

3. Select the required number of cycles from the drop-down list "Trigger watchdog after # 
cycles with missing IO data". 

The watchdog time is subsequently calculated automatically based on the preset factor. It must 
not be more than 1.92 seconds.

 

 Note

The default setting should only be changed in exceptional cases, for example, during the 
commissioning phase.

 

Calculated bandwidth for cyclic IO data

Calculated bandwidth for cyclic IO data
Adherence to the maximum available bandwidth for cyclic IO data is monitored by the system. 
The maximum bandwidth depends on the send clock cycle. If the send clock cycle is greater 
than or equal to 1 ms, the maximum bandwidth is 0.5 ms. If the send clock cycle is shorter, 
the maximum available bandwidth is also reduced.

The bandwidth actually required for cyclic IO data is determined by the system based on the 
number of configured IO devices and IO modules. Furthermore, the required bandwidth 
depends on the update time that is used.

In general, the calculated bandwidth increases in the following cases:
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● There is a greater number of IO devices

● There is a greater number of IO modules

● The update times are shorter.

Maximum bandwidth for cyclic IO data depending on the send clock
The following table shows how the maximum available bandwidth for cyclic IO data reacts 
based on the send clock:

Send clock cycle Maximum bandwidth for cyclic IO data
250 µs – 468.75 µs << 125 µs
500 µs – 968.75 µs = send clock / 2
1 – 4 ms = 500 µs

Setting port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.

Possible settings for transmission medium/duplex       
Depending on the selected device, you can make the following settings for "Transmission 
medium/duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the partner port. The "Enable autonegotiation" option is automatically 
selected by default.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.
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"Monitor" option     
This option is used to activate or deactivate the port diagnostics. Examples of port diagnostics: 
The link status is monitored, in other words, the diagnostics are generated during link-down 
and the system reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "     
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.

You must make sure the partner port has the same settings because, with this option, the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can therefore not be optimally set.

 

 Note

When a local port is interconnected, STEP 7 makes the setting for the partner port if the 
partner port supports the setting. If the partner port does not support the setting, an error 
message is generated. 

 

Wiring rules for disabled autonegotiation

Requirement
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission speed

● Autonegotiation incl. autocrossing disabled

This saves you the time required to negotiate the transmission rate during startup.

If you have disabled autonegotiation, you must observe the wiring rules.
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Wiring rules for disabled autonegotiation         
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.

Rules for cabling
You can connect several IO devices in a line using a patch cable (one-to-one wiring of both 
connectors). To do this, you connect port 2 (P2) of the IO device to port 1 (P1) of the next IO 
device. The following graphic gives an example with two IO devices.

Boundaries at the port

Requirement
To use boundaries, the respective device must have more than one port. If the PROFINET 
does not support boundary settings, they are not shown. 
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Enable boundaries        
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of discovery of accessible devices"
No forwarding of DCP frames to identify accessible devices. Devices downstream from this 
port cannot be reached by the project tree under "Accessible devices". Devices downstream 
from this port cannot be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) are not forwarded for topology detection.

● "End of sync domain"
No forwarding of sync frames transmitted to synchronize nodes within a sync domain. 
If you operate, for example, a PROFINET device with more than two ports in a ring, you 
should prevent the sync frame from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device from the other sync domain. 

Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been determined for the port, the following check boxes cannot be 
used:

– "End of discovery of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

Enabling device replacement without exchangeable medium

Replacing an IO device without exchangeable medium    
Replacement of IO devices is frequently required in automation systems. The IO devices are 
generally assigned a device name by either inserting an exchangeable medium or via the 
programming device. The CPU identifies the IO device by using these device names.

Replacing an IO device can be done without inserting an exchangeable medium (e.g. memory 
card) or without the programming device, under certain circumstances. For this purpose the 
Ethernet mechanism analyzes the relationship between the individual IO devices and the IO 
controller. From these relationships which are stored in the IO controller, the IO controller 
recognizes which IO device was replaced and assigns a device name to the new device.
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Requirements
● A port interconnection is already configured.

● The affected IO devices in the automation system must support device replacement without 
exchangeable medium.
If the individual IO devices in the automation system do not support device replacement 
without exchangeable medium, a corresponding message is output for the IO device.

 

  Note

Use only new IO devices as replacements or restore configured IO devices to their delivery 
state.

 

Procedure
In order to enable the replacement of an IO device without exchangeable medium, proceed 
as follows:

1. In the device, select the device or network view of the PROFINET interface in the 
corresponding IO controller.

2. In the interface properties under "Advanced settings > Interface options", select the "Allow 
device replacement without exchangeable medium"

See also
Components with the the device replacement without exchangeable medium function (http://
support.automation.siemens.com/WW/view/en/36752540)

Using GSD files

GSD files for IO devices

Basic information on GSD files of IO devices       
The properties of PROFINET IO devices are not stored in a keyword-based text file (as for 
PROFIBUS DP slaves), but in an XML file whose structure and rules are determined by a 
GSDML schema.

The language used to describe the GSD files is GSDML (Generic Station Description Markup 
Language). It is defined by the GSDML schema.

A GSDML schema contains validation rules that allow it, for example, to check the syntax of 
a GSD file. GSDML schemas (as schema files) are acquired by IO device manufacturers from 
PROFIBUS International.

Functional enhancements in the area of PROFINET IO will have an effect on the GSDML 
specification and the corresponding schema. A new version of the specification and of the 
schema is created by the functional enhancement.
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Names of GSD files for IO devices
One possible example of a GSD file name for IO devices is:

"GSDML-V1.0-Siemens-ET200S-20030616.xml"

Name component Explanation
GSDML String at the start of each GSD file for IO devices
V1.0 Version of the GSDML schema
Siemens Manufacturer
ET200S Name of the device
20030616 Version code (date)
.xml File extension

Versioning of GSD files for IO devices
The version information of GSD files is two-fold: 

First, the version of the GSDML schema is indicated. This determines the language scope 
used by a GSD file. 

This is followed by the version, listed as an issue date. The version number of GSD files is 
incremented, for example, after elimination of an error or introduction of a functional 
enhancement. 

Functional enhancements may result in a new version of the GSDML schema. A new version 
of a GSDML schema might only be supported with restrictions.

Installing the GSD file

Introduction
A GSD file (generic station description file) contains all properties of an IO device. If you want 
to configure an IO device that is not available in the hardware catalog, you must install the 
GSD file provided by the manufacturer. IO devices installed via GSD files are displayed in the 
hardware catalog and can then be selected and configured.

Requirement
● The hardware and network editor is closed.

● You have access to the required GSD files in a directory on the hard disk.

Procedure       
To install a GSD file, follow these steps:

1. In the "Options" menu, select the "Install generic station description files" command.

2. In the "Install generic station description files" dialog box, select the folder in which the GSD 
files are stored.
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3. Choose one or more files from the list of displayed GSD files.

4. Click on the "Install" button.

5. To create a log file for the installation, click on the "Save log file" button.
Any problems during the installation can be tracked down using the log file.

You will find the new IO devices installed by means of GSD files in the hardware catalog under 
"Additional field devices > PROFINET".

 

 Note

Installation of a GSD file cannot be undone.
 

Changing the revision of a GSD file

Changing the revision of a GSD file   
You can change the revision of a GSD file for an IO device:

● Only for the current IO device

● All suitable IO devices within the IO system

● All suitable IO devices within the complete project

First, all existing GSD files for the current IO device are shown. The only difference between 
the GSD files shown is their revision status. The currently used GSD file is highlighted.

Requirement
● The I/O data is the same for all IO devices whose revision is to be changed.

● The order number has not changed.

● The number of submodules is identical.

● The configuration data has not changed.

● There must be no module or submodule in a slot that is invalid after the new GSD file has 
been created.

Procedure
To change the revision of one or more IO devices, proceed as follows:

1. Select the IO device whose GSD file revision is to be changed.

2. Click on the "Change revision" button under "General> Catalog information" in the 
properties of the IO device.
The "Change revision" dialog box opens.

3. Select the GSD revision you want to use in the "Available revisions" table.
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4. Under "Use selected revision for", select the devices whose version are to be changed:

– Only for the current IO device

– For all suitable IO devices in the IO system

– For all suitable IO devices in the project

5. Click the "Apply" button.

8.1.4.9 Bus coupling with PN/PN coupler

Application and function

Application  
The PN/PN coupler is used to link two Ethernet subnets with one another and to exchange 
data. That way use data about input or output address areas or datasets can be used. The 
maximum size of the transferable input and output data is 1024 bytes. The division into input 
and output data is preferable, so that e.g. 800 byte input data and 200 byte output data can 
be configured.

As a device, the PN/PN coupler has two PROFINET interfaces, each of which is linked to one 
subnet.

In the configuration, two IO Devices are produced from this one PN/PN coupler which means 
that there is one IO Device for each station with its own subnet. The other part of PN/PN coupler 
in each case is known as the bus node. Once configuring is complete, the two parts are joined.

 

Figure 8-2 Coupling two PROFINET IO subnets with one PN/PN coupler

Additional information
For additional information on "PN/PN couplers", refer to Service & Support on the Internet 
(http://support.automation.siemens.com/WW/view/en/44319532).
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Linking Ethernet subnets

Linking Ethernet subnets with a PN/PN coupler
You can link Ethernet subnets with the standard device PN/PN coupler.  

To link Ethernet subnets, follow these steps:

1. Create your Ethernet subnets.

2. Select the standard field devices in the hardware catalog. Find the PN/PN coupler as head 
module in the "PROFINET IO" folder.

3. In the network view, drag the two components X1 and X2 to the required version of the PN/
PN coupler per drag-and-drop operation. The components form a device, but are shown 
separately to make handling easier.

4. Connect the Ethernet interface of the PN/PN coupler X1 to the first Ethernet subnet.

5. Connect the Ethernet interface of the PN/PN coupler X2 to the second Ethernet subnet.
The Ethernet subnets are now linked through the two components of the PN/PN coupler.

8.1.4.10 Integrating external tools

Integrating S7-external tools

Introduction
Tools external to STEP 7 ("Device Tools") with a special call interface (Tool Calling Interface) 
can be used to configure distributed devices. Such devices are also referred to as "TCI 
capable". 

The performance range of these tools exceeds the possibilities provided within GSD 
configuration, for example, they can provide expanded graphical input options.       

Distributed devices can be as follows:
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● PROFIBUS DP slaves

● Modules within a DP slave

● PROFINET IO devices

● Modules within an IO device
 

 Note
Warranty and liability

Siemens accepts no liability for third-party software (device tools) called with the TCI (Tool 
Calling Interface) or for proper interaction with the associated devices. 

 

Requirement
The call interface of the tool complies with the TCI specification. Parameters and commands 
are forwarded to the distributed device via this call interface. 

Such tools have to be installed using a setup provided by the manufacturer. The "S7-PCT" 
(Port Configuration Tool) device tool for IO-Link master modules and IO-Link devices is an 
exception; this is supplied with STEP 7. Special note: After the installation, the tool is not shown 
in the list of installed software or in the list of software products in the project. 

The GSD file of the distributed device that is to be configured with the Device Tool must be 
installed. 

Starting the device tool
The command for starting the device tool is available in the shortcut menu of the TCI-capable 
device in the shortcut menu of the graphical and tabular device view: "Start device tool".

See also
Starting the SIMATIC S7-PCT (Page 825)

Starting the SIMATIC S7-PCT

Introduction   
The "S7-PCT" (Port Configuration Tool) device tool is installed with STEP 7.

The tool is used to assign parameters to the ports of IO-Link modules such as 4SI IO-Link 
(S7-1200, ET 200S) or 4IOL+8DI+4DO (ET 200eco PN). 

Requirement
You have configured the corresponding CPU, the DP slave or the IO device with an IO-Link 
module.
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Procedure
To start via the graphical device view, follow these steps:

1. Select the IO-Link module in the device view.

2. Select "Start device tool" from the shortcut menu.

OR, to start with the tabular device view, follow these steps:

1. Select the IO-Link module in the device view.

2. Arrange the areas in the work area in such a way that the tabular device overview is visible 
(it is located between the device view and the inspector window).

3. Select the row with the IO-Link module in the device overview.

4. Select "Start device tool" from the shortcut menu.

Result
The tool starts and you can configure the ports. 

See also
Integrating S7-external tools (Page 824)

8.1.4.11 Loading a configuration

Introduction to loading a configuration
To start a device, identical configurations must be stored on the PG/PC as well as on the 
connected devices. Download a configuration to compare the PG/Pc and the connected 
devices. Configuration data can generally be downloaded in two directions:

● Download configuration from PG/PC in a device

● Download configuration from a device to the PG/PC

See also
Uploading project data from a device (Page 284)

General information on loading (Page 281)

Downloading a configuration to a device (Page 827)

Downloading project data to a device (Page 282)

Downloading a configuration to the PG/PC (Page 828)

Special features during startup (Page 839)
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Downloading a configuration to a device

Downloading the hardware configuration         
After you have inserted a new device in the project and configured it or if you have modified 
an existing hardware configuration, the next step is to load the current configuration on the 
device. This makes sure that the same configuration is set on the programming device/PC as 
well as on the physical module.

The first time you load, the entire hardware project data is loaded. When you load again later, 
only changes to the configuration are loaded.

You have the following options when loading the hardware configuration:

● Loading in the device or network view

● Loading in the project tree

● Loading on an accessible device
 

 WARNING

Load only in STOP mode

After loading, you may experience unexpected behaviors on the machine or in the process 
if the parameter settings are incorrect. The CPU must be set to STOP mode for the download 
operation to rule out possible damage to equipment or personal injury.

 

 

Special features for downloading of isochronous applications
Isochronous applications consist of a hardware configuration part and a software part. 

Example: If you change the number of an IO system, the delay time, or the process image 
partition assignment of the isochronous I/O in the hardware configuration, this affects the 
parameters of the isochronous mode interrupt OB and thus also the software part. 

For isochronous applications, we recommend performing a complete download (hardware and 
software). With partial downloading (downloading hardware and software separately at 
different times), inconsistencies can arise that, for example, can prevent CPU startup or 
isochronous operation of the application. 

See also
General information on loading (Page 281)

Downloading project data to a device (Page 282)
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Downloading a configuration to the PG/PC

Introduction  
If you have connected a new device to a PG/PC but have not yet inserted the device into the 
project, you can transfer the complete configuration from the newly connected device to the 
PG/PC. The device is thereby created in the project.

A device is always downloaded via the list of accessible devices in the project tree. You can 
download several devices into the project by selecting them accordingly. A configuration can 
be downloaded several times. A new device is created on each download, even if the device 
has already been downloaded.

Requirements
● The original hardware configuration must be created in TIA Portal V12 or higher. A project 

with an older version than the current one may have to be upgraded (Page 262).

● The opened project is in offline mode.

Scope of download
The following list presents an exact overview of the parts of the configuration that are 
transferred:

● Device parameters
All set parameters of the module are transferred.

● PROFIBUS master systems and all PROFIBUS-relevant settings
A DP master system and all connected slaves are inserted into the project. The respective 
settings remain unchanged. If a suitable PROFIBUS subnet has already been created, the 
downloaded modules are connected to the PROFIBUS interface at the existing subnet.

● PROFINET IO systems and all PROFINET-relevant settings
The devices with IO controllers, all IO systems as well as all IO devices are transferred into 
the project. Settings and topologies are also transferred.
If there already is a suitable Ethernet network in the project, the downloaded devices are 
integrated into the existing network.
Relations between IO controllers and IO devices are only established within the project if 
both the IO controller as well as the I-device are downloaded to the PG. It is unimportant 
whether you download the IO controller or the I-devices first.

● I devices and I slaves
Master-slave relations between the I slave and assigned DP master are only established 
in the project if both the master as well as the I slave are downloaded to the PG. It is 
unimportant whether you download the master system or the I-devices and I slaves first. 
As soon as both devices are downloaded, the connections are also established.

● Direct data exchange
The configuration of a direct data exchange between two devices can also be downloaded 
into the project. You must download both partners one after the other to do this.
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● S7 connections
S7 connections are automatically accepted as configured at one end when downloading a 
device configuration, even if the S7 connection was configured at both ends in the original 
project. Once both connection partners are downloaded, the connection is once again 
linked together during the next compiling procedure.

● Bus parameter
Downloaded bus parameters initially differ from the settings in the original project after 
downloading a single device. The bus parameters only match those of the original project 
after all devices involved are downloaded and there are no additional devices on the same 
bus.

● An I/O module associated with the CPU 
After downloading a CPU, all other modules within the address area of the CPU are also 
downloaded.

See also
Uploading project data from a device (Page 284)

General information on loading (Page 281)

8.1.5 Displaying alarms

8.1.5.1 Overview of the alarm display
The "Alarm display" function can be used to output asynchronous alarms of diagnostics events 
and user-defined diagnostics alarms as well a alarms from ALARM instructions.

From the alarm display, you can also start the alarm editor with the "Edit alarm" shortcut menu 
command and then create user diagnostic alarms.

Icons     
The following table shows the icons and their functions:

Icon Function

Archive view

Shows the alarms located in the archive. 

Active alarms

Shows the currently active (pending) alarms. 
Alarms that must be acknowledged are shown in 
blue lettering. 

Ignore

Ignores the arrival of alarms, These alarms are 
neither shown in the window nor stored in the 
archive. 

Acknowledge

Confirms the selected alarm as read. Alarms 
requiring acknowledgment are shown in blue 
lettering. 
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Icon Function

Clear archive

Deletes all alarms in the archive. 

Export archive

Exports the current alarm archive to a file in xml 
format. 

8.1.5.2 Archive view
In the archive view, alarms are displayed and archived according to the time they appear. You 
can set the size of the archive (between 200 and 3000 alarms) with the menu command 
"Options > Settings > Online & Diagnostics". If the selected archive size is exceeded, the oldest 
alarm it contains is deleted. 

Alarms that must be acknowledged are displayed in blue lettering and can be acknowledged 
with the shortcut menu command "Acknowledge alarm(s)".

The archive is constantly updated and does not need to be saved explicitly.

 

8.1.5.3 Layout of the alarms in the archive view
In the archive view, all events occurring on the selected CPUs are logged. A new entry is 
created for each individual event and shown as a further row in the table. 

Table structure
All attributes of the alarms can be shown as columns. You can show or hide individual columns 
as well as modify the width and order of the columns. These settings are saved when the 
project is closed. 

The alarms can be displayed in one or more rows. In the single row display, only the first row 
of the multiple-row alarm data is displayed. 

The alarms either require acknowledgment or do not require acknowledgment. The alarms 
requiring acknowledgment that have not yet been acknowledged are highlighted in blue 
lettering and can be acknowledged either with the button in the toolbar for the particular context 
or with the shortcut menu command "Acknowledge alarm(s)".

8.1.5.4 Receiving alarms
To allow alarms to be displayed, you must first set the receipt of alarms for each CPU. 
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Procedure
Toe receive alarms, follow these steps: 

1. Double-click on the "Online & Diagnostics" folder of the relevant CPU in project navigation.

2. Click the "Online access" group in the area navigation.

3. Select the option "Receive alarms".
 

  Note
If you select this procedure, alarms are only received after you have re-established an 
online connection to the device.

 
 

Or: 

1. Select the relevant CPU in the device, network, or topology view.

2. Select the command "Receive alarms" in the "Online" menu or in the shortcut menu.

Or: 

1. Select the CPU in project navigation.

2. Select the command "Receive alarms" in the "Online" menu or in the shortcut menu.
 

  Note
If you select one of the two above-named procedures, you must have first established an 
online connection to the device.

 
 

8.1.5.5 Export archive
To archive alarms, you can export the archive. Follow these steps:

1. Go to the archive view.

2. Click the "Export archive" button.

3. In the dialog that opens, select the path to export the archive.

Result
The archive is saved as an xml file at the location you selected.

8.1.5.6 Clear archive
The archive is organized as a ring buffer, in other words, when it is full, the oldest alarms are 
deleted from the archive. With the "Clear archive" button, you can delete the entire archive.
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Procedure
To clear the archive, follow these steps:

1. Click the "Clear archive" button in the toolbar of the alarm display.

8.1.5.7 "Active alarms" view
The "Active alarms" view is an image of the alarm acknowledgement memory of the selected 
CPU(s). 

8.1.5.8 Layout of the alarms in the "Active alarms" view
The "Active alarms" view represents an image of the alarm acknowledgment memory of the 
selected CPUs. One entry is shown in the table per active alarm. Events of an alarm 
("incoming", "outgoing" and "acknowledged") are displayed in one row.  

Table structure 
All attributes of the alarms can be shown as columns. You can show or hide individual columns 
as well as modify the width and order of the columns. These settings are saved when the 
project is closed.

The alarms can be displayed in one or more rows. In the single row display, only the first row 
of the multiple-row alarm data is displayed. 

The alarms either require acknowledgment or do not require acknowledgment. The alarms 
requiring acknowledgment that have not yet been acknowledged are highlighted in bold print 
and can be acknowledged either with the button in the toolbar for the specific context or with 
the shortcut menu command "Acknowledge alarm(s)". 

8.1.5.9 Status of the alarms
Depending on whether you are in the "Active alarms" view or the archive view, the displayed 
alarms may have a different status.

Status of the alarms in the "Active alarms" view
● I: Alarm came

● IA: Alarm came and was acknowledged

● IO: Alarm has gone

If more signal changes occur than can be sent (signal overflow), OV is displayed as the status 
and the status is shown in red. 

Status of the alarms in the archive view
● No information: only with alarms generated by the PG/PC and displayed in the "Archive" 

tab, for example logon status, connection abort, mode changes

● I: Alarm came
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● A: Alarm came and was acknowledged

● O Alarm has gone

● D: The alarm was deleted.

If more signal changes occur than can be sent (signal overflow), OV is displayed as the status 
and the status is shown in red.

8.1.5.10 Acknowledging alarms
Alarms that must be acknowledged are shown in blue lettering.

Procedure  
To acknowledge an alarm, follow these steps:

1. Select the required alarm or alarms from the table.

2. Click the "Acknowledge" button.
 

  Note

You can select more than one alarm to acknowledge at the same time. To do this, hold 
down the <Ctrl> key and then select the alarms you want to acknowledge.

 

Result
The selected alarm was acknowledged and is then shown in normal characters. 

 

 Note

In the "Active alarms" view, acknowledged alarms that have already gone are no longer 
displayed. 

 

 

8.1.5.11 Ignoring alarms

Ignoring alarms 
To ignore alarms, follow these steps:

1. Click the "Ignore" button.
The icon is shown on a gray background.

Result
From this point onwards, all alarms will be ignored. A message is created in the archive view 
indicating that the display of alarms and events is disabled.
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Canceling the ignoring of alarms
To cancel the ignoring of alarms, follow these steps:

1. Click the "Ignore" button.
The icon is shown on a white background.

Result
All alarms, in other words, even the alarms currently pending on the CPU while the "Ignore 
alarms" function was active, are displayed again from this point onwards. A message is created 
in the archive view indicating that the display of alarms and events is enabled again.

 

8.1.5.12 Keyboard commands in the alarm display

Alarm display 

Function Shortcut keys
Select all alarms Ctrl+A
Acknowledge all selected alarms Ctrl+Q

8.1.6 Additional information on configurations

8.1.6.1 Functional description of S7-1200 CPUs

Operating modes

Principles of the operating modes of S7-CPUs

Introduction  
Operating modes describe the behavior of the CPU. The following operating modes are 
possible:

● STARTUP

● RUN

● STOP

In these operating modes, the CPU can communicate via the PN/IE interface, for example.
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Other operating modes
If the CPU is not ready for operation, it is in one of following two operating modes:

● Deenergized, i.e. the supply voltage is switched off.

● Defective, which means an internal error has occurred.
If the "Defective" status is caused by a firmware error, this state is indicated by the status 
LEDs of the CPU (refer to the description of the CPU). To find out the cause, follow these 
steps:

– Turn the power supply switch off and on again.

– Read out the diagnostics buffer when the CPU starts up and send the data for analysis 
to Customer Support.

If the CPU does not start up, replace it.

See also
STOP mode (Page 840)

RUN mode (Page 840)

Operating mode transitions

Overview  
The following figure shows the operating modes and the operating mode transitions of S7-1200 
CPUs:

The following table shows the conditions under which the operating modes will change:

No. Operating mode transition Conditions
① POWER ON → STARTUP After switching on, the CPU goes to "STARTUP" mode if:

● "Warm restart" startup type is set, and
● the hardware configuration and the program blocks are consistent.
Non-retentive memory is cleared and the contents of non-retentive DBs are reset 
to the initial values of the load memory. Retentive memory and retentive DB contents 
are retained.

② POWER ON → STOP When startup type "No startup" is set, the CPU goes to "STOP" mode after the supply 
voltage is switched on.
Non-retentive memory is cleared and the contents of non-retentive DBs are reset 
to the initial values of the load memory. Retentive memory and retentive DB contents 
are retained.
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No. Operating mode transition Conditions
③ STOP → STARTUP The CPU switches to "STARTUP" mode if:

● CPU is set to "RUN" from the programming device, and
● the hardware configuration and the program blocks are consistent.

④ STARTUP → STOP The CPU returns to the "STOP" mode in the following situations:
● Error detected during startup.
● The CPU is set to "STOP" from the programming device.
● A STOP command is processed in the STARTUP OB.

⑤ STARTUP → RUN If the STARTUP is successful, the CPU switches to "RUN".
⑥ RUN → STOP The CPU returns to the "STOP" mode in the following situations:

● An error is detected that prevents continued processing.
● The CPU is set to "STOP" from the programming device.
● A STOP command is processed in the user program.

"STARTUP" operating mode

Principles of the STARTUP mode

Function   
After turning on the CPU, it executes a startup program before starting to execute the cyclic 
user program. 

By suitably programming startup OBs, you can specify certain initialization variables for your 
cyclic program in the startup program. There is no rule in terms of the number of startup OBs. 
That is, you can set up one or several startup OBs in your program, or none at all.

Parameter settings for startup characteristics
You can specify whether the CPU remains in STOP mode or whether a warm restart is run. 
Over and above this, you can set the response during startup (RUN or previous mode) in the 
"Startup" group of the CPU properties.

Special characteristics
Note the following points regarding the "STARTUP" mode:

● The startup OBs are executed. All startup OBs you have programmed are executed, 
regardless of the selected startup mode.

● No time-based program execution can be performed.

● Interrupt controlled program execution limited to:

– OB 82 (diagnostics interrupt)

● The outputs on the modules are disabled.

● The process image is not updated; direct I/O access to inputs is possible.
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See also
Editing properties and parameters (Page 428)

Principles of the operating modes of S7-CPUs (Page 834)

Organization blocks for startup (Page 883)

Warm restart (Page 837)

Warm restart

Function
During a warm restart, all non-retentive bit memory is deleted and non-retentive DB contents 
are reset to the initial values from load memory. Retentive bit memory and retentive DB 
contents are retained. 

Program execution begins at the call of the first startup OB.

Triggering a warm restart   
You can trigger a "Warm restart" using a corresponding menu command on your programming 
device in the following situations:

● The CPU must be in "STOP" mode.

● After a memory reset

● After downloading a consistent program and a consistent hardware configuration in the 
"STOP" mode of the CPU.

"POWER ON" triggers a "warm restart" if you have set the following parameters for the startup 
response:

● Startup type "warm restart - RUN" (regardless of the CPU operating mode prior to POWER 
OFF).

● "Warm restart - mode prior to POWER OFF" (depending on the CPU operating mode prior 
to POWER OFF. The CPU must have been in RUN mode prior to this.)

See also
Retentive memory areas (Page 845)
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Startup activities

Overview  
The following table shows which activities the CPU performs at STARTUP:

Activities in execution sequence At warm restart
Clear non-retentive bit memories Yes
Clear all bit memories No
Clear the process image output Yes
Processing startup OBs Yes
Update the process image input Yes
Enable outputs after changing to "RUN" mode Yes

Sequence
The following figure shows the activities of the CPU in "STOP", "STARTUP", and "RUN" modes.

You can use the following measures to specify the state of the I/O outputs in the first cycle of 
the user program:

● Use assignable output modules to be able to output substitute values or to retain the last 
value.

● Set default values for outputs in startup OBs.

During the startup, all interrupt events are entered in a queue so that they can be processed 
later during RUN mode. In RUN mode, hardware interrupts can be processed at any time.
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Special features during startup

Response when expected and actual configurations do not match 
The expected configuration is represented by the engineering configuration loaded on the 
CPU. The actual configuration is the actual configuration of the automation system. 

If the expected configuration and actual configuration differ, the CPU nevertheless initially 
changes to RUN.

Canceling a STARTUP
If errors occur during startup, the startup is canceled and the CPU remains in "STOP" mode. 

Under the following conditions, a startup will not be performed or will be canceled:

● If an invalid SD card is inserted.

● If no hardware configuration has been downloaded.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  839



See also
Overview of the CPU properties (Page 856)

RUN mode

Function   
In "RUN" mode the cyclic, time-driven, and interrupt-driven program sections execute:

● The process image output is read out.

● The process image input table is read.

● The user program is executed.

Active data exchange between S7-1200 CPUs by means of Open User Communication is only 
possible in "RUN" mode.

Running the user program
Once the CPU has read the inputs, the cyclic program runs from the first to the last instruction. 

If you have configured a minimum cycle time, the CPU will not end the cycle until this minimum 
cycle time is up even if the user program is completed sooner. 

A maximum cycle time is set which you can adjust according to your requirements. This 
ensures that the cyclic program is completed within a specified time. The system will respond 
with a time error if the cyclic program is not completed within this time. 

Other events such as hardware and diagnostic interrupts can interrupt the cyclic program flow 
and prolong the cycle time. 

See also
Principles of the operating modes of S7-CPUs (Page 834)

Events and OBs (Page 848)

STOP mode

Function   
In "STOP" mode, the user program is not executed. All outputs are disabled or react according 
to the parameter settings: They provide a substitute value as set in the parameters or retain 
the last value output and bring the controlled process to a safe status. 

The CPU checks the following points:

● Hardware, for example whether are all modules are available

● Whether the default settings for the CPU are applicable or parameter sets are present

● Whether the general conditions for the programmed startup behavior are correct
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See also
Principles of the operating modes of S7-CPUs (Page 834)

Basics of a memory reset

Function 
A memory reset on the CPU is possible only in STOP mode.

When memory is reset, the CPU is changed to an "initial status". This means:

● The content of the work memory and the retentive and non-retentive data are deleted.

● The load memory (code and data blocks) is then copied to work memory. As a result, the 
DBs no longer have current values but their initial values.

● An existing online connection between your programming device/PC and the CPU is 
terminated.

● The diagnostics buffer, the time, the IP address, the hardware configuration and active 
force jobs are retained.

 

Memory areas

Useful information on memory cards

How the memory card functions       
The SIMATIC Memory Card for a S7-1200 is an SD memory card preformatted by Siemens 
for the CPU user program. 

You may only delete files and folders. If you format the memory card with Windows, for example 
with a commercially available card reader, you make the memory card unusable as a storage 
medium for an S7 CPU.

Setting the card type   
You can use the memory card as a transfer card, a program card or a firmware update card.
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To set the card type, insert the memory card into the card reader of the programming device 
and select the "Card reader/USB memory" folder from the project navigation. In the properties 
of the selected memory card, designate the card type:

● Program
If it is used as a program card, you can load the user program on the memory card. In this 
case, the internal load memory of the device is replaced by the memory card and the internal 
load memory is erased. The user program is then fully executable from the memory card. 
If the memory card with the user program is removed, there is no longer a program available.

● Transfer
If it is used as a transfer card, you can transfer the user program from the memory card to 
the internal load memory of the CPU. You can then remove the memory card again. 

● Firmware card
Firmware for the S7-1200 modules can be stored on a memory card. Therefore it is possible 
to perform a firmware update with the help of a specifically prepared memory card. Likewise, 
a backup copy of firmware for a module can be stored on a memory card.

Transferring objects from the project to a memory card
When the memory card is inserted in the programming device or in an external card reader, 
you can transfer the following objects from the project tree to the memory card: 

● Individual blocks (multiple selection possible)
In this case a consistent transfer is available, as the dependencies of the blocks to each 
other is taken into account with block selection. 

● PLC
In this case, all objects relevant to processing are transferred, such as blocks and the 
hardware configuration on the memory card, just as with downloading.

To perform the transfer, you can move the objects with drag-and-drop or use the command 
"Card reader/USB memory > Write to memory card" in the "Project" menu. 

Transferring objects from the memory card to the project
You can transfer Individual blocks (multiple selection is possible) by dragging them to the 
project. A hardware configuration cannot be transferred from the memory card to the project.

Updating firmware with a memory card
You can get the latest firmware data on the Internet from the Service & Support pages: 

http://support.automation.siemens.com (http://support.automation.siemens.com/WW/view/en/
34143537)

Save the firmware files on the hard disk and plug the SIMATIC Memory Card into the card 
reader of your programming device.

To store the file on the memory card, select the memory card in the "Card Reader/USB 
memory" folder in the project navigation. Select the shortcut menu "Card Reader/USB memory 
> Create firmware update memory card". 

Then follow the instructions in the Service & Support portal for performing a firmware update 
with your CPU.
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Updating the firmware changes the CPU firmware status. If you have used the CPU in the 
project, you will have to update the CPU already configured to the CPU with the new firmware 
status by changing devices offline, and adapt and then load the program or configuration. 

See also
Replacing a hardware component (Page 427)

Useful information on CPU firmware versions and STEP 7 versions (Page 905)

Load memory

Function    
Each CPU has an internal load memory. The size of this internal load memory depends on the 
CPU used. 

This internal load memory can be replaced by using external memory cards. If there is no 
memory card inserted, the CPU uses the internal load memory; if a memory card is inserted, 
the CPU uses the memory card as load memory. 

The size of the usable external load memory cannot, however, be greater than the internal 
load memory even if the inserted SD card has more free space. 

See also
Using memory cards (Page 335)

Work memory

Function    
Work memory is a non-retentive memory area for storing elements of the user program that 
are relevant for program execution. The user program is executed exclusively in work memory 
and system memory.

System memory

System memory areas

Function                         
System memory contains the memory elements that each CPU makes available to the user 
program, such as the process image and bit memory. 

By using appropriate operations in your user program, you address the data directly in the 
relevant operand area. 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  843



The following table shows the operand areas of the system memory:

Operand area Description Access via units of the following size: S7 notation
Process image output The CPU writes the values 

from the process image 
output table to the output 
modules at the start of the 
cycle.

Output (bit) Q
Output byte QB
Output word QW
Output double word QD

Process image input The CPU reads the inputs 
from the input modules and 
saves the values to the 
process image input table at 
the start of the cycle.

Input (bit) I
Input byte IB
Input word IW
Input double word ID

Bit memory This area provides storage 
for intermediate results 
calculated in the program.

Bit memory (bit) M
Memory byte MB
Memory word MW
Memory double word MD

Data block Data blocks store 
information for the program. 
They can either be defined 
so that all code blocks can 
access them (global DBs) or 
assigned to a specific FB or 
SFB (instance DB).
Requirement: The block 
attribute "Optimized block 
access" is not enabled.

Data bit DBX
Data byte DBB
Data word DBW
Data double word DBD

Local data This area contains the 
temporary data of a block 
while the block is being 
processed. 
Requirement: The block 
attribute "Optimized block 
access" is not enabled.
Recommendation: Access 
local data (temp) 
symbolically.

Local data bit L
Local data byte LB
Local data word LW
Local data double word LD

I/O input area The I/O input and output 
areas permit direct access to 
central and distributed input 
and output modules.

I/O input bit <tag>:P
I/O input byte
I/O input word
I/O input double word

I/O output area I/O output bit
I/O output byte
I/O output word
I/O output double word
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See also
Diagnostics buffer (Page 847)

Basic principles of process images (Page 845)

Access to the I/O addresses (Page 848)

Retentive memory areas

Retentive memory areas   
Data loss after power failure can be avoided by marking certain data as retentive. This data is 
stored in a retentive memory area. A retentive memory area is an area that retains its content 
following a warm restart, in other words, after cycling the power when the CPU changes from 
STOP to RUN. 

The following data can be assigned retentivity:

● Bit memory: The precise width of the memory can be defined for bit memory in the PLC tag 
table or in the assignment list.

● Tags of a function block (FB): You can define individual tags as retentive in the interface 
of an FB if you have enabled optimized block access. Retentivity settings can be defined 
only in the assigned instance data block if optimized block access has not been activated 
for the FB.

● Tags of a global data block: You can define retentivity either for individual or for all tags of 
a global data block depending on the settings for access.

– Block with optimized access: retentivity can be set for each individual tag.

– Block with standard access: The retentivity setting applies to all tags of the DB; either 
all tags are retentive or no tag is retentive.

See also
Warm restart (Page 837)

process image input/output

Basic principles of process images

Function
When the user program addresses the input (I) and output (O) operand areas, it does not query 
or change the signal states on the digital signal modules. Instead, it accesses a memory area 
in the system memory of the CPU. This memory area is referred to as the process image.
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Advantages of the process image
Compared with direct access to input and output modules, the main advantage of accessing 
the process image is that the CPU has a consistent image of the process signals for the 
duration of one program cycle. If a signal state on an input module changes during program 
execution, the signal state in the process image is retained until the process image is updated 
again in the next cycle. The process of repeatedly scanning an input signal within a user 
program ensures that consistent input information is always available.

Access to the process image also requires far less time than direct access to the signal modules 
since the process image is located in the internal memory of the CPU.

Updating the process images

Sequence 
The operating system updates the process images at cyclic intervals unless defined otherwise 
in your configuration. The process image input/output is updated in the following order:

1. The internal tasks of the operating system are performed.

2. The process image output (PIQ) table is written to the outputs of the module.

3. The status of inputs is read to the process image input (PII) table.

4. The user program is executed with all the blocks that are called in it.

The operating system automatically controls the writing of the process image output to the 
outputs of the modules and the reading of the process image input.

Special characteristics
You have the option of accessing inputs or outputs directly using direct I/O access. 

● If an instruction accesses an output directly and the output address is located in the process 
image output, the process image of the relevant output is updated.

● If an instruction accesses an output directly and the output address is not located in the 
process image output, the process image of the relevant output is not updated.

Example of normal I/O access by way of the process image

Update QW10 in the I/O output area with the value from MW0.

I/O access error during process image updating
If an error occurs while updating the process image (I/O access error), the CPU reacts with 
the default system reaction "STOP". 
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See also
Start address of a module (Page 847)

Access to the I/O addresses (Page 848)

Startup activities (Page 838)

Diagnostics buffer

Function   
The diagnostics buffer is part of the system memory of the CPU. It contains the errors detected 
by the CPU or modules with diagnostics capability. It includes the following events:

● Every mode change of the CPU (for example, POWER UP, change to STOP mode, change 
to RUN mode)

● Every diagnostics interrupt

The diagnostics buffer of the S7-1200-CPU has a capacity of 50 entries of which the last (most 
recent) 10 entries are retained following power cycling. 

Those entries can only be cleared by restoring the CPU to factory defaults.

You can read the content of the diagnostics buffer with the help of the Online and Diagnostics 
view.

See also
Basic information on the diagnostics buffer  (Page 1003)

I/O data area

Start address of a module

Definition 
The start address is the lowest byte address of a module. It acts as the initial address of the 
module user data area. 

Configuring module start addresses 
The addresses used in the user program and the module start addresses are coordinated 
when the modules are configured. 

In the module properties ("I/O addresses" group), you can change the start addresses that 
were assigned automatically after the modules were inserted. 

You can also make a setting that decides whether or not the addresses are located in the 
process image. 
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Access to the I/O addresses

I/O addresses               
If you insert a module in the device view, its user data is located in the process image of the 
S7-1200 CPU (default). The CPU handles the data exchange between the module and the 
process image area automatically during the update of the process images. 

Append the suffix ":P" to the I/O address if you want the program to access the module directly 
instead of using the process image. 

This could be necessary, for example, during execution of a time-sensitive program which also 
has to control the outputs within the same cycle. 

Basics of program execution

Events and OBs

Events and OBs
The operating system of S7-1200-CPUs is based on events. There are two types of events:

● Events which can start an OB

● Events which cannot start an OB

An event which can start an OB triggers the following reaction:

● It calls the OB you possibly assigned to this event. The event is entered in a queue according 
to its priority if it is currently not possible to call this OB.

● The default system reaction is triggered if you did not assign an OB to this event.

An event which cannot start an OB triggers the default system reaction for the associated event 
class.

The user program cycle is therefore based on events, the assignment of OBs to those events, 
and on the code which is either contained in the OB, or called in the OB.

The following table provides an overview of the events which can start an OB, including the 
associated event classes and OBs. The table is sorted based on the default OB priority. Priority 
class 1 is the lowest.
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Event class OB no. Number of 
OBs

Start event OB priority 
(default)

Cyclic program 1, >= 123 >= 1 Starting or end of the last program cycle OB 1
Startup 100, >= 

123
>=0 STOP to RUN transition 1

Time-of-day interrupt >= 123 Max. 2 Start time has been reached 2
Time-delay interrupt >= 123 Max. 4 Delay time expired 3
Cyclic interrupt >= 123 Constant bus cycle time expired 8
Hardware interrupt >= 123 Max. 50 

(more can 
be used with 
DETACH 
and 
ATTACH)

● Positive edge (max. 16)
● Negative edge (max. 16)

18

● HSC: Count value = reference value (max. 
6)

● HSC: Count direction changed (max. 6)
● HSC: External reset (max. 6)

18

Status interrupt 55 0 or 1 CPU has received status interrupt 4
Update interrupt 56 0 or 1 CPU has received update interrupt 4
Manufacturer- or profile-
specific interrupt

57 0 or 1 CPU has received manufacturer-specific or 
profile-specific interrupt

4

Diagnostic error interrupt 82 0 or 1 Module has detected an error 5
Pull/plug interrupt 83 0 or 1 Removal/insertion of modules of distributed I/O 6
Rack error 86 0 or 1 Error in the I/O system of the distributed I/O 6
Time error 80 0 or 1 ● Maximum cycle time exceeded

● Called OB is still being executed
● Time-of-day interrupt missed
● Time-of-day interrupt missed during STOP
● Queue overflow
● Interrupt loss due to high interrupt load

22

 

The following table describes events which do not trigger an OB start, including the 
corresponding reaction of the operating system. The table is sorted based on event priority.

Event class Event Event priority System reaction
Insert/remove central modules Insert/remove a module 21 STOP
I/O access error during 
process image update

I/O access error during process image update 22 Ignore

Programming error Programming error in a block for which you 
use system reactions provided by the 
operating system (note: the error handling 
routine in the block program is executed if 
you activated local error handling).

23 RUN
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Event class Event Event priority System reaction
I/O access error I/O access error in a block for which you use 

system reactions provided by the operating 
system (note: the error handling routine in the 
block program is executed if you activated 
local error handling).

24 RUN

Maximum cycle time exceeded 
twice

Maximum cycle time exceeded twice 27 STOP

 

Assignment between OBs and events
With the exception of the cyclic program and startup program and event can only be assigned 
to one OB. However, in certain event classes such as hardware interrupts one and the same 
OB can be assigned to several events.

The assignment between OBs and events is defined in the hardware configuration. Defined 
assignments can be changed at runtime by means of ATTACH and DETACH instructions.

OB priority and runtime characteristics
S7-1200 CPUs support the priority classes 1 (lowest) to 27 (highest). An OB is assigned the 
priority of its start event.

OBs are always executed on a priority basis: The OBs with the highest priority are executed 
first. Events of the same priority are processed in order of occurrence. This means:

● Any OB with priority >= 2 will interrupt cyclic program execution.

● An OB of priority 2 to 25 cannot be interrupted by any event of priority group 2 to 25. This 
rule also applies to events of a priority higher than that of the currently active OB. Such 
events are processed later.

● A time error (priority 26) will interrupt any other OB.

OB start information
Certain OBs have start information, while others do not. This is explained in greater detail in 
the description of the relevant OB.

See also
Event-based program execution (Page 850)

Event-based program execution

OB priority and runtime behavior
S7-1200-CPUs support the priority classes 1 (lowest) to 27 (highest). An OB is assigned the 
priority of its start event.
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Interrupt OBs can only be interrupted by time error interrupts. This rule also applies to events 
of a priority higher than that of the currently active OB. That is, only one interrupt OB can be 
active, with exception of the time error interrupt OB.

Any further event of generated while an interrupt OB is being executed is added to a queue in 
accordance with its priority. Start events within a queue are processed later based on the 
chronological order of their occurrence.

Program execution on the CPU
Cyclic OBs are interrupted by interrupt OBs.

Interrupt OBs can only be interrupted by time error interrupt OBs.

The following figure shows the basic sequence:

Figure 8-3 Program sequence
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Description of program execution

① and ② An event (e.g. a hardware interrupt) calls its associated OB. 
A called OB is executed without interruption, including all of its nested blocks. 
Execution of the cyclic OB is resumed on completion of interrupt processing, 
provided the queue does not contain any events which trigger an OB start.

③ An interrupt OB can only be interrupted by a time error interrupt OB (OB 80).
④ An new alarm-triggering event occurs during interrupt processing. This new event 

is added to a queue. The queued events successively call their corresponding 
OBs only after execution of the current interrupt OBs was completed and according 
to the following rules: 
● Events are processed in the order of their priority (starting at the highest priority)
● Events of the same priority are processed in chronological order

⑤ The cyclic OBs are processed one after the other. 

Notes on queues
● Every priority class (OBs of the same priority to be called) is assigned a separate queue. 

The size of those queues is set by default.

● Any new event leading to the overflow of a queue is discarded and therefore lost. A "time 
error interrupt event" is generated simultaneously. Information identifying the OB that 
caused the error is included in the start information of the time error interrupt OB (OB 80). 
A corresponding reaction such as an alarm trigger can be programmed in the time error 
interrupt OB.

 

Example of a hardware interrupt event
The function principle of event-oriented program execution in the S7-1200 CPU is described 
based on the example of a hardware interrupt-triggering module. 

Process events and their priority
Process events are triggered by the I/O (e.g. at a digital input) and initiate a call of the assigned 
OB in the S7-1200 CPU. OBs assigned to a process event are called hardware interrupt OBs. 

Examples of process events and their priority:

● Process events "rising edge" or "falling edge" at an interrupt-triggering module: The 
hardware interrupt OB started by such an event is always assigned priority 5.

● Process events from a high-speed counter

– Count value corresponds to the reference value

– Change count direction

– External reset of the high-speed counter
The hardware interrupt OB started by this event is always assigned priority 6. 
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The figure below shows the chronological sequence of hardware interrupt execution: In the 
case of two hardware interrupt events in immediate succession, the second hardware interrupt 
triggering event is held back in the queue until the first OBx has been processed. The next 
hardware interrupt triggering event can only start the associated OBx when the OBx has been 
processed. Additional hardware interrupt triggering events are lined up in the queue according 
to this principle. 

 

Hardware interrupt execution

① A hardware interrupt-triggering event such as a rising edge at the input calls the OB to 
which it is assigned.

② If a new event occurs that triggers a hardware interrupt while the OB is executing, this 
event is entered in a queue. 

③ The new event that triggers a hardware interrupt starts the hardware interrupt OB 
assigned to the event. 
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Assigning the interrupt-triggering event
The interrupt-triggering event is assigned to an OB in the input properties of the device view.

● An interrupt-triggering event can only be assigned to a single OB.

● OBs, however, can be assigned to several interrupt-triggering events. 
This means, for example, that you can assign both the rising and the falling edge to the 
same interrupt OB in order to trigger the same reaction to any change of the input signal.

● The started OB can interrupt a cycle OB at every instruction. Consistent data access is 
secured up to dword size.

● You can parameterize module-specific interrupt-triggering events such as a rising and the 
falling edge at the input.

● Assign the interrupt-triggering event and the OB to be started in the configuration of the 
interrupt-triggering module. However, within the started hardware interrupt OB you can 
override this assignment using the DETACH instruction, or assign the same event to a 
different OB using the ATTACH instruction. This functionality allows a flexible reaction to 
external process signals.

Setting the operating behavior

Changing properties of the modules

Default settings
When they leave the factory, all hardware components with parameters have default settings 
suitable for standard applications. These default values allow the hardware components to be 
used immediately without making any additional settings. 

You can, however, modify the behavior and the properties of the hardware components to suit 
the requirements and circumstances of your application. Hardware components with settable 
parameters include, for example, communications modules and several analog and digital 
modules.

Setting and loading parameters
When you have selected a hardware component in the device or network view, you can set 
the properties in the Inspector window. When you save a device configuration with its 
parameters, data is generated that needs to be loaded on the CPU. This data is transferred 
to the relevant modules during startup.

Properties of the CPUs  
The properties of the CPUs have special significance for system behavior. For example for a 
CPU you can set:

● Interfaces

● Inputs and outputs

● High-speed counters
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● Pulse generators

● Startup behavior

● Time-of-day

● Protection level

● Bit memory for system and clock

● Cycle time

● Communications load

The entry possibilities specify what is adjustable and in which value ranges. Fields that cannot 
be edited are disabled or are not shown in the properties window.

Requirement
You have already arranged the hardware components for which you want to change properties 
on a rack.

Procedure
To change the properties and parameters of the hardware components, follow these steps:

1. In the device or network view, select the hardware component or interface that you want 
to edit.

2. Edit the settings for the selected object:

– For example in the device view you can edit addresses and names.

– In the Inspector window additional setting possibilities are available.

You do not need to confirm your entries, the changed values will be applied immediately.

See also
Editing properties and parameters (Page 428)

Introduction to loading a configuration (Page 826)
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CPU properties

Overview of the CPU properties

Overview                           
The following table provides you with an overview of the CPU properties:

Group Properties Description
General Project information General information to describe the inserted CPU. Except for the 

slot number, you can change this information.
Catalog information Read-only information from the hardware catalog for this CPU.

PROFINET interface General Name and comment for this PROFINET interface. The name is 
limited to 110 characters.

Ethernet addresses Select whether the PROFINET interface is networked. If subnets 
have already been created in the project, they are available for 
selection in the drop-down list. If not, you can create a new subnet 
with the "Add new subnet" button.
Information on the IP address, subnet mask and IP router usage 
in the subnet is available in the IP protocol. If an IP router is used, 
the information about the IP address of the IP router is necessary.

Advanced options Name, comment and additional setting options of the Ethernet 
interface port.

Time synchronization Settings for time synchronization in the NTP time format.
The NTP (network time protocol) is a general mechanism for 
synchronizing system clocks in local and global area networks. 
In NTP mode, the interface of the CPU sends time queries (in 
client mode) at regular intervals to NTP servers on the subnet 
(LAN) and the addresses must be set in the parameters here. 
Based on the replies from the server, the most reliable and most 
accurate time is calculated and synchronized. The advantage of 
this mode is that it allows the time to be synchronized across 
subnets. The accuracy depends on the quality of the NTP server 
being used.

DI#/DO# General Name of and comment on the integrated digital inputs of the CPU. 
Digital inputs
 

Input delays can be set for digital inputs. The input delays can be 
set in groups (in each case for 4 inputs). 
The detection of a positive and a negative edge can be enabled 
for each digital input. A name and a hardware interrupt can be 
assigned to this event. 
Depending on the CPU, pulse catches can be activated at various 
inputs. When the pulse catch is activated, even pulse edges that 
are shorter than the cycle time of the program are detected. 

Digital outputs The reaction to a mode change from RUN to STOP can be set 
for all digital outputs: 
The state can either be frozen (corresponds to retain last value) 
or you set a substitute value ("0" or "1")

I/O addresses The address space of the input and output addresses is specified 
as is the process image.
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Group Properties Description
Hardware identifier The hardware identifier of the device is displayed.

AI# General Name of and comment on the integrated analog inputs of the 
CPU.

Analog inputs During noise reduction, the specified integration time suppresses 
interference frequencies at the specified frequency (in Hz). 
The channel address, measurement type, voltage range, 
smoothing and overflow diagnostics must be specified in the 
"Channel #" group. The measurement type and voltage range 
are set permanently to voltage, 0 to 10 V.
Smoothing analog values provides a stable analog signal for 
further processing. Smoothing analog values can be useful with 
slow measured value changes, for example, in temperature 
measurement. The measured values are smoothed with digital 
filtering. Smoothing is achieved by the module forming mean 
values from a specified number of converted (digitalized) analog 
values. The selected level (slight, medium, strong) decides the 
number of analog signals used to create the mean value.
If overflow diagnostics is enabled, a diagnostics event is 
generated if an overflow occurs.

I/O addresses The address space of the input addresses is specified as is the 
process image.

Hardware identifier The hardware identifier of the device is displayed.
High-speed counter 
(HSC)

High-speed counter (HSC)# High-speed counters are typically used to drive counting 
mechanisms.
See: Configuring high-speed counters (Page 866) 

Pulse generators 
(PTO/PWM)

PTO#/PWM# A pulse generator is activated and can be initialized with project 
information.
For the configuration of an activated pulse generator, specify the 
usage as PWM (Pulse Width Modulation) or as PTO (Pulse Train 
Output).
Specify the output source, time base, pulse width format, cycle 
time and initial pulse width for PWM. A pulse output is specified 
as the hardware output. The PWM output is controlled by the 
CTRL_PWM instruction, see CTRL_PWM.
Specify the output source for PTO. A pulse output and a direction 
output are specified as the hardware outputs. A PTO is operated 
together with a high-speed counter in the "axis of motion" count 
mode and controlled by the Motion Control technology object 
(see keyword "Motion Control S7-1200") . 
The hardware ID is displayed in the I/O-diagnostics addresses 
and, if the PWM function is selected, the address space of the 
output addresses and the process image can be selected.

Startup Startup after POWER ON Setting the startup characteristics after cycling power. 
See: Principles of the STARTUP mode (Page 836) 
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Group Properties Description
Comparison of preset 
configuration and actual 
configuration

Specifies whether modules (SM, SB, CM, CP or even the CPU) 
can be replaced:
● Startup of the CPU only if compatible
● Startup of the CPU even if there are differences
Example: A signal module with 16 digital inputs and 16 digital 
outputs (DI16/DQ16) can be a compatible replacement for a 
signal module with 8 digital outputs (DQ8) or 4 digital inputs (DI4).

Parameter assignment time for 
distributed I/O

Specifies a maximum period (standard: 60000 ms) in which the 
distributed I/O must start up. (The CMs and CPs are supplied 
with voltage and communication parameters during the CPU 
startup. This configuration time provides a time period during 
which I/O modules connected to the CM or CP must start up.)
The CPU switches to RUN as soon as the distributed I/O has 
started and is ready for operation, regardless of the "Parameter 
assignment time for distributed I/O" parameter. If the distributed 
I/O has not started up during this period, the CPU switches to 
RUN without the distributed I/O.

Cycle Maximum cycle time and 
minimum cycle time. 

Specification of a maximum cycle time or a fixed minimum cycle 
time.
If the cycle time exceeds the maximum cycle time, the CPU goes 
to STOP mode. 
See: Cycle time and maximum cycle time (Page 859) 

Communication load Maximum allocation of the cycle 
for communication (as a 
percentage)

Controls the duration of communication processes that always 
also extend the cycle time, within certain limits. Examples of 
communication processes include: Transferring data to another 
CPU or loading blocks (initiated via the PC).
See: Cycle loading by communications (Page 860) 

System and clock 
memory

System memory bits and clock 
memory bits

You use system memory bits for the following scans: 
● Is the current cycle the first since cycling power?
● Have there been any diagnostics state changes compared 

with the previous cycle?
● Scan for "1" (high)
● Scan for "0" (low)
Clock memory bits change their values at specified periodic 
intervals.
See: Enabling system memory (Page 876) 
See: Using clock memory (Page 877) 

Web server Automatic update Sends the requested web page with current CPU data 
periodically to the web browser. Enter the period duration under 
"Update interval". Automatic update can only be activated if the 
web server is enabled.
See: Auto-Hotspot 

User-defined web pages Allows access to freely-designed web pages of the CPU via a 
web browser.
See: Auto-Hotspot 

Time Local time and daylight saving 
time

Setting of the time zone in which the CPU is operated and setting 
of the daylight-saving/standard time changeover.
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Group Properties Description
Protection Protection and password for read/

write access
Setting the read/write protection and the password for access to 
the CPU.
See: Setting options for the protection level (FW V1 to V3) 
(Page 878) 
See: Setting options for the protection (FW as of V4) (Page 879)

Connection resources - Display of available, reserved and previously configured 
connection resources of the CPU.

Address overview - Tabular representation of all addresses used by the CPU for 
integrated inputs/outputs as well as for the inserted modules. 
Addresses that are not used by any module are represented as 
gaps. 
The view can be filtered according to 
● Input addresses
● Output addresses
● Address gaps

See also
Specifying input and output addresses (Page 638)

Assigning parameters to hardware interrupt OBs (Page 900)

Access to the I/O addresses (Page 848)

Addressing modules (Page 637)

Special features during startup (Page 839)

Cycle time and maximum cycle time

Function       
The cycle time is the time that the operating system requires to execute the cyclic program 
and all the program sections that interrupt this cycle. The program execution can be interrupted 
by: 

● Time errors and 2xMaxCycleTime errors

● System activities, e.g., process image updating

The cycle time (Tcyc) is therefore not the same for every cycle. 

The following schematic shows an example of different cycle times (TZ1 ≠ TZ2) for S7-1200 
CPUs:
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In the current cycle, the cyclic OB used here (e.g. OB 1) will be interrupted by a time error (e.g. 
OB 80). Following the cyclic OB, the next cycle OB 201 is processed. 

Maximum cycle time   
The operating system monitors the execution time of the cyclic program for a configurable 
upper limit known as the maximum cycle time. You can restart this time monitoring at any point 
in your program by calling the RE_TRIGR instruction.

If the cyclic program exceeds the maximum cycle time, the operating system will attempt to 
start the time error OB (OB 80). If the OB is not available, the CPU ignores the overshoot of 
the maximum cycle time.

In addition to monitoring the runtime for overshooting of the maximum cycle time, adherence 
to a minimum cycle time is guaranteed. To do this, the operating system delays the start of 
the new cycle until the minimum cycle time has been reached. During this waiting time, new 
events and operating system services are processed.

If the maximum cycle time is exceeded a second time, for example while the time error OB is 
being processed (2xMaxCycleTime error), the CPU changes to STOP mode.

Cycle loading by communications

Function    
The cycle time of the CPU can be extended due to communications processes. These 
communications processes include for example: 

● Transferring data to another CPU

● Loading of blocks initiated by a programming device

You can control the duration of these communications processes to some extent using the 
CPU parameter "Cycle load due to communication". 
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In addition to communications processes, test functions also extend the cycle time. The "Cycle 
load due to communication" parameter can be used to influence the duration. 

How the parameter works
You use the "Cycle load due to communication" parameter to enter the percentage of the 
overall CPU processing capacity that can be available for communications processes. This 
CPU processing capacity is now available at all times for communication. This processing 
capacity can be used for program execution when not required for communication.

Effect on the actual cycle time
The "Cycle load due to communication" parameter can be used to extend the cycle time of the 
cyclic organization block (e.g., OB 1) by a factor calculated according to the following formula:

The formula does not take into account the effect of asynchronous events such as hardware 
interrupts or cyclic interrupts on the cycle time. 

If the cycle time is extended due to communication processes, more asynchronous events 
may occur within the cycle time of the cyclic organization block. This extends the cycle still 
further. The extension depends on how many events occur and how long it takes to process 
them.

Example 1 – no additional asynchronous events:
If the "Cycle load due to communication" parameter is set to 50%, this can cause the cycle 
time of the cyclic organization block to increase by up to a factor of 2.

Example 2 – additional asynchronous events:
For a pure cycle time of 500 ms, a communication load of 50% can result in an actual cycle 
time of up to 1000 ms, provided that the CPU always has enough communications jobs to 
process. If, parallel to this, a cyclic interrupt with 20 ms processing time is executed every 100 
ms, this cyclic interrupt would extend the cycle by a total of 5*20 ms = 100 ms without 
communication load. That is, the actual cycle time would be 600 ms. Because a cyclic interrupt 
also interrupts communications, it affects the cycle time by adding 10 * 20 ms at 50 % 
communication load. That is, in this case, the actual cycle time amounts to 1200 ms instead 
of 1000 ms.

 

 Note

Observe the following:
● Check the effects of changing the value of the "Cycle load due to communication" 

parameter while the system is running.
● You must always consider the communication load when setting the minimum cycle time 

as time errors will otherwise occur.
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Recommendations
● Increase this value only if the CPU is used primarily for communication purposes and the 

user program is not time critical.

● In all other situations you should only reduce this value.

Time-of-day functions

Basic principles of time of day functions
All S7-1200 CPUs are equipped with an internal clock. The backup supports the display of the 
correct time for up to 10 hours if the power supply is interrupted.

Time-of-day format    
The clock always shows the time of day with a resolution of 1 millisecond and the date including 
the day of the week. The time adjustment for daylight-saving time is also taken into account.

Setting and reading the time of day

Setting and reading the time with instructions     
You can set, start and read the time-of-day and date on the CPU clock with the following 
instructions in the user program:

● Set the time-of-day: "WR_SYS_T"

● Read time of day "RD_SYS_T"

● Read local time "RD_LOC_T"

● Set time zone "SET_TIMEZONE"

Manual setting
You can also read and set the time-of-day manually in the online and diagnostics view under 
"Functions > Set time-of-day".
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Assigning the clock parameters

Clock parameters 
The clock parameters allow you to make the following settings:

● Enable time synchronization via NTP server
Select this check box if you want the internal clock to be synchronized using the NTP 
synchronization mode.

● Network time server
The IP addresses of up to four NTP servers need to be configured.

● Update interval
The update interval defines the interval between time queries.

High-speed counters

General information on high-speed counters

Introduction    
High-speed counters are typically used to drive counting mechanisms in which a shaft turning 
at a constant speed is equipped with an incremental step encoder. The incremental step 
encoder ensures a certain number of count values per rotation and a reset pulse once per 
rotation. The clock memory bit(s) and the reset pulse of the incremental step encoder supply 
the inputs for the high-speed counter.

The various S7-1200 CPUs have differing numbers of high-speed counters available:

S7-1200 CPU Number of HSCs HSC designation
CPU 1211C 3 (with digital signal board 4)* HSC1…3 (and HSC5)*
CPU 1212C 4 (with digital signal board 5)* HSC1…4 (and HSC5)*
CPU 1214C
CPU 1215C
CPU 1217C

6 HSC1…6

* with DI2/DO2 signal board

How it works  
The first of several default values is loaded on the high-speed counter. The required outputs 
are enabled for the time during which the current value of the counter is lower than the default 
value. The counter is set up so that an interrupt occurs if the current value of the counter is 
equal to the default value or when the counter is reset.

If the current value is equal to the default value and an interrupt event results, a new default 
value is loaded and the next signal state is set for the outputs. If an interrupt event occurs 
because the counter is reset, the first default value and the first signal states of the outputs 
are set and the cycle repeated.
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Since the interrupts occur much less frequently than the high-speed counter counts, a precise 
control of the fast operations can be implemented with only a slight influence on the overall 
cycle of the automation system. Since you can assign specific interrupt programs to interrupts, 
each new default can be loaded in a separate interrupt program allowing simple control of the 
state.

 

 Note

You can also process all interrupt events in a single interrupt program.
 

Count algorithms of the various counters
All counters work in the same way, however some high-speed counters do not support all 
count algorithms. There are four basic count algorithms:

● Single-phase counter with internal direction control

● Single-phase counter with external direction control

● 2-phase counter with 2 clock inputs

● A/B counter

Each high-speed counter can be used with or without a reset input. If the reset input is activated, 
this resets the current value. The current value remains reset until the reset input is deactivated.

See also
Configuring high-speed counters (Page 866)

Interdependency of the counter mode and counter inputs (Page 864)

Interdependency of the counter mode and counter inputs

General information on counter mode and counter inputs   
You can assign not only the counter modes and counter inputs to the high-speed counters but 
also functions such as clock pulse generator, direction control, and reset. The following rules 
apply:

● An input cannot be used for two different functions.

● If an input is not required by the current counter mode of the defined high-speed counter, 
it can be used other purposes.

If, for example, you set HSC1 to counter mode 1, in which inputs I0.0 and I0.3 are required, 
you can use I0.1 for edge interrupts or for HSC2.

If, for example, you set HSC1 and HSC5, inputs I0.0 (HSC1) and I1.0 (HSC5) are always used 
with the counting and frequency counter modes. As a result, these two inputs are not available 
for any other functions when counters are operated.

You have additional inputs available if you use a digital signal board.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
864 System Manual, 07/2013,  



Overview of the interdependency of counter mode and counter inputs

Counter mode Description Inputs
 HSC1 I0.0 (CPU)

I4.0 (signal board)
I0.1 (CPU)
I4.1 (signal board)

I0.3 (CPU)
I4.3 (signal board)

HSC2 I0.2 (CPU)
I4.2 (signal board)

I0.3 (CPU)
I4.3 (signal board)

I0.1 (CPU)
I4.1 (signal board)

HSC3* I0.4 (CPU) I0.5 (CPU) I0.7 (CPU)
HSC4 (CPU 1212/14/15/17C 
only)

I0.6 (CPU) I0.7 (CPU) I0.5 (CPU)

HSC5 (CPU 1214/15/17C 
only)**

I1.0 (CPU)
I4.0 (signal board)

I1.1 (CPU)
I4.1 (signal board)

I1.2 (CPU)
I4.3 (signal board)

HSC6 (CPU 1214/15/17C 
only)**

I1.3 (CPU) I1.4 (CPU) I1.5 (CPU)

Counting / 
frequency

Single-phase counter with 
internal direction control

Clock pulse 
generator

- -

Counting Resetting
Counting / 
frequency

Single-phase counter with 
external direction control

Clock pulse 
generator

Direction -

Counting Resetting
Counting / 
frequency

2-phase counter with 2 clock 
inputs

Clock pulse 
generator forwards

Clock pulse 
generator backwards

-

Counting Resetting
Counting / 
frequency

A/B counter Clock pulse 
generator A

Clock pulse 
generator B

-

Counting Resetting
Motion axis Pulse generators PWM/PTO HSC1 and HSC2 support the motion axis count mode for the PTO1 

and PTO2 pulse generators:
● For PTO1, HSC1 evaluates the Q0.0 outputs for the number of 

pulses.
● For PTO2, HSC2 evaluates the Q0.2 outputs for the number of 

pulses.
Q0.1 is used as the output for the motion direction.

* HSC3 can only be used for CPU 1211 without a reset input

** HSC5 can be also be used for CPU 1211/12 if a DI2/DO2 signal board is used

See also
General information on high-speed counters (Page 863)

Configuring high-speed counters (Page 866)
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Configuring high-speed counters

Requirement
An S7-1200 CPU has been inserted in the hardware configuration.

Procedure  
To configure a high-speed counter, follow these steps:

1. Select an S7-1200 CPU in the device or network view.

2. Click on the required high-speed counter under "Properties > High-speed counter" in the 
inspector window:

– CPU 1211C: HSC1 to HSC3 (also HSC5 with a DI2/DO2 signal board)

– CPU 1212C: HSC1 to HSC4 (also HSC5 with a DI2/DO2 signal board)

– CPU 1214C / 1215C / 1217C: HSC1 to HSC6

3. Enable the high-speed counter in the "General" parameter group using the relevant check 
box.

 

  Note

If you use a CPU 1211C or CPU 1212C with a DI2/DO2 signal board, you can also enable 
the high-speed counter HSC5.

 

  Note

If you activate the pulse generators and operate them as PTO1 or PTO2, they use the 
associated high-speed counter HSC1 or HSC2 with "Motion axis" counting mode to 
evaluate the hardware outputs. If you configure high-speed counter HSC1 or HSC2 for 
other counting tasks, these cannot be used by pulse generator PTO1 or PTO2, 
respectively.

 

If required, you can enter a name and a comment for the high-speed counter here.

4. Define the functionality of the high-speed counter in the "Function" parameter group:

– Count mode: Select what you want to be counted from the drop-down list.

– Operating phase: Select the count algorithm from the drop-down list.

– Input source: Select the on-board CPU inputs or the inputs of an optional digital signal 
board as the input source for the count pulses from the drop-down list.

– Count direction is specified by: If you have selected a single-phase operating phase, 
open the drop-down list and select whether the count direction is set internally by an 
SFB parameter of the user program or externally via a digital input.

– Initial count direction: If the user program is set as the internal direction control for the 
count direction, you can select the count direction at the start of counting from the drop-
down list.

– Frequency meter period: If frequency is set as the count mode, you can select the 
duration of the frequency meter periods in the drop-down list.
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5. Specify the initial values and reset condition of the high-speed counter in the "Reset to initial 
values" parameter group:

– Initial counter value: Enter a start value for the high-speed counter.

– Initial reference value: Enter a maximum value for the high-speed counter.

Here, you can also specify whether the high-speed counter will use a reset input and the 
set the corresponding signal level for the reset input from the drop-down list.

6. Configure the reaction of the high-speed counter to certain events in the "Event 
configuration" parameter group. The following events can trigger an interrupt:

– The counter value matches the reference value.

– An external reset event was generated.

– A change of direction was triggered.

Enable an interrupt reaction using the check box, enter a name and select a hardware 
interrupt for the interrupt from the drop-down list.

7. Assign the start address for the high-speed counter in the "I/O/Diagnostics addresses" 
parameter group.

 

  Note

In the "Hardware inputs" parameter group, you can only see which hardware inputs and 
values are being used for the clock, direction determination, reset pulse, and maximum 
count speed.

 

Result
You have now adapted the parameters of the high-speed counter to the requirements of your 
project.

See also
General information on high-speed counters (Page 863)

Interdependency of the counter mode and counter inputs (Page 864)

Point-to-point communication

Overview of point-to-point communication
PtP communication is communication via a serial interface that uses standardized UART data 
transmission (Universal Asynchronous Receiver/Transmitter). The S7-1200 uses 
communications modules with an RS-232 or RS-485 interface to establish PtP communication.
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Functions of point-to-point communication  
Point-to-point communication (PtP) allows numerous applications:

● Direct transmission of information to an external device, for example a printer or a barcode 
reader

● Reception of information from external devices such as barcode readers, RFID readers, 
cameras and third-party optical systems as well as many other devices.

● Exchange of information with third-party devices, for example GPS devices, radio modems 
and many others

The Freeport protocol  
The S7-1200 supports the Freeport protocol for character-based serial communication. Using 
Freeport communication, the data transmission protocol can be configured entirely by the user 
program.

Siemens provides libraries with Freeport communication functions that you can use in your 
user program:

● USS Drive protocol

● Modbus RTU Master protocol

● Modbus RTU Slave protocol

See also
Configuring a communications port (Page 869)

Using RS-232 and RS-485 communications modules

Communications modules with RS-232 and RS-485 interfaces  
In an S7-1200 CPU, you can use two different communications modules:

● RS-232 communications module

● RS-485 communications module

The communications modules can be connected to the S7-1200 CPU via the I/O channel on 
the left. You can plug in up to three different modules.

Properties of the communications modules  
The communications modules have the following features:

● Support of the Freeport protocol

● Configuration by the user program with the aid of expanded instructions and library functions
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Configuring a communications port

Configuring a communications port   
After you have inserted a communications module with an RS-232 or RS-485 interface, you 
then set the interface parameters. You set the parameters for the interface either in the 
properties of the interface or you control the interface parameters from the user program using 
the PORT_CFG instruction. The following description relates to the graphic configuration.

 

 Note

If you use the user program to change the port setting, the settings of the graphic configuration 
are overwritten.

You should also keep in mind that the settings made by the user program are not retained if 
there is a power down.

 

Requirement
● A communications module is already plugged in.

● You are in the device view.

Procedure
To configure the communications port, proceed as follows:

1. Select the interface in the graphic representation in the device view.
The properties of the interface are displayed in the Inspector window.

2. Select the "Port configuration" group in the area navigation of the Inspector window.
The settings of the port are displayed.

3. From the "Transmission speed" drop-down list, select the speed for the data transmission. 
With user-programmed communication, remember the influence of the transmission speed 
on the changeover time.

4. From the "Parity" drop-down list, select the type of detection of bad information words.

5. Using the "Data bits" drop-down list, decide whether a character consists of eight or seven 
bits.

6. From the "Stop bit" drop-down list, select how many bits will identify the end of a transmitted 
word.
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7. From the "Flow control" drop-down list, select the method for ensuring a trouble-free data 
stream between sender and receiver. This parameter can only be set for the RS-232 
interface.

– Enter a HEX value in the "XON character" box that will cause the transmission of the 
message to be continued when it is detected. This parameter can only be set for 
software-controlled data flow control.

– Enter a HEX value in the "XOFF character" box that will cause the transmission of the 
message to be suspended for the set wait time. This parameter can only be set for 
software-controlled data flow control.

8. In the "Wait time" box, enter a wait time in ms that must be kept to after the end of the 
message before the next transmission can start.

 

 Note

You can configure the interface in the network view as well. To do so, you must first select 
the communication module in the tabular network view and then select the interface in the 
Inspector window. Then you can continue as described above.

 

See also
Setting data flow control (Page 870)

Setting data flow control

Data flow control
Data flow control is a method that ensures a balanced send and receive behavior. In the ideal 
situation, the intelligent control does not allow data to be lost. It ensures that a device does 
not send more information than the receiving partner can process.

There are two methods of data flow control:

● Hardware-controlled data flow control

● Software-controlled data flow control

With both methods, the DSR signals of the communications partners must be active at the 
beginning of transmission. If the DSR signals are inactive, the transmission is not started.

The RS-232 communications module can handle both methods. The RS-485 communications 
module does not support data flow control.

Hardware-controlled data flow control
Hardware-controlled data flow control uses the request to send (RTS) and clear to send (CTS) 
signals. With the RS-232 communications module, the RTS signal is transmitted via the output 
by pin 7. The CTS signal is received via pin 8.

If hardware-controlled data flow control is enabled, the RTS signal is then always set to 
activated when data is sent. At the same time, the CTS signal is monitored to check whether 
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the receiving device can accept data. If the CTS signal is active, the module can transfer data 
until the CTS signal becomes inactive. If the CTS signal is inactive, the data transfer must be 
suspended for the set wait time. If the CTS signal is still inactive after the set wait time, the 
data transfer is aborted and an error is signaled back to the user program.

Data flow control using hardware handshaking
If data flow control is controlled by hardware handshaking, the sending device sets the RTS 
signal to active as default. A device such as a modem can then transfer data at any time. It 
does not wait for the CTS signal of the receiver. The sending device itself monitors it own 
transmission by sending only a limited number of frames (characters), for example to prevent 
overflow of the receive buffer. If there is nevertheless an overflow, the transferring device must 
hold back the message and signal an error back to the user program.

Software-controlled data flow control
Software-controlled data flow control uses certain characters within the messages and these 
control the transfer. These characters are ASCII characters selected for XON and XOFF.

XOFF indicates when a transmission must be suspended. XON indicates when a transmission 
can be continued.

If the sending device receives the XOFF character, it must suspend sending for the selected 
wait time. If the XON character is sent after the selected wait time, the transfer is continued. 
If no XON character is received after the wait time, an error is signaled back to the user program.

Software data flow control requires full duplex communication because the receiving partner 
needs to send the XON character during the ongoing transfer.

See also
Configuring a communications port (Page 869)

Configuration of message transfer

User-programmed communication  
You can control the data traffic between a communications module and a device connected 
externally via the serial interface using your own mechanisms. If you want to do this, you will 
need to define a communications protocol yourself. In freely programmable communication, 
ASCII and binary protocols are supported for message transfer.

Within the communications protocol, you will need to specify the criteria by which the start and 
end of a transferred message can be recognized in the data stream.

User-programmed communication can only be activated in RUN mode. If there is a change to 
STOP mode, the user-programmed communication is stopped.
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Specifying the communications protocol  
You can specify the communications protocol as follows:

● With the user program

– The behavior when sending data is controlled by the SEND_CFG instruction.

– The behavior when receiving data is controlled by the RCV_CFG instruction.

● Using parameter settings set graphically in the Inspector window
 

  Note

If you change the communications protocol from the user program, the settings of the 
graphic configuration are overwritten.

You should keep in mind that the settings made by the user program are not retained if 
there is a power down.

 

 

See also
User-programmed communication with RS-232 devices (Page 872)

Making the settings for sending (Page 874)

Specifying the start of the message (Page 874)

Specifying the end of the message (Page 875)

User-programmed communication with RS-232 devices

RS-232/PIP multi-master cable and user-programmed communication with RS-232 devices 
Using the RS-232/PIP multi-master cable and user-programmed communication, you can 
connect a wide variety of RS-232-compliant devices to the communications modules of the 
S7-1200. The cable must, however, be set to the "PIP/user-programmed communication" 
mode.

Settings on the cable
The switches on the cable must be set as follows:

● Switch 5 must be set to 0

● Switch 6 sets either the local mode (DCE) or the remote mode (DTE):

– Switch set to 0 for the local mode

– Switch set to 1 for the remote mode
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Changing over between send and receive mode
The RS-232/PIP multi-master cable is in send mode when data is sent from the RS-232 
interface to the RS-485 interface. The cable is in receive mode when it is idle or when data is 
sent from the RS-485 interface to the RS-232 interface. The cable changes from receive to 
send mode immediately when it detects characters on the RS-232 send line.

Supported transmission speeds
The RS-232/PIP multi-master cable supports transmission rates between 1200 baud and 115.2 
kbaud. The RS-232/PIP multi-master cable can be set to the required transmission rate using 
the DIP switch on the PC/PIP cable.

The following table shows the switch settings for the various transmission speeds:

Transmission speed Switchover time Settings (1 = up)
115200 bps 0.15 ms 110
57600 bps 0.3 ms 111
38400 bps 0.5 ms 000
19200 bps 1.0 ms 001
9600 bps 2.0 ms 010
4800 bps 4.0 ms 011
2400 bps 7.0 ms 100
1200 bps 14.0 ms 101

 

The cable returns to receive mode when the RS-232 send line is idle for a certain time that is 
defined as the changeover time of the cable. The set transmission speed influences the 
changeover time as shown in the table.

Influence of the changeover time 
When working with an RS-232/PIP multi-master cable in a system in which user-programmed 
communication is used, the program must take into account the changeover time for the 
following reasons:

● The communications module reacts to messages sent by the RS-232 device.
Once the communications module has received a request from the RS-232 device, it must 
delay the reaction message for a period that is equal to or longer than the changeover time 
of the cable.

● The RS-232 device reacts to messages sent by the communications module.
Once the communications module has received a reaction message from the RS-232 
device, it must delay the next request message for a period that is equal to or longer than 
the changeover time of the cable.

In both situations, the RS-232-PIP multi-master cable has enough time to change from send 
to receive mode so that the data can be sent from the RS-485 interface to the RS-232 interface.
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See also
Configuration of message transfer (Page 871)

Making the settings for sending (Page 874)

Specifying the start of the message (Page 874)

Specifying the end of the message (Page 875)

Making the settings for sending

Sending messages  
You can program pauses between individual messages.

The following table shows which pauses can be set:

Parameter Definition
RTS ON delay You can set the time that must elapse after the send request RTS 

(request to send) before the actual data transfer starts.
RTS OFF delay You can set the time that must elapse after the complete transfer 

before RTS signal is deactivated.
Send pause at the start of the 
message

You can specify that a pause is sent at the start of every message 
transfer when the RTS ON delay has elapsed.
The pause is specified in bit times.

Send Idle Line after a pause You can make a setting so that following a selected pause at the start 
of the message, the "Idle Line" signal is output to signal that the line 
is not in use. To enable the parameter, "Send pause at message start" 
must be set.
The duration of the "Idle Line" signal is specified in bit times.

See also
Specifying the start of the message (Page 874)

Specifying the end of the message (Page 875)

User-programmed communication with RS-232 devices (Page 872)

Specifying the start of the message

Recognizing the start of the message  
To signal to the receiver when the transfer of a message is completed and when the next 
message transfer starts, criteria must be specified in the transmission protocol to identify the 
end and start of a message.

If a criterion is met that indicates the start of a message, the receiver starts searching the data 
stream for criteria that mean the end of the message.

There are two different methods for identifying the start of a message:

Editing devices and networks
8.1 Configuring devices and networks

WinCC Comfort/Advanced V12.0 SP1
874 System Manual, 07/2013,  



● Starting with any character:
Any character can defined the start of a message. This is the default method.

● Starting with a specific condition:
The start of a message is identified based on selected conditions.

Conditions for detecting the start of a message
The following table shows the various options for defining the start of a message:

Parameter Definition
Recognize start of message 
by line break

The receiver recognizes a line break when the received data stream is 
interrupted for longer than one character. If this is the case, the start of 
the message is identified by the line break.

Recognize start of message 
by idle line

The start of a message is recognized when the send transmission line 
is in the idle state for a certain time (specified in bit times) followed by an 
event such as reception of a character.

Recognize start of message 
with individual characters

The start of a message is recognized when a certain character occurs. 
You can enter the character as a HEX value.

Recognize start of message 
by a character string

The start of a message is detected when one of the specified character 
sequences arrives in the data stream. You can specify up to four 
character sequences each with up to five characters.

The individual conditions can be logically linked in any way.

See also
Making the settings for sending (Page 874)

User-programmed communication with RS-232 devices (Page 872)

Specifying the end of the message

Recognizing the end of the message   
To signal to the receiver when the transfer of a message is completed and when the next 
message transfer starts, criteria must be specified in the transmission protocol to identify the 
end and start of a message.

In total, there are six different methods of recognizing the end of a message and these can all 
be logically linked in any way. The following table shows the various possible setting options:

Parameter Definition
Recognize end of message by 
message timeout

The end of a message is recognized automatically when a selected 
maximum duration for a message is exceeded. Values from 0 to 65535 
ms can be set.

Recognize end of message by 
reply timeout

The end of a message is recognized when there is no reply within a 
set time after transferring data. Values from 0 to 65535 ms can be set.
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Parameter Definition
Recognize end of message by 
timeout between characters

The end of a message is detected when the time between two 
characters specified in bit times is exceeded. Values from 0 to 2500 
bit times can be set.
The S7-1200 CPU only accepts a maximum time of eight seconds 
even if the value that is set results in a duration of more than eight 
seconds.

Recognize end of message by 
maximum length

The end of a message is recognized when the maximum length of a 
message is exceeded. Values from 1 to 1023 characters can be set.

Read message length from 
message

The message itself contains information about the length of the 
message. The end of a message is reached when the value taken from 
the message is reached. Which characters are used for the evaluation 
of the message length is specified with the following parameters:
● Offset of the length field in the message

The value decides the position of the character in the message that 
will be used to indicate the message length. 
Values from 1 to 1022 characters can be set.

● Size of the length field
This value specifies how many characters starting at the first 
evaluation position will be used to indicate the message length. 
Values of 0, 1, 2 and 4 characters can be set.

● The data following the length field 
(does not belong to the message length)
The value specifies the number of bytes after the length field that 
must be ignored in the evaluation of the message length. 
Values from 0 to 255 characters can be set.

Recognize message end with 
a character sequence

The end of a message is detected when the specified character 
sequence arrives in the data stream. You can define up to five 
characters in the character string that are to be checked. If the 
specified characters appear at the correct location in the message, the 
message end is recognized. To recognize the message end when 
character 1 and character 3 have a certain value, for example, you 
have to activate the check box for character 1 and character 3 and 
enter a character value.

 

See also
Making the settings for sending (Page 874)

User-programmed communication with RS-232 devices (Page 872)

Enabling system memory

System memory     
A system memory is a bit memory with defined values. 

You decide which memory byte of the CPU will become the system memory byte when 
assigning the system memory parameters. 
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Benefits
You can use system memory in the user program, for example to run program segments in 
only the first program cycle after start-up. Two system memory bits are constant 1 or constant 
0. 

Bits of the system memory bytes
The following table shows the meaning of the system memory:

Bit of the system 
memory bytes

7 6 5 4 3 2 1 0

Meaning Reserved 
(=0)

Reserved 
(=0)

Reserved 
(=0)

Reserved 
(=0)

=0 =1 =1 with 
change to 
the 
diagnosis 
status

=1 in first 
program 
cycle after 
startup, 
otherwise 0

 
 

 Note

The selected memory byte cannot be used for intermediate storage of data. 
 

Using clock memory

Clock memory  
A clock memory is a bit memory that changes its binary status periodically in the pulse-no-
pulse ratio of 1:1. 

You decide which memory byte of the CPU will become the clock memory byte when assigning 
the clock memory parameters. 

Benefits
You can use clock memory, for example, to activate flashing indicator lamps or to initiate 
periodically recurring operations such as recording of actual values.

Available frequencies
Each bit of the clock bit memory byte is assigned a frequency. The following table shows the 
assignment:

Bit of the clock 
memory byte

7 6 5 4 3 2 1 0

Period (s) 2.0 1.6 1.0 0.8 0.5 0.4 0.2 0.1
Frequency (Hz) 0.5 0.625 1 1.25 2 2.5 5 10
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 Note

Clock memory runs asynchronously to the CPU cycle, i.e. the status of the clock memory can 
change several times during a long cycle.

The selected memory byte cannot be used for intermediate storage of data. 
 

Protection

Setting options for the protection level (FW V1 to V3)

Protection level       
The following section describes how to use the various protection levels of the S7-1200 CPUs 
V1 to V3. 

Effects of the protection level setting
You can choose between the following protection levels:

● No protection: This corresponds to the default behavior. You cannot enter a password. 
Read and write access is always permitted.

● Write protection: Only read-only access is possible. You cannot change any data on the 
CPU and cannot load any blocks or a configuration. HMI access and communication 
between CPUs are excluded from the write protection. Assignment of a password is 
required to select this protection level.

● Write/read protection: No write or read access is possible in the "Accessible devices" area 
or in the project for devices that are switched online. Only the CPU type and the identification 
data can be displayed in the project tree under "Accessible devices". Display of online 
information or blocks under "Accessible devices", or in the project for devices 
interconnected online, is possible.
HMI access and communication between CPUs are excluded from the write protection. 
Assignment of a password is required to select this protection level.

Behavior of a password-protected CPU during operation
The CPU protection takes effect after the settings are downloaded to the CPU.

Validity is checked before the online function is executed. If password protection is in place, 
you are prompted to enter a password. 

Example: The module was assigned write protection and you want to execute the "Modify tags" 
function. This requires write access; therefore, the assigned password must be entered to 
execute the function. 

The functions protected by a password can only be executed by one programming device/PC 
at any one time. Another programming device/PC cannot log on with a password. 
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Access authorization to the protected data is in effect for the duration of the online connection 
or until the access authorization is manually rescinded with "Online > Delete access rights". 
Access authorization will also expire when the project is closed. 

 

 Note

You can not restrict functions for process control, monitoring, and communications. 

Some functions are still protected due to their use as online data. RUN/STOP in the "Online 
Tools" task card or "Set the time" in the diagnostics and online editor is therefore write-
protected.

 

 

Setting options for the protection (FW as of V4)

Protection level     
The following section describes how to use the various access levels of the S7-1200 CPUs as 
of V4.

S7-1200 CPUs provide various access levels to limit the access to specific functions. 

The parameters for the access levels are assigned in a table. The green checkmarks in the 
columns to the right of the respective access level specify which operations are possible 
without knowing the password of this access level. If you want to use the functions of check 
boxes that are not selected, a password has to be entered.

 

 NOTICE

Configuring an access level does not replace know-how protection

Configuring access levels prevents unauthorized changes to the CPU by restricting download 
privileges. However, blocks on the memory card are not write- or read-protected. Use know-
how protection to protect the code of blocks on the memory card.

 

Default characteristics 
The default access level is "Full access (no protection)". Every user can read and change the 
hardware configuration and the blocks. A password is not set and is also not required for online 
access. 
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The access levels in detail
With an S7-1200 CPU, you can configure the following access levels:

● Full access (no protection): The hardware configuration and the blocks can be read and 
changed by all users.

● Read access: With this access level, only read access to the hardware configuration and 
the blocks is possible without entering a password - meaning that you can load the hardware 
configuration and blocks into the programming device. In addition, HMI access and access 
to diagnostics data is possible. 
You cannot load blocks or a hardware configuration into the CPU without entering the 
password. Moreover, writing test functions and firmware updates are not possible without 
a password.

● HMI access: With this access level, only HMI access and access to diagnostics data is 
possible without entering the password.
Without entering the password, you can neither load blocks and hardware configuration 
into the CPU, nor load blocks and hardware configuration from the CPU into the 
programming device. In addition, the following is not possible without a password: Writing 
test functions, changing the operating state (RUN/STOP) and firmware updates.

● No access (complete protection): When the CPU is completely protected, no read or write 
access to the hardware configuration and the blocks is possible. HMI access is also not 
possible. The server function for PUT/GET communication is disabled in this access level 
(cannot be changed).
Authorization with the password again provides you full access to the CPU.

Behavior of a password-protected module during operation
The CPU protection takes effect after the settings are downloaded to the CPU.

Validity is checked before the online function is executed. If password protection is in place, 
you are prompted to enter a password. 

Example: The module was configured with read access and you want to execute the "Modify 
tags" function. This requires write access; therefore, the assigned password must be entered 
to execute the function.

The functions protected by a password can only be executed by one programming device/PC 
at any one time. Another programming device/PC cannot log on.

Access authorization to the protected data is in effect for the duration of the online connection 
or until the access authorization is manually rescinded with "Online > Delete access rights".

Each access level allows unrestricted access to certain functions without entering a password, 
for example, identification using the "Accessible devices" function.

Configuring access levels
The following section describes how to configure an access level and enter passwords for an 
S7-1200 CPU as of V4.

For an S7-1200 CPU, you can enter multiple passwords and thereby set up different access 
rights for individual user groups.
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The passwords are entered in a table in such a way that exactly one access level is assigned 
to each password. 

The effect of the password is visualized in the "Access" column and explained in the text below 
the table.

Example
You select the "No access (complete protection)" access level for a standard CPU (in other 
words, not an F-CPU) and enter a separate password for each of the access levels that lie 
above it in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the set passwords, the effect depends on the table row in which 
the password occurs:

● The password in row 1 (Full access (no protection)) allows access as if the CPU were 
completely unprotected. Users who know this password have unrestricted access to the 
CPU.

● The password in row 2 (read access) allows access as if the CPU were write-protected. 
Users who know this password have read-only access to the CPU.

● The password in row 3 (HMI access) allows access as if the CPU were write-protected and 
read-protected so that only HMI access is possible for users who know this password.

Procedure
To configure the access levels of an S7-1200 CPU, follow these steps:

1. Open the properties of the module in the inspector window.

2. Open the "Protection" entry in the area navigation.
A table with the possible access levels appears in the inspector window.

Figure 8-4 Access protection 

3. Activate the required access level in the first column of the table. The green checkmarks 
in the columns to the right of the respective protection level show you which operations are 
still available without entering the password.
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4. In the "Password" column, specify a password for full access in the first row. In the 
"Confirmation" column, enter the selected password again to protect against incorrect 
entries.
Ensure that the password is sufficiently secure, in other words, that is does not follow a 
machine-recognizable pattern!
You must enter a password in the first row "Full access (no protection)". This enables 
unrestricted access to the CPU for those who know the password, regardless of the 
selected protection level.

5. Assign additional passwords as needed to other access levels if the selected protection 
level allows you to do so.

6. Download the hardware configuration so that the access level takes effect.

Result
The hardware configuration and the blocks are protected against unauthorized access 
according to the set access level. If an operation cannot be executed without a password due 
to the set access level, a dialog for entering a password is displayed.

Restriction of communication services

Introduction
The CPU can be the server for a number of communication services. This means that other 
communication participants can access CPU data even if you have not configured and 
programmed connections for the CPU.

The local CPU as a server thus does not have the possibility to control communication to the 
clients. 

The parameter "Connection mechanisms" in the "Protection" area of the CPU parameters is 
used to specify whether this type of communication is permitted or not for the local CPU during 
operation. 

Permit access with PUT/GET communication from remote partners     
By default, the "Permit access with PUT/GET communication from remote partners (...)" option 
is disabled. In this case, read and write access to CPU data is only possible for communication 
connections that require configuration or programming both for the local CPU and for the 
communication partner. Access through BSEND/BRCV instructions is possible, for example. 

Connections for which the local CPU is only a server (meaning that no configuration/
programming of the communication with the communication partner exists at the local CPU), 
are therefore not possible during operation of the CPU, for example, 

● For PUT/GET, FETCH/WRITE or FTP access via communication modules

● For PUT/GET access from other S7 CPUs

● For HMI access that is realized via PUT/GET communication
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If you want to allow access to CPU data from the client side, meaning that you do not want to 
restrict the communication services of the CPU, activate the "Permit access with PUT/GET 
communication from remote partners" option.

Organization blocks

Organization blocks for startup

Description    
You can determine the boundary conditions for the startup characteristics of your CPU, for 
example, the initialization values for "RUN". To do this, write a startup program. The startup 
program consists of one or more startup OBs (OB numbers 100 or >= 123). 

The startup program is executed once during the transition from "STOP" mode to "RUN" mode. 
Current values from the process image of the inputs are not available for startup program, nor 
can these values be set.

After the complete execution of the startup OBs, the process image of the inputs is read in and 
the cyclic program is started.

There is no time limit for executing the startup routine. Therefore the scan cycle monitoring 
time is not active. Time-driven or interrupt-driven organization blocks cannot be used. 

Start information
A startup OB has the following start information:

Tag Data type Description
LostRetentive BOOL = 1, if retentive data storage areas have been lost
LostRTC BOOL = 1, if realtime clock has been lost

See also
Events and OBs (Page 848)

Organization blocks for cyclic program execution

Introduction           
For the program execution to start, at least one program cycle OB must be present in the 
project. The operating system calls this program cycle OB once in each cycle and thereby 
starts the execution of the user program. You can use multiple OBs (OB numbers >= 123). 
When multiple program cycle OBs are used, these are called in one after the other in the order 
of their OB numbers. The program cycle OB with the lowest OB number is called first.

The program cycle OBs have the priority class 1. This corresponds to the lowest priority of all 
OBs. The cyclic program can be interrupted by events of any other event class. 
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Programming cyclic program execution
You program cyclic program execution by writing your user program in the cycle OBs and the 
blocks that they call.

The first cyclic program execution begins as soon as the startup program has ended without 
errors. The cycle restarts after the end of each cyclic program execution.

Sequence of cyclic program execution
One cycle of the program execution encompasses the following steps:

1. The operating system starts the maximum cycle time.

2. The operating system writes the values from the process image output to the output 
modules.

3. The operating system reads out the state of the inputs of the input modules and updates 
the process image input.

4. The operating system processes the user program and executes the operations contained 
in the program.

5. At the end of a cycle, the operating system executes any tasks that are pending, for 
example, loading and deleting blocks or calling other cycle OBs.

6. Finally, the CPU returns to the start of the cycle and restarts the scan cycle monitoring time.

See also: Auto-Hotspot

Options for interrupting
Cyclic program execution can be interrupted by the following events:

● Interrupt

● A STOP command, triggered by

– Operation of the programming device

– "STP" instruction

● Supply voltage failure

● Occurrence of a device fault or program error

Start information
● None

● Optimized start information:

Name Data type Meaning
first_scan BOOL = TRUE in the first call of this OB:

● Transition from STOP or HOLD to RUN
● After reloading

retentivity BOOL = TRUE, if retentive data are available
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See also
Events and OBs (Page 848)

Organization blocks for interrupt-driven program execution

Organization blocks for time-of-day interrupt

Function           
Organization blocks for time-of-day interrupt (OB number >=123) can be processed as follows:

● One time to a preset time (date with time of day)

● Periodically with preset start time and the following intervals:

– Every minute

– Hourly

– Daily

– Weekly

– Monthly

– Yearly

– End of month

Time-of-day interrupt-OBs are therefore used to run parts of the user program on a time-
controlled basis.

Status for time-of-day interrupt
The following table contains the possible status of a time-of-day interrupt as well as it's meaning.

Status Meaning
Cancelled The one-time processing has already taken place, or the start event of an not yet processed time-of-day 

interrupt has been deleted with the extended instruction CAN_TINT.
Set You have scheduled the time or start time for processing.
Activated You have scheduled whether processing takes place one time or periodically, and in the case of periodic 

processing, you have scheduled the interval.

Rules for time-of-day interrupts
The following rules apply to the use of time-of-day interrupts:

● A time-of-day interrupt can only be processed if it is set and activated, and a corresponding 
organization block exists in the user program.

● The start times of periodic time-of-day interrupts must correspond to a real date. For 
example, it is not possible to repeat an organization block monthly which first occurs on 
January 31st. In this case, on OB will only be started in the months that have 31 days.
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● A time-of-day interrupt activated during startup by extended instruction call ACT_TINTwill 
not be executed until the startup is complete.

● After each CPU startup, you must reactivate previously set time-of-day interrupts

Setting and activating a time-of-day interrupt OB
Before a time-of-day interrupt can be deleted and the corresponding time-of-day interrupt OB 
can be processed from the operating system, you must set and activate the interrupt. You have 
the following options:

Set time-of-day interrupt Activate time-of-day interrupt
Means of configuring Means of configuring
Means of configuring By extended instruction call ACT_TINT
By extended instruction call SET_TINTL By extended instruction call ACT_TINT

 
 

 Note

If you configure a time-of-day interrupt in such a way that the corresponding OB is to be 
processed once, the start time must not be in the past (relative to the real-time clock of the 
CPU).

If you configure a time-of-day interrupt in such a way that the corresponding OB is to be 
processed periodically, but the start time is in the past, then the time-of-day interrupt will be 
processed the next time it is due.

 

 

Time-of-day interrupt status query
In order to query the status of the time-of-day interrupt, call the extended instruction QRY_TINT.

Cancelling a time-of-day interrupt
You can cancel a time-of-day interrupt which has not yet been processed with the extended 
instruction CAN_TINT.

You can reset cancelled time-of-day interrupts with the extended instruction SET_TINTL and 
activate them with the extended instruction ACT_TINT.

 

Conditions that effect the time-of-day interrupt OBs
Since a time-of-day interrupt occurs only at specific intervals, certain conditions can affect the 
function of the associated OBs during execution of your program. The following table shows 
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some of these conditions and describes how these affect the processing of a time-of-day 
interrupt OB.

Condition Result
The extended instruction CAN_TINT is called in the user 
program.

The operating system deletes the start event (date and time) 
of the time-of-day interrupt. You must reset and reactivate the 
time-of-day interrupt if you are going to call the corresponding 
time-of-day interrupt OB again.

By synchronizing or correcting the CPU system clock, the 
time of day will be set ahead. With this, the start time for a 
time-of-day interrupt OB will be bypassed.

The operating system calls the time error interrupt OB (OB 
80) and records the start event, the number, and the priority 
of the first bypassed time-of-day interrupt OB in its start 
information. After completion of the OB 80, the operating 
system processes the bypassed time-of-day interrupt OB 
only once.

By synchronizing or correcting the CPU system clock, the 
time of day will be set back. The corrected clock time is before 
the start time of an already processed time-of-day interrupt 
OB.

The time-of-day interrupt OB is repeated.

A time-of-day interrupt OB is still being processed when the 
start event for its next execution occurs.

The operating system then calls time error interrupt OB 80. 
The requested OB is processed only after the processing and 
further execution of the current time-of-day interrupt OB has 
completed.

 

Start information
A time-of-day interrupt OB has the following start information:

Tag Data type Description
CaughtUp BOOL =1, if the OB call is executed because clock time is turned ahead.
SecondTime BOOL =1 if the OB is called a second time because clock time is turned back (more 

exactly,  if the planned time of the current OB processing is earlier than or the 
same time as the planned time for the previous OB processing).
Note: SecondTime is only set once.

Organization block for status interrupts

Description     
When it receives a status interrupt, the operating system of the S7-1200 CPU calls the status 
interrupt OB from a DP master or IO controller. This may be the case if a module of a slave 
changes its operating mode, for example, from "RUN" to "STOP". For more detailed information 
on events that trigger a status interrupt, refer to the documentation of the slave or device 
manufacturer.
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Structure of the start information
The status-interrupt OB has the following start information:

Name Data type Meaning
LADDR HW_IO Hardware address of the component triggering the interrupt
Slot UINT Slot number of the component triggering the interrupt
Specifier WORD Interrupt specifier from the interrupt frame

See also
Events and OBs (Page 848)

Organization block for update interrupts

Description     
When it receives a status interrupt, the operating system of the S7-1200 CPU calls the update 
interrupt OB from a DP master or IO controller. This may be the case if you changed a 
parameter on a slot of a slave or device. For more detailed information on events that trigger 
an update interrupt, refer to the documentation of the slave or device manufacturer.

Structure of the start information
The update interrupt OB has the following start information:

Name Data type Meaning
LADDR HW_IO Hardware address of the component triggering the interrupt
Slot UINT Slot number of the component triggering the interrupt
Specifier WORD Interrupt specifier from the interrupt frame

See also
Events and OBs (Page 848)

Organization block for manufacturer-specific or profile-specific interrupts

Description     
When it receives a manufacturer-specific or profile-specific interrupt from a DP master or IO 
controller, the operating system of the S7-1200 CPU calls OB 57. For more detailed information 
on events that trigger this type of interrupt, refer to the documentation of the slave or device 
manufacturer.
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Structure of the start information
The OB for manufacturer-specific and profile-specific interrupts has the following start 
information:

Name Data type Meaning
LADDR HW_IO Hardware address of the component triggering the interrupt
Slot UINT Slot number of the component triggering the interrupt
Specifier WORD Interrupt specifier from the interrupt frame

See also
Events and OBs (Page 848)

Organization blocks for time-delay interrupts

Description   
A time-delay interrupt OB is started after a configurable time delay of the operating system. 
The delay time starts after the SRT_DINT instruction is called.

You can use up to four time-delay interrupt OBs or cyclic OBs (OB numbers >= 123) in your 
program. If, for example, you are already using two cyclic interrupt OBs, you can insert a 
maximum of two further time-delay interrupt OBs in your program.

You can use the CAN_DINT instruction to prevent the execution of a time-delay interrupt that 
has not yet started.

Function of time-delay interrupt OBs
The operating system starts the corresponding OB after the delay time, which you have 
transferred with an OB number and an identifier to the SRT_DINT instruction.

To use a time-delay interrupt OB, you must execute the following tasks:

● You must call the instruction SRT_DINT.

● You must download the time-delay interrupt OB to the CPU as part of your program.

The delay time is measured with a precision of 1 ms. A delay time can immediately start again 
after it expires.

Time delay interrupt OBs are executed only when the CPU is in the "RUN" mode. A warm 
restart clears all start events of time-delay interrupt OBs. 

The operating system calls the time-delay interrupt OB if one of the following events occurs:

● If the operating system attempts to start an OB that is not loaded and you specified its 
number when calling the SRT_DINT instruction.

● If the next start event for a time-delay interrupt occurs before the time delay OB has 
completely executed.
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You can disable and re-enable time-delay interrupts using the DIS_AIRT and EN_AIRT 
instructions.

 

 Note

If you disable an interrupt with DIS_AIRT after executing SRT_DINT, this interrupt executes 
only after it has been enabled with EN_AIRT. The delay time is extended accordingly.

 

 

Start information
● None

● Optimized start information:

Name Data type Meaning
sign WORD User ID: Input parameter SIGN from the call of the "SRT_DINT" instruction

See also
Events and OBs (Page 848)

Organization blocks for cyclic interrupts

Description   
Cyclic interrupt OBs serve to start program in periodic time intervals independently of the cyclic 
program execution. The start times of a cyclic interrupt OB are specified using the time base 
and the phase offset. 

The time base defines the intervals at which the cyclic interrupt OB is started and is an integer 
multiple of the basic clock cycle of 1 ms. The phase offset is the time by which the start time 
is offset compared with the basic clock cycle. If several cyclic interrupt OBs are being used, 
you can use this offset to prevent a simultaneous start time if the time bases of the cyclic 
interrupt OBs have common multiples.

You can specify a time period between 1 ms and 60000 ms as the time base. 

You can use up to four cyclic interrupt OBs or time-delay OBs (OB numbers >= 123) in your 
program. If, for example, you are already using two time-delay interrupt OBs, you can insert a 
maximum of two further cyclic interrupt OBs in your program.

 

 Note

The execution time of each cyclic interrupt OB must be noticeably smaller than its time base. 
If a cyclic interrupt OB has not been completely executed but execution is again pending 
because the cycle clock has expired, the time error OB is started. The cyclic interrupt that 
caused the error is executed later or discarded. 
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Example of the use of phase offset
You have inserted two cyclic interrupt OBs in your program:

● Cyclic interrupt OB1

● Cyclic interrupt OB2

For cyclic interrupt OB1, you have set a time base of 20 ms and for cyclic interrupt OB2 a time 
base of 100 ms. After expiration of the time base of 100 ms, the cyclic interrupt OB1 reaches 
the start time for the fifth time, cyclic interrupt OB2 for the first time. To nevertheless execute 
the cyclic interrupt OBs offset, enter a phase offset for one of the two cyclic interrupt OBs.

Start information
● None

● Optimized start information:

Name Data type Meaning
first_scan BOOL = TRUE in the first call of this OB

● At the transition from STOP or HOLD to RUN
● After reloading

event_count INT Number of lost start events since the last start of this OB

See also
Assigning parameters to cyclic interrupt OBs (Page 899)

Events and OBs (Page 848)

Organization blocks for hardware interrupts

Description   
You can use hardware interrupt OBs to react to specific events. You can assign an event that 
triggers an alarm to precisely one hardware interrupt OB. A hardware interrupt OB in contrast 
can be assigned to several events.

Hardware interrupts can be triggered by high-speed counters and input channels. For each 
high-speed counter and input channel that should trigger a hardware interrupt, the following 
properties need to be configured:

● The process event that should trigger the hardware interrupt (for example, the change of 
a count direction of a high-speed counter)

● The number of the hardware interrupt OB which is assigned to this process event

You can use up to 50 hardware interrupt OBs (OB numbers >= 123) that are independent of 
each other in your program.
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Functionality of a hardware interrupt OB
After triggering a hardware interrupt, the operating system identifies the channel of the input 
or the high-speed counter and determines the assigned hardware interrupt OB.

If no other interrupt OB is active, the determined hardware interrupt OB is called. If a different 
interrupt OB is already being executed, the hardware interrupt is placed in the queue of its 
priority class. The hardware interrupt is acknowledged after the completion of the assigned 
hardware interrupt OB.

If another event that triggers a hardware interrupt occurs on the same module during the time 
between identification and acknowledgement of a hardware interrupt, the following applies:

● If the event occurs on the channel that previously triggered the hardware interrupt, then no 
additional hardware interrupt is triggered. Another hardware interrupt can only be triggered 
if the current hardware interrupt is acknowledged.

● If the event occurs on a different channel, a hardware interrupt is triggered.

Hardware interrupt OBs are called only in the CPU's "RUN" mode.

Start information
● None

● Optimized start information:

Name Data type Meaning
Laddr HW_IO Hardware identifier of the module that triggers the hardware interrupt
USI WORD Identifier for future extensions (not user-relevant)
IChannel USINT Number of the channel that triggered the hardware interrupt
EventType BYTE Identifier for the event type associated with the event triggering the 

interrupt (e.g., positive edge)
This identifier can be found in the description of the respective module.

See also
Assigning parameters to hardware interrupt OBs (Page 900)

Events and OBs (Page 848)

Organization block for time error

Description     
The operating system calls the time error OB (OB 80) if one of the following events occurs:

● The cyclic program exceeds the maximum cycle time.

● The OB called is currently still being executed (possible for time-delay interrupt OBs and 
cyclic interrupt OBs).

● A time-of-day interrupt was missed because the clock time was set forward by more than 
20 seconds.
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● A time-of-day interrupt was missed during a STOP.

● An overflow has occurred in an interrupt OB queue.

● An interrupt was lost due to the excessive interrupt load.

If you have programmed no time error OB, the S7-1200 CPU reacts as follows:

● CPUs with firmware version V1.0: The CPU remains in RUN mode.

● CPUs with firmware version V2.0:

– The CPUs goes to STOP mode when the maximum cycle time is exceeded.

– With all other start events of the time error OB, the CPU remains in RUN mode.

With CPUs with firmware version V1.0, the two-time overshooting of the maximum cycle time 
does not lead to the calling of an OB, but to the STOP of the CPU. You can avoid the second 
violation by restarting the cycle monitoring of the CPU with the RE_TRIGR instruction.

You can use only one time error OB in your program.

Start information
The time error OB has the following start information:

Tag Data type Description
fault_id BYTE ● 0x01: Maximum cycle time exceeded

● 0x02: Called OB is still being executed
● 0x05: Expired time-of-day interrupt due to time jump
● 0x06: Expired time-of-day interrupt on return to RUN mode
● 0x07: Queue overflow
● 0x09: Interrupt loss due to high interrupt load

csg_OBnr OB_ANY Number of the OB being executed at the time of the error
csg_prio UINT Priority of the OB being executed at the time of the error

See also
Events and OBs (Page 848)

Organization block for diagnostic interrupts

Description   
You can enable the diagnostic error interrupt for diagnostics-capable modules so that the 
module detects changes in the I/O status. As a result, the module triggers a diagnostic error 
interrupt in the following cases:

● A fault is present (incoming event)

● A fault is no longer present (outgoing event)
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If no other interrupt OB is active, then the diagnostic interrupt OB (OB 82) is called. If another 
interrupt OB is already being executed, the diagnostic error interrupt is placed in the queue of 
its priority group. 

You can use only one diagnostic interrupt OB in your program.

Start information
The diagnostic interrupt OB has the following start information:

Tag Data type Description
IO_state WORD Contains the I/O status of the diagnostics-

capable module. 
laddr HW_ANY HW-ID
Channel UINT Channel number
multi_error BOOL = 1, if there is more than one error

IO_state tag
The following table shows the possible I/O states that the IO_state tag can contain:

IO_state Description
Bit 0 Configuration correct:

= 1, if the configuration is correct
= 0, if the configuration is no longer correct

Bit 4 Error:
= 1, if an error is present, e.g., a wire break
= 0, if the error is no longer present

Bit 5 Configuration not correct:
= 1, if the configuration is not correct
= 0, if the configuration is correct again 

Bit 6 I/O cannot be accessed:
= 1, if an I/O access error has occurred
In this case, laddr contains the hardware identifier of the I/O with the access error. 
= 0, if the I/O can be accessed again

See also
Events and OBs (Page 848)
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Organization block for pulling and plugging

Description    
The S7-1200 CPU operating system calls the pull/plug interrupt OB (OB 83) if a configured 
and non-disabled distributed I/O module or submodule (PROFIBUS, PROFINET, AS-i) is 
removed or inserted.

 

 Note

The removal or insertion of a central module leads to the STOP of the CPU.
 

Start information
The pull/plug interrupt OB has the following start information:

Name Data type Meaning
LADDR HW_IO Hardware identifier of the affected module or submodule
Event_Class BYTE ● B#16#38: (Sub)module plugged

● B#16#39: (Sub)module pulled or not responding
Fault_ID BYTE Error code (possible values: B#16#51, B#16#54, B#16#55, 

B#16#56, B#16#57, B#16#58)

The following table shows which event caused the start of the pull/plug interrupt OB.

ev_class (B#16# ...) fault_id (B#16# ...) Meaning
39 51 Module pulled
39 54 Submodule pulled
38 54 Submodule plugged, which conforms to the 

parameterized submodule
38 55 Submodule inserted, which does not conform to 

the submodule parameter assignment
38 56 Submodule inserted, but error in module 

parameter assignment
38 57 Submodule or module inserted, but with a fault or 

maintenance
38 58 Submodule access error remedied

See also
Events and OBs (Page 848)
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Organization block for rack fault

Description   
The S7-1200 CPU operating system calls the OB 86 in the following cases:

● The failure of a DP master system or of a PROFINET IO system is detected (in the case 
of either an incoming or an outgoing event).

● The failure of a DP slave or of an IO device is detected (in the case of either an incoming 
or an outgoing event).

● Failure of some of the submodules of a PROFINET I-device is detected.

Structure of the start information
The rack fault OB has the following start information:

Name Data type Meaning
LADDR HW_IO Hardware identifier of the defective hardware object
Event_Class BYTE ● B#16#32: Activation of a DP slaves or an IO device

● B#16#33: Deactivation of a DP slaves or an IO device
● B#16#38: outgoing event
● B#16#39: incoming event

Fault_ID BYTE Error code (possible values: B#16#C3, B#16#C4, B#16#C5, 
B#16#C6, B#16#C7, B#16#C8, B#16#C9, B#16#CA, B#16#CB, 
B#16#CC, B#16#CD, B#16#CE, B#16#CF, B#16#F8, B#16#F9)

The following table shows which event caused the start of OB 86.

Ev_class
B#16# ...

Fault_id
B#16# ...

Meaning

39 C3 Failure of a DP master system
39/38 C4 Failure/return of a DP slave
38 C5 Return of a DP slave; however, slave is faulty
38 C6 Expansion unit return, but error in module parameter assignment
38 C7 Return of a DP device, but there is error in module configuration
38 C8 Return of a DP device, but discrepancy between preset/actual configuration
32/33 C9 Activation/deactivation of a DP slave with the "D_ACT_DP" instruction
39 CA Failure of a PROFINET IO system
39/38 CB Failure/return of a PROFINET IO device
38 CC Return of a PROFINET IO device with fault or maintenance
38 CD Return of a PROFINET IO device, deviation between preset/actual 

configuration
38 CE Return of a PROFINET IO device, error in module configuration
32/33 CF Activation/deactivation of an IO device with the "D_ACT_DP" instruction
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Ev_class
B#16# ...

Fault_id
B#16# ...

Meaning

39/38 F8 Failure/return of some of the submodules of a PROFINET I-device
38 F9 Return of some of the submodules of a PROFINET I-device with a device 

configuration difference

See also
Events and OBs (Page 848)

Block parameters of organization blocks

Basics of block parameters

Introduction   
Several organization blocks (OBs) have properties with which you can control their behavior 
or their assignment to specific events. You can influence these properties by assigning 
parameters.

Overview
You can assign parameters to the properties for the following organization blocks:

● Time-of-day interrupt OBs

● Cyclic interrupt OBs

● Hardware interrupt OBs

 

See also
Assigning parameters to hardware interrupt OBs (Page 900)

Assigning parameters to cyclic interrupt OBs (Page 899)

Parameter assignment for time-of-day interrupt OBs

Procedure for setting the parameters
To set the parameters of a time-of-day interrupt OB, proceed as follows:

1. Open the "Properties" dialog belonging to the time-of-day interrupt OB in question.

2. Click the "Time-of-day interrupt" group in the area navigation.
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Overview of the parameters that can be set 
You can set the following parameters:

● Execution

● Start date and time-of-day

● Option buttons "Local time" and "System time"

"Execution" parameter
Use the drop-down list "Execution" to define the periods at which the time-of-day interrupt OB 
is to be executed. The time intervals relate to the settings for "Start date" and "Time-of-day".

The following values are possible for "Execution":

● Never

● Once

● Every minute

● Hourly

● Daily

● Weekly

● Monthly

● Yearly

● End of month
 

  Note

With the value "End of month", the value specified under "Start date" is irrelevant.
 

"Start date" and "Time-of-day" parameter
Here, you specify the time at which the time-of-day interrupt is to be executed for the first time.

Example: Start date = 07/05/2013, time =11:16

Depending on the value of the "Execution" parameter, the CPU generates additional time-of-
day interrupts periodically. Depending on the setting, the start time relates either to the local 
time or to the coordinated universal timeUTC.

 

 Note

If you set the "Execution" parameter to "Monthly", the start date cannot be set to the 29th, 
the 30th, or the 31st. If you want the time-of-day interrupt OB to start at the end of the month, 
you should set the parameter "Execution" to "End of month".
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"Local time" or "System time"
Here, you decide which time the start time of the time-of-day interrupt OB relates to:

● "Local time": The start time relates to the time zone set for the CPU.

● "System time": The start time relates to the coordinated universal time UTC (Universal Time 
Coordinated).

Assigning parameters to cyclic interrupt OBs

Introduction  
You can use cyclic interrupt OBs to start programs at regular time intervals. To do so you must 
enter a scan time and a phase shift for each cyclic interrupt OB used.

You can use up to four cyclic interrupt OBs or time-delay OBs (OB numbers >= 200) in your 
program. If, for example, you are already using two time-delay interrupt OBs, you can insert a 
maximum of two further cyclic interrupt OBs in your program.

 

 Note

If you assign multiple cyclic OBs, make sure that you assign a different cycle time or phase 
offset to each cyclic interrupt OB to avoid them executing at the same time or having to queue. 
When you create a cyclic interrupt OB, the cycle time 100 and the phase offset 0 are entered 
as start value.

 

Procedure
To enter a scan time and a phase shift for a cyclic interrupt OB, proceed as follows:

1. Open the "Program blocks" folder in the project tree.

2. Right-click on an existing cyclic interrupt OB.

3. Select the "Properties" command in the shortcut menu.
The "<Name of the cyclic interrupt OB>" dialog box opens.

4. Click the "Cyclic interrupt" group in the area navigation.
The text boxes for the scan time and the phase shift are displayed.

5. Enter the scan time and the phase shift.

6. Confirm your entries with "OK".

 

 

See also
Basics of block parameters (Page 897)

Organization blocks for cyclic interrupts (Page 890)
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Assigning parameters to hardware interrupt OBs

Introduction    
You must select the corresponding event and assign the following parameters for every input 
channel and high-speed counter that should trigger a hardware interrupt:

● Event name

● Number of the hardware interrupt OB that is assigned to this process event

The parameters of the hardware interrupt are assigned in the properties of the corresponding 
device. You can assign parameters for up to 50 hardware interrupt OBs.

You can create the hardware interrupt OB to be assigned parameters either before or during 
activation of an event. 

Procedure
To configure a hardware interrupt event, follow these steps:

1. Double-click the "Devices & Networks" command in the project tree.
The hardware and network editor opens in the network view.

2. Change to the device view.

3. If the Inspector window closed in the device view, select the "Inspector window" check box 
in the "View" menu.
The Inspector window opens.

4. Click the "Properties" tab.

5. In the device view, select the module for which you want to a assign a hardware interrupt.

6. Select the corresponding event that will trigger a hardware interrupt, e.g., a positive edge.

7. Enter an event name.

8. Select an existing hardware interrupt OB from the "Hardware interrupt" drop-down list or 
create a new hardware interrupt OB. If you have not previously created any hardware 
interrupt OBs, you can click the "Add new block" button in the drop-down list.
The start information of the corresponding hardware interrupt OB, including all 
specifications for the interrupt-triggering event, is updated. 

9. If you want to assign further hardware interrupts, repeat steps 5 to 8.
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A system constant of data type Event_HwInt is created automatically for the event identified 
by the explicit event name. The system constants are displayed in the standard tag table. 

 

See also
Basics of block parameters (Page 897)

Organization blocks for hardware interrupts (Page 891)

Events and OBs (Page 848)

Symbolic and numerical names of instructions

Description
The instructions from the task card are comprised of functions (FC), function blocks (FB), 
system functions (SFC) and system function blocks (SFB) that are identified internally by 
numbers.

The following tables show the assignment of numerical and symbolic names.

Function blocks (FBs)

Numerical name Symbolic name
FB 105 TC_CONFIG
FB 110 Port_Config
FB 111 Send_Config
FB 112 Receive_Config
FB 113 Send_P2P
FB 114 Receive_P2P
FB 115 Receive_Reset
FB 116 Signal_Get
FB 117 Get_Features
FB 118 Set_Features
FB 163 TC_SEND
FB 164 TC_RECV
FB 165 TC_CON
FB 166 TC_DISCON
FB 804 SET_TIMEZONE
FB 1030 TSEND_C
FB 1031 TRCV_S
FB 1071 USS_DRIVE
FB 1080 MB_COMM_LOAD
FB 1081 MB_MASTER
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Numerical name Symbolic name
FB 1082 MB_SLAVE
FB 1084 MB_CLIENT
FB 1085 MB_SERVER
FB 1100 MB_Halt
FB 1101 MC_Home
FB 1102 MC_MoveAbsolute
FB 1103 MC_MoveJog
FB 1104 MC_MoveRelative
FB 1105 MC_MoveVelocity
FB 1107 MC_Power
FB 1108 MC_Reset
FB 1110 MC_MoveInterrupt
FB 1111 MC_ChangeDynamik
FB 1112 MC_CommandTable
FB 1113 MC_MoveLinearAbs_2D
FB 1114 MC_MoveLinearRel_2D
FB 1115 MC_MoveCircular_2D
FB 1130 PID_Compact
FB 1134 PID_3Step
FB 1140 HSC
FB 2040 RecipeCreate
FB 2041 RecipeOpen
FB 2042 RecipeRead
FB 2043 RecipeWrite
FB 2044 RecipeAppend
FB 2045 RecipeClose

Functions (FCs)

Numerical name Symbolic name
FC 2 (1) CONCAT
FC 4 (1) DELETE
FC 11 (1) FIND
FC 17 (1) INSERT
FC 20 (1) LEFT
FC 21 (1) LEN
FC 22 (1) LIMIT
FC 25 (1) MAX
FC 26 (1) MID
FC 27 (1) MIN
FC 31 (1) REPLACE
FC 32 (1) RIGHT
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Numerical name Symbolic name
FC 36 (1) ENCO
FC 36 (1) SEL
FC 37 DECO
FC 800 LED
FC 801 IM_DATA
FC 802 DeviceStates
FC 803 ModuleStates
FC 1070 USS_PORT
FC 1072 USS_RPM
FC 1073 USS_WPM
(1) MC7+ instruction

System data types (SDTs)

Numerical name Symbolic name
SDT 99 WWW_CDB
SDT 513 CONDITIONS
SDT 581 Send_Conditions
SDT 582 Receive_Conditions

System function blocks (SFBs)

Numerical name Symbolic name
SFB 0 (1) CTU
SFB 1 (1) CTD
SFB 2 (1) CTUD
SFB 3 (1) TP
SFB 4 (1) TON
SFB 5 (1) TOF
SFB 27 START_OB
SFB 52 RDREC
SFB 53 WRREC
SFB 54 RALRM
SFB 105 T_CONFIG
SFB 106 TDIAG
SFB 107 TRESET
SFB 110 PORT_CFG
SFB 111 SEND_CFG
SFB 112 RCV_CFG
SFB 113 SEND_PTP
SFB 114 RCV_PTP
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Numerical name Symbolic name
SFB 115 SGN_GET
SFB 116 SGN_SET
SFB 117 RCV_RST
SFB 120 CTRL_HSC
SFB 122 CTRL_PWM
SFB 140 DataLogCreate
SFB 141 DataLogOpen
SFB 142 DateLogWrite
SFB 143 DataLogClear
SFB 144 DataLogClose
SFB 145 DataLogDelete
SFB 146 DataLogNewFile

System functions (SFCs)

Numerical name Symbolic name
SFC 7 DP_PRAL
SFC 11 DPSYC_FR
SFC 13 DPNRM_DG
SFC 14 DPRD_DAT
SFC 16 RD_OBINF
SFC 23 DEL_DB
SFC 28 SET_TINT
SFC 29 CAN_TINT
SFC 30 ACT_TINT
SFC 31 QRY_TINT
SFC 32 SRT_DINT
SFC 33 CAN_DINT
SFC 34 QRY_DINT
SFC 41 DIS_AIRT
SFC 42 EN_AIRT
SFC 43 RE_TRIGR
SFC 45 DE_ACT
SFC 46 STP
SFC 82 CREA_DBL
SFC 83 READ_DBL
SFC 84 WRIT_DBL
SFC 86 CREATE_DB
SFC 89 RST_EVOV
SFC 99 WWW
SFC 101 RTM
SFC 117 GET_DIAG
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Numerical name Symbolic name
SFC 124 ATTR_DB
SFC 140 IO2MOD
SFC 143 RD_ADDR
SFC 154 RD_LOC_T
SFC 154 DPWR_DAT
SFC 161 WR_LOC_T
SFC 180 ID2LOG
SFC 181 LOG2ID
SFC 182 ID2GEO
SFC 190 SET_CINT
SFC 191 QRY_CINT
SFC 192 ATTACH
SFC 193 DETACH
MC7+ Anweisung GET_ERROR
MC7+ Anweisung GET_ERR_ID

Useful information on CPU firmware versions and STEP 7 versions
CPUs and engineering software for configuring the CPUs is constantly developed further to 
improve performance and security. New versions that have some special features with respect 
to the interaction of the components are created in this way. The sections below describe the 
special features of the S7-1200 CPUs with firmware version V4 as compared to firmware 
versions V1 to V3. 

Required engineering software
S7-1200 CPUs V4 can be configured with STEP 7 as of V12 Service Pack 1.

Compatibility between memory card content and firmware version of the CPU
Memory cards with configuration and program for an S7-1200 CPU V1, V2 or V3 do not work 
with an S7-1200 CPU V4. 
Memory cards with configuration and program for an S7-1200 CPU V4 do not work with an 
S7-1200 CPU V1, V2 or V3. 

When you insert the memory card into a CPU with an incompatible firmware version, the CPU 
does not start up. When you insert a memory card for a CPU V1, V2 or V3 into an S7-1200 
CPU V4, this CPU outputs a version error. 

Going online and loading
When you have configured an S7-1200 CPU with firmware version V1, V2 or V3 with STEP 
7, the CPU to which you want to go online or which you want to download must have one of 
these firmware versions. You cannot go online to an S7-1200 CPU V4 with a configured 
S7-1200 CPU V1, V2 or V3.   
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On the other hand, you cannot go online to an S7-1200 CPU V1, V2 or V3 with a configured 
S7-1200 CPU V4 or download this CPU.

Replacing an existing CPU
If you want to replace an existing S7-1200 CPU V1, V2 or V3 in your plant with a new CPU 
with a firmware version greater than or equal to 4, you have to configure and assign parameters 
for the hardware for this CPU in STEP 7. You transfer the blocks of the user program, the tags 
and the data types from the existing CPU or the existing project. 

You cannot apply an existing configuration. 

Communication with HMI devices
When you connect an HMI device to an S7-1200 CPU V4, make sure that you use the 
appropriate Runtime software version of the HMI device. 

You may have to transfer the latest HMI Runtime version by means of the WinCC engineering 
software. 

See also
Useful information on memory cards (Page 841)

8.1.6.2 Distributed I/O

Distributed I/O systems

SIMATIC ET 200 - The right solution for all applications
SIMATIC ET 200 provides the most varied range of distributed I/O systems.

● Solutions for use in the control cabinet 

● Solutions without control cabinet directly at the machine

Additionally, there are also components that can be used in explosive areas. SIMATIC ET 200 
systems for construction without a control cabinet are contained in robust, glass-fibre 
reinforced plastic casing and are therefore shock-resistant, resistant to dirt and watertight.

Their modular design allows the ET 200 systems to be easily scaled and expanded in small 
steps. Fully-integrated auxiliary modules lower costs and also provide a wide range of possible 
applications. There are several combination possibilities available:

● Digital and analog I/OS

● Intelligent modules with CPU functions,

● Safety technology,

● Pneumatics,
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● Frequency converters

● Various technology modules.

Communication via PROFIBUS and PROFINET, uniform engineering, clear diagnostic 
possibilities as well as optimal connection to SIMATIC controller and HMI devices vouch for 
the unique consistency provided by Totally Integrated Automation.

The following table provides an overview of I/O devices for use in the control cabinet:           

I/O device Properties
ET 200S ● Highly modular design with multiple conductor 

connections
● Multifunctional due to a wide range of modules
● Use in explosive areas (Zone 2)

ET 200S COMPACT ● Highly modular design with multiple conductor 
connections

● Multifunctional due to a wide range of modules
● Use in explosive areas (Zone 2)
● Integrated DE/DA

ET 200L ● Cost-effective digital block I/OS
● Digital electronic blocks up to 32 channels

ET 200M ● Modular design with standard modules from 
SIMATIC-S7-300

● Failsafe I/O modules
● Use in explosive areas up to Zone 2, sensors 

and actuators up to Zone 1
● High level of plant availability, for example by 

plugging and unplugging when in operation
ET 200iSP ● Modular design, also possible with redundancy

● Robust and intrinsically safe design
● Use in explosive areas up to Zone 1/21; 

sensors and actuators even up to Zone 0/20
● High level of plant availability, for example by 

plugging and unplugging when in operation

 

The following table provides an overview of I/O devices for use without a control 
cabinet:         
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I/O device Properties
ET 200pro ● Modular design with compact housing

● Easy assembly
● Multifunctional due to a wide range of modules
● High level of availability due to plugging and 

unplugging in operation and permanent wiring
● Comprehensive diagnostics

ET 200eco PN ● Cost-efficient, space-saving block I/OS
● Digital modules up to 16 channels (also 

configurable)
● Analog modules, IO-link master and load 

voltage distributor
● PROFINET connection with 2-port switch in 

each module
● Can be flexibly distributed via PROFINET in 

line or star shape directly within the plant
ET 200eco ● Cost-effective digital block I/OS

● Flexible connection possibilities
● Failsafe modules
● High level of plant availability

ET 200R ● Specially for use on robots
● Assembled directly on the chassis
● Resistant to weld spatter due to robust metal 

housing

 

See also
Documentation on ET 200L (http://support.automation.siemens.com/WW/view/de/1142908/0/
en)

Documentation on ET 200S (http://support.automation.siemens.com/WW/view/en/1144348)

Documentation on ET 200M (http://support.automation.siemens.com/WW/view/de/1142798/0/
en)

Documentation on ET 200pro (http://support.automation.siemens.com/WW/view/de/
21210852/0/en)

Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)

Documentation on ET 200R (http://support.automation.siemens.com/WW/view/de/
11966255/0/en)

Documentation on ET 200eco PN (http://support.automation.siemens.com/WW/view/de/
29999018/0/en)

Documentation on ET 200eco  (http://support.automation.siemens.com/WW/view/de/
12403834/0/en)
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ET 200iSP

ET 200iSP Distributed I/O Station

Definition  
The ET 200iSP distributed I/O station is a highly modular and intrinsically safe DP slave with 
degree of protection IP 30.

Area of application
The ET 200iSP distributed I/O station can be operated in potentially explosive atmospheres 
characterized by gas and dust:

Approval ET 200iSP Station* Inputs and outputs
ATEX
IECEx

Zone 1, Zone 21 up to Zone 0, Zone 20 **
Zone 2, Zone 22 up to Zone 0, Zone 20 **

* In combination with an appropriate enclosure
** for electronic module 2 DO Relay UC60V/2A: up to Zone 1, Zone 21

The ET 200iSP distributed I/O station can, of course, also be used in the safety area.

You can insert almost any combination of ET 200iSP I/O modules directly next to the interface 
module that transfers the data to the DP master. This means you can adapt the configuration 
to suit your on-site requirements.

Every ET 200iSP consists of a power supply module, an interface module and a maximum of 
32 electronic modules (for example digital electronics modules). Remember not to exceed the 
maximum current consumption.

Terminal modules and electronic modules  
In principle, the ET 200iSP distributed I/O station consists of various passive terminal modules 
onto which you plug the power supply and the electronic modules.

The ET 200iSP is connected to PROFIBUS RS 485-IS by means of a connector on terminal 
module TM-IM/EM. Every ET 200iSP is a DP slave on the PROFIBUS RS 485‑IS. 

DP master  
All ET 200iSP modules support communication with DP masters that are compliant with 
IEC 61784-1:2002 Ed1 CP 3/1 and operate with "DP" transmission protocol (DP stands for 
distributed peripherals or distributed I/O).  

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)
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Assigning the channel and IEEE tag

Properties  
Analog electronic modules 4 AI I 2WIRE/HART, 4 AI I 4WIRE/ HART and 4 AO I HART support 
up to four IEEE tags. 

The process input image (PII) provides up to 20 bytes per module for the IEEE tags. Thus, 
four blocks of 5 bytes each are available for the four IEEE tags within the PII.

Requirements
The HART field device must support the assigned number of IEEE tags.
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Assigning IEEE tags 
You assign the IEEE tags of the field devices to any one of the four blocks in the PII.

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)
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Assigning parameters to reference junctions for thermocouples

Compensation of the reference junction temperature 
There are various ways of obtaining the reference junction temperature in order to get an 
absolute temperature value from the temperature difference between the reference junction 
and the measuring point.

Table 8-49 Compensation of the reference junction temperature

Option Explanation Reference junction parameters
No compensation You record not only the temperature of 

the measurement point. The 
temperature of the reference junction 
(transition from Cu line to thermocouple 
line) also affects the thermo-
electromotive force. The measured 
value then includes an error.

None

Use of a Pt100 
Climatic Range 
resistance 
thermometer to 
record the reference 
junction temperature 
(best method)

You can record the reference junction 
temperature using a resistance 
thermometer (Pt100 Climatic Range). If 
parameterized accordingly, this 
temperature value is distributed to the 4 
AI TC modules in the ET 200iSP where 
it is offset against the temperature value 
obtained at the measuring location.
Number of reference junctions: 2

The parameter assignment of the IM 
152 and the 4 AI TC must be 
coordinated:
● 4 AI RTD assigned parameters 

for Pt100 climatic range in 
correct slot;

● 4 AI TC: Reference junction : 
"yes"; select reference junction 
number "1" or "2"

● IM 152-1:Assignment of the 
reference junction to a slot with 4 
AI RTD; channel selection;

Internal 
compensation 4 AI 
TC

The TC sensor module (temperature 
sensor) is mounted onto the terminals of 
terminal module EM 4 AI TC. The 
temperature sensor reports the 
temperature of the terminals to the 4 AI 
TC. This value is then calculated 
together with the measured value from 
the channel of the electronic module.

● 4 AI TC: Reference junction 
number "internal"

Compensation by means of a resistance thermometer at the 4 AI RTD 
If thermocouples that are connected to the inputs of the 4 AI RTD have the same reference 
junction, compensate by means of a 4 AI RTD.

For both channels of the 4 AI TC module, you can select "1", "2" or "internal" as the reference 
junction number. If you select "1" or "2", the same reference junction (RTD channel) is always 
used for all four channels.
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Setting parameters for the reference junction 
You set the reference junctions for the 4 AI TC electronic modules by means of the following 
parameters:

Table 8-50 Reference junction parameters

Parameter Module Range of values Explanation
Slot reference junction 1 to slot 2 IM 152 none, 4 to 35 With this parameter, you can assign up to 2 

slots (none, 4 to 35), on which the channels 
for reference temperature measurement 
(calculating the compensation value) are 
located.

Input reference junction 1 to 4 
input reference junction  

IM 152 RTD on channel 0
RTD on channel 1
RTD on channel 2
RTD on channel 3

This parameter allows you to set the channel 
(0/1/2/3) for measuring the reference 
temperature (calculation of the 
compensation value) for the assigned slot. 

Reference junction E0 to 
reference junction E3

4 AI TC None
yes

This parameter allows you to enable the use 
of the reference junction.

Reference junction number 4 AI TC 1
2
Internal

This parameter allows you to assign the 
reference junction (1, 2) that contains the 
reference temperature (compensation 
value).

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)

Fundamentals of Time Stamping

Properties 
Time stamping is possible with the IM 152 in customer applications using FB 62 (FB 
TIMESTMP). 

Principle of operation 
A modified input signal is assigned a time stamp and stored in a buffer (data record). If time 
stamped signals exists or a data record is full, a hardware interrupt is generated to the DP 
master. The buffer is evaluated with "Read data record". Special messages are generated for 
events that influence the time stamping (communication with the DP master interrupted, frame 
failure of time master, ...).
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Parameter Assignment
With the parameter assignment you define which IM 152 user data will be monitored. For the 
time stamping these are digital inputs that are monitoring for signal changes.

Parameter Setting Description
Time stamping ● disabled

● enabled
Activate the time staming for the 
channels of the electronics module 8 
DI NAMUR.

Edge evaluation 
incoming event

● rising edge
● falling edge

Determine the type of signal change 
that will be time-stamped.

Counting

Count properties

Counting functions
The 8 DI NAMUR electronics module has configurable counting functions:

● 2 x 16-bit up counters (standard counting function) or

● 2 x 16-bit down counters (standard counting function) or

● 1 x 32-bit down counter (cascading counter function)

● Setting a setpoint with the PIQ

● GATE function

● You can configure the control signals of the counters:

– Configuration channel 0..1: "Counter", channel 2..7: "DI": Two counters are configured. 
The control signals of the counters are stored in the PIQ (process image output).

– Configuration channel 0..1: "Counter", channel 2..7: "Control": Two counters are 
configured. The control signals of the counters are stored in the PIQ (process image 
output). They are also controlled by the digital inputs of the 8 DI NAMUR. 

See also
Principle of operation (Page 914)

Configuring counters (Page 917)

Assigning parameters to counters (Page 920)

Principle of operation

16-bit up counters (standard counting function)
The counting range is 0 to 65,535. 
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With each count pulse at the digital input, the count is incremented by 1. Once the count limit 
is reached, the counter is reset to 0 and it counts up again from this value.

If there is counter overflow, the corresponding output is set in the PII.

A positive edge of the Reset output control signal resets the output in the PII. This does not 
affect the current count value.

In 16-bit up counting operations, the system does not set any outputs in the PIQ. These are 
always reset.

The positive edge of the Reset counter control signal sets the counter to 0 and resets the set 
counter output.

The GATE control signal pauses the counting on a positive edge. Count pulses are processed 
at the digital input again, but only at the negative edge. The Reset counter control signal is 
also effective when GATE is active.

16-bit down counters (periodic counting function)
The maximum counting range is always 65,535 to 0.

When the counter is started, the actual value is set to the selected setpoint. Each counted 
pulse reduced the actual value by 1. Once the actual value reaches 0, the corresponding output 
in the PII is turned on and the actual value is set to the selected setpoint. The counter then 
counts down from this value.

The positive edge of the Reset counter control signal resets the selected setpoint and the 
corresponding output in the PII.

A positive edge of the Reset output control signal resets the output in the PII. This does not 
affect the current count value.
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The GATE control signal pauses the counting on a positive edge. At the same time, the 
assigned output in the PII is reset. Count pulses are processed at the digital input again, but 
only at the negative edge. The Reset output and Reset counter control signals are also effective 
when GATE is active.

The setpoint of the counter is set and changed using the PIQ. The setpoint is adopted on a 
positive edge of the Reset counter control signal or when the counter has reached zero.

 

32-bit down counter (cascading counter function)   
The maximum counting range is always 4294967295 to 0.

The principle of operation is identical to that of the 16-bit down counter. Channel 1 has no 
function.

See also
Count properties (Page 914)
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Configuring counters

Procedure
1. Using the mouse, pull module 8 DI Namur from the hardware catalog into distributed I/O 

station ET 200iSP.

2. Select the required configuration (channel 0..1: "Counter", channel 2..7: "DI" or "Control"). 
In the module properties (inspector window), you can find this setting under "Parameters 
> Inputs > Configuration".

Configuration channel 0..1: "Counter", channel 2..7: "DI"
● Assignment of the digital inputs on the electronic module 8 DI NAMUR

Table 8-51 Assignment of digital inputs for channel 0..1: "Counter", channel 2..7: "DI": 

Digital input Terminal Assignment
Channel 0 1, 2 Counter 1
Channel 1 5, 6 Counter 2 (does not apply to 32-bit down counters)
Channel 2 9, 10 Digital input 2
Channel 3 13, 14 Digital input 3
Channel 4 3, 4 Digital input 4
Channel 5 7, 8 Digital input 5
Channel 6 11, 12 Digital input 6
Channel 7 15, 16 Digital input 7
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● Assignment of the process image input (PII)

● Assignment of the process image output (PIQ)
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Configuration channel 0..1: "Counter", channel 2..7: "CONTROL"
With this configuration, you can also control the counters over the digital inputs.

● Assignment of the digital inputs on electronic module 8 DI NAMUR
For further information on input assignments, refer to the technical data for electronic 
module 8 DI NAMUR.

Table 8-52 Assignment of the digital inputs for 2 Count/ 6 Control

Digital input Terminal Assignment
Channel 0 1, 2 Counter 1
Channel 1 5, 6 Counter 2 (does not apply to 32-bit down counters)
Channel 2 9, 10 control signal GATE 1
Channel 3 13, 14 control signal GATE 2
Channel 4 3, 4 control signal Reset counter 1
Channel 5 7, 8 control signal Reset counter 2
Channel 6 11, 12 control signal Reset counter output 1
Channel 7 15, 16 control signal Reset counter output 2

● Assignment of the process image input (PII)
Assignment is identical to configuration 0..1: "Counter", channel 2..7: "DI".

● Assignment of the process image output (PIQ)
Assignment is identical to configuration 0..1: "Counter", channel 2..7: "DI".

See also
Count properties (Page 914)
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Assigning parameters to counters

Parameters for the counting function
Only those parameters that are relevant for the counters are explained below. These belong 
to the parameters of electronic module 8 DI NAMUR and depend on the selected configuration:

Table 8-53 Parameters for the counters

Parameter Setting Description
Sensor type counter 
inputs

● Channel disabled
● NAMUR sensor
● Single contact, no load resistance

Select the sensor for the respective 
counter of channels 0 or 1.

Mode for counter 1 ● Standard counting function
● Periodic counting function
● Cascaded counting function

Select the mode for counter 1.

Mode for counter 2 ● Standard counting function
● Periodic counting function
● Cascaded counting function

Select the mode for counter 2. This 
parameter is not relevant if you have 
set the "Mode for counter 1" 
parameter to "Cascaded counter 
function".

See also
Count properties (Page 914)

Frequency measurement

Frequency measurement properties

Properties
The electronic module 8 DI NAMUR allows the frequencies to be measured on channel 0 and 
1:

● 2 frequency meters from 1 Hz to 5 kHz

● Configurable metering window (GATE)

● The signals of the frequency meter are read in by means of the digital inputs of the electronic 
module. 

See also
Principle of operation (Page 921)

Configuring frequency meters (Page 921)

Assigning parameters for the frequency meters (Page 923)
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Principle of operation

Frequency measurement
The signal frequencies are identified from the input signals of channel 0 or 1 of the electronic 
module. To calculate the frequency the signals are measured within a configurable gate.

The frequency is displayed as 16-bit value in fixed-point format and transferred to the PII.

The frequency meter calculates the frequency according to the follow formula:

Exceeding the input frequency
If the input frequency exceeds 5kHz, 7FFFH is reported as actual value. If the input frequency 
is above approx. 8 kHz it is no longer possible to display correct actual values.

See also
Frequency measurement properties (Page 920)

Configuring frequency meters

Procedure
1. Using the mouse, pull module 8 DI Namur from the hardware catalog into distributed I/O 

station ET 200iSP.

2. Select the required configuration (channel 0..1: "Trace", channel 2..7: "DI"). In the module 
properties (inspector window), you can find this setting under "Parameters > Inputs > 
Configuration".

Configuration 0..1: "Trace", channel 2..7: "DI"
Assignment of the digital inputs on electronic module 8 DI NAMUR

Digital input Terminal Assignment
Channel 0 1, 2 Frequency counter 1
Channel 1 5, 6 Frequency counter 2
Channel 2 9, 10 Digital input 2
Channel 3 13, 14 Digital input 3
Channel 4 3, 4 Digital input 4
Channel 5 7, 8 Digital input 5
Channel 6 11, 12 Digital input 6
Channel 7 15, 16 Digital input 7
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Assignment of process image input (PII) for configuration of channel 0..1: "Trace", channel 
2..7: "DI"

Assignment of the process image output (PIQ): The PIQ is not assigned.

See also
Frequency measurement properties (Page 920)
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Assigning parameters for the frequency meters

Parameters for frequency meter
Only those parameters that are relevant for the frequency meters are explained below. These 
are part of the parameters of electronic module 8 DI NAMUR.

Table 8-54 Parameters for the frequency meters 

Parameter Setting Description
Sensor type frequency 
inputs

● Channel disabled
● NAMUR sensor
● Single contact, no load 

resistance

Select the sensor for the relevant frequency 
meter for channel 0 or 1.

Measuring window 
(GATE)

● 50 ms
● 200 ms
● 1 s

Select the required measuring window for 
channel 0 or 1. 
To achieve the highest possible accuracy 
when metering frequencies, remember the 
following rules:
● High frequencies (> 4 kHz): Set a low 

measuring window (50 ms)
● Variable/medium frequencies: set 

medium measuring window (200 ms)
● Low frequencies (< 1 kHz): Set a high 

measuring window (1 s)

See also
Frequency measurement properties (Page 920)

ET 200eco PN

ET 200eco PN Distributed I/O Device

Definition   
The ET 200eco PN distributed I/O device is a compact PROFINET IO device in degree of 
protection IP 65/66 or IP 67 and UL Enclosure Type 4x, Indoor use only.
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Field of application 
The fields of application of the ET 200eco PN are derived from its special properties. 

● A robust design and degree of protection IP 65/66 or IP 67 make the ET 200eco PN 
distributed I/O device suitable in particular for use in rugged industrial environments.

● The compact design of the ET 200eco PN is particularly favorable for applications in 
confined areas.

● The easy handling of ET 200eco PN facilitates efficient commissioning and maintenance.

Properties
The ET 200eco PN has the following properties:

● Integrated switch with 2 ports

● Supported Ethernet services:

– ping

– arp

– Network diagnostics (SNMP)

– LLDP

● Interrupts

– Diagnostics interrupts

– Maintenance interrupts

● Port diagnostics

● Isochronous real-time communication

● Prioritized startup

● Device replacement without programming device

● Media redundancy

● Connection to intelligent sensors/actuators via IO link master interface module.

IO Controller 
The ET 200eco PN can communicate with all IO Controllers that conform to IEC 61158. 

ET 200eco PN can be configured on a CPU with advanced diagnostics.

 

See also
Documentation on ET 200eco PN (http://support.automation.siemens.com/WW/view/en/
29999018)
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Parameter description analog input

Group diagnostics
You can generally enable and disable the diagnostics function of the device with this parameter.

The "Fault" and "Parameter assignment error" diagnostics functions are always independent 
of the group diagnostics.

Diagnostics, missing 1L+
If you enable this parameter, the check for missing supply voltage is enabled.

Diagnostics, sensor supply short circuit  
If you enable this parameter, a diagnostics event is generated if a short-circuit of the sensor 
supply to ground is detected and the channel is enabled. The sensor supply is monitored for 
connectors X1, X3, X5 and X7. It is not possible to differentiate which connector has 
experienced the sensor short circuit.

Interference frequency suppression
With this parameter, you set the integration time of the device, based on the selected 
interference frequency. Select the frequency of the supply voltage used. Interference 
frequency suppression Off means 500 Hz, which corresponds to an integration time of 2 ms 
for a measurement channel.

Temperature unit
Specify the unit of the temperature measurement here.

Measurement type (channel-wise)
With this parameter, you set the measurement type, for example, voltage. For any unused 
channels, you must select the disabled setting. For a disabled channel, the conversion time 
and integration time of the channel = 0 s and the cycle time is optimized.

Measuring range
With this parameter, you set the measuring range of the selected measurement type.

Temperature coefficient (for RTD, thermoresistor)  
The correction factor for the temperature coefficients (α-value) indicates by what extent the 
resistance of specific material changes relatively if the temperature increases by 1 ℃.

The α-values conform to EN 60751, GOST 6651, JIS C 1604 and ASTM E-1137.

The temperature coefficient depends on the chemical composition of the material. 
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Smoothing  
Smoothing of the analog values produces a stable analog signal for further processing. The 
smoothing of analog values is useful when handling wanted signals (measured values) with a 
slow rate of change, for example, temperature measurements.

The measured values are smoothed by digital filtering. To achieve smoothing, the device 
generates a mean value from a specified number of converted (digitized) analog values.

You assign a maximum of four levels for the smoothing (none, weak, medium, strong). The 
level determines the number of module cycles, from which the mean value is generated.

The stronger the smoothing, the more stable the smoothed analog value and the longer it takes 
until the smoothed analog value is applied following a signal change (see the example below).

The figure below shows the number of cycles a module requires to apply the smoothed analog 
value at almost 100% after a step response, based on the smoothing function settings. The 
figure applies to all signal changes at the analog input. The smoothing value defines the 
number of cycles a module requires to reach 63% of the end value of the changed signal.

① Smoothing, weak
② Smoothing, medium
③ Smoothing, strong

Diagnostics, wire break 
When this parameter is enabled, the Wire break diagnostics event is generated when a wire 
break is detected. 

Observe the rules outlined below to handle a wire break in the 1 to 5 V and 4 to 20 mA 
measuring ranges:
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Parameter Event Measured 
value

Explanation

Enable wire break1 Wire break 7FFFH Diagnostics, wire break
Wire break disabled1

 
Underflow enabled

Wire break 8000H Measured value after leaving the 
underrange
 
Diagnostic message Lower limit value 
undershot

Wire break disabled1

Underflow disabled
Wire break 8000H Measured value after leaving the 

underrange
1 Measuring range limits for wire break detection and measuring range undershoot detection:
● 1 to 5 V: At 0.296 V
● 4 to 20 mA: At 1.185 mA

Diagnostics, underflow 
If you enable this parameter, the Underflow diagnostics event is generated when the measured 
value reaches the underflow range.

Diagnostics, overflow 
If you enable this parameter, the Overflow diagnostics event is generated when the measured 
value reaches the overflow range.

Reference junction for thermoresistor (TC) 
A difference in temperature between the measuring point and the free ends of the 
thermocouple (terminal point) generates a voltage between the free ends, namely the 
thermoelectric voltage. The value of this thermoelectric voltage is determined by the 
temperature difference between the measuring point and the free ends and by the type of 
material combination of the thermocouple. Since a thermocouple always measures a 
temperature difference, the free ends at the reference junction must be maintained at a known 
temperature in order to determine the temperature of the measuring point.

If you specify Internal compensation, the temperature of the measuring point in the housing of 
the I/O device is measured. With the External compensation setting, you can connect a 
compensation box in series in order to increase the accuracy of the temperature measurement. 

Parameter description analog output

Group diagnostics
You can generally enable and disable the diagnostics function of the device with this parameter.

The "Fault" and "Parameter assignment error" diagnostics functions are always independent 
of the group diagnostics.
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Diagnostics, missing 1L+
If you enable this parameter, the check for missing supply voltage is enabled.

Diagnostics, sensor supply short circuit
When this parameter is enabled, the system generates a diagnostics event if it detects a short-
circuit of the sensor supply to ground. This diagnostics function is activated when the group 
diagnostics function is enabled.

Response to CPU/Master STOP
Select how the module's outputs will respond to a CPU STOP:

● Shut down
The I/O device goes to the safe state. The process image output is deleted (=0).

● Keep last value
The I/O device retains the last value to be output before STOP.

● Substitute value
The I/O device outputs the value for the channel set beforehand.

 

  Note

Make sure that the plant is always in a safe state if "Keep last value" is selected.
 

Type of output
With this parameter, you set the output type, for example, voltage. For any unused channels, 
select the disabled setting. For a disabled channel, the conversion time and integration time 
of the channel = 0 s, and the cycle time is optimized.

Output range
With this parameter, you set the output range of the selected output type.

Diagnostics, wire break (in current mode)
When this parameter is enabled, the Wire break diagnostics event is generated when a wire 
break is detected. This diagnostics event cannot be detected in the zero range.

Diagnostics, short circuit (in voltage mode)
If you enable this parameter, a diagnostics event is generated in the event of a short circuit in 
the output line. This diagnostics event cannot be detected in the zero range.

Diagnostics, overload
If you enable this parameter, the diagnostics event is generated in the event of an overload.
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Substitute values
With this parameter, you enter a substitute value that the module is to output in CPU-STOP 
mode. The substitute value must be in the nominal range, overrange, or underrange.

ET 200SP

ET 200SP distributed I/O system

Definition   
The ET 200SP distributed I/O system is a scalable, highly flexible distributed I/O system for 
connection of process signals to a central controller via a field bus. 

Application area   
The ET 200SP is a multi-functional distributed I/O system for various fields of application. The 
scalable design allows you to configure the system exactly to the specific requirements on 
location.

The ET 200SP is approved for degree of protection IP 20 and for installation in a control cabinet.

Structure   
The ET 200SP is mounted on a mounting rail and comprises:

● An interface module which can communicate with all IO controllers that conform to the 
PROFINET standard IEC 61158

● Up to 32 I/O modules which can be inserted on passive BaseUnits in any combination

● A server module that completes the design of the ET 200SP.

Interface module parameters

Status bytes

Status bytes
If you enable the "Status bytes" option, 4 bytes of input data are reserved for the status of the 
supply voltage of each I/O module.
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 Note

An inserted or missing server module always reports for the slot bit = 0.
 

Group diagnostics, missing supply voltage L+

Group diagnostics, missing supply voltage L+
This diagnostics is a group diagnostics that covers the supply voltage status of all I/O modules 
of a potential group which are defined by BaseUnits with incoming power supply (light-colored 
BaseUnit BU...D). 

The group diagnostics is formed from the states of the supply voltage of the inserted I/O 
modules within the potential group.

The group diagnostics does not depend on the "Missing supply voltage L+" parameter of the 
I/O modules being enabled.

The server module does not influence the missing supply voltage L+ group diagnostics.

Requirements for the correct operation of the group diagnostics for missing supply voltage L+:
● I/O modules or BU covers must be inserted on the light-colored and dark-colored BaseUnits.

If no I/O module is inserted on a light-colored BaseUnit, the start of this potential group will 
not be detected by the interface module; the I/O modules of this potential group will thus 
belong to the previous potential group. A supply voltage L+ group error will then be assigned 
to the wrong potential group. 
When an I/O module is inserted on the light-colored BaseUnit, the interface module detects 
the new potential group, re-evaluates the status, and reports a new group diagnostics in 
the case of an error. 

● The server module must be inserted.
The server module itself does not influence the missing supply voltage L+ group diagnostics.

Configuration control

Operating principle     
Configuration control allows you to operate various real configurations (options) with a single 
configuration of the distributed I/O device ET 200SP.

Configuration control provides you with the option of configuring the ET 200SP  distributed I/
O device with its maximum configuration and nevertheless operating with missing modules. If 
missing modules are retrofitted later, no new configuration is required and the hardware 
configuration does not have to be reloaded either. 

Using control data records, which are transferred to the interface module in the user program, 
you define a current set configuration. 
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● The configured module is not present on a slot.

– A base unit cover may be inserted on this slot instead of the configured I/O module. As 
there is no configured module on the slot, the term "Configuration control with empty 
slots" is also used.

– The module that is configured to the right of the missing module can be inserted on this 
slot instead of the configured module. The missing module makes the actual 
configuration appear pushed together. As the configured module is missing but no gap 
arises in the configuration, this is also referred to as a "Configuration without empty 
slots".

● The configuration is extended by an already configured module.

– In the case of configuration control with empty spaces, you extend the configuration by 
inserting the configured module on the corresponding empty slot.

– In the case of configuration control without empty spaces, insert the configured module 
on the right-hand side next to the last module of the ET 200SP.

More information and examples 
For information on the rules for configuration control, the structure of the control data record, 
and the behavior during operation as well as examples of the structure of the control data 
record for various configurations, refer to the IM 155-6 PN interface module manual (http://
support.automation.siemens.com/WW/view/en/59768173). 

Output module parameters

Substitute value reaction

Substitute value reaction
In the ET 200SP, the substitute value reaction is executed by the IO controller per slot.

The respective output reacts according to its set substitute value reaction:

● "Turn off"

● "Output substitute value"

● "Keep last value"

This substitute value reaction is triggered in the following cases:

● IO controller in STOP

● Controller failure (connection interruption)

● Firmware update

● Reset to factory settings

● More than one I/O module withdrawn simultaneously
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● Disable the IO device

● Station stop

– Missing server module

– More than one I/O module withdrawn simultaneously

– At least one I/O module is inserted on the wrong BaseUnit
 

  Note
Reducing a configuration

If you reduce the configuration of the ET 200SP and download the configuration to the 
CPU, the modules which are no longer configured but still present retain their original 
substitute value reaction. This applies until the supply voltage on the BaseUnit BU...D 
or on the interface module is turned off.

 

Input module parameters

Parameters of the digital input modules

Diagnostics missing supply voltage L+
Enabling of the diagnostics for missing or insufficient supply voltage L+.
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Diagnostics short-circuit to ground   
Enabling of the diagnostics if a short-circuit of the actuator supply to ground occurs.

① Encoder supply
② Short-circuit
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Diagnostics short-circuit to L+   
Enabling of the diagnostics if a short-circuit of the encoder supply to L+ occurs.

① Encoder supply
② Short-circuit

Diagnostics wire break
Enabling diagnostics if the line to the encoder is interrupted.

Operating mode
Determines whether a channel is enabled or disabled.

Pulse extension (only High Feature modules)   
Pulse extension is a function for changing a digital input signal. A pulse at a digital input is 
extended to at least the configured length. If the input pulse is already longer than the 
configured length, the pulse is not changed.

Pulse extension is started whenever the state of the input signal changes and no pulse 
extension is active for this channel. 
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Potential group of the left module / new potential group
Specifies whether the I/O module is located on a base unit with supply voltage feed (new 
potential group) or whether it is it located on a base unit without supply voltage feed (in which 
case it belongs to the potential group of the left module). 

Parameters of the analog input modules

Missing supply voltage L+        
Enabling of the diagnostics, with missing or too little supply voltage L+.

Reference junction (AI 4xRTD/TC 2-/3-/4-wire HF)
A BaseUnit with internal temperature sensor (BU..T) or the channel 0 of the I/O module can 
be used as reference junction, provided this has been configured as "Thermal resistance Pt100 
climatic range Celsius".

A possible configuration is shown below:

Table 8-55 RTD channel

Setting Description
No reference channel operation Temperature value at channel 0 can be used as module-wide reference value 

if the parameters of the other channels are assigned accordingly. 
Reference channel of Group 0 The channel acts as sender for the reference junction temperature of Group 0. 

Distribution is performed via the interface module.

Table 8-56 TC channel

Setting Description
Reference channel of the module The corresponding TC channel uses the channel 0 of the same module as 

reference junction temperature. This must be set as "Thermal resistance Pt 100 
climatic range Celsius" and "No reference channel operation"; otherwise, 
reference junction diagnostics is triggered.

Internal reference junction The reference junction temperature is read by an internal temperature sensor 
on the BaseUnit. Reference junction diagnostics is triggered if there is a wrong 
BaseUnit type.

Reference channel of Group 0 With the setting "TC" (thermocouple...), the channel acts as receiver for the 
reference junction temperature of Group 0 

Fixed reference temperature No temperature compensation occurs. The linearization is executed with an 
assumed reference junction temperature of 0 °C.

Overflow
Enabling of the diagnostics if the measured value exceeds the overflow range.
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Underflow
Enabling of the diagnostics if the measured value falls below the underflow range.

Wire break
Enabling of the diagnostics if the module has no current flow or too low a current flow for the 
measurement on the corresponding configured input.

Smoothing
The individual measurements are smoothed using digital filtering. The smoothing can be set 
in 4 stages, whereby the smoothing factor k multiplied by the cycle time of the I/O module 
corresponds to the time constant of the smoothing filter. The larger the smoothing, the larger 
the time constant of the filter.

The following figure shows the step response for the various smoothing factors depending on 
the number of module cycles.

Figure 8-5 Smoothing with AI 4×RTD/TC 2‑/3‑/4‑wire HF

Interference frequency suppression
With analog input modules, suppresses the disturbance caused by the frequency of the AC 
network used. 

The frequency of the AC network may interfere with measured values, particularly for 
measurements within low voltage ranges and when thermocouples are being used. This 
parameter is used to define the predominant power frequency of the system.

Hardware interrupt limits
If the high limit 1/2 or the low limit 1/2 is violated, the module triggers a hardware interrupt.
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Below are some examples for the selection of the limits 1 and 2. 

Low limit 1/2
Specify a threshold whose undershoot triggers a hardware interrupt.

High limit 1/2
Specify a threshold whose overrange triggers a hardware interrupt.

Potential group of the left module / new potential group
Specifies whether the I/O module is located on a base unit with supply voltage feed (new 
potential group) or whether it is it located on a base unit without supply voltage feed (in which 
case it belongs to the potential group of the left module). 

Temperature coefficient (measuring type thermoresistor) 
The correction factor for the temperature coefficient (α value) defines the relative rate of change 
of the resistance of a specific material at a temperature rise of 1 ℃.

The temperature coefficient depends on the chemical composition of the material. In Europe, 
only one value is used per sensor type (default value). 

The further values facilitate a sensor-specific setting of the temperature coefficient and 
enhance accuracy.

See also
Special features of AI 4xRTD/TC 2-/3-/4-wire HF (Page 938)
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Special features of AI 4xRTD/TC 2-/3-/4-wire HF

Use of Cu10 sensors  
● Select "3-wire thermal resistor" and "Cu10" in the parameter assignment.

● Wire the Cu10 sensor using 3-wire connection technology.

● An automatic, internal compensation of the line resistance of the missing measuring line 
takes place during operation.

 

  Note

To ensure optimum line compensation for Cu10, please note the following:
● The sum of cable resistance and measuring resistance must not exceed 31 Ω.
● Cable resistance should not exceed 8 Ω if you want to use the temperature range up 

to over 312 °C. 
Example: A 200 m long copper cable with 0.5 mm2 core cross-section has approx. 
7 Ω. A lower cross-section reduces the permissible cable length accordingly.

 

Use of PTC resistors
PTCs are suitable for temperature monitoring of or as thermal protective equipment for 
complex drives or transformer windings.

● Select "2-wire resistor" and "PTC" in the parameter assignment.

● Connect the PTC using 2-wire technology.

● Use type A PTC resistors (PTC thermistors) in accordance with DIN/VDE 0660, Part 302.

● If the "Over-/underflow" diagnostics is enabled, a "low limit violation" diagnostics which 
shows a short circuit is generated for resistance values < 18 Ω.

● Sensor data on PTC resistance:

Table 8-57 Use of PTC resistors

Property Technical 
specifications

Note

Switching points Reaction to rising temperature
< 550 Ω Normal range:

● SIMATIC S7: bit 0 = "0", bit 2 = "0" (in the PII)
550 Ω to 1650 Ω Prewarning range:

● SIMATIC S7: bit 0 = "0", bit 2 = "1" (in the PII)
< 1650 Ω Response range:

● SIMATIC S7: bit 0 = "1", bit 2 = "0" (in the PII)
Reaction to falling temperature
< 750 Ω Response range:

● SIMATIC S7: bit 0 = "1", bit 2 = "0" (in the PII)
750 Ω to 540 Ω Prewarning range:

● SIMATIC S7: bit 0 = "0", bit 2 = "1" (in the PII)
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Property Technical 
specifications

Note

< 540 Ω Normal range:
● SIMATIC S7: bit 0 = "0", bit 2 = "0" (in the PII)

(TNF-5) °C
(TNF+5) °C
(TNF+15) °C
Measuring voltage 
Voltage on the PTC

max. 550 Ω
min. 1330 Ω
min. 4000 Ω
max. 7.5 V 

RRT= rated response temperature

● Assignment in the process image inputs (PII) with SIMATIC S7

Figure 8-6 Assignment in the process image inputs (PII) 

● Notes on programming
 

  Note

Only the bits 0+2 are relevant for the evaluation in the process image inputs. You can use 
the bits 0+2 to monitor the temperature, for example, of a motor.

The bits 0+2 in the process image inputs have no latching function. When you are 
assigning parameters, take into consideration that a motor, for example, starts up in a 
controlled manner (via an acknowledgment).

Bits 0+2 can never be set simultaneously, but are instead set consecutively.

For safety reasons, always evaluate the diagnostic entries of the AI 4×RTD/TC 2-/3-/4-
wire HF, as no measurement is possible if I/O modules are unplugged, if the supply voltage 
of the I/O module has failed, or if there is a wire break or short circuit of the measuring 
lines.
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Example
The following diagram shows the temperature variation and the associated switching points. 

See also
Parameters of the analog input modules (Page 935)

ET 200MP

ET 200MP distributed I/O system

Definition   
The ET 200MP distributed I/O system is a scalable and flexible distributed I/O system for 
connection of process signals to a central controller via a field bus. 

Application area 
The ET 200MP is a multi-functional distributed I/O system for various fields of application. The 
scalable design allows you to configure the system exactly to the specific requirements on 
location.

The ET 200MP complies with IP 20 degree of protection and is intended for installation in a 
control cabinet.
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Structure   
The ET 200MP is installed on a mounting rail and comprises:

● An interface module that communicates with all IO controllers conforming to the PROFINET 
standard IEC 61158

● Up to 30 modules (power supply modules and I/O modules from the S7-1500 I/O range) 
can be inserted to the right of the interface module.

● If you insert a power supply module to the left of the interface module, this yields a possible 
maximum configuration of 32 modules in total. 

● The number of insertable I/O modules is limited by their power requirements. 

Slot rules
● Slot 0: Power supply module (optional)

● Slot 1: Interface module

● Slot 2 to 31: I/O modules or power supply modules

Interface module parameters

Supply voltage L+ connected

Parameter "Supply voltage L+ connected"
This parameter influences the diagnostics and the checking of the power budget. 

● Diagnostics of the ET 200MP:
If the actual configuration does not conform to the setpoint configuration with regard to the 
supply voltage of the interface module, the interface module generates a diagnostic alarm. 
Example: You have deactivated the "Supply voltage L+ connected" option, but you have 
connected the supply voltage in the actual configuration.

● Power budget check during configuration:
The power budget changes in accordance with the parameter setting: Either the interface 
module feeds power into the backplane bus or it draws power from the backplane bus.

The default ("Supply voltage L+ connected" option is activated) means that the front of the 
interface module is supplied with 24 V DC and the power is stored in the backplane bus.

If the "Supply voltage L+ connected" option is deactivated, the interface module may not be 
supplied with 24 V DC on the front. 
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In this case, insert a power supply unit (PS) on the left next to the interface module that supplies 
the interface module and the modules to the right of the interface module. 

 

 Note

We recommend that you always supply the interface module on the front side with 24 V DC. 
If a system power supply unit (PS) is inserted and connected additionally before or on the 
left next to the interface module, both the power from the system power supply unit (PS) as 
well as the power from the integrated power supply of the interface module are then available 
to the configuration. 

In this case, you do not have to change the default setting of the parameter.
 

Input module parameters

Parameters of the analog input modules

Missing supply voltage L+
Enabling of the diagnostics for missing or insufficient supply voltage L+.

Wire break
Enabling of the diagnostics if the module has no current flow or the current is too weak for the 
measurement at the corresponding configured input or the applied voltage is too low.

Current limit for wire break diagnostics
Threshold at which a wire break is reported. The value can be set to 1.185 mA or 3.6 mA, 
depending on the sensor used.

Overflow
Enabling of the diagnostics if the measured value exceeds the overrange.

Underflow
Enabling of the diagnostics if the measured value undershoots the underrange.

Common mode error
Enable diagnostics if the valid common mode voltage is exceeded.
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Reference channel error (only for AI 8xU/I/RTD/TC ST) 
● Enable diagnostics on error at the temperature compensation channel, e.g. wire break.

● Dynamic reference temperature compensation type is configured and no reference 
temperature has been transferred to the module yet.

Temperature coefficient
The temperature coefficient depends on the chemical composition of the material. In Europe, 
only one value is used per sensor type (default value). 

The correction factor for the temperature coefficient (α value) specifies how much the 
resistance of a certain material changes when the temperature is raised by 1 °C.

The further values facilitate a sensor-specific setting of the temperature coefficient and 
enhance accuracy.

Interference frequency suppression
At analog input modules, this suppresses interference caused by the frequency of AC mains. 

The frequency of the AC network may interfere with measured values, particularly for 
measurements within low voltage ranges and when thermocouples are being used. With this 
parameter, you define the mains frequency in your system.

Smoothing
The individual measured values are smoothed using filtering. Smoothing can be set in 4 stages 
for the analog input modules AI 8xU/I/RTD/TC ST and AI 8xU/I HS.

Smoothing time = number of module cycles (k) x cycle time of the module.

The figure below shows the number of module cycles after which the smoothed analog value 
is almost 100%, depending on the set smoothing. Is valid for each signal change at the analog 
input.
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3
4

2

1

① None (k = 1)
② Weak (k = 4)
③ Medium (k = 16)
④ Strong (k = 32)

Reference junction (only for AI 8xU/I/RTD/TC ST)
The following settings can be configured for the reference junction parameter:

Table 8-58 Possible parameter assignments for the reference junction parameter

Setting Description
Fixed reference temperature The reference junction temperature is configured and stored in the module as 

a fixed value.
Dynamic reference temperature The reference junction temperature is transferred in the user program from the 

CPU to the module by data records 192 to 199 using the WRREC (SFB 53) 
instruction.

Internal reference junction The reference junction temperature is determined using an integrated sensor 
of the module.

Reference channel of the module The reference junction temperature is determined using an external resistance 
thermometer (RTD) at the reference channel (COMP) of the module. 

 

 Note
Fixed reference temperature

During parameter assignment of a thermocouple Type B, only the setting "Fixed reference 
temperature" with a temperature of 0 °C is possible.
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Enable hardware interrupt 1 or 2
Enable a hardware interrupt if high limit 1 or 2 is exceeded, or low limit 1 or 2 is violated.

Low limit 1 or 2
Specifies the low limit threshold that triggers hardware interrupt 1 or 2.

High limit 1 or 2
Specifies the high limit threshold that triggers hardware interrupt 1 or 2.

Temperature compensation for thermocouples

Introduction       
You have several options of measuring the reference junction temperature in order to obtain 
an absolute temperature value as a function of the temperature difference between the 
reference junction and the measuring point.

You can use various compensation options depending on the required location of the reference 
junction.

 

 Note

During parameter assignment of a thermocouple Type B, only the setting "Fixed reference 
temperature" with a temperature of 0 °C is possible.
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Options of compensating for the reference junction temperature

Compensation options Explanation Application case
Internal reference junction With this compensation, the reference junction 

temperature is determined using an integrated 
sensor of the module.
Procedure
Connect the thermocouple to the I/O module 
directly or with compensating lines. 

● For the connection, you use 
compensating lines matching the 
thermocouple material.

● If the reference junction temperature 
and the module temperature are 
identical in your system, you may 
also use lines made from a different 
material.

Reference channel of the 
module
 

The reference junction temperature is determined 
using an external resistance thermometer (RTD).
Procedure
Connect the thermocouple to the supply lines at the 
reference junction, either directly or with 
compensating lines. You connect the supply lines 
to the appropriate terminals of the module.
Connect the resistance thermometer (RTD) to the 
reference channel of the module. The resistance 
thermometer (RTD) must be placed in the area of 
the reference junction. 

● You want to measure the 
temperature directly at the reference 
junction.

● The measured temperatures of all 
channels that you have configured 
for this compensation type is 
corrected automatically by the 
temperature value of the reference 
junction.

● You can use inexpensive lines, e.g., 
copper lines, from the reference 
junction to the module.

 
 

Dynamic reference 
temperature

The temperature of the reference junction is 
determined via a module. This temperature value 
is transferred to other modules via a data record in 
the user program.
Procedure
Connect the resistance thermometer (RTD) for the 
reference junction to any channel.
The reference junction temperature is 
communicated from the CPU to the module by data 
records 192 to 199 using the WRREC instruction. 

● You use multiple modules at the 
reference junction and can therefore 
compensate all channels using a 
common temperature value.

● You require only one resistance 
thermometer (RTD) to acquire the 
temperature value.

● You can use inexpensive lines, e.g., 
copper lines, from the reference 
junction to the module.

Fixed reference temperature The reference junction temperature is stored in the 
module as a fixed value. 
Procedure
Connect the thermocouple to the supply lines at the 
reference junction, either directly or with 
compensating lines. You connect the supply lines 
to the appropriate terminals of the module.
When configuring the module, specify a fixed 
temperature value for the reference junction (e.g. 
20 °C). 

● You keep the reference junction 
temperature constant and know the 
temperature value.

● You can use inexpensive lines, e.g., 
copper lines, from the reference 
junction to the module.
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Output module parameters

Parameters of the analog output modules

Missing supply voltage L+
Enabling of the diagnostics, with missing or too little supply voltage L+.

Short-circuit to ground
Enabling of the diagnostics if a short-circuit of the actuator supply to ground occurs.

Wire break
Enabling diagnostics if the line to the encoder is interrupted.

Overflow
Enabling of the diagnostics if the measured value exceeds the overflow range.

Underflow
Enabling of the diagnostics if the measured value falls below the underflow range.

Reaction to CPU STOP
Determines the reaction of the output to the CPU going into STOP state.

Substitute value
The substitute values are values that the outputs (the output) issue in the event of a CPU STOP.

 

ET 200M

Configuring an ET 200M

Introduction
For the ET 200M series, you can find a wide range of modules in the hardware catalog under 
"Distributed I/O". 
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Configuration and parameter assignment
Information on configuration and parameter assignment can be found in the following sections.

ET 200M configuration

Definition
The distributed IO device, ET 200M, is a modular DP slave with an IP 20 degree of protection.     

The ET 200M has the configuration technology of the S7‑300 automation system and consists 
of an IM 153‑x and I/O modules of the S7‑300.

ET 200M supports communication with:

● all DP masters compliant with IEC 61784-1:2002 Ed1 CP 3/1

● all IO controllers compliant with IEC 61158

Configuration of the ET 200M (example)
 

1 2 3 

① Power supply module PS 307 
② Interface module IM 153‑x
③ up to 12 I/O modules (SM / FM / CP)

Configuration of the 'Module replacement during operation' function

Introduction     
The ET 200M supports the "Replace modules during operation" function and the associated 
pull/plug interrupt. 

The "Replace modules during operation" function makes it possible for you to pull modules 
from or plug modules into the ET 200M rack during operation. 

Requirement
You have configured an interface module that supports replacing modules during operation. 
(as of IM 153-1, order no. 153-1AA02-0XB0).
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In addition, the configured CPU must also support the function, e.g. for PROFIBUS an S7-400 
with DP interface. 

You must use the active backplane bus (bus rail with slots) for the hardware configuration. The 
conventional profile rail with bus connectors between the modules does not support this 
function.

Configuring 
If the configuration requirements have been met, the "Replace modules during operation" 
parameter is available for selection in the inspector window's "Module parameters" area. Below 
this parameter, a table for the configured modules is displayed, which shows the required 
active bus modules for the hardware configuration. 

For a PROFIBUS configuration, the "Startup if preset configuration does not match actual 
configuration" option is displayed. This option is automatically enabled if "Replace modules 
during operation" is enabled. 

Configuring HART variables

Introduction     
Numerous HART field devices make available additional measured quantities (e.g. sensor 
temperature). These can be read if they are set accordingly in the field device configuration. 
Using the HART variables. it is possible to apply the set measured values directly from the 
field device into the I/O area of your automation system.

Regardless of the number of configured channels, a maximum of 8 HART variables can be 
assigned for HART modules and no more than 4 HART variables per channel. You assign the 
HART variables to a channel in the properties for the module ("HART variable settings" area).

Requirement
The HART module is plugged into an ET 200 M (as of IM 153-2, 6ES7 153-2BA02-0AB0).

Address assignment 
The HART module occupies 16 input/output bytes. If you configure HART variables, the 
module occupies an additional 5 bytes for each HART variable.

If you use all 8 HART variables, the HART input module occupies a total of 56 input/output 
bytes (16 bytes + 8 x 5 bytes = 56 bytes).

The "None" configuration occupies no additional input bytes.

Configuration of HART variables
You can configure up to 4 HART variables for a channel 

● PV (Primary Variable)

● SV (Secondary Variable)
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● TV (Tertiary Variable)

● QV (Quaternary)

CiR is a placeholder that reserves the address space for a HART variable. You must configure 
the HART variables you are not using with the "None" parameter.

Configuration of HART variables  
The HART variables are structured as follows:

Structure of the "Quality-Code" byte    
The Quality-Code (QC) can assume the following values: 

Quality-Code (QC) Meaning
0x4C or 0 Initialization: 0 value of IM and 4C of module
0x18 Communication cancelled / no communication
0x0C Fault in HART device
0x47 HART device is busy
0x84 OK "Configuration changed"
0x80 OK

See also
Documentation for HART analog modules (http://support.automation.siemens.com/WW/view/
en/22063748)

Signal modules for process automation

Fundamentals

Introduction
Signal modules for the process automation are S7-300 models, such as SM 321; DI 
16xNAMUR or SM 322; DO 16x24VDC/0.5A. 

They are being operated in a DP slave (IM 153-2).

Unlike standard modules, they offer the following additional technical functions, such as pulse 
extension and chatter monitoring. 
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See also
Changeover contact (Page 951)

Technological parameters (Page 951)

Changeover contact

"Changeover contact" sensor type
If the digital inputs of a channel group are configured as "changeover contacts", the module 
runs diagnostics for the changeover contact sensor type for this channel group. 

Changeover contact 
A changeover contact is an auxiliary switch with only one moving switch element with one 
close setting each for closed and open switching device. 

Remember the following rule:

● Always connect a normally open contact to the "even" channel

● Always connect a normally closed contact to the "odd" channel.

The tolerated switchover time between the two channels is fixed at 300 ms.

If the result of the check is negative, then

● the module identifies the value status of the normally open channel as "invalid"

● the module generates a diagnostic entry for the normally open channel

● triggers a diagnostic interrupt (if diagnostic interrupts have been enabled)

The digital input signal and the value status are updated only for the normally open channel. 
For the normally closed channel, the digital input signal is set permanently to "zero" and the 
value status to "invalid" since this channel is used only to check the sensor.

Diagnostics depends on the "Selection" parameter (of the sensor). You should also note the 
special features of diagnostics with the changeover contact sensor type in the "Signal Modules 
for Process Automation" manual.

See also
Documentation on modules for process automation (http://support.automation.siemens.com/
WW/view/de/7215812/0/en)

Technological parameters

Pulse extension and flutter monitoring
Pulse extension is a function for changing a digital input signal. A pulse at a digital input is 
extended to at least the length set in the parameters. If the input pulse is already longer than 
the specified length, it is not changed. 
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If you want the pulse to be extended, click in the box to select the time. If you do not want the 
pulses to be extended, select the "---" entry.

Flutter monitoring is a process control function for digital input signals. It detects and reports 
signal changes that are unexpected in process control, for example when an input signal 
fluctuates too often between "0" and "1". 

Flutter monitoring is possible only when group diagnostics has also been enabled for this input. 

Monitoring window and number of signal changes
Flutter monitoring works with aid of the two parameters Monitoring window and Number of 
signal changes.

The first time the signal changes, the time set as the monitoring window is started. If the signal 
changes more often during this time than allowed by the number of signal changes parameter, 
this is signaled as a flutter error. If no flutter error is detected during the monitoring window 
time, the monitoring window can be restarted at the next signal change.

 

 Note

If you set pulse extension for an input channel, this also affects the flutter monitoring enabled 
for this channel. The "extended pulse" signal is the input signal for the flutter monitoring. You 
should therefore make sure that the values set for pulse extension and flutter monitoring are 
compatible with each other. 

 

See also
Documentation on modules for process automation (http://support.automation.siemens.com/
WW/view/de/7215812/0/en)

IQ Sense module

Properties of 8 IQ-SENSE

Properties   
The 8 IQ-SENSE module has the following properties:

● Connection of sensors with IQ-SENSE®, photoelectric proximity switches: for example, 
reflex sensors, diffuse sensors, and laser sensors.

● It can be used centrally in an S7-300 or distributed in an ET 200M.

● You can connect up to 8 sensors to every module. Each sensor requires a two-wire cable.

● Function reserve that can be assigned parameters.

● Time functions, switching hysteresis, synchronous mode that can be assigned parameters

● Sensitivity and distance values can be specified (IntelliTeach using the "IQ-SENSE Opto" 
FB)
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● Teach-in

● Sensors can be removed and inserted during operation (automatic reassignment of 
parameters)

Anti-interference group
Only for optical IQ Sense devices (IQ profile ID 1). 

For IQ Sense devices with IQ profile ID 128 (ultrasound), see "Multiplex/synchronous mode" 
under the channel-specific parameters.

Prevention of interference (e.g., scattered light) by assigning an anti-interference group. This 
means:

● Anti-interference group: None (= default)
Optical sensors on one or more modules can mutually influence each other when 
unfavorably arranged.

● Anti-interference group: 3 or 4
Optical sensors on the same module with anti-interference group 3 or 4 cannot mutually 
influence each other. Similarly, optical sensors on different modules with anti-interference 
group 3 or 4 cannot mutually influence each other. You need not maintain minimum 
clearance between the IQ Sense devices and can, for example, align two retroreflective 
sensors on a single reflector.

Operating principle
The diagram below explains the functioning of the anti-interference group parameter:

Mutual interference is only possible between the optical sensors of the modules in slot 5, 6, 7 
and 9 because they are in the same anti-interference group 3 or "None" is set. 

 

 Note

Sensors in the same anti-interference group must be installed to maintain the minimum 
clearance (see sensor package insert) and to prevent mutual interference.
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Encoder type
This parameter is used to set the sensor type per channel:

● Reflex sensor or

● Diffuse sensor or

● Disabled

Diffuse sensor

Table 8-59 Diffuse sensor

Diffuse sensor Object  
Transmitter
Receiver

Circuit state 0: No object detected, which 
means the object is not in the beam. The 
receiver does not see any light.

Transmitter
Receiver

Circuit state 1: Object detected, which 
means the object is in the beam. The 
receiver does not see any light.

Reflex sensor

Table 8-60 Reflex sensor

Reflex sensor Object  
Transmitter
Receiver

Circuit state 0: No object detected, which 
means the object is not in the beam. The 
receiver sees light.

Transmitter
Receiver

Circuit state 1: Object detected, which 
means the object is in the beam. The 
receiver does not see any light.

Switching hysteresis
Faults with the diffuse sensor or in the production process can result in signal wobbles. The 
measured value then changes the switching threshold by 100 % (object detected - object not 
detected). You can prevent this switching threshold wobble using the switching hysteresis 
parameter. This will ensure a stable output signal on the sensor.

You can assigned parameters to 5 %/10 %/20 %/50 % for switching hysteresis.
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Requirements
You can only set the switching hysteresis parameter for diffuse sensors with background 
fadeout.

Operating principle

Figure 8-7 Switching hysteresis parameter

Time function,time value
These parameters can be used to set the electronic module for its specific application.
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Operating principle

Figure 8-8 Time functions, time values parameters

Multiplex/synchronous mode
For the prevention of mutual influence between IQ Sense ultrasound devices in spatial 
proximity (devices with IQ profile ID 128), use the "Multiplex/synchronous operation" 
parameter. 

Settings for the multiplex/synchronous mode parameter   
Disabled: Mutual influence between IQ Sense ultrasound sensors in spatial proximity is 
possible (default). The cycle time is determined by the IQ Sense ultrasound sensor.

Multiplex: The IQ Sense ultrasound sensors determine the process value (distance) one after 
another, preventing them from affecting one another. The cycle time here is the sum of the 
configured synchronous cycle times of the IQ Sense ultrasound sensors that are to be 
multiplexed.

Synchronization: The IQ Sense ultrasound sensors determine the process value (distance) at 
exactly the same time, preventing them from affecting one another. The cycle time here 
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corresponds to the greatest configured synchronous cycle time from among the IQ Sense 
ultrasound sensors that are to be synchronized.

You can, for example, use synchronous operation for a curtain function in which several IQ 
Sense ultrasound sensors aligned in parallel share a single extended detection area. The 
sensors simultaneously emit an ultrasound impulse. When an object enters the detection area, 
the sensor nearest to the object receives the echo most quickly. The object can therefore not 
only be detected, it can be located as well.

AFI value
Using the AFI value (application series identifier, as defined in the ISO 15693-3 international 
standard), transponders can be selected for different applications. Only transponders whose 
AFI value coincides with the value set on the sensor are processed. If a transponder has the 
AFI value "0", it can be identified and processed regardless of the AFI value of the sensor.

This parameter is only important if it is supported by the ident system, otherwise any value 
(normally "0") may be assigned.

Transponder type
Depending on the type of the transponder, you must configure whether it is an ISO transponder 
or a vendor-specific type.

For transponders in accordance with international standard ISO 15693, the value "1" should 
be selected; for all other types "0" is set. Based on this setting, one of the two possible air 
interface drivers is selected in the sensor. 

This parameter is only important if it is supported by the ID system, otherwise any value 
(normally "0") may be assigned.

ET 200S

Configuring an ET 200S

Introduction
For the ET 200S series, you can find a wide range of modules in the hardware catalog under 
"Distributed I/O". 

Assigning parameters
For information on configuration and parameter assignment, refer to "See also".
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Frequency converters

Use of the frequency converter

Frequency converters
The frequency converter ICU24 and ICU24F ( as fail-safe version) are modular design 
frequency converters that are completely embedded in the distributed I/O system ET 200S. 
For parameterization of both modules, please see the following.

Message frame
The message frame number and the operating mode of the module are only displayed and 
cannot be modified.

Application ID
You indicate the saved parameters in the frequency converter as a whole with the application 
ID. Enter an application ID from the value range 0 to 65535. During startup (or pull/plug), this 
ID is compared with the application ID stored on the converter.

Converters that work with identical applications are usually also identically parameterized and 
should be identified with the same application ID. Converters with the same application ID may 
be exchanged between each other. Copying of the complete parameterization of a converter 
to another converter, for example, via an MMC, is only accepted, if both have the same 
application ID.

Converters that work with different applications and are parameterized differently must be 
identified by different application IDs. This prevents a converter with unsuitable 
parameterization from starting on an incorrect slot, i.e. on the wrong application. This also 
prevents the parameterization that is saved in the converter from being accidently overwritten 
with any parameteriation that is stored on an MMC.

Enable diagnostic interrupt
You can enable the diagnostic interrupt for the frequency converter. If diagnostic interrupt is 
enabled, an OB 82 must be available in a CPU to process the diagnostic events.

See also
Documentation for the frequency converter (http://support.automation.siemens.com/WW/view/
en/26291825/0/en)
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ET 200pro

Use of the frequency converter

Frequency converters
The frequency converters ET 200pro FC and ET 200pro F-FC (as fail-safe version) are 
modularly design frequency converters that are completely embedded in the distributed I/O 
system ET 200pro. The following section describes how to configure the two modules.

Message frame
The message frame number and the operating mode of the module are only displayed and 
cannot be modified.

Application ID
You indicate the saved parameters in the frequency converter as a whole with the application 
ID. Enter an application ID from the value range 0 to 65535. During startup (or pull/plug), this 
ID is compared with the application ID stored on the converter.

Converters that work with identical applications are usually also identically configured and 
should be identified with the same application ID. Converters with the same application ID may 
be exchanged between each other. Copying of the complete configuration of a converter to 
another converter, for example, via an MMC, is only applied, if both have the same application 
ID.

Converters that work with different applications and are configured differently must be identified 
by different application IDs. This prevents a converter with unsuitable configuration from 
starting on an incorrect slot, in other words on the wrong application. This also prevents the 
configuration that is saved in the converter from being accidently overwritten with any 
configuration that is stored on an MMC.

Enable diagnostic interrupt
You can enable the diagnostic interrupt for the frequency converter. If diagnostic interrupt is 
enabled, an OB 82 must be available in a CPU to process the diagnostic events.
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8.2 Device and network diagnostics

8.2.1 Hardware diagnostics

8.2.1.1 Overview of hardware diagnostics

Principal methods of hardware diagnostics

Principal methods of hardware diagnostics  
Hardware diagnostics can be performed as follows:

● Using the Online and Diagnostics view

● Using the "Online Tools" task card

● Using the "Diagnostics > Device Info" area of the Inspector window

● Using diagnostics icons, for example, in the device view and the project tree

Structure of the Online and Diagnostics view  
The Online and Diagnostics view consists of two windows alongside each other:

● The left window shows a tree structure with folders and - when you open the folder - groups.

● The right window contains detailed information on the selected folder or selected group.

The "Online access" group and the "Diagnostics" and "Functions" folders are located here:

● "Online access" group: Displays whether or not there is currently an online connection with 
the associated target. In addition, you can establish or disconnect the online connection.

● "Diagnostics": Contains several diagnostics groups for the selected module.

● "Functions": Contains several groups, in which you can make settings for the selected 
module or issue commands to the module.

Function and structure of the "Online Tools" task card  
For modules with their own operating mode (such as CPUs), the "Online tools" task card allows 
you to read current diagnostics information and commands to the module.

If you selected a module without its own operating mode or if you selected several modules 
before activation of the "Online Tools" task card, the task card relates to the relevant CPU.

The "Online Tools" task card consists of the following panes:
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● CPU control panel

● Cycle time

● Memory
 

  Note

A pane is filled with content only if the module controls the associated functions and an 
online connection exists.

If there is no online connection to the respective module, the display "No online 
connection" appears in blue. If an existing online connection was disconnected, then "This 
target is not available" will be displayed.

 

Structure or the "Diagnostics" tab of the Inspector window  
The "Diagnostics" tab of the Inspector window itself consists of several tabs: Of these tabs, 
the following is relevant for the hardware diagnostics.

● Device information
This tab relates to all CPUs of the project to which the online connection is established. 
Alarms are reported here if one or more CPUs are defective or are not in RUN mode.

See also
Basics on task cards (Page 221)

Inspector window (Page 219)

Determination of which of the devices that are connected online are defective

Overview of the defective devices 
In the "Diagnostics > Device Info" area of the Inspector window you will obtain an overview of 
the defective devices that are or were connected online. 

The "Diagnostics> Device Info" area of the Inspector window consists of the following elements:

● Header line with the number of defective devices

● Table with detailed information on each defective device

If you originate the establishment of an online connection to a device which is not reachable 
or reports one or more faults or is not in RUN mode, it will rank as defective.

Structure of the table with detailed information on the defective devices
The table consists of the following columns:

● Online status: Contains the online status as a diagnostic symbol and in words

● Operating mode: Contains the operating mode as a symbol and in words

● Device / module: Name of the affected device or the affected module
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● Message: explains the entry of the previous column

● Details: The link opens the online and diagnostics view for the device, and places it in the 
foreground. If an online connection does not exist any longer, the link will open the 
connection establishment dialog.

● Help: The link supplies further information on the defect that has occurred.

See also
Displaying diagnostics status and comparison status using icons (Page 962)

Displaying diagnostics status and comparison status using icons

Determining diagnostics status online and displaying using icons   
When the online connection to a device is established, the diagnostics status of the device 
and, if applicable, its lower-level components are determined. The operating mode of the 
device is also determined, where applicable.

The following is a description of the symbols that are displayed in a specific view.
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● Device view

– The associated diagnostics icon is displayed for every hardware component (except the 
signal board on the CPU).

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostics icon appears as follows: The 
hardware component's diagnostics icon has a pale appearance and the diagnostics icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– For hardware components with their own operating mode, the operating mode icon is 
also displayed to the left of or above the diagnostics icon.

– The following applies to modules or submodules of a Shared Device with an S7-1500 
CPU: No diagnostics icons are displayed (due to the configuration as GSDML device).

● Device overview

– The associated diagnostics icon is displayed for every hardware component.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostics icon appears as follows: The 
hardware component's diagnostics icon has a pale appearance and the diagnostics icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The following applies to modules or submodules of a Shared Device with an S7-1500 
CPU: For modules assigned to the CPU, the associated diagnostics icon is displayed 
(modules that are not assigned do not receive a diagnostics icon). The associated 
diagnostics icon is displayed for plug-in submodules of an assigned module 
(submodules that are not plug-in are not visible and therefore do not receive a 
diagnostics icon).

● Network view

– The associated diagnostics icon is displayed for every device.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostics icon appears as follows: The 
hardware component's diagnostics icon has a pale appearance and the diagnostics icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The following applies to modules or submodules of a Shared Device with an S7-1500 
CPU: A diagnostics icon is displayed. It belongs to that part of the station that is assigned 
to the CPU.
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● Network overview

– The associated diagnostics icon is displayed for every hardware component.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostics icon appears as follows: The 
hardware component's diagnostics icon has a pale appearance and the diagnostics icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The following applies to modules or submodules of a Shared Device with an S7-1500 
CPU: A diagnostics icon is displayed. It belongs to that part of the station that is assigned 
to the CPU.

● Topology view

– The associated diagnostics icon is displayed for every device.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostics icon appears as follows: The 
hardware component's diagnostics icon has a pale appearance and the diagnostics icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The associated diagnostics icon is displayed for every port. The meaning of the 
individual colors is described further below.

– Each cable between two online ports is assigned the color associated with its diagnostics 
status. 
The color of the cable between two ports depends on the status of the individual ports:
 

Color of the first port Color of the second port Color of the connecting cable
green green green
green gray gray
green red red
gray red red

– The following applies to modules or submodules of a Shared Device with an S7-1500 
CPU: A diagnostics icon is displayed. It belongs to that part of the station that is assigned 
to the CPU.

● Topological overview

– The associated diagnostics icon is displayed for every hardware component.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostics icon appears as follows: The 
hardware component's diagnostics icon has a pale appearance and the diagnostics icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The following applies to modules or submodules of a Shared Device with an S7-1500 
CPU: A diagnostics icon is displayed. It belongs to that part of the station that is assigned 
to the CPU.
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● Project tree

– The associated diagnostics icon is displayed behind every hardware component.

– For a hardware component with lower-level components (e.g., distributed I/O, Slave_1), 
if there is a hardware error in at least one lower-level component, the diagnostics icon 
appears as follows: The hardware component's diagnostics icon has a pale appearance 
and the diagnostics icon "Hardware error in lower-level component" is also shown in the 
lower right corner.

– For hardware components with their own operating mode, the operating mode icon is 
also displayed in the top right corner of the diagnostics icon.

– If forcing is active on a CPU, a red F is displayed at the left margin of the diagnostics 
icon.

– The diagnostics icon "Hardware error in lower-level component" is displayed behind the 
"Local modules" folder when there is a hardware error in at least one of the associated 
modules.

– The diagnostics icon "Hardware error in lower-level component" is displayed behind the 
"Distributed I/O" folder when there is a hardware error in at least one of the associated 
modules.

– The diagnostics icon "Hardware error in lower-level component" is displayed behind the 
project folder when the "Hardware error on lower-level component" diagnostics icon is 
displayed behind at least one of the "Local modules" or "Distributed I/O" folders. 

– The following applies to modules or submodules of a Shared Device with an S7-1500 
CPU: The associated diagnostics icon is displayed for modules assigned to the CPU 
(modules that are not assigned are grayed out and do not receive a diagnostics icon). 
The associated diagnostics icon is displayed for plug-in submodules of an assigned 
module (submodules that are not plug-in are not visible and therefore do not receive a 
diagnostics icon).

 

 Note

If the diagnostic for a hardware component is "not reachable from the CPU", the diagnostics 
icon "Hardware error in lower-level component" is not additionally shown.

 

Diagnostics icons for modules and devices   
The following table shows the available icons and their respective meaning.

Icon Meaning
The connection with a CPU is currently being established.

The CPU is not reachable at the set address.

The configured CPU and the CPU actually present are of incompatible types.

On establishment of the online connection to a protected CPU, the password dialog 
was terminated without specification of the correct password.
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Icon Meaning
No fault

Maintenance required

Maintenance demanded

Error

The module or device is deactivated.

The module or the device cannot be reached from the CPU (valid for modules and 
devices below a CPU).
Diagnostics data is not available because the current online configuration data differ 
from the offline configuration data.
The configured module or device and the module or device actually present are 
incompatible (valid for modules or devices under a CPU).
The configured module does not support display of the diagnostics status (valid for 
modules under a CPU).
The connection is established, but the module status has not yet been determined 
or is unknown.
The configured module does not support display of the diagnostics status.

Hardware error in lower-level component: A hardware error is present in at least one 
lower-level hardware component. (occurs as a separate icon only in the project tree)

 

 Note

Some modules, for example, the FM 450-1, are only indicated as having a problem in the 
case of an error if you have enabled the diagnostic interrupt when setting the module 
properties.

 

Icons for the comparison status   
The diagnostics icons can be combined at the bottom right with additional smaller icons that 
indicate the result of the online/offline comparison. The following table shows the available 
comparison icons and their meaning.

Icon Meaning
Hardware error in lower-level component: The online and offline versions differ (only 
in the project tree) in at least one lower-level hardware component.
Software error in lower-level component: The online and offline versions differ (only 
in the project tree) in at least one lower-level software component.
Online and offline versions of the object are different

Object only exists online
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Icon Meaning
Object only exists offline

Online and offline versions of the object are the same
 

 Note

If both a comparison icon and the "Error in lower-level" diagnostics icon are to be displayed 
at the bottom right in the device view, the following rule applies: The diagnostics icon for the 
lower-level hardware component has a higher priority than the comparison icon. This means 
that a comparison icon is only displayed if the lower-level hardware components have no 
faults.

 

Display of software errors in the project tree
● The associated comparison icon is shown behind each block.

● Behind each folder, under which exclusively blocks are contained, the diagnostics icon 
"Software error in lower-level component" is displayed when there is a software error in at 
least one of the associated blocks.

● For a hardware component with lower-level software components, if there is no hardware 
error and there is an error in at least one lower-level software component, the diagnostics 
icon appears as follows: The hardware component's diagnostics icon has a pale 
appearance and the diagnostics icon "Software error in lower-level component" is also 
shown in the lower right corner.

Combined diagnostics and comparison icons
The following table shows examples of icons that are displayed in the diagnostics icon.     

Icon Meaning
Folder contains objects whose online and offline versions differ (only in the project 
tree)
Object only exists online

Operating mode icons for CPUs and CPs   
The following table shows the available icons and their respective operating states.

Icon Operating mode
RUN

STOP

STARTUP
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Icon Operating mode
HOLD

DEFECTIVE

Unknown operating mode

The configured module does not support display of the operating mode.

 

 Note

If forcing is active on a CPU, a red F is displayed on a pink background at the bottom right 
of the operating mode icon.

 

Color marking of ports and Ethernet cables     
The following table shows the available colors and their respective meaning.

Color Meaning
No fault or maintenance required

Maintenance demanded

Communication error

no diagnostic capability

Start online and diagnostics view

Overview of possible ways of starting the Online and Diagnostics view
You can start the Online and Diagnostics view of a module to be diagnosed at the following 
locations:

● Overview

● Project tree

● Device view

● Device overview

● Network view

● Network overview

● Topology view

In the following, examples are used to show how to proceed. 
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Requirement
The project with the module to be diagnosed is open.  

 

 Note

This requirement does not apply if you call the online and diagnostics view from the project 
tree after you have identified the accessible devices.

 

Procedure
To start the online and diagnostics view of a module, follow these steps:  

1. In the project tree, open the respective device folder.

2. Double click on "Online & Diagnostics".

Or:

1. In the project tree, select the respective device folder.

2. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

1. In the project tree, open the "Online access" folder.

2. Open the folder for the interface with which you want to establish the online connection.

3. Double click on "Show/Update accessible devices".

4. Select the module to be diagnosed.

5. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

1. In the project tree, open the "Local modules" folder.

2. Select the respective device or the module that is to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the main menu.

Or:

1. Open the device view in the device configuration.

2. Select the module to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

1. Open the device view in the device configuration.

2. Establish an online connection to the module to be diagnosed.

3. Double-click on the diagnostics icon above the module.

Or:
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1. Open the network view in the device configuration.

2. Select the station with the module to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

Result
The online and diagnostics view of the module to be diagnosed will be started. If an online 
connection to the associated CPU had previously been created, the header bar of the Online 
and Diagnostics view will now have an orange background.

 

 Note

If no online connection exists when the online and diagnostics view is started, no online 
information is displayed and the display fields remain empty.

 

Activation of the "Online Tools" task card

Activation of the "Online Tools" task card    
You can activate this task card as follows:

1. Start the online and diagnostics view.

2. Click on the "Online Tools" task card.

Or:

1. Start the device view.

2. Click on the "Online Tools" task card.

Or:

1. Start the network view.

2. Click on the "Online Tools" task card.

8.2.1.2 Showing non-editable and current values of configurable module properties

Showing general properties and system-relevant information for a module

Where do I find the information I need?
The general properties and system-relevant information for a module can be found in the 
"General" group in the "Diagnostics" folder in the online and diagnostics view of the module 
to be diagnosed.   
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Structure of the "General" group
The "General" group consists of the following areas:

● Module

● Module information

● Vendor information

"Module" area
This area shows the following data of the module:

● Short designation, for example, CPU 1214C DC/DC/DC

● Order no.

● Hardware

● Firmware

● Racks

● Slot

"Module information" area
This area shows the following data of the module that you configured during hardware 
configuration:

● Module name

● Installation date (not displayed for all modules)

● Additional information (not displayed for all modules)

"Manufacturer information" area
This area shows the following data of the module:

● Manufacturer

● Serial number

● Profile: Profile ID as hexadecimal number
 

  Note

You will find the corresponding profile name in the profile ID table for PROFIBUS 
International (see "www.profibus.com").

 

● Profile details: Profile-specific type as hexadecimal number
 

  Note

You will find the corresponding profile-specific type name in the profile-specific type table 
for PROFIBUS International (see "www.profibus.com").
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Display configured cycle times

Where do I find the information I need?  
The required information can be found in the following places:

● In the "Cycle time" group of the "Diagnostics" folder in the Online and Diagnostics view of 
the module to be diagnosed.

● In the "Cycle time" pane of the "Online Tools" task card

Structure of the "Cycle time" group in the "Diagnostics" folder of the Online and Diagnostics view
The "Cycle time" group consists of the following areas:

● Cycle time diagram (graphical display of the assigned and measured cycle times)

● Cycle time configured (display of the assigned cycle times as absolute values)

● Cycle times measured (display of the measured cycle times as absolute values)

Structure of the "Cycle time" pane of the "Online Tools" task card
The "Cycle time" pane displays the cycle time diagram and below it the measured cycle times 
as absolute values.

Assigned cycle times
The following assigned cycle times are displayed in the cycle time diagram and in the "Cycle 
time configured" area.

● Minimum cycle time

● Maximum cycle time

In the cycle time diagram, the minimum cycle time and the maximum cycle time correspond 
to the two markings on the time axis.

In the "Cycle time configured" area, the assigned cycle times are displayed as absolute values.
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Show interfaces and interface properties of a module

Where do I find the information I need?
The interfaces and interface properties of a module can be found in the "Diagnostics" folder 
in the Online and Diagnostics view of the module to be diagnosed in the following group:     

● PROFINET interface

"PROFINET interface" group   
This group is divided into the following areas:

● "Ethernet address" with the "Network connection" and "IP Parameters" subareas

● "Ports"

"Network connection" subarea of the "Ethernet address" area
This subarea shows the following data for the module:

● MAC Address:
MAC address of the interface.
The MAC address consists of two parts. The first part ("Basic MAC address") identifies the 
manufacturer (Siemens, 3COM, ...). The second part of the MAC address differentiates 
between the various Ethernet devices. Each Ethernet module is assigned a unique MAC 
address.

"IP Parameters" subarea of the "Ethernet address" area   
This subarea shows the following data for the module:

● IP address:
Internet protocol address of the device on the bus (TCP/IP)

● Subnet mask:
The subnet mask shows which part of the IP address determines the membership of a 
particular sub-network.

● Default router:
If the subnet is connected via a router to other subnets, the IP address of the default router 
must be known. This is the only way a datagram can be forwarded with a non-matching 
subnet address.

● IP settings:
Identifier for the path by which the device has obtained its IP settings (IP address, subnet 
mask, default router).

Identifier Meaning
0 IP address is not initialized
1 By configuration (i.e., by the configuration loaded to the device from the device or 

network view)
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Identifier Meaning
2 Via the "Assign IP address" group of the Online and Diagnostics view
3 Via the DHCP server (i.e., the IP parameters are obtained by a special service from a 

DHCP server (Dynamic Host Configuration Protocol) and assigned for a limited time)

 

● IP setting time:
Time stamp of the last change to the IP address directly through the Ethernet connection 
of the module

"Ports" area
This area shows the following data for the module:

● Ethernet ports
Physical properties of the PROFINET interface

Properties of the 
PROFINET interface

Meaning

Port no. Port number The short description of interface (X + interface no.) and port 
(P + port no.) is specified in parentheses. An "R" in the short description of 
a port means that it is a ring port.

Status Displays the status of the port LINK LED.
● Status "OK" means another device (such as a switch) is connected to 

the port and the physical connection is available.
● Status "disconnected" means no other device is connected to the port.
● Status "deactivated" means that access to the port is blocked.

Settings Individual network settings of the device (automatic or manual)
Operating mode Network settings for the speed and the transmission process

If you select a line in the port table, additional help information will be provided for the 
corresponding port.
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Displaying IO controllers that access modules of a Shared Device

Where do I find the information I need?
The display of those IO controllers that access the modules of a Shared Device can be found 
in the Online and Diagnostics view of the interface module of the Shared Device in the 
"Diagnostics" folder in the following area of the "PROFINET interface" group:

● IO controller 

 Displaying sync domain properties of a PROFINET device

Where do I find the information I need?
The sync domain properties of a PROFINET device can be found in the following area of the 
"PROFINET interface" group in the "Diagnostics" folder of the Online and Diagnostics view of 
the device to be diagnosed:

● Domain 

"Domain" area
This area is divided into the following subareas:

● Sync domain

● MRP domain

What is a sync domain?
A sync domain is a group of PROFINET devices that are synchronized to a common clock. 
Exactly one device has the role of the sync master (clock generator); all other devices assume 
the role of a sync slave. The sync master is usually an IO controller or a switch.

Non-synchronized PROFINET devices are not part of a sync domain.

"Sync domain" subarea of the "Domain" area   
This subarea shows the following properties of the sync domain:

● Name:
Name of sync domain

● Role:
Role of the PROFINET device in the sync domain. The following roles are possible:

– Sync master

– Sync slave

● Synchronization interval:
Interval at which the synchronization is performed
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● Send clock
Smallest possible send interval for the data exchange

● Jitter accuracy of the send clock

● Reserved bandwidth for cyclic communication
 

Displaying MRP domain properties of a PROFINET device

Where do I find the information I need?
The MRP domain properties of a PROFINET device can be found in the following area of the 
"PROFINET interface" group in the "Diagnostics" folder of the Online and Diagnostics view of 
the device to be diagnosed:

● Domain 

"Domain" area
This area is divided into the following subareas:

● Sync domain

● MRP domain

What is an MRP domain?
The Media Redundancy Protocol (MRP) enables redundant networks to be structured. 
Redundant transmission paths (ring topology) ensure that, if one transmission path fails, an 
alternative communication path is available. The PROFINET devices that are part of this 
redundant network form an MRP domain.

"MRP domain" subarea of the "Domain" area   
This subarea shows the following properties of the MRP domain:

● Name:
Name of MRP domain

● Role:
Role of the PROFINET device in the MRP domain. The following roles are possible:

– Manager

– Manager (Auto)

– Client

– Not a device of the ring

● Ring port 1:
The port of the PROFINET device that has the "Ring port 1" property
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● Ring port 2:
The port of the PROFINET device that has the "Ring port 2" property

● Status of the MRP ring:
Indicates whether the ring is interrupted ("open" status) or not ("closed" status).

Displaying current firmware of a module

Displaying firmware
You can display the currently installed firmware of a module.

Requirements
● The module supports a firmware update.

● The module is connected online.

Procedure
To display the current firmware, follow these steps:

1. Open the module in the Online and Diagnostics view.

2. Select the "Firmware update" group in the "Functions" folder.

3. You read off the current firmware in the "Online data" area under "Firmware".

 

8.2.1.3 Showing the current values of dynamic modules properties

Display measured cycle times

Where do I find the information I need?
The measured cycle times can be found at each of the following places:  

● In the "Cycle time" group of the "Diagnostics" folder in the Online and Diagnostics view of 
the module to be diagnosed.

● In the "Cycle time" pane of the "Online Tools" task card

Structure of the "Cycle time" group in the "Diagnostics" folder of the Online and Diagnostics view
The "Cycle time" group consists of the following areas:

● Cycle time diagram (graphical display of the assigned and measured cycle times)

● Cycle time configured (display of the assigned cycle times as absolute values)

● Cycle times measured (display of the measured cycle times as absolute values)
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Structure of the "Cycle time" pane of the "Online Tools" task card
The "Cycle time" pane displays the cycle time diagram and below it the measured cycle times 
as absolute values.

Graphical display of the measured cycle times
The following measured cycle times are displayed in the cycle time diagram:

● Shortest cycle time: Duration of the shortest cycle since the last transition from STOP to 
RUN
This corresponds to the dashed gray arrow on the left in the diagram.

● Current / last cycle time: Duration of the last cycle
This corresponds to the green arrow in the diagram. If the current / last cycle time exceeds 
the maximum cycle time, the arrow will turn red.

 

  Note

If the duration of the last cycle comes close to the maximum cycle time, it may be possible 
that it will be exceeded. Depending on the CPU type, parameter assignment and your 
user program, the CPU can switch to STOP mode. If for instance you are monitoring the 
tags in your program, this will increase the cycle time.

If the cycle lasts longer than double the maximum cycle time, and you do not restart the 
maximum cycle time in the user program (by calling the extended RE_TRIGR) instruction, 
the CPU will switch to STOP mode.

 

● Longest cycle time: Duration of the longest cycle since the last transition from STOP to 
RUN.
This corresponds to the dashed blue arrow on the right in the diagram.

A blue band extends between the two dashed lines; this band corresponds to the entire range 
of the measured cycle times. If a measured cycle time is greater than the maximum cycle time, 
the portion of the band that lies outside the assigned limits will be colored red.

Display of the measured cycle times as absolute values
The following measured times are displayed in the "Cycle times measured" area and in the 
"Cycle time" pane.

● Shortest cycle time since the last transition from STOP to RUN.

● Current/last cycle time:

● Longest cycle time since the last transition from STOP to RUN.

Showing the current status of the LEDs of a CPU

Where do I find the information I need?
The current status of the LEDs of a CPU can be found in the display area of the "CPU control 
panel" pane of the "Online tools" task card.   
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Display area of the "CPU control panel" pane of the "Online Tools" task card   
This area contains the following displays:

● Station name and CPU type (short designation)

● RUN / STOP (corresponds to the "RUN / STOP" LED of the CPU)

● ERROR (corresponds to the "ERROR" LED on the CPU)

● MAINT (corresponds to the "MAINT" LED on the CPU)

 

Showing fill levels of all types of memory on a CPU

Where do I find the information I need?     
The fill levels of all types of memory on a CPU can be found on the following two pages:

● In the display area of the "Memory" group in the "Diagnostics" folder in the online and 
diagnostics view of the module to be diagnosed

● In the display area of the "Memory" pane on the "Online Tools" task card

Display area of the "Memory" group in the "Diagnostics" folder of the online and diagnostics view
This area contains the current memory utilization of the associated module and details of the 
individual memory areas.

The memory utilization is shown both as a bar diagram and as a numerical value (percentage).

The following memory utilizations are shown:

● Load memory
If no memory card is inserted, the internal load memory is displayed.
If a memory card is inserted, the operating system only uses the inserted load memory as 
the load memory. This is displayed here.

● Work memory

● Retentive memory

Display area of the "Memory" pane of the "Online Tools" task card
This area contains the current memory utilization of the associated module. The available 
memory is shown both as a bar diagram and as a numerical value (percentage). The numerical 
value is rounded to an integer value.

 

 Note

If less than 1% of a memory area is utilized, the available portion of this memory area is 
shown as "99%".

 

The following memory utilizations are shown:
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● Load memory
If no memory card is inserted, the internal load memory is displayed.
If a memory card is inserted, the operating system only uses the inserted load memory as 
the load memory. This is displayed here.

● Work memory

● Retentive memory

See also
Load memory (Page 843)

Work memory (Page 843)

Retentive memory areas (Page 845)

Displaying fill level of all types of memory of an S7-1500 CPU

Where do I find the information I need?     
The fill levels of all types of memory of an S7-1500 CPU can be found at the following two 
places:

● In the display area of the "Memory" group in the "Diagnostics" folder in the online and 
diagnostics view of the module to be diagnosed

● In the display area of the "Memory" pane on the "Online Tools" task card

Display area of the "Memory" group in the "Diagnostics" folder of the online and diagnostics view
This area contains the current memory utilization of the associated module and details of the 
individual memory areas.

The memory utilization is shown both as a bar diagram and as a numerical value (percentage).

The following memory utilizations are shown:

● Load memory
 

  Note

The load memory is located on the SIMATIC memory card.
 

● Code work memory: work memory for program code

● Data work memory: work memory for data blocks

● Retentive memory
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Display area of the "Memory" pane of the "Online Tools" task card
This area contains the current memory utilization of the associated module. The available 
memory is shown both as a bar diagram and as a numerical value (percentage). The numerical 
value is rounded to an integer value.

 

 Note

If less than 1% of a memory area is utilized, the available portion of this memory area is 
shown as "99%".

 

The following memory utilizations are shown:

● Load memory
 

  Note

The load memory is located on the SIMATIC memory card.
 

● Code work memory: work memory for program code

● Data work memory: work memory for data blocks

● Retentive memory

8.2.1.4 Checking a module for defects

Determining the diagnostic status of a module

Where is the diagnostics status of a module displayed?     
The diagnostic status of a module is displayed in the "Diagnostic status" group in the 
"Diagnostics" folder in the online and diagnostics view of the module to be diagnosed.

The "Diagnostics status" group consists of the following areas:

● Status

● Standard diagnostics (for S7-300 and S7-400 only for non-CPU modules)

Editing devices and networks
8.2 Device and network diagnostics

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  981



"Status" area
The following status information is displayed in this area:

● Status of the module as viewed by the CPU, for example:

– Module available and OK.

– Module defective.
If the module experiences a fault and you have enabled the diagnostic error interrupt 
during configuration, the "Module defective" status is displayed.   

– Module configured, but not available.
Example: Diagnostics data is not available because the current online configuration 
differs from the offline configuration.

● Detected differences between the configured and the inserted module. Provided it can be 
ascertained, the order number will be displayed for the set and actual type.

The scope of the displayed information depends on the selected module.

"Standard diagnostics" area
The following diagnostics information for non-CPU modules is displayed in this area:

● Internal and external faults that relate to the overall module

● Associated diagnostics events

Examples of such diagnostics information are:

● Entire backup failed

● Module defective
 

  Note
Diagnostic interrupts

A diagnostic interrupt can be reported to the CPU only if the module has diagnostic 
interrupt capability and the diagnostic interrupt has been enabled.

The display of the diagnostic interrupt is a snapshot. Sporadic module defects can be 
identified in the diagnostics buffer of the respective CPU.

 

 

Reading out the diagnostics buffer of a CPU

Where do you read out the diagnostics buffer of a CPU?     
You read out the diagnostics buffer of a CPU in the "Diagnostics buffer" group in the 
"Diagnostics" folder in the Online and Diagnostics view.
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Structure of the "Diagnostics buffer" group
The "Diagnostics buffer" group consists of the following areas:

● "Events"

● "Settings"

Diagnostics buffer
The diagnostics buffer is used as a log file for the diagnostics events that occurred on the CPU 
and the modules assigned to it. These are entered in the order of their occurrence, with the 
latest event shown at the top.

"Events" area
The "Events" area consists of the following elements:

● Check box "CPU time stamp takes into account local PG/PC time"

● Event table

● "Freeze display" or "Cancel freeze" button

● Details of the event: Event no., event ID, description, time stamp, incoming/outgoing 
information

● "Help on event", "Open in editor", "Save as ..." buttons

Check box "CPU time stamp takes into account local PG/PC time"
If you have not activated the check box, the diagnostics buffer entries are shown with the 
module time.

If you have activated the check box, the diagnostics buffer entries are shown with the time 
given by the following formula:

Displayed time = module time + time zone offset on your programming device / PC

This requires the module time to be identical to UTC.

You should use this setting if you wish to see the times of the diagnostics buffer entries for the 
module expressed in the local time of your programming device / PC.

Selecting or clearing the check box immediately changes the times displayed for the 
diagnostics buffer entries.

 

 Note

If you use the "WR_SYS_T" instruction in your program or if you set the real-time clock of the 
CPU using an HMI device instead of using UTC, we recommend that you clear the "CPU time 
stamp takes into account local PG/PC time" check box. In this case, the module time is the 
sole time of concern.
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Event table
The following information is displayed in the table for each diagnostics event:

● Sequential number of the entry
The first entry contains the latest event.

● Date and time of the diagnostics event
If no date and time are shown, the module has no integral clock.

● Short name of the event and, if applicable, the reaction of the CPU
 

  Note

If an individual parameter of a text cannot be determined, the character string "###" is 
shown in its place.

If no display text is yet available for new modules or new events, the numbers of the events 
and the individual parameters are stated as hexadecimal values.

 

● Icon for information related to incoming/outgoing status
The following table shows the available icons and their respective meaning.

Icon Meaning
Incoming event

Outgoing event

Incoming event to which there is no independent outgoing event

User-defined diagnostics event

● Only for S7-1200 and S7-1500 CPUs: Icon for the severity of the event
The following table shows the available icons and their respective meaning.

Icon Meaning
No maintenance and/or no fault

Maintenance required

Maintenance demanded

Error

You can change the order of the columns, adjust the column widths and remove and add 
individual columns in the event table. In addition, you can sort as follows: by sequential number, 
by "Date and time" and by "Event".

"Freeze display" or "Cancel freeze" button
The "Freeze display" or "Cancel freeze" button is only enabled when there is an online 
connection to the CPU.

The default setting is "Freeze display".

The following happens when you click the "Freeze display" button:
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● The current display of the diagnostics buffer entries is frozen.

● The labeling of the button changes to "Cancel freeze".

If an error has occurred in your system, diagnostics events can occur very quickly in 
succession. This produces a high update rate on the display. Freezing the display allows you 
to calmly examine the situation in more detail.

If the display is frozen and you click the "Cancel freeze" button, the following happens:

● The display of the diagnostics buffer entries is updated again.

● The labeling of the button changes to "Freeze display".
 

 Note

If you freeze the diagnostics buffer display, the CPU continues to enter events in the 
diagnostics buffer.

 

Details of the event
If you select a line in the list of events, you obtain detailed information on the respective event:

● Sequential number of the event in the diagnostics buffer

● Event ID

● Description of the event with event-dependent additional information. Examples of this 
additional information:

– Command that caused the event

– Operating mode switch caused by the diagnostics event

● Time stamp

● Only for S7-1200 and S7-1500 CPUs: Associated I&M data (module, rack/slot, plant 
designation, location designation)

● Priority of the event

● Information on whether the event is an incoming or outgoing event

"Help on event" button
If you click on this button, the selected event is explained in more detail and any remedies 
given.

 

 Note

For a small number of events, the "Help on event" button is grayed out.
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"Open in editor" button
The following table shows if the "Open block" button is active and which function it conceals.

When is the "Open in editor" button enabled? What happens when you click this button?
If the diagnostics event references the relative address of a 
block.
This is the address of the command that caused the event.

The "Open in editor" function opens the referenced block in 
the offline view at the programming instruction that causes 
the error. This allows you to check and, if necessary, change 
the source code of the block at the specified place and then 
download it again to the CPU.

If the diagnostics event was triggered by a module. The "Open in editor" function opens the Device view of the 
module involved.

"Save as ..." button
If you click this button, the content of the diagnostics buffer is saved in a text file. "Diagnostics", 
depending on the language, with the extension ".txt" is suggested as the file name. You can 
however change this name.

"Settings" area
The "Settings" area consists of the following elements:

● "Display events" list

● "Apply settings as default" button

● "Output event information in hexadecimal format" check box

"Display events:" list
There is an check box in this list for every event class (default setting: all check boxes are 
selected). If you clear a check box, the events of that event class is no longer displayed in the 
"Events" area. Reselecting the check box displays the associated events once again.

"Apply settings as default" button
If you click this button, the settings are also applied to future occasions when the "Events" tab 
is opened.

"Output event information in hexadecimal format" check box
If you select the check box, the event IDs in the Events list of the "Events" area is displayed 
in hexadecimal format. If you clear the check box, the event information is given in text form.

 

See also
Basic information on the diagnostics buffer  (Page 1003)
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Saving service data

Purpose
In the event of servicing it may be possible that the SIEMENS Customer Support requires very 
special information about the state of a module of your system for diagnostic purposes.

If such a case occurs in your system, you will be asked by Customer Support to save the 
service data of the module and send the resulting file to them.

Where do you carry out the saving of service data of a module?
You carry out the saving of service data of a module in its online and diagnostics view at the 
following points: In the "Functions" folder in the "Save service data" group"

The "Save service data" group consists of the following areas:

● Online data

● Saving service data

"Online data" area
This area shows the following data for the module:

● Order number

● Firmware version

● Module name (you configured this while configuring the hardware.)

● Rack

● Slot

"Save service data" area
Proceed as follows to create and save a file with special service data:

1. Select the point in the file system at which you want to save the file:

– You use the path preset in the "Path" field.

– Click the three-dot (browse) button. In the dialog that opens specify the desired path 
and enter the file name.

2. Click the "Save data" button.
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8.2.1.5 Changing the properties of a module or the programming device/PC

Changing the mode of a CPU

Requirement  
There is an online connection to the CPU whose mode you want to change.

Procedure
To change the mode of the CPU, follow these steps:

1. Enable the "Online tools" task card of the CPU.

2. Click the "RUN" button in the "CPU control panel" pane if you want to change the CPU to 
RUN mode or the "STOP" button if you want to change the CPU to STOP mode.

 

  Note

The only button active is the one that can be selected in the current operating mode of 
the CPU.

 

3. Acknowledge the confirmation prompt with "OK".

Or:

1. Open the "Online" menu.

2. Choose the "Start CPU" menu command if you want to set the CPU to RUN mode and 
"Stop CPU" if you want to set the CPU to STOP mode.

 

  Note

The only button that is active is the one that can be chosen in the current operating mode 
of the CPU.

 

3. Acknowledge the confirmation prompt with "OK".

Or:

1. Click the "Start CPU" button in the toolbar if you want to set the CPU to RUN mode and the 
"Stop CPU" button if you want to set the CPU to STOP mode.

 

  Note

The only button that is active is the one that can be chosen in the current operating mode 
of the CPU.

 

2. Acknowledge the confirmation prompt with "OK".

 

Result
The CPU will be switched to the required operating mode.
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Performing a memory reset

Requirement   
● There is an online connection to the CPU on which the memory reset is to be performed.

● The CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start the memory reset, you can place it in STOP 
mode after acknowledging a confirmation prompt.

 

Procedure
To perform a memory reset on a CPU, follow these steps:

1. Enable the "Online Tools" task card of the CPU.

2. Click the "MRES" button in the "CPU control panel" pane.

3. Acknowledge the confirmation prompt with "OK".

Result
The CPU is switched to STOP mode, if necessary, and the memory reset is performed on the 
CPU.

See also
Basics of a memory reset (Page 841)

Determining and setting the time of day on a CPU

Where do I find the functions I need? 
You determine and change the time of day on a CPU in the "Set time of day" group in the 
"Functions" folder of the Online and Diagnostics view. This requires an online connection. 

Structure of the "Set time of day" group
The "Set time of day" group consists of the following areas:

● Area for reading out and setting the time of day

● Time system (This area does not exist for S7-1200 and will not be examined here.)
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Structure of the area for reading out and setting the time of day
This area consists of the following parts:

● Programming device / PC time
Here the time zone setting, the current date and the current time setting of your 
programming device / PC are displayed.

● Module time
Here the date and time values currently read from the module (for example the CPU), are 
converted to local time and date and displayed.
If the "Take from PG/PC" check box is selected, when you click the "Apply" button, the date 
and the PG/PC time converted to UTC are transferred to the module.
If the "Take from PG/PC" check box is not selected, you can assign the date and time for 
the integrated clock of the module. After clicking the "Apply" button, the date and the time 
recalculated to UTC time are transferred to the module.

Updating the firmware of a module

Performing a firmware update   
Using firmware files, you can update the firmware of a module.

Requirements
● The module is connected online.

● The module supports a firmware update.

● For those modules that require a supply voltage to perform the firmware update correctly: 
The supply voltage of the module is secured. For details, see the documentation of the 
module.

Procedure
To perform a firmware update, follow these steps:

1. Open the module in the Online and Diagnostics view.

2. Select the "Firmware update" group in the "Functions" folder.
 

  Note

For S7-1500-CPUs, this group is subdivided into "PLC" and "Display".
 

3. Click the "Browse" button in the "Firmware update" area in order to select the path to the 
firmware update files.

4. Select one of these files. The table then lists all modules for which an update is possible 
with the selected firmware file.
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5. Optional: Select the "Run firmware after update" check box to reset the module after the 
load operation and to start the new firmware.

6. Click the "Start update" button. If the selected file can be interpreted by the module, it is 
downloaded to the module. If the mode of the CPU needs to be changed, you will be 
prompted to do this in dialogs.

 

 WARNING

Invalid plant states possible

An S7-1500 CPU immediately goes to STOP mode when you start the firmware update, 
which can have an effect on the operation of an online process or a machine.
Unexpected operation of a process or a machine can result in severe or fatal injuries and/or 
damage to property.

 

 Note

After you have run a firmware update, you will need to replace the module involved with the 
same module with the current firmware version in the hardware configuration of your project. 
The engineering configuration then matches the actual physical configuration again.

 

"Run firmware after update" check box
If you have not selected the "Run firmware after update" check box, the previous firmware 
remains active until the module is reset (for example by cycling power). The new firmware only 
becomes active after the module has been reset.

If you have selected the check box, the module is automatically reset after the firmware has 
been downloaded and it then continues with the new firmware.

Activating the firmware following the update has the following consequences:

● A station executes a restart. This means that all modules in the station become unavailable.

● If the corresponding CPU is in RUN, activating the firmware can lead to access errors or 
other problems in the user program and might even mean that the CPU remains 
permanently in STOP.

 

  Note

For some CPUs, the "Run firmware after update" check box is grayed out and deactivated. 
In this case, you must restart the CPU manually.

For S7-1500 CPUs, the "Run firmware after update" check box is grayed out and selected. 
In this case, the new firmware is activated immediately after the download operation.

 

 

See also
Replacing a hardware component (Page 427)
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Resetting an S7-1200 CPU to factory settings

Requirement
● There is no memory card inserted in the CPU.

● There is an online connection to the CPU that you want to reset to the factory settings.

● The CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start the reset operation, you can place it in STOP 
mode by answering the security prompt with yes.

 

Procedure 
To reset an S7-1200 CPU to factory settings, follow these steps:

1. Open the Online and Diagnostics view of the CPU.

2. Select the "Reset to factory settings" group in the "Functions" folder.

3. Select the "Keep IP address" check box if you want to keep the IP address or the "Delete 
IP address" check box if you want to delete the IP address.

 

  Note

The two check boxes mentioned are only available if the module to be reset is able to 
choose whether to retain or delete the IP address.

 

4. Click the "Reset" button.

5. Acknowledge the confirmation prompt with "OK".

Result
The module is switched to STOP mode if necessary and the settings are then reset to factory 
settings. This means:

● The work memory and the internal load memory and all operand areas are cleared.

● All parameters are reset to their defaults.

● The diagnostic buffer is cleared.

● The time is reset.

● The IP address is kept or deleted depending on which setting you made.
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Resetting an S7-1500 CPU to factory settings

Requirement
● If you start a reset to factory settings from the project context, an online connection to the 

relevant CPU must exist.

● The relevant CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start the reset operation, you can place it in STOP 
mode after acknowledging a confirmation prompt.

 

Procedure   
To reset an S7-1500 CPU to factory settings, follow these steps:

1. Open the Online and Diagnostics view of the CPU (either from the project context or via 
"Accessible devices").

2. Select the "Reset to factory settings" group in the "Functions" folder.

3. Select the "Keep IP address" check box if you want to keep the IP address or the "Delete 
IP address" check box if you want to delete the IP address.

 

  Note

With "Delete IP address", all IP addresses are deleted. This applies regardless of how 
you created the online connection.

If a memory card is inserted, selecting the "Delete IP address" option causes the following: 
The IP addresses are deleted and the CPU is reset to factory settings. Then, the 
configuration (including IP addresses) that is stored on the memory card is transferred 
into the CPU (see below). If the memory card was formatted before resetting to factory 
settings or if it is empty, no IP address is transferred into the CPU.

 

4. Click the "Reset" button.

5. Acknowledge the confirmation prompt with "OK".

Result
The module is switched to STOP mode if necessary and the settings are then reset to factory 
settings. This means:

● The work memory and the internal retentive system memory and all operand areas are 
cleared.

● All parameters are reset to their defaults.

● The diagnostic buffer is cleared.

● The time of day is reset.

● The I&M data are deleted except for I&M0 data.

Editing devices and networks
8.2 Device and network diagnostics

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  993



● The runtime meters are reset.

● The IP address is kept or deleted depending on which setting you made.

● If a memory card was inserted prior to the reset to factory settings, the configuration 
contained on the memory card (hardware and software) is downloaded to the CPU.

Formatting an S7-1500 memory card

Requirement
● If you start the formatting of the memory card from the project context, an online connection 

to the relevant CPU must exist.

● The relevant CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start a formatting operation, you can place it in 
STOP mode after acknowledging a confirmation prompt.

 

Procedure  
To format an S7-1500 memory card, follow these steps:

1. Open the Online and Diagnostics view of the CPU (either from the project context or via 
"Accessible devices").

2. Select the "Format memory card" group in the "Functions" folder.

3. Click the "Format" button.

4. Answer the safety prompt with "Yes".

Result
● The memory card is formatted.

● The CPU is temporarily unavailable.

● The project data on the CPU are deleted with the exception of the IP address.

● If you start the formatting of the memory card from the project context, the Online and 
Diagnostics view remains open. If formatting is started via "Accessible devices", the Online 
and Diagnostics view will close.
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Assigning an IP address to a PROFINET IO device

Basic information on assigning an IP address to a PROFINET IO device

Overview 
All PROFINET IO devices work with the TCP/IP protocol and therefore require an IP address 
for operation on Industrial Ethernet. Once an IP address has been assigned to an IO device, 
it can be accessed via this address. You can then download configuration data or perform 
diagnostics, for example.

Requirement
● The Ethernet LAN connection must already be established.

● The Ethernet interface of your programming device or PC must be accessible.

● The IO device that is to be assigned an IP address must be in the same IP band as the 
programming device or PC.

Starting the address assignment via "Accessible devices"

Requirement
● You have opened the Online and Diagnostics view of the PROFINET IO device using 

"Update accessible devices" (in the project tree) or "Accessible devices..." ("Online" menu).

Procedure 
1. Open the "Functions" folder and the "Assign IP address" group inside this folder. The "MAC 

address" field displays the MAC address of the PROFINET IO device. The "Accessible 
devices" button is grayed out.

2. Enter the desired IP address.

3. Enter the subnet mask.

4. If a router is to be used, select the "Use router" check box and enter its IP address.

5. Click the "Assign IP address" button.
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Result
The IP address is permanently assigned to the IO device or to the relevant PROFINET interface 
of the IO device. It is retained even through a startup or a power failure.

 

 Note

For an S7-1500 CPU, you can also use the above-described method to change the IP address 
of a PROFINET interface, if a project has already been downloaded to the CPU via this 
interface. This overwrites the IP address downloaded via the project.

 

See also
Retentivity of IP address parameters and device names (Page 808)

Starting the address assignment from the project context

Requirement
● An online connection to the PROFINET IO device exists.

● You have opened the Online and Diagnostics view of the PROFINET IO device from the 
project context.

● The PROFINET IO device is not assigned to any IO controller.

Procedure 
1. Open the "Functions" folder and the "Assign IP address" group inside this folder.

2. Click the "Accessible devices" button in order to identify the devices that can be accessed.
Note: For an S7-1500 CPU, there are two entries here because it has two PROFINET 
interfaces.

3. Select the IO device. The "IP address" field, "Subnet mask" field, "Use router" check box 
and "Router address" field are grayed out and contain the node properties you used to 
establish the current online access.

4. Click the "Assign IP address" button.

Result
The IP address is permanently assigned to the IO device or to the relevant PROFINET interface 
of the IO device. It is retained even through a startup or a power failure.

See also
Retentivity of IP address parameters and device names (Page 808)
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Assigning a PROFINET device name

Basic information on assigning a name to a PROFINET IO device

Device name   
Before an IO device can be addressed by an IO controller, it must have a device name. This 
procedure was chosen for PROFINET because names are easier to handle than complex IP 
addresses.

Assigning a device name to a PROFINET IO device is comparable to setting the PROFIBUS 
address for a DP slave.

An IO device has no device name in its delivery state. For an IO controller to address an IO 
device, it must first be assigned a device name using the programming device or PC. It is now 
ready to transfer the configuration information including the IP address during startup or 
exchange user data in cyclic operation. 

Rules for the device name
The device name is subject to the following limitations:

● Restricted to a total of 240 characters (lower case letters, numbers, dash, or dot)

● A name component within the device name, which is a character string between two dots, 
must not exceed 63 characters.

● No special characters such as umlauts, brackets, underscore, slash, blank space, etc. The 
only special character permitted is the dash.

● The device name must not begin or end with the "-" character.

● The device name must not begin with a number.

● The device name form n.n.n.n (n = 0, ... 999) is not permitted.

● The device name must not begin with the string "port-xyz" or "port-xyz-abcde" (a, b, c, d, 
e, x, y, z = 0, ... 9).

Where do I find the function I am seeking?
To assign a name to a PROFINET IO device, go to the "Assign name" group in the "Functions" 
folder of the Online and Diagnostics view for the device. The user interface for this group differs 
depending on how you open the Online and Diagnostics view:

● Open via "Accessible devices"

● Open from the project context

 

See also
Starting the name assignment via "Accessible devices" (Page 998)

Calling the name assignment function from within the project context (Page 998)
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Starting the name assignment via "Accessible devices"

Requirement   
● You have opened the Online and Diagnostics view of the PROFINET IO device using 

"Update accessible devices" (in the project tree) or "Accessible devices..." ("Online" menu).

Procedure
1. Open the "Functions" folder and the "Assign name" group inside this folder. The "Type" 

field displays the module type of the PROFINET IO device.

2. Enter the required device name in the "PROFINET device name" input box.

3. Optional: Select the "LED flashes" check box in order to run an LED flash test on the 
PROFINET IO device. In this way you verify that you are naming the desired IO device.

 

  Note

The LED flash test is not supported by all PROFINET IO devices.
 

The LED flash test runs until you cancel it. This is done, for example, by clearing the "LED 
flashes" check box, by selecting another IO device in the table, or by closing the Online 
and Diagnostics view.

4. Click "Assign name".

Result
The entered name is assigned to the PROFINET IO device.

 

Calling the name assignment function from within the project context

Requirement   
● An online connection to the PROFINET IO device is not required.

● You have opened the Online and Diagnostics view of the PROFINET IO device from the 
project context.

● The PROFINET IO device can be accessed using at least one PG/PC.
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Procedure
1. Open the "Functions" folder and the "Assign name" group inside this folder. The 

"PROFINET device name" drop-down list displays the current name in the offline project, 
and the "Type" box shows the module type of the PROFINET IO device.

 

  Note

For S7-1500 CPUs, the names of the two PROFINET interfaces in the offline project are 
displayed.

 

2. Choose a different name from the drop-down list, if necessary.
 

  Note

In steps 3 to 5, you determine the IO devices that are present in the PROFINET subnet.
 

3. In the "PG/PC interface for assignment" drop-down list, select the PG/PC interface you 
want to use to establish the online connection.

4. Optional: Use the three check boxes to make a selection from all IO devices available online.

5. Click the icon for determining the IO devices present in the PROFINET subnet. The table 
is then updated.

6. Select the desired IO device in the table.

7. Optional: Select the "LED flashes" check box in order to run an LED flash test on the 
PROFINET IO device. In this way you verify that you are naming the desired IO device.

 

  Note

The LED flash test is not supported by all PROFINET IO devices.
 

The LED flash test runs until you cancel it. This is done, for example, by clearing the "LED 
flashes" check box, by selecting another IO device in the table, or by closing the Online 
and Diagnostics view.

8. Click "Assign name".

Result
The selected name is assigned to the PROFINET IO device.

 

 Note

For S7-1500-CPUs, the selected name is assigned to the PROFINET interface selected 
above.
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Calibrating an S7-1500 analog module

Calibrating an S7-1500 analog module - Overview

Where do you calibrate an S7-1500 analog module? 
You calibrate an S7-1500 analog module in its Online and Diagnostics view in the "Calibrate" 
group of the "Functions" folder.

Overview of the function scope of the calibrating function
You can perform the following functions for an S7-1500 analog module in the "Calibrate" group:

● Specifying the current calibration of all channels

● Calibrating a channel

● Canceling a running calibration

● Resetting the calibration of a channel to the factory settings

Requirement for the calibrating function described below
The following is required for the calibrating function described below:

● You have opened the Online and Diagnostics view from the project context (thus not from 
the project tree or via the "Online" menu).

● There is an online connection to the analog module that is to be calibrated.

● Offline and online configuration are identical.

Calibrating an S7-1500 analog module

Overview of the calibration of a channel of an S7-1500 analog module 
The calibration of a channel of an S7-1500 analog module consists of the following steps:

1. Start calibration

2. Perform the second step up to the next to last step of the calibration

3. Complete calibration

These steps are described in more detail in the following section.
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Requirement
● You have opened the Online and Diagnostic view of the S7-1500 analog module from the 

project context and are in the "Calibrate" group of the "Functions" folder.

● The associated CPU is online.

● No calibration is currently running on the analog module (if you want to start the calibration) 
or the last step initiated has been performed successfully (if you want to resume or complete 
the calibration).

Procedure for starting the calibration
To start the calibration, follow these steps:

1. In the overview table, select the line that belongs to the channel to be calibrated.

2. Click the "Start manual calibration" button.

The user interface then changes as follows: 

● The overview table and the "Start manual calibration" button and "Set to factory settings" 
buttons become inactive.

● The step display is activated and displays the numbers of the current and last steps.

● The "Command" field becomes active and indicates what the user must do in the next 
calibration step.

● The "Status" field becomes active and shows the current status of the calibration, e.g., 
"Calibration successfully started".

● The "Measured value" field becomes active. For an input module a value is displayed here; 
you must enter a value here for an output module.

● The "Cancel" button becomes active.

● The "Next" button becomes active. This button can be used to advance to the next step of 
the calibration.

Procedure for the second to the next to last step of the calibration
Follow these steps:

1. Click the "Next" button.

The fields of the user interface described above are then updated.

Procedure for the last step of the calibration
Follow these steps:

1. Click the "Next" button.

The user interface then changes as follows:

● The overview table becomes active.

● The calibration display of the calibrated channel is updated.

● The "Start manual calibration" button and "Set to factory settings" buttons become active.
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● The step display is deactivated and the numbers of the current step and last steps are 
empty.

● The "Command" field becomes inactive and is empty.

● The "Status" field becomes inactive and shows the last status of the calibration, e.g., 
"Calibration successfully finished".

● The "Measured value" field becomes inactive and is empty.

● The "Cancel" button becomes inactive.

● The "Next" button becomes inactive.

Error occurrence
If an error occurs during the calibration, the module cancels the calibration. Afterwards, the 
channel that was to be calibrated has the same settings as before the start of the calibration.

Except for the "Status" field, the user interface appears the same after the occurrence of an 
error as before the calibration. The "Status" field displays the error that the module detected 
during the calibration.

Canceling a running calibration of an S7-1500 analog module

Requirement
● You have opened the Online and Diagnostic view of the S7-1500 analog module from the 

project context and are in the "Calibrate" group of the "Functions" folder.

● The associated CPU is online.

● A calibration is currently running on the analog module.

Procedure 
To cancel a running calibration, follow these steps:

1. Click the "Cancel" button.

Result
The running calibration is canceled, and afterwards the channel to be calibrated has the same 
settings as before the calibration.

All operator controls in the user interface are deactivated until the cancelation is complete. 
Except for the "Status" field, the user interface appears the same afterwards as before the 
calibration. The "Status" field displays the result of the cancelation.
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Resetting an S7-1500 analog module to factory settings

Requirement
● You have opened the Online and Diagnostic view of the S7-1500 analog module from the 

project context and are in the "Calibrate" group of the "Functions" folder.

● The associated CPU is online.

Procedure 
To reset a channel of an S7-1500 analog module to factory settings, follow these steps:

1. Select the line associated with the channel to be reset in the overview table.

2. Click the "Set to factory settings" button.

Result
All operator controls in the user interface are deactivated until the reset operation is complete. 
Except for the "Status" field, the user interface appears the same afterwards as before the 
reset operation. The "Status" field displays the result of the reset operation.

8.2.1.6 Diagnostics in STOP mode

Basic information on the diagnostics buffer 

Function 
The operating system of the CPU enters the errors detected by the CPU and the diagnostics-
capable modules into the diagnostics buffer in the order in which they occurred. This includes 
the following events:

● Every mode change of the CPU (POWER UP, change to STOP mode, change to RUN 
mode)

● Every hardware and diagnostic error interrupt

The top entry contains the most recent event. The entries in the diagnostics buffer are stored 
permanently. They are retained even if the power supply fails and can only be deleted by 
resetting the CPU to factory settings.

A diagnostics buffer entry contains the following elements:

● Time stamp

● Error ID

● Additional information specific to the error ID
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Advantages of the diagnostics buffer
The diagnostics buffer offers the following advantages:

● After the CPU has changed to STOP mode, you can evaluate the last events prior to the 
STOP so that you can locate and identify the cause of the STOP.

● You can detect and eliminate the causes of errors more quickly and thus increase the 
availability of the system.

● You can evaluate and optimize the dynamic system response.

Organization of the diagnostics buffer
The diagnostics buffer is a ring buffer. The maximum number of entries for the S7-1200 CPUs 
is 50. When the diagnostics buffer is full and a further entry needs to be made, all existing 
entries are shifted by one position (which means that the oldest entry is deleted) and the new 
entry is made at the top position that is now free (FIFO principle: first in, first out).

Evaluation of the diagnostics buffer
The contents of the diagnostics buffer can be accessed as follows: 

● Using the Online and Diagnostics view

The evaluation of events occurring prior to the error event (e.g., transition to STOP mode) 
allows you to obtain a picture of the possible causes or to zero in more closely or specify in 
more detail the possible causes (depending on the error type).

Read the detailed information about the events carefully and use the "Help on event" button 
to obtain additional information and possible causes of individual entries.

 

 Note

To make the best use of the time stamp information on the diagnostics buffer entries in time-
critical systems, it is advisable to check and correct the date and time of day on the CPU 
occasionally.

Alternatively, it is possible to perform a time-of-day synchronization using an NTP time server.
 

See also
Resetting an S7-1200 CPU to factory settings (Page 992)

Determining the cause of a STOP of a CPU (Page 1005)

Determining and setting the time of day on a CPU (Page 989)

Assigning the clock parameters (Page 863)
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Determining the cause of a STOP of a CPU

Requirement
The CPU you want to analyze is in STOP mode.

Procedure
To find out the reason why a CPU changed to STOP, follow these steps:

1. Open the online and diagnostics view of the CPU.

2. Select the "Diagnostics buffer" group from the "Diagnostics" folder.

3. Evaluate the events occurring prior to the transition to STOP mode. Use this to obtain a 
picture of the possible causes or to zero in on or specify in more detail the possible causes 
(depending on the error type).
Read the detailed information about the events carefully and use the "Help on event" button 
to obtain additional information and possible causes of individual entries.

Result
You were able to zero in on or determine in more detail the cause of the CPU STOP.

 

 Note

If the analysis does not enable you to overcome the problem, contact Customer Support. In 
this case, use the "Save as" button to back up the content of the diagnostics data to a text 
file and submit it to Customer Support.

 

See also
Reading out the diagnostics buffer of a CPU (Page 982)

Editing devices and networks
8.2 Device and network diagnostics

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1005



8.2.1.7 Online accesses in the Online and Diagnostics view

Displaying status of the online connection

Requirement  
● The associated device can be accessed using at least one PG/PC interface.

Procedure
1. Open the Online and Diagnostics view for the device whose online connection status you 

want to display.

2. Select the "Online access" group.
 

  Note

The "Online access" group exists only for CPUs. However, if you have opened the Online 
and Diagnostics view using the "Show/update accessible devices" function, it will not be 
displayed.

 

Result
The status of the online connection is displayed in the "Status" area both graphically and in 
text form.

Specifying a PG/PC interface, going online

Requirement   
● The associated device can be accessed using at least one PG/PC interface.

● There is currently no online connection to the relevant device.

Procedure
1. Open the Online and Diagnostics view of the device to which you want to establish an online 

connection.

2. Choose the "Online access" group and the "Online access" area within this group.
 

  Note

The "Online access" group exists only for CPUs and some CPs. If you have opened the 
Online and Diagnostics view using the "Show/update accessible devices" function, it is 
not displayed.
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3. If an online connection was established previously for the device, the associated data for 
this online connection is preset in the drop-down lists. In this case, you can immediately 
continue with the last step of this operation, provided you have not changed the IP address 
in the meantime using the Online and Diagnostics view.

4. Choose the interface type in the "Type of PG/PC interface" drop-down list.
The "PG/PC interface for online access" drop-down list then shows only the interfaces of 
the programming device or PC that match the selected interface type.

5. In the "PG/PC interface for online access" drop-down list, select the programming device 
or PC interface via which you want to establish the online connection.

6. Optional: Click the "Properties" button to change the properties of the associated CP.

7. In the "Connection to subnet" drop-down list, select the subnet via which the device is 
connected to the PG/PC interface.

 

  Note

The PG/PC interface is connected to an interface of a device.

If you only want to access this device, select the setting "Directly at slot <interface name>" 
in the drop-down list.

If you want to access another device by means of routing, however, create a subnet at 
this interface in the hardware configuration and then select this subnet in the drop-down 
list.

 

8. If the device is accessible via a gateway, select the gateway that connects the two subnets 
involved in the "1st gateway" drop-down list.

9. In the "Device address" entry field, enter the IP address of the device to which you want to 
establish an online connection, if necessary.

 

  Note

For CPUs with multiple IP addresses, select the IP address of the PROFINET interface 
you want to use to establish an online connection from the "Device address" drop-down 
list.

 

10.Alternatively: Click the "Show accessible devices" button and choose the device from the 
list of accessible devices to which you want to establish an online connection.

11.Click the "Go online" button.

Result
The online connection to the desired device is established.
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Going offline

Requirement  
● There is currently an online connection to the relevant device.

Procedure
1. Open the Online and Diagnostics view of the device for which you want to disconnect the 

online connection.

2. Choose the "Online access" group and the "Online access" area within this group.
 

  Note

The "Online access" group exists only for CPUs. However, if you have opened the Online 
and Diagnostics view using the "Show/update accessible devices" function, it will not be 
displayed.

 

3. Click the "Go offline" button.

Result
The online connection to the desired device will be disconnected.

Performing the flash test for a device with an online connection

Requirement   
● There is currently an online connection to the relevant device.

● The FORCE function is not active.

Procedure
1. Open the Online and Diagnostics view of the device for which you want to perform a flash 

test.

2. Choose the "Online access" group and the "Status" area within this group.
 

  Note

The "Online access" group exists only for CPUs. However, if you have opened the Online 
and Diagnostics view using the "Show/update accessible devices" function, it is not 
displayed.

 

3. Select the "LED flash test" check box.
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Result
● On an S7-1200 CPU, the RUN/STOP, ERROR and MAINT LEDs flash.

● On an S7-1500 CPU, the RUN/STOP, ERROR, and MAINT LEDs flash.

● On an S7-300 or S7-400 CPU, the FRCE LED flashes.

The LEDs flash until you cancel the flash test. This is done, for example, by clearing the "LED 
flash test" check box, by changing to another group of the Online and Diagnostics view, or by 
changing settings in the "Online accesses" area.

8.2.1.8 Checking PROFIBUS DP subnets for faults

Basic information on the diagnostic repeater

What is the diagnostic repeater?  
The diagnostic repeater is a repeater that can monitor a segment of an RS 485 PROFIBUS 
subnet (copper cable) during operation and signal line errors to the DP master via a diagnostics 
message frame.

The diagnostic repeater detects, localizes and visualizes line errors during operation at an 
early stage. As a result, problems in the system are identified early and production downtimes 
will be minimized.

Function of the diagnostic repeater
The diagnostic repeater can perform line diagnostics on the DP2 and DP3 segments because 
it has a measuring circuit for these segments.

The line diagnostics run in two steps:

●  Step 1: Topology determination
You start the topology determination by calling the "DP_TOPOL" instruction in your program.
The diagnostic repeater then determines the PROFIBUS addresses and the distance of 
the devices and creates a topology table.

●  Step 2: Error localization
The diagnostic repeater checks the lines during operation. It determines the distance to the 
point of the error and the reason for the error; it then issues a diagnostics alarm with relative 
information on the error location.

Display of detailed information on the determined error location
You receive detailed information on the determined error location in the Online and Diagnostics 
view of the diagnostic repeater.

● By means of icons

● By means of a display with graphics and text

Editing devices and networks
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See also
Displaying the status of the segment diagnostics using icons (Page 1010)

Displaying the status of the segment diagnostics using graphics and text (Page 1010)

Displaying the status of the segment diagnostics using icons

Where do I find the information I need?  
The icons for the status of the segment diagnostics are available:

● In the expanded "Segment diagnostics" folder in the navigation pane of the Online and 
Diagnostics view of the relevant diagnostic repeater.

The diagnostics icon associated with the segment will be displayed behind the segment 
designation. It must be noted here that line errors will be displayed for the DP2 and DP3 
segments only. The DP1 and programming device segments do not display errors in the form 
of a diagnostics icon; rather, they signal only a few bus errors.

Diagnostics icons
The following table shows the available icons and their meaning.

Icon Meaning
Segment is error-free

Segment contains errors

Segment is deactivated

Displaying the status of the segment diagnostics using graphics and text

Where is the status of the segment diagnostics displayed with graphics and text?
The status of the segment diagnostics will be displayed using graphics and text in the "DP1", 
"DP2", "DP3", and "PG" groups of the "Segment diagnostics" folder in the Online and 
Diagnostics view of the relevant diagnostic repeater.

Structure of the "DP1", "DP2" "DP3", and "PG" groups
The "DP1", "DP2", "DP3", and "PG" groups consist of the following elements:

● "Error location" field

● "Error" field

● "Resolution" field
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● "Help on event" button

● "Freeze display" or "Cancel freeze" button

"Error location" field
This field displays the error location graphically, provided the diagnostic repeater can 
determine the location.

The following picture shows an example for a line error occurring in the DP2 segment.

In this example, the diagnostic repeater has the PROFIBUS address 2, and a line error has 
occurred between the devices with PROFIBUS addresses 16 and 17. This line error is located 
25 m from device 16, 4 m from device 17, and 72 m from the diagnostic repeater.

"Error" field
The error is explained in plain text in this field.

"Resolution" field
Here, you will find actions for resolving the error.

"Help on event" button
Click this button to obtain a more detailed explanation of the error and additional details on 
resolving the error, if applicable.

"Freeze display" or "Cancel freeze" button
The "Freeze display" or "Cancel freeze" button is only enabled when there is an online 
connection to the diagnostic repeater.

The default setting is "Freeze display".

The following happens when you click the "Freeze display" button:

● The current display of the segment diagnostics is frozen.

● The labeling of the button changes to "Cancel freeze".

If the display is frozen and you click the "Cancel freeze" button, the following happens:
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● The display of the segment diagnostics is updated again.

● The labeling of the button changes to "Freeze display".

8.2.2 Connection diagnostics

8.2.2.1 Overview of connection diagnostics

Basics  
Connection diagnostics, as described below, refers to the diagnostics of communication 
connections.

The connection diagnostics is started each time an online connection is established to a 
module (CPU or CP) that participates in one or more communication services. The connection 
status is updated automatically in the background.

In the case of one-way connections, an online connection must exist to the communication 
partner that has established the communication connection.

On connections configured at both ends, a distinction between the following two situations 
must be made:

● If there is an online connection to only one connection endpoint, only the part of the 
connection belonging to this connection endpoint can be diagnosed.

● If there is an online connection to both connection endpoints, both parts of the connection 
(and therefore the entire connection) can be diagnosed.

Basic connections diagnostics options
Connection diagnostics can be performed as follows:

● Using icons on the connection status display
This display is generated in the connection table.

● Through detailed connection diagnostics
This step is available in the "Diagnostics > Connection information" area of the Inspector 
window.

Requirement for the connection diagnostics described below
You can display the details of either all the communication connections created in the project 
(default) or selected communication connections in the connection table.

The connection diagnostics described in the following assume that you display the details of 
selected communication connections. To do this, clear the "Show all connections" option in 
the shortcut menu.
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8.2.2.2 Displaying the connection status using icons

Content of connection table without an online connection
● For a CPU or CP, the connection table lists the communication connections (including 

properties) configured offline, if an online connection is not established.

Content of connection table with an online connection   
After the online connection has been established, the properties of the communication 
connections listed offline will be expanded to include diagnostics icons for the connection 
status ("Online status" column).

In addition, entries for all communication connections that exist online only (e.g., connections 
for the instructions for Open User Communication, programming device and OP connections, 
connections for web server access) will now be added to the connection table.

For connections that exist online or offline only, the diagnostics icon at the bottom right is 
combined with a smaller additional comparison status icon.

Diagnostics icons for communication connections   
The following table shows the diagnostics icons for communication connections.

Icon Meaning
Connection setup

Connection not setup / is being setup

Connection not available

Diagnostics icons for the comparison status   
The diagnostic icons for communication connections can be combined at the bottom right with 
additional smaller icons that indicate the result of the online/offline comparison. The following 
table shows the available comparison icons and their meaning.

Icon Meaning
Connection exists online only

Connection exists offline only
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8.2.2.3 Detailed connection diagnostics

Detailed connection diagnostics - overview

Where do I perform detailed connection diagnostics?   
To perform detailed connection diagnostics, go to the "Diagnostics > Connection" information 
of the Inspector window.

How do I open the "Diagnostics > Connection information" area of the Inspector window?
The following options are available for opening the "Connection information" tab of the 
Inspector window.

● Select the line of the relevant connection in the connection table. Click the "Diagnostics" 
and "Connection information" tabs one after the other in the Inspector window.

● Double-click the diagnostics icon of the relevant connection in the connection table.

● This step takes you to the programming editor for a S7 communication instruction or open 
user communication instruction. Double-click the diagnostic icon of the instruction 
(stethoscope).

Structure or the "Diagnostics > Connection information" area of the Inspector window   
Requirements: the content of the "Connection information" tab has been filled, and an online 
connection to at least one end point of the relevant connection has been established.

If a module has been selected (network view), the tab will contain the following group:

● Connection resources (for S7-1200 and S7-1500)

If a connection has been selected (connection table), it will contain the following groups:

● Connection details

● Address details of the connection (for S7-1200 and S7-1500)

 

Determining online connection resources for S7-1200

Where do you determine the online connection resources?  
The online connection resources are obtained in the "Connection resources" group. This group 
is located in the "Diagnostics > Connection information" area of the Inspector window. It is 
displayed only if you have selected a module in the network view to which an online connection 
exists.
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Number of connection resources
● Maximum number: Specifies the maximum number of available connection resources of 

the module.

● Not assigned: Indicates how many connection resources are not yet assigned. If connection 
resources are already reserved for certain types of communication, then the unreserved 
connection resources cannot always be used for the various connection types.

Reserved and currently assigned connection resources
For the communication types indicated below, the connection resources that are reserved and 
currently assigned by the module will be displayed.

Communication type Meaning
PG communication Resources for connections between the module and programming devices (for 

example, for the establishment of a connection from the project tree, for online 
diagnostics, etc.)

HMI communication Resources for connections between the module and HMI devices
Open User Communication Resources for connection of open user communication instructions
S7 communication Resources for configured S7 connections, through which data can be exchanged by 

calling instructions in the user program.
Other communication Specifies other assigned connection resources for which connection resources are not 

reserved.

 

 

Determining online connection resources for S7-1500

Where do you determine the online connection resources?   
The online connection resources are obtained in the "Connection resources" group. This group 
is located in the "Diagnostics > Connection information" area of the Inspector window. It is 
displayed only if you have selected a module in the network view to which an online connection 
exists.

Description of the detailed display of the connection resources
The detailed display of the connection resources includes:

● Number of available connection resources

● Number of configured connection resources

● Number of connection resources still available

For a description of these, go to here .
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Determining connection details

Where do I determine the connection details?   
The connection details are obtained in the "Connection details" group. This group is located 
in the "Diagnostics > Connection information" area of the Inspector window.

When is the "Connection details" group filled in?
The following requirements must be met to fill in the "Connection details" group on the 
"Connection information" tab:

● An online connection to the end point of the relevant connection must exist.

● You have selected a line in the connection table.

Structure of the "Connection details" group
The "Connection details" group consists of the following elements:

● Local ID (hex)

● Connection type (for S7-1200 and S7-1500)

● Protocol

● Connection status: icon and description

● Details

● Last status change (for S7-300 and S7-400 only)

Determining the address details of a connection

Where do I determine the address details of a connection?   
The address details of a connection are obtained in the "Connection address details" group. 
This group is located in the "Diagnostics > Connection information" area of the Inspector 
window.

For which CPUs is the "Connection address details" group available?
The "Connection address details" group of the "Connection information" tab is available for 
S7-1200 and S7-1500 CPUs.

When is the "Connection address details" group filled in?
The following requirements must be met to fill in the "Connection address details" group on 
the "Connection information" tab:

● An online connection to the end points of the relevant connection must exist.

● You have selected a line in the connection table.
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Structure of the "Connection address details" group
The address details relevant to the connection type are specified for the two communication 
partners.
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Programming the PLC 9
9.1 Creating a user program

9.1.1 Programming basics

9.1.1.1 Operating system and user program

Operating system

Function   
The operating system is contained in every CPU and organizes all CPU functions and 
sequences that are not associated with a specific control task. 

The tasks of the operating system, for example, include the following:

● Processing a warm restart 

● Updating the process image of the inputs and outputs

● Calling the user program

● Detecting interrupts and calling interrupt OBs

● Detecting and handling errors

● Managing memory areas

The operating system is a component of the CPU and is already installed there upon delivery.

See also
User program (Page 1019)

User program

Function 
The user program contains all functions that are necessary for processing your specific 
automation task. 

The tasks of the user program include:
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● Checking the requirements for a (warm) restart using startup OBs, for example, limit switch 
in correct position or safety relay active. 

● Processing process data, e.g. linking binary signals, reading in and evaluating analog 
values, defining binary signals for output, and outputting analog values

● Reaction to interrupts, for example, diagnostic error interrupt if the limit value of an analog 
expansion module is overshot.

● Error handling in normal program execution

You write the user program and load it into the CPU.

See also
Operating system (Page 1019)

9.1.1.2 Blocks in the user program

Linear and structured programming

Linear programming 
Solutions for small automation tasks can be programmed linearly in a program cycle OB. This 
is only recommended for simple programs. 

The following figure shows a linear program schematically: The "Main1" program cycle OB 
contains the complete user program. 

Structured programming 
Complex automation tasks can be more easily handled and managed by dividing them into 
smaller sub-tasks that correspond to the technological functions of the process or that can be 
reused. These sub-tasks are represented in the user program by blocks. Each block is then 
an independent section of the user program.
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Structuring the program offers the following advantages:

● Extensive programs are easier to program through the structure.

● Individual program sections can be standardized and used repeatedly with changing 
parameters.

● Program organization is simplified.

● Changes to the program can be made more easily.

● Debugging is simplified since separate sections can be tested.

● Commissioning is simplified.

The following figure shows a structured program schematically: The "Main1" program cycle 
OB calls subprograms one after the other that execute defined subtasks.

Overview of the block types

Block types   
Different BLOCK types are available to perform tasks within an automation system. The 
following table shows the available block types:

Block type Brief description
Organization blocks  (Page 1022) (OB) Organization blocks define the structure of the user program.
Functions  (Page 1022) (FC) Functions contain program routines for recurring tasks. They have no 

"memory".
Function blocks  (Page 1023) (FB) Function blocks are code blocks that store their values permanently in 

instance data blocks, so that they remain available even after the block has 
been executed.

Instance data blocks (Page 1025) Instance data blocks are assigned to a function block when it is is called for 
the purpose of storing program data.

Global data blocks (Page 1024) Global data blocks are data areas for storing data that can be used by any 
blocks.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1021



Organization blocks (OB)

Definition    
Organization blocks (OBs) form the interface between the operating system and the user 
program. They are called by the operating system and control, for example, the following 
operations:

● Startup characteristics of the automation system

● Cyclic program processing

● Interrupt-driven program execution

● Error handling

You can program the organization blocks and at the same time determine the behavior of the 
CPU. Various organization blocks are available to you depending on the CPU used. 

For more information on organization blocks, refer to the descriptions of the modes of operation 
of CPUs in the "Additional information on configurations" chapter in "Configuring Hardware 
and Networks".

Start information of organization blocks
When certain organization blocks are started, the operating system provides information that 
can be evaluated in the user program. Refer to the descriptions of the organization blocks to 
find out which information is provided, if any. 

 

See also
Creating organization blocks (Page 1197)

Functions (FCs)

Definition     
Functions (FCs) are code blocks without memory. You have no data memory in which values 
of block parameters can be stored. Therefore, when a function is called, all formal parameters 
must be assigned actual parameters. 
Functions can use global data blocks to store data permanently.

Application
A function contains a program that is executed when the function is called by another code 
block. Functions can be used, for example, for the following purposes:

● To return function values to the calling block, e.g. for mathematical functions

● To execute technological functions, e.g. individual controls using bit logic operations
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A function can also be called several times at different points in a program. As a result, they 
simplify programming of frequently recurring functions.

 

 Note
Parameter transfer when calling functions

To avoid errors when working with functions, observe the information in chapter "Auto-
Hotspot". 

 

See also
Creating functions and function blocks (Page 1198)

Function blocks (FB)

Definition       
Function blocks are code blocks that store their input, output and in-out parameters 
permanently in instance data blocks, so that they remain available even after the block has 
been executed. Therefore they are also referred to as blocks "with memory".

Function blocks can also operate with temporary tags. Temporary tags are will not be stored 
in the instance DB, but are available for one cycle only.

Application
Function blocks contain subroutines that are always executed when a function block is called 
by another code block. A function block can also be called several times at different points in 
a program. As a result, they simplify programming of frequently recurring functions.

Instances of function blocks
A call of a function block is referred to as an instance. An instance data block is required for 
each instance of a function block; it contains instance-specific values for the formal parameters 
declared in the function block. 

The function block can store its instance-specific data in its own instance data block or in the 
instance data block of the calling block. 
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Access modes
S7-1200 and S7-1500 offer two different access options for the instance data blocks, which 
can be assigned to a function block when this is called: 

● Data blocks with optimized access
Data blocks with optimized access have no firmly defined memory structure. The data 
elements contain only a symbolic name in the declaration, no fixed address within the block.

● Data blocks with standard access (compatible with S7-300/400)
Data blocks with standard access have a fixed memory structure. The declaration elements 
contain both a symbolic name in the declaration and a fixed address within the block.

 

 Note

To avoid errors when working with function blocks, refer to the section "Auto-Hotspot".
 

 

See also
Creating functions and function blocks (Page 1198)

Multi-instances (Page 1035)

Instance data blocks (Page 1025)

Basics of block access (Page 1027)

Global data blocks (DB)

Definition     
Data blocks are used to store program data. Data blocks thus contain variable data that is 
used by the user program. Global data blocks store data that can be used by all other blocks.

The maximum size of data blocks varies depending on the CPU. You can define the structure 
of global data blocks anyway you please.

You also have the option of using PLC data types (UDT) as a template for creating global data 
blocks.

Global data blocks in the user program
Every function block, function, or organization block can read the data from a global data block 
or can itself write data to a global data block. This data remains in the data block even after 
the data block is exited. A global data block and an instance data block can be open at the 
same time. 

The following figure shows the different accesses to data blocks:
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Access modes
S7-1200 and S7-1500 offer two different access options for global data blocks: 

● Data blocks with optimized access
Data blocks with optimized access have no fixed defined structure. In the declaration, the 
data elements are assigned only a symbolic name and no fixed address within the block.

● Data blocks with standard access (compatible with S7-300/400)
Data blocks with standard access have a fixed structure. In the declaration, the data 
elements are assigned both a symbolic name and a fixed address within the block.

ARRAY data blocks (S7-1500)
ARRAY data blocks are a particular type of global data block. These consist of an ARRAY of 
any data type. For example, an ARRAY of a PLC data type (UDT) is possible. The DB contains 
no other elements besides the ARRAY. Because of their flat structure, ARRAY data blocks 
facilitate access to the ARRAY elements and their transfer to called blocks.

The "Optimized block access" attribute is always enabled for ARRAY data blocks. ARRAY 
data blocks with standard access are not possible.

The "Move operations" section of the "Instructions" task card offers options for addressing of 
ARRAY DBs. 

 

See also
Creating data blocks (Page 1199)

Basics of block access (Page 1027)

Instance data blocks

Definition       
The call of a function block is referred to as an instance. The data with which the instance 
works is stored in an instance data block. 
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The maximum size of instance data blocks varies depending on the CPU. The tags declared 
in the function block determine the structure of the instance data block. 

Access modes
S7-1200 and S7-1500 offer two different access options for the instance data blocks, which 
can be assigned to a function block when this is called: 

● Data blocks with optimized access
Data blocks with optimized access have no firmly defined structure. The declaration 
elements contain only one symbolic name in the declaration, and no fixed address within 
the block.

● Data blocks with standard access (compatible with S7-300/400)
Data blocks with standard access have a fixed structure. The declaration elements contain 
both a symbolic name in the declaration and a fixed address within the block.

 

See also: Auto-Hotspot

See also
Creating data blocks (Page 1199)

Basics of block access (Page 1027)

CPU data blocks

Definition  
CPU data blocks are generated by the CPU at runtime. To this purpose, insert the 
"CREATE_DB" instruction into your user program. You can use the data block that is generated 
at runtime to save your data. 

CPU data blocks are indicated by means of a small CPU icon in the "Program blocks" folder 
of an available node.  You can monitor the values of the variables of a CPU data block in online 
mode, similar to those of a different data block type.

You cannot create CPU data blocks in your offline project.

Loading CPU data blocks
The CPU data block that the user program has generated by means of the "CREATE_DB" 
instruction is initially only available on the device in online mode.  All CPU data blocks will be 
included with the other blocks the next time you perform a complete download from the device 
to the project. The CPU data blocks are marked with a small CPU icon in the process. However, 
you cannot upload these CPU data blocks to your device again.
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Restrictions on CPU data blocks in the project
Once the CPU data blocks have been loaded into your offline project, you can open and view 
their content. However, note that the CPU data blocks in the project are write-protected. The 
CPU data blocks in the project are therefore subject to the following restrictions: 

● You cannot edit CPU data blocks, or convert these into a different data block type.

● CPU data blocks cannot be assigned a know-how protection.

● You cannot change the programming language of a CPU data block.

● CPU data blocks cannot be compiled or downloaded to a device.

Comparing CPU data blocks
Once the CPU data blocks have been loaded into your offline project, you can run an online/
offline comparison for the CPU DBs loaded. The comparison editor provides you with a 
corresponding overview of the differences. It is possible to synchronize the online and off-line 
version of CPU data blocks if differences are found, but not by downloading the offline version 
to the device.

Deleting CPU data blocks
You can delete CPU data blocks both from the project and from the CPU. 

 

See also
Deleting CPU data blocks (Page 1218)

Blocks with optimized access

Basics of block access

Introduction         
STEP 7 offers data blocks with different access options: 

● Data blocks with optimized access (S7-1200/S7-1500)

● Data blocks with standard access (S7-300 / S7-400 / S7-1200 / S7-1500)

Within one program you can combine the two types of blocks. 

Data blocks with optimized access
Data blocks with optimized access have no fixed defined structure. In the declaration, the data 
elements are assigned only a symbolic name and no fixed address within the block. The 
elements are saved automatically in the available memory area of the block so that there are 
no gaps in the memory. This makes for optimal use of the memory capacity. 
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Tags are identified by their symbolic names in these data blocks. To address the tag, enter its 
symbolic name. For example, you access the "Fill Level" tag in the "Data" DB as follows: 
"Data".Fill Level
Blocks with optimized access offers the following advantages:

● You can create data blocks with any structure without paying attention to the physical 
arrangement of the individual data elements.

● Quick access to the optimized data is always available because the data storage is 
optimized and managed by the system.

● Access errors, as with indirect addressing or from the HMI, for example, are not possible. 

● You can define specific individual tags as retentive.

● Optimized blocks are equipped with a memory reserve by default which lets you expand 
the interfaces of function blocks or data blocks during operation. You can download the 
modified blocks without setting the CPU to STOP and without affecting the values of already 
loaded tags. 

 

 Note

The "Optimized block access" attribute is always enabled for the following blocks and cannot 
be deselected.
● GRAPH blocks
● ARRAY data blocks

 

Data blocks with standard access
Data blocks with standard access have a fixed structure. In the declaration, the data elements 
are assigned both a symbolic name and a fixed address within the block. The address is shown 
in the "Offset" column.

Tags in these data blocks can be addressed in both symbolic and absolute form. 
"Data".Fill Level
DB1.DBW2

Setting Retentivity for Optimized Access or Standard Access
If you define data as retentive, its values are retained even after a power failure or a network 
off. A retentive tag is not initialized after the hot restart but retains the value it had prior to the 
power failure. If a DB tag is defined as retentive, it is stored in the retentive memory area of 
the data block. 

The options for setting the retentivity depend on the access type of the block.
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● In data blocks with standard access, you cannot set the retentive behavior of individual 
tags. The retentivity setting is valid for all tags of the data block.

● In data blocks with optimized access you can define the retentive behavior of individual 
tags. 
For structured data type tags, the retentivity setting always applies to the entire structure. 
You cannot make any individual retentivity setting for separate elements within the data 
type. 

Setting Addressing Options for Optimized Access or Standard Access
Blocks with optimized access permit only "type-safe" access. Type-safe access addresses 
tags by their symbolic name only. This means even changes to the block or the block interface 
will not result in inconsistencies in the program or access errors.

The following table shows the permitted addressing options for optimized data:

 

Addressing Block with standard access Block with optimized access
Symbolic addressing x x
Indexed addressing of ARRAYs  x
Slice access x x
Overlapping with AT x -
Absolute addressing x -
Indirect addressing via ANY x -
Indirect addressing via POINTER and 
VARIANT

x with symbolic notation only

See also
Setting up block access (Page 1029)

Setting up block access

Introduction         
Block access is set up automatically when you create a block:

● Blocks created on CPUs of the S7-1200/1500 product range provide optimized access by 
means of a default setting.

● New blocks created on CPUs of the S7-300/S7-400 product range provide standard access 
by means of a default setting.

Access to a block that you copy or migrate to a CPU of a different product range is not converted 
automatically. However, in certain situations it may be useful to change block access in manual 
mode, e.g., in order to utilize the full functional scope of the CPU. 

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1029



In most cases, you will have to recompile and load the program after block access has been 
converted.

 

 NOTICE

Optimized block access for GRAPH blocks

The "Optimized block access" attribute is always enabled for GRAPH blocks in S7-1500 and 
cannot be deselected.

 

Procedure
To set the block access, proceed as follows:

1. Open the "Program blocks" folder in the project tree.

2. Right-click on the block whose block access you want to change.

3. Select the "Properties" command in the shortcut menu.
The properties dialog box of the block opens.

4. Click "Attributes" in the area navigation.

5. Enable or disable the "Optimized block access" option.

6. Confirm your entries with "OK".

Restrictions and special features
As a matter of principle, you can only convert block access on CPUs of the S7-1200/1500 
product range, as only these support the "optimized" access mode.

The following restrictions or special features apply in this context:

● Instance data blocks
The block access of instance data blocks is always determined by the assigned function 
block and cannot be changed in manual mode. If you change the access mode on a function 
block, you also need to update the assigned instance data blocks. This update procedure 
adapts the access mode of the instance data block.

● System blocks and know-how protected blocks
You cannot manually edit the block access for system blocks and know-how protected 
blocks. 

● Organization blocks
The start information of an OB with standard access is always stored in the first 20 bytes 
of the "Temp" section in the block interface. By contrast, the start information of an OB with 
optimized access is always written to the "Input" section. For this reason, the block interface 
of OBs will also change whenever you convert block access. Additional information is 
provided in the following sections.

Converting block access from "standard" to "optimized".
A block copied from the CPU of the S7-300/400 product range to a CPU of the S7-1200/1500 
product range will initially retain the "standard" access mode. However, you can significantly 
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increase the performance of program execution by using blocks with optimized access, which 
is why it may be useful to modify the access mode manually.

The blocks are adapted as follows in the course of conversion:

● Function blocks
All interface parameters are assigned the "Non-retain" retentivity setting. 

● Global data blocks
The retentivity setting that was assigned centrally to the entire data block is transferred to 
the individual interface parameters. It is now possible to manipulate the retentivity setting 
of the various parameters. 
However, the following rule will still apply: For structured data type tags, the retentivity 
setting always applies to the entire structure. You cannot assign separate retentivity settings 
to the various elements within a structured data type. It therefore follows that you cannot 
assign individual retentivity settings to the tags of data blocks that are based on PLC data 
types.

● Organization blocks
All interface parameters that are stored in the first 20 bytes of the "Temp" section will be 
deleted. New CPU-specific start information is entered in the "Input" section. Naming 
conflicts with user-defined interface parameters occurring in the process are resolved by 
renaming the user-defined interface parameters.

 

 CAUTION

The conversion of the block access has the following consequences:
● Absolute addressing of the interface parameters of the block is no longer possible after 

conversion of block access to the "optimized mode.
Example: #L0.1 is no longer valid. 

● Since conversion to the "optimized" block access mode of organization blocks also 
modifies the OB interface,

you may possibly have to adapt, recompile and load the program again due to these changes.

See also: Auto-Hotspot
 

Converting block access from "optimized" to "standard".
If you want to copy or move a block from the CPU of the S7-300/400 product range to a CPU 
of the S7-1200/1500 product range, you first need to set the "standard" access mode.

The blocks are adapted as follows in the course of conversion:
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● Function blocks and global data blocks.
You can no longer set a retentivity in the function block. The corresponding setting is made 
in the instance data block. 
All interface parameters in the instance DB or global DB are assigned the same retentivity 
setting. The conversion is subject to the following rule:

– If all interface parameters in the original block were retentive, the entire block will be 
retentive after conversion.

– If all interface parameters in the original block were non-retentive, the entire block will 
be non-retentive after conversion.

– If the interface parameters in the original block had different retentivity settings, the entire 
block will be non-retentive after conversion.

● Organization blocks
All interface parameters stored in the "Input" section will be deleted. New CPU-specific start 
information is entered in the "Temp" section. This data is written to the first 20 bytes. Naming 
conflicts with user-defined interface parameters occurring in the process are resolved by 
renaming the user-defined interface parameters.

 

 CAUTION

The conversion of the block access has the following consequences:

Since a conversion to "standard" block access mode might change the retentivity settings of 
the interface parameters, you may possibly have to adapt, recompile and load the program 
again due to these changes.

 See also: Auto-Hotspot
 

See also
Basics of block access (Page 1027)

9.1.1.3 Block calls

Principles of block calls

Function of block calls  
For your blocks to be executed in the user program, they need to be called from another block. 

When one block calls another block, the instructions of the called block are executed. Only 
when execution of the called block has been completed does execution of the calling block 
resume. The execution is continued with the instruction that follows on the block call.

The following figure shows the sequence of a block call within a user program:
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Parameter transfer
When a block is called, you must assign values to the parameters in the block interface. By 
providing input parameters you specify the data with which the block is executed. By providing 
the output parameters you specify where the execution results are saved.

See also
Call hierarchy (Page 1033)

Principles for single instances and multi-instances (Page 1034)

Call hierarchy

Definition    
The order and nesting of block calls is referred to as the call hierarchy. The permissible nesting 
depth depends on the CPU. 

The following figure shows an example of the order and nesting of block calls within an 
execution cycle:
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See also
Principles for single instances and multi-instances (Page 1034)

Principles of block calls (Page 1032)

Call function blocks as single or multi-instances

Principles for single instances and multi-instances

Use of single instances and multiple instances   
Function blocks (FBs) store their data in instance data blocks. Instance data blocks store the 
values of the block parameters and the static local data of the function blocks.

You can assign instance data blocks as follows:

● Single instance:
One instance data block for each instance of a function block 

● Multiple instance:
An instance data block for the instance of a function block and all instances of function 
blocks called in it.

See also
Principles of block calls (Page 1032)

Multi-instances (Page 1035)

Single instances (Page 1035)

Call hierarchy (Page 1033)
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Single instances

Definition   
The call of a function block, which is assigned its own instance data block, is called a single 
instance data block.

By assignment of the instance data block, you specify where the instance data of the FB is to 
be stored. By assigning a different instance data block to each call, you can use the same FBs 
several times with different instance data in each case.

Example of a single instance  
You can control several motors using one function block. For this purpose, you assign a 
different instance data block for each function block call for motor control.

The different data for the various motors, such as speed, ramp-up time, total operating time, 
are saved in the different instance data blocks. A different motor will be controlled, depending 
on the instance data block assigned. 

The following figure shows the control of three motors using one function block and three 
different data blocks:

 

See also
Principles for single instances and multi-instances (Page 1034)

Multi-instances (Page 1035)

Multi-instances

Definition   
Multi-instances enable a called function block to store its data in the instance data block of the 
calling function block.
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This allows you to concentrate the instance data in one instance data block and thus make 
better use of the number of instance data blocks available.

One instance data block for the instances of different function blocks
The following figure shows how multiple different function blocks store their data in a calling 
block. The FB_Workpiece calls the following on after the other: FB_Grid, FB_Punch and 
FB_Conveyor. The called blocks store their data in the DB_Workpiece, the instance data block 
of the calling block.
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One instance data block for multi-instances of a function block
The following figure shows how a function block that is called in multi-instances stores the data 
for all the instances in one instance data block.

The function block FB_Motors calls three instances of the FB_Motor. The instances are 
"Motor_1", "Motor_2" and "Motor_3". Each call uses different instance data. However, all 
instance data are located in a single instance data block, DB_MotorData. 

See also
Principles for single instances and multi-instances (Page 1034)

Single instances (Page 1035)

Parameter transfer at block call

Basics of block parameters

Introduction     
The calling block gives the called block the values with which it is to work. These values are 
referred to as block parameters. The input parameters provide the called block with the values 
that it has to process. The block returns the results via the output parameters.

Block parameters are therefore the interface between the calling and the call block. 

You use input parameters when you want to only query or read values, and output parameters 
when you want to set or write these values. If block parameters are read and written you have 
to create these as in-out parameters.
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Formal and actual parameters
The block parameters are defined in the interface of the called block. These parameters are 
referred to as formal parameters. They are placeholders for the parameters that are transferred 
to the block when it is called. The parameters transferred to the block when it is called are 
referred to as actual parameters. 

Rules for using the block parameters
The following rules apply to the use of block parameters within the block:

● Input parameters may only be read.

● Output parameters may only be written.

● In/out parameters may be read and written.

See also
Parameter assignment to function blocks (Page 1041)

Parameter assignment to functions (Page 1039)

General rules for assigning parameters (Page 1038)

Using tags within the program (Page 1049)

Keywords (Page 1051)

Supplying block parameters during call

General rules for assigning parameters

Introduction
When you call a block with block parameters, assign actual parameters to its formal 
parameters. The rules described below apply here.

Compatible data types
The data types of actual and formal parameters must be identical or convertible according to 
the rules of data type conversion.

Transferring ARRAYs
You can transfer ARRAYs as parameters. If a block has an input parameter of ARRAY type, 
you must transfer as actual parameter an ARRAY with identical structure. You can also transfer 
individual elements of an ARRAY as actual parameter if the element corresponds to the data 
type of the formal parameter.
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Transferring PLC data types
You can also transfer tags that are declared as PLC data type as actual parameters. If the 
formal parameter is declared as PLC data type in the tag declaration, you must transfer a tag 
that has the same PLC data type as actual parameter.

An element of a tag declared by means of PLC data type can also be transferred as actual 
parameter at block call, provided that the data type of the element of the tag matches the data 
type of the formal parameter.

Transferring structures (STRUCT)
You can transfer structures as parameters. If a block has an input parameter of the STRUCT 
type, you must transfer as actual parameter a STRUCT with identical structure. This means 
that the names and data types of all structure components have to be identical. 

You can also transfer individual elements of an STRUCT as actual parameter if the element 
corresponds to the data type of the formal parameter.

 

 Note

We recommend programming structures as PLC data types. PLC data types make 
programming easier, since they can be used multiple times and modified centrally.

 

See also
Parameter assignment to function blocks (Page 1041)

Parameter assignment to functions (Page 1039)

Basics of block parameters (Page 1037)

Parameter assignment to functions

Parameters of functions (FC)     
Functions have no data memory in which values of block parameters can be stored. Therefore, 
when a function is called, all formal parameters must be assigned actual parameters. 

Input parameters (Input)
Input parameters are read only once per cycle, namely before the block call. Therefore, the 
rule is that writing an input parameter within the block does not affect the actual parameter. 
Only the formal parameter is written.

Output parameters (Output)
Output parameters are read only once per cycle, namely after the block call. Therefore, the 
rule is that output parameters should not be read within the block. If you nevertheless read an 
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output parameter, please note that only the value of the formal parameter is read. The value 
of the actual parameter cannot be read within the block. 

If an output parameter of a function is not written in this function, the value that is predefined 
for the specified data type is used. For example, the value "false" is predefined for BOOL. 
However, structured output parameters are not pre-assigned with a value.

To prevent unintentional further processing of the predefined value or an undefined value, note 
the following when programming the block:

● Make sure that the output parameters are written with values for all possible program paths 
within the block. In doing so, note that jump commands may skip instruction sequences in 
which outputs are set, for example. 

● Note that the set and reset commands are dependent on the result of the logic operation. 
If the value of an output parameter is determined with these commands and RLO = 0, a 
value will not be generated. 

● If possible, assign a default value for the output parameters of functions.

In/out parameters (InOut)
In/out parameters are read before the block call and written after the block call. If you read or 
write the parameter within the block, you only access its formal parameter. 

An exception is in/out parameters with a structured data type. Structured data types consist 
of several data elements, for example ARRAY or STRUCT. These are passed to the called 
block through a POINTER. You therefore always access the actual parameter when you read 
or write a structured in/out parameter within a block.

When an in/out parameter of a function is not written to this function, the old output value or 
the input value is used as a value. Nevertheless, you should observe the information provided 
above for output parameters so that old values are not inadvertently processed further.

Temporary local data (Temp)
Temporary local data is only available within a cycle. It is treated differently depending on the 
block type:

● Standard access
The following rule applies to code blocks with standard access as well as to all tags with 
retentivity setting "Set in IDB": 
If you use temporary local data, you have to make sure that the values are written within 
the cycle in which you want to read them. Otherwise, the values will be random. Temporary 
data of the STRING data type is an exception: It is automatically pre-assigned the correct 
length information.

● Optimized access
The following rule applies to code blocks with optimized access:
If a temporary tag is not written within a function, the value that is predefined for the specified 
data type is used. For example, the value "false" is predefined for BOOL. Elements of the 
PLC data types are pre-assigned with the default value that is specified in the declaration 
of the PLC data type (UDT). ARRAY elements are pre-assigned with the value "0", even if 
they are used within a PLC data type. Strings are pre-assigned the correct length 
information.
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Function value (Return)
Functions normally calculate a function value. This function value can be returned to the calling 
block via the RET_VAL output parameter. For this, the RET_VAL  output parameter must be 
declared in the interface of the function. RET_VAL is always the first output parameter of a 
function. All data types are permitted for the RET_VAL parameter except ARRAY and 
STRUCT, as well as parameter types TIMER and COUNTER.

In the SCL programming language functions can be call directly in an expression. The result 
of the expression is then formed with the calculated function value. Therefore, the data type 
ANY is not permitted in SCL for the function value.

See also
Parameter assignment to function blocks (Page 1041)

Basics of block parameters (Page 1037)

General rules for assigning parameters (Page 1038)

Calling functions (Page 1365)

Examples for calling functions in SCL (Page 1368)

Parameter assignment to function blocks

Supplying parameters of function blocks (FB)     
In the case of function blocks the parameter values will be stored in the instance data. 

If the input, output, or in-out parameters of a function block were not assigned with values, the 
stored values are used. 

In some cases, it is mandatory to specify an actual parameter.

The following table shows which parameters of a function block must be assigned actual 
parameters: 

Parameter Elementary data type Structured data type Parameter type
Input (Input) optional optional required
Output (Output) optional optional required
In-out (InOut) optional required Permitted with S7-1200 only, 

parameter assignment 
required

Temporary (Temp) required
S7-1500: Optional with 
optimized block access

required
S7-1500: Optional with 
optimized block access

required
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See also
Basics of block parameters (Page 1037)

General rules for assigning parameters (Page 1038)

Parameter assignment to functions (Page 1039)

Access to block parameters during program execution

Introduction
Block parameters of functions and function blocks are processed differently during program 
execution. The type of access varies depending on the CPU family, block type and data type 
of the block parameter. 

We generally distinguish between the two following types of access:

● Parameters are transferred as parameter pointers
A parameter pointer is transferred to the called block. 
This means that the called block can directly access the operand that is specified as actual 
parameter. Writing a parameter in the called block results in a change of the actual 
parameter in the calling block. Read access to a block parameter reads the actual 
parameter directly.

● Parameters are transferred as copy 
The value of the actual parameter is copied to the temporary data of the called blocks during 
a block call. 
This means that the called block always works with the value that the actual parameter had 
at the block call. It cannot directly access the operand that is specified as actual parameter.  
Writing a parameter in the called block does not result in a change of the actual parameter 
in the calling block. During read access, the formal parameter and not the actual parameter 
is accessed. 
The procedure for copying is as follows:

– Input parameter: 
The value of the actual parameter is copied to the formal parameter of the called blocks 
during a block call.

– Output parameter: 
The value of the formal parameter is copied to the actual parameter after leaving the 
block.

– In/out parameter: 
The value of the actual parameter is copied to the formal parameter of the called block 
prior to the block call and copied back to the actual parameter after exiting the function. 

Parameter transfer for elementary data types
The following table shows how the different CPU families transfer block parameters with 
elementary data type. Elementary data types are, for example, Bool, Int, Byte.

 

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1042 System Manual, 07/2013,  



Called block Actual parameter in the area S7-300/400 S7-1500
FC I, Q, M, P, L Pointer Pointer

Partially qualified DB address (e.g. 
DBW 2)

Pointer Partially qualified DB 
addresses are not supported 
in S7-1500.

Fully qualified DB address (e.g. 
"MyDB".value), 
forwarded parameters of the caller, 
static parameters of the caller  

Copy Copy

FB All actual parameters Copy Copy

Parameter transfer for structured data types
The following table shows how the different CPU families transfer block parameters with 
structured data type. Structured data types are data types that consist of several data elements, 
e.g. ARRAY or STRUCT.

 

Called block Actual parameter in the area S7-300/400 S7-1500
FC IN, OUT, InOut Pointer Pointer
FB IN, OUT  Copy Copy

 InOut Pointer Pointer

Forwarding of block parameters

Basic information on forwarding block parameters

Introduction     

Definition
The "Forwarding" of block parameters is a special type of parameter use. In this case the block 
parameters of the calling block are forwarded to the parameters of the called block. The called 
block uses the values that are currently present at the block parameters of the calling block 
as the actual parameters.

The following figure shows how the parameters of the function FC_10 are forwarded to the 
function FC_12:
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Rules for LAD/FBD
The following general rules apply in LAD and FBD:

● Input parameters can only be forwarded to input parameters.

● Output parameters can only be forwarded to output parameters.

● In/out parameters can be forwarded to all parameter types.

● In S7-300/400, the two block parameters must have the same data type.

● In S7-1200/1500, the parameters can also be converted according to the rules of implicit 
conversion.

Rules for STL
The following general rules apply in STL:

● Input parameters can only be forwarded to input parameters.

● Output parameters can only be forwarded to output parameters.

● In/out parameters can be forwarded to all parameter types.

● Both block parameters must have the same data type. In STL, this rule applies to all CPU 
families.

Rules for SCL
The rules for SCL are less stringent. So that programs from previous SCL versions can be 
taken over more easily, additional parameter transfer options are permissible, but subject to 
warning. You can, for example, forward an in/out parameter to an input parameter, but a 
warning is output as the transferred in/out parameter cannot be written by the program.

Additional rules are described in detail in the following chapters.
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See also
Calling a function by another function (Page 1045)

Call of a function by a function block (Page 1046)

Call of a function block by a function (Page 1047)

Call of a function block by another function block (Page 1048)

Calling a function by another function

Permissible data types for the call of a function by another function     
Specific rules apply to the forwarding of formal parameters. The following table shows the rules 
according to which parameters can be forwarded in the various CPU families:

FC calls FC Data types
Actual 

parameter 
(calling 
block)

Formal 
parameter

s
(called 
block)

Standard data 
types

ARRAY, 
STRUCT, 

STRING, DT

ANY, 
POINTER

VARIANT Parameter types 
(TIMER, 

COUNTER, 
BLOCK_XX)

DB_Any

Input Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

S7-1500 S7-1200 as 
of V2
S7-1500

Output Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

InOut Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut InOut S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

 

See also
Basic information on forwarding block parameters (Page 1043)
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Call of a function by a function block

Permissible data types for the call of a function by a function block     
Specific rules apply to the forwarding of formal parameters. The following table shows the rules 
according to which parameters can be forwarded in the various CPU families:

FB calls FC Data types
Actual 

parameter 
(calling 
block)

Formal 
parameter

s
(called 
block)

Standard data 
types

ARRAY, 
STRUCT, 

STRING, DT

ANY, 
POINTER

VARIANT Parameter types 
(TIMER, 

COUNTER, 
BLOCK_XX)

DB_Any

Input Input S7-300/400
S7-1200
S7-1500

S7-300/400
S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

S7-1500 S7-1200 as 
of V2
S7-1500

Output Output S7-300/400
S7-1200
S7-1500

S7-300/400
S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

InOut Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut InOut S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

 

See also
Basic information on forwarding block parameters (Page 1043)
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Call of a function block by a function

Permissible data types for the call of a function block by a function     
Specific rules apply to the forwarding of formal parameters. The following table shows the rules 
according to which parameters can be forwarded in the various CPU families:

FC calls FB Data types
Actual 

parameter 
(calling 
block)

Formal 
parameter

s
(called 
block)

Standard data 
types

ARRAY, 
STRUCT, 

STRING, DT

ANY, 
POINTER

VARIANT Parameter types 
(TIMER, 

COUNTER, 
BLOCK_XX)

DB_Any

Input Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

S7-300/400
S7-1500

S7-1200 as 
of V2
S7-1500

Output Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

InOut Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut InOut S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

 

See also
Basic information on forwarding block parameters (Page 1043)
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Call of a function block by another function block

Permissible data types for the call of a function block by another function block     
Specific rules apply to the forwarding of formal parameters. The following table shows the rules 
according to which parameters can be forwarded in the various CPU families:

FB calls FB Data types
Actual 

parameter 
(calling 
block)

Formal 
parameter

s
(called 
block)

Standard data 
types

ARRAY, 
STRUCT, 

STRING, DT

ANY, 
POINTER

VARIANT Parameter types 
(TIMER, 

COUNTER, 
BLOCK_XX)

DB_Any

Input Input S7-300/400
S7-1200
S7-1500

S7-300/400
S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

S7-300/400
S7-1500

S7-1200 as 
of V2
S7-1500

Output Output S7-300/400
S7-1200
S7-1500

S7-300/400
S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

InOut Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut InOut S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

 

See also
Basic information on forwarding block parameters (Page 1043)
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9.1.1.4 Using and addressing operands

Basic information about operands

Introduction   
When you program instructions you must specify which data values the instruction should 
process. These values are referred to as operands. You can, for example, use the following 
elements as operands:

● PLC tags

● Constants

● Tags in instance data blocks

● Tags in global data blocks

Absolute address and symbolic name
Operands are identified by means of an absolute address and a symbolic name. You define 
the names and addresses in the PLC tag table or in the tag declaration of the blocks.

Data blocks with optimized access (S7-1200, S7-1500)
Data elements in data blocks with optimized access only receive a symbolic name and no 
absolute address in the declaration. For more information on this, refer to "See also". 

See also
Displaying symbolic and absolute addresses (Page 1229)

Basics of block access (Page 1027)

Using tags within the program

Definition     
A variable is a placeholder for a data value that can be changed in the program. The format 
of the data value is defined. The use of variables makes your program more flexible. For 
example, you can assign different values to variables that you have declared in the block 
interface for each block call. As a result, you can reuse a block you have already programmed 
for various purposes.

A variable consists of the following elements:

● Name

● Data type
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● Absolute address

– PLC tags and DB tags in blocks with standard access have an absolute address.

– DB variables in blocks with optimized access have no absolute address.

● Value (optional)

Declaring Variables       
You can define variables with different scopes for your program:

● PLC tags that apply in all areas of the CPU

● DB variables in global data block that can be used by all blocks throughout the CPU.

● DB tags in instance data blocks that are predominantly used within the block in which they 
are declared.

The following table shows the difference between the variable types:

 PLC tags Variables in instance DBs Variables in global DBs
Range of 
application

● Are valid throughout the entire CPU.
● Can be used by all blocks on the CPU.
● The name is unique within the CPU.

● Are predominantly used 
in the block in which they 
are defined.

● The name is unique 
within the instance DB.

● Can be used by all blocks 
on the CPU.

● The name is unique 
within the global DB.

Permissible 
characters

● Letters, numbers, special characters
● Quotation marks are not permitted.
● Reserved keywords are not permitted.

● Letters, numbers, special 
characters

● Reserved keywords are 
not permitted.

● Letters, numbers, special 
characters

● Reserved keywords are 
not permitted.

Use ● I/O signals (I, IB, IW, ID, Q, QB, QW, 
QD)

● Bit memory (M, MB, MW, MD)

● Block parameters   (input, 
output and in-out 
parameters),

● Static data of a block

● Static data

Location of 
definition

PLC tag table Block interface Declaration table of the 
global DB

 

 

See also
Keywords (Page 1051)

Basic information about operands (Page 1049)

Displaying symbolic and absolute addresses (Page 1229)

Valid names of PLC tags (Page 1175)

Permissible addresses and data types of PLC tags (Page 1176)
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Constants

Definition     
A constant defines an unchangeable data value. Constants can be read by various program 
elements during the execution of the program but cannot be overwritten. A change of the 
constant value during the program's execution can lead to syntax or runtime errors. 

Symbolic constants (S7-1200, S7-1500)   
In S7-1200 and S7-1500, you have the option of declaring symbolic names for constants and 
thus making static values available under a name in the program. The symbolic constants are 
valid throughout the CPU. Constants are declared in the "Constants" tab of the PLC tag table. 

Elements of Constants
A constant consists of the following elements:

● Name (in the case of symbolic constants)
Valid characters in the constant name are letters, number and special characters; invalid 
characters are quotation marks and reserved keywords.

● Data type

● Constant value
The input format and the value range of the constant depend on the data type of the 
constant.

 

 Note
Constants of the BOOL type

Constants of the BOOL type may not be used as inputs in LAD or FBD in S7-300/400.
 

Additional information
For more information on data types of constants and their input formats and value ranges, 
refer to the "Data types" section under "See also".

See also
Rules for symbolic constants (Page 1187)

Enter constants (Page 1076)

Declaring constants (Page 1188)

Keywords
SIMATIC recognizes a range of key words whose definitions are fixed and which have a certain 
meaning in the program. You should not use these keywords as names for tags or constants. 
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Table of keywords       
The following table shows all keywords.

Keywords 
German mnemonics

Keywords 
English mnemonics

Description

& & And logical operation of logical 
expressions

A Q Output, bit
A1 CC1 Condition code bit
A0 CC0 Condition code bit
AB QB Output, byte
AD QD Output, double word
AND AND And logical operation of logical 

expressions
ANY ANY Data type, pointer
AR1 AR1 Address Register 1
AR2 AR2 Address Register 2
ARRAY ARRAY Introduces the specification of 

an array and is followed by the 
index list between "[" and "]"

AT AT Overlaying tag declaration
AUTHOR AUTHOR Name of the author, company 

name, department name, or 
other name (max. 8 characters, 
no spaces) 

AW QW Output, word
B B Byte
BEGIN BEGIN Introduces the instruction part for 

code blocks or initialization part 
for a data block

BIE BR Binary result
BLOCK_FB BLOCK_FB Parameter type for specification 

of an FB
BLOCK_FC BLOCK_FC Parameter type for specification 

of an FC
BLOCK_SDB BLOCK_SDB Parameter type for specification 

of an SDB
BOOL BOOL Data type
BY BY Increment of the FOR loop
BYTE BYTE Data type
CALL CALL Call
CASE CASE Introduction to the CASE 

statement
CHAR CHAR Elementary data type
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

CODE_VERSION1 CODE_VERSION1 Label, whether an FB is multiple 
instance capable or not. If you 
want to declare multiple 
instances, the FB must not have 
this characteristic.

CONST CONST Start of the constant declaration
CONTINUE CONTINUE Instruction to exit a loop in SCL
COUNTER COUNTER Parameter type for specification 

of a counter
DATA_BLOCK DATA_BLOCK Introduces the data block
DATE DATE Data type
DATE_AND_TIME DATE_AND_TIME Data type
DB DB Data block
DB_ANY DB_ANY Data type
DBB DBB Data block, data byte
DBD DBD Data block, data double word
DBLG DBLG Data block length
DBNO DBNO Data block number
DBW DBW Data block, data word
DBX DBX Data block, data bit
DI DI Instance data block
DIB DIB Instance data block, data byte
DID DID Instance data block, data double 

word
DILG DILG Instance data block length
DINO DINO Instance data block number
DINT DINT Data type
DIW DIW Instance data block, data word
DIX DIX Instance data block, data bit
DO DO Introduction of the instruction 

part in FOR and WHILE 
instruction

DT DT Data type
DTL DTL Data type
DWORD DWORD Data type 
E I Input (via process image), bit
EB IB Input (via process image), byte
ED ID Input (via process image), 

double word
ELSE ELSE Alternative branch in IF and 

CASE statement
ELSIF ELSIF Alternative condition of the IF 

instruction
EN EN System operand of the EN/ENO 

mechanism
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

ENO ENO System operand of the EN/ENO 
mechanism

END_CASE END_CASE End of the CASE statement
END_DATA_BLOCK END_DATA_BLOCK Ends the data block
END_FOR END_FOR End of the FOR statement
END_FUNCTION END_FUNCTION Ends the function
END_FUNCTION_BLOCK END_FUNCTION_BLOCK Ends the function block
END_IF END_IF End of the IF instruction
END_ORGANIZATION_BLOCK END_ORGANIZATION_BLOCK Ends the organization block
END_REPEAT END_REPEAT End of the REPEAT statement
END_STRUCT END_STRUCT Ends the specification of a 

structure
END_SYSTEM_FUNCTION END_SYSTEM_FUNCTION Ends the system function 
END_SYSTEM_FUNCTION_BL
OCK

END_SYSTEM_FUNCTION_BL
OCK

Ends the system function block

END_TYPE END_TYPE Ends the PLC data type
END_VAR END_VAR Ends a declaration block
END_WHILE END_WHILE End of the WHILE instruction
EW IW Input (via process image), word
EXIT EXIT Instruction to exit a loop in SCL
FALSE FALSE Predefined Boolean constant: 

Logical condition false, value 
equal to 0

FAMILY FAMILY Block family name: e.g. controller
FB FB Function block
FC FC Function
FOR FOR Introduction of the FOR 

statement
FUNCTION FUNCTION Introduces the function
FUNCTION_BLOCK FUNCTION_BLOCK Introduces the function block
GOTO GOTO Introduction of the GOTO 

statement
IF IF Introduction of the IF instruction
INSTANCE INSTANCE Data type
INT INT Data type
KNOW_HOW_PROTECT KNOW_HOW_PROTECT Block protection 
L L Local data bit
LB LB Local data byte
LD LD Local data double word
LDT LDT Data type
LINT LINT Data type
LTIME LTIME Data type
LTOD LTOD Data type
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

LW LW Local data word
LWORD LWORD Data type
M M Memory bit
MB MB Memory byte
MD MD Memory double word
MOD MOD Modulo operator
MW MW Memory word
NAME NAME Block name 
NETWORK NETWORK Network
NOT NOT Logic inversion
NULL NULL Zero pointer
OB OB Organization block
OF OF Introduction of the data type 

specification / Introduction of the 
instruction part of the CASE 
statement

OR OR Or logical operation of logical 
expressions

ORGANIZATION_BLOCK ORGANIZATION_BLOCK Introduces the organization block
OS OS Save overflow
OV OV Overflow
PA PQ Output (direct peripherals), bit
PAB PQB Output (direct peripherals), byte
PAD PQD Output (direct peripherals), 

double word
PAW PQW Output (direct peripherals), word
PE PI Input (direct peripherals), bit
PEB PIB Input (direct peripherals), byte
PED PID Input (direct peripherals), double 

word
PEW PIW Input (direct peripherals), word
POINTER POINTER Data type
READ_ONLY READ_ONLY Write protection for data blocks
REAL REAL Data type
REPEAT REPEAT Introduction of the REPEAT 

statement
RET_VAL RET_VAL Return value
RETURN RETURN RETURN statement in SCL
S5T S5T Syntax for data type S5TIME
S5TIME S5TIME Data type
S7_ S7_ Keywords for system attributes
SDB SDB System data block
SFB SFB System function block
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

SFC SFC System function
SINT SINT Data type
STRING STRING Data type
STRUCT STRUCT Introduces the specification of a 

structure and is followed by a list 
of components

STW STW Status word
SYSTEM_FUNCTION SYSTEM_FUNCTION System function
SYSTEM_FUNCTION_BLOCK SYSTEM_FUNCTION_BLOCK System function block
T T Time element (timer)
THEN THEN Introduction of the instruction 

part of an IF instruction
THIS THIS Syntax for access to an ARRAY 

data block
TIME TIME Elementary data type for time 

information
TIME_OF_DAY TIME_OF_DAY Data type
TIMER TIMER Parameter type for specification 

of a timer
TITLE TITLE Optional block title or network 

title
TO TO Definition of the full-scale value 

of a FOR statement
TOD TOD Data type
TRUE TRUE Predefined Boolean constant: 

Logical condition true, value not 
equal to 0

TYPE TYPE Introduction of the PLC data type
UDT UDT Global or PLC data type
UDINT UDINT Data type
UINT UINT Data type
ULINT ULINT Data type
UNLINKED UNLINKED Marking 'non runtime-related'
UNTIL UNTIL End of the instruction part of a 

REPEAT statement
USINT USINT Data type
UO UO Query after (Q1=1) AND (Q0=1)
VAR VAR Introduces a declaration block
VAR_IN_OUT VAR_IN_OUT Introduces a declaration block
VAR_INPUT VAR_INPUT Introduces a declaration block
VAR_OUTPUT VAR_OUTPUT Introduces a declaration block
VAR_TEMP VAR_TEMP Introduces a declaration block
VARIANT VARIANT Data type
VERSION VERSION Version number of the block
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

VOID VOID Function has no return value
WCHAR WCHAR Data type
WSTRING WSTRING Data type
WHILE WHILE Introduction of a WHILE 

instruction
WORD WORD Data type
XOR XOR Logic operation
Z C Counter

Addressing operands

Addressing global variables

Addressing global variables
To address a global PLC variable, you can use the absolute address or the symbolic name. 

 

 Note

The LWORD, LINT, ULINT, LREAL, LTIME, LTOD and LDT data types can only be addressed 
by means of their symbolic name.

 

Addressing global variables in symbolic form       
When you use addressing in symbolic form, you enter the variable name from the PLC tag 
table. The symbolic name of global variables are automatically enclosed in quotation marks. 

You address structured tags that are based on a PLC data type with the symbolic name of the 
PLC tag. You can also indicate the names of the individual components separated by a dot. 

Addressing global variables in absolute form
When you use addressing in absolute form, you enter the address of the variables from the 
PLC tag table. The absolute address uses numerical addresses starting with zero for each 
operand range. The address identifier % is set automatically as prefix for the absolute address 
of global tags.

Examples
The following examples show applications of symbolic and absolute addressing:

Addressing Description
%Q1.0 Absolute address: Output 1.0
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Addressing Description
%I16.4 Absolute address: Input 16.4
%IW4 Absolute address: Input word 4
"Motor" Symbolic address "Motor"
"Value" Symbolic address "Value"
"Structured_Tag" Symbolic address of a tag that is based on a PLC 

data type
"Structured_Tag".Component Symbolic address of the component of a structured 

tag.

See also: Permissible addresses and data types of PLC tags (Page 1176) 

See also
Displaying symbolic and absolute addresses (Page 1229)

Accessing I/O devices (Page 1058)

Accessing I/O devices

Description         
The process image of the CPU is updated once in a cycle. In time-critical applications, however, 
it can be that the current state of a digital input or output has to be read or transferred more 
often than once per cycle. For this purpose you can use a suffix for I/O access identifiers on 
the operand to directly access the I/O.

If you want to read the input directly from the peripherals, use the peripheral inputs memory 
area (PI) instead of the process input image (I). The peripherals memory area can be read as 
a bit, byte, word, or double word. 

If you want to write directly to the output, use the peripheral output (PQ) memory area instead 
of the process output image (Q). The peripheral output memory area can be written as a bit, 
byte, word, or double word. 

To read or write a signal directly from a peripheral input, you can add the suffix for I/O access 
":P", to the operand.

Components of structured PLC tags can also be addressed with ":P". However, access to the 
higher-level tag with ":P" is not possible.

 

 WARNING

Direct writing of the I/O

Immediate writing to the I/O can lead to hazardous states, for example when writing multiple 
times to an output in one program cycle. 

 

Syntax
<Operand>:P
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Example
The following example shows applications of I/O access identifiers:

Addressing Description
"Motor" Addresses the "Motor" tag in the process image.
"Motor":P Addresses the "Motor" tag in the I/O memory area (PI 

or PQ).
"Structured_Tag".Component Addresses the component of a structured PLC tag in the 

process image.
"Structured_Tag".Component:P Addresses the component of a structured PLC tag in the 

I/O memory area (PI or PQ).

 

See also
Addressing global variables (Page 1057)

Addressing variables in data blocks

Addressing variables in global data blocks

Description       
Tags in global data blocks can be addressed in symbolic or absolute form. For symbolic 
addressing, you use the name of the data block and the name of the tag, separated by a dot. 
The name of the data block is enclosed in quotation marks.

For absolute addressing, you use the number of the data block and the absolute address of 
the tags in the data block, separated by a dot. The address identifier % is set automatically as 
prefix for the absolute address.

The S7-1200/1500 provides you with an option of accessing a data block that is not yet known 
during programming. For this purpose, create a block parameter of data type DB_Any in the 
block interface of the accessing block. The data block name or data block number is transferred 
to this parameter during runtime. In order to access the internal tags of the data block, use the 
name of the block parameter of data type DB_Any and the absolute address of the tag, 
separated by a dot.

 

 Note

Absolute addressing is not possible for the following tags:
● Tags in blocks with optimized access.
● Tags of data type LWORD, LINT, ULINT, LREAL, LTIME, LTOD and LDT.

Best practice is to use the more convenient symbolic addressing for these tags.
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ARRAY data blocks
ARRAY data blocks are a particular type of global data block. These consist of an ARRAY of 
any data type. For example, an ARRAY of a PLC data type (UDT) is possible. 

You address elements in ARRAY data blocks with the help of the keyword "THIS". The index 
is then specified in square brackets. The index can be a constant as well as a tag. Integers 
with a width of up to 32 bits are permitted as tags for the index.
Extended options for addressing ARRAY DBs are available in the "Move" section of the 
"Instructions" task card. These instructions give you the option, for example, to also address 
the DB name indirectly.

Syntax
"<DBname>".TagName
%<DBnumber>.absoluteAddress
#<DBAny_name>.%absoluteAddress
"<ArrayDBname".THIS[#i].<Component>.<ComponentElement>
SCL:
"<ArrayDBname"."THIS"[#i].<Component>.<ComponentElement>
The following table show the possible absolute addresses of tags in data blocks:

Data type Absolute address Example Description
BOOL %DBn.DBXx.y %DB1.DBX1.0 Data bit 1.0 in DB1
BYTE, CHAR, SINT, 
USINT

%DBn.DBBy %DB1.DBB1 Data bit 1 in DB1

WORD, INT, UINT %DBn. DBWy %DB1.DBW1 Data word 1 in DB1
DWORD, DINT, 
UDINT, REAL, TIME

%DBn.DBDy %DB1.DBD1 Data double word 1 in 
DB1

Example
The following examples show the addressing of tags in global data blocks:
 

Addressing Description
"Motor".Value Symbolic addressing of the "Value" tag in the 

"Motor" global data block.
%DB1.DBX1.0 Absolute addressing of the "DBX1.0" tags in the 

"DB1" global data block.
#MyDBAny.%DBX30.0 Absolute addressing of the "DBX30.0" tag in the 

global DB that is transferred at runtime at the 
"MyDBany" parameter.

"MyARRAY_DB".THIS[#MyIndex].MyCom
ponent.MyComponentElement

Addressing an ARRAY data block. The ARRAY index 
is specified with the "MyIndex" tag. The ARRAY 
element has two additional substructures: 
"MyComponent" and "MyComponentElement".
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See also
Addressing structured variables (Page 1062)

Addressing areas of a tag with slice access (Page 1064)

Basics of indirect addressing (Page 1068)

Addressing instance data (Page 1061)

Addressing instance data

Description         
You can address data elements from the interface of the current block. These tags are stored 
in the instance data block. 

 

 Note

Tags in blocks with optimized access can only be addressed in symbolic form. 
 

To address a tag from the interface of the current block, enter the character # followed by the 
symbolic tag name.

You can also access the tags of a multiple instance block. Within the multiple instance block, 
also use the character # followed by the tag name to address the data. You access the data 
of the multiple instance block from the calling block using #<Multiple 
instanceName.TagName>.

Syntax
Use the following syntax for addressing tags in instance data blocks:
#<TagName>
#<Multiple instanceName.TagName>

Examples
The following examples show the addressing of tags in instance data blocks:

Addressing Description
#Value Addressing the "Value" tag in the instance data block.
#On Addressing the "On" tag within the multiple instance block
#Multi.On Addressing the "On" tag of the multiple instance block from the 

calling block
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See also
Addressing variables in global data blocks (Page 1059)

Addressing structured variables (Page 1062)

Addressing areas of a tag with slice access (Page 1064)

Basics of indirect addressing (Page 1068)

Addressing structured variables

Addressing data elements of an ARRAY
You access an element in an ARRAY using the syntax ArrayName[i,j,k...]. 

The index of the element is specified in square brackets. The index includes an integer value 
(-2147483648 ... 2147483647) for each ARRAY dimension. 

Access errors result when you access an element during runtime which is located outside the 
declared ARRAY limits. The various CPU families react differently to violations of the ARRAY 
limits:

● S7-300/400

– The CPU changes to "STOP" mode.

– You can program the program execution error OB (OB 85) to prevent this. 

– In SCL, you also have the option of enabling the attribute "Check ARRAY limits" in the 
block properties. This causes the enable output ENO to be set to FALSE in the case of 
ARRAY access errors.

● S7-1200

– The CPU generates a diagnostic buffer entry and remains in "RUN" mode.

● S7-1500

– The CPU changes to "STOP" mode.

– You can program the programming error OB (OB 121) to prevent this. 

– You also have the option of programming the local error handling with the instructions 
"GET_ERROR: Get error locally" or "GET_ERROR_ID: Get error ID locally".

 

 Note
Monitoring ARRAY access errors with ENO

The enable output ENO is not set to the signal state FALSE if the ARRAY limits are violated 
during execution of an instruction. The only exception is SCL blocks on CPUs of the 
S7-300/400 series for which the block property "Check ARRAY limits" is set.

 

See also:

Auto-Hotspot

Indirect indexing of ARRAY components (Page 1070)
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Addressing ARRAY data blocks
ARRAY data blocks are a particular form of the ARRAY. ARRAY data blocks are global data 
blocks that consist of exactly one ARRAY. You address elements in ARRAY data blocks using 
the following syntax:
 "<GlobArrayDBname".THIS[#i].<componentname>."<elementname>"
SCL:
"<GlobArrayDBname"."THIS"[#i].<componentname>."<elementname>". 
The "Move" section of the "Instructions" task card offers extended options for addressing 
ARRAY DBs. These instructions give you the option, for example, to also address the DB name 
indirectly.

Addressing data elements in structures
You access individual elements in a structure using StructureName.ElementName.

See also: 

Auto-Hotspot

Addressing data elements of an PLC data type
The syntax PLCDataTypeName.ElementName is used to access elements of a PLC data 
type.

See also:

Auto-Hotspot

Addressing individual characters of a STRING
Use the syntax StringName[i] to access an individual character of a STRING.

Access errors result when you access a character during runtime which is located outside the 
declared STRING length. The various CPU families react differently to violations of the 
STRING length:

● S7-300/400

– If the instruction has the enable output ENO, ENO is set to the signal state FALSE.

– In all other cases, exceeding the STRING length is not monitored. If access takes place 
outside the STRING, the wrong memory area is accessed. If the access takes place 
outside the data block, the CPU goes to STOP.

– You can program the program execution error OB (OB 85) to prevent this. 

● S7-1200/1500

– If the instruction has the enable output ENO, ENO is set to the signal state FALSE.

– In all other cases, there is no error response. You receive the character '$00' with read 
access; write access is not executed.
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Examples:
The following examples show the addressing of structured data type tags:

Addressing Description
Motor.Value_1x3[2] Addressing of a one-dimensional array
Motor.Value_2x4[2,4] Addressing of a two-dimensional array
Motor.Value_4x7[2,4,1,3] Addressing of a four-dimensional array
Batch_1.Temperature Addressing of the element "Temperature" in the 

structure "Batch_1"
Values.Temperature Addressing of the "Temperature" element in the "Values" 

tag, which is based on a PLC data type.
STRING[3] Addresses the third character of the string.

See also
Basics of indirect addressing (Page 1068)

STRING (Page 1103)

Addressing areas of a tag with slice access

Description       
You have the option to specifically address areas within declared tags. You can access areas 
of the 1-bit, 8-bit, 16-bit, or 32-bit width. The type of access is referred to as "slice access".

Syntax
The following syntax is used for addressing: 
<Tag>.X<Bit number>
<Tag>.B<BYTE number>
<Tag>.W<WORD number>
<Tag>.D<DWORD number>
 

The syntax has the following components:

Part Description
<Tag> Tag that you access. The tag must be of the "Bit string" data type. In the 

case of activated IEC check, the access to tags of the "Integer" data type 
is also possible.

X
B
W
D

ID for the access width "Bit (1Bit)"
ID for the access width "Byte (8 Bit)"
ID for the access width "Word (16 Bit)"
ID for access width "DWord (32-bit)"

<BIT number> Bit number within <tag> that is accessed. Number 0 accesses the least 
significant BIT.
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Part Description
<BYTE number> Byte number within <tag> that is accessed.

The number 0 accesses the least significant BYTE.
<WORD number> Word number within <tag> that is accessed.

The number 0 accesses the least significant WORD.
<DWORD number> DWord number within <tag> that is accessed.

The number 0 accesses the least significant DWORD.

Examples
The following examples show the addressing of individual bits:

Addressing Explanation
"Engine".Motor.X0
"Engine".Motor.X7

"Motor" is a tag of the BYTE, WORD, DWORD or LWORD data 
type in the global data block "Engine".
X0 addresses the bit address 0, X7 the bit address 7 
within "Motor". 

"Engine".Speed.B0
"Engine".Speed.B1

"Speed" is a tag of the WORD, DWORD or LWORD data type in 
the global data block "Engine".
B0 addresses the byte address 0, B1 the byte address 1 
within "Speed".

"Engine".Fuel.W0
"Engine".Fuel.W1

"FUEL" is a tag of the DWORD or LWORD data type in the 
global data block "Engine".
W0 addresses the word address 0, W1 the word address 1 
within "Fuel".

"Engine".Data.D0
"Engine".Data.D1

"Data" is a tag of the LWORD data type in the global data 
block "Engine".
D0 addresses the double word address 0, D1 the double word 
address 1 within "Data".

Overlaying tags with AT

Description             
To access data areas within a declared tag, you can overlay the declared tags with an 
additional declaration. This provides you with the option of addressing an already declared tag 
with a different data type. You can, for example, address the individual bits of a tag of WORD 
data type with an ARRAY of BOOL.

Rules
The following general rules are valid for tag overlaying:

● Overlaying is possible in S7-1200 and S7-1500 in STL, LAD, FBD and GRAPH.

● SCL supports overlaying in all CPU families.
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● Overlaying of tags is possible in the following blocks:

– In code blocks with standard access

– In code blocks with optimized access for tags with the retain setting "Set in IDB"

● The data width of the overlaying tag must be equal to or less than that of the overlaid tag.

● It is not possible to overlay tags of the VARIANT and INSTANCE data types.

● Blocks from libraries which are declared as parameters in the interface cannot be overlaid.

● Structured PLC tags that are declared as parameters in the interface cannot be overlaid.

 
 

 Note
S7-1200/1500: Using AT in FCs

The data widths of the overlaying tag and the overlaid tag must be identical for FCs in 
S7-1200/1500. If this is not possible in your program, you can also address areas within 
existing tags with the .X, .B, .W or .D syntax.

See also: Addressing individual areas of a tag (Page 1064)
 

The following combination rules are also valid:

 Overlaying tag Overlaid tag
Elementary Structured * Any/Pointer DB_ANY
FB Input Elementary x x  x

Structured * x x x x
Any/Pointer  x   

Temp Elementary x x   
Structured x x x  
Any/Pointer  x   

Static, Output Elementary x x  x
Structured x x  x
Any/Pointer     

InOut Elementary x   x
Structured  x   
Any/Pointer     

FC Temp Elementary x x   
Structured x x x  
Any/Pointer  x   

Input, Output, 
InOut 

Elementary
(both tags must 
have the same bit 
width)

x   x

Structured  x x  
Any/Pointer     

OB Temp Elementary x x   
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 Overlaying tag Overlaid tag
Structured x x x  
Any/Pointer  x   

* Structured data types consist of several data elements, e.g. ARRAY or STRUCT.

Declaration
To overlay a tag, declare an additional tag directly after the tag that is to be overlaid and identify 
it with the keyword "AT". 

Example
The following figure shows the declaration of an overlaid tag in the interface of a FB:

When a block is called with the shown tag declaration, the "MyByte" tag is assigned. Within 
the block there are now two options for interpreting the data:

● as a byte

● As one-dimensional ARRAY of BOOL

 

Addressing operands indirectly

Basics of indirect addressing

Introduction    
Indirect addressing offers the option of addressing operands whose address is not calculated 
until during runtime. With indirect addressing, program sections can be executed several times 
and a different operand can be used during each run. 
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 WARNING

Risk of access errors

Since operands are only calculated during runtime with indirect addressing, there is a risk 
that access errors may occur and that the program will operate with incorrect values. In 
addition, memory areas may inadvertently be overwritten with incorrect values. The 
automation system can then react in unexpected manner.

Therefore, use indirect addressing only with caution.
 

Indirect addressing

Basics of indirect addressing

General indirect addressing options in S7-1200 and S7-1500     
The following indirect addressing options are available in all programming languages:

● Indirect addressing via pointer

● Indirect indexing of ARRAY components

● Indirect addressing of a data block via DB_ANY data type. 

Language-specific options of indirect addressing
The following specific addressing options are also available in the various programming 
languages:

● In STL, you can address operands indirectly via the address register.

● In SCL, you can read or write a variable memory area with the following instructions:

– POKE - Write memory address

– POKE_BOOL - Write memory bit

– PEEK - Read memory address

– PEEK_BOOL - Read memory bit

– POKE_BLK - Write memory area

For a detailed description of these addressing options, refer to "See also".
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See also
Addressing variables in global data blocks (Page 1059)

POKE: Write memory address (Page 2181)

POKE_BOOL: Write memory bit (Page 2183)

PEEK: Read memory address (Page 2177)

PEEK_BOOL: Read memory bit (Page 2179)

POKE_BLK: Write memory area (Page 2184)

Indirect addressing via pointer (Page 1069)

Indirect indexing of ARRAY components (Page 1070)

Indirect addressing in STL (Page 1074)

Indirect addressing via pointer

Description    
For indirect addressing, a special data format is required that contains the address and possibly 
also the range and the data type of an operand. This data format is referred to as pointer. The 
following types of pointers are available to you: 

● POINTER (S7-1500)

● ANY (S7-1500, only for blocks with standard access)

● VARIANT (S7-1200/1500)

For more information on the pointer data types, refer to "See also".
 

 Note

In SCL the use of the POINTER is restricted. The only option available is to forward it to the 
called block.

 

Example
The following example shows an indirect addressing with an area-internal pointer:

Addressing in STL Explanation
L P#10.0 // Load pointer (P#10.0) in accumulator 1
T MD20 // Transfer pointer to the operand MD20
L MW [MD20] // Load MW10 in accumulator 1  
.... // Any program
L MD [MD20] // Load MD10 in accumulator 1
.... // Any program
= M [MD20] // If RLO=1, set the memory bit M10.0
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The pointer P#10.0 is transferred to the operand MD20. If the operand MD20 in square brackets 
is programmed, this will be replaced in runtime by the address that is contained in the pointer. 

See also
Basics of indirect addressing (Page 1068)

Indirect indexing of ARRAY components

Description
For addressing the components of an ARRAY, you can specify tags of the integer data type 
as well as constants as the index. Integers with a length of up to 32 bits are allowed here. 
When tags are used, the index is calculated during runtime. You can, for example, use a 
different index for each cycle in program loops.

 

 Note

When you call a block and transfer an indirectly indexed ARRAY component ("<Data 
block>".<ARRAY>["i"]) to it as in/out parameter (InOut), you cannot change the value of the 
index tag [i] while the block is being executed. The value is therefore always written back to 
the same ARRAY component from which it was read.

 

Syntax
The following syntax is used for the indirect indexing of a ARRAY:
"<Data block>".<ARRAY>["i"] // one-dimensional ARRAY
"<Data block>".<ARRAY>["i"] // one-dimensional ARRAY of STRUCT
"<Data block>".<ARRAY>["i"] // multidimensional ARRAY
"<Data block>".<ARRAY>["i"] // multidimensional ARRAY of STRUCT
 

The syntax has the following components:

Part Description
Data block Name of the data block in which the ARRAY is located
ARRAY Tag of the ARRAY data type
i, j PLC tags of the integer data type that are used as pointers
a Additional partial tag of the structure

Examples
The following example shows indirect array indexing of an ARRAY component in STL: 

Several axes traverse at different angles. The values for axis number and angle are stored in 
the two-dimensional ARRAY "control_axis".
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You can use the "SEL" instruction to select the components of the "control_axis" ARRAY to 
be written at the "#out" output parameter. 

The axis number is defined by the constants "Constant_Axis_NoX" and "Constant_Axis_NoY"; 
the angle is defined by the "#Angle" tag.

Addressing in STL  
CALL  SEL  
    value_type:=Int  
    G   :="Select"  
    IN0 :=#control_axis["Constant_Axis_NoX", #Angle]  
    IN1 :=#control_axis["Constant_Axis_NoY", #Angle]  
    OUT :=#out  

The following examples are based on SCL and demonstrate indirect indexing of an ARRAY 
component. "MOTOR" is a one-dimensional ARRAY_of_INT with three rows. "VALUES" is a 
PLC tag of data type "Integer".

Addressing in SCL Explanation
MOTOR[2] := VALUES; (*Direct addressing: Assignment of 

VALUES to the second row of the ARRAY 
MOTOR*)

MOTOR["Tag_1"] := VALUES; (*Indirect addressing: Assignment of 
VALUES  to the rows of ARRAY MOTOR*) 
specified by "Tag_1"

#MOTOR["Tag_2"+"Tag_3"] := #Values; (*Indirect addressing: Assignment of 
VALUES to the row of the MOTOR*) ARRAY 
specified by the expression 
"Tag_2"+"Tag_3"

 

The following example shows the indirect indexing of an ARRAY component as an example 
of LAD. "ARRAY" is a three-dimensional ARRAY. "Tag_1", " "Tag_2" and ""Tag_3" are PLC 
tags of the "Integer" data type. Depending on their values, one of the "ARRAY" components 
will be copied to the "MyTarget" tag.
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Indexing ARRAY components using the "FieldRead" and "FieldWrite" instructions
You may also use the following instructions for indirect indexing of ARRAY components in LAD 
and FBD:

● FieldWrite - Write field

● FieldRead - Read field
For more information on these instructions, refer to the "References" chapter.

Additional information
For more information on the ARRAY data type, refer to "See also".

See also
Basics of indirect addressing (Page 1068)

Addressing structured variables (Page 1062)

Indirect addressing of individual characters of a STRING

Description       
For addressing the individual characters of an STRING, you can specify both constants and 
tags of the integer data type as the index. When tags are used, the index is calculated during 
runtime. You can, for example, use a different index for each cycle in program loops.

The index tag [i] is read once at the start of the block call and cannot be changed by the called 
block while it is being executed.

 

 Note
Monitoring STRING access in runtime

When a STRING that exceeds the defined length of the STRING tags is written in runtime, 
unwanted reactions may occur in the program. Violation of the STRING length is monitored 
in S7-1200/1500. You can choose whether you want to respond to violations with the global 
error handing of the CPU or with separate local error handling.

 

Syntax
The following syntax is used for the indirect indexing of a STRING:
"<Data block>".<STRING>["i"] 
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Example
The indirect indexing of a STRING is illustrated below based on the example of SCL. "STRING" 
is a tag of the STRING data type. "Tag_1" is a PLC tag of the "Integer" data type.

Addressing in SCL Explanation
STRING["Tag_1"] := CHARACTER; (*Indirect addressing: Assignment of 

"CHARACTER" to the characters of the *) 
STRING specified by "Tag_1"

Additional information
For additional information on the STRING data type, refer to "See also".

See also
STRING (Page 1103)

Indirect addressing in STL

Basic information about address registers

Introduction       
Two address registers are available for the indirect addressing of operands: address register 
1 (AR1), and address register 2 (AR2). The address registers are equal and are 32 bits in 
length. You can store area-internal and cross-area pointers in the address registers. To define 
the address of an operand, you can call the stored data in the program.

Data is exchanged between the registers and the other available memory areas with the 
assistance of load and transfer instructions. 

 

 Note

In S7-1500, special rules apply to data exchange via address register and data block register: 
● The values in the registers do not remain in existence beyond the block limits.
● The registers are reset when the language is changed within a block.
● You can only reference data in blocks with optimized access if these have the retain setting 

"Set in IDB".
● It is not possible to reference local data in blocks with optimized access with the help of 

the address registers (across areas). 
 

Additional information
For more information on the statements that address registers use and on indirect addressing, 
refer to "See also".
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See also
Indirect addressing in STL (Page 1074)

Addressing areas of a tag with slice access (Page 1064)

Indirect addressing in STL
In STL, the following options are available for indirect addressing:

● Memory-indirect addressing

● Register-indirect area-internal addressing

● Register-indirect cross-area addressing

Memory-indirect addressing
In the case of memory-indirect addressing, you store the address in a tag. The tag can be of 
WORD or DWORD data type. The tag can be located in the memory areas "Data" (DB or DI), 
"Bit memory" (M) or "Temporary local data" (L). In S7-1500, FB parameters can also be used 
to store the address. If the tag is located in a data block, it must be a data black with standard 
access.

The following example shows applications of memory-indirect addressing:

Addressing in STL Explanation
U E [MD 2] // Execute an AND logic operation with a variable input 

bit. The address of the input bit is located in the 
memory double word MD2.

= DIX [DBD 2] // Assign the RLO to a variable data bit. The address of 
the data bit is located in the data double word DBD2.

L EB [DID 4] // Load a variable input byte to ACCU 1. The address of 
the input byte is located in the instance double word 
DID4.

AUF DB [LW 2] // Open a variable data block. The number of the data 
block is located in the local data word LW2.

 

Register-indirect area-internal addressing
Register-indirect addressing uses one of the address registers (AR1 or AR2) to pick up the 
address of the operand. 

In the case of register-indirect, area-internal addressing, you index only the bit address and 
the byte address via the address register (e.g. P#10.0). You do not enter the memory area 
for which the address in the address register is to apply until during programming of the 
instruction. The address in the address register then moves to the memory area specified in 
the instruction. 

Possible memory areas are "Inputs" (I), "Outputs" (Q), "I/O" (PI or PQ), "Bit memory" (M), 
"Temporary local data" (L) and "Data" (DB or DI). If the operand is located in a data block, it 
must be a data black with standard access.
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When you enter register-indirect, area-internal addressing, specify an offset after the 
specification of the address register. This offset is added to the contents of the address register 
without changing the address register. This offset also has the format of a pointer. The 
specification of a pointer is mandatory and must be entered as constant (e.g. P#0.0 or 
P#2.0). 

The following example shows an application of register-indirect area-internal addressing:

STL Explanation
LAR1 P#10.0 // Load pointer (P#10.0) to address register 1
L IW [AR1, P#2.0] // Increase contents of address register 1 (P#10.0) by offset 

P#2.0. 
// Load contents of input word IW12 into accumulator 1

L IW [AR1, P#0.0] // Increase contents of address register 1 (P#10.0) by offset 
P#0.0. 
// Load contents of input word IW10 into accumulator 1

 

Register-indirect cross-area addressing
In the case of register-indirect, cross-area addressing, use the address register to index the 
entire address of the operand, in other words, the bit address and byte address, as well as the 
memory area. Possible memory areas are "Inputs" (I), "Outputs" (Q), "I/O" (P), "Bit memory" 
(M), "Temporary local data" (L) and "Data" (DB or DI). If the operand is located in a data block, 
it must be a data black with standard access or the operand must have the retain setting "Set 
in IDB".

In the instruction, program only the operand width. Possible operand widths are bit, byte, word, 
and double word.

The following example shows an application of register-indirect cross-area addressing:

  
LAR1 P#M10.0 // Load cross-area pointer (P#M10.0) to address register 1
L W [AR1, P#2.0] // Increase contents of address register 1 (P#M10.0) by offset 

P#2.0.
// Load contents of memory word "MW12" into accumulator 1

LAR1 P#A10.0 // Load cross-area pointer (P#A10.0) to address register 1
L W [AR1, P#2.0] // Add contents of address register 1 (P#A10.0) by offset P#2.0

// Load contents of output word QW12.0 into accumulator 1
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 Note
Special features in S7-1500

In S7-1500, special rules apply to data exchange via address register and data block register: 
● The values in the registers do not remain in existence beyond the block limits. The 

registers are also reset when the language is changed within a block. 
● If you access an operand of the BYTE, WORD or DWORD type using register-indirect 

addressing, the address must begin at a byte limit.
Examples: 
LAR1    P#0.0                                                                                           
L MW [AR1, P#0.0]   // P#0.0 + P#0.0 = P#0.0 - The addressing is allowed, because P#0.0 
points to a byte limit. 
L MW [AR1, P#2.1]  //  P#0.0 + P#2.1 = P#2.1 - The addressing is not allowed, because 
P#2.1 does not point to a byte limit.

 

See also
Basics of indirect addressing (Page 1068)

Addressing structured variables (Page 1062)

Basic information about address registers (Page 1073)

Enter constants

Description         
You have the following options for using constants in the program:

● Entering the value. You can enter just a value or, optionally, a value preceded by information 
on the data type. If you only enter a value, the program interprets the constant automatically 
in a suitable data type. If you provide information on the data type, the constant is always 
interpreted in the specified data type.

● Input of a symbolic name defined in the PLC tag table (with S7-1200/S7-1500). The 
symbolic name of a constant will be automatically included in quotation marks.

Both types of constant are displayed in blue in the program.

Syntax
● Enter a value:

<Value>
<DataType>#<Value>

● Input of a symbolic constant name from the PLC tag table:
"<Name>"
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Example
The following examples show the use of constants:

Addressing Explanation
4 Value input for a constant without information on data type. 

The program interprets the value independently in a data type 
that suits the current context.

INT#4 Value entry for a constant of Integer type with specification 
of data type.

FALSE Value entry for a constant of Bool type
"Name" Symbolic constants from the PLC tag table
"Offset" Symbolic constants from the PLC tag table

 
 

 Note
Constants of the BOOL type

Constants of the BOOL type may not be used as inputs in LAD or FBD in S7-300/400.
 

Additional information
For more information on data types of constants and their input formats and value ranges, 
refer to the "Data types" section under "See also".

 

See also
Constants (Page 1051)

Declaring constants (Page 1188)

9.1.1.5 Data types

Overview of the valid data types

Validity of data type groups
The data type groups define the properties of the data, for example, the representation of the 
contents and the valid memory areas. In the user program, you can use predefined data type 
or also data types that you have defined.

The following tables show the availability of predefined data types in the various S7-CPUs:

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1077



Table 9-1 Binary numbers

Binary numbers S7-300/400 S7-1200 S7-1500
BOOL (Page 1081) X X X
Bit strings
BYTE (Page 1082) X X X
WORD (Page 1083) X X X
DWORD (Page 1083) X X X
LWORD (Page 1084) - - X

Table 9-2 Integers

Integers S7-300/400 S7-1200 S7-1500
SINT (Page 1085) - X X
INT (Page 1087) X X X
DINT (Page 1089) X X X
USINT (Page 1086) - X X
UINT (Page 1088) - X X
UDINT (Page 1089) - X X
LINT (Page 1090) - - X
ULINT (Page 1092) - - X

Table 9-3 Floating-point numbers

Floating-point numbers S7-300/400 S7-1200 S7-1500
REAL (Page 1093) X X X
LREAL (Page 1094) - X X

Table 9-4 Timers

Timers S7-300/400 S7-1200 S7-1500
S5TIME (Page 1096) X - X
TIME (Page 1098) X X X
LTIME (Page 1098) - - X

Table 9-5 Date and time

Date and time S7-300/400 S7-1200 S7-1500
DATE (Page 1099) X X X
TIME_OF_DAY (TOD) (Page 1099) X X X
LTOD (LTIME_OF_DAY) (Page 1100) - - X
DT (DATE_AND_TIME) (Page 1100) X - X
LDT (Page 1101) - - X
DTL (Page 1102) - X X
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Table 9-6 Character

Character S7-300/400 S7-1200 S7-1500
CHAR (Page 1103) X X X
STRING (Page 1103) X X X

Table 9-7 Array

Array S7-300/400 S7-1200 S7-1500
ARRAY [….] OF <type> (Page 1105) X X X

Table 9-8 Structures

Structures S7-300/400 S7-1200 S7-1500
STRUCT (Page 1110) X X X

Table 9-9 Pointer

Pointer S7-300/400 S7-1200 S7-1500
POINTER (Page 1111) X - X
ANY (Page 1113) X - X
VARIANT (Page 1115) - X X

Table 9-10 Parameter types

Parameter types S7-300/400 S7-1200 S7-1500
TIMER (Page 1117) X - X
COUNTER (Page 1117) X - X
BLOCK_FC (Page 1117) X - X
BLOCK_FB (Page 1117) X - X
BLOCK_DB (Page 1117) X - -
BLOCK_SDB (Page 1117) X - -
BLOCK_SFB (Page 1117) X - -
BLOCK_SFC (Page 1117) X - -
VOID (Page 1117) X X X

Table 9-11 PLC data types

PLC data types S7-300/400 S7-1200 S7-1500
PLC data type (Page 1118) X X X

Table 9-12 System data types

System data types S7-300/400 S7-1200 S7-1500
IEC_TIMER (Page 1119) X1) X X
IEC_LTIMER (Page 1119) - - X
IEC_SCOUNTER (Page 1119) - X X

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1079



System data types S7-300/400 S7-1200 S7-1500
IEC_USCOUNTER (Page 1119) - X X
IEC_COUNTER (Page 1119) X2) X X
IEC_UCOUNTER (Page 1119) - X X
IEC_DCOUNTER (Page 1119) - X X
IEC_UDCOUNTER (Page 1119) - X X
IEC_LCOUNTER (Page 1119) - - X
IEC_ULCOUNTER (Page 1119) - - X
ERROR_STRUCT (Page 1119) - X X
NREF (Page 1119) - X X
CREF (Page 1119) - X X
FBTREF (Page 1119) - - -
VREF (Page 1119) - - -
STARTINFO (Page 1119) X - X
SSL_HEADER (Page 1119) X - X
CONDITIONS (Page 1119) - X X
TADDR_Param (Page 1119) - X X
TCON_Param (Page 1119) - X X
1) For S7-300/400 CPUs, the data type is represented by TP, TON and TOF.
2) For S7-300/400 CPUs, the data type is represented by CTU, CTD and CTUD.

Table 9-13 Hardware data types

Hardware data types S7-300/400 S7-1200 S7-1500
REMOTE (Page 1121) - X X
GEOADDR (Page 1121) - - X
HW_ANY (Page 1121) - X X
HW_DEVICE (Page 1121) - X X
HW_DPMASTER (Page 1121) - - X
HW_DPSLAVE (Page 1121) - X X
HW_IO (Page 1121) - X X
HW_IOSYSTEM (Page 1121) - X X
HW_SUBMODULE (Page 1121) - X X
HW_MODULE (Page 1121) - - X
HW_INTERFACE (Page 1121) - X X
HW_IEPORT (Page 1121) - X X
HW_HSC (Page 1121) - X X
HW_PWM (Page 1121) - X X
HW_PTO (Page 1121) - X X
AOM_AID (Page 1121) - X X
AOM_IDENT (Page 1121) - X X
EVENT_ANY (Page 1121) - X X
EVENT_ATT (Page 1121) - X X
EVENT_HWINT (Page 1121) - X X
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Hardware data types S7-300/400 S7-1200 S7-1500
OB_ANY (Page 1121) - X X
OB_DELAY (Page 1121) - X X
OB_TOD (Page 1121) - X X
OB_CYCLIC (Page 1121) - X X
OB_ATT (Page 1121) - X X
OB_PCYCLE (Page 1121) - X X
OB_HWINT (Page 1121) - X X
OB_DIAG (Page 1121) - X X
OB_TIMEERROR (Page 1121) - X X
OB_STARTUP (Page 1121) - X X
PORT (Page 1121) - X X
RTM (Page 1121) - X X
PIP (Page 1121) - - X
CONN_ANY (Page 1121) - X X
CONN_PRG (Page 1121) - X X
CONN_OUC (Page 1121) - X X
CONN_R_ID (Page 1121) - - X
DB_ANY (Page 1121) - X X
DB_WWW (Page 1121) - X X

 

 Note

Depending on the CPU version, the actually valid data types can deviate slightly from the 
table.

 

Binary numbers

BOOL (bit)

Description
An operand of data type BOOL represents a bit value and contains one of the following values:

● TRUE

● FALSE

The following table shows the properties of data type BOOL:
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Length (bits) Format Range of values Examples of value input 
1 Boolean FALSE or TRUE

BOOL#0 or BOOL#1
BOOL#FALSE or 
BOOL#TRUE

TRUE
BOOL#1
BOOL#TRUE

Unsigned integers 0 or 1 1
Binary numbers 2#0 or 2#1 2#0
Octal numbers 8#0 or 8#1 8#1
Hexadecimal numbers 16#0 or 16#1 16#1

 

 Note
Applies to CPUs of the S7-1500 series

For a block with the block property "Optimized block access", the bit has a length of 1 byte.
 

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

Bit strings

BYTE (byte)

Description
An operand of data type BYTE is a bit string of 8 bits.

The following table shows the properties of data type BYTE:

Length 
(bits)

Format Range of values Examples of value input

8 Unsigned integers -128 to 255 15, BYTE#15, B#15
Binary numbers 2#0 to 2#11111111 2#00001111, 

BYTE#2#00001111, 
B#2#00001111

Octal numbers 8#0 to 8#377 8#17, BYTE#8#17, B#8#17, 
Hexadecimal numbers B#16#0 to B#16#FF, 16#0 

to 16#FF
16#0F, BYTE#16#0F, 
B#16#0F

 

 Note

The BYTE data type cannot be compared for more than or less than. It can only be supplied 
with the same decimal data that can be processed by the SINT and USINT data types.
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See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

WORD

Description
An operand of data type WORD is a bit string of 16 bits.

The following table shows the properties of data type WORD:

Length 
(bits)

Format Range of values Examples of value input

16 Unsigned integers -32768 to 65535 61680, WORD#61680, 
W#61680

Binary numbers 2#0 to 2#1111111111111111 2#1111000011110000, 
WORD#2#11110000111100
00, 
W#2#1111000011110000

Octal numbers 8#0 to 8#177777 8#170360, 
WORD#8#170360, 
W#8#170360

Hexadecimal numbers W#16#0 to W#16#FFFF, 16#0 
to 16#FFFF

16#F0F0, WORD#16#F0F0, 
W#16#F0F0

BCD C#0 to C#999 C#55
Decimal sequence B#(0,0) to B#(255,255) B#(127,200)

 

 Note

The WORD data type cannot be compared for more than or less than. It can only be supplied 
with the same decimal data that can be processed by the INT and UINT data types.

 

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

DWORD

Description
An operand of data type DWORD is a bit string of 32 bits.

The following table shows the properties of data type DWORD:
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Length 
(bits)

Format Range of values Examples of value input

32 Unsigned integers -2147483648 to 4294967295 15793935, DWORD#15793935, 
DW#15793935

Binary numbers 2#0 to 
2#11111111111111111111
111111111111

2#0000000011110000111111110
0001111, 
DWORD#2#00000000111100001
111111100001111, 
DW#2#000000001111000011111
11100001111

Octal numbers 8#0 to 8#37777777777 8#74177417, 
DWORD#8#74177417, 
DW#8#74177417

Hexadecimal 
numbers

DW#16#00000000 to 
DW#16#FFFFFFFF, 
16#00000000 to 
16#FFFFFFFF

16#00F0FF0F, 
DWORD#16#00F0FF0F, 
DW#16#00F0FF0F

Decimal sequence B#(0,0,0,0) to 
B#(255,255,255,255)

B#(127,200,127,200)

 

 Note

The DWORD data type cannot be compared for more than or less than. It can only be supplied 
with the same decimal data that can be processed by the DINT and UDINT data types.

 

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

LWORD

Description
An operand of data type LWORD is a bit string of 64 bits.

The following table shows the properties of data type LWORD:
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Length 
(bits)

Format Range of values Examples of value input

64 Unsigned integers -9223372036854775808 to 
18446744073709551615

26123590360715, 
LWORD#26123590360715, 
LW#26123590360715

Binary numbers 2#0 to 
2#11111111111111111111
1111111111111111111111
1111111111111111111111

2#0000000000000000000101111
100001001011110101001011011
11010001011, 
LWORD#2#00000000000000000
001011111000010010111101010
0101101111010001011, 
LW#2#000000000000000000010
111110000100101111010100101
101111010001011

Octal numbers 8#0 to 
8#17777777777777777777
77

8#13724557213, 
LWORD#8#13724557213, 
LW#8#13724557213

Hexadecimal 
numbers

LW#16#00000000 to 
LW#16#FFFFFFFFFFFFFF
FF, 16#00000000 to 
16#FFFFFFFFFFFFFFFF

16#000000005F52DE8B, 
LWORD#16#000000005F52DE8
B, LW#16#000000005F52DE8B

Decimal sequence B#(0,0,0,0,0,0,0,0) to 
B#(255,255,255,255,255,25
5,255,255)

B#(127,200,127,200,127,200,127
,200)

 

 Note

The LWORD data type cannot be compared for more than or less than. It can only be supplied 
with the same decimal data that can be processed by the LINT and ULINT data types.

 

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

Integers

SINT (8-bit integers)

Description
An operand of data type SINT (Short INT) has a length of 8 bits and consists of two 
components: a sign and a numerical value in the two's complement. The signal states of bits 
0 to 6 represent the number value. The signal state of bit 7 represents the sign. The sign may 
assume "0" for the positive, or "1" for the negative signal state.

An operand of data type SINT occupies one BYTE in the memory.

The following table shows the properties of data type SINT:
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Length 
(bits)

Format Range of values Examples of value input

8 Signed integers -128 to 127 +44, SINT#+44
Binary numbers 2#0 to 2#01111111 2#00101100, 

SINT#2#00101100
Octal numbers (only 
positive)

8#0 to 8#177 8#54, SINT#8#54

Hexadecimal numbers 
(only positive)

16#0 to 16#7F 16#2C, SINT#16#2C

Example
The following figure shows the integer +44 as a binary number:

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

USINT (8-bit integers)

Description
An operand of data type USINT (Unsigned Short INT) has a length of 8 bits and contains 
unsigned numerical values:

An operand of data type USINT occupies one BYTE in the memory.

The following table shows the properties of data type USINT:

Length 
(bits)

Format Range of values Examples of value input

8 Unsigned integers 0 to 255 78, USINT#78
Binary numbers 2#0 to 2#11111111 2#01001110, 

USINT#2#01001110
Octal numbers 8#0 to 8#377 8#116, USINT#8#116
Hexadecimal numbers 16#0 to 16#FF 16#4E, USINT#16#4E
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Example
The following figure shows the integer 78 as a binary number:

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

INT (16-bit integers)

Description
An operand of data type INT has a length of 16 bits and consists of two components: a sign 
and a numerical value in the two's complement. The signal states of bits 0 to 14 represent the 
number value. The signal state of bit 15 represents the sign. The sign may assume "0" for the 
positive, or "1" for the negative signal state.

An operand of data type INT occupies two BYTE in the memory.

The following table shows the properties of data type INT:

Length 
(bits)

Format Range of values Examples of value input

16 Signed integers -32768 to 32767 +3785, INT#+3785
Binary numbers (only 
positive)

2#0 to 
2#0111111111111111

2#0000111011001001, 
INT#2#0000111011001001

Octal numbers 8#0 to 8#77777 8#7311, INT#8#7311
Hexadecimal numbers (only 
positive)

16#0 to 16#7FFF 16#0EC9, INT#16#0EC9

Example
The following figure shows the integer +3785 as a binary number:
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See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

UINT (16-bit integers)

Description
An operand of data type UINT (Unsigned INT) has a length of 16 bits and contains unsigned 
numerical values.

An operand of data type UINT occupies two BYTE in the memory.

The following table shows the properties of data type UINT:

Length 
(bits)

Format Range of values Examples of value input

16 Unsigned integers 0 to 65535 65295, UINT#65295
Binary numbers 2#0 to 2#1111111111111111 2#1111111100001111, 

UINT#2#1111111100001111
Octal numbers 8#0 to 8#177777 8#177417, UINT#8#177417
Hexadecimal 
numbers

16#0 to 16#FFFF 16#FF0F, UINT#16#FF0F

Example
The following figure shows the integer 65295 as a binary number:

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)
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DINT (32-bit integers)

Description
An operand of data type DINT (Double INT) has a length of 32 bits and consists of two 
components: a sign and a numerical value in the two's complement. The signal states of bits 
0 to 30 represent the number value. The signal state of bit 31 represents the sign. The sign 
may assume "0" for the positive, or "1" for the negative signal state. 

An operand of data type DINT occupies four BYTE in the memory.

The following table shows the properties of data type DINT:

Length 
(bits)

Format Range of values Examples of value input

32 Signed integers -2147483648 to +2147483647 125790, DINT#125790, L#275
Binary numbers (only 
positive)

2#0 to 
2#0111111111111111111111
1111111111

2#0000000000000001111010
1101011110, 
DINT#2#00000000000000011
110101101011110

Octal numbers (only 
positive)

8#0 to 8#17777777777 8#365536, DINT#8#365536

Hexadecimal 
numbers

16#00000000 to 
16#7FFFFFFF

16#0001EB5E, 
DINT#16#0001EB5E

Example
The following figure shows the integer +125790 as a binary number:

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

UDINT (32-bit integers)

Description
An operand of data type UDINT (Unsigned Double INT) has a length of 32 bits and contains 
unsigned numerical values.
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An operand of data type UDINT occupies four BYTE in the memory.

The following table shows the properties of data type UDINT:

Length 
(bits)

Format Range of values Examples of value input

32 Unsigned integers 0 to 4294967295 4042322160, 
UDINT#4042322160

Binary numbers 2#0 to 
2#111111111111111111
11111111111111

2#1111000011110000111100001
1110000, 
UDINT#2#111100001111000011
11000011110000

Octal numbers 8#0 to 8#37777777777 8#36074170360, 
UDINT#8#36074170360

Hexadecimal numbers 16#00000000 to 
16#FFFFFFFF

16#F0F0F0F0, 
UDINT#16#F0F0F0F0

Example
The following figure shows the integer 4042322160 as a binary number:

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

LINT (64-bit integers)

Description
An operand of data type LINT (Long INT) has a length of 64 bits and consists of two 
components: a sign and a numerical value in the two's complement. The signal states of bits 
0 to 62 represent the number value. The signal state of bit 63 represents the sign. The sign 
may assume "0" for the positive, or "1" for the negative signal state. 

An operand of data type LINT occupies eight BYTE in the memory.

The following table shows the properties of data type LINT:
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Length (bits) Format Range of values Examples of value input
64 Signed integers -9223372036854775808 to 

+9223372036854775807
+154325790816159, LINT#
+154325790816159

Binary numbers (only 
positive)

2#0 to 
2#0111111111111111111111111111
111111111111111111111111111111
111111

2#0000000000000000100011000101
101111000101111100001111011110
011111, 
LINT#2#00000000000000001000110
001011011110001011111000011110
11110011111

Octal numbers 8#0 to 8#777777777777777777777 8#4305570574173637, 
LINT#8#4305570574173637

Hexadecimal numbers 
(only positive)

16#0 to 16#7FFFFFFFFFFFFFFF 16#00008C5BC5F0F79F, 
LINT#16#00008C5BC5F0F79F

Example
The following figure shows the integer +154325790816159 as a binary number:

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)
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ULINT (64-bit integers)

Description
An operand of data type ULINT (Unsigned Long INT) has a length of 64 bits and contains 
unsigned numerical values.

An operand of data type ULINT occupies eight BYTE in the memory.

The following table shows the properties of data type ULINT:

Length (bits) Format Range of values Examples of value input
64 Unsigned integers 0 to 18446744073709551615 154325790816159, 

ULINT#154325790816159
Binary numbers 2#0 to 

2#0111111111111111111111111111
111111111111111111111111111111
111111

2#0000000000000000100011000101
101111000101111100001111011110
011111, 
ULINT#2#000000000000000010001
100010110111100010111110000111
1011110011111

Octal numbers 8#0 to 8#1777777777777777777777 8#4305570574173637, 
ULINT#8#4305570574173637

Hexadecimal numbers 16#0 to 16#FFFFFFFFFFFFFFFF 16#00008C5BC5F0F79F, 
ULINT#16#00008C5BC5F0F79F

Example
The following figure shows the integer 154325790816159 as a binary number:
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See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

Floating-point numbers

REAL

Description
Operands of the data type REAL have a length of 32 bits and are used to display floating-point 
numbers. An operand of the REAL data type consists of the following three components:

● Sign: The sign is determined by the signal state of bit 31. The bit 31 assume the value "0" 
(positive) or "1" (negative).

● 8-bit exponents to basis 2: The exponent is increased by a constant (base, +127), so that 
it has a value range of 0 to 255.

● 23-bit mantissa: Only the fraction part of the mantissa is shown. The integer part of the 
mantissa is always 1 with normalized floating-point numbers and is not stored.

The REAL data type is processed with a precision of 7 digits after the decimal point.

The following figure shows the structure of the REAL data type:

 

 Note

With floating-point numbers, only the precision defined by the IEEE754 standard is stored. 
Additionally specified decimals are rounded off according to IEEE754.

The number of decimal places may decrease for frequently nested arithmetic calculations.

If more decimal places are specified than can be stored by the data type, the number is 
rounded to the corresponding value of the precision allowed by this value range .

 

The following table shows the properties of data type REAL:
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Length 
(bits)

Format Range of values Examples of value input

32 Floating-point 
numbers according 
to IEEE754

-3.402823e+38 to -1.175 495e-38
±0
+1.175 495e-38 to +3.402823e+38

1.0e-5, REAL#1.0e-5

Floating-point 
numbers

1.0, REAL#1.0

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

LREAL

Description
Operands of the data type LREAL have a length of 64 bits and are used to represent floating-
point numbers. An operand of the LREAL data type consists of the following three components:

● Sign: The sign is determined by the signal state of bit 63. The bit 63 assumes the value "0" 
(positive) or "1" (negative).

● 11-bit exponents to base 2: The exponent is increased by a constant (base, +1023), so that 
it has a value range of 0 to 2047.

● 52-bit mantissa: Only the fraction part of the mantissa is shown. The integer part of the 
mantissa is always 1 with normalized floating-point numbers and is not stored.

The LREAL data type is processed with a precision of 15 digits after the decimal point.

The following figure shows the structure of the LREAL data type:

The following table shows the properties of data type LREAL:

Length 
(bits)

Format Range of values Examples of value input

64 Floating-point 
numbers according 
to IEEE754

-1.7976931348623158e+308 to 
-2.2250738585072014e-308
±0
+2.2250738585072014e-308 to 
+1.7976931348623158e+308

1.0e-5, LREAL#1.0e-5

Floating-point 
numbers

1.0, LREAL#1.0
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 Note

With floating-point numbers, only the precision defined by the IEEE754 standard is stored. 
Additionally specified decimals are rounded off according to IEEE754.

The number of decimal places may decrease for frequently nested arithmetic calculations.

If more decimal places are specified than can be stored by the data type, the number is 
rounded to the corresponding value of the precision allowed by this value range .

 

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

Invalid floating-point numbers

Description
We distinguish between four number ranges for data types REAL and LREAL:

● normalized numbers stored with full accuracy

● denormalized numbers not stored with full accuracy

● Infinite numbers: +Inf/-Inf (infinity)

● Invalid numbers: NaN (Not a Number)
 

 Note

Floating-point numbers are stored as specified by the IEEE754 standard. Results of 
conversion or arithmetic functions with a denormalized, infinite or NaN (Not a Number) floating 
point depend on the CPU. 

 

If you are not working with normalized floating-point numbers in mathematical functions, the 
result will show significant differences depending on the series of the CPU which you are using.

A CPU cannot calculate with denormalized floating-point numbers, with the exception of older 
CPU versions of the S7-300 and S7-400 series. The bit pattern of a denormalized number is 
interpreted as a zero. If the result of calculation falls into this range, it is continued with zero; 
the status bits OV and OS are set (number range undershoot).

Even though the values of invalid floating-point numbers can only be displayed with limited 
accuracy for mathematical functions, numbers with an exponent of -39 (e.g., 2.4408e-039) can 
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be monitored in the TIA Portal and therefore do not necessarily represent a faulty result. This 
means that floating-point values may be located outside the range of valid numerical values.

 

 Note
The following applies to CPUs of the series S7-1200 V1, V2 and V3:

The comparison operation "Equal" uses the bit pattern of the invalid floating-point number. If 
two "NaN numbers" with the same bit pattern are compared, the output of the "Equal" 
comparison operation returns the result TRUE.

 

 Note
The following applies to CPUs of the S7-1200 V4 and S7-1500 series:

If two invalid numbers (NaN) are compared with each other, the result is always FALSE, 
regardless of the bit pattern of the invalid number or the relation (>, >, ...).

 

 Note
Comparison of denormalized floating-point numbers

For the comparison operation "Equal" with two denormalized floating-point numbers, the 
output for CPUs of the S7-300/400 series is set to the signal state "0" and for CPUs of the 
S7-1200/1500 series to the signal state "1".

 

If the input variables of a mathematical function represent an invalid floating-point number, an 
invalid floating-point number will also be output as result.

You have the following options to evaluate possible errors caused by invalid floating-point 
numbers:

● In LAD/FBD and SCL, you can query the enable output ENO for FALSE

● In STL, you can evaluate the status bit OV

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

Timers

S5TIME (duration)

Format         
Data type S5TIME stores the duration in BCD format. The duration is the product from a time 
in the range 0 to 999 and a time basis. The time basis indicates the interval at which a timer 
decrements the time value by one unit until it reaches "0". The resolution of the times can be 
controlled via the time basis.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1096 System Manual, 07/2013,  



The following table shows the range of values for data type S5TIME:

Length 
(bits)

Format Range of values Examples of value input

16 S7 time in 
increments of 10 
ms (default value)

S5T#0H_0M_0S_0MS to 
S5T#2H_46M_30S_0MS

S5T#10s, S5TIME#10s

The following table shows the time base coding for S5TIME:

Time basis Binary code for time basis
10 ms 00
100 ms 01
1 s 10
10 s 11

Always observe range limits and the resolution of time values when using data type S5TIME 
with timers. The table below specifies the range associated with each resolution:

Resolution Range
0.01 s 10 ms to 9 s 990 ms
0.1 s 100 ms to 1 min 39 s 900 ms
1 s 1 s to 16 min 39 s
10 s 10 s to 2 h 46 min 30 s

Values that exceed 2h46m30s are not accepted.

Example
The following figure shows the content of the time operand for a time value of 127 and a time 
base of 1 s:
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See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

TIME (IEC time)

Description
The contents of an operand of the data type TIME is interpreted as milliseconds. The 
representation contains information for days (d), hours (h), minutes (m), seconds (s) and 
milliseconds (ms).

The following table shows the properties of data type TIME:

Length 
(bits)

Format Range of values Examples of value input

32 Signed duration T#-24d20h31m23s648ms to 
T#+24d20h31m23s647ms

T#10d20h30m20s630ms, 
TIME#10d20h30m20s630ms

It is not necessary to specify all time units. T#5h10s is a valid entry, for example. If only one 
unit is specified, the absolute value of days, hours, and minutes must not exceed the high or 
low limits. When more than one time unit is specified, the value must not exceed 24 days, 23 
hours, 59 minutes, 59 seconds or 999 milliseconds.

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

LTIME (IEC time)

Description
The contents of an operand of data type LTIME is interpreted as nanoseconds. The 
representation contains information for days (d), hours (h), minutes (m), seconds (s) and 
milliseconds (ms), microseconds (us) and nanoseconds (ns).

The following table shows the properties of data type LTIME:

Length 
(bits)

Format Range of values Examples of value input

64 Signed 
duration

LT#-106751d23h47m16s854ms775
us808ns to LT#
+106751d23h47m16s854ms775us8
07ns

LT#11350d20h25m14s830ms652us3
15ns, 
LTIME#11350d20h25m14s830ms652
us315ns

It is not necessary to specify all time units. LT#5h10s is therefore a valid entry, for example. If 
only one unit is specified, the absolute value of days, hours, and minutes must not exceed the 
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high or low limits. When more than one time unit is specified, the value must not exceed 106751 
days, 23 hours, 59 minutes, 59 seconds, 999 milliseconds, 999 microseconds or 999 
nanoseconds.

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

Date and time

DATE

Format
The DATE data type saves the date as an unsigned integer. The representation contains the 
year, the month, and the day.

The contents of an operand of DATE data type correspond in hexadecimal format to the 
number of days since 01-01-1990 (16#0000).

The following table shows the properties of data type DATE:

Length 
(bytes)

Format Range of values Examples of value input

2 IEC date
(Year-Month-Day)

D#1990-01-01 to 
D#2168-12-31

D#2009-12-31, DATE#2009-12-31

Hexadecimal 
numbers

16#0000 to 16#FF62 16#00F2

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

TIME_OF_DAY (TOD)

Format
Data type TOD (TIME_OF_DAY) occupies a double word and stores the number of 
milliseconds since the beginning of the day (0:00 h) as unsigned integer.

The following table shows the properties of data type TOD:
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Length 
(bytes)

Format Range of values Examples of value input

4 Time-of-day 
(hours:minutes:seconds)

TOD#00:00:00.000 to 
TOD#23:59:59.999

TOD#10:20:30.400, 
TIME_OF_DAY#10:20:30.40
0

You always need to specify the hours, minutes and seconds. The specification of milliseconds 
is optional.

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

LTOD (LTIME_OF_DAY)

Format
Data type LTOD (LTIME_OF_DAY) occupies two double words and stores the number of 
nanoseconds since the beginning of the day (0:00 h) as unsigned integer.

The following table shows the properties of data type LTOD:

Length 
(bytes)

Format Range of values Examples of value input

8 Time-of-day 
(hours:minutes:seconds.millis
econds.microseconds.nanose
conds)

LTOD#00:00:00.0000000
00 to 
LTOD#23:59:59.9999999
99

LTOD#10:20:30.400_365_21
5, 
LTIME_OF_DAY#10:20:30.4
00_365_215

You always need to specify the hours, minutes and seconds. The specification of milliseconds, 
microseconds and nanoseconds is optional.

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

DATE_AND_TIME (date and time of day) 

Format
The DT (DATE_AND_TIME) data type saves the information on date and time of day in BCD 
format. 

The following table shows the properties of data type DT:
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Length 
(bytes)

Format Range of values Example of value input

8 Date and time
(year-month-day-
hour:minute:second)3))

Min.: DT#1990-01-01-0:0:0
Max.: 
DT#2089-12-31-23:59:59.9
99

DT#2008-10-25-8:12:34.567, 
DATE_AND_TIME#2008-10-25
-08:12:34.567

The following table shows the structure of the DT data type:

Byte Contents Range of values
0 Year 0 to 99

(Years 1990 to 2089)
BCD#90 = 1990
...
BCD#0 = 2000
...
BCD#89 = 2089

1 Month BCD#0 to BCD#12
2 Day BCD#1 to BCD# 31
3 Hour BCD#0 to BCD#23
4 Minute BCD#0 to BCD#59
5 Second BCD#0 to BCD#59
6 The two most significant digits of MSEC BCD#0 to BCD#999
7 (4MSB) 1) The least significant digit of MSEC BCD#0 to BCD#9
7 (4LSB) 2) Weekday BCD#1 to BCD#7

BCD#1 = Sunday
...
BCD#7 = Saturday

1) MSB: Most significant bit
2) LSB: Least significant bit
3) Fixed point number

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

LDT (DATE_AND_LTIME) 

Format
Data type LDT (DATE_AND_LTIME) stores the date and time-of-day information in 
nanoseconds since 01/01/1970 0:0.

The following table shows the properties of data type LDT:
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Length 
(bytes)

Format Range of values Example of value input

8 Date and time
(Year-Month-Day-
Hour:Minute:Second)

Min.: 
LDT#1970-01-01-0:0:0.000
000000, 16#0
Max.: 
LDT#2262-04-11-23:47:16.
854775807, 
16#7FFF_FFFF_FFFF_FFF
F

LDT#2008-10-25-8:12:34.567

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

DTL

Description
An operand of data type DTL has a length of 12 bytes and stores date and time information in 
a predefined structure.

The following table shows the properties of data type DTL:

Length 
(bytes)

Format Range of values Example of value input

12 Date and time
(Year-Month-Day-
Hour:Minute:Second.Nanos
econds)

Min.: 
DTL#1970-01-01-00:00:00.0
Max.: 
DTL#2554-12-31-23:59:59.9
99999999

DTL#2008-12-16-20:30:20
.250

The structure of data type DTL consists of several components each of which can contain a 
different data type and range of values. The data type of a specified value must match the data 
type of the corresponding components.

The following table shows the structure components of data type DTL and their properties:

Byte Component Data type Range of values
0 Year UINT 1970 to 2554
1
2 Month USINT 1 to 12
3 Day USINT 1 to 31
4 Weekday USINT 1(Sunday) to 7(Saturday)

The weekday is not considered in the value 
entry.

5 Hour USINT 0 to 23
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Byte Component Data type Range of values
6 Minute USINT 0 to 59
7 Second USINT 0 to 59
8 Nanosecond UDINT 0 to 999999999
9
10
11

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

Character strings

CHAR (character)

Description       
An operand of data type CHAR has a length of 8 bits and occupies one BYTE in the memory.

The CHAR data type stores a single character in ASCII format. You can find information on 
the coding of special characters under "See also".

The following table shows the value range of the CHAR data type:

Length 
(bits)

Format Range of values Example of value inputs

8 ASCII characters ASCII character set 'A', CHAR#'A'

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

STRING

Description
An operand of the STRING data type saves several characters in a character string that can 
consist of up to 254 characters. In a character string, all characters of the ASCII code are 
permitted. The characters are specified in single quotation marks.

The following table shows the properties of a STRING tag:
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Length (bytes) Format Range of values Example of value input
n + 2 * ASCII character string 

incl. special characters
0 to 254 characters 'Name', STRING#'NAME'

* An operand of the STRING data type occupies two bytes more than the specified maximum length 
in the memory.

A character string can also contain special characters. The alignment symbol $ is used to 
identify control characters, dollar character and single quotation marks.

The following table shows examples for the notation of special characters:

Character Hex Meaning Example
$L or $l CCA Line feed '$LText', '$0AText'
$N or $n 0A and 0D Line break

The line break occupies 2 characters 
in the character string.

'$NText', '$0A$0DText'

$P or $p 0C Page feed '$PText', '$0CText'
$R or $r 0D Carriage return (CR) '$RText','$0DText'
$T or $t 09 Tabulator '$TText', '$09Text'
$$ 24 Dollar character '100$$t', '100$26'
$' 27 Single quotation marks '$'Text$'','$27Text$27'

The maximum length of the character string can be specified during the declaration of an 
operand using square brackets after the keyword STRING (for example,  STRING[4]). If the 
information on maximum length is omitted, the standard length of 254 characters is set for the 
respective operand.

If the actual length of a specified character string is shorter than the declared maximum length, 
the characters are written to the character string right-justified and the remaining character 
spaces remain undefined. Only occupied character spaces are considered in the value 
processing.

 

 Note

For S7-300/400 CPUs, please note: If a temporary tag of the STRING data type was defined, 
you must describe the BYTE "Max. length of string" with the defined length before you use 
the tags in the user program.
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Example
The example below shows the byte sequence if the STRING[4] data type is specified with 
output value 'AB':

See also
Overview of the valid data types (Page 1077)

Constants (Page 1051)

Array

Format of array (16-bit limits)

Description
The Array data type represents a data structure that consists of a fixed number of components 
of the same data type. All data types except Array are permitted.

A tag with the Array data type always starts at a WORD limit.

The array components are addressed by means of an index. In the array declaration, the index 
limits are defined in square brackets after the keyword Array. The low limit must be smaller 
than or equal to the high limit. An array may contain up to six dimensions, the limits of which 
can be specified separated by a comma.

The following table shows the property of the Array data type:

Length Format Index limits Data type
Number of 
components * length 
of the data type

Array [low limit...high 
limit] of <data type>

[-32768..32767] of 
<data type>

Bit strings, integers, 
floating-point numbers, 
timers, character 
strings, structures 
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Example
The following example shows how operands of data type Array can be declared:

Name Declaration Comment
Measured value Array[1..20] of REAL One-dimensional array with 20 components
Time-of-day Array[-5..5] of INT One-dimensional array with 11 components
Character Array[1..2, 3..4] of CHAR Two-dimensional array with 4 components

Maximum array limits
The maximum Array limits depend on the following factors:

● Data type of the Array elements

● Maximum storage capacity of the CPU (you can find more information in the relevant device 
manual)

See also
Overview of the valid data types (Page 1077)

Indirect indexing of ARRAY components (Page 1070)

Format of array (32-bit limits)

Description
The Array data type represents a data structure that consists of a fixed number of components 
of the same data type. All data types except Array are permitted.

The array components are addressed by means of an index. In the array declaration, the index 
limits are defined in square brackets after the keyword Array. The low limit must be smaller 
than or equal to the high limit. An array may contain up to six dimensions, the limits of which 
can be specified separated by a comma.

 

 Note

Depending on the CPU, the storage capacity of a data block is limited and the number of 
components of the Array is therefore also limited. However, you may initialize the addressing 
of the array components at any position within index limits.

 

The following table shows the property of the Array data type:

Length Format Index limits Data type
Number of 
components * length 
of the data type

Array [low limit...high 
limit] of <data type>

[-2147483648..214748
3647] of <data type>

Bit strings, integers, 
floating-point numbers, 
timers, character 
strings, structures 
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 Note

The length of the array depends on whether the block was created with the "Standard" or 
"with optimized access" block property.

 

 Note
Applies to CPUs of the S7-1500 series

For a block with the block property "Optimized block access", a bit requires 1 byte of memory. 
This is also true when you use an array of <data type>. An array [0..1] of BOOL, for example, 
needs 8 bytes in an optimized block.

 

Example
The following example shows how operands of data type Array can be declared:

Name Declaration Comment
Measured value Array[1..20] of REAL One-dimensional array with 20 components
Time-of-day Array[-5..5] of INT One-dimensional array with 11 components
Character Array[1..2, 3..4] of CHAR Two-dimensional array with 4 components

Maximum array limits
The maximum array limits depend on the following factors:

● Data type of the array elements

● Memory reserve (only in blocks with optimized access)
You can find additional information on this topic in the section "Loading block changes 
without reinitialization".

● Maximum size of a data block for a CPU (you can find more information in the respective 
device manual)

● The entire length of the array is available within a data block. Within a program block (OB, 
FB or FC), the possible length is reduced by the memory capacity required by the program 
code.

Example based on a CPU of the S7-1200 series
The following table shows the maximum number of elements within a block with the "with 
optimized access" block property:

Data type width (bits) Maximum number of elements Note
1 524272 = 65534*8
8 65534 Refer to the respective device 

manual of the CPU for the value.
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Data type width (bits) Maximum number of elements Note
16 32767 = 65534/2 (integer division, 

remainder 0)
32 16383 = 65534/4 (integer division, 

remainder 2)
64 8191 = 65534/8 (integer division, 

remainder 6)

Due to various technical/internal constraints, the actual usable memory area may be 
approximately 70 - 100 bytes less. The memory area may be further restricted due to a default 
setting, for example, by the "Load without reinitialization" block property.

See also
Overview of the valid data types (Page 1077)

Indirect indexing of ARRAY components (Page 1070)

Example of a one-dimensional array

Declaration
The following table shows the declaration of a one-dimensional Array tag:

Name Data type Comment
Op_Temp Array[1..3] of INT One-dimensional array tag with 3 components.

The following figure shows the structure of the declared array tag:

Access to ARRAY components
The individual array components are accessed via an index.. The index of the first ARRAY 
component is [1], of the second [2], and of the third [3]. To access the value of the second 
ARRAY component, you need to declare "Op_Temp[2]" in the program.
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Example of a multi-dimensional array

Declaration
The following table shows the declaration of a two-dimensional Array tag:

Name Data type Value Comment
Betr_Temp Array[1..2, 1..3] of INT 1,1,4(0) Two-dimensional array 

tag with 6 components. 
The first two 
components are 
assigned the value "1". 
The remaining four 
components are 
assigned the value "0".

The following figure shows the structure of the declared array tag:

Access to the array components
The values of the individual array components are accessed via an index. The index of the 
first array component is, for example, [1,1] and the index of the fourth array component is [2,1]. 
For example, you need to declare "Betr_Temp[2,1]" in the program to enable access to the 
value of the fourth array component.

Additional access option
You can also declare the "Betr_Temp" TAG as a six-dimensional array. The following table 
shows an example of the declaration of a six-dimensional Array tag:

Name Data type Value Comment
Betr_Temp Array[1..3, 1..2, 1..3, 

1..4, 1..3, 1..4] of INT
- Six-dimensional array 

tag

The index of the first array component is in this case [1,1,1,1,1,1] and the index of the last 
component is [3,2,3,4,3,4]. Intermediate values are accessed by entering the corresponding 
value for each dimension.
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Structures

STRUCT

Description       
Data type STRUCT represents a data structure that consists of a fixed number of components 
of various data types. Components of STRUCT or ARRAY data type can also be nested in a 
structure. The nesting depth is hereby limited to eight levels. Structures can be used to group 
data according to the process control system and to transfer parameters as one data unit.

A component of the ARRAY data type always starts at a WORD limit.

The following table shows the properties of data type STRUCT:

Length Format Range of values Example of value input
A STRUCT variable 
starts with one byte with 
even address and 
occupies the memory 
up to the next word limit.

STRUCT The value ranges 
of the used data 
types apply.

The value input rules of the used data 
types apply.

Example
The following figure shows an example of the structure of a STRUCT variable:

See also
Overview of the valid data types (Page 1077)
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Pointer

POINTER

Description
A parameter of the type POINTER is a pointer that can point to a specific tag. It occupies 6 
bytes (48 bits) in memory and may contain the following tag information:

● DB number, or 0 if the data is not stored in a DB

● Memory area in the CPU

● Tag address

The following figure shows the structure of parameter type POINTER:

Types of pointer
Depending on the information, you can use parameter type POINTER to declare the following 
four types of pointer:

● Area-internal pointer:
An area-internal pointer contains information on the address of a tag.

● Cross-area pointer:
A cross-area pointer contains information on the memory area and the address of a tag.

● DB pointer:
You can use a DB pointer to point to a data block tag. A DB pointer also contains a data 
block number in addition to the memory area and the address of a tag.

● Zero pointer:
Use the zero pointer to indicate a missing value. A missing value may indicate that no value 
exists, or that the value is not yet known. A zero value represents the absence of a value, 
but is also a value.

The following table shows the formats for the declaration of various pointer types:
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P#ByteRepresentation Format Example of value 
input

Description

Symbolic P#Byte.Bit "MyTag" Area-internal pointer
P#OperandAreaByte.Bit "MyTag" Cross-area pointer
P#Data_block.Data_oper
and

"MyDB"."MyTag" DB pointer

P#Zero value - Zero pointer
Absolute P#Byte.Bit P#20.0 Area-internal pointer

P#OperandAreaByte.Bit P#M20.0 Cross-area pointer
P#Data_block.Data_oper
and

P#DB10.DBX20.0 DB pointer

P#Zero value P#0.0, ZERO Zero pointer

You can enter a parameter of the type POINTER without prefix (P#). The entry is then 
automatically converted to the POINTER format.

 

 Note

If you use the prefix P#, you can only point to memory areas with "standard" access mode.
 

Memory areas
The following table shows the hexadecimal codes of the memory areas for parameter type 
POINTER:

Hexadecimal code Memory area Description
B#16#801) P Peripherals on a CPU 

S7-300/400
16#1 P Peripheral inputs on a 

CPU S7-1500
16#2 P Peripheral outputs on a 

CPU S7-1500
B#16#81 I Memory area of inputs
B#16#82 Q Memory area of outputs
B#16#83 M Memory area of bit 

memory
B#16#84 DBX Data block
B#16#85 DIX Instance data block
B#16#86 L Local data
B#16#87 V Previous local data
1) These data types can only be used for the POINTER pointer on a CPU 
S7-300/400.
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See also
Basics of indirect addressing (Page 1068)

Overview of the valid data types (Page 1077)

Constants (Page 1051)

ANY

Description
An ANY type parameter points to the start of a data area and specifies its length. An ANY 
pointer occupies 10 bytes of memory and may contain the following information:

● Data type:
Data type of the elements of the data area

● Repetition factor:
Number of elements of the data area

● DB number:
Data block that contains the declaration of data area elements.

● Memory area:
Memory area of the CPU that stores the data area elements.

● Start address of the data in the format "byte.bit":
Data area start identified by the ANY pointer.

● Zero pointer:
Use the zero pointer to indicate a missing value. A missing value may indicate that no value 
exists, or that the value is not yet known. A zero value represents the absence of a value, 
but is also a value.

The following figure shows the structure of the ANY pointer:

An ANY pointer cannot identify structures. It can only be assigned to local tags.

The following table shows the formats for the declaration of an ANY pointer:
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Representation Format Example of value input Description
Symbolic P#DataBlock.MemoryA

rea DataAddress Type 
Number

"MyDB".StructTag.Initia
lComponents

Area with 10 words in 
global DB11 starting 
with DBB20.0

P#MemoryArea 
DataAddress Type 
Number

"MyMarkerTag" Area with 4 bytes 
starting with MB 20.0

"MyTag" Input I1.0
P#Zero value - Zero value

Absolute P#DataBlock.MemoryA
rea DataAddress Type 
Number

P#DB11.DBX20.0 INT 
10

Area with 10 words in 
global DB11 starting 
with DBB20.0

P#MemoryArea 
DataAddress Type 
Number

P#M20.0 BYTE 10 Area with 10 bytes 
starting with MB 20.0

P#E1.0 BOOL 1 Input I1.0
P#Zero value P#0.0 VOID 0, ZERO Zero value

 

 Note

With the ANY pointer, you can only point to memory areas with "Standard" access mode.
 

Coding of data types
The following table lists the coding of data types for the ANY pointer:

Hexadecimal code Data type Description
B#16#00 NIL Zero pointer
B#16#011) BOOL Bits
B#16#02 BYTE bytes, 8 bits
B#16#03 CHAR 8-bit characters 
B#16#04 WORD 16-bit words
B#16#05 INT 16-bit integers 
B#16#06 DWORD 32-bit words
B#16#07 DINT 32-bit integers
B#16#08 REAL 32-bit floating-point numbers
B#16#0B TIME Duration
B#16#0C S5TIME Duration
B#16#09 DATE Date
B#16#0A TOD Date and time
B#16#0E DT Date and time
B#16#13 STRING Character string
B#16#171) BLOCK_FB Function block
B#16#181) BLOCK_FC Function
B#16#191) BLOCK_DB Data block
B#16#1A1) BLOCK_SDB System data block
B#16#1C1) COUNTER Counter
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Hexadecimal code Data type Description
B#16#1D1) TIMER Time
1) These data types can only be used for the ANY pointer on a CPU S7-300/400.

Coding of the memory area
The following table lists the coding of the memory areas for the ANY pointer:

Hexadecimal code Area Description
B#16#801) P I/O
B#16#81 I Memory area of inputs
B#16#82 Q Memory area of outputs
B#16#83 M Memory area of bit memory
B#16#84 DBX Data block
B#16#85 DIX Instance data block
B#16#86 L Local data
B#16#87 V Previous local data
1) These memory areas can only be used for the ANY pointer on an S7-300/400 CPU.

See also
Basics of indirect addressing (Page 1068)

Overview of the valid data types (Page 1077)

Constants (Page 1051)

VARIANT

Description
A parameter of the VARIANT type is a pointer that can point to tags of different data types 
other than an instance. The VARIANT pointer can be an object of an elementary data type, 
such as INT or REAL. It can also be a STRING, DTL, array of STRUCT, UDT, or array of UDT. 
The VARIANT pointer can recognize structures and point to individual structure components. 
An operand of data type VARIANT occupies no space in the instance DB or L stack. However, 
it will occupy memory space on the CPU.

But a tag of the VARIANT type is not an object but rather a reference to another object. 
Individual elements of the VARIANT type can only be declared within the block interface of a 
function. For this reason, it cannot be declared in a data block or in the static section of the 
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block interface of a function block, for example, because its size is unknown. The size of the 
referenced objects can change.

 

 Note

You can only point to a complete data block if it was originally derived from a user-defined 
data type (UDT).

 

The following table shows the properties of the VARIANT pointer:

Length 
(bytes)

Representat
ion

Format Example of value input

0 Symbolic Operand "TagResult"
NameDataBlock.NameOperand.Component "Data_TIA_Portal".StructVariable.FirstCompon

ent
Absolute Operand %MW10

DataBlockNumber.Operand Type Length
(valid only for blocks with standard access)

P#DB10.DBX10.0 INT 12

P#Zero value P#0.0 VOID 0, ZERO
 

 Note

If you use the prefix P#, you can only point to memory areas with "standard" access mode.
 

Example
The following example shows how VARIANT works using the "MOVE: Move value" instruction 
of STL:

STL Description
CALL MOVE // The "Move value" instruction is called.
VARIANT // Data type of the instruction
IN := 
"Data_TIA_Portal".StructVariable.FirstComponent

// The contents of the "FirstComponent" operand 
are moved from the "Data_TIA_Portal" DB.

OUT := "MotorDB".StructResult.TagResult // And transferred to the "TagResult" operand from 
the "MotorDB" DB.

See also
Basics of indirect addressing (Page 1068)

Overview of the valid data types (Page 1077)

Constants (Page 1051)

Basics of block access (Page 1027)
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Parameter types

Parameter types

Description
The parameter types are data types for formal parameters that are transferred to called blocks. 
A parameter type can also be a PLC data type.

The following table shows the available parameter data types and their purpose:

Parameter type Length (bits) Description
TIMER 16 Is used to specify a timer that is used in the called code block. 

If you supply a formal parameter of the TIMER parameter type, 
the associated actual parameter must be a timer.
Example: T1

COUNTER 16 Is used to specify a counter that is used in the called code block. 
If you supply a formal parameter of the COUNTER parameter 
type, the associated actual parameter must be a counter.
Example: C10

BLOCK_FC 16 Is used to specify a block that is used as input in the called code 
block.
The declaration of the parameter determines the block type (for 
example FB, FC, DB) that is to be used.
If you supply a formal parameter of the BLOCK parameter type, 
specify a block address as the actual parameter.
Example: DB3

BLOCK_FB 16
BLOCK_DB 16
BLOCK_SDB 16
BLOCK_SFB 16
BLOCK_SFC 16
BLOCK_OB 16
BLOCK_SDT -
BLOCK_UDT -
VOID - The VOID parameter type does not save any values. This 

parameter type is used if the return values of an output are not 
required. The VOID parameter type can be specified at the 
STATUS output, for example, if no error information is required.

See also
Overview of the valid data types (Page 1077)

Basics of PLC data types (Page 1409)
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PLC data types

PLC data types

Description 
PLC data types are data structures that you define and that can be used multiple times within 
the program. The structure of a PLC is made up of several components, each of which can 
contain different data types. You define the type of components during the declaration of the 
PLC data type.

PLC data types can be used for the following applications:

● PLC data types can be used as data types for variables in the variable declaration of logic 
blocks or in data blocks.

● PLC data types can be used as templates for the creation of global data blocks with identical 
data structures.

See also
Addressing structured variables (Page 1062)

Example of a PLC data type

Example
You can declare PLC data types as the type when creating data blocks. Based on this type 
you can create a number of data blocks, all of which have the same data structure. These data 
blocks can be adapted by entering different actual values for the corresponding task.

For instance, create a PLC data type for a recipe for blending paints. You can then assign this 
data type to several data blocks, each of which contains other quantity information. 

The following figure shows this application:
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System data types

System data types

Description
The system data types (SDT) are made available by the system and have a predefined 
structure. The structure of a system data type consists of a fixed number of components that 
can have various data types. It is not possible to change the structure of a system data type.

The system data types can only be used for specific instructions. The following table shows 
the available system data types and their purpose:

System data type Length (bytes) Description
IEC_TIMER 16 Structure of a timer whose timer values are of TIME data type.

This data type is used for the "TP", "TOF", "TON", "TONR", 
"RT" and "PT" instructions, for example.

IEC_LTIMER 32 Structure of a timer whose timer values are of LTIME data 
type.
This data type is used for the "TP", "TOF", "TON", "TONR", 
"RT" and "PT" instructions, for example.

IEC_SCOUNTER 3 Structure of a counter whose count values are of SINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_USCOUNTER 3 Structure of a counter whose count values are of USINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_COUNTER 6 Structure of a counter whose count values are of INT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_UCOUNTER 6 Structure of a counter whose count values are of UINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_DCOUNTER 12 Structure of a counter whose count values are of DINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_UDCOUNTER 12 Structure of a counter whose count values are of UDINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_LCOUNTER 24 Structure of a counter with count values of data type UDINT.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1119



System data type Length (bytes) Description
IEC_ULCOUNTER 24 Structure of a counter with count values of data type UINT.

This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

ERROR_STRUCT 28 Structure of an error information to a programming or I/O 
access error.
This data type is used, for example, for the "GET_ERROR" 
instruction.

CREF 8 Components of the ERROR_STRUCT data type, in which 
information about the address of a block is saved.

NREF 8 Components of the ERROR_STRUCT data type, in which 
information about the address of an operand is saved.

VREF 12 Is used for storage of a VARIANT pointer.
This data type is, for example, used for instructions from 
S7-1200 Motion Control.

STARTINFO 12 Specifies the data structure in which the start information is 
saved. 
This data type is used, for example, for the "RD_SINFO" 
instruction.

SSL_HEADER 4 Specifies the data structure in which information about the 
data records are saved during the reading of the system 
status lists. This data type is used, for example, for the 
"RDSYSST" instruction.

CONDITIONS 52 User-defined data structure defining the conditions for start 
and end of a data reception.
This data type is used, for example, for the "RCV_CFG" 
instruction. 

TADDR_Param 8 Specifies the structure of a data block which stores 
descriptions of connections for Open User Communication 
via UDP.
This data type is used for the "TUSEND" and "TURSV" 
instructions, for example.

TCON_Param 64 Specifies the structure of a data block which stores 
descriptions of connections for Open User Communication 
via Industrial Ethernet (PROFINET).
This data type is used for the "TSEND" and "TRSV" 
instructions, for example.

See also
Overview of the valid data types (Page 1077)
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Hardware data types

Hardware data types

Description
The hardware data types are made available by the CPU. The number of available hardware 
data types depends on the CPU.

Constants of a specific hardware data type are stored based on the modules set in the 
hardware configuration. When an instruction for controlling or activating a configured module 
is inserted in the user program, the available constants can be used for the parameters.

The following table shows the available hardware data types and their purpose:

Data type Basic data type Description
REMOTE ANY Serves to specify the address of a remote CPU

This data type is used, for example, for the "PUT" and 
"GET" instructions.

GEOADDR HW_IOSYSTEM Geographical address information
HW_ANY WORD Identification of any hardware component, e.g. a 

module
HW_DEVICE HW_ANY Identification of a DP slave/PROFINET IO device
HW_DPMASTER HW_INTERFACE Identification of a DP master
HW_DPSLAVE HW_DEVICE Identification of a DP slave
HW_IO HW_ANY Identification number of the CPU or the interface

The number is automatically allocated and is stored 
in the properties of the CPU or of the interface in the 
hardware configuration.

HW_IOSYSTEM HW_ANY Identification of a PN/IO system or DP master system
HW_SUBMODULE HW_IO Identification of a central hardware component
HW_MODULE HW_IO Identification of a module
HW_INTERFACE HW_SUBMODULE Identification of an interface component
HW_IEPORT HW_SUBMODULE Identification of a port (PN/IO)
HW_HSC HW_SUBMODULE Identification of a high-speed counter

This data type is used, for example, for the 
"CTRL_HSC" instruction.

HW_PWM HW_SUBMODULE Identification of a pulse width modulation
This data type is used, for example, for the 
"CTRL_PWM" instruction.

HW_PTO HW_SUBMODULE Identification of a pulse encoder
This data type is used for Motion Control

AOM_AID DWORD Is used only in connection with a system function 
block.

AOM_IDENT DWORD Identification of an object in the runtime system of the 
AS

EVENT_ANY AOM_IDENT Used to identify any event
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Data type Basic data type Description
EVENT_ATT EVENT_ANY Is used to specify an event that can be assigned 

dynamically to an OB
This data type is used, for example, for the "ATTACH" 
and "DETACH" instructions.

EVENT_HWINT EVENT_ATT Is used to specify a hardware interrupt event.
OB_ANY INT Serves to specify any organization block.
OB_DELAY OB_ANY Used to specify an organization block that is called 

when a time-delay interrupt occurs.
This data type is used, for example, for the 
"SRT_DINT" and "CAN_DINT" instructions.

OB_TOD OB_ANY Specifies the number of a time-of-day interrupt OB.
This data type is used, for example, for the 
"SET_TINT", "CAN_TINT", "ACT_TINT" and 
"QRY_TINT" instructions.

OB_CYCLIC OB_ANY Is used to specify an organization block that is called 
when a watchdog interrupt occurs.

OB_ATT OB_ANY Is used to specify an organization block that can be 
assigned dynamically to an event.
This data type is used, for example, for the "ATTACH" 
and "DETACH" instructions.

OB_PCYCLE OB_ANY Is used to specify an organization block that can be 
assigned to an event of the "Cyclic program" event 
class.

OB_HWINT OB_ATT Is used to specify an organization block that is called 
when a hardware interrupt occurs.

OB_DIAG OB_ANY Is used to specify an organization block that is called 
when a diagnostic interrupt occurs.

OB_TIMEERROR OB_ANY Is used to specify an organization block that is called 
when a time error occurs.

OB_STARTUP OB_ANY Is used to specify an organization block that is called 
when a startup event occurs.

PORT HW_SUBMODULE Serves to specify a communication port.
This data type is used for point-to-point 
communication.

RTM UINT Serves to specify the number of an operating hours 
counter.
This data type is used, for example, for the "RTM" 
instruction.

PIP UINT Is used to create and connect a "Synchronous Cycle" 
OB. This data type is used for the SFCs 26, 27, 126 
and 127.

CONN_ANY WORD Serves to specify any connection.
CONN_PRG CONN_ANY Serves to specify a connection for open 

communication over UDP.
CONN_OUC CONN_ANY Used to specify a connection for open communication 

over Industrial Ethernet (PROFINET).
CONN_R_ID DWORD Data type for the R_ID parameter on the S7 

communication blocks.
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Data type Basic data type Description
DB_ANY UINT Identification (number) of any DB

The data type "DB_ANY" has the length 0 in the 
section "Temp".

DB_WWW DB_ANY Number of a DB generated via the Web application 
(for example, "WWW" instruction)
The data type "DB_WWW" has the length 0 in the 
section "Temp".

See also
Overview of the valid data types (Page 1077)

Data type conversion

Data type conversion

Overview of data type conversion

Introduction
If you link several operands in an instruction, you must make sure that the data types are 
compatible. This applies also for assignments or for supplying block parameters. If the 
operands are not the same data type, a conversion has to be carried out. 

There are two options for the conversion:

● Implicit conversion
The conversion take place automatically when the instruction is executed.

● Explicit conversion
You use an explicit conversion instruction before the actual instruction is executed.

 

 Note

The data type conversion options described always refer to the latest version of the CPU (V.
4) Conversions marked as possible may not be available in CPU versions 1 - 3.

 

 Note
Converting bit strings in SCL

All bit strings (BYTE, WORD, DWORD and LWORD) are handled like the corresponding 
unsigned integers (USINT, UINT, UDINT and ULINT) in expressions. Therefore, implicit 
conversion from DWORD to REAL is carried out like a conversion from UDINT to REAL, for 
example.
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Implicit conversion
An implicit conversion is executed automatically if the data types of the operands are 
compatible. This compatibility test can be carried out according to criteria that are more or less 
strict:

● With IEC check (default)
If IEC check is set, the following rules are applied:

– Implicit conversion of BOOL to other data types is not possible.

– Only the REAL, BYTE, WORD, DINT, INT, SINT, UDINT, UINT, USINT, TIME, DT, 
STRING and CHAR data types can be converted implicitly.

– The bit length of the source data type must not exceed the bit length of the target data 
type. An operand of data type WORD, for example, cannot be declared at a parameter 
at which data type BYTE is expected.

● Without IEC check
If IEC check is not set, the following rules are applied:

– Implicit conversion of BOOL to other data types is not possible.

– Only the REAL, LREAL, BYTE, WORD, DWORD, SINT, INT, DINT, USINT, UINT, 
UDINT, TIME, DTL, TOD, DATE, STRING and CHAR data types can be converted 
implicitly.

– The bit length of the source data type must not exceed the bit length of the target data 
type. An operand of data type DWORD, for example, cannot be declared at a parameter 
at which data type WORD is expected.

– The bit length of an operand entered in-out parameters InOut) must be the same as the 
programmed bit length for the parameter in question.

 

 Note
Implicit conversion without IEC check

The programming editor uses a gray rectangle to mark operands that are implicitly converted. 
The dark gray rectangle signals that an implicit conversion is possible without any accuracy 
loss, for example, if you convert the data type SINT to INT. A light gray rectangle signals that 
implicit conversion is possible, but errors could occur during runtime. If, for example, you are 
converting the data type DINT to INT and an overflow occurs, the enable output ENO is set 
to "0".

 

For more information about the setting of the IEC check and the implicit conversion, refer to 
"See also".

Explicit conversion
If the operands are not compatible and an implicit conversion is therefore not possible, you 
can use an explicit conversion instruction. You can find the conversion instructions in the 
"Instructions" task card.

A possible overflow is displayed at the ENO enable output. An overflow is created, for example, 
if the value of the source data type is greater than the value of the target data type.
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For more information about explicit conversion, refer to "See also".

The following figure shows an example in which an explicit data type conversion must be 
carried out:

The "Block" function block expects a tag of the INT data type at the "IN_INT" input parameter. 
Therefore, the value of the "IN_DINT" tag must first be converted from DINT to INT. If the value 
of the "IN_DINT" tag is within the permitted value range of the INT data type, the conversion 
takes place. Otherwise, an overflow is signaled. A conversion still takes place even in case of 
an overflow, but the values are cut off and the enable output ENO is set to "0".

See also
Setting and canceling the IEC check (Page 1125)

Implicit conversion

Setting and canceling the IEC check
The data types of the operands used are check for compatibility. This compatibility test can 
be carried out according to criteria that are more or less strict. If "IEC check" is activated, stricter 
criteria are applied. 

You can set the IEC check centrally for all new blocks of the project or for individual blocks.

Setting IEC check for new blocks   
To set the IEC check for all new blocks in the project, proceed as follows:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "PLC programming > General" group in the area navigation.

3. Select or clear the "IEC check" check box in the "Default settings for new blocks" group.
The IEC check is enabled or disabled for all new blocks in the program.

Setting IEC check for a block
To set the IEC check for a block, proceed as follows:

1. Open the block.

2. Open the "Properties" tab in the Inspector window.
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3. Select the "Attributes" group in the area navigation.

4. Select or clear the "IEC check" check box.
The IEC check is enabled or disabled for this block. The setting is stored together with the 
project.

Binary numbers

Implicit conversion of BOOL

Options for implicit conversion         
The implicit conversion of the BOOL data type is not possible.

See also
BOOL (bit) (Page 1081)

Bit strings

Implicit conversion of BYTE

Options for implicit conversion         
The following table shows the options for implicit conversion of the BYTE data type:

Source Target With
IEC check

Without
IEC check

Description

BYTE BOOL - - No implicit conversion
WORD x x The bit pattern of the source value is transferred unchanged right-

justified to the target data type.DWORD x x
SINT - x
USINT - x
INT - x
UINT - x
DINT - x
UDINT - x
REAL - - No implicit conversion
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - -
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Source Target With
IEC check

Without
IEC check

Description

STRING - -
CHAR - x The bit pattern of the source value is transferred unchanged to the 

target data type.
x: Conversion possible
-: Conversion not possible

See also
BYTE (byte) (Page 1082)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of BYTE (Page 1143)

Implicit conversion of WORD

Options for implicit conversion         
The following table shows the options for implicit conversion of the WORD data type:

Source Target With
IEC check

Without
IEC check

Description

WORD BOOL - - No implicit conversion
BYTE - X The least significant byte is transferred to the target data type, while 

the most significant byte is ignored.
DWORD X X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
SINT - X The least significant byte is transferred to the target data type, while 

the most significant byte is ignored.
USINT - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.INT - X
UINT - X
DINT - X
UDINT - X
REAL - - No implicit conversion
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - X The bit pattern of the source value is transferred unchanged to the 

target data type.
STRING - - No implicit conversion
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Source Target With
IEC check

Without
IEC check

Description

CHAR - X The bit pattern of the source value is transferred unchanged to the 
target data type.

x: Conversion possible
-: Conversion not possible

See also
WORD (Page 1083)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of WORD (Page 1144)

Implicit conversion of DWORD

Options for implicit conversion         
The following table shows the options for implicit conversion of the DWORD data type:

Source Target With
IEC check

Without
IEC check

Description

DWORD BOOL - - No implicit conversion
BYTE - X The right bytes are transferred to the target data type; the left bytes 

are ignored.WORD - X
SINT - X
USINT - X
INT - X
UINT - X
DINT - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.UDINT - X
REAL - X The value is converted to the format of the target data type. (The 

value "-1", for example, is converted to the value "-1.0".)
LREAL - - No implicit conversion
TIME - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
DTL - - No implicit conversion
TOD - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
DATE - - No implicit conversion
STRING - -
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Source Target With
IEC check

Without
IEC check

Description

CHAR - X The bit pattern of the source value is transferred unchanged right-
justified to the target data type.

x: Conversion possible
-: Conversion not possible

See also
DWORD (Page 1083)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of DWORD (Page 1146)

Integers

Implicit conversion of SINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the SINT data type:

Source Target With
IEC check

Without
IEC check

Description

SINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type. The remaining bits are filled with "0".WORD - X
DWORD - X
USINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value transfer from SINT #-1 -> 
INT #-1, not filled with "0".)

INT X X
UINT - X
DINT X X
UDINT - X
REAL X X The value is converted to the format of the target data type. (The 

value "-1", for example, is converted to the value "-1.0".)LREAL X X
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - -
STRING - -
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Source Target With
IEC check

Without
IEC check

Description

CHAR - X The bit pattern of the source value is transferred unchanged right-
justified to the target data type.

x: Conversion possible
-: Conversion not possible

See also
SINT (8-bit integers) (Page 1085)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of SINT (Page 1148)

Implicit conversion of USINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the USINT data type:

Source Target With
IEC check

Without
IEC check

Description

USINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type. The remaining bits are filled with "0".WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from USINT #10 
-> DINT #10 or USINT #128 -> SINT #-128)

INT X X
UINT X X
DINT X X
UDINT X X
REAL X X The value is converted to the format of the target data type. (The 

value "1", for example, is converted to the value "1.0".)LREAL X X
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible
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See also
USINT (8-bit integers) (Page 1086)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of USINT (Page 1150)

Implicit conversion of INT

Options for implicit conversion         
The following table shows the options for implicit conversion of the INT data type:

Source Target With
IEC check

Without
IEC check

Description

INT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from INT #-1 -> 
SINT #-1, or INT #-32 767 -> UINT #32 769)

USINT - X
UINT - X
DINT X X
UDINT - X
REAL X X The value is converted to the format of the target data type. (The 

value "-1", for example, is converted to the value "-1.0".)LREAL X X
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
STRING - - No implicit conversion
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
INT (16-bit integers) (Page 1087)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of INT (Page 1151)
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Implicit conversion of UINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the UINT data type:

Source Target With
IEC check

Without
IEC check

Description

UINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from UINT #100 
-> DINT #100 or UINT #60 000 -> INT #-5536)

USINT - X
INT - X
DINT X X
UDINT X X
REAL X X The value is converted to the format of the target data type. (The 

value "1", for example, is converted to the value "1.0".)LREAL X X
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
STRING - - No implicit conversion
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
UINT (16-bit integers) (Page 1088)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of UINT (Page 1153)

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1132 System Manual, 07/2013,  



Implicit conversion of DINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the DINT data type:

Source Target With
IEC check

Without
IEC check

Description

DINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from DINT #-1 
-> SINT #-1 or DINT #-1 -> USINT #255)

USINT - X
INT - X
UINT - X
UDINT - X
REAL - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from DINT #-1 
-> REAL #-1.0, but there is a loss in accuracy for numbers with an 
absolute value greater than 8 388 608)

LREAL X X The value is converted to the format of the target data type. (The 
value "-1", for example, is converted to the value "-1.0".)

TIME - X The bit pattern of the source value is transferred unchanged right-
justified to the target data type.

DTL - - No implicit conversion
TOD - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
DATE - - No implicit conversion
STRING - -
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
DINT (32-bit integers) (Page 1089)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of DINT (Page 1155)

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1133



Implicit conversion of UDINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the UDINT data type:

Source Target With
IEC check

Without
IEC check

Description

UDINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from DINT #-1 
-> SINT #-1 or DINT #-1 -> USINT #255)

USINT - X
INT - X
UINT - X
DINT - X
REAL - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from DINT #-1 
-> REAL #-1.0, but there is a loss in accuracy for numbers with an 
absolute value greater than 8 388 608)

LREAL X X The value is converted to the format of the target data type. (The 
value "1", for example, is converted to the value "1.0".)

TIME - X The bit pattern of the source value is transferred unchanged right-
justified to the target data type.

DTL - - No implicit conversion
TOD - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
DATE - - No implicit conversion
STRING - -
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
UDINT (32-bit integers) (Page 1089)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of UDINT (Page 1157)
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Floating-point numbers

Implicit conversion of REAL

Options for implicit conversion         
The following table shows the options for implicit conversion of the REAL data type:

Source Target With
IEC check

Without
IEC check

Description

REAL BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
SINT - X The bit pattern of the source value is rounded off and converted and 

transferred to the target data type. (for example, rounding off and 
value conversion of REAL #2.5 -> INT #2 or negative number REAL 
#-2.5 -> INT #-2 -> USINT #254. With an overflow, the remainder is 
determined REAL #305.5 -> INT #306 -> USINT #50)

USINT - X
INT - X
UINT - X
DINT - X
UDINT - X
LREAL X X The value  is transferred to the target data type.
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
REAL (Page 1093)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of REAL (Page 1158)
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Implicit conversion of LREAL

Options for implicit conversion
The following table shows the options for implicit conversion of the LREAL data type:

Source Target With
IEC check

Without
IEC check

Explanation

LREAL BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - -
SINT - X The bit pattern of the source value is rounded off and converted and 

transferred to the target data type. (for example, rounding off and 
value conversion of REAL #2.5 -> INT #2 or negative number REAL 
#-2.5 -> INT #-2 -> USINT #254. With an overflow, the remainder is 
determined REAL #305.5 -> INT #306 -> USINT #50)

USINT - X
INT - X
UINT - X
DINT - X
UDINT - X
REAL - - No implicit conversion
TIME - -
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
Explicit conversion of LREAL (Page 1160)
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Timers

Implicit conversion of TIME

Options for implicit conversion         
The following table shows the options for implicit conversion of the TIME data type:

Source Target With
IEC check

Without
IEC check

Description

TIME BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion shows the duration in 
milliseconds.

SINT - - No implicit conversion
USINT - -
INT - -
UINT - -
DINT - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion shows the duration in 
milliseconds.

UDINT - X

REAL - - No implicit conversion
LREAL - -
DTL - -
TOD - X The bit pattern of a source value that is less than 24 h (86 400 00 

ms) is transferred without changes to the target data type. No further 
changes are made to the target value. The result of the conversion 
shows the time that has passed since midnight.

DATE - - No implicit conversion
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
TIME (IEC time) (Page 1098)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of TIME (Page 1161)
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Date and time

Implicit conversion of DTL

Options for implicit conversion         
The DTL data type cannot be implicitly converted.

See also
Explicit conversion of DTL (Page 1164)

Implicit conversion of TOD

Options for implicit conversion         
The following table shows the options for implicit conversion of the TOD data type:

Source Target With
IEC check

Without
IEC check

Description

TOD BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of milliseconds since the start of day (0:00 hrs).

SINT - - No implicit conversion
USINT - -
INT - -
UINT - -
DINT - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of milliseconds since the start of day (0:00 hrs).

UDINT - X

REAL - - No implicit conversion
LREAL - -
TIME - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of milliseconds since the start of day (0:00 hrs).

DTL - - No implicit conversion
DATE - -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible
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See also
TIME_OF_DAY (TOD) (Page 1099)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of TOD (Page 1163)

Implicit conversion of DATE

Options for implicit conversion         
The following table shows the options for implicit conversion of the DATE data type:

Source Target With
IEC check

Without
IEC check

Description

DATE BOOL - - No implicit conversion
BYTE - -
WORD - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of days since 01-01-1990.

DWORD - - No implicit conversion
SINT - -
USINT - -
INT - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of days since 01-01-1990.

UINT - X

DINT - - No implicit conversion
UDINT - -
REAL - -
LREAL - -
TIME - -
DTL - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of days since 01-01-1990.

TOD - - No implicit conversion
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible
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See also
DATE (Page 1099)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of DATE (Page 1162)

Character strings

Implicit conversion of CHAR

Options for implicit conversion         
The following table shows the options for implicit conversion of the CHAR data type:

Source Target With
IEC check

Without
IEC check

Description

CHAR BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type. The remaining bits are filled from the 
left with "0".

WORD - X
DWORD - X
SINT - X
USINT - X
INT - X
UINT - X
DINT - X
UDINT - X
REAL - - No implicit conversion
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - -
STRING X X The STRING is shortened to length 1 and includes the character.

x: Conversion possible
-: Conversion not possible
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See also
CHAR (character) (Page 1103)

Setting and canceling the IEC check (Page 1125)

Overview of data type conversion (Page 1123)

Explicit conversion of CHAR (Page 1165)

Implicit conversion of STRING

Options for implicit conversion         
The following table shows the options for implicit conversion of the STRING data type:

Source Target With
IEC check

Without
IEC check

Description

STRING BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - -
SINT - -
USINT - -
INT - -
UINT - -
DINT - -
UDINT - -
REAL - -
LREAL - -
TIME - -
DTL - -
DATE - -
TOD - -
CHAR - X The first character of the STRING is returned if the STRING includes 

one or more characters. Otherwise, the character is output with 
coding $00.

x: Conversion possible
-: Conversion not possible

See also
Explicit conversion of STRING (Page 1166)
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Explicit conversion

Binary numbers

Explicit conversion of BOOL

Options for explicit conversion           
The following table shows the options and instructions for the explicit conversion of the BOOL 
data type:

Source Target Conversion Description Mnemonics of the instruction
BOOL BYTE X Only the LSB (Least Significant Bit) 

is set in the target data type. The 
enable output ENO is always "1". 

BOOL_TO_BYTE
WORD X BOOL_TO_WORD
DWORD X BOOL_TO_DWORD
SINT X BOOL_TO_SINT
USINT X BOOL_TO_USINT
INT X BOOL_TO_INT
UINT X BOOL_TO_UINT
DINT X BOOL_TO_DINT
UDINT X BOOL_TO_UDINT
REAL - No explicit conversion -
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - -

x: Conversion possible
- : Conversion not possible

See also
BOOL (bit) (Page 1081)

Implicit conversion of BYTE (Page 1126)

Overview of data type conversion (Page 1123)
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Bit strings

Explicit conversion of BYTE

Options for explicit conversion
The following table shows the options and instructions for the explicit conversion of the BYTE 
data type:

Source Target Conversion Description Mnemonics of 
Instruction

BYTE1) BOOL X The following scenarios are possible:
● If the source is "0", the target data type 

is also "0" and enable output ENO is 
"1".

● If only the LSB (Least Significant Bit) 
"1" is set in the source value, the target 
data type is also "1" and enable output 
ENO is "1".

● If bits are not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output 
ENO is "0".

BYTE_TO_BOOL

WORD1) X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

BYTE_TO_WORD
DWORD1) X BYTE_TO_DWORD
SINT X BYTE_TO_SINT
USINT X BYTE_TO_USINT
INT X BYTE_TO_INT
UINT X BYTE_TO_UINT
DINT X BYTE_TO_DINT
UDINT X BYTE_TO_UDINT
REAL X BYTE_TO_REAL
LREAL X BYTE_TO_LREAL
TIME X BYTE_TO_TIME
DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

transferred unchanged right-justified to the 
target data type.

BYTE_TO_TOD
DATE X BYTE_TO_DATE

STRING - No explicit conversion -
CHAR X The bit pattern of the source value is 

transferred unchanged right-justified to the 
target data type.

BYTE_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) are interpreted as an unsigned integer with the same bit length.. Data type BYTE is 
interpreted as USINT, WORD as UINT and DWORD as UDINT.
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See also
BYTE (byte) (Page 1082)

Implicit conversion of BYTE (Page 1126)

Overview of data type conversion (Page 1123)

Explicit conversion of WORD

Options for explicit conversion
The following table shows the options and instructions for the explicit conversion of the WORD 
data type:

Source Target Conversion Description Mnemonics of the instruction
WORD1) BOOL X The following scenarios are possible:

● If the source is "0", the target data 
type is also "0" and enable output 
ENO is "1".

● If only the LSB (Least Significant Bit) 
"1" is set in the source value, the 
target data type is also "1" and 
enable output ENO is "1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output 
ENO is "0".

WORD_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to 
the target data type.

WORD_TO_BYTE
DWORD1) X WORD_TO_DWORD

SINT X ENO = TRUE
#sint1 := WORD_TO_SINT(16#FFFF); // 
-1 bis
#sint1 := WORD_TO_SINT(16#FF80); // 
-128
#sint1 := WORD_TO_SINT(16#0); // 0 
bis
#sint1 := WORD_TO_SINT(16#007F); // 
127
 
ENO = FALSE
#sint1 := WORD_TO_SINT(16#FF7F); // 
-129 bis
#sint1 := WORD_TO_SINT(16#8000); // 
-32768
#sint1 := WORD_TO_SINT(16#0080); // 
128 bis
#sint1 := WORD_TO_SINT(16#7FFF); // 
32767

WORD_TO_SINT
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Source Target Conversion Description Mnemonics of the instruction
USINT X The bit pattern of the source value is 

transferred unchanged right-justified to 
the target data type.

WORD_TO_USINT
INT X WORD_TO_INT
UINT X WORD_TO_UINT
DINT X WORD_TO_DINT
UDINT X WORD_TO_UDINT
REAL X WORD_TO_REAL
LREAL X WORD_TO_LREAL
TIME X WORD_TO_TIME
DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

transferred unchanged right-justified to 
the target data type.

WORD_TO_TOD
DATE X WORD_TO_DATE

STRING - No explicit conversion -
CHAR X The bit pattern of the source value is 

transferred unchanged right-justified to 
the target data type.

WORD_TO_CHAR

WORD_BCD16 INT X The value to be converted has data type 
WORD and is accepted as a BCD-coded 
value between -999 and +999. The 
result is available after conversion as an 
integer (in binary notation) of the type 
INT. A real conversion takes place. If the 
bit pattern includes an invalid tetrad, a 
synchronous error is not triggered but 
only the status bit OV is set instead.

WORD_BCD16_TO_INT
BCD16 INT X BCD16_TO_INT

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) are interpreted as an unsigned integer with the same bit length.. Data type BYTE is 
interpreted as USINT, WORD as UINT and DWORD as UDINT.

See also
WORD (Page 1083)

Implicit conversion of WORD (Page 1127)

Overview of data type conversion (Page 1123)

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1145



Explicit conversion of DWORD

Options for explicit conversion
The following table shows the options and instructions for the explicit conversion of the 
DWORD data type:

Source Target Conversion Description Mnemonics of the instruction
DWORD1) BOOL X The following scenarios are possible:

● If the source is "0", the target data 
type is also "0" and enable output 
ENO is "1".

● If only the LSB (Least Significant 
Bit) "1" is set in the source value, 
the target data type is also "1" and 
enable output ENO is "1".

● If bit is not equal to LSB in the 
source value, the target data type 
is set according to LSB and enable 
output ENO is "0".

DWORD_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified 
to the target data type.

DWORD_TO_BYTE
WORD1) X DWORD_TO_WORD

SINT X ENO = TRUE
#sint1 := 
DWORD_TO_SINT(16#FFFF_FFFF);
 // -1 bis
#sint1 := 
DWORD_TO_SINT(16#FFFF_FF80); 
// -128
#sint1 := DWORD_TO_SINT(16#0); // 
0 bis
#sint1 := 
DWORD_TO_SINT(16#0000_007F); /
/ 127
 
ENO = FALSE
#sint1 := 
DWORD_TO_SINT(16#FFFF_FF7F); 
// -129
#sint1 := 
DWORD_TO_SINT(16#8000_0000); /
/ -2147483648
#sint1 := 
DWORD_TO_SINT(16#0000_0080); /
/ 128 bis
#sint1 := 
DWORD_TO_SINT(16#7FFF_FFFF); 
// 2147483647

DWORD_TO_SINT

USINT X The bit pattern of the source value is 
transferred unchanged right-justified 
to the target data type.

DWORD_TO_USINT
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Source Target Conversion Description Mnemonics of the instruction
INT X ENO = TRUE

#int1 := 
DWORD_TO_INT(16#FFFF_FFFF); //
 -1 bis
#int1 := 
DWORD_TO_INT(16#FFFF_8000); // 
-32768
#int1 := DWORD_TO_INT(16#0); // 0 
bis
#int1 := 
DWORD_TO_INT(16#0000_7FFF); // 
32767
 
ENO = FALSE
#int1 := 
DWORD_TO_INT(16#FFFF_7FFF); //
 -32769
#int1 := 
DWORD_TO_INT(16#8000_0000); // 
-2147483648
#int1 := 
DWORD_TO_INT(16#8000); // 32768 
bis
#int1 := 
DWORD_TO_INT(16#7FFF_FFFF); //
 2147483647

DWORD_TO_INT

UINT X The bit pattern of the source value is 
transferred unchanged right-justified 
to the target data type.

DWORD_TO_UINT
DINT X DWORD_TO_DINT
UDINT X DWORD_TO_UDINT
REAL X The data type DWORD is converted 

to REAL. If no errors occur during the 
conversion, the signal state of ENO = 
1; if an error occurs during processing, 
the signal state of ENO = 0.

DWORD_TO_REAL

LREAL X The data type DWORD is converted 
to LREAL. If no errors occur during the 
conversion, the signal state of ENO = 
1; if an error occurs during processing, 
the signal state of ENO = 0.

DWORD_TO_LREAL

TIME X The bit pattern of the source value is 
transferred unchanged right-justified 
to the target data type.

DWORD_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

transferred unchanged right-justified 
to the target data type.

DWORD_TO_TOD
DATE X DWORD_TO_DATE

STRING - No explicit conversion -
CHAR X The bit pattern of the source value is 

transferred unchanged right-justified 
to the target data type.

DWORD_TO_CHAR
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Source Target Conversion Description Mnemonics of the instruction
DWORD_BCD32 DINT X The value to be converted has data 

type DWORD and is accepted as a 
BCD-coded value between -9999999 
and +9999999. The result is available 
after conversion as an integer (in 
binary notation) of the type DINT. A 
real conversion takes place. If the bit 
pattern includes an invalid tetrad, a 
synchronous error is not triggered but 
only the status bit OV is set instead.

DWORD_BCD32_TO_DINT
BCD32 DINT X BCD32_TO_DINT

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) are interpreted as an unsigned integer with the same bit length.. Data type BYTE is 
interpreted as USINT, WORD as UINT and DWORD as UDINT.

See also
DWORD (Page 1083)

Implicit conversion of DWORD (Page 1128)

Overview of data type conversion (Page 1123)

Integers

Explicit conversion of SINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the SINT data 
type:

Source Target Conversion Description Mnemonics of the 
instruction

SINT BOOL X The following scenarios are possible:
● If the source is "0", the target data type is also 

"0" and enable output ENO is "1".
● If only the LSB (Least Significant Bit) "1" is set 

in the source value, the target data type is also 
"1" and enable output ENO is "1".

● If bit is not equal to LSB in the source value, the 
target data type is set according to LSB and 
enable output ENO is "0".

SINT_TO_BOOL

BYTE1) X The bit pattern of the source value is transferred 
unchanged right-justified to the target data type. If a 
negative value is converted to an unsigned target 
data type, the enable output ENO is set to "0".

SINT_TO_BYTE
WORD1) X SINT_TO_WORD
DWORD1) X SINT_TO_DWORD
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Source Target Conversion Description Mnemonics of the 
instruction

USINT X The bit pattern of the source value is converted and 
transferred to the target data type. (The value "-1" 
(16#FF) becomes the value "-1" (16#FFFFFFFF). 
Enable output ENO is set to "0" if a negative value 
is converted to an unsigned target data type.

SINT_TO_USINT
INT X SINT_TO_INT
UINT X SINT_TO_UINT
DINT X SINT_TO_DINT
UDINT X SINT_TO_UDINT
REAL X The value is converted into the format of the target 

data type (the value "-1" will be converted into the 
value "-1.0" with the "Convert value" (CONVERT) 
instruction.

SINT_TO_REAL, 
NORM_X

LREAL X SINT_TO_LREAL, 
NORM_X

TIME X The value is transferred to the target data type and 
interpreted as milliseconds.

SINT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is converted and 

transferred to the target data type. (The value "-1" 
(16#FF) becomes the value "-1" (16#FFFFFFFF). 
Enable output ENO is set to "0" if a negative value 
is converted to an unsigned target data type. 
(interpretation in milliseconds since 0:0)

SINT_TO_TOD

DATE X The bit pattern of the source value is converted and 
transferred to the target data type. (The value "-1" 
(16#FF) becomes the value "-1" (16#FFFFFFFF). 
Enable output ENO is set to "0" if a negative value 
is converted to an unsigned target data type. 
(interpretation in days since 1990-1-1)

SINT_TO_DATE

STRING X The value is converted to a character string. The 
character string is shown preceded by a sign. If the 
permitted length of the character string is violated, 
the enable output ENO is set to "0". The string has 
a minimum length of 4 characters.

SINT_TO_STRING, 
S_CONV, VAL_STRG

CHAR1) X The bit pattern of the source value is transferred 
unchanged to the target data type. If negative values 
are converted, the enable output ENO is set to "0".

SINT_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width including sign, and 
then the bits are copied. The source type determines the interpretation.

See also
SINT (8-bit integers) (Page 1085)

Implicit conversion of SINT (Page 1129)

Overview of data type conversion (Page 1123)
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Explicit conversion of USINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the USINT 
data type:

Source Target Conversion Description Mnemonics of the instruction
USINT BOOL X The following scenarios are possible:

● If the source is "0", the target data type is 
also "0" and enable output ENO is "1".

● If only the LSB (Least Significant Bit) "1" 
is set in the source value, the target data 
type is also "1" and enable output ENO is 
"1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output ENO 
is "0".

USINT_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

USINT_TO_BYTE
WORD1) X USINT_TO_WORD
DWORD1) X USINT_TO_DWORD
SINT X The bit pattern of the source value is 

transferred unchanged to the target data 
type. If the sign is changed during the 
conversion, the enable output ENO is set to 
"0".

USINT_TO_SINT

INT X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

USINT_TO_INT
UINT X USINT_TO_UINT
DINT X USINT_TO_DINT
UDINT X USINT_TO_UDINT
REAL X The value is converted into the format of the 

target data type (the value "1" will be 
converted into the value "1.0" with the 
"Convert value" (CONVERT) instruction.

USINT_TO_REAL, NORM_X
LREAL X USINT_TO_LREAL, NORM_X

TIME X The value is transferred to the target data 
type and interpreted as milliseconds.

USINT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

transferred unchanged right-justified to the 
target data type.

USINT_TO_TOD
DATE X USINT_TO_DATE

STRING X The value is converted to a character string. 
If the permitted length of the character string 
is violated, the enable output ENO is set to 
"0". The string has a minimum length of 4 
characters.

USINT_TO_STRING, 
S_CONV, VAL_STRG
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Source Target Conversion Description Mnemonics of the instruction
CHAR1) X The bit pattern of the source value is 

transferred unchanged to the target data type.
USINT_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width (the non-existing sign 
is replaced with zeros) and then the bits are copied. The source type determines the interpretation.

See also
USINT (8-bit integers) (Page 1086)

Implicit conversion of USINT (Page 1130)

Overview of data type conversion (Page 1123)

Explicit conversion of INT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the INT data 
type:

Source Target Conversion Description Mnemonics of the 
instruction

INT BOOL X The following scenarios are possible:
● If the source is "0", the target data type is 

also "0" and enable output ENO is "1".
● If only the LSB (Least Significant Bit) "1" is 

set in the source value, the target data type 
is also "1" and enable output ENO is "1".

● If bit is not equal to LSB in the source value, 
the target data type is set according to LSB 
and enable output ENO is "0".

INT_TO_BOOL

BYTE1) X The bit pattern of the source value is transferred 
unchanged right-justified to the target data type. 
If a negative value is converted to an unsigned 
target data type, the enable output ENO is set 
to "0".

INT_TO_BYTE
WORD1) X INT_TO_WORD
DWORD1) X INT_TO_DWORD

SINT X The bit pattern of the source value is converted 
and transferred to the target data type. (The 
value "-1" (16#FF) becomes the value "-1" 
(16#FFFFFFFF). Enable output ENO is set to 
"0" if a negative value is converted to an 
unsigned target data type.

INT_TO_SINT
USINT X INT_TO_USINT
UINT X INT_TO_UINT
DINT X INT_TO_DINT
UDINT X INT_TO_UDINT
REAL X The value is converted to the format of the 

target data type (the value "1", for example, is 
converted with the instruction "Convert value" 
(CONVERT) to the value "-1").

INT_TO_REAL, NORM_X
LREAL X INT_TO_LREAL, NORM_X
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Source Target Conversion Description Mnemonics of the 
instruction

TIME X The value is transferred to the target data type 
and interpreted as milliseconds.

INT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is converted 

and transferred to the target data type. (The 
value "-1" (16#FF) becomes the value "-1" 
(16#FFFFFFFF). Enable output ENO is set to 
"0" if a negative value is converted to an 
unsigned target data type. (interpretation in 
milliseconds since 0:0; check for 24h limit)

INT_TO_TOD

DATE X The bit pattern of the source value is converted 
and transferred to the target data type. (The 
value "-1" (16#FF) becomes the value "-1" 
(16#FFFFFFFF). Enable output ENO is set to 
"0" if a negative value is converted to an 
unsigned target data type. (interpretation in 
days since 1990-1-1; check for negative value)

INT_TO_DATE

STRING X The value is converted to a character string. 
The character string is shown preceded by a 
sign. If the permitted length of the character 
string is violated, the enable output ENO is set 
to "0". The string has a minimum length of 6 
characters.

INT_TO_STRING, 
S_CONV, VAL_STRG)

CHAR1) X The bit pattern of the source value is converted 
and transferred to the target data type. (The 
value "-1" (16#FF) becomes the value "-1" 
(16#FFFFFFFF). Enable output ENO is set to 
"0" if a negative value is converted to an 
unsigned target data type.

INT_TO_CHAR

BCD16 X The value to be converted has type INT and is 
accepted as an integer with a value between 
-999 and +999. The result is available after 
conversion as a BCD-coded number of the type 
WORD. A real conversion takes place. If the 
value is outside the target area, a synchronous 
error is not triggered, but rather only the status 
bit OV is set.

INT_TO_BCD16
BCD16_WORD X INT_TO_BCD16_WORD

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width including sign, and 
then the bits are copied. The source type determines the interpretation.

See also
INT (16-bit integers) (Page 1087)

Implicit conversion of INT (Page 1131)

Overview of data type conversion (Page 1123)
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Explicit conversion of UINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the UINT data 
type:

Source Target Conversion Description Mnemonics of the instruction
UINT BOOL X The following scenarios are possible:

● If the source is "0", the target data type is 
also "0" and enable output ENO is "1".

● If only the LSB (Least Significant Bit) "1" 
is set in the source value, the target data 
type is also "1" and enable output ENO is 
"1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output ENO 
is "0".

UINT_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type. If bits are lost in the process, 
the enable output ENO is set to "0".

UINT_TO_BYTE
WORD1) X UINT_TO_WORD
DWORD1) X UINT_TO_DWORD
SINT X UINT_TO_SINT
USINT X UINT_TO_USINT
INT X The bit pattern of the source value is 

transferred unchanged to the target data 
type. If the sign bit is changed during the 
conversion, the enable output ENO is set to 
"0".

UINT_TO_INT

DINT X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

UINT_TO_DINT
UDINT X UINT_TO_UDINT

REAL X The value is converted to the format of the 
target data type (the value "1", for example, 
is converted with the instruction "Convert 
value" (CONVERT) to the value "1.0").

UINT_TO_REAL, NORM_X
LREAL X UINT_TO_LREAL, NORM_X

TIME X The value is transferred to the target data 
type and interpreted as milliseconds.

UINT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in milliseconds since 0:0; 
check for 24h limit)

UINT_TO_TOD
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Source Target Conversion Description Mnemonics of the instruction
DATE X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in days since 1990-1-1; check 
for negative value)

UINT_TO_DATE, T_CONV

STRING X The value is converted to a character string. 
If the permitted length of the character string 
is violated, the enable output ENO is set to 
"0". The string has a minimum length of 6 
characters.

UINT_TO_STRING, S_CONV, 
VAL_STRG

CHAR1) X The bit pattern of the source value is 
transferred unchanged to the target data 
type. The enable output ENO is set to "0" in 
the event of overflow.

UINT_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD, LWORD) and the data type CHAR are initially extended to the necessary width (the 
non-existing sign is replaced with zeros) and then the bits are copied. The source type determines the interpretation.

See also
UINT (16-bit integers) (Page 1088)

Implicit conversion of UINT (Page 1132)

Overview of data type conversion (Page 1123)
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Explicit conversion of DINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the DINT data 
type:

Source Target Conversio
n

Description Mnemonics of the instruction

DINT BOOL X The following scenarios are possible:
● If the source is "0", the target data type is 

also "0" and enable output ENO is "1".
● If only the LSB (Least Significant Bit) "1" 

is set in the source value, the target data 
type is also "1" and enable output ENO is 
"1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output ENO 
is "0".

DINT_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type. If a negative value is 
converted to an unsigned target data type, 
the enable output ENO is set to "0".

DINT_TO_BYTE
WORD1) X DINT_TO_WORD
DWORD1) X DINT_TO_DWORD

SINT X The bit pattern of the source value is 
converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type.

DINT_TO_SINT
USINT X DINT_TO_USINT
INT X DINT_TO_INT
UINT X DINT_TO_UINT
UDINT X DINT_TO_UDINT
REAL X The value is converted to the format of the 

target data type (the value "1", for example, 
is converted with the instruction "Convert 
value" (CONVERT) to the value "-1").

DINT_TO_REAL, NORM_X
LREAL X DINT_TO_LREAL, NORM_X

TIME X The value is transferred to the target data 
type and interpreted as milliseconds.

DINT_TO_TIME, T_CONV

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in milliseconds since 0:0)

DINT_TO_TOD
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Source Target Conversio
n

Description Mnemonics of the instruction

DATE X The bit pattern of the source value is 
converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in days since 1990-1-1)

DINT_TO_DATE

STRING X The value is converted to a character string. 
The character string is shown preceded by a 
sign. If the permitted length of the character 
string is violated, the enable output ENO is 
set to "0". The string has a minimum length 
of 11 characters.

DINT_TO_STRING, S_CONV, 
VAL_STRG

CHAR1) X The bit pattern of the source value is 
converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type.

DINT_TO_CHAR

BCD32 X The value to be converted has type DINT and 
is accepted as an integer with a value 
between –999999 and +9999999. The result 
is available after conversion as a BCD-coded 
number of the type DWORD. The enable 
output is set to "0" in the event of overflow. A 
real conversion takes place. If the value is 
outside the target area, a synchronous error 
is not triggered, but rather only the status bit 
OV is set.

DINT_TO_BCD32
BCD32_DWORD X DINT_TO_BCD32_DWORD

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width including sign, and 
then the bits are copied. The source type determines the interpretation.

See also
DINT (32-bit integers) (Page 1089)

Implicit conversion of DINT (Page 1133)

Overview of data type conversion (Page 1123)
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Explicit conversion of UDINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the UDINT 
data type:

Source Target Conversion Description Mnemonics of the instruction
UDINT BOOL X The following scenarios are possible:

● If the source is "0", the target data type is 
also "0" and enable output ENO is "1".

● If only the LSB (Least Significant Bit) "1" 
is set in the source value, the target data 
type is also "1" and enable output ENO is 
"1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output ENO 
is "0".

UDINT_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged to the target data 
type. Enable output ENO is set to "0" if bits 
are lost in the process.

UDINT_TO_BYTE
WORD1) X UDINT_TO_WORD
DWORD1) X UDINT_TO_DWORD
SINT X UDINT_TO_SINT
USINT X UDINT_TO_USINT
INT X UDINT_TO_INT
UINT X UDINT_TO_UINT
DINT X The bit pattern of the source value is 

transferred unchanged to the target data 
type. If the sign bit is changed during the 
conversion, the enable output ENO is set to 
"0".

UDINT_TO_DINT

REAL X The value is converted to the format of the 
target data type (the value "1", for example, 
is converted with the instruction "Convert 
value" (CONVERT) to the value "1.0").

UDINT_TO_REAL, NORM_X
LREAL X UDINT_TO_LREAL, NORM_X

TIME X The bit pattern of the source value is 
transferred unchanged right-justified and 
interpreted as milliseconds to the target data 
type.

UDINT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in milliseconds since 0:0; 
check for 24h limit)

UDINT_TO_TOD, T_CONV
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Source Target Conversion Description Mnemonics of the instruction
DATE X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in days since 1990-1-1; check 
for negative value)

UDINT_TO_DATE

STRING X The value is converted to a character string. 
If the permitted length of the character string 
is violated, the enable output ENO is set to 
"0". The string has a minimum length of 11 
characters.

UDINT_TO_STRING, 
S_CONV, VAL_STRG

CHAR1) X The bit pattern of the source value is 
transferred unchanged to the target data 
type. The enable output is set to "0" in the 
event of overflow.

UDINT_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD, LWORD) and the data type CHAR are initially extended to the necessary width (the 
non-existing sign is replaced with zeros) and then the bits are copied. The source type determines the interpretation.

See also
UDINT (32-bit integers) (Page 1089)

Implicit conversion of UDINT (Page 1134)

Overview of data type conversion (Page 1123)

Floating-point numbers

Explicit conversion of REAL

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the REAL data 
type:

Source Target Conversion Description Mnemonics of the instruction
REAL BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value is 
transferred unchanged to the target data type.

REAL_TO_BYTE
WORD1) X REAL_TO_WORD
DWORD1) X REAL_TO_DWORD
SINT X The value is converted to the target data type. 

The result of the conversion depends on the 
instruction used. Enable output ENO is set to 
"0" if the valid range of values of the target 

REAL_TO_SINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X
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Source Target Conversion Description Mnemonics of the instruction
USINT data type is exceeded during conversion, or 

if the value to be converted is an invalid 
floating-point number.

X REAL_TO_USINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

INT X REAL_TO_INT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

UINT X REAL_TO_UINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

DINT X REAL_TO_DINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

UDINT X REAL_TO_UDINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

LREAL X The value is converted to the target data type. 
The result of the conversion depends on the 
instruction used, e.g. TRUNC(2.5) = 2.0; 
CEIL(2.5) = 3.0

REAL_TO_LREAL, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

TIME - No explicit conversion -
DTL - -
TOD - -
DATE - -
STRING X The value is converted to a character string. 

Enable output ENO is set to "0" if the 
character string length is exceeded, or if the 
value to be converted is an invalid floating-
point number. The string has a minimum 
length of 14 characters.

REAL_TO_STRING, 
S_CONV, VAL_STRG

CHAR - No explicit conversion -
x: Conversion possible
-: Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width and then the bits are 
copied. The source type determines the interpretation.

See also
REAL (Page 1093)

Implicit conversion of REAL (Page 1135)

Overview of data type conversion (Page 1123)
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Explicit conversion of LREAL

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the LREAL 
data type:

Source Target Conversion Description Mnemonics of the instruction
LREAL BOOL - No explicit conversion -

BYTE X The bit pattern of the source value is 
transferred unchanged right-justified to 
the target data type.

LREAL_TO_BYTE
WORD X LREAL_TO_WORD
DWORD X LREAL_TO_DWORD
SINT X The value is converted to the target data 

type. The result of the conversion 
depends on the instruction used. Enable 
output ENO is set to "0" if the valid range 
of values of the target data type is 
exceeded during conversion, or if the 
value to be converted is an invalid 
floating-point number.

LREAL_TO_SINT, ROUND, CEIL, 
FLOOR, TRUNC, NORM_X, 
SCALE_X

USINT X LREAL_TO_USINT, ROUND, 
CEIL, FLOOR, TRUNC, NORM_X, 
SCALE_X

INT X LREAL_TO_INT, ROUND, CEIL, 
FLOOR, TRUNC, NORM_X, 
SCALE_X

UINT X LREAL_TO_UINT, ROUND, CEIL, 
FLOOR, TRUNC, NORM_X, 
SCALE_X

DINT X LREAL_TO_DINT, ROUND, CEIL, 
FLOOR, TRUNC, NORM_X, 
SCALE_X

UDINT X LREAL_TO_UDINT, ROUND, 
CEIL, FLOOR, TRUNC, NORM_X, 
SCALE_X

REAL X The value is converted to the target data 
type. Enable output ENO is set to "0" if 
the valid range of values of the target 
data type is exceeded during 
conversion, or if the value to be 
converted is an invalid floating-point 
number. A loss in accuracy is tolerated.

LREAL_TO_LREAL, ROUND, 
CEIL, FLOOR, TRUNC, NORM_X, 
SCALE_X

TIME - No explicit conversion -
DTL - -
TOD - -
DATE - -
STRING X The value is converted to a character 

string. Enable output ENO is set to "0" if 
the character string length is exceeded, 
or if the value to be converted is an 
invalid floating-point number. The string 
has a minimum length of 21 characters.

REAL_TO_STRING, S_CONV, 
VAL_STRG
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Source Target Conversion Description Mnemonics of the instruction
CHAR - No explicit conversion -

x: Conversion possible
-: Conversion not possible

See also
LREAL (Page 1094)

Overview of data type conversion (Page 1123)

Timers

Explicit conversion of TIME

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the TIME data 
type:

Source Target Conversion Description Mnemonics of the instruction
TIME BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value is 
transferred unchanged to the target data type.

TIME_TO_BYTE
WORD1) X TIME_TO_WORD
DWORD1

)
X TIME_TO_DWORD

SINT X The bit pattern of the source value is 
transferred unchanged right-justified and 
interpreted as milliseconds to the target data 
type.

TIME_TO_SINT
USINT X TIME_TO_USINT
INT X TIME_TO_INT
UINT X TIME_TO_UINT
DINT X The bit pattern of the source value is 

transferred unchanged to the target data type. 
The result of the conversion shows the 
duration in milliseconds. 

TIME_TO_DINT, T_CONV

UDINT X The bit pattern of the source value is 
transferred unchanged right-justified and 
interpreted as milliseconds to the target data 
type. Enable output ENO is set to "0" if the sign 
changes.

TIME_TO_UDINT

REAL - No explicit conversion -
LREAL - -
DTL - -
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Source Target Conversion Description Mnemonics of the instruction
TOD X The bit pattern of the source value is 

transferred unchanged right-justified to the 
target data type. If the source value exceeds 
the range of values of TOD, the target data 
type remains unchanged.

TIME_TO_TOD

DATE - No explicit conversion -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width and then the bits are 
copied. The source type determines the interpretation.

See also
TIME (IEC time) (Page 1098)

Implicit conversion of TIME (Page 1137)

Overview of data type conversion (Page 1123)

Clock and calendar

Explicit conversion of DATE

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the DATE data 
type:

Source Target Conversion Description Mnemonics of the instruction
DATE BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value 
is transferred unchanged right-
justified to the target data type.

DATE_TO_BYTE
WORD1) X DATE_TO_WORD
DWORD1) X DATE_TO_DWORD
SINT X The number of days since 1/1/1990 

is returned as result.
DATE_TO_SINT

USINT X DATE_TO_USINT
INT X DATE_TO_INT
UINT X DATE_TO_UINT
DINT X DATE_TO_DINT
UDINT X DATE_TO_UDINT
REAL - No explicit conversion -
LREAL - -
TIME - -
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Source Target Conversion Description Mnemonics of the instruction
DTL X The bit pattern of the source value 

is transferred unchanged right-
justified to the target data type.

DATE_TO_DTL

TOD - No explicit conversion -
STRING - -
CHAR - -

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width and then the bits are 
copied. The source type determines the interpretation.

See also
DATE (Page 1099)

Implicit conversion of DATE (Page 1139)

Overview of data type conversion (Page 1123)

Explicit conversion of TOD

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the TOD data 
type:

Source Target Conversion Description Mnemonics of the instruction
TOD BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value 
is transferred unchanged to the 
target data type.

TOD_TO_BYTE
WORD1) X TOD_TO_WORD
DWORD1) X TOD_TO_DWORD
SINT X The number of milliseconds since 

midnight is returned as result.
TOD_TO_SINT

USINT X TOD_TO_USINT
INT X TOD_TO_INT
UINT X TOD_TO_UINT
DINT X TOD_TO_DINT
UDINT X The result of the conversion 

corresponds to the number of 
milliseconds since the start of day 
(0:00 hrs).

TOD_TO_UDINT, T_CONV

REAL - No explicit conversion -
LREAL - -
TIME X The duration since midnight is 

returned as result.
TOD_TO_TIME

DTL X The date is set to 1.1.1970 as a 
result.

TOD_TO_DTL
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Source Target Conversion Description Mnemonics of the instruction
DATE - No explicit conversion -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width including the sign and 
then the bits are copied. The source type determines the interpretation.

See also
TIME_OF_DAY (TOD) (Page 1099)

Implicit conversion of TOD (Page 1138)

Overview of data type conversion (Page 1123)

Explicit conversion of DTL

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the DTL data 
type:

Source Target Conversion Description Mnemonics of the instruction
DTL BYTE - No explicit conversion -

WORD - -
DWORD - -
SINT - -
USINT - -
INT - -
UINT - -
DINT - -
UDINT - -
REAL - -
LREAL - -
TIME - -
TOD X During the conversion, the time-of-day is 

extracted from the DTL format and written 
to the target data type.

DTL_TO_TOD, T_CONV

DATE X During the conversion, the date is 
extracted from the DTL format and written 
to the target data type. The enable output 
ENO is set to "0" in the event of overflow.

DTL_TO_DATE, T_CONV

STRING - No explicit conversion -
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Source Target Conversion Description Mnemonics of the instruction
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
DTL (Page 1102)

Overview of data type conversion (Page 1123)

Character strings

Explicit conversion of CHAR

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the CHAR data 
type:

Source Target Conversion Description Mnemonics of the instruction
CHAR BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to 
the target data type.

CHAR_TO_BYTE
WORD1) X CHAR_TO_WORD
DWORD1) X CHAR_TO_DWORD
SINT X CHAR_TO_SINT
USINT X CHAR_TO_USINT
INT X CHAR_TO_INT
UINT X CHAR_TO_UINT
DINT X CHAR_TO_DINT
UDINT X CHAR_TO_UDINT
REAL - No explicit conversion -
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - -
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Source Target Conversion Description Mnemonics of the instruction
STRING X The value is converted to the first 

character in the character string 
(STRING). If the length of the character 
string is not defined, the length "1" is set 
after the conversion. If the length of the 
character string is defined, this remains 
unchanged after the conversion.

CHAR_TO_STRING

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width and then the bits are 
copied. The source type determines the interpretation.

See also
CHAR (character) (Page 1103)

Implicit conversion of CHAR (Page 1140)

Overview of data type conversion (Page 1123)

Explicit conversion of STRING

Options for explicit conversion
The following table shows the options and instructions for explicit conversion of the STRING 
data type:

Source Target Conversion Description Mnemonics of the instruction
STRING BOOL - No explicit conversion -

BYTE - -
WORD - -
DWORD - -
SINT X Conversion begins with the first character in 

the character string (STRING) and stops at 
the end of the string or at the first inadmissible 
character. The following characters are 
permitted for conversion:
● Digit
● Sign
● Dot
The first character of the string may be a sign 
(+, -) or a number. Leading spaces will be 
ignored. The dot is used as separation for the 
conversion of floating-point numbers. The 
exponential notation "e" or "E" is not 
permitted. The comma as thousand 
separator is permitted to the left of the 
decimal point but will be ignored. If the layout 
of the character string is invalid for the 

STRING_TO_SINT, 
S_CONV, STRG_VAL

USINT X STRING_TO_USINT, 
S_CONV, STRG_VAL

INT X STRING_TO_INT, S_CONV, 
STRG_VAL

UINT X STRING_TO_UINT, 
S_CONV, STRG_VAL

DINT X STRING_TO_DINT, 
S_CONV, STRG_VAL

UDINT X STRING_TO_UDINT, 
S_CONV, STRG_VAL

REAL X STRING_TO_REAL, 
S_CONV, STRG_VAL
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Source Target Conversion Description Mnemonics of the instruction
LREAL X conversion or an overflow occurs, then the 

enable output ENO will be set to "0".
STRING_TO_LREAL, 
S_CONV, STRG_VAL

TIME - No explicit conversion -
DTL - -
TOD - -
DATE - -
CHAR1) X The first character in the character string 

(STRING) is transferred to the destination 
data type. If the string is empty, then the value 
"0" will be written in the destination data type.

STRING_TO_CHAR, 
S_CONV

x: Conversion possible
- : Conversion not possible

See also
STRING (Page 1103)

Overview of data type conversion (Page 1123)

9.1.1.6 Program flow control

EN/ENO mechanism

Basics of the EN/ENO mechanism

Introduction   
Runtime errors that require a program abort can occur during the processing of instructions. 
You can use the EN/ENO mechanism to avoid such program aborts. This mechanism can be 
used at two levels:

● EN/ENO mechanism for individual instructions

● EN/ENO mechanism for block calls

EN/ENO mechanism for instructions in LAD/FBD
In LAD and FBD, certain instructions have an enable input EN and an enable output ENO. 

You can use the enable input EN to make the execution of the instruction dependent on 
conditions. The instructions are only executed if the signal state is "1" at the enable input EN. 

You can use the enable output ENO to query runtime errors in instructions and react to these.

The enable output ENO returns the signal state "1" if one of the following conditions applies:

● No error occurred during processing.

The enable output ENO returns signal state "0" if one of the following conditions applies:
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● The EN input has signal state "0".

● An error occurred during processing.

The EN/ENO mechanism is used for the following basic instructions:

● Mathematical functions

● Move operations

● Conversion operations

● Word logic operations

● Shift + rotate

In LAD and FBD, you can switch the evaluation of the enable output ENO on and off by means 
of the shortcut menu specifically for certain instructions.

EN/ENO mechanism for block calls in LAD/FBD
All blocks that you call in LAD or FBD are provided with an enable input EN and an enable 
output ENO when called. This applies to all called blocks, regardless of the programming 
language in which they were created.

You can use the enable input EN to call the block depending on conditions. The block is only 
executed if the signal state is "1" at the enable input EN. 

You can query the error status of the block with the enable output ENO. It has signal "1" as 
soon as the execution of the block starts. If you do not explicitly set the output ENO to "0" in 
the program code, it retains signal "1".
However, you can explicitly set it to "0" to return an error statement to the called block. In LAD 
or FBD, the output ENO is set with the instruction "RET: Return".

See also:

Example of the use of the EN/ENO mechanism in LAD (Page 1169)

Example of the use of the EN/ENO mechanism in FBD (Page 1170)

EN/ENO mechanism for STL
In STL, the EN/ENO mechanism is not required for individual instructions. This function is 
mapped by language-specific instruction sequences.

Blocks that you call from an STL block are not provided with the EN and ENO parameters. 
Regardless of the programming language in which they were created, you can transfer an 
error statement to the calling STL block using the BR bit of the status word.

In STL, you can evaluate the error status of the called block by linking the BR bit of the status 
word with the RLO. It has signal "1" as soon as the execution of the block starts. If you do not 
explicitly set it to "0" in the program code, it retains signal "1".
However, you can explicitly set it to "0" to return an error statement to the calling block. In STL, 
the error statement is set with the instructions "SAVE" or "JNB".

See also: Example of the simulation of the EN/ENO mechanism in STL (Page 1171)
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EN/ENO mechanism in SCL
With SCL, the use of the EN/ENO mechanism for instructions is optional. You can activate it 
with the block property "Set ENO automatically". If the property is active, all blocks implicitly 
receive an error handling.

You can implement a conditional block call with the enable input EN. Use the enable input EN 
in the parameter list as a normal input parameter. If EN has signal "1" or when EN is not used, 
the block is called. If EN has signal "0", the block is not called. 

 

 Note

When you call functions in SCL, you cannot use the release mechanism via EN. Use an IF 
statement instead to call functions conditionally.

 

You can query the error status of the block with the enable output ENO. If the ENO has signal 
"1", the block was processed without errors. If the ENO has signal "0", an error occurred during 
processing. To query the state of the enable output, insert an additional output parameter with 
the name ENO in the parameter list during a block call. 

See also: Example of the use of the EN/ENO mechanism in SCL (Page 1170)

EN/ENO mechanism for memory and I/O access errors
You cannot evaluate memory and I/O access errors with the EN/ENO mechanism. You do this 
either with the global troubleshooting via OBs (S7-300/400 and S7-1200/1500) or local 
troubleshooting using the "GetError" instruction (S7-1200/1500 only). If a memory access error 
occurred for an instruction, you can evaluate the associated ENO.

See also
Enabling and disabling the EN/ENO mechanism (Page 1290)

Example of the use of the EN/ENO mechanism in LAD

Description  
The following figure shows an ADD instruction with EN and ENO protective circuit:

After the normally open contact, the RLO contains the previous result of logic operation: 
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● If "TagIn" signal is "0", the addition is not executed. EN and ENO both lead to the signal 
state "0".

● If "TagIn" signal is "1", EN is also "1" and the addition is executed. If no errors occur during 
the processing of the instruction, the output ENO also has the signal state "1" and the output 
""TagOut"" is set.

See also
Basics of the EN/ENO mechanism (Page 1167)

ADD: Add (Page 1685)

Example of the use of the EN/ENO mechanism in FBD

Description  
The following figure shows an ADD instruction with EN and ENO protective circuit:

 

● If "TagIn" signal is "1", EN is also "1" and the addition is executed. If no errors occur during 
the processing of the instruction, the output ENO also has the signal state "1" and the output 
""TagOut"" is set.

● If "TagIn" signal is "0", the addition is not executed. EN and ENO both lead to the signal 
state "0".

See also
Basics of the EN/ENO mechanism (Page 1167)

Example of the use of the EN/ENO mechanism in SCL

Example of the EN/ENO mechanism for basic instructions  
To use the EN/ENO mechanism for instructions in SCL, you have to activate the block property 
"Set ENO automatically". The following example shows the use of the enable output ENO for 
the "a/b" instruction. 

SCL
"MyoutputREAL" :=a/b;
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SCL
IF ENO
    THEN "MyOutputBool":=1;
    ELSE "MyOutputBool":=0;
END_IF;

If the "a/b" instruction is executed error-free, MyOutputBool has signal "1". 

Example of the use of the EN/ENO mechanism in block calls
The following example shows the use of the enable output ENO for a block call. 

SCL
"MyDB"."MyFB"(EN:="MyTag1">"MyTag2",
              in1:="MyInputBool1",
              in2:="MyInputBool1",
              EN0=>"MyOutputBool");

If MyTag1 is not greater than MyTag2 the block call is not processed. EN and ENO both lead 
to the signal state "0".

If MyTag1 is greater than MyTag2, EN has signal "1" and the block call is executed.

If all instructions within MyFB are executed error-free, MyOutputBool has signal "1".

See also
Basics of the EN/ENO mechanism (Page 1167)

Example of the simulation of the EN/ENO mechanism in STL

Description 
The following example shows an program section for adding values with EN and ENO 
connected:

 STL Description
A"Tag_Input_1" // Query whether the signal state of the operand 

is "1" and AND with current RLO
JNBMyLABEL // Evaluation of the EN input

// If RLO="0" jump to jump label "MyLABEL" and 
save the current RLO in the BR
// Execute next instruction if RLO="1"

L"Tag_Input_2" // Load first value of addition
L"Tag_Input_3" // Load second value of addition
+I // Add values
T "Tag_Result" // Transfer sum to the operand "Tag_Result"
AN OV // Query if errors occurred
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 STL Description
SAVE // Transfer signal state of the RLO to the BR bit
CLR // Reset RLO to "0"
MyLABEL: U BR // Jump label "MyLABEL"

// Query BR and AND with RLO
= "Tag_Output" // Assign signal state of the RLO to the operand 

"Tag_Output" 

 

The query of the operand "U" Tag_Input_1"" provides the result of the preceding logic operation 
(RLO). The instruction "Jump at RLO = 0 and save RLO (SPBNB)" saves the RLO to the BR. 
The instruction "Jump if RLO = 0 and save RL0" also evaluates the RLO and executes one of 
the following actions depending on the evaluation: 

● If the RLO is "0", the processing of the program is continued at the jump label "MyLABEL" 
with the query of the BR. The addition is not executed. Assign the current RLO to the 
operand "Tag_Output".

● If the RLO is "1", the addition is executed. A query of the overflow bit (OV) shows if an error 
occurred during the addition. The query result is saved in the BR. The operation "CLR" 
resets the RLO to "0". The BR is then queried for "1" and AND'd with the current RLO. The 
result is assigned to the operand "Tag_Output". The signal state of the BR and of the 
operand "Tag_Output" shows if the addition was carried out with any error

See also
Basics of the EN/ENO mechanism (Page 1167)

9.1.2 Declaring PLC tags

9.1.2.1 Overview of PLC tag tables

Introduction     
PLC tag tables contain the definitions of the PLC tags and symbolic constants that are valid 
throughout the CPU. A PLC tag table is created automatically for each CPU used in the project. 
You can create additional tag tables and use these to sort and group tags and constants.

In the project tree there is a "PLC tags" folder for each CPU of the project. The following tables 
are included:

● "All tags" table

● Standard tag table

● Optional: Other user-defined tag tables
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All tags
The "All tags" table gives an overview of all PLC tags, user constants and system constants 
of the CPU. This table cannot be deleted or moved.

Standard tag table
There is one standard tag table for each CPU of the project. It cannot be deleted, renamed or 
moved. The default tag table contains PLC tags, user constants and system constants. You 
can declare all PLC tags in the default tag table, or create additional user-defined tag tables 
as you want.

User-defined tag tables
You can create multiple user-defined tag tables for each CPU to group tags according to your 
requirements. You can rename, gather into groups, or delete user-defined tag tables. User-
defined tag tables can contain PLC tags and user constants.

 

 

See also
Structure of the PLC tag tables (Page 1173)

Using tags within the program (Page 1049)

Constants (Page 1051)

9.1.2.2 Structure of the PLC tag tables

Introduction       
Each PLC tag table contains a tab for tags and a tab for user constants. The default tag table 
and the "All tags" table also have a "System constants" tab. 

Structure of the "PLC tags" tab
In the "Tags" tab you declare the global PLC tags that you require in the program. The following 
figure shows the tab structure. The number of columns shown may vary.

 

The following table shows the meaning of the individual columns. The number of columns 
shown may vary. You can show or hide the columns as required.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1173



Column Explanation
Symbol you can click on to drag-and-drop a tag to a program for use 
as an operand.

Name Unique name for the constants throughout the CPU.
Data type Data type of the tags.
Address Tag address.
Retentivity Marks the tag as retentive.

The values of retentive tags are retained even after the power supply 
is switched off. 

Accessible from HMI Shows whether HMI can access this tag during runtime.
Visible in HMI Shows whether the tag is visible by default in the operand selection 

of HMI.
Monitor value Current data value in the CPU. 

This column only appears if an online connection is established and 
you select the "Monitor all" button.

Tag table Shows which tag table includes the tag declaration.
This column is only available in the "All tags" table.

Comment Comment to document the tags.

Structure of the "User constants" and "System constants" tabs
In the "User constants" you define symbolic constants that are valid throughout the CPU. The 
constants required by the system are shown in the "Systems constants" tab. The following 
figure shows the structure of both tabs. The number of columns shown may vary.

The following table shows the meaning of the individual columns. You can show or hide the 
columns as required.

Column Explanation
Symbol you can click to move a tag into a network via a drag-and-
drop operation for use as an operand.

Name Unique name for the constants throughout the CPU.
Data type Data type of the constants
Value Value of the constants
Tag table Shows which tag table includes the constant declaration.

This column is only available in the "All tags" table.
Comment Comments to document the tags.
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See also
Using tags within the program (Page 1049)

Constants (Page 1051)

Overview of PLC tag tables (Page 1172)

Show and hide table columns (Page 1195)

Editing tables (Page 242)

9.1.2.3 Rules for PLC tags

Valid names of PLC tags

Permissible characters
The following rules apply to the use of names for PLC tags:

● Letters, numbers, special characters are permitted.

● Quotation marks are not permitted.

Unique tag names
The names of the PLC tags must be unique throughout the CPU, even if the tags are located 
in different tag tables of a CPU. A name that is already used for a block, another PLC tag or 
a constant within the CPU, cannot be used for a new PLC tag. The uniqueness check does 
not differentiate between use of small and capital letters. 

If you enter an already assigned name another time, a sequential number is automatically 
appended to the second name entered. For example, if you enter the name "Motor" a second 
time, the second entry is changed to "Motor(1)".

Unique table names
The names of the PLC tag tables must also be unique throughout the CPU. A unique name is 
automatically suggested when user-defined PLC tag tables are being created.

 

See also
Using tags within the program (Page 1049)

Permissible addresses and data types of PLC tags (Page 1176)

Keywords (Page 1051)
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Permissible addresses and data types of PLC tags
The addresses of PLC tags are made up of the particulars of the operand area and the address 
within this area. 

The addresses must be unique throughout the CPU. If you enter an address that is already 
assigned to another tag, the address will be highlighted at both places in yellow and an error 
message will be issued. 

Operand areas
The following table shows the possible operand areas. The available data types depend on 
the CPU you use:

Operand area Description Data type Format Address area:
Internatio
nal 
mnemoni
cs

German 
mnemoni
cs

S7-1200 S7-300/400 S7-1500

I E Input bit BOOL I x.y
E x.y

0.0..1023.7 0.0..65535.7 0.0..32766.7

I E Input (64-bit) LWORD, 
LINT, ULINT, 
LTIME, 
LTOD, LDT, 
LREAL, PLC 
data type

I x.0
E x.0

- - 0.0..32761.0

IB EB Input byte BYTE, 
CHAR, SINT, 
USINT, PLC 
data type

IB x
EB y

0..1023 0..65535 0..32767

IW EW Input word WORD, INT, 
UINT, DATE, 
S5TIME, 
PLC data 
type

IW x
EW y

0..1022 0..65534 0..32765

ID ED Input double 
word

DWORD, 
DINT, 
UDINT, 
REAL, TIME, 
TOD, PLC 
data type

ID x
ED y

0..1020 0..65532 0..32763

Q A Output bit BOOL Q x.y 
A x.y

0.0..1023.7 0.0..65535.7 0.0..32766.7

Q A Output (64-
bit)

LWORD, 
LINT, ULINT, 
LTIME, 
LTOD, LDT, 
LREAL, PLC 
data type

Q x.0 
A x.0

- - 0.0..32761.0
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Operand area Description Data type Format Address area:
Internatio
nal 
mnemoni
cs

German 
mnemoni
cs

S7-1200 S7-300/400 S7-1500

QB AB Output byte BYTE, 
CHAR, SINT, 
USINT, PLC 
data type

QB x 
AB y

0..1023 0..65535 0..32767

QW AW Output word WORD, INT, 
UINT, DATE, 
S5TIME, 
PLC data 
type

QW x 
AW y

0..1022 0..65534 0..32765

QD AD Output 
double word

DWORD, 
DINT, 
UDINT, 
REAL, TIME, 
TOD, PLC 
data type

QD x 
AD y 

0..1020 0..65532 0..32763

M M Memory bit BOOL M x.y 0.0..8191.7 0.0..65535.7 0.0..16383.7
M M Bit memory 

(64-bit)
LREAL M x.0 0.0..8190.0 - 0.0..16378.0

M M Bit memory 
(64-bit)

LWORD, 
LINT, ULINT, 
LTIME, 
LTOD, LDT

M x.0 - - 0.0..16378.0

MB MB Memory byte BYTE, 
CHAR, SINT, 
USINT

MB x 0..8191 0..65535 0..16383

MW MW Memory word WORD, INT, 
UINT, DATE, 
S5TIME

MW x 0..8190 0..65534 0..16382

MD MD Memory 
double word

DWORD, 
DINT, 
UDINT, 
REAL, TIME, 
TOD

MD x 0..8188 0..65532 0..16380

T T Time function 
(for 
S7-300/400 
only)

Timer T n - 0..65535 0..2047

C Z Counter 
function (for 
S7-300/400 
only)

Counter Z n
C n

- 0..65535 0..2047
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Addresses
The following table shows the possible addresses of tags:

Data type Address Example
BOOL Tags with BOOL data type are addressed with a byte number and a 

bit number. The numbering of the bytes begins for each operand area 
at 0. The numbering of the bits goes from 0 to 7.

A 1.0

BYTE, 
CHAR, SINT, 
USINT

Tags with BYTE, CHAR, SINT, and USINT data type are addressed 
with a byte number.

MB 1

WORD, INT, 
UINT, DATE, 
S5TIME

Tags with WORD, INT, UINT, DATE, S5TIME data type consist of two 
bytes. They are addressed with the number of the lowest byte.

IW 1

DWORD, 
DINT, 
UDINT, 
REAL, TIME, 
TOD

Tags with DWORD, DINT, UDINT, REAL, TIME, TOD data type 
consist of four bytes. They are addressed with the number of the 
lowest byte.

AD 1

LWORD, 
LINT, ULINT, 
LTIME, 
LTOD, LDT, 
LREAL

Tags of data type LWORD, LINT, ULINT, LTIME, LTOD, LDT, and 
LREAL consist of eight bytes. They are addressed with it number 0 
and the number of the lower byte.
 

I 1.0

 

Mnemonics used     
The addresses that you enter in the PLC tag table are automatically adapted to the set 
mnemonics. 

 

See also
Setting the mnemonics (Page 1229)

Using tags within the program (Page 1049)

Valid names of PLC tags (Page 1175)

Overview of the valid data types (Page 1077)

9.1.2.4 Creating and managing PLC tag tables

Creating a PLC tag table
You can created multiple user-defined PLC tag tables in a CPU. Each tag table must have 
have a unique name throughout the CPU.
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Requirement
The project view is open.

Procedure   
To created a new PLC tag table, follow these steps:

1. Open the "PLC tags" folder under the CPU in the project tree.

2. Double-click the "Add new tag table" entry.
A new PLC tag table with the default name "TagTable_x" is created.

3. Select the PLC tag table in the project tree.

4. Select the "Rename" command in the shortcut menu.

5. Type in a name that is unique throughout the CPU.

Result
A new PLC tag table is created. You can now declare tag and constants in this table.

See also
Overview of PLC tag tables (Page 1172)

Structure of the PLC tag tables (Page 1173)

Importing and exporting (Page 1549)

Grouping PLC tag tables
You can gather the user-defined tag tables of the CPU into groups. You cannot, however, 
move the standard tag table and the "All tags" table into a group.

Requirement
Multiple user-defined tag tables are contained in the "PLC tags" folder of the CPU.

Procedure  
To gather multiple PLC tag tables into a group, follow these steps:

1. Select the "PLC tags" folder under the CPU in the project tree.

2. Select the "Insert > Group" menu command.
A new group with the standard name "Group_x" is inserted.

3. Select the newly inserted group in the project tree.

4. Select the "Rename" command in the shortcut menu.

5. Assign the new group a unique name throughout the CPU.

6. Drag to the new group the tables you want to group together.
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Result
The tag tables are gathered in the new group.

See also
Overview of PLC tag tables (Page 1172)

Structure of the PLC tag tables (Page 1173)

Opening the PLC tag table

Procedure 
To open the PLC tag table in a CPU, proceed as follows:

1. Open the "PLC tags" folder under the CPU in the project tree.

2. Double-click the PLC tag table in the folder.

3. Select the desired tab in the upper corner.

Result
The PLC tag table associated with the CPU opens. You can declare the required tags and 
constants.

See also
Overview of PLC tag tables (Page 1172)

Structure of the PLC tag tables (Page 1173)

9.1.2.5 Declaring PLC tags

Entering a PLC tag declaration

Declaring tags in the PLC tag table

Requirements
The "Tags" tab of the PLC tag table is open.  
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Procedure
To define PLC tags, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the required data type in the "Data type" column. You will be supported by 
autocompletion during input.
An address corresponding to the data type is automatically appended.

3. Optional: Click on the arrow key in the "Address" column and enter an operand identifier, 
an operand type, an address and a bit number in the dialog which then opens.

4. Optional: Enter a comment in the "Comments" column.

5. Repeat steps 1 to 4 for all the tags you require.

See also: Permissible addresses and data types of PLC tags (Page 1176) 

Syntax check
A syntax check is performed automatically after each entry, and any errors found are displayed 
in red. You do not have to correct these errors immediately - you can continue editing and 
make any corrections later. As long as the tag declaration contains syntax errors and the tag 
is used in the program, you will not be able to compile the program. 

See also
Importing and exporting (Page 1549)

Valid names of PLC tags (Page 1175)

Declaring PLC tags in the program editor (Page 1181)

Structure of the PLC tag tables (Page 1173)

Editing tables (Page 242)

Declaring PLC tags in the program editor

Requirement  
● The program editor is open.

Procedure
To declare operands as global PLC tags, follow these steps:

1. Insert an instruction in your program.
The "<???>", "<??.?>" or "..." strings represent operand placeholders.

2. Replace an operand placeholder with the name of the PLC tag to be created.

3. Select the tag name.
If you want to declare multiple PLC tags, select the names of all the tags to be declared.
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4. Select the "Define tag" command in the shortcut menu.
The "Define tag" dialog box opens. This dialog displays a declaration table in which the 
name of the tag is already entered.

5. Click the arrow key in the "Section" column and select one of the following entries:

– Global Memory

– Global Input

– Global Output

6. In the other columns, enter the address, data type, and comments.
See also: Permissible addresses and data types of PLC tags (Page 1176) 

7. If the CPU contains multiple PLC tag tables, you can use an entry in the "PLC tag table" 
column to indicate in which table the tag is to be inserted. If you make no entry in the column, 
the new tag will be inserted in the default tag table.

8. Click the "Define" button to complete your entry.

 

Result
The tag declaration is written to the PLC tag table and is valid for all blocks in the CPU.

See also
Valid names of PLC tags (Page 1175)

Editing tables (Page 242)

Declaring tags in the PLC tag table (Page 1180)

Setting the retentivity of PLC tags

Retentive behavior of PLC tags

Retentive PLC tags       
Each CPU has a memory area whose content remains available even after the supply voltage 
has been switched off. This area is referred to as retentive memory area.

To avoid data loss during power failure, you can save specific PLC tags to this memory area. 
You specify the retain setting of PLC tags in the PLC tag table. 

Depending on the CPU family, the retentive memory area can accommodate various type of 
PLC tags. The following table provides an overview of the options of the various CPUs:
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CPU type Retentive bit memories Retentive SIMATIC timers Retentive SIMATIC counters
S7-300/400 series ✓ - -
S7-1200 series ✓ - -
S7-1500 series ✓ ✓ ✓

See also
Setting the retentive behavior of PLC tags (Page 1183)

Setting the retentive behavior of PLC tags

Introduction       
In the PLC tag table you can specify the width of the retentive memory area for PLC tags. All 
tags with addresses in this memory area are then designated as retentive. You can recognize 
the retentivity setting of a tag by the check mark set in the "Retain" column of the PLC tag 
table. 

Requirement
The "PLC tags" tab of the PLC tag table is open.

Procedure
To define the width of the retentive memory area for PLC tags, follow these steps:

1. On the toolbar, click the "Retain" button.
The "Retain memory" dialog will open.

2. Specify the width of the retentive memory area by entering the number of retentive bytes, 
timers or counters in the input field.

3. Click the "OK" button.

Result
The width if the retentive memory area is defined. In the "Retain" column of the tag table a 
check mark is automatically set for all tags that are located within the retentive memory area.

See also
Retentive behavior of PLC tags (Page 1182)

Editing tables (Page 242)
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9.1.2.6 Grouping PLC tags for inputs and outputs in structures

Other useful information regarding structured PLC tags

Use of structured PLC tags (S7-1200 V4 and higher/S7-1500)
To make your program easier to view, you can group several input or output addresses in a 
higher-level PLC tag. The higher-level PLC tag represents a structure that contains several 
logically related inputs or outputs. When the block is called, you transfer the higher-level tag 
and thus need only an input or output parameter for all associated inputs or outputs.

Principle of operation
To create a structured PLC tag, you initially define a PLC data type (UDT). In it you declare 
the necessary data elements and specify their names and data types.

Then, you switch to the PLC tag table and specify the higher-level PLC tag there. As a data 
type for the tag, you select your PLC data types. The system now reserves a certain number 
of input or output addresses starting from the start address of the higher-level tag. The number 
of reserved addresses depends on the length of your PLC data type. 

If you call a block that requires the reserved inputs or outputs for program execution, you 
transfer the higher-level tag as a block parameter.

You can address the individual PLC tags like structure elements in the program code.

A detailed description of the individual handling steps can be found in the following chapters.

Application example
You can use structured PLC tags in order to group the inputs or outputs of a function module. 
The following figure shows the schematic representation of a motor: A component was created 
in the "Datatype_Motor" PLC data type for each of the three inputs. 

The memory areas of the declared tags must not overlap. In the example, you see that the 
"Speed" component has the data type "Integer" and therefore must start at a word address. 
For this reason, the first input word has been filled with the "Dummy" fill tag. This means that 
"Speed" is located on the second input word.
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The following figure shows the higher-level "Motor" PLC tag that is based on the "Data 
type_Motor" data type. With the declaration of "Motor", the addresses IW0 and IW1 are 
reserved on the input module.

 

 

The following figure shows the transfer of the "Motor" PLC tag as an input parameter of the 
"Motor_Control" block.

You can address the individual components of the tag in the "Motor_Control" block.

Addressing Description
"Motor" Addressing the higher-level PLC tag.
"Motor".On Addressing a component of a structured PLC tag.
"Motor".On:P Addressing an I/O input or output (PI or PO).

Rules for use of structured PLC tags
Note the following rules when creating and using structured PLC tags.

● Structured PLC tags can be used in the "Inputs" and "Outputs" operand areas.

● Structured tags are not permitted in the bit memory address area.

● Structured PLC tags cannot be addressed from HMI.

Observe the following rules when creating the PLC data type that is to serve as the basis for 
a PLC tag:

● The memory areas of the individual elements must not overlap.
See also: Permissible addresses and data types of PLC tags (Page 1176)

● Do not group inputs and outputs in one PLC data type but create different PLC data types 
for inputs and outputs.
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● Do not group inputs or outputs from different modules in a PLC data type because it is not 
guaranteed that the process images of the modules are updated synchronously.

● In the lower-level PLC data types, all data types are permitted except for the "STRING" 
data type.

See also
Creating structured PLC tags (Page 1186)

Creating structured PLC tags

Rules
Note the following rules when creating structured PLC tags:

● Use separate PLC data types for the "Inputs" and "Outputs" operand areas. 

● Structured tags are not permitted in the bit memory address area.

● Do not group inputs or outputs from different modules in a PLC data type because it is not 
guaranteed that the process images of the modules are updated synchronously.

Procedure
To create a structured PLC tag, follow these steps:

1. Double-click the "Add new data type" command in the "PLC data types" folder in the project 
tree.
A new declaration table for creating a PLC data type will be created and opened.

2. Declare all the necessary components in the PLC type. All data types except the "STRING" 
data type are permitted.

3. Select the PLC data type in the project tree and select the "Compile > Software (only 
changes)" command from the shortcut menu.
The PLC data type is compiled and can then be used in the PLC tag table.
Even when you make changes to existing PLC data types, you must recompile the program. 
This updates all locations of use of the PLC data type.

4. Open a PLC tag table within the same CPU.

5. Declare a new tag or select an existing tag.

6. In the "Data type" column, select the PLC data type and assign it to the PLC tag.
The PLC tag receives the structure of the PLC data type. A suitable address is assigned 
automatically. Structured PLC tags always start at word addresses.
The highest structure element is displayed without its subelements in the table.
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 Note
Assignment rules and default values
● For the declaration of the PLC data type, note that the memory areas of the individual tags 

must not overlap. For example, tags of data type "Integer" must start at a word limit. If 
necessary, insert "fill tags" to prevent overlaps.
See also: Permissible addresses and data types of PLC tags (Page 1176)

● It is not possible to assign default values for the individual components. Values that you 
enter in the "Default value" column are not evaluated. Tags of data types "DT" and "DTL" 
may therefore contain invalid values.

 

See also
Other useful information regarding structured PLC tags (Page 1184)

9.1.2.7 Declaring symbolic constants

Rules for symbolic constants

Permissible characters
Names of symbol constants may consist of the following characters:

● Letters, numbers, special characters are permitted.

● Quotation marks are not permitted.

Unique constant names
The names of the symbolic constants must be unique throughout the CPU, even if the 
constants are located in different tag tables of a CPU. A name that is already used for a block, 
a PLC tag or another constant within the CPU, cannot be used for new constant. The 
uniqueness check does not differentiate between use of small and capital letters. 

If you enter an already assigned name another time, a sequential number is automatically 
appended to the second name entered. For example, if you enter the name "Motor" a second 
time, the second entry is changed to "Motor(1)".

Permissible data types   
For constants, all data types supported by the CPU are permitted, with the exception of 
structured data types.

Permitted values
You can select any value from the value range of the specified data type as constant value. 
For information on the value ranges, refer to the "Data types" chapter.
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See also: Auto-Hotspot 

See also
Constants (Page 1051)

Declaring constants (Page 1188)

Declaring constants

Introduction  
You declare constants in the "User constants" tab of a PLC tag table. During declaration you 
have to to enter a symbolic name, a data type and a fixed value for each constant. The entry 
format and the value range of the constant value depend on the data type of the constant. 

See also: Auto-Hotspot

Procedure
To declare constants, follow these steps:

1. Open a PLC tag table.

2. Open the "User constants" tab.
The constants table opens.

3. Enter a constant name in the "Name" column.

4. Enter the required data type in the "Data type" column. You will be supported by 
autocompletion during input.

5. Enter a constant value in the "Value" column; this constant value must be valid for the 
selected data type.

6. If you want, enter comments on the constants in the "Comments" column. The entry of a 
comment is optional.

7. If you want to declare additional constants, place the cursor in the next row and repeat 
steps 3 to 6.

Syntax check
A syntax check is performed automatically after each entry, and any errors found are displayed 
in red. You do not have to correct these errors immediately - you can continue editing and 
make any corrections later. As long as the tag declaration contains syntax errors and the 
constant is used in the program, you will not be able to compile the program.
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See also
Opening the PLC tag table (Page 1180)

Inserting a table row in the PLC tag table (Page 1192)

Structure of the PLC tag tables (Page 1173)

Rules for symbolic constants (Page 1187)

Editing tables (Page 242)

9.1.2.8 Editing properties

Editing the properties of PLC tags

Properties of PLC tags

Overview   
The following table provides an overview of the properties of PLC tags. The display of 
properties may vary depending on the CPU type.

Group Property Description
General Name A unique name within the CPU.

Data type Data type of the tags.
Address Tag address.
Retain Shows whether the tag is in the retentive memory area.
Comment Comment on the tag.

History Date created Time when the tag was created (cannot be changed).
Last modified Time when the tag was last changed (cannot be changed).

Usage Visible in HMI Shows whether the tag is visible by default in the HMI 
selection list.

Accessible from HMI Shows whether HMI can access this tag during runtime.

See also
Editing the properties of PLC tags (Page 1190)
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Editing the properties of PLC tags

Editing properties in a PLC tag table  
To edit the properties of one or more tags, follow these steps:

1. In the project tree, double-click the PLC tag table that contains the tags.
The PLC tag table opens.

2. Change the entries in the columns.

Editing addresses in the program editor
To edit the address of a tag in the program editor, follow these steps:

1. Select the tag name.

2. Select the "Rewire tag" command in the shortcut menu.
The "Rewire tag" dialog will open. The dialog shows a declaration table.

3. Enter the new address in the "Address" column.

4. Click the "Change" button to confirm the input.

Editing names in the program editor
To edit the name of a tag in the program editor, follow these steps:

1. Select the tag name.

2. Select the "Rename tag" command in the shortcut menu.
The "Rename tag" dialog opens. The dialog shows a declaration table.

3. Enter the new name in the "Name" column.

4. Click the "Change" button to confirm the input.

Effect in the program
In the case of a change of the tag's name, data type or address, each location of use of the 
tag is automatically updated in the program. 

See also
Properties of PLC tags (Page 1189)
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Editing the properties of symbolic constants

Properties of constants

Overview  
The following table gives an overview of the properties of constants:

Group Property Description
General Name A unique name within the table

Data type Data type of the constants
Value Value that you defined for the constants. 

This value must be compatible with the declared data 
type. 
See also: Auto-Hotspot

Comment Comment on the constants
History Date created Time when the constant was created (cannot be changed)

Last modified Time when the constant was last changed (cannot be 
changed)

Editing properties of constants

Editing properties in a PLC tag table  
To edit the properties of one or more constants, follow these steps:

1. In the project tree, double-click the PLC tag table that contains the constants.
The PLC tag table opens.

2. Open the "User constants" tab.

3. Change the entries in the "Name", "Data type", "Value", or "Comments" column.

Effect in the program
In the case of a change of a constant's name, data type or value, each location of use of the 
constant is automatically updated in the program. 

 

See also
Editing tables (Page 242)
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9.1.2.9 Monitoring of PLC tags

Monitoring of PLC tags
You can monitor the current data values of the tags on the CPU directly in the PLC tag table.

Requirements  
An online connection to the CPU is available.

Procedure
To monitor the data values, proceed as follows:

1. Open a PLC tag table.

2. Start monitoring by clicking the "Monitor all" button.
The additional "Monitor value" column is displayed in the table. This shows the current data 
values. 

3. End the monitoring by clicking the "Monitor all" button again.
 

 Note

You also have the option of copying PLC tags to a monitor or force table so that you can 
monitor, control or force them in the table.

 

See also
Structure of the PLC tag tables (Page 1173)

Introduction to testing with the watch table (Page 1499)

Introduction for testing with the force table (Page 1524)

Copying entries in the PLC tag table (Page 1193)

9.1.2.10 Editing PLC tag tables

Inserting a table row in the PLC tag table

Procedure  
Proceed as follows to insert a row above the selected row: 

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button on the toolbar of the table.
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Result
A new row is inserted above the selected row. 

See also
Editing tables (Page 242)

Copying entries in the PLC tag table
You can copy PLC tags within a table or to other tables. 

Procedure  
To copy a tag, follow these steps:

1. Select the tags you want to copy.
You can also select several tags by clicking on them one after the other while holding down 
the <Ctrl> key or by pressing and holding down <Shift> and clicking on the first and last 
tag.

2. Select "Copy" in the shortcut menu.

3. Position the insertion pointer at the location where you want to insert the tags.

4. Select "Paste" in the shortcut menu.

Or

1. Select the tag.

2. Hold down the left mouse button.

3. At the same time, press <Ctrl>.

4. Drag the tag to the destination.

Result
● The tag is copied to the destination.

● If there is a name conflict, a number is automatically appended to the tag name. For 
example, "Tag" becomes "Tag(1)".

● All other properties of the tag remain unchanged.

See also
Editing tables (Page 242)
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Deleting entries in the PLC tag table

Procedure  
To delete a tag, follow these steps:

1. Select the row with the tag to be deleted. You can also select several rows by clicking on 
them one after the other while holding down the <Ctrl> key or by pressing and holding down 
<Shift> and clicking on the first and last row.

2. Select the "Delete" command in the shortcut menu.

See also
Editing tables (Page 242)

Sorting rows in the PLC tag tables
You can sort the rows in the tables alphanumerically by name, data type, or address.

Procedure     
To sort the table rows, follow these steps:

1. Select the column by which you want to sort.

2. Click the column header.
The column will be sorted in order of increasing values.
An up arrow shows the sort sequence.

3. In order to change the sort sequence, click the arrow.
The column will be sorted in order of decreasing values. A down arrow shows the sort 
sequence.

4. To restore the original sequence, click a third time on the column header.

See also
Editing tables (Page 242)

Automatically filling in cells in the PLC tag table
You can load the contents of one or several table cells into the cells below, automatically filling 
in the successive cells. 

If you automatically fill in cells in the "Name" column, a consecutive number will be appended 
to each name. For example, "Motor" will become "Motor_1".

If you fill the cells in the column "Address" automatically, the addresses will be increased 
depending on the indicated data type.
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Procedure  
To automatically fill in successive cells, follow these steps:

1. Select the cells to be loaded.

2. Click the "Fill" symbol in the bottom right corner of the cell.
The mouse pointer is transformed into a crosshair.

3. Keep the mouse button pressed and drag the mouse pointer downwards over the cells that 
you want to fill in automatically.

4. Release the mouse button.
The cells are filled in automatically. If entries are already present in the cells that are to be 
automatically updated, a dialog appears in which you can indicate whether you want to 
overwrite the existing entries or whether you want to insert new rows for the new tags.

See also
Editing tables (Page 242)

Show and hide table columns
You can show or hide the columns in a table as needed.

Procedure     
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

See also
Editing tables (Page 242)

Editing PLC tags with external editors
To edit individual PLC tags in external editors outside the TIA portal, you can export or import 
these tags using copy and paste. However, you cannot copy structured tags to an editor.

Requirement
A PLC tag table and an external editor are opened.
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Procedure
To export and import individual PLC tags, follow these steps:

1. Select one or more PLC tags.

2. Select "Copy" in the shortcut menu.

3. Switch to the external editor and paste the copied tags.

4. Edit the tags as required.

5. Copy the tags in the external editor.

6. Switch back to the PLC tag table.

7. Select "Paste" in the shortcut menu.
 

 Note

You also have the option of export or importing PLC tags as mass data. 

See also: Importing and exporting (Page 1549)
 

9.1.3 Creating and managing blocks

9.1.3.1 Creating blocks

Block folder

Function    
You can find a "Program blocks" folder in the project tree, in which you can create and manage 
the following blocks:

● Organization blocks (OB)

● Function blocks (FB)

● Functions (FCs)

● Data blocks (DB)

A "System blocks" subfolder containing another subfolder, "Program resources", is also 
created in the "Program blocks" folder the first time you drag an instruction to your program 
which is an internal system function block. The instance data block of the internal system 
function block is also pasted to the "Program resources" folder. You can move or copy such 
instance data blocks from the "Program resources" folder to any other folder and rename or 
delete them. You can also move your blocks into the "Program resources" folder. Blocks in 
the "Program resources" folder that are not required to run the user program are removed 
during the next compilation. If the "Program resources" folder contains no more blocks then it 
is also deleted with the "System blocks" folder.
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A program cycle OB is automatically generated for each device and inserted in the "Program 
blocks" folder. 

See also
Creating functions and function blocks (Page 1198)

Creating data blocks (Page 1199)

Creating organization blocks (Page 1197)

Using blocks from libraries (Page 1200)

Creating organization blocks

Requirement 
The "Program blocks" folder in the project tree is open.

Procedure
To create an organization block, follow these steps:

1. Double-click the "Add new block" command.
The "Add new block" dialog box opens.

2. Click the "Organization block (OB)" button.

3. Select the type of new organization block.

4. Enter a name for the new organization block.

5. Enter the properties of the new organization block.

6. To enter additional properties for the new organization block, click "Additional information".
An area with further input fields is displayed.

7. Enter all the properties you require.

8. Activate the "Add new and open" check box if the organization block does not open as soon 
as it is created.

9. Confirm your entries with "OK".

Result
The new organization block is created. You can find the organization block in the project tree 
in the "Program blocks" folder. You can assign additional parameters to some organization 
blocks in the inspector window or device view after they have been created. The organization 
block description will state whether the newly created organization block has additional 
parameters. 
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See also
Organization blocks (OB) (Page 1022)

Block folder (Page 1196)

Creating functions and function blocks (Page 1198)

Creating data blocks (Page 1199)

Using blocks from libraries (Page 1200)

Entering a block title (Page 1206)

Entering a block comment (Page 1207)

Creating functions and function blocks

Requirement   
The "Program blocks" folder in the project tree is open.

Procedure
To create a function (FC) or a function block (FB), follow these steps:

1. Double-click the "Add new block" command.
The "Add new block" dialog box opens.

2. Click the "Function block (FB)" or "Function (FC)" button.

3. Enter a name for the new block.

4. Enter the properties of the new block.

5. To enter additional properties for the new block, click "Additional information".
An area with further input fields is displayed.

6. Enter all the properties you require.

7. Activate the "Add new and open" check box if the block does not open as soon as it is 
created.

8. Confirm your entries with "OK".

Result
The new block is created. You can find the block in the project tree in the "Program blocks" 
folder.
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See also
Function blocks (FB) (Page 1023)

Functions (FCs) (Page 1022)

Basics of block access (Page 1027)

Block folder (Page 1196)

Creating organization blocks (Page 1197)

Creating data blocks (Page 1199)

Using blocks from libraries (Page 1200)

Entering a block title (Page 1206)

Entering a block comment (Page 1207)

Creating data blocks

Requirement   
The "Program blocks" folder in the project tree is open.

Procedure
To create a data block, follow these steps:

1. Double-click the "Add new block" command.
The "Add new block" dialog box opens.

2. Click the "Data block (DB)" button.

3. Select the type of the data block. You have the following options available to you:

– To create a global data block, select the list entry "Global DB".

– To create an ARRAY data block, select the "ARRAY DB" entry in the list.

– To create an instance data block, select the function block to which you want to assign 
the instance data block from the list. The list contains only the function blocks that were 
previously created for the CPU.

– To create a data block based on a PLC data type, select the PLC data type from the 
list. The list contains only the PLC data types that were previously created for the CPU.

– To create a data block based on a system data type, select the system data type from 
the list. The list contains only those system data types that have already been inserted 
to program blocks in the CPU.

4. Enter a name for the data block.

5. Enter the properties of the new data block. 

6. If you have selected an ARRAY DB as the data block type, enter the ARRAY data type and 
the high limit for the ARRAY. 
You can change the high limit for the ARRAY at any time in the property window of the 
created block. The ARRAY data type cannot be changed subsequently.
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7. To enter additional properties of the new data block, click "Additional information".
An area with further input fields is displayed.

8. Enter all the properties you require.

9. Activate the "Add new and open" check box if the block does not open as soon as it is 
created.

10.Confirm your entry with "OK".

Result
The new data block is created. You can find the data block in the project tree in the "Program 
blocks" folder.

See also
Global data blocks (DB) (Page 1024)

Instance data blocks (Page 1025)

Block folder (Page 1196)

Creating organization blocks (Page 1197)

Creating functions and function blocks (Page 1198)

Using blocks from libraries (Page 1200)

Basics of block access (Page 1027)

System data types (Page 1119)

Using blocks from libraries
You can save blocks in the project library or in a global library, so that you can use them more 
than once within a user program. You can insert the blocks as master copies or as types.

See also: Library basics (Page 338)

Requirement   
● The "Libraries" task card is displayed.

● No write protection is set for global libraries.

Adding blocks as master copies to the project library or to a global library
To add new blocks as master copies to the project library or to a global library, follow these 
steps:

1. Maximize the project library or the global library.

2. Use drag-and-drop to move the block you wish to add to the library to the "Master copies" 
folder or any one of the "Master copies" subfolders in the project library or a global library. 
Do not release the left mouse button until a small plus sign appears underneath the mouse 
pointer. 
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Or:

1. Copy the element you want to add as master copy.

2. Maximize the project library or the global library.

3. Right-click the "Master copies" folder or any of its subfolders.

4. Select "Paste" in the shortcut menu.

Adding blocks as types to the project library or to a global library
To add new blocks as types to the project library or to a global library, follow these steps:

1. Maximize the project library or the global library.

2. Drag-and-drop the element you want to add as a type into the "Types" folder or any of its 
subfolders in the project library or a global library. Do not release the left mouse button until 
a small plus sign appears underneath the mouse pointer.

Or:

1. Copy the element you want to add as a type.

2. Maximize the project library or the global library.

3. Right-click the "Types" folder or any of its subfolders.

4. Select "Paste" in the shortcut menu.

Using blocks of the project library or a global library
To use a block from the project library or a global library in your project, follow these steps:

1. Maximize the project library or the global library so that you can see the block you wish to 
use.

2. Use a drag-and-drop operation to move the block to the CPU block folder. If the selected 
insertion points is not allowed, the mouse pointer will appear as a circle with a slash. 

 

 Note

If you derive an instance from a type in a global library, the type is also inserted into the project 
library. The instance is then only linked to the type in the project library.

 

See also
Using libraries (Page 338)
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Copying and pasting blocks

Basics of copying and pasting blocks

Function
You can also create new blocks by copying existing blocks and pasting the copy. Note the 
following principles when copying to CPUs of the same device family:

● You can copy organization blocks (OBs), functions (FCs), function blocks (FBs), and global 
data blocks (DBs) without restriction.

● You can copy instance data blocks only for the same function block, since the assignment 
to the function block cannot be changed afterwards. However, the assignment is canceled 
if you copy the instance data block to a different CPU. If a function block with the same 
name exists there, the instance data block will be assigned to this function block. If you 
copy the instance data block together with the function block into the other CPU, the 
instance data block is assigned to the copy of the function block.

The various device families sometimes support different blocks, especially in the case of 
organization blocks. However, function blocks and functions can also be programmed on the 
various devices with different access types. Therefore, not all blocks are supported on all 
devices. Note the following principles when copying to a different device family:
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● Copying to an S7-1200 CPU:

– Organization blocks with "Optimized" access type can be copied to an S7-1200. If the 
copied OB type is supported by the S7-1200 CPU, the copied OB retains the properties 
of its event. You must, however, compile it again.

– Although organization blocks with the "Standard" access type can be copied to an 
S7-1200, they are not supported by the CPU.

– Function blocks (FBs), functions (FCs) and global data blocks (DBs) with "Optimized" 
access type can be copied to an S7-1200. However, they must be recompiled after this.

– Although function blocks (FBs), functions (FCs) and global data blocks (DBs) with 
"Standard" access type can be copied to an S7-1200, they are not supported by the 
CPU. 

– Instance data blocks: If there is a function block in the target CPU with the name that 
was assigned to the instance data block in the source CPU, the instance data block is 
assigned to the function block in the target CPU. If you copy the instance data block 
together with the function block to which it was assigned in the source CPU into the 
target CPU, the instance data block is assigned to the copy of the function block.

● Copying to an S7-1500 CPU:

– Organization blocks with "Optimized" access type can be copied to an S7-1500. If the 
copied OB type is supported by the S7-1500 CPU, the copied OB retains the properties 
of its event. You must, however, compile it again. OB types that are not supported 
receive a no parking symbol.

– Organization blocks with "Standard" access type can be copied to an S7-1500. If the 
OB derives from an S7-300/400 CPU, it receives the standard event of the 
corresponding OB type. If the OB derives from an S7-1200/1500 CPU, it receives the 
properties of its event. However, it must be compiled again.

– Function blocks (FBs), functions (FCs) and global data blocks (DBs) with "Optimized" 
access type can be copied to an S7-1500. However, they must be recompiled after this.

– Although function blocks (FBs), functions (FCs) and global data blocks (DBs) with 
"Standard" access type can be copied to an S7-1500, they are not supported by the 
CPU. 

– Instance data blocks: If there is a function block in the target CPU with the name that 
was assigned to the instance data block in the source CPU, the instance data block is 
assigned to the function block in the target CPU. If you copy the instance data block 
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together with the function block to which it was assigned in the source CPU into the 
target CPU, the instance data block is assigned to the copy of the function block.

● Copying to S7-300/400 CPUs:

– Organization blocks can be copied as required between S7-300 and S7-400. 

– Although organization blocks from S7-1200/1500 CPUs can be copied to S7-300/400 
CPUs, they are not supported by the target CPU.

– Function blocks (FBs), functions (FCs) and global data blocks (DBs) can be copied as 
required between S7-300 and S7-400.

– Although function blocks (FBs), functions (FCs) and global data blocks (DBs) can be 
copied from S7-1200/1500 CPUs to S7-300/400 CPUs, they are not supported by the 
target CPU. 

– Instance data blocks: If there is a function block in the target CPU with the name that 
was assigned to the instance data block in the source CPU, the instance data block is 
assigned to the function block in the target CPU. If you copy the instance data block 
together with the function block to which it was assigned in the source CPU into the 
target CPU, the instance data block is assigned to the copy of the function block.

In the project tree, blocks that are not supported are indicated by the no parking symbol. Blocks 
with a no parking symbol cannot be edited, but only used again as copy source.

Copying data
With paste, all the block data is copied and forwarded to the copy. This data includes:

● Block interface tags

● All networks

● Comments in all existing compilations

● Messages defined in the block

● The entire program code of the copied block including the call instructions contained in the 
block.
However, called blocks and their associated instance data blocks are not copied.

Avoiding name conflicts during pasting 
When pasting copied blocks with identical names to already existing blocks, the following 
mechanisms are used to avoid name conflicts:

● Pasting the copied block into the same CPU:
The copy of the block gets a name that is extended by a number. For example, if block "A" 
is copied, a possible name for the copy is "A_1". Consecutive numbering is not used, but 
rather the smallest free number. The copy of block "A" can also get the name "A_25", if no 
lower number is available.

● Pasting the copied block into another CPU:
A dialog box opens in which you can select whether the block with the same name will be 
replaced or the copied block will be pasted with a duplicate designation (Name_Number).
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 Note
Number conflicts

Number conflicts may occur, if the pasted block has the same block number as an existing 
block. The block number is not automatically changed during pasting. This double number 
may have an effect on block calls. When you copy blocks you should therefore check the 
block number carefully and correct duplicate block numbers manually or using the block 
properties. Duplicate block numbers lead to a compilation error.

 

See also
Copying blocks (Page 1205)

Pasting blocks (Page 1205)

Copying blocks

Requirement
The "Program blocks" folder is opened in the project tree.

Procedure
To copy a block, follow these steps:

1. Right-click the block that you want to copy.

2. Select "Copy" in the shortcut menu.

Result
A copy of the block is now on the clipboard and can be pasted either into the same CPU or 
into another one. 

See also
Basics of copying and pasting blocks (Page 1202)

Pasting blocks (Page 1205)

Pasting blocks

Requirement
You have copied a block.
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Procedure 
To paste a copied block and its data into a CPU, follow these steps:

1. In the project tree, open the folder structure for the CPU into which you want to paste the 
copied block.

 

  Note

Please note that you can only paste the copied block into a CPU which supports the block 
programming language and type.

 

2. Right-click on the "Program blocks" folder.

3. Select "Paste" in the shortcut menu.

– If you are pasting the block into the same CPU as the original block, "_<consecutive 
number>" will be appended to the name of the copy.

– If you are pasting the block into a different CPU where a block of the same name already 
exists, the "Paste" dialog box opens. Select the required option and confirm with "OK".

 

See also
Basics of copying and pasting blocks (Page 1202)

Copying blocks (Page 1205)

Entering a block title
The block title is the title of the block. It is not the same thing as the block name, which was 
assigned when the block was created. The length of the block title is restricted to one row. You 
can enter the block title for open and closed blocks.

Requirement  
A code block is available.

Enter block title for open block
To insert the block title in an open block, follow these steps:

1. Click on the title bar of the block in the program editor.

2. Enter the block title.

Enter block title for closed blocks
To insert the block title in a closed block, follow these steps:

1. Right-click the block in the project tree.

2. Select the "Properties" command in the shortcut menu.
The dialog with the properties of the block opens.
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3. Select the entry "Information" in the area navigation.

4. Enter the block title in the "Title" input field.

5. Confirm your entry with "OK".

See also
Creating organization blocks (Page 1197)

Creating functions and function blocks (Page 1198)

Entering a block comment (Page 1207)

Entering a block comment
You can use the block comment to document the entire code block. For example, you can 
indicate the purpose of the block or draw attention to special characteristics. You can enter 
the block comment for open and closed blocks.

Requirement  
A code block is available.

Enter block comment for open blocks
To insert a block comment in an open block, proceed as follows:

1. Click the small arrow in front of the block title.
The right arrow becomes a down arrow, and the comment area is displayed.

2. Click "Comment" in the comment area.
The "Comment" text passage is selected.

3. Enter the block comment.

Enter block comments for closed blocks
To insert the block comment in a closed block, follow these steps:

1. Right-click the block in the project tree.

2. Select the "Properties" command in the shortcut menu.
The dialog with the properties of the block opens.

3. Select the entry "Information" in the area navigation.

4. Enter the block comment in the "Comment" input field.

5. Confirm your entry with "OK".
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See also
Creating organization blocks (Page 1197)

Creating functions and function blocks (Page 1198)

Entering a block title (Page 1206)

9.1.3.2 Specifying block properties

Basics of block properties 

Block properties  
Each block has certain properties, which you can display and edit. These properties are used 
amongst other things to:

● Identify the block

● Display the memory requirements and the compilation status of the block

● Display the time stamp

● Display the reference information

● Specify the access protection

See also
Overview of block properties (Page 1208)

Block time stamps (Page 1211)

Displaying and editing block properties  (Page 1213)

Setting the mnemonics (Page 1229)

Overview of block properties

Overview
The properties of the blocks are block and CPU-specific. Not all properties are therefore 
available for all blocks or in all CPU families. The following table gives an overview of block 
properties:

Group Property Description
General Name Unique block name within the station 

Constant name Name of the constant pasted for the OB in the PLC tag table 
Type Block type (cannot be changed)
Number Block number
Event class Event class of an OB (cannot be changed)
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Group Property Description
Language Programming language of the block
Language in networks Language used to program conditions in GRAPH blocks.
Process image partition number Display of the process image partitions that are assigned to the 

organization block (cannot be changed)
ARRAY data type Data type of an ARRAY data block (cannot be changed)
ARRAY limit High limit of an ARRAY data block

The "Move operations" section of the "Instructions" task card 
offers options for addressing of ARRAY data blocks.

Information Title Block title
Comment Block comment
Version Version number of the block
Family Block family name
Author Name of the author, company name, department name, or other 

names
User-defined ID ID created by the user

Time stamps Block Times of creation and time of change of the block (cannot be 
changed)

Interface Time of creation of the block interface (cannot be changed)
Code Code modification time (non-editable)
Data Data modification time (non-editable)

Compilation Status Details of the last compilation run (cannot be changed)
Lengths Details of the block lengths (cannot be changed)

Protection Protection Setting up know-how protection and copy protection for the block
See also: Protecting blocks

Attributes Optimized block access The tag declaration for blocks with optimized access contains 
only the symbolic names of the data elements. The system 
automatically optimizes and manages the addresses. The CPU 
performance increases and access errors, for example, from 
SIMATIC HMI, are prevented.
See also: Auto-Hotspot

IEC check The compatibility of the operands in comparison operations and 
arithmetic operations are tested according to IEC 61131. You 
have to explicitly convert non-compatible operands.
See also: Overview of data type conversion (Page 1123)

Handle errors within block Troubleshooting inside the block with the GET_ERROR or 
GET_ERR_ID instruction (cannot be changed).
See also: Auto-Hotspot

Create extended status 
information

Allows you to monitor all tags in an SCL block. This option does, 
however, increase the program memory space required and the 
execution times.

Check ARRAY limits Checks whether array indexes are within the range declared for 
an ARRAY during the runtime of an SCL block. The block enable 
output ENO is set to "0" if an array index is outside of the permitted 
range.

Set ENO automatically Checks whether errors occur in the processing of certain 
instructions during the runtime of an SCL block. The block enable 
output ENO is set to "0" if a runtime error occurs.
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Group Property Description
Create minimized DB Creates instance data blocks for GRAPH blocks of the S7-300 

and S7-400 in minimized format. This option reduces the GRAPH 
FB memory space required, however you will only receive limited 
program status information.

Skip steps If the transitions before and after a step become valid 
simultaneously in a GRAPH block, the step will not be activated 
and will be skipped.

Acknowledge supervision alarms Any supervision error which occurs during the operation of a 
GRAPH block must be acknowledged before the program can 
continue.

Permanent processing of all 
interlocks in manual mode

Permanently monitors all interlock conditions in a GRAPH block 
in manual mode. 

Lock operating mode selection Prevents a GRAPH block operating mode being selected.
Data block write-protected in the 
device

Indicates whether the data block is read-only in the target system, 
and cannot be overwritten while the program is running (for data 
blocks only)

Only store in load memory On activation the data block is stored only in the load memory, 
occupies no space in the work memory, and is not linked into the 
program. The "Move operations" section of the "Instructions" task 
card offers options for transferring data blocks to the work 
memory (for data blocks only).

Start information Here you specify the structure of the start information of the OB 
for S7-1500 CPUs:  either like for S7-300 and S7-400 CPUs or 
optimized start information.

Priority Shows the priority set for organization blocks. The CPU family 
used and the type of the organization block determine whether 
you can change the priority.

Parameter assignment by means 
of registers

Enables parameter input by means of registers in an STL block 
of S7-1500. This feature allows you to use the "Conditional call 
of blocks" (CC) and "Unconditional call of blocks" (UC) 
instructions in the block.

Block can be used as know-how 
protected library item

Shows whether or not the block in the library can be used with 
know-how protection.

Enable readback Enables you to mark individual parameters of the block for 
readback. The "Tag readback" function is relevant if the block is 
used in a CFC chart.

Block representation Specifies how the block is represented in a CFC chart.
Time-of-day interrupt Time-of-day interrupt Parameters of the time-of-day interrupt OB: active (yes or no), 

execution, start date and time, local time or system time 
Cyclic interrupt Cyclic interrupt Cycle time and phase shift of the cyclic interrupt OB
Triggers Triggers Display of start events of the hardware interrupt OB
Isochronous mode Isochronous mode Parameters of the isochronous mode interrupt OB: application 

cycles, automatic setting (yes or no), delay time.
Also indicated is the PROFINET IO system or DP master system 
whose IO devices or DP slaves are assigned to the isochronous 
mode interrupt OB.

Download without re-
initialization

Reserve in volatile memory Defines the reserve in volatile memory that can be used for 
interface extensions.
The number of currently available bytes is displayed in 
parentheses. This information is updated with each compilation.
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Group Property Description
Activate download without re-
initialization for retentive tags

Enables definition of a reserve in retentive memory.

Reserve in retentive memory Defines the reserve in retentive memory that can be used for 
interface extensions.
The number of currently available bytes is displayed in 
parentheses. This information is updated with each compilation.

See also
Basics of block properties  (Page 1208)

Block time stamps (Page 1211)

Displaying and editing block properties  (Page 1213)

Basics of block access (Page 1027)

Block time stamps

Introduction  
Blocks receive a number of different time stamps which show you when the block was created 
and when it was last changed. These time stamps are also used for automatic consistency 
checks before compilation. 

Code block time stamps
The following time stamps are generated for code blocks (OBs, FBs, FCs):

● Block: Created on, Modified on

● Interface: Modified on

● Code/data: Modified on

A time stamp conflict is displayed during compilation if the time stamp for the block calling is 
older than that of the interface for the block called.

Time stamps for code blocks are updated as follows:

● Block: The time stamp for the last block modification is always the same as the time stamp 
either of the interface or of the code depending on which area was modified last.

● Interface: The interface time stamp is updated each time the interface is modified. Even if 
you manually undo a change to the interface, for example change the name back, that is 
also a change which updates the time stamp. However, if you undo the change using the 
"Undo" function, the time stamp will be reset to the value it had before the undone change.

● Code/data: The code time stamp is updated each time the block code is changed. Even if 
you manually undo a change to the code, for example remove an instruction, that is also a 
change which will update the time stamp. However, if you undo the change using the "Undo" 
function, the time stamp will be reset to the value it had before the undone change.
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Global data block time stamps
The following time stamps are generated for global data blocks:

● Block: Created on, Modified on

● Interface: Modified on

● Data: Modified on

Time stamp conflict is reported during compilation of a global data block based on a PLC data 
type if the time stamp of the global data block is older than the time stamp of the PLC data 
type used.

The time stamps for global data blocks are updated as follows:

● Block: The time stamp for the last change to a global data block is always the same as the 
time stamp for the interface and the data.

● Interface and data: The interface time stamps and the data are updated each time the global 
data block is changed. Even if you manually undo a change, for example remove a tag, 
that is also a change which will update the time stamp. However, if you undo the change 
using the "Undo" function, the time stamps will be reset to the value they had before the 
undone change.

Instance data block time stamps
The following time stamps are generated for instance data blocks:

● Block: Created on, Modified on

● Interface: Modified on

● Data: Modified on

A time stamp conflict will be reported during compilation of an instance data block if the 
interface time stamps of the instance data block are not identical to those of the function block. 

The time stamps for instance data blocks are updated as follows:

● Block: The time stamp for the last change to an instance data block is always the same as 
the time stamp for the interface and the data.

● Interface and data: The interface time stamps and the data are updated each time the 
instance data block is changed. Even if you manually undo a change, for example cancel 
the tag retain setting, that is also a change which will update the time stamps. However, if 
you undo the change using the "Undo" function, the time stamps will be reset to the value 
they had before the undone change.

PLC data type time stamps
The following time stamps are generated for PLC data types:

● Block: Created on, Modified on

● Interface: Modified on

The time stamps for PLC data types are updated as follows:
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● Block: The time stamp for the last change to a PLC data type is always the same as the 
interface time stamp.

● Interface: The interface time stamp is updated each time the PLC data type is changed. 
Even if you manually undo a change, for example delete the content of a PLC data type, 
that is also a change which will update the time stamp. However, if you undo the change 
using the "Undo" function, the time stamp will be reset to the value it had before the undone 
change.

 

See also
Basics of block properties  (Page 1208)

Overview of block properties (Page 1208)

Displaying and editing block properties  (Page 1213)

Basic information on compiling blocks (Page 1438)

Displaying and editing block properties 
The properties of the blocks are block and CPU-specific. Not all properties are therefore 
available for all blocks or in all CPU families. Properties that can only be displayed are write-
protected.

Displaying and editing properties of a closed block     
To display and edit the properties of a closed block, follow these steps:

1. Open the "Program blocks" folder in the project tree.

2. Right-click the block whose properties you want to display or edit.

3. Select the "Properties" command in the shortcut menu.
The properties dialog box of the block opens.

4. In the area navigation, click a group whose properties you want to display or edit.

5. Change the relevant property.

6. Confirm your entries with "OK".

Displaying and editing properties of an open block
To display or edit the properties of an open block, follow these steps:

1. Select the "Inspector window" check box in the "View" menu.
The Inspector window opens.

2. Click the "Properties" tab.
The properties of the block are shown in the "Properties" tab of the Inspector window.

3. In the area navigation, click a group whose properties you want to display or edit.

4. Change the relevant property.
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Result
The properties of the block will be changed. The changes are not saved until the project is 
saved. 

See also
Basics of block properties  (Page 1208)

Overview of block properties (Page 1208)

Block time stamps (Page 1211)

9.1.3.3 Managing blocks

Opening blocks
You can open a block in several different ways:

● Open block directly
You can open a block directly if the corresponding block folder is open in the project tree 
or in the overview window.

● Find and open block
You can look for blocks within a project, a device or the "Program blocks" folder and then 
open them.

Open block directly
To open a block directly, follow these steps:

1. Open the folder with the block you wish to open in the project tree or in the overview window.

2. Double-click on the block you wish to open.

Find and open block
To find and then open a block, follow these steps:

1. Right-click on the project, a device, the "Program blocks" folder or a lower-level folder of 
"Program blocks" in the project tree.

2. Select the "Search in PLC and open" command from the shortcut menu.
The "Search in PLC and open" dialog box is displayed.

3. Enter the name, the address or the type of block you are looking for. 
The block list is filtered further with each letter entered. The block list is closed if there is 
no block that matches the input. You can show the complete block list at any time by clicking 
the button to the right of the text box. Keep in mind that there is no filtering in this case. If 
you want to filter for your inputs again, click the button once again.

4. In the block list, click the block you wish to open.
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Result
The block will open in the program editor. 

See also
Saving blocks (Page 1215)

Closing blocks (Page 1215)

Renaming blocks (Page 1216)

Deleting blocks offline (Page 1217)

Deleting blocks online (Page 1217)

Opening know-how protected blocks (Page 1457)

Saving blocks
Blocks are always saved together with the project. Faulty blocks can also be saved. This allows 
the error to be resolved at a convenient time. 

Procedure 
To save a block, follow these steps:

1. Select the "Save" or "Save as" command in the "Project" menu.
See also: Saving projects (Page 264)

See also
Opening blocks (Page 1214)

Closing blocks (Page 1215)

Renaming blocks (Page 1216)

Deleting blocks offline (Page 1217)

Deleting blocks online (Page 1217)

Closing blocks

Procedure
To close a block, follow these steps:

1. Click the "Close" button in the title bar of the program editor.
 

 Note

Note that the block will not be saved on closing.
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See also
Opening blocks (Page 1214)

Saving blocks (Page 1215)

Renaming blocks (Page 1216)

Deleting blocks offline (Page 1217)

Deleting blocks online (Page 1217)

Renaming blocks

Requirement
The "Program blocks" folder is opened in the project tree.

Procedure
To change the name of a block, follow these steps:

1. Right-click the block that you want to rename.

2. Select the "Rename" command in the shortcut menu.
The block name in the project tree changes to an input field.

3. Input the new name for the block.

4. Confirm your entry with the Enter key.

Result
The name of the block is now changed at all points of use in the program.

 

See also
Opening blocks (Page 1214)

Saving blocks (Page 1215)

Closing blocks (Page 1215)

Deleting blocks offline (Page 1217)

Deleting blocks online (Page 1217)

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1216 System Manual, 07/2013,  



Deleting blocks offline

Requirement   
The "Program blocks" folder opens in the project tree.

Procedure
To delete a block that exists offline, proceed as follows:

1. In the project tree in the "Program blocks" folder, right-click on the block that you want to 
delete.

2. Select the "Delete" command in the shortcut menu.

3. Confirm the safety prompt with "Yes".
The block is deleted offline from the project.

 

 Note

If you are deleting organization blocks, note that events may be assigned to these blocks. If 
you delete such organization block the program cannot respond to parameterized events.

 

See also
Opening blocks (Page 1214)

Saving blocks (Page 1215)

Closing blocks (Page 1215)

Renaming blocks (Page 1216)

Deleting blocks online (Page 1217)

Deleting blocks online

Requirement   
The "Program blocks" folder in the project tree is open.

Procedure
To delete a block that exists online, follow these steps:

1. In the "Program blocks" folder in the project tree, right-click on the block that you wish to 
delete from the device.

2. Select the "Delete" command from the shortcut menu.
The "Delete" dialog opens.
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3. Select the "Delete from device" check box.

4. Click "Yes".
The block will be deleted from the device online. 

See also
Opening blocks (Page 1214)

Saving blocks (Page 1215)

Closing blocks (Page 1215)

Renaming blocks (Page 1216)

Deleting blocks offline (Page 1217)

Deleting CPU data blocks
You may delete CPU data blocks both in offline and online mode. 

Deleting CPU data blocks in offline mode  
Proceed as follows to delete a CPU data block from the offline project:

1. Right-click the CPU data blocks that you want to delete in the project navigation, "Program 
blocks" folder.

2. Select the "Delete" command from the shortcut menu.

3. Confirm the safety prompt with "Yes".
The CPU data block is deleted from the offline project.

Deleting CPU data blocks in online mode
Proceed as follows to delete a CPU data block from the online project:

1. Establish an online connection to the device containing the CPU data block that you want 
to delete.

2. Right-click the CPU data block that you want to delete from the device in the project 
navigation, "Program blocks" folder.

3. Select the "Delete" command from the shortcut menu.
The "Delete" dialog opens.

4. Select the "Delete from device" check box.

5. Click "Yes".
The CPU data block is deleted from the online device. 

 

See also
CPU data blocks (Page 1026)
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9.1.4 Programming blocks

9.1.4.1 Program editor

Overview of the program editor

Function of the program editor  
The program editor is the integrated development environment for programming functions, 
function blocks, and organization blocks. If offers comprehensive support for programming 
and troubleshooting. 

The appearance and functionality of the program editor can vary depending on the CPU, 
programming language and block type used. 

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1219



Structure of the program editor  
Using LAD as an example, the following figure shows the components of the program editor:

① Toolbar 
② Block interface 
③ "Favorites" pane in the "Instructions" task card and favorites in the program editor 
④ Programming window 
⑤ "Instructions" task card 
⑥ "Testing" task card 
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Toolbar  
The toolbar allows you to access the principal functions of the program editor, such as:

● Show and hide absolute operands

● Showing and hiding favorites

● Skip to syntax errors

● Update block calls

● Show and hide program status

The functions available in the toolbar can vary depending on the programming language used. 

Block interface  
The block interface contains the declarations for local tags used solely within the block. The 
sections available depend on the block type.

Favorites  
You can save frequently used instructions as favorites. These favorites are then displayed in 
the "Instructions" task card and the "Favorites" pane. You can also display favorites in the 
program editor using the program editor toolbar. This allows you to access your favorites even 
when the "Instructions" task card is not visible.

Programming window  
The programming window is the work area of the program editor. You can enter the program 
code in this window. The appearance and functionality of the program window can vary 
depending on the programming language used. 

"Instructions" task card  
The "Instructions" task card offers you easy access to all instructions available for creating 
your program. The instructions are broken down by area into a number of different palettes. 
You can show additional information on the instructions via the "Show column headers and 
additional columns" button in the task card toolbar. You can modify the arrangement of columns 
by clicking a column header and moving the column to the new position by means of drag-and-
drop.

If an instruction profile is active, the offered instructions may vary.
See also: Using instruction profiles

"Testing" task card  
You can set settings in the "Testing" task card for troubleshooting using the program status. 
The functions of the "Testing" task card are only available in online mode. It contains the 
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following panes, which are displayed depending on the selected CPU and the configured 
programming language of the block:

● CPU operator panel
The CPU operator panel allows you to switch the CPU operating mode. 

● Breakpoints
You can test blocks you created in the textual programming languages STL and SCL in 
single step mode. To do this, set breakpoints in the program code.
In the "Breakpoints" pane, you can find all breakpoints that you have set and you can 
activate, delete, navigate to, or set the call environment for the individual breakpoints.

● PLC register
This pane allows you to read off the values for the PLC registers and the accumulators.

● Sequence control
In this pane you can set the operating mode for testing sequencers for GRAPH blocks.

● Test settings
This pane allows you to specify the test settings for the GRAPH block.

● Call environment
This pane allows you to specify the call environment for the block.

● Call hierarchy
In this pane, you can trace the call hierarchy of the blocks. You only see the call hierarchy 
during block monitoring.

 

See also
Layout of the block interface (Page 1239)

Enlarging the programming window (Page 1227)

Using the keyboard in the program editor

Navigating in the editor

Function Shortcut key
Open "Instructions" task card <Ctrl+Shift+C>
Open "Testing" task card <Ctrl+Shift+O>
Add new block <Ctrl+N>
Expand all networks <Alt+F11>
Collapse all networks <Alt+F12>
Navigate to the next point of use of the selected block or operand <Ctrl+Shift+F>
Navigate to the previous point of use of the selected block or 
operand

<Ctrl+Shift+G>

Navigate to the next read/write access <Alt+F8>
Navigate to the previous read/write access <Alt+F9>
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Navigating in the program code (LAD/FBD)

Function Selected object Shortcut key
Navigating between objects in the network Object in the network Arrow keys
Navigate to the first element of the network Object in the network <Home>
Navigate to the last element of the network Object in the network <End>
Navigate to the next element of the network Object in the network <Tab>
Navigate to the previous element of the network Object in the network <Shift+Tab>
Insert network Any <Ctrl+R>

Navigating in the program code (STL/SCL) 

Function Position of the cursor Shortcut key
Navigating in the program code Line Arrow keys
One word to the right/left Line <Ctrl+arrow keys>
Cursor to start of line Line <Home>
Cursor to end of line Line <End>
Cursor to start of code section Line <Ctrl+Home>
Cursor to end of code section Line <Ctrl+End>
To the next network (STL only) Network title <Down arrow>
To the next network (STL only) Line <Tab>

Repeat the shortcut keys 
until the insertion point is 
in the next network.

To the previous network (STL only) Network title <Up arrow>
To the previous network (STL only) Line <Shift+Tab>

Repeat the shortcut keys 
until the insertion point is 
in the previous network.

Insert network Any <Ctrl+R>

Inserting instructions (LAD)

Function Selected object Shortcut key
Insert normally open contact Rung <Shift+F2>
Insert normally closed contact Rung <Shift+F3>
Insert empty box Rung <Shift+F5>
Insert assignment Rung <Shift+F7>
"Insert "Open branch" Rung <Shift+F8>
"Insert "Close branch" Rung <Shift+F9>
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Inserting instructions (FBD)

Function Selected object Shortcut key
Insert assignment Network, input or 

output
<Shift+F7>

Insert empty box Network <Shift+F5>
"Insert "Open branch" Connection line 

between two boxes
<Shift+F8>

Invert RLO Network, input or 
output

<Ctrl+Shift+4>

Insert input Network, input or 
output

<Ctrl+Shift+3>

Entering operands (LAD/FBD/GRAPH)

Function Selected object Shortcut key
Activate the input field for the first operand of the 
instruction

Instruction <Return>
Or
<Any letters/numbers> 
An empty input field opens 
on <Return>, any letters or 
numbers will be entered in 
the input field.

Activate input field for the operand Operand <F2>
Delete operand Operand <Del>
Define tag Operand <Ctrl+Shift+I>
Rewire tag Operand <Ctrl+Shift+P>
Rename tag Operand <Ctrl+Shift+T>
Entering operands Input field for 

operands
<Any letters/numbers>

Confirm entry of the operand Input field for 
operands

<Return>

Open autocompletion
 

Input field for 
operands

<Ctrl+I>

Discard current change Input field for 
operands

<Esc> 
The input field is 
deactivated and the 
previous contents restored.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1224 System Manual, 07/2013,  



Process instructions (STL/SCL)

Function Selected object Shortcut key
Indent line (SCL only) Line <Tab> or

<Ctrl+R>
Outdent line (SCL only) Line <Shift+Tab> or

<Ctrl+Shift+R>
Open "Call options" dialog Cursor after block call <Return>
Define tag Operand <Ctrl+Shift+I>
Rewire tag Operand <CtrlShift+P>
Rename tag Operand <Ctrl+Shift+T>
Expand/collapse parameter list (SCL only) Operand <Ctrl+Shift+Space>
Expand/collapse code section Insertion mark within 

the code section
<Ctrl+Shift+Num+>
<Ctrl+Shift+Num->

Expand/collapse all code sections Any <Ctrl+Shift+Num*>
<Ctrl+Shift+Num/>

Open autocompletion
 

Any <Ctrl+I> or <Ctrl+Spacebar>

Set/delete bookmarks  <Ctrl+Shift+M>
To the next bookmark  <Ctrl+Shift+6>
To the previous bookmark  <Ctrl+Shift+5>
Disable code Line <Ctrl+Shift+Y>
Enable code Line <Ctrl+Shift+U>

Programming window of GRAPH
 

Function Area Shortcut key
Page Up/Down Navigation view, 

single step view, 
sequence view, 
permanent 
instructions

<Page Up>/
<Page Down>

Navigate in the navigation view Navigation view <Up arrow>
<Down arrow>

Expand/collapse object Navigation view <+> or <Right arrow>
<-> or <Left arrow>

Switch between single step view and sequence 
view when a step or a transition is selected

Navigation view <Return>

Switch between navigation view and work area Navigation view, 
single step view, 
sequence view, 
permanent 
instructions

<ALT+F6>

Go to first element in a network Single step view <Home>
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Function Area Shortcut key
Go to last element in a network Single step view <End>
Switch to interlock Single step view <Ctrl+Home>
Switch to transition Single step view <Ctrl+End>
Navigate in the structure Sequence view Arrow keys
Go to first step Sequence view <Home> or <Ctrl+Home>
Go to last step Sequence view <End> or <Ctrl+End>
Open branch Sequence view <Shift+F8>
Close branch Sequence view <Shift+F9>
Insert sequence end Sequence view <Shift+F7>
Insert jump Sequence view <Shift+F12>
Insert step and transition Sequence view <Shift+F5>
Delete element Sequence view <Del>
Go to first editable element Permanent 

instructions
<Home>

Go to next editable element Permanent 
instructions

<Tab>

Go to last editable element Permanent 
instructions

<End>

Go to previous editable element Permanent 
instructions

<Shift+Tab>

Jump to the start of the "Action" cell Actions <Home>
Jump to the end of the "Action" cell Actions <End>
Insert new action Actions <Return>

Monitor program 

Function Shortcut key
Set/remove breakpoint (STL, SCL) <Ctrl+Shift+F9>
Step over breakpoint (STL, SCL) <Ctrl+Shift+F10>
Jump to lower-level block (STL, SCL) <Ctrl+Shift+F11>
Return to calling block (STL, SCL) <Ctrl+Shift+F12>
Run program up to marker (cursor position) (STL, SCL) <Ctrl+F3>
Display program status (SCL, STL) <Ctrl+T>
Enable all breakpoints (STL, SCL) <Ctrl+Shift+F2>
Disable all breakpoints (STL, SCL) <Ctrl+Shift+F3>
Modify to 0 (LAD, FBD) <Ctrl+Shift+9>
Modify to 1 (LAD, FBD) <Ctrl+Shift+1>
Modify operand (LAD, FBD) <Ctrl+Shift+2>
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See also
Keyboard operation in the TIA Portal (Page 234)

Using project-related functions (Page 236)

Arranging windows (Page 236)

Editing tables (Page 242)

Text editing (Page 241)

Enlarging the programming window

Introduction 
The programming window is relatively small when all components of the application are shown. 
If the program code is large, you may find you have to rearrange the work area constantly. To 
avoid this problem, you can hide or minimize the display of the following components of the 
application and of the program editor:

● Project tree

● Task cards

● Block interface

● Favorites

● Comments

● Networks
 

 Note

You can also use the "Reduce automatically" option for the task cards, project tree, and 
Inspector window. These windows will then be minimized automatically when you do not need 
them. 

See also: Maximizing and minimizing the work area
 

Hiding and showing the project tree  
The project tree allows you to access all areas of the project. You can hide the project tree 
while you are creating a program so you have more space for the programming window. 

To show and hide the project tree, follow these steps:

1. To hide the project tree, deselect the "Project tree" check box in the "View" menu, or click 
on "Collapse" on the project tree title bar.

2. To show the project tree, select the "Project tree" check box in the "View" menu or click on 
"Extend" on the project tree title bar.
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Opening and closing task cards
The task cards are located at the right-hand edge of the programming window. 

To open or close the task cards, follow these steps:

1. To close the task cards, deselect the "Task card" check box in the "View" menu or click 
"Collapse" on the task cards title bar.

2. To open the task cards, select the "Task card" check box in the "View" menu or click 
"Expand" on the task cards title bar.

Hiding and showing the block interface  
The block interface is shown in the upper section of the program editor. During programming 
you can show and hide it as required.

To show and hide the block interface, follow these steps:

1. In the lower part of the interface within the window splitter, click on the Up arrow or Down 
arrow.

Showing and hiding favorites  
To hide or show the favorites in the program editor, follow these steps:

1. Click the "Display favorites in the editor" button in the program editor toolbar.

Showing and hiding comments    
Within a block you can enter a comment for the block or for each network. These two types of 
comments are shown and hidden differently.

To show or hide a block comment, follow these steps:

1. Click the the triangle at the start of the line with the block title.

To show or hide network comments, follow these steps:

1. Click "Network comments on/off" on the program editor toolbar.
 

 Note

The comments available can vary depending on the programming language used. 
 

Opening and closing networks
Some programming languages use networks. You can open or close these networks as 
required.

To open or close networks, follow these steps: 

1. If you want to open a network, click the right arrow in front of the network title. If you want 
to close a network, click the down arrow in front of the network title.

To open and close all networks, follow these steps:
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1. Click "Open all networks" or "Close all networks" in the program editor toolbar.
 

 Note

Networks are not used in every programming language. 
 

See also
Overview of the program editor (Page 1219)

Maximizing and minimizing the work area (Page 213)

Setting the mnemonics
You can program blocks using German or international mnemonics. If you open the TIA portal 
for the first the international mnemonics is set as default. You can change the mnemonics at 
any time.

Procedure  
To set the mnemonics, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group in the area navigation.

3. In the "General settings" group, select the mnemonics that you want to use.
The mnemonics is changed in all blocks.

Displaying symbolic and absolute addresses
You have the following options for displaying operands in the program editor:

● Symbolic representation
The symbolic operands are displayed in the program. The corresponding absolute 
addresses are shown in tooltips if you hold the mouse pointer over the operand.

● Absolute representation
The absolute addresses are displayed in the program. The corresponding symbolic 
operands are displayed in tooltips.

● Symbolic and absolute representation
Symbolic operands and absolute addresses are displayed in program.

Requirement
The program editor is open.
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Procedure 
To change the representation of the operands, follow these steps:

1. Click the "Absolute/symbolic operands" button in the program editor toolbar.
Each time you click the button, the representation and the symbol on the button change.

Or:

1. Click the small arrow next to the "Absolute/symbolic operands" button in the program editor 
toolbar.
A drop-down list is displayed.

2. Select the required representation from the drop-down list.
The symbol on the button changes. 

 

See also
Basic information about operands (Page 1049)

Use instruction versions

Basic information on instruction versions   
The instructions available to you for programming the user program are managed in system 
libraries. If a new version of a system library is installed by an update, the newer versions of 
the instructions of this system library may also be installed. 

If there are several versions for an instruction, these are listed in the "Instructions" task card 
after the respective instruction. If the instruction versions are not shown, you can show them 
via the "Show column headers and additional columns" button in the toolbar of the 
"Instructions" task card. You can then select the versions of the instructions to be used in the 
program from the dropdown-list box of the "Version" column. If you do not select any versions, 
the most recent versions are used. 

 

 Note

Please note the following:
● You can only ever use the same version of an instruction within a device.
● If you change the version of an instruction that other instructions depend on, the versions 

of the dependent instructions are also changed.
● If you select a version for an instruction that can not be run on the CPU used, the instruction 

is shaded out. This means that you cannot use this instruction in this version with your 
CPU.

● When you change the version of an instruction, you must compile the block before the 
new version number is displayed in the properties of the instruction. 
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Changes in the versions
New versions can be main versions or secondary versions. New versions, such as 2.0 or 3.0, 
have more substantial changes to them. New main versions may therefore result in changes 
to the block interface. New secondary versions, such as 1.3 or 1.4, contain lesser changes or 
remedies to errors. 

Using instruction versions
You can decide within a device which version of an instruction you want to use. If you select 
another version for an instruction, the new version is specified for all locations of use of this 
instruction within your program. These instructions are identified in the program by a red frame. 
You must then download your program to the device to use the new instruction version. 

Using instruction profiles

Basics of instruction profiles

Introduction 
The TIA Portal provides you with numerous instructions that you can use to program the user 
program. However, you may filter out specific instructions that you do not want to use. To this 
end you can create instruction profiles in which you can explicitly specify the instructions to be 
listed in the "Instructions" task card. However, although you may create several instruction 
profiles in a project, only one of these profiles may be active at any given time. You can 
exchange instruction profiles with other users by means of shared libraries.

 

 Note

Please note the following:
● The use of instructions that are not allowed in the active profile in a block will trigger the 

output of a block compilation error. Such a situation may be triggered if you drag-and-drop 
a block from the library to your program.

● Instructions of a profile that are not supported by the currently installed products are 
deleted from the profile the next time it is edited. If you transfer this profile to an engineering 
system in which these instructions are supported by the installed products, the instructions 
are again present in the profile but they are disabled. You can enable these instructions 
as required at any time.

● If you want to make changes to the active profile, you must recompile the blocks in the 
project. This is also necessary when you disable or delete the active profile or when you 
enable a profile.
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See also
Creating new instruction profiles (Page 1232)

Opening and editing instruction profiles (Page 1233)

Activating and deactivating instruction profiles (Page 1234)

Deleting instruction profiles (Page 1235)

Creating new instruction profiles

Requirement
The "Common data > Instruction profiles" folder is open in the project navigation.

Procedure
Proceed as follows to create a new instruction profile:

1. Double-click the "Add new profile" command.
The Instruction Profile Editor opens and displays the new instruction profile. All instructions 
are activated for the new instruction profile.

2. Edit the new instruction profile to suit your requirements.

If necessary, you can rename the new instruction profile. To do this, follow these steps:

1. Right-click on the new instruction profile.

2. Select the "Rename" command in the shortcut menu.

3. Enter a name for the new instruction profile. 
 

 Note

The first instruction profile that you create will be used as active profile. In this case, compile 
all blocks in the project. If other instruction profiles are already available you must explicitly 
activate the new one in order to use it as active profile. You can identify the active profile by 
its icon in the project navigation.

 

See also
Basics of instruction profiles (Page 1231)

Opening and editing instruction profiles (Page 1233)

Activating and deactivating instruction profiles (Page 1234)

Deleting instruction profiles (Page 1235)
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Opening and editing instruction profiles
Once you have opened an instruction profile, you can edit it as follows: 

● Activating and deactivating instructions
You can explicitly specify the instructions to be allowed in the instruction profile.

 

  Note

Note that dependencies exist between some instructions. As a result, it is possible that 
several instructions may be activated or deactivated by an action. The check box icon 
indicates the folders in which instructions are deactivated.

 

● Activating and deactivating instruction versions
Certain instructions are available with different versions. You can explicitly specify the 
instruction versions to be allowed in the instruction profile.

● Renumbering blocks
An instruction representing an internal function block (FB) or function (FC) in the system is 
assigned a specific block number by the system. You can replace this block number with 
your own block number. Within a version, there are several implementations for certain 
instructions. The block numbers in such instructions can only be changed for the specific 
implementation. 

 

  Note

If an instruction from the instruction profile is used in the program and the specified block 
number is already in use by a different block, the specified block number of the instruction 
will be replaced by a free block number. 

 

Requirement
The "Common data > Instruction profiles" folder is open in the project navigation.

Opening instruction profiles
Proceed as follows to open an instruction profile:

1. Double-click the instruction profile that you want to edit.
The  instruction profile opens in the Instruction Profile Editor.

Editing instruction profiles
Proceed as follows to edit an instruction profile in the Instruction Profile Editor:

1. Select the device that you want to edit from the "Device family"  drop-down list box.

2. Select the programming language for which you want to edit the instruction profile from the 
"Language" drop-down list box.

3. Deactivate the instructions or instruction versions that you want to exclude from the 
instruction profile. You can deactivate a folder to deactivate all subordinate instructions.
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4. Activate the instructions or instruction versions that you want to allow in the instruction 
profile.

5. You may assign your own block numbers.
 

  Note

You can assign the number up to 65535 for CPUs of the S7-1200/1500 series. For CPUs 
of the S7300/400 series you find the restrictions of the number ranges in the respective 
CPU manual.

 

 

 Note

A new compilation process is required for all blocks in the project when you change the active 
profile.

 

See also
Basics of instruction profiles (Page 1231)

Creating new instruction profiles (Page 1232)

Activating and deactivating instruction profiles (Page 1234)

Deleting instruction profiles (Page 1235)

Use instruction versions (Page 1230)

Activating and deactivating instruction profiles
You first need to activate an instruction profile in order to include filtering of its instructions. 
You can always deactivate the instruction profile to reset the instructions task card to the default 
scope of instructions.

 

 Note

A new compilation process is required for all blocks in the project.
 

Requirement
The "Common data > Instruction profiles" folder is open in the project navigation.

Activating instruction profiles   
Proceed as follows to activate an instruction profile:

1. Right-click on the instruction profile that you want to activate.

2. Select the "Activate profile" command from the shortcut menu.
The selected instruction profile is now active. Instructions can now only be used in 
accordance with the settings of this profile.
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Deactivating instruction profiles 
Proceed as follows to deactivate the instruction profile:

1. Right-click on the instruction profile that you want to deactivate.

2. Select the "Deactivate profile" command from the shortcut menu.
No instruction profile is active and the "Instructions" task card once again shows all 
instructions that are available for use.

See also
Basics of instruction profiles (Page 1231)

Creating new instruction profiles (Page 1232)

Opening and editing instruction profiles (Page 1233)

Deleting instruction profiles (Page 1235)

Deleting instruction profiles

Requirement
The "Common data > Instruction profiles" folder is open in the project tree.

Procedure
Proceed as follows to delete an instruction profile:

1. Right-click on the instruction profile that you want to delete.

2. Select the "Delete" command in the shortcut menu.
 

 Note

A new compilation process is required for all blocks in the project when you delete the active 
profile.

 

Result
The selected instruction profile is deleted. If you deleted the active instruction profile, no more 
active profiles are available and the "Instructions" task card once again shows all instructions 
that are available for use. 

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1235



See also
Basics of instruction profiles (Page 1231)

Creating new instruction profiles (Page 1232)

Opening and editing instruction profiles (Page 1233)

Activating and deactivating instruction profiles (Page 1234)

Using autocompletion

Basics of autocompletion

Function   
You can use autocompletion in the program window of the program editor as an easy way to 
access available tags or instructions during programming. Autocompletion means a context-
specific list appears in a dialog from which you can select the tags or instructions you need.

See also
Using autocompletion in graphic programming languages (Page 1236)

Using autocompletion in textual programming languages (Page 1237)

Using autocompletion in graphic programming languages

Inserting tags using autocompletion
To insert tags in graphic programming languages using autocompletion, follow these steps:

1. Select an operand of the instruction to which you wish to assign a tag.
The input field for the operand opens. The autocompletion button will appear beside the 
input field.

2. Either click the autocompletion button or use the shortcut <Ctrl+l>.
Autocompletion opens. It contains only the local and global tags, data blocks and multiple 
instances which are admissible for the operand in the given context. You can exit 
autocompletion at any time by pressing <Esc>.
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3. Select the required tag from the list. If necessary, you can also filter the list:

– For example, enter the first few letters of the name of the tag or instruction you wish to 
insert. Autocompletion will be filtered further with each letter entered. If there is no tag 
or instruction starting with the letters entered, autocompletion will remain at the last 
match. 

– Enter # to access the local tags from the block interface.

– Enter " to access the global tags.

– Enter % to access absolute addresses.

If the tag is a structured tag, a data block or a multiple instance, then an arrow is displayed 
at the end of the row. Click on the arrow to display the lower-level elements. You can 
navigate to the very last level in this way. If a structure is allowed as a data type for the 
operand, you can choose "None" from the list. This assigns the entire structure to the 
operand as a tag. Use the <Backspace> key to return to the previous level.

4. Press the <Return> key to apply the tag.

 

See also
Basics of autocompletion (Page 1236)

Using autocompletion in textual programming languages (Page 1237)

Using autocompletion in textual programming languages

Inserting tags and instructions using autocompletion
To insert tags and instructions in textual programming languages using autocompletion, follow 
these steps:

1. Enter the first few letters of the name of the tag or instruction you wish to insert. If necessary, 
you can directly filter the kind of tags:

– Enter # to access the local tags from the block interface.

– Enter " to access the global tags.

– Enter % to access absolute addresses.

Autocompletion opens. It contains only the local and global tags, data blocks, multiple 
instances and instructions which are admissible at the current position. You can exit 
autocompletion at any time by pressing <Esc>. 

2. Enter more letters of the name of the tag or instruction you wish to insert. You can use 
<Enter> or <Tab> to apply the tag or instruction and close autocompletion.
Autocompletion will be filtered further with each letter entered. If there is no tag or instruction 
starting with the letters entered, autocompletion only contains the previous matches. 
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3. Select the tag or instruction required from the list.
If a tag is a structured tag, a data block or a multiple instance, first select the tag, the data 
block or multiple instance from the autocompletion and apply the selection with <Enter>. 
To select the additional components of the structure, data block, or multiple instance, enter 
a period. Autocompletion then reopens and you can select the next component.

4. Press the <Return> key to apply the tag.

See also
Basics of autocompletion (Page 1236)

Using autocompletion in graphic programming languages (Page 1236)

General settings for the PLC programming

Overview of the general settings

Overview
The following table shows the general settings that you can make:

Group Setting Description
View With comments Network comments are shown.

with tag information Additional information for the tags used 
is displayed in the program editor. This 
setting only has an effect on blocks that 
were programmed with LAD, FBD, STL, 
or GRAPH.

Compilation Delete actual parameters on interface 
update

Actual parameters are deleted if the 
associated formal parameters were 
deleted in the called block, and you run 
the "Update block call" function or 
compile the block.

Default settings for new blocks IEC check The compatibility of operands in 
comparison operations and arithmetic 
operations are tested according to IEC 
rules. You have to explicitly convert non-
compatible operands.

Memory reserve for download without 
reinitialization

Memory reserve for new blocks Defines the size of reserve in volatile 
memory that can be used for interface 
extensions.

Additional settings Show autocompletion list The autocomplete list is displayed.
Mnemonics German or international designation of 

operations and operands
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See also
Changing the settings (Page 1239)

Permissible addresses and data types of PLC tags (Page 1176)

Overview of the print settings (Page 202)

Basics of block access (Page 1027)

Setting and canceling the IEC check (Page 1125)

Changing the settings

Procedure
To change the settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Change the settings.

Result
The change will be loaded directly, there is no need to save it explicitly.

See also
Overview of the general settings (Page 1238)

9.1.4.2 Programming code blocks

Declaring the block interface

Layout of the block interface

Introduction         
The interface contains the declarations of local tags that are used within the block. The tags 
are subdivided into two groups:

● Block parameters that form the block interface when it is called in the program.

● Local data that are used for storage of intermediate results.

You use tag declaration to define the call interface of a block in the program and the names 
and data types of tags that you want to use in the block.
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The interface of function blocks also defines the structure of the instances that are assigned 
to the function block.

Layout of the block interface       
The following figure shows the structure of the block interface. The number of columns and 
sections varies depending on the type of block. 

Block parameters
The following table shows the types of block parameters:

Type Section Function Available in
Input parameters Input Parameters whose values are read by the 

block. 
Functions, function blocks and 
some types of organization 
blocks

Output parameters Output Parameters whose values are written by the 
block.

Functions and function blocks

In/out parameters InOut Parameters whose values are read by the 
block when it is called, and whose values are 
written again by the block after execution.

Functions and function blocks

Return value Return Function value that is returned to the calling 
block.

Functions

Depending on the type of block opened, additional sections may be displayed.
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Local data
The following table shows the types of local data:

Type Section Function Available in
Temporary local data Temp Tags that are used to store temporary 

intermediate results. Temporary local data 
are retained for only one cycle. If you use 
temporary local data, you have to make sure 
that the values are written within the cycle in 
which you want to read them. Otherwise the 
values will be random.

Functions, function blocks and 
organization blocks 

Static local data Static Tags that are used for storage of static 
intermediate results in the instance data 
block. Static data is retained until 
overwritten, which may be after several 
cycles. The names of the blocks, which are 
called in this code block as multiple instance, 
will also be stored in the static local data.

Function blocks

Meaning of the columns
The following table shows the meaning of the individual columns. You can show or hide the 
columns as required. The number of columns displayed varies depending on the CPU series 
and the type of the open object.

Column Explanation
Symbol you can click on to drag-and-drop a tag to a program for use 
as an operand.

Name Name of the tags. 
Data type Data type of the tags.
Offset Relative address of the tags. The column is only visible in blocks with 

standard access.
Default value Value with which you can pre-assign specific tags in the interface of 

the code block. 
Specification of the default value is optional. If you do not specify any 
value the predefined value for the indicated data type is used. For 
example, the value "false" is predefined for BOOL.
The default value is assumed as the start value in the corresponding 
instance data block. You can replace these values with instance-
specific start values in the instance data block.
The column is only available in the interface of function blocks.

Retentivity Marks the tag as retentive. 
The values of retentive tags are retained even after the power supply 
is switched off. 
This column is only visible in the interface of the function block with 
optimized access.

Visible in HMI Shows whether the tag is visible by default in the HMI selection list.
Accessible from HMI Shows whether HMI can access this tag during runtime.
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Column Explanation
Setting value Marks the tag as setting value. Setting values are the values that will 

probably have to be fine tuned during commissioning. 
The column is only available in the interface of function blocks.

Comment Comment to document the tags.

See also
Using tags within the program (Page 1049)

Keywords (Page 1051)

Valid data types in the block interface (Page 1243)

Setting the retentivity of local tags (Page 1254)

Rules for declaring the block interface

General rules for declaring the block interface

Using POINTER
The following rules apply to the use of block parameters within the block:

● Input parameters may only be read.

● Output parameters may only be written.

● In/out parameters may be read and written.

Assigning default values to block parameters
You can assign default values to specific parameters in the function block interface. The 
possibility of the assignment depends on the declaration subsection and data type of the 
parameter.

The following table shows which parameters can be assigned a default value:

Parameter type Section Assignment of a default value is possible
Elementary data types Structured data types Parameter types

Input parameters Input X X -
Output parameters Output X X -
In/out parameters InOut X - -
Static local data Static X X -
Temporary local data Temp - - -
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See also
Using tags within the program (Page 1049)

Keywords (Page 1051)

Valid data types in the block interface

Valid data types in the block interface in S7-1200
The following table shows which data types you can assign in the parameters in the individual 
sections of the interface.

Section Standard
Data types

ARRAY
STRUCT
STRING
DT

VOID VARIANT

Organization block
Temp X X - X
Function block
Input X X - X
Output X X - -
InOut X X(1) - X
Static X X - -
Temp X X - X
Function
Input X X(1) - X
Output X X(1) - X
InOut X X(1) - X
Temp X X - X
Return X X X -
(1) STRING can only be defined in the standard length of 254 characters.

Valid data types in the block interface in S7-1500     
The following table shows which data types you can assign in the parameters in the individual 
sections of the interface.

Section Standard
Data 
types

ARRAY
STRUCT
STRING
DT

Paramete
r types

VOID DB_ANY POINTER ANY VARIANT

Organization block
Temp X X -(4) - X - X(3) X
Function block
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Section Standard
Data 
types

ARRAY
STRUCT
STRING
DT

Paramete
r types

VOID DB_ANY POINTER ANY VARIANT

Input X X X - X X X X
Output X X - - X - - -
InOut X X(1) -(4) - X X X X
Static X X - - X - - -
Temp X X -(4) - - - X(3) X
Function
Input X X(1) X - X X X X
Output X X(1) - - X X X X
InOut X X(1) -(4) - X X X X
Temp X X -(4) - X - X(3) X
Return X x - X X X x(2) -
(1) STRING can only be defined in the standard length of 254 characters.
(2) In SCL, ANY is not permissible as return value.
(3) ANY can only be used in blocks with standard access in the "Temp" section.
(4) The "INSTANCE" parameter type is the only exception permissible in the "TEMP" and "InOut" sections.

Declaring local tags

Declaring local tags in the block interface

Requirement   
The block interface is open.

Procedure
To declare a tag of the elementary data type, follow these steps:

1. Select the appropriate declaration section in the interface:

2. Enter a tag name in the "Name" column.

3. Enter the required data type in the "Data type" column. You will be supported by 
autocompletion during input.

4. Optional: Change the properties of the tags that are displayed in the other columns of the 
block interface.

Result
The tag is created. 
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Syntax check
A syntax check is performed after each entry, and any errors found are displayed in red. You 
do not have to correct these errors immediately - you can continue editing and make any 
corrections later. However, you will not be able to compile the program if the tag declaration 
contains syntax errors. 

 

 Note

If you change the interface of a block, the calls of the block in the program will possibly become 
inconsistent. The call locations are automatically updated, if possible.

If an automatic updating is not possible, the inconsistent blocks have to be updated manually. 

See also:

Updating block calls in LAD (Page 1279)

Updating block calls in FBD (Page 1320)
 

See also
Editing tables (Page 242)

Basic information on start values (Page 1392)

Using tags within the program (Page 1049)

Keywords (Page 1051)

Properties of local tags (Page 1253)

Setting the retentivity of local tags (Page 1254)

Declaring local tags in the program editor

Requirement   
The program editor is open. 

Procedure
To declare a local tag, follow these steps:

1. Insert an instruction in your program.
The "<???>", "<??.?>" or "..." strings represent operand placeholders.

2. Replace an operand placeholder with the name of the tag to be created.

3. Select the tag name.
If you want to declare multiple tags, select the names of all the tags to be declared.

4. Select the "Define tag" command in the shortcut menu.
The "Define tag" dialog box opens. This dialog displays a declaration table in which the 
name of the tag is already entered.
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5. To declare a local tag, select one of the following sections:

– Local In

– Local Out

– Local InOut

– Local Static

– Local Temp

6. In the other columns, enter data type and comments.

7. Click the "Define" button to complete your entry.

Result
The declaration is written directly into the block interface and is valid within the entire block.

 

 Note

If you change the interface of a block, the calls of the block in the program will possibly become 
inconsistent. The call locations are automatically updated, if possible.

If an automatic updating is not possible, the inconsistent blocks have to be updated manually. 

See also:

Updating block calls in LAD (Page 1279)

Updating block calls in FBD (Page 1320)
 

 

See also
Editing tables (Page 242)

Using tags within the program (Page 1049)

Keywords (Page 1051)

Basic information on start values (Page 1392)

Properties of local tags (Page 1253)

Setting the retentivity of local tags (Page 1254)

Declaring tags of the ARRAY data type

Requirement     
The block interface is open.
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Procedure
To declare a tag of the ARRAY data type, follow these steps:

1. Select the appropriate declaration section in the interface.

2. Enter a tag name in the "Name" column.

3. In the "Data type" column, click the button for the data type selection.
A list of the permissible data types is opened.

4. Select the "Array" data type.
The "Array" dialog opens.

5. In the "Data type" text box, specify the data type of the array elements.

6. In the "ARRAY limits" text box, specify the high and low limit for each dimension.
Example of a one-dimensional ARRAY:
[0..3]
Example of a three-dimensional ARRAY:
[0..3, 0..15, 0..33]

7. Confirm your entry.

8. Optional: Change the properties of the tags that are displayed in the other columns of the 
block interface.

Result
The tag of ARRAY data type is created. 

 

 Note

You cannot define specific default values for ARRAY elements. However, you can assign 
them start values in the instance.

 

See also
Using tags within the program (Page 1049)

Keywords (Page 1051)

Properties of local tags (Page 1253)

Setting the retentivity of local tags (Page 1254)

Editing tables (Page 242)

Declaring tags of STRUCT data type

Requirement    
The block interface is open.
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Procedure
To declare a tag of the STRUCT data type, follow these steps:

1. Select the appropriate declaration section in the interface:

2. Enter a tag name in the "Name" column.

3. Enter "Struct" in the "Data type" column. You will be supported by autocompletion during 
input.
An empty, indented row is inserted after the new tag.

4. Insert the first structural element in the first empty row.
An additional empty row is inserted after the element.

5. Select a data type for the structure element.

6. Optional: Change the properties of the structural element that is displayed in the other 
columns of the block interface.

7. Repeat the step 4 to 7 for all additional structure elements.
It is not necessary to end the structure explicitly. The structure ends with the last element 
that is entered.

8. To insert a new tag after the structure, leave a blank row after the end of the structure and 
then start the new tag in the second empty row.

Result
The tag of STRUCT data type is created. 

See also
Using tags within the program (Page 1049)

Keywords (Page 1051)

Properties of local tags (Page 1253)

Setting the retentivity of local tags (Page 1254)

Editing tables (Page 242)

Declaring tags based on a PLC data type

Requirement    
A PLC data type is declared in the current CPU.

Procedure
To declare a tag based on a PLC data type, follow these steps:

1. Select the appropriate declaration section in the interface:

2. Enter the PLC data type in the "Data type" column. You will be supported by Autocomplete 
during input.
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Result
The tag is created.

 
 

 Note

You define the default values of tags within a PLC data type when the PLC data type is 
created. You cannot change these values at the point of use of the PLC data type. 

If you change or delete PLC data types that are used in the block interface, the interface 
becomes inconsistent. To remedy this inconsistency, the interface has to be updated.

See also: Updating the block interface (Page 1250)
 

See also
Editing tables (Page 242)

Basics of PLC data types (Page 1409)

Declaring higher-level tags

Introduction     
To access data areas within a declared tag, you can overlay the declared tags with an 
additional declaration. This provides you with the option of addressing an already declared tag 
with a different data type. You can, for example, address the individual bits of a tag of WORD 
data type with an ARRAY of BOOL.

Overlaying tags
To overlay a tag with a new data type, follow these steps:

1. Open the block interface.

2. In the interface, select the tag that you want to overlay with a new data type.

3. Click "Add row" in the toolbar.
A row is inserted after the tag to be overlaid. The overlaying tag must be declared in the 
row directly after the tag that is to be overlaid.

4. Enter a tag name in the "Name" column.

5. Enter the "AT" entry in the "Data type" column. You will be supported by Autocomplete in 
this step.
The following is added to the entry in the "Name" column.
"AT<Name of the higher-level tag>"

6. Click the data type selection button again and select the data type for the new tag.
The tag is created. It points to the same data as the higher-level tag, however interprets 
this data with the new data type.
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Removing overlay
To remove the overlay of a tag, follow these steps:

1. Select the overlaid tag that you want to remove.

2. Select the "Delete" command in the shortcut menu.

3. The overlay is removed.

See also
Editing tables (Page 242)

Overlaying tags with AT (Page 1065)

Declaring multi-instances

Requirement    
● The function block to be called exists in project tree and is multi-instance capable.

● The block interface of the calling function block is open.

Procedure
To declare a function block to be called as a multi-instance, follow these steps:

1. In the "Name" column of the "Static" section, enter a designation for the block call.

2. In the "Data type" column, enter the symbolic name for the function block to be called.
 

 Note

The program editor will declare the multi-instance automatically if you program a block call 
in a network and then specify in the "Call options" dialog that you want to call the block as a 
multiple instance.

 

See also
Updating the block interface (Page 1250)

Updating the block interface

Introduction   
If you change or delete PLC data types or multiple instances that are used in the block interface, 
the interface will become inconsistent. To remedy this inconsistency, the interface has to be 
updated.

You have two options for updating the block interface:
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● Explicit updating of the block interface.
The used PLC data types and multiple instances will be updated. The instance data blocks 
that belong to the block are not implicitly updated during this process.

● Implicit updating during compilation.
All used PLC data types and multiple instances as well as the related instance data blocks 
will be updated.

Explicit updating of the block interface
To explicitly update the block interface, follow these steps:

1. Open the block interface.

2. Select the "Update" command in the shortcut menu.

Implicit Updating during Compilation
Proceed as follows to implicitly update all uses of PLC data types and multiple instances as 
well as the instance data blocks during compilation:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebuild all blocks)" in the shortcut menu.

See also
Basics of PLC data types (Page 1409)

Declaring tags based on a PLC data type (Page 1248)

Editing tables (Page 242)

Basic information on start values (Page 1392)

Using tags within the program (Page 1049)

Keywords (Page 1051)

Properties of local tags (Page 1253)

Setting the retentivity of local tags (Page 1254)

Updating block calls in LAD (Page 1279)

Declaring multi-instances (Page 1250)

Extending the block interface

Description
In order to enable the editing of PLC programs that have already been commissioned and that 
are running without error on a system, CPUs of the S7-1500 series and most CPUs of the 
S7-1200 V4 series support the option of extending the interfaces of function blocks during 
runtime. 
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You can download the modified blocks without setting the CPU to STOP and without affecting 
the values of already loaded tags. 

This is a simple means of implementing program changes. This load process (download 
without reinitialization) will not have a negative impact on the controlled process. 

Principle of operation
Each function block is always assigned a default memory reserve. The memory reserve is not 
used initially. Activate the memory reserve if you decide on loading interface changes after 
having compiled and downloaded the block. All tags that you subsequently declare will be 
saved to the memory reserve. The subsequent download does not influence any tags that are 
already loaded or have a negative impact on runtime.

If you decide to review your program at a later time while the plant is not in operation, you are 
also provided an option of reworking the memory layout of individual or several blocks in a 
single pass. With this action, you move all tags from the reserve area to the regular area. The 
memory reserve is now cleared and made available for further interface extensions.

Requirements
This "Download without reinitialization" function is available if the following requirements are 
met:

● The project is available in "TIA Portal V12" format.

● You are working with a CPU that supports "Download without reinitialization".

● The blocks were created in LAD, FBD, STL, or SCL.

● The blocks were created by the user, i.e. they are not included with the blocks delivered in 
your package.

● These blocks are assigned the optimized access attribute.

Basic steps
Perform the following steps if you want to extend the interface of a function block and then 
load the block without re-initialization.

1. All blocks have a default memory reserve of 100 bytes. You can adapt this memory reserve 
to suit your requirements.

2. Activate the memory reserve.

3. Extend the block interface.

4. Compile the block.

5. Download the block to the CPU as usual.
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For more information on the various steps, refer to chapter "Loading blocks (S7-1200/1500) ".
 

 Note

The full scope of the "Download without reinitialization" function is only available on CPUs of 
the S7-1500 and S7-1200 V4 series. 

However, all CPU families support the option of extending the interface of function blocks 
and downloading newly declared tags without repercussion:
● You may add new tags in the "Temp" section and download these without influencing the 

process.
● You may create new tags of a structured data type in the "InOut" section and download 

these without influencing the process.
 

Editing the properties of local tags

Properties of local tags

Properties     
The following table gives an overview of the properties of local tags:

Group Property Description
General Name Name of the tags.

Data type Data type of the tags.
Default value Value with which you pre-assign the tag in the interface 

of the code block. 
Specification of the default value is optional. If you do not 
specify any value the predefined value for the indicated 
data type is used. For example, the value "false" is 
predefined for BOOL.
The default value will be adopted as the start value in the 
corresponding instance. You can then replace these 
adopted values with instance-specific start values.
This property is only available in the interface of function 
blocks.

Comment Comment on the tag.
Attributes Retain Marks the tag as retentive. 

The values of retentive tags are retained even after the 
power supply is switched off. 
This attribute is only available in the interface of the 
function block with optimized access.

Accessible from HMI Shows whether HMI can access this tag during runtime.
Visible in HMI Shows whether the tag is visible by default in the HMI 

selection list.
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Group Property Description
Hidden parameter Indicates whether the tag should be hidden for the block 

call. This is only possible if you have specified a valid 
predefined actual parameter beforehand.

Predefined actual 
parameter

Defines a parameter that is to be used as actual parameter 
during the block call.

Configurable Indicates whether a parameter is configurable in CFC.
For test Indicates whether a parameter is registered for the CFC 

test mode.
Visible Indicates whether a parameter is visible in CFC.
Interconnectable Indicates whether a parameter is interconnectable in CFC.
Enable tag readback Indicates whether a parameter is relevant for the "Read 

back chart" function in CFC. 
Enumeration texts Assigns a parameter to an enumeration in CFC.
Engineering unit Assigns a parameter to a unit in CFC.
Low limit Defines the low limit for the parameter in CFC:
High limit Defines the high limit for the parameter in CFC:

See also
Setting the retentivity of local tags (Page 1254)

Changing properties of local tags (Page 1255)

Keywords (Page 1051)

Setting the retentivity of local tags

Introduction       
Function blocks store their data in an instance. To prevent data loss in the event of power 
failure, you can mark the data as retentive. This data is stored in a retentive memory area. The 
option of setting the retentivity depends on the set access type of the function block. 

Retentive behavior in blocks with standard access
In blocks with standard access you cannot set the retentive behavior of individual tags. You 
can only define them as retentive in the assigned instance. All tags contained in the block are 
then considered as retentive.

Retentivity for optimized block access
In data blocks with optimized access you can define the retentive behavior of individual tags. 

For structured data type tags, the retentivity setting always applies to the entire structure. You 
can make no individual retentivity setting for individual elements within the structure. 
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You cannot create retentive tags of the structured data type in the "InOut" section. In/out 
parameters with structured data type, for example ARRAY, STRUCT, or STRING, are always 
non-retentive.

The following settings are available:

● Retentive
The values of the tags or the structure are available even after a power failure.

● Non-retentive
The values of the tags or the structure are lost in the event of a power failure.

● Set in IDB
The retentivity can be set in the instance data block. The setting that is made in the instance 
data block than applies, however, centrally to all tags that are selected with "Set in IDB".

See also
Properties of local tags (Page 1253)

Basics of block access (Page 1027)

Changing properties of local tags

Editing properties in the block interface   
To edit the properties of one or more tags, follow these steps:

1. Open the block interface.

2. Change the entries in the columns.

Editing properties in the properties window
To edit the properties of an individual tag, follow these steps:

1. Select a tag in the table.
The tag properties will be displayed in the Inspector window.

2. Change the entries in the inspector window.

Renaming tags directly in the program editor
To rename one or more tags, follow these steps:

1. Select one or more tags in the program.

2. Select the "Rename tag" command in the shortcut menu.
The "Rename tag" dialog opens. This dialog box displays a declaration table with the 
selected tags.

3. Change the entries in the "Name" column.

4. Confirm the input by clicking the "Change" button.
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Editing the data type or comment in the program editor
Proceed as follows to edit the data type or tag comment in the program editor:

1. Select the tag name.

2. Select the "Rewire tag" command in the shortcut menu.
The "Rewire tag" dialog will open. The dialog shows a declaration table.

3. Change the entry in the "Data type" or "Comment" columns.

4. Click the "Change" button to confirm the input.

Effect in the program
In the case of a change of the tag's name, data type or address, each location of use of the 
tag is automatically updated in the program. 

 
 

 Note

If you change the interface of a block, the program may become inconsistent. The 
inconsistencies are automatically updated, if possible.

If an automatic updating is not possible, the inconsistent calls are marked in red. You than 
have to manually updated the inconsistencies. 

See also: 

Updating block calls in LAD (Page 1279)

Updating block calls in FBD (Page 1320)
 

 

See also
Layout of the block interface (Page 1239)

Editing tables (Page 242)

Properties of local tags (Page 1253)

Setting the retentivity of local tags (Page 1254)

Basic information on start values (Page 1392)

Using tags within the program (Page 1049)

Keywords (Page 1051)

Updating the block interface (Page 1250)
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Editing the block interface

Inserting table rows

Procedure  
Proceed as follows to insert a row above the selected row: 

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button on the toolbar of the table.

Result
A new row is inserted above the selected row. 

See also
Editing tables (Page 242)

Inserting table rows

Procedure  
Proceed as follows to insert a row below the selected row:

1. Select the row below which you want to insert a new row.

2. Click the "Add row" button on the table toolbar.

Result
A new empty row will be inserted below the selected row.

See also
Editing tables (Page 242)

Deleting tags

Procedure  
To delete a tag, follow these steps:

1. Select the row with the tag to be deleted. You can also select several rows by clicking on 
them one after the other while holding down the <Ctrl> key or by pressing and holding down 
<Shift> and clicking on the first and last row.

2. Select the "Delete" command in the shortcut menu.
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See also
Editing tables (Page 242)

Automatically filling in successive cells
You can load the contents of one or several table cells into the cells below, automatically filling 
in the successive cells. 

If you automatically fill in cells in the "Name" column, a consecutive number will be appended 
to each name. For example, "Motor" will become "Motor_1".

You can define individual or more cells as well as entire rows as source area.

If less rows exist in the open table than you want to fill, then you will first have to insert additional 
empty rows. 

Requirement
● The table is open.

● Sufficient declaration rows are available.

Procedure  
To automatically fill in successive cells, follow these steps:

1. Select the cells to be loaded.

2. Click the "Fill" symbol in the bottom right corner of the cell.
The mouse pointer is transformed into a crosshair.

3. Keep the mouse button pressed and drag the mouse pointer downwards over the cells that 
you want to fill in automatically.

4. Release the mouse button.
The cells are filled in automatically. 

5. If entries are already present in the cells that are to be automatically filled in, a dialog 
appears. In this dialog you can indicate whether you want to overwrite the existing entries 
or insert new rows for the new tags.

See also
Editing tables (Page 242)

Show and hide table columns
You can show or hide the columns in a table as needed.
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Procedure     
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

Editing tags with external editors
To edit individual tags in external table editors, such as Excel, you can export or import these 
tags using copy and paste. However, you cannot copy structured tags to an editor.

Requirements   
The block interface and an external editor are opened.

Procedure
To export individual tags to an external editor and import them again, follow these steps:

1. Select one or more tags.

2. Select "Copy" in the shortcut menu.

3. Switch to the external editor and paste the copied tags.

4. Edit the tags as required.

5. Copy the tags in the external editor.

6. Select the tags in the external editor.

7. Switch back to the block interface.

8. Select "Paste" in the shortcut menu.

Creating program code

Creating LAD programs

Basic information on LAD

LAD programming language

Overview of the Ladder Logic (LAD) programming language       
LAD is a graphical programming language. The representation is based on circuit diagrams. 
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The program is mapped in one or more networks. A network contains a power rail on the left 
where the rungs originate. The binary signal scans are arranged in the form of contacts on the 
rungs. The serial arrangement of the elements on a rung creates a series connection; 
arrangement on simultaneous branches creates a parallel connection. Complex functions are 
represented by boxes. 

Example of networks in LAD
The following figure shows a LAD network with two normally open contacts, one normally 
closed contact and one coil:

Overview of the LAD elements

LAD elements
A LAD program consists of separate elements that you can arrange in series or parallel on the 
power rail of a network. Most program elements must be supplied with tags. 

There is at least one rung from the power rail. Network programming starts at the left edge of 
the rung. You can expand the power rail by several rungs and branches. 

For example, the following figure shows elements of a LAD network:

1) Power rail

2) Rung

3) Branch

4) Contact

5) Coil
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6) Box

Power rail
Each LAD network consists of a power rail that contains at least one rung. A network can be 
extended by adding additional rungs. You can use branches to program parallel connections 
in the specific rungs.

Contacts
You can use contacts to create or interrupt a current-carrying connection between two 
elements. The current is relayed from left to right. You can use contacts to query the signal 
state or the value of an operand and control it depending on the result of the current flow.

The following types of contact are available to you in a LAD program:

● Normally open contact: 
Normally open contacts forward the current if the signal state of a specified binary operand 
is "1".

● Normally closed contacts: 
Normally closed contacts forward the current if the signal state of a specified binary operand 
is "0".

● Contact with additional function: 
Contacts with additional function forward the current if a specific condition is met. With these 
contacts you can also execute an additional function, such as an RLO edge detection and 
a comparison.

Coils
You can use coils to control binary operands. Coils can set or reset a binary operand depending 
on the signal state of the result of logic operation.

The following types of coils are available to you in a LAD program:

● Standard coils: 
Standard coils set a binary operand if current flows in the coil. The "Assignment" instruction 
is an example of a standard coil.

● Coils with additional function:
These coils have additional functions in addition to the evaluation of the logic operation 
result. Coils for RLO edge detection and program control are examples of coils with 
additional function. 

Boxes
Boxes are LAD elements with complex functions. The empty box is an exception. You can use 
the empty box as a placeholder in which you can select the required instruction.

The following types of boxes are available to you in a LAD program:
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● Boxes without EN/ENO mechanism:
A box is executed depending on the signal state at the box inputs. The error status of the 
processing cannot be queried.

● Boxes with EN/ENO mechanism:
A box is only executed if the enable input "EN" carries the signal state "1". If the box is 
processed correctly, the "ENO" enable output has signal state "1". If an error occurs during 
the processing, the "ENO" enable output is reset.

Calls of code block are also shown in the network as boxes with EN/ENO mechanism.

See also
Rules for the use of LAD elements (Page 1270)

Settings for LAD

Overview of the settings for LAD

Overview  
The following table shows the settings that you can make:

Group Setting Description
Font Font size Font size in program editor
View Layout Compact or wide

Changes the vertical spacing between 
operands and other objects (such as 
operand and contact). The change 
becomes visible once the block is 
reopened.

With absolute information Additional display of the absolute 
addresses

Operand field Maximum width Maximum number of characters that 
can be entered horizontally in the 
operand field. This setting recalculates 
the layout of the networks.

Maximum height Maximum number of characters that 
can be entered vertically in the operand 
field. This setting recalculates the layout 
of the networks.

See also
Changing the settings (Page 1263)
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Changing the settings

Procedure
To change the settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Change the settings.

Result
The change will be loaded directly, there is no need to save it explicitly.

See also
Overview of the settings for LAD (Page 1262)

Working with networks

Using networks

Function 
The user program is created in the block within networks. For a code block to be programmed, 
it must contain at least one network. To achieve a better overview of the user program, you 
can also subdivide your program into several networks.

See also
Entering the network title (Page 1267)

Entering a network comment (Page 1268)

Navigating networks (Page 1269)

Inserting networks

Requirement 
A block is open.
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Procedure
To insert a new network, follow these steps:

1. Select the network after which you want to insert a new network.

2. Select the "Insert network" command in the shortcut menu.

Result
A new empty network is inserted into the block. 

See also
Selecting networks (Page 1264)

Copying and pasting networks (Page 1265)

Deleting networks (Page 1266)

Expanding and collapsing networks (Page 1266)

Entering the network title (Page 1267)

Entering a network comment (Page 1268)

Navigating networks (Page 1269)

Selecting networks

Requirements
A network is available.

Selecting a network
To select a network, follow these steps:

1. Click the title bar of the network that you want to select.

Selecting several networks
Proceed as follows to select several individual networks:

1. Press and hold down the <Ctrl> key.

2. Click all the networks that you want to select.

To select several successive networks, follow these steps:

1. Press and hold down the <Shift> key.

2. Click the first network that you want to select.

3. Click the last network that you want to select.
The first and last networks and all those in between are selected. 
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See also
Inserting networks (Page 1263)

Copying and pasting networks (Page 1265)

Deleting networks (Page 1266)

Expanding and collapsing networks (Page 1266)

Entering the network title (Page 1267)

Entering a network comment (Page 1268)

Navigating networks (Page 1269)

Copying and pasting networks
Copied networks can be pasted within the block or in another block. Networks that were created 
in LAD or FBD can also be inserted in blocks of the respective other programming language.

Requirement     
A network is available.

Procedure
To copy and paste a network, follow these steps:

1. Select the network or networks to be copied.

2. Select "Copy" in the shortcut menu.

3. Select the network after which you want to paste in the copied network.

4. Select "Paste" in the shortcut menu.

See also
Inserting networks (Page 1263)

Selecting networks (Page 1264)

Deleting networks (Page 1266)

Expanding and collapsing networks (Page 1266)

Entering the network title (Page 1267)

Entering a network comment (Page 1268)

Navigating networks (Page 1269)
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Deleting networks

Requirement
A network is available.

Procedure
To delete a network, follow these steps:

1. Select the network that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Inserting networks (Page 1263)

Selecting networks (Page 1264)

Copying and pasting networks (Page 1265)

Expanding and collapsing networks (Page 1266)

Entering the network title (Page 1267)

Entering a network comment (Page 1268)

Navigating networks (Page 1269)

Expanding and collapsing networks

Requirements  
A network is available.

Opening and closing a network
To open a network, follow these steps:

1. Click on the right arrow in the network title bar.

To close a network, follow these steps:
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1. Click on the down arrow in the network title bar.

Opening and closing all networks
To open and close all networks, follow these steps:

1. In the toolbar, click "Open all networks" or "Close all networks".

See also
Inserting networks (Page 1263)

Selecting networks (Page 1264)

Copying and pasting networks (Page 1265)

Deleting networks (Page 1266)

Entering the network title (Page 1267)

Entering a network comment (Page 1268)

Navigating networks (Page 1269)

Entering the network title
The network title is the header of a network. The length of the network title is limited to one 
line.

Requirement 
A network is available.

Procedure
To enter a network title, follow these steps:

1. Click on the title bar of the network.

2. Enter the network title.
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See also
Using networks (Page 1263)

Inserting networks (Page 1263)

Selecting networks (Page 1264)

Copying and pasting networks (Page 1265)

Deleting networks (Page 1266)

Expanding and collapsing networks (Page 1266)

Entering a network comment (Page 1268)

Navigating networks (Page 1269)

Entering a network comment
You can use network comments to provide comments on the program contents of individual 
networks. For example, you can indicate the function of the network or draw attention to special 
characteristics. 

Requirement  
A network is available.

Procedure
To enter a network comment, follow these steps:

1. Click on the right arrow before the network title.

2. If the comment area is not visible, click "Network comments on/off" in the toolbar.
The comment area is displayed.

3. Click "Comment" in the comment area.
The "Comment" text passage is selected.

4. Enter the network comment.
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See also
Using networks (Page 1263)

Inserting networks (Page 1263)

Selecting networks (Page 1264)

Copying and pasting networks (Page 1265)

Deleting networks (Page 1266)

Expanding and collapsing networks (Page 1266)

Entering the network title (Page 1267)

Navigating networks (Page 1269)

Navigating networks
You can navigate straight to a specific position within a block.

Procedure 
To navigate to a specific position within a block, follow these steps:

1. Right-click in the code area of the programming window.

2. Select the "Go to > Network/line" command in the shortcut menu.
The "Go to" dialog will open.

3. Enter the network to which you want to navigate.

4. Enter the line number of the network to which you want to navigate.

5. Confirm your entry with "OK".

Result
The relevant line will be displayed if this is possible. If the network or line requested does not 
exist, the last existing network or the last existing line in the network requested will be displayed. 

See also
Using networks (Page 1263)

Inserting networks (Page 1263)

Selecting networks (Page 1264)

Copying and pasting networks (Page 1265)

Deleting networks (Page 1266)

Expanding and collapsing networks (Page 1266)

Entering the network title (Page 1267)

Entering a network comment (Page 1268)
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Inserting LAD elements

Rules for the use of LAD elements

Rules   
Note the following rules when inserting LAD elements:

● Every LAD network must terminate with a coil or a box. However, the following LAD 
elements must not be used to terminate a network:

– Comparator boxes

– Instructions for positive and negative RLO edge detection

● The starting point of the branch for a box connection must always be the power rail. Logic 
operations or other boxes can be present in the branch before the box.

● Only contacts can be inserted into simultaneous branches with preceding logic operations. 
The contact for negating the result of logic operation (-|NOT|-) is an exception here. The 
contact for negating the result of logic operation, as well as coils and boxes, can be used 
in simultaneous branches if they originate directly from the power rail.

● Constants (e.g. TRUE or FALSE) cannot be assigned to normally closed or normally open 
contacts. Instead, use operands of the BOOL data type.

● Only one jump instruction can be inserted in each network.

● Only one jump label can be inserted in each network.

● Instructions with positive or negative edge detection may not be arranged directly at the 
left margin of the rung as they requires a prior logic operation.

Placement rules for S7-1200/1500 CPUs
The following table sets out the instructions that can only be positioned at the end of the 
network:

Instruction Preceding logic operation 
requiredMnemonics Name

SET_BF Set bit field No
RESET_BF Reset bit field No
JMP Jump if RLO = 1 No
JMPN Jump if RLO = 0 Yes
JMP_LIST Define jump list No
SWITCH Jump distributor No
RET Return No

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1270 System Manual, 07/2013,  



Placement rules for S7-300/400 CPUs
The following table sets out the instructions that can only be positioned at the end of the 
network:

Instruction Preceding logic operation 
requiredMnemonic

s
Name

S Set output Yes
R Reset output Yes
SP Start pulse timer Yes
SE Start extended pulse timer Yes
SD Start on-delay timer Yes
SS Start retentive on-delay timer Yes
SF Start off-delay timer Yes
SC Set counter value Yes
CU Count up Yes
CD Count down Yes
JMP Jump if RLO = 1 No
JMPN Jump if RLO = 0 Yes
RET Return No
OPN Open global data block No
OPNI Open instance data block No
CALL Call block No
SAVE Save RLO in BR bit No
MCRA Enable MCR range No
MCRD Disable MCR range No
MCR< Open MCR ranges No
MCR> Close MCR ranges No

See also
Prohibited interconnections in LAD (Page 1272)

Overview of the LAD elements (Page 1260)

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1271



Prohibited interconnections in LAD

Power flow from right to left 
No branches can be programmed that could result in a power flow in the reverse direction.

Short-circuit
No branches may be programmed that would cause a short-circuit.

Logic operations
The following rules apply to logic operations:

● Only Boolean inputs can be combined with preceding logic operations.

● Only the first Boolean output can be combined with a further logic operation.

● Only one complete logical path can exist per network. Paths that are not connected can be 
linked.

See also
Rules for the use of LAD elements (Page 1270)

Inserting LAD elements using the "Instructions" task card

Requirement   
A network is available.
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Procedure
To insert a LAD element into a network using the "Instructions" task card, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to the LAD element that you want to insert.

3. Use drag-and-drop to move the element to the desired place in the network.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multiple instance", 
these are located in the block interface in the "Static" section.

Or:

1. Select the point in the network at which you want to insert the element.

2. Open the "Instructions" task card.

3. Double-click on the element you want to insert.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multiple instance", 
these are located in the block interface in the "Static" section.

Result
The selected LAD element is inserted with placeholders for the parameters. 

Inserting LAD elements using an empty box

Requirement  
A network is available.

Procedure  
To insert an LAD element into a network using an empty box, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Empty box" in the "Basic instructions" palette.

3. Use a drag-and-drop operation to move the "Empty box" element to the desired place in 
the network.
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4. Position the cursor over the triangle in the top right-hand corner of the empty box.
A drop-down list is displayed.

5. Select the required LAD element from the drop-down list.
If the element is an internal system function block (FB), the "Call option" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multi-instance", these 
are located in the block interface in the "Static" section.

Result
The empty box is changed to the respective LAD element. Placeholders are inserted for the 
parameters.

Selecting the data type of a LAD element

Selecting a data type

Introduction
Some instructions can be executed with several different data types. If you use one of these 
instructions in the program, you have to specify a valid data type for the instruction at the 
specific point in the program. For some instructions, you have to select the data types for the 
inputs and outputs separately. 

 

 Note

The valid data type (BOOL) for the tags on the enable input EN and the enable output ENO 
is predefined by the system and cannot be changed. 

 

The valid data types for an instruction are listed in the instruction drop-down list. You specify 
the data type of the instruction by selecting an entry from the drop-down list. If the data type 
of an operand differs from the data type of the instruction and cannot be converted implicitly, 
the operand is displayed in red and a rollout with the corresponding error message appears. 

Data type selection of mathematical instructions
Some mathematical instructions provide you with the option of having the data type 
automatically set corresponding to the data types of the operand. In the drop-down list for data 
type selection, these instructions have the entry "Auto" in addition to the actual data types. If 
you select this entry and then allocate the first operand, the data type of the operand is selected 
as data type for the instruction. The entry in the drop-down list changes to "Auto (<Data type>)", 
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e.g. "Auto (Real)". If you allocate additional operands, the automatically set data type of the 
instruction is adjusted according to the following criteria:

● You supply all other operands with tags of the same data type: 
The data type of the instruction is not changed.

● You supply all other operands with tags whose data type is smaller than the data type of 
the instruction: 
The data type of the instruction is not changed. For the operand with the smaller data type, 
an implicit conversion is conducted if necessary.

● You supply an additional operand with a tag whose data type is greater than the data type 
of the instruction:
The data type of the instruction is changed to the larger data type. An implicit conversion 
is performed, if necessary, for operands that deviate from the newly set data type of the 
instruction.

Each change in the data type of an operand can result in a change of the data type of the 
instruction. Other operands may possibly be implicitly converted as a result. Operands for 
which an implicit conversion is performed are marked with a gray square.

 

 Note

Please also observe the information on data type conversion for your device and, in particular, 
the notes on the IEC check. 

See also: Data type conversion
 

See also
Defining the data type of an instruction (Page 1275)

Defining the data type of an instruction

Introduction
Some instructions can be executed with several different data types. When you insert such 
instructions into your program, you must specify the data type for these instructions at the 
actual point in the program. 

Specifying the data type by means of the drop-down list
To define the data type of an instruction using the drop-down list, follow these steps:

1. Insert the instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. Click the triangle in the upper corner of the drop-down list.
The drop-down list will open to display the data types valid for the instruction.
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3. Select a data type from the drop-down list.
The selected data type is displayed.

4. If the instruction has two drop-down lists, select the data type for the instruction inputs in 
the left-hand drop-down list and the data type for the instruction outputs in the right-hand 
drop-down list.

Specifying data type by assigning tags
To define the data type of an instruction by assigning tags, follow these steps:

1. Insert the instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. At an input or output, specify a valid tag, the data type of which is to be applied as the 
instruction data type.
The data type of the tag is displayed in the drop-down list.

3. Enter a valid tag at an input and a valid tag at an output if data types need to be defined 
for both the inputs and outputs of the instruction. The tag specified at the input determines 
the data type of the inputs; the tag specified at the output determines the data type of the 
outputs of the instruction.

Automatically specifying the data type of mathematical instructions
To automatically specify the data type for mathematical instructions, follow these steps:

1. Insert the mathematical instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. Select the "Auto" entry from the drop-down list.

3. Enter a valid tag at an input or output. 
The data type of the tag is applied as data type of the instruction. The entry in the drop-
down list changes to "Auto (<Data type>)".

See also: Selecting a data type (Page 1274)

See also
Selecting a data type (Page 1274)

Using favorites in LAD

Adding LAD elements to Favorites

Requirement  
● A block is open.

● The multipane mode is set for the "Instructions" task card or the Favorites are also displayed 
in the editor.
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Procedure
To add SCL instructions to the Favorites, follow these steps:

1. Open the "Instructions" task card.

2. Maximize the "Basic instructions" pane.

3. Navigate in the "Basic instructions" pane to the instruction that you want to add to the 
Favorites.

4. Drag-and-drop the instruction into the "Favorites" pane or into the Favorites area in the 
program editor.

 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Removing LAD elements from Favorites (Page 1278)

Overview of the program editor (Page 1219)

Inserting LAD elements using favorites

Requirement  
● A block is open.

● Favorites are available.

Procedure
To insert an instruction into a program using Favorites, follow these steps:

1. Drag-and-drop the desired instruction from Favorites to the desired position.

Or:

1. Select the position in the program where you want to insert the instruction.

2. In the Favorites, click on the instruction you want to insert.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.
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See also
Removing LAD elements from Favorites (Page 1278)

Overview of the program editor (Page 1219)

Removing LAD elements from Favorites

Requirement
A code block is open. 

Procedure
To remove instructions from Favorites, follow these steps:

1. Right-click on the instruction you want to remove.

2. Select the "Remove instruction" command in the shortcut menu.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Adding LAD elements to Favorites (Page 1276)

Inserting LAD elements using favorites (Page 1277)

Overview of the program editor (Page 1219)

Insert block calls in LAD

Inserting block calls using a drag-and-drop operation
You can insert calls for existing functions (FC) and function blocks (FB) using a drag-and-drop 
operation from the project tree. If you call function blocks from other function blocks, you can 
either call them as single-instance or multi-instance blocks. If a function block is called as single 
instance, it will store its data in a data block of its own. If a function block is called as multi-
instance, it will store its data in the instance data block of the calling function block.

Requirement    
● A network is available.

● The block that is to be called is available.
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Inserting a call of a function (FC)
To insert a call of a function (FC) into a network using a drag-and-drop operation, follow these 
steps:

1. Drag the function from the project tree to the required network.

Inserting a call for a function block (FB)
To insert a call for a function block (FB), follow these steps:

1. Drag the function block from the project tree to the required network.
The "Call options" dialog opens.

2. Enter in the dialog whether you wish to call the block as single or multi-instance.

– If you click on the "Single instance" button, you will have to enter a name in the "Name" 
text box for the data block that you want to assign to the function block.

– If you click on the "Multi-instance" button, you will have to enter the name of the tag in 
the "Name in the interface" text box; this is the name that you use to enter the called 
function block as a static tag in the interface of the calling block.

3. Confirm your entries with "OK".

Result
The function or the function block is inserted with its parameters. You can then assign the 
parameters. 

See also: Auto-Hotspot 
 

 Note

If when calling a function block you specify an instance data block that does not exist, it will 
be created. If you have called a function block as a multi-instance, this will be entered as a 
static tag in the interface.

 

 

See also
Updating block calls in LAD (Page 1279)

Changing the instance type (Page 1280)

Single instances (Page 1035)

Multi-instances (Page 1035)

Updating block calls in LAD
If interface parameters of a called block are changed, the block call can no longer be executed 
correctly. You can avoid such inconsistent block calls by updating the block calls.

You have two options to update the block calls:

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1279



● Explicit updating in the program editor.
The block calls in the open block will be updated. 

● Implicit updating during compilation.
All block calls in the program as well as the used PLC data types will be updated.

Update blocks in the program editor  
To update a block call within a block, follow these steps:

1. Open the block in the program editor.

2. Click "Update inconsistent block calls" in the toolbar.

Or:

1. Open the block in the program editor.

2. Right-click on the instruction with the block call.

3. Select the "Update" command in the shortcut menu.
The "Interface update" dialog opens. This dialog shows the differences between the block 
interface in use and the changed interface of the called block.

4. If you want to update the block call, click "OK". To cancel the update, click "Cancel".

Update block calls during compilation
Follow these steps to update all block calls and uses of PLC data types during compilation 
implicitly:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebuild all blocks)" in the shortcut menu.

See also
Inserting block calls using a drag-and-drop operation (Page 1278)

Changing the instance type (Page 1280)

Changing the instance type

Instance type
There are two ways of calling function blocks:

● As a single instance

● As a multiple instance

See also: Auto-Hotspot 

You can modify a defined instance type at any time.
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Requirement       
The user program contains a block call.

Procedure
To change the instance type of a function block, follow these steps:

1. Open the code block and select the block call.

2. Select the "Change instance" command in the shortcut menu.
The "Call options" dialog opens.

3. Click the "Single instance" or "Multi instance" button.

– If you select the "Single instance" instance type, enter a name for the data block that is 
to be assigned to the function block.

– If you select "Multiple instance" as the instance type, enter in the "Name in the interface" 
text field the name of the tag with which the called function block is to be entered as a 
static tag in the interface of the calling block.

4. Confirm your entries with "OK".
 

 Note

The previous single and multiple instances will not be deleted automatically.
 

See also
Inserting block calls using a drag-and-drop operation (Page 1278)

Updating block calls in LAD (Page 1279)

Inserting complex LAD instructions

Using the "Calculate" instruction

Requirement    
A network is available.

Procedure
Proceed as follows to use the "Calculate" instruction:

1. Open the "Instructions" task card.

2. Navigate to "Math functions > CALCULATE" in the "Basic instructions" pane.
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3. Use drag-and-drop to move the element to the desired place in the network.
The instruction "Calculate" will be inserted for the data type with a placeholder expression 
and question mark.

4. Enter the data type for the calculation.

5. Enter the operands for the calculation.
 

  Note

The calculation is run with the inputs of the "Calculate" instruction. If you want to use 
constants you must also insert appropriate inputs for them. 

 

6. Click on the "Edit 'Calculate' instruction" button to replace the placeholder expression with 
the correct expression.
The "Edit 'Calculate' instruction" dialog will open.

7. Enter the required expression in the "OUT:= " text box.
 

  Note

In the "Example" area you can find an example of a valid expression and possible 
instructions that you can use. 

To determine a value with the help of Pythagoras' theorem, for example, enter "OUT := 
SQRT (SQR (IN1) + SQR (IN2))".

 

8. Confirm your entry with "OK".

See also
CALCULATE: Calculate (Page 1682)

Using free-form comments

Basic information on using free-form comments in LAD

Introduction  
Free-form comments allow you to add comments to the source code for graphic programming 
languages similar to line comments for textual languages.

Free-form comments can be used for the following elements:

● Boxes

● Coils
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See also
Inserting free-form comments (Page 1283)

Editing free-form comments (Page 1283)

Deleting free-form comments (Page 1285)

Inserting free-form comments

Requirement
A network with instructions is available.

Procedure  
To insert a free comment on an instruction, proceed as follows:

1. If necessary, activate the "Free-form comments on/off" button in the toolbar.

2. Right-click on the instruction for which you want to insert a free-form comment.

3. Select the "Insert comment" command in the shortcut menu.
A comment box with a standard comment opens. The comment box is connected by an 
arrow to the corresponding instruction.

4. Enter the required comment in the comment box.

See also
Basic information on using free-form comments in LAD (Page 1282)

Editing free-form comments (Page 1283)

Deleting free-form comments (Page 1285)

Editing free-form comments

Introduction  
Free-form comments can be edited as follows:

● Changing the comment text

● Changing the position and size of the comment box

● Attaching a comment to another element

● Showing and hiding free comments
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Changing the comment text
To change the text of free-form comments, follow these steps:

1. Click on the comment box.

2. Enter the desired text.

Changing the position of the comment box
To change the positioning of the comment box, follow the steps below:

1. Left-click the comment box and keep the mouse button pressed.

2. Drag the comment box to the desired location.

Changing the size of the comment box
To change the size of the comment box, follow the steps below:

1. Click on the comment box.

2. Drag the comment box on the move handle in the lower right corner to the desired size.

Attaching a comment to another element
To attach a free-form comment to another element, follow these steps:

1. Left-click the point of the arrow that links the comment box with the instruction and keep 
the mouse button pressed.

2. Drag the arrow to the element to which you want to attach the comment. Possible insertion 
points are marked with a green square.

3. Release the mouse button.

Showing and hiding free comments
To show or hide a free-form comments, follow these steps:

1. Click the "Free-form comment on/off" button in the toolbar.

See also
Basic information on using free-form comments in LAD (Page 1282)

Inserting free-form comments (Page 1283)

Deleting free-form comments (Page 1285)
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Deleting free-form comments

Procedure  
To delete a free-form comment, proceed as follows:

1. Right-click on the free-form comment that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Basic information on using free-form comments in LAD (Page 1282)

Inserting free-form comments (Page 1283)

Editing free-form comments (Page 1283)

Editing LAD elements

Selecting LAD elements
You can select several individual elements or all elements in a network.

Requirement  
LAD elements are available

Selecting several individual LAD elements
To select several individual LAD elements, follow these steps:

1. Press and hold down the <Ctrl> key.

2. Click on all the LAD elements you wish to select.

3. Now release the <Ctrl> key.

Selecting all LAD elements in a network
To select all LAD elements in a network, follow these steps:

1. Go to the network whose elements you wish to select.

2. Select the "Select all" command in the "Edit" menu or press <Ctrl A>.
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See also
Copying LAD elements (Page 1286)

Cutting LAD elements (Page 1287)

Pasting an LAD element from the clipboard (Page 1287)

Replacing LAD elements (Page 1288)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Enabling and disabling the EN/ENO mechanism (Page 1290)

Deleting LAD elements (Page 1292)

Copying LAD elements

Requirement 
An LAD element is available.

Procedure
To copy a LAD element, follow these steps:

1. Right-click the LAD element that you want to copy.

2. Select "Copy" in the shortcut menu.

Result
The LAD element will be copied and saved to the clipboard.

See also
Selecting LAD elements (Page 1285)

Cutting LAD elements (Page 1287)

Pasting an LAD element from the clipboard (Page 1287)

Replacing LAD elements (Page 1288)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Enabling and disabling the EN/ENO mechanism (Page 1290)

Deleting LAD elements (Page 1292)
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Cutting LAD elements

Requirement 
An LAD element is available.

Cutting
To cut a LAD element, follow these steps:

1. Right-click the LAD element that you want to cut.

2. Select "Cut" in the shortcut menu.

Result
The LAD element will be cut and saved to the clipboard.

See also
Selecting LAD elements (Page 1285)

Copying LAD elements (Page 1286)

Pasting an LAD element from the clipboard (Page 1287)

Replacing LAD elements (Page 1288)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Enabling and disabling the EN/ENO mechanism (Page 1290)

Deleting LAD elements (Page 1292)

Pasting an LAD element from the clipboard

Requirement
An LAD element is available.

Procedure
To paste an LAD element from the clipboard, follow these steps:

1. Copy a LAD element or cut a LAD element.

2. Right-click the point in the network where you want to paste the element.

3. Select "Paste" in the shortcut menu.
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See also
Selecting LAD elements (Page 1285)

Copying LAD elements (Page 1286)

Cutting LAD elements (Page 1287)

Replacing LAD elements (Page 1288)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Enabling and disabling the EN/ENO mechanism (Page 1290)

Deleting LAD elements (Page 1292)

Replacing LAD elements
You can easily exchange LAD elements with other LAD elements of the same type. This has 
the advantage that the parameters are retained and need not be entered again. For example, 
you can exchange normally open contacts and normally closed contacts or RS FlipFlop and 
SR FlipFlop.

Requirements 
A network with at least one LAD element is present.

Procedure
To replace an LAD element with another LAD element, follow these steps:

1. Select the LAD element that you want to replace.

2. Position the cursor over the triangle in the top right-hand corner of the LAD element.
A drop-down list is displayed.

3. From the drop-down list, select the LAD element that you want to use to replace the existing 
LAD element.

See also
Selecting LAD elements (Page 1285)

Copying LAD elements (Page 1286)

Cutting LAD elements (Page 1287)

Pasting an LAD element from the clipboard (Page 1287)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Enabling and disabling the EN/ENO mechanism (Page 1290)

Deleting LAD elements (Page 1292)
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Inserting additional inputs and outputs in LAD elements

Introduction   
You can expand LAD elements which execute commutative arithmetic instructions by adding 
additional inputs. Such elements are, for example, the instructions "Add" (ADD) and "Multiply" 
(MUL). You can expand the MOVE and DEMUX instruction boxes by adding additional outputs.

Requirement
An LAD element is available that permits the insertion of additional inputs and outputs.

Inserting an additional input
To add an additional input to the box of a LAD element, follow these steps:

1. Right-click on an existing input of the LAD element.

2. Select "Insert input" in the shortcut menu.
An additional input is added to the box of the LAD element.

Or:

1. Click on the yellow star symbol beside the last input in the instruction box.
An additional input is added to the box of the LAD element.

Inserting an additional output
To add an additional output to the box of a LAD element, follow these steps:

1. Right-click on an existing output of the LAD element.

2. Select "Insert output" from the shortcut menu.
An additional output is added to the box of the LAD element.

Or:

1. Click on the yellow star symbol beside the last input in the instruction box.
An additional output is added to the box of the LAD element.

See also
Selecting LAD elements (Page 1285)

Copying LAD elements (Page 1286)

Cutting LAD elements (Page 1287)

Pasting an LAD element from the clipboard (Page 1287)

Replacing LAD elements (Page 1288)

Removing inputs and outputs (Page 1290)

Enabling and disabling the EN/ENO mechanism (Page 1290)

Deleting LAD elements (Page 1292)
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Removing inputs and outputs

Introduction   
Inputs and outputs which you have added to an instruction can be removed.

Requirement
An LAD element is available to which you have added additional inputs and outputs.

Remove input
To remove an input, follow these steps:

1. Select the input that you want to remove.

2. Select the "Delete" command in the shortcut menu.
The input of the LAD element is removed.

Remove output
To remove an output, follow these steps:

1. Select the output that you want to remove.

2. Select the "Delete" command in the shortcut menu.
The output of the LAD element will be removed.

 

See also
Selecting LAD elements (Page 1285)

Copying LAD elements (Page 1286)

Cutting LAD elements (Page 1287)

Pasting an LAD element from the clipboard (Page 1287)

Replacing LAD elements (Page 1288)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Enabling and disabling the EN/ENO mechanism (Page 1290)

Deleting LAD elements (Page 1292)

Enabling and disabling the EN/ENO mechanism
In LAD and FBD, certain instructions have an enable output ENO and thus use the EN/ENO 
mechanism. This allows you to query runtime errors in instructions and react to them. In order 
to increase the performance of the CPU, the EN/ENO mechanism is disabled in the default 
setting. This means that you are not initially able to react to runtime errors of the instruction 
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using the ENO value. However, you can enable the EN/ENO mechanism again at any time, if 
required.

You can enable the EN/ENO mechanism individually for each instruction in order to generate 
the ENO. If you enable the EN/ENO mechanism for an instruction, other instructions that you 
subsequently add to your program are also inserted with the EN/ENO mechanism enabled. 
You can disable the EN/ENO mechanism again at any time if you do not want to use the 
evaluation of ENO for an instruction. Further instructions that you subsequently add to your 
program will then be inserted without the EN/ENO mechanism.

See also: Basics of the EN/ENO mechanism (Page 1167) 

Activating the EN/ENO mechanism
Proceed as follows to activate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to activate the EN/ENO 
mechanism.

2. Select the "Generate ENO" command from the shortcut menu.
The ENO value is again generated for the instruction. Other instructions are inserted with 
the enable output.

Deactivating the EN/ENO mechanism
Proceed as follows to deactivate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to deactivate the EN/ENO 
mechanism.

2. Select the "Do not generate ENO" command from the shortcut menu.
The ENO value is no longer generated for the instruction. Other instructions are inserted 
without enable output.

See also
Selecting LAD elements (Page 1285)

Copying LAD elements (Page 1286)

Cutting LAD elements (Page 1287)

Pasting an LAD element from the clipboard (Page 1287)

Replacing LAD elements (Page 1288)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Deleting LAD elements (Page 1292)
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Deleting LAD elements

Requirement
An LAD element is available.

Procedure
To delete a LAD element, follow these steps:

1. Right-click the LAD element that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Selecting LAD elements (Page 1285)

Copying LAD elements (Page 1286)

Cutting LAD elements (Page 1287)

Pasting an LAD element from the clipboard (Page 1287)

Replacing LAD elements (Page 1288)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Enabling and disabling the EN/ENO mechanism (Page 1290)

Inserting operands into LAD instructions

Inserting operands
The character strings "<???>", "<??.?>" and "..." are inserted as placeholders for the 
parameters when an LAD element is inserted. The "<???>" and "<??.?>" strings displayed in 
red indicate parameters that need to be connected. The "..." string displayed in black indicates 
parameters that may be connected. "<??.?>" stands for Boolean placeholders.

 

 Note

If you position the cursor over the placeholder, the expected data type will be displayed.
 

Requirement   
An LAD element is available.
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Procedure
To connect the parameters of a LAD element, follow these steps:

1. Double-click the placeholder of the parameter.
An entry field opens, and the placeholder is selected.

2. Enter the appropriate parameter.
 

  Note

If you enter the absolute address of a parameter that has already been defined, this 
absolute address will be changed to the symbolic name of the parameter as soon as the 
input is confirmed. If you have not yet defined the parameter, a new tag with this absolute 
address and the default name "Tag_<n>" will be entered in the PLC tag table. When you 
confirm your input, the absolute address will be replaced with the symbolic name 
"Tag_<n>".

 

3. Confirm the parameter with the Enter key.

4. If you have not yet defined the parameter, you can define it directly in the program editor 
using the shortcut menu.
See also: 
Declaring PLC tags in the program editor (Page 1181)
Declaring local tags in the program editor (Page 1245)

Or drag from it the PLC tag table:

1. In the project tree, select the "PLC tags" folder or open the PLC tag table.

2. If you have opened the PLC tag table, drag the symbol from the first column of the desired 
tag to the appropriate place in your program. If you have not opened the PLC tag table yet, 
open the detail view now. Drag the desired tag from the detail view to the appropriate place 
in your program.

Or drag from it the block interface:

1. Open the block interface.

2. Drag the required operand from the block interface to the instruction window.

 

Result
● If the syntax is error-free, the displayed parameter is black. The editor then jumps to the 

next placeholder.

● If there is an error in the syntax, the cursor stays in the entry field and a corresponding error 
message is displayed in the status line. If you press the Enter key again, the entry field is 
closed and the faulty entry is displayed in red italics.
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Wiring hidden parameters

Introduction  
Depending on the CPU used, you can use complex instructions in your program that are 
dispatched with the TIA portal. These instructions can contain parameters that are declared 
as hidden. 

If an instruction contains hidden parameters, the instruction box has a small arrow on the lower 
edge. You can recognize hidden parameters by their white font. 

You can show and wire the hidden parameters at any time.

Showing or hiding hidden parameters
To show or hide hidden parameters, follow these steps:

1. Click on the down arrow at the bottom edge of the instruction box to show hidden 
parameters.

2. Click on the up arrow at the bottom edge of the instruction box to hide hidden parameters.

Wiring hidden parameters
To wire parameters, follow these steps:

1. Wire the hidden parameters like normally visible parameters.
The hidden parameter is transformed into a visible parameter.

See also
Using libraries (Page 338)

Displaying or hiding variable information

Introduction     
You can display the following information about the tags to be used in the programming editor:

● Name of the tags

● Address of the tags

● Comments to document the tags

The information is taken from the block interface for local tags and DB tags and from the PLC 
tag table for tags that are valid CPU-wide. 

You can display the tag information either for all the blocks or for individually opened blocks. 
If you display the tag information for all the blocks, the tag information for all the blocks currently 
opened and opened in future is shown.

You can hide the tag information at any time again. If you hidden the tag information for all the 
blocks, you display it again for individual ones that are opened.
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Displaying or hiding tag information for all the blocks
Proceed as follows to display or hide the tag information for all the blocks:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. If you want to display the tag information activate the check box "With tag information" in 
the "View" section. If you want to hide the tag information, clear the "With tag information" 
check box.
The tag information is displayed or hidden for all the blocks. When you open further blocks, 
the tag information is displayed or not displayed depending on the selected setting. 

Displaying or hiding tag information for an opened block
Proceed as follows to display or hide the tag information for an opened block:

1. Activate or deactivate the "Tag information" check box in the menu "View > Display with" 
or click the "Tag information on/off" button in the toolbar.
The tag information is displayed or hidden. 

Branches in LAD

Basic information on branches in LAD

Definition  
You use branches to program parallel circuits with the Ladder Logic (LAD) programming 
language. Branches are inserted in the main rung. You can insert several contacts into the 
branch and thus achieve a parallel circuit of series connections. This allows you to program 
complex ladder logic.

The figure below shows an example of the use of branches:

MOTOR carries signal 1, if one of the following conditions is fulfilled:

● Signal 1 is pending on S2 or S4

● Signal 0 is pending on S5.
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See also
Rules for branches in LAD (Page 1296)

Inserting branches into the LAD network (Page 1296)

Closing branches in the LAD network (Page 1297)

Deleting branches in LAD networks (Page 1297)

Rules for branches in LAD

Rules  
The following rules apply to simultaneous branches:

● A simultaneous branch can only be inserted if the main branch already contains an LAD 
element.

● Simultaneous branches are opened downwards or are connected directly to the power rail. 
They are terminated upwards.

● Simultaneous branches are opened after the selected LAD element.

● Simultaneous branches are terminated after the selected LAD element.

● To delete a simultaneous branch, you must delete all LAD elements of this branch. When 
the last LAD element is removed from the branch, the rest of the branch is also removed. 

See also
Basic information on branches in LAD (Page 1295)

Inserting branches into the LAD network (Page 1296)

Deleting branches in LAD networks (Page 1297)

Closing branches in the LAD network (Page 1297)

Inserting branches into the LAD network
You can create several branches in a network.

Requirement  
● A network is available.

● The network contains elements.
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Procedure
To insert a new branch in a network, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Open branches" in the "Simple instructions" palette.

3. Use drag-and-drop to move the element to the desired place in the network.
If you want to connect the new branch directly to the power rail, drag the element to the 
power rail. 

See also
Basic information on branches in LAD (Page 1295)

Rules for branches in LAD (Page 1296)

Deleting branches in LAD networks (Page 1297)

Closing branches in the LAD network
Branches must be closed again at suitable places. If necessary, branches will be arranged so 
that they do not cross each other.

Requirement
A branch is available.

Procedure
To close an open branch, follow these steps:

1. Select the open branch.

2. Press and hold down the left mouse button.
A dashed line will appear as soon as the cursor is moved. 

3. Drag the dashed line to a suitable place on the network. Permissible connections are 
indicated by green lines.

4. Release the left mouse button.

See also
Basic information on branches in LAD (Page 1295)

Rules for branches in LAD (Page 1296)

Deleting branches in LAD networks

Requirement
A branch is available.
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Procedure
To delete a branch, follow these steps:

1. Select the connection line that links the branch to the main branch.

2. Select the "Delete" command in the shortcut menu.

See also
Basic information on branches in LAD (Page 1295)

Rules for branches in LAD (Page 1296)

Inserting branches into the LAD network (Page 1296)

Crossings in LAD

Basic information on crossings in LAD

Definition
A crossing is a place in a LAD network where one branch is closed and at the same time 
another branch is opened.

"TagOut" receives signal 1, if the following two conditions are met:

● "TagIn_1" or "TagIn_3" has signal 1

● "TagIn_2" or "TagIn_4" has signal 0

 

Inserting crossings
You can insert crossings in a LAD network by creating connections between the main branch 
and an additional branch or between different branches. 

Requirements  
A branch is available.
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Procedure
To insert a new crossing in an LAD network, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Open branches" in the "Simple instructions" palette.

3. Drag the element behind the existing branch.

4. Insert any element into the open branch.

5. Click the arrow of the open branch after the inserted element.

6. Hold down the left mouse button and drag the dashed connecting line to the main branch.

7. Release the left mouse button.

See also
Rearranging crossings (Page 1299)

Deleting crossings (Page 1300)

Inserting branches into the LAD network (Page 1296)

Rearranging crossings

Requirement
A crossing is available.

Procedure
To rearrange a connection, follow these steps:

1. Select the connection line that defines the crossings in the respective branches.

2. Select the "Delete" command in the shortcut menu.

3. Open the "Instructions" task card.

4. Navigate to "General > Open branches" in the "Simple instructions" palette.

5. Use a drag-and-drop operation to move the element to the place in the network where you 
want to insert the new crossing.

6. Click on the arrow for the open branch.

7. Hold down the left mouse button and drag the dashed connecting line to the subsidiary 
branch in which you wish to insert the new crossing.

8. Release the left mouse button.
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See also
Inserting crossings (Page 1298)

Deleting crossings (Page 1300)

Deleting crossings

Requirement
A crossing is available.

Procedure
To delete a crossing, follow these steps:

1. Select the connection line that defines the crossings in the respective branches.

2. Select the "Delete" command in the shortcut menu.

See also
Inserting crossings (Page 1298)

Rearranging crossings (Page 1299)

Rungs in LAD

Basic information on rungs in LAD

Using rungs  
The program is mapped in one or more networks. A network contains a power rail on the left 
where one or more rungs originate. The binary signal scans are arranged in the form of contacts 
on the rungs. The serial arrangement of the elements on a rung creates a series connection; 
arrangement on simultaneous branches creates a parallel connection. A rung is closed by a 
coil or a box in which the result of logic operation will be written.

The figure below shows an example of the use of several rungs within a network:
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Rules
Remember the following rules when using several rungs:

● Connections are not permitted between rungs.

● Only one jump instruction is permissible per network. The positioning rules for jump 
instructions remain valid.

Running rungs
Rungs and networks are executed from top to bottom and from left to right. This means that 
the first instruction in the first rung of the first network is processed first. All instructions of this 
rung are then processed. After this come all other rungs of the first network. The next network 
is processed only after all rungs have first been run.

Differences between branches and rungs
The difference between branches and rungs is that the rungs are independent branches that 
can also stand in a different network. Branches, on the other hand, permit the programming 
of a parallel connection.

See also
Insert rung (Page 1301)

Deleting a rung (Page 1302)

Insert rung

Requirement
● A block is open.

● A network is available.

Procedure  
To insert a new rung in a network, proceed as follows:

1. Insert any coil on the power rail.
A new rung will be inserted and the coil positioned at the end of the rung.

2. Insert additional instructions in the new rung.

See also
Basic information on rungs in LAD (Page 1300)

Deleting a rung (Page 1302)
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Deleting a rung

Requirement
A rung is available.

Procedure   
To delete a rung, proceed as follows:

1. Hold down the left mouse button and draw a frame around the rung. At the same time, 
make sure that you select all instructions. Alternatively, you can hold down the <Shift> key 
and select the first the last instruction of the rung.

2. Right-click on one of the instructions in the rung.

3. Select the "Delete" command in the shortcut menu.

See also
Basic information on rungs in LAD (Page 1300)

Insert rung (Page 1301)

Creating FBD programs

Basic information on FBD

FBD programming language

Overview of the Function Block Diagram (FBD) programming language    
FBD is a graphical programming language. The representation is based on electronic circuit 
systems.

The program is mapped in one or more networks. A network contains one or more logic 
operation paths. The binary signal scans are linked by boxes. The representation of the logic 
is based on the graphical logic symbols used in Boolean algebra.

Example of networks in FBD
The following figure shows an FBD network with AND and OR boxes and an assignment:
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Overview of the FBD elements

FBD elements
An FBD program consists of separate elements that are linked by means of a binary signal 
flow. Most program elements must be supplied with tags. 

A FBD network is programmed from left to right.

For example, the following figure shows elements of an FBD network:

1) Binary function

2) Standard box

3) Complex box

Binary functions
You can use binary functions to query binary operands and to combine their signal states. The 
following operations are examples of binary functions: "AND operation", "OR operation" and 
"EXCLUSIVE OR operation".

Standard boxes:
You can use standard boxes to control binary operands, perform RLO edge detection or 
execute jump functions in the program. Standard boxes generally have only one single input.
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Complex boxes
Complex boxes represent program elements with complex functions. The empty box is an 
exception. You can use the empty box as a placeholder in which you can select the required 
instruction.

The following types of boxes are available to you in an FBD program:

● Complex boxes without EN/ENO mechanism:
A box is executed independently of the signal state at the box inputs. The error status of 
the processing cannot be queried.

● Complex boxes with EN/ENO mechanism:
A box is only executed if the enable input "EN" has the signal state "1". If the box is 
processed correctly, the "ENO" enable output has signal state "1". If an error occurs during 
processing, the "ENO" output is reset.
If the EN enable input is not interconnected, the box is always executed.

Calls of code block are also shown in the network as complex boxes with EN/ENO mechanism. 

 

Settings for FBD

Overview of the settings for FBD

Overview  
The following table shows the settings that you can make:

Group Setting Description
Font Font size Font size in program editor
View Layout Compact or wide

Changes the vertical spacing between 
operands and other objects (such as 
operand and contact). The change 
becomes visible once the block is 
reopened.

With absolute information Additional display of the absolute 
addresses

Operand field Maximum width Maximum number of characters that 
can be entered horizontally in the 
operand field. This setting recalculates 
the layout of the networks.

Maximum height Maximum number of characters that 
can be entered vertically in the operand 
field. This setting recalculates the layout 
of the networks.
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See also
Changing the settings (Page 1305)

Changing the settings

Procedure
To change the settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Change the settings.

Result
The change will be loaded directly, there is no need to save it explicitly.

See also
Overview of the settings for FBD (Page 1304)

Working with networks

Using networks

Function 
The user program is created in the block within networks. For a code block to be programmed, 
it must contain at least one network. To achieve a better overview of the user program, you 
can also subdivide your program into several networks.

See also
Entering the network title (Page 1309)

Entering a network comment (Page 1310)

Navigating networks (Page 1311)

Inserting networks

Requirement 
A block is open.
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Procedure
To insert a new network, follow these steps:

1. Select the network after which you want to insert a new network.

2. Select the "Insert network" command in the shortcut menu.

Result
A new empty network is inserted into the block. 

See also
Entering the network title (Page 1309)

Entering a network comment (Page 1310)

Navigating networks (Page 1311)

Selecting networks

Requirements
A network is available.

Selecting a network
To select a network, follow these steps:

1. Click the title bar of the network that you want to select.

Selecting several networks
Proceed as follows to select several individual networks:

1. Press and hold down the <Ctrl> key.

2. Click all the networks that you want to select.

To select several successive networks, follow these steps:

1. Press and hold down the <Shift> key.

2. Click the first network that you want to select.

3. Click the last network that you want to select.
The first and last networks and all those in between are selected. 
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See also
Inserting networks (Page 1305)

Entering the network title (Page 1309)

Entering a network comment (Page 1310)

Navigating networks (Page 1311)

Copying and pasting networks
Copied networks can be pasted within the block or in another block. Networks that were created 
in LAD or FBD can also be inserted in blocks of the respective other programming language.

Requirement     
A network is available.

Procedure
To copy and paste a network, follow these steps:

1. Select the network or networks to be copied.

2. Select "Copy" in the shortcut menu.

3. Select the network after which you want to paste in the copied network.

4. Select "Paste" in the shortcut menu.

See also
Inserting networks (Page 1305)

Selecting networks (Page 1306)

Entering the network title (Page 1309)

Entering a network comment (Page 1310)

Navigating networks (Page 1311)

Deleting networks

Requirement
A network is available.
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Procedure
To delete a network, follow these steps:

1. Select the network that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Inserting networks (Page 1305)

Selecting networks (Page 1306)

Copying and pasting networks (Page 1307)

Entering the network title (Page 1309)

Entering a network comment (Page 1310)

Navigating networks (Page 1311)

Expanding and collapsing networks

Requirements  
A network is available.

Opening and closing a network
To open a network, follow these steps:

1. Click on the right arrow in the network title bar.

To close a network, follow these steps:
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1. Click on the down arrow in the network title bar.

Opening and closing all networks
To open and close all networks, follow these steps:

1. In the toolbar, click "Open all networks" or "Close all networks".

See also
Inserting networks (Page 1305)

Selecting networks (Page 1306)

Copying and pasting networks (Page 1307)

Deleting networks (Page 1307)

Entering the network title (Page 1309)

Entering a network comment (Page 1310)

Navigating networks (Page 1311)

Entering the network title
The network title is the header of a network. The length of the network title is limited to one 
line.

Requirement 
A network is available.

Procedure
To enter a network title, follow these steps:

1. Click on the title bar of the network.

2. Enter the network title.
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See also
Using networks (Page 1305)

Inserting networks (Page 1305)

Selecting networks (Page 1306)

Copying and pasting networks (Page 1307)

Deleting networks (Page 1307)

Expanding and collapsing networks (Page 1308)

Entering a network comment (Page 1310)

Navigating networks (Page 1311)

Entering a network comment
You can use network comments to provide comments on the program contents of individual 
networks. For example, you can indicate the function of the network or draw attention to special 
characteristics. 

Requirement  
A network is available.

Procedure
To enter a network comment, follow these steps:

1. Click on the right arrow before the network title.

2. If the comment area is not visible, click "Network comments on/off" in the toolbar.
The comment area is displayed.

3. Click "Comment" in the comment area.
The "Comment" text passage is selected.

4. Enter the network comment.
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See also
Using networks (Page 1305)

Inserting networks (Page 1305)

Selecting networks (Page 1306)

Copying and pasting networks (Page 1307)

Deleting networks (Page 1307)

Expanding and collapsing networks (Page 1308)

Entering the network title (Page 1309)

Navigating networks (Page 1311)

Navigating networks
You can navigate straight to a specific position within a block.

Procedure 
To navigate to a specific position within a block, follow these steps:

1. Right-click in the code area of the programming window.

2. Select the "Go to > Network/line" command in the shortcut menu.
The "Go to" dialog will open.

3. Enter the network to which you want to navigate.

4. Enter the line number of the network to which you want to navigate.

5. Confirm your entry with "OK".

Result
The relevant line will be displayed if this is possible. If the network or line requested does not 
exist, the last existing network or the last existing line in the network requested will be displayed. 

See also
Using networks (Page 1305)

Inserting networks (Page 1305)

Selecting networks (Page 1306)

Copying and pasting networks (Page 1307)

Deleting networks (Page 1307)

Expanding and collapsing networks (Page 1308)

Entering the network title (Page 1309)

Entering a network comment (Page 1310)
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Inserting FBD elements

Rules for the use of FBD elements

Rules   
Note the following rules when inserting FBD elements:

● An FBD network can consist of several elements. All elements of a logic path must be linked 
to each other according to IEC 61131-3.

● Standard boxes (flip flops, counters, timers, math operations, etc.) can be added as output 
to boxes with binary logic operations (for example, AND, OR). Comparison boxes are 
excluded from this rule.

● Only Boolean inputs in an instruction can be combined with preceding logic operations.

● Only the bottom Boolean output in an instruction can be combined with an additional logic 
operation.

● Enable input EN or enable output ENO can be connected to boxes, but this is not mandatory.

● Constants (for example, TRUE or FALSE) cannot be assigned to binary logic operations. 
Instead, use tags of the BOOL data type.

● Only one jump instruction can be inserted in each network.

● Only one jump label can be inserted in each network.

● Instructions for positive or negative RLO edge detection may not be arranged right at the 
left of the network as this requires a prior logic operation.

Placement rules for S7-1200/1500 CPUs
The following table sets out the instructions that can only be positioned at the end of the 
network:

Instruction Preceding logic operation 
requiredMnemonics Name

SET_BF Set bit field No
RESET_BF Reset bit field No
JMP Jump if RLO = 1 No
JMPN Jump if RLO = 0 Yes
JMP_LIST Define jump list No
SWITCH Jump distributor No
RET Return No
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Placement rules for S7-300/400 CPUs
The following table sets out the instructions that can only be positioned at the end of the 
network:

Instruction Preceding logic operation 
requiredMnemonic

s
Name

S Set output Yes
R Reset output Yes
SP Start pulse timer Yes
SE Start extended pulse timer Yes
SD Start on-delay timer Yes
SS Start retentive on-delay timer Yes
SF Start off-delay timer Yes
SC Set counter value Yes
CU Count up Yes
CD Count down Yes
JMP Jump if RLO = 1 No
JMPN Jump if RLO = 0 Yes
RET Return No
OPN Open global data block No
OPNI Open instance data block No
CALL Call block No
SAVE Save RLO in BR bit No
MCRA Enable MCR range No
MCRD Disable MCR range No
MCR< Open MCR ranges No
MCR> Close MCR ranges No

Inserting FBD elements using the "Instructions" task card

Requirement   
A network is available.
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Procedure
To insert FBD elements into a network using the "Instructions" task card, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to the FBD element that you want to insert.

3. Use drag-and-drop to move the element to the desired place in the network.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multiple instance", 
these are located in the block interface in the "Static" section.

Or:

1. Select the point in the network at which you want to insert the element.

2. Open the "Instructions" task card.

3. Double-click on the element you want to insert.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multiple instance", 
these are located in the block interface in the "Static" section.

Result
The selected FBD element is inserted with dummy entries for the parameters. 

See also
Rules for the use of FBD elements (Page 1312)

Inserting FBD elements using an empty box

Requirement  
A network is available.

Procedure  
To insert FBD elements into a network using an empty box, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Empty box" in the "Basic instructions" palette.

3. Use a drag-and-drop operation to move the "Empty box" element to the desired place in 
the network.
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4. Position the cursor over the triangle in the top right-hand corner of the empty box.
A drop-down list is displayed.

5. Select the desired FBD element from the drop-down list.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multi-instance", these 
are located in the block interface in the "Static" section.

Result
The empty box is changed to the respective FBD element. Placeholders are inserted for the 
parameters. 

Selecting the data type of an FBD element

Selecting a data type

Introduction
Some instructions can be executed with several different data types. If you use one of these 
instructions in the program, you have to specify a valid data type for the instruction at the 
specific point in the program. For some instructions, you have to select the data types for the 
inputs and outputs separately. 

 

 Note

The valid data type (BOOL) for the tags on the enable input EN and the enable output ENO 
is predefined by the system and cannot be changed. 

 

The valid data types for an instruction are listed in the instruction drop-down list. You specify 
the data type of the instruction by selecting an entry from the drop-down list. If the data type 
of an operand differs from the data type of the instruction and cannot be converted implicitly, 
the operand is displayed in red and a rollout with the corresponding error message appears. 

Data type selection of mathematical instructions
Some mathematical instructions provide you with the option of having the data type 
automatically set corresponding to the data types of the operand. In the drop-down list for data 
type selection, these instructions have the entry "Auto" in addition to the actual data types. If 
you select this entry and then allocate the first operand, the data type of the operand is selected 
as data type for the instruction. The entry in the drop-down list changes to "Auto (<Data type>)", 
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e.g. "Auto (Real)". If you allocate additional operands, the automatically set data type of the 
instruction is adjusted according to the following criteria:

● You supply all other operands with tags of the same data type: 
The data type of the instruction is not changed.

● You supply all other operands with tags whose data type is smaller than the data type of 
the instruction: 
The data type of the instruction is not changed. For the operand with the smaller data type, 
an implicit conversion is conducted if necessary.

● You supply an additional operand with a tag whose data type is greater than the data type 
of the instruction:
The data type of the instruction is changed to the larger data type. An implicit conversion 
is performed, if necessary, for operands that deviate from the newly set data type of the 
instruction.

Each change in the data type of an operand can result in a change of the data type of the 
instruction. Other operands may possibly be implicitly converted as a result. Operands for 
which an implicit conversion is performed are marked with a gray square.

 

 Note

Please also observe the information on data type conversion for your device and, in particular, 
the notes on the IEC check. 

See also: Data type conversion
 

See also
Defining the data type of an instruction (Page 1316)

Defining the data type of an instruction

Introduction
Some instructions can be executed with several different data types. When you insert such 
instructions into your program, you must specify the data type for these instructions at the 
actual point in the program. 

Specifying the data type by means of the drop-down list
To define the data type of an instruction using the drop-down list, follow these steps:

1. Insert the instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. Click the triangle in the upper corner of the drop-down list.
The drop-down list will open to display the data types valid for the instruction.
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3. Select a data type from the drop-down list.
The selected data type is displayed.

4. If the instruction has two drop-down lists, select the data type for the instruction inputs in 
the left-hand drop-down list and the data type for the instruction outputs in the right-hand 
drop-down list.

Specifying data type by assigning tags
To define the data type of an instruction by assigning tags, follow these steps:

1. Insert the instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. At an input or output, specify a valid tag, the data type of which is to be applied as the 
instruction data type.
The data type of the tag is displayed in the drop-down list.

3. Enter a valid tag at an input and a valid tag at an output if data types need to be defined 
for both the inputs and outputs of the instruction. The tag specified at the input determines 
the data type of the inputs; the tag specified at the output determines the data type of the 
outputs of the instruction.

Automatically specifying the data type of mathematical instructions
To automatically specify the data type for mathematical instructions, follow these steps:

1. Insert the mathematical instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. Select the "Auto" entry from the drop-down list.

3. Enter a valid tag at an input or output. 
The data type of the tag is applied as data type of the instruction. The entry in the drop-
down list changes to "Auto (<Data type>)".

See also: Selecting a data type (Page 1315)

See also
Selecting a data type (Page 1315)

Using favorites in FBD

Adding FBD elements to Favorites

Requirement  
● A block is open.

● The multipane mode is set for the "Instructions" task card or the Favorites are also displayed 
in the editor.
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Procedure
To add SCL instructions to the Favorites, follow these steps:

1. Open the "Instructions" task card.

2. Maximize the "Basic instructions" pane.

3. Navigate in the "Basic instructions" pane to the instruction that you want to add to the 
Favorites.

4. Drag-and-drop the instruction into the "Favorites" pane or into the Favorites area in the 
program editor.

 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Removing FBD elements from Favorites (Page 1319)

Overview of the program editor (Page 1219)

Inserting FBD elements using favorites

Requirement  
● A block is open.

● Favorites are available.

Procedure
To insert an instruction into a program using Favorites, follow these steps:

1. Drag-and-drop the desired instruction from Favorites to the desired position.

Or:

1. Select the position in the program where you want to insert the instruction.

2. In the Favorites, click on the instruction you want to insert.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.
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See also
Overview of the program editor (Page 1219)

Removing FBD elements from Favorites (Page 1319)

Removing FBD elements from Favorites

Requirement
A code block is open. 

Procedure
To remove instructions from Favorites, follow these steps:

1. Right-click on the instruction you want to remove.

2. Select the "Remove instruction" command in the shortcut menu.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Adding FBD elements to Favorites (Page 1317)

Inserting FBD elements using favorites (Page 1318)

Overview of the program editor (Page 1219)

Inserting block calls in FBD

Inserting block calls using a drag-and-drop operation
You can insert calls for existing functions (FC) and function blocks (FB) using a drag-and-drop 
operation from the project tree. If you call function blocks from other function blocks, you can 
either call them as single-instance or multi-instance blocks. If a function block is called as single 
instance, it will store its data in a data block of its own. If a function block is called as multi-
instance, it will store its data in the instance data block of the calling function block.

Requirement    
● A network is available.

● The block that is to be called is available.
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Inserting a call of a function (FC)
To insert a call of a function (FC) into a network using a drag-and-drop operation, follow these 
steps:

1. Drag the function from the project tree to the required network.

Inserting a call for a function block (FB)
To insert a call for a function block (FB), follow these steps:

1. Drag the function block from the project tree to the required network.
The "Call options" dialog opens.

2. Enter in the dialog whether you wish to call the block as single or multi-instance.

– If you click on the "Single instance" button, you will have to enter a name in the "Name" 
text box for the data block that you want to assign to the function block.

– If you click on the "Multi-instance" button, you will have to enter the name of the tag in 
the "Name in the interface" text box; this is the name that you use to enter the called 
function block as a static tag in the interface of the calling block.

3. Confirm your entries with "OK".

Result
The function or the function block is inserted with its parameters. You can then assign the 
parameters. 

See also: Auto-Hotspot 
 

 Note

If when calling a function block you specify an instance data block that does not exist, it will 
be created. If you have called a function block as a multi-instance, this will be entered as a 
static tag in the interface.

 

 

See also
Updating block calls in FBD (Page 1320)

Changing the instance type (Page 1321)

Single instances (Page 1035)

Multi-instances (Page 1035)

Updating block calls in FBD
If interface parameters of a called block are changed, the block call can no longer be executed 
correctly. You can avoid such inconsistent block calls by updating the block calls.

You have two options to update the block calls:
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● Explicit updating in the program editor.
The block calls in the open block will be updated. 

● Implicit updating during compilation.
All block calls in the program as well as the used PLC data types will be updated.

Update blocks in the program editor  
To update a block call within a block, follow these steps:

1. Open the block in the program editor.

2. Click "Update inconsistent block calls" in the toolbar.

Or:

1. Open the block in the program editor.

2. Right-click on the instruction with the block call.

3. Select the "Update" command in the shortcut menu.
The "Interface update" dialog opens. This dialog shows the differences between the block 
interface in use and the changed interface of the called block.

4. If you want to update the block call, click "OK". To cancel the update, click "Cancel".

Update block calls during compilation
Follow these steps to update all block calls and uses of PLC data types during compilation 
implicitly:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebuild all blocks)" in the shortcut menu.

See also
Inserting block calls using a drag-and-drop operation (Page 1319)

Changing the instance type (Page 1321)

Changing the instance type

Instance type
There are two ways of calling function blocks:

● As a single instance

● As a multiple instance

See also: Auto-Hotspot 

You can modify a defined instance type at any time.
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Requirement       
The user program contains a block call.

Procedure
To change the instance type of a function block, follow these steps:

1. Open the code block and select the block call.

2. Select the "Change instance" command in the shortcut menu.
The "Call options" dialog opens.

3. Click the "Single instance" or "Multi instance" button.

– If you select the "Single instance" instance type, enter a name for the data block that is 
to be assigned to the function block.

– If you select "Multiple instance" as the instance type, enter in the "Name in the interface" 
text field the name of the tag with which the called function block is to be entered as a 
static tag in the interface of the calling block.

4. Confirm your entries with "OK".
 

 Note

The previous single and multiple instances will not be deleted automatically.
 

See also
Inserting block calls using a drag-and-drop operation (Page 1319)

Updating block calls in FBD (Page 1320)

Inserting complex FBD instructions

Using the "Calculate" instruction

Requirement    
A network is available.

Procedure
Proceed as follows to use the "Calculate" instruction:

1. Open the "Instructions" task card.

2. Navigate to "Math functions > CALCULATE" in the "Basic instructions" pane.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1322 System Manual, 07/2013,  



3. Use drag-and-drop to move the element to the desired place in the network.
The instruction "Calculate" will be inserted for the data type with a placeholder expression 
and question mark.

4. Enter the data type for the calculation.

5. Enter the operands for the calculation.
 

  Note

The calculation is run with the inputs of the "Calculate" instruction. If you want to use 
constants you must also insert appropriate inputs for them.

 

6. Click on the "Edit 'Calculate' instruction" button to replace the placeholder expression with 
the correct expression.
The "Edit 'Calculate' instruction" dialog will open.

7. Enter the required expression in the "OUT:= " text box.
 

  Note

In the "Example" area you can find an example of a valid expression and possible 
instructions that you can use. 

To determine a value with the help of Pythagoras' theorem, for example, enter "OUT := 
SQRT (SQR (IN1) + SQR (IN2))".

 

8. Confirm your entry with "OK".

See also
CALCULATE: Calculate (Page 1935)

Using free-form comments

Basic information on using free comments in FBD 

Introduction   
Free-form comments allow you to add comments to the source code for graphic programming 
languages similar to line comments for textual languages.

Free-form comments can be used for all non-binary boxes.

See also
Inserting free-form comments (Page 1324)

Editing free-form comments (Page 1324)

Deleting free-form comments (Page 1325)
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Inserting free-form comments

Requirement
A network with instructions is available.

Procedure  
To insert a free comment on an instruction, proceed as follows:

1. If necessary, activate the "Free-form comments on/off" button in the toolbar.

2. Right-click on the instruction for which you want to insert a free-form comment.

3. Select the "Insert comment" command in the shortcut menu.
A comment box with a standard comment opens. The comment box is connected by an 
arrow to the corresponding instruction.

4. Enter the required comment in the comment box.

See also
Basic information on using free comments in FBD  (Page 1323)

Editing free-form comments (Page 1324)

Deleting free-form comments (Page 1325)

Editing free-form comments

Introduction  
Free-form comments can be edited as follows:

● Changing the comment text

● Changing the position and size of the comment box

● Attaching a comment to another element

● Showing and hiding free comments

Changing the comment text
To change the text of free-form comments, follow these steps:

1. Click on the comment box.

2. Enter the desired text.
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Changing the position of the comment box
To change the positioning of the comment box, follow the steps below:

1. Left-click the comment box and keep the mouse button pressed.

2. Drag the comment box to the desired location.

Changing the size of the comment box
To change the size of the comment box, follow the steps below:

1. Click on the comment box.

2. Drag the comment box on the move handle in the lower right corner to the desired size.

Attaching a comment to another element
To attach a free-form comment to another element, follow these steps:

1. Left-click the point of the arrow that links the comment box with the instruction and keep 
the mouse button pressed.

2. Drag the arrow to the element to which you want to attach the comment. Possible insertion 
points are marked with a green square.

3. Release the mouse button.

Showing and hiding free comments
To show or hide a free-form comments, follow these steps:

1. Click the "Free-form comment on/off" button in the toolbar.

See also
Basic information on using free comments in FBD  (Page 1323)

Inserting free-form comments (Page 1324)

Deleting free-form comments (Page 1325)

Deleting free-form comments

Procedure  
To delete a free-form comment, proceed as follows:

1. Right-click on the free-form comment that you want to delete.

2. Select the "Delete" command in the shortcut menu.
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See also
Basic information on using free comments in FBD  (Page 1323)

Inserting free-form comments (Page 1324)

Editing free-form comments (Page 1324)

Editing FBD elements

Selecting FBD elements
You can select several individual elements or all elements in a network.

Requirement  
FBD elements are available

Selecting several individual FBD elements
To select several individual FBD elements, follow these steps:

1. Press and hold down the <Ctrl> key.

2. Click on all the FBD elements you wish to select.

3. Now release the <Ctrl> key.

Selecting all FBD elements in a network
To select all FBD elements in a network, follow these steps:

1. Go to the network whose elements you wish to select.

2. Select the "Select all" command in the "Edit" menu or press <Ctrl+A>.

See also
Copying FBD elements (Page 1327)

Cutting FBD elements (Page 1327)

Pasting an FBD element from the clipboard (Page 1328)

Replacing FBD elements  (Page 1328)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Enabling and disabling the EN/ENO mechanism (Page 1331)

Deleting FBD elements (Page 1332)
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Copying FBD elements

Requirement 
An FBD element is available.

Procedure
To copy an FBD element, follow these steps:

1. Right-click the FBD element that you want to copy.

2. Select "Copy" in the shortcut menu.

Result
The FBD element will be copied and saved to the clipboard.

See also
Selecting FBD elements (Page 1326)

Cutting FBD elements (Page 1327)

Pasting an FBD element from the clipboard (Page 1328)

Replacing FBD elements  (Page 1328)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Enabling and disabling the EN/ENO mechanism (Page 1331)

Deleting FBD elements (Page 1332)

Cutting FBD elements

Requirement 
An FBD element is available.

Cutting
To cut an FBD element, follow these steps:

1. Right-click the FBD element that you want to cut.

2. Select "Cut" in the shortcut menu.

Result
The FBD element will be cut and saved to the clipboard.
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See also
Selecting FBD elements (Page 1326)

Copying FBD elements (Page 1327)

Pasting an FBD element from the clipboard (Page 1328)

Replacing FBD elements  (Page 1328)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Enabling and disabling the EN/ENO mechanism (Page 1331)

Deleting FBD elements (Page 1332)

Pasting an FBD element from the clipboard

Requirement
An FBD element is available.

Procedure
To paste an FBD element from the clipboard, follow these steps:

1. Copy an FBD element or cut an FBD element.

2. Right-click the point in the network where you want to paste the element.

3. Select "Paste" in the shortcut menu.

See also
Selecting FBD elements (Page 1326)

Copying FBD elements (Page 1327)

Cutting FBD elements (Page 1327)

Replacing FBD elements  (Page 1328)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Enabling and disabling the EN/ENO mechanism (Page 1331)

Deleting FBD elements (Page 1332)

Replacing FBD elements 
You can easily exchange FBD elements with other FBD elements of the same type. This has 
the advantage that the parameters are retained and need not be entered again. For example, 
you can exchange OR and AND, RS-FlipFlop and SR-FlipFlop, comparison functions or jump 
instructions.
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Requirements 
A network with at least one FBD element is present.

Procedure
To replace an FBD element with another FBD element, follow these steps:

1. Select the FBD element that you want to replace.
If elements compatible with the selected FBD element are available, a triangle will appear 
in the upper right-hand corner of the element.

2. Position the cursor above the triangle of the FBD element.
A drop-down list is displayed.

3. From the drop-down list, select the FBD element that you want to use to replace the existing 
FBD element.

 

See also
Selecting FBD elements (Page 1326)

Copying FBD elements (Page 1327)

Cutting FBD elements (Page 1327)

Pasting an FBD element from the clipboard (Page 1328)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Enabling and disabling the EN/ENO mechanism (Page 1331)

Deleting FBD elements (Page 1332)

Adding additional inputs and outputs to FBD elements

Introduction   
You can expand several FBD elements with additional inputs that execute arithmetic or binary 
operations. Such elements are, for example, the instructions "Add" (ADD), "Multiply" (MUL), 
AND or OR. You can expand the "MOVE value" (MOVE) and "Demultiplex" (DEMUX) 
instruction boxes by adding additional outputs.

The name of the new inputs and outputs is comprised of the type of inserted element and a 
consecutive number. The name of a new input is may be "IN2"; the name of a new output may 
be "OUT2".

Requirements
An FBD element is available that permits the insertion of additional inputs and outputs.
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Inserting an additional input
To add an additional input to the box of an FBD element, follow these steps:

1. Right-click on an existing input of the FBD element.

2. Select "Insert input" in the shortcut menu.
An additional input is added to the box of the FBD element.

Or:

1. Click on the yellow star symbol beside the last input in the instruction box.
An additional input is added to the box of the FBD element.

Inserting an additional output
To add an additional output to the box of an FBD element, follow these steps:

1. Right-click on an existing output of the FBD element.

2. Select "Insert output" from the shortcut menu.
An additional output is added to the box of the FBD element.

Or:

1. Click on the yellow star symbol beside the last output of the instruction box.
An additional output is added to the box of the FBD element.

See also
Selecting FBD elements (Page 1326)

Copying FBD elements (Page 1327)

Cutting FBD elements (Page 1327)

Pasting an FBD element from the clipboard (Page 1328)

Replacing FBD elements  (Page 1328)

Removing instruction inputs and outputs (Page 1330)

Enabling and disabling the EN/ENO mechanism (Page 1331)

Deleting FBD elements (Page 1332)

Removing instruction inputs and outputs

Introduction  
Inputs and outputs which you have added to an instruction can be removed.

Requirement
An FBD element is available, which you have expanded with additional inputs or outputs.
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Remove input
To remove an input, follow these steps:

1. Select the input that you want to remove.

2. Select the "Delete" command in the shortcut menu.
The input of the FBD element is removed.

Remove output
To remove an output, follow these steps:

1. Select the output that you want to remove.

2. Select the "Delete" command in the shortcut menu.
The output of the FBD element will be removed.

 

See also
Selecting FBD elements (Page 1326)

Copying FBD elements (Page 1327)

Cutting FBD elements (Page 1327)

Pasting an FBD element from the clipboard (Page 1328)

Replacing FBD elements  (Page 1328)

Adding additional inputs and outputs to FBD elements (Page 1329)

Enabling and disabling the EN/ENO mechanism (Page 1331)

Deleting FBD elements (Page 1332)

Enabling and disabling the EN/ENO mechanism
In LAD and FBD, certain instructions have an enable output ENO and thus use the EN/ENO 
mechanism. This allows you to query runtime errors in instructions and react to them. In order 
to increase the performance of the CPU, the EN/ENO mechanism is disabled in the default 
setting. This means that you are not initially able to react to runtime errors of the instruction 
using the ENO value. However, you can enable the EN/ENO mechanism again at any time, if 
required.

You can enable the EN/ENO mechanism individually for each instruction in order to generate 
the ENO. If you enable the EN/ENO mechanism for an instruction, other instructions that you 
subsequently add to your program are also inserted with the EN/ENO mechanism enabled. 
You can disable the EN/ENO mechanism again at any time if you do not want to use the 
evaluation of ENO for an instruction. Further instructions that you subsequently add to your 
program will then be inserted without the EN/ENO mechanism.

See also: Basics of the EN/ENO mechanism (Page 1167) 
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Activating the EN/ENO mechanism
Proceed as follows to activate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to activate the EN/ENO 
mechanism.

2. Select the "Generate ENO" command from the shortcut menu.
The ENO value is again generated for the instruction. Other instructions are inserted with 
the enable output.

Deactivating the EN/ENO mechanism
Proceed as follows to deactivate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to deactivate the EN/ENO 
mechanism.

2. Select the "Do not generate ENO" command from the shortcut menu.
The ENO value is no longer generated for the instruction. Other instructions are inserted 
without enable output.

See also
Selecting FBD elements (Page 1326)

Copying FBD elements (Page 1327)

Cutting FBD elements (Page 1327)

Pasting an FBD element from the clipboard (Page 1328)

Replacing FBD elements  (Page 1328)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Deleting FBD elements (Page 1332)

Deleting FBD elements

Requirement
An FBD element is available.

Procedure
To delete an FBD element, follow these steps:

1. Right-click the FBD element that you want to delete.

2. Select the "Delete" command in the shortcut menu.
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See also
Selecting FBD elements (Page 1326)

Copying FBD elements (Page 1327)

Cutting FBD elements (Page 1327)

Pasting an FBD element from the clipboard (Page 1328)

Replacing FBD elements  (Page 1328)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Enabling and disabling the EN/ENO mechanism (Page 1331)

Inserting operands in FBD instructions

Inserting operands
The character strings "<???>", "<??.?>" and "..." are inserted as placeholders for the 
parameters when a FBD element is inserted. The "<???>" and "<??.?>" strings displayed in 
red indicate parameters that need to be connected. The "..." string displayed in black indicates 
parameters that may be connected. "<??.?>" stands for Boolean placeholders.

 

 Note

To display the available data types in a tooltip, move the cursor over the placeholder.
 

Requirement   
An FBD element is available.

Procedure
To connect the parameters of an FBD element, follow these steps:

1. Click the placeholder of the parameter.
An input field is opened.

2. Enter the corresponding parameters, for example a PLC tag, a local tag or a constant.
 

  Note

If you enter the absolute address of a parameter that has already been defined, this 
absolute address will be changed to the symbolic name of the parameter as soon as the 
input is confirmed. If you have not yet defined the parameter, a new tag with this absolute 
address and the default name "Tag_1" will be entered in the PLC tag table. When you 
confirm your input, the absolute address will be replaced with the symbolic name "Tag_1".
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3. Confirm the parameter with the Enter key.

4. If you have not yet defined the parameter, you can define it directly in the program editor 
using the shortcut menu.
See also: "Declaring PLC tags in the program editor (Page 1181)".

Or drag from it the PLC tag table:

1. In the project tree, select the "PLC tags" folder and open the PLC tag table.

2. If you have opened the PLC tag table, drag the desired tag to the corresponding location 
in your program. If you have not opened the PLC tag table yet, open the detail view now. 
Drag the desired tag from the detail view to the appropriate place in your program.

Or drag from it the block interface:

1. Open the block interface.

2. Drag the desired operand from the block interface to the corresponding location in your 
program.

 

Result
● If the syntax is error-free, the displayed parameter is black.

● If there is an error in the syntax, the cursor stays in the input field and a corresponding error 
message is displayed in the inspector window in the "Info > Syntax" register.

Wiring hidden parameters

Introduction  
Depending on the CPU used, you can use complex instructions in your program that are 
dispatched with the TIA portal. These instructions can contain parameters that are declared 
as hidden. 

If an instruction contains hidden parameters, the instruction box has a small arrow on the lower 
edge. You can recognize hidden parameters by their white font. 

You can show and wire the hidden parameters at any time.

Showing or hiding hidden parameters
To show or hide hidden parameters, follow these steps:

1. Click on the down arrow at the bottom edge of the instruction box to show hidden 
parameters.

2. Click on the up arrow at the bottom edge of the instruction box to hide hidden parameters.
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Wiring hidden parameters
To wire parameters, follow these steps:

1. Wire the hidden parameters like normally visible parameters.
The hidden parameter is transformed into a visible parameter.

See also
Using libraries (Page 338)

Displaying or hiding variable information

Introduction     
You can display the following information about the tags to be used in the programming editor:

● Name of the tags

● Address of the tags

● Comments to document the tags

The information is taken from the block interface for local tags and DB tags and from the PLC 
tag table for tags that are valid CPU-wide. 

You can display the tag information either for all the blocks or for individually opened blocks. 
If you display the tag information for all the blocks, the tag information for all the blocks currently 
opened and opened in future is shown.

You can hide the tag information at any time again. If you hidden the tag information for all the 
blocks, you display it again for individual ones that are opened.

Displaying or hiding tag information for all the blocks
Proceed as follows to display or hide the tag information for all the blocks:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. If you want to display the tag information activate the check box "With tag information" in 
the "View" section. If you want to hide the tag information, clear the "With tag information" 
check box.
The tag information is displayed or hidden for all the blocks. When you open further blocks, 
the tag information is displayed or not displayed depending on the selected setting. 
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Displaying or hiding tag information for an opened block
Proceed as follows to display or hide the tag information for an opened block:

1. Activate or deactivate the "Tag information" check box in the menu "View > Display with" 
or click the "Tag information on/off" button in the toolbar.
The tag information is displayed or hidden. 

Branches in FBD

Basic information on branches in FBD

Definition
You can use the Function Block Diagram (FBD) programming language to program parallel 
branches. This is done using branches that are inserted between the boxes. You can insert 
additional boxes within the branch and in this way build up complex function block diagrams.

The figure below shows an example of the use of branches:

See also
Rules for branches in FBD (Page 1336)

Inserting branches in FBD networks  (Page 1337)

Deleting branches in FBD networks  (Page 1337)

Rules for branches in FBD

Rules  
The following rules apply to the use of branches in FBD:

● Branches are opened downward.

● Branches can be inserted only between FBD elements.

● To delete a branch, you must delete all FBD elements, including the branch itself.

● If you delete the connection between two branches, the FBD elements of the interrupted 
branch will be positioned freely in the network.
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See also
Basic information on branches in FBD (Page 1336)

Inserting branches in FBD networks  (Page 1337)

Deleting branches in FBD networks  (Page 1337)

Inserting branches in FBD networks 

Requirement  
A network is available.

Procedure
To insert a new branch in a network, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Branch" in the "Basic instructions" palette.

3. Drag the element from the "Elements" pane to the a required location on a connection line 
between two boxes.

See also
Rules for branches in FBD (Page 1336)

Basic information on branches in FBD (Page 1336)

Deleting branches in FBD networks  (Page 1337)

Deleting branches in FBD networks 

Requirement
A branch is available.

Procedure
To delete a branch, follow these steps:

1. Select the connection line that links the branch to the main branch.

2. Select the "Delete" command in the shortcut menu.

Result
The branch is now deleted. Boxes connected to the deleted branch are placed freely within 
the network. 
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See also
Rules for branches in FBD (Page 1336)

Basic information on branches in FBD (Page 1336)

Inserting branches in FBD networks  (Page 1337)

Logic paths in FBD

Basic information on logic paths in FBD

Use of logic paths  
The user program will be mapped in one or more networks. The networks can contain one or 
more logic paths on which the binary signals are arranged in the form of boxes. 

The following figure shows an example of the use of several logic paths within a network:

Rules
Remember the following rules when using logic paths:

● Connections are not permitted between logic paths.

● Only one jump instruction is permissible per network. The positioning rules for jump 
instructions remain valid.

Executing logic paths
Logic paths are executed from top to bottom and from left to right. This means that the first 
instruction in the first logic path of the first network is executed first. All instructions of this logic 
path are then executed. After this come all other logic paths of the first network. The next 
network is executed only after all logic paths have first been executed. 

When jumps are used the regular execution of the logic paths is circumvented and the 
instruction is executed at the jump destination.
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Differences between branches and logic paths
The difference between branches and logic paths is that the logic paths are independent 
branches that can also stand in a different network. Branches, on the other hand, permit the 
programming of a parallel connection and have a common preceding logic operation.

See also
Inserting a logic path (Page 1339)

Deleting a logic operation path (Page 1339)

Inserting a logic path

Requirement
● A block is open.

● A network is available.

Procedure  
To insert a new logic path in a network, follow these steps:

1. Insert any instruction in a network in such a way that it has no connection to existing 
instructions.
A new logic path is inserted.

2. Insert an assignment at the end of the new logic path.

3. Insert additional instructions in the new logic path.

 

See also
Basic information on logic paths in FBD (Page 1338)

Deleting a logic operation path (Page 1339)

Deleting a logic operation path

Requirement
A logic path is available.
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Procedure   
To delete a logic path, proceed as follows:

1. Hold down the left mouse button and draw a frame around the logic path. At the same time, 
make sure that you select all instructions of the logic path. Alternatively, you can hold down 
the <Shift> key and select the first the last instruction of the logic path.

2. Right-click on one of the instructions in the logic path.

3. Select the "Delete" command in the shortcut menu.

See also
Basic information on logic paths in FBD (Page 1338)

Inserting a logic path (Page 1339)

Creating SCL programs

Basics of SCL

Programming language SCL

Programming language SCL  
SCL (Structured Control Language) is a high-level programming language based on PASCAL. 
The language is based on DIN EN 61131-3 (international IEC 1131-3).

The standard standardizes programming languages for programmable logic controllers. The 
SCL programming language fulfills the PLCopen Basis Level of ST language (Structured Text) 
defined in this standard. 

Language elements
SCL also contains higher programming languages in addition to the typical elements of the 
PLC, such as inputs, outputs, timers or memory bits.

● Expressions

● Value assignments

● Operators

Program control
SCL provides convenient instructions for controlling the program allowing you, for example, to 
create program branches, loops or jumps.
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Application 
SCL is therefore particularly suitable for the following areas of application: 

● Data management

● Process optimization

● Recipe management

● Mathematical / statistical tasks

Expressions

Description  
Expressions are calculated during the runtime of the program and return a value. An expression 
consists of operands (such as constants, tags or function calls) and optionally out of operators 
(such as *, /, + or -). Expressions can be linked together or nested within each other by 
operators. 

Evaluation order
The evaluation of the expression occurs in a specific order that is defined by the following 
factors:

● Priority of the operators involved

● Left-to-right order

● Brackets

Types of expressions
The following expression types are available depending on the operator:

● Arithmetic expressions
Arithmetic expressions consist of either a numerical value or combine two values or 
expressions with arithmetic operators.

● Relational expressions
Relational expressions compare the values of two operands and yield a Boolean value. 
The result is TRUE if the comparison is true, and FALSE if it is not met.

● Logical expressions
Logical expressions combine two operands with logical operators (AND, OR, XOR) or 
negating operands (NOT).
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How expressions are used
You can use the result of an expression in different ways:

● As a value assignment for a tag

● As as a condition for a control instruction

● As a parameter for a calling a block or instruction

See also
Operators and operator precedence (Page 1347)

Arithmetic expressions (Page 1342)

Relational expressions (Page 1344)

Logical expressions (Page 1346)

Arithmetic expressions

Description
Arithmetic expressions consist of either a numerical value or combine two values or 
expressions with arithmetic operators. 

Arithmetic operators can process the data types that are allowed in the CPU in use. If two 
operands are involved in the operation, the data type of the result is determined based on the 
following criteria:

● If both operands are integers with sign and have different lengths, the result receives the 
data type of the longer integer (e. g. INT + DINT = DINT).

● If both operands are integers without sign and have different lengths, the result receives 
the data type of the longer integer (e. g. USINT + UDINT = UDINT).

● If one operand is an integer with sign and the other integer is an operand without sign, the 
result receives the next larger data type with sign that covers the integer without sign (e. 
g. SINT + USINT = INT).
You can only execute an operation with such operands if the IEC check is not set.

● If one operand is an integer and the other operand is a floating-point number, the result 
receives the data type of the floating-point number (e. g. INT + REAL = REAL).

● If both operands are floating-point numbers and have different lengths, the result receives 
the data type of the longer floating-point number (e. g. REAL + LREAL = LREAL).

● The data type of the result of an operation that involves operands of the data type groups 
"Times" and "Date and time" can be found in the table in section "Data types of arithmetic 
expressions".
You cannot use data types of the data type groups "Times" and "Date and time" when the 
IEC check is set.
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Data types of arithmetic expressions
The following table shows the data types you can use in arithmetic expressions:

Operation Operator 1st Operand 2nd Operand Result
Power ** Integer/floating-point 

number
Integer/floating-point 
number

Integer/floating-point 
number

Unary plus + Integer/floating-point 
number
TIME, LTIME

- Integer/floating-point 
number
TIME, LTIME

Unary minus - Integer/floating-point 
number
TIME, LTIME

- Integer/floating-point 
number
TIME, LTIME

Multiplication * Integer/floating-point 
number

Integer/floating-point 
number

Integer/floating-point 
number

TIME, LTIME Integer TIME, LTIME
Division / Integer/floating-point 

number
Integer/floating-point 
number (not equal 0)

Integer/floating-point 
number

TIME, LTIME Integer TIME, LTIME
Modulo 
function

MOD Integer Integer Integer

Addition + Integer/floating-point 
number

Integer/floating-point 
number

Integer/floating-point 
number

TIME TIME TIME
TIME DINT TIME
LTIME TIME, LTIME LTIME
LTIME LINT LTIME
TOD TIME TOD
TOD DINT TOD
LTOD TIME, LTIME LTOD
LTOD LINT LTOD
DATE LTOD DTL
DATE TOD ● S7-300/400: DT

● S7-1200/1500: 
DTL

DT TIME DT
LDT TIME, LTIME LDT
DTL TIME, LTIME DTL

Subtraction - Integer/floating-point 
number

Integer/floating-point 
number

Integer/floating-point 
number

TIME TIME TIME
TIME DINT TIME
LTIME 1) TIME, LTIME LTIME
LTIME LINT LTIME
TOD TIME TOD
 DINT TOD
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Operation Operator 1st Operand 2nd Operand Result
LTOD TIME, LTIME LTOD
LTOD LINT LTOD
DATE DATE ● S7-300/400: TIME

● S7-1200/1500: 
LTIME

DT TIME DT
LDT TIME, LTIME LDT
DTL TIME, LTIME DTL
DTL DTL LTIME

1) Combinations between nanoseconds and milliseconds are not possible within expressions.

For additional information on valid data types, refer to "See also".

Example
The following example shows an arithmetic expression:

SCL
"MyTag1":= "MyTag2" * "MyTag3";

See also
Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Relational expressions

Description   
Relational expressions compare the values of two operands and yield a Boolean value. The 
result is TRUE if the comparison is true, and FALSE if it is not met.

Relational operators can process the data types that are allowed in the CPU in use. The data 
type of the result always is BOOL.

Note the following rules when forming relational expressions: 

● All tags are comparable within the following data type groups:

– Integers/floating-point numbers

– Binary numbers

– String

● With the following data types/data groups, only tags of the same type can be compared:

– TIME, LTIME

– Date and time
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● The comparison of strings is based on the ASCII character set. The length of the tags and 
the numerical value of each ASCII character are used for the comparison.

● S5TIME tags are not permitted as comparison operands. An explicit conversion from 
S5TIME to TIME or LTIME is necessary.

Data types of relational expressions
The following table shows the data types/data type groups you can use in relational 
expressions:

Operation Operator 1st Operand 2nd Operand Result
Compare for 
equal, not equal

=, <> Integer/floating-
point number

Integer/floating-
point number

BOOL

Binary number Binary number BOOL
String String BOOL
TIME, LTIME TIME, LTIME BOOL
Date and time Date and time BOOL

Compare for less 
than, less than-
equal to, greater 
than, greater than 
or equal to

<, <=, >, >= Integer/floating-
point number

Integer/floating-
point number

BOOL

Bit strings 
(S7-1200/1500 
only)

Bit strings
(S7-1200/1500 
only)

BOOL

String String BOOL
TIME, LTIME TIME, LTIME BOOL
Date and time Date and time BOOL

For additional information on valid data types, refer to "See also".

Example
The following example shows a relational expression:

SCL  
IF a > b THEN c:= a;  
IF A > 20 AND B < 20 THEN C:= TRUE;  
IF A<>(B AND C) THEN C:= FALSE;  

 

 Note

The comparison for STRING and DT are executed internally in the S7-300/400 by extended 
instructions. The following operands are not permitted for these functions: 
● Parameter of a FC
● In-out parameter of an FB of type STRUCT or ARRAY
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See also
Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Logical expressions

Description   
Logical expressions combine two operands with logical operators AND OR XOR or negating 
operands NOT.

Logical operators can process the data types that are allowed in the CPU in use. The result 
of a logical expression is of BOOL data type, if both operands are of BOOL data type. If at 
least one of both operands is a bit string, then the result is also a bit string and is determined 
by the type of the highest operand. For example, when you link a BYTE type operand to a 
WORD type operand, the result is type WORD.

To link a BOOL type operand with a bit string, you must first explicitly convert it to a bit string.

Data types of logical expressions
The following table shows the data types you can use in logical expressions:

Operation Operator 1st Operand 2nd Operand Result
Negation NOT BOOL - BOOL
AND logic 
operation

AND or & BOOL BOOL BOOL
Bit string Bit string Bit string

OR logic operation OR BOOL BOOL BOOL
Bit string Bit string Bit string

EXCLUSIVE OR 
logic operation

XOR BOOL BOOL BOOL
Bit string Bit string Bit string

Example
The following example shows a logical expression:

SCL  
IF "MyTag1" AND NOT "MyTag2" THEN c:=a;  
MyTag:=ALPHA OR BETA;  

See also
Expressions (Page 1341)

Operators and operator precedence (Page 1347)
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Operators and operator precedence

Operators and their order of evaluation       
Expressions can be linked together or nested within each other by operators. 

The order of evaluation for expressions depends on the precedence of operators and brackets. 
The following basic rules apply:

● Arithmetic operators are evaluated before relational operators and relational operators are 
evaluated before logical operators.

● Operators with no precedence are evaluated according to their occurrence from left to right.

● Operations in brackets are evaluated first.

The following table provides an overview of the operators and their precedence:

Operator Operation Precedence
Arithmetic expressions
+ Unary plus 2
- Unary minus 2
** Power 3
* Multiplication 4
/ Division 4
MOD Modulo function 4
+ Addition 5
- Subtraction 5
Relational expressions
< Less than 6
> Greater than 6
<= Less than or equal 6
>= Greater than or equal 6
= Equal 7
<> Not equal 7
Logical expressions
NOT Negation 3
AND or & Boolean AND 8
XOR Exclusive OR 9
OR Boolean OR 10
Miscellaneous operations
( ) Brackets 1
:= Assignment 11

See also
Expressions (Page 1341)
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Value assignments

Definition     
You can use a value assignment to assign the value of an expression to a tag. On the left side 
of the assignment is the tag that takes the value of the expression on the right. 

The name of a function can also be specified as an expression. The function is called by the 
value assignment and sends its return value back to the tag on the left.

The data type of value assignment is defined by the data type of the tag on the left. The data 
type of the expression on the right must match this type. 

For additional information on compatibility and conversion of data types, refer to "See also".

Value assignments for STRUCT data type or PLC data types
An entire structure can be assigned to another if the structures are identically organized and 
the data types as well as the names of the structural components match.

You can assign a tag, an expression or another structural element to an individual structural 
element.

Value assignments for the ARRAY data type
An entire ARRAY can be assigned to another ARRAY if both the data types of the ARRAY 
elements as well as the ARRAY limits match. 

You can assign a tag, an expression or another ARRAY element to an individual ARRAY 
element.

Value assignments for the STRING data type
An entire STRING can be assigned to another STRING. If the assigned character string is 
longer than the string on the left, a warning is generated during compiling.

You can assign another STRING element to an individual STRING element.

Value assignments for the ANY data type
You can assign a tag with the ANY data type only to the following objects:

● Input parameters or temporary local data of FBs that also have the data type ANY.

● Temporary local data of FCs that also have the data type ANY.

Note that you can only point to memory areas with "standard" access mode with the ANY 
pointer.

Value assignments for the POINTER data type
You cannot use POINTER in value assignments in SCL.
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Examples
The following table shows examples for value assignments:

SCL  
"MyTag1" := "MyTag2"; (* Assignment of a tag*)
"MyTag1" := "MyTag2" * "MyTag3"; (* Assignment of an expression*)
"MyTag" := "MyFC"(); (* Call a function, which assigns its 

return value to the "MyTag" tag*)
#MyStruct.MyStructElement := "MyTag"; (* Assignment of a tag to a structure 

element*)
#MyArray[2] := "MyTag"; (* Assignment of a tag to an ARRAY 

element*)
"MyTag" := #MyArray[1,4]; (* Assignment of an ARRAY element to a 

tag*)
#MyString[2] := #MyOtherString[5]; (* Assignment of a STRING element to 

another STRING element*)

See also
Operators and operator precedence (Page 1347)

Settings for SCL

Overview of the settings for SCL

Overview
The following tables show the settings you can make for SCL:

Editor settings

Group Setting Description
View Keyword highlighting Notation used to represent the keywords of the programming 

language. You can choose between uppercase and lowercase 
letters or a notation corresponding to the conventions of the 
Pascal programming language.
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Default settings for new blocks
If you create new blocks, the following settings are set as default values. You can change 
these in the block properties at a later point in time.

Group Setting Description
Compile Create extended status information Allows all tags in a block to be monitored. The memory 

requirements of the program and execution times increase, 
however, with this option. 

Check ARRAY limits1) Checks at runtime whether array indices are within the declared 
range for an ARRAY. If an array index exceeds the permissible 
range, the enable output ENO of the block is set to "0".

Set ENO automatically Checks at runtime whether errors occur in the processing of 
certain instructions. If a runtime error occurs, the enable output 
ENO of the block is set to "0".

1)For CPUs of the S7-300/400 series: When the ARRAY limits are violated, the enable output ENO is set to FALSE.
For CPUs of the S7-1200/1500 series: When the ARRAY limits are violated, the enable output ENO is not set to FALSE. 
See "Auto-Hotspot" for error query options.

See also
Changing the settings (Page 1350)

Changing the settings

Procedure
To change the settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Change the settings.

Result
The change will be loaded directly, there is no need to save it explicitly.

See also
Overview of the settings for SCL (Page 1349)
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The programming window of SCL

Overview of the programming window

Function 
The programming window is the work area, where you enter the SCL program. 

The following figure shows the programming window of SCL:

The programming window consists of the following sections:

Section Meaning
① Sidebar You can set bookmarks and breakpoints in the sidebar.
② Line numbers The line numbers are displayed to the left of the program 

code.
③ Outline view The outline view highlights related code sections.
④ Code area You edit the SCL program in the code area.
⑤ Display of the absolute operands This table shows the assignment of symbolic operands 

to absolute addresses.

See also
Using bookmarks (Page 1354)

Customizing the programming window (Page 1352)

Indenting and outdenting lines (Page 1353)

Expanding and collapsing sections of code (Page 1354)

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1351



Customizing the programming window

Introduction  
You can customize the appearance of the programming window and the program code in the 
following way:

● By setting the font, size and color

● By setting the tab spacing

● By displaying the line numbers

● By showing or hiding the absolute operands

Setting the font, size and color  
To set the font, size and color, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General > Script/text editors" group.

3. Select the desired font and font size or choose a font color for the individual language 
elements.

Setting the tab spacing  
To provide a better overview of the program, lines are indented according to syntax. Define 
the depth of indentation with the tab spacing. 

To set the tab spacing, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General > Script/text editors" group.

3. Set the tab spacing.

Show line numbers  
To display the line numbers, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General > Script/text editors" group.

3. Select the "Show line numbers" option.

Show or hide the absolute operands  
You can show the assignment of symbolic and absolute operands in a table next to the program 
code, if required.
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To hide or show the display of the absolute operands, follow these steps:

1. Click the "Absolute/symbolic operands" icon in the toolbar.
The display of the absolute operands appears.

2. To move the display, click the table and drag it to the desired position while holding down 
the mouse button.

3. To change the width of the table, click on the right or left table border and drag it to the right 
or left while holding down the mouse button.

See also
Using bookmarks (Page 1354)

Overview of the programming window (Page 1351)

Indenting and outdenting lines (Page 1353)

Expanding and collapsing sections of code (Page 1354)

Indenting and outdenting lines

Introduction  
To provide a better overview of the program, lines are indented according to syntax. However, 
you can also manually indent individual lines.

Procedure
To indent or outdent individual lines, follow these steps:

1. Press the "Indent text", "Outdent text" button into the toolbar of the programming editor.
 

 Note

You can set the width of the indent in "Options > Settings".
 

See also
Using bookmarks (Page 1354)

Overview of the programming window (Page 1351)

Customizing the programming window (Page 1352)

Expanding and collapsing sections of code (Page 1354)
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Expanding and collapsing sections of code

Introduction
SCL instructions can span several lines. Examples for this are program control instructions or 
block calls. 

These instructions are identified as follows:

● An outline view between the display line number and the program code marks the entire 
code section. 

● When you select the opening keyword, the closing keyword is automatically highlighted.

Procedure
To expand or collapse the code section, follow these steps:

1. Click the minus sign in the outline view.
The code section closes.

2. Click the plus sign in the outline view.
The code section opens.

See also
Using bookmarks (Page 1354)

Overview of the programming window (Page 1351)

Customizing the programming window (Page 1352)

Indenting and outdenting lines (Page 1353)

Using bookmarks

Basics of bookmarks

Function
You can use bookmarks to mark program locations in extensive programs so that you can find 
them quickly later if they need revising. Bookmarks are displayed in the sidebar of the 
programming window. You can navigate between multiple bookmarks within a block using 
menu commands.

Bookmarks are saved with the project and are therefore available for anyone who wants to 
edit the block. However, they are not loaded to a device. 

Bookmarks are not evaluated when blocks are compared. 
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See also
Setting bookmarks (Page 1355)

Navigating between bookmarks (Page 1355)

Deleting bookmarks (Page 1356)

Setting bookmarks

Requirement
The SCL block is open.

Procedure 
To set a bookmark, follow these steps:

1. Right-click on the desired line in the sidebar.

2. Select the "Bookmarks > Set" command in the shortcut menu.

Or:

1. Click on the line in which you want to place the bookmark.

2. Click the "Set/delete bookmark" button in the toolbar.

Or:

1. Hold down the <Ctrl> key.

2. Click on the line in the sidebar in which you want to place the bookmark.

Result
A bookmark is placed in the program code. 

 

See also
Basics of bookmarks (Page 1354)

Navigating between bookmarks (Page 1355)

Deleting bookmarks (Page 1356)

Navigating between bookmarks

Requirement
Several bookmarks are set in a block.
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Procedure 
To navigate between bookmarks, follow these steps:

1. Set the insertion cursor in the program code.

2. In the "Edit" menu, select the "Go to > Next bookmark" or "Go to > Previous bookmark" 
command.

Or:

1. Set the insertion cursor in the program code.

2. In the toolbar of the programming editor, click the "Go to next bookmark", "Go to previous 
bookmark" button. 

Or:

1. Click in the sidebar.

2. Select the "Bookmarks > Next" or "Bookmarks > Previous" command in the shortcut menu.

Result
The line with the bookmark is highlighted. 

See also
Basics of bookmarks (Page 1354)

Setting bookmarks (Page 1355)

Deleting bookmarks (Page 1356)

Deleting bookmarks
You can delete individual bookmarks or all bookmarks from the block or the CPU.

Deleting individual bookmarks 
To delete an individual bookmark, follow these steps:

1. Right-click in the sidebar on the line in which you want to delete the bookmark.

2. Select the "Bookmarks > Remove" command in the shortcut menu.

Or:

1. Click on the line in which you want to delete the bookmark.

2. In the "Edit" menu, select the "Bookmarks > Remove" command.

Or:

1. Click on the line in which you want to delete the bookmark.

2. Click the "Set/delete bookmark" button in the toolbar.
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Deleting all bookmarks from the block
To delete all bookmarks from the block, follow these steps:

1. Right-click in the sidebar.

2. Select the "Bookmarks > Delete all from block" command in the shortcut menu.

Or:

1. In the "Edit" menu, select the "Bookmarks > Delete all from block" command.

 

 

See also
Basics of bookmarks (Page 1354)

Setting bookmarks (Page 1355)

Navigating between bookmarks (Page 1355)

Entering SCL instructions

Rules for SCL instructions

Instructions in SCL     
SCL recognizes the following types of instructions: 

● Value assignments
Value assignments are used to assign a tag a constant value, the result of an expression 
or the value of another tag. 

● Instructions for program control
Instructions for program control are used to implement program branches, loops or jumps.

● Additional instructions from the "Instructions" task card
The "Instructions" task card offers a wide selection of standard instructions that you can 
use in your SCL program.

● Block calls
Block calls are used to call up subroutines that have been placed in other blocks and to 
further process their results.

Rules
You need to observe the following rules when entering SCL instructions:

● Instructions can span several lines.

● Each instruction ends with a semicolon (;).
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● No distinction is made between upper and lower case.

● Comments serve only for documentation of the program. They do not affect the program 
execution.

Examples
The following examples shows the various types of instructions:

SCL
// Example of a value assignment 
"MyTag":= 0;
// Example of a block call
"MyDB"."MyFB" (ParamInput:= 10);
// Example of a program control instruction 
WHILE "Counter" < 10 DO 
    "MyTAG" := "MyTag" + 2;
END_WHILE;

See also
Basics of SCL (Page 1340)

Entering SCL instructions manually

Requirement   
An SCL block is open.

Procedure
To enter SCL instructions, follow these steps:

1. Enter the syntax of the instruction using the keyboard.
You are supported by the auto-complete function when performing this task. It offers all the 
instructions and operands that are allowed at the current location.

2. Select the required instruction or the desired operand from the auto-complete function.
If you select an instruction that requires specification of operands, placeholders for the 
operands are inserted into the program. The placeholders for the operands are highlighted 
in yellow. The first placeholder is selected.

3. Replace this placeholder with an operand.

4. Use the <TAB> key to navigate to all other placeholders and replace them with operands.
 

 Note

You can also drag-and-drop a defined operand from the PLC tag table or from the block 
interface into the program.
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Result
The instruction is inserted. 

The programming editor performs a syntax check. Incorrect entries are displayed in red and 
italics. In addition, you also receive a detailed error message in the inspector window.

See also
Expanding and reducing the parameter list (Page 1372)

Inserting SCL instructions using the "Instructions" task card
The "Instructions" task card offers a wide selection of instructions that you can use in your SCL 
program. The SCL-specific instructions for program control are available in the "Instructions" 
task card.

Requirement     
An SCL block is open.

Procedure
To insert SCL instructions into a program using the "Instructions" task card, follow these steps:

1. Open the "Instructions" task card.

2. To insert the instruction, select one of the following steps:

– Navigate to the SCL instruction you want to insert and drag-and-drop it to the required 
line in the program code. The insertion location is highlighted by a green rectangle.

– Select the location in the program code where you want to insert the instruction and 
then double-click on the instruction you want to insert.

The instruction is inserted in the program. The placeholders for the operands are highlighted 
in yellow. The first placeholder is selected.

3. Replace this placeholder with an operand. You can also drag a tag from the interface or 
the PLC tag table with drag-and-drop to the placeholder.

4. Use the <TAB> key to navigate to all other placeholders and replace them with operands.

Result
The instruction is inserted. 

The programming editor performs a syntax check. Incorrect entries are displayed in red and 
italics. In addition, you also receive a detailed error message in the inspector window.

See also
Expanding and reducing the parameter list (Page 1372)
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Defining the data type of an SCL instruction

Basic information on the data types of SCL instructions

Introduction
The SCL instructions that you employ for block programming use specific data types to 
calculate function values. Certain SCL instructions only support the use of a specific data type. 
You cannot change the data type for these instructions. However, most of the SCL instructions 
support the use of different data types. We differentiate between the following two types of 
such instructions:

● Instructions for which the data type of the function value is determined by the data type of 
the input parameters. This is the case for most instructions.

● Instructions with default data type. The instructions listed in the following table are of this 
type.

You will have to change the default data type if this is incompatible with the data type of the 
input parameter used. You can always change the data type based on the following syntax:
_<data type>

SCL instructions with default data type
The following table lists the SCL instructions with default data types:

Instruction Default data type
CEIL DINT
DECO DWORD
FLOOR DINT
NORM_X REAL
PEEK BYTE
SCALE_X INT
TRUNC DINT
CONCAT STRING

See also
Changing the data type of an SCL instruction (Page 1361)

Example for changing the data type of an SCL instruction (Page 1361)
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Changing the data type of an SCL instruction

Procedure    
Proceed as follows to insert an SCL instruction and change its data type:

1. Insert the instruction at the required point in the program using drag-and-drop.

2. Specify the operands for the instruction.
The data type of the function value is specified based on the input parameters, or the default 
data type of the instruction is used.

3. Append the "_<data type>" string to the instruction name. 
"<data type>" represents the data type you need for the instruction.

 

See also
Basic information on the data types of SCL instructions (Page 1360)

Example for changing the data type of an SCL instruction (Page 1361)

Modifying the data types of IEC timers and IEC counters
IEC timers and IEC counters are internal system function blocks and require an instance data 
block. You can create the instance data blocks either as single or multi-instance. The data 
type of the instance data block is determined according to the associated instruction. For CPUs 
of the S7-1200 and S7-1500 series, you can, however execute the instructions with different 
data types, depending on your requirements.

If the newly set data type of the instance data block does not match the data type of the input 
parameter, an implicit conversion takes place if possible. If the conversion is not possible, you 
will receive an error message.

Procedure 
To change the data type of an IEC timer or IEC-counter instance data block, proceed as follows:

1. Open the block in which you call the IEC timer or IEC counter.
Depending on the instance type of the instance data block, there is a green-bordered box 
before (multi-instance) or after (single instance) the name of the instance data block.

2. Click the green-bordered box.
A drop-down list box with the valid data types for the instance data block is opened.

3. Select the desired data type.

Example for changing the data type of an SCL instruction

Changing the default data type of instruction "Decode" (DECO)  
Data type DINT is set as default if you insert the "Decode" instruction in the program.
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"Tag_Result" := DECO(IN := "Tag_Value");
Modify the program code as follows to convert the data type from DINT to BYTE:
"Tag_Result" := DECO_BYTE(IN := "Tag_Value");
 

See also
Basic information on the data types of SCL instructions (Page 1360)

Changing the data type of an SCL instruction (Page 1361)

Using Favorites in SCL

Adding SCL instructions to the Favorites

Requirement  
● A block is open.

● The multipane mode is set for the "Instructions" task card or the Favorites are also displayed 
in the editor.

Procedure
To add SCL instructions to the Favorites, follow these steps:

1. Open the "Instructions" task card.

2. Maximize the "Basic instructions" pane.

3. Navigate in the "Basic instructions" pane to the instruction that you want to add to the 
Favorites.

4. Drag-and-drop the instruction into the "Favorites" pane or into the Favorites area in the 
program editor.

 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Inserting SCL instructions using Favorites (Page 1363)

Removing SCL instructions from the Favorites (Page 1363)
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Inserting SCL instructions using Favorites

Requirement  
● A block is open.

● Favorites are available.

Procedure
To insert an instruction into a program using Favorites, follow these steps:

1. Drag-and-drop the desired instruction from Favorites to the desired position.

Or:

1. Select the position in the program where you want to insert the instruction.

2. In the Favorites, click on the instruction you want to insert.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

See also
Adding SCL instructions to the Favorites (Page 1362)

Removing SCL instructions from the Favorites (Page 1363)

Removing SCL instructions from the Favorites

Requirement
A code block is open. 

Procedure
To remove instructions from Favorites, follow these steps:

1. Right-click on the instruction you want to remove.

2. Select the "Remove instruction" command in the shortcut menu.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1363



 

See also
Adding SCL instructions to the Favorites (Page 1362)

Inserting SCL instructions using Favorites (Page 1363)

Insert block calls in SCL

Basic information on the block call in SCL

Calling function blocks

Syntax of a call     
The following syntax is used to call a function block as a single or multi-instance:

● Single instance:

– If the function block originates from the project:
<DBName> (Parameter list)

– If the function block originates from the "Instructions" task card:
<DB name>.<Instruction name> (Parameter list)

● Multi-instance
<#Instance name> (Parameter list)

Calling as single instance or multi-instance
Function blocks can be called either as a single instance or a multi-instance.

● Calling as a single instance
The called function block stores its data in a data block of its own. 

● Calling as a multi-instance
The called function block stores its data in the instance data block of the calling function 
block.

For additional information on the types of calls, refer to "See also".

Parameter list
If you call another code block from a SCL block, you can supply the formal parameters of the 
called block with actual parameters.

The specification of the parameters has the form of a value assignment. This value assignment 
enables you to assign values (actual parameters) to the parameters you have defined in the 
called block.
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The formal parameters of the called code block are listed in brackets directly after the call. 
Input and in-out parameters have the assignment identifier ":=", output parameters have the 
assignment identifier "=>". A placeholder placed after the parameter shows the required data 
type and the type of the parameter. 

Rules for supplying parameters
The following rules apply to supplying parameters:

● Constants, tags and expressions can be used as actual parameters.

● The assignment order is not of importance.

● The data types of formal and actual parameters must match.

● The individual assignments are separated by commas.

● If the called block has only one parameter, it is sufficient to specify the actual parameter in 
the brackets. The formal parameter need not be specified.

See also
Manually inserting block calls (Page 1369)

Inserting block calls with drag-and-drop (Page 1370)

Examples for calling a function block in SCL (Page 1367)

Calling functions

Syntax of a call     
The following syntax is used to call a function:
<Function name> (Parameter list);     //Standard call
<Operand>:=<Function name> (Parameter list); // Call in an expression

Return value
The call options of functions depend on whether the function returns a return value to the calling 
block. The return value is defined at the RET_VAL parameter. If the RET_VAL parameter is 
of the VOID data type, then the function will not return a value to the calling block. If the 
RET_VAL parameter has another data type, then the function returns a return value of this 
data type. 

In SCL, all data types are permitted for the RET_VAL parameter except ANY, ARRAY, 
STRUCT and VARIANT, as well as the parameter types TIMER and COUNTER.
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Call options
There are two possibilities for calling functions in SCL:

● Standard call for functions with and without a return value
With a standard call, the results of the function is made available as an output and in-out 
parameter.

● Call in an expression for functions with a return value
Functions that return a return value can be used in any expression in place of an operand, 
for example, in a value assignment. 
The function calculates the return value, which has the same name as the function and 
returns it to the calling block. There the value replaces the function call. 
After the call, the results of the function will be available as return value or as an output and 
in-out parameter.

Parameter list
If you call another code block from a SCL block, you need to supply the formal parameters of 
the called block with actual parameters.

The specification of the parameters has the form of a value assignment. This value assignment 
enables you to assign values (actual parameters) to the parameters you have defined in the 
called block.

The formal parameters of the called code block are listed in brackets directly after the call. 
Input and in-out parameters have the assignment identifier ":=", output parameters have the 
assignment identifier "=>". A gray placeholder placed after the parameter shows the required 
data type and the type of the parameter. 

Rules for supplying parameters
The following rules apply to supplying parameters to functions:

● All parameters of the function must be supplied.

● The assignment order is not of importance.

● Constants, tags and expressions can be used as actual parameters.

● The data types of formal and actual parameters must match.

● The individual assignments are separated by commas.

● If the called block has only one parameter, it is sufficient to specify the actual parameter in 
the brackets. The formal parameter need not be specified.

● When you call functions in SCL, you cannot use the release mechanism via EN. Use an IF 
statement instead to call functions conditionally.
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See also
Manually inserting block calls (Page 1369)

Inserting block calls with drag-and-drop (Page 1370)

Examples for calling functions in SCL (Page 1368)

Examples for calling a function block in SCL

Calling as a single instance     
The following example shows the call of an FB as a single instance:

SCL 
// Call as a single instance 
"MyDB" (MyInput:=10, MyInout:= "Tag1"); 

Result
After the call is executed, the value determined for the "MyInout" in/out parameter is available 
in "Tag1" in the "MyDB" data block.

Calling as a multi-instance
The following example shows the call of an FB as a multi-instance:

SCL 
// Call as a multi-instance 
"MyFB" (MyInput:= 10, MyInout:= "Tag1"); 

Result
After the "MyFB" block is executed, the value determined for the "MyInout" in-out parameter 
is made available in "Tag1" in the data block of the calling code block.

See also
Calling function blocks (Page 1364)

Manually inserting block calls (Page 1369)

Inserting block calls with drag-and-drop (Page 1370)
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Examples for calling functions in SCL

Standard call  
The following example shows a standard function call:

SCL 
// Standard function call 
"MyFC" (MyInput := 10, MyInOut := "Tag1"); 

Result
After the "MyFC" block is executed, the value determined for the "MyInOut" in/out parameter 
is available in "Tag1" in the calling block and has to be further processed there.

Call in a value assignment
The following example shows a function call in a value assignment:

SCL 
(*Call in a value assignment, a return value was defined for "MyFC" *)
#MyOperand := "MyFC" (MyInput1 := 3, MyInput2 := 2, MyInput3 := 8.9, 
MyInOut := "Tag1"); 

Result
The return value of "MyFC" is transferred to "#MyOperand". 

Call in an arithmetic expression
The following example shows a function call in an arithmetic expression:

SCL 
(*Call in a mathematical expression, a return value was defined for "MyFC"  
*)
#MyOperand := "Tag2" + "MyFC" (MyInput1 := 3, MyInput2 := 2, MyInput3 := 
8.9); 

Result
The return value of "MyFC" will be added to "Tag2" and the result will be transferred to 
"MyOperand".
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See also
Calling functions (Page 1365)

Manually inserting block calls (Page 1369)

Inserting block calls with drag-and-drop (Page 1370)

Manually inserting block calls
You can insert calls for functions (FCs) and function blocks (FBs).   

Inserting a call for a function (FC)
Proceed as follows to insert a function call:

1. Enter the function name.

2. Confirm your entry with the Return key.
The syntax for the function call including the parameter list is added to the SCL program. 
The placeholders for the actual parameters are highlighted in yellow. The first placeholder 
is selected.

3. Replace this placeholder with an actual parameter. You can also drag a tag from the 
interface or the PLC tag table with drag-and-drop to the placeholder.

4. Use the <TAB> key to navigate to all other placeholders and replace them with actual 
parameters.

Inserting a call for a function block (FB)
To insert a call for a function block (FB), follow these steps:

1. Enter the name of the function block.

2. Confirm your entry with the Return key.
The "Call options" dialog opens.

3. In the dialog, specify whether you want to call the block as a single or multi-instance.

– If you click the "Single instance" button, in the "Name" field enter a name for the data 
block to be assigned to the call.

– If you click the "Multi-instance" button, in the "Name in the interface" field enter a name 
of the tag with which the called function block is to be entered as a static tag in the 
interface of the calling block.

4. Confirm your entries with "OK".
The syntax for the function block call including the parameter list is added to the SCL 
program. The placeholders for the actual parameters are highlighted in yellow. The first 
placeholder is selected.

5. Replace this placeholder with an actual parameter. You can also drag a tag from the 
interface or the PLC tag table with drag-and-drop to the placeholder.

6. Use the <TAB> key to navigate to all other placeholders and replace them with actual 
parameters.
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Result
The block call is inserted. 

If you specify an instance data block that does not exist when calling a function block, it is 
created. 

See also
Updating block calls (Page 1371)

Expanding and reducing the parameter list (Page 1372)

Basic information on the block call in SCL (Page 1364)

Inserting block calls with drag-and-drop
You can insert calls for existing functions (FC) and function blocks (FB) using a drag-and-drop 
operation from the project tree. 

Requirement   
The function to be called (FC) or the function block (FB) to be called is present.

Inserting a call for a function (FC)
To insert a function call using drag-and-drop, follow these steps:

1. Drag the function from the project tree into the program.
The syntax for the function call including the parameter list is added to the SCL program. 
The placeholders for the actual parameters are highlighted in yellow. The first placeholder 
is selected.

2. Replace this placeholder with an actual parameter. You can also drag a tag from the 
interface or the PLC tag table with drag-and-drop to the placeholder.

3. Use the <TAB> key to navigate to all other placeholders and replace them with actual 
parameters.

Inserting a call for a function block (FB)
To insert a call for a function block (FB) using drag-and-drop, follow these steps:

1. Drag the function block from the project tree and drop it into the program.
The "Call options" dialog opens.

2. In the dialog, specify whether you want to call the block as a single or multi-instance.

– If you click the "Single instance" button, in the "Name" field enter a name for the data 
block to be assigned to the call.

– If you click the "Multi-instance" button, in the "Name in the interface" field enter a name 
of the tag with which the called function block is to be entered as a static tag in the 
interface of the calling block.
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3. Confirm your entries with "OK".
The syntax for the function block call including the parameter list is added to the SCL 
program. The placeholders for the actual parameters are highlighted in yellow. The first 
placeholder is selected.

4. Replace this placeholder with an actual parameter. You can also drag a tag from the 
interface or the PLC tag table with drag-and-drop to the placeholder.

5. Use the <TAB> key to navigate to all other placeholders and replace them with actual 
parameters.

Result
The block call is inserted. 

If you specify an instance data block that does not exist when calling a function block, it is 
created. 

See also
Updating block calls (Page 1371)

Expanding and reducing the parameter list (Page 1372)

Basic information on the block call in SCL (Page 1364)

Updating block calls
If interface parameters of a called block are changed, the block call can no longer be executed 
correctly. You can avoid such inconsistent block calls by updating the block calls.

You have two options to update the block calls:

● Explicit updating in the program editor.
The inconsistencies within the open block are displayed and can be updated. 

● Implicit updating during compilation.
All block calls in the program as well as the used PLC data types will be updated.

Update blocks in the program editor  
To update a block call within a block, follow these steps:

1. Open the block in the program editor.

2. Click "Update inconsistent block calls" in the toolbar.
Inconsistent calls are displayed.

3. Correct the inconsistencies.
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Update block calls during compilation
Proceed as follows to update all block calls and uses of PLC data types during compilation 
implicitly:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebulid all blocks)" in the shortcut menu.

See also
Manually inserting block calls (Page 1369)

Inserting block calls with drag-and-drop (Page 1370)

Expanding and reducing the parameter list
In SCL, if you call blocks or insert instructions that are system-internal function blocks, the 
syntax and the parameter list with the placeholders for the actual parameters are inserted in 
the SCL program. To make the program code easier to read, the unused optional parameters 
are removed from the parameter list when you edit other instructions. You can restore these 
at any time. You can also explicitly reduce the parameter list when you have finished assigning 
the parameters.

Expanding the parameter list
To expand the parameter list, follow these steps:

1. Right-click in the block call or the instruction.

2. Select the "Expand parameter list" command from the shortcut menu or press the key 
combination <Ctrl+Shift+Space bar>. 
The parameter list is displayed in full again.

Reducing the parameter list
To reduce the parameter list, follow these steps:

1. Right-click in the block call or the instruction.

2. Select the "Reduce parameter list" command from the shortcut menu or press the key 
combination <Ctrl+Shift+Space bar>.  
All unused optional parameters are hidden.

See also
Entering SCL instructions manually (Page 1358)

Inserting SCL instructions using the "Instructions" task card (Page 1359)

Manually inserting block calls (Page 1369)

Inserting block calls with drag-and-drop (Page 1370)
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Inserting comments

Commenting program code   
You have various options for commenting SCL programs:

● Line comment
A comment line starts with "//" and extends to the end of the line.

● Comment section
A comment section is introduced with "(* and completed by "*)". It can span several lines.

Inserting line comments
To insert line comments, follow these steps:

1. Type "//" at the position where you want to place the comment. This does not have to be 
the beginning of the line.

2. Enter the comment.

Inserting a comment section
To insert a comment section, follow these steps:

1. Type "(*" at the position where you want to place the comment. This does not have to be 
the beginning of the line.

2. Enter the comment.

3. Complete the comment with "*)".

Disabling one or more lines with comments
To disable program code with comments, follow these steps:

1. Select the code lines you want to disable.

2. Click the "Disable code" button in the editor.
The line beginning "//" is inserted in the selected lines. The code that follows is interpreted 
as a comment. If lines already containing a line comment are disabled, "//" is inserted as 
well. If these lines are enabled again, the original comments are retained.

Enabling comment lines
In order to once again enable lines that have been commented out in the code, follow these 
steps:

1. Select the code lines you want to enable.

2. Click the "Enable code" button in the editor.
The "//" mark for line comments at the beginning of the line is removed.
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Example
The following code contains comment sections and line comments

(*************************************************************************************
  A description of the instructions that follow can be placed here
**************************************************************************************)
IF "MyVal1" > 0 THEN //No division by 0
    "MyReal" := "MyVal2" (* input value *) / "MyVal1" (* measured value *);
END_IF;
//Data type conversion
"MyInt" := REAL_TO_INT("MyReal");

 

Editing SCL instructions

Selecting instructions
You can select individual instructions or all instructions of a block.

Requirement   
An SCL block is open.

Selecting individual instructions
To select individual instructions, follow these steps:

1. Set the insertion mark before the first character that you want to select.

2. Press and hold down the left mouse button.

3. Move the cursor to a position after the last character that you want to select.

4. Release the left mouse button.

Selecting all the instructions of a program
To select all instructions, follow these steps:

1. In the "Edit" menu, select the "Select All" command or use the keyboard shortcut <Ctrl+A>.
 

 Note

When you select the opening keyword of an instructing, the closing keyword is automatically 
highlighted.
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Copying, cutting and pasting instructions

Copying an instruction
To copy an instruction, follow these steps:

1. Select the instruction you want to copy.

2. Select "Copy" in the shortcut menu.

Cutting an instruction
To cut an instruction, follow these steps:

1. Select the instruction you want to cut.

2. Select the "Cut" command in the shortcut menu.

Inserting an instruction from the clipboard
To insert an instruction from the clipboard, follow these steps:

1. Copy or cut an instruction.

2. Click on the position at which you want to insert the instruction.

3. Select "Paste" in the shortcut menu.

 

 

Deleting instructions

Requirement
An SCL block is open.  

Procedure
To delete an instruction, follow these steps:

1. Select the instruction you want to delete.

2. Select the "Delete" command in the shortcut menu.
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Eliminating syntax errors in the program

Basic information on syntax errors

Syntax errors  
Below are some examples of syntax errors:

● Missing separators or the use of too many separators

● Incorrect keyword spelling

● Incorrect jump label spelling/notation

● Notation which does not match the set mnemonics (for example, "I2.3" instead of "E2.3")

● The use of key words as operands

Identification of syntax errors
Syntax errors are underlined in red or appear in red type.

This identification allows you to recognise incorrect inputs at a glance and jump from error to 
error to eliminate them. Syntax errors are also listed in the "Info" tab of the inspector window 
with an error message.

 

See also
Finding syntax errors in the program (Page 1376)

Finding syntax errors in the program

Procedure   
To find syntax errors in the program, follow these steps:

1. Select the position in the program in which you wish to look for errors.

2. Click "Go to next error" in the toolbar.
The first error after the position you have selected will be marked.

You can use "Go to next error" and "Go to previous error" in the toolbar to find and correct all 
errors in the block.

Or:
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1. Open the error list in the inspector window with "Info > Syntax".
All syntax errors are listed in the table with a short description of the error.

2. If there are any errors, click on the blue question mark next to the error text to obtain 
information on eliminating the problem.

3. Double-click the error you want to correct.
The corresponding error is highlighted.

 

See also
Basic information on syntax errors (Page 1376)

Changing the programming language

Rules for changing the programming language

Rules
Observe the following rules if you want to change the programming language for a block:

● All CPU series:

– You can only change the programming language of entire blocks. The programming 
language cannot be changed for individual networks.

– You cannot switch blocks programmed in the programming languages SCL or GRAPH. 
In GRAPH blocks, however, you can change between LAD and FBD as network 
languages.

● S7-300/400: 

– You can only change between the programming languages LAD, FBD and STL.

– You can create networks within a block using another programming language and then 
copy them into the desired block.

– If the language of individual networks of the block cannot be changed, these networks 
is displayed in their original language.

● S7-1200/1500: 

– You can change between the programming languages LAD and FBD.

● S7-1500:

– You can create STL networks within the LAD and FBD blocks. However, you cannot 
copy between STL and LAD/FBD.
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Change the programming language

Procedure 
To change the programming language, follow these steps:

1. Right-click the block in the project tree.

2. Select the "Properties" command in the shortcut menu.
The dialog with the properties of the block opens.

3. Select the "General" entry in the area navigation.

4. Select the new programming language in the "Language" drop-down list.

5. Confirm your selection with "OK".

See also
Rules for changing the programming language (Page 1377)

Handling program execution errors

Basics of error handling

Introduction
Program execution errors are programming or I/O access errors.  You have a number of 
different options for responding to program execution errors depending on the CPU used.

Handling program execution errors in S7-300/400
You can program the program execution error OB (OB 85) for S7-300/400 CPUs. If a program 
execution error occurs and you do not use the program execution error OB, the CPU will switch 
to "STOP" mode. 

You will find additional information about the program execution error OB in the description of 
the mode of operation of S7-300/400 CPUs.
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Handling program execution errors in S7-1200/1500
You can select the type of error handling for CPUs of the S7-1200 and S7-1500 series. You 
have the following two options:

● Use the CPU's global troubleshooting:

– S7-1200: The CPU generates a diagnostic buffer entry and remains in "RUN" mode.

– S7-1500: You can program the programming error OB (OB 121) and the I/O access 
error OB (OB 122) for S7-1500 CPUs. If no programming error OB exists in the CPU, 
the CPU switches to "STOP" mode when a programming error occurs. In the event of 
an I/O access error, the CPU always remains in "RUN" mode, regardless of whether 
the I/O access error OB is present. 
Please note, however, that an existing I/O access or programming error OB is not called 
synchronously to the error. Therefore, depending on the selected priority, the execution 
of I/O access or programming error OBs may be delayed instead of taking place 
immediately when the error occurs. If other errors occur before execution of the I/O 
access or programming error OB is complete, no further I/O access or programming 
error OB is called. If you want to prevent I/O access or programming error OBs from 
being discarded, set the priority correspondingly high. 
You can use the enable output ENO to detect I/O access and programming errors for 
the instructions "Read field" (FieldRead), "Write field" (FieldWrite) , "Read memory 
address" (PEEK) and "Write memory address" (POKE).
You can find more information about these error OBs in the description of the mode of 
operation of S7-1500 CPUs.

● You use separate local error handling. Local error handling is error handling within a block. 
Local error handling has the following advantages:

– The error information is stored in the system memory, which you can query and evaluate.

– You can use the error information to program a response in the block to the error that 
has occurred.

– Programmed error evaluation and error reactions do not interrupt the program cycle.

– The system performance is not unnecessarily burdened by the local error handling. If 
no errors occur, programmed error analyses and reactions are not executed.
Local error handling applies only to blocks for which it has been set explicitly. If local 
error handling is set for a block, no global error handling is conducted for errors in this 
block. 

 

 Note

Note the following information:
● All memory access errors and I/O access errors must be captured either by global or local 

error handling.
● If the parameters of an instruction do not cause any memory access errors, you can query 

the associated ENO.
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See also
GET_ERROR: Get error locally (Page 2040)

GET_ERR_ID: Get error ID locally (Page 2044)

GET_ERROR: Get error locally (Page 1783)

GET_ERR_ID: Get error ID locally (Page 1787)

Local error handling

Principles of local error handling

Introduction
Local error handling makes it possible to query the occurrence of errors within a block and 
evaluate the associated error information. You can set local error handling for organization 
blocks (OBs), function blocks (FBs), and functions (FCs). If local error handling is enabled, the 
system reaction is ignored.

Local error handling applies only to blocks for which it has been set explicitly. The local error 
handling setting is not assumed by a calling block, nor is it transferred to called blocks. For 
higher-level blocks and lower-level blocks, the system settings still apply provided dedicated 
error handling has not been programmed for these blocks.

General procedure for local error handling
When errors occur while a block is being executed with local error handling, a predefined 
response is initiated based on the following error types: 

● Write errors: These errors are ignored, and program execution simply continues.

● Read errors: Program execution continues with the substitute value "0".

● Execution errors: Execution of the instruction is aborted. Program execution resumes with 
the next instruction.

Information about the first error that occurs is stored in the system memory. This information 
can be queried and output with an instruction (GET_ERROR or GET_ERR_ID). Error 
information is output in a format that can undergo additional processing. You can use additional 
instructions to analyze error information and program a reaction to the error based. 

When information about the first error is queried, the error memory space in the system memory 
is enabled. Then, when additional errors occur, information about the next error is output. 

Instructions for local error handling
You can use the following instructions for local error handling:

● GET_ERROR: Get error locally

● GET_ERR_ID: Get error ID locally

The instructions differ in the amount of error information that is output with each one. 
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For additional information on the instructions, refer to "See also".

See also
GET_ERROR: Get error locally (Page 2040)

GET_ERR_ID: Get error ID locally (Page 1787)

GET_ERR_ID: Get error ID locally (Page 2044)

GET_ERROR: Get error locally (Page 1783)

Error output priorities

Overview of the priorities   
In local error handling, information about the first error that occurred is displayed. If multiple 
errors occur at the same time while an instruction is being executed, these errors are displayed 
according to their priority. The following table shows the priority of different types of errors.

Priority Error type
1 Error in the program code
2 Missing reference 
3 Invalid range
4 DB does not exist
5 Operands are not compatible
6 Width of specified area is not sufficient 
7 Timers or counters do not exist
8 No write access to a DB
9 I/O error
10 Instruction does not exist
11 Block does not exist
12 Invalid nesting depth

 

The highest priority is 1 and the lowest priority is 12.

See also
GET_ERROR: Get error locally (Page 2040)

GET_ERR_ID: Get error ID locally (Page 1787)

GET_ERR_ID: Get error ID locally (Page 2044)

GET_ERROR: Get error locally (Page 1783)
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Enabling local error handling for a block

Introduction
Local error handling is enabled for a block if you insert one of the following instructions in a 
network.

● GET_ERROR: Get error locally

● GET_ERR_ID: Get error ID locally

For additional information on the instructions, refer to "See also".

If local error handling is enabled for a block, the system reactions for this block are ignored.

Requirement
● The block is open.

● Die "Instructions" task card is open.

Procedure
To enable local error handling for a block, proceed as follows:

1. Navigate to the "Basic instructions" pane of the "Instructions" task card.

2. Open the "Program Control" folder.

3. Drag the instruction "Get error locally" (GET_ERROR) or "Get error ID locally" 
(GET_ERR_ID) to the required network.

Result
Local error handling is enabled for the open block. The "Handle errors within block" check box 
is selected in the Inspector window under "Properties > Attributes". This setting cannot be 
edited in the Inspector window. Local error handling can be deactivated by deleting the inserted 
instructions on local error handling.

See also
GET_ERROR: Get error locally (Page 2040)

GET_ERR_ID: Get error ID locally (Page 1787)

GET_ERR_ID: Get error ID locally (Page 2044)

GET_ERROR: Get error locally (Page 1783)

9.1.4.3 Programming data blocks

Basic principles for programming of data blocks
A data block (DB) is used to save the values that are written during execution of the program. 
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In contrast to the code block, the data block contains only tag declarations. It contains no 
networks or instructions. The tag declarations define the structure of the data block.   

Types of data blocks
There are two types of data blocks:

● Global data blocks
The global data block is not assigned to a code block. You can access the values of a global 
data block from any code block. A global data block contains only static tags. 
The structure of the global data block can be freely defined. In the declaration table for data 
blocks, you declare the data elements that are to contained in the global data block. 

● Instance data blocks
The instance data block is assigned directly to a function block (FB). The structure of an 
instance data block cannot be freely defined, but is instead determined by the interface 
declaration of the function block. The instance data block contains exactly those block 
parameters and tags that are declared there. 
However, you can define instance-specific values in the instance data block, for example, 
start values for the declared tags.

ARRAY data blocks (S7-1500)
ARRAY data blocks are global data blocks that consist of an ARRAY. This ARRAY can be 
based on any data type. For example, an ARRAY of a PLC data type (UDT) is possible. The 
DB contains no other elements besides the ARRAY. Because of their flat structure, ARRAY 
data blocks facilitate access to the ARRAY elements and their transfer to called blocks.

The "Move operations" section of the "Instructions" task card offers options for addressing of 
ARRAY DBs. 

PLC data types as a template for global data blocks 
PLC data types can be used as templates for the creation of global data blocks with identical 
data structures. You create the structure as PLC data type only once and then generate the 
required data blocks by assigning the PLC data type. 

System data types as a template for global data blocks 
System data types can also be used as templates for creating global data blocks with identical 
data structure. System data types already have a pre-defined structure. You insert the system 
data type in the program only once and then generate additional data blocks with an identical 
structure by assigning the system data type.
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Access modes
There are two different modes of accessing data values in data blocks:

● Data blocks with optimized access (only S7-1200)
Data blocks with optimized access have no fixed defined structure. In the declaration, the 
data elements are assigned only a symbolic name and no fixed address within the block. 
You access the data values in these block via symbolic names.
The "Optimized block access" attribute is always enabled for ARRAY data blocks. 

● Data blocks with standard access (all CPU families)
Data blocks with standard access have a fixed structure. In the declaration, the data 
elements are assigned both a symbolic name and a fixed address within the block. You 
can access the data values in these blocks via symbolic names or the address.
ARRAY data blocks with standard access are not possible.

Retentivity of data values
To prevent data loss in the event of power failure, you can store the data values in a retentive 
memory area.

See also
Creating data blocks (Page 1199)

Global data blocks (DB) (Page 1024)

Instance data blocks (Page 1025)

Structure of the declaration table for data blocks

Structure of the declaration table for data blocks   
The figure below shows the structure of the declaration table for data blocks. The display will 
vary depending on type of block and type of access. 

Display of instance-specific values
In instance data blocks, you can apply the already defined values from the interface of the 
assigned function block or define instance-specific start values. Values that are applied from 
the function block cannot be edited. You can replace the grayed-out values with instance-
specific values. Values that were already changed instance specific are not grayed out.
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Meaning of the columns
The following table shows the meaning of the individual columns. You can show or hide the 
columns as required. The number of columns displayed varies depending on the CPU series.

Column Explanation
Symbol you can click to move or copy the tag. You can, for example, drag-
and-drop the tag into a program and use it there as operand.

Name Name of the tags. 
Data type Data type of the tags.
Offset Relative address of the tags. 

The column is only visible in data blocks with standard access.
Default value Default value of the tag in the interface of a higher-level code block or in a 

PLC data type. 
The values contained in the "Default value" column can only be changed in 
the higher-level code block or PLC data type. The values are only displayed 
in the data block. 

Start value Value that the tag should assume at startup.
The default values defined in a code block are used as start values during the 
creation of the data block. You can then replace these adopted values with 
instance-specific start values. 
Specification of an start value is optional. If you do not specify any value, the 
tag assumes the default value at startup. If a default is not defined either, the 
default value valid for the data type is used. For example, the value "FALSE" 
is specified as standard for BOOL.

Monitor value Current data value in the CPU. 
This column only appears if an online connection is available and you click 
"Monitor".

Snapshot Shows values that were loaded from the device.
Retentivity Marks the tag as retentive. The values of retentive tags are retained even 

after the power supply is switched off.
Visible in HMI Shows whether the tag is visible by default in the HMI selection list.
Accessible from HMI Shows whether HMI can access this tag during runtime.
Setting value Setting values are the values that will probably have to be fine tuned during 

commissioning. After commissioning, the values of these tags can be 
transferred to the offline program as start values and stored there. 

Comment Comment to document the tags.

See also
Creating data blocks (Page 1199)

Basic information on start values (Page 1392)
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Creating data blocks

Requirement   
The "Program blocks" folder in the project tree is open.

Procedure
To create a data block, follow these steps:

1. Double-click the "Add new block" command.
The "Add new block" dialog box opens.

2. Click the "Data block (DB)" button.

3. Select the type of the data block. You have the following options available to you:

– To create a global data block, select the list entry "Global DB".

– To create an ARRAY data block, select the "ARRAY DB" entry in the list.

– To create an instance data block, select the function block to which you want to assign 
the instance data block from the list. The list contains only the function blocks that were 
previously created for the CPU.

– To create a data block based on a PLC data type, select the PLC data type from the 
list. The list contains only the PLC data types that were previously created for the CPU.

– To create a data block based on a system data type, select the system data type from 
the list. The list contains only those system data types that have already been inserted 
to program blocks in the CPU.

4. Enter a name for the data block.

5. Enter the properties of the new data block. 

6. If you have selected an ARRAY DB as the data block type, enter the ARRAY data type and 
the high limit for the ARRAY. 
You can change the high limit for the ARRAY at any time in the property window of the 
created block. The ARRAY data type cannot be changed subsequently.

7. To enter additional properties of the new data block, click "Additional information".
An area with further input fields is displayed.

8. Enter all the properties you require.

9. Activate the "Add new and open" check box if the block does not open as soon as it is 
created.

10.Confirm your entry with "OK".

Result
The new data block is created. You can find the data block in the project tree in the "Program 
blocks" folder.
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See also
Instance data blocks (Page 1025)

Global data blocks (DB) (Page 1024)

Overview of block properties (Page 1208)

Updating data blocks

Introduction  
Changes in the interface of a function block or a PLC data type can lead to the corresponding 
data blocks becoming inconsistent. These inconsistencies are marked in red in the declaration 
table and at the call point of the block. To remedy these inconsistencies, the data blocks must 
be updated.

You have three options to update block calls:

● Explicit updating in the declaration table for data blocks.
The data block is updated. Changes from the interface of the assigned function block and 
changes to the used PLC data types are applied. 

● Explicit updating in the program editor.
The block calls in the open block will be updated. The associated instance data block is 
also adjusted in the process.

● Implicit updating during compilation.
All block calls in the program as well as the used PLC data types and the corresponding 
instance data blocks are updated.

Explicit Updating in the Declaration Table for Data Blocks
To explicitly update an individual data block, follow these steps:

1. Open the data block.

2. Select "Update interface" in the shortcut menu.

Explicit Updating in the Program Editor
To update all block calls or a specific call within a block, follow these steps:

1. Open the block in the program editor.

2. Right-click on the instruction with the block call.

3. Select the "Update" command in the shortcut menu.

4. The "Interface update" dialog opens. This dialog shows the differences between the block 
interface in use and the changed interface of the called block.

5. If you want to update the block call, click "OK". To cancel the update, click "Cancel".
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Implicit Updating during Compilation
To implicitly update all block calls and uses of PLC data types as well as the instance data 
blocks during the compiling, follow these steps:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebuild all blocks)" in the shortcut menu.

See also
Changing the properties of tags in instance data blocks (Page 1399)

Extending data blocks

Description   
In order to enable the editing of PLC programs that have already been commissioned and that 
are running without error on a system, CPUs of the S7-1500 series and most CPUs of the 
S7-1200 V4 series support the option of extending global data blocks during runtime. 

You can download the modified blocks without setting the CPU to STOP and without affecting 
the values of already loaded tags. 

This is a simple means of implementing program changes. This load process (download 
without reinitialization) will not have a negative impact on the controlled process. 

Principle of operation
Each data block is always assigned a default memory reserve. The memory reserve is not 
used initially. Activate the memory reserve if you decide on loading interface changes after 
having compiled and downloaded the block. All tags that you subsequently declare will be 
saved to the memory reserve. A subsequent download has no impact on the values of tags 
that have already been loaded.

If you decide to review your program at a later time while the plant is not in operation, you are 
also provided an option of reworking the memory layout of individual or several blocks in a 
single pass. With this action, you move all tags from the reserve area to the regular area. The 
memory reserve is now cleared and made available for further interface extensions.

Requirements
This "Download without reinitialization" function is available if the following requirements are 
met:

● The project is available in "TIA Portal V12" format.

● You are working with a CPU that supports "Download without reinitialization".

● The blocks were created in LAD, FBD, STL, or SCL.
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● The blocks were created by the user, i.e. they are not included with the blocks delivered in 
your package.

● These blocks are assigned the optimized access attribute.

Basic steps
Perform the following steps if you want to extend the data block and then load the block without 
re-initialization. 

1. All blocks have a default memory reserve of 100 bytes. You can adapt this memory reserve 
to suit your requirements.

2. Activate the memory reserve.

3. Extend the block interface.

4. Compile the block.

5. Download the block to the CPU as usual.

Reference
For more information on the various steps, refer to chapter "Loading blocks (S7-1200/1500) ".

Creating a data structure for global data blocks

Declaring tags of elementary data type

Requirement  
A global data block is open. 

 

 Note

You cannot change the structure of instance data blocks and of data blocks based on a PLC 
data type directly, since the structures of these blocks are defined by the respective function 
block or the PLC data type. 

The type of the data block is entered in the block properties.
 

 

Procedure
To declare a tag of the elementary data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. In the "Data type" column, click the button for the data type selection.
A list of the permissible data types is opened.

3. Select the desired data type.
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4. Optional: Change the properties of the tags that are displayed in the other columns.

5. Repeat steps 1 to 4 for all tags that are to be declared.

 

See also
Displaying and editing block properties  (Page 1213)

Declaring tags of the ARRAY data type (Page 1390)

Declaring tags of STRUCT data type (Page 1391)

Editing tables (Page 242)

Declaring tags of the ARRAY data type

Requirement    
A global data block is open.

Procedure
To declare a tag of the ARRAY data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the "Array" data type in the "Data type" column. You will be supported by 
autocompletion in this step.
The "Array" dialog opens.

3. In the "Data type" text box, specify the data type of the array elements.

4. In the "ARRAY limits" text box, specify the high and low limit for each dimension.
Example of a one-dimensional ARRAY:
[0..3]
Example of a three-dimensional ARRAY:
[0..3, 0..15, 0..33]

5. Confirm your entry.

6. Optional: Change the properties of the tags that are displayed in the other columns.

Entering start values of ARRAY elements
To set default start values for the individual elements of an ARRAY, follow these steps:

1. Click the triangle in front of the ARRAY data type tags.
The ARRAY opens and the individual ARRAY elements are shown in separate rows. 

2. Enter the required value in the "Start value" column.
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Declaring tags of STRUCT data type

Requirement   
A global data block is open.

Procedure
To declare a tag of the STRUCT data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter "Struct" in the "Data type" column. You will be supported by autocompletion during 
input.
An empty, indented row is inserted after the new tag.

3. Insert the first structural element in the first empty row.
An additional empty row is inserted after the element.

4. Select a data type for the structure element.

5. Optional: Change the properties of the structural element that is displayed in the other 
columns of the block interface.

6. Repeat the step 4 to 7 for all additional structure elements.
It is not necessary to end the structure explicitly. The structure ends with the last element 
that is entered.

7. To insert a new tag after the structure, leave a blank row after the end of the structure and 
then start the new tag in the second empty row.

Result
The tag of STRUCT data type is created. 

Enter start values of structure elements
To set default start values for the individual elements of a structure, follow these steps:

1. Click the triangle in front of the STRUCT data type tags.
The structure opens and the individual structure elements are shown in separate rows. 

2. Enter the required value in the "Start value" column.

See also
STRUCT (Page 1110)
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Declaring tags based on a PLC data type

Requirements    
● A global data block is open. 

● A PLC data type is declared in the current CPU.

Procedure
To declare a tag based on a PLC data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the PLC data type in the "Data type" column. You will be supported by autocompletion 
during input.

3. Optional: Change the properties of the tags that are displayed in the other columns of the 
table.

Result
The tag is created.

See also
Layout of the block interface (Page 1239)

Define start values

Basic information on start values

Definition of "Start value" 
The start value of a tag is a value defined by you which the tag assumes after a CPU startup. 

The retentive tags have a special status. Their values take the defined start value only after a 
"cold restart". After a "warm restart", they retain their values and are not reset to the start value.

Definition of "Default value" 
The structure of the data blocks can be derived from higher-level elements.

● An instance data block is based, for example, on the interface of a higher-level code block.

● A global data block can be based on a predefined PLC data type.

In this case you can define a default value for each tag in the higher-level element. These 
default values are used as start values during the creation of the data block. You can then 
replace these values with instance-specific start values in the data block. 
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Specification of an start value is optional. If you do not specify any value, the tag assumes the 
default value at startup. If a default is not defined either, the default value valid for the data 
type is used. For example, the value "FALSE" is specified as standard for BOOL.

 

See also
Define start values (Page 1393)

Structure of the declaration table for data blocks (Page 1384)

Declaring local tags in the block interface (Page 1244)

Applying values from the online program as start values (Page 1407)

Define start values

Define start values   
To define the start values for the tags of a data block, follow these steps:

1. Open the data block.
The "Default value" column shows the default values that were defined for the tags in the 
interface of a higher-level code block or in a PLC data type.

2. Click the "Expanded mode" button to show all elements of structured data types.

3. Enter the desired start values in the "Start value" column. The value must match the data 
type of the tag and should not exceed the range of the data type.
The start values are defined. The tag takes the defined value at startup, provided it was 
not declared as retentive. 

Resetting a tag to the default value
To reset a tag for which you have defined a start value to the default value, follow these steps:

1. Select a modified value in the table.

2. Delete the value.
The default value is entered. The default value is displayed.
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Resetting all tags to the default value
To reset to the default value all tags for which you have defined an start value, follow these 
steps:

1. Select the "Reset start values" icon in the toolbar.
The default values are transferred to the "Start value" column. Write-protected start values 
are not overwritten.

See also
Basic information on start values (Page 1392)

Applying values from the online program as start values (Page 1407)

Loading changed values

Introduction
To apply the changed start values from the offline program to the online program, you must 
load the changes. The following cases must be distinguished: 

● Loading changed start values of non-retentive tags

● Loading changed start values of retentive tags

● Loading changed start values of setting values

Requirement
The start values in the offline program were changed.

Procedure
To load changed start values of non-retentive tags, follow these steps:

1. Select the blocks to be loaded in the project tree.

2. Select the "Download to device > Software (only changes)" command from the shortcut 
menu.
The blocks are compiled and loaded. 
The start values of the newly defined tags are placed in the load memory of the CPU. The 
program runs with the new start values at the next transition from STOP to RUN.

 

To load changed start values of retentive tags, follow these steps:

1. Select the blocks to be loaded in the project tree.

2. Select the "Compile > Software (rebuild all blocks)" command in the shortcut menu.

3. In the "Online" menu, select the "Download and reset PLC program" command.
The online blocks are deleted and replaced with the new blocks. This reinitializes all tags, 
including the retentive tags. 
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Information about loading changed setting values and general information about loading can 
be found under "See also".

See also
Initializing setting values in the online program (Page 1406)

Setting retentivity

Retentivity of tags in data blocks

Retentive behavior    
To prevent data loss in the event of power failure, you can mark the data as retentive. This 
data is stored in a retentive memory area. The options for setting the retentivity depend on the 
type of data block and the type of block access that is set.

See also
Setting retentivity in an instance data block (Page 1395)

Setting retentivity in a global data block (Page 1396)

Setting retentivity in an instance data block

Introduction    
In an instance data block, the editability of the retentive behavior depends on the type of access 
of the higher-level function block: 

● Function block with standard access
You can define the instance data both as retentive or non-retentive. Individual retentivity 
settings are not possible for individual tags. 

● Function block with optimized access
In the instance data block, you can define the retentivity settings of the tags that are selected 
in the block interface with "Set in IDB". With these tags also, you cannot individually set the 
retentive behavior for each tag. The retentivity setting has an impact on all tags that are 
selected in the block interface with "Set in IDB".
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Setting Retentivity for Standard Access
To centrally set the retentivity of all tags in the data block with standard access, follow these 
steps:

1. Open the instance data block.

2. Select the check box in the "Retain" column of a tag.
All tags are defined as retentive.

3. To reset the retentivity setting for all tags, clear the check box in the "Retain" column of a 
tag.
All tags will be defined as non-retentive.

Setting Retentivity for Optimized Access
To set the retentive behavior of the tags that are selected with "Set in IDB" in data blocks with 
optimized access, follow these steps:

1. Open the instance data block.

2. Select the check box in the "Retain" column of a tag.
All tags selected with "Set in IDB" in the data block interface are defined as retentive.

3. To reset the retentivity setting for the tags, clear the check box in the "Retain" column of a 
tag.
All tags selected with "Set in IDB" in the data block interface will be defined as non-retentive.

See also
Basics of block access (Page 1027)

Retentivity of tags in data blocks (Page 1395)

Setting retentivity in a global data block

Introduction       
In a global data block, the editability of the retentive behavior depends on the type of access: 

● Global data block with standard access
You can define the data both as retentive or non-retentive. Individual retentivity settings 
are not possible for individual tags. 

● Global data block with optimized access
You can individually define the retentivity settings of the tags. For tags with structured data 
types, retentivity settings are transferred for all tag elements.
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Setting Retentivity for Standard Access
To centrally set the retentivity of all tags in the data block with standard access, follow these 
steps:

1. Open the global data block.

2. Select the check box in the "Retain" column of a tag.
All tags are defined as retentive.

3. To reset the retentivity setting for all tags, clear the check box in the "Retain" column of a 
tag.
All tags are defined as non-retentive.

Setting Retentivity for Optimized Access
To individually set the retentivity of all tags in data blocks with optimized access, follow these 
steps:

1. Open the global data block.

2. In the "Retain" column, select the check box for the tags for which you want to set a retentive 
behavior.
The selected tag is defined as retentive.

3. To reset the retentivity setting for the tags, clear the check box in the "Retain" column of a 
tag.
All selected tags are defined as non-retentive.
 

See also
Basics of block access (Page 1027)

Retentivity of tags in data blocks (Page 1395)

Editing the properties of tags in data blocks

Properties of the tags in data blocks

Properties     
The following table provides an overview of the properties of tags in data blocks:

Group Property Description
General Name Name of the tags.

Data type Data type of the tags.
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Group Property Description
Default value Default value of the tag in the interface of a higher-level 

code block or in a PLC data type. 
The values contained in the "Default value" column can 
only be changed in the higher-level code block or PLC 
data type. The values are only displayed in the data block. 

Start value Value that the tag should assume at CPU startup.
The default values defined in a code block are used as 
start values during the creation of the data block. You can 
then replace these adopted values with instance-specific 
start values. 
Specification of an start value is optional. If you do not 
specify any value, the tag assumes the default value at 
startup. If a default is not defined either, the default value 
valid for the data type is used. For example, the value 
"FALSE" is specified as standard for BOOL.

Comment Comment on the tag.
Attributes Retain Marks the tag as retentive. 

The values of retentive tags are retained even after the 
power supply is switched off. 
This attribute is only available in the interface of the 
function block with optimized access.

Visible Indicates whether a parameter is visible in CFC.
Configurable Indicates whether a parameter is configurable in CFC.
For test Indicates whether a parameter is registered for the CFC 

test mode.
Interconnectable Indicates whether a parameter is interconnectable in CFC.
Enable tag readback Indicates whether a parameter is relevant for the "Read 

back chart" function in CFC.
Enumeration texts Assigns a parameter to an enumeration in CFC.
Engineering unit Assigns a parameter to a unit in CFC.
Low limit Defines the low limit for the parameter in CFC.
High limit Defines the high limit for the parameter in CFC.

See also
Changing the properties of tags in instance data blocks (Page 1399)

Changing the properties of tags in global data blocks (Page 1400)
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Changing the properties of tags in instance data blocks

Instance-specific tag properties
Two options are available for defining the tag properties:

● The tag properties are applied from the interface of the assigned function block.
Properties that are applied from the function block are displayed grayed out out in the 
columns of the declaration table. The "Name" and "Data type" properties are always applied.

● You define instance-specific properties.
You can change some properties instance specific. Changeable values are, for example, 
"Comment" or "Visible in HMI". Properties that were changed instance specific are not 
grayed out in the columns of the declaration table. The instance-specific changes are 
retained, even if the interface of the higher-level function block is changed and the instance 
data blocks are subsequently updated.

Editing properties in the declaration table   
To edit the properties of one or more tags, follow these steps:

1. Open the instance data block.

2. Change the entries in the columns.

Editing properties in the properties window
To edit the properties of an individual tag, follow these steps:

1. Select a tag in the table.

2. Select the "Properties" command in the shortcut menu.
The properties window opens. It shows the properties of the tag in the "General" and 
"Attributes" areas.

3. Select the required area in the area navigation.

4. Change the entries in the text boxes.

Reset individual properties to the default value.
To reset individual tag properties to the value that was defined as default in the function block, 
follow these steps:

1. Select an instance-specific, modified value in the table.

2. Delete the value.
The instance-specific value will be deleted and the default value from the interface of the 
function block entered. The default value is displayed grayed out.

See also
Updating data blocks (Page 1387)

Properties of the tags in data blocks (Page 1397)
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Changing the properties of tags in global data blocks

Introduction
Two options are available for defining the tag properties:

● The tag properties are applied from the PLC data type.
Properties that are applied from the PLC data type are shown grayed out in the columns 
of the declaration table. The "Name" and "Data type" properties are always applied.

● You define specific properties.
You can change some properties in the global data block. Changeable values are, for 
example, "Comment" or "Visible in HMI". Properties that were changed are not grayed out 
in the columns of the declaration table. The changes are retained, even if the PLC data 
type changes and the global data block is subsequently updated.

Editing properties in the declaration table   
To edit the properties of one or more tags, follow these steps:

1. Open the global data block.

2. Change the entries in the columns.

Editing properties in the properties window
To edit the properties of an individual tag, follow these steps:

1. Select a tag in the table.

2. Select the "Properties" command in the shortcut menu.
The properties window opens. It shows the properties of the tag in the "General" and 
"Attributes" areas.

3. Select the required area in the area navigation.

4. Change the entries in the text boxes.

Reset individual properties to the default value.
To reset individual tag properties to the value that was defined as default in the PLC data type, 
follow these steps:

1. Select a modified value in the table.

2. Delete the value.
The default value from the PLC data type is entered. The default value is displayed grayed 
out.

See also
Properties of the tags in data blocks (Page 1397)
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Editing the declaration table for data blocks

Inserting table rows

Procedure  
Proceed as follows to insert a row above the selected row: 

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button on the toolbar of the table.

Result
A new row is inserted above the selected row. 

See also
Editing tables (Page 242)

Inserting table rows

Procedure  
Proceed as follows to insert a row below the selected row:

1. Select the row below which you want to insert a new row.

2. Click the "Add row" button on the table toolbar.

Result
A new empty row will be inserted below the selected row.

See also
Editing tables (Page 242)

Deleting tags

Requirements
A global data block is open.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1401



Procedure  
To delete a tag, follow these steps:

1. Select the row with the tag to be deleted. You can also select several rows by clicking on 
them one after the other while holding down the <Ctrl> key or by pressing and holding down 
<Shift> and clicking on the first and last row.

2. Select the "Delete" command in the shortcut menu.
 

 Note

You cannot directly change the structure of instance data blocks and of global data blocks 
based on a PLC data type, since the structures of these blocks are defined in the higher-level 
object. 

The type of the data block is entered in the block properties.

See also: Displaying and editing block properties  (Page 1213) 
 

 

See also
Editing tables (Page 242)

Automatically filling in successive cells
You can load the contents of one or several table cells into the cells below, automatically filling 
in the successive cells. 

If you automatically fill in cells in the "Name" column, a consecutive number will be appended 
to each name. For example, "Motor" will become "Motor_1".

You can define individual or more cells as well as entire rows as source area.

If less rows exist in the open table than you want to fill, then you will first have to insert additional 
empty rows. 

Requirement
● The table is open.

● Sufficient declaration rows are available.

Procedure  
To automatically fill in successive cells, follow these steps:

1. Select the cells to be loaded.

2. Click the "Fill" symbol in the bottom right corner of the cell.
The mouse pointer is transformed into a crosshair.
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3. Keep the mouse button pressed and drag the mouse pointer downwards over the cells that 
you want to fill in automatically.

4. Release the mouse button.
The cells are filled in automatically. 

5. If entries are already present in the cells that are to be automatically filled in, a dialog 
appears. In this dialog you can indicate whether you want to overwrite the existing entries 
or insert new rows for the new tags.

Show and hide table columns
You can show or hide the columns in a table as needed.

Procedure     
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

Editing tags with external editors
To edit individual tags in external editors outside the TIA portal, you can export or import these 
tags using copy & paste. However, you cannot copy structured tags to an editor.

Requirement   
The data block and an external editor are opened.

Procedure
To export and re-import individual tags by drag-and-drop operation, follow these steps:

1. Select one or more tags.

2. Select "Copy" in the shortcut menu.

3. Switch to the external editor and paste the copied tags.

4. Edit the tags as required.

5. Copy the tags in the external editor.

6. Switch back to the declaration table.

7. Select "Paste" in the shortcut menu.
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Monitoring data values online

Monitoring data values in data blocks online
You can monitor the current data values of the tags in the CPU directly in the declaration table.

Requirement   
● An online connection is available.

● The data block has been loaded to the CPU.

● The program execution is active (CPU in "RUN").

● The data block is open.

Procedure
To monitor the data values, proceed as follows:

1. Start monitoring by clicking the "Monitor all" button.
The additional "Monitor value" column is displayed in the table. This shows the current data 
values. 
See also: Structure of the declaration table for data blocks (Page 1384) 

2. End the monitoring by clicking the "Monitor all" button again.

 

Displaying data values loaded from the device
During the loading of a data block from a device, the current tag values are also loaded. You 
can display these values. 

Requirement
A data block was loaded from the device.

Procedure
To display the current values, follow these steps:

1. Open the data block.

2. Click a column header.

3. In the shortcut menu, select the "Show/hide columns" command.
The selection of available columns is displayed.

4. Select the check box in the "Snapshot" column.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1404 System Manual, 07/2013,  



Result
The current values will be applied in the "Snapshot" column.

 

 Note

If you subsequently change the structure of the data block, the display of the current values 
gets lost. The "Snapshot" column will then be empty.

 

Setting data values during commissioning

Basic information on adjusting data values during commissioning

Introduction  
During commissioning of a plant, data values have to be frequently adjusted in order to 
optimally adapt the program to the general operating conditions on site. The declaration table 
for data blocks offers the following functions for this purpose:

● Initialize data values in "RUN" mode
This function enables you to change data values online in order to quickly determine the 
optimum tag values.

● Transfer tag values from the online program to the offline program as start values
When you have determined the optimum tag values, you can apply these as start values 
in the offline program. This allows you to ensure that the program starts with the optimized 
values the next time it is loaded.

To use the function, first define specific tags as "Setting values" in the program. Setting values 
are the values that will probably have to be fine tuned during commissioning. 

 

Marking data as values that can be set
You can mark specific tags in the program as "Setting values". Setting values are the values 
that will probably have to be fine tuned during commissioning.

Rules  
You can mark tags as "Setting value" in the following block types:

● In function blocks (FB), but only in the "Static" section

● in global data blocks (DB)

● in PLC data types (UDT)
In the case of PLC data types (UDT), however, the setting is only effective, if the UDT is 
used in the "Static" section of a function block or data block.

It is not possible to define setting values in the following block types:
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● In data blocks based on a PLC data type, and in instance data blocks. These inherit the 
setting from the higher-level FB or UDT.

● You cannot mark tags as a "Setting value" in ARRAY data blocks.

● You also cannot mark tags as a "Setting value" at the call point of a multi-instance. You 
have to make the setting in the interface of the function block that is called as multiple 
instance.

● You cannot change the "Setting value" marking in know-how-protected blocks. To do so, 
you must first remove the know-how protection.

Requirement
A function block, a global data block or a PLC data type (UDT) is open.

Procedure
To mark a tag as "Setting value", follow these steps:

1. Select a tag from the "Static" section.

2. Select the check box in the "Setting value" column.

– You cannot define the higher-level element of a structure or a PLC data type as "Setting 
value". You have to make the setting for the lower-level elements individually.

– In the case of ARRAYs, you can only mark the higher-level element as "Setting value". 
The lower-level elements inherit the setting.

– For ARRAYs of STUCT, you can only mark the elements below the first structure as 
setting values. The elements of other structures inherit the setting.

Result
The tags are marked as setting values. During commissioning, these tags can be initialized in 
"RUN" mode. In addition, the current tag values can be transferred as start values to the offline 
program and saved there.

Initializing setting values in the online program

Basics on initializing setting values
You can initialize all tags marked as a "Setting value" with new values in the online program. 
At the same time, the start values will be loaded from the offline program to the online program. 
The CPU remains in "RUN" mode. All tags that are marked as a setting value are initialized 
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once at the next cycle control point. This applies both to retentive and non-retentive tags. The 
program execution is then continued with the new tag values.

 

 DANGER

Danger when changing tag values

Changing the tag values while the plant is operating can cause serious damage to property 
or injury to persons if there are functional disturbances or program errors!

Make sure that no dangerous situations can arise before you re-initialize the setting values.
 

Requirement
● An online connection to the CPU exists.

● The structure of the data block is identical offline and online.

● One or more tags are marked as a "Setting value".

Procedure
To initialize all setting values of the data block, follow these steps:

1. Open a global data block or an instance data block.

2. Enter the desired values in the "Start value" column. The start values must correspond to 
the indicated data type.

3. Click the "Initialize setting values" button.

Result
The setting values in the online program are initialized with the start values from the offline 
program at the next cycle control point.

The maximum number of tags that can be initialized is dependent on the CPU. If too many 
setting values are marked, an alarm informs you about this. In this case, you can insert the 
tags in a watch table and initialize them using the "Modify" function in the watch table. 
Alternatively, you can also load the entire data block. For more information on this, refer to 
"See also".

See also
Loading changed values (Page 1394)

Applying values from the online program as start values
In order to apply tag values from the online program to the offline program as start values, first 
create a snapshot of the tag values from the online program. You can then apply them to the 
offline program. Note that the values from the snapshot are always copied. There is no check 
to determine whether all values originate from the same cycle. Write-protected start values are 
not overwritten.
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You have the following basic options for applying the values:

● Applying the values of an open data block
You can apply all values or only the values of the tags marked as a "setting value" as start 
values in an open data block.

● Applying the values of multiple blocks in the project tree
You can either apply all setting values or all retentive values as start values in the project 
tree.

Requirement  
● An online connection to the CPU is available.

● As least one data block has been loaded to the CPU.

Procedure
In order to apply all values or only the values of the tags marked as a "setting value" in a data 
block, follow these steps:

1. Open the data block.

2. Start monitoring by clicking the "Monitor all" button.
The "Monitor value" column is displayed in the table. This shows the current data values. 

3. On the toolbar, click "Snapshot of monitored values".
The latest monitored values will be applied in the "Snapshot" column.

4. Click one of the following buttons on the toolbar:

– "Apply setting values from the snapshot as start values"

– "Apply all values from the snapshot as start values"

The values from the "Snapshot" column are applied to the "Start value" column.

 

To apply the monitored values of multiple data blocks in the project tree, follow these steps:

1. Select the blocks in the project tree.

2. Select the "Snapshot of the monitored values" command in the shortcut menu.
The current monitored values of all selected blocks will be applied in the "Snapshot" column.
An alarm is shown in the Inspector window after the operation is complete.

3. Then select one of the following commands in the shortcut menu:

– "Apply monitor values as start values > Only setpoints"

– "Apply monitor values as start values > Only retain values"

The values from the "Snapshot" column are applied to the "Start value" column.
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Result
The new start values are stored in the offline program. 

 

 Note
Applying values of individual tags 

You can also transfer the values of individual tags that were not marked as a setting value 
beforehand from the "Snapshot" column to the "Start values" column. Use the "Copy" and 
"Paste" commands from the shortcut menu to copy the values and insert them in the "Start 
value" column. 

 

See also
Basic information on start values (Page 1392)

Define start values (Page 1393)

9.1.4.4 Programming PLC data types

Basics of PLC data types

Description 
PLC data types are data structures that you define and that can be used multiple times within 
the program. The structure of a PLC is made up of several components, each of which can 
contain different data types. You define the type of components during the declaration of the 
PLC data type.

PLC data types can be used for the following applications:

● PLC data types can be used as data types for variables in the variable declaration of logic 
blocks or in data blocks.

● PLC data types can be used as templates for the creation of global data blocks with identical 
data structures.

See also
Creating PLC data types (Page 1411)
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Structure of the declaration table for PLC data types

Structure of the declaration table for PLC data types   
The figure below shows the structure of the declaration table for PLC data types.

Meaning of the columns
The following table shows the meaning of the individual columns. You can show or hide the 
columns as required. The number of columns displayed varies depending on the CPU 
series.

Column Explanation
Symbol you can click to move or copy the tag. 

Name Name of the tags.
Data type Data type of the tags.
Default value Value with which you predefine the tag in the declaration of the PLC data type.

Specification of the default value is optional. If you do not specify any value the 
predefined value for the indicated data type is used. For example, the value "false" 
is predefined for BOOL.

Visible in HMI Shows whether the tag is visible by default in the HMI selection list.
Accessible from 
HMI

Shows whether HMI can access this tag during runtime.

Setting value Setting values are the values that will probably have to be fine tuned during 
commissioning. After commissioning, the values of these tags can be transferred 
to the offline program as start values and stored there. 

Comment Comment to document the tags.

See also
Creating PLC data types (Page 1411)

Show and hide table columns (Page 1418)

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1410 System Manual, 07/2013,  



Creating PLC data types

Requirement  
The "PLC data types" folder opens in the project tree.

Procedure
To create a PLC data type, proceed as follows:

1. In the "PLC data types" folder, click the "Add new data type" command.
A new declaration table for creating a PLC data type will be created and opened.

2. Select the PLC data type and select the "Rename" command in the shortcut menu.

3. Enter the name of the PLC data type.

Result
The new PLC data type is created. You can find the PLC data type in the project tree in the 
"PLC data types" folder.

See also
Structure of the declaration table for PLC data types (Page 1410)

Basics of PLC data types (Page 1409)

Delete PLC data types

Requirement
The PLC data type you want to delete is not open.

Procedure  
To delete a PLC data type, follow these steps:

1. In the project tree, open the "PLC data types" folder.

2. Select the PLC data type to be deleted. You can also select several PLC data types by 
clicking on them one after the other while holding down the <Ctrl> key or by pressing and 
holding down <Shift> and clicking on the first and last data type.

3. Select the "Delete" command in the shortcut menu.
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 Note

If you delete a PLC data type, the blocks that use the data type will become inconsistent. 
These inconsistencies are marked in red in the block used. To remedy these inconsistencies, 
the data blocks have to be updated.

See also:

Updating the block interface (Page 1250)

Updating data blocks (Page 1387)
 

Programming the structure of PLC data types

Declaring tags of elementary data type

Requirement  
A PLC data type is open. 

Procedure
To declare a tag, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the required data type in the "Data type" column. You will be supported by 
autocompletion during input. 

3. Optional: Change the properties of the tags that are displayed in the other columns.

4. Repeat steps 1 to 3 for all tags that are to be declared.

See also
Editing tables (Page 242)

Declaring tags of the ARRAY data type

Requirement   
A PLC data type is open. 
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Procedure
To declare a tag of the ARRAY data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the "Array" data type in the "Data type" column. You will be supported by 
autocompletion in this step.
The "Array" dialog opens.

3. In the "Data type" text box, specify the data type of the array elements.

4. In the "ARRAY limits" text box, specify the high and low limit for each dimension.
Example of a one-dimensional ARRAY:
[0..3]
Example of a three-dimensional ARRAY:
[0..3, 0..15, 0..33]

5. Confirm your entry.

6. Optional: Change the properties of the tags that are displayed in the other columns.
 

 Note

You cannot define specific default values for ARRAY elements. You can, however, assign 
them start values at the usage point in the data block.

 

See also
Structure of the declaration table for PLC data types (Page 1410)

Declaring tags of STRUCT data type 

Requirements   
A PLC data type is open. 

Procedure
To declare a tag of the STRUCT data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter "Struct" in the "Data type" column. You will be supported by autocompletion during 
input.
An empty, indented row is inserted after the new tag.

3. Insert the first structural element in the first empty row.
An additional empty row is inserted after the element.

4. Select a data type for the structure element.

5. Optional: Change the properties of the structural element that is displayed in the other 
columns.
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6. Repeat steps 3 to 5 for all additional structure elements.
It is not necessary to end the structure explicitly. The structure ends with the last element 
that is entered.

7. To insert a new tag after the structure, leave a blank row after the end of the structure and 
then start the new tag in the second empty row.

Result
The tag of STRUCT data type is created.

See also
STRUCT (Page 1110)

Structure of the declaration table for PLC data types (Page 1410)

Declaring tags based on a different PLC data type

Requirements  
● A global data block is open. 

● A PLC data type is declared in the current CPU.

Procedure
To declare a tag based on a different PLC data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the PLC data type in the "Data type" column. You will be supported by autocompletion 
during input.

Result
The tag is created.

 

 Note

You define the default values of tags within a PLC data type when the PLC data type is 
created. You cannot change these values at the point of use of the PLC data type.

 

See also
Basics of PLC data types (Page 1409)

Structure of the declaration table for PLC data types (Page 1410)
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Editing tag properties in PLC data types

Properties of tags in PLC data types

Properties   
The following table gives an overview of tag properties in PLC data types:

Group Property Description
General Name Name of the tags.

Data type Data type of the tags.
Default value Default value of the tag in the interface of a higher-level 

code block or in a PLC data type. 
The values contained in the "Default value" column can 
only be changed in the higher-level code block or PLC 
data type. The values are only displayed in the data block. 

Start value Not relevant in PLC data types
Comment Comment on the tag.

Attributes Retain Not relevant in PLC data types
Visible Indicates whether a parameter is visible in CFC.
Configurable Indicates whether a parameter is configurable in CFC.
For test Indicates whether a parameter is registered for the CFC 

test mode.
Interconnectable Indicates whether a parameter is interconnectable in CFC.

See also
Changing the properties of tags in PLC data types (Page 1415)

Basics of PLC data types (Page 1409)

Structure of the declaration table for PLC data types (Page 1410)

Changing the properties of tags in PLC data types

Editing general properties in the declaration table   
To edit the general properties of one or more tags, follow these steps:

1. Open the PLC data type.

2. Change the entries in the columns.
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Editing detailed properties in the properties window
To edit the detailed properties of an individual tag, follow these steps:

1. Select a tag in the table.

2. Select the "Properties" command in the shortcut menu.
The inspector window shows the properties of the tag in the "General" and "Attributes" 
areas.

3. Select the required area in the area navigation.

4. Change the entries in the text boxes.

See also
Updating the block interface (Page 1250)

Updating data blocks (Page 1387)

Editing the declaration table for PLC data types

Inserting table rows

Procedure  
Proceed as follows to insert a row above the selected row: 

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button on the toolbar of the table.

Result
A new row is inserted above the selected row. 

Inserting table rows

Procedure  
Proceed as follows to insert a row below the selected row:

1. Select the row below which you want to insert a new row.

2. Click the "Add row" button on the table toolbar.

Result
A new empty row will be inserted below the selected row.
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Deleting tags

Procedure  
To delete a tag, follow these steps:

1. Select the row with the tag to be deleted. You can also select several rows by clicking on 
them one after the other while holding down the <Ctrl> key or by pressing and holding down 
<Shift> and clicking on the first and last row.

2. Select the "Delete" command in the shortcut menu.

See also
Updating the block interface (Page 1250)

Updating data blocks (Page 1387)

Automatically filling in successive cells
You can load the contents of one or several table cells into the cells below, automatically filling 
in the successive cells. 

If you automatically fill in cells in the "Name" column, a consecutive number will be appended 
to each name. For example, "Motor" will become "Motor_1".

You can define individual or more cells as well as entire rows as source area.

If less rows exist in the open table than you want to fill, then you will first have to insert additional 
empty rows. 

Requirement
● The table is open.

● Sufficient declaration rows are available.

Procedure  
To automatically fill in successive cells, follow these steps:

1. Select the cells to be loaded.

2. Click the "Fill" symbol in the bottom right corner of the cell.
The mouse pointer is transformed into a crosshair.

3. Keep the mouse button pressed and drag the mouse pointer downwards over the cells that 
you want to fill in automatically.

4. Release the mouse button.
The cells are filled in automatically. 

5. If entries are already present in the cells that are to be automatically filled in, a dialog 
appears. In this dialog you can indicate whether you want to overwrite the existing entries 
or insert new rows for the new tags.
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Show and hide table columns
You can show or hide the columns in a table as needed.

Procedure     
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

9.1.4.5 Using external source files

Basics of using external source files

Function 
The textual programming languages STL and SCL allow you to enter the program code in any 
ASCII editor and save it as an external source file. This enables you to perform a range of 
tasks, for example:

● Declaring tags

● Specify block properties

● Programming blocks

You can import these source files to your project and use them to generate blocks. You can 
generate a number of different blocks from one source file. Observe the following special 
features when generating blocks from a source file:

● A block that exists under the same name in the project will be overwritten. However, the 
block type is retained for an organization block (OB).

● If a block was programmed with its absolute block number instead of a symbolic name in 
the source file and this number is already assigned by a block in the project, the new 
generated block is initially assigned the next free symbolic name.

● If you have not explicitly defined the access mode for a block in the external source file, 
the block access mode is set depending on the CPU series used:

– Blocks generated for a CPU of the S7-1200/1500 series are assigned "optimized" 
access mode by default.

– Blocks generated for a CPU of the S7-300/400 product range are assigned "standard" 
access mode by default.

Organization blocks are the exception in this case, as they are always assigned the 
"standard" access mode by default, regardless of the CPU series. You have the option of 
changing the block access mode manually.
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● It is possible that not all comments from the source file will be applied in the block. 

● If you use absolute addressing in the external source file, a symbolic tag is created for each 
absolute address during the generation of the block. The names of these tags are made 
up of "Tag_" and a time stamp. This may result in relatively long tag names, which you can 
change manually if required.

● If you are using instructions in a different version in the external source file than in the target 
device, this may result in compilation errors. Correct the respective instructions in this case 
and start the compilation process once again. You can also select a different version for 
the target device.

You also have the option of saving existing blocks as external source files. 

See also
Rules for programming external source files  (Page 1419)

Saving blocks as external source files (Page 1420)

Inserting external source files (Page 1421)

Opening and editing external source files (Page 1422)

Generating blocks from external source files (Page 1422)

Rules for programming external source files 
An external source file basically consists of continuous text. To compile the source into blocks, 
certain structures and syntax rules must however be adhered to.

Syntax rules   
The syntax of the instructions in external source files is very similar to that in the creation of 
user programs in the program editor with STL or SCL. Note, however, the following additional 
syntax rules:

● Block call
When calling a block, transfer the parameters in the defined order in the ASCII editor. If 
you do not, the comment assignments for these lines may not match.
Enter the parameters in brackets. The individual parameters are separated by a comma. 

● Upper or lower case
The program editor generally disregards upper or lower case. Jump labels are an exception 
to this. Character string entries are also case-sensitive ("STRING" data type). Keywords 
are displayed in upper case. For compilation purposes, however, case is disregarded; you 
can therefore specify keywords in upper or lower case or a mixture of the two.

● Semicolon
Mark the end of every instruction and every tag declaration with a semicolon. You can enter 
several instructions per line.

● Forward slashes
Begin every comment with two forward slashes (//) and end the comment with the <Enter> 
key.
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See also
Basics of using external source files (Page 1418)

Saving blocks as external source files (Page 1420)

Inserting external source files (Page 1421)

Opening and editing external source files (Page 1422)

Generating blocks from external source files (Page 1422)

Saving blocks as external source files
Depending on the programming language used for the block, you have the following options 
for storing blocks as external source files:

● STL and SCL: copy a block as text

● SCL: generate external source file from one or more blocks

Copying a block as text     
To copy a block as text and export it to an external source file, follow these steps:

1. In the project tree, right-click on the block you want to export to an external source file.

2. Select the "Copy as text" command in the shortcut menu.

3. Open an external text editor.

4. Paste the copied text from the clipboard.

5. Save the file with one of the following file name extensions:

– ".scl" if you wish to generate a source file for SCL

– ".stl" if you wish to generate a source file for STL

Generating an external source file from SCL blocks
To generate an external source file from SCL blocks, follow these steps:

1. In the project tree or in the overview window, select the SCL blocks from which you want 
to generate an external source file.

2. Select the "Generate source from blocks" command from the shortcut menu.
The "Generate source from blocks" dialog opens.

3. Specify a path and a name for the external source.

4. Click "OK".

You can also generate an external source file from an open SCL block. To do this, follow these 
steps:

1. Click on the "Generate source from block" button in the programming editor.
The "Generate source from blocks" dialog opens.

2. Specify a path and a name for the external source.

3. Click "OK".
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Result
The block has been saved as an external source file. You can include this source file in a 
project in the TIA portal and use it to generate other blocks. However, please note that you 
can use STL source files only in S7-300/400/1500 CPUs. 

See also
Basics of using external source files (Page 1418)

Rules for programming external source files  (Page 1419)

Inserting external source files (Page 1421)

Opening and editing external source files (Page 1422)

Generating blocks from external source files (Page 1422)

Inserting external source files

Requirement
● An external source file is available and complies with the syntax and structure rules.

● The "External source files" folder is open in the project tree.

Procedure
Follow these steps to insert an external source file:

1. Double-click on the "Add new external file" command.
The "Open" dialog box is opened.

2. Navigate to and select existing external source files.

3. Confirm your selection with "Open".

Result
The new source file will be added to the "External source files" folder. 

See also
Basics of using external source files (Page 1418)

Rules for programming external source files  (Page 1419)

Saving blocks as external source files (Page 1420)

Opening and editing external source files (Page 1422)

Generating blocks from external source files (Page 1422)
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Opening and editing external source files
By linking the files with the file name extensions "stl" and "scl" to an editor you will be able to 
open and edit external source files with these formats directly. Use Notepad as editor because 
other text editors may not let you open several sources at the same time. 

This means you do not need to insert the external source files again after editing.

Linking files with the file name extensions "stl" and "scl" file types to an editor
Proceed as follows to link files with the file name extensions "stl" and "scl" to an editor:

1. Open Windows Explorer.

2. Right-click on an STL file.

3. Select "Properties" in the shortcut menu.
The "Properties" dialog box opens.

4. Click "Change" in the "File type" area on the "General" tab.
The "Open with" dialog box opens.

5. Select the text editor you want to link to the "stl" file type.

6. Confirm your selection with "OK".

7. Close the "Properties" dialog with "OK".

8. Repeat steps 2 to 7 with an SCL file.

Opening and editing an external source file
To open an external source file, follow these steps:

1. Open the "External source files" folder in the project tree.

2. Double-click on the external source file you want to open.
The external source file will open in the linked editor and can be edited. 

See also
Basics of using external source files (Page 1418)

Rules for programming external source files  (Page 1419)

Saving blocks as external source files (Page 1420)

Inserting external source files (Page 1421)

Generating blocks from external source files (Page 1422)

Generating blocks from external source files

Requirement   
● The "External source files" folder is open in the project tree.

● An external source file is available.
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Procedure
To generate blocks from an external source file, follow these steps:

1. Open the external source file from which you wish to generate blocks.

2. Select the "Generate blocks from source" command in the "Edit" menu.

3. A prompt will appear telling you any existing blocks will be overwritten.

4. Confirm the safety prompt with "Yes".

Result 
The external source file blocks will be generated and inserted in the "Program blocks" folder 
in the project tree. In the event of errors, information about the errors which have occurred will 
be displayed in the inspector window. This information, however, relates to the external source 
file and not to the block generated.

See also
Basics of using external source files (Page 1418)

Rules for programming external source files  (Page 1419)

Saving blocks as external source files (Page 1420)

Inserting external source files (Page 1421)

Opening and editing external source files (Page 1422)

9.1.5 Comparing PLC programs

9.1.5.1 Basic information on comparing PLC programs

Introduction to comparing PLC programs

Function
You can compare the following objects of a PLC program in order to detect any differences: 

● Code blocks with other code blocks

● Data blocks with other data blocks

● PLC tags of a PLC tag table with the PLC tags of another PLC tag table

● PLC data types with other PLC data types
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Types and levels of comparison
Two different basic types of comparison can be used:

● Online/offline comparison:
The objects in the project are compared with the objects of the corresponding device. An 
online connection to the device is necessary for this comparison. 

● Offline/offline comparison:
The objects of two devices either within a project or from different projects or libraries are 
compared. No online connection is required for this comparison.

Please note that you cannot carry out an unlimited number of comparisons at the same time. 
The limit is one comparison for each comparison type (online/offline or offline/offline) and for 
each starting point (device or "Program blocks" folder).

You can choose between the following levels of comparison depending on how in-depth an 
object comparison you require:

● Compare editor

● Detailed comparison

When you start a comparison, you will first receive an overview in the compare editor. For 
some comparison objects, you can then start a detailed comparison in which the objects 
compared will be opened side-by-side, each in its own program editor instance. Any differences 
will be highlighted. 

The table below gives an overview of the types and levels of comparison you can apply for 
each object:

Object Online/offline Offline/offline
Compare editor Detailed 

comparison
Compare editor Detailed comparison

LAD block X X X X
FBD block X X X X
STL block1 X X X X
SCL block X X3 X X
GRAPH block2 X - X -
Global data block X X X X
Instance data 
block

X X X X

PLC tags - - X X
PLC data type X4 X4 X X
Legend:
X: available
-: not available
1: STL is not available for S7-1200
2: GRAPH is not available for S7-1200/1500
3: not for S7-1200 prior to version 2.0
4: not for S7-300/400
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 Note
Please note the following:
● You cannot perform a detailed comparison for know-how protected blocks.
● If the detail comparison detects differences only with respect to the data types of local 

tags, with offline being an interrupt data type (C_ALARM C_ALARM_S C_ALARM_8 
C_ALARM_8P C_ALARM_T C_AR_SEND C_NOTIFY C_NOTIFY_8P) and online a 
DWORD, this difference is not marked as such.

● You cannot run a detailed comparison for types and master copies from libraries.
 

 

See also
Basics of project data comparison (Page 286)

Comparison of code blocks (Page 1425)

Comparison of data blocks (Page 1426)

Comparing PLC tags and PLC data types (Page 1427)

Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

Comparison of code blocks

Introduction
The blocks to be compared in a code block comparison are assigned for comparison on the 
basis of the following criteria:

● Online/offline comparison: Addresses, e.g. FB100

● Offline/offline comparison: Symbolic names of the blocks

The comparison involves an evaluation of the block time stamps. The results are displayed as 
an overview in the comparison editor. You can then use actions to define what is to be done 
about the differences. You can also start detailed comparisons for the individual blocks. The 
versions of a block compared are opened beside each other and the differences are highlighted.

For the comparison of code blocks, both the block interfaces and the individual networks are 
compared. Any differing tag names are also determined. All comments and other block 
attributes are excluded from an online/offline comparison.

If the block interface changes, the time stamp of the code block interface will also change. This 
change means a change in the time stamp of the program code. The first step in comparing 
block interfaces is therefore a comparison of the program code time stamps. If these time 
stamps are the same, it is assumed that the interfaces are the same. If the time stamps of the 
interfaces differ, the next step is to compare the data types of the interfaces, section by section. 
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Multiple instances and PLC data types are included in the comparison. If the data types in the 
sections are the same, the start values of the tags are compared. All differences are displayed. 

When networks are compared, first inserted or deleted networks are detected. Then the other 
networks are compared. Instructions are the same if the operator and operand are the same. 
The first difference in each instruction is displayed. However, several differences per network 
can be displayed. 

See also
Introduction to comparing PLC programs (Page 1423)

Comparison of data blocks (Page 1426)

Comparing PLC tags and PLC data types (Page 1427)

Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

Comparison of data blocks

Introduction   
The blocks to be compared in a data block comparison are assigned for comparison on the 
basis of the following criteria:

● Online/offline comparison: Addresses, e.g. DB100

● Offline/offline comparison: Symbolic names of the blocks

The first step in data block comparison is comparing the time stamps of the data block. If these 
time stamps are the same, it is assumed that the data structures are the same. If the time 
stamps differ, the structures are then compared until the first difference is found. If the data 
structures in the sections are the same, the initial and current values of the tags are then 
compared. All differences are displayed. Any differing tag names are also determined. 
Comments and PLC data type structures used in the data block are not included in the 
comparison. 

See also
Introduction to comparing PLC programs (Page 1423)

Comparison of code blocks (Page 1425)

Comparing PLC tags and PLC data types (Page 1427)

Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)
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Comparing PLC tags and PLC data types

Introduction
The device PLC tag tables and the device PLC data types will also be shown in the comparison 
editor if you carry out an offline/offline comparison.  The PLC tag tables and the PLC data 
types will be matched by name and you will receive the following information:

● Status: A symbol shows whether the PLC tags/PLC data types are identical or differ.

● Missing PLC tag tables / PLC data types: You can see at a glance whether the PLC tag 
tables / PLC data types are available in both devices.

You obtain the following information with an online/offline comparison of CPUs of the 
S7-1200/1500 series:

● PLC tags: A symbol shows whether the PLC tags are identical or differ. Because PLC tag 
tables are not downloaded to the device during loading, they cannot be displayed during 
an online/offline comparison.

● PLC data types: You receive the status symbol for each PLC data type. You can see at a 
glance whether the PLC data types are available in both devices.

See also
Introduction to comparing PLC programs (Page 1423)

Comparison of code blocks (Page 1425)

Comparison of data blocks (Page 1426)

Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

9.1.5.2 Comparing blocks

Comparing blocks in the compare editor
You have the following options for comparing blocks in the compare editor:

● Online/offline comparison
The blocks in the project are compared with the blocks of the selected device.

● Automatic offline/offline comparison
All blocks of the selected devices are compared offline. 

● Manual offline/offline comparison
The selected blocks of the devices are compared offline.
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Carrying out an online/offline comparison of blocks
To perform an online/offline comparison, follow these steps:

1. In the project tree, select a device that allows online/offline comparison.

2. Select the "Compare > Offline/online" command in the shortcut menu.

3. If you have not already established an online connection to this device, the "Go online" 
dialog opens. In this case, set all the necessary parameters for the connection and click 
"Connect". 
The online connection is established and the compare editor opens.

4. Open the "Program blocks" folder.
You can identify the status based on the symbols in the status and action area. You can 
define certain actions depending on the status of the objects. Note, however, that you can 
only perform actions in one direction in a synchronization action.

Carrying out an automatic offline/offline comparison of blocks
To perform an automatic offline/offline comparison of blocks, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. Open the "Program blocks" folder.
You can identify the status of the objects based on the symbols in the status and action 
area. You can define certain actions depending on the status of the objects. When you 
select an object, the object's properties and the corresponding object of the assigned device 
are clearly shown in the properties comparison.

You can drag any other device to the drop area at any time to perform further comparisons.

Carrying out a manual offline/offline comparison of blocks
To perform a manual offline/offline comparison of blocks, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane. The device to be 
compared can originate from the same project, a reference project or the library.

4. In the status and action area, click on the button for switching between automatic and 
manual comparison.

5. Select the objects that you want to compare. 
The properties comparison is displayed. You can identify the status of the objects based 
on the symbols. You can define certain actions depending on the status of the objects.

You can drag any other device to the drop area at any time to perform further comparisons.
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See also
Introduction to comparing PLC programs (Page 1423)

Using the comparison editor  (Page 288)

Comparing PLC tags (Page 1435)

Comparing PLC data types (Page 1436)

Performing detailed block comparisons

Starting a detailed comparison 
You can start a detailed comparison for blocks.  The versions of a block compared are opened 
beside each other and the differences highlighted. 

 

 Note

Please note the following:
● You cannot carry out detailed comparisons of blocks created in the GRAPH programming 

language.
● For blocks that are created in the programming language SCL, the detail comparison is 

not available for S7-1200 series CPUs with a version older than 2.0.
 

 

Starting detailed comparisons using the compare editor 
To start a detailed comparison for a block using the compare editor, follow these steps:

1. First, perform an online/offline or an offline/offline comparison.
The compare editor opens.

2. In the compare editor, select the block for which you want to perform a detailed comparison.

3. Click the "Start detailed comparison" button in the toolbar.

Starting detailed comparisons in the program editor
For the comparison type online/offline, you can start the detailed comparison directly in the 
programming editor.  To do this, follow these steps:

1. Open the block for which you wish to carry out a detailed comparison.

2. Establish an online connection.
See also: Go online and Go offline

 

  Note

Please note that the block must be available online in order for you to be able to start the 
detailed comparison for the block within the programming editor.
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3. Click the "Detailed comparison" button in the toolbar.

4. Confirm the dialog for closing the block with "Yes".

Result
One instance of the program editor will be opened for each version of the block compared and 
the two instances is displayed side by side. Any differences will be highlighted in color in each 
version. 

See also
Carrying out offline/offline comparisons (Page 287)

Carrying out an online/offline comparison (Page 287)

Using the comparison editor  (Page 288)

Representation of the detailed comparison (Page 1430)

Navigating in the detailed comparison (Page 1432)

Changing blocks during detailed comparison (Page 1433)

Updating comparison results (Page 1434)

Representation of the detailed comparison

Identification of the differences   
The detailed comparison allows you to identify the exact places where versions of a block 
differ. The following color coding allows you to find these places as quickly as possible:

● The lines where there are differences are highlighted in gray.

● Differing operands and instructions are highlighted in green.

● If the number of networks differs, pseudo-networks are added to allow the display of 
identical networks to be synchronized. These pseudo-networks are highlighted in grey and 
contain the text "No corresponding network found" in the title bar of the network. Pseudo-
networks cannot be edited.
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Example
The following figure shows an example of the detailed comparison for the LAD programming 
language:
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 Note

The display of the symbolic name of the online version of the block is only possible for S7-1200 
and S7-1500.

 

 

Reducing the number of differences displayed
For the sake of clarity, not all the differences are highlighted but rather the first difference of 
an operation in each case. For example, if all the inputs in a box with multiple inputs are different 
in the offline and online versions of the block, only the first input is highlighted as a difference. 
You can resolve this difference and update the comparison list. The next input will then be 
highlighted as a difference.

The number of differences highlighted within a network therefore depends on the number of 
instructions.

See also
Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

Starting a detailed comparison  (Page 1429)

Navigating in the detailed comparison (Page 1432)

Changing blocks during detailed comparison (Page 1433)

Updating comparison results (Page 1434)

Navigating in the detailed comparison

Requirement
You have run a detailed comparison.

Navigate to the differences   
To navigate to a difference between the two blocks, follow these steps:

1. Open the list of results for the detailed comparison under "Info > Comparison result" in the 
Inspector window.

2. Double-click a difference.
The difference is selected in both editors.

Or:
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1. Click one of the following navigation buttons on the toolbar:

– Position on first difference
Navigates to the first difference in the block, and displays the difference in both editors. 

– Position on previous difference
Navigates to the previous difference starting from the current position, and displays the 
difference in both editors. 

– Position on next difference
Navigates to the next difference starting from the current position, and displays the 
difference in both editors. 

– Position on last difference
Navigates to the last difference in the block, and displays the difference in both editors. 

Switching off/on the synchronization of the vertical scrolling between the editors   
The scrolling for both editors is synchronized to ensure that the corresponding networks are 
visible parallel to each other during vertical scrolling. You can switch this mode off and on. To 
do this, follow these steps:

1. To switch off synchronized scrolling, click the "Synchronize scrolling between editors" 
button in the toolbar.

2. To switch on synchronized scrolling again, click the "Synchronize scrolling between editors" 
button one more time in the toolbar.

See also
Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

Starting a detailed comparison  (Page 1429)

Representation of the detailed comparison (Page 1430)

Changing blocks during detailed comparison (Page 1433)

Updating comparison results (Page 1434)

Changing blocks during detailed comparison

Changing offline blocks 
You can change offline blocks at any time. 

Changing online blocks
You cannot change online blocks. 
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See also
Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

Starting a detailed comparison  (Page 1429)

Representation of the detailed comparison (Page 1430)

Navigating in the detailed comparison (Page 1432)

Updating comparison results (Page 1434)

Updating comparison results
As soon as you change an object, the comparison results are no longer valid and must be 
updated.

Requirement
You have run a detailed comparison.

Procedure
To update the comparison results, follow these steps:

1. Click "Update the comparison result" in the toolbar.

See also
Carrying out an online/offline comparison (Page 287)

Carrying out offline/offline comparisons (Page 287)

Using the comparison editor  (Page 288)

Starting a detailed comparison  (Page 1429)

Representation of the detailed comparison (Page 1430)

Navigating in the detailed comparison (Page 1432)

Changing blocks during detailed comparison (Page 1433)
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9.1.5.3 Comparing PLC tags
You have the following options for comparing PLC tags:

● Automatic offline/offline comparison in the compare editor
The PLC tag tables of the selected devices are compared offline. 

● Manual offline/offline comparison in the compare editor
The selected PLC tag tables of the devices are compared offline.

● Detailed comparison
Use the detailed comparison to determine differences within the PLC tag tables.

Performing automatic offline/offline comparison in the compare editor
To perform an automatic offline/offline comparison of PLC tag tables, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. Open the "PLC tags" folder.
You can identify the status of the PLC tag tables based on the symbols in the status and 
action area. You can define certain actions depending on the status. 

You can drag any other device to the drop area at any time to perform further comparisons.

Performing manual offline/offline comparison in the compare editor
To perform a manual offline/offline comparison of PLC tag tables, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. In the status and action area, click on the button for switching between automatic and 
manual comparison.

5. Select the PLC tag tables that you want to compare. 
The properties comparison is displayed. You can identify the status based on the symbols.

You can drag any other device to the drop area at any time to perform further comparisons.
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Running a detailed comparison
To start a detailed comparison for a PLC tag table, follow these steps:

1. Perform an automatic or manual offline/offline comparison.

2. For an automatic offline/offline comparison in the compare editor, select the PLC tag table 
for which you want to run a detailed comparison. Note that two PLC tag tables must be 
selected for comparison for a manual offline/offline comparison.

3. Click the "Start detailed comparison" button in the toolbar.
A separate compare editor opens. All existing PLC tags of the selected PLC tag tables are 
displayed depending on the settings of the compare editor. User and system constants are 
not shown, however. You can identify the status of the PLC tags based on the symbols. 
You can define certain actions depending on the status of the PLC tags. 

See also
Introduction to comparing PLC programs (Page 1423)

Using the comparison editor  (Page 288)

Comparing PLC data types (Page 1436)

9.1.5.4 Comparing PLC data types
You have the following options for comparing PLC data types:

● Online/offline comparison (S7-1200/1500 only)
The PLC data types in the project are compared with the PLC data types of the selected 
device.

● Automatic offline/offline comparison in the compare editor
The PLC data types of the selected devices are compared offline. 

● Manual offline/offline comparison in the compare editor
The selected PLC data types of the devices are compared offline.

● Detailed comparison
Use the detailed comparison to determine differences between PLC data types.

Performing online/offline comparison of PLC data types
To perform an online/offline comparison, follow these steps:

1. In the project tree, select a device that allows online/offline comparison.

2. Select the "Compare > Offline/online" command in the shortcut menu.
If you have not already established an online connection to this device, the "Go online" 
dialog opens. In this case, set all the necessary parameters for the connection and click 
"Connect". 
The online connection is established and the compare editor opens.

3. Open the "PLC data types" folder.
You can identify the status based on the symbols in the status and action area. When you 
select an object, the properties of the PLC data type and the corresponding PLC data type 
of the assigned device are displayed in the properties comparison.
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Performing automatic offline/offline comparison in the compare editor
To perform an automatic offline/offline comparison of PLC tag tables, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. Open the "PLC data types" folder.
You can identify the status of the PLC tag tables based on the symbols in the status and 
action area. You can define certain actions depending on the status. 

You can drag any other device to the drop area at any time to perform further comparisons.

Performing manual offline/offline comparison in the compare editor
To perform a manual offline/offline comparison of PLC data types, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. In the status and action area, click on the button for switching between automatic and 
manual comparison.

5. Select the PLC data types that you want to compare. 
The properties comparison is displayed. You can identify the status based on the symbols.

You can drag any other device to the drop area at any time to perform further comparisons.

Running a detailed comparison
To start a detailed comparison for a PLC data type, follow these steps:

1. Perform an offline/offline or an online/offline comparison (S7-1200/1500 only). 

2. For an automatic offline/offline comparison in the compare editor, select the PLC data type 
for which you want to run a detailed comparison. Note that two PLC data types must be 
selected for comparison with a manual offline/offline comparison.

3. Click the "Start detailed comparison" button in the toolbar.
The two PLC data types are opened next to each other so that you can easily identify the 
differences. 

See also
Introduction to comparing PLC programs (Page 1423)

Using the comparison editor  (Page 288)

Comparing PLC tags (Page 1435)
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9.1.6 Compiling and downloading blocks

9.1.6.1 Compiling blocks

Basic information on compiling blocks

Introduction
A user program must first be compiled before the CPU can execute it. You need to recompile 
your program each time you make a change.

The following procedures take place during compilation:

● The user program is checked for syntax errors.

● Unneeded instructions are removed from the user program.

● All the block calls within the compiled blocks are checked. In case of changes to the 
interface of called blocks, errors will be shown in the "Compilation" tab of the information 
window. You have to correct these errors first.

● Finally, the user program is compiled into a code that can be read by the CPU.

Compilation methods
You can start compilation in the following windows or editors:

● Compiling blocks in the project tree
Serves to compile individual blocks or the simultaneous compilation of one or several blocks 
in the "Program blocks" folder. 

● Compiling blocks in the program editor
This is intended for compilation of a single open block.

● Compiling blocks in the call or dependency structure
Used to compile individual blocks.
See also: Call structure (Page 1470), Dependency structure (Page 1476)
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Compilation options
If you are compiling blocks in project tree, you have further options:

● Software (changes only)
All program changes of the selected blocks are compiled. If you have selected a block 
folder, all program changes to the bocks contained in the folder are compiled.

● Software (compile all blocks)
All blocks are compiled. This is recommended for the first compilation and after major 
revisions. 

● Software (reset memory reserve)
All tags declared in the reserve area of the interface of selected blocks are moved to the 
standard area of the interface. Memory reserve is now available for further interface 
extensions.

 

  Note

This option is only available for CPUs of the S7-1500 and S7-1200 V4 series.
 

Consistency check 
Changing the interfaces of blocks called or PLC data types used can result in inconsistencies 
between calling blocks and called blocks or between the PLC data types and the global data 
blocks which use these PLC data types. 

To avoid such inconsistencies in the user program, the system performs an automatic 
consistency check before each compilation process.  The time stamps are compared and 
compilation is then either carried out or cancelled depending on the results of the comparison.

● The calling block can only be compiled if the time stamps of the interfaces of the called 
blocks are older than those of the calling block.

● A global data block based on a PLC data type can only be compiled correctly if the time 
stamp of the global data block is newer than the time stamp of the PLC data type used.

● The instance data block can only be compiled correctly if the interface time stamps for the 
interface of the instance data block are identical to those of the assigned function block.

If the compilation process is cancelled, a message is displayed in the inspector window. Update 
the block calls in the relevant blocks and the PLC data types in the global data blocks and then 
restart compilation. The consistency check also finds know-how protected blocks which cannot 
be compiled. The corresponding messages will also be shown in the inspector window.

If you start loading immediately instead of first compiling, the blocks selected will be 
automatically compiled and the block call and global data blocks implicitly updated. Please 
note the following differences between the CPU families:

● S7-1200/1500: All blocks affected are loaded to ensure no inconsistencies can arise.

● S7-300/400: Only the block selected is loaded.
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See also
Compiling blocks in the project tree (Page 1440)

Compiling blocks in the program editor (Page 1441)

Correcting compilation errors (Page 1442)

Block time stamps (Page 1211)

Updating block calls in LAD (Page 1279)

Updating block calls in FBD (Page 1320)

Compiling project data (Page 280)

Compiling blocks in the project tree
You can compile one block, multiple blocks or all of the blocks in the project tree.

For CPUs of the S7-1500 and S7-1200 V4 series, you can also reset the memory layout of 
blocks with memory reserve by running a compilation. For more information on memory 
reserve, refer to chapter "Loading blocks (S7-1200/1500) > Loading block changes without 
reinitialization".

Requirement
The project tree is open. 

Compiling one or more blocks in the project tree     
To compile multiple blocks in the project tree, follow these steps:

1. Open the "Program blocks" folder in project tree.

2. Select the blocks you want to compile.

3. Select the "Compile > Software (only changes)" command from the shortcut menu.

Compiling all blocks in the project tree
To compile all blocks in the "Program blocks" folder in project tree, follow these steps:

1. Select the "Program blocks" folder in the project tree.

2. You can select one of two different options for the compilation:

– If you want to compile only the changes since the last compilation, select the "Compile 
> Software (only changes)" command in the shortcut menu.

– If you want to compile all blocks completely, select the "Compile > Software (compile 
all blocks)" command in the shortcut menu.
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Resetting memory layout (S7-1500/S7-1200 V4)
Proceed as follows to reset the memory layout of blocks:

1. Select the "Program blocks" folder, or specific blocks in this folder.

2. Select the "Compile > Software (Reset memory reserve)" command from the shortcut menu.

Result
The code for the blocks will be generated if the consistency check has been successful. 
Instance data blocks generated by the system which are no longer needed will be deleted.

The message under "Info > Compilation" in the inspector window reports whether the 
compilation was successful. 

See also
Basic information on compiling blocks (Page 1438)

Compiling blocks in the program editor (Page 1441)

Correcting compilation errors (Page 1442)

Finding syntax errors in the program (Page 1376)

Compiling blocks in the program editor
 

 Note

Note that the block is recompiled even if you have not made any changes and the time stamp 
of the block is modified.

 

Requirement  
The block to be compiled is open.

Procedure
To compile a block in the program editor, follow these steps:

1. Right-click in the instruction window of the programming editor.

2. Select the "Compile" command in the shortcut menu.

Result
The code for the block is generated. Instance data blocks generated by the system which are 
no longer needed will be deleted. 

The message under "Info > Compilation" in the inspector window reports whether the 
compilation was successful. 
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See also
Basic information on compiling blocks (Page 1438)

Compiling blocks in the project tree (Page 1440)

Correcting compilation errors (Page 1442)

Correcting compilation errors
 In the Inspector window in "Info > Compile", you can see whether any compilation was 
successful or whether errors were detected in the program. If errors occur, you will need to 
correct them and then start the compilation again. 

Procedure
To correct errors following compilation, follow these steps:

1. Open the error list in the Inspector window with "Info > Compile".

2. If there is one, click on the blue question mark next to the error text for information on 
remedying errors.

3. Double-click the error you want to correct.
The corresponding error is highlighted.

4. Correct the error.

5. Restart compilation. 

See also
Basic information on compiling blocks (Page 1438)

Compiling blocks in the program editor (Page 1441)

Compiling blocks in the project tree (Page 1440)

9.1.6.2 Downloading blocks

Introduction to downloading blocks

Downloading blocks to device  
So that the CPU can execute the user program, the program must first be compiled and then 
downloaded to the device. The following options are available for downloading:

● Downloading blocks to the program editor
You can load a single open block in the program editor.

● Downloading blocks to the project tree
You can download several or all of the blocks in the block folder via the project tree.

During the loading operation, all information that is required for the reconstruction of the 
program, including symbolic information such as the names and comments for code and data 
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blocks, is also loaded in the current project language. If you change the project language, you 
must therefore re-load the program. 

The symbolic information is not loaded to the work memory, but rather to the load memory. 

After the data has been loaded from a device, the symbolic information is available again in 
your program, which increases the readability of your program code. Please note, however, 
that loading to and from a device is not a substitute for storing data in an offline project, as 
watch tables or projects' multi-language capability cannot be reproduced by loading to and 
from a device.

After loading from a device, you can only display all data from know-how-protected blocks by 
entering the correct password.

 

 Note

To avoid inconsistencies between calling and called blocks, all blocks affected are compiled 
and loaded after each global change, such as a change in the block interface.

 

 
 

 Note
S7-1200 Version 1.0

If you download an element of your project to the CPU, for example a program block, a data 
block or the hardware configuration, the CPU runs a cold restart the next time it changes to 
RUN mode. Apart from deleting the inputs, initializing the outputs and deleting the non-
retentive memory, cold restart also deletes the retentive memory areas. All subsequent 
changes from STOP to RUN are warm restarts in which the retentive memory is not deleted.

 

 Note
S7-1500

The load memory of S7-1500 series CPUs is on the SIMATIC memory card. Therefore, a 
SIMATIC memory card absolutely must be inserted in order to operate the CPU.

 

Uploading blocks from device
You can load the blocks of a device to your project. This is necessary, for example, if you want 
to edit blocks that only exist in this device. You have the option of loading either all available 
blocks (organization blocks, function blocks, functions and data blocks) and global PLC tags 
or individual blocks to the project.

Uploading blocks from or downloading blocks to a memory card
Memory cards are plug-in cards used with an S7-1200 series CPU, for example, to replace 
the load memory of a device. In the case of S7-1500 series CPUs, they contain the load 
memory. Only Siemens SD cards can be used for devices of the S7-1200 and S7-1500 product 
range.
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To use a memory card as load memory, you must download the user program or individual 
blocks to a memory card. You can just as well upload blocks from a memory card back into 
the project. 

 

 Note
S7-1200

Note the following when uploading to or downloading from a memory card:
● If the CPU contains no previous program and you insert an empty memory card in the 

CPU the program will be loaded from the PG/PC to the memory card and not to the CPU.
● If you insert an empty memory card prior to the startup of the CPU, the program that is on 

the CPU will be transferred automatically to the memory card. The program on the CPU 
will then be deleted.

● If you insert a memory card with a program in the CPU prior to the startup of the CPU and 
the CPU already contains a program, the program on the memory card will be executed 
and not the program on the CPU. The program on the CPU will be deleted.

 

Loading GRAPH function blocks
If you load a GRAPH function block together with its instance data block, the processing of the 
sequencer starts over at the initial step. As a result, problems may occur when synchronizing 
the sequencer with the process. You can avoid these problems by switching off the sequencer 
before loading.

Loading block changes without reinitialization
It often proves necessary to edit or expand a PLC program that was already commissioned 
and that is running on the plant without error. Such operations should be performed without 
causing any major interruptions of current operations.

S7-1500 therefore offers the option of extending the interfaces of function or data blocks during 
runtime and loading the modified blocks without setting the CPU to STOP or affecting the value 
of tags that are already loaded. This is a simple means of implementing program changes. 
This load process (downloading without reinitialization) will not have a negative impact on the 
controlled process.
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Effects of a load operation on the tag values of a data blocks 
When data blocks are downloaded to a device in STOP mode, the next transition of the device 
to RUN affects the current tag values as follows:

● Tags not marked as being retentive retain their defined start values.

● Retentive tags of the S7-1200 only retain their values if the following conditions are met:

– You loaded the data block by means of "Download to device > Software (changes only)". 

– You made no changes to the DB structure. 

Otherwise the retentive tags will also retain their defined start values.

● Retentive tags of the S7-1500 only retain their values if the following conditions are met: 

– You loaded the data block by means of "Download to device > Software (changes only)". 

– You made no changes to the structure of the data block or modified it within the memory 
reserve.

Otherwise the retentive tags will also retain their defined start values.

 

Downloading blocks in the "RUN" operating mode to the device

Basics on downloading blocks in the "RUN" operating mode       
When you download modified blocks to the device, it is not always necessary to switch the 
device to the "STOP" operating mode. Prior to a download operation, the Engineering System 
checks whether the device must be stopped before downloading. The result of this check is 
displayed in the "Load preview" dialog. If it is necessary to change to the "STOP" operating 
mode, you cannot continue the download process until you have set the appropriate option. 

 

 Note

Actual parameters are not overwritten by a download process in the "RUN" operating mode. 
Changes to the actual parameters will not become effective until the next time you change 
the operating mode from "STOP" to "RUN".

 

The following table shows the actions after which you can execute the download process in 
the "RUN" operating mode:

Action Download in "RUN" operating mode possible 
 S7-1200 S7-1500
Downloading individual blocks Yes Yes
Downloading all blocks No No
Adding or deleting OBs No Yes
Adding or deleting DBs, FCs or FBs Yes Yes
Changing block interfaces for FBs No Only within the 

memory reserve
Changing block interfaces for FCs Yes Yes
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Action Download in "RUN" operating mode possible 
 S7-1200 S7-1500
Changing the structure of a DB or an instance DB No Only within the 

memory reserve
Changing the hardware configuration No No
Changing the retentivity settings of bit memories and 
DBs

No No

Changing the program code of FC, FB or OB Yes Yes
Changing the attributes of OBs Yes Yes
Adding comments Yes Yes
Adding input, output or bit memory areas Yes Yes
Changing tag names Yes Yes
Maximum number of blocks that can be downloaded 
for the device used in "RUN" not exceeded

Yes Yes

See also
Downloading blocks from program editor to device (Page 1446)

Downloading blocks from the project tree to the device (Page 1447)

Downloading project data to a device (Page 282)

Downloading blocks from program editor to device

Requirement 
The block to be downloaded is open.

Procedure 
To download a block from the program editor to the device, follow these steps:

1. Right-click in the instruction window of the programming editor.

2. Select the "Download to device" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog opens. In this case, set all parameters required for the connection and 
click "Load". You can also open the "Extended download to device" dialog with the 
"Online" menu.
See also: Go online and Go offline 

– If you have already specified an online connection, then the project data is compiled if 
necessary and the "Load preview" dialog opens. This dialog displays alarms and 
proposes actions necessary for loading.
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3. Check the alarms and, where necessary, enable the actions in the "Action" column.
 

  Note
Actions

Performing the proposed actions during ongoing plant operation can cause serious 
damage to property or injury to persons if there are functional faults or program errors.

Make sure that no dangerous situations can arise before you start the actions.
 

As soon as downloading becomes possible, the "Load" button is enabled.

4. Click "Load".
The block is downloaded and the "Load results" dialog opens. This dialog shows you the 
status and the actions after downloading.

5. If you want to start the modules again directly after downloading, select the "Start all" check 
box.

6. To close the "Load results" dialog box, click "Finish".

Result
The code for the block will be downloaded to the device. If the changes affect additional blocks, 
these will be compiled and also downloaded to the device. Blocks that only exist online in the 
device are deleted. Existing CPU data blocks are retained, however. Inconsistencies between 
the blocks in the user program are avoided by loading all blocks affected and deleting the 
unneeded blocks in the device.

The messages under "Info > General" in the Inspector window show whether the downloading 
process was successful. 

See also
Downloading blocks from the project tree to the device (Page 1447)

Downloading project data to a device (Page 282)

Downloading blocks in the "RUN" operating mode to the device (Page 1445)

Downloading blocks from the project tree to the device
In the project tree you can download one block, multiple blocks or all blocks to a device.

Loading one or more blocks from the project tree to the device   
To download one block or multiple blocks to the device from the project tree, follow these steps:

1. Open the "Program blocks" folder in project tree.

2. Select the blocks you want to download.
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3. Select the "Download to device > Software (only changes)" command from the shortcut 
menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog opens. In this case, set all parameters required for the connection and 
click "Load". You can also open the "Extended download to device" dialog with the 
"Online" menu.
See also: Go online and Go offline 

– If you have already specified an online connection, then the project data is compiled if 
necessary and the "Load preview" dialog opens. This dialog displays alarms and 
proposes actions necessary for loading.

4. Check the alarms and, where necessary, enable the actions in the "Action" column.
 

  Note

Performing the proposed actions during ongoing plant operation can cause serious 
damage to property or injury to persons if there are functional faults or program errors.

Make sure that no dangerous situations can arise before you start the actions.
 

As soon as downloading becomes possible, the "Load" button is enabled.

5. Click "Load".
The block is loaded and the "Load results" dialog opens. This dialog shows you the status 
and the actions after downloading.

6. If you want to start the modules again directly after downloading, select the "Start all" check 
box.

7. To close the "Load results" dialog box, click "Finish".

Loading blocks from the project tree to the device
To download all blocks in the "Program blocks" folder to the device from the project tree, follow 
these steps:

1. Select the "Program blocks" folder in the project tree.

2. Select the "Download to device" submenu in the shortcut menu.

3. If you only want to download the changes since the last download, select the "Software 
(only changes)" option. If all blocks are to be fully loaded and all values are to be reset to 
their start values, select "Download PLC program to the device and reset".

– If you have not already established an online connection, the "Extended download to 
device" dialog opens. In this case, set all parameters required for the connection and 
click "Load". You can also open the "Extended download to device" dialog with the 
"Online" menu.
See also: Go online and Go offline 

– If you have already specified an online connection, then the project data is compiled if 
necessary and the "Load preview" dialog opens. This dialog displays alarms and 
proposes actions necessary for loading.
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4. Check the alarms and, where necessary, enable the actions in the "Action" column.
 

  Note

Performing the proposed actions during ongoing plant operation can cause serious 
damage to property or injury to persons if there are functional faults or program errors.

Make sure that no dangerous situations can arise before you start the actions.
 

As soon as downloading becomes possible, the "Load" button is enabled.

5. Click "Load".
The block is loaded and the "Load results" dialog opens. This dialog shows you the status 
and the actions after downloading.

6. If you want to start the modules again directly after downloading, select the "Start all" check 
box.

7. To close the "Load results" dialog box, click "Finish".

Result
The code for the blocks is downloaded to the device. If the changes affect additional blocks, 
these will be compiled and also downloaded to the device. Blocks that only exist online in the 
device are deleted. Inconsistencies between the blocks in the user program are avoided by 
loading all blocks affected and deleting the unneeded blocks in the device.

The messages under "Info > General" in the Inspector window show whether the downloading 
process was successful. 

See also
Downloading blocks from program editor to device (Page 1446)

Downloading project data to a device (Page 282)

Downloading blocks in the "RUN" operating mode to the device (Page 1445)

Uploading blocks from device
You can load either all blocks or individual blocks from a device into your project.

 

 Note

Note the following information:
● Please note that when you load individual blocks, no tags or other required blocks to which 

you may refer are loaded together with the individual blocks. During the loading operation, 
reference to tags and blocks are reassigned where possible based on the names. After 
the loading operation, check whether these assignments are correct.

● S7-1500: When GRAPH function blocks are loaded from a device to your project, the step-
specific alarm texts for the interlock and supervision alarms are not loaded.
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Requirement
The online and offline versions of a block to be loaded are different or the blocks only exists 
online.

Uploading all blocks from a device
To upload all blocks from a device, follow these steps:

1. Establish an online connection with the device from which you want to upload the blocks.
See also: Establishing and terminating an online connection 

2. In the project tree, select the device folder from which you want to upload blocks.

3. In the "Online" menu, select the "Upload from device" command.
The "Upload preview" dialog box opens. This dialog displays alarms and proposes actions 
necessary for loading.

4. Check the alarms and, where necessary, enable the actions in the "Action" column.
The "Upload from device" button will be enabled as soon as uploading becomes possible.

5. Click on the "Upload from device" button.
The load is executed. 

Uploading individual blocks from a device
To upload individual blocks from a device, follow these steps:

1. Establish an online connection with the device from which you want to upload the blocks.
See also: Establishing and terminating an online connection 

2. In the project tree, select the blocks that you want to upload from the device.

3. In the "Online" menu, select the "Upload from device" command.
The "Upload preview" dialog box opens. This dialog displays alarms and proposes actions 
necessary for loading.

4. Check the alarms and, where necessary, enable the actions in the "Action" column.
The "Upload from device" button will be enabled as soon as uploading becomes possible.

5. Click on the "Upload from device" button.
The load is executed. 

Result
The blocks will be uploaded from the device to the project. You can edit them as normal, 
recompile them and download them to the device again. 

Downloading blocks to a memory card

Requirement  
● The memory card is not marked as program card.

● The "Program blocks" folder of the memory card is open.
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Procedure  
To download blocks to a memory card, follow these steps:

1. Open the device "Program blocks" folder in the project tree.

2. Select the blocks you want to download to the memory card.

3. Drag the blocks in project tree to the "Program blocks" folder of the memory card.
The "Load preview" dialog opens. This dialog displays messages and proposes actions 
necessary for loading.

4. Check the messages and, where necessary, enable the actions in the "Action" column.

5. As soon as downloading becomes possible, the "Load" button is enabled.

6. Click the "Load" button.
The load is executed. The "Load results" dialog will then open. In this dialog, you can check 
whether or not loading was successful and take any further action that may be necessary.

7. Click "Finish".

Result
The block is downloaded to the memory card If the changes affect additional blocks, these will 
also be downloaded to the memory card. Blocks that exist only on the memory card are deleted. 
Inconsistencies between the blocks in the user program are avoided by downloading all 
affected blocks and the deleting of the non-required blocks on the memory card.

The messages under "Info > General" in the Inspector window show whether the downloading 
process was successful.

See also
Uploading blocks from a memory card (Page 1451)

Accessing memory cards (Page 336)

Uploading blocks from a memory card
You can only upload all blocks from one memory card back into your project. 

Requirement
The memory card is displayed.

See also: Accessing memory cards (Page 336)
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Procedure     
To upload blocks from a memory card to your project, follow these steps:

1. In the project tree, drag the folder of the memory card to the folder of the device in the 
project.
The "Upload preview" dialog box opens. This dialog displays alarms and proposes actions 
necessary for loading.

2. Check the alarms and, where necessary, enable the actions in the "Action" column.
The "Upload from device" button will be enabled as soon as uploading becomes possible.

3. Click on the "Upload from device" button.

See also
Downloading blocks to a memory card (Page 1450)

Switching off the sequencer prior to loading a GRAPH DB
You can specify the switching off of the sequencer prior to loading an instance data block either 
globally or during the load operation. 

Globally switching off the sequencer
To switch off the sequencer globally for each loading operation of an instance data block, follow 
these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "PLC programming > GRAPH" group in the area navigation.

3. Select the "Turn off sequence before downloading DB" check box.
For future loading operations, the sequencer is switched off prior to loading of the instance 
data block.

Switching off the sequencer during the loading operation
To switch off the sequencer during the loading operation, follow these steps:

1. Load the GRAPH function block to the device.
During the loading operation, the "Load preview" dialog opens. This dialog displays alarms 
and suggests the required actions for loading. If the instance data block must be loaded 
together with the GRAPH function block, the "Load preview" dialog suggests the action 
"Turn off sequence before downloading the DB".

2. Select the "Turn off sequence before downloading DB" check box.

Programming the PLC
9.1 Creating a user program

WinCC Comfort/Advanced V12.0 SP1
1452 System Manual, 07/2013,  



9.1.7 Protecting blocks

9.1.7.1 Protecting blocks

Introduction
You can use a password to protect one or more blocks of the OB, FB, FC type and global data 
blocks from unauthorized access. Note the following particularities:

● You can not manually protect instance data blocks; they depend on the know-how 
protection of the assigned FB. This means that when you create an instance data block for 
a know-how protected FB, the instance data block also receives this know-how protection. 
This is independent of whether you explicitly create the instance data block or if it is created 
by a block call. 

● You cannot provide global array data blocks with know-how protection.

If a block is know-how protected, only the following data is readable without the correct 
password:

● Interface parameters Input, Output, InOut, Return, Static

● Block title

● Block comment

● Block properties

● Global tags without information on the point of use

The following actions can be performed with a know-how protected block:

● Copying and deleting

● Calling in a program

● Online/offline comparison

● Load
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The code of the block, on the other hand, is protected from unauthorized reading and 
modification. For S7-1200/1500 CPUs, you can also set up copy protection which binds 
execution of the block to the CPU, or to the SD card with the defined serial number.

 

 Note

Note the following information:
● S7-1200 Version 1.0: If you download a know-how-protected block to a device, no restore 

information is loaded along with it. This means that you cannot open a know-how-
protected block again even with the correct password if you upload it from the device.

● Only the non-protected data is compared in offline-online comparison of know-how 
protected blocks.

● You will no longer be able to access the block if you do not have the password.
● If you add a know-how-protected block to a library, the master copy created will also be 

know-how protected. 
● For S7-1500, you can select the "Block can be used as know-how protected library item" 

check box in the block properties to obtain the information on whether or not the block 
can be used as protected library item. If the block can be used as know-how protected 
library item and you are using this block from the library, any number conflicts that may 
arise with other blocks already contained in the user program will be resolved.

● Cross references to used tags, bit memories, inputs and outputs in know-how protected 
blocks are not displayed even after the correct password is entered.. 

● If you change the name or number of a block, the loadable binary component of the device 
is out of date. This means that the block must be recompiled before loading it to a device. 
For know-how-protected blocks, this is only possible with the correct password. Keep this 
in mind particularly if you want to copy a know-how-protected block to another device in 
which there is already a block with the same name or number.

● Always pass on a project that includes know-how-protected blocks as a project archive 
or library archive. In this way, you ensure that the know-how protection cannot be 
bypassed.

 

See also
Setting up and removing block copy protection (Page 1455)

Setting up block know-how protection (Page 1456)

Opening know-how protected blocks (Page 1457)

Printing know-how protected blocks (Page 1457)

Removing block know-how protection (Page 1459)

Changing a password (Page 1459)

Archiving projects (Page 275)

Archiving global libraries (Page 355)
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9.1.7.2 Setting up and removing block copy protection
For S7-1200 /1500 CPUs, you can set up copy protection which binds execution of the block 
to a specific CPU or SD card. The block can then only be executed if it is in the device with 
the set serial number. 

It is important that you also know-how-protect any block for which you have set up copy 
protection. If you do not, anyone can reset the copy protection. You must, however, set up 
copy protection first as the copy protection settings are read-only if the block is already know-
how-protected.

 

 Note

S7-1500 and S7-1200 V2.2 and higher: If you download a copy protected block to a device 
that does not match the specified serial number, the entire download operation will be 
rejected. This means that blocks without copy protection, too, will not be downloaded.

 

Requirement
The block is not know-how protected.

Setting up copy protection
To set up copy protection for a block, follow these steps:

1. Open the block you wish to copy-protect.

2. Open the "Properties" tab in the inspector window.

3. Select "Protection" in the area navigation in the inspector window.

4. Select either "Bind to serial number of the CPU" or "Bind to serial number of the memory 
card" from the drop-down list in the "Copy protection" area.

5. Enter the serial number of the CPU or the memory card for a S7-1500 CPU. You can either 
enter the serial number directly for a S7-1200 CPU or enable the option "Serial number 
inserted when downloading to a device or memory card" if the serial number is to be inserted 
automatically during loading.

6. You can now set up the know-how protection for the block in the "Know-how protection" 
area.

Removing copy protection
To remove copy protection, follow these steps:

1. Remove the know-how protection for the block whose copy protection you wish to remove.

2. Open the block.

3. Open the "Properties" tab in the inspector window.

4. Select "Protection" in the area navigation in the inspector window.

5. Select "No binding" in the drop-down list in the "Copy protection" area.
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See also
Protecting blocks (Page 1453)

Setting up block know-how protection (Page 1456)

Opening know-how protected blocks (Page 1457)

Printing know-how protected blocks (Page 1457)

Removing block know-how protection (Page 1459)

Changing a password (Page 1459)

9.1.7.3 Setting up block know-how protection
You can set up know-how protection for blocks in the devices in your project. 

Procedure  
To set up block know-how protection, follow these steps:

1. Select the blocks with no know-how protection which you want to protect.

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click "Define".
The "Define password" dialog box opens.

4. Enter a password in the "New" field.

5. Enter the same password in the "Confirm" field.

6. Confirm your entries with "OK".

7. Close the "Know-how protection" dialog by clicking on "OK".

Result
The blocks selected will be know-how-protected. Know-how protected blocks are marked with 
a lock in the project tree. The password entered is valid for all blocks selected. 

See also
Protecting blocks (Page 1453)

Setting up and removing block copy protection (Page 1455)

Opening know-how protected blocks (Page 1457)

Printing know-how protected blocks (Page 1457)

Removing block know-how protection (Page 1459)

Changing a password (Page 1459)
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9.1.7.4 Opening know-how protected blocks
You can only open multiple know-how protected blocks at once if they are protected with the 
same password.

Procedure   
To open a know-how protected block, follow these steps:

1. Double-click on the block you wish to open.
The "Access protection" dialog will open.

2. Enter the password for the know-how protected block.

3. Confirm your entry with "OK".

Result
The know-how protected block will open provided you have entered the correct password. 
However, the block will remain know-how protected. If you copy the block or add it to a library, 
for example, the copies will also be know-how protected.

Once you have opened the block, you can edit the program code and the block interface of 
the block for as long as the block or TIA portal is open. The password must be entered again 
the next time the block is opened. If you close the "Access protection" dialog with "Cancel", 
the block will open but the block code will not be displayed and you will not be able to edit the 
block. 

See also
Protecting blocks (Page 1453)

Setting up and removing block copy protection (Page 1455)

Setting up block know-how protection (Page 1456)

Printing know-how protected blocks (Page 1457)

Removing block know-how protection (Page 1459)

Changing a password (Page 1459)

9.1.7.5 Printing know-how protected blocks
You can only print complete know-how protected blocks if they have been opened with the 
correct password. If you print a closed block or if the block was not opened with the correct 
password, only the non-protected block data will be printed.
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Procedure   
To print a know-how protected block in full, follow these steps:

1. Open the know-how protected block you wish to print.
See also: Opening know-how protected blocks (Page 1457)

2. Select the "Print" command in the "Project" menu.
The "Print" dialog will open.

3. Select the printer in the "Name" field.

4. Click "Advanced" to modify the Windows printer settings.

5. Select the documentation information set in the "Document information" drop-down list that 
you want to use for the frame layout.

6. Under "Print objects/area" select whether you want to print all objects or the complete area, 
or only a selection.

7. Under "Properties" select the print scope.

– Select "All" to print the complete block.

– Choose "Visible" to print all the information within the block that is visible on the screen.

– Select "Compact" to print a shortened form of the block.

8. Click "Preview" to generate a print preview in advance.
A print preview is created in the work area.

9. Click "Print" to start the printout.

See also
Printing project contents (Page 299)

Protecting blocks (Page 1453)

Setting up and removing block copy protection (Page 1455)

Setting up block know-how protection (Page 1456)

Removing block know-how protection (Page 1459)

Changing a password (Page 1459)
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9.1.7.6 Changing a password

Procedure   
To change the password, follow these steps:

1. Select the know-how protected blocks for which you want to change the password.
 

  Note

You can only change the password for several blocks at once if all blocks selected have 
the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click the "Change" button.

4. Enter the old password in the "Old" field.

5. Enter the new password in the "New" field.

6. Enter the new password again in the "Confirm" field.

7. Confirm your entries with "OK".

8. Close the "Know-how protection" dialog by clicking on "OK".

See also
Protecting blocks (Page 1453)

Setting up and removing block copy protection (Page 1455)

Setting up block know-how protection (Page 1456)

Opening know-how protected blocks (Page 1457)

Printing know-how protected blocks (Page 1457)

Removing block know-how protection (Page 1459)

9.1.7.7 Removing block know-how protection

Procedure  
To remove block know-how protection, follow these steps:

1. Select the blocks for which you want to remove know-how protection.
 

  Note

You can only remove know-how protection for several blocks at once if all blocks selected 
have the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.
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3. Deactivate the check box "Hide code (know-how protection)".

4. Enter the password.

5. Confirm your entries with "OK".

Result
Know-how protection will be disabled for the blocks selected. 

See also
Protecting blocks (Page 1453)

Setting up and removing block copy protection (Page 1455)

Setting up block know-how protection (Page 1456)

Opening know-how protected blocks (Page 1457)

Printing know-how protected blocks (Page 1457)

Changing a password (Page 1459)
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9.2 Displaying program information

9.2.1 Overview of available program information

Program information       
The program information of a user program contains the view specified in the following table. 

View Application
Assignment list (Page 1462) Provides an overview of the address bits for the I, 

Q, and M memory areas already allocated within 
the user program.
Also indicates if an address has been allocated by 
access from an S7 program or if the address has 
been assigned to a SIMATIC S7 module.

Call structure (Page 1470) Shows the call structure of the blocks within the 
user program and provides an overview of the 
blocks used and their relationships.

Dependency structure  (Page 1476) Shows the list of blocks used in the user program. 
A block is shown at the first level and blocks that 
call or use this block are indented below it. In 
contrast to the call structure, instance blocks are 
listed separately.

Resources (Page 1481) Shows the hardware resources of the CPU for 
objects (OB, FC, FB, DB, user-defined data types 
and PLC tags), for CPU memory areas and for the 
existing I/O modules.

Displaying several views simultaneously
You can generate and display several views for one or more user programs to facilitate testing 
and changing your user program.

Displaying multiple views, for example, enables you to:

● Display all program information for a user program next to one another

● Compare different user programs
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9.2.2 Displaying an assignment list

9.2.2.1 Introduction to the assignment list

Program information in the assignment list   
The assignment list shows if an address has been allocated by access from an S7 program 
or if the address has been assigned to a SIMATIC S7 module. It is therefore an important basis 
for locating errors or changes in the user program.

In the assignment list, you have a CPU-specific overview of which bit is used in which byte of 
the memory areas listed below:

● Input (I)

● Output (O)

● Bit memory (M)

● Timer (T)

● Counter (C)

● I/O (P)

Display of the assignment list
The assignment list of inputs, outputs, and bit memory is displayed in several separate work 
windows.

Filters
You can filter the display within the assignment list. You can use predefined filters or create 
your own. 

Displaying cross-reference information
You have the option of displaying cross-reference information for selected addresses in the 
assignment list.

You can display the cross-references for a selected address in the Inspector window using the 
"Cross-reference information" shortcut menu command. The command "Tools > Cross-
references" allows you to also open the cross-reference list for the selected object.

Displaying the PLC tag table
You can open the PLC tag table from the assignment list and edit the properties of the tags 
used. 

To do this select an address of the assignment list and select the "Open editor" command in 
the shortcut menu.
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Enabling the display of retentivity
You can enable and disable the display of the retentive state of bit memory by selecting the 
"Hide/show retain area" toolbar button. 

See also
Symbols in the assignment list (Page 1464)

Layout of the assignment list (Page 1463)

9.2.2.2 Layout of the assignment list

Layout of the assignment list      
Depending on the CPU, the assignment list is displayed in several work windows with the 
following operands.

For S7-300/400 CPUs:

● Inputs

● Outputs

● Bit memory

● Timers

● Counters

For S7-1200 CPUs:

● Inputs

● Outputs

● Bit memory

Displaying inputs, outputs, bit memory, timers and counters
It shows all operands used and their assignment in the S7 program. 

For all displayed operands, each line in the assignment list is dedicated to a byte of the memory 
area, in which the corresponding eight bits from 7 to 0 are labeled according to their access. 
In conclusion, a "bar" indicates if access is made by a byte (B), word (W) or double word (D).

You can find an explanation of the symbols in the assignment list here. (Page 1464) 

See also
Introduction to the assignment list (Page 1462)

Programming the PLC
9.2 Displaying program information

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1463



9.2.2.3 Symbols in the assignment list

Meaning of the symbols in the assignment list   
The following table shows the meaning of the symbols in the assignment list: 

Symbol Meaning
Indicates the address assignment in the selected state.
Indicates the address assignment in the non-selected state.

Indicates that a pointer start address and a tag address access the 
same address range and that they are selected.
Indicates that a pointer start address and a tag address access the 
same address range and that they are not selected.
Indicates the pointer assignment in the selected state.

Indicates the pointer assignment in the non-selected state.

Indicates that the byte is in use with byte access and the 
corresponding tag is selected. The shortcut menu allows you to 
display cross-reference information for the selected variables as 
well as the PLC tag table. 
Indicates that the byte is in use with byte access and the 
corresponding tag is not selected.
Indicates that the byte is in use with word access and the 
corresponding tag is selected. The shortcut menu allows you to 
display cross-reference information for the selected variables as 
well as the PLC tag table.
Indicates that the byte is in use with word access and the 
corresponding tag is not selected.

Indicates that the byte is in use with double word access and the 
corresponding tag is selected. The shortcut menu allows you to 
display cross-reference information for the selected variables as 
well as the PLC tag table.
Indicates that the byte is in use with double word access and the 
corresponding tag is not selected.

Background color: gray Indicates that a byte is in use with byte, word or double word access 
and that the address is also in use by the hardware. The gray 
background color indicates overlapping memory access.

Background color: yellow Indicates that the address is not in use by the hardware.
Indicates that the memory area has been defined as system 
memory.
Indicates that the memory area has been defined as clock memory.
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See also
Layout of the assignment list (Page 1463)

Introduction to the assignment list (Page 1462)

9.2.2.4 Displaying an assignment list

Requirement  
A project has been created with programmed blocks.

Procedure
Proceed as follows to display the assignment list:

1. Select the "Program blocks" folder or one or more of the blocks it contains.

2. Select the "Assignment list" command in the "Tools" menu.

Result
The assignment list for the selected program is displayed.

View options in the assignment list
Refer to view respective view options that are set to display the desired information in the 
assignment list.

 

See also
Setting the view options for the assignment list (Page 1465)

Layout of the assignment list (Page 1463)

9.2.2.5 Setting the view options for the assignment list

Introduction
The following view options are available for the assignment list:

● Used addresses:
When this check box is activated, the addresses, I/Os and pointers used in the program 
are displayed.

● Free hardware addresses:
When this check box is activated, only the free hardware addresses are displayed.

Programming the PLC
9.2 Displaying program information

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1465



Requirement   
● A project has been created with programmed blocks.

● The assignment list is open.

Procedure
Proceed as follows to set the view options for the assignment list:

1. Click on the arrow of the  symbol ("View options") in the task bar.
The view options for the assignment list are opened. Check marks are set in front of the 
activated view options.

2. If you want to activate or deactivate a view option, click on the respective check box and 
set or remove the check mark.

Result
The view options are set and the desired information is displayed in the assignment list.

 

9.2.2.6 Filter options in the assignment list

Filter settings   
You can define your own filter settings for the assignment list. The following options are 
available for defining filters:

● Display all addresses of the address areas specified.

● Display of single, defined addresses from the selected address area, for example, "0" and 
"200".

● Display of complete areas from the selected address area, for example, "0 - 256".

The following table provides an overview of all available options:

Selection in the Selection Symbol Meaning
Address area All CPU-dependent displayed 

addresses (I, O, M, T, C) can be 
activated as they are by default, or 
individual address areas can be 
activated.

Check box is activated Only the activated address 
areas (I, O, M, T, C) are shown 
in the assignment list.

Filter area Show assignment for all addresses * Displays the assignment of all 
addresses of the enabled 
address areas (I, Q, M).
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Selection in the Selection Symbol Meaning
Show assignment for selected 
addresses, for example, for the 
inputs "IB 0" and "IB 256"

0;256
Separate individual addresses 
and areas by a semicolon.

Assignments of selected 
addresses for the activated 
address areas (I) are shown.

Show assignment for selected 
areas, for example, for the inputs 
"IB 0 to IB 100" and "IB 200 to IB 
256". 

0-100;200-256
Contiguous areas should be 
connected by a hyphen.

Assignments of selected areas 
for the activated address areas 
(I) are shown.

9.2.2.7 Defining filters for assignment list

Requirement       
● A project has been created with programmed blocks.

● The assignment list is open.

Defining filter
Proceed as follows to define a filter for the assignment list:

1. Click on the  symbol ("Filter") in the task bar.
The "Assignment List Filter" dialog opens. 

2. Click on the  symbol ("Create new filter") in the task bar.
A new filter is created with the name "Filter_1". The check boxes for all addresses (inputs, 
outputs, memory bits, timers and counters) are activated by default for the filter.

3. If you want to change the name of the filter, click on the drop-down list in the task bar and 
enter a new filter name.

4. Deactivate the check boxes of addresses that are not to be affected by the filter.

5. Enter one of the following options in the filter area of the activated address:

– Show all addresses used = "*"

– Show single, defined addresses, for example, IB 0" and IB 25 = "0.25". Individual 
addresses and address areas are separated by commas or semicolons.

– Show complete address areas, for example, IB 0 to IB 256 = "0-256". Complete address 
areas should be connected by a hyphen.

6. Confirm your entries with "OK".
The newly defined filter is shown in the task bar of the assignment list under the specified 
name.
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Delete filter
Proceed as follows to delete a filter:

1. Click on the  symbol ("Filter") in the task bar.
The filter dialog for the assignment list opens. 

2. In the drop-down list of the task bar, select the filter you want to delete.

3. Click on the  symbol ("Delete selected filter") in the task bar.
The selected filter is deleted. 
 

See also
Filter options in the assignment list (Page 1466)

Displaying an assignment list (Page 1465)

Introduction to the assignment list (Page 1462)

9.2.2.8 Filtering an assignment list

Requirement
● A project has been created with programmed blocks.

● The assignment list is open.

Procedure
1. Click on the arrow on the drop-down list.

The available filter are displayed.

2. Select the desired filter.

Result
The assignment list is filtered according to the settings of the selected filter. 

 

 Note

The filter settings are saved when the project is closed.
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9.2.2.9 Defining retentive memory areas for bit memories

Introduction
In the assignment list you can define the width of the retentive memory area for bit memories. 
The content of tags which are addressed in retentive memory is retained after power off and 
at the STOP to RUN transition after power on. 

The display of retentive bit memories can be enabled and disabled in the assignment list. If 
their display is enabled, retentive bit memories are identified by an icon in the "Address" 
column. 

Requirement
The assignment list is open.

Procedure
Proceed as follows to define the width of the retentive memory area for bit memories:

1. Click "Retain" in the toolbar.
The "Retain memory" dialog will open.

2. Starting at the count of 0, define the width of the retentive memory area by entering the last 
byte of this area in the input field. Watch out for any addresses of tags already assigned to 
the retentive area.

3. Load the block to the target system. Select the "Program blocks" folder in the Project tree 
and select the "Download to device" submenu in the shortcut menu.

Result
The width of the retentive memory area is defined. If enabled in the assignment list, an icon 
will indicate the retentive state of all tags in the "Address" column. 

 

9.2.2.10 Enabling the display of retentive bit memories

Introduction      
In the assignment list you can enable and disable the display of retentive bit memories. The 
retentive bit memories are identified by means of an icon in the "Address" column if the display 
of retentivity is enabled. 

Requirement
The assignment list is open.
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Procedure
Proceed as follows to enable and disable the display of retentive bit memories:

1. Click "Display/hide retentivity" in the toolbar.

Result
The retentive tags are identified by means of an icon in the "Address" column of the bit memory 
area if the display of retentivity is enabled. The icons in the "Address" column are hidden if the 
display of retentivity is disabled. 

 

 

 

9.2.3 Displaying the call structure

9.2.3.1 Introduction to the call structure

Call structure    
The call structure describes the call hierarchy of the block within an S7 program. 

It provides an overview of:

● The blocks used

● Jumps to the places of use of the blocks

● Relationships between blocks

● Local data requirements of the blocks

● Status of the blocks

Information in the call structure
Displaying the call stucture provides you with a list of the blocks used in the user program. The 
first level of the call structure is highlighted in color and shows the blocks that are not called 
by any other block in the program. Organization blocks are always shown on the first level of 
the call structure. Functions, function blocks and data blocks are only shown on the first level 
if they are not called by an organization block. When a block calls other blocks or functions, 
they are listed indented under the calling block. Instructions and blocks are shown in the call 
structure only if they are called by a block. 
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View options
The following view options are available for the call structure:

● Show conflicts only:
When this check box is activated, only the conflicts within the call structure are displayed.

● Group multiple calls together:
When this check box is activated, several block calls are grouped together. The number of 
block calls is displayed in the "Call frequency" column. The links to the various call locations 
are offered in a drop-down list in the "Details" column.

Displaying the block calls
You can display the block calls in a block by clicking on the arrow in front of the block title. To 
display the call information of all blocks, click on the "Expand list" icon in the toolbar.

You can hide the total overview by clicking the "Collapse list" icon.

Displaying cross-reference information
You can display the cross-reference information for a block in the Inspector window by right-
clicking on the relevant block and selecting the "Cross-reference information" command from 
the shortcut menu. 

To open the "Cross-references" view, click the "Cross-references" command in the shortcut 
menu.

Displaying blocks in the program editor
You can open the program editor and edit blocks there from the call structure.

To do this select the required block in the call structure and select the "Open editor" command 
in the shortcut menu.

Displaying deleted blocks
The rows belonging to deleted blocks are identified by an icon. 

 

 Note

Please note that any existing local data can only be displayed or updated after compiling a 
block.

 

See also
Symbols in the call structure (Page 1472)
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9.2.3.2 Symbols in the call structure

Meaning of the symbols in the call structure     
The following table shows the meaning of the symbols in the call structure: 

Symbol Meaning
Indicates an organization block (OB).

Indicates a function block (FB).

Indicates a function (FC).

Indicates a data block (DB).

Indicates that the block is declared as a multiinstance.

The object has an interface dependency to an object connected to the left.

 
Indicates that the block needs to be compiled again.

Indicates that the data block needs to be compiled again.

Indicates that the object is not available.

Indicates that the interface causes a time stamp conflict.

Indicates that the variable causes a time stamp conflict.

Indicates that the block is not called directly or indirectly from an OB.

Indicates that an object has know-how protection.

Indicates that the block is normally called recursively.

Indicates that a tag declaration in the interface has a recursive dependency:
● Scenario 1: FB1 calls FB2 and this then calls FB1. The instance data blocks 

of these FBs have a recursion in the interface.
● Scenario 2: A multiple instance FB uses the instance DB of its parent FB as 

a global DB.
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9.2.3.3 Layout of the call structure

Layout of the call structure     
The view of the call structure consists of the following columns:

Column Content/meaning
Call structure Shows an overview of the blocks called 

If the viewing option "Group multiple calls together" is 
enabled, several block calls are grouped together and the 
"Number of calls" column is displayed.

Call type (!) Shows the type of call, for example recursive block call. 
Address Shows the absolute address of the block. With a function 

block, the absolute address of the corresponding instance 
data block is also shown. 

Call frequency Indicates the number of multiple calls of blocks.
Details Shows the network or interface of the calling block. All 

information are offered as a link in this column. With this link, 
you can jump to the location of the block call in the program 
editor. If the viewing option "Group multiple calls together" 
option is enabled, the calls are grouped together and are 
available as links in a drop-down list.

Local data (in path) Indicates the local data requirement of the full path.
Blocks with optimized access have higher local data 
requirements because the information for the symbolic 
addressing is stored with them.
Please note that any existing local data can only be displayed 
or updated after compiling a block.

Local data (for blocks) Show the local data requirements of the block. 
Blocks with optimized access have higher local data 
requirements because the information for the symbolic 
addressing is stored with them.
Please note that any existing local data can only be displayed 
or updated after compiling a block.

See also
Symbols in the call structure (Page 1472)

Introducing the consistency check in the call structure (Page 1475)

9.2.3.4 Displaying the call structure

Requirement   
A project has been created with blocks.
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Procedure
Proceed as follows to display the call structure:

1. Select the "Program blocks" folder or one or more of the blocks it contains.

2. Select the "Call structure" command in the "Tools" menu.

Result
The call structure for the selected program is displayed.

 

 Note

Please note that any existing local data can only be displayed or updated after compiling a 
block.

 

See also
Setting the view options for the call structure (Page 1474)

9.2.3.5 Setting the view options for the call structure

Introduction   
The following view options are available for the call structure:

● Show conflicts only:
Only the blocks causing conflicts within the call structure are displayed if this check box is 
activated. 
The following blocks cause conflicts:

– Blocks executing any calls with older or newer code time stamps.

– Blocks calling a block with modified interface.

– Blocks using a tag with modified address and/or data type.

– Block called neither directly, nor indirectly by an OB.

– Blocks calling a block which no longer exists.

● Group multiple calls together:
When this viewing option is enabled, several block calls and data block accesses are 
grouped together. The number of block calls is displayed in the "Call frequency" column. 
The links to the various call locations are offered in a drop-down list in the "Details" column.

Requirement
● A project has been created with programmed blocks.

● The call structure is open.
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Procedure
Proceed as follows to set the view options for the call structure:

1. Click on the arrow of the  symbol ("View options") in the task bar.
The view options for the call structure opens. Check marks are set in front of the activated 
view options.

2. If you want to activate or deactivate a view option, click on the respective check box and 
set or remove the check mark.

Result
The view options are set and the required information is displayed in the call structure.

9.2.3.6 Introducing the consistency check in the call structure

Consistency check
       

Changing the time stamp of a block during or after the program is generated can lead to time 
stamp conflicts, which in turn cause inconsistencies among the blocks that are calling and 
being called. 

Using the consistency check
The "Consistency check" function is used to visualize inconsistencies when time stamp 
conflicts occur. Whe the consistency check is performed, the inconsistent blocks are shown 
in the call structure and marked with the correspoinding symbols. 

● Most time stamp and interface conflicts can be rectified by recompiling the blocks.

● If compilation fails to clear up inconsistencies you can use the link in the "Details" column 
to go to the source of the problem in the program editor and manually eliminate any 
inconsistencies.

● The blocks marked in red must be recompiled.

See also
Symbols in the call structure (Page 1472)

9.2.3.7 Checking block consistency in the call structure

Requirement        
● A project has been created with programmed blocks.

● The call structure is open.
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Procedure
Proceed as follows to check the block consistency:

1. Click on the  symbol ("Consistency check") in the task bar.
The block consistency is checked. Blocks found to be inconsistent are marked accordingly 
by a symbol.

2. If a block is inconsistent, click on the arrow in front of the block title in the call structure.
The inconsistent blocks are displayed. The exact problem locations are listed as links in 
the "Details" column. 

3. Click on the respective link in the "Details" column to jump to the location in the block 
requiring correction.

4. Check and correct the inconsistencies in the blocks.

5. Recompile the blocks by selecting the required blocks and clicking on the command 
"Compile" in the shortcut menu.

6. Download the corrected blocks to the target system by clicking the command "Download 
to device" in the shortcut menu.

Result
The block consistency is checked. The inconsistencies in the blocks are corrected. The 
corrected blocks are loaded to the target system. 

See also
Symbols in the call structure (Page 1472)

9.2.4 Displaying the dependency structure

9.2.4.1 Introduction to the dependency structure

Introduction    
The dependency structure shows the dependencies each block has to other blocks in the 
program. 

Information in the dependency structure
Displaying the dependency structure provides you with a list of the blocks used in the user 
program. A block is shown at the far left and blocks that call or use this block are indented 
below it. 

The dependency structure also shows the status of the individual blocks using symbols.

Objects causing a time stamp conflict and perhaps leading to an inconsistency in the program 
are marked with various symbols.
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The dependency structure is an extension of the cross-reference list for objects.

View options
The following view options are available for the dependency structure:

● Show conflicts only:
When this check box is activated, only the conflicts within the dependency structure are 
displayed.

● Group multiple calls together:
When this check box is activated, several block calls are grouped together. The number of 
block calls is shown numerically in the "Dependency structure" column. The links to the 
various call locations are offered in a drop-down list in the "Details" column.

Displaying the dependency structure
Clicking on the arrow in front of the block title displays the blocks that call or use this block. To 
display the dependencies of all blocks, 

click the "Expand list" icon in the toolbar. 

You can hide the total overview by clicking the "Collapse list" icon.

Displaying cross-reference information
You can display the cross-reference information for a block in the Inspector window by right-
clicking on the respective block and selecting the "Display Usage" command from the shortcut 
menu. 

Displaying blocks in the program editor
You can open the program editor and edit blocks there from the dependency structure. To do 
this select the required block in the dependency structure and select the "Open editor" 
command in the shortcut menu.

9.2.4.2 Layout of the dependency structure

Layout of the dependency structure   
The view of the dependency structure consists of the following columns:

Column Content/meaning
Dependency It indicates the dependencies between each block and the 

other blocks in the program.
Call type (!) Shows the type of call, for example recursive block call. 
Address Shows the absolute address of the block. 
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Column Content/meaning
Call frequency Indicates the number of multiple calls of blocks.
Details Shows the network or interface of the called block. All 

information are offered as a link in this column. With this link, 
you can jump to the location of the block call in the program 
editor. If the viewing option "Group multiple calls together" 
option is enabled, the calls are grouped together and are 
available as links in a drop-down list.

See also
Symbols in the dependency structure (Page 1478)

9.2.4.3 Symbols in the dependency structure

Meaning of the symbols in the dependency structure     
The following table shows the meaning of the symbols in the dependency structure:

Symbol Meaning
Indicates an organization block (OB).

Indicates a function block (FB).

Indicates a function (FC).

Indicates a data block (DB).

The object has an interface dependency to an object connected to the left.

 

Indicates that the block needs to be compiled again.

Indicates that the data block needs to be compiled again.

Indicates that there is an inconsistency with this object.

Indicates that an object has know-how protection.

Indicates that a tag declaration in the interface has a recursive dependency:
● Scenario 1: FB1 calls FB2 and this then calls FB1. The instance data blocks 

of these FBs have a recursion in the interface.
● Scenario 2: A multiple instance FB uses the instance DB of its parent FB as 

a global DB.

Programming the PLC
9.2 Displaying program information

WinCC Comfort/Advanced V12.0 SP1
1478 System Manual, 07/2013,  



9.2.4.4 Displaying the dependency structure

Requirement  
A project has been created with programmed blocks.

Procedure
Proceed as follows to display the dependency structure:

1. Select the block folder or one or more of the blocks contained therein.

2. Select the "Dependency structure" command in the "Tools" menu.

Result
The dependency structure for the selected program is displayed.

See also
Setting the view options for the dependency structure (Page 1479)

9.2.4.5 Setting the view options for the dependency structure

Introduction    
The following view options are available for the dependency structure:

● Show conflicts only:
When this check box is activated, only the conflicts within the dependency structure are 
displayed.
The following blocks cause conflicts:

– Blocks executing any calls with older or newer code time stamps.

– Blocks called by a block with modified interface.

– Blocks using a tag with modified address and/or data type.

– Block called neither directly, nor indirectly by an OB.

● Group multiple calls together:
When this check box is activated, several block calls are grouped together. The number of 
block calls is shown in the relevant column. The links to the various call locations are offered 
in a drop-down list in the "Details" column.

Requirement
● A project has been created with programmed blocks.

● The dependency structure is open.
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Procedure
Proceed as follows to set the view options for the dependency structure:

1. Click on the arrow of the  symbol ("View options") in the task bar.
The view options for the dependency structure are opened. Check marks are set in front 
of the activated view options.

2. If you want to activate or deactivate a view option, click on the respective check box and 
set or remove the check mark.

Result
The view options are set and the required information is displayed in the dependency structure. 

 

9.2.4.6 Introducing the consistency check in the dependency structure

Consistency check
       

Changing the time stamp of a block during or after the program is generated can lead to time 
stamp conflicts, which in turn cause inconsistencies among the blocks that are calling and 
being called. 

Using the consistency check
The "Consistency check" function is used to visualize inconsistencies. Whe the consistency 
check is performed, the inconsistent blocks are shown in the dependency structure and marked 
with the correspoinding symbols. 

● Most time stamp and interface conflicts can be rectified by recompiling the blocks.

● If compilation fails to clear up inconsistencies you can use the link in the "Details" column 
to go to the source of the problem in the program editor and manually eliminate any 
inconsistencies.

● The blocks marked in red must be recompiled.

See also
Layout of the dependency structure (Page 1477)

Symbols in the dependency structure (Page 1478)
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9.2.4.7 Checking block consistency in the dependency structure

Requirement    
● A project has been created with programmed blocks.

● The dependency structure is open.

Procedure
Proceed as follows to check the block consistency:

1. Click on the  symbol ("Consistency check") in the task bar.
The block consistency is checked. Blocks found to be inconsistent are marked accordingly 
by a symbol.

2. If a block is inconsistent, click on the arrow in front of the block title in the dependency 
structure.
The inconsistent blocks are displayed. The exact problem locations are listed as links in 
the "Details" column.

3. Check and correct the inconsistencies in the blocks.

4. Recompile the blocks by selecting the required blocks and clicking on the command 
"Compile" in the shortcut menu.

5. Download the corrected blocks to the target system by clicking the command "Download 
to device" in the shortcut menu.

Result
The block consistency is checked. The inconsistencies in the blocks are corrected. The 
corrected blocks are loaded to the target system.

See also
Symbols in the dependency structure (Page 1478)

9.2.5 Displaying CPU resources

9.2.5.1 Introducing resources

Introduction                       
The "Resources" tab indicates the hardware resources of the configured CPU for:

● the used programming objects,

● the assignment of the different memory areas within the CPU and

● the assigned inputs and outputs of the existing input and output modules.
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Information provided in the "Resources" tab
The resources tab provides an overview of the hardware resources. The display in this tab 
depends on the CPU which you are using. The following information is displayed:

● the programming objects used in the CPU (e.g. OB, FC, FB, DB, data types and PLC tags)

● the memory areas available on the CPU (load memory, work memory - divided into code 
work memory and data work memory depending on the CPU -, retentive memory), their 
maximum size and utilization by the programming objects stated above

● the I/O of modules which can be configured for the CPU (I/O modules, digital input modules, 
digital output modules, analog input modules, and analog output modules), including the I/
O already in use.

Display of the maximum available load memory
The maximum size of available load memory can be selected from a drop-down list box in the 
"Total" row of the "Load memory" column.

Display of the maximum available work memory
The maximum size of available work memory is displayed in the "Work memory" column or in 
the "Code work memory" and "Data work memory" columns in the "Total" row.

Display of the maximum available retentive memory
The maximum size of available retentive memory can be selected from a drop-down list box 
in the "Total" row of the "Retentive memory" column.

 

 Note
Retentive memory data

All bit memories and data blocks specified as retentive will be integrated in the calculation of 
the retentive data.

 

Updating the display in the "Resources" tab
Click the "Update view" toolbar button to update the display of objects.

Benefits of the display in the "Resources" tab
The "Resources" tab of the program information dialog provides a detailed list of all objects 
and of the corresponding memory area used. 

The tab also indicates shortage of resources and helps to avoid such states. 

Blocks which are not compiled can be identified as their size is indicated by a question mark.
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See also
Layout of the "Resources" tab (Page 1483)

Displaying resources (Page 1484)

Selecting the maximum load memory available (Page 1485)

9.2.5.2 Layout of the "Resources" tab

Layout of the "Resources" tab in the program information     
The view of the "Resources" tab consists of the following columns:

Column Content/meaning
Objects The "Details" area provides an overview of the programming 

objects available in the CPU, including their memory 
assignments.

Load memory Displays the maximum load memory resources of the CPU 
as a percentage and as absolute value.
The values displayed under "Total" provide information on 
the maximum memory available in the load memory.
The values displayed under "Used" provide information on 
the memory actually used in the load memory.
If a value is displayed in red, the available memory capacity 
has been exceeded.

Work memory
or 
code and data work memory

Displays the maximum work memory resources of the CPU 
as a percentage and as absolute value.
The work memory depends on the CPU and is divided into 
"Code work memory" and "Data work memory" for a CPU 
from the S7-400 or S7-1500 series, for example.
The values displayed under "Total" provide information on 
the maximum memory available in the work memory.
The values displayed under "Used" provide information on 
the memory space actually used in the work memory.
If a value is displayed in red, the available memory capacity 
has been exceeded.

Retentive memory Displays the maximum resources for retentive memory in the 
CPU as a percentage and as absolute value.
The values displayed under "Total" provide information on 
the maximum memory available in the retentive memory.
The values displayed under "Used" provide information on 
the memory actually used in the retentive memory. 
If a value is displayed in red, the available memory capacity 
has been exceeded.
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Column Content/meaning
I/O Displays the I/Os which are available on the CPU, including 

their module-specific availability in the next columns. 
The values displayed at "Configured" provide information 
about the maximum number of I/O available.
The values displayed under "Used" provide information on 
the actually used inputs and outputs.

DI / DQ / AI / AQ Displays the number of configured and used inputs/outputs:
DI = Digital inputs
DQ = Digital outputs
AI = Analog inputs
AQ = Analog outputs
The values displayed at "Configured" provide information 
about the maximum number of I/O available.
The values displayed under "Used" provide information on 
the actually used inputs and outputs.

See also
Displaying resources (Page 1484)

Selecting the maximum load memory available (Page 1485)

Introducing resources (Page 1481)

9.2.5.3 Displaying resources

Requirement     
A project with programmed blocks has been created.

Procedure
Proceed as follows to display the resources of the respective CPU memory areas:

1. Select the block folder below the relevant CPU, or one or several of the blocks contained 
therein.

2. Select the "Resources" command in the "Tools" menu.

Result
The memory resources of the assigned CPU are displayed.
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9.2.5.4 Selecting the maximum load memory available

Requirement         
A project with programmed blocks has been created.

Procedure
Proceed as follows to display the available maximum of load memory resources:

1. Select the block folder below the relevant CPU, or one or several of the blocks contained 
therein.

2. Select the "Resources" command in the "Tools" menu.

3. In the dialog that is displayed, open the drop-down list in the "Total" field of the "Load 
memory" column by clicking the icon.

4. Select a corresponding value for the CPU used by clicking it in the drop-down list box.

Result
The "Total" field displays the selected maximum memory resources.

 

 Note
Display of maximum memory resources

If a value is displayed in red for the maximum memory resources, the available memory 
capacity has been exceeded.

In this case, adapt the memory capacity as described above.
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9.3 Displaying cross-references

9.3.1 General information about cross references

Introduction   
The cross-reference list provides an overview of the use of operands and tags within the user 
program.

Uses of cross-references
The cross-reference list offers you the following advantages:

● When creating and changing a program, you retain an overview of the operands, tags and 
block calls you have used.

● From the cross-references, you can jump directly to the point of use of operands and tags.

● During a program test or when troubleshooting, you are informed of the following:

– which operand is processed by which command in which block,

– which tag is used in which picture,

– which block is called by which other block.

● As part of the project documentation, the cross-references provide a comprehensive 
overview of all operands, memory areas, blocks, tags and pictures used.

See also
Structure of the cross-reference list (Page 1486)

Displaying the cross-reference list (Page 1488)

Displaying cross-references in the Inspector window (Page 1489)

9.3.2 Structure of the cross-reference list

Views of the cross-reference list        
There are two views of the cross-reference list. The difference between the two views is in the 
objects displayed in the first column:

● Used by:
Display of the referenced objects. Here, you can see where the object is used.

● Used:
Display of the referencing objects. Here, you can see the users of the object.

The assigned tool tips provide additional information about each object.
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Structure of the cross-reference list
The cross-reference list has the following structure:

Column Content/meaning
Object Name of the object that uses the lower-level objects or that is being 

used by the lower-level objects.
Number Number of uses
Point of use Each point of use, for example, network
Property Special properties of referenced objects, for example, the tag names 

in multi-instance declarations.
as Shows additional information about the object, e.g., that an instance 

DB is used as template or as multiple instance.
Access Type of access, whether access to the operand is read access (R) and/

or write access (W).
Address Address of the operand
Type Information on the type and language used to create the object 
Path Path of object in project tree

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references. 

Settings in the cross-reference list
You can make the following settings using the buttons in the toolbar of the cross-reference list:

● Update cross-reference list
Updates the current cross-reference list.

● Making settings for the cross-reference list
Here, you select check boxes to specify whether all used, all unused, all defined or all 
undefined objects will be displayed. If the "Undefined objects" option is enabled, references 
to previously deleted objects are also displayed.

● Collapse entries
Reduces the entries in the current cross-reference list by closing the lower-level objects.

● Expand entries
Expands the entries in the current cross-reference list by opening the low-level objects.

Sorting in the cross-reference list
You can sort the entries in the "Object" column, including other product-specific columns, in 
ascending or descending order. To do this, click on the relevant column title.

See also
General information about cross references (Page 1486)

Displaying the cross-reference list (Page 1488)
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9.3.3 Displaying the cross-reference list

Prerequisites
You have created a project.

Introduction
There are several ways of displaying cross-references depending on whether you are in the 
Portal view or in the Project view and which object you have selected in the project tree. 

In the Portal view, you can only display cross-references for the entire CPU; in the Project 
view, you can, for example, display cross-references for the following objects:

● "PLC tags" folder

● "PLC data types" folder

● "Program blocks" folder

● "Tags and connections" folder

● Individual tags

● Individual PLC data types

● Individual blocks

● Technological objects

Displaying cross-references      
Proceed as follows to display cross-references:

1. Select the required action in the Portal view, for example "PLC programming" and the "Show 
cross-references" command or select one of the objects listed above in the Project view 
and select the "Cross-references" command in the "Tools" menu.

2. Click the "Used by" button to display where the objects shown in the cross-reference list 
are used.

3. Click the "Uses" button to view the users of the objects displayed in the cross-reference list.

4. You can perform the following actions using the buttons in the toolbar:

– Update cross-reference list

– Making settings for the cross-reference list

– Collapse entries

– Expand entries

5. You can sort the entries in the "Object" and "Address" columns in ascending or descending 
order by clicking on the relevant column title.

6. To go to the point of use of the object, click on the displayed link.
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See also
General information about cross references (Page 1486)

Structure of the cross-reference list (Page 1486)

9.3.4 Displaying cross-references in the Inspector window

Introduction
The Inspector window displays cross-reference information about an object you have selected 
in the "Info > Cross-references" tab. This tab displays the instances where a selected object 
is being used and the other objects using it. 

The Inspector window also includes blocks which are only available online in the cross-
references.

You can use the "Show overlapping access..." shortcut menu command to also have 
overlapping access across block borders displayed for selected objects.

Structure
The Inspector window displays the cross-reference information in tabular format. Each column 
contains specific and detailed information on the selected object and its application. The table 
below shows the additional information listed in the "Info > Cross-reference" tab:

Column Meaning
Object Name of the object that uses the lower-level 

objects or that is being used by the lower-level 
objects.

Number Number of uses
Point of use Each location of use, for example, network
Property Special properties of referenced objects, for 

example, the tag name in multi-instance 
declarations

as Shows additional information about the object, 
e.g., that an instance DB is used as template or as 
multiple instance.

Access Access mode
Shows whether the operand is accessed by a read 
(R) and/or write (W) operation.

Address Address of the operand
Monitor value This column will only be displayed when the 

program editor is open. 
Type Information about the type and language used to 

create the object
Path Path of object in project tree
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Depending on the installed products, additional columns or different columns are displayed for 
the cross-references.
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9.4 Testing the user program

9.4.1 Basics of testing the user program

Functions  
You have the option of testing the running of your user program on the device. You can then 
monitor signal states and values of tags and can assign values to tags to simulate certain 
situations in the running of the program.

Requirement
There must be an executable program loaded on the device.

Test options
The following test options are available:

● Testing with program status
The program status allows you to monitor the running of the program. You can display the 
values of operands and the results of logic operations (RLO) allowing you to recognize and 
fix logical errors in your program.

● Testing in single step mode (S7-300/400 only)
You can test blocks you created in STL or SCL in the single step mode. You do this by 
setting breakpoints in the program code at which program execution stops. You can then 
continue to run the program one step at a time. Within a CPU, you can test either with 
program status or in single step mode. You cannot, however, use both test options at the 
same time within a CPU.

● Testing with the watch table
With the watch table, you can monitor and modify the current values of individual tags in 
the user program or on a CPU. You can assign values to individual tags for testing and run 
the program in a variety of different situations. You can also assign fixed values to the I/O 
outputs of a CPU in STOP mode, for example to check the wiring. 

● Testing with the force table
With the force table, you can monitor and force the current values of individual tags in the 
user program or on a CPU. When you force, you overwrite individual tags with specified 
values. This allows you to test your user program and run through various situations.
When forcing, make sure that you keep to the necessary safety measures for forcing 
(Page 1540)! 

See also
Introduction to testing with program status (Page 1492)

Introduction to testing with the watch table (Page 1499)

Introduction for testing with the force table (Page 1524)
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9.4.2 Testing with program status

9.4.2.1 Introduction to testing with program status

Program Status function
If you display the program status, you can monitor the execution of the program. This provides 
you with an overview of the values of the individual operands and the results of the logic 
operations and you can check whether the components of the automation system are correctly 
controlled. 

The display of the program execution in the program status can differ slightly, depending on 
the CPU family used. 

Testing with program status for S7-300/400
During testing with program status, the CPU cycle time can become extended in test mode 
because the recording of all test data can deviate from the duration of the programmed 
instructions due to the CPU capacity and therefore not run in realtime.

During the execution of the following test functions an alarm indicating the danger of a time-
out is displayed once for each online session. 

● During testing with call conditions

● During testing with breakpoints

You can only perform these test functions after you have acknowledged the alarm.
 

 Note

With older CPUs from the S7-300/400 CPU family, you will need to change the operating 
response using the hardware configuration and then download the hardware configuration 
to the device. You have the option to set the "Process operation" or "Test operation" operating 
response.

 

Restrictions with the "Program status" function
The monitoring of loops can increase the cycle time significantly, depending in each case on 
the number of tags to be monitored and on the actual number of loops processed.

To ensure that the cycle time is influenced as little as possible, the "Program status" function 
is restricted as follows:
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● The status display of a programmed loop is stopped at the return point.
 

 WARNING

Testing with program status

A test with the "Program status" function can cause serious damage to property or injury to 
persons if there are functional disturbances or program errors.

Make sure that no dangerous situations can arise before you conduct a test with the "Program 
status" function.

 

9.4.2.2 Switching test with program status on/off
You can activate the program status for all programming languages. For the graphic 
programming languages LAD and FBD, you can also enable the program status at a specific 
position or for a specific selection.

Requirement
● The identical block exists in the device.

● The block is open.

Switching the program status on or off   
To switch the program status for a block on or off, follow these steps:

1. Click the "Monitoring on/off" button in the toolbar.
If you have not already established an online connection, the "Go online" dialog opens. In 
this dialog, you can establish an online connection.
See also: Establishing and terminating an online connection

Enabling program status starting at a specific point in a network
To start the program status for LAD and FBD at a specific point, follow these steps:

1. Click the "Monitoring on/off" button in the toolbar.

2. Right-click on the tag you want program status to start from.

3. Select "Modify > "Monitor from here" in the shortcut menu.

Enabling program status for selected tags
To start the program status for LAD and FBD for selected tags, follow these steps:

1. Click the "Monitoring on/off" button in the toolbar.

2. Select the tags for which you want to start the program status.

3. Select "Modify > Monitor selection" in the shortcut menu.
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 Note

The resources for testing with program status are limited. If there are not enough resources 
for the current test, earlier tests will be terminated.

 

Result
If you enable the display of the program status, an online connection is established and the 
program status is displayed. When you turn off the display of the program status, you can 
terminate the online connection at the same time.

If the CPU is in "HOLD" or "STOP" mode, the call hierarchy of the block is displayed in the 
"Call hierarchy" pane on the "Testing" task card. With S7-1200 CPUs, the call hierarchy is also 
displayed during the test with program status. Using this call hierarchy, you can change to one 
of the calling blocks. 

9.4.2.3 Editing blocks during the program test
If you edit blocks while the test with program status is still running, online monitoring will be 
interrupted and you will be able to edit the block offline. If the block is not available offline in 
the project, you will first have to load it from the device to the project. After editing the block, 
you will also have to compile and download it again.

Procedure
To edit blocks while the test with program status is still running, follow these steps:

1. Edit the block as necessary.
The test with program status is interrupted and the block is switched offline assuming it 
exists offline.

2. If the block does not exist offline, load it to the project from the device.

3. Compile the block.
See also: Auto-Hotspot

4. Download the block to the device.
See also: Auto-Hotspot

Result
The block now contains your modifications both online and offline. The online connection is re-
established and testing with program status continues.
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9.4.2.4 Modifying tags in the program status
While testing with the program status, you have the option of modifying tags to the following 
values once and immediately:

● Modify to 1
Modifies tags of the "Bool" data type to the value "True".

● Modify to 0
Modifies tags of the "Bool" data type to the value "False"

● Modify operand
You can enter a modify value for tags that do not belong to the "Bool" data type.

Note that you cannot modify peripheral inputs, for example, via TagName:P.

Procedure  
To modify tags during testing with the program status, proceed as follows:

1. Right-click on the tag you want to modify.

2. Select one of the following commands in the shortcut menu:

– "Modify > Modify to 1"

– "Modify > Modify to 0"

– "Modify > Modify operand"

3. If you select "Modify operand", the "Modify operand" dialog opens. Enter the value you 
require in the "Modify value" box and confirm with "OK".

9.4.2.5 Switching display formats in the program status

Introduction
The display formats for tags are generally displayed in "integer" form. In the program status, 
you have the option of switching the current display format by means of the shortcut menu. 
The possible display formats for a tag are offered in a list. This is useful, for example, when 
you need a hexadecimal display in order to search for a hexadecimal error code.

 

Procedure
To switch the display format, follow these steps:

1. Open the desired block in the programming editor.

2. Switch on the program status by clicking "Monitoring on/off" in the toolbar.
If you have not already established an online connection, the "Go online" dialog opens. In 
this dialog, you can establish an online connection.

3. Select the tags for which you want to start the program status.

Programming the PLC
9.4 Testing the user program

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1495



4. Select "Modify > Monitor selection" in the shortcut menu to start monitoring this tag.

5. Select the desired tag at the corresponding block output and then select the desired display 
format in the shortcut menu, for example, "Modify > Display format > Hexadecimal".

Result
The display format for the selected tag is shown in hexadecimal form. 

 

 Note
Switching the display format in the program status

Please note that it is not possible to switch the display format for unconnected outputs, as 
no monitoring value is output in this case.

 

 

9.4.2.6 Examples of program status display

Program status display for LAD programs

Displays in program status 
The display of the program status is updated cyclically. 

The following figure shows an example of the program status display for LAD:

Representation of the program status
You can recognize the status of individual instructions and lines of a network quickly based 
on the color and type of lines and symbols. The following table shows the relationship between 
representation and status:

Representation Status
Green solid Satisfied
Blue dashed Not satisfied
Gray solid Unknown or not executed
Black Not interconnected
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Representation Status
Parameter in a frame with a saturation of 100 % Value is current
Parameter in a frame with a saturation of 50 % Value originates from an earlier cycle. The point 

in the program was not executed in the current 
cycle.

Program status display for FBD programs

Displays in program status     
The display of the program status is updated cyclically. 

The following figure shows an example of the program status display for FBD:

Representation of the program status
You can recognize the status of individual instructions and lines of a network quickly based 
on the color and type of lines and symbols. The following table shows the relationship between 
representation and status:

Representation Status
Green solid Satisfied
Blue dashed Not satisfied
Gray solid Unknown or not executed
Black Not interconnected
Parameter in a frame with a saturation of 100 % Value is current
Parameter in a frame with a saturation of 50 % Value originates from an earlier cycle. The point 

in the program was not executed in the current 
cycle.

The values of the operands are displayed above the relevant operand name in a gray box. 
 

 Note
Program status display for outputs which are not interconnected

Please note that a monitor value cannot be displayed for outputs which are not interconnected.
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Program status display for SCL programs

Displays in program status   
The display of the program status is updated cyclically and shown in a table. The table is 
displayed immediately beside the SCL program and you can see the program status for each 
line of the program. The table contains the following information:

● Tag names

● Value

You can move the table to the left or right at any time.

The following figure shows an example of the program status display for SCL: 

In the first column, you can see the name of the tag for which the current value is being 
displayed. If the line includes the "IF", "WHILE" or "REPEAT" instruction, the result of the 
instruction is displayed in the line as "True" or "False". If the line contains more than one tag, 
the value of the first tag is displayed. In both cases, all tags of these lines are displayed with 
their values in a separate list as soon as you select a line. If you place the cursor in a tag in 
the program code, this is shown in bold face in the list. You can also display the other tags of 
a line explicitly by clicking the arrow right located in front of lines containing more than one tag.

If the code of the line is not executed, the tag name is displayed in the values table in gray 
text. 

The current values of the tags are displayed in the last column. If no values can be displayed 
for a tag, the line has a yellow background and three question marks are shown. In this case, 
select the "Create extended status information" check box in the properties of the block and 
download the block to the device again. All values are then displayed. 
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9.4.3 Testing with the watch table

9.4.3.1 Introduction to testing with the watch table

Overview     
The following functions are available in the watch table:

● Monitoring tags
This displays the current values of the individual tags of a user program or a CPU on the 
programming device or PC.

● Modifying tags
You can use this function to assign specific values to the individual tags of a user program 
or CPU. Modifying is also possible with Test with program status .

● "Enable peripheral outputs" and "Modify now"
These two functions enable you to assign specific values to individual peripheral outputs 
of a CPU in STOP mode. You can also use them to check your wiring.

Monitoring and modifying tags
The following tags can be monitored and modified:

● Inputs, outputs, and bit memory

● Contents of data blocks

● I/O

Possible applications
The advantage of the watch table is that a variety of test environments can be stored. This 
enables you to reproduce tests during commissioning or for service and maintenance 
purposes. 

See also
Creating and editing watch tables (Page 1503)

Layout of the watch table (Page 1500)

Basic mode and expanded mode in the watch table (Page 1501)

Icons in the watch table (Page 1502)
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9.4.3.2 Layout of the watch table

Introduction
A watch table contains the tags you defined for the entire CPU. A "Watch and force tables" 
folder is automatically generated for each CPU created in the project. You create a new watch 
table in this folder by selecting the "Add new Watch table" command.

Layout of the watch table         
The columns displayed in the watch table depend on the mode you are working in: basic mode 
or expanded mode. 

The following additional columns are shown in expanded mode:

● Monitor with trigger

● Modify with trigger

The names of the columns can also be changed dynamically based on the action.

Meaning of the columns 
The following table shows the meaning of the individual columns in basic mode and expanded 
mode:

Mode Column Meaning
Basic mode Identifier column

Name Name of the inserted tag
Address Address of the inserted tag
Display format Selected display format
Monitor value Values of the tags, depending on the selected display 

format.
Modify value Value with which the tag is modified.

Select the tag to be modified by clicking the corresponding 
check box.

Comment Comment for documentation of the tags
The following additional 
columns are shown in 
expanded mode:

Monitor with trigger Display of selected monitoring mode
Modify with trigger Display of selected modify mode

See also
Icons in the watch table (Page 1502)
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9.4.3.3 Basic mode and expanded mode in the watch table

Difference between basic mode and expanded mode in the watch table   
Depending on the mode specified, the watch table displays different columns and column 
headings that can be used to perform different actions.

You will find a detailed list of the columns in Layout of the watch table (Page 1500).

Switching between basic mode and expanded mode
You have the following options of toggling between the basic and expanded mode:

● Click the icon "Show/hide advanced setting columns". Click this icon again to return to the 
basic mode.
Or:

● Activate the check box for the "Expanded Mode" command in the "Online" menu. Deactivate 
this check box to return to the basic mode.

Functionality in expanded mode
The following functionality is only possible in expanded mode:

● Monitor with trigger

● Modify with trigger

● Enable peripheral outputs

● Monitoring peripheral inputs

● Controlling peripheral outputs
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs and controlling peripheral outputs

Note that the monitoring of peripheral inputs and the controlling of peripheral outputs in the 
watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

See also
Setting the monitoring and modify mode (Page 1513)
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9.4.3.4 Icons in the watch table

Meaning of the icons   
The following table shows the meaning of the icons in the watch table:

Icon Meaning
Identifies a table inside the project tree as a watch table. 

Shows information in the identifier column.

Modifies the addresses of all selected tags immediately and once. This 
command is executed once and as quickly as possible without reference 
to a defined trigger point in the user program.
Modifies the addresses of all selected tags with reference to a defined 
trigger point in the user program.
Disables the command output disable of the peripheral outputs. You can 
then modify the peripheral outputs when the CPU is in STOP mode.
Displays all columns of expanded mode. If you click this icon again, the 
columns of expanded mode will be hidden.
Displays all modify columns. If you click this icon again, the modify columns 
will be hidden. 
Starts monitoring of the visible tags in the active watch table. The default 
setting for the monitoring mode in basic mode is "permanent". In expanded 
mode, you can set defined trigger points for the monitoring of tags. 
Starts monitoring of the visible tags in the active watch table. This command 
is executed immediately and the tags are monitored once.
Displays the check box for the selection of tags to be modified.

Indicates that the value of the selected tag has been modified to "1". 

Indicates that the value of the selected tag has been modified to "0". 

Indicates that the address is being used multiple times.

Indicates that the substitute value is being used. Substitute values are 
values that are output to the process in case of signal output module faults 
or are used instead of a process value in the user program in case of signal 
input module faults. The substitute values can be assigned by the user 
(e.g., retain old value).
Indicates that the address is blocked because it is already being modified.

Indicates that the address cannot be modified.

Indicates that the address cannot be monitored.

Indicates that an address is being forced.

Indicates that an address is being partly forced.

Indicates that an associated I/O address is being fully or partly forced.
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Icon Meaning
Indicates that an address cannot be fully forced. Example: It is indeed 
possible to force the address QW0:P, but it is not possible to force the 
address QD0:P since this address area is eventually not available on the 
CPU.
Indicates that a syntax error occurred.

Indicates that the address is selected but at the moment e.g. has not yet 
been modified.

See also
Layout of the watch table (Page 1500)

9.4.3.5 Creating and editing watch tables

Creating a watch table

Introduction
The watch table allows you to monitor and modify tags in the user program. Once you have 
created a watch table, you can save it, duplicate it, and print it and use it again and again to 
monitor and modify tags.

Requirement   
A project is open.

Procedure
To create a watch table, follow these steps:

1. Click "Project view" in the status bar.
The project view is displayed.

2. In the project tree, double-click the CPU for which you want to create a watch table.

3. Double-click the "Watch and force tables" folder and then the "Add new watch table" 
command.
A new watch table is added.

4. In the "Name" column or in the "Address" column, enter the name or the absolute address 
for the tags that you want to monitor or modify.

5. You can select a display format from the drop-down list in the "Display format" column if 
you want to change this default setting.

6. Now decide whether you want to monitor or modify the entered tags and, if applicable, enter 
the desired values for modifying.
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Opening a watch table

Requirement  
A watch table has been created.

Procedure
To open a watch table, follow these steps:

1. Open the "Watch and force tables" folder below the desired CPU.

2. Double-click on the required watch table in the folder.

Result
The selected watch table opens.

Copying and pasting a watch table

Requirement  
A watch table has been created.

Procedure
To copy a watch table, follow these steps:

1. Right-click the watch table that you want to copy.

2. In the context menu, select "Copy".

3. In the project tree, open the folder structure for the CPU in which you want to paste the 
copied watch table.

4. Right-click on the "Watch and force tables" folder.

5. In the context menu, select "Paste".

6. Alternatively, you can select the entire contents of the watch table and Drag & Drop  it onto 
another watch table.

Result
A copy of the selected watch table is placed in the "Watch and force tables" folder of the 
relevant CPU. 

Programming the PLC
9.4 Testing the user program

WinCC Comfort/Advanced V12.0 SP1
1504 System Manual, 07/2013,  



Saving a watch table

Prerequisite  
A watch table has been created.

Procedure
To save a watch table, follow these steps:

1. In the project tree select the watch table you want to save.

2. If you wish to change the preset name of the table, select the "Rename" command in the 
context menu and enter a new name for the table.

3. In the "Project" menu, select "Save". Note that this save operation will save the entire project.

Result
The contents of the watch table and the project are saved.

 

 Note

You can reuse saved watch tables to monitor and modify tags when retesting your program. 
 

9.4.3.6 Entering tags in the watch table

Basic information on entering tags in the watch table

Recommended procedure   
● Select the tags whose values you want to monitor or modify, and enter them in the watch 

table.

● When entering tags into the watch table, please note that these tags must be previously 
defined in the PLC tag table.

● When entering tags, work from the outside to the inside. This means that you start by 
entering the tags for the inputs in the watch table. Then, you enter the tags that are affected 
by the inputs or that affect the outputs. Finally, you enter the tags for the outputs.

Example of filling out a watch table
● Enter the absolute address to be monitored or modified in the "Address" column.

● Enter the symbolic name for the tag in the "Name" column.
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● Select the display format you require from the drop-down list in the "Display format" column, 
if you do not want to use the default setting.

● Now decide whether you want to monitor or modify the entered tags. Enter the desired 
values for modifying as well as a comment in the corresponding columns of the watch table.

Syntax check
When you enter the tags in the watch table, the syntax of each cell is checked when you exit 
the cell. Incorrect entries are marked in red.

 

 Note

When you place the mouse pointer in a cell marked in red, brief information is displayed with 
additional notes on the error. 

 

See also
Permitted operands for the watch table (Page 1506)

Permissible modify values for the watch table (Page 1507)

Permitted operands for the watch table

Permissible operands for the watch table     
The following table shows the operands that are permitted for the watch table:

Permitted operand Example of data 
type

Example (International 
mnemonics)

Input/output/bit memory BOOL I1.0, Q1.7, M10.1
I0.0:P; Q0.0:P

Input/output/bit memory BYTE IB1/QB10/MB100
IB1:P; QB1:P

Input/output/bit memory WORD IW1; QW10; MW100
IW2:P; QW3:P

Input/output/bit memory DWORD ID4; QD10; MD100
ID2:P; QD1:P

Timers TIMER T1
Counters COUNTER C1
Data block BOOL DB1.DBX1.0
Data block BYTE DB1.DBB1
Data block WORD DB1.DBW1
Data block DWORD DB1.DBD1
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 Note
Please observe the following notes to work with the watch table.
● You cannot enter "DB0..." because it is used by the system!
● Peripheral outputs can be modified but not monitored.
● Peripheral inputs can be monitored but not modified.

 

 
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs and controlling peripheral outputs

Note that the monitoring of peripheral inputs and the controlling of peripheral outputs in the 
watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

See also
Basic information on entering tags in the watch table (Page 1505)

Permissible modify values for the watch table

Entry of modify values in the watch table    
The following table shows the operands that are permitted for the entry of modify values in the 
watch table:

Table 9-14 Bit operands

Possible bit operands Example for permitted modify values
I1.0 True
M1.7 False
Q1.0 0
Q1.1:P 1
DB1.DBX1.1 2#0
M1.6 2#1

Table 9-15 Byte operands

Possible byte operands Example for permitted modify values
IB1 2#00110011
MB12 B#16#1F
QB10 1F
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Possible byte operands Example for permitted modify values
QB11:P 'a'
DB1.DBB1 10

Table 9-16 Word operands

Possible word operands Example for permitted modify values
IW1 2#0011001100110011
MW12 W#16#ABCD
MW14 ABCD
QW10 B#(12, 34)
QW12:P 12345
DB1.DBW1 'ab'
MW16 S5T#9s_340ms
MW18 C#123
MW9 D#2006-12-31

Table 9-17 Double word operands

Possible double word operands Example for permitted modify values
ID1 2#00110011001100110011001100110011
QD10 Dw#16#abcdef10
QD12:P ABCDEF10
DB1.DBD2 b#(12,34,56,78)
MD8 L#-12
MD12 L#12
MD16 123456789
MD20 123456789
MD24 T#12s345ms
MD28 Tod#1:2:34.567
MD32 P#e0.0

Table 9-18 Timers

Possible operands of the 
"Timer" type

Permitted modify/force 
values

Explanation

T1 0 ms Time value in milliseconds (ms)
T12 20 ms Time value in milliseconds (ms)
T14 12345 ms Time value in milliseconds (ms)
T16 S5t#12s340ms Time value 12s 340 ms
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Table 9-19 Counters

Possible operands of the "Counter" type Permitted modify/force values
C1 0
C14 20
C16 C#123

Notes on timers and counters
● Timers 

 

  Note

Modifying a timer influences only the value, not the status. Timer T1 can be modified to 
the value "0", but the result of logic operation for A T1 is not changed.

The time sequences "s5t" and "s5time" can be written in both lower-case and upper-case 
characters.

 

● Counter
 

  Note

Modifying a counter influences only the value, not the status. Counter C1 can be changed 
to the value "0", but the result of the logic operation for A C1 is not changed.

 

Overview of the display formats

Display formats in the watch table     
The display format you select specifies the representation of a tag value. 

When entering the address a display format is automatically preset. If you want to change this, 
you can select a display format from the drop-down list in the "Display formats" column. The 
drop-down list only offers the display formats which are valid for this data type. The display 
format that appears first in the list is the pre-selected format.

Example
The following table shows the 32-bit data types permitted for all CPU families in the watch 
table and their possible display formats:

Data type Possible display formats
BOOL Bool, Hex, BCD, Octal, Bin, Dec, Dec+/-
BYTE Hex, BCD, Octal, Bin, Dec, Dec+/-, Character
WORD Hex, BCD, Octal, Bin, Dec, Dec+/-, Dec_Sequence, Character, 

Unicode_Character, SIMATIC_Timer, Date, Counter
DWORD Hex, BCD, Octal, Bin, Dec, Dec+/-, Dec_Sequence, Character, 

Unicode_Character, Floating-point number, Time of day, Timer, Pointer
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Data type Possible display formats
SINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character
INT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, SIMATIC_Timer, Counter, Date
DINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Floating-point number, Time of day, Timer, Pointer
USINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character
UINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, SIMATIC_Timer, Counter, Date
UDINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Floating-point number, Time of day, Timer, Pointer
REAL Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec, Dec+/-, Dec_Sequence, Time of day, Timer, Pointer
DATE Date, Dec, Hex, BCD, Bin
TIME_OF_DAY Time of day, Dec, Hex, BCD, Bin
TIME Timer, Hex, BCD, Bin
DATE_AND_TIME Date and time,
TIMER SIMATIC_Timer, Hex, BCD, Bin
CHAR Character, Hex, BCD, Octal, Bin, Dec, Dec+/- 
STRING Character string
POINTER Pointer, Hex, BCD, Octal, Bin, Character, Unicode_Character, Dec, Dec+/-, 

Dec_Sequence, Floating-point number, Time of day, Timer, Number
COUNTER Counter, Hex, BCD, Bin
S5TIME SIMATIC_Timer, Hex, BCD, Bin

 

For the S7-1200 CPU family, all 32-bit data types are permitted (see table above), as well as 
the 64-bit data type LREAL with the following possible display formats:

Data type Possible display formats
LREAL In a project created with TIA Portal V12: 

Floating-point number 
Note: The display of LREAL is limited to 13 digits plus exponent.

LREAL In a project created with TIA Portal V12: 
Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 
Dec, Dec+/-, Dec_Sequence, Time of day, Timer, Date and time
Note: The display of LREAL is limited to 13 digits plus exponent.

 

For the S7-1500 CPU family, in addition to 32-bit data types, the 64-bit data types listed in the 
table are also permitted with the following possible display formats:
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Data type Possible display formats
LWORD Hex, Octal, BCD, Bin, Character, Unicode_Character, Dec, Dec+/-, 

Dec_Sequence, Floating-point number, Time of day, Timer, Date and time
LINT Dec+/-, Dec, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Time of day, Timer, Date and time
ULINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Time of day, Timer, Date and time
LREAL Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec, Dec+/-, Dec_Sequence, Time of day, Timer, Date and time
LTIME Timer, Dec+/-, Dec, Hex
LTOD Time of day, Dec, Hex, BCD, Bin
LDT Date and time, Dec, Hex

For more information, refer to the description of the valid data types.

 
 

 Note
Rounding of floating-point numbers

In the watch table, floating-point numbers are stored as binary numbers in IEEE format. 
Because not every floating point number (real, longreal) that can be displayed on the user 
interface can be mapped to the IEEE format, there is a possibility that floating-point numbers 
will be rounded. If a rounded floating-point number in the watch table is copied and, in turn, 
inserted in another input field, the rounding may cause a slight difference.

 

 
 

 Note
Only symbolic addressing is possible

In the watch table, LongDataTypes such as LWORD or LREAL can only be addressed 
symbolically.
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Selecting the display format for tags

Procedure
To select the display format of the tags, follow these steps:

1. Enter the desired address in the watch table.

2. Click the desired cell in the "Display format" column, and open the drop-down list.
The permissible display formats are shown in the drop-down list.

3. Select the desired display format from the drop-down list.
 

  Note

If the selected display format cannot be applied, then the last selected display format will 
be displayed automatically.

 

9.4.3.7 Monitoring tags in the watch table

Introduction to monitoring tags in the watch table

Introduction
The watch table allows you to monitor the tags of the configured input and output modules in 
the CPU, depending on the monitoring and modify mode (Page 1513) selected. To monitor 
tags, an online connection to the CPU must exist.

 
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs

Note that the monitoring of peripheral inputs can result in a time-out.

The CPU assumes the "STOP" mode.
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Options for monitoring tags
The following options are available for monitoring tags:

● Monitor now
This command starts the monitoring of the visible tags in the active watch table immediately 
and once only.

● Monitor all
This command starts the monitoring of all visible tags in the active watch table, depending 
on the selected watch mode:

– In basic mode, the monitoring mode is set to "permanent" by default.

– In expanded mode, you can specify defined trigger points for the monitoring of tags.
 

  Note

If the monitoring mode is changed while in expanded mode and then a switch is made 
to basic mode, the monitoring mode set before will also be applied in basic mode.

 

 

CPU-specific limitations when monitoring tags
The following CPU-specific differences exist:

● CPU S7-300/400:
CPUs from this family can only monitor the first 30 characters of a string.

● CPU S7-1200/1500:
CPUs from this family can monitor a string up to the total size of 254 characters.

 

Setting the monitoring and modify mode

Introduction       
By selecting the monitoring and modify mode, you specify the trigger point and the duration of 
the tag monitoring in the watch table and the force table.

Possible monitoring and modify modes (duration of monitoring or modifying)
The following monitoring and modify modes are available:

● Permanent

– In this mode, the inputs can be monitored at the start of the scan cycle and the outputs 
at the end.

● Once only, at start of scan cycle

● Once only, at end of scan cycle

● Permanently, at start of scan cycle

● Permanently, at end of scan cycle
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● Once only, at transition to STOP

● Permanently, at transition to STOP

Selecting the trigger point
The trigger points "Beginning of scan cycle", "End of scan cycle", and "Switch to stop" specify 
the time at which the tags are to be read from the CPU or updated in the CPU. 

The following diagram shows the position of these trigger points:

 

Position of the trigger points
From the position of the trigger points, it follows that:

● Modifying of inputs is only appropriate at the beginning of the scan cycle (corresponding 
to the beginning of the user program OB 1), because otherwise the process image input is 
updated again after modifying and is thus overwritten.

● Modifying of outputs is only appropriate at the end of the scan cycle (corresponding to the 
end of the user program OB 1), because otherwise the process image output can be 
overwritten by the user program.

● The modified value is displayed in the "Monitor value" column, provided that monitoring is 
active and the modified value is not overwritten by the user program.
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Monitoring of tags
When tags are being modified, the following applies to the trigger points:

● If you have specified the modify mode as "once only", you will receive a message if the 
selected tags cannot be modified.

● In "permanent" modify mode, you do not receive a message.

Note regarding the "Modify now" command
You can modify the values of selected tags immediately using the "Online > Modify >Modify 
now" command. This command is executed once only and as quickly as possible without 
reference to a defined position (trigger point) in the user program. This function is used mainly 
for modifying when the CPU is in STOP mode.

"Monitor all" command for tags

Introduction  
The "Monitor all" command allows you to start monitoring the visible tags in the active watch 
table. The default setting for the monitoring mode in basic mode of the watch table is 
"permanent". In expanded mode, you can specify defined trigger points for the monitoring of 
tags. In this case, the tags are monitored with reference to the specified trigger points.

 
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs

Note that the monitoring of peripheral inputs can result in a time-out.

The CPU assumes the "STOP" mode.
 

Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To execute the "Monitor all" command, follow these steps:

1. Enter the tags to be monitored and the corresponding addresses in the watch table.

2. Switch to expanded mode by clicking
the icon "Show/hide advanced setting columns" in the toolbar.
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3. If you want to change the default monitoring mode for a tag, click the appropriate cell in the 
"Monitor with trigger" column and select the desired monitoring mode from the drop-down 
list.

4. Click the "Monitor all" icon in the toolbar.

Result
The tags of the active watch table are monitored using the monitoring mode selected. 

See also
Icons in the watch table (Page 1502)

Entering tags in the watch table (Page 1505)

Basic mode and expanded mode in the watch table (Page 1501)

"Monitor now" command for tags

Introduction    
The "Monitor now" command starts the monitoring of tags immediately without reference to 
defined trigger points. The tag values are read out once only and displayed in the watch table.

 
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs

Note that the monitoring of peripheral inputs can result in a time-out.

The CPU assumes the "STOP" mode.
 

Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To execute the "Monitor now" command, follow these steps:

1. Enter the tags to be monitored and the corresponding addresses in the watch table.

2. Click the "Monitor now" icon in the toolbar.

Result
The tags of the active watch table are monitored immediately and once only. 
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See also
Icons in the watch table (Page 1502)

Entering tags in the watch table (Page 1505)

Basic mode and expanded mode in the watch table (Page 1501)

9.4.3.8 Modifying tags in the watch table

Introduction to modifying tags

Introduction 
The watch table allows you to modify the tags of the configured input and output modules in 
the CPU, depending on the monitoring and modify mode (Page 1513) selected. To monitor 
the tags, an online connection to the CPU must exist.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.

 

 
 

 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

Options for modifying tags
The following options are available for modifying tags:

● Modify to "0"
This command modifies the selected address to the modify value "0".

● Modify to "1"
This command modifies the selected address to the modify value "1".

● Modify once only and immediately
This command modifies all selected addresses in the active watch table "once only and 
immediately".
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● Modify with trigger
This command modifies all selected addresses in the active watch table using the 
monitoring and modify mode (Page 1513) selected. 
The "Modify with trigger" function is only available in expanded mode. You will not receive 
a message indicating whether or not the selected addresses were actually modified with 
the specified value. You should use the "Modify once only and immediately" function if you 
require such a confirmation.

● Enable peripheral outputs
This command disables the command output disable.
This function can only be executed in expanded mode, when the CPU is in STOP and the 
option Force (Page 1539) of tags is not enabled. If desired, deactivate this function in the 
force table.
 

 

  Note
When modifying, note the following:

Modifying can not be undone.
 

 

Modify tags to "0"

Introduction
You can assign one-time values to tags independent of the monitoring and modify mode and 
modify them. The modify command is executed as fast as possible, similar to a "Trigger now" 
command, without reference to a defined position in the user program.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.

 

 
 

 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
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Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To modify tags to "0", follow these steps:

1. Enter the desired address in the watch table.

2. Select the "Online > Modify > Modify to 0" command in order to modify the selected address 
with the specified value.

Result
The selected address is modified to "0".

 

 Note
When modifying, note the following:

Modifying can not be undone!
 

Modify tags to "1"

Introduction
You can assign one-time values to tags independent of the monitoring and modify mode and 
modify them. The modify command is executed as fast as possible, similar to a "Trigger now" 
command, without reference to a defined position in the user program.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.

 

 
 

 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
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Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To modify tags to "1", follow these steps:

1. Enter the desired address in the watch table.

2. Select the "Online > Modify > Modify to 1" command in order to modify the selected address 
with the specified value.

Result
The selected address is modified to "1". 

 

 Note
When modifying, note the following:

Modifying can not be undone!
 

"Modify now" command for tags

Introduction
You can assign one-time values to tags independent of the monitoring and modify mode and 
modify them immediately. The modify command is executed as fast as possible, similar to a 
"Trigger now" command, without reference to a defined position in the user program.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.

 

 
 

 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
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Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To modify tags immediately, follow these steps:

1. Enter the desired addresses and modify values in the watch table.

2. Select the addresses to be modified by selecting the check boxes for modifying in the 
column after the "Modify value". 
A yellow triangle appears behind the selected check box, indicating that the address is now 
selected for modifying but has not yet been modified.

3. Select the "Online > Modify > Modify once and now" command in order to immediately 
modify the selected address once only with the specified value.

Result
The selected addresses are modified immediately and once only.

 

 Note
When modifying, note the following:

Modifying can not be undone!
 

"Modify with trigger" command for tags

Introduction
You can assign values to addresses dependent on the defined monitoring and modify mode 
and modify them. The modify command is executed as specified in the monitoring and modify 
mode, with reference to the defined trigger position in the user program.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.
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 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

Requirements
● A watch table has been created.

● An online connection to the CPU exists.

● The watch table has to be in expanded mode.

Procedure
To modify tags "with trigger", follow these steps:

1. Enter the desired addresses and modify values in the watch table.

2. Select the addresses to be modified by selecting the check boxes for modifying in the 
column after the "Modify value". 
A yellow triangle appears behind the selected check box, indicating that the address is now 
selected for modifying but has not yet been modified.

3. Switch to expanded mode using the icon "Show/hide advanced settings columns" in the 
toolbar or the "Online > Expanded mode" command.
The "Monitor with trigger" and "Modify with trigger" columns are displayed.

4. In the "Modify with trigger" column, select the desired modify mode from the drop-down list 
box. The following options are available:

– Permanent

– Permanently, at start of scan cycle

– Once only, at start of scan cycle

– Permanently, at end of scan cycle

– Once only, at end of scan cycle

– Permanently, at transition to STOP

– Once only, at transition to STOP

5. Start modifying using the "Online > Modify > Modify with trigger" command.

6. Confirm the prompt with "Yes" if you want to start modifying with trigger.
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Result
The selected tags are modified using the selected monitoring and modify mode. The yellow 
triangle is no longer displayed. 

 

 Note
When modifying, note the following:

Modifying can not be undone!
 

Enable peripheral outputs

Introduction
The "Enable peripheral outputs" function deactivates the command output disable of the 
peripheral outputs. You can then modify the peripheral outputs when the CPU is in STOP 
mode. This function is available in the watch table in "Expanded mode" only. 

 

 DANGER

Danger when enabling the peripheral outputs:

Attention, the enabling of the peripheral outputs can cause serious personal injury and 
material damage! 
Make certain that dangerous conditions cannot occur before you execute the "Enable 
peripheral outputs" function.

 

Prerequisites
● A watch table has been created.

● An online connection to the CPU exists.

● The CPU is in STOP mode before you can enable the peripheral outputs.

● The watch table has to be in expanded mode.

● The option Force (Page 1539) of tags must not be enabled.
 

 Note
"Enable peripheral outputs" function
● This function is possible only in STOP mode. The function is exited by an operating state 

change of the CPU and by the termination of the online connection.
● While the function is enabled, forcing is not possible.
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Procedure
To enable the peripheral outputs in STOP mode, follow these steps:

1. Enter the desired addresses and modify values in the watch table.

2. Select the addresses to be modified by selecting the check boxes for modifying in the 
column after the "Modify value". 
A yellow triangle appears behind the selected check box, indicating that the address is now 
selected for modifying but has not yet been modified.

3. Switch to expanded mode using the icon "Show/hide advanced settings columns" in the 
toolbar or the "Online > Expanded mode" command.
The "Monitor with trigger" and "Modify with trigger" columns are displayed.

4. Change the relevant CPU to STOP using the operator panel.

5. Right-click to open the shortcut menu and select "Enable peripheral outputs".

6. Confirm the prompt with "Yes" if you want to unlock the command output disable for the 
peripheral outputs.

7. Modify the peripheral outputs using the "Online > Modify > Modify now" command.

Result
The peripheral outputs are modified with the selected modify values. The yellow triangle is no 
longer displayed.

Enabling the peripheral outputs
The "Enable peripheral outputs" function remains active until:

● The "Enable peripheral outputs" command is deactivated again via the shortcut menu or 
via the "Online > Modify > Enable peripheral outputs" command.

● The CPU is no longer in STOP mode.

● The online connection is terminated.
 

  Note
When modifying, note the following:

Modifying can not be undone!
 

9.4.4 Testing with the force table

9.4.4.1 Introduction for testing with the force table

Overview           
You can use the force table to assign permanent values to individual tags
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of the user program. This action is referred to as "forcing". 

The following functions are available in the force table:

● Monitoring tags
This displays the current values of the individual tags of a user program or a CPU on the 
programming device or PC. Tags can be monitored with or without a trigger condition.

● Forcing tags
This function lets you assign a permanent value to individual peripheral tags of the user 
program.

Monitoring and forcing tags
The monitoring and forcing of tags is always dependent on the operand scope of the CPU 
used.

The following tags can be monitored:

● Inputs, outputs, and bit memories

● Contents of data blocks

● Peripheral inputs

The following tags can be forced:

● Peripheral inputs

● Peripheral outputs

Example
● Independent of the CPU used, only I/O can be forced, such as: "Tag_1":P or "QW0:P" or 

"IW0:P". Note that "Tag_1":P must not be the symbolic name of a bit memory.

Possible applications
One advantage of the force table is that you can simulate different test environments and 
overwrite tags in the CPU with a permanent value. This enables you to intervene in the ongoing 
process for regulating purposes.

 

See also
Layout of the force table (Page 1526)

Basic mode and expanded mode in the force table (Page 1527)

Icons in the force table (Page 1528)

Open and edit force table (Page 1529)
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9.4.4.2 Safety precautions when forcing tags

Safety precautions when forcing tags   
Because the forcing function allows you to intervene permanently in the process, observance 
of the following notices is essential:

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.

 
 

 CAUTION

Prevent personal injury and material damage!
● Before you start the "Force" function, you should ensure that no one else is currently 

executing this function on the same CPU.
● Forcing can only be stopped by clicking the "Stop forcing" icon or using the "Online > 

Force > Stop forcing" command. Closing the active force table does not stop the forcing!
● Forcing can not be undone!
● Review the differences between " modifying tags" (Page 1517) and "forcing tags" 

(Page 1539).
● If a CPU does not support the "Force" function, the relevant icons cannot be selected.
● If the function "Enable peripheral outputs" is active on your CPU, then forcing is not 

possible on this CPU. If desired, deactivate this function in the watch table.

 
 

 

9.4.4.3 Layout of the force table

Introduction       
In the force table, enter the CPU-wide tags that you have defined and selected and which are 
to be forced in the allocated CPU. Only peripheral inputs and peripheral outputs can be forced.

For each CPU created in the project, a force table will automatically be created in the "Watch 
and force tables" folder. Only one force table can be allocated to a CPU. This force table 
displays all the addresses forced in the allocated CPU.
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Layout of the force table 
The columns displayed in the force table depend on the mode you are working in: basic mode 
or expanded mode. 

In expanded mode the "Monitor with trigger" column is also displayed. 

Meaning of the columns 
The following table shows the meaning of the individual columns in basic mode and expanded 
mode:

Mode Column Meaning
Basic mode Identification column

Name Name of the inserted tag
Address Address of the inserted tag
Display format Selected display format
Monitor value Values of the tags, dependent on the selected display 

format.
Force value Value with which the tag is forced.

 ("Force") Select the tag to be forced by activating the corresponding 
check box.

Comment Comment for documentation of the tags
The following additional 
column is shown in 
expanded mode:

Monitor with trigger Display of selected monitoring mode

See also
Icons in the force table (Page 1528)

Basic mode and expanded mode in the force table (Page 1527)

9.4.4.4 Basic mode and expanded mode in the force table

Difference between basic mode and expanded mode in the force table     
In expanded mode the "Monitor with trigger" column is also displayed in the force table. 

You will find a detailed list of the columns under Layout of the force table (Page 1526).
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Switching between basic mode and expanded mode
You have the following options of toggling between the basic and expanded mode:

● Click the icon "Show/hide advanced setting columns". Click this icon again to return to the 
basic mode.
Or:

● Activate the check box for the "Expanded mode" command in the "Online" menu. Deactivate 
this check box to return to the basic mode.

Functionality in expanded mode
The "Monitor with trigger" function can only be selected in expanded mode.

9.4.4.5 Icons in the force table

Meaning of the icons   
The following table shows the meaning of the icons in the force table:

Icon Meaning
Identifies a table inside the project tree as a force table. 

Identification column

Displays all columns of expanded mode. If you click this icon again, the 
columns of the expanded mode will be hidden.
Starts forcing for all addresses of the selected tags. If forcing is already 
running, the previous action is replaced without interruption.
Stops forcing of addresses in the force table.

Starts monitoring of the visible tags in the force table. The default setting for 
monitoring in basic mode is "permanent". In expanded mode an additional 
column is shown and you can set certain trigger points for monitoring tags.
Starts monitoring of the visible tags in the force table. This command is 
executed immediately and the tags are monitored once.
Displays the check box for the selection of tags to be forced.

Indicates that an address cannot be forced.

Indicates that an address cannot be fully forced. Example: It is possible to 
force the address QW0:P, but it is not possible to force the address QD0:P 
because this address area is potentially not available on the CPU.
Indicates that an address cannot be monitored.

Indicates that an address is being forced.

Indicates that an address is being partly forced.

Indicates that the associated peripheral address is being forced.
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Icon Meaning
Indicates that a syntax error occurred.

Indicates that the address is selected but has not been forced yet.

See also
Layout of the force table (Page 1526)

9.4.4.6 Open and edit force table

Display force table

Introduction
You cannot create a new force table; one force table already exists for each CPU. It is 
permanently allocated to this CPU and cannot be copied or duplicated. 

Requirements
A project with an allocated CPU has to be open.

Displaying a force table   
The force table is always displayed below a CPU in the "Watch and force tables" folder.

Open force table

Requirements   
A project with an allocated CPU must be created.

Procedure
Proceed as follows to open a force table:

1. Open the "Watch and force tables" folder below the desired CPU.

2. Double-click the "Force table" in this folder.

Result
The selected force table opens.
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Save force table

Requirements   
A project with an allocated CPU has been created. 

Procedure
Proceed as follows to save a force table:

1. Enter the desired changes in the force table.

2. Select the "Save" command in the "Project" menu or click the "Save project" icon in the 
toolbar. Note that this save operation will save the entire project.

Result
The contents of the force table and the associated project are saved.

 

 Note

You cannot rename a force table.
 

9.4.4.7 Entering tags in the force table

Basic principles for entering tags in the force table

Recommended procedure 
Select the tags whose values you want to monitor or force, and enter them in the force table.

When entering tags in the force table, please note that these tags must be previously defined 
in the PLC tag table. 

Example of filling out a force table
● You can enter the absolute address that is to be forced or monitored in the "Address" column 

or you can enter the symbolic name of the tag in the "Name" column.

● Select the display format you require from the drop-down list in the "Display format" column, 
if you do not want to use the default setting.

● Now you have to decide whether you want to monitor or force the entered tags. Enter the 
required force value and a comment in the appropriate columns of the force table.

● Note that only peripheral inputs and peripheral outputs can be forced and review the Safety 
precautions when forcing tags (Page 1540).
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Syntax check
When you enter tags in the force table, the syntax of each cell will be checked when you exit 
the cell. Incorrect entries are marked in red.

 

 Note

When you place the mouse pointer in a cell marked in red, brief information is displayed with 
additional notes on the error. 

 

 

Permitted operands for the force table

Permitted operands for the force table   
The following table shows the operands that are permitted for forcing in the force table:

Permitted operand Example of data 
type

Example (International 
mnemonics)

Peripheral input/peripheral output BOOL I0.0:P; Q0.0:P
Peripheral input/peripheral output BYTE IB1:P; QB1:P
Peripheral input/peripheral output WORD IW2:P; QW3:P
Peripheral input/Peripheral output DWORD ID2:P; QD1:P

 

The following table shows the operands that are permitted for monitoring in the force table:

Permitted operand Example of data 
type

Example (International 
mnemonics)

Input/output/bit memory BOOL I1.0, Q1.7, M10.1
I0.0:P

Input/output/bit memory BYTE IB1/QB10/MB100
IB1:P

Input/output/bit memory WORD IW1; QW10; MW100
IW2:P

Input/output/bit memory DWORD ID4; QD10; MD100
ID2:P

Data block BOOL DB1.DBX1.0
Data block BYTE DB1.DBB1
Data block WORD DB1.DBW1
Data block DWORD DB1.DBD1
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 Note

You cannot enter "DB0..." because it is used by the system!
 

 

Permitted force values for the force table

Entering force values in the force table    
The following table shows the operands that are permitted for entering force values in the force 
table:

Table 9-20 Bit operands

Possible bit operands Example for permitted force values
I1.0:P True
I1.1:P False
Q1.0P 0
Q1.1:P 1
I2.0:P 2#0
I2.1:P 2#1

Table 9-21 Byte operands

Possible byte operands Example for permitted force values
IB1:P 2#00110011
IB2:P B#16#1F
QB14:P 1F
QB10:P 'a'
IB3:P 10

Table 9-22 Word operands

Possible word operands Example for permitted force values
IW0:P 2#0011001100110011
IW2:P W#16#ABCD
QW10:P ABCD
QW12:P B#(12, 34)
IW4:P 'ab'
IW6:P 12345
IW8:P S5T#9S_340ms
IW10:P C#123
IW12:P D#2006-12-31
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Table 9-23 Double word operands

Possible double word operands Example for permitted force values
ID0:P 2#00110011001100110011001100110011
ID4:P 1.2 
QD10:P 1.234.e4
QD14:P Dw#16#abcdef10
ID8:P 16#ABCDEF10
ID12:P b#(12,34,56,78)
ID16:P L#-12
ID20:P L#12
ID24:P 123456789
ID28:P 123456789
ID32:P T#12s345ms
ID36:P Tod#14:20:40.645
ID40:P P#e0.0

 

Overview of the display formats

Display formats in the force table     
The display format you select specifies the representation of a tag value. 

When entering the address a display format is automatically preset. If you want to change this, 
you can select a display format from the drop-down list in the "Display formats" column. The 
drop-down list only offers the display formats which are valid for this data type. The display 
format that appears first in the list is the pre-selected format.

Example
The following table shows the 32-bit data types permitted for all CPU families in the force table 
and their possible display formats:

Data type Possible display formats
BOOL Bool, Hex, BCD, Octal, Bin, Dec, Dec+/-
BYTE Hex, BCD, Octal, Bin, Dec, Dec+/-, Character
WORD Hex, BCD, Octal, Bin, Dec, Dec+/-, Dec_Sequence, Character, 

SIMATIC_Timer, Date, Unicode_Character, Counter
DWORD Hex, BCD, Octal, Bin, Dec, Dec+/-, Dec_Sequence, Character, Floating-point 

number, Time of day, Timer, Pointer, Unicode_Character 
SINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character
INT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, SIMATIC_Timer, Counter, Date
DINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Floating-point number, Time of day, Timer, Pointer
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Data type Possible display formats
USINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character
UINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, SIMATIC_Timer, Counter, Date
UDINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Floating-point number, Time of day, Timer, Pointer
REAL Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec, Dec+/-, Dec_Sequence, Time of day, Timer, Pointer
DATE Date, Dec, Hex, BCD, Bin
TIME_OF_DAY Time of day, Dec, Hex, BCD, Bin
TIME Timer, Hex, BCD, Bin
DATE_AND_TIME Date and time,
TIMER SIMATIC_Timer, Hex, BCD, Bin
CHAR Character, Hex, BCD, Octal, Bin, Dec, Dec+/- 
STRING Character string
POINTER Pointer, Hex, BCD, Octal, Bin, Character, Unicode_Character, Dec, Dec+/-, 

Dec_Sequence, Floating-point number, Time of day, Timer, Number
COUNTER Counter, Hex, BCD, Bin
S5TIME SIMATIC_Timer, Hex, BCD, Bin

 

For the S7-1200 CPU family, all 32-bit data types are permitted (see table above), as well as 
the 64-bit data type LREAL with the following possible display formats:

Data type Possible display formats
LREAL In a project created with TIA Portal V12: 

Floating-point number 
Note: The display of LREAL is limited to 13 digits plus exponent.

LREAL In a project created with TIA Portal V12: 
Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 
Dec, Dec+/-, Dec_Sequence, Time of day, Timer, Date and time
Note: The display of LREAL is limited to 13 digits plus exponent.

 

For the S7-1500 CPU family, in addition to 32-bit data types, the 64-bit data types listed in the 
table are also permitted with the following possible display formats: 

Data type Possible display formats
LWORD Hex, Octal, BCD, Bin, Character, Unicode_Character, Dec, Dec+/-, 

Dec_Sequence, Floating-point number, Time of day, Timer, Date and time
LINT Dec+/-, Dec, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Time of day, Timer, Date and time
ULINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Time of day, Timer, Date and time
LREAL Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec, Dec+/-, Dec_Sequence, Time of day, Timer, Date and time
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Data type Possible display formats
LTIME Timer, Dec+/-, Dec, Hex
LTOD Dec, Hex, BCD, Bin, Time of day 
LDT Dec, Hex, Date and time

 

For more information, refer to the description of the valid data types.

 
 

 Note
Rounding of floating-point numbers

In the force table, floating-point numbers are stored as binary numbers in IEEE format. 
Because not every floating point number (real, longreal) that can be displayed on the user 
interface can be mapped to the IEEE format, there is a possibility that floating-point numbers 
will be rounded. If a rounded floating-point number in the force table is copied and, in turn, 
inserted in another input field, the rounding may cause a slight difference.

 

 
 

 Note
Only symbolic addressing is possible

In the force table, LongDataTypes such as LWORD or LREAL can only be addressed 
symbolically.

 

 

Selecting the display format for tags

Procedure
To select the display format of the tags, follow these steps:

1. Enter the desired address in the force table.

2. Click the desired cell in the "Display format" column, and open the drop-down list.
The permitted display formats are shown in the drop-down list.

3. Select the desired display format from the drop-down list.
 

  Note

If the selected display format cannot be applied, then the last selected display format will 
be displayed automatically.
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9.4.4.8 Monitoring tags in the force table

Introduction to monitoring tags in the force table

Introduction
Use the force table to monitor the tags of the configured input and output modules in the CPU, 
dependent on the monitoring mode (Page 1536) you have selected. An online connection to 
the CPU must exist to monitor tags.

Options for monitoring tags
The following options are available for monitoring tags:

● Monitor all
This command starts the monitoring of all visible tags in the active force table, dependent 
on the selected monitoring mode:

– In basic mode, the monitoring mode is set to "permanent" by default.

– In expanded mode, you can specify defined trigger points for the monitoring of tags.
 

  Note

If the monitoring mode is changed while in expanded mode and then a switch is made 
to basic mode, the monitoring mode set before will also be applied in basic mode.

 

● Monitor now
This command starts the monitoring of the visible tags in the active force table immediately 
and once only.

CPU-specific limitations when monitoring tags
The following CPU-specific differences exist:

● CPU S7-300/400:
CPUs from this family can only monitor the first 30 characters of a string.

● CPU S7-1200:
CPUs from this family can monitor a string up to the total size of 254 characters.

Setting the monitoring mode in the force table

Introduction
By selecting the monitoring mode, you specify the trigger point and the duration of tag 
monitoring in the force table.
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Possible monitoring mode (duration of monitoring)
The following selection options are available:

● Permanent: In this mode, the inputs can be monitored at the start of the scan cycle and the 
outputs at the end.

● Once only, at start of scan cycle

● Once only, at end of scan cycle

● Permanently, at start of scan cycle

● Permanently, at end of scan cycle

● Once only, at transition to STOP

● Permanently, at transition to STOP

Selecting the trigger point
The trigger points "Beginning of scan cycle", "End of scan cycle", and "Switch to stop" specify 
the time at which the tags are to be read from the CPU or updated in the CPU. 

The following diagram shows the position of these trigger points:

 

"Monitor all" command for tags

Introduction
Use the "Monitor all" command to start monitoring the visible tags in the active force table. In 
basic mode of the force table, the default setting for the monitoring mode is "permanent". In 
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expanded mode, you can specify defined trigger points for the monitoring of tags. In this case, 
the tags are monitored with reference to the specified trigger points.

Requirements
● A force table has been created.

● An online connection to the CPU exists.

Procedure
To execute the "Monitor all" command, follow these steps:

1. Enter the tags to be monitored and the corresponding addresses in the force table.

2. Switch to expanded mode by clicking
the icon "Show/hide advanced setting columns" in the toolbar.

3. If you want to change the default monitoring mode for a tag, click the appropriate cell in the 
"Monitor with trigger" column and select the desired monitoring mode from the drop-down 
list.

4. Click the "Monitor all" icon in the toolbar.

Result
The tags of the active force table will be monitored using the set monitoring mode. 

"Monitor now" command for tags

Introduction
The "Monitor now" command starts the monitoring of tags immediately without reference to 
defined trigger points. The tag values are read out only once and displayed in the force table.

Requirements
● A force table has been created.

● An online connection to the CPU exists.

Procedure
To execute the "Monitor now" command, follow these steps:

1. Enter the tags to be monitored and the corresponding addresses in the force table.

2. Click the "Monitor now" icon in the toolbar.

Result
The tags of the active force table are monitored immediately and once only. 
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9.4.4.9 Forcing tags in the force table

Introduction to forcing tags

Introduction
You can use the force table to assign permanent values to individual tags of the user program. 
This action is referred to as forcing. Only peripheral inputs and peripheral outputs can be forced.

To use the forcing function, you must have an online connection to the CPU and the utilized 
CPU must support this functionality. 

If you open a force table in the "Watch and force tables" folder below a CPU, all values forced 
in the allocated CPU will be displayed in this force table, provided that an online connection 
to the CPU exists.

Possible applications
By permanently assigning defined values to tags, you can specify defined default settings for 
your user program and, thus, test the programmed functions. Forcing is possible in basic mode 
and in expanded mode (Page 1527).

Caution when forcing tags
Before forcing, you must review the safety precautions (Page 1540) for this procedure.

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.

 
 

Options for forcing tags
The following options are available for forcing tags:

● Force to "0"
This command forces the selected address in the CPU to the force value "0".

● Force to "1"
This command forces the selected address in the CPU to the force value "1".
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● Force all
This command starts the forcing of enabled addresses in the active force table or replaces 
an existing force job without interruption. 

● Stop forcing
This command stops the forcing of all addresses in the active force table.

Constraints when forcing tags
Note the following constraints when forcing:

● Forcing is always dependent on the operand scope of the CPU used.

● In principle, only peripheral inputs and peripheral outputs can be forced.

● If the function "Enable peripheral outputs" is active on your CPU, then forcing is not possible. 
If desired, deactivate this function in the watch table.

Unique aspects when forcing tags
Note that forcing of tags will overwrite values in the CPU and will continue even after the online 
connection to the CPU is terminated. 

● Stop forcing
Terminating the online connection is not sufficient to stop the forcing operation! To stop 
forcing, you must select the "Online > Force > Stop forcing" command. Only then will the 
tags that are visible in the active force table no longer be forced.

● Stop forcing of individual tags
The "Online > Force > Stop forcing" command always applies to all tags displayed in the 
force table. To stop forcing individual tags, you must clear the check mark for forcing of 
these tags in the force table and restart forcing using the "Online > Force > Force all" 
command.

 

Safety precautions when forcing tags

Safety precautions when forcing tags   
Because the forcing function allows you to intervene permanently in the process, observance 
of the following notices is essential:

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.
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 CAUTION

Prevent personal injury and material damage!
● Before you start the "Force" function, you should ensure that no one else is currently 

executing this function on the same CPU.
● Forcing can only be stopped by clicking the "Stop forcing" icon or using the "Online > 

Force > Stop forcing" command. Closing the active force table does not stop the forcing!
● Forcing can not be undone!
● Review the differences between " modifying tags" (Page 1517) and "forcing tags" 

(Page 1539).
● If a CPU does not support the "Force" function, the relevant icons cannot be selected.
● If the function "Enable peripheral outputs" is active on your CPU, then forcing is not 

possible on this CPU. If desired, deactivate this function in the watch table.

 
 

 

Force tags to "0"

Introduction
You can use the force function to assign permanent values to individual tags of a user program. 

Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1540). 

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.

 
 

Requirements
● A force table has been created.

● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table. 
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Procedure
To force tags to "0", follow these steps:

1. Open the force table.

2. Enter the desired address in the force table.

3. Select the "Online > Force> Force to 0" command in order to force the selected address 
with the specified value.

4. Confirm the next dialog with "Yes".

Result
The selected address is forced to "0". The yellow triangle is no longer displayed. A red "F" is 
displayed in the first column, for example, indicating that the tag is being forced.

Stop forcing
To stop forcing, follow these steps: 

1. Open the force table.

2. Select the "Online > Force > Stop forcing" command.

3. Confirm the next dialog with "Yes".

Result
Forcing of the selected values is stopped. The red "F" in the first column is no longer displayed. 
The yellow triangle reappears behind the check box again to indicate that the address is 
selected for forcing but is not being forced at the moment.

 

 Note
When forcing, note the following:
● Forcing can not be undone!
● Terminating the online connection does not stop the forcing!
● To stop forcing, the forced address must be visible in the active force table.

 
 

 

Force tags to "1"

Introduction
You can use the force function to assign permanent values to individual tags of a user program.
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Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1540).

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Endanger the life or health of personnel
● Cause damage to machinery or the entire plant.

 
 

Requirements
● A force table has been created.

● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table.

Procedure
To force tags to "1", follow these steps:

1. Open the force table.

2. Enter the desired address in the force table.

3. Select the "Online > Force> Force to 1" command in order to force the selected address 
with the specified value.

4. Confirm the next dialog with "Yes".

Result
The selected address is forced to "1". The yellow triangle is no longer displayed. A red "F" is 
displayed in the first column, for example, indicating that the tag is being forced.

Stop forcing
To stop forcing, follow these steps:

1. Open the force table.

2. Select the "Online > Force > Stop forcing" command.

3. Confirm the next dialog with "Yes".
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Result
Forcing of the selected values is stopped. The red "F" in the first column is no longer displayed. 
The yellow triangle reappears behind the check box again to indicate that the address is 
selected for forcing but is not being forced at the moment.

 

 Note
When forcing, note the following:
● Forcing can not be undone!
● Terminating the online connection does not stop the forcing!
● To stop forcing, the forced address must be visible in the active force table.

 
 

"Force all" command for tags

Introduction  
You can use the force function to assign permanent values to individual tags of a user program.

If forcing is already active, this forcing operation is replaced without interruption by the "Online 
> Force > Force all" command. Any forced addresses that are not selected will no longer be 
forced.

Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1540).

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.

 
 

Requirements
● A force table has been created.

● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table.
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Procedure
To force tags with the "Online > Force > Force all" command, follow these steps:

1. Open the force table.

2. Enter the desired addresses and force values in the force table.

3. Select the addresses to be forced by selecting the check boxes for forcing in the column 
after the "Force value". 
A yellow triangle appears behind the selected check box, indicating that the address is 
selected for forcing but is not being forced at the moment.

4. Select the "Online > Force> Force all" command in order to force the selected addresses 
with the specified values.

5. Confirm the next dialog with "Yes".

Result
The selected addresses are forced to the specified values. The yellow triangle is no longer 
displayed. A red "F" is displayed in the first column, for example, indicating that the tag is being 
forced.

Stop forcing
To stop forcing, follow these steps: 

1. Open the force table.

2. Select the "Online > Force > Stop forcing" command.

3. Confirm the next dialog with "Yes".

Result
Forcing of the selected addresses is stopped. The red "F" in the first column is no longer 
displayed. The yellow triangle reappears behind the check box again to indicate that the 
address is selected for forcing but is not being forced at the moment.

 

 Note
When forcing, note the following:
● Forcing can not be undone!
● Terminating the online connection does not stop the forcing!
● To stop forcing, the forced address must be visible in the active force table.
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9.4.4.10 Stop forcing tags

Stop forcing all tags

Introduction   
Note the following before you stop forcing tags:

● The stopping of forcing can not be undone!

● Terminating the online connection does not stop the forcing!

● To stop forcing, the forced address must be visible in the active force table.

Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1540).

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when stopping the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.

 
 

Requirements
● A force table has been created in which tags are being forced.

● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table.

Procedure
Proceed as follows to stop forcing all tags :

1. Open the force table.

2. Select the "Online > Force > Stop forcing" command in order to stop forcing the displayed 
addresses.

3. Confirm the "Stop forcing" dialog with "Yes".
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Result
The forcing of all tags is stopped. The red "F" in the first column is no longer displayed. The 
yellow triangle reappears behind the check box again to indicate that the address is flagged 
for forcing but is not being forced at the moment.

Stop forcing individual tags

Introduction   
Note the following before you stop forcing tags:

● The stopping of forcing can not be undone!

● Terminating the online connection does not stop the forcing!

● To stop forcing, the forced address must be visible in the active force table.

Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1526).

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when stopping the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.

 
 

Requirements
● A force table has been created in which tags are being forced.

● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table.

Procedure
Proceed as follows to stop forcing individual tags :

1. Open the force table.

2. Deactivate the check boxes for the addresses that are no longer to be forced.

3. Reselect the "Online > Force" command.
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Result
Forcing of the disabled addresses will be stopped. The red "F" in the first column is no longer 
displayed. The yellow triangle reappears behind the check box again to indicate that the 
address is flagged for forcing but is not being forced at the moment.
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9.5 Using global project functions

9.5.1 Importing and exporting

9.5.1.1 Basics for importing and exporting

Introduction  
You can export PLC tag tables to a standardized XLSX format for editing with external table 
editors. Similarly, you can import PLC tag tables created with external table editors to the TIA 
Portal.

Overwriting existing PLC tags and constants during import
Existing entries of the same name will be overwritten during import if they have the same name 
as the entries that will be imported. 

Link to existing objects
References to PLC tags or constants that already exist in the project are updated automatically 
during import. The update is executed based on the name of the PLC tags and constants. 

 

See also
Format of the export file (Page 1549)

Exporting PLC tags (Page 1550)

Importing PLC tags (Page 1551)

9.5.1.2 Format of the export file

Introduction   
During the export of PLC tag tables, a standardized XSLX format will be generated that you 
can edit with external table editors. 

This format is also expected during the import of tables.

Format of the export file
The sheet is always named "PLC Tags". This sheet can contain the displayed columns. The 
sorting order of columns can vary. The sheet does not necessarily have to include all columns. 
During import, the following values will be identified by a <no value> entry. 
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The names of the column headers are also clearly defined and are always expected in English. 

The following table specifies the contents expected for the individual columns:

Element Explanation
Name Name of the tags
Path Group and name of the PLC tag table
Data Type The notation of the data type corresponds to the 

notation used in the PLC tag table.
Logical Address The address can be specified with German or 

international mnemonics.
Comment Free-form comments
Hmi Visible The value TRUE or FALSE is expected.
Hmi Accessible The value TRUE or FALSE is expected.

See also
Basics for importing and exporting (Page 1549)

Exporting PLC tags (Page 1550)

Importing PLC tags (Page 1551)

9.5.1.3 Exporting PLC tags

Requirement  
A PLC tag table is open.

Procedure
To export PLC tags and constants, follow these steps:

1. In the PLC tag table, click the "Export" button.
The "Export to Excel" dialog opens.

2. Select the path to which you want to save the export file.

3. Select whether to export tags and/or constants.

4. Click the "OK" button.

Result
The export file will be generated. Errors and warnings generated during export are indicated 
in the "Info" tab of the Inspector window.
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See also
Basics for importing and exporting (Page 1549)

Format of the export file (Page 1549)

Importing PLC tags (Page 1551)

9.5.1.4 Importing PLC tags

Requirement  
A table exists and it conforms to format specifications.

Procedure
To import a PLC tag table, follow these steps:

1. Open the "All tags" table.

2. Click the "Import" button.
The "Import from Excel" dialog opens.

3. Select whether to import PLC tags and/or constants.

4. Select the table you want to import.

5. Click the "OK" button.

Result
The PLC tag table will be imported. 

Errors and warnings generated during export are indicated in the "Info" tab of the Inspector 
window.

See also
Basics for importing and exporting (Page 1549)

Format of the export file (Page 1549)

Exporting PLC tags (Page 1550)
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9.6 Programming examples

9.6.1 LAD programming examples

9.6.1.1 Example of controlling a conveyor belt 

Controlling a conveyor belt   
The following figure shows a conveyor belt that can be activated electrically. There are two 
pushbutton switches at the beginning of the conveyor belt: S1 for START and S2 for STOP. 
There are also two pushbutton switches at the end of the conveyor belt: S3 for START and 
S4 for STOP. It is possible to start and stop the conveyor belt from either end.

Implementation
The following table shows the definition of the tags used:

Name Data type Description
StartSwitch_Left (S1) BOOL Start switch on the left side of the 

conveyor belt
StopSwitch_Left (S2) BOOL Stop switch on the left side of the 

conveyor belt
StartSwitch_Right (S3) BOOL Start switch on the right side of 

the conveyor belt
StopSwitch_Right (S4) BOOL Stop switch on the right side of 

the conveyor belt
MOTOR_ON BOOL Turn on the conveyor belt motor

The following networks show the LAD programming for solving this task:

Network 1:

The conveyor belt motor is switched on when Start switch "S1" or "S3" is pressed.
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Network 2:

The conveyor belt motor is switched off when Stop switch "S2" or "S4" is pressed.

9.6.1.2 Example of detecting the direction of a conveyor belt

Detecting the direction of a conveyor belt     
The following figure shows a conveyor belt that is equipped with two photoelectric barriers 
(PEB1 and PEB2). The photoelectric barriers are designed to detect the direction in which an 
object is moving on the conveyor belt.

Implementation
The following table shows the definition of the tags used:

Name Data type Description
PEB1 BOOL Photoelectric barrier 1
PEB2 BOOL Photoelectric barrier 2
RIGHT BOOL Display during movement to right
LEFT BOOL Display during movement to left
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Name Data type Description
CM1 BOOL Edge bit memory 1
CM2 BOOL Edge bit memory 2

The following networks show the LAD programming for solving this task:

Network 1:

If the signal state changes from "0" to "1" (positive edge) at photoelectric barrier "PEB1" and, 
at the same time, the signal state at "PEB2" is "0", the object on the belt is moving to the left.

Network 2:

If the signal changes from "0" to "1" (positive edge) at photoelectric barrier "PEB2" and, at the 
same time, the signal state at "PEB1" is "0", the object on the belt is moving to the right.

9.6.1.3 Example of detecting the fill level of a storage area 

Detecting the fill level of a storage area   
The following figure shows a system with two conveyor belts and a temporary storage area 
between them. Conveyor belt 1 delivers packages to the storage area. A photoelectric barrier 
at the end of conveyor belt 1 near the storage area detects how many packages are delivered 
to the storage area. Conveyor belt 2 transports packages from the temporary storage area to 
a loading dock onto which the packages are loaded for delivery to customers by truck. A 
photoelectric barrier at the storage area exit detects how many packages leave the storage 
area to be transported to the loading dock. Five display lamps indicate the capacity of the 
temporary storage area.

When a conveyor belt is restarted, the current count value is set to the number of packages 
available in the storage area.
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Implementation
The following table shows the definition of the tags used:

Name Data type Description
PEB1 BOOL Photoelectric barrier 1
PEB2 BOOL Photoelectric barrier 2
RESET BOOL Reset counter 
LOAD BOOL Set counter to value of "PV" 

parameter
STOCK INT Stock at restart
PACKAGECOUNT INT Number of packages in the 

storage area (current count 
value)

STOCK_PACKAGES BOOL Is set if the current count value 
is greater than or equal to the 
value of the tag "STOCK".

STOR_EMPTY BOOL Display lamp: Storage area 
empty

STOR_NOT_EMPTY BOOL Display lamp: Storage area not 
empty

STOR_50%_FULL BOOL Display lamp: Storage area 50% 
full

STOR_90%_FULL BOOL Display lamp: Storage area 90% 
full

STOR_FULL BOOL Display lamp: Storage area full
VOLUME_50 INT Comparison value: 50 packages
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Name Data type Description
VOLUME_90 INT Comparison value: 90 packages
VOLUME_100 INT Comparison value: 100 

packages

The following networks show the LAD programming for activating the lamps:

Network 1:

When a package is delivered to the storage area, the signal state at "PEB1" switches from "0" 
to "1" (positive signal edge). On a positive signal edge at "PEB1", the "Up" counter is enabled, 
and the current count value of "PACKAGECOUNT" is increased by one. 

When a package is delivered from the storage area to the loading dock, the signal state at 
"PEB2" switches from "0" to "1" (positive signal edge). On a positive signal edge at "PEB2", 
the "Down" counter is enabled, and the current count value of "PACKAGECOUNT" is 
decreased by one.

If there are no packages in the storage area ("PACKAGECOUNT" = "0"), the "STOR_EMPTY" 
tag is set to signal state "1", and the "Storage area empty" lamp is switched on.

The current count value can be reset to "0" if the "RESET" tag is set to signal state "1".

If the "LOAD" tag is set to signal state "1", the current count value is set to the value of the 
"STOCK" tag. If the current count value is greater than or equal to the value of the "STOCK" 
tag, the "STOCK_PACKAGES" tag supplies the signal state "1".

Network 2:

As long as there are packages in the storage area, the "STOR_NOT_EMPTY" tag is set to 
signal state "1", and the "Storage area not empty" lamp is switched on.

Network 3:

If the number of packages in the storage area is greater than or equal to 50, the lamp for 
the•"Storage area 50% full" message switches on.

Programming the PLC
9.6 Programming examples

WinCC Comfort/Advanced V12.0 SP1
1556 System Manual, 07/2013,  



Network 4:

If the number of packages in the storage area is greater than or equal to 90, the "Storage area 
90% full" lamp switches on.

Network 5:

If the number of packages in the storage area reaches 100, the lamp for the "Storage area 
full" message switches on.

9.6.1.4 Example of controlling room temperature

Controlling room temperature  
In a cold room, the temperature must be maintained below zero degrees Celsius. Any 
temperature fluctuations are monitored by a sensor. If the temperature rises above zero 
degrees Celsius, the cooling system switches on for a preset time. The "Cooling system On" 
lamp is lit during this time.

The cooling system and the lamp are turned off if one of the following conditions is met:

● The sensor reports a temperature fall below zero degrees Celsius.

● The preset cooling time has elapsed.

● The pushbutton switch "STOP" has been pressed.

If the preset cooling time has expired and the temperature in the cold room is still too high, the 
cooling system can be restarted by means of the pushbutton switch "RESET".

Programming the PLC
9.6 Programming examples

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1557



Implementation
The following table shows the definition of the tags used:

Name Data type Comment
Sensor BOOL Temperature sensor signal
RESET BOOL Restart
STOP BOOL The cooling system is switched 

off.
MaxCoolTime TIME Preset cooling time

This tag is defined in the 
"DB_Cool" data block.

CurrCoolTime TIME Currently elapsed cooling time
This tag is defined in the 
"DB_Cool" data block.

Cooling system BOOL The cooling system is switched 
on.

Lamp BOOL The lamp for the "Cooling 
system on" message is switched 
on.

TempVariable BOOL Temporary tag
This tag stores the signal state 
of the IEC time TP.

The following network shows the LAD programming for controlling room temperature:

Network 1:

Network 2:

When the temperature in the cold room rises above zero degrees Celsius, the signal state at 
the "Sensor" operand switches from "0" to "1" (positive signal edge). In the case of a positive 
signal edge at the input IN of the time function, the preset cooling time is started and the 
"TempVariable" receives the signal state "1". The signal state "1" of the "TempVariable" has 
the result in network 2 that the cooling system as well as the display lamp are turned on. The 
outputs "Sensor", "Cooling system" and "Lamp" must be programmed in network 2, because 
you can program only one coil at output Q of the time function.
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If the temperature in the cold room falls below zero degrees Celsius, the signal state of the 
sensor switches back to "0". This switches the cooling system and lamp off.

If the sensor does not signal a temperature drop, the cooling system and lamp are switched 
off after the preset cooling time has elapsed, at the latest. In this case, the cooling process 
can be restarted by pressing the "RESET" pushbutton switch. Pressing and releasing the 
pushbutton switch generates a new positive signal edge at input IN, which restarts the cooling 
system.

Using the pushbutton switch "STOP", the cooling system and the display lamp can be turned 
off at any time.

9.6.2 FBD programming examples

9.6.2.1 Example of controlling a conveyor belt 

Controlling a conveyor belt     
The following figure shows a conveyor belt that can be activated electrically. There are two 
pushbutton switches at the beginning of the conveyor belt: S1 for START and S2 for STOP. 
There are also two pushbutton switches at the end of the conveyor belt: S3 for START and 
S4 for STOP. It is possible to start and stop the conveyor belt from either end.

Implementation
The following table shows the definition of the tags used:

Name Data type Description
StartSwitch_Left (S1) BOOL Start switch on the left side of the 

conveyor belt
StopSwitch_Left (S2) BOOL Stop switch on the left side of the 

conveyor belt
StartSwitch_Right (S3) BOOL Start switch on the right side of 

the conveyor belt
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Name Data type Description
StopSwitch_Right (S4) BOOL Stop switch on the right side of 

the conveyor belt
MOTOR_ON BOOL Turn on the conveyor belt motor

The following networks show the FBD programming for solving this task:

Network 1:

The conveyor belt motor is switched on when Start switch "S1" or "S3" is pressed.

Network 2:

The conveyor belt motor is switched off when stop switch "S2" or "S4" is pressed.

9.6.2.2 Example of detecting the direction of a conveyor belt

Detecting the direction of a conveyor belt    
The following figure shows a conveyor belt that is equipped with two photoelectric barriers 
(PEB1 and PEB2). The photoelectric barriers are designed to detect the direction in which an 
object is moving on the conveyor belt.
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Implementation
The following table shows the definition of the tags used:

Name Data type Description
PEB1 BOOL Photoelectric barrier 1
PEB2 BOOL Photoelectric barrier 2
RIGHT BOOL Display during movement to right
LEFT BOOL Display during movement to left
CM1 BOOL Edge bit memory 1
CM2 BOOL Edge bit memory 2

The following networks show the FBD programming for solving this task:

Network 1:

If the signal state changes from "0" to "1" (positive edge) at photoelectric barrier "PEB1" and, 
at the same time, the signal state at "PEB2" is "0", the object on the belt is moving to the left.

Network 2:

If the signal changes from "0" to "1" (positive edge) at photoelectric barrier "PEB2" and, at the 
same time, the signal state at "PEB1" is "0", the object on the belt is moving to the right.

9.6.2.3 Example of detecting the fill level of a storage area 

Detecting the fill level of a storage area    
The following figure shows a system with two conveyor belts and a temporary storage area 
between them. Conveyor belt 1 delivers packages to the storage area. A photoelectric barrier 
at the end of conveyor belt 1 near the storage area detects how many packages are delivered 
to the storage area. Conveyor belt 2 transports packages from the temporary storage area to 
a loading dock onto which the packages are loaded for delivery to customers by truck. A 
photoelectric barrier at the storage area exit detects how many packages leave the storage 

Programming the PLC
9.6 Programming examples

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1561



area to be transported to the loading dock. Five display lamps indicate the capacity of the 
temporary storage area.

When a conveyor belt is restarted, the current count value is set to the number of packages 
available in the storage area.

Implementation
The following table shows the definition of the tags used:

Name Data type Description
PEB1 BOOL Photoelectric barrier 1
PEB2 BOOL Photoelectric barrier 2
RESET BOOL Reset counter
LOAD BOOL Set counter to value of "CV" 

parameter
STOCK INT Stock at restart
PACKAGECOUNT INT Number of packages in the 

storage area (current count 
value)

STOCK_PACKAGES BOOL Is set if the current count value 
is greater than or equal to the 
value of the tag "STOCK".

STOR_EMPTY BOOL Display lamp: Storage area 
empty

STOR_NOT_EMPTY BOOL Display lamp: Storage area not 
empty

STOR_50%_FULL BOOL Display lamp: Storage area 50% 
full
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Name Data type Description
STOR_90%_FULL BOOL Display lamp: Storage area 90% 

full
STOR_FULL BOOL Display lamp: Storage area full
VOLUME_50 INT Comparison value: 50 packages
VOLUME_90 INT Comparison value: 90 packages
VOLUME_100 INT Comparison value: 100 

packages

The following networks show the FBD programming for activating the lamps:

Network 1:

When a package is delivered to the storage area, the signal state at "PEB1" switches from "0" 
to "1" (positive signal edge). On a positive signal edge at "PEB1", the "Up" counter is enabled, 
and the current count value of "PACKAGECOUNT" is increased by one.

When a package is delivered from the storage area to the loading dock, the signal state at 
"PEB2" switches from "0" to "1" (positive signal edge). On a positive signal edge at "PEB2", 
the "Down" counter is enabled, and the current count value of "PACKAGECOUNT" is 
decreased by one.

If there are no packages in the storage area ("PACKAGECOUNT" = "0"), the "STOR_EMPTY" 
tag is set to signal state "1", and the "Storage area empty" lamp is switched on.

The current count value can be reset to "0" if the "RESET" tag is set to signal state "1".

If the "LOAD" tag is set to signal state "1", the current count value is set to the value of the 
"STOCK" tag. If the current count value is greater than or equal to the value of the "STOCK" 
tag, the "STOCK_PACKAGES" tag supplies the signal state "1".

Network 2:

As long as there are packages in the storage area, the "STOR_NOT_EMPTY" tag is set to 
signal state "1", and the "Storage area not empty" lamp is switched on.

Network 3:
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If the number of packages in the storage area is greater than or equal to 50, the lamp for the 
"Storage area 50% full" message switches on.

Network 4:

If the number of packages in the storage area is greater than or equal to 90, the "Storage area 
90% full" lamp switches on.

Network 5:

If the number of packages in the storage area reaches 100, the lamp for the "Storage area 
full" message switches on.

9.6.2.4 Example of controlling room temperature

Controlling room temperature  
In a cold room, the temperature must be maintained below zero degrees Celsius. Any 
temperature fluctuations are monitored by a sensor. If the temperature rises above zero 
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degrees Celsius, the cooling system switches on for a preset time. The "Cooling system on" 
lamp is lit during this time.

The cooling system and the lamp are turned off if one of the following conditions is met:

● The sensor reports a temperature fall below zero degrees Celsius.

● The preset cooling time has elapsed.

● The pushbutton switch "Stop" has been pressed.

If the preset cooling time has expired and the temperature in the cold room is still too high, the 
cooling system can be restarted by means of the pushbutton switch "RESET".

Implementation
The following table shows the definition of the tags used:

Name Data type Comment
Sensor BOOL Temperature sensor signal
RESET BOOL Restart
STOP BOOL The cooling system is switched 

off.
MaxCoolTime TIME Preset cooling time

This tag is defined in the 
"DB_Cool" data block.

CurrCoolTime TIME Currently elapsed cooling time
This tag is defined in the 
"DB_Cool" data block.

Cooling system BOOL The cooling system is switched 
on.

Lamp BOOL The lamp for the "Cooling 
system on" message is switched 
on.

TempVariable BOOL Temporary tag
This tag stores the signal state 
of the IEC time TP.

The following network shows the FBD programming for controlling room temperature:

Network 1:
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Network 2:

When the temperature in the cold room rises above zero degrees Celsius, the signal state at 
the "Sensor" operand switches from "0" to "1" (positive signal edge). In the case of a positive 
signal edge at the input IN of the time function, the preset cooling time is started and the 
"TempVariable" receives the signal state "1". The signal state "1" of the "TempVariable" has 
the result in network 2 that the cooling system as well as the display lamp are turned on. The 
outputs "Sensor", "Cooling system" and "Lamp" must be programmed in network 2, because 
you can program only one coil at output Q of the time function.

If the temperature in the cold room falls below zero degrees Celsius, the signal state of the 
sensor switches back to "0". This switches the cooling system and lamp off.

If the sensor does not signal a temperature drop, the cooling system and lamp are switched 
off after the preset cooling time has elapsed, at the latest. In this case, the cooling process 
can be restarted by pressing the pushbutton switch "RESET". Pressing and releasing the 
pushbutton switch generates a new positive signal edge at input IN, which restarts the cooling 
system.

Using the pushbutton switch "STOP", the cooling system and the display lamp can be turned 
off at any time.

9.6.3 STL programming examples

9.6.3.1 Example: Bit logic instructions

Controlling a conveyor belt   
The following figure shows a conveyor belt that can be activated electrically. There are two 
pushbutton switches at the beginning of the conveyor belt: S1 for START and S2 for STOP. 
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There are also two pushbutton switches at the end of the conveyor belt: S3 for START and 
S4 for STOP. It is possible to start and stop the conveyor belt from either end.

Implementation
The following table shows the definition of the tags used:

Operand Declaration Data type Description
StartSwitch_Left (S1) Input BOOL Start switch on the left 

side of the conveyor belt
StopSwitch_Left (S2) Input BOOL Stop switch on the left 

side of the conveyor belt
StartSwitch_Right (S3) Input BOOL Start switch on the right 

side of the conveyor belt
StopSwitch_Right (S4) Input BOOL Stop switch on the right 

side of the conveyor belt
MOTOR_ON/OFF Output BOOL Switching the conveyor 

belt motor on/off

The following STL program shows how to implement this task:

 STL Explanation
O #S1 // Scan start switch S1 for "1".
O #S3 // Scan start switch S3 for "1".
S #"MOTOR_ON/OFF" // If one of the start switches (S1 or S3) returns the signal 

state "1", the conveyor belt motor will be turned on.
O #S2 // Scan stop switch S2 for "1".
O #S4 // Scan stop switch S4 for "1".
R #"MOTOR_ON/OFF" // If one of the stop switches (S2 or S4) returns the signal 

state "1", the conveyor belt motor will be turned off.

Programming the PLC
9.6 Programming examples

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1567



9.6.3.2 Example of detecting the direction of a conveyor belt

Detecting the direction of a conveyor belt    
The following figure shows a conveyor belt that is equipped with two photoelectric barriers 
(PEB1 and PEB2). The photoelectric barriers are designed to detect the direction in which an 
object is moving on the conveyor belt.

Implementation
The following table shows the definition of the tags used:

Name Declaration Data type Description
S1 Input BOOL Photoelectric barrier 1
S2 Input BOOL Photoelectric barrier 2
TM1 Input BOOL Edge bit memory 1
TM2 Input BOOL Edge bit memory 2
RIGHT Output BOOL Display for movement 

to the right
LEFT Output BOOL Display for movement 

to the left

The following STL program shows how to implement this example:

 STL Explanation
A #S1 // Scan photoelectric barrier "S1" for "1"
FP #TM1 // Query positive edge
AN #S2 // Scan photoelectric barrier "S2" for "0"
S #LEFT //If the signal state changes from "0" to "1" (positive edge) 

at the photoelectric barrier "S1" and, at the same time, the 
signal state at the photoelectric barrier "S2" is "0", the 
object on the belt is moving to the left.
// The display for movement to the left is activated.

A #S2 // Scan photoelectric barrier "S2" for "1"
FP #TM2 // Query positive edge
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 STL Explanation
AN #S1 // Scan photoelectric barrier "S1" for "0"
S #RIGHT //If the signal state changes from "0" to "1" (positive edge) 

at photoelectric barrier "S2" and, at the same time, the signal 
state at photoelectric barrier "S1" is "0", the object on the 
belt is moving to the right.
// The display for movement to the right is activated.

AN #S1 // Scan photoelectric barrier "S1" for "0"
AN #S2 // Scan photoelectric barrier "S2" for "0"
R #LEFT // The display for movement to the left will be turned off when 

the signal state at both photoelectric barriers is "0".
R #RIGHT // The display for movement to the right will be turned off when 

the signal state at both photoelectric barriers is "0".

9.6.3.3 Example of detecting the fill level of a storage area 

Detecting the fill level of a storage area   
The following figure shows a system with two conveyor belts and a temporary storage area 
between them. Conveyor belt 1 delivers packages to the storage area. A photoelectric barrier 
at the end of conveyor belt 1 near the storage area detects how many packages are delivered 
to the storage area. Conveyor belt 2 transports packages from the temporary storage area to 
a loading dock onto which the packages are loaded for delivery to customers by truck. A 
photoelectric barrier at the storage area exit detects how many packages leave the storage 
area to be transported to the loading dock. Five display lamps indicate the capacity of the 
temporary storage area.

When a conveyor belt is restarted, the current count value is set to the number of packages 
available in the storage area.
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Implementation
The following table shows the definition of the tags used:

Name Data type Address Description
PACKAGECOUNT COUNTER C1 Number of packages in 

the storage area 
(current count value)

Name Section Data type Description
LS1 Input BOOL Photoelectric barrier 1
LS2 Input BOOL Photoelectric barrier 2
STOR_EMPTY Output BOOL Display lamp: Storage 

area empty
STOR_NOT_EMPTY Output BOOL Display lamp: Storage 

area not empty
STOR_50%_FULL Output BOOL Display lamp: Storage 

area 50% full
STOR_90%_FULL Output BOOL Display lamp: Storage 

area 90% full
STOR_FULL Output BOOL Display lamp: Storage 

area full

The following STL program shows how to implement this example: 

 STL Explanation
A #LS1 // Scan photoelectric barrier "LS1" for "1".
CU "PACKAGECOUNT" // At a positive edge at photoelectric barrier "LS1", the count 

value of counter "PACKAGECOUNT" is increased by one.
A #LS2 // Scan photoelectric barrier "LS2" for "1".
CD "PACKAGECOUNT" // At a positive edge at photoelectric barrier "LS2", the count 

value of counter "PACKAGECOUNT" is decreased by one.
AN "PACKAGECOUNT" // Scan count value for "0".
= #STOR_EMPTY // With a count value of "0" the display lamp "storage area 

empty" is switched on.
A "PACKAGECOUNT" // Scan count value for "1".
= #STOR_NOT_EMPTY // With a count value greater than "0" the display lamp "Storage 

area not empty" is switched on.
L 50 // Load the comparison value "50" to accumulator 1.
L "PACKAGECOUNT" // Move the comparison value to accumulator 2.

// Load the current count value to accumulator 1.
<=I // Compare values
= #"STOR_50%_FULL" // With a count value greater than or equal to "50" the display 

lamp "Storage area 50% full" is switched on.
L 90 // Move the counter value to accumulator 2.

// Load the comparison value "90" to accumulator 1.
>=I // Compare values
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 STL Explanation
= #"STOR_90%_FULL" // With a count value greater than or equal to "90" the display 

lamp "Storage area 90% full" is switched on.
L "PACKAGECOUNT" // Load the current count value to accumulator 1.
L 100 // Move the counter value to accumulator 2.

// Load the comparison value "100" to accumulator 1.
>=I // Compare values
= #STOR_FULL // At a count value greater than "100" the display lamp "Storage 

area full" is switched on.

9.6.3.4 Example of calculating an equation

Calculating an equation   
The sample program shows you how to use three math instructions to calculate the following 
equation:

RESULT = ((A + B) x C) /D

Implementation
The following table shows the declaration of the operands used in the PLC tag table:

Name Data type Comment
A INT First value for addition
B INT Second value for addition
C INT Multiplier
D INT Divisor
RESULT INT End result

The following STL program shows how to implement this example:

 STL Explanation
L "A" // Load value of the operand "A" to accumulator 1
L "B" // Load value of operand "A" to accumulator 2

// Load value of the operand "B" to accumulator 1
+I // Add the values of accumulator 1 and 2

// Store sum in accumulator 1
L "C" // Move the sum to accumulator 2

// Load value of the operand "C" to accumulator 1
*I // Multiply the values of accumulator 1 and 2

// Store product in accumulator 1
L "D" // Move the product to accumulator 2

// Load value of the operand "D" to accumulator 1
/I // Divide the value of accumulator 2 by the value of accumulator 

1
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 STL Explanation
// Store result in accumulator 1

T "RESULT" // Transfer the result to operand "RESULT"

9.6.3.5 Example: Word logic instructions

Heating an oven  
The following illustration shows an oven that is turned on with a start switch. The heating 
process is started when the start switch is pressed. The heating period is set with digital 
thumbwheels. The heating period is set in seconds using the BCD format.
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Implementation
The following table shows the declaration of the operands used in the PLC tag table:

Name Data type Address Comment
DURATION WORD EW0 Heating period in 

seconds
● I1.0 to I1.3: 

Thumbwheels for 
ones

● I1.4 to I1.7: 
Thumbwheels for 
tens

● I0.0 to I0.3: 
Thumbwheels for 
hundreds

HEATING TIMER T1 Time that is started with 
the preset heating 
period.

The following table shows the declaration of the operands used in the block interface of the 
code block:

Name Section Data type Comment
START Input BOOL Start switch
START_HEATING Output BOOL Start of the heating 

process

The following STL program shows how to implement this example:

 STL Explanation
A "HEATING" // Scan to see if time has started
= #START_HEATING // Start the heating process
BEC // For RLO=1 End processing of block 

// This prevents the "HEATING" time from being restarted if the 
button is pressed

L "DURATION" // Load the heating period in accumulator 1
AW W#16#0FFF // Reset input bits I0.4 to I0.7 to "0" 
OW W#16#4000 // Set seconds in bits I1.2 and I1.3 of accumulator 1
A #START // Scan start switch for "1"
SE "HEATING" // Start heating process as an extended pulse with a positive 

edge at the start switch
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9.6.3.6 Example of a step sequence

Programming a step sequence
The following figure shows a station for removing glass containers from a pallet. The pallets 
are transported on a conveyor belt to the station. When a pallet with glass containers reaches 
the station, the conveyor belt will be stopped and a gripper moves from its basic position (P0) 
to the position above the pallet (P2). Once the gripper is above the pallet, the gripping clamps 
will open and the gripper lowered. Sensors detect the actual position of the gripper and the 
status of the gripping clamps. The sequence of the gripper movement in this example is 
implemented by a step sequence. You can program the additional steps required for removing 
the bottles and transporting them on an additional conveyor belt.

Implementation
The following table shows the declaration of the operands used in the PLC tag table:

Name Data type Comment
NUMBER INT Step number
Tag_Error BOOL Operand that is set when the 

step number is greater than 3 or 
if one of the steps was not 
executed.

The following table shows the declaration of the operands used in the block interface of the 
code block:

Name Section Data type Comment
POS_0 Input BOOL Gripper in basic 

position (P0)
POS_1 Input BOOL Gripper in position 1 

(P1)
POS_2 Input BOOL Gripper in position 2 

(P2)
GRIPPER_OPEN Input BOOL Gripping clamps open
OUT_POS_1 Output BOOL Move gripper to position 

1
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Name Section Data type Comment
OUT_POS_2 Output BOOL Move gripper to position 

2
OUT_GRIPPER Output BOOL Open gripping clamps
OUT_POS_3 Output BOOL Move gripper to position 

3

The following STL program shows how to implement this example: 

STL Explanation
L "NUMBER" // Load the step number to accumulator 1.
JL END // Start of the jump list
JU POSITION_0 // At a value of "0" in the accumulator 1 jump to jump 

label "POSITION_0".
JU POSITION_1 // At a value of "1" in the accumulator 1 jump to jump 

label "POSITION_1".
JU POSITION_2 // At a value of "2" in the accumulator 1 jump to jump 

label "POSITION_2".
JU POSITION_3 // At a value of "3" in the accumulator 1 jump to jump 

label "POSITION_3".
END: JU ERROR // End of the jump list

// At a step number greater than 3 jump to jump label 
"ERROR".

POSITION_0: A #POS_0 // Jump label "POSITION_0"
// Scan to see if gripper is in basic position (P0).

= #OUT_POS_1 // If condition is met, set output "OUT_POS_1" and 
move gripper to position 1 (P1).

JCN ERROR // With RLO "0" jump to jump label "ERROR".
JC NEXT // With RLO "1" jump to jump label "NEXT".
POSITION_1: A #POS_1 // Jump label "POSITION_1"

// Scan to see if gripper is in position 1 (P1).
= #OUT_POS_2 // If condition is met, set output "OUT_POS_2" and 

move gripper to position 2 (P2).
JCN ERROR // With RLO "0" jump to jump label "ERROR".
JC NEXT // With RLO "1" jump to jump label "NEXT".
POSITION_2: A #POS_2 // Jump label "POSITION_2"

// Scan to see if gripper is in position 2 (P2).
= #OUT_GRIPPER // If condition is met, set output "OUT_GRIPPER" and 

open gripping clamps.
JCN ERROR // With RLO "0" jump to jump label "ERROR".
JC NEXT // With RLO "1" jump to jump label "NEXT".
POSITION_3: A #POS_2 // Jump label "POSITION_3"

// Scan to see if gripper is in position 2 (P2).
A #GRIPPER_OPEN // Scan to see if the gripping clamps are open
= #OUT_POS_3 // If condition is met, set output "OUT_POS_3" and 

move gripper to position 3 (P3).
JCN ERROR // With RLO "0" jump to jump label "ERROR".
JC NEXT // With RLO "1" jump to jump label "NEXT".
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STL Explanation
NEXT: INC 1 // Jump label "NEXT"

// Increase step number in accumulator 1 by one.
T "NUMBER" // Transfer step number to operand "NUMBER".
L 3 // Move the current step number to accumulator 2.

// Load value 3 to accumulator 1.
>I // Scan to see if current step number is greater than 

3.
JC RESET_NUMBER // With a scan result "1" jump to jump label 

"RESET_NUMBER" and continue with program processing
BEU // End block
RESET_NUMBER: L 0 // Jump label "RESET_NUMBER"

// Load value "0" in accumulator 1.
T "NUMBER" // Assign value "0" to operands "NUMBER" (step 

number).
BEU // End block
ERROR: NOT // Jump label "ERROR"
= "Tag_Error" // Assign negated RLO to the operand "Tag_Error".
BEU // End block

9.6.4 SCL programming examples

9.6.4.1 Example: Bit logic instructions

Controlling a conveyor belt     
The following figure shows a conveyor belt that can be activated electrically. There are two 
pushbutton switches at the beginning of the conveyor belt: S1 for START and S2 for STOP. 
There are also two pushbutton switches at the end of the conveyor belt: S3 for START and 
S4 for STOP. It is possible to start and stop the conveyor belt from either end.
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Implementation
The following table shows the definition of the tags used:

Operand Declaration Data type Description
StartSwitch_Left (S1) Input BOOL Start switch on the left 

side of the conveyor belt
StopSwitch_Left (S2) Input BOOL Stop switch on the left 

side of the conveyor belt
StartSwitch_Right (S3) Input BOOL Start switch on the right 

side of the conveyor belt
StopSwitch_Right (S4) Input BOOL Stop switch on the right 

side of the conveyor belt
MOTOR_ON Output BOOL Turn on the conveyor 

belt motor
MOTOR_OFF Output BOOL Turn off the conveyor 

belt motor

The following SCL program shows how to implement this task:

SCL
IF "StartSwitch_Left" OR "StartSwitch_Right" = 1 THEN 1 := "MOTOR_ON";
IF "StopSwitch_Left" OR "StopSwitch_Right" = 1 THEN 1 := "MOTOR_OFF";

The conveyor belt motor is switched on when start switch "StartSwitch_Left" or 
"StartSwitch_Right" is pressed. The conveyor belt motor is switched off when stop switch 
"StopSwitch_Left" or "StopSwitch_Right" is pressed.

See also
Logical expressions (Page 1346)
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9.6.4.2 Example of detecting the direction of a conveyor belt

Detecting the direction of a conveyor belt     
The following figure shows a conveyor belt that is equipped with two photoelectric barriers 
(PEB1 and PEB2). The photoelectric barriers are designed to detect the direction in which an 
object is moving on the conveyor belt.

Implementation
The following table shows the definition of the tags used:

Name Declaration Data type Description
LS1 Input BOOL Photoelectric barrier 1
LS2 Input BOOL Photoelectric barrier 2
RIGHT Output BOOL Display for movement 

to the right
LEFT Output BOOL Display for movement 

to the left

The following SCL program shows how to implement this example:

SCL
IF "LS1" = 1 AND NOT "LS2" = 0 THEN 1 := "LEFT";
IF "LS2" = 1 AND NOT "LS1" = 0 THEN 1 := "RIGHT";
IF "LS2" = 0 THEN 0 := "RIGHT";
IF "LS1" = 0 THEN 0 := "LEFT";

If the photoelectric barrier "PEB1" has signal state "1" and the photoelectric barrier "PEB2" 
has signal state "0" at the same time, the object on the belt is moving to the left. If the 
photoelectric barrier "PEB2" has signal state "1" and the photoelectric barrier "PEB1" has signal 
state "0" at the same time, the object on the belt is moving to the right. The displays for a 
movement to the left or right will be turned off when the signal state at both photoelectric 
barriers is "0".
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See also
Logical expressions (Page 1346)

9.6.4.3 Example of detecting the fill level of a storage area 

Detecting the fill level of a storage area   
The following figure shows a system with two conveyor belts and a temporary storage area 
between them. Conveyor belt 1 delivers packages to the storage area. A photoelectric barrier 
at the end of conveyor belt 1 near the storage area detects how many packages are delivered 
to the storage area. Conveyor belt 2 transports packages from the temporary storage area to 
a loading dock onto which the packages are loaded for delivery to customers by truck. A 
photoelectric barrier at the storage area exit detects how many packages leave the storage 
area to be transported to the loading dock. Five display lamps indicate the capacity of the 
temporary storage area.

When a conveyor belt is restarted, the current count value is set to the number of packages 
available in the storage area.

Implementation
The following table shows the definition of the tags used:

Name Declaration Data type Description
PEB1 Input BOOL Photoelectric barrier 1
PEB2 Input BOOL Photoelectric barrier 2
RESET Input BOOL Reset counter
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Name Declaration Data type Description
LOAD Input BOOL Set counter to value of 

"CV" parameter
STOCK Input INT Stock at restart
PACKAGECOUNT Output INT Number of packages in 

the storage area 
(current count value)

STOCK_PACKAGES Output BOOL Is set if the current 
count value is greater 
than or equal to the 
value of the tag 
"STOCK".

STOR_EMPTY Output BOOL Display lamp: Storage 
area empty

STOR_NOT_EMPTY Output BOOL Display lamp: Storage 
area not empty

STOR_50%_FULL Output BOOL Display lamp: Storage 
area 50% full

STOR_90%_FULL Output BOOL Display lamp: Storage 
area 90% full

STOR_FULL Output BOOL Display lamp: Storage 
area full

VOLUME_50 Input INT Comparison value: 50 
packages

VOLUME_90 Input INT Comparison value: 90 
packages

VOLUME_100 Input INT Comparison value: 100 
packages

The following SCL program shows how to implement this example:

When a package is delivered to the storage area, the signal state at "PEB1" switches from "0" 
to "1" (positive signal edge). On a positive signal edge at "PEB1", the "Up" counter is enabled, 
and the current count value of "PACKAGECOUNT" is increased by one.

When a package is delivered from the storage area to the loading dock, the signal state at 
"PEB2" switches from "0" to "1" (positive signal edge). On a positive signal edge at "PEB2", 
the "Down" counter is enabled, and the current count value of "PACKAGECOUNT" is 
decreased by one.

If there are no packages in the storage area ("PACKAGECOUNT" = "0"), the "STOR_EMPTY" 
tag is set to signal state "1", and the "Storage area empty" lamp is switched on.

The current count value can be reset to "0" if the "RESET" tag is set to signal state "1".

If the "LOAD" tag is set to signal state "1", the current count value is set to the value of the 
"STOCK" tag. If the current count value is greater than or equal to the value of the "STOCK" 
tag, the "STOCK_PACKAGES" tag supplies the signal state "1".

SCL
"CTUD_DB".CTUD(CU := "PEB1",
               CD := "PEB2",
               R  := "RESET",
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SCL
               LD := "LOAD",
               PV := "STOCK",
               QU := "STOCK_PACKAGES",
               QD := "STOR_EMPTY",
               CV := "PACKAGECOUNT");

As long as there are packages in the storage area, the "STOR_NOT_EMPTY" tag is set to 
signal state "1", and the "Storage area not empty" lamp is switched on.

SCL
"STOR_NOT_EMPTY" := NOT "STOR_EMPTY"

If the number of packages in the storage area is greater than or equal to 50, the lamp for 
the•"Storage area 50% full" message switches on.

SCL
IF "PACKAGECOUNT" >= "VOLUME_50" THEN "STOR_50%_FULL" := 1;
IF "PACKAGECOUNT" <= "VOLUME_90" THEN "STOR_50%_FULL" := 1;

If the number of packages in the storage area is greater than or equal to 90, the "Storage area 
90% full" lamp switches on.

SCL
IF "PACKAGECOUNT" >= "VOLUME_90" THEN "STOR_90%_FULL" := 1;
IF "PACKAGECOUNT" <= "VOLUME_100" THEN "STOR_90%_FULL" := 1;

If the number of packages in the storage area reaches 100, the lamp for the "Storage area 
full" message switches on.

SCL
IF "PACKAGECOUNT" >= "VOLUME_100" THEN "STOR_FULL" := 1;

See also
Logical expressions (Page 1346)
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9.7 References

9.7.1 General parameters of the instructions

9.7.1.1 Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous instructions

Asynchronous instructions
For instructions that work asynchronously, the function is executed with several calls.

Identification of the job
If you use asynchronous instructions to trigger a process interrupt, output control commands 
to DP slaves, start a data transfer, or abort a non-configured connection with one of the SFCs 
listed above and then call the same SFC again before the current job is completed, then the 
reaction of the SFC will depend on whether the second call involves the same job. 

Parameter REQ
The input parameter REQ (request) is used solely to start the job:

● If you call the instruction for a job that is not currently active, the job is started with REQ = 
1 (case 1).

● If a particular job has been started and not yet completed and you call the instruction again 
to perform the same job (for example, in a cyclic interrupt OB), then REQ is not evaluated 
by the instruction (case 2).

Parameter RET_VAL and BUSY
The output parameters RET_VAL and BUSY indicate the status of the job. 

Pay attention to the note in section: Evaluating errors with output parameter RET_VAL 
(Page 1584) 

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1582 System Manual, 07/2013,  



● In case 1 (first call with REQ=1), the input parameter will be entered in 
RET_VALW#16#7001 if system resources are available and supply is correct. BUSY will 
be set.
If the required system resources are currently being used or the input parameters have 
errors, the corresponding error code is entered in RET_VAL and BUSY has the value 0.

● In case 2 (interim call) W#16#7002 will be entered in RET_VAL (this corresponds to a 
warning: Job still being processed!), and BUSY will be set.

● The following applies to the last call for a job:

– For instruction "DPNRM_DG (Page 2378)", the number of data in bytes will entered as 
integer in RET_VAL in case there are no errors in data transmission. BUSY has the 
value "0" in this case.
If there is an error, then the error information will be entered in RET_VAL and you should 
not evaluate BUSY in this case.

– For all other instructions, "0" will be entered in RET_VAL if the job was executed without 
errors and BUSY has the value "0" in this case. If there is an error, the error code is 
entered in RET_VAL and BUSY has the value "0" in this case.

 

  Note

If the first and last call coincide, the reaction is the same for RET_VAL and BUSY as 
described for the last call.

 

Overview
The following table provides you with an overview of the relationships explained above. In 
particular, it shows the possible values of the output parameters if the execution of the job is 
not completed after an instruction call has been completed. 

 

 Note

Following every call, you must evaluate the relevant output parameters in your program.
 

Relationship between call, REQ, RET_VAL and BUSY during execution of a "running" job.

Number of the 
call

Type of call REQ RET_VAL BUSY

1 First call 1 W#16#7001 1
   Error code 0
2 to (n - 1) Intermediate call irrelevant W#16#7002 1
n Last call irrelevant W#16#0000, if no errors have occurred. 0
   Error code if errors occurred 0
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9.7.1.2 Evaluating errors with output parameter RET_VAL

Types of error information 
An executed instruction indicates in the user program whether or not the CPU was able to 
execute the function of the instruction successfully. 

You can obtain information about any errors that occurred in two ways:

● In the BR bit of the status word

● in the output parameter RET_VAL (return value).
 

  Note

Before evaluating the output parameters specific to an instruction, you should always 
follow the steps below:
● First, evaluate the BR bit of the status word.
● Then check the output parameter RET_VAL.

If the BR bit indicates that an error has occurred or if RET_VAL contains a general error 
code, you should not evaluate the instruction-specific output parameters.

 

Error information in the return value
An instruction indicates that an error occurred during its execution by entering the value "0" in 
the binary result bit (BR) of the status word. Some instructions provide an additional error code 
at an output parameter known as the return value (RET_VAL). If a general error is entered in 
the output parameter RET_VAL (see below for explanation), this is only indicated by the value 
"0" in the BR bit of the status word. 

The return value is of the data type integer (INT). The relationship of the return value to the 
value "0" indicates whether or not an error occurred during execution of the function. 

CPU execution of the 
instruction

BR Return value Sign of the integer

With error(s) 0 less than "0" negative 
(sign bit is "1") 

Without error 1 greater than or
 equal to "0"

positive 
(sign bit is "0")

Reacting to error information
There are two types of error codes in RET_VAL:

● A general error code that all instructions can output and

● A specific error code that an instruction can output and which relates to its specific function.

You can write your program so that it reacts to the errors that occur during execution of an 
instruction. This way you prevent further errors occurring as a result of the first error.
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General and specific error information
The return value (RET_VAL) of an instruction provides one of the two following types of error 
codes:

● A general error code that relates to errors that can occur in any instruction.

● A specific error code that relates only to the particular instruction.

Even though the data type of the output parameter RET_VAL is an integer (INT), the error 
codes for the instruction are grouped according to hexadecimal values. If you want to examine 
a return value and compare the value with the error codes listed in this documentation, then 
display the error code in hexadecimal format.

The figure below shows the structure of a system function error code in hexadecimal format.

General error information
The general error code indicates errors that can occur in all instructions. A general error code 
consists of the following two numbers:

● A parameter number from 1 to 111, where 1 indicates the first parameter of the called 
instruction, 2 the second parameter, and so forth.

● An event number from 0 to 127. The event number indicates that a synchronous error 
occurred.

The following table lists the codes for general errors and an explanation of each error.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1585



 

 Note

If a general error code was entered in RET_VAL, then the following situations are possible:
● The action associated with the instruction may have been started or already completed.
● A specific instruction error may have occurred when the action was performed. As a result 

of a general error that occurred later, the specific error could, however, no longer be 
indicated.

 

Specific error information
Some instructions have a return value that provides an error code specific for the instruction. 
A specific error code indicates errors that can occur only in specific instructions.

A specific error code consists of the following two numbers: 

● An error class from 0 to 7.

● An error number from 0 to 15.

General error codes
The following table explains the general error codes of a return value. The error code is shown 
in hexadecimal format. The letter x in each code number is simply a place holder and 
represents the number of the system function parameter that caused the error.

General error codes

Error code

(W#16#...)

Explanation

8x7F Internal error
This error code indicates an internal error at parameter x.

8x01 Illegal syntax ID at an VARIANT parameter
8x22 Range length error when reading a parameter.
8x23 Range length error when writing a parameter.

This error code indicates that the parameter x is located either entirely or partly outside 
the range of an address, or that the length of a bit range is not a multiple of 8 with an 
VARIANT parameter.

8x24 Range error when reading a parameter.
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Error code

(W#16#...)

Explanation

8x25 Range error when writing a parameter.
This error code indicates that the parameter x is located in a range that is illegal for 
the system function. Refer to the descriptions of the individual functions for information 
about the illegal ranges.

8x26 The parameter contains a timer cell number that is too high.
This error code indicates that the timer cell specified in parameter x does not exist.

8x27 The parameter contains a counter cell number that is too high (counter number error).
This error code indicates that the counter cell specified in parameter x does not exist.

8x28 Alignment error when reading a parameter.
8x29 Alignment error when writing a parameter.

This error code indicates that the reference to parameter x is an operand with bit 
address that is not equal to 0.

8x30 The parameter is located in a read-only global DB.
8x31 The parameter is located in a read-only instance DB.

This error code indicates that parameter x is located in a read-only data block. If the 
data block was opened by the system function itself, the system function always 
returns the value W#16#8x30.

8x32 The parameter contains a DB number that is too high (DB number error).
8x34 The parameter contains an FC number that is too high (FC number error).
8x35 The parameter contains an FB number that is too high (FB number error).

This error code indicates that parameter x contains a block number higher than the 
highest permitted number.

8x3A The parameter contains the number of a DB that is not loaded.
8x3C The parameter contains the number of an FC that is not loaded.
8x3E The parameter contains the number of an FB that is not loaded.
8x42 An access error occurred while the system was attempting to read a parameter from 

the peripheral input area.
8x43 An access error occurred while the system was attempting to write a parameter to the 

peripheral output area.
8x44 Error in the nth (n > 1) read access after an error occurred.
8x45 Error in the nth (n > 1) write access after an error occurred.

This error code indicates that access to the required parameter is denied.
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9.7.2 Basic instructions

9.7.2.1 LAD

Bit logic operations

---|   |---: Normally open contact

Description   
The activation of the normally open contact depends on the signal state of the associated 
operand. When the operand has signal state "1", the normally open contact closes and the 
signal state at the output is set to the signal state of the input.

When the operand has signal state "0", the normally open contact is not activated and the 
signal state at the output of the instruction is reset to "0".

Two or more normally open contacts are linked bit-by-bit by AND when connected in series. 
With a series connection, power flows when all contacts are closed.

The normally open contacts are linked by OR when connected in parallel. With a parallel 
connection, power flows when one of the contacts is closed.

Parameter
The following table shows the parameters of the instruction:

Paramete
r

Declaratio
n

Data 
type

Memory area Description
S7-1200 S7-1500

<Operan
d>

Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Operand whose 
signal state is 
queried.

Example
The following example shows how the instruction works:

The "TagOut" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "1".
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See also
Overview of the valid data types (Page 1077)

---| / |---: Normally closed contact

Description   
The activation of the normally closed contact depends on the signal state of the associated 
operand. When the operand has signal state "1", the normally closed contact opens and the 
signal state at the output of the instruction is reset to "0".

When the operand has signal state "0", the normally closed contact is not enabled and the 
signal state of the input is transferred to the output.

Two or more normally closed contacts are linked bit-by-bit by AND when connected in series. 
With a series connection, power flows when all contacts are closed.

The normally closed contacts are linked by OR when connected in parallel. With a parallel 
connection, power flows when one of the contacts is closed.

Parameter
The following table shows the parameters of the instruction:

Parameter Declaratio
n

Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Operand 
whose signal 
state is 
queried.

Example
The following example shows how the instruction works:

The "TagOut" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "0".
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See also
Overview of the valid data types (Page 1077)

--|NOT|--: Invert RLO

Description       
You use the "Invert RLO" instruction to invert the signal state of the result of logic operation 
(RLO). If the signal state is "1" at the input of the instruction, the output of the instruction has 
signal state "0". If the signal state is "0" at the input of the instruction, the output has the signal 
state "1".

Example
The following example shows how the instruction works:

Operand "TagOut" is reset when one of the following conditions is fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The signal state of the operands "TagIn_2" and "TagIn_3" is "1".

---(   )---: Assignment

Description     
You can use the "Assignment" instruction to set the bit of a specified operand. If the result of 
logic operation (RLO) at the input of the coil has signal state "1", the specified operand is set 
to signal state "1". If the signal state is "0" at the input of the coil, the bit of the specified operand 
is reset to "0".

The instruction does not influence the RLO. The RLO at the input of the coil is sent directly to 
the output.
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Parameter
The following table shows the parameters of the "Assignment" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand to which 

the RLO is 
assigned.

Example
The following example shows how the instruction works:

The "TagOut_1" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The signal state of the operand "TagIn_3" is "0".

The "TagOut_2" operand is set when one of the following conditions is fulfilled:

● Operands "TagIn_1", "TagIn_2", and "TagIn_4" have signal state "1".

● The signal state of the "TagIn_3" operand is "0" and the signal state of the "TagIn_4" 
operand is "1".

See also
Overview of the valid data types (Page 1077)

--( / )--: Negate assignment

Description     
The "Negate assignment" instruction inverts the result of logic operation (RLO) and assigns it 
to the specified operand. When the RLO at the input of the coil is "1", the operand is reset. 
When the RLO at the input of the coil is "0", the operand is set to signal state "1".
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Parameter
The following table shows the parameters of the "Negate assignment" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand to which 

the RLO is 
assigned.

Example
The following example shows how the instruction works:

Operand "TagOut_1" is reset when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The signal state of the operand "TagIn_3" is "0".

See also
Overview of the valid data types (Page 1077)

---( R )---: Reset output

Description     
You can use the "Reset output" instruction to reset the signal state of a specified operand to 
"0".

The instruction is only executed if the result of logic operation (RLO) at the input of the coil is 
"1". If power flows to the coil (RLO = "1"), the specified operand is reset to "0". If the RLO at 
the input of the coil is "0" (no signal flow to the coil), the signal state of the specified operand 
remains unchanged.
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Parameter
The following table shows the parameters of the "Reset output" instruction:

Parameter Declaration Data type Memory area  
S7-1200 S7-1500 Description

<Operand> Output BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Operand that 
is reset when 
RLO = "1".

Example
The following example shows how the instruction works:

Operand "TagOut" is reset when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The signal state of the operand "TagIn_3" is "0".

See also
Overview of the valid data types (Page 1077)

---( S )---: Set output

Description     
You can use the "Set output" instruction to set the signal state of a specified operand to "1".

The instruction is only executed if the result of logic operation (RLO) at the input of the coil is 
"1". If power flows to the coil (RLO = "1"), the specified operand is set to "1". If the RLO at the 
input of the coil is "0" (no signal flow to the coil), the signal state of the specified operand 
remains unchanged.

Parameter
The following table shows the parameters of the "Set output" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand which is 

set with RLO = "1".
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Example
The following example shows how the instruction works:

The "TagOut" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The signal state of the operand "TagIn_3" is "0".

See also
Overview of the valid data types (Page 1077)

SET_BF: Set bit field

Description       
You use the instruction "Set bit field" to set multiple bits starting from a certain address.

You determine the number of bits to be set using the value of <Operand1>. The address of 
the first bit to be set is defined by <Operand2>. If the value of <Operand1> is greater than the 
number of bits in a selected byte, then the bits of the next byte will be set. The bits remain set 
until they are explicitly reset, for example, by another instruction.

The instruction is only executed if the result of logic operation (RLO) at the input of the coil is 
"1". If the RLO at the input of the coil is "0", the instruction does not execute.

Parameter
The following table shows the parameters of the "Set bit field" instruction:

Parameter Declaration Data type Memory area Description
<Operand2> Output BOOL I, Q, M

In the case of a DB 
or an IDB, an 
element of an 
ARRAY[..] of 
BOOL

Pointer to the first 
bit to be set.

<Operand1> Input UINT Constant Number of bits to 
be set.
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Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", 5 bits are set starting at the 
address of the operand "MyDB".MyBoolArray[4]

See also
Overview of the valid data types (Page 1077)

RESET_BF: Reset bit field

Description       
You use the "Reset bit field" instruction to reset several bits starting from a certain address.

You specify the number of bits to be reset using the value of <Operand1>. The address of the 
first bit to be reset is specified by <Operand2>. If the value of <Operand1> is greater than the 
number of bits in a selected byte, the bits of the next byte will be reset. The bits remain reset 
until they are explicitly set, for example, by another instruction.

The instruction is only executed if the result of logic operation (RLO) at the input of the coil is 
"1". If the RLO at the input of the coil is "0", the instruction does not execute.

Parameter
The following table shows the parameters of the "Reset bit field" instruction:

Parameter Declaration Data type Memory area Description
<Operand2> Output BOOL I, Q, M

In the case of a DB 
or an IDB, an 
element of an 
ARRAY[..] of 
BOOL

Pointer to the first 
bit to be reset.

<Operand1> Input UINT Constant Number of bits to 
be reset.

Example
The following example shows how the instruction works:
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If the operands "TagIn_1" and "TagIn_2" have the signal state "1", 5 bits are reset starting at 
the address of the operand "MyDB".MyBoolArray[4]

See also
Overview of the valid data types (Page 1077)

SR: Set/reset flip-flop

Description       
Use the instruction "Set/reset flip-flop" to set or reset the bit of the specified operand, depending 
on the signal state of the inputs S and  R1. If the signal state is "1" at input S and "0" at input 
R1, the specified operand is set to "1". If the signal state is "0" at input S and "1" at input R1, 
the specified operand will be reset to "0".

Input R1 takes priority over input S. When the signal state is "1" on both inputs S and R1, the 
signal state of the specified operand is reset to "0".

The instruction is not executed if the signal state at the two inputs S and R1 is "0". The signal 
state of the operand then remains unchanged.

The current signal state of the operand is transferred to output Q and can be queried there.

Parameter
The following table shows the parameters of the "Set/reset flip-flop" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

S Input BOOL I, Q, M, D, L I, Q, M, D, L Enable setting
R1 Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 

C
Enable 
resetting

<Operand> InOut BOOL I, Q, M, D, L I, Q, M, D, L Operand that 
is set or reset.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Signal state of 
the operand

Example
The following example shows how the instruction works:
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The operands "TagSR" and "TagOut" are set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The operand "TagIn_2" has the signal state "0".

The operands "TagSR" and "TagOut" are reset when one of the following conditions is fulfilled:

● The operand "TagIn_1" has signal state "0" and the operand "TagIn_2" has signal state "1".

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

See also
Overview of the valid data types (Page 1077)

RS: Reset/set flip-flop

Description       
You can use the "Reset/set flip-flop" instruction to reset or set the bit of a specified operand 
based on the signal state of the inputs R and S1. If the signal state is "1" at input R and "0" at 
input S1, the specified operand will be reset to "0". If the signal state is "0" at input R and "1" 
at input S1, the specified operand is set to "1".

Input S1 takes priority over input R. When the signal state is "1" at both inputs R and S1, the 
signal state of the specified operand is set to "1".

The instruction is not executed if the signal state at the two inputs R and S1 is "0". The signal 
state of the operand then remains unchanged.

The current signal state of the operand is transferred to output Q and can be queried there.

Parameter
The following table shows the parameters of the "Reset/set flip-flop" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

R Input BOOL I, Q, M, D, L I, Q, M, D, L Enable 
resetting

S1 Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable setting

<Operand> InOut BOOL I, Q, M, D, L I, Q, M, D, L Operand that 
is reset or set.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Signal state of 
the operand
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Example
The following example shows how the instruction works:

The operands "TagRS" and "TagOut" are reset when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The operand "TagIn_2" has the signal state "0".

The operands "TagRS" and "TagOut" are set when one of the following conditions is fulfilled:

● The operand "TagIn_1" has signal state "0" and the operand "TagIn_2" has signal state "1".

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

See also
Overview of the valid data types (Page 1077)

--|P|--: Scan operand for positive signal edge

Description
You can use the "Scan operand for positive signal edge" instruction to determine if there is a 
"0" to "1" change in the signal state of a specified operand (<Operand1>). The instruction 
compares the current signal state of <Operand1> with the signal state of the previous scan 
that is saved in an edge memory bit (<Operand2>). If the instruction detects a change in the 
result of logic operation (RLO) from "0" to "1", there is a positive, rising edge.

If a positive edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

Specify the operand to be queried (<Operand1>) in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.
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Parameter
The following table shows the parameters of the "Scan operand for positive signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Signal to be 
scanned

<Operand2> InOut BOOL I, Q, M, D, L I, Q, M, D, L Edge memory bit 
in which the 
signal state of 
the previous 
query is saved.

Example
The following example shows how the instruction works:

Operand "TagOut" is set when the following conditions are fulfilled:

● The operands "TagIn_1", "TagIn_2", and "TagIn_3" have signal state "1".

● There is a rising edge at operand "TagIn_4". The signal state of the previous scan is stored 
in the edge memory bit "Tag_M".

● The signal state of the operand "TagIn_5" is "1".

See also
Overview of the valid data types (Page 1077)

--|N|--: Scan operand for negative signal edge

Description
You can use the "Scan operand for negative signal edge" instruction to determine if there is a 
"1" to "0" change in the signal state of a specified operand (<Operand1>). The instruction 
compares the current signal state of <Operand1> with the signal state of the previous scan 
that is saved in an edge memory bit <Operand2>. If the instruction detects a change in the 
result of logic operation (RLO) from "1" to "0", there is a negative, falling edge.

If a negative signal edge is detected, the output of the instruction has the signal state "1". In 
all other cases, the signal state at the output of the instruction is "0".
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Specify the operand to be queried (<Operand1>) in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Scan operand for negative signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1
>

Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Signal to be 
scanned

<Operand2
>

InOut BOOL I, Q, M, D, L I, Q, M, D, L Edge memory bit 
in which the 
signal state of the 
previous query is 
saved.

Example
The following example shows how the instruction works:

Operand "TagOut" is set when the following conditions are fulfilled:

● The operands "TagIn_1", "TagIn_2", and "TagIn_3" have signal state "1".

● There is a negative signal edge at operand "TagIn_4". The signal state of the previous scan 
is stored in the edge memory bit "Tag_M".

● The signal state of the operand "TagIn_5" is "1".

See also
Overview of the valid data types (Page 1077)
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--(P)--: Set operand on positive signal edge

Description
You can use the "Set operand on positive signal edge" instruction to set a specified operand 
(<Operand1>) when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO with the RLO from the previous query, which is saved 
in the edge memory bit (<Operand2>). If the instruction detects a change in the RLO from "0" 
to "1", there is a positive signal edge.

When a positive signal edge is detected, <Operand1> is set to signal state "1" for one program 
cycle. In all other cases, the operand has the signal state "0".

Specify the operand to be set (<Operand1>) in the operand placeholder above the instruction. 
Specify the edge memory bit (<Operand2>) in the operand placeholder below the instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Set operand on positive signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
<Operand1> Output BOOL I, Q, M, D, L Operand which is 

set by a positive 
edge.

<Operand2> InOut BOOL I, Q, M, D, L Edge memory bit

Example
The following example shows how the instruction works:

Operand "TagOut" is set for one program cycle, when the signal state at the input of the coil 
switches from "0" to "1" (positive signal edge). In all other cases, the operand "TagOut" has 
the signal state "0".
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See also
Overview of the valid data types (Page 1077)

--(N)--: Set operand on negative signal edge

Description
You can use the "Set operand on negative signal edge" instruction to set a specified operand 
(<Operand1>) when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO with the RLO from the previous query, which is saved 
in the edge memory bit (<Operand2>). If the instruction detects a change in the RLO from "1" 
to "0", there is a negative edge.

When a negative signal edge is detected, <Operand1> is set to signal state "1" for one program 
cycle. In all other cases, the operand has the signal state "0".

Specify the operand to be set (<Operand1>) in the operand placeholder above the instruction. 
Specify the edge memory bit (<Operand2>) in the operand placeholder below the instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Set operand on negative signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
<Operand1> Output BOOL I, Q, M, D, L Operand which is 

set by a negative 
edge.

<Operand2> InOut BOOL I, Q, M, D, L Edge memory bit

Example
The following example shows how the instruction works:
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Operand "TagOut" is set for one program cycle, when the signal state at the input of the coil 
switches from "1" to "0" (negative signal edge). In all other cases, the operand "TagOut" has 
the signal state "0".

See also
Overview of the valid data types (Page 1077)

P_TRIG: Scan RLO for positive signal edge

Description
Use the "Scan RLO for positive signal edge" instruction to query a "0" to "1" change in the 
signal state of the result of logic operation (RLO). The instruction compares the current signal 
state of the RLO with the signal state of the previous query, which is saved in an edge memory 
bit (<operand>). If the instruction detects a change in the RLO from "0" to "1", there is a positive 
signal edge.

If a positive edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Scan RLO for positive signal edge" instruction:

Parameter Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L Current RLO
<Operand> InOut BOOL M, D Edge memory bit 

in which the RLO 
of the previous 
query is saved.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation
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Example
The following example shows how the instruction works:

The RLO of the previous query is saved in the edge memory bit "Tag_M". If a "0" to "1" change 
is detected in the signal state of the RLO, the program jumps to jump label CAS1.

See also
Overview of the valid data types (Page 1077)

N_TRIG: Scan RLO for negative signal edge

Description
Use the "Scan RLO for negative signal edge" instruction to query a "1" to "0" change in the 
signal state of the result of logic operation (RLO). The instruction compares the current signal 
state of the RLO with the signal state of the previous query, which is saved in an edge memory 
bit (<operand>). If the instruction detects a change in the RLO from "1" to "0", there is a negative 
edge.

If a negative signal edge is detected, the output of the instruction has the signal state "1". In 
all other cases, the signal state at the output of the instruction is "0".

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.
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Parameter
The following table shows the parameters of the "Scan RLO for negative signal edge" 
instruction:

Parameters Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L Current RLO
<Operand> InOut BOOL M, D Edge memory bit 

in which the RLO 
of the previous 
query is saved.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the previous query is saved in the edge memory bit "Tag_M". If a "1" to "0" change 
is detected in the signal state of the RLO, the program jumps to jump label CAS1.

See also
Overview of the valid data types (Page 1077)

R_TRIG: Set tag on positive signal edge

Description
You can use the "Set tag on positive signal edge" instruction to set a specified tag in the 
instance DB when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the RLO 
from "0" to "1", there is a positive signal edge.

If a positive edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
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separate data block, you will find it in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Parameter
The following table shows the parameters of the instruction "Set tag on positive signal edge":

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
CLK Input BOOL I, Q, M, D, L or 

constant
Incoming signal, 
the edge of which 
is to be queried.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the preceding query is saved in the instance DB "R_TRIG_DB". If a change is the 
signal state of the RLO from "0" to "1" is detected in the operands "TagIn_1" and "TagIn_2" or 
in the operand "TagIn_3", the output "TagOut_Q" has signal state "1".

See also
Overview of the valid data types (Page 1077)

F_TRIG: Set tag on negative signal edge

Description
You can use the "Set tag on negative signal edge" instruction to set a specified tag in the 
instance DB when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the RLO 
from "1" to "0", there is a negative edge.
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If a negative edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find it in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Parameter
The following table shows the parameters of the instruction "Set tag on negative signal edge":

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
CLK Input BOOL I, Q, M, D, L or 

constant
Incoming signal, 
the edge of which 
is to be queried.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the preceding query is saved in the instance DB "F_TRIG_DB". If a change is the 
signal state of the RLO from "1" to "0" is detected in the operands "TagIn_1" and "TagIn_2" or 
in the operand "TagIn_3", the output "TagOut_Q" has signal state "1".

See also
Overview of the valid data types (Page 1077)
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Timer operations

IEC Timers

TP: Generate pulse

Description
You can use the "Generate pulse" instruction to set the output Q for a programmed duration. 
The instruction is started when the result of logic operation (RLO) at input IN changes from "0" 
to "1" (positive signal edge). The programmed time PT begins when the instruction starts. 
Output Q is set for the duration PT, regardless of the subsequent course of the input signal. 
Even if a new positive signal edge is detected, the signal state at the output Q is not affected 
as long as the PT time duration is running.

You can scan the current time value at the ET output. The time value starts at T#0s and ends 
when the value of duration PT is reached. When the duration PT is reached and the signal 
state at input IN is "0", the ET output is reset.

Each call of the "Generate pulse" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, the ET output 
returns a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC timer is a structure of the data type IEC_TIMER or TP_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME or IEC_TIMER in the "Static" 
section of a block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TP_TIME or TP_LTIME 
that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
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it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate pulse" instruction requires a preceding logic operation. It can 
be placed within or at the end of the network.

Parameter
The following table shows the parameters of the "Generate pulse" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Start input

PT Input TIME TIME, LTIME I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Duration of 
the pulse.
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Pulse output

ET Output TIME TIME, LTIME I, Q, M, D, 
L

I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1609



Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate pulse" instruction:

See also
Overview of the valid data types (Page 1077)

TON: Generate on-delay

Description
You can use the "Generate on-delay" instruction to delay setting of the Q output by the 
programmed duration PT. The instruction is started when the result of logic operation (RLO) 
at input IN changes from "0" to "1" (positive signal edge). The programmed time PT begins 
when the instruction starts. When the duration PT expires, the output Q has the signal state 
"1". Output Q remains set as long as the start input is still "1". When the signal state at the 
start input changes from "1" to "0", the Q output is reset. The timer function is started again 
when a new positive signal edge is detected at the start input.

The current time value can be queried at the ET output. The time value starts at T#0s and 
ends when the value of duration PT is reached. The ET output is reset as soon as the signal 
state at the IN input changes to "0".

Each call of the "Generate on-delay" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, the ET output 
returns a constant value as soon as the timer has expired.
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For S7-1200 CPU
An IEC timer is a structure of the data type IEC_TIMER or TON_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TON_TIME or 
TON_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME, TON_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate on-delay" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameter
The following table shows the parameters of the "Generate on-delay" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Start input

PT Input TIME TIME, LTIME I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Duration of 
the on-delay
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Output that 
is set when 
the time PT 
expires.

ET Output TIME TIME, LTIME I, Q, M, D, 
L

I, Q, M, D, L, 
P

Current time 
value
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For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate on-delay" instruction:

See also
Overview of the valid data types (Page 1077)

TOF: Generate off-delay

Description
You can use the "Generate off-delay" instruction to delay resetting of the Q output by the 
programmed duration PT. The Q output is set when the result of logic operation (RLO) at input 
IN changes from "0" to "1" (positive signal edge). When the signal state at input IN changes 
back to "0", the programmed time PT starts. Output Q remains set as long as the duration PT 
is running. When duration PT expires, the Q output is reset. If the signal state at input IN 
changes to "1" before the PT time duration expires, the timer is reset. The signal state at the 
output Q continues to be "1".

The current time value can be queried at the ET output. The time value starts at T#0s and 
ends when the value of duration PT is reached. When the time duration PT expires, the ET 
output remains set to the current value until the IN input changes back to "1". If input IN switches 
to "1" before the duration PT has expired, the ET output is reset to the value T#0s.
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Each call of the "Generate off-delay" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, the ET output 
returns a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC timer is a structure of the data type IEC_TIMER or TOF_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TOF_TIME or 
TOF_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME, TOF_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate off-delay" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.
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Parameter
The following table shows the parameters of the "Generate off-delay" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Start input

PT Input TIME TIME, LTIME I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Duration of 
the off delay
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Output that 
is reset 
when the 
timer PT 
expires.

ET Output TIME TIME, LTIME I, Q, M, D, 
L

I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate off-delay" instruction:

See also
Overview of the valid data types (Page 1077)
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TONR: Time accumulator

Description
The "Time accumulator" instruction is used to accumulate time values within a period set by 
the PT parameter. When the signal state at input IN changes from "0" to "1" (positive signal 
edge), the instruction executes and the duration PT starts. While the duration PT is running, 
the time values are accumulated that are recorded when the IN input has signal state "1". The 
accumulated time is written to output ET and can be queried there. When the duration PT 
expires, the output Q has the signal state "1". The Q parameter remains set to "1", even when 
the signal state at the IN parameter changes from "1" to "0" (negative signal edge).

The R input resets the outputs ET and Q regardless of the signal state at the start input.

Each call of the "Time accumulator" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC timer is a structure of the data type IEC_TIMER or TONR_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or IEC_TIMER in the "Static" section of 
a block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TONR_TIME or 
TONR_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME, TONR_LTIME, IEC_TIMER or 
IEC_LTIMER in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the Time accumulator" instruction requires a preceding logic operation. It can 
be placed within or at the end of the network.
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Parameter
The following table shows the parameters of the "Time accumulator" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Start input

R Input BOOL BOOL I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Reset input

PT Input TIME TIME, LTIME I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Maximum 
duration of 
time 
recording
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Output that 
is set when 
the time PT 
expires.

ET Output TIME TIME, LTIME I, Q, M, D, 
L

I, Q, M, D, L, 
P

Accumulated
 time

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Time accumulator" instruction:

See also
Overview of the valid data types (Page 1077)

---( TP )---: Start pulse timer

Description
Use the "Start pulse timer" instruction to start an IEC timer with a specified duration as pulse. 
The IEC timer is started when the result of logic operation (RLO) changes from "0" to "1" 
(positive signal edge). The IEC timer runs for the specified duration regardless of any 
subsequent changes in the RLO. The run of the IEC timer is also not affected by the detection 
of a new positive signal edge. As long as the IEC timer is running, the querying of the timer 
status for "1" returns the signal state "1". When the IEC timer has expired, the timer status 
returns the signal state "0".

 

 Note

You can start and query the IEC timer at various execution levels, as each querying of the 
outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start pulse timer" stores its data in a structure of the data type IEC_TIMER or 
TP_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TP_LTIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The instruction "Start pulse timer" stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TP_TIME or TP_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
assigned timer is accessed.

The current timer status is stored in the Q structure component of the IEC timer. You can use 
a normally open contact to query timer status for "1" or a normally closed contact for "0". The 
query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER 
structure.

The execution of the "Start pulse timer" instruction assumes a preceding logic operation. It can 
be placed only at the end of the network.

Parameter
The following table shows the parameters of the "Start pulse timer" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> InOut IEC_TIMER, 
TP_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME

D, L IEC timer that 
is started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start pulse timer" instruction is executed when the signal state of the operand "Tag_Input" 
changes from "0" to "1". The timer "DB1".MyIEC_TIMER is started for the time stored in the 
operand "TagTime".

As long as the timer "DB1". MyIEC_TIMER is running, the timer status 
("DB1".MyIEC_TIMER.Q) has signal state "1" and the operand "Tag_Output" is set. When the 
IEC timer has expired, the signal state of the time status changes back to "0" and the 
"Tag_Output" operand is reset.

See also
Overview of the valid data types (Page 1077)

---( TON )---: Start on-delay timer

Description
Use the "Start on-delay timer" instruction to start an IEC timer with a specified duration as on-
delay. The IEC timer is started when the result of logic operation (RLO) changes from "0" to 
"1" (positive signal edge). The IEC timer runs for the specified time. The output returns the 
signal state "1" if the RLO at the input of the instruction has the signal state "1". If the RLO 
changes to "0" before the time expires, the IEC timer is reset. In this case, querying the timer 
status for "1" returns signal state "0". The IEC timer restarts when the next positive signal edge 
is detected at the input of the instruction.

 

 Note

You can start and query the IEC timer at various execution levels, as each querying of the 
outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start on-delay timer" stores its data in a structure of the data type IEC_TIMER 
or TON_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Start on-delay timer" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TON_TIME or TON_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME, TON_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
assigned timer is accessed.

The current timer status is stored in the ET structure component of the IEC timer. You can use 
a normally open contact to query timer status for "1" or a normally closed contact for "0". The 
query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER 
structure.

The execution of the "Start on-delay timer" instruction assumes a preceding logic operation. 
It can be placed only at the end of the network.

Parameter
The following table shows the parameters of the "Start on-delay timer" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> InOut IEC_TIMER, 
TON_TIME

IEC_TIMER, 
IEC_LTIMER, 
TON_TIME, 
TON_LTIME

D, L IEC timer that 
is started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start on-delay timer" instruction is executed when the signal state of the operand 
"Tag_Input" changes from "0" to "1". The "MyIEC_TIMER timer is started for the time stored 
in the "TagTime" operand.

If the timer "MyIEC_TIMER" has expired and the operand "Tag_Input" has the signal state "1", 
querying the timer status ("MyIEC_TIMER).Q) returns signal state "1" and the "Tag_Output" 
operand is set. When the signal state of the operand "Tag_Input" changes to "0", the querying 
of the timer status returns the signal state "0" and the operand "Tag_Output" is reset.

See also
Overview of the valid data types (Page 1077)

---( TOF )---: Start off-delay timer

Description
Use the "Start off-delay timer" instruction to start an IEC timer with a specified duration as on-
delay. The query of the timer status for "1" returns the signal state "0" if the result of logic 
operation (RLO) at the input of the instruction has the signal state "1". When the RLO changes 
from "1" to "0" (negative signal edge), the IEC timer starts with the specified time. The timer 
status remains at signal state "1" as long as the IEC timer is running. When the timer has run 
out and the RLO at the input of the instruction has the signal state "0", the timer status is set 
to the signal state "0". If the RLO changes to "1" before the time expires, the IEC timer is reset 
and the timer status remains at signal state "1".

 

 Note

You can start and query the IEC timer at various execution levels, as each querying of the 
outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start off-delay timer" stores its data in a structure of the data type IEC_TIMER 
or TOF_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Start off-delay timer" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TOF_TIME or TOF_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME, TOF_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
assigned timer is accessed.

The current timer status is stored in the ET structure component of the IEC timer. You can use 
a normally open contact to query timer status for "1" or a normally closed contact for "0". The 
query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER 
structure.

The execution of the "Start off-delay timer" instruction assumes a preceding logic operation. 
It can be placed only at the end of the network.

Parameters
The following table shows the parameters of the "Start off-delay timer" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> InOut IEC_TIMER, 
TOF_TIME

IEC_TIMER, 
IEC_LTIMER, 
TOF_TIME, 
TOF_LTIME

D, L IEC timer that 
is started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start off-delay timer" instruction is executed when the signal state of the operand 
"Tag_Input" changes from "1" to "0". The timer #MyIEC_TIMER is started for the time stored 
in the operand "TagTime".

As long as timer #MyIEC_TIMER is running, the query of the time status (#MyIEC_TIMER.Q) 
returns the signal state "1" and operand "Tag_Output" is set. If the timer has expired and the 
operand "Tag_Input" has the signal state "0", the query of the timer status returns the signal 
state "0". If the signal state of the operand "Tag_Input" changes to "1" before timer 
#MyIEC_TIMER expires, the timer is reset. When the signal state of the operand "Tag_Input" 
is "1", the query of the timer status returns the signal state "1".

See also
Overview of the valid data types (Page 1077)

---( TONR )---: Time accumulator

Description
You can use the "Time accumulator" instruction to record how long the signal is at the input 
of instruction "1". The instruction is started when the result of logic operation (RLO) changes 
from "0" to "1" (positive signal edge). The time is recorded as long at the RLO is "1". If the RLO 
changes to "0", the instruction is halted. If the RLO changes back to "1", the time recording is 
continued. The query of the timer status for "1" returns the signal state "1" if the recorded time 
exceeds the value of the specified duration and the RLO at the input of coil is "1".

The timer status and the currently expired timer can be reset to "0" using the "Reset timer" 
instruction.

 

 Note

You can start and query the IEC timer at various execution levels, as each querying of the 
outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The "Time accumulator" instruction stores its data in a structure of the data type IEC_TIMER 
or TONR_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or IEC_TIMER in the "Static" section of 
a block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Time accumulator" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TONR_TIME or TONR_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME, TONR_LTIME, IEC_TIMER or 
IEC_LTIMER in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
assigned timer is accessed.

The current timer status is stored in the ET structure component of the IEC timer. You can use 
a normally open contact to query timer status for "1" or a normally closed contact for "0". The 
query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER 
structure.

The execution of the Time accumulator" instruction requires a preceding logic operation. It can 
be placed only at the end of the network.

Parameter
The following table shows the parameters of the "Time accumulator" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> InOut IEC_TIMER, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TONR_TIME, 
TONR_LTIME

D, L IEC timer that 
is started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Time accumulator" instruction executes on a positive signal edge in the RLO. The time 
is recorded as long as the operand "Tag_Input" has the signal state "1".

If the recorded time exceeds the value of the operand "TagTime", then the query of the timer 
status ("MyIEC_TIMER".Q) will return the signal state "1" and the operand "Tag_Output" will 
be set.

See also
Overview of the valid data types (Page 1077)

---( RT )---: Reset timer

Description     
You can use the "Reset timer" instruction to reset an IEC timer to "0". The instruction is only 
executed if the result of logic operation (RLO) at the input of the coil is "1". If current is flowing 
to the coil (RLO is "1"), the structure components of the timer in the specified data block are 
reset to "0". If the RLO at the input of the instruction is "0", the timer remains unchanged.

The instruction does not influence the RLO. The RLO at the input of the coil is sent directly to 
the output of the coil.

You assign the "Reset timer" instruction an IEC timer that has been declared in the program.

The instruction data is updated only when the instruction is called and not each time the 
assigned IEC timer is accessed. Querying the data is only identical from the call of the 
instruction to the next call of the instruction.
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Parameters
The following table shows the parameters of the "Reset timer" instruction":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<IEC timer> Output IEC_TIMER, 
TP_TIME, 
TON_TIME, 
TOF_TIME, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

D, L IEC timer that 
is reset.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "Generate on-delay" instruction executes when the signal state of the "Tag_Input_1" 
operand changes from "0" to "1". The timer stored in the "TON_DB" instance data block starts 
running for the time duration specified by operand "Tag_PT".

If operands "Tag_Input_2" and "Tag_Input_3" have the signal state "1", the "Reset timer" 
instruction is executed and the timer stored in the "TON_DB" data block.

See also
Overview of the valid data types (Page 1077)

---( PT )---: Load time duration

Description   
You can use the "Load time duration" instruction to set the time for an IEC timer. The instruction 
is executed in every cycle when the result of logic operation (RLO) at the input of the instruction 
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has the signal state "1". The instruction writes the specified time to the structure of the specified 
IEC timer.

 

 Note

If the specified IEC timer is running while the instruction executes, the instruction overwrites 
the current time of the specified IEC timer. This can change the timer status of the IEC timer.

 

You assign an IEC timer declared in the program to the "Load time duration" instruction.

The instruction data is updated only when the instruction is called and each time the assigned 
IEC timer is accessed. The query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) 
updates the IEC_TIMER structure.

Parameter
The following table shows the parameters of the "Load time duration" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> Output IEC_TIMER, 
TP_TIME, 
TON_TIME, 
TOF_TIME, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

D, L IEC timer, the 
duration of 
which is set.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "Generate on-delay" instruction executes when the signal state of the "Tag_Input_1" 
operand changes from "0" to "1". The IEC timer stored in the instance data block "TON_DB" 
is started with the time duration that is specified by the operand "Tag_PT".
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The "Load time duration" instruction is executed when the operand "Tag_Input_2" has the 
signal state "1". The instruction writes the time duration "Tag_PT_2" in the instance data block 
"TON_DB" and at the same time overwrites the value of the operand "Tag_PT" within the data 
block. The signal state of the timer status may therefore change at the next query or when 
"MyTimer".Q or "MyTimer".ET are accessed.

See also
Overview of the valid data types (Page 1077)

SIMATIC Timers

S_PULSE: Assign pulse timer parameters and start

Description
The "Assign pulse timer parameters and start" instruction starts a programmed timer when a 
change from "0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) 
at input S. The timer expires with the programmed duration (TV) as soon as the signal state 
at input S is "1". If the signal state at input S changes to "0" before the programmed duration 
expires, the timer is stopped. In this case, the signal state at output Q is "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

If the timer is running and the signal state at input R changes to "1" then the current time value 
and the time base are also set to zero. If the timer is not running, the signal state "1" at the R 
input has no effect.

The "Assign pulse timer parameters and start" instruction requires a preceding logic operation 
for edge evaluation and can be placed within or at the end of the network.

The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameters
The following table shows the parameters of the instruction "Assign pulse timer parameters 
and start":

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the instruction "Assign pulse timer 
parameters and start":

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number" as long as the 
operand "TagIn_1" has the signal state "1". If the signal state of the operand "TagIn_1" changes 
from "1" to "0" before the timer expires, the timer "Timer_1" is stopped. The operand "TagOut" 
is reset to "0" in this case.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1630 System Manual, 07/2013,  



The operand "TagOut" has the signal state "1" as long as the timer is running and the operand 
"TagIn_1" has the signal state "1". When the timer expires or is reset, the operand "TagOut" 
is reset to "0".

See also
Overview of the valid data types (Page 1077)

S_PEXT: Assign extended pulse timer parameters and start

Description
The "Assign extended pulse timer parameters and start" instruction starts a programmed timer 
when a change from "0" to "1" (positive signal edge) is detected in the result of logic operation 
(RLO) at input S. The timer expires with the programmed duration (TV), even if the signal state 
at input S changes to "0". As long as the timer is running, the output Q has the signal state "1". 
When the timer expires, the output Q is reset to "0". If the signal state at input S changes from 
"0" to "1" while the timer is running, the timer is restarted with the duration programmed at 
input TV.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

If the timer is running and the signal state at input R changes to "1" then the current time value 
and the time base are also set to zero. If the timer is not running, the signal state "1" at the R 
input has no effect.

The "Assign extended pulse timer parameters and start" instruction requires a preceding logic 
operation for edge evaluation and can be placed within or at the end of the network.

The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameter
The following table shows the parameters of the instruction "Assign extended pulse timer 
parameters and start":

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign extended pulse timer 
parameters and start" instruction:

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number" without being 
affected by a negative edge at input S. If the signal state of the operand "TagIn_1" changes 
from "0" to "1" before the timer expires, the timer is restarted.
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The operand "TagOut" has the signal state "1" as long as the timer is running. When the timer 
expires or is reset, the operand "TagOut" is reset to "0".

See also
Overview of the valid data types (Page 1077)

S_ODT: Assign on-delay timer parameters and start

Description
The "Assign on-delay timer parameters and start" instruction starts a programmed timer when 
a change from "0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) 
at input S. The timer expires with the programmed duration (TV) as soon as the signal state 
at input S is "1". If the timer expires correctly and input S still has signal state "1" then output 
Q returns signal state "1". If the signal state at input S changes from "1" to "0" while the timer 
is running, the timer is stopped. In this case, output Q is reset to signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

If the time is running and the signal state at input R changes from "0" to "1" then the current 
time value and the time base are also set to zero. In this case, the signal state at output Q is 
"0". The timer is reset if the signal state is "1" at the R input even if the timer is not running and 
the RLO at input S is "1".

Specify the timer of the instruction in the placeholder above the box. The timer must be declared 
with the data type TIMER.

The "Assign on-delay timer parameters and start" instruction requires a preceding logic 
operation for edge evaluation and can be placed within or at the end of the network.

The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameter
The following table shows the parameters of the "Assign on-delay timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign on-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number". If the timer 
expires and the operand has the signal state "1", the operand "TagOut" is set to "1". If the 
signal state of the operand "TagIn_1" changes from "1" to "0" before the timer expires, the 
timer is stopped. The operand "TagOut" has the signal state "0" in this case.
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See also
Overview of the valid data types (Page 1077)

S_ODTS: Assign retentive on-delay timer parameters and start

Description
The "Assign retentive on-delay timer parameters and start" instruction starts a programmed 
timer when a change from "0" to "1" (positive signal edge) is detected in the result of logic 
operation (RLO) at input S. The timer expires with the programmed duration (TV), even if the 
signal state at input S changes to "0". If the timer expires, the "Q" output returns signal state 
"1" regardless of the signal state at input "S". If the signal state at input S changes from "0" to 
"1" while the timer is running, the timer is restarted with the duration programmed at input (TV).

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

Signal state "1" at input R resets the current time value and time base to "0" regardless of the 
signal state at start input S. In this case, the signal state at output Q is "0".

The "Assign retentive on-delay timer parameters and start" instruction requires a preceding 
logic operation for edge evaluation and can be placed within or at the end of the network.

The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Assign retentive on-delay timer parameters 
and start" instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
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Parameter Declaration Data type Memory area Description
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign retentive on-delay timer 
parameters and start" instruction:
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Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number", even if the 
signal state of the operand "TagIn_1" changes to "0". When the timer expires, the operand 
"TagOut" is set to "1". If the signal state of the operand "TagIn_1" changes from "0" to "1" while 
the timer is running, the timer is restarted.

See also
Overview of the valid data types (Page 1077)

S_OFFDT: Assign off-delay timer parameters and start

Description
The "Assign off-delay timer parameters and start" instruction starts a programmed timer when 
a change from "1" to "0" (negative signal edge) is detected in the result of logic operation (RLO) 
at input S. The timer expires with the programmed duration (TV). As long as the timer is running 
or input S returns signal state "1", then output Q has signal state "1". When the timer expires 
and the signal state at input S is "0", output Q is reset to the signal state "0". If the signal state 
at input S changes from "0" to "1" while the timer is running, the timer is stopped. The timer is 
only restarted after a falling signal edge is detected at input S.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

Signal state "1" at input R resets the current time value and time base to "0". In this case, the 
signal state at output Q is "0".

The "Assign off-delay timer parameters and start" instruction requires a preceding logic 
operation for edge evaluation and can be placed within or at the end of the network.
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The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Assign off-delay timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1640 System Manual, 07/2013,  



Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign off-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"1" to "0". The timer expires with the time value of the operand "TagIn_Number". The operand 
"TagOut" is set to "1" when the timer is running and when the operand "TagIn_1" has the signal 
state "0". If the signal state of the operand "TagIn_1" changes from "0" to "1" while the timer 
is running, the timer is reset.

See also
Overview of the valid data types (Page 1077)
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---( SP ): Start pulse timer

Description
The "Start pulse timer" instruction starts a programmed timer when a change from "0" to "1" 
(positive signal edge) is detected in the result of logic operation (RLO). The time runs with the 
specified duration as long as the RLO has the signal state "1". As long as the timer is running, 
the querying of the timer status for "1" returns the signal state "1". If there is a change from "1" 
to "0" in the RLO before the time value has elapsed, the timer stops. In this case, the querying 
of the timer status for "1" returns the signal state "0".

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed.

The "Start pulse timer" instruction requires a preceding logic operation for edge evaluation and 
can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the "Start pulse timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number" as long as the 
signal state of the operand "TagIn_1" is "1". If the signal state of the operand "TagIn_1" changes 
from "1" to "0" before the timer expires, the timer is stopped. As long as the timer is running, 
the operand "TagOut" has the signal state "1". A signal state change of the operand "TagIn_1" 
from "0" to "1" resets the timer, which stops the timer and sets the current time value to "0".

See also
Overview of the valid data types (Page 1077)

---( SE ): Start extended pulse timer

Description
The "Start extended pulse timer" instruction starts a programmed timer when a change from 
"0" to "1" (positive signal edge) is detected in the result of logic operation (RLO). The timer 
expires with the specified duration, even if the RLO changes to the signal state "0". As long 
as the timer is running, the querying of the timer status for "1" returns the signal state "1". If 
the RLO changes from "0" to "1" while the timer is running, the timer is restarted with the 
programmed duration. The querying of the timer status for "1" returns the signal state "0" when 
the timer expires.

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed. 
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The "Start extended pulse timer" instruction requires a preceding logic operation for edge 
evaluation and can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Start extended pulse timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number" without being 
affected by a negative edge in the RLO. As long as the timer is running, the operand "TagOut" 
has the signal state "1". If the signal state of the operand "TagIn_1" changes from "0" to "1" 
before the timer expires, the timer is restarted.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1644 System Manual, 07/2013,  



See also
Overview of the valid data types (Page 1077)

---( SD ): Start on-delay timer

Description
The "Start on-delay timer" instruction starts a programmed timer when a change from "0" to 
"1" (positive signal edge) is detected in the result of logic operation (RLO). The timer runs for 
the specified duration as long as the RLO is "1". If the timer expires and the RLO still has the 
signal state "1", the query of the timer status for "1" returns the signal state "1". If the RLO 
changes from "1" to "0" while the timer is running, the timer is stopped. In this case, the querying 
of the timer status for "1" returns the signal state "0".

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed.

The "Start on-delay timer" instruction requires a preceding logic operation for edge evaluation 
and can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Start on-delay timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number". If the timer 
expires and the RLO has the signal state "1", the operand "TagOut" is set to "1". If the signal 
state of the operand "TagIn_1" changes from "1" to "0" before the timer expires, the timer is 
stopped. If the signal state of the operand "TagIn_2" is "1", the timer "Timer_1" is reset, which 
stops the timer and sets the current time value to "0".

See also
Overview of the valid data types (Page 1077)

---( SS ): Start retentive on-delay timer

Description
The "Start retentive on-delay timer" instruction starts a programmed timer when a change from 
"0" to "1" (positive signal edge) is detected in the result of logic operation (RLO). The timer 
expires with the specified duration, even if the RLO changes to the signal state "0". When the 
timer expires, the querying of the timer status for "1" returns the signal state "1". After expiry 
of the timer, the timer can only be restarted if it is explicitly reset.

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed.

The "Start retentive on-delay timer" instruction requires a preceding logic operation for edge 
evaluation and can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1646 System Manual, 07/2013,  



You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the "Start retentive on-delay timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number". When the 
timer expires, the operand "TagOut" is set to "1". If the signal state of the operand "TagIn_1" 
changes from "0" to "1" while the timer is running, the timer is restarted. If the signal state of 
the operand "TagIn_2" is "1", the timer "Timer_1" is reset, which stops the timer and sets the 
current time value to "0".

See also
Overview of the valid data types (Page 1077)
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---( SF ): Start off-delay timer

Description
The "Start off-delay timer" instruction starts a programmed timer when a change from "1" to 
"0" (negative signal edge) is detected in the result of logic operation (RLO). The timer expires 
with the specified duration. As long as the timer is running, the querying of the timer status for 
"1" returns the signal state "1". If the RLO changes from "0" to "1" while the timer is running, 
the timer is reset. The timer is always restarted when the RLO changes from "1" to "0".

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed.

The "Start off-delay timer" instruction requires a preceding logic operation for edge evaluation 
and can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Start off-delay timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"1" to "0". The timer expires with the time value of the operand "TagIn_Number". As long as 
the timer is running, the operand "TagOut" is set to "1". If the signal state of the operand 
"TagIn_1" changes from "1" to "0" while the timer is running, the timer is restarted. If the signal 
state of the operand "TagIn_2" is "1", the timer "Timer_1" is reset, which stops the timer and 
sets the current time value to "0".

See also
Overview of the valid data types (Page 1077)

Counter operations

IEC Counters

CTU: Count up

Description
You can use the "Count up" instruction to increment the value at output CV. When the signal 
state at the CU input changes from "0" to "1" (positive signal edge), the instruction executes 
and the current counter value at the CV output is incremented by one. When the instruction 
executes for the first time, the current counter value at the CV output is set to zero. The counter 
value is incremented each time a positive signal edge is detected, until it reaches the high limit 
for the data type specified at the CV output. When the high limit is reached, the signal state at 
the CU input no longer has an effect on the instruction.

You can scan the counter status at the Q output. The signal state at the Q output is determined 
by the parameter PV. If the current counter value is greater than or equal to the value of the 
PV parameter, the Q output is set to signal state "1". In all other cases, the Q output has signal 
state "0".
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The value at the CV output is reset to zero when the signal state at input R changes to "1". As 
long as the R input has signal state "1", the signal state at the CU input has no effect on the 
instruction.

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Each call of the "Count up" instruction must be assigned an IEC counter in which the instruction 
data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● CTU_LINT / CTU_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTU or IEC_COUNTER in the "Static" section of a 
block (for example, #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".
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The execution of the "Count up" instruction requires a preceding logic operation. It can be 
placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Count up" instruction:

Parameter Declaration Data type Memory area Description
CU Input BOOL I, Q, M, D, L or 

constant
Count input

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

PV Input Integers I, Q, M, D, L, P or 
constant

Value at which the 
output Q is set.

Q Output BOOL I, Q, M, D, L Counter status
CV Output Integers, CHAR, 

DATE
I, Q, M, D, L, P Current counter 

value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1", the "Count up" 
instruction executes and the current counter value of the operand "Tag_CV" is incremented 
by one. With each additional positive signal edge, the counter value is incremented until the 
high limit value of the data type (INT = 32767) is reached.

The value of the PV parameter is adopted as the limit for determining the "TagOut" output. 
The "TagOut" output has signal state "1" as long as the current counter value is greater than 
or equal to the value of the "Tag_PV" operand. In all other cases, the "TagOut" output has 
signal state "0".

See also
Overview of the valid data types (Page 1077)
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CTD: Count down

Description
You can use the "Count down" instruction to decrement the value at output CV. When the 
signal state at the CD input changes from "0" to "1" (positive signal edge), the instruction 
executes and the current counter value at the CV output is decremented by one. When the 
instruction executes the first time, the counter value of the CV parameter is set to the value of 
the PV parameter. Each time a positive signal edge is detected, the counter value is 
decremented until it reaches the low limit value of the specified data type. When the low limit 
is reached, the signal state at the CD input no longer has an effect on the instruction.

You can scan the counter status at the Q output. If the current counter value is less than or 
equal to zero, the Q output is set to signal state "1". In all other cases, the Q output has signal 
state "0".

The value at the CV output is set to the value of the PV parameter when the signal state at the 
LD input changes to "1". As long as the LD input has signal state "1", the signal state at the 
CD input has no effect on the instruction.

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Each call of the "Count down" instruction must be assigned an IEC counter in which the 
instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
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For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● CTD_LINT / CTD_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTD or IEC_COUNTER in the "Static" section of a 
block (for example, #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

The execution of the "Count down" instruction requires a preceding logic operation. It can be 
placed within or at the end of the network.

Parameters 
The following table shows the parameters of the "Count down" instruction:

Parameter Declaration Data type Memory area Description
CD Input BOOL I, Q, M, D, L or 

constant
Count input

LD Input BOOL I, Q, M, T, C, D, L, 
P or constant

Load input

PV Input Integers I, Q, M, D, L, P or 
constant

Value at which the 
output Q is set.

Q Output BOOL I, Q, M, D, L Counter status
CV Output Integers, CHAR, 

DATE
I, Q, M, D, L, P Current counter 

value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1", the "Count down" 
instruction is executed and the value at the "Tag_CV" output is decremented by one. With each 
additional positive signal edge, the counter value is decremented until the low limit of the 
specified data type (INT = -32768) is reached.

The "TagOut" output has signal state "1" as long as the current counter value is less than or 
equal to zero. In all other cases, the "TagOut" output has signal state "0".

See also
Overview of the valid data types (Page 1077)

CTUD: Count up and down

Description
You can use the "Count up and down" instruction to increment and decrement the counter 
value at the CV output. If the signal state at the CU input changes from "0" to "1" (positive 
signal edge), the current counter value is incremented by one and stored at the CV output. If 
the signal state at the CD input changes from "0" to "1" (positive signal edge), the counter 
value at the CV output is decremented by one. If there is a positive signal edge at the CU and 
CD inputs in one program cycle, the current counter value at the CV output remains unchanged.

The counter value can be incremented until it reaches the high limit of the data type specified 
at the CV output. When the high limit value is reached, the counter value is no longer 
incremented on a positive signal edge. When the low limit of the specified data type is reached, 
the counter value is not decremented any further.

When the signal state at the LD input changes to "1", the counter value at the CV output is set 
to the value of the PV parameter. As long as the LD input has the signal state "1", the signal 
state at the CU and CD inputs has no effect on the instruction.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has signal state "1", a change in the the signal state of the CU, CD and LD inputs 
has no effect on the "Count up and down" instruction.

You can scan the current status of the up counter at the QU output. If the current counter value 
is greater than or equal to the value of the PV parameter, the QU output is set to signal state 
"1". In all other cases, the QU output has signal state "0".
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You can scan the current status of the down counter at the QD output. If the current counter 
value is less than or equal to zero, the QD output is set to signal state "1". In all other cases, 
the QD output has signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Each call of the "Count up and down" instruction must be assigned an IEC counter in which 
the instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● CTUD_LINT / CTUD_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTUD or IEC_COUNTER in the "Static" section of a 
block (for example, #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".
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The execution of the "Count up and down" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Count up and down" instruction:

Parameter Declaration Data type Memory area Description
CU Input BOOL I, Q, M, D, L or 

constant
Count up input

CD Input BOOL I, Q, M, D, L or 
constant

Count down input

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

LD Input BOOL I, Q, M, T, C, D, L, 
P or constant

Load input

PV Input Integers I, Q, M, D, L, P or 
constant

Value at which the 
output QU is set.

QU Output BOOL I, Q, M, D, L Status of the 
counter up

QD Output BOOL I, Q, M, D, L Status of the 
down-counter

CV Output Integers, CHAR, 
DATE

I, Q, M, D, L, P Current counter 
value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the signal state at the "TagIn_1" or "TagIn_2" input changes from "0" to "1" (positive signal 
edge), the "Count up and down" instruction is executed. When there is a positive signal edge 
at the "TagIn_1" input, the current counter value is incremented by one and stored at the 
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"Tag_CV" output. When there is a positive signal edge at the "TagIn_2" input, the counter value 
is decremented by one and stored at the "Tag_CV" output. When there is a positive signal 
edge at the CU input, the counter value is incremented until it reaches the high limit of 32767. 
If input CD has a positive signal edge, the counter value is decremented until it reaches the 
low limit value of INT = -32768.

The "TagOut" output has signal state "1" as long as the current counter value is greater than 
or equal to the value at the "Tag_PV" input. In all other cases, the "TagOut" output has signal 
state "0".

The "TagOut_QD" output has signal state "1" as long as the current counter value is less than 
or equal to zero. In all other cases, the "TagOut_QD" output has signal state "0".

See also
Overview of the valid data types (Page 1077)

SIMATIC Counters

S_CUD: Assign parameters and count up / down

Description
You can use the "Assign parameters and count up / down" instruction to increment or 
decrement the value of a counter. If the signal state at the CU input changes from "0" to "1" 
(positive signal edge), the current counter value is incremented by one. If the signal state at 
the CD input changes from "0" to "1" (positive signal edge), the counter value is decremented 
by one. The current counter value is output as a hexadecimal value at output CV and BCD-
coded at output CV_BCD. If there is a positive signal edge at the CU and CD inputs in one 
program cycle, the counter value remains unchanged.

The counter value can be incremented until the high limit of "999" is reached. When the high 
limit value is reached, the counter value is no longer incremented on a positive signal edge. 
When the low limit "0" is reached, the counter value is not decremented any further.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO is "1" at the inputs CU and CD, the counter 
counts accordingly in the next scan cycle, even if no change in the signal edge was detected.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CU, CD and S 
inputs has no effect on the counter value.

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

The "Assign parameters and count up / down" instruction requires a preceding logic operation 
for edge evaluation and can be placed within or at the end of the network.
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Parameters
The following table shows the parameters of the "Assign parameters and count up / down" 
instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CU Input BOOL I, Q, M, D, L Count up input
CD Input BOOL I, Q, M, D, L, T, C 

or constant
Count down input

S Input BOOL I, Q, M, D, L, T, C 
or constant

Input for 
presetting counter

PV Input WORD I, Q, M, D, L, C or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

BI Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the signal state at the "TagIn_1"" or "TagIn_2" input changes from "0" to "1" (positive signal 
edge), the "Assign parameters and count up / down" instruction is executed. When there is a 
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positive signal edge at the "TagIn_1" input and the current counter value is less than "999", 
the counter value is incremented by one. When there is a positive signal edge at the "TagIn_2" 
input and the current counter value is greater than "0", the counter value is decremented by 
one. 

When the signal state at input "TagIn_3" changes from "0" to "1", the counter value is set to 
the value of the operand "TagPresetValue". The counter value is reset to "0" when the 
"TagIn_4" operand has signal state "1".

The current counter value is saved as a hexadecimal value in the operand "TagValue_1" and 
BCD-coded in the operand "TagValue_2".

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1077)

S_CU: Assign parameters and count up

Description     
You can use the "Assign parameters and count up" instruction to increment the value of a 
counter. If the signal state at the CU input changes from "0" to "1" (positive signal edge), the 
current counter value is incremented by one. The current counter value is output as a 
hexadecimal value at output CV and BCD-coded at output CV_BCD. The counter value can 
be incremented until the limit of "999" is reached. When the limit is reached, the counter value 
is no longer incremented on a positive signal edge.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO at input CU is "1", the counter will count 
accordingly in the next scan cycle, even when no change has been detected in the signal edge.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CU and S inputs 
has no effect on the counter value. 

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

The "Assign parameters and count up" instruction requires a preceding logic operation for edge 
evaluation and can be placed within or at the end of the network.
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Parameter
The following table shows the parameters of the "Assign parameters and count up" instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CU Input BOOL I, Q, M, D, L Count up input
S Input BOOL I, Q, M, D, L, T, C 

or constant
Input for 
presetting counter

PV Input WORD I, Q, M, D, L, C or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

BI Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state at the "TagIn_1" input changes from "0" to "1" (positive signal edge) and 
the current counter value is less than "999", the counter value is incremented by one. When 
the signal state at input "TagIn_2" changes from "0" to "1", the counter value is set to the value 
of the operand "TagPresetValue". The counter value is reset to "0" when the "TagIn_3" operand 
has signal state "1".
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The current counter value is saved as a hexadecimal value in the operand "TagValue_1" and 
BCD-coded in the operand "TagValue_2".

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1077)

S_CD: Assign parameters and count down

Description     
You can use the "Assign parameters and count down" instruction to decrement the value of a 
counter. If the signal state at the CD input changes from "0" to "1" (positive signal edge), the 
counter value is decremented by one. The current counter value is output as a hexadecimal 
value at output CV and BCD-coded at output CV_BCD. The counter value can be decremented 
until the low limit of "0" is reached. When the low limit is reached, the counter value is no longer 
decremented on a positive signal edge. 

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO at input CD is "1", the counter will count 
accordingly in the next scan cycle, even when no change has been detected in the signal edge.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CD and S inputs 
has no effect on the counter value.

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

The "Assign parameters and count down" instruction requires a preceding logic operation for 
edge evaluation and can be placed within or at the end of the network.
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Parameter
The following table shows the parameters of the "Assign parameters and count down" 
instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CD Input BOOL I, Q, M, D, L or 
constant

Count down input

S Input BOOL I, Q, M, D, L, T, C 
or constant

Input for 
presetting counter

PV Input WORD I, Q, M, D, L, C or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state at the "TagIn_1" input changes from "0" to "1" (positive signal edge) and 
the current counter value is greater than "0", the counter value is decremented by one. When 
the signal state at input "TagIn_2" changes from "0" to "1", the counter value is set to the value 
of the operand "TagPresetValue". The counter value is reset to "0" when the "TagIn_3" operand 
has signal state "1".
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The current counter value is saved as a hexadecimal value in the operand "TagValue_1" and 
BCD-coded in the operand "TagValue_2".

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1077)

---( SC ): Set counter value

Description
You can use the "Set counter value" instruction to set the value of a counter. The instruction 
is executed when the result of logic operation (RLO) at the input changes from "0" to "1". When 
the instruction is executed, the counter is set to the specified counter value.

The "Set counter value" instruction requires a preceding logic operation for edge evaluation 
and can only be placed at the right side of the network.

Parameter
The following table shows the parameters of the "Set counter value" instruction:

Parameter Declaration Data type Memory area Description
<Count value> Input WORD I, Q, M, D, L or 

constant
Value with which 
the counter is 
preset in the BCD 
format.
(C#0 to C#999)

<Counter> InOut/Input COUNTER C Counter that is 
preset

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The counter "Counter_1" is preset with the value "100" when the signal state of the operand 
"TagIn" changes from "0" to "1".
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See also
Overview of the valid data types (Page 1077)

---( CU ): Count up

Description
With the "Count up" instruction you can increment the value of the specified counter by one if 
there is a positive signal edge in the result of logic operation (RLO). The counter value can be 
incremented until the limit of "999" is reached. When the limit is reached, the counter value is 
no longer incremented on a positive signal edge. 

The "Count up" instruction requires a preceding logic operation for edge evaluation and can 
only be placed at the right side of the network.

Parameter
The following table shows the parameters of the "Count up" instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter whose 

value is 
incremented.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1" (positive signal edge), 
the counter "Counter_1" is preset with the value "100".

The value of the counter "Counter_1" is incremented by one when the signal state of the 
operand "TagIn_2" changes from "0" to "1".

When the operand "TagIn_3" has the signal state "1", the value of the counter "Counter_1" is 
reset to "0".
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See also
Overview of the valid data types (Page 1077)

---( CD ): Count down

Description
With the "Count down" instruction you can increment the value of the specified counter by one 
if there is a positive signal edge in the result of logic operation (RLO). The counter value can 
be decremented until the limit of "0" is reached. When the limit is reached, the counter value 
is no longer changed on a positive signal edge. 

The "Count down" instruction requires a preceding logic operation for edge evaluation and can 
only be placed at the right side of the network.

Parameter
The following table shows the parameters of the "Count down" instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter whose 

value is 
decremented.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1" (positive signal edge), 
the counter "Counter_1" is preset with the value "100".

The value of the counter "Counter_1" is decremented by one when the signal state of the 
operand "TagIn_2" changes from "0" to "1". 

When the operand "TagIn_3" has the signal state "1", the value of the counter "Counter_1" is 
reset to "0".
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See also
Overview of the valid data types (Page 1077)

Comparator operations

CMP ==: Equal

Description
You can use the "Equal" instruction to determine if a first comparison value (<Operand1>) is 
equal to a second comparison value (<Operand2>).

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character that is different decides the result of the comparison.

The following table shows examples of string comparisons:

<Operand1> <Operand2> RLO of instruction
'AA' 'AA' 1
'Hello World' 'HelloWorld' 0
'AA' 'aa' 0

You can also use the "Equal" instruction to compare individual characters of a string (STRING). 
The number of the character to be compared is given in brackets next to the operand name. 
"MyString[2]", for example, compares the second character of the "MyString" string.

When IEC Check is selected, the operands to be compared must have the same data type. If 
IEC Check is not selected, the width (length) of the operands must be the same. When floating-
point numbers are compared, the operands to be compared must have the same data type 
regardless of the setting for the IEC Check.

 

 Note
Comparison of floating-point numbers

If you want to compare the data types REAL or LREAL, instead of the instruction "CMP ==: 
Equal", use the instruction "IN_RANGE: Value within range".
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Parameters
The following table shows the parameters of the "Equal" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Bit strings, 
integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Bit strings, 
integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have the signal state "1".

● The condition of the comparison instruction is fulfilled if ("Tag_Value1" = "Tag_Value2").

See also
Overview of the valid data types (Page 1077)
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CMP <>: Not equal

Description     
You can use the "Not equal" instruction to determine if a first comparison value (<Operand1>) 
is not equal to a second comparison value (<Operand2>).

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character that is different decides the result of the comparison.

The following table shows examples of string comparisons:

<Operand1> <Operand2> RLO of instruction
'AA' 'aa' 1
'Hello World' 'HelloWorld' 1
'AA' 'AA' 0

You can also use the "Not equal" instruction to compare individual characters of a string 
(STRING). The number of the character to be compared is given in brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When IEC Check is selected, the operands to be compared must have the same data type. If 
IEC Check is not selected, the width (length) of the operands must be the same. When floating-
point numbers are compared, the operands to be compared must have the same data type 
regardless of the setting for the IEC Check.
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Parameters
The following table shows the parameters of the "Not equal" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Bit strings, 
integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Bit strings, 
integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if ("Tag_Value1" <> "Tag_Value2").

See also
Overview of the valid data types (Page 1077)
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CMP >=: Greater or equal

Description     
You can use the "Greater or equal" instruction to determine if a first comparison value 
(<Operand1>) is greater than or equal to a second comparison value (<Operand2>). Both 
values to be compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character that is different decides the result of the comparison. If the left part 
of the longer string is identical to the shorter string, the longer string is considered greater.

The following table shows examples of string comparisons:

<Operand1> <Operand2> RLO of instruction
'BB' 'AA' 1
'AAA' 'AA' 1
'Hello World' 'Hello World' 1
'Hello World' 'HelloWorld' 0
'AA' 'aa' 0
'AAA' 'a' 0

You can also use the "Greater or equal" instruction to compare individual characters of a string 
(STRING). The number of the character to be compared is given in brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When time values are compared, the RLO of the instruction is "1" if the point of time at 
<Operand1> is greater (more recent) than or equal to the point of time at <Operand2>.
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Parameters
The following table shows the parameters of the "Greater or equal" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if ("Tag_Value1" >= "Tag_Value2").

See also
Overview of the valid data types (Page 1077)

Example of detecting the fill level of a storage area  (Page 1554)
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CMP <=: Less or equal

Description     
You can use the "Less or equal" instruction to determine if a first comparison value 
(<Operand1>) is less than or equal to a second comparison value (<Operand2>). Both values 
to be compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character that is different decides the result of the comparison. If the left part 
of the longer string is identical to the shorter string, the shorter string is considered smaller.

The following table shows examples of string comparisons:

<Operand1> <Operand2> RLO of instruction
'AA' 'aa' 1
'AAA' 'a' 1
'Hello World' 'Hello World' 1
'HelloWorld' 'Hello World' 0
'BB' 'AA' 0
'AAA' 'AA' 0

You can also use the "Less or equal" instruction to compare individual characters of a string 
(STRING). The number of the character to be compared is given in brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When time values are compared, the RLO of the instruction is "1" if the point of time at 
<Operand1> is less (less recent) than or equal to the point of time at <Operand2>.
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Parameters
The following table shows the parameters of the "Less or equal" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if ("Tag_Value1" <= "Tag_Value2").

See also
Overview of the valid data types (Page 1077)
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CMP >: Greater than

Description     
You can use the "Greater than" instruction to determine if a first comparison value 
(<Operand1>) is greater than a second comparison value (<Operand2>). Both values to be 
compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character that is different decides the result of the comparison. If the left part 
of the longer string is identical to the shorter string, the longer string is considered greater.

The following table shows examples of string comparisons:

<Operand1> <Operand2> RLO of instruction
'BB' 'AA' 1
'AAA' 'AA' 1
'AA' 'aa' 0
'AAA' 'a' 0

You can also use the "Greater than" instruction to compare individual characters of a string 
(STRING). The number of the character to be compared is given in brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When time values are compared, the RLO of the instruction is "1" if the point of time at 
<Operand1> is greater (more recent) than the point of time at <Operand2>.
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Parameters
The following table shows the parameters of the "Greater than" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if ("Tag_Value1" > "Tag_Value2").

See also
Overview of the valid data types (Page 1077)
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CMP <: Less than

Description     
You can use the "Less than" instruction to determine if a first comparison value (<Operand1>) 
is less than a second comparison value (<Operand2>). Both values to be compared must be 
of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character that is different decides the result of the comparison. If the left part 
of the longer string is identical to the shorter string, the shorter string is considered smaller.

The following table shows examples of string comparisons:

<Operand1> <Operand2> RLO of instruction
'AA' 'aa' 1
'AAA' 'a' 1
'BB' 'AA' 0
'AAA' 'AA' 0

You can also use the "Less than" instruction to compare individual characters of a string 
(STRING). The number of the character to be compared is given in brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When time values are compared, the RLO of the instruction is "1" if the point of time at 
<Operand1> is less (less recent) than the point of time at <Operand2>.
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Parameters
The following table shows the parameters of the "Less than" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Integers, 
floating-point 
numbers, 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if ("Tag_Value1" < "Tag_Value2").

See also
Overview of the valid data types (Page 1077)

Example of detecting the fill level of a storage area  (Page 1554)
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IN_RANGE: Value within range

Description     
You can use the "Value within range" instruction to determine if the value at the VAL input is 
within a specific value range.

You specify the limits of the value range with the MIN and MAX inputs. The "Value within range" 
instruction compares the value at the VAL input with the values of the MIN and MAX inputs 
and sends the result to the box output. If the value at the VAL input fulfills the comparison MIN 
<= VAL or VAL <= MAX, the box output has the signal state "1". If the comparison is not fulfilled, 
the box output has the signal state "0".

If the box input has the signal state "0", the "Value within range" instruction is not executed.

The comparison function can only execute if the values to be compared are of the same data 
type and the box input is interconnected.

Parameters
The following table shows the parameters of the "Value within range" instruction:

Parameter Declaration Data type Memory area Description
Box input Input BOOL I, Q, M, D, L Result of the 

previous logic 
operation

MIN Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Low limit of the 
value range

VAL Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Comparison value

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

Box output Output BOOL I, Q, M, D, L Result of the 
comparison

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:
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The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The value of the operand "Tag_Value" is within the value range that is specified by the 
current values of the operands "Tag_Min" and "Tag_Max" (MIN <= VAL or VAL <= MAX).

● The operand "TagIn_3" has the signal state "1".

See also
Overview of the valid data types (Page 1077)

OUT_RANGE: Value outside range

Description     
You can use the "Value outside range" instruction to determine if the value at the VAL input is 
outside a specific value range.

You specify the limits of the value range with the MIN and MAX inputs. The "Value outside 
range" instruction compares the value at the VAL input with the values of the MIN and MAX 
inputs and sends the result to the box output. If the value at the VAL input fulfills the comparison 
MIN > VAL or VAL > MAX, the box output has the signal state "1". The box output also has 
the signal state "1" if a specified operand with the REAL data type shows an invalid value. 

The box output returns the signal state "0", if the value at input VAL does not satisfy the MIN 
> VAL or VAL > MAX  condition.

If the box input has the signal state "0", the "Value outside range" instruction is not executed.

The comparison function can only execute if the values to be compared are of the same data 
type and the box input is interconnected.

Parameters 
The following table shows the parameters of the "Value outside range" instruction:

Parameter Declaration Data type Memory area Description
Box input Input BOOL I, Q, M, D, L Result of the 

previous logic 
operation

MIN Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Low limit of the 
value range

VAL Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Comparison value

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

Box output Output BOOL I, Q, M, D, L Result of the 
comparison
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You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The value of the operand "Tag_Value" is outside the value range that is specified by the 
values of the operands "Tag_Min" and "Tag_Max" (MIN > VAL or VAL > MAX).

● The operand "TagIn_3" has the signal state "1".

See also
Overview of the valid data types (Page 1077)

----I OK I----: Check validity

Description     
You can use the "Check validity" instruction to check if the value of an operand (<operand>) 
is a valid floating-point number. The query is started in each program cycle when the signal 
state at the input of the instruction is "1".

The output of the instruction has signal state "1" when the value of the operand is a valid 
floating-point number at the time of the query and the input of the instruction has signal state 
"1". In all other cases, the signal state at the output of the "Check validity" instruction is "0".

You can use the "Check validity" instruction together with the EN mechanism. If you connect 
the instruction box to an EN enable input, the enable input is set only when the result of the 
validity query of the value is positive. You can use this function to ensure that an instruction is 
enabled only when the value of the specified operand is a valid floating-point number.
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Parameters
The following table shows the parameters of the "Check validity" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Input Floating-point 

numbers
I, Q, M, D, L Value to be 

queried.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the values of the operands "Tag_Value1" and "Tag_Value2" show valid floating-point 
numbers, the "Multiply" (MUL) instruction is activated and the ENO output is set. During the 
execution of the "Multiply" (MUL) instruction, the value of the operand "Tag_Value1" is 
multiplied with the value of the operand "Tag_Value2". The product of the multiplication is then 
stored in the operand "Tag_Result". If the instruction is executed without errors, the ENO and 
"TagOut" outputs are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

----I NOT_OK I----: Check invalidity

Description     
You can use the "Check invalidity" instruction to check if the value of an operand (<operand>) 
is an invalid floating-point number. The query is started in each program cycle when the signal 
state at the input of the instruction is "1".

The output of the instruction has signal state "1" when the value of the operand is an invalid 
floating-point number at the time of the query and the input of the instruction has signal state 
"1". In all other cases, the signal state at the output of the "Check invalidity" instruction is "0".
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Parameters
The following table shows the parameters of the "Check invalidity" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Input Floating-point 

numbers
I, Q, M, D, L Value to be 

queried.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the value of operand "TagIn_Value" is an invalid floating-point number, the "Move value" 
(MOVE) instruction will not be executed. The "TagOut" output is reset to signal state "0".

See also
Overview of the valid data types (Page 1077)

Math functions

CALCULATE: Calculate

Description     
The "Calculate" instruction is used to define and execute an expression for the calculation of 
mathematical operations or complex logic operations depending on the selected data type.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box. Depending on the data type selected, you can combine the functions of certain instructions 
to perform a complex calculation. The information for the expression to be calculated is entered 
in a dialog, which you can open with the icon at the upper right edge of the instruction box. 
The expression can contain names of input parameters and the syntax of the instructions. 
Operand names and operand addresses cannot be specified.

The following table shows the instructions that can be combined in the expression of the 
"Calculate" instruction, depending on the selected data type:

Data type Instruction Syntax Example
Bit strings AND: AND logic operation AND IN1 AND IN2 OR IN3

OR: OR logic operation OR
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Data type Instruction Syntax Example
XOR: EXCLUSIVE OR logic operation XOR
INV: Create ones complement NOT
SWAP: Swap 1) SWAP

Integers ADD: Add + (IN1 + IN2) * IN3;
(ABS(IN2))*(ABS(IN1
))

SUB: Subtract -
MUL: Multiply *
DIV: Divide /
MOD: Return remainder of division MOD
INV: Create ones complement NOT
NEG: Create twos complement -(in1)
ABS: Form absolute value ABS( )

Floating-point numbers ADD: Add + ((SIN(IN2)*SIN(IN2)+ 
(SIN(IN3)*SIN(IN3))/
IN3;
(SQR(SIN(IN2))+
(SQR(COS(IN3))/IN2

SUB: Subtract -
MUL: Multiply *
DIV: Divide /
EXPT: Exponentiate **
ABS: Form absolute value ABS( )
SQR: Form square SQR( )
SQRT: Form square root SQRT( )
LN: Form natural logarithm LN( )
EXP: Form exponential value EXP( )
FRAC: Return fraction FRAC( )
SIN: Form sine value SIN( )
COS: Form cosine value COS( )
TAN: Form tangent value TAN( )
ASIN: Form arcsine value ASIN( )
ACOS: Form arccosine value ACOS( )
ATAN: Form arctangent value ATAN( )
NEG: Create twos complement -(in1)
TRUNC: Truncate numerical value TRUNC( )
ROUND: Round numerical value ROUND( )
CEIL: Generate next higher integer from floating-
point number

CEIL( )

FLOOR: Generate next lower integer from floating-
point number

FLOOR( )

1) Not possible for data type BYTE.

In its initial state, the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box.

The values of the inputs are used to execute the specified expression. Not all of the defined 
inputs have to be used in the expression. The result of the instruction is transferred to the 
output OUT.

If you use inputs in the expression that are not available in the box, they are inserted 
automatically. This requires that there are no gaps in the numbering of the inputs to be newly 
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defined in the expression. For example, you cannot use the IN4 input in the expression unless 
the IN3 input has been defined.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The result of the "Calculate" instruction is outside the range permitted for the data type 
specified at the OUT output.

● A floating-point number has an invalid value.

● An error occurred during execution of one of the instructions in the expression.

Parameters
The following table shows the parameters of the "Calculate" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Bit strings, 

integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

First available 
input

IN2 Input Bit strings, 
integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Second available 
input

INn Input Bit strings, 
integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Additionally 
inserted inputs

OUT Output Bit strings, 
integers, floating-
point numbers

I, Q, M, D, L, P Output to which 
the end result is to 
be transferred.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value_1 4
IN2 Tag_Value_2 4
IN3 Tag_Value_3 3
IN4 Tag_Value_4 2
OUT Tag_Result 12

If the "Tag_Input" input has the signal state"1", the "Calculate" instruction is executed. The 
value of operand "Tag_Value_1" is added to the value of operand "Tag_Value_2". The sum is 
multiplied with the value of operand "Tag_Value_3". The product is divided by the value of 
operand "Tag_Value_4". The quotient is transferred as end result to the operand "Tag_Result" 
at the OUT output of the instruction. If the instruction is executed without errors, the enable 
output ENO and operand "Tag_Output" are set to "1".

See also
Using the "Calculate" instruction (Page 1281)

Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Basics of the EN/ENO mechanism (Page 1167)

ADD: Add

Description
You can use the "Add" instruction to add the value at input IN1 and the value at input IN2 and 
query the sum at output OUT (OUT := IN1+IN2).

In its initial state, the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box. When 
the instruction is executed, the values of all available input parameters are added. The sum is 
stored at the OUT output.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at the 
OUT output.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the "Add" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

First number to be 
added

IN2 Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Second number to 
be added

INn Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Optional input 
values that are 
added.

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Sum

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Add" instruction is executed. The value of 
operand "Tag_Value1" is added to the value of operand "Tag_Value2". The result of the 
addition is stored in operand "Tag_Result". If the instruction is executed without errors, the 
ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Removing inputs and outputs (Page 1290)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1274)

Inserting additional inputs and outputs in LAD elements (Page 1289)
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SUB: Subtract

Description     
You can use the "Subtract" instruction to subtract the value at input IN2 from the value at input 
IN1 and query the difference at output OUT (OUT := IN1-IN2).

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at the 
OUT output.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Subtract" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

Minuend

IN2 Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Subtracting

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Difference

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Subtract" instruction is executed. The value of 
operand "Tag_Value2" is subtracted from the value of operand "Tag_Value1". The result of 
the subtraction is stored in operand "Tag_Result". If the instruction is executed without errors, 
the ENO enable output has the signal state "1" and the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1274)

MUL: Multiply

Description     
You can use the "Multiply" instruction to multiply the value at input IN1 with the value at input 
IN2 and query the product at output OUT (OUT := IN1*IN2).

The number of inputs can be expanded in the instruction box. The added inputs are numbered 
in ascending order in the box. When the instruction is executed, the values of all available input 
parameters are multiplied. The product is stored at the OUT output.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN input has the signal state "0".

● The result is outside the range permitted for the data type specified at output OUT.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Multiply" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

Multiplier

IN2 Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Number being 
multiplied

INn Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Optional input 
values that can be 
multiplied.

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Product

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Multiply" instruction is executed. The value of 
operand "Tag_Value1" is multiplied by the value of operand "Tag_Value2". The result of the 
multiplication is stored in operand "Tag_Result". If the instruction is executed without errors, 
the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Removing inputs and outputs (Page 1290)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1274)

Inserting additional inputs and outputs in LAD elements (Page 1289)

DIV: Divide

Description     
You can use the "Divide" instruction to divide the value at input IN1 by the value at input IN2 
and query the quotient at output OUT (OUT := IN1/IN2).

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at the 
OUT output.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Divide" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

Dividend

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1689



Parameter Declaration Data type Memory area Description
IN2 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

Divisor

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Quotient value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Divide" instruction is executed. The value of 
operand "Tag_Value1" is divided by the value of operand "Tag_Value2". The division result is 
stored in operand "Tag_Result". If the instruction is executed without errors, the ENO enable 
output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1274)

MOD: Return remainder of division

Description     
You can use the "Return remainder of division" instruction to divide the value at input IN1 by 
the value at input IN2 and query the remainder of division at output OUT.

Parameters
The following table shows the parameters of the "Return remainder of division" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
IN1 Input Integers I, Q, M, D, L, P or 

constant
Dividend

IN2 Input Integers I, Q, M, D, L, P or 
constant

Divisor

OUT Output Integers I, Q, M, D, L, P Remainder of 
division

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Return remainder of division" instruction is 
executed. The value of operand "Tag_Value1" is divided by the value of operand "Tag_Value2". 
The remainder is stored in operand "Tag_Result". If the instruction is executed without errors, 
the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1274)

NEG: Create twos complement

Description       
You can use the "Create twos complement" instruction to change the sign of the value at the 
IN input and query the result at the OUT output. If there is a positive value at input IN, for 
example, the negative equivalent of this value is sent to output OUT.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at the 
OUT output.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the "Create twos complement" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input SINT, INT, 

DINT, floating-
point numbers

SINT, INT, 
DINT, LINT, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

Input value

OUT Output SINT, INT, 
DINT, floating-
point numbers

SINT, INT, 
DINT, LINT, 
floating-point 
numbers

I, Q, M, D, L, P Twos 
complement of 
the input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Create twos complement" instruction is 
executed. The sign of the value at input "TagIn_Value" is changed and the result is provided 
at "TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

INC: Increment

Description     
You can use the "Increment" instruction to change the value of the operand at the IN/OUT 
parameter to the next higher value and query the result. The "Increment" instruction is only 
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started when the signal state at the EN enable input is "1". If no overflow error occurs during 
the execution, the ENO enable output also has the signal state "1".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Increment" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN/OUT InOut Integers I, Q, M, D, L Value to be 

incremented.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the value of operand 
"Tag_InOut" is incremented by one and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

DEC: Decrement

Description     
You can use the "Decrement" instruction to change the value of the operand at the IN/OUT 
parameter to the next lower value and query the result. The "Decrement" instruction is only 
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started when the signal state at the EN enable input is "1". If the range of values of the selected 
data type is not exceeded during processing, the ENO output also has the signal state "1".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● A floating-point number has an invalid value.

Parameter
The following table shows the parameters of the "Decrement" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN/OUT InOut Integers I, Q, M, D, L Value to be 

decremented.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the value of operand 
"Tag_InOut" is decremented by one and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ABS: Form absolute value

Description         
You can use the "Form absolute value" instruction to calculate the absolute value of the value 
specified at input IN. The result of the instruction is sent to the OUT output and can be queried 
there.
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The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Form absolute value" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input SINT, INT, 

DINT, floating-
point numbers

SINT, INT, 
DINT, LINT, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

Input value

OUT Output SINT, INT, 
DINT, floating-
point numbers

SINT, INT, 
DINT, LINT, 
floating-point 
numbers

I, Q, M, D, L, P Absolute value 
of the input 
value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value -6.234
OUT TagOut_Value 6.234

If operand "TagIn" has the signal state "1", the "Form absolute value" instruction is executed. 
The instruction calculates the absolute value of the value at input "TagIn_Value" and sends 
the result to output "TagOut_Value". If the instruction is executed without errors, the "TagOut" 
output is set.
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

MIN: Get minimum

Description
The "Get minimum" instruction compares the values at the available inputs and writes the 
lowest value to the OUT output. The number of inputs can be expanded at the instruction box 
by additional inputs. The inputs are numbered in ascending order in the box.

A minimum of two and a maximum of 100 inputs must be specified for the execution of the 
instruction.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Get minimum" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

First input value

IN2 Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Second input 
value
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

INn Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Additionally 
inserted inputs 
whose values 
are to be 
compared

OUT Output Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Result

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 TagIn_Value1 12222
IN2 TagIn_Value2 14444
IN3 TagIn_Value3 13333
OUT TagOut_Value 12222

If the "TagIn_1" and "TagIn_2" operands have signal state "1", the "Get minimum" instruction 
is executed. The instruction compares the values of the specified operands and copies the 
lowest value ("TagIn_Value1") to output "TagOut_Value". If the instruction is executed without 
errors, the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Basics of the EN/ENO mechanism (Page 1167)

MAX: Get maximum

Description
The "Get maximum" instruction compares the values at the available inputs and writes the 
highest value to the OUT output. The number of inputs can be expanded at the instruction box 
by additional inputs. The inputs are numbered in ascending order in the box.

A minimum of two and a maximum of 100 inputs must be specified for the execution of the 
instruction.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Get maximum" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

First input value

IN2 Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Second input 
value
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

INn Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Additionally 
inserted inputs 
whose values 
are to be 
compared

OUT Output Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Result

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 TagIn_Value1 12222
IN2 TagIn_Value2 14444
IN3 TagIn_Value3 13333
OUT TagOut_Value 14444

If the "TagIn_1" and "TagIn_2" operands have signal state "1", the "Get maximum" instruction 
is executed. The instruction compares the values of the specified operands and copies the 
highest value ("TagIn_Value2") to output "TagOut_Value". If the instruction is executed without 
errors, the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Basics of the EN/ENO mechanism (Page 1167)

LIMIT: Set limit value

Description
You use the "Set limit value" instruction to limit the value at input IN to the values at the inputs 
MN and MX. If the value at the IN input meets the condition MN <= IN <= MX, it is copied to 
the OUT output. If the condition is not fulfilled and the input value IN is below the low limit MN, 
the output OUT is set to the value of the MN input. If the MX high limit is exceeded, the OUT 
output is set to the value of the MX input.

If the value at the MN input is greater than at the MX input, the result is undefined and the 
enable output ENO is "0".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The specified tags are not of the same data type.

● An operand has an invalid value.

● The value at the MN input is greater than the value at the MX input.

Parameters
The following table shows the parameters of the "Set limit value" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
MN Input Integers, 

floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Low limit

IN Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Input value
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

MX Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

High limit

OUT Output Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Result

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MN Tag_MN 12000
IN Tag_Value 8000
MX Tag_MX 16000
OUT Tag_Result 12000

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Set limit value" instruction 
is executed. The value of operand "Tag_Value" is compared with the values of operands 
"Tag_MN" and "Tag_MX". Since the value of operand "Tag_Value" is less than the low limit, 
the value of operand "Tag_MN" is copied to the "Tag_Result" output. If the instruction is 
executed without errors, the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SQR: Form square

Description     
You can use the "Form square" instruction to square the value at the IN input and query the 
result at the OUT output.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form square" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Square of the 
input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN Tag_Value 5.0
OUT Tag_Result 25.0

If operand "TagIn" has the signal state "1", the "Form square" instruction is executed. The 
instruction squares the value of operand "Tag_Value" and sends the result to the "Tag_Result" 
output. If the instruction is executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SQRT: Form square root

Description     
You can use the "Form square root" instruction to  find the square root of the value at the IN 
input and query the result at the OUT output. The instruction outputs a positive result if the 
input value is greater than zero. If input values are less than zero, the OUT output returns an 
invalid floating-point number. If the value at input IN is "0", then the result is also "0".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

● The value at the IN input is negative.

Parameters
The following table shows the parameters of the "Form square root" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Square root of the 
input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 25.0
OUT Tag_Result 5.0

If operand "TagIn" has the signal state "1", the "Form square root" instruction is executed. The 
instruction finds the square root of the value of operand "Tag_Value" and stores the result in 
the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" output is 
set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

LN: Form natural logarithm

Description     
You can use the "Form natural logarithm" instruction to calculate the natural logarithm to base 
e (e = 2.718282) of the value at input IN. The result is sent to the OUT output and can be 
queried there. The instruction outputs a positive result if the input value is greater than zero. 
If input values are less than zero, the OUT output returns an invalid floating-point number.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● The value at the IN input is not a valid floating-point number.

● The value at the IN input is negative.
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Parameters
The following table shows the parameters of the "Form natural logarithm" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Natural logarithm 
of the input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Form natural logarithm" instruction is executed. 
The instruction forms the natural logarithm of the value at the "Tag_Value" input and stores 
the result in the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

EXP: Form exponential value

Description     
You can use the "Form exponential value" instruction to calculate the exponent from the base 
e (e = 2.718282) and the value specified at input IN. The result is provided at output OUT and 
can be queried there  (OUT = eIN).

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● The value at the IN input is not a valid floating-point number.
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Parameters
The following table shows the parameters of the "Form exponential value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Exponential value 
of input value IN

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Form exponential value" instruction is executed. 
The instruction calculates the exponent from base e and the value of operand "Tag_Value" 
and sends the result to the "Tag_Result" output. If the instruction is executed without errors, 
the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SIN: Form sine value

Description     
Use the "Form sine value" instruction to calculate the sine of the angle. The size of the angle 
is specified in radians at the IN input. The result of the instruction is sent to the OUT output 
and can be queried there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.
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Parameters
The following table shows the parameters of the "Form sine value" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Size of angle in 
radians

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Sine of the 
specified angle

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value +1.570796 (π/2)
OUT Tag_Result 1.0

If operand "TagIn" has the signal state "1", the "Form sine value" instruction is executed. The 
instruction calculates the sine of the angle specified at the "Tag_Value" input and stores the 
result in the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)
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COS: Form cosine value

Description     
Use the "Form cosine value" instruction to calculate the cosine of the angle. The size of the 
angle is specified in radians at the IN input. The result of the instruction is sent to the OUT 
output and can be queried there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form cosine value" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Size of angle in 
radians

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Cosine of the 
specified angle

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value +1.570796 (π/2)
OUT Tag_Result 0

If operand "TagIn" has the signal state "1", the "Form cosine value" instruction is executed. 
The instruction calculates the cosine of the angle specified at the "Tag_Value" input and stores 
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the result in the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

TAN: Form tangent value

Description     
Use the "Form tangent value" instruction to calculate the tangent of the angle. The size of the 
angle is specified in radians at the IN input. The result of the instruction is sent to the OUT 
output and can be queried there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form tangent value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Size of angle in 
radians

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Tangent of the 
specified angle

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value +3.141593 (π)
OUT Tag_Result 0

If operand "TagIn" has the signal state "1", the "Form tangent value" instruction is executed. 
The instruction calculates the tangent of the angle specified at the "Tag_Value" input and stores 
the result in the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ASIN: Form arcsine value

Description     
You can use the "Form arcsine value" instruction to calculate the size of the angle from the 
arcsine value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers within the range -1 to +1 can be specified at the IN input. The calculated angle size 
is output in radians at the OUT output and can range in value from -π/2 to +π/2. 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

● The value at the IN input is outside the permitted value range (-1 to +1).

Parameters
The following table shows the parameters of the "Form arcsine value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Sine value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Size of angle in 
radians

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 1.0
OUT Tag_Result +1.570796 (π/2)

If operand "TagIn" has the signal state "1", the "Form arcsine value" instruction is executed. 
The instruction calculates the size of the angle corresponding to the sine value at the 
"Tag_Value" input. The result of the instruction is stored in the "Tag_Result" output. If the 
instruction is executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ACOS: Form arccosine value

Description     
You can use the "Form arccosine value" instruction to calculate the size of the angle from the 
cosine value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers within the range -1 to +1 can be specified at the IN input. The calculated angle size 
is output in radians at the OUT output and can range in value from 0 to +π. 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

● The value at the IN input is outside the permitted value range (-1 to +1).
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Parameters
The following table shows the parameters of the "Form arccosine value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Cosine value 

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Size of angle in 
radians

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 0
OUT Tag_Result +1.570796 (π/2)

If operand "TagIn" has the signal state "1", the "Form arccosine value" instruction is executed. 
The instruction calculates the size of the angle corresponding to the cosine value at the 
"Tag_Value" input. The result of the instruction is stored in the "Tag_Result" output. If the 
instruction is executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)
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ATAN: Form arctangent value

Description     
You can use the "Form arctangent value" instruction to calculate the size of the angle from the 
tangent value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers may be specified at the IN input. The calculated angle size is output in radians at the 
OUT output and can range in value from -π/2 to +π/2.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form arctangent value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Tangent value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Size of angle in 
radians

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 1.0
OUT Tag_Result +0.785398 (π/4)
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If operand "TagIn" has the signal state"1", the "Form arctangent value" instruction is executed. 
The instruction calculates the size of the angle corresponding to the tangent value at the 
"Tag_Value" input. The result of the instruction is stored in the "Tag_Result" output. If the 
instruction is executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

FRAC: Return fraction

Description
You can use the "Return fraction" instruction to determine the decimal places of the value at 
the IN input. The result of the query is stored at the OUT output and can be queried there. If, 
for example, the IN input has the value 123.4567, the OUT output returns the value 0.4567.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Return fraction" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Value, whose 
decimal places 
are to be 
determined.

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Decimal places of 
the value at the IN 
input

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 2.555
OUT Tag_Result 0.555

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Return fraction" instruction 
is started. The decimal places from the value of operand "Tag_Value" are copied to operand 
"Tag_Result". If the instruction is executed without errors, the ENO output has the signal state 
"1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

EXPT: Exponentiate

Description     
You can use the "Exponentiate" instruction to raise the value at the IN1 input to a power 
specified with the value at the IN2 input. The result of the instruction is provided at the OUT 
output and can be queried there (OUT =IN1IN2).

The IN1 input can only be assigned valid floating-point numbers. Integers can also be assigned 
to the IN2 input.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● Errors occur during execution of the instruction, for example, an overflow occurs.
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Parameters
The following table shows the parameters of the "Exponentiate" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Base value

IN2 Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Value with which 
the base value is 
exponentiated

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Result

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Exponentiate" instruction 
is started. The value of operand "Tag_Value1" is raised to a power specified with the value of 
operand "Tag_Value2". The result is stored in the "Tag_Result" output. If the instruction is 
executed without errors, the ENO enable output has the signal state "1" and the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1716 System Manual, 07/2013,  



Move operations

MOVE: Move value

Description     
You use the "Move value" instruction to transfer the contents of the operand at the IN input to 
the operand at the OUT1 output. The transfer is always made in the direction of the ascending 
address.

The following table shows the available transfers for the S7-1200 CPU family:

Source (IN) Destination (OUT1)
With IEC check Without IEC check

BYTE BYTE, WORD, DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE ,TOD, CHAR

WORD WORD, DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD, CHAR

DWORD DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, REAL, TIME, DATE, TOD, CHAR

SINT SINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

USINT USINT, UINT, UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

INT INT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

UINT UINT, UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

DINT DINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

UDINT UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

REAL REAL DWORD, REAL
LREAL LREAL LREAL
TIME TIME BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, TIME
DATE DATE BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, DATE
TOD TOD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, TOD
DTL DTL DTL
CHAR CHAR BYTE, WORD, DWORD, CHAR, Character of a 

string1)

Character of a 
string1)

Character of a string Character of a string CHAR

ARRAY2) ARRAY ARRAY
STRUCT STRUCT STRUCT
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

PLC data type 
(UDT)

PLC data type (UDT) PLC data type (UDT)

IEC_TIMER IEC_TIMER IEC_TIMER
IEC_SCOUNTE
R

IEC_SCOUNTER IEC_SCOUNTER

IEC_USCOUNT
ER

IEC_USCOUNTER IEC_USCOUNTER

IEC_COUNTER IEC_COUNTER IEC_COUNTER
IEC_UCOUNTE
R

IEC_UCOUNTER IEC_UCOUNTER

IEC_DCOUNTE
R

IEC_DCOUNTER IEC_DCOUNTER

IEC_UDCOUN
TER

IEC_UDCOUNTER IEC_UDCOUNTER

The following table shows the available transfers for the S7-1500 CPU family:

Source (IN) Destination (OUT1)
With IEC check Without IEC check

BYTE BYTE, WORD, DWORD, 
LWORD

BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE ,TOD, LTOD, CHAR

WORD WORD, DWORD, LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, S5TIME, 
TIME, LTIME, LDT, DATE, TOD, LTOD, CHAR

DWORD DWORD, LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, REAL, TIME, 
LTIME, LDT, DATE, TOD, LTOD, CHAR

LWORD LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, LREAL, 
TIME, LTIME, LDT, DATE, TOD, LTOD, CHAR

SINT SINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

USINT USINT, UINT, UDINT, 
ULINT

BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

INT INT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

UINT UINT, UDINT, ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD. LTOD

DINT DINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1718 System Manual, 07/2013,  



Source (IN) Destination (OUT1)
With IEC check Without IEC check

UDINT UDINT, ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

LINT LINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

ULINT ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

REAL REAL DWORD, REAL
LREAL LREAL LWORD, LREAL
S5TIME S5TIME WORD, S5TIME
TIME TIME BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, TIME
LTIME LTIME BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LTIME
DATE DATE BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, DATE
DT DT DT
LDT LDT BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LDT
TOD TOD BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, TOD
LTOD LTOD BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LTOD
DTL DTL DTL
CHAR CHAR BYTE, WORD, DWORD, LWORD, CHAR, Character 

of a string1)

Character of a 
string1)

Character of a string Character of a string CHAR

ARRAY2) ARRAY ARRAY
STRUCT STRUCT STRUCT
COUNTER COUNTER, WORD, INT WORD, DWORD, INT, UINT, DINT, UDINT
TIMER TIMER, WORD, INT WORD, DWORD, INT, UINT, DINT, UDINT
PLC data type 
(UDT)

PLC data type (UDT) PLC data type (UDT)

IEC_TIMER IEC_TIMER IEC_TIMER
IEC_LTIMER IEC_LTIMER IEC_LTIMER
IEC_SCOUNTE
R

IEC_SCOUNTER IEC_SCOUNTER

IEC_USCOUNT
ER

IEC_USCOUNTER IEC_USCOUNTER

IEC_COUNTER IEC_COUNTER IEC_COUNTER
IEC_UCOUNTE
R

IEC_UCOUNTER IEC_UCOUNTER
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

IEC_DCOUNTE
R

IEC_DCOUNTER IEC_DCOUNTER

IEC_UDCOUN
TER

IEC_UDCOUNTER IEC_UDCOUNTER

IEC_LCOUNTE
R

IEC_LCOUNTER IEC_LCOUNTER

IEC_ULCOUNT
ER

IEC_ULCOUNTER IEC_ULCOUNTER

1) You can also use the "Move value" instruction to transfer individual characters of a string 
(STRING) to operands of CHAR data type. The number of the character to be transferred is 
given in brackets next to the operand name. "MyString[2]", for example, transfers the second 
character of the "MyString" string. It is also possible to transfer from operands of the data type 
CHAR to the individual characters of a string. You can also replace a specific character of a 
string with the character of another string. 
2) Transferring entire arrays (ARRAY) is possible only when the array components of the 
operands at input IN and at output OUT1 are of the same data type.

If the bit length of the data type at IN input exceeds the bit length of the data type at OUT1 
output, the higher order bits of the source value are lost. If the bit length of the data type at 
the  IN input is less than the bit length of the data type at the OUT1 output, then the more 
significant bits of the destination value will be overwritten with zeros.

In its initial state, the instruction box contains 1 output (OUT1). The number of outputs can be 
extended. The added outputs are numbered in ascending order on the box. When the 
instruction is executed, the content of the operand at the IN input is sent to all available outputs. 
The instruction box cannot be extended if structured data types (DTL, STRUCT, ARRAY) or 
characters of a string (STRING) are transferred.

The "Move block" (MOVE_BLK) and "Move block uninterruptible" (UMOVE_BLK) instructions 
can also be used to copy operands of the ARRAY data type. You can move operands of the 
STRING data type with the instruction "Move character string" (S_MOVE).

Parameters
The following table shows the parameters of the "Move value" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input Bit strings, 
integers, 
floating-point 
numbers, 
DATE, TIME, 
TOD, DTL, 
CHAR, 
STRUCT, 
ARRAY, IEC 
data types, 
PLC data type 
(UDT)

Bit strings, 
integers, 
floating-point 
numbers, 
DATE, DT, 
LDT, S5TIME, 
TIME, LTIME, 
TOD, LTOD, 
DTL, CHAR, 
STRUCT, 
ARRAY, 
TIMER, 
COUNTER, 
IEC data 
types, PLC 
data type 
(UDT)

I, Q, M, D, L or 
constant

Source value

OUT1 Output Bit strings, 
integers, 
floating-point 
numbers, 
DATE, TIME, 
TOD, DTL, 
CHAR, 
STRUCT, 
ARRAY, IEC 
data types, 
PLC data type 
(UDT)

Bit strings, 
integers, 
floating-point 
numbers, 
DATE, DT, 
LDT, S5TIME, 
TIME, LTIME, 
TOD, LTOD, 
DTL, CHAR, 
STRUCT, 
ARRAY, 
TIMER, 
COUNTER, 
IEC data 
types, PLC 
data type 
(UDT)

I, Q, M, D, L Operands to 
which in the 
source value is 
transferred.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
OUT1 TagOut_Value 0011 1111 1010 1111

If operand "TagIn" has the signal state "1", the "Move value" instruction is executed. The 
instruction copies the contents of operand "TagIn_Value" to operand "TagOut_Value" and sets 
output "TagOut" to signal state "1".

See also
Overview of the valid data types (Page 1077)

Removing inputs and outputs (Page 1290)

Basics of the EN/ENO mechanism (Page 1167)

MOVE_BLK: Move block (Page 1726)

UMOVE_BLK: Move block uninterruptible (Page 1731)

S_MOVE: Move character string (Page 2294)

Inserting additional inputs and outputs in LAD elements (Page 1289)

FieldRead: Read field

Description
You can use the "Read field" instruction to read out a specific component from the field 
specified at input MEMBER and transfer its content to the tag at output VALUE. You specify 
the index of the field component to be read at input INDEX. Specify the first component of the 
field from which reading is to occur at input MEMBER.

The data types of the field component at input MEMBER and the tags at output VALUE must 
correspond to the data type of the instruction "Read field".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The field component specified at input INDEX is not defined in the field specified at output 
MEMBER.

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Read field" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

INDEX Input DINT DINT I, Q, M, D, L, P 
or constant

Index of field 
component 
whose content 
is read out

MEMBER Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD and 
CHAR as 
components of 
an ARRAY tag

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD 
and CHAR as 
components of 
an ARRAY tag

D, L First 
component of 
the field from 
which reading 
occurs.

VALUE Output Bit strings, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD and 
CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD 
and CHAR

I, Q, M, D, L, P Operand to 
which the 
content of the 
field 
component is 
transferred

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Tag Value
INDEX a_index 4
MEMBER "DB_1".Main_Field[-10] First component of the "Main_Field[-10..10] of 

REAL" field in the "DB_1" data block
VALUE a_real Component with index 4 of the 

"Main_Field[-10..10] of REAL" field
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The field component with index 4 is read from the "Main_Field[-10...10] of REAL" field and 
written to the "a_real" tag. The field component to be read is specified by the value at input 
INDEX.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

FieldWrite: Write field

Description
The "Write field" instruction is used to transfer the content of the tag at the VALUE input to a 
specific component of the field at the MEMBER output. You use the value at the INDEX input 
to specify the index of the field component that is described. At the MEMBER output, enter the 
first component of the field which is to be written to.

The data types of the field component specified at the MEMBER output and the tags at the 
VALUE input have to match the data type of the "Write field" instruction.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The field component specified at the input INDEX is not defined in the field specified at the 
output MEMBER.

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Write field" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
INDEX Input DINT DINT I, Q, M, D, L, P 

or constant
Index of the 
field 
component 
that is being 
written with the 
content of 
VALUE.
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

VALUE Input Bit strings, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD and 
CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD 
and CHAR

I, Q, M, D, L, P 
or constant

Operand 
whose content 
is copied.

MEMBER Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD and 
CHAR as 
components of 
an ARRAY tag

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD 
and CHAR as 
components of 
an ARRAY tag

D, L First 
component of 
the field to 
which the 
content of 
VALUE is 
written.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
INDEX a_index 4
VALUE a_real 10.54
MEMBER "DB_1".Main_Field[-10] First component of the "Main_Field[-10..10] of 

REAL" field in the "DB_1" data block

The value "10.54" of the "a_real" tag is written to the field component with index 4 of the 
"Main_Field[-10..10] of REAL" field. The index of the field component to which the content of 
the tag "a_real" is transferred is specified by the value at the input INDEX.
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

MOVE_BLK: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). The number of elements to be moved to the 
destination area is specified at input COUNT. The width of the elements to be moved is defined 
by the width of the element at the IN input.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available at the IN input or OUT output.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the ARRAY structure is exceeded. If the byte limit of the ARRAY structure is 
exceeded by the value at the COUNT input, the ENO enable output is reset to "0".

Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN 1) Input Binary 

numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD

D, L The first 
element of the 
source area 
that is being 
copied

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L, P 
or constant

Number of 
elements to be 
copied from 
the source 
area to the 
destination 
area.
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

OUT 1) Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD

D, L The first 
element of the 
destination 
area to which 
the contents of 
the source 
area are being 
copied

1) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Move block" instruction is 
executed. Starting from the third element, the instruction selects three INT elements from the 
#a_array tag and copies their contents to the #b_array output tag, beginning with the second 
element. If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)
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MOVE_BLK_VARIANT: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). You can copy elements of an array to another array 
of the same data type. The size (number of elements) of the source and destination array may 
be different. You can copy several elements within an array or individual elements.

If you are using the instruction, the array must not yet be known at the time the block is created, 
as the source and the destination are transferred using VARIANT.

The counting at the parameters SRC_INDEX and DEST_INDEX always starts with the low 
limit "0", regardless of the later declaration of the array.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● The EN enable input has the signal state "0".

● More data is copied than is made available.

Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC Input VARIANT

(array or single 
element)

I, Q, D, L) The first element of the 
source area that is 
being copied

COUNT Input UDINT I, Q, M, D, L or constant Specifies the number 
of elements that will be 
copied.
Set the value at the 
parameter COUNT to 
“1”, if no Array is 
specified at the 
parameter SRC or the 
parameter DEST.
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Parameter Declaration Data type Memory area Description
SRC_INDEX Input UDINT I, Q, M, D, L or constant ● If an Array is 

specified at 
parameter SRC, 
the parameter 
SRC_INDEX 
specifies the first 
element at the 
parameter SRC, 
which is to be 
copied.

● If no Array is 
specified at the 
parameter SRC, 
then enter the 
value “0” at the 
parameter 
SRC_INDEX.

DEST_INDEX Input UDINT I, Q, M, D, L or constant ● If an Array is 
specified at 
parameter DEST, 
the parameter 
DEST_INDEX 
specifies the first 
element at the 
parameter DEST, 
which is to be 
copied.

● If no Array is 
specified at the 
parameter DEST, 
then enter the 
value “0” at the 
parameter 
DEST_INDEX.

DEST InOut VARIANT I, Q, D, L) The first element of the 
source area that is 
being copied

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during execution of the 
instruction, an error 
code is output on the 
RET_VAL parameter.

For additional information on valid data types, refer to "See also".
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Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8082 Data types do not correspond
80B4 Data types do not correspond
8151 Code generation error at SRC parameter
8152 Code generation error at SRC parameter
8153 Code generation error at SRC parameter
8251 The COUNT parameter has an invalid value
8254 The COUNT parameter has an invalid value
8281 The COUNT parameter has an invalid value
8282 The COUNT parameter has an invalid value
8382 The value at the SRC_INDEX parameter is outside the limit of the VARIANT
8383 The value at the SRC_INDEX parameter is outside the high limit of the array.
8482 The value at the DEST_INDEX parameter is outside the limit of the VARIANT
8483 The value at the DEST_INDEX parameter is outside the high limit of the 

array.
8534 The DEST parameter is write protected.
8551 Code generation error at DEST parameter
8552 Code generation error at DEST parameter
8553 Code generation error at DEST parameter
85A2 The DEST parameter is write protected.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
SRC #SrcField The local operand #SrcField 

uses a UDT that was still 
unknown at the time when the 
block was programmed.

COUNT Tag_Count 3
SRC_INDEX Tag_Src_Index 4
DEST_INDEX Tag_Dest_Index 2
DEST #DestField The local operand #DestField 

uses a UDT that was still 
unknown at the time when the 
block was programmed.

If the operand "TagIn" has the signal state "1", the "Move block" instruction is executed. If the 
instruction is executed without errors, the ENO enable output has the signal state "1" and the 
"TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

UMOVE_BLK: Move block uninterruptible

Description
You can use the "Move block uninterruptible" instruction to move the content of a memory area 
(source area) to another memory area (destination area). The number of elements to be moved 
to the destination area is specified with the COUNT parameter. The width of the elements to 
be moved is defined by the width of the element at the IN input.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The copy operation cannot be interrupted by other operating system activities. This is why 
the interrupt reaction times of the CPU increase during the execution of the "Move block 
uninterruptible" instruction.

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available at the IN input or OUT output.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the ARRAY structure is exceeded. If the byte limit of the ARRAY structure is 
exceeded by the value at the COUNT input, the ENO enable output is reset to "0".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1731



You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Parameters
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN 1) Input Binary 

numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD

D, L The first 
element of the 
source area 
that is being 
copied

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L, P 
or constant

Number of 
elements to be 
moved from 
the source 
area to the 
destination 
area.

OUT 1) Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD

D, L The first 
element of the 
destination 
area to which 
the contents of 
the source 
area are being 
copied

1) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Move block uninterruptible" 
instruction is executed. Starting from the third element, the instruction selects three INT 
elements from the #a_array tag and copies their contents to the #b_array output tag, beginning 
with the second element. The copy operation cannot be interrupted by other operating system 
activities. If the instruction is executed without errors, the ENO output has the signal state "1" 
and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

FILL_BLK: Fill block

Description
You can use the "Fill block" instruction to fill a memory area (destination area) with the value 
of the IN input.  The destination area is filled starting from the address specified at the OUT 
output. The number of repeated copy operations is specified with the COUNT parameter. When 
the instruction is executed, the value at the IN input is selected and copied to the destination 
area as often as specified by the value in the COUNT parameter.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available at the IN input or OUT output.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the ARRAY structure is exceeded. If the byte limit of the ARRAY structure is 
exceeded by the value at the COUNT input, the ENO enable output is reset to "0".
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Parameters
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Memory area
 
 

Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN 1) Input Binary 

numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD, CHAR

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

I, Q, M, D, L, P 
or constant

Element used 
to fill the 
destination 
area

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L, P 
or constant

Number of 
repeated move 
operations

OUT 2) Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD, CHAR

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

D, L Address in 
destination 
area from 
which filling 
starts.

1) The specified data types can also be used as elements of an ARRAY structure.
2) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1734 System Manual, 07/2013,  



Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Fill block" instruction is 
executed. The instruction copies the third element (#a_array[2]) of the #a_array tag three times 
to the #b_array output tag. If the instruction is executed without errors, the ENO and "TagOut" 
enable outputs are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

UFILL_BLK: Fill block uninterruptible

Description
You can use the "Fill block uninterruptible" instruction to fill a memory area (destination area) 
with the value of the IN input without interruption.  The destination area is filled starting from 
the address specified at the OUT output. The number of repeated copy operations is specified 
with the COUNT parameter. When the instruction is executed, the value at the IN input is 
selected and copied to the destination area as often as specified by the value in the COUNT 
parameter.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The copy operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the "Fill block 
uninterruptible" instruction.

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available at the IN input or OUT output.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the ARRAY structure is exceeded. If the byte limit of the ARRAY structure is 
exceeded by the value at the COUNT input, the ENO enable output is reset to "0".
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You can use the "Fill block uninterruptible" instruction to move a maximum of 16 KB. Note the 
CPU-specific restrictions for this.

Parameters
The following table shows the parameters of the "Fill block uninterruptible" instruction:

Parameter Declaration Data type Memory area
 

Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN 1) Input Binary 

numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

I, Q, M, D, L, P 
or constant

Element used 
to fill the 
destination 
area.

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L, P 
or constant

Number of 
repeated move 
operations

OUT 2) Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

D, L Address in 
destination 
area from 
which filling 
begins.

1) The specified data types can also be used as elements of an ARRAY structure.
2) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Fill block uninterruptible" 
instruction is executed. The instruction copies the third element (#a_array[2]) of the #a_array 
tag three times to the #b_array output tag. The copy operation cannot be interrupted by other 
operating system activities. If the instruction is executed without errors, the ENO and "TagOut" 
enable outputs are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

SWAP: Swap

Description       
You can use the "Swap" instruction to change the order of the bytes at input IN and query the 
result at output OUT.

The following figure shows how the bytes of an operand of the DWORD data type are swapped 
using the "Swap" instruction:
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Parameter
The following table shows the parameters of the "Swap" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input WORD, 

DWORD
WORD, 
DWORD, 
LWORD

I, Q, M, D, L or, 
P constant

Operand 
whose bytes 
are swapped.

OUT Output WORD, 
DWORD

WORD, 
DWORD, 
LWORD

I, Q, M, D, L, P Result

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1738 System Manual, 07/2013,  



The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0000 1111 0101 0101
OUT TagOut_Value 0101 0101 0000 1111

If operand "TagIn" has the signal state "1", the "Swap" instruction is executed. The order of 
the bytes is changed and stored in operand "TagOut_Value".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Array data blocks

ReadFromArrayDB: Read from array data block

Description
You can use the "Read from array data block" instruction to read data from an array DB.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table shows the parameters of the "Read from array data block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
DB Input DB_ANY I, Q, M, D, L Data block that is 

read
INDEX Input DINT I, Q, M, D, L Element that is 

read
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Parameter Declaration Data type Memory area Description
VALUE InOut VARIANT I, Q, M, D, L Value that is read
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during execution 
of the instruction, 
an error code is 
output on the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

WriteToArrayDB: Write to array data block

Description
You can use the "Write to array data block" instruction to write data to an array DB.
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An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table shows the parameters of the "Write to array data block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
DB Input DB_ANY I, Q, M, D, L Data block to 

which data is 
written

INDEX Input DINT I, Q, M, D, L Element in the DB 
to which data is 
written

VALUE Input VARIANT I, Q, M, D, L Value to be written
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during execution 
of the instruction, 
an error code is 
output on the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
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Error code*
(W#16#...)

Explanation

8282 The value at the INDEX parameter is outside the 
limit values of the array.

8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

ReadFromArrayDBL: Read from array data block in load memory

Description
You can use the "Read from array data block in load memory" instruction to read data from an 
array DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". The instruction is terminated if a negative 
signal edge is detected at the BUSY parameter. The DONE parameter has the signal state "1" 
for one program cycle and the read value is output at the VALUE parameter within this cycle. 
With all other program cycles, the value at the VALUE parameter is not changed.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.
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Parameters
The following table shows the parameters of the "Read from array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L REQ = "1": 

Starting with the 
reading of the 
array DB

DB Input DB_ANY I, Q, M, D, L Data block that is 
read

INDEX Input DINT I, Q, M, D, L Element that is 
read

BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 
array DB is still 
being read

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully

VALUE InOut VARIANT I, Q, M, D, L Value that is read
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during execution 
of the instruction, 
an error code is 
output on the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
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Error code*
(W#16#...)

Explanation

8282 The value at the INDEX parameter is outside the 
limit values of the array.

8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

WriteToArrayDBL: Write to array data block in load memory

Description
You can use the "Write to array data block in load memory" instruction to write data to an array 
DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". If a negative signal edge is detected at the 
BUSY parameter, the instruction is terminated and the value at the VALUE parameter is written 
to the data block. The DONE parameter then has the signal state "1" for one program cycle.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.
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Parameters
The following table shows the parameters of the "Write to array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L REQ = "1": Start 

writing into the 
array DB

DB Input DB_ANY D Data block to 
which data is 
written

INDEX Input DINT I, Q, M, D, L Element in the DB 
to which data is 
written

VALUE Input VARIANT I, Q, M, D, L Value to be written
BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 

array DB is still 
being written

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during execution 
of the instruction, 
an error code is 
output on the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
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Error code*
(W#16#...)

Explanation

8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Other

BLKMOV: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). The move operation takes place in the direction 
of ascending addresses. You use VARIANT to define the source and destination area.

 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

The following figure shows the principle of the move operation:
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Consistency of the source data and the target data
Make sure that the source data remain unchanged during execution of the instruction Move 
block instruction. Otherwise the consistency of the target data cannot be ensured.

Interrupt ability
There is no limit to the nesting depth.

Memory areas
You can use the "Move block" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap. If the source and destination area have 
different lengths, only the length of the smaller area will be moved.

If the source area is less than the destination area, the entire source area will be written to the 
destination area. The remaining bytes of the destination area remain unchanged.

If the destination area is less than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.
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If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

Rules for moving character strings
You can use the "Move block" instruction to also move source and destination areas of the 
STRING data type. If only the source area is STRING data type, the characters will be moved 
that are actually contained in the character string. Information on the actual and maximum 
length is also written to the destination area. If the source and destination area are each 
STRING data type, the current length of the character string in the destination area is set to 
the number of actually moved characters.

If you want to move the information on the maximum and actual length of a character string, 
specify the areas in bytes to the SRCBLK and DSTBLK parameters.

Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRCBLK Input VARIANT I, Q, M, D, L Specifies the memory area to be 

moved (source area).
RET_VAL Output INT I, Q, M, D, L, P Error information:

If an error occurs during 
execution of the instruction, an 
error code is output at the 
RET_VAL parameter.

DSTBLK Output VARIANT I, Q, M, D, L Specifies the memory area to 
which the block is to be moved 
(destination area).

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8091 The permitted nesting depth was exceeded
8092 The instruction cannot be executed because a specified data block is write protection, non-executable or 

unloaded.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 1787)

Inserting additional inputs and outputs in LAD elements (Page 1289)

UBLKMOV: Move block uninterruptible

Description
You can use the "Move block uninterruptible" instruction to move the content of a memory area 
(source area) to another memory area (destination area). The move operation takes place in 
the direction of ascending addresses. You use VARIANT to define the source and destination 
area.

The copy operation cannot be interrupted by other operating system activities. As a result the 
alarm reaction time of the CPU can increase during the execution of the "Move block 
uninterruptible" instruction.

 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

Memory areas
You can use the "Move block uninterruptible" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap during the execution of the "Move block 
uninterruptible" instruction. If the source area is less than the destination area, the entire source 
area will be written to the destination area. The remaining bytes of the destination area remain 
unchanged.

If the destination area is less than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a source or destination area defined as a formal parameter is less than a destination or 
source area specified on the SRCBLK or DSTBLK parameter, no data will be transferred.
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If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Rules for moving character strings
You can use the "Move block uninterruptible" instruction to also move source and destination 
areas of the STRING data type. If only the source area is STRING data type, the characters 
will be moved that are actually contained in the character string. Information on the actual and 
maximum length are not written in the destination area. If the source and destination area are 
each STRING data type, the current length of the character string in the destination area is 
set to the number of actually moved characters. If areas of the data type STRING are moved, 
you have to specify "1" as area length.

Parameters
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRCBLK Input VARIANT I, Q, M, D, L Specifies the memory area to 

be moved (source area).
RET_VAL Output INT I, Q, M, D, L, P Error information:

If an error occurs during 
execution of the instruction, an 
error code is output at the 
RET_VAL parameter.

DSTBLK Output VARIANT I, Q, M, D, L Specifies the memory area to 
which the block is to be moved 
(destination area).

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8091 The source area is in a data block that is not relevant for program execution.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 1787)

Inserting additional inputs and outputs in LAD elements (Page 1289)

FILL: Fill block

Description
You can use the "Fill block" instruction to fill a memory area (destination area) with the content 
of another memory area (source area). The "Fill block" instruction moves the content of the 
source area to the destination area until the destination area is completely written. The move 
operation takes place in the direction of ascending addresses.

You use VARIANT to define the source and destination area.
 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

For blocks with the "Optimized block access" attribute, you can use the "FILL_BLK: Fill block" 
instruction.

 

The following figure shows the principle of the move operation:
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Example: The contents of the range MW100 to MW118 are to be preassigned with the contents 
of the memory words MW14 to MW20.

Consistency of the source data and the target data
Please note that during execution of the instruction "Fill block" that the source data remain 
unchanged, otherwise the consistency of the target data is not ensured.

Memory areas
You can use the "Fill block" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap. If the destination block to be preset is not 
an integer multiple of the length of the input parameter BVAL, the destination block is 
nevertheless written up to the last byte.

If the destination area to be preset is smaller than the source area, the function only copies as 
much data as can be written to the destination area.

If the destination or source block actually present is smaller than the assigned memory area 
for the source or destination block (BVAL BLK parameters), no data will be transferred.

If the ANY pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.

If the destination block is of data type STRING, the instruction describes the entire string 
including the administration information.

Parameters
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
BVAL Input VARIANT I, Q, M, D, L Specification of the memory area 

(source area) with whose content 
the destination area on the BLK 
parameter will be filled.
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Parameter Declaration Data type Memory area Description
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs during 
execution of the instruction, an 
error code is output at the 
RET_VAL parameter.

BLK Output VARIANT I, Q, M, D, L Specification of the memory area 
that will be filled with the content 
of the source area.

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 1787)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Conversion operations

CONVERT: Convert value

Description       
The "Convert value" instruction reads the content of the IN parameter and converts it according 
to the data types selected in the instruction box. The converted value is sent to the output OUT.

For information on possible conversions, refer to the "Explicit conversion" section at "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:
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● The EN enable input has the signal state "0".

● Errors such as an overflow occur during execution.

● An operand of data type BYTE, WORD, DWORD or LWORD is specified at the IN input. 
This operand's most significant bit is set. A signed integer (SINT, INT, DINT, LINT) is 
specified at the OUT output. It has the same bit length as the operand at the IN input.

Parameters
The following table shows the parameters of the "Convert value" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers, floating-
point numbers, 
CHAR, BCD16, 
BCD32

I, Q, M, D, L, P or 
constant

Value to be 
converted.

OUT Output Bit strings, 
integers, floating-
point numbers, 
CHAR, BCD16, 
BCD32

I, Q, M, D, L, P Result of the 
conversion

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

Bit strings (BYTE, WORD, DWORD, LWORD) cannot be selected in the instruction box. If you 
have specified an operand of data type BYTE, WORD, DWORD or LWORD at a parameter of 
the instruction, the value of the operand is interpreted as an unsigned integer with the same 
bit length. In this case the data type BYTE is interpreted as USINT, WORD as UINT, DWORD 
as UDINT, and LWORD as LINT.

 

 Note

For S7-1500 CPU: The data types DWORD and LWORD can be selected, if REAL or LREAL 
is selected as IN data type.

 

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the content of operand "TagIn_Value" is read and 
converted to an integer (32-bit). The result is stored in operand "TagOut_Value". The output 
"TagOut" is set to "1" if the instruction was executed without errors.

See also
Overview of the valid data types (Page 1077)

Explicit conversion of CHAR (Page 1165)

ROUND: Round numerical value

Description     
You can use the "Round numerical value" instruction to round the value at input IN  to the 
nearest integer. The instruction interprets the value at input IN as a floating-point number and 
converts this to an integer of data type DINT. If the input value is exactly between an even and 
odd number, the even number is selected. The result of the instruction is sent to the OUT 
output and can be queried there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Round numerical value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value to be 
rounded.

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Result of rounding

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 1.50000000 -1.50000000
OUT TagOut_Value 2 -2

If operand "TagIn" has the signal state "1", the "Round numerical value" instruction is executed. 
The floating-point number at input "TagIn_Value" is rounded to the nearest even integer and 
sent to output "TagOut_Value". If the instruction is executed without errors, the "TagOut" output 
is set.

See also
Overview of the valid data types (Page 1077)

CEIL: Generate next higher integer from floating-point number

Description     
You can use the "Generate next higher integer from floating-point number" instruction to round 
the value at input IN to the next higher integer. The instruction interprets the value at the IN 
input as a floating-point number and converts this number to the next higher integer. The result 
of the instruction is sent to the OUT output and can be queried there. The output value can be 
greater than or equal to the input value.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● Errors such as an overflow occur during execution.
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Parameters
The following table shows the parameters of the "Generate next higher integer from floating-
point number" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Result with next 
higher integer

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0.50000000 -0.50000000
OUT TagOut_Value 1 0

If operand "TagIn" has the signal state "1", the "Generate next higher integer from floating-
point number" instruction is executed. The floating-point number at the "TagIn_Value" input is 
rounded to the next higher integer and sent to the "TagOut_Value" output. If the instruction is 
executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)
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FLOOR: Generate next lower integer from floating-point number

Description     
You can use the "Generate next lower integer from floating-point number" instruction to round 
the value at input IN to the next lower integer. The instruction interprets the value at input IN 
as a floating-point number and converts this to the next lower integer. The result of the 
instruction is sent to the OUT output and can be queried there. The output value can be less 
than or equal to the input value.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Generate next lower integer from floating-
point number" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Result with next 
lower integer

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1758 System Manual, 07/2013,  



Parameter Operand Value
IN TagIn_Value 0.50000000 -0.50000000
OUT TagOut_Value 0 -1

If operand "TagIn" has the signal state "1", the "Generate next lower integer from floating-point 
number" instruction is executed. The floating-point number at input "TagIn_Value" is rounded 
to the next lower integer and sent to output "TagOut_Value". If the instruction is executed 
without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

TRUNC: Truncate numerical value

Description       
You can use the "Truncate numerical value" instruction to form an integer from the value at 
the IN input. The value at the IN input is interpreted as a floating-point number. The instruction 
selects only the integer part of the floating-point number and sends this to the OUT output 
without decimal places.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN input has the signal state "0".

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Truncate numerical value" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L or 
constant

Input value

OUT Output Integers, floating-
point numbers

I, Q, M, D, L Integer part of the 
input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 1.50000000 -1.50000000
OUT TagOut_Value 1 -1

If operand "TagIn" has the signal state "1", the "Truncate numerical value" instruction is 
executed. The integer part of the floating-point number at the "TagIn_Value" input is converted 
to an integer and sent to the "TagOut_Value" output. If the instruction is executed without 
errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

SCALE_X: Scale

Description
You can use the "Scale" instruction to scale the value at the VALUE input  by mapping it to a 
specified value range. When the "Scale" instruction is executed, the floating-point value at the 
VALUE input is scaled to the value range that was defined by the MIN and MAX parameters. 
The result of the scaling is an integer, which is stored in the OUT output.

The following figure shows an example of how values can be scaled:
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The "Scale" instruction works with the following equation:

OUT = [VALUE ∗ (MAX – MIN)] + MIN

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the MIN input is greater than or equal to the value at the MAX input.

● The value of a specified floating-point number is outside the range of the normalized 
numbers according to IEEE-754.

● An overflow occurs.

● The value at the VALUE input is NaN (Not a Number = result of an invalid arithmetic 
operation).

Parameters
The following table shows the parameters of the "Scale" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
MIN Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VALUE Input Floating-point 
numbers

I, Q, M, D, L or 
constant

Value to be scaled.
If you enter a 
constant, you 
must declare it.
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Parameter Declaration Data type Memory area Description
MAX Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

High limit of the 
value range

OUT Output Integers, floating-
point numbers

I, Q, M, D, L Result of scaling

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MIN Tag_MIN 10
VALUE Tag_Value 0.5
MAX Tag_MAX 30
OUT Tag_Result 20

If operand "TagIn" has the signal state "1", the "Scale" instruction is executed. The value at 
the "Tag_Value" input is scaled to the range of values defined by the values at the "Tag_MIN" 
and "Tag_MAX" inputs. The result is stored in the "Tag_Result" output. If the instruction is 
executed without errors, the ENO enable output has the signal state "1" and the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1077)

NORM_X: Normalize (Page 1763)

Declaring constants (Page 1188)
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NORM_X: Normalize

Description
You can use the instruction "Normalize" to normalize the value of the tag at the VALUE input 
by mapping it to a linear scale. You can use the MIN and MAX parameters to define the limits 
of a value range that is applied to the scale. The result at the OUT output is calculated and 
stored as a floating-point number depending on the location of the value to be normalized 
within this value range. If the value to be normalized is equal to the value at the MIN input, the 
OUT output has the value "0.0". If the value to be normalized is equal to the value at input 
MAX, output OUT returns the value "1.0".

The following figure shows an example of how values can be normalized:

The "Normalize" instruction works with the following equation:

OUT = (VALUE – MIN) / (MAX – MIN)

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the MIN input is greater than or equal to the value at the MAX input.

● The value of a specified floating-point number is outside the range of the normalized 
numbers according to IEEE-754.

● The value at the VALUE input is NaN (result of an invalid arithmetic operation).
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Parameter
The following table shows the parameters of the "Normalize" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
MIN 1) Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VALUE 1) Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Value to be 
normalized.

MAX 1) Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

OUT Output Floating-point 
numbers

I, Q, M, D, L Result of the 
normalization

1) If you use constants in these three parameters, you only need to declare one of them.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MIN Tag_MIN 10
VALUE Tag_Value 20
MAX Tag_MAX 30
OUT Tag_Result 0.5

If operand "TagIn" has the signal state "1", the "Normalize" instruction is executed. The value 
at the "Tag_Value" input is mapped to the range of values that were defined by the values at 
the "Tag_MIN" and "Tag_MAX" inputs. The tag value at the "Tag_Value" input is normalized 
to the defined value range. The result is stored as a floating-point number in the "Tag_Result" 
output. If the instruction is executed without errors, the ENO enable output has the signal state 
"1" and the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1077)

SCALE_X: Scale (Page 1760)

Declaring constants (Page 1188)

Other

SCALE: Scale

Description
Use the "Scale" instruction to convert the integer at the IN parameter into a floating-point 
number, which can be scaled in physical units between a low limit value and a high limit value. 
You can use the LO_LIM and HI_LIM parameters to specify the low limit and high limit of the 
value range to which the input value is scaled. The result of the instruction is output on the 
OUT parameter.

The "Scale" instruction works with the following equation:

OUT = [((FLOAT (IN) – K1)/(K2–K1)) ∗ (HI_LIM–LO_LIM)] + LO_LIM

The values of the constants "K1" and "K2" are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter:

● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0,0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the constant "K2", the result 
of the instruction is set to the value of the high limit (HI_LIM) and an error is output. 

When the value at the IN parameter is less than the value of the constant "K1", the result of 
the instruction is set to the value of the low limit value (LO_LIM) and an error is output. 

When the indicated low limit value is greater than the high limit value (LO_LIM > HI_LIM), the 
result is scaled in reverse proportion to the input value. 

Parameter
The following table shows the parameters of the "Scale" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input INT I, Q, M, D, L, P or 

constant
Input value to be 
scaled.
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Parameter Declaration Data type Memory area Description
HI_LIM Input REAL I, Q, M, D, L, P or 

constant
High limit 

LO_LIM Input REAL I, Q, M, D, L, P or 
constant

Low limit

BIPOLAR Input BOOL I, Q, M, D, L or 
constant

Indicates if the 
value at IN 
parameter is to be 
interpreted as 
bipolar or unipolar. 
The parameter 
can assume the 
following values:
1: Bipolar
0: Unipolar

OUT Output REAL I, Q, M, D, L, P Result of the 
instruction

RET_VAL Output WORD I, Q, M, D, L, P Error information

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0008 The value of the  IN parameter is greater than the value of the constant "K2" or less than the value of the 

constant "K1"
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN Tag_InputValue 22
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_OutputValue 50.03978588
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 1787)

UNSCALE: Unscale

Description
The "Unscale" instruction is used to unscale the floating-point number on the IN parameter 
into physical units between a low limit and a high limit and convert it into an integer. You can 
use the LO_LIM and HI_LIM parameters to specify the low limit and high limit of the value range 
to which the input value is unscaled. The result of the instruction is output on the OUT 
parameter.

The "Unscale" instruction works with the following equation:

OUT = [ ((IN–LO_LIM)/(HI_LIM–LO_LIM)) ∗ (K2–K1) ] + K1

The values of the constants "K1" and "K2" are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter: 

● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the constant "HI_LIM", the 
result of the instruction is set to the value of the constant (K2) and an error is output. 

When the value at the IN parameter is less than the value of the constant of the low limit 
(LO_LIM), the result of the instruction is set to the value of the constant (K1) and an error is 
output.
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Parameters
The following table shows the parameters of the "Unscale" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Input BOOL I, Q, M, D, L Enable output
IN Input REAL I, Q, M, D, L, P or 

constant
Input value to be 
unscaled to an 
integer value.

HI_LIM Input REAL I, Q, M, D, L, P or 
constant

High limit

LO_LIM Input REAL I, Q, M, D, L, P or 
constant

Low limit

BIPOLAR Input BOOL I, Q, M, D, L or 
constant

Indicates if the 
value at IN 
parameter is to be 
interpreted as 
bipolar or unipolar. 
The parameter 
can assume the 
following values:
1: Bipolar
0: Unipolar

OUT Output INT I, Q, M, D, L, P Result of the 
instruction

RET_VAL Output WORD I, Q, M, D, L, P Error information

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0008 The value of the IN parameter is greater than the value of the high limit (HI_LIM) or less than the value 

of the low limit (LO_LIM).
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 50.03978588
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_OutputValue 22
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 1787)

Program control operations

---( JMP ): Jump if RLO = 1

Description     
You can use the "Jump if RLO = 1" instruction to interrupt the linear execution of the program 
and resume it in another network. The destination network must be identified by a jump label 
(LABEL). The name of this jump label is specified in the placeholder above the instruction.

The specified jump label must be in the same block in which the instruction is executed. The 
name you specify can only occur once in the block. Only one jumping coil is permitted within 
a network.

If the result of logic operation (RLO) at the input of the instruction is "1", the jump to the network 
identified by the specified jump label is executed. The jump direction can be towards higher 
or lower network numbers.
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If the condition at the input of the instruction is not fulfilled (RLO = 0), execution of the program 
continues in the next network.

Example
The following example shows how the instruction works:

If operand "TagIn_1" has the signal state "1", the "Jump if RLO = 1" instruction is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If the "TagIn_3" input has the signal state "1", the "TagOut_3" 
output is set.

---( JMPN ): Jump if RLO = 0

Description     
You can use the instruction "Jump if RLO = 0" to interrupt the linear execution of the program 
and resume it in another network, when the result of logic operation at the input of the 
instruction is "0". The destination network must be identified by a jump label (LABEL). The 
name of this jump label is specified in the placeholder above the instruction.

The specified jump label must be in the same block in which the instruction is executed. The 
name you specify can only occur once in the block. Only one jumping coil is permitted within 
a network.

If the result of logic operation (RLO) at the input of the instruction is "0", the jump to the network 
identified by the specified jump label is executed. The jump direction can be towards higher 
or lower network numbers.

If the result of logic operation at the input of the instruction is "1", execution of the program 
continues in the next network.
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Example
The following example shows how the instruction works:

If operand "TagIn_1" has the signal state "0", the "Jump if RLO = 0" instruction is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If the "TagIn_3" input has the signal state "1", the "TagOut_3" 
output is set.

See also
Overview of the valid data types (Page 1077)

LABEL: Jump label

Description       
You can use a jump label to identify a destination network, in which the program execution 
should resume when a jump is executed.

The jump label and the instruction in which the jump label is specified must be located in the 
same block. The name of a jump label can only be assigned once in a block. You can declare 
up to 32 jump labels when you use a CPU S7-1200 and a maximum of 256 jump labels when 
you use a CPU S7-1500.

Only one jump label can be placed in a network. Each jump label can jump to several locations.
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Example
The following example shows how the instruction works:

If operand "TagIn_1" has the signal state "1", the "Jump if RLO = 1" instruction is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If the "TagIn_3" input has the signal state "1", the "TagOut_3" 
output is set.

See also
Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

JMP_LIST: Define jump list

Description       
You can use the "Define jump list" instruction to define several conditional jumps and continue 
the program execution in a specific network depending on the value of the K parameter.

You define the jumps with jump labels (LABEL), which you specify at the outputs of the 
instruction box. The number of outputs can be expanded in the instruction box. You can declare 
up to 32 outputs when you use a CPU S7-1200 and a maximum of 256 outputs when you use 
a CPU S7-1500.

The numbering of the outputs begins with the value "0" and continues in ascending order with 
each new output. Only jump labels can be specified at the outputs of the instruction. Instructions 
or operands cannot be specified.

The value of the K parameter specifies the number of the output and thus the jump label where 
the program execution is to be resumed. If the value in the K parameter is greater than the 
number of available outputs, the program execution is resumed in the next network of the block.
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The "Define jump list" instruction is only executed if the signal state is "1" at the EN enable 
input.

Parameter
The following table shows the parameters of the "Define jump list" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
K Input UINT I, Q, M, D, L or 

constant
Specifies the 
number of the 
output and thus 
the jump that is to 
be made.

DEST0 - - - First jump label
DEST1 - - - Second jump label
DESTn - - - Optional jump 

labels

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand/Jump label Value
K Tag_Value 1
Dest0 LABEL0 Jump to the network that is 

identified with the jump label 
"LABEL0".

Dest1 LABEL1 Jump to the network that is 
identified with the jump label 
"LABEL1".

Dest2 LABEL2 Jump to the network that is 
identified with the jump label 
"LABEL2".
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If operand "Tag_Input" has the signal state "1", the "Define jump list" instruction is executed. 
The program execution is resumed according to the value of operand "Tag_Value" in the 
network that is identified with the jump label "LABEL1".

See also
Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

SWITCH: Jump distributor

Description       
You can use the "Jump distributor" instruction to define multiple program jumps to be executed 
depending on the result of one or more comparison instructions.

You specify the value to be compared in the K parameter. This value is compared with the 
values that are provided by the various inputs. You can select the comparison method for each 
individual input. The availability of the various comparison instructions depends on the data 
type of the instruction.

The following table shows the comparison instructions that are available depending on the 
selected data type:

Data type Instruction Syntax
S7-1200 S7-1500
Bit strings Bit strings Equal ==

Not equal <>
Integers, floating-point 
numbers, TIME, 
DATE, TOD

Integers, floating-point 
numbers, TIME, 
LTIME, DATE, TOD, 
LTOD, LDT

Equal ==
Not equal <>
Greater or equal >=
Less or equal <=
Greater than >
Less than <

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box. If you select a comparison instruction and the data type of the instruction is not yet defined, 
the "<???>" drop-down list only offers the data types that are permitted for the selected 
comparison instruction.

Execution of the instruction begins with the first comparison and runs until a comparison 
condition is met. If a comparison condition is met, the subsequent comparison conditions are 
not considered. If none of the specified comparison conditions are met, the jump at the ELSE 
output is executed. If no program jump is defined at the ELSE output, execution of the program 
continues in the next network.

The number of outputs can be expanded in the instruction box. The numbering of the outputs 
begins with the value "0" and continues in ascending order with each new output. Specify jump 
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labels (LABEL) at the outputs of the instruction. Instructions or operands cannot be specified 
at the outputs of the instruction.

An input is automatically inserted for each additional output. The jump programmed at an 
output is executed if the comparison condition of the corresponding input is fulfilled.

Parameters
The following table shows the parameters of the "Jump distributor" instruction:

Parameter Declarati
on

Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
K Input UINT UINT I, Q, M, D, L or 

constant
Specifies the value to 
be compared.

<Comparison 
values>

Input Bit strings, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD

Bit strings, 
integers, 
floating-point 
numbers, 
TIME, 
LTIME, 
DATE, TOD, 
LTOD, LDT

I, Q, M, D, L or 
constant

Input value with 
which the value of the 
K parameter is 
compared.

DEST0 - - - - First jump label
DEST1 - - - - Second jump label
DEST(n) - - - - Optional jump 

labels(n = 2 to 99)
ELSE - - - - Program jump that is 

executed when none 
of the comparison 
conditions are 
fulfilled.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand/Jump label Value
K Tag_Value 23
== Tag_Value_1 20
> Tag_Value_2 21
< Tag_Value_3 19
Dest 0 LABEL0 Jump to jump label "LABEL0", if 

the value of the K parameter 
equals 20.

Dest 1 LABEL1 Jump to jump label "LABEL1" if 
the value of the K parameter is 
greater than 21.

Dest 2 LABEL2 Jump to jump label "LABEL2", if 
the value of the K parameter is 
less than 19.

ELSE LABEL 3 Jump to jump label "LABEL3", if 
the none of the comparison 
conditions are fulfilled.

If the operand "Tag_Input" changes to signal state "1", the instruction "Jump distributor" is 
executed. The execution of the program is continued in the network that is identified with the 
jump label "LABEL1".

See also
Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)
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--(RET): Return

Description     
You can use the "Return" instruction to stop the execution of a block. The results is three types 
through which the block processing can be completed.

● Without call of the "Return" instruction
The block is exited after execution of the last network. The ENO of the function call is set 
to the signal state "1".

● Call of the "Return" instruction with preceding logic operation (see example)
If the left connector has the signal state "1", the block will be exited. The ENO of the function 
call corresponds to the operand.

● Call of the "Return" instruction without previous logic operation
The block is exited. The ENO of the function call corresponds to the operand.

 

  Note

Only one jumping coil may be used in a network ("Return", "Jump if RLO=1", "Jump if 
RLO=0").

 

If the result of logic operation (RLO) at the input of the "Return" instruction is "1", program 
execution is terminated in the currently called block and resumed after the call function in the 
calling block (for example, in the calling OB). The status (ENO) of the call function is determined 
by the parameter of the instruction. This can assume the following values:

● RLO

● TRUE/FALSE

● <Operand>

To set the parameter values, double-click the instruction and select the corresponding value 
in the drop-down list.

The following table shows the status of the call function if the "Return" instruction is 
programmed in a network within the called block:

RLO Parameter value ENO of the call function
1 RLO 1

TRUE 1
FALSE 0
<Operand> <Operand>

0 RLO The program execution continues in the 
next network of the called block.TRUE

FALSE
<Operand>

If an OB is completed, another block will be selected and started or executed by the priority 
class system:
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● If the program cycle OB was completed, it will be restarted.

● If an OB is completed that has interrupted another block (for example, an alarm OB), then 
the interrupted block (for example, program cycle OB) will be executed.

Parameters
The following table shows the parameters of the "Return" instruction:

Parameter Declaration Data type Memory area Description
Status of the 
calling function 
with RLO = 1:
RLO - -  Is set to the signal 

status of the RLO.
TRUE - -  1
FALSE - -  0
<Operand> Input BOOL I, Q, M, D, L Signal state of the 

specified operand

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Return" instruction is executed. Program 
execution is terminated in the called block and continues in the calling block. The ENO enable 
output of the call function is reset to signal state "0".

See also
Overview of the valid data types (Page 1077)

Runtime control

ENDIS_PW: Limit and enable password legitimation

Description
You can use the "Limit and enable password legitimation" instruction to specify whether or not 
legitimation is allowed for the CPU. You can prevent legitimated connections, even when the 
correct password is known. When you invoke the command and the REQ parameter has the 
signal state "0", only the currently set condition is displayed at the output parameters, but no 
setting is changed. If the REQ parameter has the signal state "1", the signal state is taken from 
the input parameters (F_PWD, FULL_PWD, R_PWD, HMI_PWD). FALSE means that 
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legitimation per password is not allowed; TRUE means the password can be used. Disable or 
enabling of the passwords can be allowed or prohibited individually. For example, all 
passwords can be prohibited, except the fail-safe password. You can thus limit access options 
to a small user group. The output parameters (F_PWD_ON, FULL_PWD_ON, R_PWD_ON, 
HMI_PWD_ON) always show the current status of the password use, regardless of the REQ 
parameter.

The same setting can be made on the front panel of the CPU and the CPU saves the most 
recent setting.

To prevent accidental lockout, the protection can be disabled by setting the mode switch to 
STOP with an S7-1500 CPU. The protection is automatically enabled again by setting mode 
selector to RUN without having to call the "Limit and enable password legitimation" instruction 
again or taking additional actions on the front panel.

The instruction must always be fully executed, in other words, the F_PWD parameter must 
always have the signal state "0", for example, so that the settings can be saved.

Disabled passwords can be enabled again under the following conditions:

● The CPU is reset to its factory settings.

● The front panel of the S7-1500 CPU supports a dialog that allows you to navigate to the 
appropriate menu in which the passwords can be enabled again.

● When you call the "Limit and enable password legitimation" instruction, the input parameter 
of the desired password has the signal state "1".

● Set the mode selector to STOP. The restriction to password legitimation is re-established 
as soon as the switch is set back to RUN.

● Plugging a transfer module into an S7-1200 CPU.
 

 Note

The "Limit and enable password legitimation" instruction blocks access to the HMI panel, if 
the HMI password has not been enabled.

 

 Note

Existing legitimized connections retain their access rights and you cannot use the "Limit and 
enable password legitimation" instruction to restrict them.

 

Procedure for lost passwords with an S7-1200 CPU
If you have lost the password for a password-protected S7-1200 CPU, delete the password-
protected program with an empty transfer card. The empty transfer card deletes the internal 
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load memory of the CPU. You can then load a new user program from STEP 7 Basic in the 
CPU.

 

 WARNING

Inserting transfer card

When you insert a transfer card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

 

You must remove the transfer card before you put the CPU into RUN mode.

Effects of password use on the operating modes
The following table shows what effects the password use by means of the "Limit and enable 
password legitimation" instruction has on the operating modes and the corresponding user 
actions.

Action Password protection by means of the 
instruction

Basic state after
● Operating mode switch to STOP
● Reset memory manually (PG, switch, change of 

MC (Motion Control))
● Reset to factory setting

Not activated
(no restrictions)

Basic state after POWER ON Enabled (when a lock was activated before 
POWER OFF)
The option of not allowing passwords is 
retentive.

Operating mode transition RUN/STARTUP/HOLD -> 
STOP (by terminating the instruction, an error or 
communication) or STOP -> STARTUP/RUN/HOLD

Activated
Passwords still cannot be used.

Parameters
The following table shows the parameters of the "Limit and enable password legitimation" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L When the REQ 

parameter has the 
signal state "0", the 
currently set signal 
state of the passwords 
is queried.
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Parameter Declaration Data type Memory area Description
F_PWD Input BOOL I, Q, M, D, L Read/write access 

including fail-safe
● F_PWD = "0": Do 

not allow password
● F_PWD = "1": 

Allow password
FULL_PWD Input BOOL I, Q, M, D, L Read/write access

● FULL_PWD = "0": 
Do not allow 
password

● FULL_PWD = "1": 
Allow password

R_PWD Input BOOL I, Q, M, D, L Read access
● R_PWD = "0": Do 

not allow password
● R_PWD = "1": 

Allow password
HMI_PWD Input BOOL I, Q, M, D, L HMI access

● HMI_PWD = "0": 
Do not allow 
password

● HMI_PWD = "1": 
Allow password

F_PWD_ON Output BOOL I, Q, M, D, L Read/write access 
including fail-safe
● F_PWD_ON = "0": 

Password not 
allowed

● F_PWD_ON = "1": 
Password allowed

FULL_PWD_ON Output BOOL I, Q, M, D, L Read/write access 
status
● FULL_PWD_ON = 

"0": Password not 
allowed

● FULL_PWD_ON = 
"1": Password 
allowed

R_PWD_ON Output BOOL I, Q, M, D, L Read-access status
● R_PWD_ON = "0": 

Password not 
allowed

● R_PWD_ON = "1": 
Password allowed
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Parameter Declaration Data type Memory area Description
HMI_PWD_ON Output BOOL I, Q, M, D, L HMI-access status

● HMI_PWD_ON = 
"0": Password not 
allowed

● HMI_PWD_ON = 
"1": Password 
allowed

RET_VAL Output WORD I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8090 The "Limit and enable password legitimation" instruction is not supported
80D0 The password for fail-safe is not configured
80D1 The read/write access is not configured
80D2 The read access is not configured
80D3 The HMI access is not configured
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

RE_TRIGR: Restart cycle monitoring time

Description
You can use the "Restart cycle monitoring time" instruction to restart the cycle time monitoring 
of the CPU. The maximum cycle time then starts over again for the duration you have set in 
the CPU configuration. 

The instruction "Restart cycle monitoring time" can be called regardless of the priority in all 
blocks.

If the instruction is called in a block with a higher priority, such as a hardware interrupt, 
diagnostic error interrupt, or cyclic interrupt, the instruction is not executed and the ENO enable 
output is set to signal state "0".
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The instruction "Restart cycle monitoring time" can be called a maximum of 10 times in a 
program cycle.

Parameter
The "Restart cycle monitoring time" instruction has no parameters.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

STP: Exit program

Description       
You use the "Exit program" instruction to set the CPU to STOP mode and therefore to terminate 
the execution of the program. The effects of changing from RUN to STOP depend on the CPU 
configuration.

When the result of logic operation (RLO) at the input of the instruction is "1", the CPU changes 
to STOP mode and program execution is terminated. The signal state at the output of the 
instruction is not evaluated.

When the RLO is "0" at the input of the instruction, then the instruction will not be executed.

Parameters
The "Exit program" instruction has no parameters.

See also
Overview of the valid data types (Page 1077)

GET_ERROR: Get error locally

Description
The "Get error locally" instruction is used to query the occurrence of errors within a block. If 
the system signals errors during block execution, detailed information about the first error that 
occurred is saved in the operand at the ERROR output.

Only operands of the "ErrorStruct" system data type can be specified at the ERROR output. 
The "ErrorStruct" system data type specifies the exact structure in which the information about 
the error is stored. Using additional instructions, you can evaluate this structure and program 
an appropriate response. When the first error has been eliminated, the instruction outputs 
information about the next error that occurred.
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Parameters
The following table shows the parameters of the "Get error locally" instruction:

Parameter Declaration Data type Memory area Description
ERROR Output ErrorStruct D, L Error information

Data type "ErrorStuct"
The following table shows the structure of the "ErrorStruct" data type:

Structure component Data type Description
ERROR_ID WORD Error ID
FLAGS BYTE Shows if an error occurred during a block call.

16#01: Error during a block call 
16#00: No error during a block call 

REACTION BYTE Default reaction: 
0: Ignore (write error), 
1: Continue with substitute value "0" (read error), 
2: Skip instruction (system error)

CODE_ADDRESS CREF Information about the address and type of block
 BLOCK_TYPE BYTE Type of block where the error occurred:

1: OB
2: FC
3: FB

 CB_NUMBER UINT Number of the code block
 OFFSET UDINT Reference to the internal memory
MODE BYTE Access mode: Depending on the type of access, the 

following information can be output:
Mode (A) (B) (C) (D) (E)
0      
1     Offset
2   Area   
3 Location Scope  Numb

er
 

4   Area  Offset
5   Area DB no. Offset
6 PtrNo./

Acc
 Area DB no. Offset

7 PtrNo./
Acc

Slot 
No. / 
Scope

Area DB no. Offset

OPERAND_NUMBER UINT Operand number of the machine command
 

POINTER_NUMBER_LOCATION UINT (A) Internal pointer
SLOT_NUMBER_SCOPE UINT (B) Storage area in internal memory
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Structure component Data type Description
DATA_ADDRESS NREF Information about the address of an operand
 AREA BYTE (C) Memory area:

L: 16#40 – 4E, 86, 87, 8E, 8F, C0 – CE
E: 16#81
A: 16#82
M: 16#83
DB: 16#84, 85, 8A, 8B
Range violations for a directly editable tag of data 
type DINT: 16#04

 DB_NUMBER UINT (D) Number of the data block
 OFFSET UDINT (E) Relative address of the operand

Structure component "ERROR_ID"
The following table shows the values that can be output on the structure component 
"ERROR_ID":

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist 
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2577 9591 Die block property "Parameter assignment via register" is not 

selected.
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ID*
(hexadecimal)

ID*
(decimal)

Description

2576 9590 Error in the local data distribution
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

The ENO enable output of the "Get error locally" instruction is only set if the EN enable input 
has the signal state "1" and error information is present. If one of these conditions is not fulfilled, 
the remaining program execution is not affected by the "Get error locally" instruction.

The "Get error locally" instruction can also be used to forward an alarm about the error status 
to the calling block. To do this, the instruction must be positioned in the last network of the 
called block.

 

 Note

The "Get error locally" instruction enables local error handling within a block. If "Get error 
locally" is inserted in the program code of a block, any predefined system reactions are 
ignored if errors occur.

 

Example
The following example shows how the instruction works:

When an error occurs, the "Get error locally" instruction returns the error information to the 
locally created "#error" structure at the ERROR output. The error information is converted and 
evaluated using the "Equal" comparison instruction. Information about the type of error is the 
first comparison value assigned to the instruction. The value "1" is specified in operand 
"substitute" as the second comparison value. If the error is a read error, the condition of the 
comparison instruction is fulfilled. The "#out" and "OK" outputs are reset in this case.
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See also
Overview of the valid data types (Page 1077)

Basics of error handling (Page 1378)

Principles of local error handling (Page 1380)

Error output priorities (Page 1381)

Enabling local error handling for a block (Page 1382)

GET_ERR_ID: Get error ID locally

Description
The "Get error ID locally" instruction is used to query the occurrence of errors within a block. 
If the system signals errors during block execution, the error ID of the first error that occurred 
is saved in the tag at output ID. Only operands of the WORD data type can be specified at the 
ID output. When the first error has been eliminated, the instruction outputs the error ID of the 
next error that occurred.

The output of the "Get error ID locally" instruction is only set if the input of the instruction has 
the signal state "1" and error information is present. If one of these conditions is not fulfilled, 
the remaining program execution is not affected by the "Get error ID locally" instruction.

The "Get error ID locally" instruction can also be used to forward an alarm about the error 
status to the calling block. To do this, the instruction must be positioned in the last network of 
the called block.

 

 Note

The "Get error ID locally" instruction enables local error handling within a block. If the "Get 
error ID locally" instruction is inserted in the program code of a block, any predefined system 
reactions are ignored if errors occur.

 

Parameters
The following table shows the parameters of the "Get error ID locally" instruction:

Parameter Declaration Data type Memory area Description
ID Output WORD I, Q, M, D, L Error ID
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Parameter ID
The following table shows the values that can be output at the ID parameter:

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist 
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 Die block property "Parameter assignment via register" is not 

selected.
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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See also
Overview of the valid data types (Page 1077)

Basics of error handling (Page 1378)

Principles of local error handling (Page 1380)

Error output priorities (Page 1381)

Enabling local error handling for a block (Page 1382)

INIT_RD: Initialize all retain data

Description
You can use the "Initialize all retain data" instruction to reset the retain data of all data blocks, 
bit memories and SIMATIC timers and counters at the same time. The instruction can only be 
executed within a startup OB because the execution would exceed the program cycle duration.

Parameter
The following table shows the parameters of the "Initialize all retain data" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L, T, C 

or constant
If the input "REQ" 
has the signal 
state "1", all retain 
data are reset.

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during execution 
of the instruction, 
an error code is 
output at the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B5 The instruction cannot be executed because it was not programmed within a startup OB.
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Error code*
(W#16#...)

Explanation

General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "Tag_REQ" have signal state "1", the instruction is executed. 
The retain data of all data blocks, bit memories and SIMATIC timers and counters are reset If 
the instruction is executed without errors, the ENO enable output has the signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 1787)

WAIT: Configure time delay

Description     
The "Configure time delay" instruction is used to halt the execution of the program for a set 
period of time. You indicate the period of time in microseconds on the WT parameter of the 
instruction.

You can configure time delays of up to 32767 microseconds (μs). The smallest possible delay 
time depends on the respective CPU and corresponds to the execution time of the "Configure 
time delay" instruction.

The execution of the instruction can be interrupted by higher priority events.

The "Configure time delay" instruction supplies no error information.
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Parameters
The following table shows the parameters of the "Configure time delay" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
WT Input INT I, Q, M, D, L, P or 

constant
Time delay in 
microseconds (μs)

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Word logic operations

AND: AND logic operation

Description     
You can use the "AND logic operation" instruction to combine the value at the IN1 input and 
the value at the IN2 input bit-by-bit by AND logic and query the result at the OUT output.

When the instruction is executed, bit 0 of the value at the IN1 input and bit 0 of the value at 
the IN2 input are logically ANDed. The result is stored in bit 0 of output OUT. The same logic 
operation is executed for all other bits of the specified values.

The number of inputs can be expanded in the instruction box. The added inputs are numbered 
in ascending order in the box. When the instruction is executed, the values of all available input 
parameters are combined with AND logic (ANDed). The result is stored in the OUT output.

The result bit has signal state "1" only when both of the bits in the logic operation also have 
signal state "1". If one of the two bits of the logic operation has signal state "0", the 
corresponding result bit is reset.

Parameters
The following table shows the parameters of the "AND logic operation" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P or 

constant
First value for logic 
operation

IN2 Input Bit strings I, Q, M, D, L, P or 
constant

Second value for 
logic operation

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1791



Parameter Declaration Data type Memory area Description
INn Input Bit strings I, Q, M, D, L, P or 

constant
Other inputs 
whose values are 
logically 
combined.

OUT Output Bit strings I, Q, M, D, L, P Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0000 0000 0000 0101

If operand "TagIn" has the signal state "1", the "AND logic operation" instruction is executed. 
The value of operand "Tag_Value1" and the value of operand "Tag_Value2" are ANDed. The 
result is mapped bit-for-bit and output in operand "Tag_Result". The ENO enable output and 
the "TagOut" output are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Basics of the EN/ENO mechanism (Page 1167)

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1792 System Manual, 07/2013,  



OR: OR logic operation

Description     
You can use the "OR logic operation" instruction to combine the value at the IN1 input and the 
value at the IN2 input bit-by-bit by OR logic and query the result at the OUT output.

When the instruction is executed, bit 0 of the value at the IN1 input and bit 0 of the value at 
the IN2 input are combined by OR logic operation. The result is stored in bit 0 of output OUT. 
The same logic operation is executed for all bits of the specified tags.

The number of inputs can be expanded in the instruction box. The added inputs are numbered 
in ascending order in the box. When the instruction is executed, the values of all available input 
parameters are combined with OR logic (ORed). The result is stored in the OUT output.

The result bit has signal state "1" when at least one of the two bits in the logic operation has 
the signal state "1". If both of the bits of the logic operation have signal state "0", the 
corresponding result bit is reset.

Parameters
The following table shows the parameters of the "OR logic operation" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P or 

constant
First value for logic 
operation

IN2 Input Bit strings I, Q, M, D, L, P or 
constant

Second value for 
logic operation

INn Input Bit strings I, Q, M, D, L, P or 
constant

Other inputs 
whose values are 
logically 
combined.

OUT Output Bit strings I, Q, M, D, L, P Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0101 0101 0101 1111

If operand "TagIn" has the signal state "1", the "OR logic operation" instruction is executed. 
The value of operand "Tag_Value1" and the value of operand "Tag_Value2" are ORed. The 
result is mapped bit-for-bit and output in operand "Tag_Result". The ENO enable output and 
the "TagOut" output are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Basics of the EN/ENO mechanism (Page 1167)

XOR: EXCLUSIVE OR logic operation

Description     
You can use the "EXCLUSIVE OR logic operation" instruction to combine the value at the IN1 
input and the value at the IN2 input bit-by-bit by EXCLUSIVE OR logic and query the result at 
the OUT output.

When the instruction is executed, bit 0 of the value at the IN1 input and bit 0 of the value at 
the IN2 input are combined by EXCLUSIVE OR logic operation. The result is stored in bit 0 of 
output OUT. The same logic operation is executed for all other bits of the specified value.

The number of inputs can be expanded in the instruction box. The added inputs are numbered 
in ascending order in the box. When the instruction is executed, the values of all available input 
parameters are combined with EXCLUSIVE OR logic. The result is stored in the OUT output.

The result bit has signal state "1" when one of the two bits in the logic operation has the signal 
state "1". If both of the bits of the logic operation have signal state "1" or "0", the corresponding 
result bit is reset.
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Parameters
The following table shows the parameters of the "EXCLUSIVE OR logic operation" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P or 

constant
First value for logic 
operation

IN2 Input Bit strings I, Q, M, D, L, P or 
constant

Second value for 
logic operation

INn Input Bit strings I, Q, M, D, L, P or 
constant

Other inputs 
whose values are 
logically 
combined.

OUT Output Bit strings I, Q, M, D, L, P Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0101 0101 0101 1010

If operand "TagIn" has the signal state "1", the "EXCLUSIVE OR logic operation" instruction 
is executed. The value of operand "Tag_Value1" and the value of operand "Tag_Value2" are 
combined by EXCLUSIVE OR logic. The result is mapped bit-for-bit and output in operand 
"Tag_Result". The ENO enable output and the "TagOut" output are set to signal state "1".
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See also
Overview of the valid data types (Page 1077)

Inserting additional inputs and outputs in LAD elements (Page 1289)

Removing inputs and outputs (Page 1290)

Basics of the EN/ENO mechanism (Page 1167)

INV: Create ones complement

Description       
You can use the "Create ones complement" instruction to invert the signal state of the bits at 
the IN input. When the instruction is processed, the value at the IN input and a hexadecimal 
template (W#16#FFFF for 16-bit numbers or DW#16#FFFF FFFF for 32-bit numbers) are 
combined by EXCLUSIVE OR logic. This inverts the signal state of the individual bits that are 
then stored at output OUT.

Parameters
The following table shows the parameters of the "Create ones complement" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Bit strings, 
integers

I, Q, M, D, L, P Ones complement 
of the value at 
input IN

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN TagIn_Value W#16#000F W#16#7E
OUT TagOut_Value W#16#FFF0 W#16#81

If operand "TagIn" has the signal state "1", the "Create ones complement" instruction is 
executed. The instruction inverts the signal state of the individual bits at input TagIn_Value" 
and writes the result to output "TagOut_Value". The ENO enable output and the "TagOut" 
output are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

DECO: Decode

Description     
You can use the "Decode" instruction to set a bit in the output value specified by the input 
value.

The "Decode" instruction reads the value at the IN input and sets the bit in the output value 
whose bit position corresponds to the read value. The other bits in the output value are filled 
with zeroes. When the value at the IN input is greater than 31, a modulo 32 instruction is 
executed.

Parameters
The following table shows the parameters of the "Decode" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input UINT I, Q, M, D, L, P or 

constant
Position of the bit 
in the output value 
which is set.

OUT Output Bit strings I, Q, M, D, L, P Output value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following figure shows how the instruction works using specific operand values:

If operand "TagIn" has the signal state "1", the "Decode" instruction is executed. The instruction 
reads bit number "3" from the value of the operand "TagIn_Value" at the input and sets the 
third bit to the value of the operand "TagOut_Value" at the output.

If the instruction is executed without errors, the ENO enable output has the signal state "1" 
and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ENCO: Encode

Description     
You can use the "Encode" instruction to read the bit number of the least significant bit in the 
input value and to send it to the OUT output.

The "Encode" instruction selects the least significant bit of the value at the IN input and writes 
its bit number to the tag in the OUT output.

Parameters
The following table shows the parameters of the "Encode" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
IN Input Bit strings I, Q, M, D, L, P or 

constant
Input value

OUT Output INT I, Q, M, D, L, P Output value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following figure shows how the instruction works using specific operand values:

If operand "TagIn" has the signal state "1", the "Encode" instruction is executed. The instruction 
selects the least significant bit at the "TagIn_Value" input and writes bit position "3" to the tag 
in the "TagOut_Value" output.

If the instruction is executed without errors, the ENO enable output has the signal state "1" 
and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SEL: Select

Description
Depending on a switch (G input), the "Select" instruction selects one of the inputs, IN0 or IN1 
and copies its content to the OUT output. When the G input has the signal state "0", the value 
at the IN0 input is moved. When the G input has the signal state "1", the value at the IN1 input 
is moved to the OUT output.

All tags at all parameters must have the same data type.
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Parameters
The following table shows the parameters of the "Select" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L Enable input

ENO Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L Enable output

G Input BOOL BOOL I, Q, M, D, 
L or 
constant

I, Q, M, D, L, T, 
C or constant

Switch

IN0 Input Bit strings, 
integers, 
floating-point 
numbers, TIME, 
TOD, CHAR, 
DATE

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, LDT, 
CHAR, DATE

I, Q, M, D, 
L, P or 
constant

I, Q, M, D, L, P 
or constant

First input value

IN1 Input Bit strings, 
integers, 
floating-point 
numbers, TIME, 
TOD, CHAR, 
DATE

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, LDT, 
CHAR, DATE

I, Q, M, D, 
L, P or 
constant

I, Q, M, D, L, P 
or constant

Second input value

OUT Output Bit strings, 
integers, 
floating-point 
numbers, TIME, 
TOD, CHAR, 
DATE

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, LDT, 
CHAR, DATE

I, Q, M, D, 
L, P

I, Q, M, D, L, P Result

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
G TagIn_G 0 1
IN0 TagIn_Value0 W#16#0000 W#16#4C
IN1 TagIn_Value1 W#16#FFFF W#16#5E
OUT TagOut_Value W#16#0000 W#16#5E

If operand "TagIn" has the signal state "1", the "Select" instruction is executed. Based on the 
signal state at the "TagIn_G" input, the value at the "TagIn_Value0" or "TagIn_Value1" input 
is selected and copied to the "TagOut_Value" output. If the instruction is executed without 
errors, enable output ENO has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

MUX: Multiplex

Description
You can use the "Multiplex" instruction to copy the content of a selected input to the OUT 
output. The number of selectable inputs of the instruction box can be expanded. You can 
declare a maximum of 32 inputs.

The inputs are automatically numbered in the box. Numbering starts at IN0 and continues 
consecutively with each new input. You use the K parameter to define the input whose content 
is to be copied to the OUT output. If the value of the K parameter is greater than the number 
of available inputs, the content of the ELSE parameter is copied to the OUT output and the 
ENO enable output is assigned the signal state "0".

The "Multiplex" instruction can only be executed, when the tags in all inputs and in the OUT 
output have the same data type. The K parameter is an exception, since only integers can be 
specified for it.

The ENO enable output is reset if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value of the K parameter is greater than the number of available inputs.

● Errors occurred during execution of the instruction.
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Parameters
The following table shows the parameters of the "Multiplex" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
K Input Integers Integers I, Q, M, D, L, P 

or constant
Specifies the 
input whose 
content is to be 
copied.
● If K = 0 => 

Parameter 
IN0

● If K = 1 => 
Parameter 
IN1, etc.

IN0 Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

First input 
value

IN1 Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Second input 
value

INn Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Optional input 
values

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1802 System Manual, 07/2013,  



Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

ELSE Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Specifies the 
value to be 
copied when K 
> n.

OUT Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Output to 
which the 
value is to be 
copied.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
K Tag_Number 1
IN0 Tag_Value_0 DW#16#00000000
IN1 Tag_Value_1 DW#16#003E4A7D
ELSE Tag_Value_2 DW#16#FFFF0000
OUT Tag_Result DW#16#003E4A7D

If operand "Tag_Input" has the signal state "1", the "Multiplex" instruction is executed. 
Depending on the value of the operand "Tag_Number", the value at input "Tag_Value_1" is 
copied and assigned to the operand at output "Tag_Result". If the instruction is executed 
without errors, the "ENO" and "Tag_Output" enable outputs are set.
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

DEMUX: Demultiplex

Description
You can use the "Demultiplex" instruction to copy the content of the IN input to the selected 
output. The number of selectable outputs can be expanded in the instruction box. The outputs 
are automatically numbered in the box. Numbering starts at OUT0 and continues consecutively 
with each new output. You use the K parameter to define the output to which the content of 
the IN input is to be copied. The other outputs are not changed. If the value of the parameter 
K is greater than the number of available outputs, then the content of input IN in the parameter 
ELSE and the enable output ENO will be assigned to the signal state "0".

The "Demultiplex" instruction can only be executed if the tags in the IN input and in all outputs 
have the same data type. The K parameter is an exception, since only integers can be specified 
for it.

The ENO enable output is reset if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value of the K parameter is greater than the number of available outputs.

● Errors occurred during execution of the instruction.

Parameters
The following table shows the parameters of the "Demultiplex" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
K Input Integers Integers I, Q, M, D, L, P 

or constant
Specifies the 
output to which 
the input value 
(IN) is copied.
● If K = 0 => 

Parameter 
OUT0

● If K = 1 => 
Parameter 
OUT1, etc.
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Input value

OUT0 Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P First output

OUT1 Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Second output

OUTn Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Optional 
outputs

ELSE Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Output to 
which the input 
value (IN) at K 
> n is copied.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on available data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following tables show how the instruction works using specific operand values:

Table 9-24 Input values of the "Demultiplex" instruction before network execution

Parameter Operand Values
K Tag_Number 1 4
IN Tag_Value DW#16#FFFFFFFF DW#16#003E4A7D

Table 9-25 Output values of the "Demultiplex" instruction after network execution

Parameter Operand Values
OUT0 Tag_Output_0 Unchanged Unchanged
OUT1 Tag_Output_1 DW#16#FFFFFFFF Unchanged
ELSE Tag_Output_2 Unchanged DW#16#003E4A7D

If the "Tag_Input" input has the signal state"1", the "Demultiplex" instruction is executed. 
Depending on the value of operand "Tag_Number", the value at the IN input is copied to the 
corresponding output.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Shift and rotate

SHR: Shift right

Description
You can use the "Shift right" instruction to rotate the content of the operand at the input INbit-
by-bit to the right and query the result at the OUT output. You use the N parameter to specify 
the number of bit positions by which the specified value is to be shifted.

When the value at the N parameter is "0", the value at the IN input is copied to the operand at 
the OUT output.
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When the value at the N parameter is greater than the number of available bit positions, the 
operand value at the IN input is shifted by the available number of bit positions to the right.

In the case of unsigned values, the freed bit positions in the left area of the operand are filled 
with zeroes when shifting occurs. If the specified value has a sign, the free bit positions are 
filled with the signal state of the sign bit.

The following figure show how the content of an operand of integer data type is shifted four bit 
positions to the right:

Parameters
The following table shows the parameters of the "Shift right" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
Bit strings, 
integers

I, Q, M, D, L or 
constant

Value to be 
shifted

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, 
ULINT

I, Q, M, D, L or 
constant

Number of bit 
positions by 
which the value 
is shifted

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
N Tag_Number 3
OUT TagOut_Value 0000 0111 1111 0101

If operand "TagIn" has the signal state "1", the "Shift right" instruction is executed. The content 
of operand "TagIn_Value" is shifted three bit positions to the right. The result is sent to the 
"TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SHL: Shift left

Description
You can use the "Shift left" instruction to rotate the content of the operand at the IN input bit-
by-bit to the left and query the result at the OUT output. You use the N parameter to specify 
the number of bit positions by which the specified value is to be shifted.

When the value at the N parameter is "0", the value at the IN input is copied to the operand at 
the OUT output.

When the value at the N parameter is greater than the number of available bit positions, the 
operand value at the IN input is shifted by the available number of bit positions to the left.

The bit positions in the right part of the operand freed by shifting are filled with zeros.

The following figure shows how the content of an operand of the WORD data type is shifted 
by six bit positions to the left:
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Parameters
The following table shows the parameters of the "Shift left" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
Bit strings, 
integers

I, Q, M, D, L or 
constant

Value to be 
shifted

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, 
ULINT

I, Q, M, D, L or 
constant

Number of bit 
positions by 
which the value 
is shifted

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
N Tag_Number 4
OUT TagOut_Value 1111 1010 1111 0000

If operand "TagIn" has the signal state "1", the "Shift left" instruction is executed. The content 
of operand "TagIn_Value" is shifted four bit positions to the left. The result is sent to the 
"TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ROR: Rotate right

Description
You can use the "Rotate right" instruction to rotate the content of the operand at the IN input 
bit-by-bit to the right and query the result at the OUT output. You use the N parameter to specify 
the number of bit positions by which the specified value is to be rotated. The bit positions freed 
by rotating are filled with the bit positions that are pushed out.

When the value at the N parameter is "0", the value at the IN input is copied to the operand at 
the OUT output.

When the value at the N parameter is greater than the number of available bit positions, the 
operand value at the IN input is nevertheless rotated by the specified number of bit positions.

The following figure shows how the content of an operand of DWORD data type is rotated 
three positions to the right:

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1810 System Manual, 07/2013,  



Parameters
The following table shows the parameters of the "Rotate right" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
Bit strings, 
integers

I, Q, M, D, L or 
constant

Value to be 
rotated

N Input USINT, 
UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L or 
constant

Number of bit 
positions by 
which the value 
is rotated

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1811



Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0000 1111 1001 0101
N Tag_Number 5
OUT TagOut_Value 1010 1000 0111 1100

If operand "TagIn" has the signal state "1", the "Rotate right" instruction is executed. The 
content of operand "TagIn_Value" is rotated five bit positions to the right. The result is sent to 
the "TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ROL: Rotate left

Description
You can use the "Rotate left" instruction to rotate the content of the operand at the IN input bit-
by-bit to the left and query the result at the OUT output. You use the N parameter to specify 
the number of bit positions by which the specified value is to be rotated. The bit positions freed 
by rotating are filled with the bit positions that are pushed out.

When the value at the N parameter is "0", the value at the IN input is copied to the operand at 
the OUT output.

When the value at the N parameter is greater than the number of available bit positions, the 
operand value at the IN input is nevertheless rotated by the specified number of bit positions.

The following figure shows how the content of an operand of DWORD data type is rotated 
three positions to the left:
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Parameters
The following table shows the parameters of the "Rotate left" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
Bit strings, 
integers

I, Q, M, D, L or 
constant

Value to be 
rotated

N Input USINT, 
UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L or 
constant

Number of bit 
positions by 
which the value 
is rotated

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 1010 1000 1111 0110
N Tag_Number 5
OUT TagOut_Value 0001 1110 1101 0101

If the "TagIn" input has the signal state "1", the "Rotate left" instruction is executed. The content 
of operand "TagIn_Value" is rotated five bit positions to the left. The result is sent to the 
"TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Additional instructions

DRUM: Implement sequencer

Description
You can use the "Implement sequencer" instruction to assign the programmed values of the 
OUT_VAL parameter of the corresponding step to the programmed output bits (OUT1 to 
OUT16) and the output word (OUT_WORD). The specific step must thereby satisfy the 
conditions of the programmed enable mask on the S_MASK parameter while the instruction 
remains at this step. The instruction advances to the next step if the event for the step is true 
and the programmed time for the current step elapses, or if the value at the JOG parameter 
changes from "0" to "1". The instruction is reset if the signal state on the RESET parameter 
changes to "1". The current step is hereby equated to the preset step (DSP).

The amount of time spent on a step is determined by the product of the preset timebase (DTBP) 
and the preset counter value (S_PRESET) for each step. At the start of a new step, this 
calculated value is loaded into the DCC parameter, which contains the time remaining for the 
current step. If, for example the value at the DTBP parameter is "2" and the preset value for 
the first step is "100" (100 ms), the DCC parameter has the value "200" (200 ms).
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A step can be programmed with a timer value, an event, or both. Steps that have an event bit 
and the timer value "0" advance to the next step as soon as the signal state of the event bit is 
"1". Steps that are programmed only with a timer value start the time immediately. Steps that 
are programmed with an event bit and a timer value greater than "0" start the time when the 
signal state of the event bit is "1". The event bits are initialized with a signal state of "1".

When the sequencer is on the last programmed step (LST_STEP) and the time for this step 
has expired, the signal state on the Q parameter is set to "1"; otherwise it is set to "0". When 
the parameter Q is set, the instruction remains on the step until it is reset.

In the configurable mask (S_MASK) you can selected the separate bits in the output word 
(OUT_WORD) and set or reset the output bits (OUT1 to OUT16) by means of the output values 
(OUT_VAL). If a bit of the configurable mask is in the signal state "1", the value OUT_VAL sets 
or resets the corresponding bit. If the signal state of a bit of the configurable mask is "0", the 
corresponding bit is left unchanged. All the bits of the configurable mask for all 16 steps are 
initialized with a signal state of "1".

The output bit on the OUT1 parameter corresponds to the least significant bit of the output 
word (OUT_WORD). The output bit on the OUT16 parameter corresponds to the most 
significant bit of the output word (OUT_WORD).

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Implement sequencer" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
RESET Input BOOL I, Q, M, D, L or 

constant
A signal state of 
"1" indicates a 
reset condition.

JOG Input BOOL I, Q, M, D, L or 
constant

When the signal 
state changes 
from "0" to "1", the 
instruction 
advances to the 
next step.

DRUM_EN Input BOOL I, Q, M, D, L or 
constant

A signal state of 
"1" allows the 
sequencer to 
advance based on 
the event and time 
criteria.

LST_STEP Input BYTE I, Q, M, D, L or 
constant

Step number of 
the last step 
programmed.
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Parameter Declaration Data type Memory area Description
EVENT(i),
1 ≤ i ≤ 16

Input BOOL I, Q, M, D, L or 
constant

Event bit (i);
Initial signal state 
is "1".

OUT(j),
1 ≤ j ≤ 16

Output BOOL I, Q, M, D, L Output bit (j)

Q Output BOOL I, Q, M, D, L A signal state of 
"1" indicates that 
the time for the 
last step has 
elapsed.

OUT_WORD Output WORD I, Q, M, D, L, P Word address to 
which the 
sequencer writes 
the output values.

ERR_CODE Output WORD I, Q, M, D, L, P Error information
JOG_HIS Static BOOL I, Q, M, D, L JOG parameter 

history bit
EOD Static BOOL I, Q, M, D, L A signal state of 

"1" indicates that 
the time for the 
last step has 
elapsed.

DSP Static BYTE I, Q, M, D, L, P Preset step of the 
sequencer

DSC Static BYTE I, Q, M, D, L, P Current step of the 
sequencer

DCC Static DWORD I, Q, M, D, L, P Current numerical 
value of the 
sequencer

DTBP Static WORD I, Q, M, D, L, P Preset timebase 
of the sequencer

PREV_TIME Static DWORD I, Q, M, D, L or 
constant

Previous system 
time

S_PRESET Static ARRAY of WORD I, Q, M, D, L Count preset for 
each step [1 to 16] 
where 1 count = 1 
ms.

OUT_VAL Static ARRAY of BOOL I, Q, M, D, L Output values for 
each step [1 to 16, 
0 to 15].

S_MASK Static ARRAY of BOOL I, Q, M, D, L Configurable 
mask for each 
step [1 to 16, 
0 to 15]. Initial 
signal states are 
"1".

For additional information on valid data types, refer to "See also".
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Parameter ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

ERR_CODE* Explanation
W#16#0000 No error
W#16#000B The value at the LST_STEP parameter is less than 1 or 

greater than 16.
W#16#000C The value at the DSC parameter is less than 1 or greater than 

the value at the LST_STEP parameter.
W#16#000D The value at the DSP parameter is less than 1 or greater than 

the value at the LST_STEP parameter.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

DCAT: Discrete control-timer alarm

Description
The instruction "Discrete control-timer alarm" is used to accumulate the time from the point at 
which the CMD parameter issued the command to open or close. The time is accumulated 
until the preset time (PT) is exceeded or the information is received that the device was opened 
or closed (O_FB or C_FB) within the specified time. If the preset time is exceeded before the 
information on the opening or closing of the device is received, the corresponding alarm is 
activated. If the signal state on the command input changes state before the preset time, the 
time is restarted.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The "Discrete control-timer alarm" instruction has the following reactions to the input conditions:

● When the signal state of the CMD parameter changes from "0" to "1", the signal states of 
the parameters Q, CMD_HIS, ET (only if ET < PT), OA and CA are influenced as follows:

– The parameters Q and CMD_HIS are set to "1".

– The parameters ET, OA and CA are reset to "0".

● When the signal state on the parameter CMD changes from "1" to "0", the parameters Q, 
ET (only if ET < PT),  OA, CA and CMD_HIS are reset to "0".
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● When the signal state of the parameters CMD and CMD_HIS is "1" and the parameter O_FB 
is set to "0", the time difference (ms) since the last execution of the instruction is added to 
the value at the parameter ET. If the value of the parameter ET exceeds the value of the 
parameter PT, the signal state on the parameter OA is set to "1". If the value of the 
parameter ET does not exceed the value of the parameter PT, the signal state on the 
parameter OA is reset to "0". The value at the parameter CMD_HIS is reset to the value of 
the parameter CMD.

● If the signal state of the parameters CMD, CMD_HIS and O_FB are set to "1" and the 
parameter C_FB has the value "0", the signal state of the parameter OA is set to "0". The 
value of the parameter ET is set to the value of the parameter PT. If the signal state of the 
parameter O_FB changes to "0", the alarm is set the next time the instruction is executed. 
The value of the parameter CMD_HIS is set to the value of the parameter CMD.

● If the parameters CMD, CMD_HIS and C_FB have the value "0", the time difference (ms) 
since the last execution of the instruction is added to the value of the parameter ET. If the 
value of the parameter ET exceeds the value of the parameter PT, the signal state of the 
parameter CA is reset to "1". If the value at the parameter PT is not exceeded, the parameter 
CA has the signal state "0". The value of the parameter CMD_HIS is set to the value of the 
parameter CMD.

● If the parameters CMD, CMD_HIS and O_FB have the signal state "0" and the parameter 
C_FB is set to "1", the parameter CA is set to "0". The value of the parameter ET is set to 
the value of the parameter PT. If the signal state of the parameter C_FB changes to "0", 
the alarm is set the next time the instruction is executed. The value of the parameter 
CMD_HIS is set to the value of the parameter CMD.

● If the parameters O_FB and C_FB simultaneously have the signal state "1", the signal states 
of both alarm outputs are set to "1".

The "Discrete control-timer alarm" instruction has no error information.

Parameters
The following table shows the parameters of the "Discrete control-timer alarm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
CMD Input BOOL I, Q, M, D, L or constant A signal state of "0" 

indicates a "close" 
command.
A signal state of "1" 
indicates an "open" 
command.

O_FB Input BOOL I, Q, M, D, L or constant Feedback input when 
opening

C_FB Input BOOL I, Q, M, D, L or constant Feedback input when 
closing

Q Output BOOL I, Q, M, D, L Shows the status of the 
parameter CMD

OA Output BOOL I, Q, M, D, L Alarm output when opening
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Parameter Declaration Data type Memory area Description
CA Output BOOL I, Q, M, D, L Alarm output when closing
ET Static DINT D, L Currently elapsed time, 

where 1 count = 1 ms
PT Static DINT D, L Preset timer value, where 1 

count = 1 ms
PREV_TIME Static DWORD D, L Previous system time
CMD_HIS Static BOOL D, L  CMD history bit

For additional information on valid data types, refer to "See also".

Example
In the following example the parameter CMD changes from "0" to "1". After the execution of 
the instruction the parameter Q is set to "1" and the two alarm outputs OA and CA have the 
signal state "0". The parameter CMD_HIS of the instance data block is set to the signal state 
"1" and the parameter ET is reset to "0".

 

 Note

You can initialize static parameters in the data block.
 

The following tables show how the instruction works using specific values.

Before processing

In this example, the following values are used for the input and output parameters:

Parameter Operand Value
CMD Tag_Input_CMD TRUE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
Q Tag_Output_Q FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:
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Parameter Address Value
ET DBD4 L#12
PT DBD8 L#222
CMD_HIS DBX16.0 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
Q Tag_Output_Q TRUE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
CMD_HIS DBX16.0 TRUE

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

MCAT: Motor control-timer alarm

Description
The instruction "Motor control-timer alarm" is used to accumulate the time from the point of 
time from which the one of the command inputs (opening or closing) is switched on. The time 
is accumulated until the preset time is exceeded or the relevant feedback input indicates that 
the device has executed the requested operation within the specified time. If the preset time 
is exceeded before the feedback is received, the corresponding alarm is triggered.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1820 System Manual, 07/2013,  



Execution of the "Motor control-timer alarm" instruction
The following table shows the reactions of the instruction "Motor control-timer alarm" to the 
various input conditions:

Input parameters Output parameters
ET O_H

IS
C_H
IS

O_C
MD

C_C
MD

S_C
MD

O_F
B

C_F
B

OO CO OA CA ET O_H
IS

C_H
IS

Q Status

X 1 1 X X X X X 0 0 1 1 PT 0 0 0 Alarm
X X X X X X 1 1 0 0 1 1 PT 0 0 0 Alarm
X X X X X 1 X X 0 0 0 0 X 0 0 1 Stop
X X X 1 1 X X X 0 0 0 0 X 0 0 1 Stop
X 0 X 1 0 0 X X 1 0 0 0 0 1 0 1 Start 

opening
<PT 1 0 X 0 0 0 X 1 0 0 0 INC 1 0 1 Open
X 1 0 X 0 0 1 0 0 0 0 0 PT 1 0 1 Opened
>=P
T

1 0 X 0 0 0 X 0 0 1 0 PT 1 0 0 Opening 
alarm

X X 0 0 1 0 X X 0 1 0 0 0 0 1 1 Start closing
<PT 0 1 0 X 0 X 0 0 1 0 0 INC 0 1 1 Close
X 0 1 0 X 0 0 1 0 0 0 0 PT 0 1 1 Closed
>=P
T

0 1 0 X 0 X 0 0 0 0 1 PT 0 1 0 Closing 
alarm

X 0 0 0 0 0 X X 0 0 0 0 X 0 0 1 Stopped
Legend:
INC Add the time difference (ms) since the last processing of the FB to ET
PT PT is set to the same value as ET
X Cannot be used
<PT ET < PT
>=PT ET >= PT
If the input parameters O_HIS and C_HIS both have the signal state "1", they are immediately set to signal state "0". In this 
case, the last row in the table (X) mentioned above is valid. Because it is therefore no longer possible to check whether the 
input parameters O_HIS and C_HIS have the signal state "1", the output parameters are set as follows in this case: 
OO = FALSE
CO = FALSE
OA = FALSE
CA = FALSE
ET = PT
Q = TRUE

The "Motor control-timer alarm" instruction has no error information.
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Parameters
The following table shows the reactions of the instruction "Motor control-timer alarm":

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
O_CMD Input BOOL I, Q, M, D, L or 

constant
"Open" command 
input

C_CMD Input BOOL I, Q, M, D, L or 
constant

"Close" command 
input

S_CMD Input BOOL I, Q, M, D, L or 
constant

"Stop" command 
input

O_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when opening

C_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when closing

OO Output BOOL I, Q, M, D, L "Open" output
CO Output BOOL I, Q, M, D, L "Close" output
OA Output BOOL I, Q, M, D, L Alarm output 

when opening
CA Output BOOL I, Q, M, D, L Alarm output 

when closing
Q Output BOOL I, Q, M, D, L A signal state of 

"0" indicates an 
error condition.

ET Static DINT D, L Currently elapsed 
time, where 1 
count = 1 ms

PT Static DINT D, L Preset time value, 
where 1 count = 1 
ms

PREV_TIME Static DWORD D, L Previous system 
time

O_HIS Static BOOL D, L "Open" history bit
C_HIS Static BOOL D, L "Close" history bit

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
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The following tables show how the instruction works using specific values.

Before processing

In this example, the following values are used for the input and output parameters:

Parameter Operand Value
O_CMD Tag_Input_O_CMD TRUE
C_CMD Tag_Input_C_CMD FALSE
S_CMD Tag_Input_S_CMD FALSE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
OO Tag_OutputOpen FALSE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q FALSE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#2
PT DBD8 L#22
O_HIS DBX16.0 TRUE
C_HIS DBX16.1 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:
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Parameter Operand Value
OO Tag_OutputOpen TRUE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q TRUE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
O_HIS DBX16.0 TRUE
CMD_HIS DBX16.1 FALSE

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

IMC: Compare input bits with the bits of a mask

Description
The instruction "Compare input bits with the bits of a mask" is used to compare the signal state 
of up to 16 programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bits of a mask. 
Up to 16 steps with masks can be programmed. The value of the IN_BIT0 parameter  is 
compared with the value of the mask CMP_VAL[x,0], with "x" indicating the step number. On 
the CMP_STEP parameter, you specify the step number of the mask that is used for the 
comparison.  All programmed values are compared in the same manner. Unprogrammed input 
bits or unprogrammed bits of the mask have the default signal state FALSE.

If a match is found in the comparison, the signal state of the OUT parameter is set to "1". 
Otherwise, the OUT parameter is set to "0".

If the value of CMP_STEP parameter is greater than 15, the instruction is not executed. An 
error message is output at the ERR_CODE parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".
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Parameters
The following table shows the parameters of the "Compare input bits with the bits of a mask" 
instruction:

Paramete
r

Declarati
on

Data type Memory area Description

EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN_BIT0 Input BOOL I, Q, M, D, L or constant Input bit 0 to be compared with 

bit 0 of the mask.
IN_BIT1 Input BOOL I, Q, M, D, L or constant Input bit 1 to be compared with 

bit 1 of the mask.
IN_BIT2 Input BOOL I, Q, M, D, L or constant Input bit 2 to be compared with 

bit 2 of the mask.
IN_BIT3 Input BOOL I, Q, M, D, L or constant Input bit 3 to be compared with 

bit 3 of the mask.
IN_BIT4 Input BOOL I, Q, M, D, L or constant Input bit 4 to be compared with 

bit 4 of the mask.
IN_BIT5 Input BOOL I, Q, M, D, L or constant Input bit 5 to be compared with 

bit 5 of the mask.
IN_BIT6 Input BOOL I, Q, M, D, L or constant Input bit 6 to be compared with 

bit 6 of the mask.
IN_BIT7 Input BOOL I, Q, M, D, L or constant Input bit 7 to be compared with 

bit 7 of the mask.
IN_BIT8 Input BOOL I, Q, M, D, L or constant Input bit 8 to be compared with 

bit 8 of the mask.
IN_BIT9 Input BOOL I, Q, M, D, L or constant Input bit 9 to be compared with 

bit 9 of the mask.
IN_BIT10 Input BOOL I, Q, M, D, L or constant Input bit 10 to be compared 

with bit 10 of the mask.
IN_BIT11 Input BOOL I, Q, M, D, L or constant Input bit 11 to be compared 

with bit 11 of the mask.
IN_BIT12 Input BOOL I, Q, M, D, L or constant Input bit 12 to be compared 

with bit 12 of the mask.
IN_BIT13 Input BOOL I, Q, M, D, L or constant Input bit 13 to be compared 

with bit 13 of the mask.
IN_BIT14 Input BOOL I, Q, M, D, L or constant Input bit 14 to be compared 

with bit 14 of the mask.
IN_BIT15 Input BOOL I, Q, M, D, L or constant Input bit 15 to be compared 

with bit 15 of the mask.
CMP_ST
EP

Input BYTE I, Q, M, D, L, P or constant The step number of the mask 
used for the comparison.

OUT Output BOOL I, Q, M, D, L A signal state of "1" indicates 
that a match was found.
A signal state of "0" indicates 
that a match was found.
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Paramete
r

Declarati
on

Data type Memory area Description

ERR_CO
DE

Output WORD I, Q, M, D, L, P Error information 

CMP_VA
L

Static ARRAY OF 
WORD

I, Q, M, D, L Comparison masks [0 to 15, 0 
to 15]: The first number of the 
index is the step number and 
the second number is the bit 
number of the mask.

For additional information on valid data types, refer to "See also".

Parameter ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000A The value at the CMP_STEP parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SMC: Compare scan matrix

Description
The "Compare scan matrix" instruction is used to compare the signal state of up to 16 
programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bits of the comparison 
masks for each step. Processing starts at step 1 and is continued until the last programmed 
step (LAST) or until a match is found. The input bit of the IN_BIT0 parameter is compared with 
the value of the mask CMP_VAL[x,0], with "x" indicating the step number. All programmed 
values are compared in the same manner. If a match is found the signal state of the OUT 
parameter is set to "1" and the step number with the matching mask is written in the OUT_STEP 
parameter. Unprogrammed input bits or unprogrammed bits of the mask have the default signal 
state FALSE. If more than one step has a matching mask, only the first one found is indicated 
in the OUT_STEP parameter. If no match is found, the signal state of the OUT parameter is 
set to "0". In this case the value at the OUT_STEP parameter is greater by "1" than the value 
at the LAST parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
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data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Compare scan matrix" instruction:

Paramete
r

Declarati
on

Data type Memory area Description

EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN_BIT0 Input BOOL I, Q, M, D, L or constant Input bit 0 to be compared with 

bit 0 of the mask.
IN_BIT1 Input BOOL I, Q, M, D, L or constant Input bit 1 to be compared with 

bit 1 of the mask.
IN_BIT2 Input BOOL I, Q, M, D, L or constant Input bit 2 to be compared with 

bit 2 of the mask.
IN_BIT3 Input BOOL I, Q, M, D, L or constant Input bit 3 to be compared with 

bit 3 of the mask.
IN_BIT4 Input BOOL I, Q, M, D, L or constant Input bit 4 to be compared with 

bit 4 of the mask.
IN_BIT5 Input BOOL I, Q, M, D, L or constant Input bit 5 to be compared with 

bit 5 of the mask.
IN_BIT6 Input BOOL I, Q, M, D, L or constant Input bit 6 to be compared with 

bit 6 of the mask.
IN_BIT7 Input BOOL I, Q, M, D, L or constant Input bit 7 to be compared with 

bit 7 of the mask.
IN_BIT8 Input BOOL I, Q, M, D, L or constant Input bit 8 to be compared with 

bit 8 of the mask.
IN_BIT9 Input BOOL I, Q, M, D, L or constant Input bit 9 to be compared with 

bit 9 of the mask.
IN_BIT10 Input BOOL I, Q, M, D, L or constant Input bit 10 to be compared 

with bit 10 of the mask.
IN_BIT11 Input BOOL I, Q, M, D, L or constant Input bit 11 to be compared 

with bit 11 of the mask.
IN_BIT12 Input BOOL I, Q, M, D, L or constant Input bit 12 to be compared 

with bit 12 of the mask.
IN_BIT13 Input BOOL I, Q, M, D, L or constant Input bit 13 to be compared 

with bit 13 of the mask.
IN_BIT14 Input BOOL I, Q, M, D, L or constant Input bit 14 to be compared 

with bit 14 of the mask.
IN_BIT15 Input BOOL I, Q, M, D, L or constant Input bit 15 to be compared 

with bit 15 of the mask.
OUT Output BOOL I, Q, M, D, L A signal state of "1" indicates 

that a match was found.
A signal state of "0" indicates 
that no match was found. 

ERR_CO
DE

Output WORD I, Q, M, D, L, P Error information 
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Paramete
r

Declarati
on

Data type Memory area Description

OUT_ST
EP

Output BYTE I, Q, M, D, L, P Contains the step number with 
the matching mask, or the 
step number which is greater 
by "1" than the value at the 
LAST parameter, provided no 
match is found.

LAST Static BYTE I, Q, M, D, L, P Specifies the step number of 
the last step to be scanned for 
a matching mask.

CMP_VA
L

Static ARRAY OF 
WORD

I, Q, M, D, L Comparison masks [0 to 15, 0 
to 15]: The first number of the 
index is the step number and 
the second number is the bit 
number of the mask.

For additional information on valid data types, refer to "See also".

Parameter ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000E The value at the LAST parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

LEAD_LAG: Lead and lag algorithm 

Description
The "Lead and lag algorithm" instruction is used to process signals with an analog tag. The 
gain value at the GAIN parameter must be greater than zero. The result of the instruction "Lead 
and lag algorithm" is calculated using the following equation:

The "Lead and lag algorithm" instruction supplies plausible results only when processing is in 
fixed program cycles. The same units must be specified for the LD_TIME, LG_TIME, and 
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SAMPLE_T parameters. At LG_TIME > 4 + SAMPLE_T, the instruction approaches the 
following function:

OUT = GAIN * ((1 + LD_TIME * s) / (1 + LG_TIME * s)) * IN

When the value of the GAIN parameter is less than or equal to zero, the calculation is not 
performed and an error information is output on the ERR_CODE parameter.

You can use the "Lead and lag algorithm" instruction in conjunction with loops as a 
compensator in dynamic feed-forward control. The instruction consists of two operations. The 
"Lead" operation shifts the phase of the OUT output so that the output leads the input. The 
"Lag" operation, on the other hand, shifts the output so that the output lags behind the input. 
Because the "Lag" operation is equivalent to an integration, it can be used as a noise 
suppressor or as a low-pass filter. The "Lead" operation is equivalent to a differentiation and 
can therefore be used as a high-pass filter. The two operations together (Lead and Lag) result 
in the output phase lagging behind the the input at lower frequencies and leading it at higher 
frequencies. This means that the "Lead and lag algorithm" instruction can be used as a band 
pass filter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Lead and lag algorithm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input REAL I, Q, M, D, L, P or 

constant
The input value of 
the current sample 
time (cycle time) to 
be processed.
Constants can 
also be specified 
on the IN 
parameter.

SAMPLE_T Input INT I, Q, M, D, L, P or 
constant

Sample time
Constants can 
also be specified 
on the SAMPLE_T 
parameter.

OUT Output REAL I, Q, M, D, L Result of the 
instruction

ERR_CODE Output WORD I, Q, M, D, L Error information 
LD_TIME Static REAL I, Q, M, D, L, P or 

constant
Lead time in the 
same unit as 
sample time.
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Parameter Declaration Data type Memory area Description
LG_TIME Static REAL I, Q, M, D, L, P or 

constant
Lag time in in the 
same unit as 
sample time.

GAIN Static REAL I, Q, M, D, L, P or 
constant

Gain as % / % (the 
ratio of the change 
in output to a 
change in input as 
a steady state).

PREV_IN Static REAL I, Q, M, D, L, P or 
constant

Previous input

PREV_OUT Static REAL I, Q, M, D, L, P or 
constant

Previous output

For additional information on valid data types, refer to "See also".

Parameter ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0009 The value at the GAIN parameter is less than or equal to zero.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
 

The following table shows how the instruction works using specific operand values:

Before processing

In this example the following values are used for the input parameters:
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Parameter Operand Value
IN Tag_Input 2.0
SAMPLE_T Tag_InputSampleTime 10

The following values are saved in the instance data block "LEAD_LAG_DB" of the instruction:

Parameter Address Value
LD_TIME DBD12 2.0
LG_TIME DBD16 2.0
GAIN DBD20 1.0
PREV_IN DBD24 6.0
PREV_OUT DBD28 6.0

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
OUT Tag_Output_Result 2.0

The following values are saved in the instance data block "LEAD_LAD_DB" of the instruction:

Parameter Operand Value
PREV_IN DBD24 2.0
PREV_OUT DBD28 2.0

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SEG: Create bit pattern for seven-segment display

Description       
The instruction "Create bit pattern for seven-segment display" is used to convert each of the 
four hexadecimal digits of the specified source word (IN) into an equivalent bit pattern for a 
seven-segment display. The result of the instruction is output in the double word on the OUT 
parameter.

The following relation exists between the hexadecimal digits and the assignment of the 7 
segments (a, b, c, d, e, f, g):
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Input digit
(Binary)

Assignment of 
the segments
‑ g f e d c b a

Display
(Hexadecimal)

Seven-segment display

0000 00111111 0
0001 00000110 1
0010 01011011 2
0011 01001111 3
0100 01100110 4
0101 01101101 5
0110 01111101 6
0111 00000111 7
1000 01111111 8
1001 01100111 9
1010 01110111 A
1011 01111100 B
1100 00111001 C
1101 01011110 D
1110 01111001 E
1111 01110001 F

Parameter
The following table shows the parameters of the "Create bit pattern for seven-segment display" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input WORD I, Q, M, D, L, P or 

constant
Source word with 
four hexadecimal 
digits

OUT Output DWORD I, Q, M, D, L, P Bit pattern for the 
seven-segment 
display
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
Hexadecimal Binary
IN Tag_Input W#16#1234 0001 0010 0011 0100
OUT Tag_Output DW#16065B4F66 000 00110 0101 1011 0100 

1111 0110 0110
Display: 1234

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

BCDCPL: Create tens complement

Description     
The "Create tens complement" instruction is used to create the tens complement of a seven-
digit BCD number specified on the IN parameter. This instruction uses the following 
mathematical formula to calculate:

10000000 (as BCD)

– 7-digit BCD value

----------------------------------------

Tens complement (as BCD)

Parameters
The following table shows the parameters of the "Create tens complement" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
IN Input DWORD I, Q, M, D, L, P or 

constant
7-digit BCD 
number

ERR_CODE Output DWORD I, Q, M, D, L, P Result of the 
instruction

Example
The following example shows how the instruction works:

The following table shows how the instruction functions using specific values:

Parameter Operand Value*
IN Tag_Input DW#16#01234567
ERR_CODE Tag_Output DW#16#08765433
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

BITSUM: Count number of set bits

Description     
The "Count number of set bits" instruction is used to count the number of bits of an operand 
that is set to the signal state "1". The operand whose bits are to be counted is specified on the  
IN parameter. The result of the instruction is output on the RET_VAL parameter.

Parameters
The following table shows the parameters of the "Count number of set bits" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
IN Input DWORD I, Q, M, D, L, P or 

constant
Operand whose 
set bits are 
counted

RET_VAL Output INT I, Q, M, D, L, P Number of bits to 
be set

Example
The following example shows how the instruction works:

The following table shows how the instruction functions using specific values:

Parameter Operand Value*
IN Tag_Input DW#16#12345678
RET_VAL Tag_Output W#16#000D (13 Bits)
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

9.7.2.2 FBD

Bit logic operations

&: AND logic operation

Description     
You can use the instruction "AND logic operation" to query the signal states of two or more 
specified operands and evaluate them according to the AND truth table.

If the signal state of all the operands is "1", then the condition is fulfilled and the instruction 
returns the result "1". If the signal state of one of the operands is "0", then the condition is not 
fulfilled and the instruction generates the result "0".
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Parameters
The following table shows the parameters of the instruction "AND logic operation":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

The operand 
indicates the 
bit whose 
signal state will 
be queried.

Example
The following example shows how the instruction works:

Output "TagOut" is set, when the signal state of the operands "TagIn_1" and "TagIn_2" is "1" 
and reset when the state of the operands "TagIn_1" and "TagIn_2" is "0".

See also
AND truth table (Page 1836)

Example of detecting the direction of a conveyor belt (Page 1560)

Example of controlling room temperature (Page 1564)

Overview of the valid data types (Page 1077)

Adding additional inputs and outputs to FBD elements (Page 1329)

Insert input (Page 1840)

AND truth table

Results of the logic operation   
The following table shows the results that arise from the AND logic operation of two operands:

Signal state of the first operand Signal state of the second 
operand

Result of the logic operation 

1 1 1
0 1 0
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Signal state of the first operand Signal state of the second 
operand

Result of the logic operation 

1 0 0
0 0 0

See also
&: AND logic operation (Page 1835)

Overview of the valid data types (Page 1077)

>=1: OR logic operation

Description     
You can use the instruction "OR logic operation" to query the signal states of two or more 
specified operands and evaluate them according to the OR truth table.

If the signal state of one of the operands is "1", then the condition is fulfilled and the instruction 
returns the result "1". If the signal state of all the operands is "0", then the condition is not 
fulfilled and the instruction generates the result "0".

Parameters
The following table shows the parameters of the instruction "OR logic operation":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

The operand 
indicates the 
bit whose 
signal state will 
be queried.

Example
The following example shows how the instruction works:

Output "TagOut" is set, when the signal state of the operands "TagIn_1" or "TagIn_2" is "1".
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See also
OR truth table (Page 1838)

Example of controlling a conveyor belt  (Page 1559)

Adding additional inputs and outputs to FBD elements (Page 1329)

Overview of the valid data types (Page 1077)

Insert input (Page 1840)

OR truth table

Results of the logic operation   
The following table shows the results that arise from the OR logic operation of two operands:

Signal state of the first operand Signal state of the second 
operand

Result of the logic operation 

1 0 1
0 1 1
1 1 1
0 0 0

See also
>=1: OR logic operation (Page 1837)

Overview of the valid data types (Page 1077)

X: EXCLUSIVE OR logic operation

Description       
You can use the instruction "EXCLUSIVE OR logic operation" to query the result of a signal 
state query according to the EXCLUSIVE OR truth table.

With an instruction "EXCLUSIVE OR logic operation", the signal state is "1" when the signal 
state of one of the two specified operands is "1". When more than two operands are queried, 
the common RLO is "1" if an odd number of the queried operands returns the result "1".
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Parameters
The following table shows the parameters of the instruction "EXCLUSIVE OR logic operation":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

The operand 
indicates the 
bit whose 
signal state will 
be queried.

Example
The following example shows how the instruction works:

Output "TagOut" is set when the signal state of the operands "TagIn_1" and "TagIn_2" is "1". 
When both operands return the signal state "1" or "0", the output "TagOut" is reset.

See also
EXCLUSIVE OR truth table (Page 1839)

Adding additional inputs and outputs to FBD elements (Page 1329)

Overview of the valid data types (Page 1077)

Insert input (Page 1840)

EXCLUSIVE OR truth table

Results of the logic operation      
The following table shows the results that arise from the EXCLUSIVE OR logic operation of 
two operands:

Signal state of the first operand Signal state of the second 
operand 

Result of the logic operation

1 0 1
0 1 1
1 1 0
0 0 0
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The following table shows the results that arise from the EXCLUSIVE OR logic operation of 
three operands:

Signal state of the first 
operand

Signal state of the 
second operand 

Signal state of the third 
operand 

Result of the logic 
operation

1 0 0 1
0 1 1 0
0 1 0 1
1 0 1 0
0 0 1 1
1 1 0 0
1 1 1 1
0 0 0 0

 
 

See also
X: EXCLUSIVE OR logic operation (Page 1838)

Overview of the valid data types (Page 1077)

Insert input

Description     
The "Insert input" instruction is used to add an input to the box of one of the following 
instructions:

● "AND logic operation"

● "OR logic operation"

● "EXCLUSIVE OR logic operation"

You can query the signal state of several operands by the extension of an instruction box.

Parameters
The following table shows the parameters of the instruction "Insert input":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

The operand 
indicates the 
bit whose 
signal state will 
be queried.
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Example
The following example shows how the instruction works:

The box of the instruction "AND logic operation" was extended by an additional input at which 
the signal state of the operand "TagIn_3" is queried. The output "TagOut" is set, when the 
signal state of the operands "TagIn_1", "TagIn_2" and "TagIn_3" returns the signal state "1".

See also
&: AND logic operation (Page 1835)

>=1: OR logic operation (Page 1837)

X: EXCLUSIVE OR logic operation (Page 1838)

Overview of the valid data types (Page 1077)

Invert RLO

Description     
You use the "Invert RLO" instruction to invert the signal state of the result of logic operation 
(RLO).

Example
The following example shows how the instruction works:

The output "TagOut" is set when the following conditions are fulfilled:

● The input "TagIn_1" and/or "TagIn_2" has signal state "0".

● The input "TagIn_3" and/or "TagIn_4" has signal state "0" or the input "TagIn_5" has signal 
state "1".

See also
Overview of the valid data types (Page 1077)
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=: Assignment

Description   
You can use the instruction "Assignment" to set the bit of a specified operand. If the result of 
logic operation (RLO) at the box input has the signal state "1", the specified operand is set to 
signal state "1". If the signal state at the box input is "0", the bit of the specified operand is 
reset to "0".

The instruction does not influence the RLO. The RLO at the box input is assigned directly to 
the operand above the assignment box.

Parameters
The following table shows the parameters of the instruction "Assignment":

Parameters Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand to which 

the RLO is 
assigned. 

Example
The following example shows how the instruction works:

The operand "TagOut" is set at the output of the "Assignment" instruction when one of the 
following conditions is fulfilled:

● The inputs "TagIn_1" and "TagIn_2" have the signal state "1".

● The signal state at the input "TagIn_3" is "0".

See also
Overview of the valid data types (Page 1077)

Example of detecting the fill level of a storage area  (Page 1561)

Example of controlling room temperature (Page 1564)
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/=: Negate assignment

Description   
The instruction "Negate assignment" inverts the result of logic operation (RLO) and assigns 
this to the operand above the box. If the RLO at the input of the box is "1", the binary operand 
is reset. If the RLO at the input of the box is "0", the operand is set to signal state "1".

Parameters
The following table shows the parameters of the instruction "Negate assignment":

Parameters Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand to which 

the negated RLO 
is assigned.

Example
The following example shows how the instruction works:

The operand "TagOut" is reset when the following conditions are fulfilled:

● The operand "TagIn_1" or "TagIn_2" has the signal state "1".

● The operand "TagIn_3" has the signal state "0".

See also
Overview of the valid data types (Page 1077)

R: Reset output

Description     
You can use the "Reset output" instruction to reset the signal state of a specified operand to 
"0".

The instruction is only executed if the result of logic operation (RLO) at the box input is "1". If 
the box input has the signal state "1", the specified operand is reset to "0". If there is an RLO 
of "0" at the box input, the signal state of the specified operand remains unchanged.
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Parameters
The following table shows the parameters of the "Reset output" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Output BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Operand that 
is reset if 
RLO = "1".

Example
The following example shows how the instruction works:

Operand "TagOut" is reset when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "0".

See also
Example of controlling a conveyor belt  (Page 1559)

Example of detecting the direction of a conveyor belt (Page 1560)

Overview of the valid data types (Page 1077)

S: Set output

Description     
You can use the instruction "Set output" to set the signal state of a specified operand to "1".

The instruction is only executed if the result of logic operation (RLO) at the box input is "1". If 
the box input has the signal state "1", the specified operand is set to "1". If there is an RLO of 
"0" at the box input, the signal state of the specified operand remains unchanged.
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Parameters
The following table shows the parameters of the instruction "Set output":

Parameters Declaratio
n

Data type Memory area Description

<Operand> Output BOOL I, Q, M, D, L Operand which is set with 
RLO = "1".

Example
The following example shows how the instruction works:

The "TagOut" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "0".

See also
Overview of the valid data types (Page 1077)

SET_BF: Set bit field

Description       
You use the instruction "Set bit field" to set multiple bits starting from a certain address.

You use the input N to define the number of bits to be set. The address of the first bit to be set 
is defined by (<Operand>). If the value of the N input is greater than the number of bits in a 
selected byte, the bits of the next byte are set. The bits remain set until they are explicitly reset, 
for example, by another instruction.
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Parameters
The following table shows the parameters of the instruction "Set bit field":

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
N Input UINT Constant Number of bits to 

be set
<Operand> Output BOOL I, Q, M

In the case of a DB 
or an IDB, an 
element of an 
ARRAY[..] of 
BOOL

Pointer to the first 
bit to be set.

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", 5 bits are set starting at the 
address of the operand "MyDB".MyBoolArray[4].

See also
Overview of the valid data types (Page 1077)

RESET_BF: Reset bit field

Description       
You use the instruction "Reset bit field" to reset several bits starting from a certain address.

You use the value of the N input to define the number of bits to be reset. The address of the 
first bit to be reset is defined by (<Operand>). If the value of the input N is greater than the 
number of bits in a selected byte, the bits of the next byte are reset. The bits remain reset until 
they are explicitly set, for example, by another instruction.
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Parameters
The following table shows the parameters of the instruction "Reset bit field":

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
N Input UINT Constant Number of bits to 

be reset.
<Operand> Output BOOL I, Q, M

In the case of a DB 
or an IDB, an 
element of an 
ARRAY[..] of 
BOOL

Pointer to the first 
bit to be reset.

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", 5 bits are reset starting at 
the address of the operand "MyDB".MyBoolArray[4].

See also
Overview of the valid data types (Page 1077)

SR: Set/reset flip-flop

Description       
You can use the instruction "Set/reset flip-flop" to set or reset the bit of a specified operand 
based on the signal state of the inputs S and R1. If the signal state is "1" at input S and "0" at 
input R1, the specified operand is set to "1". If the signal state is "0" at input S and "1" at input 
R1, the specified operand will be reset to "0".

Input R1 takes priority over input S. When the signal state is "1" on both inputs S and R1, the 
signal state of the specified operand is reset to "0".

The instruction is not executed if the signal state at the two inputs S and R1 is "0". The signal 
state of the operand then remains unchanged.

The current signal state of the operand is transferred to output Q and can be queried there.
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Parameters
The following table shows the parameters of the instruction "Set/reset flip-flop":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

S Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable setting

R1 Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable 
resetting

<Operand> InOut BOOL I, Q, M, D, L I, Q, M, D, L Operand that 
is set or reset

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Signal state of 
the operand

Example
The following example shows how the instruction works:

The operands "TagSR" and "TagOut" are set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The operand "TagIn_2" has the signal state "0".

The operands "TagSR" and "TagOut" are reset when one of the following conditions is fulfilled:

● The operand "TagIn_1" has signal state "0" and the operand "TagIn_2" has signal state "1".

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

See also
Overview of the valid data types (Page 1077)

RS: Reset/set flip-flop

Description       
You can use the instruction "Reset/set flip-flop" to reset or set the bit of a specified operand 
based on the signal state of the inputs R and S1. If the signal state is "1" at input R and "0" at 
input S1, the specified operand will be reset to "0". If the signal state is "0" at input R and "1" 
at input S1, the specified operand is set to "1". 
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Input S1 takes priority over input R. When the signal state is "1" at both inputs R and S1, the 
signal state of the specified operand is set to "1".

The instruction is not executed if the signal state at the two inputs R and S1 is "0". The signal 
state of the operand then remains unchanged.

The current signal state of the operand is transferred to output Q and can be queried there.

Parameters
The following table shows the parameters of the instruction "Reset/set flip-flop":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

R Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable 
resetting

S1 Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable setting

<Operand> InOut BOOL I, Q, M, D, L I, Q, M, D, L Operand that 
is reset or set.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Signal state of 
the operand

Example
The following example shows how the instruction works:

The operands "TagRS" and "TagOut" are reset when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The operand "TagIn_2" has the signal state "0".

The operands "TagRS" and "TagOut" are set when the following conditions are fulfilled:

● The operand "TagIn_1" has signal state "0" and the operand "TagIn_2" has signal state "1".

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

See also
Overview of the valid data types (Page 1077)
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P: Scan operand for positive signal edge

Description
You can use the instruction "Scan operand for positive signal edge" to determine whether there 
is a "0" to "1" change in the signal state of a specified operand (<Operand1>). The instruction 
compares the current signal state of <Operand1> with the signal state of the previous scan, 
which is saved in an edge memory bit (<Operand2>). If the instruction detects a change in the 
result of logic operation (RLO) from "0" to "1", there is a positive, rising edge.

If a rising edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

Specify the operand to be queried (<Operand1>) in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the "Scan operand for positive signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Signal to be 
scanned 

<Operand2> InOut BOOL I, Q, M, D, L I, Q, M, D, L Edge memory 
bit in which the 
signal state of 
the previous 
query is saved.

Example
The following example shows how the instruction works:
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Output "TagOut" is set when the following conditions are fulfilled:

● There is a rising edge at input "TagIn_1".

● The signal state of the operand "TagIn_2" is "1".

See also
Overview of the valid data types (Page 1077)

Example of detecting the direction of a conveyor belt (Page 1560)

N: Scan operand for negative signal edge

Description
You can use the instruction "Scan operand for negative signal edge" to determine whether 
there is a "1" to "0" change in the signal state of a specified operand (<Operand1>). The 
instruction compares the current signal state of <Operand1> with the signal state of the 
previous scan, which is saved in an edge memory bit (<Operand2>). If the instruction detects 
a change in the result of logic operation (RLO) from "1" to "0", there is a negative, falling edge.

If a falling edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

Specify the operand to be queried (<Operand1>) in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the "Scan operand for negative signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Signal to be 
scanned

<Operand2> InOut BOOL I, Q, M, D, L I, Q, M, D, L Edge memory 
bit in which the 
signal state of 
the previous 
query is saved.
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Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● There is a falling edge at input "TagIn_1".

● The signal state of the operand "TagIn_2" is "1".

See also
Overview of the valid data types (Page 1077)

P=: Set operand on positive signal edge

Description
You can use the instruction "Set operand on positive signal edge" to set a specified operand 
(<Operand2>) when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO with the RLO from the previous query, which is saved 
in the edge memory bit (<Operand1>). If the instruction detects a change in the result of logic 
operation (RLO) from "0" to "1", there is a positive, rising edge.

When a positive edge is detected, <Operand2> is set to signal state "1" for one program cycle. 
In all other cases, the operand has the signal state "0".

You specify the operand (<Operand2>) to be set in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand1>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.
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Parameters
The following table shows the parameters of the instruction "Set operand on positive signal 
edge":

Parameter Declaration Data type Memory area Description
<Operand2> Output BOOL I, Q, M, D, L Operand which is 

set when there is a 
positive signal 
edge.

<Operand1> InOut BOOL I, Q, M, D, L Edge memory bit

Example
The following example shows the parameters of the instruction:

The "TagOut" output is set for one program cycle, when the signal state at the input of the 
instruction box switches from "0" to "1" (positive signal edge). In all other cases, the "TagOut" 
output has signal state "0".

See also
Overview of the valid data types (Page 1077)

N=: Set operand on negative signal edge

Description
You can use the instruction "Set operand on negative signal edge" to set a specified operand 
(<Operand1>) when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO with the RLO from the previous query, which is saved 
in the edge memory bit (<Operand2>). If the instruction detects a change in the result of logic 
operation (RLO) from "1" to "0", there is a negative, falling edge.

When a negative edge is detected, <Operand1> is set to signal state "1" for one program cycle. 
In all other cases, the operand has the signal state "0".
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You specify the operand (<Operand1>) to be set in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the instruction "Set operand on negative signal 
edge":

Parameter Declaration Data type Memory area Description
<Operand1> Output BOOL I, Q, M, D, L Operand which is 

set when there is a 
negative signal 
edge.

<Operand2> InOut BOOL I, Q, M, D, L Edge memory bit

Example
The following example shows how the instruction works:

The operand  "TagOut" is set for one program cycle if the signal state at the input of the 
instruction box changes from "1" to "0" (negative signal edge). In all other cases, the operand 
"TagOut" has the signal state "0".

See also
Overview of the valid data types (Page 1077)

P_TRIG: Scan RLO for positive signal edge

Description
Use the instruction "Scan RLO for positive signal edge" to query a "0" to "1" change in the 
signal state of the result of logic operation (RLO). The instruction compares the current signal 
state of the RLO with the signal state of the previous query, which is saved in an edge memory 
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bit (<Operand>). If the instruction detects a change in the result of logic operation (RLO) from 
"0" to "1", there is a positive, rising edge.

If a rising edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the instruction "Scan RLO for positive signal edge":

Parameter Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L Current RLO
<Operand> InOut BOOL M, D Edge memory bit 

in which the RLO 
of the previous 
query is saved.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the preceding bit logic operation is saved in the edge memory bit "Tag_M". If a "0" 
to "1" change is detected in the signal state of the RLO, the program jumps to jump label CAS1.

See also
Overview of the valid data types (Page 1077)
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N_TRIG: Scan RLO for negative signal edge

Description
Use the instruction "Scan RLO for negative signal edge" to query a "1" to "0" change in the 
signal state of the result of logic operation (RLO). The instruction compares the current signal 
state of the RLO with the signal state of the previous query saved in the edge memory bit 
(<Operand>). If the instruction detects a change in the result of logic operation (RLO) from "1" 
to "0", there is a negative, falling edge.

If a falling edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the instruction "Scan RLO for negative signal 
edge":

Parameter Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L Current RLO
<Operand> InOut BOOL M, D Edge memory bit 

in which the RLO 
of the previous 
query is saved.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the preceding bit logic operation is saved in the edge memory bit "Tag_M". If a "1" 
to "0" change is detected in the signal state of the RLO, the program jumps to jump label CAS1.
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See also
Overview of the valid data types (Page 1077)

R_TRIG: Set tag on positive signal edge

Description
You can use the "Set tag on positive signal edge" instruction to set a specified tag in the 
instance DB when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the result of 
logic operation (RLO) from "0" to "1", there is a positive, rising edge.

If a positive edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find this in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the instruction "Set tag on positive signal edge":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
CLK Input BOOL I, Q, M, D, L or 

constant
I, Q, M, D, L, T, 
C or constant

Incoming 
signal, the 
edge of which 
is to be 
queried.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Result of edge 
evaluation
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Example
The following example shows how the instruction works:

The RLO of the preceding query is saved in the instance DB "R_TRIG_DB". If a change is the 
signal state of the RLO from "0" to "1" is detected in the operands "TagIn_1" and "TagIn_2" or 
in the operand "TagIn_3", the output "TagOut" has signal state "1".

See also
Overview of the valid data types (Page 1077)

F_TRIG: Set tag on negative signal edge

Description
You can use the "Set tag on negative signal edge" instruction to set a specified tag in the 
instance DB when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the result of 
logic operation (RLO) from "1" to "0", there is a negative, falling edge.

If a negative edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find this in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the instruction "Set tag on negative signal edge":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1858 System Manual, 07/2013,  



Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

CLK Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L, T, 
C or constant

Incoming 
signal, the 
edge of which 
is to be 
queried.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the preceding query is saved in the instance DB "F_TRIG_DB". If a change is the 
signal state of the RLO from "1" to "0" is detected in the operands "TagIn_1" and "TagIn_2" or 
in the operand "TagIn_3", the output "TagOut" has signal state "1".

See also
Overview of the valid data types (Page 1077)

Timer operations

IEC Timers

TP: Generate pulse

Description
You can use the instruction "Generate pulse" to set output Q for the duration PT. The instruction 
is started when the result of logic operation (RLO) at input IN changes from "0" to "1" (positive 
signal edge). The configured time duration PT begins when the instruction starts. Output Q is 
set for the time duration PT, regardless of the subsequent course of the input signal (positive 
edge). Even when a new positive signal edge is detected, the signal state of the Q output is 
not affected as long as the PT duration is running.

The current time value can be queried at the output ET. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. If the configured time duration PT is 
reached and the signal state at input IN is "0", the ET output is reset.
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Each call of the "Generate pulse" instruction must be assigned an IEC Timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TP_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC Timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TP_TIME or TP_LTIME 
that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
this in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate pulse" instruction requires a preceding logic operation. It can 
be placed within or at the end of the network.
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Parameters
The following table shows the parameters of the "Generate pulse" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C, P

Start input

PT Input TIME TIME, 
LTIME

I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Duration of 
the pulse.
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
P

Pulse output

ET Output TIME TIME, 
LTIME

I, Q, M, D, L I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate pulse" instruction:

See also
Overview of the valid data types (Page 1077)

Example of controlling room temperature (Page 1564)
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TON: Generate on-delay

Description
You can use the instruction "Generate on-delay" to delay setting of the Q output by the time 
configured with the PT time. The instruction is started when the result of logic operation (RLO) 
at input IN changes from "0" to "1" (positive signal edge). The programmed time PT begins 
when the instruction starts. When the duration PT expires, output Q has the signal state "1". 
Output Q remains set as long as the start input is still "1". When the signal state at the start 
input changes from "1" to "0", the Q output is reset. The timer function is started again when 
a new positive signal edge is detected at the start input.

The current time value can be queried at the output ET. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. The ET output is reset as soon as the 
signal state at the IN input changes to "0".

Each call of the "Generate on-delay" instruction must be assigned an IEC Timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TON_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC Timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TON_TIME or 
TON_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME, TON_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, it is saved to 
the "Program resources" folder in the "Program blocks > System blocks" path of the project 
tree. For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.
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The execution of the "Generate on-delay" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Generate on-delay" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C, P

Start input

PT Input TIME TIME, 
LTIME

I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Duration of 
the on delay.
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
P

Output that 
is set when 
the time PT 
expires.

ET Output TIME TIME, 
LTIME

I, Q, M, D, L I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate on-delay" instruction:
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See also
Overview of the valid data types (Page 1077)

TOF: Generate off-delay

Description
You can use the "Generate off-delay" instruction to delay setting of the Q output by the time 
configured with the PT time. The output Q is set when the result of logic operation (RLO) at 
input IN changes from "0" to "1" (positive signal edge). When the signal state at input IN 
changes back to "0" (positive signal edge), the configured time duration PT starts. Output Q 
remains set as long as the time duration PT is running. When the PT time duration expires, 
the Q output is reset. If the signal state at input IN changes to "1" before the PT time duration 
expires, the timer is reset. The signal state at the output Q will continue to be "1".

The current time value can be queried at the output ET. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. When the time duration PT expires, 
the ET output remains set to the current value until input IN changes back to "1". If input IN 
changes to "1" before the time duration PT has expired, the ET output is reset to the value 
T#0s.

Each call of the "Generate off-delay" instruction must be assigned to an IEC Timer in which 
the instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TOF_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC Timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TOF_TIME or 
TOF_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME, TOF_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Timer is stored in its own data block (single instance) or as a local 
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tag (multiple instance) in the block interface. If you create a separate data block, you will find 
this in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate off-delay" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Generate off-delay" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C, P

Start input

PT Input TIME TIME, 
LTIME

I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Duration of 
the off delay
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
P

Output that 
is reset 
when the 
timer PT 
expires.

ET Output TIME TIME, 
LTIME

I, Q, M, D, L I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate off-delay" instruction:

See also
Overview of the valid data types (Page 1077)

TONR: Time accumulator

Description
The instruction "Time accumulator" is used to accumulate time values within a period set by 
the parameter PT. The instruction is executed and the configured time duration PT is started 
when the result of logic operation (RLO) at input IN changes from "0" to "1" (positive edge). 
While the time set at PT is running, the time values are accumulated that are recorded at signal 
state "1" at input IN. The accumulated time is written to output ET and can be queried there. 
When the current time value PT is reached, the output Q has the signal state "1". Output Q 
remains set at "1", even when the signal state at input IN changes to "0".

The R input resets the outputs ET and Q regardless of the signal state at the start input.

Each call of the "Time accumulator" instruction must be assigned to an IEC Timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TONR_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or IEC_TIMER in the "Static" section of 
a block (for example, #MyIEC_TIMER)
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For S7-1500 CPU
An IEC Timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TONR_TIME or 
TONR_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME, TONR_LTIME, IEC_TIMER or 
IEC_LTIMER in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
this in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Time accumulator" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Time accumulator" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C, P

Start input

R Input BOOL BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Reset input

PT Input TIME TIME, 
LTIME

I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Maximum 
duration of 
time 
recording.
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
P

Output that 
is set when 
the time PT 
expires.

ET Output TIME TIME, 
LTIME

I, Q, M, D, L I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Time accumulator" instruction:

See also
Overview of the valid data types (Page 1077)

TP: Start pulse timer

Description
Use the instruction "Start pulse timer" to start an IEC Timer with a specified duration as pulse. 
The IEC Timer is started when the result of logic operation (RLO) changes from "0" to "1" 
(positive signal edge). The IEC Timer runs for the specified time duration regardless of the 
subsequent course of the RLO. The expiry of the IEC Timer is also not affected by the detection 
of a new rising edge. As long as the IEC Timer is running, the querying of the timer status for 
"1" returns the signal state "1". When the IEC Timer has expired, the timer status returns the 
signal state "0".

 

 Note

The start and the query of the IEC Timer may be on different expiry levels as each query of 
the outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start pulse timer" stores its data in a structure of the data type IEC_TIMER or 
TP_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The instruction "Start pulse timer" stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TP_TIME or TP_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
specified timer is accessed.

The current timer status is saved in the structure components Q of the IEC Timer. You can 
query the timer status with the help of a binary logic operation. The query for Q or ET (e. g. 
"MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER structure.

The execution of the instruction "Start pulse timer" assumes a preceding logic operation. It can 
be placed only at the end of the network.

Parameters
The following table shows the parameters of the instruction "Start pulse timer":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

VALUE Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
Timer runs.

<IEC Timer> InOut IEC_TIMER, 
TP_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME

D, L IEC Timer 
which is 
started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The instruction "Start pulse timer" is executed when the signal state of the operand "Tag_Input" 
changes from "0" to "1". The timer "DB1".MyIEC_TIMER is started for the time stored in the 
operand "TagTime".

As long as the timer "DB1".MyIEC_TIMER is running, the timer status 
("DB1".MyIEC_TIMER.Q) has signal state "1" and the operand "Tag_Output" is set. When the 
IEC Timer has expired, the signal state of the time status changes back to "0" and the 
"Tag_Output" operand is reset.

See also
Overview of the valid data types (Page 1077)

TON: Start on-delay timer

Description
Use the "Start on-delay timer" instruction to start an IEC Timer with a specified duration as on-
delay. The IEC Timer is started when the result of logic operation (RLO) changes from "0" to 
"1" (positive signal edge). The IEC Timer runs for the specified time duration. The output returns 
the signal state "1" if the RLO at the input of the instruction has the signal state "1". If the RLO 
changes to "0" before the end of the timer, the running IEC Timer is reset. The query of the 
timer status for "1" returns the signal state "0". The IEC Timer restarts when the next rising 
signal edge is detected at the input of the instruction.

 

 Note

The start and the query of the IEC Timer may be on different expiry levels as each query of 
the outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start on-delay timer" stores its data in a structure of the data type IEC_TIMER 
or TON_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Start on-delay timer" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TON_TIME or TON_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME, TON_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
specified timer is accessed.

The current timer status is saved in the structure components ET of the IEC Timer. You can 
query the timer status with the help of a binary logic operation. The query for Q or ET (e. g. 
"MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER structure.

The execution of the "Start on-delay timer" instruction assumes a preceding logic operation. 
It can be placed only at the end of the network.

Parameters
The following table shows the parameters of the instruction "Start on-delay timer":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

VALUE Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
Timer runs.

<IEC Timer> InOut IEC_TIMER, 
TON_TIME

IEC_TIMER, 
IEC_LTIMER, 
TON_TIME, 
TON_LTIME

D, L IEC Timer 
which is 
started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start on-delay timer" instruction is executed when the signal state of the operand 
"Tag_Input" changes from "0" to "1". The "MyIEC_TIMER" timer is started for the time stored 
in the "Tag_TIME" operand.

If the timer "MyIEC_TIMER" has expired and the operand "Tag_Input" has the signal state "1", 
querying the timer status ("MyIEC_TIMER".Q) returns signal state "1" and the "Tag_Output" 
operand is set. When the signal state of the operand "Tag_Input" changes to "0", the querying 
of the timer status returns the signal state "0" and the operand "Tag_Output" is reset.

See also
Overview of the valid data types (Page 1077)

TOF: Start off-delay timer

Description
Use the "Start off-delay timer" instruction to start an IEC Timer with a specified duration as off-
delay. The query of the timer status for "1" returns the signal state "0" if the result of the logic 
operation (RLO) at the input of the instruction has the signal state "1". When the RLO changes 
from "1" to "0" (negative signal edge), the IEC Timer starts with the specified time duration. 
The timer status remains at signal state "1" as long as the IEC Timer is running. When the 
timer has run out and the RLO at the input of the instruction has the signal state "0", the timer 
status is set to the signal state "0". If the RLO changes to "1" before the end of the timer, the 
running IEC Timer is reset and the timer status remain at the signal state "1".

 

 Note

The start and the query of the IEC Timer may be on different expiry levels as each query of 
the outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start off-delay timer" stores its data in a structure of the data type IEC_TIMER 
or TOF_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Start off-delay timer" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TOF_TIME or TOF_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME, TOF_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
specified timer is accessed.

The current timer status is saved in the structure components ET of the IEC Timer. You can 
query the timer status with the help of a binary logic operation. The query for Q or ET (e. g. 
"MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER structure.

The execution of the "Start off-delay timer" instruction assumes a preceding logic operation. 
It can be placed only at the end of the network.

Parameters
The following table shows the parameters of the instruction "Start off-delay timer":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

VALUE Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with which 
the IEC Timer runs.

<IEC Timer> InOut IEC_TIMER, 
TOF_TIME

IEC_TIMER, 
IEC_LTIMER
, TOF_TIME, 
TOF_LTIME

D, L IEC Timer which is 
started.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1873



Example
The following example shows how the instruction works:

The "Start off-delay timer" instruction is executed when the signal state of the operand 
"Tag_Input" changes from "1" to "0". The #MyIEC_TIMER timer is started for the time stored 
in the operand "Tag_TIME".

As long as timer #MyIEC_TIMER is running, the query of the time status (#MyIEC_TIMER.Q) 
returns the signal state "1" and operand "Tag_Output" is set. If the timer has expired and the 
operand "Tag_Input" has the signal state "0", the query of the timer status returns the signal 
state "0". If the signal state of the operand "Tag_Input" changes to "1" before timer 
#MyIEC_TIMER expires, the timer is reset. When the signal state of the operand "Tag_Input" 
is "1", the query of the timer status returns the signal state "1".

See also
Overview of the valid data types (Page 1077)

TONR: Time accumulator

Description
You can use the "Time accumulator" instruction to record how long the signal is at the input 
of instruction "1". The instruction is started when the result of logic operation (RLO) changes 
from "0" to "1" (positive signal edge). The time is recorded as long at the RLO is "1". If the RLO 
changes to "0", the instruction is halted. If the RLO changes back to "1", the time recording is 
continued. The query of the timer status for "1" returns the signal state "1" if the recorded time 
exceeds the value of the specified time duration and the RLO at the input of coil is "1".

The timer status and the currently expired timer can be reset to "0" using the "Reset timer" 
instruction.

 

 Note

The start and the query of the IEC Timer may be on different expiry levels as each query of 
the outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The "Time accumulator" instruction stores its data in a structure of the data type IEC_TIMER 
or TONR_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or IEC_TIMER in the "Static" section of 
a block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Time accumulator" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TONR_TIME or TONR_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME, TONR_LTIME, IEC_TIMER or 
IEC_LTIMER in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
specified timer is accessed.

The current timer status is saved in the structure components ET of the IEC Timer. You can 
query the timer status with the help of a binary logic operation. The query for Q or ET (e. g. 
"MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER structure.

The execution of the "Time accumulator" instruction requires a preceding logic operation. It 
can be placed only at the end of the network.

Parameters
The following table shows the parameters of the "Time accumulator" instruction:

Parameters Declaration Data type Memory area Descripti
onS7-1200 S7-1500

VALUE Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration 
with 
which 
the IEC 
Timer 
runs.

<IEC Timer> InOut IEC_TIMER, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TONR_TIME, 
TONR_LTIME

D, L IEC 
Timer 
which is 
started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Time accumulator" instruction is executed if there is a positive signal edge in the RLO. 
The time is recorded as long as the operand "Tag_Input" has the signal state "1".

If the recorded time exceeds the value of the operand "Tag_TIME", then the query of the timer 
status ("MyIEC_TIMER".Q) will return the signal state "1" and the operand "Tag_Output" will 
be set.

See also
Overview of the valid data types (Page 1077)

RT: Reset timer (Page 1876)

RT: Reset timer

Description
You can use the "Reset timer" instruction to reset an IEC Timer to "0". You specify the IEC 
Timer to be reset by entering the name of the data block that contains the structure of the IEC 
Timer in the placeholder above the instruction.

The instruction is only executed if the result of logic operation (RLO) at the box input is "1". 
When the instruction is executed the structure components of the IEC Timer are reset to "0" 
in the specified data block. If the RLO at box input  is "0", the instruction is not executed.

The instruction does not influence the RLO. The RLO at the box input is transferred directly to 
the box output.

You must assign a IEC Timer declared in the program to the "Reset timer" instruction.

The instruction data is updated only when the instruction is called and not each time the 
assigned IEC Timer is accessed. The query of the data is only identical from the call of the 
instruction to the next call of the instruction.
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Parameters
The following table shows the parameters of the instruction "Reset timer":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

<IEC Timer> InOut IEC_TIMER, 
TP_TIME, 
TON_TIME, 
TOF_TIME, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

D, L IEC Timer, 
which is reset.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "Generate on-delay" instruction executes when the signal state of the "Tag_Input_1" 
operand changes from "0" to "1". The IEC Timer stored in the instance data block "TON_DB" 
is started with the time duration that is specified by the operand "Tag_PT".

If the operands "Tag_Input_2" and "Tag_Input_3" have the signal state "1", the "Reset timer" 
instruction is executed and the IEC Timer stored in the data block "TON_DB" is reset.

See also
Overview of the valid data types (Page 1077)
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PT: Load time duration

Description     
Use the "Load time duration" instruction to set the time duration of an IEC Timer. The instruction 
is executed in every cycle when the result of logic operation (RLO) at the input of the instruction 
has the signal state "1". The instruction writes the specified time duration to the structure of 
the specified IEC Timer.

 

 Note

If the specified IEC Timer is running during the execution, the instruction overwrites the 
current time duration of the specified IEC Timer. As a result, the timer status of the IEC Timer 
can change.

 

You must assign a IEC Timer declared in the program to the "Load time duration" instruction.

The instruction data is updated when the instruction is called and each time the assigned IEC 
Timer is accessed. The query for Q or ET (e. g. "MyTimer".Q or "MyTimer".ET) updates the 
IEC_TIMER structure.

Parameters
The following table shows the parameters of the instruction "Load time duration":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

PT Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Time duration

<IEC Timer> InOut IEC_TIMER, 
TP_TIME, 
TON_TIME, 
TOF_TIME, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

D, L IEC Timer, the 
duration of 
which is set.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Generate on-delay" instruction executes when the signal state of the "Tag_Input_1" 
operand changes from "0" to "1". The IEC Timer stored in the instance data block "TON_DB" 
is started with the time duration that is specified by the operand "Tag_PT".

The "Load time duration" instruction is executed when the operand "Tag_Input_2" has the 
signal state "1". The instruction writes the time duration "Tag_PT_2" in the instance data block 
"TON_DB" and at the same time overwrites the value of the operand "Tag_PT" within the data 
block. As a result, the signal state of the timer status can change at the next query or upon 
access to "MyTimer".Q or "MyTimer".ET.

 

 Note

The "Tag_Input_2" is executed as pulse flag in order that the time duration is loaded only 
throughout one program cycle.

 

See also
Overview of the valid data types (Page 1077)

SIMATIC Timers

S_PULSE: Assign pulse timer parameters and start

Description
The "Assign pulse timer parameters and start" instruction starts a programmed timer when a 
transition from "0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) 
at input S. The timer expires with the programmed duration (TV) as long as the signal state at 
input S is "1". If the signal state at input S changes to "0" before the programmed duration 
expires, the timer is stopped. In this case, the signal state at output Q is "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
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to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

If the timer is running and the signal state at input R changes to "1", the current time value and 
the time base are also set to zero. If the timer is not running, the signal state "1" at the R input 
has no effect.

The "Assign pulse timer parameters and start" instruction needs a preceding logic operation 
for the edge evaluation and can be placed within or at the end of the network.

The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the "Assign pulse timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign pulse timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer runs for the time value of the "TagIn_Number" operand as long as the "TagIn_1" operand 
has the signal state "1". If the signal state of the operand "TagIn_1" changes from "1" to "0" 
before the timer expires, the timer "Timer_1" is stopped. The "TagOut" operand is reset to 
signal state "0".
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The "TagOut" operand has the signal state "1" as long as the timer is running and the "TagIn_1" 
operand has the signal state "1". When the time has expired or is reset, the "TagOut" operand 
is reset to "0".

See also
Overview of the valid data types (Page 1077)

S_PEXT: Assign extended pulse timer parameters and start

Description
The "Assign extended pulse timer parameters and start" instruction starts a programmed timer 
when a transition from "0" to "1" (positive signal edge) is detected in the result of logic operation 
(RLO) at input S. The timer expires with the programmed duration (TV), even if the signal state 
at input S changes to "0". As long as the timer is running, output Q has the signal state "1". 
When the timer has expired, output Q is reset to "0". If the signal state at input S changes from 
"0" to "1" while the timer is running, the timer is restarted with the duration programmed at 
input TV.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

If the timer is running and the signal state at input R changes to "1", the current time value and 
the time base are also set to zero. If the timer is not running, the signal state "1" at the R input 
has no effect.

The "Assign extended pulse timer parameters and start" instruction needs a preceding logic 
operation for the edge evaluation and can be placed within or at the end of the network.

The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameters
The following table shows the parameters of the "Assign extended pulse timer parameters and 
start" instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign extended pulse timer 
parameters and start" instruction:

Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer runs for the time value of the "TagIn_Number" operand without being affected by a 
negative edge at the S input. If the signal state at the "TagIn_1" operand changes from "0" to 
"1" before the timer expires, the timer is restarted.

The "TagOut" operand has the signal state "1" as long as the timer is running. When the time 
has expired or is reset, the "TagOut" operand is reset to "0".
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See also
Overview of the valid data types (Page 1077)

S_ODT: Assign on-delay timer parameters and start

Description
The "Assign on-delay timer parameters and start" instruction starts a programmed timer when 
a transition from "0" to "1" (positive signal edge) is detected in the result of logic operation 
(RLO) at input S. The timer expires with the programmed duration (TV) as long as the signal 
state at input S is "1". If the timer expires correctly and input S still has signal state "1", output 
Q returns signal state "1". If the signal state at input S changes from "1" to "0" while the timer 
is running, the timer is stopped. In this case, output Q is reset to signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

If the time is running and the signal state at input R changes from "0" to "1", the current time 
value and the time base are also set to zero. In this case, the signal state at output Q is "0". 
The timer is reset if the signal state is "1" at the R input even if the timer is not running and the 
RLO at input S is "1".

The "Assign on-delay timer parameters and start" instruction needs a preceding logic operation 
for the edge evaluation and can be placed within or at the end of the network.

The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameters
The following table shows the parameters of the "Assign on-delay timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign on-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the value of operand "TagIn_Number". If the timer expires and the signal 
state of the operand is "1", the "TagOut" operand is set to "1". If the signal state at the "TagIn_1" 
operand changes from "1" to "0" before the timer expires, the timer is stopped. The "TagOut" 
operand has the signal state "0".
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See also
Overview of the valid data types (Page 1077)

S_ODTS: Assign retentive on-delay timer parameters and start

Description
The "Assign retentive on-delay timer parameters and start" instruction starts a programmed 
timer when a transition from "0" to "1" (positive signal edge) is detected in the result of logic 
operation (RLO) at input S. The timer expires with the programmed duration (TV), even if the 
signal state at input S changes to "0". If the timer expires, the "Q" output returns signal state 
"1" regardless of the signal state at input "S". If the signal state at input S changes from "0" to 
"1" while the timer is running, the timer is restarted with the duration programmed at input (TV).

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

Signal state "1" at input R resets the current time value and time base to "0" regardless of the 
signal state at start input S. In this case, the signal state at output Q is "0".

The "Assign retentive on-delay timer parameters and start" instruction needs a preceding logic 
operation for the edge evaluation and can be placed within or at the end of the network.

The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameters
The following table shows the parameters of the "Assign retentive on-delay timer parameters 
and start" instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign retentive on-delay timer 
parameters and start" instruction:
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the time value of the "TagIn_Number" operand, even when the signal state 
of the "TagIn_1" operand changes to "0". When the time expires, the "TagOut" operand is reset 
to "1". If the signal state at the "TagIn_1" operand changes from "0" to "1" while the timer is 
running, the timer is restarted.

See also
Overview of the valid data types (Page 1077)

S_OFFDT:  Assign off-delay timer parameters and start

Description
The "Assign off-delay timer parameters and start" instruction starts a programmed timer when 
a transition from "1" to "0" (negative signal edge) is detected in the result of logic operation 
(RLO) at input S. The timer expires with the programmed duration (TV). As long as the timer 
is running or input S returns signal state "1", output Q has signal state "1". If the timer expires 
and the signal state is "0", output Q is reset to signal state "0". If the signal state at input S 
changes from "0" to "1" while the timer is running, the timer is stopped. The timer is only 
restarted after a falling signal edge is detected at input S.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

Signal state "1" at input R resets the current time value and time base to "0". In this case, the 
signal state at output Q is "0".

The "Assign off-delay timer parameters and start" instruction needs a preceding logic operation 
for the edge evaluation and can be placed within or at the end of the network.
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The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the "Assign off-delay timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign off-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "1" to "0". The 
timer expires with the value of operand "TagIn_Number". The "TagOut" operand is set to "1" 
if the timer is running or the "TagIn_1" operand has the signal state "0". If the signal state at 
the "TagIn_1" operand changes from "0" to "1" while the timer is running, the timer is reset.

See also
Overview of the valid data types (Page 1077)
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SP: Start pulse timer

Description
The instruction "Start pulse timer" starts a programmed timer when a change from "0" to "1" 
(positive signal edge) is detected in the result of logic operation (RLO) at the start input. The 
timer runs with the specified duration as long as the RLO has the signal state "1". As long as 
the timer is running, the query of timer status "1" returns the signal state "1". If there is a change 
from "1" to "0" in the RLO before the time value has elapsed, the timer stops. In this case, the 
query for timer status for "1" returns the signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.

The "Start pulse timer" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start pulse timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the time value of the "TagIn_Number" operand as long as the signal state 
of the "TagIn_1" operand is "1". If the signal state at the "TagIn_1" operand changes from "1" 
to "0" before the timer expires, the timer is stopped. As long as the timer is running, the "TagOut" 
operand returns signal state "1". If the signal state of the "TagIn_1" operand changes from "0" 
to "1", the timer is reset, i.e. the timer is stopped and the current time value is set to "0".

See also
Overview of the valid data types (Page 1077)

SE: Start extended pulse timer

Description
The "Start extended pulse timer" instruction starts a programmed timer when a change from 
"0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) at the start 
input. The timer runs for the specified time period even when the RLO changes to signal state 
"0". As long as the timer is running, the query of timer status "1" returns the signal state "1". If 
the RLO changes from "0" to "1" while the timer is running, the timer is restarted with the 
programmed time period. When the timer expires, the query for timer status for "1" returns the 
signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.
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The "Start extended pulse timer" instruction needs a preceding logic operation for the edge 
evaluation and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start extended pulse timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the time value of the "TagIn_Number" operand without being affected by a 
negative edge at the RLO. As long as the timer is running, the "TagOut" operand returns signal 
state "1". If the signal state at the "TagIn_1" operand changes from "0" to "1" before the timer 
expires, the timer is restarted.

See also
Overview of the valid data types (Page 1077)

SD: Start on-delay timer

Description
The "Start on-delay timer" instruction starts a programmed timer when a change from "0" to 
"1" (positive signal edge) is detected in the result of logic operation (RLO) at the start input. 
The timer runs for the specified period of time as long as the RLO is "1". If the timer expires 
and the RLO has the signal state "1", the query timer status "1" returns the signal state "1". If 
the RLO changes from "1" to "0" while the timer is running, the timer is stopped. In this case, 
querying the timer status for "1" returns the signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.
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The "Start on-delay timer" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start on-delay timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the value of operand "TagIn_Number". If the timer expires and the RLO has 
the signal state "1", the "TagOut" operand is set to "1". If the signal state at the "TagIn_1" 
operand changes from "1" to "0" before the timer expires, the timer is stopped. If the signal 
state of the "TagIn_2" operand changes to "1", "Timer_1" is reset, i.e. the timer is stopped and 
the current time value is set to "0".

See also
Overview of the valid data types (Page 1077)

SS: Start retentive on-delay timer

Description
The "Start retentive on-delay timer" instruction starts a programmed timer when a change from 
"0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) at the start 
input. The timer runs for the specified time period even when the RLO changes to signal state 
"0". When the timer expires, the query for timer status for "1" returns the signal state "1". When 
the timer expires, the timer can only be restarted if it is explicitly reset.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.
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The "Start retentive on-delay timer" instruction needs a preceding logic operation for the edge 
evaluation and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start retentive on-delay timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1899



Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the value of operand "TagIn_Number". When the time expires, the "TagOut" 
operand is reset to "1". If the signal state at the "TagIn_1" operand changes from "0" to "1" 
while the timer is running, the timer is restarted. If the signal state of the "TagIn_2" operand 
changes to "1", "Timer_1" is reset, i.e. the timer is stopped and the current time value is set to 
"0".

See also
Overview of the valid data types (Page 1077)

SF: Start off-delay timer

Description
The "Start off-delay timer" instruction starts a programmed timer when a change from "1" to 
"0" (negative signal edge) is detected in the result of logic operation (RLO) at the start input. 
The timer runs for the specified time period. As long as the timer is running, the query of timer 
status "1" returns the signal state "1". If the RLO changes from "0" to "1" while the timer is 
running, the timer is reset. The timer is always restarted when the RLO changes from "1" to 
"0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.
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The "Start off-delay timer" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start off-delay timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "1" to "0". The 
timer expires with the value of operand "TagIn_Number".  As long as the timer is running, the 
"TagOut" operand is set to "1". If the signal state at the "TagIn_1" operand changes from "1" 
to "0" while the timer is running, the timer is restarted. If the signal state of the "TagIn_2" 
operand changes to "1", "Timer_1" is reset, i.e. the timer is stopped and the current time value 
is set to "0".

See also
Overview of the valid data types (Page 1077)

Counter operations

IEC Counters

CTU: Count up

Description
You can use the "Count up" instruction to increment the value at output CV. When the signal 
state at the CU input changes from "0" to "1" (positive signal edge), the instruction is executed 
and the current counter value at the CV output is incremented by one. When the instruction 
executes for the first time, the current counter value at the CV output is set to zero. The counter 
is incremented each time a positive signal edge is detected, until it reaches the high limit for 
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the specified data type at output CV. When the high limit is reached, the signal state at the CU 
input no longer has an effect on the instruction.

You can scan the counter status at the Q output. The signal state at the Q output is determined 
by the PV parameter. If the current counter value is greater than or equal to the value of the 
PV parameter, the Q output is set to signal state "1". In all other cases, the Q output has signal 
state "0". You can also specify a constant for the PV parameter.

The value at the CV output is reset to "0" and saved to an edge memory bit when the signal 
state at input R changes to "1". As long as the R input has signal state "1", the signal state at 
the CU input has no effect on the instruction.

 

 Note

Avoid using a counter at more than one point in the program (risk of counting errors).
 

Each call of the "Count up" instruction must be assigned to an IEC Counter in which the 
instruction data is stored. An IEC Counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● CTU_LINT / CTU_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC Counter as follows:
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● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTU or IEC_COUNTER in the "Static" section of a 
block (for example, #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, it is 
saved to the "Program resources" folder in the "Program blocks > System blocks" path of the 
project tree. For additional information on this topic, refer to "See also".

The execution of the "Count up" instruction requires a preceding logic operation. It can be 
placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Count up" instruction:

Parameters Declaration Data type Memory area Description
CU Input BOOL I, Q, M, D, L or 

constant
Count input

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

PV Input Integers I, Q, M, D, L, P or 
constant

Value at which the 
output Q is set.

Q Output BOOL I, Q, M, D, L Counter status
CV Output Integers, CHAR, 

DATE
I, Q, M, D, L, P Current counter 

value 

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1", the "Count up" 
instruction executes and the current counter value of the "Tag_CV" operand is incremented 
by one. With each additional positive signal edge, the counter value is incremented until the 
high limit of the specified data type (INT = 32767) is reached.
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The value of the PV parameter is adopted as the limit for determining the "TagOut" output. 
The "TagOut" output has signal state "1" as long as the current counter value is greater than 
or equal to the value of the "Tag_PV" operand. In all other cases, the "TagOut" output returns 
the signal state "0".

See also
Overview of the valid data types (Page 1077)

CTD: Count down

Description
You can use the "Count down" instruction to decrement the value at output CV. When the 
signal state at the CD input changes from "0" to "1" (positive signal edge), the instruction is 
executed and the current counter value at the CV output is decremented by one. When the 
instruction executes the first time, the counter value of the CV parameter will be set to the 
value of the PV parameter. Each time a positive signal edge is detected, the counter value is 
decremented until it reaches the low limit value of the specified data type. When the low limit 
is reached, the signal state at the CD input no longer has an effect on the instruction.

You can scan the counter status at the Q output. If the current counter value is less than or 
equal to "0", the Q output is set to signal state "1". In all other cases, the Q output has signal 
state "0". You can also specify a constant for the PV parameter.

The value at the CV output is set to the value of the PV parameter and saved to a edge memory 
bit when the signal state at the LD input changes from "0" to "1". As long as the LD input has 
signal state "1", the signal state at the CD input has no effect on the instruction.

 

 Note

Avoid using a counter at more than one point in the program (risk of counting errors).
 

Each call of the "Count down" instruction must be assigned to an IEC Counter in which the 
instruction data is stored. An IEC Counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
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For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● CTD_LINT / CTD_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC Counter as follows:

● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTD or IEC_COUNTER in the "Static" section of a 
block (for example, #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, it is 
saved to the "Program resources" folder in the "Program blocks > System blocks" path of the 
project tree. For additional information on this topic, refer to "See also".

The execution of the "Count down" instruction requires a preceding logic operation. It can be 
placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Count down" instruction:

Parameters Declaration Data type Memory area Description
CD Input BOOL I, Q, M, D, L or 

constant
Count input

LD Input BOOL I, Q, M, T, C, D, L, 
P or constant

Load input

PV Input Integers I, Q, M, D, L, P or 
constant

Value at which the 
output Q is set.

Q Output BOOL I, Q, M, D, L Counter status
CV Output Integers, CHAR, 

DATE
I, Q, M, D, L, P Current counter 

value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1", the "Count down" 
instruction executes and the value at the "Tag_CV" output is decremented by one. With each 
additional positive signal edge, the counter value is decremented until the low limit of the 
specified data type (INT = -32768) is reached.

The value of the PV parameter is adopted as the limit for determining the "TagOut" output. 
The "TagOut" output has signal state "1" as long as the current counter value is less than or 
equal to "0". In all other cases, the "TagOut" output returns the signal state "0".

See also
Overview of the valid data types (Page 1077)

CTUD: Count up and down

Description
You can use the "Count up and down" instruction to increment and decrement the counter 
value at the CV output. If the signal state at the CU input changes from "0" to "1" (positive 
signal edge), the current counter value is incremented by one and stored at the CV output. If 
the signal state at the CD input changes from "0" to "1" (positive signal edge), the current 
counter value at the CV output is decremented by one. If there is a positive signal edge at the 
CU and CD inputs in one program cycle, the current counter value at the CV output remains 
unchanged.

The counter can be incremented until it reaches the high limit value of the data type specified 
at output CV. When the high limit value is reached, the counter value is no longer incremented 
on a positive signal edge. When the low limit value of the specified data type is reached, the 
counter value is not decremented any further.

When the signal state at the LD input changes to "1", the counter value at the CV output is set 
to the value of the PV parameter and stored in a edge memory bit. As long as the LD input 
has signal state "1", the signal state at the CU and CD inputs has no effect on the instruction.

The counter value is set to "0" and stored in an edge memory bit when the signal state at input 
R changes to "1". As long as the R input has signal state "1", a change in the signal state of 
the CU, CD and LD inputs has no effect on the "Count up and down" instruction.

You can scan the current status of the up counter at the QU output. If the current counter value 
is greater than or equal to the value of the PV parameter, the QU output is set to signal state 
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"1". In all other cases, the QU output has signal state "0". You can also specify a constant for 
the PV parameter.

You can scan the current status of the down counter at the QD output. If the current counter 
value is less than or equal to zero, the QD output is set to signal state "1". In all other cases, 
the QD output has signal state "0".

 

 Note

Avoid using a counter at more than one point in the program (risk of counting errors).
 

Each call of the "Count up and down" instruction must be assigned an IEC Counter in which 
the instruction data is stored. An IEC Counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● CTUD_LINT / CTUD_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC Counter as follows:

● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTUD or IEC_COUNTER in the "Static" section of a 
block (for example, #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Counter is stored in its own data block (single instance) or as a 
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local tag (multiple instance) in the block interface. If you create a separate data block, it is 
saved to the "Program resources" folder in the "Program blocks > System blocks" path of the 
project tree. For additional information on this topic, refer to "See also".

The execution of the "Count up and down" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Count up and down" instruction:

Parameters Declaration Data type Memory area Description
CU Input BOOL I, Q, M, D, L or 

constant
Count up input

CD Input BOOL I, Q, M, D, L or 
constant

Count down input

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

LD Input BOOL I, Q, M, T, C, D, L, 
P or constant

Load input

PV Input Integers I, Q, M, D, L, P or 
constant

Value at which the 
output QU is set.

QU Output BOOL I, Q, M, D, L Up-counter status
QD Output BOOL I, Q, M, D, L Down-counter 

status
CV Output Integers, CHAR, 

DATE
I, Q, M, D, L, P Current counter 

value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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If the signal state at the "TagIn_CU" or "TagIn_CD" input changes from "0" to "1" (positive 
signal edge), the "Count up and down" instruction is executed. When there is a positive signal 
edge at the "TagIn_CU" input, the current counter value is incremented by one and stored at 
the "Tag_CV" output. When there is a positive signal edge at the "TagIn_CD" input, the counter 
value is decremented by one and stored at the "Tag_CV" output. When there is a positive edge 
at the CU input, the counter value is incremented until it reaches the high limit value (INT = 
32767). If input CD has a positive signal edge, the counter value is decremented until it reaches 
the low limit value (INT = -32768).

The "TagOut_GU" output has signal state "1" as long as the current counter value is greater 
than or equal to the value at the "Tag_PV" input. In all other cases, the "TagOut_QU" output 
returns the signal state "0".

The "TagOut_QD" output has signal state "1" as long as the current counter value is less than 
or equal to "0". In all other cases, the "TagOut_QD" output has signal state "0".

See also
Overview of the valid data types (Page 1077)

Example of detecting the fill level of a storage area  (Page 1561)

SIMATIC counters

S_CUD: Assign parameters and count up / down

Description     
You can use the "Assign parameters and count up / down" instruction to increment or 
decrement the value of a counter. If the signal state at the CU input changes from "0" to "1" 
(positive signal edge), the current counter value is incremented by one. If the signal state at 
the CD input changes from "0" to "1" (positive signal edge), the counter value is decremented 
by one. The current counter value is output as a hexadecimal value at output CV and BCD-
coded at output CV_BCD. If there is a positive signal edge at the CU and CD inputs in one 
program cycle, the counter value remains unchanged.

The counter value is incremented until the high limit of "999" is reached. When the high limit 
value is reached, the counter value is no longer incremented on a positive signal edge. When 
the low limit of "0" is reached, the counter value is no longer decremented.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO is "1" at the inputs CU and CD, the counter 
counts accordingly in the next scan cycle, even if no change in the signal edge is detected.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CU, CD and S 
inputs has no effect on the counter value.
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The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Avoid using a counter at more than one point in the program (risk of counting errors).
 

The "Assign parameters and count up / down" instruction needs a preceding logic operation 
for the edge evaluation and can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Assign parameters and count up / down" 
instruction:

Parameters Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CU Input BOOL I, Q, M, D, L, T, C Count up input
CD Input BOOL I, Q, M, D, L, T, C 

or constant
Count down input

S Input BOOL I, Q, M, D, L, T, C 
or constant

Input for 
presetting counter

PV Input WORD I, Q, M, D, L, C or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If the signal state at the "TagIn_1" or "TagIn_2" input changes from "0" to "1" (positive signal 
edge), the "Assign parameters and count up / down" instruction is executed. When there is a 
positive signal edge at the "TagIn_1" input and the current counter value is less than "999", 
the counter value is incremented by one. When there is a positive signal edge at the "TagIn_2" 
input and the current counter value is greater than "0", the counter value is decremented by 
one.

When the signal state at the "TagIn_3" input changes from "0" to "1", the counter value is set 
to the value of the "TagPresetValue" operand. The counter value is reset to "0" when the 
"TagIn_4" operand has signal state "1".

The current counter value is hexadecimal in the "TagValue_1" operand and BCD-coded in the 
"TagValue_2" operand.

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1077)

S_CU: Assign parameters and count up

Description     
You can use the "Assign parameters and count up" instruction to increment the value of a 
counter. If the signal state at the CU input changes from "0" to "1" (positive signal edge), the 
current counter value is incremented by one. The current counter value is output as a 
hexadecimal value at output CV and BCD-coded at output CV_BCD. The count is incremented 
until the limit of "999" is reached. When the limit is reached, the counter value is no longer 
incremented on a positive signal edge.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO at input CU is "1", the counter will count 
accordingly in the next scan cycle, even when no change has been detected in the signal edge.
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The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CU and S inputs 
has no effect on the counter value.

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Avoid using a counter at more than one point in the program (risk of counting errors).
 

The "Assign parameters and count up" instruction needs a preceding logic operation for the 
edge evaluation and can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Assign parameters and count up" instruction:

Parameters Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CU Input BOOL I, Q, M, D, L, T, C Count up input
S Input BOOL I, Q, M, D, L, T, C 

or constant
Input for 
presetting counter

PV Input WORD I, Q, M, D, L, C or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

When the signal state at the "TagIn_1" input changes from "0" to "1" (positive signal edge) and 
the current counter value is less than "999", the counter value is incremented by one. When 
the signal state at the "TagIn_2" input changes from "0" to "1", the counter value is set to the 
value of the "TagPresetValue" operand. The counter value is reset to "0" when the "TagIn_3" 
operand has signal state "1".

The current counter value is hexadecimal in the "TagValue_1" operand and BCD-coded in the 
"TagValue_2" operand.

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1077)

S_CD: Assign parameters and count down

Description     
You can use the "Assign parameters and count down" instruction to decrement the value of a 
counter. If the signal state at the CD input changes from "0" to "1" (positive signal edge), the 
counter value is decremented by one. The current counter value is output as a hexadecimal 
value at output CV and BCD-coded at output CV_BCD. The count is decremented until the 
low limit of "0" is reached. When the low limit is reached, the counter value is no longer 
decremented on a positive signal edge.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO at input CD is "1", the counter will count 
accordingly in the next scan cycle, even when no change has been detected in the signal edge.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CD and S inputs 
has no effect on the counter value.
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The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Avoid using a counter at more than one point in the program (risk of counting errors).
 

The "Assign parameters and count down" instruction needs a preceding logic operation for the 
edge evaluation and can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Assign parameters and count down" 
instruction:

Parameters Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CD Input BOOL I, Q, M, D, L or 
constant

Count down input

S Input BOOL I, Q, M, D, L, T, C 
or constant

Input for 
presetting counter

PV Input WORD I, Q, M, D, L, C or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

When the signal state at the "TagIn_1" input changes from "0" to "1" (positive signal edge) and 
the current counter value is greater than "0", the counter value is decremented by one. When 
the signal state at the "TagIn_2" input changes from "0" to "1", the counter value is set to the 
value of the "TagPresetValue" operand. The counter value is reset to "0" when the "TagIn_3" 
operand has signal state "1".

The current counter value is hexadecimal in the "TagValue_1" operand and BCD-coded in the 
"TagValue_2" operand.

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1077)

SC: Set counter value

Description
You can use the "Set counter value" instruction to increment the value of a counter. The 
instruction is executed when the result of logic operation (RLO) at the start input of the 
instruction changes from "0" to "1". If the instruction is executed, the counter is set to the 
specified counter value.

The "Set counter value" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.
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Parameters
 The following table shows the parameters of the "Set counter value" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L Start input
PV Input WORD I, Q, M, D, L or 

constant
Value with which 
the counter is 
preset in the BCD 
format.
(C#0 to C#999)

<Counter> InOut/Input COUNTER C Counter which is 
preset.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

"Counter_1" starts with the value "100" when the signal state of the "TagIn" operand changes 
from "0" to "1".

See also
Overview of the valid data types (Page 1077)

CU: Count up

Description
You use the "Count up" instruction to increment the value of the specified counter by the count 
of one on a rising edge at the start input. The count is incremented until the limit of "999" is 
reached. When the limit is reached, the counter value is no longer incremented on a positive 
signal edge.

The "Count up" instruction needs a preceding logic operation for the edge evaluation and can 
only be placed on the right edge of the network.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1917



Parameters
The following table shows the parameters of the "Count up" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L Start input
<Counter> InOut/Input COUNTER C Counter whose 

value is 
incremented.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the operand "TagIn_1" changes from "0" to "1" (positive signal edge), 
the counter "Counter_1" is preset with the value "100".

The value of "Counter_1" is incremented by the count of one when the signal state of the 
"TagIn_2" operand changes from "0" to "1". 

If the "TagIn_3" operand returns signal state "1", the value of "Counter_1" is reset to "0".

See also
Overview of the valid data types (Page 1077)
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CD: Count down

Description
You use the "Count down" instruction to decrement the value of the specified counter by the 
count of one on a rising edge at the start input. The count is decremented until the limit of "0" 
is reached. When the limit is reached, the counter value is no longer changed on a positive 
signal edge.

The "Count down" instruction needs a preceding logic operation for the edge evaluation and 
can only be placed on the right edge of the network.

Parameters
The following table shows the parameters of the "Count down" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L Start input
<Counter> InOut/Input COUNTER C Counter whose 

value is 
decremented.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the operand "TagIn_1" changes from "0" to "1" (positive signal edge), 
the counter "Counter_1" is preset with the value "100".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1919



The value of "Counter_1" is incremented by the count of one when the signal state of the 
"TagIn_2" operand changes from "0" to "1". 

If the "TagIn_3" operand returns signal state "1", the value of "Counter_1" is reset to "0".

See also
Overview of the valid data types (Page 1077)

Comparator operations

CMP ==: Equal

Description
You can use the "Equal" instruction to query whether the value at input IN1  is equal to the 
value at input IN2.

If the condition of the comparison is satisfied, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character to be different decides the result of the comparison.

The following table shows examples of string comparisons:

IN1 IN2 RLO of the instruction
'AA' 'AA' 1
'Hello World' 'HelloWorld' 0
'AA' 'aa' 0

The "Equal" instruction also compares individual characters of a string (STRING). The number 
of the character to be compared is specified in square brackets beside the operand name. 
"MyString[2]", for example, compares the second character of the "MyString" string.

If IEC check is enabled, the operands to be compared must be of the same data type. If IEC 
check is not enabled, the width (length) of the operands must be the same. If the floating-point 
numbers are being compared, the operands to be compared must be of the same data type 
regardless of the IEC check setting.

 

 Note
Comparison of floating-point numbers

If you want to compare the data types REAL or LREAL, instead of the instruction "CMP ==: 
Equal", use the instruction "IN_RANGE: Value within range".
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Parameters
The following table shows the parameters of the instruction "Equal":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

IN2 Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled ("Tag_Value1" = "Tag_Value2").

See also
Overview of the valid data types (Page 1077)
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CMP <>: Not equal

Description     
You can use the "Not equal" instruction to query whether the value at input IN1  is not equal 
to the value at input IN2.

If the condition of the comparison is satisfied, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character to be different decides the result of the comparison.

The following table shows examples of string comparisons:

IN1 IN2 RLO of the instruction
'AA' 'aa' 1
'Hello World' 'HelloWorld' 1
'AA' 'AA' 0

The "Not equal" instruction also compares individual characters of a string STRING). The 
number of the character to be compared is specified in square brackets beside the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

If IEC check is enabled, the operands to be compared must be of the same data type. If IEC 
check is not enabled, the width (length) of the operands must be the same. If the floating-point 
numbers are being compared, the operands to be compared must be of the same data type 
regardless of the IEC check setting.
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Parameters
The following table shows the parameters of the instruction "Not equal":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First value to 
compare

IN2 Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled ("Tag_Value1" <> "Tag_Value2").

See also
Overview of the valid data types (Page 1077)
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CMP >=: Greater or equal

Description     
You can use the "Greater or equal" instruction to query whether the value at input IN1  is greater 
or equal to the value at input IN2. Both values to be compared must be of the same data type.

If the condition of the comparison is satisfied, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character to be different decides the result of the comparison. If the left part 
of the longer string is identical to the shorter string, the longer string is considered greater.

The following table shows examples of string comparisons:

IN1 IN2 RLO of the instruction
'BB' 'AA' 1
'AAA' 'AA' 1
'Hello World' 'Hello World' 1
'Hello World' 'HelloWorld' 0
'AA' 'aa' 0
'AAA' 'a' 0

The "Greater or equal" instruction also compares individual characters of a string (STRING). 
The number of the character to be compared is specified in square brackets beside the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

In comparing timer values, the RLO of the instruction is "1" if the timer at input  IN1 is greater 
(more recent) than or equal to the timer at input IN2.
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Parameters
The following table shows the parameters of the instruction "Greater or equal":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First value to 
compare

IN2 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled ("Tag_Value1" >= "Tag_Value2").

See also
Overview of the valid data types (Page 1077)

Example of detecting the fill level of a storage area  (Page 1561)
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CMP <=: Less or equal

Description     
You can use the "Less or equal" instruction to query whether the value at input IN1  is less or 
equal to the value at input IN2. Both values to be compared must be of the same data type.

If the condition of the comparison is satisfied, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character to be different decides the result of the comparison. If the left part 
of the longer string is identical to the shorter string, the shorter string is considered smaller. 

The following table shows examples of string comparisons:

IN1 IN2 RLO of the instruction
'AA' 'aa' 1
'AAA' 'a' 1
'Hello World' 'Hello World' 1
'HelloWorld' 'Hello World' 0
'BB' 'AA' 0
'AAA' 'AA' 0

The "Less or equal" instruction also compares individual characters of a string (STRING). The 
number of the character to be compared is specified in square brackets beside the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

In comparing timer values, the RLO of the instruction is "1" if the timer at input IN1 is smaller 
(less recent) than or equal to the timer at input IN2.
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Parameters
The following table shows the parameters of the instruction "Less or equal":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First value to 
compare

IN2 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled ("Tag_Value1" <= "Tag_Value2").

See also
Overview of the valid data types (Page 1077)
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CMP >: Greater than

Description     
You can use the "Greater than" instruction to query whether the value at input IN1  is greater 
than the value at input IN2. Both values to be compared must be of the same data type.

If the condition of the comparison is satisfied, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character to be different decides the result of the comparison. If the left part 
of the longer string is identical to the shorter string, the longer string is considered greater.

The following table shows examples of string comparisons:

IN1 IN2 RLO of the instruction
'BB' 'AA' 1
'AAA' 'AA' 1
'AA' 'aa' 0
'AAA' 'a' 0

The "Greater than" instruction also compares individual characters of a string (STRING). The 
number of the character to be compared is specified in square brackets beside the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

In comparing timer values, the RLO of the instruction is "1" if the timer at input IN1 is greater 
(more recent) than the timer at input IN2.

Parameters
The following table shows the parameters of the instruction "Greater than":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First value to 
compare

IN2 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare
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You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled ("Tag_Value1" > "Tag_Value2").

See also
Overview of the valid data types (Page 1077)

CMP <: Less than

Description     
You can use the "Less than" instruction to query whether the value at input IN1  is less than 
the value at input IN2. Both values to be compared must be of the same data type.

If the condition of the comparison is satisfied, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their ASCII code (for example, 'a' is 
greater than 'A') during the comparison of the strings. The comparison is performed from left 
to right. The first character to be different decides the result of the comparison. If the left part 
of the longer string is identical to the shorter string, the shorter string is considered smaller.

The following table shows examples of string comparisons:

<Operand1> <Operand2> RLO of the instruction
'AA' 'aa' 1
'AAA' 'a' 1
'BB' 'AA' 0
'AAA' 'AA' 0

The "Less than" instruction also compares individual characters of a string (STRING). The 
number of the character to be compared is specified in square brackets beside the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.
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In comparing timer values, the RLO of the instruction is "1" if the timer at input IN1 is less (less 
recent) than the timer at input IN2 .

Parameters
The following table shows the parameters of the instruction "Less than":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First value to 
compare

IN2 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled ("Tag_Value1" < "Tag_Value2").

See also
Overview of the valid data types (Page 1077)

Example of detecting the fill level of a storage area  (Page 1561)
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IN_RANGE: Value within range

Description     
You can use the "Value within range" instruction to query whether of the value at input VAL is 
within a specific value range.

You specify the limits of the value range with the MIN and MAX inputs. The "Value within range" 
instruction compares the value at input VAL with the values of the inputs MIN and MAX and 
sends the result to the box output. If the value at input VAL satisfies the comparison MIN <= 
VAL or VAL <=MAX, the box output has the signal state "1". If the comparison is not fulfilled, 
the signal state is "0" at the box output.

The comparison function can only execute if the values to be compared are of the same data 
type.

Parameters
The following table shows the parameters of the "Value within range" instruction:

Parameters Declaration Data type Memory area Description
MIN Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VAL Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Comparison value

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

Box output Output BOOL I, Q, M, D, L Result of the 
comparison

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:
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● The operands "TagIn_1" or "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "1".

● The value of the operand "Tag_Value" is within the value range that is specified by the 
current values of the operands "Tag_Min" and "Tag_Max" (MIN <= VAL or VAL <= MAX).

See also
Overview of the valid data types (Page 1077)

OUT_RANGE: Value outside range

Description     
You can use the "Value outside range" instruction to query whether of the value at input VAL 
is outside a specific value range.

You specify the limits of the value range with the MIN and MAX inputs. The "Value outside 
range" instruction compares the value at input VAL with the values of the inputs MIN and MAX  
and sends the result to the box output. If the value at input VAL satisfies the comparison MIN 
> VAL or VAL >MAX, the box output has the signal state "1". The box output has the signal 
state "1" if a specified operand of data type REAL has an invalid value.

The box output returns the signal state "0", if the value at input VAL does not satisfy the MIN 
> VAL or VAL > MAX  condition.

The comparison function can only execute if the values to be compared are of the same data 
type.

Parameters 
The following table shows the parameters of the "Value outside range" instruction:

Parameters Declaration Data type Memory area Description
MIN Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VAL Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Comparison value

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

Box output Output BOOL I, Q, M, D, L Result of the 
comparison

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "1".

● The value of the operand "Tag_Value" is outside the value range that is specified by the 
values of the operands "Tag_Min" and "Tag_Max" (MIN > VAL or VAL > MAX).

See also
Overview of the valid data types (Page 1077)

OK: Check validity

Description     
You can use the "Check validity" instruction to check if the value of an operand (<Operand>) 
is a valid floating-point number. The check is performed in every program cycle. If the operand 
value at the time of the query is a valid floating-point number, the output box will return the 
signal state"1". In all other cases, the signal state at the output of the "Check validity" instruction 
is "0".

You can use the "Check validity" instruction together with the EN mechanism. If you connect 
the instruction box to an EN enable input, the enable input is set only when the result of the 
validity query of the value is positive. You can use this function to ensure that an instruction is 
enabled only when the value of the specified operand is a valid floating-point number.

Parameters
The following example shows how the "Check validity" instruction works:

Parameters Declaration Data type Memory area Description
<Operand> Input Floating-point 

numbers
I, Q, M, D, L Value to be 

checked.

For additional information on valid data types, refer to "See also":
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Example
The following example shows how the instruction works:

When the values of the operands "Tag_Value1" and "Tag_Value2" show valid floating-point 
numbers, the "Multiply" (MUL) instruction is activated and the ENO output is set. During the 
execution of the "Multiply" (MUL) instruction, the value of the operand "Tag_Value1" is 
multiplied by the value of operand "Tag_Value2". The product of the multiplication is then stored 
in the operand "Tag_Result". If no errors occur during the execution of the instruction, the 
outputs ENO and "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

NOT_OK: Check invalidity

Description     
You can use the "Check invalidity" instruction to check if the value of an operand (<Operand>) 
is an invalid floating-point number. The check is performed in every program cycle. If the 
operand value at the time of the query is a valid floating-point number, then the output box will 
return the signal state "1". In all other cases, the signal state on the output box is "0".

Parameters
The following table shows the parameters of the instruction "Check invalidity":

Parameters Declaration Data type Memory area Description
<Operand> Input Floating-point 

numbers
I, Q, M, D, L Value to be 

checked.

For additional information on valid data types, refer to "See also":
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Example
The following example shows how the instruction works:

When the value of operand "TagIn_Value" is an invalid floating-point number, the instruction 
"Move value" (MOVE) is not executed. The "TagOut" output is reset to signal state "0".

See also
Overview of the valid data types (Page 1077)

Math functions

CALCULATE: Calculate

Description     
The "Calculate" instruction is used to define and execute an expression (formula) for the 
calculation of mathematical operations or complex logic operations depending on the selected 
data type.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box. Depending on the selected data type, you can combine the functionality of specific 
instructions to execute a complex calculation. The expression to be calculated is specified via 
a dialog you can open via the "Calculator" icon at the top of the instruction box. The expression 
can contain the names of the input parameters and the syntax of the instructions. It is not 
permitted to specify operand names or operand addresses. 

The following table shows the instructions that, depending on the selected data type, can be 
combined and executed in the expression of the "Calculate" instruction:

Data type Instruction Syntax Example
Bit strings AND: AND logic operation AND IN1 AND IN2 OR IN3

OR: OR logic operation OR
XOR: EXCLUSIVE OR logic operation XOR
INV: Create ones complement NOT
SWAP: Swap 1) SWAP

Integers ADD: Add + (IN1 + IN2) * IN3;
(ABS(IN2))*(ABS(IN1
))

SUB: Subtract -
MUL: Multiply *
DIV: Divide /
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Data type Instruction Syntax Example
MOD: Return remainder of division MOD
INV: Create ones complement NOT
NEG: Create twos complement -(in1)
ABS: Form absolute value ABS( )

Floating-point numbers ADD: Add + ((SIN(IN2)*SIN(IN2)+ 
(SIN(IN3)*SIN(IN3))/
IN3;
(SQR(SIN(IN2))+
(SQR(COS(IN3))/IN2

SUB: Subtract -
MUL: Multiply *
DIV: Divide /
EXPT: Exponentiate **
ABS: Form absolute value ABS( )
SQR: Form square SQR( )
SQRT: Form square root SQRT( )
LN: Form natural logarithm LN( )
EXP: Form exponential value EXP( )
FRAC: Return fraction FRAC( )
SIN: Form sine value SIN( )
COS: Form cosine value COS( )
TAN: Form tangent value TAN( )
ASIN: Form arcsine value ASIN( )
ACOS: Form arccosine value ACOS( )
ATAN: Form arctangent value ATAN( )
NEG: Create twos complement -(in1)
TRUNC: Truncate numerical value TRUNC( )
ROUND: Round numerical value ROUND( )
CEIL: Generate next higher integer from floating-
point number

CEIL( )

FLOOR: Generate next lower integer from floating-
point number

FLOOR( )

1) Not possible for data type BYTE.

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box.

The values of the inputs are use to execute the specified expression. Not all defined inputs 
have to be used in the expression. The result of the instruction is transferred to the box output 
OUT.

If, in the expression, you use inputs that are not available in the box, these inputs are 
automatically inserted. Provided that there are no gaps in the numbering of the inputs that are 
to be newly defined in the expression.  You cannot, for example, use the input IN4 in the 
expression if the input IN3 is not defined.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result or an interim result of the "Calculate" instruction is outside the range permitted 
for the data type specified at output OUT.
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● A floating-point number has an invalid value.

● An error occurred during the execution of one of the instructions specified in the expression.

Parameters
The following table shows the parameters of the instruction "Calculate":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Bit strings, 

integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

First available 
input

IN2 Input Bit strings, 
integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second 
available input

INn Input Bit strings, 
integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Additionally 
inserted inputs

OUT Output Bit strings, 
integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Output to 
which the end 
result is to be 
transferred.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN1 Tag_Value_1 4
IN2 Tag_Value_2 4
IN3 Tag_Value_3 3
IN4 Tag_Value_4 2
OUT Tag_Result 12

The "Calculate" instruction is executed when input "Tag_Input" has the signal state "1". The 
value of operand "Tag_Value_1" is added to the value of operand "Tag_Value_2". The sum is 
multiplied with the value of the operand "Tag_Value_3". The product is divided by the value of 
the operand "Tag_Value_4". The quotient is transferred as end result to the operand 
"Tag_Result" at the OUT output of the instruction. If no errors occur during the execution of 
the individual instructions, output ENO and the operand "Tag_Output" are set to "1".

See also
Overview of the valid data types (Page 1077)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Basics of the EN/ENO mechanism (Page 1167)

ADD: Add

Description     
You can use the "Add" instruction to add the value at input  IN1 to the value at input IN2 and 
query the sum at output  OUT (OUT := IN1+IN2).

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box. 
During the execution of the instruction, the values of all available input parameters are added. 
The sum is stored at output OUT.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at 
output OUT.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the instruction "Add":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

First number to 
be added

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second 
number to be 
added

INn Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values, which 
are added.

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Sum

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Add" instruction is executed. The value of 
operand "Tag_Value1" is added to the value of operand "Tag_Value2". The result of the 
addition is stored in the operand "Tag_Result". If the instruction is executed without errors, the 
ENO enable output has the signal state "1" and the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1077)

Removing instruction inputs and outputs (Page 1330)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1315)

Adding additional inputs and outputs to FBD elements (Page 1329)

SUB: Subtract

Description     
You can use the "Subtract" instruction to subtract the value at input  IN2 from the value at input 
IN1 and query the difference at output  OUT (OUT := IN1-IN2).

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at 
output OUT.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Subtract":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Minuend

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Subtrahend

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Difference

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Subtract" instruction is executed. The value 
of operand "Tag_Value2" is subtracted from the value of operand "Tag_Value1". The result of 
the subtraction is stored in the operand "Tag_Result". If the instruction is executed without 
errors, the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1315)

MUL: Multiply

Description     
You can use the "Multiply" instruction to multiply the value at input  IN1 with the value at input 
IN2 and query the total at output  OUT (OUT := IN1*IN2).

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box. When 
the instruction is executed, the values of all available input parameters are multiplied. The 
product is stored at the OUT output.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result is outside the range permitted for the data type specified at output OUT.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the instruction "Multiply":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

First value for 
multiplication

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second value 
for 
multiplication

INn Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values, which 
are multiplied.

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Product

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Multiply" instruction is executed. The value 
of operand "Tag_Value1" is multiplied with the value of operand "Tag_Value2". The result of 
the multiplication is stored in the operand "Tag_Result". If the instruction is executed without 
errors, the ENO enable output has the signal state "1" and the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1077)

Removing instruction inputs and outputs (Page 1330)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1315)

Adding additional inputs and outputs to FBD elements (Page 1329)

DIV: Divide

Description     
You can use the "Divide" instruction to divide the value at input  IN1 by the value at input IN2 
and query the quotient at output  OUT (OUT := IN1/IN2).

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at 
output OUT.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Divide":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Dividend

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Divisor

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Quotient value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1943



Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Divide" instruction is executed. The value 
of operand "Tag_Value1" is divided by the value of operand "Tag_Value2". The result of the 
division is stored in the operand "Tag_Result". If the instruction is executed without errors, the 
ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1315)

MOD: Return remainder of division

Description     
You can use the "Return remainder of division" instruction to divide the value at input  IN1 by 
the value at input IN2 and query the quotient at output  OUT.

Parameters
The following table shows the parameters of the instruction "Return remainder of division":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

Dividend

IN2 Input Integers I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Divisor

OUT Output Integers I, Q, M, D, L, P I, Q, M, D, L, P Remainder of 
division

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Return remainder of division" instruction 
is executed. The value of operand "Tag_Value1" is divided by the value of operand 
"Tag_Value2". The remainder of division is stored in operand "Tag_Result". If the instruction 
is executed without errors, the ENO enable output has the signal state "1" and the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Selecting a data type (Page 1315)

NEG: Create twos complement

Description       
You can use the "Create twos complement" instruction to change the sign of the value at input 
IN and query the result at output OUT. If there is a positive value at input IN, for example, the 
negative equivalent of this value is sent to output OUT.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at 
output OUT.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the "Create twos complement" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input SINT, INT, 
DINT, 
Floating-
point 
numbers

SINT, INT, 
DINT, LINT, 
Floating-
point 
numbers

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Input value

OUT Output SINT, INT, 
DINT, 
Floating-
point 
numbers

SINT, INT, 
DINT, LINT, 
Floating-
point 
numbers

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Twos 
complement 
of the input 
value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Create twos complement" instruction is 
executed. The sign of the value at input "TagIn_Value" is changed and the result is stored at 
output "TagOut_Value". If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)
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INC: Increment

Description     
You can use the "Increment" instruction to change the value of the operand at parameter IN/
OUT to the next higher value and query the result.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Increment" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN/OUT InOut Integers I, Q, M, D, L I, Q, M, D, L Value to be 

incremented.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operands TagIn_1 and TagIn_2 have the signal state "1", the value of the operand 
"Tag_InOut" is incremented by one and the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)
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DEC: Decrement

Description     
You can use the "Decrement" instruction to change the value of the operand at parameter IN/
OUT to the next lower value and query the result.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Decrement":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN/OUT InOut Integers I, Q, M, D, L I, Q, M, D, L Value to be 

decremented.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", the value of the operand 
"Tag_InOut" is decremented by one and the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)
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ABS: Form absolute value

Description         
You can use the "Form absolute value" instruction to calculate the absolute value of the value 
specified at input IN. The result of the instruction is provided at output OUT and can be queried 
there.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Form absolute value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input SINT, INT, 
DINT, 
floating-
point 
numbers

SINT, INT, 
DINT, LINT, 
floating-
point 
numbers

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Input value

OUT Output SINT, INT, 
DINT, 
floating-
point 
numbers

SINT, INT, 
DINT, LINT, 
floating-
point 
numbers

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Absolute 
value of the 
input value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN TagIn_Value -6.234
OUT TagOut_Value 6.234

If the operand "TagIn" has the signal state "1", the "Form absolute value" instruction is 
executed. The instruction calculates the absolute value of the value at input "TagIn_Value" 
and sends the result to output "TagOut_Value". If no errors occur during the execution of the 
instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)

MIN: Get minimum

Description
The "Get minimum" instruction compares the values at the available inputs and writes the 
lowest value to the OUT output. The number of inputs can be expanded at the instruction box 
by additional inputs. The inputs are numbered in ascending order in the box.

In its initial state the instruction contains at least two inputs (IN1 and IN2) and no more than 
100 inputs.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Get minimum" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN1 Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

First input 
value

IN2 Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Second 
input value

INn Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Additionally 
inserted 
inputs 
whose 
values are to 
be compared

OUT Output Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 TagIn_Value1 12222
IN2 TagIn_Value2 14444
IN3 TagIn_Value3 13333
OUT TagOut_Value 12222

If the "TagIn_1" and "TagIn_2" operands have signal state "1", the "Get minimum" instruction 
is executed. The instruction compares the values of the specified operands and copies the 
lowest value ("TagIn_Value1") to output "TagOut_Value". If no errors occur during the 
execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Removing instruction inputs and outputs (Page 1330)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)

MAX: Get maximum

Description
The "Get maximum" instruction compares the values at the available inputs and writes the 
highest value to the OUT output. The number of inputs can be expanded at the instruction box 
by additional inputs. The inputs are numbered in ascending order in the box.

In its initial state the instruction contains at least two inputs (IN1 and IN2) and no more than 
100 inputs.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the "Get maximum" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN1 Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

First input 
value

IN2 Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Second 
input value

INn Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Additionally 
inserted 
inputs 
whose 
values are to 
be 
compared.

OUT Output Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 TagIn_Value1 12222
IN2 TagIn_Value2 14444
IN3 TagIn_Value3 13333
OUT TagOut_Value 14444

If the "TagIn_1" and "TagIn_2" operands have signal state "1", the "Get maximum" instruction 
is executed. The instruction compares the values of the specified operands and copies the 
highest value ("TagIn_Value2") to output "TagOut_Value". If no errors occur during the 
execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Removing instruction inputs and outputs (Page 1330)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)

LIMIT: Set limit value

Description 
You use the "Set limit value" instruction to limit the value at input IN to the values at the inputs 
MN and MX. If the value at the IN input meets the MN condition <= IN <= MX, it is copied to 
the OUT output. If the condition is not fulfilled and the input value IN is below the low limit MN, 
output OUT is set to the value of the input MN. If the high limit MX is exceeded, output OUT 
is set to the value of the input MX.

If the value at input MN is greater than that at input MX, the result is undefined and the enable 
output ENO is "0".

Enable output ENO has the signal state "0" if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The specified tags are not of the same data type.

● An operand has an invalid value.

● The value at input MN is greater than the value at input MX.

Parameters
The following table shows the parameters of the "Set limit value" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

MN Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Low limit

IN Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Input value

MX Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

High limit

OUT Output Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MN Tag_MN 12000
IN Tag_Value 8000
MX Tag_MX 16000
OUT Tag_Result 12000

If the "TagIn_1" and "TagIn_2" operands have the signal state "1", the "Set limit value" 
instruction is executed. The value of operand "Tag_Value" is compared with the values of 
operands "Tag_MN" and "Tag_MX". Since the value at the operand "Tag_Value"  is less than 
the low limit, the value of the operand "Tag_MN" is copied to output "Tag_Result". If no errors 
occur during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)

SQR: Form square

Description     
You can use the "Form square" instruction to square the value at input IN and query the result 
at output OUT.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.
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Parameters
The following table shows the parameters of the instruction "Form square":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Square of the 
input value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 5.0
OUT Tag_Result 25.0

If the operand "TagIn" has the signal state "1", the "Form square" instruction is executed. The 
instruction squares the value of the operand "Tag_Value" and sends the result to output 
"Tag_Result". If no errors occur during the execution of the instruction, the output "TagOut" is 
set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)
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SQRT: Form square root

Description     
You can use the "Form square root" instruction to form the square root of the value at input IN 
and query the result at output OUT. The instruction has a positive result if the input value is 
greater than zero. If input values are less than zero, output OUT returns an invalid floating-
point number. If the value at input IN is "0", the result is also "0".

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

● The value at input IN is negative.

Parameters
The following table shows the parameters of the instruction "Form square root":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L I, Q, M, D, L Square root of 
the input value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN Tag_Value 25.0
OUT Tag_Result 5.0

If the operand "TagIn" has the signal state "1", the "Form square root" instruction is executed. 
The instruction calculates the square root of the operand "Tag_Value" and sends the result to 
output "Tag_Result". If no errors occur during the execution of the instruction, the output 
"TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

LN: Form natural logarithm

Description     
You can use the "Form natural logarithm" instruction to calculate the natural logarithm to base 
e (e = 2.718282) of the value at input IN. The result is sent to output OUT and can be queried 
there. The instruction has a positive result if the input value is greater than zero. If input values 
are less than zero, output OUT returns an invalid floating-point number.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

● The value at input IN is negative.

Parameters
The following table shows the parameters of the instruction "Form natural logarithm":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Natural 
logarithm of 
the input value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Form natural logarithm" instruction is 
executed. The instruction forms the natural logarithm of the value at input "Tag_Value" and 
sends the result to output "Tag_Result". If no errors occur during the execution of the 
instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

EXP: Form exponential value

Description     
You can use the "Form exponential value" instruction to calculate the exponent from the base 
e (e = 2.718282 and the value specified at input IN. The result is provided at output OUTand 
can be queried there  (OUT = eIN).

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form exponential value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Exponential 
value of the 
input value IN
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You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Form exponential value" instruction is 
executed. The instruction forms the exponent from base e and the value of the operand 
"Tag_Value" and sends the result to output "Tag_Result". If no errors occur during the 
execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SIN: Form sine value

Description     
You can use the "Form sine value" instruction to calculate the sine of an angle. The size of the 
angle is specified in the radian measure at input IN. The result of the instruction is provided at 
output OUT and can be queried there.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form sine value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  1961



Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input Floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Size of angle in 
the radian 
measure

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Sine of the 
specified angle

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value +1.570796 (π/2)
OUT Tag_Result 1.0

If the operand "TagIn" has the signal state "1", the "Form sine value" instruction is executed. 
The instruction calculates the sine of the angle specified at input "Tag_Value" and sends the 
result to output "Tag_Result". If no errors occur during the execution of the instruction, the 
output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

COS: Form cosine value

Description     
You can use the "Form cosine value" instruction to calculate the cosine of an angle. The size 
of the angle is specified in the radian measure at input IN. The result of the instruction is 
provided at output OUT and can be queried there.

Enable output ENO has the signal state "0" if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form cosine value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Size of angle in 
the radian 
measure

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Cosine of the 
specified angle

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value +1.570796 (π/2)
OUT Tag_Result 0

If the operand "TagIn" has the signal state "1", the "Form cosine value" instruction is executed. 
The instruction calculates the cosine of the angle specified at input "Tag_Value" and sends 
the result to output "Tag_Result". If no errors occur during the execution of the instruction, the 
output "TagOut" is set.
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

TAN: Form tangent value

Description     
You can use the "Form tangent value" instruction to calculate the tangent of an angle. The size 
of the angle is specified in the radian measure at input IN. The result of the instruction is 
provided at output OUT and can be queried there.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form tangent value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Size of angle in 
the radian 
measure

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Tangent of the 
specified angle

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN Tag_Value +3.141593 (π)
OUT Tag_Result 0

If the operand "TagIn" has the signal state "1", the "Form tangent value" instruction is executed. 
The instruction calculates the tangent of the angle specified at input "Tag_Value" and stores 
the result at output "Tag_Result". If no errors occur during the execution of the instruction, the 
output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ASIN: Form arcsine value

Description     
You can use the "Form arcsine value" instruction to calculate the size of the angle from the 
sine value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers within the range -1 to +1 can be specified at input IN. The calculated angle size is 
output in radians at output OUT and can range in value from -π/2 to +π/2.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

● The value at input IN is outside the permitted range (-1 to +1).

Parameters
The following table shows the parameters of the instruction "Form arcsine value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Sine value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Size of angle in 
the radian 
measure

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 1.0
OUT Tag_Result +1.570796 (π/2)

If the operand "TagIn" has the signal state "1", the "Form arcsine value" instruction is executed. 
The instruction calculates the size of the angle corresponding to the sine value at input 
"Tag_Value". The result of the instruction is stored at output "Tag_Result". If no errors occur 
during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ACOS: Form arccosine value

Description     
You can use the "Form arccosine value" instruction to calculate the size of the angle from the 
cosine value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers within the range -1 to +1 can be specified at input IN. The calculated angle size is 
output in radians at output OUT and can range in value from 0 to +π.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

● The value at input IN is outside the permitted range (-1 to +1).
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Parameters
The following table shows the parameters of the instruction "Form arccosine value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Cosine value 

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Size of angle in 
the radian 
measure

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 0
OUT Tag_Result +1.570796 (π/2)

If the operand "TagIn" has the signal state "1", the "Form arccosine value" instruction is 
executed. The instruction calculates the size of the angle corresponding to the cosine value 
at input "Tag_Value". The result of the instruction is stored at output "Tag_Result". If no errors 
occur during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)
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ATAN: Form arctangent value

Description     
You can use the "Form arctangent value" instruction to calculate the size of the angle from the 
tangent value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers may be specified at input IN. The calculated angle size is output in radians at the 
output OUT and can range in value from -π/2 to +π/2. 

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form arctangent value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Tangent value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Size of angle in 
the radian 
measure

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN Tag_Value 1.0
OUT Tag_Result +0.785398 (π/4)

If the operand "TagIn" has the signal state "1", the "Form arctangent value" instruction is 
executed. The instruction calculates the size of the angle corresponding to the tangent value 
at input "Tag_Value". The result of the instruction is stored at output "Tag_Result". If no errors 
occur during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

FRAC: Return fraction

Description     
You can use the "Return fraction" instruction to determine the decimal places of the value at 
the IN input. The result of the query is stored at output OUT and can be queried there. If the 
input IN has e.g. the value 123.4567, the output  OUT has the value 0.4567.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors occur during the execution of the instruction, for example there is no valid floating-
point number at the input.

Parameters
The following table shows the parameters of the "Return fraction" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value, 
whose decimal 
places are to 
be determined.

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Decimal 
places of the 
input value at 
input IN

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 2.555
OUT Tag_Result 0.555

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Return fraction" instruction 
is executed. The decimal places from the value at the operand "Tag_Value" are copied to the 
operand "Tag_Result". If the instruction is executed without errors, the ENO enable output has 
the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)

EXPT: Exponentiate

Description     
You can use the "Exponentiate" instruction to raise the value at the input IN1 by a power 
specified with the value at input IN2. The result of the instruction is stored at output OUT and 
can be queried there (OUT = IN1IN2).

The value at input IN1 must be a valid floating-point number. Integers are also allowed for 
setting the input IN2.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors occur during the instruction processing, for example, if there is an overflow.
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Parameters
The following table shows the parameters of the instruction "Exponentiate":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Base value

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Value with 
which the base 
value is 
exponentiated

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Exponentiate" instruction 
is executed. The value of operand "Tag_Value1" is raised by the power of the value of the  
operand "Tag_Value2". The result is stored at output "Tag_Result". If the instruction is executed 
without errors, the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Adding additional inputs and outputs to FBD elements (Page 1329)
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Move operations

MOVE: Move value

Description     
You use the "Move value" instruction to transfer the content of the operand at the IN input to 
the operand at the OUT1 output. The transfer is always made in the direction of ascending 
addresses.

The following table shows the possible transfers for the S7-1200 CPU family:

Source (IN) Destination (OUT1)
With IEC check Without IEC check

BYTE BYTE, WORD, DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE ,TOD, CHAR

WORD WORD, DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD, CHAR

DWORD DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, REAL, TIME, DATE, TOD, CHAR

SINT SINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

USINT USINT, UINT, UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

INT INT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

UINT UINT, UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

DINT DINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

UDINT UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

REAL REAL DWORD, REAL
LREAL LREAL LREAL
TIME TIME BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, TIME
DATE DATE BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, DATE
TOD TOD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, TOD
DTL DTL DTL
CHAR CHAR BYTE, WORD, DWORD, CHAR, Character of a 

string1)

Character of a 
string1)

Character of a string Character of a string CHAR

ARRAY2) ARRAY ARRAY
STRUCT STRUCT STRUCT

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1972 System Manual, 07/2013,  



Source (IN) Destination (OUT1)
With IEC check Without IEC check

PLC data type 
(UDT)

PLC data type (UDT) PLC data type (UDT)

IEC_TIMER IEC_TIMER IEC_TIMER
IEC_SCOUNTE
R

IEC_SCOUNTER IEC_SCOUNTER

IEC_USCOUNT
ER

IEC_USCOUNTER IEC_USCOUNTER

IEC_COUNTER IEC_COUNTER IEC_COUNTER
IEC_UCOUNTE
R

IEC_UCOUNTER IEC_UCOUNTER

IEC_DCOUNTE
R

IEC_DCOUNTER IEC_DCOUNTER

IEC_UDCOUN
TER

IEC_UDCOUNTER IEC_UDCOUNTER

The following table shows the possible transfers for the S7-1500 CPU family:

Source (IN) Destination (OUT1)
With IEC check Without IEC check

BYTE BYTE, WORD, DWORD, 
LWORD

BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE ,TOD, LTOD, CHAR

WORD WORD, DWORD, LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, S5TIME, 
TIME, LTIME, LDT, DATE, TOD, LTOD, CHAR

DWORD DWORD, LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, REAL, TIME, 
LTIME, LDT, DATE, TOD, LTOD, CHAR

LWORD LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, LREAL, 
TIME, LTIME, LDT, DATE, TOD, LTOD, CHAR

SINT SINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

USINT USINT, UINT, UDINT, 
ULINT

BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

INT INT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

UINT UINT, UDINT, ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD. LTOD

DINT DINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

UDINT UDINT, ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

LINT LINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

ULINT ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

REAL REAL DWORD, REAL
LREAL LREAL LWORD, LREAL
S5TIME S5TIME WORD, S5TIME
TIME TIME BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, TIME
LTIME LTIME BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LTIME
DATE DATE BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, DATE
DT DT DT
LDT LDT BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LDT
TOD TOD BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, TOD
LTOD LTOD BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LTOD
DTL DTL DTL
CHAR CHAR BYTE, WORD, DWORD, LWORD, CHAR, Character 

of a string1)

Character of a 
string1)

Character of a string Character of a string CHAR

ARRAY2) ARRAY ARRAY
STRUCT STRUCT STRUCT
COUNTER COUNTER, WORD, INT WORD, DWORD, INT, UINT, DINT, UDINT
TIMER TIMER, WORD, INT WORD, DWORD, INT, UINT, DINT, UDINT
PLC data type 
(UDT)

PLC data type (UDT) PLC data type (UDT)

IEC_TIMER IEC_TIMER IEC_TIMER
IEC_LTIMER IEC_LTIMER IEC_LTIMER
IEC_SCOUNTE
R

IEC_SCOUNTER IEC_SCOUNTER

IEC_USCOUNT
ER

IEC_USCOUNTER IEC_USCOUNTER

IEC_COUNTER IEC_COUNTER IEC_COUNTER
IEC_UCOUNTE
R

IEC_UCOUNTER IEC_UCOUNTER

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1974 System Manual, 07/2013,  



Source (IN) Destination (OUT1)
With IEC check Without IEC check

IEC_DCOUNTE
R

IEC_DCOUNTER IEC_DCOUNTER

IEC_UDCOUN
TER

IEC_UDCOUNTER IEC_UDCOUNTER

IEC_LCOUNTE
R

IEC_LCOUNTER IEC_LCOUNTER

IEC_ULCOUNT
ER

IEC_ULCOUNTER IEC_ULCOUNTER

1) You can also use the "Move value" instruction to transfer individual characters of a string 
(STRING) to operands of CHAR data type. The number of the character to be transferred is 
specified in square brackets beside the operand name. "MyString[2]", for example, transfers 
the second character of the "MyString" string. It is also possible to transfer from operands of 
the data type CHAR to the individual characters of a string. You can also replace a specific 
character of a string with a character of another string. 
2) Transferring entire arrays (ARRAY) is possible only when the array components of the 
operands at input IN and at output OUT1 are of the same data type.

If the bit length of the data type at input IN exceeds the bit length of the data type at output 
OUT1, the higher-order bits of the source value are lost. If the bit length of the data type at 
input  IN is less than the bit length of the data type at output OUT1, the higher-order bits of the 
destination value will be overwritten with zeros.

In its initial state the instruction box contains 1 output (OUT1). The number of outputs can be 
extended. The added outputs are numbered in ascending order on the box. During the 
execution of the instruction the content of the operand at the input IN is transferred to all 
available outputs. The instruction box cannot be extended if structured data types (DTL, 
STRUCT, ARRAY) or characters of a string (STRING) are transferred.

You can also use the "Move block"  (MOVE_BLK) and "Move block uninterruptible" 
(UMOVE_BLK) instructions to move operands of the ARRAY data type. You can move 
operands of the STRING data type with the instruction "Move character string" (S_MOVE).

Parameters
The following table shows the parameters of the "Move value" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output
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Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input Bit strings, 
integers, 
floating-
point 
numbers, 
DATE, 
TIME, TOD, 
DTL, CHAR, 
STRUCT, 
ARRAY, 
IEC data 
types, PLC 
data type 
(UDT)

Bit strings, 
integers, 
floating-
point 
numbers, 
DATE, DT, 
LDT, 
S5TIME, 
TIME, 
LTIME, 
TOD, 
LTOD, DTL, 
CHAR, 
STRUCT, 
ARRAY, 
TIMER, 
COUNTER, 
IEC data 
types, PLC 
data type 
(UDT)

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Element 
used to 
overwrite 
the 
destination 
address.

OUT1 Output Bit strings, 
integers, 
floating-
point 
numbers, 
DATE, 
TIME, TOD, 
DTL, CHAR, 
STRUCT, 
ARRAY, 
IEC data 
types, PLC 
data type 
(UDT)

Bit strings, 
integers, 
floating-
point 
numbers, 
DATE, DT, 
LDT, 
S5TIME, 
TIME, 
LTIME, 
TOD, 
LTOD, DTL, 
CHAR, 
STRUCT, 
ARRAY, 
TIMER, 
COUNTER, 
IEC data 
types, PLC 
data type 
(UDT)

I, Q, M, D, L I, Q, M, D, L Destination 
address

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 0011 1111 1010 1111
OUT1 TagOut_Value 0011 1111 1010 1111

If the operand "TagIn" has the signal state "1", the "Move value" instruction is executed. The 
instruction copies the content of the operand "TagIn_Value" to the operand "TagOut_Value" 
and set output "TagOut" to signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Removing instruction inputs and outputs (Page 1330)

MOVE_BLK: Move block (Page 1981)

UMOVE_BLK: Move block uninterruptible (Page 1987)

S_MOVE: Move character string (Page 2294)

Adding additional inputs and outputs to FBD elements (Page 1329)

FieldRead: Read field

Description
You can use the "Read field" instruction to read out a specific component from the field 
specified in the MEMBER parameter and transfer its content to the tag in the VALUE 
parameter. You use the parameter INDEX to define the index of the field components that are 
to be read. At the parameter MEMBER you specify the first component of the field to be read.

The data types of the field component at parameter MEMBER and the tags at parameter 
VALUE must correspond to the data type of the instruction "Read field".

Enable output ENO has the signal state "0" if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The field component specified at the parameter INDEX is not defined in the field specified 
at the parameter MEMBER.

● Errors, such as an overflow, occur during execution.

Parameters
The following table shows the parameters of the instruction "Read field":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

INDEX Input DINT DINT I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Index of field 
components 
whose 
content is 
read out 

MEMBER Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD 
and CHAR 
as 
components 
of an 
ARRAY tag

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
TOD, LTOD 
and CHAR 
as 
components 
of an 
ARRAY tag

D, L D, L First 
component 
of the field 
from which 
will be read

VALUE Output Bit strings, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD 
and CHAR

Bit strings, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
TOD, LTOD 
and CHAR

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Operand to 
which the 
contents of 
the field 
component 
are 
transferred.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Tag Value
INDEX a_index 4
MEMBER "DB_1".Main_Field[-10] First component of the field 

"Main_Field[-10..10] of REAL" in the data 
block "DB_1"

VALUE a_real Component with Index 4 of the field 
"Main_Field[-10..10] of REAL"

The field component with index 4 is read out from the field "Main_Field[-10...10] of REAL" and 
written to the tag "a_real". The field component to be read is defined by the value at the 
parameter INDEX.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

FieldWrite: Write field

Description
The "Write field" instruction is used to transfer the content of the tag at the VALUE input to a 
specific component of the field at the MEMBER output. You use the value at the INDEX input 
to specify the index of the field component that is described. At the MEMBER output, enter the 
first component of the field which is to be written to.

The data types of the field component specified at the MEMBER output and the tags at the 
VALUE input have to match the data type of the "Write field" instruction.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The field component specified at the input INDEX is not defined in the field specified at the 
output MEMBER.

● Errors, such as an overflow, occur during execution.
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Parameters
The following table shows the parameters of the instruction "Write field":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

INDEX Input DINT DINT I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Index of field 
component 
that is 
written with 
the content 
of VALUE

VALUE Input Bit strings, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD 
and CHAR

Bit strings, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
TOD, LTOD 
and CHAR

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Operand 
whose 
contents are 
copied

MEMBER Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD 
and CHAR 
as 
components 
of an 
ARRAY tag

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
TOD, LTOD 
and CHAR 
as 
components 
of an 
ARRAY tag

D, L D, L First 
component 
of the field to 
which the 
content of 
VALUE is 
written.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
INDEX a_index 4
VALUE a_real 10.54
MEMBER "DB_1".Main_Field[-10] First component of the field 

"Main_Field[-10..10] of REAL" in the data 
block "DB_1"

The value "10.54" of the "a_real" tag is written to the field component with index 4 of the 
"Main_Field[-10 ... 10] of REAL" field. The index of the field component to which the content 
of the tag "a_real" is transferred is specified by the value at the input INDEX.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

MOVE_BLK: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). The number of elements to be moved to the 
destination area is specified with the COUNT parameter. The width of the elements to be 
moved is defined by the width of the element at input IN.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is moved than is made available at input IN or output OUT.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the Array structure is exceeded. If the byte limit of the Array structure is exceeded 
by the value at the COUNT input, the ENO enable output is reset to "0".
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Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN 1) Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L The first 
element of 
the source 
area that is 
being copied

COUNT Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Number of 
elements to 
be copied 
from the 
source area 
to the 
destination 
area

OUT 1) Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L The first 
element of 
the 
destination 
area to 
which the 
contents of 
the source 
area are 
being copied

1) The specified data types can only be used as elements of an Array structure.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Move block" instruction is 
executed. Starting from the third element, the instruction selects three INT elements from the 
#a_array tag and copies their contents to the #b_array output tag, beginning with the second 
element. If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

MOVE_BLK_VARIANT: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). You can copy elements of an array to another array 
of the same data type. The size (number of elements) of the source and destination array may 
be different. You can copy several elements within an array or individual elements.

If you are using the instruction, the array must not yet be known at the time the block is created, 
as the source and the destination are transferred using VARIANT.
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The counting at the parameters SRC_INDEX and DEST_INDEX always starts with the low 
limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available.

Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC Input VARIANT

(array or single 
element)

I, Q, D, L The first element of the 
source area that is 
being copied

COUNT Input UDINT I, Q, M, D, L or constant Specifies the number 
of elements that will be 
copied.
Set the value at the 
parameter COUNT to 
“1”, if no Array is 
specified at the 
parameter SRC or the 
parameter DEST.

SRC_INDEX Input UDINT I, Q, M, D, L or constant ● If an Array is 
specified at 
parameter SRC, 
the parameter 
SRC_INDEX 
specifies the first 
element at the 
parameter SRC, 
which is to be 
copied.

● If no Array is 
specified at the 
parameter SRC, 
then enter the 
value “0” at the 
parameter 
SRC_INDEX.
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Parameter Declaration Data type Memory area Description
DEST_INDEX Input UDINT I, Q, M, D, L or constant ● If an Array is 

specified at 
parameter DEST, 
the parameter 
DEST_INDEX 
specifies the first 
element at the 
parameter DEST, 
which is to be 
copied.

● If no Array is 
specified at the 
parameter DEST, 
then enter the 
value “0” at the 
parameter 
DEST_INDEX.

DEST InOut VARIANT I, Q, D, L The first element of the 
source area that is 
being copied

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during execution of the 
instruction, an error 
code is output on the 
RET_VAL parameter.

For additional information on valid data types, refer to "See also".

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8082 Data types do not correspond
80B4 Data types do not correspond
8151 Code generation error at SRC parameter
8152 Code generation error at SRC parameter
8153 Code generation error at SRC parameter
8251 The COUNT parameter has an invalid value
8254 The COUNT parameter has an invalid value
8281 The COUNT parameter has an invalid value
8282 The COUNT parameter has an invalid value
8382 The value at the SRC_INDEX parameter is outside the limit of the VARIANT
8383 The value at the SRC_INDEX parameter is outside the high limit of the array.
8482 The value at the DEST_INDEX parameter is outside the limit of the VARIANT
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Error code*
(W#16#...)

Explanation

8483 The value at the DEST_INDEX parameter is outside the high limit of the 
array.

8534 The DEST parameter is write protected.
8551 Code generation error at DEST parameter
8552 Code generation error at DEST parameter
8553 Code generation error at DEST parameter
85A2 The DEST parameter is write protected.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
SRC #SrcField The local operand #SrcField 

uses a UDT that was still 
unknown at the time when the 
block was programmed.

COUNT Tag_Count 3
SRC_INDEX Tag_Src_Index 4
DEST_INDEX Tag_Dest_Index 2
DEST #DestField The local operand #DestField 

uses a UDT that was still 
unknown at the time when the 
block was programmed.

If the operand "TagIn" has the signal state "1", the "Move block" instruction is executed. If the 
instruction is executed without errors, the ENO enable output has the signal state "1" and the 
"TagOut" output is set.
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See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

UMOVE_BLK: Move block uninterruptible

Description
You can use the "Move block uninterruptible" instruction to move the content of a memory area 
(source area) to another memory area (destination area). The number of elements to be moved 
to the destination area is specified with the COUNT parameter. The width of the elements to 
be moved is defined by the width of the element at input IN.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The move operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the "Move block 
uninterruptible" instruction.

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is moved than is made available at input IN or output OUT.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the Array structure is exceeded. If the byte limit of the Array structure is exceeded 
by the value at the COUNT input, the ENO enable output is reset to "0".

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Parameters
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN 1) Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L The first 
element of 
the source 
area that is 
being copied

COUNT Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Number of 
elements to 
be copied 
from the 
source area 
to the 
destination 
area

OUT 1) Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L The first 
element of 
the 
destination 
area to 
which the 
contents of 
the source 
area are 
being copied

1) The specified data types can only be used as elements of an array structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Move block uninterruptible" 
instruction is executed. Starting from the third element, the instruction selects three INT 
elements from the #a_array tag and copies their contents to the #b_array output tag, beginning 
with the second element. The move operation cannot be interrupted by other operating system 
activities. If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

FILL_BLK: Fill block

Description
You can use the "Fill block" instruction to fill a memory area (destination area) with the value 
of input IN. The destination area is filled beginning with the address specified at the OUT output. 
The number of repeated move operations is specified with the COUNT parameter. When the 
instruction is executed, the value at the input IN is selected and moved to the destination area 
as often as specified by the value of the COUNT parameter.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is moved than is made available at input IN or output OUT.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the Array structure is exceeded. If the byte limit of the Array structure is exceeded 
by the value at the COUNT input, the ENO enable output is reset to "0".
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Parameters
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN 1) Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD, 
CHAR

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Element 
used to fill 
the 
destination 
area

COUNT Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Number of 
repeated 
move 
operations

OUT 2) Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD, 
CHAR

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L Address in 
destination 
area from 
which filling 
starts.

1) The specified data types can also be used as elements of an Array structure.
2) The specified data types can only be used as elements of an Array structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Fill block" instruction is 
executed. The instruction copies the third element (#a_array[2]) of the #a_array tag three times 
to the #b_array output tag. If no errors occur during the execution of the instruction, the outputs 
ENO and "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

UFILL_BLK: Fill block uninterruptible

Description
You can use the instruction "Fill block uninterruptible" to fill a memory area (destination area) 
with the value of input IN uninterruptibly. The destination area is filled beginning with the 
address specified at the OUT output. The number of repeated move operations is specified 
with the COUNT parameter. When the instruction is executed, the value at the input IN is 
selected and moved to the destination area as often as specified by the value of the COUNT 
parameter.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The move operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the "Fill block 
uninterruptible" instruction.

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is moved than is made available at input IN or output OUT.
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When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the Array structure is exceeded. If the byte limit of the Array structure is exceeded 
by the value at the COUNT input, the ENO enable output is reset to "0".

You can use the "Fill block uninterruptible" instruction to move a maximum of 16 KB. Note the 
CPU-specific restrictions for this.

Parameters
The following table shows the parameters of the "Fill block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN 1) Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Element 
used to fill 
the 
destination 
area

COUNT Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Number of 
repeated 
move 
operations

OUT 2) Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L Address in 
destination 
area from 
which filling 
starts.

1) The specified data types can also be used as elements of an Array structure.
2) The specified data types can only be used as elements of an Array structure.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Fill block uninterruptible" 
instruction is executed. The instruction copies the third element (#a_array[2]) of the #a_array 
tag three times to the #b_array output tag. The move operation cannot be interrupted by other 
operating system activities. If no errors occur during the execution of the instruction, the outputs 
ENO and "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SWAP: Swap

Description       
You can use the instruction "Swap" to change the order of the bytes within the tag at input IN 
and query the result at output OUT.

The following figure shows how the bytes of a DWORD data type operand are swapped using 
the "Swap" instruction:
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Parameters
The following table shows the parameters of the "Swap" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input WORD, 
DWORD

WORD, 
DWORD, 
LWORD

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Operand 
whose bytes 
are 
swapped.

OUT Output WORD, 
DWORD

WORD, 
DWORD, 
LWORD

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
1994 System Manual, 07/2013,  



Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 0000 1111 0101 0101
OUT TagOut_Value 0101 0101 0000 1111

If the operand "TagIn" has the signal state "1", the "Swap" instruction is executed. The 
arrangement of the bytes is changed and stored in the operand "TagOut_Value".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Array data blocks

ReadFromArrayDB: Read from array data block

Description
You can use the "Read from array data block" instruction to read data from an array DB.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table shows the parameters of the "Read from array data block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
DB Input DB_ANY I, Q, M, D, L Data block that is 

read
INDEX Input DINT I, Q, M, D, L Element that is 

read
VALUE InOut VARIANT I, Q, M, D, L Value that is read
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during execution 
of the instruction, 
an error code is 
output on the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)
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WriteToArrayDB: Write to array data block

Description
You can use the "Write to array data block" instruction to write data to an array DB.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table shows the parameters of the "Write to array data block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
DB Input DB_ANY I, Q, M, D, L Data block to 

which data is 
written

INDEX Input DINT I, Q, M, D, L Element in the DB 
to which data is 
written

VALUE Input VARIANT I, Q, M, D, L Value to be written
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during execution 
of the instruction, 
an error code is 
output on the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
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Error code*
(W#16#...)

Explanation

8131 The data block does not exist
8132 The data block is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ReadFromArrayDBL: Read from array data block in load memory

Description
You can use the "Read from array data block in load memory" instruction to read data from an 
array DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". The instruction is terminated if a negative 
signal edge is detected at the BUSY parameter. The DONE parameter has the signal state "1" 
for one program cycle and the read value is output at the VALUE parameter within this cycle. 
With all other program cycles, the value at the VALUE parameter is not changed.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.
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Parameters
The following table shows the parameters of the "Read from array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L REQ = "1": 

Starting with the 
reading of the 
array DB

DB Input DB_ANY I, Q, M, D, L Data block that is 
read

INDEX Input DINT I, Q, M, D, L Element that is 
read

BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 
array DB is still 
being read

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully

VALUE InOut VARIANT I, Q, M, D, L Value that is read
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during execution 
of the instruction, 
an error code is 
output on the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
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Error code*
(W#16#...)

Explanation

8282 The value at the INDEX parameter is outside the 
limit values of the array.

8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

WriteToArrayDBL: Write to array data block in load memory

Description
You can use the "Write to array data block in load memory" instruction to write data to an array 
DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". If a negative signal edge is detected at the 
BUSY parameter, the instruction is terminated and the value at the VALUE parameter is written 
to the data block. The DONE parameter then has the signal state "1" for one program cycle.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.
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Parameters
The following table shows the parameters of the "Write to array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L REQ = "1": Start 

writing into the 
array DB

DB Input DB_ANY D Data block to 
which data is 
written

INDEX Input DINT I, Q, M, D, L Element in the DB 
to which data is 
written

VALUE Input VARIANT I, Q, M, D, L Value to be written
BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 

array DB is still 
being written

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during execution 
of the instruction, 
an error code is 
output on the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
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Error code*
(W#16#...)

Explanation

8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Other

BLKMOV: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). The move operation takes place in the direction 
of ascending addresses. You use VARIANT to define the source and destination area.

 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

The following figure shows the principle of the move operation:
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Consistency of the source data and the target data
Make sure that the source data remain unchanged during the execution of the instruction "Move 
block". Otherwise the consistency of the target data cannot be ensured.

Interruptibility
There is no limit to the nesting depth.

Memory areas
You can use the "Move block" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap. If the source and destination area have 
different lengths, only the length of the smaller area will be moved.

If the source area is less than the destination area, the entire source area will be written to the 
destination area. The remaining bytes of the destination area remain unchanged.

If the destination area is less than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.
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If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

Rules for moving character strings
You can use the "Move block" instruction to also move source and destination areas of the 
STRING data type. If only the source area is STRING data type, the characters will be moved 
that are actually contained in the character string. Information on the actual and maximum 
length is also written to the destination area. If the source and destination area are each 
STRING data type, the current length of the character string in the destination area is set to 
the number of actually moved characters.

If you want to move the information on the maximum and actual length of a character string, 
specify the areas in bytes to the SRCBLK and DSTBLK parameters.

Parameters
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
SRCBLK Input VARIANT I, Q, M, D, L I, Q, M, D, L Specifies the 

memory area to be 
moved 
(source area).

RET_VAL Output INT I, Q, M, D, L, P I, Q, M, D, L, P Error information:
If an error occurs 
during execution of 
the instruction, an 
error code is output 
at the RET_VAL 
parameter.

DSTBLK Output VARIANT I, Q, M, D, L I, Q, M, D, L Specifies the 
memory area to 
which the block is to 
be moved 
(destination area).

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8091 The permitted nesting depth was exceeded
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Error code*
(W#16#...)

Explanation

8092 The instruction cannot be executed because a specified data block is write protection, non-executable or 
unloaded.

General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 2044)

UBLKMOV: Move block uninterruptible

Description
You can use the "Move block uninterruptible" instruction to move the content of a memory area 
(source area) to another memory area (destination area). The move operation takes place in 
the direction of ascending addresses. You use VARIANT to define the source and destination 
area.

The move operation cannot be interrupted by other operating system activities. As a result the 
alarm reaction time of the CPU can increase during the execution of the "Move block 
uninterruptible" instruction.

 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

Memory areas
You can use the "Move block uninterruptible" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs
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General rules for moving
The source and destination area must not overlap during the execution of the "Move block 
uninterruptible" instruction. If the source area is less than the destination area, the entire source 
area will be written to the destination area. The remaining bytes of the destination area remain 
unchanged.

If the destination area is less than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a source or destination area defined as a formal parameter is less than a destination or 
source area specified on the SRCBLK or DSTBLK parameter, no data will be transferred.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Rules for moving character strings
You can use the "Move block uninterruptible" instruction to also move source and destination 
areas of the STRING data type. If only the source area is STRING data type, the characters 
will be moved that are actually contained in the character string. Information on the actual and 
maximum length are not written in the destination area. If the source and destination area are 
each STRING data type, the current length of the character string in the destination area is 
set to the number of actually moved characters. If areas of the data type STRING are moved, 
you have to specify "1" as area length.

Parameters
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
SRCBLK Input VARIANT I, Q, M, D, L I, Q, M, D, L Specifies the memory 

area to be moved 
(source area).

RET_VAL Output INT I, Q, M, D, L, P I, Q, M, D, L, 
P

Error information:
If an error occurs during 
execution of the 
instruction, an error 
code is output at the 
RET_VAL parameter.

DSTBLK Output VARIANT I, Q, M, D, L I, Q, M, D, L Specifies the memory 
area to which the block 
is to be moved 
(destination area).
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Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code
(W#16#...)

Explanation

0000 No error
8091 The source area is in a data block that is not relevant for program execution.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 2044)

FILL: Fill block

Description
You can use the "Fill block" instruction to fill a memory area (destination area) with the content 
of another memory area (source area). The "Fill block" instruction moves the content of the 
source area to the destination area until the destination area is completely written. The move 
operation takes place in the direction of ascending addresses.

You use VARIANT to define the source and destination area.
 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

For blocks with the "Optimized block access" attribute, you can use the "FILL_BLK: Fill block" 
instruction.

 

The following figure shows the principle of the move operation:
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Consistency of the source data and the target data
Please note that during execution of the instruction "Fill block" that the source data remain 
unchanged, otherwise the consistency of the target data is not ensured.

Memory areas
You can use the "Fill block" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap. If the destination block to be preset is not 
an integer multiple of the length of the input parameter BVAL, the destination block is 
nevertheless written up to the last byte.

If the destination area to be preset is smaller than the source area, the function only copies as 
much data as can be written to the destination area.

If the destination or source block actually present is smaller than the assigned memory area 
for the source or destination block (BVAL, BLK parameters), no data is transferred.

If the ANY pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.
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If the destination block is of data type STRING, the instruction describes the entire string 
including the administration information.

Parameters
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
BVAL Input VARIANT I, Q, M, D, L Specification of the memory 

area (source area) with 
whose content the 
destination area on the BLK 
parameter is filled.

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs during 
execution of the instruction, 
an error code is output at the 
RET_VAL parameter.

BLK Output VARIANT I, Q, M, D, L Specification of the memory 
area that is filled with the 
content of the source area.

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 2044)
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Conversion operations

CONVERT: Convert value

Description       
The "Convert value" instruction reads the content of the IN parameter and converts it according 
to the data types configured in the instruction box. The converted value is provided at output 
OUT.

For information on possible conversions, refer to the "Explicit conversion" section at "See also".

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.

● For the input IN, an operand of data type BYTE, WORD, DWORD or LWORDis configured, 
whose highest value bit is set. A signed integer of data type (SINT, INT DINT, LINT) is 
configured in the instruction box for the output OUT, which has the same bit length as the 
operand at input IN.

Parameters
The following table shows the parameters of the "Convert value" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Bit strings, 

integers, 
floating-point 
numbers, 
CHAR, 
BCD16, 
BCD32

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Value to be 
converted.

OUT Output Bit strings, 
integers, 
floating-point 
numbers, 
CHAR, 
BCD16, 
BCD32

I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
conversion

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

Bit strings (BYTE, WORD, DWORD, LWORD) cannot be selected in the instruction box. If you 
have specified an operand of data type BYTE, WORD, or DWORD or LWORD at a parameter 
of the instruction, the value of the operand is interpreted as an unsigned integer with the same 
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bit length. In this case the data type BYTE is interpreted as USINT, WORD as UINT, and 
DWORD as UDINT and LWORD as LINT.

 

 Note

For S7-1500 CPU applies: As data types DWORD and LWORD can be selected if REAL or 
LREAL were selected as IN data type.

 

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the content of the operand "TagIn_Value" is 
read and converted to an integer (16 bits). The result is stored in the operand "TagOut_Value". 
The output "TagOut" is set to "1" if the instruction was executed without errors.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ROUND: Round numerical value

Description     
You can use the "Round numerical value" instruction to round the value at input IN  to the 
nearest integer. The instruction interprets the value at input IN as a floating-point number and 
converts this to the nearest integer. If the input value is exactly between an even and odd 
number, then the even number is converted. The result of the instruction is provided at output 
OUT and can be queried there.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.
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Parameters
The following table shows the parameters of the "Round numerical value" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value to 
be rounded.

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
rounding

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 1.50000000 -1.50000000
OUT TagOut_Value 2 -2

If the operand "TagIn" has the signal state "1", the "Round numerical value" instruction is 
executed. The floating-point number at input "TagIn_Value" is rounded to the nearest even 
integer and sent to output "TagOut_Value". If no errors occur during the execution of the 
instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)
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CEIL: Generate next higher integer from floating-point number

Description     
You can use the "Generate next higher integer from floating-point number" instruction to round 
the value at input IN to the next higher integer. The instruction interprets the value at input IN 
as a floating-point number and converts this to the next higher integer. The result of the 
instruction is provided at output OUT and can be queried there. The output value can be greater 
than or equal to the input value.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.

Parameters
The following table shows the parameters of the instruction "Generate next higher integer from 
floating-point number":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value as 
floating-point 
number

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Result with the 
next higher 
integer

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN TagIn_Value 0.50000000 -0.50000000
OUT TagOut_Value 1 0

If the operand "TagIn" has the signal state "1", the instruction "Generate next higher integer 
from floating-point number" is executed. The floating-point number at input "TagIn_Value" is 
rounded to the next higher integer and sent to output "TagOut_Value". If no errors occur during 
the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

FLOOR: Generate next lower integer from floating-point number

Description     
You can use the "Generate next lower integer from floating-point number" instruction to round 
the value at input IN to the next lower integer. The instruction interprets the value at input IN 
as a floating-point number and converts this to the next lower integer. The result of the 
instruction is provided at output OUT and can be queried there. The output value can be less 
than or equal to the input value.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.

Parameters
The following table shows the parameters of the instruction "Generate next lower integer from 
floating-point number":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value as 
floating-point 
number

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Result with the 
next lower 
integer

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 0.50000000 -0.50000000
OUT TagOut_Value 0 -1

If the operand "TagIn" has the signal state "1", the instruction "Generate next lower integer 
from floating-point number" is executed. The floating-point number at input "TagIn_Value" is 
rounded to the next lower integer and displayed at output "TagOut_Value". If no errors occur 
during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

TRUNC: Truncate numerical value

Description       
You can use the "Truncate numerical value" instruction to form an integer from the value at 
input IN. The value at input IN is interpreted as a floating-point number. The instruction selects 
only the integer part of the floating-point number and sends this to output OUT without decimal 
places.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.
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Parameters
The following table shows the parameters of the instruction "Truncate numerical value":

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L or 
constant

Input value as 
floating-point 
number

OUT Output Integers, floating-
point numbers

I, Q, M, D, L Result with integer 
part of the floating-
point number

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 1.50000000 -1.50000000
OUT TagOut_Value 1 -1

If the operand "TagIn" has the signal state "1", the "Truncate numerical value" instruction is 
executed. The integer part of the floating-point number at input "TagIn_Value" is converted to 
an integer and sent to output "TagOut_Value". If no errors occur during the execution of the 
instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)
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SCALE_X: Scale

Description
You can use the "Scale" instruction to scale the value at the VALUE input  by mapping it to a 
specified value range. When the instruction "Scale" is executed, the floating-point value at 
input VALUE is scaled to the value range, which is defined by the parameters MIN and MAX. 
The result of the scaling is an integer, which is stored at output OUT.

The following figure shows an example of how values can be scaled:

The "Scale" instruction works with the following equation:

OUT = [VALUE ∗ (MAX – MIN)] + MIN

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input MIN is greater than or equal to the value at input MAX.

● The value of a specified floating-point number is outside the range of the normalized 
numbers according to IEEE-754.

● An overflow occurs.

● The value at input VALUE is NaN (Not a number = result of an invalid arithmetic operation).
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Parameters
The following table shows the parameters of the "Scale" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
MIN Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VALUE Input Floating-point 
numbers

I, Q, M, D, L or 
constant

Value to be scaled.
If you enter a 
constant, you 
must declare it.

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

OUT Output Integers, floating-
point numbers

I, Q, M, D, L Result of scaling

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MIN Tag_MIN 10
VALUE Tag_Value 0.5
MAX Tag_MAX 30
OUT Tag_Result 20

If the operand "TagIn" has the signal state "1", the "Scale" instruction is executed. The value 
at input "Tag_Value" is scaled to the range of values defined by the values at inputs "Tag_MIN" 
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and "Tag_MAX". The result is stored at output "Tag_Result". If the instruction is executed 
without errors, the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

NORM_X: Normalize (Page 2019)

Declaring constants (Page 1188)

NORM_X: Normalize

Description
You can use the instruction "Normalize" to normalize the value of the tag at the VALUE input 
by mapping it to a linear scale. You can use the parameters MIN and MAX to define the limits 
of a value range that is applied to the scale. Depending on the location of the normalized value 
in this value range, the result at output OUT is calculated and stored as a floating-point number. 
If the value to be normalized is equal to the value at input MIN, output OUT returns the value 
"0.0". If the value to be normalized is equal to the value at input MAX, output OUT returns the 
value "1.0".

The following figure shows an example of how values can be normalized:

The "Normalize" instruction works with the following equation:

OUT = (VALUE – MIN) / (MAX – MIN)

Enable output ENO has the signal state "0" if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The value at input MIN is greater than or equal to the value at input MAX.

● The value of a specified floating-point number is outside the range of the normalized 
numbers according to IEEE-754.

● The value at input VALUE is NaN (result of an invalid arithmetic operation).

Parameters
The following table shows the parameters of the instruction "Normalize":

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
MIN 1) Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VALUE 1) Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Value to be 
normalized.

MAX 1) Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

OUT Output Floating-point 
numbers

I, Q, M, D, L Result of the 
normalization

1) If you use constants in these three parameters, you only need to declare one of them.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
MIN Tag_MIN 10
VALUE Tag_Value 20
MAX Tag_MAX 30
OUT Tag_Result 0.5

If the operand "TagIn" has the signal state "1", the "Normalize" instruction is executed. The 
value at input "Tag_Value" is assigned to the range of values defined by the values at inputs 
"Tag_MIN" and "Tag_MAX". The tag value at input "Tag_Value" is normalized corresponding 
to the defined value range. The result is stored as a floating-point number at output 
"Tag_Result". If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SCALE_X: Scale (Page 2017)

Declaring constants (Page 1188)

Other

SCALE: Scale

Description
Use the Scale instruction to convert the integer at the IN parameter into a floating-point number, 
which can be scaled in physical units between a low limit value and a high limit value. You can 
use the LO_LIM and HI_LIM parameters to specify the low limit and high limit of the value range 
to which the input value is scaled. The result of the instruction is output at the OUT parameter.

The "Scale" instruction works with the following equation:

OUT = [((FLOAT (IN) – K1)/(K2–K1)) ∗ (HI_LIM–LO_LIM)] + LO_LIM

The values of the constants "K1" and "K2" are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter: 

● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the constant "K2", the result 
of the instruction is set to the value of the high limit (HI_LIM) and an error is output. 

When the value at the IN parameter is less than the value of the constant "K1", the result of 
the instruction is set to the value of the low limit value (LO_LIM) and an error is output. 
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When the indicated low limit value is greater than the high limit value (LO_LIM > HI_LIM), the 
result is scaled in reverse proportion to the input value. 

Parameters
The following table shows the parameters of the "Scale" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input INT I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

Input value to 
be scaled.

HI_LIM Input REAL I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

High limit 

LO_LIM Input REAL I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Low limit

BIPOLAR Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Indicates if the 
value at IN 
parameter is to 
be interpreted 
as bipolar or 
unipolar. The 
parameter can 
assume the 
following 
values:
1: Bipolar
0: Unipolar

OUT Output REAL I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

RET_VAL Output WORD I, Q, M, D, L, P I, Q, M, D, L, P Error 
information

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0008 The value of the  IN parameter is greater than the value of the "K2" constant or less than the value of the 

"K1" constant.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 22
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_OutputValue 50.03978588
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 2044)

UNSCALE: Unscale

Description
The "Unscale" instruction unscales the floating-point number at the IN parameter into physical 
units between a low limit value and a high limit and converts them into integers. You can use 
the LO_LIM and HI_LIM parameters to specify the low limit and high limit of the value range 
to which the input value is unscaled. The result of the instruction is output at the OUT parameter.

The "Unscale" instruction works with the following equation:

OUT = [ ((IN–LO_LIM)/(HI_LIM–LO_LIM)) ∗ (K2–K1) ] + K1

The values of the constants "K1" and "K2" are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter:
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● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the constant "HI_LIM", the 
result of the instruction is set to the value of the constant (K2) and an error is output. 

When the value at the IN parameter is less than the value of the constant of the low limit 
(LO_LIM), the result of the instruction is set to the value of the constant (K1) and an error is 
output.

Parameters
The following table shows the parameters of the "Unscale" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Input BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input REAL I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

Input value to 
be unscaled to 
an integer 
value.

HI_LIM Input REAL I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

High limit

LO_LIM Input REAL I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Low limit

BIPOLAR Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Indicates if the 
value at the IN 
parameter is to 
be interpreted 
as bipolar or 
unipolar. The 
parameter can 
assume the 
following 
values:
1: Bipolar
0: Unipolar

OUT Output INT I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

RET_VAL Output WORD I, Q, M, D, L, P I, Q, M, D, L, P Error 
information
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Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0008 The value of the IN parameter is greater than the value of the high limit (HI_LIM) or less than the value 

of the low limit (LO_LIM).
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 50.03978588
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_OutputValue 22
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 2044)
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Program control operations

JMP: Jump if RLO = 1

Description     
You can use the "Jump if RLO = 1" instruction to interrupt the linear execution of the program 
and resume it in another network. The target network must be identified by a jump label 
(LABEL). The jump label description is entered in the placeholder above the instruction box.

The specified jump label must be in the same block in which the instruction is executed. The 
name you specify can only occur once in the block. Only one jumping coil can occur in a 
network.

If the result of logic operation (RLO) at the input of the instruction is "1", the jump to the network 
identified by the jump label is executed. The jump direction can be towards higher or lower 
network numbers.

If the condition at the input of the instruction is not fulfilled (RLO = 0), execution of the program 
continues in the next network.

Example
The following example shows how the instruction works:

If the operand "TagIn_1" has the signal state "1", the instruction "Jump if RLO = 1" is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If input "TagIn_3" has the signal state "1", output "TagOut_3" 
is reset.

See also
Overview of the valid data types (Page 1077)
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JMPN: Jump if RLO = 0

Description     
You can use the instruction "Jump if RLO = 0" to interrupt the linear execution of the program 
and resume it in another network, when the result of logic operation at the input of the 
instruction is "0". The target network must be identified by a jump label (LABEL). The jump 
label description is entered in the placeholder above the instruction box.

The specified jump label must be in the same block in which the instruction is executed. The 
name you specify can only occur once in the block. Only one jumping coil can occur in a 
network.

If the result of logic operation (RLO) at the input of the instruction is "0", the jump to the network 
identified by the jump label is executed. The jump direction can be towards higher or lower 
network numbers.

If the result of the logic operation RLO at the input of the instruction is "1", execution of the 
program continues in the next network.

Example
The following example shows how the instruction works:

If the operand "TagIn_1" has the signal state "0", the instruction "Jump if RLO = 0" is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If input "TagIn_3" has the signal state "1", output "TagOut_3" 
is reset.

See also
Overview of the valid data types (Page 1077)
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LABEL: Jump label

Description       
The jump label identifies a destination network in which the execution of the program can be 
resumed after the execution of a jump instruction.

The jump label and the instruction in which the jump label is specified must be located in the 
same block. The name of a jump label can only be assigned once in a block. You can declare 
up to 32 jump labels when you use a CPU S7-1200 and a maximum of 256 jump labels when 
you use a CPU S7-1500.

Only one jump label can be placed in a network. Each jump label can jump to several locations.

Example
The following example shows how the instruction works:

If the operand "TagIn_1" has the signal state "1", the instruction "Jump if RLO = 1" is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If input "TagIn_3" has the signal state "1", output "TagOut_3" 
is reset.

See also
Overview of the valid data types (Page 1077)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)
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JMP_LIST: Define jump list

Description       
The instruction "Define jump list" is used to define several conditional jumps and to resume 
the program execution in a defined network depending on the value of the parameter K.

You define the jumps with jump labels (LABEL), which you specify at the outputs of the 
instruction box. In its initial state the instruction box contains at least 2 outputs (DEST0 and 
DEST1). The number of outputs can be extended. You can declare up to 32 outputs when you 
use a CPU S7-1200 and a maximum of 256 outputs when you use a CPU S7-1500.

The numbering of the outputs begins with the value "0" and is continued in ascending order 
with each new output. Only jump labels can be specified at the outputs of the instruction. It is 
not permitted to specify instructions or operands.

You use the value of the parameter K to specify the number of the output and, accordingly, 
the jump label at which the program execution is continued. If the value at the parameter K is 
greater than the number of available outputs, the linear execution of the program is not 
interrupted but instead continued in the next network.

Parameters
The following table shows the parameters of the "Define jump list" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, L, D Enable input
K Input UINT I, Q, M, L, D or 

constant
Specifies the 
number of the 
output and thus 
the jump that is 
executed.

DEST0 - - - First jump label
DEST1 - - - Second jump label
DESTn - - - Optional jump 

labels

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand/Jump label Value
K Tag_Value 1
DEST0 LABEL0 Jump in the network that is 

identified with the jump label 
"LABEL0".

DEST1 LABEL1 Jump in the network that is 
identified with the jump label 
"LABEL1".

DEST2 LABEL2 Jump in the network that is 
identified with the jump label 
"LABEL2".

If the operand "Tag_Input" has the signal state "1", the instruction "Define jump list" is executed. 
The execution of the program is continued according to the value of the operand "Tag_Value" 
in the network that is identified with the jump label "LABEL1".

See also
Overview of the valid data types (Page 1077)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

SWITCH: Jump distributor

Description       
You can use the "Jump distributor" instruction to define multiple program jumps to be executed 
depending on the result of one or more comparison instructions.

At the parameter K, you specify the value to be compared. This value is compared with the 
values that the individual inputs return. You select the type of comparison for each input. The 
availability of various comparison instructions depends on the data type of the instruction.
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The following table shows the comparison instructions that are available depending on the 
selected data type:

Data type Instruction Syntax
S7-1200 S7-1500
Bit strings Bit strings Equal ==

Not equal <>
Integers, floating-point 
numbers, TIME, 
DATE, TOD

Integers, floating-point 
numbers, TIME, 
LTIME, DATE, TOD, 
LTOD, LDT

Equal ==
Not equal <>
Greater or equal >=
Less or equal <=
Greater than >
Less than <

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box. If you select a comparison instruction and the data type of the instruction is not yet defined, 
then the "<???>" drop-down list will only list those data types that are permitted for the selected 
comparison instruction.

The execution of the instruction begins with the first comparison and is executed until a 
comparison condition is fulfilled. When a comparison condition is fulfilled the subsequent 
comparison conditions are not considered. If none of the specified comparison conditions are 
fulfilled, the jump is executed at output ELSE. If not jump label is defined at output ELSE, the 
linear execution of the program is not interrupted but instead continued in the next network.

In its initial state the instruction box contains at least 2 outputs (DEST0 and DEST1). The 
number of outputs can be extended. The numbering of the outputs begins with the value "0" 
and is continued in ascending order with each new output. Specify jump labels (LABEL) at the 
outputs of the instruction. It is not permitted to specify instructions or operands at the outputs 
of the instruction.

An input is automatically inserted to each additional output. The jump programmed at an output 
is executed when the comparison condition of the corresponding is fulfilled.

Parameters
The following table shows the parameters of the instruction "Jump distributor":

Parameters Declarat
ion

Data type Memory area Description

  S7-1200 S7-1500
EN Input BOOL BOOL I, Q, M, D, L Enable input
K Input UINT UINT I, Q, M, D, L or 

constant
Specifies the value to 
be compared.
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Parameters Declarat
ion

Data type Memory area Description

  S7-1200 S7-1500
<Comparison 
values>

Input Bit strings, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
TOD

Bit strings, 
integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
DATE, 
TOD, 
LTOD, LDT

I, Q, M, D, L or 
constant

Input values with 
which the value of the 
parameter K is 
compared.

DEST0 - - - - First jump label
DEST1 - - - - Second jump label
DEST(n) - - - - Optional jump labels

(n = 2 to 99)
ELSE - - - - Program jump which 

is executed if none of 
the comparison 
conditions are fulfilled.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand/Jump label Value
K Tag_Value 23
== Tag_Value_1 20
> Tag_Value_2 21
< Tag_Value_3 19
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Parameters Operand/Jump label Value
DEST0 LABEL0 Jump to jump label "LABEL0", if 

the value of parameter K is equal 
to 20.

DEST1 LABEL1 Jump to jump label "LABEL1", if 
the value of parameter K is 
greater than 21.

DEST2 LABEL2 Jump to jump label "LABEL2", if 
the value of parameter K is less 
than 19.

ELSE LABEL 3 Jump to jump label "LABEL3", if 
none of the comparison 
conditions are fulfilled.

If the operand "Tag_Input" changes to signal state "1", the instruction "Jump distributor" is 
executed. The execution of the program is continued in the network that is identified with the 
jump label "LABEL1".

See also
Overview of the valid data types (Page 1077)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

RET: Return

Description     
You can use the instruction "Return" to stop the execution of a block. This results in three 
types, in which the block processing can be completed:

● Without call of the "Return" instruction
The block is exited after the execution of the last network. The ENO of the call function is 
set to the signal state "1".

● Call of the "Return" instruction with logic operation (see example)
If the left connector has the signal state "1", then the block is exited. The  ENO of the function 
call corresponds to the operand.

● Call of the "Return" instruction without logic operation
The block is exited. The  ENO of the function call corresponds to the operand.

 

  Note

Only one jumping coil may be used in a network ("Return", "Jump if RLO = 1", "Jump if 
RLO = 0").

 

If the result of logic operation (RLO) at the input of the instruction "Return" is "1", the execution 
of the program is terminated in the currently called block and continued after the call function 
in the calling block (for example, in the calling OB). The status (ENO) of the call function is 
determined by the parameter of the instruction. This can assume the following values:
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● RLO

● TRUE/FALSE

● <Operand>

To set the parameter values, double-click the instruction and select the corresponding value 
in the drop-down list.

The following table shows the status of the call function when the instruction "Return" is 
programmed in a network within the called block:

RLO Parameter value ENO of the call function
1 RLO 1

TRUE 1
FALSE 0
<Operand> <Operand>

0 RLO In this case, the execution of the program 
continues in the next network of the called 
block.

TRUE
FALSE
<Operand>

If an OB is completed, another block is selected by the priority class system and started or re-
executed.

● If the OB program cycle was completed, it is restarted.

● If an OB, which interrupted another block (e.g. an Alarm OB), is completed, then the 
interrupted block (e.g. OB program cycle) is executed.

Parameters
The following table shows the parameters of the instruction "Return":

Parameters Declaration Data type Memory area Description
Status of the 
calling function 
when RLO = 1:
RLO - - - Is set to the signal 

state of the RLO.
TRUE - - - 1
FALSE - - - 0
<Operand> Input BOOL I, Q, M, D, L Signal state of the 

specified operand
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Example
The following example shows how the instruction works:

If the operands "TagIn_1" or "TagIn_2" have signal state "1", the instruction "Return" is 
executed. Program execution in the called block is terminated and continues in the calling 
block. The enable output ENO of the call function is reset to signal state "0".

See also
Overview of the valid data types (Page 1077)

Runtime control

ENDIS_PW: Limit and enable password legitimation

Description
You can use the "Limit and enable password legitimation" instruction to specify whether or not 
legitimation is allowed for the CPU. You can prevent legitimated connections, even when the 
correct password is known. When you invoke the command and the REQ parameter has the 
signal state "0", only the currently set condition is displayed at the output parameters, but no 
setting is changed. If the REQ parameter has the signal state "1", the signal state is taken from 
the input parameters (F_PWD, FULL_PWD, R_PWD, HMI_PWD). FALSE means that 
legitimation per password is not allowed; TRUE means the password can be used. Disable or 
enabling of the passwords can be allowed or prohibited individually. For example, all 
passwords can be prohibited, except the fail-safe password. You can thus limit access options 
to a small user group. The output parameters (F_PWD_ON, FULL_PWD_ON, R_PWD_ON, 
HMI_PWD_ON) always show the current status of the password use, regardless of the REQ 
parameter.

The same setting can be made on the front panel of the CPU and the CPU saves the most 
recent setting.

To prevent accidental lockout, the protection can be disabled by setting the mode switch to 
STOP with an S7-1500 CPU. The protection is automatically enabled again by setting mode 
selector to RUN without having to call the "Limit and enable password legitimation" instruction 
again or taking additional actions on the front panel.

The instruction must always be fully executed, in other words, the F_PWD parameter must 
always have the signal state "0", for example, so that the settings can be saved.

Disabled passwords can be enabled again under the following conditions:

● The CPU is reset to its factory settings.

● The front panel of the S7-1500 CPU supports a dialog that allows you to navigate to the 
appropriate menu in which the passwords can be enabled again.
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● When you call the "Limit and enable password legitimation" instruction, the input parameter 
of the desired password has the signal state "1".

● Set the mode selector to STOP. The restriction to password legitimation is re-established 
as soon as the switch is set back to RUN.

● Plugging a transfer module into an S7-1200 CPU.
 

 Note

The "Limit and enable password legitimation" instruction blocks access to the HMI panel, if 
the HMI password has not been enabled.

 

 Note

Existing legitimized connections retain their access rights and you cannot use the "Limit and 
enable password legitimation" instruction to restrict them.

 

Procedure for lost passwords with an S7-1200 CPU
If you have lost the password for a password-protected CPU, delete the password-protected 
program with an empty transfer card. The empty transfer card deletes the internal load memory 
of the CPU. You can then load a new user program from STEP 7 Basic in the CPU.

 

 WARNING

Inserting transfer card

When you insert a transfer card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

 

You must remove the transfer card before you put the CPU into RUN mode.
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Effects of password use on the operating modes
The following table shows what effects the password use by means of the "Limit and enable 
password legitimation" instruction has on the operating modes and the corresponding user 
actions.

Action Password protection by means of the 
instruction

Basic state after
● Operating mode switch to STOP
● Reset memory manually (PG, switch, change of 

MC (Motion Control))
● Reset to factory setting

Not activated
(no restrictions)

Basic state after POWER ON Enabled (when a lock was activated before 
POWER OFF)
The option of not allowing passwords is 
retentive.

Operating mode transition RUN/STARTUP/HOLD -> 
STOP (by terminating the instruction, an error or 
communication) or STOP -> STARTUP/RUN/HOLD

Activated
Passwords still cannot be used.

Parameters
The following table shows the parameters of the "Limit and enable password legitimation" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L When the REQ 

parameter has the 
signal state "0", the 
currently set signal 
state of the passwords 
is queried.

F_PWD Input BOOL I, Q, M, D, L Read/write access 
including fail-safe
● F_PWD = "0": Do 

not allow password
● F_PWD = "1": 

Allow password
FULL_PWD Input BOOL I, Q, M, D, L Read/write access

● FULL_PWD = "0": 
Do not allow 
password

● FULL_PWD = "1": 
Allow password
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Parameter Declaration Data type Memory area Description
R_PWD Input BOOL I, Q, M, D, L Read access

● R_PWD = "0": Do 
not allow password

● R_PWD = "1": 
Allow password

HMI_PWD Input BOOL I, Q, M, D, L HMI access
● HMI_PWD = "0": 

Do not allow 
password

● HMI_PWD = "1": 
Allow password

F_PWD_ON Output BOOL I, Q, M, D, L Read/write access 
including fail-safe
● F_PWD_ON = "0": 

Password not 
allowed

● F_PWD_ON = "1": 
Password allowed

FULL_PWD_ON Output BOOL I, Q, M, D, L Read/write access 
status
● FULL_PWD_ON = 

"0": Password not 
allowed

● FULL_PWD_ON = 
"1": Password 
allowed

R_PWD_ON Output BOOL I, Q, M, D, L Read-access status
● R_PWD_ON = "0": 

Password not 
allowed

● R_PWD_ON = "1": 
Password allowed

HMI_PWD_ON Output BOOL I, Q, M, D, L HMI-access status
● HMI_PWD_ON = 

"0": Password not 
allowed

● HMI_PWD_ON = 
"1": Password 
allowed

RET_VAL Output WORD I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".
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Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8090 The "Limit and enable password legitimation" instruction is not supported
80D0 The password for fail-safe is not configured
80D1 The read/write access is not configured
80D2 The read access is not configured
80D3 The HMI access is not configured
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of error handling (Page 1378)

Principles of local error handling (Page 1380)

Error output priorities (Page 1381)

Enabling local error handling for a block (Page 1382)

RE_TRIGR: Restart cycle monitoring time

Description
You can use the "Restart cycle monitoring time" instruction to restart the cycle time monitoring 
of the CPU. The cycle monitoring time then starts over for the duration you have set in the 
CPU configuration. 

The instruction "Restart cycle monitoring time" can be called regardless of the priority in all 
blocks.

If the instruction is called in a block with a higher priority, such as a hardware interrupt, a 
diagnostics interrupt or a cyclic interrupt, the instruction is not executed and the ENO enable 
output is set to signal state "0".

The instruction "Restart cycle monitoring time" can be called a maximum of 10 times in a 
program cycle.

Parameters
The instruction "Restart cycle monitoring time" has no parameters.
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See also
Overview of the valid data types (Page 1077)

Basics of error handling (Page 1378)

Principles of local error handling (Page 1380)

Error output priorities (Page 1381)

Enabling local error handling for a block (Page 1382)

STP: Exit program

Description       
The instruction "Exit program" instruction is used to set the CPU to STOP mode and therefore 
to terminate the execution of the program. The effects of changing from RUN to STOP depend 
on the CPU configuration.

When the (RLO) at the input of the instruction is "1", the CPU changes to STOP mode and the 
execution of the program is terminated. The signal state at the output of the instruction is not 
evaluated.

If the RLO at the input of the instruction is "0", then the instruction will not be executed.

Parameters
The instruction "Exit program" has no parameters.

See also
Overview of the valid data types (Page 1077)

GET_ERROR: Get error locally

Description
The "Get error locally" instruction is used to query the occurrence of errors within a block. If 
the system signals errors during block execution, detailed information about the first error that 
occurred is saved in the operand at output ERROR.

Only operands of the system data type "ErrorStruct" can be specified at output ERROR. The 
system data type "ErrorStruct" specifies the exact structure in which the information about the 
error is stored. Using additional instructions, you can evaluate this structure and program an 
appropriate response. When the first error has been eliminated, the instruction outputs 
information about the next error that occurred.
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Parameters
The following table shows the parameters of the "Get error locally" instruction:

Parameter Declaration Data type Memory area Description
ERROR Output ErrorStruct D, L Error information

Data type "ErrorStuct"
The following table shows the structure of the data type ErrorStruct:

Structure component Data type Description
ERROR_ID WORD Error ID
FLAGS BYTE Shows if an error occurred during a block call.

16#01: Error during a block call. 
16#00: No error during a block call. 

REACTION BYTE Default reaction: 
0: Ignore (write error), 
1: Continue with substitute value "0" (read error), 
2: Skip instruction (system error)

CODE_ADDRESS CREF Information on address and type of block
 BLOCK_TYPE BYTE Type of block where the error occurred:

1: OB
2: FC
3: FB

 CB_NUMBER UINT Number of the code block
 OFFSET UDINT Reference to the internal memory
MODE BYTE Access mode: Depending on the type of access, the 

following information can be output:
Mode (A) (B) (C) (D) (E)
0      
1     Offset
2   Area   
3 Location Scope  Numb

er
 

4   Area  Offset
5   Area DB no. Offset
6 PtrNo./

Acc
 Area DB no. Offset

7 PtrNo./
Acc

Slot 
No. / 
Scope

Area DB no. Offset

OPERAND_NUMBER UINT Operand number of the machine command
POINTER_NUMBER_LOCATION UINT (A) Internal pointer
SLOT_NUMBER_SCOPE UINT (B) Storage area in internal memory
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Structure component Data type Description
DATA_ADDRESS NREF Information about the address of an operand
 AREA BYTE (C) Memory area:

L: 16#40 – 4E, 86, 87, 8E, 8F, C0 – CE
I: 16#81
Q: 16#82
M: 16#83
DB: 16#84, 85, 8A, 8B
Range violations for a directly editable tag of data 
type DINT: 16#04

 DB_NUMBER UINT (D) Number of the data block
 OFFSET UDINT (E) Relative address of the operand

Structure components "ERROR_ID"
The following table shows the values that can be output on the structure components 
"ERROR_ID":

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist 
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
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ID*
(hexadecimal)

ID*
(decimal)

Description

2577 9591 Die block property "Parameter assignment via register" is not 
selected.

25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal values in the program editor. For 
information on toggling display formats, refer to "See also".

The enable output ENO of the instruction "Get error locally" instruction is set only if the enable 
input EN returns signal state "1" and error information is present. If one of these conditions 
does not apply, the remaining program execution is not affected by the instruction "Get error 
locally".

The "Get error locally" instruction can also be used to forward an alarm about the error status 
to the calling block. To do this, the instruction must be positioned in the last network of the 
called block.

 

 Note

The "Get error locally" instruction enables local error handling within a block. When "Get error 
locally" is inserted in the program code of a block, any predefined system reactions are 
ignored if errors occur.

 

Example
The following example shows how the instruction works:
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If an error occurs, the instruction "Get error locally" returns the error information to the locally 
created structure "#error" at output ERROR. The error information is converted and evaluated 
with the comparison instruction "Equal to". Information about the type of error is the first 
comparison value assigned to the instruction. For the second comparison value, a value of "1" 
is specified in the operand "substitute". If the error is a read error, the condition of the 
comparison instruction is satisfied. In this case the outputs "#out" and "OK" are reset.

See also
Overview of the valid data types (Page 1077)

Basics of error handling (Page 1378)

Principles of local error handling (Page 1380)

Error output priorities (Page 1381)

Enabling local error handling for a block (Page 1382)

GET_ERR_ID: Get error ID locally

Description
The "Get error ID locally" instruction is used to query the occurrence of errors within a block. 
If the system signals errors during block execution, the error ID of the first error that occurred 
is saved in the tag at output ID. Only tags of the WORD data type can be specified at the ID 
output. When the first error has been eliminated, the instruction outputs the error ID of the next 
error that occurred.

The output of the instruction "Get error ID locally" is only set if the input of the instruction returns 
signal state "1" and error information is present. If one of these conditions does not apply, the 
remaining program execution is not affected by the instruction "Get error ID locally".

The "Get error ID locally" instruction can also be used to forward an alarm about the error 
status to the calling block. To do this, the instruction must be positioned in the last network of 
the called block.

 

 Note

The "Get error ID locally" instruction enables local error handling within a block. When the 
instruction "Get error ID locally" is inserted in the program code of a block, any predefined 
system reactions are ignored if errors occur.

 

Parameters
The following table shows the parameters of the instruction "Get error ID locally":

Parameter Declaration Data type Memory area Description
ID Output WORD I, Q, M, D, L Error ID
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Parameter ID
The following table shows the values that can be output at the ID parameter:

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist 
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 Die block property "Parameter assignment via register" is not 

selected.
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal values in the program editor. For 
information on toggling display formats, refer to "See also".
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See also
Overview of the valid data types (Page 1077)

Basics of error handling (Page 1378)

Principles of local error handling (Page 1380)

Error output priorities (Page 1381)

Enabling local error handling for a block (Page 1382)

INIT_RD: Initialize all retain data

Description
The "Initialize all retain data" instruction is used to reset the retentive data of all data blocks, 
bit memories and SIMATIC timers and counters at the same time. The instruction can only be 
executed within a startup OB because the execution exceeds the program cycle duration.

Parameters
The following table shows the parameters of the "Initialize all retain data" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L, T, C 

or constant
If the input "REQ" 
has the signal 
state "1", all 
retentive data are 
reset.

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".
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Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B5 The instruction cannot be executed because it was not programmed within a startup OB.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal values in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "Tag_REQ" have signal state "1", the instruction is executed. 
All retentive data of all data blocks, bit memories and SIMATIC timers and counters are reset. 
If the instruction is executed without errors, the ENO enable output has the signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of error handling (Page 1378)

Principles of local error handling (Page 1380)

Error output priorities (Page 1381)

Enabling local error handling for a block (Page 1382)

Basics of the EN/ENO mechanism (Page 1167)

GET_ERR_ID: Get error ID locally (Page 2044)

WAIT: Configure time delay

Description     
The "Configure time delay" instruction is used to halt the execution of the program for a set 
period of time. You indicate the period of time in microseconds on the WT parameter of the 
instruction.
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You can configure time delays of up to 32767 microseconds (μs). The smallest possible delay 
time depends on the respective CPU and corresponds to the execution time of the "Configure 
time delay" instruction.

The execution of the instruction can be interrupted by higher priority events.

The "Configure time delay" instruction supplies no error information.

Parameters
The following table shows the parameters of the "Configure time delay" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
WT Input INT I, Q, M, D, L, P or 

constant
Time delay in 
microseconds (μs)

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Word logic operations

AND: AND logic operation

Description     
You can use the instruction "AND logic operation" to link the value at input IN1 to the value at 
input IN2 bit-by-bit by AND logic and query the result at the output OUT.

When the instruction is executed, bit 0 of the value at input IN1 is linked by AND logic to bit 0 
of the value at input IN2. The result is stored in bit 0 of output OUT. The same logic operation 
is executed for all other bits of the specified values.

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box. 
During the execution of the instruction, the values of all available input parameters are linked 
by AND logic. The result is stored at output "OUT".

The result bit has the signal state "1" only when both of the bits in the logic operation also have 
signal state "1". If one of the two bits of the logic operation has signal state "0", the 
corresponding result bit is reset.
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Parameters
The following table shows the parameters of the instruction "AND logic operation":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

First value for 
logic operation

IN2 Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second value 
for logic 
operation

INn Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values

OUT Output Bit strings I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0000 0000 0000 0101

If the operand "TagIn" has the signal state "1", the instruction "AND logic operation" is 
executed. The value of operand "Tag_Value1" is linked by AND to the value of the  operand 
"Tag_Value2". The result is mapped bit-for-bit and sent to the operand "Tag_Result". The 
enable output ENO and the output "TagOut" are set to signal state "1".
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See also
Overview of the valid data types (Page 1077)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Basics of the EN/ENO mechanism (Page 1167)

OR: OR logic operation

Description     
You can use the instruction "OR logic operation" to link the value at input IN1 to the value at 
input IN2 bit-by-bit by OR logic and query the result at the output OUT.

When the instruction is executed, bit 0 of the value at input IN1 is linked by OR logic to bit 0 
of the value at input IN2. The result is stored in bit 0 of output OUT. The same logic operation 
is executed for all bits of the specified tags.

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended in the instruction box. The inserted inputs are numbered in ascending 
order in the box. During the execution of the instruction, the values of all available input 
parameters are linked by OR logic. The result is stored at output "OUT".

The result bit has the signal state "1" when at least one of the two bits in the logic operation 
has the signal state "1". If both of the bits of the logic operation have signal state "0", the 
corresponding result bit is reset.

Parameters
The following table shows the parameters of the instruction "OR logic operation":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

First value for 
logic operation

IN2 Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second value 
for logic 
operation

INn Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values

OUT Output Bit strings I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2050 System Manual, 07/2013,  



Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0101 0101 0101 1111

If the operand "TagIn" has the signal state "1", the instruction "OR logic operation" is executed. 
The value of operand "Tag_Value1" is linked by OR to the value of the  operand "Tag_Value2". 
The result is mapped bit-for-bit and sent to the operand "Tag_Result". The enable output ENO 
and the output "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Basics of the EN/ENO mechanism (Page 1167)

XOR: EXCLUSIVE OR logic operation

Description     
You can use the instruction "EXCLUSIVE OR logic operation" to link the value at input IN1 to 
the value at input IN2 bit-by-bit by EXCLUSIVE OR logic and query the result at the output 
OUT.

When the instruction is executed, bit 0 of the value at input IN1 is linked by EXCLUSIVE OR 
logic to bit 0 of the value at input IN2. The result is stored in bit 0 of output OUT. The same 
logic operation is executed for all other bits of the specified value.

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended in the instruction box. The inserted inputs are numbered in ascending 
order in the box. During the execution of the instruction, the values of all available input 
parameters are linked by EXCLUSIVE OR logic. The result is stored at output "OUT".
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The result bit has the signal state "1" when one of the two bits in the logic operation has the 
signal state "1". If both of the bits of the logic operation have signal state "1" or "0", the 
corresponding result bit is reset.

Parameters
The following table shows the parameters of the instruction "EXCLUSIVE OR logic operation":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

First value for 
logic operation

IN2 Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second value 
for logic 
operation

INn Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values

OUT Output Bit strings I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0101 0101 0101 1010

If the operand "TagIn" has the signal state "1", the instruction "EXCLUSIVE OR logic operation" 
is executed. The value of operand "Tag_Value1" is linked by EXCLUSIVE OR to the value of 
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the operand "Tag_Value2". The result is mapped bit-for-bit and sent to the operand 
"Tag_Result". The enable output ENO and the output "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Adding additional inputs and outputs to FBD elements (Page 1329)

Removing instruction inputs and outputs (Page 1330)

Basics of the EN/ENO mechanism (Page 1167)

INV: Create ones complement

Description       
You can use the instruction "Create ones complement" to invert the signal status of the bits at 
input IN. When the instruction is processed, the value at input IN is linked to EXCLUSIVE OR 
by a hexadecimal mask (W#16#FFFF for 16-bit numbers or DW#16#FFFF FFFF for 32-bit 
number). This inverts the signal state of the individual bits that are then stored at output OUT.

Parameters
The following table shows the parameters of the instruction "Create ones complement":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Bit strings, 
integers

I, Q, M, D, L, P I, Q, M, D, L, P Ones 
complement of 
the value at 
input IN

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value W#16#000F W#16#7E
OUT TagOut_Value W#16#FFF0 W#16#81

If the operand "TagIn" has the signal state "1", the "Create ones complement" instruction is 
executed. The instruction inverts the signal state of the individual bits at input "TagIn_Value" 
and writes the result to output "TagOut_Value". The enable output ENO and the output 
"TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

DECO: Decode

Description     
You can use the "Decode" instruction to set a bit in the output value specified by the input 
value.

The "Decode" instruction reads the value at the IN input and sets the bit in the output value 
whose bit position corresponds to the read value. The other bits in the output value are filled 
with zeroes. If the value at input IN is greater than 31, a modulo 32 instruction is executed.

Parameters
The following table shows the parameters of the "Decode" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
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Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input UINT I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Position of the 
bit in the output 
value which is 
set.

OUT Output Bit strings I, Q, M, D, L, P I, Q, M, D, L, P Output value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following figure shows how the instruction works using specific operand values:

If the operand "TagIn" has the signal state "1", the "Decode" instruction is executed. The 
instruction reads bit number "3" from the value of the operand "TagIn_Value" and sets the third 
bit to the value of the operand "TagOut_Value".

If no errors occur during the execution of the instruction, the output ENO has the signal state 
"1" and the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ENCO: Encode

Description     
The instruction "Encode" is used to read the bit number of the lowest bit in the input value and 
output it to the output OUT.
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The instruction "Encode" selects the least significant bit of the value at the IN input and writes 
its bit number to the tag in the output OUT.

Parameters
The following table shows the parameters of the instruction "Encode":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Bit strings I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

Input value

OUT Output INT I, Q, M, D, L, P I, Q, M, D, L, P Output value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following figure shows how the instruction works using specific operand values:

If the operand "TagIn" has the signal state "1", the "Encode" instruction is executed. The 
instruction selects bit position "3" as the least significant bit at input "TagIn_Value" and writes 
the value "3" to the tag at the output "TagOut_Value.

If the instruction is executed without errors, the ENO enable output has the signal state "1" 
and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2056 System Manual, 07/2013,  



SEL: Select

Description
Depending on the signal state at switch (input G), the "Select" instruction selects one of the 
inputs IN0 or IN1 and moves its content to the output OUT. When the input G has the signal 
state "0", the value at the input IN0 is moved. When the input G has the signal state "1", the 
value at the input IN1 is moved to the output OUT.

The instruction can only be executed if the enable input EN has the signal state "1" and the 
tags at all parameters have the same data type.

Parameters
The following table shows the parameters of the "Select" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable output
G Input BOOL BOOL I, Q, M, D, L 

or constant
I, Q, M, D, L, T, 
C or constant

Switch

IN0 Input Bit strings, 
integers, 
floating-point 
numbers, 
TIME, TOD, 
DATE, CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, DATE, 
CHAR

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

First input value

IN1 Input Bit strings, 
integers, 
floating-point 
numbers, 
TIME, TOD, 
DATE, CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, DATE, 
CHAR

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

Second input value

OUT Output Bit strings, 
integers, 
floating-point 
numbers, 
TIME, TOD, 
DATE, CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, DATE, 
CHAR

I, Q, M, D, L, 
P

I, Q, M, D, L, P Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
G TagIn_G 0 1
IN0 TagIn_Value0 W#16#0000 W#16#4C
IN1 TagIn_Value1 W#16#FFFF W#16#5E
OUT TagOut_Value W#16#0000 W#16#5E

If the operand "TagIn" has the signal state "1", the instruction "Select" is executed. Based on 
the signal state at the "TagIn_G" input, the value of the "TagIn_Value0" or "TagIn_Value1" 
input is selected and moved to the "TagOut_Value" output. If the instruction is executed without 
errors, the enable output ENO has the signal state "1" and the output "TagOut" is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

MUX: Multiplex

Description
You can use the instruction "Multiplex" to copy the content of a selected input to output OUT. 
In its initial state the instruction box contains at least 2 inputs (IN0 and IN1). The number of 
selectable inputs of the instruction box can be expanded. You can declare a maximum of 32 
inputs.

The inputs are numbered automatically in the box. Numbering starts at IN0 and is incremented 
continuously with each new input. You can use the parameter K to determine the input whose 
content should be copied to output OUT. If the value of the parameter K is greater than the 
number of available inputs, the content of the parameter ELSE is copied to output OUT and 
enable output ENO is assigned the signal state "0". 

The "Multiplex" instruction can only be executed if the tags have the same data type in all 
inputs and in the OUT output. The exception here is the parameter K, which can only be 
specified as an integer.

The enable output ENO is reset if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The value of the parameter K is greater than the number of available inputs.

● Errors occurred during the execution of the instruction.

Parameters
The following table shows the parameters of the "Multiplex" instruction:

Parameter Declaring Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

K Input Integers Integers I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Specifies 
the input 
whose 
content is to 
be copied.
● If K = 0 

=> 
Paramet
er IN0

● If K = 1 
=> 
Paramet
er IN1, 
etc.

IN0 Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

First input 
value

IN1 Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Second 
input value
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Parameter Declaring Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

INn Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Optional 
input values

ELSE Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Specifies 
the value to 
be copied 
when K > n.

OUT Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Output to 
which the 
value is to 
be copied.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
K Tag_Number 1
IN0 Tag_ValueI_0 DW#16#00000000
IN1 Tag_Value_1 DW#16#003E4A7D
ELSE Tag_Value_2 DW#16#FFFF0000
OUT Tag_Result DW#16#003E4A7D

If the operand "Tag_Input" has the signal state "1", the "Multiplex" instruction is executed. 
Depending on the value of the operand "Tag_Number", the value at input "Tag_Value_1" is 
copied and assigned to the operand at output "Tag_Result". If no errors occur during the 
execution of the instruction, the outputs ENO and "Tag_Output" are set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

DEMUX: Demultiplex

Description
You can use the instruction "Demultiplex" to copy the content of the input IN to a selected 
output. In its initial state the instruction box contains at least 2 outputs (OUT0 and OUT1). The 
number of selectable outputs can be extended in the instruction box. The outputs are numbered 
automatically in the box. Numbering starts at OUT0 and continues consecutively with each 
new output. You can use the parameter K to define the output to which the content of input IN 
will be copied. The other outputs will not be changed. If the value of the parameter K is greater 
than the number of available outputs, then the content of input IN in the parameter ELSE and 
the enable output ENO will be assigned to the signal state "0".

The instruction "Demultiplex" can only be executed if the tags at the input IN and at all outputs 
are of the same data type. The exception here is the parameter K, which can only be specified 
as an integer.
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The enable output ENO is reset if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value of the parameter K is greater than the number of available outputs.

● Errors occurred during the execution of the instruction.

Parameters
The following table shows the parameters of the instruction "Demultiplex":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, 
L, T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L Enable output

K Input Integers Integers I, Q, M, D, 
L, P or 
constant

I, Q, M, D, 
L, P or 
constant

Specifies the 
output to which 
the input value 
(IN) will be copied.
● If K = 0 => 

Parameter 
OUT0

● If K = 1 => 
Parameter 
OUT1, etc.

IN Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P or 
constant

I, Q, M, D, 
L, P or 
constant

Input value

OUT0 Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P

I, Q, M, D, 
L, P

First output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

OUT1 Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P

I, Q, M, D, 
L, P

Second output

OUTn Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P

I, Q, M, D, 
L, P

Optional outputs

ELSE Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P

I, Q, M, D, 
L, P

Output to which 
the input value 
(IN) at K > n is 
copied.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on available data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following tables show how the instruction works using specific operand values:

Table 9-26 Input values of the "Demultiplex" instruction before network execution

Parameter Operand Values
K Tag_Number 1 4
IN Tag_Value DW#16#FFFFFFFF DW#16#003E4A7D

Table 9-27 Output values of the "Demultiplex" instruction after network execution

Parameter Operand Values
OUT0 Tag_Output_0 Unchanged Unchanged
OUT1 Tag_Output_1 DW#16#FFFFFFFF Unchanged
ELSE Tag_Output_2 Unchanged DW#16#003E4A7D

The "Demultiplex" instruction is executed when input "Tag_Input" has the signal state "1". 
Depending on the value of the operand "Tag_Number", the value at input "IN" is copied to the 
corresponding output.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Shift and rotate

SHR: Shift right

Description
You can use the "Shift right" instruction to shift the content of the operand at the input IN bit-
by-bit to the right and query the result at the OUT output. The input N is used to specify the 
number of bit positions by which the specified value should be moved.
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If the value at the input N is "0", the value at input IN is copied unchanged to the operand at 
output OUT.

If the value at the input N is greater than the number of available bit positions, the operand 
value at input IN is shifted to the right by the available number of bit positions.

The freed bit positions in the left area of the operand are filled by zeroes when values without 
signs are shifted. If the specified value has a sign, the free bit positions are filled with the signal 
state of the sign bit.

The following figure show how the content of an integer data type operand is shifted four bit 
positions to the right:

Parameters
The following table shows the parameters of the instruction "Shift right":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Value to be 
shifted

N Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Number of 
bit positions 
by which the 
value is 
shifted

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L I, Q, M, D, L Result of the 
instruction

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2065



You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
N Tag_Number 3
OUT TagOut_Value 0000 0111 1111 0101

If the operand "TagIn" has the signal state "1", the instruction "Shift right" is executed. The 
content of the operand "TagIn_Value" is shifted three bit positions to the right. The result is 
sent at output "TagOut_Value". If the instruction is executed without errors, the ENO enable 
output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SHL: Shift left

Description
You can use the "Shift left" instruction to shift the content of the operand at the input IN bit-by-
bit to the left and query the result at the OUT output. The input N is used to specify the number 
of bit positions by which the specified value should be moved.

If the value at the input N is "0", the value at input IN is copied unchanged to the operand at 
output OUT.

If the value at the input N is greater than the number of available bit positions, the operand 
value at input IN is shifted to the left by the available number of bit positions.

The bit positions in the right part of the operand freed by shifting are filled with zeros.
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The following figure show how the content of an operand of the data type WORD is shifted six 
bit positions to the left:

Parameters
The following table shows the parameters of the instruction "Shift left":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Value to be 
shifted.

N Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Number of 
bit positions 
by which the 
value is 
shifted.

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
N Tag_Number 4
OUT TagOut_Value 1111 1010 1111 0000

If the operand "TagIn" has the signal state "1", the instruction "Shift left" is executed. The 
content of the operand "TagIn_Value" is shifted four bit positions to the left. The result is sent 
at output "TagOut_Value". If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ROR: Rotate right

Description
You can use the "Rotate right" instruction to rotate the content of the operand at the input IN 
bit-by-bit to the right and query the result at the OUT output. The input N is used to specify the 
number of bit positions by which the specified value should be rotated. The bit positions freed 
by rotating on the left-hand side are filled true-to-position with the bit positions that are pushed 
out from the left-hand side.

If the value at the input N is "0", the value at input IN is copied unchanged to the operand at 
output OUT.

If the value at the parameter N is greater than the number of available bit positions, the operand 
value at input IN is nevertheless rotated by the specified number of bit positions.

The following figure shows how the content of an operand of the data type DWORD is rotated 
three bit positions to the right:
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Parameters
The following table shows the parameters of the instruction "Rotate right":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Value to be 
rotated

N Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Number of 
bit positions 
by which the 
value is 
rotated

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0000 1111 1001 0101
N Tag_Number 5
OUT TagOut_Value 1010 1000 0111 1100

If the operand "TagIn" has the signal state "1", the instruction "Rotate right" is executed. The 
content of the operand "TagIn_Value" is rotated five bit positions to the right. The result is sent 
at output "TagOut_Value". If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

ROL: Rotate left

Description
You can use the "Rotate left" instruction to rotate the content of the operand at the input IN bit-
by-bit to the left and query the result at the OUT output. The input N is used to specify the 
number of bit positions by which the specified value should be rotated. The bit positions freed 
by rotating on the right-hand side are filled true-to-position with the bit positions that are pushed 
out from the left-hand side.

If the value at the input N is "0", the value at input IN is copied to the operand at output OUT.

If the value at the parameter N is greater than the number of available bit positions, the operand 
value at input IN is nevertheless rotated by the specified number of bit positions.

The following figure shows how the content of an operand of the data type DWORD is rotated 
three bit positions to the left:
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Parameters
The following table shows the parameters of the instruction "Rotate left":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Value to be 
rotated.

N Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Number of 
bit positions 
by which the 
value is 
rotated.

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 1010 1000 1111 0110
N Tag_Number 5
OUT TagOut_Value 0001 1110 1101 0101

If input "TagIn" has the signal state "1", the instruction "Rotate left" is executed. The content 
of the operand "TagIn_Value" is rotated five bit positions to the left. The result is sent at output 
"TagOut_Value". If the instruction is executed without errors, the ENO enable output has the 
signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

Additional instructions

DRUM: Implement sequencer

Description
You can use the "Implement sequencer" instruction to assign the programmed values of the 
OUT_VAL parameter of the corresponding step to the programmed output bits (OUT1 to 
OUT16) and the output word (OUT_WORD). The specific step must thereby satisfy the 
conditions of the programmed enable mask on the S_MASK parameter while the instruction 
remains at this step. The instruction advances to the next step if the event for the step is true 
and the programmed time for the current step elapses, or if the value at the JOG parameter 
changes from "0" to "1". The instruction is reset if the signal state on the RESET parameter 
changes to "1". The current step is hereby equated to the preset step (DSP).

The amount of time spent on a step is determined by the product of the preset timebase (DTBP) 
and the preset counter value (S_PRESET) for each step. At the start of a new step, this 
calculated value is loaded into the DCC parameter, which contains the time remaining for the 
current step. If, for example the value at the DTBP parameter is "2" and the preset value for 
the first step is "100" (100 ms), the DCC parameter has the value "200" (200 ms).
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A step can be programmed with a timer value, an event, or both. Steps that have an event bit 
and the timer value "0" advance to the next step as soon as the signal state of the event bit is 
"1". Steps that are programmed only with a timer value start the time immediately. Steps that 
are programmed with an event bit and a timer value greater than "0" start the time when the 
signal state of the event bit is "1". The event bits are initialized with a signal state of "1".

When the sequencer is on the last programmed step (LST_STEP) and the time for this step 
has expired, the signal state on the Q parameter is set to "1"; otherwise it is set to "0". When 
the parameter Q is set, the instruction remains on the step until it is reset.

In the configurable mask (S_MASK) you can select the separate bits in the output word 
(OUT_WORD) and set or reset the output bits (OUT1 to OUT16) by means of the output values 
(OUT_VAL). If a bit of the configurable mask is in the signal state "1", the value OUT_VAL sets 
or resets the corresponding bit. If the signal state of a bit of the configurable mask is "0", the 
corresponding bit is left unchanged. All the bits of the configurable mask for all 16 steps are 
initialized with a signal state of "1".

The output bit on the OUT1 parameter corresponds to the least significant bit of the output 
word (OUT_WORD). The output bit on the OUT16 parameter corresponds to the most 
significant bit of the output word (OUT_WORD).

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Implement sequencer" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
RESET Input BOOL I, Q, M, D, L or 

constant
A signal state of 
"1" indicates a 
reset condition.

JOG Input BOOL I, Q, M, D, L or 
constant

When the signal 
state changes 
from "0" to "1", the 
instruction 
advances to the 
next step.

DRUM_EN Input BOOL I, Q, M, D, L or 
constant

A signal state of 
"1" allows the 
sequencer to 
advance based on 
the event and time 
criteria.

LST_STEP Input BYTE I, Q, M, D, L or 
constant

Number of the last 
programmed step
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Parameter Declaration Data type Memory area Description
EVENT(i),
1 ≤ i ≤ 16

Input BOOL I, Q, M, D, L or 
constant

Event bit (i);
Initial signal state 
is "1".

OUT(j),
1 ≤ j ≤ 16

Output BOOL I, Q, M, D, L Output bit (j)

Q Output BOOL I, Q, M, D, L A signal state of 
"1" indicates that 
the time for the last 
step has elapsed.

OUT_WORD Output WORD I, Q, M, D, L, P Word address to 
which the 
sequencer writes 
the output values.

ERR_CODE Output WORD I, Q, M, D, L, P Error information
JOG_HIS Static BOOL I, Q, M, D, L JOG parameter 

history bit
EOD Static BOOL I, Q, M, D, L A signal state of 

"1" indicates that 
the time for the last 
step has elapsed.

DSP Static BYTE I, Q, M, D, L, P Preset step of the 
sequencer

DSC Static BYTE I, Q, M, D, L, P Current step of the 
sequencer

DCC Static DWORD I, Q, M, D, L, P Current numerical 
value of the 
sequencer

DTBP Static WORD I, Q, M, D, L, P Preset timebase of 
the sequencer

PREV_TIME Static DWORD I, Q, M, D, L or 
constant

Previous system 
time

S_PRESET Static ARRAY of WORD I, Q, M, D, L Count preset for 
each step [1 to 16]; 
whereby 1 count = 
1 ms.

OUT_VAL Static ARRAY of BOOL I, Q, M, D, L Output values for 
each step [1 to 16, 
0 to 15].

S_MASK Static ARRAY of BOOL I, Q, M, D, L Configurable 
mask for each 
step [1 to 16, 
0 to 15]. Initial 
signal states are 
"1".

For additional information on valid data types, refer to "See also".
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Parameter ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

ERR_CODE* Explanation
W#16#0000 No error
W#16#000B The value at the LST_STEP parameter is less than 1 or greater than 16.
W#16#000C The value at the DSC parameter is less than 1 or greater than the value at 

the LST_STEP parameter.
W#16#000D The value at the DSP parameter is less than 1 or greater than the value at 

the LST_STEP parameter.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

DCAT: Discrete control-timer alarm

Description
The "Discrete control-timer alarm" instruction is used to accumulate the time from the point at 
which the CMD parameter issued the command to open or close. The time is accumulated 
until the preset time (PT) is exceeded or the information is received that the device was opened 
or closed (O_FB or C_FB) within the specified time. If the preset time is exceeded before the 
information on the opening or closing of the device is received, the corresponding alarm is 
activated. If the signal state on the command input changes state before the preset time, the 
time is restarted.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The "Discrete control-timer alarm" instruction has the following reactions to the input conditions:

● When the signal state of the CMD parameter changes from "0" to "1", the signal states of 
the parameters Q, CMD_HIS, ET (only if  ET is < PT) OA and CA are influenced as follows:

– The parameters Q and CMD_HIS are set to "1".

– The parameters ET, OA and CA are reset to "0".

● When the signal state on the parameter CMD changes from "1" to "0", the parameters Q, 
ET (only if ET is < PT), OA, CA and CMD_HIS are reset to "0".
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● When the signal state of the CMD and CMD_HIS parameters is "1" and the parameter O_FB 
is set to "0", the time difference (ms) since the last execution of the instruction is added to 
the value at the parameter ET. If the value of the parameter ET exceeds the value of the 
parameter PT, the signal state on the parameter OA is set to "1". If the value of the 
parameter ET does not exceed the value of the parameter PT, the signal state on the 
parameter OA is reset to "0". The value at the parameter CMD_HIS is reset to the value of 
the parameter CMD.

● If the signal state of the parameters CMD, CMD_HIS and O_FB are set to "1" and the 
parameter C_FB has the value "0", the signal state of the parameter OA is set to "0". The 
value of the parameter ET is set to the value of the parameter PT. If the signal state of the 
parameter O_FB changes to "0", the alarm is set the next time the instruction is executed. 
The value of the parameter CMD_HIS is set to the value of the parameter CMD.

● If the CMD, CMD_HIS and C_FB parameters return signal state "0", the time difference 
(ms) since the last execution of the instruction is added to the value of the ET parameter. 
If the value of the parameter ET exceeds the value of the parameter PT, the signal state 
of the parameter CA is reset to "1". If the value at the parameter PT is not exceeded, the 
parameter CA has the signal state "0". The value of the parameter CMD_HIS is set to the 
value of the parameter CMD.

● If the parameters CMD, CMD_HIS and O_FB have the signal state "0" and the parameter 
C_FB is set to "1", the parameter CA is set to "0". The value of the parameter ET is set to 
the value of the parameter PT. If the signal state of the parameter C_FB changes to "0", 
the alarm is set the next time the instruction is executed. The value of the parameter 
CMD_HIS is set to the value of the parameter CMD.

● If the parameters O_FB and C_FB simultaneously have the signal state "1", the signal states 
of both alarm outputs are set to "1".

The "Discrete control-timer alarm" instruction has no error information.

Parameters
The following table shows the parameters of the "Discrete control-timer alarm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
CMD Input BOOL I, Q, M, D, L or 

constant
A signal state of 
"0" indicates a 
"close" 
command.
A signal state of 
"1" indicates an 
"open" 
command.

O_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when opening

C_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when closing
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Parameter Declaration Data type Memory area Description
Q Output BOOL I, Q, M, D, L Shows the 

status of the 
parameter CMD

OA Output BOOL I, Q, M, D, L Alarm output 
when opening

CA Output BOOL I, Q, M, D, L Alarm output 
when closing

ET Static DINT D, L Currently 
elapsed time, 
where one count 
= 1 ms.

PT Static DINT D, L Preset timer 
value, where 
one count = 1 
ms.

PREV_TIME Static DWORD D, L Previous system 
time

CMD_HIS Static BOOL D, L  CMD history bit

For additional information on valid data types, refer to "See also".

Example
In the following example the parameter CMD changes from "0" to "1". After the execution of 
the instruction the parameter Q is set to "1" and the two alarm outputs OA and CA have the 
signal state "0". The parameter CMD_HIS of the instance data block is set to the signal state 
"1" and the parameter ET is reset to "0".

 

 Note

You can initialize static parameters in the data block.
 

The following tables show how the instruction works using specific values.

Before processing

In this example, the following values are used for the input and output parameters:
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Parameter Operand Value
CMD Tag_Input_CMD TRUE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
Q Tag_Output_Q FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#12
PT DBD8 L#222
CMD_HIS DBX16.0 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
Q Tag_Output_Q TRUE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
CMD_HIS DBX16.0 TRUE

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

MCAT: Motor control-timer alarm

Description
The instruction "Motor control-timer alarm" is used to accumulate the time from the point of 
time from which the one of the command inputs (opening or closing) is switched on. The time 
is accumulated until the preset time is exceeded or the relevant feedback input indicates that 
the device has executed the requested operation within the specified time. If the preset time 
is exceeded before the feedback is received, the corresponding alarm is triggered.
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When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The "Motor control-timer alarm" instruction returns no error information.

Execution of the "Motor control-timer alarm" instruction
The following table shows the reactions of the instruction "Motor control-timer alarm" to the 
various input conditions:

Input parameters Output parameters
ET O_H

IS
C_H
IS

O_C
MD

C_C
MD

S_C
MD

O_F
B

C_F
B

OO CO OA CA ET O_H
IS

C_H
IS

Q Status

X 1 1 X X X X X 0 0 1 1 PT 0 0 0 Alarm
X X X X X X 1 1 0 0 1 1 PT 0 0 0 Alarm
X X X X X 1 X X 0 0 0 0 X 0 0 1 Stop
X X X 1 1 X X X 0 0 0 0 X 0 0 1 Stop
X 0 X 1 0 0 X X 1 0 0 0 0 1 0 1 Start 

opening
<PT 1 0 X 0 0 0 X 1 0 0 0 INC 1 0 1 Open
X 1 0 X 0 0 1 0 0 0 0 0 PT 1 0 1 Opened
>=P
T

1 0 X 0 0 0 X 0 0 1 0 PT 1 0 0 Opening 
alarm

X X 0 0 1 0 X X 0 1 0 0 0 0 1 1 Start closing
<PT 0 1 0 X 0 X 0 0 1 0 0 INC 0 1 1 Close
X 0 1 0 X 0 0 1 0 0 0 0 PT 0 1 1 Closed
>=P
T

0 1 0 X 0 X 0 0 0 0 1 PT 0 1 0 Closing 
alarm

X 0 0 0 0 0 X X 0 0 0 0 X 0 0 1 Stopped
Legend:
INC Add the time difference (ms) since the last processing of the FB to ET
PT PT is set to the same value as ET
X Cannot be used
<PT ET < PT
>=PT ET >= PT
If the input parameters O_HIS and C_HIS both have the signal state "1", they are immediately set to signal state "0". In this 
case, the last row of the above-named table (X) is valid. Because it is therefore no longer possible to check whether the 
input parameters O_HIS and C_HIS have the signal state "1", the output parameters are set as follows in this case: 
OO = FALSE
CO = FALSE
OA = FALSE
CA = FALSE
ET = PT
Q = TRUE
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Parameters
The following table shows the parameters of the "Motor control-timer alarm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
O_CMD Input BOOL I, Q, M, D, L or 

constant
"Open" command 
input

C_CMD Input BOOL I, Q, M, D, L or 
constant

"Close" command 
input

S_CMD Input BOOL I, Q, M, D, L or 
constant

"Stop" command 
input

O_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when opening

C_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when closing

OO Output BOOL I, Q, M, D, L "Open" output
CO Output BOOL I, Q, M, D, L "Close" output
OA Output BOOL I, Q, M, D, L Alarm output when 

opening
CA Output BOOL I, Q, M, D, L Alarm output when 

closing
Q Output BOOL I, Q, M, D, L A signal state of 

"0" indicates an 
error condition.

ET Static DINT D, L Currently elapsed 
time, where one 
count = 1 ms

PT Static DINT D, L Preset timer value, 
where one count = 
1 ms

PREV_TIME Static DWORD D, L Previous system 
time

O_HIS Static BOOL D, L "Open" history bit
C_HIS Static BOOL D, L "Close" history bit

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
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The following tables show how the instruction works using specific values.

Before processing

In this example, the following values are used for the input and output parameters:

Parameter Operand Value
O_CMD Tag_Input_O_CMD TRUE
C_CMD Tag_Input_C_CMD FALSE
S_CMD Tag_Input_S_CMD FALSE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
OO Tag_OutputOpen FALSE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q FALSE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#2
PT DBD8 L#22
O_HIS DBX16.0 TRUE
C_HIS DBX16.1 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:
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Parameter Operand Value
OO Tag_OutputOpen TRUE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q TRUE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
O_HIS DBX16.0 TRUE
CMD_HIS DBX16.1 FALSE

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

IMC: Compare input bits with the bits of a mask

Description
The instruction "Compare input bits with the bits of a mask" is used to compare the signal state 
of up to 16 programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bits of a mask. 
Up to 16 steps with masks can be programmed. The value of the IN_BIT0 parameter  is 
compared with the value of the mask CMP_VAL[x,0], with "x" indicating the step number. At 
the CMP_STEP parameter, specify the step number of the mask that is used for the 
comparison.  All programmed values are compared in the same manner. Unprogrammed input 
bits or unprogrammed bits of the mask have a default signal state of FALSE.

If a match is found in the comparison, the signal state of the OUT parameter is set to "1". 
Otherwise the OUT parameter is set to "0".

If the value of CMP_STEP parameter is greater than 15, the instruction is not executed. An 
error message is output at the ERR_CODE parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".
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Parameters
The following table shows the parameters of the "Compare input bits with the bits of a mask" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, 

C
Enable input

ENO Output BOOL I, Q, M, D, L Enable output
IN_BIT0 Input BOOL I, Q, M, D, L or 

constant
Input bit 0 to be compared 
with bit 0 of the mask.

IN_BIT1 Input BOOL I, Q, M, D, L or 
constant

Input bit 1 to be compared 
with bit 1 of the mask.

IN_BIT2 Input BOOL I, Q, M, D, L or 
constant

Input bit 2 to be compared 
with bit 2 of the mask.

IN_BIT3 Input BOOL I, Q, M, D, L or 
constant

Input bit 3 to be compared 
with bit 3 of the mask.

IN_BIT4 Input BOOL I, Q, M, D, L or 
constant

Input bit 4 to be compared 
with bit 4 of the mask.

IN_BIT5 Input BOOL I, Q, M, D, L or 
constant

Input bit 5 to be compared 
with bit 5 of the mask.

IN_BIT6 Input BOOL I, Q, M, D, L or 
constant

Input bit 6 to be compared 
with bit 6 of the mask.

IN_BIT7 Input BOOL I, Q, M, D, L or 
constant

Input bit 7 to be compared 
with bit 7 of the mask.

IN_BIT8 Input BOOL I, Q, M, D, L or 
constant

Input bit 8 to be compared 
with bit 8 of the mask.

IN_BIT9 Input BOOL I, Q, M, D, L or 
constant

Input bit 9 to be compared 
with bit 9 of the mask.

IN_BIT10 Input BOOL I, Q, M, D, L or 
constant

Input bit 10 to be compared 
with bit 10 of the mask.

IN_BIT11 Input BOOL I, Q, M, D, L or 
constant

Input bit 11 to be compared 
with bit 11 of the mask.

IN_BIT12 Input BOOL I, Q, M, D, L or 
constant

Input bit 12 to be compared 
with bit 12 of the mask.

IN_BIT13 Input BOOL I, Q, M, D, L or 
constant

Input bit 13 to be compared 
with bit 13 of the mask.

IN_BIT14 Input BOOL I, Q, M, D, L or 
constant

Input bit 14 to be compared 
with bit 14 of the mask.

IN_BIT15 Input BOOL I, Q, M, D, L or 
constant

Input bit 15 to be compared 
with bit 15 of the mask.

CMP_STEP Input BYTE I, Q, M, D, L, P 
or constant

The step number of the 
mask used for the 
comparison.

OUT Output BOOL I, Q, M, D, L A signal state of "1" 
indicates that a match was 
found.
A signal state of "0" 
indicates that no match was 
found.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2083



Parameter Declaration Data type Memory area Description
ERR_CODE Output WORD I, Q, M, D, L, P Error information 
CMP_VAL Static ARRAY OF 

WORD
I, Q, M, D, L Comparison masks [0 to 15, 

0 to 15]: The first number of 
the index is the step number 
and the second number is 
the bit number of the mask.

For additional information on valid data types, refer to "See also".

Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000A The value at the CMP_STEP parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SMC: Compare scan matrix

Description
The instruction "Compare scan matrix" is used to compare the signal state of up to 16 
programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bits of the comparison 
masks for each step. Processing starts at step 1 and is continued until the last programmed 
step (LAST), or until a match is found. The input bit of the IN_BIT0 parameter is compared with 
the value of the mask CMP_VAL[x,0], with "x" indicating the step number. All programmed 
values are compared in the same manner. If a match is found, the signal state of the OUT 
parameter is set to "1" and the step number with the matching mask is written to the OUT_STEP 
parameter. Unprogrammed input bits or unprogrammed bits of the mask have the default signal 
state FALSE. If more than one step has a matching mask, only the first one found is indicated 
in the OUT_STEP parameter. If no match is found, the signal state of the OUT parameter is 
set to "0". In this case the value at the OUT_STEP parameter is greater by "1" than the value 
at the LAST parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2084 System Manual, 07/2013,  



Parameters
The following table shows the parameters of the "Compare scan matrix" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, 

C
Enable input

ENO Output BOOL I, Q, M, D, L Enable output
IN_BIT0 Input BOOL I, Q, M, D, L or 

constant
Input bit 0 to be compared 
with bit 0 of the mask.

IN_BIT1 Input BOOL I, Q, M, D, L or 
constant

Input bit 1 to be compared 
with bit 1 of the mask.

IN_BIT2 Input BOOL I, Q, M, D, L or 
constant

Input bit 2 to be compared 
with bit 2 of the mask.

IN_BIT3 Input BOOL I, Q, M, D, L or 
constant

Input bit 3 to be compared 
with bit 3 of the mask.

IN_BIT4 Input BOOL I, Q, M, D, L or 
constant

Input bit 4 to be compared 
with bit 4 of the mask.

IN_BIT5 Input BOOL I, Q, M, D, L or 
constant

Input bit 5 to be compared 
with bit 5 of the mask.

IN_BIT6 Input BOOL I, Q, M, D, L or 
constant

Input bit 6 to be compared 
with bit 6 of the mask.

IN_BIT7 Input BOOL I, Q, M, D, L or 
constant

Input bit 7 to be compared 
with bit 7 of the mask.

IN_BIT8 Input BOOL I, Q, M, D, L or 
constant

Input bit 8 to be compared 
with bit 8 of the mask.

IN_BIT9 Input BOOL I, Q, M, D, L or 
constant

Input bit 9 to be compared 
with bit 9 of the mask.

IN_BIT10 Input BOOL I, Q, M, D, L or 
constant

Input bit 10 to be compared 
with bit 10 of the mask.

IN_BIT11 Input BOOL I, Q, M, D, L or 
constant

Input bit 11 to be compared 
with bit 11 of the mask.

IN_BIT12 Input BOOL I, Q, M, D, L or 
constant

Input bit 12 to be compared 
with bit 12 of the mask.

IN_BIT13 Input BOOL I, Q, M, D, L or 
constant

Input bit 13 to be compared 
with bit 13 of the mask.

IN_BIT14 Input BOOL I, Q, M, D, L or 
constant

Input bit 14 to be compared 
with bit 14 of the mask.

IN_BIT15 Input BOOL I, Q, M, D, L or 
constant

Input bit 15 to be compared 
with bit 15 of the mask.

OUT Output BOOL I, Q, M, D, L A signal state of "1" 
indicates that a match was 
found.
A signal state of "0" 
indicates that no match 
was found. 

ERR_CODE Output WORD I, Q, M, D, L, P Error information 
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Parameter Declaration Data type Memory area Description
OUT_STEP Output BYTE I, Q, M, D, L, P Contains the step number 

with the matching mask, or 
the step number which is 
greater by "1" than the 
value at the LAST 
parameter, provided no 
match is found.

LAST Static BYTE I, Q, M, D, L, P Specifies the step number 
of the last step to be 
scanned for a matching 
mask.

CMP_VAL Static ARRAY OF WORD I, Q, M, D, L Comparison masks [0 to 
15, 0 to 15]: The first 
number of the index is the 
step number and the 
second number is the bit 
number of the mask.

For additional information on valid data types, refer to "See also".

Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000E The value at the LAST parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

LEAD_LAG: Lead and lag algorithm 

Description
The "Lead and lag algorithm" instruction is used to process signals with an analog tag. The 
gain value at the GAIN parameter must be greater than zero. The result of the instruction "Lead 
and lag algorithm" is calculated using the following equation:
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The "Lead and lag algorithm" instruction supplies plausible results only when processing is in 
fixed program cycles. The same units must be specified for the LD_TIME, LG_TIME, and 
SAMPLE_T parameters. At LG_TIME > 4 + SAMPLE_T, the instruction approaches the 
following function:

OUT = GAIN * ((1 + LD_TIME * s) / (1 + LG_TIME * s)) * IN

When the value of the GAIN parameter is less than or equal to zero, the calculation is not 
performed and an error information is output on the ERR_CODE parameter.

You can use the "Lead and lag algorithm" instruction in conjunction with loops as a 
compensator in dynamic feed-forward control. The instruction consists of two operations. The 
"Lead" operation shifts the phase of the OUT output so that the output leads the input. The 
"Lag" operation, on the other hand, shifts the output so that the output lags behind the input. 
Because the "Lag" operation is equivalent to an integration, it can be used as a noise 
suppressor or as a low-pass filter. The "Lead" operation is equivalent to a differentiation and 
can therefore be used as a high-pass filter. The two instructions together (Lead and Lag) result 
in the output phase lagging behind the the input at lower frequencies and leading it at higher 
frequencies. This means that the "Lead and lag algorithm" instruction can be used as a band 
pass filter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find this in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Lead and lag algorithm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input REAL I, Q, M, D, L, P or 

constant
The input value of 
the current sample 
time (cycle time) to 
be processed.

SAMPLE_T Input INT I, Q, M, D, L, P or 
constant

Sample time

OUT Output REAL I, Q, M, D, L, P Result of the 
instruction

ERR_CODE Output WORD I, Q, M, D, L, P Error information 
LD_TIME Static REAL I, Q, M, D, L, P or 

constant
Lead time in the 
same unit as 
sample time.

LG_TIME Static REAL I, Q, M, D, L, P or 
constant

Lag time in the 
same unit as 
sample time

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2087



Parameter Declaration Data type Memory area Description
GAIN Static REAL I, Q, M, D, L, P or 

constant
Gain as % / % (the 
ratio of the change 
in output to a 
change in input as 
a steady state).

PREV_IN Static REAL I, Q, M, D, L, P or 
constant

Previous input

PREV_OUT Static REAL I, Q, M, D, L, P or 
constant

Previous output

For additional information on valid data types, refer to "See also".

Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0009 The value at the GAIN parameter is less than or equal to zero.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
 

The following table shows how the instruction works using specific operand values: 

Before processing

In this example the following values are used for the input parameters:
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Parameters Operand Value
IN Tag_Input 2.0
SAMPLE_T Tag_InputSampleTime 10

The following values are saved in the instance data block "LEAD_LAG_DB" of the instruction:

Parameters Address Value
LD_TIME DBD12 2.0
LG_TIME DBD16 2.0
GAIN DBD20 1.0
PREV_IN DBD24 6.0
PREV_OUT DBD28 6.0

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameters Operand Value
OUT Tag_Output_Result 2.0

The following values are saved in the instance data block "LEAD_LAD_DB" of the instruction:

Parameters Operand Value
PREV_IN DBD24 2.0
PREV_OUT DBD28 2.0

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

SEG: Create bit pattern for seven-segment display

Description
The instruction "Create bit pattern for seven-segment display" is used to convert each of the 
four hexadecimal digits of the specified source word (IN) into an equivalent bit pattern for a 
seven-segment display. The result of the instruction is output in the double word on the OUT 
parameter.

The following relation exists between the hexadecimal digits and the assignment of the 7 
segments (a, b, c, d, e, f, g):

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2089



Input digit 
(Binary)

Assignment of the 
segments
‑ g f e d c b a

Display
(Hexadecimal)

Seven-segment display

0000 00111111 0
0001 00000110 1
0010 01011011 2
0011 01001111 3
0100 01100110 4
0101 01101101 5
0110 01111101 6
0111 00000111 7
1000 01111111 8
1001 01100111 9
1010 01110111 A
1011 01111100 B
1100 00111001 C
1101 01011110 D
1110 01111001 E
1111 01110001 F

Parameters
The following table shows the parameters of the "Create bit pattern for seven-segment display" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input WORD I, Q, M, D, L, P or 

constant
Source word with 
four hexadecimal 
digits

OUT Output DWORD I, Q, M, D, L, P Bit pattern for the 
seven-segment 
display

Example
The following example shows how the instruction works:
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The following table shows how the instruction functions using specific values:

Parameters Operand Value
Hexadecimal Binary
IN Tag_Input W#16#1234 0001 0010 0011 0100
OUT Tag_Output DW#16065B4F66 00000110 01011011 01001111 

01100110
Display: 1234

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

BCDCPL: Create tens complement

Description
You use the "Create tens complement" instruction to create the tens complement of a seven-
digit BCD number specified in the IN parameter. This instruction uses the following 
mathematical formula to calculate:

10000000 (as BCD)

– 7-digit BCD value

----------------------------------------

Tens complement (as BCD)

Parameters
The following table shows the parameters of the "Create tens complement" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input DWORD I, Q, M, D, L, P or 

constant
7-digit BCD 
number

ERR_CODE Output DWORD I, Q, M, D, L, P Result of the 
instruction
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Example
The following example shows how the instruction works:

The following table shows how the instruction functions using specific values:

Parameter Operand Value*
IN Tag_Input DW#16#01234567
ERR_CODE Tag_Output DW#16#08765433
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

BITSUM: Count number of set bits

Description
The "Count number of set bits" instruction is used to count the number of bits of an operand 
that is set to the signal state "1". The operand whose bits are to be counted is specified on the 
IN parameter. The result of the instruction is output at the RET_VAL parameter.

Parameters
The following table shows the parameters of the "Count number of set bits" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input DWORD I, Q, M, D, L, P or 

constant
Operand whose 
set bits are 
counted.

RET_VAL Output INT I, Q, M, D, L, P Number of bits to 
be set
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Example
The following example shows how the instruction works:

The following table shows how the instruction functions using specific values:

Parameter Operand Value*
IN Tag_Input DW#16#12345678
RET_VAL Tag_Output W#16#000D (13 Bits)
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Basics of the EN/ENO mechanism (Page 1167)

9.7.2.3 SCL

Bit logic operations

R_TRIG: Set tag on positive signal edge

Description
You can use the "Set tag on positive signal edge" instruction to set a specified tag in the 
instance DB when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the result of 
logic operation (RLO) from "0" to "1", there is a positive, rising edge.

If a positive edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find it in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".
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Syntax
Use the following syntax for the "Set tag on positive signal edge" instruction:

SCL
<Instance_DB>(CLK := <Operand>,
             Q => <Operand>)

Parameter
The following table shows the parameters of the instruction "Set tag on positive signal edge":

Parameter Declaration Data type Description
CLK Input BOOL Incoming signal, the 

edge of which is to be 
queried

Q Output BOOL Result of edge 
evaluation

Example
The following example shows how the instruction works:

SCL
"R_TRIG_DB"(CLK := "TagIn",
            Q => "TagOut");

The RLO of the preceding query is saved in the instance DB "R_TRIG_DB". If a change in the 
signal state of the RLO from "0" to "1" is detected in the operand "TagIn", the output "TagOut" 
has signal state "1".

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

F_TRIG: Set tag on negative signal edge

Description
You can use the "Set tag on negative signal edge" instruction to set a specified tag in the 
instance DB when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
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which is saved in the specified instance DB. If the instruction detects a change in the result of 
logic operation (RLO) from "1" to "0", there is a negative, falling edge.

If a negative edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find it in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Syntax
Use the following syntax for the "Set tag on negative signal edge" instruction:

SCL
<Instance_DB>(CLK := <Operand>,
             Q => <Operand>)

Parameter
The following table shows the parameters of the instruction "Set tag on negative signal edge":

Parameter Declaration Data type Description
CLK Input BOOL Incoming signal, the 

edge of which is to be 
queried

Q Output BOOL Result of edge 
evaluation

Example
The following example shows how the instruction works:

SCL
"F_TRIG_DB"(CLK := "TagIn",
            Q => "TagOut");

The RLO of the preceding query is saved in the instance DB "F_TRIG_DB". If a change in the 
signal state of the RLO from "1" to "0" is detected in the operand "TagIn", the output "TagOut" 
has signal state "1".
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See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Timer operations

IEC Timers

TP: Generate pulse

Description
You can use the "Generate pulse" instruction to set the Q parameter for the duration PT. The 
instruction starts when the result of logic operation (RLO) of the IN parameter changes from 
"0" to "1" (positive signal edge). The programmed time PT begins when the instruction starts. 
The Q parameter is set for the time PT, regardless of the subsequent changes in the input 
signal. Even when a new positive signal edge is detected, the signal state of the Q parameter 
is not affected as long as the time duration PT is active.

The current time value can be queried in the ET parameter. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. When the time duration PT is reached 
and the signal state at the IN parameter is "0", the ET parameter is reset.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

Each call of the "Generate pulse" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TP_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the TP_TIME type in the "Static" section of a block (for example, 
#MyTP_TIMER)
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For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TP_TIME or TP_LTIME 
that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME or TP_LTIME in the "Static" section of a 
block (for example #MyTP_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when an instruction is called and also at each access to 
the Q or ET outputs.

Syntax
Use the following syntax for the "Generate pulse" instruction:

● Data block of system data type IEC_Timer (global DB):

SCL
<IEC_Timer_DB> TP(IN := <Operand>,
                 PT := <Operand>,
                 Q => <Operand>,
                 ET => <Operand>)

● Local tag:

SCL
#myLocal_timer(IN := <Operand>,
               PT := <Operand>,
               Q => <Operand>,
               ET => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
  S7-1200 S7-1500
IN Input BOOL BOOL Start input
PT Input TIME TIME, LTIME Duration of the 

pulse.
The value of the 
PT parameter 
must be positive.
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Parameter Declaration Data type Description
  S7-1200 S7-1500
Q Output BOOL BOOL Operand that is 

set for the PT 
duration.

ET Output TIME TIME, LTIME Current time value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate pulse" instruction:

Example
The following example shows how the instruction works:

SCL
"TP_DB".TP(IN := "Tag_Start",
           PT := "Tag_PresetTime",
           Q => "Tag_Status",
           ET => "Tag_ElapsedTime");

When the signal state of the "Tag_Start" operand changes from "0" to "1", the time period 
programmed for the PT parameter is started and the "Tag_Status" operand is set to "1". The 
current time value is stored in the "Tag_ElapsedTime" operand.
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See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

TON: Generate on-delay

Description
You can use the "Generate on-delay" instruction to delay the setting of the Q parameter for 
the programmed duration PT. The instruction starts when the result of logic operation (RLO) 
of the IN parameter changes from "0" to "1" (positive signal edge). The programmed time PT 
begins when the instruction starts. When the duration PT has expired, the Q parameter returns 
signal state "1". The Q parameter remains set as long as the start input is still "1". If the signal 
state of the IN parameter changes from "1" to "0", the parameter Q will be reset. The timer 
function is restarted when a new positive signal edge is detected at the IN parameter.

The current time value can be queried in the ET parameter. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. The ET parameter is reset as soon 
as the signal state of the IN parameter changes to "0".

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

Each call of the "Generate on-delay" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TON_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the TON_TIME type in the "Static" section of a block (for 
example, #MyTON_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TON_TIME or 
TON_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or TON_LTIME in the "Static" section of 
a block (for example #MyTON_TIMER)
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When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when an instruction is called and also at each access to 
the Q or ET outputs.

Syntax
Use the following syntax for the "Generate on-delay" instruction:

● Data block of system data type IEC_Timer (global DB):

SCL
<IEC_Timer_DB> TON(IN := <Operand>,
                  PT := <Operand>,
                  Q => <Operand>,
                  ET => <Operand>)

● Local tag:

SCL
#myLocal_timer(IN := <Operand>,
               PT := <Operand>,
               Q => <Operand>,
               ET => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input BOOL BOOL Start input
PT Input TIME TIME, LTIME Duration of the on 

delay.
The value of the 
PT parameter 
must be positive.

Q Output BOOL BOOL Operand that is 
set when the timer 
PT expires.

ET Output TIME TIME, LTIME Current time value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate on-delay" instruction:

Example
The following example shows how the instruction works:

SCL
"TON_DB".TON(IN := "Tag_Start",
             PT := "Tag_PresetTime",
             Q => "Tag_Status",
             ET => "Tag_ElapsedTime");

When the signal state of the "Tag_Start" operand changes from "0" to "1", the time programmed 
for the PT parameter is started. After the end of the period the "Tag_Status" operand is set to 
the signal state "1". The operand Tag_Status remains set to signal state "1" as long as the 
operand Tag_Start has signal state "1". The current time value is stored in the operand 
"Tag_ElapsedTime". When the signal state at the operand "Tag_Start" changes from "1" to 
"0", the "Tag_Status" operand is reset.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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TOF: Generate off-delay

Description
You can use the "Generate off-delay" instruction to delay the resetting of the Q parameter for 
the programmed duration PT. The Q parameter is set when the result of logic operation (RLO) 
of the IN parameter changes from "0" to "1" (positive signal edge). When the signal state of 
the IN parameter changes back to "0", the programmed time PT starts. The Q parameter 
remains set as long the time duration PT is running. When the time PT expires, the Q parameter 
is reset. If the signal state of the IN parameter changes to "1" before the time duration PT has 
expired, the timer is reset. The signal state of the Q parameter remains set to "1".

The current time value can be queried in the ET parameter. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. When the time duration PT expires, 
the ET parameter remains set to the current value until the IN parameter changes back to "1". 
If the IN parameter changes to "1" before the time PT has expired, the ET parameter is reset 
to the value T#0s.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

Each call of the "Generate off-delay" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TOF_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the TOF_TIME type in the "Static" section of a block (for 
example, #MyTOF_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TOF_TIME or 
TOF_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or TOF_LTIME in the "Static" section of 
a block (for example #MyTOF_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".
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The instruction data is updated both when an instruction is called and also at each access to 
the Q or ET outputs.

Syntax
Use the following syntax for the "Generate off-delay" instruction:

● Data block of system data type IEC_Timer (global DB):

SCL
<IEC_Timer_DB> TOF(IN := <Operand>,
                  PT := <Operand>,
                  Q => <Operand>,
                  ET => <Operand>)

● Local tag:

SCL
#myLocal_timer(IN := <Operand>,
               PT := <Operand>,
               Q => <Operand>,
               ET => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input BOOL BOOL Start input
PT Input TIME TIME, LTIME Duration of the off 

delay.
The value of the 
PT parameter 
must be positive.

Q Output BOOL BOOL Operand that is 
reset when the 
time PT expires.

ET Output TIME TIME, LTIME Current time value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the instruction "Generate off-delay":

Example
The following example shows how the instruction works:

SCL
"TOF_DB".TOF(IN := "Tag_Start",
             PT := "Tag_PresetTime",
             Q => "Tag_Status",
             ET => "Tag_ElapsedTime");

With a change in the signal state of the "Tag_Start" operand from "0" to "1", the "Tag_Status" 
operand is set. When the signal state of the "Tag_Start" operand changes from "1" to "0", the 
time programmed for the PT parameter is started. As long as the time is running, the 
"Tag_Status" operand remains set. When the time has expired, the "Tag_Status" operand is 
reset. The current time value is stored in the operand "Tag_ElapsedTime".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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TONR: Time accumulator

Description
The "Time accumulator" instruction is used to accumulate time values within a period set by 
the PT parameter. When the signal state of the IN parameter changes to "1", the instruction 
executes and the time duration PT starts. While the time duration PT is running, the time values 
that are recorded when the IN parameter has signal state "1" are accumulated. The 
accumulated time is output in the ET parameter and can be queried there. When the time 
duration PT is reached, the Q parameter has signal state "1". The Q parameter remains set 
to "1", even when the signal state at the IN parameter changes to "0".

The R parameter resets the ET and Q parameters regardless of the signal state at the IN 
parameter.

Each call of the "Time accumulator" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TONR_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the TONR_TIME type in the "Static" section of a block (for 
example, #MyTONR_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TONR_TIME or 
TONR_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or TONR_LTIME in the "Static" section 
of a block (for example #MyTONR_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when an instruction is called and also at each access to 
the Q or ET outputs.
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Syntax
Use the following syntax for the "Time accumulator" instruction:

● Data block of system data type IEC_Timer (global DB):

SCL
<IEC_Timer_DB> TONR(IN := <Operand>,
                   R := <Operand>,
                   PT := <Operand>,
                   Q => <Operand>,
                   ET => <Operand>)

● Local tag:

SCL
#myLocal_timer(IN := <Operand>,
               R := <Operand>,
               PT := <Operand>,
               Q => <Operand>,
               ET => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input BOOL BOOL Start input
R Input BOOL BOOL Reset of the ET 

and Q parameters
PT Input TIME TIME, LTIME Maximum 

duration of time 
recording.
The value of the 
PT parameter 
must be positive.

Q Output BOOL BOOL Operand that 
remains set when 
the timer PT has 
expired.

ET Output TIME TIME, LTIME Accumulated time

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Time accumulator" instruction:

Example
The following example shows how the instruction works:

SCL
"TONR_DB".TONR(IN := "Tag_Start",
               R := "Tag_Reset",
               PT := "Tag_PresetTime",
               Q => "Tag_Status",
               ET => "Tag_Time");

When the signal state of the "Tag_Start" operand changes from "0" to "1", the time programmed 
for the PT parameter is started. While the timer is running, the time values that are recorded 
at signal state "1" of the operand "Tag_Start" is accumulated. The accumulated times is stored 
in the "Tag_Time" operand. When the time value displayed at the PT parameter is reached, 
the "Tag_Status" operand is set to the signal state "1". The current time value is stored in the 
operand "Tag_Time".
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See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

RESET_TIMER: Reset timer

Description
You can use the "Reset timer" instruction to reset an IEC timer to "0". The structure components 
of the timer in the specified data block are reset to "0".

The instruction does not influence the RLO. At the TIMER parameter, the "Reset timer" 
instruction is assigned an IEC timer declared in the program.

The instruction data is updated only when the instruction is called and not each time the 
assigned IEC timer is accessed. Querying the data is only identical from the call of the 
instruction to the next call of the instruction.

Syntax
Use the following syntax for the "Reset timer" instruction:

SCL
RESET_TIMER(TIMER := <IEC timer>)

Parameters
The following table shows the parameters of the "Reset timer" instruction":

Parameter Declaration Data type Description
<IEC timer> Output IEC_TIMER, 

IEC_LTIMER, 
TP_TIME, TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

IEC timer that is reset

For more information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
IF #started = false THEN
"TON_DB".TON(IN := "Tag_Start",
             PT := "Tag_PresetTime",
             Q => "Tag_Status",
             ET => "Tag_ElapsedTime");
#started := true;
END_IF;
 
IF "TON_DB".ET < T#25s THEN
RESET_TIMER(TIMER := "TON_DB");
#started := false;
END_IF;

When the tag #started has the signal state "0", the instruction "Generate on-delay" is executed 
when there is positive signal edge on the operand "Tag_Start". The IEC timer stored in the 
instance data block "TON_DB" is started with the time duration that is specified by the operand 
"Tag_PresetTime". The operand "Tag_Status" is set if the time duration specified by the 
operand "Tag_PresetTime" has expired. The parameter Q remains set as long as the operand 
"Tag_Start" still has the signal state "1". When the signal state of the start input changes from 
"1" to "0", the operand on the Q parameter is reset.

If the expired time of the IEC timer "TON_DB" is less than 25s, the "Reset timer" instruction is 
executed and the timer stored in the "TON_DB" instance data block is reset.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

PRESET_TIMER: Load time duration

Description
You can use the "Load time duration" instruction to set the time for an IEC timer. The instruction 
is executed in every cycle when the result of logic operation (RLO) at the input of the instruction 
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has the signal state "1". The instruction writes the specified time to the structure of the specified 
IEC timer.

 

 Note

If the specified IEC timer is running while the instruction executes, the instruction overwrites 
the current time of the specified IEC timer. This can change the timer status of the IEC timer.

 

You assign an IEC timer declared in the program to the "Load time duration" instruction.

The instruction data is updated only when the instruction is called and each time the assigned 
IEC timer is accessed. The query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) 
updates the IEC_TIMER structure.

Syntax
Use the following syntax for the "Load time duration" instruction:

SCL
PRESET_TIMER(PT := <Operand>,
              TIMER := <IEC timer)

Parameter
The following table shows the parameters of the "Load time duration" instruction:

Parameter Declaration Data type Description
<Time duration> Input TIME, LTIME Duration with which the 

IEC timer runs.
<IEC timer> Output IEC_TIMER, 

IEC_LTIMER, 
TP_TIME, TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

IEC timer whose 
duration of which is set.

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF #started = false THEN
"TON_DB".TON(IN := "Tag_Start",
             PT := "Tag_PresetTime",
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SCL
             Q => "Tag_Status",
             ET => "Tag_ElapsedTime");
#started := true;
#preset = true
END_IF;
 
IF "TON_DB".ET < T#10s AND #preset = true THEN
PRESET_TIMER(PT := T#25s,
             TIMER := "TON_DB");
#preset := false;
END_IF;

When the tag #started has the signal state "0" and the operand "Tag_Start" has a positive 
signal edge, the instruction "Generate on-delay" is executed. The IEC timer stored in the 
instance data block "TON_DB" is started with the time duration that is specified by the operand 
"Tag_PresetTime". The operand "Tag_Status" is set if the time duration PT specified by the 
operand "Tag_PresetTime" has expired. The parameter Q remains set as long as the operand 
"Tag_Start" still has the signal state "1". When the signal state of the start input changes from 
"1" to "0", the operand on the Q parameter is reset.

The instruction "Load time duration" is executed when the expired time of the IEC timer 
"TON_DB" is less than 10s and the tag #preset has the signal state "1". The instruction writes 
the time duration that is specified at the parameter "PT" in the instance data block "TON_DB", 
thereby overwriting the time value of the operand "Tag_PresetTime" within the instance data 
block. The signal state of the timer status may therefore change at the next query or when 
"TON_DB".Q or "TON_DB".ET are accessed.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SIMATIC Timers

S_PULSE: Assign pulse timer parameters and start

Description
The "Assign pulse timer parameters and start" instruction starts the time programmed in the 
T_NO parameter when a change from "0" to "1" (positive signal edge) is detected in the result 
of logic operation (RLO) of the S parameter. The timer runs for the programmed time (TV) as 
long as the signal state of the S parameter is "1".

When the signal state of the S parameter changes to "0" before the programmed time has 
expired, the timer is stopped and the "Q" parameter is reset to "0".
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Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

If the timer is running and the signal state at input R changes to "1" then the current time value 
and the time base are also set to zero. If the timer is not running, the signal state "1" at the R 
input has no effect.

Parameter Q returns signal state "1" as long as the timer is running and the signal state at 
parameter S is "1". When the signal state of the S parameter changes to "0" before the 
programmed time has expired, the Q parameter returns signal state "0". If the timer is reset 
by parameter R or if the timer has expired then parameter Q also returns signal state "0".

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Syntax
Use the following syntax for the "Assign pulse timer parameters and start" instruction:

SCL
S_PULSE(T_NO := <Operand>,
        S := <Operand>,
        TV := <Operand>,
        R := <Operand>,
        Q => <Operand>,
        BI => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value
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For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign pulse timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_PULSE(T_NO := "Timer_1",
                        S := "Tag_1",
                        TV := "Tag_Number",
                        R := "Tag_Reset",
                        Q := "Tag_Status",
                        BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". The 
timer counts down with the time value of the operand "Tag_Number" until operand "Tag_1" 
returns signal state "1".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2113



If the signal state at the S parameter changes to "0" before the programmed time has elapsed, 
the "Tag_Status" operand is reset to "0". If the timer is reset by the R parameter or if the timer 
has expired, the "Tag_Status" operand also returns signal state "0".

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

S_PEXT: Assign extended pulse timer parameters and start

Description
The "Assign extended pulse timer parameters and start" instruction starts a programmed timer 
when a positive signal edge is detected at the S parameter. The timer runs for the programmed 
time (TV) even if the signal state at the S parameter changes to "0". As long as the timer runs, 
parameter Q returns the signal state "1".

When the timer has expired, parameter Q is reset to "0". If the signal state at the S parameter 
changes from "0" to "1" while the timer is running, the timer is restarted with the time 
programmed in the TV parameter.

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

If the timer is running and the signal state at parameter R changes to "1" then the current time 
value and the time base are also set to zero. If the timer is not running then signal state "1" at 
parameter R has no effect.

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2114 System Manual, 07/2013,  



Syntax
Use the following syntax for the "Assign extended pulse timer parameters and start" instruction:

SCL
S_PEXT(T_NO := <Operand>,
       S := <Operand>,
       TV := <Operand>,
       R := <Operand>,
       Q => <Operand>,
       BI => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign extended pulse timer 
parameters and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_PEXT(T_NO := "Timer_1",
                       S := "Tag_1",
                       TV := "Tag_Number",
                       R := "Tag_Reset",
                       Q := "Tag_Status",
                       BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". As long 
as the timer runs, operand "Tag_Status" returns the signal state "1". When the timer has 
expired, operand "Tag_Status" is reset to "0". If the signal state at the S input changes from 
"0" to "1" while the timer is running, the timer is restarted with the time "Tag_Number".

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.
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See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

S_ODT: Assign on-delay timer parameters and start

Description
The "Assign on-delay timer parameters and start" instruction starts a programmed timer as on-
delay when a positive signal edge is detected at the S parameter. The timer runs for the 
programmed time (TV) as long as the signal state of the S parameter is "1".

If the timer expires correctly and parameter S still has signal state "1" then parameter Q returns 
signal state "1". If the signal state at the S parameter changes from "1" to "0" while the timer 
is running, the timer is stopped. In this case, output Q is reset to signal state "0".

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

If the time is running and the signal state at input R changes from "0" to "1" then the current 
time value and the time base are also set to zero. In this case, the signal state at parameter 
Q is "0". The timer is reset if the signal state at the R parameter is "1", even if the timer is not 
running and the result of logic operation (RLO) at the S parameter is "1".

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Syntax
Use the following syntax for the "Assign on-delay timer parameters and start" instruction:

SCL
S_ODT(T_NO := <Operand>,
      S := <Operand>,
      TV := <Operand>,
      R := <Operand>,
      Q => <Operand>,
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SCL
      BI => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".

ulse timing diagram
The following figure shows the pulse timing diagram of the "Assign on-delay timer parameters 
and start" instruction:
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_ODT(T_NO := "Timer_1",
                      S := "Tag_1",
                      TV := "Tag_Number",
                      R := "Tag_Reset",
                      Q := "Tag_Status",
                      BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". The 
timer runs for the duration "Tag_Number" as long as the signal state of operand "Tag_1" is "1".

If the timer expires correctly and operand "Tag_Status" has signal state "1" then operand 
"Tag_Status" is reset to "1". If the signal state of the "Tag_1" operand changes from "1" to "0" 
while the timer is running, the timer is stopped. In this case, operand "Tag_Status" returns 
signal state "0".

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

S_ODTS: Assign retentive on-delay timer parameters and start

Description
The "Assign retentive on-delay timer parameters and start" instruction starts a programmed 
timer when a positive signal edge is detected at the S parameter. The timer runs for the 
programmed time (TV) even if the signal state at the S parameter changes to "0".

If the timer expires, the "Q" parameter returns signal state "1" regardless of the signal state of 
the "S" parameter. If the signal state at the S parameter changes from "0" to "1" while the timer 
is running, the timer is restarted with the programmed time TV.

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

Signal state "1" at parameterR resets the current time value and time base to "0", independent 
of the signal state at parameter S. In this case, the signal state at parameter Q is "0".
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The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Syntax
Use the following syntax for the "Assign retentive on-delay timer parameters and start" 
instruction:

SCL
S_ODTS(T_NO := <Operand>,
       S := <Operand>,
       TV := <Operand>,
       R := <Operand>,
       Q => <Operand>,
       BI =><Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign retentive on-delay timer 
parameters and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_ODTS(T_NO := "Timer_1",
                       S := "Tag_1",
                       TV := "Tag_Number",
                       R := "Tag_Reset",
                       Q := "Tag_Status",
                       BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". The 
timer runs for the duration "Tag_Number".

If the timer expires, operand "Tag_Status" returns signal state "1" independent of the signal 
state of operand "Tag_1". If the signal state of the "Tag_1" operand changes from "0" to "1" 
while the timer is running, the timer is restarted with the time "Tag_Number".

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.
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See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

S_OFFDT: Assign off-delay timer parameters and start

Description
The "Assign off-delay timer parameters and start" instruction starts a programmed timer when 
a negative signal edge is detected at the S parameter. The timer runs for the programmed 
time (TV). As long as the timer is running or parameter S returns signal state "1", then 
parameter Q has signal state "1".

If the timer expires and the signal state is "0" then parameter Q is reset to signal state "0". If 
the signal state at parameter S changes from "0" to "1" while the timer is running, the timer is 
stopped. The timer is only restarted after a falling signal edge is detected at parameter S.

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

Signal state "1" at parameter R resets the current time value and time base to "0". In this case, 
the signal state at parameter Q is "0".

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Syntax
Use the following syntax for the "Assign off-delay timer parameters and start" instruction:

SCL
S_OFFDT(T_NO := <Operand>,
        S := <Operand>,
        TV := <Operand>,
        R := <Operand>,
        Q => <Operand>,
        BI =><Operand>)
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The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign off-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_OFFDT(T_NO := "Timer_1",
                        S := "Tag_1",
                        TV := "Tag_Number",
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SCL
                        R := "Tag_Reset",
                        Q := "Tag_Status",
                        BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". The 
timer runs for the duration "Tag_Number". As long as the timer is running or operand "Tag_1" 
returns signal state "1", then operand "Tag_Status" has signal state "1".

If the timer expires and the signal state of operand "Tag_1" is "0" then operand "Tag_Status" 
is reset to signal state "0". If the signal state of the "Tag_1" operand changes from "0" to "1" 
while the timer is running, the timer is reset. The timer is only restarted after a falling edge is 
detected at parameter S.

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Counter operations

IEC Counters

CTU: Count up

Description
You can use the "Count up" instruction to increment the value at the CV parameter. When the 
signal state of the CU parameter changes from "0" to "1" (positive signal edge), the instruction 
is executed and the current counter value of the CV parameter is incremented by one. When 
the instruction is executed for the first time the the current count of the CV parameter is set to 
zero. The counter value is incremented each time a positive signal edge is detected, until it 
reaches the high limit of the data type specified for the CV parameter. When the high limit is 
reached, the signal state of the CU parameter no longer has an effect on the instruction.

You can query the count status of the Q parameter. The signal state of the Q parameter is 
determined by the PV parameter. When the current counter value is greater than or equal to 
the value of the PV parameter, the Q parameter is set to signal state "1". In all other cases, 
the signal state of the Q parameter is "0". You can also specify a constant for the PV parameter.
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The value of the CV parameter is reset to zero when the signal state at the R parameter 
changes to "1". As long as the signal state of the R parameter is "1", the signal state of the CU 
parameter has no effect on the instruction.

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Each call of the "Count up" instruction must be assigned an IEC counter in which the instruction 
data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT

For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● CTU_LINT / CTU_ULINT

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the CTU type in the "Static" section of a block (for example, 
#MyCTU_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".
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Syntax
The following syntax is used for the "Count up" instruction:

Table 9-28 Data block of system data type IEC_counter (global DB)

SCL
<IEC_Counter_DB>.CTU(CU := <Operand>,
                    R := <Operand>,
                    PV := <Operand>,
                    Q => <Operand>,
                    CV => <Operand>)

Table 9-29 Local tag

SCL
#myLocal_counter(CU := <Operand>,
                 R := <Operand>,
                 PV := <Operand>,
                 Q => <Operand>,
                 CV => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
CU Input BOOL Count input
R Input BOOL Reset input
PV Input Integers Value at which the 

output Q is set
Q Output BOOL Counter status
CV Output Integers, CHAR, DATE Current counter value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"IEC_COUNTER_DB".CTU(CU := "Tag_Start",
                     R := "Tag_Reset",
                     PV := "Tag_PresetValue",
                     Q => "Tag_Status",
                     CV => "Tag_CounterValue");

When the signal state of the "Tag_Start" operand changes from "0" to "1", the "Count up" 
instruction executes and the current counter value of the "Tag_CounterValue" operand is 
incremented by one. With each additional positive signal edge, the counter value is 
incremented until the high limit value of the specified data type (INT = 32767) is reached.

The "Tag_Status" output has signal state "1" as long as the current counter value is greater 
than or equal to the value of the "Tag_PresetValue" operand. In all other cases, the 
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"Tag_Status" output has signal state "0". The current counter value is stored in the 
"Tag_CounterValue" operand.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

CTD: Count down

Description
The "Count down" instruction is used to decrement the value at the parameter CV. When the 
signal state of the CD parameter changes from "0" to "1" (positive signal edge), the instruction 
is executed and the current counter value of the CV parameter is decremented by one. When 
the instruction is executed the first time, the counter value of the CV parameter will be set to 
the value of the PV parameter. Each time a positive signal edge is detected, the counter is 
decremented until it reaches the low limit value of the specified data type. When the low limit 
is reached, the signal state of the CD parameter no longer has an effect on the instruction.

You can query the count status of the Q parameter. If the current counter value is less than or 
equal to zero, the Q parameter is set to signal state "1". In all other cases, the signal state of 
the Q parameter is "0". You can also specify a constant for the PV parameter.

The value of the CV parameter is set to the value of the PV parameter when the signal state 
of the LD parameter changes to "1". As long as the signal state of the LD parameter is "1", the 
signal state of the CD parameter has no effect on the instruction.

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Each call of the "Count down" instruction must be assigned an IEC counter in which the 
instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
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For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● CTD_LINT / CTD_ULINT

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the CTD type in the "Static" section of a block (for example, 
#MyCTD_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Count down" instruction:

Table 9-30 Data block of system data type IEC_counter (global DB)

SCL
<IEC_Counter_DB>.CTD(CD := <Operand>,
                    LD := <Operand>,
                    PV := <Operand>,
                    Q => <Operand>,
                    CV => <Operand>)

Table 9-31 Local tag

SCL
#myLocal_counter(CD := <Operand>,
                 LD := <Operand>,
                 PV := <Operand>,
                 Q => <Operand>,
                 CV => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
CD Input BOOL Count input
LD Input BOOL Load input
PV Input Integers Value at which the 

output Q is set

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2128 System Manual, 07/2013,  



Parameter Declaration Data type Description
Q Output BOOL Counter status
CV Output Integers, CHAR, DATE Current counter value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 SCL
"IEC_SCOUNTER_DB".CTD(CD := "Tag_Start",
                      LD := "Tag_Load",
                      PV := "Tag_PresetValue",
                      Q => "Tag_Status",
                      CV => "Tag_CounterValue");

When the signal state of the "Tag_Start" changes from "0" to "1", the "Count down" instruction 
executes and the value of the "Tag_CounterValue" operand is decremented by one. With each 
additional positive signal edge, the counter value is decremented until it reaches the low limit 
of the specified data type (-128).

The operand "Tag_Status" has the signal state "1" as long as the current counter value is less 
than or equal to zero. In all other cases, the "Tag_Status" output has signal state "0". The 
current counter value is stored in the "Tag_CounterValue" operand.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

CTUD: Count up and down

Description
Use the "Count up and down" instruction to increment or decrement the counter value at the 
CV parameter. When the signal state of the CU parameter changes from "0" to "1" (positive 
signal edge), the current counter value of the CV parameter is incremented by one. When the 
signal state of the CD parameter changes from "0" to "1" (positive signal edge), the counter 
value of the CV parameter is decremented by one. If there is a positive signal edge at the CU 
and CD inputs in one program cycle, the current counter value of the CV parameter remains 
unchanged.

The counter value can be incremented until it reaches the high limit value of the data type 
specified for the CV parameter. When the high limit value is reached, the counter value is no 
longer incremented on a positive signal edge. When the low limit value of the specified data 
type is reached, the counter value is not decremented any further.
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When the signal state of the LD parameter changes to "1", the counter value of the CV 
parameter is set to the value of the PV parameter. As long as the LD parameter has the signal 
state "1", the signal state of the CU and CD parameters has no effect on the instruction.

The counter value is set to zero when the signal state of the parameter R changes to "1". As 
long as the parameter R has signal state "1", a change in the the signal state of the parameters 
CU, CD and LD has no effect on the "Count up and down" instruction.

You can scan the current status of the up counter based on the value of the QU parameter. 
When the current counter value is greater than or equal to the value of the PV parameter, the 
QU parameter is set to signal state "1". In all other cases, the signal state of the QU parameter 
is "0". You can also specify a constant for the PV parameter.

You can scan the current status of the down counter based on the value of the QD parameter. 
If the current counter value is less than or equal to zero, the QD parameter is set to signal state 
"1". In all other cases, the signal state of the QD parameter is "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Each call of the "Count up and down" instruction must be assigned an IEC counter in which 
the instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT

For S7-1500 CPU

Data block of system data type IEC_counter 
(global DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● CTUD_LINT / CTUD_ULINT

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_COUNTER (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the CTUD type in the "Static" section of a block (for example, 
#MyCTUD_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
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local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Count up and down" instruction:

Table 9-32 Data block of system data type IEC_counter (global DB)

SCL
<IEC_Counter_DB>.CTUD(CU := <Operand>,
                     CD := <Operand>,
                     R := <Operand>,
                     LD := <Operand>,
                     PV := <Operand>,
                     QU=> <Operand>,
                     QD := <Operand>,
                     CV=> <Operand>)

Table 9-33 Local tag

SCL
myLocal_counter(CU := <Operand>,
                CD := <Operand>,
                R := <Operand>,
                LD := <Operand>,
                PV := <Operand>,
                QU=> <Operand>,
                QD := <Operand>,
                CV=> <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
CU Input BOOL Count up input
CD Input BOOL Count down input
R Input BOOL Reset input
LD Input BOOL Load input
PV Input Integers Value at which the 

output QU is set.
QU Output BOOL Status of the counter up
QD Output BOOL Status of the counter 

down
CV Output Integers, CHAR, DATE Current counter value

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

 SCL
"IEC_COUNTER_DB".CTUD(CU := "Tag_Start1",
                      CD := "Tag_Start2",
                      LD := "Tag_Load",
                      R := "Tag_Reset",
                      PV := "Tag_PresetValue",
                      QU => "Tag_CU_Status",
                      QD => "Tag_CD_Status",
                      CV => "Tag_CounterValue");

If the "Tag_Start1" operand has a positive signal edge in the signal state, the current counter 
value is incremented by one and stored in the "Tag_CounterValue" operand. If the "Tag_Start2" 
operand has a positive signal edge in the signal state, the counter value is decremented by 
one and is also stored in the "Tag_CounterValue" operand. The counter value is incremented 
on the positive signal edge of the CU parameter until it reaches the high limit of the specified 
data type (INT). If the CD parameter has a positive signal edge, the counter value is 
decremented until it reaches the low limit of the specified data type (INT).

The operand "Tag_CU_Status" has the signal state "1" as long as the current counter value is 
greater than or equal to the value of the operand "Tag_PresetValue". In all other cases, the 
"Tag_CU_Status" output has signal state "0".

The operand "Tag_CD_Status" has the signal state "1" as long as the current counter value is 
less than or equal to zero. In all other cases, the "Tag_CD_Status" output has signal state "0".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SIMATIC Counters

S_CU: Assign parameters and count up

Description
You can use the "Assign parameters and count up" instruction to increment the value of a 
counter. When the signal state of the parameter CU changes from "0" to "1" (positive signal 
edge), the current counter value is incremented by one. The current counter value is provided 
at the parameter CV. The counter value is incremented until the limit of "999" is reached. When 
the limit value is reached, the counter value is no longer incremented on a positive signal edge.

When the signal state of the parameter S changes from "0" to "1", the counter value is set to 
the value of the parameter PV. If the counter is set and if the result of logic operation (RLO) 
at the CU input is "1", the counter counts once in the next cycle, even when no signal edge 
change is detected.
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The counter value is set to zero when the signal state of the parameter R changes to "1". As 
long as the parameter R has the signal state "1", a change in the signal state of the parameters 
CU and S has no effect on the counter value.

The signal state at parameter Q is "1" if the counter value is greater than zero. When the 
counter value equals zero, parameter Q returns signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Syntax
The following syntax is used for the "Assign parameters and count up" instruction:

SCL
S_CU(C_NO := <Operand>,
     CU:= <Operand>,
     S := <Operand>,
     PV := <Operand>,
     R := <Operand>,
     Q => <Operand>,
     CV=> <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
C_NO Input COUNTER, INT Counters

The number of counters 
depends on the CPU.

CU Input BOOL Count up input
S Input BOOL Input for presetting the 

counter
PV Input WORD Preset counter value 

(C#0 to C#999) in BCD 
format

R Input BOOL Reset input
Q Output BOOL Status of the counter
CV Output WORD, S5TIME, DATE Current counter value 
Function value WORD, S5TIME, DATE Current counter value in 

BCD format

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_CU(C_NO := "Counter_1",
                     CU := "Tag_Start",
                     S := "Tag_1",
                     PV := "Tag_PresetValue",
                     R := "Tag_Reset",
                     Q => "Tag_Status",
                     CV => "Tag_Value");

If the signal state of the parameter "Tag_Start" changes from "0" to "1" (positive signal edge) 
and the current counter value is less than "999", the counter value is incremented by one. If 
the signal state of the input "Tag_1" changes from "0" to "1", the counter value in BCD format 
is set to the value of the operand "Tag_PresetValue". The counter value is reset to "0" when 
the operand "Tag_Reset" has signal state "1".

The current counter value is stored in hexadecimal form in the operand "Tag_Value".

The output "Tag_Status" has the signal state "1" as long as the current counter value is not 
equal to "0". The current counter value is returned in the "Tag_Value" operand and as a function 
value.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

S_CD: Assign parameters and count down

Description   
You can use the "Assign parameters and count down" instruction to decrement the value of a 
counter. When the signal state of the parameter CD changes from "0" to "1" (positive signal 
edge), the current counter value is decreased by one. The current counter value is provided 
at the parameter CV. The counter value is decreased until the low limit of "0" is reached. When 
the low limit value is reached, the counter value is no longer decreased on a positive signal 
edge.

When the signal state of the parameter S changes from "0" to "1", the counter value is set to 
the value of the parameter PV. If the counter is set and if the result of logic operation (RLO) 
at the parameter CD is "1", the counter counts once in the next cycle, even when no signal 
edge change is detected.

The counter value is set to zero when the signal state of the parameter R changes to "1". As 
long as the parameter R has the signal state "1", a change in the signal state of the parameters 
CD and S has no effect on the counter value.
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The signal state at parameter Q is "1" if the counter value is greater than zero. When the 
counter value equals zero, parameter Q returns signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Syntax
The following syntax is used for the "Assign parameters and count down" instruction:

SCL
S_CD(C_NO:= <Operand>,
     CD:= <Operand>,
     S:= <Operand>,
     PV:= <Operand>,
     R:= <Operand>,
     Q=> <Operand>,
     CV=> <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
C_NO Input COUNTER, INT Counters

The number of counters 
depends on the CPU.

CD Input BOOL Count down input
S Input BOOL Input for presetting the 

counter
PV Input WORD Preset counter value 

(C#0 to C#999) in BCD 
format

R Input BOOL Reset input
Q Output BOOL Status of the counter
CV Output WORD, S5TIME, 

WORD
Current counter value 

Function value WORD, S5TIME, DATE Current counter value in 
BCD format

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_CD(C_NO := "Counter_1",
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SCL
                     CD := "Tag_Start",
                     S := "Tag_1",
                     PV := "Tag_PresetValue",
                     R := "Tag_Reset",
                     Q => "Tag_Status",
                     CV => "Tag_Value");

When the signal state of the operand "Tag_Start" changes from "0" to "1" (positive signal edge) 
and the current counter value is greater than "0", the counter value is decreased by one. If the 
signal state of the operand "Tag_1" changes from "0" to "1", the counter value is set to the 
value of the operand "Tag_PresetValue". The counter value is reset to "0" when the operand 
"Tag_Reset" has signal state "1".

The current counter value is stored in the operand "Tag_Value".

The operand "Tag_Status" returns signal state "1" as long as the current counter value is not 
equal to "0". The current counter value is returned in the "Tag_Value" operand and as a function 
value.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

S_CUD: Assign parameters and count up / down

Description     
You can use the "Assign parameters and count up / down" instruction to increment and 
decrement the value of a counter. When the signal state of the parameter CU changes from 
"0" to "1" (positive signal edge), the current counter value is incremented by one. When the 
signal state of the parameter CD changes from "0" to "1" (positive signal edge), the counter 
value is decreased by one. The current counter value is provided at the parameter CV. If there 
is a positive signal edge at the parameters CU and  CD in one program cycle, the counter 
value remains unchanged.

The counter value is incremented until the high limit value of "999" is reached. When the high 
limit value is reached, the counter value is no longer incremented on a positive signal edge. 
When the low limit value "0" is reached, the counter value is not decremented any further.

When the signal state of the parameter S changes from "0" to "1", the counter value is set to 
the value of the parameter PV. If the counter is set and if the result of logic operation (RLO) 
of the parameters CU and CD is "1", the counter will count once in the next cycle, even if no 
signal edge change was detected.

The counter value is set to zero when the signal state of the parameter R changes to "1". As 
long as the parameter R has the signal state "1", processing of the signal state of the 
parameters CU, CD and S has no effect on the counter value.
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The signal state at parameter Q is "1" if the counter value is greater than zero. When the 
counter value equals zero, parameter Q returns signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Syntax
The following syntax is used for the "Assign parameters and count up / down" instruction:

SCL
S_CUD(C_NO:= <Operand>,
      CU:= <Operand>,
      CD:= <Operand>,
      S:= <Operand>,
      PV:= <Operand>,
      R:= <Operand>,
      Q=> <Operand>,
      CV=> <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
C_NO Input COUNTER, INT Counters

The number of counters 
depends on the CPU.

CU Input BOOL Count up input
CD Input BOOL Count down input
S Input BOOL Input for presetting the 

counter
PV Input WORD Preset counter value 

(C#0 to C#999) in BCD 
format

R Input BOOL Reset input
Q Output BOOL Status of the counter
CV Output WORD, S5TIME, DATE Current counter value 

(hexadecimal)
Function value WORD, S5TIME, DATE Current counter value in 

BCD format

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_CD(C_NO := "Counter_1",
                     CU := "Tag_CU",
                     CD := "Tag_CD",
                     S := "Tag_1",
                     PV := "Tag_PresetValue",
                     R := "Tag_Reset",
                     Q => "Tag_Status",
                     CV => "Tag_Value");

When a positive signal edge is detected in the signal state of the operand "Tag_CU" and the 
current counter value is less than "999", the counter value is incremented by one. When a 
positive signal edge is detected in the signal state of the operand "Tag_CD" and the current 
counter value is greater than "0", the counter value is decremented by one.

If the signal state of the operand "Tag_1" changes from "0" to "1", the counter value is set to 
the value of the operand "Tag_PresetValue". The counter value is reset to "0" when the 
operand "Tag_Reset" has signal state "1".

The current counter value is stored in the operand "Tag_Value".

The operand "Tag_Status" returns signal state "1" as long as the current counter value is not 
equal to "0". The current counter value is returned in the "Tag_Value" operand and as a function 
value.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Math functions

ABS: Form absolute value

Description     
Use the "Form absolute value" instruction to calculate the absolute value of an input value and 
to save the result in the specified operands.
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Syntax
Use the following syntax for the "Form absolute value" instruction:

SCL
ABS(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

<Expression> Input SINT, INT, DINT, 
floating-point 
numbers

SINT, INT, DINT, 
LINT, floating-
point numbers

Input value

Function value SINT, INT, DINT, 
floating-point 
numbers

SINT, INT, DINT, 
LINT, floating-
point numbers

Absolute value of 
the input value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 SCL
"Tag_Result1" := ABS("Tag_Value");
"Tag_Result2" := ABS("Tag_Value1"*"Tag_Value2");

The absolute value of the input value is returned in the format of the input value as a function 
value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value -2
Tag_Result1 2
Tag_Value1 4
Tag_Value2 -1
Tag_Result2 4

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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MIN: Get minimum

Description
The "Get minimum" instruction compares the values of the available inputs and returns the 
lowest value as the result.

A minimum of two and a maximum of 32 inputs can be specified at the instruction.

The result is invalid if any of the following conditions are met:

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Syntax
The following syntax is used for the "Get minimum" instruction:

SCL
MIN(IN1:= <Operand>,
    IN2 := <Operand>)

Parameter
The following table shows the parameters of the "Get minimum" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN1 Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

First input value

IN2 Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Second input 
value
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Parameter Declaration Data type Description
S7-1200 S7-1500

INn Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Additionally 
inserted inputs 
whose values are 
to be compared

Function value Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Result of the 
instruction

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := MIN(IN1 := "Tag_Value1",
                    IN2 := "Tag_Value2",
                    IN3 := "Tag_Value3");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 12222
IN2 Tag_Value2 14444
IN3 Tag_Value3 13333
Function value Tag_Result 12222

The instruction compares the values of the available inputs and copies the lowest value 
("Tag_Value1") to operand "Tag_Result".

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2141



MAX: Get maximum

Description
The "Get maximum" instruction compares the values of the available inputs and returns the 
greatest value as the result.

A minimum of two and a maximum of 32 inputs can be specified at the instruction.

The result is invalid if any of the following conditions are met:

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Syntax
The following syntax is used for the "Get maximum" instruction:

SCL
MAX(IN1:= <Operand>,
    IN2 := <Operand>)

Parameter
The following table shows the parameters of the "Get maximum" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN1 Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

First input value

IN2 Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Second input 
value
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Parameter Declaration Data type Description
S7-1200 S7-1500

INn Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Additionally 
inserted inputs 
whose values are 
to be compared

Function value Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Result of the 
instruction

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := MAX(IN1 := "Tag_Value1",
                    IN2 := "Tag_Value2",
                    IN3 := "Tag_Value3");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 12 222
IN2 Tag_Value2 14 444
IN3 Tag_Value3 13 333
Function value Tag_Result 14 444

The instruction compares the values of the specified operands and copies the greatest value 
("Tag_Value2") to the operand "Tag_Result".

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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LIMIT: Set limit value

Description
The "Set limit value" instruction limits the value of the parameter IN to the values of the 
parameters MN and MX. The value of the parameter MN may not be greater than the value of 
the parameter MX.

If the value of the parameter IN fulfills the MN condition <=IN <= MX, it is returned as the result 
of the instruction. If the condition is not fulfilled and the IN input value is less than the MN low 
limit, the value of the MN parameter is returned as the result. If the high limit MX is exceeded, 
the value of the MX parameter is returned as the result.

If the value of the MN input is greater than the value of the MX input, the result is undefined.

The instruction is only executed if the operands of all parameters are of the same data type.

Syntax
The following syntax is used for the "Set limit value" instruction:

SCL
LIMIT(MN := <Operand>,
      IN := <Operand>,
      MX := <Operand>)

The syntax of the instruction consists of the following parts:

Parameter
 

Declaration
 

Data type Description
S7-1200 S7-1500

MN Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Low limit

IN Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Input value
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Parameter
 

Declaration
 

Data type Description
S7-1200 S7-1500

MX Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

High limit

Function value Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Result of the 
instruction

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := LIMIT(MN := "Tag_Minimum",
                      IN := "Tag_Value",
                      MX := "Tag_Maximum");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MN Tag_Minimum 12 000
IN Tag_Value 8 000
MX Tag_Maximum 16 000
Function value Tag_Result 12 000

The value of operand "Tag_Value" is compared with the values of operands "Tag_Minimum" 
and "Tag_Maximum". Because the value of the operand "Tag_Value" is less than the low limit 
value, the value of operand "Tag_Minimum" will be copied to operand "Tag_Result".

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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SQR: Form square

Description     
Use the "Form square" instruction to square the input value and save the result in the specified 
operand.

Syntax
Use the following syntax for the instruction "Form square":

SCL
SQR(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
Function value Floating-point numbers Square of the input 

value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := SQR("Tag_Value");
"Tag_Result2" := SQR((SQR("Tag_Value1"))*"Tag_Value2);

The square of the input value is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 2.5
Tag_Result1 6.25
Tag_Value1 6.0
Tag_Value2 2.0
Tag_Result2 5184.0
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See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SQRT: Form square root

Description       
Use the "Form square root" instruction to calculate the square root of the the input value and 
save the result in the specified operand. The instruction has a positive result if the input value 
is greater than zero. If input values are less than zero, the instruction returns an invalid floating-
point number. If the input value is "-0", the result is also "-0".

Syntax
Use the following syntax for the "Form square root" instruction:

SCL
SQRT(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
Function value Floating-point numbers Square root of the input 

value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := SQRT("Tag_Value");
"Tag_Result2" := SQRT((SQR("Tag_Value1"))+"Tag_Value2");

The square root of the input value is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:
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Operand Value
Tag_Value 4.0
Tag_Result1 2.0
Tag_Value1 3.0
Tag_Value2 16.0
Tag_Result2 5.0

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

LN: Form natural logarithm

Description     
You can use the "Form natural logarithm" instruction to calculate the natural logarithm to base 
e (e=2.718282) of the input value. The instruction has a positive result if the input value is 
greater than zero. If input values are less than zero, the instruction returns an invalid floating-
point number.

Syntax
Use the following syntax for the "Form natural logarithm" instruction:

SCL
LN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point 

numbers
Input value

Function value Floating-point 
numbers

Natural logarithm of the input 
value

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := LN("Tag_Value");
"Tag_Result2" := LN("Tag_Value1"+"Tag_Value2");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 2.5
Tag_Result1 0.916
Tag_Value1 1.5
Tag_Value2 3.2
Tag_Result2 1.548

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

EXP: Form exponential value

Description     
The "Form exponential value" instruction calculates the exponent from the base e (e = 
2.718282) and the input value and saves the result in the specified operand.

Syntax
The following syntax is used for the "Form exponential value" instruction:

SCL
EXP(<Expression>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
Function value Floating-point numbers Exponential value of the 

input value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := EXP("Tag_Value");
"Tag_Result2" := EXP("Tag_Value1"/"Tag_Value2");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 20.5
Tag_Result1 799 902 200
Tag_Value1 15.5
Tag_Value2 30.2
Tag_Result2 1.671

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SIN: Form sine value

Description     
Use the "Form sine value" instruction to calculate the sine of the input value. The input value 
must be given in the radian measure.
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Syntax
Use the following syntax for the "Form sine value" instruction:

SCL
SIN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value (size of an 

angle in the radian 
measure)

Function value Floating-point numbers Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := SIN("Tag_Value");

The result of the instruction is returned in the "Tag_Result" operand as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value +1.570796 (π/2)
Tag_Result 1.0

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

COS: Form cosine value

Description     
Use the "Form cosine value" instruction to calculate the cosine of the input value. The input 
value must be given in the radian measure.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2151



Syntax
Use the following syntax for the "Form cosine value" instruction:

SCL
COS(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value (size of an 

angle in the radian 
measure)

Function value Floating-point numbers Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := COS("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value +1.570796 (π/2)
Tag_Result 0

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

TAN: Form tangent value

Description     
Use the "Form tangent value" instruction to calculate the sine of the input value. The input 
value must be given in the radian measure.
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Syntax
Use the following syntax for the "Form tangent value" instruction:

SCL
TAN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value (size of an 

angle in the radian 
measure)

Function value Floating-point numbers Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 SCL
"Tag_Result" := TAN("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value +3.141593 (π)
Tag_Result 0

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

ASIN: Form arcsine value

Description     
You can use the "Form arcsine value" instruction to calculate the size of the angle from a sine 
value, which corresponds to this value. Only valid floating-point numbers within the range -1 
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to +1 can be specified as input values. The calculated angle size is given in the radian measure 
and can range in value from -π/2 to +π/2.

Syntax
Use the following syntax for the "Form arcsine value" instruction:

SCL
ASIN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Sine value
Function value Floating-point numbers Size of angle in the 

radian measure

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ASIN("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 1.0
Tag_Result +1.570796 (π/2)

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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ACOS: Form arccosine value

Description     
You can use the "Form arccosine value" instruction to calculate the size of the angle from a 
cosine value, which corresponds to this value. Only valid floating-point numbers within the 
range -1 to +1 can be specified as input values. The calculated angle size is given in the radian 
measure and can range in value from 0 to +π.

Syntax
Use the following syntax for the "Form arccosine value" instruction:

SCL
ACOS(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Cosine value
Function value Floating-point numbers Size of angle in the 

radian measure

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ACOS("Tag_Value");

The result of the instruction is returned in the "Tag_Result" operand as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 0
Tag_Result +1.570796 (π/2)
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See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

ATAN: Form arctangent value

Description     
You can use the "Form arctangent value" instruction to calculate the size of the angle from a 
tangent value, which corresponds to this value. Only valid floating-point numbers may be 
specified as input values. The calculated angle size is given in the radian measure and can 
range in value from -π/2 to +π/2.

Syntax
Use the following syntax for the "Form arctangent value" instruction:

SCL
ATAN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Tangent value
Function value Floating-point numbers Size of angle in the 

radian measure

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ATAN("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:
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Operand Value
Tag_Value 1.0
Tag_Result +0.785398 (π/4)

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

FRAC: Return fraction

Description     
The result of the instruction "Return fraction" returns the decimal places of a value. Input value 
123.4567, for example, returns the value 0.4567.

Syntax
The following syntax is used for the instruction "Return fraction":

SCL
FRAC(<Expression>)
FRAC_<Data type>(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
_<Data type> Floating-point numbers

Default: REAL
Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Floating-point numbers Decimal places of the 
input value

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := FRAC("Tag_Value");
"Tag_Result2" := FRAC_LREAL("Tag_Value");

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 2.555 -1.4421
Tag_Result1 0.555 -0.4421

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Move operations

MOVE_BLK: Move block

Description
The instruction "Move block" copies the contents of a memory area (source area) to another 
memory area (destination area). The number of elements to be copied to the destination area 
is specified with the COUNT parameter. The width of the elements to be moved is defined by 
the width of the first element in the source area.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The value of the OUT output is invalid if the following condition is met:

● More data is moved than is made available at the IN parameter or OUT parameter.

Syntax
The following syntax is used for the instruction "Move block":

SCL
MOVE_BLK(IN := <Operand>,
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SCL
         COUNT := <Operand>,
         OUT => <Operand>)

Parameter
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type  
S7-1200 S7-1500 Description

IN 1) Input Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

The first element 
of the source area 
that is being copied

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of 
elements to be 
copied from the 
source area to the 
destination area

OUT 1) Output Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

The first element 
of the destination 
area to which the 
contents of the 
source area are 
being copied

1) The specified data types can only be used as elements of an ARRAY structure.

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
MOVE_BLK(IN := #a_array[2],
         COUNT := "Tag_Count",
         OUT => #b_array[1]);

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

Starting from the third element, the instruction selects three INT elements from the #a_array 
tag and copies their contents to the #b_array output tag, beginning with the second element.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

MOVE_BLK_VARIANT: Move block

Description
The instruction "Move block" copies the contents of a memory area (source area) to another 
memory area (destination area). You can copy elements of an array to another array of the 
same data type. The size (number of elements) of the source and destination array may be 
different. You can copy several elements within an array or individual elements.

If you are using the instruction, the array must not yet be known at the time the block is created, 
as the source and the destination are transferred using VARIANT.

The counting at the parameters SRC_INDEX and DEST_INDEX always starts with the low 
limit "0", regardless of the later declaration of the array.

The instruction is not executed if more data is copied than is made available.

Syntax
The following syntax is used for the instruction "Move block":

SCL
MOVE_BLK_VARIANT(SRC := <Operand>,
                 COUNT := <Operand>,
                 SRC_INDEX := <Operand>,
                 DEST_INDEX := <Operand>,
                 DEST := <Operand>,
                 RET_VAL => <Operand>)
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Parameter
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type Description
SRC Input VARIANT

(array or single element)
The first element of the 
source area that is being 
copied

COUNT Input UDINT Specifies the number of 
elements that will be copied.
Set the value at the 
parameter COUNT to “1”, if 
no Array is specified at the 
parameter SRC or the 
parameter DEST.

SRC_INDEX Input UDINT ● If an Array is specified at 
parameter SRC, the 
parameter SRC_INDEX 
specifies the first element 
at the parameter SRC, 
which is to be copied.

● If no Array is specified at 
the parameter SRC, then 
enter the value “0” at the 
parameter SRC_INDEX.

DEST_INDEX Input UDINT ● If an Array is specified at 
parameter DEST, the 
parameter DEST_INDEX 
specifies the first element 
at the parameter DEST, 
which is to be copied.

● If no Array is specified at 
the parameter DEST, 
then enter the value “0” at 
the parameter 
DEST_INDEX.

DEST InOut VARIANT The first element of the 
source area that is being 
copied

RET_VAL Output INT Error information:
If an error occurs during the 
execution of the instruction, 
an error code is output at the 
RET_VAL parameter.

For more information on valid data types, refer to "See also".
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Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8082 Data types do not correspond
80B4 Data types do not correspond
8151 Code generation error at SRC parameter
8152 Code generation error at SRC parameter
8153 Code generation error at SRC parameter
8251 The COUNT parameter has an invalid value
8254 The COUNT parameter has an invalid value
8281 The COUNT parameter has an invalid value
8282 The COUNT parameter has an invalid value
8382 The value at the SRC_INDEX parameter is outside the limit of the VARIANT
8383 The value at the SRC_INDEX parameter is outside the high limit of the array.
8482 The value at the DEST_INDEX parameter is outside the limit of the VARIANT
8483 The value at the DEST_INDEX parameter is outside the high limit of the 

array.
8534 The DEST parameter is write protected
8551 Code generation error at DEST parameter
8552 Code generation error at DEST parameter
8553 Code generation error at DEST parameter
85A2 The DEST parameter is write protected
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
MOVE_BLK_VARIANT(SRC := #SrcField,
                 COUNT := "Tag_Count",
                 SRC_INDEX := "Tag_Src_Index",
                 DEST_INDEX := "Tag_Dest_Index",
                 DEST := #DestField,
                 RET_VAL := "Tag_Result");

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
SRC #SrcField The local operand #SrcField 

uses a UDT that was still 
unknown at the time when the 
block was programmed.

COUNT Tag_Count 3
SRC_INDEX Tag_Src_Index 4
DEST_INDEX Tag_Dest_Index 2
DEST #DestField The local operand #DestField 

uses a UDT that was still 
unknown at the time when the 
block was programmed.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

UMOVE_BLK: Move block uninterruptible

Description
The instruction "Move block uninterruptible" copies the contents of a memory area (source 
area) to another memory area (destination area) without interruption. The number of elements 
to be copied to the destination area is specified with the COUNT parameter. The width of the 
elements to be moved is defined by the width of the first element in the source area.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The copy operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the instruction "Move 
block uninterruptible".

 

The value of the OUT output is invalid if the following condition is met:

● More data is moved than is made available at the IN parameter or OUT parameter.

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.
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Syntax
The following syntax is used for the instruction "Move block uninterruptible":

SCL
UMOVE_BLK(IN := <Operand>,
          COUNT := <Operand>,
          OUT => <Operand>)

Parameter
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN 1) Input Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

The first element 
of the source area 
that is being copied

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of 
elements to be 
copied from the 
source area to the 
destination area

OUT 1) Output Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

The first element 
of the destination 
area to which the 
contents of the 
source area are 
being copied

1) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
UMOVE_BLK(IN := #a_array[2],
          COUNT := "Tag_Count",
          OUT => #b_array[1]);

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

Starting from the third element, the instruction selects three INT elements from the #a_array 
tag and copies their contents to the #b_array output tag, beginning with the second element. 
The copy operation cannot be interrupted by other operating system activities.

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

FILL_BLK: Fill block

Description
The "Fill block" instruction is used to copy the content of a memory area (source area) to a 
selected memory area (target area). The number of repeated copy operations is specified with 
the COUNT parameter. When the instruction is executed, the source area is selected and 
moved to the destination area as often as specified by the value of the COUNT parameter.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The value of the OUT output is invalid if the following condition is met:

● More data is moved than is made available at input IN or output OUT.

Syntax
The following syntax is used for the instruction "Fill block":

SCL
FILL_BLK(IN := <Operand>,
         COUNT := <Operand>,
         OUT => <Operand>)
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Parameter
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN 1) Input Binary numbers, 
integers, floating-
point numbers, 
TIME, TOD, 
DATE, CHAR

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

Element used to 
fill the destination 
area

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of 
repeated copy 
operations

OUT 2) Output Binary numbers, 
integers, floating-
point numbers, 
TIME, TOD, 
DATE, CHAR

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

Address in 
destination area 
from which filling 
starts

1) The specified data types can also be used as elements of an ARRAY structure.
2) The specified data types can only be used as elements of an ARRAY structure.

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
FILL_BLK(IN := #a_array[2],
         COUNT := "Tag_Count",
         OUT => #b_array[1]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

The instruction copies the third element (#a_array[2]) of the #a_array tag three times to the 
#b_array output tag.
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See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

UFILL_BLK: Fill block uninterruptible

Description
The instruction "Fill block uninterruptible" is used to copy the content of a memory area (source 
area) to a selected memory area (target area). The number of repeated copy operations is 
specified with the COUNT parameter. When the instruction is executed, the value at the IN 
input is selected and copied to the destination area as often as specified by the value in the 
COUNT parameter.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The copy operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the "Fill block 
uninterruptible" instruction.

 

The value of the OUT output is invalid if the following condition is met:

● More data is moved than is made available at input IN or output OUT.

You can use the "Fill block uninterruptible" instruction to move a maximum of 16 KB. Note the 
CPU-specific restrictions for this.

Syntax
The following syntax is used for the "Fill block uninterruptible" instruction:

SCL
UFILL_BLK(IN := <Operand>,
          COUNT := <Operand>,
          OUT => <Operand>)
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Parameter
The following table shows the parameters of the "Fill block uninterruptible" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN 1) Input Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

Element used to 
fill the destination 
area

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of 
repeated copy 
operations

OUT 2) Output Binary numbers, 
integers, floating-
point numbers, 
TIME, TOD, 
DATE, CHAR

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

Address in 
destination area 
from which filling 
starts

1) The specified data types can also be used as elements of an ARRAY structure.
2) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
UFILL_BLK(IN := #a_array[2],
          COUNT := "Tag_Count",
          OUT => #b_array[1]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

The instruction copies the third element (#a_array[2]) of the #a_array tag three times to the 
#b_array output tag. The copy operation cannot be interrupted by other operating system 
activities.
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See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SWAP: Swap

Description       
You can use the "Swap" instruction to change the arrangement of the bytes of an input value 
and save the result in the specified operand.

The following figure shows how the bytes of an operand of the DWORD data type are swapped 
using the "Swap" instruction:

Syntax
The following syntax is used for the "Swap" instruction:

 SCL
SWAP(<Expression>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
S7-1200 S7-1500

<Expression> Input WORD, DWORD WORD, DWORD, 
LWORD

Input value

Function value WORD, DWORD WORD, DWORD, 
LWORD

Result of the 
instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 SCL
"Tag_Result" := SWAP("Tag_Value");

The result of the instruction is returned as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 0000 1111 0101 0101
Tag_Result 0101 0101 0000 1111

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Array data blocks

ReadFromArrayDB: Read from array data block

Description
You can use the "Read from array data block" instruction to read data from an array DB.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.
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Parameter
The following table shows the parameters of the "Read from array data block" instruction:

Parameter Declaration Data type Memory area Description
DB Input DB_ANY I, Q, M, D, L Data block that is 

read
INDEX Input DINT I, Q, M, D, L Element that is 

read
VALUE InOut VARIANT I, Q, M, D, L Value that is read
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For more information on valid data types, refer to "See also".

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".
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See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

WriteToArrayDB: Write to array data block

Description
You can use the "Write to array data block" instruction to write data to an array DB.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameter
The following table shows the parameters of the "Write to array data block" instruction:

Parameter Declaration Data type Memory area Description
DB Input DB_ANY I, Q, M, D, L Data block to 

which data is 
written

INDEX Input DINT I, Q, M, D, L Element in the DB 
to which data is 
written

VALUE Input VARIANT I, Q, M, D, L Value to be written
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For more information on valid data types, refer to "See also".
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Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

ReadFromArrayDBL: Read from array data block in load memory

Description
You can use the "Read from array data block in load memory" instruction to read data from an 
array DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". The instruction is terminated if a negative 
signal edge is detected at the BUSY parameter. The DONE parameter has the signal state "1" 
for one program cycle and the read value is output at the VALUE parameter within this cycle. 
With all other program cycles, the value at the VALUE parameter is not changed.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2173



When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameter
The following table shows the parameters of the "Read from array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L REQ = "1": 

Starting with the 
reading of the 
array DB

DB Input DB_ANY I, Q, M, D, L Data block that is 
read

INDEX Input DINT I, Q, M, D, L Element that is 
read

BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 
array DB is still 
being read

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully

VALUE InOut VARIANT I, Q, M, D, L Value that is read
RET_VAL Output INT I, Q, M, D, L Error information:

If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For more information on valid data types, refer to "See also".
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Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

WriteToArrayDBL: Write to array data block in load memory

Description
You can use the "Write to array data block in load memory" instruction to write data to an array 
DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". If a negative signal edge is detected at the 
BUSY parameter, the instruction is terminated and the value at the VALUE parameter is written 
to the data block. The DONE parameter then has the signal state "1" for one program cycle.
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When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameter
The following table shows the parameters of the "Write to array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L REQ = "1": Start 

writing to the array 
DB

DB Input DB_ANY D Data block to 
which data is 
written

INDEX Input DINT I, Q, M, D, L Element in the DB 
to which data is 
written

VALUE Input VARIANT I, Q, M, D, L Value to be written
BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 

array DB is still 
being written

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For more information on valid data types, refer to "See also".
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Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8131 The data block does not exist
8132 The data block is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Read/write access

PEEK: Read memory address

Description
The "Read memory address" instruction is used to read a memory address from a memory 
area without specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.
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Syntax
The following syntax is used for the "Read memory address" instruction:

SCL
PEEK(AREA:= <Operand>,
     DBNUMBER:= <Operand>,
     BYTEOFFSET:= <Operand>)

 

SCL
PEEK_<Data type>(AREA := <Operand>,
                DBNUMBER := <Operand>,
                BYTEOFFSET:= <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
AREA Input BYTE The following areas can 

be selected:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB
● 16#1: Peripheral 

input (S7-1500 only)
DBNUMBER Input DINT, DB_ANY Number of the data 

block if AREA = DB, 
otherwise "0"

BYTEOFFSET Input DINT Address to read from
_<Data type> Bit strings

default: BYTE
Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Bit strings Result of the instruction

For additional information on valid data types, refer to "See also".
 

 Note

If you read the memory address of the input, output or bit memory areas, you will need to set 
the "DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.
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Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := PEEK(AREA := "Tag_Area",
                      DBNUMBER := "Tag_DBNumber",
                      BYTEOFFSET := "Tag_Byte");

 

SCL
"Tag_Result2" := PEEK_WORD(AREA := "Tag_Area",
                           DBNUMBER := "Tag_DBNumber",
                           BYTEOFFSET := "Tag_Byte");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA Tag_Area 16#84
DBNUMBER Tag_DBNumber 5
BYTEOFFSET Tag_Byte 20
Function value Tag_Result1 Byte value "20"
Function value Tag_Result2 Word value "20"

The instruction reads the value of address "20" from the "Tag_Byte" operand at data block "5" 
and returns the result as a function value at the "Tag_Result" operand.

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

PEEK_BOOL: Read memory bit

Description
The "Read memory bit" instruction is used to read a memory bit from a memory area without 
specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

 

 Note

The instruction can only be used to access "Standard" memory areas.
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Syntax
The following syntax is used for the "Read memory bit" instruction:

SCL
PEEK_BOOL(AREA := <Operand>,
          DBNumber := <Operand>,
          BYTEEOFFSET := <Operand>,
          BITOFFSET := <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
AREA Input BYTE The following areas can 

be selected:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB
● 16#1: Peripheral 

input (S7-1500 only)
DBNUMBER Input DINT, DB_ANY Number of the data 

block if AREA = DB, 
otherwise "0"

BYTEOFFSET Input DINT Address to read from
BITOFFSET Input INT Bit to be read from
Function value BOOL Result of the instruction

For additional information on valid data types, refer to "See also".
 

 Note

If you read the memory bit from the input, output or bit memory areas, you will need to set 
the "DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := PEEK_BOOL(AREA := "Tag_Area",
                          DBNUMBER := "Tag_DBNumber",
                          BYTEOFFSET := "Tag_Byte",
                          BITOFFSET := "Tag_Bit");

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
AREA Tag_Area 16#84
DBNUMBER Tag_DBNumber 5
BYTEOFFSET Tag_Byte 20
BITOFFSET Tag_Bit 3
Function value Tag_Result 3

The instruction reads the value of memory bit "3" from the "Tag_Bit" operand at byte "20" of 
data block "5" and returns the result at the "Tag_Result" operand as function value.

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

POKE: Write memory address

Description
The "Write memory address" instruction is used to write a memory address to a memory area 
without specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

 

 Note

The instruction can only be used to access "Standard" memory areas.
 

Syntax
The following syntax is used for the "Write memory address" instruction:

SCL
POKE(AREA := <Operand>,
     DBNUMBER := <Operand>,
     BYTEOFFSET := <Operand>,
     VALUE := <Operand>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
AREA Input BYTE The following areas can 

be selected:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB
● 16#2: Peripheral 

output (S7-1500 
only)

DBNUMBER Input DINT, DB_ANY Number of the data 
block if AREA = DB, 
otherwise "0"

BYTEOFFSET Input DINT Address to be written
VALUE Input Bit strings Value to be written

For additional information on valid data types, refer to "See also".
 

 Note

If you write the memory address in the input, output or bit memory areas, you will need to set 
the "DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
POKE(AREA := "Tag_Area",
     DBNUMBER := "Tag_DBNumber",
     BYTEOFFSET := "Tag_Byte"),
     VALUE := "Tag_Value";

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA Tag_Area 16#84
DBNUMBER Tag_DBNumber 5
BYTEOFFSET Tag_Byte 20
VALUE Tag_Value 16#11

The instruction overwrites the memory address "20" in the data block "5" with value "16#11".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2182 System Manual, 07/2013,  



See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

POKE_BOOL: Write memory bit

Description
The "Write memory bit" instruction is used to write a memory bit to a memory area without 
specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

 

 Note

The instruction can only be used to access "Standard" memory areas.
 

Syntax
The following syntax is used for the "Write memory bit" instruction:

SCL
POKE_BOOL(AREA := <Operand>,
          DBNUMBER := <Operand>,
          BYTEOFFSET := <Operand>,
          BITOFFSET := <Operand>,
          VALUE := <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
AREA Input BYTE The following areas can 

be selected:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB
● 16#2: Peripheral 

input (S7-1500 only)
DBNUMBER Input DINT, DB_ANY Number of the data 

block if AREA = DB, 
otherwise "0"

BYTEOFFSET Input DINT Address to be written
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Parameter Declaration Data type Description
BITOFFSET Input INT Bit to be written
VALUE Input BOOL Value to be written

For additional information on valid data types, refer to "See also".
 

 Note

If you write the memory bit in the input, output or bit memory areas, you need to set the 
"DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
POKE_BOOL(AREA := "Tag_Area",
          DBNUMBER := "Tag_DBNumber",
          BYTEOFFSET := "Tag_Byte",
          BITOFFSET := "Tag_Bit",
          VALUE := "Tag_Value");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA Tag_Area 16#84
DBNUMBER Tag_DBNumber 5
BYTEOFFSET Tag_Byte 20
BITOFFSET Tag_Bit 3
VALUE Tag_Value M0.0

The instruction overwrites the memory bit "3" in data block "5" in byte "20" with the value "M0.0".

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

POKE_BLK: Write memory area

Description
The "Write memory area" instruction copies the content a memory area to a different memory 
area without specifying a data type.
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If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

 

 Note

The instruction can only be used to access "Standard" memory areas.
 

Syntax
The following syntax is used for the "Write memory area" instruction:

SCL
POKE_BLK(AREA_SRC:= <Operand>,
         DBNUMBER_SRC:= <Operand>,
         BYTEOFFSET_SRC:= <Operand>,
         AREA_DEST:= <Operand>,
         DBNUMBER_DEST:= <Operand>,
         BYTEOFFSET_DEST:= <Operand>,
         COUNT:= <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
AREA_SRC Input BYTE The following areas can 

be selected in the 
source memory area:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB

DBNUMBER_SRC Input DINT, DB_ANY Number of the data 
block in the source 
memory area, if AREA 
= DB, otherwise "0"

BYTEOFFSET_SRC Input DINT Address in the source 
memory area to be 
written

AREA_DEST Input BYTE The following areas can 
be selected in the 
destination memory 
area:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB

DBNUMBER_DEST Input DINT, DB_ANY Number of the data 
block in the destination 
memory area, if AREA 
= DB, otherwise "0"
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Parameter Declaration Data type Description
BYTEOFFSET_DEST Input DINT Address in the 

destination memory 
area to be written

COUNT Input DINT Number of bytes which 
are copied

For additional information on valid data types, refer to "See also".
 

 Note

If you write the memory address in the input, output or bit memory areas, you will need to set 
the "DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
POKE_BLK(AREA_SRC := "Tag_Source_Area",
         DBNUMBER_SRC := "Tag_Source_DBNumber",
         BYTEOFFSET_SRC := "Tag_Source_Byte"),
         AREA_DEST := "Tag_Destination_Area",
         DBNUMBER_DEST := "Tag_Destination_DBNumber",
         BYTEOFFSET_DEST := "Tag_Destination_Byte",
         COUNT := "Tag_Count");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA_SRC Tag_Source_Area 16#84
DBNUMBER_SRC Tag_Source_DBNumber 5
BYTEOFFSET_SRC Tag_Source_Byte 20
AREA_DEST Tag_Destination_Area 16#83
DBNUMBER_DEST Tag_Destination_DBNumber 0
BYTEOFFSET_DEST Tag_Destination_Byte 30
COUNT Tag_Count 100

The instruction writes 100 byte from data block "5" starting with address "20" in the memory 
area of the bit memory starting at address "30".

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)
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Other

BLKMOV: Move block

Description
The instruction "Move block" copies the contents of a memory area (source area) to another 
memory area (destination area). The move operation takes place in the direction of ascending 
addresses. You use VARIANT to define the source and destination areas.

 

 Note

The tags of the instruction can only be used in data blocks in which the attribute "Optimized 
block access" is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

The following figure shows the principle of the move operation:

Consistency of the source data and destination data
Note that while the instruction "Move block" is being executed, the source data remains 
unchanged; otherwise the consistency of the destination data cannot be guaranteed.

Interruptibility
There is no limit to the nesting depth.
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Memory areas
The instruction "Move block" moves the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules when copying
The source and destination areas must not overlap. If the source and destination areas have 
different lengths, only the length of the smaller area will be moved.

If the source area is smaller than the destination area, the entire source area will be written to 
the destination area. The remaining bytes of the destination area remain unchanged. 

If the destination area is smaller than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

Rules for moving character strings
You can use the "Move block" instruction to also move source and destination areas of the 
STRING data type. If only the source area is of the data type STRING, the characters that are 
actually contained in the character string are moved. Information on the actual and maximum 
length is also written to the destination area. If the source and destination area are both 
STRING data type, the current length of the character string in the destination area is set to 
the number of characters actually moved.

If you want to move the information on the maximum and actual length of a character string, 
specify the areas in bytes in the SRCBLK and DSTBLK parameters. 

Syntax
The following syntax is used for the instruction "Move block":

SCL
BLKMOV(SRCBLK:= <Operand>,
       DSTBLK => <Operand>)
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Parameter
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type Description
SRCBLK Input VARIANT Specifies the memory 

area to be moved 
(source area).

DSTBLK Output VARIANT Specifies the memory 
area to which the data 
will be moved 
(destination area).

Function value (RET_VAL) INT Error information

For additional information on valid data types, refer to "See also".

RET_VAL Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8091 The permitted nesting depth was exceeded
8092 The instruction cannot be executed because a specified data block is write protected, non-executable, or 

not loaded.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

GET_ERR_ID: Get error ID locally (Page 2237)

UBLKMOV: Move block uninterruptible

Description
The instruction "Move block uninterruptible" copies the contents of a memory area (source 
area) to another memory area (destination area). The move operation takes place in the 
direction of ascending addresses. You use VARIANT to define the source and destination 
areas.
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The copy operation cannot be interrupted by other operating system activities. As a result the 
alarm reaction time of the CPU can increase during the execution of the instruction "Move 
block uninterruptible".

 

 Note

The tags of the instruction can only be used in data blocks in which the attribute "Optimized 
block access" is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

Memory areas
You can use the "Move block uninterruptible" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules when copying
The source and destination area must not overlap during the execution of the instruction "Move 
block uninterruptible". If the source area is smaller than the destination area, the entire source 
area will be written to the destination area. The remaining bytes of the destination area remain 
unchanged.

If the destination area is smaller than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a source or destination area defined as a formal parameter is less than a destination or 
source area specified on the SRCBLK or DSTBLK  parameter, No data is transferred.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Rules for moving character strings
The instruction "Move block uninterruptible" copies source and destination areas of the data 
type STRING. If only the source area is of the data type STRING, the characters that are 
actually contained in the character string are moved. Information on the actual and maximum 
length are not written in the destination area. If the source and destination area are both 
STRING data type, the current length of the character string in the destination area is set to 
the number of characters actually moved. If areas of the STRING data type are moved, specify 
"1" as the area length.
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Syntax
The following syntax is used for the instruction "Move block uninterruptible":

SCL
UBLKMOV(SRCBLK:= <Operand>,
        DSTBLK => <Operand>)

Parameter
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Description
SRCBLK Input VARIANT Specifies the memory 

area to be moved 
(source area).

DSTBLK Output ANY Specifies the memory 
area to which the data 
will be moved 
(destination area).

Function value (RET_VAL) VARIANT Error information

For additional information on valid data types, refer to "See also".

RET_VAL Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code
(W#16#...)

Explanation

0000 No error
8091 The source area is in a data block that is not relevant for program execution.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

GET_ERR_ID: Get error ID locally (Page 2237)
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FILL: Fill block

Description
The instruction "Fill block" fills a memory area (destination area) with the content of another 
memory area (source area). The instruction "Fill block" copies the content of the source area 
to the destination area until the destination area is completely written. The move operation 
takes place in the direction of ascending addresses.

You use VARIANT to define the source and destination areas.
 

 Note

The tags of the instruction can only be used in data blocks in which the attribute "Optimized 
block access" is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

For blocks with the "Optimized block access" attribute, you can use the "FILL_BLK: Fill block" 
instruction.

 

The following figure shows the principle of the move operation:

Example: The contents of the range MW100 to MW118 are to be preassigned with the contents 
of the memory words MW14 to MW20.

Consistency of the source data and destination data
Note that while the instruction "Fill block" is being executed, the source data remains 
unchanged; otherwise the consistency of the destination data cannot be guaranteed.
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Memory areas
The instruction "Fill block" copies the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

The instruction "Fill block" copies the following memory areas:

● Instructions, system data blocks

● Counters

● Timers

● Memory areas of the I/O area

General rules when copying
The source and destination areas must not overlap. If the destination area to be preset is not 
an integer multiple of the length of the BVAL input parameter, the destination area is 
nevertheless written up to the last byte.

If the destination area to be preset is smaller than the source area, the function only copies as 
much data as can be written to the destination area.

If the actually present destination or source area is smaller than the assigned memory area 
for the source or destination area (BVAL, BLK parameters), No data is transferred.

If the ANY pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.

If the destination area is STRING data type, the instruction writes the entire string including 
the administration information.

Syntax
The following syntax is used for the instruction "Fill block":

SCL
FILL(BVAL:= <Operand>,
     BLK => <Operand>)
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Parameter
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Description
BVAL Input VARIANT Specification of the 

memory area (source 
area) with whose 
content the destination 
area on the BLK 
parameter will be filled.

BLK Output VARIANT Specification of the 
memory area that will 
be filled with the content 
of the source area.

Function value (RET_VAL) INT Error information

For additional information on valid data types, refer to "See also".

BVAL Parameter
When you transfer a structure as an input parameter, remember that the length of a structure 
is always based on an even number of bytes. The structure will need one byte of additional 
memory space if you declare a structure with an odd number of bytes.

RET_VAL Parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code
(W#16#...)

Explanation

0000 No error
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

GET_ERR_ID: Get error ID locally (Page 2237)
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Conversion operations

CONVERT: Convert value

Description       
Use the "Convert value" instruction to program explicit conversions. You determine the data 
types to be converted in a dialogue box with opens automatically when you insert the 
instruction. When executed, the instruction reads the source value and converts it into the 
specified target value.

For information on possible conversions, refer to the "Explicit conversion" section at "See also".
 

 Note

For S7-1500 CPU: You can select the data types DWORD and LWORD if REAL or LREAL 
were selected as IN data type.

 

Syntax
Use the following syntax for the "Convert value" instruction:

SCL
<Target_value> := <Conversion_function>(<Source_value>);

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

<Source_value> Input, constant Bit strings, 
integers, floating-
point numbers, 
TIME, DATE, 
TOD, DTL, strings

Bit strings, 
integers, floating-
point numbers, 
TIME, LTIME, 
DATE, TOD, 
LTOD, DTL, 
strings

Value to be 
converted.

<Conversion_function
>

- - - Function that 
specifies the data 
type to be 
converted .

<Target_value> Output Bit strings, 
integers, floating-
point numbers, 
TIME, DATE, 
TOD, DTL, strings

Bit strings, 
integers, floating-
point numbers, 
TIME, LTIME, 
DATE, TOD, 
LTOD, DTL, 
strings

Result of the 
conversion

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

 SCL
"Tag_INT" := REAL_TO_INT("Tag_REAL");

The following table shows how the instruction works using specific operand values:

Operand Data type Value
Tag_REAL REAL 20.56
Tag_INT INT 21

During the conversion, the value of the "Tag_REAL" operand will be rounded to the nearest 
integer and saved in the "Tag_INT" operand.

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

ROUND: Round numerical value

Description     
The "Round numerical value" instruction is used to round the value at input IN to the nearest 
integer. The instruction interprets the value at input IN as a floating-point number and converts 
it into an integer or floating-point number. If the input value is exactly between an even and 
odd number, the even number is selected.

Syntax
The following syntax is used for the "Round numerical value" instruction:

SCL
ROUND(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value to be 

rounded.
Function value Integers, floating-point 

numbers
Result of the rounding
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ROUND("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 1.50000000 -1.50000000
Tag_Result 2 -2

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

CEIL: Generate next higher integer from floating-point number

Description     
Use the "Generate next higher integer from floating-point number" instruction to round the 
value to the nearest integer. The instruction interprets the input value as floating-point number 
and converts it to the next higher integer. The function value can be greater than or equal to 
the input value.

Syntax
The following syntax is used for the "Generate next higher integer from floating-point number" 
instruction:

SCL
CEIL(<Expression>)
CEIL_<Data type>(<Expression>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
<Expression> Input Floating-point 

numbers
Input value

_<Data type> Integers, floating-
point numbers. 
Default: DINT

Data type of the function value:
● You do not need to specify the data 

type if using the default.
● Any other valid data type you may use 

must be declared explicitly.
Function value Integers, floating-

point numbers
Input value rounded up

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := CEIL("Tag_Value");
"Tag_Result2" := CEIL_REAL("Tag_Value);

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 0.5 -0.5
Tag_Result1 1 0
Tag_Result2 1.0 0.0

The result of the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

FLOOR: Generate next lower integer from floating-point number

Description     
Use the "Generate next lower integer from floating-point number" instruction to round the value 
of a floating point number to the next lower integer. The instruction interprets the input value 
as floating-point number and converts it to the next lower integer. The function value can be 
equal or less than the input value.
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Syntax
Use the following syntax for the "Generate next lower integer from floating-point number" 
instruction:

SCL
FLOOR(<Expression>)
FLOOR_<data type>(<expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point 

numbers
Input value

_<Data type> Integers, floating-
point numbers. 
Default: DINT

Data type of the function value:
● You do not need to specify the data 

type if using the default.
● Any other valid data type you may 

use must be declared explicitly.
Function value Integers, floating-

point numbers
Input value rounded

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := FLOOR("Tag_Value");
"Tag_Result2" := FLOOR_REAL("Tag_Value");

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 0.5 -0.5
Tag_Result1 0 -1
Tag_Result2 0.0 -1.0

The result of the instruction is returned in the operand "Tag_Result" as a function value.
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See also
Overview of the valid data types (Page 1077)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

TRUNC: Truncate numerical value

Description
The "Truncate numerical value" instruction is used to generate an integer from the input value 
without rounding. The instruction selects only the integer part of the input value and returns 
this part without decimal places as the function value.

Syntax
The following syntax is used for the "Truncate numerical value" instruction:

SCL
TRUNC(<Expression>)
TRUNC_<Data type>(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
_<Data type> Integers, floating-point 

numbers
Default: DINT

Data type of the function value:
● You do not need to specify the 

data type if using the default.
● Any other valid data type you 

may use must be declared 
explicitly.

Function value Integers, floating-point 
numbers

Integer component of the input 
value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := TRUNC("Tag_Value1");
"Tag_Result2" := TRUNC("Tag_Value2"+"Tag_Value3");
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SCL
"Tag_Result3" := TRUNC_SINT("Tag_Value4");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value1 -1.5
Tag_Result1 -1
Tag_Value2 2.1
Tag_Value3 3.2
Tag_Result2 5
Tag_Result3 2
Tag_Value4 2.4

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SCALE_X: Scale

Description
Use the "Scale" instruction to scale a floating-point number by mapping it to a specific value 
range. You specify the value range with the MIN and MAX parameters. The result of the scaling 
is an integer.

The following figure shows an example of how values can be scaled:
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The instruction "Scale" works with the following equation:

OUT = [VALUE ∗ (MAX – MIN)] + MIN

Syntax
The following syntax is used for the "Scale" instruction:

SCL
SCALE_X(MIN := <Operand>,
        VALUE := <Operand>,
        MAX := <Operand>)
SCALE_X_<Data type>(MIN := <Operand>,
                   VALUE := <Operand>,
                   MAX := <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
MIN Input Integers, floating-point numbers Low limit of the value 

range
VALUE Input Floating-point numbers Value to be scaled.

If you enter a constant, 
you must declare it.

MAX Input Integers, floating-point numbers High limit of the value 
range
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Parameter Declaration Data type Description
_<Data type> Integers, floating-point numbers

Default: INT
Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Integers, floating-point numbers Result of scaling

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := SCALE_X(MIN := "Tag_Value1", 
                         VALUE := "Tag_Real",
                         MAX := "Tag_Value2");
"Tag_Result2" := SCALE_X_REAL(MIN := "Tag_Value1", 
                              VALUE := "Tag_Real",
                              MAX := "Tag_Value2");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Real 0.5
Tag_Value1 10
Tag_Value2 30
Tag_Result1 20
Tag_Result2 20.0

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Declaring constants (Page 1188)
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NORM_X: Normalize

Description
You can use the instruction "Normalize" to normalize the value of the tag at the VALUE input 
by mapping it to a linear scale. You can use the parameters MIN and MAX to define the limits 
of a value range that is applied to the scale. Depending on the location of the normalized value 
in this value range, the result at output OUT is calculated and stored as a floating-point number. 
If the value to be normalized equals the value at input MIN, the instruction returns returns the 
result "0.0". If the value to be normalized equals the value at input MAX, the instruction returns 
returns the result "1.0".

The following figure shows an example of how values can be normalized:

The "Normalize" instruction works with the following equation:

OUT = (VALUE – MIN) / (MAX – MIN)

Syntax
The following syntax is used for the "Normalize" instruction:

SCL
NORM_X(MIN := <Operand>,
       VALUE := <Operand>,
       MAX := <Operand>)
NORM_X_<Data type>(MIN := <Operand>,
                  VALUE := <Operand>,
                  MAX := <Operand>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
MIN 1) Input Integers, floating-point 

numbers
Low limit of the value 
range

VALUE 1) Input Integers, floating-point 
numbers

Value to be normalized.

MAX 1) Input Integers, floating-point 
numbers

High limit of the value 
range

_<Data type> Floating-point numbers
Default: REAL

Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Floating-point numbers Result of the 
normalization

1) If you use constants in these three parameters, you only need to declare one of them.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := NORM_X(MIN := "Tag_Value1",
                       VALUE := "Tag_InputValue",
                       MAX := "Tag_Value2");
"Tag_Result2" := NORM_X_LREAL(MIN := "Tag_Value1",
                             VALUE := "Tag_InputValue",
                             MAX := "Tag_Value2");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_InputValue 20
Tag_Value1 10
Tag_Value2 30
Tag_Result1 0.5
Tag_Result2 0.5
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See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Declaring constants (Page 1188)

VARIANT

VARIANT_TO_DB_ANY: Convert VARIANT to DB_ANY

Description
The instruction "Convert VARIANT to DB_ANY" is used to read the number of the data block 
from a VARIANT and covert it to the data type DB_ANY.

Requirements
If the conditions are met, the instruction is executed. If the conditions are not met, "0" is output 
as data block number.

The output tag... homed... Conversion options
VARIANT ...a data block which is an instance data 

block of an UDT or SDT
The output tag can be converted to a 
data block number.

VARIANT ...an Array DB The output tag can be converted to a 
data block number.

VARIANT ...an object with an elementary data type It is not possible to convert the output 
tag to a database number because a 
data block can never comprise only one 
elementary data type.

VARIANT ...a structure within a data block It is not possible to convert the output 
tags to a database number because it is 
only a part within the data block.

Syntax
The following syntax is used for the "Convert VARIANT To DB_ANY" instruction:

SCL
VARIANT_TO_DB_ANY(IN := <Operand>,
                  ERR => <Operand>)
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Parameter
The following table shows the parameters of the "Convert VARIANT to DB_ANY" instruction:

Parameter Declaration Data type Memory area Description
IN Input VARIANT I, Q, M, D, L Tag to be read
ERR Output INT I, Q, M, D, L Error information
Function value DB_ANY I, Q, M, D, L Result: Number of 

the DB

For more information on valid data types, refer to "See also".

ERR parameter
The following table shows the meaning of the values of the ERR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
252C The VARIANT data type has the value "0"
8130 The number of the data block is "0"
8131 The data block does not exist
8132 The data block is too short
8134 The data block is write protected
8150 The VARIANT data type has the value "0"
8154 The data type is not correctly declared
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

DB_ANY_TO_VARIANT: Convert DB_ANY to VARIANT

Description
The instruction "Convert DB_ANY to VARIANT" is used to read the number of the data block 
from a DB_ANY and covert it to the data type VARIANT.
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Requirements
If the conditions are met, the instruction is executed. If the conditions are not met or the data 
block does not exist, the value "0" is output. All additional accesses to this value "0" fail.

The output tag... homed... Conversion options
DB_ANY ...a data block which is an instance data 

block of an UDT or SDT
It is possible to convert the output tag to 
the VARIANT data type.

DB_ANY ...a DB which is an ARRAY DB It is possible to convert the output tag to 
the VARIANT data type.

DB_ANY ...a data block which is an instance data 
block of a function block or a global data 
block

It is not  possible to convert the output 
tags to the VARIANT data type.

Syntax
The following syntax is used for the "Convert DB_ANY to VARIANT" instruction:

SCL
DB_ANY_TO_VARIANT(IN := <Operand>,
                  ERR => <Operand>)

Parameter
The following table shows the parameters of the "Convert DB_ANY to VARIANT" instruction:

Parameter Declaration Data type Memory area Description
IN Input DB_ANY I, Q, M, D, L Tag to be read
ERR Output INT I, Q, M, D, L Error information
Function value VARIANT L Result

For more information on valid data types, refer to "See also".

ERR parameter
The following table shows the meaning of the values of the parameter ERR:

Error code*
(W#16#...)

Explanation

0000 No error
8130 The number of the data block is "0"
8131 The data block does not exist
8132 The data block is too short
8134 The data block is write protected
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Error code*
(W#16#...)

Explanation

8154 The data type is not correctly declared
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Other

SCALE: Scale

Description
The instruction "Scale" converts the integer on the parameter IN into a floating-point number, 
which can be scaled in physical units between a low and a high limit. You can use the LO_LIM 
and HI_LIM parameters to specify the low limit and high limit of the value range to which the 
input value is scaled. The result of the instruction is output on the OUT parameter.

The instruction "Scale" works with the following equation:

OUT = [((FLOAT (IN) – K1)/(K2–K1)) ∗ (HI_LIM–LO_LIM)] + LO_LIM

The values of the "K1" and "K2" constants are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter: 

● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the "K2" constant, the result 
of the instruction is set to the value of the high limit (HI_LIM) and an error is output.

When the value at the IN parameter is less than the value of the "K1" constant, the result of 
the instruction is set to the value of the low limit value (LO_LIM) and an error is output.

When the indicated low limit is greater than the high limit (LO_LIM >HI_LIM), the result is scaled 
in reverse proportion to the input value.
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Syntax
The following syntax is used for the "Scale" instruction:

SCL
SCALE(IN:= <Expression>,
      HI_LIM := <Operand>,
      LO_LIM := <Operand>,
      BIPOLAR := <Operand>,
      OUT => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
IN Input INT Input value to be scaled.
HI_LIM Input REAL High limit
LO_LIM Input REAL Low limit
BIPOLAR Input BOOL Indicates if the value at 

the IN parameter is to 
be interpreted as 
bipolar or unipolar. The 
parameter can assume 
the following values:
1: Bipolar
0: Unipolar

OUT Output REAL Result of the instruction
Function value (RET_VAL) WORD Error information

For additional information on valid data types, refer to "See also".

RET_VAL Parameter
The following table shows the meaning of the values of the parameter RET_VAL:

Error code
(W#16#...)

Explanation

0000 No error
0008 The value of the parameter IN is greater than 27 648 or is less than 0 (unipolar) or -27 

648 (bipolar).
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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Example
The following example shows how the instruction works:

 
"Tag_ErrorCode" := SCALE(IN := "Tag_InputValue",
                         HI_LIM := "Tag_HighLimit"
                         LO_LIM := "Tag_LowLimit"
                         BIPOLAR := "Tag_Bipolar",
                         OUT => "Tag_Result");

The error information is returned in the operand "Tag_ErrorCode" as a function value.

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 22
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_Result 50.03978588
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

GET_ERR_ID: Get error ID locally (Page 2237)

UNSCALE: Unscale

Description
The instruction "Unscale" unscales the floating-point number on the IN parameter in physical 
units between a low and a high limit and converts them into an integer. You can use the LO_LIM 
and HI_LIM parameters to specify the low limit and high limit of the value range to which the 
input value is unscaled. The result of the instruction is output on the OUT parameter.

The instruction "Unscale" works with the following equation:

OUT = [((IN–LO_LIM)/(HI_LIM–LO_LIM)) ∗ (K2–K1)] + K1

The values of the "K1" and "K2" constants are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter: 
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● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the "HI_LIM" constant, the 
result of the instruction is set to the value of the constant (K2) and an error is output. 

When the value at the IN parameter is less than the value of the constant of the low limit 
(LO_LIM), the result of the instruction is set to the value of the constant (K1) and an error is 
output.

Syntax
The following syntax is used for the instruction "Unscale":

SCL
UNSCALE(IN := <Expression>,
        HI_LIM := <Operand>,
        LO_LIM := <Operand>,
        BIPOLAR := <Operand>,
        OUT => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
IN Input REAL Input value to be 

unscaled to an integer 
value.

HI_LIM Input REAL High limit
LO_LIM Input REAL Low limit
BIPOLAR Input BOOL Indicates if the value at 

the IN parameter is to 
be interpreted as 
bipolar or unipolar. The 
parameter can assume 
the following values:
1: Bipolar
0: Unipolar

OUT Output INT Result of the instruction
Function value (RET_VAL) WORD Error information

For additional information on valid data types, refer to "See also".
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RET_VAL Parameter
The following table shows the meaning of the values of the parameter RET_VAL:

Error code
(W#16#...)

Explanation

0000 No error
0008 The value of the IN parameter is greater than the value of the high limit (HI_LIM) or less than the value 

of the low limit (LO_LIM).
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_ErrorCode" := UNSCALE(IN := "Tag_InputValue",
                           HI_LIM := "Tag_HighLimit"
                           LO_LIM := "Tag_LowLimit"
                           BIPOLAR := "Tag_Bipolar",
                           OUT => "Tag_Result");

The error information is returned in the operand "Tag_ErrorCode" as a function value.

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 50.03978588
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_Result 22
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Expressions (Page 1341)

Operators and operator precedence (Page 1347)

GET_ERR_ID: Get error ID locally (Page 2237)
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Program control operations

IF: Run conditionally

Description       
The instruction "Run conditionally" branches the program flow depending on a condition. The 
condition is an expression with Boolean value (TRUE or FALSE). Logical expression or 
comparative expressions can be stated as conditions.

When the instruction is executed, the stated expressions are evaluated. If the value of an 
expression is TRUE, the condition is fulfilled; if the value is FALSE, it is not fulfilled.

Syntax
Depending on the type of branch, you can program the following forms of the instruction:

● Branch through IF:

SCL
IF <Condition> THEN <Instructions>
END_IF;

If the condition is satisfied, the instructions programmed after the THEN are executed. If the 
condition is not satisfied, the execution of the program continues with the next instruction after 
the  END_IF.

● Branch through IF and ELSE:

SCL
IF <Condition> THEN <Instructions1>
ELSE <Instructions0>;
END_IF;

If the condition is satisfied, the instructions programmed after the THEN are executed. If the 
condition is not satisfied, the instructions programmed after the ELSE are executed. Then the 
execution of the program continues with the next instruction after the  END_IF.

● Branch through IF, ELSIF and ELSE:

SCL
IF <Condition1> THEN <Instructions1>
ELSIF <Condition2> THEN <Instruction2>
ELSE <Instructions0>;
END_IF;

If the first condition (<Condition1>) is satisfied, the instructions (<Instructions1>) after the 
THEN are executed. After execution of the instructions, the execution of the program continues 
after the END_IF.
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If the first condition is not satisfied, the second condition (<Condition2>) is checked. If the 
second condition (<Condition2>) is fulfilled, the instructions (<Instructions2>) after the THEN 
are executed. After execution of the instructions, the execution of the program continues after 
the END_IF.

If none of the conditions are fulfilled, the instructions (<Instructions0>) after ELSE are executed 
followed by the execution of the program after END_IF.

You can nest as many combinations of ELSIF and THEN as you like within the IF instruction. 
The programming of an ELSE branch is optional.

The syntax of the IF instruction consists of the following parts:

Parameter Data type Description
<Condition> BOOL Expression to be evaluated
<Instructions> - Instructions to be executed with satisfied condition. An 

exception are instructions programmed after the ELSE. These 
are executed if no condition within the program loop is satisfied.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF "Tag_1" = 1
THEN "Tag_Value" := 10;
ELSIF "Tag_2" = 1
THEN "Tag_Value" := 20;
ELSIF "Tag_3" = 1
THEN "Tag_Value" := 30;
ELSE "Tag_Value" := 0;
END_IF;

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_1 1 0 0 0
Tag_2 0 1 0 0
Tag_3 0 0 1 0
Tag_Value 10 20 30 0
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See also
Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

CASE: Create multiway branch

Description
The instruction "Create multiway branch" executes one of several instruction sequences 
depending on the value of a numerical expression.

The value of the expression must be an integer. When the instruction is executed, the value 
of the expression is compared with the values of several constants. If the value of the 
expression agrees with the value of a constant, the instructions programmed directly after this 
constant are executed. The constants can assume the following values:

● An integer (for example, 5)

● A range of integers (for example, 15..20)

● An enumeration consisting of integers and ranges (for example, 10, 11, 15..20)

Syntax
The following syntax is used for the "Create multiway branch" instruction:

SCL
CASE <expression> OF
<Constant1>: <Instructions1>
<Constant2>: <Instructions2>
<ConstantX>: <InstructionsX>; // X >=3
ELSE <Instructions0>;
END_CASE;

The syntax of the instruction consists of the following parts:
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Parameter Data type Description
<expression> Integers Value which is compared to the programmed constant values.
<Constant> Integers Constant values which form the condition for the execution of 

an instruction sequence. The constants can assume the 
following values:
● An integer (for example, 5)
● A range of integers (for example, 15..20)
● An enumeration consisting of integers and ranges (for 

example, 10, 11, 15..20)
<Instruction> - Any instructions which are executed if the value of the 

expression agrees with the value of a constant. An exception 
are instructions programmed after the ELSE. These 
instructions are executed if the values do not agree.

For additional information on valid data types, refer to "See also".

If the value of the expression agrees with the value of the first constant (<Constant1>), the 
instructions (<Instructions1>) which are programmed directly after the first constant are 
executed. Program execution subsequently resumes after the END_CASE.

If the value of the expression does not agree with the value of the first constant (<Constant1>), 
this value is compared to the value of the constant which is programmed next. In this way, the 
CASE instruction is executed until the values agree. If the value of the expression does not 
correspond to any of the programmed constant values, the instructions (<Instructions0>) which 
are programmed after the ELSE are executed. ELSE is an optional part of the syntax and can 
be omitted.

The CASE instruction can also be nested by replacing an instruction block with CASE. 
END_CASE represents the end of the CASE instruction.

Example
The following example shows how the instruction works:

SCL
CASE "Tag_Value" OF
     0 :
     "Tag_1" := 1;
     1,3,5 :
     "Tag_2" :=1;
     6..10 :
     "Tag_3" := 1;
     16,17,20..25 :
     "Tag_4" := 1;
ELSE "Tag_5" := 1;
END_CASE;

The following table shows how the instruction works using specific operand values:
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Operand Values
Tag_Value 0 1, 3 , 5 6, 7, 8, 9, 10 16,17, 20, 21, 

22, 23, 24, 25
2

Tag_1 1 - - - -
Tag_2 - 1 - - -
Tag_3 - - 1 - -
Tag_4 - - - 1 -
Tag_5 - - - - 1
1: The operand is set to the signal state "1".
-: The signal state of the operand remains unaltered.

See also
CONTINUE: Recheck loop condition (Page 2223)

Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

EXIT: Exit loop immediately (Page 2224)

FOR: Run in counting loop

Description
The instruction "Run in counting loop" causes repeated execution of a program loop until a 
loop variable lies within a specified value range.

Program loops can also be nested. Within a program loop, you can program additional program 
loops with other loop variables.

The current continuous run of a program loop can be ended by the instruction "Recheck loop 
condition" (CONTINUE). The instruction "Exit loop immediately" (EXIT) ends the entire loop 
execution. For additional information on this topic, refer to "See also".

Limit values for FOR statements
To program "safe" FOR statements that do not run endlessly, observe the following rules and 
limit values:

Rule
FOR ii := Start TO End BY Step DO
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If ... ... then Note
start < end end < (PMAX step) Run tag ii runs in a positive 

direction
start > end AND step < O end > (NMAX step) Run tag ii runs in a negative 

direction

Limit values
Different limit values apply to the possible data types:

Data type PMAX NMAX
ii of type SINT 127 -128
ii of type INT 32767 -32768
ii of type DINT 2147483647 -2147483648
ii of type LINT 9223372036854775807 -9223372036854775808

Syntax
The following syntax is used for the "Run in counting loop" instruction:

SCL
FOR<Run_tag> := <Start_value> TO<End_value> BY<Increment> DO<Instructions>
END_FOR;

Parameter
The following table shows the parameters of the "Run in counting loop" instruction:

Parameter Data type Description
S7-1200 S7-1500

<Run tag> SINT, INT, DINT SINT, INT, DINT, 
LINT

Operand whose value is evaluated with the 
loop execution. The data type of the loop 
variable determines the data type of the other 
parameters.

<Start value> SINT, INT, DINT SINT, INT, DINT, 
LINT

Expression whose value is allocated at the 
start of the loop execution of the loop variables.

<End value> SINT, INT, DINT SINT, INT, DINT, 
LINT

Expression whose value defines the last run 
of the program loop. The value of the loop 
variable is checked before each loop:
● End value not reached:

The instructions according to DO are 
executed

● End value is reached:
The FOR loop is executed one last time

● End value exceeded:
The FOR loop is completed

An alteration to the end value is not permitted 
during execution of the instruction.
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Parameter Data type Description
S7-1200 S7-1500

<Increment> SINT, INT, DINT SINT, INT, DINT, 
LINT

Expression by whose value the loop variable 
is increased (positive increment) or decreased 
(negative increment) after each loop. 
Specification of the increment is optional. If no 
increment is given, the value of the loop 
variable is increased by 1 after each loop.
An alteration of the increment is not permitted 
during execution of the instruction.

<Instructions> - - Instructions which are carried out with each 
loop, as long as the value of the loop variable 
lies within the value range. The value range is 
defined by the start and end values.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
FOR i := 2 TO 8 BY 2
    DO "a_array[i] := "Tag_Value"*"b_array[i]";
END_FOR;

The operand "Tag_Value" is multiplied with the elements (2, 4, 6, 8) of the ARRAY tag 
"b_array". The result is read in to the elements (2, 4, 6, 8) of the ARRAY tag "a_array".

See also
CONTINUE: Recheck loop condition (Page 2223)

EXIT: Exit loop immediately (Page 2224)

Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

WHILE: Run if condition is met

Description     
The instruction "Run if condition is met" causes a program loop to be repeatedly executed until 
the implementation condition is satisfied. The condition is an expression with Boolean value 
((TRUE or FALSE). Logical expression or comparative expressions can be stated as 
conditions.
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When the instruction is executed, the stated expressions are evaluated. If the value of an 
expression is TRUE, the condition is fulfilled; if the value is FALSE, it is not fulfilled.

Program loops can also be nested. Within a program loop, you can program additional program 
loops with other run variables.

The current continuous run of a program loop can be ended by the instruction "Recheck loop 
condition" (CONTINUE). The instruction "Exit loop immediately" (EXIT) ends the entire loop 
execution. For additional information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Run if condition is met" instruction:

SCL
WHILE <Condition> DO <Instructions>
END_WHILE;

The syntax of the WHILE instruction consists of the following parts:

Parameter Data type Description
<Condition> BOOL Expression which is evaluated before each loop.
<Instructions> - Instructions to be executed with satisfied condition. If the 

condition has not been satisfied, program execution continues 
after END_WHILE.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
WHILE
      "Tag_Value1" <> "Tag_Value2"
      DO "Tag_Result"
      := "Tag_Input";
END_WHILE;

As long as the values of the operands "Tag_Value1" and "Tag_Value2" do not match, the value 
of the operand "Tag_Input" is allocated to the operand "Tag_Result".
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See also
EXIT: Exit loop immediately (Page 2224)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

CONTINUE: Recheck loop condition (Page 2223)

Overview of the valid data types (Page 1077)

REPEAT: Run if condition is not met

Description     
The instruction "Run if condition is not met" causes a program loop to be repeatedly executed 
until a termination condition is met. The condition is an expression with Boolean value (TRUE 
or FALSE). Logical expression or comparative expressions can be stated as conditions.

When the instruction is executed, the stated expressions are evaluated. If the value of an 
expression is TRUE, the condition is fulfilled; if the value is FALSE, it is not fulfilled.

The instructions are executed once, even if the termination condition is fulfilled.

Program loops can also be nested. Within a program loop, you can program additional program 
loops with other run variables.

The current continuous run of a program loop can be ended by the instruction "Recheck loop 
condition" (CONTINUE). The instruction "Exit loop immediately" (EXIT) ends the entire loop 
execution. For additional information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Run if condition is not met" instruction:

SCL
REPEAT <Instructions>
UNTIL <Condition> END_REPEAT;

The syntax of the REPEAT instruction consists of the following parts:

Parameter Data type Description
<Instructions> - Instructions that are executed as long as the programmed 

condition has the value FALSE. The instructions are executed 
once, even if the termination condition is fulfilled.

<Condition> BOOL Expression which is evaluated after each loop. If the expression 
has the value FALSE, the program loop is executed once again. 
If the expression has the value TRUE, the program loop 
continues after END_REPEAT.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
REPEAT "Tag_Result"
        := "Tag_Value";
UNTIL "Tag_Error"
END_REPEAT;

As long as the value of the operand "Tag_Error" has the signal state "0", the value of the 
operand "Tag_Value" is allocated to the operand "Tag_Result".

See also
CONTINUE: Recheck loop condition (Page 2223)

EXIT: Exit loop immediately (Page 2224)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

CONTINUE: Recheck loop condition

Description     
The "Recheck loop condition" instruction ends the current program run of a FOR, WHILE or 
REPEAT loop.

After execution of the instruction, the conditions for the continuation of the program loop are 
evaluated again. The instruction affects the program loop which directly contains the instruction.

Syntax
The following syntax is used for the "Recheck loop condition" instruction:

SCL
CONTINUE;

Example
The following example shows how the instruction works:

SCL
FOR i 
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SCL
     := 1 TO 15 BY 2 DO
     IF (i < 5) THEN
     CONTINUE;
END_IF;
      "DB10".Test[i] := 1;
END_FOR;

For additional information on valid data types, refer to "See also".

If the condition i < 5 is satisfied, then the subsequent value allocation ("DB10".Test[i] := 1) will 
not be executed. The run variable (i) is increased by the increment of "2" and checked to see 
whether its current value lies in the programmed value range. If the run variable lies in the 
value range, the IF condition is evaluated again.

If the condition i < 5 is not satisfied, then the subsequent value allocation ("DB10".Test[i] := 1) 
will be executed and a new loop started. In this case, the run variable is also increased by the 
increment "2" and checked.

See also
Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

EXIT: Exit loop immediately (Page 2224)

Overview of the valid data types (Page 1077)

EXIT: Exit loop immediately

Description     
The instruction "Exit loop immediately" cancels the execution of a FOR, WHILE or REPEAT 
loop at any point regardless of conditions. The execution of the program is continued after the 
end of the loop (END_FOR, END_WHILE, END_REPEAT).

The instruction affects the program loop which directly contains the instruction.

Syntax
The following syntax is used for the "Exit loop immediately" instruction:

SCL
EXIT;
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Example
The following example shows how the instruction works:

SCL
FOR i := 15 TO 1 BY -2 DO 
IF (i < 5)
THEN EXIT; 
END_IF;
"DB10".Test[i] := 1;
END_FOR;

For additional information on valid data types, refer to "See also".

If the condition i < 5 is satisfied, then the execution of the loop will be cancelled. Program 
execution resumes after the END_FOR.

If the condition i < 5 is not satisfied, then the subsequent value allocation ("DB10".Test[i] := 1) 
will be executed and a new loop started. The run tag (i) is decreased by the increment of "-2" 
and it is checked whether its current value lies in the programmed value range. If the (i) run 
variable lies within the value range, the IF condition is evaluated again.

See also
Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

CONTINUE: Recheck loop condition (Page 2223)

Overview of the valid data types (Page 1077)

GOTO: Jump

Description     
Use the instruction "Jump" to resume the execution of a program at a given point marked with 
a jump label.

The jump labels and the instruction "Jump" must be in the same block. The name of a jump 
label can only be assigned once within a block. Each jump label can be the target of several 
jump instructions.

A jump from the "outside" into a program loop is not permitted, but a jump from a loop to the 
"outside" is possible.
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Syntax
Use the following syntax for the "Jump" instruction:

SCL
GOTO <Jump label>
...
<Jump label>: <Instructions>

The syntax of the GOTO instruction consists of the following parts:

Parameter Data type Description
<jump label> - Jump label to be jumped to
<Instructions> - Instructions which are executed after the jump.

Example
The following example shows how the instruction works:

SCL
CASE "Tag_Value" OF
1 : GOTO MyLABEL1;
2 : GOTO MyLABEL2;
3 : GOTO MyLABEL3;
ELSE GOTO MyLABEL4;
END_CASE;
MyLABEL1: "Tag_1" := 1;
MyLABEL2: "Tag_2" := 1;
MyLABEL3: "Tag_3" := 1;
MyLABEL4: "Tag_4" := 1;

Depending on the value of the "Tag_Value" operand, the execution of the program will resume 
at the point identified by the corresponding jump label. If the operand "Tag_Value" has the 
value 2, for example, program execution will resume at the jump label "MyLABEL2". The 
program line identified by the jump label "MyLABEL1" will be skipped in this case. 

See also
Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)
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RETURN: Exit block

Description     
The instruction "Exit block" exits the program execution in the currently edited block and 
continues in the calling block.

The instruction can be omitted at the end of the block.

Syntax
The following syntax is used for the "Exit block" instruction:

SCL
RETURN;

Example
The following example shows how the instruction works:

SCL
IF "Tag_Error" <>0 THEN RETURN;
END_IF;

If the signal state of the "Tag_Error" operand is not zero, execution of the program ends in the 
block currently being processed.

See also
Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

(*...*): Inserting a comment section

Description   
You can use the "Insert comment section" instruction to add a comment section. The text within 
the parenthesis "(*...*)" is handled as a comment.
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Syntax
The following syntax is used for the "Insert comment section" instruction:

SCL
(*...*)

Example
The following example shows how the instruction works:

SCL
(*This is a comment section.*)

See also
Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

Runtime control

ENDIS_PW: Limit and enable password legitimation

Description
You can use the "Limit and enable password legitimation" instruction to specify whether or not 
legitimation is allowed for the CPU. You can prevent legitimated connections, even when the 
correct password is known. When you invoke the command and the REQ parameter has the 
signal state "0", only the currently set condition is displayed at the output parameters, but no 
setting is changed. If the REQ parameter has the signal state "1", the signal state is taken from 
the input parameters (F_PWD, FULL_PWD, R_PWD, HMI_PWD). FALSE means that 
legitimation per password is not allowed; TRUE means the password can be used. Disable or 
enabling of the passwords can be allowed or prohibited individually. For example, all 
passwords can be prohibited, except the fail-safe password. You can thus limit access options 
to a small user group. The output parameters (F_PWD_ON, FULL_PWD_ON, R_PWD_ON, 
HMI_PWD_ON) always show the current status of the password use, regardless of the REQ 
parameter.

The same setting can be made on the front panel of the CPU and the CPU saves the most 
recent setting.

To prevent accidental lockout, the protection can be disabled by setting the mode switch to 
STOP with an S7-1500 CPU. The protection is automatically enabled again by setting mode 
selector to RUN without having to call the "Limit and enable password legitimation" instruction 
again or taking additional actions on the front panel.
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The instruction must always be fully executed, in other words, the F_PWD parameter must 
always have the signal state "0", for example, so that the settings can be saved.

Disabled passwords can be enabled again under the following conditions:

● The CPU is reset to its factory settings.

● The front panel of the S7-1500 CPU supports a dialog that allows you to navigate to the 
appropriate menu in which the passwords can be enabled again.

● When you call the "Limit and enable password legitimation" instruction, the input parameter 
of the desired password has the signal state "1".

● Set the mode selector to STOP. The restriction to password legitimation is re-established 
as soon as the switch is set back to RUN.

● Plugging a transfer module into an S7-1200 CPU.
 

 Note

The "Limit and enable password legitimation" instruction blocks access to the HMI panel, if 
the HMI password has not been enabled.

 

 Note

Existing legitimized connections retain their access rights and you cannot use the "Limit and 
enable password legitimation" instruction to restrict them.

 

Procedure for lost passwords with an S7-1200 CPU
If you have lost the password for a password-protected CPU, delete the password-protected 
program with an empty transfer card. The empty transfer card deletes the internal load memory 
of the CPU. You can then load a new user program from STEP 7 Basic in the CPU.

 

 WARNING

Inserting transfer card

When you insert a transfer card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

 

You must remove the transfer card before you put the CPU into RUN mode.
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Effects of password use on the operating modes
The following table shows what effects the password use by means of the "Limit and enable 
password legitimation" instruction has on the operating modes and the corresponding user 
actions.

Action Password protection by means of the 
instruction

Basic state after
● Operating mode switch to STOP
● Reset memory manually (PG, switch, change of 

MC (Motion Control))
● Reset to factory setting

Not activated
(no restrictions)

Basic state after POWER ON Enabled (when a lock was activated before 
POWER OFF)
The option of not allowing passwords is 
retentive.

Operating mode transition RUN/STARTUP/HOLD -> 
STOP (by terminating the instruction, an error or 
communication) or STOP -> STARTUP/RUN/HOLD

Activated
Passwords still cannot be used.

Syntax
Use the following syntax for the "Limit and enable password legitimation" instruction:

SCL
ENDIS_PW(REQ := <Operand>,
         F_PWD := <Operand>,
         FULL_PWD := <Operand>,
         R_PWD := <Operand>,
         HMI_PWD := <Operand>,
         F_PWD_ON => <Operand>,
         FULL_PWD_ON => <Operand>,
         R_PWD_ON => <Operand>,
         HMI_PWD_ON => <Operand>,
         RET_VAL => <Operand>)
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Parameter
The following table shows the parameters of the "Limit and enable password legitimation" 
instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L When the REQ 

parameter has the 
signal state "0", the 
currently set signal 
state of the passwords 
is queried.

F_PWD Input BOOL I, Q, M, D, L Read/write access 
including fail-safe
● F_PWD = "0": Do 

not allow password
● F_PWD = "1": 

Allow password
FULL_PWD Input BOOL I, Q, M, D, L Read/write access

● FULL_PWD = "0": 
Do not allow 
password

● FULL_PWD = "1": 
Allow password

R_PWD Input BOOL I, Q, M, D, L Read access
● R_PWD = "0": Do 

not allow password
● R_PWD = "1": 

Allow password
HMI_PWD Input BOOL I, Q, M, D, L HMI access

● HMI_PWD = "0": 
Do not allow 
password

● HMI_PWD = "1": 
Allow password

F_PWD_ON Output BOOL I, Q, M, D, L Read/write access 
including fail-safe
● F_PWD_ON = "0": 

Password not 
allowed

● F_PWD_ON = "1": 
Password allowed

FULL_PWD_ON Output BOOL I, Q, M, D, L Read/write access 
status
● FULL_PWD_ON = 

"0": Password not 
allowed

● FULL_PWD_ON = 
"1": Password 
allowed
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Parameter Declaration Data type Memory area Description
R_PWD_ON Output BOOL I, Q, M, D, L Read-access status

● R_PWD_ON = "0": 
Password not 
allowed

● R_PWD_ON = "1": 
Password allowed

HMI_PWD_ON Output BOOL I, Q, M, D, L HMI-access status
● HMI_PWD_ON = 

"0": Password not 
allowed

● HMI_PWD_ON = 
"1": Password 
allowed

RET_VAL Output WORD I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8090 The "Limit and enable password legitimation" instruction is not supported
80D0 The password for fail-safe is not configured
80D1 The read/write access is not configured
80D2 The read access is not configured
80D3 The HMI access is not configured
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

RE_TRIGR: Restart cycle monitoring time

Description
The instruction "Restart cycle monitoring time" restarts the cycle monitoring of the CPU. The 
cycle time monitoring then restarts with the time you have set in the CPU configuration. 

The instruction "Restart cycle monitoring time" can be called, regardless of the priority, in all 
blocks.
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If the instruction is called in a block with a higher priority, such as a hardware interrupt, 
diagnostic interrupt, or cyclic interrupt, the instruction is not executed and the ENO enable 
output is set to signal state "0".

The instruction "Restart cycle monitoring time" can be called a maximum of 10 times in a 
program cycle.

 

 Note

If the instruction "Restart cycle monitoring time" is started more than 30 times within a LOOP 
instruction, the CPU switches to STOP because of a runtime error.

 

Syntax
The following syntax is used for the "Restart cycle monitoring time" instruction:

SCL
RE_TRIGR()

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

STP: Exit program

Description       
The "Exit program" instruction is used to set the CPU to STOP mode and therefore to terminate 
the execution of the program. The effects of changing from RUN to STOP depend on the CPU 
configuration.

Syntax
The following syntax is used for the instruction "Exit program":

SCL
STP()

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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GET_ERROR: Get error locally

Description
The instruction "Get error locally" queries the occurrence of errors within a block. If the system 
signals errors during block execution, the instruction gives detailed information about the first 
error that occurred.

The error information can only be saved in operands of the "ErrorStruct" system data type. 
The system data type "ErrorStruct" specifies the exact structure in which the information about 
the error is stored. Use additional instructions to evaluate this structure and program an 
appropriate response. When the first error has been eliminated, the instruction issues 
additional information about the next error that has occurred.

 

 Note

The "Get error locally" instruction enables local error handling within a block. If "Get error 
locally" is inserted into the program code of a block, any predefined system reactions are 
ignored if errors occur.

 

Syntax
The following syntax is used for the instruction "Get error locally":

SCL
<Error information> := GET_ERROR(<Operand>)

Parameter
The following table shows the parameters of the "Get error locally" instruction:

Parameter Data type Description
Function value ErrorStruct Information about errors that have occurred

Data type "ErrorStruct"
The following table shows the structure of the data type ErrorStruct:

Structure component Data type Description
ERROR_ID WORD Error ID
FLAGS BYTE Shows if an error occurred during a block call.

16#01: Error during a block call.
16#00: No error during a block call.
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Structure component Data type Description
REACTION BYTE Default reaction:

0: Ignore (write error),
1: Continue with substitute value "0" (read error),
2: Skip instruction (system error)

CODE_ADDRESS CREF Information on address and type of block
 BLOCK_TYPE BYTE Type of block where the error occurred:

1: OB
2: FC
3: FB

 CB_NUMBER UINT Number of the code block
 OFFSET UDINT Reference to the internal memory
MODE BYTE Access mode: Depending on the type of access, the 

following information can be output:
Mode (A) (B) (C) (D) (E)
0      
1     Offset
2   Area   
3 Location Scope  Numb

er
 

4   Area  Offset
5   Area DB no. Offset
6 PtrNo./

Acc
 Area DB no. Offset

7 PtrNo./
Acc

Slot 
No. / 
Scope

Area DB no. Offset

OPERAND_NUMBER UINT Operand number of the machine command
POINTER_NUMBER_LOCATION UINT (A) Internal pointer
SLOT_NUMBER_SCOPE UINT (B) Storage area in internal memory
DATA_ADDRESS NREF Information about the address of an operand
 AREA BYTE (C) Memory area:

L: 16#40 – 4E, 86, 87, 8E, 8F, C0 – CE
E: 16#81
A: 16#82
M: 16#83
DB: 16#84, 85, 8A, 8B
Range violations for a directly editable tag of data 
type DINT: 16#04

 DB_NUMBER UINT (D) Number of the data block
 OFFSET UDINT (E) Relative address of the operand
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Structure component "ERROR_ID"
The following table shows the values that can be output at the structure component 
"ERROR_ID":

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 Die block property "Parameter assignment via register" is not 

selected.
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

The "Get error locally" instruction can also be used to forward an alarm about the error status 
to the calling block. To do this, you have to program the instruction at the end of the called 
block.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2236 System Manual, 07/2013,  



See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

GET_ERR_ID: Get error ID locally

Description
The instruction "Get error ID locally" queries the occurrence of errors within a block. If the 
system signals errors during block execution, the error ID of the first error that has occurred 
is given. The error ID can only be saved in operands of the WORD data type. When the first 
error has been eliminated, the instruction outputs the error ID of the next error that occurred.

The "Get error ID locally" instruction can also be used to forward an alarm about the error 
status to the calling block. To do this, you have to program the instruction at the end of the 
called block.

 

 Note

The "Get error ID locally" instruction enables local error handling within a block. If the 
instruction "Get error ID locally" is inserted in the program code of a block, any predefined 
system reactions are ignored if errors occur.

 

Syntax
The following syntax is used for the instruction "Get error ID locally":

SCL
<Error_ID> := GET_ERR_ID(<Operand>)

Parameter
The following table shows the parameters of the "Get error ID locally" instruction:

Parameter Data type Description
Function value WORD Error ID

Error ID
The following table shows the values that can be output:

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
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ID*
(hexadecimal)

ID*
(decimal)

Description

2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 Die block property "Parameter assignment via register" is not 

selected.
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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INIT_RD: Initialize all retain data

Description
The "Initialize all retain data" instruction is used to reset the retentive data of all data blocks, 
bit memories and SIMATIC timers and counters at the same time. The instruction can only be 
executed within a startup OB because the execution exceeds the program cycle duration.

Syntax
Use the following syntax for the "Initialize all retain data" instruction:

SCL
INIT_RD(REQ := <Operand>
        RET_VAL := <Operand>)

Parameter
The following table shows the parameters of the "Initialize all retain data" instruction:

Parameter Declaration Data type Description
REQ Input BOOL If the input "REQ" has 

the signal state "1", all 
retentive data are reset.

RET_VAL Output INT Error information:
If an error occurs during 
the execution of the 
instruction, an error 
code is output at the 
RET_VAL parameter.

For additional information on valid data types, refer to "See also".

RET_VAL Parameter
The following table shows the meaning of the values of the parameter RET_VAL:

Error code*
(W#16#...)

Explanation

0000 No error
80B5 The instruction cannot be executed because it was not programmed within a startup OB.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
INIT_RD(REQ := "Tag_REQ",
        RET_VAL := "Tag_Result");

If the operand "Tag_REQ" has the signal state "1", the instruction is executed. All retentive 
data of all data blocks, bit memories and SIMATIC timers and counters are reset.

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

GET_ERR_ID: Get error ID locally (Page 2237)

WAIT: Configure time delay

Description     
The instruction "Configure time delay" pauses the program execution for a specific period of 
time. You indicate the period of time in microseconds on the WT parameter of the instruction.

You can configure time delays of up to 32 767 microseconds (μs). The shortest possible time 
delay depends on the respective CPU and corresponds to the execution time of the instruction 
"Configure time delay".

The execution of the instruction can be interrupted by higher priority events.

The instruction "Configure time delay" supplies no error information.

Syntax
The following syntax is used for the instruction "Configure time delay":

SCL
WAIT(WT:= <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
WT Input INT Time delay in microseconds (μs)
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See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

RUNTIME: Measure program runtime

Description
The "Measure program runtime" instruction is used to measure the runtime of the entire 
program, individual blocks or command sequences.

If you want to measure the runtime of your entire program, call the instruction "Measure 
program runtime" in OB1. Measurement of the runtime is started with the first call and the 
output RET_VAL returns the runtime of the program after the second call. The measured 
runtime includes all CPU processes that can occur during the program execution, for example, 
interruptions caused by higher-level events or communication. The instruction "Measure 
program runtime" reads an internal counter of the CPU and writes the value to the in/out 
parameter. The instruction calculates the current program runtime according to the internal 
counter frequency and writes it to output RET_VAL.

If you want to measure the runtime of individual blocks or individual command sequences, you 
need three separate networks. Call the instruction "Measure program runtime" in an individual 
network within your program. You set the starting point of the runtime measurement with this 
first call of the instruction. Then you call the required program block or the command sequence 
in the next network. In another network, call the "Measure program runtime" instruction a 
second time and assign the same memory to the in/out parameter as you did during the first 
call of the instruction. The "Measure program runtime" instruction in the third network reads 
an internal CPU counter and calculates the current runtime of the program block or the 
command sequence according to the internal counter frequency and writes it to the output 
RET_VAL.

The Measure program runtime" instruction uses an internal high-frequency counter to calculate 
the time. If the counter overruns, the instruction returns values <= 0.0. Ignore these runtime 
values.

 

 Note

The runtime of a command sequence cannot be determined exactly, because the sequence 
of instructions within a command sequence is changed during optimized compilation of the 
program.

 

The "Measure program runtime" instruction has no error information.
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Syntax
The following syntax is used for the "Measure program runtime" instruction:

SCL
RUNTIME(<Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Operand> InOut LREAL Saves the starting point 

of the runtime 
measurement.

Function value
 

LREAL Returns the measured 
runtime in seconds

For additional information on valid data types, refer to "See also".

Example
The following example shows the how the instruction works based on the runtime calculation 
of a program block:

SCL
"Tag_Result" := RUNTIME("Tag_Memory");
 
"Best_before_date_DB" ();
 
"Tag_Result" := RUNTIME("Tag_Memory");

The starting point for the runtime measurement is set with the first call of the instruction and 
buffered as reference for the second call of the instruction in the "TagMemory" operand.

The "Best_before_date" program block FB1 is called.

When the program block FB1 has been processed, the instruction is executed a second time. 
The second call of the instruction calculates the runtime of the program block and writes the 
result to the output "Tag_Result".

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)
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Word logic operations

DECO: Decode

Description
The instruction "Decode" sets a bit specified by the input value in the output value.

The instruction "Decode" reads the value of the parameter IN and sets the bit in the output 
value, whose bit position corresponds to the read value. The other bits in the output value are 
filled with zeroes. If the value of the IN parameter is greater than 31, a modulo 32 instruction 
is executed.

Syntax
The following syntax is used for the instruction "Decode":

SCL
DECO(IN := <Expression>)
DECO_WORD(IN := <Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
IN Input UINT Position of the bit in the 

output value which is 
set.

_<Data type> Bit strings
default: DWORD

Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Bit strings Current output value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := DECO(IN := "Tag_Value");
"Tag_Result2" := DECO_BYTE(IN := "Tag_Value2");
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The following figure shows how the instruction works using specific operand values:

The instruction reads the number "3" from the value of the operand "Tag_Value" and sets the 
third bit to the value of the operand "Tag_Result".

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

ENCO: Encode

Description
The instruction "Encode" reads the bit number of the lowest-value bit set in the input value and 
issues this as a result.

Syntax
The following syntax is used for the instruction "Encode":

SCL
ENCO(IN := <Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
IN Input Bit strings Input value
Function value INT Bit number of the bit in 

the input value that is 
read out.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ENCO(IN := "Tag_Value");

The following figure shows how the instruction works using specific operand values:

The instruction reads the lowest-value set bit of the operand "Tag_Value" and writes the bit 
position "3" in the operand "Tag_Result".

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SEL: Select

Description
The instruction "Select" selects one of the parameters IN0 or IN1 depending on a switch (G 
parameter) and issues its content as a result. When the parameter G has the signal status "0", 
the value at parameter IN0 is moved. When the parameter G has the signal status "1", the 
value at parameter IN1 is moved and returned as a function value.

The instruction is only executed if the tags of all parameters have the same data type class.

Syntax
The following syntax is used for the instruction "Select":

SCL
SEL(G:= <Expression>,
    IN0 := <Expression>,
    IN1 := <Expression>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type  
S7-1200 S7-1500 Description

G Input BOOL BOOL Switch
IN0 Input Bit strings, integers, 

floating-point 
numbers, TIME, 
TOD, DATE, CHAR, 
DT

Bit strings, integers, 
floating-point 
numbers, CHAR, 
timers, DATE, 
TOD, LTOD, DT, 
LDT

First input value

IN1 Input Bit strings, integers, 
floating-point 
numbers, TIME, 
TOD, DATE, CHAR, 
DT

Bit strings, integers, 
floating-point 
numbers, CHAR, 
timers, DATE, 
TOD, LTOD, DT, 
LDT

Second input value

Function value Bit strings, integers, 
floating-point 
numbers, TIME, 
TOD, DATE, CHAR, 
DT

Bit strings, integers, 
floating-point 
numbers, CHAR, 
timers, DATE, 
TOD, LTOD, DT, 
LDT

Result of the 
instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := SEL(G := "Tag_Value",
                    IN0 := "Tag_0",
                    IN1 := "Tag_1");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 0 1
Tag_0 W#16#0000 W#16#4C
Tag_1 W#16#FFFF D#16#5E
Tag_Result W#16#0000 D#16#5E

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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MUX: Multiplex

Description
The "Multiplex" instruction copies the value of a selected input parameter and issues it. Use 
the parameter K to determine the number of the input parameter whose value will be moved. 
Numbering starts at IN0 and is incremented continuously with each new input. You can declare 
a maximum of 32 inputs.

If the value of the K parameter is greater than the number of inputs and the INELSE parameter 
is not set, the instruction function value is invalid and the ENO enable output is set to 0.

Numerical data types and time data types are permitted at the inputs. All tags with assigned 
parameters must be of the same data type.

The function value is invalid if any of the following conditions are met:

● The value of the parameter K is greater than the number of available inputs.

● Errors occurred during the execution of the instruction.

Syntax
The following syntax is used for the instruction "Multiplex":

 SCL
MUX(K := <Expression>,
    IN0 := <Expression>,
    IN1 := <Expression>,
    INELSE := <Expression>)

Parameter
The following table shows the parameters of the "Multiplex" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

K Input Integers Integers Specifies the 
parameter whose 
content is to be 
transferred.
● If K = 0 => 

Parameter IN0
● If K = 1 => 

Parameter 
IN1, etc.

IN0 Input Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

First input value
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Parameter Declaration Data type Description
S7-1200 S7-1500

IN1 Input Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

Second input value

INn Input Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

Optional input 
values

INELSE Input Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

Specifies the 
value to be copied 
when K <> n.

Function value
 

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

Result of the 
instruction

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := MUX(K := "Tag_Number",
                    IN0 := "Tag_1",
                    IN1 := "Tag_2",
                    INELSE := "Tag_3");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Number 2 4
Tag_1 DW#16#00000000 DW#16#00000000
Tag_2 DW#16#003E4A7D DW#16#003E4A7D
Tag_3 DW#16#FFFF0000 DW#16#FFFF0000
Tag_Result DW#16#003E4A7D DW#16#FFFF0000
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See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

DEMUX: Demultiplex

Description
The "Demultiplex" instruction transfers the value of the input parameter IN to a selected output 
parameter. The selection of the input parameter takes place independently of the parameter 
value K. The K parameter specifies the output parameter number to which the value of the 
input parameter IN is transferred. The other output parameters are not changed. Numbering 
starts at OUT0 and continues consecutively with each new output. You can declare a maximum 
of 32 output parameters.

If the value of the K parameter is greater than the number of output parameters, the value of 
the input parameter IN is transferred to the output parameter OUTELSE.

Syntax
The following syntax is used for the instruction "Demultiplex":

SCL
DEMUX(K := <Expression>,
      IN := <Expression>,
      OUT0 := <Operand>,
      OUT1 := <Operand>,
      OUTELSE := <Operand>)
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Parameter
The following table shows the parameters of the instruction "Demultiplex":

Parameter Declaration Data type Description
S7-1200 S7-1500

K Input Integers Integers Specifies the 
output to which the 
input value (IN) 
will be copied.
● If K = 0 => 

Parameter 
OUT0

● If K = 1 => 
Parameter 
OUT1, etc.

IN Input Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

Input value

OUT0 Output Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

First output

OUT1 Output Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

Second output

OUTn Output Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

Optional outputs

OUTELSE Output Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

Output to which 
the value at input 
IN is copied if K > 
n.

For more information on available data types, refer to "See also".
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Example
The following example shows how the instruction works:

 SCL
DEMUX(K := "Tag_Number",
      IN := "Tag_Value",
      OUT0 := "Tag_1",
      OUT1 := "Tag_2",
      OUTELSE := "Tag_3");

The following tables show how the instruction works using specific operand values:

Input values of the "Demultiplex" instruction before the network execution

Parameter Operand Values
K Tag_Number 2 4
IN Tag_Value DW#16#FFFFFFFF DW#16#003E4A7D

Output values of the "Demultiplex" instruction after the network execution

Parameter Operand Values
OUT0 Tag_1 Unchanged Unchanged
OUT1 Tag_2 DW#16#FFFFFFFF Unchanged
OUTELSE Tag_3 Unchanged DW#16#003E4A7D

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Shift and rotate

SHR: Shift right

Description
The "Shift right" instruction shifts the contents of the IN  parameter bit-by-bit to the right and 
returns it as a function value. The parameter N is used to specify the number of bit positions 
by which the specified value should be shifted.

If the value of the N parameter is "0", the value of the IN parameter is given as a result.

If the value of the N parameter is greater than the number of available bit positions, then the 
value of the IN parameter is shifted to the right by the available number of bit positions.
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The bit positions that are freed by shifting in the left operand area are filled with zeros.

The following figure shows how the content of an integer data type operand is shifted by four 
bit positions to the right:

Syntax
The following syntax is used for the instruction "Shift right":

SCL
SHR(IN := <Operand>,
    N := <Operand>)

Parameter
The following table shows the parameters of the "Shift right" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input Bit strings, 
integers

Bit strings, integers Value to be shifted

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of bits by 
which the value 
(IN) is shifted

Function value Bit strings, 
integers

Bit strings, integers Result of the 
instruction

For more information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2252 System Manual, 07/2013,  



Example
The following example shows how the instruction works:

SCL
"Tag_Result" := SHR(IN := "Tag_Value",
                    N := "Tag_Number");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 0011 1111 1010 1111
N Tag_Number 3
Function value Tag_Result 0000 0111 1111 010 1

The content of the "Tag_Value" operand is shifted by three bit positions to the right. The result 
of the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SHL: Shift left

Description
The "Shift left" instruction shifts the contents of the IN parameter bit-by-bit to the left and returns 
it as a function value. The parameter N is used to specify the number of bit positions by which 
the specified value should be shifted.

If the value of the N parameter is "0", the value of the IN parameter is given as a result.

If the value of the N parameter is greater than the number of bit positions, the value of the IN 
parameter is shifted to the left by the available number of bit positions.

The bit positions freed by the shift are filled with zeros in the result value. 

The following figure shows how the content of an operand of the WORD data type is shifted 
six bit positions to the left:
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Syntax
The following syntax is used for the instruction "Shift left":

SCL
SHL(IN := <Operand>,
    N := <Operand>)

Parameter
The following table shows the parameters of the "Shift left" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input Bit strings, 
integers

Bit strings, integers Value to be shifted

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of bits by 
which the value 
(IN) is shifted

Function value Bit strings, 
integers

Bit strings, integers Result of the 
instruction

For more information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := SHL(IN := "Tag_Value",
                    N := "Tag_Number");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 0011 1111 1010 1111
N Tag_Number 4
Function value Tag_Result 1111 1010 1111 0000

The value of the "Tag_Value" operand is shifted by four bit positions to the left. The result of 
the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

ROR: Rotate right

Description
The "Rotate right" instruction rotates the content of the IN parameter bit-by-bit to the right and 
assigns the result to the specified operand. The parameter N is used to specify the number of 
bit positions by which the specified value should be rotated. The bit positions freed by rotating 
are filled with the bit positions that are pushed out.

If the value of the N parameter is "0", the value at input IN is given as a result.

If the value at the N parameter is greater than the number of available bit positions, the operand 
value at the IN input is still rotated by the specified number of bit positions.

The following figure shows how the content of an operand of the DWORD data type is rotated 
three bit positions to the right:
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Syntax
The following syntax is used for the instruction "Rotate right":

SCL
ROR(IN := <Operand>,
    N := <Operand>)

Parameter
The following table shows the parameters of the "Rotate right" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input Bit strings, 
integers

Bit strings, integers Value to be rotated

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of bit 
positions by which 
the value (IN) is 
rotated

Function value Bit strings, 
integers

Bit strings, integers Result of the 
instruction

For more information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ROR(IN := "Tag_Value",
                    N := "Tag_Number");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 0000 1111 1001 0101
N Tag_Number 5
Function value Tag_Result 1010 1000 0111 1100

The content of the "Tag_Value" operand is rotated by five bit positions to the right. The result 
of the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

ROL: Rotate left

Description
The "Rotate left" instruction rotates the contents of the IN parameter bit-by-bit to the left and 
returns it as a function value. The parameter N is used to specify the number of bit positions 
by which the specified value should be rotated. The bit positions freed by rotating are filled 
with the bit positions that are pushed out.

If the value of the N parameter is "0", the value at input IN is given as a result.

If the value at the N parameter is greater than the number of available bit positions, the operand 
value at the IN input is still rotated by the specified number of bit positions.

The following figure shows how the content of an operand of the DWORD data type is rotated 
three bit positions to the left:
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Syntax
The following syntax is used for the "Rotate left" instruction:

SCL
ROL(IN := <Operand>,
    N := <Operand>)

Parameter
The following table shows the parameters of the "Rotate left" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input Bit strings, 
integers

Bit strings, integers Value to be rotated

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of bit 
positions by which 
the value (IN) is 
rotated

Function value Bit strings, 
integers

Bit strings, integers Result of the 
instruction

For more information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

 SCL
"Tag_Result" := ROL(IN := "Tag_Value",
                    N := "Tag_Number");

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 1010 1000 1111 0110
N Tag_Number 5
Function value Tag_Result 0001 1110 1101 0101

The content of the operand "Tag_Value" is rotated five bit positions to the left. The result of 
the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1077)

Operators and operator precedence (Page 1347)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Additional instructions

DRUM: Implement sequencer

Description
The "Implement sequencer" instruction is used to assign the programmed values of the 
OUT_VAL parameter of the corresponding step to the programmed output bits (OUT1 to 
OUT16) and the output word (OUT_WORD). The specific step must thereby satisfy the 
conditions of the programmed enable mask on the S_MASK parameter while the instruction 
remains at this step. The instruction advances to the next step if the event for the step is true 
and the programmed time for the current step elapses, or if the value at the JOG parameter 
changes from "0" to "1". The instruction is reset if the signal state on the RESET parameter 
changes to "1". The current step is hereby equated to the preset step (DSP).

The amount of time spent on a step is determined by the product of the preset timebase (DTBP) 
and the preset counter value (S_PRESET) for each step. At the start of a new step, this 
calculated value is loaded into the DCC parameter, which contains the time remaining for the 
current step. If, for example the value at the DTBP parameter is "2" and the preset value for 
the first step is "100" (100 ms), the DCC parameter has the value "200" (200 ms).

A step can be programmed with a time value, an event, or both. Steps that have an event bit 
and the time value "0" advance to the next step as soon as the signal state of the event bit is 
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"1". Steps that are programmed only with a time value start the time immediately. Steps that 
are programmed with an event bit and a time value greater than "0" start the time when the 
signal state of the event bit is "1". The event bits are initialized with a signal state of "1".

When the sequencer is on the last programmed step (LST_STEP) and the time for this step 
has expired, the signal state on the Q parameter is set to "1"; otherwise it is set to "0". When 
the parameter Q is set, the instruction remains on the step until it is reset.

In the configurable mask (S_MASK) you can selected the separate bits in the output word 
(OUT_WORD) and set or reset the output bits (OUT1 to OUT16) by means of the output values 
(OUT_VAL). If a bit of the configurable mask is in the signal state "1", the value OUT_VAL sets 
or resets the corresponding bit. If the signal state of a bit of the configurable mask is "0", the 
corresponding bit is left unchanged. All the bits of the configurable mask for all 16 steps are 
initialized with a signal state of "1".

The output bit on the OUT1 parameter corresponds to the least significant bit of the output 
word (OUT_WORD). The output bit on the OUT16 parameter corresponds to the most 
significant bit of the output word (OUT_WORD).

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Implement sequencer" instruction:

SCL
<Instance>RESET:= <Operand>,
          JOG := <Operand>,
          DRUM_EN := <Operand>,
          LST_STEP := <Operand>,
          EVENT1 - 16 := <Operand>,
          OUT1 - 16 => <Operand>,
          Q => <Operand>,
          OUT_WORD => <Operand>,
          ERR_CODE => <Operand>)
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Parameter
The following table shows the parameters of the "Implement sequencer" instruction:

Parameter Declaration Data type Description
RESET Input BOOL A signal state of "1" 

indicates a reset 
condition.

JOG Input BOOL When the signal state 
changes from "0" to "1", 
the instruction 
advances to the next 
step.

DRUM_EN Input BOOL A signal state of "1" 
allows the sequencer to 
advance based on the 
event and time criteria.

LST_STEP Input BYTE Step number of the last 
step programmed.

EVENT(i),
1 ≤ i ≤ 16

Input BOOL Event bit (i);
Initial signal state is "1".

OUT(j),
1 ≤ j ≤ 16

Output BOOL Output bit (j)

Q Output BOOL A signal state of "1" 
indicates that the time 
for the last step has 
elapsed.

OUT_WORD Output WORD Word address to which 
the sequencer writes 
the output values.

ERR_CODE Output WORD Error information
JOG_HIS Static BOOL JOG parameter history 

bit
EOD Static BOOL A signal state of "1" 

indicates that the time 
for the last step has 
elapsed.

DSP Static BYTE Preset step of the 
sequencer

DSC Static BYTE Current step of the 
sequencer

DCC Static DWORD Current numerical 
value of the sequencer

DTBP Static WORD Preset timebase of the 
sequencer

PREV_TIME Static DWORD Previous system time
S_PRESET Static ARRAY of WORD Count preset for each 

step [1 to 16] where 1 
count = 1 ms.
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Parameter Declaration Data type Description
OUT_VAL Static ARRAY of BOOL Output values for each 

step [1 to 16, 0 to 15].
S_MASK Static ARRAY of BOOL Configurable mask for 

each step [1 to 16, 
0 to 15]. Initial signal 
states are "1".

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.

ERR_CODE Parameter
The following table shows the meaning of the values of the parameter ERR_CODE:

ERR_CODE* Explanation
W#16#0000 No error
W#16#000B The value at the LST_STEP parameter is less than 1 or greater than 16.
W#16#000C The value at the DSC parameter is less than 1 or greater than the value at 

the LST_STEP parameter.
W#16#000D The value at the DSP parameter is less than 1 or greater than the value at 

the LST_STEP parameter.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more information on toggling 
display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

DCAT: Discrete control-timer alarm

Description
The "Discrete control-timer alarm" instruction is used to accumulate the time from the point at 
which the CMD parameter issues the command to open or close. The time is accumulated 
until the preset time (PT) is exceeded or the information is received that the device was opened 
or closed (O_FB or C_FB) within the specified time. If the preset time is exceeded before the 
information on the opening or closing of the device is received, the corresponding alarm is 
activated. If the signal state on the command input changes state before the preset time, the 
time is restarted.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
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data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

The "Discrete control-timer alarm" instruction has the following reactions to the input conditions:

● When the signal state of the CMD parameter changes from "0" to "1", the signal states of 
the parameters Q, CMD_HIS, ET (only if ET < PT), OA and CA are influenced as follows:

– The parameters Q and CMD_HIS are set to "1".

– The parameters ET, OA and CA are reset to "0".

● When the signal state on the parameter CMD changes from "1" to "0", the parameters Q, 
ET (only if ET < PT),  OA, CA and CMD_HIS are reset to "0".

● When the signal state of the parameters CMD and CMD_HIS is "1" and the parameter O_FB 
is set to "0", the time difference (ms) since the last execution of the instruction is added to 
the value at the parameter ET. If the value of the parameter ET exceeds the value of the 
parameter PT, the signal state on the parameter OA is set to "1". If the value of the 
parameter ET does not exceed the value of the parameter PT, the signal state on the 
parameter OA is reset to "0". The value at the parameter CMD_HIS is set to the value of 
the parameter CMD.

● If the signal state of the parameters CMD, CMD_HIS and O_FB are set to "1" and the 
parameter C_FB has the value "0", the signal state of the parameter OA is set to "0". The 
value of parameter ET is set to the value of parameter PT. If the signal state of the parameter 
O_FB changes to "0", the alarm is set the next time the instruction is executed. The value 
of parameter CMD_HIS is set to the value of parameter CMD.

● If the parameters CMD, CMD_HIS and C_FB have the value "0", the time difference (ms) 
since the last execution of the instruction is added to the value of the parameter ET. If the 
value of the parameter ET exceeds the value of the parameter PT, the signal state of the 
parameter CA is set to "1". If the value at the parameter PT is not exceeded, the parameter 
CA has the signal state "0". The value of parameter CMD_HIS is set to the value of 
parameter CMD.

● If the parameters CMD, CMD_HIS and O_FB have the signal state "0" and the parameter 
C_FB is set to "1", the parameter CA is set to "0". The value of parameter ET is set to the 
value of parameter PT. If the signal state of the parameter C_FB changes to "0", the alarm 
is set the next time the instruction is executed. The value of parameter CMD_HIS is set to 
the value of parameter CMD.

● If the parameters O_FB and C_FB simultaneously have the signal state "1", the signal states 
of both alarm outputs are set to "1".

The "Discrete control-timer alarm" instruction has no error information.

Syntax
The following syntax is used for the "Discrete control-timer alarm" instruction:

SCL
<Instance>CMD:= <Operand>,
          O_FB := <Operand>,
          C_FB := <Operand>,
          Q => <Operand>,
          OA => <Operand>,
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SCL
          CA => <Operand>)

Parameter
The following table shows the parameters of the instruction:

Parameter Declaration Data type Description
CMD Input BOOL A signal state of "0" indicates a "close" 

command.
A signal state of "1" indicates an "open" 
command.

O_FB Input BOOL Feedback input when opening
C_FB Input BOOL Feedback input when closing
Q Output BOOL Shows the status of the parameter CMD
OA Output BOOL Alarm output when opening
CA Output BOOL Alarm output when closing
ET Static DINT Currently elapsed time, where one count 

= 1 ms.
PT Static DINT Preset time value, where one count = 1 

ms.
PREV_TIME Static DWORD Previous system time
CMD_HIS Static BOOL CMD history bit

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.

Example
In the following example the parameter CMD changes from "0" to "1". After the execution of 
the instruction the parameter Q is set to "1" and the two alarm outputs OA and CA have the 
signal state "0". The parameter CMD_HIS of the instance data block is set to the signal state 
"1" and the parameter ET is reset to "0".

 

 Note

You can initialize static parameters in the data block.
 

SCL
"DCAT_DB"(CMD := "Tag_Input_CMD",
          O_FB := "Tag_Input_O_FB",
          C_FB := "Tag_Input_C_FB",
          Q => "Tag_Output_Q",
          OA => "Tag_Output_OA",
          CA => "Tag_Output_CA");

The following tables show how the instruction works using specific values:
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Before processing

In this example the following values are used for the input and output parameters:

Parameter Operand Value
CMD Tag_Input_CMD TRUE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
Q Tag_Output_Q FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#12
PT DBD8 L#222
CMD_HIS DBX16.0 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
Q Tag_Output_Q TRUE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
CMD_HIS DBX16.0 TRUE

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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MCAT: Motor control-timer alarm

Description
The "Motor control-timer alarm" instruction is used to accumulate the time from the point at 
which one of the command inputs (opening or closing) is switched on. The time is accumulated 
until the preset time is exceeded or the relevant feedback input indicates that the device has 
executed the requested operation within the specified time. If the preset time is exceeded 
before the feedback is received, the corresponding alarm is triggered.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Execution of the "Motor control-timer alarm" instruction
The following table shows the reactions of the "Motor control-timer alarm" instruction to the 
various input conditions:

Input parameters Output parameters
ET O_H

IS
C_H
IS

O_C
MD

C_C
MD

S_C
MD

O_F
B

C_F
B

OO CO OA CA ET O_H
IS

C_H
IS

Q State

X 1 1 X X X X X 0 0 1 1 PT 0 0 0 Alarm
X X X X X X 1 1 0 0 1 1 PT 0 0 0 Alarm
X X X X X 1 X X 0 0 0 0 X 0 0 1 Stop
X X X 1 1 X X X 0 0 0 0 X 0 0 1 Stop
X 0 X 1 0 0 X X 1 0 0 0 0 1 0 1 Start 

opening
<PT 1 0 X 0 0 0 X 1 0 0 0 INC 1 0 1 Open
X 1 0 X 0 0 1 0 0 0 0 0 PT 1 0 1 Opened
>=P
T

1 0 X 0 0 0 X 0 0 1 0 PT 1 0 0 Opening 
alarm

X X 0 0 1 0 X X 0 1 0 0 0 0 1 1 Start closing
<PT 0 1 0 X 0 X 0 0 1 0 0 INC 0 1 1 Close
X 0 1 0 X 0 0 1 0 0 0 0 PT 0 1 1 Closed
>=P
T

0 1 0 X 0 X 0 0 0 0 1 PT 0 1 0 Closing 
alarm

X 0 0 0 0 0 X X 0 0 0 0 X 0 0 1 Stopped
Legend:
INC Add the time difference (ms) since the last processing of the FB to ET
PT PT is set to the same value as ET
X Cannot be used
<PT ET < PT
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Input parameters Output parameters
>=PT ET >= PT
If the input parameters O_HIS and C_HIS both have the signal state "1", they are immediately set to the signal state "0". In 
this case, the last row in the table (X) mentioned above is valid. Because it is therefore not possible to check whether the 
input parameters O_HIS and C_HIS have the signal state "1", the output parameters are set as follows in this case: 
OO = FALSE
CO = FALSE
OA = FALSE
CA = FALSE
ET = PT
Q = TRUE

Syntax
The following syntax is used for the "Motor control-timer alarm" instruction:

SCL
<Instance>O_CMD:= <Operand>,
          C_CMD := <Operand>,
          S_CMD := <Operand>,
          O_FB := <Operand>,
          C_FB := <Operand>,
          00 => <Operand>,
          C0 => <Operand>,
          OA => <Operand>,
          CA => <Operand>,
          Q => <Operand>)

Parameter
The following table shows the parameters of the "Motor control-timer alarm" instruction:

Parameter Declaration Data type Description
O_CMD Input BOOL "Open" command input
C_CMD Input BOOL "Close" command input
S_CMD Input BOOL "Stop" command input
O_FB Input BOOL Feedback input when 

opening
C_FB Input BOOL Feedback input when 

closing
OO Output BOOL "Open" output
CO Output BOOL "Close" output
OA Output BOOL Alarm output when 

opening
CA Output BOOL Alarm output when 

closing
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Parameter Declaration Data type Description
Q Output BOOL A signal state of "0" 

indicates an error 
condition.

ET Static DINT Currently elapsed time, 
where one count = 1 ms

PT Static DINT Preset time value, 
where one count = 1 ms

PREV_TIME Static DWORD Previous system time
O_HIS Static BOOL "Open" history bit
C_HIS Static BOOL "Close" history bit

For additional information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
 

SCL
"MCAT_DB"(O_CMD := "Tag_Iput_O_CMD",
          C_CMD := "Tag_Input_C_CMD",
          S_CMD := "Tag_Input_S_CMD",
          O_FB := "Tag_Input_O_FB",
          C_FB := "Tag_Input_C_FB",
          OO => "Tag_OutputOpen",
          CO => "Tag_OutputClosed",
          OA => "Tag_Output_OA",
          CA => "Tag_Output_CA",
          Q => "Tag_Output_Q");

The following tables show how the instruction works using specific values:

Before processing

In this example the following values are used for the input and output parameters:

Parameter Operand Value
O_CMD Tag_Input_O_CMD TRUE
C_CMD Tag_Input_C_CMD FALSE
S_CMD Tag_Input_S_CMD FALSE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
OO Tag_OutputOpen FALSE
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Parameter Operand Value
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q FALSE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#2
PT DBD8 L#22
O_HIS DBX16.0 TRUE
C_HIS DBX16.1 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
OO Tag_OutputOpen TRUE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q TRUE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
O_HIS DBX16.0 TRUE
CMD_HIS DBX16.1 FALSE

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

IMC: Compare input bits with the bits of a mask

Description
The "Compare input bits with the bits of a mask" instruction is used to compare the signal state 
of up to 16 programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bit of a mask. 
Up to 16 steps with masks can be programmed. The value of the IN_BIT0 parameter  is 
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compared with the value of the mask CMP_VAL[x,0], with "x" indicating the step number. On 
the CMP_STEP parameter, you specify the step number of the mask that is used for the 
comparison.  All programmed values are compared in the same manner. Unprogrammed input 
bits or unprogrammed bits of the mask have a default signal state FALSE.

If a match is found in the comparison, the signal state of the OUT parameter is set to "1". 
Otherwise the OUT parameter is set to "0".

If the value of CMP_STEP parameter is greater than 15, the instruction is not executed. An 
error message is output at the ERR_CODE parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Compare input bits with the bits of a mask" instruction:

SCL
<Instance>(IN_BIT0 - 15 := <Operand>,
          CMP_STEP := <Operand>,
          OUT => <Operand>,
          ERR_CODE => <Operand>)

Parameters
The following table shows the parameters of the "Compare input bits with the bits of a mask" 
instruction:

Parameter Declaration Data type Description
IN_BIT0 Input BOOL Input bit 0 is compared with bit 0 of the mask.
IN_BIT1 Input BOOL Input bit 1 is compared with bit 1 of the mask.
IN_BIT2 Input BOOL Input bit 2 is compared with bit 2 of the mask.
IN_BIT3 Input BOOL Input bit 3 is compared with bit 3 of the mask.
IN_BIT4 Input BOOL Input bit 4 is compared with bit 4 of the mask.
IN_BIT5 Input BOOL Input bit 5 is compared with bit 5 of the mask.
IN_BIT6 Input BOOL Input bit 6 is compared with bit 6 of the mask.
IN_BIT7 Input BOOL Input bit 7 is compared with bit 7 of the mask.
IN_BIT8 Input BOOL Input bit 8 is compared with bit 8 of the mask.
IN_BIT9 Input BOOL Input bit 9 is compared with bit 9 of the mask.
IN_BIT10 Input BOOL Input bit 10 is compared with bit 10 of the 

mask.
IN_BIT11 Input BOOL Input bit 11 is compared with bit 11 of the 

mask.
IN_BIT12 Input BOOL Input bit 12 is compared with bit 12 of the 

mask.
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Parameter Declaration Data type Description
IN_BIT13 Input BOOL Input bit 13 is compared with bit 13 of the 

mask.
IN_BIT14 Input BOOL Input bit 14 is compared with bit 14 of the 

mask.
IN_BIT15 Input BOOL Input bit 15 is compared with bit 15 of the 

mask.
CMP_STEP Input BYTE The step number of the mask used for the 

comparison.
OUT Output BOOL A signal state of "1" indicates that a match 

was found.
A signal state of "0" indicates that no match 
was found.

ERR_CODE Output WORD Error information 
CMP_VAL Static ARRAY OF WORD Comparison masks [0 to 15, 0 to 15]: The first 

number of the index is the step number and 
the second number is the bit number of the 
mask.

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.

ERR_CODE Parameter
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000A The value at the CMP_STEP parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more information on toggling 
display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

SMC: Compare scan matrix

Description
You can use the "Compare scan matrix" instruction to compare the signal state of up to 16 
programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bit of the comparison 
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masks for each step. Processing starts at step 1 and is continued until the last programmed 
step (LAST) or until a match is found. The input bit of the IN_BIT0 parameter is compared with 
the value of the mask CMP_VAL[x,0], with "x" indicating the step number. All programmed 
values are compared in the same manner. If a match is found the signal state of the OUT 
parameter is set to "1" and the step number with the matching mask is written in the OUT_STEP 
parameter. Unprogrammed input bits or unprogrammed bits of the mask have a default signal 
state FALSE. If more than one step has a matching mask, only the first one found is indicated 
in the OUT_STEP parameter. If no match is found, the signal state of the OUT parameter is 
set to "0". In this case the value at the OUT_STEP parameter is greater by "1" than the value 
at the LAST parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Compare scan matrix" instruction:

SCL
<Instance>(IN_BIT0 - 15 := <Operand>,
          OUT => <Operand>,
          OUT_STEP => <Operand>,
          ERR_CODE => <Operand>)

Syntax
The following table shows the parameters of the "Compare scan matrix" instruction:

Parameter Declaration Data type Description
IN_BIT0 Input BOOL Input bit 0 is compared with bit 0 of the mask.
IN_BIT1 Input BOOL Input bit 1 is compared with bit 1 of the mask.
IN_BIT2 Input BOOL Input bit 2 is compared with bit 2 of the mask.
IN_BIT3 Input BOOL Input bit 3 is compared with bit 3 of the mask.
IN_BIT4 Input BOOL Input bit 4 is compared with bit 4 of the mask.
IN_BIT5 Input BOOL Input bit 5 is compared with bit 5 of the mask.
IN_BIT6 Input BOOL Input bit 6 is compared with bit 6 of the mask.
IN_BIT7 Input BOOL Input bit 7 is compared with bit 7 of the mask.
IN_BIT8 Input BOOL Input bit 8 is compared with bit 8 of the mask.
IN_BIT9 Input BOOL Input bit 9 is compared with bit 9 of the mask.
IN_BIT10 Input BOOL Input bit 10 is compared with bit 10 of the 

mask.
IN_BIT11 Input BOOL Input bit 11 is compared with bit 11 of the 

mask.
IN_BIT12 Input BOOL Input bit 12 is compared with bit 12 of the 

mask.
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Parameter Declaration Data type Description
IN_BIT13 Input BOOL Input bit 13 is compared with bit 13 of the 

mask.
IN_BIT14 Input BOOL Input bit 14 is compared with bit 14 of the 

mask.
IN_BIT15 Input BOOL Input bit 15 is compared with bit 15 of the 

mask.
OUT Output BOOL A signal state of "1" indicates that a match 

was found.
A signal state of "0" indicates that no match 
was found. 

OUT_STEP Output BYTE Contains the step number with the matching 
mask, or the step number which is greater by 
"1" than the value at the LAST parameter, 
provided no match is found.

ERR_CODE Output WORD Error information 
LAST Static BYTE Specifies the step number of the last step to 

be scanned for a matching mask.
CMP_VAL Static ARRAY OF WORD Comparison masks [0 to 15, 0 to 15]: The first 

number of the index is the step number and 
the second number is the bit number of the 
mask.

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.

ERR_CODE Parameter
The following table shows the meaning of the values of the parameter ERR_CODE:

Error code*
(W#16#...)

Explanation

0000 No error
000E The value at the LAST parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more information on toggling 
display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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LEAD_LAG: Lead and lag algorithm 

Description
Use the "Lead and lag algorithm" instruction to process signals with an analog tag. The gain 
value at the GAIN parameter must be greater than zero. The result of the "Lead and lag 
algorithm" instruction is calculated using the following equation:

The instruction "Lead and lag algorithm" supplies plausible results only when processing is in 
fixed program cycles. The same units must be specified at the parameters LD_TIME, LG_TIME 
and SAMPLE_T. At LG_TIME > 4 + SAMPLE_T, the instruction approaches the following 
function:

OUT = GAIN * ((1 + LD_TIME * s) / (1 + LG_TIME * s)) * IN

When the value of the GAIN parameter is less than or equal to zero, the calculation is not 
performed and an error information is output on the ERR_CODE parameter.

You can use the "Lead and lag algorithm" instruction in conjunction with loops as a 
compensator in dynamic feed-forward control. The instruction consists of two operations. The 
"Lead" operation shifts the phase of output OUT so that the output leads the input. The "Lag" 
operation, on the other hand, shifts the output so that the output lags behind the input. Because 
the "Lag" operation is equivalent to an integration, it can be used as a noise suppressor or as 
a low-pass filter. The "Lead" operation is equivalent to a differentiation and can therefore be 
used as a high-pass filter. The two instructions together (Lead and Lag) result in the output 
phase lagging behind the the input at lower frequencies and leading it at higher frequencies. 
This means that the "Lead and lag algorithm" instruction can be used as a band pass filter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Lead and lag algorithm" instruction:

SCL
<Instance>(IN:= <Operand>,
          SAMPLE_T := <Operand>,
          OUT => <Operand>,
          ERR_CODE => <Operand>)

The following table shows the parameters of the instruction:
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Parameter Declaration Data type Description
IN Input REAL The input value of the 

current sample time 
(cycle time) to be 
processed.
Constants can also be 
specified on the IN 
parameter.

SAMPLE_T Input INT Sample time
Constants can also be 
specified on the 
SAMPLE_T parameter.

OUT Output REAL Result of the instruction
ERR_CODE Output WORD Error information 
LD_TIME Static REAL Lead time in the same 

unit as sample time.
LG_TIME Static REAL Lag time in the same 

unit as sample time
GAIN Static REAL Gain as % / % (the ratio 

of the change in output 
to a change in input as 
a steady state).

PREV_IN Static REAL Previous input
PREV_OUT Static REAL Previous output

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.

ERR_CODE Parameter
The following table shows the meaning of the values of the parameter ERR_CODE:

Error code*
(W#16#...)

Explanation

0000 No error
0009 The value at the GAIN parameter is less than or equal to zero.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more information on toggling 
display formats, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
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SCL
"LEAD_LAG_DB"(IN := "Tag_Input",
              SAMPLE_T := "Tag_Input_SAMPLE_T",
              OUT => "Tag_Output_Result",
              ERR_CODE => "Tag_ErrorCode");

The following tables show how the instruction works using specific values:

Before processing

In this example the following values are used for the input parameters:

Parameter Operand Value
IN Tag_Input 2.0
SAMPLE_T Tag_Input_SAMPLE_T 10

The following values are saved in the instance data block "LEAD_LAG_DB" of the instruction:

Parameter Address Value
LD_TIME DBD12 2.0
LG_TIME DBD16 2.0
GAIN DBD20 1.0
PREV_IN DBD24 6.0
PREV_OUT DBD28 6.0

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
OUT Tag_Output_Result 2.0

The following values are saved in the instance data block "LEAD_LAD_DB" of the instruction:

Parameter Operand Value
PREV_IN DBD24 2.0
PREV_OUT DBD28 2.0

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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SEG: Create bit pattern for seven-segment display

Description
The "Create bit pattern for seven-segment display" instruction is used to convert each of the 
four hexadecimal digits of the specified source word (IN) into an equivalent bit pattern for a 7-
segment display.  The result of the instruction is output in the double word on the OUT 
parameter.

The following relation exists between the hexadecimal digits and the assignment of the 7 
segments (a, b, c, d, e, f, g):

Input digit 
(Binary)

Assignment of the 
segments
‑ g f e d c b a

Display
(Hexadecimal)

Seven-segment display

0000 00111111 0
0001 00000110 1
0010 01011011 2
0011 01001111 3
0100 01100110 4
0101 01101101 5
0110 01111101 6
0111 00000111 7
1000 01111111 8
1001 01100111 9
1010 01110111 A
1011 01111100 B
1100 00111001 C
1101 01011110 D
1110 01111001 E
1111 01110001 F

Syntax
Use the following syntax for the "Create bit pattern for seven-segment display" instruction:

SCL
SEG(IN := <Operand>,
    OUT => <Operand>)
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Parameter
The following table shows the parameters of the "Create bit pattern for seven-segment display" 
instruction:

Parameter Declaration Data type Description
IN Input WORD Source word with four 

hexadecimal digits
OUT Output DWORD Bit pattern for the seven-

segment display
Function value VOID Empty function value

Example
The following example shows how the instruction works:

SCL
SEG(IN := "Tag_Input",
    OUT => "Tag_Output");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
 Hexadecimal Binary
IN Tag_Input W#16#1234 0001 0010 0011 0100
OUT Tag_Output DW16#065B4F66 00000110 01011011 01001111 

01100110
Display: 1234

See also
Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)

Overview of the valid data types (Page 1077)

BCDCPL: Create tens complement

Description
The "Create tens complement" instruction is used to create the tens complement of a seven-
digit BCD number specified by the operand. This instruction uses the following mathematical 
formula to calculate:

10000000 (as BCD)

– 7-digit BCD value

----------------------------------------
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Tens complement (as BCD)

Syntax
The following syntax is used for the "Create tens complement" instruction:

SCL
BCDCPL(<Operand>)

Parameter
The following table shows the parameters of the "Create tens complement" instruction:

Parameter Declaration Data type Description
<Operand> Input DWORD 7-digit BCD number
Function value DWORD Result of the instruction

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := BCDCPL("Tag_Input");

The following table shows how the instruction functions using specific values:

Operand Value*
Tag_Input DW#16#01234567
Tag_Result DW#16#08765433
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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BITSUM: Count number of set bits

Description
The "Count number of set bits" instruction is used to count the number of bits of an operand 
that are set to the signal state "1".

Syntax
The following syntax is used for the "Count number of set bits" instruction:

SCL
BITSUM(<Operand>)

Parameter
The following table shows the parameters of the "Count number of set bits" instruction:

Parameter Declaration Data type Description
<Operand> Input DWORD Operand whose set bits 

are counted
Function value INT Result of the instruction

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := BITSUM("Tag_Input");

The following table shows how the instruction functions using specific values:

Operand Value*
Tag_Input DW#16#12345678
Tag_Result W#16#000D (13 bits)
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1077)

Entering SCL instructions (Page 1357)

Editing SCL instructions (Page 1374)
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9.7.3 Extended instructions

9.7.3.1 Date and time-of-day

T_COMP: Compare time tags

Description       
This instruction is used to compare the contents of two tags of the data types "Timers" or "Date 
and time". 

The instruction supports comparisons of the following data types: DATE, TIME, LTIME, TOD 
(TIME_OF_DAY), LTOD (LTIME_OF_DAY), DT (DATE_AND_TIME), LDT 
(DATE_AND_LTIME), DTL. Before you can execute a comparison, the data types must have 
the same length and format.

The comparison result is output at the OUT parameter as a return value. The parameter OUT 
is set to "1" if the comparison condition applied has been satisfied.

The following comparison options can be used:

Symbol Description
EQ The return value has the signal state “1" if the time is the same at the parameter IN1 and IN2.
NE The return value has the signal state “1" if the time at parameters IN1 and IN2 is not identical.
GE The return value has the signal state "1" if the time at parameter IN1 is greater (more recent) than or equal 

to the time at parameter IN2 .
LE The return value has the signal state "1" if the time at parameter IN1 is less (less recent) than or equal to 

the time at parameter IN2.
GT The return value has the signal state “1" if the time at parameter IN1  is greater (more recent) than the time 

at parameter IN2.
LT The return value has the signal state "1" if the time at parameter IN1  is less (less recent) than the time at 

parameter IN2 .

Parameter
The following table shows the parameters of the instruction "T_COMP":

Parameter Declaration Data type Memory area Description
IN1 Input DATE, TIME, LTIME, 

TOD, LTOD, DT, 
LDT, DTL

I, Q, M, D, L or constant First value to be compared.

IN2 Input DATE, TIME, LTIME, 
TOD, LTOD, DT, 
LDT, DTL

I, Q, M, D, L or constant Second value to be compared.

OUT Output BOOL I, Q, M, D, L Return value
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For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

T_CONV: Convert times and extract

Description
You use the instruction "T_CONV" to convert the data type of the IN input parameter to the 
data type that is output at the OUT output. You select the data formats for the conversion from 
the instruction boxes of the input and output.

Parameters
The following table shows the parameters of the instruction "T_CONV". If an input and output 
parameter of the same data type is used, the instruction copies the corresponding value.

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input Integers, TIME, 
date and time*

WORD, 
integers, 
timers, date 
and time*

I, Q, M, D, L or 
constant

Value to be converted

OUT Return Integers, TIME, 
date and time*

WORD, 
integers, 
timers, date 
and time*

I, Q, M, D, L Result of the conversion

* The range of supported data types depends on the CPU. Please refer to the overviews of valid data types for information 
on the data types supported by the S7-1200 and S7-1500 modules.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

T_ADD: Add times

Description       
You use this instruction to add the time information in the IN1 input to the time information in 
the IN2 input. You can query the result in the OUToutput parameter. You can add the following 
formats:

● Addition of a time period to another time period.
Example: Addition of a TIME data type to another TIME data type.

● Addition of a time period to a time.
Example: Addition of a TIME data type to the DTL data type.

The data type for the value at input parameter IN1 and output parameter OUT is defined by 
the selection in the instruction boxes of the input and output. You can only specify time 
information in TIME format in the IN2 input parameter (for S7-1500 modules also LTIME). 
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Parameters
The following tables show the parameters of the "T_ADD" instruction, according to the possible 
conversions:

Table 9-34 Addition of a time period to another time period

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input
 

TIME TIME, LTIME I, Q, M, D, L or 
constant

First number to be added

IN2 Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Second number to be added

OUT Return DINT, 
DWORD, 
TIME, TOD

TIME, LTIME, I, Q, M, D, L Result of addition
The data type selection depends on 
the data types selected for the IN1 
and IN2 input parameters.

 

Table 9-35 Addition of a time period to a time

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input DTL, TOD DT, TOD, 
LTOD, LDT, 
DTL

I, Q, M, D, L or 
constant

First number to be added

IN2 Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Second number to be added

OUT Return DINT, 
DWORD, 
TIME, TOD, 
UDINT, DTL

DT, DTL, 
LDT, TOD,  
LTOD

I, Q, M, D, L Result of addition
The data type selection depends on 
the data types selected for the IN1 
and IN2 input parameters.

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".
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T_SUB: Subtract times

Description       
You use this instruction to subtract the time information in the IN2 input parameter from the 
time information in the IN1 input parameter. You can query the difference in the OUT output 
parameter. You can subtract the following formats:

● Subtraction of a time period from another time period
Example: Subtraction of a time period of the data type TIME from another time period of 
the data type TIME. The result can be output to a tag with the TIME format.

● Subtraction of a time period from a time
Example: Subtraction of a time period of the data type TIME from a time of the data type 
DTL. The result can be output to a tag with the DTL format.

You decide the formats of the values in the IN1 input parameter and the OUT output parameter 
by selecting the data types for the input and output parameters of the instruction.

Parameters
The following tables show the parameters of the "T_SUB" instruction, according to the possible 
conversions:

Table 9-36 Subtraction of a time period from another time period

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Minuend

IN2 Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Subtrahend

OUT Return DINT, DWORD, 
TIME, TOD, 
UDINT

TIME, LTIME I, Q, M, D, L Result of subtraction

 

Table 9-37 Subtraction of a time period from a time

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input DTL, TOD TOD, LTOD, DTL, 
DT, LDT

I, Q, M, D, L or 
constant

Minuend

IN2 Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Subtrahend

OUT Return DTL, DINT, 
DWORD, TIME, 
TOD, UDINT

TOD, LTOD, DTL, 
DT, LDT

I, Q, M, D, L Result of subtraction
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You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

T_DIFF: Time difference

Description
You use this instruction to subtract the time information in the IN2 input parameter from the 
time information in the IN1 input parameter. The result is stored in the OUT output parameter 
in TIME format.

● If the time information at the IN2 input parameter is greater than the time information at the 
IN1 input parameter, the result is output as a negative value at the OUT output parameter.

● If the result of the subtraction is outside the TIME range, the result is set to "0" (0:00) and 
the enable output ENO = "0".

 

Parameters
The following table shows the parameters of the "T_DIFF" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input DTL DTL, DATE, DT, 
TOD, LTOD, 
LDT

I, Q, M, D, L or 
constant

Minuend

IN2 Input DTL DTL, DATE, DT, 
TOD, LTOD, 
LDT

I, Q, M, D, L or 
constant

Subtrahend

OUT Return TIME TIME, LTIME, 
INT

I, Q, M, D, L Difference in TIME format

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

T_COMBINE: Combine times

Description     
The instruction combines the value of a date with the value of a time and converts this into a 
combined date and time value.

● The date is output at the input parameter IN1. A value of between 1990-01-01 and 
2089-12-31 must be used for the data type DATE (this is not checked).

● The time is input at the IN2 input value (TOD/LTOD data type).

● The combined data type for the date and time value is output at the OUT output value.
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Parameter
The following table shows the parameters of the instruction "T_COMBINE":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input DATE DATE, 
WORD, 
UINT, INT

I, Q, M, D, L or 
constant

Input tag of the date

IN2 Input TOD TOD, LTOD I, Q, M, D, L or 
constant

Input tag of the time

OUT Return DTL DT, DTL, LDT I, Q, M, D, L Return value of the date and time

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Time-of-day functions

WR_SYS_T: Set time-of-day

Description       
You use this instruction to set the date and time-of-day of the CPU clock. You specify the date 
and time information at the IN input parameter of the instruction. You can query whether errors 
have occurred during execution of the instruction in the RET_VAL output parameter.

The "WR_SYS_T" instruction cannot be used to pass information about the local time zone or 
daylight saving time.

Parameters
The following table shows the parameters of the "WR_SYS_T" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input DTL DT, DTL, LDT I, Q, M, D, L or 
constant

Date and time

RET_VAL Return INT, REAL, 
DINT

INT I, Q, M, D, L Status of the instruction

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".
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RET_VAL parameter

Error code*
(W#16#....) 

Description

0000 No error
8080 Error in date
8081 Error in time
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

RD_SYS_T: Read time-of-day

Description     
You use this instruction to read out the current date and current time-of-day of the CPU clock.

The read out dates are output at the OUT output parameter of the instruction. The provided 
value does not include information about the local time zone or daylight saving time.

You can query whether errors have occurred during execution of the instruction in the 
RET_VALoutput.

Parameters
The following table shows the parameters of the "RD_SYS_T" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

RET_VAL Return INT INT I, Q, M, D, L Status of the instruction
OUT Output DTL DT, DTL, LDT I, Q, M, D, L Date and time of CPU

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#....) 

Description

0000 No error
8081 Time value specified at the LOCTIME parameter is outside the valid value range:

With DTL: min. DTL#1970-01-01-00:00:00.0, max. DTL#2200-12-31-23:59:59.999999999
With LDT: min.  LDT#1970-1-1-0:0:0.000000000, max. LDT#2200-12-31-23:59:59.999999999

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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RD_LOC_T: Read local time

Description       
You use this instruction to read out the current local time from the CPU clock and output this 
at the OUT output. Information on the time zone and the start of daylight saving time and 
standard time, which you have set in the configuration of the CPU clock, is used to output the 
local time.

Parameter
The following table shows the parameters of the "RD_LOC_T" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

RET_VAL Return INT INT M, D, L Status of the instruction
OUT Output DTL DT, LDT, DTL D Local time

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

RET_VAL parameter

Error code*
(W#16#....) 

Description

0000 No error
0001 No error. Local time is output as daylight saving time.
8080 Local time cannot be read out.
8081 Time value specified at the LOCTIME parameter is outside the valid value range:

With DTL: min. DTL#1970-01-01-00:00:00.0, max. DTL#2554-12-31-23:59:59.999999999

With LDT: min. LDT#1970-1-1-0:0:0.000000000, max. LDT#2262-04-11-23:47:16.854775807
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

WR_LOC_T: Write local time

Description     
The instruction "WR_LOC_T" is used to set the date and time of the CPU clock. You specify 
the date and time information as local time at the LOCTIME input parameter of the instruction.

The instruction uses the "TimeTransformationRule" structure to calculate the system time. The 
granularity of the time information for local time and system time is product-specific and is at 
least one millisecond. Input values at the LOCTIME parameter which are less than those 
supported by the CPU are rounded up during system time calculation.
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You can query whether errors have occurred during execution of the instruction in the 
RET_VAL output parameter.

Parameter
The following table shows the parameters of the "WR_LOC_T" instruction:

Parameter Declaration Data type Memory area Description
LOCTIME Input DTL, LDT I, Q, M, D, L or 

constant
Local time

DST Input BOOL I, Q, M, D, L or 
constant

Daylight Saving Time
Only evaluated during the "double hour" 
when the clocks change to daylight saving 
time.
● TRUE = daylight saving time (first hour)
● FALSE = standard time (second hour)

RET_VAL Return INT I, Q, M, D, L Error message (see "RET_VAL parameter")

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

RET_VAL parameter

Error code*
(W#16#....) 

Description

0000 No error.
8080 The LOCTIME parameter has an invalid value.
8081 Time value specified at the LOCTIME parameter is outside the valid value range:

● With DTL: min. DTL#1970-01-01-00:00:00.0, max. DTL#2554-12-31-23:59:59.999999999
● With LDT: min. LDT#1970-1-1-0:0:0.000000000, max. LDT#2262-04-11-23:47:16.854775807

8082** Invalid value specified for the month (byte 2 in DTL format).
8083** Invalid value specified for the day (byte 3 in DTL format).
8084** Invalid value specified for the hour (byte 5 in DTL format).
8085** Invalid value specified for the minute (byte 5 in DTL format).
8086** Invalid value specified for the second (byte 7 in DTL format).
8087** Invalid value specified for the nanosecond (byte 8 to 11 in DTL format).
8089 Time value does not exist (hour already passed upon changeover to daylight saving time).
80B0 The real-time clock has failed.
80B1 The "TimeTransformationRule" structure has not been defined.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
** Only for local time information at the LOCTIME parameter in DTL format.
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SET_TIMEZONE: Set time zone

Description        
You use this instruction to calculate the local time based on the module time. The module time 
of the CPU is the UTC time. The module time is used exclusively for communication within the 
system. The rule for conversion to local time is defined in the "TimeTransformationRule" 
attribute that you specify in the TimeZone parameter. The rule defines the time zone calculation 
as well as the automatic changeover between daylight saving time and standard time. 

Parameters
The following table shows the parameters of the "SET_TIMEZONE" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ=1: Conversion of module time to local 
time

TimeZone Input Time Transformation 
Rule (Page 2291) 

D Rule for conversion of module time to local 
time. 

DONE Output BOOL I, Q, M, D, L ● 0: Job not yet started or is still executing
● 1: Job completed error-free

BUSY Output BOOL I, Q, M, D, L ● 0: Job not yet started or already 
completed

● 1: Job not yet completed. A new job 
cannot be started.

ERROR Output BOOL I, Q, M, D, L ● 0: No error
● 1: Error occurred

STATUS Output DINT, DWORD, 
UDINT, WORD

I, Q, M, D, L Error message

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

STATUS parameter

Error code*
(W#16#....) 

Description

7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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TimeTransformationRule

Description
The times for changeover to daylight saving time and standard time are defined in the 
TimeTransformationRule structure. The structure is as follows:

Name Data type Description
TimeTransformationRule STRUCT  
 Bias INT // Time difference between local time and UTC [min]
 DaylightBias INT // Time difference between daylight saving and standard time [min]
 DaylightStartMonth USINT // Month of conversion to daylight saving time
 DaylightStartWeek USINT // Week of conversion to daylight saving time 

// 1 = First occurrence of the weekday in the month, ..., 
// 5 = Last occurrence of the weekday in the month

 DaylightStartWeekday USINT // Weekday of daylight saving time changeover: 
// 1 = Sunday

 DaylightStartHour USINT // Hour of daylight saving time changeover
 DaylightStartMinute USINT // Minute of daylight saving time changeover
 StandardStartMonth USINT // Month of conversion to standard time
 StandardStartWeek USINT // Week of conversion to standard time 

// 1 = First occurrence of the weekday in the month, ..., 
// 5 = Last occurrence of the weekday in the month

 StandardStartWeekday USINT // Weekday of standard time changeover: 
// 1 = Sunday

 StandardStartHour USINT // Hour of standard time changeover
 StandardStartMinute USINT // Minute of standard time changeover
 TimeZoneName STRING[80] // Name of time zone: "(GMT+01:00) Amsterdam, Berlin, Bern, Rome, 

Stockholm, Vienna"

SNC_RTCB: Synchronize slave clocks

Definition: Synchronization of slave clocks     
The synchronization of clock slaves refers to the transfer of the date and time-of-day from the 
clock master of a bus segment to all clock slaves of this bus segment.

Description
You use this instruction to synchronize all slave clocks present on a bus segment independent 
of the assigned synchronization interval. Successful synchronization is only possible if 
"SNC_RTCB" is called on a CPU whose real-time clock was assigned as the master clock for 
at least one bus segment.
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Parameters
The following table shows the parameters of the "SNC_RTCB" instruction:

Parameter Declaration Data type Memory area Description
RET_VAL Output INT I, Q, M, D, L If an error occurs while the instruction is 

being executed, the return value contains 
an error code.

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred during synchronization.
0001 The existing clock was not assigned the master clock function for 

any of the bus segments.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TIME_TCK: Read system time

Description      
With the "TIME_TCK" instruction, you read the system time of the CPU. The system time is a 
time counter that counts from 0 to a maximum of 2147483647 ms. In case of an overflow, the 
system time is counted again starting with "0". The time scale and the accuracy of the system 
time is 1 ms. The system time is only influenced by the operating modes of the CPU. You can 
use the system time, for example, to measure the duration of processes by comparing the 
results of two "TIME_TCK" calls. The instruction does not provide any error information.

The following table provides an overview of how the system time changes depending on the 
operating modes of the CPU.

Mode System time ...
Startup ... is constantly updated
RUN  
STOP ... is stopped and retains the current value
Warm restart ... is deleted and restarts with "0"
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Parameter
The following table shows the parameters of the instruction "TIME_TCK":

Parameters Declaration Data type Memory area Description
RET_VAL Return TIME I, Q, M, D, L The RET_VAL  parameter contains 

the read system time in the range 
from 0 to 231 -1 ms.

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

RTM: Runtime meters

Description   
You can use this instruction to set, start, stop, and read out a 32-bit runtime meter of your CPU.

Ensure that the runtime meter can also be stopped or restarted during execution of the user 
program, which may render the saved values incorrect.

Parameters
The following table shows the parameters of the instruction "RTM":

Parameter Declaration Data type Memory area Description
NR Input RTM (UINT) I, Q, M, D, L or 

constant
Number of the runtime meter
Numbering starts with 0.
For information on the number of runtime meters 
of your CPU, refer to the technical data.

MODE Input BYTE I, Q, M, D, L or 
constant

Job ID:
● 0: Read out (the status is then written to CQ 

and the current value to CV). After the 
runtime meter has reached (2E31) -1 hours, 
it stops at the highest value that can be 
displayed and outputs an "Overflow" error 
message.

● 1: start (at the last counter value)
● 2: stop
● 4: set (to the value specified in PV)
● 5: set (to the value specified in PV) and then 

start
● 6: set (to the value specified in PV) and then 

stop
PV Input DINT I, Q, M, D, L or 

constant
New value for the runtime meter
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Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 

executed, the return value contains an error 
code.

CQ Output BOOL I, Q, M, D, L Status of the runtime meter (1: running)
CV Output DINT I, Q, M, D, L Current value of the runtime meter

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code
(W#16#...)

Explanation

0000 No error
8080 Wrong number for the runtime meter
8081 A negative value was passed to the PV parameter.
8082 Overflow of the runtime meter
8091 The MODE  input parameter contains an invalid value.
General error 
information

See also: Evaluating errors with GET_ERR_ID (Page 2237) 

9.7.3.2 String + Char

S_MOVE: Move character string

Description     
You can use this instruction to move the content of a character string (STRING). The character 
string in the IN input parameter is copied to the OUT output parameter.

You can insert additional outputs for the S_MOVE instruction. In this case, the content of the 
operand in the IN input parameter is transferred to all available outputs.

You can use the "MOVE_BLK" and "UMOVE_BLK" instructions to copy tags of data type 
ARRAY.

Parameters
The following table shows the parameters of the "S_MOVE" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L Source value
OUT Output STRING D, L Destination address
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For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

S_COMP: Compare character strings

Description         
The instruction compares the contents of two tags in the STRING  format and outputs the result 
of the comparison as a return value. The tags that are to be compared will be interconnected 
at the IN1 and IN2  inputs. You can only assign a symbolically defined tag for the input 
parameters.

Use the instruction box to select the comparison condition. If the comparison condition (for 
example, greater than or equal to) is satisfied, the signal state is set to "1" at the output 
parameter OUT .

The following comparison options can be used:

Symbol Description
EQ The return value has the signal state "1" if the string at the IN1 parameter is the same as 

the string at the IN2  parameter.
NE The return value has the signal state "1" if the string at the IN1  parameter is not equal to 

the string at the IN2  parameter.
GT (1) The return value has the signal state “1" if the string at the IN1  parameter is greater than 

the string at the IN2  parameter.
LT (1) The return value has the signal state "1" if the string at the IN1  parameter is less than the 

string at the IN2  parameter.
GE (1) The return value has the signal state "1" if the string at the IN1  parameter is greater than 

or equal to the string at the IN2  parameter. 
LE (1) The return value has the signal state "1" if the string at the IN1  parameter is less than or 

equal to the string at the IN2  parameter.
(1) The characters are compared by their ASCII code (for example, 'a' is greater than 'A'), starting from 
the left. The first character to be different decides the result of the comparison. If the first characters 
are the same, the longer string is greater.

Parameters
The following table shows the parameters of the instruction "S_COMP":

Parameters Declaration Data type Memory area Description
IN1 Input STRING* D, L Input tag in the STRING 

format.
IN2 Input STRING* D, L Input tag in the STRING 

format.
OUT Output BOOL I, Q, M, D, L Result of comparison
* Define the maximum length of the character string if you use the data type STRING in the interface 
declaration for a temporary variable (you will find further information in the description of the data type).

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2295



For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

S_CONV: Convert character string

Description       
You use this instruction to convert the value at the IN input to the data format you have specified 
in the OUT output. The following conversions are possible:

● Conversion of a character string (STRING) to a numerical value:
The conversion is performed for all characters of the character string specified in the IN 
input parameter. Permitted characters are the digits "0" to "9", the decimal point, and the 
plus and minus signs. The first character of the string may be a valid number or a sign. 
Leading spaces and exponential notations are ignored. 
Character conversion can be interrupted by invalid characters. You decide the output format 
of the conversion by selecting a data type for the OUT output parameter.

● Conversion of a numerical value to a character string (STRING):
You decide the format of the numeric value to be converted by selecting a data type for the 
IN input. A valid tag of the STRING data type must be specified in the OUT output. The 
length of the character string after conversion depends on the value at the IN input. The 
conversion result is saved as a string starting at the third byte. The first byte of the string 
records the maximum length and the second byte the actual length of the character string. 
Positive numeric value are output without a sign.

 

  Note

When you convert zero (e.g. INT_TO_STRING(0)), the string will be 6 characters long.
 

● Copying a character string:
If you enter the STRING data type in the input and output parameters of the instruction, the 
character string in the IN input will be copied to the OUT output. If the actual length of the 
character string in the IN input exceeds the maximum character string length in the OUT 
output; only the part of the character string that exactly fits into the character string of OUT 
will be copied to IN.

 

  Note
Exponential notation during conversion from floating-point numbers

Do not use exponential notation ("e" or "E") for the conversion from floating-point numbers 
with the instruction "S_CONV". Instead, use the instruction "STRG_VAL (Page 2297)" for 
the conversion of floating-point numbers with exponential notation. You can use the 
FORMAT parameter of the instruction to select exponential notation as input format.
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Parameters
The following tables show the parameters of the "S_CONV" instruction, according to the 
possible conversions:

Table 9-38 Parameters for converting a character string to a numeric value:

Parameters Declaration Data type Memory area Description
IN Input STRING D, L Value to be converted
OUT Output CHAR, USINT, 

UINT, UDINT, 
ULINT, SINT, INT, 
DINT, LINT, 
REAL, LREAL

I, Q, M, D, L Result of the conversion

Table 9-39 Parameters for converting a numeric value to a character string:

Parameter Declaration Data type Memory area Description
IN Input CHAR, USINT, 

UINT, UDINT, 
ULINT, SINT, INT, 
DINT, LINT, 
REAL, LREAL

I, Q, M, D, L or constant Value to be converted

OUT Output STRING D, L Result of the conversion

Table 9-40 Parameters for copying a character string:

Parameters Declaration Data type Memory area Description
IN Input STRING D, L Value to be copied
OUT Output STRING D, L Result of the copy operation

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

STRG_VAL: Convert character string to numerical value

Description       
The "STRG_VAL" instruction converts a numeric character string to the corresponding integer 
or floating-point notation:

● You specify the character string to be converted in the IN input parameter.

● You define the format of the output value by selecting a data type for the OUT output 
parameter. You can query the result in the OUToutput parameter.

Permitted characters for the conversion are the digits "0" to "9", the decimal point, the decimal 
comma, notations "E" and "e" and the plus and minus characters. The conversion can be 
interrupted by invalid characters.
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Parameters
The following table shows the parameters of the "STRG_VAL" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input STRING STRING D, L or constant Numeric character string to 
be converted

FORMAT Input WORD WORD I, Q, M, D, L or 
constant

Output format of the 
characters

P Input UINT UINT I, Q, M, D, L or 
constant

Reference to the first 
character to be converted 
(first character = 1, the value 
"0" or a value > length of the 
string is invalid)

OUT Output USINT, SINT, 
UINT, INT, 
UDINT, DINT, 
REAL, LREAL

USINT, SINT, 
UINT, INT, 
UDINT, DINT, 
ULINT, LINT, 
REAL, LREAL

I, Q, M, D, L Result of the conversion

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter FORMAT
You use the FORMAT parameter to specify how the characters of a character string are to be 
interpreted. Exponential values can also be converted and represented with the "STRG_VAL" 
instruction. Only tags of the USINT data type can be specified in the FORMAT parameter.

The following table shows the possible values of the FORMAT parameter and their meaning:

Value
(W#16#....)

Notation Decimal representation

0000 Decimal fraction "."
0001 ","
0002 Exponential "."
0003 ","
0004 to FFFF Invalid values

Parameter P
The conversion starts at the character whose position you specified in the P parameter. If, for 
example, the value "1" is specified in the P parameter, the conversion starts at the first 
character of the specified character string.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2298 System Manual, 07/2013,  



Example
The following table shows examples of the conversion of a character string to a numeric value:

IN (STRING) FORMAT 
(W#16#....)

OUT (data type) OUT (value) ENO status

'123' 0000 INT/DINT 123 1
'-00456' 0000 INT/DINT -456 1
'123.45' 0000 INT/DINT 123 1
'+2345' 0000 INT/DINT 2345 1
'00123AB' 0000 INT/DINT 123 1
'123' 0000 REAL 123.0 1
'-00456' 0001 REAL -456.0 1
'+00456' 0001 REAL 456.0 1
'123.45' 0000 REAL 123.45 1
'123.45' 0001 REAL 12345.0 1
'123,45' 0000 REAL 12345.0 1
'123,45' 0001 REAL 123.45 1
'.00123AB' 0001 REAL 123.0 1
'1.23e-4' 0000 REAL 1.23 1
'1.23E-4' 0000 REAL 1.23 1
'1.23E-4' 0002 REAL 1.23E-4 1
'12,345.67' 0000 REAL 12345.67 1
'12,345.67' 0001 REAL 12.345 1
'3.4e39' 0002 REAL W#16#7F800000 1
'-3.4e39' 0002 REAL W#16#FF800000 1
'1.1754943e-38' 0002 REAL 0.0 1
'12345' -/- SINT 0 0
'A123' -/- -/- 0 0
'' -/- -/- 0 0
'++123' -/- -/- 0 0
'+-123' -/- -/- 0 0

VAL_STRG: Convert numerical value to character string

Description       
The "VAL_STRG" instruction is used to convert a numerical value into a character string.

● You specify the value to be converted in the IN input parameter. You decide the format of 
the numeric value by selecting a data type.

● You query the result of the conversion in the OUT output parameter.

Permitted characters for the conversion are the digits "0" to "9", the decimal point, the decimal 
comma, notations "E" and "e", and the plus and minus characters. The conversion can be 
interrupted by invalid characters. 
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Parameters
The following table shows the parameters of the "VAL_STRG" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input USINT, SINT, 
UINT, INT, 
UDINT, DINT, 
REAL, LREAL

USINT, SINT, 
UINT, INT, 
UDINT, DINT, 
ULINT, LINT, 
REAL, LREAL

I, Q, M, D, L or 
constant

Value to be converted

SIZE Input USINT USINT I, Q, M, D, L or 
constant

Number of character 
positions

PREC Input USINT USINT I, Q, M, D, L or 
constant

Number of decimal places

FORMAT Input WORD WORD I, Q, M, D, L or 
constant

Output format of the 
characters

P InOut UINT UINT I, Q, M, D, L or 
constant

Character starting at which 
the result is written.

OUT Output STRING STRING D, L Result of the conversion

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter P
With the P parameter, you specify the character in the string starting at which the result is 
written. If, for example, the value "2" is specified in the P parameter, the converted value is 
saved starting at the second character of the string. 

Parameter SIZE and P
Use the SIZE parameter to specify how many characters of the character string will be written. 
This is counted starting from the character specified in the P parameter. If the output value is 
shorter than the specified length, the result is written to the character string right-justified. The 
empty character positions are filled with blanks.

Parameter FORMAT
Use the FORMAT parameter to specify how the numerical value is interpreted during 
conversion and written to the character string. You can specify only tags of the FORMAT data 
type in the USINT parameter.

The following table shows the possible values of the FORMAT parameter and their meaning: 

Value
(W#16#....)

Notation Sign Decimal representation

0000 Decimal fraction "-" "."
0001 ","
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Value
(W#16#....)

Notation Sign Decimal representation

0002 Exponential "."
0003 ","
0004 Decimal fraction "+" and "-" "."
0005 ","
0006 Exponential "."
0007 ","
0008 to FFFF Invalid values

Parameter PREC
Use the PREC parameter to define the number of decimal places when converting floating-
point numbers. A maximum precision of seven numbers is supported for numerical values of 
the REAL data type. If the value to be converted is an integer, you use the PREC parameter 
to specify the position where the decimal point will be placed.

Example
The following table shows examples of the conversion of numeric values to a character string.

IN (value) IN (data type) P SIZE FORMAT (W#16#....) PREC OUT (STRING) ENO status
123 UINT 16 10 0000 0 xxxxxxx123 C 1
0 UINT 16 10 0000 2 xxxxxx0.00 C 1
12345678 UDINT 16 10 0000 3 x12345.678 C 1
12345678 UDINT 16 10 0001 3 x12345.678 C 1
123 INT 16 10 0004 0 xxxxxx+123 C 1
-123 INT 16 10 0004 0 xxxxxx-123 C 1
-0.00123 REAL 16 10 0004 4 xxx-0.0012 C 1
-0.00123 REAL 16 10 0006 4 -1.2300E-3 C 1
-Inf 1) REAL 16 10 -/- 4 xxxxxx-INF C 0
+Inf 2) REAL 16 10 -/- 4 xxxxxx+INF C 0
NaN 3) REAL 16 10 -/- 4 xxxxxxxNaN C 0
12345678 UDINT 16 6 -/- 3 xxxxxxxxxx C 0
"x" represents blanks
1)-Inf: Floating-point number representing a negative infinite value.
2)+Inf: Floating-point number representing a positive infinite value.
3)NaN: Value returned as the result of invalid math operations.
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Strg_TO_Chars: Convert character string to Array of CHAR

Description       
Use this instruction to copy characters from a character string STRING to a field of several 
characters of the data type CHAR or BYTE (Array of CHAR / BYTE).

● Specify the character string from which characters are to be copied at the input parameter 
STRG.

● The characters are written to a data type Array of CHAR or Array of BYTE at the parameter 
CHARS. With the PCHARS parameter, you specify the position starting at which the 
characters are to be written to the field Array of CHAR / BYTE. The low limit of the array is 
used as standard (example: "0" with Array[1 .. 10] of CHAR).

● The number of characters in the field Array of CHAR must be at least as many characters 
as are to be copied from the character string STRING.

Only ASCII characters are valid for data types STRING, BYTE and CHAR. 

Parameters
The following table shows the parameters of the instruction "Strg_TO_Chars":

Parameter Declaration Data type Memory area Description
STRG Input STRING D, L or constant Source: Character string
PCHARS Input DINT I, Q, M, D, L or constant Position in the destination character string 

from which the characters will be written.
PCHARS = "0" addresses the first index 
of the character string.

CHARS InOut VARIANT D, L Destination: Field in which the characters 
will be copied. The characters are copied 
to a field of data type Array of CHAR or 
Array of BYTE.

CNT Output UINT I, Q, M, D, L Number of copied characters.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Chars_TO_Strg: Convert Array of CHAR to character string

Description       
Use the instruction "Chars_TO_Strg" to copy characters from a field of multiple characters of 
the data type CHAR or BYTE (Array of CHAR / BYTE) to a character string STRING.

● Specify the characters of the field Array of CHAR / BYTE to be copied to a character string 
at the input parameter CHARS. Use the PCHARS parameter to specify the position starting 
at which the characters of the Array are to be copied. The low limit of the array is used as 
standard (example: "0" with Array[1 .. 10] of CHAR).

● The characters are written to a data type STRING at the parameter STRG. The number of 
characters in the character string STRING must be at least as many characters as are to 
be copied from the field Array of CHAR.

Only ASCII characters are valid for data types STRING, CHAR and BYTE. 

Parameters
The following table shows the parameters of the instruction "Chars_TO_Strg":

Parameter Declaration Data type Memory area Description
CHARS Input VARIANT D, L Source: Field from which the 

characters will be copied.
PCHARS Input DINT I, Q, M, D, L or 

constant
Position in the field Array of CHAR / 
Array of BYTE from which the 
characters will be copied.
PCHARS = "0" addresses the first 
index of the field.

CNT Input UINT I, Q, M, D, L or 
constant

Number of characters to be copied. 
Use "0" to copy all characters.

STRG Output STRING D, L Destination: Character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

MAX_LEN: Determine the length of a character string

Description
A tag of the STRING data type contains two lengths: the maximum length and the current 
length (this is the number of currently valid characters). 

● The maximum length of the character string is specified for each tag in the STRING keyword 
in square brackets. The number of bytes occupied by a string is 2 greater than the maximum 
length.

● The current length represents the number of the character places actually used. The current 
length must be less than or equal to the maximum length. 
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You use the "MAX_LEN" instruction to query the maximum length of the character string 
specified at the IN input parameter and output this information as a numerical value at the OUT 
output parameter.

If errors occur during processing of the instruction, then an empty string will be output.

 
 

 Note
Reading out the current length

You can also use the LEN (Page 2308) instruction to read out the current length of a string.
 

Parameter
The following table shows the parameters of the "MAX_LEN" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
OUT Return DINT I, Q, M, D, L Maximum number of characters

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

ATH: Convert ASCII string to hexadecimal number

Description
You use the instruction "ATH" to convert the ASCII character string specified at the IN input 
parameter into a hexadecimal number. The result of the conversion is output to the OUT output 
parameter.

● You can reference the following data types using the pointer in the IN parameter (ASCII): 
STRING, Array of CHAR, Array of BYTE.

● You can reference the following data types using the pointer in the OUT parameter 
(hexadecimal): Bit strings, integers, STRING, Array of CHAR, Array of BYTE.

With the N parameter, you specify the number of ASCII characters to be converted. A maximum 
of 32767 valid ASCII characters can be converted. Only digits "0" to "9", upper case letters "A" 
to "F", and lower case letters "a" to "f" can be interpreted. All other characters are converted 
to zeros.

Since 8 bits are required for the ASCII character and only 4 bits for the hexadecimal digit, the 
output word length is only half of the input word length. The ASCII characters are converted 
and positioned in the output in the same order as they are read in. If there is an odd number 
of ASCII characters, the hexadecimal number is padded with zeros in the nibble to the right of 
the last converted hexadecimal number.
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Parameters
The following table shows the parameters of the "ATH" instruction:

Parameter Declaration Data type Memory area Description
IN Input VARIANT I, Q, M, D, L Pointer to ASCII character string
N Input UINT I, Q, M, D, L or 

constant
Number of ASCII characters to be 
converted

RET_VAL Return WORD I, Q, M, D, L Status of the instruction
OUT Output VARIANT I, Q, M, D, L Hexadecimal number

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code
(W#16#....)*

Description

0000 No error
0007 Invalid character. Only the following ASCII characters may be used: Digits "0" to "9", upper case letters 

"A" to "F", lower case letters "a" to "f".
8101 Invalid pointer in the IN parameter, e.g., because a non-existing data block is referenced.
8182 Input buffer is too small for data in the N parameter.
8120 Invalid format in the IN parameter.
8151 Non-supported data type in the IN parameter.
8401 Invalid pointer in the OUT parameter, e.g., because a non-existing data block is referenced.
8482 Output buffer is too small for data in the N parameter.
8420 Invalid format in the OUT parameter.
8451 Non-supported data type in the OUT parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

ASCII characters and hexadecimal values
The following table shows the ASCII characters and the corresponding hexadecimal values:

 ASCII-coded hexadecimal value Hexadecimal digit
"0" 30 0
"1" 31 1
"2" 32 2
"3" 33 3
"4" 34 4
"5" 35 5
"6" 36 6
"7" 37 7
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 ASCII-coded hexadecimal value Hexadecimal digit
"8" 38 8
"9" 39 9
"A" 41 A
"B" 42 B
"C" 43 C
D 44 D
E 45 E
F 46 F

Example
The following table shows examples of the conversion of ASCII character strings to 
hexadecimal numbers:

IN N OUT ENO status
'0123' 4 16#0123 1
'123AFx1a23' 10 16#123AF01a23 0

HTA: Convert hexadecimal number to ASCII string

Description
You use the instruction "HTA" to convert the hexadecimal number specified at the IN input into 
an ASCII character string. The result of the conversion is stored at the address specified in 
the OUT parameter.

● You can reference the following data types using the pointer in the IN parameter 
(hexadecimal): Bit strings, integers, STRING, Array of CHAR, Array of BYTE.

● You can reference the following data types using the pointer in the OUT parameter (ASCII): 
STRING, Array of CHAR, Array of BYTE.

With the N parameter, you specify the number of hexadecimal bytes to be converted. Since 8 
bits are required for the ASCII character and only 4 bits for the hexadecimal digit, the output 
value is twice as long as the input value. Each nibble of the hexadecimal number is converted 
to a character while maintaining the original order.

A maximum of 32767 characters can be written to the ASCII character string. The result of the 
conversion is represented by the digits "0" to "9" and upper-case letters "A" to "F".

If the complete result of the conversion cannot be displayed in the OUT parameter, the result 
is will only be partially written to the parameter.
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Parameters
The following table shows the parameters of the "HTA" instruction:

Parameter Declaration Data type Memory area Description
IN Input VARIANT I, Q, M, D, L Start address of the hexadecimal 

digits
N Input UINT I, Q, M, D, L or 

constant
Number of hexadecimal bytes to 
be converted 

RET_VAL Return WORD I, Q, M, D, L Error message
OUT Output VARIANT I, Q, M, D, L Address at which the result is 

stored. 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#....)

Description

0000 No error
8101 Invalid pointer at the IN parameter, e.g., because a non-existing data block is referenced.
8182 Input buffer is too small for data in the N parameter.
8120 Invalid format in the IN parameter.
8151 Non-supported data type in the IN parameter.
8401 Invalid pointer in the OUT parameter, e.g., because a non-existing data block is referenced.
8482 Output buffer is too small for data in the N parameter.
8420 Invalid format in the OUT parameter.
8451 Non-supported data type in the OUT parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

ASCII characters and hexadecimal values
The following table shows the ASCII characters and the corresponding hexadecimal values:

Hexadecimal digit ASCII-coded hexadecimal value ASCII character
0 30 "0"
1 31 "1"
2 32 "2"
3 33 "3"
4 34 "4"
5 35 "5"
6 36 "6"
7 37 "7"
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Hexadecimal digit ASCII-coded hexadecimal value ASCII character
8 38 "8"
9 39 "9"
A 41 "A"
B 42 "B"
C 43 "C"
D 44 "D"
E 45 "E"
F 46 "F"

Example
The following table shows examples of the conversion of hexadecimal numbers to ASCII 
character strings:

IN N OUT ENO status
W#16#0123 2 '0123' 1
16#123AF01023 4 '123AF010' 0

Other instructions

LEN: Determine the length of a character string

Description     
A tag of the STRING data type contains two lengths: the maximum length and the current 
length (this is the number of currently valid characters). 

● The maximum length of the character string is specified for each tag in the STRING keyword 
in square brackets. The number of bytes occupied by a string is 2 greater than the maximum 
length.

● The current length represents the number of the character places actually used. The current 
length must be less than or equal to the maximum length. 

You use the instruction "LEN" to query the current length of the character string specified at 
the IN input parameter and output this information as a numerical value at the OUT output 
parameter. An empty string ('') has the length zero.

If errors occur during processing of the instruction, then an empty string will be output.
 

 Note
Reading out the maximum length

You can also use the MAX_LEN (Page 2303) instruction to read out the current length of a 
string.
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Parameters
The following table shows the parameters of the "LEN" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
OUT Return INT, DINT, 

REAL, 
LREAL

I, Q, M, D, L Number of valid characters

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

CONCAT: Combine character strings

Description     
You use the instruction "CONCAT" to combine the character string at the IN1 input parameter 
with the character string at the IN2 input parameter. The result is output in the OUT output 
parameter with the STRING format. If the resulting character string is longer than the tag 
specified in the OUT output parameter, then the resulting character string will be limited to the 
available length.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameters
The following table shows the parameters of the "CONCAT" instruction:

Parameter Declaration Data type Memory area Description
IN1 Input STRING D, L or constant Character string
IN2 Input STRING D, L or constant Character string
OUT Return STRING D, L Resulting character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

LEFT: Read the left character of a character string

Description     
You use the instruction "LEFT" to extract a partial string beginning with the first character of 
the string at the IN input parameter. You specify the number of characters to be extracted in 
the L parameter. The extracted characters are output in the OUT output parameter with 
STRING format.

If the number of characters to be extracted is greater than the current length of the character 
string, the OUT output parameter returns the input character string as a result. If the L 
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parameter contains the value "0" or the input value is an empty string, an empty string will be 
returned. If the value in the L parameter is negative, an empty string will be output.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameters
The following table shows the parameters of the "LEFT" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
L Input BYTE, INT, 

SINT, USINT
I, Q, M, D, L or 
constant

Number of characters to be 
extracted

OUT Return STRING D, L Extracted partial string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

RIGHT: Read the right characters of a character string

Description     
You use this instruction to extract the last L character in a character string in the input parameter 
IN. You specify the number of characters to be extracted in the L parameter. The extracted 
characters are output in the OUT output parameter with STRING format.

If the number of characters to be extracted is greater than the current length of the character 
string, the OUT output parameter returns the input character string as a result. If the L 
parameter contains the value "0" or the input value is an empty string, an empty string will be 
returned. If the value in the L parameter is negative, an empty string will be output.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameters
The following table shows the parameters of the "RIGHT" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
L Input BYTE, INT, 

SINT, USINT
I, Q, M, D, L or 
constant

Number of characters to be 
extracted

OUT Return STRING D, L Extracted partial string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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MID: Read middle characters of a character string

Description     
You use this instruction to extract a portion of the character string in the IN input parameter. 
With the P parameter, you specify the position of the first character to be extracted. With the 
L parameter, you define the length of the character string to be extracted. The extracted partial 
character string is output to the OUT output parameter.

The following rules must be observed when executing the instruction: 

● If the number of characters to be extracted exceeds the current length of the character 
string in the IN input parameter, a partial character string will be output, starting from 
character position P and continuing to the end of the character string.

● If the character position specified in the P parameter falls outside the current character 
string length in the IN input parameter, an empty character string will be output in the OUT 
output parameter.

● If the value of the P or L parameter equals zero or is negative, an empty character string 
will be output in the OUT output parameter.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameters
The following table shows the parameters of the "MID" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
L Input BYTE, INT, 

SINT, 
USINT

I, Q, M, D, L or 
constant

Length of the string to be extracted

P Input BYTE, INT, 
SINT, 
USINT

I, Q, M, D, L or 
constant

Position of the first character to be 
extracted (first character = 1)

OUT Return STRING D, L Extracted partial string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

DELETE: Delete characters in a character string

Description     
You use this instruction to delete a portion of the character string in the IN input parameter. 
With the P parameter, you specify the position of the first character to be deleted. You specify 
the number of characters to be deleted in the L parameter. The remaining partial character 
string is output to the OUT output parameter with STRING format.

The following rules must be observed when executing the instruction:
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● If the value in the P parameter is less than or equals zero, an empty character string will 
be output in the OUT output parameter.

● If the value in the P parameter is greater than the current length of the character string in 
the IN input, the input character string will be returned in the OUT output parameter.

● If the value in the L parameter equals zero, the input character string will be returned in the 
OUT output parameter.

● If the number of characters to be deleted at the L parameter is greater than the length of 
the character string in the IN parameter, an empty character string will be output.

● If the value in the L parameter is negative, an empty character string will be output.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameter
The following table shows the parameters of the "DELETE" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
L Input BYTE, INT, 

SINT, USINT
I, Q, M, D, L or 
constant

Number of characters to be deleted

P Input BYTE, INT, 
SINT, USINT

I, Q, M, D, L or 
constant

Position of first character to be 
deleted

OUT Return STRING D, L Resulting character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

INSERT: Insert characters in a character string

Description     
You use this instruction to insert the character string in the IN2 input parameter to the character 
string in the IN1 input parameter. With the P parameter, you specify the position of the character 
starting at which the characters are inserted. The result is output in the OUT output parameter 
with the STRING format.

The following rules must be observed when executing the instruction:

● If the value in the P parameter exceeds the current length of the character string in the IN1 
input parameter, the character string of the IN2 input parameter will be appended to the 
character string of the IN1 input parameter.

● If the value at the P parameter is zero, the character string at the IN2 parameter followed 
by the character string at the IN1 parameter will be output in the OUT output parameter.
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● If the value in the P parameter is negative, an empty character string will be output in the 
OUT output parameter.

● If the resulting character string is longer than the tag specified in the OUT output parameter, 
the resulting character string will be limited to the available length.

Parameter
The following table shows the parameters of the "INSERT" instruction:

Parameter Declaration Data type Memory area Description
IN1 Input STRING D, L or constant Character string 
IN2 Input STRING D, L or constant String to insert
P Input BYTE, 

INT, SINT, 
USINT

I, Q, M, D, L or 
constant

Insert position

OUT Return STRING D, L Resulting character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

REPLACE: Replace characters in a character string

Description     
You use this instruction to replace a portion of the character string in the IN1 input with the 
character string in the IN2 input. You specify the position of the first character to be replaced 
in the P parameter. You specify the number of characters to be replaced in the L parameter. 
The result is output in the OUT output parameter with the STRING format.

The following rules must be observed when executing the instruction:

● If the value in the P parameter is less than or equals zero, an empty character string will 
be output in the OUT output parameter.

● If the value in the L parameter is less than zero, an empty character string will be output in 
the OUT output parameter.

● If P equals one, the character string in the IN1 input will be replaced beginning with (and 
including) the first character.

● If the value in the P parameter exceeds the current length of the character string in the IN1 
input parameter, the character string of the IN2 input parameter will be appended to the 
character string of the IN1 input parameter.

● If the resulting character string is longer than the tag specified in the OUT output parameter, 
the resulting character string will be limited to the available length.

● If the value at parameter L is zero, characters are not replaced but inserted. The same 
conditions apply as with the instruction INSERT. See also: INSERT: Insert characters in a 
character string (Page 2312)
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Parameters
The following table shows the parameters of the "REPLACE" instruction:

Parameter Declaration Data type Memory area Description
IN1 Input STRING D, L or constant String with characters to be 

replaced.
IN2 Input STRING D, L or constant String with characters to be 

inserted.
L Input BYTE, INT, 

SINT, USINT
I, Q, M, D, L or 
constant

Number of characters to be 
replaced

P Input BYTE, INT, 
SINT, USINT

I, Q, M, D, L or 
constant

Position of first character to be 
replaced

OUT Return STRING D, L Resulting character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

FIND: Find characters in a character string

Description     
You can use this instruction to search through the character string in the IN1 input parameter 
for a specific character or a specific string of characters.

● You specify the value to be searched for in the IN2 input parameter. The search is made 
from left to right.

● The position of the first occurrence is output in the OUT output parameter. If the search 
returns no match, the value "0" will be output in the OUT output parameter.

If errors occur during processing of the instruction, an empty string will be output.

Parameters
The following table shows the parameters of the "FIND" instruction:

Parameter Declaration Data type Memory area Description
IN1 Input STRING D, L or constant String searched through
IN2 Input STRING, 

CHAR
D, L or constant
(For CHAR also I, Q, 
M)

Characters to search for

OUT Return DINT, INT, 
LREAL, 
REAL

I, Q, M, D, L Character position

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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9.7.3.3 Process image

UPDAT_PI: Update the process image inputs

Description  
With the instruction, you update the OB 1 process image (=process image partition 0) of the 
inputs or a process image partition of the inputs of the inputs defined by configuration.

If you have configured repeated signaling of I/O access errors for the system-side process 
image update, then the selected process image will be updated constantly.

Otherwise, this update will only be performed if the selected process image partition is not 
updated by the system, in other words:

● If you have not assigned this process image partition to an interrupt OB 
or

● If you selected process image partition 0 and have disabled updating of the OB 1 process 
image partition during configuration.

 

  Note

Each logical address that you have assigned to a process image partition of the inputs 
per configuration no longer belongs to the OB 1 process image of the inputs.

When you update a process image partition with "UPDAT_PI", you must not perform a 
simultaneous update with the "SYNC_PI (Page 2318)" instruction.

 

System-side updating of the OB 1 process image of the inputs and the process image partitions 
of inputs that you have assigned to an interrupt OB takes place independently of "UPDAT_PI" 
calls.

Parameters
The following table shows the parameters of the "UPDAT_PI"instruction:

Parameter Declaration Data type Memory area Description
PART Input PIP I, Q, M, D, L or 

constant
Number of the process image 
partition of the inputs to 
be updated. Maximum value range 
(depending on the CPU): 
0 to 31 (0 means OB 1 process 
image, n where 1 <= n <= 31 means 
process image partition n).

RET_VAL Return INT I, Q, M, D, L Error information
FLADDR Output WORD I, Q, M, D, L Address of the first byte to cause an 

error 
if an access error has occurred.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8090 Illegal value for PART parameter
8091 The specified process image partition was not yet defined or is not located in the permitted process image 

area on the CPU.
8092 The process image partition is being updated by the system and cannot be used for the PART parameter.
8093 The process image partition update is being processed in another OB.
80A0 An access error was detected when accessing the I/O.
General error 
information

See also:  GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note

If you use the instruction for process image partitions of DP standard slaves for which you 
have defined a consistency area greater than 32 bytes, the error codes of the "DPRD_DAT 
(Page 2363)" instruction are also possible.

 

UPDAT_PO: Update the process image outputs

Description     
You use the instruction to transfer the signal states of the OB 1 process image (= process 
image partition 0) of the outputs or a process image partition of the outputs defined per 
configuration to the output modules.

If you have specified a consistency range for the selected process image partition, 
corresponding data is transferred as consistent data to the respective I/O module.

 

 Note

Each logical address you have assigned to a process image partition of the outputs during 
configuration no longer belongs to the OB 1 process image of the outputs.

Outputs that you update with "UPDAT_PO" must not be updated simultaneously with the 
"SYNC_PO (Page 2319)" instruction.

 

The OB 1 process image of the outputs and the process image partitions of the outputs that 
you have assigned to an interrupt OB are transferred by the system to the output modules 
independently of "UPDAT_PO" calls.
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Parameters
The following table shows the parameters of the "UPDAT_PO" instruction:

Parameter Declaration Data type Memory area Description
PART Input PIP I, Q, M, D, L or 

constant
Number of the process image partition 
of the outputs to be transferred. 
Maximum value range (depending on 
the CPU): 0 to 31.
(0 means OB 1 process image, n 
where 1 <= n <= 31 means process 
image partition n)

RET_VAL Return INT I, Q, M, D, L Error information
FLADDR Output WORD I, Q, M, D, L Address of the first byte to cause an 

error 
if an access error has occurred.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8090 Illegal value for PART parameter
8091 The specified process image partition was not yet defined or is not located in the permitted process image 

area on the CPU.
8092 The process image partition is being updated by the system and cannot be used for the PART parameter. 
8093 The process image partition update is being processed in another OB.
80A0 An access error was detected when accessing the I/O.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note

If you use the instruction for process image partitions of DP standard slaves for which you 
have defined a consistency area greater than 32 bytes, the error codes of the "DPWR_DAT 
(Page 2365)" instruction are also possible.
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SYNC_PI: Synchronize the process image inputs

Description
The "SYNC_PI" is used to update the process image partition of inputs in isochronous mode. 
A user program linked to a DP cycle or PN send cycle can use this instruction to update input 
data acquired in a process image partition of the inputs isochronously and consistently.

Call
"SYNC_PI" is interruptible and can only be called in OBs 61, 62, 63 and 64.

 

 Note

A call of the "SYNC_PI" instruction in OBs 61 to 64 is only permitted if you have assigned the 
affected process image partition to the associated OB in the HW configuration.

A process image partition that you update with "SYNC_PI" must not be updated 
simultaneously with the "UPDAT_PI (Page 2315)" instruction.

 

Parameters
The following table shows the parameters of the "SYNC_PI" instruction:

Parameter Declaration Data type Memory area Range of values Description
PART Input PIP I, Q, M, D, L or 

constant
1 to 31 Number of the process image partition of 

the inputs to be updated isochronously.
RET_VAL Return INT I, Q, M, D, L - Error information
FLADDR Output WORD I, Q, M, D, L  Address of the first byte to cause an error 

if an access error has occurred.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Event class Error 
code (W#16#...)*

Explanation

0000 No error occurred.
0001 Consistency warning. The update of the process image partition was distributed over two DP or PN 

cycles. However, the data in one slave or IO device were consistently transferred.
8090 Illegal value on PART parameter or updating the specified process image partition of the inputs is not 

permitted in this OB. The process image partition of the inputs was not updated.
8091 The specified process image partition was not yet defined or is not located in the permitted process 

image area on the CPU. The process image partition of the inputs was not updated.
8092 The process image partition is being updated by the system and cannot be used for the PART 

parameter. 
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Event class Error 
code (W#16#...)*

Explanation

8093 The process image partition update is being processed in another OB.
80A0 During updating an access error was detected. The affected inputs were set to "0".
80A1 The update time is after the permitted access window. The process image partition of the inputs was 

not updated.
The DP or PN cycle is too short to ensure enough time for processing the instruction. You must therefore 
increase the TDP (also known as T_DC), Ti and To timers.

80A2 Access error with consistency warning
In the case of update of the specified process image partition an access error with simultaneous 
consistency warning was detected.
● The data of the incorrect inputs was not read by the I/O. In the process image partition of the inputs 

the involved inputs are set to zero.
● The update of the process image partition of the not involved by an access error input data was 

distributed over two DP and PN cycles.
80C1 The update time is before the permitted access window. The process image partition of the inputs was 

not updated.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note

If you use the "SYNC_PI" instruction for process image partitions of DP standard slaves for 
which you have defined a consistency area greater than 32 bytes, the error codes of the 
"DPRD_DAT (Page 2363)" instruction are also possible.

 

SYNC_PO: Synchronize the process image outputs

Description
The instruction "SYNC_PO" is used to update a process image partition of outputs in 
isochronous mode. A user program linked to a DP cycle can use this instruction to transfer the 
calculated output data of a process image partition outputs to the I/O isochronously and 
consistently.
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Call
"SYNC_PO" is interruptible and can only be called in OBs 61, 62, 63 and 64.

 

 Note

A call of the "SYNC_PO" instruction in OBs 61 to 64 is only permitted if you have assigned 
the affected process image partition to the associated OB in the HW configuration.

A process image partition that you update with "SYNC_PO" must not be updated 
simultaneously with the "UPDAT_PO (Page 2316)" instruction.

 

Parameters
The following table shows the parameters of the "SYNC_PO" instruction:

Parameter Declaration Data type Memory area Range of values Description
PART Input PIP I, Q, M, D, L or 

constant
1 to 31 Number of the process image partition of 

the outputs to be updated isochronously.
RET_VAL Return INT I, Q, M, D, L - If an error occurs while the instruction is 

being executed, the return value contains 
an error code.

FLADDR Output WORD I, Q, M, D, L - Address of the first byte that has caused 
the error.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code 
(W#16#...)*

Explanation

0000 No error occurred.
0001 Consistency warning. The update of the process image partition was distributed over two DP or PN cycles. 

However, the data in one slave or IO device were consistently transferred.
8090 Illegal value in PART parameter, or updating the specified process image partition of the outputs is not 

permitted in this OB. Outputs were not transferred to the I/O. The process image partition of the outputs 
remains unchanged.

8091 The specified process image partition was not yet defined or is not located in the permitted process image 
area on the CPU. Outputs were not transferred to the I/O. The process image partition of the outputs remains 
unchanged.

8092 The process image partition is being updated by the system and cannot be used for the PART parameter. 
8093 The process image partition update is being processed in another OB.
80A0 In the case of update of the specified process image partition of the outputs an access error was detected. 

Incorrect outputs were not transferred to the I/O. During process image partition of the outputs, these outputs 
remain unchanged.
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Error code 
(W#16#...)*

Explanation

80A1 Access error with consistency warning
In the case of update of the specified process image partition of the outputs an access error with 
simultaneous consistency warning was detected.
● The data of the incorrect outputs were not transferred to the I/O. During process image partition of the 

outputs, the involved outputs remain unchanged.
● The update of the process image partition of the not involved by an access error input data was 

distributed over two DP and PN cycles.
80A2 The update time is after the permitted access window. Outputs were not transferred to the I/O. The process 

image partition of the outputs remains unchanged.
80C1 The update time is before the permitted access window. Outputs were not transferred to the I/O. The process 

image partition of the outputs remains unchanged.
General error 
information

See also:  GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note

If you use the "SYNC_PO" instruction for process image partitions of DP standard slaves for 
which you have defined a consistency area greater than 32 bytes, the error codes of the 
"DPWR_DAT (Page 2365)" instruction are also possible.

 

9.7.3.4 Distributed I/O

RDREC: Read data record

Description
You use the instruction "RDREC" to read the data record with the number INDEX from the 
component addressed using the ID. This may be a module in a central rack or a distributed 
component (PROFIBUS DP or PROFINET IO).

● Use MLEN to specify the maximum number of bytes you want to read. If length "0" is 
selected at the parameter MLEN, the complete data record is written at the parameter 
RECORD.

● The target range RECORD should have at least the length of MLEN bytes.

● The value TRUE  for the output parameter VALID indicates that the data record was 
successfully transferred to the target range RECORD. In this case, the LEN output 
parameter contains the length of the read data in bytes.

● If an error has occurred during transfer of the data record, this is indicated by the output 
parameter ERROR. In this case, the output parameter STATUS contains the error 
information.
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 Note

The interface of the "RDREC" instruction is identical to the "RDREC" FB defined in 
"PROFIBUS Guideline PROFIBUS Communication and Proxy Function Blocks according to 
IEC 61131-3".

 

Functional description
"RDREC" works asynchronously, which means its execution extends over multiple calls. You 
start the data record transfer by calling "RDREC" with REQ= 1.

The job status is displayed via the output parameter BUSY and the two central bytes of output 
parameter STATUS. The two central bytes of STATUS correspond to the RET_VAL output 
parameter of the instructions that operate asynchronously.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

The transfer of the data record is complete when the output parameter BUSY has the value 
FALSE .

Parameter
The following table shows the parameters of the instruction "RDREC":

Parameter Declaration Data type* Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
REQ = 1: Transfer data record

ID Input HW_IO I, Q, M, L or constant Hardware identifier of the hardware 
component (DP/PROFINET IO)
The number is assigned automatically and is 
stored in the properties of the component or of 
the interface in the hardware configuration.

INDEX Input BYTE, DINT, 
INT, SINT, 
UINT, USINT, 
WORD

I, Q, M, D, L or 
constant

Data record number

MLEN Input BYTE, UINT, 
USINT

I, Q, M, D, L or 
constant

Maximum length in bytes of the data record 
information to be read

VALID Output BOOL I, Q, M, D, L New data record was received and is valid
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The reading process is not yet 

complete.
ERROR Output BOOL I, Q, M, D, L ERROR = 1: An error occurred during the 

reading process.
STATUS Output DWORD I, Q, M, D, L Block status or error information
LEN Output UINT I, Q, M, D, L Length of the read data record information
RECORD InOut VARIANT I, Q, M, D, L Target range for the data record read.
* There is no implicit conversion in STL, which is why the range of valid data types may be limited. During programming in 
STL, please note the valid data types. These are displayed in the parameter tooltip.
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You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

 

 Note

If you use "RDREC" to read a data record for PROFINET IO, then negative values in the 
INDEX, MLEN, and LEN parameters will be interpreted as an unsigned 16-bit integer.

 

STATUS parameter
For interpretation of the STATUS parameter, see Parameter STATUS (Page 2330).

See also
Basics of block access (Page 1027)

WRREC: Write data record

Description
The instruction "WRREC" is used to transfer the RECORD data record to the component 
addressed using ID. This may be a module in a central rack or a distributed component 
(PROFIBUS DP or PROFINET IO).

● Use LEN to specify the length of the data record to be transmitted in bytes. The selected 
length of the source range RECORD should have at least the length of LEN bytes.

● The value TRUE  at output parameter DONE indicates that the data record has been 
successfully transferred.

● If an error has occurred during transfer of the data record, this is indicated by the output 
parameter ERROR. In this case, the output parameter STATUS contains the error 
information.

 

 Note

The interface of the "WRREC" instruction is identical to the "WRREC" FB defined in 
"PROFIBUS Guideline PROFIBUS Communication and Proxy Function Blocks according to 
IEC 61131-3".

 

Functional description
"The WRREC" instruction works asynchronously, that is, its execution extends over multiple 
calls. You start the data record transfer by calling "WRREC" with REQ  = 1.

The job status is displayed via the output parameter BUSY and the two central bytes of output 
parameter STATUS. The two central bytes of STATUS correspond to the RET_VAL output 
parameter of the instructions that operate asynchronously.
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See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

Note that you must assign the same value to the actual parameter of RECORD for all "WRREC" 
calls that belong to one and the same job. The same applies to the actual parameters of LEN.

The transfer of the data record is complete when the output parameter BUSY has the value 
FALSE.

Parameter
The following table shows the parameters of the instruction "WRREC":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
REQ= 1: Transfer data record

ID Input HW_IO I, Q, M, L or constant ID number of the hardware component (DP/
PROFINET IO)
The number is assigned automatically and is 
stored in the properties of the component or of 
the interface in the hardware configuration.

INDEX Input DINT I, Q, M, D, L or 
constant

Data record number

LEN Input BYTE, UINT, 
USINT

I, Q, M, D, L or 
constant

(hidden)
Maximum length of the data record to be 
transferred in bytes

DONE Output BOOL I, Q, M, D, L Data record was transferred
BUSY Output BOOL I, Q, M, D, L BUSY= 1: The writing process is not yet 

complete.
ERROR Output BOOL I, Q, M, D, L ERROR = 1: An error occurred during the 

writing process.
STATUS Output DWORD I, Q, M, D, L Block status or error information

For interpretation of the STATUS parameter, 
see Parameter STATUS (Page 2330).

RECORD InOut VARIANT I, Q, M, D, L Data record

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

 

 Note

If you use "WRREC" to write a data record for PROFINET IO, negative values in the INDEX 
and LEN parameters will be interpreted as an unsigned 16-bit integer.

 

STATUS parameter
For interpretation of the STATUS parameter, see Parameter STATUS (Page 2330).
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GETIO: Read process image

Description
You use the instruction "GETIO" to consistently read out all inputs of a DP standard slave/
PROFINET IO device. The instruction "GETIO" calls the instruction "DPRD_DAT (Page 2363)". 
If there was no error during the data transmission, the data that have been read are entered 
in the target range indicated by INPUTS .

The target range must have the same length that you configured for the selected component.

If you read from a DP standard slave with a modular configuration or with several DP identifiers, 
you can only access the data of one component/DP identifier at the configured start address 
with a "GETIO" call.

Parameter
The following table shows the parameters of the instruction "GETIO":

Parameter Declaration Data type Memory area Description
ID Input HW_SUBMOD

ULE
I, Q, M, D, L or constant Hardware ID of the DP standard slave / 

PROFINET IO device.
STATUS Output DWORD I, Q, M, D, L Contains the error information of 

"DPRD_DAT (Page 2363)" in the form 
DW#16#40xxxx00.

LEN Output INT I, Q, M, D, L Amount of data read in bytes
INPUTS InOut VARIANT I, Q, M, D Target range for the read data. It must have 

the same length as the range that you 
configured for the selected DP standard 
slave / PROFINET IO device. Only the 
BYTE  data type is permitted.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter
See also: DPRD_DAT: Read consistent data of a DP standard slave (Page 2363).

SETIO: Transfer process image

Description
You use the instruction "SETIO" to consistently transfer data from the source range defined 
by the parameter OUTPUTS  to the addressed DP standard slave / PROFINET IO device, 
and, if necessary, to the process image (if you have configured the relevant address area of 
the DP standard slave / PROFINET IO device as a consistent range in a process image). 
"SETIO" calls the instruction "DPWR_DAT (Page 2365)".

The source range must have the same length that you configured for the selected component.
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In the case of a DP standard slave / PROFINET IO device with modular configuration or with 
several DP identifiers, you can only access one DP identifier / component per "SETIO" call.

Parameters
The following table shows the parameters of the "SETIO" instruction:

Parameter Declaration Data type Memory area Description
ID Input HW_SUBMODU

LE
I, Q, M, D, L or 
constant

Hardware ID of the DP standard slave / 
PROFINET IO device.

STATUS Output DWORD I, Q, M, D, L Contains the error information of 
"DPWR_DAT (Page 2365)" in the form 
DW#16#40xxxx00.

OUTPUTS InOut VARIANT I, Q, M, D Source range for the data to be written. It 
must have the same length as the range 
that you configured for the selected DP 
standard slave / PROFINET IO device. 
Only the BYTE data type is permitted.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS
See also: DPWR_DAT: Write consistent data of a DP standard slave (Page 2365).

GETIO_PART: Read process image area

Description
You use the instruction "GETIO_PART" to consistently read out a related part of the inputs of 
an IO module. "GETIO_PART" calls the instruction "DPWR_DAT (Page 2363)".

Use the ID input parameter to select the IO module by means of the hardware ID.

You use the OFFSET and LEN parameters to specify the portion of the process image area 
to be read. If the input area spanned by OFFSET and LEN is not completely covered by the 
module, the block returns the error code DW#16#4080B700. 

The length of the target range must be larger than or equal to the amount of bytes to be read:

● If there was no error during the data transmission, ERROR receives the value FALSE. The 
data that are read are written to the target range defined at the INPUTS parameter.

● If there was no error during the data transmission, ERROR receives the value TRUE. The 
STATUS parameter receives the error information from "DPRD_DAT".

● If the target range is greater than LEN, then the first LEN bytes of the target range will be 
written. ERROR receives the value FALSE.
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Parameters
The following table shows the parameters of the "GETIO_PART" instruction:

Parameter Declaration Data type Memory area Description
ID Input HW_SUBMOD

ULE
I, Q, M, D, L or constant Hardware identifier of the module

OFFSET Input INT I, Q, M, D, L or constant Number of the first byte to be read in the 
process image for the component 
(smallest possible value: 0).

LEN Input INT I, Q, M, D, L or constant Number of bytes to be read.
STATUS Output DWORD I, Q, M, D, L Contains the error information of 

"DPRD_DAT" in the form 
DW#16#40xxxx00, if ERROR = TRUE.

ERROR Output BOOL I, Q, M, D, L Error display:
ERROR = TRUE if an error occurs when 
"DPRD_DAT" is called.

INPUTS InOut VARIANT I, Q, M, D Target range for read data:
If the target range is greater than LEN, the 
first LEN bytes of the target range are 
written.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS
See "RET_VAL" parameter of the "DPRD_DAT (Page 2363)" instruction.

SETIO_PART: Transfer process image area

Description
You can use the "SETIO_PART" instruction to consistently write data from the source area 
spanned by OUTPUTS to the outputs of an IO module. "SETIO_PART" calls the instruction 
"DPWR_DAT (Page 2365)".

Use the ID input parameter to select the IO module by means of the hardware ID.
You use the OFFSET and LEN parameters to specify the portion of the process image area 
to be written for the components addressed by means of ID. If the output area spanned by 
OFFSET and LEN is not completely covered by the module, the block returns the error code 
DW#16#4080B700.

The length of the source range must be greater than or equal to the number of bytes to be 
written:
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● If there was no error during the data transmission, ERROR receives the value FALSE.

● If there was an error during the data transmission, ERROR receives the value TRUE, and 
STATUS receives the error information of "DPWR_DAT".

● If the source range is greater than LEN, the first LEN bytes from OUTPUTS are transferred. 
ERROR receives the value FALSE.

Parameter
The following table shows the parameters of the instruction "SETIO_PART":

Parameter Declaration Data type Memory area Description
ID Input HW_SUBMO

DULE
I, Q, M, D, L or constant Hardware identifier of the IO module.

OFFSET Input INT I, Q, M, D, L or constant Number of the first byte to be written in the 
process image for the component (smallest 
possible value: 0).

LEN Input INT I, Q, M, D, L or constant Number of bytes to be written.
STATUS Output DWORD I, Q, M, D, L Contains the error information of 

"DPWR_DAT" in the form 
DW#16#40xxxx00, if ERROR = TRUE.

ERROR Output BOOL I, Q, M, D, L Error display:
ERROR = TRUE if an error occurs when 
"DPWR_DAT" is called.

OUTPUTS InOut VARIANT I, Q, M, D Source range for the data to be written:
If the source range is greater than LEN, the 
first LEN bytes are transferred from 
OUTPUTS.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameters STATUS and ERROR
See instruction "DPWR_DAT  (Page 2365)".

RALRM: Receive interrupt

Description RALRM

Description
The instruction receives an interrupt with all corresponding information from an I/O module 
(centralized configuration) or from a module of a DP slave or PROFINET IO device and 
supplies this information to its output parameters.

The information in the output parameters contains the start information of the called OB as 
well as information of the interrupt source.
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For a central configuration, the configuration of the data structure of the target range AINFO 
corresponds to the data structure of PROFINET IO.

Call "RALRM" only within the interrupt OB started by the CPU operating system as a result of 
the I/O interrupt that is to be examined.

 

 Note

If you call "RALRM" in an OB whose start event is not an I/O interrupt, the instruction will 
provide correspondingly reduced information in its outputs.
Make sure to use different instance DBs when you call "RALRM" in different OBs. If you 
evaluate data resulting from an "RALRM" call outside of the associated interrupt OB, you 
should moreover use a separate instance DB per OB start event.

 

 Note

The interface of the "RALRM" instruction is identical to the "RALRM" FB defined in 
"PROFIBUS Guideline PROFIBUS Communication and Proxy Function Blocks according to 
IEC 61131-3".

 

Calling RALRM
"RALRM" can be called in three operating modes (MODE parameter). These are explained in 
the table below.

MODE RALRM ...
0 ... shows the component that triggered the interrupt in the ID output parameter and writes TRUE in the NEW 

output parameter.
1 ... writes all output parameters, independent of the interrupt triggering component.
2 ... checks whether the component specified in the F_ID input parameter has triggered the interrupt.

● If not, NEW  = FALSE
● If yes, NEW  = TRUE and all other output parameters are written.

Parameters
The following table shows the parameters of the "RALRM" instruction:

Parameter Declaration Data type Memory area Description
MODE Input INT I, Q, M, D, L or 

constant
Mode

F_ID Input HW_IO D, L or constant Hardware identifier of the module.
The number is assigned automatically and is 
stored in the hardware configuration properties 
of the component or interface.

MLEN Input UINT I, Q, M, D, L or 
constant

Maximum length of the interrupt information to 
be received in bytes.
With MLEN = 0, all data specified at the AINFO 
parameter are read.
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Parameter Declaration Data type Memory area Description
NEW Output BOOL I, Q, M, D, L A new interrupt was received.
STATUS 
(Page 2330) 

Output DWORD I, Q, M, D, L Error code

ID Output HW_IO I, Q, M, D, L Hardware identifier of the module from which the 
interrupt was received.

LEN Output UINT I, Q, M, D, L Length of the received interrupt information
TINFO 
(Page 2334) 

InOut VARIANT I, Q, M, D, L Destination area for OB start and management 
information

AINFO 
(Page 2346) 

InOut VARIANT I, Q, M, D, L Destination area for header information and 
additional interrupt information
For AINFO , you should provide a length of at 
least MLEN  bytes.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

 

 Note

If you select a target range  (Page 2352)TINFO or AINFO that is too short, RALRM cannot 
enter the full information.

 

Parameter STATUS

Description
The STATUS  output parameter contains error information. If it is interpreted as 
ARRAY[1...4] of BYTE, the error information has the following structure:

Array element Name Meaning
STATUS[1] Function_Num ● B#16#00, if no error

● Function ID from DPV1-PDU:
In the event of an error, B#16#80  is output (in the event of an error reading a 
data record B#16#DE and writing a data record B#16#DF).
If no DPV1 protocol element is used, then B#16#C0 will be output.

STATUS[2] Error_Decode Location of the error ID
STATUS[3] Error_Code_1 Error ID
STATUS[4] Error_Code_2 Manufacturer-specific error ID extension
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Array element  STATUS[2]
STATUS[2] can have the following values:

Error_Decode 
(B#16#...)

Source Meaning

00 to 7F CPU No error or no warning
80 DPV1 Error according to IEC 61158-6
81 to 8F CPU B#16#8x shows an error in the xth call parameter of the instruction.
FE, FF DP profile Profile-specific error

Array element  STATUS[3]
STATUS[3] can have the following values:

Error_Decode
(B#16#...)

Error_Code_1
(B#16#...)

Explanation 
according to DVP1

Meaning

00 00  No error, no warning
    
70 00 reserved, reject Initial call; no active data record transfer
 01 reserved, reject Initial call; data record transfer has started
 02 reserved, reject Intermediate call; data record transfer already active
    
80 90 reserved, pass Invalid logical start address
 92 reserved, pass Illegal type for VARIANT pointer
 93 reserved, pass The DP component addressed via ID or F_ID is not 

configured.
 96  The "RALRM (Page 2328)" cannot supply the OB start 

information, management information, header information, 
or additional interrupt information.
For OBs 4x, 55, 56, 57, 82 and 83, you can use the 
"DPNRM_DG (Page 2378)" instruction to read the current 
diagnostic frame of the relevant DP slave asynchronously 
(address information from OB start information).

 A0 read error Negative acknowledgment while reading the module
 A1 write error Negative acknowledgement when writing 

to the module
 A2 module failure DP protocol error at layer 2 (e.g., slave failure or bus 

problems)
 A3 reserved, pass ● PROFIBUS DP: DP protocol error with Direct-Data-Link-

Mapper or User-Interface/User
● PROFINET IO: General CM error

 A4 reserved, pass Communication on PBUS+ disrupted
 A5 reserved, pass –
 A7 reserved, pass DP slave or module is occupied (temporary error
 A8 version conflict DP slave or module reports non-compatible versions
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Error_Decode
(B#16#...)

Error_Code_1
(B#16#...)

Explanation 
according to DVP1

Meaning

 A9 feature not 
supported

Function is not supported by DP slave or module

 AA to AF user specific DP slave or module reports a manufacturer-specific error 
in its application. Please check the documentation from the 
manufacturer of the DP slave or module.

 B0 invalid index Data record not known in module

Illegal data record number ≥ 256
 B1 write length error The length information in the RECORD parameter is 

incorrect
With "RALRM (Page 2328)": length error in AINFO 
(Page 2346),
with "RDREC (Page 2321)" and "WRREC (Page 2323)": 
length error in MLEN

 B2 invalid slot The configured slot is 
not assigned.

 B3 type conflict Actual module type 
does not match 
specified module type

 B4 invalid area DP slave or module reports access to an invalid area
 B5 state conflict DP slave or module not ready
 B6 access denied DP slave or module denies access
 B7 invalid range DP slave or module reports an invalid range for a parameter 

or value
 B8 invalid parameter DP slave or module reports an invalid parameter
 B9 invalid type DP slave or module reports an invalid type

With "RDREC (Page 2321)": buffer too small (subsets 
cannot be read)
With "WRREC (Page 2323)": buffer too small (subsets 
cannot be written)

 BA to BF user specific DP slave or module reports a manufacturer-specific error 
when accessing. Please check the documentation from the 
manufacturer of the DP slave or module.

 C0 read constrain 
conflict

With "WRREC (Page 2323)": the data can only be written 
when the CPU is in STOP mode. Note: this means that 
writing by the user program is not possible. You can only 
write the data online with PG/PC.
With "RDREC (Page 2321)": the module routes the data 
record, but either no data is present or the data can only be 
read when the CPU is in STOP mode. Note: if data can only 
be read when the CPU is in STOP mode, then an evaluation 
by the user program is not possible. In this case, you can 
only read the data online with PG/PC.

 C1 write constrain 
conflict

The data of the previous write job on the module for the 
same data record have not yet been processed by the 
module.

 C2 resource busy The module is currently processing the maximum possible 
number of jobs for a CPU.
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Error_Decode
(B#16#...)

Error_Code_1
(B#16#...)

Explanation 
according to DVP1

Meaning

 C3 resource unavailable The required operating resources are currently occupied.
 C4  Internal temporary error. Job could not be executed.

Repeat the job. If this error occurs often, check your 
installation for sources of electrical interference.

 C5  DP slave or module not available.
 C6  Data record transfer was canceled due to priority class 

cancellation
 C7  Job aborted due to warm or cold restart on the DP master
 C8 to CF  DP slave or module reports a manufacturer-specific 

resource error. Please check the documentation from the 
manufacturer of the DP slave or module.

 Dx user specific DP slave specific. Refer to the description of the DP slave.
    
81 00 to FF  Error in the initial call parameter (with "RALRM 

(Page 2328)": MODE)
 00  Illegal operating mode
    
82 00 to FF  Error in the second call parameter
: :  :
88 00 to FF  Error in the eighth call parameter (with "RALRM 

(Page 2328)": TINFO (Page 2334))
 01  Wrong syntax ID
 23  Quantity structure exceeded or target range too small
 24  Wrong range ID
 32  DB/DI no. out of user range
 3A  DB/DI no. is NULL for area ID DB/DI or specified DB/DI 

does not exist
    
89 00 to FF  Error in the ninth call parameter (with "RALRM 

(Page 2328)": AINFO (Page 2346))
 01  Wrong syntax ID
 23  Quantity structure exceeded or target range too small
 24  Wrong range ID
 32  DB/DI no. out of user range
 3A  DB/DI no. is NULL for area ID DB/DI or specified DB/DI 

does not exist
    
8A 00 to FF  Error in the 10th call parameter
: :  :
8F 00 to FF  Error in the 15th call parameter
    
FE, FF 00 to FF  Profile-specific error
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Array element  STATUS[4]
With DPV1 errors, the DP master passes on STATUS[4] to the CPU and the instruction. 
Without DPV1 error, this value is set to 0, with the following exceptions for "RDREC":

● STATUS[4]  contains the target range length from RECORD, if MLEN  > the target range 
length from RECORD

● STATUS[4]=MLEN, if the actual data record length  < MLEN < the target range length from 
RECORD

● STATUS[4]=0, if STATUS[4]> 255 would have to be set

In PROFINET IO, STATUS[4] has the value "0".

Parameter TINFO

Data structure of the destination area TINFO
The data structure of the destination area TINFO contains the start information of the 
organization block in which "RALRM" is currently being called.

The TINFO destination area can contain the start information with standard access or 
optimized access. The format of the start information in the TINFO destination area must 
always match the start information of the corresponding organization block.

● The start information of an OB with standard access is always stored in the first 20 bytes 
of the "Temp" section in the block interface. Use the "TI_Classic" data structure for this.

● The start information of an OB with optimized access is always written to the "Input" section. 
Use a data structure for the specific OB type for these OBs.

Changing the block access (standard/optimized) also changes the block interface.

The following table provides an overview of the data structures that are used depending on 
the organization block at the TINFO parameter.

Name of the data structure S7-1200 
CPUs as 
of version

S7-1500 
CPUs as 
of version

Data structure used for:

Data structure for organization blocks with standard access
 TI_Classic - V1 Organization blocks without optimized block access.
Data structure for organization blocks with optimized block access
 TI_ProgramCycle V2 V1 Cycle OB (program cycle)

TI_Startup V2 V1 Startup OB (startup)
TI_Delay V2 V1 Time delay interrupt
TI_Cyclic V2 V1 Cyclic interrupt OB
TI_HWInterrupt V2 V1 Hardware interrupt OB
TI_TimeError V2 V1 Time error OB
TI_DiagnosticInterrupt V2 V1 Diagnostic error interrupt OB
TI_PlugPullModule V2 V1 Pull/plug of modules OB
TI_StationFailure V2 V1 Rack or station failure OB
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Name of the data structure S7-1200 
CPUs as 
of version

S7-1500 
CPUs as 
of version

Data structure used for:

TI_ProgIOAccessError V2
 

V1
 

● Programming error OB
● I/O access error OB

TI_TimeOfDay V2 V1 Time-of-day interrupt OB
TI_SynchCycle - V1 Synchronous cycle interrupt OB
TI_Submodule V2 V1 ● Status interrupt OB

● Update interrupt OB
● OB for manufacturer or profile-specific interrupt

Data structure for organization blocks with standard access
The following shows the  TI_Classic data structure:

Parameter Data type Byte Description
TI_Classic Data structure for organization blocks with optimized block access.
 Bytes 0 to 19:  Start information of the OB in which "RALRM" is currently being called.*

EV_CLASS BYTE 0 Event class
Example OB1:
● Bits 0-3: ID of the event (1 = incoming event)
● Bits 4-7: Event class (1 = Event class 1)

EV_NUM BYTE 1 Event number (depending on OB type)
Example OB1 (SCAN_1):
● SCAN_1 = 1 for first call
● SCAN_1 = 3 for all additional calls

PRIORITY BYTE 2 Priority class
NUM BYTE 3 OB number
TYP2_3 BYTE 4 Additional information 

Different information is stored in the BYTES "TYP2_3" and "TYPE 1" depending on 
the OB type used.
What these are is described in the documentation for the organization blocks.
Example (OB1):
● TYP2_3: OB1_RESERVED_1 (reserved)
● TYP1: OB1_RESERVED_2 (reserved)

TYP1 BYTE 5

ZI1 WORD 6 to 7 Additional information 
Different information is stored in "ZI1" depending on the OB type used.
What these are is described in the documentation for the organization blocks.
Example (OB1):
● ZI1: OB1_PREV_CYCLE (runtime of previous cycle in ms)
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Parameter Data type Byte Description
ZI2_3 DWORD 8 to 11 Additional information

Different information is stored in "ZI2_3" depending on the OB type used.
What these are is described in the documentation for the organization blocks.
Example (OB1):
● ZI2: OB1_MIN_CYCLE (minimum cycle time (ms) since the last startup)
● ZI3: OB1_MAX_CYCLE (maximum cycle time (ms) since the last startup)

OB_DATE_
TIME

DATE_AN
D_TIME 
(DT)

12 to 19 Date and time-of-day when the OB was called.

Bytes 20 and 21: Address information
address WORD 20 and 

21
Address information like S7-300/400 CPUs:
● In a central configuration, the rack number (0-31):

● For a distributed configuration with PROFIBUS DP: 
– DP master system ID (1-31)
– Station number (0-127).

● In a distributed configuration with PROFINET IO:
– The last two positions in the PROFINET IO system ID (0-15). To obtain the 

complete PROFINET IO system ID, you must add 100 (decimal) to it.
– Station number (0-2047).

Bytes 22 to 31:  Management information
slv_prfl BYTE 22 Slave profile like S7-300/400 CPUs:

● In a central configuration: 0 (data record 0 or data record 1)
● In a distributed configuration:

– Bit 0 to 3: Slave 
type
- 0000: DP (structure data record 0)
- 0001: DPS7 (structure data record 0 or data record 1)
- 0010:  DPS7 V1 (structure data record 0 or data record 1)
- 0011: DPV1 (structure according to PROFIBUS DP standard)
- 0100 – 0111: Reserved
- 1000: PROFINET IO (structure according to PROFINET IO standard)
- from 1001: Reserved

– Bit 4 to 7: Profile type (reserved)
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Parameter Data type Byte Description
intr_type BYTE 23 Interrupt info type like S7-300/400 CPUs:

● In a central configuration: 0
● In a distributed configuration: 

– Bit 0 to 3: Interrupt info type
- 0000: Interrupt comes from a configured remote module
- 0001: Interrupt comes from a non-DPV1 slav / non IO device or a slot that 
is not configured
- 0010: Interrupt generated in the CPU
- from 0011: Reserved

– Bit 4 to 7: Structure version
- 0000: Initial
- from 0001: Reserved

flags1 BYTE 24 Flags of the PROFIBUS DP master interface module / PROFINET IO controller 
interface module like S7-300/400 CPUs:
● In a central configuration: 0
● In a distributed configuration: 

– Bit 0 = 0: Interrupt originating from an integrated interface
 module (PROFINET IO or PROFIBUS DP)

– Bit 0 = 1: Interrupt originating from an external interface module 
(PROFINET IO or PROFIBUS DP)

– Bit 1 to 7: Reserved
flags2 BYTE 25 Flags of the PROFIBUS DP master interface module / PROFINET IO controller 

interface module like S7-300/400 CPUs:
● In a central configuration: 0
● For a distributed configuration with PROFIBUS DP: 

– Bit 0: EXT_DIAG_FLAG from the diagnostics message frame, or 0 if this bit 
does not exist in the interrupt The bit is 1 if the DP slave is faulty.

– Bit 1 to 7: Reserved
● In a distributed configuration with PROFINET IO:

– Bit 0: ARDiagnosisState or 0 if there is no information in the interrupt. The 
bit is 1 if the IO device is faulty.

– Bit 1 to 7: Reserved
id UINT 26 and 

27
Management information
● In a central configuration: 0
● For a distributed configuration with PROFIBUS DP: PROFIBUS ID number as 

unique identifier of the PROFIBUS DP slave
● In a distributed configuration with PROFINET IO: PROFINET IO device ID 

number as unique identifier of the PROFINET IO device
manufacture
r

UINT 28 and 
29

Manufacturer ID (only in a distributed configuration with PROFINET IO).

instance UINT 30 and 
31

Ident number of the instance (only in a distributed configuration with PROFINET 
IO).

*The start information depends on the OB used. You can find the start information of each OB type at the interface or in the 
documentation of the OB.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2337



Data structures for organization blocks with optimized block access
The data structures for organization blocks with optimized block access have the following 
format:

● Bytes 0 to 3:  Format of the start information, class and number of the called OB (same 
structure for all data structures).

● Bytes 4 to 19:  Optimized start information (structure depends on the OB type). The data 
in bytes 4 to 19 correspond to the structure and content of the corresponding OB interface.

● Bytes 20 to 31:  In addition, the address and management information for certain OBs. The 
data in bytes 20 to 31 correspond to the data of 20 to 31 bytes of the  TI_Classic data 
structure.

The format of the data structures is described in the following tables.

Table 9-41 Cycle OB: Data structure TI_ProgramCycle

Parameter Data type Byte Description
TI_ProgramCycle Data structure for cycle OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=1)
OB_Nr UINT 2 OB number (1...32767).
Initial_Call BOOL 4 = TRUE in the first call of this OB:

● Transition from STOP or HOLD to RUN
● After reloading

Remanence BOOL 5 = TRUE, if retentive data are available.

Table 9-42 Startup OB: Data structure TI_Startup

Parameter Data type Byte Description
TI_Startup Data structure for startup OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=100)
OB_Nr UINT 2 OB number (1...32767).
LostRetentive BOOL 4 =TRUE, if the contents of retentive data areas have been lost.
LostRTC BOOL 5 =TRUE, if the time-of-day of the real-time clock has been lost.

Table 9-43 Time delay interrupt OB: Data structurer TI_Delay

Parameter Data type Byte Description
TI_Delay Data structure for time delay interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 
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Parameter Data type Byte Description
OB_Class USINT 1 OB class (=20)
OB_Nr UINT 2 OB number (1...32767).
Sign WORD 4 User ID: Input parameter SIGN from the call of the "SRT_DINT (Page 2453)" 

instruction.

Table 9-44 Cyclic interrupt OB: Data structure TI_Cyclic

Parameter Data type Byte Description
TI_Cyclic Data structure for cyclic interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=30)
OB_Nr UINT 2 OB number (1...32767).
Initial_Call BOOL 4 = TRUE in the first call of this OB

● At the transition from STOP or HOLD to RUN
● After reloading

Event_Count INT 6 Number of discarded start events since the last start of this OB.

Table 9-45 Hardware interrupt OB: Data structure TI_HWInterrupt

Parameter Data type Byte Description
TI_HWInterrupt Data structure for hardware interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=40)
OB_Nr UINT 2 OB number (1...32767).
LADDR HW_IO 4 Hardware identifier of the module that triggers the hardware interrupt.
USI WORD 6 Identifier for future extensions (not user-relevant).
IChannel USINT 8 Number of the channel that triggered the hardware interrupt.
EventType BYTE 9 Identifier for the event type associated with the event triggering the interrupt (e.g., 

rising edge).
You can find this ID in the description of the respective module.

address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UNIT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UNIT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UNIT 30 See "instance" parameter for the TI_Cassic data structure.
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Table 9-46 Time error OB: Data structure TI_TimeError

Parameter Data type Byte Description
TI_TimeError Data structure for time error OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=80)
OB_Nr UINT 2 OB number (1...32767).
Csg_OBnr OB_ANY 4 Number of the OB that was being executed when the time error occurred.
Fault_ID BYTE 7 Error code. Possible values:

● B#16#01: Cycle time exceeded
● B#16#02: The requested OB is still being processed.
● B#16#05: Expired time-of-day interrupt due to time jump.
● B#16#06: Expired time-of-day interrupt upon re-entry into RUN after HOLD.
● B#16#07: Overflow of the OB request buffer for the current priority class.
● B#16#08: Isochronous mode interrupt - time error.
● B#16#09: Interrupt loss due to high interrupt load
● B#16#0B: Technology synchronization interrupt - time error

Csg_Prio UNIT 8 Priority of the OB that was being executed when the time error occurred.

Table 9-47 Diagnostic interrupt OB: Data structure TI_DiagnosticInterrupt

Parameter Data type Byte Description
TI_DiagnosticInterrupt Data structure for diagnostic interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=82)
OB_Nr UINT 2 OB number (1...32767).
LADDR HW_ANY 4 Hardware identifier of the hardware object that triggered the diagnostic interrupt.
IO_State WORD 6 Status of the hardware object:

● Bit 0: Good
● Bit 1: Disabled
● Bit 2: Maintenance required
● Bit 3: Maintenance demanded
● Bit 4: Error
● Bit 5: Not accessible
● Bit 6: Qualified
● Bit 7: Not available

Channel UINT 8 Channel number
MultiError BOOL 10 =TRUE, if there is more than one error.
address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
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Parameter Data type Byte Description
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UINT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UINT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UINT 30 See "instance" parameter for the TI_Cassic data structure.

Table 9-48 Pull/plug interrupt OB: Data structure TI_PlugPullModule

Parameter Data type Byte Description
TI_PlugPullModule Data structure for pull/plug interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=83)
OB_Nr UINT 2 OB number (1...32767).
LADDR HW_IO 4 Hardware identifier of the affected module or submodule
Event_Class BYTE 6 ● B#16#38: (Sub)module plugged

● B#16#39: (Sub)module pulled or not responding
Fault_ID BYTE 7 Error code

The following table shows the events that cause the start of the pull/plug interrupt 
OB.
● With Event_Class = B#16#38 - (sub-)module plugged:

– B#16#54: PROFINET IO submodule inserted and matches configured 
submodule

– B#16#55: PROFINET IO submodule inserted, but does not match configured 
submodule

– B#16#56: PROFINET IO submodule inserted; but error in module parameter 
assignment

– B#16#57: PROFINET IO submodule or module inserted, but with a problem 
or maintenance

– B#16#58: PROFINET IO submodule, access error corrected
● With Event_Class = B#16#39 - (sub-)module pulled or cannot be reached:

– B#16#51: PROFINET IO module removed
– B#16#54: PROFINET IO submodule removed

address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UINT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UINT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UINT 30 See "instance" parameter for the TI_Cassic data structure.
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Table 9-49 Rack error OB: Data structure TI_StationFailure

Parameter Data type Byte Description
TI_StationFailure Data structure for rack error OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=86)
OB_Nr UINT 2 OB number (1...32767).
LADDR HW_Devi

ce
4 Hardware identifier of the defective hardware object.

Event_Class BYTE 6 ● B#16#38: (Sub)module plugged
● B#16#39: (Sub)module pulled or not responding

Fault_ID BYTE 7 Error code
The following table shows the events that cause the start of the pull/plug interrupt 
OB.
● With Event_Class = B#16#38 - (sub-)module plugged:

– B#16#54: PROFINET IO submodule inserted and matches configured 
submodule

– B#16#55: PROFINET IO submodule inserted, but does not match configured 
submodule

– B#16#56: PROFINET IO submodule inserted; but error in module parameter 
assignment

– B#16#57: PROFINET IO submodule or module inserted, but with a problem 
or maintenance

– B#16#58: PROFINET IO submodule, access error corrected
● With Event_Class = B#16#39 - (sub-)module pulled or cannot be reached:

– B#16#51: PROFINET IO module removed
– B#16#54: PROFINET IO submodule removed

address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UINT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UINT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UINT 30 See "instance" parameter for the TI_Cassic data structure.

Table 9-50 Programming error OB / I/O access error OB: Data structure TI_ProgIOAccessError

Parameter Data type Byte Description*
TI_ProgIOAccessError Data structure for programming error OB and I/O access error OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 
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Parameter Data type Byte Description*
OB_Class USINT 1 OB class:

● =121 for programming error OB 
● =122 for I/O access error OB

OB_Nr UINT 2 OB number (1...32767).
BlockNr UINT 4 Number of the block in which the programming error occurred.
Reaction USINT 6 ● 0: Ignore error

● 1: Substitute bad value
● 2: Skip command

Fault_ID BYTE 7 Error code
● B#16#21: BCD conversion error
● B#16#22: Area length error when reading
● B#16#23: Area length error when writing
● B#16#24: Range error when reading
● B#16#25: Range error when writing
● B#16#26: Error in timer no.
● B#16#27: Error in counter no.
● B#16#28: Read access to a byte, word or double word with a pointer whose bit 

address is not zero
● B#16#29: Write access to a byte, word or double word with a pointer whose bit 

address is not zero
● B#16#:30: Write access to a write-protected global DB
● B#16#31: Write access to a write-protected instance DB
● B#16#32: DB number error when accessing a global DB
● B#16#33: DB number error when accessing an instance DB
● B#16#34: Number error during FC call
● B#16#35: Number error during FB call
● B#16#42: I/O access error, reading
● B#16#43: I/O access error, writing
● B#16#3A: Access to a DB that is not loaded; the DB number is located in the 

permitted area
● B#16#3C: Access to an FC that is not loaded; the FC number is within the 

permissible range
● B#16#3D: Access to an instruction (SFC) that is not loaded; the SFC number is 

within the permissible range
● B#16#3E: Access to an FB that is not loaded; the FB number is within the 

permissible range
● B#16#3F: Access to an SFB that is not available; the SFB number is within the 

permissible range
BlockType USINT 8 Type of block in which the error has occurred:

● OB: B#16#88
● FC: B#16#8C
● FB: B#16#8E
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Parameter Data type Byte Description*
Area USINT 9 Memory area in which the incorrect access occurred:

● Local data: B#16#40 to 4E, 86, 87, 8E, 8F, C0 to CE
● Process image input: B#16#01
● Process image output: B#16#02
● Technology DB: B#16#04
● I: B#16#81
● Q: B#16#82
● M: B#16#83
● DB: B#16#84, 85, 8A, 8B

DBNr DB_ANY 10 DB no. if AREA = DB (global DB or instance DB)
Only relevant for programming error OB.

Csg_OBNr OB_ANY 12 OB number:
● 121: Programming error OB
● 122: I/O access error OB

Csg_Prio USINT 14 OB priority 
Width USINT 15 Type of access during which the error occurred:

● Bit: B#16#00
● Byte: B#16#01
● Word: B#16#02
● DWord: B#16#03
● LWord: B#16#04

* Only certain output values are possible depending on the OB (I/O access error OB or programming error OB) from which 
information is read.

Table 9-51 Time-of-day interrupt OB: Data structure TI_TimeOfDay

Parameter Data type Byte Description
TI_TimeOfDay Data structure for time-of-day interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=10)
OB_Nr UINT 2 OB number (1...32767).
CaughtUp BOOL 4 =TRUE if an OB call was executed subsequently because time was adjusted ahead
SecondTime BOOL 5 =TRUE if an OB was called a second time because time was adjusted back. Note: 

SecondTime is set only once in situations in which the time is set back.

Table 9-52 Isochronous mode interrupt OB: Data structure TI_SynchCycle

Parameter Data type Byte Description
TI_SynchCycle Data structure for isochronous mode interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 
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Parameter Data type Byte Description
OB_Class USINT 1 OB class (=61)
OB_Nr UINT 2 OB number (1...32767).
Initial_Call BOOL 4 = TRUE in the first call of this OB:

● Transition from STOP or HOLD to RUN
● After reloading

IO _System USINT 5 Number of the distributed I/O system triggering the interrupt
Event_Count INT 6 ● = n: Number of lost cycles

● = -1: An unknown number of cycles has been lost (e.g., because cycle has 
changed).

PIP_Input BOOL 10 =TRUE: The associated process image of the inputs is up-to-date
PIP_Output BOOL 11 =TRUE: The associated process image of the outputs was transferred to the outputs 

in good time after the last cycle
SyncCycleTim
e

LTIME 16 Calculated cycle time

Table 9-53 Status interrupt OB / update interrupt OB for manufacturer or profile-specific interrupt: Data structure 
TI_Submodule

Parameter Data type Byte Description
TI_Submodule Data structure for status interrupt OB / update interrupt OB for manufacturer or 

profile-specific interrupt
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class
● =55 for status interrupt OB
● =56 for update interrupt OB
● =57 for manufacturer or profile-specific interrupt OB

OB_Nr UINT 2 OB number (1...32767).
LADDR HW_IO 4 Hardware address of the component triggering the interrupt
Slot UINT 6 Slot number of the component triggering the interrupt
Specifier WORD 8 Interrupt specifier from the interrupt frame
address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UINT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UINT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UINT 30 See "instance" parameter for the TI_Cassic data structure.
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Parameter AINFO

Data structure of the destination area AINFO with interrupts from PROFIBUS DP

Byte Meaning
0 to 3 Header information, for exact description, see below
4 to 63 Additional interrupt information: data for the respective interrupt:

distributed: ARRAY[0] to ARRAY[59]

 

Structure of the header information with interrupts from PROFIBUS DP

Byte Data type Meaning
0 BYTE Length of the received interrupt information in bytes

central:
distributed:

4 to 224
4 to 63

1 BYTE central: Reserved
distributed: ID for the interrupt type

1:
2:
3:
4:
5:
6:
31

Diagnostics interrupt

Process interrupt

Pull interrupt
Plug interrupt

Status interrupt

Update interrupt

Failure of an expansion device, DP master system or DP 
station

32 to 126: Manufacturer-specific interrupt
2 BYTE Slot number of the component that triggered the interrupt
3 BYTE central: Reserved

distributed: Specifier
Bits 0 and 1: 0: No further information;

1: Incoming event, fault at slot

2: Outgoing event, fault at slot cleared

3: Outgoing event, slot still faulty
Bit 2: Add_Ack
Bits 3 to 7: Sequence number
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Data structure of the destination area AINFO with interrupts from PROFINET IO or central I/O devices

Byte Meaning
0 to 25 Header information, for exact description, see below
26 to 1431 Additional interrupt information: Standardized diagnostic data for the respective interrupt: 

ARRAY[0] to ARRAY[1405]
Note: The additional interrupt information may also be omitted.

 

Structure of the header information with interrupts from PROFINET IO or central I/O devices

Byte Data type Meaning
0 and 1 WORD ● Bits 0 to 7: Block type

● Bits 8 to 15: Reserved
2 and 3 WORD Block length
4 and 5 WORD Version:

● Bits 0 to 7: low byte
● Bits 8 to 15: high byte

6 and 7 WORD ID for interrupt type:
● 1: Diagnostics interrupt (incoming)
● 2: Process interrupt
● 3: Remove module interrupt
● 4: Insert module interrupt
● 5: Status interrupt
● 6: Update interrupt
● 7: Redundancy interrupt
● 8: Controlled by supervisor
● 9: Released by supervisor
● 10: Configured module not inserted
● 11: Return of the sub-module
● 12: Diagnostics interrupt (outgoing)
● 13: Slave-to-slave connection alarm
● 14: Neighborhood change alarm
● 15: Clock synchronization message (bus end)
● 16: Clock synchronization alarm (device end)
● 17: Network component alarm
● 18: Time synchronization alarm (bus end)
● 19 to 31: Reserved
● 32 to 127: Manufacturer-specific interrupt
● 128 to 65535: Reserved

8 to 11 DWORD API (Application Process Identifier)
12 to 13 WORD Slot number of the component triggering the interrupt (value range 0 to 65535)
14 to 15 WORD Submodule slot number of the component triggering the interrupt (value range 0 to 

65535)
16 to 19 DWORD Module identification; specific information on the source of the interrupt
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Byte Data type Meaning
20 to 23 DWORD Submodule identification; specific information on the source of the interrupt
24 to 25 WORD Interrupt specifier:

● Bits 0 to 10: Sequence number (value range 0 to 2047)
● Bit 11: Channel diagnostics:

0: No channel diagnostics available
1: Channel diagnostic information exists

● Bit 12: Status of manufacturer-specific diagnostics:
0: No manufacturer-specific status information available
1: Manufacturer-specific status information available

● Bit 13: Status of diagnostics for sub-module:
0: No status information available, all errors have been corrected
1: At least one item of channel diagnostics and/or status information is available

● Bit 14: Reserved
● Bit 15: Application relationship diagnosis state:

– 0: None of the modules configured within this application relationship reports 
diagnostic information

– 1: At least one of the modules configured in this AR is reporting diagnostic 
information

 

Structure of the additional interrupt information for interrupts from PROFINET IO or central I/O

The additional interrupt information for PROFINET IO depends on the format identifier. It can 
comprise multiple data blocks with the same or different format identifier. The following format 
identifiers are available:
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● W#16#0000 to W#16#7FFF: Manufacturer-specific diagnostics

Byte Data type Meaning
0 to 1 WORD Format identifier for the structure of the following data serving as 

additional interrupt information
W#16#0000 to W#16#7FFF: Manufacturer-specific diagnostics

2 to n BYTE See manufacturer's manual.

● W#16#8000: Channel diagnostics
Channel diagnostics is output in blocks of 6 bytes each. The additional interrupt information 
(without format identifier) is only output for disrupted channels.

Byte Data type Meaning
0 to 1 WORD Format identifier for the structure of the following data serving as 

additional interrupt information
W#16#8000: Channel diagnostics

2 to 3 WORD Channel number of the component triggering the interrupt (value range: 
0 to 65535):
● W#16#0000 to W#16#7FFF: Channel number of the interface module/

sub-module
● W#16#8000: The generic substitute for the entire sub-module
● W#16#8001 to W#16#FFFF: Reserved

4 BYTE Bits 0 to 2: Reserved
Bits 3 to 4: Type of error:

● 0: Reserved
● 1: Incoming error
● 2: Outgoing error
● 3: Outgoing error, other errors present

Bits 5 to 7: Type of channel:
● 0: Reserved
● 1: Input channel
● 2: Output channel
● 3: Input/output channel
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Byte Data type Meaning
5 BYTE Data format:

● B#16#00: Free data format
● B#16#01: Bit
● B#16#02: 2 bits
● B#16#03: 4 bits
● B#16#04: Byte
● B#16#05: Word
● B#16#06: Double word
● B#16#07: 2 double words
● B#16#08 to B#16#FF: Reserved

6 to 7 WORD Type of error:
● W#16#0000: Reserved
● W#16#0001: Short circuit
● W#16#0002: Undervoltage
● W#16#0003: Overvoltage
● W#16#0004: Overload
● W#16#0005: Overtemperature
● W#16#0006: Wire break
● W#16#0007: High limit exceeded
● W#16#0008: Low limit exceeded
● W#16#0009: Error
● W#16#000A to W#16#000F: Reserved
● W#16#0010 to W#16#001F: Manufacturer-specific
● W#16#0020 to W#16#00FF: Reserved
● W#16#0100 to w#16#7FFF: Manufacturer-specific
● W#16#8000: Device diagnostics available
● W#16#8001 to W#16#FFFF: Reserved
Not all channels support every error type. For detailed information, refer 
to the description of the diagnostic data for the specific device.

 

  Note

The section from "channel number" to "type of error" can occur from 0 to n times.
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● W#16#8001: MULTIPLE (different types of diagnostic information are transmitted). In this 
case, the additional interrupt information is transmitted as blocks of variable length.

Byte Data type Meaning
0 to 1 WORD Format identifier for the structure of the following data serving as additional 

interrupt information
W#16#8001: Manufacturer-specific diagnostics and/or channel diagnostics

2 to 3 WORD Block type
4 to 5 WORD Block length
6 BYTE Version: high byte
7 BYTE Version: low byte
8 to 11 DWORD API (only if low byte of version = 1)
12 to 13 WORD Slot number
14 to 15 WORD Subslot number
16 to 17 WORD Channel number
18 to 19 WORD Channel properties
20 to 21 WORD Format identifier:

● W#16#0000 to W#16#7FFF: Manufacturer-specific diagnostics
● W#16#8000: Channel diagnostics
● W#16#8002: Extended channel diagnostics
● W#16#8003: Stepped extended channel diagnostics
● W#16#8004  to W#16#80FF: Reserved

22 to n BYTE Data depend on the format identifier
 

  Note

The section starting from "block type" can occur from 1 to n times.
 

● W#16#8002: Extended channel diagnostics

Byte Meaning
0 to 1 Format identifier W#16#8002
2 to 3 Channel number
4 to 5 Channel properties
6 to 7 Error type
8 to 9 Additional error value
10 to 13 Additional error information
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● W#16#8003: Stepped extended channel diagnostics

Byte Meaning
0 to 1 Format identifier W#16#8003
2 to 3 Channel number
4 to 5 Channel properties
6 to 7 Error type
8 to 9 Additional error value
10 to 13 Additional error information
14 to 17 Qualified channel qualifier

● W#16#8100: Maintenance information

Byte Meaning
0 to 1 Format identifier W#16#8100
2 to 3 Block type
4 to 5 Block length
6 to 7 Block version
8 to 9 Reserved
10 to 13 Maintenance status

 

  Note

You can find more detailed information about the structure of the additional alarm 
information in the Programming Manual SIMATIC PROFINET IO from PROFIBUS DP to 
PROFINET IO and the current version of IEC 61158-6-10-1.

 

Destination area TINFO and AINFO

Destination area TINFO  and AINFO
Depending on the respective OB in which "RALRM (Page 2328)" is called, the destination 
areas TINFO and AINFO are only partially written. Refer to the table below to find out which 
information is entered respectively.

Interrupt type OB 
class

TINFO
OB start 
information

TINFO
Management 
information

AINFO
Header 
information

AINFO
Additional interrupt information

Process interrupt 4x Yes Yes Yes central: No
distributed: as supplied by 

PROFIBUS DP slave/
PROFINET IO device

Status interrupt 55 Yes Yes Yes Yes Yes
Update interrupt 56 Yes Yes Yes Yes Yes
Manufacturer-specific 
interrupt

57 Yes Yes Yes Yes Yes
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Interrupt type OB 
class

TINFO
OB start 
information

TINFO
Management 
information

AINFO
Header 
information

AINFO
Additional interrupt information

I/O
redundancy error

70 Yes Yes No No No

Diagnostics interrupt 82 Yes Yes Yes central: Data record 1
distributed: as supplied by 

PROFIBUS DP slave/
PROFINET IO device

Insert/remove 
interrupt

83 Yes Yes Yes central: No
distributed: as supplied by 

PROFIBUS DP slave/
PROFINET IO device

Special form of the 
remove module 
interrupt:
Controlled by 
supervisor

83 Yes Yes Yes PROFINET IO only

Special form of the 
insert module interrupt:
Enabled by supervisor

83 Yes Yes Yes PROFINET IO only

Unconfigured module 
inserted

83 Yes Yes Yes PROFINET IO only

Rack failure/
station failure

86 Yes Yes No No

... all other OBs Yes No No No

D_ACT_DP: Enable/disable DP slaves

Description
Use the "D_ACT_DP" instruction to specifically deactivate and reactivate configured DP slaves/
PROFINET IO devices. In addition, you can determine whether each assigned DP slave or 
PROFINET IO device is currently activated or deactivated.

If you use the instruction to deactivate an IE/PB Link PN IO type of gateway, then all connected 
PROFIBUS DP slaves will also cease to function. These failures will be reported.

The instruction cannot be used on PROFIBUS PA field devices that are connected by a DP/
PA link to a DP master system.

 

 Note

As long as one or more "D_ACT_DP" jobs are active, you cannot load a changed configuration 
from the programming device to the CPU (within the scope of CiR).
If a changed configuration is being loaded from the programming device to the CPU during 
ongoing operation (CiR), the CPU will reject activation of a "D_ACT_DP" job.

Several runs through the cycle control point are required to perform the disabling or enabling 
job. Therefore, you cannot wait for the end of such a job in a programmed loop.
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Functional description
"D_ACT_DP" works asynchronously, that is, its execution extends over multiple calls. You start 
the job by calling D_ACT_DP with REQ = 1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

Application
If you configure DP slaves/PROFINET IO devices in a CPU which are not actually present or 
not currently required, the CPU will nevertheless continue to access these DP slaves/
PROFINET IO devices at regular intervals. After the slaves are deactivated, further CPU 
accessing will stop. With PROFIBUS DP, the fastest possible DP bus cycle can be achieved 
in this manner and the corresponding error events no longer occur.

Examples
From a machine OEM's point of view, there are numerous device options possible in series 
production of machines. However, each delivered machine includes only one combination of 
selected options.

Every one of these possible machine options is configured as a DP slave/PROFINET IO device 
by the manufacturer in order to create and maintain a common user program having all possible 
options. Use "D_ACT_DP" to deactivate all DP slaves/PROFINET IO devices not present at 
machine startup.

A similar situation exists for machine tools having numerous tooling options available but 
actually using only a few of them at any given time. These tools are implemented as DP slaves/
PROFINET IO devices. With "D_ACT_DP", the user program activates the tools currently 
needed and deactivates those required later.

Identification of a job
If you have started a deactivation or activation job and you call "D_ACT_DP" again before the 
job is complete, the behavior of the instruction depends on whether or not the new call involves 
the same job. If the input parameter LADDR  matches, then the call will be interpreted as a 
follow-on call.

Deactivating DP slaves/PROFINET IO devices
When you deactivate a DP slave/PROFINET IO device with "D_ACT_DP", its process outputs 
are set to the configured substitute values or to 0 (safe state). The assigned DP master/
PROFINET IO controller does not continue to address this component. Deactivated DP slaves/
PROFINET IO devices are not identified as faulty or missing by the error LEDs on the DP 
master/PROFINET IO controller or CPU.

The process image of the inputs of deactivated DP slaves/PROFINET IO devices is updated 
with 0, that is, it is handled just as it is for failed DP slaves/PROFINET IO devices.

If you are using your program to directly access the user data of a previously deactivated DP 
slave/PROFINET IO device, the I/O access error OB is called and the corresponding start 
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event is entered in the diagnostic buffer. If you attempt to access a deactivated DP slave/
PROFINET IO device via an instruction (such as "RD_REC (Page 2358)"), you will receive the 
same error information in RET_VAL  as for an unavailable DP slave/PROFINET IO device.

Deactivating a DP slave/PROFINET IO device does not start the program error OB, even if its 
inputs or outputs belong to the system-side process image to be updated. Also there is no 
entry in the diagnostic buffer.

If a DP station/PNIO station fails after you have deactivated it with "D_ACT_DP", the operating 
system does not detect the failure.

Applies to PROFIBUS DP: If you wish to deactivate DP slaves functioning as transmitters in 
slave-to-slave communication, we recommend that you first deactivate the receivers (listeners) 
that detect which input data the transmitter is transferring to its DP master. Deactivate the 
transmitter only after you have performed this step.

Activating DP slaves/PROFINET IO devices
When you reactivate a DP slave/PROFINET IO device with "D_ACT_DP", this component is 
configured and assigned parameters by the associated DP master/PROFINET IO controller 
(as with the return of a failed DP station/PROFINET IO station). This activation is complete 
when the component is able to transfer user data.

Activating a DP slave/PROFINET IO device does not start the program error OB, even if its 
inputs or outputs belong to the system-side process image to be updated. Also there is no 
entry in the diagnostic buffer.

If you try to activate a DP slave/PROFINET IO device with "D_ACT_DP" that cannot be 
accessed (for example, because it was physically separated from the bus), the instruction 
returns the error code W#16#80A7 after expiration of the configured parameter assignment 
time for distributed I/O. The DP slave/PROFINET IO device is activated and the fact that the 
activated DP slave/PROFINET IO device cannot be accessed results in a corresponding 
display in the system diagnostics.

If the DP slave/PROFINET IO device is accessible again afterwards, this results in standard 
system behavior (for example, a call of the OB configured for this purpose).

 

 Note

Activating a DP slave/PROFINET IO device may be time-consuming. If you wish to cancel a 
current activation job, start "D_ACT_DP" again with the same value for LADDR  and 
MODE = 2. Repeat the call of "D_ACT_DP" with MODE = 2 until successful cancellation of 
the activation job is indicated by RET_VAL  = 0.

 

If you wish to activate DP slaves which take part in the slave-to-slave communication, we 
recommend that you first activate the transmitters and then the receivers (listeners).
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Parameters
The following table shows the parameters of the "D_ACT_DP" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Level-triggered control parameter 

REQ=1: Execute activation or deactivation
MODE Input USINT I, Q, M, D, L or 

constant
Job identifier
Possible values:
● 0: Request information on whether the 

addressed component is activated or 
deactivated (output via RET_VAL 
parameter)

● 1: Activate the DP slave/PROFINET IO 
device

● 2: Deactivate the DP slave/PROFINET IO 
device

LADDR Input HW_DEVICE I, Q, M, D, L or 
constant

Hardware identifier of the DP slave 
(HW_DPSlave)/PROFINET IO device 
(HW_Device)
The number can be taken from the properties 
of the DP slave / PROFINET IO device in the 
Network view or from the "System constants" 
tab of the standard tag table.

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

BUSY Output BOOL I, Q, M, D, L Active code:
● BUSY = 1: The job is still active.
● BUSY = 0: The job was terminated.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 Job completed without error.
0001 The DP slave/PROFINET IO device is active (this error code is possible only with MODE = 0.)
0002 The DP slave/PROFINET IO device is deactivated (this error code is possible only with MODE = 0.)
7000 First call with REQ=0. The job specified with LADDR is not active; BUSY has the value "0".
7001 First call with REQ=1. The job specified with LADDR was initiated. BUSY has the value "1".
7002 Intermediate call (REQ 

irrelevant). The activated job is still active; BUSY has the value "1".
8090 ● You have not configured a module with the address specified in LADDR.

● You operate your CPU as I-Slave and you have specified in LADDR an address of this I-Slave.
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Error code*
(W#16#...)

Explanation

8092 The deactivation of the currently addressed DP slave/PROFINET IO device (MODE=2) cannot be 
canceled by being activated (MODE=1). Activate the component at a later time.

8093 No DP slave / PROFINET IO device that can be activated or deactivated is assigned to the address 
specified in LADDR.

8094 You have attempted to activate a device which is potential partner for a tool change port. However, another 
device is already activated on this tool change port at this time. The activated device will remain activated.

80A0 Error during the communication between the CPU and the IO controller.
80A1 Parameters could not be assigned for the addressed component. (This error code is only available when 

MODE = 1.)
Note: "D_ACT_DP" returns this error information only if the activated slaves/devices of this component 
fails again during parameter assignment. If the parameter assignment of a single module was 
unsuccessful, "D_ACT_DP" returns the error information W#16#0000.

80A2 The addressed DP slave does not return an acknowledgment. (This error information is not available with 
PROFINET IO devices. The process is not time-monitored by PROFINET.)

80A3 The DP master/PROFINET IO controller concerned does not support this function.
80A4 The CPU does not support this function for external DP masters/PROFINET IO controller.
80A6 Slot error in the DP slave/PROFINET IO device; not all user data can be accessed (this error code is only 

available when MODE=1).
Note: "D_ACT_DP" returns this error information only if the activated component fails again after 
parameter assignment and before the end of "D_ACT_DP". If only a single module is unavailable, 
"D_ACT_DP" returns the error information W#16#0000.

80A7 Activation of a non-accessible device.
80AA Activation with errors in the DP slave/PROFINET IO device: Differences in the configuration
80AB Activation with errors in the DP slave/PROFINET IO device: Parameter assignment error
80AC Activation with errors in the DP slave/PROFINET IO device: Maintenance required
80C1 "D_ACT_DP" has been started and is being continued with another address (this error code is possible 

when MODE=1 and MODE=2).
80C3 ● Temporary resource error: The CPU is currently processing the maximum possible activation and 

deactivation jobs. (This error code is available only when MODE = 1 and MODE = 2.)
● The CPU is busy receiving a modified configuration. Currently you can not enable/disable DP slaves/

PROFINET IO devices.
80C5 DP: Jobs not collected by the user are discarded at restart.
80C6 PROFINET: Jobs not collected by the user are discarded at restart.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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Others

RD_REC: Read data record from I/O

Description       
Use the instruction to read the data record with the number RECNUM  from the addressed 
module. You start the read process by assigning the value "1" to the input parameter REQ  
during the call. If the read process could be executed immediately, the instruction returns the 
value "0" at the output parameter BUSY . If BUSY has the value "1", reading is not yet complete.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582). The data record read is entered in the target range spanned by the 
RECORD  parameter, providing the data transfer was free of errors.

 

 Note

When you read out a data record with a number greater than one from an FM or a CP you 
have purchased prior to February 1997 (below referred to as "old modules"), "RD_REC" 
responds differently than it does in new modules. This special situation is covered in the 
section "Using old S7-300 FMs and CPs with data record numbers >1" (see below).

If a DPV1 slave is configured via GSD file (GSD rev. 3 and higher) and the DP interface of 
the DP master is set to "S7 compatible", then you may not read any data records from the I/
O modules in the user program with "RD_REC". In this case, the DP master addresses the 
wrong slot (configured slot + 3).

Remedy: Set the interface of the DP master to "DPV1".
 

Parameters
The following table shows the parameters of the "RD_REC" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

LADDR Input HW_IO 
(WORD)

I, Q, M, D, L or 
constant

Hardware identifier of the module.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number (permitted values: 0 to 240)

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code. In addition: the length of the data record 
actually transferred in bytes (possible values: +1 
to +240), if the target range is greater than the 
transferred data record and if no error occurred 
during the transfer.
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Parameter Declaration Data type Memory area Description
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The reading process is not yet 

complete.
RECORD Output ANY I, Q, M, D, L Target range for the data record read. With 

asynchronous execution of "RD_REC", 
make sure that the actual parameters of 
RECORD  have the same length information 
for all calls. Only the BYTE  data type is permitted.
Note: Note that for S7-300 CPUs the parameter 
RECORD always requires the full specification 
of the DB parameters (for example, 
P#DB13.DBX0.0 byte 100). The omission of an 
explicit DB number is only permitted for S7-300 
CPUs and leads to an error message in the user 
program.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RECORD
 

 Note

If you want to ensure that the entire data record is always read, select a target range with a 
length of 241 bytes. If the data transfer is without error, RET_VAL  contains the actual data 
record length.

 

Using old S7-300 FMs and CPs with data record numbers > 1
If you want to use the instruction "RD_REC" to read out a data record with a number greater 
than one from an old S7-300 FM or old S7-300 CP, remember the following points:

● If the target range is greater than the actual length of the required data record, no data is 
entered in RECORD . RET_VAL is written with W#16#80B1.

● If the target range is smaller than the actual length of the required data record, the CPU 
reads as many bytes beginning at the start of the record as are specified in the length 
information of RECORD  and enters this number of bytes inRECORD . RET_VAL has the 
value "0".

● If the length specified in RECORD  is the same as the actual length of the required data 
record, the CPU reads the data record and enters it in RECORD . RET_VAL  is written with 
"0".
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Parameter RET_VAL
● If an error has occurred while the function was being executed, the return value contains 

an error code.

● If no error occurred during the transfer, RET_VAL contains the following:

– 0, if the entire target range was filled with data from the selected data record (the data 
record can also be incomplete).

– The length of the data record actually transferred in bytes (possible values: +1 to +240) 
if the target range is greater than the transferred data record.

 

  Note

If the general error W#16#8745 occurs, this only indicates that access to at least one 
byte of the process image was blocked. The data record was read by the module 
correctly and written to the I/O memory area.

 

When looking at the "real" error information (error codes W#16#8xyz) in the following table, 
we distinguish between two cases:

● Temporary errors (error codes W#16#80A2 to 80A3, 80Cx):
This type of error can possibly be eliminated without user action, meaning it is helpful to 
call the instruction again (multiple calls, if necessary).
Example of a temporary error: Resources required are currently in use (W#16#80C3).

● Permanent errors (error codes W#16#809x, 80A0, 80A1, 80Bx):
This type of error does not correct itself. A new call of the instruction will not be successful 
until you have eliminated the error. Example of a permanent error: Wrong length 
specification in RECORD (W#16#80B1).

 

  Note

If you transfer data records to a DPV1 slave with "WR_REC (Page 2362)" or if you read 
data records from a DPV1 slave with RD_REC and if this DPV1 slave operates in DPV1 
mode, the DP master evaluates the error information it received from the slave as follows: 

If the error information lies within the range from W#16#8000 to W#16#80FF or 
W#16#F000 to W#16#FFFF, the DP master passes the error information to the instruction. 
If the error information is outside this range, the DP master passes the value W#16#80A2 
to the instruction and suspends the slave.

For a description of the error information originating from DPV1 slaves, refer to STATUS[3] 
Parameter STATUS (Page 2330).

 

Parameter RET_VAL for WR_REC and RD_REC

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value 

0.
-

7001 First call with REQ=1: Data transfer started; BUSY  has the value 1. Distributed I/O
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Error code*
(W#16#...)

Explanation Restriction

7002 Intermediate call (REQ 
irrelevant): Data transfer already active; BUSY has the value 1.

Distributed I/O

8090 Specified logical base address invalid: There is no 
assignment in SDB1/SDB2x or there is no base address.

-

8092 A type other than BYTE is specified in the ANY reference. -
8093 This instruction is not permitted for the module selected by means of 

LADDR  and IOID . (permitted are S7-300 modules for an S7-300, 
S7-400 modules for an 
S7-400, S7-DP modules for an S7-300 and S7-400).

-

80A0 Negative acknowledgement when reading from the module: Module 
was removed during the reading process or is defective

With "RD_REC" only

80A1 Negative acknowledgement when writing to the module: Module was 
removed during the writing process or is 
defective

With "WR_REC (Page 2362)" only

80A2 ● DP protocol error at layer 2 (for example, slave failure or bus 
problems)

● For ET200S, data record cannot be read in DPV0 mode.

Distributed I/O

80A3 DP protocol error with user interface/user Distributed I/O
80A4 Communication on PBUS+ disrupted -
80B0 ● Instruction not possible for module type.

● The module does not recognize the data record.
● Data record number 241 not permitted.
● With "WR_REC (Page 2362)", data records 0 and 1 are not 

permitted.

-

80B1 The length specified in parameter RECORD is incorrect. ● With "WR_REC (Page 2362)": 
Length incorrect

● With "RD_REC" 
(only when using old 
S7-300 FMs and S7-300 
CPs): specified length > data 
record length

● With DPNRM_DG: specified 
length < data record length

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type does not match the specified module 
type in SDB1.

-

80B7 DP slave or module reports an invalid range for a parameter or value. With "RD_REC" only
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Error code*
(W#16#...)

Explanation Restriction

80C0 With "WR_REC (Page 2362)": the data can only be written when the 
CPU is in STOP mode. Note: this means that writing by the user 
program is not possible. You can only write the data online with PG/
PC.
With "RD_REC": the module routes the data record, but either no data 
is present or the data can only be read when the CPU is in STOP 
mode. Note: if data can only be read when the CPU is in STOP mode, 
then an evaluation by the user program is not possible. In this case, 
you can only read the data online with PG/PC.
With "DPNRM_DG (Page 2378)": There are no diagnostic data 
available.

With "WR_REC (Page 2362)" or 
"RD_REC" or "DPNRM_DG 
(Page 2378)"

80C1 The data of the previous write job on the module for the same data 
record have not yet been processed by the module.

-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

-

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available. Distributed I/O
80C6 Data record transfer stopped due to priority class abort (restart or 

background)
Distributed I/O

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

WR_REC: Write data record to I/O

Description       
Use the instruction "WR_REC" to transfer the data record RECORD to the addressed module. 

You start the writing process by assigning the value "1" to the input parameter REQ during the 
call. If the writing process could be executed immediately, the instruction returns the value "0" 
at the output parameter BUSY. If BUSY has the value "1", writing is not yet complete.

 

 Note

If a DPV1 slave is configured via GSD file (GSD rev. 3 and higher) and the DP interface of 
the DP master is set to "S7 compatible", then you may not write any data records from the I/
O modules to the user program with "WR_REC". In this case, the DP master addresses the 
wrong slot (configured slot + 3).

Remedy: set the interface of the DP master to "DPV1".
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Parameters
The following table shows the parameters of the instruction "WR_REC":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Write request

LADDR Input HW_IO 
(WORD)

I, Q, M, D, L or 
constant

Hardware identifier of the module.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number

RECORD Input ANY I, Q, M, D, L Data record. Only the BYTE data type is 
permitted.

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

BUSY Output BOOL I, Q, M, D, L BUSY = 1: The writing process is not yet 
completed.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RECORD
The data to be transferred are read from the RECORD parameter during the first call. If the 
transfer of the data record takes longer than the duration of one call, the contents of the 
RECORD parameter are no longer relevant for the subsequent instruction calls (for the same 
job).

Parameter RET_VAL
See also: RD_REC: Read data record from I/O (Page 2358) 

 

 Note

If the general error W#16#8544 occurs, it only indicates that access to at least one byte of 
the I/O memory area containing the data record was denied. The data transfer was continued.

 

DPRD_DAT: Read consistent data of a DP standard slave

Description
You use the "DPRD_DAT" instruction to read out consistent data of a DP standard slave/
PROFINET IO device. 

You require "DPRD_DAT" because you can only read out a maximum of four continuous bytes 
using the load commands that access the I/O or the process image input table. If required, you 
can also read consistent data via the process image of the inputs. Refer to the related 
documentation to find out if your CPU supports this functionality. For additional information on 
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consistent data of a DP standard slave/PROFINET IO device, refer to Section "Data 
consistency (Page 2826)". 

If necessary, the instruction "DPRD_DAT" can also be used for a data area of 1 byte or larger. 
For information on the maximum length of the data, refer to the documentation of your CPU 
(e.g. 64 bytes for an S7-1214). 

● Use the LADDR parameter to select the DP standard slave / PROFINET IO device. If an 
access error occurs, the error code W#16#8090 is output.

● Use the RECORD parameter to define the target range of the read data:

– The target range has to be at least as long as the inputs of the selected module. Only 
the inputs are transferred, the other bytes are not considered. If you read from a DP 
standard slave with a modular configuration or with several DP identifiers, you can only 
access the data of a module of the configured hardware identifier per "DPRD_DAT" call. 
If you select a target range that is too small, the error code 80B1 is output at the 
RET_VAL parameter. 

– All bit strings and all integers can be used as data type. It is also possible to use these 
data types in a data structure of the ARRAY type . The data type STRING is not 
supported.

● If there was no error during the data transmission, the data that have been read are entered 
in the target range defined at the RECORD  parameter.

Parameters
The following table shows the parameters of the instruction "DPRD_DAT":

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, L or 

constant
Hardware identifier of the DP standard slave / 
PROFINET IO device from which it is to be read.

RET_VAL Return DINT, INT, 
LREAL, REAL

I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error code.

RECORD Output VARIANT I, Q, M, D, L Destination area for the user data that were read.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0000 No error occurred.
8090 ● You have not configured a module for the specified hardware identifier or

● You have ignored the restriction concerning the length of consistent data, or
● you have not specified a hardware identifier as an address at parameter LADDR .

8092 A data type other than (Array of)  bit string or integer was specified at the RECORD parameter.
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Error code* 
(W#16#...)

Explanation

8093 No DP module/PROFINET IO device from which you can read consistent data exists for the hardware 
identifier specified in LADDR . This error code also occurs if the module addressed by means of LADDR 
does not have inputs.

80A0 An access error was detected when accessing the I/O.
80B1 The length of the specified target range at parameter RECORD is shorter than the configured user data 

length.
80C0 The data have not been read yet.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Parameter STATUS (Page 2330)

DPWR_DAT: Write consistent data of a DP standard slave

Description
You use the "DPWR_DAT" instruction to consistently transfer the data at the RECORD  
parameter to the addressed DP standard slave / PROFINET IO device, and, if applicable, to 
the process image (if you have configured the relevant address area of the DP standard slave 
as a consistent range in a process image). 

You require "DPWR_DAT" because you can only write a maximum of four continuous bytes 
using the transfer commands that access the I/O or process image output. If required, you can 
also write consistent data via the process image outputs. Refer to the related documentation 
to find out if your CPU supports this functionality. Do not use both possibilities concurrently 
when writing consistent data: Either use "DPWR_DAT" or write via the process image output 
table. For additional information on consistent data of a DP standard slave/PROFINET IO 
device, refer to Section "Data consistency (Page 2826)". If the DP standard slave has a 
modular design, you can only access one module of the DP slave.

 

 CAUTION

I/O access

When using "DPWR_DAT", avoid accessing I/O areas that have process image partitions 
with OB6x connections (isochronous mode interrupts) assigned to them.

 

If necessary, the instruction "DPRD_DAT" can also be used for a data area of 1 byte or larger. 
For information on the maximum length of the data, refer to the documentation of your CPU 
(e.g. 64 bytes for an S7-1214). 
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● Use the LADDR parameter to select the DP standard slave / PROFINET IO device. If an 
access error occurs on the addressed module, the error code 8090 is output.

● Use the RECORD parameter to define the source range of the data to be written:

– The source range has to be at least as long as the outputs of the selected module. Only 
the outputs are transferred, the other bytes are not considered. If the source range at 
parameter RECORD is longer than the outputs of the configured module, only the data 
up to the maximum length of the outputs is transferred. If the source range at parameter 
RECORD is shorter than the outputs of the configured module, the error code 80B1 is 
output. 

– All bit strings and all integers can be used as data type. It is also possible to use these 
data types in a data structure of the ARRAY type . The data type STRING is not 
supported.

The data is transferred synchronously, that is, the write process is completed when the 
instruction is completed.

Parameters
The following table shows the parameters of the instruction "DPWR_DAT":

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, L or constant Hardware identifier of the DP standard slave / 

PROFINET IO device to those PIQ range it is 
to be written.

RECORD Input VARIANT I, Q, M, D, L Source area for the user data to be 
written.

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0000 No error occurred.
8090 ● You have not configured a module for the specified hardware identifier or

● You have ignored the restriction concerning the length of consistent data, or
● you have not specified a hardware identifier at parameter LADDR .

8092 A data type other than (Array of) bit string or integer was specified at the RECORD parameter.
8093 No DP module /PROFINET IO device to which you can write consistent data exists at the HW ID specified 

in LADDR . This error code also occurs if the DP standard slave / PROFINET IO device addressed via 
LADDR does not have outputs.

80A1 Access error detected while I/O devices were being accessed.
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Error code* 
(W#16#...)

Explanation

80B1 The length of the specified source range at the RECORD parameter is shorter than the outputs of the 
configured DP standard slave / PROFINET IO device.

80C1 The data of the previous write job have not yet been processed by the DP standard slave / PROFINET 
IO device.

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Parameter STATUS (Page 2330)

iDevice / iSlave

RCVREC: Receive data record

Description
An I-device can receive a data record from a superordinate controller. The receipt takes place 
in the user program with the instruction "RCVREC" (receive record).

The instruction has the following operating modes:

● Check whether the I-device has a request for a data record receipt.

● Make the data record available to the output parameters.

● Send an answer to the superordinate controller.

You can determine the operating mode executed by the instruction using the input parameter 
MODE (see below).

The I-device must be in the RUN or STARTUP mode.

With MLEN, you specify the maximum number of bytes you want to receive. The selected 
length of the target range RECORD should have at least the length of MLEN bytes.

If a data record was received (MODE=1 or MODE=2), the output parameter NEW will indicate 
that the data record was stored in RECORD. Note that RECORD has a sufficient length. The 
output parameter LEN contains the actual length of the data record received in bytes.
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Set CODE1 and CODE2 to zero for the positive answer to the superordinate controller. If the 
received data record is to be rejected, enter the negative answer to the superordinate controller 
in Error Code 1 of the CODE1 and in Error Code 2 of the CODE2.

 

 Note

If the I-device has received a request for a data record receipt, you must recognize the delivery 
of this request within a certain duration. After recognition, you must send an answer to the 
superordinate controller within this time period. Otherwise the I-device will experience a 
timeout error which causes the operating system of the I-device to send a negative answer 
to the superordinate controller. For information on the value for the time period, refer to the 
specifications of your CPU.

 

The output parameter STATUS receives the error information after the occurrence of an error.

Operating modes
You can determine the operating mode of the instruction "RCVREC" with the input parameter 
MODE. This step will be explained in the following table.

MODE Meaning
0 Check whether a request for a data record receipt exists

If a data record from a higher-level controller exists on the I-device, the instruction will only write the output 
parameters NEW, SLOT, SUBSLOT, INDEX and LEN. If you call the instruction several times with MODE=0, 
then the output parameter will only refer to one and the same request.

1 Receiving a data record for any subslot of the I-device
If a data record from a superordinate controller exists on the I-device for any subslot of the I-device, the instruction 
will write the output parameter and transfer the data record to the parameter RECORD.

2 Receiving a data record for a specific subslot of the I-device
If a data record from a superordinate controller exists on the I-device for a specific subslot of the I-device, the 
instruction will write the output parameter and transfer the data record to the parameter RECORD.

3 Sending a positive answer to the superordinate controller
The instruction checks the request of the superordinate controller to receive a data record, accepts the existing 
data record and sends a positive acknowledgement to the superordinate controller.

4 Sending a negative answer to the superordinate controller
The instruction checks the request of the superordinate controller to receive a data record, rejects the existing 
data record and sends a negative acknowledgement to the superordinate controller. Enter the reason for the 
rejection in the input parameters CODE1 and CODE2.

 

 Note

After the receipt of a data record (NEW=1) you must call "RCVREC" twice to ensure complete 
processing. You must do this in the following order:
● First call with MODE=1 or MODE=2
● Second call with MODE=3 or MODE=4
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Parameters
The following table shows the parameters of the "RCVREC" instruction:

Parameter Declaration Data type Memory area Description
MODE Input INT I, Q, M, D, L or 

constant
Mode

F_ID Input HW_SUBMO
DULE 
(DWORD)

I, Q, M, D, L or 
constant

Subslot in the transfer area of the I-device for 
the data record to be received (only relevant 
for MODE=2). The high word is always set to 
zero.

MLEN Input INT I, Q, M, D, L or 
constant

Maximum length of the data record to be 
received in bytes

CODE1 Input BYTE I, Q, M, D, L or 
constant

Zero (for MODE=3) and/or Error Code 1 (for 
MODE=4)

CODE2 Input BYTE I, Q, M, D, L or 
constant

Zero (for MODE=3) and/or Error Code 2 
(forMODE=4)

NEW Output BOOL I, Q, M, D, L ● MODE = 0: New data record was received
● MODE=1 or 2: Data record was transferred 

to RECORD
STATUS Output DWORD I, Q, M, D, L Error information
SLOT Output HW_SUBMO

DULE
I, Q, M, D, L Identical to F_ID

SUBSLOT Output HW_SUBMO
DULE

I, Q, M, D, L Identical to F_ID

INDEX Output UINT I, Q, M, D, L Number of the data record received
LEN Output UINT I, Q, M, D, L Length of the data record received
RECORD InOut VARIANT I, Q, M, D, L Target range for the data record received.

Note: Note that for S7-300 CPUs the 
parameter RECORD always requires the full 
specification of the DB parameters (for 
example, P#DB13.DBX0.0 Byte 100). The 
omission of an explicit DB number is not 
permitted for S7-300 CPUs and results in an 
error message in the user program.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS
For interpretation of the parameter STATUS refer to section: Parameter STATUS 
(Page 2330) 
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PRVREC: Make data record available

Description
An I-device can receive a request from a superordinate controller to make a data record 
available. The I-device makes the data record available in the user program with the instruction 
"PRVREC" (provide record).

The instruction has the following operating modes:

● Check whether the I-device has a request for making a data record available.

● Transfer the requested data record to the superordinate controller.

● Sending an answer to the superordinate controller.

You can determine the operating mode executed by the instruction using the input parameter 
MODE (see below).

The I-device must be in the RUN or STARTUP mode.

Enter the maximum number of bytes the data record to be sent should have with LEN. The 
selected length of the target range RECORD should have at least the length of LEN bytes.

If a request to make a data record available exists, (MODE=0), the output parameter NEW will 
be set to TRUE.

If the request for making a data record available is accepted, write RECORD for the positive 
answer to the superordinate controller with the requested data record and write zero for CODE1 
and CODE2. If the request for making a data record available is to be rejected, enter the 
negative answer to the superordinate controller in Error Code 1 of the CODE1 and in Error 
Code 2 of theCODE2.

 

 Note

If the I-device has received a request for making a data record available, you must recognize 
the delivery of this request within a certain time period. After recognition, you must send an 
answer to the superordinate controller within this time period. Otherwise the I-device will 
experience a timeout error which causes the operating system of the I-device to send a 
negative answer to the superordinate controller. For information on the value for the time 
period, refer to the specifications of your CPU.

 

The output parameter STATUS receives the error information after the occurrence of an error.
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Operating modes
You can determine the operating mode of the instruction "PRVREC" with the input parameter 
MODE. This step will be explained in the following table.

MODE Meaning
0 Check whether a request for making a data record available exists

If a request from a higher-level controller for making a data record available exists on the I-device, the instruction 
will only write the output parameters NEW, SLOT, SUBSLOT, INDEX and RLEN. If you call the instruction several 
times with MODE=0, then the output parameter will only refer to one and the same request.

1 Receiving a request for making a data record available for any subslot of the I-device
If such a request from a superordinate controller for any subslot of the I-device exists on the I-device, the 
instruction will write the output parameter.

2 Receiving a request for making a data record available for a specific subslot of the I-device
If such a request from a superordinate controller for a specific subslot of the I-device exists on the I-device, the 
instruction will write the output parameter.

3 Make the data record available and send a positive answer to the superordinate controller
The instruction checks the request of the superordinate controller to make a data record available, makes the 
request data record available to RECORD and sends a positive acknowledgement to the superordinate controller.

4 Sending a negative answer to the superordinate controller
The instruction checks the request of the superordinate controller to make a data record available, rejects this 
request and sends a negative acknowledgement to the superordinate controller. Enter the reason for the rejection 
in the input parameters CODE1 and CODE2.

 

 Note

After the receipt of a request (NEW=1) you must call the instruction twice to ensure complete 
processing. You must do this in the following order:
● First call with MODE=1 or MODE=2
● Second call with MODE=3 or MODE=4

 

Parameters
The following table shows the parameters of the "PRVREC" instruction:

Parameter Declaration Data type Memory area Description
MODE Input INT I, Q, M, D, L or 

constant
Mode

F_ID Input HW_SUBMO
DULE 
(DWORD)

I, Q, M, D, L or 
constant

Subslot in the transfer area of the I-device for the 
data record to be sent (only relevant for 
MODE=2). The high word is always set to zero.

CODE1 Input BYTE I, Q, M, D, L or 
constant

Zero (for MODE=3) and/or Error Code 1 
(forMODE=4)

CODE2 Input BYTE I, Q, M, D, L or 
constant

Zero (for MODE=3) and/or Error Code 2 
(forMODE=4)

LEN Input UINT I, Q, M, D, L or 
constant

Maximum length of the data record to be sent in 
bytes
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Parameter Declaration Data type Memory area Description
NEW Output BOOL I, Q, M, D, L The new data record was requested by the 

superordinate controller.
STATUS Output DWORD I, Q, M, D, L Error information
SLOT Output HW_SUBMO

DULE
I, Q, M, D, L Identical to F_ID

SUBSLOT Output HW_SUBMO
DULE

I, Q, M, D, L Identical to F_ID

INDEX Output UINT I, Q, M, D, L Number of the data record to be sent
RLEN Output UINT I, Q, M, D, L Length of the data record to be sent
RECORD InOut VARIANT I, Q, M, D, L Data record made available

Note: Note that for S7-300 CPUs the parameter 
RECORD always requires the full specification of 
the DB parameters (for example, 
P#DB13.DBX0.0 Byte 100). The omission of an 
explicit DB number is not permitted for S7-300 
CPUs and results in an error message in the user 
program.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS
For interpretation of the parameter STATUS refer to section: Parameter STATUS 
(Page 2330) 

PROFIBUS

DPSYC_FR: Synchronize DP slaves / Freeze inputs

Description       
You use the instruction to synchronize one or more groups of DP slaves.

The function involves sending one of the control commands below, or a combination of them, 
to the relevant groups:

● SYNC (simultaneous output and freezing of output states on the DP slaves)

● UNSYNC (cancels the SYNC control command)

● FREEZE (freeze the input states on the DP slaves and read in the frozen inputs)

● UNFREEZE (cancels the FREEZE control command)

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2372 System Manual, 07/2013,  



Before you send the control commands listed above, you must assign the DP slaves to groups 
per configuration. You must know which DP slave is assigned to which group, with which 
number and know the reactions of the various groups to SYNC/FREEZE.

 

 Note

Note that the control commands SYNC and FREEZE also remain valid when you perform a 
warm/cold restart.

Please note also that you may initiate only one SYNC/UNSYNC job or only one FREEZE/
UNFREEZE job at a time.

 

Functional description
"DPSYC_FR" works asynchronously, that is, its execution extends over multiple calls. You 
start the job by calling "DPSYC_FR" with REQ=1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

Identification of a job
If you have triggered a SYNC/FREEZE job and called "DPSYC_FR" again before the first job 
was completed, the response of the instruction depends on whether the new call is for the 
same job. If the input parameters LADDR, GROUP  and MODE  match, the call is interpreted 
as a follow-on call.

Writing outputs of DP modules
The writing of outputs of DP modules is triggered as follows:

● By transfer commands to the DP I/O

● By writing the process image of the outputs to the modules (by the operating system at the 
end of OB 1 or by calling the instruction "UPDAT_PO (Page 2316)")

● Calling the "DPWR_DAT (Page 2365)" instruction.

In normal operation, the DP master transfers the output bytes cyclically (within the cycle of the 
PROFIBUS DP bus) to the outputs of the DP slaves.

If you want to have certain output data (possibly distributed on several slaves) applied to the 
outputs to the process at exactly the same time, you can send the SYNC control command to 
the relevant DP master using the "DPSYC_FR" instruction.

What are the effects of SYNC?
With the SYNC control command, the DP slaves of the selected groups are switched to Sync 
mode. In other words, the DP master transfers the current output data and instructs the DP 
slaves involved to freeze their outputs. With the following output message frames, the DP 
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slaves enter the output data in an internal buffer and the state of the outputs remains 
unchanged.

Following each SYNC control command, the DP slaves of the selected groups apply the output 
data of their internal buffer to the outputs on the process.

The outputs are only updated cyclically again when you send the UNSYNC control command 
using the "DPSYC_FR" instruction.

 

 Note

If the DP slaves of the selected group(s) are not currently connected to the network or have 
failed when the control command was sent, they will not be switched to SYNC mode. This 
information will not be communicated in the return value of the instruction.

 

Reading input data of DP modules
The input data of the DP modules are read as follows:

● Using load commands to the DP I/O

● When the process image of the inputs is updated (by the operating system at the start of 
OB 1 or by calling the "UPDAT_PI (Page 2315)" instruction)

● By calling the "DPRD_DAT (Page 2363)" instruction.

In normal operation, the DP master receives this input data cyclically (within the cycle of the 
PROFIBUS DP bus) from its DP slaves and makes them available to the CPU.

If you want to have certain input data (possibly distributed on several slaves) to be read from 
the process at exactly the same time, send the FREEZE control command to the relevant DP 
master using the "DPSYC_FR" instruction.

What are the effects of FREEZE?
With the FREEZE control command, the DP slaves involved are switched to Freeze mode, in 
other words the DP master instructs the DP slaves to freeze the current state of the inputs. It 
then transfers the frozen data to the input area of the CPU. 

Following each FREEZE control command, the DP slaves freeze the state of their inputs again.

The DP master only receives the current state of the inputs cyclically again after you have sent 
the UNFREEZE control command with the "DPSYC_FR" instruction.

 

 Note

If the DP slaves of the selected group(s) are not currently connected to the network or have 
failed when the control command has been sent, they will not be switched to FREEZE mode. 
This information will not be communicated in the return value of the instruction.
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Data consistency
Because the DPSYC_FR functions are asynchronous and can be interrupted by higher priority 
classes, you should make sure that the process images are consistent with the actual inputs 
and outputs of the I/O when using the "DPSYC_FR" instruction.

This is guaranteed if you comply with the following consistency rules:

● Define suitable process image partitions for the "SYNC outputs" and the "FREEZE inputs" 
(only possible on the S7-400). Call the "UPDAT_PO (Page 2316)" instruction immediately 
before each first call of a SYNC job. Call the "UPDAT_PI (Page 2315)" instruction 
immediately after the respective last call of a FREEZE job.

● As an alternative: Use only direct I/O access for outputs involved in a SYNC job and for 
inputs involved in a FREEZE job. Do not write to these outputs when a SYNC job is active 
and do not read in these inputs when a FREEZE job is active.

Use of DPWR_DAT and DPRD_DAT
If you use the "DPWR_DAT (Page 2365)" instruction, it must be complete before you send a 
SYNC job for the outputs involved.

If you use the "DPRD_DAT (Page 2363)" instruction, it must be complete before you send a 
FREEZE job for the inputs involved.

Startup and "DPSYC_FR"
The user alone must take responsibility for sending the SYNC and FREEZE control commands 
in the startup OBs.

If you want the outputs of one or more groups to be in SYNC mode when the user program 
starts, you must initialize these outputs during startup and completely execute the 
"DPSYC_FR" instruction with the SYNC control command.

If you want the inputs of one or more groups to be in FREEZE mode when the user program 
starts, you must execute the "DPSYC_FR" instruction with the FREEZE control command 
completely for these inputs during startup.

Parameters
The following table shows the parameters of the "DPSYC_FR" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Level-triggered control parameter REQ = 1: 

Triggering of the SYNC/FREEZE job
LADDR Input HW_DPMAST

ER (WORD)
I, Q, M, D, L or 
constant

Hardware identifier of the DP master interface
The number can be taken from the properties of the 
DP master interface in the Network view or from the 
"System constants" tab of the standard tag table.
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Parameter Declaration Data type Memory area Description
GROUP Input BYTE I, Q, M, D, L or 

constant
Group selection
Bit 0 = 1: group 1 selected
Bit 1 = 1: group 2 selected
:
Bit 7 = 1: group 8 selected
You can select several groups per job. The value 
B#16#0 is invalid.

MODE Input BYTE I, Q, M, D, L or 
constant

Job ID (coding complies with EN 50 170 Volume 2, 
PROFIBUS)
Bit 0: reserved (value 0)
Bit 1: reserved (value 0)
Bit 2:
● = 1: UNFREEZE will be executed
● = 0: no meaning
Bit 3:
● = 1: FREEZE will be executed
● = 0: no meaning
Bit 4:
● = 1: UNSYNC will be executed
● = 0: no meaning
Bit 5:
● = 1: SYNC will be executed
● = 0: no meaning
Bit 6: reserved (value 0)
Bit 7: reserved (value 0)
 
Possible values:
● with exactly one ID per job:

– B#16#04 (UNFREEZE)
– B#16#08 (FREEZE)
– B#16#10 (UNSYNC)
– B#16#20 (SYNC)

● with more than one ID per job:
– B#16#14 (UNSYNC, UNFREEZE)
– B#16#18 (UNSYNC, FREEZE)
– B#16#24 (SYNC, UNFREEZE)
– B#16#28 (SYNC, FREEZE)

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error code.
Make sure that you evaluate RET_VAL  each time 
the block has been executed.

BUSY Output BOOL I, Q, M, D, L BUSY=1:
The SYNC/FREEZE job is not yet complete.
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For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL
 

 Note

If you access DPV1 slaves, error information of these slaves can be forwarded from the DP 
master to the instruction. For a description of this error information, refer to STATUS[3], 
STATUS (Page 2330) parameter.

 

Error code*
(W#16#...)

Explanation

0000 Job completed without error.
7000 First call with REQ=0. The job specified with LADDR, GROUP  and MODE  is not active; BUSY  has the 

value 0.
7001 First call with REQ=1. The job specified with LADDR, GROUP  and MODE was triggered; BUSY  has the 

value 1.
7002 Intermediate call (REQ 

irrelevant). The activated SYNC/FREEZE job is still running; BUSY  has 
the value 1.

8090 The module selected with LADDR  is not a DP master.
8093 This instruction is not permitted for the module selected with LADDR  (configuration or version of the DP 

master).
8094 GROUP  parameter is incorrect
8095 MODE  parameter is incorrect
80B0 The group selected with GROUP  is not configured.
80B1 The group selected with GROUP  is not assigned to this CPU.
80B2 The SYNC job specified with MODE  is not permitted on the group selected 

with GROUP.
80B3 The FREEZE job specified with MODE  is not permitted on the group selected 

with GROUP .
80C2 Temporary shortage of resources on the DP master: The DP master is 

currently processing the maximum number of jobs for a CPU.
80C3 This SYNC/UNSYNC job cannot be activated at present because only one 

SYNC/UNSYNC job can be triggered at a time. Check your user 
program.

80C4 This FREEZE/UNFREEZE job cannot be activated at present because only one 
FREEZE/UNFREEZE job can be triggered at a time. Check your user 
program.

80C5 Short circuit directly at DP interface
80C6 Job aborted due to I/O disconnection by CPU
80C7 Job aborted due to warm or cold restart on the DP master
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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DPNRM_DG: Read diagnostics data from a DP slave

Description
You use the "DPNRM_DG" instruction to read the current diagnostic data of a DP slave in the 
form specified in EN 50 170 Volume 2, PROFIBUS. 

Refer to the following table for the basic structure of the slave diagnostic data and to the 
manuals of the DP slaves for further information.

Byte Meaning
0 Station status 1
1 Station status 2
2 Station status 3
3 Master station number
4 Vendor ID (high byte)
5 Vendor ID (low byte)
6 ... Additional slave-specific diagnostic information

The data that has been read is entered in the target range indicated by RECORD following 
without error data transfer. You start the read process by assigning the value "1" to the REQ 
input parameter when the "DPNRM_DG" instruction is called.

Functional description
The reading process is executed asynchronously, in other words, it can extend over several 
calls. The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

Parameters
The following table shows the parameters of the "DPNRM_DG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

LADDR Input HW_DPSLAVE
 (WORD)

D, L or constant Configured diagnostic address of the DP 
slave
Note: Address must be specified in hexadecimal 
form, for example, diagnostic address 1022 means: 
LADDR:=W#16#3FE.

RET_VAL Return DINT, INT, 
LREAL, REAL

I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error code. 
If no error has occurred, the length of 
the data actually transferred is entered in RET_VAL
.
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Parameter Declaration Data type Memory area Description
RECORD Output VARIANT I, Q, M, D, L Destination area for the diagnostic data that were 

read. Only the BYTE data type is permitted. The 
minimum length of the data record to be read or the 
target range is 6. The maximum length of the data 
record to be sent is 240. Standard slaves can 
provide more than 240 bytes of diagnostic data up 
to a maximum of 244 bytes. In this case, the first 
240 bytes are transferred to the target range and 
the overflow bit is set in the data.

BUSY Output BOOL I, Q, M, D, L BUSY = 1:
The reading process is not yet complete.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

You can find information on data type conversion in the different programming languages under 
"Auto-Hotspot".

Parameter RECORD
The CPU evaluates the actual length of the read diagnostic data:

If the length specified for RECORD

● is less than the number of data bytes supplied, the data is discarded and a corresponding 
error code is entered in RET_VAL.

● is greater than or equal to the number of data bytes supplied, the data is accepted in the 
destination area and the actual length is entered in RET_VAL as a positive value.

 

  Note

You must ensure that the actual parameters of RECORD correspond in all calls belonging 
to a job.

A job is uniquely identified by the LADDR input parameter.
 

Standard slaves with more than 240 bytes of diagnostic data
With standard slaves on which the number of standard diagnostic data is between 241 and 
244 bytes, note the following points:

If the length specified for RECORD

● is less than 240 bytes, the data is discarded and a corresponding error code is entered in 
RET_VAL.

● If the length specified for RECORD is greater than or equal to 240 bytes, the first 240 bytes 
of the standard diagnostic data is transferred to the target range and the overflow bit is set 
in the data.
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Parameter RET_VAL
● If an error occurs while the function is being executed, the return value contains an error 

code.

● If no errors have occurred during data transfer, RET_VAL contains the length of the data 
read in bytes as a positive number.

 

  Note

The amount of data read in a DP slave depends on its diagnostics status.
 

For the evaluation of the error information of the RET_VAL parameter, refer to the following 
table.

Error code 
(W#16#...)

Explanation Restriction

7000 First call with REQ = 0: No data transfer active; BUSY has the value "0". -
7001 First call with REQ = 1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ irrelevant): Data transfer already active; BUSY 

has the value "1".
Distributed I/O

8090 Specified logical base address invalid: There is no 
assignment in SDB1/SDB2x or there is no base address.

-

8093 This instruction is not permitted for the module selected by means of 
LADDR and IOID.

-

80A2 ● DP protocol error at layer 2 (for example, slave failure or bus 
problems)

● For ET200S, data record cannot be read in DPV0 mode.

Distributed I/O

80A3 DP protocol error with user interface/user Distributed I/O
80A4 Communication on PBUS+ disrupted Distributed I/O
80B0 ● Instruction not possible for module type.

● The module does not recognize the data record.
● Data record number 241 not permitted.
● With "WR_REC (Page 2323)", data records 0 and 1 are not 

permitted.

-

80B1 The length specified in parameter RECORD is incorrect. specified length < data record 
length

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type does not match the specified module 
type in SDB1.

-

80C0 There are no diagnostic data available. -
80C1 The data of the previous write job on the module for the same data record 

have not yet been processed by the module.
-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

-
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Error code 
(W#16#...)

Explanation Restriction

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available. Distributed I/O
80C6 Data record transfer stopped due to priority class abort (restart or 

background)
Distributed I/O

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DP_TOPOL: Determine topology for DP master system

Description     
You use the instruction to trigger the topology determination for a selected DP master system. 
Calling the instruction will address all diagnostics repeaters on a DP master system.

 

 Note

The topology can only be determined for one DP master system at a time.
 

Topology determination is the prerequisite for the detailed display of the error location if line 
errors occur. After configuration and after every change to the physical configuration of a DP 
master system, you must repeat the topology determination with "DP_TOPOL".

Changes to the physical configuration are:

● Changes in line lengths

● Adding or removing stations or components with repeater function

● Changing station addresses

If an error is reported by a diagnostics repeater, "DP_TOPOL" writes the DPR  and DPRI  
outputs for the duration of one "DP_TOPOL pass. If errors are reported by multiple diagnostics 
repeaters of the selected DP master system, "DP_TOPOL" writes DPR  and DPRI  with 
information regarding the first diagnostics repeater reporting the error. You can read out the 
entire diagnostic information on the programming device or using the "DPNRM_DG 
(Page 2378)" instruction. If no diagnostics repeater reports an error, the DPR and DPRI  
outputs have the value NULL.

If you want to repeat a topology determination after an error occurs, you must first reset 
"DP_TOPOL". This is done by calling "DP_TOPOL" with REQ=0  and R=1.

Functional description
"DP_TOPOL" works asynchronously, that is, its execution extends over multiple calls. You 
start determining the bus topology by calling "DP_TOPOL" with REQ=1 . If you want to cancel 
the process, call "DP_TOPOL" with R=1 .
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The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

 

 Note

Determining the topology may take several minutes.
 

Identification of a job
The input parameter DP_ID uniquely specifies a job. 

If you have called "DP_TOPOL" and you call this instruction again before the topology is re-
determined, the manner in which the instruction reacts depends on whether the new call 
involves the same job: If the DP_ID parameter matches a job that has not yet been completed, 
then the call is interpreted as a follow-up call and the value W#16#7002 will be entered in 
RET_VAL. On the other hand, if another job is involved, the CPU rejects it.

Parameters
The following table shows the parameters of the "DP_TOPOL" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ=1: Trigger topology determination

R Input BOOL I, Q, M, D, L or 
constant

R=1: Cancel topology determination

DP_ID Input HW_IOSYST
EM

I, Q, M, D, L or 
constant

DP master system ID of those master systems 
for which the topology will be determined

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

BUSY Output BOOL I, Q, M, D, L BUSY=1: Topology determination is not yet 
complete.

DPR Output BYTE I, Q, M, D, L PROFIBUS address of the diagnostics repeater 
reporting the error.

DPRI Output BYTE I, Q, M, D, L Measuring segment diagnostics repeater 
reporting the error:
● Bit 0 = 1: Temporary faults on segment DP2
● Bit 1 = 1: Permanent faults on segment DP2
● Bit 4 = 1: Temporary faults on segment DP3
● Bit 5 = 1: Permanent faults on segment DP3

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter RET_VAL
When looking at the "real" error information (error codes W#16#8xyz) in the following table, 
we distinguish between two cases:

● Temporary errors (error codes W#16#80A2 to 80A4, 80C3, 80C5):
It is possible to eliminate this type of error without user action; in other words, it is advisable 
to call "DP_TOPOL" again (multiple calls, if necessary).
Example of a temporary error: Resources required are currently in use (W#16#80C3).

● Permanent errors (error codes W#16#8082, 80B0, 80B2):
This type of error does not correct itself. A new call of "DP_TOPOL" is only advisable after 
you have eliminated the error. Example of a permanent error: The DP master/CPU does 
not support this service. (W#16#80B0).

Error code*
(W#16#...)

Explanation

0000 Job completed without error.
7000 First call with REQ=0. Topology determination is not triggered. BUSY has the value "0".
7001 First call with REQ=1. The request to execute topology determination was sent. BUSY  has the value "1".
7002 Intermediate call (REQ 

irrelevant): Topology determination is not yet complete. BUSY  has the value "1".
7010 You have attempted to cancel topology identification. But there is no running job with the specified DP_ID. 

BUSY  has the value "0". 
7011 First call with R=1. The cancellation of the topology determination was triggered. BUSY  has the value 

"1".
7012 Intermediate call: The cancellation of the topology determination is not yet complete. BUSY  has the value 

"1".
7013 Final call: The topology determination was cancelled. BUSY  has the value "0".
8082 No DP master system is configured with the specified DP_ID.
80A2 Error during topology determination; for more detailed information, refer to output parameters DPR  and 

DPRI.
80A3 Error during topology determination: Monitoring time has elapsed (timeout). 
80A4 Communication on PBUS+ disrupted
80B0 The DP master/CPU does not support this service.
80B2 Error during topology determination: No diagnostics repeater was found at the selected DP master system.
80C3 Resources required are currently in use. Possible cause: You have initiated a second topology 

determination (only one topology determination is permitted at one time).
80C5 The DP master system is currently not available.
General error 
information

See also:  GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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ASi

ASI_CTRL: Controlling ASi master behavior

Description of ASI_CTRL

Description
Using the instruction "ASI_CTRL", you can control the behavior of the AS-i master from the 
user program of the PLC. The instruction processes the command protocol automatically. It 
also enables parameter assignment on SIMATIC AS-i masters and reading out information 
data. The functions and operation of the command interface are detailed in the manual for the 
AS-i master.

Both centrally inserted AS-i masters and distributed AS-i masters via PROFIBUS DP are 
supported. Combinations with PROFINET IO (e.g. IE/PB Link PN IO) are also possible.

The schematic diagram below shows the functions of the "ASI_CTRL" instruction:

Start
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Read data 
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Command no. / job 
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Command 

processing
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① Start of processing at the REQ parameter.
② The program sends the required command to the AS-i master via the instruction 

"RDREC".
③ The AS-i master processes the command.
④ The current status of the AS-i master is stored in the input area of the binary data 

(logical start address).
⑤ The instruction "ASI_CTRL" cyclically queries and evaluates the 4 status bits.
⑥ Once command processing is complete, the command job is completed with 

"RDREC". Depending on the command, the data field of "RDREC" may contain the 
response data for the command or additional status information.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2384 System Manual, 07/2013,  



Differences in the command call between IE/ AS-i Link and DP/AS-i Links
There are significant differences in how a controller exchanges commands with an AS-i master.

● IE/AS-i Link (PROFINET) used the data record interface. The different commands are 
called with either "Write data record" ("WRREC" instruction) or "Read data record" 
("RDREC" instruction) by various data record numbers.

● DP/AS-i Links (PROFIBUS) use the command interface. All commands are called by data 
record number 2 with "Write data record" ("WRREC" instruction) plus "Read data record" 
("RDREC" instruction). The type of command is defined by the data content in the write job.

Changes compared to the instruction "ASi_3422".
The instruction "ASI_CTRL" is a revised version of the instruction "ASi_3422" (S7-300/400) 
and provides improved functionality and compatibility. The specific changes are as follows:

● For writing and reading diagnostic data records, the instructions "WR_REC (Page 2362)" 
and "RD_REC (Page 2358)" have been replaced by the instructions "RDREC (Page 2321)" 
and "WRREC (Page 2323)". Their function is identical; however, they support data transfer 
via PROFINET IO.

● The block type of the instruction has been changed from a function (FC) to a function block 
(FB). "ASI_CTRL" has an instance data block and is multi-instance-capable.

● The designation of the formal parameters of "ASI_CTRL" complies with the SIMATIC 
system blocks. There is no STARTUP input parameter. The definition of the STATUS 
parameter is based on the instructions "RDREC (Page 2321)" and "WRREC (Page 2323)". 
The status identifiers for the parameter DONE and the new parameter BUSY have also 
been adjusted.

Operation of the "ASI_CTRL" instruction
The instruction "ASI_CTRL" is an asynchronous function block; in other words, its processing 
extends over multiple calls.

● A job is started with REQ = TRUE.

● The job status is displayed via the BUSY output parameters and the two central bytes of 
the output parameter STATUS.

● The BUSY parameter is set during job processing. Upon the first call, STATUS is assigned 
the value 00700100H. Upon all subsequent calls for this job, it is assigned the value 
00700200H. When the job is complete, the result is output at the parameters DONE or 
ERROR.

– If no errors have occurred, DONE is set. For jobs with response data from the AS-i 
master, this data is provided in the specified receive buffer. In such cases, the STATUS 
parameter also displays the volume of data supplied in bytes. For jobs without response 
data, the value 00000000H is entered in STATUS.

– If an error occurs during job processing, ERROR is set. The content of the receive buffer 
is invalid in such a case. An error code is entered in the STATUS parameter for a more 
detailed description of the error which has occurred.
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Number of command calls
If you use the instruction "ASI_CTRL" to send commands, you may not simultaneously send 
other commands to the same AS-i master with "RDREC (Page 2321)" or "WRREC 
(Page 2323)". This also applies to multiple calls of the instruction for the same AS-i master.

The instruction "ASI_CTRL" cannot be run with interruptions. Calls therefore cannot be 
programmed in program priority classes which interrupt each other (for example with calls in 
OB 1 and in OB 35).

Parameter
The following table shows the parameters of the instruction "ASI_CTRL":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, constant REQ = TRUE starts a new job unless a job is 

already in progress. No edge evaluation takes 
place.

LADDR Input WORD I, Q, M, D, L, constant Start address of the AS-i master in the S7 
address space (logical base address). The 
start address is defined in the hardware 
configuration when the master is configured.

SD Input VARIANT I, Q, M, D, L Send buffer
The parameter refers to a memory area in 
which the command is to be specified (see " 
ASi commands (Page 2387)").
Example: P#DB101.DBX 0.0 BYTE 223

RD Input VARIANT I, Q, M, D, L Receive buffer
This buffer is only relevant for commands 
which deliver answer data. The parameter 
refers to a memory area in which a command 
response is stored (see "ASi commands 
(Page 2387)").
Example: P#DB102.DBX 224.0 BYTE 221

DONE Output BOOL Q, M, D, L DONE = TRUE: Job completed without errors.
BUSY Output BOOL Q, M, D, L BUSY = TRUE: Job in progress.
ERROR Output BOOL Q, M, D, L ERROR = TRUE: Job aborted with error.
STATUS Output DWORD M, D Job status / error code

See the "STATUS parameter" description.

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

 

 Note
Parameters LADDR, SD, and RD

The parameters LADDR, SD, and RD must not be changed in any block cycle when a job is 
in progress: they must remain constant.
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STATUS parameter
The following table shows the possible STATUS displays dependent upon DONE and ERROR.

DONE ERROR STATUS Meaning
0 0 00700000H First call with REQ = FALSE; no active job.
0 0 00700100H First call with REQ = TRUE; job has started.
0 0 00700200H Subsequent call (REQ irrelevant); job is still in progress.
1 0 00000000H Job completed without errors. No response data.
1 0 0000xx00H Job completed without errors. Number of xx bytes of response data.
0 1 C0818400H Data type of formal operand RD invalid.
0 1 C0818500H Error in communication with AS-i master (incorrect address configured at the LADDR 

parameter).
0 1 C0838100H Incorrect AS-i slave address.
0 1 C0838200H AS-i slave is not enabled (not in LAS).
0 1 C0838300H Error at the AS interface (the SD parameter may have been set too small).
0 1 C0838400H The command is not valid with the current AS-i master status.
0 1 C0838500H There is no AS-i slave with the address "0".
0 1 C0838600H The AS-i slave has invalid configuration data (I/O or ID codes).
0 1 C083A100H The AS-i slave addressed has not been found at the AS interface.
0 1 C083A200H There is no AS-i slave with the address "0".
0 1 C083A300H There is already an AS-i slave with the new address at the AS interface.
0 1 C083A400H The AS-i slave address cannot be deleted.
0 1 C083A500H The AS-i slave address cannot be set.
0 1 C083A600H The AS-i slave address cannot be permanently saved.
0 1 C083A700H Error during reading of the extended ID1 code.
0 1 C083A800H The target address is not plausible (e.g. a B slave address has been used for a standard 

slave).
0 1 C083B100H A length error has occurred during string transfer.
0 1 C083B200H A protocol error has occurred during string transfer.
0 1 C083F800H Unknown job number or job parameter.
0 1 C083F900H The AS-i master has detected an EEPROM error.

 

ASi commands

Description
The command interface allows the controller and AS-i master to exchange parameter 
assignment and information data.

These commands
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● provide the complete functionality of the M4 master profile of the AS-i master specifications.

● enable the AS-i master to be completely configured from the controller.
 

  Note
AS-i commands supported

Please see the manual of the relevant AS-i master for the AS-i commands supported and 
a detailed description.

 

General structure of the send buffer
The general structure of the send buffer for commands and job data is set out in the table 
below. The area for the command number must always be filled. The number of bytes for the 
job data can be found in the description of the command (see AS-i master documentation). 
"q" is the start address of the send buffer.

Byte Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Meaning

q + 0 Command number
q + 1 Job data
q + 2 Job data
q + ... Job data

General structure of the receive buffer
The general structure of the receive buffer for the command response data is set out in the 
table below. The number of bytes for the response data depends on the command. Some 
commands do not return response data, and therefore only require the definition of a virtual 
receive buffer which is not filled with data. "n" is the start address of the receive buffer.

Byte Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Meaning

n + 0 Command number (echo)
n + 1 Response data
n + 2 Response data
n + ... Response data
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 CAUTION

Memory areas can be overwritten

If the receive buffer of the "ASI_CTRL" instruction is too short, neighboring memory areas 
may be overwritten. The length specified in the ANY pointer of the RD parameter when the 
instruction "ASI_CTRL" is called is irrelevant. The required length for the receive buffer can 
be found in the description of the command.

The following applies for command numbers 39H, 41H, 42H, 43H and 44H:

The receive buffer must be 221 bytes long (bytes 0 to 220), even if the command returns less 
data. Depending on the command, the highest bytes in the receive buffer may be overwritten 
with zero values by the AS-i master.

 

AS-i commands
A selection of possible AS-i commands is set out in the table below.

Name Parameter Return Coding
Set_permanent_parameter
(Set_Permanent_Parameter)

Slave address, parameter  00 H

Get_permanent_parameter
(Get_Permanent_Parameter)

Slave address Parameter 01 H

Write_parameter
(Write_Parameter)

Slave address, parameter Parameter echo 02 H

Read_parameter
(Read_Parameter)

Slave address Parameter value 03 H

Store_actual_parameters
(Store_Actual_Parameters)

  04 H

Set_configuration_data Slave address, 
configuration

 25 H

Get_configuration_data Slave address set configuration data 26 H
Store_actual_configuration
(Store_Actual_Configuration)

  07 H

Get_actual_configuration Slave address Actual configuration 
data

28 H

Configure_LPS LPS  29 H

Set_offline_mode Mode  0AH

Select_auto-program Mode  0B H

Set_mode Mode  0C H

Change_AS–iSlave_address
(Change_AS–iSlave_Address)

Address1, Address2  0D H

Get_AS-iSlave_status Slave address Error record of the AS-i 
slave

0F H

Read_lists_and_flags  LDS, LAS, LPS, flags 30 H
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Name Parameter Return Coding
Get_overall_configuration  Actual configuration 

data, current 
parameters, LAS, flags

39 H

Set_overall_configuration Overall configuration  3A H

Write_parameter_list Parameter list  3C H

Read_parameter_echo_list  Parameter echo list 33 H

Write_CTT2_request Slave address
CTT2 string

CTT2 string 44 H

Read_version_identifier  Version string 14 H

Read_AS-i_slave Slave address ID code 17 H

Read_AS-i_slave_extended_ID1 Slave address Extended ID1 code 37 H

Write_AS-iSlave_extended_ID1 Extended ID1 code  3F H
Read_AS-iSlave_extended_ID2 Slave address Extended ID2 code 38 H
Read_AS-iSlave_IO Slave address I/O configuration 18 H
Read_I/O_error_list  LPF 3E H
Write_AS–i-slave_parameter_string Slave address, parameter 

string
 40 H

Read_AS–iSlave_parameter_string Slave address Parameter string 41 H
Read_AS-iSlave_ID_string Slave address ID string 42 H

Read_AS-iSlave_diagnostic_string Slave address Diagnostic string 43 H

Read_AS-i_line_error_counter   4A H
Read_and_clear_AS-i_line_error_counter   4B H

Read_AS-iSlave_error_counter Slave address  4C H

Read_and_clear_AS-iSlave_error_counter Slave address  4D H

Additional command for DP/ AS-i F-Link:
AS–i_status/diag_of_F_slaves  Status/diagnostics of 

all AS-i safe slaves
51 H

 
 

 Note
Re-initializing the AS-i master command interface

Another command which is not mentioned in the table is command 77 H. This call re-initializes 
the command interface of the AS-i master. Any command which the AS-i master specified is 
currently processing will be terminated.

As of version V2.1.20 of DP/AS-i LINK Advanced, command 0E H is also available. This call 
enables you to release and block the ground fault monitoring function for a line.
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9.7.3.5 PROFIenergy

Description of PROFIenergy

PROFIenergy
PROFIenergy is a manufacturer- and device-neutral profile for energy management with 
PROFINET. PROFIenergy enables central, coordinated device shutdown to reduce electricity 
consumption during breaks in production and unplanned interruptions.

The PROFINET devices/power modules are switched off via special commands in the user 
program of the PROFINET IO controller. No additional hardware is required. The PROFINET 
devices interpret the PROFIenergy commands directly. 

PROFIenergy controller (PE controller)
The PE controller is a PLC which enables/disables the idle state in lower-level devices. 
Individual production components and entire production lines are switched off and reactivated 
from the user program. Commands (e.g. "Start_Pause" and "End_Pause") are sent to the lower-
level device using corresponding instructions (function blocks). The commands are sent via 
the PROFINET communication protocol.

PROFIenergy entity (PE entity)
The PE entity receives the PROFIenergy commands of the PE controller and executes these 
accordingly (for example, by returning a measured value or activating an energy saving mode). 
Implementation of the PE entity in a PROFIenergy-capable device is device- and manufacturer-
specific.

The PE entity can, for example, be executed:
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● Within the proxy of a submodule: The PE commands are valid for the addressed submodule 
and any existing lower-level submodules.

● Within the proxy of a module: The PE commands are valid for different submodules within 
the module.

● For networked submodules without a proxy function: The PE commands in this case are 
only valid for the respective submodule.

PROFIenergy instructions
● Instructions for IO controller

– The "PE_START_END (Page 2393)" instruction represents the simplest way to activate 
or deactivate the idle state of the PROFINET devices (PROFIenergy commands 
"Start_Pause" and "End_Pause"). This is done using a positive and negative signal edge 
in the instruction.

– The "PE_CMD (Page 2397)" instruction allows you to transmit all PROFIenergy 
commands, including "Start_Pause" and "End_Pause". With other commands, you can 
query the current status of the PROFINET devices or the behavior during breaks, for 
example.

– The instruction "PE_DS3_Write_ET200S (Page 2402)" is used to define the switching 
characteristic of up to 8 slots of ET 200S. The instruction is not a PROFIenergy 
instruction; however, it supplements the PROFIenergy functions for an ET 200S.

● Instruction for iDevices
The "PE_I_DEV (Page 2415)" instruction allows you to implement PROFIenergy on 
iDevices as well. The instruction receives PROFIenergy commands on the iDevice and 
forwards these to the user program for processing. After processing the command, the user 
program calls the "PE_I_DEV (Page 2415)" instruction again in order to send the 
acknowledgement to the IO controller. For these replies, each command offers you a 
corresponding auxiliary block that supplies the response data to the instruction 
"PE_I_DEV (Page 2415)".
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PROFIenergy commands (PE commands)
The PE controller transmits PE commands to the PE entity. The PE command can be either 
a control command to switch a PE entity to the energy-saving mode, or a command to read a 
status or measured value:

● PI commands for control
PROFIenergy supports two control commands that can be executed using either the 
"PE_Start_End (Page 2393)" instruction or the "PE_CMD (Page 2397)" instruction:

– Start_Pause: Starting a suitable energy-saving mode (PE Energy-saving mode)

– End_Pause: Exiting the energy-saving mode (switch to PE_ready_to_operate mode)

● PI commands for reading a status or measured value
Certain condition information can be read by the control system using the following status 
commands with the instruction "PE_CMD (Page 2397)":

– PE_Identify: Read out which PE commands are supported by the PE entity.

– PEM_Status: Read out the currently active mode of a PE entity (e. g. 
PE_ready_to_operate).

– Query_Modes: Output an overview of all supported energy-saving modes, including the 
time and energy information

– Query_Measurement: Output the measured values of a PE entity

Example applications
Examples for use of PROFIenergy instructions can be found in the Industry Online Support in 
the entry "PROFIenergy - Saving Energy with SIMATIC S7 (http://
support.automation.siemens.com/WW/view/en/41986454)".

See also
Service and Support (http://support.automation.siemens.com/)

IO controller

PE_START_END: Start and exit energy-saving mode

Description       
The instruction "PE_START_END" is used to start and exit the energy-saving mode of a 
specified PE entity (e.g. ET 200S). 

The instruction "PE_START_END" is used in the PE controller, preferably when only field 
devices from which energy data does not need to be read out are connected to the 
corresponding PE devices. Alternatively, the instruction "PE_CMD (Page 2397)" can be used 
to read energy data.
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The energy-saving modes are configured in the user program of the PE controller. On 
completion of the "PE_START_END" instruction, the PE entity reports its current energy-saving 
mode and outputs this data at parameter PE_MODE_ID.

Write and read jobs of the "PE_START_END" instruction.
The instruction "PE_START_END" sends a PROFIenergy command internally as a write job 
to the PE entity using "WRREC (Page 2323)". "PE_START_END" then waits for 
acknowledgement from the PE entity. The acknowledgement data record is read with the 
instruction "RDREC (Page 2321)" every 100 milliseconds. Until acknowledgment is received 
from the PE entity, the function repeats the read job for 10 seconds at intervals of 
100 milliseconds. The response data returned by the PE entity is also read with the instruction 
"RDREC (Page 2321)".

Below is a flowchart of the write and read jobs:
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Parameter
The following table shows the parameters of the instruction "PE_START_END":

Parameter Declaration Data type Memory area Description
START Input BOOL I, Q, M, D, L or 

constant
Transmitting the PE command "Start_Pause" 
to the PE entity with the address set at 
parameter ID.

END Input BOOL I, Q, M, D, L or 
constant

Transmitting the PE command "End_Pause" 
to the PE entity with the address set at 
parameter ID.

ID Input HW_
SUBMODULE

I, Q, M, D, L or 
constant

Address of the PE entity (e.g., ET 200S). The 
address may be taken from the hardware 
configuration.

PAUSE_TIME Input TIME I, Q, M, D, L or 
constant

Planned pause duration.
● Range:

T#1MS to T#24D20H31M23S647MS
● Start value:

T#0MS
VALID Output BOOL I, Q, M, D, L PE command successfully sent.
BUSY Output BOOL I, Q, M, D, L PE command still being processed.
ERROR Output BOOL I, Q, M, D, L Error occurred during processing. The error 

message is output at the STATUS parameter.
STATUS Output DWORD I, Q, M, D, L Block status / error number (see "STATUS 

parameter")
PE_MODE_ID Output BYTE I, Q, M, D, L Identification number of energy-saving mode 

(energy-saving level for the duration of the 
pause).

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

PAUSE_TIME parameter
The parameter PAUSE_TIME is used to set the default duration of the energy-saving period 
at the PE entity. The PE entity checks whether the pause period is of sufficient length and 
whether it can be implemented. The minimum pause duration (Time_min_Pause) must be 
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greater than the sum of the times the device needs to switch to energy-saving mode 
(Time_to_Pause) and to switch back to operating mode (Time_to_Operate).

ET 200S checks whether the scheduled pause duration is greater than or equal to the minimum 
pause duration (PM-E_Pause_Min) saved on the ET 200S. This is fixed at 10 seconds. If a 
shorter pause is used, the power modules (PM-E) of the ET 200S will remain on.

The module does not switch back on automatically at the end of the pause; it remains in OFF 
mode until the "END" command is sent. This prevents uncoordinated switch-on, which can 
cause undesired peak loads.

STATUS parameter
Error information is output at the STATUS output parameter. If it is interpreted as 
ARRAY[1...4] of BYTE, the error information has the following structure:

Field element Name Meaning
STATUS[1] Function_Num Cause of the error

● B#16#00: No error
● B#16#DE: Error during reading of data record
● B#16#DF: Error during writing of data record
● B#16#C0: Error message from the instruction or from the communication 

instructions "RDREC (Page 2321)" and "WRREC (Page 2323)" used internally.
STATUS[2] Error_Decode Location of the error ID

● 80: DPV1 error as defined in IEC 61158-6 or application-specific
● FE: DP/PNIO profiles - PROFIenergy-specific error
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Field element Name Meaning
STATUS[3] Error_Code_1 Error ID

● When Error_Decode = 80:
– 80: Simultaneous rising edge at the input parameters START and END.
– 81: Length conflict at the CMD_PARAM and CMD_PARAM_LEN 

parameters.
– 82-8F: Other error messages (reserved)

● When Error_Decode = FE:
– 01: "Service Request ID" invalid
– 02: Incorrect "Request_Reference"
– 03: "Modifier" invalid
– 04: "Data Structure Identifier RQ" invalid
– 05: "Data Structure Identifier RS" invalid
– 06: "PE energy-saving modes" are not supported
– 07: "Response" is too long (maximum transmissible length exceeded)
– 08: "Count" invalid
– 50: No suitable "energy mode" is available.
– 51: Time value specified is not supported.
– 52: "PE_Mode_ID" invalid

STATUS[4] Error_Code_2 Manufacturer-specific error ID extension
 

 Note
Error messages of the instructions RDREC and WRREC

The instruction "PE_START_END" uses the instructions "WRREC (Page 2323)" and 
"RDREC (Page 2321)" for communication. Error messages for these instructions are output 
in the field elements STATUS[1] to STATUS[4].

Please see the description of the corresponding STATUS (Page 2330) parameter for an 
explanation of the error codes of the "WRREC (Page 2323)" and "RDREC (Page 2321)" 
instructions.

 

See also
Description of PROFIenergy (Page 2391)

PE_CMD: Start and exit energy-saving mode / Read out status information

Description
The instruction "PE_CMD" is used in the PE controller to start or terminate a pause in the 
energy-saving mode in the PE entity. Additional information and energy measurements can 
also be read out from a PE entity using "PE_CMD".

The instruction is best used with PE controllers to which assigned PE devices are connected 
from which energy measurements are to be read out. If this is not the case, the instruction 
"PE_START_END (Page 2393)" can also be used to start and end the pauses.
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Transfer of the PROFIenergy commands (PE commands)
The instruction "PE_CMD" transfers a PROFIenergy command to a PE entity.

The instruction can also be used if additional commands are to be added to the PROFIenergy 
profile in future. The commands which can be used with the current PROFIenergy profile are 
listed in the description of the CMD and CMD_MODIFIER parameters (see the "CMD and 
CMD_MODIFIER parameters" table).

● The individual PE commands which are transferred to the PE entity using the instruction 
are assigned defined "Service_Request_IDs". The Service_Request_IDs 01 to 05 and 16 
are assigned at the CMD parameter.

● The two PE commands 04 (Query_Modes) and 16 (Query_Measurement) are defined in 
more detail with the CMD_MODIFIER parameter.

● Additional values are transferred at the CMD_PARA parameter for individual PE commands 
(see the description of the individual PE commands). The parameter CMD_PARA_LEN 
defines the length of the data at the parameter CMD_PARA.

The commands are transferred without plausibility test. The response data of the PE entity is 
saved to the RESPONSE_DATA data area that is addressed by VARIANT pointer (for 
information about the response frame contents, refer to the description of the respective PE 
command).

Write and read jobs of the "PE_CMD" instruction.
The instruction "PE_CMD" uses "WRREC (Page 2323)" internally to transmit a PROFIenergy 
command as a write job to the PE entity. "PE_CMD" then waits for acknowledgement from the 
PE entity. The acknowledgement data record is read with the instruction "RDREC 
(Page 2321)" every 100 milliseconds. Until acknowledgment is received from the PE entity, 
the function repeats the read job for 10 seconds at intervals of 100 milliseconds. The response 
data of the PE entity is also read with the instruction "RDREC (Page 2321)".

Below is a flowchart of the write and read jobs:
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Parameter
The following table shows the parameters of the instruction "PE_CMD":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts transferring the PE command upon 
a positive edge.

ID Input HW_
SUBMODULE

I, Q, M, D, L or 
constant

Address of the PE entity
For PROFINET IO devices, you can apply 
the address from the hardware 
configuration.

CMD Input BYTE I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command in accordance with the 
PROFIenergy profile (see "CMD and 
CMD_MODIFIER parameters").
Further service request IDs are possible 
following extensions of the PROFIenergy 
profile.
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Parameter Declaration Data type Memory area Description
CMD_MODIFIER Input BYTE I, Q, M, D, L or 

constant
PROFIenergy sub-command
(only when CMD=3 or CMD=16, see 
"CMD and CMD_MODIFIER parameters")
Further sub-commands are possible 
following extensions of the PROFIenergy 
profile.

CMD_PARA Input VARIANT I, Q, M, D, L Parameters for the PE commands:
● Get mode: PE_mode_ID
● Get measurement values: List of 

Measurement_Ids
The complete Service Data Request is 
entered.

CMD_PARA_LEN Input INT I, Q, M, D, L The actual length of the command 
parameters (<= length defined in 
CMD_PARA; is verified by the instruction).

RESPONSE_DATA InOut VARIANT I, Q, M, D, L PROFIenergy information 
May be complete response frame 
including block header, depending on the 
command.
Note: If the buffer is too small, only the 
number of bytes which is specified in the 
VARIANT pointer will be entered.

VALID Output BOOL I, Q, M, D, L Command successfully sent.
BUSY Output BOOL I, Q, M, D, L Command still being processed.
ERROR Output BOOL I, Q, M, D, L Error occurred during processing.
STATUS Output DWORD I, Q, M, D, L Block status / error number (see 

"STATUS parameter"):

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters CMD and CMD_MODIFIER

CMD CMD_
MODIFIER

PROFIenergy command Description

01 0 Start_Pause (Page 2405) Start energy-saving mode or switch to a different energy-
saving mode.

02 0 End_Pause (Page 2405) End energy-saving mode.
03 1 Query_Modes - List of energy-

saving modes (Page 2406) 
Output the energy-saving modes supported.

2 Query_Modes - Get mode 
(Page 2407) 

Output attributes of the energy-saving mode currently 
enabled.

04 0 PEM_Status (Page 2409) Query status of energy-saving mode.
05 0 PE_Identify (Page 2410) Read out the number and description of PE commands 

supported.
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CMD CMD_
MODIFIER

PROFIenergy command Description

16 1 Query_Measurement - 
Get_Measurement_List 
(Page 2411) 

List the measured values supported by the PE entity.

2 Query_Measurement - 
Get_Measurement_Values 
(Page 2413) 

Output the measured values of the PE entity.

STATUS parameter
Error information is output at the STATUS output parameter. If it is interpreted as 
ARRAY[1...4] of BYTE, the error information has the following structure:

Field element Name Meaning
STATUS[1] Function_Num Cause of the error

● B#16#00: No error
● B#16#DE: Error during reading of data record
● B#16#DF: Error during writing of data record
● B#16#C0: Error message from the internal communication instructions 

"RDREC (Page 2321)" and "WRREC (Page 2323)".
STATUS[2] Error_Decode Location of the error ID

● 80: DPV1 error as defined in IEC 61158-6 or application-specific
● FE: DP/PNIO profiles - PROFIenergy-specific error

STATUS[3] Error_Code_1 Error ID
● When Error_Decode = 80:

– 81: Length conflict at the CMD_PARA and CMD_PARA_LEN parameters, 
or maximum data record length (4095 bytes) exceeded.

– 82-8F: Other error messages (reserved)
● When Error_Decode = FE:

– 01: "Service Request ID" invalid
– 02: Incorrect "Request_Reference"
– 03: "Modifier" invalid
– 04: "Data Structure Identifier RQ" invalid
– 05: "Data Structure Identifier RS" invalid
– 06: "PE energy-saving modes" are not supported
– 07: "Response" is too long (maximum transmissible length exceeded)
– 08: "Count" invalid
– 50: No suitable energy-saving mode (energy mode) is available.
– 51: Time value specified is not supported.
– 52: "PE_Mode_ID" invalid

STATUS[4] Error_Code_2 Manufacturer-specific error ID extension
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 Note
Error messages of the instructions RDREC and WRREC

The "PE_CMD" instructions use the "WRREC (Page 2323)" and "RDREC (Page 2321)" 
instructions for communication. Error messages for these instructions are output in the field 
elements STATUS[1] to STATUS[4].

Please see the description of the corresponding STATUS (Page 2330) parameter for an 
explanation of the error codes of the "WRREC (Page 2323)" and "RDREC (Page 2321)" 
instructions.

 

See also
Description of PROFIenergy (Page 2391)

PE_DS3_Write_ET200S: Set power module switching behavior

Description
The instruction "PE_DS3_Write_ET200S" sends basic settings for power module switching 
behavior to the ET 200S. The switching behavior of up to 8 slots in the ET 200S (e.g. for power 
modules) can be defined with the instruction "PE_DS3_Write_ET200S".

 

 Note

This instruction is not part of the PROFIenergy profile, but supplements SIMATIC-specific 
functions.

 

Parameter
The following table shows the parameters of the instruction "PE_DS3_Write_ET200S":

Parameter Declaration Data type Memory area Description
ENABLE Input BOOL I, Q, M, D, L or 

constant
A positive edge triggers the transfer of the data 
record. The data record must be transferred 
again after voltage OFF/ON.

ID Input HW_SUBMODU
LE

I, Q, M, D, L or 
constant

Address of the ET 200S
The address may be taken from the hardware 
configuration.

SLOT_NO_X Input INT I, Q, M, D, L or 
constant

Slot number of switchable power module X.
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Parameter Declaration Data type Memory area Description
FUNC_X Input INT I, Q, M, D, L or 

constant
Function of the module in this slot. The 
switching behavior of the PM-E (ET 200S 
power module) is defined using the FUNC_X 
parameter:
● FALSE:

– With "PAUSE_START":
-No effect on PM-E
-PM-E remains on

– With "PAUSE_STOP":
-Switches PM_E back on

● TRUE:
– With "PAUSE_START":

-Switches PM_E off
– With "PAUSE_STOP":

-Switches PM-E back on
BUSY Output BOOL I, Q, M, D, L Transfer not yet complete.
DONE Output BOOL I, Q, M, D, L Transfer completed without errors.
ERROR Output BOOL I, Q, M, D, L Transfer completed with error.
STATUS Output DWORD I, Q, M, D, L Error number (see STATUS parameter of the 

instruction "PE_Start_End (Page 2393)")

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

See also
Description of PROFIenergy (Page 2391)

PROFIenergy commands

Structure of the message frames

Structure of the response frame in accordance with the PROFIenergy profile
The table below shows the basic structure of the response frame in accordance with the 
PROFIenergy profile. The response frame consists of a general section (Header) and a specific 
section (Service Data Response). The contents of the specific section of the response frame 
can be found in the description of the relevant PROFIenergy command.

Block definition Attributes Value Data type Description
BlockHeader BlockType 801 hex WORD  

BlockLength  WORD Number of bytes without consideration of 
the fields BlockType and BlockLength.

BlockVersionHigh 1 hex BYTE  
BlockVersionLow 0 hex BYTE  
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Block definition Attributes Value Data type Description
Response Header Service_Request_ID 1hex to FF hex BYTE ID of the PI command executed. The ID of 

the PE command processed by the PE 
entity is returned in the response frame:
● 01: Start_Pause
● 02: End_Pause
● 03: Query_Modes
● 04: PEM_Status
● 05: PE_Identify
● 06 to 09: Reserved
● 16: Query_Measurement
● 11 to CF: Reserved
● D0 to FF: Manufacturer-specific

Request_Reference 1hex to FF hex BYTE Unique number to identify the query/
response pair (returned by the server in the 
response).

Service Header 
Response

Status 1hex to FF hex BYTE Information whether or not the PI command 
was executed:
● 00: Reserved
● 01: Completed
● 02: Completed with error
● 03: Data incomplete
● 04 to CF: Reserved
● D0 to FF: Depends on the 

Service_Request_ID
Data_Structure_
Identifier_RS

1hex to FF hex BYTE ● 00: Reserved
● 01 to FF: Data structure depends on the 

Service_Request_ID
● 0xFF - Error

Service Data 
Response

   Depends on the Service-Request-ID:
● For the service request IDs, see the 

CMD and CMD_MODIFIER parameters 
of the instruction "PE_CMD 
(Page 2397)".

● The specific contents of the response 
frame can be found in the description of 
the PE command (see for example the 
"Start_Pause (Page 2405)" command).
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PI Command "Start_Pause"

Description
Use the PE command "Start_Pause" to start the energy-saving mode. The command 
Start_Pause can be used to:

● Switch the PE from "ready" state (PE_ready_to_operate) to an energy-saving mode 
(PE_energy_saving_mode).

● The PE entity can automatically switch between the energy-saving modes.
Energy consumption can increase or decrease when you switch energy-saving mode.

Calling the PI command "Start_Pause"
The command "Start_Pause" is called with the instruction "PE_CMD (Page 2397)" with the 
following parameters:

Parameter Value Description
CMD 1 Call of PE command "Start_Pause".
CMD_MODIFIER 0 There are no additional specifications of the command call for 

command "Start_Pause".
CMD_PARA_LEN 4 Length of the CMD_PARA parameter of 4 bytes.
CMD_PARA VARIANT VARIANT pointer to the value for "Pause_Time" (TIME).

Response frame (Service Data Response)
The following response frame data of the PE entity is written to the data block that is referenced 
at parameter RESPONSE_DATA (see instruction "PE_CMD (Page 2397)"):

Attribute Value Data type Description
PE_Mode_ID 1 to 255 BYTE Identification number of the energy-saving 

mode
Reserved 0 BYTE -

 

PI Command "End_Pause"

Description
The PE command "End_Pause" is used to end the energy-saving mode of the PE entity.
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Calling the PE command "End_Pause"
The command "End_Pause" is called with the instruction "PE_CMD (Page 2397)" with the 
following parameters:

Parameter Value Description
CMD 2 Call of PE command "End_Pause".
CMD_MODIFIER 0 There are no additional specifications of the command call for 

command "End_Pause".
CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -

Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2397)"):

Attribute Value Data type Description
Time_to_operate - DWORD Expected time it takes to switch to the 

"PE_ready_to_operate" mode.

PI command "Query_modes" - "List_Energy_Saving_Modes"

Description
Use PE command "Query_modes" and sub-command (modifier) "List_Energy_Saving_Modes" 
to output all energy-saving modes (PE_Mode_ID) supported by the PE entity.

The query result is written in the form of a response frame to the data block referenced by 
theRESPONSE_DATA parameter. 

Calling the PE command "Query_modes" - "List_Energy_Saving_Modes"
The command "List_Energy_Saving_Modes" is called with the instruction "PE_CMD 
(Page 2397)" with the following parameters:

Parameter Value Description
CMD 3 Call of PE command "Query_modes".
CMD_MODIFIER 1 Specification of the command call: Select the sub-command 

"List_Energy_Saving_Modes" to output the number and types 
of energy-saving modes supported.

CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -
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Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2397)"):

Attribute Value Data type Description
Number_of_PE_
Mode_IDs

1 BYTE The number of energy-saving modes.

PE_Mode_IDs - Array [...] of 
BYTE

Array with the IDs of the supported energy-
saving modes. The meaning of the 
individual IDs depends on the PE entity.

 

PI command "Query_modes" - "Get_Mode"

Description
You use the PE command "Query_modes" and the sub-command (modifier) "Get_Mode" to 
output the attributes of the energy-saving mode which is currently enabled.

Calling the PE command "Query_modes" - "Get_Mode"
The call of the command with the instruction "PE_CMD" occurs with the following parameters:

Parameter Value Description
CMD 3 Call of the PE command "Query_modes"
CMD_MODIFIER 2 Specification of the command call: Select the sub-command "Get_Mode" to output 

the status of the mode which is currently enabled.
CMD_PARA_LEN 1 Length of the CMD_PARA parameter of 1 byte.
CMD_PARA VARIANT VARIANT pointer to the value for PE_MODE_ID.
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Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2397)"):

Attribute Value Data type Description
PE_Mode_ID ● 0

"PE_power_off" mode
● 1...254 

Energy-saving mode of the PE 
entity (manufacturer-specific)

● 255
"PE_ready_to_operate" mode

BYTE ID of the energy-saving mode currently 
enabled.

PE_Mode_Attributes Bit 0:
● = 0: Only static energy consumer 

and time values are available.
● = 1: Dynamic energy consumer 

and time values are available.
Bit 1 to 7:
● Reserved

BYTE  

Time_min_Pause 1 Time difference without date DWORD Minimum pause time for the PI mode. The 
minimum pause time is the sum of the 
values of the following attributes:
● Time_to_Pause
● Time_to_operate
● Time_min_length_of_stay
See the description "PAUSE_TIME 
parameter" of the instruction 
"PE_START_END: Start and exit energy-
saving mode (Page 2393)".

Time_to_Pause 1 Time difference without date DWORD Switch off time: Duration from call of 
energy-saving mode to start of energy-
saving mode (transition duration of 
PE_ready_to_operate to 
PE_energy_saving_mode). The switch-off 
time depends on the PE entity.

Time_to_operate 1 Time difference without date DWORD Switch-on time: Duration of the transition 
from energy-saving mode 
(PE_energy_saving_mode) to ready to 
operate mode (PE_ready_to_operate).
The PE entity calculates the duration 
dynamically in the output operation.

Time_min_length_
of_stay 1

 DWORD Minimum active period of the energy-
saving mode on the PE entity.

Time_max_length_
of_stay 1

 DWORD Maximum active period of the energy-
saving mode on the PE entity.

Mode_Power_
Consumption 2

 REAL Power consumption of the PE entity in 
active energy-saving mode.
Unit: kW
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Attribute Value Data type Description
Energy_
Consumption_
to_pause 2

 REAL Energy consumption of the PE entity 
during transition from ready-to-operate 
mode (PE_ready_to_operate) to energy-
saving mode (PE_energy_saving_mode)
Unit: kWh

Energy_
Consumption_
to_operate 2

 REAL Energy consumption of the PE entity 
during transition from energy-saving mode 
(PE_energy_saving_mode) to ready-to-
operate mode (PE_ready_to_operate) 
Unit: kWh

1 If the duration is infinite, 0xFFFFFFFF will be output. If the duration is zero, "0" will be output.
2 If the data for energy and power consumption is not defined by the PE entity, "0.0" will be output as the value.

PI command "PEM_Status"

Description
The PE command "PEM_Status" is used to query the status of a PE entity energy-saving mode 
that is currently enabled.

Calling the PE command "PEM_Status"
The command "PEM_Status" is called with the instruction "PE_CMD" with the following 
parameters:

Parameter Value Description
CMD 4 Call of PE command "PEM_Status".
CMD_MODIFIER 0 There are no other specifications of the command call for command 

"PEM_Status".
CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -
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Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2397)"):

Attribute Value Data type Description
PE_Mode_ID_
Source

● 0
"PE_power_off" mode

● 1 to 254
Energy-saving mode of the PE 
entity (manufacturer-specific)

● 255
"PE_ready_to_operate" mode

BYTE Mode of the PE entity before a PE 
command is sent.

PE_Mode_ID_
Destination

● 0
"PE_power_off" mode

● 1 to 254
Energy-saving mode of the PE 
entity (manufacturer-specific)

● 255
"PE_ready_to_operate" mode

BYTE Mode of the PE entity after a PE 
command is executed.

Time_to_operate Time difference without date DWORD Switch-on time: Duration of the transition 
from energy-saving mode 
(PE_energy_saving_mode) to ready to 
operate mode (PE_ready_to_operate).
The PE entity calculates the duration 
dynamically during output.

Remaining_time_to_
destination

Time difference without date DWORD Remaining time to switch to another 
mode.

Mode_Power_
Consumption

 REAL Power consumption of the PE entity in 
active energy-saving mode.
Unit: kW

Energy_
Consumption_
to_Destination

 REAL Energy consumption for the current PI 
transition
Unit: kWh

Energy_
Consumption_
to_operate

 REAL Energy consumption of the PE entity 
during transition from energy-saving 
mode (PE_energy-saving mode) to ready-
to-operate mode (PE_ready_to_operate) 
Unit: kWh

 

PI command "PE_Identify"

Description
The PE command "PE_Identify" is used to read out the number and description of PE 
commands supported by the PE entity. The number of specific commands supported depends 
on the PE entity. As PE_Identify is itself a PE command, at least three supported PE commands 
will be output upon a positive response: Start_Pause, End_Pause and PE_Identify.
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Calling the PE command "PE_Identify"
The command "PE_Identify" is called with the instruction "PE_CMD (Page 2397)" with the 
following parameters:

Parameter Value Description
CMD 5 Call of the command "PE_Identify".
CMD_MODIFIER 0 There are no other specifications of the command call for command 

"PE_Identify".
CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -

Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2397)"):

Attribute Value Data type Description
Count 1 6 BYTE Number of supported PROFIenergy commands
Start_Pause 1 BYTE First PE command supported (Service_Request_ID)
End_Pause 2 BYTE ...
Query_Modes 3 BYTE ...
PEM_Status 4 BYTE ...
PE_Identify 5 BYTE ...
Query_Measurement 16 BYTE Last PE command supported (Service_Request_ID)
1 The number of commands supported is manufacturer-specific and depends on the PE entity used. The values given are 
an example of a response frame where all 6 PE commands are supported.

 

PI Command "Query_Measurement" - "Get_Measurement_list"

Description
Use the PE command "Query_Measurement" and sub-command (modifier) 
"Get_measurement_list" to query the specific measured values supported by the PE entity. 
The supported measured values are output as a list in the data block referenced by the 
RESPONSE_DATA parameter.
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Calling the PE command "Query_Measurement" - "Get_Measurement_list"
The command is called with the instruction "PE_CMD (Page 2397)" with the following 
parameters:

Parameter Value Description
CMD 16 Call of the command "Query_Measurement".
CMD_MODIFIER 1 Specification of the command call: Select the sub-command 

"Get_Measurement_List" to output a list of supported measured values.
CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -

Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2397)"):

Attribute Value Data type Description
Count - BYTE Number of measurement IDs
reserved - BYTE  
...    
Measurement_ID - WORD First supported Measurement_ID The Measurement_ID is 

manufacturer-specific. For more information, refer to the manual of 
the respective PE entity.

Accuracy_Domain - BYTE See "accuracy domain" table.
Accuracy_Class - BYTE See "accuracy classes" table.
Range - REAL Specifies the scale end value of the measured value (only for 

accuracy domain 1). The attribute range uses the same unit as 
defined using attribute Measurement_ID (only one unit is used for 
each Measurement_ID). 

...    
Measurement_ID - WORD Last supported Measurement_ID
Accuracy_Domain - BYTE See "accuracy domain" table.
Accuracy_Class - BYTE See "accuracy classes" table.
Range - REAL Specifies the scale end value of the measurement value (only for 

accuracy domain 1). The attribute range uses the same unit as 
defined using attribute Measurement_ID (only one unit is used for 
each Measurement_ID).

Accuracy domains

Accuracy domain Description
0 Reserved
1 The accuracy deviation is output in percentages of the scale end value. The percentage of the 

possible deviation is divided into accuracy classes (see table: Accuracy classes of the accuracy 
domains 1 and 2).
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Accuracy domain Description
2 The accuracy deviation is output in percentages of the current measurement value. The percentage 

of the possible deviation is divided into accuracy classes (see table: Accuracy classes of the accuracy 
domains 1 and 2).

3 The measuring accuracy adheres to the standard IEC 61557-12. 
The function performance classes for performance measurement and monitoring devices (PMD) 
without external sensors, and the system performance classes for PMD with external sensors, are 
coded as set out in the "Accuracy classes of accuracy domain 3" table.

4 The entry of the accuracy adheres to the standard EN 50470-3, chapter 8 (see also table: Accuracy 
classes of accuracy domain 4).

Accuracy classes

Table 9-54 Accuracy classes of the accuracy domains 1 and 2

Accuracy class 0 1 2 3 4 5 6 7 8
Meaning Reserved 0.01% 0.02% 0.05% 0.1% 0.2% 0.5% 1% 1.5%
 
Accuracy class 9 10 11 12 13 14 15 >15
Meaning 2% 2.5% 3% 5% 10% 20% >20% Not defined

 

Table 9-55 Accuracy classes of accuracy domain 3

Accuracy class 0 1 2 3 4 5 6 7 8
Meaning Reserved 0,02 0,05 0,1 0,2 0,5 1 1,5 2
 
Accuracy class 9 10 11 12 13 14 >13
Meaning 2,5 3 5 10 20 20% Not defined

 

Table 9-56 Accuracy classes of accuracy domain 4

Accuracy class 0 1 2 3 4 5 6 >7
Meaning Reserved 0,5 1,0 1,5 2,0 2,5 3,0 Not defined

 

PI Command "Query_Measurement" - "Get_Measurement_values"

Description
Use the PE command "Query_Measurement" and sub-command (modifier) 
"Get_measurement_values" to output a list of measured values supported by the PE entity. 
The measured values are output as a list in the data block referenced by the 
RESPONSE_DATA parameter.
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Calling the PE command "Query_Measurement" - "Get_Measurement_values"
The command is called with the instruction "PE_CMD (Page 2397)" with the following 
parameters:

Parameter Value Description
CMD 16 Call of the command "Query_Measurement".
CMD_MODIFIER 2 Specification of the command call: Select the command 

"Get_Measurement_Values" to output a list of supported measurement values.
CMD_PARA_LEN 0 Depends on the number of measurement values. The length of the parameters 

results from the attribute count and the sum of the lengths of the attributes for the 
transferred measurement values.

CMD_PARA VARIANT VARIANT pointer to data structure with list of measured values to be queried (see 
"CMD_PARA parameter").

 

Parameter CMD_PARA

The structure specified with the VARIANT pointer at the CMD_PARA parameter must have 
the following setup:

Attribute Value Data type Description
Count - BYTE Number of measured values (Measurement-IDs)
reserved 0 BYTE Not used
Measurement_ID - WORD First measured value queried
...    
Measurement_ID - WORD Last measured value queried

Response frame (Service Data Response)
The following response frame data of the PE entity is written to the data block that is referenced 
at parameter RESPONSE_DATA (see "PE_CMD (Page 2397)"):

Attribute Value Data type Description
Count 1 - BYTE Number of measured values (Measurement-IDs)
reserved 0 BYTE Not used
    
Length_of_Structure 2 to 65535 WORD Length of the structure in bytes
Measurement_Data_
Structure_ID

1 = simple value BYTE Defines the following structure.

Measurement_ID 0 to 65535 WORD ID of the supported measurement value.
Status_of_
Measurement_Value

1 to 3 BYTE Status of the measurement value:
● 1: Valid
● 2: Not supported
● 3: Invalid

Transmission_Data_
Type

- REAL  
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Attribute Value Data type Description
End_of_demand - TOD Optional time stamping with data type TimeOfDay.
...    
Length_of_Structure - WORD Length of the structure in bytes
Measurement_Data_
Structure_ID

- BYTE Defines the following structure.

Measurement_ID - WORD ID of the supported measurement value.
Status_of_Measurem
ent_Value

- BYTE Status of the measurement value:
● 1: Valid
● 2: Not supported
● 3: Invalid

Transmission_Data_
Type

- REAL  

End_of_demand - TOD Optional time stamping with data type TimeOfDay.
1 If the data length of the measurement values queried exceeds the size of the PDU (Protocol Data Unit) of the protocol layer, 
the data will not be completely transferred and only the supported measurement values will be output.

iDevice / iSlave

PE_I_DEV: Control PROFIenergy commands in the I-Device

Description
The instruction "PE_I_DEV" is used to process the PROFIenergy profile in the intelligent IO 
device (iDevice). The functions which are executed by the firmware in standard PROFIenergy-
compatible IO devices, such as the ET 200S, are implemented in the iDevice by the instruction 
"PE_I_DEV" and the corresponding auxiliary blocks:

● The instruction "PE_I_DEV" is called cyclically by the user program of the iDevice and 
receives all PROFIenergy commands.

● The PROFIenergy response is generated by configuring an auxiliary block. The response 
in the pause is fully programmable. The response data must be provided within 10 seconds; 
otherwise, "State conflict 0x80B5" will occur at the STATUS parameter of the instruction in 
the IO controller.

No specific knowledge of the PROFIenergy standard is required to use the instruction. 
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PROFIenergy auxiliary blocks (PE auxiliary blocks)
The PE auxiliary blocks are used to generate the response frame. Enter the response data (in 
plain text) at the input parameters of the relevant block.

● For each PROFIenergy command, there is a corresponding auxiliary block for a positive 
response:

– PE command "Start_Pause": PE_Start_RSP (Page 2420)

– PE command "End_Pause": PE_End_RSP (Page 2421)

– PE command "Query_modes" - "List_Energy_Saving_Modes": PE_List_Modes_RSP 
(Page 2423)

– PE command "Query_modes" - "Get_Mode": PE_Get_Mode_RSP (Page 2424)

– PE command "PEM_Status": PE_PEM_Status_RSP (Page 2426)

– PE command "PE_Identify": PE_Identify_RSP (Page 2427)

– PE command "Query_Measurement" - "Get_Measurement_list": 
PE_Measurement_List_RSP (Page 2429)

– PE command "Query_Measurement" - "Get_Measurement_values": 
PE_Measurement_Value_RSP (Page 2430)

● Irrespective of the PROFIenergy command, there is an additional shared auxiliary block 
for a negative response (see PE_Error_RSP (Page 2419)).

Interconnection of the auxiliary blocks
The instruction "PE_I_DEV" and the auxiliary blocks are coordinated. Some of the parameters 
are simply interconnected. The diagram below shows which of the parameters need to be 
interconnected.
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Parameters
The following table shows the parameters of the instruction "PE_I_DEV":

Parameter Declaration Data type Memory area Description
RESET Input BOOL I, Q, M, D, L or 

constant
Resets the instruction.

ID Input DWORD I, Q, M, D, L Address of the iDevice
The address may be taken from the hardware 
configuration.

VALID Input BOOL I, Q, M, D, L The response data for the PROFIenergy 
controller is ready and can be sent.

CMD_PARA Output VARIANT I, Q, M, D, L Parameters for:
● Get mode: PE_mode_ID
● Get measurement values: List of 

Measurement_IDs (list of IDs of the tags to 
be read; either one tag or multiple tags may 
be read at any given time).

Maximum length: 234 bytes
DATA_ERRO
RRSP

InOut VARIANT I, Q, M, D, L Pointer to the data area containing the 
acknowledgement data for the PROFIenergy 
controller.
This must correspond to the pointer which is 
also used with the auxiliary blocks.

INDEX Output INT I, Q, M, D, L or 
constant

Data record number of the PROFIenergy 
record (set at 0x80A0)

CMD Output INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command in accordance with the 
PROFIenergy profile (see "CMD and 
CMD_MODIFIER parameters").
Further PE commands (Service-Request-IDs) 
are possible following extensions of the 
PROFIenergy profile.

CMD_
MODIFIER

Output INT I, Q, M, D, L or 
constant

PROFIenergy sub-command:
● Only when CMD=3 or CMD=16; see "CMD 

and CMD_MODIFIER parameters".
● For all other commands: "0".
Further sub-commands are possible following 
extensions of the PROFIenergy profile.

NEW Output BOOL I, Q, M, D, L New data available from the PROFIenergy 
controller.

ERROR Output BOOL I, Q, M, D, L Command completed with error.
STATUS Output DWORD I, Q, M, D, L Error information (see "STATUS parameter").

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameters CMD and CMD_MODIFIER

CMD CMD_
MODIFIER

PROFIenergy command Description

01 0 Start_Pause Start energy-saving mode or switch to a different energy-
saving mode.

02 0 End_Pause End energy-saving mode.
03 1 Query_Modes - List energy 

saving Modes 
Output the energy-saving modes supported.

2 Query_Modes - Get Mode Output attributes of the energy-saving mode currently 
enabled.

04 0 PEM_Status Query status of energy-saving mode.
05 0 PE_Identify Read out the number and description of PE commands 

supported.
16 1 Query_Measurement - 

Get_Measurement_List 
List of the measured values supported by the PE entity.

2 Query_Measurement - 
Get_Measurement_Values 

Output of the measured values of the PE entity.

STATUS parameter
Error information is output at the STATUS output parameter. If it is interpreted as 
ARRAY[1...4] of BYTE, the error information has the following structure:

Field element Name Meaning
STATUS[1] Function_Num Cause of the error

● B#16#00: No error
● B#16#DE: Error during reading of data record
● B#16#DF: Error during writing of data record
● B#16#C0: Error message from the instruction "PE_I_DEV" or from the internal 

communication instructions "RDREC (Page 2321)" and "WRREC (Page 2323)".
STATUS[2] Error_Decode Location of the error ID

● 80: DPV1 error as defined in IEC 61158-6 or application-specific
STATUS[3] Error_Code_1 Error ID (when Error_Decode = 80):

● B1: Write length error (error in write length or insufficient length information with 
the data type VARIANT).

STATUS[4] Error_Code_2 For PROFINET errors: Output of IO controller error message If no PROFINET error 
has occurred, the value in STATUS[4] = "0".
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 Note
Error messages of the instructions RDREC and WRREC

The instruction "PE_I_DEV" uses the instructions "WRREC (Page 2323)" and "RDREC 
(Page 2321)" for communication. Error messages for these instructions are output in the field 
elements STATUS[1] to STATUS[4].

Please see the description of the corresponding STATUS (Page 2330) parameter for an 
explanation of the error codes of the "WRREC (Page 2323)" and "RDREC (Page 2321)" 
instructions.

 

See also
Description of PROFIenergy (Page 2391)

Auxiliary blocks of the instruction PE_I_DEV

PE_Error_RSP: Generate negative answer to command

Description
The auxiliary block "PE_Error_RSP" (Response with failure) generates a negative response if 
the command requested is not supported (either in general or temporarily). Response 
generation does not depend on the command requested.

Parameter
The following table shows the parameters of the "PE_Error_RSP" auxiliary block:

Parameter Declaration Data type Initial value Description
PE_I_DEV_NEW Input BOOL 0 The parameter must be interconnected with 

output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

ERROR_CODE Input BYTE 0 Error number
ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 

the DATA_ERROR_RSP data area at a 
positive edge at input ACTIVATE. The 
parameter is then reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" 
instruction.
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Parameter Declaration Data type Initial value Description
VALID InOut BOOL 1 The parameter must be interconnected with 

input VALID of the "PE_I_DEV (Page 2415)" 
instruction. 
The parameter is set by the auxiliary block 
when the response data for the PROFIenergy 
controller is ready and can be sent.

DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL 0 ● "0": No error
● "1": Error occurred.

STATUS Output WORD 0 ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

PE_Start_RSP: Generate answer to command at start of pause

Description
The auxiliary block "PE_Start_RSP" (Start Pause) generates the response to the PE command 
Start_Pause (Page 2405). The instruction returns the energy-saving mode to which the device 
has switched (PE_MODE_ID parameter).

If the response differs depending on the length of the pause, you can return this fact in the 
feedback on the energy-saving mode (PE_Mode_ID = 1 for a brief pause, PE_Mode_ID = 2 
for a longer pause, etc.).

Parameter
The following table shows the parameters of the "PE_Start_RSP" auxiliary block:

Parameter Declaration Data type Initial value Description
PE_I_DEV_NE
W

Input BOOL 0 The parameter must be interconnected with 
output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT 0 Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
output parameter CMD of the "PE_I_DEV 
(Page 2415)" instruction.
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Parameter Declaration Data type Initial value Description
PE_MODE_ID Input BYTE 0 PE mode that the process assumes
ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 

the DATA_ERROR_RSP data area at a 
positive edge at input ACTIVATE. The 
parameter is then reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" 
instruction.

VALID InOut BOOL 1 The parameter must be interconnected to the 
VALID input of the instruction "PE_I_DEV 
(Page 2415)". 
The parameter is set by the auxiliary block 
when the response data for the PROFIenergy 
controller is ready and can be sent.

DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL 0 ● "0": No error
● "1": Error occurred.

STATUS Output WORD 0 ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

PE_End_RSP: Generate answer to command at end of pause

Description
Auxiliary block "PE_End_RSP" generates the response to PE command End_Pause 
(Page 2405). The response returned is the time required to switch from the current mode to 
"Ready_To_Operate" mode.
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Parameter
The following table shows the parameters of the "PE_End_RSP" auxiliary block:

Parameter Declaration Data type Initial value Description
PE_I_DEV_NEW Input BOOL 0 The parameter must be interconnected with 

output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT 0 Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
output parameter CMD of the "PE_I_DEV 
(Page 2415)" instruction.

Time_to_Operate Input DWORD 0 Time required to switch from the current mode 
to "Ready_To_Operate".

ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a 
positive edge at input ACTIVATE. The 
parameter is then reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" 
instruction.

VALID InOut BOOL 1 The parameter must be interconnected to the 
VALID input of the instruction "PE_I_DEV 
(Page 2415)". 
The parameter is set by the auxiliary block 
when the response data for the PROFIenergy 
controller is ready and can be sent.

DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL 0 ● "0": No error
● "1": Error occurred.

STATUS Output WORD 0 ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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PE_List_Modes_RSP: Generate queried energy savings modes as answer

Description
The auxiliary block "PE_List_Modes_RSP" generates the response to the PE command 
List_Energy_Saving_Modes (Page 2406). The response generated includes the number and 
the IDs of energy-saving modes supported.

Parameter
The following table shows the parameters of the "PE_List_Modes_RSP" auxiliary block:

Parameter Declaration Data type Initial value Description
PE_I_DEV_NEW Input BOOL 0 The parameter must be interconnected with 

output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT 0 Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
output parameter CMD of the "PE_I_DEV 
(Page 2415)" instruction.

CMD_MODIFIER Input INT 0 PROFIenergy sub-command (evaluated only if 
CMD=3, or CMD=16). The parameter must be 
interconnected to the CMD_MODIFIER output 
parameter of the instruction "PE_I_DEV".

Number_of_PE_
Mode_IDs

Input BYTE 0 Number of energy-saving modes supported.
Permitted values: 1 to 254

PE_MODE_ID Input VARIANT 0 Points to the area in which the IDs of the energy-
saving modes supported (PE_Mode_ID) are 
stored.
Valid range: 1 to 254.

ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a positive 
edge at input ACTIVATE. The parameter is then 
reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" instruction.

VALID InOut BOOL 1 The parameter must be interconnected to the 
VALID input of the instruction "PE_I_DEV 
(Page 2415)". 
The parameter is set by the auxiliary block when 
the response data for the PROFIenergy 
controller is ready and can be sent.
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Parameter Declaration Data type Initial value Description
DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL 0 ● "0": No error
● "1": Error occurred.

STATUS Output WORD 0 ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

PE_Get_Mode_RSP: Generate queried energy data as answer

Description
The auxiliary block "PE_Get_Mode_RSP" generates the response to the command 
Get_Mode (Page 2407). The response contains the times and the performance/energy data 
of the individual energy-saving states.

Parameter
The following table shows the parameters of the "PE_Get_Mode_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NEW Input BOOL 0 The parameter must be interconnected with 

output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT 0 Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
output parameter CMD of the "PE_I_DEV 
(Page 2415)" instruction.

CMD_MODIFIER Input INT 0 PROFIenergy sub-command (evaluated only if 
CMD=3, or CMD=16). The parameter must be 
interconnected to the CMD_MODIFIER output 
parameter of the instruction "PE_I_DEV".

PE_Mode_ID Input BYTE I, Q, M, D, L ID of the energy-saving mode currently 
enabled.
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Parameter Declaration Data type Memory area Description
Time_min_Pause Input DWORD I, Q, M, D, L Minimum pause duration for this PE energy-

saving mode.
This is the sum of the following three 
parameters:
● Time_to_Pause
● Time_to_operate
● Time_min_length_of_stay

Time_to_Pause Input DWORD I, Q, M, D, L Time between the edge at the START 
parameter (see "PE_I_DEV (Page 2415)") and 
the requested PE energy-saving mode being 
reached.

Time_to_Operate Input DWORD I, Q, M, D, L Maximum switch-on time to 
"PE_ready_to_operate". The 
"Time_to_operate" parameter can be used 
directly for the relevant calculations. The value 
may be a static maximum, or be calculated 
dynamically by the PE entity.

Time_min_Lenght_
of_stay

Input DWORD I, Q, M, D, L Minimum dwell time of the PE entity in this PE 
mode.

Time_max_Lenght_o
f_stay

Input DWORD I, Q, M, D, L Maximum dwell time of the PE entity in this PE 
mode.

Mode_Power_
Consumption

Input DWORD I, Q, M, D, L Energy consumption in the current PE mode in 
[kW].

Energy_Consum_
to_Pause

Input DWORD I, Q, M, D, L Energy consumption from 
"PE_ready_to_operate" to the current PE 
mode in [kWh].

Energy_Consum_
to_operate

Input DWORD I, Q, M, D, L Energy consumption from the current PE mode 
to "PE_ready_to_operate" in [kWh].

ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a 
positive edge at input ACTIVATE. The 
parameter is then reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" 
instruction.

VALID InOut BOOL 1 The parameter must be interconnected to the 
VALID input of the instruction "PE_I_DEV 
(Page 2415)". 
The parameter is set by the auxiliary block 
when the response data for the PROFIenergy 
controller is ready and can be sent.

DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL 0 ● "0": No error

● "1": Error occurred.
STATUS Output WORD 0 ● "0": No error

● "0x80B1": Error in VARIANT setting, e.g. 
incorrect range

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

PE_PEM_Status_RSP: Generate PEM status as answer

Description
The auxiliary block "PE_PEM_Status_RSP" generates the response to the command 
PEM_Status (Page 2409).

Parameter
The following table shows the parameters of the "PE_PEM_Status_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NEW Input BOOL 0 The parameter must be interconnected with 

output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT 0 Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
output parameter CMD of the "PE_I_DEV 
(Page 2415)" instruction.

PE_MODE_ID_
Source

Input BYTE I, Q, M, D, L Source and Destination for PEM_STATUS.
Values:
● 0x00: PE_POWER_OFF
● 0x01 – 0xFE: manufacturer-specific
● 0xFF: PE_READY_TO_OPERATE

PE_MODE_ID_
Destination

Input BYTE I, Q, M, D, L

Time_to_Operate1 Input DWORD I, Q, M, D, L Maximum switch-on time to 
"PE_ready_to_operate".
"Time_to_operate" can be used directly for the 
relevant calculations. The value may be a static 
maximum, or be calculated dynamically by the 
PE entity.

Remaining_time_
to_destination1

Input DWORD I, Q, M, D, L Optional: Time remaining until the requested PE 
mode. Dynamic value or static maximum value

Mode_Power_
Consumption2

Input DWORD I, Q, M, D, L Energy consumption in the current PE mode in 
[kW].
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Parameter Declaration Data type Memory area Description
Energy_
Consumption_
to_Destination2

Input DWORD I, Q, M, D, L Energy consumption in the time until the 
requested PE mode in [kW].

Energy_
Consumption_
to_operate2

Input DWORD I, Q, M, D, L Energy consumption from the current PE mode 
to "PE_ready_to_operate" in [kWh].

ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a positive 
edge at input ACTIVATE. The parameter is then 
reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" instruction.

VALID InOut BOOL 1 The parameter must be interconnected to the 
VALID input of the instruction "PE_I_DEV 
(Page 2415)". 
The parameter is set by the auxiliary block when 
the response data for the PROFIenergy 
controller is ready and can be sent.

DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL 0 ● "0": No error
● "1": Error occurred.

STATUS Output WORD 0 ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range
1 If the time period is unlimited, the maximum value "0xFFFFFFFF" can be specified. If the time period is "Zero", "0x00" can 
be used.
2 If no energy consumption value has been defined, "0.0" can be specified.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

PE_Identify_RSP: Generate supported PROFIenergy commands as answer

Description
The auxiliary block "PE_Identify_RSP" generates the response to the command PE_Identify 
(Page 2410). In the response to the command, specify which PROFIenergy commands are 
supported. Please note that PE_IDENTIFY is itself a PE command and has to be included in 
the response.
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Parameter
The following table shows the parameters of the "PE_Identify_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NE
W

Input BOOL 0 The parameter must be interconnected with 
output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT 0 Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
output parameter CMD of the "PE_I_DEV 
(Page 2415)" instruction.

Start_Pause Input BOOL I, Q, M, D, L One parameter for each of the relevant 
PROFIenergy commands:
● 0: PE command is not supported
● 1: PE command is supported

End_Pause Input BOOL I, Q, M, D, L
Query_Modes Input BOOL I, Q, M, D, L
PEM_Status Input BOOL I, Q, M, D, L
PE_Identify Input BOOL I, Q, M, D, L
Query_
Measurement

Input BOOL I, Q, M, D, L

ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a 
positive edge at input ACTIVATE. The 
parameter is then reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" 
instruction.

VALID InOut BOOL 1 The parameter must be interconnected to the 
VALID input of the instruction "PE_I_DEV 
(Page 2415)". 
The parameter is set by the auxiliary block 
when the response data for the PROFIenergy 
controller is ready and can be sent.

DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL 0 ● "0": No error
● "1": Error occurred.

STATUS Output WORD 0 ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2428 System Manual, 07/2013,  



PE_Measurement_List_RSP: Generate list of supported measured values as answer

Description
The auxiliary block "PE_Measurement_List_RSP" generates the response to the command 
Get_measurement_list (Page 2411). In the response, specify which measured values 
(Measurement-IDs) are supported.

Parameter
The following table shows the parameters of the "PE_Measurement_List_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NE
W

Input BOOL 0 The parameter must be interconnected with 
output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT 0 Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
output parameter CMD of the "PE_I_DEV 
(Page 2415)" instruction.

CMD_MODIFIE
R

Input INT 0 PROFIenergy sub-command (evaluated only 
if CMD=3, or CMD=16). The parameter must 
be interconnected to the CMD_MODIFIER 
output parameter of the instruction 
"PE_I_DEV".

Count Input BYTE I, Q, M, D, L Number of measured values supported 
(measurement IDs)

Measurement_
List

Input VARIANT D Pointer to the array with the Measurement_IDs 
supported.
For information on the structure of the array in 
accordance with the PROFIenergy profile, 
please see: PI Command 
"Query_Measurement" - 
"Get_Measurement_list" (Page 2411) 

ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a 
positive edge at input ACTIVATE. The 
parameter is then reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" 
instruction.

VALID InOut BOOL 1 The parameter must be interconnected to the 
VALID input of the instruction "PE_I_DEV 
(Page 2415)". 
The parameter is set by the auxiliary block 
when the response data for the PROFIenergy 
controller is ready and can be sent.
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Parameter Declaration Data type Memory area Description
DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL 0 ● "0": No error
● "1": Error occurred.

STATUS Output WORD 0 ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

PE_Measurement_Value_RSP: Generate queried measured values as answer

Description   
The auxiliary block "PE_Measurement_Value_RSP" generates the response to the command 
Get_measurement_values (Page 2413). In the response, return the values of the requested 
measurements.

Parameter
The following table shows the parameters of the "PE_Measurement_Value_RSP" auxiliary 
block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NE
W

Input BOOL 0 The parameter must be interconnected with 
output parameter NEW of the "PE_I_DEV 
(Page 2415)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT 0 Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
output parameter CMD of the "PE_I_DEV 
(Page 2415)" instruction.

CMD_MODIFIE
R

Input INT 0 PROFIenergy sub-command (evaluated only if 
CMD=3, or CMD=16). The parameter must be 
interconnected to the CMD_MODIFIER output 
parameter of the instruction "PE_I_DEV".

Count Input BYTE I, Q, M, D, L Number of measured values 
(Measurement_Values).
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Parameter Declaration Data type Memory area Description
Measurement_V
alues

Input VARIANT D Pointer to the array with the measured values 
(Measurement_IDs).
For information on the structure of the array in 
accordance with the PROFIenergy profile, 
please see PI Command "Query_Measurement" 
- "Get_Measurement_values" (Page 2413) 

ACTIVATE InOut BOOL 0 The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a positive 
edge at input ACTIVATE. The parameter is then 
reset by the instruction.
The parameter must be set within 10 seconds 
after a positive edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2415)" instruction.

VALID InOut BOOL 1 The parameter must be interconnected to the 
VALID input of the instruction "PE_I_DEV 
(Page 2415)". 
The parameter is set by the auxiliary block when 
the response data for the PROFIenergy 
controller is ready and can be sent.

DATA_
ERRORRSP

InOut VARIANT 0 Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer with DATA_ERRORRSP of the 
instruction "PE_I_DEV (Page 2415)". The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL 0 ● "0": No error
● "1": Error occurred.

STATUS Output WORD 0 ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

9.7.3.6 Module parameter assignment

Writing and reading data records

Principle
Some modules have a write-only system data area to which your program can transfer data 
records. This area contains data records with numbers from 0 to a maximum of 240. Not every 
module contains all of the data records (see following table).
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Modules can also have a read-only system data area in which your program can read data 
records. This area contains data records with numbers from 0 to a maximum of 240. Not every 
module contains all of the data records (see following table).

 

 Note

There are modules that have both system data areas. These are physically separate areas 
and the only thing they have in common is their logical structure.

 

Write-only system data area
The following table shows the structure of the write-only system data area. This table also 
shows how the permitted size of the individual data records and which instructions can be used 
to write them.

Data record 
number

Contents Size Can be written with 
instruction

0 Parameter - WR_DPARM (Page 2439)
1 Parameter - WR_DPARM (Page 2439)
2 to 127 User data Each ≤ 240 bytes WR_DPARM (Page 2439)

WR_REC (Page 2362)
128 to 240 Parameter Each ≤ 240 bytes WR_DPARM (Page 2439)

WR_REC (Page 2362)

Read-only system data area
The following table shows the structure of the read-only system data area. This table also 
shows the permitted size of the individual data records and which instructions can be used to 
read them.

Data record 

number

Contents Size Can be read with instruction

0 Module-specific 
diagnostics data (set as 
standard for the entire 
system)

4 bytes RD_REC (Page 2358)

1 Channel-specific 
diagnostics data
(incl. data record 0)

4 to 220 Bytes RD_REC (Page 2358)

2 to 127 User data Each ≤ 240 bytes RD_REC (Page 2358)
128 to 240 Diagnostics data Each ≤ 240 bytes RD_REC (Page 2358)
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System resources
If you start several asynchronous data record transfers one after the other with only short 
intervals between them, the allocation of system resources by the operating system ensures 
that all the jobs are executed and that they do not interfere with each other.

If the limits of the system resources are reached, this is indicated in RET_VAL. You can remedy 
this temporary error situation by simply repeating the job.

The maximum number of "simultaneously" active jobs of a single instruction type depends on 
the CPU.

RD_DPAR: Read module data record

Description
You use the instruction to read the data record with the number INDEX of the addressed 
component from the configured system data. This may be a module in a central rack or a 
distributed component (PROFIBUS DP or PROFINET IO).

The value TRUE for the output parameter VALID  indicates that the data record was 
successfully transferred to the target range RECORD. In this case, the LEN output parameter 
contains the length of the read data in bytes.

If an error has occurred during transfer of the data record, this is indicated by the output 
parameter ERROR . In this case, the output parameter STATUS contains the error information.

Functional description
The "RD_DPAR" instruction works asynchronously, that is, its execution extends over multiple 
calls. You start the data record transfer by calling "RD_DPAR" with REQ = 1.

The output parameter BUSY  and bytes 2 and 3 of the output parameter STATUS  show the 
status of the job. Bytes 2 and 3 of STATUS  match the output parameter RET_VAL of the 
instructions that operate asynchronously.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

The transfer of the data record is complete when the output parameter BUSY has the value 
FALSE.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2433



Parameter
The following table shows the parameters of the instruction "RD_DPAR":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

LADDR Input HW_IO I, Q, M, D, L or 
constant

Identification number of the CPU or the 
interface.
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface of the hardware configuration.

INDEX Input INT I, Q, M, D, L or 
constant

Data record number

RECORD InOut VARIANT I, Q, M, D, L Target range for the read data record
VALID Output BOOL I, Q, M, D, L New data record was received and is valid
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The job is not yet completed.
ERROR Output BOOL I, Q, M, D, L ERROR = 1: An error occurred during the 

reading process.
STATUS Output DWORD I, Q, M, D, L ● Call ID (bytes 2 and 3) or error code

● Byte 1: B#16#00, if no error. Otherwise 
function ID from DPV1-PDU: In the case of 
error for data record reading B#16#DE, in 
the case of error for data record writing 
B#16#DF. If no DPV1 protocol element is 
used: B#16#C0.

● Byte 4: Manufacturer-specific error ID 
extension

LEN Output INT I, Q, M, D, L Length of the read data record information

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value 0. -
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ 

irrelevant): Data transfer already active; BUSY has the value "1".
Distributed I/O

8090 Specified logical base address invalid. -
8092 A data type other than (Array of) bit string or integer was specified at 

the RECORD parameter.
-

8093 This instruction is not valid for the module selected with LADDR. -
80A1 Negative acknowledgement during sending of data record to module 

(module defective or unplugged during sending).
-
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Error code*
(W#16#...)

Explanation Restriction

80A2 DP protocol error at layer 2, possible hardware/interface error in DP 
slave.

Distributed I/O

80A3 DP protocol error at user interface/user. Distributed I/O
80A4 Communication problem on com bus. Error occurs between CPU and 

external DP 
interface module

80B0 Instruction for module type not possible, or module does not recognize 
the data record.

-

80B1 The length of the data 
record to be sent is 
incorrect. 

-

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type 
does not correspond to 
specified module type.

-

80C1 The data of the previous write job on the module for the same data 
record have not yet been processed by the module.

-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

 

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available or deactivated. Distributed I/O 
80C6 Data record transfer cancelled due to priority class abort (restart or 

background).
Distributed I/O 

80D0 There is no entry for the module. -
80D1 The data record number is not configured for the module (data record 

numbers > 
241 are rejected).

-

80D2 The module cannot be assigned parameters according to its type 
identifier.

-

80D5 The data record is static. -
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
RD_DPARM: Read data record from configured system data (Page 2438)
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RD_DPARA: Read module data record asynchronously

Description
You use the instruction to read the data record with the number RECNUM  of a selected module 
from the configured system data. The read data record is entered in the target range defined 
by the parameter RECORD .

Functional description
The "RD_DPARA" instruction works asynchronously, that is, its execution extends over 
multiple calls. You start the job by calling the instruction with REQ = 1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

Parameters
The following table shows the parameters of the "RD_DPARA" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

LADDR Input HW_IO I, Q, M, D, L or 
constant

Identification number of the CPU or the 
interface.
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface of the hardware configuration.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number (permitted values: 0 to 
240)

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.
If no error occurred during the transmission, 
the following two cases are distinguished:
● RET_VAL  contains the length of the 

actually read data record in bytes if the 
target range is larger than the read data 
record.

● RET_VAL  contains "0" if the length of the 
read data record is equal to the length of 
the target range.

BUSY Output BOOL I, Q, M, D, L BUSY = 1: The job is not yet completed.
RECORD Output VARIANT I, Q, M, D, L Target range for the data record read.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter RET_VAL

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value 0. -
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ 

irrelevant): Data transfer already active; BUSY has the value "1".
Distributed I/O

8090 Specified logical base address invalid. -
8092 A data type other than (Array of) bit string or integer was specified at 

the RECORD parameter.
-

8093 This instruction is not valid for the module selected with LADDR. -
80A1 Negative acknowledgement during sending of data record to module 

(module defective or unplugged during sending).
-

80A2 DP protocol error at layer 2, possible hardware/interface error in DP 
slave.

Distributed I/O

80A3 DP protocol error at user interface/user. Distributed I/O
80A4 Communication on PBUS+ disrupted -
80B0 Instruction for module type not possible, or module does not recognize 

the data record.
-

80B1 The length of the data 
record to be sent is 
incorrect. With RD_DPARM (Page 2438): The target range 
spanned by RECORD  is too short.

-

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type 
does not correspond to 
specified module type.

-

80C1 The data of the previous write job on the module for the same data 
record have not yet been processed by the module.

-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

 

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available or deactivated. Distributed I/O 
80C6 Data record transfer cancelled due to priority class abort (restart or 

background).
Distributed I/O 

80D0 There is no entry for the module. -
80D1 The data record number is not configured for the module (data record 

numbers > 
241 are rejected).

-

80D2 The module cannot be assigned parameters according to its type 
identifier.

-
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Error code*
(W#16#...)

Explanation Restriction

80D5 The data record is static. -
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

RD_DPARM: Read data record from configured system data

Description
You use instruction to read the data record with the number RECNUM of the addressed module 
from the configured system data. The read data record is entered into the target range spanned 
by the RECORD parameter.

Parameters
The following table shows the parameters of the instruction "RD_DPARM":

Parameter Declaration Data type Memory area Description
IOID Input BYTE I, Q, M, D, L or 

constant
Address area identifier:
● B#16#54 = Peripheral input (PI)
● B#16#55 = Peripheral output (PQ)
If the module is a mixed module, the area 
identifier of the lower address must be 
specified. If the addresses are identical, 
specify B#16#54.

LADDR Input HW_IO I, Q, M, D, L or 
constant

Identification number of the CPU or the 
interface.
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface of the hardware configuration.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number (permitted values: 0 to 
240)

RET_VAL Return INT I, Q, M, D, L Length of the data record read in bytes if 
the read data record fits in the target range 
and no error occurred in the transfer.
If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

RECORD Output VARIANT I, Q, M, D, L Target range for the data record read.

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter RET_VAL

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value 0. -
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ 

irrelevant): Data transfer already active; BUSY has the value "1".
Distributed I/O

8090 Specified logical base address invalid. -
8092 A type other than BYTE  is specified in the VARIANT reference at the 

RECORD parameter.
-

8093 This instruction is not valid for the module selected with LADDR. -
80B1 The target range 

spanned by RECORD  is too short.
-

80C3 The required resources (memory, etc.) are currently 
occupied.

-

80D0 There is no entry for the module. -
80D1 The data record number is not configured for the module (data record 

numbers > 
241 are rejected).

-

80D2 The module cannot be assigned parameters according to its type 
identifier.

-

80D5 The data record is static. -
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

WR_DPARM: Transfer data record

Description
You use the instruction "WR_DPARM" to transfer the data record with the number RECNUM 
from the configuration data to the addressed module. With this instruction, it is irrelevant 
whether the data record is static or dynamic.
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Parameters
The following table shows the parameters of the "WR_DPARM" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L REQ = 1: Write request
LADDR Input HW_IO I, Q, M, D, L or 

constant
Identification number of the CPU or the 
interface. 
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface in the hardware configuration.
Please see the relevant module manual for the 
possible DB number bands.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

BUSY Output BOOL I, Q, M, D, L BUSY = 1: The writing process is not yet 
completed.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value 0. -
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ 

irrelevant): Data transfer already active; BUSY has the value "1".
Distributed I/O

8090 Specified logical base address invalid. -
8093 This instruction is not valid for the module selected with LADDR. -
80A1 Negative acknowledgement during sending of data record to module 

(module defective or unplugged during sending).
-

80A2 DP protocol error at layer 2, possible hardware/interface error in DP 
slave.

Distributed I/O

80A3 DP protocol error at user interface/user. Distributed I/O
80A4 Communication on PBUS+ disrupted -
80B0 Instruction for module type not possible, or module does not recognize 

the data record.
-

80B1 The length of the data 
record to be sent is 
incorrect. 

-

80B2 The configured slot is 
not assigned.

-
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Error code*
(W#16#...)

Explanation Restriction

80B3 Actual module type 
does not correspond to 
specified module type.

-

80C1 The data of the previous write job on the module for the same data 
record have not yet been processed by the module.

-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

 

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available or deactivated. Distributed I/O 
80C6 Data record transfer cancelled due to priority class abort (restart or 

background).
Distributed I/O 

80D0 There is no entry for the module. -
80D1 The data record number is not configured for the module (data record 

numbers > 
241 are rejected).

-

80D2 The module cannot be assigned parameters according to its type 
identifier.

-

80D5 The data record is static. -
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

9.7.3.7 Interrupts

ATTACH: Attach an OB to an interrupt event

Description
You use the instruction "ATTACH" to assign an organization block (OB) to an event.

You enter the symbolic or numeric name of the organization block in the OB_NR parameter. 
This will then be assigned to the event specified in the EVENT parameter.

If the event in the EVENT parameter occurs following error-free execution of the "ATTACH" 
instruction, the organization block in the OB_NR parameter will be called and its program 
executed.

With the ADD parameter, you specify whether previous assignments of the organization block 
to other events should be canceled or retained. If the ADD parameter has the value "0", the 
existing assignments will be replaced by the current assignment.
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Parameters
The following table shows the parameters of the "ATTACH" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_ATT (INT) I, Q, M, D, L or constant Organization block (numbers up to 32767 

are supported.)
EVENT Input EVENT_ATT 

(DWORD)
D, L or constant Event, e.g., creation of a process event 

(failure of a hardware module; read 
hardware ID (16#C0xxyyzz) and query at 
block)

ADD Input BOOL I, Q, M, D, L or constant Effects on previous assignments:
● ADD=0 (default): This event replaces all 

previous event assignments for this OB.
● ADD=1: This event is added to the 

previous event assignments for this OB.
RET_VAL Return INT I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

RET_VAL parameter

Error code*
(W#16#....) 

Description

0 No error
8090 OB does not exist
8091 OB is incorrect type
8093 Event does not exist
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DETACH: Detach an OB from an interrupt event

Description       
You use this instruction to cancel the existing assignment of an organization block to one or 
more events during runtime.

● If you have selected a single event, the assignment of the OB to this event will be cancelled. 
All other currently existing assignments remain active. You can select an individual event 
using the drop-down list of the operand placeholder at the EVENT parameter.

● If you have not selected an event, all currently existing assignments of the organization 
block to events will be canceled.

You enter the symbolic or numeric name of the organization block in the OB_NR parameter. 
The assignment of this organization block to the event specified in the EVENT parameter will 
then be canceled.
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Parameters
The following table shows the parameters of the "DETACH" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_ATT (INT) I, Q, M, D, L or constant Organization block (numbers up to 32768 

are supported.)
EVENT Input EVENT_ATT 

(DWORD)
D, L or constant Event

RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#....) 

Description

0 No error
1 No assignment exists (warning)
8090 OB does not exist
8091 OB has incorrect type
8093 Event does not exist
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Cyclic interrupt

SET_CINT: Set cyclic interrupt parameters

Description       
You use this instruction to set the parameters for a cyclic interrupt OB. The start time for a 
cyclic interrupt OB is generated from the respective time interval of the OB and the phase 
offset.

● The time interval of an OB is the interval at which the OB is periodically called. For example, 
if the time interval is 100 μs, the OB will be called every 100 μs during program execution.

● The phase offset is a time interval by which the call of a cyclic interrupt OB is offset. You 
can use the phase offset to process low priority organization blocks in a precise time base.

If the OB does not exist or if the time interval used is not supported, a corresponding error 
alarm is output in the RET_VAL parameter.

A time interval in the CYCLE parameter of "0" means that the OB will not be called.
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Functional description
If a lower priority OB and a higher priority OB are called in the same time interval, the lower 
priority OB will only be called once the higher priority OB has been executed. The call time for 
the lower priority OB can be offset according to the length of time to execute the higher-priority 
OB.

If a phase offset is configured for the lower priority OB and the phase offset is greater than the 
current execution time of the respective higher priority OB, then the block will be called in a 
fixed time base.

Parameters
The following table shows the parameters of the "SET_CINT" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_CYCLIC I, Q, M, D, L or constant OB number (<32768)
CYCLE Input UDINT I, Q, M, D, L or constant Time interval in microseconds
PHASE Input UDINT I, Q, M, D, L or constant Phase offset
RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter RET_VAL

Error code*
(W#16#....) 

Description

0 No error
8090 OB does not exist or is of the wrong type
8091 Incorrect time interval
8092 Incorrect phase offset
80B2 No event assigned to OB
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

QRY_CINT: Query cyclic interrupt parameters

Description       
You can use this instruction to query the current parameters of a cyclic interrupt OB. The cyclic 
interrupt OB is identified using the OB_NR parameter.

The values of the queried cyclic interrupt parameters correspond to those at the time the 
"QRY_CINT" instruction is executed.

Parameters
The following table shows the parameters of the "QRY_CINT" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_CYCLIC 

(INT)
I, Q, M, D, L or constant OB number (<32768) or symbolic 

addressing via the name of the OB (e.g. 
OB_MyOB)

CYCLE Output UDINT I, Q, M, D, L Time interval in microseconds
PHASE Output UDINT I, Q, M, D, L Phase offset
STATUS Output WORD I, Q, M, D, L Status of the cyclic interrupt:

● Bit 0 to bit 4: see parameter STATUS
● Other bits: Always "0"

RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Bit Value Meaning
0 0 The CPU is in RUN mode.

1 The CPU is in startup.
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Bit Value Meaning
1 0 The cyclic interrupt is enabled.

1 The cyclic interrupt is delayed.
2 0 The cyclic interrupt is not enabled or has expired.

1 The cyclic interrupt is enabled.
3 0 -

1 -
4 0 An OB with the specified number does not exist.

1 An OB with the specified number exists.
Other bits Always "0"

Parameter RET_VAL
If an error occurs, the relevant error code will be displayed in the RET_VAL parameter and the 
STATUS parameter is set to "0".

Error code*
(W#16#....) 

Description

0 No error
8090 OB does not exist or is of the wrong type
80B2 No event assigned to OB
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Time-of-day interrupt

SET_TINT: Set time-of-day interrupt

Description       
With the instruction, you can set the start date and time of the time-of-day interrupt organization 
blocks. The seconds and milliseconds of the specified start time are ignored and set to "0".
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Parameters
The following table shows the parameters of the "SET_TINT" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_TOD 

(INT)
I, Q, M, D, L or 
constant

Number of the OB started at the time SDT + 
multiple of PERIOD (OB 10 to OB 17 and from 
OB 123).

SDT Input DT D, L Start date and time: the seconds and 
milliseconds of the specified start time are 
ignored and set to 0.

If you want to set a monthly start of a time-of-
day interrupt OB, you can only use the days 1, 
2, ... 28 as a start date.

PERIOD Input WORD I, Q, M, D, L or 
constant

Period from starting point SDT onwards:
● W#16#0000 = once
● W#16#0201 = once every minute
● W#16#0401 = once hourly
● W#16#1001 = once daily
● W#16#1201 = once weekly
● W#16#1401 = once monthly
● W#16#1801 = once yearly
● W#16#2001 = at month's end

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of RET_VAL 
contains an error code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Incorrect parameter OB_NR
8091 Incorrect parameter SDT
8092 Incorrect parameter PERIOD
80A1 The set start time is in the past. (This error code occurs only when PERIOD = W#16#0000.)
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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SET_TINTL: Set time-of-day interrupt

Description
The instruction "SET_TINTL" is used to set the start data and time of the time-of-day interrupt 
organization blocks from the user program, without having to make settings in the hardware 
configuration. 

With the SDT parameter, you specify the start date and time-of-day. With the PERIOD 
parameter, you can specify the cycle at which the instruction call is to be repeated (e.g., daily, 
once per week). If you set the repetition period to "monthly", you may only specify a day 
between 1. and 28. for the start date. It is not permitted to assign parameters for day 29 to 31, 
as no hardware interrupt would be called, for example, in February. If you want to initiate the 
time-of-day interrupt at the end of each month, use the "End of month" function.

With the ACTIVATE parameter, you specify whether the settings made for the organization 
block are to be applied directly (ACTIVATE = true) or only after "ACT_TINT (Page 2450)" for 
the time-of-day interrupt organization block is called (ACTIVATE = false).

 

 Note

When calling time-delay interrupt organization blocks with a start time within the second hour 
during changeover from daylight saving time to standard time, also use a time-delay interrupt 
during the first hour of the time changeover.

 

Parameters
The following table shows the parameters of the "SET_TINTL" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_TOD 

(INT)
I, Q, M, D, L or 
constant

Number of the OB started at the time SDT + 
multiple of PERIOD (OB 10 to OB 17 and from 
OB 123).

SDT Input DTL D, L Start date and start time: The seconds and 
milliseconds of the specified start time are 
ignored and set to "0".

LOCAL Input BOOL I, Q, M, D, L or 
constant

● LOCAL = true: Use local time
● LOCAL = false: Use system time

PERIOD Input WORD I, Q, M, D, L or 
constant

Period from starting point SDT onwards:
● W#16#0000 = Once
● W#16#0201 = Once every minute
● W#16#0401 = Once hourly
● W#16#1001 = once daily
● W#16#1201 = once weekly
● W#16#1401 = once monthly
● W#16#1801 = once yearly
● W#16#2001 = at month's end
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Parameter Declaration Data type Memory area Description
ACTIVATE Input BOOL I, Q, M, D, L or 

constant
● ACTIVATE = true: Execute instruction
● ACTIVATE = false: Execute instruction only 

when "ACT_TINT (Page 2450)" is called
RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 

instruction, the actual parameter of RET_VAL 
contains an error code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Incorrect parameter OB_NR
8091 Incorrect parameter SDT
8092 Incorrect parameter PERIOD
80A1 The set start time is in the past. (This error code occurs only when PERIOD = W#16#0000.)
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

CAN_TINT: Cancel time-of-day interrupt

Description
The instruction "CAN_TINT" is used to delete the start data and start time of a specified time-
of-day interrupt organization block. This deactivates the time-of-day interrupt, and the 
organization block is no longer called.

If you want to use the time-of-day interrupt again, you must first reset the start time 
("SET_TINTL (Page 2448)" instruction) and then activate the time-of-day interrupt 
("ACT_TINT (Page 2450)" interrupt).

Parameters
The following table shows the parameters of the instruction "CAN_TINT":

Parameter Declaration Data type Memory area Description
OB_NR Input OB_TOD 

(INT)
I, Q, M, D, L or constant Number of the OB whose start data and start 

time are to be deleted.
RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 

instruction, the actual parameter of 
RET_VAL contains an error code.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2449



For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred.
8090 Incorrect parameter OB_NR
80A0 No start date/time specified for the time-of-day interrupt OB
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

ACT_TINT: Enable time-of-day interrupt

Description       
You use the instruction to activate a time-of-day interrupt organization block.

Parameters
The following table shows the parameters of the instruction "ACT_TINT":

Parameter Declaration Data type Memory area Description
OB_NR Input OB_TOD 

(INT)
I, Q, M, D, L or 
constant

Number of the OB to be activated.

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of RET_VAL 
contains an error code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Incorrect parameter OB_NR
80A0 Start date and time-of day not set for the relevant time-of-day interrupt OB.
80A1 The activated time lies in the past; error occurs for execution "once".
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Error code*
(W#16#...)

Description

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

QRY_TINT: Query status of time-of-day interrupt

Description       
You can use this instruction to display the status of a time-of-day interrupt organization block 
in the STATUS output parameter. 

Parameters
The following table shows the parameters of the "QRY_TINT" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_TOD 

(INT)
I, Q, M, D, L or constant Number of the OB that will be 

queried for status (OB 10 to OB 17 and from 
OB 123).

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of 
RET_VAL contains an error code.

STATUS Output WORD I, Q, M, D, L Status of the time-of-day interrupt; 
see following table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS
If an error occurs (see RET_VAL parameter), "0" is output in the STATUS parameter.

Bit Value Meaning
0 0 In Run.
 1 During startup.
1 0 The time-of-day interrupt is enabled.
 1 The time-of-day interrupt is disabled.
2 0 Time-of-day interrupt is not activated or has elapsed.
 1 The time-of-day interrupt is activated.
4 0 An OB with an OB number as specified at OB_NR parameter does not exist.
 1 An OB with an OB number as specified at OB_NR parameter does exist.
6 0 Base for the time-of-day interrupt is the basic time
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Bit Value Meaning
 1 Base for the time-of-day interrupt is the local time
Other Always "0"

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Incorrect parameter OB_NR
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Time-delay interrupt

Using time-delay interrupts

Definition  
After you have called the "SRT_DINT (Page 2453)" instruction, the operating system generates 
an interrupt after the specified delay time has elapsed, in other words, the assigned time-delay 
interrupt OB is called.

Prerequisites for the call
Before a time-delay interrupt can be called by the operating system, the following conditions 
must be met:

● The time-delay interrupt OB must be started by the "SRT_DINT (Page 2453)" instruction.

● The time-delay interrupt OB must not be deselected during configuration.

● The time-delay interrupt OB must exist in the CPU.

Purpose of the instructions "SRT_DINT", "CAN_DINT" and "QRY_DINT"
You use the instructions to

● Start time-delay interrupts ("SRT_DINT (Page 2453)")

● Cancel time-delay interrupts ("CAN_DINT (Page 2454)")

● Query time-delay interrupts ("QRY_DINT (Page 2455)")

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2452 System Manual, 07/2013,  



Effects on the time-delay interrupt
The following table lists a number of different situations and explains the effect they have on 
a time-delay interrupt.

If ... and ... Then ...
A time-delay interrupt is 
started (by calling 
"SRT_DINT (Page 2453)")

The time-delay interrupt has 
already started,

The delay time is overwritten; the 
time-delay interrupt is started 
again.

 The time-delay interrupt OB 
does 
not exist at the time of the 
call,

The operating system generates 
a priority class error (calls OB 85). If OB 
85 does not exist, the CPU 
changes to STOP.

 The interrupt is started in a 
startup 
OB and the delay time 
elapses 
before the CPU changes to 
RUN,

The call of the time-delay interrupt 
OB is delayed until the CPU is in 
RUN mode.

The delay time has elapsed, A previously started time-
delay 
interrupt OB is still being 
executed,

The operating system generates a 
time error (calls OB 80). If OB 80 
does not exist, the CPU changes 
to STOP.

Response to warm restart and cold restart 
During a warm restart or a cold restart, all the time-delay interrupt settings made in the user 
program by means of instructions are cleared.

Starting in a startup OB
A time-delay interrupt can be started in a startup OB. Two conditions must be satisfied to call 
the time-delay OB:

● The delay time must have elapsed.

● The CPU must be in the RUN mode.

If the delay time has elapsed and the CPU is not yet in the RUN mode, the time-delay interrupt 
OB call is delayed until the CPU is in RUN mode. The time-delay interrupt OB is then called 
before the first instruction in OB Main [OB 1] is executed.

SRT_DINT: Start time-delay interrupt

Description
The instruction "SRT_DINT" is used to start a time-delay interrupt, which calls a time-delay 
interrupt OB after the expiry of the delay time specified at the parameter DTIME. The delay 
time is started when a negative edge is generated in the EN enable input. The signal state of 
enable input EN must be "0" during delay time countdown. If the delay time countdown is 
interrupted, the OB configured in the OB_NR parameter is not executed.
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Accuracy
The maximum time between the call of the "SRT_DINT" instruction and the start of the time-
delay interrupt OB is one millisecond longer than the configured delay time, provided that no 
interruption events delay the call.

Parameters
The following table shows the parameters of the instruction "SRT_DINT":

Parameter Declaration Data type Memory area Description
OB_NR Input OB_DELAY 

(INT)
I, Q, M, D, L or constant Number of the OB to be executed after a 

delay time 
DTIME Input TIME I, Q, M, D, L or constant Delay time (1 to 60000 ms)

You can realize longer times, for example, 
by using a counter in a time-delay 
interrupt OB.

SIGN Input WORD I, Q, M, D, L or constant Identifier that appears when the time-
delay interrupt OB is called in the start 
event information of the OB.

RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*

(W#16#...)

Description

0000 No error 
8090 Incorrect parameter OB_NR
8091 Incorrect parameter DTIME
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

CAN_DINT: Cancel time-delay interrupt

Description
You use this instruction to cancel a started time-delay interrupt and, thus, also cancel the call 
of the time delay interrupt OB that is to be executed after the configured delay time. You specify 
the number of the organization block whose call is to be canceled in the OB_NR parameter.
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Parameters
The following table shows the parameters of the "CAN_DINT" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_DELAY 

(INT)
I, Q, M, D, L or constant Number of the OB whose call will be 

canceled 
RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*

(W#16#...)

Description

0000 No error 
8090 Incorrect parameter OB_NR
80A0 Time-delay interrupt has not started.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

QRY_DINT: Query time-delay interrupt status

Description
The instruction "QRY_DINT" is used to query the status of the time-delay interrupt.

Parameters
The following table shows the parameters of the instruction "QRY_DINT":

Parameter Declaration Data type Memory area Description
OB_NR Input OB_DELAY 

(INT)
I, Q, M, D, L or 
constant

Number of the OB whose status is being 
queried.

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of RET_VAL 
contains an error code. The value "0" is 
displayed in the STATUS parameter.

STATUS Output WORD I, Q, M, D, L Status of the time-delay interrupt, see 
following table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter STATUS

Bit Value Meaning
0 0 Operating system in RUN
 1 Operating system in startup
1 0 Time-delay interrupt is enabled by the operating system.
 1 Time-delay interrupt is disabled.
2 0 Time-delay interrupt is not activated or has elapsed.
 1 Time-delay interrupt is activated.
3 - -
4 0 Time-delay interrupt OB with the specified number does not exist.
 1 Time-delay interrupt OB with the specified number exists.
Other bits Always "0"

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Incorrect information in the OB_NR parameter
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Synchronous errors

Mask synchronous error events

Introduction
Synchronous errors are programming and access errors. Such errors occur as a result of 
programming with incorrect operand areas or numbers, or incorrect addresses. Masking these 
synchronous errors means the following:

● Masked synchronous errors do not trigger an error OB call and do not lead to a programmed 
alternative reaction.

● The CPU "records" the masked errors that have occurred in an error status register.

Masking is carried out by calling the "MSK_FLT (Page 2463)" instruction.

Unmasking errors means canceling a previously set mask and clearing the corresponding bit 
in the event status register of the current priority class. Masking is canceled as follows: 
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● By calling the "DMSK_FLT (Page 2464)" instruction.

● Once the current priority class has been completed.

If an error event occurs after it has been unmasked, then the operating system will start the 
associated error OB. You program OB 121 for the reaction to programming errors and OB 122 
for the reaction to access errors.

You can use the "READ_ERR (Page 2464)" instruction to read the masked errors that have 
occurred.

 

 Note

With the S7-300 (except CPU 318), regardless of whether an error is masked or unmasked, 
the error is entered in the diagnostic buffer and the group error LED of the CPU is illuminated.

 

Handling errors in general
If programming and access errors occur in a user program, you can react to them in different 
ways:

● You can program an error OB that is called by the operating system when the corresponding 
error occurs.

● You can disable the error OB call individually for each priority class. In this case, the CPU 
does not change to STOP when an error of this type occurs in the particular priority class. 
The CPU enters the error in an error register. From this entry, however, you cannot 
recognize when or how often the error occurred.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2457



Error filter
Synchronous errors are assigned to a particular bit pattern known as the error filter. You can 
find this error filter in the input and output parameters of the "MSK_FLT (Page 2463)", 
"DMSK_FLT (Page 2464)", and "READ_ERR (Page 2464)" instructions.

Synchronous errors are divided into programming and access errors that you can mask using 
two error filters. The error filters are illustrated in the following figures.

Programming error filter
The following figure shows the bit pattern of the error filter for programming errors. The error 
filter for the programming errors is available in the "PRGFLT_..." parameters (see below 
"Programming errors, Low-Word" or "Programming errors, High-Word").
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Non-relevant bits
In the figure above, x means ...

● ... Input parameters For "MSK_FLT (Page 2463)", "DMSK_FLT 
(Page 2464)", "READ_ERR (Page 2464)"

= "0"

● ... Output parameters For "MSK_FLT (Page 2463)", "DMSK_FLT (Page 2464)" = "1" for S7-300
= "0" for S7-400

For "READ_ERR (Page 2464)" = "0"

Access error filter for all CPUs
The following figure shows you the bit pattern of the error filter for access errors. The filter for 
access errors is in the parameters ACCFLT_...  For an explanation of the access errors, refer 
to the table "Possible causes of errors for all CPUs 31x except CPU 318" or "Possible causes 
of errors for all CPUs 41x and CPU 318".
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Example
The following figure shows the low word of the error filter for access errors with all masked 
errors for all CPUs.

● As input parameters for "MSK_FLT (Page 2463)"

● As output parameters for "MSK_FLT (Page 2463)"

Programming error low word
The following table lists the errors assigned to the low word of the error filter for programming 
errors. The possible causes of the errors are also listed.

Possible causes of programming errors, low word

Error Event ID
(W#16#...)

Error occurs ...

BCD conversion error 2521 ... when the value to be converted is not a BCD number 
(for 
example, 5E8).

Area length error when 
reading

2522 ... when an addressed operand is being used that is not 
completely 
within the possible operand area.
Example: MW 320 should be read although the memory 
area 
is only 256 bytes long.

Area length error when 
writing

2523 ... when an addressed operand is being used that is not 
completely 
within the possible operand area.
Example: A value should be written to MW 320 although 
the 
memory area is only 256 bytes long.
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Error Event ID
(W#16#...)

Error occurs ...

Range error when reading 2524 ... when an incorrect area identifier is specified for the 
operand when using indirect, area-overlapping 
addressing.
Example: 
 Correct: LAR1 P#E 12.0
 L W[AR1, P#0.0]
 Incorrect: LAR1 P#12.0
 L W[AR1, P#0.0] 
For this operation 
 the area length error is signaled.

Range error when writing 2525 ... when an incorrect area identifier is specified for the 
operand when using indirect, area-overlapping 
addressing.
Example: 
 Correct: LAR1 P#E 12.0
 T W[AR1, P#0.0]
 Incorrect: LAR1 P#12.0
 T W[AR1, P#0.0] 
For this operation 
 the area length error is signaled.

Timer number error 2526 ... when a non-existent timer is accessed.
Example: SP T [MW 0] where MW 0 = 129; timer 129 
should 
be started although there are only 128 timers available.

Counter number error 2527 ... when a non-existent counter is accessed.
Example: CU C [MW 0] where MW 0 = 600; counter 600 
must be accessed although there are only 512 counters 
available (CPU 416-1).

Alignment error when 
reading

2528 ... when a byte, word, or double word operand is 
addressed 
with a bit address ≠ 0.
Example: Correct: LAR1 P#M12.0
 L B[AR1, P#0.0]
 Incorrect: LAR1 P#M12.4
 L B[AR1, P#0.0]

Alignment error when 
writing

2529 ... when a byte, word, or double word operand is 
addressed 
with a bit address ≠ 0.
Example: 
 Correct: LAR1 P#M12.0
 T B[AR1, P#0.0]
 Incorrect: LAR1 P#M12.4
 T B[AR1, P#0.0]
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Programming error high word
The following table lists the errors assigned to the high word of the error filter for programming 
errors. The possible causes of the errors are also listed.

Possible causes of programming errors, high word

Error Event ID
(W#16#...)

Error occurs ...

Write error data block 2530 ... when the data block to be written to is read-only.
Write error instance data block 2531 ... when the instance data block to be written to is read-

only.
Block number error DB 2532 ... when a data block must be opened whose number 

is 
higher than the highest permitted number.

Block number error DI 2533 ... when an instance data block must be opened 
whose 
number is higher than the highest permitted number.

Block number error FC 2534 ... when a function is called whose number is higher 
than the 
highest permitted number.

Block number error FB 2535 ... when a function block is called whose number is 
higher 
than the highest permitted number.

DB not loaded 253A ... when the data block to be opened is not loaded.
Instruction not loaded 253C to 253F ... when the called instruction is not loaded.

Access error
The following table lists the errors assigned to the error filter for access errors for all CPUs. 
The possible causes of the errors are also listed.

Error Event ID
(W#16#...)

Error occurs ...

I/O access error 
when reading

2942 ... when a signal module is not assigned to the 
address in the 
I/O area.
Or
... when access to this I/O area is not acknowledged 
within 
the specified module monitoring time (timeout).

I/O access error 
when writing

2943 ... when a signal module is not assigned to the 
address in the 
I/O area.
Or
... when access to this I/O area is not acknowledged 
within 
the specified module monitoring time (timeout).
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MSK_FLT: Mask synchronous error events

Description     
You use the instruction to control the reaction of the CPU to synchronous errors. This is done 
by masking the respective synchronous errors (for error filters, see Mask synchronous error 
events (Page 2456)). When you call "MSK_FLT", you mask the synchronous errors in the 
current priority class.

If you set individual bits of the synchronous error filter to "1" in the input parameters, other bits 
that were set previously retain their value of "1". You obtain new error filters that you can read 
out using the output parameters. The synchronous errors you have masked do not call an OB 
but are simply entered in an error register. You can read the error register with the 
"READ_ERR (Page 2464)" instruction. 

Parameters
The following table shows the parameters of the instruction "MSK_FLT":

Parameter Declaration Data type Memory area Description
PRGFLT_SET_MASK Input DWORD I, Q, M, D, L or constant Programming error to be 

masked
ACCFLT_SET_MASK Input DWORD I, Q, M, D, L or constant Access error to be masked
RET_VAL Return INT I, Q, M, D, L Error information
PRGFLT_MASKED Output DWORD I, Q, M, D, L Masked programming errors
ACCFLT_MASKED Output DWORD I, Q, M, D, L Masked access errors

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 None of the errors were already masked.
0001 At least one of the errors was already masked. Nevertheless the other errors will be masked.
- General error information

See also: Getting error ID locally with GetErrorID (Page 2237)
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Evaluating errors with output parameter RET_VAL (Page 1584)
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DMSK_FLT: Unmask synchronous error events

Description     
You use the instruction to unmask the errors masked with "MSK_FLT (Page 2463)". To do 
this, you must set the corresponding bits of the error filter to "1" in the input parameters. With 
the "DMSK_FLT" call, you unmask the corresponding synchronous errors of the current priority 
class. At the same time, the queried entries are cleared in the error register. You can read out 
the new error filters using the output parameters.

Parameters
The following table shows the parameters of the instruction "DMSK_FLT":

Parameter Declaration Data type Memory area Description
PRGFLT_RESET_
MASK

Input DWORD I, Q, M, D, L or constant Programming errors to be 
unmasked

ACCFLT_RESET_
MASK

Input DWORD I, Q, M, D, L or constant Access errors to be 
unmasked

RET_VAL Return INT I, Q, M, D, L Error information
PRGFLT_MASKE
D

Output DWORD I, Q, M, D, L Still masked programming 
errors

ACCFLT_MASKE
D

Output DWORD I, Q, M, D, L Still masked access errors

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 All specified errors were unmasked.
0001 At least one of the errors was not masked. Nevertheless the other errors will be unmasked.
- General error information

See also: GET_ERR_ID: Get error ID locally (Page 2237)
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

READ_ERR: Read out event status register

Description     
You use the instruction to read the error register. The structure of the error register corresponds 
to that of the programming and access error filters, which you can program as input parameters 
with "MSK_FLT (Page 2463)" and "DMSK_FLT (Page 2464)".
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In the input parameters, you enter the synchronous errors you want to read from the error 
register. When you call "READ_ERR", you read the required entries from the error register and 
at the same time clear these entries.

The error register contains information that tells you which of the masked synchronous errors 
in the current priority class occurred at least once. If a bit is set, this means that the 
corresponding masked synchronous error occurred at least once.

Parameters
The following table shows the parameters of the instruction "READ_ERR":

Parameter Declaration Data type Memory area Description
PRGFLT_QUERY Input DWORD I, Q, M, D, L or constant Query programming error
ACCFLT_QUERY Input DWORD I, Q, M, D, L or constant Query access error
RET_VAL Return INT I, Q, M, D, L Error information
PRGFLT_CLR Output DWORD I, Q, M, D, L Programming errors that occurred
ACCFLT_CLR Output DWORD I, Q, M, D, L Access errors that occurred

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 All queried errors are masked.
0001 At least one of the queried errors is not masked.
- General error information

See also: Getting error ID locally with GetErrorID (Page 2237)
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Evaluating errors with output parameter RET_VAL (Page 1584)
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Asynchronous error event

DIS_IRT: Disable interrupt event

Description
The instruction "DIS_IRT" is used to disable the processing of new interrupts and 
asynchronous error events. Disabling means that if an interrupting event occurs, the operating 
system of the CPU reacts as follows:

● It neither calls an interrupt OB nor an asynchronous error OB,

● nor does it trigger the normal reaction if an interrupt OB or asynchronous error OB is not 
programmed.

If you disable interrupts and asynchronous error events, this remains in effect for all priority 
classes. The disable can only be canceled with the "EN_IRT (Page 2467)" instruction or by a 
warm or a cold restart.

Whether the operating system writes interrupts and asynchronous error events to the 
diagnostics buffer when they occur depends on the input parameter setting you select for 
MODE.

 

 Note

Remember that when you program the "DIS_IRT" instruction, all interrupts that occur will be 
discarded.

 

Parameters
The following table shows the parameters of the instruction "DIS_IRT":

Parameter Declaration Data type Memory area Description
MODE Input BYTE I, Q, M, D, L or constant Specifies which interrupts and 

asynchronous 
errors are disabled.

OB_NR Input INT I, Q, M, D, L or constant OB number
RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is 

being executed, the return value contains 
an error code.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".
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Parameter MODE

MODE 
(B#16#...)

Meaning

00 All newly occurring interrupts and asynchronous error events are disabled. (Synchronous errors 
are not disabled.) Assign the value "0" to the OB_NR  parameter. Entries continue to be made in the 
diagnostics buffer.

01 All newly occurring events belonging to a specified interrupt class are disabled. Identify the interrupt class 
by specifying it as follows:
● Time-of-day interrupts: 10
● Time-delay interrupts: 20
● Cyclic interrupts: 30
● Process interrupts: 40
● Interrupts for DPV1: 50
● Multicomputing interrupt: 60
● Redundancy error interrupts: 70
● Asynchronous error interrupts: 80
Entries continue to be made in the diagnostics buffer.

02 All new occurrences of a specified interrupt are disabled. You designate the interrupt 
using the OB number. Entries continue to be made in the diagnostics buffer.

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred.
8090 The OB_NR  input parameter contains an invalid value.
8091 The MODE  input parameter contains an invalid value.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

EN_IRT: Enable interrupt event

Description       
You use the instruction to enable the processing of new interrupts and asynchronous error 
events that you have previously disabled with the "DIS_IRT (Page 2466)" instruction. This 
means that if an interrupting event occurs, the operating system of the CPU reacts in one of 
the following ways:

● It calls an interrupt OB or asynchronous error OB.
or

● It triggers the standard reaction if the interrupt OB or asynchronous error OB is not 
programmed.
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Parameters
The following table shows the parameters of the instruction "EN_IRT":

Parameter Declaration Data type Memory area Description
MODE Input BYTE I, Q, M, D, L or constant Specifies which interrupts and 

asynchronous error events will be 
enabled.

OB_NR Input INT I, Q, M, D, L or constant OB number
RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction 

is being executed, the return value 
contains an error code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter MODE

MODE Meaning
0 All newly occurring interrupts and asynchronous error events are enabled.
1 All newly occurring events belonging to a specified interrupt class are enabled. Identify the interrupt class by 

specifying it as follows:
● Time-of-day interrupts: 10
● Time-delay interrupts: 20
● Cyclic interrupts: 30
● Process interrupts: 40
● Interrupts for DPV1: 50
● Multicomputing interrupt: 60
● Redundancy error interrupts: 70
● Asynchronous error interrupts: 80

2 All newly occurring events of a specified interrupt are enabled. You designate the interrupt 
using the OB number.

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred.
8090 The OB_NR  input parameter contains an invalid value.
8091 The MODE  input parameter contains an invalid value.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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DIS_AIRT: Delay execution of higher priority interrupts and asynchronous error events

Description       
You use "DIS_AIRT" to delay the processing of interrupt OBs whose priority are higher than 
the priority of the current organization block. 

You can call "DIS_AIRT" multiple times in an organization block. The "DIS_AIRT" calls are 
counted by the operating system. Processing is delayed more and more each time "DIS_AIRT" 
is executed. To cancel a delay, you must execute the "EN_AIRT (Page 2469)" instruction. To 
cancel all delays, the number of "EN_AIRT (Page 2469)" executions must be equal to the 
number of "DIS_AIRT" calls.

You can query the number of delays in the RET_VAL parameter of the "DIS_AIRT" instruction. 
If the value in the RET_VAL parameter is "0", there are no delays.

Parameters
The following table shows the parameters of the "DIS_AIRT" instruction:

Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L Number of delays

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

EN_AIRT: Enable execution of higher priority interrupts and asynchronous error events

Description       
You use "EN_AIRT" to enable processing of organization blocks when interrupts occur that 
have been delayed by the "DIS_AIRT (Page 2469)" instruction. 

When "EN_AIRT" is executed, you cancel a processing delay that was registered by the 
operating system when "DIS_AIRT (Page 2469)" was called. To cancel all delays, the number 
of "EN_AIRT" executions must be equal to the number of "DIS_AIRT (Page 2469)" calls. If, for 
example, you have called "DIS_AIRT (Page 2469)" five times and thereby also delayed the 
processing five times, you must call the "EN_AIRT" instruction five times in order to cancel all 
five delays.

You can query the number of interrupt delays that have not yet been enabled after the 
execution of "EN_AIRT" in the RET_VAL parameter of the "EN_AIRT" instruction. The value 
"0" in the RET_VAL parameter means that all delays enabled by "DIS_AIRT (Page 2469)" have 
been cancelled. 
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Parameters
The following table shows the parameters of the "EN_AIRT" instruction:

Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L Number of configured delays

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

9.7.3.8 Alarms

Program_Alarm: Generate program alarm with associated values

Description
The instruction "Program_Alarm" monitors a signal and generates a program alarm when a 
signal change occurs at the SIG parameter (for definition, see also: Auto-Hotspot). An incoming 
alarm is generated if the signal changes from 0 to 1 and an outgoing program alarm if the 
signal changes from 1 to 0. The program alarm is triggered synchronously to program 
execution.

You can append up to ten associated values to the program alarm at the parameters SD_i (0 
≤ i ≤10). The associated values are detected at the time of signal change at parameter SIG 
and assigned to the program alarm. For more information on configuring associated values, 
refer to the following sections: Auto-Hotspot, Auto-Hotspot, Auto-Hotspot.

Each incoming or outgoing alarm is assigned a time stamp:

● The current system time of the PLC when the signal change occurs is used by default 
(default value at the TIMESTAMP parameter).

● If you wish to specify a different time stamp, you can create one at the TIMESTAMP 
parameter.
The time value must always be specified in system time (i.e. UTC), as this is the time used 
for time synchronization throughout the plant.

● If an alarm is to be time-stamped with a local time, a conversion module, which converts 
the local time to system time, must be connected in series. This is the only way to make 
sure that the time stamp is shown properly in the alarm display.

To use the current system time of the CPU, set the TIMESTAMP parameter to its default value 
(LDT#1970-1-1-0:0:0.0).

Calling the "Program_Alarm" instruction
The instruction "Program_Alarm" can only be called in a function block (FB). 

Once the instruction has been inserted in the FB, a multiple instance of the data type 
"Program_Alarm" is created in the "Static" section of the FB interfaces. You can choose any 
name for this multiple instance in the dialog which appears. The name of the multiple instance 
is also the name of the program alarm.
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Finally, add the parameters of the "Program_Alarm" instruction in line with your requirements 
(see the "Parameters" table).

Configuring the program alarm
The program alarm settings are displayed in the "Properties" window when you select the 
name of the program alarm in the "Static" section or in the network of the FB. In this window, 
you can select the alarm class, priority, etc. and edit the alarm text.

The settings that are made here can be edited in the project tree. Go to "PLC alarms" and 
open the "Program alarms" tab. All existing program alarms are then displayed in the "Alarm 
types" table.

Parameters
The following table shows the parameters of the "Program_Alarm" instruction:

Parameter Declaration Data type Memory area Description
SIG Input BOOL I, Q, M, D, L or 

constant
The signal to be monitored.

TIMESTAMP Input LDT M, D, L or constant This parameter is used to assign an alarm a 
time stamp, for example, from an input signal 
with a distributed stamp. The time value must 
always be specified in system time (i.e. UTC), 
as this is the time used for time 
synchronization throughout the plant.
● "Not assigned" means that the system time 

of the CPU will be used as the interrupt 
time stamp when a signal change occurs 
(default).

● Any system time input will be used as the 
interrupt time stamp when a signal change 
occurs.

Note: If an interrupt is to be time-stamped with 
a local time, a conversion module must be 
connected in series to convert the local time to 
system time. This is the only way to make sure 
that the time stamp is shown correctly in the 
interrupt display.

SD_i
 
 

Input LREAL, REAL, 
DINT, INT, 
DWORD, 
WORD, BYTE, 
BOOL, STRING 
or CHAR

I, Q, M, D, T, C i-th associated value (0 ≤ i ≤ 10)
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Parameter Declaration Data type Memory area Description
ERROR Input BOOL I, Q, M, D, L Status parameter ERROR

ERROR = TRUE indicates that an error has 
occurred during processing. The possible 
error cause is displayed at the STATUS 
parameter.

STATUS Input WORD I, Q, M, D, L Status parameter STATUS
Display of error information (see "ERROR  and 
STATUS parameters").

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters ERROR and STATUS
The following table contains all specific error information that can be output via the ERROR  
and STATUS  parameters.

ERROR STATUS* Explanation
0 0000 No error
0 7001 Alarm is generated.
1 8001 Invalid static alarm information.
1 8002 No valid static alarm information.
1 8004 Maximum size of 512 bytes for the alarm has been reached.
1 8005 Incoming alarm.
1 8007 Outgoing alarm, preceded by no incoming alarm.
1 8087 Deactivate static alarms.
1 8089 Length of the alarm is too large.
1 80Ax The parameter nr. x has an invalid value.
1 80C1 The CPU cannot generate any alarms at this time because initialization routines are running (this 

is the case after download in RUN, for example). Try again later.
1 80C2 The maximum number of alarms per time unit has been sent. Try again later.
1 80C3 All dynamic alarm instances are being used. Try again later.
1 80C4 Alarm is being output and cannot be overwritten. Try again later.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Get_AlarmState: Output alarm status

Description
The "Get_AlarmState" instruction outputs the alarm status of a program alarm. The output of 
the alarm status always refers to a program alarm that was created using the 
"Program_Alarm (Page 2470)" instruction.

The program alarm is selected with the Alarm input parameter. Specify the instance DB of the 
"Program_Alarm" instruction at the Alarm parameter.
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The alarm status is returned in a byte via the AlarmState output parameter. The meaning of 
the individual bits is shown in the following figure:

You can find more information about the possible alarm states in the section "Auto-Hotspot". 

The execution status of the instruction is shown with the output parameters ERROR and 
STATUS. 

Parameters
The following table shows the parameters of the "Get_AlarmState" instruction:

Parameter Declaration Data type Memory area Description
Alarm Input ALARM_BASE D Instance of the "Program_Alarm (Page 2470)" 

instruction. 
AlarmState Output BYTE I, Q, M, D, L Status of the alarm as a bit array.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L Status parameter

● 0: No error
● 1: An error occurred during execution of the 

instruction.
Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter
The parameter is only set for the duration of 
one call. To display the status, you should 
therefore copy STATUS to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code* 
(W#16#...)

Explanation

8001 Invalid static alarm instance.
8002 ID of the alarm is invalid.
8003 No active alarms within the message class.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Gen_UsrMsg: Generate user diagnostic alarms

Description
You use the "Gen_UsrMsg" instruction to generate a user diagnostic alarm. By means of user 
diagnostic alarms, you can write a user entry to the diagnostics buffer and send a 
corresponding alarm.

The entry to the diagnostics buffer and the query of the Send parameter take place at the same 
time. The info report is transmitted asynchronously.

You define the contents of the user entry to the diagnostics buffer with the parameters TextID, 
TextListID, AlarmDomain and AssocValues.
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Parameters
The following table shows the parameters of the "Gen_UsrMsg" instruction:

Parameter Declaration Data type Memory area Description
Mode Input UInt I, Q, M, D, L or 

constant
● 1: Incoming alarm
● 2: Outgoing alarm

Send Input Bool I, Q, M, D, L or 
constant

● 0: Do not send info report
● 1: Send info report

TextID Input UInt I, Q, M, D, L or 
constant

ID of the user-defined text

TextListID Input UInt I, Q, M, D, L or 
constant

ID of the user-defined text list

AlarmDomain Input UInt I, Q, M, D, L or 
constant

Used alarm domain

Ret_Val Return Int I, Q, M, D, L Error code of the instruction
AssocValues InOut Array [0..7] of 

UInt
I, Q, M, D, L Associated values

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL
The following table contains all specific error information that can be output via the RET_VAL  
parameter.

Error code* 
(W#16#...)

Explanation

0000 No error
8080 Value in the MODE parameter is not supported.
80C1 Resource bottleneck due to too many parallel calls. 
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

9.7.3.9 Diagnostics

RD_SINFO: Read current OB start information

Description
You use the instruction "RD_SINFO" to read the start information

● of the last OB called that has not yet been completely executed, and

● of the last startup OB started.
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There is no time stamp in either case. If the call is in OB 100, OB 101 or OB 102, two identical 
start information messages will be returned.

Parameter
The following table shows the parameters of the "RD_SINFO" instruction:

Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L Error information
TOP_SI Output VARIANT D, L Start information of the current OB
START_UP_SI Output VARIANT D, L Start information of the startup OB 

last started

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

SDTs of the TOP_SI parameter
The following table shows the possible SDTs for the TOP_SI parameter:

Organization blocks (OB) System data types (SDT) System data type numbers
Any SI_classic 592
 SI_none 593
ProgramCycleOB SI_ProgramCycle 594
TimeOfDayOB SI_TimeOfDay 595
TimeDelayOB SI_Delay 596
CyclicOB SI_Cyclic 597
ProcessEventOB SI_HWInterrupt 598
ProfileEventOB
StatusEventOB
UpdateEventOB

SI_Submodule 601

SynchronousCycleOB SI_SynchCycle 602
IOredundancyErrorOB SI_IORedundancyError 604
CPUredundancyErrorOB SI_CPURedundancyError 605
TimeErrorOB SI_TimeError 606
DiagnosticErrorOB SI_DiagnosticInterrupt 607
PullPlugEventOB SI_PlugPullModule 608
PeripheralAccessErrorOB SI_AccessError 609
RackStationFailureOB SI_StationFailure 610
ServoOB SI_Servo 611
IpoOB SI_Ipo 612
StartupOB SI_Startup 613
ProgrammingErrorOB
IOaccessErrorOB

SI_ProgIOAccessError 614
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SDTs of the START_UP_SI parameter
The following table shows the possible SDTs for the START_UP_SI parameter:

 

System data types (SDT) System data type numbers
SI_classic 592
SI_none 593
SI_Startup 613

Structures
The following tables set out the meaning of the structure elements of the individual structures:

Table 9-57 SI_classic structure

Structure element Data type Description
EV_CLASS BYTE ● Bits 0 to 3: Event ID

● Bits 4 to 7: Event class
EV_NUM BYTE Event number
PRIORITY BYTE Priority class number

(Meaning of B#16#FE: OB not available or disabled or cannot be started in 
current operating mode)

NUM BYTE OB number
TYP2_3 BYTE Data ID 2_3: 

Identifies the information entered in ZI2_3
TYP1 BYTE Data ID 1: 

Identifies the information entered in ZI1
ZI1 WORD Additional information 1
ZI2_3 DWORD Additional information 2_3

Table 9-58 SI_none structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)

Table 9-59 SI_ProgramCycle structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 1 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
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Structure element Data type Description
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
Remanence BOOL For OB_Class = 1

Table 9-60 SI_TimeOfDay structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 10 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
CaughtUp BOOL For OB_Class = 10
SecondTime BOOL For OB_Class = 10

Table 9-61 SI_Delay structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 20 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Sign WORD For OB_Class = 20

Table 9-62 SI_Cyclic structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 30 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
Event_Count INT For OB_Class = 30, 51, 52, 61, 65, 91, 92

Table 9-63 SI_HWInterrupt structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 40 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
USI WORD For OB_Class = 40
IChannel USINT For OB_Class = 40
EventType BYTE For OB_Class = 40
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Table 9-64 SI_Submodule structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Slot UINT For OB_Class = 55, 56, 57
Specifier WORD For OB_Class = 55, 56, 57

Table 9-65 SI_SynchCycle structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 61 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
PIP_Input BOOL For OB_Class = 61, 91, 92
PIP_Output BOOL For OB_Class = 61, 91, 92
IO_System USINT For OB_Class = 61, 91, 92
Event_Count INT For OB_Class = 30, 51, 52, 61, 65, 91, 92
SyncCycleTime LTIME Calculated cycle time

Table 9-66 SI_IORedundancyError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 70 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_ANY For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Event_Class BYTE For OB_Class = 70, 83, 85, 86
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86

Table 9-67 SI_CPURedundancyError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 72 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Switch_Over BOOL For OB_Class = 72
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Table 9-68 SI_TimeError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 80 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86
Csg_OBnr OB_ANY For OB_Class = 80
Csg_Prio UINT For OB_Class = 80

Table 9-69 SI_DiagnosticInterrupt structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 82 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
IO_State WORD For OB_Class = 82
LADDR HW_ANY For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Channel UINT For OB_Class = 82
MultiError BOOL For OB_Class = 82

Table 9-70 SI_PlugPullModule structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 83 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Event_Class BYTE For OB_Class = 70, 83, 85, 86
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86

Table 9-71 SI_AccessError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 85 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Event_Class BYTE For OB_Class = 70, 83, 85, 86
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86
IO_Addr UINT For OB_Class = 85
IO_LEN UINT For OB_Class = 85
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Table 9-72 SI_StationFailure structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 86 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Event_Class BYTE For OB_Class = 70, 83, 85, 86
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86

Table 9-73 SI_Servo structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 91 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
PIP_Input BOOL For OB_Class = 61, 91, 92
PIP_Output BOOL For OB_Class = 61, 91, 92
IO_System USINT For OB_Class = 61, 91, 92
Event_Count INT For OB_Class = 30, 51, 52, 61, 65, 91, 92
Synchronous BOOL  

Table 9-74 SI_Ipo structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 92 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
PIP_Input BOOL For OB_Class = 61, 91, 92
PIP_Output BOOL For OB_Class = 61, 91, 92
IO_System USINT For OB_Class = 61, 91, 92
Event_Count INT For OB_Class = 30, 51, 52, 61, 65, 91, 92
Reduction UINT For OB_Class = 92

Table 9-75 SI_Startup structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 100 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
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Structure element Data type Description
LostRetentive BOOL For OB_Class = 100
LostRTC BOOL For OB_Class = 100

Table 9-76 SI_ProgIOAcessError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
BlockNr UINT For OB_Class = 121, 122
Reaction USINT For OB_Class = 121, 122
Fault_ID BYTE For OB_Class = 121, 122
BlockType USINT For OB_Class = 121, 122
Area USINT For OB_Class = 121, 122
DBNr DB_ANY For OB_Class = 121, 122
Csg_OBNr OB_ANY For OB_Class = 121, 122
Csg_Prio USINT For OB_Class = 121, 122
Width USINT For OB_Class = 121, 122

 

 Note

The structure elements specified for the SI_classic structure are identical in content to the 
temporary tags of any OB created with the block property "Default".

Please note, however, that temporary tags of the individual OBs can have different names 
and different data types. Also note that the call interface of each OB includes additional 
information regarding the date and the time of the OB request.

 

Bits 4 to 7 of the EV_CLASS structure element contain the event class. The following values 
are possible here:

● 1: Start events from standard OBs

● 2: Start events from synchronous error OBs

● 3: Start events from asynchronous error OBs

The PRIORITY structure element supplies the priority class belonging to the current OB.

Apart from these two elements, NUM  is also relevant. NUM  contains the number of the current 
OB or the startup OB that was started last.
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RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code* 
(W#16#...)

Explanation

8080 Start information of the current OB does not correspond to the specified user-defined data type
8081 Start information of the current OB does not correspond to the specified system data type
8082 Start information of the last startup OB started does not correspond to the specified user-defined data type
8083 Start information of the last startup OB started does not correspond to the specified system data type

Example
OB 80 is the OB that was called last and that has not yet been completely processed and OB 
100 is the start-up OB that was started last.

The following table shows the assignment between the structure elements of the TOP_SI 
parameter of the "RD_SINFO" instruction and the associated local tags of OB 80.

TOP_SI
structure element

Data type OB 80 - Associated local tag Data type

EV_CLASS BYTE OB80_EV_CLASS BYTE
EV_NUM BYTE OB80_FLT_ID BYTE
PRIORITY BYTE OB80_PRIORITY BYTE
NUM BYTE OB80_OB_NUMBR BYTE
TYP2_3 BYTE OB80_RESERVED_1 BYTE
TYP1 BYTE OB80_RESERVED_2 BYTE
ZI1 WORD OB80_ERROR_INFO WORD
ZI2_3 DWORD OB80_ERR_EV_CLASS BYTE

OB80_ERR_EV_NUM BYTE
OB80_OB_PRIORITY BYTE
OB80_OB_NUM BYTE

The following table shows the assignment between the structure elements of the 
START_UP_SI  parameter of the "RD_SINFO" instruction and the associated local tags of 
OB 100.

START_UP_SI
structure element

Data type OB 100 - Local tag Data type

EV_CLASS BYTE OB100_EV_CLASS BYTE
EV_NUM BYTE OB100_STRTUP BYTE
PRIORITY BYTE OB100_PRIORITY BYTE
NUM BYTE OB100_OB_NUMBR BYTE
TYP2_3 BYTE OB100_RESERVED_1 BYTE
TYP1 BYTE OB100_RESERVED_2 BYTE
ZI1 WORD OB100_STOP WORD
ZI2_3 DWORD OB100_STRT_INFO DWORD
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See also
Evaluating errors with output parameter RET_VAL (Page 1584)

LED: Read LED status

Description       
You can use the "LED" instruction to read out the status (e.g., "On" or "Off") of a particular 
module LED.

● With the LADDR parameter, you address the CPU or the interface.

● With the LED parameter, you select the module LED whose current status is to be read out 
using the instruction.

● The RET_VAL parameter outputs the status of the selected LED when the instruction is 
called. Depending on the LED selected, only certain status information may be displayed. 
For example, some LEDs have only color information. Refer to the hardware documentation 
of the respective module for the available status information of a particular LED.

Parameters
The following table shows the parameters of the "LED" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, L or constant Identification number of the CPU or interface. 

The number is automatically assigned and 
stored in the CPU properties or the interface 
in the hardware configuration.

LED Input UINT I, Q, M, D, L or 
constant

Identification number of the LED:
● 1: STOP/RUN
● 2: ERROR
● 3: MAINT (maintenance)
● 4: Redundant
● 5: Link (green)
● 6: Rx/Tx (yellow)

RET_VAL Return INT I, Q, M, D, L Status of LED

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter RET_VAL

RET_VAL Description
0 to 9 LED status:

● 0 = LED does not exist
● 1 = Permanently switched off
● 2 = Color 1 (e.g., for LED STOP/RUN: green) permanently ON
● 3 = Color 2 (e.g., for LED STOP/RUN: orange) permanently ON
● 4 = Color 1 flashing at 2 Hz
● 5 = Color 2 flashing at 2 Hz
● 6 = Colors 1 and 2 flashing alternately at 2 Hz
● 7 = LED is active, color 1
● 8 = LED is active, color 2
● 9 = LED exists, but status information not available

8091 Module addressed with the LADDR parameter does not exist.
8092 A module that does not support LEDs was addressed with the LADDR parameter.
8093 The identification number specified in the LED parameter is not defined.
80Bx The CPU specified in the LADDR parameter does not support the "LED" instruction.

Get_IM_Data: Reading identification and maintenance data

Description
The "Get_IM_Data" instruction reads the identification and maintenance data (I&M) data from 
a device. Use the LADDR parameter to select the device from which you want to read the I&M 
via the hardware identifier.

You select the data to be read via the instruction using the IM_TYPE parameter. Reading the 
I&M 0 data is supported for TIA Portal V12 SP1 (IM_TYPE = 0). The I&M 0 data are the device-
specific basic information of a device and contain information such as the manufacturer ID, 
order number, serial number and the hardware and firmware version. This information is also 
displayed with the "Online & Diagnostics" view of a device.

The I&M 0 data read are written to the addressed area defined at the DATA parameter. You 
can use a STRING, or an ARRAY of CHAR/BYTE or STRUCT data structure to store the data:

● If you address a string (STRING data type) at the the DATA parameter, the length of the 
string automatically adjusts the length of the read I&M data (up to 254 characters).

● If you crate a data structure with a STRUCT data type at the DATA parameter, use a data 
block without optimized block access (see category "Attributes" of the block properties).

● If you address a data structure (ARRAY of CHAR/BYTE or STRUCT) a the DATA 
parameter, the I&M data read are written to the individual components of the data type 
used. If the addressed data structure is longer than the read data, the remaining 
components are filled with zeros.
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● The "IuM0_data" structure can also be used to read the I&M 0 data (parameter IM_TYPE 
= 0).

● Other data types are not permissible. If a data type other than STRING, ARRAY of BYTE/
CHAR or STRUCT is used at the DATA parameter, the STATUS parameter generates error 
code 8093.

The execution status of the read job is displayed via the BUSY, DONE, ERROR output 
parameters and the two middle bytes of the STATUS output parameter. 

Definition: Identification and maintenance data (I&M)
Identification and maintenance (I&M) data refers to information stored in a module, which 
assists you in checking the plant configuration, locating hardware changes in a plant and 
eliminating errors.

● Identification data (I data) are static information about a device that can only be read.

● Maintenance data (M-data) refers to plant-dependent information, such as the installation 
location or date. Maintenance data are created during configuration and written to the 
module.

Parameters
The following table shows the parameters of the "Get_IM_Data" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, D, L or 

constant
Hardware ID of the device The 
number is assigned automatically 
and is stored in the properties of the 
device or in the hardware 
configuration.

IM_TYPE Input UINT I, Q, M, D, L or 
constant

Identification and maintenance data 
number
Connect this parameter to the value 
"0".

DATA InOut VARIANT I, Q, M, D, L Area for storing the read identification 
and maintenance data.

DONE Output BOOL I, Q, M, D, L The instruction was executed 
successfully. The I&M data were 
transferred to the DATA parameter.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: Execution of the instruction 

complete.
● 1: Execution of the instruction not 

yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L Status parameter

● 0: No error.
● 1: An error occurred during 

execution of the instruction.
Detailed information is output via the 
STATUS parameter.

STATUS Output WORD I, Q, M, D, L Status parameter 
The parameter is only set for the 
duration of one call. To display it, you 
should therefore copy STATUS to a 
free data area.

You can find more information on the data types in "Overview of the valid data types 
(Page 1077)".

Parameter DATA
The "IuM0_data" structure can also be used to read and store the I&M 0 data (parameter 
IM_TYPE = 0).

Parameter Data type Bytes Description
Manufacturer_ID UINT 2 Manufacturer ID (e.g. "42" for SIEMENS)
Order_ID CHAR[20] 20 Order number
Serial_Number CHAR[16] 16 Serial number
Hardware_Revision UNIT 2 Hardware revision
Software_Revision STRUCT 4 Firmware revision
 Type CHAR 1 -

Functional UNIT8 1 -
Bugfix UNIT8 1 -
Internal UINT8 1 -

Revision_Counter UINT 2 Revision counter
Profile_ID UNIT 2 Profile
Profile_Specific_Type UNIT 2 Device class
IM_Version UNIT 2 -
I&M_Supported UNIT 2 -

Parameter STATUS

Error code* 
(W#16#...)

Description

0 No error
7000 No job in progress.
7001 First call of the asynchronous instruction "Get_IM_Data". Execution of the instruction 

not yet complete (BUSY = 1, DONE = 0).
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Error code* 
(W#16#...)

Description

7002 Additional call of the asynchronous instruction "Get_IM_Data". Execution of the 
instruction not yet complete (BUSY = 1, DONE = 0).

8091 The device addressed at the LADDR parameter does not exist.
8092 LADDR addresses a device that does not support the output of the I&M data.
8093 Data type at the DATA parameter is not supported.
80B1 The "Get_IM_Data" instruction is not supported by the CPU used.
80B2 Invalid value at the IM_TYPE parameter or the selected IM_TYPE is not supported by 

the CPU or the addressed device.
8752 The memory area specified at the  DATA parameter is too small to store all the I&M 

data. The read I&M data are stored only up to the maximum length of the specified 
memory area.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For 
additional information on toggling display formats, refer to "See also".

GET_NAME: Reading the name of a module

Description
The instruction "GET_NAME" reads the name of an IO device. The name is displayed in the 
network view and in the properties of the IO device:

You select the IO device by using the hardware identifier of the PROFINET IO system (at the 
LADDR parameter) and the device number of the IO device (STATION_NR parameter).
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Once the instruction has been executed, the name of the IO device is written to the area 
addressed with the DATA parameter.

The length of the name is output at the LEN parameter. If the name is longer than the area 
specified at the DATA parameter, only that section which corresponds to the maximum length 
of the addressed area will be written.

Parameters
The following table shows the parameters of the "GET_NAME" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IOSYSTEM I, Q, M, D, L or 

constant
Hardware identifier of the PROFINET IO 
system. The number from the PROFINET IO 
system properties can be applied in the 
network view.

STATION_NR Input UINT I, Q, M, D, L or 
constant

Device number of the IO device. The device 
number can be applied in the Network view 
from the properties of the IO device under 
"Ethernet addresses".

DATA InOut VARIANT I, Q, M, D, L Pointer to the area to which the name of the 
module is written.

DONE Output BOOL I, Q, M, D, L The instruction was executed successfully. 
Name of the module transferred to the area at 
the DATA parameter.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: Execution of the instruction complete.
● 1: Execution of the instruction not yet 

complete.
ERROR Output BOOL I, Q, M, D, L Status parameter

● 0: No error.
● 1: An error occurred during execution of the 

instruction.
Detailed information is output via the STATUS 
parameter.

LEN Output DINT I, Q, M, D, L Length of the name of the IO device (number 
of characters).

STATUS Output WORD I, Q, M, D, L Status parameter
The parameter is only set for the duration of 
one call. To display the status, you should 
therefore copy STATUS to a free data area. 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter STATUS

Error code* 
(W#16#...)

Explanation

0 No error
7000 No job in progress.
7001 First call of the asynchronous instruction "GET_NAME". Execution of the instruction not yet complete (BUSY 

= 1, DONE = 0).
7002 Additional call of the asynchronous instruction "GET_NAME". Execution of the instruction not yet complete 

(BUSY = 1, DONE = 0).
8090 The LADDR input parameter contains an invalid value. Possible causes:

● The specified number is not a hardware identifier of a PROFINET IO system. 
● You have not specified a number at the LADDR parameter.

8092 The value at the LADDR parameter does not address a PROFINET IO system.
8093 Instruction does not support data type at the DATA parameter.
8095 Device number (STATION_NR parameter) does not exist in the selected PROFINET IO system.
80B1 The CPU used does not support the instruction.
80C3 Temporary resource error: The CPU is currently processing the maximum possible number of simultaneous 

block calls. "GET_NAME" cannot be executed unless at least one of the block calls is finished.
8852 The area specified at the DATA parameter is too short for the full name of the IO device. The name will be 

written up to the maximum possible length.
To read the full name, use a longer data area at the DATA parameter. The area must have at least as many 
characters as there are at the LEN parameter.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

GetStationInfo: Read information of an IO device

Description
You can use the "GetStationInfo" instruction to read information of a PROFINET IO device. 
The instruction also enables you to read the information of an IO device located in a lower-
level IO system (connected via CP/CM). 

The IO device is addressed via the hardware identifier of the station at the LADDR parameter. 
The hardware identifier is displayed in the "Devices & Networks" view in the station properties.

Use the MODE parameter to select the information to be read. The instruction supports reading 
the IP address parameters according IPv4 in TIA V12 SP1 (MODE = 1).

At the DATA parameter, specify the data area to which you want to write the read address 
data. Use the "IF_CONF_v4" structure to store the IP address.

Enable reading of the address data using the REQ control parameter. This requires the IO 
device to be accessible.
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The execution status of the read job is displayed via the BUSY, DONE, ERROR output 
parameters and the STATUS output parameter. 

 

 Note
Address the IO device using only the hardware identifier of the station

The station, the IO device and PROFINET interface have their own hardware identifier. Use 
only the hardware identifier of the station for the "GetStationInfo" instruction.

If a PROFINET is addressed via the LADDR parameter, for example, the address data is not 
read and the error code 8092 is generate.

To read the address data of an integrated PROFINET interface or a CM/CP in the central 
configuration, use the "RDREC" instruction.

 

Parameters
The following table shows the parameters of the "GetStationInfo" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Control parameter Request

Activates the reading of the information 
with REQ = "1".

LADDR Input HW_DEVICE I, Q, M, D, L or 
constant

Hardware identifier of the station of the 
IO device
The number can be taken from the 
properties of the station in the Network 
view or from the "System constants" 
tab of the standard tag table.

DETAIL Input HW_SUBMO
DULE

I, Q, M, D, L or 
constant

The DETAIL parameter is not used. 
Leave the parameter unconnected.

MODE Input UNIT I, Q, M, D, L or 
constant

Selection of address data to be read
Connect the MODE parameter with "1" 
(read address parameter according to 
IPv4).

DATA InOut VARIANT D, L Pointer to the area to which the 
address data of the IO device is written. 
Use the "IF_CONF_v4" structure for 
MODE = 1.

DONE Output BOOL I, Q, M, D, L The instruction was executed 
successfully. The address data was 
transferred to the DATA parameter.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: Execution of the instruction 

complete.
● 1: Execution of the instruction not 

yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L Status parameter

● 0: No error.
● 1: An error occurred during 

execution of the instruction.
Detailed information is output via the 
STATUS parameter.

STATUS Output WORD I, Q, M, D, L Status parameter 
The parameter is only set for the 
duration of one call. To display the 
status, you should therefore copy 
STATUS to a free data area.

You can find more information on the data types in "Overview of the valid data types 
(Page 1077)".

Parameter DATA 
Use the "IF_CONF_v4" structure at the DATA parameter to store the address parameter 
according to IPv4.

Byte Parameter Data type Start value Description
0 … 1 Id UINT 30 ID of the "IF_CONF_v4" structure.
2 … 3 Length UNIT 18 Length of data read in BYTE.
4 ... 5 Mode UNIT 0 Not relevant for the "GetStationInfo" 

instruction (left at "0").
6 ... 9 InterfaceAddress ARRAY 

[1..4] of 
BYTE

- IP address of the IO device in the format 
IP_V4, e.g. for 192.168.3.10:
● addr[1] = 192 
● addr[2] = 168 
● addr[3] = 3 
● addr[4] = 10 

10 … 
13

SubnetMask ARRAY 
[1..4] of 
BYTE

- Subnet mask of the IO device in the format 
IP_V4, e.g. for 255.255.255.0: 
● addr[1] = 255
● addr[2] = 255
● addr[3] = 255
● addr[4] = 0

14 ... 
17

DefaultRouter ARRAY 
[1..4] of 
BYTE

- IP address of the router in the format IP_V4, 
e.g. for 192.168.3.1:
● addr[1] = 192 
● addr[2] = 168 
● addr[3] = 3 
● addr[4] = 1 
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Parameter STATUS

Error code* 
(W#16#...)

Explanation

0 No error
7000 No job in progress.
7001 First call of the asynchronous instruction "GetStationInfo". Execution of the instruction 

not yet complete (BUSY = 1, DONE = 0).
7002 Additional call of the asynchronous instruction "GetStationInfo". Execution of the 

instruction not yet complete (BUSY = 1, DONE = 0).
8080 Value at the MODE parameter is not supported.
8090 The hardware identifier specified at the LADDR parameter is not configured.
8092 The LADDR parameter does not address a PROFINET IO device.
8093 Invalid data type at the DATA parameter.
80A0 Cannot read requested information.
80C0 Addressed IO device is not reachable.
80C3 The maximum number of simultaneous calls of the "GetStationInfo" instruction (10 

instances) has been reached.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For 
additional information on toggling display formats, refer to "See also".

DeviceStates: Read module status information in an IO system

Description
You use the instruction "DeviceStates" to query specific status information for all modules in 
an IO system, which means:

● Either for all IO devices in a PROFINET IO system

● Or for all DP slaves in a DP master system

The Boolean value that is output indicates the modules to which the selected status applies. 
You can, for example, read which IO devices are currently disabled in a PROFINET IO system.

Information is also displayed as to whether the status information to be read applies to at least 
one of the IO devices or DP slaves.

The instruction can be called in a cyclic OB as well as in an interrupt OB (e.g. OB82 - diagnostic 
interrupt).
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Parameters
The following table shows the parameters of the "DeviceStates" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IOSYSTEM I, Q, M, L or constant Hardware identifier of the PROFINET IO 

or DP master system (see description 
below)

MODE Input UINT I, Q, M, D, L or constant Selection of status information to be read 
(see description below)

RET_VAL Return INT I, Q, M, D, L Status of instruction (see description 
below)

STATE InOut VARIANT I, Q, M, D, L Buffer for status of the IO devices or the 
DP slaves (see description below)

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter LADDR
You select the PROFINET IO or DP master system at the LADDR parameter by means of the 
hardware identifier.

The hardware identifier is available:

● Either in the Network view of the properties of the PROFINET IO or DP master system.

● Or in the PLC tag table in the listed system constants with the data type HW_IOSYSTEM.

Parameter MODE
You use the MODE parameter to read out status information. You can read out one of the 
following status information items for the entire PROFINET IO or DP master system:

● 1: IO devices/DP slaves are configured

● 2: IO devices/DP slaves are faulty

● 3: IO devices/DP slaves are disabled

● 4: IO devices/DP slaves exist

● 5: IO devices/DP slaves for which a problem has occurred. For example:

– Maintenance demanded or recommended

– Not accessible

– Not available

– Error occurred

Parameter STATE
With the STATE parameter, the status of the IO devices/DP slaves that was selected with the 
MODE parameter is output. 
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If the status selected using MODE applies to an IO device/DP slave, the following bits are set 
to "1" at the STATE parameter:

● Bit 0 = 1: Group display. The bit n of at least one IO device/DP slave was set to "1".

● Bit n = 1: The status selected with MODE applies to the IO device/DP slave. 

– With a PROFINET IO system, bit n corresponds to the device number of the respective 
IO device (see properties of the PROFINET interface in the device view and network 
view)

– With a PROFIBUS DP system, bit n corresponds to the PROFIBUS address of the DP 
slave (see properties of the DP slave in the device view and network view)

Use "BOOL" or "Array of BOOL" as data type:

● To only output the bit for group display of the status information, you can use the data type 
BOOL at the STATE parameter.

● To output the status information for all IO devices/DP slaves, use Array of BOOL with the 
following length:

– With PROFINET IO system: 1024 bits

– With DP master system: 128 bits

Parameter RET_VAL

Error code*
(W#16#...)

Description

0 No error
8091 Hardware identifier of the LADDR parameter does not exist. Check (for example, in the system constants) 

whether the value for LADDR exists in the project.
8092 LADDR does not address a PROFINET IO or DP master system.
8093 Invalid data type at the STATE parameter.
80B1 Instruction "DeviceStates" is not supported by the CPU.
80B2 The selected MODE parameter is not supported by the used CPU for the IO system specified in the LADDR 

parameter.
8452 The complete status information does not fit in the tag configured in the STATE parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example - Reading the faulty stations of a PROFINET IO master system
A PROFINET IO system consists of 4 IO devices with the device numbers 1, 2, 3 and 4. The 
IO device with number 2 is faulty.

The instruction "DeviceStates" is executed for the PROFINET IO system with MODE = 2 (faulty/
not faulty). 

The following bits are set in the STATE parameter:

● Bit 0 = 1: A fault exists for at least one of the IO devices.

● Bit 1 = 0: IO device with device number 1 is not faulty.
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● Bit 2 = 1: IO device with device number 2 is faulty.

● Bit 3 = 0: IO device with device number 3 is not faulty.

● Bit 4 = 0: IO device with device number 4 is not faulty.

● Bit 5 = 0: irrelevant

● Bit 6 = 0: irrelevant

● ...

Example - Reading the faulty stations of a PROFIBUS DP master system
A DP master system consists of 4 DP slaves with the PROFIBUS addresses 3, 4, 5 and 6. 
The DP slave with address 4 is faulty.

The instruction "DeviceStates" is executed for the DP master system with MODE = 2 (faulty/
not faulty). 

The following bits are set in the STATE parameter:

● Bit 0 = 1: A fault exists for at least one of the DP slaves.

● Bit 1 = 0: irrelevant

● Bit 2 = 0: irrelevant

● Bit 3 = 0: DP slave with address 3 is not faulty.

● Bit 4 = 1: DP slave with address 4 is faulty.

● Bit 5 = 0: DP slave with address 5 is not faulty.

● Bit 6 = 0: DP slave with address 6 is not faulty.

● Bit 7 = 0: irrelevant

● Bit 8 = 0: irrelevant

● ...

ModuleStates: Read module status information of a module

Description
You can use the "ModuleStates" instruction to read the status information of the modules of a 
PROFINET IO device or PROFIBUS DP slave. 

The Boolean value that is output indicates the modules to which the selected status applies. 
You can, for example, read which modules are currently disabled in a PROFINET IO device.

Information is also displayed as to whether the status information to be read applies to at least 
one of the modules.

The instruction can be called in a cyclic OB as well as in an interrupt OB (e.g. OB82 - diagnostic 
interrupt).
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Parameters
The following table shows the parameters of the "ModuleStates" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_DEVICE I, Q, M, D, L or 

constant
Hardware identifier of the station (see 
description below)

MODE Input UINT I, Q, M, D, L or 
constant

Selection of module status information to be 
read (see description below)

RET_VAL Return INT I, Q, M, D, L Status of instruction (see description below)
STATE InOut VARIANT I, Q, M, D, L Buffer for the module status (see description 

below)

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter LADDR
You select the IO device or the DP slave at the LADDR parameter by means of the hardware 
identifier of the station.

The hardware identifier is available:

● Either in the network view of the properties of the IO device station or DP slave station.

● Or in the PLC tag table for the listed system constants with the data type HW_DEVICE (for 
an IO device) or with the data type HW_DPSLAVE (for a DP slave).

Parameter MODE
You use the MODE parameter to read out status information. One of the following status 
information items can be read for the modules:

● 1: Modules are configured

● 2: Modules are faulty

● 3: Modules are disabled

● 4: Modules exist

● 5: There is a problem in the modules. For example:

– Maintenance demanded or recommended

– Not accessible

– Not available

– Error occurred

Parameter STATE
The STATE parameter outputs the status of the modules selected with the MODE parameter. 

If the status selected using MODE applies to a module, the following bits are set to "1":
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● Bit 0 = 1: Group display. The bit n of at least one module was set to "1".

● Bit n = 1: The status selected with MODE applies to the module in slot n-1 (example: bit 3 
= slot 2). 

Use "BOOL" or "Array of BOOL" as data type:

● To only output the bit for group display of the status information, you can use the data type 
BOOL at the STATE parameter.

● To output the status information for all modules, use Array of BOOL with a length of 128 
bits.

Parameter RET_VAL

Error code*
(W#16#...)

Description

0 No error
8091 Hardware identifier of the LADDR parameter does not exist. Check (for example, in the system constants) 

whether the value for LADDR exists in the project.
8092 LADDR does not address an IO device or DP slave.
8093 Invalid data type at the STATE parameter.
80B1 The instruction "ModuleStates" is not supported by the CPU.
80B2 The selected MODE parameter is not supported by the used CPU for the IO device/the DP slave in the 

LADDR parameter.
8452 The complete status information does not fit in the tag configured in the STATE parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example
An IO device includes 4 modules in slots 1 to 4. The module in slot 2 is faulty. 

The instruction "ModuleStates" is executed for the IO device with MODE = 2 (faulty/not faulty). 

The following bits are set in the STATE parameter:

● Bit 0 = 1: A fault exists for at least one module.

● Bit 1 = 0: Slot number 0 (used by IO device)

● Bit 2 = 0: Module in slot number 1 is not faulty.

● Bit 3 = 1: Module in slot number 2 is faulty.

● Bit 4 = 0: Module in slot number 3 is not faulty.

● Bit 5 = 0: Module in slot number 4 is not faulty.

● Bit 6 = 0: irrelevant

● Bit 7 = 0: irrelevant
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GEN_DIAG: Generate diagnostics information

Description
The "GEN_DIAG" instruction generates diagnostics information for hardware components from 
other manufacturers for use in TIA Portal diagnostics. The GSD(GSDL/GSDML) file supplied 
by the manufacturer must first be installed before the instruction can be used.

The instruction generates all diagnostic events (including those for maintenance).

● Use the LADDR parameter to select the hardware component for which you want to 
generate a diagnostic event.

● Use the MODE parameter to specify whether the event is to be outgoing or incoming.

● Use the DiagEvent parameter to define the diagnostic event in the DiagnosticDetail 
structure. The structure is created automatically in the local interface of the block when you 
define a tag at the DiagEvent parameter.

The diagnostics information is provided synchronously. Diagnostics information transfer and 
alarm output are asynchronous.

 
 

 NOTICE

Failsafe-specific errors messages are not valid

If you define failsafe-specific diagnostics information at the DiagEvent parameter, the 
instruction will check this information and output the error code 80A1.

 

Parameters
The following table shows the parameters of the "GEN_DIAG" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_ANY I, Q, M, D, L or 

constant
Identification number of the hardware 
component

MODE Input UINT I, Q, M, D, L or 
constant

Selection of incoming/outgoing information:
● 1: The diagnostic event specified is an 

incoming event
● 2: The diagnostic event specified is an 

outgoing event
● 3: All diagnostic events are outgoing. 

There are therefore no hardware 
component faults (green diagnostics 
symbol). The DiagEvent parameter is not 
evaluated when MODE = 3.
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Parameter Declaration Data type Memory area Description
DiagEvent InOut DiagnosticDetail L Specifies the diagnostic event (see 

"DiagEvent parameter"). 
RET_VAL Return INT I, Q, M, D, L Status of instruction / error message (see 

"RET_VAL parameter")

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

DiagEvent parameter
The structure DiagnosticDetail is a system data type for specifying the diagnostic event. Its 
structure is as follows:

Parameter Data type Description
DiagnosticDet
ail

Struct  

 ChannelI
nfo

WORD Channel properties (0...7)

ALID UINT Local ID of the alarm. The ID uniquely identifies the alarm.
TextID UINT ID of an alarm text in a text list.
Channel
Number

UINT Manufacturer-specific channel number (0x0000 — 0x7FFF)

Addval_0 DWORD Placeholder for additional information The value / list of values depends on the connection 
error.

TextID2 UINT Texts for CPU response (mode, OB calls, etc.).
LADDR HW_ANY Identical to the LADDR parameter.
TextListI
d

UINT ● 0: No text list
● ≠0: ID of the text list

Channel
Direction

UINT ● 0000: irrelevant
● FFF1: Input
● FFF2: Output
● FFF3: Input/Output

Addval_1 DWORD Placeholder for additional information on the channel error (depends on the GSD file).
For channel error types, see also: IEC 61158 (PROFINET IO Type 10 and PROFIBUS 
DP Type 3).

Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0 No error
8080 Value in the MODE parameter is not supported.
8090 Identification for hardware component not available at the LADDR parameter.
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Error code* 
(W#16#...)

Explanation

8091 Diagnostics information cannot be generated for the hardware component addressed at the LADDR 
parameter.

80A1 ● Content of the DiagnosticsDetail structure at the DiagEvent parameter is invalid or inconsistent.
● Failsafe-specific diagnostics information defined at the DiagEvent parameter (not valid).

80A4 Hardware component addressed cannot be accessed.
80C1 Insufficient resources for parallel execution.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

GET_DIAG: Read diagnostic information

Description
You can use the "GET_DIAG" instruction to read out the diagnostic information of a hardware 
object. The hardware object is selected using the parameter LADDR. With the MODE 
parameter, you select which diagnostic information is to be read out.

Parameters
The following table shows the parameters of the "GET_DIAG" instruction:

Parameter Declaration Data type Memory area Description
MODE Input UINT I, Q, M, D, L or constant Use the MODE parameter to select which 

diagnostic data is to be output.
LADDR Input HW_ANY 

(WORD)
I, Q, M, L or constant Hardware identifier of the device.

RET_VAL Return INT I, Q, M, D, L Status of the instruction
CNT_DIAG Output UINT I, Q, M, D, L Number of output diagnostic details
DIAG InOut VARIANT I, Q, M, D, L Diagnostic information corresponds to the 

selected mode, see table below
DETAIL InOut VARIANT I, Q, M, D, L Diagnostics details correspond with the 

selected mode.
Parameter is hidden (only used for  
MODE = 3).

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter MODE
Depending on the value at the MODE parameter, different diagnostic data is output at the 
DIAG, CNT_DIAG and DETAIL output parameters.

MODE Description DIAG CNT_DIAG DETAIL
0 Output of all supported 

diagnostic information for a 
module as DWORD, where Bit 
X=1 indicates that mode X is 
supported.

Bit string of the supported 
modes as DWORD, where 
Bit X=1 indicates that mode 
X is supported.

0 -

1 Output of the inherent status 
of the addressed hardware 
object.

Diagnostics status.
Output of the inherent status 
of the addressed hardware 
object in accordance with 
the DIS structure.

0 -

2 Output of the status of all 
subordinate modules of the 
addressed hardware object. 

Diagnostics status. Output 
in accordance with the DNN 
structure.

0 -

3 Output of the inherent status 
of the addressed hardware 
object and detailed 
information on channel 
diagnostics.

Output of the inherent status 
of the addressed hardware 
object in accordance with 
the DIS structure.

Number of module 
status information.

Module status 
information in 
accordance with the 
DiagnosticDetail 
structure.

DIS structure
With parameter MODE = 1 or = 3, the diagnostic information is output in accordance with the 
DIS structure. In this case, enter the system data type "DIS" as data type for the tag declaration.

The following table shows the meaning of the individual parameter values.

Parameter Data type Value Description
MaintenanceState DWORD Enum  

0 No maintenance required
1 The module or device is disabled.
2 -
3 -
4 -
5 Maintenance required
6 Maintenance demanded
7 Error
8 Status unknown / error in subordinate module
9 -
10 Inputs/outputs are not available.

ComponentStateD
etail

DWORD Bit array Status of the module sub-modules:
● Bit 0 to 15: Status message of the module
● Bit 16 to 31: Status message of the CPU

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2502 System Manual, 07/2013,  



Parameter Data type Value Description
0 to 2 
(enum)

Additional information:
● Bit 0: No additional information
● Bit 1: Transfer not permitted

3 Bit 3 = 1: At least one channel supports qualifiers for diagnostics
4 Bit 4 = 1: Maintenance required for at least one channel or one 

component.
5 Bit 5 = 1: Maintenance demanded for at least one channel or one 

component.
6 Bit 6 = 1: Error in at least one channel or one component.
7 to 10 Reserved (always = 0)
11 to 14 ● Bit 11 = 1: PNIO - sub-module correct

● Bit 12 = 1: PNIO - replacement module
● Bit 13 = 1: PNIO - incorrect module
● Bit 14 = 1: PNIO - module disconnected

15 Reserved (always = 0)
16 to 31 Status information for modules generated by the CPU:

● Bit 16 = 1: Module disabled
● Bit 17 = 1: CiR operation active
● Bit 18 = 1: Input not available
● Bit 19 = 1: Output not available bit 
● 20 = 1: Overflow diagnostics buffer bit 
● 21 = 1: Diagnostics not available bit 
● 22 - 31: Reserved (always 0)

OwnState UINT Enum The value of the parameter Ownstate describes the maintenance status 
of the module.

0 No fault
1 The module or device is disabled.
2 Maintenance required
3 Maintenance demanded
4 Error
5 The module or the device cannot be reached from the CPU (valid for 

modules and devices below a CPU).
6 Inputs/outputs are not available.
7 -

IOState WORD Bit array I/O status of the module
0 Bit 0 = 1: No maintenance required
1 Bit 1 = 1: The module or device is disabled.
2 Bit 2 = 1: Maintenance required
3 Bit 3 = 1: Maintenance demanded
4 Bit 4 = 1: Error
5 Bit 5 = 1: The module or the device cannot be reached from the CPU 

(valid for modules and devices below a CPU).
6 Inputs/outputs are not available.
7 Qualifier; bit 7 = 1, if bit 0, 2, or 3 are set
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Parameter Data type Value Description
8 to 15 Reserved (always = 0)

OperatingState UINT Enum  
0 -
1 In STOP / Firmware update
2 In STOP / reset memory
3 In STOP / self start
4 In STOP
5 Memory reset
6 In START
7 In RUN
8 -
9 In HOLD
10 -
11 -
12 Module defective
13 -
14 No power
15 CiR
16 In STOP / without ODIS
17 In 
18  
19  
20  

DNN structure
With parameter MODE = 2, the diagnostic information details are output in accordance with 
the DNN structure. In this case, enter the system data type "DNN" as data type for the tag 
declaration.

The following table shows the meaning of the individual parameter values.

Parameter Data type Value Description
SubordinateState UINT Enum Status of the subordinate module (see parameter OwnState of the 

DIS structure)
SubordinateIOState WORD Bitarray Status of the inputs and outputs of the subordinate module (see 

parameter IO State of the DIS structure)
DNNmode WORD Bitarray ● Bit 0 = 0: Diagnostics enabled

● Bit 0 = 1: Diagnostics disabled
● Bit 1 to 15: Reserved
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DiagnosticDetail structure
With parameter MODE = 3, the diagnostic information details are output in accordance with 
the DiagnosticDetail structure. In this case, enter the system data type "DiagnosticDetail" as 
data type for the tag declaration.

The following table shows the meaning of the individual parameter values.

Parameter Data type Description
ChannelInfo WORD Channel properties (0...7)
ALID UInt Identification ID of alarm
TextID UNIT ID of an alarm text in a text list.
ChannelNumber UINT Manufacturer-specific channel number (0x0000 — 0x7FFF)
Addval_0 DWORD Placeholder for additional information The value / list of values depends on the 

connection error.
TextID2 UInt Texts for CPU response (mode, OB calls, etc.).
LADDR HW_ANY Identical to the LADDR parameter.
TextListId UInt ● 0: No text list

● ≠0: ID of the text list
ChannelDirection UInt ● 000: Manufacturer-specific

● 001: Input
● 002: Output
● 003: Input/Output
● 004 - 007: Reserved

AddVal_1 DWORD Placeholder for additional information on the channel error (depends on the GSD 
file).
For channel error types, see also: IEC 61158 (PROFINET IO Type 10 and 
PROFIBUS DP Type 3).

Parameter RET_VAL

Error code*

(W#16#...)

Description

0 No error
n The data area at the DETAIL parameter is too small. Not all details of the diagnostic data can be output.
8080 Value in the MODE parameter is not supported.
8081 Type at the DIAG parameter is not supported with the selected mode (parameter MODE).
8082 Type at the DETAIL parameter is not supported by the selected mode (parameter MODE).
8090 LADDR does not exist
80C1 Insufficient resources for parallel execution.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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9.7.3.10 Pulse

CTRL_PWM: Pulse-width modulation

Description     
You can use the "CTRL_PWM" instruction to enable and disable a pulse output supported by 
the CPU using the software.

 

 Note

Pulse output parameters are assigned exclusively in the device configuration and not using 
the "CTRL_PWM" instruction. Any change of parameters that is intended to have an effect 
on the CPU must therefore be made while the CPU is in STOP mode.

 

You enter the hardware ID of the pulse output you want to control with the instruction in the 
PWM input. Error-free execution of the instruction is possible only when the specified pulse 
output is enabled in the hardware configuration.

Only tags of "HW_PWM" data type can be specified in the PWM input. The hardware data type 
HW_PWM has a length of one WORD.

The pulse output is enabled when the bit in the ENABLE input of the instruction is set. If 
ENABLE has the value TRUE, the pulse output generates pulses that have the properties 
defined in the device configuration. When the bit in the ENABLE input is reset or the CPU 
changes to STOP, the pulse output is disabled and no more pulses are generated.

The "CTRL_PWM " instruction is only executed if the signal state in the EN input is "1". 

Since the S7-1200 enables the pulse output when the "CTRL_PWM" instruction is executed, 
BUSY at S7-1200 always has the value FALSE.

The ENO enable output is set only when the EN enable input has signal state "1" and no errors 
have occurred during execution of the instruction.

 

 Note
Use of the force table for PWM and PTO

Digital inputs and outputs that are used for PWM and PTO cannot be forced. Digital inputs 
and outputs that were assigned via device configuration cannot be controlled by either the 
force table or the monitoring table.
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Parameters
The following table shows the parameters of the "CTRL_PWM" instruction:

Parameter Declaration Data type Memory area Description
PWM Input HW_PWM 

(WORD)
I, Q, M, L or constant Hardware ID of the pulse generator

ENABLE Input BOOL I, Q, M, D, L or 
constant

The pulse output is enabled when ENABLE = 
TRUE and disabled when ENABLE = FALSE.

BUSY Output BOOL I, Q, M, D, L Processing status
STATUS Output WORD I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code* 
(W#16#...)

Description

0 No error
80A1 Hardware ID of the pulse generator is invalid
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

9.7.3.11 Recipes and data logging

Recipe functions

RecipeExport: Exporting recipes

Description
The "RecipeExport" instruction exports the recipe data from a data block to a CSV file on the 
memory card of the CPU.

The export is triggered by the "REQ" parameter. The BUSY parameter is set to "1" during the 
export. During the export, the CSV file is created in the "Recipes" folder in the main directory 
of the memory card. The name of the data block is used as file name of the created CSV file. 
If a CSV file with an identical name already exists, it is overwritten during the export.

After the execution of the instruction, BUSY is reset to  "0" and the completion of the operation 
is indicated with "1" at the DONE parameter. If an error occurs during execution, this is signaled 
by the parameters ERROR and STATUS.
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Parameters
The following table shows the parameters of the "RecipeExport" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Control parameter REQUEST: Activates the 
export on a rising edge.

RECIPE_DB InOut VARIANT  Pointer to the recipe data block. For 
information on the structure of the data block, 
refer to: Structure of a recipe DB (Page 2511)

DONE Output BOOL I, Q, M, D, L Status parameter
● 0: Job not yet started or still executing.
● 1: Job executed without errors.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: The instruction is not executed.
● 1: The instruction is executed.

ERROR Output BOOL I, Q, M, D, L Status parameter
● 0: Neither warning nor error.
● 1: An error has occurred. STATUS 

supplies detailed information on the type of 
error.

STATUS Output WORD I, Q, M, D, L Status parameter
See the "STATUS" parameter table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code* 
(W#16#...)

Explanation

0 No error occurred
7000 No job processing active
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8090 File name of the CSV file contains invalid characters. The file name of the CSV file is identical to the name 

of the data block.
8091 The data structure referenced with RECIPE_DB cannot be processed.
8092 Data structure at RECIPE_DB parameter exceeds 5000 bytes.
80B3 Insufficient memory space on the memory card or the internal load memory.
80B4 The memory card is write-protected.
80C0 CSV files is temporarily locked.
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Error code* 
(W#16#...)

Explanation

80C1 Data block temporarily locked.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

RecipeImport: Importing recipes

Description
The "RecipeImport" instruction imports the recipe data from a CSV file on the memory card 
into the data block at the RECIPE_DB parameter. The values in the data block are overwritten 
in the process.

Note the following when importing the CSV file:

● The CSV file must be located in the  "Recipes" directory of the memory card.

● The name of the CSV file must match the name of the data block at the RECIPE_DB 
parameter.

● The first line (header) of the CSV file contains the name of the recipe components (see 
also: Structure of a recipe DB (Page 2511)). The first line is ignored during import. The 
names of the recipe components in the CSV file and the data block are not reconciled during 
import.

● In each case the first value in each line of the CSV file is the index number of the recipe. 
The individual recipes are imported in the order of the index. For this, the index in the CSV 
file has to be in ascending order and may contain no gaps (if this is not the case, the error 
message 80B0 is output at the STATUS parameter.

● The CSV file may not contain more recipe data records than provided for in the data block. 
The maximum number of data records is indicated by the array limits in the data  block.

The import is triggered by the "REQ" parameter. The BUSY parameter is set to "1" during the 
import. After the execution of the instruction, BUSY is reset to  "0" and the completion of the 
operation is indicated with "1" at the DONE  parameter. If an error occurs during execution, 
this is signaled by the parameters ERROR and STATUS.

Parameters
 The following table shows the parameters of the "RecipeImport" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Control parameter REQUEST: Activates the 
import on a rising edge.

RECIPE_DB InOut VARIANT D Pointer to the recipe data block. For 
information on the structure of the data block, 
refer to: 

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2509



Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, D, L Status parameter

● 0: Job not yet started or still executing.
● 1: Job completed without error.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: The instruction is not executed.
● 1: The instruction is executed.

ERROR Output BOOL I, Q, M, D, L Status parameter
● 0: Neither warning nor error.
● 1: An error has occurred. STATUS 

supplies detailed information on the type of 
error.

STATUS Output WORD I, Q, M, D, L Status parameter
See the "STATUS" parameter table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code* 
(W#16#...)

Explanation

0 No error occurred
7000 No job processing active
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8090 The file name contains invalid characters.
8092 No matching CSV file found for the import. Possible cause: The name of the CSV file does not match the 

name of the recipe DB.
80C0 CSV file is temporarily locked.
80C1 Data block is temporarily locked.
80B0 Numbering in the index of the CSV file is not continuous, not ascending or exceeds the maximum number 

(array limit) in the data block.
80B1 Structure of the recipe data block and the CSV file do not match: The CSV file contains too many fields.
80B2 Structure of the recipe data block and the CSV file do not match: The CSV file contains too few fields.
80D0 +n Structure of the recipe data block and the CSV file do not match: Data type in field n does not match (n<=46).
80FF Structure of the recipe data block and the CSV file do not match: Data type in field n does not match (n>46).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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Structure of a recipe DB

Introduction
The following sections describes the structure of a recipe DB based on a simple example. The 
recipe DB consists of five data records, three of which are used. The fourth and fifth data 
records are left free for later expansions. Each data record contains one recipe, which is made 
up of the recipe name and eight ingredients. 

product
name

water barley wheat hops yeast waterT
mp

mashT
mp

mashTi
me

QTest

Pils 10 9 3 280 39 40 30 100 0
Lager 10 9 3 150 33 50 30 120 0
BlackBe
er

10 9 3 410 47 60 30 90 1

Not_use
d

0 0 0 0 0 0 0 0 0

Not_use
d

0 0 0 0 0 0 0 0 0

Structure of the recipe data block
The recipe data are implemented as follows in a global data block:

● The template for all recipes is the PLC data type "Beer_Recipe" with the recipe components 
"procutname", "water", etc. with the corresponding data types.

● In a global data block, the PLC data type is used as Array [1.. 5] of "Beer_Recipe". The 
array limits (1 to 5 in this case) indicate the maximum number of recipes that the DB may 
contain.

● The values for the recipe components are added as start value in the data block.

● The global DB is interconnected with the instruction via the InOut parameter RECIPE_DB.
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Exporting to CSV file
After the execution of the "RecipeExport (Page 2507)" instruction the data of the DB are written 
to a CSV file with the following structure:

Recipe_DB.csv
index,productname,water,barley,wheat,hops,yeast,waterTmp,mashTmp,mashTime,QTest
1,”Pils”,10,9,3,280,39,40,30,100,0
2,”Lager”,10,9,3,150,33,50,30,120,0
3,”BlackBeer”,10,9,3,410,47,60,30,90,1
4,”Not_used”,0,0,0,0,0,0,0,0,0
5,”Not_used”,0,0,0,0,0,0,0,0,0

The CSV file can be uploaded to the PC/programming device by means of the Web browser 
and edited: 

● If the data are to be reloaded in the DB, not changes may be made to the structure (for 
example, by adding ingredients in a new column).

● If you add data records to the file, make sure when importing into the data block that the 
array limits through which you specify the maximum number of data records correspond to 
at least the number of data records.

● An index is automatically generated during export to the CSV file. If you create additional 
data records, add consecutive index numbers accordingly.

After editing, the modified file can be reloaded in the CPU. The original CSV file is overwritten 
in the process. You can use the "RecipeImport (Page 2509)" instruction to re-import the 
modified data from the CSV file into the data block.

 

Display in Excel

The CSV file can be opened in Excel to make reading and editing easier. If the commas are 
not recognized as decimal separators, use the Excel import function to output the data in 
structured form.

Data logging

Data logging - Overview

Saving process values
The data logging instructions are used in the user program to save process values to data 
logs. Data logs can be saved on the Memory Card (MC) or in the internal load memory. The 
data logs are saved in CSV format (Comma Separated Value).
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The data logging instructions are used in your program to create or open a data log, to write 
an entry and to close the data log file. 

You decide by the creation of the data buffer which program values are stored in the data log 
during the creation of the data buffer. The data buffer is used as a memory for new data log 
entries. New values have to be written to the buffer before "DataLogWrite (Page 2524)" is 
called. During execution of the "DataLogWrite (Page 2524)" instruction, data is written from 
the buffer to a data log record.

Data log files can be copied to the PC as follows:

● If the PROFINET interface is connected to the PC, you use a Web browser to access the 
data logs via the Web server. The CPU can be in RUN or STOP mode for this. If the CPU 
is in "RUN" mode, the program continues running while the Web server is transferring data.

● If there is a memory card in the CPU, you can remove this card and insert it into a standard 
slot for SD (Secure Digital) cards or MMC (MultiMediaCard) cards on a PC or programming 
device. Use File Manager to transfer the data log files from the memory card to the PC. 
The CPU goes to "STOP" when you remove the memory card.

Properties of the data log
Writing of the data records of a data log is carried out in accordance with the principle of a ring 
buffer. New data records are added until the maximum number of data records is reached 
(RECORD parameter). The next data record then overwrites the "oldest" data record of the 
data log. 

If you want to prevent data records from being overwritten, use the "DataLogNewFile 
(Page 2529)" instruction to create a new data log file based on the current data log. New data 
records are then written into the new data log. 
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Creating data logs
With the "DataLogCreate (Page 2515)" instruction, you can create a new data log file in the 
""\DataLogs" directory of the load memory.

● The name assigned at the NAME parameter is the designation for the data log and is also 
used the file name for the CSV file. The file is stored in the directory "DataLogs".

● The block parameter DATA specifies the data buffer for the new data log object and the 
columns and data types in the data log. The columns and data types of a data record in 
the data log are generated by the elements in the structure declaration or the array 
declaration of this data buffer. Each element of a structure or of an array corresponds to a 
column in a line in the data log.

● You can use the HEADER block parameter to assign a header text in the header to each 
column.

● The "DataLogCreate (Page 2515)" instruction returns an ID. This ID is used by the other 
data logging instructions as a reference for the created data log.

Opening data logs
You use the instructions "DataLogOpen" (S7-1200) and "DataLogTypedOpen" (S7-1500) to 
open an existing data log on the memory card. A data log must be open before you can write 
new data records to it. 

The data log opens automatically when you execute the instructions "DataLogCreate 
(Page 2515)" and "DataLogNewFile (Page 2529)". 

Up to 10 data logs can be open simultaneously. You can select the data log to be opened 
using the ID or name of the data log.

● If you specify the ID and the name of the data log in the ID and NAME parameters, 
respectively, the data log will be identified based on the ID. The data log name will not be 
compared.

● If you select the data log using the NAME parameter and no ID is specified, the ID will be 
displayed in the ID parameter when the data log is opened.

● If you select the data log using the ID parameter and no name is specified, the name will 
be displayed in the NAME parameter when the data log is opened.

You use the MODE parameter to specify whether the data records of the data log are to be 
deleted upon opening.

Writing to data logs
A data log must be open ("DataLogOpen (Page 2519)" instruction) before a data record can 
be written to a data log. The "DataLogWrite (Page 2524)" instruction writes a data record to 
the data log.

Closing data logs
You use the "DataLogClose (Page 2526)" instruction to close an open data log. You select the 
data log using the ID parameter.

The data log is closed automatically when the CPU switches to STOP and upon restart.
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Deleting data logs
You use the instruction "DataLogDelete (Page 2528)" (S7-1500) to delete a data log file from 
the memory card. The data log and the data records it contains can only be deleted if the log 
was created with the instruction "DataLogCreate (Page 2515)".

Select the data log to be deleted using the NAME and  ID  parameters. The  ID  parameter is 
evaluated first. If there is a data log with the relevant ID, the NAME parameter will not be 
evaluated. If the value "0" is used at the ID  parameter, a value with the data type STRING 
must be used at the NAME parameter.

Clearing data logs
You use the instruction "DataLogClear (Page 2522)" (S7-1500) to delete all the data records 
in an existing data log. The instruction does not delete the optional header of the CSV file (see 
the description of the HEADER parameter of the instruction "DataLogCreate (Page 2515)").

You use the  ID parameter to select the data log whose data records are to be deleted. Before 
you can delete data records, the data log must be open.

New file for data logs
You use the instruction "DataLogNewFile (Page 2529)" (S7-1200) or "DataLogTypedNewFile 
(Page 2531)" (S7-1500) to create a new data log with the same properties as an existing data 
log. This allows you to retain the contents of an existing data log.

When called, the instruction creates a new data log on the memory card or in the internal load 
memory with the name defined at the NAME parameter. You use the ID parameter to specify 
the ID of the old data log whose properties you want to apply to the new data log. The ID of 
the new data log is then output via the ID parameter.

You specify the file size of the new data log with the RECORDS parameter of the instruction. 

You can run a consistency check for "DataLogTypedNewFile (Page 2531)" (S7-1500).

DataLogCreate: Create data log

Description
You use the "DataLogCreate" instruction to create a data log. The data log is saved to the 
memory card / the internal load memory in the "\DataLogs" folder. You can use the data logging 
instructions to save the process data. The amount of data that can be stored in a data log 
depends on the memory space available on the memory card or the available internal load 
memory of the CPU used.

You specify the maximum number of data records that can be stored in a data log in the 
RECORDS parameter. If the specified maximum number of data records in the data log is 
reached, the oldest data record will be overwritten. To avoid overwriting of existing data 
records, use the "DataLogNewFile (Page 2529)" instruction. The instruction can be used to 
create a new data log with the same structure when the number specified at the RECORDS 
parameter is reached (return value 1 at the STATUS parameter of the "DataLogWrite 
(Page 2524)" instruction). The data records are then saved in the new data log.
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You can specify the name for the data log in the NAME parameter. The data log is created in 
CSV (Comma Separated Value) format. With the HEADER parameter, you can create an 
(optional) header for the data log. A comma has to be used as the separator.

Once the data log is created, it is opened automatically.

Parameters
The following table shows the parameters of the "DataLogCreate" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execution of the instruction upon a rising edge.

RECORDS Input UDInt I, Q, M, L, D or 
constant

Number of data records in the data log

FORMAT Input UInt I, Q, M, L, D or 
constant

Data format:
● 0: Internal (not supported)
● 1: CSV (Comma separated values)

TIMESTAMP Input UInt I, Q, M, L, D or 
constant

Time stamp:
● 0: No time stamp
● 1: Date and time
With the time stamp, an additional header is not 
required for the data log.

NAME Input VARIANT L, D Name of the data log. The specified name is also 
used as a file name for the csv file.
The restrictions for Windows file names apply when 
assigning the name. The following characters must 
not be used:
"\", "/", ":", "*", "?", "<", ">", "|", "space"

ID InOut DWORD I, Q, M, L, D Object ID of the data log (output only). The ID of the 
data log is required for the additional data logging 
instructions.

HEADER InOut VARIANT L, D Header of the CSV file (optional). The parameter is 
hidden once the instruction has been inserted.

DATA InOut VARIANT L, D Data buffer for a data log data record.
DONE Output BOOL I, Q, M, L, D The instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Creation of the data log is not yet complete.
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.
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For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter HEADER
The HEADER parameter is a VARIANT pointer to a data block that defines a header for the 
CSV file (header). The header is always the first line in the CSV file representation. When 
creating a header, remember that the individual columns must be separated by a comma 
(S7-1200) or a semicolon (S7-1500). A STRING, Array of BYTE, or Array of CHAR data type 
can be used for the individual column names. A longer character string is possible with the 
Array [...] of type data type than with the STRING data type. When the STRING data type is 
used, the length is limited to 254 bytes. 

If no header is to be created, do not specify a value in the HEADER parameter.

Parameter DATA
The DATA parameter is a VARIANT pointer to a structure or an array in a data block. An 
element of a structure or an array corresponds to a column in the data log with a specific data 
type.

Note the following when creating the data block:

● The number of columns must correspond to the number of columns defined in the HEADER 
parameter.

● If the STRUCT data type is used, structure nestings (STRUCT in STRUCT) may not be 
used.

● Arrays (only 1-dimensional) can be configured as a single element or as a structure 
component. Each element in the array generates a separate column in the data log.

● The tags of the data block can be set as retentive or non-retentive tags. However, the 
retentive setting must be the same for all tags of the data block.

Parameter STATUS (S7-1200)

Error code*
(W#16#...)

Description

0 No errors.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 Invalid file name (see description of the NAME parameter).
8093 Data log already exists.
8097 File length exceeds the file system limit.
80B3 Insufficient memory space on the memory card.
80B4 The memory card is write-protected.
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Error code*
(W#16#...)

Description

80C1 Too many files open.
8453 Invalid format selection.
8553 Invalid time stamp.
8B51 Invalid data type at HEADER parameter.
8C20 String with length specification other than 254 used.
8C51 Invalid data type at DATA parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (S7-1500)

Error code*
(W#16#...)

Description

0 No errors.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
8070 Complete internal instance memory is assigned.
8090 Invalid file name (see description of the NAME parameter).
8091 "NAME" parameter is not a string.
8093 Data log already exists.
8097 File length exceeds the file system limit.
80B3 Insufficient memory space on the memory card.
80B4 The memory card is write-protected.
80C0 Access currently not possible.
80C1 Too many files open.
8253 Invalid value at  RECORDS parameter.
8353 Invalid format selection.
8453 Invalid time stamp.
8B51 Invalid data type at HEADER parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2512)
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DataLogOpen: Open data log

DataLogOpen: Open data log

Description     
You use the "DataLogOpen" instruction to open an existing data log on the memory card. A 
data log must be open before you can write new data records to it. 

Data log opens automatically when you execute the instructions "DataLogCreate (Page 2515)" 
and "DataLogNewFile (Page 2529)". 

Up to 10 data logs can be open simultaneously. You can select the data log to be opened 
using the ID or name of the data log.

● If you specify the ID and the name of the data log in the ID and NAME parameters, 
respectively, the data log will be identified based on the ID. The data log name will not be 
compared.

● If you select the data log using the NAME parameter and no ID is specified, the ID will be 
displayed in the ID parameter when the data log is opened.

● If you select the data log using the ID parameter and no name is specified, the name will 
be displayed in the NAME parameter when the data log is opened.

You use the MODE parameter to specify whether the data records of the data log are to be 
deleted upon opening.

Parameters
The following table shows the parameters of the "DataLogOpen" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execution of the instruction upon a rising edge.

MODE Input UInt I, Q, M, L, D or 
constant

Mode for opening the data log:
● MODE= "0"

Data records of the data log are retained
● MODE= "1"

Data records of the data log are deleted, but the 
header is retained

NAME Input VARIANT L, D (File) name of the data log.
ID InOut DWORD I, Q, M, L, D Object ID of the data log.
DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of instruction not yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter 
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code* 
(W#16#...)

Description

0 No errors.
2 Warning: Data log file has already been opened by this application.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 There are inconsistencies between the data log definition and existing data log data.
8091 A data type other than String was used at the NAME parameter.
8092 Data log does not exist.
80B4 The memory card is write-protected.
80C0 The data log file is locked.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2512)

DataLogOpen: Open data log

Description
You use the "DataLogOpen" instruction to open an existing data log on the memory card. A 
data log must be open to write new data records to it. 

Data log opens automatically when you execute the instructions "DataLogCreate (Page 2515)" 
and "DataLogNewFile (Page 2529)".
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Up to 10 data logs can be open simultaneously. You can select the data log to be opened 
using the ID or name of the data log.

● If you specify the ID and the name of the data log in the ID and NAME parameters, 
respectively, the data log will be identified based on the ID. The data log name will not be 
compared.

● If you select the data log using the NAME parameter and no ID is specified, the ID will be 
displayed in the ID parameter when the data log is opened.

● If you select the data log using the ID parameter and no name is specified, the name will 
be displayed in the NAME parameter when the data log is opened.

You use the MODE parameter to specify whether the data records of the data log are to be 
deleted upon opening.

The parameter DATA enables a consistency check between the data log to be opened and 
the definition of the data log of the instruction "DataLogCreate (Page 2515)". The consistency 
check can only be executed if the data log was created with the instruction "DataLogCreate 
(Page 2515)":

● If you are using the same pointer at the DATA parameter as at the DATA parameter of the 
"DataLogCreate (Page 2515)" instruction, a check is performed to determine whether the 
data types match. If the data types do not match, the error code W#16#80A0 is output at 
the STATUS parameter.

● If the data log to be opened was not created with "DataLogCreate (Page 2515)", a 
consistency check is not possible. In this case, enter the value "NULL" in the DATA 
parameter.

Parameters
The following table shows the parameters of the "DataLogOpen" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execution of the instruction upon a rising edge.

MODE Input UInt I, Q, M, L, D or 
constant

Mode for opening the data log:
● MODE= "0"

Data records of the data log are retained
● MODE= "1"

Data records of the data log are deleted, but the 
header is retained

NAME Input VARIANT L, D (File) name of the data log.
ID InOut DWORD I, Q, M, L, D Object ID of the data log.
DATA InOut VARIANT L, D With consistency check: Pointer to the data area at 

the DATA parameter of the "DataLogCreate 
(Page 2515)" instruction.

DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of instruction not yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter 
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code* 
(W#16#...)

Description

0 No errors.
2 Warning: Data log file has already been opened by this application.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 There are inconsistencies between the data log definition and existing data log data.
8091 A data type other than String was used at the NAME parameter.
8092 Data log does not exist.
80A0 Data types inconsistent. The data log at the ID parameter uses different data types than specified in the 

DATA parameter.
80B4 The memory card is write-protected.
80C1 Too many files open.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2512)

DataLogClear: Empty data log

Description
The "DataLogClear" instruction deletes all data records in an existing data log. The instruction 
does not delete the optional header of the CSV file (see the description of the HEADER 
parameter of the instruction "DataLogCreate (Page 2515)").
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You use the ID parameter to select the data log whose data records are to be deleted.

Requirement
Before you can delete data records, the data log must be open (see "DataLogOpen 
(Page 2519) instruction").

Parameters
The following table shows the parameters of the "DataLogClear" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execution of the instruction upon a rising edge.

ID InOut DWORD I, Q, M, D, L Object ID of the data log
DONE Output BOOL I, Q, M, D, L Instruction was executed successfully.
BUSY Output BOOL I, Q, M, D, L Execution of the instruction not yet complete.
ERROR Output BOOL I, Q, M, D, L ● 0: No error.

● 1: An error occurred during execution of the 
instruction. 

Detailed information is output at the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter
The parameter is only set for the duration of 
one call. To display the status, you should 
therefore copy the STATUS parameter to a 
free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code* 
(W#16#...)

Explanation

0000 No error.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8080 Data log file does not correspond to instruction.
8092 Data log does not exist.
80B0 Data log is not open.
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Error code* 
(W#16#...)

Explanation

80B4 The memory card is write-protected.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2512)

DataLogWrite: Write data log

Description     
The instruction "DataLogWrite" is used to write a data record to an existing data log. The ID 
parameter is used to select the data log to which the data record is to be written. To create a 
new data record, the data log must be open. The instruction creates a new data record in the 
format that was specified in the DATA parameter when the data log was created.

Before calling the "DataLogWrite" instruction, transfer the data to the tag that you 
interconnected at the DATA parameter of the "DataLogCreate" instruction. When the 
"DataLogWrite" instruction is executed, the transferred data is copied to the data log.

 

 NOTICE

Data log data loss when the power supply to the CPU is interrupted

If the power supply is interrupted during execution of the "DataLogWrite" instruction, the data 
record to be transferred is lost.

 

Parameters
The following table shows the parameters of the "DataLogWrite" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execution of the instruction upon a rising edge.

ID InOut DWORD I, Q, M, L, D Object ID of the data log
DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of the instruction not yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS (S7-1200)

Error code*
(W#16#...)

Description

0 No errors
0001 Last possible data record created at the end of the file. Creating another data record will overwrite an 

older data record.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8092 Data log does not exist.
80B0 Data log is not open.
80B3 Insufficient memory space on the memory card.
80B4 The memory card is write-protected.
80C0 Data log is locked.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (S7-1500)

Error code*
(W#16#...)

Description

0 No errors
0001 Last possible data record created at the end of the file. Creating another data record will overwrite an 

older data record.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
8070 Complete internal instance memory is assigned.
8092 Data log does not exist.
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Error code*
(W#16#...)

Description

80B0 Data log is not open.
80B3 Insufficient memory space on the memory card.
80B4 The memory card is write-protected.
80C0 Data log is locked.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2512)

DataLogClose: Close data log

Description     
You use the "DataLogClose" instruction to close an open data log. You select the data log 
using the ID parameter.

 

 Note
Closing data logs automatically

The data log is closed automatically when the CPU goes to STOP or if there is a restart.
 

Parameters
The following table shows the parameters of the "DataLogClose" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execute function on a rising edge.

ID InOut DWORD I, Q, M, L, D Object ID of the data log
DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of the instruction not yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS (S7-1200)

Error code*
(W#16#...)

Description

0 No errors
1 Data log is not open
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8092 Data log does not exist.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (S7-1500)

Error code*
(W#16#...)

Description

0 No errors
1 Data log is not open
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
8092 Data log does not exist.
80B4 The memory card is write-protected.
80C0 Access currently not possible.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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DataLogDelete: Delete data log

Description     
You use the "DataLogDelete" instruction to delete a data log file from the memory card. The 
data log and the data records it contains can only be deleted if the log was created with the 
instruction "DataLogCreate (Page 2515)".

Parameters
The following table shows the parameters of the "DataLogDelete" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execution of the instruction upon a rising edge.

NAME Input VARIANT L, D File name of the data log
DELFILE Input BOOL I, Q, M, D, L ● 0: Data log is retained.

● 1: Data log is deleted.
Detailed information is output at the STATUS 
parameter.

ID InOut DWORD I, Q, M, D, L Object ID of the data log
DONE Output BOOL I, Q, M, D, L Instruction was executed successfully.
BUSY Output BOOL I, Q, M, D, L Deletion of the data log is not yet complete.
ERROR Output BOOL I, Q, M, D, L ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output at the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter
The parameter is only set for the duration of 
one call. To display the status, you should 
therefore copy the STATUS parameter to a 
free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters NAME and ID
Select the data log to be deleted using the NAME and ID parameters. The ID parameter is 
evaluated first. If there is a data log with the relevant ID, the NAME parameter will not be 
evaluated. If the value "0" is used at the ID parameter, a value with the data type STRING 
must be used at the NAME parameter.
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Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0 No error.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8091 A data type other than STRING is being used at the NAME parameter.
8092 Data log does not exist.
80A2 Write error
80B4 The memory card is write-protected.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DataLogNewFile: Data log in new file

DataLogNewFile: Data log in new file

Description     
You use the "DataLogNewFile" instruction to create a new data log with the same properties 
as an existing data log. This allows the contents of an existing data log to be retained.

When called, the instruction creates a new data log on the memory card or in the internal load 
memory with the name defined at the NAME parameter. You use the ID parameter to specify 
the ID of the old data log whose properties you want to apply to the new data log. The ID of 
the new data log is then output via the ID parameter.

You specify the file size of the new data log with the RECORDS parameter of the instruction.

Parameters
The following table shows the parameters of the "DataLogNewFile" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execution of the instruction upon a rising edge.

RECORDS Input UDInt I, Q, M, L, D or 
constant

Number of data records in the data log.

NAME Input VARIANT L, D File name of the new data log.
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Parameter Declaration Data type Memory area Description
ID InOut DWORD I, Q, M, L, D Object ID of the data log

● In: ID of the existing data log
● Out: ID of the new data log

DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of the instruction not yet complete.
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter 
The parameter is only set for the duration of one call. 
To display the status, you should therefore copy the 
STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code*
(W#16#...)

Description

0 No errors.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 Invalid file name.
8091 Path does not exist.
8092 Source data log does not exist.
8093 New data log already exists.
8097 File length exceeds the file system limit.
80B3 Load memory not sufficient.
80B4 The memory card is write-protected.
80C1 Too many files open.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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DataLogNewFile: Data log in new file

Description
You use the "DataLogNewFile" instruction to create a new data log with the same properties 
as an existing data log. This allows the contents of an existing data log to be retained.

When called, the instruction creates a new data log on the memory card or in the internal load 
memory with the name defined at the NAME parameter. You use the ID parameter to specify 
the ID of the old data log whose properties you want to apply to the new data log. The ID of 
the new data log is then output via the ID parameter.

You specify the file size of the new data log with the RECORDS parameter of the instruction.

The parameter DATA enables a consistency check between the new data log to be created 
and the definition of the data log of the instruction "DataLogCreate (Page 2515)". The 
consistency check can only be executed if the data log was created with the instruction 
"DataLogCreate (Page 2515)":

● If you are using the same pointer at the DATA parameter as at the DATA parameter of the 
"DataLogCreate (Page 2515)" instruction, a check is performed to determine whether the 
data types match. If the data types do not match, the error code W#16#80A0 is output at 
the STATUS parameter.

● If the data log to be opened was not created with "DataLogCreate (Page 2515)", a 
consistency check is not possible. In this case, enter the value "NULL" in the DATA 
parameter.

Parameters
The following table shows the parameters of the "DataLogNewFile" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD)

Execution of the instruction upon a rising edge.

RECORDS Input UDInt I, Q, M, L, D or 
constant

Number of data records in the data log.

NAME Input VARIANT L, D File name of the new data log.
ID InOut DWORD I, Q, M, L, D Object ID of the data log

● In: ID of the existing data log
● Out: ID of the new data log

DATA InOut VARIANT L, D Data type for consistency check
DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of the instruction not yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter 
The parameter is only set for the duration of one call. 
To display the status, you should therefore copy the 
STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code*
(W#16#...)

Description

0 No errors.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 Invalid file name.
8091 Path does not exist.
8092 Source data log does not exist.
8093 New data log already exists.
8097 File length exceeds the file system limit.
80A0 Data types inconsistent. The data log at the ID parameter uses different data types than specified in the 

DATA parameter.
80B3 Load memory not sufficient.
80B4 The memory card is write-protected.
80C0 Access currently not possible.
80C1 Too many files open.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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9.7.3.12 Data block functions

CREATE_DB: Create data block

Description
The instruction "CREATE_DB" is used to create a new data block in the load and/or work 
memory.

The instruction "CREATE_DB" does not change the checksum of the user program.

Number of the data block
The data block created is assigned a number from the range defined at the LOW_LIMIT (low 
limit) and UP_LIMIT (high limit) parameters. "CREATE_DB" assigns the smallest possible 
number from the specified range to the DB. You cannot assign the numbers of the DBs already 
contained in the user program.

To create a DB with a specific number, enter the same number for the high and low limit of the 
range to be specified. If a DB with the same number already exists in the work memory and/
or load memory, or if the DB exists as a copied version, the instruction will be terminated and 
an error message will be generated at the RET_VAL parameter.

Start values of the data block
Using the SRCBLK parameter, you can define start values for the DB to be created. The 
SRCBLK parameter is a pointer to a DB or a DB area from which you apply the start values. 
The DB addressed at the SRCBLK parameter must have been generated with standard access 
("Optimized block access" attribute disabled).

● If the area specified at the SRCBLK parameter is larger than the DB generated, the values 
up to the length of the DB generated will be applied as start values.

● If the area specified at the SRCBLK parameter is smaller than the DB generated, the 
remaining values will be filled with "0".

To ensure data consistency, you must not change this data area while "CREATE_DB" is being 
executed (which means as long as the BUSY parameter has the value TRUE).

Parameters
The following table shows the parameters of the "CREATE_DB" instruction:

Parameter Declarati
on

Data 
type

Memory area Description

REQ Input BOOL I, Q, M, D, L or 
constant

REQ= 1: Request to create the DB

LOW_LIMIT Input UINT I, Q, M, D, L or 
constant

Low limit of the area ### used by "CREATE_DB" to assign a 
number to your DB 60000)

UP_LIMIT Input UINT I, Q, M, D, L or 
constant

High limit of the area ### used by "CREATE_DB" to assign a 
number to your DB (largest possible DB number: 60999)
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Parameter Declarati
on

Data 
type

Memory area Description

COUNT Input UDINT I, Q, M, D, L or 
constant

The count value specifies the number of bytes which you want 
to reserve for the DB generated. The number of bytes must be 
an even number. The maximum length is 65534 bytes.

ATTRIB Input BYTE I, Q, M, D, L or 
constant

The first 4 bits of the byte at the ATTRIB parameter define the 
properties of the data block:
● Bit 0 = 0: DB only in the work memory
● Bit 0 = 1: DB only in the load memory
● Bit 1 = 0: DB is not write-protected.
● Bit 1 = 1: DB is write-protected
● Bit 2 = 0: DB is retentive (only for DBs generated in the load 

memory)
● Bit 2 = 1: DB is not retentive
● Bit 3= 0: DB generated either in load or in work memory
● Bit 3= 1: DB generated both in load and in work memory
To ensure compatibility with STEP7 V5.x, bits 1 and 3 must be 
used in combination:
Bit 0 Bit 3 DB generation
0 0 In work memory only
1 0 In load memory only
0 1 Work and load memory
1 1 Work and load memory
● Bit 4 = 0 - No start values specified (input values at the 

SRCBLK parameter will be ignored).
● Bit 4 = 1 - Specify start values (values correspond to the DB 

addressed by the SRCBLK parameter).
SRCBLK Input VARIAN

T
D Pointer to the data block whose values will be used to initialize 

the data block to be generated.
RET_VAL Return INT I, Q, M, D, L Error information
BUSY Output BOOL I, Q, M, D, L BUSY= 1: The process is not yet complete.
DB_NUM Output DB_DY

N (UINT)
I, Q, M, D, L Number of the DB created.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error
0081 The target range is greater than the source range. 

The complete source range is written to the target range. The remaining bytes of the target range are filled 
with 0.

7000 First call with REQ = 0: No data transfer active; BUSY has the value "0".
7001 First call with REQ = 1: Data transfer triggered; BUSY has the value "1".
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Error code*
(W#16#...)

Description

7002 Intermediate call (REQ 
irrelevant): Data transfer already active; BUSY has the value "1".

8081 The source range is larger than the target range. 
The complete target range is written. The remaining bytes of the source range are ignored.

8091 You have called "CREATE_DB" as a nested instruction.
8092 The "Create data block" function is currently unavailable because

● The "Compress user memory" function is currently active.
● The maximum number of blocks on your CPU has already been reached.

8093 No data block or a data block that is not in the work memory is specified for the SRCBLK parameter.
8094 A not yet supported attribute was specified for the ATTRIBparameter.
80A1 DB number error:

● The number is "0"
● Low limit > high limit

80A2 DB length error:
● The length is "0"
● The length is an odd number
● The length is greater than permitted by the CPU

80A3 The data block at the SRCBLK parameter was not created with standard access.
80B1 There is no DB number free.
80B2 Not enough work memory.
80B4 The memory card is write-protected.
80BB Not enough load memory.
80C0 The destination is currently being processed by another instruction or a communication function.
80C1 A DB with this DB number is currently being deleted.
80C3 The maximum number of simultaneously active "CREATE_DB" instructions has already been reached.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

READ_DBL: Read from data block in the load memory

Description
With the instruction you copy a DB or an area of a DB in load memory (Micro Memory Card) 
to the data area of a destination DB. The destination DB must be relevant for execution; that 
is, it must not be created with the attribute UNLINKED. The content of the load memory is not 
changed during the copy process.

To ensure data consistency, you must not change the target range while "READ_DBL" is being 
executed (i.e., as long as the BUSY parameter has the value TRUE).

The following restrictions apply to the SRCBLK and DSTBLK parameters (source and 
destination blocks):
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● You must be able to divide the length of the VARIANT pointer by eight.

● For a VARIANT pointer of type STRING, the length must be equal to 1.

● The source and destination block must have been created with the same block access, i.e. 
both must use either the access type "Optimized" or "Standard".

 

  Note

""READ_DBL" is processed asynchronously. Therefore, it is not suitable for frequent (or 
cyclical) reading of tags in the load memory. 

Once started, a job is always completed. If the maximum number of simultaneously active 
"READ_DBL" instructions is reached and you call "READ_DBL" once again at this time in 
a priority class having higher priority, error code W#16#80C3 will be returned. 
Consequently it does not make sense to restart the high-priority job right away.

 

Functional description
The "READ_DBL" instruction works asynchronously, that is, its execution extends over multiple 
calls. You start the job by calling "READ_DBL" with REQ = 1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582) 

Parameters
The following table shows the parameters of the "READ_DBL" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

SRCBLK Input VARIANT D Pointer to data block in the load memory that 
is to be read from

RET_VAL Return INT I, Q, M, D, L Error information
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The reading process is not yet 

complete.
DSTBLK Output VARIANT D Pointer to the data block in the work memory 

that is to be written to

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error
0081 The target range is greater than the source range. The source range is written completely to the target 

range; the remaining bytes of the target range will not be changed.
7000 First call with REQ = 0: No data transfer active; BUSY  has the value "0".
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1".
7002 Intermediate call (REQ  

irrelevant): Data transfer already active; BUSY has the value "1".
8081 The source range is larger than the target range. 

The complete target range is written. The remaining bytes of the source range are ignored.
8082 Destination DB type different from source DB type (optimized/standard access).
8093 No data block or a data block that is not in the work memory is specified for the DSTBLK  parameter.
80B1 No data block is specified for the SRCBLK  parameter, or the data block specified there is not a load 

memory object.
80B4 DB with F-attribute must not be read.
80C3 The maximum number of simultaneously active "READ_DBL" instructions has already been reached.
80C0 The destination DB is currently being processed by another instruction or a communication function.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
GET_ERR_ID: Get error ID locally (Page 2237)

WRIT_DBL: Write to data block in the load memory

Description
The instruction "WRIT_DBL" is used to transfer the contents of a DB or a DB area from the 
work memory to a DB or a DB area in the load memory (Micro Memory Card). The source DB 
must be relevant for execution, which means it must not be created with the attribute 
UNLINKED.

To ensure data consistency, it is not permitted to change the source range while "WRIT_DBL" 
is being executed (i.e., as long as the BUSY parameter has the value TRUE).

The following restrictions apply to the SRCBLK and DSTBLK parameters (source and 
destination blocks):

● For a VARIANT pointer of type BOOL, the length must be divisible by 8.

● For a VARIANT pointer of type STRING, the length must be equal to 1.

●  The source and destination block must have been created with the same block access, 
i.e. both must use either the access type "Optimized" or "Standard - compatible with 
S7-300/400".
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The "WRIT_DBL" instruction does not change the checksum of the user program if you write 
a DB that was created using an instruction. However, when a loaded DB is written, the first 
entry in this DB changes the checksum of the user program.

 

 Note

"WRIT_DBL" is not suitable for frequent (or cyclical) writing of tags in the load memory. This 
is because the Micro Memory Card technology limits the number of write accesses that can 
be made to a Micro Memory Card.

 

Functional description
The "WRIT_DBL" instruction works asynchronously, that is, its execution extends over multiple 
calls. You start the job by calling "WRIT_DBL" with REQ=1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

Parameters
The following table shows the parameters of the instruction "WRIT_DBL":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Write request

SRCBLK Input VARIANT D Pointer to the DB in the work memory that is 
to be read from

RET_VAL Return INT I, Q, M, D, L Error information
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The writing process is not yet 

completed.
DSTBLK Output VARIANT D Pointer to the data block in the load memory 

that is to be written to

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error
0081 The target range is greater than the source range. The source range is written completely to the target 

range; the remaining bytes of the target range will not be changed.
7000 First call with REQ = 0: No data transfer active; BUSY has the value "0".
7001 First call with REQ = 1: Data transfer triggered; BUSY has the value "1".
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Error code*
(W#16#...)

Description

7002 Intermediate call (REQ 
irrelevant): Data transfer already active; BUSY has the value "1".

8081 The source range is larger than the target range.
The complete target range is written. The remaining bytes of the source range are ignored.

8082 Destination DB type different from source DB type (optimized/non-optimized access).
8092 Incorrect operating mode: While "WRIT_DBL" was active, the CPU went into STOP mode. This error code 

is supplied at the next transition to RUN. Call "WRIT_DBL" again.
8093 No data block or a data block that is not in the work memory is specified for the SRCBLK parameter.
80B1 No data block has been specified for the DSTBLK parameter, or the data block specified there is not a 

load memory object.
80B4 DB with F-attribute must not be read.
80C3 The maximum number of simultaneously active "WRIT_DBL" instructions has already been reached.
80C0 The destination DB is currently being processed by another instruction or a communication function.
General error 
codes

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

ATTR_DB: Read data block attribute

Description
You use the instruction "ATTR_DB" to obtain information about a data block (DB) located in 
the work memory of the CPU. The instruction determines the attributes set at the ATTRIB 
parameter for the DB selected.

The length cannot be read out for data blocks with optimized access, the DB_LENGH 
parameter contains the length "0" for DBs with optimized access.

Data blocks for Motion Control cannot be read out with the "ATTR_DB" instruction. The error 
code 80B2 is output for this.

Parameters
The following table shows the parameters of the "ATTR_DB" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or constant REQ  = 1: Read request for block attributes
DB_NUMBE
R

Input DB_ANY 
(UINT)

I, Q, M, D, L or constant Number of the DB to be tested

RET_VAL Output INT I, Q, M, D, L Error information
DB_LENGTH Output UDINT I, Q, M, D, L Number of data bytes which the selected DB 

contains.
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Parameter Declaration Data type Memory area Description
ATTRIB Output BYTE I, Q, M, D, L DB properties:

● Bit 0*= 0: LINKED - The DB only exists in the work 
memory

● Bit 0*= 1: UNLINKED - The DB only exists in the 
load memory

● Bit 1 = 0: READ_ONLY - The DB is not write-
protected.

● Bit 1 = 1: READ_ONLY - The DB is write-protected.
● Bit 2 = 0: RETAIN - The DB is retentive.
● Bit 2 = 1: NON_RETAIN - The DB is not retentive.
● Bit 3*= 0: The DB exists either in the load or the 

work memory
● Bit 3*= 1: The DB is generated in both the load and 

the work memory
* The relationship between bit 0 and bit 3 is explained in the parameters of the instruction "CREATE_DB: Create data 
block (Page 2533)".

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
80A1 Error in input parameter DB_NUMBER: the actual parameter selected

● Is "0"
● Is greater than the maximum permitted DB number for the CPU used.

80B1 The DB with the specified number does not exist on the CPU.
80B2 Data blocks of Motion Control technology objects cannot be read out with the "ATTR_DB" instruction.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DELETE_DB: Delete data block

Description
You use the instruction "DELETE_DB" to delete a data block (DB) that was created from the 
user program by calling the instruction "CREATE_DB (Page 2533)". 

If the data block was not created with "CREATE_DB", the error code W#16#80B5 is output at 
the RET_VAL parameter.

The DB to be deleted may not be located in the current or in a lower priority class. Otherwise, 
the CPU starts OB 121 when the "DELETE_DB" instruction is called. If OB 121 is not present, 
the CPU switches to STOP mode. The instruction "DELETE_DB" can be interrupted by higher 
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priority classes. If the instruction is called again there, then this second call will be aborted and 
W#16#8091 will be entered in RET_VAL .

Parameters
The following table shows the parameters of the "DELETE_DB" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or constant REQ =1: Request to delete the DB with the 

number in parameter DB_NUMBER
DB_NUMBER Input UINT I, Q, M, D, L or constant Number of the DB to be 

deleted
RET_VAL Output INT I, Q, M, D, L Error information (see "RET_VAL parameter")
BUSY Output BOOL I, Q, M, D, L BUSY= 1: The process is not yet complete.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8091 "DELETE_DB" calls were nested and the maximum nesting level of the CPU used was exceeded.
8092 The instruction can currently not be executed because:

● The "Compress user memory" function is currently active.
● You are copying the DB to be deleted from the CPU to an offline project.

80A1 Error in input parameter DB_NUMBER:
● The value at the parameter is "0".
● The value at the parameter is greater than the maximum permitted DB number for the CPU used.

80B1 The DB with the specified number does not exist on the CPU.
80B4 The DB cannot be deleted because the memory card of the CPU is write-protected.
80B5 The DB was not created using "CREATE_DB".
80C1 The "Delete a DB" function cannot be executed at this time due to a temporary resource bottleneck.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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9.7.3.13 Addressing

Instructions for address conversion

Description
There are different options for addressing a module (IO address, hardware identifier, slot). 

You can convert the address data with the following instructions:

● GEO2LOG: Determine hardware identifier from slot (Page 2543)

● LOG2GEO: Determine slot from hardware identifier (Page 2545)

● LOG2MOD: Determine the hardware identifier from addressing of STEP 7 V5.5 SPx 
(Page 2546)

● IO2MOD: Determine hardware identifier from an IO address (Page 2547)

● RD_ADDR: Determine IO addresses from the hardware identifier (Page 2548)

The following instructions are supported in addition for migrated projects:

● GEO_LOG: Determine hardware identifier from slot (Page 2549)

● LOG_GEO: Determine slot from hardware identifier (Page 2551)

● RD_LGADR: Determine IO addresses from the hardware identifier (Page 2552)

● GADR_LGC: Determine hardware identifier from slot and offset in the user data address 
area (Page 2553)

● LGC_GADR: Determine slot from hardware identifier (Page 2555)
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Type of address conversion
The figure below shows which instruction runs which address conversion.

GEO2LOG: Determine hardware identifier from slot

Description
You use the "LOG2GEO" instruction to determine the logical address based on slot information 
that you define using the system data type GEOADDR.

Depending on the hardware type that you define at the HWTYPE parameter, the following 
information is evaluated from the other parameters of GEOADDR:

● With HWTYPE = 1 (PROFINET IO system): 

– Only IOSYSTEM is evaluated. The other parameters of GEOADDR are not taken into 
consideration. 

– The hardware identifier of the PROFINET IO system is output. 

● With HWTYPE = 2 (PROFINET IO device): 

– IOSYSTEM and STATION are evaluated. The other parameters of GEOADDR are not 
taken into consideration. 

– The hardware identifier of the PROFINET IO device is output.

● With HWTYPE = 3 (rack):

– Only IOSYSTEM and STATION are evaluated. The other parameters of GEOADDR are 
not taken into consideration. 

– The hardware identifier of the rack is output.
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● With HWTYPE = 4 (module):

– IOSYSTEM, STATION and SLOT are evaluated. The SUBSLOT parameter of 
GEOADDR is not taken into consideration. 

– The hardware identifier of the module is output.

● With HWTYPE = 5 (submodule):

– All parameters of GEOADDR are evaluated.

– The hardware identifier of the submodule is output.

The AREA parameter of the GEOADDR system data type is not evaluated.

Parameter
The following table shows the parameters of the "GEO2LOG" instruction:

Parameter Declaration Data type Memory area Description
GEOADDR Input VARIANT D, L Pointer to the structure of the GEOADDR 

system data type.
RET_VAL Return INT I, Q, M, D, L Output of error information.
LADDR Output HW_ANY I, Q, M, D, L Hardware identifier of the module or the 

submodule.
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface in the hardware configuration.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

GEOADDR system data type
The GEOADDR system data type is a structure with the following configuration:

Parameter name Data type Description
GEOADDR STRUCT  
 HWTYPE UNIT Hardware type:

● 1: PROFINET IO system
● 2: PROFINET IO device
● 3: Rack
● 4: Module
● 5: Submodule
If a hardware type is not supported by the instruction, a HWTYPE "0" is output.

AREA UNIT Area identifier (0 = central module)
IOSYSTEM UNIT PROFINET IO system (0 = central device in rack 0-3)
STATION UNIT ● Number of the rack if the area identifier  AREA = 0.

● Station number if area identifier AREA > 0.
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Parameter name Data type Description
SLOT UNIT Slot number
SUBSLOT UNIT Number of the submodule. If no submodule can be inserted, this parameter has 

the value "0".

RET_VAL parameter

Error code* 
(W#16#...)

Explanation

0 No error occurred.
8091 Invalid value for in GEOADDR for HWTYPE.
8094 Invalid value for in GEOADDR for IOSYSTEM.
8095 Invalid value for in GEOADDR for STATION.
8096 Invalid value for in GEOADDR for SLOT.
8097 Invalid value for in GEOADDR for SUBSLOT.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2542)

LOG2GEO: Determine slot from hardware identifier

Description
You use the "LOG2GEO" instruction to determine the module slot belonging to a hardware 
identifier.

Parameters
The following table shows the parameters of the "LOG2GEO" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_ANY I, Q, M, D, L or 

constant
Hardware identifier of the IO system or the 
module.
The number is assigned automatically and is 
stored in the hardware configuration 
properties of the CPU or the interface.

RET_VAL Output INT I, Q, M, D, L Output of error information.
GEOADDR InOut VARIANT D Pointer to the GEOADDR system data type.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".
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GEOADDR system data type
The GEOADDR system data type is a structure with the following configuration:

Parameter name Data type Description
GEOADDR STRUCT  
 HWTYPE UNIT Hardware type:

● 1: IO system (PROFINET/PROFIBUS)
● 2: IO device/DP slave
● 3: Rack
● 4: Module
● 5: Submodule
If a hardware type is not supported by the instruction, a HWTYPE "0" is output.

AREA UNIT Area ID: 
● 0 = CPU
● 1 = PROFINET IO
● 2 = PROFIBUS DP

IOSYSTEM UNIT PROFINET IO system (0 = central device in rack 0-3)
STATION UNIT ● Number of the rack if the area identifier  AREA = 0.

● Station number if area identifier AREA > 0.
SLOT UNIT Slot number
SUBSLOT UNIT Number of the submodule. If no submodule can be inserted, this parameter has 

the value "0".

Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0 No error occurred.
8090 The address specified at the LADDR parameter is invalid.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

LOG2MOD: Determine the hardware identifier from addressing of STEP 7 V5.5 SPx

Description 
You use the "LOG2MOD" instruction to determine the hardware identifier for an IO (sub)module 
from the addressing of STEP 7 5.5 SPx (IO data address or diagnostic address).

The hardware identifier is used at the LADDR input parameter for addressing of various 
instructions. You can convert the addressing parameters from STEP 7 5.5 SPx by calling 
"LOG2MOD" beforehand.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2546 System Manual, 07/2013,  



Parameter
The following table shows the parameters of the "LOG2MOD" instruction:

Parameter Declaration Data type Memory area Description
IOID Input BYTE I, Q, M, D, L or 

constant
Identifier of the address area as in STEP 7 5.5 
SPx:
● B#16#00: Bit15 of ADDR specifies whether 

an input (Bit15=0) or output address 
(Bit15=1) exists.

● B#16#54= Peripheral input (PI)
● B#16#55= Peripheral output (PQ)

ADDR Input WORD I, Q, M, D, L or 
constant

Logical address of the IO data of the module 
as offset (corresponding addressing in STEP 
7 5.5 SPx) or diagnostic address.

RET_VAL Return INT I, Q, M, D, L Error code of the instruction.
HWID Output HW_IO I, Q, M, D, L Determined hardware identifier (logical 

address) of the IO (sub)module.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

RET_VAL parameter

Error code* 
(W#16#...)

Explanation

0 No error occurred.
8093 ● Specified address is not used by any hardware components.

● Specified value at IOID parameter is invalid.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

IO2MOD: Determine hardware identifier from an IO address

Description
The "IO2MOD" instruction determines the hardware identifier of the module from an IO address 
(I, Q, PI, PQ) of a (sub)module.

Enter the IO address at the ADDR parameter. If a series of IO addresses is used at this 
parameter, only the first address is evaluated to determine the hardware identifier. If the first 
address is correctly specified, the length for the address specification at the ADDR is of no 
significance. If an address area is used that encompasses several modules or non-used 
addresses, the hardware  identifier of the first module can also be determined.

If no IO address of a sub(module) is specified at the ADDR parameter, the error code 8090 is 
output at the RET_VAL parameter.
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Parameter
The following table shows the parameters of the "IO2MOD" instruction:

Parameter Declaration Data type Memory area Description
ADDR Input VARIANT I, Q, M, D, L IO address (I, Q, PI, PQ) within a (sub)module.
RET_VAL Return INT I, Q, M, D, L Error code of the instruction.
LADDR Output HW_IO I, Q, M, D, L Determined hardware identifier (logical 

address) of the IO (sub)module.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

RET_VAL parameter

Error code* 
(W#16#...)

Explanation

0  No error occurred.
8090 IO address specified at ADDR parameter is not used by any hardware component.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

RD_ADDR: Determine IO addresses from the hardware identifier

Description
The "RD_ADDR" instruction determines the length and the start address of the inputs or 
outputs based on the hardware identifier of a sub(module).

● Use the LADDR parameter to select the input or output module based on the hardware 
identifier.

● The following output parameters are used depending on whether it is an input module or 
output module:

– In the case of an input module the determined values are output at the PIADDR and 
PICOUNT parameters.

– In the case of an output module the determined values are output at the PQADDR and 
PQCOUNT parameters.

● The PIADDR and PQADDR parameters each contain the start address of the I/O addresses 
of the module.

● The PICOUNT and PQCOUNT parameters each contain the number of bytes of the inputs 
our outputs (1 byte for 8 inputs/outputs, 2 bytes for 16 inputs/outputs).
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 Note
Addressing packed modules

If packed modules (not the first module of the packed module group) are addressed, the 
displayed data deviates from the hardware configuration. "0" is returned for PIADDR or 
PQADDR and PICOUNT or PQCOUNT. RET_VAL does not indicate an error (16#0000).

 

Parameters
The following table shows the parameters of the "RD_ADDR" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, D, L or 

constant
Hardware identifier of the (sub)module.

RET_VAL Return INT I, Q, M, D, L Error code of the instruction.
PIADDR Output UDINT I, Q, M, D, L Start address of the input module.
PICOUNT Output UINT I, Q, M, D, L Number of bytes of the inputs.
PQADDR Output UDINT I, Q, M, D, L Start address of the output module.
PQCOUNT Output UINT I, Q, M, D, L Number of bytes of the outputs.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0 No error occurred.
8090 Hardware identifier of the module at the LADDR parameter is invalid.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Other

GEO_LOG: Determine hardware identifier from slot

Description
The associated module slot of the module is known from the channel of a signal module. Use 
the "GEO_LOG" instruction to determine the corresponding hardware identifier of the module 
from this.

If you use the "GEO_LOG" instruction on power modules or modules with packed addresses 
(ET 200S), then the diagnostics address will be returned.
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Parameters
The following table shows the parameters of the instruction "GEO_LOG":

Parameter Declaration Data type Memory area Description
MASTER Input INT I, Q, M, D, L or 

constant
Area ID:
● 0, if the slot is located in a centralized 

configuration.
● 1 to 32: DP master system ID of the 

associated field device if the slot is located 
in a field device on PROFIBUS

● 100 to 115: PROFINET IO system ID of the 
associated field device if the slot is located 
in a field device on PROFINET

STATION Input INT I, Q, M, D, L or 
constant

● If MASTER = 0: Number of the rack
● If MASTER > 0: Station number of the field 

device
SLOT Input INT I, Q, M, D, L or 

constant
Slot number

SUBSLOT Input INT I, Q, M, D, L or 
constant

The SUBLOT parameter is not evaluated by 
the instruction.

RET_VAL Return INT I, Q, M, D, L Error information
LADDR Output HW_IO I, Q, M, D, L Hardware identifier or diagnostic address of 

the module

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8094 No subnet was configured with the specified SUBNETID .
8095 Illegal value for STATION parameter
8096 Illegal value for SLOT parameter
8099 The slot is not configured.
809A The number is not configured for the selected slot.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2542)

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2550 System Manual, 07/2013,  



LOG_GEO: Determine slot from hardware identifier

Description
You use the "LOG_GEO" instruction to determine the module slot belonging to a hardware 
identifier.

Parameters
The following table shows the parameters of the instruction "LOG_GEO":

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, D, L or constant Hardware identifier of the module for 

which the slot is to be determined.
RET_VAL Return INT I, Q, M, D, L Error information
AREA Output INT I, Q, M, D, L Area ID: indicates how the remaining 

output parameters are to be interpreted:
● 0: central device
● 2: PROFIBUS DP / PROFINET IO

MASTER Output INT I, Q, M, D, L or constant With AREA = 0:
● 0: If the slot is located in one of the 

racks (central device).
With AREA = 2:
● 1 to 32: DP master system ID of the 

associated field device if the slot is 
located in a field device on 
PROFIBUS

● 100 to 115: PROFINET IO system ID 
of the associated field device if the 
slot is located in a field device on 
PROFINET

STATION Output INT I, Q, M, D, L ● With MASTER = 0: Number of the rack
● With MASTER > 0: Station number of 

the field device
SLOT Output INT I, Q, M, D, L Slot number
SUBSLOT Output INT I, Q, M, D, L The SUBSLOT parameter is not output 

by the instruction (always "0").
OFFSET Output INT I, Q, M, D, L The OFFSET parameter is not output by 

the instruction (always "0").

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".
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Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8090 Specified logical address invalid
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2542)

RD_LGADR: Determine IO addresses from the hardware identifier

Description
You use a hardware identifier of a module, central submodule or a submodule for PNIO. You 
use the instruction to determine all the declared logical addresses of this module and the 
submodule. The "RD_LGADR" instruction enters the determined logical addresses in the 
PEADDR  or PAADDR  parameter in ascending order.

Parameters
The following table shows the parameters of the instruction "RD_LGADR":

Parameter Declaration Data type Memory area Description
IOID Input BYTE I, Q, M, D, L or constant Address area identifier:

● B#16#54 = Peripheral input (PI)
● B#16#55  = Peripheral output (PQ)

LADDR Input HW_ANY I, Q, M, D, L or constant Hardware identifier of the module or the 
submodule.

RET_VAL Return INT I, Q, M, D, L Error information
PEADDR Output ANY I, Q, M, D, L Array for the PI addresses, array elements 

must be of the WORD data type.
PECOUNT Output INT I, Q, M, D, L Number of returned PI addresses
PAADDR Output ANY I, Q, M, D, L Array for the PQ addresses, array elements 

must be of the WORD data type.
PACOUNT Output INT I, Q, M, D, L Number of returned PQ addresses

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".
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Parameter RET_VAL

Error code
(W#16#...)

Explanation

0000 No error occurred.
8090 Specified logical address invalid or illegal value for the IOID parameter.
80A0 Error in the output parameter PEADDR: The data type of the array elements is 

not WORD.
80A1 Error in the output parameter PAADDR: The data type of the array elements is 

not WORD.
80A2 Error in the output parameter PEADDR: The specified array could not 

accommodate all the logical addresses.
80A3 Error in the output parameter PAADDR: The specified array could not 

accommodate all the logical addresses.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

See also
Instructions for address conversion (Page 2542)

GADR_LGC: Determine hardware identifier from slot and offset in the user data address area

Description
You use the "GADR_LGC" instruction to determine the hardware identifier of a signal module. 
The hardware identifier is determined from the module slot and the offset in the user data 
address area of the module. 

If you use the "GADR_LGC" instruction on power modules or modules with packed addresses 
(ET 200S), then the diagnostics address will be returned.
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Parameters
The following table shows the parameters of the instruction "GADR_LGC":

Parameter Declaration Data type Memory area Description
SUBNETID Input BYTE I, Q, M, D, L or constant Area ID:

● 0: If the slot is located in the central 
module

● 1 to 32: DP master system ID of the 
corresponding distributed I/O system if 
the slot is in a 
distributed I/O device.

● 100 to 115: PROFINET IO system ID of 
the associated field device if the slot is 
located in a field device on PROFINET

RACK Input WORD I, Q, M, D, L or constant ● Number of the rack, if area identifier is 0
● Device number of the distributed I/O 

device if the area identifier > 0
SLOT Input WORD I, Q, M, D, L or constant Slot no.
SUBSLOT Input BYTE I, Q, M, D, L or constant Sub-module slot (if no sub-module can be 

inserted, 0 must be entered here)
SUBADDR Input WORD I, Q, M, D, L or constant Offset in the user data address area of the 

module
RET_VAL Return INT I, Q, M, D, L Error information
IOID Output BYTE I, Q, M, D, L The IOID output parameter is not written 

(always "0").
LADDR Output HW_MODUL

E
I, Q, M, D, L Hardware identifier of the module

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8089 Illegal value for SUBADDR parameter.
8093 Illegal value for SUBNETID parameter
8094 No subnet was configured with the specified SUBNETID .
8095 Illegal value for RACK parameter.
8096 Illegal value for SLOT parameter.
8097 Illegal value for SUBSLOT parameter.
8099 The slot is not configured.
809A The sub-address of the selected slot is not configured (only possible with central I/O for CPU and IM).
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Error code*
(W#16#...)

Explanation

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2542)

LGC_GADR: Determine slot from hardware identifier

Description
You use the "LGC_GADR" instruction to determine the module slot belonging to a hardware 
identifier.

 

 Note

The "LGC_GADR" instruction cannot be used on a module with packed addresses (ET 200S).
 

Parameters
The following table shows the parameters of the instruction "LGC_GADR":

Parameter Declaration Data type Memory area Description
IOID Input BYTE I, Q, M, D, L or constant Is not evaluated.
LADDR Input HW_MODUL

E
I, Q, M, D, L or constant Hardware identifier of the module

RET_VAL Return INT I, Q, M, D, L Error information
AREA Output BYTE I, Q, M, D, L Area ID: indicates how the remaining output 

parameters are to be interpreted:
● 0: Central module
● 2: PROFIBUS DP

RACK Output WORD I, Q, M, D, L Rack number:
● With central module AREA= 0):

– Rack number
● For PROFIBUS DP (AREA=2):

– Low byte: Station number
– High byte: DP master system ID
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Parameter Declaration Data type Memory area Description
SLOT Output WORD I, Q, M, D, L Slot number:

● With central module AREA= 0):
– Slot number

● For PROFIBUS DP (AREA=2):
– Slot no. in the station

SUBADDR Output WORD I, Q, M, D, L Is not output (always "0").

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8090 Specified logical address invalid or illegal value for the IOID parameter.
8093 This instruction is not permitted for the module selected by the parameters IOID and LADDR .
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2542)

9.7.4 Technology

9.7.4.1 S7-1200 Motion Control

MC_Power

MC_Power: Enable, disable axis

Description
The Motion Control instruction "MC_Power" releases or locks an axis.   
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Requirements
● The technology object "Axis" has been configured correctly.

● There is no pending enable-inhibiting error.

Override response
Execution of "MC_Power" cannot be aborted by a motion control command.

Disabling the axis (input parameter "Enable" = FALSE ) aborts all motion control commands 
for the associated technology object in accordance with the selected "StopMode".

Parameter   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Enable INPUT BOOL FALSE TRUE Motion Control attempts to enable the axis. 

FALSE All active commands are aborted according to the 
configured "StopMode" and the axis is stopped.

StopMode INPUT INT 0 0 Emergency stop
If a request to disable the axis is pending, the axis 
brakes at the configured emergency stop 
deceleration. The axis is disabled after reaching 
standstill.

1 Immediate stop
If a request to disable the axis is pending, this axis 
is disabled without deceleration. The pulse output 
is stopped immediately.

2 Emergency stop with jerk control
If a request to disable the axis is pending, the axis 
brakes at the configured emergency stop 
deceleration. If the jerk control is activated, the 
configured jerk is taken into account. The axis is 
disabled after reaching standstill.

Status OUTPUT BOOL FALSE Status of axis enable
FALSE The axis is disabled.

The axis does not execute motion control 
commands and does not accept any new 
commands (exception: MC_Reset command).
The axis is not homed.
Upon disabling, the status does not change to 
FALSE until the axis reaches a standstill.
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Parameter Declaration Data type Default value Description
TRUE The axis is enabled.

The axis is ready to execute motion control 
commands.
Upon axis enabling, the status does not change to 
TRUE until the signal "Drive ready" is pending. If 
the "Drive ready" drive interface was not configured 
in the axis configuration, the status changes to 
TRUE immediately.

Busy OUTPUT BOOL FALSE TRUE MC Power is active
Error OUTPUT BOOL FALSE TRUE An error occurred in motion control instruction 

"MC_Power" or in the associated technology 
object. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"

 
 

 Note

If the axis is switched off due to an error, it will be enabled again automatically after the error 
has been eliminated and acknowledged. This requires that input parameter "Enable" has 
retained the value TRUE during this process.

 

Enabling an axis with configured drive interface
To enable the axis, follow these steps:

1. Check the requirements indicated above.

2. Initialize input parameter "StopMode" with the desired value. Set input parameter "Enable" 
to TRUE.
The enable output for "Drive enabled" changes to TRUE to enable the power to the drive. 
The CPU waits for the "Drive ready" signal of the drive.
When the "Drive ready" signal is available at the configured ready input of the CPU, the 
axis becomes enabled. Output parameter "Status" and tag of technology object <Axis 
name>.StatusBits.Enable indicate the value TRUE.

Enabling an axis without configured drive interface
To enable the axis, follow these steps:

1. Check the requirements indicated above.

2. Initialize input parameter "StopMode" with the desired value. Set input parameter "Enable" 
to TRUE. The axis is enabled. Output parameter "Status" and tag of technology object <Axis 
name>.StatusBits.Enable indicate the value TRUE.
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Disabling an axis
To disable an axis, you can follow the steps described below:

1. Bring the axis to a standstill.
You can identify when the axis is at a standstill in the tag of the technology object <Axis 
name>.StatusBits.StandStill.

2. Set input parameter "Enable" to FALSE after standstill is reached.

3. If output parameters "Busy" and "Status" and tag of technology object <Axis 
name>.StatusBits.Enable indicate the value FALSE, disabling of the axis is complete.

 

 

See also
List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

MC_Power: Function chart (Page 2560)

MC_Reset: Acknowledge error (Page 2561)

MC_Home: Home axes, set home position  (Page 2562)

MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)
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MC_Power: Function chart

Function chart 

① An axis is enabled and then disabled again. When the drive has signaled "Drive ready" back to the CPU, the successful 
enable can be read out via "Status_1".

② Following an axis enable, an error has occurred that caused the axis to be disabled. The error is eliminated and 
acknowledged with "MC_Reset". The axis is then enabled again.

See also
MC_Power: Enable, disable axis (Page 2556)
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MC_Reset

MC_Reset: Acknowledge error

Description
Motion Control instruction "MC_Reset" can be used to acknowledge "Operating error with axis 
stop" and "Configuration error". The errors that require acknowledgement can be found in the 
"List of ErrorIDs and ErrorInfos" under "Remedy".   

From version V3.0, the axis configuration can be downloaded to the work memory in RUN 
operating mode.

Requirements
● The technology object "Axis" has been configured correctly.

● The cause of a pending configuration error requiring acknowledgement has been eliminated 
(for example, acceleration in "Axis" technology object has been changed to a valid value).

Override response
The MC_Reset command cannot be aborted by any other motion control command.

The new MC_Reset command does not abort any other active motion control commands.

Parameter   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Restart INPUT BOOL FALSE (From version V3.0)

TRUE Download the axis configuration from the load 
memory to the work memory. The command can 
only be executed when the axis is disabled.
Please refer to the notes on Download to the CPU 
(Page 6068).

FALSE Acknowledges pending errors
Done OUTPUT BOOL FALSE TRUE Error has been acknowledged.
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"
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Acknowledging an error requiring acknowledgement with MC_Reset
To acknowledge an error, follow these steps:

1. Check the requirements indicated above.

2. Start the acknowledgement of the error with a rising edge at input parameter "Execute".

3. If output parameter "Done" indicates the value TRUE and tag of technology object <Axis 
name>.StatusBits.Error the value FALSE, the error has been acknowledged.

 

See also
Download to CPU (Page 6068)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

MC_Power: Enable, disable axis (Page 2556)

MC_Home: Home axes, set home position  (Page 2562)

MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)

MC_Home

MC_Home: Home axes, set home position 

Description
Use the motion control instruction "MC_Home" to match the axis coordinates to the real, 
physical drive position. Homing is required for absolute positioning of the axis. The following 
types of homing can be executed:   

● Active homing (Mode = 3)
The homing procedure is executed automatically.

● Passive homing (Mode = 2)
During passive homing, the motion control instruction "MC_Home" does not carry out any 
homing motion. The traversing motion required for this step must be implemented by the 
user via other motion control instructions. When the homing switch is detected, the axis is 
homed.
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● Direct homing absolute (Mode = 0)
The current axis position is set to the value of parameter "Position".

● Direct homing relative (Mode = 1)
The current axis position is offset by the value of parameter "Position".

Requirements
● The technology object "Axis" has been configured correctly.

● The axis is enabled.

● No MC_CommandTable command may be active upon start with Mode = 0, 1 or 2.

Override response
The override response is dependent on the selected mode:

Mode = 0, 1

The MC_Home command cannot be aborted by any other motion control command.

The MC_Home command does not abort any active motion control commands. Position-
related motion commands are resumed after homing according to the new homing position 
(value at input parameter: "Position").

Mode = 2

The MC_Home command can be aborted by the following motion control commands:

● MC_Home command Mode  = 2, 3

The new MC_Home command aborts the following active motion control command.

● MC_Home command Mode  = 2

Position-related motion commands are resumed after homing according to the new homing 
position (value at input parameter: "Position").

Mode = 3

The MC_Home command can be aborted by the following motion control commands:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

The new MC_Home command aborts the following active motion control commands:

● MC_Home command Mode  = 2, 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command
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● MC_MoveVelocity command

● MC_MoveJog command

Parameter   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Position INPUT REAL 0.0 ● Mode = 0, 2, and 3

Absolute position of axis after completion of the 
homing operation

● Mode = 1
Correction value for the current axis position

Limit values:
-1.0e12 ≤ Position ≤ 1.0e12

Mode INPUT INT 0 Homing mode
0 Direct homing absolute

New axis position is the position value of 
parameter "Position".

1 Direct homing relative
New axis position is the current axis 
position + position value of parameter 
"Position".

2 Passive homing
Homing according to the axis 
configuration. Following homing, the 
value of parameter "Position" is set as the 
new axis position.

3 Active homing
Home position approach in accordance 
with the axis configuration. Following 
homing, the value of parameter "Position" 
is set as the new axis position.

Done OUTPUT BOOL FALSE TRUE Command completed
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was 

aborted by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID for parameter "ErrorID"
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 Note

Axis homing is lost under the following conditions:
● Disabling of axis by motion control instruction "MC_Power"
● Changeover between automatic mode and manual control
● Upon start of active homing. After successful completion of the homing operation, axis 

homing is again available.
● After POWER OFF -> POWER ON of the CPU
● After CPU restart (RUN-STOP -> STOP-RUN)

 

 

Homing an axis
To home the axis, follow these stops:

1. Check the requirements indicated above.

2. Initialize the necessary input parameters with values, and start the homing operation with 
a rising edge at input parameter "Execute"

3. If output parameter "Done" and technology object tag <Axis 
name>.StatusBits.HomingDone indicate the value TRUE, homing is complete.

 

See also
List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

MC_Power: Enable, disable axis (Page 2556)

MC_Reset: Acknowledge error (Page 2561)

MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)
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MC_Halt

MC_Halt: Halt axis

Description
The "MC_Halt" motion control instruction stops all movements and brings the axis to a standstill 
with the configured deceleration. The standstill position is not defined.  

Requirements
● The technology object "Axis" has been configured correctly.

● The axis is enabled.

Override response
The MC_Halt command can be aborted by the following motion control jobs:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

The new MC_Halt command aborts the following active motion control jobs:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

Parameter  

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Done OUTPUT BOOL FALSE TRUE Zero velocity reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
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Parameter Declaration Data type Default value Description
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"

See also
MC_Halt: Function chart (Page 2568)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

MC_Power: Enable, disable axis (Page 2556)

MC_Reset: Acknowledge error (Page 2561)

MC_Home: Home axes, set home position  (Page 2562)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)
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MC_Halt: Function chart

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 5.0

① The axis is braked by an MC_Halt command until it comes to a standstill. The axis standstill is signaled via "Done_2".
② While an MC_Halt command is braking the axis, this command is aborted by another motion command. The abort is 

signaled via "Abort_2".
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See also
MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute

MC_MoveAbsolute: Absolute positioning of axes

Description
The "MC_MoveAbsolute" motion control instruction starts an axis positioning motion to move 
it to an absolute position.   

Requirements
● The technology object "Axis" has been configured correctly.

● The axis is enabled.

● The axis is homed.

Override response
The MC_MoveAbsolute command can be aborted by the following motion control commands:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

The new MC_MoveAbsolute command aborts the following active motion control commands:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command
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Parameter   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Position INPUT REAL 0.0 Absolute target position

Limit values: 
-1.0e12 ≤ Position ≤ 1.0e12

Velocity INPUT REAL 10.0 Velocity of axis
This velocity is not always reached on account of the 
configured acceleration and deceleration and the 
target position to be approached.
Limit values:
Start/stop velocity ≤ Velocity ≤ maximum velocity

Done OUTPUT BOOL FALSE TRUE Absolute target position reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"

See also
MC_MoveAbsolute: Function chart (Page 2571)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

MC_Power: Enable, disable axis (Page 2556)

MC_Reset: Acknowledge error (Page 2561)

MC_Home: Home axes, set home position  (Page 2562)

MC_Halt: Halt axis (Page 2566)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)
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MC_MoveAbsolute: Function chart

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 10.0
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① An axis is moved to absolute position 1000.0 with an MC_MoveAbsolute command. When the axis reaches the target 
position, this is signaled via "Done_1". When "Done_1" = TRUE, another MC_MoveAbsolute command, with target 
position 1500.0, is started. Because of the response times (e.g., cycle time of user program, etc.), the axis comes to a 
standstill briefly (see zoomed-in detail). When the axis reaches the new target position, this is signaled via "Done_2".

② An active MC_MoveAbsolute command is aborted by another MC_MoveAbsolute command. The abort is signaled via 
"Abort_1". The axis is then moved at the new velocity to the new target position 1500.0. When the new target position 
is reached, this is signaled via "Done_2".

See also
MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative

MC_MoveRelative: Relative positioning of axes

Description
The "MC_MoveRelative" motion control instruction starts a positioning motion relative to the 
start position.  

Requirements
● The technology object "Axis" has been configured correctly.

● The axis is enabled.

Override response
The MC_MoveRelative command can be aborted by the following motion control jobs:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

The new MC_MoveRelative command aborts the following active motion control jobs:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2572 System Manual, 07/2013,  



● MC_MoveVelocity command

● MC_MoveJog command

Parameter  

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Distance INPUT REAL 0.0 Travel distance for the positioning operation

Limit values: 
-1.0e12 ≤ Distance  ≤ 1.0e12

Velocity INPUT REAL 10.0 Velocity of axis
This velocity is not always reached on account of the 
configured acceleration and deceleration and the 
distance to be traveled.
Limit values:
Start/stop velocity ≤ Velocity ≤ maximum velocity

Done OUTPUT BOOL FALSE TRUE Target position reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"
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See also
MC_MoveRelative: Function chart (Page 2575)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

MC_Power: Enable, disable axis (Page 2556)

MC_Reset: Acknowledge error (Page 2561)

MC_Home: Home axes, set home position  (Page 2562)

MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)
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MC_MoveRelative: Function chart

Function chart  

The following values were configured in the configuration window Dynamics > General:
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● Acceleration: 10.0

● Deceleration: 10.0

① The axis is moved by an MC_MoveRelative command by the distance ("Distance") 1000.0. When the axis reaches the 
target position, this is signaled via "Done_1". When "Done_1" = TRUE, another MC_MoveRelative command, with travel 
distance 500.0, is started. Because of the response times (e.g., cycle time of user program, etc.), the axis comes to a 
standstill briefly (see zoomed-in detail). When the axis reaches the new target position, this is signaled via "Done_2".

② An active MC_MoveRelative command is aborted by another MC_MoveRelative command. The abort is signaled via 
"Abort_1". The axis is then moved at the new velocity by the new distance ("Distance") 500.0. When the new target 
position is reached, this is signaled via "Done_2".

See also
MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity

MC_MoveVelocity: Move axes at preset rotational speed

Description
Motion control instruction "MC_MoveVelocity" moves the axis constantly at the specified 
velocity.   

Requirements
● The technology object "Axis" has been configured correctly.

● The axis is enabled.

Override response
MC_MoveVelocity can be aborted by the following motion control commands:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

The new MC_MoveVelocity command aborts the following active motion control commands:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command
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● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

Parameter 

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Velocity INPUT REAL 10.0 Velocity specification for axis motion

Limit values:
Start/stop velocity ≤ |Velocity ≤ maximum velocity
(Velocity = 0.0 is permitted)

Direction INPUT INT 0 Direction specification
0 Direction of rotation corresponds to the sign 

of the value in parameter "Velocity"
1 Positive direction of rotation

(The sign of the value in parameter 
"Velocity" is ignored)

2 Negative direction of rotation
(The sign of the value in parameter 
"Velocity" is ignored)

Current INPUT BOOL FALSE Maintain current velocity
FALSE "Maintain current velocity" is deactivated. 

The values of parameters "Velocity" and 
"Direction" are used.

TRUE "Maintain current velocity" is activated. The 
values in parameters "Velocity" and 
"Direction" are not taken into account.
When the axis resumes motion at the 
current velocity, the "InVelocity" parameter 
returns the value TRUE.

InVelocity OUTPUT BOOL FALSE TRUE ● "Current" = FALSE:
The velocity specified in parameter 
"Velocity" was reached.

● "Current" = TRUE:
The axis travels at the current velocity at 
the start time.

Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"
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Behavior with zero set velocity (Velocity = 0.0)
An MC_MoveVelocity command with "Velocity" = 0.0 (such as an MC_Halt command) aborts 
active motion commands and stops the axis with the configured deceleration.

When the axis comes to a standstill, output parameter "InVelocity" indicates TRUE for at least 
one program cycle. 

"Busy" indicates the value TRUE during the deceleration process and changes to FALSE 
together with "InVelocity". If parameter "Execute" = TRUE is set, "InVelocity" and "Busy" are 
latched.

When the "MC_MoveVelocity" command is started, status bit "SpeedCommand" is set in the 
technology object. Status bit "ConstantVelocity" is set upon axis standstill. Both bits are 
adapted to the new situation when a new motion command is started.

 

See also
MC_MoveVelocity: Function chart (Page 2579)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

MC_Power: Enable, disable axis (Page 2556)

MC_Reset: Acknowledge error (Page 2561)

MC_Home: Home axes, set home position  (Page 2562)

MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)
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MC_MoveVelocity: Function chart

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 10.0
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① An active MC_MoveVelocity command signals via "InVel_1" that its target velocity has been reached. It is then aborted 
by another MC_MoveVelocity command. The abort is signaled via "Abort_1". When the new target velocity 15.0 is 
reached, this is signaled via "InVel_2". The axis then continues moving at the new constant velocity.

② An active MC_MoveVelocity command is aborted by another MC_MoveVelocity command prior to reaching its target 
velocity. The abort is signaled via "Abort_1". When the new target velocity 15.0 is reached, this is signaled via "InVel_2". 
The axis then continues moving at the new constant velocity.

See also
MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog

MC_MoveJog: Move axes in jogging mode

Description
Motion control instruction "MC_MoveJog" moves the axis constantly at the specified velocity 
in jog mode. You use this motion control instruction, for example, for testing and commissioning 
purposes.   

Requirements
● The technology object "Axis" has been configured correctly.

● The axis is enabled.

Override response
The MC_MoveJog command can be aborted by the following motion control commands:

● MC_Home command Mode  = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

The new MC_MoveJog command aborts the following active motion control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command
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● MC_MoveVelocity command

● MC_MoveJog command

Parameter   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
JogForward INPUT BOOL FALSE As long as the parameter is TRUE, the axis moves in 

the positive direction at the velocity specified in 
parameter "Velocity".

JogBackward INPUT BOOL FALSE As long as the parameter is TRUE, the axis moves in 
the negative direction at the velocity specified in 
parameter "Velocity".

If both parameters are simultaneously TRUE, the axis stops with the configured deceleration. An error is indicated in 
parameters "Error", "ErrorID", and "ErrorInfo".
Velocity INPUT REAL 10.0 Preset velocity for jog mode

Limit values, instruction version V1.0:
Start/stop velocity ≤ |Velocity ≤ maximum velocity
Limits, instruction version V2.0:
Start/stop velocity ≤ velocity ≤ maximum velocity

InVelocity OUTPUT BOOL FALSE TRUE The velocity specified in parameter 
"Velocity" was reached.

Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"
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See also
MC_MoveJog: Function chart (Page 2583)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

MC_Power: Enable, disable axis (Page 2556)

MC_Reset: Acknowledge error (Page 2561)

MC_Home: Home axes, set home position  (Page 2562)

MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)
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MC_MoveJog: Function chart

Function chart 

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 5.0

① The axis is moved in the positive direction in jog mode via "Jog_F". When the target velocity 50.0 is reached, this is 
signaled via "InVelo_1". The axis brakes to a standstill again after  Jog_F is reset.

② The axis is moved in the negative direction in jog mode via "Jog_B". When the target velocity 50.0 is reached, this is 
signaled via "InVelo_1". The axis brakes to a standstill again after  Jog_B is reset.

See also
MC_MoveJog: Move axes in jogging mode (Page 2580)
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MC_CommandTable

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" V2.0)

Description
The Motion Control instruction "MC_CommandTable" combines multiple individual axis control 
commands in one movement sequence.   

Requirements
● The technology object "Axis" has been added to Version V2.0 and correctly configured.

● The technology object "Command table" has been added and correctly configured.

● The axis is enabled.

Override response
The MC_CommandTable command can be aborted by the following motion control commands:

● MC_Home command (Mode = 3)

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_CommandTable command aborts the following active motion control commands:

● MC_Home command (Mode = 3)

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The active motion control command is cancelled by the start of the first "Positioning Relative", 
"Positioning Absolute", "Velocity set point" or "Halt" command.
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Parameter   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
CommandTab
le

INPUT TO_CommandT
able_1

- Command table technology object

Execute INPUT BOOL FALSE Command table start with positive edge
StartStep INPUT INT 1 Defines the step at which the execution of the command 

table should begin
Limit values:
1 ≤ StartStep ≤ EndStep

EndStep INPUT INT 32 Defines the step up to which the execution of command 
table should take place
Limit values:
StartStep ≤ EndStep ≤ 32

Done OUTPUT BOOL FALSE TRUE Command table has been successfully executed
Busy OUTPU BOOL FALSE TRUE The command table is being executed.
CommandAb
orted

OUTPUT BOOL FALSE TRUE The command table was cancelled by another 
command.

Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 
command table. The cause of the error can be 
found in parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"
CurrentStep OUTPUT INT 0 Step in command table currently being executed
StepCode OUTPUT WORD 16#0000 User-defined numerical value / bit pattern of the step 

currently being executed

See also
List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

Overview of the Motion Control statements (Page 6072)

MC_Power: Enable, disable axis (Page 2556)

MC_Reset: Acknowledge error (Page 2561)

MC_Home: Home axes, set home position  (Page 2562)

MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)
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MC_ChangeDynamic

MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object "Axis" V2.0)

Description
Motion Control instruction "MC_ChangeDynamic" allows you to change the following settings 
of the axis:   

● Change the ramp-up time (acceleration) value

● Change the ramp-down time (deceleration) value

● Change the emergency stop ramp-down time (emergency stop deceleration) value

● Change the smoothing time (jerk) value

The effectiveness of the change is shown in the description of the tag (Page 6118).

Requirements
● The technology object "Axis" has been added to Version V2.0.

● The technology object "Axis" has been configured correctly.

Override response
A MC_ChangeDynamic command cannot be aborted by any other Motion Control command.

A new MC_ChangeDynamic command does not abort any active Motion Control commands.

Parameter   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
ChangeRa
mpUp

INPUT BOOL FALSE TRUE Change ramp-up time in line with input parameter 
"RampUpTime"

RampUpTi
me

INPUT REAL 5.00 Time (in seconds) to accelerate axis from standstill to 
configured maximum velocity without jerk limit.
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Acceleration. The effectiveness of 
the change is shown in the description of this tag.

ChangeRa
mpDown

INPUT BOOL FALSE TRUE Change ramp-down time in line with input 
parameter "RampDownTime"

RampDown
Time

INPUT REAL 5.00 Time (in seconds) to decelerate axis from the configured 
maximum velocity to standstill without jerk limiter.
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Deceleration . The effectiveness of 
the change is shown in the description of this tag.
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Parameter Declaration Data type Default value Description
ChangeEm
ergency

INPUT BOOL FALSE TRUE Change emergency stop ramp-down time in line 
with input parameter "EmergencyRampTime"

Emergency
RampTime

INPUT REAL 2.00 Time (in seconds) to decelerate the axis from configured 
maximum velocity to standstill without jerk limiter in 
emergency stop mode. 
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.EmergencyDeceleration . The 
effectiveness of the change is shown in the description of this 
tag.

ChangeJer
kTime

INPUT BOOL FALSE TRUE Change smoothing time according to the input 
parameter "JerkTime"

JerkTime INPUT REAL 0.25 Smoothing time (in seconds) used for the axis acceleration 
and deceleration ramps
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Jerk . The effectiveness of the 
change is shown in the description of this tag.

Done OUTPUT BOOL FALSE TRUE The changed values have been written to the 
technology data block. The description of the tags 
will show when the change becomes effective.

Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 
command. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 6109) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 6109) for parameter "ErrorID"

 
 

 Note

At the input parameters "RampUpTime", "RampDownTime", "EmergencyRampTime" and 
"JerkTime", values can be entered which exceed the admissible limits of the resulting 
parameters: "Acceleration", "Deceleration", "Emergency stop deceleration" and "Jerk".

Please note the equations and limit values in  "Axis technology object" -> "Configuring the 
technology object" -> "Dynamics" and ensure that the values you input are within the valid 
range.
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See also
List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

Overview of the Motion Control statements (Page 6072)

Changing the configuration of dynamics in the user program (Page 6042)

Changing the homing configuration in the user program (Page 6049)

MC_Power: Enable, disable axis (Page 2556)

MC_Reset: Acknowledge error (Page 2561)

MC_Home: Home axes, set home position  (Page 2562)

MC_Halt: Halt axis (Page 2566)

MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

MC_MoveRelative: Relative positioning of axes (Page 2572)

MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

MC_MoveJog: Move axes in jogging mode (Page 2580)

MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

Tag of the Axis technology object (Page 6118)

9.7.4.2 High-speed counters

CTRL_HSC: Control high-speed counters

Parameter

Parameter Data type Memory area Description
EN BOOL I, Q, M, D, L Enable input
ENO BOOL I, Q, M, D, L Enable output
HSC HW_HSC I, Q, M or constant Hardware address of 

the high-speed counter 
(HW-ID)

DIR BOOL I, Q, M, D, L or constant Enables the new count 
direction (see 
NEW_DIR) 

CV BOOL I, Q, M, D, L or constant Enables the new count 
value (see NEW_CV)

RV BOOL I, Q, M, D, L or constant Enables the new 
reference value (see 
NEW_RV)

PERIOD BOOL I, Q, M, D, L or constant Enables the new period 
of a frequency 
measurement (see 
NEW_PERIOD)
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Parameter Data type Memory area Description
NEW_DIR INT I, Q, M, D, L or constant Count direction loaded 

when DIR = TRUE. 
NEW_CV DINT I, Q, M, D, L or constant Count value loaded 

when CV = TRUE.
NEW_RV DINT I, Q, M, D, L or constant Reference value loaded 

when RV = TRUE.
NEW_PERIOD INT I, Q, M, D, L or constant Period of the frequency 

measurement loaded 
when PERIOD = TRUE. 

BUSY BOOL I, Q, M, D, L Processing status 
STATUS WORD I, Q, M, D, L Status of the operation

Description
With the "Control high-speed counters" instruction, you can make parameter settings and 
control the high-speed counters supported by the CPU by loading new values into the counter. 
Execution of the instruction requires that the high-speed counter to be controlled is enabled. 
You cannot execute multiple "Control high-speed counters" instructions simultaneously in the 
program for a given high-speed counter.

You can load the following parameter values into a high-speed counter using the "Control high-
speed counters" instruction:

● Count direction (NEW_DIR): The count direction defines whether a high-speed counter 
counts up or down. The count direction is defined by the following values at the NEW_DIR 
input: 1 = up, -1 = down. 
A change to the count direction with the "Control high-speed counters" instruction is only 
possible when direction control is set in the parameters by the program. The count direction 
specified at the NEW_DIR input is loaded into a high-speed counter when the bit at the DIR 
input is set.

● Count value (NEW_CV): The count value is the initial value at which a high-speed counter 
starts counting. The count value can be in the range -2147483648 to 2147483647.
The count value specified at the NEW_CV input is loaded into a high-speed counter when 
the bit at the CV input is set.

● Reference value (NEW_RV): You can compare the reference value with the current counter 
value to trigger an alarm. Similar to the counter value, the reference value can be in the 
range -2147483648 to 2147483647.
The reference value specified at the NEW_RV input is loaded into a high-speed counter 
when the bit at the RV input is set.

● Period of the frequency measurement (NEW_PERIOD): The period of the frequency 
measurement is specified by the following values at the NEW_PERIOD input: 10 = 0.01s, 
100 = 0.1s, 1000 = 1s. 
The time period can be updated if the "Measure frequency" function for the specified high-
speed counter is configured. The time period specified at the NEW_PERIOD input is loaded 
into a high-speed counter when the bit at the PERIOD input is set.

The "Control high-speed counters" instruction is only executed if the signal state at the EN 
input is "1". As long as the operation is executing, the bit at the BUSY output is set. Once the 
operation has executed completely, the bit at the BUSY output is reset.
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The ENO enable output is set only when the EN enable input has signal state "1" and no errors 
occur during execution of the operation.

When inserting the "Control high-speed counters" instruction, an instance data block is created 
in which the operation data is saved.

Parameter STATUS
At the STATUS output, you can query whether errors occurred during execution of the "Control 
high-speed counters" instruction. The following table shows the meaning of the values output 
at the STATUS output:

Error code (hexadecimal) Description
0 No error
80A1 Hardware identifier of the high-speed counter invalid
80B1 Count direction (NEW_DIR) invalid
80B2 Count value (NEW_CV) invalid
80B3 Reference value (NEW_RV) invalid
80B4 Period of the frequency measurement (NEW_PERIOD) invalid
80C0 Multiple access to the high-speed counter
80D0 The high-speed counter (HSC) is not enabled in the CPU hardware 

configuration.
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9.7.4.3 PID Control

PID_Compact

New features of PID_Compact

PID_Compact V2.1
● Use with S7-1200

As of PID_Compact V2.1, the instruction with V2 functionality can also be used on S7-1200 
with firmware version 4.0 or higher.

PID_Compact V2.0
● Reaction to error

The reaction to error has been completely overhauled. PID_Compact now reacts in a more 
fault-tolerant manner in the default setting. This reaction is set when copying PID_Compact 
V1.X from an S7-1200 CPU to an S7-1500 CPU.

 

 
 NOTICE

Your system may be damaged.

If you use the default setting, PID_Compact remains in automatic mode when the process 
value limits are exceeded. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to 
protect your system from damage. 

 

The Error parameter indicates if an error is pending. When the error is no longer pending, 
Error = FALSE. The ErrorBits parameter shows which errors have occurred. Use ErrorAck 
to acknowledge the errors and warnings without restarting the controller or clearing the 
integral action. Switching operating modes no longer clears errors that are no longer 
pending. 
You can configure the reaction to error with SetSubstituteOutput and ActivateRecoverMode.

● Substitute output value
You can configure a substitute output value that is to be output if an error occurs.

● Switching the operating mode
You specify the operating mode at the Mode in/out parameter and use a rising edge at 
ModeActivate to start the operating mode. The sRet.i_Mode tag has been omitted. 

● Multi-instance capability
You can call up PID_Compact as multi-instance DB. No technology object is created in this 
case and no parameter assignment interface or commissioning interface is available. You 
must assign parameters for PID_Compact directly in the multi-instance DB and commission 
it via a watch table.

● Startup characteristics
The operating mode specified at the Mode parameter is also started on a falling edge at 
Reset and during a CPU cold restart, if RunModeByStartup = TRUE.
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● ENO characteristics
ENO is set depending on the operating mode.
If State = 0, then ENO = FALSE.
If State ≠ 0, then ENO = TRUE. 

● Setpoint value specification during tuning
You configure the permitted fluctuation of the setpoint during tuning at the 
CancelTuningLevel tag.

● Value range for output value limits
The value 0.0 no longer has to fall within the output value limits.

● Pre-assigning the integral action
Using the tags IntegralResetMode and OverwriteInitialOutputValue, you can determine the 
pre-assignment of the integral action when switching from "Inactive" operating mode to 
"Automatic mode".

● Switching a disturbance variable on
You can switch a disturbance variable on at the Disturbance parameter.

● Default value of PID parameters
The following default settings have been changed:

– Proportional action weighting (PWeighting) from 0.0 to 1.0

– Derivative action weighting (DWeighting) from 0.0 to 1.0

– Coefficient for derivative delay (TdFiltRatio) from 0.0 to 0.2

● Renaming tags
The static tags have been given new names that are compatible with PID_3Step. 

PID_Compact V1.2
● Manual mode on CPU startup

If ManualEnable = TRUE when the CPU starts, PID_Compact starts in manual mode. A 
rising edge at ManualEnable is not necessary. 

● Pretuning
If the CPU is switched off during pretuning, pretuning starts again when the CPU is switched 
back on.

PID_Compact V1.1
● Manual mode on CPU startup

When the CPU starts up, PID_Compact only switches to manual mode with a rising edge 
at ManualEnable. Without rising edge, PID_Compact starts in the last operating mode in 
which ManualEnable was FALSE.

● Reaction to reset
A rising edge at Reset resets the errors and warnings and clears the integral action. A falling 
edge at Reset triggers a switchover to the most recently active operating mode.

● Pre-assignment of process value high limit
The pre-assigned value of r_Pv_Hlm has been changed to 120.0.
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● Monitoring the sampling time

– An error is no longer output when the current sampling time is >= 1.5 x current mean 
value or when the current sampling time is <= 0.5 x current mean value. The sampling 
time may deviate much more in automatic mode.

– PID_Compact is compatible with FW, V2.0 or higher.

● Access to tags
The following tags can now be used in the user program.

– i_Event_SUT

– i_Event_TIR

– r_Ctrl_Ioutv

● Troubleshooting
PID_Compact now outputs the correct pulses when the shortest ON time is not equal to 
the shortest OFF time.

Compatibility with CPU and FW
The following table shows which version of PID_Compact can be used on which CPU.

CPU FW PID_Compact
S7-1200 V4.x V2.1

V1.2
S7-1200 V3.X V1.2

V1.1
S7-1200 V2.X V1.2

V1.1
S7-1200 V1.X V1.0
S7-1500 V1.1 V2.1

V2.0
S7-1500 V1.0 V2.0

PID_Compact V2

Description of PID_Compact V2

Description 
The PID_Compact instruction provides a PID controller with integrated tuning for actuators 
with proportional action.

The following operating modes are possible:

● Inactive

● Pretuning
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● Fine tuning

● Automatic mode

● Manual mode

● Substitute output value with error monitoring

For a more detailed description of the operating modes, see the State parameter.

PID algorithm
PID_Compact is a PIDT1 controller with anti-windup and weighting of the proportional and 
derivative actions. The PID algorithm operates according to the following equation:

y  =  K
p 
 (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
TD Derivative action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
c Derivative action weighting
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Block diagram of PID_Compact

Block diagram of PIDT1 with anti-windup
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Call
PID_Compact is called in the constant time scale of a cycle interrupt OB.

If you call PID_Compact as a multi-instance DB, no technology object is created. No parameter 
assignment interface or commissioning interface is available. You must assign parameters for 
PID_Compact directly in the multi-instance DB and commission it via a watch table.

Download to device
The actual values of retentive variables are only updated when you download PID_Compact 
completely. 

Downloading technology objects to device (Page 5937)

Startup
When the CPU starts up, PID_Compact starts in the operating mode that is saved in the Mode 
in/out parameter. To switch to "Inactive" operating mode during startup, set 
RunModeByStartup = FALSE.

Reaction to error
In automatic mode and during commissioning, the reaction to error depends on the 
SetSubstituteOutput and ActivateRecoverMode variables. In manual mode, the reaction is 
independent of SetSubstituteOutput and ActivateRecoverMode. If ActivateRecoverMode = 
TRUE, the reaction additionally depends on the error that occurred.

SetSubstituteOu
tput

ActivateReco
verMode

Configuration editor 
> output value 
> Set Output to

Reaction

Not relevant FALSE Zero (inactive) Switch to "Inactive" mode (State = 0)
The value 0.0 0 is transferred to the actuator.

FALSE TRUE Current output value while error is 
pending

Switch to "Substitute output value with error 
monitoring" mode (State = 5)
The current output value is transferred to the 
actuator while the error is pending.

TRUE TRUE Substitute output value while error 
is pending

Switch to "Substitute output value with error 
monitoring" mode (State = 5)
The value at SubstituteOutput is transferred to the 
actuator while the error is pending.

In manual mode, PID_Compact uses ManualValue as output value, unless ManualValue is 
invalid. If ManualValue is invalid, SubstituteOutput is used. If ManualValue and 
SubstituteOutput are invalid, Config.OutputLowerLimit is used.

The Error parameter indicates if an error is pending. When the error is no longer pending, Error 
= FALSE. The ErrorBits parameter shows which errors have occurred. ErrorBits is reset by a 
rising edge at Reset or ErrorAck.
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PID_Compact V2 mode of operation

Monitoring process value limits
You specify the high limit and low limit of the process value in the Config.InputUpperLimit and 
Config.InputLowerLimit tags. If the process value is outside these limits, an error occurs 
(ErrorBits = 0001h).

You specify a high and low warning limit of the process value in the Config.InputUpperWarning 
and Config.InputLowerWarning tags. If the process value is outside these warning limits, a 
warning occurs (Warning = 0040h), and the InputWarning_H or InputWarning_L output 
parameter changes to TRUE. 

Limiting the setpoint 
You specify a high limit and low limit of the setpoint in the Config.SetpointUpperLimit and 
Config.SetpointLowerLimit tags. PID_Compact automatically limits the setpoint to the process 
value limits. You can limit the setpoint to a smaller range. PID_Compact checks whether this 
range falls within the process value limits. If the setpoint is outside these limits, the high or low 
limit is used as the setpoint, and output parameter SetpointLimit_H or SetpointLimit_L is set 
to TRUE.

The setpoint is limited in all operating modes.

Limiting the output value
You specify a high limit and low limit of the output value in the Config.OutputUpperLimit and 
Config.OutputLowerLimit tags. Output, ManualValue, and SubstituteOutput are limited to these 
values. The output value limits must match the control logic.

The valid output value limit values depend on the Output used.

Output -100.0 to 100.0%
Output_PER -100.0 to 100.0%
Output_PWM 0.0 to 100.0%

Rule:

OutputUpperLimit > OutputLowerLimit

Substitute output value
In the event of an error, PID_Compact can output a substitute output value that you define at 
the tag SubstituteOutput. The substitute output value must be within the output value limits.

Monitoring signal validity
The values of the following parameters are monitored for validity when used:

● Setpoint

● Input
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● Input_PER

● Disturbance

● ManualValue

● SubstituteOutput

● Output

● Output_PER

● Output_PWM

Monitoring of the sampling time PID_Compact
Ideally, the sampling time is equivalent to the cycle time of the calling OB. The PID_Compact 
instruction measures the time interval between two calls. This is the current sampling time. On 
every switchover of operating mode and during the initial startup, the mean value is formed 
from the first 10 sampling times. Too great a difference between the current sampling time and 
this mean value triggers an error (Error = 0800h).

The error occurs during tuning if: 

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

The error occurs in automatic mode if: 

● New mean value >= 1.5 x old mean value

● New mean value <= 0.5 x old mean value

If you deactivate the sampling time monitoring (CycleTime.EnMonitoring = FALSE), you can 
also call PID_Compact in OB1. You must then accept a lower control quality due to the 
deviating sampling time.

Sampling time of the PID algorithm
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_Compact are executed at every call.

If you use Output_PWM, the accuracy of the output signal is determined by the ratio of the PID 
algorithm sampling time to the cycle time of the OB. The cycle time should be at least 10 times 
the PID algorithm sampling time.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. For cooling and discharge control systems, it may 
be necessary to invert the control logic. PID_Compact does not work with negative proportional 
gain. If InvertControl = TRUE, an increasing control deviation causes a reduction in the output 
value. The control logic is also taken into account during pretuning and fine tuning. 
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Input parameters of PID_Compact V2

Table 9-77    

Parameter Data type Default Description
Setpoint REAL 0.0 Setpoint of the PID controller in automatic mode
Input REAL 0.0 A tag of the user program is used as the source of the 

process value. 
If you are using the Input parameter, then 
Config.InputPerOn = FALSE must be set.

Input_PER INT 0 An analog input is used as the source of the process 
value.
If you are using the Input_PER parameter, then 
Config.InputPerOn = TRUE must be set.

Disturbance REAL 0.0 Disturbance variable or precontrol value
ManualEnable BOOL FALSE ● A FALSE -> TRUE edge activates "manual mode", 

while State = 4, Mode remain unchanged.
As long as ManualEnable = TRUE, you cannot 
change the operating mode via a rising edge at 
ModeActivate or use the commissioning dialog.

● A TRUE -> FALSE edge activates the operating 
mode that is specified by Mode.

We recommend that you change the operating mode 
using ModeActivate only.

ManualValue REAL 0.0 Manual value
This value is used as the output value in manual mode.
Values from Config.OutputLowerLimit to 
Config.OutputUpperLimit are permitted.

ErrorAck BOOL FALSE ● FALSE -> TRUE edge
ErrorBits and Warning are reset.

Reset BOOL FALSE Restarts the controller.
● FALSE -> TRUE edge

– Switch to "Inactive" mode
– ErrorBits and Warnings are reset.
– Integral action is cleared

(PID parameters are retained)
● As long as Reset = TRUE, PID_Compact remains 

in "Inactive" mode (State = 0).
● TRUE -> FALSE edge

PID_Compact switches to the operating mode that 
is saved in the Mode parameter.

ModeActivate BOOL FALSE ● FALSE -> TRUE edge
PID_Compact switches to the operating mode that 
is saved in the Mode parameter.
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Output parameters of PID_Compact V2

Table 9-78    

Parameter Data type Default Description
ScaledInput REAL 0.0 Scaled process value
The "Output", "Output_PER", and "Output_PWM" outputs can be used concurrently.
Output REAL 0.0 Output value in REAL format
Output_PER INT 0 Analog output value 
Output_PWM BOOL FALSE Pulse-width-modulated output value

The output value is formed by by variable On and Off times.
SetpointLimit_H BOOL FALSE If SetpointLimit_H = TRUE, the absolute setpoint high limit 

is reached (Setpoint ≥ Config.SetpointUpperLimit).
The setpoint is limited to Config.SetpointUpperLimit .

SetpointLimit_L BOOL FALSE If SetpointLimit_L = TRUE, the absolute setpoint low limit 
has been reached (Setpoint ≤ Config.SetpointLowerLimit).
The setpoint is limited to Config.SetpointLowerLimit .

InputWarning_H BOOL FALSE If InputWarning_H = TRUE, the process value has reached 
or exceeded the warning high limit.

InputWarning_L BOOL FALSE If InputWarning_L = TRUE, the process value has reached 
or fallen below the warning low limit.

State INT 0 The State parameter (Page 2610) shows the current 
operating mode of the PID controller. You can change the 
operating mode using the input parameter Mode and a rising 
edge at ModeActivate. 
● State = 0: Inactive
● State = 1: Pretuning
● State = 2: Fine tuning
● State = 3: Automatic mode
● State = 4: Manual mode
● State = 5: Substitute output value with error monitoring

Error BOOL FALSE If Error = TRUE, at least one error message is pending in 
this cycle.

ErrorBits DWORD DW#16#0 The ErrorBits parameter (Page 2614) shows which error 
messages are pending. ErrorBits is retentive and is reset 
upon a rising edge at Reset or ErrorAck.
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In/out parameters of PID_Compact V2

Table 9-79  

Parameter Data type Default Description
Mode INT 4 At Mode, specify the operating mode to 

which PID_Compact is to switch. Options 
are:
● Mode = 0: Inactive
● Mode = 1: Pretuning
● Mode = 2: Fine tuning
● Mode = 3: Automatic mode
● Mode = 4: Manual mode
The operating mode is activated by:
● Rising edge at ModeActivate
● Falling edge at Reset
● Falling edge at ManualEnable
● Cold restart of CPU if 

RunModeByStartup = TRUE
Mode is retentive.
A detailed description of the operating 
modes can be found in Parameters State 
and Mode V2 (Page 2610).

See also
Parameters State and Mode V2 (Page 2610)
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Static tags of PID_Compact V2
You must not change variables that are not listed. These are used for internal purposes only.

Table 9-80    

Tag Data type Default Description
IntegralResetMode INT 1 The tag IntegralResetMode determines how 

PIDCtrl.IntegralSum is pre-assigned when switching 
from "Inactive" operating mode to "Automatic mode". 
This setting only works for one cycle.
Options are:
● IntegralResetMode = 0: Smoothing

The value of IntegralSum is pre-assigned so that the 
switchover is bumpless.

● IntegralResetMode = 1: Deleting
The value of IntegralSum is deleted. Any control 
deviation will cause a jump change of the output 
value.

● IntegralResetMode = 2: Holding
The value of IntegralSum is not changed. You can 
define a new value using the user program.

● IntegralResetMode = 3: Pre-assigning
The value of IntegralSum is automatically pre-
assigned so that Output is calculated with reference 
to the value OverwriteInitialOutputValue. This 
setting is useful, for example, for an override 
controller. 

OverwriteInitialOutputValue REAL 0.0 If IntegralResetMode = 3, the value of IntegralSum is 
automatically pre-assigned so that Output = 
OverwriteInitialOutputValue in the next cycle. 

RunModeByStartup BOOL TRUE Activate operating mode at Mode parameter after CPU 
restart
If RunModeByStartup = TRUE, PID_Compact starts in 
the operating mode saved in the Mode parameter after 
CPU startup.
If RunModeByStartup = FALSE, PID_Compact remains 
in "Inactive" mode after CPU startup.

LoadBackUp BOOL FALSE If LoadBackUp = TRUE, the last set of PID parameters 
is reloaded. The set was saved prior to the last tuning. 
LoadBackUp is automatically set back to FALSE.

PhysicalUnit INT 0 Unit of measurement of the process value and setpoint, 
e.g., ºC, or ºF.

PhysicalQuantity INT 0 Physical quantity of the process value and setpoint, 
e.g., temperature.

ActivateRecoverMode BOOL TRUE The Tag ActivateRecoverMode V2 (Page 2616) 
determines the reaction to error.

Warning DWORD 0 Tag Warning V2 (Page 2618) shows the warnings since 
Reset = TRUE or ErrorAck =TRUE. Warning is 
retentive.

Progress REAL 0.0 Progress of tuning as a percentage (0.0 - 100.0)
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Tag Data type Default Description
CurrentSetpoint REAL 0.0 CurrentSetpoint always displays the current setpoint. 

This value is frozen during tuning.
CancelTuningLevel REAL 10.0 Permissible fluctuation of setpoint during tuning. Tuning 

is not canceled until:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel

SubstituteOutput REAL 0.0 Substitute output value
When the following conditions are met, the substitute 
output value is used:
● An error has occurred in automatic mode.
● SetSubstituteOutput = TRUE
● ActivateRecoverMode = TRUE

SetSubstituteOutput BOOL TRUE If SetSubstituteOutput = TRUE and 
ActivateRecoverMode = TRUE, the substitute output 
value configured is output as long as an error is pending.
If SetSubstituteOutput = FALSE and 
ActivateRecoverMode = TRUE, the actuator remains at 
the current output value as long as an error is pending.
If ActivateRecoverMode = FALSE, SetSubstituteOutput 
is not effective.
If SubstituteOutput is invalid (ErrorBits = 20000h), the 
substitute output value cannot be output.

Config.InputPerOn BOOL TRUE If InputPerOn = TRUE, the Input_PER parameter is 
used. If InputPerOn = FALSE, the Input parameter is 
used.

Config.InvertControl BOOL FALSE Invert control logic
If InvertControl = TRUE, an increasing control deviation 
causes a reduction in the output value.

Config.InputUpperLimit REAL 120.0 High limit of the process value
Input and Input_PER are monitored to ensure 
adherence to this limit.
At the I/O input, the process value can be a maximum 
of 18% higher than the standard range (overrange). 
This pre-assignment ensures that an error is no longer 
signaled due to a violation of the "Process value high 
limit". Only a wire-break and a short-circuit are 
recognized and PID_Compact reacts according to the 
configured reaction to error.
InputUpperLimit > InputLowerLimit

Config.InputLowerLimit REAL 0.0 Low limit of the process value
Input and Input_PER are monitored to ensure 
adherence to this limit.
InputLowerLimit < InputUpperLimit
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Tag Data type Default Description
Config.InputUpperWarning REAL 3.402822e+38 Warning high limit of the process value

If you set InputUpperWarning outside the process value 
limits, the configured absolute process value high limit 
is used as the warning high limit. 
If you configure InputUpperWarning within the process 
value limits, this value is used as the warning high limit.
InputUpperWarning > InputLowerWarning
InputUpperWarning ≤ InputUpperLimit

Config.InputLowerWarning REAL -
3.402822e+38

Warning low limit of the process value
If you set InputLowerWarning outside the process value 
limits, the configured absolute process value low limit 
is used as the warning low limit. 
If you configure InputLowerWarning within the process 
value limits, this value is used as the warning low limit.
InputLowerWarning < InputUpperWarning
InputLowerWarning ≥ InputLowerLimit

Config.OutputUpperLimit REAL 100.0 High limit of output value
For details, see OutputLowerLimit
OutputUpperLimit > OutputLowerLimit

Config.OutputLowerLimit REAL 0.0 Low limit of output value 
For Output and Output_PER, the range of values from 
-100.0 to +100.0, including zero, is valid. At -100.0, 
Output_PER = -27648; at +100.0, Output_PER = 27648.
For Output_PWM, the value range 0.0 to +100.0 
applies.
The output value limits must match the control logic.
OutputLowerLimit < OutputUpperLimit

Config.SetpointUpperLimit REAL 3.40282
2e+38

High limit of setpoint
If you configure SetpointUpperLimit outside the process 
value limits, the configured absolute process value high 
limit is used as the setpoint high limit. 
If you configure SetpointUpperLimit within the process 
value limits, this value is used as the setpoint high limit.

Config.SetpointLowerLimit REAL -3.402822e
+38

Low limit of the setpoint
If you set SetpointLowerLimit outside the process value 
limits, the configured process value absolute low limit 
is used as the setpoint low limit.
If you set SetpointLowerLimit within the process value 
limits, this value is used as the setpoint low limit.

Config.MinimumOnTime REAL 0.0 The minimum ON time of the pulse width modulation in 
seconds is rounded to
MinimumOnTime = n×CycleTime.Value

Config.MinimumOffTime REAL 0.0 The minimum OFF time of the pulse width modulation 
in seconds is rounded to
MinimumOffTime = n×CycleTime.Value
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Tag Data type Default Description
Config.InputScaling.UpperPointIn REAL 27648.0 Scaling Input_PER high

Input_PER is converted to percent based on the two 
value pairs UpperPointOut, UpperPointIn and 
LowerPointOut, LowerPointIn.

Config.InputScaling.LowerPointIn REAL 0.0 Scaling Input_PER low
Input_PER is converted to percent based on the two 
value pairs UpperPointOut, UpperPointIn and 
LowerPointOut, LowerPointIn.

Config.InputScaling.UpperPointOut REAL 100.0 Scaled high process value 
Input_PER is converted to percent based on the two 
value pairs UpperPointOut, UpperPointIn and 
LowerPointOut, LowerPointIn.

Config.InputScaling.LowerPointOut REAL 0.0 Scaled low process value 
Input_PER is converted to percent based on the two 
value pairs UpperPointOut, UpperPointIn and 
LowerPointOut, LowerPointIn.

CycleTime.StartEstimation BOOL TRUE If CycleTime.StartEstimation = TRUE, the automatic 
determination of the cycle time is started. 
CycleTime.StartEstimation = FALSE once 
measurement is complete.

CycleTime.EnEstimation BOOL TRUE If CycleTime.EnEstimation = TRUE, the PID_Compact 
sampling time is calculated. 
If CycleTime.EnEstimation = FALSE, the PID_Compact 
sampling time is not calculated and you need to correct 
the configuration of CycleTime.Value manually.

CycleTime.EnMonitoring BOOL TRUE If CycleTime.EnMonitoring = FALSE, the PID_Compact 
sampling time is not monitored. If it is not possible to 
execute PID_Compact within the sampling time, no 
error (ErrorBits=0800h) is output and PID_Compact 
does not switch to "Inactive" mode.

CycleTime.Value REAL 0.1 PID_Compact sampling time in seconds
CycleTime.Value is determined automatically and is 
usually equivalent to the cycle time of the calling OB.

CtrlParamsBackUp.Gain REAL 1.0 Saved proportional gain
You can reload values from the CtrlParamsBackUp 
structure with LoadBackUp = TRUE.

CtrlParamsBackUp.Ti REAL 20.0 Saved integral action time [s]
CtrlParamsBackUp.Td REAL 0.0 Saved derivative action time [s]
CtrlParamsBackUp.TdFiltRatio REAL 0.0 Saved derivative delay coefficient
CtrlParamsBackUp.PWeighting REAL 0.0 Saved proportional action weighting factor
CtrlParamsBackUp.DWeighting REAL 0.0 Saved derivative action weighting factor
CtrlParamsBackUp.Cycle REAL 1.0 Saved sampling time of PID algorithm
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Tag Data type Default Description
PIDSelfTune.SUT.CalculateParams BOOL FALSE The properties of the controlled system are saved 

during tuning. If SUT.CalculateParams = TRUE, the 
parameters for pretuning are recalculated according to 
these properties. This enables you to change the 
parameter calculation method without having to repeat 
controller tuning.
SUT.CalculateParams is set to FALSE after the 
calculation.

PIDSelfTune.SUT.TuneRule INT 0 Methods used to calculate parameters during pretuning:
● SUT.TuneRule = 0: PID according to Chien, Hrones 

and Reswick
● SUT.TuneRule = 1: PI according to Chien, Hrones 

and Reswick
PIDSelfTune.SUT.State INT 0 The SUT.State tag indicates the current phase of 

pretuning:
● State = 0: Initialize pretuning
● State = 100: Calculate standard deviation
● State = 200: Determine point of inflection
● State = 9900: Pretuning successful
● State = 1: Pretuning not successful

PIDSelfTune.TIR.RunIn BOOL FALSE With the RunIn tag, you can specify that fine tuning can 
also be performed without pretuning.
● RunIn = FALSE

Pretuning is started when fine tuning is started from 
inactive or manual mode. If the requirements for 
pretuning are not met, PID_Compact reacts as 
when RunIn = TRUE.
If fine tuning is started from automatic mode, the 
system uses the existing PID parameters to control 
to the setpoint.
Only then will fine tuning start. If pretuning is not 
possible, PID_Compact switches to the mode from 
which tuning was started.

● RunIn = TRUE
The pretuning is skipped. PID_Compact tries to 
reach the setpoint with minimum or maximum 
output value. This can produce increased 
overshoot. Fine tuning then starts automatically.
RunIn is set to FALSE after fine tuning.

PIDSelfTune.TIR.CalculateParams BOOL FALSE The properties of the controlled system are saved 
during tuning. If TIR.CalculateParams = TRUE, the 
parameters for fine tuning are recalculated according 
to these properties. This enables you to change the 
parameter calculation method without having to repeat 
controller tuning.
TIR.CalculateParams is set to FALSE after the 
calculation.
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Tag Data type Default Description
PIDSelfTune.TIR.TuneRule INT 0 Methods used to calculate parameters during fine 

tuning:
● TIR.TuneRule = 0: PID automatic
● TIR.TuneRule = 1: PID rapid
● TIR.TuneRule = 2: PID slow
● TIR.TuneRule = 3: Ziegler-Nichols PID
● TIR.TuneRule = 4: Ziegler-Nichols PI
● TIR.TuneRule = 5: Ziegler-Nichols P

PIDSelfTune.TIR.State INT 0 The TIR.State tag indicates the current phase of fine 
tuning:
● State = -100 Fine tuning is not possible. Pretuning 

will be performed first.
● State = 0: Initialize fine tuning
● State = 200: Calculate standard deviation
● State = 300: Attempt to reach the setpoint
● State = 400: Attempt to reach the setpoint with 

existing PID parameters
(if pretuning was successful)

● State = 500: Determine oscillation and calculate 
parameters

● State = 9900: Fine tuning successful
● State = 1: Fine tuning not successful

PIDCtrl.IntegralSum REAL 0.0 Current integral action
Retain.CtrlParams.Gain REAL 1.0 Active proportional gain

To invert the control logic, use the Config.InvertControl 
tag. Negative values at Gain also invert the control 
logic. We recommend you use only InvertControl to set 
the control logic. The control logic is also inverted if 
InvertControl = TRUE and Gain < 0.0. 
Gain is retentive.

Retain.CtrlParams.Ti REAL 20.0 ● CtrlParams.Ti > 0.0: Active integral action time
● CtrlParams.Ti = 0.0: Integral action is deactivated
Ti is retentive.

Retain.CtrlParams.Td REAL 0.0 ● CtrlParams.Td > 0.0: Active derivative action time
● CtrlParams.Td = 0.0: Derivative action is 

deactivated
Td is retentive.
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Tag Data type Default Description
Retain.CtrlParams.TdFiltRatio REAL 0.2 Active derivative delay coefficient

The derivative delay coefficient delays the effect of the 
derivative action. 
Derivative delay = derivative action time × derivative 
delay coefficient
● 0.0: Derivative action is effective for one cycle only 

and therefore almost not effective.
● 0.5: This value has proved useful in practice for 

controlled systems with one dominant time constant.
● > 1.0: The greater the coefficient, the longer the 

effect of the derivative action is delayed.
TdFiltRatio is retentive.

Retain.CtrlParams.PWeighting REAL 1.0 Active proportional action weighting
The proportional action may weaken with changes to 
the setpoint.
Values from 0.0 to 1.0 are applicable.
● 1.0: Proportional action for setpoint change is fully 

effective
● 0.0: Proportional action for setpoint change is not 

effective
The proportional action is always fully effective when 
the process value is changed.
PWeighting is retentive.

Retain.CtrlParams.DWeighting REAL 1.0 Active derivative action weighting
The derivative action may weaken with changes to the 
setpoint.
Values from 0.0 to 1.0 are applicable.
● 1.0: Derivative action is fully effective upon setpoint 

change
● 0.0: Derivative action is not effective upon setpoint 

change
The derivative action is always fully effective when the 
process value is changed.
DWeighting is retentive.

Retain.CtrlParams.Cycle REAL 1.0 Active sampling time of the PID algorithm
CtrlParams.Cycle is calculated during tuning and 
rounded to an integer multiple of CycleTime.Value.
Cycle is retentive.

 

 Note

Change the tags listed in this table in "Inactive" mode to prevent malfunction of the PID 
controller.
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See also
Tag ActivateRecoverMode V2 (Page 2616)

Tag Warning V2 (Page 2618)

Downloading technology objects to device (Page 5937)

Changing the PID_Compact V2 interface
The following table shows what has changed in the PID_Compact instruction interface.

 

PID_Compact V1 PID_Compact V2 Change
Input_PER Input_PER Data type from Word to Int
 Disturbance New
 ErrorAck New
 ModeActivate New
Output_PER Output_PER Data type from Word to Int
Error ErrorBits Renamed
 Error New
 Mode New
sb_RunModeByStartup RunModeByStartup Function
 IntegralResetMode  
 OverwriteInitialOutputValue New
 SetSubstituteOutput New
 CancelTuningLevel New
 SubstituteOutput New

The following table shows which variables have been renamed.

PID_Compact V1.x PID_Compact V2
sb_GetCycleTime CycleTime.StartEstimation
sb_EnCyclEstimation CycleTime.EnEstimation
sb_EnCyclMonitoring CycleTime.EnMonitoring
sb_RunModeByStartup RunModeByStartup
si_Unit PhysicalUnit
si_Type PhysicalQuantity
sd_Warning Warning
sBackUp.r_Gain CtrlParamsBackUp.Gain
sBackUp.r_Ti CtrlParamsBackUp.Ti
sBackUp.r_Td CtrlParamsBackUp.Td
sBackUp.r_A CtrlParamsBackUp.TdFiltRatio
sBackUp.r_B CtrlParamsBackUp.PWeighting
sBackUp.r_C CtrlParamsBackUp.DWeighting
sBackUp.r_Cycle CtrlParamsBackUp.Cycle
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PID_Compact V1.x PID_Compact V2
sPid_Calc.r_Cycle CycleTime.Value
sPid_Calc.b_RunIn PIDSelfTune.TIR.RunIn
sPid_Calc.b_CalcParamSUT PIDSelfTune.SUT.CalculateParams
sPid_Calc.b_CalcParamTIR PIDSelfTune.TIR.CalculateParams
sPid_Calc.i_CtrlTypeSUT PIDSelfTune.SUT.TuneRule
sPid_Calc.i_CtrlTypeTIR PIDSelfTune.TIR.TuneRule
sPid_Calc.r_Progress Progress
sPid_Cmpt.r_Sp_Hlm Config.SetpointUpperLimit
sPid_Cmpt.r_Sp_Llm Config.SetpointLowerLimit
sPid_Cmpt.r_Pv_Norm_IN_1 Config.InputScaling.LowerPointIn
sPid_Cmpt.r_Pv_Norm_IN_2 Config.InputScaling.UpperPointIn
sPid_Cmpt.r_Pv_Norm_OUT_1 Config.InputScaling.LowerPointOut
sPid_Cmpt.r_Pv_Norm_OUT_2 Config.InputScaling.UpperPointOut
sPid_Cmpt.r_Lmn_Hlm Config.OutputUpperLimit
sPid_Cmpt.r_Lmn_Llm Config.OutputLowerLimit
sPid_Cmpt.b_Input_PER_On Config.InputPerOn
sPid_Cmpt.b_LoadBackUp LoadBackUp
sPid_Cmpt.b_InvCtrl Config.InvertControl
sPid_Cmpt.r_Lmn_Pwm_PPTm Config.MinimumOnTime
sPid_Cmpt.r_Lmn_Pwm_PBTm Config.MinimumOffTime
sPid_Cmpt.r_Pv_Hlm Config.InputUpperLimit
sPid_Cmpt.r_Pv_Llm Config.InputLowerLimit
sPid_Cmpt.r_Pv_HWrn Config.InputUpperWarning
sPid_Cmpt.r_Pv_LWrn Config.InputLowerWarning
sParamCalc.i_Event_SUT PIDSelfTune.SUT.State
sParamCalc.i_Event_TIR PIDSelfTune.TIR.State
sRet.i_Mode sRet.i_Mode has been omitted. The operating 

mode is changed using Mode and ModeActivate.
sRet.r_Ctrl_Gain Retain.CtrlParams.Gain
sRet.r_Ctrl_Ti Retain.CtrlParams.Ti
sRet.r_Ctrl_Td Retain.CtrlParams.Td
sRet.r_Ctrl_A Retain.CtrlParams.TdFiltRatio
sRet.r_Ctrl_B Retain.CtrlParams.PWeighting
sRet.r_Ctrl_C Retain.CtrlParams.DWeighting
sRet.r_Ctrl_Cycle Retain.CtrlParams.Cycle

Parameters State and Mode V2

Correlation of the parameters
The State parameter shows the current operating mode of the PID controller. You cannot 
change the State parameter. 
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With a rising edge at ModeActivate, PID_Compact switches to the operating mode saved in 
the Mode in-out parameter.

When the CPU is switched on or switches from Stop to RUN mode, PID_Compact starts in the 
operating mode that is saved in the Mode parameter. To leave PID_Compact in "Inactive" 
mode, set RunModeByStartup = FALSE.

Meaning of values

State / Mode Description of operating mode
0 Inactive

In "Inactive" operating mode, the output value 0.0 is always output, regardless of Config.OutputUpperLimit 
and Config.OutputLowerLimit. Pulse width modulation is off.

1 Pretuning
The pretuning determines the process response to a jump change of the output value and searches for the 
point of inflection. The PID parameters are calculated from the maximum rate of rise and dead time of the 
controlled system. You obtain the best PID parameters when you perform pretuning and fine tuning.
Pretuning requirements:
● Inactive (State = 0), manual mode (State = 4), or automatic mode (State = 3)
● ManualEnable = FALSE
● Reset = FALSE
● The process value must not be too close to the setpoint.

|Setpoint - Input| > 0.3 * | Config.InputUpperLimit - Config.InputLowerLimit| and
|Setpoint - Input| > 0.5 * |Setpoint|

● The setpoint and the process value lie within the configured limits.
The more stable the process value is, the easier it is to calculate the PID parameters and the more precise 
the result will be. Noise on the process value can be tolerated as long as the rate of rise of the process value 
is significantly higher compared to the noise. 
The setpoint is frozen in the CurrentSetpoint tag. Tuning is canceled when:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel
Before the PID parameters are recalculated, they are backed up and can be reactivated with LoadBackUp.
The controller switches to automatic mode following successful pretuning. If pretuning is unsuccessful, the 
switchover of the operating mode is dependent on ActivateRecoverMode.
The phase of pretuning is indicated with PIDSelfTune.SUT.State.
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State / Mode Description of operating mode
2 Fine tuning

Fine tuning generates a constant, limited oscillation of the process value. The PID parameters are recalculated 
based on the amplitude and frequency of this oscillation. PID parameters from fine tuning usually have better 
master control and disturbance characteristics than PID parameters from pretuning. You obtain the best PID 
parameters when you perform pretuning and fine tuning.
PID_Compact automatically attempts to generate an oscillation greater than the noise of the process value. 
Fine tuning is only minimally influenced by the stability of the process value. 
The setpoint is frozen in the CurrentSetpoint tag. Tuning is canceled when:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel
Before the PID parameters are recalculated, they are backed up and can be reactivated with LoadBackUp.
Requirements for fine tuning:
● No disturbances are expected.
● The setpoint and the process value lie within the configured limits.
● ManualEnable = FALSE
● Reset = FALSE
● Automatic (State = 3), inactive (State = 0) or manual (State = 4) mode
Fine tuning proceeds as follows when started from:
● Automatic mode (State = 3)

Start fine tuning from automatic mode if you wish to improve the existing PID parameters through tuning.
PID_Compact controls the system using the existing PID parameters until the control loop has stabilized 
and the requirements for fine tuning have been met. Only then will fine tuning start.

● Inactive (State = 0) or manual mode (State = 4)
If the requirements for pretuning are met, pretuning is started. The determined PID parameters will be 
used for control until the control loop has stabilized and the requirements for fine tuning have been met. 
If the process value for pretuning is already too near the setpoint or PIDSelfTune.TIR.RunIn = TRUE, an 
attempt is made to reach the setpoint with the minimum or maximum output value. This can produce 
increased overshoot. 
Only then will fine tuning start.

The controller switches to automatic mode following successful fine tuning. If fine tuning is unsuccessful, the 
switchover of the operating mode is dependent on ActivateRecoverMode.
The "Fine tuning" phase is indicated with PIDSelfTune.TIR.State.

3 Automatic mode
In automatic mode, PID_Compact corrects the controlled system in accordance with the parameters specified. 
The controller switches to automatic mode if one the following requirements is fulfilled:
● Pretuning successfully completed
● Fine tuning successfully completed
● Changing of the Mode in-out parameter to the value 3 and a rising edge at ModeActivate.
The switchover from automatic mode to manual mode is only bumpless if carried out in the commissioning 
editor.
The ActivateRecoverMode tag is taken into consideration in automatic mode.
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State / Mode Description of operating mode
4 Manual mode

In manual mode, you specify a manual output value in the ManualValue parameter.
You can also activate this operating mode using ManualEnable = TRUE. We recommend that you change 
the operating mode using Mode and ModeActivate only.
The switchover from manual mode to automatic mode is bumpless. Manual mode is also possible when an 
error is pending.

5 Substitute output value with error monitoring
The control algorithm is deactivated. The SetSubstituteOutput tag determines which output value is output in 
this operating mode.
● SetSubstituteOutput = FALSE: Last valid output value
● SetSubstituteOutput = TRUE: Substitute output value
You cannot activate this operating mode using Mode = 5. 
In the event of an error, it is activated instead of "Inactive" operating mode if all the following conditions are 
met:
● Automatic mode (Mode = 3)
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode is effective.
As soon as the errors are no longer pending, PID_Compact switches back to automatic mode.

ENO characteristics
If State = 0, then ENO = FALSE.

If State ≠ 0, then ENO = TRUE. 

Automatic switchover of operating mode during commissioning
Automatic mode is activated following successful pretuning or fine tuning. The following table 
shows how Mode and State change during successful pretuning.

Cycle no. Mode State Action
0 4 4 Set Mode = 1
1 1 4 Set ModeActivate = TRUE
1 4 1 Value of State is saved in Mode parameter

Pretuning is started
n 4 1 Pretuning successfully completed
n 3 3 Automatic mode is started

PID_Compact automatically switches the operating mode in the event of an error. The following 
table shows how Mode and State change during pretuning with errors. 

Cycle no. Mode State Action
0 4 4 Set Mode = 1
1 1 4 Set ModeActivate = TRUE

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2613



Cycle no. Mode State Action
1 4 1 Value of State is saved in Mode parameter

Pretuning is started
n 4 1 Pretuning canceled
n 4 4 Manual mode is started

If ActivateRecoverMode = TRUE, the operating mode that is saved in the Mode parameter is 
activated. At the start of pretuning or fine tuning, PID_Compact has saved the value of State 
in the Mode in/out parameter. PID_Compact therefore switches to the operating mode from 
which tuning was started.

If ActivateRecoverMode = FALSE, the system switches to "Inactive" operating mode.

See also
Output parameters of PID_Compact V2 (Page 2600)

Parameter ErrorBits V2
If several errors are pending simultaneously, the values of the ErrorBits are displayed with 
binary addition. The display of ErrorBits = 0003h, for example, indicates that the errors 0001h 
and 0002h are pending simultaneously.

In manual mode, PID_Compact uses ManualValue as output value. The exception is Errorbits 
= 10000h.

ErrorBits
 (DW#16#...)

Description

0000 There is no error.
0001 The "Input" parameter is outside the process value limits.

● Input > Config.InputUpperLimit or
● Input < Config.InputLowerLimit
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
remains in automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

0002 Invalid value at "Input_PER" parameter. Check whether an error is pending at the analog input.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
outputs the configured substitute output value. As soon as the error is no longer pending, PID_Compact 
switches back to automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

0004 Error during fine tuning. Oscillation of the process value could not be maintained.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0008 Error at start of pretuning. The process value is too close to the setpoint. Start fine tuning.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.
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ErrorBits
 (DW#16#...)

Description

0010 The setpoint was changed during tuning.
You can set the permitted fluctuation of the setpoint at the CancelTuningLevel tag.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0020 Pretuning is not permitted during fine tuning.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact remains in fine tuning mode.

0080 Error during pretuning. Incorrect configuration of output value limits.
Check whether the limits of the output value are configured correctly and match the control logic.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0100 Error during fine tuning resulted in invalid parameters.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0200 Invalid value at "Input" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
outputs the configured substitute output value. As soon as the error is no longer pending, PID_Compact 
switches back to automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

0400 Calculation of output value failed. Check the PID parameters.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
outputs the configured substitute output value. As soon as the error is no longer pending, PID_Compact 
switches back to automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

0800 Sampling time error: PID_Compact is not called within the sampling time of the cyclic interrupt OB.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
remains in automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

1000 Invalid value at "Setpoint" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
outputs the configured substitute output value. As soon as the error is no longer pending, PID_Compact 
switches back to automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

10000 Invalid value at ManualValue parameter. Value has an invalid number format.
If ActivateRecoverMode = TRUE  before an error occurred, PID_Compact uses SubstituteOutput as the 
output value. As soon as you specify a valid value in ManualValue, PID_Compact uses it as the output 
value.
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ErrorBits
 (DW#16#...)

Description

20000 Invalid value at SubstituteOutput tag. Value has an invalid number format.
PID_Compact uses the output value low limit as the output value. 
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_Compact switches back to automatic mode.

40000 Invalid value at Disturbance parameter. Value has an invalid number format.
If automatic mode was active and ActivateRecoverMode = TRUE before the error occurred, Disturbance 
is set to zero. PID_Compact remains in automatic mode.
If pretuning or fine tuning mode was active and ActivateRecoverMode = TRUE before the error occurred, 
PID_Compact switches to the operating mode saved in the Mode parameter. If Disturbance in the current 
phase has no effect on the output value, tuning is not be canceled. 

Tag ActivateRecoverMode V2
The ActivateRecoverMode tag determines the reaction to error. The Error parameter indicates 
if an error is pending. When the error is no longer pending, Error = FALSE. The ErrorBits 
parameter shows which errors have occurred. 

Automatic mode
 

 NOTICE

Your system may be damaged.

If ActivateRecoverMode = TRUE, PID_Compact remains in automatic mode even if there is 
an error and the process limit values are exceeded. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to protect 
your system from damage. 
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ActivateRecover
Mode

Description

FALSE PID_Compact automatically switches to "Inactive" mode in the event of an error. The controller is only 
activated by a falling edge at Reset or a rising edge at ModeActivate.

TRUE If errors occur frequently in automatic mode, this setting has a negative effect on the control response, 
because PID_Compact switches between the calculated output value and the substitute output value at 
each error. In this case, check the ErrorBits parameter and eliminate the cause of the error.
If one or more of the following errors occur, PID_Compact stays in automatic mode:
● 0001h: The "Input" parameter is outside the process value limits.
● 0800h: Sampling time error
● 40000h: Invalid value at parameter Disturbance. 
If one or more of the following errors occur, PID_Compact switches to "Substitute output value with error 
monitoring" mode:
● 0002h: Invalid value at Input_PER parameter.
● 0200h: Invalid value at Input parameter.
● 0400h: Calculation of output value failed.
● 1000h: Invalid value at Setpoint parameter. 
If the following error occurs, PID_Compact switches to "Substitute output value with error monitoring" 
mode and moves the actuator to Config.OutputLowerLimit:
● 20000h: Invalid value at SubstituteOutput tag. Value has an invalid number format.
This characteristics are independent of SetSubstituteOutput. 
As soon as the errors are no longer pending, PID_Compact switches back to automatic mode.

Pretuning and fine tuning

ActivateRecover
Mode

Description

FALSE PID_Compact automatically switches to "Inactive" mode in the event of an error. The controller is only 
activated by a falling edge at Reset or a rising edge at ModeActivate.

TRUE If the following error occurs, PID_Compact remains in the active mode:
● 0020h: Pretuning is not permitted during fine tuning.
The following errors are ignored:
● 10000h: Invalid value at ManualValue parameter.
● 20000h: Invalid value at SubstituteOutput tag. 
When any other error occurs, PID_Compact cancels the tuning and switches to the mode from which 
tuning was started.

Manual mode
ActivateRecoverMode is not effective in manual mode.
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Tag Warning V2
If several warnings are pending simultaneously, the values of the Warning tag are displayed 
with binary addition. The display of warning 0003h, for example, indicates that the warnings 
0001h and 0002h are pending simultaneously.

Warning
(DW#16#....)

Description

0000 No warning pending.
0001 The point of inflection was not found during pretuning.
0004 The setpoint was limited to the configured limits.
0008 Not all the necessary controlled system properties were defined for the selected method of calculation. 

Instead, the PID parameters were calculated using the TIR.TuneRule = 3 method.
0010 The operating mode could not be changed because Reset = TRUE or ManualEnable = TRUE.
0020 The cycle time of the calling OB limits the sampling time of the PID algorithm. 

Improve results by using shorter OB cycle times.
0040 The process value exceeded one of its warning limits.
0080 Invalid value at Mode. The operating mode is not switched.
0100 The manual value was limited to the limits of the controller output.
0200 The specified rule for tuning is not supported. No PID parameters are calculated.
1000 The substitute output value cannot be reached because it is outside the output value limits.

The following warnings are deleted as soon as the cause is eliminated:

● 0001h

● 0004h

● 0008h

● 0040h

● 0100h

All other warnings are cleared with a rising edge at Reset or ErrorAck.

PID_Compact V1

Description of PID_Compact V1

Description   
The PID_Compact instruction provides a PID controller with integrated tuning for automatic 
and manual mode.

Call
PID_Compact is called in the constant interval of the cycle time of the calling OB (preferably 
in a cyclic interrupt OB).
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Download to device
The actual values of retentive tags are only updated when you download PID_Compact 
completely.

Downloading technology objects to device (Page 5937)

Startup
At the startup of the CPU, PID_Compact starts in the operating mode that was last active. To 
retain PID_ Compact in "Inactive" mode, set sb_RunModeByStartup = FALSE.

Monitoring of the sampling time PID_Compact
Ideally, the sampling time is equivalent to the cycle time of the calling OB. The PID_Compact 
instruction measures the time interval between two calls. This is the current sampling time. On 
every switchover of operating mode and during the initial startup, the mean value is formed 
from the first 10 sampling times. If the current sampling time deviates too much from this mean 
value, Error = 0800 hex occurs and PID_Compact switches to "Inactive" mode.

PID_Compact, Version 1.1 or higher is set to "Inactive" mode during controller tuning under 
the following conditions:

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

In automatic mode, PID_Compact, Version 1.1 or higher, is set to "Inactive" mode under the 
following conditions:

● New mean value >= 1.5 x old mean value

● New mean value <= 0.5 x old mean value

During controller tuning and in automatic mode, PID_Compact 1.0 is set to "Inactive" operating 
mode under the following conditions:

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

● Current sampling time >= 1.5 x current mean value

● Current sampling time <= 0.5 x current mean value

Sampling time of the PID algorithm
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_Compact are executed at every call.
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PID algorithm
PID_Compact is a PIDT1 controller with anti-windup and weighting of the proportional and 
derivative actions. The following equation is used to calculate the output value.

y  =  K
p 
 (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
a Derivative delay coefficient (T1 = a × TD)
 Derivative action time
c Derivative action weighting

Block diagram of PID_Compact
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Block diagram of PIDT1 with anti-windup

Reaction to error
If errors occur, they are output in parameter Error, and PID_Compact changes to "Inactive" 
mode. Reset the errors using the Reset parameter.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. For cooling and discharge control systems, it may 
be necessary to invert the control logic. PID_Compact does not work with negative proportional 
gain. If InvertControl = TRUE, an increasing control deviation causes a reduction in the output 
value. The control logic is also taken into account during pretuning and fine tuning. 

See also
Controller type (Page 5959)

Input parameters of PID_Compact V1

Table 9-81    

Parameter Data type Default Description
Setpoint REAL 0.0 Setpoint of the PID controller in automatic mode
Input REAL 0.0 A variable of the user program is used as source for the process value. 

If you are using parameter Input, then 
sPid_Cmpt.b_Input_PER_On = FALSE must be set.
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Parameter Data type Default Description
Input_PER WORD W#16#0 Analog input as the source of the process value 

If you are using parameter Input_PER, then 
sPid_Cmpt.b_Input_PER_On = TRUE must be set.

ManualEnable BOOL FALSE ● A FALSE -> TRUE edge selects "Manual mode", while State = 4, 
sRet.i_Mode remains unchanged.

● A TRUE -> FALSE edge selects the most recently active operating 
mode, State =sRet.i_Mode

A change of sRet.i_Mode will not take effect during ManualEnable = 
TRUE. The change of sRet.i_Mode will only be considered upon a 
TRUE -> FALSE edge at ManualEnable .
PID_Compact V1.2 und PID_Compact V1.0
If at start of the CPU ManualEnable = TRUE, PID_Compact starts in 
manual mode. A rising edge (FALSE > TRUE) at ManualEnable is not 
necessary.
PID_Compact V1.1
At the start of the CPU, PID_Compact only switches to manual mode 
with a rising edge (FALSE->TRUE) at ManualEnable . Without rising 
edge, PID_Compact starts in the last operating mode in which 
ManualEnable was FALSE.

ManualValue REAL 0.0 Manual value
This value is used as the output value in manual mode.

Reset BOOL FALSE The Reset parameter (Page 2631) restarts the controller.

Output parameters of PID_Compact V1

Parameter Data type Default Description
ScaledInput REAL 0.0 Output of the scaled process value
Outputs "Output", "Output_PER", and "Output_PWM" can be used concurrently.
Output REAL 0.0 Output value in REAL format
Output_PER WORD W#16#0 Analog output value 
Output_PWM BOOL FALSE Pulse-width-modulated output value

The output value is formed by minimum On and Off times.
SetpointLimit_H BOOL FALSE If SetpointLimit_H = TRUE, the setpoint absolute high limit is reached. 

The setpoint in the CPU is limited to the configured setpoint absolute 
high limit. The configured process value absolute high limit is the 
default for the setpoint high limit.
If you set sPid_Cmpt.r_Sp_Hlm  to a value within the process value 
limits, this value is used as the setpoint high limit.

SetpointLimit_L BOOL FALSE If SetpointLimit_L = TRUE, the setpoint absolute low limit has been 
reached. In the CPU, the setpoint is limited to the configured setpoint 
absolute low limit. The configured process value absolute low limit is 
the default setting for the setpoint low limit.
If you set sPid_Cmpt.r_Sp_Llm  to a value within the process value 
limits, this value is used as the setpoint low limit.

InputWarning_H BOOL FALSE If InputWarning_H = TRUE, the process value has reached or 
exceeded the warning high limit.
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Parameter Data type Default Description
InputWarning_L BOOL FALSE If InputWarning_L = TRUE, the process value has reached or fallen 

below the warning low limit.
State INT 0 The State parameter (Page 2628) shows the current operating mode 

of the PID controller. To change the operating mode, use variable 
sRet.i_Mode. 
● State = 0: Inactive
● State = 1: pretuning
● State = 2: fine tuning
● State = 3: Automatic mode
● State = 4: Manual mode

Error DWORD W#16#0 The Error parameter (Page 2631) indicates the error messages. 
Error = 0000: No error pending.

Static tags of PID_Compact V1
You must not change tags that are not listed. These are used for internal purposes only.

Table 9-82    

Tag Data type Default Description
sb_GetCycleTime BOOL TRUE If sb_GetCycleTime = TRUE, the automatic 

determination of the cycle time is started. 
CycleTime.StartEstimation = FALSE once 
measurement is complete.

sb_EnCyclEstimation BOOL TRUE If sb_EnCyclEstimation = TRUE, the sampling time 
PID_Compact is calculated. 

sb_EnCyclMonitoring BOOL TRUE If sb_EnCyclMonitoring = FALSE, the sampling time 
PID_Compact is not monitored. If it is not possible to 
execute PID_Compact within the sampling time, an 
0800 error is not output and PID_Compact does not 
change to "Inactive" mode.

sb_RunModeByStartup BOOL TRUE Activate Mode after CPU restart
If sb_RunModeByStartup = FALSE, the controller will 
remain inactive after a CPU startup. 
After a CPU startup and if sb_RunModeByStartup = 
TRUE, the controller will return to the most recently 
active operating mode.

si_Unit INT 0 Unit of measurement of the process value and 
setpoint, e.g., ºC, or ºF.

si_Type INT 0 Physical quantity of the process value and setpoint, 
e.g., temperature.

sd_Warning DWORD DW#16#0 Variable sd_warning (Page 2633) displays the 
warnings generated since the reset, or since the last 
change of the operating mode.

sBackUp.r_Gain REAL 1.0 Saved proportional gain
You can reload values from the sBackUp structure 
with sPid_Cmpt.b_LoadBackUp = TRUE.

sBackUp.r_Ti REAL 20.0 Saved integral action time [s]
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Tag Data type Default Description
sBackUp.r_Td REAL 0.0 Saved derivative action time [s]
sBackUp.r_A REAL 0.0 Saved derivative delay coefficient
sBackUp.r_B REAL 0.0 Saved proportional action weighting factor
sBackUp.r_C REAL 0.0 Saved derivative action weighting factor
sBackUp.r_Cycle REAL 1.0 Saved sampling time of PID algorithm
sPid_Calc.r_Cycle REAL 0.1 Sampling time of the PID_Compact instruction

r_Cycle is determined automatically and usually 
equivalent to the cycle time of the calling OB.

sPid_Calc.b_RunIn BOOL FALSE ● b_RunIn = FALSE
Pretuning is started when fine tuning is started 
from inactive or manual mode. If the requirements 
for pretuning are not met, PID_Compact reacts like 
b_RunIn = TRUE.
If fine tuning is started from automatic mode, the 
system uses the existing PID parameters to control 
to the setpoint.
Only then will fine tuning start. If pretuning is not 
possible, PID_Compact will change to "Inactive" 
mode.

● b_RunIn = TRUE
The pretuning is skipped. PID_3Compact tries to 
reach the setpoint with minimum or maximum 
output value. This can produce increased 
overshoot. Fine tuning then starts automatically.
b_RunIn is set to FALSE after fine tuning.

sPid_Calc.b_CalcParamSUT BOOL FALSE The parameters for pretuning will be recalculated if 
b_CalcParamSUT = TRUE. This enables you to 
change the parameter calculation method without 
having to repeat controller tuning.
b_CalcParamSUT will be set to FALSE after 
calculation.

sPid_Calc.b_CalcParamTIR BOOL FALSE The parameters for fine tuning will be recalculated if 
b_CalcParamTIR = TRUE. This enables you to 
change the parameter calculation method without 
having to repeat controller tuning.
b_CalcParamTIR  will be set to FALSE after 
calculation.

sPid_Calc.i_CtrlTypeSUT INT 0 Methods used to calculate parameters during 
pretuning:
● i_CtrlTypeSUT = 0: PID according to Chien, 

Hrones and Reswick
● i_CtrlTypeSUT = 1: PI according to Chien, Hrones 

and Reswick

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2624 System Manual, 07/2013,  



Tag Data type Default Description
sPid_Calc.i_CtrlTypeTIR INT 0 Methods used to calculate parameters during fine 

tuning:
● i_CtrlTypeTIR = 0: PID automatic
● i_CtrlTypeTIR = 1: PID rapid
● i_CtrlTypeTIR = 2: PID slow
● i_CtrlTypeTIR = 3: Ziegler-Nichols PID
● i_CtrlTypeTIR = 4: Ziegler-Nichols PI
● i_CtrlTypeTIR = 5: Ziegler-Nichols P

sPid_Calc.r_Progress REAL 0.0 Progress of tuning as a percentage (0.0 - 100.0)
sPid_Cmpt.r_Sp_Hlm REAL +3.402822e

+38
High limit of setpoint
If you set sPid_Cmpt.r_Sp_Hlm outside the process 
value limits, the configured process value absolute 
high limit is used as the setpoint high limit. 
If you set sPid_Cmpt.r_Sp_Hlm  within the process 
value limits, this value is used as the setpoint high limit. 

sPid_Cmpt.r_Sp_Llm REAL -3.402822e
+38

Low limit of the setpoint
If you set sPid_Cmpt.r_Sp_Llm outside the process 
value limits, the configured process value absolute low 
limit is used as the setpoint low limit.
If you set sPid_Cmpt.r_Sp_Llm  within the process 
value limits, this value is used as the setpoint low limit. 

sPid_Cmpt.r_Pv_Norm_IN_1 REAL 0.0 Scaling Input_PER low
Input_PER is converted to percent based on the two 
value pairs r_Pv_Norm_OUT_1, r_Pv_Norm_IN_1 and 
r_Pv_Norm_OUT_2, r_Pv_Norm_IN_2 from the 
sPid_Cmpt structure.

sPid_Cmpt.r_Pv_Norm_IN_2 REAL 27648.0 Scaling Input_PER high
Input_PER is converted to percent based on the two 
value pairs r_Pv_Norm_OUT_1, r_Pv_Norm_IN_1 and 
r_Pv_Norm_OUT_2, r_Pv_Norm_IN_2 from the 
sPid_Cmpt structure.

sPid_Cmpt.r_Pv_Norm_OUT_1 REAL 0.0 Scaled low process value 
Input_PER is converted to percent based on the two 
value pairs r_Pv_Norm_OUT_1, r_Pv_Norm_IN_1 and 
r_Pv_Norm_OUT_2, r_Pv_Norm_IN_2 from the 
sPid_Cmpt structure.

sPid_Cmpt.r_Pv_Norm_OUT_2 REAL 100.0 Scaled high process value 
Input_PER is converted to percent based on the two 
value pairs r_Pv_Norm_OUT_1, r_Pv_Norm_IN_1 and 
r_Pv_Norm_OUT_2, r_Pv_Norm_IN_2 from the 
sPid_Cmpt structure.

sPid_Cmpt.r_Lmn_Hlm REAL 100.0 Output value high limit for output parameter "Output"
sPid_Cmpt.r_Lmn_Llm REAL 0.0 Low output value limit for output parameter "Output"
sPid_Cmpt.b_Input_PER_On BOOL TRUE If b_Input_PER_On = TRUE, then parameter 

Input_PER is used. If b_Input_PER_On = FALSE, then 
parameter Input is used.
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Tag Data type Default Description
sPid_Cmpt.b_LoadBackUp BOOL FALSE Activate the back-up parameter set. If an optimization 

has failed, you can reactivate the previous PID 
parameters by setting this bit.

sPid_Cmpt.b_InvCtrl BOOL FALSE Invert control logic
With b_InvCtrl = TRUE, a rising control deviation 
reduces the output value.

sPid_Cmpt.r_Lmn_Pwm_PPTm REAL 0.0 The minimum ON time of the pulse width modulation 
in seconds is rounded to
r_Lmn_Pwm_PPTm = r_Cycle or 
r_Lmn_Pwm_PPTm = n*r_Cycle

sPid_Cmpt.r_Lmn_Pwm_PBTm REAL 0.0 The minimum OFF time of the pulse width modulation 
in seconds is rounded to
r_Lmn_Pwm_PBTm = r_Cycle or 
r_Lmn_Pwm_PBTm = n*r_Cycle

sPid_Cmpt.r_Pv_Hlm REAL 120.0 High limit of the process value
At the I/O input, the process value can be a maximum 
of 18% higher than the standard range (overrange). 
An error is no longer reported for a violation of the 
"Process value high limit". Only a wire-break and a 
short-circuit are recognized and the PID_Compact 
switches to "Inactive" mode.
r_Pv_Hlm > r_Pv_Llm

sPid_Cmpt.r_Pv_Llm REAL 0.0 Low limit of the process value
r_Pv_Llm < r_Pv_Hlm

sPid_Cmpt.r_Pv_HWrn REAL +3.402822e
+38

Warning high limit of the process value
If you set r_Pv_HWrn outside the process value limits, 
the configured process value absolute high limit is 
used as the warning high limit. 
If you set r_Pv_HWrn within the process value limits, 
this value is used as the warning high limit.
r_Pv_HWrn > r_Pv_LWrn
r_Pv_HWrn ≤ r_Pv_Hlm

sPid_Cmpt.r_Pv_LWrn REAL -3.402822e
+38

Warning low limit of the process value
If you set r_Pv_LWrn outside the process value limits, 
the configured process value absolute low limit is used 
as the warning low limit. 
If you set r_Pv_LWrn within the process value limits, 
this value is used as the warning low limit.
r_Pv_LWrn < r_Pv_HWrn
r_Pv_LWrn ≥ r_Pv_LWrn

sParamCalc.i_Event_SUT INT 0 Variable i_Event_SUT (Page 2634) indicates the 
current phase of "pretuning":

sParamCalc.i_Event_TIR INT 0 Variable i_Event_TIR (Page 2634) indicates the 
current phase of "fine tuning": 
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Tag Data type Default Description
sRet.i_Mode INT 0 The operating mode is changed edge-triggered.

The following operating mode is enabled on a change 
to
● i_Mode = 0: "Inactive" (controller stop)
● i_Mode = 1: "Pretuning" mode
● i_Mode = 2: "Fine tuning" mode
● i_Mode = 3: "Automatic mode"
● i_Mode = 4: "Manual mode"
i_Mode is retentive.

sRet.r_Ctrl_Gain REAL 1.0 Active proportional gain
Gain is retentive.

sRet.r_Ctrl_Ti REAL 20.0 ● r_Ctrl_Ti > 0.0: active integral action time
● r_Ctrl_Ti = 0.0: Integral action is disabled
r_Ctrl_Ti is retentive.

sRet.r_Ctrl_Td REAL 0.0 ● r_Ctrl_Td > 0.0: Active derivative action time
● r_Ctrl_Td = 0.0: Derivative action is disabled
r_Ctrl_Td is retentive.

sRet.r_Ctrl_A REAL 0.0 Active derivative delay coefficient
r_Ctrl_A is retentive.

sRet.r_Ctrl_B REAL 0.0 Active proportional action weighting
r_Ctrl_B is retentive.

sRet.r_Ctrl_C REAL 0.0 Active derivative action weighting
r_Ctrl_C is retentive.

sRet.r_Ctrl_Cycle REAL 1.0 Active sampling time of the PID algorithm
r_Ctrl_Cycle is calculated during controller tuning and 
rounded to an integer multiple of r_Cycle.
r_Ctrl_Cycle is retentive.

 
 

 Note

Change the tags listed in this table in "Inactive" mode to prevent malfunction of the PID 
controller. The "Inactive" mode is forced by setting variable "sRet.i_Mode" to "0".

 

See also
Downloading technology objects to device (Page 5937)
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Parameters State and sRet.i_Mode V1

Correlation of the parameters
The State parameter indicates the current operating mode of the PID controller. You cannot 
modify the State parameter. 

You need to modify the sRet.i_Mode tag to change the operating mode. This also applies when 
the value for the new operating mode is already in sRet.i_Mode. First set sRet.i_Mode = 0 and 
then sRet.i_Mode = 3. Provided the current operating mode of the controller supports this 
change, State is set to the value of sRet.i_Mode.

When PID_Compact automatically switches the operating mode, the following applies: State !
= sRet.i_Mode.

Examples:

● Successful pretuning
State = 3 and sRet.i_Mode = 1

● Error
State = 0 and sRet.i_Mode remains at the same value, e.g sRet.i_Mode = 3

● ManualEnalbe = TRUE
State = 4 and sRet.i_Mode remain at the previous value, for example, sRet.i_Mode = 3

 

  Note

You wish to repeat successful fine tuning without exiting automatic mode with i_Mode = 0.

Setting sRet.i_Mode to an invalid value such as 9999 for one cycle has no effect on State. 
Set Mode = 2 in the next cycle. You can generate a change to sRet.i_Mode without first 
switching to "inactive" mode.
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Meaning of values

State / 
sRet.i_Mode

Description of the operating mode

0 Inactive
The controller is switched off. 
The controller was in "inactive" mode before pretuning was performed.
The PID controller will change to "inactive" mode when running if an error occurs or if the "Deactivate 
controller" icon is clicked in the commissioning window.

1 Pretuning
The pretuning determines the process response to a jump of the output value and searches for the point of 
inflection. The optimized PID parameters are calculated as a function of the maximum rate of rise and dead 
time of the controlled system. 
Pretuning requirements:
● The controller is in inactive mode or manual mode
● ManualEnable = FALSE
● The process value must not be too close to the setpoint.

|Setpoint - Input| > 0.3 * |sPid_Cmpt.r_Pv_Hlm - sPid_Cmpt.r_Pv_Llm| and
|Setpoint - Input| > 0.5 * |Setpoint|

● The setpoint may not be changed during pretuning.
The higher the stability of the process value, the easier it is to calculate the PID parameters and increase 
precision of the result. Noise on the process value can be tolerated as long as the rate of rise of the process 
value is significantly higher compared to the noise. 
PID parameters are backed up before they are recalculated and can be reactivated with 
sPid_Cmpt.b_LoadBackUp.
There is a change to automatic mode following successful pretuning and to "inactive" mode following 
unsuccessful pretuning.
The phase of pretuning is indicated with Tag i_Event_SUT V1 (Page 2634).

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2629



State / 
sRet.i_Mode

Description of the operating mode

2 Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters are optimized 
based on the amplitude and frequency of this oscillation. The differences between the process response 
during pretuning and fine tuning are analyzed. All PID parameters are recalculated on the basis of the findings. 
PID parameters from fine tuning usually have better master control and disturbance behavior than PID 
parameters from pretuning.
PID_Compact automatically attempts to generate an oscillation greater than the noise of the process value. 
Fine tuning is only minimally influenced by the stability of the process value. 
PID parameters are backed up before they are recalculated and can be reactivated with 
sPid_Cmpt.b_LoadBackUp.
Requirements for fine tuning:
● No disturbances are expected.
● The setpoint and the process value lie within the configured limits.
● The setpoint may not be changed during fine tuning.
● ManualEnable = FALSE
● Automatic (State = 3), inactive (State = 0) or manual (State = 4) mode
Fine tuning proceeds as follows when started in:
● Automatic mode (State = 3)

Start fine tuning in automatic mode if you wish to improve the existing PID parameters using controller 
tuning.
PID_Comact will regulate using the existing PID parameters until the control loop has stabilized and the 
requirements for fine tuning have been met. Only then will fine tuning start.

● Inactive (State = 0) or manual (State = 4) mode
If the requirements for pretuning are met, pretuning is started. The PID parameters established will be 
used for adjustment until the control loop has stabilized and the requirements for fine tuning have been 
met. Only then will fine tuning start. If pretuning is not possible, PID_Compact will change to "Inactive" 
mode.
An attempt is made to reach the setpoint with a minimum or maximum output value if the process value 
for pretuning is already too near the setpoint or sPid_Calc.b_RunIn = TRUE. This can produce increased 
overshoot.

The controller will change to "automatic mode" after successfully completed "fine tuning" and to "inactive" 
mode if "fine tuning" has not been successfully completed.
The "Fine tuning" phase is indicated with Tag i_Event_TIR V1 (Page 2634).

3 Automatic mode
In automatic mode, PID_Compact corrects the controlled system in accordance with the parameters specified. 
The controller changes to automatic mode if one the following conditions is fulfilled:
● Pretuning successfully completed
● Fine tuning successfully completed
● Change of variable sRet.i_Mode to the value 3.
After CPU startup or change from Stop to RUN mode, PID_Compact will start in the most recently active 
operating mode. To retain PID_Compact in "Inactive" mode, set sb_RunModeByStartup = FALSE.

4 Manual mode
In manual mode, you specify a manual output value in the ManualValue parameter.
This operating mode is enabled if sRet.i_Mode = 4, or at the rising edge on ManualEnable. If ManualEnable 
changes to TRUE, only State will change. sRet.i_Mode will retain its current value. PID_Compact will return 
to the previous operating mode upon a falling edge at ManualEnable.
The change to automatic mode is bumpless.
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See also
Output parameters of PID_Compact V1 (Page 2622)

Pretuning (Page 5969)

Fine tuning (Page 5971)

"Manual" mode (Page 5973)

Tag i_Event_SUT V1 (Page 2634)

Tag i_Event_TIR V1 (Page 2634)

Parameter Error V1
If several errors are pending simultaneously, the values of the error codes are displayed with 
binary addition. The display of error code 0003, for example, indicates that the errors 0001 
and 0002 are pending simultaneously.

Error
 (DW#16#...)

Description

0000 There is no error.
0001 The "Input" parameter is outside the process value limits.

● Input > sPid_Cmpt.r_Pv_Hlm or
● Input < sPid_Cmpt.r_Pv_Llm
You cannot move the actuator again until you eliminate the error.

0002 Invalid value at "Input_PER" parameter. Check whether an error is pending at the analog input.
0004 Error during fine tuning. Oscillation of the process value could not be maintained.
0008 Error at start of pretuning. The process value is too close to the setpoint. Start fine tuning.
0010 The setpoint was changed during tuning.
0020 Pretuning is not permitted in automatic mode or during fine tuning.
0080 Incorrect configuration of output value limits.

Check whether the limits of the output value are configured correctly and match the control logic.
0100 Error during tuning resulted in invalid parameters.
0200 Invalid value at "Input" parameter: Value has an invalid number format.
0400 Calculation of output value failed. Check the PID parameters.
0800 Sampling time error: PID_Compact is not called within the sampling time of the cyclic interrupt OB.
1000 Invalid value at "Setpoint" parameter: Value has an invalid number format.

See also
Output parameters of PID_Compact V1 (Page 2622)

Parameter Reset V1
The response to Reset = TRUE depends on the version of the PID_Compact instruction.
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Reset response PID_Compact V.1.1 or higher
A rising edge at Reset resets the errors and warnings and clears the integral action. A falling 
edge at Reset triggers a change to the most recently active operating mode.

① Activation
② Error
③ Reset
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Reset response PID_Compact V.1.0
A rising edge at Reset resets the errors and warnings and clears the integral action. The 
controller is not reactivated until the next edge at i_Mode. 

① Activation
② Error
③ Reset

 

Tag sd_warning V1
If several warnings are pending, the values of variable sd_warning are displayed by means of 
binary addition. The display of warning 0003, for example, indicates that the warnings 0001 
and 0002 are also pending.

sd_warning
(DW#16#....)

Description

0000 No warning pending.
0001 The point of inflection was not found during pretuning.
0002 Oscillation increased during fine tuning.
0004 The setpoint was outside the set limits.
0008 Not all the necessary controlled system properties were defined for the selected method of calculation. The 

PID parameters were instead calculated using the "i_CtrlTypeTIR = 3" method.
0010 The operating mode could not be changed because ManualEnable = TRUE.
0020 The cycle time of the calling OB limits the sampling time of the PID algorithm. 

Improve results by using shorter OB cycle times.
0040 The process value exceeded one of its warning limits.
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The following warnings are deleted as soon as the cause is dealt with:

● 0004

● 0020

● 0040

All other warnings are cleared with a rising edge at Reset.

Tag i_Event_SUT V1

i_Event_SUT Name Description
0 SUT_INIT Initialize pretuning

100 SUT_STDABW Calculate the standard deviation
200 SUT_GET_POI Find the point of inflection

9900 SUT_IO Pretuning successful
1 SUT_NIO Pretuning not successful

See also
Static tags of PID_Compact V1 (Page 2623)

Parameters State and sRet.i_Mode V1 (Page 2628)

Tag i_Event_TIR V1

i_Event_TIR Name Description
-100 TIR_FIRST_SUT Fine tuning is not possible. Pretuning will be executed first.

0 TIR_INIT Initialize fine tuning
200 TIR_STDABW Calculate the standard deviation
300 TIR_RUN_IN Attempt to reach the setpoint
400 TIR_CTRLN Attempt to reach the setpoint with the existing PID parameters 

(if pretuning has been successful)
500 TIR_OSZIL Determine oscillation and calculate parameters

9900 TIR_IO Fine tuning successful
1 TIR_NIO Fine tuning not successful

See also
Static tags of PID_Compact V1 (Page 2623)

Parameters State and sRet.i_Mode V1 (Page 2628)
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PID_3Step

New features of PID_3Step

PID_3Step V2.1
●  Use with S7-1200

As of PID_3Step V2.1, the instruction with V2 functionality can also be used on S7-1200 
with firmware version 4.0 or higher.

PID_3Step V2.0
● Reaction to error

The reaction to ActivateRecoverMode = TRUE has been completely overhauled. 
PID_3Step reacts in a more fault tolerant manner in the default setting.

 

 
 NOTICE

Your system may be damaged.

If you use the default setting, PID_3Step remains in automatic mode even if the process 
value limits are exceeded. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to 
protect your system from damage. 

 

You use the ErrorAck input parameter to acknowledge the errors and warnings without 
restarting the controller or clearing the integral action.
Switching operating modes does not acknowledge errors that are no longer pending.

● Switching the operating mode
You specify the operating mode at the Mode in/out parameter and use a rising edge at 
ModeActivate to start the operating mode. The Retain.Mode tag has been omitted. 
The transition time measurement can no longer be started with GetTransitTime.Start, but 
only with Mode = 6 and a rising edge at ModeActivate.

● Multi-instance capability
You can call up PID_3Step as multi-instance DB. No technology object is created in this 
case and no parameter assignment interface or commissioning interface is available. You 
must assign parameters for PID_3Step directly in the multi-instance DB and commission it 
via a watch table.

● Startup characteristics
The operating mode specified at the Mode parameter is also started on a falling edge at 
Reset and during a CPU cold restart, if RunModeByStartup = TRUE.

● ENO characteristics
ENO is set depending on the operating mode.
If State = 0, then ENO = FALSE.
If State ≠ 0, then ENO = TRUE. 
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● Manual mode
The Manual_UP and Manual_DN input parameters no longer function as edge-triggered 
parameters. Edge-triggered manual mode continues to be possible using the 
ManualUpInternal and ManualDnInternal tags.
In "Manual mode without endstop signals" (Mode = 10), the endstop signals Actuator_H 
and Actuator_L are ignored even though they are activated.

● Default value of PID parameters
The following default settings have been changed:

– Proportional action weighting (PWeighting) from 0.0 to 1.0

– Derivative action weighting (DWeighting) from 0.0 to 1.0

– Coefficient for derivative delay (TdFiltRatio) from 0.0 to 0.2

● Limiting of motor transition time
You configure the maximum percentage of the motor transition time that the actuator will 
travel in one direction in the Config.VirtualActuatorLimit tag.

● Setpoint value specification during tuning
You configure the permitted fluctuation of the setpoint during tuning at the 
CancelTuningLevel tag.

● Switching a disturbance variable on
You can switch a disturbance variable on at the Disturbance parameter.

● Troubleshooting
If the endstop signals are not activated (ActuatorEndStopOn = FALSE), ScaledFeedback 
is determined without Actuator_H or Actuator_L. 

PID_3Step V1.1
● Manual mode on CPU startup

If ManualEnable = TRUE when the CPU starts, PID_3Step starts in manual mode. A rising 
edge at ManualEnable is not necessary. 

● Reaction to error
The ActivateRecoverMode tag is no longer effective in manual mode.

● Troubleshooting
The Progress tag is reset following successful tuning or transition time measurement.

Compatibility with CPU and FW 
The following table shows which version of PID_3Step can be used on which CPU.

CPU FW PID_3Step
S7-1200 V4.X V2.1

V1.1
S7-1200 V3.X V1.1

V1.0
S7-1200 V2.X V1.1

V1.0
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CPU FW PID_3Step
S7-1200 V1.X -
S7-1500 V1.1 V2.1

V2.0
S7-1500 V1.0 V2.0

PID_3Step V2

Description of PID_3Step V2

Description   
You use the PID_3Step instruction to configure a PID controller with self tuning for valves or 
actuators with integrating behavior. 

The following operating modes are possible:

● Inactive

● Pretuning

● Fine tuning

● Automatic mode

● Manual mode

● Approach substitute output value

● Transition time measurement

● Error monitoring

● Approach substitute output value with error monitoring

● Manual mode without endstop signals

For a more detailed description of the operating modes, see the State parameter.
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PID algorithm
PID_3Step is a PIDT1 controller with anti-windup and weighting of the proportional and 
derivative actions. The PID algorithm operates according to the following equation:

Δ y  =  K
p 
 · s  ·  (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
Δy Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
TD Derivative action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
c Derivative action weighting
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Block diagram without position feedback
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Block diagram with position feedback

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2640 System Manual, 07/2013,  



Block diagram of PIDT1 with anti-windup

Call
PID_3Step is called in the constant time scale of a cycle interrupt OB.

If you call PID_3Step as a multi-instance DB, no technology object is created. No parameter 
assignment interface or commissioning interface is available. You must assign parameters for 
PID_3Step directly in the multi-instance DB and commission it via a watch table.

Download to device
The actual values of retentive tags are only updated when you download PID_3Step 
completely.

Downloading technology objects to device (Page 5937)

Startup
When the CPU starts up, PID_3Step starts in the operating mode that is saved in the Mode in/
out parameter. To leave PID_3Step in "Inactive" mode, set RunModeByStartup = FALSE.

Reaction to error
In automatic mode and during commissioning, the reaction to error depends on the 
ErrorBehaviour and ActivateRecoverMode tags. In manual mode, the reaction is independent 
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of ErrorBehaviour and ActivateRecoverMode. If ActivateRecoverMode = TRUE, the reaction 
additionally depends on the error that occurred.

ErrorBeha
viour

ActivateRecov
erMode

Configuration editor 
> actuator setting
> Set Output to

Reaction

FALSE FALSE Current output value Switch to "Inactive" mode (State = 0)
The actuator remains in the current 
position. 

FALSE TRUE Current output value while 
error is pending

Switch to "Error monitoring" mode 
(State = 7)
The actuator remains in the current 
position while the error is pending.

TRUE FALSE Substitute output value Switch to "Approach substitute output 
value" mode (State = 5)
The actuator moves to the configured 
substitute output value.
Switch to "Inactive" mode (State = 0)
The actuator remains in the current 
position. 

TRUE TRUE Substitute output value while 
error is pending

Switch to "Approach substitute output 
value with error monitoring" mode 
(State = 8)
The actuator moves to the configured 
substitute output value.
Switch to "Error monitoring" mode 
(State = 7)

In manual mode, PID_3Step uses ManualValue as output value, unless the following errors 
occur:

● 2000h: Invalid value at Feedback_PER parameter.

● 4000h: Invalid value at Feedback parameter.

● 8000h: Error during digital position feedback.

You can only change the position of the actuator with Manual_UP and Manual_DN, not with 
ManualValue.

The Error parameter indicates whether an error has occurred in this cycle. The ErrorBits 
parameter shows which errors have occurred. ErrorBits is reset by a rising edge at Reset or 
ErrorAck.

See also
Parameters State and Mode V2 (Page 2658)

Parameter ErrorBits V2 (Page 2663)

Configuring PID_3Step V2 (Page 5975)
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Mode of operation of PID_3Step V2

Monitoring process value limits
You specify the high limit and low limit of the process value in the Config.InputUpperLimit and 
Config.InputLowerLimit variables. If the process value is outside these limits, an error occurs 
(ErrorBits = 0001h).

You specify a high and low warning limit of the process value in the Config.InputUpperWarning 
and Config.InputLowerWarning variables. If the process value is outside these warning limits, 
a warning occurs (Warning = 0040h), and the InputWarning_H or InputWarning_L output 
parameter changes to TRUE. 

Limiting the setpoint 
You specify a high limit and low limit of the setpoint in the Config.SetpointUpperLimit and 
Config.SetpointLowerLimit variables. PID_3Step automatically limits the setpoint to the 
process value limits. You can limit the setpoint to a smaller range. PID_3Step checks whether 
this range falls within the process value limits. If the setpoint is outside these limits, the high 
or low limit is used as the setpoint, and output parameter SetpointLimit_H or SetpointLimit_L 
is set to TRUE.

The setpoint is limited in all operating modes.

Limiting the output value
You specify a high limit and low limit of the output value in the Config.OutputUpperLimit and 
Config.OutputLowerLimit variables. The output value limits must be within "Low endstop" and 
"High endstop".

● High endstop: Config.FeedbackScaling.UpperPointOut

● Low endstop: Config.FeedbackScaling.LowerPointOut

Rule:

UpperPointOut ≥ OutputUpperLimit > OutputLowerLimit ≥ LowerPointOut

The valid values for "High endstop" and "Low endstop" depend upon:

● FeedbackOn

● FeedbackPerOn

● OutputPerOn

OutputPerOn FeedbackOn FeedbackPerOn LowerPointOut UpperPointOut
FALSE FALSE FALSE Cannot be set (0.0%) Cannot be set (100.0%)
FALSE TRUE FALSE -100.0% or 0.0% 0.0% or +100.0%
FALSE TRUE TRUE -100.0% or 0.0% 0.0% or +100.0%
TRUE FALSE FALSE Cannot be set (0.0%) Cannot be set (100.0%)
TRUE TRUE FALSE -100.0% or 0.0% 0.0% or +100.0%
TRUE TRUE TRUE -100.0% or 0.0% 0.0% or +100.0%
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If OutputPerOn = FALSE  and FeedbackOn = FALSE, you cannot limit the output value. 
Output_UP and Output_DN are then reset at Actuator_H = TRUE or Actuator_L = TRUE. If 
endstop signals are also not present, Output_UP and Output_DN are reset after a travel time 
of Config.VirtualActuatorLimit × Retain.TransitTime/100.

The output value is 27648 at 100% and -27648 at -100%. PID_3Step must be able to close 
the valve completely.

Substitute output value
If an error has occurred, PID_3Step can output a substitute output value and move the actuator 
to a safe position that is specified in the SavePosition tag. The substitute output value must 
be within the output value limits.

Monitoring signal validity
The values of the following parameters are monitored for validity when used:

● Setpoint

● Input

● Input_PER

● Input_PER

● Feedback

● Feedback_PER

● Disturbance

● ManualValue

● SavePosition

● Output_PER

Monitoring the PID_3Step sampling time
Ideally, the sampling time is equivalent to the cycle time of the calling OB. The PID_3Step 
instruction measures the time interval between two calls. This is the current sampling time. On 
every switchover of operating mode and during the initial startup, the mean value is formed 
from the first 10 sampling times. Too great a difference between the current sampling time and 
this mean value triggers an error (ErrorBits = 0800h).

The error occurs during tuning if: 

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

The error occurs in automatic mode if: 

● New mean value >= 1.5 x old mean value

● New mean value <= 0.5 x old mean value
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If you deactivate the sampling time monitoring (CycleTime.EnMonitoring = FALSE), you can 
also call PID_3Step in OB1. You must then accept a lower control quality due to the deviating 
sampling time.

Sampling time of the PID algorithm 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_3Step are executed at every call.

Measuring the motor transition time
The motor transition time is the time in seconds the motor requires to move the actuator from 
the closed to the opened state. The actuator is moved in one direction for a maximum time of 
Config.VirtualActuatorLimit × Retain.TransitTime/100. PID_3Step requires the motor transition 
time to be as accurate as possible for good controller results. The data in the actuator 
documentation contains average values for this type of actuator. The value for the specific 
actuator used may differ. You can measure the motor transition time during commissioning. 
The output value limits are not taken into consideration during the motor transition time 
measurement. The actuator can travel to the high or the low endstop.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. For cooling and discharge control systems, it may 
be necessary to invert the control logic. PID_3Step does not work with negative proportional 
gain. If InvertControl = TRUE, an increasing control deviation causes a reduction in the output 
value. The control logic is also taken into account during pretuning and fine tuning. 

See also
Configuring PID_3Step V1 (Page 5991)

Changing the PID_3Step V2 interface
The following table shows what has changed in the PID_3Step instruction interface.

 

PID_3Step V1 PID_3Step V2 Change
Input_PER Input_PER Data type from Word to Int
Feedback_PER Feedback_PER Data type from Word to Int
 Disturbance New
Manual_UP Manual_UP Function
Manual_DN Manual_DN Function
 ErrorAck New
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PID_3Step V1 PID_3Step V2 Change
 ModeActivate New
Output_PER Output_PER Data type from Word to Int
 ManualUPInternal New
 ManualDNInternal New
 CancelTuningLevel New
 VirtualActuatorLImit New
Config.Loadbackup Loadbackup Renamed
Config.TransitTime Retain.TransitTime Renamed and retentivity added 
GetTransitTime.Start  Replaced by Mode and ModeActivate
SUT.CalculateSUTPara
ms

SUT.CalculateParams Renamed

SUT.TuneRuleSUT SUT.TuneRule Renamed
TIR.CalculateTIRParams TIR.CalculateParams Renamed
TIR.TuneRuleTIR TIR.TuneRule Renamed
Retain.Mode Mode Function

Declaration of static for in-out parameters

Input parameters of PID_3Step V2

Table 9-83    

Parameter Data type Default Description
Setpoint REAL 0.0 Setpoint of the PID controller in automatic mode
Input REAL 0.0 A tag of the user program is used as the source of the process 

value. 
If you are using the Input parameter, then 
Config.InputPerOn = FALSE must be set.

Input_PER INT 0 An analog input is used as the source of the process value.
If you are using the Input_PER parameter, then 
Config.InputPerOn = TRUE must be set.

Actuator_H BOOL FALSE Digital position feedback of the valve for the high endstop
If Actuator_H = TRUE, the valve is at the high endstop and is 
no longer moved towards this direction.

Actuator_L BOOL FALSE Digital position feedback of the valve for the low endstop 
If Actuator_L = TRUE, the valve is at the low endstop and is no 
longer moved towards this direction.

Feedback REAL 0.0 Position feedback of the valve
If you are using the Feedback parameter, then 
Config.FeedbackPerOn = FALSE must be set.
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Parameter Data type Default Description
Feedback_PER INT 0 Analog position feedback of a valve

If you are using the Feedback_PER parameter, then 
Config.FeedbackPerOn = TRUE must be set.
Feedback_PER is scaled based on the tags:
● Config.FeedbackScaling.LowerPointIn
● Config.FeedbackScaling.UpperPointIn
● Config.FeedbackScaling.LowerPointOut
● Config.FeedbackScaling.UpperPointOut

Disturbance REAL 0.0 Disturbance tag or precontrol value
ManualEnable BOOL FALSE ● A FALSE -> TRUE edge activates "manual mode", while 

State = 4, Mode remain unchanged.
As long as ManualEnable = TRUE, you cannot change the 
operating mode via a rising edge at ModeActivate or use 
the commissioning dialog.

● A TRUE -> FALSE edge activates the operating mode that 
is specified by Mode.

We recommend that you change the operating mode using 
ModeActivate only.

ManualValue REAL 0.0 In manual mode, the absolute position of the valve is specified. 
ManualValue is only evaluated if you are using Output_PER, 
or if position feedback is available.

Manual_UP BOOL FALSE ● Manual_UP = TRUE
The valve is opened even if you are using Output_PER or 
a position feedback. The valve is no longer moved if the 
high endstop has been reached. 
See also Config.VirtualActuatorLimit

● Manual_UP = FALSE
If you are using Output_PER or a position feedback, the 
valve is moved to ManualValue. Otherwise, the valve is no 
longer moved.

If Manual_UP and Manual_DN are set to TRUE simultaneously, 
the valve is not moved.

Manual_DN BOOL FALSE ● Manual_DN = TRUE
The valve is closed even if you are using Output_PER or a 
position feedback. The valve is no longer moved if the low 
endstop has been reached. 
See also Config.VirtualActuatorLimit

● Manual_DN = FALSE
If you are using Output_PER or a position feedback, the 
valve is moved to ManualValue. Otherwise, the valve is no 
longer moved.

ErrorAck BOOL FALSE ● FALSE -> TRUE edge
ErrorBits and Warning are reset.
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Parameter Data type Default Description
Reset BOOL FALSE Restarts the controller.

● FALSE -> TRUE edge
– Switch to "Inactive" mode
– ErrorBits and Warning are reset.
– Integral action is cleared

(PID parameters are retained)
● As long as Reset = TRUE, PID_3Step remains in "Inactive" 

mode (State = 0).
● TRUE -> FALSE edge

PID_3Step switches to the operating mode that is saved in 
the Mode parameter.

ModeActivate BOOL FALSE ● FALSE -> TRUE edge
PID_3Step switches to the operating mode that is saved in 
the Mode parameter.

Output parameters of PID_3Step V2

Table 9-84    

Parameter Data type Default Description
ScaledInput REAL 0.0 Scaled process value 
ScaledFeedback REAL 0.0 Scaled position feedback

For an actuator without position feedback, the position of the 
actuator indicated by ScaledFeedback is very imprecise. 
ScaledFeedback may only be used for rough estimation of the 
current position in this case.

Output_UP BOOL FALSE Digital output value for opening the valve
If Config.OutputPerOn = FALSE, the Output_UP parameter is 
used.

Output_DN BOOL FALSE Digital output value for closing the valve
If Config.OutputPerOn = FALSE, the Output_DN parameter is 
used.

Output_PER INT 0 Analog output value
If Config.OutputPerOn = TRUE, Output_PER is used.

SetpointLimit_H BOOL FALSE If SetpointLimit_H = TRUE, the absolute setpoint high limit is 
reached (Setpoint ≥ Config.SetpointUpperLimit).
The setpoint is limited to Config.SetpointUpperLimit .

SetpointLimit_L BOOL FALSE If SetpointLimit_L = TRUE, the absolute setpoint low limit has 
been reached (Setpoint ≤ Config.SetpointLowerLimit).
The setpoint is limited to Config.SetpointLowerLimit .

InputWarning_H BOOL FALSE If InputWarning_H = TRUE, the process value has reached or 
exceeded the warning high limit.

InputWarning_L BOOL FALSE If InputWarning_L = TRUE, the process value has reached or 
fallen below the warning low limit.
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Parameter Data type Default Description
State INT 0 The State parameter (Page 2658) shows the current operating 

mode of the PID controller. You can change the operating 
mode using the input parameter Mode and a rising edge at 
ModeActivate.
● State = 0: Inactive
● State = 1: Pretuning
● State = 2: Fine tuning
● State = 3: Automatic mode
● State = 4: Manual mode
● State = 5: Approach substitute output value
● State = 6: Transition time measurement
● State = 7: Error monitoring
● State = 8: Approach substitute output value with error 

monitoring
● State = 10: Manual mode without end stop signals

Error BOOL FALSE If Error = TRUE, at least one error message is pending in this 
cycle.

ErrorBits DWORD DW#16#0 The ErrorBits parameter (Page 2663) shows which error 
messages are pending. ErrorBits is retentive and is reset upon 
a rising edge at Reset or ErrorAck.

See also
Parameters State and Mode V2 (Page 2658)

Parameter ErrorBits V2 (Page 2663)
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In-out parameters of PID_3Step V2

Table 9-85    

Parameter Data type Default Description
Mode INT 4 At the Mode parameter, you specify the operating mode to 

which PID_3Step is to switch. Options are:
● Mode = 0: Inactive
● Mode = 1: Pretuning
● Mode = 2: Fine tuning
● Mode = 3: Automatic mode
● Mode = 4: Manual mode
● Mode = 6: Transition time measurement
● Mode = 10: Manual mode without endstop signals
The operating mode is activated by:
● Rising edge at ModeActivate
● Falling edge at Reset
● Falling edge at ManualEnable
● Cold restart of CPU if RunModeByStartup = TRUE
Mode is retentive.
A detailed description of the operating modes can be found in 
Parameters State and Mode V2 (Page 2658).

Static tags of PID_3Step V2
You must not change tags that are not listed. These are used for internal purposes only.

Tag Data type Default Description
ManualUpInternal BOOL FALSE In manual mode, each rising edge opens the valve by 5% of the total 

control range or for the duration of the minimum motor transition 
time. ManualUpInternal is only evaluated if you are not using 
Output_PER or position feedback. This tag is used in the 
commissioning dialog.

ManualDnInternal BOOL FALSE In manual mode, every rising edge closes the valve by 5% of the 
total control range or for the duration of the minimum motor transition 
time. ManualDnInternal is only evaluated if you are not using 
Output_PER or position feedback. This tag is used in the 
commissioning dialog.

ActivateRecoverMode BOOL TRUE The ActivateRecoverMode V2 (Page 2666) tag determines the 
reaction to error.

RunModeByStartup BOOL TRUE Activate operating mode at Mode parameter after CPU restart
If RunModeByStartup = TRUE, PID_3Step starts in the operating 
mode saved in the Mode parameter after CPU startup.
If RunModeByStartup = FALSE, PID_3Step remains in "Inactive" 
mode after CPU startup. 

LoadBackUp BOOL FALSE If LoadBackUp = TRUE, the last set of PID parameters is reloaded. 
The set was saved prior to the last tuning. LoadBackUp is 
automatically set back to FALSE.
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Tag Data type Default Description
PhysicalUnit INT 0 Unit of measurement of the process value and setpoint, e.g., ºC, or 

ºF.
PhysicalQuantity INT 0 Physical quantity of the process value and setpoint, e.g., 

temperature.
ErrorBehaviour BOOL FALSE If ErrorBehaviour = FALSE and an error has occurred, the valve 

stays at its current position and the controller switches directly to 
"Inactive" or "Error monitoring" mode.
If ErrorBehaviour = TRUE and an error occurs, the actuator moves 
to the substitute output value and only then switches to "Inactive" or 
"Error monitoring" mode.
If the following errors occur, you can no longer move the valve to a 
configured substitute output value.
● 2000h: Invalid value at Feedback_PER parameter.
● 4000h: Invalid value at Feedback parameter.
● 8000h: Error during digital position feedback.
● 20000h: Invalid value at SavePosition tag.

Warning DWORD DW#16#
0

The Warning tag (Page 2658) shows the warnings since Reset = 
TRUE or ErrorAck =TRUE. Warning is retentive.
Cyclic warnings (for example, process value warning) are shown 
until the cause of the warning is removed. They are automatically 
deleted once their cause has gone. Non-cyclic warnings (for 
example, point of inflection not found) remain and are deleted like 
errors.

SavePosition REAL 0.0 Substitute output value
If ErrorBehaviour = TRUE, the actuator is moved to a position that 
is safe for the plant when an error occurs. As soon as the substitute 
output value has been reached, PID_3Step switches the operating 
mode according to ActivateRecoverMode.

CurrentSetpoint REAL 0.0 Currently active setpoint. This value is frozen at the start of tuning.
CancelTuningLevel REAL 10.0 Permissible fluctuation of setpoint during tuning. Tuning is not 

canceled until:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel

Progress REAL 0.0 Progress of tuning as a percentage (0.0 - 100.0)
Config.InputPerOn BOOL TRUE If InputPerOn = TRUE, the Input_PER parameter is used. If 

InputPerOn = FALSE, the Input parameter is used.
Config.OutputPerOn BOOL FALSE If OutputPerOn = TRUE, the Output_PER parameter is used. If 

OutputPerOn = FALSE, the Ouput_UP and Output_DN parameters 
are used.

Config.InvertControl BOOL FALSE Invert control logic
If InvertControl = TRUE, an increasing control deviation causes a 
reduction in the output value.

Config.FeedbackOn BOOL FALSE If FeedbackOn = FALSE, a position feedback is simulated.
Position feedback is generally activated when 
FeedbackOn = TRUE. 

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2651



Tag Data type Default Description
Config.FeedbackPerOn BOOL FALSE FeedbackPerOn is only effective when FeedbackOn = TRUE.

If FeedbackPerOn = TRUE, the analog input is used for the position 
feedback (Feedback_PER parameter).
If FeedbackPerOn = FALSE, the Feedback parameter is used for 
the position feedback.

Config.ActuatorEndStopOn BOOL FALSE If ActuatorEndStopOn = TRUE, the digital position feedback 
Actuator_L  and Actuator_H  are taken into consideration.

Config.InputUpperLimit REAL 120.0 High limit of the process value
Input and Input_PER are monitored to ensure adherence to this limit.
At the I/O input, the process value can be a maximum of 18% higher 
than the standard range (overrange). An error is no longer signaled 
due to a violation of the "Process value high limit". Only a wire-break 
and a short-circuit are recognized and PID_3Step reacts according 
to the configured reaction to error.
InputUpperLimit > InputLowerLimit

Config.InputLowerLimit REAL 0.0 Low limit of the process value
InputLowerLimit < InputUpperLimit

Config.InputUpperWarning REAL +3.40282
2e+38

Warning high limit of the process value
If you set InputUpperWarning outside the process value limits, the 
configured absolute process value high limit is used as the warning 
high limit. 
If you configure InputUpperWarning within the process value limits, 
this value is used as the warning high limit.
InputUpperWarning > InputLowerWarning
InputUpperWarning ≤ InputUpperLimit

Config.InputLowerWarning REAL -3.40282
2e+38

Warning low limit of the process value
If you set InputLowerWarning outside the process value limits, the 
configured absolute process value low limit is used as the warning 
low limit. 
If you configure InputLowerWarning within the process value limits, 
this value is used as the warning low limit.
InputLowerWarning < InputUpperWarning
InputLowerWarning ≥ InputLowerLimit

Config.OutputUpperLimit REAL 100.0 High limit of output value
For details, see OutputLowerLimit

Config.OutputLowerLimit REAL 0.0 Low limit of output value
If OutputPerOn = TRUE or FeedbackOn = TRUE, the range of 
values from -100% to +100%, including zero, is valid. At -100%, 
Output = -27648; at +100%, Output = 27648
If OutputPerOn = FALSE, the range of values from 0% to 100% is 
valid. The valve is completely closed at 0% and completely opened 
at 100%.

Config.SetpointUpperLimit REAL +3.40282
2e+38

High limit of setpoint
If you set SetpointUpperLimit outside the process value limits, the 
configured absolute process value high limit is preassigned as the 
setpoint high limit. 
If you configure SetpointUpperLimit within the process value limits, 
this value is used as the setpoint high limit.
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Tag Data type Default Description
Config.SetpointLowerLimit REAL - 

3.402822
e+38

Low limit of the setpoint
If you set SetpointLowerLimit outside the process value limits, the 
configured absolute process value low limit is preassigned as the 
setpoint low limit.
If you set SetpointLowerLimit within the process value limits, this 
value is used as the setpoint low limit. 

Config.MinimumOnTime REAL 0.0 Minimum ON time
Minimum time in seconds for which the servo drive must be switched 
on.

Config.MinimumOffTime REAL 0.0 Minimum OFF time
Minimum time in seconds for which the servo drive must be switched 
off.

Config.VirtualActuatorLimit REAL 150.0 If all the following conditions have been satisfied, the actuator is 
moved in one direction for the maximum period of 
VirtualActuatorLimit × Retain.TransitTime/100 and the warning 
2000h is output:
● Config.OutputPerOn = FALSE
● Config.ActuatorEndStopOn = FALSE
● Config.FeedbackOn = FALSE 
If Config.OutputPerOn = FALSE and Config.ActuatorEndStopOn = 
TRUE or Config.FeedbackOn = TRUE, only the warning 2000h is 
output. 
If Config.OutputPerOn = TRUE, VirtualActuatorLimit is not taken 
into consideration.

Config.InputScaling.UpperPoi
ntIn

REAL 27648.0 Scaling Input_PER high
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.LowerPoi
ntIn

REAL 0.0 Scaling Input_PER low
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.UpperPoi
ntOut

REAL 100.0 Scaled high process value 
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.LowerPoi
ntOut

REAL 0.0 Scaled low process value
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.FeedbackScaling.Uppe
rPointIn

REAL 27648.0 Scaling Feedback_PER high
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Lowe
rPointIn

REAL 0.0 Scaling Feedback_PER low
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.
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Tag Data type Default Description
Config.FeedbackScaling.Uppe
rPointOut

REAL 100.0 High endstop
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Lowe
rPointOut

REAL 0.0 Low endstop
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

GetTransitTime.InvertDirectio
n

BOOL FALSE If InvertDirection = FALSE, the valve is fully opened, closed, and 
then reopened in order to determine the valve transition time.
If InvertDirection = TRUE, the valve is fully closed, opened, and then 
closed again.

GetTransitTime.SelectFeedba
ck

BOOL FALSE If SelectFeedback = TRUE, then Feedback_PER, or Feedback is 
taken into consideration in the transition time measurement.
If SelectFeedback = FALSE, then Actuator_H and Actuator_L are 
taken into consideration in the transition time measurement.

GetTransitTime.State INT 0 Current phase of the transition time measurement
● State = 0: Inactive
● State = 1: Open valve completely
● State = 2: Close valve completely
● State = 3: Move valve to target position (NewOutput)
● State = 4: Transition time measurement successfully completed
● State = 5: Transition time measurement canceled

GetTransitTime.NewOutput REAL 0.0 Target position for transition time measurement with position 
feedback
The target position must be between "High endstop" and "Low 
endstop". The difference between NewOutput and ScaledFeedback 
must be at least 50% of the permissible control range.

CycleTime.StartEstimation BOOL TRUE If StartEstimation = TRUE, the measurement of the PID_3Step 
sampling time is started. CycleTime.StartEstimation = FALSE once 
measurement is complete.

CycleTime.EnEstimation BOOL TRUE If EnEstimation = TRUE, the PID_3Step sampling time is calculated.
If CycleTime.EnEstimation = FALSE, the PID_3Step sampling time 
is not calculated and you need to correct the configuration of 
CycleTime.Value manually.

CycleTime.EnMonitoring BOOL TRUE If EnMonitoring = TRUE, the PID_3Step sampling time is monitored. 
If it is not possible to execute PID_3Step within the sampling time, 
the error 0800h is output and the operating mode is switched.  
ActivateRecoverMode and ErrorBehaviour determine which 
operating mode is switched to. 
If EnMonitoring = FALSE, the PID_3Step sampling time is not 
monitored, the error 0800h is not output, and the operating mode is 
not switched.

CycleTime.Value REAL 0.1 PID_3Step sampling time in seconds
CycleTime.Value is determined automatically and is usually 
equivalent to the cycle time of the calling OB.
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Tag Data type Default Description
CtrlParamsBackUp.SetByUser BOOL FALSE Saved value of Retain.CtrlParams.SetByUser.

You can reload values from the CtrlParamsBackUp structure with 
LoadBackUp = TRUE.

CtrlParamsBackUp.Gain REAL 1.0 Saved proportional gain
CtrlParamsBackUp.Ti REAL 20.0 Saved integral action time in seconds
CtrlParamsBackUp.Td REAL 0.0 Saved derivative action time in seconds
CtrlParamsBackUp.TdFiltRati
o

REAL 0.0 Saved derivative delay coefficient

CtrlParamsBackUp.PWeightin
g

REAL 0.0 Saved proportional action weighting

CtrlParamsBackUp.DWeightin
g

REAL 0.0 Saved derivative action weighting

CtrlParamsBackUp.Cycle REAL 1.0 Saved sampling time of PID algorithm in seconds
CtrlParamsBackUp.InputDead
Band

REAL 0.0 Saved deadband width of the control deviation

PIDSelfTune.SUT.CalculateP
arams

BOOL FALSE The properties of the controlled system are saved during tuning. If 
CalculateParams = TRUE, the PID parameters are recalculated on 
the basis of these properties. The PID parameters are calculated 
using the method set in TuneRule. CalculateParams is set to FALSE 
following calculation.

PIDSelfTune.SUT.TuneRule INT 1 Methods used to calculate parameters during pretuning:
● SUT.TuneRule = 0: PID rapid I
● SUT.TuneRule = 1: PID slow I
● SUT.TuneRule = 2: Chien, Hrones and Reswick PID
● SUT.TuneRule = 3: Chien, Hrones, Reswick PI
● SUT.TuneRule = 4: PID rapid II
● SUT.TuneRule = 5: PID slow II

PIDSelfTune.SUT.State INT 0 The SUT.State tag indicates the current phase of pretuning:
● State = 0: Initialize pretuning
● State = 50: Determine start position without position feedback
● State = 100: Calculate standard deviation
● State = 200: Determine point of inflection
● State = 300: Determine rise time
● State = 9900: Pretuning successful
● State = 1: Pretuning not successful
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Tag Data type Default Description
PIDSelfTune.TIR.RunIn BOOL FALSE With the RunIn tag, you can specify that fine tuning can also be 

performed without pretuning.
● RunIn = FALSE

Pretuning is started when fine tuning is started from inactive or 
manual mode. 
If fine tuning is started from automatic mode, the system uses 
the existing PID parameters to control to the setpoint. 
Only then will fine tuning start. If pretuning is not possible, 
PID_3Step switches to the mode from which tuning was started.

● RunIn = TRUE
The pretuning is skipped. PID_3Step attempts to reach the 
setpoint with the minimum or maximum output value. This can 
produce increased overshoot. Only then will fine tuning start.
RunIn is set to FALSE after fine tuning.

PIDSelfTune.TIR.CalculatePar
ams

BOOL FALSE The properties of the controlled system are saved during tuning. If 
CalculateParams = TRUE, the PID parameters are recalculated on 
the basis of these properties. The PID parameters are calculated 
using the method set in TuneRule. CalculateParams is set to FALSE 
following calculation.

PIDSelfTune.TIR.TuneRule INT 0 Methods used to calculate parameters during fine tuning:
● TIR.TuneRule = 0: PID automatic
● TIR.TuneRule = 1: PID rapid
● TIR.TuneRule = 2: PID slow
● TIR.TuneRule = 3: Ziegler-Nichols PID
● TIR.TuneRule = 4: Ziegler-Nichols PI
● TIR.TuneRule = 5: Ziegler-Nichols P

PIDSelfTune.TIR.State INT 0 The TIR.State tag indicates the current phase of fine tuning:
● State = -100 Fine tuning is not possible. Pretuning will be 

performed first.
● State = 0: Initialize fine tuning
● State = 200: Calculate standard deviation
● State = 300: Attempt to reach the setpoint with the maximum or 

minimum output value
● State = 400: Attempt to reach the setpoint with existing PID 

parameters
(if pretuning was successful)

● State = 500: Determine oscillation and calculate parameters
● State = 9900: Fine tuning successful
● State = 1: Fine tuning not successful

Retain.TransitTime REAL 30.0 Motor transition time in seconds
Time in seconds the actuating drive requires to move the valve from 
the closed to the opened state. 
TransitTime is retentive.
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Tag Data type Default Description
Retain.CtrlParams.SetByUser BOOL FALSE If SetByUser = FALSE, the PID parameters are determined 

automatically and PID_3Step operates with a deadband at the 
output value. The deadband width is calculated during tuning on the 
basis of the standard deviation of the output value and saved in 
Retain.CtrlParams.OutputDeadBand.
If SetByUser = TRUE, the PID parameters are entered manually 
and PID_3 Step operates without a deadband at the output value. 
Retain.CtrlParams.OutputDeadBand = 0.0
SetByUser is retentive.

Retain.CtrlParams.Gain REAL 1.0 Active proportional gain
To invert the control logic, use the Config.InvertControl tag. 
Negative values at Gain also invert the control logic. We recommend 
you use only InvertControl to set the control logic. The control logic 
is also inverted if InvertControl = TRUE and Gain < 0.0.
Gain is retentive.

Retain.CtrlParams.Ti REAL 20.0 ● Ti > 0.0: Active integral action time in seconds
● Ti = 0.0: Integral action is deactivated
Ti is retentive.

Retain.CtrlParams.Td REAL 0.0 ● Td > 0.0: Active derivative action time in seconds
● Td = 0.0: Derivative action is deactivated
Td is retentive.

Retain.CtrlParams.TdFiltRatio REAL 0.2 Active derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative 
action. 
Derivative delay = derivative action time × derivative delay 
coefficient
● 0.0: Derivative action is effective for one cycle only and therefore 

almost not effective.
● 0.5: This value has proved useful in practice for controlled 

systems with one dominant time constant.
● > 1.0: The greater the coefficient, the longer the effect of the 

derivative action is delayed.
TdFiltRatio is retentive.

Retain.CtrlParams.PWeighting REAL 1.0 Active proportional action weighting
The proportional action may weaken with changes to the setpoint.
Values from 0.0 to 1.0 are applicable.
● 1.0: Proportional action for setpoint change is fully effective
● 0.0: Proportional action for setpoint change is not effective
The proportional action is always fully effective when the process 
value is changed.
PWeighting is retentive.
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Tag Data type Default Description
Retain.CtrlParams.DWeightin
g

REAL 1.0 Active derivative action weighting
The derivative action may weaken with changes to the setpoint.
Values from 0.0 to 1.0 are applicable.
● 1.0: Derivative action is fully effective upon setpoint change
● 0.0: Derivative action is not effective upon setpoint change
The derivative action is always fully effective when the process value 
is changed. 
DWeighting is retentive.

Retain.CtrlParams.Cycle REAL 1.0 Active sampling time of PID algorithm in seconds, rounded to an 
integer multiple of the cycle time of the calling OB.
Cycle is retentive.

Retain.CtrlParams.InputDead
Band

REAL 0.0 Deadband width of the control deviation
InputDeadBand is retentive.

 
 

 Note

Change the tags listed in this table in "Inactive" mode to prevent malfunction of the PID 
controller.

 

See also
Parameters State and Mode V2 (Page 2658)

Tag ActivateRecoverMode V2 (Page 2666)

Downloading technology objects to device (Page 5937)

Parameters State and Mode V2

Correlation of the parameters
The State parameter shows the current operating mode of the PID controller. You cannot 
change the State parameter. 

With a rising edge at ModeActivate, PID_3Step switches to the operating mode saved in the 
Mode in-out parameter.

When the CPU is switched on or switches from Stop to RUN mode, PID_3Step starts in the 
operating mode that is saved in the Mode parameter. To leave PID_3Step in "Inactive" mode, 
set RunModeByStartup = FALSE.
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Meaning of values

State Description of operating mode
0 Inactive

The controller is switched off and no longer changes the valve position.
1 Pretuning

The pretuning determines the process response to a pulse of the output value and searches for the point of 
inflection. The PID parameters are calculated from the maximum rate of rise and dead time of the controlled 
system. You obtain the best PID parameters when you perform pretuning and fine tuning.
Pretuning requirements:
● The motor transition time has been configured or measured.
● Inactive (State = 0), manual mode (State = 4), or automatic mode (State = 3)
● ManualEnable = FALSE
● Reset = FALSE
● The setpoint and the process value lie within the configured limits.
The more stable the process value is, the easier it is to calculate the PID parameters and the more precise 
the result will be. Noise on the process value can be tolerated as long as the rate of rise of the process value 
is significantly higher as compared to the noise. This is most likely the case in operating modes "Inactive" 
and "manual mode".
The setpoint is frozen in the CurrentSetpoint tag. Tuning is canceled when:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel
Before the PID parameters are recalculated, they are backed up and can be reactivated with LoadBackUp. 
The controller switches to automatic mode following successful pretuning. If pretuning is unsuccessful, the 
switchover of operating mode is dependent on ActivateRecoverMode and ErrorBehaviour.
The pretuning phase is indicated with the SUT.State tag.
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State Description of operating mode
2 Fine tuning

Fine tuning generates a constant, limited oscillation of the process value. The PID parameters are recalculated 
based on the amplitude and frequency of this oscillation. PID parameters from fine tuning usually have better 
master control and disturbance characteristics than PID parameters from pretuning. You obtain the best PID 
parameters when you perform pretuning and fine tuning.
PID_3Step automatically attempts to generate an oscillation greater than the noise of the process value. Fine 
tuning is only minimally influenced by the stability of the process value. 
The setpoint is frozen in the CurrentSetpoint tag. Tuning is canceled when:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel
The PID parameters are backed up before fine tuning. They can be reactivated with LoadBackUp. 
Requirements for fine tuning:
● The motor transition time has been configured or measured.
● The setpoint and the process value lie within the configured limits.
● ManualEnable = FALSE
● Reset = FALSE
● Automatic (State = 3), inactive (State = 0) or manual (State = 4) mode
Fine tuning proceeds as follows when started from:
● Automatic mode (State = 3)

Start fine tuning from automatic mode if you wish to improve the existing PID parameters through tuning.
PID_3Step controls the system using the existing PID parameters until the control loop has stabilized and 
the requirements for fine tuning have been met. Only then will fine tuning start.

● Inactive (State = 0) or manual mode (State = 4)
If the requirements for pretuning are met, pretuning is started. The determined PID parameters will be 
used for control until the control loop has stabilized and the requirements for fine tuning have been met.
If PIDSelfTune.TIR.RunIn = TRUE, pretuning is skipped and an attempt is made to reach the setpoint with 
the minimum or maximum output value. This can produce increased overshoot. Fine tuning then starts 
automatically.

The controller switches to automatic mode following successful fine tuning. If fine tuning is unsuccessful, the 
switchover of operating mode is dependent on ActivateRecoverMode and ErrorBehaviour.
The fine tuning phase is indicated with the TIR.State tag.

3 Automatic mode
In automatic mode, PID_3Step controls the controlled system in accordance with the parameters specified.
The controller switches to automatic mode if one the following requirements is fulfilled:
● Pretuning successfully completed
● Fine tuning successfully completed
● Changing of the Mode in-out parameter to the value 3 and a rising edge at ModeActivate.
The switchover from automatic mode to manual mode is only bumpless if carried out in the commissioning 
editor.
The ActivateRecoverMode tag is taken into consideration in automatic mode.
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State Description of operating mode
4 Manual mode

In manual mode, you specify manual output values in the Manual_UP and Manual_DN parameters or 
ManualValue parameter. Whether or not the actuator can be moved to the output value in the event of an 
error is described in the ErrorBits parameter.
You can also activate this operating mode using ManualEnable = TRUE. We recommend that you change 
the operating mode using Mode and ModeActivate only.
The switchover from manual mode to automatic mode is bumpless. Manual mode is also possible when an 
error is pending.

5 Approach substitute output value
This operating mode is activated in the event of an error, if Errorbehaviour = TRUE and ActivateRecoverMode 
= FALSE..
PID_3Step moves the actuator to the substitute output value and then switches to "Inactive" mode.

6 Transition time measurement
The time that the motor needs to completely open the valve from the closed condition is determined.
This operating mode is activated when Mode = 6 and ModeActivate = TRUE is set.
If endstop signals are used to measure the transition time, the valve will be opened completely from its current 
position, closed completely, and opened completely again. If GetTransitTime.InvertDirection = TRUE, this 
behavior is inverted.
If position feedback is used to measure the transition time, the actuator will be moved from its current position 
to a target position.
The output value limits are not taken into consideration during the transition time measurement. The actuator 
can travel to the high or the low endstop.

7 Error monitoring
The control algorithm is switched off and no longer changes the valve position.
This operating mode is activated instead of "Inactive" mode in the event of an error. 
All the following conditions must be met:
● Automatic mode (Mode = 3)
● Errorbehaviour = FALSE
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode (Page 2666) is effective.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode. 

8 Approach substitute output value with error monitoring
This operating mode is activated instead of "approach substitute output value" mode when an error occurs. 
PID_3Step moves the actuator to the substitute output value and then switches to "error monitoring" mode.
All the following conditions must be met:
● Automatic mode (Mode = 3)
● Errorbehaviour = TRUE
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode (Page 2666) is effective.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.

10 Manual mode without endstop signals
The endstop signals are not taken into consideration, even though Config.ActuatorEndStopOn = TRUE. The 
output value limits are not taken into consideration. Otherwise, PID_3Step behaves the same as in manual 
mode.
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ENO characteristics
If State = 0, then ENO = FALSE.

If State ≠ 0, then ENO = TRUE. 

Automatic switchover of operating mode during commissioning
Automatic mode is activated following successful pretuning or fine tuning. The following table 
shows how Mode and State change during successful pretuning.

Cycle no. Mode State Action
0 4 4 Set Mode = 1
1 1 4 Set ModeActivate = TRUE
1 4 1 Value of State is saved in Mode parameter

Pretuning is started
n 4 1 Pretuning successfully completed
n 3 3 Automatic mode is started

PID_3Step automatically switches the operating mode in the event of an error. The following 
table shows how Mode and State change during pretuning with errors. 

Cycle no. Mode State Action
0 4 4 Set Mode = 1
1 1 4 Set ModeActivate = TRUE
1 4 1 Value of State is saved in Mode parameter

Pretuning is started
n 4 1 Pretuning canceled
n 4 4 Manual mode is started

If ActivateRecoverMode = TRUE, the operating mode that is saved in the Mode parameter is 
activated. At the start of transition time measurement, pretuning, or fine tuning, PID_3Step 
saved the value of State in the Mode in/out parameter. PID_3Step therefore switches to the 
operating mode from which transition time measurement or tuning was started.

If ActivateRecoverMode = FALSE, "Inactive" or "Approach substitute output value" mode is 
activated.

Automatic switchover of operating mode after transition time measurement
If ActivateRecoverMode = TRUE, the operating mode that is saved in the Mode parameter is 
activated after successful transition time measurement. 

If ActivateRecoverMode = FALSE, the system switches to "Inactive" operating mode after 
successful transition time measurement.
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Automatic switchover of operating mode in automatic mode
PID_3Step automatically switches the operating mode in the event of an error. The following 
diagram illustrates the influence of ErrorBehaviour and ActivateRecoverMode on this 
switchover of operating mode.

Automatic switchover of operating mode in the event of an error

Automatic switchover of operating mode once the current operation has been completed.

Automatic switchover of operating mode when error is no longer pending.

 

See also
Tag ActivateRecoverMode V2 (Page 2666)

Parameter ErrorBits V2 (Page 2663)

Parameter ErrorBits V2
If several errors are pending simultaneously, the values of the ErrorBits are displayed with 
binary addition. The display of ErrorBits = 0003h, for example, indicates that the errors 0001h 
and 0002h are pending simultaneously.

If there is a position feedback, PID_3Step uses ManualValue as output value in manual mode. 
The exception is Errorbits = 10000h.
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ErrorBits
 (DW#16#...)

Description

0000 There is no error.
0001 The "Input" parameter is outside the process value limits.

● Input > Config.InputUpperLimit or
● Input < Config.InputLowerLimit
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
remains in automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

0002 Invalid value at "Input_PER" parameter. Check whether an error is pending at the analog input.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
switches to "Approach substitute output value with error monitoring" or "Error monitoring" mode. As soon 
as the error is no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

0004 Error during fine tuning. Oscillation of the process value could not be maintained.
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0010 The setpoint was changed during tuning.
You can set the permitted fluctuation of the setpoint at the CancelTuningLevel tag. 
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0020 Pretuning is not permitted during fine tuning.
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step remains in fine tuning mode.

0080 Error during pretuning. Incorrect configuration of output value limits.
Check whether the limits of the output value are configured correctly and match the control logic.
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0100 Error during fine tuning resulted in invalid parameters.
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0200 Invalid value at "Input" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
switches to "Approach substitute output value with error monitoring" or "Error monitoring" mode. As soon 
as the error is no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

0400 Calculation of output value failed. Check the PID parameters.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
switches to "Approach substitute output value with error monitoring" or "Error monitoring" mode. As soon 
as the error is no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.
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ErrorBits
 (DW#16#...)

Description

0800 Sampling time error: PID_3Step is not called within the sampling time of the cyclic interrupt OB.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
remains in automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

1000 Invalid value at "Setpoint" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
switches to "Approach substitute output value with error monitoring" or "Error monitoring" mode. As soon 
as the error is no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

2000 Invalid value at Feedback_PER parameter. 
Check whether an error is pending at the analog input. 
The actuator cannot be moved to the substitute output value and remains in its current position. In manual 
mode, you can change the position of the actuator only with Manual_UP and Manual_DN, and not with 
ManualValue.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode. 
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

4000 Invalid value at Feedback parameter. Value has an invalid number format. 
The actuator cannot be moved to the substitute output value and remains in its current position. In manual 
mode, you can change the position of the actuator only with Manual_UP and Manual_DN, and not with 
ManualValue.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

8000 Error during digital position feedback. Actuator_H = TRUE and Actuator_L = TRUE. 
The actuator cannot be moved to the substitute output value and remains in its current position. Manual 
mode is not possible in this state.
In order to move the actuator from this state, you must deactivate the "Actuator endstop" 
(Config.ActuatorEndStopOn = FALSE) or switch to manual mode without endstop signals (Mode = 10).
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

10000 Invalid value at ManualValue parameter. Value has an invalid number format.
The actuator cannot be moved to the manual value and remains in its current position. 
Specify a valid value in ManualValue or move the actuator in manual mode with Manual_UP and 
Manual_DN.
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ErrorBits
 (DW#16#...)

Description

20000 Invalid value at SavePosition tag. Value has an invalid number format.
The actuator cannot be moved to the substitute output value and remains in its current position.

40000 Invalid value at Disturbance parameter. Value has an invalid number format.
If automatic mode was active and ActivateRecoverMode = TRUE before the error occurred, Disturbance 
is set to zero. PID_3Step remains in automatic mode.
If pretuning or fine tuning mode was active and ActivateRecoverMode = TRUE before the error occurred, 
PID_3Step switches to the operating mode saved in the Mode parameter. If Disturbance in the current 
phase has no effect on the output value, tuning is not be canceled.
The error has no effect during transition time measurement. 

Tag ActivateRecoverMode V2
The ActivateRecoverMode tag determines the reaction to error. The Error parameter indicates 
if an error is pending. When the error is no longer pending, Error = FALSE. The ErrorBits 
parameter shows which errors have occurred. 

 

 NOTICE

Your system may be damaged.

If ActivateRecoverMode = TRUE, PID_3Step remains in automatic mode even if the process 
limit values are exceeded. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to protect 
your system from damage. 
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Automatic mode

ActivateRecover
Mode

Description

FALSE In the event of an error, PID_3Step switches to "Inactive" or "Approach substitute output value" mode. 
The controller is only activated by a falling edge at Reset or a rising edge at ModeActivate.

TRUE If errors occur frequently in automatic mode, this setting has a negative effect on the control response, 
because PID_3Step switches between the calculated output value and the substitute output value at each 
error. In this case, check the ErrorBits parameter and eliminate the cause of the error.
If one or more of the following errors occur, PID_3Step stays in automatic mode:
● 0001h: The "Input" parameter is outside the process value limits.
● 0800h: Sampling time error
● 40000h: Invalid value at Disturbance parameter.
If one or more of the following errors occur, PID_3Step switches to "Approach substitute output value with 
error monitoring" or "Error monitoring" mode:
● 0002h: Invalid value at Input_PER parameter.
● 0200h: Invalid value at Input parameter.
● 0400h: Calculation of output value failed.
● 1000h: Invalid value at Setpoint parameter.
If one or more of the following errors occur, PID_3Step can no longer move the actuator:
● 2000h: Invalid value at Feedback_PER parameter.
● 4000h: Invalid value at Feedback parameter.
● 8000h: Error during digital position feedback.
● 20000h: Invalid value at SavePosition tag. Value has an invalid number format.
The characteristics are independent of ErrorBehaviour. 
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.

Pretuning, fine tuning, and transition time measurement

ActivateRecover
Mode

Description

FALSE In the event of an error, PID_3Step switches to "Inactive" or "Approach substitute output value" mode. 
The controller is only activated by a falling edge at Reset or a rising edge at ModeActivate. 
The controller changes to "Inactive" mode after successful transition time measurement.

TRUE If the following error occurs, PID_3Step remains in the active mode:
● 0020h: Pretuning is not permitted during fine tuning.
The following errors are ignored:
● 10000h: Invalid value at ManualValue parameter.
● 20000h: Invalid value at SavePosition tag.
When any other error occurs, PID_3Step cancels the tuning and switches to the mode from which tuning 
was started.

Manual mode
ActivateRecoverMode is not effective in manual mode.
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See also
Static tags of PID_3Step V2 (Page 2650)

Parameters State and Mode V2 (Page 2658)

Tag Warning V2
If several warnings are pending simultaneously, their values are displayed with binary addition. 
The display of warning 0005h, for example, indicates that the warnings 0001h and 0004h are 
pending simultaneously.

Warning
 (DW#16#...)

Description

0000 No warning pending.
0001 The point of inflection was not found during pretuning.
0004 The setpoint was limited to the configured limits. 
0008 Not all the necessary controlled system properties were defined for the selected method of calculation. 

Instead, the PID parameters were calculated using the TIR.TuneRule = 3 method.
0010 The operating mode could not be changed because Reset = TRUE or ManualEnable = TRUE.
0020 The cycle time of the calling OB limits the sampling time of the PID algorithm. 

Improve results by using shorter OB cycle times.
0040 The process value exceeded one of its warning limits.
0080 Invalid value at Mode. The operating mode is not switched.
0100 The manual value was limited to the limits of the controller output.
0200 The specified rule for tuning is not supported. No PID parameters are calculated.
0400 The transition time cannot be measured because the actuator settings do not match the selected 

measuring method. 
0800 The difference between the current position and the new output value is too small for transition time 

measurement. This can produce incorrect results. The difference between the current output value and 
new output value must be at least 50% of the entire control range.

1000 The substitute output value cannot be reached because it is outside the output value limits.
2000 The actuator was moved in one direction for longer than Config.VirtualActuatorLimit × Retain.TransitTime. 

Check whether the actuator has reached an endstop signal.

The following warnings are deleted as soon as the cause is eliminated:

● 0001h

● 0004h

● 0008h

● 0040h

● 0100h

All other warnings are cleared with a rising edge at Reset or ErrorAck.
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PID_3Step V1

Description of PID_3Step

Description   
You use the PID_3Step instruction to configure a PID controller with self tuning for valves or 
actuators with integrating behavior. 

The following operating modes are possible:

● Inactive

● Pretuning

● Fine tuning

● Automatic mode

● Manual mode

● Approach substitute output value

● Transition time measurement

● Approach substitute output value with error monitoring

● Error monitoring

For a more detailed description of the operating modes, see the State parameter.
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PID algorithm
PID_3Step is a PIDT1 controller with anti-windup and weighting of the proportional and 
derivative actions. The following equation is used to calculate the output value.

Δ y  =  K
p 
 · s  ·  (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
a Derivative delay coefficient (T1 = a × TD)
TD Derivative action time
c Derivative action weighting
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Block diagram without position feedback
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Block diagram with position feedback
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Block diagram of PIDT1 with anti-windup

Call
PID_3Step is called in a constant time interval of the cycle time of the calling OB (preferably 
in a cyclic interrupt OB).

Download to device
The actual values of retentive tags are only updated when you download PID_3Step 
completely.

Downloading technology objects to device (Page 5937)

Startup
At the startup of the CPU, PID_3Step starts in the operating mode that was last active. To 
leave PID_3Step in "Inactive" mode, set RunModeByStartup = FALSE.

Reaction to error
If errors occur, these are output in the Error parameter. You configure the reaction of PID_3Step 
using the ErrorBehaviour and ActivateRecoverMode tags. 

ErrorBeha
viour

ActivateRecov
erMode

Actuator setting configuration
Set Output to

Reaction

0 FALSE Current output value Switch to "Inactive" mode (Mode = 0)
0 TRUE Current output value while 

error is pending
Switch to "Error monitoring" mode 
(Mode = 7)
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ErrorBeha
viour

ActivateRecov
erMode

Actuator setting configuration
Set Output to

Reaction

1 FALSE Substitute output value Switch to "Approach substitute output 
value" mode (Mode = 5)
Switch to "Inactive" mode (Mode = 0)

1 TRUE Substitute output value while 
error is pending

Switch to "Approach substitute output 
value with error monitoring" mode 
(Mode = 8)
Switch to "Error monitoring" mode 
(Mode = 7)

The ErrorBits parameter shows which errors have occurred.

See also
State and Retain.Mode parameters (Page 2686)

ErrorBits parameter (Page 2693)

Configuring PID_3Step V1 (Page 5991)

Operating principle of PID_3Step

Monitoring process value limits
You specify the high limit and low limit of the process value in the Config.InputUpperLimit and 
Config.InputLowerLimit tags. If the process value is outside these limits, an error occurs 
(ErrorBits = 0001hex).

You specify a high and low warning limit of the process value in the Config.InputUpperWarning 
and Config.InputLowerWarning tags. If the process value is outside these warning limits, a 
warning occurs (Warnings = 0040hex), and the InputWarning_H or InputWarning_L output 
parameter changes to TRUE. 

Limiting the setpoint 
You specify a high limit and low limit of the setpoint in the Config.SetpointUpperLimit and 
Config.SetpointLowerLimit tags. PID_3Step automatically limits the setpoint to the process 
value limits. You can limit the setpoint to a smaller range. PID_3Step checks whether this range 
falls within the process value limits. If the setpoint is outside these limits, the high or low limit 
is used as the setpoint, and output parameter SetpointLimit_H or SetpointLimit_L is set to 
TRUE.

The setpoint is limited in all operating modes.
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Limiting the output value
You specify a high limit and low limit of the output value in the Config.OutputUpperLimit and 
Config.OutputLowerLimit tags. The output value limits must be within "Low endstop" and "High 
endstop".

● High endstop: Config.FeedbackScaling.UpperPointOut

● Low endstop: Config.FeedbackScaling.LowerPointOut

Rule:

UpperPointOut ≥ OutputUpperLimit > OutputLowerLimit ≥ LowerPointOut

The valid values for "High endstop" and "Low endstop" depend upon:

● FeedbackOn

● FeedbackPerOn

● OutputPerOn

OutputPerOn FeedbackOn FeedbackPerOn LowerPointOut UpperPointOut
FALSE FALSE FALSE Cannot be set (0.0%) Cannot be set (100.0%)
FALSE TRUE FALSE -100.0% or 0.0% 0.0% or +100.0%
FALSE TRUE TRUE -100.0% or 0.0% 0.0% or +100.0%
TRUE FALSE FALSE Cannot be set (100.0%) Cannot be set (100.0%)
TRUE TRUE FALSE -100.0% or 0.0% 0.0% or +100.0%
TRUE TRUE TRUE -100.0% or 0.0% 0.0% or +100.0%

If OutputPerOn = FALSE  and FeedbackOn = FALSE, you cannot limit the output value. The 
digital outputs are reset with Actuator_H = TRUE or Actuator_L = TRUE, or after a travel time 
amounting to 110% of the motor transition time.

The output value is 27648 at 100% and -27648 at -100%. PID_3Step must be able to close 
the valve completely. Therefore, zero must be included in the output value limits.

Substitute output value
If an error has occurred, PID_3Step can output a substitute output value and move the actuator 
to a safe position that is specified in the SavePosition tag. The substitute output value must 
be within the output value limits.

Monitoring signal validity
The values of the following parameters are monitored for validity:

● Setpoint

● Input

● Input_PER

● Feedback

● Feedback_PER

● Output 
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Monitoring the PID_3Step sampling time
Ideally, the sampling time is equivalent to the cycle time of the calling OB. The PID_3Step 
instruction measures the time interval between two calls. This is the current sampling time. On 
every switchover of operating mode and during the initial startup, the mean value is formed 
from the first 10 sampling times. Too great a difference between the current sampling time and 
this mean value triggers an error (ErrorBits = 0800 hex).

PID_3Step is set to "Inactive" mode during tuning under the following conditions:

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

In automatic mode, PID_3Step is set to "Inactive" mode under the following conditions:

● New mean value >= 1.5 x old mean value

● New mean value <= 0.5 x old mean value

Sampling time of the PID algorithm 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_3Step are executed at every call.

Measuring the motor transition time
The motor transition time is the time in seconds the motor requires to move the actuator from 
the closed to the opened state. The maximum time that the actuator is moved in one direction 
is 110% of the motor transition time. PID_3Step requires the motor transition time to be as 
accurate as possible for good controller results. The data in the actuator documentation 
contains average values for this type of actuator. The value for the specific actuator used may 
differ. You can measure the motor transition time during commissioning. The output value 
limits are not taken into consideration during the motor transition time measurement. The 
actuator can travel to the high or the low endstop.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. For cooling and discharge control systems, it may 
be necessary to invert the control logic. PID_3Step does not work with negative proportional 
gain. If InvertControl = TRUE, an increasing control deviation causes a reduction in the output 
value. The control logic is also taken into account during pretuning and fine tuning. 

See also
Configuring PID_3Step V1 (Page 5991)
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Input parameters of PID_3Step

Table 9-86    

Parameters Data type Default Description
Setpoint REAL 0.0 Setpoint of the PID controller in automatic mode
Input REAL 0.0 A variable of the user program is used as source for the process 

value. 
If you are using parameter Input, then 
Config.InputPerOn = FALSE must be set.

Input_PER WORD W#16#0 An analog input is used as source for the process value.
If you are using parameter Input_PER, then 
Config.InputPerOn = TRUE must be set.

Actuator_H BOOL FALSE Digital position feedback of the valve for the high endstop
If Actuator_H = TRUE, the valve is at the high endstop and is 
no longer moved towards this direction.

Actuator_L BOOL FALSE Digital position feedback of the valve for the low endstop 
If Actuator_L = TRUE, the valve is at the low endstop and is no 
longer moved towards this direction.

Feedback REAL 0.0 Position feedback of the valve
If you are using parameter Feedback, then 
Config.FeedbackPerOn = FALSE must be set.

Feedback_PER WORD W#16#0 Analog feedback of the valve position
If you are using parameter Feedback_PER, then 
Config.FeedbackPerOn = TRUE must be set.
Feedback_PER is scaled based on the variables:
● Config.FeedbackScaling.LowerPointIn
● Config.FeedbackScaling.UpperPointIn
● Config.FeedbackScaling.LowerPointOut
● Config.FeedbackScaling.UpperPointOut

ManualEnable BOOL FALSE ● A FALSE -> TRUE edge selects "Manual mode", while State 
= 4, Retain.Mode remains unchanged.

● A TRUE -> FALSE edge selects the most recently active 
operating mode

A change of Retain.Mode will not take effect during 
ManualEnable = TRUE. The change of Retain.Mode will only 
be considered upon a TRUE -> FALSE edge at ManualEnable .
PID_3Step V1.1If at start of the CPU ManualEnable = TRUE, 
PID_3Step starts in manual mode. A rising edge 
(FALSE > TRUE) at ManualEnable is not necessary.
PID_3Step V1.0
At the start of the CPU, PID_3Step only switches to manual 
mode with a rising edge (FALSE->TRUE) at ManualEnable . 
Without rising edge, PID_3Step starts in the last operating 
mode in which ManualEnable was FALSE.

ManualValue REAL 0.0 In manual mode, you specify the absolute position of the valve. 
ManualValue will only be evaluated if you are using OutputPer, 
or if position feedback is available.
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Parameters Data type Default Description
Manual_UP BOOL FALSE In manual mode, every rising edge opens the valve by 5% of 

the total control range, or for the duration of the minimum motor 
transition time. Manual_UP is evaluated only if you are not 
using Output_PER and there is no position feedback available.

Manual_DN BOOL FALSE In manual mode, every rising edge closes the valve by 5% of 
the total control range, or for the duration of the minimum motor 
transition time. Manual_DN is evaluated only if you are not 
using Output_PER and there is no position feedback available.

Reset BOOL FALSE Restarts the controller.
● FALSE -> TRUE edge

– Change to "Inactive" mode
– Intermediate controller values are reset

(PID parameters are retained)
● TRUE -> FALSE edge

Change in most recent active mode

Output parameters of PID_3Step

Table 9-87    

Parameter Data type Default Description
ScaledInput REAL 0.0 Scaled process value 
ScaledFeedback REAL 0.0 Scaled position feedback

For an actuator without position feedback, the position of the 
actuator indicated by ScaledFeedback is very imprecise. 
ScaledFeedback may only be used for rough estimation of the 
current position in this case.

Output_UP BOOL FALSE Digital output value for opening the valve
If Config.OutputPerOn = FALSE, the Output_UP parameter is 
used.

Output_DN BOOL FALSE Digital output value for closing the valve
If Config.OutputPerOn = FALSE, the Output_DN parameter is 
used.

Output_PER WORD W#16#0 Analog output value
If Config.OutputPerOn = TRUE, Output_PER is used.

SetpointLimit_H BOOL FALSE If SetpointLimit_H = TRUE, the absolute setpoint high limit is 
reached. In the CPU, the setpoint is limited to the configured 
absolute setpoint high limit. The configured absolute process 
value high limit is the default for the setpoint high limit.
If you configure Config.SetpointUpperLimit to a value within the 
process value limits, this value is used as the setpoint high limit.

SetpointLimit_L BOOL FALSE If SetpointLimit_L = TRUE, the absolute setpoint low limit has 
been reached. In the CPU, the setpoint is limited to the 
configured absolute setpoint low limit. The configured absolute 
process value low limit is the default setting for the setpoint low 
limit. 
If you configure Config.SetpointLowerLimit to a value within the 
process value limits, this value is used as the setpoint low limit.
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Parameter Data type Default Description
InputWarning_H BOOL FALSE If InputWarning_H = TRUE, the process value has reached or 

exceeded the warning high limit.
InputWarning_L BOOL FALSE If InputWarning_L = TRUE, the process value has reached or 

fallen below the warning low limit.
State INT 0 The State parameter (Page 2686) shows the current operating 

mode of the PID controller. You change the operating mode 
with the Retain.Mode tag. 
● State = 0: Inactive
● State = 1: Pretuning
● State = 2: Fine tuning
● State = 3: Automatic mode
● State = 4: Manual mode
● State = 5: Approach substitute output value
● State = 6: Transition time measurement
● State = 7: Error monitoring
● State = 8: Approach substitute output value with error 

monitoring
Error BOOL FALSE If Error = TRUE, at least one error message is pending.
ErrorBits DWORD DW#16#0 The ErrorBits parameter (Page 2693) indicates the error 

messages.

See also
State and Retain.Mode parameters (Page 2686)

ErrorBits parameter (Page 2693)

PID_3Step static variables
You must not change tags that are not listed. These are used for internal purposes only.

Table 9-88    

Tag Data type Default Description
ActivateRecoverMode BOOL TRUE The ActivateRecoverMode tag (Page 2694) determines the reaction 

to error.
RunModeByStartup BOOL TRUE Activate Mode after CPU restart

If RunModeByStartup = TRUE, the controller returns to the last 
active operating mode after a CPU restart.
If RunModeByStartup = FALSE, the controller remains inactive after 
a CPU restart. 

PhysicalUnit INT 0 Unit of measurement of the process value and setpoint, e.g., ºC, or 
ºF.

PhysicalQuantity INT 0 Physical quantity of the process value and setpoint, e.g., 
temperature.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2679



Tag Data type Default Description
ErrorBehaviour INT 0 If ErrorBehaviour = 0 and an error has occurred, the valve stays at 

its current position and the controller switches directly to "Inactive" 
or "Error monitoring" mode.
If ErrorBehaviour = 1 and an error occurs, the actuator moves to the 
substitute output value and only then switches to "Inactive" or "Error 
monitoring" mode.
If the following errors occur, you can no longer move the valve to a 
configured substitute output value.
● 2000h: Invalid value at Feedback_PER parameter.
● 4000h: Invalid value at Feedback parameter.
● 8000h: Error during digital position feedback.

Warning DWORD DW#16#
0

The Warning tag (Page 2686) displays the warnings generated 
since a Reset or since the last switchover of operating mode.
Cyclic warnings (for example, process value warning) are shown 
until the cause of the warning is removed. They are automatically 
deleted once their cause has gone. Non-cyclic warnings (for 
example, point of inflection not found) remain and are deleted like 
errors.

SavePosition REAL 0.0 Substitute output value
If ErrorBehaviour = 1 and an error occurs, the actuator moves to a 
safe position for the plant and only then switches to "Inactive" mode.

CurrentSetpoint REAL 0.0 Currently active setpoint. This value is frozen at the start of tuning.
Progress REAL 0.0 Progress of tuning as a percentage (0.0 - 100.0)
Config.InputPerOn BOOL TRUE If InputPerOn = TRUE, the Input_PER parameter is used. If 

InputPerOn = FALSE, the Input parameter is used.
Config.OutputPerOn BOOL FALSE If OutputPerOn = TRUE, the Output_PER parameter is used. If 

OutputPerOn = FALSE, the Ouput_UP and Output_DN parameters 
are used.

Config.LoadBackUp BOOL FALSE If LoadBackUp = TRUE, the last set of PID parameters is reloaded. 
This set was saved prior to the last tuning operation. LoadBackUp 
is automatically reset to FALSE.

Config.InvertControl BOOL FALSE Invert control logic
If InvertControl = TRUE, an increasing control deviation causes a 
reduction in the output value.

Config.FeedbackOn BOOL FALSE If FeedbackOn = FALSE, a position feedback is simulated.
Position feedback is generally activated when 
FeedbackOn = TRUE. 

Config.FeedbackPerOn BOOL FALSE FeedbackPerOn is only effective when FeedbackOn = TRUE.
If FeedbackPerOn = TRUE, the analog input is used for the position 
feedback (Feedback_PER parameter).
If FeedbackPerOn = FALSE, the Feedback parameter is used for 
the position feedback.

Config.ActuatorEndStopOn BOOL FALSE If ActuatorEndStopOn = TRUE, the digital position feedback 
Actuator_L  and Actuator_H  are taken into consideration.
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Tag Data type Default Description
Config.InputUpperLimit REAL 120.0 High limit of the process value

At the I/O input, the process value can be a maximum of 18% higher 
than the standard range (overrange). An error is no longer signaled 
due to a violation of the "Process value high limit". Only a wire-break 
and a short-circuit are recognized and PID_3Step reacts according 
to the configured reaction to error.
InputUpperLimit > InputLowerLimit

Config.InputLowerLimit REAL 0.0 Low limit of the process value
InputLowerLimit < InputUpperLimit

Config.InputUpperWarning REAL +3.40282
2e+38

Warning high limit of the process value
If you set InputUpperWarning outside the process value limits, the 
configured absolute process value high limit is used as the warning 
high limit. 
If you configure InputUpperWarning within the process value limits, 
this value is used as the warning high limit.
InputUpperWarning > InputLowerWarning
InputUpperWarning ≤ InputUpperLimit

Config.InputLowerWarning REAL -3.40282
2e+38

Warning low limit of the process value
If you set InputLowerWarning outside the process value limits, the 
configured absolute process value low limit is used as the warning 
low limit. 
If you configure InputLowerWarning within the process value limits, 
this value is used as the warning low limit.
InputLowerWarning < InputUpperWarning
InputLowerWarning ≥ InputLowerLimit

Config.OutputUpperLimit REAL 100.0 High limit of output value
For details, see OutputLowerLimit

Config.OutputLowerLimit REAL 0.0 Low limit of output value
If OutputPerOn = TRUE or FeedbackOn = TRUE, the range of 
values from -100% to +100%, including zero, is valid. At -100%, 
Output = -27648; at +100%, Output = 27648
If OutputPerOn = FALSE, the range of values from 0% to 100% is 
valid. The valve is completely closed at 0% and completely opened 
at 100%.

Config.SetpointUpperLimit REAL +3.40282
2e+38

High limit of setpoint
If you set SetpointUpperLimit outside the process value limits, the 
configured absolute process value high limit is preassigned as the 
setpoint high limit. 
If you configure SetpointUpperLimit within the process value limits, 
this value is used as the setpoint high limit.

Config.SetpointLowerLimit REAL - 
3.402822
e+38

Low limit of the setpoint
If you set SetpointLowerLimit outside the process value limits, the 
configured absolute process value low limit is preassigned as the 
setpoint low limit.
If you set SetpointLowerLimit within the process value limits, this 
value is used as the setpoint low limit. 
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Tag Data type Default Description
Config.MinimumOnTime REAL 0.0 Minimum ON time

Minimum time in seconds for which the servo drive must be switched 
on.

Config.MinimumOffTime REAL 0.0 Minimum OFF time
Minimum time in seconds for which the servo drive must be switched 
off.

Config.TransitTime REAL 30.0 Motor transition time
Time in seconds the actuating drive requires to move the valve from 
the closed to the opened state. 

Config.InputScaling.UpperPoi
ntIn

REAL 27648.0 Scaling Input_PER high
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.LowerPoi
ntIn

REAL 0.0 Scaling Input_PER low
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.UpperPoi
ntOut

REAL 100.0 Scaled high process value 
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.LowerPoi
ntOut

REAL 0.0 Scaled low process value
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.FeedbackScaling.Uppe
rPointIn

REAL 27648.0 Scaling Feedback_PER high
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Lowe
rPointIn

REAL 0.0 Scaling Feedback_PER low
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Uppe
rPointOut

REAL 100.0 High endstop
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Lowe
rPointOut

REAL 0.0 Low endstop
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

GetTransitTime.InvertDirectio
n

BOOL FALSE If InvertDirection = FALSE, the valve is fully opened, closed, and 
then reopened in order to determine the valve transition time.
If InvertDirection = TRUE, the valve is fully closed, opened, and then 
closed again.
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Tag Data type Default Description
GetTransitTime.SelectFeedba
ck

BOOL FALSE If SelectFeedback = TRUE, then Feedback_PER, or Feedback is 
taken into consideration in the transition time measurement.
If SelectFeedback = FALSE, then Actuator_H and Actuator_L are 
taken into consideration in the transition time measurement.

GetTransitTime.Start BOOL FALSE If Start = TRUE, the transition time measurement is started.
GetTransitTime.State INT 0 Current phase of the transition time measurement

● State = 0: Inactive
● State = 1: Open valve completely
● State = 2: Close valve completely
● State = 3: Move valve to target position (NewOutput)
● State = 4: Transition time measurement successfully completed
● State = 5: Transition time measurement canceled

GetTransitTime.NewOutput REAL 0.0 Target position for transition time measurement with position 
feedback
The target position must be between "High endstop" and "Low 
endstop". The difference between NewOutput and ScaledFeedback 
must be at least 50% of the permissible control range.

CycleTime.StartEstimation BOOL TRUE If StartEstimation = TRUE, the measurement of the PID_3Step 
sampling time is started. CycleTime.StartEstimation = FALSE once 
measurement is complete.

CycleTime.EnEstimation BOOL TRUE If EnEstimation = TRUE, the PID_3Step sampling time is calculated. 
CycleTime.EnMonitoring BOOL TRUE If EnMonitoring = TRUE, the PID_3Step sampling time is monitored. 

If it is not possible to execute PID_3Step within the sampling time, 
the error 0800h is output and the operating mode is switched.  
ActivateRecoverMode and ErrorBehaviour determine which 
operating mode is switched to. 
If EnMonitoring = FALSE, the PID_3Step sampling time is not 
monitored, the error 0800h is not output, and the operating mode is 
not switched.

CycleTime.Value REAL 0.1 PID_3Step sampling time in seconds
CycleTime.Value is determined automatically and is usually 
equivalent to the cycle time of the calling OB.

CtrlParamsBackUp.SetByUser BOOL FALSE Saved value of Retain.CtrlParams.SetByUser.
You can reload values from the CtrlParamsBackUp structure with 
Config.LoadBackUp = TRUE.

CtrlParamsBackUp.Gain REAL 1.0 Saved proportional gain
CtrlParamsBackUp.Ti REAL 20.0 Saved integral action time
CtrlParamsBackUp.Td REAL 0.0 Saved derivative action time
CtrlParamsBackUp.TdFiltRati
o

REAL 0.0 Saved derivative delay coefficient

CtrlParamsBackUp.PWeightin
g

REAL 0.0 Saved proportional action weighting

CtrlParamsBackUp.DWeightin
g

REAL 0.0 Saved derivative action weighting

CtrlParamsBackUp.Cycle REAL 1.0 Saved sampling time of PID algorithm
CtrlParamsBackUp.InputDead
Band

REAL 0.0 Saved dead band width of the control deviation
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Tag Data type Default Description
PIDSelfTune.SUT.CalculateS
UTParams

BOOL FALSE The properties of the controlled system are saved during tuning. If 
CalculateSUTParams = TRUE, the PID parameters are recalculated 
on the basis of these properties. The PID parameters are calculated 
using the method set in TuneRuleSUT. CalculateSUTParams is set 
to FALSE following calculation.

PIDSelfTune.SUT.TuneRuleS
UT

INT 1 Methods used to calculate parameters during pretuning:
● TuneRuleSUT = 0: PID rapid I
● TuneRuleSUT = 1: PID slow I
● TuneRuleSUT = 2: Chien, Hrones and Reswick PID
● TuneRuleSUT = 3TuneRuleSUT = 3: Chien, Hrones, Reswick 

PI  
● TuneRuleSUT = 4: PID rapid II
● TuneRuleSUT = 5: PID slow II

PIDSelfTune.SUT.State INT 0 The SUT.State tag indicates the current phase of pretuning:
PIDSelfTune.TIR.RunIn BOOL FALSE ● RunIn = FALSE

Pretuning is started when fine tuning is started from inactive or 
manual mode. 
If fine tuning is started from automatic mode, the system uses 
the existing PID parameters to control to the setpoint. 
Only then will fine tuning start. If pretuning is not possible, 
PID_3Step switches to "Inactive" mode.

● RunIn = TRUE
The pretuning is skipped. PID_3Step attempts to reach the 
setpoint with the minimum or maximum output value. This can 
produce increased overshoot. Only then will fine tuning start.
RunIn is set to FALSE after fine tuning.

PIDSelfTune.TIR.CalculateTI
RParams

BOOL FALSE The properties of the controlled system are saved during tuning. If 
CalculateTIRParams = TRUE, the PID parameters are recalculated 
on the basis of these properties. The PID parameters are calculated 
using the method set in TuneRuleTIR. CalculateTIRParams is set 
to FALSE following calculation.

PIDSelfTune.TIR.TuneRuleTI
R

INT 0 Methods used to calculate parameters during fine tuning:
● TuneRuleTIR = 0: PID automatic
● TuneRuleTIR = 1: PID rapid
● TuneRuleTIR = 2: PID slow
● TuneRuleTIR = 3: Ziegler-Nichols PID
● TuneRuleTIR = 4: Ziegler-Nichols PI
● TuneRuleTIR = 5: Ziegler-Nichols P

PIDSelfTune.TIR.State INT 0 The TIR.State tag indicates the current phase of "fine tuning":
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Tag Data type Default Description
Retain.Mode INT 0 A change to the value of Retain.Mode initiates a switch to another 

operating mode.
The following operating mode is enabled upon a change of Mode to:
● Mode = 0: Inactive
● Mode = 1: Pretuning
● Mode = 2: Fine tuning
● Mode = 3: Automatic mode
● Mode = 4: Manual mode
● Mode = 5: Approach substitute output value
● Mode = 6: Transition time measurement
● Mode = 7Mode = 7: Error monitoring  
● Mode = 8: Approach substitute output value with error monitoring
Mode is retentive.

Retain.CtrlParams.SetByUser BOOL FALSE If SetByUser = FALSE, the PID parameters are determined 
automatically and PID_3Step operates with a dead band at the 
output value. The dead band width is calculated during tuning on 
the basis of the standard deviation of the output value and saved in 
Retain.CtrlParams.OutputDeadBand.
If SetByUser = TRUE, the PID parameters are entered manually 
and PID_3 Step operates without a dead band at the output value. 
Retain.CtrlParams.OutputDeadBand = 0.0
SetByUser is retentive.

Retain.CtrlParams.Gain REAL 1.0 Active proportional gain
Gain is retentive.

Retain.CtrlParams.Ti REAL 20.0 ● Ti > 0.0: Active integral action time
● Ti = 0.0: Integral action is deactivated
Ti is retentive.

Retain.CtrlParams.Td REAL 0.0 ● Td > 0.0: Active derivative action time
● Td = 0.0: Derivative action is deactivated
Td is retentive.

Retain.CtrlParams.TdFiltRatio REAL 0.0 Active derivative delay coefficient
TdFiltRatio is retentive.

Retain.CtrlParams.PWeighting REAL 0.0 Active proportional action weighting
PWeighting is retentive.

Retain.CtrlParams.DWeightin
g

REAL 0.0 Active derivative action weighting 
DWeighting is retentive.

Retain.CtrlParams.Cycle REAL 1.0 Active sampling time of PID algorithm in seconds, rounded to an 
integer multiple of the cycle time of the calling OB.
Cycle is retentive.

Retain.CtrlParams.InputDead
Band

REAL 0.0 Dead band width of the control deviation
InputDeadBand is retentive.
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 Note

Change the tags listed in this table in "Inactive" mode to prevent malfunction of the PID 
controller. "Inactive" mode is forced by setting the "Retain.Mode" tag to "0".

 

See also
State and Retain.Mode parameters (Page 2686)

ActivateRecoverMode variable (Page 2694)

Downloading technology objects to device (Page 5937)

State and Retain.Mode parameters

Correlation of the parameters
The State parameter shows the current operating mode of the PID controller. You cannot 
change the State parameter. 

To switch from one operating mode to another, you must change the Retain.Mode tag. This 
also applies when the value for the new operating mode is already in Retain.Mode. For 
example, set Retain.Mode = 0 first and then Retain.Mode = 3. Provided the current operating 
mode of the controller permits this switchover, State will be set to the value of Retain.Mode.

When PID_3Step automatically switches from one operating mode to another, the following 
applies: State != Retain.Mode.

Examples:

● After successful pretuning
State = 3 and Retain.Mode = 1

● In the event of an error
State = 0 and Retain.Mode remain at the previous value, for example, Retain.Mode = 3

● ManualEnalbe = TRUE
State = 4 and Retain.Mode remain at the previous value, e.g., Retain.Mode = 3

 

  Note

You want, for example, to repeat successful fine tuning without exiting automatic mode 
with Mode = 0.

Setting Retain.Mode to an invalid value such as 9999 for one cycle has no effect on State. 
Set Mode = 2 in the next cycle. In this way, you can generate a change to Retain.Mode 
without first switching to "Inactive" mode.
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Meaning of values

State / 
Retain.Mode

Description

0 Inactive
The controller is switched off and no longer changes the valve position.

1 Pretuning
The pretuning determines the process response to a pulse of the output value and searches for the point of 
inflection. The optimized PID parameters are calculated as a function of the maximum rate of rise and dead 
time of the controlled system. 
Pretuning requirements:
● State = 0 or State = 4
● ManualEnable = FALSE
● The motor transition time has been configured or measured.
● The setpoint and the process value lie within the configured limits.
The more stable the process value is, the easier it is to calculate the PID parameters and the more precise 
the result will be. Noise on the process value can be tolerated as long as the rate of rise of the process value 
is significantly higher as compared to the noise.
Before the PID parameters are recalculated, they are backed up and can be reactivated with 
Config.LoadBackUp. The setpoint is frozen in the CurrentSetpoint tag.
The controller switches to automatic mode following successful pretuning and to "Inactive" mode following 
unsuccessful pretuning.
The pretuning phase is indicated with the SUT.State tag.
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State / 
Retain.Mode

Description

2 Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters are tuned 
based on the amplitude and frequency of this oscillation. The differences between the process response 
during pretuning and fine tuning are analyzed. All PID parameters are recalculated from the results. PID 
parameters from fine tuning usually have better master control and disturbance characteristics than PID 
parameters from pretuning.
PID_3Step automatically attempts to generate an oscillation greater than the noise of the process value. Fine 
tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before fine tuning. They can be reactivated with Config.LoadBackUp. 
The setpoint is frozen in the CurrentSetpoint tag.
Requirements for fine tuning:
● The motor transition time has been configured or measured.
● The setpoint and the process value lie within the configured limits.
● ManualEnable = FALSE
● Automatic (State = 3), inactive (State = 0) or manual (State = 4) mode
Fine tuning proceeds as follows when started from:
● Automatic mode (State = 3)

Start fine tuning from automatic mode if you wish to improve the existing PID parameters through tuning.
PID_3Step controls the system using the existing PID parameters until the control loop has stabilized and 
the requirements for fine tuning have been met. Only then will fine tuning start.

● Inactive (State = 0) or manual mode (State = 4)
Pretuning is always started first. The determined PID parameters will be used for control until the control 
loop has stabilized and the requirements for fine tuning have been met.
If PIDSelfTune.TIR.RunIn = TRUE, pretuning is skipped and an attempt is made to reach the setpoint with 
the minimum or maximum output value. This can produce increased overshoot. Fine tuning then starts 
automatically.

The controller switches to automatic mode following successful fine tuning. If fine tuning was not successful, 
the controller switches to "Inactive" mode. 
The fine tuning phase is indicated with the TIR.State tag.

3 Automatic mode
In automatic mode, PID_3Step controls the controlled system in accordance with the parameters specified.
The controller switches to automatic mode if one the following requirements is fulfilled:
● Pretuning successfully completed
● Fine tuning successfully completed
● Changing the Retain.Mode tag to the value 3.
When the CPU is switched on or switches from Stop to RUN mode, PID_3Step starts in the most recently 
active operating mode. To leave PID_3Step in "Inactive" mode, set RunModeByStartup = FALSE.
The ActivateRecoverMode tag is taken into consideration in automatic mode.
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State / 
Retain.Mode

Description

4 Manual mode
In manual mode, you specify manual output values in the Manual_UP and Manual_DN parameters or 
ManualValue parameter. Whether or not the actuator can be moved to the output value in the event of an 
error is described in the ErrorBits parameter.
This operating mode is enabled if Retain.Mode = 4, or on a rising edge at ManualEnable. 
If ManualEnable changes to TRUE, only State changes. Retain.Mode retains its current value. On a falling 
edge at ManualEnable, PID_3Step returns to the previous operating mode.
The switchover to automatic mode is bumpless.
PID_3Step V1.1
Manual mode is always possible in the event of an error.
PID_3Step V1.0
Manual mode is dependent on the ActivateRecoverMode tag in the event of an error.

5 Approach substitute output value
This operating mode is activated in the event of an error or when Reset = TRUE if Errorbehaviour = 1 and 
ActivateRecoverMode = FALSE..
PID_3Step moves the actuator to the substitute output value and then switches to "Inactive" mode.

6 Transition time measurement
The time that the motor needs to completely open the valve from the closed condition is determined.
This operating mode is activated when GetTransitTime.Start = TRUE is set.
If endstop signals are used to measure the transition time, the valve will be opened completely from its current 
position, closed completely, and opened completely again. If GetTransitTime.InvertDirection = TRUE, this 
behavior is inverted.
If position feedback is used to measure the transition time, the actuator will be moved from its current position 
to a target position. 
The output value limits are not taken into consideration during the transition time measurement. The actuator 
can travel to the high or the low endstop.

7 Error monitoring
The control algorithm is switched off and no longer changes the valve position.
This operating mode is activated instead of "Inactive" mode in the event of an error. 
All the following conditions must be met:
● Mode = 3 (automatic mode)
● Errorbehaviour = 0
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode (Page 2694) is effective.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode. 

8 Approach substitute output value with error monitoring
This operating mode is activated instead of "Approach substitute output value" mode in the event of an error. 
PID_3Step moves the actuator to the substitute output value and then switches to "Error monitoring" mode.
All the following conditions must be met:
● Mode = 3 (automatic mode)
● Errorbehaviour = 1
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode (Page 2694) is effective.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.
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Automatic switchover of operating mode during commissioning 
PID_3Step automatically switches the operating mode in the event of an error. The following 
diagram illustrates the influence of ErrorBehaviour on the switchover of operating mode from 
transition time measurement, pretuning, and fine tuning modes.

Automatic switchover of operating mode in the event of an error

Automatic switchover of operating mode once the current operation has been completed.
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Automatic switchover of operating mode in automatic mode (PID_3Step V1.1)
PID_3Step automatically switches the operating mode in the event of an error. The following 
diagram illustrates the influence of ErrorBehaviour and ActivateRecoverMode on this 
switchover of operating mode.

Automatic switchover of operating mode in the event of an error

Automatic switchover of operating mode once the current operation has been completed.
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Automatic switchover of operating mode in automatic and manual modes (PID_3Step V1.0)
PID_3Step automatically switches the operating mode in the event of an error. The following 
diagram illustrates the influence of ErrorBehaviour and ActivateRecoverMode on this 
switchover of operating mode.

Automatic switchover of operating mode in the event of an error

Automatic switchover of operating mode once the current operation has been completed.

Automatic switchover of operating mode when error is no longer pending.

 

See also
ActivateRecoverMode variable (Page 2694)

ErrorBits parameter (Page 2693)
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ErrorBits parameter
If several errors are pending simultaneously, the values of the error codes are displayed with 
binary addition. The display of error code 0003, for example, indicates that the errors 0001 
and 0002 are pending simultaneously.

ErrorBits

(DW#16#...)

Description

0000 There is no error.
0001 The "Input" parameter is outside the process value limits.

● Input > Config.InputUpperLimit or
● Input < Config.InputLowerLimit
If ActivateRecoverMode = TRUE and ErrorBehaviour = 1, the actuator moves to the substitute output 
value. If ActivateRecoverMode = TRUE and ErrorBehaviour = 0, the actuator stops in its current position. 
If ActivateRecoverMode = FALSE, the actuator stops in its current position. 
PID_3Step V1.1
You can move the actuator in manual mode.
PID_3Step V1.0
Manual mode is not possible in this state. You cannot move the actuator again until you eliminate the 
error.

0002 Invalid value at "Input_PER" parameter. Check whether an error is pending at the analog input.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

0004 Error during fine tuning. Oscillation of the process value could not be maintained.
0020 Pretuning is not permitted in automatic mode or during fine tuning.
0080 Error during pretuning. Incorrect configuration of output value limits.

Check whether the limits of the output value are configured correctly and match the control logic.
0100 Error during fine tuning resulted in invalid parameters.
0200 Invalid value at "Input" parameter: Value has an invalid number format.

If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

0400 Calculation of output value failed. Check the PID parameters.
0800 Sampling time error: PID_3Step is not called within the sampling time of the cyclic interrupt OB.

If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

1000 Invalid value at "Setpoint" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

2000 Invalid value at Feedback_PER parameter. 
Check whether an error is pending at the analog input. 
The actuator cannot be moved to the substitute output value and remains in its current position. Manual 
mode is not possible in this state. You must deactivate position feedback (Config. FeedbackOn = FALSE) 
to move the actuator from this state.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.
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ErrorBits

(DW#16#...)

Description

4000 Invalid value at Feedback parameter. Value has an invalid number format. 
The actuator cannot be moved to the substitute output value and remains in its current position. Manual 
mode is not possible in this state. You must deactivate position feedback (Config. FeedbackOn = FALSE) 
to move the actuator from this state.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

8000 Error during digital position feedback. Actuator_H = TRUE and Actuator_L = TRUE. 
The actuator cannot be moved to the substitute output value and remains in its current position. Manual 
mode is not possible in this state.
In order to move the actuator from this state, you must deactivate the "Actuator endstop" 
(Config.ActuatorEndStopOn = FALSE).
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

Reset parameter
A rising edge at Reset resets the errors and warnings and clears the integral action. A falling 
edge at Reset triggers a change to the most recently active operating mode.

① Activation
② Error
③ Reset

 

ActivateRecoverMode variable
The effect of the ActivateRecoverMode variable depends on the version of the PID_3Step.
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Behavior in version 1.1
The ActivateRecoverMode variable determines the behavior in the event of an error in 
automatic mode. ActivateRecoverMode is not effective during pretuning, fine tuning and 
transition time measurement.

ActivateRecover
Mode

Description

FALSE In the event of an error, PID_3Step switches to "Inactive" or "Approach substitute output value" operating 
mode. The controller is activated by a reset or a change in Retain.Mode.

TRUE If errors occur frequently in automatic mode, this setting has a negative effect on the control response. In 
this case, check the ErrorBits parameter and eliminate the cause of the error.
If one or more errors occur, PID_3Step switches to "Approach substitute output value with error 
monitoring" or "Error monitoring" mode:
● 0002h: Invalid value at parameter Input_PER.
● 0200h: Invalid value at parameter Input.
● 0800h: Sampling time error
● 1000h: Invalid value at parameter Setpoint.
● 2000h: Invalid value at parameter Feedback_PER.
● 4000h: Invalid value at parameter Feedback.
● 8000h: Error in digital position feedback.
With errors 2000h, 4000h and 8000h, PID_3Step cannot  approach the configured substitute output value.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.
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Behavior in version 1.0
The ActivateRecoverMode variable determines the behavior in the event of an error in 
automatic and manual mode. ActivateRecoverMode is not effective during pretuning, fine 
tuning and transition time measurement.

ActivateRecover
Mode

Description

FALSE In the event of an error, PID_3Step switches to "Inactive" or "Approach substitute output value" operating 
mode. The controller is activated by a reset or a change in Retain.Mode.

TRUE Errors in automatic mode
If errors occur frequently in automatic mode, this setting has a negative effect on the control response. In 
this case, check the ErrorBits parameter and eliminate the cause of the error.
If one or more errors occur, PID_3Step switches to "Approach substitute output value with error 
monitoring" or "Error monitoring" mode:
● 0002h: Invalid value at parameter Input_PER.
● 0200h: Invalid value at parameter Input.
● 0800h: Sampling time error
● 1000h: Invalid value at parameter Setpoint.
● 2000h: Invalid value at parameter Feedback_PER.
● 4000h: Invalid value at parameter Feedback.
● 8000h: Error in digital position feedback.
With errors 2000h, 4000h and 8000h, PID_3Step cannot  approach the configured substitute output value.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.
Errors in manual mode
If one or more of the following errors occur, PID_3Step stays in manual mode:
● 0002h: Invalid value at parameter Input_PER.
● 0200h: Invalid value at parameter Input.
● 0800h: Sampling time error
● 1000h: Invalid value at parameter Setpoint.
● 2000h: Invalid value at parameter Feedback_PER.
● 4000h: Invalid value at parameter Feedback.
● 8000h: Error in digital position feedback.
With errors 2000h, 4000h and 8000h, you cannot move the valve to a suitable position.

See also
PID_3Step static variables (Page 2679)

State and Retain.Mode parameters (Page 2686)
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Tag Warning
If several warnings are pending simultaneously, their values are displayed with binary addition. 
The display of warning 0003, for example, indicates that the warnings 0001 and 0002 are 
pending simultaneously.

Warning
 (DW#16#...)

Description

0000 No warning pending.
0001 The point of inflection was not found during pretuning.
0002 Oscillation increased during fine tuning.
0004 The setpoint was limited to the configured limits. 
0008 Not all the necessary controlled system properties were defined for the selected method of calculation. 

The PID parameters were instead calculated using the TuneRuleTIR = 3 method.
0010 The operating mode could not be changed because ManualEnable = TRUE.
0020 The cycle time of the calling OB limits the sampling time of the PID algorithm. 

Improve results by using shorter OB cycle times.
0040 The process value exceeded one of its warning limits.
0080 Invalid value at Retain.Mode. The operating mode is not switched.
0100 The manual value was limited to the limits of the controller output.
0200 The rule used for tuning produces an incorrect result, or is not supported.
0400 Method selected for transition time measurement not suitable for actuator.

The transition time cannot be measured because the actuator settings do not match the selected 
measuring method. 

0800 The difference between the current position and the new output value is too small for transition time 
measurement. This can produce incorrect results. The difference between the current output value and 
new output value must be at least 50% of the entire control range.

1000 The substitute output value cannot be reached because it is outside the output value limits.

The following warnings are deleted as soon as the cause is eliminated:

● 0004

● 0020

● 0040

● 0100

All other warnings are cleared with a rising edge at Reset.

SUT.State variable

SUT.Stat
e

Name Description

0 SUT_INIT Initialize pretuning
50 SUT_TPDN Determine start position without position feedback

100 SUT_STDABW Calculate the standard deviation
200 SUT_GET_POI Find the point of inflection
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SUT.Stat
e

Name Description

300 SUT_GET_RISETM Determine the rise time
9900 SUT_IO Pretuning successful

1 SUT_NIO Pretuning not successful

TIR.State variable

TIR.State Name Description
-100 TIR_FIRST_SUT Fine tuning is not possible. Pretuning will be executed first.

0 TIR_INIT Initialize fine tuning
200 TIR_STDABW Calculate the standard deviation
300 TIR_RUN_IN Attempt to reach the setpoint with the maximum or minimum output value
400 TIR_CTRLN Attempt to reach the setpoint with the existing PID parameters

(if pretuning has been successful)
500 TIR_OSZIL Determine oscillation and calculate parameters

9900 TIR_IO Fine tuning successful
1 TIR_NIO Fine tuning not successful
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9.7.5 Communication

9.7.5.1 Communications processor

SIMATIC NET CM/CP

S7-1500 CM/CP

Industrial Ethernet

Instructions for FTP services

FTP_CMD for FTP services

Overview of FTP_CMD

Meaning   
Using the FTP_CMD instruction, you can establish FTP connections and transfer files from 
and to an FTP server.

Data transfer is possible using FTP or FTPS (secure SSL connections).

 
 

 Note
FTPS: Comparing certificates

FTPS requires a comparison of the certificates between FTP server and FTP client. If the 
FTP server is configured outside the STEP 7 project of the FTP client, the certificate needs 
to be imported from the FTP server. Import the certificate of the FTP server as a trusted 
certificate in the certificate manager.

 

How it works
The FTP_CMD instruction references a job block (ARG) in which the FTP command is 
specified. Depending on the type of FTP command (CMD), this job block uses different data 
structures for parameter assignment. Suitable data types (UDTs) are available for these 
various structures.

The following diagram shows the call structure:
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Job blocks
The following data structures are used for the job blocks:

● Connection establishment
Various data structures are available for the connection establishment using the following 
types of access:

– UDT FTP_CONNECT_IPV4: Connection establishment with IP addresses according to 
IPv4

– UDT FTP_CONNECT_IPV6: Connection establishment with IP addresses according to 
IPv6

– UDT FTP_CONNECT_NAME: Connection establishment with server name (DNS)

● Data transfer
For the data transfer, two different data structures are available:

– UDT FTP_FILENAME: Data structure for access to a complete file

– UDT FTP_FILENAME_PART: Data structure for read access to a data area

Data transfer in the File_DB
The data transfer is achieved using data blocks containing a header for job data and the area 
for the user data. The data block is specified in the job buffer.

Requirements in the CPU configuration
Use the following settings to allow FTP access:

● In the configuration data of the CPU in "Properties > General > Protection": Disable the 
"Disable PUT/GET communication" option.

● For all data blocks being used as file DBs, disable the "Optimized block access" attribute 
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Validity
The FTP_CMD instruction can be used with the following module types:

● CP 1543-1

Call interface
Call interface in FBD representation

See also
Output parameters and status information FTP_CMD (Page 2708)

Input parameter - FTP_CMD (Page 2701)

Structure of the data blocks (file DBs) for FTP services - FTP client mode (Page 2712)

Input parameter - FTP_CMD

Explanation of the input parameters
You supply the FTP_CMD instruction with the following input parameters:

Table 9-89 Formal parameters of the FTP_CMD instruction - input parameters

Parameter Declaration Data type Memory area Meaning / remarks
REQ Input BOOL I, Q, M, D, L Starts the send job on a rising edge.
ID INPUT INT  The FTP jobs are handled on FTP 

connections. The parameter identifies the 
connection being used. 
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Parameter Declaration Data type Memory area Meaning / remarks
CMD INPUT BYTE  FTP command to be executed when the 

instruction is called. You will find value ranges 
for the FTP command types after the table.
Note:
The FTP command specified here must be 
specified identically in the job block (ARG 
parameter).
If a command is not supported by the CP 
firmware, an error message with STATUS = 
8F6BH is output.

ARG INPUT VARIANT  Job block
References the data area with the execution 
parameters suitable for the FTP command.
Specific data types (UDT) are used depending 
on the FTP command. The UDTs are shown 
below.
Note:
Do not use the data type ANY
The ANY data type is not permitted for the 
pointer to be specified here!

FTP commands in the "CMD" parameter
The following table shows you the significance of the commands of the "CMD" parameter and 
which UDTs you use to supply the job blocks.

Table 9-90 Command types

CMD (command type) Relevant job blocks / UDT Meaning / handling
0 (NOOP) - The called FC does not execute any action. The status codes are set 

as follows when these parameters are supplied:
● DONE=1; ERROR=0; STATUS=0

1 (CONNECT) FTP_CONNECT_IPV4 
FTP_CONNECT_IPV6
FTP_CONNECT_NAME

FTP connection establishment
With this command, the FTP client establishes an FTP connection to 
an FTP server (port 21).
The connection is available under the connection ID specified here for 
all further FTP commands. Data is then exchanged with the FTP server 
specified for this user.

2 (STORE) FTP_FILENAME This function call transfers a data block (file DB) from the FTP client 
(S7-CPU) to the FTP server. 
Caution: If the file (file DB) already exists on the FTP server, it will be 
overwritten.

3 (RETRIEVE) FTP_FILENAME
 

This function call transfers a file from the FTP server to the FTP client 
(S7-CPU). 
Caution: If the data block (file DB) on the FTP client already contains 
a file, it will be overwritten.

4 (DELETE) FTP_FILENAME With this function call, you delete a file on the FTP server.
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CMD (command type) Relevant job blocks / UDT Meaning / handling
5 (QUIT) None With this function call, you establish the FTP connections selected with 

the ID.
6 (APPEND) FTP_FILENAME Similar to "STORE", the "APPEND" command saves a file on the FTP 

server. With "APPEND", the file on the FTP server is, however, not 
overwritten. The new content is appended to the existing file.
If the file (file DB) does not exist on the FTP server, it will be created.

7 (RETR_PART) FTP_FILENAME_PART Using the "RETR_PART" command (retrieve part) , you can request a 
section of a file from the FTP server. 
If very large files are involved, this allows you to restrict the read to the 
part you currently require.
To do this, you need to know the structure of the file. 
Enter the required part of the file using the two parameters "OFFSET" 
and "LEN" in FB40.

See also
Overview of FTP_CMD (Page 2699)

Job blocks for FTP_CMD

Meaning
You supply the FTP_CMD instruction with a job block using the ARG parameter. The structure 
depends on the FTP command type. By using the default data types (UDT), the instruction 
recognizes the type of the job block. Below, you will find the relevant data types (UDTs) for 
the following job blocks:

● FTP connection establishment with IP address according to IPv4

● FTP connection establishment with IP address according to IPv6

● FTP connection establishment with server name

● Write and read access and other FTP commands

● FTP command RETR_PART
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Job block for FTP connection establishment with IP address according to IPv4
For FTP connection establishment with IP address according to IPv4, the following data 
structure is used. 

Table 9-91 UDT FTP_CONNECT_IPV4

Parameter Type Range of values Meaning / remarks
LADDR WORD  Module start address

When you call an instruction, you transfer the module start 
address of the CP in the LADDR parameter. 
You will find the module start address of the CP in the 
configuration of the CP under: 
"Properties>Addresses>Inputs"

ID INT 1, 2...64 The FTP jobs are handled on FTP connections. The 
parameter identifies the connection being used. 

ConnectionType BYTE 0 Connection type "FTP"
ActiveEstablished BOOL TRUE  
FTPcmd BYTE 1 FTP command  "CONNECT"

FTP command that executes when the instruction is called. 
You will find the ranges of values in Table 9-90 Command 
types (Page 2702) 
Note:
The FTP command specified here must be specified 
identically in the CMD input parameter.

CertIndex BYTE 0 = FTP
1 = FTPS

Here, choose between the protocol types FTP or FTPS.
Note on FTPS:
If the FTP server is configured outside the STEP 7 project 
of the FTP client, the certificate needs to be imported from 
the FTP server.

UserName STRING[32] 'user' User name for the login on the FTP server
Password STRING[32] 'password' Password for the login on the FTP server
FTPserverIP_addr IPv4 ’142.11.25.135’ IP address of the FTP server
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Job block for FTP connection establishment with IP address according to IPv6
For FTP connection establishment with IP address according to IPv6, the following data 
structure is used. 

Table 9-92 UDT FTP_CONNECT_IPV6

Parameter Type Range of values Meaning / remarks
LADDR WORD  Module start address

When you call an instruction, you transfer the module start 
address of the CP in the LADDR parameter. 
You will find the module start address of the CP in the 
configuration of the CP under: 
"Properties>Addresses>Inputs"

ID INT 1, 2...64 The FTP jobs are handled on FTP connections. The 
parameter identifies the connection being used. 

ConnectionType BYTE 0 Connection type "FTP"
ActiveEstablished BOOL TRUE  
FTPcmd BYTE 1 FTP command  "CONNECT"

FTP command that executes when the instruction is called. 
You will find the ranges of values in Table 9-90 Command 
types (Page 2702) 
Note:
The FTP command specified here must be specified 
identically in the CMD input parameter.

CertIndex BYTE 0 = FTP
1 = FTPS

Here, choose between the protocol types FTP or FTPS.
Note on FTPS:
If the FTP server is configured outside the STEP 7 project 
of the FTP client, the certificate needs to be imported from 
the FTP server.

UserName STRING[32] 'user' User name for the login on the FTP server
Password STRING[32] 'password' Password for the login on the FTP server
FTPserverIP_addr IPv6

array [1..16] of 
Byte

 IP address of the FTP server
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Job block for FTP connection establishment with server name
For FTP connection establishment specifying the server name, the following data structure is 
used. The server name is assigned to an IP address using DNS. 

Table 9-93 UDT FTP_CONNECT_NAME

Parameter Type Range of values Meaning / remarks
LADDR WORD  Module start address

When you call an instruction, you transfer the module start 
address of the CP in the LADDR parameter. 
You will find the module start address of the CP in the 
configuration of the CP under: 
"Properties>Addresses>Inputs"

ID INT 1, 2...64 The FTP jobs are handled on FTP connections. The 
parameter identifies the connection being used. 

ConnectionType BYTE 0 Connection type "FTP"
ActiveEstablished BOOL TRUE  
FTPcmd BYTE 1 FTP command  "CONNECT"

FTP command that executes when the instruction is called. 
You will find the ranges of values in Table 9-90 Command 
types (Page 2702) 
Note:
The FTP command specified here must be specified 
identically in the CMD input parameter.

CertIndex BYTE 0 = FTP
1 = FTPS

Here, choose between the protocol types FTP or FTPS.
Note on FTPS:
If the FTP server is configured outside the STEP 7 project 
of the FTP client, the certificate needs to be imported from 
the FTP server.

UserName STRING[32] 'user' User name for the login on the FTP server
Password STRING[32] 'password' Password for the login on the FTP server
FTPserverName STRING[254]  IP address of the FTP server

Job block for write and read access and other FTP commands
The following data structure is used for the FTP commands store, retrieve, delete and append. 

Table 9-94 UDT FTP_FILENAME

Parameter Type Range of values Meaning / remarks
LADDR WORD  Module start address

When you call an instruction, you transfer the module start 
address of the CP in the LADDR parameter. 
You will find the module start address of the CP in the 
configuration of the CP under: 
"Properties>Addresses>Inputs"

ID INT 1, 2...64 The FTP jobs are handled on FTP connections. The 
parameter identifies the connection being used. 
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Parameter Type Range of values Meaning / remarks
ConnectionType BYTE 0 Connection type "FTP"
ActiveEstablished BOOL TRUE  
FTPcmd BYTE 2, 3, 4, 6 FTP command  "STORE / RETRIEVE / DELETE / APPEND"

FTP command that executes when the instruction is called. 
You will find the ranges of values in table Table 9-90 
Command types (Page 2702) 
Note:
The FTP command specified here must be specified 
identically in the CMD input parameter.

CertIndex BYTE 0 = FTP
1 = FTPS

Here, choose between the protocol types FTP or FTPS.
Note on FTPS:
If the FTP server is configured outside the STEP 7 project 
of the FTP client, the certificate needs to be imported from 
the FTP server.

DataBlockNumber UINT  The data block specified here contains the file DB to be read / 
written.

LenFilename UINT 0...1000 Total length of the file name.
Filename ARRAY[0..3] OF 

STRING[ 220]
 File name of the source or destination file.

Job block for the RETR_PART FTP command
The following data structure is used for the RETR_PART FTP command. 

Table 9-95 UDT FTP_FILENAME_PART

Parameter Type Range of values Meaning / remarks
LADDR WORD  Module start address

When you call an instruction, you transfer the module start 
address of the CP in the LADDR parameter. 
You will find the module start address of the CP in the 
configuration of the CP under: 
"Properties>Addresses>Inputs"

ID INT 1, 2...64 The FTP jobs are handled on FTP connections. The 
parameter identifies the connection being used. 

ConnectionType BYTE 0 Connection type "FTP"
ActiveEstablished BOOL TRUE  
FTPcmd BYTE 7 FTP command  "RETR_PART"

FTP command that is executed when the instruction is 
called. You will find value ranges in table Table 9-90 
Command types (Page 2702) 
Note:
The FTP command specified here must be specified 
identically in the CMD input parameter.
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Parameter Type Range of values Meaning / remarks
CertIndex BYTE 0 = FTP

1 = FTPS
Here, choose between the protocol types FTP or FTPS.
Note on FTPS:
If the FTP server is configured outside the STEP 7 project 
of the FTP client, the certificate needs to be imported from 
the FTP server.

Offset DWORD  Offset in bytes starting at which the file will be read.
Length DWORD  Sublength in bytes that is read starting at the value specified 

in "OFFSET".
Special features:
● If "DW#16#FFFFFFFF" is specified, the available rest of 

the file will be read.
Result OK (DONE = 1, STATUS = 0) if no other error 
occurred.

● When OFFSET > length of the original file:
Length of the destination file (ACT_LENGTH in file DB): 
0 bytes on the CPU.
Result OK (DONE = 1, STATUS = 0) if no other error 
occurred.

● When OFFSET + LEN > length of the original file (and 
LEN ≠ 0xFFFFFFFF):
Length of the destination file (ACT_LENGTH in file DB): 
Available bytes starting at "OFFSET".

Result OK (DONE = 1, STATUS = 0) if no other error 
occurred.

DataBlockNumber UINT  The data block specified here contains the file DB to be read / 
written.

LenFilename UINT 0...1000 Total length of the file name.
Filename ARRAY[0..3] OF 

STRING[ 220]
 File name of the source or destination file.

See also
Overview of FTP_CMD (Page 2699)

Input parameter - FTP_CMD (Page 2701)

Output parameters and status information FTP_CMD

Parameters BUSY, DONE and ERROR
You control the execution status with the parameters BUSY, DONE, ERROR and STATUS. 
The BUSY parameter indicates the processing status. With the DONE parameter, you check 
whether or not a job was correctly executed. The ERROR parameter is set if errors occur during 
execution of "FTP_CMD". Error information is output in the STATUS parameter.

The following table shows the relationship between the parameters BUSY, DONE and ERROR:
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BUSY DONE ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job was terminated with an error. The cause of the error is specified in the STATUS 

parameter.
0 0 0 No new job was assigned.

 

Evaluating status codes
 

 Note

For entries coded with 8FxxH in STATUS, refer to the information in the STEP 7 Standard 
and System Functions reference manual. The chapter describing error evaluation with the 
RET_VAL output parameter contains detailed information.

 

Table 9-96 FTP_CMD: Meaning of the STATUS parameter in conjunction with DONE and ERROR

DONE ERROR STATUS Meaning
0 0 0000H No job is being executed.
1 0 0000H the job was completed without error.
0 0 7001H The job was triggered the first time (BUSY=1)
0 0 7002H The job is still being executed (BUSY=1)
0 0 80C4H Communication error (occurs temporarily, it is usually best to repeat the 

job in the user program).
0 0 8183H The configuration does not match the job parameters.
0 1 8401H Unknown error

Possible causes:
● A timeout was detected on the connection.
● The FTP server has aborted the connection.
Remedy:
● Send the QUIT and CONNECT commands again to re-establish the 

connection.
0 1 8402H The connection has an error status.

The timeout of the connection may have been exceeded or the FTP 
server may have terminated the connection.
Remedy:
Send the QUIT and CONNECT commands to re-establish the 
connection.

0 1 8403H Login has failed.
0 1 8404H FTP server is not obtainable.
0 1 8405H Transfer has failed.
0 1 8406H Timeout for current action
0 1 8407H File was not found on the FTP server.
0 1 8408H Transfer not possible.
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DONE ERROR STATUS Meaning
0 1 8409H File could not be fetched.
0 1 8410H Setting the TCP port for the data connection has failed.
0 1 8411H Offset information does not match.
0 1 8412H Error changing the specified directory
0 1 8413H Error receiving data
0 1 8414H Error sending data
0 1 8415H Specified CMD (command type) was rejected by the client.
0 1 8416H Connection was closed by the FTP server.
0 1 8418H Error in the user data.

Possible causes:
● File name is empty.
● Data length is "0"
● etc.

0 1 8419H There is no socket resource for opening a data connection.
0 1 8420H There is no socket resource for opening a control connection.
0 1 8421H Error opening the file DB to be read.
0 1 8422H Error opening the file DB to be written.
0 1 8423H Connection establishment to the FTP server has failed.
0 1 8424H Internal error
0 1 8425H Format error in the domain name
0 1 8426H There are too many DNS queries pending.
0 1 8427H The specified DNS server could not assign the specified domain name.
0 1 8428H There is no connection resource available.
0 1 8429H Unknown channel ID
0 1 8430H The file DB is too short.
0 1 8431H Error when writing to the file DB.
0 1 8432H Error when reading from the file DB.
0 1 8433H Error when accessing the file DB.
0 1 8434H Action was aborted.
0 1 8435H Channel will be reset.
0 1 8436H Unexpected server reply
0 1 8437H Certificate could not be verified.
0 1 8438H Unknown error occurred
0 1 8439H The FTP command causes an error. The cause must be looked for on 

the FTP server (REST command).
0 1 8440H The FTP server does not support the requested SSL protocol.
0 1 8446H After the FTP password was sent to the FTP server, an unexpected code 

was returned by the FTP server.
0 1 8451H An error was signaled when attempting to change the transmission mode 

from binary to ASCII.
0 1 8455H A memory request has failed on the CM/CP.
0 1 8460H A problem has occurred handling SSL/TLS.
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DONE ERROR STATUS Meaning
0 1 8469H Interface error

The specified output interface could not be used.
Remedy:
Set the interface to be used for outgoing connections.

0 1 8475H The SSL certificate or the SSH md5 fingerprint was not considered 
trusted.

0 1 8476H Nothing was received from the FTP server. In the current status, an 
incorrect response must be assumed.

0 1 8477H The specified "Crypto engine" (cryptographic module) was not found.
0 1 8478H The attempt to set the selected SSL "Crypto engine" as the default failed.
0 1 8480H A problem has occurred with the certificate of the FTP client.
0 1 8481H The specified number could not be used.
0 1 8482H The FTP server uses a coding that is not supported.
0 1 8484H The maximum file size was exceeded.
0 1 8485H The file DB was modified while being processed to be sent or the file DB 

is incorrectly structured.
0 1 8489H Data could not be sent. There is not enough memory available for the 

action on the FTP server.
0 1 8492H The file already exists. The file will not be overwritten.
0 1 8496H A problem occurred reading the SSL CA certificate.
0 1 8497H An unexpected error occurred in the SSH session.
0 1 8498H It was not possible to terminate the SSL connection.
0 1 8499H The socket is not ready for sending/receiving. Wait until it is ready and 

try again.
0 1 8501H The SSL certificate check by the FTP server has failed.
0 1 8507H A timeout has occurred establishing the connection during the active 

FTP session while waiting for the FTP server.
0 1 8F55H Header status bit: Locked
0 1 8F56H The NEW bit in the file DB header was not reset
0 1 8F6BH Possible causes:

● Bad value for the CMD parameter
Values from 0 to 15 are permitted.

● An FB40 command is not supported.
Possible cause: Wrong firmware on the CP
Remedy: Firmware update (with older CPs, use the functions 
FC 40...FC 44 instead of FB 40.)

0 1 8F7FH Internal error, for example illegal ANY reference

See also
Overview of FTP_CMD (Page 2699)

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2711



Structure and use of the file DB - FTP client mode

Structure of the data blocks (file DBs) for FTP services - FTP client mode

How it works
To transfer data with FTP, create data blocks (file DBs) on the CPU of your S7 station. These 
data blocks must have certain structure to allow them to be handled as transferable files by 
the FTP services. They consist of the following sections:

● Section 1: File DB header (has a fixed length of 20 bytes)

● Section 2: User data (has a variable length and structure)

Requirements in the CPU configuration
Use the following settings to allow FTP access:

● In the configuration data of the CPU in "Properties > General > Protection": Disable the 
"Disable PUT/GET communication" option.

● For all data blocks being used as file DBs, disable the "Optimized block access" attribute 

File DB header for FTP client mode
Note: The file DB header described here is largely identical to the file DB header for server 
mode. The differences relate to the following parameters:

● WRITE_ACCESS

● FTP_REPLY_CODE
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Parameter Type Value / meaning Supply
EXIST BOOL The EXIST bit indicates whether 

the user data area contains valid 
data.
The retrieve FTP command 
executes the job only when 
EXIST=1.
● 0: 

The file DB does not contain 
valid user data ("file does not 
exist").

● 1:
The file DB contains valid user 
data ("file exists").

The dele FTP command sets EXIST=0;
The store FTP command sets EXIST=1;

LOCKED BOOL The LOCKED bit is used to restrict 
access to the file DB.
● 0:

The file DB can be accessed.
● 1:

The file DB is locked.

The stor and retr FTP commands set 
LOCKED=1 when they are executed.
The following function is also possible 
when writing from the user program:
The user program on the S7 CPU can 
set or reset LOCKED during write 
access to achieve data consistency.
Recommended sequence in the user 
program:
1. Check LOCKED bit; 

if = 0
2. Set WRITEACCESS bit = 0
3. Check LOCKED bit; 

if = 0
4. Set LOCKED bit = 1
5. Write data
6. Set LOCKED bit = 0

NEW BOOL The NEW bit indicates whether 
data has been modified since the 
last read access.
● 0:

The content of the file DB is 
unchanged since the last write 
access. The user program of 
the S7 CPU has registered the 
last modification.

● 1:
The user program of the S7 
CPU has not yet registered the 
last write access.

After execution, the stor FTP command 
sets NEW=1
After reading the data, the user program 
in the S7-CPU must set NEW=0 to allow 
a new retr command.
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Parameter Type Value / meaning Supply
WRITE_ACCESS BOOL 0:

The user program (FTP client 
blocks) has write access rights for 
the file DBs on the S7 CPU.
1:
The user program (FTP client 
blocks) has no write access rights 
for the file DBs on the S7 CPU.

During the configuration of the DB, the 
bit is set to an initialization value.
Recommendation:
Whenever possible, the bit should 
remain unchanged! In special 
situations, adaptation during operation 
is possible.

ACT_LENGTH DINT Current length of the user data 
area.
The content of this field is only valid 
when EXIST = 1.

The current length is updated following 
write access.

MAX_LENGTH DINT Maximum length of the user data 
area (length of the entire DB less 
20 bytes header).

The maximum length should be 
specified during configuration of the DB.
The value can also be modified by the 
user program during operation.

FTP_REPLY_CODE INT Unsigned integer (16-bit) 
containing the last reply code from 
FTP as a binary value. 
The content of this field is only valid 
when EXIST = 1.

This is updated by the FTP client when 
the FTP command is executed.

DATE_TIME DATE_AND_TIME Date and time of the last 
modification to the file. 
The content of this field is only valid 
when EXIST = 1.

The current date is updated following a 
write access.
If the function for forwarding the time of 
day is used, the entry corresponds to 
the time that was passed on.
If the function for forwarding the time of 
day is not used, a relative time is 
entered. This time relates to the startup 
of the CP (the initialization value is 
1.1.1994 0.0 (midnight)).

See also
FILE_DB_HEADER data block as template - FTP client mode (Page 2714)

FILE_DB_HEADER data block as template - FTP client mode

Meaning
The data type FILE_DB_HEADER is predefined for creating a file DB header.
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How it works
To transfer data with FTP, create data blocks (file DBs) on the CPU of your S7 station. These 
data blocks must have certain structure to allow them to be handled as transferable files by 
the FTP services. They consist of the following sections:

● Section 1: File DB header (has a fixed length of 20 bytes)

● Section 2: User data (has a variable length and structure)

Follow the steps outlined below:
1. For the PLC CPU on which you create the user program with the FTP instructions, create 

a data block of the type "Global DB".

2. Select the line you want to use as the start line for the file DB.

3. From the drop-down list in the "Data type" column, select a structure element of the type 
FILE_DB_HEADER.
Result: A data structure with the header structure required for the file DB is created.

4.  Select the properties of the newly created data block and disable the "Optimized block 
access" attribute.

 

 Note
"Add new block" function - type selection

When you create new data blocks, the "FILE_DB_HEADER" block type is also available under 
the "Type" entry in the drop-down list. Do not use this option! The data block created in this 
way only contains the header structure and cannot be expanded by the area required for 
storing user data.

 

FILE_DB_HEADER data block - example and template for the file DB header
In the declaration view, you will see the following structure:

Address Name Type Initial value Comment
0.0  STRUCT   
+0.0 bit08 BOOL FALSE reserved
+0.1 bit09 BOOL FALSE reserved
+0.2 bit10 BOOL FALSE reserved
+0.3 bit11 BOOL FALSE reserved
+0.4 bit12 BOOL FALSE reserved
+0.5 bit13 BOOL FALSE reserved
+0.6 bit14 BOOL FALSE reserved
+0.7 bit15 BOOL FALSE reserved
+1.0 EXIST BOOL FALSE if TRUE: 

File DB does not contain valid 
data
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Address Name Type Initial value Comment
+1.1 LOCKED BOOL FALSE if TRUE: 

The file DB is blocked due to a 
change to the content.

+1.2 NEW BOOL FALSE if TRUE:
The content of the File DB is 
new and must not be 
overwritten.

+1.3 WRITE_ACCESS BOOL FALSE if TRUE:
The FTP server has write 
access.

+1.4 bit04 BOOL FALSE reserved
+1.5 bit05 BOOL FALSE reserved
+1.6 bit06 BOOL FALSE reserved
+1.7 bit07 BOOL FALSE reserved
+2.0 ACT_LENGTH DINT L#0 Current length of the content in 

bytes (not including 20 bytes for 
the header)

+6.0 MAX_LENGTH DINT L#0 Current length of the content in 
bytes (not including 20 bytes for 
the header)

+10.0 FTP_REPLY_CODE INT 0 Last replay information from the 
remote FTP server.

+12.0 DATE_TIME DATE_AND_TIME DT#00-1-1-0:0:0.000 Date and time of the last 
change to the content of the file 
DB.

=20.0  END_STRUCT   

Differences in the modes 
File DB header for FTP client mode

The file DB header described here is largely identical for the FTP client mode and FTP server 
mode. The differences relate to the following parameters:

● WRITE_ACCESS

● FTP_REPLY_CODE
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S7-1200 CM/CP

Telecontrol

Telecontrol instructions

TC_CON: Establish connection via the GSM network

Meaning
The TC_CON instruction allows an S7‑1200 with a CP 1242‑7 to establish a connection of the 
following types:

● ISO‑ON‑TCP
Connection partner is a CP 1242‑7.
ISO‑ON‑TCP connections are used only in "GPRS direct" mode.

● UDP
Any connection partner is possible.

● SMS
The connection partner is an SMS client.

● Telecontrol connection
The connection partner is either a telecontrol server or another station that can be reached 
via the telecontrol server.

A TC_CON establishes exactly one connection. Depending on the mode of the CP 1242-7 and 
the protocol you are using, a maximum of 3 to 5 simultaneous connections with unique IDs 
(see below) are supported per CP. You will find the maximum number of simultaneous 
connections in the performance data of the CP.

The CONNECT parameter uses a data block (DB) with the structure of a system data type 
(SDT) for the connection description.

The required connection type is defined using a connection-specific SDT "TCON_..." (see 
below). For each of the connection types listed above, one of the following SDTs must be 
assigned:

● TCON_IP_RFC for ISO‑ON‑TCP connections

● TCON_IP_V4 for UDP connections

● TCON_PHONE for SMS connections

● TCON_WDC for telecontrol connections

The "ActiveEstablished" parameter of these SDTs also specifies whether or not connection 
establishment is active or passive.

For parameter settings for these SDTs, see TCON_...: SDTs for the telecontrol connection 
establishment (Page 2732).

The ID parameter references the GPRS connection. The ID is assigned and must be unique 
within the CPU.
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The INTERFACE parameter references the GPRS interface of the required local CP. This must 
be taken from STEP 7.

Call interface in FBD representation

Explanation of the formal parameters
The following table explains all the formal parameters for the TC_CON instruction.

Parameter Declaration Data type Range of values Description
REQ INPUT BOOL 0, 1 The instruction is started and the status 

codes initialized on a rising edge.
Updating of the DONE, ERROR and 
STATUS status codes when there is a 
positive edge.

ID INPUT CONN_OUC 
(WORD)

1...07FFh Reference to the relevant connection. 
The ID is assigned.
The value of ID is also required by the 
system data type (SDT) of the CONNECT 
parameter.

INTERFACE INPUT HW_INTERFA
CE

 Reference to the interface of the local 
CP 1242‑7 (see STEP 7 > CP 
configuration > Telecontrol interface > 
"Hardware identifier")   

CONNECT INOUT TCON_Param See also "TCON_...: SDTs for 
telecontrol connection 
establishment"

Reference to a data block for connection 
establishment.
The SDTs of the type TCON_IP_RFC, 
TCON_IP_V4, TCON_PHONE or 
TCON_WDC specify the structure of the 
data block suitable for the relevant 
connection.
In the SDTs, note the parameter 
"ActiveEstablished" (active / passive 
connection establishment).

ENO OUTPUT BOOL 0: Error
1: Error-free

Enable output
If there is a runtime error with the 
instruction, ENO = 0 is set.
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Parameter Declaration Data type Range of values Description
BUSY OUTPUT BOOL 0: Execution of the instruction 

not started, completed or 
aborted
1: The instruction is executing

Display of the processing status of the 
instruction

DONE OUTPUT BOOL 0: -
1: The instruction executed 
successfully

This parameter indicates whether or not 
the job was completed without errors.
For the meaning in conjunction with the 
parameters ERROR and STATUS, refer 
to Codes of the instruction.

ERROR OUTPUT BOOL 0: -
1: Error

Error code
For the meaning in conjunction with the 
parameters DONE and STATUS, refer to 
Codes of the instruction.

STATUS OUTPUT WORD  Status code
For the meaning in conjunction with the 
parameters DONE and ERROR, refer to 
Codes of the instruction.

The codes BUSY, DONE and ERROR
The codes of DONE and ERROR are relevant only when BUSY = 0.

BUSY DONE ERROR Meaning
0 0 0 No job being executed

You will find all other code combinations of DONE and ERROR in the following table.

When called, the instruction remains in the BUSY = 1 state for several seconds. In the following 
situations, the BUSY state = 1 can last for a longer time:

● On active ISO-on-TCP connections if the partner cannot be reached.

● On passive connections when no frame is received.

The codes DONE, ERROR and STATUS
The following table shows the condition codes formed based on DONE, ERROR and STATUS 
that must be evaluated by the user program.

DONE ERROR STATUS Meaning
1 0 0000H Job executed without errors
0 0 7000H No job processing active (first instruction call)
0 0 7001H Job processing started (first instruction call)
0 0 7002H Job processing already active (renewed instruction call when BUSY = 1)
0 1 8086H Illegal value for ID
0 1 8087H Maximum number of connections reached, no further connection possible
0 1 80E3H The ID is already being used by another connection.
0 1 80E6H No query in progress (instruction call not started)

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2719



DONE ERROR STATUS Meaning
0 1 80E8H Remote partner cannot be reached. Check the connection parameters.

In the "GPRS direct" mode, the message is output if the partner can be reached but is 
not accepting a connection request.

0 1 80EBH Request temporarily denied (TC_CON has already been called with the same destination 
address.)

0 1 80ECH Opening the Listener Port failed:
Check the connection parameters.

0 1 80F2H The CP is in the wrong mode:
● Telecontrol connections are permitted only in "Telecontrol" mode.
● ISO‑ON‑TCP connections are permitted only in "GPRS direct" mode.

0 1 80F3H No free connection endpoint for sending data:
● Use less connections or
● Use less passive connections or
● Turn off NTP.
Remember the maximum number of simultaneous connections of the CP 1242-7.

0 1 80F4H Connection endpoint cannot be generated:
Repeat the call. If necessary, check the connection parameters.

0 1 80F6H Format error of a parameter in the called data block (wrong length, wrong format or invalid 
value)
Check the configuration of the "TC_CON..." SDT.

TC_DISCON: Terminate connection via the GSM network

Meaning
The TC_DISCON instruction on an S7‑1200 with CP 1242‑7 terminates an ISO‑ON‑TCP, UDP, 
SMS or telecontrol connection that was established with the TC_CON instruction.

You will find detailed information on the connection types in the description of the TC_CON 
instruction.

TC_DISCON terminates the connection to the telecontrol server only logically. If you want the 
connection to the telecontrol server to be terminated physically, configure the connection as 
a "Temporary connection" in the "telecontrol server" parameter group in STEP 7.

At the TCP/IP level, the connection is retained. Temporary stations terminate the connection 
automatically after sending the data.

The ID parameter references the GPRS connection. The ID must be unique within the CPU 
and the same as the ID used with TC_CON.

The INTERFACE parameter references the GPRS interface of the required local CP. The value 
must be the same as that used by TC_CON for INTERFACE.
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Call interface in FBD representation

Explanation of the formal parameters
The following table explains all the formal parameters for the TC_DISCON instruction

Parameter Declaration Data type Range of values Description
REQ INPUT BOOL 0, 1 The instruction is started and the status 

codes initialized on a rising edge.
Updating of the DONE, ERROR and 
STATUS status codes when there is a 
positive edge.

ID INPUT CONN_OUC 
(WORD)

1...07FFh Reference to the relevant connection

INTERFACE INPUT HW_INTERFA
CE

 Reference to the interface of the local 
CP 1242‑7 (see STEP 7 > CP 
configuration > Telecontrol interface > 
"Hardware identifier")   

ENO OUTPUT BOOL 0: Error
1: Error-free

Enable output
If there is a runtime error with the 
instruction, ENO = 0 is set.

BUSY OUTPUT BOOL 0: Execution of the instruction 
not started, completed or 
aborted
1: The instruction is executing

Display of the processing status of the 
instruction

DONE OUTPUT BOOL 0: -
1: The instruction executed 
successfully

This parameter indicates whether or not 
the job was completed without errors.
For the meaning in conjunction with the 
parameters ERROR and STATUS, refer 
to Codes of the instruction.

ERROR OUTPUT BOOL 0: -
1: Error

Error code
For the meaning in conjunction with the 
parameters DONE and STATUS, refer to 
Codes of the instruction.

STATUS OUTPUT WORD  Status code
For the meaning in conjunction with the 
parameters DONE and ERROR, refer to 
Codes of the instruction.
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The codes BUSY, DONE and ERROR
The codes of DONE and ERROR are relevant only when BUSY = 0.

BUSY DONE ERROR Meaning
0 0 0 The instruction has not yet been called.

You will find all other code combinations of DONE and ERROR in the following table.
 

 Note

When called, the instruction remains in the BUSY = 1 state for several seconds.
 

The codes DONE, ERROR and STATUS
The following table shows the condition codes formed based on DONE, ERROR and STATUS 
that must be evaluated by the user program.

DONE ERROR STATUS Meaning
1 0 0000H Job executed without errors
0 0 7000H No job processing active (first instruction call)
0 0 7001H Job processing started (first instruction call)
0 0 7002H Job processing already active (renewed instruction call when BUSY = 1)
0 1 8086H Illegal value for ID
0 1 80E4H Unknown ID: No connection with this ID has been established by TC_CON.
0 1 80E6H No query in progress (instruction call not started)
0 1 80F5H Invalid connection endpoint:

● Connection establishment by TC_CON failed or
● Connection terminated by remote partner.

0 1 80F6H Format error of a parameter in the called data block (wrong length, wrong format or invalid 
value)
Check the configuration of the "TC_CON..." SDT.

TC_SEND: Send data via the GSM network

Meaning
The TC_SEND instruction allows the sending of data via programmed connections of the 
following types:

● ISO‑ON‑TCP connections

● UDP connections
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● SMS connections
The sending of SMS messages is supported only if this was set up in the STEP 7 
configuration of the CP.

● Telecontrol connections
 

  Note
Sending SMS messages to multiple recipients   

If you want to send an identical SMS message to several recipients, you need to establish 
a connection to each recipient.

 

You will find more detailed information on the connection types in the description of the 
TC_CON instruction.

The ID parameter references the GPRS connection. The value of ID must correspond to the 
value used for ID by TC_CON.

The INTERFACE parameter references the GPRS interface of the required local CP. The value 
must be the same as that used by TC_CON for INTERFACE.

The amount of data to be sent is specified with the LEN parameter.

The size of the data area specified in DATA must be at least as large as the number of bytes 
configured for LEN. Permitted data types in the data area specified in DATA are all except 
BOOL and ARRAY of BOOL.

The destination address (connection partner) for the data to be sent is configured in the 
TC_CON instruction.

Call interface in FBD representation
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Explanation of the formal parameters
The following table explains all the formal parameters for the TC_SEND instruction.

Parameter Declaration Data type Range of values Description
REQ INPUT BOOL 0, 1 The instruction is started and the status 

codes initialized on a rising edge.
Updating of the DONE, ERROR and 
STATUS status codes when there is a 
positive edge.

ID INPUT CONN_OUC 
(WORD)

1...07FFh Reference to the relevant connection

INTERFACE INPUT HW_INTERFA
CE

 Reference to the interface of the local 
CP 1242‑7 (see STEP 7 > CP 
configuration > Telecontrol interface > 
"Hardware identifier")   

LEN INPUT UINT 1...2048 Number of bytes of data to be sent, 
maximum 2048. The value should match 
the size of the range of DATA.

DATA INOUT VARIANT  Address reference to the send data area 
of the CPU *

ENO OUTPUT BOOL 0: Error
1: Error-free

Enable output
If there is a runtime error with the 
instruction, ENO = 0 is set.

BUSY OUTPUT BOOL 0: Execution of the instruction 
not started, completed or 
aborted
1: The instruction is executing

Display of the processing status of the 
instruction

DONE OUTPUT BOOL 0: -
1: The instruction executed 
successfully

This parameter indicates whether or not 
the job was completed without errors. **
For the meaning in conjunction with the 
parameters ERROR and STATUS, refer 
to Codes of the instruction.

ERROR OUTPUT BOOL 0: -
1: Error

Error code
For the meaning in conjunction with the 
parameters DONE and STATUS, refer to 
Codes of the instruction.

STATUS OUTPUT WORD  Status code
For the meaning in conjunction with the 
parameters DONE and ERROR, refer to 
Codes of the instruction.

* For special features of the DATA parameter for SMS texts, refer to the next section.
** After sending a frame, TC_SEND sets DONE = 1. Note the following response:
The loss of an ISO-on-TCP connection is only recognized by the sender after 1 to 2 minutes. The transferred data may be lost 
although TC_SEND has set DONE = 1 at the sender.
If an ISO-on-TCP connection is aborted after receiving a frame before TC_RECV was started, the transferred data may be 
lost even if TC_SEND sets DONE = 1 at the sender.
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Configuring SMS texts with the DATA parameter   
The instruction sends the data referenced by the pointer of the type VARIANT of the DATA 
parameter as an SMS text.

If an operand of the data type STRING is referenced by DATA for SMS texts, the first two bytes 
are transferred with length information of the string.

One option for the correct text representation of SMS messages to be sent is to convert the 
text string into an Array of BYTE or Array of CHAR using the conversion function 
Strg_TO_Chars. Strg_TO_Chars at the EN parameter is linked to the output parameter ENO 
by TC_SEND.

For SMS texts, the CP does not support all special characters, for example umlauts (ü, ä etc.). 
The specification GSM 03.38 applies. There may be additional restrictions imposed by the 
GSM network provider.

The codes BUSY, DONE and ERROR
The codes of DONE and ERROR are relevant only when BUSY = 0.

BUSY DONE ERROR Meaning
0 0 0 No job being executed

You will find all other code combinations of DONE and ERROR in the following table.

The codes DONE, ERROR and STATUS
The following table shows the condition codes formed based on DONE, ERROR and STATUS 
that must be evaluated by the user program.

DONE ERROR STATUS * Meaning
1 0 0000H Job executed without errors
0 0 7000H No job processing active (first instruction call)
0 0 7001H Job processing started (first instruction call)
0 0 7002H Job processing already active (renewed instruction call when BUSY = 1)
0 1 8086H Illegal value for ID
0 1 80E0H ● The length information under LEN is greater than the range of data to be transferred 

under DATA.
or

● Internal error
If you send the frames directly to the telecontrol server (mode "Telecontrol"), make 
sure that the send cycle time is ≥ 1 second.

0 1 80E1H Timeout:
● Increase the value of the "Connection monitoring time" in the configuration of the CP 

1242-7 or
● Check the connection partner.

0 1 80E4H Unknown ID:
First call TC_CON.

0 1 80E6H No query in progress (instruction call not started)
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DONE ERROR STATUS * Meaning
0 1 80E7H Data to be sent not completely transferred:

Repeat the job.
0 1 80E8H Remote partner cannot be reached. Check the connection parameters.

In the "GPRS direct" mode, the message is output if the partner can be reached but is 
not accepting a connection request.

0 1 80E9H Connection establishment by remote partner:
Check the connection partner. If necessary, terminate the connection with TC_DISCON 
and establish it again with TC_CON.

0 1 80EAH Error message from remote partner:
● Check the connection partner. Enable the "TC_RECV" instruction on the 

communications partner.
● If necessary, terminate the connection with TC_DISCON and establish it again with 

TC_CON.
0 1 80EFH SMS could not be sent:

● Check whether the destination address (telephone number of the destination 
subscriber) exists.

● Check whether the inserted SIM card allows sending of SMS.
● Make sure that when the data block TCON_PHONE was created, the "Standard" 

option was selected for block access.
0 1 80F1H Sending of SMS messages is not enabled in the STEP 7 configuration of the CP:

Enalble the "Allow SMS" option in the configuration of the CP.
0 1 80F4H Connection endpoint cannot be generated:

Check the connection partner.
0 1 80F5H Invalid connection endpoint:

● Connection establishment by TC_CON failed.
or

● Connection terminated by remote partner: First call TC_DISCON.
0 1 80F6H Format error of a parameter in the called data block (wrong length, wrong format or invalid 

value):
Check the configuration of the "TC_CON..." SDT.

* Further statuses that are not listed here can be found in the status display is of the "RDREC" or "WRREC" instructions in the 
two middle status bytes (STATUS[2], STATUS[3]).
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TC_RECV: Receive data via the GSM network

Meaning
The TC_RECV instruction allows the reception of data via programmed connections of the 
following types:

● ISO‑ON‑TCP connections

● SMS connections
To receive SMS messages, the phone number of the sender must be configured in the 
STEP 7 configuration of the receiving CP (authorized phone numbers). The sender must 
support the CLIP function.
The phone number of the connection partner must be entered in the "TCON_PHONE" SDT.
Wake-up SMS messages are filtered out.

● Telecontrol connections
 

  Note
Receiving SMS messages from different senders   

If you want to receive SMS messages from different senders, you have two alternatives:
● You configure several connections (TC_CON, TC_RECV, TC_DISCON).

or
● You may only enter no telephone number for only one configured connection in the 

required data block "TCON_PHONE" in the "PhoneNumber" parameter. When 
receiving messages, this is then interpreted as a placeholder for all authorized 
connection partners.

 

You will find more detailed information on the connection types in the description of the 
TC_CON instruction.

The ID parameter references the GPRS connection. The value of ID must correspond to the 
value used for ID by TC_CON.

The INTERFACE parameter references the GPRS interface of the required local CP. The value 
must be the same as that used by TC_CON for INTERFACE.

The maximum amount of data to be received is specified with the LEN parameter.

The size of the data area specified in DATA must be at least as large as the number of bytes 
configured for LEN. Permitted data types in the data area specified in DATA are all except 
BOOL and ARRAY of BOOL. The received data is interpreted as if the sending partner had 
used the same data types.

The DB (system data type) used for the connection description of TC_RECV must differ from 
a DB used for TC_SEND.
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Call interface in FBD representation

Explanation of the formal parameters
The following table explains all the formal parameters for the TC_RECV instruction

Parameter Declaration Data type Range of values Description
EN_R INPUT BOOL 0: Data reception locked

1: Data reception enabled
Enables / locks the reception of data.
After setting 1 to 0, the program block 
receives data again.

ID INPUT CONN_OUC 
(WORD)

1...07FFh Reference to the relevant connection

INTERFACE INPUT HW_INTERFA
CE

 Reference to the interface of the local 
CP 1242‑7 (see STEP 7 > CP 
configuration > Telecontrol interface > 
"Hardware identifier")   

LEN INPUT UINT 1...2048 (minimum) number of bytes of data to be 
received, maximum 2048

DATA INOUT VARIANT  Address reference to the receive data 
area of the CPU *

ENO OUTPUT BOOL 0: Error
1: Error-free

Enable output
If there is a runtime error with the 
instruction, ENO = 0 is set.

RCVD_LEN OUTPUT UINT  Number of bytes of received data
BUSY OUTPUT BOOL 0: Execution of the instruction 

not started, completed or 
aborted
1: The instruction is executing

Display of the processing status of the 
instruction

DONE OUTPUT BOOL 0: -
1: The instruction executed 
successfully

This parameter indicates whether or not 
the job was completed without errors.
For the meaning in conjunction with the 
parameters ERROR and STATUS, refer 
to Codes of the instruction.
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Parameter Declaration Data type Range of values Description
ERROR OUTPUT BOOL 0: -

1: Error
Error code
For the meaning in conjunction with the 
parameters DONE and STATUS, refer to 
Codes of the instruction.

STATUS OUTPUT WORD  Status code
For the meaning in conjunction with the 
parameters DONE and ERROR, refer to 
Codes of the instruction.

* For special features of the DATA parameter for SMS texts, refer to the next section.

Configuring SMS texts with the DATA parameter   
The instruction references the received SMS text with the pointer of the type VARIANT of the 
DATA parameter to the data area of the CPU.

If DATA references an operand of the data type STRING for the SMS text, the first two bytes 
of the SMS text will be interpreted as length information of the data type STRING and not as 
SMS text.

One option for the correct text representation of SMS messages to be received is to convert 
an Array of BYTE or Array of CHAR to a text string using the conversion function 
Chars_TO_Strg. Chars_TO_Strg at the EN parameter is linked to the output parameter ENO 
of TC_RECV.

For SMS texts, the CP does not support all special characters, for example umlauts (ü, ä etc.). 
The specification GSM 03.38 applies. There may be additional restrictions imposed by the 
GSM network provider.

The codes BUSY, DONE and ERROR
The codes of DONE and ERROR are relevant only when BUSY = 0.

BUSY DONE ERROR Meaning
0 0 0 No job being executed

You will find all other code combinations of DONE and ERROR in the following table.

The codes DONE, ERROR and STATUS
The following table shows the condition codes formed based on DONE, ERROR and STATUS 
that must be evaluated by the user program.

DONE ERROR STATUS * Meaning
1 0 0000H Job executed without errors
0 0 7000H No job processing active (first instruction call)
0 0 7001H Job processing started (first instruction call)
0 0 7002H Job processing already active (renewed instruction call when BUSY = 1)
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DONE ERROR STATUS * Meaning
0 1 80A3H ● An attempt is made to re-establish an existing connection.

● An attempt is made to terminate a non-existent connection.
0 1 80E0H ● The size of the data received for the range specified by DATA is greater than the 

length information in LEN.
or

● Internal error
0 1 8086H Illegal value for ID
0 1 80E4H Unknown ID:

First call TC_CON.
0 1 80E6H No query in progress (instruction call not started)
0 1 80F5H Invalid connection endpoint:

● Connection establishment by TC_CON failed.
or

● Connection terminated by remote partner: First call TC_DISCON.
0 1 80F6H Format error of a parameter in the called data block (wrong length, wrong format or invalid 

value)
Check the configuration of the "TC_CON..." SDT.

* Further statuses that are not listed here can be found in the status display is of the "RDREC" or "WRREC" instructions in the 
two middle status bytes (STATUS[2], STATUS[3]).

TC_CONFIG: Transferring configuration data to a CP

Meaning
With the TC_CONFIG instruction, parameters of a the CP 1242‑7 configured in STEP 7 can 
be modified. The configured values are not overwritten retentively. The overwritten values 
remain valid until TC_CONFIG is called again or until the station starts up again (cold restart 
after cycling power).

If the STEP 7 configuration data of the CP needs to be changed permanently, the instruction 
needs to be called again each time the station restarts (cold restart) or a modified project must 
be downloaded to the station.

The CONFIG parameter points to the memory area with the configuration data. The 
configuration data is stored in a data block (DB). The structure of the DB is specified by the 
system data type (SDT) IF_CONF.

The configuration data to be modified on the CP is put together as necessary in blocks in 
IF_CONF "IF_CONF_..." for the individual parameters.

Parameters that are not intended to change as a result of the instruction are not entered in 
IF_CONF. They retain the value configured in STEP 7.

For detail information on assigning value to IF_CONF, refer to the section IF_CONF: SDT for 
telecontrol configuration data (Page 2737).

The INTERFACE parameter references the GPRS interface of the required local CP.
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Call interface in FBD representation

Explanation of the formal parameters
The following table explains all the formal parameters for the TC_CONFIG instruction

Parameter Declaration Data type Range of values Description
REQ INPUT BOOL 0, 1 The instruction is started and the status 

codes initialized on a rising edge.
Updating of the DONE, ERROR and 
STATUS status codes when there is a 
positive edge.

INTERFACE INPUT HW_INTERFA
CE (WORD)

 Reference to the interface of the local 
CP 1242‑7

CONFIG INOUT VARIANT See also "IF_CONF: SDT for 
telecontrol configuration data

Reference to the memory area with the 
collected configuration data to be modified

ENO OUTPUT BOOL 0: Error
1: Error-free

Enable output
If there is a runtime error with the 
instruction, ENO = 0 is set.

BUSY OUTPUT BOOL 0: Execution of the instruction 
not started, completed or 
aborted
1: The instruction is executing

Display of the processing status of the 
instruction

DONE OUTPUT BOOL 0: -
1: The instruction executed 
successfully

This parameter indicates whether or not 
the job was completed without errors.
For the meaning in conjunction with the 
parameters ERROR and STATUS, refer 
to Codes of the instruction.

ERROR OUTPUT BOOL 0: -
1: Error

Error code
For the meaning in conjunction with the 
parameters DONE and STATUS, refer to 
Codes of the instruction.

STATUS OUTPUT WORD  Status code
For the meaning in conjunction with the 
parameters DONE and ERROR, refer to 
Codes of the instruction.
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The codes BUSY, DONE and ERROR
The codes of DONE and ERROR are relevant only when BUSY = 0.

BUSY DONE ERROR Meaning
0 0 0 No job being executed

You will find all other code combinations of DONE and ERROR in the following table.

The codes DONE, ERROR and STATUS
The following table shows the condition codes formed based on DONE, ERROR and STATUS 
that must be evaluated by the user program.

DONE ERROR STATUS Meaning
1 0 0000H Job executed without errors
0 0 7000H No job processing active (first instruction call)
0 0 7001H Job processing started (first instruction call)
0 0 7002H Job processing already active (renewed instruction call when BUSY = 1)
0 1 80E6H No query in progress (instruction call not started)
0 1 80EBH Query temporarily rejected (the CP is currently being configured by STEP 7).
0 1 80F6H Format error of a parameter in the called data block (wrong length, wrong format or invalid 

value)
Check the "IF_CONF" SDT.

0 1 80F7H Wrong ID in the parameter fields of the configuration data:
Check the "IF_CONF" SDT.

Other error messages

Other error messages
The following error messages are used for diagnostics purposes. You can obtain more 
information from the Siemens hotline.

DONE ERROR STATUS Meaning
0 1 80E0H Internal error

You should also note the possible meaning with the TC_SEND and TC_RECV 
instructions.

TCON_...: SDTs for the telecontrol connection establishment

System data types TCON_... for the TC_CON instruction
To configure a telecontrol connection using the TC_CON instruction, the CONNECT parameter 
of the instruction is used for the connection description.
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The connection description is specified by the structure of the system data type (SDT). The 
structure of the relevant SDT contains the parameters necessary to establish the connection 
with the remote communications partner.

For different connection types that depend on the remote communications partner, the 
following SDTs are used:

● TCON_IP_RFC for ISO-on-TCP connections to IPv4 stations with CP 1242‑7

● TCON_IP_V4 for UDP connections to IPv4 stations (sending only)

● TCON_PHONE for connections to SMS clients

● TCON_WDC for connections to telecontrol servers or stations that can be reached via the 
telecontrol server.

The parameter assignment of the connection description is made in a data block of the same 
type as the SDT.

Creating a DB of the type TCON_...
You will need to type in the data types of the relevant DBs with the keyboard. They are not 
displayed in the selection list. The data types are not case-sensitive.

To create a TCON_... DB, follow the steps outlined below:

1. Create a data block of the type "global DB" with block access "Standard".

2. Create an SDT in the table of the parameter configuration of the DB by assigning the name 
and typing in the required type (for example "TCON_IP_RFC") in the cell of the data type.
The SDT and its parameters are created (see below).

3. Configure the parameters that are described below for each SDT type.

Reserved bits are not displayed.

System data type TCON_IP_RFC for connections to IPv4 stations
This connection type is supported only on ISO‑on‑TCP connections to communications 
partners with a fixed IP address. The CP must be configured for the "GPRS direct" mode.

Table 9-97 Parameters of TCON_IP_RFC

Byte Parameter Data type Initial value Description
0 ... 1 InterfaceID HW_ANY  Reference to the interface of the local CP 1242‑7 (see 

STEP 7 > CP configuration > Telecontrol interface > 
"Hardware identifier")   

2 ... 3 ID CONN_OUC 1...07FFh Reference to the GPRS connection. The ID is 
assigned and must be unique within the CPU.
Here, the same value as that of the ID parameter of 
the TC_CON instruction must be used.

4 ConnectionType BYTE W#16#0C Protocol variant 12 (Ch): ISO‑on‑TCP connection
5 ActiveEstablished BOOL  Identifier for the type of connection establishment:

● 0: Passive connection establishment
● 1: Active connection establishment
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Byte Parameter Data type Initial value Description
6 ... 7 - - - - reserved -
 
8 ... 11

RemoteAddress IP_V4  IP address of the connection partner
ADDR Array [1...4] of 

Byte
 IP address of the relevant connection partner

 
12 ... 
13

RemoteTSelector TSelector  Remote T selector
TSelLen UINT  Length of the remote T selector "RemoteTSelector"

14 ... 
45

TSel Array [1...32] 
of Byte

any Remote transport selector of the connection
● When "ActiveEstablished" = 1:

With active connection establishment, the T 
selector of the local partner must be the same as 
the T selector of the connection partner (passive 
connection establishment on the remote partner).

● When "ActiveEstablished" = 0 correspondingly
(passive connection establishment local, active 
connection establishment remote)

 
46 ... 
47

LocalTSelector TSelector  Local T selector
TSelLen UINT  Length of the local T selector "LOCAL_TSel"

48 ... 
79

TSel Array [1...32] 
of Byte

any Local transport selector of the connection
● When "ActiveEstablished" = 1:

With active connection establishment, the T 
selector of the local partner must be the same as 
the T selector of the connection partner (passive 
connection establishment on the remote partner).

● When "ActiveEstablished" = 0 correspondingly
(passive connection establishment local, active 
connection establishment remote)

System data type TCON_IP_V4 for connections to IPv4 stations
This connection type is supported only for sending on UDP connections to communications 
partners with a fixed IP address.

To receive, ActiveEstablished = 0 must be set.

Table 9-98 Parameters of TCON_IP_V4

Byte Parameter Data type Initial value Description
0 ... 1 InterfaceID HW_ANY  Reference to the interface of the local CP 1242‑7 (see 

STEP 7 > CP configuration > Telecontrol interface > 
"Hardware identifier")   

2 ... 3 ID CONN_OUC 1...07FFh Reference to the GPRS connection. The ID is 
assigned and must be unique within the CPU.
Here, the same value as that of the ID parameter of 
the TC_CON instruction must be used.

4 ConnectionType BYTE W#16#0B Protocol variant 11 (Bh): UDP connection
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Byte Parameter Data type Initial value Description
5 ActiveEstablished BOOL  Identifier for the type of connection establishment:

● 0: Passive connection establishment
Setting for sending and receiving data.

● 1: Active connection establishment
Setting for sending data only.

6 ... 7 - - - - reserved -
 
8 ... 11

RemoteAddress IP_V4  IP address of the connection partner
ADDR Array [1...4] of 

Byte
 IP address of the relevant connection partner

12 ... 
13

RemotePort UINT 1...65535 IP port of the connection partner
Not relevant if ActiveEstablished = 0

14 ... 
15

LocalPort UINT 1...65535 Local IP port ("0" is not permitted)
Not relevant if ActiveEstablished = 1

System data type TCON_PHONE for SMS connections
 

 Note
Authorized phone numbers

The CP only accepts an SMS if the sending communication partner is authorized based on 
its phone number. These numbers are in configured for the CP in STEP 7 in the "authorized 
phone numbers" list.

SMS text   
● Programmed SMS texts for SMS messages to be sent are accessed using the DATA 

parameter of the TC_SEND instruction.
● The text of a received SMS message is assigned to the address area of the CPU by the 

DATA parameter of the TC_RECV instruction.
 

Table 9-99 Parameters of TCON_PHONE

Byte Parameter Data type Initial value Description
0 ... 1 InterfaceID HW_ANY  Reference to the interface of the local CP 1242‑7 (see 

STEP 7 > CP configuration > Telecontrol interface > 
"Hardware identifier")   

2 ... 3 ID CONN_OUC 1...07FFh Reference to the GPRS connection. The ID is 
assigned and must be unique within the CPU.
Here, the same value as that of the ID parameter of 
the TC_CON instruction must be used.

4 ConnectionType BYTE W#16#0E Protocol variant 14 (Eh): SMS connection
5 ActiveEstablished BOOL  Identifier for the type of connection establishment (not 

relevant for the CP 1242-7):
● 0: Passive connection establishment (not relevant 

here)
● 1: Active connection establishment
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Byte Parameter Data type Initial value Description
6...7 - - - - reserviert -
8 ... 31 PhoneNumber STRING[22]  Call number of the connection partner

Permitted values: Plus character (+) and numbers
Note the exact notation of the international dialing 
code of the relevant phone number assigned by the 
network provider ("+" character or zeros).
Without an entry for the PhoneNumber parameter, no 
connection partner is specified and SMS messages 
can be received reception from all authorized 
connection partners.
Note the following during startup: Without an entry, 
TC_RECV first delivers the oldest received SMS 
message.

System data type TCON_WDC for connections to telecontrol servers or remote stations
You can configure the connection to the telecontrol server assigned to the S7‑1200 or to a 
remote station that can be reached via the telecontrol server with TCON_WDC. The address 
data of the telecontrol server assigned to the CP can be found in STEP 7 in the "Telecontrol 
interface > Mode" tab of the CP. The telecontrol server or a remote station is addressed using 
the host name or the IP address.

The "RemoteWdcAddress" parameter of TCON_WDC specifies the Access ID of the 
connection partner.

Table 9-100 Parameters of TCON_WDC

Byte Parameter Data type Initial value Description
0 ... 1 InterfaceID HW_ANY  Reference to the interface of the local CP 1242‑7 (see 

STEP 7 > CP configuration > Telecontrol interface > 
"Hardware identifier")   

2 ... 3 ID CONN_OUC 1...07FFh Reference to the GPRS connection. The ID is 
assigned and must be unique within the CPU.
Here, the same value as that of the ID parameter of 
the TC_CON instruction must be used.

4 ConnectionType BYTE W#16#0F Protocol variant 15 (Fh): Telecontrol connection using 
an IP address

5 ActiveEstablished BOOL  Identifier for the type of connection establishment:
● 0: Passive connection establishment
● 1: Active connection establishment
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Byte Parameter Data type Initial value Description
6 ... 7 - - - - reserved -
8 ... 11 RemoteWdcAddress DWORD  Specifies the Access ID (hex). The access ID depends 

on the connection partner.
● Connection to a remote CP:

The access ID is made up of the following:
– STEP 7 project number
– Station number
– Slot

If the remote station has more than one GPRS-
CP and you do not want to specify the path, 
the last byte for the slot must be set to 0.

You will find the access ID in the STEP 7 project 
in the "CP authentication of the CP" parameter 
group.

● Connection to the telecontrol server:
Access ID = 0

● To only write to the process image of the CP:
Access ID = DW#16#FEEDDADA

IF_CONF: SDT for telecontrol configuration data

Structure of the system data type IF_CONF for the TC_CONFIG instruction
The CONFIG parameter of the TC_CONFIG instruction references the memory area with the 
configuration data of the CP 1242-7 to be modified. The configuration data stored in a data 
block is described as a structure of the system data type (SDT) IF_CONF.

IF_CONF is made up of a header followed by fields that correspond to the parameters or 
parameter areas of the CP in the device properties of the STEP 7 project.

The CP configuration data to be modified is collected together as IF_CONF fields. Parameters 
that will not be modified are ignored in the IF_CONF structure and remain as they were 
configured in the STEP 7 project.

Creating the DB and the IF_CONF structures
You can create the parameters of the CP within the IF_CONF DB in one or more structures 
each with one or more fields.

You will need to type in the data types of the fields using the keyboard. They are not displayed 
in the selection list. The data types are not case-sensitive.

Follow the steps below to create IF_CONF:

1. Create a data block of the type "global DB" with block access "Standard".

2. Create a structure (data type "Struct") in the table of the parameter configuration of the DB.
You can specify any name.

3. Under this structure add a header by assigning the name of the header and typing it in in 
the cell of the data type "IF_CONF_Header".
The header of the structure and its three parameters (see below) is created.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2737



4. Create a field for the first parameter to be changed by typing in the required data type (for 
example "IF_CONF_APN") in the cell of the data type.

5. Repeat the last step for all parameters you want to change on the CP using the TC_CONFIG 
instruction.

6. Finally, update the number of fields in the header in the "subfieldCnt" parameter.

Header of IF_CONF

Table 9-101 IF_CONF_Header

Byte Parameter Data type Initial value Description
0 ... 1 fieldType UINT  Field type: Must always be 0.
2 ... 3 fieldId UINT  Field ID: Must always be 0.
4 ... 5 subfieldCnt UINT  Total number of fields contained in the structure

General parameters of the parameter fields
Each field has the following general parameters:

● Id
This parameter identifies the field and must not be modified.

● Length
This parameter indicates the length of the field. The value serves as information.
Fields with strings and / or arrays have a variable length. Due to hidden bytes, the actual 
length of fields can be greater than the sum of the displayed parameters.

● Mode
The following values are permitted to these parameters:

Table 9-102 Values of "Mode"

Value Meaning
1 Permanent validity of the configuration data

Not relevant for the CP 1242‑7
2 Temporary validity of the configuration data, including deleting of existing permanent 

configuration data
The permanent configuration data is replaced by the parameter fields of IF_CONF.

Field for the parameter area "GPRS access"

Table 9-103 IF_CONF_APN

Parameter Data type Initial value Description
Id UINT 4 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 174
Mode UINT  Validity (1: permanent, 2: temporary)
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Parameter Data type Initial value Description
AccesspointGPRS STRING [98]  APN: Name of the access point of the GSM network 

provider to the Internet
AccesspointUser STRING [42]  APN user name
AccesspointPassword STRING [22]  APN password

Field for the parameter area "CP identification"

Table 9-104 IF_CONF_Login

Parameter Data type Initial value Description
Id UINT 5 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 54
Mode UINT  Validity (1: permanent, 2: temporary)
ModemName STRING [22]  Access ID

The value cannot be set.
ModemPassword STRING [22]  Telecontrol password (max. 20 characters)

Field for the parameter area "Telecontrol server access"
This field is only used when the telecontrol server is addressed with a name that can be 
resolved by DNS. If the telecontrol server is addressed with its IP address, the 
"IF_CONF_TCS_IP_V4" field is used.

In STEP 7, the corresponding data is located in the "Mode" parameter area.

If there is more than one telecontrol server, use the field once per server.

Table 9-105 IF_CONF_TCS_Name

Parameter Data type Initial value Description
Id UINT 6 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 266
Mode UINT  Validity (1: permanent, 2: temporary)
TcsName - - - reserved -

STRING [254]  Name of the telecontrol server that can be resolved by DNS
RemotePort UINT  Port of the telecontrol server
Rank UINT  Priority of the server [1, 2]

1 = main telecontrol server,
2 = substitute telecontrol server

Field for the parameter area "Telecontrol server access"
This field is only used when the telecontrol server is addressed by its IP address. If the 
telecontrol server is addressed by its DNS name, the "IF_CONF_TCS_Name" field is used.

In STEP 7, the corresponding data is located in the "Mode" parameter area.

If there is more than one telecontrol server, use the field once per server.
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Table 9-106 IF_CONF_TCS_IP_v4

Parameter Data type Initial value Description
Id UINT 7 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 14
Mode UINT  Validity (1: permanent, 2: temporary)
RemoteAddress IP_V4  IP address of the telecontrol server
RemotePort UINT  Port of the telecontrol server
Rank UINT  Priority of the server [1, 2]

1 = main telecontrol server,
2 = substitute telecontrol server

Field for the "Mode" parameter area
In STEP 7, the corresponding data is located in the parameter areas "Mode" and Modem 
settings".

Table 9-107 IF_CONF_GPRS_Mode

Parameter Data type Initial value Description
Id UINT 8 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 10
Mode UINT  Validity (1: permanent, 2: temporary)
GPRSmode UINT  Mode of the CP:

● 0 = Telecontrol
● 1 = GPRS direct

TemporaryStation BOOL  Bit 0: Temporary connection
If this option is selected, the CP only establishes a 
temporary connection to send data. Once the frames have 
been transferred, the CP terminates the connection again.
● 1: activated (temporary connection)
● 0: deactivated (permanent connection)

SMS_Enabled BOOL  Bit 1: Allow SMS
Selecting the option allows the S7 station to send SMS 
messages.
● 1: activated (SMS allowed)
● 0: deactivated (no SMS)

Field for the "SMSC" parameter
In STEP 7, the corresponding data is located in the parameter area "Modem settings".

Table 9-108 IF_CONF_SMS_Provider

Parameter Data type Initial value Description
Id UINT 10 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 28
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Parameter Data type Initial value Description
Mode UINT  Validity (1: permanent, 2: temporary)
SMSProvider STRING [20]  Node number of the SMS center (SMSC) of the GSM 

network provider with which the contract was signed for 
this station.

Field for the "PIN" parameter
In STEP 7, the corresponding data is located in the parameter area "Modem settings".

Table 9-109 IF_CONF_PIN

Parameter Data type Initial value Description
Id UINT 11 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 16
Mode UINT  Validity (1: permanent, 2: temporary)
Pin STRING [8]  PIN of the SIM card inserted in the SIM card

The parameter is not relevant if the PIN was correctly 
configured. If the PIN was incorrectly configured, the 
correct PIN can be entered.

Field for monitoring times
In STEP 7, the corresponding data is located in the parameter areas "Keepalive timeout" and 
Operating mode".

Table 9-110 IF_CONF_TC_Timeouts

Parameter Data type Initial value Description
Id UINT 12 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 12
Mode UINT  Validity (1: permanent, 2: temporary)
KeepAliveTimeout ‑ ‑ - Reserved - (cannot be set)
SendTimeout UINT  Connection monitoring time: Monitoring time of the 

connection to the communications partner (seconds)
Relevant in the modes "Telecontrol" and "GPRS direct"

RedialTimeout UINT  Dialing repetition delay: Basic value for the wait time until 
the next attempt to establish a connection following an 
unsuccessful connection establishment. After every 3 
attempts, the basic value is doubled up to a maximum of 
900 s. Range of values: 10 to 600 s. If a substitute 
telecontrol server is configured, the CP attempts to connect 
to it at the 4th dialin attempt. Example: Basic value 20 
results in the following dialing intervals: three times 20 s, 
three times 40 s, three times 80 s etc. up to a maximum of 
900 s.
Not relevant for SMS connections
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Field for the "Wake up right" parameter area

Table 9-111 IF_CONF_WakeupList

Parameter Data type Initial value Description
Id UINT 13 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 246
Mode UINT  Validity (1: permanent, 2: temporary)
WakeupPhone [1...10] ARRAY 

[1...10] of 
STRING [22]

 Phone number subscriber authorized to wake up
The asterisk (*) at the end of a call number is used a 
placeholder for direct dialing numbers.

Field for the "Preferred GSM networks" parameter area

Table 9-112 IF_CONF_PrefProvider

Parameter Data type Initial value Description
Id UINT 14 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 46
Mode UINT  Validity (1: permanent, 2: temporary)
Provider [1...5] ARRAY [1...5] 

of STRING [6]
 Alternative GSM networks with priority 1 to 5 into which the 

CP dials. Up to 5 networks can be configured. No. 1 with 
highest priority, no. 5 with lowest priority.
Entry of the Public Land Mobile Network (PLMN) of the 
network provider consisting of Mobile Country Code (MCC) 
and Mobile Network Code (MNC).
Example (test network of Siemens AG): 26276

Field for the "DNS configuration" parameter area

Table 9-113 IF_CONF_DNS

Parameter Data type Initial value Description
Id UINT 16 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 14
Mode UINT  Validity (1: permanent, 2: temporary)
DNS_IP [1] IP_V4  IP address of the 1st domain name system server
DNS_IP [2] IP_V4  IP address of the 2nd domain name system server
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Field for the "Time-of-day synchronization" parameter area

Table 9-114 IF_CONF_NTP

Parameter Data type Initial value Description
Id UINT 17 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 24
Mode UINT  Validity (1: permanent, 2: temporary)
NTP_IP [1] ARRAY [1...4] 

of IP_V4
 IP address of NTP server 1

... ...  (IP address of NTP server 2...3)
NTP_IP [4] ARRAY [1...4] 

of IP_V4
 IP address of NTP server 4

Block for activating / deactivating TeleService users
SDT for activating or deactivating TeleService users already configured in the STEP 7 project 
of the CP. In STEP 7, the corresponding data can be found in the parameter area "TeleService 
settings" > "TeleService user management".

Table 9-115 IF_CONF_GPRS_UserList

Parameter Data type Initial value Description
Id UINT 19 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 506
Mode UINT  Validity (1: permanent, 2: temporary)
GPRS_User [1...10] ARRAY 

[1...10] of 
GPRS_User

 TeleService user no. 1 to max. no. 10

The array is formed from the parameter records for the TeleService users ("GPRS_User" 
[1...n]).

Table 9-116 GPRS_User [n] (parameter for TeleService user)

Parameter Data type Initial value Description
UserName [n] STRING [22]  TeleService user name
Password [n] STRING [22]  - The string must be empty! -
Diag_Allowed [n] BOOL  - Reserved - (cannot be set)
Teleserv_Allowed [n] BOOL  Activation of the TeleService user

● 0 = user is deactivated
● 1 = user is activated

FW_Load_Allowed [n] BOOL  - Reserved - (cannot be set)

Field for setting the parameters for TeleService access (DNS name of the server)
Access data of the TeleService server (switching station).

In STEP 7, the corresponding data is located in the parameter area "TeleService settings".
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If there is more than one TeleService server, use the field once per server.

Table 9-117 IF_CONF_TS_Name

Parameter Data type Initial value Description
Id UINT 20 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 266
Mode UINT  Validity (1: permanent, 2: temporary)
ts_name String [254]  Name of the TeleService server that can be resolved by 

DNS
RemotePort UINT  Port of the engineering station
Rank UINT  Priority of the server [1] or [2]

1 = server 1, 2 = server 2

Field for setting the parameters for TeleService access (IP address of the server)
Access data of the TeleService server (switching station).

In STEP 7, the corresponding data is located in the parameter area "TeleService settings".

If there is more than one TeleService server, use the field once per server.

Table 9-118 IF_CONF_TS_IF_V4

Parameter Data type Initial value Description
Id UINT 21 ID of the parameter field
Length UINT  Length of the parameter field in bytes: 14
Mode UINT  Validity (1: permanent, 2: temporary)
RemoteAddress IP_V4  IP address of the TeleService server
RemotePort UINT  Port of the TeleService server
Rank UINT  Priority of the server [1] or [2]

1 = server 1, 2 = server 2

Point-to-point

PORT_CFG: Configure communication parameters dynamically

Description    
The instruction "PORT_CFG" allows dynamic configuration of communications parameters for 
a point-to-point communications port.

You set up the original static configuration of the port in the hardware configuration. You can 
change this configuration by executing the "PORT_CFG" instruction. You can also use this 
function to save created blocks in libraries and to avoid configuration in the hardware 
configuration when you reuse it.

With "PORT_CFG" you can influence the following communications parameter settings:
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● Parity

● Baud rate

● Number of bits per character

● Number of stop bits

● Type and properties of flow control

The changes made by the "PORT_CFG" instruction are not stored permanently on the target 
system.

You can transfer serial data via the electrical connections RS-232 (half and full duplex) and 
RS-485 (half duplex).

Parameters
The following table shows the parameters of the "PORT_CFG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Activates the configuration change on a rising edge
PORT Input PORT 

(UINT)
D, L or constant Identification of the communication port (HW-ID)

PROTOCOL Input UINT I, Q, M, D, L or 
constant

Transmission protocol:
● 0: Point-to-point communication protocol
● 1..n: Future definition for specific transmission 

protocols
BAUD Input UINT I, Q, M, D, L or 

constant
Baud rate of the port:
● 1: 300 baud
● 2: 600 baud
● 3: 1200 baud
● 4: 2400 baud
● 5: 4800 baud
● 6: 9600 baud (default)
● 7: 19200 baud
● 8: 38400 baud
● 9: 57600 baud
● 10: 76800 baud
● 11: 115200 baud

PARITY Input UINT I, Q, M, D, L or 
constant

Parity of the port:
● 1: No parity (default)
● 2: Even parity
● 3: Odd parity
● 4: Mark parity
● 5: Space parity

DATABITS Input UINT I, Q, M, D, L or 
constant

Bits per character:
● 1: 8 bits per character (default)
● 2: 7 bits per character
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Parameter Declaration Data type Memory area Description
STOPBITS Input UINT I, Q, M, D, L or 

constant
Number of stop bits:
● 1: 1 stop bit (default)
● 2: 2 stop bits

FLOWCTRL Input UINT I, Q, M, D, L or 
constant

Data flow control:
● 1: None (default)
● 2: XON/XOFF
● 3: Hardware flow control (RTS always activated)
● 4: Hardware flow control (RTS can be deactivated 

during transmission)
XONCHAR Input CHAR D Indicates the character used as XON character. The 

character DC1 (11H) is set as default.
XOFFCHAR Input CHAR D Indicates the character used as XOFF character. The 

character DC3 (13H) is set as default.
WAITIME Input UINT I, Q, M, D, L or 

constant
Specifies the wait time for XON or CTS after the start 
of the transmission. 
The specified value must be greater than 0. 2000 
milliseconds are set as default.

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter

Error code*
(W#16#...)

Description

80A0 The specified protocol is invalid.
80A1 The specified baud rate is invalid.
80A2 The specified parity rate is invalid.
80A3 The specified number of bits per character is invalid.
80A4 The specified number of stop bits is invalid.
80A5 The specified type of flow control is invalid.
80A6 Incorrect value at the WAITTIME parameter

When the data flow control is enabled, the value at the WAITTIME parameter must be greater than zero.
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Error code*
(W#16#...)

Description

80A7 Invalid values at XONCHAR and XOFFCHAR parameters.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 2762)".

SEND_CFG: Configure serial transmission parameters dynamically

Description    
The instruction "SEND_CFG" allows dynamic configuration of serial transmission parameters 
for a point-to-point communications port. All the messages waiting for transfer are discarded 
after execution of SEND_CFG.

You set up the original static configuration of the port in the hardware configuration. You can 
change this configuration by executing the "SEND_CFG" instruction. You can also use this 
function to save created blocks in libraries and to avoid configuration in the hardware 
configuration when you reuse it. With "SEND_CFG" you can influence the following 
transmission parameter settings:

● Time between the activation of RTS (Request to Send) and the start of the transmission

● Time between the end of transmission and the deactivation of RTS

● Define bit times for breaks

The changes made by the "SEND_CFG" instruction are not stored permanently on the target 
system.

You can transfer serial data via the electrical connections RS-232 (half and full duplex) and 
RS-485 (half duplex).

Parameters
The following table shows the parameters of the "SEND_CFG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Activates the configuration change on a rising edge
PORT Input PORT

(UINT)
D, L or constant Identification of the communication port (HW-ID)

RTSONDLY Input UINT I, Q, M, D, L or 
constant

The time that should elapse after activating RTS until 
the start of transmission. 
Valid values for this parameter are as follows:
● 0 (default)
● 0 to 65535 ms in steps of 1 ms
This parameter does not apply to RS-485 modules. 
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Parameter Declaration Data type Memory area Description
RTSOFFDLY Input UINT I, Q, M, D, L or 

constant
Time that should elapse after the end of transmission 
until deactivation of RTS. 
Valid values for this parameter are as follows:
● 0 (default)
● 0 to 65535 ms in steps of 1 ms
This parameter does not apply to RS-485 modules.

BREAK Input UINT I, Q, M, D, L or 
constant

Specifies the bit times for a break, which are sent at 
the start of the message.
12 bit times are set as default. A maximum of 25000 
bit times can be specified.

IDLELINE Input UINT I, Q, M, D, L or 
constant

Specifies the bit times for idle line after the break at 
the start of the message.
12 bit times are set as default. A maximum of 25000 
bit times can be specified.

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter

Error code*
(W#16#...)

Description

80B0 The configuration of a transmission interruption is not permitted.
80B1 The specified break time exceeds the permitted maximum of 25000 bit times.
80B2 The specified time for idle line exceeds the permitted maximum of 25000 bit times.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 2762)".
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RCV_CFG: Configure serial receive parameters dynamically

Description    
The instruction "RCV_CFG" allows dynamic configuration of serial receive parameters for a 
point-to-point communications port. You can use this instruction to configure the conditions 
that specify the start and end of the message to be transmitted. The receipt of messages that 
correspond to these conditions can be enabled by the "RCV_PTP (Page 2757)" instruction.

You set up the original static configuration of the port in the properties of the hardware 
configuration. Execute the "RCV_CFG" instruction in your program to change the configuration. 
You can also use this function to save created blocks in libraries and to avoid configuration in 
the hardware configuration when you reuse it. The changes made by the "RCV_CFG" 
instruction are not stored permanently on the target system.

All the messages waiting for transfer are discarded after execution of the "RCV_CFG" 
instruction.

Parameters
The following table shows the parameters of the "RCV_CFG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Activates the configuration change on a 

rising edge.
PORT Input PORT (UINT) D, L or constant Identification of the communication port 

(HW-ID)
CONDITIONS Input CONDITIONS D, L Data structure defining the conditions for 

start and end of data transmission. 
DONE Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred.

STATUS Output WORD I, Q, M, D, L Status of the instruction

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Data type CONDITIONS
You can use the CONDITIONS structure to define the start and end conditions for the message 
transmission. The structure CONDITIONS is included in the instance DB of the "RCV_CFG" 
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instruction. Use the structure CONDITIONS to define the start and end conditions when the 
transmission of a message is complete and when the next message transfer is to start:

● You define the start conditions for the data transfer in the START structure.

● You define the end conditions for the data transfer in the END structure.

You can define one or more start and end conditions for this. If you specify multiple start or 
end conditions these are linked by an OR logic instruction.

The following table shows the "CONDITIONS" structure:

Parameters Data type Description
START STRUCT Start conditions
 STARTCOND UINT Specifies the start condition (details, see below).

The start condition can be specified as a 16-bit hexadecimal value. Possible values 
for the start condition are:
● 1: Start character
● 2: Any character (default)
● 4: Line break
● 8: Idle line
● 16: Character string 1
● 32: Character string 2
● 64: Character string 3
● 128: Character string 4
Multiple start conditions can also be defined at the STARTCOND parameter. The 
total from the values of the individual conditions is specified for this. If, for example, 
you want to define "Idle line" OR "Character string 1" OR "Character string 4" as 
start condition, the value "152" must be specified.

IDLETIME UINT Specifies the maximum idle time of the line before receipt is started. 
Valid values for this parameter are as follows:
● 40 bit times (default)
● 0 to 2500 bit times

STARTCHAR BYTE Specifies the start character. This setting is only enabled when the configured start 
condition is "Start character".
Valid values for this parameter are as follows:
● 02 (STX): Default setting
● B#16#00 to B#16#FF

SEQ[1].CTL BYTE Character string 1: Control sequence for each character 
You can use the bit position of the character to define which characters of the 
character string will be considered or ignored. To evaluate the characters, the 
corresponding bits have to be set. 
● Bit 0: 1 character
● Bit 1: 2 characters
● Bit 2: 3 characters
● Bit 3: 4 characters
● Bit 4: 5 characters
A character is ignored when the corresponding bit is reset.

SEQ[1].STR CHAR[5] Character string 1: Start character (5 characters)
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Parameters Data type Description
SEQ[2].CTL BYTE Character string 2: Ignore/compare control sequence for each character
SEQ[2].STR CHAR[5] Character string 2: Start character (5 characters)
SEQ[3].CTL BYTE Character string 3: Ignore/compare control sequence for each character
SEQ[3].STR CHAR[5] Character string 3: Start character (5 characters)
SEQ[4].CTL BYTE Character string 4: Ignore/compare control sequence for each character
SEQ[4].STR CHAR[5] Character string 4: Start character (5 characters)

END STRUCT End conditions
 ENDCOND UINT Specifies the end condition (details, see below).

The end condition can be specified as a 16-bit hexadecimal value. Possible values 
for the end condition are:
● 1: Reply timeout
● 2: Message timeout
● 4: Timeout within the character string
● 8: Maximum length
● 16: N+LEN+M; the information on the message length in integrated in the 

message and will be evaluated.
● 32: Character string 1
Multiple end conditions can also be defined at the ENDCOND parameter. The total 
from the values of the individual end conditions is specified for this. If, for example, 
you want to define the end condition "Maximum length" OR "Sequence 1", the 
value "40" must be specified.

MAXLEN UINT Specifies the maximum number of characters in a message. 
Valid values* for this parameter are as follows:
● 1 character (default)
● 0 to 1024 characters
This setting is only enabled if the "Maximum length" end condition is set at the 
ENDCOND parameter.

N UINT Offset of the length field in the message
Valid values for this parameter are as follows:
● 0 characters (default)
● 0 to 1024 characters
This setting is only enabled if the "N+LEN+M" end condition is set at the 
ENDCOND parameter.

LENGTHSIZE UINT Size of the length field in bytes
Valid values* for this parameter are as follows:
● 0 bytes (default)
● 1 byte
● 2 bytes
● 4 bytes
This setting is only enabled if the "N+LEN+M" end condition is set at the 
ENDCOND parameter.
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Parameters Data type Description
LENGTHM UINT Specifies the number of end characters that follow the length field but are not 

contained in the length of the message. 
Valid values for this parameter are as follows:
● 0 characters (default)
● 0 to 255 characters
This setting is only enabled if the "N+LEN+M" end condition is set at the 
ENDCOND parameter.

RCVTIME UINT Specifies the maximum duration for the receipt of the first character of a message.
Valid values for this parameter are as follows:
● 200 ms (default)
● 0 to 65535 ms in steps of 1 ms
This setting is only enabled if the "Reply timeout" end condition is set at the 
ENDCOND parameter.

MSGTIME UINT Specifies the maximum duration of the receipt of a message. 
Valid values for this parameter are as follows:
● 200 ms (default)
● 0 to 65535 ms in steps of 1 ms
This setting is only enabled if the "Message timeout" end condition is set at the 
ENDCOND parameter. 

CHARGAP UINT Specifies the time interval between received consecutive characters.
Valid values for this parameter are as follows:
● 12 bit times (default)
● 0 to 2500 bit times
This setting is only enabled if the "Timeout within the character string" end 
condition is set at the ENDCOND parameter.

SEQ.CTL BYTE Character string: Control sequence for each character 
You can use the bit position of the character to define which characters of the 
character string will be considered or ignored. To evaluate the characters, the 
corresponding bits have to be set. 
● Bit 0: 1 character
● Bit 1: 2 characters
● Bit 2: 3 characters
● Bit 3: 4 characters
● Bit 4: 5 characters
A character is ignored when the corresponding bit is reset.

SEQ.STR CHAR[5] Character string: Start character (5 characters)
* These value ranges also apply to the corresponding hardware settings for specifying the end of message.
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Start conditions for the message receipt (STARTCOND parameter)
The start of the message is recognized by the receiver if a configured start condition applies. 
The following conditions can be defined as start conditions for message receipt:

● Start character: The start of a message is recognized when a certain character occurs. This 
character is stored as first character of the message. All characters received before the 
start character are rejected.

● Any character: Any character can define the start of a message. This character is stored 
as first character of the message.

● Line break: The start of a message is recognized if the received data stream is interrupted 
for longer than one character length.

● Idle line: The start of a message is recognized when the send transmission line is in the 
idle state for a certain time (specified in bit times) followed by renewed transmission of 
characters.

● Character string (sequence): The start of a message is recognized when a specified 
character sequence occurs in the data stream. You can specify up to four character 
sequences with up to five characters each.
Example: A received hexadecimal message includes the following characters: "68 10 aa 
68 bb 10 aa 16". The configured start character sequences are listed in the following
table. Start character sequences will be evaluated once the first character 68H
has been received successfully. After the fourth character has been received successfully 
(the
second 68H), the start condition "1" has been met. Once the start conditions have been 
met,
evaluation of the end conditions will start.
Processing of the start character sequence can end due to different errors in parity,
framing or time intervals between characters. These errors will prevent
reception of the message, because the start condition has not
been met.

Start condition First character First character +1 First character +2 First character +3 First character +4
1 68H xx xx 68H xx
2 10H aaH xx xx xx
3 dcH aaH xx xx xx
4 e5H xx xx xx xx
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End conditions for the message receipt (ENDCOND parameter)
The start of a message is recognized by the receiver if a configured end condition applies. The 
following conditions can be defined as end conditions for message receipt:

● Reply timeout: The receipt of messages will end when the specified maximum duration for 
the receipt of a character is exceeded. The maximum duration is defined at the RCVTIME 
parameter. The defined time starts to run down as soon at the last transmission is completed 
and the RCV_PTP instruction enables the receipt of the message. If no character was 
received within the defined time (RCVTIME), the RCV_PTP instruction reports an error.

● Message timeout: The receipt of messages will end when the specified maximum duration 
for the receipt of a message is exceeded. The maximum duration is defined at the 
MSGTIME parameter. The defined time starts to run down as soon as the first character of 
the message is received.

● Timeout within the character string: The receipt of messages will end when the time interval 
between the receipt of two consecutive characters is longer than the value at the CHARGAP 
parameter.

● Maximum length: The receipt of messages will end when the length of the message defined 
at the MAXLEN  parameter is exceeded.

● Reading message length (N+LEN+M): The receipt of messages will end when a certain 
message length is reached. This length is calculated by the values of the following 
parameters:

– N: Position of the character in the message from which the length field begins.

– LENGTHSIZE: Size of the length field in bytes

– LENGTHM: Number of end characters that follow the length field. These characters are 
not taken into account in the evaluation of the message length.

● Character string: The receipt of messages will end when a defined character sequence is 
received. The character string can contain a maximum of five characters. For each 
character of the character string, you can use the bit position to define if this will be 
considered or ignored in the evaluation.

STATUS parameter

Error code*
(W#16#...)

Description

80C0 Error in start condition
80C1 ● Error in end condition

● No end condition defined
80C2 Receive interrupt enabled
80C3 A value that is equal to 0 or greater than 4132 was entered at the MAXLEN parameter while the "Maximum 

length" end condition was set.
80C4 A value that is greater than 4131 was entered at the N parameter while the "N+LEN+M" end condition was 

set.
80C5 A value that is equal to 0 or invalid was entered at the LENGTHSIZE parameter while the "N+LEN+M" end 

condition was set.
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Error code*
(W#16#...)

Description

80C6 A value that is greater than 255 was entered at the LENGTHM parameter while the "N+LEN+M" end condition 
was set.

80C7 A message length greater than 4132 was calculated while the "N+LEN+M" end condition was set.
80C8 A value that is equal to 0 was entered at the RCVTIME parameter while the "Reply timeout" end condition 

was set.
80C9 A value that is equal to 0 or greater than 2500 was entered at the CHARGAP parameter while the "Timeout 

within a character string" end condition was set.
80CA A value that is equal to 0 or greater than 2500 was entered at the IDLETIME parameter while the "Idle line" 

start condition was set.
80CB All characters of the character string are marked as "Don't care" even though "Character string" is set as 

the end condition.
80CC All characters of the character string are marked as "Don't care" even though "Character string" is set as 

the start condition.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 2762)".

SEND_PTP: Transmit send buffer data

Description    
You use the "SEND_PTP" instruction to start the transmission of data. The "SEND_PTP" 
instruction does not execute the actual transmission of the data. The data of the send buffer 
is transmitted to the relevant point-to-point communication module (CM). The CM executes 
the actual transmission.

Parameters
The following table shows the parameters of the "SEND_PTP" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Enables the requested transmission on a rising edge 

of this enable input. The content of buffer is 
transmitted to the point-to-point communication 
module (CM).

PORT Input PORT 
(UINT)

D, L or constant Identification of the communication port (HW-ID)

BUFFER Input VARIANT I, Q, M, D, L or 
constant

Pointer to the start address of the send buffer. 
Boolean values or Array of BOOL are not supported.

LENGTH Input UINT I, Q, M, D, L or 
constant

Length of the send buffer
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Parameter Declaration Data type Memory area Description
PTRCL Input BOOL I, Q, M, D, L or 

constant
This parameter selects the buffer for normal point-to-
point communication or for specific Siemens 
protocols implemented in the connected CM.
FALSE = point-to-point operations controlled by the 
user program (only valid option)

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter

Error code*
(W#16#...)

Description

7000 The send operation is not active.
7001 The send operation is processing the first call.
7002 The send operation is processing subsequent calls (queries following the first call).
8080 The identifier entered for the communications port number is invalid.
8088 The length of the LENGHT parameter does not correspond to the length of data to be sent. See also: 

Parameters LENGHT and BUFFER.
80D0 A new send request was received while a transmission was taking place.
80D1 The transmission was interrupted because the CTS signal was not confirmed within the specified wait 

time.
80D2 The send request was interrupted because the communications partner (DCE) signaled that it was not 

willing to receive (DSR).
80D3 The send request was interrupted because the maximum size of the waiting loop was exceeded (more 

than 1024 Byte).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 2762)".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2756 System Manual, 07/2013,  



Parameters LENGTH and BUFFER
The minimum data size that can be sent by the "PTP_SEND" instruction is one byte. The 
parameter BUFFER defines the size of the data to be sent. You can use neither the BOOL nor 
the Array of BOOL data type for the BUFFER parameter. 

LENGTH parameter BUFFER parameter Description
LENGTH = 0 Not used The complete data is sent as defined by the BUFFER parameter. If 

LENGTH = 0, you do not need to specify the number of bytes 
transferred.

LENGTH > 0 Elementary data type The LENGTH value must contain the byte count of this data type. 
Otherwise, data is not transferred and error 8088 is output.

STRUCT The LENGTH value can contain a byte count that is smaller than 
the complete byte length of the structure. In this case, only the first 
LENGTH bytes are transferred.

ARRAY The LENGTH value can contain a byte count that is smaller than 
the complete byte length of the field. In this case, only the field 
elements that fit completely in the LENGTH bytes are transferred.
The LENGTH value must be a multiple of the byte count of the data 
elements. Otherwise, STATUS = 8088, ERROR = 1, and no data is 
transferred.

STRING The complete memory arrangement of the character sequence 
format will be transmitted as well as the information about maximum 
length of the character string and the actual length of the character 
string.
The LENGTH value must contain bytes for maximum length, actual 
length, and the characters of the character string. 
With the data type STRING, all lengths and characters have the size 
of one byte.
If a character string is used for the BUFFER parameter, the 
LENGTH value must also contain two bytes for the two length fields.

RCV_PTP: Enable receive messages

Description    
With the RCV_PTP instruction you enable receipt of a sent message. Each message must be 
enabled individually. The sent data is only available in the receive area when the message 
has been acknowledged by the relevant communications partner.

Parameters
The following table shows the parameters of the "RCV_PTP" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L Enables receipt on a rising edge 
PORT Input PORT 

(UINT)
D, L or constant Identification of the communication port (HW-ID)
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Parameter Declaration Data type Memory area Description
BUFFER Input VARIANT I, Q, M, D, L or 

constant
Points to the start address of the receive buffer. Do not 
use a tag of the type STRING in the receive buffer.

NDR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction
LENGTH Output UINT I, Q, M, D, L Length of the message in the receive buffer

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter

Error code*
(W#16#....)

Description

80E0 Receipt of messages was terminated because the receive buffer is full.
80E1 Receipt of messages was terminated as a result of a parity error.
80E2 Receipt of messages was terminated as a result of a framing error. 
80E3 Receipt of messages was terminated as a result of an overflow error.
80E4 Receipt of messages was terminated because the calculated message length (N+LEN+M) exceeds the 

size of the receive buffer.
8080 The identifier entered for the communications port number is invalid.
8088 A data type STRING is referenced via the BUFFER parameter. 
0094 Receipt of messages was terminated because the maximum character length was received.
0095 Receipt of messages was terminated as a result of a timeout. 
0096 Receipt of messages was terminated because of a timeout within the character string.
0097 Receipt of messages was terminated as a result of a reply timeout.
0098 Receipt of messages was terminated because the "N+LEN+M" length condition has been satisfied.
0099 Receipt of messages was terminated because the character string defined as the end condition was 

received.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 2762)".
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RCV_RST: Delete receive buffer

Description    
With the "RCV_RST" instruction, you delete the receive buffer of a communications partner.

Parameters
The following table shows the parameters of the "RCV_RST" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Enables deleting of the receive buffer on a rising 

edge
PORT Input PORT (UINT) D, L or constant Identification of the communication port (HW-ID)
DONE Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction
You will find more detailed information on general 
error codes of the communication instructions in: 
"General status information of the communications 
blocks (Page 2762)".

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

SGN_GET: Query RS-232 signals

Description     
With the "SGN_GET" instruction, you query the current state of several signals of an RS-232 
communications module.

Parameters
The following table shows the parameters of the "SGN_GET" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Enables the query on a rising edge

PORT Input PORT (UINT) D, L or constant Identification of the communication port (HW-ID)
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Parameter Declaration Data type Memory area Description
NDR Output BOOL I, Q, M, D, L Is set for one cycle if new data are ready for 

sending and the instruction was executed error-
free.

DTR Output BOOL I, Q, M, D, L Data terminal ready, module ready
DSR Output BOOL I, Q, M, D, L Data set ready, communications partner ready
RTS Output BOOL I, Q, M, D, L Send request, module ready to send
CTS Output BOOL I, Q, M, D, L Clear to send, communications partner can 

receive data (reaction to RTS = ON of the 
module).

DCD Output BOOL I, Q, M, D, L Data carrier detect, received signal level
RING Output BOOL I, Q, M, D, L Ring display, display of an incoming call
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter

Error code*
(W#16#....)

Description

80F0 The communication module is an RS-485 module and no signals are available.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 2762)".

SGN_SET: Set RS-232 signals

Description     
With the "SGN_SET" instruction, you set the status of the output signals of an RS-232 
communications module.
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Parameters
The following table shows the parameters of the "SGN_SET" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Activates the action on a rising edge
Initial value: FALSE

PORT Input PORT (UINT) D, L or constant Identification of the communication port (HW-ID)
Initial value: 0

SIGNAL Input BYTE I, Q, M, D, L or 
constant

Specifies the signals to be set:
● Set 01H = RTS
● Set 02H = DTR
● Set 04H = DSR
Initial value: FALSE

RTS Input BOOL I, Q, M, D, L or 
constant

Send request, module ready to send
Initial value: FALSE

DTR Input BOOL I, Q, M, D, L or 
constant

Data terminal ready, module ready
Initial value: FALSE

DSR Input BOOL I, Q, M, D, L or 
constant

Data set ready (applies only to interfaces of the 
DCE type)
Initial value: FALSE

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors
Initial value: FALSE

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred
Initial value: FALSE

STATUS Output WORD I, Q, M, D, L Status of the instruction
Initial value: 0

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter

Error code*
 (W#16#...)

Description

80F0 The communication module is an RS-485 module and no signals are available.
80F1 No signals are settable because H/W flow control is enabled.
80F2 The DSR signal cannot be set because the module is a DTE device.
80F3 The DTR signal cannot be set because the module is a DCE device.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 2762)".

General status information of the communications blocks

General information on execution status of the communications blocks
The following table shows which general information can be output at the STATUS parameter 
of the communications blocks:

Error code*
(W#16#....)

Description

8070 All internal instance memory is in use
8080 The identifier entered for the communications port is invalid
8081 Timeout, module error, internal error
8085 Error specifying the length at the LENGHT parameter. The specified length is "0" or greater than the 

maximum permitted value.
8090 Message length invalid, module invalid, message invalid
8091 Incorrect version in parameterization message
8092 Invalid record length in parameterization message
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

USS

Overview of USS instructions

Introduction  
The USS instructions control the operation of drives that support the universal serial interface 
(USS). With the USS instructions, you can communicate with more than one drive via an 
RS-485 connection.

To do this, you require a CM 1241 RS-485 communications module or a CB 1241 RS-485 
communications board. Up to three CM 1241 RS-485 modules and one CB 1241 RS-485 board 
can be installed in an S7-1200 CPU.

Each RS-485 port can operate up to sixteen drives. 

The USS protocol uses a master/slave network for communication via a serial bus. The master 
uses an address parameter to send a message to a selected slave. A slave itself can never 
send without previously receiving a request. Direct exchange of messages between slaves is 
not possible. USS communication works in half duplex mode.

The following figure shows an example of a USS network diagram:
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Requirements for using the USS protocol

General requirements for setting up a drive
● The use of 4 PKW words must be set up for the drives.

● The drives can be configured for 2, 4, 6 or 8 PZD words.

● The number of PZD words in the drive must correspond to the PZD_LEN input of the 
"USS_DRIVE (Page 2767)" instruction of the drive.

● The baud rate of all drives must match the baud rate of the BAUD input parameter of the 
"USS_PORT (Page 2766)" instruction.

● The drive must be set up for remote control.

● USS must be specified for the desired frequency value on the COM connection of the drive.

● 1 to 16 must be set as the drive address. This address must correspond to the address of 
the DRIVE input parameter of the "USS_DRIVE (Page 2767)" instruction.

● To control the direction of the drive, the polarity of the drive desired value must be set up.

● The RS-485 network must be connected correctly.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2763



Definition: PKW / PZD area
● The PKW area relates to the handling of the parameter-identifier-value interface.

The PKW interface is not a physical interface but describes a mechanism that controls the 
exchange of parameters between two communications partners, in other words, reading 
and writing parameter values, parameter descriptions and corresponding texts and the 
handling of parameter changes due to spontaneous messages. All the tasks handled via 
the PKW interface are essentially tasks for operator control and monitoring, service and 
diagnostics.

● The PZD area includes the signals required for automation:

– Control word(s), and setpoint(s) from the master to the slave

– Status word(s), and actual value(s) from the slave to the master.

Both areas together result in the user data field. This is transferred by the master to the slave 
as a job frame or by the slave to the master as a reply frame.

Description   
Each communication module CM 1241 RS485 supports a maximum of 16 drives. A single 
instance data block contains temporary memory and buffer functions for all drives in the USS 
network that are connected to a PtP communications module you installed. The USS 
instructions for these drives have shared access to the information in this data block.
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● All drives (max. 16) that are connected to an  RS485 port are part of the same USS network. 
All drives that are connected to a different RS485 port are part of a different USS network. 
As the S7-1200 supports up to three CM 1241 RS485 modules, you can set up up to three 
USS networks, each having a maximum of 16 drives, thus a total of 48 USS drives are 
supported.

● Each USS network is managed via a unique data block (three data blocks are required for 
three USS networks with three CM 1241 RS485 modules). All instructions that belong to a 
USS network must share this data block. This includes all "USS_DRIVE (Page 2767)", 
"USS_PORT (Page 2766)", "USS_RPM (Page 2770)", and "USS_WPM (Page 2771)" 
instructions for controlling all drives in a USS network.

● The instruction "USS_DRIVE (Page 2767)" is a function block (FB). When you insert the 
instruction "USS_DRIVE" in the editor, the "Call options" dialog will ask you to assign a DB 
to the instruction.

– If this is the first "USS_DRIVE" instruction in this program for this USS network, you can 
accept the default DB assignment (or, if necessary, change the name) and the new DB 
will be created.

– If, however, this is not the first "USS_DRIVE" instruction for this network, you must select 
the DB that was previously assigned to this USS network in the drop-down list in the 
"Call options" dialog.

● All "USS_PORT (Page 2766), USS_RPM (Page 2770)", and "USS_WPM (Page 2771)" 
instructions are functions (FCs). When you insert these FCs in the editor, no DB is assigned. 
Instead, you have to assign the DB in question to the USS_DB input of these instructions 
(double-click on the parameter field and then on the icon to display the available DBs).

● The instruction "USS_PORT (Page 2766)" controls communication between the CPU and 
the drives via the PtP communications module. Whenever this instruction is called, 
communication with a drive is processed. Your program must call this function quickly 
enough so that the drives do not report a timeout. The instruction can be called from the 
main program or any interrupt OB.

● The function block "USS_DRIVE (Page 2767)" gives your program access to a specified 
drive in the USS network. Its inputs and outputs correspond to the states and operating 
functions of the drive. If there are 16 drives in the network, "USS_DRIVE" must be called 
at least 16 times in your program, i.e., once for each drive. How quickly these blocks are 
called depends on the required speed for controlling drive functions.
You can only call the instruction "USS_DRIVE" from the main program OB.

 

 
 CAUTION

Call "USS_DRIVE", "USS_RPM", "USS_WPM" only from the main program OB. The 
instruction "USS_PORT" can be called from any OB, it is usually called from a time-delay 
interrupt OB. If the instruction "USS_PORT" is interrupted during execution, this may result 
in unexpected errors.

 

The "USS_RPM" and "USS_WPM" instructions are used to read and write the operating 
parameters of the drive. These parameters control the internal mode of operation of the drive. 
A definition of these parameters can be found in the drive manual.
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Your program may also contain any number of these instructions; however only one read or 
write request can be active for a drive. You may only call the instructions "USS_RPM" and 
"USS_WPM" from the main program OB.

Calculating the time for communication with the drive
Communication with the drive is runs asynchronous to the cycle of the S7-1200. The S7-1200 
runs through several cycles before communication with a drive is completed.

The interval of "USS_PORT" is the time required for a drive transaction. The following table 
shows the minimum intervals for "USS_PORT" for each baud rate. Calling the "USS_PORT" 
more frequently than the "USS_PORT" interval will not increase the number of transactions. 
The timeout interval of the drive is the period of time available to a transaction if 3 attempts 
are required to complete the transaction due to communications errors. By default, up to 2 
further attempts are made for each transaction with the USS protocol.

Baud rate Calculated minimum interval for calling 
USS_PORT (ms) 

Drive message interval timeout per 
drive (ms)

1200 790 2370
2400 405 1215
4800 212.5 638
9600 116.3 349
19200 68.2 205
38400 44.1 133
57600 36.1 109
115200 28.1 85

USS_PORT: Edit communication via USS network

Description     
The "USS_PORT" instruction handles communication over the USS network. In the program, 
use one "USS_PORT" instruction per PtP communications port to control the transmission to 
or from one drive. 

All USS instructions that are assigned to one USS network and one PtP communications port 
must use the same instance data block. 

Call
Your program must execute the "USS_PORT" instruction often enough to prevent timeouts in 
the drive. You should therefore call the "USS_PORT" instruction from a cyclic interrupt OB to 
prevent drive timeouts and keep the most recent USS data updates available for 
"USS_DRIVE (Page 2767)" calls.
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Parameters
The following table shows the parameters of the "USS_PORT" instruction:

Parameter Declaration Data type Memory area Description
PORT Input PORT D, L or constant PtP communications port identifier

Constant that can be referenced within the 
"Constants" tab of the default tag table.

BAUD Input DINT I, Q, M, D, L or 
constant

Baud rate for USS communication.

USS_DB InOut USS_BASE D Reference to the instance DB of the "USS_DRIVE 
(Page 2767)" instruction.

ERROR Output BOOL I, Q, M, D, L ERROR is set to TRUE if an error occurs. A 
corresponding error code will be output at the 
STATUS output.

STATUS 
(Page 2772) 

Output WORD I, Q, M, D, L Status value of the request. It indicates the result of 
the cycle or initialization. Additional information is 
available in the "USS_Extended_Error (Page 2772)" 
tag for some status codes.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

USS_DRIVE: Swap data with drive

Description     
The "USS_DRIVE" instruction exchanges data with the drive by creating request messages 
and interpreting the drive response messages. A separate instruction must be used for each 
drive, but all USS instructions assigned to one USS network and one PtP communications 
module must use the same instance data block. You must create the DB name when you place 
the first "USS_DRIVE" instruction. Then reuse this DB that was created when the initial 
instruction was inserted.

When the "USS_DRIVE" instruction is executed the first time, the drive indicated by the USS 
address (parameter DRIVE) is initialized in the instance DB. After this initialization, subsequent 
"USS_PORT (Page 2766)" instructions can start communication with the drive at this drive 
number. 

Changing the drive number requires a PLC STOP to RUN mode transition that initializes the 
instance DB. Input parameters are configured in the USS send buffer, and outputs are read 
from a "previous" valid response buffer if any exists. There is no data transmission during 
execution of the "USS_DRIVE" instruction. Communication with the drives takes place when 
"USS_PORT (Page 2766)" is executed. "USS_DRIVE" only configures the messages to be 
sent and interprets data received in a previous request.

You can control the drive direction of rotation using either the DIR (BOOL) input or using the 
sign (positive or negative) at the SPEED_SP (REAL) input. The following table explains how 
these inputs work together to determine the drive direction, assuming the motor is wired for 
forward rotation.
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SPEED_SP DIR Direction of rotation of drive
Value > 0 0 Reverse
Value > 0 1 Forward
Value < 0 0 Forward
Value < 0 1 Reverse

Parameters
Expand the box to display all the parameters by clicking the  bottom of the box. The parameter 
connections that are grayed are optional and do not need to be assigned.

The following table shows the parameters of the "USS_DRIVE" instruction:

Parameter Declaration Data type Memory area Description
RUN Input BOOL I, Q, M, D, L or 

constant
Drive start bit: If this parameter has the value TRUE, 
this input enables the drive to run at the preset speed.

OFF2 Input BOOL I, Q, M, D, L or 
constant

"Electrical stop" bit: If this parameter has the value 
FALSE, this bit cause the drive to coast to a stop 
without braking.

OFF3 Input BOOL I, Q, M, D, L or 
constant

Fast stop bit - If this parameter has the value FALSE, 
this bit causes a fast stop by braking the drive.

F_ACK Input BOOL I, Q, M, D, L or 
constant

Fault acknowledge bit - This bit resets the fault bit on 
a drive. This bit is set after the fault is cleared to 
indicate to the drive that it no longer needs to indicate 
the previous fault.

DIR Input BOOL I, Q, M, D, L or 
constant

Drive direction control - This bit is set to indicate that 
the direction is forward (when SPEED_SP is positive).

DRIVE Input USINT I, Q, M, D, L or 
constant

Drive address: This input is the address of the USS 
drive. The valid range is drive 1 to drive 16.

PZD_LEN Input USINT I, Q, M, D, L or 
constant

Word length - This is the number of words of PZD 
data. Valid values are 2, 4, 6, or 8 words. The default 
is 2.

SPEED_SP Input REAL I, Q, M, D, L or 
constant

Speed setpoint - This is the speed of the drive as a 
percentage of configured frequency. A positive value 
specifies forward direction (when DIR has the value 
TRUE).

CTRL3 Input WORD I, Q, M, D, L or 
constant

Control word 3 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

CTRL4 Input WORD I, Q, M, D, L or 
constant

Control word 4 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

CTRL5 Input WORD I, Q, M, D, L or 
constant

Control word 5 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

CTRL6 Input WORD I, Q, M, D, L or 
constant

Control word 6 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive.
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Parameter Declaration Data type Memory area Description
CTRL7 Input WORD I, Q, M, D, L or 

constant
Control word 7 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

CTRL8 Input WORD I, Q, M, D, L or 
constant

Control word 8 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

NDR Output BOOL I, Q, M, D, L New data ready - If this parameter has the value 
TRUE, the bit indicates that the output contains data 
from a new communication request.

ERROR Output BOOL I, Q, M, D, L Error occurred - If this parameter has the value TRUE, 
this indicates that an error has occurred and the 
STATUS output is valid. All other outputs are set to 
zero on an error. Communication errors are only 
reported at the ERROR and STATUS outputs of the 
"USS_PORT" instruction.

STATUS 
(Page 2772) 

Output WORD I, Q, M, D, L Status value of the request. It indicates the result of 
the cycle. This is not a status word returned from the 
drive.

RUN_EN Output BOOL I, Q, M, D, L Run enabled - This bit indicates whether the drive is 
running.

D_DIR Output BOOL I, Q, M, D, L Drive direction - This bit indicates whether the drive 
is running forward.

INHIBIT Output BOOL I, Q, M, D, L Drive inhibited - This bit indicates the state of the 
inhibit bit on the drive.

FAULT Output BOOL I, Q, M, D, L Drive fault - This bit indicates that the drive has 
registered a fault. The user must eliminate the fault 
and then set the F_ACK bit to clear this bit.

SPEED Output REAL I, Q, M, D, L Drive current speed (scaled value of drive status word 
2) - The value of the speed of the drive as a 
percentage of configured speed.

STATUS1 Output WORD I, Q, M, D, L Drive status word 1 - This value contains fixed status 
bits of a drive.

STATUS3 Output WORD I, Q, M, D, L Drive status word 3 - This value contains a user-
configurable status word on the drive.

STATUS4 Output WORD I, Q, M, D, L Drive status word 4 - This value contains a user-
configurable status word on the drive.

STATUS5 Output WORD I, Q, M, D, L Drive status word 5 - This value contains a user-
configurable status word on the drive.

STATUS6 Output WORD I, Q, M, D, L Drive status word 6 - This value contains a user-
configurable status word on the drive.

STATUS7 Output WORD I, Q, M, D, L Drive status word 7 - This value contains a user-
configurable status word on the drive.

STATUS8 Output WORD I, Q, M, D, L Drive status word 8 - This value contains a user-
configurable status word on the drive.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".
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USS_RPM: Readout parameters from the drive

Description
The "USS_RPM" instruction reads a parameter from the drive. All USS functions that are 
assigned to one USS network and one PtP communications module must use the same 
instance data block. "USS_RPM" must be called from the main program OB. 

Parameter
The following table shows the parameters of the "USS_RPM" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Send request: If this parameter has the value TRUE, 

it indicates that a new read request is desired. This is 
ignored if the request for this parameter is already 
pending. 

DRIVE Input USINT I, Q, M, D, L or 
constant

Drive address: This input is the address of the USS 
drive. The valid range is drive 1 to drive 16.

PARAM Input UINT I, Q, M, D, L or 
constant

Parameter number: This input specifies which drive 
parameter is written. The range of this parameter is 0 
to 2047. See your drive manual for details on how to 
access any parameters above this range.

INDEX Input UINT I, Q, M, D, L or 
constant

Parameter index: This input specifies which drive 
parameter index is to be written. This is a 16-bit value 
where the least significant byte is the actual index 
value with a range of (0 to 255). The most significant 
byte may also be used by the drive and is drive-
specific. See your drive manual for additional 
information.

USS_DB InOut USS_BASE D Reference to the instance DB that is created and 
initialized when a "USS_DRIVE" instruction is 
inserted in your program.

DONE Output BOOL I, Q, M, D, L If this parameter has the value TRUE, it indicates that 
the VALUE output holds the previously requested 
read parameter value. 
This bit is set when the "USS_DRIVE" instruction 
recognizes the read response from the drive. 
This bit is reset when either:
● you request the response data via another 

"USS_RPM" poll
 or 

● the second of the next two calls of "USS_DRIVE 
(Page 2767)" is executed

ERROR Output BOOL I, Q, M, D, L Error occurred - If this parameter has the value TRUE, 
this indicates that an error has occurred and the 
STATUS output is valid. All other outputs are set to 
zero on an error. Communication errors are only 
reported at the ERROR and STATUS outputs of the 
"USS_PORT (Page 2766)" instruction.
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Parameter Declaration Data type Memory area Description
STATUS 
(Page 2772) 

Output WORD I, Q, M, D, L This is the status value of the request. It indicates the 
result of the read request. Additional information is 
available in the "USS_Extended_Error (Page 2772)" 
tag for some status codes.

VALUE Output VARIANT I, Q, M, D, L This is the value of the parameter that was read and 
is valid only when the DONE bit has the value TRUE.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

USS_WPM: Change parameters in the drive

Description
The "USS_WPM" instruction modifies a parameter in the drive. All USS functions that are 
assigned to one USS network and one PtP communications module must use the same 
instance data block. "USS_WPM" must be called from the main program OB.

 

 Note
EEPROM write operations

Beware of overusing the EEPROM write operation. Minimize the number of EEPROM write 
operations to extend the EEPROM life. 

 

Parameter
The following table shows the parameters of the "USS_WPM" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Send request: If this parameter has the value TRUE, it 

indicates that a new write request is desired. This is 
ignored if the request for this parameter is already 
pending. 

DRIVE Input USINT I, Q, M, D, L or 
constant

Drive address: This input is the address of the USS 
drive. The valid range is drive 1 to drive 16.

PARAM Input UINT I, Q, M, D, L or 
constant

Parameter number: This input specifies which drive 
parameter is written. The range of this parameter is 0 to 
2047. See your drive manual for details on how to 
access any parameters above this range. 

INDEX Input UINT I, Q, M, D, L or 
constant

Parameter index: This input specifies which drive 
parameter index is to be written. This is a 16-bit value 
where the least significant byte is the actual index value 
with a range of (0 to 255). The most significant byte may 
also be used by the drive and is drive-specific. See your 
drive manual for additional information.
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Parameter Declaration Data type Memory area Description
EEPROM Input BOOL I, Q, M, D, L or 

constant
Store to drive EEPROM: If this parameter has the value 
TRUE, values written to the drive parameter will be 
stored in the drive EEPROM. If this parameter has the 
value FALSE, the value written is only temporarily saved 
and will be lost the next time the drive is switched on. 

VALUE Input VARIANT I, Q, M, D, L or 
constant

The value of the parameter that is to be written. It must 
be valid on the transition of REQ.

USS_DB InOut USS_BASE D This is a reference to the instance DB that is created 
and initialized when a "USS_DRIVE (Page 2767)" 
instruction is inserted in your program.

DONE Output BOOL I, Q, M, D, L If this parameter has the value TRUE, the VALUE input 
was written to the drive. 
This bit is set when the "USS_DRIVE (Page 2767)" 
instruction recognizes the write response from the drive. 
This bit is reset when either:
You request the drive's confirmation that the write 
operation has been completed via another "USS_WPM" 
query or when the second of the next two calls of 
"USS_DRIVE (Page 2767)" is executed.

ERROR Output BOOL I, Q, M, D, L Error occurred: If this parameter has the value TRUE, 
this indicates that an error has occurred and the 
STATUS output is valid. All other outputs are set to zero 
on an error. Communication errors are only reported at 
the ERROR and STATUS outputs of the "USS_PORT 
(Page 2766)" instruction.

STATUS 
(Page 2772) 

Output WORD I, Q, M, D, L This is the status value of the request. It indicates the 
result of the write request. Additional information is 
available in the "USS_Extended_Error (Page 2772)" tag 
for some status codes.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter STATUS of USS instructions

STATUS parameter
The following table contains the status codes of the USS operation that are output at the 
STATUS output of the USS instructions:   

STATUS* 
(W#16#....)

Description

0000 No error
8180 The length of the drive response did not match the characters received from the drive. The drive number 

where the error occurred is returned in the "USS_Extended_Error" tag. See the extended error description 
below this table.

8181 The parameter VALUE is not of the data type WORD, REAL, or DWORD
8182 User supplied a parameter value of the type word and received a DWORD or REAL from the drive in the 

response
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STATUS* 
(W#16#....)

Description

8183 User supplied a parameter value of the type DWORD or REAL and received a word from the drive in the 
response

8184 Response telegram from drive had a bad checksum. The drive number where the error occurred is returned 
in the "USS_Extended_Error" tag. See the extended error description below this table.

8185 Illegal drive address (valid drive address range: 1-16)
8186 Speed set point out of valid range (valid speed SP range: -200% to 200%)
8187 Wrong drive number responded to the request sent. The drive number where the error occurred is returned 

in the "USS_Extended_Error" tag. See the extended error description below this table.
8188 Illegal PZD word length specified (valid range = 2, 4, 6 or 8 words)
8189 Illegal baud rate was specified 
818A Parameter request channel is in use by another request for this drive
818B Drive has not responded to requests and retries. The drive number where the error occurred is returned in 

the "USS_Extended_Error" tag. See the extended error description below this table.
818C Drive returned an extended error on a parameter request operation. See the extended error description 

below this table.
818D Drive returned an invalid access error on a parameter request operation. See your drive manual for 

information of why parameter access may be limited
818E Drive has not been initialized: This error code is output at "USS_RPM (Page 2770)" or "USS_WPM 

(Page 2771)" if the "USS_DRIVE (Page 2767)" instruction has not been called at least once for this drive. 
This prevents the initialization of the first cycle of "USS_DRIVE (Page 2767)" from overwriting a pending 
parameter read or write request since it initializes the drive as a new entry. To eliminate this error, call the 
"USS_DRIVE (Page 2767)" instruction for this drive.

80Ax-80Fx Specific errors returned from PtP (Point-to-Point) communication instructions called by the USS library: 
These error code values are not modified by the USS library and are defined in the PtP instruction 
descriptions.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

USS_Extended_Error - USS drive extended error codes
USS drives support read and write access to a drive’s internal parameters. This feature allows 
distributed control and configuration of the drive. Drive parameter access operations can fail 
due to errors such as values out of range or invalid requests in a drive’s current mode. The 
drive generates an error code that is output in the "USS_Extended_Error" variable in the 
instance DB of the "USS_DRIVE (Page 2767)" instruction. This error code value is only valid 
for the last execution of the "USS_RPM (Page 2770)" or "USS_WPM (Page 2771)" instruction. 
The drive error code is put into the "USS_Extended_Error" tag when the value of STATUS is 
hexadecimal 818C. The error code of "USS_Extended_Error" depends on the drive variant. 
See the drive's manual for a description of the extended error codes for read and write 
parameter operations.
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MODBUS (RTU)

MB_COMM_LOAD: Configure port on the PtP module for Modbus RTU

Description    
The "MB_COMM_LOAD" instruction configures a port for communication using the Modbus 
RTU protocol. The following hardware can be used for this:

● Up to three point-to-point modules (PtP) CM 1241 RS485 or CM 1241 RS232

● A communications board CB 1241 RS485 in addition to this

After configuration of the port, you communicate over Modbus by executing the "MB_SLAVE" 
or "MB_MASTER" instruction.

Call
"MB_COMM_LOAD" must be called once to configure the port for the Modbus RTU protocol. 
On completion of the configuration, the port can be used by the "MB_MASTER (Page 2777)" 
and "MB_SLAVE (Page 2785)" instructions.

"MB_COMM_LOAD" only needs to be called again if one of the communication parameters 
has to be modified. Each "MB_COMM_LOAD" call deletes the communications buffer. To avoid 
data loss during communication, you should not call the instruction unnecessarily.

One instance of "MB_COMM_LOAD" must be used to configure the port of each 
communication module that is used for Modbus communication. You assign a unique 
"MB_COMM_LOAD" instance data block for each port that you use. The S7-1200 CPU is 
limited to three communication modules.

An instance data block is assigned when you insert the "MB_MASTER (Page 2777)" or 
"MB_SLAVE (Page 2785)" instruction. This instance data block is referenced when you specify 
the MB_DB parameter on the "MB_COMM_LOAD" instruction.

Parameters
The following table shows the parameters of the instruction "MB_COMM_LOAD":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Execution of the instruction upon a rising edge.
PORT Input PORT I, Q, M, D, L or 

constant
ID of the communications port:
After you have inserted the communications 
module in the device configuration, the port ID 
appears in the drop-down list at the PORT box 
connection. This constant can also be referenced 
within the "Constants" tab of the tag table.

BAUD Input UDINT I, Q, M, D, L or 
constant

Baud rate selection:
300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 
57600, 76800, 115200 
All other values are invalid.
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Parameter Declaration Data type Memory area Description
PARITY Input UINT I, Q, M, D, L or 

constant
Parity selection:
● 0 – None
● 1 – Odd
● 2 – Even

FLOW_CTRL Input UINT I, Q, M, D, L or 
constant

Flow control selection:
● 0 – (default) No flow control
● 1 – Hardware flow control with RTS always ON 

(does not apply to RS485 ports)
● 2 - Hardware flow control with RTS switched

RTS_ON_DLY Input UINT I, Q, M, D, L or 
constant

RTS on-delay selection:
● 0 – (default) No delay of RTS active until the first 

character of the message is transmitted.
● 1 to 65535 – Delay in milliseconds of "RTS 

active" until the first character of the message 
is transmitted (does not apply to RS-485 ports). 
RTS delays must be applied independent of the 
FLOW_CTRL selection.

RTS_OFF_DLY Input UINT I, Q, M, D, L or 
constant

RTS off-delay selection:
● 0 – (default) No delay after the last character 

transmitted until "RTS inactive"
● 1 to 65535 – Delay in milliseconds after the last 

character transmitted until "RTS inactive" (does 
not apply to RS-485 ports). RTS delays must be 
applied independent of the FLOW_CTRL 
selection.

RESP_TO Input UINT I, Q, M, D, L or 
constant

Response timeout:
Time in milliseconds allowed by "MB_MASTER 
(Page 2777)" for the slave to respond. If the slave 
does not respond in this time, "MB_MASTER 
(Page 2777)" repeats the request or terminates the 
request with an error if the specified number of 
retries has been sent. 
5 ms to 65535 ms (default = 1000 ms).

MB_DB Input MB_BASE D A reference to the instance data block of the 
"MB_MASTER (Page 2777)" or "MB_SLAVE 
(Page 2785)" instructions. After you insert 
"MB_SLAVE (Page 2785)" or "MB_MASTER 
(Page 2777)" in your program, the DB identifier 
appears in the drop-down list at the MB_DB box 
connection. 

DONE Output BOOL I, Q, M, D, L Execution of instruction completed without error.
ERROR Output BOOL I, Q, M, D, L Error:

● 0 – No error detected
● 1 – Indicates that an error was detected. An 

error code is output in the STATUS parameter.
STATUS Output WORD I, Q, M, D, L Port configuration error code
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For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameter STATUS

Error code*
 (W#16#...) 

Description

0000 No error
8180 Invalid value for the port ID (wrong address for the communications module).
8181 Invalid baud rate value.
8182 Invalid parity value.
8183 Invalid flow control value.
8184 Invalid value for the timeout of the response (the time before which a timeout is reported must be at least 

25 ms).
8185 Incorrect pointer in the MB_DB parameter to the instance DB of the "MB_MASTER (Page 2777)" or 

"MB_SLAVE (Page 2785)" instruction.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

MB_COMM_LOAD data block tags
The table below shows the public static tags in the instance DB of MB_COMM_LOAD that you 
can use in your program.

Table 9-119 Static tags in the instance DB

Tag Data type Default Description
ICHAR_GAP WORD 0 Delay for the character spacing between characters. This parameter is 

specified in milliseconds and is used to increase the anticipated period 
between the received characters. The corresponding number of bit times for 
this parameter is added to the Modbus standard value of 35 bit times (3.5 
character times).

RETRIES WORD 2 The number of repeated attempts by the master before the error code 
0x80C8 is returned for "No response".

MODE USINT 0 Mode
Permitted modes are: 
● 0 = Full duplex (RS232) 
● 1 = Full duplex (RS422) four-wire mode (point-to-point) 
● 2 = Full duplex (RS422) four-wire mode (multipoint master) 
● 3 = Full duplex (RS422) four-wire mode (multipoint slave)
● 4 = Half duplex (RS485) two-wire mode 
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Tag Data type Default Description
LINE_PRE USINT 0 Receive line initial state

Permitted defaults are:
● 0 = "No" default 
● 1 = Signal R(A)=5V, signal R(B)=0 V (break detection): 

No break detection is possible with this default. 
Can only be selected with: "Full duplex (RS422) four-wire mode (point-to-
point connection)" and "Full duplex (RS422) four-wire mode (multipoint 
slave)".

● 2 = Signal R(A)=0 V, signal R(B)=5 V: 
This default corresponds to the at-rest state (no send process is active). 
No break detection is possible with this default.

CABLE-
BREAK

USINT 0 Activate cable break detection:
● 0 - not activated
● 1 - activated

MB_MASTER: Communicate via the PtP port as Modbus master

Description of MB_MASTER

Description    
The "MB_MASTER" instruction allows your program to communicate as a Modbus master 
using a port on a point-to-point module (CM) or a communications board (CB). You can access 
data in one or more Modbus slave devices.

Before the "MB_MASTER" instruction can communicate with a port, "MB_COMM_LOAD 
(Page 2774)" must first execute.

An instance DB is created when you insert the "MB_MASTER" instruction in your program. 
You specify this instance DB in the MB_DB input parameter of the "MB_COMM_LOAD 
(Page 2774)" instruction.

Rules for Modbus master communication
● A port used for Modbus master requests cannot be used for "MB_SLAVE".

● A port can be used for one or more "MB_MASTER" calls if the same instance DB is used.

● The Modbus instructions do not use communication interrupt events to control the 
communication process. Your program must poll the "MB_MASTER" instruction for 
completed send and receive operations.
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● Calling the instruction:

– Call the "MB_MASTER" instruction if possible in a cyclic program OB. The instruction 
can only be called in a time delay or cyclic interrupt OB.

– Do not call more than one "MB_MASTER" instruction in organization blocks with different 
priority classes. If a "MB_MASTER" instruction executes "preemptively" from a higher 
priority class, the instruction may execute incorrectly.

– Do not call the "MB_MASTER" instruction in a startup, diagnostics or time error OB.

● After a transfer has started, the EN parameter (LAD/FBD) must remain set to the value "1" 
until the DONE or ERROR output parameter is set to "1" by the instruction. A renewed call 
by the REQ parameter while the instruction is executing causes an error. After the 
instruction executes, the bit in the REQ parameter remains set for the time specified by the 
BLOCKED_PROC_TIMEOUT parameter in the instance DB.

● If "MB_MASTER" sends a request to a slave, make sure that "MB_MASTER" continues to 
execute until the response from the slave arrives.

Parameters
The following table shows the parameters of the "MB_MASTER" instruction:

Parameters Declaration Data type Memory area Description
REQ 
(Page 2780) 

Input BOOL I, Q, M, D, L Request input:
● 0 – No request
● 1 – Request to transmit data to Modbus slave(s)

MB_ADDR Input UINT I, Q, M, D, L or 
constant

Modbus RTU station address: 
● Default address range: 0 to 247
● Extended address range: 0 to 65535
The value "0" is reserved for broadcasting a message 
to all Modbus slaves. Modbus function codes 05, 06, 15, 
and 16 are the only function codes supported for 
broadcast.

MODE 
(Page 2780) 

Input USINT I, Q, M, D, L or 
constant

Mode selection: Specifies the type of request: Read, 
write, or diagnostics: 
Refer to the Modbus functions table for details.

DATA_ADDR 
(Page 2780) 

Input UDINT I, Q, M, D, L or 
constant

Starting address in the slave: Specifies the starting 
address of the data to be accessed in the Modbus slave. 
You will find the valid addresses in the Modbus functions 
table.

DATA_LEN Input UINT I, Q, M, D, L or 
constant

Data length: Specifies the number of bits or words to be 
accessed in this request. You will find the valid lengths 
in the Modbus functions table.

DATA_PTR 
(Page 2782) 

Input VARIANT M, D Points to the DB or bit memory address of the CPU for 
the data to be written or read. For a DB, this must be 
created with the "Standard - compatible with 
S7-300/400" access type.

DONE Output BOOL I, Q, M, D, L ● 0: Transaction not completed
● 1: Transaction completed without error
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Parameters Declaration Data type Memory area Description
BUSY Output BOOL I, Q, M, D, L ● 0: No "MB_MASTER" transaction in progress

● 1: "MB_MASTER" transaction in progress
ERROR Output BOOL I, Q, M, D, L ● 0: No error

● 1: Error, the error code is indicated by the STATUS 
parameter

STATUS Output WORD I, Q, M, D, L Execution condition code

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter

Table 9-120 Communications and configuration error messages of the instruction

Error code*
(W#16#....) 

Description

0000 No error
80C8 Slave timeout. Check the baud rate, parity and the connectors on the slave.
80D1 The receiver issued a flow control request to suspend an active transmission and never re-enabled the 

transmission within the wait time.
This error is also generated during hardware flow control if the recipient does not detect CTS within the 
wait time.

80D2 The send request was aborted because no DSR signal is received from the DCE.
80E0 The message was terminated because the receive buffer is full.
80E1 The message was terminated as a result of a parity error.
80E2 The message was terminated as a result of a framing error.
80E3 The message was terminated as a result of an overrun error.
80E4 The message was terminated as a result of the specified length exceeding the total buffer size.
8180 Invalid value for the port ID.
8186 Invalid Modbus station address
8188 The MODE parameter has an invalid value for a broadcast call.
8189 Invalid data address value.
818A Invalid data length value.
818B Invalid pointer to the local data source/destination: Size not correct
818C The DATA_PTR parameter has an invalid pointer. Use a pointer to a bit memory area or a DB with the 

"Standard - compatible with S7-300/400" access type.
8200 Port is busy processing a send request
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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Table 9-121 Error messages of the Modbus protocol

Error code*
(W#16#....)

Response code of 
slave

Description

8380 - CRC error
8381 01 Function code not supported
8382 03 Data length error
8383 02 Error in the data address or address outside the valid range of DATA_PTR
8384 > 03 Data value error
8385 03 Data diagnostic code value not supported (function code 08)
8386 - Function code of the response does not match the function code of the query.
8387 - Response from wrong slave
8388 - The response of the slave to a write call is not correct. The data sent by the slave 

does not match the query from the master.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter REQ

Description
● REQ = FALSE: No request

● REQ = TRUE: Request to transmit data to Modbus slave(s)

You must supply this input through a positive edge-triggered contact on the first call of 
"MB_MASTER" execution. The edge-triggered pulse will invoke the transmission request once. 
All inputs are captured and kept unchanged for the duration of a request and response triggered 
by this input.

While an instance of the "MB_MASTER" executes, no further instance of the instruction can 
be called. If there is a further instance call by the REQ parameter while "MB_MASTER" is 
executing, no automatic follow-on call will be started. To be able to call the instance again, the 
instruction must first be completed before it can be called again by the REQ parameter.

DATA_ADDR and MODE parameters

Description
You specify the start address for data access to the Modbus slave using the DATA_ADDR 
parameter.

With the MODE parameter and the Modbus address, you specify the function code to be 
transferred to the Modbus slave. The following table shows the relationship between the MODE 
parameter, the function code and Modbus address range.
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MODE Modbus 
function

Data length Operation and data Modbus address

0 01 1 to 2000
1 to 1992 (1)

Read output bits:
1 to (1992 or 2000) bits per query

1 to 9999

0 02 1 to 2000
1 to 1992 (1)

Read input bits:
1 to (1992 or 2000) bits per query

10001 to 19999

0 03 1 to 125
1 to 124 (1)

Read holding register:
1 to (124 or 125) WORD per query

40001 to 49999 or
400001 to 465535

0 04 1 to 125
1 to 124 (1)

Read input WORD:
1 to (124 or 125) WORD per query

30001 to 39999

1 05 1 Writing an output bit:
One bit per query

1 to 9999

1 06 1 Writing a holding register:
1 WORD per query

40001 to 49999 or
400001 to 465535

1 15 2 to 1968
2 to 1960 (1)

Writing multiple output bits:
2 to (1960 or 1968) bits per query

1 to 9999

1 16 2 to 123
2 to 122 (1)

Writing multiple holding registers:
2 to (122 or 123) WORD per query

40001 to 49999 or
400001 to 465535

2 15 1 to 1968
2 to 1960 (1)

Writing one or more output bits:
1 to (1960 or 1968) bits per query

1 to 9999

2 16 1 to 123
2 to 122 (1)

Writing one or more holding registers:
1 to (122 or 123) WORD per query

40001 to 49999 or
400001 to 465535

11 11 0 Reading out the communications status word of the 
slaves and the event counter:
The status word indicates execution of the 
instruction (0: is not executing; 0xFFFF: is 
executing). The event counter is incremented each 
time a message is transferred successfully.
The DATA_ADDR and DATA_LEN parameters of 
the "MB_MASTER" instruction are ignored with this 
function.

-

80 08 1 Checking the slave status by reading the error code 
(0x0000):
1 WORD per query

-

81 08 1 Resetting the event counter of the slave with the 
diagnostics code 0x000A:
1 WORD per query

-

3 to 10, 12 
to 79, 82 to 
2555

  Reserved -

(1) For the "Extended address range", the maximum data length is reduced by one byte or one WORD depending on which 
data type is used for the function.
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Parameter DATA_PTR

Description
The DATA_PTR parameter is a pointer to a data block or bit memory from which the data 
should be written or read. If you use a data block, create a global data block with the "Standard 
- compatible with S7-300/400" access type.

Data block structures for the DATA_PTR parameter
● These data types are valid for reading of words of Modbus addresses 30001 to 39999, 

40001 to 49999, and 400001 to 465536 and also for writing of words to Modbus addresses 
40001 to 49999 and 400001 to 465536.

– Standard array of WORD, UINT, or INT data types (see below).

– Named WORD, UINT, or INT structure where each element has a unique name and 16 
bit data type.

– Named complex structure where each element has a unique name and 16 bit or 32 bit 
data type.

● For reading and writing of bits of Modbus addresses 00001 to 09999 and 10001 to 19999.

– Standard array of Boolean data types.

– Named Boolean structure of uniquely named Boolean variables.

● Although not required, it is recommended that each "MB_MASTER" instruction has its own 
separate memory area in a global data block. The reason for this recommendation is that 
there is a greater possibility of data corruption if multiple "MB_MASTER" instructions are 
reading and writing the same area of a global data block.

● The memory areas for DATA_PTR do not need to be in the same global data block. You 
can create one data block with multiple areas for Modbus read operations, one data block 
for Modbus write operations, or one data block for each slave station.
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Instance DB of the "MB_MASTER" instruction

Static variables of the instance DB
The following table describes the static variables of the instance DB of the instruction that you 
can use in the user program.

Variable Data type Description
MB_STATE UINT Internal status of the Modbus instruction
BLOCKED_ 
PROC_TIMEOUT

REAL Time between completion of the instruction call and resetting the 
ACTIVE bit in the instance DB. The time buffer is used to avoid 
execution of the instruction being terminated before a job has been 
sent completely. The default time is 500 ms.

EXTENDED_ 
ADDRESSING

BOOL Configuring addressing:
● 0: Default address area (1 byte)
● 1: Extended address area (2 bytes)
For additional information, refer to the section 
EXTENDED_ADDRESSING: Instance DB of the "MB_SLAVE" 
instruction (Page 2788)

Sample program for a Modbus master

Networks (LAD)
Network 1: Initialize parameters of the RS-485 module only once during the first cycle.

Network 2: Read 100 words from the holding register of the slave.
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Network 3: This is an optional network that displays the values of the first 3 words as soon as 
the read operation has executed.

Network 4: Write 64 bits to the process image output, starting at slave address Q2.0.
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MB_SLAVE: Communicate via the PtP port as Modbus slave

Description of MB_SLAVE

Description    
The "MB_SLAVE" instruction allows your program to communicate as a Modbus slave using 
a port on a point-to-point module (PtP) or a communications board (CB). A Modbus RTU master 
can issue a request and then your program responds via "MB_SLAVE" execution.

You must assign a unique instance data block when you insert the "MB_SLAVE" instruction 
in your program. This instance data block is used when you specify it at the MB_DB parameter 
of the "MB_COMM_LOAD (Page 2774)" instruction.

Modbus communication function codes (1, 2, 4, 5, and 15) can read and write bits and words 
directly in the process image input and process image output in the target system. The following 
table shows the mapping of Modbus addresses to the process image in the CPU.

Modbus functions of "MB_SLAVE" S7-1200
Codes Function Data area Address range Data area CPU address
01 Read bits Output 1 to 8192 Process image output Q0.0 to Q1023.7
02 Read bits Input 10001 to 18192 Process image input I0.0 to I1023.7
04 Read words Input 30001 to 30512 Process image input IW0 to IW1022
05 Write bit Output 1 to 8192 Process image output Q0.0 to Q1023.7
15 Write bits Output 1 to 8192 Process image output Q0.0 to Q1023.7

 

Modbus communication function codes (function codes 3, 6, 16) use a separate holding 
register. To do this, you can use bit memory or a data block with the "Standard - compatible 
with S7-300/400" access type.

You specify the type of the holding register using the MB_HOLD_REG parameter of the 
MB_SLAVE instruction. The following table shows the mapping of the Modbus holding register 
to the DB address of MB_HOLD_REG in the target system.

Modbus functions of "MB_SLAVE" S7-1200
Codes Function Data area Address range

(WORD number)
Address in the DB
(BYTE number)

Bit memory address
(BYTE number)

03 Read words Holding 
register

40001 to 49999 or DW0 to DW19998 or MW0 to CPU limit
400001 to 465535 DW0 to DW131068

06 Write word Holding 
register

40001 to 49999 or DW0 to DW19998 or
400001 to 465535 DW0 to DW131068

16 Write words Holding 
register

40001 to 49999 or DW0 to DW19998 or
400001 to 465535 DW0 to DW131068

 

The table below shows the supported Modbus diagnostic functions.
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S7-1200 "MB_SLAVE" Modbus diagnostic functions 
Codes Subfunction Description
08 0000H Return query data echo test: The "MB_SLAVE" instruction returns the echo of a received data 

word to a Modbus master. 
08 000AH Clear communication event counter: The "MB_SLAVE" instruction clears the communication 

event counter that is used for Modbus function 11.
11 - Get communication event counter: The "MB_SLAVE" instruction uses an internal communication 

event counter for recording the number of successful Modbus read and write requests that are 
sent to the Modbus slave. The counter is not incremented on any Function 8, Function 11, or 
broadcast requests. It is also not incremented on any requests that result in a communication 
error (for example, parity or CRC errors).

 

The "MB_SLAVE" instruction supports broadcast write requests from Modbus masters as long 
as the requests include access to valid addresses. 

Regardless of the validity of a request, "MB_SLAVE" gives no response to a Modbus master 
as the result of a broadcast request.

Rules of Modbus slave communication
● "MB_COMM_LOAD" must be executed to configure a port, before the "MB_SLAVE" 

instruction can communicate with this port.

● If a port is to respond as a slave to a Modbus master, then that port cannot be used by 
"MB_MASTER (Page 2777)". Only one instance of "MB_SLAVE" can be used with a given 
port.

● The Modbus instructions do not use communication interrupt events to control the 
communication process. Your program must control the communication process by polling 
the "MB_SLAVE" instruction for completed send and receive operations.

● The "MB_SLAVE" instruction must be executed periodically at a rate that allows it to make 
a timely response to incoming requests from a Modbus master. It is therefore advisable to 
call the instruction in a cyclic program OB. Calling the "MB_SLAVE" instruction in an 
interrupt OB is possible but not advisable since it can lead to long delays in execution.

Frequency of execution of "MB_SLAVE"
The "MB_SLAVE" instruction must be executed periodically to receive each request from the 
Modbus master and to respond as required. The frequency of execution of "MB_SLAVE" is 
dependent upon the specified response timeout period of the Modbus master. This is illustrated 
in the following diagram.
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The response timeout period is the amount of time a Modbus master waits for the start of a 
response from a Modbus slave. This time period is not defined by the Modbus protocol, but 
rather by a parameter of each Modbus master. The frequency of execution (time between one 
execution and the next execution) of "MB_SLAVE" must be based on the particular parameters 
of your Modbus master. As a minimum, you should execute "MB_SLAVE" twice within the 
response timeout period of the Modbus master.

Parameters
The following table shows the parameters of the "MB_SLAVE" instruction:

Parameter Declaration Data type Memory area Description
MB_ADDR Input UINT I, Q, M, D, L or 

constant
Station address of the Modbus slave 
● Default address range: 0 to 247
● Extended address range: 0 to 65535

MB_HOLD_REG Input VARIANT D Pointer to the Modbus holding register DB. The DB 
must be created with the "Standard - compatible 
with S7-300/400" access type.

NDR Output BOOL I, Q, M, D, L New data ready: 
● 0: No new data
● 1: Indicates that new data has been written by 

the Modbus master
DR Output BOOL I, Q, M, D, L Read data: 

● 0: No data read
● 1: Indicates that data has been read by the 

Modbus master
ERROR Output BOOL I, Q, M, D, L ● 0: No error detected

● 1: Error, a corresponding error code is output in 
the STATUS

STATUS Output WORD I, Q, M, D, L Error code

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

STATUS parameter

STATUS* 
(W#16#....)

Description

80C8 The specified response timeout (refer to RCVTIME or MSGTIME) is "0".
80D1 The receiver issued a flow control request to suspend an active transmission and never re-enabled the 

transmission within the wait time.
This error is also generated during hardware flow control if the recipient does not detect CTS within the 
wait time.

80D2 The send request was aborted because no DSR signal is received from the DCE.
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STATUS* 
(W#16#....)

Description

80E0 The message was terminated because the receive buffer is full
80E1 The message was terminated as a result of a parity error
80E2 The message was terminated as a result of a message frame error
80E3 The message was terminated as a result of a overrun error
80E4 The message was terminated as a result of the specified length exceeding the total buffer size
8180 Invalid value for the port ID.
8186 Invalid Modbus station address
8187 Invalid pointer to MB_HOLD_REG-DB
818C Pointer to a type safe DB type MB_HOLD_REG (must be a Classic DB type)
 
Response code sent to Modbus master (B#16#...)
8380 No response CRC error
8381 01 Function code not supported or not supported in a broadcast
8382 03 Data length error 
8383 02 Error in the data address or address outside the valid range of MB_HOLD_REG
8384 03 Data value error
8385 03 Data diagnostic code value not supported (function code 08)
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

Instance DB of the "MB_SLAVE" instruction

Static variables of the instance DB
The following table describes the static variables of the instance DB of the instruction that you 
can use in the user program. Your program can write values to the HR_Start_Offset and 
Extended_Addressing variables and control the Modbus slave operations.

The other variables can be read to monitor the Modbus status.

Variable Data type Description
HR_Start_Offset WORD Start address of the Modbus holding register (default = " 0")
Extended_ 
Addressing

BOOL Configuring addressing:
● 0: Default address area (1 byte)
● 1: Extended address area (2 bytes)

Request_Count WORD Total number of queries received by the slave
Slave_Message_
Count

WORD Number of queries sent to this specific slave

Bad_CRC_Count WORD Number of received queries with CRC errors
Broadcast_Count WORD Number of received broadcast queries
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Variable Data type Description
Exception_Count WORD Number of Modbus-specific errors that require the return of an 

exception
Success_Count WORD The number of requests received for this specific slave without 

protocol errors

HR_Start_Offset
The addresses of the Modbus holding register start at 40001 or 400001. These addresses 
correspond to the start address of the holding register in the target system memory. Using the 
HR_Start_Offset variable, you can set the offset to a different start address.

Example: A holding register starts at MW 100 and has a length of 100 WORD. With an offset 
of 20 in the HR_Start_Offset parameter, the holding register begins at address 40021 instead 
of 40001. Each address below 40021 and above 400119 causes an addressing error.

 HR_Start_Offset = 0  HR_Start_Offset = 20
 Modbus word 

address
S7-1200 byte 

address
 Modbus word 

address
S7-1200 byte 

address
Minimum 40001 MW100  40021 MW100
Maximum 40099 MW198  40119 MW198

 

Extended_Addressing
To address the Modbus slave, a single byte (default address range) or a double byte (extended 
address range) can be configured. Extended addressing is used to address more than 247 
devices in a single network. If you decide on extended addressing, you can address a 
maximum of 64,000 addresses. Below, you will see a frame of Modbus function 1 as an 
example.

Table 9-122 Slave address with one byte (byte 0)

Function 1 Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5  
Request Slave 

address
F code Start address Length of the coils  

Valid response Slave 
address

F code Length Coil data  

Error response Slave 
address

0x81 E code     

 

Table 9-123 Slave address with two bytes (byte 0 and byte 1)

Function 1 Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6
Request Slave address F code Start address Length of the coils
Valid response Slave address F code Length Coil data
Error response Slave address 0x81 F code    
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Sample program for a Modbus slave

Networks (LAD)
Network 1: Initialize parameters of the RS-485 module only once during the first cycle.

Network 2: Check the requests of the Modbus master in every cycle. 100 words starting at 
MW1000 are configured for the Modbus holding register.

MODBUS (TCP)

MODBUS (TCP)

MB_CLIENT: Communicating via PROFINET as a Modbus TCP client

Description of MB_CLIENT

Description
The "MB_CLIENT" instruction communicates as a Modbus TCP client via the PROFINET 
connection of the S7-1200 CPU. To use the instruction, you do not require any additional 
hardware module. With the "MB_CLIENT" instruction, you establish a connection between the 
client and the server, send requests and receive responses and control connection termination 
of the Modbus TCP server.
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Parameters
The following table shows the parameters of the "MB_CLIENT" instruction:

Parameter Declaration Data type Description
REQ (Page 2793) Input BOOL Communications request to the Modbus TCP server on a rising 

edge.
The instance DB for other clients is blocked with the 
communications request. Changes to the input parameters will not 
become effective until the server has responded or an error 
message has been output. If the parameter REQ is set again during 
an ongoing request, no additional transmission takes place 
afterwards.

DISCONNECT 
(Page 2793) 

Input BOOL With this parameter, you control the establishment and termination 
of the connection to the Modbus server:
● 0: Establish a communications connection to the specified IP 

address and port number.
● 1: Disconnect the communications connection. No other function 

is executed during connection termination. The value 7003 is 
output at the STATUS parameter after successful connection 
termination.

The request is sent immediately if the REQ parameter is set during 
connection establishment.

CONNECT_ID Input UINT Unique ID to identify the connection. Each instance of the 
instructions "MB_CLIENT" and "MB_SERVER (Page 2798)" must 
be assigned a unique connection ID.

IP_OCTET_1 Input USINT 1. Octet of the IP address* of the Modbus TCP server.
IP_OCTET_2 Input USINT 2. Octet of the IP address* of the Modbus TCP server.
IP_OCTET_3 Input USINT 3. Octet of the IP address* of the Modbus TCP server.
IP_OCTET_4 Input USINT 4. Octet of the IP address* of the Modbus TCP server.
IP_PORT Input UINT IP port number of the server to which the client establishes the 

connection and communicates using the TCP/IP protocol (default 
value: 502).

MB_MODE 
(Page 2794) 

Input USINT Selects the mode of the request (read, write or diagnostics).

MB_DATA_ADDR 
(Page 2794) 

Input UDINT Start address of the data accessed by the "MB_CLIENT" instruction.

DATA_LEN Input UINT Data length: Number of bits or words for the data access (see 
"MB_MODE and MB_DATA_ADDR parameters" - data length). 

MB_DATA_PTR 
(Page 2795)

InOut VARIANT Pointer to the Modbus data register: The register is a buffer for the 
data received from the Modbus server or to be sent to the Modbus 
server. The pointer must reference a global data block with standard 
access.
The number of bits addressed must be divisible by 8.

DONE Out BOOL The bit at output parameter DONE is set to "1" as soon as the last 
job is completed without errors. 

BUSY Out BOOL ● 0: No "MB_CLIENT " job in progress
● 1: "MB_ CLIENT " job in progress
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Parameter Declaration Data type Description
ERROR Out BOOL ● 0: No error

● 1: Error occurred. The cause of error is indicated by the STATUS 
parameter.

STATUS 
(Page 2796) 

Out WORD Error code of the instruction.

* 8-bit long component of the 32-bit IPv4 IP address of the Modbus TCP server.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

 

 Note
Consistent input data during an "MB_CLIENT" call

When a Modbus client calls a Modbus instruction, the status of the input parameters is stored 
internally and then compared at the next call. The comparison is used to determine whether 
this particular call initialized the current request. Several "MB_CLIENT" calls can be executed 
if you use a common instance DB. The values of the input parameters must not be changed 
while an "MB_CLIENT" instance is being executed. If the input parameters are changed 
during execution, "MB_CLIENT" cannot be used to check whether or not the instance is 
currently being executed.

 

Multiple client connections
A Modbus TCP client can support several TCP connections and the maximum number of 
connections depends on the CPU being used. The total number of connections of one CPU, 
including those of the Modbus TCP clients and server must not exceed the maximum number 
of supported connections. Modbus TCP connections can also be shared by client and/or server 
connections.

With individual client connections, remember the following rules:

● Each "MB_CLIENT" connection must use a unique instance DB.

● For each "MB_CLIENT" connection, a unique server IP address must be specified.

● Each "MB_CLIENT" connection requires a unique connection ID.
The relevant individual connection ID must be used for each individual instance DB of the 
instruction. The connection ID and instance DB belong together in pairs and must be unique 
for each connection.

● Unique numbers for the IP port may or may not be required depending on the server 
configuration.
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Static tags of the instruction
The following table describes the editable static tags of the instance data block of the 
"MB_CLIENT" instruction.

Tag Data type Start value Description
Blocked_Proc_Timeo
ut

REAL 3.0 Wait time in seconds before the static tag ACTIVE is reset if there 
is a blocked Modbus instance. This can, for example, occur if a client 
request is output and the execution of the client function aborts 
before the request was fully executed. The maximum wait time is 55 
seconds.

MB_Transaction_ID WORD 1 Transaction ID of the Modbus TCP protocol. The start value of "1" 
should only be changed if the Modbus TCP server requires a 
different value.

MB_Unit_ID WORD 65535 Unit ID of the Modbus protocol. The tag corresponds to the slave 
address of the Modbus RTU protocol. Change this value only if the 
Modbus TCP server can be used as a gateway and is controlled by 
the application program within the Modbus server.

RCV_TIMEOUT REAL 2.0 Time interval in seconds in which the "MB_CLIENT" instruction waits 
for a response from the server.

Connected BOOL 0 Indicates whether the connection to the assigned client has been 
established or not: 1 = connected, 0 = not connected.

See also
MB_CLIENT example 1: Send several requests via a TCP connection (Page 2804)

MB_CLIENT example 2: Send multiple requests via several TCP connections (Page 2805)

MB_CLIENT example 3: Coordinate several requests (Page 2806)

REQ and DISCONNECT parameters

Description
If no instance of the "MB_CLIENT" instruction is executing and if the value of the DISCONNECT 
parameter is "0", a new job executes on a rising edge of the REQ parameter. If there is not yet 
a connection, this is established during execution.

If the same instance of the "MB_CLIENT" instruction executes again (DISCONNECT = 0 and 
REQ = 1), before the active job was executed, this is not executed on completion of the active 
job. A new job can only be started on completion of the active job (REQ = 1).

You can monitor the status of execution with the DONE parameter. You can use this to monitor 
the status of execution if the "MB_CLIENT" instruction is executed sequentially.

See also
Description of MB_CLIENT (Page 2790)
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MB_MODE and MB_DATA_ADDR parameters

Description
Instead of a function code, the "MB_CLIENT" instruction uses the MB_MODE parameter.  The 
MB_DATA_ADDR parameter is used to specify the Modbus start address of the data you want 
to access. The combination of the parameters MB_MODE and MB_DATA_ADDRdefines the 
function code used in the current Modbus message. 

The following table shows the relationship between the MB_MODE parameter, the Modbus 
function and the address space.

MB_MODE Modbus 
function

Data length Function and data type MB_DATA_ADDR

0 01 1 to 2000 Read output bits: 
1 to 2000 bits per call

1 to 9999

0 02 1 to 2000 Read input bits: 
1 to 2000 bits per call

10001 to 19999

0 03 1 to 125 Read holding register: 
1 to 125 WORD per call

40001 to 49999

0 04 1 to 125 Read input words: 
1 to 125 WORD per call

30001 to 39999

1 05 1 Write an output bit:
One bit per call

1 to 9999

1 06 1 Write a holding register: 
1 WORD per call

40001 to 49999 

1 15 2 to 1968 Write multiple output bits: 
2 to 1968 bits per call

1 to 9999

1 16 2 to 123 Write several holding registers:
2 to 123 WORD per call

40001 to 49999 

2 15 1 to 1968 Write one or more output bits:
1 to 1968 bits per call

1 to 9999

2 16 1 to 123 Write one or more holding registers: 
1 to 123 WORD per call

40001 to 49999 

11 11 0 Read status word and event counter of server 
communication:
● The status word reflects the the processing status (0 

- not processing, 0xFFFF - processing).
● The event counter is incremented each time a 

message is sent successfully.
The MB_DATA_ADDR and MB_DATA_LEN parameters 
of the "MB_CLIENT" instruction are not evaluated when 
this function executes.

-

80 08 1 Check the server status with the error code 0x0000 
(return loop test - the server sends the request back):
1 WORD per call

-

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2794 System Manual, 07/2013,  



MB_MODE Modbus 
function

Data length Function and data type MB_DATA_ADDR

81 08 1 Reset the event counter of the server with the error code 
0x000A:
1 WORD per call

 

3 to 10,
12 to 79,
82 to 255

  Reserved  

See also
Description of MB_CLIENT (Page 2790)

MB_DATA_PTR parameter

Description
The MB_DATA_PTR parameter is a pointer to a data buffer for storing the data read from or 
written to the Modbus server. As the data buffer, you can use a global data block or a memory 
area (M).

For a buffer in the memory area (M), use a pointer in the ANY format as follows: "P#bit address" 
"data type" "length" (example: P#M1000.0 WORD 500).

The MB_DATA_PTR parameter uses a communications buffer:

● For the communication functions of the "MB_CLIENT" instruction:

– Reading and writing of 1 bit of data of the Modbus server addresses 00001 to 09999 
and 10001 to 19999.

– Reading of 16-bit WORD data of the Modbus server addresses 30001 to 39999 and 
40001 to 49999.

– Writing 16-bit WORD data of the Modbus server addresses 40001 to 49999.

● During data transmission (length: bit or WORD) from or to the global DB or the memory 
area (M) that you assigned with the MB_DATA_PTR parameter.

 

If you use a data block for the buffer in the MB_DATA_PTR parameter, you will need to assign 
data types to the DB elements.

● Use the 1-bit data type BOOL for a Modbus bit address

● Use a 16-bit data type such as WORD, UINT, INT or REAL for a Modbus WORD address.

● Use a 32-bit data type (double word) such as DWORD, DINT or REAL for two Modbus 
WORD addresses.
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● With MB_DATA_PTR, you can also access complex DB elements such as:

– Standard arrays

– Structures with unique element names

– Complex structures with unique naming of the elements and data type lengths of 16 or 
32 bits.

● The data areas for the MB_DATA_PTR parameter can also be in different global data blocks 
(or in different memory areas). You can, for example, use a data block for the the read jobs 
and another one for the write jobs or a separate data block for each "MB_CLIENT" station.

See also
Description of MB_CLIENT (Page 2790)

Parameter STATUS 

Parameter STATUS (general status information)

STATUS* 
(W#16#)

Description

0000 Instruction executed without errors.
0001 Connection established.
0003 Connection terminated.
7000 No call active (REQ=0).
7001 First call with REQ=1: Processing started; BUSY has the value 1.
7002 Intermediate call (REQ 

irrelevant). Processing already active; BUSY has the value 1.
7003 Connection is being terminated.
7004 Connection established and monitored. No job processing active.
7005 Data was sent.
7006 Data was received.
80BB Invalid value at ACTIVE_EST parameter (identifier for the type of connection establishment, see 

T_CON_PARAM): 
● Only passive connection establishment permitted for server (ACTIVE_EST = FALSE).
● Only active connection establishment permitted for client (ACTIVE_EST = TRUE).

8380 Received Modbus frame has incorrect format or too few bytes were received.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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Parameter STATUS (protocol error)

STATUS* 
(W#16#)

Code of the response to the 
Modbus client (B#16#)

Description

8381 01 Function code is not supported.
8382 03 Error in data length.
8383 02 Error in the data address or access outside the address area of 

MB_DATA_PTR (Page 2795).
8384 03 Error in data value.
8385 03 Error codes of diagnostics not supported (function code 08).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (parameter error)
In addition to the errors listed in the following table, errors are also possible with the 
"MB_CLIENT" instruction caused by the communications instructions ("TCON", "TDISCON", 
"TSEND" and "TRCV").

STATUS* 
(W#16#)

Description

80C8 No response of the server in the defined period. Check the connection to the Modbus server. This error is only 
reported on completion of the configured repeated attempts. 
If the "MB_CLIENT" instruction does not receive an answer with the originally transferred transaction ID 
(MB_TRANSACTION_ID tag) within the defined period, this error code is output.

8188 The MB_MODE parameter has an invalid value.
8189 Invalid addressing of data at the MB_DATA_ADDR parameter.
818A Invalid data length at the MB_DATA_LEN parameter.
818B The MB_DATA_PTR parameter has an invalid pointer. You should also check the values of the 

MB_DATA_ADDR (Page 2794) and MB_DATA_LEN parameters.
818C ● The MB_DATA_PTR (Page 2795) pointer references an an optimized data block. Either use a data block 

with standard access or a memory area
● Timeout at parameter BLOCKED_PROC_TIMEOUT (see static tags of instruction). The limit of 55 seconds 

has been exceeded.
818D The transaction ID (MB_TRANSACTION_ID tag) does not correspond to the one sent originally (see static 

tags of instruction).
8200 ● A further Modbus request is currently being processed via the port.

● Another instance of MB_CLIENT with the same connection parameters is processing an existing Modbus 
request.

8380 Received block of transferred Modbus data is not well-formed or too few bytes were received.
8386 Received function code does not match the one sent originally.
8387 ● The assigned connection ID is different from that used for previous requests. Only one connection ID can 

be used for each instance DB of the "MB_CLIENT" instruction.
● The error code is also output when the ID of the Modbus TCP protocol received by the server is not "0".
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STATUS* 
(W#16#)

Description

8388 The Modbus server sent a different data length than was requested. This error occurs only when using the 
Modbus functions 15 or 16.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error codes of internally used communications instructions.

With the "MB_CLIENT" instruction, in addition to the errors listed in the tables, errors caused 
by the communication instructions ("TCON", "TDISCON", "TSEND" and "TRCV") used by the 
instruction can occur.

The error codes are assigned via the instance data block of the "MB_CLIENT" instruction. 
The error codes are displayed for the respective instruction under STATUS in the Static 
section.

The meaning of the error codes is available in the documentation of the corresponding 
communications instruction.

 

See also
Description of MB_CLIENT (Page 2790)

MB_HOLD_REG parameter (Page 2802)

MB_SERVER: Communicating via PROFINET as a Modbus TCP server

Description of MB_SERVER

Description
The "MB_SERVER" instruction communicates as a Modbus TCP server via the PROFINET 
connection of the S7-1200 CPU. To use the instruction, you do not require any additional 
hardware module. The "MB_SERVER" instruction processes connection requests of a Modbus 
TCP client, receives requests from Modbus functions and sends responses.
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Parameters
The following table shows the parameters of the "MB_SERVER" instruction:

Parameter Declaration Data type Description
DISCONNECT Input BOOL The instruction "MB_SERVER" enters into a passive connection with a 

partner module, which means the server responds to a TCP connection 
request from each requesting IP address. You can use this parameter to 
control when a connection request is accepted:
● 0: A passive connection is established when there is no 

communications connection.
● 1: Initialization of the connection termination.  If the input is set, no 

other operations are executed. The value 7003 is output at the 
STATUS parameter after successful connection termination.

CONNECT_ID Input UINT The parameter uniquely identifies a connection within the CPU. Each 
individual instance of the instructions "MB_CLIENT (Page 2790)" and 
"MB_SERVER" must have a unique CONNECT_ID parameter.

IP_PORT Input UINT Start value = 502. The number of IP ports defines which IP port is 
monitored for connection requests of the Modbus client. 
The following TCP port numbers must not be used for the passive 
connection of the "MB_SERVER" instruction: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964. 

MB_HOLD_REG 
(Page 2802) 

InOut VARIANT Pointer to the Modbus holding register of the "MB_SERVER" instruction: 
Use a global data block with standard access as holding register. The 
holding register contains the values that may be accessed by a Modbus 
client using the Modbus functions 3 (read), 6 (write) and 16 (read).

NDR Output BOOL "New Data Ready":
● 0: No new data
● 1: New data written by the Modbus client written

DR Output BOOL "Data Read":
● 0: No data read
● 1: Data read by the Modbus client

ERROR Output BOOL If an error occurs during the call of the "MB_SERVER" instruction, the 
output of the ERROR parameter is set to TRUE. Detailed information 
about the cause of the problem is indicated by the STATUS parameter. 

STATUS 
(Page 2803) 

Output WORD Error code of the instruction.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Mapping of Modbus addresses to the process image
The "MB_SERVER" instruction allows incoming Modbus functions (1, 2, 4, 5 and 15) direct 
read and write access to the process image input and output of the S7-1200 CPU (use of the 
data types BOOL and WORD). 

For the data transfer of the function codes 3, 6 and 16, the holding register (MB_HOLD_REG 
parameter) must be defined longer than one byte. The following table shows the mapping of 
the Modbus addresses to the process image of the CPU.
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Modbus function S7-1200
Code Function Data area Address space Data area CPU address
01 Read: Bits Output 1 to 8192 Process image output Q0.0 to Q1023.7
02 Read: Bits Input 10001 to 18192 Process image input I0.0 to I1023.7
04 Read: WORD Input 30001 to 30512 Process image input IW0 to IW1022
05 Write: Bits Output 1 to 8192 Process image output Q0.0 to Q1023.7
15 Write: Bits Output 1 to 8192 Process image output Q0.0 to Q1023.7

Incoming Modbus messages with the function codes 3, 6 and 16 write to or read from the 
Modbus holding registers (you specify the holding registers with the MB_HOLD_REG 
parameter).

Multiple server connections
You can create multiple Server connections. This allows a single CPU to establish connections 
to more than one Modbus TCP client at the same time.

A Modbus TCP server can support several TCP connections and the maximum number of 
connections depends on the CPU being used.

The total number of connections of one CPU, including those of the Modbus TCP clients and 
server must not exceed the maximum number of supported connections. 

Modbus TCP connections can also be shared by client and/or server connections.

In the case of Server connections, remember the following rules:

● Each "MB_SERVER" connection must use a unique instance DB.

● Each "MB_SERVER" connection must be created with a unique IP port number. Only one 
connection is supported for each port.

● Each "MB_SERVER" connection must use a unique connection ID.
The relevant individual connection ID must be used for each individual instance DB of the 
instruction. The connection ID and instance DB belong together in pairs and must be unique 
for each connection.

● For each connection, the "MB_SERVER" instruction must be called individually.
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Modbus diagnostics functions
The table below contains a description of the Modbus diagnostics functions.

Code Subfunction Description
08 0x0000 Echo test: The "MB_SERVER" instruction receives a data word and returns this unchanged to 

the Modbus master.
08 0x000A Reset event counter: The "MB_SERVER" instruction resets the event counter for communication 

that is used for Modbus function 11.
11 - Fetch event counter of the communication: The "MB_SERVER" instruction uses an internal event 

counter for communication to record the number of successfully executed read and write 
requests sent to the Modbus server.
The event counter is not incremented by the functions 8, 11 or broadcast requests. The same 
applies to requests that result in a communications error (for example parity errors or CRC 
errors). The broadcast function is not available for Modbus TCP because only one client/server 
connection can exist at any one time.

Static tags of the instruction
The following table describes the static tags of the instance data block of the "MB_SERVER" 
instruction used in the program. You can write the HR_Start_Offset tag. You can read the other 
tags to monitor the Modbus status.

Tag Data type Start value Description
HR_Start_Offset WORD 0 Assign the start address of the Modbus holding register.
Request_Count WORD 0 Total number of requests received by the server.
Server_Message_Co
unt

WORD 0 Total number of received messages for the relevant Server.

Xmt_Rcv_Count WORD 0 Counter for detecting the number of transfers during which an error 
occurred. The counter is also incremented if an invalid Modbus message 
is received.

Exception_Count WORD 0 Counter for detecting the number of errors specifically for Modbus cause 
an exception.

Success_Count WORD 0 Counter for detecting the number of requests that contain no error in the 
transferred protocol.

Connected BOOL 0 Indicates whether the connection to the assigned client has been 
established or not: 1 = connected, 0 = not connected.

Example: Addressing via static tag HR_Start_Offset
The addresses of the Modbus holding register start at 40001. These addresses correspond to 
the address space of the CPU memory area for the holding register. You can also define the 
HR_Start_Offset tag so that the Modbus holding register has a start address other than 40001.

Example: The holding register begins at MW100, and has a length of 100 WORD. An offset 
value in the HR_Start_Offset parameter means that the start address of the holding register is 
moved from 40001 to 40021. Whenever the holding register is addressed below the address 
40021 and above the address 40119, this causes an error.
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HR_Start_Offset Address Minimum Maximum
0 Modbus address (WORD) 40001 40099

S7-1200 address MW100 MW298
20 Modbus address (WORD) 40021 40119

S7-1200 address MW100 MW298

See also
MB_SERVER example: Multiple TCP connections (Page 2807)

MB_HOLD_REG parameter

Description
The MB_HOLD_REG parameter is a pointer to a data buffer for storing the data read from or 
written to the Modbus server. As the data buffer, you can use a global data block or a memory 
area (M).

As pointer to a buffer in the memory area (M), use the ANY format as follows: "P#bit address" 
"data type" "length" (example: P#M1000.0 WORD 500).

The following table shows examples of mapping Modbus addresses to the holding register for 
the Modbus functions 3 (read WORD), 6 (write WORD) and 16 (write several WORD). The 
upper limit for the number of addresses in the data block is decided by the maximum work 
memory of the CPU. If you use a memory area, the upper limit for the addresses is decided 
by the size of the memory area of the CPU.

Modbus 
addresses

MB_HOLD_REG parameter - examples

P#M100.0 
WORD 5

P#DB10.DBx0.0 WORD 5 "Recipe".ingredient

40001 MW100 DB10.DBW0 "Recipe".ingredient[1]
40002 MW102 DB10.DBW2 "Recipe".ingredient[2]
40003 MW104 DB10.DBW4 "Recipe".ingredient[3]
40004 MW106 DB10.DBW6 "Recipe".ingredient[4]
40005 MW108 DB10.DBW8 "Recipe".ingredient[5]

See also
Description of MB_SERVER (Page 2798)
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Parameter STATUS

Parameter STATUS (general status information)

STATUS* 
(W#16#)

Description

0000 Instruction executed without errors.
0001 Connection established.
0003 Connection terminated.
7000 No call active (REQ=0).
7001 First call with REQ=1: Processing started; BUSY has the value 1.
7002 Intermediate call (REQ 

irrelevant). Processing already active; BUSY has the value 1.
7003 Connection is being terminated.
7004 Connection established and monitored. No job processing active.
7005 Data was sent.
7006 Data was received.
80BB Invalid value at ACTIVE_EST parameter (identifier for the type of connection establishment, see 

T_CON_PARAM): 
● Only passive connection establishment permitted for server (ACTIVE_EST = FALSE).
● Only active connection establishment permitted for client (ACTIVE_EST = TRUE).

8380 Received Modbus frame has incorrect format or too few bytes were received.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (parameter error)

STATUS* 
(W#16#)

Code of the response to 
the Modbus server 
(B#16#)

Description

8187 No response The MB_HOLD_REG parameter has an invalid pointer. Data area is too small.
818C No response ● The MB_HOLD_REG parameter references an an optimized data block. 

Either use a data block with standard access or a memory area
● Error due to timeout of execution (more than 55 seconds).

8381 01 Function code is not supported.
8382 03 Error in data length
8383 02 Error in data address or access outside the address area of the holding register 

(MB_HOLD_REG (Page 2802) parameter).
8384 03 Error in data value
8385 03 Value of the diagnostic code is not supported (only with function code 08).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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 Note
Error codes of internally used communications instructions.

With the "MB_SERVER" instruction, in addition to the errors listed in the tables, errors caused 
by the communication instructions ("TCON", "TDISCON", "TSEND" and "TRCV") used by the 
instruction can occur.

The error codes are assigned via the instance data block of the "MB_SERVER" instruction. 
The error codes are displayed for the respective instruction under STATUS in the Static 
section.

The meaning of the error codes is available in the documentation of the corresponding 
communications instruction.

 

See also
Description of MB_SERVER (Page 2798)

Examples

MB_CLIENT example 1: Send several requests via a TCP connection

Description
Several requests of the Modbus Client can be sent via a TCP connection. To do this, use the 
same instance DB, the same connection ID and the same port number.

Only one client can be active at any one time. After processing of a client has been completed, 
the next client is processed. The order of execution must be defined in the program.

In the following sample program, the value of the STATUS output parameter is also copied.
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Network 1: Modbus function 1 - 16 read output bits

Network 2: Modbus function 2 - 32 read input bits

MB_CLIENT example 2: Send multiple requests via several TCP connections

Description
Requests from the Modbus client can be sent via different TCP connections. If you require 
this, use a different instance DB and a different connection ID.

Use a different port number, if the connections are to the same Modbus server. If the 
connections are to different Modbus servers, you can freely assign the port number.
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Network 1: Modbus function 4 - read input (WORD)

Network 2: Modbus function 3 - read holding register (WORD)

MB_CLIENT example 3: Coordinate several requests

Description
Make sure that the individual Modbus requests are executed. You control coordination of 
requests with the program. The following example demonstrates how the output parameters 
of the first and second client request can be used to coordinate execution of the instructions.
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Network 1: Modbus function 3 - read holding register (WORD)

Network 2: Modbus function 3 - read holding register (WORD)

MB_SERVER example: Multiple TCP connections

Description
You can use several Modbus TCP server connections. To do this, the "MB_SERVER" 
instruction must be called independently for each connection. 

Every connection requires the following:

● An independent instance data block of the instruction

● A unique connection ID

● A separate IP port (on the S7-1200, only one connection is permitted per IP port)
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To optimize the performance "MB_SERVER" should be executed once per program cycle for 
each connection.

Network 1: Connection #1 with associated IP port connection ID and instance DB

Network 2: Connection #1 with associated IP port connection ID and instance DB

MODBUS (TCP)

MB_CLIENT: Communicating via PROFINET as a Modbus TCP client

Description of MB_CLIENT

Description
The "MB_CLIENT" instruction communicates as a Modbus TCP client via the PROFINET 
connection. With the "MB_CLIENT" instruction, you establish a connection between the client 
and the server, send Modbus requests and receive responses and control connection 
termination of the Modbus TCP client.

The "MB_CLIENT" instruction V3.0 can be used for the S7-1500 as well as for the S7-1200 
version 4.0 or higher. The connection can take place via the local interface of the CPU or CM/
CP.

To use the instruction, you do not require an additional hardware module.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2808 System Manual, 07/2013,  



Multiple client connections
A Modbus TCP client can support several TCP connections and the maximum number of 
connections depends on the CPU being used. The total number of connections of one CPU, 
including those of the Modbus TCP clients and server must not exceed the maximum number 
of supported connections. Modbus TCP connections can also be shared by "MB_CLIENT" and/
or "MB_SERVER" instances.

With individual client connections, remember the following rules:

● Each "MB_CLIENT" connection must use a unique instance DB.

● For each "MB_CLIENT" connection, a unique server IP address must be specified.

● Each "MB_CLIENT" connection requires a unique connection ID.
The relevant individual connection ID must be used for each individual instance DB of the 
instruction. The connection ID and instance DB belong together in pairs and must be unique 
for each connection.

● Unique numbers for the IP port may or may not be required depending on the server 
configuration.

Parameters
The following table shows the parameters of the "MB_CLIENT" instruction:

Parameter Declaration Data type Description
REQ (Page 2811) Input BOOL Communications request to the Modbus TCP server on a rising 

edge.
The instance DB for other clients is blocked with the 
communications request. Changes to the input parameters will not 
become effective until the server has responded or an error 
message has been output. If the parameter REQ is set again during 
an ongoing Modbus request, no additional transmission takes place 
afterwards.

DISCONNECT 
(Page 2811) 

Input BOOL With this parameter, you control the establishment and termination 
of the connection to the Modbus server:
● 0: Establish communications connection to the connection 

partner configured at the CONNECT parameter (see CONNECT 
parameter).

● 1: Disconnect the communications connection. No other function 
is executed during connection termination. The value 0003 is 
output at the STATUS parameter after successful connection 
termination.

The Modbus request is sent immediately if the REQ parameter is 
set during connection establishment.

MB_MODE 
(Page 2811) 

Input USINT Selects the mode of the Modbus request (read, write or diagnostics).

MB_DATA_ADDR 
(Page 2811) 

Input UDINT Start address of the data accessed by the "MB_CLIENT" instruction.

MB_DATA_LEN Input UINT Data length: Number of bits or words for the data access (see 
"MB_MODE and MB_DATA_ADDR parameters" - data length). 
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Parameter Declaration Data type Description
MB_DATA_PTR 
(Page 2813)

InOut VARIANT Pointer to the Modbus data register: The register is a buffer for the 
data received from the Modbus server or to be sent to the Modbus 
server. The pointer must reference a global data block with 
optimized access.
The number of bits addressed must be divisible by 8.

CONNECT 
(Page 2814)

InOut VARIANT Pointer to the structure of the connection description
The following structures (SDTs) can be used:
● TCON_IP_v4: Includes all address parameters required for 

establishing a programmed connection. When using 
TCON_IP_v4, the connection is established when calling the 
instruction "MB_SERVER".

● TCON_Configured: Includes the address parameters of a 
configured connection. When using TCON_Configured, an 
existing connection is used that was created by the CPU after 
download of the hardware configuration.

DONE Out BOOL The bit at output parameter DONE is set to "1" as soon as the last 
job is completed without errors. 

BUSY Out BOOL ● 0: No Modbus request in progress
● 1: Modbus request being processed
The output parameter BUSY is not set during connection 
establishment and termination.

ERROR Out BOOL ● 0: No error
● 1: Error occurred. The cause of error is indicated by the STATUS 

parameter.
STATUS 
(Page 2816) 

Out WORD Detailed status information of the instruction.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

 

 Note
Consistent input data during an "MB_CLIENT" call

When a Modbus client instruction is called, the status of the input parameters is stored 
internally and then compared at the next call. The comparison is used to determine whether 
this particular call initialized the current request. Several "MB_CLIENT" calls can be executed 
if you use a common instance DB. The values of the input parameters must not be changed 
while an "MB_CLIENT" instance is being executed. If the input parameters are changed 
during execution, "MB_CLIENT" cannot be used to check whether or not the instance is 
currently being executed.
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Static tags of the instruction
The following table describes the editable static tags of the instance data block of the 
"MB_CLIENT" instruction.

Tag Data type Start value Description
Blocked_Proc_Timeo
ut

REAL 3.0 Wait time in seconds before the static tag ACTIVE is reset if there 
is a blocked Modbus instance. This can, for example, occur if a client 
request is output and the execution of the client function aborts 
before the request was fully executed. The maximum wait time is 55 
seconds.

MB_Transaction_ID WORD 1 Transaction ID of the Modbus TCP protocol. The start value of "1" 
should only be changed if the Modbus TCP server requires a 
different value.

MB_Unit_ID WORD 65535 Unit ID of the Modbus protocol. The tag corresponds to the slave 
address of the Modbus RTU protocol. Change this value only if the 
Modbus TCP server can be used as a gateway and is controlled by 
the application program within the Modbus server.

RCV_TIMEOUT REAL 2.0 Time interval in seconds in which the "MB_CLIENT" instruction waits 
for a response from the server.

Connected BOOL 0 Indicates whether the connection to the assigned server has been 
established or not: 1 = connected, 0 = not connected.

REQ and DISCONNECT parameters

Description
If no instance of the "MB_CLIENT" instruction is executing and if the value of the DISCONNECT 
parameter is "0", a new job executes on a rising edge of the REQ parameter. If there is not yet 
a connection, this is established during execution.

If the same instance of the "MB_CLIENT" instruction executes again (DISCONNECT = 0 and 
REQ = 1), before the active job was executed, this is not executed on completion of the active 
job. A new job can only be started on completion of the active job (REQ = 1).

The status of the execution is output by the output parameters. You can use it to monitor the 
execution status when the "MB_CLIENT" instruction is executed sequentially.

MB_MODE and MB_DATA_ADDR parameters

Description
Instead of a function code, the "MB_CLIENT" instruction uses the MB_MODE parameter.  The 
MB_DATA_ADDR parameter is used to specify the Modbus start address of the data you want 
to access. 

The combination of the parameters MB_MODE, MB_DATA_ADDR and MB_DATA_LEN 
defines the function code used in the current Modbus message. For example:
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● Function code 5

– MB_MODE=1

– MB_DATA_ADDR=1

– MB_DATA_LEN=1

● Function code 15

– MB_MODE=1

– MB_DATA_ADDR=1

– MB_DATA_LEN=2

The following table shows the relationship between the input parameters of the "MB_CLIENT" 
instruction and the Modbus function.

MB_MODE MB_DATA_A
DDR

MB_DATA_L
EN

Modbus 
function

Function and data type

0 Start address:
● 1 to 9999

Data length 
(bits) per call:
● 1 to 2000

01 Read input bits: 
● 1 to 2000

0 Start address:
● 10001 to 1

9999

Data length 
(bits) per call:
● 1 to 2000

02 Read input bits: 
● 1 to 2000

0 Start address:
● 40001 to 

49999
● 400001 to 

465535

Data length 
(WORD) per 
call:
● 1 to 125
● 1 to 125

03 Read holding register: 
● 0 to 9998
● 0 to 65534

0 Start address:
● 30001 to 3

9999

Data length 
(WORD) per 
call:
● 1 to 125

04 Read input words: 
● 0 to 9998

1 Start address:
● 1 to 9999

Data length 
(bits) per call:
● 1

05 Writing an output bit:
● 0 to 9998

1 Start address:
● 40001 to 

49999
● 400001 to 

465535

Data length 
(WORD) per 
call:
● 1
● 1

06 Write a holding register: 
● 0 to 9998
● 0 to 65524

1 Start address:
● 1 to 9999

Data length 
(bits) per call:
● 2 to 1968

15 Write multiple output bits: 
● 0 to 9998

1 Start address:
● 40001 to 

49999 
● 400001 to 

465534

Data length 
(WORD) per 
call:
● 2 to 123
● 2 to 123

16 Write multiple holding registers:
● 0 to 9998
● 0 to 65534
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MB_MODE MB_DATA_A
DDR

MB_DATA_L
EN

Modbus 
function

Function and data type

2 Start address:
● 1 to 9999

Data length 
(bits) per call:
● 1 to 1968

15 Write one or more output bits:
● 0 to 9998

2 Start address:
● 40001 to 

49999
● 400001 to 

465535

Data length 
(WORD) per 
call:
● 1 to 123
● 1 to 123

16 Write one or more holding registers: 
● 0 to 9998
● 0 to 65534

11 The MB_DATA_ADDR and 
MB_DATA_LEN parameters 
are not evaluated when this 
function is executed.

11 Read status word and event counter of the server:
● The status word reflects the the processing status (0 - not 

processing, 0xFFFF - processing).
● The event counter is incremented when the Modbus 

request was executed successfully. If an error occurred 
during execution of a Modbus function, a message is sent 
by the server but the event counter is not incremented.

80 - Data length 
(WORD) per 
call:
● 1

08 Check the server status with the diagnostic code 0x0000 
(return loop test - the server sends the request back):
● 1 WORD per call

81 - Data length 
(WORD) per 
call:
● 1

08 Reset the event counter of the server with the diagnostic code 
0x000A:
● 1 WORD per call

3 to 10,
12 to 79,
82 to 255

   Reserved

MB_DATA_PTR parameter

Description
The MB_DATA_PTR parameter is a pointer to a data buffer for storing the data read from or 
written to the Modbus server. As the data buffer, you can use a global data block or a memory 
area (M).

For a buffer in the memory area (M), use a pointer in the ANY format as follows: "P#bit address" 
"data type" "length" (example: P#M1000.0 WORD 500).

The MB_DATA_PTR parameter uses a communications buffer:

The communications buffer is used:
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● For the communication functions of the "MB_CLIENT" instruction:

– Reading and writing of 1 bit of data of the Modbus server addresses 00001 to 09999 
and 10001 to 19999.

– Reading of 16-bit WORD data of the Modbus server addresses 30001 to 39999 and 
40001 to 49999.

– Writing of 16-bit WORD data of the Modbus server addresses 40001 to 49999.

● During data transmission (length: bit or WORD) from or to the global DB or the memory 
area (M) that you assigned with the MB_DATA_PTR parameter.

 

If you use a data block for the buffer in the MB_DATA_PTR parameter, you will need to assign 
data types to the DB elements.

● Use the 1-bit data type BOOL for a Modbus bit address

● Use a 16-bit data type such as WORD, UINT, INT or REAL for a Modbus WORD address.

● Use a 32-bit data type (double word) such as DWORD, DINT or REAL for two Modbus 
WORD addresses.

● With MB_DATA_PTR, you can also access complex DB elements such as:

– Standard arrays

– Structures with unique element names

– Complex structures with unique naming of the elements and data type lengths of 16 or 
32 bits.

● The data areas for the MB_DATA_PTR parameter can also be in different global data blocks 
(or in different memory areas). You can, for example, use a data block for the the read jobs 
and another one for the write jobs or a separate data block for each "MB_CLIENT" station.

CONNECT parameter

Connection descriptions at CONNECT parameter
Two different connection descriptions can be used for the "MB_CLIENT" instruction:

● Programmed connections with the structure TCON_IP_v4
The connection parameters are stored in the TCON_IP_v4 structure and the connection is 
set up with the call of the instruction "MB_CLIENT".

● Configured connections with the structure TCON_Configured
The configured connection has already been established by the CPU. Use the structure 
TCON_Configured to specify which existing connection is to be used for the instruction.

Each instance of the instruction "MB_CLIENT" requires a unique connection. Create a separate 
structure TCON_IP_v4 or TCON_Configured for each instance of the instruction to describe 
the connection.
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Connection description for programmed connections
Use the following structure for connection description to TCON_IP_v4 for programmed 
connections at the CONNECT parameter:

● Make sure that only connections of the type TCP are specified in the TCON_IP_v4 structure.

● The connection may not use the following TCP port numbers: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964.

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to this connection (value range: 1 to 4095).

The parameter uniquely identifies a connection within the 
CPU. Each individual instance of the instruction 
"MB_CLIENT" must use a unique ID.

4 ConnectionType BYTE 11 Connection type
Select 11 (decimal) for TCP. Other connection types are not 
permitted. If another connection type (e.g. UDP) is used, a 
corresponding error message is output at the STATUS 
parameter of the instruction.

5 ActiveEstablished BOOL TRUE ID for the manner in which the connection is established
Select TRUE for active connection establishment.

6 … 9 RemoteAddress ARRAY 
[1..4] of 
BYTE

- IP address of the connection partner (Modbus server), for 
example, for 192.168.0.1: 
● addr[1] = 192
● addr[2] = 168
● addr[3] = 0
● addr[4] = 1

10 … 
11

RemotePort UINT 502 Port number of the remote connection partner (value range: 
1 to 49151).
Use the IP port number of the server to which the client 
establishes the connection and communicates using the TCP/
IP protocol (default value: 502).

12 … 
13

LocalPort UINT 0 Port number of the local connection partner:
● Port numbers: 1 to 49151
● Any port: "0" 

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2815



 

 Note
Migration of the instruction "MB_CLIENT" version 2.1

The parameters CONNECT_ID, IP_PORT and IP_OCTET_x are mapped in version 3.0 of 
the "MB_CLIENT" instruction in the TCON_IP_v4 structure:
● The parameter CONNECT_ID of the "MB_CLIENT" V2.1 instruction corresponds to the 

ID parameter of TCON_IP_v4. 
● The parameter IP_PORT of the "MB_CLIENT" V2.1 instruction corresponds to the 

RemotePort parameter of TCON_IP_v4. 
● The four parameters IP_OCTET_x of the "MB_CLIENT" V2.1 instruction correspond to 

the array of the RemoteAddress parameter of TCON_IP_v4.
 

Connection description for configured connections
For programmed connections at the CONNECT parameter, use the following structure for 
connection description to TCON_Configured.

● Make sure that only connections of the type TCP are specified in the TCON_Configured 
structure.

● The connection may not use the following TCP port numbers: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964.

Byte Parameter Data type Start value Description
0 … 1 InterfaceId HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to this connection (value range: 1 to 4095).

Enter the connection ID of the existing connection.
4 ConnectionType BYTE 0 Connection type

Select 254 (decimal) for a configured connection.

Parameter STATUS 

Parameter STATUS (general status information)

STATUS* 
(W#16#)

Description

0000 Instruction executed without errors.
0001 Connection established.
0003 Connection terminated.
7000 No call active and no connection established (REQ=0).
7001 Connection establishment triggered.
7002 Intermediate call. Connection is being established.
7003 Connection is being terminated.
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STATUS* 
(W#16#)

Description

7004 Connection established and monitored. No job processing active.
7005 Data is being sent.
7006 Data is being received.
80BB Invalid value at ActiveEstablished parameter (identifier for the type of connection establishment, see 

CONNECT parameter (Page 2814)): 
● Only passive connection establishment permitted for server (ActiveEstablished = FALSE).
● Only active connection establishment permitted for client (ActiveEstablished = TRUE).

8380 Received Modbus frame has incorrect format or too few bytes were received.
* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (protocol error)

STATUS* 
(W#16#)

Error code in the error 
message from 
MB_SERVER (B#16#)

Description

8381 01 Function code is not supported.
8382 03 Error in data length:

● Invalid length specification in received Modbus frame.
● The length of the Modbus frame in the frame header does not match the 

number of received bytes.
● The number of bytes does not match the number of actually transmitted 

bytes (only functions 1-4).
● The received start address does not match the one sent originally (functions 

5, 6, 15, 16).
● The number of words does not match the number of actually transmitted 

words (only functions 15 and 16).
8383 02 Error reading or writing data or access outside the address area of 

MB_DATA_PTR (Page 2813).
The error can occur locally as well as with the instruction "MB_SERVER".

8384 03 Error in data value:
● Error in data value for function 5 (error on server).
● A different data value was received than was originally sent by the client 

(functions 5 and 6) (local error).
● Invalid exception code received.

8385 03 Diagnostic code is not supported (function code 08). The error can occur locally 
as well as on the server.

8386 - Received function code does not match the one sent originally.
8387 - ● The assigned connection ID is different from that used for previous requests. 

Only one connection ID can be used for each instance DB of the 
"MB_CLIENT" instruction.

● The error code is also output when the protocol ID of the Modbus TCP frame 
received by the server is not "0".
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STATUS* 
(W#16#)

Error code in the error 
message from 
MB_SERVER (B#16#)

Description

8388 15 or 16 The Modbus server sent a different data length than was requested. This error 
occurs only when using the Modbus functions 15 or 16.

* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (parameter error)

STATUS* 
(W#16#)

Description

80B6 Invalid connection type, only TCP connections are supported.
80C8 No response of the server in the defined period. Check the connection to the Modbus server. This error is only 

reported on completion of the configured repeated attempts. 
If the "MB_CLIENT" instruction does not receive an answer with the originally transferred transaction ID (see 
static MB_TRANSACTION_ID tag) within the defined period, this error code is output.

8188 The MB_MODE parameter has an invalid value.
8189 Invalid addressing of data at the MB_DATA_ADDR parameter.
818A Invalid data length at the MB_DATA_LEN parameter.
818B The MB_DATA_PTR parameter has an invalid pointer. You should also check the values of the 

MB_DATA_ADDR (Page 2813) and MB_DATA_LEN parameters.
818C Timeout at parameter BLOCKED_PROC_TIMEOUT or RCV_TIMEOUT (see static tags of instruction). The 

limit of 55 seconds has been exceeded.
818D The transaction ID (MB_TRANSACTION_ID tag) does not correspond to the one sent originally (see static 

tags of instruction).
8200 ● A different Modbus request is currently being processed via the port.

● Another instance of MB_CLIENT with the same connection parameters is processing an existing Modbus 
request.

* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error codes of internally used communications instructions

With the "MB_CLIENT" instruction, in addition to the errors listed in the tables, errors caused 
by the communication instructions ("TCON", "TDISCON", "TSEND", "TRCV", "T_DIAG" and 
"TRESET") used by the instruction can occur.

The error codes are assigned via the instance data block of the "MB_CLIENT" instruction. 
The error codes are displayed for the respective instruction under STATUS in the "Static" 
section.

The meaning of the error codes is available in the documentation of the corresponding 
communications instruction.
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See also
GET_ERR_ID: Get error ID locally (Page 1787)

MB_SERVER: Communicating via PROFINET as a Modbus TCP server

Description of MB_SERVER

Description
The "MB_SERVER" instruction communicates as Modbus TCP server via a PROFINET 
connection. The "MB_SERVER" instruction processes connection requests of a Modbus TCP 
client, receives and processes Modbus requests and sends responses.

The "MB_SERVER" instruction V3.0 can be used for the S7-1500 as well as for the S7-1200 
version 4.0 or higher. The connection can take place via the local interface of the CPU or CM/
CP.

To use the instruction, you do not require an additional hardware module.

Multiple server connections
You can create multiple Server connections. This allows a single CPU to accept connections 
from multiple Modbus TCP clients at the same time.

A Modbus TCP server can support several TCP connections and the maximum number of 
connections depends on the CPU being used.

The total number of connections of one CPU, including those of the Modbus TCP clients and 
server must not exceed the maximum number of supported connections. 

Modbus TCP connections can also be shared by "MB_CLIENT" and/or "MB_SERVER" 
instances.

In the case of Server connections, remember the following rules:

● Each "MB_SERVER" connection must use a unique instance DB.

● Each "MB_SERVER" connection must use a unique connection ID.
The relevant individual connection ID must be used for each individual instance DB of the 
instruction. The connection ID and instance DB belong together in pairs and must be unique 
for each connection.

● For each connection, the "MB_SERVER" instruction must be called individually.
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Parameters
The following table shows the parameters of the "MB_SERVER" instruction:

Parameter Declaration Data type Description
DISCONNECT Input BOOL The "MB_SERVER" instruction is used to enter into a passive connection 

with a partner module. The server responds to a connection request from 
the IP address which is entered in the SDT "TCON_IP_v4" in the 
CONNECT parameter.  
You can use this parameter to control when a connection request is 
accepted:
● 0: A passive connection is established when there is no 

communications connection.
● 1: Initialization of the connection termination.  If the input is set, no 

other operations are executed. The value 0003 is output at the 
STATUS parameter after successful connection termination.

MB_HOLD_REG 
(Page 2822) 

InOut VARIANT Pointer to the Modbus holding register of the "MB_SERVER" instruction
The holding register contains the values that may be accessed by a 
Modbus client using the Modbus functions 3 (read), 6 (write) and 16 
(read).
As the holding register, use either a global data block with optimized 
access or the memory area of the bit memories.

CONNECT 
(Page 2823)

InOut VARIANT Pointer to the structure of the connection description
The following structures (SDTs) can be used:
● TCON_IP_v4: Includes all address parameters required for 

establishing a programmed connection. The default address is 0.0.0.0 
(any IP address), but you can enter a specific IP address so that the 
server only responds to requests from this address. When using 
TCON_IP_v4, the connection is established when calling the 
instruction "MB_SERVER".

● TCON_Configured: Includes the address parameters of a configured 
connection. When using TCON_Configured, the connection is 
established by the CPU after download of the hardware configuration.

NDR Output BOOL "New Data Ready":
● 0: No new data
● 1: New data written by the Modbus client written

DR Output BOOL "Data Read":
● 0: No data read
● 1: Data read by the Modbus client

ERROR Output BOOL If an error occurs during the call of the "MB_SERVER" instruction, the 
output of the ERROR parameter is set to "1". Detailed information about 
the cause of the problem is indicated by the STATUS parameter. 

STATUS 
(Page 2825) 

Output WORD Detailed status information of the instruction.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Static tags of the instruction
The following table describes the static tags of the instance data block of the "MB_SERVER" 
instruction used in the program. You can write the HR_Start_Offset tag. You can read the other 
tags to monitor the Modbus status.

Tag Data type Start value Description
HR_Start_Offset WORD 0 Assign the start address of the Modbus holding register.
Request_Count WORD 0 Total number of requests received by the server.
Server_Message_Co
unt

WORD 0 Total number of received messages for the relevant Server.

Xmt_Rcv_Count WORD 0 Counter for detecting the number of transfers during which an error 
occurred. The counter is only incremented when an invalid Modbus 
request is received.

Exception_Count WORD 0 Counters for detecting the number of errors specifically for Modbus which 
cause an error message to "MB_CLIENT".

Success_Count WORD 0 Event counter for detecting the number of requests that were 
successfully executed by the server.

Connected BOOL 0 Indicates whether the connection to the assigned client has been 
established or not: 1 = connected, 0 = not connected.

Mapping of Modbus addresses to the process image
The "MB_SERVER" instruction allows incoming Modbus functions (1, 2, 4, 5 and 15) direct 
read and write access to the process image inputs and outputs of the CPU (use of the data 
types BOOL and WORD). 

For the data transfer of the function codes 3, 6 and 16, the holding register (MB_HOLD_REG 
parameter) must be defined longer than one byte. The following table shows the mapping of 
the Modbus addresses to the process image of the CPU.

Modbus function S7-1500, S7-1200 V4.0
Function 
code

Function Data area Address space Data area CPU address

01 Read: Bits Output 1 to 9999 Process image output Q0.0 to Q1248.6
02 Read: Bits Input 10001 to 19999 Process image input I0.0 to I1248.6
04 Read: WORD Input 30001 to 39999 Process image input IW0 to IW19996
05 Write: Bits Output 1 to 9999 Process image output Q0.0 to Q1248.6
15 Write: Bits Output 1 to 9999 Process image output Q0.0 to Q1248.6

Incoming Modbus requests with the function codes 3, 6, 16 and 23 write to or read from the 
Modbus holding register (you specify the holding register with the MB_HOLD_REG parameter).

Example: Addressing via static tag HR_Start_Offset
The addresses of the Modbus holding register start at 40001. These addresses correspond to 
the address space of the CPU memory area for the holding register. You can also define the 
HR_Start_Offset tag so that the Modbus holding register has a start address other than 40001.
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Example: The holding register begins at MW100, and has a length of 100 WORD. An offset 
value in the HR_Start_Offset parameter means that the start address of the holding register is 
moved from 40001 to 40021. Whenever the holding register is addressed below the address 
40021 and above the address 40120, this causes an error.

HR_Start_Offset Address Minimum Maximum
0 Modbus address (WORD) 40001 40100

CPU address MW100 MW298
20 Modbus address (WORD) 40021 40120

CPU address MW100 MW298

Modbus diagnostics functions
The table below contains a description of the Modbus diagnostics functions.

Function 
code

Diagnostic 
code

Description

08 0x0000 Echo test: The "MB_SERVER" instruction receives a data word and returns this unchanged 
to the Modbus client.

08 0x000A Reset event counter: The "MB_SERVER" instruction resets the following event counters: 
"Success_Count", "Xmt_Rcv_Count", "Exception_Count", "Server_Message_Co" and 
"Request_Count".

11 - Fetch event counter of the communication: The "MB_SERVER" instruction uses an internal 
event counter for communication to record the number of successfully executed read and 
write requests sent to the Modbus server.
The event counter is not incremented with the functions 8 or 11. The same holds true for 
requests that cause a communications error, for example, if a protocol error has occurred 
(e.g., the function code in the received Modbus request is not supported).

MB_HOLD_REG parameter

Description
The MB_HOLD_REG parameter is a pointer to a data buffer for storing the data read from or 
written to the Modbus server. You can use a global data block or a bit memory (M) as memory 
area.

● The high limit for the number of addresses in the data block (D) is determined by the 
maximum work memory of the CPU. 

● The high limit for the number of bit memories (M) is determined by the size of the CPU 
memory area.

The following table shows examples of mapping Modbus addresses to the holding register for 
the Modbus functions 3 (read WORD), 6 (write WORD), 16 (write several WORD) and 23 (write 
and read several words). 
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Modbus 
addresses

MB_HOLD_REG parameter - examples

40001 MW100 DB10.DBW0 "Recipe".ingredient[1]
40002 MW102 DB10.DBW2 "Recipe".ingredient[2]
40003 MW104 DB10.DBW4 "Recipe".ingredient[3]
40004 MW106 DB10.DBW6 "Recipe".ingredient[4]
40005 MW108 DB10.DBW8 "Recipe".ingredient[5]

CONNECT parameter

Connection descriptions at CONNECT parameter
Two different connection descriptions can be used for the "MB_SERVER" instruction:

● Programmed connections with the structure TCON_IP_v4
The connection parameters are stored in the TCON_IP_v4 structure and the connection is 
set up with the call of the instruction "MB_SERVER".

● Configured connections with the structure TCON_Configured
The configured connection has already been established by the CPU. Use the structure 
TCON_Configured to specify which existing connection is to be used for the instruction.

Each instance of the instruction "MB_SERVER" requires a unique connection. Create a 
separate structure TCON_IP_v4 or TCON_Configured for each instance of the instruction to 
describe the connection.

Connection description for programmed connections
For programmed connections at the CONNECT parameter, use the following structure for 
connection description to TCON_IP_v4.

● Make sure that only connections of the type TCP are specified in the TCON_IP_v4 structure.

● The connection may not use the following TCP port numbers: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964.

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to this connection (value range: 1 to 4095).

The parameter uniquely identifies a connection within the 
CPU. Each individual instance of the instruction 
"MB_SERVER" must use a unique ID.

4 ConnectionType BYTE 11 Connection type
Select 11 (decimal) for TCP. Other connection types are not 
permitted. If another connection type (e.g. UDP) is used, a 
corresponding error message is output at the STATUS 
parameter of the instruction.

5 ActiveEstablished BOOL FALSE ID for the manner in which the connection is established
Select FALSE for passive connection establishment.
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Byte Parameter Data type Start value Description
6 … 9 RemoteAddress ARRAY 

[1..4] of 
BYTE

0.0.0.0 IP address of the connection partner, for example, for 
192.168.0.1: 
● addr[1] = 192
● addr[2] = 168
● addr[3] = 0
● addr[4] = 1
If the instruction "MB_SERVER" is to accept connection 
requests from any connection partner, use "0.0.0.0" as IP 
address.

10 … 
11

RemotePort UINT 0 Port number of the remote connection partner (value range: 
1 to 49151).
If the instruction "MB_SERVER" is to accept connection 
requests from any remote partner, use "0" as port number.

12 … 
13

LocalPort UINT 502 Port number of the local connection partner (value range: 1 
to 49151).
The number of the IP port defines which IP port is monitored 
for connection requests of the Modbus client. 
The following TCP port numbers must not be used for the 
passive connection of the "MB_SERVER" instruction: 20, 21, 
25, 80, 102, 123, 5001, 34962, 34963 and 34964. 

 

 Note
Migration of the instruction "MB_SERVER" version 2.1

The parameters CONNECT_ID and IP_PORT are mapped in version 3.0 of the 
"MB_SERVER" instruction in the TCON_IP_v4 structure:
● The parameter CONNECT_ID of the "MB_SERVER" V2.1 instruction corresponds to the 

ID parameter of TCON_IP_v4. 
● The parameter IP_PORT of the "MB_SERVER" V2.1 instruction corresponds to the 

LocalPort parameter of TCON_IP_v4. 
 

Connection description for configured connections
For configured connections at the CONNECT parameter, use the following structure for 
connection description to TCON_Configured.

● Make sure that only connections of the type TCP are specified in the TCON_Configured 
structure.

● The connection may not use the following TCP port numbers: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964.
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Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to this connection (value range: 1 to 4095).

Enter the connection ID of the existing connection.
4 ConnectionType BYTE - Connection type

Select 254 (decimal) for a configured connection.

Parameter STATUS

Parameter STATUS (general status information)

STATUS* 
(W#16#)

Description

0000 Instruction executed without errors.
0001 Connection established.
0003 Connection terminated.
7000 No call active (REQ=0).
7001 First call. Connection establishment triggered.
7002 Intermediate call. Connection is being established.
7003 Connection is being terminated.
7005 Data is being sent.
7006 Data is being received.
80BB Invalid value at ActiveEstablished parameter (identifier for the type of connection establishment, see 

CONNECT parameter (Page 2823)): 
● Only passive connection establishment permitted for server (active_established = FALSE).
● Only active connection establishment permitted for client (active_established = TRUE).

8380 Received Modbus frame has incorrect format or too few bytes were received.
* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (parameter error)

STATUS* 
(W#16#)

Error code in the error 
message from 
"MB_SERVER" (B#16#)

Description

8187 No response The MB_HOLD_REG parameter has an invalid pointer. Data area is too small.
8381 01 Function code is not supported.
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STATUS* 
(W#16#)

Error code in the error 
message from 
"MB_SERVER" (B#16#)

Description

8382 03 Error in data length:
● Invalid length specification in received Modbus frame
● The frame length entered in the header of the Modbus frame does not match 

the number of actually received bytes.
● The number of bytes entered in the header of the Modbus frame does not 

match the number of actually received bytes (functions 15 and 16).
8383 02 Error in data address or access outside the address area of the holding register 

(MB_HOLD_REG (Page 2822) parameter).
8384 03 Invalid data value (function 5).
8385 03 Diagnostic code is not supported (only with function code 08).
* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error codes of internally used communications instructions

With the "MB_SERVER" instruction, in addition to the errors listed in the tables, errors caused 
by the communication instructions ("TCON", "TDISCON", "TSEND", "TRCV", "T_DIAG" and 
"T_RESET") used by the instruction can occur.

The error codes are assigned via the instance data block of the "MB_SERVER" instruction. 
The error codes are displayed for the respective instruction under STATUS in the "Static" 
section.

The meaning of the error codes is available in the documentation of the corresponding 
communications instruction.

 

See also
GET_ERR_ID: Get error ID locally (Page 1787)

9.7.5.2 S7 communication

Data consistency

Definition 
The size of the data area which can be modified simultaneously by concurrent processes is 
called the consistent data area. Data areas which are larger than the consistent data area can 
thus be falsified as a whole.

This means that a data area which belongs together and which is larger than consistent data 
area can consist in part of new and of old consistent data blocks at the same time.
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Example
An inconsistency can arise if a communication block is interrupted, for example, by a hardware 
interrupt OB with a higher priority. If the user program in this OB now changes the data which 
have already been processed in part by the communication block, the transferred data 
originate:

● In part from the time before the hardware interrupt was processed

● And in part from the time after the hardware interrupt was processed

This means that these data are inconsistent (not coherent).

Effect
If larger packages of data are to be transferred in a consistent form, the transfer should not be 
interrupted. This can, for example, increase the interrupt reaction time of the CPU. 

In other words: The greater the quantity of data which must be transferred with absolute 
consistency, the longer the interrupt reaction time of a system.

Data consistency with SIMATIC
● If the user program contains a communication function that accesses common data, access 

to this data area can be coordinated, e.g., by means of the DONE parameter itself. The 
data consistency of the communication areas which are transferred locally with a 
communication block can therefore be ensured in the user program.

● In the case of S7 communication instructions "PUT (Page 2833)"/"GET (Page 2831)", the 
size of the consistent data areas must already be taken into consideration during 
programming or configuration, because a communication block is not available in the user 
program of the target device (server) to synchronize communication data to the user 
program.

● For the S7-300 and C7-300 (exception: CPU 318-2 DP) the communication data are copied 
consistently into the user memory in blocks of 32 bytes in the cycle control point of the 
operating system. Data consistency is not guaranteed for larger data areas. If a defined 
data consistency is required, the communication data in the user program may not exceed 
32 bytes (maximum of 8 bytes, depending on the version).

● In the S7-400 and S7-1500, on the other hand, the communication data in 462-byte blocks 
are not processed in the cycle control point, but in fixed time slices during the program 
cycle. The consistency of a tag is ensured by the system. These communication areas can 
then be accessed consistently using the "PUT (Page 2833)" / "GET (Page 2831)" 
instructions or when reading/writing tags, for example by an OP or an OS.

 

  Note

Additional information on data consistency is provided in the description of the specific 
instructions.
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Common parameters of instructions for S7 communication

Classification
The parameters of the instructions for S7 communication can be divided into the following five 
categories according to their functions:

1. Control parameters are used to activate an instruction.

2. Addressing parameters are used to address the remote communication partner.

3. Send parameters point to the data areas that are to be sent to the remote partner.

4. Receive parameters point to the data areas where the data received from remote partners 
will be entered.

5. Status parameters are used to monitor whether the instruction has completed its task 
without error or for the analysis of any errors that have occurred.

Control parameter
Data exchange will only be activated if the appropriate control parameters have a defined value 
(for example, are set) when the instruction is called or when the value has undergone a specific 
change since the previous call (for example, a positive edge).

Addressing parameters

Parameter Description
ID Reference to the local connection description (specified by the configuration of the 

connection). Note: The ID W#16#EEEE is not permitted for S7communication instructions.
R_ID With the R_ID parameter, you specify that a send and a receive instruction belong 

together: The R_ID parameter must match in the instruction at the sending end and the 
instruction at the receiving end.
This allows the communication of several instruction pairs via the same logic connection.
● R_ID must be specified in the form DW#16#wxyzWXYZ.
● The instruction pairs of a logical connection specified in R_ID must be unique for this 

connection.
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 Note
Addressing parameters ID and R_ID

You can reassign the addressing parameters ID and R_ID during runtime. The new 
parameters are validated with each new job after the previous job has been closed.

You can use the following options to reduce the number of instance DBs and therefore the 
work memory required:
1. With tag IDs, you can use several connections via one data instance block.
2. With tag R_IDs, you can define several pairs of sending and receiving instructions for one 

job with a single instance.
3. You can combine cases 1 and 2.

Please note that the new parameters are valid after the last job is executed. When you activate 
the sending operation, the R_ID parameter in the instruction at the sending end must match 
its counterpart at the receiving end.

 

Status parameter 
With the status parameters, you monitor whether the instruction has completed its task 
correctly or whether it is still active. The status parameters also indicate errors.

 

 Note

The status parameters are valid for one cycle only, namely from the first command following 
the call until the next call. As a result, you must evaluate these parameters after each 
instruction cycle.

 

Send and receive parameters
For communication instructions configured at both ends 

● The number of the SD_i and RD_i parameters used must match at the send and receive 
end.

● The data types of the SD_i and RD_i parameters that belong together must match at the 
send and receive end.

● The amount of data to be sent according to the SD_i parameter must not exceed the range 
made available by the corresponding RD_i (does not apply to "BSEND 
(Page 2839)" / "BRCV (Page 2841)"). The RD_i parameters must (with exception of 
"BSEND"/"BRCV") have the identical data size.
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If you do not keep to the rules above, this is indicated by ERROR = 1 and STATUS = 4.
 

 Note
Supplying the send and receive parameters  

With the VARIANT data type, send and receive parameters must always be supplied any 
time a communication instruction is called. It is not possible, for example, to supply the send 
buffer of the communication instruction at startup and to only trigger the send job in cyclic 
operation.

 

User data size
With the "USEND (Page 2836)", "URCV (Page 2837)", "GET (Page 2831)" and "PUT 
(Page 2833)" instructions, the amount of data to be transferred must not exceed a defined user 
data size. The maximum user data size depends on:

● The instruction used

● The communication partner.

The guaranteed minimum size of the user data for an instruction with 1-4 tags is listed in the 
following table:

Instruction Partner: S7-300 Partner: S7-400 Partner: S7-1200 Partner: S7-1500
PUT / GET 160 bytes 400 bytes 160 bytes 880 bytes
USEND / URCV 160 bytes 440 bytes - 920 bytes
BSEND / BRCV 32768/65534 

bytes
65534 bytes - 65534 bytes

Further information on the user data size can be found in the technical data of the respective 
CPU.

Exact user data size
If the user data size specified above is insufficient you can determine the maximum byte length 
of the user data as follows:

First read the data block size valid for communication from the following table:

Local CPU Remote CPU Data block size in bytes
S7-1200 Any 240
S7-1500
 

S7-300 240
S7-400 480
S7-1200 240
S7-1500 960
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Use this value in the following table to read the maximum possible user data length in bytes 
as total of the parameters used. It applies for even lengths of the areas SD_i, RD_i, and 
ADDR_i. 

For each range of uneven length the maximum possible user data length is reduced by one 
byte.

 Number of SD_i, RD_i, ADDR_i parameters used
Data block size Instruction 1 2 3 4
240 (S7-300) PUT/GET/

USEND
160 - - -

240 (S7-300 via 
integrated interface)

PUT 212 - - -
GET 222 - - -
USEND 212 - - -

240 (S7-400) PUT 212 196 180 164
GET 222 218 214 210
USEND 212 - - -

480 (S7-400) PUT 452 436 420 404
GET 462 458 454 450
USEND 452 448 444 440

240 (S7-1200) PUT 212 196 180 164
GET 222 218 214 210

960 (S7-1500) PUT 932 916 900 884
GET 942 938 934 930
USEND 932 928 924 920

GET: Read data from a remote CPU

Description
With the instruction "GET", you can read data from a remote CPU. This is only possible if the 
"Allow remote partner access via PUT/GET communication" function was activated for the 
partner CPU in the properties of the CPU in "Protection". You cannot use the "GET" instruction 
to access blocks that were created with "optimized" access type. 

The instruction is started on a rising edge at control input REQ. The relevant pointers to the 
areas to be read out (ADDR_i) are then sent to the partner CPU. The remote CPU can be in 
RUN or STOP mode. The remote partner returns the data. 

● A zero at any of the ADDR_i parameters will be ignored. The received data is copied to the 
configured receive areas (RD_i) at the next call. 

● Make sure that the areas defined with the parameters ADDR_i and RD_i match in terms of 
number, length and data type. 
The area to be read (ADDR_i parameter) may not be smaller than the area for data storage 
(RD_i parameter). Both areas must match in terms of number, length and data type.
If the response exceeds the maximum user data length, this is indicated with the error code 
"2" at the STATUS parameter.
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Changes in the data areas addressed on the partner CPU are not registered by the "GET" 
instruction. 

Completion of this action is indicated by the status parameter NDR having the value "1". 
Reading can only be activated again after the previous reading process has been completed. 

Errors and warnings are output via ERROR and STATUS if access problems occurred while 
the data was being read or if the data type check results in an error.

Parameters
The following table shows the parameters of the "GET" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter request, activates the 
data exchange on a rising edge.

ID Input CONN_PRG 
(WORD)

I, Q, M, D, L or 
constant

Addressing parameters for specifying the 
connection to the partner CPU.

NDR Output BOOL I, Q, M, D, L Status parameter NDR: 
● 0: Job not yet started or still running.
● 1: Job successfully completed.

ERROR
 

Output BOOL I, Q, M, D, L Status parameters ERROR and STATUS, 
error code:
● ERROR=0

STATUS has the value:
– 0000H: Neither warning nor error
– <> 0000H: Warning, STATUS 

supplies detailed information.
● ERROR=1

An error has occurred. STATUS 
supplies detailed information on the type 
of error.

STATUS Output WORD I, Q, M, D, L

ADDR_1 InOut REMOTE I, Q, M, D
 

Pointers to the areas on the partner CPU 
that are to be read.
When the REMOTE pointer accesses a DB, 
the DB must always be specified. 
Example: P#DB10.DBX5.0 Byte 10.
When transferring data structures (e.g., 
Struct, Array), the data type CHAR, BYTE, 
WORD or DWORD must be used at the 
ADDR parameter.

ADDR_2 InOut REMOTE
ADDR_3 InOut REMOTE
ADDR_4 InOut REMOTE

RD_1 InOut VARIANT I, Q, M, D, L Pointers to the areas on the local CPU in 
which the read data is entered.RD_2 InOut VARIANT

RD_3 InOut VARIANT
RD_4 InOut VARIANT

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".
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Parameters ERROR and STATUS
The following table contains all specific error information for the "GET" instruction that can be 
output via the ERROR  and STATUS  parameters.

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: New job not active because the previous job is still busy.
0 25 Communication has started. The job is being processed.
1 1 Communications problems, for example

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 2 ● Negative acknowledgement from the partner device. The function cannot be executed.
● Response from the remote station exceeds the maximum user data length.
● For S7-1500: Access protection for remote station activated.

1 4 Error in the pointers to the data storage RD_i:
● Data types of the parameters RD_i and ADDR_i are not compatible with each other.
● The length of the area RD_i is smaller than the length of the data of the ADDR_i parameter 

that is to be read.
1 8 Access error on the partner CPU.
1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with low priority (first call).
 

 Note
Data consistency

Data is received consistently if you read the part of the receive area RD_i currently being 
used completely before initiating another job.

 

See also
Common parameters of instructions for S7 communication (Page 2828)

PUT: Write data to a remote CPU

Description
You can write data to a remote CPU with the instruction "PUT". This is only possible if the 
"Permit access via PUT/GET communication from remote partner" function was activated for 
the partner CPU in the properties of the CPU under "Protection". You cannot use the "PUT" 
instruction to access blocks that were created with "optimized" access type. The remote CPU 
can be in RUN or STOP mode.
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The instruction is started on a rising edge at control input REQ. The pointers to the areas to 
be written (ADDR_i) and the data (SD_i) are then sent to the partner CPU. Make sure that the 
areas defined with the parameters ADDR_i and SD_i match in terms of number, length and 
data type. 

● The data to be sent is copied from the configured send areas (SD_i) with a positive edge 
at the REQ parameter. 

● Make sure that the areas defined with the parameters ADDR_i and SD_i match in terms of 
number, length and data type.
The area to be written (ADDR_i parameter) may not be larger than the send area (SD_i 
parameter). Both areas must match in terms of number, length and data type.

The remote partner saves the required data under the addresses supplied with the data and 
returns an execution acknowledgement. If no errors occur, this is indicated at the next 
instruction call with status parameter DONE = "1". The writing process can only be activated 
again after the last job is complete.

Errors and warnings are output via ERROR and STATUS if access problems occurred while 
the data was being written or if the execution check results in an error.

Parameters
The following table shows the parameters of the "PUT" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter request, activates the data 
exchange on a rising edge.

ID Input CONN_PRG
(WORD)

I, Q, M, D, L or 
constant

Addressing parameters for specifying the 
connection to the partner CPU.

DONE Output BOOL I, Q, M, D, L Status parameter DONE: 
● 0: Job not yet started or still executing
● 1: Job executed without errors.

ERROR
 

Output
 

BOOL
 

I, Q, M, D, L Status parameters ERROR and STATUS, 
error code:
● ERROR=0

STATUS has the value:
– 0000H: Neither warning nor error
– <> 0000H: Warning, STATUS supplies 

detailed information.
● ERROR=1

An error has occurred. STATUS supplies 
detailed information on the type of error.

STATUS Output WORD I, Q, M, D, L

ADDR_1 InOut REMOTE I, Q, M, D Pointers to the areas on the partner CPU to 
which the data will be written.
When the REMOTE pointer accesses a DB, 
the DB must always be specified. 
Example: P#DB10.DBX5.0 Byte 10.
When transferring data structures (e.g., Struct, 
Array) the data type CHAR must be used at the 
ADDR_i parameters.

ADDR_2 InOut REMOTE
ADDR_3 InOut REMOTE
ADDR_4 InOut REMOTE
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Parameter Declaration Data type Memory area Description
SD_1 InOut VARIANT I, Q, M, D, L Pointers to the areas on the local CPU which 

contain the data to be sent.
Only the data types BOOL, BYTE, CHAR, 
WORD, INT, DWORD, DINT, REAL are 
permitted.
When transferring data structures (e.g., Struct, 
Array) the data type CHAR must be used at the 
SD_i parameters.

SD_2 InOut VARIANT
SD_3 InOut VARIANT
SD_4 InOut VARIANT

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters ERROR and STATUS
The following table contains all specific error information for the "PUT" instruction that can be 
output via the ERROR and STATUS parameters.

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: New job not active because the previous job is still busy.
0 25 Communication has started. The job is being processed.
1 1 Communications problems, for example

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 2 ● Negative acknowledgement from the partner device. The function cannot be executed.
● For S7-1500: Access protection for remote station activated.

1 4 Error in the pointers to the data storage:
● Data types of the parameters SD_i and ADDR_i are not compatible with each other.
● The length of the area SD_i is greater than the length of the data of the ADDR_i parameter 

that is to be written.
● Not possible to access SD_i.
● Maximum user data size exceeded.
● Number of the parameters SD_i and ADDR_i does not match.

1 8 Access error with the partner CPU (e.g. DB not loaded or write-protected).
1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with low priority (first call).
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Data consistency
When a send operation is activated (rising edge at REQ), the data to be sent from the send 
area SD_i is copied from the user program. After the block call, you can write to these areas 
without corrupting the current send data.

 

 Note

The send operation is only complete when the DONE status parameter has the value "1".
 

Other

USEND: Send data uncoordinated

Description
The "USEND" instruction sends data to a remote partner instruction of type "URCV 
(Page 2837)". The sending process is carried out without coordination with the partner 
instruction. This means that the data transfer is carried out without acknowledgement by the 
partner instruction.

When a send operation is activated (rising edge at REQ), the data to be sent from the send 
areas SD_i are copied from the user program. After the instruction call, you can write to these 
send areas again without corrupting the current send data.

Successful completion of the send operation is indicated by the value of the DONE  status 
parameter being set to "1".

Parameters
The following table shows the parameters of the "USEND" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter request, activates the data 
exchange on a rising edge.

ID Input CONN_PRG M, D or constant Addressing parameters for specifying the 
connection to the partner CPU.

R_ID Input CONN_R_ID I, Q, M, D, L or 
constant

Addressing parameter R_ID for defining the 
instruction pairs "USEND" and "URCV".
See also: Common parameters of instructions for 
S7 communication (Page 2828)

DONE Output BOOL I, Q, M, D, L Status parameter
● 0: Job not yet started or still executing.
● 1: Job executed without errors.

ERROR
 

Output
 

BOOL
 

I, Q, M, D, L
 

Status parameter
● 0: Neither warning nor error.
● 1: An error has occurred. STATUS supplies 

detailed information on the type of error.
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Parameter Declaration Data type Memory area Description
STATUS Output WORD I, Q, M, D, L Status parameter

See "ERROR and STATUS parameters" table.
SD_i (1≤ i ≤4) InOut VARIANT M, D Pointer to the i-th send area. 

The only valid data types are BOOL  (not valid: 
bit array), BYTE, CHAR, WORD, INT, DWORD, 
DINT, REAL.
The maximum user data size for SD_i 
parameters depends on the partner CPU 
("URCV" instruction) and on the number of 
parameters used. 
Additional information is available in: Common 
parameters of instructions for S7 
communication (Page 2828)

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameters ERROR and STATUS

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: New job not active because the previous job is still busy.
0 25 Communication has started. The job is being processed.
1 1 Communication problem has occurred. Possible causes:

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 4 ● Errors in the send area pointers SD_i relating to the data length or the data type.
● Maximum user data length was exceeded.

1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 18 Value at R_ID parameter already exists in the connection specified at the ID parameter (R_ID value 

must be unique for the connection).
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with lower priority (first call).

URCV: Receive data uncoordinated

Description
The "URCV" instruction receives data asynchronously from a remote partner instruction of type 
"USEND (Page 2836)" and copies this data into the configured receive areas.

The instruction is ready to receive if there is a logical 1 at the EN_R input. An active job can 
be canceled with EN_R=0.
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The receive data areas are referenced by the parameters RD_1 to RD_4. Make sure that the 
areas defined by the parameters RD_i / RD_1 and SD_i / SD_1 (with the associated partner 
instruction "USEND (Page 2836)") match in terms of number and length.

Successful completion of the copy operation is indicated when the value of the NDR  status 
parameter is set to logical "1". Once the status parameter NDR  has changed to "1", there will 
be new receive data in your receive areas (RD_i). A new block call may cause these data to 
be overwritten with new receive data. If you want to prevent this, call "URCV" (for example, 
during cyclic block processing) with the value 0 at EN_R until you have finished processing 
the received data.

Parameters
The following table shows the parameters of the "URCV" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Control parameter enabled to receive, signals 
ready to receive if the input is set.

ID Input CONN_PR
G

M, D or constant Addressing parameters for specifying the 
connection to the partner CPU.

R_ID Input CONN_R_I
D

I, Q, M, D, L or 
constant

Addressing parameter for defining the instruction 
pairs "USEND" and "URCV".
See also: Common parameters of instructions for 
S7 communication (Page 2828)

NDR Output BOOL I, Q, M, D, L Status parameter
● 0: Job not yet started or still running.
● 1: Job successfully completed.

ERROR
 

Output
 

BOOL
 

I, Q, M, D, L
 

Status parameter
● 0: Neither warning nor error
● 1: An error has occurred. STATUS supplies 

detailed information on the type of error.
STATUS Output WORD I, Q, M, D, L Status parameter

See "ERROR and STATUS parameters" table.
RD_i (1≤ i ≤4) InOut VARIANT I, Q, M, D Pointer to the i-th receive area:

The only valid data types are BOOL (not valid: bit 
array), BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL.
Additional information is available in: Common 
parameters of instructions for S7 communication 
(Page 2828)

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameters ERROR and STATUS

ERROR STATUS 
(decimal)

Explanation

0 9 Warning: older received data is overwritten by newer received data.
0 11 Warning: The received data is already being processed in a priority class with lower priority (error 

can occur when copying data to the receive area).
0 25 Communication has started. The job is being processed.
1 1 Communication problem has occurred. Possible causes:

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 4 Errors in the receive area pointers RD_i relating to the data length or the data type.
1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 18 Value at R_ID parameter already exists in the connection specified at the ID parameter (R_ID 

value must be unique for the connection).
1 19 The associated "USEND (Page 2836)" instruction sends data faster than it can be copied to the 

receive areas by "URCV".
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with lower priority (first call).

BSEND: Send data in segments

Description
The "BSEND" instruction sends data to a remote partner instruction of type "BRCV 
(Page 2841)". With this type of data transfer, more data can be transported between the 
communication partners than is possible with all other communication instructions for 
configured S7 connections. In each case, the maximum data volume amounts to 65534 bytes 
for the integrated interface and for SIMATIC Net CP.

Functional description
You specify the instruction pair "BSEND" and "BRCV" with the input parameter R_ID. The R_ID 
parameter must be identical in the related instructions. 

The send job is activated after the instruction is called and a rising edge is detected at control 
input REQ. After the call, "BSEND" is not processed in the background, which means the data 
can only be read within the user program. 

The data area to be transmitted is segmented. Each segment is sent individually to the partner. 
The last segment is acknowledged by the partner after the application of this segment by 
"BRCV (Page 2841)". If the data is segmented, "BSEND" must be called multiple times until 
all segments have been transferred.

The data area of the data to be sent is specified by SD_1. To ensure data consistency, you 
may only write to the part of the currently used sending area SD_1 after the current send 
operation is complete. This is the case when the value of the status parameter DONE changes 
to "1".
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The length of the send data is specified by LEN based on the job. With LEN = "0", all data 
addressed with the SD_1 parameter is sent.

If there is a rising edge at control input R, the current sending process is canceled.

Due to the asynchronous data transfer, a new data transfer can only be initiated if the previous 
data has been fetched by a partner instruction call. When the data has been collected, the 
status parameter "NDR" is set in the partner instruction "BRCV".

 
 

 Note
Migration of S7-400 user programs

An S7-400 CPU interprets the parameter SD_1 as pointer and not as data area. 

With S7-1500, LEN may not exceed the area of SD1. This was permitted with S7-400. 
Recommendation: Use the maximum size for the LEN parameter (65534 bytes for the 
integrated interface) as size of the data area at the SD_1 parameter.

 

Parameters
The following table shows the parameters of the "BSEND" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter request, activates the data 
exchange at a rising edge.

R Input BOOL I, Q, M, D, L or 
constant

Control parameter reset, activates an abort of the 
current data exchange at a rising edge

ID Input CONN_PR
G

M, D or constant Addressing parameters for specifying the connection 
to the partner CPU.

R_ID Input CONN_R_I
D

I, Q, M, D, L or 
constant

Addressing parameter for defining the instruction 
pairs "BSEND" and "BRCV (Page 2841)".
See also: Common parameters of instructions for S7 
communication (Page 2828)

SD_1 InOut VARIANT I, Q, M, D Pointer to send area
LEN InOut WORD I, Q, M, D, L Length of the block of data to be sent in bytes.

With LEN = "0", all data is sent by SD_1.
DONE Output BOOL I, Q, M, D, L Status parameter

● 0: Job not yet started or still executing.
● 1: Job executed without errors.

ERROR Output BOOL I, Q, M, D, L Status parameter
● 0: Neither warning nor error.
● 1: An error has occurred. STATUS supplies 

detailed information on the type of error.
STATUS Output WORD I, Q, M, D, L Status parameter

See "ERROR and STATUS parameters" table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2840 System Manual, 07/2013,  



Parameters ERROR and STATUS
The following table contains all specific error information for "BSEND" that can be output via 
the ERROR  and STATUS  parameters.

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: New job not active because the previous job is still busy.
0 25 Communication has started. The job is being processed.
1 1 Communication problem has occurred. Possible causes:

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 2 Negative acknowledgement of partner instruction. The instruction cannot be executed.
1 3 R_ID  is unknown on the connection specified by the ID or the receive block 

has not yet been called.
1 4 ● Error in the data length or data type in the send area pointer SD_1.

● Value for LEN is greater than area SD_1.
● A memory area with optimized access is used and the value for LEN is not "0".
● A memory area with standard access is used and the value for LEN is "0". 

1 5 Reset request was executed.
1 6 Partner instruction is in DISABLED  status (EN_R  has the value "0"). Also check the input 

parameters of "BRCV (Page 2841)" for consistency with "BSEND".
1 7 "BRCV (Page 2841)" partner instruction not called since the last data transfer.
1 8 Access to remote object in the user memory was rejected: The destination area for the associated 

"BRCV (Page 2841)" is too small.
ERROR = 1, STATUS = 4 or ERROR = 1, STATUS = 10 reported at the output parameters of 
"BRCV (Page 2841)".

1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 18 R_ID  already exists in the connection.
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with lower priority (first call).

BRCV: Receive data in segments

Description
The "BRCV" instruction receives data from a remote partner instruction of type "BSEND 
(Page 2839)". The R_ID parameter must be identical in the related instructions.

The instruction is ready to receive data (STATUS = 25) after it is called with the value "1" at 
control input EN_R. An active job can be canceled with EN_R=0.

The maximum receive area is specified by RD_1. Data will be received consistently if you fully 
evaluate the part of the RD_1 receive area currently in use before calling the block again with 
value 1 at control input EN_R.

After each received data segment, an acknowledgement is sent to the partner instruction. In 
the case of multiple segments it is necessary to call "BRCV" several times until all segments 
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have been received. Asynchronous data receipt is indicated by STATUS = 17. The number of 
the currently received data is displayed at the LEN parameter. The RD_1 parameter must 
remain constant during the operation.

Value "1" at the NDR  status parameter indicates that all data segments have been received 
without error. The received data remains unchanged until the next call with EN_R=1.

Parameters
The following table shows the parameters of the "BRCV" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Control parameter enabled to receive, signals 
ready to receive if the input is set.

ID Input CONN_PRG M, D or constant Addressing parameters for specifying the 
connection to the partner CPU.

R_ID Input CONN_R_ID I, Q, M, D, L or 
constant

Addressing parameter for defining the instruction 
pairs "BSEND (Page 2839)" and "BRCV".
See also: Common parameters of instructions for 
S7 communication (Page 2828)

RD_1 InOut VARIANT I, Q, M, D Pointer to the receive area. The length 
information specifies the maximum length of the 
block to be received. 

LEN InOut WORD I, Q, M, D, L Length of the data already received in bytes.
NDR Output BOOL I, Q, M, D, L Status parameter

● 0: Job not yet started or still running.
● 1: Job successfully completed.

ERROR
 

Output
 

BOOL
 

I, Q, M, D, L
 

Status parameter
● 0: Neither warning nor error
● 1: An error has occurred. STATUS supplies 

detailed information on the type of error.
STATUS Output WORD I, Q, M, D, L Status parameter

See "ERROR and STATUS parameters" table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters ERROR and STATUS
The following table contains all specific error information for "BRCV" that can be output via the 
ERROR  and STATUS  parameters.

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: The received data is already being processed in a priority class with lower priority.
0 17 Warning: Instruction receives data asynchronously. The LEN  parameter shows the amount of data 

already received in bytes.
0 25 Communication has started. The job is being processed.
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ERROR STATUS 
(decimal)

Explanation

1 1 Communication problem has occurred. Possible causes:
● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 2 Function cannot be executed (protocol error).
1 4 Error in the receive area pointer RD_1 relating to the data length or data type. The block of data 

sent is longer than the receive area.
1 5 Reset request received, incomplete transfer.
1 8 Access error in associated "BSEND (Page 2839)": After the last valid data segment has been sent, 

ERROR  = 1 and STATUS  = 4 or ERROR  = 1 and STATUS  = 10 is reported.
1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 18 Value at R_ID parameter already exists in the connection specified at the ID parameter (R_ID value 

must be unique for the connection).
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with lower priority (first call).

9.7.5.3 Open User Communication

TSEND_C: Send data via Ethernet

TSEND_C: Send data via Ethernet

Description
The following description of the "TSEND_C" instruction is valid for the CPU S7-1200 to version 
3.0.

The "TSEND_C" instruction sets up and establishes a TCP or ISO-on-TCP communication 
connection. Once the connection has been set up and established, it is automatically 
maintained and monitored by the CPU. The connection description specified at the CONNECT 
parameter is used to set up the communication connection.

The instruction is executed asynchronously and has the following functions:
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● A communication connection is set up and established:
The communication connection is set up and established with CONT=1. Once the 
connection is successfully established, the DONE parameter is set to "1" for one cycle. An 
existing connection is terminated and the connection which has been set up is removed 
when the CPU goes into STOP mode. To set up and establish the connection again, you 
must execute "TSEND_C" again. For information on the number of possible communication 
connections, refer to the technical specifications for your CPU.

● Sending data via an existing communication connection:
You specify the send area with the DATA parameter. This includes the address and the 
length of the data to be sent. Do not use a data area with the data type BOOL or Array of 
BOOL at the DATA parameter. If you use purely symbolic values at the DATA parameter, 
the LEN parameter must have the value "0".

● The send job is executed when a rising edge is detected at the REQ parameter. With the 
LEN parameter, you specify the maximum number of bytes sent with a send job. When 
sending data (rising edge at the REQ parameter), the CONT parameter must have the 
value "1" in order to establish or maintain a connection. The data to be sent must not be 
edited until the send job is completed. If the send job executes successfully, the DONE 
parameter is set to "1". Signal state "1" at the DONE parameter is not confirmation that the 
data sent has already been read by the communication partner.

● Terminating the communication connection:
The communication connection is terminated when the CONT parameter is set to "0" even 
if an ongoing data transmission is not complete yet. This does not apply if you are using 
an already configured connection for "TSEND_C".

When setting the COM_RST parameter to "1", the currently established connection or a current 
data transmission can be reset at any time. This terminates the existing communication 
connection and a new connection is established. If data is being transferred when it executes 
again, this can lead to a loss of data.

To enable "TSEND_C" again after the execution (DONE = 1), call the instruction once with 
REQ = 0.

Parameters
The following table shows the parameters of the "TSEND_C" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Starts the send job on a rising edge.
CONT Input BOOL I, Q, M, D, L Controls the communication connection:

● 0: Disconnect the communication connection
● 1: Establish and maintain the communication 

connection
When sending data (rising edge at the REQ 
parameter), the CONT parameter must have the 
value TRUE in order to establish or maintain a 
connection.

LEN Input UINT I, Q, M, D, L or 
constant

Maximum number of bytes to be sent with the job. 
If you use purely symbolic values at the DATA 
parameter, the LEN parameter must have the value 
"0".
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Parameter Declaration Data type Memory area Description
CONNECT InOut TCON_Param D Pointer to the connection description

See also: Auto-Hotspot 
DATA InOut VARIANT I, Q, M, D, L Pointer to the send area containing the address and 

the length of the data to be sent.
COM_RST InOut BOOL I, Q, M, D, L Restarts the instruction:

● 0: Irrelevant
● 1: Complete restart of the instruction causing an 

existing connection to be terminated and a new 
connection to be established.

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters BUSY, DONE and ERROR
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TSEND_C". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is specified in the STATUS parameter.
0 0 0 No new job was assigned.
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Parameters ERROR and STATUS

ERROR STATUS*
(W#16#...)

Description

0 0000 Job completed without error.
0 0001 The connection establishment is complete.
0 0003 The connection termination is complete.
0 7000 No job processing active.
0 7001 ● Start execution of the job

● Establish connection
● Wait for connection partner

0 7002 Data was sent.
0 7003 Connection is being terminated.
0 7004 Connection established and monitored, no job processing active.
0 7005 Data is currently being sent.
1 80A0 Group error for error codes 80A1 and 80A2.
1 80A1 ● Connection or port already being used by user.

● Communication error:
– The specified connection has not yet been established.
– The specified connection is being terminated. Transfer via this connection is not possible.
– The interface is being re-initialized.

1 80A2 Local or remote port is being used by the system.
1 80A3 Attempt being made to terminate a non-existent connection.
1 80A4 IP address of the remote endpoint of the connection is invalid, in other words, it matches the IP 

address of the local partner.
1 80A7 Communication error: You called the instruction with COM_RST = 1 before the send job was 

complete.
1 80B2 The CONNECT parameter points to a data block that was generated with the attribute "Only 

store in load memory".
1 80B3 Inconsistent parameter assignment: Group error for error codes 80A0 to 80A2, 80A4, 80B4 to 

80B9.
1 80B4 You have violated one or both of the following conditions for passive connection establishment 

(active_est = FALSE) when using the ISO-on-TCP protocol variant (connection_type = 
B#16#12): "local_tsap_id_len >= B#16#02", and/or "local_tsap_id[1] = B#16#E0".

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error in the connection_type parameter of the data block for connection 

description.
1 80B7 Error in one of the following parameters of the data block for connection description: 

block_length, local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, 
next_staddr_len.

1 8085 The LEN parameter is larger than the highest permitted value.
1 8086 The ID parameter within the CONNECT parameter is outside the permitted range.
1 8087 Maximum number of connections reached; no additional connection possible.
1 8088 The value at the LEN parameter does not correspond to the receive area set at the DATA 

parameter.
1 8089 The CONNECT parameter does not point to a data block.
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ERROR STATUS*
(W#16#...)

Description

1 8091 Maximum nesting depth exceeded.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the 

connection description.
1 809B The ID of the local device in the connection description does not correspond to the CPU.
1 80C3 ● All connection resources are in use.

● A block with this ID is already being processed in a different priority group.
1 80C4 Temporary communication error:

● The connection cannot be established at this time.
● The interface is receiving new parameters or the connection is being established.
● The configured connection is currently being removed by a "TDISCON" instruction.
● The connection used is being terminated by a call with COM_RST= 1.

1 80C6 Remote network error. Remote partner cannot be reached.
1 8722 Parameter CONNECT: The source area is invalid. The area does not exist in the DB.
1 873A Parameter CONNECT: Access to the connection description is not possible (for example, DB 

does not exist).
1 877F Parameter CONNECT: Internal error.
1 8822 Parameter DATA: Invalid source area, the area does not exist in the DB.
1 8824 Parameter DATA: Area error in the VARIANT pointer.
1 8832 Parameter DATA: The DB number is too high.
1 883A Parameter CONNECT: Access to specified connection data not possible (e.g. because the DB 

does not exist).
1 887F Parameter DATA: Internal error, e.g. invalid VARIANT reference.
1 893A Parameter DATA: Access to send area not possible (e.g. because the DB does not exist).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error messages of the instructions "TCON", "TSEND", "T_DIAG" and "TDISCON"

Internally, the "TSEND_C" instruction uses the instructions "TCON (Page 2877)", "TSEND 
(Page 2889)", "T_DIAG (Page 2909)", "T_RESET (Page 2907)" and "TDISCON (Page 2884)". 
The error messages of these instructions can also be output at the STATUS parameter. The 
meaning of the error codes is described in the corresponding instructions. In the event of 
identical error codes for internally used instructions with different meanings, the instance data 
block of "TSEND_C" can be used to determine which instruction output the error.

 

TSEND_C: Send data via Ethernet

Description
The following description of the "TSEND_C" instruction is valid for the CPU S7-1500 and 
S7-1200 V4.0.
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The "TSEND_C" instruction sets up and establishes a communications connection. Once the 
connection has been set up and established, it is automatically maintained and monitored by 
the CPU. 

The instruction is executed asynchronously and has the following functions:

● Setting up and establishing a communication connection

● Sending data via an existing communication connection

● Terminating or resetting the communication connection

Internally, the instruction "TSEND_C" uses the communication instructions TCON", "TSEND", 
"T_DIAG", "T_RESET" and "TDISCON".

Setting up and establishing a communication connection
The communication connection is set up and established with CONT=1. For information on 
the number of possible communication connections, refer to the technical specifications for 
your CPU. The connection description specified at the CONNECT parameter is used to set up 
the communication connection. The following connection types can be used:

● Programmed connections (structure of connection via "TCON"):

– TCP / UDP: Connection description via the TCON_IP_v4 system data type 

– ISO-on-TCP: Connection description via the TCON_IP_RFC system data type

– ISO: Connection description via the TCON_ISOnative system data type (for CP1543-1 
only)

● Configured connections

– Specify an existing connection in the TCON_Configured system data type.

An existing connection is terminated and the connection which has been set up is removed 
when the CPU goes into STOP mode. To set up and establish the connection again, you must 
execute "TSEND_C" again.

Sending data via an existing communication connection
The send job is executed when a rising edge is detected at the REQ parameter. As described 
above, the communication connection is established first.

You specify the send area with the DATA parameter. This includes the address and the length 
of the data to be sent. Do not use a data area with the data type BOOL or Array of BOOL at 
the DATA parameter. With the LEN parameter, you specify the maximum number of bytes sent 
with a send job. If you use a send area with optimized access at the DATA parameter, the LEN 
parameter must have the value "0".

The data to be sent must not be edited until the send job is completed.

Terminating and resetting the communication connection
The communication connection is terminated when the CONT parameter is set to "0" even if 
an ongoing data transmission is not complete yet. This does not apply if you are using a 
configured connection for "TSEND_C".
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The connection can be reset at any time by setting the parameter COM_RST to "1". This 
terminates the existing communication connection and a new connection is established. If data 
is being transferred at this time, this can lead to data loss.

Parameters
The following table shows the parameters of the "TSEND_C" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C 

or constant
Starts the send job on a rising edge. 

CONT Input BOOL I, Q, M, D, L Controls the communication connection:
● 0: Disconnect the communications connection.
● 1: Establish and maintain the communication 

connection.
LEN Input UDINT I, Q, M, D, L or 

constant
Optional parameter (hidden)
Maximum number of bytes to be sent with the job. 
If you use a send area with optimized access at the 
DATA parameter, the value "0" must be used at the 
LEN parameter.

CONNECT InOut VARIANT D Pointer to the structure of the connection 
description:
● Programmed connection:

– For TCP, use the TCON_IP_v4 system data 
type
For description, refer to:Auto-Hotspot

– For ISO-on-TCP, use the TCON_IP_RFC 
system data type
For description, refer to: Auto-Hotspot

– For ISO, use the TCON_ISOnative system 
data type (only for CP1543-1)
For description, refer to instruction "TCON 
(Page 2880)".

● Configured connection:
– For existing connections, use the 

TCON_Configured system data type
For a description see "System data type for 
configured connections" below

DATA InOut VARIANT I, Q, M, D, L Pointer to the send area containing the address and 
the length of the data to be sent.

ADDR InOut VARIANT D Optional parameter (hidden)
Pointer to the address of the recipient.

COM_RST InOut BOOL I, Q, M, D, L Optional parameter (hidden)
Resets the connection:
● 0: Irrelevant
● 1: The existing connection is reset.
The COM_RST parameter is reset after evaluation 
by the "TSEND_C" instruction and should not, 
therefore, be interconnected statically.
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Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: Send job not yet started or still in progress.
● 1: Send job executed without error. This state 

is only displayed for one cycle.
The output parameter DONE is set if an 
intermediate step was completed successfully 
during processing (connection establishment, 
sending, connection termination) and if the 
execution of "TSEND_C" was completed 
successfully.

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Send job not yet started or already completed.
● 1: Send job not yet completed. A new send job 

cannot be started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred during connection 

establishment, data transmission or connection 
termination.

The output parameter ERROR can be set due to 
an error in the "TSEND_C" instruction or the 
communication instructions used internally.

STATUS Output WORD I, Q, M, D, L Status of instruction (see the "ERROR and 
STATUS" parameters" description).

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters REQ, CONT  and  COM_RST
The parameter CONT controls the connection establishment of the "TSEND_C" instruction 
regardless of the REQ parameter. The behavior of the CONT parameter partially depends on 
whether a programmed or a configured connection is used:

● With CONT = "0": No data is sent (regardless of whether a programmed or a configured 
connection is used).

● When changing CONT = "0" to "1":

– With a programmed connection, it is established with "TCON".

– With a configured connection, it is checked with "T_DIAG".

● With CONT = "1":

– As long as no data is sent (REQ="0"), the connection is checked with "T_DIAG".

– If the internally used communication instructions signal that no connection end point 
exists, the connection is automatically reestablished with "TCON".

● When changing CONT = "1" to "0":

– With a programmed connection, it is terminated with "TDISCON".

– With a configured connection, it is reset with "T_RESET".
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The parameter COM_RST resets the connection when changing from "0" to "1":

● If a connection is established, it is reset with "T_RESET" (regardless of whether a 
programmed or configured connection is used).

● If no connection is established, the setting of the parameter has no effect.

The parameters REQ and COM_RST are only active if CONT was set to "1". The following 
table shows the relationship between the  REQ, CONT  and  COM_RST parameters:

REQ CONT COM_
RST

Status of the 
instruction

Description

irreleva
nt

0 irreleva
nt

Not yet executed No job active (STATUS = 7000).

irreleva
nt

0 irreleva
nt

Initialization Connection is being terminated. The instruction is being reset.

irreleva
nt

0 > 1 irreleva
nt

Connection 
establishment

Connection is being established. Data is not being transferred yet.

0 1 0 Connection 
established

The connection is established and is monitored with the instruction 
"T_DIAG".

irreleva
nt

1 0 > 1 Connection 
established

The connection is interrupted by "T_RESET" briefly and reset.

0 > 1 1 0 Connection 
established

Instruction starts sending.

irreleva
nt

1 0 > 1 Data is being sent Data transmission is interrupted. The connection is being reset.

System data type for configured connections
For configured connections at the CONNECT parameter, use the following structure for 
connection description to TCON_Configured:

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to the connection (value range: 1 to 4095).

Enter the connection ID of the existing connection.
4 ConnectionType BYTE - Connection type

Select 254 (decimal) for a configured connection.

Parameters BUSY, DONE and ERROR
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a send job executed successfully. The ERROR parameter is set when 
errors occurred during execution of "TSEND_C". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:
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DONE BUSY ERROR Description
0 0 0 The instruction has not been executed yet (no positive edge at REQ parameter).
0 1 0 The instruction is being executed and calls the internally used communication instructions.
1 0 0 The send job was completed successfully. "0000" is output at the STATUS parameter. 

DONE = "1" is only displayed for one cycle.
0 0 1 The execution of the instruction or an intermediate step during processing was terminated 

with an error. If there is a subsequent error due to an internally used communication 
instruction, the error that occurred first during processing is displayed. This state is only 
displayed for one cycle.

Parameters ERROR and STATUS

ERROR STATUS*
(W#16#...)

Description

0 0000 Send job was executed without error.
0 0001 The connection establishment is complete.
0 0003 The connection termination is complete.
0 7000 No active send job execution; no communication connection established.
0 7001 ● Start send job execution.

● Establish connection.
● Wait for connection partner.

0 7002 Data is being sent.
0 7003 Communication connection is being terminated.
0 7004 Communication connection established and monitored; no send job execution active.
0 7005 Communication connection is being reset.
1 80A1 ● Connection or port already being used by user.

● Communication error:
– The specified connection has not yet been established.
– The specified connection is being terminated.

Transfer via this connection is not possible.
– The interface is being re-initialized.

1 80A3 Attempt being made to terminate a non-existent connection.
1 80A4 IP address of the remote endpoint of the connection is invalid or it matches the IP address of 

the local partner.
1 80A7 Communication error: You called the instruction with COM_RST = 1 before the send job was 

complete.
1 80B4 You have violated one or both of the following conditions for passive connection establishment 

(active_est = FALSE) when using the ISO-on-TCP protocol variant (connection_type = 
B#16#12): 
● local_tsap_id_len >= B#16#02
● local_tsap_id[1] = B#16#E0

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error in the connection_type parameter of the data block for connection 

description.
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ERROR STATUS*
(W#16#...)

Description

1 80B7 Error in one of the following parameters of the data block for connection description: 
block_length, local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, 
next_staddr_len.

1 8085 The LEN parameter is larger than the highest permitted value.
1 8086 The ID parameter within the CONNECT parameter is outside the permitted range.
1 8087 Maximum number of connections reached; no additional connection possible.
1 8088 The value at the LEN parameter does not correspond to the receive area set at the DATA 

parameter.
1 8089 The CONNECT parameter does not point to a data block.
1 8091 Maximum nesting depth exceeded.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the 

connection description.
1 809B InterfaceID is invalid. It is either zero or it does not point to a local CPU interface or a CP.
1 80C3 ● All connection resources are in use.

● A block with this ID is already being processed in a different priority group.
1 80C4 Temporary communication error:

● The connection cannot be established at this time.
● The interface is receiving new parameters or the connection is being established.
● The configured connection is currently being removed by a "TDISCON (Page 2884)" 

instruction.
● The connection used is being terminated by a call with COM_RST = 1.

1 80C6 Remote network error. Remote partner cannot be reached.
1 8722 Parameter CONNECT: The source area is invalid. The area does not exist in the DB.
1 873A Parameter CONNECT: Access to the connection description is not possible (for example, 

because the DB is not available).
1 877F Parameter CONNECT: Internal error.
1 8822 Parameter DATA: Invalid source area, the area does not exist in the DB.
1 8824 Parameter DATA: Area error in the VARIANT pointer.
1 8832 Parameter DATA: The DB number is too high.
1 883A Parameter CONNECT: Access to specified connection data not possible (e.g. because the DB 

does not exist).
1 887F Parameter DATA: Internal error, e.g. invalid VARIANT reference.
1 893A Parameter DATA: Access to send area not possible (e.g. because the DB does not exist).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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 Note
Error messages of the instructions "TCON", "TSEND", "T_DIAG", "T_RESET" and 
"TDISCON"

Internally, the "TSEND_C" instruction uses the instructions "TCON (Page 2880)", "TSEND 
(Page 2889)", "T_DIAG (Page 2909)", "T_RESET (Page 2907)" and "TDISCON (Page 2884)". 
The error messages of these instructions can also be output at the STATUS parameter. The 
meaning of the error codes is described in the corresponding instructions. In the event of 
identical error codes for internally used instructions with different meanings, the instance data 
block of "TSEND_C" can be used to determine which instruction output the error.

 

TRCV_C: Receive data via Ethernet

TRCV_C: Receive data via Ethernet

Description    
The "TRCV_C" instruction is executed asynchronously and has the following functions:

1. Setting up and establishing a communication connection:
"TRCV_C" sets up and establishes a TCP or ISO-on-TCP communication connection. Once 
the connection has been set up and established, it is automatically maintained and 
monitored by the CPU.
The connection description specified at the CONNECT parameter is used to set up the 
communication connection. To establish a connection, the CONT parameter must be set 
to the value "1". Once the connection is successfully established, the DONE parameter is 
set to "1".
An existing connection is terminated and the connection which has been set up is removed 
when the CPU goes into STOP mode. To set up and establish the connection again, you 
must execute "TRCV_C" again.
For information on the number of possible communication connections, refer to the 
technical specifications for your CPU.

2. Receiving data via an existing communication connection:
If the EN_R parameter is set to the value "1", receipt of data is enabled. When receiving 
data (rising edge at the EN_R parameter), the CONT parameter must have the value TRUE 
in order to establish or maintain a connection.
The received data is entered in a receive area. You specify the length of the receive area 
either with the LEN parameter (if LEN <> 0) or with the length information of the DATA 
parameter (if LEN = 0) in accordance with the protocol variant used. If you use purely 
symbolic values at the DATA parameter, the LEN parameter must have the value "0".
After data has been received successfully, the signal state at the DONE parameter is "1". 
If errors occur in the data transfer, the DONE parameter is set to "0".

3. Terminating the communication connection:
The communication connection is terminated when the CONT parameter is set to "0".
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TRCV_C is executed again when the COM_RST parameter is set. This terminates the existing 
communication connection and a new connection is established. If data is being received when 
it executes again, this can lead to a loss of data.

Receive modes of TRCV_C
The following table shows how the received data is entered in the receive area.

Protocol variant Availability of data in the receive area connection_type parameter of the 
connection description

Parameter LEN

TCP
(Ad-hoc mode)

The data is immediately available. Hexadecimal value: B#16#11
Integer value: 17

0

TCP 
(Receipt of data with 
specified length)

The data is available as soon as the 
data length specified at the LEN 
parameter has been fully received.

Hexadecimal value: B#16#11
Integer value: 17

1 to 8192

ISO on TCP
(Message-oriented 
data transfer)

The data is available as soon as the 
data length specified at the LEN 
parameter has been fully received.

Hexadecimal value: B#16#12
Integer value: 18

● 1 to 1452, if a CP 
is used.

● 1 to 8192, if no 
CP is used.

TCP (Ad-hoc mode)
The ad-hoc mode is only available with the TCP protocol variant. You use the ad-hoc mode 
to receive data with dynamic length with the "TRCV" instruction.

You set ad-hoc mode by assigning the value "0" to the LEN parameter. All data types can be 
used for data blocks with standard access when you use ad-hoc mode. Only ARRAY of BYTE 
or data types with a length of 8 bits can be used for data blocks with optimized access (e.g., 
CHAR, USINT, SINT, etc.).  The data length actually received is output at the RCVD_LEN 
parameter.

TCP (Receipt of data with specified length)
You use the value of the LEN parameter to specify the length for the data receipt. The data 
receipt is not complete until the length of data specified at the LEN parameter has been 
completely received. Only then is the data available in the receive area (DATA parameter). 
The actually received data length in bytes at the RCVD_LEN parameter corresponds to the 
data length at the LEN parameter after receipt. 

ISO on TCP (Message-oriented data transfer)
Complete message blocks are sent via a connection with the protocol variant ISO on TCP; 
these are recognized as such by the recipient. When using ISO on TCP, "TRCV_C" signals 
data receipt as soon as the message block has been completely received. The receive area 
is defined by the LEN and DATA parameters. If the receive buffer (DATA parameter) is too 
small for the sent data, "TRCV_C" signals an error. The actually received data length in bytes 
at the RCVD_LEN parameter corresponds to the data length at the LEN parameter after 
receipt. 
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Parameters
The following table shows the parameters of the "TRCV_C" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L Receive enable
CONT Input BOOL I, Q, M, D, L Controls the communication connection:

● 0: Automatically disconnect communication 
connection after data have been sent

● 1: Establish and maintain the communication 
connection

When receiving data (rising edge at the EN_R 
parameter), the CONT parameter must have the 
value TRUE in order to establish or maintain a 
connection.

LEN Input UINT I, Q, M, D, L or 
constant

Maximum length of the data to be received. If you 
use purely symbolic values at the DATA parameter, 
the LEN parameter must have the value "0".

CONNECT InOut TCON_Param D Pointer to the connection description
See also: Auto-Hotspot 

DATA InOut VARIANT I, Q, M, D, L Pointer to the receive area
COM_RST InOut BOOL I, Q, M, D, L Restarts the instruction:

● 0: Irrelevant
● 1: Complete restart of the instruction causing an 

existing connection to be terminated
DONE Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction
RCVD_LEN Output UDINT I, Q, M, D, L Amount of data actually received in bytes

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters BUSY, DONE and ERROR
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
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occurred during execution of "TRCV_C". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

Parameters ERROR and STATUS

ERROR STATUS*
(W#16#...)

Description

0 0000 Job completed without error.
0 0001 The connection establishment is complete.
0 0003 The connection termination is complete.
0 7000 No job processing active.
0 7001 ● Start execution of the job

● Establish connection
● Wait for connection partner

0 7002 Data is being received.
0 7003 Connection is being terminated.
0 7004 ● Connection established and monitored

● No job processing active
0 7006 Data is currently being received.
1 8085 ● The LEN parameter is larger than the highest permitted value.

● The value at the LEN or DATA parameter was changed after the first call.
1 8086 The ID parameter is outside the permitted range.
1 8087 Maximum number of connections reached; no additional connection possible
1 8088 The value at the LEN parameter does not correspond to the receive area set at the DATA parameter.
1 8089 The CONNECT parameter does not point to a data block.
1 8091 Maximum nesting depth exceeded.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the connection 

description.
1 809B The ID of the local device (local_device_id) in the connection description does not correspond to 

the CPU.
1 80A0 Group error for error codes W#16#80A1 and W#16#80A2.
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ERROR STATUS*
(W#16#...)

Description

1 80A1 ● Connection or port already being used by user.
● Communication error:

– The specified connection has not yet been established.
– The specified connection is being terminated.

Transfer via this connection is not possible.
– The interface is being re-initialized.

1 80A2 Local or remote port is being used by the system.
1 80A3 ● Attempt being made to re-establish an existing connection.

● Attempt being made to terminate a non-existent connection.
1 80A4 IP address of the remote endpoint of the connection is invalid, in other words, it matches the IP 

address of the local partner.
1 80A7 Communication error: You called the instruction with COM_RST = 1 before the send job was 

complete.
1 80B2 The CONNECT parameter points to a data block that was generated with the attribute "Only store 

in load memory".
1 80B3 Inconsistent parameter assignment: Group error for error codes W#16#80A0 to W#16#80A2, 

W#16#80A4, W#16#80B4 to W#16#80B9.
1 80B4 You have violated one or both of the following conditions for passive connection establishment 

(active_est = FALSE) when using the ISO-on-TCP protocol variant (connection_type = B#16#12): 
"local_tsap_id_len >= B#16#02", and/or "local_tsap_id[1] = B#16#E0".

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error in the connection_type parameter of the data block for connection 

description.
1 80B7

 
Error in one of the following parameters of the data block for connection description: block_length, 
local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, next_staddr_len.

1 80C3 ● All connection resources are in use.
● A block with this ID is already being processed in a different priority group.

1 80C4
 

Temporary communication error:
● The connection cannot be established at this time.
● The interface is receiving new parameters or the connection is being established.
● The configured connection is currently being removed by a "TDISCON" instruction.
● The connection used is being terminated by a call with COM_RST= 1.

1 8722 Error in the CONNECT parameter: Invalid source area (area not declared in data block).
1 873A Error in the CONNECT parameter: Access to connection description is not possible (no access to 

data block).
1 877F Error in the CONNECT parameter: Internal error
1 8922 Parameter DATA: Invalid target area; the area does not exist in the DB.
1 8924 Parameter DATA: Area error in the VARIANT pointer.
1 8932 Parameter DATA: The DB number is too high.
1 893A Parameter CONNECT: Access to specified connection data not possible (e.g. because the DB 

does not exist).
1 897F Parameter DATA: Internal error, e.g. invalid VARIANT reference.
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ERROR STATUS*
(W#16#...)

Description

1 8A3A Parameter DATA: No access to the data area, for example because the data block does not exist.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error messages of the instructions "TCON", "TRCV" and "TDISCON"

Internally, the TRV_C instruction uses the "TCON (Page 2877)", "TRCV (Page 2892)" and 
"TDISCON (Page 2884)" instructions. The error messages of these instructions are contained 
in the respective descriptions.

 

TRCV_C: Receive data via Ethernet

Description
The following description of the "TRCV_C" instruction is valid for the CPU S7-1500 and 
S7-1200 V4.0.

The "TRCV_C" instruction is executed asynchronously and implements the following functions 
in sequence:

● Setting up and establishing a communication connection

● Receiving data via an existing communication connection

● Terminating or resetting the communication connection

Internally, the instruction "TRCV_C" uses the communication instructions TCON", "TRCV", 
"T_DIAG", "T_RESET" and "TDISCON".

Setting up and establishing a communication connection
The communication connection is set up and established with CONT=1. For information on 
the number of possible communication connections, refer to the technical specifications for 
your CPU. The connection description specified at the CONNECT parameter is used to set up 
the communication connection. The following connection types can be used:

● Programmed connections (structure of connection via "TCON"):

– TCP / UDP: Connection description via the TCON_IP_v4 system data type 

– ISO-on-TCP: Connection description via the TCON_IP_RFC system data type

– ISO: Connection description via the TCON_ISOnative system data type (for CP1543-1 
only)

● Configured connections

– Specify an existing connection in the TCON_Configured system data type.
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An existing connection is terminated and the connection which has been set up is removed 
when the CPU goes into STOP mode. To set up and establish the connection again, you must 
execute "TRCV_C" again.

Receiving data via an existing communication connection
Receipt of data is enabled when the EN_R parameter is set to the value "1". The received data 
is entered in a receive area. You specify the length of the receive area either with the LEN 
parameter (if LEN <> 0) or with the length information of the DATA parameter (if LEN = 0), 
depending on the protocol variant being used. If you use purely symbolic values at the DATA 
parameter, the LEN parameter must have the value "0".

Receive modes of TRCV_C:

● TCP (Ad-hoc mode)
The ad-hoc mode is only available with the TCP protocol variant. You use the ad-hoc mode 
to receive data with dynamic length with the "TRCV_C" instruction.
You set ad-hoc mode by assigning the value "1" to the ADHOC parameter. All data types 
can be used for data blocks with standard access when you use ad-hoc mode. Only ARRAY 
of BYTE or data types with a length of 8 bits can be used for data blocks with optimized 
access (e.g., CHAR, USINT, SINT, etc.). The data length actually received is output at the 
RCVD_LEN parameter.

● TCP (Receipt of data with specified length)
Assign the value "0" to the ADHOC parameter for receipt of data with specified length. If 
ad-hoc mode is disabled, the data receipt is not complete until the length of data specified 
at the LEN parameter has been completely received. Only then is the data available in the 
receive area (DATA parameter). The actually received data length in bytes at the 
RCVD_LEN parameter corresponds to the data length at the LEN parameter after receipt. 

● ISO on TCP (Message-oriented data transfer)
Complete message blocks are sent via a connection with the protocol variant ISO on TCP; 
these are recognized as such by the recipient. The receive area is defined by the LEN and 
DATA parameters. If the receive buffer (DATA parameter) is too small for the sent data, 
"TRCV_C" signals an error. The actually received data length in bytes at the RCVD_LEN 
parameter corresponds to the data length at the LEN parameter after receipt. 

The following table shows how the received data is entered in the receive area.

Protocol variant Availability of data in the receive area connection_type parameter of 
the connection description

Parameter LEN

TCP
(Ad-hoc mode)

The data is immediately available. Hexadecimal value: B#16#11
Integer value: 17

1 up to maximum 
length (depending on 
the CPU)

TCP 
(Receipt of data with 
specified length)

The data is available as soon as the 
data length specified at the LEN 
parameter has been fully received.

Hexadecimal value: B#16#11
Integer value: 17

1 to 8192

ISO on TCP
(Message-oriented 
data transfer)

The data is available as soon as the 
data length specified at the LEN 
parameter has been fully received.

Hexadecimal value: B#16#12
Integer value: 18

1 to 8192
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Terminating the communication connection 
The communication connection is terminated when the CONT parameter is set to "0" even if 
an ongoing data transmission is not complete yet. This does not apply if you are using a 
configured connection, however.

The connection can be reset at any time by setting the parameter COM_RST to "1". This 
terminates the existing communication connection and a new connection is established. If data 
is being transferred at this time, this can lead to data loss.

Parameters
The following table shows the parameters of the "TRCV_C" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L, T, C 

or constant
Receive enable

CONT Input BOOL I, Q, M, D, L Controls the communication connection:
● 0: Automatically disconnect communication 

connection after data has been received.
● 1: Establish communication connection and 

maintain after receipt of data.
LEN Input UDINT I, Q, M, D, L or 

constant
Maximum length of the data to be received. If you 
use a receive area with optimized access at the 
DATA parameter, the value "0" must be used at the 
LEN parameter.

ADHOC Input BOOL I, Q, M, D, L or 
constant

Optional parameter (hidden)
Use ad-hoc mode for the TCP protocol variant.

CONNECT InOut VARIANT D Pointer to the connection description
● Programmed connection:

– For TCP or UDP, use the structure 
TCON_IP_v4
For description, refer to:Auto-Hotspot

– For ISO-on-TCP, use the structure 
TCON_IP_RFC
For description, refer to: Auto-Hotspot

– For ISO, use the structure TCON_ISOnative 
(only for CP1543-1)
For description, refer to instruction "TCON 
(Page 2880)": "Structure of the connection 
description according to  TCON_ISOnative"

● Configured connection:
– For existing connections, use the 

TCON_Configured system data type. For a 
description, see "System data type for 
configured connections" below.

DATA InOut VARIANT I, Q, M, D, L Pointer to the receive area.
ADDR InOut VARIANT D Optional parameter (hidden)

Pointer to the address of the sender with 
connection type UDP.
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Parameter Declaration Data type Memory area Description
COM_RST InOut BOOL I, Q, M, D, L Optional parameter (hidden)

Resets the connection:
● 0: Irrelevant
● 1: The existing connection is reset.
The COM_RST parameter is reset after evaluation 
by the "TRCV_C" instruction and should not, 
therefore, be interconnected statically.

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Receipt not yet started or still in progress.
● 1: Receipt executed without error. This state is 

only displayed for one cycle.
The output parameter DONE is set if an 
intermediate step was completed successfully 
during processing (connection establishment, 
receipt, connection termination) and if the 
execution of "TRCV_C" was completed 
successfully.

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Receipt not yet started or already completed.
● 1: Receipt not yet completed. A new send job 

cannot be started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred during connection 

establishment, data receipt or connection 
termination.

The output parameter ERROR can be set due to 
an error in the "TRCV_C" instruction or the 
communication instructions used internally.

STATUS Output WORD I, Q, M, D, L Status of the instruction
RCVD_LEN Output UDINT I, Q, M, D, L Amount of data actually received in bytes

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters EN_R, CONT and COM_RST
The parameter CONT controls the connection establishment of the "TRCV_C" instruction 
regardless of the EN_R parameter. The behavior of the CONT parameter partially depends 
on whether a programmed or a configured connection is used:

● With CONT = "0": No data is received (regardless of whether a programmed or a configured 
connection is used).

● When changing CONT = "0" to "1":

– With a programmed connection, it is established with "TCON".

– With a configured connection, it is checked with "T_DIAG".
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● With CONT = "1":

– As long as no data is received (EN_R="0"), the connection is checked with "T_DIAG".

– If the internally used communication instructions signal that no connection end point 
exists, the connection is automatically reestablished with "TCON".

● When changing CONT = "1" to "0":

– With a programmed connection, it is terminated with "TDISCON".

– With a configured connection, it is reset with "T_RESET".

The parameter COM_RST resets the connection when changing from "0" to "1":

● If a connection is established, it is reset with "T_RESET" (regardless of whether a 
programmed or configured connection is used).

● If no connection is established, the setting of the parameter has no effect.

The parameters EN_R and COM_RST are only active if CONT was set to "1". The following 
table shows the relationship between the  EN_R, CONT  and  COM_RST parameters:

EN_R CONT COM_
RST

Status of the 
instruction

Description

irreleva
nt

0 irreleva
nt

Not yet executed No job active (STATUS = 7000).

irreleva
nt

0 irreleva
nt

Initialization Connection is being terminated. The instruction is being reset.

irreleva
nt

0 > 1 irreleva
nt

Connection 
establishment

Connection is being established. Data is not being transferred yet.

0 1 0 Connection 
established

The connection is established and is monitored with the instruction 
"T_DIAG".

irreleva
nt

1 0 > 1 Connection 
established

The connection is interrupted by "T_RESET" briefly and reset.

0 > 1 1 0 Connection 
established

Instruction starts receiving.

irreleva
nt

1 0 > 1 Data is being 
received

Data transmission is interrupted. The connection is being reset.

System data type for configured connections
For configured connections at the CONNECT parameter, use the following structure for 
connection description to TCON_Configured:

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to the connection (value range: 1 to 4095).

Enter the connection ID of the existing connection.
4 ConnectionType BYTE - Connection type

Select 254 (decimal) for a configured connection.
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Parameters BUSY, DONE and ERROR
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TRCV_C". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

DONE BUSY ERROR Description
0 0 0 The instruction has not been executed yet (no positive edge at EN_R parameter).
0 1 0 The instruction is being executed and calls the internally used communication instructions.
1 0 0 The receipt has been completed successfully. "0000" is output at the STATUS parameter. 

DONE = "1" is only displayed for one cycle.
0 0 1 The execution of the instruction or an intermediate step during processing was terminated 

with an error. If there is a subsequent error due to an internally used communication 
instruction, the error that occurred first during processing is displayed. This state is only 
displayed for one cycle.

Parameters ERROR and STATUS

ERROR STATUS
(W#16#...)

Description

0 0000 Receive job executed without error.
0 0001 The connection establishment is complete.
0 0003 The connection termination is complete.
0 7000 No job processing active.
0 7001 ● Start receive job execution

● Establish communication connection
● Wait for connection partner

0 7002 Data is being received.
0 7003 Communication connection is being terminated.
0 7004 ● Communication connection established and monitored.

● No receive job processing active.
0 7005 Communication connection is being reset.
0 7006 Data is currently being received.
1 8085 ● The LEN parameter is larger than the highest permitted value.

● The value at the LEN or DATA parameter was changed after the first call.
1 8086 The ID parameter is outside the permitted range.
1 8087 Maximum number of connections reached; no additional connection possible
1 8088 The value at the LEN parameter does not correspond to the receive area set at the DATA parameter.
1 8089 The CONNECT parameter does not point to a data block.
1 8091 Maximum nesting depth exceeded.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the connection 

description.
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ERROR STATUS
(W#16#...)

Description

1 809B InterfaceID is invalid. It is either zero or it does not point to a local CPU interface or a CP.
1 80A1 ● Connection or port already being used by user.

● Communication error:
– The specified connection has not yet been established.
– The specified connection is being terminated.

Transfer via this connection is not possible.
– The interface is being re-initialized.

1 80A3 ● Attempt being made to re-establish an existing connection.
● Attempt being made to terminate a non-existent connection.

1 80A4 IP address of the remote endpoint of the connection is invalid or it matches the IP address of the 
local partner.

1 80A7 Communication error: You called the instruction with COM_RST = 1 before the send job was 
complete.

1 80B4 You have violated one or both of the following conditions for passive connection establishment 
(active_est = FALSE) when using the ISO-on-TCP protocol variant (connection_type = B#16#12): 
"local_tsap_id_len >= B#16#02", and/or "local_tsap_id[1] = B#16#E0".

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error in the connection_type parameter of the data block for connection 

description.
1 80B7

 
Error in one of the following parameters of the data block for connection description: block_length, 
local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, next_staddr_len.

1 80C3 ● All connection resources are in use.
● A block with this ID is already being processed in a different priority group.

1 80C4
 

Temporary communication error:
● The connection cannot be established at this time.
● The interface is receiving new parameters or the connection is being established.
● The configured connection is currently being removed by a "TDISCON" instruction.
● The connection used is being terminated by a call with COM_RST = 1.

1 8722 Error in the CONNECT parameter: Invalid source area (area not declared in data block).
1 873A Error in the CONNECT parameter: Access to connection description is not possible (no access to 

data block).
1 877F Error in the CONNECT parameter: Internal error
1 8922 Parameter DATA: Invalid target area; the area does not exist in the DB.
1 8924 Parameter DATA: Area error in the VARIANT pointer.
1 8932 Parameter DATA: The DB number is too high.
1 893A Parameter CONNECT: Access to specified connection data not possible (e.g. because the DB 

does not exist).
1 897F Parameter DATA: Internal error, e.g. invalid VARIANT reference.
1 8A3A Parameter DATA: No access to the data area, for example because the data block does not exist.
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 Note
Error messages of the instructions "TCON", "TRCV" and "TDISCON"

Internally, the TRV_C instruction uses the "TCON (Page 2880)", "TRCV (Page 2892)" and 
"TDISCON (Page 2884)" instructions. The error messages of these instructions are contained 
in the respective descriptions.

 

See also
TSEND_C: Send data via Ethernet (Page 2847)

TMAIL_C: Transfer email

Description of TMAIL_C

Description
You use the instruction "TMAIL_C" to send an e-mail via the Ethernet interface of the S7-1500 
CPU or S7-1200 V4.0, a communication module (CM), or of a communication processor (CP).

The instruction can only be used once the hardware has been configured and if the network 
infrastructure allows for a communication connection to the mail server.

You define the content of the e-mail, and the connection data, using the following parameters:

● You define the recipient addresses with the parameters TO_S and CC.

● You define the content of the e-mail with the parameters SUBJECT and TEXT.

● You can define an attachment using VARIANT pointers at the ATTACHMENT and 
ATTACHMENT_NAME parameters.

● The connection data is defined, and addressing and authentication for the mail server 
executed, using the system data type Tmail_v4, Tmail_v6 or Tmail_FQDN at the 
MAIL_ADDR_PARAM parameter.

– If you are using the interface of the S7-1500 CPU, the system data type Tmail_v4 must 
be used. In this case, the e-mail can only be sent via SMTP.

– Any of the system data types can be used if you are using the interface of a CM/CP. 
The e-mail can then also be sent via SMTPS.

● You start the sending of an e-mail with an edge change from "0" to "1" for the REQ 
parameter. 

● The job status is indicated by the output parameters "BUSY", "DONE", "ERROR" and 
"STATUS".

You cannot send an SMS directly with the "TMAIL_C" instruction. Whether or not the e-mail 
can be forwarded by the mail server as an SMS depends on your telecommunications provider.
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Operation of the instruction
The "TMAIL_C" instruction works asynchronously, which means its execution extends over 
multiple calls. You must specify an instance when you call the instruction "TMAIL_C". 

In the following cases, the connection to the mail server will be lost:

● If the CPU switches to STOP while "TMAIL_C" is active.

● If communication problems occur at the Industrial Ethernet bus. 

In this case, the transfer of the e-mail will be interrupted and it will not reach its recipient. The 
connection is also canceled once the instruction has been successfully executed and the e-
mail sent.

 

 NOTICE

Changing user programs

You can change the parts of your user program that directly affect calls of "TMAIL_C" only:
● The CPU is in "STOP" mode.
● No e-mail is being sent (REQ = 0 and BUSY = 0).

This relates, in particular, to deleting and replacing program blocks that contain "TMAIL_C" 
calls or calls for the instance of "TMAIL_C".

Ignoring this restriction can tie up connection resources. The automation system can change 
to an undefined status with the TCP/IP communication functions via Industrial Ethernet.

A warm or cold restart of the CPU is required after the changes are transferred.
 

Data consistency
The TO_S, CC, SUBJECT, TEXT, ATTACHMENT and  MAIL_ADDR_PARAM parameters are 
applied by the "TMAIL_C" instruction while it is running, which means that they may only be 
changed after the job has been completed (BUSY = 0).

SMTP authentication 
Authentication refers here to a procedure for verifying identity, for example, with a password 
query. 

If you are using the S7-1500 CPU interface, the instruction "TMAIL_C" supports the SMTP 
authentication procedure AUTH-LOGIN which is required by most mail servers. For information 
about the authentication procedure of your mail server, please refer to your mail server manual 
or the website of your Internet service provider. 
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● Before you can use the AUTH-LOGIN authentication procedure, the "TMAIL_C" instruction 
requires the user name with which it is to log on to the mail server. This user name 
corresponds to the user name with which you set up a mail account on your mail server. It 
is transferred via the UserName parameter to the structure at parameter 
MAIL_ADDR_PARAM.
If no user name is specified at the MAIL_ADDR_PARAM parameter, the AUTH-LOGIN 
authentication procedure is not used. The e-mail is then sent without authentication.

● To log on, the "TMAIL_C" instruction also requires the associated password. This password 
corresponds to the password you specified when you set up your mail account. It is 
transferred via the PassWord parameter to the structure at parameter 
MAIL_ADDR_PARAM. 

Parameters
The following table shows the parameters of the "TMAIL_C" instruction:

Parameter Declaratio
n

Data type Memory area Description

REQ Input BOOL I, Q, M, D, L, 
T, C or 
constant

Control parameter REQUEST: Activates the 
sending of an e-mail upon a rising edge.

TO_S 
(Page 2870)

Input STRING D Recipient addresses
STRING with a maximum length of 180 
characters (bytes). 
For the e-mail address format, please see 
the example in the parameter description.

CC 
(Page 2870)

Input STRING D CC recipient addresses (optional)
STRING with a maximum length of 180 
characters (bytes). 
Same e-mail address format as for the TO_S 
parameter. If an empty string is assigned 
here, the e-mail is not sent to a CC recipient.

SUBJECT Input STRING D Subject of the e-mail
STRING with a maximum length of 180 
characters (bytes).

TEXT Input STRING D Text of the e-mail (optional)
STRING with a maximum length of 180 
characters (bytes). If an empty string is 
assigned at this parameter, the e-mail is sent 
without text.

ATTACHMEN
T

Input VARIANT D E-mail attachment (optional)
Reference to a byte/word/double word field 
(ArrayOfByte, ArrayOfWord or 
ArrayOfDWord) with a maximum length of 
64 bytes. If no value is assigned, the e-mail 
is sent without an attachment.
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Parameter Declaratio
n

Data type Memory area Description

ATTACHMEN
T_NAME

Input VARIANT D E-mail attachment name (optional)
Reference to a character string with a 
maximum length of 50 characters (bytes) to 
define the file name of the attachment. If an 
empty string is assigned at this parameter, 
the e-mail attachment will be sent with the 
file name "attachment.bin".

MAIL_ADDR_
PARAM 
(Page 2870)

Input VARIANT D Connection parameter and address of the e-
mail server
To define the connection parameters, use 
the structure Tmail_v4, Tmail_v6 or 
Tmail_FQDN (see parameter description).

DONE 
(Page 2873)

Output BOOL I, Q, M, D, L Status parameter
● DONE = 0: Job not yet started or still 

executing.
● DONE = 1: Job was executed without 

errors.
BUSY 
(Page 2873)

Output BOOL I, Q, M, D, L Status parameter
● BUSY=0: The processing of "TMAIL_C" 

was stopped.
● BUSY = 1: E-mail transmission is not yet 

complete.
ERROR 
(Page 2873)

Output BOOL I, Q, M, D, L Status parameter
● ERROR = 0: No error has occurred.
● ERROR = 1: An error occurred during 

processing. STATUS supplies detailed 
information on the type of error.

STATUS 
(Page 2874)

Output WORD I, Q, M, D, L Status parameter
Return value or error information of the 
"TMAIL_C" instruction (see parameter 
description).

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

 

 Note
Optional parameters

The optional parameters CC, TEXT, and ATTACHMENT are only sent with the e-mail if the 
corresponding parameters contain a string of length > 0.
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TO_S and CC parameters

Description
The TO_S and CC parameters are strings, for example, with the following content:

● <wenna@mydomain.com>, <ruby@mydomain.com>

● <admin@mydomain.com>, <judy@mydomain.com>

 

Note the following rules when entering the parameters:

● A space and an opening pointed bracket "<" must be entered before each address.

● A closing pointed bracket ">" must be entered after each address.

● A comma must be entered between the addresses in TO and CC.

For runtime and memory space reasons, the "TMAIL_C" instruction does not perform a syntax 
check of parameter TO_S or CC.

MAIL_ADDR_PARAM parameter

Description
At the MAIL_ADDR_PARAM parameter, you define the connection for sending the e-mail in 
the structure Tmail_v4, Tmail_v6 or Tmail_FQDN, and save the e-mail server address and 
login details.

The structure you use at the MAIL_ADDR_PARAM parameter depends on the format in which 
the e-mail server is to be addressed:

● Tmail_v4: Addressing by IP address (IPv4).

● Tmail_v6: Addressing by IP address (IPv6).

● Tmail_FQDN: Addressing by fully qualified domain name (FQDN).

Which structure you can use depends on the interface addressed at the InterfaceId parameter:

● If you want to use the "TMAIL_C" instruction with the internal interface, the structure 
Tmail_v4 must be used at the MAIL_ADDR_PARAM parameter.

● If you are using a communication processor (CP) or communication module (CM), you can 
use all three addressing options (IPv4, IPv6 and FQDN).

Table 9-124 Tmail_v4: Addressing the mail server by IP address (IPv4)

Parameter Data type Description
Tmail_v4 Struct  
 InterfaceId LADDR Hardware identifier of the interface

ID CONN_OUC Connection ID
ConnectionType BYTE Connection type. Select 16#20 as the connection type for 

IPv4.
ActiveEstablished BOOL Status bit. Set to "1" once the connection is established.
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Parameter Data type Description
CertIndex BYTE ● =0: SMTP used (Simple Mail Transfer Protocol). SMTP 

must be used if the e-mail is being sent via the interface 
of an S7-1500 CPU.

● ≠0: SMTPS used to secure the connection before it is 
established (with CPs/CMs). You use the CertIndex 
parameter to specify the certificate to be used (see 
"Project navigation" > "Global security settings" > 
"Certificate manager").

WatchDogTime TIME Execution watchdog. Use this parameter to define the 
maximum execution time for the send operation.
Note: Connection establishment can take longer (approx. 
one minute) if the connection is slow. When you specify the 
WATCH_DOG_TIME parameter, remember to allow for the 
time required to establish the connection.
The connection is terminated once the specified time has 
elapsed.

MailServerAddress IP_v4 IP address of the mail server. IPv4 in the following format: 
XXX.XXX.XXX.XXX (decimal). 
Example: 192.142.131.237.

UserName STRING[254] Mail server login name
PassWord STRING[254] Mail server password
From EMAIL_ADDR E-mail sender address, which is defined using the following 

two STRING parameters. For example: 
"myname@mymailserver.com".

 LocalPartPlusAtSi
gn

STRING[64] Local part of sender address, including @ sign. Example: 
"myname@".

FullQualifiedDom
ainName

STRING[254] Fully Qualified Domain Name ( FQDN for short) of the mail 
server. Example: "mymailserver.com".

Table 9-125 Tmail_v6: Addressing the mail server by IP address (IPv6)

Parameter Data type Description
Tmail_v6 Struct  
 InterfaceId LADDR Hardware identifier of the interface

ID CONN_OUC Connection ID
ConnectionType BYTE Connection type. Select 16#21 as the connection type for 

IPv6.
ActiveEstablished BOOL Status bit. Set to "1" once the connection is established.
CertIndex BYTE ● =0: SMTP used (Simple Mail Transfer Protocol). SMTP 

must be used if the e-mail is being sent via the interface 
of an S7-1500 CPU.

● ≠0: SMTPS used to secure the connection before it is 
established (with CPs/CMs). You use the CertIndex 
parameter to specify the certificate to be used (see 
"Project navigation" > "Global security settings" > 
"Certificate manager").
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Parameter Data type Description
WatchDogTime TIME Execution watchdog. Use this parameter to define the 

maximum execution time for the send operation.
Note: Connection establishment can take longer (approx. 
one minute) if the connection is slow. When you specify the 
WATCH_DOG_TIME parameter, remember to allow for the 
time required to establish the connection.
The connection is terminated once the specified time has 
elapsed.

MailServerAddress IP_v6 IP address of the mail server (IPv6) in the following format: 
XXXX.XXXX.XXXX.XXXX.XXXX.XXXX.XXXX.XXXX 
(hexadecimal). 
The address is divided into 8 blocks of 2 bytes each (16 bytes 
in total). 
Example: 2001:db8:1f11:08d3:290:27ff:0370:2093

UserName STRING[254] Mail server login name
PassWord STRING[254] Mail server password
From EMAIL_ADDR E-mail sender address, which is defined using the following 

two STRING parameters. For example: 
"myname@mymailserver.com".

 LocalPartPlusAtSi
gn

STRING[64] Local part of sender address, including @ sign. Example: 
"myname@".

FullQualifiedDom
ainName

STRING[254] Fully Qualified Domain Name ( FQDN for short) of the mail 
server. Example: "mymailserver.com".

Table 9-126 Tmail_FQDN: Addressing the mail server by FQDN

Parameter Data type Description
Tmail_v6 Struct  
 Tmail_FQDN LADDR Hardware identifier of the interface

ID CONN_OUC Connection ID
ConnectionType BYTE Connection type. Select 16#22 as the connection type for 

FQDN.
ActiveEstablished BOOL Status bit. Set to "1" once the connection is established.
CertIndex BYTE ● =0: SMTP used (Simple Mail Transfer Protocol). SMTP 

must be used if the e-mail is being sent via the interface 
of an S7-1500 CPU.

● ≠0: SMTPS used to secure the connection before it is 
established (with CPs/CMs). You use the CertIndex 
parameter to specify the certificate to be used (see 
"Project navigation" > "Global security settings" > 
"Certificate manager").

WatchDogTime TIME Execution watchdog. Use this parameter to define the 
maximum execution time for the send operation.
Note: Connection establishment can take longer (approx. 
one minute) if the connection is slow. When you specify the 
WATCH_DOG_TIME parameter, remember to allow for the 
time required to establish the connection.
The connection is terminated once the specified time has 
elapsed.
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Parameter Data type Description
MailServerAddress STRING[254] FQDN (Fully Qualified Domain Name) of the mail server. The 

mail server is addressed using the fully qualified domain 
name. 
Example: "www.mymailserver.com.".

UserName STRING[254] Mail server login name
PassWord STRING[254] Mail server password
From Struct E-mail sender address, which is defined using the following 

two STRING parameters. For example: 
"myname@mymailserver.com".

 LocalPartPlusAtSi
gn

STRING[64] Local part of sender address, including @ sign. Example: 
"myname@".

FullQualifiedDom
ainName

STRING[254] Fully Qualified Domain Name ( FQDN for short) of the mail 
server. Example: "mymailserver.com".

DONE, BUSY and ERROR parameters

Description
The output parameters DONE, BUSY and ERROR are each displayed for only one cycle if the 
status of the BUSY output parameter changes from "1" to "0".

The following table shows the relationship between DONE, BUSY, and ERROR. Using this 
table, you can determine the current status of the instruction "TMAIL_C and when the sending 
of the e-mail is complete.

DONE BUSY ERRO
R

Description

0 1 0 The job is being processed.
1 0 0 Job successfully completed.
0 0 1 The job ended with an error. The cause of the error can be found in the 

STATUS (Page 2874) parameter.
0 0 0 The "TMAIL_C" instruction was not assigned a (new) job.
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STATUS parameter

Description
The following table shows the return values of "TMAIL_C" at the STATUS parameter:

Return value
STATUS*
(W#16#...):

Explanation Notes

0000 The processing of "TMAIL_C" was 
completed without errors.

Error-free completion of "TMAIL_C" does not 
mean that the e-mail sent will necessarily 
arrive. 
Incorrectly entering the recipient addresses 
does not generate a status error of the 
"TMAIL_C" instruction. In this case, there is no 
guarantee that the e-mail will be sent to other 
recipients, even if these were entered correctly.

7001 "TMAIL_C" is active (BUSY = 1). First call: Job triggered.
7002 "TMAIL_C" is active (BUSY = 1). Intermediate call: Job already active.
8xxx The processing of "TMAIL_C" was 

completed with an error code of the 
communication instructions called 
internally.

For detailed information, please refer to the 
STATUS parameter descriptions for the 
"TCON (Page 2880)", "TDISCON 
(Page 2884)", "TSEND (Page 2889)" and 
"TRCV (Page 2892)" communication 
instructions.

8010 Error during connection establishment You will find further information on evaluation in
the SFB_STATUS parameter of the instance 
data block. The error code displayed at the 
SFB_STATUS parameter is explained in the 
STATUS parameter description for the "TCON 
(Page 2880)" instruction.

8011 Error sending the data You will find further information on evaluation in
the SFB_STATUS parameter of the instance 
data block. The error code displayed at the 
SFB_STATUS parameter is explained in the 
STATUS parameter description for the 
"TSEND (Page 2889)" instruction.

8012 Error receiving the data You will find further information on evaluation in
the SFB_STATUS parameter of the instance 
data block. The error code displayed at the 
SFB_STATUS parameter is explained in the 
STATUS parameter description for the "TRCV 
(Page 2892)" instruction.

8013 Error during connection establishment You will find further information on evaluation in
the SFB_STATUS parameter of the instance 
data block. The error code displayed at the 
SFB_STATUS parameter is explained in the 
STATUS parameter description for the TCON 
(Page 2880)" and "TDISCON (Page 2884)" 
instructions.
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Return value
STATUS*
(W#16#...):

Explanation Notes

8014 Establishment of a connection is not 
possible.

You may have entered an incorrect mail server 
IP address (MailServerAddress (Page 2870)) 
or too short a time span (WatchDogTime 
(Page 2870)) for connection establishment. It is 
also possible that the CPU has no connection 
to the network or that the CPU configuration is 
incorrect.

8015 Incorrect data type for 
MAIL_ADDR_PARAM

The only valid data types are the system data 
types (structures) Tmail_v4, Tmail_v6 and 
TMail_FQDN.

8016 Incorrect data type for the 
ATTACHMENT parameter

The only valid data types are ArrayOfByte, 
ArrayOfWord and ArrayOfDWord.

8017 Incorrect data length for the 
ATTACHMENT parameter

Data length must be <= 65534 bytes.

8401 No channels available. Possible 
cause: There is already an e-mail 
connection via the CP. A second 
connection cannot be established in 
parallel.

Specific error for CP 1543

8403 A TCP/IP connection to the mail server 
was not possible.

Specific error for CP 1543

8405 Server has denied login request. Specific error for CP 1543
8406 SMTP client has detected an internal 

SSL error or a problem with the 
certificate structure.

Specific error for CP 1543

8407 Request to use SSL denied. Specific error for CP 1543
8408 Client unable to identify socket for 

establishing a TCP/IP connection to 
the mail server.

Specific error for CP 1543

8409 Writing via the connection not 
possible. Possible cause: The 
communication partner has reset the 
connection or the connection has been 
lost.

Specific error for CP 1543

8410 Reading via the connection not 
possible. Possible cause: The 
communication partner has reset the 
connection or the connection has been 
lost.

Specific error for CP 1543

8411 E-mail could not be sent. Cause: 
Insufficient memory space to execute 
the send operation.

Specific error for CP 1543

8412 DNS server configured was unable to 
resolve the specified domain name.

Specific error for CP 1543

8413 An internal error in the DNS 
subsystem prevented domain name 
resolution.

Specific error for CP 1543
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Return value
STATUS*
(W#16#...):

Explanation Notes

8414 Empty character string entered as 
domain name.

Specific error for CP 1543

8415 An internal error has occurred in the 
cURL module. Execution was stopped.

Specific error for CP 1543

8416 An internal error has occurred in the 
SMTP module.  Execution was 
stopped.

Specific error for CP 1543

8417 Request to SMTP on a channel 
already in use or invalid channel ID. 
Execution was stopped.

Specific error for CP 1543

8418 E-mail send job aborted. Possible 
causes: Execution time exceeded 
(WatchDogTime parameter) or CP 
transition from start to stop.

Specific error for CP 1543

8419 Channel interrupted and cannot be 
used before the connection is closed.

Specific error for CP 1543

8420 Server certificate string could not be 
verified with CP root certificate.

Specific error for CP 1543

8421 Internal error occurred. Execution was 
stopped.

Specific error for CP 1543

82xx, 84xx, 
or 85xx

The error message originates from the 
mail server and corresponds, except 
for the "8", to the error number of the 
SMTP protocol.
The following lines list several error 
codes that can occur.

You will find more detailed information on the 
SMTP error code and other error codes in the 
SMTP protocol on the Internet or in the error 
documentation of the mail server. You can also 
view the most recent error message from the 
mail server in your instance DB in the 
BUFFER1 parameter. You will find the last data 
sent by the "TMAIL_C" instruction under 
DATEN in the instance DB.

8450 Action not executed: Mailbox not 
available/cannot be reached

Try again later.

8451 Action aborted: Local processing error Try again later.
8500 Syntax error: Error not recognized. 

This also includes the error when a 
command string is too long. This can 
also occur when the e-mail server 
does not support the LOGIN 
authentication procedure.

Check the parameters of "TMAIL_C". Try to 
send an e-mail without authentication. To do 
this, replace the content of the UserName 
parameter with an empty string. If no user name 
is specified, the LOGIN authentication 
procedure is not used.

8501 Syntax error: Incorrect input at a 
parameter

Possible cause: Incorrect address at the TO_S 
or CC parameter (see also: TO_S and CC 
parameters (Page 2870)).

8502 Command unknown or not 
implemented

Check your entries, in particular the FROM 
parameter. It may be incomplete and you may 
have forgotten the "@" or "." (see also: TO_S 
and CC parameters (Page 2870)).

8535 SMTP authentication 
incomplete                        

You have possibly entered an incorrect user 
name or incorrect password.
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Return value
STATUS*
(W#16#...):

Explanation Notes

8550 Mail server cannot be reached. You 
have no access rights.

You may have entered an incorrect user name 
or password, or the mail server may not support 
your login. Another cause of error could be a 
mistake in the domain name after the "@" at the 
TO_S or CC parameter (see also: TO_S and 
CC parameters (Page 2870)).

8552 Action aborted: Assigned memory size 
has been exceeded                         

Try again later.

8554 Transfer failed Try again later.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For 
additional information on toggling display formats, refer to "See also".

Other

TCON: Establishing a communication connection

TCON: Establish communication connection

Description
You use the "TCON" instruction to set up and establish a communication connection. Once 
the connection has been set up and established, it is automatically maintained and monitored 
by the CPU. "TCON" is executed asynchronously.

The connection data specified for the CONNECT and ID parameters are used to set up the 
communication connection. To establish the connection, a rising edge must be detected at the 
REQ parameter. Once the connection is successfully established, the DONE parameter is set 
to "1".

Number of possible connections
For information on the number of possible communication connections, refer to the technical 
specifications for your CPU.

Connection with TCP and ISO-on-TCP
Both communication partners call the "TCON" instruction to set up and establish the 
communication connection. During parameter assignment, you specify which partner is the 
active communication end point and which is the passive one.

If the connection aborts, for example due to a line break or due to the remote communication 
partner, the active partner attempts to reestablish the configured connection. You do not have 
to call "TCON" again. This applies only if "TCON" has been executed successfully once (DONE 
= 1).
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An existing connection is terminated and the connection set up is removed when the 
"TDISCON (Page 2884)" instruction is executed or when the CPU changes to STOP mode. 
To set up and establish the connection again, you will need to execute "TCON" again.

Parameters
The following table shows the parameters of the "TCON" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the job to establish the connection 
specified in the ID upon a rising edge.

ID Input CONN_OUC 
(WORD)

I, Q, M, D, L or 
constant

Reference to the assigned connection.
Range of values: W#16#0001 to W#16#0FFF

CONNECT InOut TCON_Param D Pointer to the connection description
See also: Auto-Hotspot 

DONE Output BOOL I, Q, M, D, L Status parameter with the following values: 
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot 

be started
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters BUSY, DONE and ERROR
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. You use the DONE parameter to check 
whether or not a job has been executed successfully. The ERROR parameter is set when 
errors occurred during execution of "TCON". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.
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Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Connection successfully established.
0 7000 No job processing active
0 7001 Start job execution, establish connection.
0 7002 Connection is being established (REQ irrelevant).
1 8085 ID is used by a configured connection
1 8086 The ID parameter is outside the valid range.
1 8087 Maximum number of connections reached; no additional connection possible
1 8089 The CONNECT parameter does not point to a data block.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the 

connection description.
1 809B The element InterfaceId within the TCON_xxx structure does not reference a hardware identifier 

of a CPU or CM/CP interface or has the value "0". 
1 80A0 Group error for error codes W#16#80A1 and W#16#80A2.
1 80A2 Local or remote port is being used by the system.
1 80A3 Attempt being made to re-establish an existing connection.
1 80A4 IP address of the remote endpoint of the connection is invalid, in other words, it matches the IP 

address of the local partner.
1 80A5 Connection ID is already in use.
1 80A7 Communication error: You executed "TDISCON (Page 2884)" before "TCON" had completed. 
1 80B2 The CONNECT parameter points to a data block that was generated with the attribute "Only 

store in load memory".
1 80B4 You have violated one or more of the following conditions for passive connection establishment 

with the ISO-on-TCP protocol variant (connection_type = B#16#12):
● local_tsap_id_len >= B#16#02
● local_tsap_id[1] = B#16#E0
● With local_tsap_id_len >= B#16#03, local_tsap_id[1] is an ASCII character.
● local_tsap_id[1] is an ASCII character and local_tsap_id_len >= B#16#03.

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error at the connection_type parameter of the SDT TCON_Param.
1 80B7 Error in one of the following parameters of the data block for connection description: 

block_length, local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, 
next_staddr_len.

1 80B8 Connection description of the structure element ID and the block parameter ID are not identical.
1 80C3 All connection resources are in use.
1 80C4 Temporary communication error:

● The connection cannot be established at this time.
● The interface is currently receiving new parameters.
● The configured connection is currently being removed by a "TDISCON (Page 2884)" 

instruction.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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TCON: Establish communication connection

Description
You use the "TCON" instruction to set up and establish a communication connection. Once 
the connection has been set up and established, it is automatically maintained and monitored 
by the CPU. "TCON" is executed asynchronously.

The connection data specified for the CONNECT and ID parameters are used to set up the 
communication connection. 

● At the CONNECT parameter, if possible, only use the predefined structures as created by 
the connection parameter assignment in the Inspector window of the program editor. 

● If the CONNECT parameter is not interconnected with a structure listed in the parameter 
table or if the structure includes an error, the error code 8089 is output at the STATUS 
parameter.

To establish the connection, a rising edge must be detected at the REQ parameter. Once the 
connection is successfully established, the DONE parameter is set to "1".

The instruction "TCON" V3.0 can also be used with CPU S7-1200, Version 4.0 or later.

Number of possible connections
For information on the number of possible communication connections, refer to the technical 
specifications for your CPU.

Connection with TCP and ISO-on-TCP
Both communication partners call the "TCON" instruction to set up and establish the 
communication connection. During parameter assignment, you specify which partner is the 
active communication end point and which is the passive one.

If the connection aborts, for example due to a line break or due to the remote communication 
partner, the active partner attempts to reestablish the configured connection. You do not have 
to call "TCON" again. This applies only if "TCON" has been executed successfully once (DONE 
= 1).

An existing connection is terminated and the connection set up is removed when the 
"TDISCON (Page 2884)" instruction is executed or when the CPU changes to STOP mode. 
To set up and establish the connection again, you will need to execute "TCON" again.
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Parameters
The following table shows the parameters of the "TCON" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the job to establish the connection 
specified on a rising edge.
 

ID Input CONN_OUC 
(WORD)

I, Q, M, D, L or 
constant

Reference to the assigned connection.
Range of values: W#16#0001 to W#16#0FFF

CONNECT InOut VARIANT D Pointer to the connection description
● For TCP or UDP, use the structure 

TCON_IP_v4
For description, refer to: Auto-Hotspot 

● For ISO-on-TCP, use the structure 
TCON_IP_RFC
For description, refer to: Auto-Hotspot

● For ISO, use the structure 
TCON_ISOnative (only for CP1543-1)
For description, refer to: "Structure of the 
connection description according to  
TCON_ISOnative"

DONE Output BOOL I, Q, M, D, L Status parameter with the following values: 
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot 

be started
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters BUSY, DONE and ERROR
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. You use the DONE parameter to check 
whether or not a job has been executed successfully. The ERROR parameter is set when 
errors occurred during execution of "TCON". The error information is output at the STATUS 
parameter.

The instruction "TCON" generates an error message in version 3.0 if an active connection 
establishment to a remote partner fails. Create a rising edge at the REQ parameter to establish 
a connection once again.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:
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BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

Structure of the connection description according to TCON_ISOnative
A connection description DB with a structure according to  TCON_ISOnative is used to assign 
the communication connection parameters for ISO. The fixed data structure of the 
TCON_ISOnative contains all parameters that are required to establish the connection. 

Byte Parameter Data type Start value Description
0 … 
1

InterfaceId HW_ANY 64 Hardware identifier of the local interface (value range: 0 to 
65535).

2 … 
3

ID CONN_OUC 1 Reference to this connection (unique ID in the value range: 
1 to 4095).

4 ConnectionType BYTE 16#16 Connection type: ISO
5 ActiveEstablished BOOL TRUE ID for the manner in which the connection is established:

● FALSE: Passive connection establishment
● TRUE: Active connection establishment

8 … 
13

RemoteMacAddress ARRAY [1..6] of 
BYTE

- MAC address of the partner end point, for example, for 
00-74-41-FD-AE-84: 
● MacAddr[1] = 00
● MacAddr[2] = 74
● MacAddr[3] = 41
● MacAddr[4] = FD
● MacAddr[5] = AE
● MacAddr[6] = 84

14 ..
. 19

LocalMacAddress ARRAY [1..6] of 
BYTE

- MAC address of the local end point, for example, for 
00-74-41-FD-AE-84: 
● MacAddr[1] = 00
● MacAddr[2] = 74
● MacAddr[3] = 41
● MacAddr[4] = FD
● MacAddr[5] = AE
● MacAddr[6] = 84

20 ..
. 53

RemoteTSelector Struct - TSelector of the remote connection partner:
● Bytes 20 to 21 = TSelLength
● Bytes 22 to 53:  = TSel[1-32]

 TSelLength UINT - Value range from 0 to 32
TSel ARRAY [1..32] 

of BYTE
- Value range in each case 0 to 255 in bytes
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Byte Parameter Data type Start value Description
54 ..
. 87

LocalTSelector Struct - TSelector of the remote connection partner:
● Bytes 20 to 21 = TSelLength
● Bytes 22 to 53:  = TSel[1-32]

 TSelLength UINT  Value range from 0 to 32
TSel ARRAY [1..32] 

of BYTE
- Value range in each case 0 to 255 in bytes

88 
… 
89

CrRetransmitionTime UINT - Duration until connection attempt is repeated in seconds.

90 ..
. 91

DataRetransmitionTim
e

UINT 100 ms Duration until data transfer is repeated in milliseconds.

92 ..
. 93

MaxRetransmitionCou
nt

UINT - Maximum number of repetitions.

94 ..
. 95

InactivityTime UINT - in seconds

96 ..
. 97

WindowTime UINT  in seconds

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Connection successfully established.
0 7000 No job processing active
0 7001 Start job execution, establish connection.
0 7002 Connection is being established (REQ irrelevant).
1 8085 ID is used by a configured connection.
1 8086 The ID parameter is outside the valid range.
1 8087 Maximum number of connections reached; no additional connection possible
1 8089 The CONNECT parameter does not point to a connection description or the connection 

description was created manually.
1 809A The structure at the CONNECT parameter is not supported or the length is invalid.
1 809B The element InterfaceId within the TCON_xxx structure does not reference a hardware identifier 

of a CPU or CM/CP interface or has the value "0". 
1 80A2 Local or remote port is being used by the system. The following ports are reserved locally: 20, 

21, 80, 102, 135, 161, 162, 443, 34962, 34963, 34964 as well as the area 49152 to 65535.
1 80A3 ID is used by a connection created by the user program, which uses the same connection 

description at the CONNECT parameter.
1 80A4 IP address of the remote endpoint of the connection is invalid or it corresponds to the IP address 

of the local partner.
1 80A7 Communication error: You executed "TDISCON (Page 2884)" before "TCON" had completed. 
1 80B4 Only with TCON_IP_RFC: The local T selector was not specified or the first byte does not contain 

the value 0x0E (only with a length of T selector = 2) or the local T selector starts with "SIMATIC-".
1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP (parameter 

ActiveEstablished of the structure TCON_IP_v4 / TCON_PARAM has the value TRUE).
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ERROR STATUS* 
(W#16#...)

Explanation

1 80B6 Parameter assignment error in the ConnectionType parameter of the data block for connection 
description.
● Only valid with TCON_IP_v4: 0x11, 0x0B and 0x13.
● Only valid with TCON_IP_RFC: 0x0C and 0x12

1 80B7 With TCON_IP_v4:
● TCP (active connection establishment): Remote port is "0".
● TCP (passive connection establishment): Local port is "0".
● UDP: Local port is "0".
With TCON_IP_RFC: 
● Local (LocalTSelector) or remote (RemoteTSelector) T selector was specified with a length 

of more than 32 bytes.
● For TSelLength of the T selector (local or remote), a length greater than 32 was entered.
● Error in the length of the IP address of the specific connection partner.

1 80B8 Parameter ID in the local connection description (structure at CONNECT parameter) and 
parameter ID of the instruction are different.

1 80C3 All connection resources are in use.
1 80C4 Temporary communication error:

● The connection cannot be established at this time.
● The interface is currently receiving new parameters.
● The configured connection is currently being removed by a "TDISCON (Page 2884)" 

instruction.
1 80C5 The connection partner refuses to establish the connection, has terminated the connection or 

actively ended it.
1 80C6 The connection partner cannot be reached (network error).
1 80C7 Execution timeout.
1 80C8 Value at the ID parameter is already being used by a connection that was created using the user 

program. The connection uses the identical ID, but different connection settings at the parameter 
CONNECT.

1 80C9 Validation of the connection partner failed. The connection partner that wants to establish the 
connection does not match the defined partner of the structure at the CONNECT parameter.

1 80CE The IP address of the local interface is 0.0.0.0.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TDISCON: Terminate communication connection

Description
The "TDISCON" instruction terminates a communications connection from the CPU to a 
connection partner.
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Functional description
"The TDISCON" instruction works asynchronously, which means its job processing extends 
over multiple calls. You start the job for terminating a connection by calling the "TDISCON" 
instruction with REQ = 1.

After "TDISCON" has been successfully executed, the ID specified for "TCON" is no longer 
valid and cannot be used for sending or receiving.

The job status is indicated by the output parameters BUSY and STATUS. Here, STATUS 
corresponds to the output parameter RET_VAL of the asynchronous instructions (see also: 
Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous instructions 
(Page 1582)).

The following table shows the relationship between BUSY, DONE and ERROR. Using this 
table, you can recognize the current status of "TDISCON" or when the establishment of the 
connection is completed.

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 Job successfully completed.
0 0 1 The job ended with an error. The cause of the error can be found in the STATUS 

parameter.
0 0 0 The instruction was not assigned a (new) job.

Parameters
The following table shows the parameters of the instruction "TDISCON":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

REQ Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Control parameter REQUEST starts the 
job for terminating the connection 
specified by ID. The job starts on a rising 
edge.

ID Input CONN_OU
C (WORD)

D, L or constant I, Q, M, D, L or 
constant

Reference to the connection to be 
terminated (connection ID)
Range of values: W#16#0001 to 
W#16#0FFF

DONE Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter: 
● 0: Job not yet started or still executing.
● 1: Job executed without errors

BUSY Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter:
● BUSY = 1: The job is not yet 

completed.
● BUSY = 0: The job is completed or has 

not started yet.
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

ERROR Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter:
● ERROR=0: No error.
● ERROR=1: Error occurred during 

processing. STATUS supplies 
detailed information on the type of 
error

STATUS Output WORD I, Q, M, D, L I, Q, M, D, L Status parameter: 
Error information (see "Parameters 
ERROR and STATUS")

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Connection terminated successfully.
0 7000 No job processing active.
0 7001 Start of job processing, connection being terminated.
0 7002 Intermediate call (REQ irrelevant), connection being terminated.
1 8086 The ID parameter is not in the permitted value range.
1 80A3 Attempt is being made to terminate a non-existent connection or the connection is already 

terminated.
1 80C4 Temporary communication error: New parameters are being assigned to the interface or the 

connection is currently being established.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TSEND: Send data via communication connection

TSEND: Send data via communication connection

Description
The following description of the "TSEND" instruction is valid for the CPU S7-1200 to version 
3.0.

You use the "TSEND" instruction to send data over an existing communication connection. 
"TSEND" is executed asynchronously.

You specify the send area with the DATA parameter. This includes the address and the length 
of the data to be sent. All data types except BOOL and Array of BOOL can be used for the 
data to be sent.

The send job is executed when a rising edge is detected at the REQ parameter.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2886 System Manual, 07/2013,  



With the LEN parameter, you specify the maximum number of bytes sent with a send job.

● When data is transferred with TCP (streaming protocol), the "TSEND" instruction provides 
no information about the length of the data sent to "TRCV (Page 2892)".

● When data is transferred with ISO-on-TCP (message-oriented protocol), the length of the 
data sent is communicated to "TRCV (Page 2892)". The amount of data sent with "TSEND" 
as packet must also be received again at the receiving end ("TRCV (Page 2892)"):

– If the receive buffer is too small for the sent data, an error occurs at the receiving end.

– If the receive buffer is sufficiently large, "TRCV" returns with DONE=1 as soon as the 
data packet is received.

The data to be sent must not be edited until the send job is completed. If the send job executes 
successfully, the DONE parameter is set to "1". Signal state "1" at the DONE parameter is not 
confirmation that the data sent has already been read out by the communication partner.

Parameters
The following table shows the parameters of the "TSEND" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the send job on a rising edge.

ID Input CONN_OUC 
(WORD)

D, L or constant Reference to the connection established with "TCON".
Range of values: W#16#0001 to W#16#0FFF

LEN Input UINT I, Q, M, D, L Maximum number of bytes to be sent with the job.
DATA InOut VARIANT I, Q, M, D Pointer to the send area containing the address and 

the length of the data to be sent. The address 
references:
● The process image of the inputs
● The process image of the outputs
● A bit memory
● A data block

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameters LEN and DATA
● With LEN = 0 , all the data specified with the DATA parameter is sent.

● If the number of bytes at the LEN parameter is larger than the length of the data to be sent 
that was defined with the DATA parameter, the error code 8088 is output at the STATUS 
parameter (see description of the STATUS parameter below).

● If a structure (Struct) is referenced via the DATA parameter, LEN can be shorter than the 
structure. In this case, only the data up to the length of the LEN parameter is transferred.

● With data types STRING and WSTRING, all data is transferred if the parameter LEN = 0. 
When LEN > 0, the length must be at least the maximum number of bytes plus two additional 
bytes which contain the length information. You can find more detailed information on the 
structure of the data types in: "Overview of the valid data types (Page 1077)".

● The maximum number of bytes that can be transmitted is 65534.

● When you use structured tags from optimized DBs, the address of the structured tag should 
be interconnected at the DATA parameter and the parameter LEN = 0. This guarantees 
type-safe transmission of the entire structure if the same structure is used at the receiving 
end.

Parameters BUSY, DONE and ERROR
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TSEND". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is specified in the STATUS parameter.
0 0 0 No new job was assigned.

 

 Note

Because "TSEND" is executed asynchronously, you must keep the data in the send area 
consistent until the DONE parameter or the ERROR parameter changes to the value "1".

 

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Description

0 0000 Send job completed without error.
0 7000 No job processing active.
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ERROR STATUS* 
(W#16#...)

Description

0 7001 Start of job execution, data is being sent.
When processing this job, the operating system accesses the data in the DATA send area.

0 7002 Job executing (REQ irrelevant).
When processing this job, the operating system accesses the data in the DATA send area.

1 8085 ● The LEN parameter is greater than the highest permitted value (65536).
● DATA and LEN parameters both have the value "0".

1 8086 The ID parameter is outside the permitted address range (1..0xFFF).
1 8088 The LEN parameter is greater than the area specified in DATA.
1 80A1 Communication error:

● The specified connection has not yet been established.
● The specified connection is being terminated. Transfer via this connection is not possible.
● The interface is being re-initialized.

1 80B3 The protocol variant (ConnectionType parameter in the connection description) is set to UDP. Use 
the instruction "TUSEND" with a UDP connection.

1 80C3 ● A block with this ID is already being processed in a different priority group.
● Internal lack of resources.

1 80C4 Temporary communication error:
● The connection cannot be established to the partner at this time.
● The interface is receiving new parameter settings or the connection is being established.

1 80C5 Connection terminated by the communication partner.
1 80C6 Network error. Communication partner cannot be reached.
1 80C7 Execution timeout.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TSEND: Send data via communication connection

Description
The following description of the "TSEND" instruction is valid for the CPU S7-1500 and S7-1200 
V4.0.

You use the "TSEND" instruction to send data over an existing communication connection. 
"TSEND" is executed asynchronously.

You specify the send area with the DATA parameter. This includes the address and the length 
of the data to be sent. All data types except BOOL and Array of BOOL can be used for the 
data to be sent.

The send job is executed when a rising edge is detected at the REQ parameter.

With the LEN parameter, you specify the maximum number of bytes sent with a send job.
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● When data is transferred with TCP (streaming protocol), the "TSEND" instruction provides 
no information about the length of the data sent to "TRCV (Page 2892)".

● When data is transferred with ISO-on-TCP (message-oriented protocol), the length of the 
data sent is communicated to "TRCV (Page 2892)". The amount of data sent with "TSEND" 
as packet must also be received again at the receiving end ("TRCV (Page 2892)"):

– If the receive buffer is too small for the sent data, an error occurs at the receiving end.

– If the receive buffer is sufficiently large, "TRCV" returns with DONE=1 as soon as the 
data packet is received.

The data to be sent must not be edited until the send job is completed. If the send job executes 
successfully, the DONE parameter is set to "1". Signal state "1" at the DONE parameter is not 
confirmation that the data sent has already been read out by the communication partner.

Parameters
The following table shows the parameters of the "TSEND" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the send job on a rising edge.

ID Input CONN_OUC 
(WORD)

D, L or constant Reference to the connection established with "TCON".
Range of values: W#16#0001 to W#16#0FFF

LEN Input UDINT I, Q, M, D, L Maximum number of bytes to be sent with the job.
DATA InOut VARIANT I, Q, M, D Pointer to the send area containing the address and 

the length of the data to be sent. The address 
references:
● The process image of the inputs
● The process image of the outputs
● A bit memory
● A data block

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".
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Parameters LEN and DATA
● With LEN = 0 , all the data specified with the DATA parameter is sent.

● If the number of bytes at the LEN parameter is larger than the length of the data to be sent 
that was defined with the DATA parameter, the error code 8088 is output at the STATUS 
parameter (see description of the STATUS parameter below).

● If a structure (Struct) is referenced via the DATA parameter, LEN can be shorter than the 
structure. In this case, only the data up to the length of the LEN parameter is transferred.

● With data types STRING and WSTRING, all data is transferred if the parameter LEN = 0. 
When LEN > 0, the length must be at least the maximum number of bytes plus two additional 
bytes which contain the length information. You can find more detailed information on the 
structure of the data types in: "Overview of the valid data types (Page 1077)".

● The maximum number of bytes that can be transmitted depends on the device.

● When you use structured tags from optimized DBs, the address of the structured tag should 
be interconnected at the DATA parameter and the parameter LEN = 0. This guarantees 
type-safe transmission of the entire structure if the same structure is used at the receiving 
end.

Parameters BUSY, DONE and ERROR
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TSEND". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is specified in the STATUS parameter.
0 0 0 No new job was assigned.

 

 Note

Because "TSEND" is executed asynchronously, you must keep the data in the send area 
consistent until the DONE parameter or the ERROR parameter changes to the value "1".

 

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Description

0 0000 Send job completed without error.
0 7000 No job processing active.
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ERROR STATUS* 
(W#16#...)

Description

0 7001 Start of job execution, data is being sent.
When processing this job, the operating system accesses the data in the DATA send area.

0 7002 Job executing (REQ irrelevant).
When processing this job, the operating system accesses the data in the DATA send area.

1 8085 ● The LEN parameter is greater than the highest permitted value (65536).
● DATA and LEN parameters both have the value "0".

1 8086 The ID parameter is outside the permitted address range (1..0xFFF).
1 8088 The LEN parameter is greater than the area specified in DATA.
1 80A1 Communication error:

● The specified connection has not yet been established.
● The specified connection is being terminated. Transfer via this connection is not possible.
● The interface is being re-initialized.

1 80B3 The protocol variant (ConnectionType parameter in the connection description) is set to UDP. Use 
the instruction "TUSEND" with a UDP connection.

1 80C3 ● A block with this ID is already being processed in a different priority group.
● Internal lack of resources.

1 80C4 Temporary communication error:
● The connection cannot be established to the partner at this time.
● The interface is receiving new parameter settings or the connection is being established.

1 80C5 Connection terminated by the communication partner.
1 80C6 Network error. Communication partner cannot be reached.
1 80C7 Execution timeout.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TRCV: Receive data via communication connection

TRCV: Receive data via communication connection

Description
The following description of the "TRCV" instruction is valid for the CPU S7-1200 up to version 
3.0.

You use the "TRCV" instruction to receive data over an existing communication connection. 
"TRCV" is executed asynchronously.

Receipt of data is enabled when the EN_R parameter is set to the value "1". The received data 
is entered in a receive area. You specify the length of the receive area either with the LEN 
parameter (if LEN <> 0) or with the length information of the DATA parameter (if LEN = 0), 
depending on the protocol variant being used. 

While data is being received, you cannot make changes to the DATA parameter or the defined 
receive area to ensure consistency of the received data.
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After successful receipt of data, the NDR parameter is set to the value "1". You can query the 
amount of data actually received at the RCVD_LEN parameter.

Receive modes of "TRCV"
The following table shows how the received data is entered in the receive area.

Protocol variant Availability of data in the receive area connection_type* 
parameter of the 
connection description

Parameter LEN

TCP
(Ad-hoc mode)

The data is immediately available. Hexadecimal value: 
B#16#11
Integer value: 17

0

TCP 
(Receipt of data with 
specified length)

The data is available as soon as the data 
length specified at the LEN parameter 
has been fully received.

Hexadecimal value: 
B#16#11
Integer value: 17

1 to 8192

ISO on TCP
(Message-oriented data 
transfer)

The data is available as soon as the data 
length specified at the LEN parameter 
has been fully received.

Hexadecimal value: 
B#16#12
Integer value: 18

● 1 to 1452, if a CP is 
used.

● 1 to 8192, if no CP is 
used.

* See "Auto-Hotspot". 

TCP (Ad-hoc mode)
The ad-hoc mode is only available with the TCP protocol variant. You use the ad-hoc mode 
to receive data with dynamic length with the "TRCV" instruction.

You set ad-hoc mode by assigning the value "0" to the LEN parameter. All data types can be 
used for data blocks with standard access when you use ad-hoc mode. Only ARRAY of BYTE 
or data types with a length of 8 bits can be used for data blocks with optimized access (e.g., 
CHAR, USINT, SINT, etc.). When ad-hoc mode is active, receipt of data is already signaled 
after a received byte at the NDR parameter.

TCP (Receipt of data with specified length)
For receipt of data with a specified length, enter the length of the data at the LEN parameter. 
The data receipt is not complete until the length of data specified at the LEN parameter has 
been completely received. Only then is the data available in the receive area (DATA 
parameter). The receipt of data is signaled by the NDR output parameter. The actually received 
data length in bytes at the RCVD_LEN parameter corresponds to the data length at the LEN 
parameter after receipt. 

ISO on TCP (Message-oriented data transfer)
Complete message blocks are sent via a connection with the protocol variant ISO on TCP; 
these are recognized as such by the recipient. When using ISO on TCP, "TRCV" signals data 
receipt as soon as the message block has been completely received. The receive area is 
defined by the LEN and DATA parameters. If the receive buffer (DATA parameter) is too small 
for the sent data, "TRCV" signals an error. The successful receipt of data is signaled by the 
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NDR output parameter. The actually received data length in bytes at the RCVD_LEN parameter 
corresponds to the data length at the LEN parameter after receipt. 

Parameters
The following table shows the parameters of the "TRCV" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Receive enable

ID Input CONN_OUC 
(WORD)

D, L or constant Reference to the connection established with 
"TCON (Page 2877)".
Range of values: W#16#0001 (1) to W#16#0FFF 
(4095)

LEN Input UDINT I, Q, M, D, L or 
constant

Length of the receive area in bytes (hidden). 
If you use a memory area with optimized access at 
the DATA parameter, the LEN parameter must have 
the value "0".

DATA InOut VARIANT I, Q, M, D Pointer to the receive area
NDR Output BOOL I, Q, M, D, L Status parameter (New Data Received):

● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started
ERROR Output BOOL I, Q, M, D, L Status parameter:

● 0: No error.
● 1: An error occurred during execution of the 

instruction.
Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter:
Output of status and error information.

RCVD_LEN Output UDINT I, Q, M, D, L Amount of data actually received in bytes

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters LEN, DATA and RCVD_LEN
● If LEN = 0, the received data is saved in the receive area specified at the DATA parameter. 

The number of bytes received is indicated at the RCVD_LEN parameter.

● If the length specified at the LEN parameter is greater than the length of the data received 
at the DATA parameter, the error code 8088 is output at the STATUS parameter (see 
description of the STATUS) parameter in the following.

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2894 System Manual, 07/2013,  



● If a structure (Struct) is referenced via the DATA parameter, LEN can be shorter than the 
structure. In this case, only the data up to the length of the LEN parameter is transferred.

● If the DATA parameter references a data block with optimized access, the LEN parameter 
must be set to "0".

● If a STRING data type is referenced via the DATA parameter, the length specified at the 
LEN parameter must be 0 or >=2 (LEN = 1 is not permitted).

● If a WSTRING data type is referenced via the DATA parameter, the length specified at the 
LEN parameter must be 0 or >=5.

Parameters BUSY, NDR and ERROR
You can check the status of the job with the BUSY, NDR, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the NDR parameter, you can check 
whether or not a job executed successfully. The ERROR parameter is set when errors occurred 
during execution of TRCV. The error information is output at the STATUS parameter.

The following table shows the relationship between the BUSY, NDR and ERROR parameters:

BUSY NDR ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

 

 Note

Because "TRCV" is executed asynchronously, the data in the receive area is only consistent 
when the NDR parameter is set to the value "1".

 

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Job completed successfully. The current length of the received data is output at the RCVD_LEN 
parameter.

0 7000 Block not ready to receive.
0 7001 Block is ready to receive, receive job was activated.
0 7002 Interim call, the receive job is executing.

Note: While the job is being processed, data is written to the receive area. Access to the receive 
area during this time may provide inconsistent data. 

1 8085 ● The LEN parameter is larger than the highest permitted value.
● The value of the LEN or DATA parameter was changed after the first call.
● Both LEN parameters and the DATA parameter have the value "0" or LEN is longer than the 

maximum permitted value (65536).
1 8086 The ID parameter is outside the permitted address range (1 .. 0x0FFF).
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ERROR STATUS* 
(W#16#...)

Explanation

1 8088 ● Receive area is too small.
● The value at the LEN parameter is larger than the receive area set at the DATA parameter.

1 80A1 Communication error:
● The specified connection has not yet been established.
● The specified connection is being terminated. Receive job over this connection is not possible.
● The connection is being re-initialized.

1 80B3 The protocol variant (connection_type parameter in the connection description) is set to UDP. Use 
the instruction "TURCV" with a UDP connection.

1 80C3 ● A block with this ID is already being processed in a different priority group.
● Internal lack of resources.

1 80C4 Temporary communication error:
● The connection cannot be established to the partner at this time.
● The interface is receiving new parameter settings or the connection is being established.

1 80C5 The remote partner has terminated the connection.
1 80C6 The remote partner cannot be reached (network error).
1 80C7 Execution timeout.
1 80C9 The length of the receive area is smaller than the length of the sent data.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TRCV: Receive data via communication connection

Description
The following description of the "TRCV" instruction is valid for the CPU S7-1500 and S7-1200 
V4.0.

You use the "TRCV" instruction to receive data over an existing communication connection. 
"TRCV" is executed asynchronously.

Receipt of data is enabled when the EN_R parameter is set to the value "1". The received data 
is entered in a receive area. You specify the length of the receive area either with the LEN 
parameter (if LEN <> 0) or with the length information of the DATA parameter (if LEN = 0), 
depending on the protocol variant being used.

While data is being received, you cannot make changes to the DATA parameter or the defined 
receive area to ensure consistency of the received data.

After successful receipt of data, the NDR parameter is set to the value "1". You can query the 
amount of data actually received at the RCVD_LEN parameter.
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Receive modes of "TRCV"
The following table shows how the received data is entered in the receive area.

Protocol variant Parameter 
ADHOC

Availability of data in the 
receive area

connection_type 
parameter of the 
connection description

Parameter LEN

TCP
(Ad-hoc mode)

1 (ad-hoc 
activated)

The data is immediately 
available.

Hexadecimal value: 
B#16#11
Integer value: 17

1 up to maximum 
length (depending on 
the CPU)

TCP 
(Receipt of data with 
specified length)

0 (ad-hoc 
deactivated)

The data is available as soon 
as the data length specified at 
the LEN parameter has been 
fully received.

Hexadecimal value: 
B#16#11
Integer value: 17

1 to 8192

ISO on TCP
(Message-oriented 
data transfer)

- The data is available as soon 
as the data length specified at 
the LEN parameter has been 
fully received.

Hexadecimal value: 
B#16#12
Integer value: 18

● 1 to 1452, if a CP is 
used.

● 1 to 8192, if no CP 
is used.

TCP (Ad-hoc mode)
The ad-hoc mode is only available with the TCP protocol variant. You use the ad-hoc mode 
to receive data with dynamic length with the "TRCV" instruction.

You set ad-hoc mode by assigning the value "1" to the ADHOC parameter. All data types can 
be used for data blocks with standard access when you use ad-hoc mode. Only ARRAY of 
BYTE or data types with a length of 8 bits can be used for data blocks with optimized access 
(e.g., CHAR, USINT, SINT, etc.). When ad-hoc mode is active, receipt of data is already 
signaled after a received byte at the NDR parameter. 

TCP (Receipt of data with specified length)
Assign the value "0" to the ADHOC parameter for receipt of data with specified length. If ad-
hoc mode is disabled, the data receipt is not complete until the length of data specified at the 
LEN parameter has been completely received. Only then is the data available in the receive 
area (DATA parameter). The successful receipt of data is signaled by the NDR output 
parameter. The actually received data length in bytes at the RCVD_LEN parameter 
corresponds to the data length at the LEN parameter after receipt. 

ISO on TCP (Message-oriented data transfer)
Complete message blocks are sent via a connection with the protocol variant ISO on TCP; 
these are recognized as such by the recipient. When using ISO on TCP, "TRCV" signals data 
receipt as soon as the message block has been completely received. The receive area is 
defined by the LEN and DATA parameters. If the receive buffer (DATA parameter) is too small 
for the sent data, "TRCV" signals an error. The successful receipt of data is signaled by the 
NDR output parameter. The actually received data length in bytes at the RCVD_LEN parameter 
corresponds to the data length at the LEN parameter after receipt. 
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Parameters
The following table shows the parameters of the "TRCV" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Receive enable

ID Input CONN_OUC 
(WORD)

D, L or constant Reference to the connection established with 
"TCON".
Range of values: W#16#0001 to W#16#0FFF

LEN Input UDINT I, Q, M, D, L or 
constant

Length of the receive area in bytes (hidden).
If you use a receive area with optimized access at 
the DATA parameter, the LEN parameter must have 
the value "0".

ADHOC Input BOOL I, Q, M, D, L or 
constant

Use ad-hoc mode for the TCP protocol variant 
(hidden).

DATA InOut VARIANT I, Q, M, D Pointer to the receive area
NDR Output BOOL I, Q, M, D, L Status parameter (New Data Received):

● 0: Job not yet started or still in progress
● 1: New data received

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction
RCVD_LEN Output UDINT I, Q, M, D, L Amount of data actually received in bytes

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters LEN, DATA and RCVD_LEN
● If LEN = 0, the received data is saved in the receive area specified at the DATA parameter. 

The number of bytes received is indicated at the RCVD_LEN parameter.

● If the length specified at the LEN parameter is greater than the length of the data received 
at the DATA parameter, the error code 8088 is output at the STATUS parameter (see 
description of the STATUS) parameter in the following.

● If a structure (Struct) is referenced via the DATA parameter, LEN can be shorter than the 
structure. In this case, only the data up to the length of the LEN parameter is transferred.

● If the DATA parameter references a data block with optimized access, the LEN parameter 
must be set to "0". If the length of the data does not match for elementary data types, the 
data will not be received and the error code 8088 is output at the STATUS parameter.
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● If a STRING data type is referenced via the DATA parameter, the length specified at the 
LEN parameter must be 0 or >=2 (LEN = 1 is not permitted).

● If a WSTRING data type is referenced via the DATA parameter, the length specified at the 
LEN parameter must be 0 or >=5.

Parameters BUSY, NDR and ERROR
You can check the status of the job with the BUSY, NDR, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the NDR parameter, you can check 
whether or not a job executed successfully. The ERROR parameter is set when errors occurred 
during execution of TRCV. The error information is output at the STATUS parameter.

The following table shows the relationship between the BUSY, NDR and ERROR parameters:

BUSY NDR ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

 

 Note

Because "TRCV" is executed asynchronously, the data in the receive area is only consistent 
when the NDR parameter is set to the value "1".

 

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Job completed successfully. The current length of the received data is output at the RCVD_LEN 
parameter.

0 7000 Block not ready to receive.
0 7001 Block is ready to receive, receive job was activated.
0 7002 Interim call, the receive job is executing.

Note: While the job is being processed, data is written to the receive area. Access to the receive 
area during this time may provide inconsistent data. 

1 8085 ● The LEN parameter is larger than the highest permitted value.
● The value of the LEN or DATA parameter was changed after the first call.
● Both LEN parameters and the DATA parameter have the value "0" or LEN is longer than the 

maximum permitted value (65536).
1 8086 The ID parameter is outside the permitted value range (1 .. 0x0FFF).
1 8088 ● Receive area is too small.

● The value at the LEN parameter is larger than the receive area set at the DATA parameter.
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ERROR STATUS* 
(W#16#...)

Explanation

1 80A1 Communication error:
● The specified connection has not yet been established.
● The specified connection is being terminated. Receive job over this connection is not possible.
● The connection is being re-initialized.

1 80B3 The protocol variant (connection_type parameter in the connection description) is set to UDP. Use 
the instruction "TURCV" with a UDP connection.

1 80C3 ● A block with this ID is already being processed in a different priority group.
● Internal lack of resources.

1 80C4 Temporary communication error:
● The connection cannot be established to the partner at this time.
● The interface is receiving new parameter settings or the connection is being established.

1 80C5 The remote partner has terminated the connection.
1 80C6 The remote partner cannot be reached (network error).
1 80C7 Execution timeout.
1 80C9 The length of the receive area is smaller than the length of the sent data.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
TRCV: Receive data via communication connection (Page 2892)

TCON: Establish communication connection (Page 2880)

Structure of the address information for the remote partner with UDP

Overview
● With "TUSEND (Page 2901)", you transfer the address information of the receiver at the 

ADDR parameter. This address information must have the structure specified below.

● With "TURCV (Page 2904)", you receive the address of the sender of the received data at 
the ADDRparameter. This address information must have the structure specified below.

Data block for the address information of the remote partner
You must create a DB that contains one or more data structures as per PLC data type 
"TADDR_PARAM". 

In the ADDR parameter of "TUSEND (Page 2901)", you transfer a pointer of type VARIANT 
to the address of the corresponding remote partner (e.g. P#DB100.DBX0.0 USINT 8). This 
pointer is received in the ADDR parameter of "TURCV (Page 2904)".
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Configuration of the address information for the remote partner for "TADDR_PARAM"

Byte Parameter Data type Start value Description
0 to 3 rem_ip_addr ARRAY [1..4] of USINT B#16#00 ... IP address of the remote partner, e.g. 192.168.002.003:

● rem_ip_addr[1] = B#16#C0 (192)
● rem_ip_addr[2] = B#16#A8 (168)
● rem_ip_addr[3] = B#16#02 (002)
● rem_ip_addr[4] = B#16#03 (003)

4 to 5 rem_port_nr UINT B#16#00 ... remote port no. (possible values see: Auto-Hotspot):
● rem_port_nr[1] = high byte of the port no. in 

hexadecimal notation
● rem_port_nr[2] = low byte of port no. in hexadecimal 

notation
6 to 7 reserved WORD B#16#00 ... Not used. Assign "0" to this parameter.

TUSEND: Send data via Ethernet (UDP)

Description
The "TUSEND" instruction sends data to the remote partner addressed by the ADDR 
parameter using UDP.

 

 WARNING

Data transfer via UDP

Data transferred via UDP to RFC 768 to the remote partner are sent without 
acknowledgement and are therefore unsecured. This means the data can be lost without any 
indication at the block.

 

 Note

For sequential send operations to different partners, you only need to adjust the ADDR 
parameter when calling "TUSEND". You do not need to call the "TCON (Page 2877)" and 
"TDISCON (Page 2884)" instructions again.

 

Functional description
"The TUSEND" instruction works asynchronously, which means its job processing extends 
over multiple calls. You start the send operation by calling "TUSEND" with REQ = 1.

The job status is indicated by the output parameters BUSY and STATUS. Here, STATUS 
corresponds to the output parameter RET_VAL of the asynchronous instructions.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).
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The following table shows the relationship between BUSY, DONE and ERROR. Using this 
table, you can determine the current status of "TUSEND" or when the send process is 
concluded.

BUSY DONE ERROR Description
TRUE irrelevant irrelevant The job is being processed.
FALSE TRUE FALSE Job successfully completed.
FALSE FALSE TRUE The job ended with an error. The cause of the error can be found in the STATUS 

parameter.
FALSE FALSE FALSE The instruction was not assigned a (new) job.

 

 Note

Due to the asynchronous operation of "TUSEND", make sure the data in the send area 
remains consistent until the DONE parameter or the ERROR parameter has the value TRUE.

 

Parameters
The following table shows the parameters of the "TUSEND" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

REQ Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Control parameter REQUEST starts the 
send job on a rising edge.
The data is transferred from the area 
specified by DATA and LEN.

ID Input WORD M, D or constant M, D or constant Reference to the associated connection 
between the user program and the 
communication layer of the operating 
system. ID must be identical to the 
associated parameter ID in the local 
connection description. 
Range of values: W#16#0001 to 
W#16#0FFF

LEN Input UINT I, Q, M, D, L I, Q, M, D, L Number of bytes to be sent with the job
Range of values: 1 to 1472

DONE Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter DONE: 
● 0: Job not yet started or still executing.
● 1: Job executed without errors

BUSY Output BOOL I, Q, M, D, L I, Q, M, D, L ● BUSY = 1: The job is not yet completed. 
A new job cannot be triggered.

● BUSY = 0: The job is completed.
ERROR Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter ERROR:

● ERROR=1: An error has occurred 
during processing, STATUS supplies 
detailed information on the type of error.
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

STATUS Output WORD M, D M, D Status parameter STATUS: Error 
information

DATA InOut VARIANT I, Q, M, D I, Q, M, D Send area, contains address and length

The address refers to:
● The process image of the inputs
● The process image of the outputs
● A bit memory
● A data block

ADDR InOut TADDR_P
aram

D D Pointers to the address of the recipient (e.g. 
P#DB100.DBX0.0  USINT 8)
See also: Structure of the address 
information for the remote partner with 
UDP (Page 2900)

 

 Note

Create the data block for the ADDR parameter using the "Add new block" dialog, by selecting 
the type "TADDR_Param".

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1077)".

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Send job completed without error
0 7000 No job processing active
0 7001 Start of job processing, data being sent

Note: During this processing phase, the operating system accesses the data in the DATA send 
area.

0 7002 Intermediate call (REQ irrelevant), job is being processed
Note: During this processing phase, the operating system accesses the data in the DATA send 
area.

1 8085 The LEN parameter has the value "0" or is greater than the highest permitted value.
1 8086 The ID parameter is not in the permitted value range.
0 8088 The LEN parameter is greater than the memory area specified in DATA.
1 8089 The ADDR parameter does not point to a data block with the TADDR_Param structure.
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ERROR STATUS* 
(W#16#...)

Explanation

1 80A1 Communication error:
● The specified connection between user program and communication layer of the operating 

system has not yet been established.
● The specified connection between the user program and the communication layer of the 

operating system is currently being terminated. Transmission over this connection is not 
possible.

● The interface is being reinitialized.
1 80A4 IP address (at the ADDR parameter) of the remote connection end point is invalid; it may 

correspond to the local partner's own IP address.
1 80B3 ● The protocol variant (connection_type parameter in the connection description) is not set to 

UDP. Please use "TSEND (Page 2889)".
● ADDR parameter: Invalid information for port no.

1 80C3 ● A block with this ID is already being processed in a different priority class.
● Internal lack of resources.

1 80C4 Temporary communication error:
● The connection between the user program and the communication layer of the operating system 

cannot be established at this time.
● New parameter settings are being assigned to the interface.

1 80C5 The remote partner has terminated the connection.
1 80C6 The remote partner cannot be reached (network error).
1 80C7 Execution timeout.
- General 

error 
informatio
n

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TURCV: Receive data via Ethernet (UDP)

Description
The "TURCV" instruction receives data via UDP. After successful completion of "TURCV", the 
ADDR parameter will show you the address of the remote partner (the sender).

 

 WARNING

Unsecured data transfer

Data transferred via UDP to RFC 768 to the remote partner are sent without 
acknowledgement and are therefore unsecured. This means the data can be lost without any 
indication at the block.
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Functional description
"The TURCV" instruction works asynchronously, which means its job processing extends over 
multiple calls. You start the receive job by calling "TURCV" with EN_R = 1.

The job status is indicated by the output parameters BUSY and STATUS. Here, STATUS 
corresponds to the output parameter RET_VAL of the asynchronous instructions

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1582).

The following table shows the relationship between BUSY, NDR and ERROR. Using this table, 
you can determine the current status of TURCV or when the receive process is concluded.

BUSY NDR ERROR Description
TRUE irrelevant irrelevant The job is being processed.
FALSE TRUE FALSE Job successfully completed.
FALSE FALSE TRUE The job ended with an error. The cause of the error can be found in the STATUS 

parameter.
FALSE FALSE FALSE The instruction was not assigned a (new) job.

 

 Note

Due to the asynchronous operation of "TURCV", the data in the receive area is only consistent 
when the NDR parameter has the value TRUE.

 

Parameters
The following table shows the parameters of the "TURCV" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN_R Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Control parameter enabled to receive: When 
EN_R = 1, "TURCV" is ready to receive. The 
receive job is being processed.

ID Input WORD M, D or constant M, D or constant Reference to the associated connection 
between the user program and the 
communication layer of the operating system. 
ID must be identical to the corresponding 
parameter ID in the local connection description.
Value range: W#16#0001 to W#16#0FFF

LEN Input UINT I, Q, M, D, L I, Q, M, D, L Length of the receive area in bytes: 0 
(recommended) or 1 to 1472

NDR Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter NDR:
● NDR = 0: Job not yet started or still running
● NDR = 1: Job successfully completed

ERROR Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter ERROR:
● ERROR=1: Error occurred during 

processing. STATUS supplies detailed 
information on the type of error
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

BUSY Output BOOL I, Q, M, D, L I, Q, M, D, L ● BUSY = 1: The job is not yet completed. A 
new job cannot be triggered.

● BUSY = 0: The job is completed.
STATUS Output WORD M, D M, D Status parameter STATUS: Error information
RCVD_LEN Output UINT I, Q, M, D, L I, Q, M, D, L Amount of data actually received in bytes
DATA InOut VARIANT I, Q, M, D I, Q, M, D Receive area

The address references:
● The process image of the inputs
● The process image of the outputs
● A bit memory
● A data block

ADDR InOut TADDR_
Param

D D Pointers to the address of the receiver (for 
example, P#DB100.DBX0.0 byte 8), see also: 
Structure of the address information for the 
remote partner with UDP (Page 2900)

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 New data was accepted. The current length of the received data is shown in RCVD_LEN.
0 7000 Block not ready to receive
0 7001 Block is ready to receive, receive job was activated
0 7002 Intermediate call, receive job being processed

Note: During this processing phase, "TURCV" writes data to the receive area. For this reason, an 
error could result in inconsistent data in the receive area.

1 8085 The LEN parameter is greater than the largest permitted value, or you changed the value of the 
LEN or DATA parameter since the first call

1 8086 The ID parameter is not in the permitted range
1 8088 ● Receive area is too small

● Value in LEN is higher than the receive area specified by DATA
1 8089 The ADDR parameter does not point to a data block with the TADDR_Param structure.
1 80A1 Communication error:

● The specified connection between user program and communication layer of the operating 
system has not yet been established.

● The specified connection between the user program and the communication layer of the 
operating system is currently being terminated. A receive job over this connection is not 
possible.

● New parameter settings are being assigned to the interface.
1 80A4 IP address (at the ADDR parameter) of the remote connection end point is invalid; it may 

correspond to the local partner's own IP address.
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ERROR STATUS* 
(W#16#...)

Explanation

1 80B3 The protocol variant (connection_type parameter in the connection description) is not set to UDP. 
Please use "TRCV (Page 2892)".

1 80B7 The length at ADDR parameter does not correspond to 8 bytes.
1 80C3 ● A block with this ID is already being processed in a different priority class.

● Internal lack of resources.
1 80C4 Temporary communication error: New parameter settings are being assigned to the interface.
1 80C5 The remote partner has terminated the connection.
1 80C6 The remote partner cannot be reached (network error).
1 80C7 Execution timeout.
1 80C9 With RFC1006 / UDP: The received data is longer than expected (size of receive buffer exceeded).
- General 

error 
information

See also: GET_ERR_ID: Get error ID locally (Page 1787)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
TCON: Establish communication connection (Page 2877)

TDISCON: Terminate communication connection (Page 2884)

T_RESET: Resetting the connection

Description
The "T_RESET" instruction terminates and then reestablishes an existing connection. 

The local end points of the connection are retained. They are generated automatically:

● If a connection has been configured and loaded to the CPU.

● If a connection has been generated by the user program, for example, by calling the 
instruction "TCON (Page 2877)".

The instruction "T_RESET" can be executed for all connection types (TCP, UDP, ISO-on-TCP, 
etc.). It does not matter whether the local interface of the CPU or the interface of a CM/CP was 
used for the connection.

Once the instruction "T_RESET" has been called using the REQ parameter, the connection 
specified with the ID parameter is terminated and, if necessary, the data send and receive 
buffer cleared. Canceling the connection also cancels any data transfer in progress. There is 
therefore a risk of losing data if data transfer is in progress. The CPU defined as the active 
connection partner will then automatically attempt to restore the interrupted communication 
connection. You therefore do not need to call the "TCON (Page 2877)" instruction to reestablish 
the communication connection.

The output parameters DONE, BUSY and STATUS indicate the status of the job.
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Parameters
The following table shows the parameters of the "T_RESET" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter REQUEST starts the job for 
terminating the connection specified by ID. 
The job starts on a rising edge.

ID Input CONN_OUC 
(WORD)

L, D or constant Reference to the connection to the passive 
partner which is to be terminated. ID must be 
identical to the corresponding parameter ID in 
the local connection description.
Range of values: W#16#0001 to W#16#0FFF

DONE Output BOOL I, Q, M, D, L Status parameter DONE
● 0: Job not yet started or still executing.
● 1: Job executed without errors

BUSY Output BOOL I, Q, M, D, L Status parameter BUSY
● 0: Job is complete.
● 1: The job is not yet completed.

ERROR Output BOOL I, Q, M, D, L Status parameter ERROR
● 0: No error occurred.
● 1: Error occurred during processing. The 

STATUS parameter supplies detailed 
information on the type of error

STATUS Output WORD I, Q, M, D, L Status parameter STATUS
Error information (see "STATUS parameter" 
table).

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameter STATUS

STATUS* 
(W#16#...)

Explanation

0000 No error.
0001 Connection has not been established.
7001 Connection termination launched.
7002 Connection being terminated.
8081 Unknown connection specified at the ID parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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T_DIAG: Checking the connection

Description
You use the "T_DIAG" instruction to check the status of a connection and read further 
information on the local end point of this connection. 

● The connection is referenced by the ID parameter. You can read both connection end points 
configured in the connection editor and programmed connection end points (e.g. with the 
"TCON" instruction). 
Temporary connection end points (for example end points created when you connect to an 
engineering station) cannot be diagnosed, as no connection ID is generated in this process.

● The connection information read is stored in a structure referenced by the RESULT 
parameter. 

● The output parameter STATUS indicates whether it was possible to read the connection 
information. The connection information in the structure at the RESULT parameter is only 
valid if the "T_DIAG" instruction has been completed with STATUS = W#16#0000 and 
ERROR = FALSE. 
Connection information cannot be evaluated if an error occurs.

Possible connection information
Two different structures can be used to read the connection information at the RESULT 
parameter:

● The "TDiag_Status" structure only contains the most important information about a 
connection end point, for example the protocol used, the connection status and the number 
of data bytes sent or received.

● The structure "TDiag_StatusExt" supplies not just the most important information, but also 
the number of connection attempts, the reason for a connection abort, etc. 

The structure and parameters of the two structures are described below (see the 
"TDIAG_Status and TDIAG_StatusExt structures" table).

Parameters
The following table shows the parameters of the "T_DIAG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the instruction to check the connection 
specified in the ID parameter when there is a 
positive edge.

ID Input CONN_OUC 
(WORD)

L, D or constant Reference to the assigned connection. 
Range of values: W#16#0001 to W#16#0FFF

RESULT InOut VARIANT D Pointer to the structure in which the connection 
information is stored. The structure 
TDiag_Status or TDiag_StatusExt can be used 
at the RESULT parameter (for a description, 
see the "TDIAG_Status and TDIAG_StatusExt 
structures" table).
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Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, D, L Status parameter:

● 0: Instruction not yet started or still in 
progress.

● 1: Instruction executed without errors.
BUSY Output BOOL I, Q, M, D, L Status parameter:

● 0: Instruction not yet started or already 
completed.

● 1: Instruction not yet completed. A new job 
cannot be started.

ERROR Output BOOL I, Q, M, D, L Status parameter:
● 0: No error.
● 1: Error occurred.

STATUS Output WORD I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameters BUSY, DONE and ERROR
You can check the status of "T_DIAG" instruction execution with the BUSY, DONE, ERROR 
and STATUS parameters. The BUSY parameter indicates the processing status. You use the 
DONE parameter to check whether or not an instruction has been executed successfully. The 
ERROR parameter is set if errors occur during execution of "T_DIAG".

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERRO
R

Description

1 - - The instruction is being processed.
0 1 0 The instruction has been executed successfully. The data in the structure referenced by RESULT 

are only valid if this is the case.
0 0 1 Instruction completed with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new instruction has been assigned.

Parameter STATUS
The following table shows the meaning of the values at the STATUS parameter:

STATU
S* 
(W#16#.
..)

Explanation

0000 The instruction "T_DIAG" has been executed successfully. The data in the structure referenced at the RESULT 
parameter can be evaluated.

7000 No instruction processing active.
7001 Instruction processing launched.
7002 Connection information is being read (REQ parameter irrelevant).
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STATU
S* 
(W#16#.
..)

Explanation

8086 The value at the ID parameter is outside the valid range (W#16#0001 ... W#16#0FFF).
8089 The RESULT parameter points to an invalid data type (structures TDIAG_Status and TDIAG_StatusExt only).
80A3 The ID parameter references a connection end point which does not exist. With programmed connections, this 

error can also occur after the "TDISCON" instruction is called.
80C4 Internal error. Access to the connection end point is temporarily unavailable.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Structures TDIAG_Status and TDIAG_StatusExt
The table below details the form of the TDIAG_Status and TDIAG_StatusExt structures:

● From the InterfaceID to the ReceivedBytes parameter, the "TDIAG_StatusExt" and 
"TDIAG_Status" structures are identical.

● The structure TDIAG_StatusExt also includes the parameters ConnTrials to 
LastDisconnTimeStamp.

The value of each element is only valid if the instruction has been executed without errors. If 
an error occurs, the content of the parameters will not change.

Name Data type Description
The following parameters are in both the TDIAG_Status and the TDIAG_StatusExt structure:
InterfaceID HW_ANY Interface ID (LADDR) of the CPU or the CM/CP.
ID CONN_OU

C
ID of the connection diagnosed. Following a successful call, the value of this element is 
identical to the parameter ID of the "T_DIAG" instruction.
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Name Data type Description
ConnectionType BYTE Protocol type used for connection:

● 0x01: Not used.
● ...
● 0x0B: TCP protocol (IP_v4)
● 0x0C: ISO-on-TCP protocol (RFC1006)
● 0x0D: TCP protocol (DNS)
● 0x0E: Dial-in protocol
● 0x0F: WDC protocol
● 0x10: SMTP protocol
● 0x11: TCP protocol
● 0x12: TCP and ISO-on-TCP protocol (RFC1006)
● 0x13: UDP protocol
● 0x14: Reserved
● 0x15: PROFIBUS bus access protocol (FDL)
● 0x16: ISO 8073 transport protocol (ISO native)
● ...
● 0x20: SMTP or SMTPS protocol - based on IPv4
● 0x21: SMTP or SMTPS protocol - based on IPv6
● 0x22: SMTP or SMTPS protocol - based on FQDN (Fully Qualified Domain Name)
● ...
● 0x70: S7 connection
● Other: Reserved

ActiveEstablished BOOL ● FALSE: Locally, the passive connection end point
● TRUE: Locally, the active connection end point

State BYTE Current status of the connection end point
● 0x00: Not used.
● 0x01: Connection terminated. Temporary status, for example, after the "T_RESET" 

instruction is called. The system then automatically attempts to reestablish the 
connection.

● 0x02: The active connection end point is attempting to establish a connection to the 
remote communication partner.

● 0x03: The passive connection end point is waiting for establishment of the connection 
to the remote communication partner.

● 0x04: Connection established.
● 0x05: The connection is being terminated. This may be because the "T_RESET" or 

"T_DISCON" instruction has been called. Other possible reasons are protocol errors 
and line breaks.

● 0x06..0xFF: Not used.
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Name Data type Description
Kind BYTE Mode of the connection end point:

● 0x00: Not used.
● 0x01: Configured, static connection which has been configured and loaded to the CPU.
● 0x02: Configured, dynamic connection which has been configured and loaded to the 

CPU (not currently supported).
● 0x03: Programmed connection generated in the user program with the instruction 

"TCON". A call of the instruction "TDISCON" or a transition to CPU STOP status has 
destroyed the connection end point.

● 0x04: Temporary, dynamic connection established by the engineering station (ES) or 
operator station (OS), for example. (this connection type cannot currently by diagnosed 
as there is no ID).

● 0x05..0xFF: Not used.
SentBytes UDINT Number of data bytes sent.
ReceivedBytes UDINT Number of data bytes received.
The following parameters only occur in the TDiag_StatusExt structure:
ConnTrials UDINT Number of connection attempts. Once a connection has been established, ConnTrials has 

the value 0. If this element is not equal to 0, there are connection problems. 
Note: With a passive connection end point, this value is never greater than 1.

ConnTrialsSucces
s

UDINT Number of successful connection attempts. This element is never reset during the life cycle 
of a connection end point, and returns to 0 after reaching 0xFFFF FFFF. 
Note: This parameter is 1 if there has never been a problem in this connection.

LastConnErrReas
on

UDINT Error ID output during the last connection attempt with errors (the error messages are 
identical to those at the LastDisconnReason parameter):
● 0x4F01: Remote connection end point cannot be reached (this error usually occurs 

during connection establishment).
● 0x4F02: Connection terminated locally.
● 0x4F03: Connection terminated by remote communication partner.
● 0x4F04: Connection terminated by a protocol error.
● 0x4F05: Connection terminated by a network problem detected locally.
● 0x4F06: Connection terminated by a network problem detected remotely.
● 0x4F07: Connected terminated due to timeout in protocol.
● 0x4F08: Incorrect parameter assignment: Connection to be established to local 

partner's own address.
● 0x4F09: Connection temporarily reset by a call of the instruction "T_RESET".
● 0x4F0A: Insufficient connection resources available (quantity exceeded)
● 0x4F0B: Internal error: Incorrect addressing parameters
● 0x4F0C: Internal CPU communication error
● 0x4F0D: Internal AS communication error between CPU and CM/CP
● 0x4F0E: The local TCP/UDP port (or RFC1006-T selector) specified is already in use.

LastConnErrTime
Stamp

LDT Time of the last connection attempt with errors.
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Name Data type Description
LastDisconnReas
on

UDINT Error ID which led to the last connection termination (the error messages are identical to 
those at the LastConnErrReason parameter):
● 0x4F01: Remote connection end point cannot be reached (this error usually occurs 

during connection establishment).
● 0x4F02: Connection terminated locally.
● 0x4F03: Connection terminated by remote communication partner.
● 0x4F04: Connection terminated by a protocol error.
● 0x4F05: Connection terminated by a network problem detected locally.
● 0x4F06: Connection terminated by a network problem detected remotely.
● 0x4F07: Connected terminated due to timeout in protocol.
● 0x4F08: Incorrect parameter assignment: Connection to be established to local 

partner's own address.
● 0x4F09: Connection temporarily reset by a call of the instruction "T_RESET".
● 0x4F0A: Insufficient connection resources available (quantity exceeded)
● 0x4F0B: Internal error: Incorrect addressing parameters
● 0x4F0C: Internal CPU communication error
● 0x4F0D: Internal AS communication error between CPU and CM/CP
● 0x4F0E: The local TCP/UDP port (or RFC1006-T selector) specified is already in use.
 

LastDisconnTime
Stamp

LDT Time of the last connection termination.

T_CONFIG: Configure interface

Description T_CONFIG

Description
The "T_CONFIG" instruction is used for the program-controlled configuration of the integrated 
PROFINET interfaces of the CPU or the interface of a CP/CM. The existing configuration data 
is overwritten.

You can make the following interface configuration settings:

● IP parameters: IP address, subnet mask, router address

● PROFINET IO device name (if the CPU is operated as a PROFINET IO device)

You store the configuration data in a data block (CONF_DB parameter).

You can make the program-controlled setting of the IP configuration with the "T_CONFIG" 
instruction as an alternative to configuration in the device configuration. It only takes effect, 
however, if you explicitly specified in the hardware configuration that IP address parameters 
are assigned differently.
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Functional description
The "T_CONFIG" instruction works asynchronously, which means its execution extends over 
multiple calls. You start the transfer operation by calling "T_CONFIG" with REQ = 1. Only one 
job can be active at any time.

The block is edge-triggered, which means the block must be activated again following BUSY= 
FALSE using REQ=FALSE to enable the instance. 

The job status is indicated by the output parameters BUSY and STATUS.

The following table shows the relationship between BUSY, DONE and ERROR. Using this 
table, you can determine the current status of the instruction and when the transfer of 
configuration data is concluded.

BUSY DONE ERROR Description
TRUE irrelevant irrelevant The job is being processed.
FALSE TRUE FALSE Job successfully completed.
FALSE FALSE TRUE The job ended with an error. The cause of the error can be found in the 

STATUS parameter.
FALSE FALSE FALSE The instruction was not assigned a (new) job.

Parameters
The following table shows the parameters of the "T_CONFIG" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

REQ Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L, T, 
C or constant

Calling the instruction with REQ = 1 starts 
processing of the instruction.

INTERFAC
E

Input HW_INTERFA
CE

I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Hardware identification of the interface 
(see "Properties" in the Inspector window 
of the device configuration). The hardware 
identifier is stored in the system constants 
of the PLC tags. 

CONF_DA
TA 
(Page 
2917) 

Input VARIANT D D Pointer to a data block in which you store 
the connection data. Use the pointer to 
reference a higher-level Struct element 
containing the Header, Addr and NOS 
fields as subelements (refer to the 
description of the CONF_DATA 
parameter).

DONE Output BOOL I, Q, M, D, L I, Q, M, D, L The status parameter indicates if the job 
was executed without errors:
● 0: Processing not yet complete.
● 1: Processing of instruction finished 

successfully.
BUSY Output BOOL I, Q, M, D, L I, Q, M, D, L Status of the instruction:

● 0: Processing of the instruction has not 
started, completed or canceled yet.

● 1: Processing of instruction in progress
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

ERROR Output BOOL I, Q, M, D, L I, Q, M, D, L Error display
● 0: No error
● 1: Error

STATUS Output DWORD I, Q, M, D, L I, Q, M, D, L Status display
For meaning in connection with the 
parameters DONE and ERROR see under 
displays of the instruction.

ERR_LOC Output DWORD I, Q, M, D, L I, Q, M, D, L Error location (fieldId and id of the subfield 
in which an error has occurred at a 
parameter)

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

Parameters ERROR and STATUS

ERROR STATUS 
(DW#16#..)

ERR_LOC* Explanation

0 00000000 0 Job execution terminated without error
0 00700000 0 No job processing active
0 00700100 0 Start of job execution
0 00700200 0 Intermediate call (REQ  

irrelevant)
1 C08xyy00 0 General error information

See also: Evaluating errors with output parameter RET_VAL (Page 1584) 
1 C0808000 0 Hardware identification at parameter INTERFACE invalid.
1 C0808100 0 Hardware identification at parameter INTERFACE is not assigned to the supported 

PROFINET interface.
1 C0808700 0 Incorrect length of the data block at the CONF_DATA parameter.
1 C0808800 f, 0 Field_type has an invalid value.
1 C0808900 f, 0 The parameter fieldid has an invalid value or was used several times.
1 C0808A00 f, 0 Incorrect number for subfield_cnt parameter or incorrect length at Length 

parameter.
1 C0808B00 f, s The parameter Id of a subfield contains an invalid value.
1 C0808C00 f, s Error when placing subfield (incorrect subfield, incorrect sequence or multiple use 

of subfield).
1 C0808D00 f, s The parameter Lenght of a subfield contains an incorrect or invalid value.
1 C0808E00 f, s The parameter Mode of a subfield contains an incorrect or invalid value.
1 C0809000 f, s The parameters of the subfield are write-protected. E.g. parameters are specified 

via configuration or PNIO mode is enabled.
1 C0809100 f, s Reserved
1 C0809400 f, s The parameter value in the subfield is not defined or invalid.
1 C0809500 f, s The value of a subfield parameter is inconsistent with another parameter value.
1 C080C200 0 Transfer cannot be carried out (e.g. because the interface is not reachable).

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2916 System Manual, 07/2013,  



ERROR STATUS 
(DW#16#..)

ERR_LOC* Explanation

1 C080C300 0 Insufficient resources (for example, multiple calling of "T_CONFIG" with different 
parameters)

1 C080C400 0 Temporary communication error
1 C080D200 0 Call not possible / not supported by the PROFINET interface
* In the table above, f is the field_id and s the id of the subfield in which the error occurred.

Parameter CONF_DATA

Structure of the DBs of the configuration data
The CONF_DATA parameter of the "T_CONFIG" instruction points to a global data block (DB), 
in which you store the configuration data.

The DB consists of a IF_CONF_Header structure and the IF_CONF_V4 and / or 
IF_CONF_NOS structures:

● The structure IF_CONF_Header has to be at the start of the DB. Use the structure to 
determine the number of subfields you want to use.

● The structures IF_CONF_V4 and IF_CONF_NOS are the subfields used in the DB which 
contain the actual configuration data. The respective parameters of the two subfields 
correspond largely to the structure in the device properties.

● All three structures must be defined below a higher-level structure (in the following example 
the Struct Element "Conf_Data"). The following figure shows the data block structure.
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Interconnection of the data block in the CONF_DATA parameter
In the CONF_DATA parameter, call the higher-level Struct element of the data block (in the 
example above the Struct element "Conf_Data"; the call in the parameter is achieved by 
specifying the data block followed by the name of the Struct element: 
"Name_of_DB".Conf_data).

Field IF_CONF_Header
Use the field IF_CONF_Header to select how many subfields you want to use during execution 
of "T_CONFIG".

Byte Parameter Data type Start value Description
0 ... 1 FieldType UINT  Field type: Must always be 0.
2 ... 3 FieldId UINT  Error ID: Must always be 0.
4 ... 5 SubfieldCount UINT  Total number of subfields in the structure

General parameters of the subfields
The subfields "Addr" and "Nos" contain the following general parameters:

● Id
This parameter identifies the respective field and may not be altered.

● Length
This parameter specifies the actual length of the subfield. If a field contains a parameter of 
the data type String or Array, it may be that the maximum length of the parameter is not 
exhausted. In this case the actual length of the subfield is less than the maximum length.

● Mode
The following values are permitted for this parameter:

– 1: Permanent validity of the configuration data

– 2: Temporary validity of the configuration data including the deletion of existing 
permanent configuration data

Subfield IF_CONF_V4
Use the subfield IF_CONF_V4 to specify the Ethernet addresses that you want to assign to 
the interface of the CPU.

Byte Parameter Data type Start value Description
0 ... 1 Id UINT 30 Subfield identifier
2 ... 3 Length UINT 18 Length of the subfield in bytes
4 ... 5 Mode UINT  Validity of addressing:

● 1: permanent
● 2: temporary

6 ... 9 InterfaceAddress IP_V4 *  IP address
10 ... 12 SubnetMask IP_V4 *  Subnet mask
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Byte Parameter Data type Start value Description
14 ... 16 DefaultRouter IP_V4 *  Router address
* The data type IP_V4 is a structure of 4 BYTE, which includes the respective address of the respective parameter (e.g. at 
parameter SubnetMask the four-digit address of the subnet mask of the IP protocol).

Subfield IF_CONF_NOS
Use the subfield IF_CONF_NOS to specify the station name to be assigned during execution 
of the instruction "T_CONFIG".

Byte Parameter Data type Start value Description
0 ... 1 Id UINT 40 Subfield identifier
2 ... 3 Length UINT 246 Length of the subfield in bytes
4 ... 5 Mode UINT  Validity of the station name change:

● 1: permanent
● 2: temporary

6 ... 244 NoS ARRAY 
[1...240] of 
Byte

 Station name: You must occupy the ARRAY from 
the first byte. If the ARRAY is longer than the station 
name to be assigned, you must enter a zero byte 
after the actual station name (in conformity with IEC 
61185-6-10). Otherwise, NoS is rejected and the 
"T_CONFIG" instruction enters the error code 
DW#16#C0809400 in STATUS. If you occupy the 
first byte with zero, the station name is deleted.

 

The station name is subject to the following limitations:

● The name must be specified in ASCII code.

● Restricted to a total of 240 characters (lower case letters, numbers, dash, or dot)

● No name component within the station name, which means a character string between two 
dots may not exceed 63 characters.

● No special characters such as umlauts, brackets, underscore, slash, blank space, etc. The 
only special character permitted is the dash.

● The station name must not begin or end with the "-" character.

● The station name must not begin with a number.

● The station name form n.n.n.n (n = 0, ... 999) is not permitted.

● The station name must not begin with the string "port-xyz" or "port-xyz-abcde" (a, b, c, d, 
e, x, y, z = 0, ... 9).

 

  Note

You can also create an ARRAY NoS that is shorter than 240 bytes, but not less than 2 
bytes. In this case, you must adjust the "Length" (length of subfield) tag accordingly.
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9.7.5.4 Web server

WWW: Synchronizing user-defined web pages

Description   
The instruction WWW initializes the web server of the CPU or synchronizes user-defined web 
pages with the user program in the CPU. 

User-defined web pages together with the web server make it possible for the CPU to access 
freely designed web pages of the CPU with a web browser. 

Use script instructions (such as Javascript) and HTML code in user-defined web pages to 
transfer data via a web browser for further processing to the CPU and to display data from the 
operand area of the CPU in the web browser. Call the WWW instruction in the user program 
for synchronization of the user program and the web server as well as initialization. 

Initialization
User-defined web pages are "packaged" in data blocks for processing by the CPU. You will 
have to generate appropriate data blocks from the source files (HTML files, screens, Javascript 
files, ...) during configuration. The Web Control DB has a special role (default: DB 333). It 
contains status and control information as well as links to additional data blocks with coded 
web pages. The data blocks with coded web pages are called fragment DBs. 

When the data block is downloaded into the CPU, the CPU does not "know" that user-defined 
web pages are coded inside it. The instruction "WWW" in the startup OB, for example, will 
inform the CPU which DB is the Web Control DB. The user-defined web pages can be accessed 
via a web browser after this initialization. 

Synchronization
If you want the user program to interact with the user-defined web pages, then the instruction 
WWW must be used in the cyclical program part. 

Examples of interaction between user program and web page: 

● Check received data

● Assemble and send back data to the web browser making the request

In this case it must be possible to evaluate the current status information and the web server 
must receive control information, such as release of a web page requested by a web browser. 

 

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2920 System Manual, 07/2013,  



Parameter
The following table shows the parameters of the instruction "WWW":

Parameter Declaration Data type Description
CTRL_DB Input DB_WWW Data block that describes the user-defined web 

pages (Web Control DB)
RET_VAL Output INT Error information

 

For additional information on valid data types, refer to Overview of the valid data types 
(Page 1077).

Parameter RET_VAL

Error code

(W#16#...)

Explanation

0000 No error occurred. There are no web page requests that have to be released by the 
user program. 

00xy x: indicates whether an error has occurred during initialization of the Web Control DB 
(CTRL_DB):
x=0: No errors occurred.
x=1: Error occurred. The error is coded in the byte "CTRL_DB.last_error" of the Web 
Control DB, see description of Web Control DB.
y: Number of the pending request. Several requests are possible (e. g. requests "0" 
and "1" are pending: y="3".
y="1": Request "0"
y="2": Request "1"
y="4": Request "2"
y="8": Request "3"

803A The specified Web Control DB does not exist on the CPU.
8081 Incorrect version or incorrect format of the Web Control DB
80C1 There are no resources to initialize the web application.

See also
Overview of the valid data types (Page 1077)
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9.7.5.5 TeleService

TM_MAIL: Transfer email

Description of TM_MAIL

Description       
The "TM_MAIL" instruction works asynchronously, in other words, its execution extends over 
multiple calls. You must specify an instance when you call the instruction "TM_MAIL". The 
attribute "retentive" may not be set in the instance. This attribute ensures that the instance is 
initialized when the CPU switches from STOP to RUN and that a new e-mail send job can be 
triggered afterwards.

You start the sending of an e-mail with an edge change from "0" to "1" for the REQ parameter. 
The job status is indicated by the output parameters BUSY , "DONE", "ERROR", "STATUS" 
and "SFC_STATUS". "SFC_STATUS" corresponds in this case to the "STATUS" output 
parameter of the called communication blocks. 

The output parameters DONE, ERROR, STATUS, and SFC_STATUS are each displayed for 
only one cycle if the status of the BUSY output parameter changes from "1" to "0". The following 
table shows the relationship between BUSY, DONE, and ERROR. Using this table, you can 
determine the current status of the instruction "TM_MAILand when the sending of the e-mail 
is complete.

DONE BUSY ERROR Description
0 1 0 The job is being processed.
1 0 0 Job successfully completed.
0 0 1 The job ended with an error. The cause of the error can be found in the STATUS and 

SFC_STATUS parameters.
0 0 0 The "TM_MAIL" instruction was not assigned a (new) job.

If the CPU changes to STOP mode while "TM_MAIL" is active, the communication connection 
to the mail server aborts. The communication connection to the mail server will also be lost if 
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communication problems occur on the Industrial Ethernet bus. In this case, the transfer of the 
e-mail will be interrupted and it will not reach its recipient.

 

 NOTICE

Changing user programs

You can change the parts of your user program that directly affect calls of "TM_MAIL" only:
● when the CPU is in "STOP" mode or
● when no mail is being sent (REQ = 0 and BUSY = 0).

This relates, in particular, to deleting and replacing program blocks that contain "TM_MAIL" 
calls or calls for the instance of "TM_MAIL".

Ignoring this restriction can tie up connection resources. The automation system can change 
to an undefined status for the TPC/IP communication functions via Industrial Ethernet.

A warm or cold restart of the CPU is required after the changes are transferred.
 

Data consistency
The ADDR_MAIL_SERVER input parameter of the instruction is taken from the "TM_MAIL" 
instruction again each time the sending of an e-mail is triggered. If a change is made during 
operation, the "new" value only becomes effective once an e-mail is triggered again. 

In contrast, the WATCH_DOG_TIME, TO_S, CC, FROM, SUBJECT, TEXT, ATTACHMENT, 
and, if applicable, USERNAME and PASSWORD parameters are taken from the "TM_MAIL" 
instruction while it is running, which means that they may only be changed after the job is 
complete (BUSY = 0)

Setting the parameters of the TS Adapter IE
On the TS Adapter IE, you need to specify parameters for outgoing calls in such a way as to 
enable the TS Adapter IE to establish a connection to the dial-up server of your service 
provider. 

If you set "When required" for connection establishment, the connection will only be established 
when an e-mail needs to be sent. 

Connection establishment can take longer (approx. one minute) for an analog modem 
connection. When you specify the WATCH_DOG_TIME parameter, remember to allow for the 
time required to establish the connection.
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Parameters
The following table shows the parameters of the "TM_MAIL" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter REQUEST: Activates the sending 
of an e-mail on a rising edge.

ID Input CONN_OU
C (Word)

D, L or constant Reference to the connection to be established. See 
ID parameter of the TCON (Page 2877), TDISCON 
(Page 2884), TSEND (Page 2889), and TRCV 
(Page 2892) instructions. A number that is not used 
for any additional instances of this instruction in the 
user program must be entered here.

TO_S 
(Page 2926) 

Input STRING D Input parameter for receiver addresses:
STRING with a maximum length of 240 characters 
(see example call).

CC (Page 2926) Input STRING D Input parameter for CC recipient addresses 
(optional): STRING with a maximum length of 240 
characters (see example call).
If an empty string is assigned here, the e-mail is not 
sent to a CC recipient.

SUBJECT Input STRING D Input parameter for subject of the e-mail:
STRING with a maximum length of 240 characters.

TEXT Input STRING D Input parameter for text of the e-mail (optional):
Reference to a data string with a maximum length of 
240 characters.
If an empty string is assigned at this parameter, the 
e-mail is sent without text.

ATTACHMENT Input VARIANT I, Q, M, D, L Input parameter for e-mail attachment (optional): 
Reference to a byte/word/double word field with a 
maximum length of 65534 bytes.
If no value is assigned, the e-mail is sent without an 
attachment.

DONE Output BOOL I, Q, M, D, L ● DONE = 0: Job not yet started or still executing.
● DONE = 1: Job was executed without errors.

BUSY Output BOOL I, Q, M, D, L ● BUSY = 1: E-mail transmission is not yet complete.
● BUSY=0: The processing of "TM_MAIL" was 

stopped.
ERROR Output BOOL I, Q, M, D, L ERROR=1: An error occurred during processing. 

STATUS and SFC_STATUS supply detailed 
information about the type of error.

STATUS 
(Page 2927) 

Output WORD I, Q, M, D, L Output/status parameter STATUS:
Return value or error information of the "TM_MAIL" 
instruction.
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Parameter Declaration Data type Memory area Description
ADDR_MAIL_S
ERVER

Static* DWORD I, Q, M, D, L IP address input parameter of the mail server: Specify 
as a data word in HEX format, for example: IP address 
= 192.168.0.200.
ADDR_MAIL_SERVER = DW#16#C0A800C8, 
where:
● 192 = 16#C0,
● 168 =16#A8
● 0 = 16#00 and
● 200 = 16#C8.

WATCH_DOG_
TIME

Static* TIME I, Q, M, D, L Input parameter for max. period of time:
The "TM_MAIL" instruction should establish a 
connection within the period specified by 
WATCH_DOG_TIME. The block is exited with an 
error if this period is exceeded. The time before the 
block is exited and the error is output can exceed the 
WATCH_DOG_TIME because connection 
termination also takes a certain amount of time. To 
begin with, you should set a period of 2 minutes. If 
you have an ISDN telephone connection, a 
significantly shorter period can be selected.

USERNAME Static* STRING D Input parameter for user name:
STRING with a maximum length of 180 characters. A 
user name is an absolute requirement for 
authentication.

PASSWORD Static* STRING D Input parameter for password:
STRING with a maximum length of 180 characters. A 
password is an absolute requirement for 
authentication.

FROM 
(Page 2926) 

Static* STRING D Input parameter for sender address:
STRING with a maximum length of 240 characters 
(see example call).

SFC_STATUS 
(Page 2927) 

Static* WORD I, Q, M, D, L Output/status parameter "SFC_STATUS":
Error information of the called communication blocks.

*The values of the parameter are not modified at every call of the instruction "TM_MAIL". The values are in the static 
parameters of the instance and are only written once at the first call of the instruction.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1077)".

 

 Note
Optional parameters

The optional parameters CC, TEXT, and ATTACHMENT are only sent with the e-mail if the 
corresponding parameters contain a string of length > 0.

 

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  2925



SMTP authentication 
Authentication refers here to a procedure for ensuring an identity, for example, by a password 
query. 

The "TM_MAIL" instruction supports the SMTP authentication procedure AUTH-LOGIN that 
is requested by most mail servers. For information about the authentication procedure of your 
mail server, please refer to your mail server manual or the website of your Internet service 
provider. 

To use the AUTH-LOGIN authentication procedure, the "TM_MAIL" instruction requires the 
user name with which it can log onto the mail server. This user name corresponds to the user 
name with which you set up a mail account on your mail server. It is made available to the 
"TM_MAIL" instruction in the USERNAME parameter. 

To log on, the "TM_MAIL" instruction also requires the associated password. This password 
corresponds to the password you specified when you set up your mail account. It is made 
available to the "TM_MAIL" instruction in the PASSWORD parameter. 

The user name and the password are each transferred to the mail server unencrypted 
(BASE64-coded).

If no user name is specified in the DB, the AUTH-LOGIN authentication procedure is not used. 
The e-mail is then sent without authentication.

Parameters TO_S, CC, and FROM

Description
The TO_S, CC, and FROM parameters are strings with, for example, the following content:

● TO: <wenna@mydomain.com>, <ruby@mydomain.com>,

● CC: <admin@mydomain.com>, <judy@mydomain.com>,

● FROM: <admin@mydomain.com>

Note the following rules when entering the parameters:

● The "TO:", "CC:", and "FROM:" characters must be entered.

● A space and an opening pointed bracket "<" must be entered before each address.

● A closing pointed bracket ">" must be entered after each address.

● A comma must be entered after each address in TO and CC.

● Only one e-mail may be entered in FROM, and there must not be a comma at the end of 
this address

Because of runtime and memory space, the "TM_MAIL" instruction does not perform any 
syntax check of the parameters TO_S, CC and FROM.
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STATUS and SFB_STATUS parameters

Description
The return values of the "TM_MAIL" instruction can be classified as follows:

● W#16#0000: "TM_MAIL" was completed successfully

● W#16#7xxx: Status of "TM_MAIL"

● W#16#8xxx: An error was reported during the internal call of a communication block or from 
the mail server.

The following table shows the return values of "TM_MAIL" except for error codes of the 
internally called communication blocks.

Return value
STATUS*
(W#16#...):

Return value
SFB_STATUS
(W#16#...):

Explanation Notes

0000 - The processing of "TM_MAIL" was 
completed without error.

A without error completion of 
"TM_MAIL" does not mean that the 
sent e-mail will necessarily arrive (see 
below - note on point 1)

7001  "TM_MAIL" is active (BUSY = 1). Initial call; job has started
7002 7002 "TM_MAIL" is active (BUSY = 1). Intermediate call; job already active
8xxx xxxx The processing of "TM_MAIL" was 

completed with an error code of the internally 
called communication instructions.

For detailed information on the 
evaluation of the SFB_STATUS 
parameter, refer to the descriptions of 
the STATUS parameter of the 
communication instructions.

8010 xxxx Error during connection establishment. For further information on the 
evaluation of the SFB_STATUS 
parameter, refer to the descriptions of 
the STATUS parameter of the "TCON 
(Page 2877)" instruction.

8011 xxxx Error sending the data. For further information on the 
evaluation of SFB_STATUS, refer to 
the descriptions of the STATUS 
parameter of the "TSEND (Page 2889)" 
instruction.

8012 xxxx Error receiving the data. For further information on the 
evaluation of SFB_STATUS, refer to 
the descriptions of the STATUS 
parameter of the "TRCV (Page 2892)" 
instruction.

8013 xxxx Error during connection establishment. For further information on the 
evaluation of SFB_STATUS, refer to 
the descriptions of the STATUS 
parameter of the "TCON (Page 2877)" 
and "TDISCON (Page 2884)" 
instructions.
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Return value
STATUS*
(W#16#...):

Return value
SFB_STATUS
(W#16#...):

Explanation Notes

8014 - Establishment of a connection is not possible. You have possibly entered an incorrect 
mail server IP address 
(ADDR_MAIL_SERVER) or a time 
span that is too short 
(WATCH_DOG_TIME) to establish the 
connection. It is also possible that the 
CPU has no connection to the network 
or that the CPU configuration is 
incorrect.

8016 - Error copying the attachment -
82xx, 84xx, or 
85xx

- The error message originates from the mail 
server and corresponds, except for the "8", to 
the error number of the SMTP protocol.
The following columns list several error 
codes that can occur:

See point 2 in the note.

8450 - Action not executed: Mailbox not available/
not reachable.

Try again later.

8451 - Action aborted: Local processing error Try again later.
8500 - Syntax error: Error not recognized. This also 

includes the error when a command string is 
too long. This can also be occur when the e-
mail server does not support the LOGIN 
authentication procedure.

Check the parameters of "TM_MAIL". 
Try to send an e-mail without 
authentication. To do this, replace the 
USERNAME parameter with an empty 
string.

8501 - Syntax error: Parameter or argument 
incorrect

You have possibly entered an incorrect 
address in TO_S or CC.

8502 - Command unknown or not implemented. Check your entries, in particular the 
FROM parameter. This is possibly 
incomplete and you have forgotten "@" 
or ".".

8535 - SMTP authentication incomplete. You have possibly entered an incorrect 
user name or incorrect password.

8550 - Mail server cannot be reached, you have no 
access rights.

You have possibly entered an incorrect 
user name or password, or the mail 
server does not support your LOGIN. 
Another cause of error could be an 
incorrect entry of the domain name 
after the "@" in TO_S or CC.

8552 - Action aborted: Assigned memory size has 
been exceeded

Try again later.

8554 - Transmission failed. Try again later.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Programming the PLC
9.7 References

WinCC Comfort/Advanced V12.0 SP1
2928 System Manual, 07/2013,  



 

 Note
Status error
1. An incorrect entry of the recipient addresses does not generate a status error of the 

"TM_MAIL" instruction. In this case, there is no guarantee that the e-mail will be sent to 
other recipients, even if these were entered correctly.

2. You can find more detailed information on the SMTP error code and other error codes in 
SMTP protocol on the Internet or in the error documentation of the mail server. You can 
also view the most recent message from the mail server in your instance DB in the 
BUFFER1 parameter. If you look under "Data", you will find the data most recently sent 
by the "TM_MAIL" instruction.
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Visualizing processes (Comfort/Advanced) 10
10.1 Creating screens

10.1.1 Basics

10.1.1.1 Screen basics

Introduction
In WinCC you create screens that an operator can use to control and monitor machines and 
plants. When you create your screens, the object templates included support you in visualizing 
processes, creating images of your plant, and defining process values.

Application example
The figure shows a screen that was created in WinCC. With the help of this screen, the operator 
can operate and monitor the mixing station of a fruit juice manufacturing system. Fruit juice 
base is supplied from various tanks to a mixing unit. The screen indicates the fill level of the 
tanks. 

Screen design
Insert an object you need to represent a process into your screen. Configure the object to 
correspond to the requirements of your process.

A screen may consist of static and dynamic elements. 
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● Static elements such as text or graphic objects do not change their status in runtime. The 
tank labels (W, K, Z, A) shown in this example of a mixing unit are static elements.

● Dynamic elements change their status based on the process. Visual current process values 
as follows:

– From the memory of the PLC

– From the memory of the HMI device in the form of alphanumeric displays, trends and 
bars.

Input fields on the HMI device are also considered dynamic objects. The fill level values of 
the tanks in our example of a mixing plant are dynamic objects.

Process values and operator inputs are exchanged between the controller and the HMI device 
via tags.

Screen properties
The screen layout is determined by the features of the HMI device you are configuring. It 
corresponds with the layout of the user interface of this device. If the set HMI device has 
function keys, the screen shows these function keys. Other properties such as the screen 
resolution, fonts and colors are also determined by the characteristics of the selected HMI.

Function keys
A function key is a key on the HMI device to which you can assign one or several functions in 
WinCC. The functions are triggered as soon as the operator presses the key on the HMI device. 

A function key can be assigned global or local functions: 

Global function keys always trigger the same action, regardless of the currently displayed 
screen.

Local function keys trigger different actions depending on the currently displayed screen on 
the HMI device. This assignment applies only to the screen in which you have defined the 
function key.
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Navigation
You configure a screen navigation to enable the operator to call a screen on the HMI device 
in Runtime. 

● The "Screen" editor is used to configure buttons for calling other screens.

● You use the "Global Screen" editor to configure globally assigned function keys.

See also
Overview of objects (Page 2950)

Basics on dynamizing screens (Page 3007)

Basics on working with layers (Page 3042)

Basics on libraries (Page 5488)

Basics on faceplates (Page 3049)

Bar (Page 3086)

Basics on screen navigation (Page 3162)

Basics on text lists (Page 2991)

Basic principles of graphics lists (Page 2999)

10.1.1.2 Device-specific functional scope of screens

Introduction
The functions of an HMI device determine the display of the device in WinCC and the scope 
of functions of the editors.

The following screen properties are determined by the functions of the selected HMI device:

● Device layout

● Screen resolution

● Number of colors

● Fonts

● Objects available

Device layout
The device layout of a screen forms the image of the HMI device in your configuration. The 
device layout of the screen shows all the function keys available on the HMI device, for 
example.   
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Screen resolution
The screen resolution is determined by the different display dimensions of the various operator 
panels. You can only change the screen resolution if you configure the 
"WinCC Runtime Advanced" or "WinCC Runtime Professional" HMI device. 

Number of colors
You can assign colors to the screen objects. The number of possible colors is determined by 
the color depth and specific colors supported on the selected HMI device. 

Fonts
You can customize the appearance of the texts in all the screen objects that contain static or 
dynamic text. How to highlight individual texts in a screen. Select the font, font style and size, 
and set additional effects such as underscoring, for example.  

The settings for the text markups such as font style and effects always refer to the entire text 
of a screen object. That is, you can display the complete title in bold format, but not its individual 
characters or words, for example. 

Objects available
Some of the screen objects can not be configured globally for all HMI devices. These screen 
objects are not displayed in the "Tools" task card. For a KTP 1000 touch panel unit you can 
not configure a slider, for example. 
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10.1.1.3 Elements and basic settings

Task cards

Introduction
The following task cards are available in the "Screens" editor:   

● Tools: Display and operating objects

● Animations: Templates for dynamic configuration

● Layout: Aid for customizing the display

● Libraries: Administration of the project library and of the global libraries
 

  Note
WinCC Basic

The "Animations" task card is not available in WinCC Basic.
 

Tools
The "Tools" task card contains objects in different panes:

● Basic objects

● Elements

● Controls

● User controls (optional)

● Graphics

You paste objects from the palettes into your screens by drag&drop or a double click. The 
objects available for selection are determined by the features of the HMI device you are 
configuring. The following icons are used to change the display mode:

Icon Meaning
Displays the objects as a list.

Displays the objects as a graphic.

Animations
The "Animations" task card contains the possible dynamizations of a screen object in the 
palettes. You paste the animations to a screen object by drag&drop or a double click from the 
"Movements", "Display" and "Tag Binding" palettes.

Layout
The "Layout" task card contains the following panes for displaying objects and elements:
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● Layers: Serves to manage screen object layers The layers are displayed in a tree view and 
contain information about the active layer and the visibility of all layers.

● Grid: You specify whether you want to align the objects to a grid or to other objects and set 
the grid size for a grid. 

● Objects out of range: Objects that lie outside the visible area are displayed with name, 
position and type.

Libraries
The "Libraries" task card show the following libraries in separate panes:

● Project library: The project library is stored together with the project.

● Global library: The global library is stored in a separate file in the specified path on your 
configuration PC.

Move view

Introduction
To display only a section of the entire screen in the work area, use the  icon of the "Screens" 
editor:

Requirement
● A screen is open.

● The view shows only a screen section.

Procedure
To move the view:

1. Click the  icon at the bottom right corner of the work area and press the left mouse button.
A miniature view of the full screen is shown. An orange frame shows the currently selected 
area.

2. Hold down the mouse button and drag the frame to the desired area.
 

  Note

The screen is scrolled when you drag a screen object from the visible to a currently hidden 
section. 
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Zooming the view

Introduction
To view a small screen section in closer detail, use the zoom tool to magnify the screen in the 
working area. The maximum zoom amounts to 800%.     

You can zoom with the toolbar in the work area or with the "Layout > Zoom" task card.

There are different ways to increase the screen, for example, with the zoom factor or by 
adapting the work area to the height of the screen.

Requirement
The screen is opened.

Procedure
Proceed as follows to zoom a view with the selection frame:

1. Click the  toolbar button.

2. Use the mouse to draw a selection frame in the screen.

After you have released the mouse button, the section enclosed by the selection frame is 
zoomed to fit the complete work area. 

Alternatively, use the slider in the lower right-hand corner of the screen.

Result
The selected screen section is magnified. 

10.1.1.4 Working with screens

Steps

Steps
To create screens, you need to take the following initial steps:   

● Plan the structure of the process visualization: Number of screens and their layout
Example: Subprocesses are visualized in separate screens, and merged in a master screen.

● Define your screen navigation control strategies.
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● Adapt the templates and the global screen.
You define objects centrally and assign function keys for example. 

● Create the screens. Use the following options of efficient screen creation:

– Working with libraries

– Working with layers

– Working with faceplates

Creating a new screen

Introduction
Create screens to display processes in your system.   

Requirement
● The project has been created.

● The Inspector window is open.

Procedure
1. Double-click "Screens > Add New Screen" in the project navigation.

The screen is generated in the project and appears in your view. The screen properties are 
shown in the Inspector window.

2. Enter a meaningful name for the screen.

3. Configure the screen properties in the Inspector window:

– Specify whether and on which template the screen is based.

– Set the "Background Color" and the "Screen Number."

– Specify a documenting text under "Tooltip".

– Specify the layers to be displayed under "Layers" in the engineering system.

– Select dynamic screen update under "Animations."

– Select "Events" to define which functions you want to execute in Runtime when you call 
and exit the screen or at other events.

 

  Note

Not all HMI devices support the "Visibility" animation.
 

Result
You created the screen in your project. You can now paste objects and control elements from 
the "Tools" task card and assign function keys in further work steps.
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Managing Screens

Introduction
You can move screens within a project to other groups, or copy, rename, and delete them.          

Moving screens in a group
1. Select the "Screens" folder in the project tree.

2. Select the "Add group" command from the shortcut menu.
A folder called "Group_x" is inserted.

3. Select the screen in the project tree.

4. Drag-and-drop the screen to the required group.
The screen is moved into this group.

Copy screen
1. Select the screen in the project tree.

2. Select the "Copy" command in the shortcut menu to copy the screen to the clipboard.

3. In the project tree, select the screen insert position.

4. Select "Paste" from the shortcut menu to insert the screen.
A copy of the screen is inserted. A consecutive number is appended to the name of the 
original in the copy. 

Alternatively, press <Ctrl> while you drag the screen to the required position.
 

 Note

If you copy a screen with interconnected template for several devices and projects, the 
template will also be copied. Any existing matching template is not used. This holds 
particularly true when you copy the screens with drag-and-drop.

 

Rename screen
1. Select the screen in the project tree.

2. Select "Rename" from the shortcut menu.

3. Type in a new name.

4. Press <Enter>.

As an option, use the <F2> function key to rename the screen.
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Delete screen
1. Select the screen in the project tree.

2. Select "Delete" from the shortcut menu.
The screen and all its objects are deleted from the current project. 

Defining the start screen of the project

Introduction
The start screen is the initial screen opened at the start of project in Runtime. You can define 
a different start screen for each one of the HMI devices. Beginning at this start screen, the 
operator calls the other screens.     

Requirement
The project contains the screen you want to use as the start screen.

Procedure
1. Double-click "Runtime settings > General" in the project tree.

2. Select the desired screen as "Start screen".

Alternatively select a screen in the project tree and select "Use as start screen" in the shortcut 
menu.

Result
The start screen opens on the HMI at the start of Runtime. 
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10.1.1.5 Working with templates

Basics on working with templates

Introduction
Configure the objects in a template which are to be displayed in all screens based on this 
template.

Note the following rules:

● A screen must not be based on a template.

● A screen is only based on one template.

● You can create several templates for one device.

● A template cannot be based on another template.

Objects for a template
You determine functions and objects in the template which are to apply for all screens based 
on this template:

● Assignment of function keys: You also assign the function keys in the template for HMI 
devices with function keys. This assignment overwrites a possible global assignment.

● Permanent window: Some devices support a permanent window for all screens in the top 
area of the screen. In contrast to the template, the permanent window occupies an area of 
the screen for itself alone.

● Operator controls: You can paste all screen objects which you also use for a screen into a 
template.

Application examples
● You want to assign the ActivateScreen" function to a function key in the template. The 

operator uses this key to switch to another screen in runtime. This configuration applies to 
all screens that are based on this template.

● A graphic with your company logo can be added to the template. The logo appears on all 
screens that are based on this template.

 

  Note

If an object from the template has the same position as an object in the screen, the 
template object is covered.
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See also
Screen basics (Page 2931)

Using a template in the screen (Page 2946)

Configuring a permanent window in the template (Page 2945)

Global screen

Introduction
You define global elements for all screens of an HMI device independently of the used 
template.  

Function keys  
For HMI devices with function keys you assign the function keys globally in the "Global Screen" 
editor. This global assignment applies for all screens of the HMI device.

Proceed as follows to assign function keys locally in screens or templates:

1. Click the function key in your screens or templates.

2. Deactivate "Properties > Properties > General > Use Global Assignment" in the inspection 
window.   

Indicator and control objects for alarms 
The "Alarm window" and "Alarm indicator" objects that are available as global objects are 
configured within the "Global screen" editor.

The "Alarm window" and "Alarm indicator" are always shown in the foreground.

For Comfort Panels you also have the possibility of configuring a "System diagnostic view" in 
the global screen.

 

 Note

If you have configured a permanent window in a template, do not position the alarm window 
and alarm indicator in the area of the permanent window. Otherwise, the alarm window and 
the alarm indicator will not be displayed in Runtime. 

The permanent window is not visible in the "Global screen" editor. 
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Order of configuration of screens  
The following order applies for the configuration:

● The global screen comes before screens and templates

● Screens come before templates

The system layer is not configurable. This contains

● input dialog boxes

● alarms from the operating system

● the direct keys for touch panels

Managing templates

Introduction
You can move, copy, rename, and delete templates within a project in the Project window.          

Moving a template into a group
1. Select the templates in the project navigation "Screen management > Templates".

2. Select "Add group" in the shortcut menu.
A folder called "Group_x" is inserted.

3. Select the template in the project navigation.

4. Drag-and-drop the template to the required group.
The template is moved to this group.
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Copying templates
1. Select the template in the project navigation.

2. Select "Copy" in the shortcut menu.

3. Select the position in the project navigation where you want to paste the template.

4. Select "Paste" from the shortcut menu to insert the template.
A unique name is assigned automatically to the copy. 

Alternatively, you can hold down the <Ctrl> key, and drag the template into position.

Deleting a template
1. In the project navigation, select the template to be deleted.

2. Select "Delete" in the shortcut menu.
The template, and all its objects are deleted from the current project. 

Assigning a template to a screen
1. In the project navigation, select the screen to which you want to assign the template.

2. In the Inspector window, select "Properties > Properties > General".

3. Select the desired template under "Template."
The selected template and all the objects contained in it are assigned to the screen. 

Creating a new template

Introduction
In a template, you can centrally modify objects and function keys. Changes to an object or of 
a function key assignment in the template are applied to the object in all the screens which 
are based on this template.   

 

 Note
HMI device dependency

Function keys are not available on all HMI devices.
 

Requirement
● The project has been created.

● The Inspector window is open.
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Procedure
1. Select "Screen management > Templates" in the project tree and then double-click "Add 

new template".
The template is created in the project, and appears in your view. 
The properties of the template are displayed in the Inspector window.

2. Define the name of the template under "Properties > Properties > General" in the Inspector 
window.

3. Specify the layers in the engineering system that are displayed under "Properties 
>Properties >Layers" in the Inspector window.

4. Add the necessary objects from the "Tools" task card.

5. Configure the function keys.

Result
The template is created in your project. 

Configuring a permanent window in the template

Introduction
In the permanent window you configure objects which are visible in all screens. In contrast to 
the template, the permanent window occupies an area of the screen for itself alone.

Configuring permanent windows
Proceed as follows to configure a permanent window:  

1. Open a template for a HMI device with a permanent window.

2. Use the mouse (cursor shape: ) to drag the top edge of the editable screen area down.

3. Configure the desired objects in the area of the permanent window.

The default height of the permanent window is "0". The maximum height is the maximum height 
of the screen minus 10 pixels.
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Result
The content of the permanent window appears on every screen, and in the template. The area 
above this line is now used as a permanent window in all the screens of the HMI device. Already 
configured objects in the screens are moved down by the height of the permanent window.

See also
Basics on working with templates (Page 2941)

Using a template in the screen

Introduction
You use a template in the screen. All the objects configured in the template are also available 
in the screen.

Requirement
A template has been created.

A screen has been created.

Procedure
Proceed as follows to use a template in a screen:   

1. Double click a screen in the project tree. The screen opens in the work area.

2. Open "Properties > Properties > General" in the inspector window.

3. Select a template that is to be applied to the screen under "Template".

Show template in screen
When you edit a screen, you can show an existing template in the screen. 

Proceed as follows to show a template in the screen:

1. Activate "Extras > Settings > Visualization > Show template in screens" in the menu.

Result
The screen is based on the selected template. All objects which you have configured in the 
template are available in the screen. The template is displayed in the screen. 

See also
Basics on working with templates (Page 2941)
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10.1.2 Working with objects

10.1.2.1 Overview of objects

Introduction
Objects are graphics elements which you use to design the screens of your project.     

The "Tools" task card contains all objects that can be used for the HMI device. Display the 
Task Card with menu command "View" by activating the "Task Card" option. 

The toolbox contains various palettes, depending on the currently active editor. If the "Screens" 
editor is open, the toolbox contains the following palettes:

● "Basic objects"
The basic objects include basic graphic objects such as "Line", "Circle", "Text field" or 
"Graphic view". 

● "Elements"
The elements include basic control elements, e.g. "I/O field", "Button" or "Gauge".

● "Controls"
The controls provide advanced functions. They also represent process operations 
dynamically, for example Trend view and Recipe view.
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● "Graphics"
Graphics are broken down into subjects in the form of a directory tree structure. The various 
folders contain the following graphic illustrations:

– Machine and plant areas

– Measuring equipment

– Control elements

– Flags

– Buildings

You can create links to your own graphic folders. The external graphics are located in these 
folders and subfolders. They are displayed in the toolbox and incorporated into the project 
using links. 

● "Libraries" task card
In addition to the display and operating elements, the library objects are available. They 
are located within the palettes of the "Libraries" task card. A library contains preconfigured 
objects such as graphics of pipes, pumps, or preconfigured buttons. You can also integrate 
multiple instances of library objects into your project without having to reconfigure them.
The WinCC software package includes libraries, e.g. "HMI Buttons & Switches".
You can also store customized objects, and faceplates in user libraries.
Faceplates are objects that you create from existing screen objects, and for which you 
define the configurable properties. 

 

  Note
HMI device dependency

Some of the toolbox objects are either available with restricted functionality, or not at all. 
This depends on the HMI device you are configuring. Unavailable properties of an object 
are displayed as deactivated, and cannot be selected. 

 

Basic objects

Icon Object Instructions
"Line" -

"Ellipsis" -

"Circle" -

"Rectangle" -

"Text field" One or more lines of text. The font and layout are adjustable.

"Graphic view" Displays graphics from external graphic programs, and inserts OLE 
objects. The following graphic formats can be used: "*.emf", "*.wmf", 
"*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".
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Elements

Icon Object Instructions
"I/O field" Outputs the values of a tag, and/or writes values to a tag.

You can define limits for the tag values shown in the I/O field. To 
hide the operator input in runtime, configure "Hidden input".

"Button" Executes a list of functions, or a script as configured.

"Symbolic I/O field" Outputs the values of a tag, and/or writes values to a tag. A text from 
a text list is displayed in relation to the tag value.

"Graphic I/O field" Outputs the values of a tag, and/or writes values to a tag. A graphic 
from a graphics list is displayed in relation to the tag value.

"Date/time field" Outputs the system date and time, or the time and date from a tag. 
This allows the operator to enter new values. The display format is 
adjustable.

"Bar" The bar represents a value from the PLC in the form of a scaled bar 
graph.

"Switch" Toggles between two defined states. You can label a switch with 
text, or a graphic.

Controls

Icon Object Description
"Alarm view" Shows currently pending alarms or alarm events from 

the alarm buffer or alarm log.
"Trend view" Represents multiple curves with values from the PLC, 

or from a log.
"User view" Allows an administrator to administer users on the HMI 

device.
It also allows an operator without administrator rights 
to change his password.

"Recipe view" Displays data records, and allows them to be edited.
 

"System diagnostics 
view"

Provides an overview of all devices capable of 
diagnostics.
Displays errors in the plant.

See also
Overview of objects (Page 2950)

Designing an object (Page 2966)
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10.1.2.2 Overview of objects

Introduction
Objects are graphics elements which you use to design the screens of your project.     

The "Tools" task card contains all objects that can be used for the HMI device. Display the 
Task Card with menu command "View" by activating the "Task Card" option. 

The toolbox contains various palettes, depending on the currently active editor. If the "Screens" 
editor is open, the toolbox contains the following palettes:

● "Basic objects"
The basic objects include basic graphic objects such as "Line", "Circle", "Text field" or 
"Graphic view". 

● "Elements"
The elements include basic control elements, e.g. "I/O field", "Button" or "Gauge".

● "Controls"
The controls provide advanced functions. They also represent process operations 
dynamically, for example Trend view and Recipe view.

● "Graphics"
Graphics are broken down into subjects in the form of a directory tree structure. The various 
folders contain the following graphic illustrations:

– Machine and plant areas

– Measuring equipment

– Control elements

– Flags

– Buildings

You can create links to your own graphic folders. The external graphics are located in these 
folders and subfolders. They are displayed in the toolbox and incorporated into the project 
using links. 

● "Libraries" task card
In addition to the display and operating elements, the library objects are available. They 
are located within the palettes of the "Libraries" task card. A library contains preconfigured 
objects such as graphics of pipes, pumps, or preconfigured buttons. You can also integrate 
multiple instances of library objects into your project without having to reconfigure them.
The WinCC software package includes libraries, e.g. "HMI Buttons & Switches".
You can also store customized objects, and faceplates in user libraries.
Faceplates are objects that you create from existing screen objects, and for which you 
define the configurable properties. 

 

  Note
HMI device dependency

Some of the toolbox objects are either available with restricted functionality, or not at all. 
This depends on the HMI device you are configuring. Unavailable properties of an object 
are displayed as deactivated, and cannot be selected. 
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Basic objects

Icon Object Instructions
"Line" -

"Polyline" The polyline is an open object. Even if the start and end points have 
the same coordinates, the area they enclose cannot be filled in. If you 
want to fill a polygon, select the "Polygon" object.

"Polygon" - 

"Ellipsis" -

"Circle" -

"Rectangle" -

"Text field" One or more lines of text. The font and layout are adjustable.

"Graphic view" Displays graphics from external graphic programs, and inserts OLE 
objects. The following graphic formats can be used: "*.emf", "*.wmf", 
"*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".

Elements

Icon Object Instructions
"I/O field" Outputs the values of a tag, and/or writes values to a tag.

You can define limits for the tag values shown in the I/O field. 
To hide the operator input in runtime, configure "Hidden 
input".

"Button" Executes a list of functions, or a script as configured.

"Symbolic I/O field" Outputs the values of a tag, and/or writes values to a tag. A 
text from a text list is displayed in relation to the tag value.

"Graphic I/O field" Outputs the values of a tag, and/or writes values to a tag. A 
graphic from a graphics list is displayed in relation to the tag 
value.

"Date/time field" Outputs the system date and time, or the time and date from 
a tag. This allows the operator to enter new values. The 
display format is adjustable.

"Bar" The bar represents a value from the PLC in the form of a 
scaled bar graph.

"Charge condition" Shows the charge condition of the battery for Mobile Wireless 

"Switch" Toggles between two defined states. You can label a switch 
with text, or a graphic.

"Slider" Displays a current value from the PLC, or sends a numeric 
value to the PLC.

"Symbol library" Used to add screen objects based on controls of the same 
name. 

"Effective range name" Shows the name of the effective range.
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Icon Object Instructions
"Effective range 
name (RFID)"

Displays the name of the effective range (RFID).

"Effective range signal" Indicates how accurately the Mobile Panel Wireless is 
positioned within an effective range. 

"WLAN reception" Indicates how good the WLAN radio connection is.

"Gauge" Displays numeric values.
The appearance of the gauge is adjustable.

"Zone name" Displays the name of the zone.

"Zone signal" Indicates how accurately the Mobile Panel Wireless is 
positioned within a zone.

"Clock" Displays the system time in analog or digital format.

Controls

Icon Object Description
"Alarm view" Shows currently pending alarms or alarm events from 

the alarm buffer or alarm log.
"Trend view" Represents multiple curves with values from the PLC, 

or from a log.
"User view" Allows an administrator to administer users on the HMI 

device.
It also allows an operator without administrator rights 
to change his password.

"HTML browser" Displays HTML pages.

"Status/Force" This function gives the operator direct read / write 
access from the HMI device to individual address 
areas in the connected SIMATIC S7.

"Sm@rtClient view" Allows an operator to monitor and maintain a 
connected device remotely.

"Recipe view" Displays data records, and allows them to be edited.

"f(x) trend view" Represents the values of a tag as a function of another 
tag.

"System diagnostics 
view"

Provides an overview of all diagnostics capable 
devices.
Displays errors in the plant.

"Media Player"  Media files are shown in the media player.
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See also
Screen basics (Page 2931)

Example: Configuring a rectangle (Page 2988)

Storing an external image in the graphics library. (Page 2977)

Managing external graphics (Page 2975)

External graphics  (Page 2974)

Repositioning and resizing multiple objects (Page 2971)

Selecting multiple objects  (Page 2969)

Inserting multiple objects of the same type (stamping tool) (Page 2967)

Flashing (Page 2966)

Flipping objects (Page 2965)

Rotating objects (Page 2963)

Show objects outside the screen area (Page 2963)

Moving an object forward or backward (Page 2962)

Aligning objects (Page 2960)

Resizing an object (Page 2958)

Positioning an object (Page 2957)

Deleting an Object (Page 2956)

Inserting an object (Page 2954)

Overview of objects (Page 2947)

10.1.2.3 Options for Editing Objects

Introduction
Objects are graphics elements which you use to design the screens of your project. 

You have the following options for editing objects:

● Copying, pasting or deleting objects using the shortcut menu If you copy an object in a 
screen and the screen already includes an object of the same name, the name of the object 
is changed.

● Maintaining the standard size of the objects you are inserting or customizing their size on 
insertion.    

● Moving an object in front of or behind other objects      

● Rotating objects    

● Mirroring objects    

● Defining the tab sequence for objects  

● Stamping: Inserting several objects of the same type  
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● Selecting several objects simultaneously    

● Repositioning and resizing multiple objects  

● You can assign external graphics to objects, e.g. in the Graphic View.
You can view only the images you have previously stored in the graphic browser of your 
WinCC project.   
You can save graphics in the graphic browser:

– Via drag & drop from the "Graphics" object group to the working area

– As graphic files in the following formats: *.bmp, *.dib, *.ico, *.emf, *.wmf, *.gif, *.tif, *.jpeg 
or *.jpg

– As an OLE object
You either create a new OLE object or save an existing graphic file as an OLE object. 
To save an OLE object, an OLE-compatible graphics program must be installed on the 
configuration computer.         

10.1.2.4 Inserting an object

Introduction     
In the "Screens" or "Reports" editor, insert the objects to the "Toolbox" task card. Use the 
mouse to drag the objects into the work area. You either keep the objects in their original size, 
or scale them up or down when you paste them. 

In addition, you can copy or move objects via the clipboard from one editor to another, for 
example to transfer a screen object to a report. Alternatively, you can also use the mouse 
instead of the clipboard for copying and moving:

● Copying: <Ctrl + Drag&Drop>

● Moving: Drag&drop
 

  Note
Basic Panels

The "Reports" editor is not available for Basic Panels.
 

Requirement
The "Tools" task card is open.

Inserting objects in their standard size
1. In the "Toolbox" task card, select the desired graphic object or the desired graphic in the 

WinCC graphics folder.
When you move the cursor across the work area, it turns into a crosshair with an appended 
object icon. 

2. Click the location in the work area where you want to insert the object or graphic.
The object is inserted with its standard size at the desired position in the work area. 
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Alternatively, double-click the object in the "Toolbox" task card.

Copying an object
1. Select the desired object.

2. Select "Copy" in the shortcut menu.

3. Click the desired location and select "Paste" in the shortcut menu.

WinCC inserts a copy of the object at the desired location. You can only change the properties 
that are appropriate for the relevant context. 

Example: In the "Screens" editor, you can set for I/O fields and the mode for input and output. 
In the "Reports" editor, the mode is set to "Output". 

Original and copy are not interconnected and are configured independently from one another.

Inserting lines
1. Select the desired graphic object in the "Tools" task card.

2. Click on a location in the work area. A line in the standard size is inserted. 

Inserting a polygon or polyline
1. Select the desired object "Polyline" or "Polygon" in the "Tools" task card.

2. Click on a location in the work area. This fixes the starting point of the object.

3. Click another location in the work area. A corner point is set.

4. For every additional corner point, click on the corresponding location in the work area.

5. Double-click on a location in the work area. The last corner point is set.
This fixes all the points of the polygon or polyline.

 

  Note
Basic Panels

The "Polyline" and "Polygon" objects are not available for Basic Panels.
 

 

 Note

If you want to insert several objects of the same type, use the "Stamp" function. This avoids 
having to reselect the object in the "Tools" task card every time before inserting it. To do so, 
select the  icon in the toolbar of the "Tools" task card.
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See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.5 Deleting an Object

Introduction   
You can delete objects individually or with a multiple selection. 

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to delete.

To delete multiple objects, keep the <Shift> key pressed and select the objects to be deleted 
one after the other. Alternatively, drag and maximize an area around the desired objects 
with the mouse. 

2. Select "Delete" from the shortcut menu.

Result
The selected objects are deleted. 

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)
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10.1.2.6 Positioning an object

Introduction
When you select an object, it is enclosed by a rectangle with resizing handles. This rectangle 
is the rectangle which surrounds the object. The position of an object is defined by the 
coordinates of the top left corner of the rectangle surrounding the object.   

 

 Note

If the position is outside the work area the object is not displayed in Runtime.
 

Position and align
You have the possibility of having a grid displayed in the work area. You have three options 
for easier positioning of objects:

● "Snap to grid" When you resposition objects, they are automatically snapped and pasted 
to the grid. If you hold down the <Alt> key, the object is no longer snapped to the grid.

● "Snap to objects" When you reposition objects, they are displayed with help lines. You can 
use other objects for orientation during positioning.

● "None": You position the objects in any position. 

You activate and deactivate the grid and options as follows: 

● In the "Options > Settings > Visualization > Screens" menu

● In the "Layout > Grid" task card

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object you want to move.

The selected object is framed by a rectangle with resizing handles.

2. Left-click the object and keep the mouse button pressed.
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3. Move the mouse pointer onto the new position.
The contour of the object moves with the mouse and displays the new position for the object.

The object initially remains at its original position.

4. Now release the mouse button.
The object is moved into the position indicated by the contour of the selection rectangle.

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the X and Y values for the position under "Position & Size".

Result
The object appears at its new position. 

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.7 Resizing an object

Introduction
When you select an object, it is enclosed by a rectangle with handles. You have the following 
options of resizing an object: 

● Drag the handles using the mouse.

● Modify the "Size" property in the Inspector window.

Requirement
You have opened the work area containing at least one object.
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Procedure     
1. Select the object you want to resize.

The selection rectangle appears. The following figure shows a selected object:

2. Drag a resizing contact of the rectangle to a new position.
The size of the object changes.

– The size of the object is aligned to the grid pattern, provided the "Snap to grid" function 
is set.

– Press <ALT> to disable this function while you drag the object.
In order to scale the object proportionally, keep the <Shift> key pressed while changing 
the size with the mouse.

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the size of the object under "Position & Size".

Harmonizing the object size     
1. Select the objects.

2. Now, click one of the following buttons:   or  or  
The size of the selected objects is matched to each other.

The following screen shows how the selected objects are adapted to the height of the reference 
object:
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Icon Description
 Aligns the selected objects to the width of the reference object.

 Aligns the selected objects to the height of the reference object.

 Aligns the selected objects to the width and height of the reference object.

Result
The object now appears with its new size. 

See also
Overview of objects (Page 2950)

Designing an object (Page 2966)

10.1.2.8 Aligning objects

Procedure
1. Select the objects via multiple selection.

2. Specify an object as the reference object.

3. Select the desired command in the toolbar or the shortcut menu - see table below.
The selected objects will be aligned.

Aligning objects flush     
The selected objects will be aligned flush to the reference object. 

Icon Description
Aligns the selected objects to the left edge of the reference object. 
Aligns the selected objects to the vertical center axis of the reference object. 
Aligns the selected objects to the right edge of the reference object. 
Aligns the selected objects to the upper edge of the reference object. 

Aligns the selected objects to the horizontal center axis of the reference object. 
Aligns the selected objects to the lower edge of the reference object. 
Centers the selected objects to the center points of the reference object. 
Centers the selected objects vertically in the screen.
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Snap to object
When you reposition objects, they are displayed with help lines. You can use other objects for 
orientation during positioning.

If you are working with the keyboard, press the Alt key. When you move the selected object 
with the arrow keys, the next anchor point is displayed.

Distributing objects evenly     
You need at least three selected objects. A reference object is not required.

1. Select the objects.

2. Click one of the buttons "Distribute horizontally equal" or "Distribute vertically equal".
The selected objects are distributed at equal distances.

The following screen shows how you align the vertical spacing of the selected objects:

Icon Description
Aligns the horizontal distance between the objects. 
The position of the objects on the extreme left and right side remains unchanged. All 
other objects are distributed evenly between them. 
Aligns the vertical distance between the objects. 
The position of the objects at the extreme top and bottom (right and left) remains 
unchanged. All other objects are distributed evenly between them. 

See also
Overview of objects (Page 2950)

Designing an object (Page 2966)
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10.1.2.9 Moving an object forward or backward

Introduction
You can use the "Order" functions in the shortcut menu of a selected object or in the toolbar 
to move a selected object in front of or behind other objects within an object layer.    

 

 Note

ActiveX controls are always positioned in front of an object layer (.NET property).
 

Requirement
You have opened a screen which contains a layer with multiple objects.

Procedure
1. Select the object you want to move forward or backward.

2. Select the "Sort" command and one of the following commands from the shortcut menu:

Icon Description
Moves the selected object before all the other objects of the same layer
Moves the selected object to the lowest position in the same layer
Moves the selected object up by one position
Moves the selected object down by one position

Alternative procedure
1. Open the "Layers" palette of the "Layout" task card.

2. Navigate to the required object.

3. Hold down the mouse button, and drag the object in the tree topology to the required position 
in the layer.

4. Now release the mouse button.

Result
The object is moved up or down. 

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)
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10.1.2.10 Show objects outside the screen area

Introduction 
If you assign objects to positions that are outside the configurable area, these objects will be 
hidden. The functions of the "Objects outside the visible area" palette in the "Layout" task card 
are used to move these objects back into the screen.

Requirement
● You have opened a screen which contains objects that are outside the configurable area.

● The "Layout" task card is open.

Procedure
1. Open the "Layout > Objects outside the area" task card.

This displays a list of objects that are outside the configurable area.

2. Select the the object which you want to move back into the screen from the list.

3. Select "Move to screen" in the object shortcut menu.

Alternatively open the "Layout > Layer" task card. Objects outside the area are indicated by 
the  icon. If you click this icon, the object is moved back into the screen.

Result
The objects are moved to the configurable area.

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.11 Rotating objects

Introduction   
You can rotate a suitable object clockwise or counterclockwise around its center axis in steps 
of 90°. 

 

 Note

Not all the objects can be rotated. Some objects that can be rotated in screens cannot be 
rotated in reports.
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You can also rotate multiple objects using the multiple selection function. Certain WinCC 
objects such as buttons cannot be rotated.

The alignment of elements in an object will change in a rotated object. The following figure 
shows how a rectangle and an ellipse behave under the different commands for rotating an 
object:

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to rotate.

2. Click one of the following toolbar icons:
, to rotate the object clockwise around its center point. The angle of rotation is 90°.
, to rotate the object counterclockwise around its center point. The angle of rotation is 

90°.
, to rotate the object clockwise by 180°.

Result
The object is shown at its new angle. 

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)
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10.1.2.12 Flipping objects

Introduction
You can flip an object along its vertical or horizontal center axis. The alignment of elements in 
an object will change when you flip an object. The following figure shows how a rectangle and 
an ellipse behave under the different commands for flipping an object.

Requirement
You have opened a screen which contains at least one object.

Procedure
1. Select the object that you want to flip.

2. Click the "Flip" command in the shortcut menu and select one of the options displayed:

– , to flip the selected object along its vertical center axis.

– , to flip the selected object along its horizontal center axis.

Result
The object is shown at its flipped position. 

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)
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10.1.2.13 Flashing

Introduction   
You want an object to flash in Runtime.

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to flash.

2. In the Inspector window, select the type "Default" under ""Properties > Properties > 
Flashing".

Result
The object flashes in runtime.

See also
Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.14 Designing an object

Introduction
You design the border and background of an object.      

Requirement
A line has been created in a screen.

Procedure
1. Select the line on your screen.

2. In the Inspector window, select "Properties > Properties > Appearance":

3. Select "Dash" as the style.

4. To display the dashed line in two colors, select the line width "1".

5. Select the setting "Arrow" in the "Line ends" area.
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Result
The line is displayed in two colors as a dashed line. The end of the line is an arrow. 

See also
Overview of objects (Page 2947)

Inserting an object (Page 2954)

Deleting an Object (Page 2956)

Positioning an object (Page 2957)

Resizing an object (Page 2958)

Aligning objects (Page 2960)

Moving an object forward or backward (Page 2962)

Show objects outside the screen area (Page 2963)

Rotating objects (Page 2963)

Flipping objects (Page 2965)

Flashing (Page 2966)

Inserting multiple objects of the same type (stamping tool) (Page 2967)

Selecting multiple objects  (Page 2969)

Repositioning and resizing multiple objects (Page 2971)

Managing My Controls (Page 2972)

External graphics  (Page 2974)

Managing external graphics (Page 2975)

Storing an external image in the graphics library. (Page 2977)

10.1.2.15 Inserting multiple objects of the same type (stamping tool)

Introduction
WinCC offers the possibility to "stamp" several objects of the same type directly one after the 
other, i.e. paste without having to reselect the object every time. In addition you have the 
possibility of multiplying an object that has already been inserted.         

Requirement
The "Tools" task card is open.
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Inserting several objects of one type
1. Select the object that you want to insert in the "Tools" task card.

2. Click the  icon in the toolbar of the "Tools" task card.
The "Stamp" function is activated.

3. To insert the object with its standard size, click the relevant insertion position in the work 
area.
To insert the object with another size, position the mouse pointer at the desired location in 
the work area. Press the left mouse button and drag the object to the required size.
The object is inserted in the work area as soon as you release the mouse button.

4. Repeat step 3 to insert further objects of the same type.

5. Click the  icon again.
The "Stamp" function is deactivated.

 

  Note

You can copy existing objects using the drag-and-drop +<CTRL> function. The existing 
object is not moved in this case. You paste a copy of this object into the new position 
instead.

 

Inserting and multiplying an object
1. Insert the desired object from the "Tools" task card.

2. Press the <Ctrl> key and position the cursor on one of the handles displayed in the figure 
shown below.
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3. Drag the handles to the right and/or down while keeping the left mouse button pressed.

4. The object is multiplied depending on available space if you keep moving the cursor.

Result
You have pasted and stamped an object in a screen.

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.16 Selecting multiple objects 

Introduction    
Select all objects you want to align with each other or to change global properties. This 
procedure is called "multiple selection." 

The Inspector window shows all the properties of the selected objects. 

You now have several options of selecting multiple objects:

● Draw a selection frame around the objects.

● Hold down the <Shift> key, and click the required objects.

Selection frame of a multiple selection
The selection frame surrounds all objects of a multiple selection. The selection frame is 
comparable with the rectangle that surrounds an individual object.

The selection frame is not visible. When you have made your multiple selection, the following 
frame is displayed:

● The reference object is indicated by the rectangle around it.

● The other selected objects are indicated by a dashed-line frame.
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Specifying a reference object   
The reference object is the object upon which the other objects are oriented. The reference 
object is framed by a rectangle with handles. The following figure shows a reference object 
with two other selected objects:

You have the following options to specify the reference object:

● Select the objects via multiple selection. The object selected first is then the reference 
object.

● Draw a selection frame around the objects. The reference object compiled automatically. 
If you wish to specify a different object within the selection as the reference object, click on 
the desired object. This action does not cancel your multiple selection.

Requirement
You have opened the work area containing at least two objects.

Selecting multiple objects with a selection frame
1. Position the mouse pointer in the work area close to one of the objects to be selected.

2. Hold down the mouse button, and draw a selection frame around the objects to be selected.

Or:

1. Hold down the <Shift> key.

2. Click the relevant objects, working in succession.
All the selected objects are identified by frames.
The object selected first is identified as reference object.

 

  Note

To remove an object from the multiple selection, press <SHIFT>, hold it down and then 
click the relevant object once again.

 

Result
Multiple objects are selected. One of those is identified as the reference object. You can now 
perform the following steps:

● Changing the object properties of all the objects

● Resizing all the objects by the same ratio, by dragging the selection frame to increase or 
reduce the size
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● Moving all the objects in one group

● Aligning the objects to the reference object

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.17 Repositioning and resizing multiple objects

Possible modifications
After you have selected multiple objects, you edit them:

● Shift using the mouse

– To change the absolute position of the marked objects, position the mouse pointer over 
an object, and shift the multiple selection with the mouse button pressed.

– To resize all the objects by the same ratio, grab the resizing handles of the reference 
object.

● Move over the work area with the icons of the toolbar

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

● Moving with the shortcut menu commands of the work area

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

See also
Overview of objects (Page 2950)

Designing an object (Page 2966)
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10.1.2.18 Managing My Controls

Introduction
Add standardized or user-defined controls in the "Tools > My Controls" task card. All the 
ActiveX controls registered in the operating system and the .Net controls on your system are 
available for use in WinCC.

● ActiveX controls
ActiveX controls are control elements from any providers, which can be used by other 
programs over a defined OLE-based interface.

● .Net controls
.Net controls are control elements from any providers based on the Microsoft .Net 
Framework.

● Specific .Net controls
.Net controls are control elements from any providers based on the Microsoft .Net 
Framework.

When you intend to run external controls in your WinCC project, you need to verify that these 
run on the HMI device you are configuring. If you are using controls from third parties, you 
must first of all add these to the "My controls" palette before you copy the project to different 
PCs.

 

 Note

The use of any control elements that are not included in the delivery scope (for example of 
third parties) may cause errors such as performance loss, or system hangs. The user of such 
control software is alone responsible for any problems caused by its use. We therefore advise 
you to closely examine such elements prior to their use.

 

Requirement
● The required  ActiveX control is installed in the PC's operating system.

● The required or specific .Net control is available on the PC in an assembly.

● A screen is open.

● The "Tools" task card is open.
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Adding a new control to the "My controls" group     
1. Open "Tools > My controls" in the "Tools" task card.

2. Select "Select objects" from the shortcut menu.
A dialog opens. This contains all the controls available on the system. Controls that already 
exist in the "Tools" task card are identified by a check mark.

3. Select the desired tab, e.g. ActiveX controls.

4. Activate the required control.

5. Confirm your selection with "OK".

Inserting a specific .Net control in the "My controls" group  
1. Select the "Specific .Net controls" tab. The list is empty the first time you select the tab.

2. Click the "…" button.

3. Select the folder in which the assembly is contained.

4. Select a file.

5. Click "Open." All the available controls are displayed in the "Specific .Net controls" tab.

6. Activate the required .Net control.

7. Confirm your selection with "OK".
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Result
The control now appears in the "Tools > My controls" task card and can be configured in a 
screen.

Removing a control from the "My controls" group    
1. Select "Delete" from the shortcut menu for the control concerned.

The control is removed from the "My controls" group. 

See also
Designing an object (Page 2966)

10.1.2.19 External graphics 

Introduction
You can use graphics created with an external graphic program in WinCC. To use these 
graphics you store them in the graphic browser of the WinCC project. 

You can save graphics in the graphic browser:

● When you drag-and-drop graphics objects from the "Graphics" pane into the work area, 
these are stored automatically in the graphic browser. The graphic names are numbered 
in the order of their creation, for example, "Graphic_1." Use the <F2> function key to rename 
the graphic.

● As a graphic file with the following formats:
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tif, *.png, *.jpeg or *.jpg

● As an OLE object that is embedded in WinCC and is linked to an external graphic editor. 
In the case of an OLE link, you open the external graphic editor from WinCC. The linked 
object is edited using the graphic editor. An OLE link only works if the external graphic 
editor is installed on your PC, and supports OLE.

Use of graphics from the graphic browser
Graphics from the graphic browser are used in your screens:   

● In a Graphic view 

● In a graphics list

● As labeling for a button/function key

Transparent graphics
In WinCC you also use graphics with a transparent background. When a graphic with a 
transparent background is inserted into a graphic object of WinCC, the transparency is 
replaced by the background color specified for the graphic object. The selected background 
color is linked firmly with the graphic. If you use the graphic in another graphic object of WinCC, 
this object is displayed with the same background color as the graphic object that was 
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configured first. If you want to use the graphic with different background colors, include this 
graphic in the graphic browser again under a different name. The additional background color 
is configured when the graphic is used at the corresponding graphic object of WinCC.   

Managing graphics
An extensive collection of graphics, icons and symbols is installed with WinCC, for example:

In the Toolbox window of the "Graphic" pane the graphic objects are structured by topic in the 
"WinCC graphics folder." The link to the WinCC graphics folder cannot be removed, edited or 
renamed.   

The "Graphics" pane is also used to manage the external graphics. The following possibilities 
are available:

● Creating links to graphics folders
The external graphic objects in this folder, and in the subfolders, are displayed in the toolbox 
and are thus integrated in the project. 

● Editing folder links

● You open the program required for editing of the external graphic in WinCC.

 

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.20 Managing external graphics

Introduction    
External graphics that you want to use in WinCC are managed in the "Screens" editor by using 
the "Tools" task card in the "Graphics" pane.

Requirement
● The "Screens" editor is open.

● The "Tools" task card is open.

● The graphics are available.

● The graphics have the following formats:
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tif, *.jpeg or *.jpg         
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Creating a folder link   
1. Click "My graphics folder."

2. Select "Link" in the shortcut menu.
The "Create link to folder" dialog is opened. The dialog suggests a name for the folder link. 

3. Edit the name as required. Select the path containing the graphic objects.

4. Click "OK" to confirm your input.
The new folder link is added to the "Graphics" object group. The external graphics that are 
located in the target folder and in sub-folders are displayed in the toolbox.

Editing folder links   
1. Select the folder link to edit.

2. Select the "Edit link..." command from the shortcut menu. 
The "Create link to folder" dialog is opened.

3. Edit the name and path of the folder link as required.

4. Click "OK" to confirm your input.

Renaming the folder link  
1. Select the folder link to rename.

2. Select "Rename" from the shortcut menu.

3. Assign a name to the new folder link.

Removing a folder link   
1. Select the folder link you want to delete.

2. Select "Remove" in the shortcut menu.

Edit external graphics
1. Select the graphic you want to edit.

2. Select the "Edit graphic" command from the shortcut menu.
This opens the screen editor associated with the graphic object file.

Editing graphics folders from WinCC
1. Select the graphic you want to edit.

2. Select the "Open parent folder" command from the shortcut menu.
The Windows Explorer opens. 
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See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.21 Storing an external image in the graphics library.

Introduction
To display graphics that have been created in an external graphics program in your screens, 
you will first have to store these graphics in the graphics browser of the WinCC project.      

Requirement
● A screen has been created.

● A Graphic View is inserted in the screen.

● The Inspector window of the Graphic view  is open.

To store an external graphic in the image browser: 

● A graphic is available.

To store an OLE object in the browser: 

● An OLE-compatible graphics program is installed on your configuration computer.

Save graphics file
1. Open the Windows Explorer.

2. Select the graphic that you want to store.

3. Drag-and-drop the graphic into the graphic browser.

Creating and saving a new graphic as an OLE object
1. Select the Graphic view  on your screen.

2. In the Inspector window, select "Properties > Properties > General":

3. Open the graphic selection list.

4. Click .

5. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.
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6. From the "Insert object" dialog box, select "New" and an object type. The settings in 
"Settings > "OLE settings" determine which object types are shown.

7. Click "OK." The associated graphic program is opened.
When you are finished creating graphics, end the graphic programming software with "File 
> Close" or "File > Close & return to WinCC." 
The graphic will be stored in the graphic programming software standard format and added 
to the graphic browser.

Inserting created graphics in WinCC
 

 Note

A new graphic object created as OLE object may not be directly accepted in WinCC when 
you save it to an external graphics program. 

 

1. Reopen the dialog for inserting a graphic.

2. From the "Insert object" dialog box, select "Create from file."

3. Click the "Browse" button.

4. Navigate to the created graphic and select it.

Saving an existing graphic object as an OLE object
1. In the Inspector window, select "Properties > Properties > General":

2. Open the graphic selection list.

3. Click .

4. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

5. From the "Insert object" dialog box, select "Create from file."

6. Click the "Browse" button.

7. Use the dialog to help you navigate to the folder in which the graphic file is saved.
 

  Note

To import graphics files, note the following size restrictions:

*.bmp, *.tif, *.emf, *.wmf  ≤4 MB

*.jpg, *.jpeg, *.ico, *.gif "*≤1 MB
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Result
The image file is now stored in your image browser. It is shown in a screen with a Graphic 
view , or is added as a list element in an image list.

You can double-click OLE objects in your library to open them for editing in the corresponding 
graphic editor. When you have finished editing graphics, end the graphic programming 
software with "File > Close" or "File > Close & return to WinCC." The changes are applied to 
WinCC. 

 

See also
Overview of objects (Page 2950)

Example: Configuring a rectangle (Page 2988)

Designing an object (Page 2966)

10.1.2.22 Working with object groups

Basics on groups

Introduction
Groups are several objects that are grouped together with the "Group" function. You edit a 
group in the same way as any other object. 

Overview
WinCC offers the following methods for editing multiple objects: 

● Multiple selection

● Creating object groups

Editing mode
To edit an individual object in a group, select the object in the "Layout > Layers" task card. 

Alternatively select "Group > Edit group" in the object group's shortcut menu.

Hierarchical groups
You add further objects or groups to extend a group. The group is enlarged by the new objects 
and is structured hierarchically in main and sub-groups. Such hierarchical groups must be 
broken up in stages. You also break up the group in the same order in which you grouped the 
objects or groups. It takes exactly the same number of steps to break up these hierarchical 
groups as it did to create them.
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Rectangle surrounding the object
Only one surrounding rectangle is now displayed for the whole group. The surrounding 
rectangles of all objects are displayed for a multiple selection on the other hand.

Layers
All objects of a group are located in the same layer. 

See also
Example: Configuring a rectangle (Page 2988)

Creating object groups

Introduction
The "Group" command combines multiple objects to form a group.       

You can change the size and position of the group. The following rules apply: 

● The system automatically adapts the position coordinates of the grouped objects when you 
reposition the group. The relative position of the grouped objects to the group is not affected.

● The system automatically adapts the height and width of the grouped objects in proportion 
to a change of the group size.

● To change the size of the group proportionately, hold down the <Shift> key and drag the 
rectangle around the object until has the required size.

 

  Note

To create a hierarchical group, organize the individual groups like objects. 
 

Requirement
● You have opened a screen which contains at least two objects.

Creating object groups
1. Select all the objects you want to organize in a group.

2. Select the command "Group > Group" from the shortcut menu.

The objects of the group are displayed with a rectangle around the objects.

Grouping objects within a group
1. Select the group you want to edit.

2. Select the command "Group > Edit group" from the shortcut menu.
The group that you are editing is highlighted by a red frame.
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3. Select the objects of a group that you want to combine into a subgroup.

4. Select the command "Group > Group" from the shortcut menu.

A subgroup with the objects is created.

Adding objects into an existing group
1. Select the group to which you want to add objects.

2. Press the <Shift> key and select the object you want to add to the group.

3. Select the "Group > Add to group" command from the shortcut menu.

The object is added to this group.

Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.

Result
The selected objects are combined in a group. The multiple selection rectangle becomes the 
rectangle surroundings the objects in the group. The handles are shown only for the group. 
The group in in the active layer.

See also
Example: Configuring a rectangle (Page 2988)

Ungroup

Introduction
Select the "Ungroup" command to split a group into the original object fractions.     

Requirement
● You have opened a screen that contains a group.

Ungroup
1. Select the group.

2. Select the "Group > Ungroup" command from the shortcut menu.
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Ungrouping a group within a group
1. Select the higher-level group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group that you are editing is highlighted by a red frame.

3. Select the lower-level group.

4. Select the "Group > Ungroup" command from the shortcut menu.

Result
The lower-level group is ungrouped. The objects are assigned to the next higher group.

Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.

See also
Example: Configuring a rectangle (Page 2988)

Adding objects to a group

Introduction
The "Add objects to group" command is used to add objects to a group, without ungrouping it 
first.   

Requirements
A screen with one group and at least one other object is opened.

Procedure
1. Select the group.

2. Press the <Shift> key and select the object you want to add to the group.

3. Select the "Group > Add to group" command from the shortcut menu.

Result
The group consists of the original objects, and the newly-added objects. The added objects 
are arranged at the front of the group.
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Alternative procedure
You can also edit groups in the "Layout" task card. Using drag&drop you can also easily edit 
hierarchical groups in the "Layers" palette.

 

See also
Example: Configuring a rectangle (Page 2988)

Removing Objects from the Group

Introduction
You use the "Remove objects from group" command to remove individual objects from a group, 
without ungrouping it first.    

You do not have to remove the object from the group to edit an object in a group. You can edit 
the objects of a group individually.

Requirement
● You have opened a screen that contains a group.

Removing objects from a group
To remove an object from a group:

1. Select the group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group you want to edit is highlighted by a red frame.

3. Select all objects in the group that you want to remove from the group.

4. Select the "Group > Remove from group" command from the shortcut menu.

The objects are removed from the group.
 

 Note

If there are only two objects in the group, the menu command "Remove from group" is not 
available.

 

Deleting objects from a group
To remove an object from the group, and from the screen:

1. Select the group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group you want to edit is highlighted by a red frame.
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3. Select the objects in the group that you want to delete.

4. Select "Delete" from the shortcut menu.
 

  Note

If there are only two objects in the group, the menu command "Delete" is not available.
 

Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.

See also
Example: Configuring a rectangle (Page 2988)

Editing an Object in a Group

Introduction
You can edit the objects of a group individually.    

Requirement
You have opened a screen that contains a group.

Editing grouped objects
1. Select the group.

The properties of the group are displayed in the Inspector window.

2. Change the position and size of the grouped objects in "Properties > Properties >Layout."

3. Change the name of the group in "Properties > Properties > Miscellaneous."
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Modifying the properties of an object within a group
1. Select the group.

2. Select the object whose properties you want to change in the Inspector window.

The properties of the object are displayed.

3. Change the object properties.

Result
Although you have edited the object, it is still an element of the group. These changes do not 
affect the other objects of the group. 

See also
Example: Configuring a rectangle (Page 2988)

10.1.2.23 Configuring the keyboard access

Overview of keyboard access

Introduction
For keyboard units without a mouse, the operator activates control objects using the <Tab> 
key. You can set up keyboard input to make the process easier to run, and to make sure that 
the operator enters all the necessary values. If you are using the keyboard, use the <Tab> key 
to activate the objects in a certain order, and to enter the necessary values.

For HMI devices without key, you can simulate the <Tab> key by configuring the 
"SimulateSystemKey" system function to a function key.
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Operator authorizations and operator control enables
If you configure an object for operator input with the <Tab> key, the object must have both an 
operator authorization, and an operator control enable. 

Editing the tab sequence
The tab sequence is determined automatically when the control objects are created. The 
numbers of the tab sequence are assigned in the sequence in which the libraries are created.

It makes sense to change the tab sequence in the following cases:

● The operator changes directly to a specific control object.

● The screen requires a specific sequence

Change to the tab sequence mode to change the tab sequence. In this mode, the tab sequence 
number is displayed at the top left of the control objects. The tab sequence numbers of hidden 
objects are also shown. The distribution of these numbers is edited using the mouse.

 

 Note

Other functions are not available in the tab sequence mode.
 

See also
Example: Configuring a rectangle (Page 2988)

Defining the Operator Authorization and Operator Control Enable for an Object

Introduction
If you configure an object for operator input with the <Tab> key, the object must have both an 
operator authorization, and an operator control enable.

Requirement
You have opened a screen which contains at least one object.

Procedure
1. Select the object.

2. Select "Properties > Properties > Security" in the Inspector window.

3. Select the operator authorization under "Authorization."

4. Activate the authorization to operate.
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Result
The operator can use the <Tab> key in Runtime to select the object.

See also
Example: Configuring a rectangle (Page 2988)

Setting the tab sequence order

Introduction
All operable objects can be reached in runtime with the <Tab> key. You use the "Tab sequence" 
command to define the order in which the operator can activate objects in runtime. 

 

 Note

You cannot reach objects with the "Output" or "Two states" mode in runtime with the <Tab> 
key.

 

You can operate the screen in runtime:

● Using the <Tab> key

● Using the mouse

● Using a configured hotkey

Requirement
● The active screen contains operable objects.

● No object is selected.

● The objects have been enabled for use in runtime, and have operator authorization.
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Procedure
1. Select "Edit tab sequence" in the "Edit" menu.

Tab sequence mode is activated. The tab sequence number is displayed for all objects that 
can be used. The tab sequence number is also displayed for hidden objects.

2. Use edit the tab sequence mode, click the accessible objects in the order in which you want 
them to be activated using <Tab> in runtime.
The following figure shows how the tab sequence is defined in the screen. In runtime, the 
<Tab> key first activates the alarm view (number 1), then the I/O field (number 2), and then 
the button (number 3):

3. To exclude a screen object from the tab sequence, press the key combination <Shift+Ctrl> 
and click on the desired object.
The tab sequence number is no longer displayed in the screen object. The screen object 
is now excluded from the tab sequence. The remaining tab sequence numbers are 
automatically decreased by 1.

4. To reenter an excluded screen object in the tab sequence, repeat step 3.
The screen object entered as the first object in the tab sequence.

Result
The operator selects the objects in the specified order in Runtime with the <Tab> key.

See also
Example: Configuring a rectangle (Page 2988)

10.1.2.24 Examples

Example: Configuring a rectangle

Task
In this example you configure a rectangle:   

● Color = red

● Black frame 2 pixels wide

● Position = (20, 20)

● Size = (100,100)
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Changing the color of the rectangle
To change the color of the rectangle:

1. Select the rectangle.

2. Define the background color in "Properties > Properties > Appearance > Background > 
Color" in the Inspector window.

3. Select "Solid" as the fill pattern.

4. Define the color for the border in "Properties > Properties > Appearance > Border > Color" 
in the Inspector window.

5. Enter the value "2" for "width".

6. Select "Solid" as the "Style".

Interim result
The rectangle is red and has a black frame with a width of two pixels.

Repositioning and resizing the rectangle
To change the position and size of the rectangle:

1. Select the rectangle.

2. In the Inspector window, select "Properties > Properties > Layout".

3. Set "20" for the both the X and Y coordinates under "Position & Size".

4. Set "100" for the height and for the width.

Result
The rectangle is positioned at the coordinates (20, 20), and has a width and height of 100 pixels. 
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See also
Overview of objects (Page 2950)

Example: Inserting a rectangle

Task
In this example, you insert and rename a rectangle. Do not use the special characters ?, ", /, 
\, *, <, > for the name.   

Requirement
● A screen is open.

● The Inspector window is open.

● The "Tools" task card is open.

Procedure
1. Click the "Basic objects" palette in the "Tools" task card.

2. Drag the "Rectangle" object into the screen.

3. In the Inspector window, select "Properties > Properties > Miscellaneous".

4. Type in the new name "MyRectangle".

Result
The rectangle is now inserted and named "MyRectangle". The rectangle has the default 
properties of the "rectangle" object. 

Example: Inserting and configuring a rectangle

Task
In this example, you insert a rectangle in a screen. You can configure the following properties:  

● Name = "MyRectangle"

● Position = (20, 20)

● Size = (100,100)

● Color = red

● Black frame 2 pixels wide
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Principle
The rectangle is a closed object which can be filled with a color or pattern. The height and 
width of a rectangle can be adjusted to allow its horizontal and vertical alignment.

 

Overview
Carry out the following steps in order to create a rectangle:

● Inserting a rectangle

● Configuring a rectangle

10.1.3 Working with text lists and graphics lists

10.1.3.1 Working with text lists

Basics on text lists

Introduction
Texts are assigned to the values of a tag in a text list. Assign the text list to a symbolic I/O field 
for example in the configuration. This supplies the text to be displayed to the object. The text 
lists are created in the ""Text List" editor. You configure the interface between the text list and 
a tag at the object that uses the text list. 

The selection of objects that can have a text list assigned depends on the Runtime.  

Application
The text list is used, for example, to display a drop-down list in a symbolic I/O field. 
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If the symbolic I/O field is a display field, the associated texts will differ according to the value 
of the configured tags. If the symbolic I/O field is an input field, the configured tag assumes 
the associated value when the operator selects the corresponding text in Runtime. 

 

 Note
Display of tag values without text

The display of tag values to which no text has been assigned depends on the Runtime:
● The display and operating object remains empty.
● Three asterisks *** are displayed.

 

Multilingual texts
You can configure multiple languages for the texts in a text list. The texts will then be displayed 
in the set language in Runtime. To this purpose you set the languages in the Project window 
under "Language support > Project languages." 

Configuration steps
The following steps are necessary to display texts in a symbolic I/O field for example:

1. Creating the text list

2. Assignment of the texts to values or value ranges of a text list

3. Assignment of a text list in the display object, e.g. the symbolic I/O field

See also
Screen basics (Page 2931)

Creating a text list

Introduction
The text list allows you to assign specific texts to values and to output these in Runtime, for 
example in a symbolic I/O field. The type of symbolic I/O field can be specified, for example 
as a pure input field. 

The following types of list are available:  

● Value/Range

● Bit

● Bit Number
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Procedure
1. Double-click "Text and graphics lists" in the project window.

2. Open the "Text lists" tab.

3. Click "Add" in the "Text lists" table.
The Inspector window of the text list is open.

4. Assign a name to the text list that indicates its function.

5. Select the text list type under "Selection":

– Value/Range: Text from the text list is displayed when the tag has a value that lies within 
the specified range.

– Bit (0,1): A text from the text list is displayed when the tag has the value 0. A different 
text from the text list is displayed when the tag has the value 1.

– Bit number (0-31): Text from the text list is displayed when the tag has the value of the 
assigned bit number.

6. Enter a comment for the text list.
 

  Note

You must not use semicolons in the texts in a text list. The semicolon is a control character 
and is automatically deleted from a text. 

 

Result
A text list is created.

Assigning texts and values to a range text list

Introduction
For each area text list you specify which texts are displayed at which value range.
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Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● An area text list has been created and selected.

Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Range" in "Properties > Properties > General > Value" in the Inspector 
window.

– Enter the value "1" for  "Min" for example.

– Enter the value "20" for  "Max" for example.

– For "Text", enter the text that is displayed in Runtime if the tag is within the specified 
value range.

 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. Click "Add" in the "Text list entries" table. A second list entry is created.
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4. Select the setting "Range" in "Properties > Properties > General > Value" in the Inspector 
window.

– Enter the value "21" for  "Min" for example.

– Enter the value "40" for  "Max" for example.

– For "Text", enter the text that is displayed in Runtime when the tag is within the specified 
value range.

5. If required, activate the "default entry".
The entered text is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

Result
An area text list is created. Texts have been assigned to the possible value ranges.     

Assigning texts and values to a bit text list

Introduction
For each text list, you specify which text is displayed at which bit value.

Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● A bit text list has been created and selected.
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Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "0" for "Value."

– Enter the text which is displayed in Runtime under "Text" if the bit tag is set to "0".
 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. Click "Add" in the "Text list entries" table. A second list entry is created.

4. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "1" under "Value."

– Enter the text which is to be displayed in Runtime under "Text" if the bit tag is set to "1".

Result
A bit text list is created. Texts that appear in Runtime are assigned to the possible values "0" 
and "1".     

Assigning texts and values to a bit number text list

Introduction
For each bit number text list you specify which texts are displayed at which bit number.
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Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● A bit number text list has been created and selected.

Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "10", for example, for "Value".

– Under "Text", enter the text that is displayed in Runtime when the tag 
has the value "10".

 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. If required, activate the "default entry".
The entered text is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

4. Create further list entries for additional bit numbers of the same text list.

Result
A bit number text list is created. Texts that appear in Runtime are assigned to the specified bit 
numbers.     
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Configuring objects with a text list

Introduction
The output value and value application for text lists are specified in the display and operating 
object that displays the texts of the text list in Runtime. The properties of these objects are 
configured as required.   

Requirement
● A text list is created.

● You have created a tag.

● The "Screens" editor is open.

● A screen with a symbolic I/O field is open. The object is edited.

Procedure
1. Select the text list which you want to have displayed in Runtime in "Properties > Properties 

> General > Text list" in the Inspection window.

2. Select the setting "Output" as the "Mode".
 

  Note
Runtime dependency

Different field types are available for a symbolic I/O field depending on the Runtime.
 

3. Select the tag the value of which determines the display in the symbolic I/O field as "Tag".

Result
The defined texts of the text list are displayed in the symbolic I/O field in Runtime when the 
tag has the specified value. 
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10.1.3.2 Working with graphics lists

Basic principles of graphics lists

Introduction
The possible values of a tag are assigned to specific graphics in a graphics list. During 
configuration, you can create a graphics list for a button or a graphic I/O field. This supplies 
the graphics to be displayed to the object. 

The graphics lists are created with the "Text and graphics list" editor. You configure the 
interface between the graphics list and a tag at the object that uses the graphics list. The 
availability of the graphics list is determined by the HMI device used.  

Application
You can configure the graphics list for the following situations: 

● Drop-down list with a graphic I/O field

● State-specific graphic for a button

The graphics in a graphics list can be configured as multilingual. The graphics will then be 
displayed in the set language in runtime. 

Graphic sources
Graphics can be added to the graphics list from the following sources: 

● By selecting from a graphic browser

● By selecting an existing file 
You can use the following file types: 
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tiff, *.png, *.jpeg and *.jpg.

● By creating a new file

Function
If the graphic I/O field is a display field, the associated graphics will differ according to the value 
of the configured tags. If the graphic I/O field is an input field, the configured tag assumes the 
associated value when the operator selects a graphic in runtime. 

Configuration steps
The following tasks are required to display graphics, for example, in a graphic I/O field:

1. Creating the graphics list

2. Assignment of the graphics to values or value ranges of a graphics list

3. Assigning a graphics list in the display object, for example the graphic I/O field
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See also
Screen basics (Page 2931)

Creating a graphics list

Introduction
The graphics list allows you to assign specific graphics to variable values and to output these 
in a graphic IO field in Runtime. You can specify the type of graphic I/O field, for example as 
a pure output field.  

Procedure
1. Double-click "Text and graphics lists" in the project window.

2. Open the "Graphics lists" tab.

3. Click "Add" in the "Graphics lists" table. The Inspector window of the graphics list will open 
up.

4. Assign a name to the graphics list that indicates its function.

5. Select the graphics list type "Bit number (0 - 31)" for example under "Select".

6. Enter a comment for the graphics list.
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Result
A graphics list of the type "Range (0 - 31)" is created.  

Assigning a graphic and values to a range graphics list

Introduction
For each area graphics list you specify which graphics are displayed at which value range.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is open.

● An area graphics list has been created and selected.
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Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Range" in "Properties > Properties > General > Value" in the Inspector 
window:

– Enter the value "1" for  "Min" for example.

– Enter the value "20" for  "Max" for example.

– Select a graphic that is displayed in Runtime when the tag is within the specified value 
range.

 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. Click "Add" in the "Graphics list entries" table. A further list entry is created.
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4. Select the settings "Single value" in "Properties > Properties > General > Value" in the 
Inspector window:

– Enter the value "21" for example.

– Select a graphic which is displayed in Runtime if the bit "21" is set in the tag.

5. If required, activate the "default entry".
The graphic is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

Result
An area graphics list is created. Graphics that appear in Runtime are assigned to the possible 
values.   

Assigning graphics and values to a bit graphics list

Introduction
For each graphics list you specify which graphic is displayed at which bit value.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is opened.

● A bit graphics list has been created and selected.
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Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Single value" in the inspector window "Properties > Properties > 
General > Value":

– Enter "0" as the value.

– Select a graphic which is displayed in Runtime if the bit "0" is set in the tag.
 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. Click "Add" in the "Graphics list entries" table. A new list entry is created.

4. Select "Properties > Properties > General > Value > Single value": in the Inspector window.

– Enter "1" as the value.

– Select a graphic which is displayed in Runtime if the bit "1" is set in the tag.

Result
A bit graphics list is created. Graphics that appear in Runtime are assigned to the values "0" 
and "1".   

Assigning graphics and values to a bit number graphics list

Introduction
For each bit number graphics list you specify which graphics are displayed at which bit number.
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Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is open.

● A bit number graphics list has been created and selected.

Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Single value" in "Properties > Properties > General > Value" in the 
Inspector window:

– Enter the value "0" for example.

– Select a graphic which is displayed in Runtime if the bit "0" is set in the tag.

 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.
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3. If required, activate the "default entry".
The graphic is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

4. Create further list entries for additional bit numbers of the same graphics list.

Result
A bit number graphics list is created. Graphics that appear in Runtime are assigned to the 
specified bit numbers.   

Configuring objects with a graphics list

Introduction
The output value and value application for graphics list are specified in the display and 
operating object that displays the graphics of the graphics list in Runtime. The properties of 
these objects are configured as required.  

Requirement
● A graphics list is created. The values have been defined. Graphics have been assigned to 

the values.

● You have created a tag.

● The "Screens" editor is open.

● A screen with a graphics I/O field is open. The object is edited.

Procedure
1. Select the graphics list the graphics of which you want to have displayed in Runtime in 

"Properties > Properties > General > Graphics list" in the inspector window.

2. Select the setting "Input/Output" 

 as the "Mode".
 

  Note
Runtime dependency

Different field types are available for a graphic I/O field depending on the Runtime.
 

3. As "Tag", select the tag whose values are defined by the display in the graphic I/O field.

Result
The defined graphics of the graphics list are displayed in the graphic I/O field in Runtime when 
the tag has the specified value.
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10.1.4 Dynamizing screens

10.1.4.1 Basics on dynamizing screens

Dynamizing objects   
In WinCC you dynamize objects to map your system and show processes on HMI devices. 

You implement dynamizations by

● Animations

● Tags

● System functions

One example is the mapping of a tank, the liquid level of which rises or falls in relation to a 
process value. 

The options for dynamization depend on the object involved. When you copy an object, its 
dynamization functions are included.

See also
Basics on dynamizing screens (Page 3007)

Screen basics (Page 2931)

Basics on dynamization in the property list (Page 3024)

Basic on events (Page 3028)

Dynamization in the inspector window (Page 3010)

Dynamization in the inspector window (Page 3008)

10.1.4.2 Basics on dynamizing screens

Dynamizing objects   
In WinCC you dynamize objects to map your system and show processes on HMI devices. 

You implement dynamizations by

● Animations

● System functions

● Tags

● Local scripts

One example is the mapping of a tank, the liquid level of which rises or falls in relation to a 
process value. 
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The options for dynamization depend on the object involved. When you copy an object, its 
dynamization functions are included.

See also
Basics on dynamizing screens (Page 3007)

10.1.4.3 Dynamization in the inspector window

Introduction
Basically, you can dynamize all the screen objects which you have configured in a screen. 
Which dynamization possibilities and which events are available depends on the device and 
the selected object.

Animations
WinCC helps you to implement dynamization using predefined animations. If you want to 
animate an object, first configure the desired animation in the object's inspector window. Then 
adapt the animation to the requirements of your project. 

The selection of the supported animations depends on the HMI device and the selected object. 
You choose between the following types of animation: 

● Layout: Appearance, visibility

● Movements: direct, diagonal, horizontal and vertical movement

● Variable binding

You can configure the "Variable binding" type of animation several times for one object.

You configure animations in the "Properties > Animations" inspector window.
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Events
Operable objects also react to events, such as a mouse click. 

You configure a function list with system functions on an event. The system functions are 
processed as a reaction to the triggered event.

You configure events in the "Properties > Events" inspector window.

You will find further information in "Working with function lists".

See also
Basics on dynamizing screens (Page 3007)
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10.1.4.4 Dynamization in the inspector window

Introduction
Basically, you can dynamize all the screen objects which you have configured in a screen. 
Which dynamization possibilities and which events are available depends on the device and 
the selected object.

The inspector window offers you the possibilities for dynamization of screen objects in three 
tabs.

Property list
With the  button you go to the properties list in the "Properties > Properties" inspector 
window.

In the property list, you set any dynamization for the individual object properties using tags or 
local C and VB scripts. You can, for example, dynamically change the background color of an 
object.

In the "Dynamic Value" column you can dynamize the object property of a tag, a C-script or a 
VB-script.

Whether an object property can be dynamized is indicated in the Property list by means of the 
background color:

● Light gray: Can be dynamized

● Dark gray: Cannot be dynamized

Any animations you have already configured will also appear in the object property list, where 
you can edit the animations. 

The following table shows you how to sort the property list:

Sort by alphabet

Sort by category

With the  button you return to the property pages in the inspector window.   
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Animations
You have two different options for animating objects.

You configure animations  

● in the inspector window under "Properties > Animations",

● in the "Animations" task card.

WinCC helps you to implement dynamization using predefined animations. If you want to 
animate an object, first configure the desired animation with the tools of the toolbox or in the 
object's inspector window. Then customize the animation in the Inspector window to suit the 
requirements of your project. 

The selection of the supported animations depends on the device and the selected object. You 
choose between the following types of animation: 

● Tag binding

● Layout: Appearance, control enable, visibility

● Movements: direct, diagonal, horizontal and vertical movement

● Property animation
 

  Note
HMI device dependency

The "Control enable" animation is not available for every HMI device.
 

You can configure the "Tag binding" and "Property animation" types of animation several times 
for one object.

You configure animations in the "Properties > Animations" inspector window.
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Events  
Operator control enabled objects also react to events, such as a mouse click. 

You configure a function list with system functions or local scripts on an event. The system 
functions or the local script are processed as a reaction to the triggered event.

You configure events in the "Properties > Events" inspector window.

You will find further information in "Working with function lists".

See also
Basics on dynamizing screens (Page 3007)

10.1.4.5 Dynamization with animations

Configuring a new animation

Introduction
Use predefined animations to dynamize screen objects. 

Requirement
● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.

Procedure in the inspector window
1. In the Inspector window, select "Properties > Animations".

2. Select the animation you want to use.

3. Click the button. 
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Procedure in the "Animations" task card.
1. Open the object group containing the required animation in the "Animations" task card.

2. Drag the animation onto the object that you want to make dynamic.

Alternatively you select the object in the screen and double click the desired animation in the 
"Animation" task card.

Result
The animation appears in the Inspector window of the object. You configure the animation in 
the following steps. 

In the animations overview the green arrow indicates which animation is already configured. 
The configured animation opens in the inspector window when you click the green arrow.    

See also
Animations in multiple selection (Page 3023)

Animations of object groups (Page 3023)

Animations of object groups (Page 3022)

Configuring animation with tag binding (Page 3020)

Dynamizing the visibility of an object (Page 3019)

Dynamization of the control enable state of an operating element (Page 3018)

Configuring direct movement (Page 3017)

Configuring movement  (Page 3015)

Dynamizing the appearance of an object (Page 3014)
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Dynamizing the appearance of an object

Introduction
The appearance of a screen object is controlled by changing the value of a tag in runtime. 
When the tag adopts a certain value, the screen object changes its color or flashing 
characteristics according to the configuration.         

Type
Areas or single values of the tag are observed in Runtime depending on the selection. The 
appearance of the object changes according to the configuration.

Requirement
● A screen is open.

● A dynamic object is contained and selected in the screen.

● The Inspector window is open.

● The toolbox window is displayed.

Procedure
1. In the Inspector window, select "Properties > Animations".

The animations available for the selected object are displayed. 

2. Select the animation "Appearance" and click the  button.
The parameters of the animation are displayed.

3. Select a tag in "Tag > Name".

4. Select "Type > Range" for example.

5. Click "Add" in the table.

6. Enter the tag interval "0 - 20" in the "Range" column for example.

7. For "Foreground color" and "Background color", select the color the object is to acquire in 
Runtime when the tag reaches the interval.
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8. Select a flashing mode for the object from the "Flashing" list.

9. Repeat steps 5 to 8 to create another tag interval, e.g. "21 - 60".

Result
In Runtime, the flashing response, and color of the object change dynamically according to 
the process value returned in the tag. 

See also
Configuring a new animation (Page 3012)

Configuring movement 

Introduction
You can configure dynamic objects in such a way that they move on a certain track. The 
movement is controlled via tags. The object moves every time the tag is updated.         

You can only program one type of movement for each object. 

Requirement
● You have created a tag.

● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.
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Procedure
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Horizontal movement" and click the  button.
The parameters of the animation are displayed.
A transparent copy of the object is shown in the work area, which is connected to the source 
object by means of an arrow.

4. Select a tag for control of movement.

5. Move the object copy to the relevant destination. The system automatically enters the pixel 
values of the final position in the Inspector window.

6. Customize the range of values for the tag as required.

Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. The direction of movement corresponds to the configured type of 
movement "horizontal".

 

 Note

You configure vertical and diagonal movements similar to horizontal movements         
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See also
Configuring a new animation (Page 3012)

Configuring direct movement

Introduction
The object is moved respectively in x direction and y direction with "Direct movement". Two 
tags define the number of pixels by which the object moves from its original static start 
position.       

Requirement
● Two tags are set up.

● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.

Configuring "Direct movement"
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".

3. Select "Direct movement" and click the  button.
The parameters of the animation are displayed.

4. Select a tag for the X position with which the movement in x direction is controlled.

5. Select a tag for the Y position with which the movement in y direction is controlled.

Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. 
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See also
Configuring a new animation (Page 3012)

Dynamization of the control enable state of an operating element

Introduction
You can dynamically change the usability of  an operating element. The object either can, or 
cannot be used in Runtime, depending on the value of a tag.    

You can use this dynamic control to restrict operator access to  an operating element to specific 
situations, such as for maintenance.

Requirement
● You have created a tag.

● A screen with an operating element is open.

● The Inspector window is open.

● The toolbox window is displayed.

Procedure
1. Select the operating element in the screen that you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Control enable" and click the  button.
The parameters of the animation are displayed.

4. Select a tag.
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5. Activate "Range".

– For "From:" enter  e.g. the value "0"

– For "To:" enter  e.g. the value "100"

6. Activate "Control enable > Activated".

Result
The screen object is operator control enabled in Runtime depending on the tag value:

● The object becomes operator control enabled when the tag value is between 0 and 100.

● The object is not operator control enabled if the tag value is outside the range.

See also
Configuring a new animation (Page 3012)

Dynamizing the visibility of an object

Introduction
Dynamization of the "Visibility" property allows you to output an alarm to your screen, which 
is triggered when the tag value exceeds a critical range, for example. The alarm is cleared 
when the tag value returns to the non-critical range.

The "Simple recipe view" and "Simple alarm view" objects are always visible.

Requirement
● You have created a tag.

● You have opened a screen containing an object that you want to show or hide in Runtime.

● The Inspector window is open.

Procedure
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Visibility" and click the  button.
The parameters of the animation are displayed.

4. Select a tag.

5. Activate "Range".
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6. Select, for example, "from 20" and "to 40"

7. Activate "Visible".

Result
The screen object is shown or hidden in Runtime depending on the tag value.

● If the tag value matches the configured range between 20 and 40, the screen object is 
shown.

● If the tag value is outside the configured range, the screen object is hidden.

See also
Configuring a new animation (Page 3012)

Configuring animation with tag binding

Introduction
When you object property an object property with a tag, the object property is changed in 
Runtime depending on the tag value.       

The following example shows the tag binding in the "Properties > Animations" inspector 
window. If you have configured tag binding it is also visible in the property list or in the property 
pages in the inspector window.

Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The Inspector window is open.
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Procedure
1. Select the screen object whose properties you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animation".
The animations available for the selected object are displayed. 

3. Select "Tag connection" and click the  button.
The parameters of the animation are displayed.

4. Select the object property that you want to dynamize in "Properties > Animation > Tag 
binding > Property > Name", e.g. "Background color".

5. Select a tag.

Result
You have dynamized the "Background color" property with a tag. The background color of the 
screen object changes in Runtime depending on which value the tag adopts. 

See also
Configuring a new animation (Page 3012)
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Animations of object groups

Applying animations to object groups
The inspector window shows all objects of a group and their possible animations. The 
animation types which are supported by all objects in the group are also listed separately.

If you configure an animation for an object group, this animation will apply to all individual 
objects that support this animation.

Application example
The "horizontal movement" animation is configured for the object of an object group. The "direct 
movement" animation is configured for the whole object group. Only the animation of the object 
group i.e. "direct movement" is executed in Runtime. This also applies for object groups within 
object groups. Only the animation of the group on the top layer is listed.

 

See also
Configuring a new animation (Page 3012)
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Animations of object groups

Changing animations of object groups
The inspector window shows all objects of a group and their possible animations. The 
animation types which are supported by all objects in the group are also listed separately.   

If you configure an animation for an object group, this animation will apply to all individual 
objects that support this animation.

Application example
The "horizontal movement" animation is configured for the object of an object group. The "direct 
movement" animation is configured for the whole object group. Both animation types are 
executed in runtime. This also applies for object groups within object groups.

See also
Configuring a new animation (Page 3012)

Animations in multiple selection

Changing animations for multiple objects  
For a multiple selection, the animations that are configured for the reference object appear in 
the Inspector window. You can change the animations as usual. The changes will apply to all 
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the objects in the multiple selection that support the configured animation. This means that 
even objects for which you have not yet configured an animation will have the reference object's 
animation. 

Application example
Select a button, and a circle at the same time. The button is the reference object. The 
"Appearance" animation is already configured for the button, so it appears in the Inspector 
window of the multiple selection. When you activate "Properties > Animations >Appearance > 
Flashing" in the inspector window, the settings of the "Appearance" animation apply for the 
button and for the circle.

Configuring new animations for multiple objects
If you configure a new animation for the objects of a multiple selection, this animation will apply 
to all selected objects that support the configured animation. If the new animation replaces an 
existing animation, a security prompt appears.

Application example
You select a circle, and a rectangle. The "Diagonal movement" animation is already configured 
for the circle. You configure the "Horizontal movement" animation for the multiple selection. 
This animation applies to the rectangle since no animation of the Movement type is yet 
configured for it. For the circle, you are asked to confirm that you want to replace the existing 
"Diagonal movement" animation with the new "Horizontal movement" animation. 

See also
Configuring a new animation (Page 3012)

10.1.4.6 Dynamization in the property list

Basics on dynamization in the property list

Basic principle of dynamization
Select a tag from the object list for a dynamizable object property in the property list. The object 
is dynamized if the tag value changes in Runtime.

Dynamization with tags
You dynamize an object property with a tag and configure a function list. The tags are updated 
in the update cycle set for the screen.

The figure below shows the "Radius" object property dynamized with a tag. When the value 
of the tag changes, a function list is executed additionally:
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You can also convert the function list into a local script.

You can find additional information under "Basics on the function list (Page 3545)".

See also
Basics on dynamizing screens (Page 3007)

Programming a dynamization method for a tag change (Page 3027)

Dynamizing an object property with a tag (Page 3025)

Dynamizing an object property with a tag

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. When you indirectly dynamize the object property, you connect 
the property to a tag that sets the property value in Runtime.

Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The Inspector window is open.
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Procedure
1. Select the screen object whose properties you want to control dynamically.

The object properties are displayed in the Inspector window.

2. Click the  button in the Inspector window.
The property list is displayed with the properties of the selected object. 

3. Select the property to be dynamized.

4. In the "Dynamization" column, select the entry "HMI_Tag".
A dialog opens.

5. Select a tag.

6. Activate "Use indirect addressing" to dynamize the object property.

Result
The object property changes in Runtime according to how the property list is configured. 

Representation of a multiple selection in the property list
If you selected multiple objects at the same time, the "Object type" column is added to the 
property list. The objects that support the property displayed in the row are displayed in this 
column. Changes to, or dynamization applied to a property affect all the objects displayed in 
the "Object type" column.

See also
Basics on dynamization in the property list (Page 3024)
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Programming a dynamization method for a tag change

Introduction
If you have entered a tag in the "Dynamization" column, you can configure a function list 
additionally on different events.

Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The property list is open in the inspector window.

● An object property is connected with the tag.

Procedure
1. Extend the property list by clicking next to the property which you have dynamized with a 

tag.

2. Three other lines with the following events are displayed below the property.

– Changed

– Tag status changed

– Quality code changed

3. Configure a function list for the required event.
Alternatively you can convert the function list into a local script.
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Result
The object property changes in Runtime according to how the property list is configured. 

See also
Basics on dynamization in the property list (Page 3024)

10.1.4.7 Dynamize with system functions

Basic on events

Introduction
Screen objects react to events. You configure a function list with system functions on the events 
of an object. 

Events 
Which events and system functions are available depends on the object used.

If the operator activates a screen object for example, the configured system function is 
executed.

You can find additional information under "Basics on the function list (Page 3545)".

See also
Basics on dynamizing screens (Page 3007)

Example: Configuring a button for language switching (Page 3029)

Configure system function on the "Click" event (Page 3028)

Configure system function on the "Click" event

Introduction
You configure a function list on an object event. The linked system function is executed when 
the event occurs in runtime.

Requirements
A screen is open.

A button has been created in the screen.

The inspector window is open.
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Procedure
1. Select the button.

2. Click "Properties> Events" in the Inspector window.

3. Select the "Click" event.

4. Click "Add function" in the table.

5. Select the "ShowAlarmWindow" system function.

Result
The alarm window opens in the screen if the operator clicks the button in runtime. 

See also
Basic on events (Page 3028)

Example: Configuring a button for language switching

Introduction
In this example, you configure a button that can be used to toggle between multiple runtime 
languages during runtime.

Requirements
● You have completed the "Configuring a button in multiple languages" example.

● The "Screen_1" screen is open.

● The button on the screen has been selected.

Procedure
1. In the Inspector window, select "Properties > Events > Press".

2. Click on "Add function" in the table.

3. Select the "SetLanguage" system function and the "Switch" setting.

Result
You have assigned the button the function "SetLanguage". Pressing the button during runtime 
will switch the runtime language. The runtime languages are switched in the order specified 
by the number sequence in the "Languages and fonts" editor. 
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See also
Basic on events (Page 3028)

Button (Page 3130)

10.1.5 Working with function keys

10.1.5.1 Working with function keys 

Introduction
The function key is a physical key on your HMI device and its functions can be configured. A 
function list can be configured for the events "Key pressed" and "Release key".       

A function key can be assigned global or local functions.
 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Global function keys
Global function keys always trigger the same action, regardless of the displayed screen.

Global function keys are configured in the "Global Screen" editor. The global assignment 
applies for all the screens of the set HMI device. 

Global function keys reduce programming considerably, because there is no need to assign 
these global keys to each individual screen.

Local function keys in screens
Local function keys in screens can trigger a different action in each screen. This assignment 
applies only to the screen in which you have defined the function key.

Within a screen, a function key has only one function assignment, either a global or local one. 
The project planner specifies which assignment has priority.

 

 Note

If a screen with local function keys is overlapped by an alarm view or an alarm window, then 
the function keys are still active in runtime. This may happen in particular on HMI devices 
with a small display.
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Local function keys in templates
Local functions keys that are assigned in templates are valid for all the screens based on this 
template. They can trigger a different action in every screen. Function keys for templates are 
assigned in the template of the "Screens" editor.  Within a template, a function key has only 
one function assignment, either a global or local one. The project planner specifies which 
assignment has priority.

Hotkey assignment
You can assign hotkeys, such as buttons, to control objects. The available hotkeys depend on 
the HMI device.

 

 Note

The function key has a local or global action assigned to it. If the function key also has a 
hotkey assigned to it, then the hotkey function will be executed in Runtime.

 

Graphics
When a function key is placed directly next to the display, you can assign a graphic to it to 
make the function of the function key more clear.

Display of assignment

Table 10-1 The following table shows which symbols display the assignment of the function keys:

Function key Description
Not assigned

Global assignment

Assigned locally in the template

Local assignment

Local assignment (local assignment of the template overwrites global 
assignment)
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Function key Description
Local assignment (local assignment overwrites global assignment)

Local assignment (local assignment overwrites local assignment of the template)

Local assignment (local assignment overwrites local assignment of the 
template, which already overwrites global assignment)

Assigning buttons with screen navigation
 

 Note
Basic Panels

The "Screen Navigation" editor is not available for Basic Panels.
 

 

10.1.5.2 Assigning function keys globally

Introduction
You define the global assignment of a function key in the "Global Screen" editor. The global 
assignment applies to all screens of the set HMI device.             

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Requirement
● You have opened the project.

● The Inspector window is open.
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Procedure
Proceed as follows to assign a screen-based function to a function key:

1. To open the "Global Screen" editor, double-click "Global Screen" in the "Screen 
management" group of the Project window.

2. Select the desired function key.
The properties of the function key are shown in the Inspector window.

3. Under "General", configure a graphic and an operator authorization for the function key.

4. Configure a function list for the required event under "Events".

Result
If a local assignment does not overwrite the global assignment, the assignment of the function 
key changes in all the screens of the set HMI device in accordance with your entry. 

10.1.5.3 Local assignment of function keys

Introduction
Function keys are assigned globally and locally. A local assignment of the function keys is only 
valid for the screen or the template in which it was defined. The following local function keys 
are available:

● Local function keys of a screen
Different functions are assigned to the function key for each screen. This assignment 
applies only to the screen in which you have defined the function key.

● Local function keys of a template
You assign the function keys in a template. The assignment applies to all the screens that 
are based on this template and are not overwritten by a local assignment in a screen.
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A local assignment overwrites the global assignment of a function key.         
 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Using existing assignments
The option for using existing assignments is referred to as follows in the Inspector window:

● In a template: "Use global assignment"

● In a screen:

– Screen based on a template: "Use local template"

– Screen not based on a template: "Use global assignment"

The "Use local template" option includes the use of the local assignment in the template and 
the global assignment.

Requirement
● You have opened the screen or the template in which you want to assign a function key 

locally.

● The Inspector window is open.

Procedure
Proceed as follows:

1. Select the desired function key in the screen or in the template.
The properties of the function key are shown in the Inspector window.

2. Click "General" in the Inspector window.
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3. Disable the "Use local template" or "Use global assignment" option.

4. Under "General", configure a graphic and an operator authorization for the function key.

5. Configure a function list for the required event under "Events".

Result
The function key is assigned the configured function in the screen or in the template. 

10.1.5.4 Assigning a function key to a function

Introduction
A function key can have two states:       

● Pressed: Defined by the "Key pressed" event.

● Released: Defined by the "Release key" event.

Both of these events are configured in the Inspector window of the function key. You can assign 
any event a function list which contains system functions or scripts. Execution of this function 
list is event-driven in runtime.

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

 Note
Basic Panels

Scripts are not available for Basic Panels.
 

Requirement
To assign the function key a global function: 

● The "Global Screen" editor is open.

To assign the function key a local function: 

● The screen in which you want to assign a function key is open.

If you want to assign a function key locally in a template: 

● The template in which you want to assign a function key is open.

● The Inspector window is open.
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Procedure
Proceed as follows:

1. Select the function key you want to define.
The properties of the function key are shown in the Inspector window.

2. Configure the function list for the desired result in the Inspector window under "Properties" 
in the "General" group.

Result
The function list is executed in runtime when the operator presses or releases the function 
key. 

10.1.5.5 Assigning operator authorization for a function key

Introduction
In WinCC you can assign an operator authorization for a function key in runtime. This allows 
you to restrict access to the function keys to specific persons or operator groups when you 
configure your project. Only authorized personnel can then change important parameters and 
settings in runtime.       

You configure access protection in order to avoid operator errors and increase plant or machine 
security.

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Requirement
● The user groups have been defined.

To protect a global function key: 

● The "Global Screen" editor is open.

If you want to protect a local function key of a screen or of a template: 

● The screen or the template which contains the function key is open.

● The Inspector window is open.
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Procedure
Proceed as follows:

1. Select the relevant function key.
The properties of the function key are shown in the Inspector window.

2. Click "General" in the Inspector window.

3. In the "Authorization" list, select the user group you want to allow runtime access to the 
function key.

Result
The operator authorization is configured. 

10.1.5.6 Assigning a function key to a graphic

Introduction
In order to make the function of a key more clear, you can insert a graphic in the screen 
alongside the function key. Graphics can only be assigned to function keys that border the 
screen margin of the HMI device.       

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
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Requirement
To assign a graphic to a global function key:

● The "Global Screen" editor is open.

If you want to assign a graphic to a local function key in a screen or template: 

● The screen or the template that contains the corresponding function key is open.

● The Inspector window is open.

● You have created the graphic for the function key.

Procedure
Proceed as follows:

1. Select the relevant function key.
The properties of the function key are shown in the Inspector window.

2. Click "General" in the Inspector window.
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3. Click in the "Graphic" area of the list.
The graphic browser of your WinCC project appears. The pane on the left side shows the 
external graphics which are stored in the browser. The pane on the right side shows you a 
preview of the graphic you have selected in the browser.

Using the  and  icons, you can display the collection either in form of thumbnails 
or as a list.
In order to open and edit OLE objects with the associated graphics program, double-click 
on the object.

4. In the browser click the desired graphic or store the relevant graphic in the graphic browser.
The graphic preview is shown in the right pane.

5. Click "Select" to add the graphic to the screen.
Click "Clear" to remove the graphic from the screen.

Result
The graphic is displayed next to the function key. 

10.1.5.7 Configuring LED tags

Requirements
● An HMI device with key operation has been created.  

● You have created an LED tag.

Procedure
1. Create a new screen.

2. Click an F-key of the HMI device.
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3. In the Inspector window, click "Properties > Properties > General".

4. Select a tag under "LED tag" in the "General > Settings" area.

5. Under "Bit" enter the correct bit number.
The correct bit number depends on the HMI device and the input and output assignments 
on the HMI device.

Assignment of inputs and outputs
The exact assignment of inputs and outputs can be found under: 

● PROFINET IO direct keys: Auto-Hotspot

● PROFIBUS DP direct keys: Auto-Hotspot
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10.1.5.8 Example: Using function keys for screen navigation

Task
In this example you create a local function key in a screen. When the operator presses this 
function key, a screen change to a predefined screen is triggered, for example "Boiler 2".     

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Requirement
● The screen in which you want to assign the function key is open.

● You have created the "Boiler 2" screen.

● The Inspector window is open.

Procedure
Proceed as follows to use the "ActivateScreen" function:

1. Select the desired function key.
The properties of the function key are shown in the Inspector window.

2. Click "General."

3. To overwrite a global assignment, disable the "Use local template" option.

4. Click "Key pressed" under "Events".
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5. Select the "ActivateScreen" system function from the list.
The "ActivateScreen" function appears in the "Function list" dialog box, including the 
"Screen name" and "Object number" parameters.

6. Select the "Boiler 2" screen from the "Screen name" list.

Result
The operator changes to the "Boiler 2" screen in runtime by pressing the selected function key.

10.1.6 Working with layers

10.1.6.1 Basics on working with layers

Layers
Use layers in order to achieve differentiated editing of the objects in a screen. A screen consists 
of 32 layers that you can give any names. If you assign objects to the layers, you thereby define 
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the screen depth. Objects of layer 0 are located at the screen background, while objects of 
layer 31 are located in the foreground. 

The objects of a single layer are also arranged hierarchically. When you create a screen, the 
object inserted first is located at the rear within the layer. Each further object is placed one 
position towards the front. You can shift objects forwards and backwards within a layer.

Principle of the layer technique
Always one layer of the 32 layers is active. New objects you add to the screen are always 
assigned to the active layer. The number of the active level is displayed in the inspector window 
of the screen and in the "Layout > Layers" task card. 

When you open a screen, all 32 layers of the screen are displayed. You can hide all the layers 
except for the active layer in the inspector window of the screen and in the "Layout > Layers" 
task card. You then explicitly edit objects of the active layer.

In the tree view of the "Layers" palette in the "Layout" task card, you administer layers and 
objects with drag-and-drop and the context menu.

Application examples
Use layers, for example, in the following cases:

● To hide the labeling of objects when editing,

● To hide objects, e.g. alarm windows, while configuring other objects

See also
Screen basics (Page 2931)

Renaming layers (Page 3047)

Show and hide layers (Page 3046)

Setting the active layer (Page 3044)

Moving objects between layers (Page 3044)
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10.1.6.2 Moving objects between layers

Introduction
By default, a new object is inserted on the active layer. You can, however, assign an object to 
another layer at a later time.     

Requirement
● A screen with an object is open.

● The Inspector window is open.

Procedure
1. Select the object in the screen.

The object properties are displayed in the Inspector window.

2. Enter the layer to which you want to move the object in "Properties > Properties > 
Miscellaneous > Layer" in the Inspector window.

Alternatively, select the object from the "Layout" task card and drag it to the required layer.

Changing the order of objects
1. Select the object in the screen.

The object properties are displayed in the Inspector window.

2. To move the object to the front or back, select the "Order" > "Move backward" or "Move 
forward" command from the shortcut menu.
Alternatively, use the  or  button in the toolbar.

Result
The object is assigned to the selected layer, and positioned at the top of the layer. 

See also
Basics on working with layers (Page 3042)

10.1.6.3 Setting the active layer

Introduction
The screen objects are always assigned to one of the 32 layers. There is always an active 
layer in the screen. New objects you add to the screen are always assigned to the active layer. 

The number of the active layer is indicated in the "Layer" toolbar. The active layer is indicated 
by the  icon in the "Layout > Layers" task card.
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Layer 0 is the active layer when you start programming. You can activate a different layer 
during configuration, if necessary.

Requirement
● You have opened a screen which contains at least one object.

● The Inspector window of the active screen is open.

Procedure
1. Click "Properties > Properties > Layers" in the Inspector window of the current screen.

2. Enter the layer number in "Settings > Active layer".

Alternative procedure
1. Select "Layout > Layers" in the "Layout" task card.

2. Select the "Set to active" command from the shortcut menu of a layer.

Result
The layer with the specified number is now active.

See also
Basics on working with layers (Page 3042)
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10.1.6.4 Show and hide layers

Introduction
You can show or hide the layers of a screen as required. You specify the layers that are shown 
in the Engineering System. When you open a screen, all the layers are always shown. 

Requirement
● The screen is opened.

● The "Layout" task card is open.

Procedure
1. Select the layer that you want to hide or show in the "Layout > Layers" task card.

2. Click one of the icons next to the corresponding layer:

–  A shown layer is hidden

–  A hidden layer is shown
 

  Note

The active layer cannot be hidden.
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Alternative procedure
1. Click in an area of the screen that does not contain an object.

The screen properties are shown in the Inspector window.

2. In the Inspector window, select "Properties > Properties > Layers":

3. In the list, disable the levels you wish to hide.
If you activate "All ES layers" for a layer, the objects in this layer will be shown in the 
Engineering System.

Result
The layers are shown according to your settings. 

See also
Basics on working with layers (Page 3042)

10.1.6.5 Renaming layers

Introduction
When you create a screen, the 32 layers are numbered consecutively by default. To improve 
clarity, you can rename the layers to suit your requirements.
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Requirement
● The screen is opened.

Procedure
1. Click in an area of the screen that does not contain an object.

The screen properties are shown in the Inspector window.

2. In the Inspector window, select "Properties > Properties > Layers".

3. Enter the new layer name.

Result
The layer is displayed with the new name. 

See also
Basics on working with layers (Page 3042)
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10.1.7 Working with faceplates

10.1.7.1 Basics on faceplates

Introduction
Faceplates are a configured group of display and control objects which you manage and 
change centrally in a library. You can use a faceplate in several projects as required. The 
faceplates are stored in the project library. 

Use
You use faceplates to create individually configured display and control objects. You can use 
faceplates several times in the project or in different projects. All instances of a faceplate in 
the project are changed centrally. This reduces the configuration effort.

Types and instances     
Faceplates are based on a type-instance model to support the central changeability. You 
create central properties for an object in types. The instances represent local application points 
of the types.

● Faceplate type 
You create a display and control object according to your requirements and store it in the 
project library. The instances are bound to the respective faceplate type. If you change a 
property of a faceplate type, the property is saved centrally and also changed in all 
instances. In the faceplate type, you define the properties that can be changed on the 
faceplate. You edit a faceplate type in the "Faceplates" editor.

● Faceplate 
The faceplate is an instance of the faceplate type. You use a faceplate in screens as a 
display and control object. You configure the variable properties of the faceplate type on 
the instance. You assign the tags of your project to the faceplate for example. If you 
configure properties on the faceplate, you overwrite the properties of the faceplate type. 
The changes on the faceplate are saved at the application point and have no effects on the 
faceplate type.

The figure below shows the relations between the faceplate type and the faceplate. The 
background color of the I/O field is configured in the faceplate type in such a way that every 
instance can change the property. Blue is used as a background color for the faceplate type. 
Use yellow as a background color for the faceplate. 
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When you change the background color in the faceplate type, this has no effect on the faceplate 
because the "Background color" property is assigned instance-specifically.

Device dependence of faceplates
Not all HMI devices support every display and screen object. The screen objects which are 
not available in the respective HMI device are not displayed when using the faceplate.

The following devices support faceplates:

Runtimes
● WinCC Runtime Advanced

● WinCC Runtime Professional

Comfort Panels
● KTP 400

● KP 400

● TP 700

● KP 700

● TP 900

● KP 900

● TP 1200

● KP 1200

● TP 1500

● KP 1500

● TP 1900

● TP 2200

Panels
● TP 277

● OP 277

Mobile Panels
● Mobile Panels

● Mobile Panel 277

● Mobile Panel 277 IWLAN V2

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277F IWLAN (RFID Tag)
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Multi Panels
● MP 277

● MP 377

See also
Faceplate editor (Page 3051)

Creating a faceplate type (Page 3054)

Screen basics (Page 2931)

Basics of dynamizing faceplates (Page 3069)

Example: Configuring a faceplate (Page 3070)

10.1.7.2 Faceplate editor

Open
Create faceplate types and edit them in the library view. 
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Layout
The library view for faceplate types consists of several editors, e.g. "Screens" and "Tags" which 
are arranged in the work area and the configuration area.

Work area
In the work area, place the objects contained in the faceplate type as you usually do in the 
"Screens" editor. You can remove objects, or use the "Toolbox" task card to add new objects.
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Configuration section
● Properties 

The static and dynamic properties are identified as follows: 

– The  symbol identifies a dynamic property. Dynamic implementation of this property, 
using tags or text and graphic lists.

– The  symbol identifies a static property. You change only the values of a static 
property.
 

 

  Note
Device dependency of static properties

Static properties are only available for panels and RT Advanced.
 

You define the faceplate type properties in the "Properties" tab.
You use the following two lists for this:

– The "Contained objects" list
This list includes the properties of the objects contained in the faceplate type. These 
properties can only be configured in the faceplate type in the "Faceplate" editor.

– The "Interface" list contains the properties and tags of the faceplate type. The "Interface" 
list consists of the pre-defined category "Dynamic properties" and user-defined 
categories.

● Events 
You define the faceplate type events in the "Events" tab. You use the following two lists for 
this:

– The "Contained objects" list contains the events of the objects embedded in the 
faceplate type.

– The "Interface" list contains the events of the faceplate.
You create links between the two lists using a drag and drop operation.

● Tags 
You can also create faceplate tags on the "Tags" tab. The tags are only available within 
the faceplate type. You can interconnect the faceplate type tags directly with an object 
contained in the faceplate type. 

● Scripts 
In the "Scripts" tab, you can configure scripts for the faceplate type. In the script, you can 
call up system functions or program new functions, for example to convert values. The 
scripts are only available within the faceplate type. They work with VB Script code.

 

  Note

The "Scripts" tab is not available for Runtime Professional.
 

● Text lists 
You can also create and edit texts lists for the faceplate type in the "Text lists" tab. These 
text lists are only available within the faceplate type. You can interconnect the text lists of 
the faceplate type directly with an object contained in the faceplate type, such as a symbolic 
I/O field.
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● Graphics lists 
If necessary, you can also create graphics lists for the faceplate type in the "Graphics lists" 
tab. These graphic lists are only available within the faceplate type. You can interconnect 
the graphic lists of the faceplate type directly with an object contained in the faceplate type, 
e.g. a graphic I/O field. 

● User texts 
The "User text" tab shows the contained user text of the opened faceplate type, for example 
entries from text lists. You can enter the compilations for the individual project languages 
directly in the "User text" tab. 

See also
Basics on faceplates (Page 3049)

Example: Configuring a faceplate (Page 3070)

10.1.7.3 Creating and managing faceplates

Creating a faceplate type

Introduction       
Faceplate types are display and control objects which are made up of several objects, e.g. 
controller modules. 

Requirement
You have opened a screen which contains multiple objects.

Procedure in the project view
1. Select all the objects that you need for the faceplate type.

2. Select the "Create faceplate type" command in the shortcut menu of the multiple selection.
A dialog opens. 

3. Enter a name for the faceplate. 

4. If necessary, add a comment or change the version number.

Result
The library view opens. Two versions of the type are displayed in the "types" folder. Version 
0.0.1 has been released and contains the currently selected objects. 

The 0.0.2 version has the status "in progress". Edit the faceplate type in version 0.0.2 as 
required.
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Procedure in the library view
1. The library view is open.

2. Select the "Create new type" command in the shortcut menu of the project library. A dialog 
opens.

3. Select the runtime for which the faceplate type is to be available. An empty faceplate type 
is created.

4. Drag-and-drop the objects from the "Toolbox" task card to the work area of the faceplate 
type. 

Result
The new faceplate type is created and displayed under the selected name in the project library. 

The faceplate type is assigned the status "in progress" and the version 0.0.1. 

See also
Configuring a faceplate type (Page 3055)

Configuring a tag in the faceplate type  (Page 3059)

Configuring an event in the faceplate type (Page 3060)

Configuring scripts in the faceplate type (Page 3061)

Creating an instance of the faceplate type (Page 3067)

Editing the faceplate type (Page 3065)

Basics on faceplates (Page 3049)

Example: Configuring a faceplate (Page 3070)

Editing the category and property of a faceplate type (Page 3058)

Configuring a graphics list in the faceplate type (Page 3063)

Configuring text lists in the faceplate type (Page 3062)

Removing faceplate object from faceplate (Page 3068)

Resizing a faceplate (Page 3066)

Configuring a faceplate type

Introduction
In the configuration area of the "Faceplates" editor you define which properties and process 
values of the objects contained in the faceplate can be configured in the "Properties" tab. 
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Requirement
● The faceplate is generated and is displayed in the "Faceplate" editor.

● The "Properties" tab is open in the configuration area.

Procedure
1. To create a new property, click the "Add property"  button in the interface list.

A new property is displayed in the "Interface" list.

2. To create a new category, click the "Add category"  button in the interface list.
A new category including a new property is displayed in the "Interface" list.

3. Click the name of the property and assign a name, for example, "Color".

4. Select the data type.

Interim result
You have created a new property.

1. Click an object in the "Contained objects" list.

2. Select a property, e.g. "Appearance > Background color".
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3. Move the property from the "Contained objects" list to the desired property in the "Interface" 
list by drag&drop.
The connection is displayed as a colored line.
The system assigns the same data type to the property in the "Interface" list as that of the 
property in the "Contained objects" list.
To change the data type, select the data type from the data types of the connected property. 

4. Repeat step 3 to connect other properties of the contained properties with the interface.
 

  Note

The property from the "Contained objects" list must be in concordance with the data type 
of the already connected property of the "Interface" list.

 

Deleting a connection     
1. Click the connection that you wish to delete.

2. In the shortcut menu select the "Delete" command or use the <DEL> key.
The connection is deleted.

Result
You have created a new property or a new category with a property. You have connected the 
property of the interface with a property of the contained objects. If you use an instance of the 
faceplate type in a screen, you configure the properties of the faceplate which you have created 
in the "Interface" list. 

 
 

 Note
Device dependency of static properties

Static properties are only available for panels and RT Advanced. You work with dynamic 
properties in RT Professional.
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See also
Creating a faceplate type (Page 3054)

Example: Configuring a faceplate (Page 3070)

Editing the category and property of a faceplate type

Deleting a property in the "Interface" list   
1. Select "Edit faceplate" in the shortcut menu. The "Faceplates" editor is open.

2. Select the property which you want to delete in the "Interface" list.

3. Select "Delete" in the shortcut menu.

The property is deleted from the "Interface" list. Existing connections to the contained objects 
are deleted. All linked faceplates lose their instance-specific property.

Deleting a category in the "Interface" list   
1. Select "Edit faceplate" in the shortcut menu. The "Faceplates" editor is open.

2. Select the category which you want to delete in the "Interface" list.

3. Select "Delete" in the shortcut menu.

The category including the properties is deleted from the "Interface" list. Existing connections 
to the contained objects are deleted. All linked faceplates lose their instance-specific properties.

Moving a property to another category
1. Select a property in the "Interface" list.

2. Move the property to a new category by "drag&drop".

You have moved the property to a new category.

Changing the data type of a property
1. Select a property in the "Interface" list.

2. Click the second column of the drop-down list.

3. Select a data type.

You have changed the data type of the property in the "Interface" list.

See also
Creating a faceplate type (Page 3054)
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Configuring a tag in the faceplate type 

Introduction
You connect a tag in the faceplate type directly with the properties of the objects contained in 
the faceplate type. The tags in the faceplate type are a central means of defining dynamic 
properties in the faceplate type.

The tags of a faceplate type have limited functionality. The "Tags" tab of the configuration area 
has the same structure as the "Tags" editor.

Array elements for faceplates
In the following situations you may not assign an array element or a multiplex tag that is 
interconnected with a faceplate to the property of a screen object.  

● The property is configured in a faceplate as parameter of a system function.

● System functions or scripts are assigned in the faceplate to events of the property.

Requirements
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● The "Tags" tab is open in the configuration area.

Procedure
1. Click "Add" in the "HMI tags" table. A new tag is created in the faceplate type.

2. Open "Properties > Events" in the inspector window if necessary. You configure the "Value 
change" event on the tag for example.

3. In the work area, select the object to which you want to assign this tag, e.g. an I/O field.

4. Select the tag in the inspector window of the I/O field "Properties > Properties > General > 
Process > Tag".

 

  Note

Only tags of the faceplate type are displayed in the object list in the "Faceplates" editor.
 

Result
You have created a tag in the faceplate type. You are using the tag in the faceplate for scripting, 
for example.

See also
Creating a faceplate type (Page 3054)

Example: Configuring a faceplate (Page 3070)
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Configuring an event in the faceplate type

Introduction
In the configuration area of the "Faceplates" editor you define which events of the objects 
contained in the faceplate can be configured in the "Events" tab. You configure a function list 
on the events of the faceplate in the "Screens" editor.

Requirement
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● The "Events" tab of the configuration area is open.

Procedure
1. Click an object in the "Contained objects" list.

2. Select an event, e.g. "Activate".

3. Move the event from the "Contained objects" list to a new category in the "Interface" list.
The new event is displayed in the "Interface" list.
The connection appears as a colored line.

4. Double-click the event and, if required, change the name of the event.
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Result
You have created an event in the faceplate type. if you use an instance of the faceplate type, 
you will only be offered the configured events in the inspector window. You configure a function 
list on the event in the faceplate. 

See also
Creating a faceplate type (Page 3054)

Example: Configuring a faceplate (Page 3070)

Configuring scripts in the faceplate type

Introduction
In the configuration area of the "Faceplates" editor you create scripts which you only use within 
a faceplate type. You can only refer to tags of the faceplate type or properties of the contained 
objects within the script. The script is used as a copy in the instance of the faceplate type. 

Requirement
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● Faceplate tags or dynamic properties have been created.

Procedure
1. Click the "Scripts" tab in the configuration area of the faceplate.

2. Double click "Faceplate scripts > Add VB script".

3. Write the program code.
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4. Press the shortcut keys <CTRL+J> to Include tags of the faceplate type in the script. The 
object list opens.

5. Click "HMI tags".
All tags of the faceplate type are displayed in the object list.

6. Select a tag and confirm the selection.

7. Press the shortcut keys <CTRL+J> to use properties of the faceplate type in the script. The 
object list opens.

8. Click "Properties".
All dynamic properties of the "Interface" list for the faceplate type are displayed in the object 
list.

Result
You have created a script in the faceplate type. The instance of the faceplate type uses a copy 
of the script. The script is executed in runtime depending on the configuration. 

See also
Creating a faceplate type (Page 3054)

Example: Configuring a faceplate (Page 3070)

Configuring text lists in the faceplate type

Introduction
In a faceplate type, you connect a text list with an object included in the faceplate type. Text 
is assigned to the values of a tag in a text list. The text list is used, for example, to display a 
selection list in a symbolic I/O field contained in the faceplate type. The interface between the 
text list and a tag of the faceplate type is configured at the object that uses the text list.

Requirements
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● The "Text list" tab is open in the configuration range.

● A tag has been created in the faceplate type.

Procedure
1. Click "Add" in the "Text lists" table. A new text list is created in the faceplate type.

2. Assign a name to the text list that indicates its function.

3. Select the text list type, e.g. "Value/Range" under "Select".

4. Click "Add" in the "Text list entries" table.
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5. Define the values or range of values for the text list.

6. Enter a text for every value range which is displayed in Runtime when the tag is within the 
specified value range.

7. Select an object, for example a button in the work area of the faceplate type.

8. In the Inspector window of the object, enable "Properties > Properties > General > Label > 
Text list".

9. Select the "Text list" from the selection list.

10.Select a tag of the faceplate type under "Process > Tag".

Result
You have created a text list in the faceplate type. This text list is linked to an object contained 
in the faceplate type. You have configured a faceplate type tag at the object. 

See also
Creating a faceplate type (Page 3054)

Configuring a graphics list in the faceplate type

Introduction
In a graphics list, specific graphics are assigned to possible values of a tag. In a faceplate type, 
you connect a graphics list with an object included in the faceplate type. Graphics are assigned 
to the values of a tag in a graphics list. For example, the graphics list is used to display a 
selection list in a graphic I/O field contained in the faceplate type. The interface between the 
graphics list and a tag of the faceplate type is configured at the object that uses the graphics 
list.

Requirements
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● The "Graphics list" tab is open in the configuration range.

● A tag has been created in the faceplate type.

Procedure
1. Click "Add" in the "Graphics lists" table. A new graphics list is created in the faceplate type.

2. Assign a functional name to the graphics list.

3. Select a graphics list type, e.g. "Range (... - ...)", under "Selection".

4. Click "Add" in the "Graphics list entries" table. A new entry is created in the list.

5. Define the values or range of values for the graphics list.
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6. Select a graphic for every value or value range which is displayed in runtime when the tag 
is within the specified value range.

7. Select an object, e.g. a graphic I/O field, in the work area of the faceplate type.

8. Activate "Properties > Properties > General > Contents > Graphics list" in the object's 
Inspector window.

9. Select the "Graphics list" from the selection list.

10.Select a tag of the faceplate type in "Process > Tag".

Result
You have created a graphics list in the faceplate type. This graphics list is linked to an object 
contained in the faceplate type. You have configured a faceplate type tag at the object.

See also
Creating a faceplate type (Page 3054)

Translating texts directly in the faceplate type

Translating texts   
If you use several languages in your project, you can translate individual texts directly. As soon 
as you change the language of the software user interface, the translated texts are available 
in the selected language.

Requirements
● A project is open.

● You have opened the "Faceplates" editor.

● You have created a faceplate type.

● The faceplate type contains at least one object with text, e.g. a text field.

Procedure
Proceed as follows to translate individual texts:

1. Open the "Tasks" task card.

2. Click the  button under "Languages & Resources > Editing language". The "Project 
languages" editor opens.

3. Activate at least two project languages.
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4. Open the "Texts" tab in the "Faceplates" editor.
A list with the texts in the project is displayed in the work area. There is a separate column 
for each project language.

5. Click on the  button in the toolbar to group identical texts together.

6. To hide texts that do not have a translation, click on the  button in the toolbar.

7. Click on an empty column and enter the translation.

Result
You have translated individual texts in the "Texts" tab of the faceplate type. The texts will then 
be displayed in the runtime language.

Editing the faceplate type

Introduction   
All faceplate types in the project library have a status. You create a faceplate type in the "in 
progress" status. You can edit the faceplate types as required in this status. When editing is 
complete, release the faceplate type.

Requirement
● A faceplate type has been created.

● The faceplate type has the version 0.0.1. and the status "in progress".

● The "Library" task card or the library view is open.
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Enable faceplate type   
1. Select version 0.01 of the faceplate type in the project library.

2. Select "Enable faceplate type" in the shortcut menu.

You have enabled version 0.0.1 of the faceplate type.

Edit faceplate type  
1. In the project library select, for example, the enabled version 0.0.1 of a faceplate type.

2. Select "Edit faceplate type" in the shortcut menu. 

The library view opens. The new version 0.0.2 of the faceplate type has been created.

The faceplate type has the "In progress" status. 

Restoring the last version of the faceplate type
The last enabled version of the faceplate type is version 0.0.2. 

Edit the faceplate type. A new version 0.0.3 is created and the "in progress" status is assigned 
to it.

1. Select the faceplate type from the project library.

2. Select "Discard changes and restore type" in the shortcut menu.

All changes to the faceplate type since the last enabling operation are rejected. The faceplate 
type is enabled again and has the version 0.0.2. 

See also
Creating a faceplate type (Page 3054)

Example: Configuring a faceplate (Page 3070)

Resizing a faceplate

Introduction
In the faceplate type, specify the response of the faceplate when it is resized.        

Requirements
● A faceplate type has been created.

● You have opened the "Faceplates" editor.

● The Inspector window is open.
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Specifying the response to resizing
1. Activate "Properties > Properties > Layout > Fit to size > Auto-size."

2. Select the "Fixed aspect ratio" setting, for example.
This setting retains the aspect ratio when you resize the faceplate.

3. Click the faceplate in the "Libraries" task card.

4. Select "Enable faceplate type" in the shortcut menu.

Result
You have specified how the faceplate responds when its size in a screen is changed. You can 
change the response for a particular faceplate. 

Select a faceplate in the screen. Select the required setting in "Properties > Properties > Layout 
> Characteristics" in the Inspector window. 

See also
Creating a faceplate type (Page 3054)

Creating an instance of the faceplate type

Introduction
The faceplate type is stored in the project library. If you use the faceplate type in a screen, you 
create an instance of the faceplate type.       

 

 Note

Note that a faceplate is always configured for a particular class of HMI devices. For example, 
you cannot use a faceplate type that is configured for "RT Professional" in a screen on an 
"RT Advanced" HMI device.

 

Requirement
● A screen is open.

● The "Libraries" task card is opened.

● The project library is open and it contains at least one faceplate type.
 

  Note

Faceplate types are also stored in global libraries. When you add a faceplate type from 
the global library to the screen, the system automatically saves a copy of it to the project 
library.

 

● The Inspector window is open.
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Procedure
1. Move the desired faceplate type from a library to the screen by drag&drop.

Result
You have created an instance of the faceplate type. The instance is given the version number 
of the most recently released type.

Configure the properties of the faceplate in the Inspector window as required. To dynamize 
the faceplate, open the interface in the Inspector window.

 

See also
Creating a faceplate type (Page 3054)

Example: Configuring a faceplate (Page 3070)

Removing faceplate object from faceplate

Introduction
Cancel application, to remove specified instances from the update of the faceplate type. 

Requirement
● A faceplate type has been created.

● The faceplate must be used in a minimum of one screen.

Disconnect the faceplate object from faceplate type.    
1. Select a faceplate on the screen.

2. In the shortcut menu, select "Disconnect faceplate object from faceplate type".

Result
The faceplate is independent of the associated faceplate type. Changes to the faceplate type 
are not updated in the faceplate. 

See also
Creating a faceplate type (Page 3054)
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10.1.7.4 Dynamizing faceplates

Basics of dynamizing faceplates

Application
You can dynamically control events and properties of faceplates in two ways:   

● Dynamically controlling faceplates
You configure the events or dynamic properties individually for the application point on the 
faceplate. To do this, define in the "Faceplates" editor that these properties and events are 
configurable in the faceplate. To dynamize the faceplates in the "Screens" editor, use the 
scripts and tags that are created in the project. 

● Dynamizing the faceplate type 
You dynamize the objects which are contained in the faceplate type in the "Faceplates" 
editor. You configure the individual objects as in the "Screens" editor. Tags and scripts are 
available in the "Faceplates" editor to dynamize properties and events. You do not have 
access to the tags and scripts of the project within the faceplate. 
Every faceplate created with the faceplate type has the same preconfigured dynamization. 
You can edit this dynamic control only in the "Faceplates" editor. 

Animation
WinCC provides preconfigured dynamic control in the "Animations" task card. You use 
animations to dynamize faceplates and faceplate types. 

See also
Basics on faceplates (Page 3049)

Example: Configuring a faceplate (Page 3070)

Dynamizing faceplates

Introduction   
You dynamize a faceplate in exactly the same way as you dynamize an object from the "Tools" 
task card. 

You connect the dynamic properties of the faceplate in the "Screens" editior with a tag or a 
script which supplies values to the property in runtime.

You Include tags and scripts which you have created in the project for the faceplate.
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Requirement
● A faceplate is inserted in the screen.

Procedure
1. Select the faceplate.

2. In the Inspector window, open "Properties > Animation".
The animations available for the selected object are displayed. 

3. Select "Horizontal movement" and click the  button.
The parameters of the animation are displayed.
A transparent copy of the object is shown in the work area, which is connected to the source 
object by means of an arrow.

4. Select a tag for control of movement.

5. Move the object copy to the relevant destination. The system automatically enters the pixel 
values of the final position in the Inspector window.

6. Customize the range of values for the tag as required.

Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. The direction of movement corresponds to the configured type of 
movement "horizontal".

10.1.7.5 Examples of faceplates

Example: Configuring a faceplate

Introduction
In this example you create a faceplate in which you can convert the value of a length measuring 
system from kilometers into meters. The length in meters is displayed in an output field.  

Procedures overview
The example is divided into the following steps:

1. Creating a faceplate type

2. Configuring a faceplate type

3. Creating a script in the faceplate type

4. Connecting a script with the contained objects of the faceplate type

5. Creating a faceplate and connecting with a tag
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See also
Basics on faceplates (Page 3049)

Example: Creating an instance of the faceplate type (Page 3075)

Example: Configuring included objects (Page 3075)

Example: Creating a script in the faceplate type (Page 3073)

Example: Configuring a faceplate type (Page 3072)

Example: Creating a faceplate type (Page 3071)

Example: Creating a faceplate type

Task
You create a faceplate type.   

Requirement
● A screen is open.

● The toolbox window is displayed.

Settings
For the example you require objects with the following settings:

Object Object name Properties
Text field Label_Meter Text: Meter
I/O field Output_Meter Mode: Output
Button KM_to_Meter Text OFF: Convert

Procedure
1. In the toolbox, click the individual objects and drag&drop the objects into the screen.

2. Set the properties as shown above.

3. Select all objects.

4. Select the "Create faceplate type" command in the shortcut menu of the multiple selection.
The library view opens.

5. In the Inspector window, click "Properties > Properties > Miscellaneous".

6. Enter "KMtoMeter" as the name.
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Result
The faceplate types appears in the project library under the name "KMtoMeter". The faceplate 
type is assigned the "in progress" status.

See also
Example: Configuring a faceplate (Page 3070)

Example: Configuring a faceplate type

Job
You create the dynamic property and tag of the faceplate type.  

Creating a new property
1. Click "Properties" in the configuration area of the faceplate.

2. In the "Interface" list, click the  icon "Add property".
A new property is added to the "Interface" list.

3. Double click the name of the property and enter "KMToMeter".

4. Click the selection list and select the data type "Int".

Interim result
The "KMToMeter" property is displayed in the "Interface" list. The symbol identifies the dynamic 
property. The property will be linked to a tag in the next step.

Creating a tag in the faceplate type   
1. Click "Tags" in the configuration area.

2. Click "Add" in the "HMI tags" table. A new tag is added to the table. The inspector window 
of the tag is opened.

3. In the Inspector window, select "Properties > Properties > General":

4. Enter "BB_Tag" as the name. Select the "Int" data type.
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Result
The "KMToMeter" property and the "BB_Tag" of the faceplate type are created in the 
configuration area of the "Faceplates" editor.

See also
Example: Configuring a faceplate (Page 3070)

Example: Creating a script in the faceplate type

Task
You create a script that converts the value of a length measuring system from kilometers to 
meters.  

Procedure
1. Click "Scripts > Faceplate scripts" in the configuration area.

2. Double click "Add VB script".

3. Press the shortcut keys <CTRL+J>.
The object list opens. 

4. Click "HMI tags".
The faceplate tag "BB_Tag" is displayed in the object list.

5. Select the faceplate type tag "BB_Tag". Confirm the selection.

6. Insert an "=" sign.

7. Press the shortcut keys <CTRL+J>. The object list is opened.
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8. Click "Properties."
The dynamic property "KMtoMeter" is displayed in the object list.

9. Select the "KMToMeter" dynamic property. Confirm the selection.

10.Enter "*1000" at the end of the code. This corresponds to the conversion factor from 
kilometers to meters.

11.Enter the name "Script_1" under "Properties > Properties > General >Setting > Name" in 
the Inspector window.

Result
The script has been created in the faceplate type. If you use the "KMtoMeter" faceplate type 
in a screen, you assign a tag to the "KMtoMeter" property. The value of this tag is multiplied 
by factor 1000 and assigned to the tag of the faceplate type "BB_Tag" as a new value. In this 
way you supply values to the tags of the faceplate type. 

See also
Example: Configuring a faceplate (Page 3070)
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Example: Configuring included objects

Task
You connect the included objects in the faceplate "KMtoMeter" to a faceplate tag and a 
faceplate script. 

You connect the I/O field with the "BB_Var" tag of the faceplate type. You connect the "Click" 
event for a button to the script "Script_1".  

Requirement
The faceplate is displayed in the "Faceplates" editor.

Interconnecting I/O field with a tag
1. Select the "Output_Meter" I/O field in the faceplate.

2. Connect the I/O field with the faceplate tag "BB_Tag" in the "General > Process > Tag" 
inspector window.

Connecting an event to a faceplate script
1. Select the "KM_to_Meter" button in the faceplate.

2. Select "Script_1" in the inspector window under "Events > Click".

Result
The I/O field is connected with the tag of the faceplate type. The button is connected with the 
script of the faceplate type. 

If you click the button of the faceplate during runtime, the script is executed. The value of the 
tag of the faceplate is output in the I/O field. 

See also
Example: Configuring a faceplate (Page 3070)

Example: Creating an instance of the faceplate type

Task
You insert the faceplate type "KMtoMeter" in a screen and assign a tag to the dynamic property 
"KMtoMeter".
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Requirement
● The "Screens" editor is open.

● A new screen has been created.

Settings
For the example you require a tag with the following settings:

Name PLC connection Type
Kilometer No ULong

Procedure
1. Create the HMI tag "Kilometer" with the settings named above.

2. Open the  "project library" in the "Libraries" task card.

3. Move the "KMtoMeter" faceplate type into the screen by drag&drop.

4. Click "Properties > Properties > Interface" in the Inspector window.
The table shows all the properties which you can dynamize in the faceplate.

5. Click the "Dynamization" column in the "KMtoMeter" line.

6. Select "HMI tag".

7. Click the "..." button.

8. Select the tag "Kilometer" from the object list.

9. Confirm the selection.

Result
The dynamic property "KMtoMeter" is linked with the "Kilometer" tag. During runtime the 
dynamic property is supplied with values of the "Kilometer" tag. The values are multiplied by 
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factor 1000 in the script of the faceplate type and assigned to the tag in the faceplate as a new 
value.

See also
Example: Configuring a faceplate (Page 3070)

10.1.8 Indicator and control objects

10.1.8.1 Device-Specific Nature of the Objects

Objects for Basic Panels

Availability of display and operating elements for Basic Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Basic Panels. 

Overview

 KP300 Basic
KP400 Basic

KTP400 Basic
KTP600 Basic
KTP1000 Basic
TP1500 Basic

Bar Yes Yes
User view Yes Yes
Date/time field Yes Yes
I/O field Yes Yes
Ellipse Yes Yes
Graphic view Yes Yes
Graphic I/O field Yes Yes
Help indicator Yes No
Circle Yes Yes
Trend view Yes Yes
Line Yes Yes
Alarm view
Alarm window

Yes Yes

Alarm indicator Yes Yes
Rectangle Yes Yes
Recipe view Yes Yes
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 KP300 Basic
KP400 Basic

KTP400 Basic
KTP600 Basic
KTP1000 Basic
TP1500 Basic

Button Yes Yes
Switch Yes Yes
Symbolic I/O field Yes Yes
System diagnostics view Yes Yes
Text field Yes Yes

See also
Objects for Panels (Page 3078)

Objects for Comfort Panels (Page 3080)

Objects for Multi Panels (Page 3081)

Objects for Mobile Panels (Page 3083)

Objects for WinCC Runtime Advanced (Page 3084)

Objects for Panels

Availability of display and operating elements for Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Panels. 

Overview

 OP 73 OP 77A
OP 77B

TP 177A TP 177B
OP 177B

TP 277
OP 277

Bar Yes Yes Yes Yes Yes
User view Simple Simple Simple Yes Yes
Date/time field Yes Yes Yes Yes Yes
I/O field Yes Yes Yes Yes Yes
Ellipse No No Yes Yes Yes
f(x) trend view No No No No No
Function key only on keyboard units
Graphic view Yes Yes Yes Yes Yes
Graphic I/O field Yes 1) Yes 1) Yes 1) Yes Yes
Handwheel No No No No No
Help indicator Yes No No No No
HTML Browser No No No No No
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 OP 73 OP 77A
OP 77B

TP 177A TP 177B
OP 177B

TP 277
OP 277

Circle No No Yes Yes Yes
Trend view No No Yes Yes Yes
Charging condition No No No No No
Illuminated pushbutton No No No No No
Line No No Yes Yes Yes
Media Player No No No No No
Alarm view 
Alarm window 

Simple Simple Simple Yes Yes

Alarm indicator Simple No Simple Yes Yes
Polygon No No No Yes Yes
Polyline No No No Yes Yes
Rectangle No No Yes Yes Yes
Recipe view No Simple Simple Yes Yes
Button Yes Yes Yes Yes Yes
Switch Yes 2) Yes 2) Yes 2) Yes Yes
Slider No No No Yes Yes
Key switch No No No No No
Sm@rtClient view No No No Yes Yes
Status/Force No No No Yes Yes
Symbol library No No No Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes
System diagnostics view No No No No No
System diagnostics 
window

No No No No No

Text field Yes Yes Yes Yes Yes
Clock No No No No No
Effective range signal No No No No No
Effective range name No No No No No
Effective range name 
(RFID)

No No No No No

WLAN reception No No No No Yes
Gauge No No Yes Yes Yes
Zone name No No No No No
Zone signal No No No No No

1) Only two different graphics can be used.
2) Only the "Switch with text" and "Switch with graphic" types can be used.

See also
Objects for Basic Panels (Page 3077)
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Objects for Comfort Panels

Availability of display and operating elements for Comfort Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects on 
Comfort Panels. 

Overview

 KP400 Comfort
KTP400 Comfort

KP700 Comfort
TP700 Comfort

KP900 Comfort
TP900 Comfort

KP1200 
Comfort
TP1200 
Comfort

TP1900 Comfort
TP2200 Comfort

Bar Yes Yes Yes Yes Yes
User view Yes Yes Yes Yes Yes
Date/time field Yes Yes Yes Yes Yes
I/O field Yes Yes Yes Yes Yes
Ellipse Yes Yes Yes Yes Yes
f(x) trend view Yes Yes Yes Yes Yes
Function key only on keyboard units  
Graphic view Yes Yes Yes Yes Yes
Graphic I/O field Yes Yes Yes Yes Yes
Handwheel No No No No No
Help indicator No No No No No
HTML browser No No No No No
Circle Yes Yes Yes Yes Yes
Trend view Yes Yes Yes Yes Yes
Charging condition No No No No No
Illuminated pushbutton No No No No No
Line Yes Yes Yes Yes Yes
Media Player Yes Yes Yes Yes Yes
Alarm view 
alarm window

Yes Yes Yes Yes Yes

Alarm indicator Yes Yes Yes Yes Yes
Polygon Yes Yes Yes Yes Yes
Polyline Yes Yes Yes Yes Yes
Rectangle Yes Yes Yes Yes Yes
Recipe view Yes Yes Yes Yes Yes
Button Yes Yes Yes Yes Yes
Switch Yes Yes Yes Yes Yes
Slider Yes Yes Yes Yes Yes
KeySwitch No) No No No No
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 KP400 Comfort
KTP400 Comfort

KP700 Comfort
TP700 Comfort

KP900 Comfort
TP900 Comfort

KP1200 
Comfort
TP1200 
Comfort

TP1900 Comfort
TP2200 Comfort

Sm@rtClient view Yes Yes Yes Yes Yes
Status/Force Yes Yes Yes Yes Yes
Symbol library Yes Yes Yes Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes
System diagnostics view Yes Yes Yes Yes Yes
System diagnostics 
window

Yes Yes Yes Yes Yes

Text field Yes Yes Yes Yes Yes
Clock Yes Yes Yes Yes Yes
Effective range signal No No No No No
Effective range name No No No No No
Effective range name 
(RFID)

No No No No No

WLAN reception No No No Yes Yes
Gauge Yes Yes Yes Yes Yes
Zone name No No No No No
Zone signal No No No No No

 

 

See also
Objects for Basic Panels (Page 3077)

Objects for Multi Panels

Availability of display and operating elements for Multi Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Multi Panels. 

Overview

 MP 177 MP 277 MP 377
Bar Yes Yes Yes
User view Yes Yes Yes
Date/time field Yes Yes Yes
I/O field Yes Yes Yes
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 MP 177 MP 277 MP 377
Ellipse Yes Yes Yes
f(x) trend view No No No
Function key only on keyboard units
Graphic view Yes Yes Yes
Graphic I/O field Yes Yes Yes
Handwheel No No No
Help indicator No No No
HTML browser No No No
Circle Yes Yes Yes
Trend view Yes Yes Yes
Charging condition No No No
Illuminated pushbutton No No No
Line Yes Yes Yes
Media Player No No Yes
Alarm view, 
Alarm window

Yes Yes Yes

Alarm indicator Yes Yes Yes
Polygon Yes Yes Yes
Polyline Yes Yes Yes
Rectangle Yes Yes Yes
Recipe view Yes Yes Yes
Button Yes Yes Yes
Switch Yes Yes Yes
Slider Yes Yes Yes
Key switch No No No
Sm@rtClient view Yes Yes Yes
Status/Force Yes Yes Yes
Symbol library Yes Yes Yes
Symbolic I/O field Yes Yes Yes
System diagnostics display No No No
System diagnostics window No No No
Text field Yes Yes Yes
Clock Yes Yes Yes
Effective range signal No No No
Effective range name No No No
Effective range name (RFID) No No No
WLAN reception No No No
Gauge Yes Yes Yes
Zone name No No No
Zone signal No No No
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See also
Objects for Basic Panels (Page 3077)

Objects for Mobile Panels

Availability of display and operating elements for Mobile Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Mobile Panels. 

Overview

 Mobile Panel 
177 DP

Mobile Panel 
177 PN

Mobile Panel 
277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN 
V2

Mobile Panel 
277F IWLAN 
(RFID Tag)

Bar Yes Yes Yes Yes Yes Yes
User view Yes Yes Yes Yes Yes Yes
Date/time field Yes Yes Yes Yes Yes Yes
I/O field Yes Yes Yes Yes Yes Yes
Ellipse Yes Yes Yes Yes Yes Yes
f(x) trend view No No No No No No
Function key Yes Yes Yes Yes Yes Yes
Graphic view Yes Yes Yes Yes Yes Yes
Graphic I/O field Yes Yes Yes Yes Yes Yes
Handwheel Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Help indicator No No No No No No
HTML browser No No No No No No
Circle Yes Yes Yes Yes Yes Yes
Trend view Yes Yes Yes Yes Yes Yes
Charging condition No No No Yes Yes Yes
Illuminated pushbutton Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Line Yes Yes Yes Yes Yes Yes
Media Player No No No No No No
Alarm view, 
Alarm window

Yes Yes Yes Yes Yes Yes

Alarm indicator Yes Yes Yes Yes Yes Yes
Polygon Yes Yes Yes Yes Yes Yes
Polyline Yes Yes Yes Yes Yes Yes
Rectangle Yes Yes Yes Yes Yes Yes
Recipe view Yes Yes Yes Yes Yes Yes
Button Yes Yes Yes Yes Yes Yes
Switch Yes Yes Yes Yes Yes Yes
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 Mobile Panel 
177 DP

Mobile Panel 
177 PN

Mobile Panel 
277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN 
V2

Mobile Panel 
277F IWLAN 
(RFID Tag)

Slider Yes Yes Yes Yes Yes Yes
Key switch Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Sm@rtClient view No Yes Yes Yes Yes Yes
Status/Force Yes Yes Yes Yes Yes Yes
Symbol library Yes Yes Yes Yes Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes Yes
System diagnostics 
display

No No No No No No

System diagnostics 
window

No No No No No No

Text field Yes Yes Yes Yes Yes Yes
Clock No No Yes Yes Yes Yes
Effective range signal No No No No Yes Yes
Effective range name No No No No Yes No
Effective range name 
(RFID)

No No No No No Yes

WLAN reception No No No Yes Yes Yes
Gauge Yes Yes Yes Yes Yes Yes
Zone name No No No Yes Yes No
Zone signal No No No Yes Yes No
1) optional operator control

 

 

See also
Objects for Basic Panels (Page 3077)

Objects for WinCC Runtime Advanced

Availability of display and operating elements for WinCC Runtime Advanced           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
WinCC Runtime Advanced. 
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Overview

 WinCC Runtime Advanced
Bar Yes
User view Yes
Date/time field Yes
I/O field Yes
Ellipse Yes
f(x) trend view Yes
Function key No
Graphic view Yes
Graphic I/O field Yes
Handwheel No
Help indicator No
HTML browser Yes
Circle Yes
Trend view Yes
Charging condition No
Illuminated pushbutton No
Line Yes
Media Player No
Alarm view, 
Alarm window

Yes

Alarm indicator Yes
Polygon Yes
Polyline Yes
Rectangle Yes
Recipe view Yes
Switch Yes
Button Yes
Slider Yes
Key switch No
Sm@rtClient view Yes
Status/Force Yes
Symbol library Yes
Symbolic I/O field Yes
System diagnostics display Yes
System diagnostics window Yes
Text field Yes
Clock Yes
Effective range signal No
Effective range name No
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 WinCC Runtime Advanced
Effective range name 
(RFID)

No

WLAN reception No
Gauge Yes
Zone name No
Zone signal No

See also
Objects for Basic Panels (Page 3077)

10.1.8.2 Objects

Bar

Application  
The tags are displayed graphically using the "Bar" object. The bar graph can be labeled with 
a scale of values.

Layout  
In the Inspector window, you customize the settings for the position, shape, style, color, and 
font types of the object. You can adapt the following properties in particular:

● Color transition: Specifies the change in color display when limit values are exceeded.

● Displaying the limit lines / limit markers: Shows the configured limit as a line or marker.

● Define bar segments: Defines the gradations on the bar scale.

● Define scale gradation: Defines the subdivisions, scale markings and intervals of a bar 
scale.

Color transition   
You define how the color change is represented in "Properties > Properties > Appearance" in 
the Inspector window.

Color transition Description
"Segmented" If a particular limit was reached, the bar changes color segment by segment. 

With segment by segment representation, you visualize, for example, which 
limits are exceeded by the displayed value.

"Entire bar" If a particular limit was reached, the entire bar changes color.
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Displaying limit lines and limit markers   
You display the configured limit in the bar as a line or marking in Runtime using the "Lines" 
and "Markings" property:

1. In the Inspector window, select "Properties > Properties > Appearance":

2. Activate "Lines" and "Markings".

Define bar segments  
Use the "Subdivisions" property to define the number of segments into which the bar is divided 
by the main gradations on the scale. 

Use the "Interval" property to divide the distance between the main gradations. The value 
appears as the difference in value between two adjacent main gradations:

1. In the Inspector window, select "Properties > Properties > Scales":

2. Activate "Show scale."

3. Select the corresponding value for "Settings > Subdivisions".

4. Select the corresponding value for "Settings > Marks label".

5. Select the corresponding value for "Large interval > Interval".

See also
Device-Specific Nature of the Objects (Page 3077)

User view

Application 
The "User view" object is used to set up and administer users and authorizations. The user 
view is used, for example, to create new users in runtime and assign them to a user group.

 

 Note

Configure only one user view at a time in one screen on the HMI devices TP 177A 6", TP 
177A 6" (Portrait), OP 73 and OP 77A. Otherwise, a corresponding error message appears 
during generation. 
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Complex user view   
The complex or simple user view is available for administration of users and authorizations 
depending on the HMI devices.

Simple user view   

Proceed as follows to configure the appropriate user view:

1. Click "Properties > Properties > Layout > Mode" in the inspector window.

2. Select "Simple" or "Complex".

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Number of lines: Specifies the maximum number of visible entries.

● Columns moveable: Specifies whether the operator can change the sequence of columns 
in Runtime.

Number of lines  
The number of lines in the user view displayed in Runtime is specified in the Inspector window. 
The setting for the number of lines is only effective if "Fit object to contents" is active.

1. Click "Properties > Properties > View" in the Inspector window.

2. Enter an integer value under "Number of lines".

3. In the Inspector window, select "Properties > Properties > Layout".

4. Activate "Fit object to contents."
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Columns moveable  
The operator can change the sequence of columns in Runtime with the "Columns movable" 
property.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Columns moveable".

This option is only available at the complex user view.

See also
Device-Specific Nature of the Objects (Page 3077)

Configuring a user view (Page 3519)

Complex user view (Page 3518)

Creating users (Page 3519)

Basic user view (Page 3516)

Date/time field

Application   
The "Date/time field" object shows the system time and the system date. The appearance of 
the "Date/time field" depends on the language set on the HMI device.

Layout   
In the Inspector window, you customize the position, style, colors and font types of the object. 
You can adapt the following properties in particular:

● Display system time: Specifies that the system time is displayed.

● Include tag: Specifies that the time of the connected tag is displayed.

● Long date/time format: This setting defines the format displayed for the data and time.

Display system time     
The time displayed in the "Date/time field" on the HMI device is specified in the inspector 
window.

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "Format > System time".
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Using tags     
The time of the interconnected tag is displayed in the date/time field.

1. In the Inspector window, select "Properties > Properties > General".

2. In the "Format" area, select a tag with the "DateTime" data type, e.g. an internal tag.

Long date/time format     
Visualization of the date and time is specified in the "Format" area under "General" in the 
inspector window.

Option Description
"Enabled" Date and time are displayed in full, e.g. "Sunday, December 31, 2000 10:59:59 

AM"
"Disabled" Date and time are displayed in short form, e.g. "12/31/2000 10:59:59 AM"

See also
Device-Specific Nature of the Objects (Page 3077)

Example: 2. Configuring a Date/time field (Page 4908)

I/O field 

Application  
The "I/O field" object is used to enter and display process values.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Display format: Specifies the display format in the I/O field for input and output of values.

● Hidden input: Specifies whether the input value is displayed normally or encrypted during 
input.

 

  Note
Reports

In reports, I/O fields only output data. "Output" mode is preset. Properties for configuring 
input are not available, e.g. "hidden input".

 

Mode   
The response of the I/O field is specified in the Inspector window in "Properties > Properties 
> General > Type".

Mode Description
"Input" Values can only be input into the I/O field in runtime.
"Input/output" Values can be input and output in the I/O field in runtime.
"Output" The I/O field is used for the output of values only.

Layout  
The "display format" for the input and output of values is specified in "Properties > Properties 
> General > Format" in the Inspector window.

Layout  
"Binary" Input and output of values in binary form
"Date" Input and output of date information. The format depends on the language setting 

on the HMI device.
"Date/time" Input and output of date and time information. The format depends on the 

language setting on the HMI device.
"Decimal" Input and output of values in decimal form
"Hexadecimal" Input and output of values in hexadecimal form
"Time" Input and output of times. The format depends on the language setting on the HMI 

device.
"Character string" Input and output of character strings.
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 Note
Data formats

Not all data formats are available for selection for Runtime Professional.
 

Hidden input   
In Runtime the input can be displayed normally or encrypted, for example for hidden input of 
a password. A "*" is displayed for every character during hidden input. The data format of the 
value entered cannot be recognized. 

1. In the Inspector window, select "Properties > Properties > Response":

2. Activate "Hidden input".

Avoid overlaps in output fields
If several I/O fields are configured as output fields with a transparent background in a screen, 
these I/O fields may overlap. The transparent part of the one field covers the digits of the other 
field. This may cause display problems in Runtime. In order to avoid such overlaps, set the 
margins of the I/O fields to zero in the object properties under "Properties > Properties > 
Appearance". Activate "Properties > Properties > Layout > Fit object to contents."

See also
Using multiple tags simultaneously in a screen (Page 3180)

Device-Specific Nature of the Objects (Page 3077)

Ellipse

Application 
The "Ellipse" is an enclosed object that can be filled with a color or pattern. 

Layout 
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Horizontal radius: Specifies the horizontal radius of the elliptical object.

● Vertical radius: Specifies the vertical radius of the elliptical object.
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Horizontal radius   
The horizontal radius of the "Ellipse" object is specified in the Inspector window. The value is 
entered in pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 under "Horizontal."

Vertical radius   
The vertical radius of the "Ellipse" object is specified in the Inspector window. The value is 
entered in pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 at "Vertical."

See also
Device-Specific Nature of the Objects (Page 3077)

Rotating objects (Page 2963)

Flipping objects (Page 2965)

f(x) trend view

Application   
You use the "f(x) trend view" object to represent the values of a tag as a function of another 
tag. This means that you can present temperature trends as a function of the pressure, for 
example. You can also compare the trend to a setpoint trend. 
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Layout   
In the Inspector window, you customize the position, shape, style, colors and font types of the 
object. You can adapt the following properties in particular:

● Adding and configuring trends

● Configuring a diagram

● Window settings

● Persistence

● Toolbar

Configuring trends
You create and configure trends in the Inspector window "Properties > Properties > Properties 
> Trend".

1. Select the data supply for the trend in the "Data source" column. 

– "Log tag": The trend window is supplied with values from a data log.

– "Tags": The trend view is supplied with current values from the PLC. The values are 
constantly updated.

2. Configure the area of the trend display under "Data area".

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

3. Configure the value range of the trend display under "X axis" and "Y axis".

4. Under "Limits", configure the colored marking of specific values, .e.g.. high and low limit, 
uncertain status.

Configuring a diagram
Configure the display of several trends under "Properties > Properties > Appearance":

● Common diagram or separate diagrams

● Common or separate axes

● Writing direction of all trends
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Toolbar       
The control elements of the f(x) trend display are defined in the "Properties > Properties > 
Toolbar" inspector window. The following control elements are available for the f(x) trend view:

Button Name Function
Zoom +/- Increases or decreases the size of the trends in the trend window. 

Increase the size of the trends by left-clicking with the mouse. Hold 
down <Shift> and left-click to decrease the size of the trends.

Zoom area Increases the size of any section of the trend window. Specify an 
area in the trend window by using the mouse. This area of the trend 
window is enlarged.

Zoom X axis Increases or decreases the size of the X axis in the trend window. 
Enlarge the X axis by left-clicking with the mouse. Hold down <Shift> 
and left-click to decrease the size of the X axis.

Zoom Y axis Increases or decreases the size of the Y axis in the trend window. 
Enlarge the Y axis by left-clicking with the mouse. Hold down <Shift> 
and left-click to decrease the size of the Y axis. 

Trend area Shift the trends in the trend window along the X axis and Y axis by 
using this button.

Axis area Shift the trends in the trend window along the value axis by using 
this button.

Original view Switches from the magnified trend view back to the normal view

Start/stop Stops and starts the trend update. The values are buffered and 
updated as soon as you start trend update again.

Ruler Determines the coordination of a point of the trend. 

The order of the buttons is fixed. The operator can set up individual key assignments, and 
shortcuts for every button on the toolbar.

See also
Bar (Page 3086)

Device-Specific Nature of the Objects (Page 3077)

Trend view (Page 3104)
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Graphic view

Application  
The "Graphic view" object is used to display graphics.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Graphic: Specifies the graphic file that is displayed in the object.

● Stretch graphic: Specifies the automatic size stretching for objects with graphics.

● Transparent color: Specify whether or not the transparent color is used for the graphic.

Inserting graphics  
The following graphic format is used in the "Graphic view" object: *.bmp, *.tif, *.png, *.ico, *.emf, 
*.wmf, *.gif, *.jpg or *.jpeg. You may also use graphics as OLE objects in the Graphic view .

1. In the Inspector window, select "Properties > Properties > General":

2. Select the graphic that you wish to insert.
The graphic preview is shown in the right pane.

3. Click "Apply" to insert the graphic in the Graphic view .

Stretch graphic  
Whether a graphic displayed in a Graphic view  is stretched to the size of the Graphic view  in 
runtime is specified in the Inspector window.

1. Click "Properties > Properties > Layout" in the inspector window.

2. Select the required size adjustment for the graphic.
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Transparent color   
This property defines whether the transparent color is used for the graphic to be displayed. 

1. Click "Properties > Properties > Appearance" in the inspector window:

2. Activate "Background > Transparent".

3. Select a transparent color.
 

  Note

When using bitmaps in WinCC screens the "Transparent color" setting demands a high 
character performance in the layout on the panel. Visualization performance is enhanced 
by disabling the "Transparent" setting in the properties of the relevant display object. This 
restriction applies in particular when bitmaps are used as background image.  

 

  Note
Basic Panels

The "Transparent" property is not available for Basic Panels.
 

See also
Device-Specific Nature of the Objects (Page 3077)

Options for Editing Objects (Page 2953)

Storing an external image in the graphics library. (Page 2977)

Graphic I/O field

Application  
The "Graphic I/O field" object can be used to configure a list for display and selection of graphic 
files.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Scroll bar type: Specifies the graphic layout of the scroll bar.

Visualizing processes (Comfort/Advanced)
10.1 Creating screens

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3097



 

 Note
Basic Panels

The scroll bar is not available for Basic Panels.
 

 Note
Reports

Graphic I/O fields output exclusively graphics in reports. "Output" mode is preset. Properties 
for configuring the selection of graphics are not available, e.g. "scroll bar".

 

Mode  
The response of the "Graphic I/O field" object is specified under "Properties > Properties > 
General > Type > Mode" in the Inspector window.

Mode Description
"Input" The "Graphic I/O field" object is only used to select graphics.
"Input/output" The "Graphic I/O field" object is used to select and display graphics.
"Output" The "Graphic I/O field" object is used to display graphics only.
"Two states" The "Graphic I/O field" object is only used to display graphics and can have a 

maximum of two states.
You use no graphics list but insert one graphic each for the "ON" and "OFF" 
state.

Stretch graphic  
Whether a graphic displayed in a graphic I/O field is stretched to the size of the view in runtime 
is specified in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required size adjustment for the graphic.

Scroll bar type
The response for the graphic representation of the scroll bar is specified under "Properties > 
Properties > Appearance > Scroll Bar > Type" in the Inspector window.

Type Description
"Permanent" The scroll bar is always visible.
"No scrollbar" The scroll bar is not visible.
"Visible after clicking" The scroll bar is made visible by a mouse click.
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See also
Device-Specific Nature of the Objects (Page 3077)

Symbolic I/O field  (Page 3142)

Handwheel

Application   
The object "Handwheel" is a control element for some SIMATIC Mobile Panels. You can enter 
incremental values in Runtime using the "HandWheel" object. 

Layout   
You can set the following property in the Inspector window:

● Tag: Specifies the tags to which the "HandWheel" object is linked.

Tag     

Global assignment
The "Tag" property is specified in the template for the global assignment of the "HandWheel" 
object. There is only one template for each HMI device. 

1. In the Inspector window, select "Properties > Properties > General":

2. Select a tag from the selection list under "Settings > Tag".

Local assignment
The "HandWheel" object is assigned to another tag. To do so you configure a function that 
assigns the tag to the handwheel in Runtime.

Example for configuration to a button:

1. Open the screen in which the "HandWheel" object is assigned to another tag.

2. Drag the "Button" object from the toolbox to the screen. Select the button on your screen.

3. Click "Properties > Events > Click" in the Inspector window.
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4. The "Function list" dialog box opens. Click the first line of the function list. The list of system 
functions and scripts available in the project appears.

5. Select the system function "SetTagToHandWheel" from the "Other functions" group. Select 
a tag from the combo box at "Value".

 

  Note

The Mobile Panel may ignore the change of the value in the PLC made at another location 
while the handwheel is being operated. The value is the PLC is overwritten again. 

 

See also
Device-Specific Nature of the Objects (Page 3077)

Illuminated pushbutton (Page 3106)

Help indicator

Application  
The object "help indicator" is available for the HMI devices OP 73 and KP300 Basic. If a a 
tooltip exists for the selected object, the help indicator is displayed during runtime. If a tooltip 
was configured for the opened screen, the help indicator always remains visible.

You configure the object "help indicator" exclusively in the global screen.

Layout
You can adapt the following properties in the Inspector window:

● Position: Determines the position of the object "Help indicator."

Position
You can use this property to set the position of the object "Help indicator." 

1. Select the object "Help indicator" in the template.

2. In the Inspector window, select "Properties > Properties > Layout".

3. Enter a value for X and Y. You can also use the cursor keys to position the selected object.

If you have configured a screen object at this position, the visible help indicator covers the 
screen object. The help indicator is covered only by incoming system alarms and dialogs. 

See also
Device-Specific Nature of the Objects (Page 3077)
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HTML browser

Application   
The "HTML Browser" object is designed for the visualization of simple HTML pages. This 
function allows you to draw up machine-specific descriptions which are stored centrally and 
which can then be displayed from different HMI devices.

 

 Note

Changing the functionality of the HTML Browser to that of a file explorer by one of the following 
methods, for example, is not authorized in the context of WinCC:
● Entering a folder or drive, for example "\" or "C:" or
● Connecting to an FTP server, for example "ftp://"

One reason this function is not implemented is to prevent inadvertent changes to files, their 
deletion or execution.     

When configuring, ensure that the operator can only enter valid Internet addresses, for 
example, by using symbolic I/O fields. Configure a password-protected input for service 
purposes.

 

Layout   
Customize the object position and size in the Inspector window. In particular, you can 
customize the following property:

● URL: Specifies which Internet address is opened in the HTML Browser.

Address   
The internet address is specified in "Properties > Properties > General >URL" in the Inspector 
window. 
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Basic procedure
1. Create an internal tag of the "String" data type, for example InternetAddress, in the "Tag" 

editor.

2. Insert the "HTML Browser" object in the screen in the "Screens" editor.

3. In the Inspector window, select "Properties > Properties > General".

4. At "Tag for the URL", select the "InternetAddress" tag from the selection list.

5. Insert an I/O field in the screen in the "Screens" editor.

6. Select "Properties > Properties > General > Tag for URL" in the Inspector window and then 
select the "InternetAddress" tag at "URL tag" from the selection list.

The HTML Browser opens the relevant page after the operator has entered an address.

Control elements       
Control elements are configured buttons in the process screen or softkeys on the HMI device. 

The "HTML Browser" object does not have its own operator control components. Assign the 
system functions used to control the "HTML Browser" object to your configured control 
elements, such as buttons.

1. For example, drag the "Button" object to the screen from the toolbox.

2. Input a text of any length or select a graphic, for example Update.

3. In the Inspector window, select "Properties > Events > Click". 
The "Function list" dialog box is opened.

4. The system functions for controlling the "HTML Browser" object can be found in the list of 
system functions in the "Keyboard online operation for screen objects". 
Select a function from the list, for example, HTMLBrowserRefreshName.

5. Select the object name of the HTML Browser in which the command will be executed from 
the "Screen object" list.
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Comments
The functional scope of the HTML Browser is limited in comparison to the Internet Explorer:

● The HTML Browser will only show pure HTML pages. VBScript, Java, JavaScript, Flash 
and ActiveX controls are not supported. Set up the HTML pages for display in the HTML 
Browser by using a text editor or using a simple HTML editor.

● Links to embedded files, for example *.pdf or *.xls, are not supported.

● Queries and dialogs that are conducted during the access of, for example protected pages 
are not supported. When accessing protected pages enter your user name and password 
in the URL: <http://User_Name:Password@Server_Name> (for example, "http://
Administrator:Admin123@192.168.0.199").

Circle

Application
The "Circle" object is a closed object which can be filled with a color or pattern.

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Radius: Specifies the size of the circle.

Radius
The radius of the "Circle" object is specified in the Inspector window. The value is entered in 
pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 in the "Radius" area.

See also
Device-Specific Nature of the Objects (Page 3077)
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Trend view

Application   
The trend view is meant for the graphical representation of tag values from the current process 
or from a log in form of trends.

Layout   
In the Inspector window, you customize the position, geometry, style, color, and font types of 
the object. You can adapt the following properties in particular:

● Display value table, ruler and grid: Specifies whether a value table, a ruler or a grid is 
displayed in addition to the coordinate system to improve legibility.

● Toolbars: Defines the display of the control elements.

Display value table, ruler and grid
For improved legibility a value table, a ruler and a grid can be displayed in Runtime.

1. Activate "Properties > Properties > Appearance > Show ruler".

2. Activate "Properties > Properties > Table > Show table".

3. Activate "Properties > Properties > Table > Show grid".

Toolbars     
The layout of the control elements is defined in the "Properties > Properties > Toolbar" 
inspector window. 

 

 Note
Basic Panels

As archiving is not possible for Basic Panels, the control elements are not available.
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Toolbar button Brief description Description
"Go to start" Scrolls back to the beginning of the trend recording. 

The start values with which the trend recording started 
are displayed. 

"Zoom in" Zooms out of the displayed time section

"Zoom out" Zooms into the displayed time section.
"Ruler backward" Moves the ruler back.
"Ruler forward" Moves the ruler forward.
"Backward" Scrolls back one display width.
"Forward" Scrolls forward one display width.
"Ruler" Shows or hides the ruler. The ruler displays the X-

value associated with a Y-value.
"Start/stop" Stops trend recording or continues trend recording.

Configuration behavior

Displaying column headers
The layout of the table in the trend view depends on the view settings in the Control Panel. 
Depending on the setting, the column headers may be truncated. This setting is found under 
"Display > Appearance" in the control panel. To display column headers correctly, set the 
display in "Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime. 

Consistency test
If warnings or errors are displayed in the output window during a consistency check in 
connection with trend views, clicking "Go to Error/Tag" on the shortcut menu will not always 
take you to the exact error position. In some cases only the trend view is shown as cause of 
error.

Adding, configuring, and removing trends
The trends of the trend view are managed in the Inspector window under "Properties > 
Properties > Trend". You can copy trends between different trend views. 

See also
Device-Specific Nature of the Objects (Page 3077)

Configuring trend displays for values from the PLC (Page 3240)

Trends (Page 3237)

Outputting tag values in screens (Page 3239)

Configuring trend display for values from the PLC (Basic) (Page 3236)
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Charging status

Application
The object "Charging condition" is a control element for some SIMATIC Mobile Panels. The 
"Charging condition" object indicates the charging status of the battery. Charge the battery in 
good time. Alternatively, you can replace the battery with a spare battery.     

Layout

Symbol Description Charging condition
Battery is charged >20 %

Battery must be charged <20 % and
>6 %

Battery is weak < 6 %

Operation
The object is for display only and cannot be controlled by the operator.   

See also
Device-Specific Nature of the Objects (Page 3077)

Effective range name (Page 3152)

Effective range name (RFID) (Page 3154)

Effective range signal (Page 3156)

WLAN reception (Page 3157)

Zone name (Page 3160)

Zone signal (Page 3161)

Illuminated pushbutton

Application  
The object "Illuminated pushbutton" is a control element for some SIMATIC Mobile Panels. 
The LEDs can be activated by the PLC. The illuminated LED signals the operator in Runtime 
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that the illuminated pushbutton has to be pressed. The illuminated pushbutton is configured 
in the global screen.

Layout  
You can adapt the following properties in the Inspector window:

● Tag: Specifies the tag in which the status of the illuminated pushbutton is written.

● LED assignment: Specifies the assignment of the LED to the bit in the LED tag.

Tag   
The "Tag" property is used to specify the global assignment of the "Illuminated pushbutton" 
object in the global screen. 

 

 Note
Information for configuring

The current status of the illuminated pushbutton is written to the tag when Runtime is started 
and whenever the button is pressed. This may cause inconsistencies between the status of 
the illuminated pushbutton and the illuminated pushbutton tags.
1. If the tag has a connection to the PLC, the current value is transferred from the PLC to 

the tag after establishment of communication. The tag that contains the current status of 
the key is overwritten by this process. The illuminated pushbutton tag may therefore no 
longer reflect the current value of the illuminated pushbutton, for example if the Mobile 
Panel is switched off while the illuminated pushbutton is pressed.

2. If the illuminated pushbutton is pushed before communication to the PLC could be 
established (for example after a device start-up), it may not be possible to send the value 
of the illuminated pushbutton tag to the PLC. In this case the value of the tag in the PLC 
is different from the current status of the key.

Carry out the following configuration steps so that the illuminated pushbutton always reflects 
the actual state.
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Basic procedure
1. Specify the connection to the PLC in the "Connections" editor. Activate the "Coordination" 

area pointer to ensure that the life bit is available to the PLC side.

2. Open the "HMI tags" editor and create three tags.

– Internal tag: Pushbutton_State

– External tag: BufferTag

– External tag: Pushbutton_PLC

3. Open the Inspector window of the "Pushbutton_State" tag.

4. In the Inspector window, select "Properties > Events > Value change". Click the first line of 
the function list. The list opens, showing the system functions available in the project.

5. Select the "SetTag" system function.

– Select the "Pushbutton_PLC" tag at "Tag (output)".

– Select the "Pushbutton_State" tag at "Value".

The value of the "Pushbutton_PLC" tag is written to the PLC with the "Pushbutton_PLC" 
tag. A program in the PLC evaluates the life bit. If communication is established, the 
current value is written to the "Pushbutton_PLC" tag from the PLC. The "BufferTag" is 
required to transfer the current position of the pushbutton to the PLC.
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6. Open the Inspector window of the "BufferTag" tag.

7. In the Inspector window, select "Properties > Events > Value change".

8. Click the first line of the function list. The list opens, showing the system functions available 
in the project.

9. Select the "SetTag" system function.

– Select the "Pushbutton_PLC" tag at "Tag (output)".

– Select the "Pushbutton_State" tag at "Value".

After establishing communication the current value is written to the "BufferTag" from the 
PLC. The "SetTag" system function is executed by the value change in the auxiliary tag. 
The system function re-allocates the value of the "Pushbutton_State" tag to the 
"Pushbutton_PLC" tag.

10.Open the global screen in the "Screen navigation" editor.

11.Select the illuminated key on the global screen.

12.Select the tag "Pushbutton_State" in "Properties > Properties > General > Settings >Tag" 
in the Inspector window.
If you press the illuminated pushbutton, the value is written to the "Pushbutton_PLC" tag.

LED assignment
To actuate the LED an LED tag or an array tag must be set up in the PLC and specified as an 
LED tag during configuration. The LED tag is specified at "LED tag" in the "Settings" area in 
the "General" group. With "LED bit" the allocated bit is given. When the bit is set the following 
states of the LED can be realized in runtime.

Bit n+1 Bit n LED function
0 0 Off
0 1 Fast flash
1 0 Slow flash
1 1 On permanently
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See also
Device-Specific Nature of the Objects (Page 3077)

Handwheel (Page 3099)

Line

Application  
The "Line" object is an open object. The line length and gradient slope are defined by the height 
and width of the rectangle enclosing the object. 

Layout  
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Line style

● Line start and end

Line style 
The representation of the line is specified under "Properties > Properties > Appearance" in the 
Inspector window. The line is shown without interruption if you select "Solid", for example.

 

 Note

The line styles available depend on the selected HMI device.
 

Line start and end     
The start and end points of the line are specified under "Properties > Properties > Appearance 
> Line ends" in the Inspector window. 

Use arrow point, for example, as start and end point. The available start and end points depend 
on the device.

See also
Device-Specific Nature of the Objects (Page 3077)
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Media Player

Application   
The Media Player is used in Runtime to play back video or audio files.

The Media Player is only available for the following devices:

● MP 377

● Comfort Panels

Layout   
You can set the following properties in the Inspector window:

● Display status bar: Determines whether to display the status bar.

● Display control elements: specifies the control elements during runtime.

● Show seek: establishes, whether a slider is available for the operation.

Control elements   
The control elements that can be used to control the Media Player in Runtime are specified in 
the Inspector window under "Properties > Properties > Appearance > Elements". 

Supported file formats
The following audio formats are supported by Media Player:

● Moving Picture Experts Group standard 1, Layer 1,2, 3 (.mpa, .mp2, .mp3)

● Windows Media Audio (.wma)

● Waveform Audio (.wav)

The following video formats are supported by Media Player:

● Moving Picture Experts Group standard 1 (.mpg, .mpeg, .mpv, .mpe)

● Advanced Streaming Format (.asf)

Visualizing processes (Comfort/Advanced)
10.1 Creating screens

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3111



● Windows Media Video Format (.wmv)

● Audio-Video Interleaved (.avi)
 

 Note

Media Player does not support the creation and management of favorites. If you create 
favorites before closing the Media Player, they will not reappear when you open it again. 

 

See also
Device-Specific Nature of the Objects (Page 3077)

Alarm view

Application       
Alarms are indicated in the Alarm view or in the Alarm window of the HMI device. The following 
screen contains an alarm view with no content:

Complex alarm view       
The complex or simple alarm view is available for editing alarms depending on the HMI devices. 
The figure below shows a complex alarm view:
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Simple alarm view       
The following screen contains a simple alarm view:

Proceed as follows to configure the appropriate alarm view:

1. Click "Properties > Properties > Layout > Mode" in the Inspector window.

2. Select "Simple" or "Complex".
 

  Note

In the Engineering System you can dynamically control the visibility of an object, for 
example, in the "Animations" tab of the Inspector window. In Runtime, the "Simple alarm 
view" does not support animations. If you have configured an animation and, for example, 
wish to perform a consistency check of the project, then an error alarm is issued in the 
Output window.

 

Alarm line       
The alarm line allows display of the most current pending alarm in Runtime. The following 
figure shows an alarm line:

How to configure the alarm line: 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select "Mode > Alarm line".
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Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. 

 

 Note

The fonts available for selection depend on the "Language and fonts" you have configured 
in the device settings and the fonts your HMI device supports.

 

You can adapt the following properties in particular:

● Control elements: Defines the operator controls of the alarm view.

● Alarm classes: This setting defines which alarm classes are displayed in the alarm view.

● Columns: Specifies the displayed columns in Runtime.

● Sequence of columns: Specifies whether the sequence of columns can be changed in 
Runtime.

● Identification of alarm classes: To be able to distinguish various alarm classes, they are 
identified in the first column of the alarm view.

● Filter: Defines that only alarms that contain a specific character string will be displayed in 
the alarm text.

● Enable sorting: Specifies whether the messages can be sorted in runtime by date and time.

● Defining display area This setting specifies from which date on alarms are displayed in the 
alarm view.

 

  Note

If you have different alarm classes output, these will be initially sorted into alarm classes 
in runtime, and then by when the alarm occurred.

 

Control elements     
The control elements that can be used to control the alarm view in Runtime are specified in 
the Inspector window under "Properties > Properties > Display > Settings". The following table 
shows the control elements in the alarm view, and what they do:

Button  Function
"Tooltip" Displays a tooltip for an alarm.

"Acknowledge" Acknowledges an alarm.

"Loop-In-Alarm" If a screen change is configured, the display switches to a screen 
containing information about the alarm.
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Select alarm classes
1. Click "Properties > Properties > General" in the Inspector window.

2. Under "Alarm classes" activate the alarm classes to be displayed in the alarm view in 
Runtime .

Access protection in Runtime
Configure access protection in the "Properties > Security" group in the properties of the alarm 
view. If a logged-on user has the required authorization, he can acknowledge and edit alarms 
using the operator controls in the alarm view. If the logged-in user does not have the required 
authorization, or if no user is logged in, using the "Acknowledge" or "Edit" buttons or double-
clicking an alarm line opens the login dialog.

Define columns     
Define the columns to be displayed in the alarm view in Runtime in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate the columns that are to be displayed in Runtime under "Columns".

Sequence of columns
If this property is enabled, the column sequence in the alarm view can be changed in Runtime.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Column properties > Column order".

Enable sorting     
If this property is enabled, the alarms displayed in the alarm view in Runtime can be sorted by 
date and time.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Column properties > Sorting by date/time possible".

Filtering alarms
This property is used to define that only alarms that contain a configured string will be displayed 
in the alarm text in runtime for the extended alarm view.

1. In the Inspector window, select "Properties > Properties > Filter.

2. Enter the required term for filtering in the field "Filter string".
Alternatively, you configure a filter tag using the field "Filter tag". The contents of the filter 
tag serve as the filter criterion in runtime.
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Identify alarm classes             
An icon is displayed in the first column of the alarm view. This symbol allows the alarm to be 
allocated to an alarm class.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Columns > Alarm class".

3. Open the "Alarms" editor, and click the "Alarm Classes" tab.

4. Specify an icon for use to identify the alarms of this alarm class for an alarm class in the 
"Display name" column.

 

  Note

The "alarm view" object cannot be grouped. 
 

Defining display area
You select a tag which defines the time from which alarms should be displayed. The following 
data types are permitted:

● External tags: Date, Date_and_Time, Time_of_Day

● Internal Tags: DateTime

To define the display area, proceed as follows:

1. Click "Properties > Properties > Display" in the Inspector window.

2. Define the tag in which the time is specified under "Control tag for the display area".

Configuration behavior

Displaying column headers
The layout of the alarm view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is found under "Display > 
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Appearance tab" in the control panel. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime. 

Displaying the buttons for operation
The simple alarm view in the HMI devices OP 73, OP 77A and TP 177A has a button which 
displays the alarm text in its own window. This button is not shown during configuration.

The display of the buttons for using the simple alarm view depends on the configured size. 
You should check on the HMI device whether all necessary buttons are available.

See also
Device-Specific Nature of the Objects (Page 3077)

Alarm window (Page 3117)

Alarm indicator (Page 3120)

Configuring an alarm view for active alarms (Page 3286)

Alarm window

Application   
Alarms are indicated in the Alarm view or in the Alarm window of the HMI device. The layout 
and operation of the Alarm window are similar to that of the Alarm view. The Alarm window 
has the following characteristics that are the same as in the Alarm view:

● Simple alarm window

● Advanced alarm window

● Alarm line
 

  Note
Basic Panels

Only the simple alarm window is available for Basic Panels.
 

The Alarm window is configured in the "Global screen" editor. 

The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active. Depending 
on the configuration, it is not closed until the alarm is acknowledged. 
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 Note

In the engineering system you dynamize, for example, the visibility of an object in "Properties 
> Animations" in the Inspector window. In runtime, the "Simple alarm window" object does 
not support animations. If you have configured an animation and, for example, wish to perform 
a consistency check of the project, then an error alarm is issued in the Output window.

 

Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You configure the Alarm window in the same way as the Alarm view. In addition 
you adapt the following properties:

● Fixed alarm windows: Specifies that the Alarm window retains the focus after a screen 
change.

● Window: You define the operator input and response of the Alarm window in runtime.
 

  Note

If you have different alarm classes output, these will be initially sorted into alarm classes 
in runtime, and then by when the alarm occurred.

 

Control elements   
The control elements that can be used to control the alarm view in runtime are specified in the 
Inspector window under "Properties >Display > Settings". The following table shows the control 
elements in the Alarm window, and what they do:

Button  Function
"Tooltip" Displays a tooltip for an alarm.

"Acknowledge" Acknowledges an alarm.

"Loop-In-Alarm" If a screen change is configured, the display switches to a screen 
containing information about the alarm.
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Access protection in Runtime
Configure access protection under "Properties > Properties > Security" in the Inspector window 
of the alarm view. If a logged-on user has the required authorization, he can acknowledge and 
edit alarms using the operator controls in the alarm view. If the logged-in user does not have 
the required authorization, or if no user is logged in, clicking the "Acknowledge" or "Edit" buttons 
or double-clicking an alarm line opens the login dialog box.

 

 Note
Basic Panels

Access protection is not available for Basic Panels.
 

Activating the focus of the Alarm window
Select the following option so that the Alarm window does not lose the focus after a screen 
change:

1. In the Inspector window, select "Properties > Properties > Mode".

2. Enable "Label".

Window
Define the response of the Alarm window under "Properties > Properties > Mode > Window" 
in the Inspector window. The following table shows the possible properties:

Option Function
Automatic display The Alarm window is automatically displayed when a system alarm 

occurs, for example.
Closable The window closes again after a set time has elapsed. You define the 

display duration in the alarm settings. 
Modal The Alarm window is linked to a confirmation, such as: Alarm must be 

acknowledged. If the modal alarm window has the focus, the buttons in 
the screen behind it cannot be used. The functions configured on a 
function key are carried out. 

Sizeable You can change the size of the Alarm window in runtime.

See also
Device-Specific Nature of the Objects (Page 3077)

Alarm view (Page 3112)

Alarm indicator (Page 3120)

Configuring an alarm window  (Page 3291)
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Alarm indicator

Application  
The alarm indicator is a graphic symbol that shows current errors or errors that need to be 
acknowledged, depending on the configuration. The alarm indicator is configured in the "Global 
screen" editor. The following figure shows an alarm indicator:

Alarm indicator OP 73
A "simple" alarm indicator is available for the HMI OP 73. The following diagram shows the 
alarm indicator for the OP 73 HMI devices:

The "simple" alarm indicator shows alarms to be acknowledged or alarms which have already 
been acknowledged and have not yet gone. Only the position can be defined for the "simple" 
alarm indicator. The alarm indicator is displayed on the device at the selected position. If you 
have configured a screen object at this position, the visible alarm indicator covers the screen 
object. The alarm indicator is covered by system dialogs, such as the login dialog, Help dialog, 
and alarm windows. 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Alarm classes: Establishes the alarm classes where the alarm indicator is displayed.

● Operator control in Runtime: Defines the operator actions in Runtime that cause the Alarm 
window to open.

Alarm classes  
You define which alarm classes are shown with an alarm indicator in "General > Alarm classes" 
in the Inspector window. Alarm classes, such as "Warnings" or "Errors".

Define operator control in Runtime  
1. Select the alarm indicator in the screen.

2. Click "Events > Click" or "Click when flashing" in the Inspector window.

3. The "function list" opens. Click the first line of the function list. The list of system functions, 
and scripts available in the project opens.
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4. Select the "ShowAlarmWindow". system function under "Alarms."

5. Under "object name" select the name of the Alarm window from the selection list. Under 
"Layout", define whether the Alarm window should be visible, hidden, or should toggle 
between the two states.

See also
Device-Specific Nature of the Objects (Page 3077)

Alarm view (Page 3112)

Alarm window (Page 3117)

Configuring an alarm indicator (Page 3292)

Polygon 

Application   
The "Polygon" is a closed object which you can fill with a background color. 

Layout     
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. In particular, you can customize the following property:

Geometry: Modifies, deletes or adds corners.

Geometry         
The corner points are numbered in the order of their creation. You can change, delete, or add 
more corner points:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required corner point in the "Geometry" area. Input a value at "X position " and 
"Y position ".
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3. To add a corner point, click the  button.

4. To delete a corner point, click the  button.

Alternative procedure
You can also change, delete, or add new corner points using the mouse:

1. Select the object. Position the mouse cursor on the desired corner. The mouse cursor 
changes to a crosshair.

2. Drag the corner to the desired position while holding down the mouse button.

3. Right-click the position at which you want to insert the corner point. Select "Add point" from 
the shortcut menu.

Configuring Rotation in runtime
You configure the "Polygon" object so that it rotates about a reference point in runtime. The 
rotation in runtime is only possible for devices with Runtime Professional.

Enter the values for the angle of rotation using Degrees as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter values for the following attributes in the "Rotation" area.

– X

– Y

– Angle

See also
Device-Specific Nature of the Objects (Page 3077)

Polyline (Page 3123)
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Polyline

Application   
The "Polyline" is an open object. Use the "Polygon" object if you want to fill the object with 
color.

Layout   
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Line start and end: Specifies the type of line start and line end.

● Geometry: Modifies, deletes or adds corners.

Line start and end         
You define the start point and the end point of the line under "Properties > Properties 
>"Appearance" in the Inspector window. Use arrow point, for example, as start and end point. 
The available start and end points depend on the device.

Geometry         
The corner points are numbered in the order of their creation. You can change, delete, or add 
more corner points:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required corner point in the "Geometry" area. Input a value at "X position" and 
"Y position".

3. To add a corner point, click the  button.

4. To delete a corner point, click the  button.
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Alternative procedure
You can also change, delete, or add new corner points using the mouse:

1. Select the object. Position the mouse cursor on the desired corner. The mouse cursor 
changes to a crosshair.

2. Drag the corner to the desired position while holding down the mouse button.

Configuring rotation in Runtime
You configure the "Polyline" object so that it rotates about a reference point in Runtime. The 
rotation in Runtime is only possible for devices with Runtime Professional.

Enter the values for the angle of rotation using Degrees as the unit.

1. Click "Layout" in the Inspector window.

2. Enter values for the following attributes in the "Rotation" area.

– X

– Y

– Angle

Further information can be found in "Device-Specific Nature of the Objects (Page 3077)".

See also
Polygon  (Page 3121)

Rectangle

Application 
The "Rectangle" is a closed object which you can fill with a color. 
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Corner radius: Specifies the horizontal and vertical distance between the corner of the 
rectangle and the start point of a rounded corner.

Corner radius   
The corners of the "Rectangle" object can be rounded to suit your requirements. When the 
properties "X" and "Y" are set to the 100 % value, the rectangle is displayed as an ellipse. As 
soon as one of the properties has the value 0%, a normal rectangle without a rounded corner 
is shown.

1. Click "Properties > Properties > Layout" in the inspector window.

2. Enter a value for "X" in the "Corner radius" area.
The input value is the percentage proportion of half the width of the rectangle.

3. Enter a value for "Y" in the "Corner radius" area.
The input value is the percentage proportion of half the height of the rectangle.

See also
Device-Specific Nature of the Objects (Page 3077)

Rotating objects (Page 2963)

Flipping objects (Page 2965)

Recipe view

Application   
The "Recipe view" object is used to display and modify recipes.
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Advanced recipe view       
Both the advanced and the "Simple recipe view" can be used to administer and process recipes 
on HMI devices with a display larger than 6".

Configuring the advanced recipe view:

1. Click "Properties > Properties > General" in the Inspector window.

2. Activate "Format > Advanced view" in the "Display type" area.

Simple recipe view       
The "Simple recipe view" is used for display and processing of recipes on HMI devices with a 
display size less than 6". 

 

 Note

Do not use the simple recipe view in a group.
 

Configuring the simple recipe view:

1. In the Inspector window, select "Properties > Properties > General".

2. Activate ""Display type" > Basic view".
 

  Note
Behavior for Runtime Professional, Runtime Advanced and Panels

In the Engineering System you can dynamically control the visibility of an object, for 
example, in the "Animations" tab of the Inspector window. In Runtime, the "Simple recipe 
view" does not support animations. If you have configured an animation and, for example, 
want to check the consistency of the project, an error alarm is displayed in the Output 
window. 

 

Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You can adapt the following properties in particular:

● Control elements: Defines the control elements of the recipe view.

● Display number: establishes if the number of the recipe and the number of the recipe data 
record is displayed.
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Control elements     
The control elements with which the recipe view is operated in runtime are configured under 
"Properties > Buttons" in the inspector window. In the simple recipe view the operating 
elements are based on the functions of the menu.

Control element  Description
"Tooltip" Calls up the configured tooltip for the selected 

recipe.
"New record" Creates a new recipe data record in the recipe.
"Delete record" Deletes the selected record.
"Saving" Saves the modified record with its current name.
"Save as" Saves the modified record with a new name.
"Write to PLC" Sends the current value to the PLC.
"Read from PLC" Reads the current value from the PLC.
"Synchronizing recipe tags" Compares the values of the selected record with 

the values on the PLC.

Display number     
Specifies whether the number of the recipe and the number of the recipe data record are 
displayed during runtime. The number of the recipe uniquely identifies the recipe in the project.

1. Click "Properties > Properties > View" in the Inspector window.

2. Activate "Display > Display numbers".

Configuration behavior

Displaying column headers
The layout of the recipe view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is found under "Display > 
Appearance" in the control panel. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime.

 

See also
Device-Specific Nature of the Objects (Page 3077)

Simple recipe view (Page 3407)

Advanced recipe view (Page 3412)

Display of recipes (Page 3395)

Configuring the Advanced Recipe View (Page 3430)
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Recipe view

Application     
The "Recipe view" object is used to display and modify recipes.

Layout     
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You can adapt the following properties in particular:

● Toolbar: Specifies the menu commands of the recipe view.

Toolbar     
The menu items with which the recipe view is operated in Runtime are configured under 
"Properties > Properties > Toolbar" in the Inspector window.

Menu command Description
"Tooltip" Calls up the configured tooltip for the selected recipe.
"New record" Creates a new recipe record in the recipe.
"Delete record" Deletes the selected record.
"Saving" Saves the modified record with its current name.
"Save as" Saves the modified record with a new name.
"Write to PLC" Sends the current value to the PLC.
"Read from PLC" Reads the current value from the PLC.
"Rename" Specifies that the "Rename" button is shown.
"Forward" Specifies that the menu buttons are visible.
"Back" Specifies that the "Back" button is shown.

See also
Objects for Basic Panels (Page 3077)
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Switch

Application   
The "Switch" object is used to configure a switch that is used to switch between two predefined 
states in runtime. The current state of the "Switch" object can be visualized with either a label 
or a graphic.

The following figure shows a "Switch" type switch.

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. In particular, you can customize the following property:

● Type: Defines the graphic representation of the object.

Type   
Button visualization is specified at "Properties > Properties > General >Type" in the Inspector 
window.

Type Description
"Switch" The two states of the "Switch" are displayed in the form of a switch. The 

position of the switch indicates the current state. The state is changed in 
runtime by sliding the switch. 
You specify the direction of movement of the switch in "Switch orientation" 
with this type.

"Switch with text" The switch is shown as a button. The current state is visualized with a label. 
In runtime click on the button to actuate the switch.

"Switch with graphic" The switch is shown as a button. The current state is visualized with a graphic. 
In runtime click on the button to actuate the switch.

 

 Note
Basic Panels

The "Switch" type is not available for Basic Panels. 
 

See also
Device-Specific Nature of the Objects (Page 3077)

Overview of objects (Page 2950)
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Button

Application   
The "Button" object allows you to configure an object that the operator can use in runtime to 
execute any configurable function. 

Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You can adapt the following properties in particular:

● Mode: Defines the graphic representation of the object.

● Text / Graphic: Defines whether the Graphic view  is static or dynamic.

● Define hotkey: Defines a key, or shortcut that the operator can use to actuate the button.
 

  Note

You can only define a hotkey for HMI devices with keys.
 

Mode     
The button display is defined in "Properties > Properties > General >Mode" in the Inspector 
window.

Mode Description
"Invisible" The button is not visible in runtime.
"Text" The button is displayed with text. This text explains the function of the button.
"Graphic" The button is displayed with a graphic. This graphics represents the function of the 

button.

Depending on the device, further options are available:

Text / Graphic 
The "Mode" property settings are used to define whether the display is static or dynamic. The 
display is defined in "Properties > Properties > General >Text" or "Graphic" in the Inspector 
window.

Your options for the type "Graphic" include the following.
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Type Option Description
"Graphic" "Graphic" "Graphic OFF" is used to specify a graphic that is displayed in the button 

when the state is "OFF". 
If you enable "Graphic ON", you can enter a graphic for the "ON" state.

"Graphics 
list"

The graphic in the button depends on the state. The entry from the graphics 
list corresponding to the state is displayed.

Define hotkey     
In the Inspector window, a key or key combination is defined that the operator can use to 
control the button in runtime.

1. In the Inspector window, select "Properties > Properties > General":

2. Select a key or key combination from the selection list in the "Hotkey" area.

 

See also
Device-Specific Nature of the Objects (Page 3077)

Example: Configuring a button for language switching (Page 3029)

Example: Configuring a button with logon dialog box (Page 3531)

Example: Configuring a button with access protection (Page 3535)

Slider

Application   
Process values are monitored and adapted within a defined range with the "Slider" object. The 
monitored range is visualized in the form of a slider. By adjusting the slider, you intervene in 
the process and correct the displayed process value.

 

 Note

Do not configure a system function at the "Change" event for a regulated project if it is used 
to execute a GMP-relevant action. 

Instead configure the system functions at the "Value change" event of the tags in order to 
reduce the number of user actions.
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Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can, in particular, adapt the following properties as required:

● Maximum Value and Minimum Value: Specifies the top and bottom values of the scale.

● Display current value: Specifies whether the current position of the controller appears below 
the slider.

● Display of bars: The sliders above and below the bar can be hidden.

Maximum Value and Minimum Value     
The top and bottom end values of the scale are specified in the Inspector window.

1. In the Inspector window, activate "Properties > Properties > General".

2. Enter a number at "Maximum value" and "Minimum value". If you select a tag as the end 
value of the scale, the number will be no longer available.

Display current value   
Specify that the value of the current position is displayed below the slider in the Inspector 
window.

1. In the Inspector window, activate "Properties > Properties > Layout".

2. Activate "Show current value."

Display bar   
The bar can be hidden.

1. In the Inspector window, activate "Properties > Properties > Layout".

2. Deactivate "Display bar".
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See also
Device-Specific Nature of the Objects (Page 3077)

KeySwitch

Application     
The object "KeySwitch" is an optional control element for the SIMATIC Mobile Panel. The key 
switch is used to lock functions that can be triggered from the Mobile Panel.

You configure the object "key switch" object in the "global screen" or in a template.

Layout     
You can set the following properties in the Properties view:

● Tag: Specifies the tag in which the position of the key switch is written.

Tag     
The "Tag" property is used to specify the "Key switch" object assignment in the global screen 
or template. 

 

 Note
Notes on configuring

When starting runtime and every time the key is pressed the current position of the key switch 
is written to the tag. In doing so it can cause inconsistencies between the position of the key 
switch and the key switch tags.
1. If the tag has a process connection, the current value is transferred from the PLC to the 

tag after establishment of communication. The tag that contains the current position of 
the key is overwritten by this process. It can be that the key switch tag no longer reflects 
the current value of the key switch, e.g. if the Mobile Panel is switched off while the key 
is being turned.

2. If the key switch is pressed before communication with the PLC has been established 
(e.g. after a device start-up), it may not be possible to send the value of the key switch 
tag to the PLC. In this case the value of the tag in the PLC is different from the current 
position of the key.

A specific configuration is required to make sure that the key switch tag reflects the actual 
position of the key switch at all times. See the instructions below for the basic procedure.
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Basic procedure
1. Specify the connection to the PLC in the "Connections" editor. Activate the "Coordination" 

area pointer to ensure that the life bit is available to the PLC side.

2. Create three tags in the "Tag" editor.

– Internal tag: Position_Keyswitch

– External tag: Auxiliary tag

– External tag: Keyswitch_PLC

3. Open the Inspector window of the "Position_KeySwitch" tag.

4. In the Inspector window, select "Properties > Events > Value change".

5. Click the first line of the function list. The list of system functions available in the project 
appears.

6. Select the "SetTag" system function.

– Select the "Keyswitch_PLC" tag at "Tag (output)".

– Select the "Position_Keyswitch" tag at "Value".

The value of the "Keyswitch_PLC" tag is written to the PLC with the "Position_Keyswitch" 
tag. A program in the PLC evaluates the life bit. If communication is established, the 
current value is written to the "Keyswitch_PLC" tag from the PLC. 
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7. Open the Inspector window of the "Auxiliary tag" tags.

8. In the Inspector window, select "Properties > Events > Value change".

9. Click the first line of the function list. The list of system functions available in the project 
appears.

10.Select the "SetTag" system function.

– Select the "Keyswitch_PLC" tag at "Tag (output)".

– Select the "Position_Keyswitch" tag at "Value".

After establishing communication the current value is written to the "Auxiliary Tag" from 
the PLC. The "SetTag" system function is executed by the value change in the auxiliary 
tags. The system function re-allocates the value of the "Position_Keyswitch" tag to the 
"Keyswitch_PLC".

11.Open the global screen or a template in the "Screen navigation" editor.

12.Select the key switch in the screen.

13.Select the "Position_KeySwitch" tag in the Inspector window under "Properties > Properties 
> General > Settings > Tag".
If you press the illuminated pushbutton, the value is written to the "Position_KeySwitch" tag.

See also
Field of application of the Mobile Panel Wireless (Page 4864)
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Sm@rtClient view

Application   
The "Sm@rtClient View" object is used to configure a network connection to the remote 
monitoring and remote maintenance of a connected unit.

Layout     
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Connect on start: Establishes whether when opening the Sm@rtClient view the connection 
to the HMI device is automatically created which should be remote-controlled.

● Shared use_ Specifies that an HMI device is shared by several Sm@rtClient Views.

● Local cursor: Specifies whether the cursor data is transferred separately in order to increase 
the performance.

● Use cursor key scroll: For keyboard devices places the control of the horizontal and vertical 
scroll with the cursor keys.

● Show controls: Establishes whether additional fields exist for entering the address and 
password.

● Allow menu: Specifies whether the shortcut menu is enabled to control the Sm@rtClient 
view.

● Connection type: Establishes the expected transfer speed for the remote monitoring.

● Scaling: Specifies whether the Sm@rtClient view can be zoomed in or out.

Connect on start
Establishes whether when opening the Sm@rtClient view the connection to the HMI device is 
automatically created which is remote-controlled. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Connect on start".
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Shared use   
Define whether the HMI device can be used by several Sm@rtClient views under "Properties 
> Properties > General > View > Shared".

Shared use  
Enabled HMI devices on which remote control is activated can access the remote 

HMI device and control the process. Only one HMI device can be active 
at a time in this case. A different HMI device can only assume control when 
there has been no activity on the active HMI device for a specified period 
of time.

Disabled Only one HMI device can use the remote control at any given time. The 
activities can be followed on the other HMI devices. 
Depending on the settings on the Sm@rtServer the following options are 
available if another HMI device logs on:
● The HMI device is rejected.
● The active HMI device is disconnected and the new HMI device is 

connected.

Local cursor   
If this property is set, then the cursor data is transferred separately. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Local cursor".

Display extended objects
If this property is set then there are additional fields for inputting the address and password. 
For the fields to be shown the "Connect on start" option is not activated.

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Show enhanced objects".

Allow menu
If this property is set, then a shortcut menu to control the Sm@rtClient view is opened in 
runtime. 

When operating using the mouse, the left mouse key must remain depressed for a few seconds 
for the shortcut menu to open. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Allow Menu".

Connection type
The "Connection type" property establishes the expected transfer speed for the remote 
monitoring. 
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Set the connection type at "Connection type" under "Properties > Properties > General > 
Connection type" in the Inspector window.

Connection type  
LAN Connection via network
Slow Connection with a low transfer speed
Medium Connection with a medium transfer speed
Modem Connection via an analog modem
Very slow Connection with a very low transfer speed 

Scaling
If this property is set, then via "Client scale factor" and "Server scale" you can reduce or enlarge 
the Sm@rtClient view on the HMI device. 

1. In the Inspector window, select "Properties > Properties > Scaling".

2. Activate "Scaling > Scaling".

3. Enter the values for the scaling under "Client scale factor" and "Server scale factor".

Operation behavior
If the program cannot resolve the dynamic address of a Sm@rtClient view after a screen 
change, the system connects to the configured server using the static address of the server. 
If a tag is now set using the dynamic address, you can make a second connection to this server. 
As a remedy preset the tags of the dynamic address for example by means of a script. 

See also
Device-Specific Nature of the Objects (Page 3077)

Status/Force

Application 
The "Status/Force" object is used to configure an editor that will allow you to process single 
address areas of a SIMATIC S7 in runtime.
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Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● PLC type: Specifies the PLC type in the object for which the address area is output in 
runtime.

● Control elements: Specifies the controls of the object.

● Visible columns: Specifies the displayed columns in runtime.

● Columns moveable: Specifies whether the operator can change the sequence of columns 
in runtime.

Control elements     
Set the control elements that you can use to control the "Status/Force" object in runtime at 
"Properties > Properties > Display" in the "Settings" area of the Inspector window.

 Function
This button refreshes the display in the status value column.

Use this button to accept the new value in the control value column. The control value 
is then written to the PLC.

Visible columns     
The columns that are displayed in runtime are specified in the Inspector window in the 
"General" group in the "Visible columns" area.

Column Description
"Connection" The PLC of which the address areas are displayed.
"Type"
"DB- number"
"Offset"
"Bit"

The address area of the operand.

"Data type"
"Format"

The data type of the operand.

"Status value" The value that was read from the specified address of the operand.
"Control value" The value written to the specified address of the operand.

Sequence of columns     
The operator can use the "Column ordering" property to change the sequence of columns in 
runtime.

1. Select "Properties > Properties > Columns" in the Inspector window.

2. Activate "Properties of columns > Sequence of columns".
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Display of the column headers and buttons
The layout of the "Status/Force" object is dependent on the view settings in the control panel. 
Depending on the setting, the column headers may be truncated. This setting is found under 
"Display > Appearance" in the control panel. To display column headers correctly, set the 
display in "Windows and buttons" to "Windows Classic" style. This behavior only occurs during 
configuration. The column headers are displayed correctly in runtime.   

If you change the layout, for example from "Windows Classic" to "Windows XP Style", the 
button in the "Status/Force" object may no longer be displayed. Change the size of the object 
to make the buttons in the engineering system visible again.     

See also
Device-Specific Nature of the Objects (Page 3077)

Symbol library

Application   
The "Symbol library" object contains a large collection of ready-to-use icons. These icons are 
used to represent systems and plant areas in screens.

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Select icon: Specifies which library object will be used.

● Fill style: Specifies the graphic design of the object.

● Flip: Specifies the flip type of the library object.

● Rotate: Specifies the angle around which the library object is rotated.

● Fixed aspect ratio Defines whether the aspect ratio is maintained if the size is changed.

Select symbol
Select the icon at "Properties > Properties > General" in the Inspector window.

Visualizing processes (Comfort/Advanced)
10.1 Creating screens

WinCC Comfort/Advanced V12.0 SP1
3140 System Manual, 07/2013,  



Fill style     
Specify the design of the library object at "Properties > Properties > Appearance > Style" in 
the Inspector window.

1 "Hollow" The library object is displayed in outline.
2 "Solid" Black lines remain as outlines. Elements of the icon with a different color are displayed 

as a main color.
3 "Original" The screen object will not be changed.
4 "Shaded" Black lines remain as outlines. Elements of the symbol in other colors are displayed as 

brightness levels of a main color.

At the TP 177B mono and OP 177B mono HMI devices the library object is displayed as an 
outline. "Hollow" is set as the default value for the fill style. 

If you change the setting from "hollow" to "original" or "shaded" then the color of the display 
on the configuration computer will deviate from that on the HMI device. This deviation is caused 
by the different color resolutions. You may also use a graphic object from the "Graphics" object 
group. The graphic objects are structured by topic and by depth of color in the "WinCC graphics 
folder."         

Flip and rotate       
The content of the screen flips around the horizontal or vertical central axis of the icon. The 
icon can be flipped horizontally, vertically or simultaneously horizontally and vertically. 

The screen content rotates around the central point of the icon. The symbol is rotated clockwise 
in increments of 90, 180, or 270 degrees.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the mirroring mode at "Orientation > Mirror image".

3. Select the angle of rotation at "Orientation > Rotate".

Fixed aspect ratio     
The smaller page of the library object defines the maximum size of the symbol. If you change 
the size of the library object unproportionally, the symbol is still scaled proportionally. Proceed 
as follows to configure a fixed aspect ratio:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Form > Fixed aspect ratio".
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See also
Device-Specific Nature of the Objects (Page 3077)

Symbolic I/O field 

Application   
The "Symbolic I/O field" object can be used to configure a selection list for input and output of 
texts in runtime.

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in runtime.

● Text list: Specifies the text list that is linked to the object.

● Button for selection list: Specifies that the object has a button to open the selection list.
 

  Note
Reports

In reports, symbolic I/O fields only output data. "Output" mode is preset. Properties for 
configuring the selection of graphics are not available, e.g. "button for selection list".

 

Mode   
The response of the symbolic I/O field is specified in the Inspector window in "Properties > 
Properties > General > Type".

Mode Description
"Output" The symbolic I/O field is used to output values.
"Input" The symbolic I/O field is used to input values.
"Input/output" The symbolic I/O field is used for the input and output of values.
"Two states" The symbolic I/O field is used only to output values and has a maximum of two 

states. The field switches between two predefined texts. This is used, for 
example, to visualize the two states of a valve: closed or open.

 

 Note

The behavior possible for the symbolic I/O field depends on the Runtime.
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Text list     
In the Inspector window, you specify which text list is linked to the symbolic I/O field.

1. In the Inspector window, select "Properties > Properties > General".

2. Under "Contents" open the selection list for "Text list".

3. Select a text list.

Button for selection list 
The "Button for selection list" property is used to display a button for opening the selection list.

1. Select "Properties > Properties > Layout" in the Inspector window.

2. Activate "Response > Button for selection list".
 

  Note
Basic Panels

The "Button for selection list" option is not available for Basic Panels.
 

 

See also
Device-Specific Nature of the Objects (Page 3077)

Graphic I/O field (Page 3097)

System diagnostics view

Introduction
The system diagnostics view offers you an overview of all the available devices in your plant. 
You navigate directly to the cause of the error and to the relevant device. You have access to 
all diagnostics-capable devices which you have configured in the "Devices & networks" editor.

Application
The system diagnostics view enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.

Basic Panels support only the "Basic system diagnostics view".
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Three different views are available in the system diagnostics view. 

● Device view

● Diagnostic buffer view

● Detail view

Device view   
The device view of the system diagnostics view shows all the available links in tabular form. 
Double-clicking a link opens the detail view. The device view is only displayed if more than 
one link has been created in the "Devices & Networks" editor.

Diagnostic buffer view   
In the diagnostic buffer view, the current data from the diagnostic buffer is displayed.

Detail view   
The detail view shows detailed information on the selected link. You cannot sort error texts in 
the detail view. The detail view is only available if there is an integrated link to an S7 1200 or 
S7 1500
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Layout
In the Inspector window, you customize the position, shape, style, color and font type of the 
object. You can adapt the following properties in particular:

● Lines per entry: Specifies the number of lines that are shown for an entry.

Configuring the system diagnostics view
1. Drag-and-drop the system diagnostics view from the toolbox.

2. In the Inspector window, select "Properties > Layout".

3. Enter a number under "Lines per entry", i.e. 5.

4. Select an authorization for operation in "Properties > Properties > Security".

See also
System diagnostics display (Page 3145)

System diagnostics display

Introduction
The system diagnostic view offers you an overview of all the available devices in your plant. 
You navigate directly to the cause of the error and to the relevant device. You have access to 
all diagnostics-capable devices which you have configured in the "Devices & networks" editor.
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Use
The system diagnostic view enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.

Three different views are available in the system diagnostic view. 

● Device view

● Detail view

● Diagnostic buffer view

● Matrix view (only for master systems, PROFIBUS)

Layout
In the Inspector window, you can change the position, geometry, style, color and font of the 
object. You can adapt the following properties in particular:

● Columns: Defines the elements of the device view and detail view.

● Show split view: Specifies that the device view and the detail view are shown 
simultaneously.

Configuring the system diagnostic view
1. Drag-and-drop the system diagnostic view from the toolbox.

2. In the Inspector window, select "Properties > Properties > Columns".

3. Enable the columns that you require in the device view for Runtime, for example: status, 
name, slot.

4. Activate the columns which you need in the detail view for runtime, e.g.: status, name, 
address.
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5. Activate the columns that you require in the diagnostic buffer view, e.g. status, name, rack.

6. Customize the column headers, if necessary.

7. Enter "IP" for "Address", for example.
The column header "IP" is displayed in the device view in runtime. 

8. Rename other elements if necessary.

9. Select an authorization for operation in "Properties > Properties > Security".

Showing device view and detail view in a single display
You can split the system diagnostic view and allow the device and detail view to be shown in 
the same window.

1. In the Inspector window, click "Properties > Properties > Layout".

2. Activate "Show split view".

Single display
1. In the Inspector window, select "Properties > Properties > Layout".

2. Select "Mode > Display type > Single".

Symbols in the system diagnostic view   

Icon Function
Device in operation

Device cannot be accessed
Errors in device

Device deactivated

Maintenance required

Maintenance recommended

Superimposed symbol
Shows the subordinate status 
Current configuration

Stop e.g. Update, Boot, Own initialization

Stop
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See also
Device-Specific Nature of the Objects (Page 3077)

System diagnostics window (Page 3148)

System diagnostics view (Page 3143)

System diagnostics window

Introduction
The system diagnostics window offers you an overview of all the available devices in your 
plant. You navigate directly to the cause of the error and to the relevant device. You have 
access to all diagnostics-capable devices which you have configured in the "Devices & 
networks" editor.

The system diagnostics window is only available in the global screen.

Use
The system diagnostics window enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.

Three different views are available in the system diagnostics window. 

● Device view

● Detail view

● Diagnostic buffer view

● Matrix view (only for master systems, PROFIBUS)
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Layout
In the Inspector window, you can change the position, geometry, style, color and font of the 
object. You can adapt the following properties in particular:

● Columns: Defines the elements of the device view and detail view.

● Table headers: Specifies the table headers of the view.

● Window: Specifies whether the system diagnostics window can be closed, for example.

Configuring the system diagnostics window
1. Drag and drop the system diagnostics view from the toolbox into the global screen.

2. In the Inspector window, select "Properties > Properties > Columns".

3. Activate the columns that you require in the device view for Runtime, e.g. status, name, 
slot.

4. Activate the columns that you require in the device view for Runtime, e.g. Status, Name, 
Plant designation.

5. To change a column heading, click in the field and (for example) enter "IP" for "Address".
The column header "IP" is displayed in the device view in runtime. 

6. Rename other elements if necessary.

7. To be able to close the system diagnostics window in runtime, select "Properties > 
Properties > Window > Closable" in the Inspector window.

Icons in the system diagnostics window

Button Function
Device in operation

Device cannot be accessed
Errors in device

Device deactivated

Maintenance required

Maintenance recommended

Superimposed symbol
Shows the subordinate status 
Current configuration

Stop e.g. Update, Boot, Own initialization

Stop
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See also
System diagnostics display (Page 3145)

Device-Specific Nature of the Objects (Page 3077)

Text field

Application   
The "Text field" is a closed object which you can fill with a color. 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Text: Specifies the text for the text field.

● Size of text field: Defines whether the size of the object is adapted to the space required 
by the largest list entry.

Text   
Specify the text for the text field in the Inspector window. 

1. In the Inspector window, select "Properties > Properties > General".

2. Enter a text.
For texts over several lines you can set a line break by pressing the key combination <Shift 
+ Enter>.

Size of text field   
In the Inspector window, you can define whether the size of the object is adapted to the space 
required by the largest list entry. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Resize > Fit to contents".

See also
Device-Specific Nature of the Objects (Page 3077)

Visualizing processes (Comfort/Advanced)
10.1 Creating screens

WinCC Comfort/Advanced V12.0 SP1
3150 System Manual, 07/2013,  



Clock

Application 
The "Clock" object displays the date and time.

Layout 
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Analog display: Specifies whether the clock is shown as an analog clock or digital clock.

● Display clock dial: Specifies whether hour marks of the analog clock will be displayed.

● Width and length of hands: Specifies the width and length of the hands.

Analog display 
In the Inspector window you can specify whether the clock is displayed as an analog or digital 
clock. The digital clock shows both the time and the date. The display format depends on the 
language set on the HMI device.

1. In the Inspector window, select "Properties > Properties > General":

2. Activate "Analog".

Display dial  
In the Inspector window you can specify whether hour marks will be displayed.

1. In the Inspector window, select "Properties > Properties > General":

2. Activate "Analog".

3. Activate "Show dial".

Width and length of hands  
The width of the second hand, minute hand and hour hand is set for the analog display. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter values for "width" and "length".
The values for the length are interpreted as a percentage of the size of the clock. The value 
for the length of the second hand influences the radius of the dial at the same time.
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See also
Device-Specific Nature of the Objects (Page 3077)

Effective range name

Application  
The "Effective range name" object is a control element for some SIMATIC Mobile Panels. The 
"Effective range name" object shows the names of the effective range in which the HMI device 
is located and also the logon status. 

Layout  

Symbol Meaning Description Logon status
Acknowledgement 
button has no effect

Within the "MixingAxisControl" 
effective range

It is not possible to log on to the 
effective range

Acknowledgement 
button functions

Within the "MixingAxisControl" 
effective range

Logged on to effective range

Acknowledgement 
button has no effect

Within the "MixingAxisControl" 
effective range

Logon to the effective range is 
rejected because a different 
HMI device is already logged on.
Note:
When using the "Override" 
mode: Although no other HMI 
device is still logged on to the 
effective range, logon is 
rejected because the override 
switch is still set.

Acknowledgement 
button has no effect

Outside of each effective range Note: You can only log on within 
the effective range

In the Inspector window "Properties > Properties > Security", assign an authorization to log on 
to a machine in runtime.

Logon requirements   
● The HMI device is located within the effective range.

● No HMI device is logged on to this effective range.
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Logon procedure
1. Click on the "Effective range name" object.

The "Effective range logon" dialog box opens.

2. Read the ID from the machine or plant to be operated.

3. Enter the ID you read.

4. Confirm your entries by clicking "OK".

Result
If the ID and effective range match, the HMI device is logged on to the effective range. 
Successful logon is signaled by an icon on green background. No other HMI device can log 
on to this effective range.

Requirement for logging off
The HMI device is logged on to this effective range.

Logoff procedure   
Before you leave the effective range or runtime, you must log off from the effective range first. 
If you leave the effective range without logging off, a warning appears.

1. Click on the "Effective range name" object. The "Effective range logoff" dialog box opens.

2. Confirm logoff with "Yes".

Result
The HMI device is no longer logged into the effective range. Other HMI devices can now log 
on to this effective range.

 

 Note

Do not deactivate the "Override" mode again unless you logon a different HMI device.
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See also
Device-Specific Nature of the Objects (Page 3077)

Charging status (Page 3106)

Effective range signal (Page 3156)

WLAN reception (Page 3157)

Zone name (Page 3160)

Zone signal (Page 3161)

Configuring the effective range name (Page 4887)

Effective range name (RFID)

Application  
The "Effective range name (RFID)" object is a control element for some SIMATIC Mobile 
Panels. The "Effective range name (RFID)" object shows the name of the effective range 
(RFID) in which the HMI device is located and also the logon status. 

 

 Note
RFID tags in the plant area

RFID tags may only be attached in demarcated areas which are secured by additional 
protective measures, e.g. protective fencing. 

 

Layout  

Symbol Description Description Logon status
Acknowledgement 
button has no effect

Within the effective 
range (RFID)  
"MixingAxisControl"

It is not possible to log on to the 
effective range (RFID)

Acknowledgement 
button functions

Within the effective 
range (RFID)  
"MixingAxisControl"

Logon to effective range (RFID) 
running

Acknowledgement 
button functions

Within the effective 
range (RFID)  
"MixingAxisControl"

Logged on to the effective 
range (RFID)

In the "Properties > Properties > Security" category of the Inspector window, you can assign 
an authorization for the user group that logs on to the effective range (RFID) during runtime. 
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Logon requirements   
● The HMI device is located within the effective range (RFID).

● The machine is demarcated by additional protective measures.

● No HMI device is logged on to this effective range (RFID).

Logon procedure
1. Click on the "Effective range name (RFID)" object.

The "Effective range logon" dialog box opens.

2. Read the ID from the machine or plant to be operated.

3. Enter the ID you read.

4. Confirm your entries by clicking "OK".

Result
If the ID and effective range (RFID)  match, the HMI device is logged on to the machine. 
Successful logon is signaled by an icon on green background. No other HMI device can log 
on to this effective range (RFID) or the machine.

Logoff requirements
The HMI device is logged on to this effective range (RFID).

Logoff procedure   
Before you exit the effective range (RFID) or runtime, you must first log off from the effective 
range (RFID). If you exit the effective range (RFID) without logging off, a local rampdown is 
executed.

1. Click on the "Effective range name (RFID)" object. The "Effective range (RFID) - logoff" 
dialog box opens.

2. Confirm logoff with "Yes".

Result
The HMI device is no longer logged into the effective range (RFID) or machine. Other HMI 
devices can now log on to this effective range (RFID).

See also
Device-Specific Nature of the Objects (Page 3077)

Charging status (Page 3106)

WLAN reception (Page 3157)

Configuring the effective range name (RFID) (Page 4890)
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Effective range signal

Application
The "Effective range signal" object is a control element for some SIMATIC Mobile Panels. The 
"Effective range signal" object indicates how accurately the Mobile Panel Wireless is positioned 
within an effective range.   

Layout

Symbol Description 
Within an effective range

When leaving an effective range
When entering an effective range

Outside of each effective range

Override function is activated:
Within a special security range of the effective range

The "Effective range name" object indicates which effective range this concerns.

Override function
An effective range, e.g. "robots" is formed outwardly through transponders. However, within a 
special protection zone, e.g. "robot cells", the effective range is not formed by transponders, 
but by alternative restrictions e.g. by railings and a door.

The operator initially logs on to the effective range. An operator who enters the restricted and 
secure zone "robot cells" must press an additional switch to activate the override function:   

● The effective range is allocated and can no longer be established by the transponder.

● Therefore, the quality does not play a role and is no longer displayed.

● The HMI device remains logged into the effective range.

● Other HMI devices can no longer logon to this effective range.

Calculating the signal quality
The quality within an effective range depends, as follows, on the measured distance:

● In the center of the effective range the quality is 100%.  

● On the transponder and on the border of the effective range, the quality is 0%.

Operation
The object is for display only and cannot be controlled by the operator.
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See also
Device-Specific Nature of the Objects (Page 3077)

Charging status (Page 3106)

Effective range name (Page 3152)

WLAN reception (Page 3157)

Zone name (Page 3160)

Zone signal (Page 3161)

Configuring additional Mobile Wireless objects (Page 4888)

WLAN reception

Application
The "WLAN reception" object is a control element for some SIMATIC Mobile Panels. The 
"WLAN reception" object displays the signal strength of the WLAN wireless connection. In 
addition, the signal strength is measured and displayed by means of 5 bars.    

Layout

Symbol Meaning Signal strength
No wireless connection No signal

Very poor wireless connection =<20 % 

Poor wireless connection >20 %
=<40 %

Wireless connection OK >40 %
=<60 %

Good wireless connection >60 %
=<80 %

Very good wireless connection >80 %

Operation
The object is for display only and cannot be controlled by the operator.
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See also
Device-Specific Nature of the Objects (Page 3077)

Charging status (Page 3106)

Effective range name (Page 3152)

Effective range name (RFID) (Page 3154)

Effective range signal (Page 3156)

Zone name (Page 3160)

Zone signal (Page 3161)

Configuring additional Mobile Wireless objects (Page 4888)

Gauge

Use       
The "Gauge" object shows numeric values in the form of an analog gauge. For example, a 
glance during Runtime is enough to note that the boiler pressure is in the normal range.

 

 Note

The gauge is for display only and cannot be controlled by the operator.

Configure system functions that are performed at value changes in the tag properties at the 
"Value change" event and not at the "Change" event of the gauge. If your project is to comply 
with Good Manufacturing Practices, and the system function performs a GMP-relevant action. 
e.g. increasing a GMP-relevant tag, every value change of the tag used at the gauge is 
interpreted as a user action.
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Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You can adapt the following properties in particular:

● Display peak value pointer: Specifies whether the actual measurement range is indicated 
with a slave pointer.

● Maximum Value and Minimum Value: Specifies the top and bottom values of the scale.

● Start value of the danger range and start value of the warning range: Specifies the scale 
value from which the danger range and the warning range start.

● Display normal range: Specifies whether the normal range is shown in color on the scale.

● Color of individual ranges: Different operating modes, such as normal range, warning range 
and danger range, are shown in different colors so that the operator can distinguish them 
easily.

Display peak value     
The "Display peak value" property can be used to activate a marker function for the maximum 
and minimum pointer movement in Runtime. The actual measurement range is shown with a 
slave pointer.

1. In the Inspector window, activate "Properties > Properties > Appearance > Show peak 
values".

Maximum Value and Minimum Value     
You can set the top and bottom end values of the scale in the Inspector window.

1. In the Inspector window, select "Properties > Properties > General":

2. Enter a number under "Scale > Maximum value" and at "Minimum value".
If you select a tag as the end value of the scale, the number will be no longer available.

 

 Note

Ensure that the minimum value is always less than the maximum value, especially if you 
make the minimum value or maximum value dynamic through a tag. If the minimum value is 
greater than the maximum value, no adjustment is made to the scale end values.

 

Start value of the danger range and start value of the warning range     
Define the scale value at which the danger range and the warning range start in the inspector 
window.

1. Click "Properties > Properties > Areas" in the inspector window.

2. Input the start value at "start value of danger range" and "start value of warning range".

3. Activate "start value of danger range" and "start value of warning range" to display the 
ranges on the scale.

Visualizing processes (Comfort/Advanced)
10.1 Creating screens

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3159



Normal range visible     
In the inspector window, define whether to show the normal range in color.

1. Click "Properties > Properties > Areas" in the inspector window.

2. Activate "Normal".

Color of individual ranges     
You can display the normal range, the danger range and the warning range in different colors. 
Define the color in the inspector window.

1. In the Inspector window, select "Properties > Properties > Areas".

2. Select a color from the color palette for the three areas.
 

  Note

The following restrictions apply for HMI devices with Windows CE:
● The three ranges (normal / warning / danger) are not visualized in different colors in 

Runtime.
 

See also
Device-Specific Nature of the Objects (Page 3077)

Zone name

Application
The "Zone name" object is a control element for some SIMATIC Mobile Panels. The "Zone 
name" object shows the names of the zone in which the HMI device is located.   

Layout

Symbol Meaning Description
The "On entry" and "On exit" events of the zone 
and the zone ID can be used in the configuration.

Within the "MixingPlant" zone

– Outside of each zone
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Procedure for "On entry" event
1. In the "Zones" or "Zones and effective ranges" editor, configure the function 

"ActivateScreen" on the "On entry" event.

Procedure with zone ID
1. Select an internal tag as the "Zone ID / Connection point ID" in the "Runtime settings > 

General" editor.

2. Animate the visibility of an object, e.g. "I/O field" via the internal tag.

Operation
The object is for display only and cannot be operated.

See also
Device-Specific Nature of the Objects (Page 3077)

Charging status (Page 3106)

Effective range name (Page 3152)

Effective range signal (Page 3156)

WLAN reception (Page 3157)

Zone signal (Page 3161)

Zone signal

Application
The "Zone signal" object is a control element for some SIMATIC Mobile Panels. The "Zone 
signal" object indicates how well the Mobile Panel is still in a zone. Compared to the "WLAN 
reception" object, it is not the signal strength that is measured, it is calculated from the 
distance.   

Layout

Symbol Meaning Quality
Within one zone >=15 %

When leaving a zone
When entering a zone

<15 % and
>0 %

Outside of each zone =0 %

The "Zone name" object indicates which zone this concerns.
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Calculating the signal quality
The quality of the signal within a zone depends, as follows, on the measured distance:  

● In the centre of the zone the quality is 100%.

● To the rear towards the transponder and to the front away from the transponder, the quality 
starts to diminish linearly.

● On the transponder and on the border of the zone, the quality is 0%.

Operation
The object is for display only and cannot be operated. 

See also
Device-Specific Nature of the Objects (Page 3077)

Charging status (Page 3106)

Effective range name (Page 3152)

Effective range signal (Page 3156)

WLAN reception (Page 3157)

Zone name (Page 3160)

10.1.9 Configuring screen navigation

10.1.9.1 Basics on screen navigation

Types of navigation for the screen change
For a production process consisting of multiple subprocesses, you will configure multiple 
screens. You have the following options to enable the operator to switch from one screen to 
the next in Runtime:

● Assign buttons to screen changes

● Configuring screen changes at local function keys

Procedure
Before you create a screen change, define the plant structure and derive from it the screen 
changes that you want to configure. 

Create the start screen under "Runtime Settings > General > Start screen". 
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See also
Screen basics (Page 2931)

Assigning screen change to function key (Page 3164)

Assigning button with screen change (Page 3163)

10.1.9.2 Assigning button with screen change

Introduction
Configure a button in the screen to switch between the screens on the HMI device during 
operation. 

 

 Note

If you have set the "Visibility" of animations to "Hidden" in the Inspector window of a screen, 
this screen cannot be called up in Runtime.

 

Requirements
● You have created the project.

● You have created the "Screen_2" screen.

● "Screen_1" is created.

Procedure
1. Double-click "Screen_1" in the project navigation. The screen is displayed in the work area.

2. Move "Screen_2" from the project tree to the open screen by drag&drop.
A button with the name "Screen_1" is inserted.

3. In the Inspector window, select "Properties > Events > Click".
The "ActivateScreen" system function is displayed in the "Function list". 

4. At the "Object number" attribute, define, if required, the tab sequence number of the object 
on which the focus is to be set after a screen change. You can also specify a tag that 
contains the object number.
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Alternative procedure
1. Move a button from the "Tools" task card to "Screen2" by drag&drop.

2. In the Inspector window, select "Properties > Events > Click".

3. Select the "ActivateScreen" system function.

4. Select "Screen_2" for the "Screen number".

Result
The operator goes to "Screen_1 with the button in Runtime. If you have specified an object 
number, the object with this object number has the focus following a screen change. 

See also
Basics on screen navigation (Page 3162)

10.1.9.3 Assigning screen change to function key

Introduction
Configure a screen change function key in the screen to switch between the screens on the 
HMI device during operation. 

 

 Note

If you have set the "Visibility" of animations to "Hidden" in the inspector window of a screen, 
this screen cannot be called up in Runtime.

 

Requirements
● You have created a project.

● You have created the "Screen_2" screen.

● You have created the "Screen_1" screen.

Procedure
1. Double click "Screen_1" in the project tree. The screen is displayed in the work area.

2. Move "Screen_2" from the project tree to a function key, e.g. "F2".
The configured function key displays a yellow triangle. 

3. Click "Properties > Events > Press key" in the inspector window.
The "ActivateScreen" system function is displayed. 
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Result
The operator goes to the specified "Screen_2" with function key "F2" in Runtime. 

See also
Basics on screen navigation (Page 3162)

Visualizing processes (Comfort/Advanced)
10.1 Creating screens

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3165



10.2 Working with Tags

10.2.1 Basics

10.2.1.1 Basics of tags

Introduction
Process values are forwarded in runtime using tags. Process values are data which is stored 
in the memory of one of the connected automation systems. They represent the status of a 
plant in the form of temperatures, fill levels or switching states, for example. Define external 
tags for processing the process values in WinCC.

WinCC works with two types of tag:

● External tags

● Internal tags

The external tags form the link between WinCC and the automation systems. The values of 
external tags correspond to the process values from the memory of an automation system. 
The value of an external tag is determined by reading the process value from the memory of 
the automation system. It is also possible to rewrite a process value in the memory of the 
automation system.

Internal tags do not have a process link and only convey values within the WinCC. The tag 
values are only available as long as runtime is running.

Tags in WinCC
For external tags, the properties of the tag are used to define the connection that the WinCC 
uses to communicate with the automation system and form of data exchange.   

Tags that are not supplied with values by the process - the internal tags - are not connected 
to the automation system. In the tag's "Connection" property, this is identified by the "Internal 
tag" entry.

You can create tags in different tag tables for greater clarity. You then directly access the 
individual tag tables in the "HMI tags" node in the project tree. The tags from all tag tables can 
be displayed with the help of the table "Show all tags".
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With structures you bundle a number of different tags that form one logical unit. Structures are 
project-associated data and are available for all HMI devices of the project. You use the "Types" 
editor in the project library to create and edit a structure.

See also
Creating external tags (Page 3173)

Editing a Tag (Page 3177)

Tag Limits (Page 3183)

Indirect addressing of tags (Page 3197)

Internal Tags (Page 3172)

Basics on arrays (Page 3201)

Basics on user data types (Page 3204)

Cycle basics (Page 3212)

Trends (Page 3237)

Overview of HMI tag tables (Page 3167)

Addressing external tags (Page 3170)

Basic principles for data logging (Page 3214)

External tags (Page 3169)

Outputting tag values in screens (Basic) (Page 3235)

10.2.1.2 Overview of HMI tag tables

Introduction
HMI tag tables contain the definitions of the HMI tags that apply across all devices. A tag table 
is created automatically for each HMI device created in the project.    

In the project tree there is an "HMI tags" folder for each HMI device. The following tables can 
be contained in this folder:

● Default tag table

● User-defined tag tables

● Table of all tags

In the project tree you can create additional tag tables in the HMI tags folder and use these to 
sort and group tags and constants. You can move tags to a different tag table using a drag-
and-drop operation or with the help of the "Tag table" field. Activate the "Tags table" field using 
the shortcut menu of the column headings.

Default tag table
There is one default tag table for each HMI device of the project. It cannot be deleted or moved. 
The default tag table contains HMI tags and, depending on the HMI device, also system tags. 
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You can declare all HMI tags in the standard tags table or, as necessary, additional user-
defined tables of tags.

User-defined tag tables
You can create multiple user-defined tag tables for each HMI device in order to group tags 
according to your requirements. You can rename, gather into groups, or delete user-defined 
tag tables. To group tag tables, create additional subfolders in the HMI tags folder. 

All tags
The "All tags" table shows an overview of all HMI tags and system tags of the HMI device in 
question. This table cannot be deleted, renamed or moved. This table also contains the "Tags 
table" column, which indicates the tag table of where a tag is included. Using the "Tags table" 
field, the assignment of a tag to a tags table can be changed. 

With devices for Runtime Professional, the table "All tags" contain an additional tab "System 
tags". The system tags are created by the system and used for internal management of the 
project. The names of the system tags begin with the "@" character. System tags cannot be 
deleted or renamed. You can evaluate the value of a system tag, but cannot modify it.

Additional tables
The following tables are also available in an HMI tag table:

● Discrete alarms

● Analog alarms

● Logging tags

With the help of these tables you configure alarms and logging tags for the currently selected 
HMI tag. 

Discrete alarms table
In the "Discrete alarms" table, you configure discrete alarms to the HMI tag selected in the 
HMI tag table. When you configure a discrete alarm, multiple selection in the HMI tag table is 
not possible. You configure the discrete alarms for each HMI tag separately.

Analog alarms table
In the "Analog alarms" table, you configure analog alarms to the HMI tag selected in the HMI 
tag table. When you configure an analog alarm, multiple selection in the HMI tag table is not 
possible. You configure the analog alarms for each HMI tag separately.

Logging tags table
In the "Logging tags" table, you configure logging tags to the HMI tag selected in the HMI tag 
table. When you configure a logging tag, multiple selection in the HMI tag table is not possible. 
You configure the logging tags for each HMI tag separately. The "Logging tags" table is only 
available if the HMI device used supports logging. 
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If WinCC Runtime Professional is used, you can also assign several log tags to a tag. With 
the other HMI devices, you can only assign one log tag to a tag.

See also
Basics of tags (Page 3166)

10.2.1.3 External tags

Introduction
External tags allow communication (exchange of data) between the components of an 
automation system, such as between the HMI device and the PLC.

Principle
An external tag is the image of a defined memory location in the PLC. You have read and write 
access to this storage location from both the HMI device and from the PLC.  

Since external tags are the image of a storage location in the PLC, the applicable data types 
depend on the PLC which is connected to the HMI device.

In STEP 7, if you write a PLC control program, the PLC tags created in the control program 
will be added to the PLC tag table. If you want to connect an external tag to a PLC tag, access 
the PLC tags directly via the PLC tag table and connect them to the external tag.

Data types
All the data types which are available at the connected PLC are available at an external tag 
in WinCC. Information about data types which are available for connection to other PLCs can 
be found in the documentation about the respective communication drivers.

See "Auto-Hotspot" for additional information.
 

 Note

As well as external tags, area pointers are also available for communication between the HMI 
device and PLC. You can set up and enable the area indicators in the "Connections" editor.

 

Update of tag values
For external tags, the current tag values are transmitted in runtime via the communication 
connection between WinCC and the connected automation systems and then saved in the 
runtime memory. Next, the tag value will be updated to the set cycle time. For use in the runtime 
project, WinCC accesses tag values in the runtime memory that were read from the PLC at 
the previous cycle time. As a result, the value in the PLC can already change whilst the value 
from the runtime memory is being processed.   
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See also
Basics of tags (Page 3166)

10.2.1.4 Addressing external tags

Introduction
The options for addressing external tags depend on the type of connection between WinCC 
and the PLC in question. A distinction must be made between the following connection 
types:         

● Integrated connection
Connections of devices which are within a project and were created with the "Devices & 
Networks" editor are referred to as integrated connections.

● Non-integrated connection
Connections of devices which were created with the "Connections" editor are referred to 
as non-integrated connections. It is not necessary that all of the devices be within a single 
project.

The connection type can also be recognized by its icon.

Integrated connection
Non-integrated connection

You can find additional information in the section "Basics of communication (Page 4911)".

Addressing with integrated connections
An integrated connection offers the advantage that you can address a tag both symbolically 
and absolutely.

For symbolic addressing, you select the PLC tag via its name and connect it to the HMI tag. 
The valid data type for the HMI tag is automatically selected by the system. You have to 
distinguish between the following cases when you address elements in data blocks:

Symbolic addressing of data blocks with optimized access and standard access: 

During the symbolic addressing of a data block with optimized access and standard access, 
the address of an element in the data block is dynamically assigned and is automatically 
adopted in the HMI tag in the event of a change. You do not need to compile the connected 
data block or the WinCC project for this step.
For data blocks with optimized access, only symbolic addressing is available.

For symbolic addressing of elements in a data block, you only need to recompile and reload 
the WinCC project in case of the following changes:

● If the name or the data type of the linked data block element or global PLC tag has changed.

● If the name or the data type of the higher level structure node of a linked element in the 
data block element or global PLC tag has changed.

● If the name of the connected data block has changed.

Symbolic addressing is currently available with the following PLCs:

Visualizing processes (Comfort/Advanced)
10.2 Working with Tags

WinCC Comfort/Advanced V12.0 SP1
3170 System Manual, 07/2013,  



● SIMATIC S7 1200

● SIMATIC S7 1500

Symbolic addressing is also available if you have an integrated link.

 
 

 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

You can also use absolute addressing with an integrated connection. You have to use absolute 
addressing for PLC tags from a SIMATIC S7 300/400 PLC. If you have connected an HMI tag 
with a PLC tag and the address of the PLC tag changes, you only have to recompile the control 
program to update the new address in WinCC. Then you recompile the WinCC project and 
load it onto the HMI device.

In WinCC, symbolic addressing is the default method. To change the default setting, select 
the menu command "Options > Settings". Select "Visualization > Tags" in the "Settings" dialog. 
If required, disable the "Symbolic access" option.     

The availability of an integrated connection depends on the PLC used. The following table 
shows the availability:

PLC Integrated connection Comments
S7 300/400 Yes The linking of tags is not checked in Runtime. If 

the tag address changes in the PLC and the HMI 
device is not compiled again and loaded, the 
change is not registered in runtime.

S7 1200 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. In the case of absolute addressing, the 
following behavior applies to the S7 300/400.

S7 1500 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. In the case of absolute addressing, the 
following behavior applies to the S7 300/400.

Create an integrated connection in the "Devices & Networks" editor. If the PLC is contained in 
the project and integrated connections are supported, you can then also have the connection 
created automatically. To do this, when configuring the HMI tag, simply select an existing PLC 
tag to which you want to connect the HMI tag. The integrated connection is then automatically 
created by the system.

Addressing with non-integrated connections
In the case of a project with a non-integrated connection, you always configure a tag connection 
with absolute addressing. Select the valid data type yourself. If the address of a PLC tag 
changes in a project with a non-integrated connection during the course of the project, you 
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also have to make the change in WinCC. The tag connection cannot be checked for validity 
in Runtime, an error message is not issued.

A non-integrated connection is available for all supported PLCs.

Symbolic addressing is not available in a non-integrated connection.

With a non-integrated connection, the control program does not need to be part of the WinCC 
project. You can perform the configuration of the PLC and the WinCC project independently 
of each other. For configuration in WinCC, only the addresses used in the PLC and their 
function have to be known.

See also
Basics of communication (Page 4911)

Basics of tags (Page 3166)

10.2.1.5 Internal Tags

Introduction
Internal tags do not have any connection to the PLC. Internal tags transport values within the 
HMI device. The tag values are only available as long as runtime is running. 

Principle
Internal tags are stored in the memory of the HMI device. Therefore, only this HMI device has 
read and write access to the internal tags. You can create internal tags to perform local 
calculations, for example.   

You can use the HMI data types for internal tags. Availability depends on the HMI device being 
used.

The following HMI data types are available:

HMI data type Data format
ARRAY One-dimensional array
BOOL Binary tag
DATETIME Date/time format
DINT Signed 32-bit value
INT Signed 16-bit value
LREAL Floating-point number 64-bit IEEE 754
REAL Floating-point number 32-bit IEEE 754
SINT Signed 8-bit value
UDINT Unsigned 32-bit value
UINT Unsigned 16-bit value
USINT Unsigned 8-bit value
WSTRING Text tag, 16-bit character set
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See also
Basics of tags (Page 3166)

10.2.2 Working with Tags

10.2.2.1 Creating tags

Creating external tags

Introduction
You can access an address in the PLC via a PLC tag using an external tag. The following 
options are available for addressing:

● Symbolic addressing

● Absolute Addressing

You can find further details on symbolic addressing in section "Addressing external tags 
(Page 3170)". If possible, use symbolic addressing when configuring a tag. You create tags 
either in the standard tag table or in a tag table you defined yourself.         

Requirement
● You have opened the project.

● A connection to the PLC is configured.

● The Inspector window is open.

Procedure
To create an external tag, proceed as follows:

1. Open the "HMI tags" folder in the project tree and double-click the standard tag table. The 
tag table open.
Alternatively, create a new tag table and then open it.

2. In the "Name" column, double-click "Add" in the tag table. A new tag is created.

3. Select the "Properties > Properties >General" category in the Inspector window and, if 
required, enter a unique tag name in the "Name" field. The tag name must be unique 
throughout the device.

4. If required, select the "Display name" field to enter a name to be displayed in Runtime. The 
name to be displayed is language-specific and can be translated for the required Runtime 
languages. The display name is available for Basic Panels, Panels and Runtime Advanced.
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5. Select the connection to the required PLC in the "Connection" box. If the connection you 
require is not displayed, you must first create the connection to the PLC. You create the 
connection to a SIMATIC S7 PLC in the "Devices & Networks" editor. You create the 
connection to external PLCs in the "Connections" editor.
If the project contains the PLC and supports integrated connections, you can also have the 
connection created automatically. To do this, when configuring the HMI tag, simply select 
an existing PLC tag to which you want to connect the HMI tag. The integrated connection 
is then automatically created by the system.

6. If you are working with an integrated connection, click the  button in the "PLC tag" field 
and select an already created PLC tag in the object list. Click the  button to confirm the 
selection.

7. If you are working with a non-integrated connection, enter the address from the PLC in the 
"Address" field. The "PLC tag" field remains empty.

8. Configure the other properties of the tag in the inspector window.

You can also configure all tag properties directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.     

You can also create new tags alternatively directly at the application point, e.g. on an I/O field. 
To do this, click the  button in the object list. You then configure the new tag in 
the Inspector window.

Result
An external tag has been created and linked to a PLC tag or an address in the PLC.

 

Alternative procedure
You can also create external HMI tags by dragging and dropping data block elements or global 
PLC tags in an HMI tag table. 
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See also
Creating internal tags (Page 3175)

Creating multiple tags (Page 3176)

Basics of tags (Page 3166)

Addressing external tags (Page 3170)

Editing a Tag (Page 3177)

Tag Limits (Page 3183)

Indirect addressing of tags (Page 3197)

Creating internal tags

Introduction
You must at least set the name and data type for internal tags. Select the "Internal tag" item, 
rather than a connection to a PLC.               

For documentation purposes, it is a good idea to enter a comment for every tag.

Requirement
You have opened the project.

Procedure
1. Open the "HMI tags" folder in the project tree and double-click the entry "Standard tag 

table". The tag table opens.
Alternatively, create and then open a new tag table.

2. Double-click "Add" in the "Name" column of the tag table. A new tag is created.

3. If the Inspector window is not open, select the "Inspector window" option in the "View" menu.

4. Select the "Properties > Properties >General" category in the Inspector window and, if 
required, enter a unique tag name in the "Name" field. This tag name must be unique 
throughout the project.

5. If required, select the "Display name" field to enter a name to be displayed in Runtime. The 
name to be displayed is language-specific and can be translated for the required Runtime 
languages. The display name is available for Basic Panels, Panels and Runtime Advanced.

6. Select "Internal tag" as the connection in the "Connection" field.

7. Select the required data type in the "Data type" field.

8. In the "Length" field, you must specify the maximum number of characters to be stored in 
the tag according to the selected data type. The length is automatically defined by the data 
type for numerical tags.

9. As an option, you can enter a comment regarding the use of the tag. To do so, click 
"Properties > Properties > Comment" in the Inspector window and enter a text.
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You can also configure all tag properties directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.

You can also create new tags alternatively directly at the application point, e.g. on an I/O field. 
Click the  button in the object list. You can then configure the new tag in the 
Properties window that opens.

Result
An internal tag is created. You can now use this in your project.

In additional steps you can configure the tag, for example, by setting the start value and limits.

See also
Creating external tags (Page 3173)

Creating multiple tags

Introduction
In a tag table, you create additional identical tags by automatically filling the rows of the table 
below a tag.

The tag names are incremented automatically when filling in automatically.

You can also use the auto fill function to fill table cells below a tag with a single tag property 
and thus modify the corresponding tags.

If you apply the automatic filling in to already filled cells of a tab table, you will be asked whether 
you want to overwrite the cells or insert new tags.

If you do not want to overwrite already configured tags, activate insert mode. Activate insert 
mode by keeping the <Ctrl> key pressed during insertion. Already existing entries in the tag 
table are moved down if insert mode is activated.

Requirement
● You have opened the project.

● A tag table is open.

● The tag which is to serve as a template for other tags is configured.
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Procedure
1. If you want to create new tags, mark in the "Name" column the tag that should be used as 

a template for the new tags.
If you want to copy a property of a tag to the tags below it, select the cell which contains 
this property.
The selected cell will be highlighted in color and a small blue square will appear in its bottom 
right corner. If you move the mouse over this square, the cursor will change to a black cross.

2. Hold down the mouse button and drag this square over the cells below that you wish to fill 
automatically.
The marking will be extended to cover this area.

3. Now release the mouse button. All of the marked cells will be filled automatically.
New tags will be created in all empty cells in the marked area.

Result
Depending on which cells were selected, the function may automatically fill individual 
properties or create new tags.

See also
Creating external tags (Page 3173)

10.2.2.2 Editing tags

Editing a Tag

Introduction
You can always rename, copy or delete tags.

When a tag is renamed, the new name must be unique for the whole device.

If you use the "Copy" command to copy a tag to the clipboard, the objects and references 
linked to the tag are copied as well.

If you use the "Insert" command to add a tag to another device, the tag will be added without 
the connected references. Only the object name of the reference will be inserted. If a reference 
of the same name and valid properties exists in the target system, the existing reference will 
then be connected to the copied tag.

If you copy a tag, some of the objects linked to the tag are copied as well. The following objects 
are copied:

● Logging tags

● Cycles

● Alarms
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If you add the copied tag to another device, the tag is added together with the linked objects.

Requirement
● The tag which you wish to rename, copy or delete must exist.

● The tag table containing the tag is open.

Renaming tags
1. In the "Name" field, select the tag in the tag table.  

2. Select "Rename" from the shortcut menu.

3. Type in a new name.
The tag appears under its new name.

Copying tags
1. Mark one or more tags in the tags table.  

2. Select "Copy" from the shortcut menu.

3. Click on the point at which you want to insert the tag. For example, click another tag table 
in the same device or the tag table in a second device.

4. Select "Paste" from the shortcut menu. The tag is inserted as described above.

Deleting a tag
1. Select one or more tags in the tag table.  

2. Select the "Cross-reference" command from the "Tools" menu. In the "Cross-reference" 
editor, check to see where the tags are used. In this manner, you can see what impact the 
deletion of the tag will have on your project.

3. Select "Delete" in the pop-up menu of the tag.
All marked tags will be deleted.

Export and import of tags
WinCC gives you the option to export and import tags. With Export and Import, you have the 
option to export tags from one project and import them into another project. There is also the 
option to create larger numbers of tags outside of WinCC, edit them and subsequently import 
into any WinCC project. For further details, refer to Importing and exporting tags (Page 5519).
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See also
Changing the tag configuration (Page 3179)

Configuring multiple tags simultaneously (Page 3179)

Using multiple tags simultaneously in a screen (Page 3180)

Basics of tags (Page 3166)

Reconnecting a tag (Page 3182)

Creating external tags (Page 3173)

Importing and exporting tags (Page 5519)

Changing the tag configuration

Introduction
You can modify tags at any time to adapt them to changed requirements in the project.   

Changing the tag configuration
if you want to change the configuration of a tag, open the tag table in which the tag is contained. 
Open the "Show all tags" tag table alternatively.

In the tag tables, you can perform such tasks as comparing and adjusting the properties of 
multiple tags or sorting the tags by their properties.

Change the properties either directly in the table or in the inspector window.

If you change a tag property and this change causes a conflict with another property, it will be 
highlighted in color to draw your attention to this fact. This could happen, for example, if you 
connect the tag to another PLC which does not support this data type.

See also
Editing a Tag (Page 3177)

Configuring multiple tags simultaneously

Introduction
In WinCC, you can assign the same properties to multiple tags in a single operation. This 
facilitates efficient programming.   

Requirement
● You created the tags you want to configure.

● The tag table is open.

● The Inspector window is open.
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Procedure
1. In the tag table, select all the tags that you want to configure at the same time.

If the selected property is identical for all the tags, the setting for this property will appear 
in the Inspector window. The associated field will remain blank otherwise.

2. You can define the shared properties in the Inspector window or directly in the tag table.

if you change a property commonly on several tags, only this one property is changed. The 
other properties of the tag remain unchanged.

Result
All marked tags will be reconfigured.

To edit tag properties which differ from one tag to the other, simply clear the multiple selection.

See also
Editing a Tag (Page 3177)

Using multiple tags simultaneously in a screen

Introduction
In WinCC, you can create multiple I/O fields that are linked with tags in one screen in a single 
operation. This facilitates efficient programming.

Requirement
● Several tags are set up.

● A screen is open.
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Procedure
1. In the project tree, select the required tag table under "HMI tags".

2. Select the detail view at the bottom of the project tree. The detail view shows the tags that 
exist in the selected tag group.

3. Mark the tags in the detail window.

4. Drag the tags to the screen. For each tag, this creates an I/O field that is connected to the 
tag.

 

 Note

When you move a PLC tag from the detail window to the work area by drag&drop, a network 
and a connection are created additionally in the "Devices & Networks" editor.

 

 

See also
Editing a Tag (Page 3177)
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Reconnecting a tag

Introduction
WinCC enables you to automatically connect tags to addresses in the PLC. This procedure is 
suitable if, for example, changes were made to the connection between the HMI device and 
the PLC and the tag connections were lost. The function can also be used if you have 
configured the control program and HMI project separately.

The shortcut menu "Reconnect PLC tag" is available for this.

The menu command is available under the following conditions:

● An integrated connection to the PLC is present.

● The absolute address from the PLC is entered in the HMI tag.

● The HMI tag is configured with the correct data type.

The menu command is not available at a tag with symbolic addressing.

If you select multiple tags, the menu command is available if at least one of the selected tags 
meets the above-mentioned requirements. Only the tags that meet the requirements are 
connected.

Requirement
● You have created an HMI tag.

● The tag table is open.

● A PLC tag with the absolute address from the PLC is present.

Procedure
Proceed as follows to reconnect tags:

1. Select the row with the tag in the tag table.

2. Open the shortcut menu and select the menu command "Reconnect PLC tag".
The system looks for a PLC tag whose absolute address and data type match the settings 
for the HMI tag. If a matching PLC tag is found, the tag connection is established 
immediately.

Result
The PLC tag is connected to the HMI tag.

See also
Editing a Tag (Page 3177)
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10.2.2.3 Configuring Tags

Tag Configuration Basics

Tag Limits

Introduction
You can restrict the value range with limits for numerical tags.

Principle
You can specify a value range defined by a high limit and a low limit for numerical tags.   

If the operator enters a value for the tag that is outside the configured value range, the input 
is rejected. The value is not accepted. You configure a function list when configuring for 
Runtime Advanced and Panels. When the tag value leaves the value range, the function list 
is processed. 

 

 Note

If you want to output an analog alarm when a limit is violated, configure the respective tag in 
the "Analog alarms" tab. You can also configure the analog alarm in the "HMI alarms" editor. 
The values for output of an analog alarm depend on the configured tag limits.

 

Application example
Use the limits to warn the operator when the value of a tag enters a critical range, for example.
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See also
Defining Limits for a Tag (Page 3184)

Start value of a tag (Page 3185)

Defining the start value of a tag (Page 3186)

Updating the Tag Value in Runtime (Page 3186)

Linear scaling of a tag (Page 3187)

Applying linear scaling to a tag (Page 3189)

Connecting a tag to another PLC (Page 3189)

Basics of tags (Page 3166)

Address multiplexing (Page 3190)

Configuring address multiplexing with absolute addressing (Page 3191)

Configuring address multiplexing with symbolic addressing (Page 3194)

Creating external tags (Page 3173)

Defining Limits for a Tag

Introduction
For numerical tags, you can specify a value range by defining a low and high limit.    

For Runtime Advanced and Panels you can configure the system to process a function list 
whenever a tag value drops below or exceeds its configured value range.

Requirement
● The tag for which you want to set the limits is created.

● The Inspector window with the properties for this tag is open.

Procedure
To define limits for a tag, proceed as follows:

1. In the Inspector window select "Properties > Properties > Limits." If you want to define one 
of the limits as a constant value, select "Constant" using the  button. Enter a number in 
the relevant field.
If you want to define one of the limits as a tag value, select "HMI tag" using the  button. 
Use the object list to define the tag for the limit.

2. To set additional limits for the tag, repeat step 1 with the appropriate settings.

Alternative procedure
You can also configure the high and low limit directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.
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Configuring a function list for Runtime Advanced and Panels
When you configure Runtime Advanced and Panels, you can have a function list called up if 
a high or low limit is violated.

1. If you want to start a function list when the value drops below the value range, click 
"Properties > Events > Minimum violated" in the Inspector window. Create a function list in 
this dialog.

2. If you want to start a function list when the value exceeds the value range, click "Properties 
> Events > Maximum violated" in the Inspector window. Create a function list in this dialog.

Result
You have set a value range defined by a high and low limit for the selected tag. If the value 
range is exceeded or undershot, a function list may be carried out.

See also
Tag Limits (Page 3183)

Start value of a tag

Value of a tag at start of Runtime
You can configure a start value for numeric tags and tags for date/time values. The tag will be 
preset to this value when Runtime starts. In this way, you can ensure that the tag has a defined 
status when Runtime starts.   

For external tags, the start value will be displayed on the HMI device until it is overwritten by 
the PLC or by input.

If no start value was configured, the tag contains the value "0" when starting Runtime.

In WinCC Runtime Professional you can enter a tag value in place of the start value on a tag 
with the "String" data type. The tag value is saved in the "Project texts" editor and is multilingual. 
After the text has been translated, it is displayed in Runtime as a language-dependent start 
value.

Application example
You can assign a default value to an I/O field. Enter the desired default value as start value 
for the tag that is linked to the I/O field. 

See also
Tag Limits (Page 3183)
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Defining the start value of a tag

Introduction
In WinCC you can configure a start value for a numeric tag and a tag for date/time values 
which this adopts at Runtime start. 

Requirement
● You have created the tag for which you want to define a start value.

● The Inspector window with the tag properties is open.

Procedure
To configure a start value, proceed as follows:

1. In the Inspector window select "Properties > Properties > Values."

2. Enter the desired "Start value."

Alternative procedure
You can also configure the start value directly in the tag table. To view hidden columns, activate 
the column titles using the shortcut menu.

Result
The start value you selected for the tag is transferred to the project.

See also
Tag Limits (Page 3183)

Updating the Tag Value in Runtime

Introduction
Tags contain process values which change while Runtime is running. Value changes are 
handled differently at internal and external tags.      

Principle
When Runtime starts, the value of a tag is equal to its start value. Tag values change in 
Runtime.

In Runtime, you have the following options for changing the value of a tag:
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● A value change in an external tag in the PLC.

● By input, for example, in an I/O field.

● By running a system function, such as "SetValue."

● A value assignment in a script.

Updating the Value of External Tags
The value of an external tag is updated as follows:      

● Cyclic in operation
If you select the "Cyclic in operation" acquisition mode, the tag is updated in Runtime while 
it is displayed in a screen or is logged. The acquisition cycle determines the update cycle 
for tag value updates on the HMI device. You can either choose a default acquisition cycle 
or define a user-specific cycle.

● Cyclic continuous
If you select the "Cyclic continuous" acquisition mode, the tag will be updated continuously 
in Runtime, even if it is not in the currently-open screen. This setting is activated for tags 
that are configured to trigger a function list when their value changes, for example.   
Only use the "Cyclic continuous" setting for tags that must truly be updated. Frequent read 
operations increase communication load.

● On demand
If you select the "On demand" acquisition mode, the tag is not updated cyclically. It will only 
be updated on demand using the "UpdateTag" system function, for example, or by a script. 

See also
Tag Limits (Page 3183)

Linear scaling of a tag

Introduction
Numeric data types can be processed with linear scaling. The process values in the PLC for 
an external tag can be mapped onto a specific value range in the project.
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Principle
To apply linear scaling to a tag, you must specify one value range on the HMI device and one 
on the PLC. The value ranges will be mapped to each other linearly. 

As soon as data from the HMI device is written to an external tag, it will be automatically 
mapped to the value range of the PLC. As soon as data from the HMI device is read from the 
external tag, a corresponding transformation will be performed in the other direction.

 

 Note

You can also use the system functions "LinearScaling" and "InvertLinearScaling" to 
automatically convert process values.

 

Application example
The user enters length dimensions in centimeters but the PLC is expecting inches. The entered 
values are automatically converted before they are forwarded to the controller. Using linear 
scaling, the value range [0 to 100] on the PLC can be mapped onto the value range [0 to 254] 
on the HMI device.

See also
Tag Limits (Page 3183)
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Applying linear scaling to a tag

Introduction
To apply linear scaling to a tag, you must specify one value range on the HMI device and one 
on the PLC. The value ranges will be mapped to each other linearly. 

Requirement
● The external tag to which linear scaling is to be applied must exist.

● The Inspector window with the properties for this tag is open.

Procedure
To apply linear scaling to a tag, follow these steps:

1. In the Inspector window select "Properties > Properties > Linear scaling."

2. Click on "Enable" to switch on linear scaling.
Using this option, you can temporarily switch off linear scaling for testing purposes, for 
example. Settings which were made earlier for linear scaling remain unchanged.

3. In the "PLC" area, enter the start and end values of the value range to be applied to the 
process values on the PLC.

4. In the "HMI device" area, enter the end and start values of the value range to be applied to 
the process values on the HMI device.

Result
In Runtime the data will be automatically mapped from one value range to the other.

 

 Note

You can also use the "LinearScaling" and "InvertLinearScaling" system functions to 
automatically convert process values.

 

See also
Tag Limits (Page 3183)

Connecting a tag to another PLC

Introduction
In WinCC, you can change the PLC connection of a tag at any time. This is needed when you 
change the configuration of your plant, for example.
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Depending on the PLC selected, you may need to modify the configuration of the tag. The tag 
properties which must be changed will be highlighted in color.   

Requirement
● The external tag, whose connection you wish to change, must already exist.

● The connection to the PLC must already exist.

● The Properties window for this tag is open.

Procedure
To change the PLC connection of a tag, proceed as follows:

1. In the Inspector window select "Properties > Properties > General."

2. Select the new connection in the "Connection" field.
The tag properties that you must change will be highlighted in color in the tag table and in 
the Inspector window.

3. Change all highlighted properties of the tag to suit the requirements of the new PLC.

Result
The external tag is connected to the new PLC.

See also
Tag Limits (Page 3183)

Address multiplexing

Introduction
Using address multiplexing, you can use a single tag to access a multitude of memory locations 
within the PLC's address range. You read and write to the addresses without defining a tag 
for each individual address.

Multiplexing with absolute addressing
When using multiplexing with absolute addressing, you configure tags as placeholders for the 
address in the PLC to be addressed.    

If you want to access, for example, an address of the format "%DBx.DBWy", the expression 
for multiplexing is as follows:

"%DB[HMITag1].DBW[HMITag2]"

In Runtime, you supply the tag "HMITag1" with the required value for the data block you want 
to address. 

In Runtime, you supply the tag "HMITag2" with the required address from the data block.
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Tags are supplied with values, for example, with the help of values from the PLC or via a script.

Multiplexing with absolute addresses is supported for the following PLCs and communication 
drivers. 

● SIMATIC S7 300/400

● SIMATIC S7 1200

Multiplexing with absolute addresses is not available for data blocks with optimized access.

Multiplexing with symbolic addressing
When multiplexing with symbolic addressing, you access an array element of an array tag in 
a data block of the connected PLC by means of a multiplex tag and an index tag. The multiplex 
tag contains the symbolic address of the data block which you want to access. The symbolic 
address also contains the index tag via which you access the index of the array tag.   

If you want to access, for example, the array tag "Arraytag_1" in the data block "Datablock_1", 
the expression for symbolic addressing is as follows:

"Datablock_1.Arraytag_1["HMITag_1"]

You control the access to the index of the array elements with the HMI-Variable "HMITag_1". 
In Runtime, you supply the tag with the index of the array element that you want to access.

Multiplexing with symbolic addressing is only available if the following components support 
symbolic addressing:

● the HMI device

● PLC

● Communication driver

Symbolic addressing is currently only supported by the SIMATIC S7 1200 communication 
driver.

See also
Tag Limits (Page 3183)

Configuring address multiplexing with absolute addressing

Introduction
When using address multiplexing, you can efficiently access different addresses in the PLC 
with the help of a small number of tags. Instead of the absolute address in the PLC, you use 
tags in order to be able to change the address in Runtime.

Requirement
● The tag for address multiplexing is created and connected to the PLC.

● The Properties window for this tag is open.
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Procedure
1. Select the tag for address multiplexing in the tag table, and select "Properties > Properties 

> General" in the Inspector window. The general properties of the tag are displayed.

2. Select the "Int" data type for this example.

3. Select the access type "Absolute addressing".

4. Click the selection button in the "Address" field. The address dialog opens.

5. Click the selection button in the "DB number" field and select the entry "HMI tag".
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6. In the "DB number" field, click the  button and select a tag for the DB number in the object 
list. Or create a new tag with the help of the object list. Accept the tag by clicking the  
button.

7. Repeat steps 3 and 4 for the "Address" field and configure a further tag for calling the 
address area in the data block.

The selection options in the Address dialog depend on the selected data type of the multiplex 
tag. The Address dialog offers only address settings that can be configured with the selected 
data type. 

Result
In runtime, the multiplex tag is used to access the memory location corresponding to the 
address currently found in the tag. You control access to the data block with the tag in the DB 
number field. You control access to the address in the selected data block with the tag in the 
"Address" field. 

 

 Note

The value in the memory location will only be read at the next update cycle for the addressed 
tag. 

If, for example, you use a multiplex tag in a script, do not attempt to access contents of the 
memory location directly after changing it. 

 

See also
Tag Limits (Page 3183)
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Configuring address multiplexing with symbolic addressing

Introduction
When using address multiplexing, you can efficiently access different addresses in the PLC 
with the help of a small number of tags. Instead of the symbolic address in the PLC, you use 
tags in order to be able to change the address in Runtime.

Requirement
● The tag for address multiplexing is created.

● The Properties window for this tag is open.

● A data block with an array tag is created in the connected PLC.

● The data block was compiled.
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Procedure
1. Select the tag for address multiplexing in the tag table, and select "Properties > Properties 

> General" in the Inspector window. The general properties of the tag are displayed.

2. Select the connection to the PLC via the "Connection" field.

3. Select the access type "Symbolic addressing".
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4. Navigate to the data block of the PLC via the "PLC tag" field and select an array element 
of the array tag.

5. Click the selection button in the "Address" field. The address dialog opens. 

6. Click the selection button in the "Index tag" field and select the entry "HMI tag".

7. In the "Index tag" field, click the  button and select a tag for the array index in the object 
list. Or create a new tag with the help of the object list. Accept the tag by clicking the  
button.

Result
In Runtime, the array element whose index value is contained in the index tag is accessed.
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See also
Indirect addressing of tags (Page 3197)

Tag Limits (Page 3183)

Special configuration options

Indirect addressing of tags

Principle
In multiplexes, a type of indirect addressing, the tag used is first determined at runtime. A list 
of tags is defined for the multiplex tag. The relevant tag is selected from the list of tags in 
runtime. The selection of the tag depends on the value of the index tag.

In Runtime, the system first reads the value of the index tag. Then the tag which is specified 
in the corresponding place in the tag list is accessed. 

Application example
Using indirect addressing, you could configure the following scenario: 

The operator selects one of several machines from a selection list. Depending on the operator's 
selection, data from the selected machine will be displayed in an output field.

To configure such a scenario, configure the index tag for a symbolic I/O field. Configure the 
multiplex tag at an I/O field. Configure the tag list of the multiplex tag to reflect the structure of 
the selection list.

If the operator selects another machine, the value of the index tag will change. The selection 
field then displays the content of the tag that is pointed to in the tag list in the multiplex tag by 
the new index value.

See also
Addressing tags indirectly (Page 3198)

Using tags to trigger functions (Page 3199)

Defining the acquisition cycle for a tag (Page 3200)

Basics of tags (Page 3166)

Configuring address multiplexing with symbolic addressing (Page 3194)

Creating external tags (Page 3173)
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Addressing tags indirectly

Introduction
With indirect addressing, the tag used is first determined at runtime. Instead of a single tag, a 
list of tags is defined. The list entries consist of an index value and the name of the tag to be 
used. Using an index tag, you can control which entry in the tag list will be accessed.      

Requirement
● The tag which you wish to address indirectly must already exist.

● The index tag must exist.

● The tags which will be contained in the tag list must already exist.

● The Inspector window with the tag properties is open.

Procedure
To address tags indirectly, proceed as follows:

1. In the Inspector window select "Properties > Properties > Multiplexing".

2. Select the "Multiplexing" option to activate indirect addressing.
Using this option, you can temporarily switch off indirect addressing for testing purposes, 
for example. Settings which were made earlier for indirect addressing remain unchanged. 

3. Select an "Index tag" or define a new tag using the object list.

4. Click the first entry in the "Tags" column in the tag list.

5. Select a tag as a list entry or define a new tag using the object list.
The entry in the "Index" column will be generated automatically.

6. Repeat step 5 for all tags that you wish to add to the tag list.

7. If necessary, you can use drag-and-drop to change the order of the entries in the list.

Result
In runtime, the system will dynamically access the tag in the tag list which has the same index 
value as the value currently in the index tag.

See also
Indirect addressing of tags (Page 3197)

Visualizing processes (Comfort/Advanced)
10.2 Working with Tags

WinCC Comfort/Advanced V12.0 SP1
3198 System Manual, 07/2013,  



Using tags to trigger functions

Introduction
You can use the values of variables as the triggering event for an action in runtime. To start 
an action in Runtime, configure a function list for a tag. Include one or more system functions 
or VB scripts in the function list. The function list is processed when the configured event 
occurs.     

The following events are available for a tag: 

● Change in value of the tag
Function list processing is triggered by each change in the value of the variable.
When the tag is defined as an array tag, the function list is processed whenever an array 
element changes.

● Violation of the tag's high limit
The function list is processed when the high limit is violated.

● Violation of the tag's low limit
The function list is processed when the low limit is violated.

Requirement
● The tag whose value you wish to use as an event already exists.

● The Inspector window with the properties for this tag is open.

Procedure
To configure a tag with a function list, proceed as follows:

1. Under "Properties > Events >" in the Inspector window, select the event for which you want 
to create a function list.
The function list associated with the selected event is shown.

2. Click "<Add function>". The second table column contains a selection button.

3. Click the selection button and select a system function.

4. Define the parameter values.

Alternatively, select a script to run in the function list, rather than a system function. The "VB 
scripts" entry is only displayed if there is a script available in the project.

Result
If the configured event occurs in Runtime, the function list or the script is processed.

See also
Indirect addressing of tags (Page 3197)
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Defining the acquisition cycle for a tag

Introduction
The value of an external tag can be changed in Runtime by the PLC to which the tag is linked. 
To ensure that the HMI device is informed of any changes in tag values by the PLC, the values 
must be updated on the HMI. The value is updated at regular intervals while the tag is displayed 
in the process screen or is logged. The interval for regular updates is set with the acquisition 
cycle. The update can also be made continuous.     

Requirement
● You have created the tag for which you want to define an acquisition cycle.

● The Inspector window with the tag properties is open.

Procedure
To configure an acquisition cycle for a tag, follow these steps:

1. In the Inspector window select "Properties > Properties > General."

2. If you want to update the tag at regular intervals as long as it is being displayed on the 
screen or logged, select "Cyclic in operation" as the acquisition mode.
Or:
If you want to update the tag at regular intervals even though it is not being displayed on 
the screen or logged, select "Cyclic continuous" as the acquisition mode.
The "Cyclic continuous" setting is selected for a tag, for example, that has a function list 
configured for a change of its value and that is not directly visible in a screen.

3. Select the required cycle time in the "Acquisition cycle" field or define a new acquisition 
cycle using the object list.

Alternatively, you can configure the acquisition cycle directly in the work area of the tag table. 
To view hidden columns, activate the column titles using the shortcut menu.

 

 Note

Only use the "Cyclic continuous" acquisition mode for tags that really have to be continuously 
updated. Frequent read operations generate a heavy communication load.

 

Result
The configured tag is updated in Runtime with the selected acquisition cycle.

See also
Indirect addressing of tags (Page 3197)
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10.2.3 Working with arrays

10.2.3.1 Basics on arrays

Definition
Array data of a uniform data type is successively arranged and is addressed within the address 
space to allow access to these data by means of an index. The individual array elements are 
addressed by means of an integer index. Each array element is assigned the same properties 
which are configured at the array tag.       

Advantages
You can configure numerous array elements with the same properties all at once with a single 
array tag. You can then use each array element as any other tag in your configuration. 

Restrictions
The following restrictions apply to the use of arrays:

● Arrays are only available in projects for Runtime Advanced and Panels; array tags are not 
available for Runtime Professional.

● An array may contain only one dimension.

● The lower index of an array must begin with "0".

Application examples
Array tags can be used in the following situations:

● To group process values in profile trends: You map process values to trends which are 
acquired at different points in time, for example.

● To access specific values which are grouped in trends: For example, display all recorded 
values of the profile trend by gradually increasing the index tag.

● To configure discrete alarms with successive bit number.

● To save the complete machine data records in a recipe.

Visualizing processes (Comfort/Advanced)
10.2 Working with Tags

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3201



License rule for runtime
An array tag is counted in WinCC Runtime as one PowerTag, regardless of the number of 
array elements.

Special features
 

 WARNING

Increased system load and performance losses

Read or write access to a single array element always includes read or write access to all 
array elements of the array tag. Transfer of the data of large arrays from and to the PLC 
usually takes longer compared to the transfer of a basic data type. This may cause 
communication overload and disruption as a result.

 

Example:
● An array tag which consists of 100 array elements of data type "Real" was configured.

● If an array element with a length of four bytes changes, 100 x 4 bytes are written to the 
PLC.

Use in scripts.
To maintain performance, always use internal arrays to change arrays in scripts.

1. Copy the PLC array to the internal array at the start of the script.

2. Load on data transfer to the PLC is avoided while the script processes the internal array.
 

 
 CAUTION

Data inconsistency at array tags

If the value of a single element must be changed in an array tag, the whole array is read, 
changed and rewritten as a complete array. Changes carried out in the meantime to other 
array elements in the PLC are overwritten during rewriting.

You should always prevent the HMI device and the PLC from concurrently writing values 
to the same array tag. Use synchronous transfer of recipe data records to synchronize an 
array tag with the PLC.

 

See also
Basics of tags (Page 3166)

Creating array tags (Page 3203)

Examples of arrays (Page 3204)
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10.2.3.2 Creating array tags

Introduction
Create an array tag to configure a large number of tags of the same data type. The array 
elements are saved to a consecutive address space.

You can create an array tag as an internal tag or as an external tag.

If you want to create an array tag as an external tag, first configure an array tag in a data block 
of the connected PLC. You then connect the array tag to an HMI tag.    

Requirement
● The HMI tag table is open.

Procedure
To create an array tag, follow these steps:

1. Double click <Add> in the "Name" column of the HMI tag table.
A new HMI tag is created.

2. Click  in the Data type column and select the "Array" data type.

3. Click  in the data type column. The dialog box for configuring the array is opened.

4. Select the desired data type for the array tag in the "Date type" field.

5. Define the number of array elements in the "Array limits" field. The lower limit must begin 
with "0".

6. Click . The settings for the array are saved.

7. Save the project.
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Result
An array tag is created. The properties of the array elements are inherited from the parent 
array tag.

See also
Basics on arrays (Page 3201)

10.2.3.3 Examples of arrays

Introduction
Array tags combine a number of tags, e.g. 100 array elements. You use array tags as complete 
arrays in the following places:

● In the "Alarms" editor

● In the "Recipes" editor

● For address multiplexing

● In the trend view

You use individual array elements everywhere in the configuration like HMI tags.

Examples
You can configure an array tag with the corresponding number of array elements to handle 
multiple tags of the same data type.

● The individual array elements can be accessed indirectly by means of a multiplex index 
tag, for example.

● Use these index tags to operate and monitor the array elements.

See also
Basics on arrays (Page 3201)

10.2.4 Working with user data types

10.2.4.1 Basics on user data types

Introduction
With user data types you bundle a number of different tags that form one logical unit. You 
create a user data type as a type and use instances of this type in the project. User data types 
are project-associated data and are available for all HMI devices of the project. 

Visualizing processes (Comfort/Advanced)
10.2 Working with Tags

WinCC Comfort/Advanced V12.0 SP1
3204 System Manual, 07/2013,  



User data types differ in their association to a family of devices. User data types are available 
for the following families of devices:

● WinCC Runtime Advanced and Panels

● WinCC Runtime Professional

User data types also differ in their applicability with a specific communication driver. User data 
types are available for the following communication drivers:

● SIMATIC S7 300/400

● SIMATIC S7 1200

● SIMATIC S7 1500

Create user data types and user data type elements in the project library.           

Principle
For example, the different conditions of a motor can be described using six unique Boolean 
tags.

If the overall condition should be described with a single tag, this tag can be created based on 
a user data type. For each of the individual Boolean tags you create a user data type element 
in the user data type. 

This user data type can then be assigned complete to a faceplate for the motor. The created 
and released version of user data type is displayed at the tag in the "Data type" selection field.

The configured properties of a user data type are used in the instances of the user data type. 
If required, you change individual properties directly at the point of use, e.g. at a tag. Changing 
a property at the tag does not affect the user data type created.

 

 NOTICE

Availability of user data types

The connection of user data types to faceplates is only supported in WinCC Runtime 
Advanced and Panels.
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License regulation in Runtime
If you use external tags of the "User data type" data type in a faceplate instance, each user 
data type element is counted as a tag in Runtime.

Example
You have created two screens in the "Screens" editor: Screen_1 and Screen_2

3 instances of a faceplate type are inserted in Screen_1. 4 instances of a faceplate type are 
inserted in Screen_2. 

Each faceplate instance is connected to an external tag of the "User data type" data type. The 
user data type includes 10 user data type elements.

Screen 1: 3 faceplate instances * 10 user data type elements corresponds to 30 external tags 
= 30 PowerTags.

Screen 2: 4 faceplate instances * 10 user data type elements corresponds to 40 external tags 
= 40 PowerTags.

In Runtime, 70 PowerTags are counted together for both screens. This also applies to the user 
data type elements that are not required.

See also
Basics of tags (Page 3166)

Creating tags with a user data type data type (Page 3210)

Managing versions of user data types (Page 3209)

Creating user data type elements (Page 3208)

Creating a user data type (Page 3206)

10.2.4.2 Creating a user data type

Introduction
You create a user data type in the project library.         

Requirement
● A project is open.

● The "Libraries" task card is displayed or the library view is open.

Procedure
To create a user data type, follow these steps:

1. Click the "Libraries" task card.

2. Double-click the "Project library" item. The folder structure of the project library is open.
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3. Click the "Create new type" button.
A dialog opens.

4. Click the "HMI UDT" button in the dialog. 

5. In the "Specify device for the new type" area select the HMI device on which the user data 
type is used.

6. Enter a descriptive name in the "Name" field. 

7. Click "OK" to apply your settings. The user data type is created. The library view opens.

 

Result
A user data type with the configured properties is created. Version  0.0.1 of the user data type 
is created and receives the status "in progress". 

Create the required user data type elements in the next step.

Before you use the version of user data types, for example at a tag, the version must be 
released.

See also
Basics on user data types (Page 3204)

Managing versions of user data types (Page 3209)
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10.2.4.3 Creating user data type elements

Introduction
You define user data type elements in the library view. You add or delete elements in the "HMI 
user data types" table in the work area.

Requirement
● The library view is open.

● A user data type is created and opened in the editor.

Procedure
1. Select a communication driver for the user data type.

● If you select the <Internal communication> entry, you can only assign the user data type 
to the internal tags as the data type.

● If a connection to a PLC is selected as the communication driver, the user data type can 
only be assigned to tags with a connection to this PLC as the data type.

● The communication type set applies to all user data type elements of a user data type. In 
a user data type for the"WinCC Runtime Professional" family of devices, you can define for 
each user data type element whether the configured driver is used for control or internal 
communication.

1. Double-click "Add" in the "Name" column of the table. A new user data type element is 
added to the user data type.

2. Assign a name.

3. Select the required data type in the "Data Type" field.

4. Create as many user data type elements as you need.

5. You configure the user data type elements in the "Properties" group in the Inspector window.

Alternatively, you can configure the properties of the user data type elements directly in the 
table. To view hidden columns, activate the column titles using the shortcut menu.

Result
You have added elements to version 0.0.1 of the user data type. The version 0.0.1 has the 
status "in progress".

To use the version in the project, release the version in the next step.

See also
Basics on user data types (Page 3204)
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10.2.4.4 Managing versions of user data types

Introduction   
All user data types have at least one version. When a user data type is created, a version is 
created at the same time and this version has the status "in progress". You can edit the user 
data type in this status as required. When the editing is complete, you release the version of 
the user data type.

Requirement
● You have created a user data type.

● The user data type has the version 0.0.1. and the status "In progress".

● The "Libraries" task card or the library view is open.

Releasing a version   
1. Select the version 0.0.1 of the user data type in the project library.

2. Select "Release version" in the shortcut menu.
A dialog opens.

3. If necessary, change the properties of the version:

● Enter a name for the type in the "Name" field.

● In the "Version" field, define a main and an intermediate version number for the 
version to be released.

1. Select the options for the release:

● Select the "Delete all unused versions of the affected type" to delete all versions of 
the same type from the library if these are not assigned any instance in the project and no 
other dependencies exist.

You have released version 0.0.1 of the user data type.

Editing a version  
1. Select, for example, the released version 0.0.1 of a user data type in the project library.

2. Select "Edit type" in the shortcut menu. 

The library view opens. The new version 0.0.2 of the user data type is created.

The version has the status "in progress". 

Restoring the last version of a user data type
The last released version of the user data type is version 0.0.2. 

You edit the user data type. A new version of the user data type, 0.0.3, is generated and 
receives the status "In progress".
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1. Select the version of the user data type in the project library.

2. Select "Discard changes and restore version" in the shortcut menu.

Alternative

1. If you have opened a version for editing, click "Discard version" in the toolbar.
The version is deleted.

All changes to the user data type since the last release operation are discarded. The user data 
type is released again and has version 0.0.2.

Deleting user data type
To delete a user data type, follow these steps:   

1. In the project library, under "Types", select the user data type you want to delete.

2. Select "Delete" from the shortcut menu. If the user data type is being used in a faceplate, 
a request will be made to confirm deletion of the user data type.

If you delete a user data type, you also delete all user data type elements contained therein. 
The entry remains in the allocated tag. In the "Tags" editor, a colored background appears to 
draw your attention to the fact that an invalid data type has occurred by the deletion. 

If you delete a user data type, all instances and copy templates of this user data type are 
deleted as well. You are informed by a warning message that the deletion action will delete 
existing instances or copy templates. Deletion starts after confirmation of the warning message 
with "OK".

See also
Basics on user data types (Page 3204)

Creating a user data type (Page 3206)

10.2.4.5 Creating tags with a user data type data type

Introduction
When a tag is created, you assign the version of user data type as a data type. In the "Tag" 
editor you can create internal tags or tags with a link to a PLC. A tag has access to all user 
data type versions that use the same communication driver as the tag itself. 
In connection with a PLC, a user data type can only be used if the absolute addressing is 
selected.

Requirement
● A user data type with a user data type element is created.

● The user data type is enabled.

● The tag table is open.

● The Inspector window with the tag properties is open.
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Procedure
To create a tag of the "User data type" data type, follow these steps:

1. In the "Name" column, double-click "Add" in the tag table. A new tag is created.

2. In the Inspector window select "Properties > Properties > General".

3. Enter a unique tag name in the "Name" field.

4. Select the connection to the required PLC in the "Connection" box.

5. Select the desired version of the user data type in the "Data type" field. 
The selected connection determines which user data types will be displayed.
For internal tags, only user data type versions of the <Internal user data type> type are 
available.

For tags with a connection to a PLC, only those user data types that have a link to a PLC 
can be accessed.

6. Enter the address of the PLC that you want to access with the external tags in the "Address" 
field of the "Settings" area. The specified address must always point to the start data bit, 
for example, <DB1.DBX0.0>.
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Result
You have created a tag of the "User data type" data type. In additional steps you can configure 
the tag, for example, by setting the start value and limits.

With tags of the "User data type" data type, you can connect the dynamic properties of a 
faceplate instance, which then supplies these properties with values in Runtime.

If you wish to change the properties of a user data type tag, you must change the properties 
of the user data type element.

Properties such as "Start value", "Use substitute value" or " Linear scaling" can be changed 
in the employed instances of the user data type.

See also
Basics on user data types (Page 3204)

10.2.5 Working with cycles

10.2.5.1 Cycle basics

Introduction
Cycles are used to control actions that regularly occur in runtime. Common applications are 
the acquisition cycle, the logging cycle and the update cycle. You can also define your own 
cycles in addition to those already provided in WinCC.      

Principle
In Runtime, actions that are performed regularly are controlled by cycles. Typical applications 
for cycles:

● Acquisition of external tags
The acquisition cycle determines when the HMI device will read the process value of an 
external tag from the PLC. Set the acquisition cycle to suit the rate of change of the process 
values. The temperature of an oven, for example, changes much more slowly than the 
speed of an electrical drive.
Do not set the acquisition cycle too low, since this will unnecessarily increase the 
communication load of the process.

● Logging process values
The logging cycle determines when a process value is saved in the logging database. The 
logging cycle is always an integer multiple of the acquisition cycle.

The smallest possible value for the cycle depends on the HMI device that will be used in your 
project. For most HMIs, this value is 100 ms. The values of all other cycles are always an 
integer multiple of the smallest value.
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If the cycles provided in WinCC do not meet the needs of your project, you can define your 
own cycles using the "Cycles" editor. User-defined cycles must always be an integer multiple 
of the smallest value.

 

 Note
Device dependency

You cannot configure self-defined cycle times for Basic Panels.
 

Application example
You can use cycles for the following tasks:

● To regularly log a process.

● To draw attention to maintenance intervals.

See also
Basics of tags (Page 3166)

Defining cycles (Page 3213)

10.2.5.2 Defining cycles

Introduction
Use cycles to control actions that are run at regular intervals in Runtime. You can also define 
your own cycles in addition to those already provided in WinCC.   

Requirement
You have opened the project.

Procedure
1. Double-click the "Cycles" entry in the project navigation.

The "Cycles" editor opens.

2. In the "Name" column of the "Cycles" editor, double-click "Add".
A new cycle time is created.

3. Enter a unique name in the "Name" field.

4. Select the desired cycle unit.

Visualizing processes (Comfort/Advanced)
10.2 Working with Tags

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3213



5. Select the desired value for the cycle time.
The available selection of values varies depending on the cycle unit selected. The smallest 
possible value for the cycle depends on the HMI device that will be used in your project. 
For most HMIs, this value is 100 ms. The available values are always an integer multiple 
of this value.

6. As an option, you can enter a comment regarding the use of the cycle.

Result
The cycle you configured is created and beside the default cycles in WinCC for use during 
configuration.

See also
Cycle basics (Page 3212)

10.2.6 Logging tags

10.2.6.1 Basic principles for data logging

Introduction
Data logging is used to collect, process and log process data from an industrial system. 

When you analyze the logged process data, you can extract important business and technical 
information regarding the operational state of the system. 

Application of the data logging
You can use data logging to analyze error statuses and to document the process. By analyzing 
data logs, you can extract the information necessary to allow you to optimize maintenance 
cycles, increase product quality and ensure that quality standards are met. 

See also
Data logging (Page 3215)

Logging Tags (Page 3218)

Basics of tags (Page 3166)
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10.2.6.2 Data logging in Runtime Advanced and Panels

Basics

Data logging

Introduction
Data is information that is collected during the process and saved in the memory of one of the 
connected automation systems. They represent the status of a plant in the form of 
temperatures, fill levels or switching states, for example. You define tags for acquiring and 
editing the process values in WinCC.   

External tags are used in WinCC to collect process values and to access a memory address 
in the connected automation system. Internal tags are not connected to any process and are 
only available to the associated HMI device.

Principle
The values of external and internal tags can be saved in data logs. Create a log tag for every 
tag and specify the log in which it is saved.

Data logging is controlled via cycles and events. Logging cycles are used to ensure continuous 
acquisition and storage of the tag values. You can also trigger tag logging in response to 
events, such as the change in value of a tag. Define these settings independently for each log 
tag.   

In runtime, the tag values which are to be logged are captured, processed and stored in an 
ODBC database or a file.

Logging methods
In WinCC, you have access to the following logging methods:       

● Circular log

● Segmented circular log

● Circular log which sends a system alarm message when it is full

● Circular log which executes system functions when it is full.
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Storage media and storage location
The logged data is stored in an ODBC database or in a file. An ODBC database is only available 
on a PC.  

Depending on the hardware configuration of the HMI device, the data logs and alarm logs can 
be saved locally (on the hard disk of the PC or on the memory card on a panel) or, if available, 
on a network drive.

You can further process the saved data in other programs for analysis purposes, for example.

Outputting logged data
In runtime, you can output the logged tag values as trends in the process screens.  

See also
Basic principles for data logging (Page 3214)

Storage locations of logs (Page 3216)

Storage locations of logs

Storage location of a log
Depending on the HMI device used, you have several options of setting up the storage location 
for a data log you may be using in WinCC flexible.

File - CSV (ASCII)
Data is saved to a CSV file in standard ASCII format.
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Use the "File - CSV (ASCII)" storage location if you are going to read or evaluate logged data 
without using WinCC Runtime.

 

 Note

Double quotation marks or several characters are not permitted as list separators for the 
storage location "File - CSV (ASCII)." You can find the settings for list separators under "Start 
> Settings > Control Panel > Regional and Language Options".

 

File - TXT (Unicode)
Data is stored in Unicode.

This file format supports all characters that can be used in WinCC and WinCC Runtime. For 
editing, you will need software that can save files in Unicode, such as Notepad.

 

 Note

Use "File - TXT (Unicode)" as the storage location to log Asian languages.
 

File - RDB
Data will be saved with quick access to a proprietary database. 

Use the "File - RDB" storage location if you require maximum read performance in Runtime. 

Data logs of this format can only be read or displayed using WinCC Runtime.

Convert the RDB file to CSV format using the "CopyLog" function to make the data available 
for applications outside WinCC Runtime.

Logs with checksum
The following files are generated under special circumstances:    

*.keep

1. If a log is started without checksum and will be continued with a checksum.

2. If you update WinCC with a service pack or a new version and the Audit Trail or the log is 
continued with the checksum.

The content of the keep file will remain the same when compared with the original csv file or 
txt file. 

*.bak

If WinCC Runtime has determined a serious, irregular problem in the file.

Database
Data is saved to a database which is set up for ODBC access by the PC administrator. 
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See also
Data logging (Page 3215)

Working with Data Logs

Logging Tags

Introduction
In Runtime, you store tag values in logs. You can then analyze the logged data at a later date. 
You define the following conditions for logging a tag:       

● The log tag, through which the values of the connected tag are logged.

● The data log in which the tag is stored.

● The cycle or the event with which the tag is stored.

● The value range within which the tag is stored.
 

  Note

You use data logging mainly to log the values of external tags. You can also log the values 
of internal tags.
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Principle
Several steps come together during data logging:

● Creating and configuring the data log
When you create a data log, you define the following settings:

– General settings, such as name, size and storage location

– Runtime start characteristics

– Behavior when the log is full

● Configuring the logging of tags
For every log tag, specify a data log in which the values of the connected tags and other 
information are logged, such as the time of logging.
When and how often the values of a log tag are logged are also defined. You have the 
following options: 

– "On demand":
The tag values are logged by calling the "LogTag" system function.

– "On change":
The tag values are logged as soon as the HMI device detects a change in the value of 
the tag.

– "Cyclic":
The tag values are logged at regular intervals. You can supplement the default cycles 
in WinCC with your own cycles based on the default cycles. The smallest value that can 
be set is 1 s. All other values are integer multiples of this value.
You can also restrict the logging of values within or outside a tolerance band. In this 
way, the logging of values within a relevant range of values is restricted.

 
Note the following points if you want to log a tag on demand:

– Do not log this type of tag in a segmented circular log in which tags are logged in a 
continuous cycle or in response to changes.

Background:

– If logging takes place on demand only rarely, the log segment will be filled by cyclically-
logged values, for example, and the next log segment will be created. If you then attempt 
to access the tag that was logged on demand, it will not be possible to display the tag 
since it is the current log segment that is accessed in Runtime. To remedy this, you 
should create a separate data log for tags that are logged only rarely.

● Further processing logged tag values
You can analyze the logged tag values directly in your project, such as in a trend view, or 
in another user program, such as Excel.
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See also
Creating a data log (Page 3220)

Managing logging behavior when Runtime starts (Page 3222)

Controlling the Logging in relation to the Fill Level (Page 3223)

Logging process values (Page 3224)

Triggering a system function when log is full (Page 3226)

System functions for logs (Page 3227)

Basic principles for data logging (Page 3214)

Configuring logging tags (Page 3233)

Configuring a checksum for a log (Page 3228)

Evaluating the checksum of log data (Page 3229)

Creating a data log

Introduction
Data logs are used to store values from external and internal tags in runtime. When you create 
a log, you must give it a name and define its size and storage location. In addition you can 
enter comments for each log.   

Requirement
● A project is open.

● The Inspector window is open.

Procedure
To create a data log, proceed as follows:

1. Double-click on the "Historical Data" entry in the project tree.
The editor for data logs and alarm logs opens.

2. Open the "Data logs" tab and double-click "Add" in the "Name" column of the "Data logs" 
editor.
A new data log is created.

3. In the Inspector window select "Properties > Properties > General."

4. Enter a unique name for the log in the "Name" field.

5. Define the number of data records to be logged in each log in the "Number of data records 
per log" field.
The size of a log is calculated as follows: The number of items * the length of each tag 
value to be logged.
In the Inspector window, the maximum size that the log can reach if the currently selected 
number of data records is observed is displayed beneath the "Number of data records" 
input field.
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6. In the "Storage location" field, select whether the logged data should be stored in a file or 
in a database. The log can only be stored in a database on a PC.

7. If you selected "File" as the storage location, select the storage location for the file in the 
"Path" field.
On PC HMI devices, you save the log on the hard disk or on a network drive, if there is one. 
The syntax for path specification is as follows:

– For hard disk: <C:\My_File_Folder\My_Archives\Machine_1>

– For network drive: <\\My_Fileservername\My_File_Folder\My_Archives\Machine_1>

Select one the following storage location for Panel HMI devices:

– Memory card
Select the path <\Storage Card MMC>. Here, as required, a sub-folder can be specified, 
for example <\Storage Card MMC\My_Archives\TagLogs>

– USB memory 
Select the path <\Storage Card USB>. Here, as required, a sub-folder can be specified, 
for example <\Storage Card USB\My_Archives\TagLogs>

– Network drive
The syntax to specify the path is as follows: <\\My_Fileservername\My_File_Folder
\My_Archives\Machine_1>

The selection available depends on the HMI device in use.

8. If you selected "Database" as the storage location, specify whether the data source name 
from the system should be used or whether you want to enter one yourself. In the latter 
case, enter a name for the data source.

9. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Data log" editor. To view hidden 
columns, activate the column titles using the shortcut menu.

 

 Note

The characters which can be used in the name of the data source depend on the storage 
location.

If the "File" storage location is used, the following characters must not be used: \ / * ? : " < > 
|

If the "Database" storage location is used, the following characters may be used: a-z A-Z 0-9 
_ @ # $
However, the characters _ @ # $ may not be used as the first character of the name.   

The names of logs must be unique in a project. Log names must also be unique if different 
storage locations are selected for different logs. You must also assign different names for 
alarm logs and data logs.  

 

Result
The data log is created.

You can now configure tags so that their values are stored in this log.
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To continue the log configuration, perform the following steps:

● Define the restart characteristics of the log when Runtime is started.

● Define how the log should behave when it is full.

● Configure a function list for the "Overflow" event.

See also
Logging Tags (Page 3218)

Managing logging behavior when Runtime starts

Introduction
When you configure a data log, you define the restart characteristics of the log when Runtime 
is started. You define whether the logging should start when Runtime starts in the log 
properties. You can also define whether an existing log will be continued or overwritten.  

You define the restart characteristics separately for each log.

Requirement
● A data log has been created.

● The "Data log" editor is open.

● The Inspector window with the log properties is open.

Procedure
To configure the restart characteristics of a data log, proceed as follows:

1. Select the log for which you want to define the restart characteristics in the "Data Log" editor.

2. In the Inspector window select "Properties > Properties > Restart behavior."

3. If you want logging to start when Runtime starts, enable the "Enable logging at runtime 
start" option in the "Logging" area.
You can also start logging in Runtime using the "StartLogging" system function, for example.

4. Select the restart behavior of the log in the "Log handling at restart" area.

– The logged values are deleted and logging is started again with the option "Reset log".

– The option "Append data to existing log" is used to append the values to be logged to 
the existing log.

Alternatively you can configure the restart characteristics of a log directly in the "Data log" 
editor table. To view hidden columns, activate the column titles using the shortcut menu.

Result
Logging will start in runtime according to your settings. 
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See also
Logging Tags (Page 3218)

Controlling the Logging in relation to the Fill Level

Introduction
The size of a log is determined by the number of entries. You use the logging method to 
determine how the log responds when it is full.   

Logging methods
The following logging methods are available:

●  Circular log
When the configured log size has been reached, the oldest entries are deleted. When the 
configured log size has been reached, approx. 20% of the oldest entries are deleted. It is 
therefore not possible to display all the configured entries. During configuration, select an 
appropriate size for the circulation log. Alternatively, configure a segmented circular log.  

●  Segmented circular log
In a segmented circular log, multiple log segments of the same size are filled in succession. 
When all logs are completely full, the oldest log is overwritten.

●  Log that sends a system alarm when it is full
When a defined level is reached, such as 90 %, a system alarm is triggered. When the log 
is 100% full, new tag values are not logged. 

●  Log with level-dependent triggering of an event.
When the log is completely full, the "Overflow" event is triggered. Configure a function list 
for the event that will be carried out when the "Overflow" event occurs. When the configured 
size of the log is reached, new tag values are not logged.
The following system functions are available for further processing of full logs: For further 
details, refer to System functions for logs (Page 3227).

Requirement
● A data log has been created.

● The "Data log" editor is open.

● The Inspector window with the log properties is open.
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Procedure
1. Select the log for which you want to define the logging method in the "Data Log" editor.

2. Select "Properties > Properties > Logging method" in the Inspector window and select the 
required logging method.

3. If you have selected the "Segmented circular log" type, enter the number of log segments.
If you selected a log with the "Display system alarm on" setting, specify the level as a 
percentage at which a system alarm is to be triggered.
If you selected the "Trigger event" setting, configure the function list in the "Events" group.

Alternatively you can configure the logging method directly in the "Data log" editor table. To 
view hidden columns, activate the column titles using the shortcut menu.

The "Overflow" event is not available in the editor table. You must therefore configure the 
function list in the Inspector window.

Result
The selected log responds according to the settings in Runtime.

See also
Logging Tags (Page 3218)

System functions for logs (Page 3227)

Logging process values

Introduction
You can save the process values of a tag in a data log in Runtime. You define the following 
conditions for logging a tag:

● The log tag, through which the values of the connected tag are logged.

● In which log the values are stored

● The conditions under which the values are stored

● If only process values for a certain range of values are stored          

To log the tag values, assign a logging tag to an HMI tag. The logging tag is stored in the data 
log and logs the values of the connected HMI tag. You can configure logging tags directly in 
the "HMI tags" editor. The " HMI tags" editor contains the "Logging tags" editing table.
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If the view of the "Logging tags" table is minimized, click the arrow button below the tag table.

Figure 10-1 The "Logging tags" table is displayed.

Requirement
● The data log has been created.

● The tag for which you wish to configure the logging must already exist.

● The "Tags" editor is open.

● The "Logging tags" table is displayed.

● The Inspector window with the tag properties is open.

Procedure
To log process values in a tag, proceed as follows:

1. Select a tag in the tag table.

2. Double-click "Add" in the "Name" field in the "Logging tags" table.
A new logging tag is created; it is given the same name as the associated HMI tag.

3. Select the data log in which the values of the tags are to be logged under "Properties > 
Properties > General" in the Inspector window.

4. Select "Properties > Properties > Logging type" in the Inspector window and select the log 
type for logging.

– "Cyclic": The tag values are logged in accordance with the set logging cycle.

– "On change": The tag values are logged, as soon as the operator device detects a 
change in value.

– "On demand": The tag values are logged by calling the "LogTag" system function.
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5. If you want to log tag values cyclically, select a cycle time in the "Logging cycle" area. 
Alternatively, you can define your own cycle using the object list. The smallest value that 
can be set is 1 s. All other values are integer multiples of this value.

6. If you only want to log tag values outside or inside a defined value range, select "Properties 
> Properties > Deadband for logging" in the Inspector window. Define the values for the 
high and low limits.
If you want to configure a dynamic limit, select "HMI tag" using the selection button. In the 
second field, select the tag that contains the limit.
If you want to configure a fixed limit, select "Constant." Enter the limit value in the second 
field.
If you want to leave a limit undefined, select "None".

7. Under "Scope", specify whether tag values are to be logged only if they are within the 
defined limits or only if they are outside the defined limits.

Alternatively, you can configure the logging of a tag directly in the "Logging tags" editor table. 
To view hidden columns, activate the column titles using the shortcut menu.

You can also fully configure a logging tag in the "Historical Data" editor.

Result
The process values of the configured tag are logged in Runtime according to the selected 
settings.

 

 Note

To have the tag values actually logged in runtime, you must ensure that the data log is started. 
Logging can be started automatically at start up or by means of a system function. To 
automatically start the log, use the setting in the log Properties window.

 

See also
Logging Tags (Page 3218)

Triggering a system function when log is full

Introduction
You can select a logging method that executes a function list as soon as the log is full.  

Application example
You can use system functions, for example, to swap the data from a full log file out to another 
log before the full log is overwritten. You can then continue to process the transferred data in 
another program. Assign the "CopyLog" system function to the "Overflow" event accordingly.  
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Requirement
● A log with the "Trigger event" logging method is created.

● The "Data log" editor is open.

● The Inspector window with the data log properties is open.

Procedure
To configure a system function for the "Overflow" event, proceed as follows:

1. Select the required log in the table in the "Data Log" editor.

2. In the Inspector window select "Properties > Events > Overflow."
The function list will open.

3. Double-click "Add function" and select the desired system function.

4. Configure the required parameters of the selected system function.

Result
During runtime, the function list will be executed as soon as the log is full.

See also
Logging Tags (Page 3218)

System functions for logs

System functions
The following system functions are available for logging:

Function name How it works
ArchiveLogFile This function moves or copies a log to another storage location for long-

term archiving. Use the system function if you want to move the Audit Trail, 
for example, from a local storage medium to the server.
With Audit Trails, always use the "Move log (hmiMove)" mode, otherwise 
you will be violating the FDA guideline by duplicating the data stored.

LogTag Saves the value of the given tags in the given data log. Use the system 
function to log a process values at a specific time.

StartLogging Starts the logging process in the specified log. You can interrupt logging 
in Runtime by calling the "StopLogging" system function.

StopLogging Stops the logging process in the specified log. To resume logging in 
Runtime, select the "StartLogging" system function.

ClearLog Deletes all entries in the specified log.
StartNextLog Stops the logging process in the specified log. Logging is continued in the 

log segment that has been configured for the given log.
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Function name How it works
CloseAllLogs Closes all logs. The connection between WinCC and the log files or log 

database is terminated. You can use this system function, for example, to 
enable hot-swapping of the storage medium on the HMI device without 
exiting the Runtime software.

OpenAllLogs Opens all logs to resume logging. The connection between WinCC and 
the log files or log database is restored.

CopyLog Copies the contents of the specified log to another log.

See also
Logging Tags (Page 3218)

Configuring a checksum for a log

Introduction
In a regulated project, you have the option of assigning a checksum to the log data of an data 
log or alarm log. This checksum can be used during plant operation to determine if the data 
of this log has subsequently changed. 

Requirement
● GMP compliant configuration is enabled.

● A data log or alarm log has been created.

Procedure
Proceed as follows to configure a data log or alarm log for the use of a checksum:

1. Open the data log or alarm log in the corresponding log editor.

2. In the "Storage location" box, select "File - CSV (ASCII)" or "File - TXT (Unicode)".
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3. Under "Properties > Properties > Logging method" in the Inspector window , select the 
option "Display system event at" or "Trigger event".

4. In the editor table activate the option "Activate checksum".
Columns that are not displayed are activated with the shortcut menu of the column title.

5. Save the project.

Result
The log data of the log is assigned a checksum in runtime.

See also
Logging Tags (Page 3218)

Enabling GMP compliant configuration (Page 5761)

GMP-compliant configuration (Page 5757)

Evaluating the checksum of log data (Page 3229)

Evaluating the checksum of log data

Introduction
If you have configured a data log or alarm log with generation of a checksum, you can check 
if the log data has subsequently changed.

The DOS program "HmiCheckLogIntegrity" is available for checking the integrity of the log 
data.

The "HmiCheckLogIntegrity" program supports verification of the following files:

● Log files of alarm logs, data logs, and Audit in CSV format

● Log files of alarm logs, data logs, and Audit  in TXT format

● Recipe data records in CSV format

● Recipe data records in TXT format
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You can find the "HmiCheckLogIntegrity.exe" program in the installation directory of WinCC 
under the folder "WinCC Runtime Advanced", for example <C:\Program Files\Siemens
\Automation WinCC Runtime Advanced>.

 

 Note
Audit Trail and Log with Checksum

Before you update WinCC with a Service Pack or a new version, exit and save the Audit Trail 
or the logs using checksum. After WinCC is updated, the audit trail or logs will be continued 
with new files using checksum. 

Make sure that the logs are started at a defined state with the new version.      
 

Procedure
1. Copy the file to be checked from the HMI device to your configuration computer.

2. Open a command line prompt with "Start > Programs > Accessories > Command Prompt".

3. Enter the path to "HmiCheckLogIntegrity.exe" followed by a space in the command line 
prompt. After the space, enter the storage location of the file to be checked within quotation 
marks.

4. Press <Enter>.

5. The check is performed.
When the checked data are consistent, the "Consistency check succeeded" message 
appears.

When the checked data are inconsistent, the "Consistency check failed" message appears. 
Information about the first inconsistent line in the file is also displayed.
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 Note

If there are spaces in the path to the "HmiCheckLogIntegrity.exe" program, you need to 
specify the path in quotation marks.

 

You can also check the integrity of the log data with the AuditViewer.

See also
Logging Tags (Page 3218)

Enabling GMP compliant configuration (Page 5761)

Configuring a checksum for a log (Page 3228)

GMP-compliant configuration (Page 5757)

Evaluating Audit Trails in AuditViewer (Page 5779)

Log response to language switching in runtime

Introduction
In the "Device Settings" editor, select the language to be used for writing to logs in runtime.      

Requirements
● The languages used in your project are activated in the "Project languages" editor, for 

example, "German (Germany)" and "English (USA)" .

Procedure
1. Open the "Languages and fonts" editor.

2. Activate the runtime language, for example, "German (Germany)" and "English (USA)".

3. Set the "Language switch order":

– German 0

– English 1
With "0", German is specified as the "Startup language".

4. Open the "Device settings" editor.

5. Select "Startup language" in the "Settings for Runtime" area.

Result
The project starts after it is transferred. German is specified as the "Startup language" with 
"Language switch order". The logs are now written in German. During runtime, the operator 
switches the runtime language to English. The logs will still to be written in German.
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The operator closes runtime. Due to the previously performed language switch, the next time 
the system starts the "startup language" is English. Since English is the startup language, the 
logs are now written in English.

The logging language remains English even when the language is switched again in runtime 
until runtime is closed once again.

If you use another option instead of "Startup language" to select the language, the logs are 
always written in the same language. This is true regardless of the language selected by the 
operator in runtime. 

Direct access to the ODBC log database (Advanced)

Overview
The storage location of a log can be a database or a file.  

The database is addressed by means of its "Data source name" (DSN). Select the database 
to be used in WinCC as follows:

Select the database from the Windows Start menu under "Settings > Control panel > ODBC 
Data Sources".

In your configuration, specify the "Data source name" (DSN) instead of a directory name as 
storage path for log data. With the DSN, you are referencing the database and the storage 
location.

The entire functional scope of the database is available for additional processing and 
evaluation of log data.

Application
The data source sets up the connection to the database. Create the data source on the same 
PC on which the Runtime software is stored. Then enter the DSN configured on this PC when 
you create a log in WinCC. 

The ODBC interface allows you to use other programs, such as MS Access or MS SQL Server, 
to access the database directly.

In addition, you can use the "StartProgram" system function to configure program calls, e.g. 
MS Access, on the HMI device. Runtime is not interrupted while you configure such calls. 

Setting up the ODBC data source

Introduction
To store process values or alarms in the log database in Runtime, set up the ODBC data 
source.
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Requirement
● A log database has been created. 

You create the log database using the SQL Enterprise Manager. You can find more detailed 
information on how to do this from Microsoft.

Procedure
To set up an ODBC data source, follow these steps:

1. In Control Panel, open "Administrative Tools" and select "Data Sources (ODBC)".
The "ODBC Data Source Administrator" dialog is opened. 

2. Click "User DSN > Add".

3. Select the "SQL-Server and click on "Finish". 

4. In the dialog that follows, enter a name for the User DSN and the SQL-Server  and click on 
"Next".

5. In the dialog that follows, define the logon procedure for the SQL database and click on 
"Next".

6. Activate "Change the default database to". 

7. Select the database you have created and click on "Next".

8. In the dialog that follows, click "Finish".

Logging tags in the "Historical Data" editor

Configuring logging tags

Introduction
You can also create and edit logging tags in the "Historical Data" editor in WinCC. You also 
directly edit the properties of logging tags in the "Historical Data" editor.

 

 Note

If you delete, move or copy in the "Historical Data" editor, the changes also take effect in the 
tag table.

 

Requirement
● The "Data logs" tab is open in the "Historical Data" editor.

● A data log has been created.
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Procedure
Proceed as follows to configure a logging tag in the "Historical Data" editor:  

1. Select an existing data log in the "Data logs" table of the editor.
Alternatively, double-click on "Add..." in the "Name" column to create a new data log.

2. Double-click "Add ..." in the "Name" column of the editor "Logging tags" table.

3. Enter a unique name for the logging tag in the "Name" field.

4. In the "Process tag" field, click on the selection button and select the process tag for logging 
in the object list.

5. Select the desired trigger mode in the "Log type" field:

– "Cyclic": The tag values are logged in accordance with the set logging cycle.

– "On change": The tag values are logged, as soon as the operator device detects a 
change in value.

– "On demand": The tag values are logged by calling the "LogTag" system function.
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6. If you want to log tag values cyclically, select the desired cycle time in the "Logging cycle" 
area. Alternatively, you can define your own cycle using the object list. The smallest value 
that can be set is 1 s. All other values are integer multiples of this value.

7. Configure additional parameters for logging in the table of the editor or in the Inspector 
window.

Result
The configured logging tag is created in the "Historical Data" editor and is also displayed in 
the tag table.

See also
Logging Tags (Page 3218)

10.2.7 Displaying Tags

10.2.7.1 Displaying tags with Basic Panels

Outputting tag values in screens (Basic)

Introduction
In runtime you can output tag values in the screens of the operator device in the form of a 
trend. A trend is a graphic representation of the values that a tag takes during runtime. Use 
the "Trend display" graphic object to represent it. Process values for the trend display are 
loaded by the PLC from the ongoing process.     

The values to be displayed are determined individually within a fixed, configurable cycle. 
Cyclically-triggered trends are suitable for representing continuous curves, such as the 
changes in the operating temperature of a motor.

Displayed values
You will need to configure a trend view in a screen so that tag values are displayed on the HMI 
device. When configuring the trend view, specify which tag values are to be displayed.

You can control the updating of the trend display by defining the cycle time.

See also
Configuring trend display for values from the PLC (Basic) (Page 3236)

Basics of tags (Page 3166)
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Configuring trend display for values from the PLC (Basic)

Introduction
You use a trend view to graphically represent values that a tag assumes during the 
process.     

Requirement
● A screen is open.

● The Inspector window with the trend view properties is open.

Procedure
To configure a trend view, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Control" group to the screen.

2. Select the "Trend" category from the "Properties" group in the Inspector window and double-
click "<Add>" in the "Name" column.

3. Assign a name to the trend in the "Name" column.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. Select the number of trend values in the "Trend values" column.
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6. In the "Settings" column, use the selection button to open the "Data source" dialog and 
select the tags to supply the trend with values.
Specify the cycle for reading the tags from the PLC.

7. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

  Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is 
activated. You set the column width and the position of the columns in the table header 
of the values table in active mode. In order to activate the trend view the zoom factor has 
to be set to 100 %.

 

Result
In runtime, the values of the selected tags are displayed in the configured trend view. 

See also
Outputting tag values in screens (Basic) (Page 3235)

10.2.7.2 Displaying tags with Runtime Advanced and Panels

Trends

Introduction
A trend is a graphic representation of the values that a tag takes during runtime. In order to 
display trends, configure a trend view in a screen of your project.

To configure the trend view, specify a trend type for the values to be displayed.

● Log: For displaying the logged values of a tag

● Cyclical real time: For time-triggered display of values

● Bit-triggered real time: For event-triggered display of values

● Bit-triggered buffer: For event-triggered display with buffered data acquisition
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Displaying logged values
In Runtime, the trend view displays the values of a tag from a data log. The trend shows the 
logged values in a particular window in time. The operator can move the time window in 
Runtime to view the desired information from the log.

Pulse-triggered trends
The values to be displayed are determined individually with a definable time pattern. Cyclically-
triggered trends are suitable for representing continuous curves, such as the changes in the 
operating temperature of a motor.

Bit-triggered trends
The values to be displayed are event-driven by setting a defined bit in "Trend transfer" tags. 
The bit is reset after reading has been completed. Bit-triggered trends are useful for displaying 
fast-changing values, such as the injection pressure for producing plastic parts.

Bit-triggered trends with buffered data acquisition
When you set buffered data acquisition, the values to be displayed are buffered in the PLC 
and read in bit-triggered as a block. These trends are suitable for displaying rapid changes 
when the course of the trend as a whole is interesting and not so much the individual values.

You configure a switch buffer in the PLC so it can continue to write the new values while the 
trend buffer is being read. The switch buffer ensures that the PLC does not overwrite values 
while the operator devices reads the values for the trend.

The switch between the trend buffer and the switch buffer functions as follows:

Whenever the bit assigned to the trend is set in the "Trend transfer 1" tag, all the values are 
read simultaneously from the trend buffer and are displayed as a trend on the HMI device. The 
bit in "Trend Transfer 1" is reset after reading has been completed.
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While the operator device is reading the tag values from the trend buffer, the PLC writes the 
new tag values into the switch buffer. When the bit which is assigned to the trend is set in the 
"Trend transfer 2" tag , all the trend values are read from the switch buffer and displayed at 
the operator device. While the operating device is reading the switch buffer, the PLC writes 
again to the trend buffer. 

 

Outputting tag values in screens

Introduction
In runtime you can output tag values in the screens of the operator device in the form of a 
trend. The process values are loaded by the PLC from the current process or from a log 
database.     

Displayed values
You will need to configure a trend view in a screen so that tag values are displayed on the HMI 
device. When configuring the trend view, specify which tag values are to be displayed.
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The following options are available:

● Current values from the PLC
Writing of the trend is continued with individual values from the PLC. The following trigger 
types are available for display in real time:

– Bit-triggered real time: The time of the update can be controlled by setting a bit. Bit-
triggered trends are normally used to visualize rapidly changing values. One example 
might be the injection pressure in the production of plastic parts.

– Cyclical real time: You control the update time with a cycle. Cyclically-triggered trends 
are suitable for representing continuous curves, such as the changes in the operating 
temperature of a motor.

– Bit-triggered buffer: The trend contains values that were stored in a buffer in the period 
between two reads from the PLC. Use this format pattern if the course of the trend as 
a whole is more interesting than the individual values.

● Logged tag values
In runtime, the trend view displays the values of a tag from a data log. The following trigger 
type is available to display logged tag values:

– Data log: The trend shows the logged values in a particular window in time. To obtain 
the requested information from the archive, the operator uses the corresponding 
operator controls in the screen or in the trend view.

Configuring trend displays for values from the PLC

Introduction
You use a trend view to graphically represent values that a tag assumes during the process.   

Requirement
● A screen is open.

Procedure
To configure a trend view, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Controls" group to the screen.

2. Select "Properties . Properties > Trend" in the Inspector window and double-click "Add" in 
the "Name" field. A new trend is created.

3. If required, enter a unique name for the trend in the "Name" field.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. Select the number of trend values in the "Trend values" column.
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6. In the "Trend type" column, select the required trend type. The following entries are 
available:

– "Bit-triggered real time"

– "Cyclical real time"

– "Bit-triggered buffer"

– "Data log"

7. In the "Settings source" column, use the selection button to open the "Data source" dialog 
and select the tags to supply the trend with values.
If you selected the "Cyclical real time" trend type, specify a cycle for reading the tags from 
the PLC.
Only for bit-triggered trends:

– Under "Bit", specify which bit of the "Trend request" tag and of the "Trend transfer" tags 
are to be assigned to the trend. Select a different value for each trend.

– Enter a tag under "Trend request" which contains at least as many bits as trends are to 
be displayed in the trend view. The status of the bits of these tags specifies which trend 
is currently being displayed at the operator device.

Only for the trend type "Bit-triggered real time":

– Enter a tag under "Trend transfer" which contains at least as many bits as trends are to 
be displayed in the trend view. The status of the bits of these tags specifies for which 
trend values are to be read from the PLC.

Only for the trend type "Bit-triggered buffer":

– Enter a buffer tag for the switch buffer. The tags have to be of the same type and of the 
same length as the trend tag.

– Enter a tag each under "Trend transfer 1" and "Trend transfer 2" which contains at least 
as many bits as trends are to be displayed in the trend view. The status of these tag bits 
specifies the trend for which values will be read from the PLC. "Trend transfer 1" controls 
reading from the trend buffer; "Trend transfer 2" controls reading from the switch buffer.

8. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

 Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is activated. 
You can set the column width and the position of the columns in active mode in the values 
table. In order to activate the trend view the zoom factor has to be set to 100 %.

 

Result
In runtime, the values of the selected tags are displayed in the configured trend view. 
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Configuring a trend view for a data log

Introduction
You can use a trend view to display logged tag values in Runtime. The trend view shows the 
logged tag values in a particular window in time. To obtain the requested information from the 
archive, the operator uses the corresponding operator controls in the screen or in the trend 
view.     

Application example
At the end of a shift, for example, an operator wants information about the process carried out 
during the shift.

Requirement
● A data log has been created.

● A screen is open.

● The Inspector window with the trend view properties is open.

Procedure
To configure a trend view to display values from a data log, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Controls" group to the screen.

2. Select "Properties . Properties > Trend" in the Inspector window and double-click "Add" in 
the "Name" field. A new trend is created.

3. If required, enter a unique name for the trend in the "Name" field.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. In the "Trend type" column, select the trend type "Data log".

6. In the "Settings" column, use the selection button to open the "Data source" dialog; select 
the data log and the tags to supply the trend with values.

7. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

  Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is 
activated. You can set the column width and the position of the columns in active mode 
in the values table. In order to activate the trend view the zoom factor has to be set to 100 
%.

 

Visualizing processes (Comfort/Advanced)
10.2 Working with Tags

WinCC Comfort/Advanced V12.0 SP1
3242 System Manual, 07/2013,  



Result
In runtime, the logged values of the selected tags are displayed in the configured trend view.

The structure of a *.CSV file with tags

Introduction
In the *.csv (comma-separated value) file format, the "Name" and "Value" table columns of the 
entry are separated by semicolons. Each table row ends with a line break.  

Example of a *.CSV file
The example shows a file with logged tag values:  

"VarName";"TimeString";"VarValue";"Validity";"Time_ms"

"Var_107";"01.04.98 11:02:52";66,00;1;35886460322,81

"Var_108";"01.04.98 11:02:55 AM";60.00;1;35886460358.73

"Var_109";"01.04.98 11:02:57 AM";59.00;1;35886460381.22

Structure of a log file in *.csv format
The following values are entered in the individual columns of a log file:

Parameters Description
VarName Name of the tag from WinCC
Time string Time stamp as a STRING, e.g. readable data format
VarValue Value of the tag
Validity Validity: 

1 = value is valid
0 = an error occurred (e.g. interrupted connection)

Time_ms Specify a time stamp as a decimal value (see below for conversion).
Only needed to display the tag values in a trend.
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Conversion of the time stamp decimal value
If the value needs to be processed using a different program, proceed as follows:

1. Divide Time_ms by 1,000,000.
Example: : 36343476928:1 000 000 = 36343,476928

2. The whole number portion (36344) is the date calculated from 31.12.1899.
Example: 36343 results in 02.07.1999
You can now convert the time stamp value to days in Excel by assigning a corresponding 
format from the "Date" group to the cells, which contain the time stamp.
Result: 37986 results in 31.12.2003

3. The value after the comma (0,476928) indicates the time:

– Multiply the value (0.476928) by 24 to obtain the hours (11.446272).

– Multiply the remainder (0.446272) by 60 results in the minutes (26.77632).

– Multiply the remainder (0.77632) by 60 results in the seconds (46.5792).

Result 11:26:46.579
This conversion is supported by Microsoft Excel, for example.

Accessing the ODBC log database directly

Introduction
The storage location of a log can be a database or a file.  

The database is addressed by means of its "Data source name" (DSN). Select the database 
you want to use in WinCC from the Windows Start menu under "Settings > Control panel > 
ODBC Data Sources".

To store log data, specify the DSN, rather than a directory name during configuration. With the 
DSN, you are referencing the database and the storage location.

Application
The entire functional scope of the database is available for additional processing and 
evaluation of log data.

Principle
The data source establishes the connection to the database. You create the data source on 
the same computer that contains the Runtime software. Then enter the DSN configured here 
when you create a log in WinCC.

The ODBC interface allows you to use other programs, such as MS Access or MS SQL Server, 
to access the database directly.

With the "StartProgram" system function, you can also configure a program call (to MS Access, 
for example) on the HMI device. This does not interrupt Runtime.
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10.3 Working with alarms

10.3.1 Basics

10.3.1.1 Alarm Logging in WinCC

Introduction
The alarm system allows you to display and record operating states and faults on the HMI 
device that are present or occur in a plant.

An alarm may have the following content:

N
o.

Time Date Alarm text Status Alarm class

5 12:50:24
:590

24.02.
2007

Boiler pressure above 
high limit.

Incoming 
Outgoing

Warning:
Color Red

Alarm system in WinCC  
The alarm system processes a variety of alarm types. The alarm procedures can be broken 
down into system-defined alarms and user-defined alarms: 

● User-defined alarms are used to monitor the plant process.

● System-defined alarms monitor the HMI device.

The detected alarm events are displayed on the HMI device. Targeted access to the alarms 
combined with supplementary information about individual alarms ensures that faults are 
localized and cleared quickly. This reduces stoppages or even prevents them altogether.

The following figure shows the alarm system structure:
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10.3.1.2 Alarm Logging in WinCC

Introduction
Alarm logging allows you to display and record operating states and faults on the HMI device 
that are present or occur in a plant.

An alarm may have the following content:

N
o.

Time of 
day

Date Alarm text Status Alarm class

5 12:50:24
:590

24.02.
2007

Boiler pressure above 
high limit.

Incoming 
Outgoing

Warning:
Color Red

Alarm Logging in WinCC
Alarm logging processes various alarm procedures used by the PLC and the HMI device. The 
alarm procedures can be broken down into system-defined alarms and user-defined alarms: 

● User-defined alarms serve to monitor the plant.

● System-defined alarms are used to monitor the HMI device or the PLC.
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The detected alarm events are displayed on the HMI device. You can use the alarm logging 
system to log alarms from the ongoing process. Targeted access to the alarms combined with 
supplementary information about individual alarms ensures that faults are localized and 
cleared quickly. This reduces stoppages or even prevents them altogether.

The following figure shows the alarm logging structure:

10.3.1.3 Alarm Procedures

Overview of the alarm types

Introduction
The alarm types serve various purposes for monitoring the plant. The alarms from the individual 
alarm types are configured and triggered in different ways. 

Select the relevant tab in the "HMI alarms" editor to configure alarms based on the individual 
alarm types. 
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Alarm types in WinCC   
WinCC supports the following alarm types:

User-defined alarms
● Analog alarms    

– Analog alarms are used to monitor limit violations.

● Discrete alarms    

– Discrete alarms are used to monitor states.

System-defined alarms
● System events 

– System events belong to the HMI device and are imported into the project.

– System events monitor the HMI device.

Overview of the alarm types

Introduction
The alarm types serve various purposes for monitoring the plant. The alarms from the individual 
alarm types are configured and triggered in different ways. 

Select the relevant tab in the "HMI alarms" editor to configure alarms based on the individual 
alarm types. 

Alarm types in WinCC   
WinCC supports the following alarm types:
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User-defined alarms
● Analog alarms    

– Analog alarms are used to monitor limit violations.

● Discrete alarms    

– Discrete alarms are used to monitor states.

● Controller alarms 

– You configure controller alarms in STEP 7.

– You continue to process the controller alarms in WinCC.
 

  Note
Device dependency

The controller alarm is not supported on all HMI devices.
 

System-defined alarms
● System-defined controller alarms       

– System-defined controller alarms consist of diagnostic alarms (SIMATIC S7) and system 
errors (SFM)

– System-defined controller alarms are used to monitor the PLC.
 

  Note
Device dependency

System-defined controller alarms are not supported on all HMI devices.
 

● System events 

– System events belong to the HMI device and are imported into the project.

– System events monitor the HMI device.

User-defined alarms

Analog alarms

Description
Analog alarms signal limit violations during the process.

Example
The speed of the mixer in a fruit juice mixing plant must not be too high or too low. You can 
configure analog alarms to monitor the speed of the mixer. If the high or low limit for the speed 
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of the mixer is violated, an alarm is output on the HMI device containing the following alarm 
text, for example: "Mixer speed is too low".

Discrete alarms

Description
Discrete alarms indicate a status in the current process.  

Example  
A fruit juice mixing plant consists of several tanks containing the ingredients. To ensure the 
correct mixing ratio of water, fruit concentrate, sugar, and flavoring, the valves in the intakes 
open and close at the right moment. This operation should be monitored. 

You configure a suitable discrete alarm for all the valve states. If a valve on one of the four 
tanks opens or closes, an alarm is displayed, such as "Water valve closed". 

The operator can thus monitor whether the plant is producing correctly. 

PLC alarms

Example of an alarm
CPU operating mode switch to Stop

Description
The custom controller alarms are created by the control system engineer in STEP 7. The status 
values, such as time stamp and process values, are mapped in the controller alarm. If controller 
alarms are configured in STEP 7, accept them into the integrated WinCC operation as soon 
as a connection is established to the PLC.  

In STEP 7, the controller alarm is assigned to an alarm class. You can import this alarm class 
with the controller alarm as a common alarm class.

Types of controller alarms 
SIMATIC S7 supports different types of controller alarms. WinCC supports different types of 
controller alarms according to which Runtime is used.

Controller alarms for multiple HMI devices
If a PLC is connected to multiple HMI devices, the project engineer assigns display classes to 
the controller alarms in STEP7. The display classes determine the allocation to the HMI device. 
You can activate the display classes for your HMI device that are to be displayed on it. In this 
case, only the controller alarms from this display class will be displayed on the HMI device. 
Up to 17 display classes are possible.
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See also
Editing controller alarms (Page 3277)

System-defined Alarms

System events

Examples for alarms
● "An online connection to the PLC is established."

Description   
A system alarm indicates the status of the system, plus communication errors between the 
HMI device and system.

Under "Runtime settings > Alarms" you specify how long a system alarm is shown on the HMI 
device.

Support
The reference contains a list of the possible system events, along with the cause and possible 
remedies. If you contact online support because of a system alarm on the HMI device, you will 
need the alarm number and tags used in the system alarm.

System events

Examples of alarms
● "Overflow of the buffer for printing lines in text mode"

● "No printer is installed or a default printer has not been set up."

Description   
A system event indicates the system status, including errors in the communication between 
the HMI device and system. 

The system events depend on the HMI device. 

You can load system events in the "HMI alarms" editor from a an *.xml file. 

Support
The reference contains a list of the possible system events, along with the cause and possible 
remedies. When contacting Online Support because of a system event on the HMI device, you 
need the event number and tags used in the system event.
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System-defined controller alarms 

Example of an alarm
Valve open due to overpressure

Description     
System-defined controller alarms are installed with STEP 7 and are only available if WinCC is 
operated in the STEP 7 environment. 

WinCC processes system-defined controller alarms of the type "SIMATIC S7 diagnostic alarm".

S7 diagnostic alarms show states and events in the SIMATIC S7 controllers. You only have 
read access to S7 diagnostic alarms. They are assigned to the "Diagnostics" alarm class by 
the system. S7 diagnostic alarms are not acknowledged or reported. They are for signaling 
purposes only.

See also
Enabling system-defined controller alarms (Page 3278)

10.3.1.4 Alarm states

Introduction
An alarm assumes various alarm states in Runtime. The user analyzes and reports on the 
process execution with reference to the alarm states. 

 

 Note

Device dependency

Reporting and logging are not available for all HMI devices.
 

Description
Every alarm has an alarm status. The alarm states are made up of the following events: 

● Incoming       
The condition for triggering an alarm is satisfied. The alarm is displayed, such as "Boiler 
pressure too high".

● Outgoing  
The condition for triggering an alarm is no longer satisfied. The alarm is no longer displayed 
as the boiler was vented.

● Acknowledge   
The operator acknowledges the alarm.
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Alarms without acknowledgment
The following table shows the alarm states for alarms that do not have to be acknowledged:

Status Description
Incoming The condition for an alarm is satisfied.
Outgoing The condition for an alarm is no longer satisfied.

Alarms with acknowledgment
The following table shows the alarm states for alarms that have to be acknowledged:

Status Description
Incoming The condition for an alarm is satisfied 
Outgoing,
not acknowledged

The condition for an alarm is no longer satisfied. The operator 
has not acknowledged the alarm.

Outgoing,
and subsequently acknowledged

The condition for an alarm is no longer satisfied. The operator 
has acknowledged the alarm after this time.

Incoming, 
acknowledged

The condition for an alarm is satisfied. The operator has 
acknowledged the alarm.

Outgoing,
but acknowledged first

The condition for an alarm is no longer satisfied. The operator 
acknowledged the alarm while the condition was still satisfied.

Each occurrence of these states can be displayed and logged on the HMI device and a protocol 
printed.

 

 Note

The display text for the states of an alarm is language-specific and configuration-specific.
 

10.3.1.5 Alarm classes

Basics on alarm classes

Introduction
Many alarms occur in a plant. These are all of different importance. You can assign the alarms 
of your project to alarm classes to clearly show the user which of the alarms are most important. 

Description
The alarm class defines how an alarm is displayed. The alarm class specifies if and how the 
user has to acknowledge alarms of this alarm class. 
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A new alarm class with mandatory acknowledgment is generated in WinCC.
 

 Note

The choice of display modes for alarm classes depends on the options on your HMI device.
 

Examples of how to use alarm classes   
● The alarm "Speed of fan 1 in upper tolerance range" has alarm class "Warnings". The alarm 

is displayed with a white background. The alarm does not have to be acknowledged.

● The alarm "Speed of fan 2 has exceeded upper warning range" is assigned to the "Errors" 
alarm class. The alarm is displayed with a red background and flashes at high frequency 
in runtime. The alarm is displayed until the user acknowledges it.

Using alarm classes  
Use the following alarm classes to define the acknowledgment model and display of alarms 
for your project:

● Predefined alarm classes  
You cannot delete predefined alarm classes and edit them only to a limited extent. 
Predefined alarm classes have been created for each HMI device under "HMI alarms > 
Alarm classes".

● Custom alarm classes  
You can create new alarm classes under "HMI alarms > Alarm classes", configure how you 
want the alarms to be displayed, and define an acknowledgment model for alarms of this 
alarm class. The possible number of custom alarm classes depends on which runtime is 
used in your project.

See also
Predefined alarm classes (Page 3255)

Creating alarm classes (Page 3263)

Using project-wide alarm classes (Page 3264)

Basics on alarm classes

Introduction
Many alarms occur in a plant. These are all of different importance. You can assign the alarms 
of your project to alarm classes to clearly show the user which of the alarms are most important. 

Description
The alarm class defines how an alarm is displayed. The alarm class specifies if and how the 
user has to acknowledge alarms of this alarm class. 
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A new alarm class with mandatory acknowledgment is generated in WinCC.
 

 Note

The choice of display modes for alarm classes depends on the options on your HMI device.
 

Examples of how to use alarm classes   
● The "Speed of fan 1 in upper tolerance range" alarm has "Warnings" alarm class. The alarm 

is displayed with a white background. The alarm does not have to be acknowledged.

● The "Speed of fan 2 has exceeded upper warning range" alarm is assigned to the "Errors" 
alarm class. The alarm is displayed with a red background and flashes at high frequency 
in runtime. The alarm is displayed until the user acknowledges it.

Using alarm classes  
Use the following alarm classes to define the acknowledgment model and display of alarms 
for your project:

● Predefined alarm classes  
You cannot delete predefined alarm classes and edit them only to a limited extent. 
Predefined alarm classes have been created for each HMI device under "HMI alarms > 
Alarm classes".

● Custom alarm classes  
You can create new alarm classes under "HMI alarms > Alarm classes", configure how you 
want the alarms to be displayed, and define an acknowledgment model for alarms of this 
alarm class. The possible number of custom alarm classes depends on which runtime is 
used in your project.

● Common alarm classes  
Common alarm classes are displayed under "Shared data > Alarm classes" in the project 
tree and can be used for the alarms of an HMI device. Common alarm classes originate in 
the alarm configuration of STEP 7. If needed, you can create additional common alarm 
classes in WinCC. 

See also
Predefined alarm classes (Page 3255)

Creating alarm classes (Page 3263)

Using project-wide alarm classes (Page 3264)

Predefined alarm classes

Predefined alarm classes   
The following alarm classes already created in WinCC for every HMI device:
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Alarm classes for user-defined alarms
● "Warnings"

The "Warnings" alarm class is designed to show irregular statuses and routines in the 
process. Users do not acknowledge alarms from this alarm class.

● "Errors"
The "Errors" alarm class is intended to show critical or dangerous states or limit violations 
in the process. The user must acknowledge alarms from this alarm class. 

Alarm classes for system-defined alarms
● "System"

The "System" alarm class contains alarms that display states of the HMI device and the 
PLCs.

● "Diagnosis Events"
The "Diagnosis Events" alarm class contains alarms that display states and events in 
SIMATIC S7 controllers. Users do not acknowledge alarms from this alarm class.

 

  Note
Device dependency

The "Diagnosis Events" alarm class is not available for all HMI devices.
 

See also
Basics on alarm classes (Page 3254)

Creating alarm classes (Page 3263)

Using project-wide alarm classes (Page 3264)

10.3.1.6 Acknowledgement

Acknowledging alarms

Introduction   
To make sure that an alarm was registered by the plant operator, configure this alarm so that 
it is displayed until acknowledged by the operator. Alarms that display critical or hazardous 
states in the process have to be acknowledged. 

Description
The acknowledgment of an alarm is an event that is logged and reported. Acknowledging an 
alarm changes the alarm status from "Incoming" to "Acknowledged". When the operator 
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acknowledges an alarm, the operator confirms that he or she has processed the status that 
triggered the alarm. 

 

 Note
HMI device dependency

Reporting and logging are not available for all HMI devices.
 

Triggering acknowledgment of an alarm
In Runtime, you trigger alarm acknowledgments in various ways:

● Acknowledgement by the authorized user at the HMI device

● Automatic acknowledgment by the system without operator action, e.g. by means of

– Tags

– PLC

– System functions in function lists or scripts
 

  Note
HMI device dependency

Scripts are not available for all HMI devices.
 

Acknowledging alarms that belong together
To make the alarm system clearer and easier to use in Runtime, you can configure an alarm 
group. You can acknowledge all alarms belonging to this alarm group in a single pass. 

Acknowledgment by the PLC
Discrete alarms will be automatically acknowledged by the PLC, if necessary. The 
acknowledgment is triggered by a bit in the "Acknowledgment tag PLC". You define the bit and 
tag at the configuration stage. 
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Acknowledgment of an alarm on the HMI device
In Runtime, the user acknowledges an alarm in one of the following ways, depending on the 
configuration:

● Using the acknowledgment button <ACK> on the HMI device

● Using the button in the alarm view

● Using configured function keys or buttons in screens
 

  Note
Acknowledgment button <ACK> on the HMI device

To ensure that critical alarms are processed only by authorized users, protect the "ACK" 
button on the HMI devices, including the operating controls and display objects of the 
alarms. Use the appropriate operator authorization for this.

 

  Note
HMI device dependency

The acknowledgement key <ACK> is not available on all HMI devices.
 

Reaction to the acknowledgment of alarms of an alarm group
● Alarm acknowledgment by the operator

You acknowledge the alarm of an alarm group, for example, using the <ACK> 
acknowledgment key or a function key. All alarms of the alarm group are acknowledged.

● Alarm acknowledgment by the controller
The controller sets a tag bit to acknowledge the alarm of an alarm group.
The respective alarm is acknowledged.

Acknowledgement Model

Overview 
You define the acknowledgment model for an alarm class. Alarms that are assigned to this 
alarm class will be acknowledged on the basis of this acknowledgment model. The following 
acknowledgment model is used in WinCC:  

● Alarm without acknowledgment 
This alarm comes and goes without having to be acknowledged. There is no visible 
response from the system. 

● Alarm with simple acknowledgment 
This alarm must be acknowledged as soon as the event that triggers the alarm occurs. The 
alarm remains pending until it is acknowledged.
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10.3.1.7 Alarm groups

Introduction
Many alarms from different areas and processes occur in a plant. You can compile associated 
alarms into alarm groups. 

Alarm groups  
You can use the alarm groups to monitor the parts of the plant and to acknowledge the 
associated alarms together as required. 

Alarm groups can contain alarms from different alarm classes. You only assign alarms that 
require acknowledgment to alarm groups. 

Using alarm groups
It is a good idea to compile alarm groups for alarms such as the following:

● Alarms that are caused by the same fault.

● Alarms of the same type

● Alarms from a machine unit, such as "Fault in drive XY"

● Alarms from an associated part of the process, such as "Fault in cooling water supply"

Display in Runtime
In Runtime, the "Alarm group" column displays the number of the alarm group to which the 
alarm belongs. 

See also
Configuring Alarm Groups (Page 3267)

10.3.1.8 Alarm number

Assigning alarm numbers
The system assigns unique alarm numbers within an alarm type. 

 

 Note

When adapting alarm numbers, observe the uniqueness of the alarm number within an alarm 
type.
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10.3.2 Working with Alarms 

10.3.2.1 Alarm components and properties

Overview   
You configure the components of alarms in WinCC. The following table shows the basic 
components of alarms:

Alarm
 class

Alarm 
number

Time 
of day

Date Alarm 
status 

Alarm text Alarm
 
group

Tooltip Trigger tag Limit 
value

Warni
ng

1 11:09
:14

06.08.2
007

IO Maximum speed 
reached

2 This alarm is ... speed_1 27

Syste
m

110001 11:25
:58

06.08.2
007

I Switch to "Online" 
mode

0 This alarm is ... PLC-
Variable_1

–

Alarm class  
Alarm classes, such as "Warnings" or "Errors". The alarm class defines the following for an 
alarm: 

● Acknowledgment model

● Appearance in Runtime (e.g. color)

● Logging
 

 Note
Device dependency

Logging is not available for all HMI devices.
 

Alarm number  
An alarm is identified by a unique alarm number. The alarm number is assigned by the system. 
You can change the alarm number to a sequential alarm number, if necessary, to identify 
alarms associated in your project.

Time and date  
Every alarm has a time stamp that shows the time and date at which the alarm was triggered.

Alarm status  
An alarm has the events "Incoming," "Outgoing," "Acknowledge." For each event, a new alarm 
is output with the current status of the alarm. 
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Alarm text  
The alarm text describes the cause of the alarm. 

The alarm text can contain output fields for current values. The values you can insert depend 
on the Runtime in use. The value is retained at the time at which the alarm status changes.

Alarm group  
The alarm group bundles individual alarms. 

Tooltip  
You can configure a separate tooltip for each alarm; the user can display this tooltip in Runtime.

Trigger tag  
Each alarm is assigned a tag as trigger. The alarm is output when this trigger tag meets the 
defined condition, e.g. when its state changes or it exceeds a limit.

Limit value  
Analog alarms indicate limit violations. Depending on the configuration, WinCC outputs the 
analog alarm as soon as the trigger tag exceeds or undershoots the limit value.

See also
Output of a tag value in the alarm text (Page 3274)

Alarm states (Page 3252)

Basics on alarm classes (Page 3254)

Alarm groups (Page 3259)

10.3.2.2 Configuring Alarms

Overview of alarm configuration tasks

Steps to configure alarms                 
Configuring alarms in WinCC involves the following steps:

1. Edit and create alarm classes
You use the alarm class to define how an alarm will be displayed in runtime and to define 
the acknowledgment model for it. 

2. Creating tags in the "HMI tags" editor

– Configure the tags for your project.

– You create range values for the tags.
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3. Creating tags in the "HMI alarms " editor

– Create custom alarms and assign these the tag to be monitored, alarm classes, alarm 
groups, and other properties.

– You can also assign system functions or scripts to the alarm events.

4. Output of configured alarms
To output configured alarms, configure an alarm view or an alarm window in the "Screens" 
editor.

Additional configuration tasks
Additional tasks may be necessary for configuring alarms, depending on the requirements of 
your project:

1. Creating alarm groups
You assign the alarms of your project to alarm groups according to their association, such 
as by the cause of the problem (power failure) or source of the error (Motor 1).

2. Configuring Loop-In-Alarm
A Loop-In-Alarm is configured in order to change to a screen containing relevant information 
on an alarm received.

Overview of alarm configuration tasks

Steps to configure alarms         
Configuring alarms in WinCC involves the following steps:

1. Edit and create alarm classes
You use the alarm class to define how an alarm will be displayed in runtime and to define 
the acknowledgment model for it. 

2. Creating tags in the "HMI tags" editor

– Configure the tags for your project.

– You create range values for the tags.

1. Creating tags in the "HMI alarms " editor

– Create custom alarms and assign these the tag to be monitored, alarm classes, alarm 
groups, and other properties.

– You can also assign system functions or scripts to the alarm events.

2. Output of configured alarms
To output configured alarms, configure an alarm view or an alarm window in the "Screens" 
editor.
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Additional configuration tasks
Additional tasks may be necessary for configuring alarms, depending on the requirements of 
your project:

● Activating and editing system events
You can import system events when you initially open the "System events" tab in the "HMI 
alarms" editor. On completion of the import, you can edit the system events.

● Activating and editing controller alarms
For integrated operation of a project in STEP 7, specify the controller alarms to be displayed 
on your HMI device in the alarm settings.

● Creating alarm groups
Assign the alarms of your project to alarm groups based on their relation, e.g. by error cause 
(e.g. "power failure"), or by error source (e.g. "Motor 1").

● Configuring Loop-In-Alarm
Configure a Loop-In-Alarm in order to change to a screen that contains information about 
an incoming alarm. 

Configuring Alarm Classes

Creating alarm classes

Introduction
Create alarm classes in the "Alarm classes" tab of the "HMI alarms" editor. Some default alarm 
classes are already created for every project. You can create additional custom alarm classes. 
You can create up to 32 alarm classes. 

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.
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Procedure
To create an alarm class, proceed as follows:

1. Click the "Alarm Classes" tab.
The predefined and existing custom alarm classes are displayed. The following table lists 
the predefined alarm classes:

1. Double-click "<Add>" in the table.
A new alarm class is created. Each new alarm is automatically assigned a static ID.
The properties of the new alarm class are shown in the Inspector window. 

2. Configure the alarm class under "Properties > Properties >General" in the Inspector window.

– Enter a "Name" and the "Display name".

– Depending on the HMI device, you can also activate logging, or automatic sending of e-
mails.

3. Define the acknowledgment model for the alarm class under "Properties > Properties > 
Acknowledgment" in the Inspector window.

4. Change the default text under "Properties > Properties > Status" in the Inspector window.
This text indicates the status of an alarm in Runtime. 

5. Change the default colors under "Properties > Properties > Colors" in the Inspector window. 
Depending on the HMI device, also change the flashing characteristics.

These settings define how alarms from this alarm class are displayed in Runtime.
 

 Note

To display the alarm classes in color in Runtime, the "Use alarm class colors" option must 
be activated. In the project navigation, enable "Runtime settings > Alarms > General > Use 
alarm class colors" accordingly. This option is selected in a new project in WinCC. 

 

See also
Predefined alarm classes (Page 3255)

Basics on alarm classes (Page 3254)

Using project-wide alarm classes

Introduction
Project-wide alarm classes are displayed under "Shared data > Alarm classes" in the project 
navigation. Create additional common alarm classes in WinCC. 

Controller alarms are assigned to common alarm classes. If you work with controller alarms, 
common alarm classes are automatically loaded in WinCC.
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Requirements 
● You have created a project.

Creating project-wide alarm class    
To create a project-wide alarm class, proceed as follows:

1. Double-click "Shared data > Alarm classes" in the project navigation.
The "Project-wide message classes" editor opens in the work area.

2. To create a project-wide message class, double-click in the first empty line of the table 
editor.

3. Specify the name and display name of the alarm class.

4. Select "With acknowledgment" if the alarm class requires acknowledgment.

Assign alarms to a common alarm class   
Proceed as follows to assign an analog or discrete alarm to a common alarm class:

1. In the "HMI alarms" editor, select the alarm that you want to assign to the common alarm 
class.

2. Click "General" in the Inspector window.

3. Click "Shared data > Alarm classes" in the project navigation.

4. Select the common alarm class in the detail view.
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5. Drag-and-drop the alarm class to the "Alarm class" selection box or "Alarm class" column 
in the work area of the Inspector window of the alarm.

The system creates a new alarm class that is linked to the common alarm class. The new 
name of the common alarm class is displayed in the "Alarm class" area of the Inspector 
window of the alarm. The display name of the common alarm class is activated for the alarm 
class in your project.

6. Click the "Alarm Class" tab.

7. Check to see whether the display name of the common alarm class is displayed in WinCC.

8. You can change the object name of the alarm class.
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Alternative procedure
To assign an alarm to a common alarm class, proceed as follows:

1. Click the "Alarm Classes" tab.
The alarm classes are displayed. 

2. Click "Shared data > Alarm classes" in the project navigation. The following table shows 
the common alarm classes:

3. Select the common alarm class in the detail view.

4. Drag-and-drop the alarm class to the "Alarm classes" tab of the "HMI alarms" editor
The system creates a new alarm class that is linked to the common alarm class. The new 
name of the new alarm class in your project is displayed in the "Alarm class" tab.

5. Open the tab with the alarm procedure for the required alarm.

6. Under "General" in the Inspector window, select the alarm and the alarm class linked to the 
common alarm class.

 

 Note
Deleting a common alarm class

If you delete a common alarm class, the linked alarm class is maintained. If necessary, link 
the alarm class with another common alarm class or use it as WinCC alarm class.

 

See also
Predefined alarm classes (Page 3255)

Basics on alarm classes (Page 3254)

Configuring Alarm Groups

Introduction
Create alarm groups on the "Alarm Groups" tab in the "HMI alarms" editor. An alarm group is 
a compilation of single alarms. You assign alarms in an alarm group by association, such as 
cause of the problem or source of the error. If you acknowledge an alarm from this alarm group 
in Runtime, all other alarms in the alarm group are acknowledged automatically.
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Requirement
● You have created a project.

● The "HMI alarms" editor is open.

● The Inspector window is open.

Creating a new alarm group     
1. Click the "Alarm Groups" tab.

The existing alarm groups are displayed. 

2. In the work area of the table, double-click "<Add>" in the first free row.
A new alarm group is created. 

3. You can overwrite the proposed "Name".

Result
An alarm group is created. For the group acknowledgment of alarms in Runtime, assign the 
associated alarms that require acknowledgment to an alarm group.

Configuring discrete alarms

Introduction
Discrete alarms triggered by the PLC indicate status changes in a plant. They indicate the 
opened or closed state of a valve, for example.

The following sections describes the configuration procedures in the "HMI alarms" editor. You 
can also configure discrete alarms in the "HMI tags" editor.

Requirements
● The "HMI alarms" editor is open.

● The Inspector window is open.

● You have created the required alarm classes and alarm groups.

Procedure     
To configure a discrete alarm, proceed as follows:

1. Open the "Discrete alarms" tab.

2. To create a new discrete alarm, double-click in the work area on "<Add>".
A new discrete alarm is created.
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3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– Enter an alarm text as event text.
Use the functions of the shortcut menu to format the text on a character-by-character 
basis, or to insert output fields for HMI tags, or texts from the text lists. 

– You can renumber the alarm.

– Select the alarm class and the alarm group, if necessary.

4. In the Inspector window, select the tag and the bit that triggers the alarm under "Properties 
> Properties > Trigger". Note the following information:

– Use the data types "Int" or "UInt" to select an HMI tag.

– Use the data types "Int" or "Word" to select a PLC tag.

– Use trigger tag bits only for alarms.

– Do not use trigger tags for anything else.

– If you want to acknowledge the alarm via the PLC, use this tag also as PLC 
acknowledgment tag.

 

 Note

Note the method used to count bits in the utilized PLC when specifying the bit. For more 
information, refer to the "Communication" section in the PLC Online Help.

 

 Note

If the object does not yet exist in the selection list, create it directly in the object list and change 
its properties later.

 

Status-dependent alarm texts
To display a different text independent of the alarm status, link a text list to the alarm text. You 
control the text list with a tag.
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Additional settings for discrete alarms

Creating a tooltip    
To configure a tooltip for the alarm, follow these steps:

● Enter your text under "Properties > Properties > Tooltip".

Configuring event-driven tasks    
To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the discrete alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Configuring trigger for alarm acknowledgment (Page 3301)

Output of a tag value in the alarm text (Page 3274)

Formatting alarm text  (Page 3273)

Configuring loop-in alarm (Page 3279)

Configuring analog alarms

Introduction
Analog alarms indicate limit violations. For example, if the speed of a motor drops below a 
certain value, an analog alarm is triggered. 

Requirements
● The "HMI alarms" editor is open.

● The Inspector window is open.

● You have created the required alarm classes and alarm groups.

Procedure       
To configure an analog alarm, proceed as follows:

1. Click the "Analog alarms" tab.

2. To create a new analog alarm, double-click in the table on "<Add>".
A new analog alarm is created. 
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3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– Enter an alarm text as event text.
Format the text character-for-character using the shortcut menu. 
Using the shortcut menu, you can insert output fields for HMI tags, or text from text lists.

– You can renumber the alarm.

– Select the alarm class and the alarm group, if necessary.

4. Configure the tag that triggers the alarm under "Properties > Properties > Trigger > 
Settings".
Do not use trigger tags for anything else.

Configure limit values for an analog alarm
1. In the Inspector window, click the button  under "Properties > Properties > Trigger > 

Limit > Value".

– To use a constant as limit value, select "Constant".
Enter the required limit value.

– To use a tag as limit value, select "HMI tag".
The  button is shown. Use this button to select the tag you want to use.

 

  Note

If the required tag does not exist in the selection list yet, create it in the object list and 
change its properties later.

 

2. Select the mode:

– "High limit violation": The alarm is triggered when the limit is exceeded.

– "Low limit violation": The alarm is triggered when the limit is undershot.
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Optional settings for analog alarms

Setting the delay time    
To set the delay time, proceed as follows:

● Enter a time period in the Inspector window under "Properties > Properties> Trigger > 
Settings > Delay".
The alarm is only triggered when the trigger condition is still present after the delay time 
has elapsed.

Setting the deadband
 

 Note

If a process value fluctuates around the limit, the alarm associated with this fault may be 
triggered multiple times. To prevent this from happening, configure a deadband or delay 
time.     

 

To enter the deadband, follow these steps:

1. Under "Properties > Properties> Trigger > Deadband > Mode", select the change in alarm 
status for which the deadband is to be taken into account.

2. Enter a constant value under "Value".

3. To define the deadband value as a percentage of the limit, set the "in %" check box.
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Automatic reporting    
To print the alarms continuously:

● Select the "Activate" option under "Properties > Properties > Miscellaneous > Report."
 

  Note

Device dependency

Reporting is not available for all HMI devices.
 

Creating a tooltip    
To configure a tooltip for the alarm, follow these steps:

● Select "Properties > Properties > Tooltip" in the Inspector window and enter your text.

Configuring event-driven tasks  
To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the analog alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Configuring trigger for alarm acknowledgment (Page 3301)

Output of a tag value in the alarm text (Page 3274)

Formatting alarm text  (Page 3273)

Configuring loop-in alarm (Page 3279)

Formatting alarm text 

Requirements
● The "HMI alarms" editor is open.

● An alarm has been created.

Procedure   
To format an alarm text, proceed as follows:

1. Select the alarm to edit.

2. In the Inspector window, select the characters to format under "Properties > Properties > 
General > Alarm text".

3. Select the formatting from the shortcut menu, e.g. "Underscored" or "Uppercase".
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Result
The selected characters are displayed in Runtime with the selected formatting. 

Removing format settings   
To remove all text formats, proceed as follows:

1. In the Inspector window, select the characters whose formatting you want to remove in the 
alarm text.

2. Select "Delete formatting characters" from the shortcut menu.

Result
The selected characters are displayed in unformatted notation in Runtime.

Output of a tag value in the alarm text

Introduction   
In WinCC, you can insert output fields into the alarm text which display the content of tags.

Requirements
● The "HMI alarms" editor is open.

● The alarm is selected.

Output of a tag value in the alarm text
To insert an output field for a tag value in the alarm text, proceed as follows:

1. Place the cursor onto the required position in the event text.

2. Select "Insert tag output field" in the shortcut menu.

3. Open the object list under "Tag" and select a tag.
You can also create the tag in the object list.

4. Under "Format", specify the length of the output field and the format for tag value output in 
the alarm text.
Configure an output field of sufficient size. Otherwise, the tag content is not output to the 
full extent in the alarm. 

5. Click  to save your entries.

WinCC inserts a placeholder for the output field into the alarm text: "<tag: n, [tag name]>" 
whereby n = text string length.

Visualizing processes (Comfort/Advanced)
10.3 Working with alarms

WinCC Comfort/Advanced V12.0 SP1
3274 System Manual, 07/2013,  



Editing output field properties
To edit the properties of an output field, proceed as follows:

● Double-click on the output field in the alarm text and edit the settings.

Deleting an output field from the alarm text
To delete an output field from the alarm text, proceed as follows:

● Select the output field in the alarm text and then select the "Delete" command from the 
shortcut menu.

 

 Note

The sequence of the tag output fields in the alarm text depends on the language. The 
sequence of the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log.

Device dependency

Logging is not available for all HMI devices.
 

Output of texts from a text list in an alarm

Introduction   
Text lists are used to create dynamic alarm texts. For example, you can configure the output 
of both states of a discrete alarm in an alarm text. 

Insert a corresponding output field in the alarm text and specify the tag that returns the search 
key for the text list. 

Requirements
● A text list is created.

● The "HMI alarms" editor is open

● The alarm is selected

Output of a text list value in an alarm text
To insert an output field for a value from a text list in the alarm text, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. Select "Insert text list output field" command from the shortcut menu.

3. Select the text list under "Text list".
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4. Open the object list under "Tag" and select the tag that returns the search key for the text 
list.
You can also create the tag in the object list.

5. Define the length of the output field under "Format".
Configure an output field of sufficient size so that the complete text from the text list is 
displayed in the alarm.

6. Click on the  icon to save your entries.
WinCC inserts a placeholder for the output field into the alarm text: 
""<textlist: n, [textlist name]>" whereby n = text string length.

Editing output field properties
To edit the properties of an output field, proceed as follows: 

● Double-click on the output field in the alarm text and edit the settings.

Deleting text list from the alarm text
To delete an output field from the alarm text, proceed as follows:

● Select the output field in the alarm text and then select the "Delete" command from the 
shortcut menu.

Editing System Events

Editing system events   
When you open the "System events" tab in the "HMI alarms" editor, WinCC prompts you to 
import or update the system events. Import the system events and specify the display period. 
You cannot delete or create new system events. You can only edit the alarm text with system 
events. 

Requirements
● You have imported the system events.

Specifying the display period
To determine the display period, proceed as follows:

1. Double-click "Runtime settings" in the project navigation.

2. Enter a value under "Alarms > System events > Display period".
This value specifies a time in seconds during which the system events are displayed on 
the HMI device. If you want to display system events permanently, enter "0".
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Changing the alarm text
To change the alarm text of a system event, follow these steps:

1. Open the "HMI alarms" editor and then click the "System events" tab.

2. Select the system event that you want to edit.

1. Change the alarm text under "Properties > Properties > Properties > General" in the 
Inspector window.

 

 Note

If you change an alarm text for a system event that contains a placeholder, leave the number 
of placeholders unchanged. A placeholder may be a "%1".

 

Configuring event-driven tasks
The "Incoming" event is available for certain system events, depending on the HMI device. To 
configure event-driven tasks, proceed as follows:

1. Select the system event.

2. Select "Properties > Properties > Incoming" in the inspector window and configure a function 
list.

Editing controller alarms

Introduction
Controller alarms are configured in STEP 7. Controller alarms are available in WinCC running 
in a STEP 7 environment. 

In WinCC you only edit the properties of controller alarms that are specific to an HMI device. 
Different properties of a controller alarm can be edited, depending on the HMI device and PLC.

You can filter the displayed controller alarms for your project using the display classes that 
were configured on the PLC for controller alarms.

Requirements
● The connection was established to the PLC.

● Alarms were configured in STEP 7.

Editing controller alarms
Proceed as follows to edit controller alarms:

1. Double-click "HMI alarms" in the project navigation.
The "HMI alarms" editor is opened.

2. Open the "Controller alarms" tab.

Visualizing processes (Comfort/Advanced)
10.3 Working with alarms

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3277



3. Select the alarm that you want to change in the work area.

4. Make your changes. Depending on the HMI device, it may not be possible to display or 
enable some of the controller alarm properties.

Editing SIMATIC S7 alarms
You can edit these controller alarms in the STEP 7 alarm configuration system. To do this, 
proceed as follows:

1. Select the alarm that you want to change in the work area.

2. Select "Open in alarm editor of the PLC" from the shortcut menu.
The STEP 7 alarm configuration system is opened.

3. Make your changes.

Filtering the controller alarm using display classes
To filter controller alarms by display classes, proceed as follows:

1. Click "Runtime settings > Alarms" in the project navigation under your HMI device.
One or several connections to a PLC are shown in "Contoller alarms".

2. Select the display classes whose controller alarms you want to display for the connection.

Result
Only those controller alarms whose display class you have enabled for your HMI device will 
be displayed on the "Controller alarms" tab of the "HMI alarms" editor.

See also
PLC alarms (Page 3250)

Enabling system-defined controller alarms

Enabling system-defined controller alarms   
To activate system-defined controller alarms for your HMI device, proceed as follows:

1. Select "Runtime settings > Alarms" in the project navigation.
The alarm settings open.

2. Under "System events" activate the system-defined controller alarms.
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3. To display the system events with alarm text, activate "With text".

4. To display these alarms in Runtime, configure an alarm view that displays alarms from the 
"Diagnosis Events" alarm class.

 

  Note

For HMI devices with small display units, specify to display only the alarm number for 
system-defined controller alarms.

 

 

See also
System-defined controller alarms  (Page 3252)

Configuring loop-in alarm

Introduction
A Loop-In-Alarm is configured in order to change to a screen containing relevant information 
on an alarm received.     

Requirement
● The screen called by the Loop-In-Alarm has been created.

● The "HMI alarms" editor is open.

Procedure
To configure a Loop-In-Alarm for an alarm, proceed as follows:

1. Click the tab that contains the alarm for which you want to configure the Loop-In-Alarm.

2. Select the alarm.

3. In the Inspector window, select "Properties > Events > Loop-In-Alarm".
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4. Select the "ActivateScreen" system function.

5. Select the screen called by the Loop-In-Alarm  as parameter.

 

  Note

To configure the Loop-In-Alarm for an alarm view with an "alarm line" format, use a button 
with the following system functions:
● "EditAlarm" for HMI devices with keys
● "AlarmViewEditAlarm" for HMI devices without keys

The system functions trigger the "Loop-In-Alarm" event. The alarm line has no buttons.
 

Result
If you click on the "Loop-In-Alarm" button of the alarm view in Runtime, a screen is opened 
with information on the selected alarm.

See also
Configuring discrete alarms (Page 3268)

Configuring analog alarms (Page 3270)
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Alarms in the "HMI tags" Editor

Configuring discrete alarms

Introduction
In WinCC, you can create and edit discrete and analog alarms, including the trigger tags, in 
the "HMI tags" editor. 

 

 Note

If you delete, move or copy objects in the "HMI tags" editor, the changes also take effect in 
the "HMI alarms" editor.

 

Requirements
The "HMI tags" editor is open.

Procedure    
To configure a discrete alarm, proceed as follows:

1. To create a tag, click on "<Add>" in the table at the top of the work area.
A new tag is created. 

2. Configure an internal or external tag as required.

– Use the data types "Int" or "UInt" to select an HMI tag.

– Use the data types "Int" or "Word" to select a PLC tag.

3. Select the tag at the top of the work area.

4. Click on "<Add>" in the table on the "Discrete alarms" tab at the bottom of the work area.
A new discrete alarm is created for the tag. If you have selected the incorrect data type, 
the tag will be marked in the discrete alarm.

5. Configure the discrete alarm in the Inspector window:

– Enter the alarm text under "Properties > Properties > General > Alarm text".
You can also insert output fields into the alarm text.

– Select an alarm class.

– Select the trigger bit of the tag that triggers the discrete alarm under "Properties > 
Trigger".

6. You can create additional discrete alarms to monitor the tags.
 

  Note

A tag is monitored using only one alarm type. You should therefore create either analog 
alarms or discrete alarms for a tag.
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Result
The configured discrete alarms are created in the "HMI tags" editor and displayed in the "HMI 
alarms" and "HMI tags" editors. 

Configuring analog alarms

Introduction
In WinCC, create the discrete and analog alarms, including the trigger tags, in the "HMI tags" 
editor. You can also edit the alarms as in the "HMI alarms" editor. You can create up to two 
range values for a tag. You monitor these limits with analog alarms.

Requirements
The "HMI tags" editor is open.

Procedure   
To configure an analog alarm in the "HMI tags" editor, proceed as follows:

1. To create a tag, click on "<Add>" in the table at the top of the work area.
A new tag is created. 

2. Configure an internal or external tag as required.

3. In the Inspector window, configure the range values of the tags under "Properties > 
Properties > Range":

– Select whether to use a "Constant" or an "HMI tag" as limit value for your range values. 
The object list opens when you select "HMI tag". Select the tag you want to use.

Visualizing processes (Comfort/Advanced)
10.3 Working with alarms

WinCC Comfort/Advanced V12.0 SP1
3282 System Manual, 07/2013,  



1. Click the "Analog Alarms" tab at the bottom of the work area.
Create an analog alarm for both range values.

2. Select an analog alarm and configure it in the Inspector window:

– Enter the alarm text under "Properties > Properties > General > Alarm text".

– You can also insert output fields into the alarm text.

– You can change the default alarm class.

3. Configure the analog alarms as in the "HMI alarms" editor.

4. Complete the configuration of all analog alarms.
 

  Note

A tag is monitored using only one alarm type. You should therefore create either analog 
alarms or discrete alarms for a tag.

 

Result
The configured analog alarms are created in the "HMI tags" editor and displayed in the "HMI 
alarms" and "HMI tags" editors. 

10.3.2.3 Configuring the Outputting of Alarms

Overview of configuring alarm output

Steps to complete when configuring alarm output   
You configure the alarm output in WinCC in the following steps:

1. Create alarm view
Use the display and control objects in the "Screens" editor to display alarms in Runtime. 
You can also configure an alarm view for logged alarms.

2. Configure acknowledgment
In the "Screens" editor, you can set the operator action that will trigger the acknowledgment. 

3. Configure reporting
You can create reports in the "Reports" editor to print alarms in Runtime. In the "Scheduler", 
"Screens", "HMI alarms" or "HMI tags" editors, you define when and how the printing of a 
report is triggered. 

 

  Note

Device dependency

Reporting and logging are not available for all HMI devices.
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Additional configuration tasks
Additional tasks may be necessary for configuring alarm views, depending on the requirements 
of your project:

1. Setting up authorizations
To make sure only authorized operators process the alarms, assign authorizations for the 
alarm view and the function keys of the HMI device.

2. Configuring the filtering of the alarm view
You configure the filtering of the alarms in Runtime in the "Screens" editor. You can also 
configure alarm views that only display selected alarms.

3. Configure operator input alarms
Configure the operator input alarms on the operator controls of the HMI device in the 
"Screens" editor. A preconfigured operator input alarm is output for an operator action. An 
operator input is, e.g. the acknowledgment of an alarm.

Displaying alarms

Options for displaying alarms on the HMI device
WinCC offers the following options for displaying alarms on the HMI device: 

● Alarm view
The alarm view is configured in a screen. More than one alarm can be displayed 
simultaneously, depending on the configured size. You can configure multiple alarm views 
with different contents.

● Alarm window
The Alarm window is configured in the "Global screen" editor. The alarm window can display 
multiple alarms at the same time, depending on the configured size. An event can trigger 
closing and reopening of the alarm window. To hide it during configuration, create an alarm 
window on its own level.
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Additional signals
● Alarm indicator

The alarm indicator is a configurable, graphical icon. When an alarm comes in, the alarm 
indicator is displayed on the HMI device. You configure the alarm indicator in the "Global 
screen" editor.
The alarm indicator has two states:

– Flashing: At least one alarm that requires acknowledgment is pending.

– Static: The alarms are acknowledged but at least one of them has not gone out yet.
The alarm indicator also displays the number of pending alarms according to the HMI 
device.

● E-mail notification
To inform someone other than the operator, such as an engineer, when an alarm with a 
specific alarm class arrives, assign the alarm class to an e-mail address.

 

  Note
Device dependency

E-mail notification is not available for all HMI devices.
 

● System functions
You can configure a list of functions for the event associated with an alarm. These functions 
must be executed in Runtime when the event occurs. 
Use system functions for alarms in WinCC to control the alarm view or the alarm window 
other than via the toolbar.

Displaying the predefined alarm classes in Runtime  
The following table shows the symbols used to display the predefined alarm classes in the 
alarm view:

Alarm class Displayed icon
"Diagnosis Events" S7
"Errors" !
"System" $
"Warnings" <No symbol>

See also
Configuring an alarm view for active alarms (Page 3286)

Configuring an alarm window  (Page 3291)

Configuring an alarm indicator (Page 3292)

Configuring alarm filtering (Page 3294)

Displaying Logged Alarms (Page 3297)

System functions for alarms (Page 3334)
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Configuring an alarm view

Configuring an alarm view for active alarms

Introduction
Current alarms are displayed in Runtime in an alarm view or alarm window.

Requirement
● A screen is open in the "Screen" editor.

● The "Tools" task card is open.
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Configuring alarms for the alarm view   
To specify the alarms that will be shown in the alarm view, proceed as follows:

1. Insert an "Alarm view" object from the "Tools" task card into the screen.

2. Select the alarm view.

– In the Inspector window, select "Properties > Properties > General > View > Current 
alarm states".
Set whether to display alarms with and/or without mandatory acknowledgment.

– To display all alarms in the alarm buffer, enable "Alarm buffer".
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3. In the table, activate the alarm classes to be displayed in the alarm view.

4. Under ""Properties > Properties > View > Control tag for display area", define the tag that 
returns the date as of which the alarms will be displayed.

 

  Note
Device dependency

The "Control tag for display area" property is not available for all HMI devices.
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Configuring the layout of the alarm view   
To specify how the alarms are shown in the alarm view, proceed as follows.

1. Under "Properties > Properties > Layout > Settings > Lines per alarm" in the Inspection 
window, specify the number of lines to display for each alarm.

2. In "Properties > Properties > View", select the control elements that are available on the 
HMI device.

3. Configure the columns under "Properties > Properties > Columns":

– Under "Visible columns" select the columns to be output in the alarm view.

– Under "Properties Column", define the properties of the columns.

– Under "Sort", select the sorting order of the alarms.

 

  Note

Select the "Edit" command in the shortcut menu for the alarm view to activate the alarm 
view. You can set the column width and position in active mode. To enable the alarm 
view, set the zoom factor to 100 %.

The alarm view is deactivated as soon as you deselect the object in the screen.
 

Result
Alarms of various alarm classes are output in the alarm view during runtime. 

See also
Creating alarm classes (Page 3263)

Configuring an alarm window  (Page 3291)

Alarm view (Page 3112)
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Configuring an alarm view for the S7 diagnostic alarms

Introduction   
To display S7 diagnostic alarms, configure an alarm view or alarm window for the predefined 
"Diagnosis Events alarm class. Activate the diagnostic alarms accordingly in the Runtime 
settings of your HMI device.

 

 Note
HMI device dependency

The "Diagnosis Events" alarm class is not available for all HMI devices.
 

Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● A connection to the PLC is set up.

Configuring the display of S7 diagnostic alarms   
To configure the display of S7 diagnostic alarms, follow these steps:

1. Select "Runtime settings > Alarms > System events > S7 diagnostics alarms" in the project 
navigation.

2. To display the S7 diagnostics alarms with text, activate "With text".

3. Open the screen with the alarm view and select the alarm view.

4. In the Inspector window, select "Properties > Properties > General > Display > Alarm class 
"Diagnosis Events".

5. Continue to configure the alarm view as for the display of current alarms.
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Result
In Runtime the alarm view displays the S7 diagnostic alarms of the controller. 

Configuring an alarm view for logged alarms

Introduction
In Runtime, logged alarms are displayed in an alarm view or alarm window.

Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● An alarm log was created in the "Log" editor.

● The alarms are assigned the "loggable" attribute in the "HMI alarms" editor.

Configuring an alarm view for logged alarms   
To configure an alarm view for logged alarms, proceed as follows:

1. Open the screen with the alarm view and select the alarm view.

2. In the Inspector window, select "Properties > Properties > General > Alarm log".

3. Click the "...." button and select the alarm log.

4. Continue to configure the alarm view as for the display of current alarms.

Result
In Runtime, the logged alarms are output in the alarm view. 

Configuring an alarm window 

Introduction
The alarm window displays current alarms. The alarm window is configured in the "Global 
screen" editor. The alarm window is not assigned to any screen. Depending on the 
configuration the alarm window is opened when an alarm that belongs to a specific alarm class 
is active. Depending on the configuration, it is not closed until the alarm is acknowledged. The 
HMI device can still be used, even if alarms are pending and displayed. An alarm window is 
displayed and configured like an alarm view.  

To hide an alarm window during configuration, create it on its own level. 
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Requirement
● The "Global Screen" editor is open.

● The "Tools" task card is displayed.

● The Inspector window is open.

Procedure   
Proceed as follows to configure an alarm window:

1. Insert an "Alarm window" object from the "Tools" task card into the global screen.

2. Configure the alarm window like an alarm view.

3. Under "Properties > Properties > Mode >  Window" in the Inspector window, select how 
the alarm window reacts and is operated in Runtime.

– Activate "Modal" if the alarm window is to retain the focus in Runtime after a screen 
change.
This option is important, as switching back and forth between the screen and different 
windows with <Ctrl+TAB> is not supported.

Result
During runtime, the alarms of the selected alarm class are displayed in the alarm window. 

See also
Configuring an alarm view for active alarms (Page 3286)

Creating alarm classes (Page 3263)

Alarm window (Page 3117)

Configuring an alarm indicator

Introduction
The alarm indicator uses a warning triangle to indicate that alarms are pending or require 
acknowledgement. If an alarm of the configured alarm class occurs, the alarm indicator is 
displayed.  

The alarm indicator has two states:

● Flashing: At least one alarm that requires acknowledgment is pending.

● Static: At least one of the acknowledged alarms has not gone out yet.

During configuration, specify whether Runtime has to open an alarm window when you operate 
the alarm indicator.
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Requirement
● The "Global Screen" editor is open.

● The "Tools" task card is open.

● The Inspector window is open.

Procedure
Proceed as follows to configure the alarm indicator:

1. Insert the "Alarm indicator" object from the "Tools" task card into the work area.

2. Select the alarm indicator.

3. Under "Properties  > Properties  > General" in the Inspector window, select the alarm 
classes to be displayed by the alarm indicator.
Specify whether to display pending and/or acknowledged alarms in the alarm indicator.

4. Under "Properties > Event", assign system function "ShowAlarmWindow" to an event of 
the alarm indicator.

 

  Note

If you have configured a permanent window in the screen or template, do not position the 
alarm window and alarm indicator in the vicinity of the permanent window. Otherwise the 
alarm window and the alarm indicator are not displayed in Runtime. However, the 
permanent window is not visible in the "Global screen" editor.

 

Result
The alarm indicator is displayed if alarms from the selected alarm class are pending or need 
to be acknowledged in Runtime. The alarm window opens when the user operates the alarm 
indicator. 
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See also
Alarm indicator (Page 3120)

Configuring alarm filtering

Introduction
You can filter the display of alarms in the enhanced alarm view. The criterion is always a 
character string. There are two ways to filter the alarm view:

● A fixed criterion is configured in WinCC.
In Runtime, all alarms that contain the complete character string in the alarm text are 
displayed.

● You filter the alarm view in Runtime.
In Runtime, a filter tag sets the relevant character string in the alarm view by means of an 
I/O field, e.g. as described below. 
The filter affects the display in the alarm view. All alarms in the alarm buffer are retained. 

Requirements
● An enhanced alarm view has been configured.

● The screen with the alarm view is open.

● The Inspector window is open.
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Configuring filters for a fixed character string
1. Select the alarm view.

2. In the Inspector window, select "Properties > Properties > Filter".

3. Enter a filter string in "Filter string".

Result
Only those alarms are displayed in Runtime that contain the complete character string from 
the filter in the alarm text.

Configuring filters for a variable character string    
1. Select the enhanced alarm view.

2. In the Inspector window, select "Properties > Properties > Filter".
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3. Select a tag from "Filter tag". The tag must be of the "String" type.

4. In the screen, configure an I/O field for entering the filter string in Runtime.

– In the Inspector window, select "Properties > Properties > General > Format > Display 
format > String".

– To link the I/O field to the alarm view, select "Process" to set the filter tag you selected 
for the alarm view.

Result
If you enter a string in the I/O field in Runtime, the alarm view only displays alarms that contain 
the complete string in their alarm text. 

If a permanently configured character string and a filter tag were configured, the alarms will 
be filtered in Runtime according to the content of the filter tag. If the filter tag is blank, the 
permanently configured character string is used as the filter. 

 

 Note

Filtering is not possible for the following alarm views:
● Simple alarm view
● Alarm line
● Alarm window
● Alarm view for logged alarms
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Displaying Logged Alarms

Introduction
You display logged alarms in Runtime in an alarm view. The alarm view shows the content of 
an alarm log.   

Application
For example, you want to view information about the process at the end of a shift.

Requirements
● An alarm log has been created.

● A screen is open.

● The Inspector window is open.

Procedure
Proceed as follows to configure an alarm view to output an alarm log:

1. Configure an alarm view in a screen.

2. Under "Properties > Properties > General  > Display > Alarm log"" in the Inspector window, 
select the required alarm log.
You can always create a new alarm log.

Result
During runtime, the alarms logged in the selected alarm log appear in the Alarm view.

 

 Note

In runtime, the alarm texts logged are not displayed but rather the alarm texts in the current 
project. The logged alarm texts are only intended for external evaluation of the log file.

If the alarm log displayed was configured differently, the alarm texts displayed may not 
correspond with those logged. 
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Reporting Alarms

Overview
WinCC can report on all alarms that occur in the system. The following options are available:

● Output an alarm sequence report
In Runtime, the standard printer of the HMI device will continuously print each alarm and 
any changes in its status.

● Output of an alarm report
You configure an alarm report in the "Reports" editor and specify when it is output in 
Runtime: 

– For event-driven output, configure an object that is assigned the "PrintReport" system 
function. The object can be a button or tag.

– For time-driven output, create a "Print job" in the scheduler. Assign an alarm report to 
the job.

 

  Note

In the alarm report, specify whether to output current or logged alarms. 
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Requirements
● A printer was configured on the HMI device.

Activating continuous alarm reporting   
To activate continuous reporting of alarms, follow these steps:

1. Double-click "Runtime settings" in the project navigation.

2. Select "Alarms > General > Report".

Result
The latest alarms are output at the printer of the HMI device. 
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Excluding an alarm from reporting
To exclude specific alarms from reporting, proceed as follows:

1. Open the "HMI alarms" editor.

2. Select the alarm to exclude from reporting on the tab of the selected alarm type.

3. In the Inspector window, disable "Properties > Properties > Miscellaneous > Report".

Result
WinCC does not output these alarms currently on the connected printer. 

See also
Working with reports (Page 3463)

10.3.2.4 Acknowledging alarms

Configuring alarm acknowledgment by means of alarm class

Introduction
To configure an alarm with alarm acknowledgment, assign it to an alarm class with the "Alarm 
with single acknowledgment" acknowledgment model. 

Requirement   
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created.
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Selecting the acknowledgment model for an alarm class
The acknowledgment model for a predefined alarm class has already been set. You can only 
set the acknowledgment model for user-defined alarm classes. Proceed as follows:

1. In the "HMI alarms" editor, click the "Alarm class" tab and select the alarm class.

2. Select the required acknowledgment model under "Properties > Properties > 
Acknowledgment" in the Inspector window.

Assign alarms to an alarm class requiring acknowledgment
Proceed as follows to assign an alarm to an alarm class requiring acknowledgment.

1. In the "HMI alarms" editor, click the tab for the alarm type and select the alarm.

2. Under "Properties > Properties > General" in the Inspector window, select the alarm class 
of the alarm.

Result
The alarm will not disappear in Runtime until it is acknowledged by the operator.

Configuring trigger for alarm acknowledgment

Introduction
You always specify the acknowledgment requirement for an alarm using the alarm class. Then 
the operator acknowledges the alarm using the "ACK" function key of the HMI device or the 
"Acknowledgment" button of the alarm view. 

The following options are also available to trigger acknowledgment:

● Configuring a button to acknowledge an alarm

● Acknowledgment of a Discrete Alarm by the PLC

Requirement   
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created.

● An alarm view and a button are created in the "Screens" editor.
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Configuring a button to acknowledge an alarm
To configure a button for acknowledging an alarm, proceed as follows:

1. Select the button in the "Screens" editor.

2. Under "Properties > Events" in the Inspector window, assign the 
"AlarmViewAcknowledgeAlarm" system function to the "Click" event.

3. Select the alarm view as parameter.

Acknowledgment of a Discrete Alarm by the PLC
1. In the "HMI alarms" editor, click the "Discrete alarm" tab and select the discrete alarm.

2. In the Inspector window, select the tag and the bit that acknowledges the PLC alarm under 
"Properties > Properties > Acknowledgment > PLC".

Sending alarm acknowledgments to the PLC

Requirement     
● The "HMI alarms" editor is open.

● The required alarm has been created and assigned to an alarm class requiring 
acknowledgment.

 

  Note

You cannot send the acknowledgment of analog alarms to the PLC. 
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Sending alarm acknowledgments to the PLC
To configure that acknowledgment of an alarm is sent to the PLC, follow these steps:

1. In the "HMI alarms" editor, click the "Discrete alarm" tab and select the discrete alarm.

2. In the Inspector window, select "Properties > Properties > Acknowledgment".

3. Under "HMI", select the tag and the bit set by the alarm acknowledgment function.
 

  Note

The HMI device and PLC only have read access to the acknowledgment tag memory area.
 

Result
If the operator acknowledges the alarm in Runtime, the operating step is forwarded to the PLC.

10.3.2.5 Configuring alarm buffer overflow

Introduction
The size of the alarm buffer depends on the type of HMI device. In WinCC, specify the 
percentage of the alarm buffer to be deleted on alarm buffer overflow.  

Requirements
● You have created a project.

Procedure
To configure the response to an alarm buffer overflow, follow these steps:

1. Double-click "Runtime settings" in the project navigation under your HMI device.

2. Under "Alarms > General > Buffer clearance in percent upon buffer overflow", enter a value 
between 1 and 100.
This value specifies the percentage of the alarm buffer that is deleted on alarm buffer 
overflow.    

Result
If data in the alarm buffer exceeds the resources of alarm buffer memory, the configured 
percentage of data will be deleted from the oldest alarms in the alarm buffer.

 

 Note

You cannot check the alarm buffer overflow separately by alarm method. You can use the 
"ClearAlarmBuffer" system function to delete specific alarms of specific alarm classes from 
the alarm buffer. 
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See also
Alarm Logging Basics (Page 3304)

10.3.3 Logging Alarms

10.3.3.1 Alarm Logging Basics

Introduction
An alarm log is used to record project alarms.  

 

 Note

Alarm logging is not available for every HMI device.
 

Configuration steps
To log an alarm, follow these configuration steps:

1. Creating an alarm log  
You define the following properties for the alarm log:

– Logging method
Behavior of the log when reaching a specific fill level

– Storage location and file format

– Log size

– Runtime start characteristics

– Checksum

2. Assigning an alarm log to an alarm class
You can log the alarms from multiple alarm classes in an alarm log.

3. Assigning an alarm to a loggable alarm class

4. Configure display of logged alarms in an alarm view

Content of the alarm log
All states are logged for configured alarms. The following three entries, for example, are stored 
in the log for an alarm that requires acknowledgment:

● 04.08.2007 10:00:25:520, analog alarm, ID5, K, error, fill level exceeded by 10 %

● 04.08.2007 10:01:20:442, analog alarm, ID5, Q, error, fill level exceeded by 10 %

● 04.08.2007 10:01:30:112, analog alarm, ID5, G, error, fill level exceeded by 10 %

In the example, the alarm states are identified by the following letters:
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K = Incoming

Q = Acknowledged

G = Outgoing

All data belonging to an alarm is stored in the alarm log, including configuration data such as 
the alarm class, time stamp, and alarm text.

The potential number of logged alarms depends on the data medium used.
 

 Note

Alarm text and error location are only logged if you have configured such a setting in the log 
properties.

 

 Note

The time stamp of a logged alarm is always specified in standard UTC format (Universal Time 
Coordinated).

 

Logging methods
The logging method determines how the alarm log responds when the configured size is 
reached. WinCC supports the following logging methods:   

● Circular log
When the configured log size has been reached, the oldest entries are deleted. When the 
configured log size has been reached, approximately 20% of the oldest entries are deleted. 
It is therefore not possible to display all the configured entries. During configuration, select 
an appropriate size for the circulation log. Alternatively, configure a segmented circular log.

● Segmented circular log
In a segmented circular log, multiple single logs of the same size are filled in succession. 
When all logs are completely full, the oldest log is overwritten.

● Log with level-dependent system alarm
When a defined level is reached, such as 90 %, a system alarm is triggered. When the 
configured size of the log has been reached, new alarm events are not logged.

● Log with level-dependent execution of system functions
When the log is completely full, the "Overflow" event is triggered. You configure a function 
list for the event. 
When the configured size of the log has been reached, new alarm events are not logged.

Checksums in regulated projects  
With WinCC you configure regulated projects as required by FDA guidelines, if necessary. Use 
the "Audit" option to create regulated projects. 

In regulated projects you supply a checksum for the logged data of an alarm log. The operator 
will use this checksum during operation of the plant to see if the data of an alarm log have 
been changed.
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For the checksum to be clear, it starts with the first line of an alarm log and integrates the 
previous lines when continuously generating the checksum. This means a checksum can only 
be generated for the following logs:

● Log that sends a system alarm when it is full

● Log with execution of system functions when log is full.

Generation of a checksum is also available for alarm logs that are saved as files of the "*.csv" 
or "*.txt" (Unicode) format.

If you want to continue an existing log without checksum as one with checksum, a backup 
copy of the existing log is created in the "*.keep" file format. A new log with checksums is 
created.

To maintain the validity of checksums, the following limitations apply when using the system 
function "CopyLog":

● You cannot copy a log without checksums into a log with checksums.

● You cannot copy a log with checksums into a log without checksums.

Storage location and storage medium   
You can save the log data to a file on a data carrier, e.g. MMC, SD, or CF cards. If you are 
using a PC as your HMI device, you may store your information in a database. You can further 
process the saved data in other programs for analysis purposes, for example.  

Displaying logged data
On the HMI device, the logged data is displayed in an alarm view that is configured for this 
purpose.   

See also
Configuring alarm buffer overflow (Page 3303)

10.3.3.2 Storage locations for log files

Introduction
The alarm log is stored in an ODBC database or in a file. Select "Database" or "File" as the 
storage location. 

 

 Note

An "ODBC database" storage location is only available on a PC.
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Log file
Depending on the configuration of the HMI device, select one of the following storage locations 
for the log file:

● Local hard disk of the PC

● Storage card of the Panel

● Network drive
 

  Note
Logging on network drives

Do not log alarms, tags and Audit Trail directly on a network drive. Power supply can be 
interrupted at any time. This means there is no guarantee for a reliable operation of logs 
and audit trails.

Save the logs on your local hard drive or a local storage card. Use the system function 
"ArchiveLogFile" to save the logs long-term on a network drive. This step ensures reliable 
operation.

 

File - CSV (ASCII)
Data is saved to a "*.csv" file in standard ASCII format.

Use the "File - CSV (ASCII)" storage location if you are going to read logged data without using 
WinCC Runtime.

 

 Note

Double quotation marks or several characters are not permitted as list separator for the 
storage site "File - CSV (ASCII)." You can find the settings for list separators under "Start > 
Settings > Control Panel > Regional and Language Options."

 

File - TXT (Unicode)
The log data are saved in Unicode.

This file format supports all characters that can be used in WinCC and WinCC Runtime. For 
editing, use software that can save files in Unicode, such as Notepad.

 

 Note

Use "File - TXT (Unicode)" as the storage location to log Asian languages.
 

File - RDB
Data will be saved with quick access to a proprietary database. 

Use the "File - RDB" storage location if you require maximum read performance in Runtime. 

Data logs of this format can only be read and displayed using WinCC Runtime.
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Convert the RDB file to CSV format using the "CopyLog" function to make the data available 
for applications outside WinCC Runtime.

Files of logs with checksums
● *.keep

This file is created in the following cases:

– A log is started without checksum and will be continued with a checksum.

– You update WinCC with a Service Pack or a new version. Writing of the Audit Trail or 
the log with checksum is continued.

The content of the "*.keep" file remains the same when compared with the original "*.csv" 
or *.txt" file. 

● *.bak
This file is created when WinCC Runtime has determined a serious, irregular problem in 
the file.

Database
Data is saved to a database which is set up for ODBC access by the PC administrator. 

If you have selected an ODBC database as storage location, select one of the following options 
for naming:

● "User-defined name of data source"
You define the name of the data source.

● "System-defined name of data source",
The system defines the name.
You will need a special instance of Microsoft SQL Server on the target system in order to 
do this. Download the free SQL Server 2005 Express from the Internet for this purpose. 

 

  Note
Device dependency

This setting is not available on the Panel PC 477.
 

 

10.3.3.3 Creating an alarm log

Introduction
In Runtime, you save alarms to the alarm logs. Specify the alarm log in the alarm class. An 
alarm log contains the alarms of several alarm classes. Create the alarm log in the "Logs" 
editor. When creating an alarm log, define the following parameters:

● Name

● Size

● Storage location
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● Runtime start characteristics

● Log type

● Advanced content

● Checksum

You can also enter comments for each log. 

Requirement
● The "Alarm log" tab is open in the "Log" editor.

● The Inspector window is open.

Procedure     
To create an alarm log, proceed as follows:

1. Double-click "<Add>" in the table.
A new alarm log is created.

2. Under "Properties > Properties > General" in the Inspector window, enter a unique name 
for the alarm log.

 

 Note

The log names must be unambiguous in a project. The name of a log must always be unique, 
regardless of whether different storage locations are selected for the log. 
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 Note

The characters which can be used in the name of the data source depend on the storage 
location.

The characters \ / * ? : " < > | are not permitted for the following storage locations:
● File - RDB
● File - CSV (ASCII)
● File - TXT (Unicode)

If the "Database" storage location is used, the following characters may be used: a-z A-Z 0-9 
_ @ # $

The characters _ @ # $ cannot be used as the first character of a name.
 

1. Under "Number of data records per log", define the number of alarms to be saved to a log 
file.
The approximate space required on the storage medium is displayed. Memory space 
requirements will increase accordingly if you log alarm texts with tag values. 

2. Under "Storage location", select a file, or an ODBC database.

– If you select a file, enter the corresponding path. Depending on the HMI device, save 
the log files to the hard disk of the PC, to the memory card of a panel, or to a network 
drive.
Different file formats are supported, depending on the HMI device.

– If you select a "Database" storage location, specify the following:
Specify whether the name of the data source is accepted by the system.
Specify whether to select the name of the data source yourself.
Enter a name for the database.
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1. To determine if audit trail data were changed at a later time, activate "Properties > 
Properties > General > Checksum".

 

  Note
Device dependency

The "Checksum" option is only available for display and HMI devices which support logs.
 

Configuring the behavior of the log when it reaches a specific fill level
1. Define how the log should behave when it is full under "Properties > Properties > Logging 

method".

– Specify the number of logs for the "Segmented circular log" log type.

– For the "Display system event on" log type, specify the fill level triggering the system 
event.

– If you selected the "Trigger event" log version, configure a function list under "Properties 
> Events > Overflow". The function list will be processed when the log is full.

2. Under "Properties > Properties > Archiving method > Settings", specify whether to log the 
alarm text and fault location.
Logged alarms that contain alarm text and the fault location exceed the estimated size of 
the configured alarms. Check to see whether the specified specified storage location still 
has sufficient space.
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Configuring the behavior of the log when Runtime starts
1. Select "Properties > Properties > Start behavior> Type".

– Define whether to start the log automatically at the start of Runtime.

– To overwrite logged data with new data, activate "Reset log".

– To add the logged data to an existing log, activate "Continue log".
 

  Note

Use system functions to control the restart of a log in Runtime.
 

Configuring a comment
To record a text to document your configuration of a log, follow these steps: 

1. Enter your text under "Properties > Properties > Comment".

Result
The alarm log is created. You can assign one or several alarm classes to this alarm log. 

See also
Managing logging behavior when Runtime starts (Page 3319)

Controlling the Logging in relation to the Fill Level (Page 3320)

10.3.3.4 Logging Alarms

Overview
To log alarms, follow these steps:

● Create an alarm log.

● Assign the created alarm log to an alarm class.

● Assign the alarm class with the created alarm log to an alarm.
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● In the Runtime settings specify the language in which you want to write the logs.

● You evaluate logged alarms.
You can analyze the logged alarms directly in your WinCC project, such as in an alarm 
view, or in another user program, such as Microsoft Excel.

 

  Note
Tag fields in the alarm text

The sequence of tag fields in the alarm text is language dependent. The sequence of the 
Runtime language is used for logging alarms to a "*.csv" log file.

Changing the tag of an output field in one language causes the modified output field to 
appear at the end of the alarm text in all other languages. This means the sequence of 
the output fields in the log file can change.

 

Requirements
● You have created an alarm log.

● The "HMI alarms" editor is open.

Assigning an alarm log to an alarm class
To assign the alarm log to an alarm class, proceed as follows:

1. Open the "Alarm classes" tab in the "HMI alarms" editor.

2. Select the required alarm class.

3. Under "Properties > Properties > General  > Log" in the Inspector window, select the alarm 
log.

Assign alarm to an alarm class
To assign an alarm to the alarm class, proceed as follows:

1. In the "HMI alarms" editor, open the "Analog alarms" tab, or the "Discrete alarms" tab.

2. Select the required alarm.

3. Under "Properties > Properties > General > Alarm class" in the Inspection window, select 
the alarm class for which the alarm log was configured.

Result
The alarm is saved to the configured alarm log. 

10.3.3.5 Configuring an alarm view for logged alarms

Introduction
In Runtime, logged alarms are displayed in an alarm view or alarm window.
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Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● An alarm log was created in the "Log" editor.

● The alarms are assigned the "loggable" attribute in the "HMI alarms" editor.

Configuring an alarm view for logged alarms   
To configure an alarm view for logged alarms, proceed as follows:

1. Open the screen with the alarm view and select the alarm view.

2. In the Inspector window, select "Properties > Properties > General > Alarm log".

3. Click the "...." button and select the alarm log.

4. Continue to configure the alarm view as for the display of current alarms.

Result
In Runtime, the logged alarms are output in the alarm view. 

10.3.3.6 Direct access to the ODBC log database

Overview
The storage location of a log can be a database or a file.  

The database is addressed by means of its "Data source name" (DSN). Select the database 
to be used in WinCC as follows:

Select the database from the Windows Start menu under "Settings > Control panel > ODBC 
Data Sources".

In your configuration, specify the "Data source name" (DSN) instead of a directory name as 
storage path for log data. With the DSN, you are referencing the database and the storage 
location.

The entire functional scope of the database is available for additional processing and 
evaluation of log data.

Application
The data source sets up the connection to the database. Create the data source on the same 
PC on which the Runtime software is stored. Then enter the DSN configured on this PC when 
you create a log in WinCC. 

The ODBC interface allows you to use other programs, such as MS Access or MS SQL Server, 
to access the database directly.

In addition, you can use the "StartProgram" system function to configure program calls, e.g. 
MS Access, on the HMI device. Runtime is not interrupted while you configure such calls. 
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10.3.3.7 Setting up the ODBC data source

Introduction
To store process values or alarms in the log database in Runtime, set up the ODBC data 
source.

Requirement
● A log database has been created. 

You create the log database using the SQL Enterprise Manager. You can find more detailed 
information on how to do this from Microsoft.

Procedure
To set up an ODBC data source, follow these steps:

1. In Control Panel, open "Administrative Tools" and select "Data Sources (ODBC)".
The "ODBC Data Source Administrator" dialog is opened. 

2. Click "User DSN > Add".

3. Select the "SQL-Server and click on "Finish". 

4. In the dialog that follows, enter a name for the User DSN and the SQL-Server  and click on 
"Next".

5. In the dialog that follows, define the logon procedure for the SQL database and click on 
"Next".

6. Activate "Change the default database to". 

7. Select the database you have created and click on "Next".

8. In the dialog that follows, click "Finish".

10.3.3.8 Configuring a checksum for a log

Introduction
In a regulated project, you have the option of assigning a checksum to the log data of an data 
log or alarm log. This checksum can be used during plant operation to determine if the data 
of this log has subsequently changed. 

Requirement
● GMP compliant configuration is enabled.

● A data log or alarm log has been created.
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Procedure
Proceed as follows to configure a data log or alarm log for the use of a checksum:

1. Open the data log or alarm log in the corresponding log editor.

2. In the "Storage location" box, select "File - CSV (ASCII)" or "File - TXT (Unicode)".

3. Under "Properties > Properties > Logging method" in the Inspector window , select the 
option "Display system event at" or "Trigger event".

4. In the editor table activate the option "Activate checksum".
Columns that are not displayed are activated with the shortcut menu of the column title.

5. Save the project.

Result
The log data of the log is assigned a checksum in runtime.

See also
GMP-compliant configuration (Page 5757)

Enabling GMP compliant configuration (Page 5761)
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10.3.3.9 Evaluating the checksum of log data

Introduction
If you have configured a data log or alarm log with generation of a checksum, you can check 
if the log data has subsequently changed.

The DOS program "HmiCheckLogIntegrity" is available for checking the integrity of the log 
data.

The "HmiCheckLogIntegrity" program supports verification of the following files:

● Log files of alarm logs, data logs, and Audit in CSV format

● Log files of alarm logs, data logs, and Audit  in TXT format

● Recipe data records in CSV format

● Recipe data records in TXT format

You can find the "HmiCheckLogIntegrity.exe" program in the installation directory of WinCC 
under the folder "WinCC Runtime Advanced", for example <C:\Program Files\Siemens
\Automation WinCC Runtime Advanced>.

 

 Note
Audit Trail and Log with Checksum

Before you update WinCC with a Service Pack or a new version, exit and save the Audit Trail 
or the logs using checksum. After WinCC is updated, the audit trail or logs will be continued 
with new files using checksum. 

Make sure that the logs are started at a defined state with the new version.      
 

Procedure
1. Copy the file to be checked from the HMI device to your configuration computer.

2. Open a command line prompt with "Start > Programs > Accessories > Command Prompt".

3. Enter the path to "HmiCheckLogIntegrity.exe" followed by a space in the command line 
prompt. After the space, enter the storage location of the file to be checked within quotation 
marks.
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4. Press <Enter>.

5. The check is performed.
When the checked data are consistent, the "Consistency check succeeded" message 
appears.

When the checked data are inconsistent, the "Consistency check failed" message appears. 
Information about the first inconsistent line in the file is also displayed.

 

 Note

If there are spaces in the path to the "HmiCheckLogIntegrity.exe" program, you need to 
specify the path in quotation marks.

 

You can also check the integrity of the log data with the AuditViewer.

See also
Enabling GMP compliant configuration (Page 5761)

Evaluating Audit Trails in AuditViewer (Page 5779)

10.3.3.10 Log response to language switching in runtime

Introduction
In the Runtime settings of your HMI device, select the language to be used for writing to logs 
in runtime.       
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Requirement
● The languages used in your project are activated in the "Project languages" editor, for 

example, "German (Germany)" and "English (USA)" .

Procedure
To determine the startup language, follow these steps:   

1. Select "Runtime settings > Language and fonts" in the project navigation.

2. Activate the runtime language, for example, "German (Germany)" and "English (USA)".

3. Set the "Language switch order". Use 0 to determine the startup language, for example:

– German 0.

– English 1
With "0", German is specified as the "Startup language".

4. Select "Runtime settings > General" in the project navigation.

5. Select the "Logs > Logging language > Startup language".

Result
The project starts after it is transferred. German is specified as the "Startup language" with 
"Language switch order". The logs are now written in German. During runtime, the operator 
switches the runtime language to English. The logs will still to be written in German.

The operator closes runtime. Due to the previously performed language switch, the next time 
the system starts the "startup language" is English. Since English is the startup language, the 
logs are now written in English.

The logging language remains English even when the language is switched again in runtime 
until runtime is closed once again.

If you use another option instead of "Startup language" to select the language, the logs are 
always written in the same language. This is true regardless of the language selected by the 
operator in runtime. 

10.3.3.11 Managing logging behavior when Runtime starts

Introduction
When you configure a data log, you define the restart characteristics of the log when Runtime 
is started. You define whether the logging should start when Runtime starts in the log 
properties. You can also define whether an existing log will be continued or overwritten.  

You define the restart characteristics separately for each log.
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Requirement
● A data log has been created.

● The "Data log" editor is open.

● The Inspector window with the log properties is open.

Procedure
To configure the restart characteristics of a data log, proceed as follows:

1. Select the log for which you want to define the restart characteristics in the "Data Log" editor.

2. In the Inspector window select "Properties > Properties > Restart behavior."

3. If you want logging to start when Runtime starts, enable the "Enable logging at runtime 
start" option in the "Logging" area.
You can also start logging in Runtime using the "StartLogging" system function, for example.

4. Select the restart behavior of the log in the "Log handling at restart" area.

– The logged values are deleted and logging is started again with the option "Reset log".

– The option "Append data to existing log" is used to append the values to be logged to 
the existing log.

Alternatively you can configure the restart characteristics of a log directly in the "Data log" 
editor table. To view hidden columns, activate the column titles using the shortcut menu.

Result
Logging will start in runtime according to your settings. 

10.3.3.12 Controlling the Logging in relation to the Fill Level

Introduction
The size of a log is determined by the number of entries. You use the logging method to 
determine how the log responds when it is full.   

Logging methods
The following logging methods are available:

●  Circular log
When the configured log size has been reached, the oldest entries are deleted. When the 
configured log size has been reached, approx. 20% of the oldest entries are deleted. It is 
therefore not possible to display all the configured entries. During configuration, select an 
appropriate size for the circulation log. Alternatively, configure a segmented circular log.  

●  Segmented circular log
In a segmented circular log, multiple log segments of the same size are filled in succession. 
When all logs are completely full, the oldest log is overwritten.
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●  Log that sends a system alarm when it is full
When a defined level is reached, such as 90 %, a system alarm is triggered. When the log 
is 100% full, new tag values are not logged. 

●  Log with level-dependent triggering of an event.
When the log is completely full, the "Overflow" event is triggered. Configure a function list 
for the event that will be carried out when the "Overflow" event occurs. When the configured 
size of the log is reached, new tag values are not logged.
The following system functions are available for further processing of full logs: For further 
details, refer to Auto-Hotspot.

Requirement
● A data log has been created.

● The "Data log" editor is open.

● The Inspector window with the log properties is open.

Procedure
1. Select the log for which you want to define the logging method in the "Data Log" editor.

2. Select "Properties > Properties > Logging method" in the Inspector window and select the 
required logging method.

3. If you have selected the "Segmented circular log" type, enter the number of log segments.
If you selected a log with the "Display system alarm on" setting, specify the level as a 
percentage at which a system alarm is to be triggered.
If you selected the "Trigger event" setting, configure the function list in the "Events" group.

Alternatively you can configure the logging method directly in the "Data log" editor table. To 
view hidden columns, activate the column titles using the shortcut menu.

The "Overflow" event is not available in the editor table. You must therefore configure the 
function list in the Inspector window.

Result
The selected log responds according to the settings in Runtime.

10.3.4 Using Alarms in Runtime

10.3.4.1 Alarms in Runtime

Alarms   
Alarms indicate events and states on the HMI device which have occurred in the system, in 
the process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 
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● Incoming

● Outgoing

● Acknowledge

● Loop-in-alarm

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time

● Alarm text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group

Alarm classes   
Alarms are assigned to various alarm classes.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on". Alarms 
in this class do not require acknowledgement.

● "Errors"
Alarms in this class must always be acknowledged. Error alarms normally indicate critical 
errors within the plant such as "Motor temperature too high".

● "System"
System alarms indicate states or events which occur on the HMI device. 
System alarms provide information on occurrences such as operator errors or 
communication faults. 

● Custom alarm classes
The properties of this alarm class must be defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.   

Alarm view
The alarm view shows selected alarms or alarm events from the alarm buffer. Whether alarm 
events have to be acknowledged or not is specified in your configuration.
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Alarm window
The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active.  

You can configure the order in which the alarms are displayed. You can choose to display the 
alarms in ascending or descending order of their occurrence. The alarm window can also be 
set to indicate the exact location of the fault, including the date and time of the alarm event. 
By means of configuration, the display can be filtered in such a way that only alarms that 
contain a specific character string will be shown.

Alarm indicator
The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the 
specified alarm class is activated.   

The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number indicates the number of queued alarms.

 

10.3.4.2 Alarms in Runtime

Alarms   
Alarms indicate events and states on the HMI device which have occurred in the system, in 
the process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time

● Alarm text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group
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Alarm classes   
Alarms are assigned to various alarm classes.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on". Alarms 
in this class do not require acknowledgement.

● "Errors"
Alarms in this class must always be acknowledged. Error alarms normally indicate critical 
errors within the plant such as "Motor temperature too high".

● "System"
System alarms indicate states or events which occur on the HMI device. 
System events provide information on occurrences such as operator errors or 
communication faults. 

● "Diagnosis Events"
SIMATIC diagnostic alarms show states and events in the SIMATIC S7 controller.

● STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.

● Custom alarm classes
The properties of this alarm class are defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.   

Alarm report 
When alarm logging is enabled in the project, alarms are output directly to the printer. 

You can set the logging function separately for each alarm. Printing of such an alarm is initiated 
when the "incoming" and "outgoing" alarm events are generated.

The output of alarms of the "System" alarm class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the content of the alarm buffer to the printer. To be 
able to initiate this print function, you need to configure a corresponding control object in the 
project.

Alarm log
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.   

Alarm view
The alarm view shows selected alarms or events from the alarm buffer or alarm log. Whether 
alarm events have to be acknowledged or not is specified in your configuration. By means of 
configuration, the display can be filtered in such a way that only alarms that contain a specific 
character string will be shown.

Visualizing processes (Comfort/Advanced)
10.3 Working with alarms

WinCC Comfort/Advanced V12.0 SP1
3324 System Manual, 07/2013,  



Alarm window
The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active. Depending 
on the configuration, it is not closed until the alarm is acknowledged. 

You can configure the order in which the alarms are displayed. At the first position, the current, 
or the oldest alarm will be displayed. The alarm window can also be set to indicate the exact 
location of the fault, including the date and time of the alarm event. By means of configuration, 
the display can be filtered in such a way that only alarms that contain a specific character string 
will be shown.

Alarm indicator
The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the 
specified alarm class is activated.   

The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number indicates the number of queued alarms.

 

10.3.4.3 Using the Alarm Window or Alarm View

Alarm window, alarm view in Runtime

Application             
Alarms are indicated in the alarm view or in the alarm window on the HMI device. The layout 
and operation of the alarm window correspond to that of the alarm view.

The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active. Depending 
on the configuration, it is not closed until the alarm is acknowledged.

Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed. If a filter is configured, only alarms that contain a 
specific string in the alarm text will be displayed.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     
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Symbol Alarm class
! "Errors"
Empty "Warnings"
depends on the configuration Custom alarm classes
$ "System"
S7 "Diagnosis Event"

Operation         
You use the alarm view as follows, depending on how it is configured:

● Change the order of the columns.

● Change the order in which the alarms are displayed.

● Acknowledging alarms

● Editing alarms

Control elements
The buttons have the following functions:         

Button Function
Displaying a tooltip for an alarm

Editing alarms

Acknowledge alarm

Operation behavior 

Linked alarm window for touch panels
When configuring the alarm window for keyboard units, enable the "Modal" property under 
"Properties > Mode". This ensures that the alarm window does not defocus during screen 
changes. Switching back and forth between the screen and different windows with <Ctrl+TAB> 
is not supported. If the linked alarm window has the focus, then the buttons in the screen behind 
it cannot be operated. The functions configured on a function key are carried out.

Changing the order of the displayed alarms
When you click on the column, first of all alarms requiring acknowledgement are sorted 
according to date and time. Then those alarms that do not require acknowledgement are sorted 
according to date and time.
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Using the Alarm Window, Alarm View

Introduction
As an alternative to using the mouse, you can operate the alarm view and the alarm window 
using the <TAB> key on your HMI device. This allows you to select the button and the most 
recently selected alarm in the alarm view. Depending on the configuration, you can also 
operate the alarm view via the function keys.

Operation using the mouse     
1. Select the alarm to be edited.

2. Click the button whose function you want to run.

Operation using the keyboard     
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Up> and <Down> keys accordingly.

3. Press the <Tab> key until the button whose function you wish to use is selected.

4. Press <Enter>.

Change the order of the columns
1. Select the column header, such as the "Date" column header.

2. While holding down the mouse button, drag the column header to the column header "Time".
The "Date" column is in front of the "Time" column.

Change the sorting
You can sort the list according to date or time.

1. Click on the corresponding column header.
The list is sorted in descending or ascending order according to this criterion.

2. Click the same column header again to reverse the sort order.

Acknowledge alarm  
1. Click on the alarm to be edited.

2. Click the button.
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Loop-In-Alarm trigger  
1. Click on the alarm to be edited.

2. Click the button.
The screen containing information about the alarm is displayed.

 

  Note

If you trigger a Loop-In-Alarm  during an unacknowledged alarm, it is acknowledged 
automatically.

 

Displaying configured tooltip  
1. Click on the alarm concerned.

2. Click the  button.
The tooltip configured for the alarm is displayed. 

10.3.4.4 Using the Simple Alarm Window, Alarm View

Basic alarm view, alarm window in Runtime

Application   
The simple alarm view shows selected alarms or alarm events from the alarm buffer. The layout 
and operation of the simple alarm window correspond to that of the simple alarm view.         

 

 Note

The "Single alarm view" object is not assigned dynamic functions by means of scripting. 

In the Engineering System, for example, dynamize the visibility of an object in the 
"Animations" tab of the Inspector window. In Runtime, the "Simple alarm view" does not 
support animations. If you configured an animation and, for example, run a consistency check 
on the project, an error alarm is displayed in the output window.
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Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Icon Alarm class
! "Errors"
empty "Warnings"
depends on the configuration Custom alarm classes
$ "System"

Operation
You use the alarm view as follows, depending on how it is configured:     

● Acknowledging alarms

● Editing alarms

Control elements
The buttons have the following functions:     

Button Function
Acknowledge alarm

Loop-In-Alarm
Changes to the screen that contains information about the error event

Visualizing processes (Comfort/Advanced)
10.3 Working with alarms

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3329



Button Function
Displaying a tooltip for an alarm

Displays the full text of the selected alarm in a separate window, namely the alarm text 
window
In the alarm text window, you can view alarm texts that exceed the space available in 
the Alarm view. Close the alarm text window with the  button.
Scrolls one alarm up.

Scrolls one page up in the alarm view.

Scrolls one page down in the alarm view.

Scrolls one alarm down.

Format of the control elements
The display of the buttons for using the simple alarm view depends on the configured size. 
You should therefore check on the HMI device whether all the required buttons are 
available.       

Basic alarm view, using the alarm window

Introduction
As an alternative to using the mouse, you can operate the simple alarm view using the <TAB> 
key on your HMI device. This allows you to select the button and the most recently selected 
alarm in the alarm view. Depending on the configuration, you can also operate the alarm view 
via the function keys.

Operation using the mouse  
1. Select the alarm to be edited.

2. Click the button whose function you want to run.

Operation using the keyboard  
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Up> and <Down> keys accordingly.

3. Press the <Tab> key until the button whose function you wish to use is selected.

4. Press <Enter>.

Acknowledge alarm 
1. Select the alarm to be acknowledged.

2. Click the button.
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Loop-In-Alarm trigger  
1. Select the alarm to be edited.

2. Click the button.
The screen containing information about the alarm is displayed.

Calling the infotext 
1. Select the alarm to be edited.

2. Click the button.

3. To close the window for displaying the operator note, press the  button or use the key 
combination <Alt+F4>.

10.3.4.5 Using the Alarm Indicator

Alarm indicator in Runtime

Application    
The alarm indicator is displayed if alarms of the specified alarm class are pending or require 
acknowledgment.

Layout   
The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number indicates the number of queued alarms.

Operation   
Depending on the configuration, when operating the alarm indicator an alarm window is 
opened. The icons from the symbol library can only be operated with a mouse or touch screen. 

 

 Note
Device dependency

Operation with mouse is not available for all HMI devices.
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Operating the alarm indicator using the mouse

Operation using the mouse  
1. Click on the alarm indicator with the mouse pointer. Depending on the configuration, the 

Alarm window is open.

2. Click  to close the alarm window. The Alarm window can be opened again by clicking 
on the alarm indicator.

10.3.4.6 Acknowledging alarms

Introduction
You can acknowledge alarms in Runtime according to your project configuration settings. You 
can acknowledge alarms as follows:

● Using the display and control object buttons

● Using the "ACK" key on your HMI device

● Using individually-configured function keys or buttons

If an operator authorization is configured for an individual control, the alarms can only be 
acknowledged by authorized users.

To automatically acknowledge alarms in Runtime, use the system functions and scripts, plus 
the "Acknowledgment by the PLC" option.

 

 Note
Device dependency

Scripts are not available for all HMI devices.
 

Acknowledgment variants
You acknowledge individual alarms or multiple alarms together in Runtime. They are 
distinguished as follows:

● Single acknowledgment
Acknowledgment of an alarm using a button or a function key. 

● Acknowledge alarm groups
Acknowledgment of all the alarms of an alarm group using a button or a function key.
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Requirement
● An alarm is displayed on the HMI device.

Procedure
To acknowledge an alarm, proceed as follows:

1. Select the alarm.

2. If you are using an alarm view or an alarm window, click the  button.

3. If you are using a simple alarm view or a simple alarm window, click the  button.

4. Press the "ACK" button on your HMI device to acknowledge an alarm in an alarm line.
 

  Note
Device dependency

The extended alarm view or alarm window and the alarm line are not available for all HMI 
devices.

 

Result
The alarm status changes to "Acknowledged". If the condition for triggering an alarm no longer 
applies, the alarm status also changes to "Outgoing", and it is no longer displayed on the HMI 
device. 

10.3.4.7 Filtering Alarms 

Introduction
The alarm view in Runtime does not contain a control element for entering filter criteria. To 
provide this functionality, configure an I/O field using the "Screens" editor. 

Requirements
● A filter has been configured for the alarm view.

● An I/O field for entering the criterion is displayed.

● Alarms are displayed in Runtime.

Enable filter
1. Enter the filter string in the I/O field.

2. Confirm your input.
The alarm view displays only those alarms that are contained in the specified character 
string. Thereby this distinguishes between upper and lower case letters. 
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Disable filter
1. Delete the string from the I/O field that is used to filter the alarm view.

2. Confirm your input.
All alarms are displayed in the alarm view once more.

10.3.5 Reference

10.3.5.1 System functions for alarms

System functions
System functions are predefined functions you can use to implement many tasks in runtime, 
even with no programming knowledge. You use system functions in a function list or in a 
script.   

 

 Note
Device dependency

Scripts are not available for all HMI devices.
 

The table shows all the system functions available for displaying and editing alarms.

System function Effect 
EditAlarm Triggers the Loop-In-Alarm event for all selected 

alarms.
ClearAlarmBuffer Deletes alarms from the alarm buffer on the HMI 

device.
ClearAlarmBufferProtoolLegacy Function such as "ClearAlarmBuffer". This system 

function has been retained to ensure compatibility 
and uses the old ProTool numbering. 

AlarmViewUpdate Updates the advanced alarm view.
AlarmViewEditAlarm Triggers the event Loop-In-Alarm for all alarms 

selected in the specified alarm view.
AlarmViewAcknowledgeAlarm Acknowledges the alarms that are selected in the 

specified alarm view.
AlarmViewShowOperatorNotes Displays the configured tooltip for the alarm 

selected in the specified alarm view.
AcknowledgeAlarm Acknowledges all selected alarms.
SetAlarmReportMode Switches the automatic reporting of alarms on the 

printer on or off.
ShowAlarmWindow Hides or shows the alarm window on the HMI 

device.
ShowSystemEvent Displays the value of the delivered parameter as 

a system event on the HMI device.
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 Note
Device dependency

The following system functions are not available for all HMI devices:
● SetAlarmReportMode
● AlarmViewUpdate
● ShowSystemEvent

 

10.3.5.2 Alarm events

Alarm events and their display and control objects
In Runtime, the following alarm events are triggered by their display and control objects. You 
can configure a function list for every event.  

Object Configurable events
Alarms Incoming

Outgoing
Acknowledge
Loop-In-Alarm

Alarm view Enabling
Disable
Selection changed

Alarm indicator Click
Click when flashing

 

 Note
Device dependency

The following events in the alarm view are not available for all HMI devices:
● Enabling
● Disable
● Selection changed
● Click
● Click when flashing
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10.3.5.3 System functions for logs

System functions
The following system functions are available for logging:

Function name Function method
ArchiveLogFile This function moves or copies a log to another storage location for long-

term archiving. Use the system function, for example, to move the audit 
trail from a local storage medium to the server.
When handling audit trails, always use the "Move log (hmiMove)" mode in 
order to avoid noncompliance with FDA guidelines as a result of redundant 
data storage. 

LogTag Saves the value of the given tags in the given data log. Use the system 
function to log a process values at a specific time.

StartLogging Starts the logging process in the specified log. You can interrupt logging 
in Runtime by calling the "StopLogging" system function.

StopLogging Stops the logging process in the specified log. To resume logging in 
Runtime, select the "StartLogging" system function.

ClearLog Deletes all entries in the specified log.
StartNextLog Stops the logging process in the specified log. Logging is continued in the 

sequential log that has been configured for the specified log file.
CloseAllLogs Closes all logs. The connection between WinCC and the log files or log 

database is terminated. You can use this system function, for example, to 
enable hot-swapping of the storage medium on the HMI device without 
exiting the Runtime software.

OpenAllLogs Opens all logs to resume logging. The connection between WinCC and 
the log files or log database is recovered.

CopyLog Copies the contents of the specified log to another log.

10.3.5.4 Structure of *.csv files that contain alarms

Introduction
You can save an alarm log as a file in "*.csv" format. CSV stands for Comma Separated Value. 
In this format, the table columns that contain the names and the value of the entry are separated 
by semicolons. Each table row terminates with a line break.   

Example of a log file in *.csv format
This example shows a file with logged alarms:   

"Time_ms";"MsgProc";"StateAfter";"MsgClass";"MsgNumber";"Var1";...;"Var8";"TimeString";"
MsgText";"PLC"37986550590,27;1;1;3;110001;"";...;"";"30.06.99 13:12:51";"Change to 
operating mode 'online'";37986550682,87;1;1;3;140010;"";...;"";"30.06.99 
13:12:59";"Connection established: PLC_1, Station 2, Rack 0, Position 2"; 
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Structure of a log file in *.csv format
The following values are entered in the log file columns:

Parameters Description
Time_ms Specify a time stamp as a decimal value ( see below for conversion)
Msg_Proc Alarm procedures: 

0 = Unknown alarm procedure
1 = System event
2 = Alarm bit procedure (operating alarms)
3 = Alarm number procedure ALARM_S
4 = Diagnostic event
7 = Analog alarm procedure
100 = Alarm bit procedure (fault alarms)

State after Alarm event: 
0 = Incoming/Outgoing
1 = Incoming
2 = Incoming/Acknowledged/Outgoing
3 = Incoming/Acknowledged
4 = All alarms in the PLC were deleted with SFC106 or after PLC STOP/RUN an 
alarm is pending
6 = Incoming/Outgoing/Acknowledged

Msg_Class Alarm class: 
0 = No alarm class
1 = "Errors"
2 = "Warnings"
3 = "System"
4 = "Diagnostic Events"
64 ... = user-configured alarm classes

Msg Number Alarm number
Var1 to Var8 Value of the trigger tag as a STRING
Time string Time stamp, as STRING in legible data format
Msg text Alarm in a readable STRING
PLC Alarm localization (relevant PLC)
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Conversion of the time stamp decimal value
To further process the time stamp value using a different program, proceed as follows:

1. Divide Time_ms by 1,000,000.
Example: 37986476928 : 1,000,000 = 37986.476928

2. The whole number portion (37986) is the date calculated from 12/31/1899.
In Excel you can now convert the time stamp into days. To do this, assign to the cell that 
contains the time stamp, a respective format form the "Date" group.
Result: 37986 results in 12/31/2003

3. The value after the point (0.476928) indicates the time:

– Multiply the value (0.476928) by 24 to obtain the hours (11.446272).

– Multiply the remainder (0.446272) by 60 results in the minutes (26.77632).

– Multiply the remainder (0.77632) by 60 results in the seconds (46.5792).

Result 11:26:46.579
This conversion is supported by Microsoft Excel, for example. 

10.3.5.5 System events

Basics on system events

System events
System events on the HMI device provide information about internal states of the HMI device 
and PLC.

The following overview illustrates when a system event occurs and how to eliminate the cause 
of error.

 

 Note
HMI device dependency

Some of the system events described in this section apply to the individual HMI devices based 
on their scope of functions.

 

 
 

 Note

System events are output in an alarm view. System events are output in the language 
currently set on your HMI device.
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System event parameters  
System events may contain encrypted parameters. The parameters are of relevance when 
troubleshooting because they provide a reference to the source code of the Runtime software. 
These parameters are output after the "Error code:" text.

10000 - Printer alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 

Table 10-2 10000 - Printer alarms

Number Effect/cause Remedy
10000 The print job could not be started or was canceled 

due to an unknown error. Faulty printer setup. Or: 
No authorization is available for accessing the 
network printer.
Power supply failure during data transfer.

Check the printer settings, cable connections and the 
power supply.
Set up the printer once again. Obtain a network printer 
authorization.
If the error persists, contact the Hotline!

10001 No printer is installed or a default printer has not 
been set up.

Install a printer and/or select it as the default printer.

10002 Overflow of the graphics buffer for printing. Up to two 
graphics are buffered.

Allow sufficient intervals between successive print jobs.

10003 Graphics can now be buffered again. --
10004 Overflow of the buffer for printing lines in text mode 

(e.g. alarms). Up to 1000 lines are buffered.
Allow sufficient intervals between successive print jobs.

10005 Text lines can now be buffered again. --
10006 The Windows printing system reports an error. Refer 

to the output text and the error ID to determine the 
possible causes. Nothing is printed or the print is 
faulty.

Repeat the action if necessary. 

20000 - Global script alarms

Meaning of the system events  
All system events that can be displayed are listed below. The system events are divided into 
different ranges.
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Table 10-3 20000 - Global script alarms

Number Effect/causes Remedy
20010 An error has occurred in the specified script line. 

Execution of the script was therefore aborted. Note 
the system event that may have occurred prior to 
this.

Select the specified script line in the configuration. 
Ensure that the tags used are of the allowed types. For 
system functions, verify the correct number of 
parameters and the parameter types.

20011 An error has occurred in a script that was called by 
the specified script. 
Execution of the script was therefore aborted in the 
called script. 
Note the system event that may have occurred prior 
to this. 

In the configuration, select the script that has been 
called directly or indirectly by the specified script. 
Ensure that the tags used are of the allowed types. 
For system functions, verify the correct number of 
parameters and the parameter types.

20012 Inconsistent configuration data. The script could 
therefore not be generated.

Recompile the configuration data.

20013 Incorrect installation of the scripting component of 
WinCC Runtime. Therefore, no scripts can be 
executed.

Reinstall WinCC Runtime on your PC.
Recompile your project using the "Compile > Software 
(compile all)" command from the context-sensitive 
menu and then download the project to the HMI device.

20014 The system function returns a value that is not 
written in any return tag.

Select the specified script in the configuration.
Check whether the script name has been assigned a 
value.

20015 Too many successive scripts have been triggered in 
short intervals. When more than 20 scripts are 
queued for processing, any subsequent scripts are 
rejected. In this case, the script indicated in the 
alarm is not executed.

Check what is triggering the scripts. Extend the times, 
e.g. the acquisition cycle of the tag initiating the script.

30000 - Alarms errors when using system functions

Meaning of the system events
All system events that can be displayed are listed below. The system events are divided into 
different ranges.

Table 10-4 30000 - Alarms errors when using system functions

Number Effect/causes Remedy
30010 The tag could not accept the function result, e.g. 

when it has exceeded the value range.
Check the tag types of the system function parameters.

30011 A system function could not be executed because 
the function was assigned an invalid value or type in 
the parameter.

Check the parameter value and tag type of the invalid 
parameter. If a tag is used as a parameter, check its 
value.

30012 A system function could not be executed because 
the function was assigned an invalid value or type in 
the parameter.

Check the parameter value and tag type of the invalid 
parameter. If a tag is used as a parameter, check its 
value.
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40000 - Linear scaling alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. The system alarms are divided into 
different ranges:

Table 10-5 40000 - Linear scaling alarms

Number Effect/causes Remedy
40010 The system function could not be executed since the 

parameters could not be converted to a common tag 
type.

Check the parameter types in the configuration.

40011 The system function could not be executed since the 
parameters could not be converted to a common tag 
type.

Check the parameter types in the configuration.

50000 - Data server alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. The system alarms are divided into 
different ranges:

Table 10-6 50000 - Data server alarms

Number Effect/causes Remedy
50000 The HMI device is receiving data faster than it is 

capable of processing. Therefore, no further data is 
accepted until all current data have been processed. 
Data exchange then resumes.

--

50001 Data exchange has been resumed. --

60000 - Win32 function alarms

Meaning of the system events 
All system events that can be displayed are listed below. 
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Table 10-7 60000 - Win32 function alarms

Number Effect/causes Remedy
60000 This alarm is generated by the "ShowSystemEvent" 

system function. The text to be displayed is 
transferred to the function as a parameter.

--

60010 The file could not be copied in the direction defined 
because one of the two files is currently open or the 
source/target path is not available.
It is possible that the Windows user has no access 
rights to one of the two files.

Restart the system function or check the paths of the 
source/target files. In Windows NT/XP: Users executing 
WinCC Runtime must be granted access to the files.

60011 An attempt was made to copy a file to itself.
It is possible that the Windows user has no access 
rights to one of the two files.

Check the path of the source/target file.
In Windows NT//XP and NTFS file system: Users 
executing WinCC Runtime  must be granted access to 
the files.

70000 - Win32 function alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-8 70000 - Win32 function alarms

Number Effect/causes Remedy
70010 The application could not be started because it could 

not be found in the path specified or there is 
insufficient memory space.

Check whether the application exists in the specified 
path or close other applications.

70011 The system time could not be modified.
The error alarm only appears in connection with area 
pointer "Date/time PLC". Possible causes:
● An invalid time was transferred in the job mailbox.
● The Windows user has no right to modify the 

system time.
If the first parameter in the system event is displayed 
with the value 13, the second parameter indicates 
the byte containing the incorrect value.

Check the time which is to be set.
Using Windows NT/XP: Users running WinCC Runtime 
must be granted the right to set the system time of the 
operating system.

70012 Error when executing the function "StopRuntime" 
with the "Runtime and operating system" option.
Windows and WinCC Runtime are not closed. 
The error was possibly generated because other 
programs cannot be closed. 

Close all programs currently running.
Then close Windows.

70013 The system time could not be modified because an 
invalid value was entered. Incorrect separators may 
have been used.

Check the time which is to be set.
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Number Effect/causes Remedy
70014 The system time could not be modified. Possible 

causes:
● An invalid time was transferred.
● The Windows user has no right to modify the 

system time.
Windows rejects the setting request.

Check the time which is to be set.
Using Windows NT/XP: Users running WinCC Runtime 
must be granted the right to set the system time of the 
operating system.

70015 The system time could not be read because 
Windows rejects the reading function.

--

70016 An attempt was made to select a screen by means 
of a system function or job. This is not possible 
because the screen number specified does not exist.
Or: A screen could not be generated due to 
insufficient system memory.
Or: The screen is blocked.
Or: Screen call has not been executed correctly.

Check the screen number in the function or job with the 
screen numbers configured.
Assign the number to a screen if necessary.
Check the details for the screen call and whether the 
screen is blocked for specific users.

70017 Date/time is not read from the area pointer because 
the address set in the PLC is either not available or 
has not been set up.

Change the address or set up the address in the PLC.

70018 Acknowledgment that the password list has been 
successfully imported.

--

70019 Acknowledgment that the password list has been 
successfully exported.

--

70020 Acknowledgment for activation of alarm reporting. --
70021 Acknowledgment for deactivation of alarm reporting. --
70022 Acknowledgment to starting the Import Password 

List action.
--

70023 Acknowledgment to starting the Export Password 
List action.

--

70024 The range of values of the tag was exceeded in the 
system function.
No calculation of the system function.

Check and correct the calculation.

70025 The range of values of the tag was exceeded in the 
system function.
No calculation of the system function.

Check and correct the calculation.

70026 No other screens are stored in the internal screen 
memory.
No other screens can be selected.

--

70027 The backup of the RAM file system has been started. --
70028 The files from the RAM have been copied in the 

Flash memory.
The files from the RAM have been copied in the 
Flash memory. Following a restart, these saved files 
are copied back to the RAM file system.

--

70029 Backup of the RAM file system has failed.
No backup copy of the RAM file system has been 
made.

Check the settings in the "Control Panel > OP" dialog 
and save the RAM file system using the "Save Files" 
button in the "Persistent Storage" tab.

70030 The parameters configured for the system function 
are faulty.
The connection to the new PLC was not established.

Compare the parameters configured for the system 
function with the parameters configured for the PLCs 
and correct them as necessary.
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Number Effect/causes Remedy
70031 The PLC configured in the system function is not an 

S7 PLC.
The connection to the new PLC was not established.

Compare the S7 PLC name parameter configured for 
the system function with the parameters configured for 
the PLC and correct them as necessary.

70032 The object configured with this number in the tab 
sequence is not available in the selected screen.
The screen changes but the focus is set to the first 
object.

Check the number of the tab sequence and correct it if 
necessary.

70033 An e-mail cannot be sent because a TCP/IP 
connection to the SMTP server no longer exists.
This system event is generated only at the first 
attempt. All subsequent unsuccessful attempts to 
send an e-mail will no longer generate a system 
event. The event is regenerated when an e-mail has 
been successfully sent in the meantime.
The central e-mail component in WinCC Runtime 
attempts to connect to the SMTP server at cyclic 
intervals (1 minute) in order to transmit the remaining 
e-mails.

Check the network connection to the SMTP server and 
re-establish it if necessary.

70034 Following a disruption, the TCP/IP connection to the 
SMTP server could be re-established.
The queued e-mails are then sent.

--

70036 No SMTP server for sending e-mails is configured. 
An attempt to connect to an SMTP server has failed 
and it is not possible to send e-mails.
WinCC Runtime generates the system event after 
the first attempt was made to send an e-mail.

Configure an SMTP server:
In the WinCC Engineering System
using "Device settings > Device settings"
In the Windows CE operating system
using "Control Panel > Internet Settings > E-mail > 
SMTP Server"

70037 An e-mail cannot be sent for unknown reasons.
The contents of the e-mail are lost.

Check the e-mail parameters (recipient etc.).

70038 The SMTP server has rejected sending or 
forwarding an e-mail because the domain of the 
recipient is unknown to the server or because the 
SMTP server requires authentication.
The contents of the e-mail are lost.

Check the domain of the recipient address or disable 
the authentication on the SMTP server if possible. 
SMTP authentication is currently not used in 
WinCC Runtime.

70039 The syntax of the e-mail address is incorrect or 
contains illegal characters.
The contents of the e-mail are discarded.

Check the e-mail address of the recipient.

70040 The syntax of the e-mail address is incorrect or 
contains illegal characters.

--

70041 The import of the user management was aborted 
due to an error.
Nothing was imported.

Check your user administration or download it again to 
the panel.

70042 The range of values of the tag was exceeded while 
executing the system function.
The system function was not calculated.

Check and correct the calculation.

70043 The range of values of the tag was exceeded while 
executing the system function.
The system function was not calculated.

Check and correct the calculation.

70044 An error occurred while sending the e-mails. The e-
mails were not sent. 

Check the SMTP settings and the error message in the 
system event.
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70045 Cannot load a file required for encrypting the e-mail. Update the operating system and Runtime.
70046 The server does not support encryption. Select an SMTP server that supports encryption.
70047 The SSL versions of the HMI device and SMTP 

server may not be compatible.
Contact your network administrator or the operator of 
the SMTP server.

80000 - Log alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-9 80000 - Log alarms

Number Effect/causes Remedy
80001 The log specified is filled to the size defined (in 

percent) and must be stored elsewhere.
You swap out the file or table by executing a ‘move’ or 
‘copy’ function.

80002 A line is missing in the specified log. --
80003 The copying process for logging was not successful.

In this case, it is advisable to check any subsequent 
system events, too.

--

80006 Since logging is not possible, this causes a 
permanent loss of the functionality.

In the case of databases, check whether the 
corresponding data source exists and start up the 
system again.

80009 A copying action has been completed successfully. --
80010 An incorrect storage location was entered in WinCC 

and causes permanent loss of functionality.
Configure the storage location for the respective log 
again and restart the system when the full functionality 
is required.

80012 Log entries are stored in a buffer. If the values are 
read to the buffer faster than they can be physically 
written (using a hard disk, for example), overloading 
may occur and recording is then stopped.

Archive fewer values.
Or:
Increase the logging cycle.

80013 The overload status no longer exists. Archiving 
resumes the recording of all values.

--

80014 The same action was triggered twice in quick 
succession. Since the process is already in 
operation, the action is only carried out once.

--

80015 This system event is used to report DOS or database 
errors to the user.

--

80016 The logs are separated by system function 
"CloseAllLogs" and the incoming entries exceed the 
defined buffer size.
All buffer entries are deleted.

Reconnect the logs.

80017 The number of incoming entries cause a buffer 
overflow. This can be caused, for example, by 
several copying actions being activated at the same 
time.
All copy jobs in the buffer are deleted.

Stop the copy action. 
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80019 The connection between WinCC and all log files was 

shut down, for example, after execution of the 
"CloseAllLogs" system function.
Entries are written to the buffer and written to the 
logs when the connection is recovered. 
There is no connection to the storage location and 
the storage medium can be changed.

--

80020 The maximum number of simultaneously copy 
operations has been exceeded. Copying is not 
executed.

Wait until the current copying actions have been 
completed, then restart the last copy action.

80021 An attempt was made to delete a log which is still 
busy with a copy action. Deletion has not been 
executed.

Wait until the current copying actions have been 
completed, then restart the last action.

80022 An attempt was made to use system function 
"StartSequenceLog" to start a sequence log for a log 
which is not configured as sequence log. No 
sequence log file is created.

In the project, check
● whether the "StartSequenceLog" system function 

was properly configured.
● if the tag parameters are properly provided with data 

on the HMI device.
80023 An attempt was made to copy a log to itself.

The log is not copied.
In the project, check
● whether the "CopyLog" system function was 

properly configured.
● if the tag parameters are properly provided with data 

on the HMI device.
80024 In your configuration, you specified that the 

"CopyLog" system function should not allow copying 
if the destination log already contains data ("Mode" 
parameter). The log is not copied.

Edit the "CopyLog" system function in your 
configuration, if necessary. Before you initiate the 
system function, delete the destination log file.

80025 You have canceled the copy operation.
Data written up to this point are retained. The target 
log file (if configured) was not deleted.
The cancellation is reported by an error entry 
$RT_ERR$  at the end of the target log.

--

80026 This alarm is output after all logs are initialized. 
Values are written to the logs from then on. No 
entries are written to the logs before this time has 
expired, irrespective of the active state of 
WinCC Runtime.

--

80027 The internal Flash memory has been specified as 
the storage location for a log. This is not permissible.
No values are written to this log and the log file is 
not created.

Configure "Storage Card" or network path as the 
storage location.

80028 The alarm serves as status report indicating that the 
logs are currently being initialized. No values are 
logged until the alarm 80026 is output.

--

80029 The number of logs specified in the alarm could not 
be initialized. Initialization of logs was finished.
 The faulty log files are not available for logging jobs.

Evaluate the additional system events related to this 
alarm. Check the configuration, the ODBC (Open 
Database Connectivity), and the specified drive.

80030 The structure of the existing log file does not match 
the expected structure.
Logging is stopped for this log.

Delete the existing log data manually, in advance.
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80031 The log in CSV format is corrupted.

The log cannot be used.
Delete the faulty file.

80032 Logs can be configured with events. These are 
triggered as soon as the log is full. Assuming 
WinCC Runtime is started and the log is already full, 
the event would never be triggered.
The specified log is full and no longer accepts data.

Close WinCC Runtime, delete the log, and restart 
WinCC Runtime.
Or:
Configure a button which contains the same actions as 
the event and press it.

80033 "System Defined" is set in the data log file as the 
data source name. This causes an error. No data is 
written to the database logs, whereas the logging to 
the CSV logs works.

Reinstall SQL Sever 2005 Express.

80034 An error has occurred in the initialization of the logs. 
An attempt has been made to create the tables as a 
backup. This action was successful. A backup copy 
of the tables of the corrupted log file was generated 
and the cleared log restarted.

No action is necessary. However, it is recommended to 
save the backup files or delete them in order to make 
the space available again.

80035 An error has occurred in the initialization of the logs. 
An attempt has been made to create backups of the 
tables and this has failed. No logging or backup has 
been performed.

It is recommended to save the backups or to delete them 
in order to release memory.

80044 The export of a log was interrupted because 
Runtime was closed or due to a power failure. At the 
restart of Runtime, it was detected that the export 
must be resumed.

The export resumes automatically.

80045 The export of a log was interrupted due to an error 
in the connection to the server or at the server itself.

The export is repeated automatically. Check:
● The connection to the server.
● If the server is running.
● If there is enough free space on the server.

80046 The destination file or the associated directory could 
not be created on the server.

Check whether there is enough space on the server and 
it you have permission to create the log file.

80047 The log could not be read while exporting it. Check whether the storage medium is correctly inserted.
80049 The log could not be renamed while preparing to 

export it. 
The job can not be completed."

Check whether the storage medium is correctly inserted 
and if there is sufficient space on the medium.

80050 The log which shall be exported is not closed.
 The job can not be completed.

Make sure to call the "CloseAllLogs" system function 
before using the "ExportLog" system function. Change 
the configuration as required.

80051 The log to be copied contains an invalid checksum.
The log was not copied.

Select a log with a valid checksum. The selected log 
may have been manipulated.

80052 The log cannot be read. Check the log and the specified path.
80053 The closed log cannot be read. Open the log.

90000 - FDA alarms

Meaning of the system events   
All system events that can be displayed are listed below. 
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Table 10-10 90000 - FDA alarms

Number Effect/causes Remedy
90024 No operator actions can be logged due to lack of 

space on the storage medium for log. The operator 
action will therefore not be executed.

Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90025 No user actions can be logged because of error 
state of the archive. Therefore the user action will 
not be executed.

Check whether the storage medium is correctly inserted.

90026 No operator actions can be logged because the log 
is closed. The operator action will therefore not be 
executed.

Before further operator actions are carried out, the log 
must be reopened with the help of system function 
"OpenAllLogs". Change the configuration as required.

90028 The password you entered is incorrect. Enter the correct password.
90029 Runtime was closed during ongoing operation 

(perhaps due to a power failure) or a storage 
medium in use is incompatible with Audit Trail. An 
Audit Trail is not suitable if it belongs to another 
project or has already been logged.
It could also be that archiving was not stopped 
before automatic execution of the 
"CloseAllArchives" function was started (e.g. by the 
task scheduler). 

Ensure that you are using the correct storage medium.

90030 Runtime was closed during ongoing operation 
(perhaps due to a power failure).

--

90031 Runtime was closed during ongoing operation 
(perhaps due to a power failure).

--

90032 Running out of space on the storage medium for log. Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90033 No more space on the storage medium for log. As 
of now, no more operator actions requiring logging 
will be executed.

Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90039 You do not have the necessary authorization to 
perform this action. 

Adapt or upgrade your authorizations.

90040 Audit Trail is switched off because of a forced user 
action.

Reactivate the "Audit Trail" with the help of system 
function "StartLog".

90041 A user action which has to be logged has been 
executed without a logged on user.

A user action requiring logging should only be possible 
with permission. Change the configuration by setting a 
required authorization for the input object.

90044 A user action which has to be confirmed was 
blocked, because there is another user action 
pending.

Repeat the user action if necessary.

90048 The Audit Trail  cannot be printed while data 
relevant to the audit is being logged.

Stop logging by calling system function "StopLogging".

90049 Access to required file is not possible. Check the network connection or the storage medium.
90056 The recipe was not imported because the file 

contains no checksum.
Select a file with a checksum.
You can also disable checksum verification by calling 
system function "ImportDataRecords".

90057 The recipe was not imported because the file 
contains an invalid checksum. The selected file may 
have been manipulated.

Select a file with a valid checksum.
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110000 - Offline function alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-11 110000 - Offline function alarms

Number Effect/causes Remedy
110000 The operating mode was changed. "Offline" mode 

is now set.
--

110001 The operating mode was changed. "Online" mode 
is now set.

--

110002 The operating mode was not changed. Check the connection to the PLCs.
Check whether the address range for the “Coordination" 
area pointer is present in the PLC.

110003 The operating mode of the specified PLC was 
changed by the "SetConnectionMode" system 
function.
 The "offline" operating mode is now set.

--

110004 The operating mode of the specified PLC was 
changed by the "SetConnectionMode" system 
function.
 The "online" operating mode is now set.

--

110005 An attempt was made to use the 
"SetConnectionMode" system function to set the 
specified PLC to "online" mode, although the entire 
system is in "offline" mode. This changeover is not 
allowed. The PLC remains in "offline" mode.

Switch the complete system to "online" mode and repeat 
execution of the system function.

110006 The content of the "project ID" area pointer does not 
match the project ID configured in WinCC. The 
WinCC Runtime is therefore terminated.

Check:
● the project ID entered on the PLC.
● the project ID entered in WinCC.

120000 - Trend alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 

Table 10-12 120000 - Trend alarms

Number Effect/causes Remedy
120000 The trend is not displayed because you configured 

an incorrect axis to the trend or an incorrect trend.
Change the configuration.

120001 The trend is not displayed because you configured 
an incorrect axis to the trend or an incorrect trend.

Change the configuration.

120002 The trend is not displayed because the tag assigned 
attempts to access an invalid PLC address.

Check whether the data area for the tag exists in the 
PLC, the configured address is correct and the value 
range for the tag is correct.
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130000 - System information alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-13 130000 - System information alarms

Number Effect/causes Remedy
130000 The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.
130001 The action was not executed. Delete files no longer required from the hard disk.
130002 The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.
130003 No data medium found. The operation is canceled. Check the following conditions, for example:

● Access to the correct data carrier?
● Is a data carrier inserted?

130004 The data carrier is write-protected. The operation is 
canceled.

Check whether the correct data medium is being 
accessed. Remove the write-protection if necessary.

130005 The file is read only. The operation is canceled. Check whether the correct file is being accessed. 
Change the file attributes.

130006 No access to the file. The operation is canceled. Check the following conditions, for example:
● Is the correct file being accessed?
● Does the file exist?
● Is another action preventing concurrent access to the 

file?
130007 The network connection is interrupted.

Records cannot be saved or read via the network 
connection.

Check the network connection and eliminate the cause 
of error.

130008 No storage card available.
The specified records cannot be saved to or read 
from Storage Card.

Insert the storage card.

130009 The specified folder does not exist on the storage 
card.
The files stored in this directory are not backed up 
after switching off the HMI device.

Insert the storage card.

130010 The maximum nesting depth can be exhausted 
when, for example, value changes in a script initiate 
the call of an infinite number of further scripts.  
The configured functionality is not provided.

Check the configuration.

130013 No storage card available.
The specified records cannot be saved to or read 
from Storage Card.

Insert the storage card.
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140000 - Connection alarms: Connection + device

Meaning of the system events   
All system events that can be displayed are listed below. 

Table 10-14 140000 - Connection alarms: Connection + device

Number Effect/causes Remedy
140000 An online connection to the PLC is established. --
140001 The online connection to the PLC was shut down. --
140003 No tag update or write operations are executed. Check whether the connection is up and the PLC is 

switched on.
In the Control Panel, check the set parameters using the 
"Set PG/PC interface" function.
Restart the system.

140004 No tag update or write operations are executed due 
to an incorrect access point, or incorrect module 
configuration.

Check the connection and whether the PLC is switched 
on.
Check the access point or the module configuration 
(MPI, PPI, PROFIBUS) in the Control Panel with "Set 
PG/PC interface".
Restart the system.

140005 No tag update or write operations are executed due 
to an incorrect HMI device address (possibly too 
high).

Use a different address for the HMI device.
Check the connection and whether the PLC is switched 
on.
Check the parameters set in the "Set PG/PC interface" 
dialog of the Control Panel.
Restart the system.

140006 No tag update or write operations are executed due 
to an incorrect baud rate setting.

Select a different baud rate in WinCC (according to 
module, profile, communication peer, etc.).

140007 An incorrect bus profile prevents tag updates or 
write operations (see %1).
The following parameters could not be written to the 
registry database:
1:  Tslot
2:  Tqui
3:  Tset
4:  MinTsdr
5:  MaxTsdr
6:  Trdy
7:  Tid1
8:  Tid2
9:  Gap Factor
10: Retry Limit

Check the custom bus profile.
Check the connection and whether the PLC is switched 
on.
Check the parameters set in the "Set PG/PC interface" 
dialog of the Control Panel.
Restart the system.
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140008 An incorrect baud rate prevents tag updates or write 

operations. The following parameters could not be 
written to the registry database: 
0:  General error
1:  Wrong version
2:  Profile cannot be written to the registry database.
3:  The subnet type cannot be written to the registry 
database.
4:  The Target Rotation Time cannot be written to 
the registry database.
5:  Incorrect Highest Station Address (HSA).

Check whether the connection is up and the PLC is 
switched on.
In the Control Panel, check the set parameters using the 
"Set PG/PC interface" function.
Restart the system.

140009 No tag updates or write operations because the S7 
communication module was not found.

To reinstall the module, open the Control Panel and 
select "Set PG/PC interface".

140010 No S7 communication partner found because the 
PLC is shut down.
DP/T:
The option "PG/PC is the only master" is not set in 
the Control Panel under "Set PG/PC interface".

Switch on the PLC.
DP/T:
If only one master is connected to the network, disable 
"PG/PC is the only master" in "Set PG/PC interface".
If several masters are connected to the network, enable 
these. Do not change any settings, for this will cause bus 
errors.

140011 No tag updates or write operations because 
communication is down.

Check the connection and whether the communication 
partner is switched on.

140012 Initialization error (e.g. if WinCC Runtime was 
closed in Task Manager).
Or:
Another application (e.g. STEP 7) with different bus 
parameters is active and the driver cannot be 
started with the new bus parameters (baud rate, for 
example).

Restart the HMI device.
Or:
Start WinCC Runtime and then start your other 
applications.

140013 The MPI cable is disconnected and, therefore, there 
is no power supply.

Check the connections.

140014 The configured bus address is in use by another 
application.

Change the HMI device address in the PLC 
configuration.

140015 Incorrect baud rate
Or: 
Incorrect bus parameters (e.g. HSA)
Or:
OP address > HSA or: Incorrect interrupt vector 
(interrupt not registered by the driver)

Correct the parameters.

140016 The hardware does not support the configured 
interrupt.

Change the interrupt number.

140017 The set interrupt is in use by another driver. Change the interrupt number.
140018 SIMOTION Scout disabled the consistency check. 

Only a corresponding note appears.
In SIMOTION Scout, reactivate the consistency check 
and once again download the project to the PLC.

140019 SIMOTION Scout is downloading a new project to 
the PLC. Connection to the PLC is canceled.

Wait until the end of the reconfiguration.

140020 Mismatch of the PLC and project (FWX file) 
versions.
The connection to the PLC is canceled.

The following remedies are available:
Download the current version to the PLC using 
SIMOTION Scout.
Recompile the project using WinCC ES, close 
WinCC Runtime, and restart with the new configuration.
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140021 Setup of the connection to the PLC failed. Incorrect 

configuration of the "Access password" for the 
connection to the PLC.

Select the "Access password" area in the "Connections" 
editor to check the password entered for the connection 
to the PLC.
Assign the correct password.
The "Password" for the connection to the PLC is 
assigned in the "Security" area of the PLC properties.

140022 Setup of the connection to the PLC failed. 
Incorrect configuration of the access password for 
the connection to the PLC.

Select the "Access password" area in the "Connections" 
editor to check the password entered for the connection 
to the PLC. 
The "Password" for the connection to the PLC is 
assigned in the "Security" area of the PLC properties.

140025 Setup of the connection to the PLC failed. 
The access password of the PLC is disabled in the 
PLC display.

Enable the access password in the PLC display.

160000 - Connection alarms: OPC: Connection

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-15 160000 - Connection alarms: OPC: Connection

Number Effect/causes Remedy
160000 No more data is read or written. Possible causes:

● The cable connection is interrupted.
● The PLC does not respond or has failed, etc.
● The wrong port is used for the connection.
● System overload

Check whether the cable is plugged in and the PLC is 
OK, and whether the correct port is used.
Restart the system if the system event persists.

160001 The connection is recovered because the cause of 
the interruption has been eliminated.

--

160010 No connection to the server because the server ID 
(CLS-ID) cannot be determined.
Values cannot be read or written.

Check access rights.

160011 No connection to the server because the server ID 
(CLS-ID) cannot be determined.
Values cannot be read or written.

Check the following conditions, for example:
● Correct server name?
● Correct station name?
● Is the server registered?

160012 No connection to the server because the server ID 
(CLS-ID) cannot be determined.
Values cannot be read or written.

Check the following conditions, for example:
● Correct server name?
● Correct station name?
● Is the server registered?
Note for advanced users:
Interpret the value from HRESULT. 
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160013 The specified server was started as InProc server. 

This has not been released and may lead to 
undefined behavior because the server is running 
in the same process area as WinCC Runtime.

Configure the server as OutProc Server or Local Server.

160014 Only one OPC server project can be started on a 
PC/MP. An alarm is output after an attempt was 
made to start a second project.
The second project has no OPC server functionality 
and cannot be located as an OPC server by external 
sources.

Do not start a second project with OPC server 
functionality on the computer.

170000 - S7 dialog alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 

Table 10-16 170000 - S7 dialog alarms

Number Effect/causes Remedy
170000 S7 diagnostics events are not indicated because it 

is not possible to log on to the S7 diagnostics 
functions at this device. The service is not 
supported.

--

170001 The S7 diagnostics buffer cannot be viewed 
because communication with the PLC is shut down.

Set the PLC to online mode.

170002 The S7 diagnostics buffer cannot be viewed 
because reading of the diagnostics buffer (SSL) 
was canceled with error.

--

170003 An S7 diagnostics event cannot be visualized. The 
system returns internal error %2.

--

170004 An S7 diagnostics event cannot be visualized. The 
system returns an internal error of error class %2, 
error number %3.

--

170007 It is not possible to read the S7 diagnostics buffer 
(SSL) because this operation was canceled with an 
internal error of class %2 and error code %3.

--

180000 - General alarms

Meaning of the system events  
All system events that can be displayed are listed below. 
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Table 10-17 180000 - General alarms

Number Effect/causes Remedy
180000 A component/OCX received configuration data with 

a version ID which is not supported.
Install a newer component.

180001 System overload because too many actions are 
running in parallel. Certain actions can be executed, 
while others are discarded.

Several remedies are available:
● Generate alarms at a slower rate (polling).
● Initiate scripts and functions at greater intervals.
If the alarm appears more frequently:
Restart the HMI device. 

180002 The screen keyboard could not be activated. 
Possible causes:
"TouchInputPC.exe" was not registered due to 
faulty Setup.

Reinstall WinCC Runtime.

190000 - Tag alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-18 190000 - Tag alarms

Number Effect/causes Remedy
190000 It is possible that the tag is not updated. --
190001 The tag is updated after the cause of the last error 

state has been eliminated (recovery of normal 
operation).

--

190002 The tag is not updated because communication with 
the PLC is down.

Select system function "SetOnline" to enable 
communication.

190004 The tag is not updated because the address 
configured for this tag does not exist.

Check the configuration.

190005 The tag is not updated because the configured PLC 
type does not exist for this tag.

Check the configuration.

190006 The tag is not updated because it is not possible to 
map the PLC type in the data type of the tag.

Check the configuration.

190007 The tag value is not modified because the 
connection to the PLC is interrupted or the tag is 
offline.

Set online mode or reconnect to the PLC.

190008 The configured tag limits were violated due to one 
of the following events:
● Value input
● System function
● Script

Observe the configured or current tag limits.

190009 An attempt was made to assign this tag a value that 
is outside the valid range of values for this data type.
For example, input of the value 260 for a byte tag, 
or input of the value -3 for an unsigned word tag.

Observe the range of values for the data type of the tags.
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190010 The rate at which values are written to the tag is too 

high (e.g. initiated in a script loop).
Values will be lost because buffer capacity is limited 
to 100 operations.

The following remedies are available:
● Extend the interval between multiple write actions.
● Do not use an array tag longer than 6 words when 

configuring an acknowledgment on the HMI device 
using "HMI acknowledgment tag".

190011 Possible cause 1:
The value entered could not be written to the 
configured PLC tag because the high or low limit 
was exceeded.
The system discarded the entry and restored the 
original value.
Possible cause 2:
The connection to the PLC was interrupted.

 
Note that the value entered must be within the range of 
values of the control tag.
 
 
 
 
Check the connection to the PLC.

190012 It is not possible to convert a value from a source 
format to a target format, for example:
An attempt is being made to write a counter value 
that is outside the valid, PLC-specific range of 
values.
A tag of the type Integer should be assigned a value 
of the type string.

Check the range of values, or the data type of the tag.

190013 You entered a string that exceeds the tag length. 
The string is truncated automatically to a valid 
length.

Always enter strings that do not exceed the valid tag 
length.
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190100 - Area pointer alarms

190100 - Area pointer alarms 

Number Effect/causes Remedy
190100 The area pointer is not updated because the 

address configured for this pointer does not exist.
Type
1  Warnings
2  Errors
3  PLC acknowledgment
4  HMI device acknowledgment
5  LED image
6  Trend request
7  Trend transfer 1
8  Trend transfer 2
No.:
Consecutive number displayed in WinCC ES.

Check the configuration.

190101 The area pointer is not updated because it is not 
possible to map the PLC type to the area pointer 
type.
Parameter type and no.:
see alarm 190100

--

190102 The area pointer is updated after the cause of the 
last error state has been eliminated (recovery of 
normal operation). Parameter type and no.: See 
alarm 190100.

--

200000 - PLC coordination alarms

200000 - PLC coordination alarms

Number Effect/causes Remedy
200000 Coordination is not executed because the address 

configured in the PLC does not exist/is not set.
Change the address or set up the address in the PLC.

200001 Coordination is canceled because the write access 
to the address configured in the PLC is not possible.

Change the address or set the address in the PLC at an 
area which allows write access.

200002 Coordination is not carried out at the moment 
because the address format of the area pointer 
does not match the internal storage format.

Internal error

200003 Coordination can be executed again because the 
last error state is eliminated (return to normal 
operation).

--

200004 The coordination may not be executed. --
200005 No more data is read or written. Possible causes:

● The cable is defective.
● The PLC does not respond, is defective, etc.
● System overload

Ensure that the cable is plugged in and the PLC is 
operational.
Restart the system if the system alarm persists.
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210000 - PLC job alarms

210000 - PLC job alarms

Number Effect/causes Remedy
210000 Jobs are not processed because the configured 

address does not exist/has not been set up in 
the PLC.

Change the address or set up the address in the PLC.

210001 Jobs are not processed because read/write 
access to the configured address is not possible 
in the PLC.

Change the address, or set up the address in a PLC 
area at which read/write access is possible.

210002 Jobs are not executed because the address 
format of the area pointer does not match the 
internal storage format.

Internal error

210003 The job buffer is processed again because the 
last error status has been eliminated (recovery 
of normal operation).

--

210004 The job buffer is possibly not going to be 
processed.

--

210005 A job mailbox with invalid number was initiated. Check the PLC program.
210006 An error occurred while executing the job 

mailbox. As a result, the control job is not 
executed. Observe the next/previous system 
event.

Check the parameters of the control job. Recompile 
the configuration data.

220000 - WinCC communication driver alarms

220000 - WinCC communication driver alarms 

Number Effect/causes Remedy
220001 The tag is not downloaded because write access 

to data type Bool/Bit  is not supported by the 
sublevel communication driver/HMI device.

Change the configuration.

220002 The tag is not downloaded because write access 
to data type Byte  is not supported by the 
sublevel communication driver/HMI device.

Change the configuration.

220003 The communication driver cannot be loaded as 
it is possibly not installed.

Install the driver by reinstalling WinCC Runtime.

220004 Communication is down and no update data is 
transferred because the cable is not connected 
or defective etc.

Check the connection.

220005 Communication is up. --
220006 The connection between the specified PLC and 

the specified port is active.
--
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220007 The connection to the specified PLC is 

interrupted at the specified port.
Check the following:
● Is the cable plugged in?
● Is the PLC OK?
● Is the right port being used?
● Is your configuration OK (port parameters, 

protocol settings, PLC address)?
Restart the system if the system event persists.

220008 The communication driver cannot access or 
open the specified port. This port might be in use 
by another application, or a port that does not 
exist on the target device is being used.
No communication with the PLC.

Close all applications that access the port and restart 
the computer.
Use another port that exists in the system.

230000 - Screen object alarms

230000 - Screen object alarms 

Number Effect/causes Remedy
230000 The value entered could not be used. The system 

discards this entry and restores the previous 
value.
Possible causes:
● The range of values is exceeded.
● You entered invalid characters
● The valid maximum number of users has 

been exceeded.

Enter a practical value, or delete a user that is no 
longer required.

230002 The user currently logged on does not have the 
necessary authorization, so the system discards 
the entry and restores the previous value.

Log on as user with appropriate authorization.

230003 Change to the specified screen failed because 
this screen is not available/configured. The 
current screen remains selected.

Configure the screen and check the selection 
function.

230005 The range of values of the tag has been 
exceeded in the I/O field.
The original tag value is retained.

Observe the range of values for the tag when 
entering a value.

230100 During navigation in the Web browser, the 
system returned a message which may be of 
interest to the user.
The Web browser continues to run but may not 
(fully) show the new page.

Navigate to another page.

230200 The HTTP channel connection was interrupted 
due to an error. This error is explained in detail 
by another system event.
Data is no longer exchanged.

Check the network connection.
Check the server configuration.

230201 The HTTP channel connection is set up.
Data is exchanged.

--
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230202 WININET.DLL has detected an error. Usually, 

this error occurs if it is not possible to connect to 
the server, or the server denies a connection 
because the client lacks proper authorization.
An unknown server certificate may also be the 
cause if the connection is encrypted by means of 
SSL.
The alarm text provides details.
This text is always in the language of the 
Windows installation because it is returned by the 
Windows OS.
Process values are no longer exchanged.
The part of the alarm returned by the Windows 
OS might not be displayed, e.g. "An error has 
occurred". WININET.DLL returns the following 
error: Number: 12055 Text:HTTP: <no error text 
available>."

Depending on the cause:
When an attempt to connect fails, or a timeout occurs:
● Check the network connection and the network.
● Check the server address.
● Check whether the WebServer is actually running 

on the target station.
Incorrect authorization:
● The configured user name and/or password do 

not match the entries on the server. Set 
consistent data.

If the server certificate is rejected:
Certificate signed by an unknown CA ( ):
● Ignore this point, or install a certificate that has 

been signed with one of the root certificates 
known to the client station.

The date of the certificate is invalid:
● Ignore this point, or install a certificate with valid 

date on the server.
Invalid CN (Common Name or Computer Name):
● Ignore this point, or install a certificate with a 

name that corresponds to the server address.
230203 Although a connection can be made to the 

server, the HTTP server refused to connect. 
Possible causes:
● WinCC Runtime does not run on the server
● The HTTP channel is not supported (503 

Service unavailable).
Other errors can only occur if the Webserver 
does not support the HTTP channel. The 
language of the alarm text depends on the 
Webserver.
Data is not exchanged.

On 503 Service unavailable error:
Check whether WinCC Runtime is running on the 
server and whether the HTTP channel is supported.

230301 Internal error. An English text explains the error 
in more detail. The error may be caused by 
insufficient memory.
OCX does not work.

--

230302 The name of the remote server cannot be 
resolved.
An attempt to connect has failed.

Check the configured server address.
Check whether the DNS service is available on the 
network.

230303 The remote server is not running on the 
addressed computer.
incorrect server address.
An attempt to connect has failed.

Check the configured server address.
Check whether the remote server is running on the 
target computer.

230304 The remote server on the addressed computer is 
incompatible with VNCOCX.
An attempt to connect failed.

Use a compatible remote server.

230305 Authentication has failed due to incorrect 
password.
An attempt to connect failed.

Configure the correct password.
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230306 Error in the connection to the remote server. This 

may occur as a result of network problems.
An attempt to connect failed.

Check whether the network cable is plugged in, or 
whether there are network problems.

230307 The connection to the remote server was shut 
down. Possible causes:
● The remote server was shut down
● The user instructed the server to close all 

connections.
The connection is cancelled.

--

230308 This alarm provides information on the 
connection status.
An attempt is made to connect.

--

240000 - Authorization alarms

240000 - Authorization alarms 

Number Effect/causes Remedy
240000 WinCC Runtime is running in demo mode.

You have no authorization, or your authorization 
is corrupted.

Install the authorization.

240001 WinCC Runtime is running in demo mode.
You configured too many tags for the installed 
version.

Load an adequate authorization / powerpack.

240002 WinCC Runtime is running with time-limited 
emergency authorization.

Restore the full authorization.

240004 Error when reading the emergency authorization.
WinCC Runtime is running in demo mode.

Restart WinCC Runtime. Install or repair the 
authorization (see Commissioning Instructions for 
Software Protection).

240005 Automation License Manager has detected an 
internal system error. 
Possible causes:
● Corrupted file
● Faulty installation
● No free memory space for Automation 

License Manager, or similar.

Restart the HMI device/PC. If this procedure does not 
solve the problem, remove and then reinstall 
Automation License Manager.
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250000 - S7 Status/Force alarms

250000 - S7 Status/Force alarms

Number Effect/causes Remedy
250000 The tag in the specified line in "Status Force" is 

not updated because the address configured for 
this tag is not available.

Check the set address and then verify that the 
address is set up in the PLC.

250001 The tag in the specified line in "Status Force" is 
not updated because the PLC type configured 
for this tag does not exist.

Check the set address.

250002 The tag in the specified line in "Status Force" is 
not updated because it is not possible to map the 
PLC type in the tag type.

Check the set address.

250003 An attempt to connect to the PLC failed. The tags 
are not updated.

Check the connection to the PLC. Check that the PLC 
is switched on and is online.

260000 - Password system alarms

260000 - Password system alarms   

Number Effect/causes Remedy
260000 An unknown user or an unknown password has 

been entered in the system.
The current user is logged off from the system.

Log on to the system as a user with a valid password.

260001 The logged in user does not have sufficient 
authorization to execute the protected functions 
on the system.

Log on to the system as a user with sufficient 
authorization.

260002 This alarm output when the "TrackUserChange" 
system function is triggered.

--

260003 The user has logged off from the system. --
260004 The user name entered into the user view 

already exists in the user management.
Select another user name because user names have 
to be unique in the user management.

260005 The entry is discarded. Enter a shorter user name.
260006 The entry is discarded. Use a shorter or longer password.
260007 The logoff time entered is outside the valid range 

from 0 to 60 minutes.
The new value entered is discarded and the 
original value is retained.

Enter a logon timeout value between 0 and 60 
minutes.

260008 An attempt was made in WinCC to read a 
PTProRun.pwl file created with ProTool V 6.0.
Reading of the file was canceled due to 
incompatibility of the format.

--

260009 You have attempted to delete the user 
"Administrator" or "PLC User". These users are 
fixed components of the user management and 
cannot be deleted.

If you need to delete a user, because perhaps you 
have exceeded the maximum number permitted, 
delete another user.
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260012 The password entries in the "Change Password" 

dialog and in the confirmation field do not match.
The password is not changed. User will be 
logged off.

You have to log on to the system again. Then enter 
the identical password twice to be able to change the 
password.

260013 The password entered in the "Change 
Password" dialog is invalid because it is already 
in use.
The password is not changed. User will be 
logged off.

You have to log on to the system again. Then enter a 
new password that has not been used before.

260014 You have tried to log on with an incorrect 
password three times in a row.
You will be locked out and assigned to group no. 
0.

You can log on to the system with your correct 
password. Only an administrator can change the 
assignment to a group.

260024 The password you entered does not meet the 
necessary security guidelines.

Enter a password that contains at least one number.

260025 The password you entered does not meet the 
necessary security guidelines.

Enter a password that comprises at least three 
characters.

260028 Upon system start-up, an attempt to log on, or 
when trying to change the password of a 
SIMATIC log-on user, the system attempts to 
access the SIMATIC Logon Server.
If attempting to log on, the new user is not logged 
in. If a different user was logged on before, then 
this user is logged off.

Check the connection to the SIMATIC Logon Server 
and its configuration; for example:
1. Port number
2. IP address
3. Server name
4. Functional transfer cable
Or use a local user.

260030 The SIMATIC Logon user could not change his 
password on the SIMATIC Logon Server. The 
new password is possibly noncompliant with 
password rules set on the server, or the user is 
not authorized to change his password.
The old password remains and the user is 
logged off.

Log in again and choose a different password. Check 
the password rules on the SIMATIC Logon Server.

260033 The action change password or log on user 
could not be carried out.

Check the connection to the SIMATIC Logon Server 
and its configuration; for example:
1. Port number
2. IP address
3. Server name
4. Functional transfer cable
Or use a local user.

260034 The last logon operation has not yet ended. A 
user action or a logon dialog can therefore not 
be called.
The logon dialog is not opened. The user action 
is not executed.

Wait until the logon operation is complete.

260035 The last attempt to change the password was 
not completed. A user action or a logon dialog 
can therefore not be called.
The logon dialog is not opened. The user action 
is not executed.

Wait until the procedure is complete.
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260036 There are insufficient licenses on the SIMATIC 

Logon Sever. The logon is not authorized.
Check the licensing on the SIMATIC Logon Server.

260037 There is no license on the SIMATIC Logon 
Sever. A logon is not possible.
It is not possible to log on via the SIMATIC Logon 
Server, only via a local user.

Check the licensing on the SIMATIC Logon Server.

260040 The system attempts to access the SIMATIC 
Logon Server upon system start-up or when 
trying to change the password.
If attempting to log on, the new user is not logged 
in. If a different user was logged on before, then 
this user is logged off.

Check connection to the domain and its configuration 
in the Runtime security settings editor.
Or use a local user.

260043 It was not possible to log the user on to the 
SIMATIC Logon Server. The user name or the 
password could be incorrect or the user does not 
have sufficient rights to log on.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Try again. If necessary, check the password data on 
the SIMATIC Logon Server.

260044 It was not possible to log the user on to the 
SIMATIC Logon Server as his account is 
blocked.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Check the user data on the SIMATIC Logon Server.

260045 The SIMATIC Logon user is not associated to 
any or several groups.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Check user data on the SIMATIC Logon Server and 
the configuration in your WinCC project. A user may 
only be assigned to one group.

270000 - System alarms

270000 - System Alarms

Number Effect/causes Remedy
270000 The alarm does not indicate the tag because it 

is accessing an invalid address in the PLC.
Check whether the data area for the tag exists on the 
PLC, whether the configured address is correct, and 
whether the value range for the tag is correct.

270001 There is a device-specific limit as to how many 
alarms may be queued for viewing (see the 
operating instructions). This limit has been 
exceeded.
The view no longer contains all the alarms.
However, all alarms are written to the alarm 
buffer.

--
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270002 The view shows alarms of a log for which there 

is no data in the current project.
Placeholders are output for the alarms.

Delete old log data, if necessary.

270003 The service cannot be set up because too many 
devices want to access this service.
A maximum of four devices can execute this 
action.

Reduce the number of HMI devices which want to use 
the service.

270004 Access to the persistent alarm buffer is not 
possible. Alarms cannot be restored or backed 
up.

If the problems persist at the next restart, contact 
Customer Support (delete Flash).

270005 Persistent alarm buffer corrupted: Alarms 
cannot be restored.

If the problems persist at the next restart, contact 
Customer Support (delete Flash).

270006 Project modified: Alarms cannot be restored 
from the persistent alarm buffer.

The project was compiled and downloaded again to 
the HMI device. The error should no longer occur at 
the next restart of the HMI device.

270007 A configuration problem is preventing you from 
the restoring the data (e.g. a DLL was deleted, 
or unknown directory).

Update the operating system and download your 
project again to the HMI device.

290000 - Recipe system alarms

290000 - Recipe system alarms 

Number Effect/causes Remedy
290000 The recipe tag could not be read or written. It is 

assigned the start value.
The alarm can be entered in the alarm buffer for 
up to four more faulty tags. After that, alarm 
290003 is output.

Check the configuration to see whether the address 
has been set up in the PLC.

290001 An attempt was made to assign the recipe tag a 
value that is outside the valid range of values for 
this type.
The alarm can be entered in the alarm buffer for 
up to four more faulty tags if necessary. After 
that, alarm 290004 is output.

Observe the range of values for the tag type.

290002 It is not possible to convert a value from a source 
format to a target format.
The alarm can be entered in the alarm buffer for 
up to four more faulty recipe tags if necessary. 
After that, alarm 290005 is output.

Check the range of values or type of the tag.

290003 This alarm is output after alarm 290000 was 
triggered more than five times.
In this case, no further separate alarms are 
generated.

Check the configuration to see whether the tag 
addresses have been set up in the PLC.

290004 This alarm is output after alarm 290001 was 
triggered more than five times.
In this case, no further separate alarms are 
generated.

Observe the range of values for the tag type.
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290005 This alarm is output after alarm 290002 was 

triggered more than five times.
In this case, no further separate alarms are 
generated.

Check the range of values or type of the tag.

290006 The limits configured for the tag have been 
exceeded by the values entered.

Observe the configured or current tag limits.

290007 There is a difference between the source and 
target structure in the recipe currently being 
processed. The target structure contains an 
additional recipe tag that is not available in the 
source structure.
The recipe tag specified is assigned its start 
value.

Insert the specified recipe tag into the source 
structure.

290008 There is a difference between the source and 
target structure in the recipe currently being 
processed.The source structure contains an 
additional recipe tag that is not available in the 
target structure and cannot be assigned.
The value is discarded.

Remove the specified recipe tag in the specified 
recipe from the project.

290010 The storage location configured for the recipe is 
invalid.
Possible causes:
Invalid characters, write protection, data carrier 
out of space or not available.

Check the configured storage location.

290011 A data record of the specified number does not 
exist.

Check the source for the number (constant or tag 
value).

290012 A recipe of the specified number does not exist. Check the source for the number (constant or tag 
value).

290013 An attempt was made to save a data record 
under a data record number that already exists.
The operation is not executed.

The following remedies are available:
● Check the source for the number (constant or tag 

value).
● First, delete the data record.
● Modify the "Overwrite" function parameter.

290014 The specified import file was not found. Check the following:
● The file name
● Ensure that the file is in the specified directory.

290020 Check back to verify that the download of data 
records from the HMI device to the PLC has 
started. 

--

290021 Check back to verify that the download of 
records from the HMI device to the PLC was 
completed.

--

290022 Check back to indicate that the download of data 
records from the HMI device to the PLC was 
canceled due to an error.

Check the following conditions in the configuration:
● Are the tag addresses configured in the PLC?
● Does the recipe number exist?
● Does the data record number exist?
● Is the "Overwrite" function parameter set?

Visualizing processes (Comfort/Advanced)
10.3 Working with alarms

WinCC Comfort/Advanced V12.0 SP1
3366 System Manual, 07/2013,  



Number Effect/causes Remedy
290023 Check back to verify that the download of data 

records from the PLC to the HMI device has 
started.

--

290024 Check back to verify that the download of data 
records from the PLC to the HMI device was 
completed.

---

290025 Check back to indicate that the download of data 
records from the PLC to the HMI device was 
canceled due to an error.

Check the following conditions in the configuration:
● Are the tag addresses configured in the PLC?
● Does the recipe number exist?
● Does the data record number exist?
● Is the "Overwrite" function parameter set?

290026 An attempt was made to read/write a data record 
that is not free at present.
This error can occur if recipes were configured 
for download with synchronization.

Set the mailbox status to zero.

290027 Unable to connect to the PLC at present. As a 
result, the data record cannot be read or written.
Possible causes:
No hardware connection to the PLC (no cable 
plugged in, cable is defect), or the PLC is 
switched off.

Check the connection to the PLC.

290030 This alarm is output after you selected screen 
which contains a recipe view in which a data 
record is already selected.

Reload the data record from the storage location, or 
retain the current values.

290031 While saving, it was detected that a data record 
with the specified number already exists.

Overwrite the data record, or cancel the action.

290032 During the export of data records, a file with the 
specified name was found.

Overwrite the file, or cancel the process.

290033 Confirmation prompt before deleting data 
records.

--

290040 A data record error with error code %1 that 
cannot be described in more detail occurred.
The action is canceled.
It is possible that the mailbox was not installed 
correctly on the PLC.

Check the storage location, the data record, the "Data 
record" area pointer, and the connection to the PLC.
Restart the action after a short waiting time.
If the error persists, contact Customer Support. 
Forward the relevant error code to Customer Support.

290041 A data record or file cannot be saved because 
the storage location is out of sufficient space.

Delete files no longer required.

290042 An attempt was made to execute several recipe 
actions simultaneously. The last action is not 
executed.

Retrigger the action after a short waiting time.

290043 Confirmation prompt before saving data records. --
290044 The database for the recipe was corrupted and 

will be deleted.
--

290050 A check back indicates that the export of data 
records was started.

--

290051 A check back indicates successful completion of 
the export of data records.

--
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290052 A check back indicates that the export of data 

records was canceled due to an error.
Ensure that the structure of the data records at the 
storage location and the current recipe structure on 
the HMI device are identical.

290053 A check back indicates that the import of records 
was started.

--

290054 A check back indicates successful completion of 
the import of data records.

--

290055 A check back indicates that the import of data 
records was canceled due to an error.

Ensure that the structure of the data records at the 
storage location and the current recipe structure on 
the HMI device are identical.

290056 Error when reading/writing the value in the 
specified row/column.
The action was canceled.

Check the specified row/column.

290057 The tags of the recipe specified were toggled 
from "offline" to "online" mode.
Each change of a tag in this recipe is now 
immediately transferred to the PLC.

--

290058 The tags of the specified recipe were toggled 
from "online" to "offline" mode.
Modifications to tags in this recipe are no longer 
immediately transferred to the PLC but must be 
transferred there explicitly by downloading a 
data record.

--

290059 A check back indicates that the specified record 
was successfully saved.

--

290060 A check back indicates that the specified data 
record memory was cleared.

--

290061 A check back indicates that deletion of the data 
record memory was canceled due to an error.

--

290062 The data record number exceeds the maximum 
of 65536.
This data record cannot be created.

Select another number.

290063 This occurs when you execute system function 
"ExportDataRecords" while the "Overwrite" 
parameter is set to "No". 
An attempt was made to save a recipe under a 
file name that already exists.
The export is canceled.

Check the parameters of the "ExportDataRecords" 
system function.

290064 A check back indicates that the deletion of data 
records was started.

--

290065 A check back indicates successful completion of 
the deletion of data records.

--

290066 Confirmation prompt before deleting data 
records.

--

290068 Confirmation prompt for deletion of all recipe 
data records.

--

290069 Confirmation prompt for deletion of all recipe 
data records.

--

290070 The data record specified was not found in the 
import file.

Check the source of the data record number, or the 
data record name (constant, or tag value).
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Number Effect/causes Remedy
290071 When the editing data record values, you 

entered a value that is below the low limit of the 
recipe tag.
The entry is discarded.

Enter a value within the recipe tag limits.

290072 When editing data record values, you entered a 
value that exceeds the high limit of the recipe tag.
The entry is discarded.

Enter a value within the recipe tag limits.

290073 An action (e.g. saving a record) failed for an 
unknown reason.
The error corresponds to status alarm 
IDS_OUT_CMD_EXE_ERR in the large recipe 
view.

--

290074 While saving, a data record with the specified 
number but with different name was found.

Overwrite the record, change the record number or 
cancel the action.

290075 A data record of this name already exists.
The data record is not saved.

Select a different data record name.

290110 The default values could not be set due to an 
error.

--

290111 The recipes subsystem cannot be used. Recipe 
views have no content and recipe-specific 
functions will not be executed.
Possible causes:
● Error when loading the recipes.
● The recipe structure was changed in the ES. 

The recipes were not included in the latest 
project download. This means that the new 
configuration data no longer matches the old 
recipes on the device.

Download the project to the device again, including 
the recipes (the corresponding check box in the 
download dialog must be check marked).

300000 - Alarm_S alarms

300000 - Alarm_S alarms

Number Effect/causes Remedy
300000 Faulty configuration of process monitoring (e.g. 

using PDiag or S7 Graph): More alarms are 
queued than specified in the specifications of the 
CPU. No further ALARM_S alarms can be 
managed by the PLC and reported to the HMI 
devices.

Change the PLC configuration.

300001 ALARM_S is not registered on this PLC. Select a controller that supports the ALARM_S 
service.
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310000 - Reporting alarms

310000 - Reporting alarms

Number Effect/causes Remedy
310000 An attempt is being made to print too many 

reports in parallel.
Only one log file can be output to the printer at 
a given time; the print job is therefore rejected.

Wait until the previous active log was printed.
Repeat the print job if necessary.

310001 An error occurred on triggering the printer. The 
report is either not printed or printed with errors.

Evaluate the additional system alarms related to this 
alarm.
Repeat the print job if necessary.

330000 - Interaction alarms

330000 - Interaction alarms 

Number Effect/causes Remedy
330022 Too many open dialogs on the HMI device. Close all dialogs you do not require on the HMI device.

 

 

350000 - PROFIsafe alarms

350000 - PROFIsafe alarms  

Number Effect/causes Remedy
350000 PROFIsafe packets were not received within the 

specified time.
There is a communication problem with the F-
CPU. 
RT is terminated.

Check the WLAN connection.

350001 PROFIsafe packets were not received within the 
specified time.
There is a communication problem with the F-
CPU.
The PROFIsafe connection is set up again.

Check the WLAN connection.

350002 Internal error.
Runtime is terminated.

Internal error

350003 Check back for indicating the connection setup 
to the F-CPU.
The Emergency-Off buttons are active 
immediately.

--
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Number Effect/causes Remedy
350004 PROFIsafe communication was set up and the 

connection was shut down.
Runtime can be terminated.
The Emergency-Off buttons are deactivated 
immediately.

--

350005 Incorrect address configured for the F-Device.
A PROFIsafe connection cannot be set up.

Check and modify the address of the F-Device in 
WinCC ES.

350006 The project was started. At the start of the 
project, check the proper function of the ACK 
buttons. 

Press the two ACK buttons successively in the 
"Acknowledge" and "Panic" positions.

350008 You configured an incorrect number of failsafe 
buttons.
A PROFIsafe connection cannot be set up.

Modify the number of failsafe buttons in the project.

350009 The device is in Override mode. 
It may no longer be possible to detect the 
location because transponder detection fails.

Exit the override mode.

350010 Internal error: The device has no failsafe buttons. Return the device to Siemens.
Worldwide contact partners

10.3.6 Configuring system diagnostics

10.3.6.1 System diagnostics basics

Introduction
You use system diagnostics to detect problems and errors in any part of your plant. WinCC 
has two display and operating elements for quick error localization.

       

System diagnostics view   
The alarm view shows the status of a PLC while the system diagnostics view gives you an 
overview of all devices available in your plant: You navigate directly to the cause of the error 
and to the relevant device. You have access to all diagnostics-capable devices which you have 
configured in the "Devices & networks" editor.

System diagnostics window   
The system diagnostics window is an operating and display element that you can only use in 
the global screen. 
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The functions of the system diagnostics window are no different than those of the system 
diagnostics view. Because the system diagnostics window is configured in the global screen, 
you can, for example, also specify if the object is closable in Runtime. 

 

 Note
System diagnostics on Basic Panels

The "System--Diagnostics window" object is not available for Basic Panels.
 

See also
System diagnostics views (Page 3372)

10.3.6.2 System diagnostics views

Introduction
There are four different views available in the system diagnostics view and the system 
diagnostics window. 

● Device view

● Diagnostic buffer view     

● Detail view

● Matrix view (for master systems, PROFIBUS, PROFINET only)

Visualizing processes (Comfort/Advanced)
10.3 Working with alarms

WinCC Comfort/Advanced V12.0 SP1
3372 System Manual, 07/2013,  



Device view
The device view shows all the available devices of a layer in a table. Double-clicking on a 
device opens either the child devices or the detail view. Symbols in the first column provide 
information about the current status of the device.

Diagnostic buffer view 
In the diagnostic buffer view, the current data from the diagnostic buffer of the device is 
displayed. The diagnostic buffer view can only be called up in the device view.

To update the diagnostic buffer view, you click . 
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Detail view
The detail view gives detailed information about the selected device and the pending errors. 
Check whether the data is correct in the detail view. You cannot sort error texts in the detail 
view.

 

 Note
Contents of the detail view

The contents of the detail view are only available for integrated connections with S7 1200 
and S7 1500 PLCs.
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Matrix view
The matrix view is only available for master systems. In the matrix view you can see the status 
of the subdevices of the master system. 

● In PROFIBUS, the numbers assigned by PROFIBUS are used as identification (DP station 
number).

● The IO devices are numbered consecutively beginning with 1 in PROFINET. 

Navigation buttons

Button Key Function
Enter key Opens the child devices or the detail view 

if there are no child devices.

Esc key Opens the parent device or the device 
view if there is no parent device.

Home key Opens the device view.

Configured function key, e.g. F1. Opens the diagnostic buffer view.
Only visible in the device view.

Configured function key, e.g. F2. Updates the diagnostic buffer view.
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 Note
Navigation in the matrix view of Comfort Panels with function keys

The Shift key is additionally used to select PNIO or PROFIBUS slaves in the matrix view. 
 

Language switching in runtime
Switch over the language in runtime before you open the details view. 

If you switch over the runtime language while the details view is opened, you change back to 
the diagnostic buffer view. 

Open the details view again. The selected runtime language is now displayed correctly.

See also
System diagnostics basics (Page 3371)

10.3.6.3 Basic Panel basics

System diagnostics basics

Introduction
Using system diagnostics, you can display the messages from the diagnostic buffer of all 
integrated connections.

       

System diagnostics view   
The system diagnostics display is an operating and display object that you use in a screen. 

You navigate directly to the cause of the error and the associated connection. You have access 
to all integrated connections that you have configured in the "Devices & networks" editor.

System diagnostics views

Introduction
Three different views are available in the simple system diagnostic view. 

● Device view

● Diagnostic buffer view

● Detail view
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Device view
The device view is only displayed if more than one integrated connection has been configured.

The device view shows all available connections in a table. Double-clicking a connection opens 
the diagnostic buffer view. 

Diagnostic buffer view 
The diagnostic buffer view shows the current data from the diagnostic buffer. 

To update the diagnostic buffer view, you click .
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Detail view
The detail view gives detailed information about the selected connection and any pending 
errors. Check whether the data is correct in the detail view. 

 

 Note
Contents of the detail view

The contents of the detail view are only available for integrated connections with S7 1200 
and S7 1500 PLCs.

 

Navigation buttons

Button Key Function
Enter key In the device view: 

Opens the diagnostic buffer view of the selected 
device. 
In the diagnostic buffer view:
Opens the detail view. 

Esc key In the diagnostic buffer view: 
Opens the device view.
In the detail view: 
Opens the diagnostic buffer view.

Configured function key, e.g. 
F1.

Updates the diagnostic buffer view.
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10.3.6.4 Configuring system diagnostics objects

Enabling system diagnostics in the PLC

Introduction
During communication with the SIMATIC S7 1500 and SIMATIC S7 1200 PLCs, system 
diagnostics is automatically activated. 

For other PLCs, the following settings must be implemented in the PLC to enable the PLC to 
transfer error messages to the system diagnostics view.

    

Requirements
● A PLC such as SIMATIC S7 300/400 or ET 200 has been created.

● The "Devices & Networks" editor is open in the "Device view".

Procedure
1. Select the PLC in the selection list.

2. Click on the PLC and select "Properties" in the shortcut menu. The properties of the PLC 
are displayed in the Inspector window.

3. Select "Properties > General > System diagnostics" in the Inspector window.

4. Enable "Activate system diagnostics for this CPU".

5. Select the PLC and then "Compile > Hardware configuration" in the shortcut menu.

Result
The settings will be effective following compilation. The PLC can now transfer error messages 
to the system diagnostics display. 

Adding a system diagnostics indicator

Introduction
The system diagnostics indicator is a predefined graphic symbol of the library which alerts you 
to errors in your system. 

If an error occurs, the appearance of the object changes. The library object can display two 
states:

- No error

- Error         
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Requirement
● The "Libraries" task card is opened.

● The global library "Buttons and Switches > Master copies > DiagnosticsButtons" is open.

● A screen is open.

● A system diagnostics window has been created in the global screen.
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Procedure
1. Select the "DiagnosticsIndicator" object in the library.

 
 

  Note
System diagnostics indicator for different device types

When selecting the object ensure that you use the correct object for the device type used 
in the project.

 

2. Drag-and-drop the library object to the position in the work area where you want to insert 
the object.
The library object is inserted.

3. Select the library object.

4. Click "Properties > Events" in the Inspector window.
The system function "ShowSystemDiagnosticsWindow" is preset for the event "Click".
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Result
The status diagnostics indicator has been added to the project and connected with the system 
diagnostics window. 

The system diagnostics indicator changes its appearance if an error message is output in 
Runtime. The system diagnostics window opens when you click on the system diagnostics 
indicator. The system diagnostics window shows the detail view of the affected device. 

Configuring access protection for the system diagnostics window
Configure access protection for the system diagnostics indicator to prevent unauthorized 
access to the system diagnostics window.

1. Select the "DiagnosticsIndicator" object in the screen.

2. Select an authorization in "Properties > Properties > Security in Runtime" in the Inspector 
window.

A logon dialog opens when you click on the system diagnostics indicator in Runtime. The 
system diagnostics window does not open unless you have the required authorization. 

Configuring a system diagnostics window in the global screen

Introduction
The system diagnostics window gives you an overview of all devices available in your plant. 
The system diagnostics window operates like the system diagnostics view, but it is only 
available in the global screen.       

Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● A Comfort Panel or WinCC RT Advanced has been created.

● The global screen is open.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics window" object in the "Tools" task card. The object 

is added to the global screen.

2. Select "Properties > Properties > Columns > Devices/Detail view" in the Inspector window.

3. Enable the columns that you require in the device view for Runtime, for example: status, 
name, address.

4. Enable the properties which you require in the detail view for Runtime, for example: status, 
name, plant designation.
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5. Activate the columns that you require in the diagnostic buffer view, for example, status, 
name.

6. Customize the column headers, if necessary.

7. Enable "Properties >Properties > Layout > Column settings > Columns moveable" to move 
the columns in Runtime.

8. Enable "Properties > Properties > Window > Closable" to allow the system diagnostics 
window to be closed in Runtime.

Result
The system diagnostics window has been added to the global screen. The system diagnostics 
window will respond to error messages in the plant and display the device affected.

Configure a system diagnostics indicator in a screen to open the system diagnostics window.

Configuring button as system diagnostics indicator

Introduction
Instead of using the object "DiagnosticsIndicator" from the library, you can configure a button, 
for example, to indicate errors in your plant.         

Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● The "Tools" task card is open.

● A bit graphics list has been created with two different graphics for the statuses.

● A screen is open.

● You have created a system diagnostics view.

Procedure
1. Double-click the "Button" object in the "Tools" task card. A button will be added to the screen.

2. In the Inspector window, select "Properties > Properties > General > Mode > Graphic".

3. Select the bit graphics list under "Graphic > Graphics list".

4. Select the "@DiagnosticsIndicatorTag" tag under "Properties > Properties > General > Tag" 
in the Inspector window.

Configuring system function to the button
1. Click "Properties > Events" in the Inspector window.

2. Select the "Click" event.
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3. Click on "Add function" in the table.

4. Select the "ActivateSystemDiagnosticsView" system function.

5. Select the system diagnostics view.

Result
You have now configured a button which will respond to error messages from the PLC. The 
button changes its appearance if an error message is output in Runtime. 

The button has two states:

● Error
The system diagnostics view opens when you click the button. The system diagnostics view 
shows the detail view of the device concerned.

● No error
The system diagnostics view opens when you click the button. The system diagnostics view 
shows the device view. 

Configuring the system diagnostic view

Introduction
You add a system diagnostics view to your project to get an overview of all devices available 
in your plant.

Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● A Comfort Panel or WinCC RT Advanced has been created.

● You have created a screen.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen. 

2. Select "Properties > Properties > Columns > Devices/Detail view" in the Inspector window.

3. Activate the columns that you require in the device view for Runtime, e.g. Status, Name, 
Slot.

4. Activate the columns that you require in the device view for Runtime, e.g. Status, Name, 
Plant designation.

5. Activate the columns that you require in the diagnostic buffer view, for example, Status, 
Name.
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6. Enable "Properties >Properties > Layout > Column settings > Columns moveable" to move 
the columns in Runtime.

7. You can change the column headers under "Properties > Properties > Column headers", 
if necessary.

Result
The system diagnostics view has been added to the screen. Error for the entire plant are now 
displayed in the system diagnostics view in Runtime. 

Configuring the system diagnostic view

Introduction
For an overview of all integrated connections, you insert a system diagnostics view in your 
project.

Requirements
● A PLC has been created.

● A Basic Panel has been created.

● An integrated connection has been created in the "Devices & Networks" editor.

● You have created a screen.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen. 

2. In the Inspector window, select "Properties > Layout".

3. Enter a number under "Lines per entry", i.e. 5.

Result
The system diagnostics view has been added to the screen. 

To obtain the latest alarms, update the diagnostic buffer.

Splitting the view in system diagnostics view

Introduction
The system diagnostics view also offers a split view of the display. You have the option to see 
the devices and the associated details at a glance.
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Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● An HMI device has been created, for example, a Comfort Panel.

● You have created a screen.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen. 

2. In the Inspector window, click "Properties > Properties > Layout".

3. Activate "Show split view".

4. Activate "Sizing > Auto-size"

5. You may also change the number of lines for the "Device view" and the "Detail view" if 
required.

Result
The system diagnostics view has been added to the screen. The system diagnostics view is 
split into two areas. 

The top area shows the device view. The bottom view shows the detail view.

If you open the diagnostic buffer view, the top area displays an overview of the diagnostic 
buffer and the bottom area displays the details.

Visualizing processes (Comfort/Advanced)
10.3 Working with alarms

WinCC Comfort/Advanced V12.0 SP1
3386 System Manual, 07/2013,  



 

 Note
Contents of the detail view

The contents of the detail view are only available for integrated connections with S7 1200 
and S7 1500 PLCs.
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10.4 Working with logs

10.4.1 Working with logs for Runtime Advanced and Panels

10.4.1.1 Log Basics

Introduction
WinCC provides the following types of log for logging process data for HMI Runtime:

● Data logs

● Alarm logs

A data log is used to log process data from an industrial plant.

An alarm log is used to log alarms that occur in the monitored process.     

Principle
The two types of log both have roughly the same structure and largely work in the same way. 
They are very clear and easy to configure. With both types of log you define the same properties 
for the log. The same logging methods are also available for both types of log.

The following logging methods are available:

● Circular log
If a circular log is totally full, the oldest entries are overwritten.

● Segmented circular log
In a segmented circular log, multiple single logs of the same size are filled in succession. 
When all log segments are filled, the oldest log segment is overwritten.

● Log with level-dependent system alarm
A system alarm is triggered when a defined level is reached.

● Log with level-dependent triggering of an event
The "Overflow" event is triggered when the log is full. The "Overflow" event triggers a system 
function.

10.4.1.2 Properties of Logs

Introduction
You define the properties of a data log in the "Data logs" editor.

You define the properties of an alarm log in the "Alarm log" editor.

The properties of the data log and alarm log are configured in the same way. You configure 
the properties either directly in the table of the respective editor or in the log properties of the 
Inspector window.
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General properties
● Name

You can assign any name to the log. The name must contain at least one letter or one 
number.

● Storage location
The log is stored in a file or a database. You can only save to a database on a PC. Select 
"File" or "Database" as the storage location.
You can specify a folder on the local PC hard disk or a folder on a network drive as the 
storage location, depending on how the HMI device is configured. The following storage 
locations are available for an HMI device:

– Memory card

– USB storage medium

– Network drive

The selection available depends on the HMI device in use.

● Size
The size of a log depends on the type of log and the selected settings.

– Size of a data log
The size of a data log is calculated as follows:
The number of items * the length of each tag value to be logged.
In the "Properties" window, the maximum size that the log accepts for retention of the 
currently selected number of data records is displayed in the input field "Number of data 
records". The maximum log size is limited by the volume of the storage medium.

– Size of an alarm log
The size of an alarm log is calculated from the number of data records and the 
approximate size of an entry. The size of an entry depends on whether the alarm text 
and the associated tag values are to be logged as well.

● Restart characteristics
Under Restart characteristics you can specify that the logging starts when Runtime starts. 
Check the "Enable logging at runtime start" check box.
You can also control the behavior when Runtime starts. Enable "Reset log" if you want to 
overwrite existing logged data with the new data. Select the "Append data to existing log" 
option if you want to retain the existing logged data. This setting adds the data to be logged 
to an existing log.

See "Auto-Hotspot" and "Auto-Hotspot" for more details.
 

 Note

You can use system functions to control the restarting of a log in Runtime.
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Automatic log entries  
In Runtime, the following log entries are created as standard:

Entry File format Log type Meaning
$RT_DIS$ Any Data log Indicates that the connection to the log was 

interrupted at this point in time. 
(A bold line is shown in the trend display for 
this time period.)

$RT_OFF$ Any Data log Indicates that Runtime was shut down at this 
point in time. 
(No line is shown in the trend display for this 
time period.)

$RT_ERR$ Any Data log
Alarm log
AuditTrail

Indicates in the target log that a copy operation 
was not successful or was interrupted.
(The log copy was not fully created.)

$RT_COUNT *.CSV
*. TXT

Data log
Alarm log
AuditTrail

This entry was created at the end of the log 
and serves to increase the system 
performance when Runtime starts.
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10.5 Working with recipes

10.5.1 Basics

10.5.1.1 Definition and applications

Introduction
Recipes are collections of related data, for example, machine parameterizations or production 
data.   

 

 Note
Restrictions for recipes

Recipes are not available on the HMI device OP 73:
 

Examples:

● Machine parameter settings that are needed to convert production to a different product 
variant.

● Product components that result in different compositions for different end products.

A recipe has a fixed data structure. The structure of a recipe is defined during configuration. 
A recipe contains recipe data records. These differ in terms of their values, but not their 
structure. 

Recipes are stored on the HMI device or on an external storage medium. Recipe data records 
are always transferred complete and in a single pass between the HMI device and the PLC. 
In addition, production data can be imported in runtime, in the form of a CSV file.

 

 Note
Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported using 
ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is interrupted.
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Using recipes
Recipes can be used in the following situations:

● Manual production
You select the required recipe data and display it on the HMI device. You modify the recipe 
data as required and save it on the HMI device. You transfer the recipe data to the PLC. 

● Automatic production
The control program starts transfer of the recipe data between the PLC and HMI device. 
You can also start the transfer from the HMI device. Production is then implemented 
automatically. It is not essential to display or modify the data. 

● Teach-in mode
You optimize production data that was optimized manually on the system, e.g. axis positions 
or filling volumes. The values thus determined are transferred to the HMI device and saved 
in a recipe data record. You can then transfer the saved recipe data back to the PLC at a 
later date.

Entering and modifying the recipe data
You enter the data in the individual recipe data records and modify it as required. The following 
options are available:

● Data entry during configuration
If the production data exists already, you enter the data in the "Recipes" editor during recipe 
configuration.

● Entering the data in Runtime
If you have to frequently modify production data, you can do this directly in Runtime as 
follows:

– Enter the data directly on the HMI device.

– Set the parameters directly on the machine. You then transfer the data from the PLC to 
the HMI device and save it in the recipe.
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10.5.1.2 Examples for using recipes
Recipes are used in the manufacturing industry and mechanical engineering, for example. The 
following recipes show typical applications which you can implement with the recipe function 
of WinCC:    

● Machine parameter assignment
One field of application for recipes is the assignment of machine parameters in the 
manufacturing industry: A machine cuts wooden boards to a certain size and drills holes. 
The guide rails and drill have to be moved to new positions according to the board size. 
The required position data are stored as data records in a recipe. You reassign the machine 
parameters using "Teach in" mode if, for example, a new board size is to be processed. 
You transfer the new position data directly from the PLC to the HMI device and save it as 
a new data record. 

● Batch production
Batch production in the food processing industry represents another field of application for 
recipes: A filling station in a fruit juice plant produces juice, nectar, and fruit drinks in a 
variety of flavors. The ingredients are always the same, differing only in their mixing ratios. 
Each flavor corresponds to a recipe. Each mixing ratio corresponds to a data record. All of 
the required data for a mixing ratio can be transferred to the machine control at the touch 
of a button. 

10.5.1.3 Recipe structure

Introduction
The basic structure of a recipe is illustrated with reference to the filling station in a fruit juice 
plant. 

There may be several different recipes in an HMI device. A recipe can be compared to an 
index card box that contains several index cards. The index card box contains several variants 
for manufacturing a product family. All the data for each manufacturing variant is contained on 
a single index card. 

Example:

In a soft drinks production plant, a recipe is needed for different flavors. Drink variants include 
fruit juice drink, juice and nectar.
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Recipe
The recipe contains all the recipe data records for the different drink variants.
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Recipe data records
Each index card represents a recipe data record needed to manufacture a product variant.

Recipe entries
Each index card in a drawer has the same structure. All the index cards contain fields for the 
different ingredients. Each field corresponds to a recipe entry. All the records of a recipe thus 
contain the same entries. The records differ, however, in the value of the individual entries. 

Example:

All the drinks contain the following ingredients: 

● Water

● Concentrate

● Sugar

● Flavoring

The records for juice drink, fruit juice or nectar differ, however, in the quantity of sugar used 
in production. 
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10.5.1.4 Display of recipes

Introduction
You can display recipes in the following ways:

● Recipe view

● Recipe screen

Input in the recipe view and recipe screen
You change the values of a recipe in the recipe screen or recipe view and thus modify the 
manufacturing process or a machine.

The recipe view and recipe screen can perform the same functions when using recipes. They 
differ in the following respects:

● Display options

● Operation

● Possibility of transferring data between the PLC and the HMI device

Recipe view  
The recipe view is suitable for viewing simple recipes.

The recipe view is an off-the-shelf WinCC display and operator control object for managing 
recipe data records. The recipe view is always part of a screen. The recipe view shows recipe 
data records in tabular form. You adapt the appearance and the possible operations to suit 
your specific needs.

If you are editing recipes with a recipe view in your project, the values are saved in recipe data 
records. The values are not transferred between the HMI device and PLC until you use the 
relevant operator control object. 
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Recipe screen   
The recipe screen is an individual screen that contains:

● Input fields for recipe variables

● Operator control objects for using the recipes, e.g. "SaveDataRecord"

The recipe screen is suitable in the following situations:

● Large recipes

● Allocation of recipe fields to the graphic display of the relevant plant area

● Breakdown of the recipe data into several screens
 

  Note

The values of recipe variables are transferred between the PLC and recipe screen at the 
following times depending on the configuration:
● Immediately after modification
● When a relevant operator control object is used

 

Synchronizing recipe view and recipe screen  
There may be differences in Runtime between the values displayed in the recipe view and the 
values saved in the associated tags when you edit recipes in both a recipe view and a recipe 
screen. To prevent this, you must synchronize the recipe data record values with the values 
of the recipe tags. 

A complete recipe data record will always be saved or synchronized.
 

 Note

Recipe tags can only be synchronized in the advanced recipe view. Synchronization only 
takes place if the "Synchronize recipe view and recipe tags" setting is activated for the recipe.
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10.5.1.5 Transferring recipe data records

Flow of data in recipes
The following picture illustrates the flow of data in recipes:   

Interaction between the components
There is interaction between the following components at runtime:

● Recipe view / recipe screen
On the HMI device, recipes are displayed and edited in the recipe view or in a recipe screen:

– The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

– The values of the recipe tags are displayed and edited in the recipe screen.

You synchronize the values displayed in the recipe view with the values of recipe tags 
according to the configuration.

● HMI device recipe memory
Recipes are saved in the form of recipe data records in the HMI device's recipe memory.

● Recipe tags
The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe 
values are stored in recipe tags. The point at which the values of the recipe tags are 
exchanged with the PLC depends on the configuration.

 

  Note

You can synchronize the recipe tags with the recipe data records so that the same values 
are saved in both.
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Loading and saving recipe data
Complete recipe data records are loaded from or saved to the recipe memory on the HMI 
device in the recipe view.

The values of the recipe data record are loaded from the recipe memory to the recipe tags in 
the recipe screen. When they are saved, the values of the recipe tags are saved to a recipe 
data record in the recipe memory.

Transferring the recipe values between the HMI device and the PLC
Complete recipe data records are transferred between the recipe view and PLC.

The following transfers are possible between the recipe screen and PLC, depending on the 
configuration:
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● Transferring recipe data records between recipe view and recipe tags

● Immediate transfer of individual modified values between the recipe tags and PLC. The 
following settings are needed in the recipe in order to do this:

– "Synchronizing recipe view and recipe tags" is activated.

– "Manual transfer of individual modified values (teach-in mode)" is deactivated.

Recipe data records can be transferred directly between the HMI device and PLC. In these 
situations, the display on the HMI device is not essential.

Exporting and importing recipe data records
Recipe data records are exported from the HMI device recipe memory and are saved to a CSV 
file on the external storage medium. The records can be reimported from the storage medium 
to the recipe memory.   

The following external storage media may be used, depending on the HMI device:

● No storage medium, for example, for basic panels

● Memory card

● USB stick

● Hard disk
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10.5.1.6 Configuration of recipes

Introduction
Recipes are configured differently according to the intended use: 

● If you are editing recipes with a recipe view in your project, the values are only saved in 
recipe data records.

● If you are editing recipes in a recipe screen in your project, the values are saved in recipe 
tags.

The following possible settings determine how the recipe data records, recipe tags and PLC 
all interact.

"Synchronizing recipe view and recipe tags" deactivated
The data in a data record is only displayed and can only be edited in the recipe view. If you 
use data outside the recipe view, they are not synchronized with the recipe view.

"Synchronizing recipe view and recipe tags" activated 
There may be differences in Runtime between the values displayed in the recipe view and the 
values saved in the associated tags when you edit recipes in both a recipe view and a recipe 
screen. To prevent this, you must synchronize the recipe data record values with the values 
of the recipe tags. 

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
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The values of the recipe view and the associated recipe tags are not synchronized 
automatically. The recipe tags and the recipe view are not synchronized until you use the 
operating element with the "RecipeViewSynchronizeDataRecordWithTags" function.

"Synchronize recipe view and recipe tags" activated and "Manual transfer of individual modified values 
(teach-in mode)" activated 

With this setting, modified recipe values are not synchronized immediately between the recipe 
tags in the recipe screen of the HMI device,and PLC. 

There must be an operating element with the "SetDataRecordToPLC" and 
"GetDataRecordFromPLC" functions present in order to synchronize the values.

If recipe values are changed in the controller, the modified values are displayed immediately 
in the recipe screen if you use the operating element with the "GetDataRecordFromPLC" 
function. 

"Synchronize recipe view and recipe tags" activated and "Manual transfer of individual modified values 
(teach-in mode)" deactivated 

With this setting, modified recipe values are synchronized immediately between the recipe 
tags on the HMI device and PLC. 

When you change recipe values in the recipe screen, these changes are applied immediately 
by the PLC and immediately influence the process.

If recipe values are changed in the PLC, the changed values are displayed immediately in the 
recipe screen.

10.5.1.7 Special features of some devices
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Basic panels, OP 77A, TP 177A and TP 177A (Portrait) respond differently to the other HMI 
devices in the following respects:   

● Only the simple recipe view is supported.

● Recipe tags are always synchronized with the recipe view (see figure above): When the 
operator changes a value of the recipe element in recipe view, the value of the associated 
recipe tag will also change.

● Recipe tags are not automatically transferred between the PLC and HMI device when they 
are modified. Recipe tags are always transferred manually in teach-in mode.
There must be an operator control object with the "SetDataRecordToPLC" and 
"GetDataRecordFromPLC" functions present in order to synchronize the values with the 
PLC.

 

  Note
Restrictions for recipe tags

Generally, in Basic Panels and OP77A, TP177A (Portrait) recipe tags cannot be used, 
except in a recipe.

 

  Note
Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported 
using ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is 
interrupted.

 

 
 NOTICE

Data loss with several recipe views in the screen

Applies only to Basic Panels, OP73, OP77A, TP177A and TP177A (Portrait): If two or 
more recipe views show the same recipe in a screen, you have a conflict when accessing 
the data.

The result is data loss and unpredictable status of recipe data.

Make sure the operators do not select and edit the same recipe in different recipe views. 
● Display only one recipe in a recipe view.
● Display a different recipe in each recipe view.
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Interaction between the components
There is interaction between the following components at runtime:

● Recipe view
Recipes are displayed and edited in the recipe view on the HMI device.
The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

● HMI device recipe memory
Recipes are saved in the form of recipe data records in the HMI device's recipe memory.

● Recipe tags
The recipe tags contain the values of recipe elements.

10.5.1.8 Synchronization of recipe data records with the PLC

Overview
When recipe data records are transferred between the HMI device and PLC, both 
communication peers access common communication areas on the other peer.

Recipe data records are always transferred directly. The values of the tags are written directly 
to or read directly from the configured addresses without being placed on the clipboard.

Data transfer types
There are two ways to transfer recipe data records between the HMI device and PLC:

● Transfer without coordination

● Coordinated transfer via the "Data record" area pointer.
 

  Note
Coordinated transfer

Transfer with coordinated transfer is used to prevent the uncontrolled overwriting of data 
in either direction in your control program.

 

Requirements for coordinated transfer
The following requirements apply to coordinated transfer:

● The "Data record" area pointer must be set up for the required connection in the 
"Communication > Connections" editor.

● In the properties of the recipe "Coordinated transfer of data records" is activated.

● The connection to the PLC is specified in the properties of the recipe with which the HMI 
device coordinates the transfer.
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Coordinated transfer
In the case of coordinated transfer, both the PLC and the HMI device set the status bits in the 
shared data compartment.

Coordinated transfer of recipe data records can be a useful solution in the following cases:

● The PLC is the "active partner" for the transfer of recipe data records.

● The PLC evaluates information about the recipe number and name, as well as the recipe 
data record number and name.

● The transfer of recipe data records is started by the following PLC jobs:

– "Set_data_record_in_PLC"

– "Get_data_record_from_PLC"  

10.5.1.9 "Recipes" editor

Introduction
You can create, configure and edit recipes, recipe entries and recipe data records in the 
"Recipes" editor. The "Recipes" editor also allows you to enter values in recipe data records. 

Structure of the "Recipes" editor
You create recipes in the top part of the table editor. You can also configure them there or in 
the Inspector window.

The bottom part of the table editor has the following tabs:

● Elements
Define the recipe elements of the selected recipe using the table cells provided here. You 
can move recipe elements within the table with the shortcut menu commands, "Up" and 
"Down".

● Data records
Define the values of the data records of the selected recipe using the table cells provided 
here.
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You can then configure the selected recipe, the recipe element or the recipe data record in the 
Inspector window. You will find further notes on configuring the components of a recipe under 
"Configuring Recipes".

Recipe settings
The following settings are available for recipes:

Setting Description
Name of the recipe This is a unique identification for the recipe within the HMI device. 
Display name Appears in the recipe view, for example, in Runtime. You can configure 

display names in multiple languages. Assign descriptive names or 
designations which the operator can associate directly with a recipe, e.g. "fruit 
juice drink".

Recipe number This is a unique identification for the recipe within the HMI device.
Version Information about the recipe. The date and time of the last change to the 

recipe is set by default.
Path Defines the storage location for recipes. The recipes are stored as a file.
Size type [fixed] The recipe data records are limited to a predetermined number by default.
Number of data 
records [fixed]

Maximum number of data records in a recipe in Runtime. The number is 
limited by the recipe memory of the HMI device.

Communication type 
[fixed]

The recipe data records are written directly to the addresses of the recipe 
tags and read from there.

Tooltip Tooltip for the recipe which is shown to the operator in Runtime.
 

 Note
Path

The storage location depends on the storage media available on the HMI device. 

Basic Panels and OP77A, TP177A (Portrait)

These HMI devices have no external memory. Recipes are always saved in the internal Flash 
memory. The "Path" setting is therefore not available.

 

Recipe element settings
You can make the following settings on the "Elements" tab:

Setting Description
Name of the recipe element Identifies a recipe element uniquely within the recipe. Enter meaningful 

names or labels that you can allocate uniquely, such as axis labels on 
a machine or ingredients such as "Flavoring".

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Assign meaningful names or 
designations which the operator can associate directly, e.g. "fruit juice 
flavoring".
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Setting Description
Recipe tag An assigned tag in Runtime stores the current value of the recipe 

element in the recipe data record.
Data type Data type of the recipe tag.
Data length [fixed] Data length of the recipe tag, depending on the data type.
Text list Text is assigned to a value or range of values in a text list. You can 

display this text in an output field, for example. 
The assigned recipe tag must have the data type of a number. The tag 
value must be within the range of values of the text list.    

Default value This is used as the default entry when you create a new recipe data 
record.

Minimum value [fixed] The smallest representable value of a number-based recipe tag, 
depending on the type of data.

Maximum value [fixed] The largest representable value of a number-based recipe tag, 
depending on the type of data.

Decimal places Determines how many places a decimal number is rounded to, e.g. 3 
decimal places and vice versa by what power of ten an integer value 
is multiplied, e.g. 1,000. 

Tooltip Tooltip about the recipe element which is shown to the operator in 
Runtime.

Recipe data record settings
You can make the following settings on the "Data records" tab:

Setting Description
Name of the recipe data 
record

Identifies a recipe data record uniquely within the recipe. 

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Assign meaningful names or 
product numbers which the operator can associate directly with a 
product, e.g. "yellow fruit juice E231".

Recipe data record number Identifies a recipe data record uniquely within the recipe.
Recipe elements 1 to n You can store various values for each recipe element even during 

configuration. Together with the values of the other recipe elements, a 
value always forms a recipe data record. You can store multiple recipe 
data records.
If enabled in the transfer settings, the recipe data records are 
transferred to the HMI device when downloading the project and 
existing data records on the HMI device are overwritten. 

Comment Comment about the recipe data record
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10.5.2 Displaying and Editing Recipes in Runtime

10.5.2.1 Recipe screen and recipe view
You can display and edit recipes on the HMI device with a recipe view or recipe screen.   

Recipe view
The recipe view is an off-the-shelf WinCC display and operator control object.

The recipe view is available in the following views: 

● As anvanced recipe view

● As simple recipe view
 

  Note
Availability

In basic panels and OP77A, TP177A, only the simple recipe view is available.
 

Recipe screen
The recipe screen contains an individual screen form for entering the recipes. The screen form 
contains I/O fields and other display and operator control objects. The recipe functionality is 
implemented with system functions, e.g. for saving recipe data records.

 

 Note
Availability

In basic panels and OP73, OP77A, TP177A (Portrait), the recipe screens are not available.
 

10.5.2.2 Simple recipe view

Recipe view  
The simple recipe view is a ready-made display element and operator control that is used to 
manage recipe data records. The recipe view shows recipe data records in tabular form. 

The displayed buttons and information in the columns are adjustable.

The values displayed or entered in the recipe view are saved in recipe data records. The 
displayed recipe data record can be written into the PLC by buttons or values can be read in 
from the PLC. 
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Layout of the display   
The simple recipe view consists of three areas:

● Recipe list

● Data record list

● Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on 
the configuration, the simple recipe view starts with the recipe list.

The figure below shows an example of the data record list.

Display of values  
 

 Note
Processed recipe data record is changed in the background  

Only applies for Basic Panels: if an operator has changed a recipe data record and a PLC 
job wants to read or write any recipe data record of this recipe, the PLC job is stopped and 
a system alarm is output. On the other hand, the changed value is displayed immediately if 
only the PLC job and no operator has changed recipe data.

Does not apply for Basic Panels: If an operator has changed a recipe data record and a PLC 
job has changed the values of the recipe data record concerned, the recipe view is not 
updated automatically. To update the recipe view, reselect the respective recipe data record.

 

See also
Recipe view (Page 3125)
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10.5.2.3 Configuration options of the simple recipe view
The response of the simple recipe view can be defined in the recipe view inspector window.

 

 Note
Validity

Some devices, for example basic panels, only support the simple recipe view.

For all other devices, observe the following:
● In the Inspector window, under "Properties > Display > Mode", select "Simple view" as 

"View type".
● The "Properties > Simple view" area contains additional properties only applicable to the 

simple recipe view.
● All other properties are also applicable to the advanced recipe view.

 

Displaying recipe data record values only
To display the recipe data in a recipe view for checking only, proceed as follows: 

1. Deselect "Edit mode" in the "General" group.

You cannot create, rename, edit or delete recipe data.  

Writing a recipe data record number or name to a tag
A tag to each recipe data record can be configured in the advanced recipe view. Depending 
on the "String" or "Int" data type of the tag, the name or number of the recipe data record is 
stored in the tag. Conversely, the tag can also be used to select a recipe data record by entering 
the corresponding value. For example, the tag can be transferred as a parameter for a system 
function. 

Proceed as follows:     
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1. Enter a tag of the "Int" type in the field "Tag", under "Properties > General > Recipe data 
record".

The number of the recipe data record is stored in a tag.

Configuring an event on the recipe view    
 

 Note
Events and buttons

The "Events" register is faded out when a minimum of one button is enabled.
 

To configure an event for the recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. Deactivate all buttons under "Properties > Toolbar" and "Properties > Simple view".

3. In the Inspector window, under "Properties > Events", click the event to be configured, e.g. 
"Enable".

4. Configure a function list for the event.

The function list is processed when the operator enables the recipe view.
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Animation properties of the recipe view    
To configure an animation of a recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. Click under "Properties > Animations" in the Inspector window.

3. Link a tag to one or more of the following properties.

– X-Position and y-Position

– Design: Colors, flashing

– Operability

– Visibility
In the "Animations> Overview" area, all animations are summarized in tabular form. 
Under "Animations> Tag links > Tag linkage", as well as visibility and position a tag can 
also be linked to height and width.

 

  Note
Animations and buttons

If all buttons are not disabled, an error message appears whilst compiling the project 
for windows-CE HMI devices.

 

Constraints on the simple recipe view  
The following functions are not possible in the simple recipe view:

● Synchronizing recipe view and recipe tags

● Writing a recipe number / name to a tag

● Display status bar
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● Display data record number

● Display label

● Display table

10.5.2.4 Advanced recipe view

Recipe view  
The advanced recipe view is an off-the-shelf display and operator control object that is used 
to manage recipe data records. The recipe view shows recipe data records in tabular form. 

The buttons, headers and information displayed in the columns are variable.

The values displayed or entered in the recipe view are saved in recipe data records.

Layout of the display   
The picture below contains an example of the advanced recipe view:

Display of values  
 

 Note
Changing the recipe data record in the background  

Applies to the processing of a recipe data record: 
If values of the corresponding recipe data record are changed by a control job, the recipe 
view is not updated automatically. 

To update the recipe view, reselect the respective recipe data record.
 

Visualizing processes (Comfort/Advanced)
10.5 Working with recipes

WinCC Comfort/Advanced V12.0 SP1
3412 System Manual, 07/2013,  



See also
Recipe view (Page 3125)

10.5.2.5 Configuration options of the advanced recipe view
The response of the advanced recipe view in the recipe view inspector window can be 
determined.

 

 Note
Validity

The following description also applies to the advanced recipe view. In the Inspector window, 
under "Properties > Display > Mode", select "Advanced view" as "View type".

All properties described for the simple recipe view are also applicable in the advanced recipe 
view, except "Properties > Simple view". The "Simple view" area contains additional 
properties only applicable to the simple recipe view.

Basic Panels, OP77A and TP177A (Portrait) do not support any advanced recipe view.
 

Displaying a recipe
To allow access to the recipe data records of a specific recipe only in a screen, proceed as 
follows:  

1. Enter the recipe or select an existing recipe in the "Recipe" field, under "Properties > 
General".

2. When a recipe is entered in the "Recipe" field, you will have to enable the "Selection list" if 
you want to display the recipe name in Runtime.

The selected recipe appears in the recipe view.
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Writing a recipe number or name and recipe data record number or name to a tag
Both the recipe and the recipe data record can each be configured to a tag in the recipe view. 
Depending on the "String" or "Int" data type of the tag, the name or number of the recipe or 
recipe data record is stored in the tag. Conversely, the tag can be used to select the recipe or 
recipe data record by entering the corresponding value. For example, the tag can be 
transferred as a parameter for a system function. 

Proceed as follows:     

1. Enter a tag of the "String" type in the field "Recipe tag", under "Properties > General > 
Recipe".

2. Enter a tag of the "Int" type in the field "Tag", under "Properties > General > Recipe data 
record".

The name of the recipe and the number of the recipe data record are each stored in a tag.

Using the recipe view as a drop-down list  
To use the recipe view as a selection field for recipes and recipe data records in a recipe 
screen, proceed as follows:

1. Select the tag for the recipe name under "General > Recipe > Recipe tag".

2. Select the tag for the recipe data record name under "General > Recipe data record >Tag".

3. Disable the "Edit mode". You cannot create, rename, edit or delete recipe data.

4. In order to select recipes, enable "Show selection list" and make sure that no recipe is 
selected under "Properties > General > Recipe".

5. Deactivate all buttons under "Properties > Toolbar".
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Configuring an event on the recipe view    
To configure an event on the recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. In the Inspector window, click the event you want to configure under "Properties > Events".

3. Configure a function list for the selected event.

The function list is processed when the configured event occurs.

10.5.2.6 Response of the recipe view in Runtime

Screen change
If you change to another screen and have not yet saved changes to the recipe data in the 
recipe view, you will be prompted to save the recipe data. The recipe name and the name of 
the recipe data record are displayed to show which recipe data have not been saved yet.  

Create, change, copy or delete recipe data records
If you attempt to create a new recipe data record and a recipe data record already exists, a 
system alarm will appear on screen. 

Operating the recipe view with function keys
The Recipe view can be operated with function keys, e.g. if the HMI device does not have 
touch functionality. You can assign functions such as "SaveDataRecord" to the function keys 
on the HMI device.  

Display after import of recipe data
 

 Note
Availability

Import and export of recipe data is not available for Basic Panels and OP77A, TP177A 
(Portrait).

 

If you open the recipe view during the import of recipe data, only the recipe data that is already 
completely imported will be displayed. The recipe view is not automatically updated with a data 
import. In order to have a complete view of all the recipe data, do not open the recipe view 
until the system prompts you that the recipe data has been imported successfully. Alternatively, 
update the recipe view after successful completion of the import procedure.

Visualizing processes (Comfort/Advanced)
10.5 Working with recipes

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3415



Updating tag for recipes and recipe data records
 

 Note
Availability

Tags for recipes and recipe data records are not available for Basic Panels and OP77A, 
TP177A (Portrait).

 

The current recipe data record or its number can be saved to a tag, depending on the 
configuration. The tag will be updated under the following conditions:

● The recipe data record has been loaded.

● The screen with the recipe view was not exited during loading.

This operation may take some time.  

10.5.2.7 Basics on the recipe screen

Introduction
The recipe screen contains an individual screen form for entering the recipes. The screen form 
contains I/O fields and other display and operator control objects. The recipe functionality is 
implemented with system functions, e.g. for saving recipe data records.

The picture below contains an example of a recipe screen:

 

 Note
Availability of recipe screens

Basic Panels and OP73A, OP77A, TP177A (Portrait) do not support any recipe screens.
 

Visualizing processes (Comfort/Advanced)
10.5 Working with recipes

WinCC Comfort/Advanced V12.0 SP1
3416 System Manual, 07/2013,  



Principle
Configuring a recipe screen allows you to customize the display. You can spread large recipes 
over several screens according to topic and display them clearly using features such as 
graphical display and operator control objects.

● Spreading recipes over several screens according to topic

– You can distribute recipe data records with multiple entries across several screens. For 
example, for each plant area you can configure a screen containing the associated 
screen forms for the recipe data records.

Spreading recipes over several screens is useful for HMI devices with small displays as 
they avoid having to scroll through tables in Runtime. 

● Visual machine simulation
You can visually simulate your machine in a screen using graphical screen objects. This 
enables you to display parameter settings more clearly by positioning I/O fields immediately 
next to machine elements such as axes or guide rails. which produces a direct relationship 
between the values and the machine.  

Synchronizing recipe values     
To enter recipe data record values outside the advanced recipe view in the configured I/O 
fields, activate "Synchronize recipe view and recipe tags" under "Properties > Synchronization" 
in the recipe properties.

The "Synchronize recipe view and recipe tags" option is not available for the simple recipe 
view.

Transferring recipe values automatically     
If the entered recipe values must be immediately transferred to the connected PLC in Runtime, 
deactivate "Manual transfer of individual modified values (teach-in mode)" under "Properties 
> Options". 

Configure the "SetRecipeTags" system function if you want to enable and disable the 
immediate transfer of entered recipe values in Runtime.
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System functions
The following system functions are available for operator control of a recipe screen:

● ImportDataRecords

● ExportDataRecords

● LoadDataRecord

● SaveDataRecord

● SetDataRecordTagsToPLC

● GetDataRecordTagsFromPLC

The following system functions are available for operator control of the recipe view when it is 
being used in the recipe screen:

● RecipeViewSaveDataRecord

● RecipeViewSaveAsDataRecord

● RecipeViewSynchronizeDataRecordWithTags

● RecipeViewDeleteDataRecord

● RecipeViewNewDataRecord

● RecipeViewGetDataRecordFromPLC

● RecipeViewRenameDataRecord (for simple recipe view only)

● RecipeViewShowOperatorNotes

● RecipeViewMenu (for simple recipe view only)

● RecipeViewOpen (for simple recipe view only)

● RecipeViewBack (for simple recipe view only)

The system functions for loading, saving and transferring recipe data records and recipes are 
located in the "Recipes" group. 

10.5.3 Configuring Recipes

10.5.3.1 General configuration procedure
Carry out the following configuration steps when you create a new recipe:

Step Description
1 Define the structure of the recipe.
2 Create tags according to the recipe structure. 

Assign process names to these tags.
3 Create the recipe.
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Step Description
4 Enter the required properties for the recipe:

● Language-dependent view name of the recipe
● "Coordinated transfer of data records" option
Not for Basic Panels:
● Recipe storage location
● "Synchronize recipe view and recipe tags" option
● "Manual transfer of individual modified values (teach-in mode)" option

5 Create the recipe elements and enter the required properties:
● Language-dependent view name of the recipe elements
● Tag binding of the recipe elements
● Standard values and decimal places (power of ten) for the recipe elements

6 Create the recipe data records.
Enter the language-specific display names for the recipe data records.

7 Configure a screen with recipe view or a recipe screen.
 

 Note
Basic Panels and OP77A, TP177A (Portrait)

The selection of the storage location is not available for these devices. The recipes are always 
saved in the internal Flash memory.

Recipe tags cannot be used outside a recipe, e.g. not in I/O fields, not in alarms as trigger 
tags, not in systems functions as parameters, etc.

 

 Note
Restrictions recipe view and recipe image

Only the simple recipe view is available in Basic Panels and OP77A, TP177A. Recipe images 
are not available in Basic Panels and OP73, OP77A, TP177A (Portrait).

 

10.5.3.2 Creating and Editing Recipes

Creating a new recipe

Introduction
To create a complete recipe, start by creating a new recipe, assign the corresponding recipe 
elements and then define the associated values in a recipe data record.

Requirement
● The tags for the recipe have been created.

● The "Recipes" editor is open.
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Create recipe
Create a recipe as follows:

1. Click "Add" in the first free row of the table in the "Recipes" editor.     
The new recipe is created and displayed on a line.

2. Enter a descriptive name for the recipe under "Name" in the "General" area.
This name identifies the recipe unambiguously within the project.

3. Select "Display name" to enter the language-specific name to be displayed in runtime.

4. Select a recipe number in "Number".
The number identifies the recipe unambiguously within the HMI device.
The recipe is automatically assigned a version that indicates the date and time of the last 
change. As an alternative, you can enter specific information relating to the recipe.

5. Specify the storage location for recipe data records in "Data medium". The options offered 
depend on the specific HMI device used.

 

  Note
Basic Panels and OP77A, TP177A (Portrait)

The selection of the storage location is not available for these devices. The recipes are 
always saved in the internal Flash memory.

Recipe tags cannot be used outside a recipe, e.g. not in I/O fields, not in alarms as trigger 
tags, not in systems functions as parameters, etc.

 

6. Enter a tooltip that is shown to the operator in runtime.
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7. To compare recipe tags which are configured in I/O fields with the recipe view in Runtime, 
activate "Synchronize recipe view and recipe tags" in the Inspector window under 
"Properties > Synchronization".

 

  Note
Basic Panels and OP77A, TP177A (Portrait)

Because the recipe tags cannot be additionally used in I/O fields in screens for Basic 
Panels, the "Synchronize recipe view and recipe tags" is not available; you will also not 
be able to use the "Manual transfer of individual modified values (teach-in mode)" option.

 

8. Deactivate "Manual transfer of individual modified values (teach-in mode)" to specify that 
the recipe tags are automatically transferred to the PLC when editing the I/O fields.

9. Activate "Coordinated transfer of data records" to monitor the transfer of recipe data in 
Runtime using area pointers.

10.Select the appropriate connection to the PLC for coordinated transfer under "Synchronize 
with".

Create recipe element
To create recipe elements, proceed as follows:

1. Click the "Elements" tab.

2. Click "Add" in the first free line of the table editor.
A new recipe element is created.

3. Enter a descriptive name for the element under "Name".
The name identifies the element uniquely within the recipe.

4. Enter a language-specific display name for the element under "Display name".
The display name appears in the recipe view, for example, in runtime.
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5. Select the tag you want to link to the recipe element under "Tag".
The value of the recipe data element is saved in Runtime in this tag, which is stored in a 
recipe data record.

6. Enter a tooltip.
The tooltip is shown to the operator in Runtime.

7. Under "Default value", enter the value that you want to use as the default entry when you 
create a new recipe data record.

8. To assign text to a value or range of values, select the relevant text list here. The assigned 
recipe tag must have the data type of a number. The tag value must be within the range of 
values of the text list.
The text stored in the text list is displayed in an output field, for example, in Runtime.

9. Determine exactly how many places a decimal number is rounded to in the "Decimal places" 
column, e.g. 3 decimal places and vice versa by what power of ten an integer value is 
multiplied, e.g. 1,000.
Examples for 3 decimal places: Entering "5" for a recipe element with the "Integer" data 
type gives the value "5000". Entering "5.6789" for a recipe element with the "Real" data 
type gives the value "5.679".

10.Create as many recipe entries as needed for the recipe. The maximum number of recipe 
entries possible depends on the HMI device being used.
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Create recipe data record with known recipe values
To create recipe elements, proceed as follows:

1. Click the "Data records" tab.

2. Click "Add" in the first free line of the table editor.
A new recipe data record is created. The recipe data record has a separate column for 
every recipe element created in the recipe.

3. Enter a descriptive name under "Name".
The name identifies the data record uniquely within the recipe.

4. Enter a language-specific name under "Display name".
The display name appears in the recipe view, for example, in runtime.

5. Enter a recipe data record number under "Number".
The recipe data record number identifies the recipe data record uniquely within the recipe.

6. If you already know the recipe values at the configuration stage, you can enter the relevant 
value for each recipe element.

7. Create as many data records as you need for the recipe.
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Enter the values in runtime
The following options are available for entering values in the recipe data records at runtime:

● Transfer data directly from the PLC (Teach-in mode)

● Import of values from a CSV file

● Input values on the HMI device
 

  Note
Basic Panels and OP77A, TP177A (Portrait)

The import of values is not available for these devices.
 

Result
The complete recipe is configured. 

Recipe data records with date or time stamp
If you use date or time data, make sure that the system setting for time and date on the 
configuring computer match those on the target system.  Example: You load a recipe data 
record on the target system at 13:55 in which 14 h is stored as the processing time. If it is 
already 14:05 on the target computer, the recipe will not be processed. If an operator processes 
the recipe, change information will not written back correctly into the database. 

After loading to the target system, check the recipes with date or time stamps on the target 
system.

Editing a recipe

Purpose
You want to modify, extend or delete parts of a recipe. 

Requirement
● You have created at least one recipe.

● The "Recipes" editor is open.

Changing recipe settings
To change the recipe settings, proceed as follows:

1. Select the recipe that you want to change in the "Recipes" editor.
The Inspector window opens.

2. Change the recipe configuration in the Inspector window.

You change recipe elements and recipe data records in the same way.
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Change recipe values
To change recipe values, proceed as follows:

1. Select the recipe whose values you want to change.

2. Click the "Data records" tab.

3. Enter the new values in the value columns.

Adding a recipe element
To add more recipe elements to a recipe, proceed as follows:

1. Select the recipe to which you want to add more elements in the "Recipes" editor.

2. Click the "Elements" tab.

3. Click "Add" in the first free line.
The recipe element is created.

4. Configure the recipe element.

You add recipe data records in the same way.

Managing recipes

Requirement
● You have created a recipe with recipe elements and recipe data record.

● The "Recipes" editor is open.

Renaming recipes
We distinguish between internal names and display names for recipes, recipe entries and 
recipe data records.

To rename recipe elements, proceed as follows:

1. Select the recipe that you want to rename.
The Inspector window opens.

2. Select the "Rename" command from the shortcut menu.

3. Enter the new name.
You rename recipe elements and recipe data records on the relevant tab in the same way.

 

  Note

The view names in the "Recipes" editor can also be renamed under "Languages & 
Resources > Project Texts". This possibility is useful when you have already configured 
in several languages for example.
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Copying and pasting recipes
To copy and paste recipes, proceed as follows:

1. Select the recipe that you want to copy.

2. Select the "Copy" command from the shortcut menu.

3. Select the "Paste" command from the shortcut menu in the first free table row.

The copied recipe is pasted into the table. The recipe elements and recipe data records are 
also copied in the appropriate tab with the recipe.

You also copy the recipe elements and recipe data records on the appropriate tab in the same 
way.

If a recipe data record of the same name already exists, the name of the copied recipe data 
record is extended by one digit. This ensures that the name is unique. Recipe data records 
can only be copied or pasted within the same recipe.

Deleting a recipe
To delete a recipe, proceed as follows:

1. Select the recipe that you want to delete.

2. Select the "Delete" command from the shortcut menu.
The recipe is deleted.

You delete recipe elements and recipe data records on the relevant tab in the same way.
 

 Note

When a recipe is deleted, the recipe data records contained in the recipe are also deleted.
 

 Note

When you delete a recipe element, the associated values in the recipe data records are also 
deleted. The assigned tags are retained.
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10.5.3.3 Configuring the display of recipes

Configuring the simple recipe view

Requirement
● The recipe has been created.

● The "Screens" editor is open.

● The screen has been created and opened.
 

 
 NOTICE

Data loss with several recipe views in the screen

Applies only to Basic Panels, OP73, OP77A, TP177A and TP177A (Portrait): If two or 
more recipe views show the same recipe in a screen, you have a conflict when accessing 
the data.

The result is data loss and unpredictable status of recipe data.

Make sure the operators do not select and edit the same recipe in different recipe views. 
● Display only one recipe in a recipe view.
● Display a different recipe in each recipe view.

 

Procedure
To configure a simple recipe view, proceed as follows:

1. Paste the recipe view into the screen. You will find the recipe view under "Controls" in the 
"Tools" task card.    

2. Only in devices which also support the extended recipe view: Activate "Simple view" under 
"Properties > Display > Mode".
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3. If you want to display only the recipe data records of a specific recipe in the recipe view, 
select the specific recipe under "Properties > General > Recipe".

4. If you only want to display the recipe data in the recipe view, deactivate "Processing mode" 
in the "Recipe data record" area.

5. You can define additional options for the recipe view under "Properties > Appearance" and 
"Properties > Layout".
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6. Select "Properties > Simple view" to select the position, the field length, and the number of 
lines required.
Select "Position > Top" to display the recipe value in the first line of the recipe entry.
Select "Position > Bottom" to display the recipe value in the last line of the recipe entry. 

7. Under "Properties" > Toolbar" specify which menu commands are available in the recipe 
view in Runtime.

Result
The simple recipe view is configured. You can use the recipe view to display and edit recipe 
data during runtime.

Deactivation of the editing mode in "Properties > Properties > General" has no impact on the 
toolbar icons. The buttons you activated in "Properties > Toolbar" can still be used even if 
editing mode is disabled.
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Configuring the Advanced Recipe View

Requirement
● The recipe has been created.

● The "Screens" editor is open.

● The screen has been created and opened.

Procedure
To configure an advanced recipe view, proceed as follows:

1. Paste the recipe view into the screen. The recipe view is found in the task card "Tools" > 
"Controls".    

2. Select "Properties > Display > Mode > Advanced view" in the Inspector window.

3. Select the required settings from the "General" group in the Inspector window.

– If you want to display only the recipe data records for a particular recipe in the recipe 
view, select the recipe under "Recipe" in the "Recipes" area.

– If you want to save the recipe name or the recipe number in a tag, select the tag under 
"Recipe tag" in the "Recipe" area.

– If you want to save the recipe data record name or number in a tag, select the tag under 
"Tag" in the "Recipe data record" area.

– If you only want to display the recipe data in the recipe view, deselect "Edit mode".

– If you only want to use the recipe view to select recipes, disable "Display table" under 
"Properties > Table".

4. You can define additional options for the recipe view under "Properties > Appearance" and 
"Properties > Layout".
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5. If you want to change the label in the recipe view, enter a suitable text under "Properties" 
> "Label".

6. Under "Properties" > Toolbar" specify which buttons are available in the recipe view in 
Runtime.

 

  Note

If you select the "Edit" command in the context menu of the recipe view, the recipe view 
becomes active. To activate the recipe view, the zoom factor must be set to 100%.

You can set the column width and the position of the "Entry name" and "Value" columns 
in active mode.

 

Result
The recipe view is configured. You can use the recipe view to display and edit recipe data 
during runtime. 

Deactivation of the editing mode in "Properties > Properties > General" has no impact on the 
toolbar icons. The buttons you activated in "Properties > Toolbar" can still be used even if 
editing mode is disabled.

Configuring a recipe screen

Introduction
The recipe screen is a screen in which you configure a customized screen form in the "Screens" 
editor. You create the screen form from input/output fields and other display and operator 
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control objects. System functions are used to configure the recipe functionality, such as saving 
recipe data records.    

 

 Note
Availability

Recipe screens cannot be created for basic panels and OP73, OP77A and TP177A (Portrait).
 

Application
You can spread recipe data records containing lots of entries across several screens. For 
example, for each plant you can configure a screen containing the associated screen forms 
for the recipe data records.

You can visually simulate your machine in a screen using graphical screen objects. This 
enables you to display parameter settings more clearly by positioning I/O fields immediately 
next to machine elements, such as axes or guide rails. You can use this to produce a direct 
reference between the values and the machine.

Requirement
● You have created the recipe.

● The "Screens" editor is open.

Procedure
To configure a recipe screen, proceed as follows:

1. Configure the screen and create the I/O fields for the input mask of the recipe.
You can create multiple screens to suit the size and complexity of the recipe.

2. Configure the I/O fields with the tags you have linked to the recipe element.

3. Configure I/O fields for selecting recipes and recipe data records.

Alternatively:

1. Configure a recipe view as a selection list for recipe data records and recipes.

2. Hide the buttons that are not required in the recipe view.

3. Configure the system functions for editing recipe data records on the configured control 
elements.
Control elements are configured buttons in the screen or function keys on the HMI device.
You will find the system functions for editing recipe data records under "Recipes" and 
"Keyboard operation for screen objects".

Result
The recipe screen is created.
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10.5.3.4 Importing recipes into the configuration and exporting them

Introduction
You can export recipes as a CSV file and import them again into the configuration. 

Application case
Recipe data is exported for long-term storage and backup on a computer. 

In order to unify and distribute recipe data, export the recipe data to an HMI device. Change 
the CSV file in Microsoft Excel and import the CSV file to all HMI devices that require the same 
recipe data.

You want to exchange recipe data between different projects. You change the recipe data in 
Runtime. To transfer the modified recipe data to WinCC ES, export the recipe data records in 
Runtime and copy the CSV file to the configuring computer. There you import the CSV file 
containing the recipe data records into the recipe. And in the opposite direction, you transfer 
the modified recipe data records to the HMI device in WinCC ES in Runtime.

Requirement
● You have created the recipe.

● The structures of the exported CSV file and the recipe in WinCC ES match; name, number 
and data type of the recipe elements are identical. 

● The "Recipes" editor is open.
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Importing CSV files
To import recipe data records into a recipe, proceed as follows:

1. Select the row which contains the desired recipe in the "Recipes" tab.

2. Select the "Import recipe data" command from the shortcut menu.
The "Import" dialog box opens.

3. To select the desired CSV file, go to "File name".

4. Under "Strategy", specify whether a recipe data record with the same recipe number in 
WinCC ES should be overwritten.

5. Specify the list separator and decimal separator under "Data separation". The list separator 
separates individual recipe elements in the CSV file. The decimal separator separates 
integers and decimal places.

 

  Note

Use the same list separator for import as in the CSV file for export.
 

6. Click "Import" to start the operation.

Result
The recipe will be amended by recipe data records from the CSV file that have not yet been 
entered. If the option is selected, existing recipe data records will be overwritten.

An error message is shown in the "Info" of the Inspector window if the structure of the recipe 
does not match the structure of the CSV file.
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Exporting CSV files  
1. Select the row which contains the recipe to export in the "Recipes" tab.

2. Select the "Export recipe data" command from the shortcut menu.
The "Export" dialog box opens.

3. Under "File name", specify the path of the CSV file.

4. Select all recipe data records under "Selection content", or restrict the selection to specific 
record numbers of the recipe data.

5. Specify the list separator and decimal separator under "Data separation". The list separator 
separates individual recipe elements in the CSV file. The decimal separator separates 
integers and decimal places.

6. Click "Export" to start the operation.

Result
The configuration is exported as a CSV file. 
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10.5.4 Using Recipes in Runtime

10.5.4.1 Simple recipe view

Description of the simple recipe view

Layout
The simple recipe view consists of the following display areas:     

● Recipe list

● Data record list

● Element list

This application is illustrated below:

In the simple recipe view, each area is shown separately on the HMI device. You can use the 
shortcut menu to operate each of these display areas.

The simple recipe view always begins with the recipe list.

Operation     
You have the following options for using the simple recipe view, according to the configuration:

● Create, change, copy or delete recipe data records

● Read recipe data records from the PLC or transfer to the PLC

Using the display area and shortcut menu
Toggle between the display areas and the shortcut menus to operate the simple recipe views.

The table below shows the operation of the display area.

Button Key Function
 <Enter> The next lowest display area is opened, i.e. the data record 

list or the element list.
<Esc> The previous display area opens. 
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Button Key Function
 <INS> Creates a new data record for the selected recipe if the list 

of recipes or recipe data records is displayed. Then changes 
to the list of recipe element.
Requirement: "Properties >General > Processing mode" is 
activated.
The button can be simulated with the "Key 
SimulateSystemKey" function even on devices without keys.

 <DEL> Deletes the selected recipe data record in the list of recipe 
data records.
Requirement: "Properties >General > Processing mode" is 
activated.

 <Up>/<Down> Selects the previous/next entry.
 <Pg Up>/<Pg Down> Moves the display up or down one page.
 <Home>/<End> Selects the first/last entry. The first/last entry is selected.

The table below shows the operation of the shortcut menu:

Button Key Function
<Right> The shortcut menu of the display area opens.

<Esc> The menu is closed. 
The display area opens.

 Input of the number of 
the menu command

The menu command is executed.

Shortcut menus of the simple recipe view     
You can click the  button in each display area to call up a selection of commands. The 
command selection lists those commands that are available in the current display area. A 
number is assigned to each command. The command is executed when you enter this number. 
Alternatively select the command and press the <Return> key.     

Shortcut menus in the recipe list

Menu command Function
New A new recipe data record is created for the selected recipe.

If a start value is configured, it is displayed in the input field.
Display tooltip The tooltip configured for the recipe is displayed.
Open The record list of the selected recipe opens.
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Shortcut menus of the recipe data record list

Menu command Function
New Creates a new recipe data record.

If a start value is configured, it is displayed in the input field.
Deleting The displayed record is deleted.
Save as The selected data record is saved under a different name. A dialog box opens 

where you can enter the name.
Rename Renames the selected data record. A dialog box opens where you can enter 

the name.
Open The element list of the selected data record opens.
Previous The recipe list opens.

Shortcut menus of the recipe element list

Menu command Function
Save The selected data record with the recipe element is saved.
To PLC The displayed values of the selected data record are transferred from the 

HMI device to the PLC.
From PLC The recipe values from the PLC are displayed in the recipe view of the HMI 

device.
Save as The data record is saved under a new name. A dialog box opens where you 

can enter the name.
Display tooltip The tooltip configured for the recipe element is displayed.
Rename The selected recipe element is renamed. A dialog box opens where you can 

enter the name.
Previous The data record list opens.

Shortcut menus in the data record list
 

 Note
HMI device dependency

The following menu commands are configured in Basic Panels and in OP 77A, TP 177A, 
TP 177A (Portrait) and TB 177B.

 

Menu command Function
To PLC The displayed values of the selected data record are transferred from the 

HMI device to the PLC.
From PLC The recipe values from the PLC are displayed in the recipe view of the HMI 

device.
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Using the simple recipe view

Controlling the simple recipe view with mouse or touchpad
To control the simple recipe view with mouse or touchpad, proceed as follows:

1. Select the desired recipe from the recipe view.

2. Click the button.
The shortcut menu is opened.

3. Select the desired menu command.
The menu command is executed.

Controlling the simple recipe view with the keyboard
To control the simple recipe view with the keyboard, proceed as follows:

1. Press the <Tab> key until the simple recipe view is selected.

2. Select the desired recipe with the cursor keys.

3. Press <Right>.
The shortcut menu is opened.

4. Press the <Down> key until the desired menu command is selected.

5. Press <Enter> to confirm the command.

Key shortcuts for the simple recipe view
The following key shortcuts are activated for the simple recipe view in Runtime if "Activate 
keyboard operation" is enabled in the ES. 

Key shortcut Effect Menu command
<Insert> Generates a new recipe data record New
<Del> Deletes the recipe data record displayed. Delete

Managing recipe data records

Recipe data record administration
You have the following options for managing the simple recipe view, according to the 
configuration:

● Creating new recipe data records

● Copy recipe data records

● Edit recipe data records

● Delete recipe data records
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Creating new recipe data records
To create a new recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to create a new recipe data record.

2. Select the "New" command from the shortcut menu for the recipe list.
A new data record with the next available number will be created. 
The element list of the new recipe data record opens.

3. Enter values for the elements of the recipe data record.
The configuration data may already contain default values for the recipe data record. 

4. Select the "Save" command from the shortcut menu for the element list.
The dialog "Save as" opens.

5. Enter the name and number of the recipe data record.

6. Click the "OK" button.

Result
The new recipe data records will be saved to the selected recipe. If the recipe data records 
already exists, a system event will be output to the screen. 

Copying a recipe data record
To copy a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to copy an existing recipe data record.

2. On the HMI device, select the recipe data record of which you want to save a copy.

3. Select the "Save As" command from the shortcut menu for the data record list.
The dialog "Save as" opens. The recipe data record is automatically given the next free 
recipe data record number.

4. Under name, enter the name of the record.

5. Click the "OK" button.

Result
The recipe data record is stored under the new name.

Modify recipe data record
To change a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to edit an existing recipe data record.

2. Select the recipe data record that you want to edit on the HMI device.

3. Select the recipe data record.
The element list of the recipe data record is displayed.

4. Replace the old values with new ones.

5. Select the "Save" command from the shortcut menu for the element list.
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Result
The modified values are applied to the recipe data record.

Deleting a recipe data record
To delete a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device from which you want to delete an existing recipe data 
record.

2. Select the recipe data record that you want to delete on the HMI device.

3. Select the "Delete" command from the shortcut menu for the data record list.

4. Confirm this security prompt to delete the data record.

Result
The recipe data record is deleted. 

Read recipe data record from PLC

Introduction
In Runtime, you can change values directly in the plant that are also stored in recipes in the 
HMI device. This applies if a valve was opened further directly in the plant than was specified 
in the recipe. The values of the recipe data records saved in the HMI device possibly no longer 
match the values in the PLC.

You can read the values of the recipe tags from the PLC and write them to a recipe data record. 

The read values are written to the recipe data record that is currently displayed on the HMI 
device.

Procedure
To read a recipe data record from the PLC, proceed as follows:

1. Open the recipe on the HMI device.
The data record list opens.

2. Select the element list of the recipe data record to which you want to apply the values from 
the PLC.

3. Select the "From PLC" command from the shortcut menu for the element list.
The values are read from the PLC and displayed in the current recipe data record.

4. If you want to save the values, select the "Save" or "Save As" command.

Result
The values are read from the PLC, visualized on the HMI device and saved to the recipe data 
record. 
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Transferring a recipe data record to the PLC

Introduction   
For the values of a data record that was changed in the recipe view to take effect, you must 
transfer the values to the PLC.

The values displayed in the recipe view are always transferred to the PLC.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. Open the recipe you want to use.
The data record list opens.

2. Select the element list of the recipe data record whose values you want to transfer to the 
PLC.

3. Select the "To PLC" command from the shortcut menu for the element list.

Result
The values of the recipe data record are transferred to the PLC.

10.5.4.2 Advanced recipe view

Description of the advanced recipe view

Application
The recipe view is used to display, edit and manage data records.    
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Operation
Depending on the configuration you can:   

● Create, change, copy or delete recipe data records

● Synchronizing recipe data records with the associated recipe tags

● Read recipe data records from or transfer to the PLC

Operating elements
The following operating elements can be configured in the recipe view:   

Operating 
element

Key combination Function

 The configured tooltip is displayed.

<Ctrl+Space 
Bar>

Creates a new recipe data record.
If a start value is configured, it is shown in the input field.

<Ctrl+Enter> Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

<Ctrl+*> The recipe data record is saved under a different name regardless 
of the recipe view. A dialog box opens where you can enter the 
name.

<Ctrl+Del> The displayed recipe data record is deleted.

<Ctrl+=> The system always updates the current value of the recipe view 
with the up-to-date recipe tag value.
When the value shown in the recipe view is more recent than the 
current recipe tag value, the system writes this value to the recipe 
tag.
"Synchronize recipe view and recipe tags" must be activated in the 
recipe properties before this function can be used.

<Ctrl+Down> The values of the set recipe data record displayed in the recipe view 
are transferred to the PLC.

<Ctrl+Up> The recipe values from the PLC are displayed in the recipe view.

Using the advanced recipe view

Introduction
You can control the recipe view using both mouse or touchpad or with the keyboard.
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Controlling the recipe view with mouse or touchpad
To control the recipe view with mouse or touchpad, proceed as follows:  

1. Select the recipe you want to use.
The records for the recipe are displayed.

2. Click on the data record you wish to edit.

3. Click the button whose function you want to run.

Controlling the recipe view with the keyboard
To control the recipe view with the keyboard, proceed as follows:  

1. Press the <Tab> key until the cursor reaches the field for selecting the recipe.

2. Press <Enter>.
The drop-down list box for the recipes opens. 

3. Select a recipe. You navigate between the next or previous entry in the list by using the 
cursor keys <Left>, <Right>, <Up> and <Down>.

4. Select a data record.

5. Press the <Tab> key until the operator control object you wish to use is selected.

Alternatively you can control the recipe view using certain key combinations.

Key shortcuts for the advanced recipe view
The following key shortcuts are activated for the advanced recipe view in Runtime if "Activate 
keyboard operation" is enabled in the ES. 

Keys
shortcut

Effect Menu command Button

<Ctrl
+Space>

Generates a new recipe data record.
Any configured start value is displayed in 
the input field.

Add data record

<Ctrl+Del> Deletes the recipe data record displayed. Delete data record"
<Ctrl+Enter> Saves the edited data record by its current 

name.
Save

<Ctrl+*> Saves the edited data record by a new 
name.

Save as

<Ctrl+=> Compares the values of the selected data 
record with the values on the PLC.
Any value in the recipe view which is more 
recent compared to the current recipe tag 
value is written to the recipe tag.
This function is only available if enabled in 
the ES. 

Synchronizing recipe tags

<Ctrl+Down> Transfers the current value to the PLC. Write to PLC
<Ctrl+Up> Reads the actual value from the PLC. Read from PLC
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Managing recipe data records

Administration of recipe data records
You have the following options for managing recipe data records, according to the 
configuration:

● Create new recipe data records

● Copy recipe data records

● Edit recipe data records

● Delete recipe data records

Creating new recipe data records 
To create a new recipe data record, proceed as follows:      

1. Select the recipe on the HMI device in which you want to create a new recipe data record.

2. Click the  button or press the <Ctrl + Spacebar> keys.
A new recipe data record with the next available number is created.
If you change the new data record number to an existing data record number, the existing 
data record is overwritten.

3. Enter values for the elements of the data record.
The elements of the recipe data record can be assigned default values depending on the 
configuration.

4. Click the  button or press the <Ctrl + *> keys.
The dialog "Save as" opens.

5. Enter a name for the data record.

6. Click on "OK" to confirm your input.
The data record is saved under the new name. 
If the recipe data record already exists, a dialog is opened. In this dialog, specify whether 
the existing data record is to be overwritten.

Result
The new recipe data records will be saved to the selected recipe. If the recipe data records 
already exists, a system alarm will be output to the screen. 

Copying a recipe data record
To copy a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to copy an existing recipe data record.

2. Select the recipe data record that you want to copy on the HMI device.

3. Click the  button in the recipe view or press the <Ctrl + *> keys.
The dialog "Save as" opens.
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4. Enter a name for the data record.

5. Click on "OK" to confirm your input.

Result
The recipe data record is stored under the new name.

Modify recipe data record
To change a recipe data record, proceed as follows:            

1. Select the recipe on the HMI device in which you want to edit an existing recipe data record.

2. Select the recipe data record that you want to edit on the HMI device.

3. Replace the old values with new ones.

4. Click the  button in the recipe view or press the <Ctrl + Enter> keys.

Result
The modified values are applied to the recipe data record.

Delete recipe data record      
To delete a recipe data record, proceed as follows:            

1. Select the recipe on the HMI device in which you want to delete an existing recipe data 
record.

2. Select the recipe data record that you want to delete on the HMI device.

3. Click the  button in the recipe view or press the <Ctrl + Del> keys.

Result
The recipe data record is deleted. 

Synchronizing recipe data record

Introduction
Differences between the following values may occur during runtime:

● The values displayed in the recipe view

● The actual values of the recipe tags
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Depending on the configuration, the values displayed in the recipe view are synchronized with 
the recipe tags. Synchronization encompasses all tags of a recipe data record.

 

 Note
Changed tag name

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Requirement
● A recipe data record is displayed in the recipe view.

● The values of recipe tags were modified by teaching, for example.

Procedure
To synchronize a recipe data record, proceed as follows:

1. Click the  button in the recipe view or press the <Ctrl + => keys.

Result
The system always updates the current value of the recipe view with the up-to-date recipe tag 
value.

When the value shown in the recipe view is more recent than the current recipe tag value, the 
system writes this value to the recipe tag. 

Read recipe data record from PLC

Introduction
In Runtime, you can change values directly in the plant which are also stored in recipes in the 
HMI device. This applies if a valve was opened further directly in the plant than was specified 
in the recipe. The values of the recipe data records saved in the HMI device possibly no longer 
match the values in the PLC.

You can read the values of the recipe tags from the PLC and write them to a recipe data record. 

The read values are written to the recipe data record that is currently displayed on the HMI 
device.
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Procedure
To read a recipe data record from the PLC, proceed as follows:

1. Select the recipe on the HMI device.

2. On the HMI device, select the recipe data record of which you want to fetch the values from 
the PLC.

3. Click the  button in the recipe view or press the <Ctrl + Up> keys.

Result
The values are read from the PLC and displayed on the HMI device. 

Transferring recipe data records to the PLC

Introduction
For the values of a data record that was changed in the recipe view to take effect, you must 
transfer the values to the PLC.

The values displayed in the recipe view are always transferred to the PLC.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. Select the recipe on the HMI device.

2. On the HMI device, select the recipe data record of which you want to transfer the values 
to PLC.

3. Click the  button in the recipe view, or press the <CTRL+DOWN> shortcut key.

Result
The values of the recipe data record are transferred to the PLC. 
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10.5.4.3 Exporting and importing recipe data records

Introduction          
Depending on configuration and the HMI device, either export recipe data records to a CSV 
file, e.g. for editing in MS Excel, or import these from a CSV file. The extent to which you can 
influence these processes is determined by the project configuration. 

 

 Note
Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported using 
ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is interrupted.

 

A list separator is used to separate the data records during importing and exporting.
 

 Note

The list separator used as the default depends on the setting for formats and numbers in the 
operating system. Select "Start > Settings > Control Panel > Regional and Language 
Options". If you want to import or export recipe data records, do not use this list separator in 
the display name of the recipe data records.

 

The following fields can be configured on the user interface, for example, in order to use the 
export/import function:

● Selection field for the recipe

● Selection field for the recipe data record

● Operating element with the "ExportDataRecords" functionality

● Operating element with the "ImportDataRecords" functionality

Export recipe data record
To export a recipe data record, proceed as follows:

1. Select the relevant recipe and recipe data record from the selection boxes.

2. Click the control element with the "ExportDataRecords" functionality.
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Result
The recipe data record are exported to a CSV file. 

 

 Note

New data records created in runtime can be exported to an external file.
 

Importing recipe data records
To import a recipe data record, proceed as follows:

1. Select the relevant recipe and recipe data record from the selection boxes.

2. Click the control element with the "ImportDataRecords" functionality.

Result
The recipe data record are imported. 

10.5.4.4 Reactions to modifications of the recipe structure

Introduction
Different recipe structures can occur in the following situations:

● In the event of changes during commissioning

● When work is carried out on the machine by the machine manufacturer (retrofit)

● When CSV files are imported, the structure of the CSV file can differ from the recipe 
structure.

Nevertheless, you can still use any recipe data records already created.
 

 NOTICE

When a tag is renamed, the assignment is lost. 
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Effects
Handle any structural differences as follows:

● If the old recipe data record or the CSV file contains additional values, these values will be 
discarded.

● If the old recipe data record or the CSV file contains values of the wrong data type, the 
configured default value will be used in the recipe data record.
Example: The recipe data record contains values that show the tank contents and were 
input as floating point numbers. However, the corresponding recipe tag expects an integer 
value. In this case, the system discards the transferred value and the configured default 
value is used. 

● If the old recipe data record or the CSV file contains too few values, the configured default 
value will also be used in the recipe data record.

10.5.5 Examples

10.5.5.1 Example of creating a recipe

Task
In this example, you create three recipes for a fruit juice mixing machine. The fruit juice mixing 
machine produces drinks with "orange", "apple" and "tropical" flavors. You create a recipe for 
each flavor.

Each recipe contains a recipe data record for the following mixing ratios:

● Beverage

● Nectar

● Juice

Settings
The settings relate to an HMI device which is connected to a SIMATIC S7-300 or 
SIMATIC S7-400.

In this example, you will need the following tags, recipes, recipe entries and recipe data records:

Tags:

Name PLC connection Address Type
Liter water Yes DB 120, DBW 0 Integer
Liter concentrate Yes DB 120, DBW 4 Integer
Kilo sugar Yes DB 120, DBW 8 Integer
Gram flavoring Yes DB 120, DBW 12 Integer

Recipes:
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● Orange

● Apple

● Tropical

Recipe entries:

Recipe element Associated tag
Liter water Liter water
Liter concentrate Liter concentrate
Kilo sugar Kilo sugar
Gram flavoring Gram flavoring

Recipe data records for drink, nectar and juice:

Data record name Liter water Liter concentrate Kilo sugar Gram flavoring
Beverage 30 70 45 600
Nectar 50 50 10 300
Juice 5 95 3 100

Procedure
To create a recipe, proceed as follows:

1. Create the following tags with the settings specified above: "LiterWater", "LiterConcentrate", 
"KiloSugar" and "GramFlavoring".

2. Create the "Orange", "Apple" and "Tropical" recipes with the settings indicated above. 
Create the recipe entries in each recipe.
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3. Not for Basic Panels: Configure each recipe so that you can synchronize the recipe data 
records between the recipe screen and recipe view. The values of the recipe tags should 
not be transferred automatically to the PLC.
You will have to make the following settings in the Properties dialog for the recipe concerned:
Under "Properties > Options":

– Activate the "Synchronize recipe view and recipe tags" option.

– Activate the "Manual transfer of individual modified values (teach-in mode)" option.

4. Create the data records indicated above in each recipe. Enter the values indicated above 
in each of the data records.

Result
The "Orange", "Apple" and "Tropical" recipes have been created.

10.5.5.2 Example of configuring a recipe screen

Task
In this example, you create a recipe screen for the visualization of values of the fruit juice 
mixing machine. You use a recipe view to select the recipes and their associated recipe data 
records. 

You should be able to use the following functions with the buttons:

● "Load" Button
The selected recipe data record is loaded from the recipe memory on the HMI device and 
displayed in the recipe screen.

● "Save" Button
The displayed recipe tags are saved in the recipe memory of the HMI device.
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● "Data to PLC" button
The displayed tags are transferred to the PLC.

● "Data from PLC" button
The current recipe data record in the PLC is transferred to the recipe variables and 
displayed on the HMI device. 

Requirement
● The "Creating a recipe" sample application has been carried out.

● You have created and opened the "Fruit juice mixing plant" screen.

Settings
In this example, you need the following tags and buttons with the indicated settings:

Tags:

Name PLC connection Type
RecipeNumber No Integer
Data record number No Integer

Buttons:

Labeling Configured event System function
Load Click LoadDataRecord
Save Click SaveDataRecord
Data to PLC Click SetDataRecordTagsToPLC
Data from PLC Click GetDataRecordTagsFromPLC
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Procedure
To configure a recipe screen, proceed as follows:

1. Drag-and-drop the "Liter water", "Liter concentrate", "Kilo sugar" and "Gram flavoring" tags 
from the object view to the "Fruit juice mixing machine" process screen.
Four IO fields are created and linked by the specified tags. 

2. Add a recipe view containing selection fields for the recipe name and data record name 
only.
Make the following settings in the Inspector window for the recipe view:

– Select the "Advanced view" display type under "General".

– Deselect "Edit mode" under "Properties > General" and "Display table" under "Properties 
> Table".

– Connect the "Recipe tag" field to the "RecipeNumber" tag.

– Connect the "Tag" field to the "DataRecordNumber" tag.

– Disable all the buttons under "Properties > Buttons".

3. Assign the above settings to four buttons. Transfer each "Recipe number" and "Data record 
number" tag as a parameter for the recipe number and recipe data record number.

Result
You can select the recipe and the associated recipe data record from the recipe view and 
modify the recipe values at runtime. You can load, save and transfer the recipe data records 
using the buttons. 

10.5.5.3 Scenario for Entering Recipe Data Records in Runtime

Objective
You want to enter production data on the HMI device without disturbing the process that is 
currently underway. Therefore, the production data should not be transferred to the PLC. 

Requirement
● The recipe has been created.

● The recipe has the following settings:

– "Synchronizing recipe view and recipe tags" is activated or deactivated.

– If "Synchronize recipe view and recipe tags" is activated, "Manual transfer of individual 
modified values (teach-in mode)" has to be activated.
This will prevent the recipe tags being transferred automatically between the HMI device 
and PLC.

● A recipe screen or a screen with recipe view is available.

● There is an operating element for saving the recipe data records.
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Sequence

1. Enter the production data in the recipe view or recipe screen.

2. Save the modified recipe data record.

Transfer the recipe data to the PLC
The configuration may provide operating elements for transferring recipe data to the PLC.

10.5.5.4 Scenario for a manual production sequence

Objective
A reading device connected to the PLC reads a bar code on the work piece to be processed. 
The recipe data record names correspond to the respective bar code names. This will enable 
the PLC to load the necessary recipe data record from the storage medium of the HMI device. 
The recipe data record is displayed for inspection on screen. 

You want to be able to correct the transferred production data online, if necessary.
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Requirement
● You have created the recipe.

● The recipe has the following settings:

– "Synchronizing recipe view and recipe tags" is activated.

– "Manual transfer of individual modified values (teach-in mode)" is deactivated.
 

  Note

The changes are immediately transferred to the PLC
 

● There is a recipe screen available.
There may also be an operating element for saving the recipe data records in the recipe 
screen.

Sequence

Behavior when the recipe view is used
If the recipe view is used, it is not possible to transfer changes immediately. You must use the 
operating element to transfer the recipe data record to the PLC.
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10.5.5.5 Scenario for an Automatic Production Sequence

Objective
You want production to be executed automatically. The production data is to be transferred 
directly to the PLC, either from the recipe memory in the HMI device or from an external storage 
medium. The screen display is not necessary.

Requirement
● You have created the recipe.

● The recipe has the following settings:

– "Coordinated transfer of data records" is activated.
The production data is transferred to the PLC, so a coordinated transfer with the PLC 
in necessary to prevent the data from being accidentally overwritten.

Sequence

Implementation
You can control the flow of data in the following ways:

● The control program controls the automatic transfer via control jobs or via WinCC system 
functions, if necessary.
The sequence is controlled via the status information in the mailbox and via return values 
from the functions used.

● One or more scripts control the automatic transfer via WinCC system functions.
The sequence can be checked using the values returned by the functions used.
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You can implement the automatic production sequence with available system functions: 

● "ImportDataRecords"
This function loads data records from a *.CSV file into the recipe memory of the HMI device.

● "SetDataRecordToPLC"
This function transfers a data record from the HMI device's recipe memory to the PLC. 
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10.6 Working with reports

10.6.1 Basics

10.6.1.1 Reports

Introduction
Reports are used to record process data and processed production cycles. You have the 
opportunity, for example, to create regular shift reports, output batch data, or record the 
production process for quality control (QC).

Creating reports 
A report is created and edited in the "Reports" editor. In this editor, you configure the following 
report items:

● Formal appearance
Specify the formal layout of the report in the Inspector window.  In this window, for example, 
you specify the page format, page margins, title page, back page, headers, or footers for 
the report.

● Content
In the work area, specify the content of the report, for example, the alarms of a shift. To 
this purpose you insert the corresponding objects into the report.

The modular structure lets you configure reports that suit all of your applications. 
 

 Note

The "Reports" editor is not available at HMI devices that do not support reporting.
 

Report output
In runtime, the configured reports are printed on the default printer of the HMI device.

In runtime, report output is event or time-controlled.

● Time-controlled: Automatic print at specific dates, times or intervals.

● Event-driven: Printing is initiated by specific events, e.g. click on a button, or when a limit 
is exceeded.
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See also
Principles for preparation of reports (Page 3463)

Printing reports (Page 3468)

Structure of reports (Page 3461)

Inserting an object (Page 3469)

Printing reports (Page 3484)

Audit report (Page 3484)

10.6.1.2 Structure of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required. 
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Sections of a report
The following figure shows an example of the different sections of a report in the "Reports" 
editor.

Title page and back page     
The title page contains important information about the report content. The back page is used, 
for example, as Impressum, on which you provide contact information of shift managers or 
service technicians. The title page and back page are output separately on a single page. Each 
of them consist of exactly one page and page breaks are not used. 
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Detail page   
Configure the output of runtime data such as recipe or alarm reports on the detail pages of the 
report. 

Use the shortcut menu on the detail page to insert additional detail pages or change their order. 

Header and footer     
The header and footer are output on each detail page of the report. You typically insert the 
page numbers or the date in the header or footer. 

See also
Reports (Page 3460)

Principles for preparation of reports (Page 3463)

10.6.2 Working with reports

10.6.2.1 Creating reports

Principles for preparation of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required.

● Title page

● Back page

● Detail pages

● Headers and footers for the detail pages
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Procedure    
The following figure shows the general procedure for creating a report: 

1) Settings depend on the report object used. 

Tools for the design of reports
The tools that you can use to design reports are available in the "Tools" task card.

● For graphic design insert "basic objects", "elements" and "graphics" in the different sections 
of the report. For example, for a Logo in the header, separation lines and a page number 
in the footer.

● Using the "Controls" in the detail pages, configure the output of runtime data.
 

  Note

The "Screens" editor provides many objects for designing a report – however, with 
restricted functionality. Data input properties are not available. The I/O fields in the reports, 
for example, serve only to output data.
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Position and size of objects    
Insert the objects at the position where you want them to be output in the report.  The objects 
are output in their configured size and with the following special features: 

On the detail pages, configure "recipe reports" or "alarm reports" that serve to output runtime 
data in tabular format. 

● The width of the table is set up automatically to fit the width of the detail page. You cannot 
modify the width.

● WinCC automatically wraps the height of the table to fit the data content for output in the 
report. The table can be continued on the next page.
In the detail page, WinCC automatically extends tables of dynamic length to the bottom 
margin.

The following figure shows an example of a detail page in the report and its output in Runtime:

Detail page in the report Report output in Runtime

Additional detail pages   
Use the shortcut menu on the detail page to insert additional detail pages or change their order.

See also
Objects in reports (Page 3484)

Structure of reports (Page 3461)

Administration of detail pages (Page 3467)

Create a report 

Requirement
A project with an HMI device is open. 
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Procedure   
To create a report, proceed as follows:

1. Double-click "Add new report" under "Reports" in the project navigation.
A new blank report is displayed in the "Reports" editor. 

2. Select the "Report properties" command in the shortcut menu of the report.

3. In the "Properties > Properties > General" area of the Inspector window, specify whether 
you want to configure the "Title page", "Back page", "Header" and "Footer" in the report.
The report sections are updated accordingly.
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4. Configure the format, the page layout, and the page margins of the report under "Properties 
> Properties > Layout."

5. Enter a meaningful report name under "Properties > Properties > Miscellaneous."

6. Design the report sections as required. 
Drag and drop the necessary basic objects, elements, graphic images and controls from 
the "Tools" task card to the required position.
Alternatively, you can also copy or move objects already configured from a screen to the 
report. 

7. Configure the objects in the Inspector window: 

See also
Objects in reports (Page 3484)

Administration of detail pages

Adding a detail page    
1. Open the shortcut menu of a detail page.

2. Select the command "Pages > Insert page before" or "Pages > Insert page after."
Depending on the selected command, the new detail page is inserted either before or after 
the existing detail page.
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Deleting a detail page     
1. Open the shortcut menu of the detail page that you want to remove.

2. Select the command "Pages > Delete detail page".
The detail page is deleted. 

Sorting detail pages     
1. Open the shortcut menu of the detail page that you want to move.

2. Select the "Pages > Move one page up" or "Pages > Move one page down" command.
Depending on the selected command, the detail page is moved either upward or downward.

Showing and hiding sections    
1. To show or hide a specific section, click on the plus or minus sign in the title bar of the 

section in the working area. 

2. If you want to show or hide all sections of a report, select the command "Show all pages" 
or "Hide all pages" in the report shortcut menu.

See also
Structure of reports (Page 3461)

Principles for preparation of reports (Page 3463)

10.6.2.2 Printing reports

Introduction    
In Runtime, report output is event-driven or time-driven. 

Event-driven output   
The report is output after an event was generated.

Examples:

● A tag value changes or exceeds a limit.

● Alarm is incoming, outgoing or acknowledged

● Action by the operator, for example, clicking a button

Time-driven output   
The report is output automatically.

Examples:
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● Once at a specified date, e.g. on December 31, 2010

● At intervals, e.g. daily at 8 am, or on Mondays at 6 pm

Configuration steps  
Configuring event-driven output:

● An event is configured on a button or tag with the "PrintReport" system function.

Configuring time-driven output:

● In the scheduled tasks, configure a "Print job" task and assign it to the desired report.
In the task properties, specify the time and frequency of report output.

Output in Runtime
On the control panel of the HMI device, the report is output to the printer that is specified as 
the default printer. 

The default printer enabled for a HMI device can be found in the "Printer list". For further 
information about the "Printer list", refer to the Internet page of Siemens Customer Support 
and the Article ID "11376409".

See also
Planning jobs (Page 4900)

Printing reports (Page 3484)

10.6.2.3 Working with objects

Inserting an object

Introduction     
In the "Screens" or "Reports" editor, insert the objects to the "Toolbox" task card. Use the 
mouse to drag the objects into the work area. You either keep the objects in their original size, 
or scale them up or down when you paste them. 

In addition, you can copy or move objects via the clipboard from one editor to another, for 
example to transfer a screen object to a report. Alternatively, you can also use the mouse 
instead of the clipboard for copying and moving:

● Copying: <Ctrl + Drag&Drop>

● Moving: Drag&drop
 

  Note
Basic Panels

The "Reports" editor is not available for Basic Panels.
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Requirement
The "Tools" task card is open.

Inserting objects in their standard size
1. In the "Toolbox" task card, select the desired graphic object or the desired graphic in the 

WinCC graphics folder.
When you move the cursor across the work area, it turns into a crosshair with an appended 
object icon. 

2. Click the location in the work area where you want to insert the object or graphic.
The object is inserted with its standard size at the desired position in the work area. 

Alternatively, double-click the object in the "Toolbox" task card.

Copying an object
1. Select the desired object.

2. Select "Copy" in the shortcut menu.

3. Click the desired location and select "Paste" in the shortcut menu.

WinCC inserts a copy of the object at the desired location. You can only change the properties 
that are appropriate for the relevant context. 

Example: In the "Screens" editor, you can set for I/O fields and the mode for input and output. 
In the "Reports" editor, the mode is set to "Output". 

Original and copy are not interconnected and are configured independently from one another.

Inserting lines
1. Select the desired graphic object in the "Tools" task card.

2. Click on a location in the work area. A line in the standard size is inserted. 

Inserting a polygon or polyline
1. Select the desired object "Polyline" or "Polygon" in the "Tools" task card.

2. Click on a location in the work area. This fixes the starting point of the object.

3. Click another location in the work area. A corner point is set.

4. For every additional corner point, click on the corresponding location in the work area.

5. Double-click on a location in the work area. The last corner point is set.
This fixes all the points of the polygon or polyline.

 

  Note
Basic Panels

The "Polyline" and "Polygon" objects are not available for Basic Panels.
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 Note

If you want to insert several objects of the same type, use the "Stamp" function. This avoids 
having to reselect the object in the "Tools" task card every time before inserting it. To do so, 
select the  icon in the toolbar of the "Tools" task card.

 

 

See also
Deleting an object (Page 3471)

Inserting multiple objects of the same type (stamping tool)  (Page 3472)

Positioning objects (Page 3473)

Resizing objects (Page 3476)

Storing an object in a library (Page 5502)

Inserting a library object (Page 5502)

Moving an object forwards or backwards (Page 3475)

Flipping objects (Page 3483)

Reports (Page 3460)

Deleting an object

Introduction   
You can delete objects individually or with a multiple selection. 

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to delete.

To delete multiple objects, keep the <Shift> key pressed and select the objects to be deleted 
one after the other. Alternatively, drag and maximize an area around the desired objects 
with the mouse. 

2. Select "Delete" from the shortcut menu.

Result
The selected objects are deleted. 
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Inserting multiple objects of the same type (stamping tool) 

Introduction
WinCC offers the possibility to "stamp" several objects of the same type directly one after the 
other, i.e. paste without having to reselect the object every time. In addition you have the 
possibility of multiplying an object that has already been inserted.         

Requirement
The "Tools" task card is open.

Inserting several objects of one type
1. Select the object that you want to insert in the "Tools" task card.

2. Click the  icon in the toolbar of the "Tools" task card.
The "Stamp" function is activated.

3. To insert the object with its standard size, click the relevant insertion position in the work 
area.
To insert the object with another size, position the mouse pointer at the desired location in 
the work area. Press the left mouse button and drag the object to the required size.
The object is inserted in the work area as soon as you release the mouse button.

4. Repeat step 3 to insert further objects of the same type.

5. Click the  icon again.
The "Stamp" function is deactivated.

 

  Note

You can copy existing objects using the drag-and-drop +<CTRL> function. The existing 
object is not moved in this case. You paste a copy of this object into the new position 
instead.
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Inserting and multiplying an object
1. Insert the desired object from the "Tools" task card.

2. Press the <Ctrl> key and position the cursor on one of the handles displayed in the figure 
shown below.

3. Drag the handles to the right and/or down while keeping the left mouse button pressed.

4. The object is multiplied depending on available space if you keep moving the cursor.

Result
You have pasted and stamped an object in a screen.

Positioning objects

Introduction
When you select an object, it is enclosed by a rectangle with resizing handles. This rectangle 
is the rectangle which surrounds the object. The position of an object is defined by the 
coordinates of the top left corner of the rectangle surrounding the object.   
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 Note

If the position is outside the work area the object is not displayed in Runtime.
 

Position and align
You have the possibility of having a grid displayed in the work area. You have three options 
for easier positioning of objects:

● "Snap to grid" When you resposition objects, they are automatically snapped and pasted 
to the grid. If you hold down the <Alt> key, the object is no longer snapped to the grid.

● "Snap to objects" When you reposition objects, they are displayed with help lines. You can 
use other objects for orientation during positioning.

● "None": You position the objects in any position. 

You activate and deactivate the grid and options as follows: 

● In the "Options > Settings > Visualization > Screens" menu

● In the "Layout > Grid" task card

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object you want to move.

The selected object is framed by a rectangle with resizing handles.

2. Left-click the object and keep the mouse button pressed.

3. Move the mouse pointer onto the new position.
The contour of the object moves with the mouse and displays the new position for the object.

The object initially remains at its original position.

4. Now release the mouse button.
The object is moved into the position indicated by the contour of the selection rectangle.
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Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the X and Y values for the position under "Position & Size".

Result
The object appears at its new position. 

See also
Rotating objects (Page 3481)

Moving an object forwards or backwards

Introduction
You can use the "Order" functions in the shortcut menu of a selected object or in the toolbar 
to move a selected object in front of or behind other objects within an object layer.    

 

 Note

ActiveX controls are always positioned in front of an object layer (.NET property).
 

Requirement
You have opened a screen which contains a layer with multiple objects.

Procedure
1. Select the object you want to move forward or backward.

2. Select the "Sort" command and one of the following commands from the shortcut menu:

Icon Description
Moves the selected object before all the other objects of the same layer
Moves the selected object to the lowest position in the same layer
Moves the selected object up by one position
Moves the selected object down by one position

Alternative procedure
1. Open the "Layers" palette of the "Layout" task card.

2. Navigate to the required object.
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3. Hold down the mouse button, and drag the object in the tree topology to the required position 
in the layer.

4. Now release the mouse button.

Result
The object is moved up or down. 

See also
Inserting an object (Page 3469)

Resizing objects

Introduction
When you select an object, it is enclosed by a rectangle with handles. You have the following 
options of resizing an object: 

● Drag the handles using the mouse.

● Modify the "Size" property in the Inspector window.

Requirement
You have opened the work area containing at least one object.

Procedure     
1. Select the object you want to resize.

The selection rectangle appears. The following figure shows a selected object:

2. Drag a resizing contact of the rectangle to a new position.
The size of the object changes.

– The size of the object is aligned to the grid pattern, provided the "Snap to grid" function 
is set.

– Press <ALT> to disable this function while you drag the object.
In order to scale the object proportionally, keep the <Shift> key pressed while changing 
the size with the mouse.

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the size of the object under "Position & Size".
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Harmonizing the object size     
1. Select the objects.

2. Now, click one of the following buttons:   or  or  
The size of the selected objects is matched to each other.

The following screen shows how the selected objects are adapted to the height of the reference 
object:

 

 

 

Icon Description
 Aligns the selected objects to the width of the reference object.

 Aligns the selected objects to the height of the reference object.

 Aligns the selected objects to the width and height of the reference object.

Result
The object now appears with its new size. 

Selecting multiple objects

Introduction    
Select all objects you want to align with each other or to change global properties. This 
procedure is called "multiple selection." 

The Inspector window shows all the properties of the selected objects. 
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You now have several options of selecting multiple objects:

● Draw a selection frame around the objects.

● Hold down the <Shift> key, and click the required objects.

Selection frame of a multiple selection
The selection frame surrounds all objects of a multiple selection. The selection frame is 
comparable with the rectangle that surrounds an individual object.

The selection frame is not visible. When you have made your multiple selection, the following 
frame is displayed:

● The reference object is indicated by the rectangle around it.

● The other selected objects are indicated by a dashed-line frame.

Specifying a reference object   
The reference object is the object upon which the other objects are oriented. The reference 
object is framed by a rectangle with handles. The following figure shows a reference object 
with two other selected objects:

You have the following options to specify the reference object:

● Select the objects via multiple selection. The object selected first is then the reference 
object.

● Draw a selection frame around the objects. The reference object compiled automatically. 
If you wish to specify a different object within the selection as the reference object, click on 
the desired object. This action does not cancel your multiple selection.

Requirement
You have opened the work area containing at least two objects.

Selecting multiple objects with a selection frame
1. Position the mouse pointer in the work area close to one of the objects to be selected.

2. Hold down the mouse button, and draw a selection frame around the objects to be selected.

Or:
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1. Hold down the <Shift> key.

2. Click the relevant objects, working in succession.
All the selected objects are identified by frames.
The object selected first is identified as reference object.

 

  Note

To remove an object from the multiple selection, press <SHIFT>, hold it down and then 
click the relevant object once again.

 

Result
Multiple objects are selected. One of those is identified as the reference object. You can now 
perform the following steps:

● Changing the object properties of all the objects

● Resizing all the objects by the same ratio, by dragging the selection frame to increase or 
reduce the size

● Moving all the objects in one group

● Aligning the objects to the reference object

Repositioning and resizing multiple objects

Possible modifications
After you have selected multiple objects, you edit them:

● Shift using the mouse

– To change the absolute position of the marked objects, position the mouse pointer over 
an object, and shift the multiple selection with the mouse button pressed.

– To resize all the objects by the same ratio, grab the resizing handles of the reference 
object.

● Move over the work area with the icons of the toolbar

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

● Moving with the shortcut menu commands of the work area

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects
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Aligning objects 

Procedure
1. Select the objects via multiple selection.

2. Specify an object as the reference object.

3. Select the desired command in the toolbar or the shortcut menu - see table below.
The selected objects will be aligned.

Aligning objects flush     
The selected objects will be aligned flush to the reference object. 

Icon Description
Aligns the selected objects to the left edge of the reference object. 
Aligns the selected objects to the vertical center axis of the reference object. 
Aligns the selected objects to the right edge of the reference object. 
Aligns the selected objects to the upper edge of the reference object. 

Aligns the selected objects to the horizontal center axis of the reference object. 
Aligns the selected objects to the lower edge of the reference object. 
Centers the selected objects to the center points of the reference object. 
Centers the selected objects vertically in the screen.

Snap to object
When you reposition objects, they are displayed with help lines. You can use other objects for 
orientation during positioning.

If you are working with the keyboard, press the Alt key. When you move the selected object 
with the arrow keys, the next anchor point is displayed.

Distributing objects evenly     
You need at least three selected objects. A reference object is not required.

1. Select the objects.

2. Click one of the buttons "Distribute horizontally equal" or "Distribute vertically equal".
The selected objects are distributed at equal distances.
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The following screen shows how you align the vertical spacing of the selected objects:

Icon Description
Aligns the horizontal distance between the objects. 
The position of the objects on the extreme left and right side remains unchanged. All 
other objects are distributed evenly between them. 
Aligns the vertical distance between the objects. 
The position of the objects at the extreme top and bottom (right and left) remains 
unchanged. All other objects are distributed evenly between them. 

Rotating objects

Introduction   
You can rotate a suitable object clockwise or counterclockwise around its center axis in steps 
of 90°. 

 

 Note

Not all the objects can be rotated. Some objects that can be rotated in screens cannot be 
rotated in reports.

 

You can also rotate multiple objects using the multiple selection function. Certain WinCC 
objects such as buttons cannot be rotated.

The alignment of elements in an object will change in a rotated object. The following figure 
shows how a rectangle and an ellipse behave under the different commands for rotating an 
object:
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Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to rotate.

2. Click one of the following toolbar icons:
, to rotate the object clockwise around its center point. The angle of rotation is 90°.
, to rotate the object counterclockwise around its center point. The angle of rotation is 

90°.
, to rotate the object clockwise by 180°.

Result
The object is shown at its new angle. 
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Flipping objects

Introduction
You can flip an object along its vertical or horizontal center axis. The alignment of elements in 
an object will change when you flip an object. The following figure shows how a rectangle and 
an ellipse behave under the different commands for flipping an object.

Requirement
You have opened a screen which contains at least one object.

Procedure
1. Select the object that you want to flip.

2. Click the "Flip" command in the shortcut menu and select one of the options displayed:

– , to flip the selected object along its vertical center axis.

– , to flip the selected object along its horizontal center axis.

Result
The object is shown at its flipped position. 

See also
Inserting an object (Page 3469)
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10.6.3 Operation in Runtime

10.6.3.1 Printing reports

Printing a report in Runtime
If you have configured an object with the "PrintReport" system function, the operator can print 
out a report in Runtime. To do this, the operator uses the "Print report" button on a screen. 
The operator can set or change further settings for the report. The report is output to the default 
printer. 

See also
Printing reports (Page 3468)

Principles for preparation of reports (Page 3463)

Reports (Page 3460)

10.6.4 Objects in reports

10.6.4.1 Audit report

Application
With the audit report, the content of the audit trail of a HMI device is output as a report. 

Requirements
The "audit report" object is available only if the following requirements are met:

● The HMI device supports a GMP-compliant configuration.

● GMP-compliant configuration is active in the Runtime settings of the HMI device.

Note that operator actions and system operations are only recorded if a corresponding log is 
configured. 
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Layout
In the Inspector window the position, shape, style, color and font types of the object are 
customized. In particular, the following can be adjusted:

● Visibility of the comment

See also
Enabling GMP compliant configuration (Page 5761)

Audit Trail (Page 5763)

Creating an audit trail (Page 5764)

Principles for preparation of reports (Page 3463)

Reporting an audit trail (Page 5772)

Audit Trail reporting (Page 5773)

Parameters for the audit trail report (Page 5774)

Printing out an audit trail report (Page 5777)

Date/time field (Page 3485)

I/O field (Page 3486)

Graphic view (Page 3488)

Graphic I/O field (Page 3489)

Alarm report (Page 3489)

Recipe report (Page 3492)

Page number (Page 3493)

Symbolic I/O field (Page 3494)

Text field (Page 3494)

Reports (Page 3460)

10.6.4.2 Date/time field

Application   
The "Date/time field" object shows the system time of the HMI device or the date and / or time 
of a connected tag. The layout depends on the language setting on the HMI device.
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Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. In the "Properties > Properties > General" dialog, you can adapt the following properties 
in particular:

● Long date/time format: This setting defines the format displayed for the data and / or time.

● System time: Specifies whether to use the system time of the HMI device, or the data and / 
or time of a connected tag.

Long date/time format 

Option Description
"Enabled" Date and / or time is fully displayed, for example "Sunday, December 31, 2000 

10:59:59 AM"
"Disabled" Date and / or time is displayed in abbreviated form, e.g. "12/31/2000 10:59:59 

AM"

System time 

Option Description
"Enabled" The system time of the HMI device is displayed
"Disabled" The date and / or time of the connected tag is displayed

Select a tag of the "DateTime" data type, e.g. an internal tag. Information about 
data types which are available for connection to other PLCs can be found in 
the documentation about the respective communication drivers.

See also
Create a report  (Page 3465)

Principles for preparation of reports (Page 3463)

Audit report (Page 3484)

10.6.4.3 I/O field

Application   
The "I/O field" object is used to enter process values.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Display format: Specifies the format in which the values in the I/O field are output.
 

  Note

The "I/O field" object is also available in "Screens" editor. In reports, the object only outputs 
data. Accordingly only configure the output of data for application in reports.

 

Display format  
The "display format" for the output of values is specified in "Properties > Properties > General 
> Format", in the Inspector window.

Layout  
"Binary" Output of values in binary form
"Date" * Output of date specifications. The format depends on the language setting on the 

HMI device.
"Date/time" * Output of date and time specifications. The format depends on the language 

setting on the HMI device.
"Decimal" * Output of values in decimal form.
"Hexadecimal" Output of values in hexadecimal form.
"Time" * Output of time specifications. The format depends on the language setting on the 

HMI device.
"Character string" Output of strings.
*: not in Runtime Professional

Avoid overlaps with output fields 
If several I/O fields are configured as output fields with a transparent background in a report, 
these I/O fields may overlap. The transparent part of the one field covers the digits of the other 
field. This may cause display problems in the report. In order to avoid such overlaps, set the 
margins of the I/O fields to zero in the object properties under "Properties > Properties > 
Appearance". Activate "Properties > Properties > Layout > Fit object to contents."

See also
Create a report  (Page 3465)

Principles for preparation of reports (Page 3463)

Audit report (Page 3484)
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10.6.4.4 Graphic view

application  
The "Graphic view" object is used to display graphics.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Graphic: Specifies the graphic file that is displayed in the object.

● Stretch graphic: Specifies the automatic size stretching for objects with graphics.

Inserting graphics  
The following graphic format is used in the "Graphic view" object: *.bmp, *.tif, *.png, *.ico, *.emf, 
*.wmf, *.gif, *.jpg or *.jpeg. You may also use graphics as OLE objects in the Graphic view .

1. In the Inspector window, select "Properties > Properties > General":

2. Select the graphic you want to add in the drop-down list under "Graphic".
The graphic preview is shown in the right pane.

3. Click "Assign" to insert the graphic in the Graphic view .

Stretch graphic  
Whether a graphic displayed in a Graphic view  is stretched to the size of the Graphic view  in 
runtime is specified in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select one of the following options from the "Fit to size" area:

– Fit object size to content

– Fit content to object size

See also
Audit report (Page 3484)
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10.6.4.5 Graphic I/O field

Application   
With the "Graphic I/O field" object, the graphics of a graphics list are displayed, depending on 
the tag value. In the Inspector window, the tag and graphics list are configured, under 
"Properties > Properties > General":

 

 Note

The "Graphic I/O field" object is also available in "Screens" editor. In reports, the object only 
outputs data. Accordingly only configure the output of data for application in reports.

 

Layout  
Customize settings for color, frame, position and object size in the inspector window. In 
particular, the "Fit to size" is defined by specifying whether the object is adjusted to the graphics 
during output in the report or the graphic is adjusted in the object. 

See also
Create a report  (Page 3465)

Audit report (Page 3484)

Objects in reports (Page 3484)

10.6.4.6 Alarm report

Application   
Use the "Alarm report" object to output alarms of the selected alarm classes from the alarm 
buffer or alarm log to the report.
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Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Source

● Alarm classes

● Time range

● Additional settings for the display

● Visible columns

Specifying the source
Under "Properties > Properties > General > Settings > Source", specify whether to display 
alarms from the alarm buffer, or from the alarm log. Select the alarm log in the "Alarm log" 
dialog.

Specifying alarm classes
Under "Properties > Properties > General > Alarm classes, enable the alarm classes for the 
alarms output to the report. 

Specifying the time range
If you want to restrict alarm output to a specific time range, select the start and end tags for 
the time range in the "Properties > Properties > General > Time range" dialog. The tag must 
be of the "DateTime" type.
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Additional settings for the display
Under "Properties > Properties > General > Settings, specify the following settings for the 
display in the alarm report:  

● Under "Sorting", specify whether to start the display with the oldest or most recent alarm.

● Under "Lines per entry", specify the number of lines to be available for each alarm. The 
required number of lines depends on the following factors:

– Number and width of the selected columns for the output

– Font size used

– Paper format of the printer

● Select "Visible heading" to enable the display of column headers.

● Select "Display milliseconds" to enable the display of milliseconds for time data.

Visible columns
Under ""Properties > Properties > Layout > Visible columns", enable the columns to be 
displayed in the alarm report. 

See also
Create a report  (Page 3465)

Principles for preparation of reports (Page 3463)

Audit report (Page 3484)
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10.6.4.7 Recipe report

application   
Use the "Recipe report" object to output the elements of recipe data records in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Recipe

● Data record

● Format

● Visible entries

Selecting a recipe
Specify the recipes to be output in the recipe report under "Properties > Properties > General 
> Recipe". You can define the recipes based on their recipe name, or on a range of recipe 
numbers. Under "First recipe" and "Last recipe", enter a value or select a tag.

You can also choose to display all recipes.

Selecting a data record
Under "Properties > Properties > General > Data record", specify which data records of the 
selected recipes are to be output in the recipe report. You can define the data records based 
on the data record name, or on a range of data record numbers. Under "First recipe" and "Last 
recipe", enter a value or select a tag.

You can also choose to display all data records of the selected recipes.
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Format
In the "Format" field of the "Properties > Properties > Layout > Settings" dialog, specify whether 
to output the data records as a table in column format or line report format.

WinCC updates the preview in the detail page accordingly.

Visible entries
Under ""Properties > Properties > Layout > Visible entries", enable the columns to be displayed 
in the recipe report. Select "Show headings" to enable the display of column headers. 

See also
Create a report  (Page 3465)

Principles for preparation of reports (Page 3463)

Audit report (Page 3484)

10.6.4.8 Page number

application   
Use the "Page number" object to output the current page number in the report.

Layout    
In the inspector window, change the settings for color, font, position and object size. In 
particular, specify "Size adaptation":

Fit to size
Under "Properties > Properties > Layout > Fit to size", the "Fit object to content" option is used 
to specify whether WinCC adjusts to the object size of the field content:

● Enabled "Fit object to contents" option:
WinCC automatically adjusts the size of the object to the configured format. The font size 
and field length are defined under "Properties > Properties > General > Text". 
The object can be moved in the working area, however, the size cannot be changed. During 
report output, the entire field content is output at the time of report output.

● Disabled "Fit object to contents" option:
Customize the field size by yourself. WinCC does not resize the field for report output. It 
can be possible that not all content of the field is output in the report. Therefore, configure 
a field of sufficient size. 
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See also
Create a report  (Page 3465)

Principles for preparation of reports (Page 3463)

Audit report (Page 3484)

10.6.4.9 Symbolic I/O field

application   
With the "Symbolic I/O field" object, the content of a text list in reports is displayed, depending 
on the tag value. In the inspector window, the tag and text list is configured under "Properties 
> Properties > General":

Layout  
In the inspector window, change the settings for color, frame, font, position and object size. In 
particular, the "Fit to size" is defined, by specifying whether the object size is adjusted to the 
text during output in the report or not.

 

 Note

The "Symbolic I/O field" object is also available in "Screens" editor. In reports, the object only 
outputs data. Accordingly only configure the output of data for application in reports. 

 

See also
Create a report  (Page 3465)

Principles for preparation of reports (Page 3463)

Audit report (Page 3484)

10.6.4.10 Text field

Application   
The "Text field" is a closed object which you can fill with a color. 
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Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Text: Specifies the text for the text field.

● Size of text field: Defines whether the size of the object is adapted to the space required 
by the largest list entry.

Text   
Specify the text for the text field in the Inspector window. 

1. In the Inspector window, select "Properties > Properties > General".

2. Enter a text.
For texts over several lines you can set a line break by pressing the key combination <Shift 
+ Enter>.

Size of text field   
In the Inspector window, you can define whether the size of the object is adapted to the space 
required by the largest list entry. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Resize > Fit to contents".

See also
Audit report (Page 3484)

Visualizing processes (Comfort/Advanced)
10.6 Working with reports

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3495



10.7 Configuring user administration

10.7.1 Field of application of the user administration

Principle
The access protection controls access to data and functions in Runtime. This feature protects 
your applications against unauthorized operation. Safety-related operations are already limited 
to specific user groups when a project is being created. To this purpose you set up users and 
user groups that you equip with characteristic access rights, so-called authorizations. You then 
configure the authorizations required for operation of safety-related objects. Operators only 
have access, for example, to specific operator controls. Commissioners, for example, have 
unlimited access in Runtime. 

Definition
You administer users, user groups and authorizations centrally in the user administration of 
WinCC. You transfer users and user groups together with the project to the HMI device. The 
users and passwords are managed on the HMI device in the User view. 

Application example
You configure the "Service" authorization so that only service technicians have access to the 
configuration parameters. You assign the authorization to the "Service technician" user group. 
This allows all members of this group to set the protected configuration parameters.

 

 NOTICE

Access protection does not protect against incorrect operations. It is your job to ensure that 
only authorized personnel with appropriate training will design, commission, operate and 
maintain plants and machines. 

Access protection is not suitable for defining work routines and monitoring their observance. 
 

10.7.2 Form of the user administration

Introduction
In case of a project in manufacturing engineering, the environment at the equipment 
manufacturer has to be differentiated from the environment at the end customer as plant 
operator. 

The equipment manufacturer allows users, for example Mr. Foreman, a specific access within 
the application or HMI device. However, a user Foreman does not exist at the end customer. 
The machine manufacturer cannot know the end users and the tasks they have to perform for 
configuration. The final users are usually set after commissioning at the end customer.

Visualizing processes (Comfort/Advanced)
10.7 Configuring user administration

WinCC Comfort/Advanced V12.0 SP1
3496 System Manual, 07/2013,  



 

Principle
To minimize the work required for management, authorizations are assigned via user groups 
and not directly to individual users.

A user group assembles configured authorizations according to common jobs. For example, 
all permissions required for a service job are collected in a "Service technician" group. When 
you create a user who should be responsible for servicing, you simply assign him to the 
"Service technician" group.

The user view enables user administration in Runtime. Use user view to create, delete and 
assign an authorization to users in Runtime.

The user administration separates the administration of the users from the configuration of the 
authorizations. This ensures flexibility at the access protection. 

Defaults can be set for the user administration during the configuration phase in the 
Engineering System. 

10.7.3 Basics

10.7.3.1 Users

Introduction
You can create users in the "Users" tab of the "User administration" editor and assign them to 
user groups. The "Users" tab is part of the user administration in WinCC. 
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Open
To open the "Users" tab, double-click "User administration" in the project window.

Work area
The users are managed in the work area:

● You create or delete users.

● You assign users to user groups.
 

  Note

You can assign a user to exactly one user group.
 

Inspector window
When you select a user, you can change the password in the "General" group. Under 
"Automatic logoff" you can specify if the user is to be automatically logged off by the HMI device 
when there is no operator activity after the specified time. 

10.7.3.2 Users work area

Introduction
The "Users" work area lists the users and user groups in table form. You administrate the users 
and assign them to a user group. 

Principle
The work area consists of the "Users" and "Groups" tables.
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The "Users" table shows the existing users. When you select a user in this table, the "Groups" 
table shows the user group to which the user belongs. 

 

 Note

For the user "Administrator", the default password is "administrator". For security reasons, 
you should change the password of this user.

 

10.7.3.3 User groups

Introduction
You can create users and authorizations in the "User groups" tab of the "User Administration" 
editor. The "User groups" tab is part of the user administration in WinCC.

Open
Double-click the "User administration" in the project window. Open the "User groups" tab.

Work area
The user groups and authorizations are managed in the work area:

● You create new user groups and authorizations or delete them.

● You assign the authorizations to the user groups.

Inspector window
When a user group or an authorization is selected, you can edit the name in the "General" 
group. You can also enter a brief description in the "Comment" group.

10.7.3.4 User groups work area

Introduction
The "User groups" work area shows a table of the groups and their authorizations. You 
administer the user groups and assign authorizations to them.
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Principle
The work area consists of the "Groups" and "Authorizations" tables.

The "Groups" table shows the existing user groups. When you select a user group in this table, 
the "Active" column of the "Authorizations" table shows the authorizations which were assigned 
to the user group.

The number of the user group and of the authorization is assigned by the user administration. 
The designations and descriptions are assigned by you.

The number of predefined authorizations are fixed. Authorizations that you create can be freely 
edited. Ensure that the assigned numbers are unique.

10.7.3.5 Settings for the user administration

Introduction
In the "Runtime settings > User administration" editor, configure the security settings for users 
and their passwords in runtime.     

Open
Double-click the "Runtime settings" editor in the project window. Click "User administration".

Work area
You carry out the settings for the validity of passwords in runtime in the work area. You 
determine the complexity of the password, for example. 
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Effects in Runtime
The security settings have the following effects in runtime, depending on the configuration. 

● "General" group

– "Enable limit for logon attempts" check box selected
The number entered in the "Number of incorrect logon attempts" box defines the number 
of logon attempts a user is allowed before being assigned to the "Unauthorized" group.
"Enable limit for logon attempts" check box not selected
The user has an unlimited number of logon attempts in runtime.

– "Number of incorrect logon attempts" field
If you enter "4" in the field, for example, and the fourth logon attempt fails, the user is 
automatically assigned to the "Unauthorized" group.
You can specify 1 to 9 attempts. 

– "Logon only with password" check box
When the check box is selected, the user will be authenticated by the password. The 
user name is not required. 
To match users to passwords, you cannot configure passwords more than once. 

● "Hierarchy level" group 

– "Group-specific rights for user administration" check box
When this check box is selected, administrators only manage users whose group 
number is less than or equal to their own.
For example, an administrator whose group number is 5 can only manage users whose 
group number is less than or equal to 5. This means that the administrator can assign 
users only to groups with a group number less than or equal to 5. 
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● "Password" group 

– "Enable password aging" checkbox selected
The password expires after the number of days set in the "Validity of the password 
(days)" field. 
The "Password aging" column is selected in the "User groups" editor. This enables you 
to specify group-by-group, if the passwords should expire or if the password generations 
should be saved. Passwords never expire for groups for which password aging is not 
enabled.

– "Prewarning time (days)" field
The user is informed that the password will expire the specified number of days before 
the password expires. 

– "Password generations" field
If the user changes the password, the new password must be different from the specified 
number of previous passwords. The number of password generations ranges from 1 to 
5.

● "Password complexity" group 

– "Must include special characters" check box selected
The user must enter a password containing at least one special character at any position.

– "Must include number" check box selected
The user must enter a password containing at least one number at any position.

– "Minimum password length" field
The user must enter a password with a minimum length, as specified in the "Minimum 
password length" field.
The minimum length of the password is 3 characters. 

10.7.3.6 Settings for the user administration

Introduction
In the "Runtime settings > User administration" editor, configure the security settings for users 
and their passwords in runtime.     

Open
Double-click the "Runtime settings" editor in the project window. Click "User administration".

Work area
You carry out the settings for the validity of passwords in runtime in the work area. You 
determine the complexity of the password, for example. 
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Effects in Runtime
The security settings have the following effects in runtime, depending on the configuration. 

● "General" group

– "Change initial password" check box selected
The user must change the administrator-assigned password when logging on for the 
first time.

– "Change logoff time" checkbox selected
Simple user rights are sufficient for changing the logoff time. 
The logoff time is the period after which the user administration automatically logs off a 
user when no operator activity is detected in the system.
The logoff time for the SIMATIC Logon user corresponds to the logoff time of the default 
user "Administrator".
Any user changes of the logoff time are logged in the Audit Trail. 

– "Enable limit for logon attempts" check box selected
The number entered in the "Number of incorrect logon attempts" box defines the number 
of logon attempts a user is allowed before being assigned to the "Unauthorized" group.
"Enable limit for logon attempts" check box not selected
The user has an unlimited number of logon attempts in runtime.

– "Number of incorrect logon attempts" field
If you enter "4" in the field, for example, and the fourth logon attempt fails, the user is 
automatically assigned to the "Unauthorized" group.
You can specify 1 to 9 attempts. 

– "Logon only with password" check box
When the check box is selected, the user will be authenticated by the password. The 
user name is not required. 
To match users to passwords, you cannot configure passwords more than once. 

● "Hierarchy level" group 

– "Group-specific rights for user administration" check box
When this check box is selected, administrators only manage users whose group 
number is less than or equal to their own.
For example, an administrator whose group number is 5 can only manage users whose 
group number is less than or equal to 5. This means that the administrator can assign 
users only to groups with a group number less than or equal to 5. 
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● "Password" group

– "Enable password aging" checkbox selected
The password expires after the number of days set in the "Validity of the password 
(days)" field. 
The "Password aging" column is selected in the "User groups" editor. This enables you 
to specify group-by-group, if the passwords should expire or if the password generations 
should be saved. Passwords never expire for groups for which password aging is not 
enabled.

– "Prewarning time (days)" field
The user is informed that the password will expire the specified number of days before 
the password expires. 

– "Password generations" field
If the user changes the password, the new password must be different from the specified 
number of previous passwords. The number of password generations ranges from 1 to 
5.

● "Password complexity" group 

– "Must include special characters" check box selected
The user must enter a password containing at least one special character at any position.

– "Must include number" check box selected
The user must enter a password containing at least one number at any position.

– "Minimum password length" field
The user must enter a password with a minimum length, as specified in the "Minimum 
password length" field.
The minimum length of the password is 3 characters.

● "SIMATIC Logon" group

– "Activate SIMATIC Logon" check box selected
A connection is established to the server. Authorization is performed via SIMATIC Logon.

– "Encrypted transfer" checkbox selected
The data is encrypted before it is transferred to the server. 

10.7.4 Building up and structuring a user administration

10.7.4.1 Basics of user administration

Principle
This section addresses four target groups. The topics are organized correspondingly. The 
target groups serve as examples for different groups of persons who use the user 
administration. 

1. Administrator OEM

2. Administrator RT
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3. Planners

4. Operator

As Administrator OEM you create the user groups, users and authorizations for Runtime in 
the Engineering System of, for example, an equipment manufacturer.

As Administrator RT you administer users in Runtime by means of the "User view."

As the project engineer you assign the authorizations to the user groups in the Engineering 
System. In addition, you configure the authorizations for objects. 

As Operator you log on in runtime. You can only access a protected object if you have the 
required authorization.

 

 Note

The Administrator RT target group already exists in the Runtime user administration as the 
predefined user group "Administrator group." For a better understanding the predefined user 
groups and authorizations are not used below. 

 

10.7.4.2 Administering users for Runtime 

Creating an authorization

Introduction
You create an authorization and assign it to one or more user groups.   

Requirements
The "User groups" work area is open.

Procedure
1. Double-click "Add" in the "Authorizations" table.

2. Enter "Stop runtime" as the name of the authorization.

3. Enter a brief description as the "Comment".

See also
Creating a user group (Page 3506)
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Creating a user group

Introduction
User groups are created so that you do not have to assign an authorization to every single 
user. You create a user group, assign authorizations and then assign users to it.  

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

 
 

 Note
Using SIMATIC Logon

Ensure that the names of the user groups in Windows and WinCC are identical.
 

Requirements
The "User groups" work area is open.

Procedure
1. Double-click "Add" in the "Groups" table.

2. Enter "Operators" as the "Name" of the user group.

3. Change the "Number" of the user group as required.

4. Enter "Display name" of the "Operators" user group.

5. Enter a brief description as the "Comment".

In runtime, the user view shows the display name of the user group. The display name of the 
user group depends on the language. You can specify the name in several languages and 
switch between languages in runtime. 

See also
Creating an authorization (Page 3505)

Example: Configuring a button with logon dialog box (Page 3531)

Example: Logging the logon and logoff events (Page 3532)
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Assigning an authorization

Introduction
When you allocate an authorization to a user group, all assigned users have this authorization.  

Requirements
● A "Stop runtime" authorization has been created.

● An "Operators" user group has been created.

● The "User groups" work area is open.

Procedure
1. Click on the "Operators" user group in the "Groups" table. The "Authorizations" table shows 

all authorizations.

2. Enable the "Stop runtime" authorization in the "Authorizations" table.
 

  Note

The "Stop runtime" authorization is only a designation and does not have any relation to 
the function "StopRuntime". You have to establish this relation yourself. To do so, 
configure the "StopRuntime" system functions at a button and select "Stop runtime" as 
the "Authorization".

 

Creating users

Introduction
You create a user so that users can log on with their user names in runtime after loading to 
the device.   

As an alternative, you can create and change users by means of the "User view" in Runtime.

In order for a created user to have authorizations you have to assign him to a user group and 
allocate authorizations to the user group.

The logon is successful when the user name entered during the logon matches a user in 
Runtime. In addition, the entered password must agree with the stored password of the user. 

 

 Note

Note that the entry is case-sensitive.
 

Requirements
The "Users" work area is open.
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Procedure
1. Double-click "Add" in the "Users" table.

2. Enter "Foreman" as the user name.
 

  Note

The user name must be unique within the project. Otherwise the input is not accepted.
 

3. Click the  button in the "Password" column. A dialog box for entering the password is 
displayed.

4. Enter the password of the user.

5. To confirm the password enter it a second time in the lower field.

6. Close the dialog box by using the  icon.

7. If a user is to be logged off after a specific time period, activate "Automatic logoff".

8. Click in the "Logoff time" column. The preset value for "Logoff time" is 5 minutes.

9. Enter a brief description as the "Comment".

Assigning a user to a user group

Introduction
When you assign a user to a user group, the user has the authorizations of the user group. 

 

 Note

You have to assign a user to exactly one user group. The assignment is checked during the 
consistency check and generation of the project.

 

Requirements
● The user "Foreman" has been created.

● An "Operators" user group has been created.

● The "Users" work area is open.

Procedure
1. Click on the "Foreman" user in the "Users" table. The "Groups" table shows all user groups.

2. Activate the "Operators" user group in the "Groups" table.
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Managing users

Introduction
In the work area, you can administer users and assign them to user groups.   

Requirements
The "Users" work area is open.

Changing the user name
1. In the "Users" table, double-click the field in the "Name" column to change the user name.  

2. Change the user name.

3. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the user name under "Properties > 
Properties > General" in the Inspector window.

Changing the password of the user
1. Click the  button in the "Password" column of the "Users" table. A dialog for entering the 

password opens.  

2. In the "Enter password" field, enter the new password.

3. Reenter the new password in the "Confirm password" field.

4. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the password under "Properties > 
Properties > General" in the Inspector window.

Displaying invisible columns
1. Position the mouse cursor on the title of the "Users" table.

2. Right-click to open the shortcut menu and enable the display of the "Logoff time" column, 
for example.

Changing the logoff time of the user
1. In the "Users" area, double-click on the field in the "Logoff time" column to change the logoff 

time.

2. Change the logoff time.

3. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the logoff time under "Properties > 
Properties > Automatic logoff" in the Inspector window.  
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Deleting a user
1. Select the line of the user to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined users cannot be deleted. 
 

Managing user groups

Introduction
In the workplace you administer user groups and assign authorizations for use in runtime.     

Requirements
The "User groups" work area is open.

Changing the name of the user group
1. In the "Groups" table, double-click the field in the "Name" column to change the name of 

the user group.  

2. Change the name of the user group.

3. Confirm your entry with <Return>.

Alternatively, select the user group in the work area. Change the name under "Properties > 
Properties > General" in the Inspector window.

 

 Note

Predefined user groups cannot be deleted.
 

Displaying invisible columns
1. Position the mouse cursor on the title of the "Users" table.

2. Right-click to open the shortcut menu and enable the display of the "Display name" column, 
for example.

Changing the displayed name of the user group
1. In the "Groups" table, double-click the field in the "Display name" column to change the 

display name of the user group.  

2. Change the displayed name of the user group.

3. Confirm your entry with <Return>.
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Alternatively, select the user group in the work area. Change the display name under 
"Properties > Properties > General" in the Inspector window.

Deleting a user group
1. Mark the line of the user group to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined user groups cannot be deleted.
 

Changing the name of the authorization
1. In the "Authorizations" table, double-click the field in the "Name" column to change the 

name of the authorization.  

2. Change the name of the authorization.

3. Confirm your entry with <Return>.

Alternatively, select the authorization in the work area. Change the name under "Properties > 
Properties > General" in the Inspector window.

Deleting authorizations
1. Mark the line of the authorization to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined authorizations cannot be deleted. 
 

10.7.4.3 Managing users on the server

Central user administration using SIMATIC Logon

Introduction
To manage users and user groups for several applications or HMI devices, activate SIMATIC 
Logon.      

Principle
SIMATIC Logon is a tool for system-wide user administration. If you use SIMATIC Logon, the 
users are centrally managed outside the application or HMI device. 

Visualizing processes (Comfort/Advanced)
10.7 Configuring user administration

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3511



You configure the user groups and their permissions as you usually do with the local user 
administration in WinCC. You assign identical names to the user groups on the server and in 
WinCC. Authorizations are assigned in runtime to a user group when the names are identical. 

You do not have to create users in WinCC because they are taken dynamically from Windows 
user management during the logon process. The application or HMI device forwards each 
logon or password change to SIMATIC Logon for processing.

 

 Note

SIMATIC Logon is a product requiring a license. For more information on SIMATIC Logon 
go to <http://support.automation.siemens.com>.

Enter the ID "34519648" in the search field and start searching. The "SIMATIC Logon - 
Electronic Signature" manual is available to download.
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Log on process via SIMATIC Logon Service
The following diagram illustrates the process that runs automatically when a user logs onto 
Runtime.

The application opens the logon dialog box

1. Query: Login and password

The user enters the logon data in the logon dialog box:

<Login>

<Password>

Logon

dialog box

2. Transfer: Logon data

Logon data is verified

3. Query: Does Windows recognize the user?

Logon data is verified

on the local computer or in the domain

4. User authentication in progress 

SIMATIC

Logon

Service

Determining user data:

Operating 

system

User and group 

administration

Transfer of user data:

6. Transfer: full user name,

  group membership,

  password age 

5. Query: Which user data

   is known?

Verifying and transferring user data:

7. Transfer:  full user name,

  group membership

8. Determining roles

9. Setting rights in accordance with role

Results: The user can implement the role functions.

Applications 

which use 

SIMATIC Logon 

functions

Making settings on the server

Introduction
Perform the following steps on your sever to ensure correct operation of SIMATIC Logon.

Procedure
1. Install SIMATIC Logon Services.

2. Create the user group in the user administration of the operating system.
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3. Create the users in the user administration of the operating system.
 

  Note

Users of SIMATIC Logon must be members of a user group of the operating system. 
Members of a subgroup cannot be logged on.

 

4. Assign the new users to a group.

5. Transfer the licenses for each HMI device on the server.
 

 Note

You can find more detailed information in the documentation supplied with SIMATIC Logon.
 

 Note

The password policies stored on the server are valid if users are authorized by means of 
SIMATIC Logon.

The logoff time for the SIMATIC Logon user corresponds to that of the predefined 
"Administrator" user.

 

Logging on using SIMATIC Logon

Requirements
● User administration exists.

● The groups created in WinCC agree with the Windows groups on the server.

● There is a server with SIMATIC Logon Service installed.
 

 Note

A user may only be a member of one user group in WinCC. When a user is a member of 
several user groups on the server, only one of these user groups can be made known in 
WinCC.

"Administrators" and "Users" are predefined groups in both Windows and WinCC. Any new 
user created in Windows is automatically a member of the "Users" group. A user will be a 
member of two groups if assigned to a new group, for example, to the "SL user" group.

Remove this user from the "Users" group of the operating system to enable logon of this user 
using SIMATIC Logon. 

A system message in runtime always confirms the successful logon of a user on the server.
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Procedure
1. Open the "Runtime settings > User administration" editor in the Project window.

2. Activate "Activate SIMATIC Logon".

3. Select "Windows domain" or "Windows computer", depending on where you run user 
administration.

4. Enter the name or IP address of the SIMATIC Logon server in the "Server name" text box.
 

  Note

Make sure your SIMATIC Logon Server always has the same IP address if you use IP 
addresses. 

 

5. Enter the port number for TCP/IP communication in the "Port number" text box. The valid 
range of values lies between 1024 and 49151. The preset port number is "16389" and used 
by SIMATIC Logon as the default.

6. Enter the Windows domain or the logon server with the user data in the "Windows domain" 
text box.
Enter the name of the sever to access users on the logon server.
Enter the name of the domain if the logon sever is in a domain and you wish to access 
users of the domain. 

 

  Note

Local Windows users are not accepted when the logon server is in a domain.
 

7. Activate the "Encrypted transfer" check box in order to encrypt the data before sending it 
to the server.

Emergency user
If the server cannot be accessed, all local users that were created in WinCC user administration 
can also be used as emergency users.

Emergency users have the rights of the user group to which they were assigned.
 

 Note

For additional information, refer to the included SIMATIC Logon documentation. 

This documentation is available at: [SIMATIC Logon installation directory] \manuals
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10.7.4.4 Administering users in Runtime

Users in runtime

Principle
You create users and user groups and assign authorizations to them. You configure objects 
with authorizations. After download to the HMI device, all objects which were configured with 
an authorization are protected against unauthorized access in Runtime.

User view
When you configure a user view in the Engineering System, you administer users in this user 
view following download to the HMI device.  

 

 NOTICE

Changes in the user view are effective immediately in Runtime. Changes in runtime are not 
updated in the engineering system. When downloading the user administration to the HMI 
device, all changes in the user view are overwritten after a security prompt and based on the 
settings.

 

Users who have a "User administration" authorization have unlimited access to the user view. 
This allows them to administer all users. Any other user has only limited access to the user 
view for self administration.

See also
Complex user view (Page 3518)

Basic user view

Purpose
You configure a user view in the engineering system to also administer the users in 
Runtime.   

Structure
The user view shows the following in each line:

● The user

● The corresponding user group.

If no user is logged on, the user view is empty. The content of the individual fields is displayed 
after logon.
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User view of an administrator

When an administrator is logged on, the user view shows all the users. The administrator 
changes the user name and the password. The administrator creates new users and assigns 
them to an existing user group. 

User view of a user

When no administrator is logged on, the user view shows only the logged-on user. Users can 
change their own passwords. 
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Complex user view

Purpose
You configure a user view in the engineering system to also administer the users in 
Runtime.   

Structure
The user view shows the following in each line:

● The user

● The encrypted password

● The corresponding user group

● The logoff time

If no user is logged on, the user view is empty. The content of the individual fields is displayed 
after logon.

User view of an administrator

When an administrator is logged on, the user view shows all the users. The administrator 
changes the user name and the password. The administrator creates new users and assigns 
them to an existing user group. 

User view of a user
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When no administrator is logged on, the user view shows only the logged-on user. Users can 
change their own passwords and logoff time.

See also
Users in runtime (Page 3516)

Configuring a user view

Introduction
You configure a user view in the Engineering System to also administer users in Runtime.  

Requirements
A screen has been created.

Procedure
1. Select the "User view" object from the "Controls" category in the toolbox.

2. Drag-and-drop the "User view" object into the screen.

3. Click on "Properties > Properties" in the Inspector window.

4. Specify the appearance of the "User view".

5. You can, for example, select " "Display mode > Fit to size > Fit object to contents".

Result
You have created a user view in the screen.

Creating users

Introduction
You create a user so that users can log on under their user name in runtime.     

As an alternative, you can create users in the engineering system and download them to the 
HMI device.

The logon is successful only when the user name entered during the logon matches a user in 
runtime. In addition, the password entered at logon has to match that of the user.

 

 Note

Note that the entry is case-sensitive. 
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You assign the user to a user group. The user then has the authorizations of the user group.
 

 Note

Runtime users must be assigned to a user group. The user group is created in the Engineering 
System. The designation of the user group is language-dependent.

 

Requirements
● The user view is open.

● A "Group 2" user group has been created.

Procedure
1. Click "<New User>" in the user view. A dialog opens.

2. Enter "Foreman" as the user name.

3. Press the <Return> button.

4. Click "Password."

5. Enter the password of the user.

6. Press the <Return> button. The password is hidden.

7. Click in the "Group" column.

8. Select "Group 2" as the "Group".

9. Press the <Return> button.

10.Click in the "Logoff time" column.

11.Enter the time after which the user is logged off automatically.
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Managing users in the simple user view

Introduction
If you have configured a user view in the engineering system, the users and user groups can 
be managed in runtime. 

 

 NOTICE

Changes in the user view are effective immediately in runtime. Changes in runtime are not 
updated in the Engineering System. When downloading the user administration to the HMI 
device, all changes in the user view are overwritten after a security prompt and based on the 
settings.

 

Requirements
● Runtime is enabled.

● The simple user view has been created.

● The screen with the simple user view is open.

● You have the default "User administration" authorization.
 

  Note

If you do not have a "User administration" authorization, you can only change your own 
password and your logoff time.

 

Changing a user name
1. Click on the line of the user whose name you want to change. A dialog box opens.

2. Enter a new user name.

3. Click "OK" to confirm your entry.  
 

  Note

The user can then no longer log on with his previous password in runtime. If you delete 
the name and press <Return>, the user is deleted.
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Changing the user password in basic user display
1. Click on the line of the user whose password you want to change. A dialog box opens.

2. Enter a new password.

3. Click "OK" to confirm your entry.  
 

  Note

The user can then no longer log on with his previous password in runtime.

If you delete the password in the basic user view and press <Return>, a message will be 
generated. The message specifies that the password does not lie within the defined limits. 

 

Changing the logoff time of the user
1. Click on the line of the user whose logoff time you want to change. A dialog box opens.

2. Enter a new logoff time.

3. Click "OK" to confirm your entry.  

Deleting a user
1. Click the name of the user to be deleted. 

2. Delete the name.

3. Press the <Return> button.
 

  Note

The user can no longer log on in runtime.
 

Assigning a user to a different user group
1. Click on the line of the user whose user group you want to change. A dialog box opens.

2. Click on the "User group" box.  

3. Select a user group.

4. Click "OK" to confirm your selection.
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Managing users in the complex user view

Introduction
If you have configured a user view in the engineering system, the users and user groups can 
be managed in runtime.   

 

 NOTICE

Changes in the user view are effective immediately in runtime. Changes in runtime are not 
updated in the engineering system. When downloading the user administration to the HMI 
device, all changes in the user view are overwritten after a security prompt and based on the 
settings.

 

Requirements
● Runtime is enabled.

● A complex user view has been created.

● The screen with the user view is open.

● You have the default "User administration" authorization.
 

  Note

If you do not have a "User administration" authorization, you can only change your own 
password and your logoff time.

 

Changing the user name
1. Enter a new user name in the "Users" column in the user display.

2. Confirm your entry with <Return>.  
 

  Note

The user can then no longer log on with his previous password in runtime. If you delete 
the name and press <Return>, the user is deleted.
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Changing the password of the user
Availability of complex user display in selected devices only.

1. Enter a new password in the "Password" column in the user display.

2. Confirm your entry with <Return>.
 

  Note

The user can then no longer log on with his previous password in runtime.

If you delete the password in the complex user view and press <Return>, the user will be 
deleted. 

 

Changing the logoff time of the user
1. Enter a new logoff time in the "Logoff time" column in the user display.

2. Confirm your entry with <Return>.  

Deleting a user
1. Click the name of the user to be deleted. 

2. Delete the name.

3. Press the <Return> button.
 

  Note

The user can no longer log on in runtime.
 

Assigning a user to a different user group
1. Activate the user group field for the corresponding user.  

2. Select a user group.

3. Confirm your selection with <Return>.

Unlock locked out users

Unlock locked out users
The check box "Activate limit for login attempts" is activated in the "Runtime settings > User 
administration". 
The number 3 is entered in the field "Number of invalid login attempts".

If users have three failed attempts at login, e.g. by entering an incorrect password, they are 
assigned to the "Unauthorized" group. The user loses all authorizations. The user can still log 
on, but no longer has any authorizations. Only a user with administrator rights re-assigns the 
unauthorized user to a user group.   
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Exporting the user administration

Introduction
The users and user groups are transferred to the HMI device from the Engineering System. If 
you have configured a user view, you administer the users at the HMI device via the user 
view.   

If a user has access to several HMI devices, the same user and the same password must be 
configured on each HMI device. Create a standard for user administration of the different HMI 
devices. Export the users and passwords on an HMI device to a storage medium, such as a 
floppy, memory card or a network drive. You import the users and passwords from this storage 
medium at all the other HMI devices.

You program a function which exports the user data at a button.

The system function "ExportImportUserAdministration" is not available on all HMI devices.
 

 NOTICE

When exporting, the user data are encrypted and written from the HMI device to the target 
file. The target file is overwritten. 

 

Requirements
● You have created an HMI device with Runtime Advanced.

● A screen has been created.

● A button has been created in the screen.

● The Inspector window is open.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Release" in the Inspector window.

3. Click the entry "Add function" in the function list.

4. Select the "ExportImportUserAdministration" system function.

5. Select "Export" as the "Direction". When exporting, the target file is overwritten with the 
user data.

6. Enter the full path of the destination file as the "File name", for example "a:\test
\usersview.txt".

 

  Note

Ensure that the file name is written correctly. If the directory, for example "\test\", does not 
exist, it will be created without a prompt. 
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Importing the user administration

Introduction
If a user has access to several HMI devices, the same user and the same password must be 
configured on each HMI device. Create a standard for user administration of the different HMI 
devices. Export the users and passwords on an HMI device to a storage medium, such as a 
floppy, memory card or a network drive. You import the users and passwords from this storage 
medium at all the other HMI devices.   

You configure a function which imports the user data at a command button.

The system function "ExportImportUserAdministration" is not available on all HMI devices.
 

 NOTICE

When importing, the user data are read in from the source file and written into the HMI device. 
The users and passwords currently valid in the HMI device are overwritten. The imported 
users and passwords are valid immediately.

 

Requirements
● A screen has been created.

● A command button has been created in the screen.

● The Inspector window is open.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Release" in the Inspector window.

3. Click the entry "Add function" in the function list.

4. Select the "ExportImportUserAdministration" system function.

5. Select "Import" as the "Direction." When importing, the user data in the HMI device are 
overwritten.

6. Enter the full path of the source file as the "File name", for example "a:\test\usersview.txt".
 

  Note

Ensure that the file name is written correctly. If the folder, for example "\test\", or the file 
does not exist, an error message will be displayed. 
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Logging on as a user

Introduction
As a rule you log-on as a user by means of a special button. The logon dialog box is displayed 
to this purpose.     

The logon dialog box is displayed by default during access to a protected object if

● No user is logged on in runtime.

● The logged-on user does not have the required authorization.
 

  Note

The system always opens the logon dialog on the OP 73, OP 77A, TP 177A and Basic 
Panels HMI devices when you press an access-protected button:

 

Requirements
● Under "Runtime settings > User administration" the

– "Enable limit for logon attempts" check box has been selected.

– The number 3 is entered in the field "Number of incorrect login attempts".

● The "ShowLogonDialog" system function is configured on a button called "Logon".

Procedure
1. Click the "Logon" button. The logon dialog box is displayed.

2. Enter your user name as it was specified in the user administration, for example "Foreman".
If someone has logged on before you, the name of the user will be displayed.

3. Enter the corresponding password. The input is concealed.

4. Click "OK" to close the dialog box.
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Logon was successful
If you have entered the user name "Foreman" and the entered password corresponds with the 
stored password, you are logged on as the user "Foreman" in runtime. You have the 
authorizations of the user "Foreman". 

When the user "Foreman" accesses a protected object such as the "Logging" button, access 
to this protected object will only be authorized if the user "Foreman" has the required 
authorization. The programmed function is executed immediately. 

If you do not have the required authorization after the successful log-on, a corresponding error 
message is displayed. However, you remain logged on in runtime.

Logon was unsuccessful
An error message is displayed.   

In order to maintain security, you or the user logged-on before you no longer has any 
authorizations. However, access to unprotected objects remains possible. The user view does 
not, however, show any entries. The user view and the authorizations change after the next 
successful log-on.

If the third login attempt has failed, the user will be assigned to the "Unauthorized" group. For 
this reason, do not configure a user group with this display name.   

If the "Log off" function is called up or the logoff time of the user has expired, the user is logged 
off. 

10.7.4.5 Configuring access protection

Access protection

Introduction
You configure an authorization at an object in order to protect it against access. All logged-on 
users who have this authorization can then access the object. If a user does not have 
authorization to operate an object, the logon dialog is displayed automatically.

 

 Note

Several system functions are available under "User administration" so that user, password, 
and user group can be edited, for example, in the PLC. 

 

Configuring operating authorizations

Introduction
You configure the "Stop runtime" authorization for a button. Then only those users who have 
the appropriate authorization have access to this button, for example all the users of the 
"Operators" user group.     
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This ensures that access to the command button is protected. If a logged-on user who belongs 
to the "Operators" user group and has the required authorizations clicks the button, runtime is 
stopped. 

An example describes in detail how to configure a command button with access protection.

Requirements
● The "Operators" user group has been created.

● The "Stop runtime" authorization has been created.

● A screen has been created and opened.

● The screen contains a button.

Procedure
1. Click the button in the screen.

2. Click "Properties > Properties > Security" in the Inspector window.

3. Select "Stop runtime" as the "Authorization".

4. In the Inspector window, select "Properties > Events > Click".

5. Select a system function from the function list, for example, "StopRuntime".
 

  Note

The "Enable" and "Disable" events are only used to detect whether an object was selected 
or deselected. The events do not, however, trigger a password prompt.

Do not use the "Enable"or "Disable" event if you want to configure access protection at 
the function call of the object.

 

 

10.7.5 Reference

10.7.5.1 Objects with access protection

Introduction
The following objects can be configured with an authorization:     

● Date/time field

● I/O field

● Graphic I/O field

● Recipe view

● Switch
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● Button

● Symbolic I/O field

● System diagnostic view

10.7.5.2 Objects with access protection

Introduction
The following objects can be configured with an authorization:     

● Date/time field

● I/O field

● f(x) trend view

● Graphic I/O field

● HTML Browser

● Alarm view

● Alarm window

● Recipe view

● Switch

● Button

● Slider

● Symbol library

● Symbolic I/O field

● System diagnostic view

● System diagnostic window

10.7.5.3 Default user groups and authorizations

Principle
The predefined user groups and authorizations have the following numbers:

User group Number
"Administrator group" 1
"Users" 2
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Authorization Number
"User administration" 1
"Monitor" 2
"Operate" 3

10.7.6 Examples

10.7.6.1 Example: Configuring a button with logon dialog box

Task
In the following example, you configure the function "ShowLogonDialog" for a button. A 
different user can then log on in runtime when the shift changes, for example. In the process 
the user previously logged on is logged off.    

 

 Note

In runtime the logon dialog box is not displayed by default until you access a protected object. 
Either no user is logged on or the logged-on user does not have the required authorization.

 

Requirements
● A screen has been created.

● A button has been created in the screen.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Release" in the Inspector window.
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3. Click the entry "Add function" in the "Function list" table.

4. Select the system function "ShowLogonDialog" from the "User administration" group.

Result
If the user clicks on the button in runtime, the function "ShowLogonDialog" is called up. When 
the function "ShowLogonDialog" is called up, the logon dialog box is displayed. The user logs 
on with his user name and password. 

10.7.6.2 Example: Logging the logon and logoff events

Task
In the following example, you configure the function "TraceUserChange" to the event "User 
change".   

Principle
The "TraceUserChange" function is called when a user logs on or off. When a function is called 
up, a system message with information about the corresponding user is output. 

This system message can be archived. When archiving, the system message is provided with 
a date stamp and time stamp. This ensures that you can track which user was logged on at 
the HMI device at which time and for how long.

Requirements
● You have created an HMI device with Runtime Advanced.

● The Inspector window is open.
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Procedure
1. Double-click the "Scheduler" in the Project view.

2. Double-click "Add" in the table of the tasks.

3. Enter "Logon-Protocol" as the "Name".

4. Select "User change" as the "Trigger".

5. Open "Properties > Events" in the Inspector window.

6. Click the entry "Add function" in the "Function list" table.

7. Select the "TraceUserChange" system function.

Result
A system message is output when a user logs on or logs off. 

10.7.6.3 Example of a user administration

Example: Structure of user administration

Task
In the following example you set up a user administration for different users and user groups. 
The example orientates itself to a typical requirement profile from manufacturing engineering.  

Principle
Completely different groups of persons are involved in a plant or project. Each group of persons 
protects its respective data and functions against access by others. For this purpose, users 
are created and assigned to a user group. 

You can reproduce different views through user groups. 

Example:

● Organizational view: Commissioners, Operators, Shift I, Shift II

● Technological view: Axis control, Tool changers, Plant North, Plant South

The following example orientates itself to the organizational view.

Every user group has characteristic requirements regarding access protection: A user group 
has operating authorizations for specific application cases. A programmer changes, for 
example, recipe data records. 

In the example the users Miller, Group Smith and Foreman are created and assigned to 
different user groups.

Ms. Miller works as a programmer in the engineering system. The Group Smith are 
commissioners. Mr. Foreman is an operator.
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Requirements
● A new project has been created.

● The "User administration" editor is open.

Procedures overview
Working with user administration has the following procedure in the example:

1. Creating authorizations The planner specifies which authorizations are required for access 
protection.

2. Configuring authorizations: The planner specifies which objects may be operated and which 
functions may be executed.

3. Creating user groups and allocating authorizations: The administrator creates the user 
groups together with the planner. The planner uses the authorizations to specify who may 
operate objects and change parameters.

4. Creating users and assigning them to a user group: The administrator administers the users.

Result
The aim is the following structure of the user administration of users, user groups and 
authorizations:

Users User groups Authorizations
Miller Smith Foreman Roles Changing 

recipe 
records

Changing 
system 
parameters

Changing 
process 
parameters

Managing

   Administrator group    x
X   Programmer X    
 X  Commissioning 

engineers
X X X  

  X Operators x    

The user "Foreman" who belongs to the "Operators" user group has access to the configured 
"To Recipe view" button.

 

 Note

Alternatively, you can create several users as operators with different operating 
authorizations, for example, Operator Level 1, Operator Level 2. 

 

Example: Creating and configuring authorizations

Task
The following example shows you how to create the authorizations  
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Procedure
1. Open the "User groups" work area.

2. Double-click "Add" in the "Authorizations" table.

3. Enter "Change recipe data records" as the "Name" of the authorization.

4. Repeat steps 2 and 3 to create additional authorizations: "Change system parameters", 
"Change process parameters".

Result

Example: Configuring a button with access protection

Task
In the following example you use a system function to create a button for a screen change. 
You protect the "To Recipe view" button against unauthorized operation. To do so, you 
configure the "Change recipe data records" authorization at the "To Recipe view" button.       

Requirements
● A "Change recipe data records" authorization has been created.

● A "Recipes" screen has been created.

● A "Start" screen has been created and opened.

● A button has been created and marked in the "Start" screen.
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Procedure
1. Click "Properties > Properties > General" in the Inspector window.

2. Enter "To Recipe view" as the text.

3. Click "Properties > Events > Click" in the Inspector window.

4. Click the "Add function" entry in the first line of the "Function list" table.

5. Select the "ActivateScreen" system function in the "Screens" group.

6. Click the  button in the "Screen name" field. A dialog box for selecting the screen opens.

7. Select the "Recipes" screen and use the  button to close the dialog box.

8. Click "Properties > Properties > Security" in the Inspector window.

9. Select "Change recipe data records" as the "Authorization."

Result

Access to the "To Recipe view" button is protected. If, for example, the user "Smith" clicks the 
button in Runtime, the function "Recipe view" screen is called up. Prerequisite is that the user 
"Smith" has logged on correctly and has the required authorization. The "Recipes" screen 
contains a recipe view and other screen objects. 
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If the logged-on user does not have the required authorization or if no user is logged on, the 
"Logon dialog box" is displayed. 

Example: Creating user groups and assigning authorizations:

Task
In the following example you create the user groups and assign authorizations to them.       

Procedure
1. Open the "User groups" work area.

2. Double-click "Add" in the "Groups" table.

3. Enter "Programmer" as the "Name".

4. Repeat steps 2 and 3 to create the "Commissioner" and "Operator" user groups.

5. Click "Administrator" in the "Groups" table.

6. Activate the "Change system parameters" authorization in the "Authorizations" table.

Interim result
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Procedure
1. Click "Operator" in the "Groups" table.

2. Activate the "Change recipe data records" authorization in the "Authorizations" table.

3. Click "Commissioner" in the "Groups" table.

4. Activate the authorizations "Change recipe data records", "Change system parameters" 
and "Change process parameters" in the "Authorizations" table.

5. Click "Programmer" in the "Groups" table.

6. Activate the "Change recipe data records" authorization in the "Authorizations" table.

Result

Example: Creating users and assigning them to a user group

Task
In the following example you create the users and assign user groups to them. The users are 
sorted alphabetically immediately after the name has been entered.    

Procedure
1. Open the "Users" work area.

2. Double-click "Add" in the "Users" table.
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3. Enter "Miller" as the user name.

4. Click the  button in the "Password" column. The dialog box for entering the password is 
displayed.

5. Enter "miller" as the password.

6. To confirm the password enter it a second time in the lower field.

7. Close the dialog box by using the  icon.

8. Activate the "Programmer" user group in the "Groups" table.

Interim result

Procedure
1. Double-click "Add" in the "Users" table.

2. Enter "Smith" as the user name.

3. Click the  button in the "Password" column. The dialog box for entering the password is 
displayed.

4. Enter "smith" as the password.

5. To confirm the password enter it a second time in the lower field.

6. Close the dialog box by using the  icon.

7. Activate the "Commissioner" user group in the "Groups" table.

8. Repeat steps 2 to 6 for the user "Foreman."

9. Activate the "Operators" user group in the "Groups" table.
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Result
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10.8 Working with system functions and Runtime scripting

10.8.1 Basics

10.8.1.1 Runtime scripting

Term definition 
The following terms are used in the documentation:         

Term  
Runtime scripting Generic term for all activities in user-defined functions.
Function Generic term for system functions and user-defined functions.
System functions System functions are all functions supplied with WinCC. The system functions 

are used either in function lists or user-defined functions.
User-defined functions User-defined functions are functions written in the "Scripts" editor. For more 

precise specification, the term "User-defined VB function" is used in the 
documentation.

VBS / VBScript Abbreviation for Visual Basic Script

Applying Runtime scripting
The following figure serves as a decision guide for programming tasks at hand:
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10.8.1.2 System functions

Applications
You use system functions for the following:       

● Function lists
A function list is executed from top to bottom in Runtime. If a function list includes system 
functions with longer runtime, these are processed asynchronously. See "Auto-Hotspot" 
for additional information. 

● User-defined functions
If the HMI device supports customized functions, you use system functions in combination 
with instructions and conditions in the code of a customized function. In this way you 
execute a customized function depending on a specific system state. In addition, you can 
evaluate return values of system functions, for example. Depending on the return value, 
you then perform test functions, for example, that in turn affect the user-defined function 
flow.

Application examples of system functions
● Calculations, increase tag value by a defined or variable amount.

● Log function, e.g. to start a process value log.

● Settings, e.g. to switch the PLC or set a bit in the PLC.

● Alarms, e.g after changing the user.
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Usage
● Function list

When configuring a function list, you select the system functions from a selection list that 
is sorted by categories:   

● User-defined function
If you are using a system function in a user-defined function, you choose it from a selection 
list. To open the selection list, use the key shortcut <Ctrl+Space> or click . 

Language dependency
In the function list, the names of the system functions are dependent on the set project 
language. The functionality can then be recognized immediately by the project planner.

You use the English name of the system function in user-defined functions. You will find the 
English name of the system function in the reference.   

Availability
Which system functions are available depends on the selected HMI device.
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HMI device replacement
If you use system functions in a function list that are not available on the set HMI device, these 
system functions are marked in color.

If you use a system function in a user-defined function which is not available on the set HMI 
device, a warning is issued. In addition, the respective system function will be underlined with 
a wavy blue line. 

See also
System functions for logs (Page 3227)

10.8.1.3 User-defined functions

Applications
You use customized functions for the following for example: :    

● Configuring an extended function list
In a customized function you have the option to have customized functions and system 
functions executed depending on conditions or executed repeatedly. You then add the 
customized function to a function list. 

● Programming new functions
Customized functions are only valid in the project in which they are defined. For user-
defined functions you define transfer parameters and return values, for example, for 
conversion of values. 

Properties of customized functions
A customized function has the following properties:  

● Name

● Parameter (optional)

● Return value and type (optional)

● Can be modified centrally

● has no trigger. You have to call the customoized function explicitly, e.g. in a function list.

● behaves like a system function

Usage
You create customized functions with the "Scripts" editor. See "Scripts" editor (Page 3550) for 
additional information.  

Customized functions are saved in the project. To protect user-defined functions, set up know-
how protection. See Auto-Hotspot for additional information.
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● Project tree
The user-defined functions are listed in the project tree under "VB scripts".

● Function list
The user-defined functions are listed in a function list under "VB functions".

● User-defined function
If you are using a system function in a user-defined function, you choose it from a selection 
list. To open the selection list, use the key shortcut <Ctrl+Space> or click .

Recursion level
The recursion level in user-defined functions is limited by the stack size of the HMI device. If 
the number is exceeded, a system error message is output in Runtime. This means you should 
limit the number of recursions in a user-defined function. 

10.8.2 Working with function lists

10.8.2.1 Basics of the function list

Introduction
A function list performs one or more system functions and user-defined functions when the 
configured event occurs.  
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Principle
The function list is configured for an event of an object, for example, for a screen object or a 
task. You can configure a function list precisely on every event. The events which are available 
depend on the selected object and the HMI device.

Events occur only when the project is in Runtime. Events include:

● Execution of a task

● Pressing of a button

● Acknowledging an alarm
 

  Note

The choice of configurable system functions in a function list is dependent on the selected 
HMI device. For additional information, refer to "Availability for specific devices of system 
functions".

 

10.8.2.2 Properties of a function list

Status information
During configuration the project data is tested in the background. 

With the following causes the function list is not executed in Runtime and the incorrect entries 
are marked red:

● At least one system function or one user-defined function is not completely supplied with 
parameters.

● At least one system function or one user-defined function is contained which is not 
supported by the selected HMI device, e.g. by changing the device type.
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Processing of system functions and user-defined functions (WinCC Runtime Advanced and Panels)
A function list is executed from top to bottom in Runtime. If a function list includes system 
functions with longer runtime, these are processed asynchronously. You can find additional 
information about this in the sections "Calling system functions" and "Calling user-defined 
functions".

See also
Executing a function list in Runtime (Page 3573)

Processing sequence for user-defined functions and system functions (Page 3574)

10.8.2.3 Configuring a function list

Introduction
You configure a function list by selecting the system functions and customized functions from 
a drop-down list. The system functions are arranged in the selection list according to 
categories. 

You only use customized functions of a programming language in a function list. Your selection 
of the first user-defined function determines whether user-defined VB functions or user-defined 
C functions can be selected in the function list. Which programming languages are available 
depends on the selected HMI device.

If you have created a user-defined VB function, for example, the user-defined function is 
available under the entry "VB functions".   

Requirement
Object has at least one configurable event.

Procedure
Proceed as follows to configure a function list:

1. Open the editor in which the object is located.

2. Select the object.

3. Click "Properties > Events" in the Inspector window. Choose the event for which you want 
to configure the function list.

4. Mark the "<Add function>" entry in the inspector window in the drop-down list.
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5. Select the desired system function or the desired user-defined function from the selection 
list. You can also enter the name of the system function or the user-defined function.

The system function or the customized function is entered in the function list. 

6. If the system function or the customized function has parameters, select the appropriate 
values for the parameters.

7. If you want to add other system functions or user-defined functions to the function list, repeat 
steps 4) to 6).

Result
The function list is configured. In addition, to the configured event, the status of the function 
list is displayed in the Inspector window. When the configured event occurs in Runtime, the 
function list is completed from top to bottom. 
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10.8.2.4 Editing a function list

Introduction
A function list can be edited as follows:   

● Change the order of system functions and user-defined functions.

● Remove system functions or user-defined functions.

Requirement
The function list is configured and opened.

Changing the order of a system function or a customized function
1. Select the desired system function or customized function in the function list.

2. Then click the appropriate direction arrow in the inspector window until the system function 
or customized function is in the desired position.

Changing the order of several system functions and customized functions
1. Hold down the <Shift> key.

2. Click desired system functions or customized functions one after another with the mouse.

3. Move the selection to the desired position by drag&drop.

Removing a system function or customized function
1. Select the desired system function or customized function in the function list.

2. Select "Delete" in the shortcut menu.
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10.8.3 Working with user-defined VB functions

10.8.3.1 "Scripts" editor

Introduction
The "Scripts" editor supports you in the creating of user-defined functions with functionalities 
such as auto-completion and syntax highlighting. You can insert code templates for frequently 
used instructions with the "Instructions" task card for example.

Autocompletion and parameter entry         
The "Scripts" editor provides you context-dependent programming support with 
autocompletion parameter entry support. 

When you use system functions, the parameters of the function are shown as a tooltip. 

<Ctrl+J>
The object list can be called context-specifically by using the shortcut <Ctrl+J>. Use the object 
list to supply values to system functions, methods, and properties: For example, you select 
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screens, screen objects, tags, or colors. You transfer a selected object from the object list into 
the code by double-clicking it. 

 

 Note

Tags and screens can also be inserted using a drag-and-drop operation. Use, for example, 
drag-and-drop to assign values to parameters.

 

<Ctrl+Space>
With the key combination <Ctrl+Space> you call a list with the following contents:

● Constants and functions of the programming language used in the "Scripts" editor.

● User-defined functions

● System functions

"Instructions" task card           
The "Instructions" task card contains the "Code templates" and "Function list" palettes.

● Code templates
To insert frequently used instructions, double click the desired instruction in the "Code 
templates" palette. Replace the space holders with the used expressions.

● Function list
In the function list you select the system functions and user-defined functions from a drop-
down list. Proceed as for configuring a function list. To transfer the function list to the code, 
click the "Transfer" button. The function list is automatically converted into the correct 
syntax. 

 

  Note

Not all system functions are available in the "Scripts" editor. For additional information, 
refer to the reference.

 

Edit functions
Use the buttons of the toolbar "Advanced Edit" to make the code more readable by means of 
indentation and the use of comments.

Bookmarks help you keep an overview, even of many lines of code. 

Further information regarding each button can be obtained in the accompanying direct help. 

Synchronization of tags and objects         
If you change tag names or object names in the project which you use in a user-defined 
function, the names are adapted automatically in the user-defined function. 
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If you change the tag name or object name in the function, the tag names or object names are 
not adapted in the project. An appropriate error message is output when executing the user-
defined function.

Syntax highlighting     
Keywords in the "Scripts" editor are highlighted using different colors. Unknown words are 
underlined with a red wavy line. 

The table shows the preset colors for the most important keywords:

Color Meaning Example
Blue Keyword If, Then
Dark violet Function FahrenheitToCelsius
Chocolate System function SetTag
Orange HMI tag Tag_1
Green Comment 'This is a comment'

Adapting display properties   
When you have opened a user-defined function, you can customize the display properties in 
the editor. Select the "Options > Settings" menu command. Click "General > Text editors" in 
the "Settings" editor. For example, you can change the colors for syntax highlighting or adapt 
the indents for code in the work area. 

See also
Create customized VB functions (Page 3558)

10.8.3.2 Access to HMI tags

Introduction
In user-defined VB functions, you have access to HMI tags which you have created in the 
project. Change or read the tag value with a user-defined VB function in Runtime. 

In addition, you can create local tags as counters or buffers in the user-defined VB function. 
You must declare each tag to avoid errors due to misspelled tags.         

HMI tags
The user-defined VB function accesses the tag value which is saved in Runtime memory. Next, 
the tag value will be updated to the set cycle time. The user-defined VB function first accesses 
the tag values which were read at the previous cycle time.

If the tag name matches the VBS name conventions in the project, you can use the HMI tag 
directly in the function.

'VBS_Example_03
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If BeltDriveOilTemperature > 100 Then [instruction]
If the tag name in the project does not match the VBS name conventions, you must reference 
the HMI tag using the "SmartTags list". In the following example the tag name contains the "&" 
character that is not permitted in accordance with the VBS name conventions:

'VBS_Example_04
SmartTags("Test&Trial")= 2005

Local tags 
You define local tags with the Dim instruction. You can only use local tags within user-defined 
VB functions. They therefore do not appear in the "HMI Tags" editor. You use a local tag in 
the user-defined VB function, for example, as a counter in a For instruction.

'VBS_Example_05
Dim intCount
For intCount = 1 To 10 [instruction] Next

Access to HMI tags with a dynamic name
The user-defined VB function accesses the tag value using the tag name. You can specify the 
tag name in such a way that the tag name is composed at the runtime of the user-defined 
function. 

If you only call the user-defined VB function in a screen in which the HMI tag is also used 
elsewhere, for example in an I/O field, you should for performance reasons configure the HMI 
tag with "Cyclic in operation" acquisition mode.

If the user-defined VB function is accessed and the HMI tag is not being used in the screen 
currently displayed, configure the HMI tag with "Cyclic continuous" acquisition mode. This 
ensures that the current value of the tag is always available.

See also
SmartTags (Page 3910)

10.8.3.3 Access to objects

Introduction
The objects of the VBS object model with the appropriate properties and methods are available 
in user-defined VB functions.

The object properties can be read and changed in Runtime. 

Referencing objects
In customized VB functions you reference the objects by the corresponding list. To identify the 
object, use its name or the position number within the list. 
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If you access the properties of an object more often, create an object reference. You can 
access object properties with and without object reference.   

With the following instruction the first object is referenced in the "MainScreen":

 
'VBS_Example_01
Dim objObject
'Change to Screen "MainScreen"
HMIRuntime.BaseScreenName = "MainScreen"
Set objObject = HMIRuntime.Screens(1).ScreenItems(1)

 

With the following instruction an object is referenced by its name and an object property is 
changed. You must have created the object with this name in the screen.

 
'VBS_Example_02
Dim objCircle
HMIRuntime.BaseScreenName = "MainScreen"
Set objCircle = HMIRuntime.Screens(1).ScreenItems("Circle_01")
objCircle.BackColor = vbGreen

10.8.3.4 Calling system functions

Introduction
You can insert system functions in a user-defined VB function.

This can be done in the following ways:

● With <Ctrl+Space> or with 

● Direct input

● With the "Function list" palette

With <Ctrl+Space> or with 
Open the list of system functions with <Ctrl+Space> or with  and select the desired system 
function.

Direct input
You enter the system functions directly into the code. You use the English name of the system 
function. You can find the English name of the system function in the system function reference 
under "Syntax". The editing language setting is not taken into consideration. 

References to objects, e.g. screens, connections and logs are transferred in inverted commas:
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Calling system functions without return value in VBS

 
SetTag "Tag1",64

Calling system functions with return value in VBS

 
InverseLinearScaling "XValue","Tag1", 0, 1

With the "Function list" palette
Select the system functions from a selection list that is sorted by categories in the "Function 
list" palette. Proceed as for configuring a function list. You will find further information about 
this under "Configuring a function list". 

To transfer the list to the code, click the "Transfer" button. The list is automatically converted 
into the correct syntax.

HMI device replacement
The code of a customized function depends on the selected HMI device. If you use system 
functions in the customized function which are not supported by the selected HMI device, you 
receive an error message in the output window. See "Auto-Hotspot" for additional 
information.     

10.8.3.5 Calling user-defined VB functions

Introduction
You can only insert user-defined VB functions in a user-defined VB function. 

This can be done in the following ways:

● With <Ctrl+Space> or with 

● Direct input

● With the "Function list" palette

With <Ctrl+Space> or with 
Open the list of user-defined VB functions with <Ctrl+Space> or with  and select the desired 
user-defined VB function.
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Direct input
You enter the user-defined VB function directly into the code. References to objects, e.g. 
screens, connections and logs are transferred in inverted commas.

 
Function Average(ByVal Var1, ByVal Var2)
  Average = (Var1+Var2)*(1/2)
End Function

Calling user-defined VB functions without return value in VBS     

 
Average 4,10

Calling user-defined VB functions with return value in VBS

 
Dim ValueA
ValueA = Average (4,10)

If you do not want to evaluate the return value, use the call as for a user-defined VB function 
without return value.

With the "Function list" palette
Select the desired user-defined VB function from a selection list in the "Function list" palette. 

Proceed as for configuring a function list. You will find additional information under "Configuring 
a function list". 

To transfer the list to the code, click the "Transfer" button. The list is automatically converted 
into the correct syntax.
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10.8.3.6 Transfer and return of values in VBS

Transfer of a value
The following options are available for transferring parameters.

● "Call by Value" - ByVal
ByVal transfers the parameter value. If you transfer a tag as a parameter, the tag value is 
transferred to the user-defined function when the user-defined function is executed.

● "Call by Reference" - ByRef
ByRef transfers the address of the parameter. If you transfer a tag as a parameter, the tag 
address is transferred to the user-defined function when the user-defined function is 
executed. 
When user-defined functions and system functions are called in user-defined functions, the 
parameter is transferred as ByRef.

Return of a value
Return values can return the result of a calculation (e.g., average value of two numbers). But 
a return value can also give information about whether an instruction was executed correctly.  

Therefore, the system functions that perform file operations such as "Delete" also have return 
values. 

For a user-defined function to return a value, you must set the "Function" type. You assign the 
function name to the return value in the user-defined function:

To form an average value of two numbers, call the user-defined VB function Average and 
transfer the result to the HMI tag for example AverageValue. 

● In a customized VB function

 
SmartTags("AverageValue") = Average ("4", "10")

● In the function list

You can output the value of the HMI tag AverageValue in an I/O field. 
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See also
Create customized VB functions (Page 3558)

10.8.3.7 Create customized VB functions

Introduction
When you create a customized VB function, you define the following settings:    

● The name with which you call the user-defined VB function.

● The type of user-defined VB function.

● The parameters which are transferred to the user-defined VB function in Runtime.

Use only the following characters for the name:

● "A" to "Z"

● "a" to "z"

● "0" to "9"

● "_" as a separator
 

  Note

When you change the parameters or the function type, the change is color marked at the 
application point, e.g. in the function list. 

 

Procedure
To create a user-defined VB function, follow these steps:

1. Open "Scripts" in the project tree.

2. Double click "Add new VB function" in the project tree under "VB scripts".

The user-defined VB function is created as a new tab in the work area. The input mask for 
the configuration settings of the user-defined VB function opens in the Inspector window.
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3. Configure the user-defined VB function in the Inspector window "Properties > General > 
General".

4. Enter a descriptive "Name" for the user-defined VB function.

5. Select the "Type" of the user-defined VB function.

– "Function" have a return value.

– "Sub" have no return value.

6. Click "<Add>" in the "Parameters" list to add parameters. Enter the parameter name and 
specify the parameter type.
Further information can be found in "Transfer and return of values in VBS (Page 3557)".

– "ByVal" transfers the parameter value.

– "ByRef" transfers the address of the parameter.

7. Enter its code in the work area.
You will find further information about this in ""Scripts" Editor" (Page 3550)".

Result
The user-defined VB function has been created. The type, name, and function parameters are 
displayed in the title bar. 

The start and end are inserted automatically when the user-defined function is created.

If you have protected the user-defined VB functions by a password, it is saved encrypted in 
the project. For additional information, refer to "Protecting user-defined functions". 

The figure below shows a user-defined VB function which converts the temperature from 
"Fahrenheit" to "Degrees Celsius":
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10.8.3.8 Testing the syntax of customized functions

Introduction
During programming, the code is tested in the background. Syntactical errors are marked with 
a wavy red line. The customized function is checked for correct syntax and valid object 
references. 

Check the syntax in the "Scripts" editor to identify all the errors in the code and output the 
appropriate error messages. In this case, error messages generated by the script parser are 
output. 

Use a separate debugger to check customized VB functions for logical programming errors.   

Error types
The following error types are detected in the syntax test and output in the "output window":

● Unknown string (e.g., not a keyword)

● Assignment of value to a constant

● The name of a local tag created with the Dim instruction is already known, e.g.: as a 
parameter, object, or component of the object model

● Syntax error

Requirements
● Customized function is open.

Procedure
Proceed as follows to check the syntax:

1. Click  to start the syntax check.
The syntax is checked. The result of the syntax check is displayed in the Inspector window 
under "Info > Compilation." Syntax errors are output with the line number. 

2. Correct the errors in the customized function if necessary.

Special consideration in the syntax checking of customized functions 
Customized functions are not interpreted until in Runtime. When an HMI device is being 
compiled, the system checks its user-defined functions for correct syntax. However, runtime 
errors may occur in certain circumstances. 

See also
Configuring a function list (Page 3547)
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10.8.3.9 Renaming customized VB functions

Renaming a user-defined VB function in the project tree   
Proceed as follows to rename a user-defined VB function in the project tree:

1. Select the desired user-defined VB function in the project tree.

2. Select the "Rename" (F2) command in the shortcut menu of the user-defined VB function.

3. Enter a new name for the user-defined VB function.

Renaming a user-defined VB function in the Inspector window
Proceed as follows to rename a user-defined VB function in the Inspector window:

1. Open the user-defined VB function in the "Scripts" editor.

2. In the Inspector window, click "Properties > Properties > General".

3. Enter the new function name.

Result
The user-defined VB function is renamed. The application points are adapted automatically.

10.8.3.10 Executing customized VB functions

Introduction
In WinCC you have the following options to execute a customized function:

● Function list

● Customized VB function

Calling a customized VB function in a function list 
1. Add the user-defined VB function to a function list like a system function. You will find the 

customized VB functions in the drop-down list under "VB functions". You will find further 
information in "Configuring a function list (Page 3547)".

2. If the VB function has parameters, supply the parameters with static values or HMI tags.

3. If the VB function has a return value, select an HMI tag. The value to be processed is 
transferred to the HMI tag.
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Calling a customized VB function in a customized VB function 
1. Open the user-defined VB function in which you want to call the user-defined VB function.

2. Call the customized VB function in the syntax of the programming language. You will find 
further information in "Calling user-defined VB functions (Page 3555)".

3. If the VB function has a return value, assign an expression, e.g. a local tag, to the VB 
function.

See also
Configuring a function list (Page 3547)

Calling system functions (Page 3554)

Calling user-defined VB functions (Page 3555)

10.8.3.11 Protecting user-defined functions

Setting up know-how protection

Procedure  
To set up know-how protection for user-defined functions, follow these steps:

1. Select the user-defined function without know-how protection that you want to protect.

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click "Define".
The "Define password" dialog box opens.

4. Enter a password in the "New" field.

5. Enter the same password in the "Confirm" field.

6. Confirm your entries with "OK".

7. Close the "Know-how protection" dialog by clicking on "OK".

Result
The user-defined function receives know-how protection. User-defined functions with know-
how protection are marked with a lock in the project tree. The password entered is valid for all 
user-defined functions selected. 

Opening user-defined functions with know-how protection
You can only open multiple user-defined functions with know-how protection at once if they 
are protected with the same password.
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Procedure   
To create a user-defined function with know-how protection, follow these steps:

1. Double-click the user-defined function you want to open.
The "Access protection" dialog will open.

2. Enter the password for the user-defined function with know-how protection.

3. Confirm your entry with "OK".

Result
The user-defined function with know-how protection will open provided you have entered the 
correct password. However, the function will remain know-how protected. 

Once you have opened the user-defined function, you can edit it for as long as the user-defined 
function or TIA portal is open. You must enter the password again the next time you open the 
user-defined function. If you close the "Access protection" dialog with "Cancel" or "Close", the 
user-defined function is opened but the code is not displayed. You cannot edit the user-defined 
function. 

Removing know-how protection

Procedure  
To remove the know-how protection of a user-defined function, follow these steps:

1. Select the user-defined function for which you want to remove know-how protection.
 

  Note

To remove know-how protection for several user-defined functions at once, all selected 
user-defined functions must have the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Deactivate the check box "Hide code (know-how protection)".

4. Enter the password.

5. Confirm your entries with "OK".

Result
Know-how protection will be disabled for the selected user-defined function. 
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Changing a password

Procedure  
To change the password, follow these steps:

1. Select the user-defined function with know-how protection for which you want to change 
the password.

 

  Note

To change the password for several user-defined functions at once, all selected user-
defined functions must have the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click the "Change" button.

4. Enter the old password in the "Old" field.

5. Enter the new password in the "New" field.

6. Enter the new password again in the "Confirm" field.

7. Confirm your entries with "OK".

8. Close the "Know-how protection" dialog by clicking on "OK".

10.8.4 Debugging user-defined VB functions

10.8.4.1 Debugging user-defined VB functions

Introduction
Debugging allows you to test the user-defined VB functions for logical programming errors in 
Runtime. For example, you can test whether the proper values were transferred to the tags, 
and whether cancellation terms are realized correctly.     

The following VBScript-capable debuggers have been tested and approved:

● "Microsoft Script Debugger"

● "Microsoft Script Editor": The debugger is included in Microsoft Office XP.

"Microsoft Script Debugger" provides the following functionality:
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● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note
Difference with regard to VBScript for Windows and Windows CE 

The debugger checks the syntax for VBScript for Windows. If the function contains a 
VBScript function for Windows CE, a corresponding error message is output. Some 
VBScript functions are different, e.g., CreateObject. You can find a list of these VBScript 
functions under "VBScript for Windows CE (Page 3880)".

 

Microsoft Script Debugger
If you want to use the Microsoft Script Debugger for debugging, the English version 
"scd10en.exe" must be used. The German version "scd10de.exe" may not be installed.

"Microsoft Script Debugger" provides the following functionality:

● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note

For tips and tricks on debugging, common sources of errors, and additional information, 
refer to the online help for the Microsoft Script Debugger.

 

The Microsoft Script Debugger is located in the Microsoft Download Center under the following 
URL:

● http://www.microsoft.com/downloads/Search.aspx?
displaylang=en833a6a92-961e-4ce1-9069-528d22605127 

Use the "Search" field to search for "Script Debugger" and select the required download.

Basic procedure
The debugger is only intended for identifying error locations in the user-defined VB function. 
For this purpose, for example, you use break points or execute the user-defined VB function 
step-by-step. For detailed information, refer to the documentation of the debugger you are 
using. In order to correct errors, you change to the "Scripts" editor in WinCC. After having 
recompiled and reloaded the script, you test the user-defined VB function once again using 
the debugger.

 

 Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes.
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Error types
The following error types are distinguished when debugging:           

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the user-
defined VB function step by step. This way, you identify the portion of the user-defined VB 
function that is not working.

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
To intercept runtime errors, use the "On Error Resume Next" instruction in the user-defined 
VB function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. To stop the handling of runtime 
errors in the user-defined VB function again, use the "On Error Goto 0" instruction. 
Example for error handling

 
Sub OnClick(ByVal Item)
'VBS27
  Dim objScreenItem
'
  'Activation of errorhandling:
  On Error Resume Next
  For Each objScreenItem In ScreenItems
    If "HMIRectangle" = objScreenItem.Type Then
    '
      '=== Property "RoundCornerHeight" only available for RoundRectangle
      objScreenItem.RoundCornerHeight = objScreenItem.RoundCornerHeight * 2
      If 0 <> Err.Number Then
        HMIRuntime.Trace objScreenItem.Name & ": no RoundedRectangle" & vbCrLf
        '
        'Delete error message
        Err.Clear
      End If
    End If
  Next
  On Error Goto 0  'Deactivation of errorhandling
End Sub

Screen change while debugging
If you change to another screen while debugging, the user-defined VB function of the previous 
screen stays open but is no longer valid. The debugger could return invalid error messages in 
this case, as the objects called will no longer exist after the screen change. 
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10.8.4.2 Integrating the Debugger

Installing a script debugger for WinCC
A VBScript-capable debugger must be installed to search for errors in user-defined VB 
functions.

The following VBScript-capable debuggers have been tested and released:

● Microsoft Script Editor by Office XP

● Microsoft Script Debugger: The English version "scd10en.exe" must be used. The German 
version "scd10de.exe" may not be installed.

An installed debugger is started as follows:

● If a runtime error occurs during execution

● Via "Online > Simulate Runtime > With script debugger"

Microsoft Script Editor
The Microsoft Office XP component "Microsoft Script Editor" contains a Script Debugger. If 
the default configuration was installed by Microsoft Office Setup, the "Microsoft Script Editor" 
component is not installed until called the first time ("Installed on First Use"). If you wish to 
explicitly install these components, you must specify it in the Microsoft Office setup. Select the 
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component selection menu, click"Web Debugging" component and then select the "Run from 
My Computer" option.

If a project is activated in WinCC via "Online > Simulate Runtime > With script debugger", a 
dialog containing the list of available script debuggers appears when the first user-defined 
function is run.

Other installed script debuggers such as "Microsoft Visual Interdev" or "Microsoft Visual 
Studio .NET" may also appear in the list. Select "Microsoft Script Editor" and confirm your 
selection with "Yes".
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Activate the "Script" program object in the "Step Into Remote Procedure Call" dialog and 
confirm your selection with "OK".
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The "Microsoft Script Editor" is launched. The execution pauses at the first line of the first 
function.
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Microsoft Script Debugger
If a script debugger is not available, download "Microsoft Script Debugger" (scd10en.exe) free 
of charge from Microsoft (www.microsoft.com). It will be started automatically in WinCC once 
it is installed.

 

 Note

The "Microsoft Script Debugger" can no longer be called or installed when another VBScript-
capable script debugger is available on your computer.

 

Script Debugger is not started at the start of Runtime
If you installed a script debugger and the "Start Runtime with Script Debugger" command still 
fails to start it, make the following settings in the Windows registry to set Microsoft Script 
Debugger as default Just-In-Time (JIT) Debugger: 

● "HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-00805F2CD064}]
(Default)="ScriptDebugSvc Class"
"AppID"="{A87F84D0-7A74-11D0-B216-080000185165}"

● [HKEY_CLASSES_ROOT\CLSID
\{834128A2-51F4-11D0-8F20-00805F2CD064}\LocalServer32]
(Default)="c:\\Program Files\\Microsoft Script Debugger\\msscrdbg.exe"
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● [HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-00805F2CD064}\ProgID]
(Default)="ScriptDebugSvc.ScriptDebugSvc.1"

● [HKEY_CLASSES_ROOT\CLSID
\{834128A2-51F4-11D0-8F2000805F2CD064}\VersionIndependentProgID]
(Default)="ScriptDebugSvc.ScriptDebugSvc"

The "LocalServer32" file path must point to the installation folder of Microsoft Script Debugger. 
If you have installed Microsoft Script Debugger in a different folder, adapt the path information. 

10.8.4.3 Starting and stopping the debugger

Requirement
● VBScript-capable debugger (e.g., MS Script Debugger) and WinCC Runtime are installed 

on the configuration PC.

● Project is open.  

Starting the debugger
To start the debugger, proceed as follows:

1. Select the HMI device and then select the "Online > Simulation > With script debugger" 
menu command.
The Runtime software searches for debuggers installed on the configuration PC. 

2. If several debuggers are found click on the one required.

Or:

1. Click "Start > Run".

2. Enter the following command: "HmiRtm /ScriptDebug /<ProjectFile>".
Further information about the project file can be found in "Starting Runtime Advanced and 
Panels (Page 5616)".

Or:

1. Select the "debug" command in the project file shortcut menu in the Windows Explorer.

Result
The debugger is connected automatically with the runtime software.

Stopping the debugger
The debugger is not closed automatically when you close the Runtime software. Therefore, 
close the debugger separately.   
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10.8.5 Runtime behavior in Runtime

10.8.5.1 Executing a function list in Runtime

Principle
A function list is executed from top to bottom in Runtime. A distinction is made between 
synchronous and asynchronous execution, so that no waiting periods ensue during execution. 
The distinction is made by the system by evaluating the different runtimes of the system 
functions. User-defined functions are always executed synchronously independent of the 
runtime. If a system function returns an error status, the execution of the function list is 
cancelled.   

Synchronous execution
During synchronous execution, the system functions in a function list are executed one after 
the other. The previous system function must be finished before the next system function can 
be executed.  

Asynchronous execution
System functions that perform file operations such as saving and reading have a longer runtime 
than system functions that, for example, set a tag value. 

Therefore, system functions with longer runtimes are executed asynchronously. For example, 
while a system function is writing a recipe data record to a storage medium, the next system 
function is already being executed. Due to the parallel execution of system functions, waiting 
periods at the HMI device are avoided.  

10.8.5.2 Executing user-defined functions in Runtime

Principle
Only one user-defined function at a time is executed in Runtime. If several user-defined 
functions are waiting to be executed, they are lined up in a queue and executed one after the 
other. 

 

 Note

A loop in a user-defined function therefore blocks the execution of the other functions in the 
queue even if the functions were initiated asynchronously.
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WinCC supports a maximum nesting depth of eight user-defined functions. Note that the 
nesting depth is not checked.    

 

 Note

If a user-defined function is configured for the "Runtime stop" event, the only system functions 
that may be used in this user-defined function are those which are available at the "Runtime 
stop" event.

Ensure that the ending of the Runtime is not interfered with by the execution of the user-
defined function. 

 

 Note
Configuration of user-defined functions

During configuration make sure that not too many user-defined functions are activated at the 
same time. Avoid a continuous system load of 100%. 

User-defined functions are processed at a lower priority so as not to interfere with the display 
of values and operability. If system utilization is extreme, the user-defined functions to be 
executed are therefore first only reserved for execution. The maximum size of the reservation 
list is dependent on the HMI device and is limited by the maximum permitted number of user-
defined functions. For additional information, see the performance features. If more user-
defined functions are activated at one time than can be reserved, excess calls are discarded 
and a system alarm displayed.

 

HMI device changeover
If you use system functions in a customized function which are not available on the set HMI 
device, you get a warning.  In addition, the corresponding system function in the user-defined 
function will be underlined with a wavy blue line.   

See also
Runtime Stop (Page 3795)

10.8.5.3 Processing sequence for user-defined functions and system functions
 

 WARNING

Adherence to the expected processing sequence for user-defined functions and system 
functions in Runtime cannot always be guaranteed. This fact may lead to unexpected 
operating states.

Please note the following description in which the correlations are explained. Instructions for 
a solution are available under "Remedy".
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Use of user-defined functions for events       
It is not always possible to adhere to the processing sequence for user-defined functions and 
system functions expected in the configuration, for example, when the processing of a user-
defined function lasts beyond the trigger time of a subsequent event. In this case, system 
functions that are configured for the following event may be executed before the system 
functions that were configured with the user-defined function for the same event.

Background
User-defined functions are arranged in a low-priority queue. The queue is processed in 
sequence. If system functions and user-defined functions are configured for an event, all 
system functions and user-defined functions configured for this event are executed in this 
queue.

Example
On a button, you have configured:

 Event Functions
Press User-defined function (1)

SetBit(Tag) (2)

Release ResetBit(Tag) (3)

A

B

Press

Interrupts

lower priority

program

Release

Press Release

(1) Execution time of the user-defined function
(2) Execution time of system function SetBit(Tag)
(3) Execution time of system function ResetBit(Tag)

A: Expected execution of the user-defined function and system functions in the configuration.
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When you press the button, user-defined function (1) and then system function SetBit(Tag) 
(2) are executed. When you release the key, system function ResetBit(Tag) (3) is then 
executed.

B: Processing of the user-defined function is not yet complete when you release the key.

When you press the key, the user-defined function (1) is then executed. The execution of the 
user-defined function (1) is not yet complete and you have already released the key. System 
function ResetBit(Tag) (3) interrupts the execution of the function. In this case, system function 
ResetBit(Tag) (3) is executed before system function SetBit(Tag) (2). As a result, the bit 
remains placed.

System function "SetBitWhileKeyPressed" shows the same behavior, if the system function is 
configured together with user-defined functions.

Remedy
The processing sequence of the previous Example A is adhered to, if you additionally configure 
a user-defined function for the "Release" event. The user-defined function does not require 
functionality for this purpose. 

 Event Functions
Press User-defined function (1)

SetBit(Tag) (2)

Release User-defined function_2 (3)
ResetBit(Tag) (4)

 

 Note

Make sure that the user-defined function queue does not overflow; otherwise the system 
function for the following event may not be executed.

An overflow is recognizable by "Overload: Script <name> is rejected" or "Adherence to the 
expected processing order for user-defined functions and system functions in Runtime cannot 
always be ensured". 

 

10.8.5.4 Making object properties dynamic in Runtime

Introduction
You can use user-defined functions to access object properties of screen objects as well as 
tags in Runtime. If you use a user-defined function to change values of object properties, this 
will not affect the project data.    
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Changes to object properties
If you use a user-defined function in Runtime to change an object property of a screen element, 
this change will only remain effective while the screen is active. If you change to the screen, 
or reload the screen, the configured object properties are displayed once more. 

Language switching
If you switch the language in Runtime, the foreign language labels are loaded from the project 
data. If you use a user-defined function to change texts, the texts changed by the user-defined 
function are overwritten again.   

10.8.6 Examples

10.8.6.1 Example: Converting Fahrenheit into degrees Celsius

Scheduled task
In this example, create a user-defined VB function which converts the values of a temperature 
sensor from Fahrenheit to degrees Celsius. The temperature is displayed in an output field on 
the HMI device.   

Settings
For the example you need two HMI tags and a user-defined VB function with the following 
settings:

HMI tags:

Name PLC connection Type
Fahrenheit Yes Real
Centigrade No Real

User-defined VB function:

Name Type Parameters
FahrenheitToCelsius Function Fahrenheit
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Procedure
1. Create the two HMI-tags "Fahrenheit" and "Celsius" with the settings named above.

2. Create the user-defined VB function "FahrenheitToCelsius" with the settings given above.

3. Write the following VBS code:
FahrenheitToCelsius = (Fahrenheit-32) * (5/9)

Interim result
The HMI tags and the VB user-defined function are created.

Procedure
1. Open the "HMI Tag"editor and click on the "Fahrenheit" tag.

2. Click the "Properties > Events" tab in the Inspector window. Select the "Value change" 
event.

3. Configure the user-defined VB function "FahrenheitToCelsius" to the "Value change" event.

4. Select the tag "Fahrenheit" for the parameter "Fahrenheit".

5. Select the HMI-tag "Celsius" for the return value "Fahrenheit to Celsius".

6. Configure an output field in a screen and connect it with the tag "Celsius".

Alternative procedure
Instead of using a user-defined VB function of the "Function" type, you can also use the "Sub" 
type. In this case, assign the converted value directly to the HMI-tag "Celsius".

SmartTags("Celsius") = (Fahrenheit-32) * (5/9)
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In this case the return value of the user-defined VB function is not applicable. 

Result
When the tag value of "Fahrenheit" changes in Runtime, the user-defined VB function 
"Fahrenheit to Celsius" is performed. The converted temperature value is returned to the HMI-
tag "Celsius" and displayed in the output field. 

10.8.6.2 Example: Converting inches into meters

Scheduled task
In this example you create a user-defined VB function that converts the value of a length 
measuring system from inches into meters. The length in meters is displayed on the HMI device 
in an output field. 

Settings
For the example you need two HMI tags and a user-defined VB function with the following 
settings:

HMI tags:

Name PLC connection Type
VarInch Yes Real
VarMeter No Real

Customized VB function

Name Type Parameters
InchToMeter Sub Inch
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Procedure
1. Create the two HMI tags "VarInch" and "VarMeter" with the above settings.

2. Create the user-defined VB function "InchToMeter" with the settings given above.

3. Write the following VBS code:
VarMeter = Inch*0.0254

Interim result
The tags and the user-defined VB function are created.

Procedure
1. Open the "HMI tags" editor and click the "VarInch" tag.

2. Click "Properties> Events" in the Inspector window. Select the "Value change" event.

3. Configure the user-defined VB function "InchToMeter" to the "Value change" event.

4. Select the "VarInch" HMI tag for the "Inch" parameter.

5. Configure an output field in a screen and connect it with the "VarMeter" HMI tag.

Result
When the tag value of "VarInch" changes in Runtime, the "InchToMeter" user-defined VB 
function is performed. The calculated value is written into the "VarMeter" HMI tag and displayed 
in the output field. 
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10.8.6.3 Example: Changing the operating mode on the HMI device with the current display

Scheduled task
In this example, you use the "SetDeviceMode" system function to switch between the "online" 
and "offline" modes on the HMI device. You also display the current set operating mode on 
the HMI device.   

Requirements
A screen has been created.

Settings
For this example you require a HMI-tag and a text list with the following settings:

HMI tag:

Name PLC connection Type
OperatingMode No Bool

Text list:

Name Contains Values
ShowOperatingMode Bit (0/1) 1: Operating mode: "Online"

0: Operating mode: "Offline"

Procedure
1. Create the "OperatingMode" HMI-tag indicated above.

2. Create the "ShowOperatingMode" text list indicated above.

3. Open the screen and insert a button for which you configure the operating mode change 
to "online".

4. Click "Properties> Events" in the Inspector window. Select the "Press" event.
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5. Configure the "SetDeviceMode" system function for the "Press" event. The system function 
is found in the selection list under "Settings".

6. For the "Mode" parameter, select the "Online" entry.

7. Configure the system function "SetBit" on the event "Press". The system function is found 
in the selection list under "Bit processing".

8. Select the HMI-tag "Operating mode" from the selection list for the parameter "Tag".

9. Add a button in the process screen for which you configure the operating mode change to 
"offline".

10.Repeat steps four to seven. For the "Mode" parameter, select the "Offline" entry. Configure 
the system function "ResetBit" in place of the system function "SetBit."

Interim result
You can toggle the operating mode of the HMI device with the two buttons in Runtime. 

You want to display the current set operating mode in an output field on the HMI device.
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Procedure
1. Create a "Symbolic I/O field" in the process image. Click "Properties > Properties" in the 

Inspector window.

2. Make the following settings in the "General" group:

– Select "Output" as the "Mode".

– Select the text list "Show operating mode" as "Text list".

– Select "Operating mode" as "Tag".

Result
When you change the operating mode with the buttons, the currently set operating mode on 
the HMI device is always shown.

10.8.7 Reference

10.8.7.1 Function list

Device dependency

System functions for Basic Panels

 Availability of system functions
The following table shows the availability of the system functions on the Basic Panels.

Technical data subject to change.     
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Overview

 KP300 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP1000
 Basic DP

KTP1000
 Basic PN

TP1500 
Basic 
PN

User-defined functions No No No No No No No
Logoff (Page 3619) Yes Yes Yes Yes Yes Yes Yes
ActivateScreen (Page 3620) Yes Yes Yes Yes Yes Yes Yes
ActivateScreenByNumber 
(Page 3621) 

Yes Yes Yes Yes Yes Yes Yes

ActivateCleanScreen (Page 3622) No Yes Yes Yes Yes Yes Yes
ActivateSystemDiagnosticsView 
(Page 3740) 

No No No No No No No

ActivatePreviousScreen 
(Page 3623) 

Yes Yes Yes Yes Yes Yes Yes

UpdateTag (Page 3623) Yes Yes Yes Yes Yes Yes Yes
AdjustContrast (Page 3624) Yes Yes No Yes 1) Yes Yes Yes
Logon (Page 3625) Yes Yes Yes Yes Yes Yes Yes
ArchiveLogFile (Page 3626) No No No No No No No
LogTag (Page 3627) No No No No No No No
EditAlarm (Page 3628) Yes Yes Yes Yes Yes Yes No
ScreenObjectCursorDown 
(Page 3629) 

Yes Yes Yes Yes Yes Yes Yes

ScreenObjectCursorUp 
(Page 3629) 

Yes Yes Yes Yes Yes Yes Yes

ScreenObjectPageDown 
(Page 3630) 

Yes Yes Yes Yes Yes Yes Yes

ScreenObjectPageUp 
(Page 3631) 

Yes Yes Yes Yes Yes Yes Yes

Encode (Page 3631) No No No No No No No
EncodeEx (Page 3632) No No No No No No No
DirectKey (Page 3633) No No No No No No No
DirectKeyScreenNumber 
(Page 3636) 

No No No No No No No

PrintScreen (Page 3637) No No No No No No No
PrintReport (Page 3637) No No No No No No No
NotifyUserAction (Page 3638) No No No No No No No
IncreaseFocusedValue 
(Page 3639) 

Yes Yes Yes Yes Yes Yes No

IncreaseTag (Page 3640) Yes Yes Yes Yes Yes Yes Yes
ExportDataRecords (Page 3641) No No No No No No No
ExportDataRecordsWithChecksu
m (Page 3643) 

No No No No No No No

ExportImportUserAdministration 
(Page 3646) 

No No No No No No No
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 KP300 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP1000
 Basic DP

KTP1000
 Basic PN

TP1500 
Basic 
PN

GoToHome (Page 3647) Yes Yes Yes Yes Yes Yes No
GoToEnd (Page 3647) Yes Yes Yes Yes Yes Yes No
SafelyRemoveHardware 
(Page 3648) 

No No No No No No No

HTMLBrowserStop (Page 3649) No No No No No No No
HTMLBrowserRefresh 
(Page 3649) 

No No No No No No No

HTMLBrowserForward 
(Page 3650) 

No No No No No No No

HTMLBrowserBack (Page 3650) No No No No No No No
ImportDataRecords (Page 3651) No No No No No No No
ImportDataRecordsWithChecksu
m (Page 3653) 

No No No No No No No

InvertBit (Page 3654) Yes Yes Yes Yes Yes Yes Yes
InvertBitInTag (Page 3655) Yes Yes Yes Yes Yes Yes Yes
InvertLinearScaling (Page 3656) Yes Yes Yes Yes Yes Yes Yes
CalibrateTouchScreen 
(Page 3658) 

No Yes Yes Yes Yes Yes Yes

CopyLog (Page 3659) No No No No No No No
TrendViewScrollForward 
(Page 3660) 

Yes Yes Yes Yes Yes Yes Yes

TrendViewScrollBack (Page 3660) Yes Yes Yes Yes Yes Yes Yes
TrendViewExtend (Page 3661) Yes Yes Yes Yes Yes Yes Yes
TrendViewCompress (Page 3661) Yes Yes Yes Yes Yes Yes Yes
TrendViewRulerLeft (Page 3662) Yes Yes Yes Yes Yes Yes Yes
TrendViewRulerRight (Page 3663) Yes Yes Yes Yes Yes Yes Yes
TrendViewSetRulerMode 
(Page 3663) 

Yes Yes Yes Yes Yes Yes Yes

TrendViewStartStop (Page 3664) Yes Yes Yes Yes Yes Yes Yes
TrendViewBackToBeginning 
(Page 3664) 

Yes Yes Yes Yes Yes Yes Yes

LoadDataRecord (Page 3665) No No No No No No No
GetUserName (Page 3666) Yes Yes Yes Yes Yes Yes Yes
GetDataRecordFromPLC 
(Page 3667) 

No No No No No No No

GetDataRecordName 
(Page 3668) 

No No No No No No No

GetDataRecordTagsFromPLC 
(Page 3670) 

No No No No No No No

GetGroupNumber (Page 3671) Yes Yes Yes Yes Yes Yes Yes
GetBrightness (Page 3671) No No No No No No No
GetPassword (Page 3672) Yes Yes Yes Yes Yes Yes Yes
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 KP300 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP1000
 Basic DP

KTP1000
 Basic PN

TP1500 
Basic 
PN

LinearScaling (Page 3673) Yes Yes Yes Yes Yes Yes Yes
ClearLog (Page 3675) No No No No No No No
ClearDataRecord (Page 3676) No No No No No No No
ClearDataRecordMemory 
(Page 3677) 

No No No No No No No

ClearAlarmBuffer (Page 3678) Yes Yes Yes Yes Yes Yes Yes
ClearAlarmBufferProTool 
(Page 3679) 

Yes Yes Yes Yes Yes Yes Yes

AlarmViewUpdate (Page 3680) No No No No No No No
AlarmViewEditAlarm (Page 3680) Yes Yes Yes Yes Yes Yes Yes
AlarmViewAcknowledgeAlarm 
(Page 3681) 

Yes Yes Yes Yes Yes Yes Yes

AlarmViewShowOperatorNotes 
(Page 3682) 

Yes Yes Yes Yes Yes Yes Yes

OpenAllLogs (Page 3683) No No No No No No No
OpenScreenKeyboard 
(Page 3684) 

No No No No No No No

OpenControlPanelDialog Yes 2) Yes 2) Yes 2) Yes 2) Yes 2) Yes 2) Yes 2)

OpenCommandPrompt 
(Page 3686) 

No No No No No No No

OpenInternetExplorer 
(Page 3687) 

No No No No No No No

OpenControlPanel No No No No No No No
OpenTaskManager (Page 3689) No No No No No No No
AcknowledgeAlarm (Page 3689) Yes Yes Yes Yes Yes Yes No
RecipeViewNewDataRecord 
(Page 3690) 

Yes Yes Yes Yes Yes Yes Yes

RecipeViewGetDataRecordFromP
LC (Page 3690) 

Yes Yes Yes Yes Yes Yes Yes

RecipeViewClearDataRecord 
(Page 3691) 

Yes Yes Yes Yes Yes Yes Yes

RecipeViewMenu (Page 3691) Yes Yes Yes Yes Yes Yes Yes
RecipeViewOpen (Page 3692) Yes Yes Yes Yes Yes Yes Yes
RecipeViewSetDataRecordToPLC
 (Page 3693) 

Yes Yes Yes Yes Yes Yes Yes

RecipeViewSaveDataRecord 
(Page 3693) 

Yes Yes Yes Yes Yes Yes Yes

RecipeViewSaveAsDataRecord 
(Page 3694) 

Yes Yes Yes Yes Yes Yes Yes

RecipeViewSynchronizeDataReco
rdWithTags (Page 3694) 

No No No No No No No

RecipeViewRenameDataRecord 
(Page 3695) 

Yes Yes Yes Yes Yes Yes Yes

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3586 System Manual, 07/2013,  



 KP300 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP1000
 Basic DP

KTP1000
 Basic PN

TP1500 
Basic 
PN

RecipeViewShowOperatorNotes 
(Page 3696) 

Yes Yes Yes Yes Yes Yes Yes

RecipeViewBack (Page 3696) Yes Yes Yes Yes Yes Yes Yes
ResetBit (Page 3697) Yes Yes Yes Yes Yes Yes Yes
ResetBitInTag (Page 3698) Yes Yes Yes Yes Yes Yes Yes
PressButton (Page 3699) Yes Yes Yes Yes Yes Yes No
ReleaseButton (Page 3700) Yes Yes Yes Yes Yes Yes No
ShiftAndMask (Page 3701) Yes Yes Yes Yes Yes Yes Yes
CloseAllLogs (Page 3702) No No No No No No No
SetDataRecordToPLC 
(Page 3703) 

No No No No No No No

SetDataRecordTagsToPLC 
(Page 3704) 

No No No No No No No

PageDown (Page 3705) Yes Yes Yes Yes Yes Yes No
PageUp (Page 3706) Yes Yes Yes Yes Yes Yes No
SendEMail (Page 3706) No No No No No No No
SetAcousticSignal (Page 3707) No No No No No No No
SetDisplayMode (Page 3708) No No No No No No No
SetDeviceMode (Page 3709) Yes Yes Yes Yes Yes Yes Yes
SetBit (Page 3710) Yes Yes Yes Yes Yes Yes Yes
SetBitInTag (Page 3711) Yes Yes Yes Yes Yes Yes Yes
SetBitWhileKeyPressed 
(Page 3712) 

Yes Yes Yes Yes Yes Yes Yes

SetBacklightColor (Page 3713) Yes No No No No No No
SetBrightness (Page 3714) No No No No No No No
SetScreenKeyboardMode 
(Page 3715) 

No No No No No No No

SetAlarmReportMode 
(Page 3717) 

No No No No No No No

SetRecipeTags (Page 3718) No No No No No No No
SetDaylightSavingTime 
(Page 3719) 

No No No No No No No

SetLanguage (Page 3720) Yes Yes Yes Yes Yes Yes Yes
SetTag (Page 3722) Yes Yes Yes Yes Yes Yes Yes
SetConnectionMode (Page 3723) Yes Yes Yes Yes Yes Yes Yes
SetWebAccess (Page 3724) No No No No No No No
BackupRAMFileSystem 
(Page 3725) 

No No No No No No No

SimulateSystemKey (Page 3726) Yes Yes Yes Yes Yes Yes No
SimulateTag (Page 3727) Yes Yes Yes Yes Yes Yes Yes
SmartClientViewRefresh 
(Page 3728) 

No No No No No No No
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 KP300 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP1000
 Basic DP

KTP1000
 Basic PN

TP1500 
Basic 
PN

SmartClientViewReadOnlyOff 
(Page 3728) 

No No No No No No No

SmartClientViewReadOnlyOn 
(Page 3729) 

No No No No No No No

SmartClientViewDisconnect 
(Page 3729) 

No No No No No No No

SmartClientViewConnect 
(Page 3730) 

No No No No No No No

SmartClientViewLeave 
(Page 3731) 

No No No No No No No

SaveDataRecord (Page 3731) No No No No No No No
StartLogging (Page 3732) No No No No No No No
StartNextLog (Page 3733) No No No No No No No
StartProgram (Page 3734) No No No No No No No
StatusForceGetValues 
(Page 3736) 

No No No No No No No

StatusForceSetValues 
(Page 3736) 

No No No No No No No

ControlSmartServer (Page 3737) No No No No No No No
ControlWebServer (Page 3737) No No No No No No No
StopLogging (Page 3738) No No No No No No No
StopRuntime (Page 3739) Yes Yes Yes Yes Yes Yes Yes
LookupText (Page 3743) No No No No No No No
ResetTagToHandWheel 
(Page 3744) 

No No No No No No No

SetTagToHandWheel 
(Page 3745) 

No No No No No No No

TraceUserChange (Page 3745) Yes Yes Yes Yes Yes Yes Yes
DecreaseFocusedValue 
(Page 3746) 

Yes Yes Yes Yes Yes Yes No

DecreaseTag (Page 3746) Yes Yes Yes Yes Yes Yes Yes
ChangeConnection (Page 3747) Yes Yes Yes Yes Yes Yes Yes
WinACMPUpdateStartupCharacte
ristics (Page 3753) 

No No No No No No No

WinACMPUpdateKeySwitchSettin
g (Page 3754) 

No No No No No No No

WinACMPUpdateBUSF1LED 
(Page 3755) 

No No No No No No No

WinACMPUpdateBUSF2LED 
(Page 3756) 

No No No No No No No

WinACMPUpdateAverageExecTi
me (Page 3757) 

No No No No No No No

WinACMPUpdateAverageCycleTi
me (Page 3758) 

No No No No No No No
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 KP300 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP1000
 Basic DP

KTP1000
 Basic PN

TP1500 
Basic 
PN

WinACMPUpdateEXTFLED 
(Page 3759) 

No No No No No No No

WinACMPUpdateHMIEnableTime 
(Page 3760) 

No No No No No No No

WinACMPUpdateINTFLED 
(Page 3760) 

No No No No No No No

WinACMPUpdateLastCycleTime 
(Page 3761) 

No No No No No No No

WinACMPUpdateMaximumCycleT
ime (Page 3762) 

No No No No No No No

WinACMPUpdateMinimumCycleTi
me (Page 3763) 

No No No No No No No

WinACMPUpdatePowerLED 
(Page 3764) 

No No No No No No No

WinACMPUpdateSleepTime 
(Page 3765) 

No No No No No No No

WinACMPUpdateRUNLED 
(Page 3766) 

No No No No No No No

WinACMPUpdateSTOPLED 
(Page 3767) 

No No No No No No No

WinACMPArchive (Page 3768) No No No No No No No
WinACMPGetStartCharacteristics 
(Page 3768) 

No No No No No No No

WinACMPGetVersion 
(Page 3769) 

No No No No No No No

WinACMPClearCycleTimeBuffer 
(Page 3770) 

No No No No No No No

WinACMPSetStartAtBoot 
(Page 3770) 

No No No No No No No

WinACMPSetKeySwitch 
(Page 3771) 

No No No No No No No

WinACMPSetHMIExecutionTime 
(Page 3771) 

No No No No No No No

WinACMPSetRestartMethod 
(Page 3772) 

No No No No No No No

WinACMPSetSleepTime 
(Page 3772) 

No No No No No No No

WinACMPSetStartMode 
(Page 3773) 

No No No No No No No

WinACMPStartHistogram 
(Page 3773) 

No No No No No No No

WinACMPControl (Page 3774) No No No No No No No
WinACMPStopHistogram 
(Page 3774) 

No No No No No No No

WinACMPRestore (Page 3775) No No No No No No No
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 KP300 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP1000
 Basic DP

KTP1000
 Basic PN

TP1500 
Basic 
PN

ShowLogonDialog (Page 3749) Yes Yes Yes Yes Yes Yes Yes
ShowOperatorNotes (Page 3749) Yes Yes Yes Yes Yes Yes Yes
ShowAlarmWindow (Page 3750) Yes Yes Yes Yes Yes Yes Yes
ShowSoftwareVersion 
(Page 3751) 

No No No No No No No

ShowSystemDiagnosticsWindow 
(Page 3752) 

No No No No No No No

ShowSystemAlarm (Page 3752) No No No No No No No

1) For KTP600 Basic mono PN only
2) Only for editing the IP settings

See also
OpenControlPanelDialog (Page 3685)

System functions for Panels

Availability of system functions
The following table shows the availability of the system functions on the Panels. 

Technical data subject to change.       

Overview

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

User-defined functions No No No No No Yes
Logoff (Page 3619) Yes Yes Yes Yes Yes Yes
ActivateScreen (Page 3620) Yes Yes Yes Yes Yes Yes
ActivateScreenByNumber 
(Page 3621) 

Yes Yes Yes Yes Yes Yes

ActivateCleanScreen (Page 3622) No No No Yes Yes 4) Yes 2)

ActivateSystemDiagnosticsView 
(Page 3740) 

No No No No No No

ActivatePreviousScreen 
(Page 3623) 

Yes Yes Yes Yes Yes Yes

UpdateTag (Page 3623) Yes Yes No Yes Yes Yes
AdjustContrast (Page 3624) Yes Yes Yes Yes Yes No
Logon (Page 3625) Yes Yes Yes Yes Yes Yes
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

ArchiveLogFile (Page 3626) No No No No No Yes
LogTag (Page 3627) No No No No No Yes
EditAlarm (Page 3628) Yes Yes Yes No Yes Yes 1)

ScreenObjectCursorDown 
(Page 3629) 

Yes Yes Yes Yes Yes Yes

ScreenObjectCursorUp 
(Page 3629) 

Yes Yes Yes Yes Yes Yes

ScreenObjectPageDown 
(Page 3630) 

Yes Yes Yes Yes Yes Yes

ScreenObjectPageUp (Page 3631) Yes Yes Yes Yes Yes Yes
Encode (Page 3631) No No Yes Yes Yes Yes
EncodeEx (Page 3632) No No Yes Yes Yes Yes
DirectKey (Page 3633) No No No No Yes) Yes 2)

DirectKeyScreenNumber 
(Page 3636) 

No No No No Yes) Yes 2)

PrintScreen (Page 3637) No No Yes No Yes Yes
PrintReport (Page 3637) No No Yes No Yes Yes
NotifyUserAction (Page 3638) No No No No No Yes
IncreaseFocusedValue 
(Page 3639) 

Yes Yes Yes No Yes 1) Yes 1)

IncreaseTag (Page 3640) Yes Yes Yes Yes Yes Yes
ExportDataRecords (Page 3641) No No Yes No Yes Yes
ExportDataRecordsWithChecksum 
(Page 3643) 

No No No No No Yes

ExportImportUserAdministration 
(Page 3646) 

No No Yes No Yes Yes

GoToHome (Page 3647) Yes Yes Yes No Yes 1) Yes 1)

GoToEnd (Page 3647) Yes Yes Yes No Yes 1) Yes 1)

SafelyRemoveHardware 
(Page 3648) 

No No No No Yes 5) No

HTMLBrowserStop (Page 3649) No No No No No No
HTMLBrowserRefresh (Page 3649) No No No No No No
HTMLBrowserForward (Page 3650) No No No No No No
HTMLBrowserBack (Page 3650) No No No No No No
ImportDataRecords (Page 3651) No No Yes No Yes Yes
ImportDataRecordsWithChecksum 
(Page 3653) 

No No No No No Yes

InvertBit (Page 3654) Yes Yes Yes Yes Yes Yes
InvertBitInTag (Page 3655) Yes Yes Yes Yes Yes Yes
InvertLinearScaling (Page 3656) Yes Yes Yes Yes Yes Yes
CalibrateTouchScreen (Page 3658) No No No Yes Yes Yes 2)

CopyLog (Page 3659) No No No No No Yes
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

TrendViewScrollForward 
(Page 3660) 

No No No Yes Yes Yes

TrendViewScrollBack (Page 3660) No No No Yes Yes Yes
TrendViewExtend (Page 3661) No No No Yes Yes Yes
TrendViewCompress (Page 3661) No No No Yes Yes Yes
TrendViewRulerLeft (Page 3662) No No No Yes Yes Yes
TrendViewRulerRight (Page 3663) No No No Yes Yes Yes
TrendViewSetRulerMode 
(Page 3663) 

No No No Yes Yes Yes

TrendViewStartStop (Page 3664) No No No Yes Yes Yes
TrendViewBackToBeginning 
(Page 3664) 

No No No Yes Yes Yes

LoadDataRecord (Page 3665) No No No No Yes Yes
GetUserName (Page 3666) Yes Yes Yes Yes Yes Yes
GetDataRecordFromPLC 
(Page 3667) 

No No No No Yes Yes

GetDataRecordName (Page 3668) No No No No Yes Yes
GetDataRecordTagsFromPLC 
(Page 3670) 

No No No No Yes Yes

GetGroupNumber (Page 3671) Yes Yes Yes Yes Yes Yes
GetBrightness (Page 3671) No No No No No No
GetPassword (Page 3672) Yes Yes Yes Yes Yes Yes
LinearScaling (Page 3673) Yes Yes Yes Yes Yes Yes
ClearLog (Page 3675) No No No No No Yes
ClearDataRecord (Page 3676) No No No No Yes Yes
ClearDataRecordMemory 
(Page 3677) 

No No No No Yes Yes

ClearAlarmBuffer (Page 3678) Yes Yes Yes Yes Yes Yes
ClearAlarmBufferProTool 
(Page 3679) 

Yes Yes Yes No Yes Yes

AlarmViewUpdate (Page 3680) No No Yes No Yes Yes
AlarmViewEditAlarm (Page 3680) Yes Yes Yes Yes Yes Yes
AlarmViewAcknowledgeAlarm 
(Page 3681) 

Yes Yes Yes Yes Yes Yes

AlarmViewShowOperatorNotes 
(Page 3682) 

Yes Yes Yes Yes Yes Yes

OpenAllLogs (Page 3683) No No No No No Yes
OpenScreenKeyboard (Page 3684) No No No No No Yes
OpenControlPanelDialog No No No No No No
OpenCommandPrompt 
(Page 3686) 

No No No No No Yes

OpenInternetExplorer (Page 3687) No No No No Yes 3) Yes
OpenControlPanel No No No No Yes Yes
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

OpenTaskManager (Page 3689) No No No No No Yes
AcknowledgeAlarm (Page 3689) Yes Yes Yes No Yes 1) 4) Yes 1)

RecipeViewNewDataRecord 
(Page 3690) 

No Yes Yes Yes Yes Yes

RecipeViewGetDataRecordFromPL
C (Page 3690) 

No Yes Yes Yes Yes Yes

RecipeViewClearDataRecord 
(Page 3691) 

No Yes Yes Yes Yes Yes

RecipeViewMenu (Page 3691) No Yes Yes Yes Yes Yes
RecipeViewOpen (Page 3692) No Yes Yes Yes Yes Yes
RecipeViewSetDataRecordToPLC 
(Page 3693) 

No Yes Yes Yes Yes Yes

RecipeViewSaveDataRecord 
(Page 3693) 

No Yes Yes Yes Yes Yes

RecipeViewSaveAsDataRecord 
(Page 3694) 

No Yes Yes Yes Yes Yes

RecipeViewSynchronizeDataRecor
dWithTags (Page 3694) 

No No No No Yes Yes

RecipeViewRenameDataRecord 
(Page 3695) 

No Yes Yes Yes Yes Yes

RecipeViewShowOperatorNotes 
(Page 3696) 

No Yes Yes Yes Yes Yes

RecipeViewBack (Page 3696) No Yes Yes Yes Yes Yes
ResetBit (Page 3697) Yes Yes Yes Yes Yes Yes
ResetBitInTag (Page 3698) Yes Yes Yes Yes Yes Yes
PressButton (Page 3699) Yes Yes Yes No Yes) Yes)

ReleaseButton (Page 3700) Yes Yes Yes No Yes Yes 1)

ShiftAndMask (Page 3701) Yes Yes Yes Yes Yes Yes
CloseAllLogs (Page 3702) No No No No No Yes
SetDataRecordToPLC (Page 3703) No No No No Yes Yes
SetDataRecordTagsToPLC 
(Page 3704) 

No No No No Yes Yes

PageDown (Page 3705) Yes Yes Yes No Yes 1) 4) Yes 1)

PageUp (Page 3706) Yes Yes Yes No yes 1).4) Yes 1)

SendEMail (Page 3706) Yes Yes Yes No Yes 3) Yes
SetAcousticSignal (Page 3707) No No No No No No
SetDisplayMode (Page 3708) No No No No No No
SetDeviceMode (Page 3709) Yes Yes Yes Yes Yes Yes
SetBit (Page 3710) Yes Yes Yes Yes Yes Yes
SetBitInTag (Page 3711) Yes Yes Yes Yes Yes Yes
SetBitWhileKeyPressed 
(Page 3712) 

Yes Yes Yes Yes Yes Yes

SetBacklightColor (Page 3713) No No No No No No
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

SetBrightness (Page 3714) No No No No No No
SetScreenKeyboardMode 
(Page 3715) 

No No No No No Yes

SetAlarmReportMode (Page 3717) No No Yes No Yes Yes
SetRecipeTags (Page 3718) No No Yes No Yes Yes
SetDaylightSavingTime 
(Page 3719) 

No No No No No No

SetLanguage (Page 3720) Yes Yes Yes Yes Yes Yes
SetTag (Page 3722) Yes Yes Yes Yes Yes Yes
SetConnectionMode (Page 3723) Yes Yes Yes Yes Yes Yes
SetWebAccess (Page 3724) No No No No Yes Yes
BackupRAMFileSystem 
(Page 3725) 

No No No No No No

SimulateSystemKey (Page 3726) No No Yes No yes 1) 4) Yes 1)

SimulateTag (Page 3727) Yes Yes Yes Yes Yes Yes
SmartClientViewRefresh 
(Page 3728) 

No No No No Yes 3) Yes

SmartClientViewReadOnlyOff 
(Page 3728) 

No No No No Yes 3) Yes

SmartClientViewReadOnlyOn 
(Page 3729) 

No No No No Yes 3) Yes

SmartClientViewDisconnect 
(Page 3729) 

No No No No Yes 3) Yes

SmartClientViewConnect 
(Page 3730) 

No No No No Yes 3) Yes

SmartClientViewLeave (Page 3731) No No No No Yes 3) Yes
SaveDataRecord (Page 3731) No No No No Yes Yes
StartLogging (Page 3732) No No No No No Yes
StartNextLog (Page 3733) No No No No No Yes
StartProgram (Page 3734) No No No No No Yes
StatusForceGetValues (Page 3736) No No No No Yes Yes
StatusForceSetValues (Page 3736) No No No No Yes Yes
ControlSmartServer (Page 3737) No No No No Yes 3) Yes
ControlWebServer (Page 3737) No No No No Yes 3) Yes
StopLogging (Page 3738) No No No No No Yes
StopRuntime (Page 3739) Yes Yes Yes Yes Yes Yes
LookupText (Page 3743) No No Yes No Yes Yes
ResetTagToHandWheel 
(Page 3744) 

No No No No No No

SetTagToHandWheel (Page 3745) No No No No No No
TraceUserChange (Page 3745) Yes Yes Yes Yes Yes Yes
DecreaseFocusedValue 
(Page 3746) 

Yes Yes Yes No yes 1)4) Yes 1)
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

DecreaseTag (Page 3746) Yes Yes Yes Yes Yes Yes
ChangeConnection (Page 3747) Yes Yes Yes Yes Yes Yes
WinACMPUpdateStartupCharacteri
stics (Page 3753) 

No No No No No No

WinACMPUpdateKeySwitchSetting 
(Page 3754) 

No No No No No No

WinACMPUpdateBUSF1LED 
(Page 3755) 

No No No No No No

WinACMPUpdateBUSF2LED 
(Page 3756) 

No No No No No No

WinACMPUpdateAverageExecTim
e (Page 3757) 

No No No No No No

WinACMPUpdateAverageCycleTim
e (Page 3758) 

No No No No No No

WinACMPUpdateEXTFLED 
(Page 3759) 

No No No No No No

WinACMPUpdateHMIEnableTime 
(Page 3760) 

No No No No No No

WinACMPUpdateINTFLED 
(Page 3760) 

No No No No No No

WinACMPUpdateLastCycleTime 
(Page 3761) 

No No No No No No

WinACMPUpdateMaximumCycleTi
me (Page 3762) 

No No No No No No

WinACMPUpdateMinimumCycleTi
me (Page 3763) 

No No No No No No

WinACMPUpdatePowerLED 
(Page 3764) 

No No No No No No

WinACMPUpdateSleepTime 
(Page 3765) 

No No No No No No

WinACMPUpdateRUNLED 
(Page 3766) 

No No No No No No

WinACMPUpdateSTOPLED 
(Page 3767) 

No No No No No No

WinACMPArchive (Page 3768) No No No No No No
WinACMPGetStartCharacteristics 
(Page 3768) 

No No No No No No

WinACMPGetVersion (Page 3769) No No No No No No
WinACMPClearCycleTimeBuffer 
(Page 3770) 

No No No No No No

WinACMPSetStartAtBoot 
(Page 3770) 

No No No No No No

WinACMPSetKeySwitch 
(Page 3771) 

No No No No No No

WinACMPSetHMIExecutionTime 
(Page 3771) 

No No No No No No
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

WinACMPSetRestartMethod 
(Page 3772) 

No No No No No No

WinACMPSetSleepTime 
(Page 3772) 

No No No No No No

WinACMPSetStartMode 
(Page 3773) 

No No No No No No

WinACMPStartHistogram 
(Page 3773) 

No No No No No No

WinACMPControl (Page 3774) No No No No No No
WinACMPStopHistogram 
(Page 3774) 

No No No No No No

WinACMPRestore (Page 3775) No No No No No No
ShowLogonDialog (Page 3749) Yes Yes Yes Yes Yes Yes
ShowOperatorNotes (Page 3749) Yes Yes Yes Yes Yes Yes
ShowAlarmWindow (Page 3750) Yes Yes Yes Yes Yes Yes
ShowSoftwareVersion (Page 3751) No No No No No Yes
ShowSystemDiagnosticsWindow 
(Page 3752) 

No No No No No No

ShowSystemAlarm (Page 3752) No No Yes No Yes Yes

1) only with keyboard units
2) only with touch screen devices
3) only with PROFINET Bus (PN devices)
4) only with TP 177B
5) Only for TP 177B 4" PN/DP

See also
OpenControlPanelDialog (Page 3685)

System functions for Multi Panels

Availability of system functions
The following table shows the availability of the system functions on the Multi Panels. 

Technical data subject to change.       
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Overview

 MP 177 MP 277 MP 377
User-defined functions No Yes Yes
Logoff (Page 3619) Yes Yes Yes
ActivateScreen (Page 3620) Yes Yes Yes
ActivateScreenByNumber (Page 3621) Yes Yes Yes
ActivateCleanScreen (Page 3622) Yes 2) Yes 2) Yes 2)

ActivateSystemDiagnosticsView 
(Page 3740) 

No No No

ActivatePreviousScreen (Page 3623) Yes Yes Yes
UpdateTag (Page 3623) Yes Yes Yes
AdjustContrast (Page 3624) Yes 2) No No
Logon (Page 3625) Yes Yes Yes
ArchiveLogFile (Page 3626) No Yes Yes
LogTag (Page 3627) No Yes Yes
EditAlarm (Page 3628) No Yes 1) No
ScreenObjectCursorDown 
(Page 3629) 

Yes Yes Yes

ScreenObjectCursorUp (Page 3629) Yes Yes Yes
ScreenObjectPageDown (Page 3630) Yes Yes Yes
ScreenObjectPageUp (Page 3631) Yes Yes Yes
Encode (Page 3631) Yes Yes Yes
EncodeEx (Page 3632) Yes Yes Yes
DirectKey (Page 3633) Yes 2) Yes 2) Yes 2)

DirectKeyScreenNumber (Page 3636) Yes 2) Yes 2) Yes 2)

PrintScreen (Page 3637) Yes Yes Yes
PrintReport (Page 3637) Yes Yes Yes
NotifyUserAction (Page 3638) No Yes Yes
IncreaseFocusedValue (Page 3639) Yes 1) Yes 1) Yes 1)

IncreaseTag (Page 3640) Yes Yes Yes
ExportDataRecords (Page 3641) Yes Yes Yes
ExportDataRecordsWithChecksum 
(Page 3643) 

Yes Yes Yes

ExportImportUserAdministration 
(Page 3646) 

Yes Yes Yes

GoToHome (Page 3647) Yes 1) Yes 1) Yes 1)

GoToEnd (Page 3647) Yes 1) Yes 1) Yes 1)

SafelyRemoveHardware (Page 3648) No Yes Yes
HTMLBrowserStop (Page 3649) No No No
HTMLBrowserRefresh (Page 3649) No No No
HTMLBrowserForward (Page 3650) No No No
HTMLBrowserBack (Page 3650) No No No
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 MP 177 MP 277 MP 377
ImportDataRecords (Page 3651) Yes Yes Yes
ImportDataRecordsWithChecksum 
(Page 3653) 

Yes Yes Yes

InvertBit (Page 3654) Yes Yes Yes
InvertBitInTag (Page 3655) Yes Yes Yes
InvertLinearScaling (Page 3656) Yes Yes Yes
CalibrateTouchScreen (Page 3658) Yes 2) Yes 2) Yes 2)

CopyLog (Page 3659) No Yes Yes
TrendViewScrollForward (Page 3660) Yes Yes Yes
TrendViewScrollBack (Page 3660) Yes Yes Yes
TrendViewExtend (Page 3661) Yes Yes Yes
TrendViewCompress (Page 3661) Yes Yes Yes
TrendViewRulerLeft (Page 3662) Yes Yes Yes
TrendViewRulerRight (Page 3663) Yes Yes Yes
TrendViewSetRulerMode (Page 3663) Yes Yes Yes
TrendViewStartStop (Page 3664) Yes Yes Yes
TrendViewBackToBeginning 
(Page 3664) 

Yes Yes Yes

LoadDataRecord (Page 3665) Yes Yes Yes
GetUserName (Page 3666) Yes Yes Yes
GetDataRecordFromPLC (Page 3667) Yes Yes Yes
GetDataRecordName (Page 3668) Yes Yes Yes
GetDataRecordTagsFromPLC 
(Page 3670) 

Yes Yes Yes

GetGroupNumber (Page 3671) Yes Yes Yes
GetBrightness (Page 3671) No No No
GetPassword (Page 3672) Yes Yes Yes
LinearScaling (Page 3673) Yes Yes Yes
ClearLog (Page 3675) No Yes Yes
ClearDataRecord (Page 3676) Yes Yes Yes
ClearDataRecordMemory (Page 3677) Yes Yes Yes
ClearAlarmBuffer (Page 3678) Yes Yes Yes
ClearAlarmBufferProTool (Page 3679) Yes Yes Yes
AlarmViewUpdate (Page 3680) Yes Yes Yes
AlarmViewEditAlarm (Page 3680) Yes Yes Yes
AlarmViewAcknowledgeAlarm 
(Page 3681) 

Yes Yes Yes

AlarmViewShowOperatorNotes 
(Page 3682) 

Yes Yes Yes

OpenAllLogs (Page 3683) No Yes Yes
OpenScreenKeyboard (Page 3684) No Yes Yes
OpenControlPanelDialog No No No
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 MP 177 MP 277 MP 377
OpenCommandPrompt (Page 3686) No Yes Yes
OpenInternetExplorer (Page 3687) No Yes Yes
OpenControlPanel Yes Yes Yes
OpenTaskManager (Page 3689) No Yes Yes
AcknowledgeAlarm (Page 3689) Yes 1) Yes 1) Yes 1)

RecipeViewNewDataRecord 
(Page 3690) 

Yes Yes Yes

RecipeViewGetDataRecordFromPLC 
(Page 3690) 

Yes Yes Yes

RecipeViewClearDataRecord 
(Page 3691) 

Yes Yes Yes

RecipeViewMenu (Page 3691) Yes Yes Yes
RecipeViewOpen (Page 3692) Yes Yes Yes
RecipeViewSetDataRecordToPLC 
(Page 3693) 

Yes Yes Yes

RecipeViewSaveDataRecord 
(Page 3693) 

Yes Yes Yes

RecipeViewSaveAsDataRecord 
(Page 3694) 

Yes Yes Yes

RecipeViewSynchronizeDataRecordW
ithTags (Page 3694) 

Yes Yes Yes

RecipeViewRenameDataRecord 
(Page 3695) 

Yes Yes Yes

RecipeViewShowOperatorNotes 
(Page 3696) 

Yes Yes Yes

RecipeViewBack (Page 3696) Yes Yes Yes
ResetBit (Page 3697) Yes Yes Yes
ResetBitInTag (Page 3698) Yes Yes Yes
PressButton (Page 3699) Yes Yes Yes)

ReleaseButton (Page 3700) Yes) Yes) Yes)

ShiftAndMask (Page 3701) Yes Yes Yes
CloseAllLogs (Page 3702) No Yes Yes
SetDataRecordToPLC (Page 3703) Yes Yes Yes
SetDataRecordTagsToPLC 
(Page 3704) 

Yes Yes Yes

PageDown (Page 3705) Yes 1) Yes 1) Yes 1)

PageUp (Page 3706) Yes 1) Yes 1) Yes 1)

SendEMail (Page 3706) Yes Yes Yes
SetAcousticSignal (Page 3707) No Yes 2) Yes 2)

SetDisplayMode (Page 3708) No No No
SetDeviceMode (Page 3709) Yes Yes Yes
SetBit (Page 3710) Yes Yes Yes
SetBitInTag (Page 3711) Yes Yes Yes
SetBitWhileKeyPressed (Page 3712) Yes Yes 1) Yes 1)
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 MP 177 MP 277 MP 377
SetBacklightColor (Page 3713) No No No
SetBrightness (Page 3714) No No No
SetScreenKeyboardMode (Page 3715) No Yes Yes
SetAlarmReportMode (Page 3717) Yes Yes Yes
SetRecipeTags (Page 3718) Yes Yes Yes
SetDaylightSavingTime (Page 3719) No Yes Yes
SetLanguage (Page 3720) Yes Yes Yes
SetAndGetBrightness (Page 3721) No No Yes 3)

SetTag (Page 3722) Yes Yes Yes
SetConnectionMode (Page 3723) Yes Yes Yes
SetWebAccess (Page 3724) Yes Yes Yes
BackupRAMFileSystem (Page 3725) No Yes Yes
SimulateSystemKey (Page 3726) No Yes 1) Yes 1)

SimulateTag (Page 3727) Yes Yes Yes
SmartClientViewRefresh (Page 3728) Yes Yes Yes
SmartClientViewReadOnlyOff 
(Page 3728) 

Yes Yes Yes

SmartClientViewReadOnlyOn 
(Page 3729) 

Yes Yes Yes

SmartClientViewDisconnect 
(Page 3729) 

Yes Yes Yes

SmartClientViewConnect (Page 3730) Yes Yes Yes
SmartClientViewLeave (Page 3731) Yes Yes Yes
SaveDataRecord (Page 3731) Yes Yes Yes
StartLogging (Page 3732) No Yes Yes
StartNextLog (Page 3733) No Yes Yes
StartProgram (Page 3734) Yes Yes Yes
StatusForceGetValues (Page 3736) Yes Yes Yes
StatusForceSetValues (Page 3736) Yes Yes Yes
ControlSmartServer (Page 3737) Yes Yes Yes
ControlWebServer (Page 3737) Yes Yes Yes
StopLogging (Page 3738) No Yes Yes
StopRuntime (Page 3739) Yes Yes Yes
LookupText (Page 3743) Yes Yes Yes
ResetTagToHandWheel (Page 3744) No No No
SetTagToHandWheel (Page 3745) No No No
TraceUserChange (Page 3745) Yes Yes Yes
DecreaseFocusedValue (Page 3746) Yes 1) Yes 1) Yes 1)

DecreaseTag (Page 3746) Yes Yes Yes
ChangeConnection (Page 3747) Yes Yes Yes
WinACMPUpdateStartupCharacteristic
s (Page 3753) 

Yes Yes Yes
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 MP 177 MP 277 MP 377
WinACMPUpdateKeySwitchSetting 
(Page 3754) 

Yes Yes Yes

WinACMPUpdateBUSF1LED 
(Page 3755) 

Yes Yes Yes

WinACMPUpdateBUSF2LED 
(Page 3756) 

Yes Yes Yes

WinACMPUpdateAverageExecTime 
(Page 3757) 

Yes Yes Yes

WinACMPUpdateAverageCycleTime 
(Page 3758) 

Yes Yes Yes

WinACMPUpdateEXTFLED 
(Page 3759) 

Yes Yes Yes

WinACMPUpdateHMIEnableTime 
(Page 3760) 

Yes Yes Yes

WinACMPUpdateINTFLED 
(Page 3760) 

Yes Yes Yes

WinACMPUpdateLastCycleTime 
(Page 3761) 

Yes Yes Yes

WinACMPUpdateMaximumCycleTime 
(Page 3762) 

Yes Yes Yes

WinACMPUpdateMinimumCycleTime 
(Page 3763) 

Yes Yes Yes

WinACMPUpdatePowerLED 
(Page 3764) 

Yes Yes Yes

WinACMPUpdateSleepTime 
(Page 3765) 

Yes Yes Yes

WinACMPUpdateRUNLED 
(Page 3766) 

Yes Yes Yes

WinACMPUpdateSTOPLED 
(Page 3767) 

Yes Yes Yes

WinACMPArchive (Page 3768) Yes Yes Yes
WinACMPGetStartCharacteristics 
(Page 3768) 

Yes Yes Yes

WinACMPGetVersion (Page 3769) Yes Yes Yes
WinACMPClearCycleTimeBuffer 
(Page 3770) 

Yes Yes Yes

WinACMPSetStartAtBoot (Page 3770) Yes Yes Yes
WinACMPSetKeySwitch (Page 3771) Yes Yes Yes
WinACMPSetHMIExecutionTime 
(Page 3771) 

Yes Yes Yes

WinACMPSetRestartMethod 
(Page 3772) 

Yes Yes Yes

WinACMPSetSleepTime (Page 3772) Yes Yes Yes
WinACMPSetStartMode (Page 3773) Yes Yes Yes
WinACMPStartHistogram (Page 3773) Yes Yes Yes
WinACMPControl (Page 3774) Yes Yes Yes
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 MP 177 MP 277 MP 377
WinACMPStopHistogram (Page 3774) Yes Yes Yes
WinACMPRestore (Page 3775) Yes Yes Yes
ShowLogonDialog (Page 3749) Yes Yes Yes
ShowOperatorNotes (Page 3749) Yes Yes Yes
ShowAlarmWindow (Page 3750) Yes Yes Yes
ShowSoftwareVersion (Page 3751) No Yes Yes
ShowSystemDiagnosticsWindow 
(Page 3752) 

No No No

ShowSystemAlarm (Page 3752) Yes Yes Yes

1) only with keyboard units
2) only with touch screen devices
3) only with MP 377 Touch daylight readable

See also
OpenControlPanelDialog (Page 3685)

System functions for Comfort Panels

Availability of system functions
The following table shows the availability of the system functions on the Comfort Panels. 

Technical data subject to change.       

Overview

 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

User-defined functions Yes Yes Yes
Logoff (Page 3619) Yes Yes Yes
ActivateScreen (Page 3620) Yes Yes Yes
ActivateScreenByNumber 
(Page 3621) 

Yes Yes Yes

ActivateCleanScreen (Page 3622) Yes 1) Yes No
ActivateSystemDiagnosticsView 
(Page 3740) 

Yes Yes Yes

ActivatePreviousScreen (Page 3623) Yes Yes Yes

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3602 System Manual, 07/2013,  



 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

UpdateTag (Page 3623) Yes Yes Yes
AdjustContrast (Page 3624) No No No
Logon (Page 3625) Yes Yes Yes
ArchiveLogFile (Page 3626) Yes Yes Yes
LogTag (Page 3627) Yes Yes Yes
EditAlarm (Page 3628) Yes No Yes
ScreenObjectCursorDown 
(Page 3629) 

Yes Yes Yes

ScreenObjectCursorUp (Page 3629) Yes Yes Yes
ScreenObjectPageDown (Page 3630) Yes Yes Yes
ScreenObjectPageUp (Page 3631) Yes Yes Yes
Encode (Page 3631) Yes Yes Yes
EncodeEx (Page 3632) Yes Yes Yes
DirectKey (Page 3633) Yes 1) Yes No
DirectKeyScreenNumber 
(Page 3636) 

Yes 1) Yes No

PrintScreen (Page 3637) Yes Yes Yes
PrintReport (Page 3637) Yes Yes Yes
NotifyUserAction (Page 3638) Yes Yes Yes
IncreaseFocusedValue (Page 3639) Yes No Yes
IncreaseTag (Page 3640) Yes Yes Yes
ExportDataRecords (Page 3641) Yes Yes Yes
ExportDataRecordsWithChecksum 
(Page 3643) 

Yes Yes Yes

ExportImportUserAdministration 
(Page 3646) 

Yes Yes Yes

GoToHome (Page 3647) Yes No Yes
GoToEnd (Page 3647) Yes No Yes
SafelyRemoveHardware (Page 3648) Yes Yes Yes
HTMLBrowserStop (Page 3649) No No No
HTMLBrowserRefresh (Page 3649) No No No
HTMLBrowserForward (Page 3650) No No No
HTMLBrowserBack (Page 3650) No No No
ImportDataRecords (Page 3651) Yes Yes Yes
ImportDataRecordsWithChecksum 
(Page 3653) 

Yes Yes Yes

InvertBit (Page 3654) Yes Yes Yes
InvertBitInTag (Page 3655) Yes Yes Yes
InvertLinearScaling (Page 3656) Yes Yes Yes
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

CalibrateTouchScreen (Page 3658) Yes 1) Yes No
CopyLog (Page 3659) Yes Yes Yes
TrendViewScrollForward (Page 3660) Yes Yes Yes
TrendViewScrollBack (Page 3660) Yes Yes Yes
TrendViewExtend (Page 3661) Yes Yes Yes
TrendViewCompress (Page 3661) Yes Yes Yes
TrendViewRulerLeft (Page 3662) Yes Yes Yes
TrendViewRulerRight (Page 3663) Yes Yes Yes
TrendViewSetRulerMode 
(Page 3663) 

Yes Yes Yes

TrendViewStartStop (Page 3664) Yes Yes Yes
TrendViewBackToBeginning 
(Page 3664) 

Yes Yes Yes

LoadDataRecord (Page 3665) Yes Yes Yes
GetUserName (Page 3666) Yes Yes Yes
GetDataRecordFromPLC 
(Page 3667) 

Yes Yes Yes

GetDataRecordName (Page 3668) Yes Yes Yes
GetDataRecordTagsFromPLC 
(Page 3670) 

Yes Yes Yes

GetGroupNumber (Page 3671) Yes Yes Yes
GetBrightness (Page 3671) Yes Yes Yes
GetPassword (Page 3672) Yes Yes Yes
LinearScaling (Page 3673) Yes Yes Yes
ClearLog (Page 3675) Yes Yes Yes
ClearDataRecord (Page 3676) Yes Yes Yes
ClearDataRecordMemory 
(Page 3677) 

Yes Yes Yes

ClearAlarmBuffer (Page 3678) Yes Yes Yes
ClearAlarmBufferProTool 
(Page 3679) 

Yes Yes Yes

AlarmViewUpdate (Page 3680) Yes Yes Yes
AlarmViewEditAlarm (Page 3680) Yes Yes Yes
AlarmViewAcknowledgeAlarm 
(Page 3681) 

Yes Yes Yes

AlarmViewShowOperatorNotes 
(Page 3682) 

Yes Yes Yes

OpenAllLogs (Page 3683) Yes Yes Yes
OpenScreenKeyboard (Page 3684) Yes Yes Yes
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

OpenControlPanelDialog Yes Yes Yes
OpenCommandPrompt (Page 3686) Yes Yes Yes
OpenInternetExplorer (Page 3687) Yes Yes Yes
OpenControlPanel Yes Yes Yes
OpenTaskManager (Page 3689) Yes Yes Yes
AcknowledgeAlarm (Page 3689) Yes No Yes
RecipeViewNewDataRecord 
(Page 3690) 

Yes Yes Yes

RecipeViewGetDataRecordFromPLC 
(Page 3690) 

Yes Yes Yes

RecipeViewClearDataRecord 
(Page 3691) 

Yes Yes Yes

RecipeViewMenu (Page 3691) Yes Yes Yes
RecipeViewOpen (Page 3692) Yes Yes Yes
RecipeViewSetDataRecordToPLC 
(Page 3693) 

Yes Yes Yes

RecipeViewSaveDataRecord 
(Page 3693) 

Yes Yes Yes

RecipeViewSaveAsDataRecord 
(Page 3694) 

Yes Yes Yes

RecipeViewSynchronizeDataRecord
WithTags (Page 3694) 

Yes Yes Yes

RecipeViewRenameDataRecord 
(Page 3695) 

Yes Yes Yes

RecipeViewShowOperatorNotes 
(Page 3696) 

Yes Yes Yes

RecipeViewBack (Page 3696) Yes Yes Yes
ResetBit (Page 3697) Yes Yes Yes
ResetBitInTag (Page 3698) Yes Yes Yes
PressButton (Page 3699) Yes Yes Yes
ReleaseButton (Page 3700) Yes Yes Yes
ShiftAndMask (Page 3701) Yes Yes Yes
CloseAllLogs (Page 3702) Yes Yes Yes
SetDataRecordToPLC (Page 3703) Yes Yes Yes
SetDataRecordTagsToPLC 
(Page 3704) 

Yes Yes Yes

PageDown (Page 3705) Yes No Yes
PageUp (Page 3706) Yes No Yes
SendEMail (Page 3706) Yes Yes Yes
SetAcousticSignal (Page 3707) Yes 1) Yes No
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

SetDisplayMode (Page 3708) No No No
SetDeviceMode (Page 3709) Yes Yes Yes
SetBit (Page 3710) Yes Yes Yes
SetBitInTag (Page 3711) Yes Yes Yes
SetBitWhileKeyPressed (Page 3712) Yes Yes Yes
SetBacklightColor (Page 3713) No No No
SetBrightness (Page 3714) Yes Yes Yes
SetScreenKeyboardMode 
(Page 3715) 

Yes Yes Yes

SetAlarmReportMode (Page 3717) Yes Yes Yes
SetRecipeTags (Page 3718) Yes Yes Yes
SetDaylightSavingTime (Page 3719) Yes Yes Yes
SetLanguage (Page 3720) Yes Yes Yes
SetTag (Page 3722) Yes Yes Yes
SetConnectionMode (Page 3723) Yes Yes Yes
SetWebAccess (Page 3724) Yes Yes Yes
BackupRAMFileSystem (Page 3725) Yes Yes Yes
SimulateSystemKey (Page 3726) Yes No Yes
SimulateTag (Page 3727) Yes Yes Yes
SmartClientViewRefresh (Page 3728) Yes Yes Yes
SmartClientViewReadOnlyOff 
(Page 3728) 

Yes Yes Yes

SmartClientViewReadOnlyOn 
(Page 3729) 

Yes Yes Yes

SmartClientViewDisconnect 
(Page 3729) 

Yes Yes Yes

SmartClientViewConnect 
(Page 3730) 

Yes Yes Yes

SmartClientViewLeave (Page 3731) Yes Yes Yes
SaveDataRecord (Page 3731) Yes Yes Yes
StartLogging (Page 3732) Yes Yes Yes
StartNextLog (Page 3733) Yes Yes Yes
StartProgram (Page 3734) Yes Yes Yes
StatusForceGetValues (Page 3736) Yes Yes Yes
StatusForceSetValues (Page 3736) Yes Yes Yes
ControlSmartServer (Page 3737) Yes Yes Yes
ControlWebServer (Page 3737) Yes Yes Yes
StopLogging (Page 3738) Yes Yes Yes
StopRuntime (Page 3739) Yes Yes Yes
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

LookupText (Page 3743) Yes Yes Yes
ResetTagToHandWheel (Page 3744) No No No
SetTagToHandWheel (Page 3745) No No No
TraceUserChange (Page 3745) Yes Yes Yes
DecreaseFocusedValue (Page 3746) Yes No Yes
DecreaseTag (Page 3746) Yes Yes Yes
ChangeConnection (Page 3747) Yes Yes Yes
WinACMPUpdateStartupCharacteristi
cs (Page 3753) 

No No No

WinACMPUpdateKeySwitchSetting 
(Page 3754) 

No No No

WinACMPUpdateBUSF1LED 
(Page 3755) 

No No No

WinACMPUpdateBUSF2LED 
(Page 3756) 

No No No

WinACMPUpdateAverageExecTime 
(Page 3757) 

No No No

WinACMPUpdateAverageCycleTime 
(Page 3758) 

No No No

WinACMPUpdateEXTFLED 
(Page 3759) 

No No No

WinACMPUpdateHMIEnableTime 
(Page 3760) 

No No No

WinACMPUpdateINTFLED 
(Page 3760) 

No No No

WinACMPUpdateLastCycleTime 
(Page 3761) 

No No No

WinACMPUpdateMaximumCycleTim
e (Page 3762) 

No No No

WinACMPUpdateMinimumCycleTime
 (Page 3763) 

No No No

WinACMPUpdatePowerLED 
(Page 3764) 

No No No

WinACMPUpdateSleepTime 
(Page 3765) 

No No No

WinACMPUpdateRUNLED 
(Page 3766) 

No No No

WinACMPUpdateSTOPLED 
(Page 3767) 

No No No

WinACMPArchive (Page 3768) No No No
WinACMPGetStartCharacteristics 
(Page 3768) 

No No No
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

WinACMPGetVersion (Page 3769) No No No
WinACMPClearCycleTimeBuffer 
(Page 3770) 

No No No

WinACMPSetStartAtBoot 
(Page 3770) 

No No No

WinACMPSetKeySwitch (Page 3771) No No No
WinACMPSetHMIExecutionTime 
(Page 3771) 

No No No

WinACMPSetRestartMethod 
(Page 3772) 

No No No

WinACMPSetSleepTime (Page 3772) No No No
WinACMPSetStartMode (Page 3773) No No No
WinACMPStartHistogram 
(Page 3773) 

No No No

WinACMPControl (Page 3774) No No No
WinACMPStopHistogram 
(Page 3774) 

No No No

WinACMPRestore (Page 3775) No No No
ShowLogonDialog (Page 3749) Yes Yes Yes
ShowOperatorNotes (Page 3749) Yes Yes Yes
ShowAlarmWindow (Page 3750) Yes Yes Yes
ShowSoftwareVersion (Page 3751) Yes Yes Yes
ShowSystemDiagnosticsWindow 
(Page 3752) 

Yes Yes Yes

ShowSystemAlarm (Page 3752) Yes Yes Yes

1) Only on KTP 400 Comfort

See also
OpenControlPanelDialog (Page 3685)

System functions for Mobile Panels

Availability of system functions
The following table shows the availability of the system functions on the mobile panels. 

Technical data subject to change.       
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Overview

 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

User-defined functions No No Yes
Logoff (Page 3619) Yes Yes Yes
ActivateScreen (Page 3620) Yes Yes Yes
ActivateScreenByNumber (Page 3621) Yes Yes Yes
ActivateCleanScreen (Page 3622) No No No
ActivateSystemDiagnosticsView 
(Page 3740) 

No No No

ActivatePreviousScreen (Page 3623) Yes Yes Yes
UpdateTag (Page 3623) Yes Yes Yes
AdjustContrast (Page 3624) No No No
Logon (Page 3625) Yes Yes Yes
ArchiveLogFile (Page 3626) No No Yes
LogTag (Page 3627) No No Yes
EditAlarm (Page 3628) Yes Yes Yes
ScreenObjectCursorDown (Page 3629) Yes Yes Yes
ScreenObjectCursorUp (Page 3629) Yes Yes Yes
ScreenObjectPageDown (Page 3630) Yes Yes Yes
ScreenObjectPageUp (Page 3631) Yes Yes Yes
Encode (Page 3631) Yes Yes Yes
EncodeEx (Page 3632) Yes Yes Yes
DirectKey (Page 3633) Yes Yes Yes
DirectKeyScreenNumber (Page 3636) Yes Yes Yes
PrintScreen (Page 3637) No Yes Yes
PrintReport (Page 3637) No Yes Yes
NotifyUserAction (Page 3638) No No Yes
IncreaseFocusedValue (Page 3639) Yes Yes Yes
IncreaseTag (Page 3640) Yes Yes Yes
ExportDataRecords (Page 3641) Yes Yes Yes
ExportDataRecordsWithChecksum 
(Page 3643) 

No No Yes

ExportImportUserAdministration 
(Page 3646) 

Yes Yes Yes

GoToHome (Page 3647) Yes Yes Yes
GoToEnd (Page 3647) Yes Yes Yes
SafelyRemoveHardware (Page 3648) No No Yes
HTMLBrowserStop (Page 3649) No No No
HTMLBrowserRefresh (Page 3649) No No No
HTMLBrowserForward (Page 3650) No No No
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

HTMLBrowserBack (Page 3650) No No No
ImportDataRecords (Page 3651) Yes Yes Yes
ImportDataRecordsWithChecksum 
(Page 3653) 

No No Yes

InvertBit (Page 3654) Yes Yes Yes
InvertBitInTag (Page 3655) Yes Yes Yes
InvertLinearScaling (Page 3656) Yes Yes Yes
CalibrateTouchScreen (Page 3658) Yes Yes Yes 2)

CopyLog (Page 3659) No No Yes
TrendViewScrollForward (Page 3660) Yes Yes Yes
TrendViewScrollBack (Page 3660) Yes Yes Yes
TrendViewExtend (Page 3661) Yes Yes Yes
TrendViewCompress (Page 3661) Yes Yes Yes
TrendViewRulerLeft (Page 3662) Yes Yes Yes
TrendViewRulerRight (Page 3663) Yes Yes Yes
TrendViewSetRulerMode (Page 3663) Yes Yes Yes
TrendViewStartStop (Page 3664) Yes Yes Yes
TrendViewBackToBeginning (Page 3664) Yes Yes Yes
LoadDataRecord (Page 3665) Yes Yes Yes
GetUserName (Page 3666) Yes Yes Yes
GetDataRecordFromPLC (Page 3667) Yes Yes Yes
GetDataRecordName (Page 3668) Yes Yes Yes
GetDataRecordTagsFromPLC (Page 3670) Yes Yes Yes
GetGroupNumber (Page 3671) Yes Yes Yes
GetBrightness (Page 3671) No No No
GetPassword (Page 3672) Yes Yes Yes
ClearLog (Page 3675) No No Yes
ClearDataRecord (Page 3676) Yes Yes Yes
ClearDataRecordMemory (Page 3677) Yes Yes Yes
ClearAlarmBuffer (Page 3678) Yes Yes Yes
ClearAlarmBufferProTool (Page 3679) Yes Yes Yes
AlarmViewUpdate (Page 3680) Yes Yes Yes
AlarmViewEditAlarm (Page 3680) Yes Yes Yes
AlarmViewAcknowledgeAlarm (Page 3681) Yes Yes Yes
AlarmViewShowOperatorNotes (Page 3682) Yes Yes Yes
OpenAllLogs (Page 3683) No No Yes
OpenScreenKeyboard (Page 3684) No No Yes
OpenCommandPrompt (Page 3686) No No Yes
OpenControlPanelDialog (Page 3685) No No No
OpenInternetExplorer (Page 3687) No Yes Yes
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

Auto-Hotspot No No Yes
OpenControlPanel (Page 3688) No No Yes
AcknowledgeAlarm (Page 3689) Yes Yes Yes
RecipeViewNewDataRecord (Page 3690) Yes Yes Yes
RecipeViewGetDataRecordFromPLC 
(Page 3690) 

Yes Yes Yes

RecipeViewClearDataRecord (Page 3691) Yes Yes Yes
RecipeViewMenu (Page 3691) Yes Yes Yes
RecipeViewOpen (Page 3692) Yes Yes Yes
RecipeViewSetDataRecordToPLC 
(Page 3693) 

Yes Yes Yes

RecipeViewSaveDataRecord (Page 3693) Yes Yes Yes
RecipeViewSaveAsDataRecord 
(Page 3694) 

Yes Yes Yes

RecipeViewSynchronizeDataRecordWithTa
gs (Page 3694) 

Yes Yes Yes

RecipeViewRenameDataRecord 
(Page 3695) 

Yes Yes Yes

RecipeViewShowOperatorNotes 
(Page 3696) 

Yes Yes Yes

RecipeViewBack (Page 3696) Yes Yes Yes
ResetBit (Page 3697) Yes Yes Yes
ResetBitInTag (Page 3698) Yes Yes Yes
PressButton (Page 3699) Yes Yes Yes
ReleaseButton (Page 3700) Yes Yes Yes
ShiftAndMask (Page 3701) Yes Yes Yes
CloseAllLogs (Page 3702) No No Yes
SetDataRecordToPLC (Page 3703) Yes Yes Yes
SetDataRecordTagsToPLC (Page 3704) Yes Yes Yes
PageDown (Page 3705) Yes Yes Yes
PageUp (Page 3706) Yes Yes Yes
SendEMail (Page 3706) No Yes Yes
SetAcousticSignal (Page 3707) No No No
SetDisplayMode (Page 3708) No No No
SetDeviceMode (Page 3709) Yes Yes Yes
SetBit (Page 3710) Yes Yes Yes
SetBitInTag (Page 3711) Yes Yes Yes
SetBitWhileKeyPressed (Page 3712) Yes Yes Yes
SetBacklightColor (Page 3713) No No No
SetBrightness (Page 3714) No No No
SetScreenKeyboardMode (Page 3715) No No Yes
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

SetAlarmReportMode (Page 3717) No No Yes
SetRecipeTags (Page 3718) Yes Yes Yes
SetDaylightSavingTime (Page 3719) Yes Yes Yes
SetLanguage (Page 3720) Yes Yes Yes
SetTag (Page 3722) Yes Yes Yes
SetConnectionMode (Page 3723) Yes Yes Yes
SetWebAccess (Page 3724) No Yes Yes
BackupRAMFileSystem (Page 3725) No No Yes
SimulateSystemKey (Page 3726) Yes Yes Yes
SimulateTag (Page 3727) Yes Yes Yes
SmartClientViewRefresh (Page 3728) No Yes Yes
SmartClientViewReadOnlyOff (Page 3728) No Yes Yes
SmartClientViewReadOnlyOn (Page 3729) No Yes Yes
SmartClientViewDisconnect (Page 3729) No Yes Yes
SmartClientViewConnect (Page 3730) No Yes Yes
SmartClientViewLeave (Page 3731) No Yes Yes
SaveDataRecord (Page 3731) Yes Yes Yes
StartLogging (Page 3732) No No Yes
StartNextLog (Page 3733) No No Yes
StartProgram (Page 3734) No No Yes
StatusForceGetValues (Page 3736) Yes Yes Yes
StatusForceSetValues (Page 3736) No Yes Yes
ControlSmartServer (Page 3737) No Yes Yes
ControlWebServer (Page 3737) No Yes Yes
StopLogging (Page 3738) No No Yes
StopRuntime (Page 3739) Yes Yes Yes
LookupText (Page 3743) Yes Yes Yes
ResetTagToHandWheel (Page 3744) Yes Yes Yes
SetTagToHandWheel (Page 3745) Yes Yes Yes
TraceUserChange (Page 3745) Yes Yes Yes
DecreaseFocusedValue (Page 3746) Yes Yes Yes
DecreaseTag (Page 3746) Yes Yes Yes 1)

ChangeConnection (Page 3747) Yes Yes Yes
WinACMPUpdateStartupCharacteristics 
(Page 3753) 

No No No

WinACMPUpdateKeySwitchSetting 
(Page 3754) 

No No No

WinACMPUpdateBUSF1LED (Page 3755) No No No
WinACMPUpdateBUSF2LED (Page 3756) No No No
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

WinACMPUpdateAverageExecTime 
(Page 3757) 

No No No

WinACMPUpdateAverageCycleTime 
(Page 3758) 

No No No

WinACMPUpdateEXTFLED (Page 3759) No No No
WinACMPUpdateHMIEnableTime 
(Page 3760) 

No No No

WinACMPUpdateINTFLED (Page 3760) No No No
WinACMPUpdateLastCycleTime 
(Page 3761) 

No No No

WinACMPUpdateMaximumCycleTime 
(Page 3762) 

No No No

WinACMPUpdateMinimumCycleTime 
(Page 3763) 

No No No

WinACMPUpdatePowerLED (Page 3764) No No No
WinACMPUpdateSleepTime (Page 3765) No No No
WinACMPUpdateRUNLED (Page 3766) No No No
WinACMPUpdateSTOPLED (Page 3767) No No No
WinACMPArchive (Page 3768) No No No
WinACMPGetStartCharacteristics 
(Page 3768) 

No No No

WinACMPGetVersion (Page 3769) No No No
WinACMPClearCycleTimeBuffer 
(Page 3770) 

No No No

WinACMPSetStartAtBoot (Page 3770) No No No
WinACMPSetKeySwitch (Page 3771) No No No
WinACMPSetHMIExecutionTime 
(Page 3771) 

No No No

WinACMPSetRestartMethod (Page 3772) No No No
WinACMPSetSleepTime (Page 3772) No No No
WinACMPSetStartMode (Page 3773) No No No
WinACMPStartHistogram (Page 3773) No No No
WinACMPControl (Page 3774) No No No
WinACMPStopHistogram (Page 3774) No No No
WinACMPRestore (Page 3775) No No No
ShowLogonDialog (Page 3749) Yes Yes Yes
ShowOperatorNotes (Page 3749) Yes Yes Yes
ShowAlarmWindow (Page 3750) Yes Yes Yes
ShowSoftwareVersion (Page 3751) No No Yes
ShowSystemDiagnosticsWindow 
(Page 3752) 

No No No

ShowSystemAlarm (Page 3752) Yes Yes Yes
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1) only for Mobile Panel 277
2) Only for Mobile Panel 277, Mobile Panel 277 IWLAN

See also
LinearScaling (Page 3673)

OpenTaskManager (Page 3689)

System functions for Runtime Advanced

Availability of system functions
The following table shows the availability of the system functions for WinCC RT Advanced. 

Technical data subject to change.       

Overview

 WinCC RT Advanced
User-defined functions Yes
Logoff (Page 3619) Yes
ActivateScreen (Page 3620) Yes
ActivateScreenByNumber (Page 3621) Yes
ActivateCleanScreen (Page 3622) Yes
ActivateSystemDiagnosticsView (Page 3740) No
ActivatePreviousScreen (Page 3623) Yes
UpdateTag (Page 3623) Yes
AdjustContrast (Page 3624) No
Logon (Page 3625) Yes
ArchiveLogFile (Page 3626) Yes
LogTag (Page 3627) Yes
EditAlarm (Page 3628) Yes
ScreenObjectCursorDown (Page 3629) Yes
ScreenObjectCursorUp (Page 3629) Yes
ScreenObjectPageDown (Page 3630) Yes
ScreenObjectPageUp (Page 3631) Yes
Encode (Page 3631) Yes
EncodeEx (Page 3632) Yes
DirectKey (Page 3633) No
DirectKeyScreenNumber (Page 3636) No
PrintScreen (Page 3637) Yes
PrintReport (Page 3637) Yes
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 WinCC RT Advanced
NotifyUserAction (Page 3638) Yes
IncreaseFocusedValue (Page 3639) Yes
IncreaseTag (Page 3640) Yes
ExportDataRecords (Page 3641) Yes
ExportDataRecordsWithChecksum (Page 3643) No
ExportImportUserAdministration (Page 3646) Yes
GoToHome (Page 3647) Yes
GoToEnd (Page 3647) Yes
SafelyRemoveHardware (Page 3648) No
HTMLBrowserStop (Page 3649) Yes
HTMLBrowserRefresh (Page 3649) Yes
HTMLBrowserForward (Page 3650) Yes
HTMLBrowserBack (Page 3650) Yes
ImportDataRecords (Page 3651) Yes
ImportDataRecordsWithChecksum (Page 3653) No
InvertBit (Page 3654) Yes
InvertBitInTag (Page 3655) Yes
InvertLinearScaling (Page 3656) Yes
CalibrateTouchScreen (Page 3658) No
CopyLog (Page 3659) Yes
TrendViewScrollForward (Page 3660) Yes
TrendViewScrollBack (Page 3660) Yes
TrendViewExtend (Page 3661) Yes
TrendViewCompress (Page 3661) Yes
TrendViewRulerLeft (Page 3662) Yes
TrendViewRulerRight (Page 3663) Yes
TrendViewSetRulerMode (Page 3663) Yes
TrendViewStartStop (Page 3664) Yes
TrendViewBackToBeginning (Page 3664) Yes
LoadDataRecord (Page 3665) Yes
GetUserName (Page 3666) Yes
GetDataRecordFromPLC (Page 3667) Yes
GetDataRecordName (Page 3668) Yes
GetDataRecordTagsFromPLC (Page 3670) Yes
GetGroupNumber (Page 3671) Yes
GetBrightness (Page 3671) No
GetPassword (Page 3672) Yes
LinearScaling (Page 3673) Yes
ClearLog (Page 3675) Yes
ClearDataRecord (Page 3676) Yes
ClearDataRecordMemory (Page 3677) No
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 WinCC RT Advanced
ClearAlarmBuffer (Page 3678) Yes
ClearAlarmBufferProTool (Page 3679) Yes
AlarmViewUpdate (Page 3680) Yes
AlarmViewEditAlarm (Page 3680) Yes
AlarmViewAcknowledgeAlarm (Page 3681) Yes
AlarmViewShowOperatorNotes (Page 3682) Yes
OpenAllLogs (Page 3683) Yes
OpenScreenKeyboard (Page 3684) Yes
OpenControlPanelDialog (Page 3685) No
OpenCommandPrompt (Page 3686) No
OpenInternetExplorer (Page 3687) No
OpenControlPanel (Page 3688) No
OpenTaskManager (Page 3689) Yes
AcknowledgeAlarm (Page 3689) Yes
RecipeViewNewDataRecord (Page 3690) Yes
RecipeViewGetDataRecordFromPLC (Page 3690) Yes
RecipeViewClearDataRecord (Page 3691) Yes
RecipeViewMenu (Page 3691) Yes
RecipeViewOpen (Page 3692) Yes
RecipeViewSetDataRecordToPLC (Page 3693) Yes
RecipeViewSaveDataRecord (Page 3693) Yes
RecipeViewSaveAsDataRecord (Page 3694) Yes
RecipeViewSynchronizeDataRecordWithTags (Page 3694) Yes
RecipeViewRenameDataRecord (Page 3695) Yes
RecipeViewShowOperatorNotes (Page 3696) Yes
RecipeViewBack (Page 3696) Yes
ResetBit (Page 3697) Yes
ResetBitInTag (Page 3698) Yes
PressButton (Page 3699) Yes
ReleaseButton (Page 3700) Yes
ShiftAndMask (Page 3701) Yes
CloseAllLogs (Page 3702) Yes
SetDataRecordToPLC (Page 3703) Yes
SetDataRecordTagsToPLC (Page 3704) Yes
PageDown (Page 3705) Yes
PageUp (Page 3706) Yes
SendEMail (Page 3706) Yes
SetAcousticSignal (Page 3707) No
SetDisplayMode (Page 3708) Yes
SetDeviceMode (Page 3709) Yes
SetBit (Page 3710) Yes
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 WinCC RT Advanced
SetBitInTag (Page 3711) Yes
SetBitWhileKeyPressed (Page 3712) Yes
SetBacklightColor (Page 3713) No
SetBrightness (Page 3714) No
SetScreenKeyboardMode (Page 3715) Yes
SetAlarmReportMode (Page 3717) Yes
SetRecipeTags (Page 3718) Yes
SetDaylightSavingTime (Page 3719) Yes
SetLanguage (Page 3720) Yes
SetTag (Page 3722) Yes
SetConnectionMode (Page 3723) Yes
SetWebAccess (Page 3724) Yes
BackupRAMFileSystem (Page 3725) No
SimulateSystemKey (Page 3726) Yes
SimulateTag (Page 3727) Yes
SmartClientViewRefresh (Page 3728) Yes
SmartClientViewReadOnlyOff (Page 3728) Yes
SmartClientViewReadOnlyOn (Page 3729) Yes
SmartClientViewDisconnect (Page 3729) Yes
SmartClientViewConnect (Page 3730) Yes
SmartClientViewLeave (Page 3731) Yes
SaveDataRecord (Page 3731) Yes
StartLogging (Page 3732) Yes
StartNextLog (Page 3733) Yes
StartProgram (Page 3734) Yes
StatusForceGetValues (Page 3736) Yes
StatusForceSetValues (Page 3736) Yes
ControlSmartServer (Page 3737) Yes
ControlWebServer (Page 3737) Yes
StopLogging (Page 3738) Yes
StopRuntime (Page 3739) Yes
LookupText (Page 3743) Yes
ResetTagToHandWheel (Page 3744) No
SetTagToHandWheel (Page 3745) No
TraceUserChange (Page 3745) Yes
DecreaseFocusedValue (Page 3746) Yes
DecreaseTag (Page 3746) Yes
ChangeConnection (Page 3747) Yes
WinACMPUpdateStartupCharacteristics (Page 3753) No
WinACMPUpdateKeySwitchSetting (Page 3754) No
WinACMPUpdateBUSF1LED (Page 3755) No
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 WinCC RT Advanced
WinACMPUpdateBUSF2LED (Page 3756) No
WinACMPUpdateAverageExecTime (Page 3757) No
WinACMPUpdateAverageCycleTime (Page 3758) No
WinACMPUpdateEXTFLED (Page 3759) No
WinACMPUpdateHMIEnableTime (Page 3760) No
WinACMPUpdateINTFLED (Page 3760) No
WinACMPUpdateLastCycleTime (Page 3761) No
WinACMPUpdateMaximumCycleTime (Page 3762) No
WinACMPUpdateMinimumCycleTime (Page 3763) No
WinACMPUpdatePowerLED (Page 3764) No
WinACMPUpdateSleepTime (Page 3765) No
WinACMPUpdateRUNLED (Page 3766) No
WinACMPUpdateSTOPLED (Page 3767) No
WinACMPArchive (Page 3768) No
WinACMPGetStartCharacteristics (Page 3768) No
WinACMPGetVersion (Page 3769) No
WinACMPClearCycleTimeBuffer (Page 3770) No
WinACMPSetStartAtBoot (Page 3770) No
WinACMPSetKeySwitch (Page 3771) No
WinACMPSetHMIExecutionTime (Page 3771) No
WinACMPSetRestartMethod (Page 3772) No
WinACMPSetSleepTime (Page 3772) No
WinACMPSetStartMode (Page 3773) No
WinACMPStartHistogram (Page 3773) No
WinACMPControl (Page 3774) No
WinACMPStopHistogram (Page 3774) No
WinACMPRestore (Page 3775) No
ShowLogonDialog (Page 3749) Yes
ShowOperatorNotes (Page 3749) Yes
ShowAlarmWindow (Page 3750) Yes
ShowSoftwareVersion (Page 3751) Yes
ShowSystemDiagnosticsWindow (Page 3752) No
ShowSystemAlarm (Page 3752) Yes

System functions

Logoff

Description
Logs off the current user on the HMI device.       
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Use in the function list
Logoff

Use in user-defined functions
Logoff

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)

ActivateScreen

Description
Performs a screen change to the given screen.       

Use the "ActivateScreenByNumber" system function to change from the root screen to the 
permanent window or vice versa. 

Use in the function list
ActivateScreen (Screen name, Object number)

Use in user-defined functions
ActivateScreen (Screen_name, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen name
Name of the screen to which you change.

Object number
The operator control element which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.
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When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

 

  Note

If the "Reach margin" event is assigned to the "ActivateScreen" system function, only the 
value "0" is valid for the "Object number" parameter. The active object is not defined by 
the object number, but rather by the X position it had prior to the screen change.

 

Example
The ActivateScreen function is used in the following program code to activate the "Screen_2" 
screen when you click a button.

 
 
{
 
// User defined code 
// i.e. when pressing a button 
ActivateScreen ("Screen_2", 0);
...
}

See also
ActivateScreenByNumber (Page 3621)

Device dependency (Page 3583)

ActivateScreenByNumber

Description
Performs a screen change to a screen depending on a tag value.       

The screen is identified by its screen number.

Use in the function list
ActivateScreenByNumber (Screen number, Object number)

Use in user-defined functions
ActivateScreenByNumber (Screen_number, Object_number)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Screen number
Tag which contains the screen number of the destination screen.

When a change from the root screen to the permanent window is desired, "0" or "-1" is specified:

0 = Change from root screen to permanent window

-1 = Change from permanent window to root screen

Object number
The number of the screen object which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

See also
ActivateScreen (Page 3619)

Device dependency (Page 3583)

ActivateCleanScreen

Description
Activates the clean screen on the HMI device. The display of the HMI device is disabled for 
the given time period.     

When the display of the HMI device is deactivated, it can be cleaned without triggering touch 
functions by mistake.

Use in the function list
ActivateCleanScreen (Time period)

Use in user-defined functions
--
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Parameters

Time period
Time period for which the display is disabled. The time remaining is displayed as a progress 
bar.

Value range in seconds from 10 through 300.
 

 Note

The system function ActivateCleanScreen cannot be simulated.
 

 

See also
Logoff (Page 3618)

Device dependency (Page 3583)

ActivatePreviousScreen

Description
Performs a screen change to the screen which was activated before the current screen. The 
screen change is not performed if no screen was activated beforehand.       

The last 10 screens that were called up are saved. A system alarm is output when you change 
to a screen which is no longer saved.

 

 Note

If you want to use the system function, the screen to which you change has to be used in the 
navigation structure.

 

 

Use in the function list
ActivatePreviousScreen

Use in user-defined functions
ActivatePreviousScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter
--

See also
Device dependency (Page 3583)

UpdateTag

Description
Reads the current value of the tag with the specified Update ID from the PLC.     

Use in the function list
UpdateTag (Update ID)

Use in user-defined functions
-

Parameters

Update ID
Update ID assigned to the tag that will be updated.

See also
Device dependency (Page 3583)

Logoff (Page 3618)

AdjustContrast

Description
Changes the contrast of the display one level on the HMI device.     

Use in the function list
AdjustContrast (Adjust)

Use in user-defined functions
-
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Parameters

Adjust
Specifies how the contrast is changed:

0 (hmiDecrease) = Decrease: Decreases the contrast one level.

1 (hmiIncrease) = Increase: Increases the contrast one level.

Application example

Objective
One button each for increasing and decreasing the screen contrast is desired.

Notes on configuring
Configure two buttons and configure the "AdjustContrast" system function on the "Press" event. 
The parameters "Increase" and "Decrease" are allocated.

Procedure on HMI device
When one of the two buttons is pressed in runtime, the contrast is increased or decreased one 
level.

See also
Logoff (Page 3618)

Device dependency (Page 3583)

Logon

Description
Logs on the current user on the HMI device.       

Use in the function list
Logon (Password, User name)

Use in user-defined functions
Logon (Password, User_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Password
The tag from which the password for the user logging on is read.

If the user is logged on, the password in the tag is deleted.

User name
The tag from which the user name for the user logging on is read.

See also
Device dependency (Page 3583)

ArchiveLogFile

Description
This system function moves or copies a log to another storage location for long-term logging. 

With Audit Trails, always use the "Move" (hmiMove)" mode, otherwise you will be violating the 
FDA guideline by duplicating the data stored.       

Prior to "ArchiveLogFile" always run the system function "CloseAllLogs".

After this system function, run the "OpenAllLogs" system function.

In "Copy log" mode, the logs are not reopened until the log has been successfully copied, or 
unless a timeout occurs during the copy process. In "Move log" mode, the logs to be moved 
are renamed and the new logs are opened immediately. To move the renamed logs, a job is 
submitted which attempts to move them every 300 seconds if the server cannot be reached. 
The job is also retained after Runtime is restarted until it is executed.

Use in the function list
ArchiveLogFile (Log type, Log, Directory name, Mode)

Use in user-defined functions
ArchiveLogFile (Log_type, Log, Directory_name, Mode) 

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log
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1 (miAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail log available for GMP compliant projects. Additional 
information is available under "Activating GMP-compliant configuration".

Log
Name of the log being archived.

Directory name
Path for saving the log.

Mode
0 (hmiCopy) = Copy log

1 (hmiMove) = Move log

Application example
You want to move a log file from a local storage medium to the server in order to generate a 
backup copy of this file at cyclic intervals.

Notes on configuring

Set up a task in the scheduler which is executed at a specific time on a daily basis. Configure 
the following function list for the task:

Procedure on HMI device

● All log files will be closed.

● The log file you specified is moved to the server.

● All closed log files will be opened again.
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See also
Device dependency (Page 3583)

LogTag

Description
Saves the value of the given tags in the given data log.     

This system function is used to archive a process value at a certain point in time.

Use in the function list
LogTag (Tag)

Use in user-defined functions
-

Parameters

Tag
The tag whose value is logged. The tag is stored in the log which is configured for the specified 
tag.

See also
Device dependency (Page 3583)

EditAlarm

Description
Triggers the "Edit" event for all selected alarms.       

If the alarms to be edited have not yet been acknowledged, the acknowledgment takes place 
automatically when this system function is called up.

This system function can only be used for function keys.

Use in the function list
EditAlarm
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Use in user-defined functions
EditAlarm

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)

ScreenObjectCursorDown

Description
Results in a line-by-line, downward cursor movement in the specified screen object.     

The system function can be used for the following screen objects:

● User view

● Alarm view

● Recipe view

Use in the function list
ScreenObjectCursorDown (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the screen object in which the key function is triggered.

See also
Device dependency (Page 3583)
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ScreenObjectCursorUp

Description
 Results in a line-by-line, upward cursor movement in the specified screen object.     

The system function can be used for the following screen objects:

● User view

● Alarm view

● Recipe view

Use in the function list
ScreenObjectCursorUp (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the screen object in which the key function is triggered.

See also
Device dependency (Page 3583)

ScreenObjectPageDown

Description
Results in a page-by-page, downward cursor movement in the specified screen object.     

The system function can be used for the following screen objects:

● User view

● Alarm view

● Recipe view

Use in the function list
ScreenObjectPageDown (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the screen object in which the key function is triggered.

See also
Device dependency (Page 3583)

ScreenObjectPageUp

Description
Results in a page-by-page, upward cursor movement in the specified screen object.    

The system function can be used for the following screen objects:

● User view

● Alarm view

● Recipe view

Use in the function list
ScreenObjectPageUp (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the screen object in which the key function is triggered.

See also
Device dependency (Page 3583)
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Encode

Description     
Adapts the "String" data type of a tag for transfer to the automation system (AS). The tag of 
WinCC data type "String" is converted into the AS data type "Array of byte". The result is written 
to a tag. 

Use in the function list
Encode (Byte array, String, Coding)

Use in user-defined functions
Encode (Byte_array, String, Encoding)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Byte array
The tag that contains the converted value. 

 

 Note

The Byte array must be twice the size of the string length + 2. The Byte array must contain 
242 array elements if the string has a length of 120 characters.

Characters are either truncated or not converted if the size is insufficient.
 

String
The tag of data type "String" that is converted.

Encode
0 (hmiEncodeUTF16LE) - String is encoded in UTF16LE (Unicode 16 Little Endian). 

See also
Device dependency (Page 3583)
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EncodeEx

Description       
Adapts the "String" data type of a tag for transfer to the automation system (AS). The tag of 
WinCC data type "String" is converted into the AS data type "Array of byte". The result is written 
to a tag. 

By contrast to the Encode system function, you can define the Line break parameter. Using 
the Line break parameter you can delete line breaks or replace these with predefined 
characters.

Use in the function list
EncodeEx (Byte array, String , Encode , Line break)

Use in user-defined functions
EncodeEx (Byte_array, String, Encoding, Line_break)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Byte array
The tag that contains the converted value. 

 

 Note

The byte array must be twice the size of the string length +2. If the string has a length of 120 
characters, the byte array must contain 242 array elements.

Characters are either truncated or not converted if the size is insufficient.
 

String
The tag of data type "String" that is converted.

Encode
0 (hmiEncodeUTF16LE) - String is encoded in UTF16LE (Unicode 16 Little Endian). 

Line break
All line breaks are either deleted or replaced with predefined characters. Do not replace line 
breaks if set as the default value. 

0 (replace with "\r\n' (0x000D, 0x000A)) - the line break is replaced with "\r\n".

1 (replace with "\n' (0x000A)) - the line break is replaced with "\n".

2 (do not replace) - the line break is not replaced.
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3 (remove line breaks) - the line breaks are removed.

See also
Device dependency (Page 3583)

DirectKey

Description
Allows rapid operation of keys on an HMI device without having communication caused delays 
occur.     

Use this system function, for example. to set bits in the I/O area of a SIMATIC S7 directly from 
the HMI device.

 

 Note

If you have integrated WinCC in SIMATIC STEP 7 and have configured a DP area in SIMATIC 
STEP 7: When the button on which the system function was configured is activated, a bit is 
set in the IO area of the CPU. Releasing the button resets the bit.

 

Notes on configuring the system function
When a button is configured with the "DirectKey" system function, a fixed area of the touch 
display is reserved for DirectKey operation.

Screen objects that are above the button with the "DirectKey" system function in this area in 
runtime will hide the button visually. However, the screen objects do not interfere with the 
triggering of the "DirectKey" system function.

 

 Note

If an external application, such as Pocket Internet Explorer or Control Panel is started, it will 
run in the foreground and Runtime is placed in the background. The bit for the 
"DirectKeyScreenNumber" function is no longer set and the keys or buttons which are 
assigned the "DirectKey" function no longer to trigger the associated bit in the PLC.

 

 WARNING

Triggering the "DirectKey" system function by mistake will endanger personnel or result in 
damage to the machine.

 

In order to avoid this danger, the following must be observed:
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● When the process screen is configured, the button with the "DirectKey" system function 
must not be covered by a screen object.

● The dynamic positioning or display (release) of a screen object in relation to process values 
must not cover the button with the "DirectKey" system function in runtime.

 

  Note

Please observe this guideline during configuration. Check also existing configurations and 
adjust them immediately.

 

In the following cases, the covering of a button with the "DirectKey" system function does not 
lead to the problems described above:

● Operation of the alarm window

● Operation of the Recipe view

● Cancellation of the screen saver

● Use of the screen keyboard

● Running the "ActivateCleanScreen" system function

Actions of DP direct-keys in offline operation
When the "ChangeConnection" system function is performed with the "Offline" parameter on 
the HMI device, the connection to the specified PLC is disconnected.

 

 Note

Please note the following on the SIMATIC STEP 7 side as well as the WinCC side:

The DP DirectKeys are still active in this case. If you activate a button with the "DirectKey" 
system function in "Offline" operating mode or activate the DirectKey on a keyboard device, 
the corresponding bit is set in the PLC.

 

Use in the function list
DirectKey (Bit)

Use in user-defined functions
-

Parameters

Bit
Specifies the bit which is set. Depending on the HMI device, the bit numbers 0 to 31 or 0 to 
39 are possible.
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Application example

Objective
You want to set bits in the IO area of a SIMATIC S7 directly from the HMI device using a button.

Requirement
WinCC integrated in SIMATIC STEP 7 is installed.

During operation, the HMI device is coupled to a SIMATIC S7 through PROFIBUS-DP.

WinCC integrated was installed when you compiled your project.

The bit area for DirectKeys is determined in SIMATIC STEP 7. For configuration see the 
"Communication" user's manual.

Notes on configuring
Configure the button to be used as the DirectKey. Assign the "DirectKey" system function to 
the button. As a parameter, enter the number of the bit which is set when the key is pressed.

Procedure on HMI device
When the DirectKey is touched, the bit is set, and reset when the key is released or the screen 
is exited. 

See also
Device dependency (Page 3583)

DirectKeyScreenNumber

Description
Sets the bit within the given bit area of a DirectKey and transfers it to the S7 controller to which 
the HMI device is connected. This ensures unambiguous allocation of a control bit to screen 
number at all times.     

Without the use of the system function, the S7 controller must distinguish the respective 
functionality by means of the screen number. This delays the updating of the screen number 
after a screen change.

 

 Note

If an external application, such as Pocket Internet Explorer or Control Panel is started, it will 
run in the foreground and Runtime is placed in the background. Nevertheless, the bit for the 
"DirectKeyScreenNumber" function is set and the keys or buttons with the configured 
"DirectKey" function continue to trigger the associated bit in the PLC.   

 

Use in the function list
DirectKeyScreenNumber (Bit)
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Use in user-defined functions
-

Parameters

Bit
Specifies the bit which is set. Depending on the HMI device, the bit numbers 0 to 31 or 0 to 
39 are possible.

See also
Device dependency (Page 3583)

PrintScreen

Description
Prints the screen currently being displayed on the HMI device from the printer which is 
connected to the HMI device.       

Opened windows are also printed.
 

 Note

The printer settings are taken over from the current settings in the Windows operation system.
 

Use in the function list
PrintScreen

Use in user-defined functions
PrintScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)
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PrintReport

Description
Prints the given report from the printer which is connected to the HMI device. The report is 
printed in the language which is set on the HMI device.       

 

 Note

If runtime is closed whilst log data are being printed using the system function, the report will 
cease to be supplied with data as soon as runtime stops.

 

Use in the function list
PrintReport (Report)

Use in user-defined functions
PrintReport (Report)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Report
Name of the report to be printed.

 

 Note

If you have set up via the "Function list" dialog box a new report for the "PrintReport" function, 
when compiling, the following warning appears: "The report "Report_1" has no printed pages."

In order to remedy the warning, open the "Report_1" via the project view and recompile the 
project.

 

See also
Device dependency (Page 3583)

NotifyUserAction

Description
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This system function is used to log user actions that are not automatically logged in the audit 
trail. You can also use this system function to require the user to enter an acknowledgment or 
an electronic signature and a comment for the operator action. Requirement for the use of the 
system function is that the GMP-compliant configuration is activated under "Runtime settings".

If you use the "NotifyUserAction" system function in a function, the debugger may open if you 
cancel your input by clicking "Cancel". To compensate for this reaction, you can use the "On 
Error Resume Next" statement in a function. With this instruction, the next instruction is 
executed after a runtime error. If you use the "On Error Resume Next" statement, output of 
system events is also suppressed.

Use in the function list
NotifyUserAction (Confirmation type, Mandatory commenting, Category, Object name, 
Description)

Use in user-defined functions
NotifyUserAction (Confirmation_type, Mandatory_commenting, Category, Object_name, 
Description)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Confirmation type
Establishes how the action must be confirmed

0 = (None): No confirmation required, an entry is created in the audit trail

1 = (Acknowledgement): Acknowledgment, the user must acknowledge the action; an entry is 
created in the audit trail

2 = (Digital Signature): Electronic signature, a dialog window opens in which the user must 
enter his electronic signature - an entry is created in the audit trail

Mandatory commenting
Establishes if the user has to enter a comment. The comment is logged in the audit trail.

0 = (True): True; a dialog window opens in which the user must enter a comment

1 = (False): False; no mandatory commenting

Category
Category or class name of the modified object

Object name
Name of the modified object

Description
Text which describes the archiving user action.
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See also
Device dependency (Page 3583)

IncreaseFocusedValue

Description
Adds the given value to the value of the tag which is connected to the input field (drop-down 
list, graphic selection list, slider bar) which has the current focus.       

This system function can only be used for function keys.

Use in the function list
IncreaseFocusedValue (Value)

Use in user-defined functions
-

Parameters

Value
The value which is added to the tag value.

See also
Device dependency (Page 3583)

IncreaseTag

Description
Adds the given value to the value of the tags.       

X = X + a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, help tags must be used. You can use the "SetTag" system function 
to assign the tag value to the auxiliary tags.

 

If you configure the system function on the events of an alarm and the tag is not being used 
in the current screen, it is not ensured that the actual value of the tags is being used in the 
PLC. You can improve the situation by setting the "Cyclic continuous" acquisition mode.
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Use in the function list
IncreaseTag (Tag, Value)

Use in user-defined functions 
IncreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the given value is added.

Value
The value that is added.

See also
Device dependency (Page 3583)

SetTag (Page 3722)

ExportDataRecords

Description
Exports one or all data records of a recipe to a CSV file.       

One file is created per recipe.

Use in the function list
ExportDataRecords (Recipe number/name, Data record number/name, File name, Overwrite, 
Output status message, Processing status)

Use in user-defined functions
ExportDataRecords (Recipe_number/name,Data_record number/name, File_name, 
Overwrite, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Recipe number/name
Number or name of the recipe from which the data records are exported. Specify "0" if recipe 
data records are to be exported from all available recipes.

File name
Name of the CSV file to which the recipe data records are exported. Enter the file location and 
the file extension (*.csv), for example, "C:\TEMP\Orange.csv".

 

 Note
Storage of the CSV file
● If a storage card is used as storage location, specify the storage location as follows: 

"\StorageCard\<File name>".
● If you only enter one file name and no path, the file will be saved in a system directory, 

for example, "C:\Documents and Settings\[User]".
● When only one path for the export is specified, the file name is automatically created from 

the respective recipe name. It is a requirement that the folder "D:\Temp\", for example, 
has been created. If the folder  "D:\Temp" has not been created, the folder name will be 
used as the prefix of the file name, Temp_Recipe names.csv.

 

Data record number/name
Number or name of the recipe data record to be exported. Specify "0" if all recipe data records 
are to be exported.

Overwrite
Determines whether an existing CSV file with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: CSV file will not be overwritten. The export process will not 
be carried out.

1 (hmiOverwriteAlways) = Yes: CSV file is overwritten without a prompt for confirmation.

2 (hmiOverwriteWithPrompting) = With confirmation: CSV file is not overwritten until confirmed.

Output status message
Determines whether a status message is output after the export:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.
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Export format of the recipe data records
If ".csv" is chosen as a file extension for the export file, then only valid characters from the 
ANSI character set will be supported. This also applies to separators in decimal numbers and 
list elements. The separators used are defined in the country/regional settings of the operating 
system of the exporting computer.

You may also set "Unicode text" (".txt") format for the export file. This file format supports the 
WinCC and WinCC Runtime character set. Again, the separators used are specified in the 
country/regional settings of the operating system of the exporting computer. This file format 
always uses tab separators in list elements.

The corresponding file import function also supports the ".csv" and ".txt" (Unicode) file 
formats.       

Application example
You want to export all data records using a key.

Notes on configuring

Configure the "ExportDataRecords" system function on the "Press" event for the desired key. 
Transfer the following parameters:

● Recipe number/name = 1

● Data record number/name = 0

● File name = c:\temp\orange.csv

● Overwrite = 1

● Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data records are exported.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated. All data records of Recipe 1 are exported to the orange.csv file. If the file already 
exists, it will be overwritten.

After exporting the data records, a system message is output.

See also
Device dependency (Page 3583)

ExportDataRecordsWithChecksum

Description
Exports one or all data records of a recipe to a CSV file and generates a checksum for each 
line in the file.       
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One file is created per recipe.

Use in the function list
ExportDataRecordsWithChecksum (Recipe number/name, Data record number/name, File 
name, Overwrite, Output status message, Processing status)

Use in user-defined functions
ExportDataRecordsWithChecksum (Recipe_number/name, Data_record number/name, 
File_name, Overwrite, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which the data records are exported. Specify "0" if recipe 
data records are to be exported from all available recipes.

Data record number/name
Number or name of the recipe data record to be exported. Specify "0" if all recipe data records 
are to be exported.

File name
Name of the CSV file to which the recipe data records are exported. Enter the path and the 
file extension e.g. "C:\TEMP\Orange.CSV".

If a storage card is used as storage location, specify the storage location as follows: 
"\StorageCard\<File name>".

If you define only a file name without specifying a path, the file is saved to the directory from 
which Runtime was started. If write access to this directory is not enabled in the Windows 7 
operating system, the file is saved to the "VirtualStore" folder of the user directory.

When only one path for the export is specified, the file name is automatically created from the 
respective recipe name. This requires, for example, that the directory "D:\Temp\" has been 
created. If the directory  "D:\Temp" does not exist, the directory name is used as the prefix for 
the file name, Temp_Recipe names.csv.

Overwrite
Determines whether an existing CSV file with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: CSV file will not be overwritten. The export process will not 
be carried out.

1 (hmiOverwriteAlways) = Yes: CSV file is overwritten without a prompt for confirmation.

2 (hmiOverwriteWithConfirmation) = With confirmation: CSV file is not overwritten until 
confirmed.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3643



Output status message
Determines whether a status message is output after the export:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Export format of the recipe data records
If ".csv" is chosen as a file extension for the export file, then only valid characters from the 
ANSI character set will be supported. This also applies to separators in decimal numbers and 
list elements. The separators used are defined in the country/regional settings of the operating 
system of the exporting computer.

You may also set "Unicode text" (".txt") format for the export file. This file format supports the 
WinCC and WinCC Runtime character set. Again, the separators used are specified in the 
country/regional settings of the operating system of the exporting computer. This file format 
always uses tab separators in list elements.

The corresponding file import function also supports the ".csv" and ".txt" (Unicode) file formats.

Application example
Using a key, you want to export all data records and assign a checksum.

Notes on configuring

Configure the "ExportDataRecordsWithChecksum" system function on the "Press" event for 
the desired key. Transfer the following parameters:

● Recipe number/name = 1

● Data record number/name = 0

● File name = c:\temp\orange.csv

● Overwrite = 1

● Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data records are exported.

Procedure on HMI device
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As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated. All data records of Recipe 1 are exported to the orange.csv file and assigned 
checksums. If the file already exists, it will be overwritten.

After exporting the data records, a system message is output.

See also
Device dependency (Page 3583)

ExportImportUserAdministration

Description
Exports all users of the user administration of the currently active project to the given file or 
imports the users from the given file into the currently active project.       

Users, their passwords and rights are saved in the user administration.

All users are overwritten when importing. The imported users are valid immediately.

Use in the function list
ExportImportUserAdministration (File name, Direction)

Use in user-defined functions
ExportImportUserAdministration (File_name, Direction)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the file which contains the passwords or to which the passwords are written. Enter 
the file location and the file extension (*.txt), for example, "C:\TEMP\Passwords.txt".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Direction
Specifies whether passwords are exported or imported:

0 (hmiExport) = Export: Passwords are exported.

1 (hmiImport) = Import: Passwords are imported.
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See also
Device dependency (Page 3583)

GoToHome

Description
Executes the key function <Home> on the HMI device.       

This system function is used when the HMI device does not have this functionality by default.

The system function can only be used for the following function keys.

Use in the function list
GoToHome

Use in user-defined functions
GoToHome

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)

GoToEnd

Description
Executes the key function <End> on the HMI device.       

This system function is used when the HMI device does not have this functionality by default.

The system function can only be used for the following function keys.

Use in the function list
GoToEnd
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Use in user-defined functions
GoToEnd

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)

SafelyRemoveHardware

Description
Checks whether there is read or write access to the external storage medium. If there is no 
access, the external storage medium can be removed without data loss.       

Use in the function list
SafelyRemoveHardware(Path, Result)

Use in user-defined functions
SafelyRemoveHardware(Path, Result)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Path
Path of storage medium , e.g. \Storage Card USB\

Result
The tag in which the result is entered.

TRUE : The storage medium can be removed safely. A corresponding system message will 
be issued.

FALSE : The storage medium can be removed safely. A corresponding system message will 
be issued. 
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See also
Device dependency (Page 3583)

HTMLBrowserStop

Description
Performs the function "Stop" the HTML browser.     

Use in the function list
HTMLBrowserStop (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Object name of the HTML browser in which the command is performed.

See also
Device dependency (Page 3583)

HTMLBrowserRefresh

Description
Performs the function "Refresh" of the HTML browser.     

Use in the function list
HTMLBrowserRefresh (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Object name of the HTML browser in which the command is performed.
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See also
Device dependency (Page 3583)

HTMLBrowserForward

Description
Performs the function "Forward" of the HTML browser.     

Use in the function list
HTMLBrowserForward (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Object name of the HTML browser in which the command is performed.

See also
Device dependency (Page 3583)

HTMLBrowserBack

Description
Performs the "Back" function of the HTML browser.     

Use in the function list
HTMLBrowserBack (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Object name of the HTML browser in which the command is performed.
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See also
Device dependency (Page 3583)

ImportDataRecords

Description
Imports one or all data records of a recipe from a CSV file.       

When a path is specified, all records of the given directory are imported.

Use in the function list
ImportDataRecords (File name, Data record number/name, Overwrite, Output status 
message, Processing status)

Use in user-defined functions
ImportDataRecords (File_name, Data_record number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the CSV file from which the recipe data records are imported. Enter the file location 
and the file extension (*.csv), for example "C:\TEMP\Orange.csv".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Data record number/name
Number or name of the recipe data record to be imported. Specify "0" if all recipe data records 
are to be imported.

Overwrite
Determines whether existing recipe data records are to be overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data records are not overwritten. The import process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data records are overwritten without prompting.

2 (hmiOverwriteWithPrompting) = With confirmation: Recipe data records are not overwritten 
until confirmed.
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Output status message
Determines whether a status message is output after the import:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Configurable objects

Object Event
Tag Value change

High limit violated
Low limit violated

Function key (global) Release
Press

Function key (local) Release
Press

Screen Loaded
Cleared

Screen object Press
Release
Click
Change (or toggle for switch)
Switch on
Switch off
Enable
Disable

Scheduler Time expired

 

 

See also
Device dependency (Page 3583)
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ImportDataRecordsWithChecksum

Description
Imports one or all data records of a recipe from a CSV file with a checksum and verifies the 
checksum.       

Use in the function list
ImportDataRecordsWithChecksum (File name, Data record number/name, Overwrite, Output 
status message, Processing status, verify checksum)

Use in user-defined functions
ImportDataRecordsWithChecksum (File_name, Data_record number/name, Overwrite, 
Output_status_message, Processing_status, Verify_Checksum)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the CSV file from which the recipe data records are imported. Enter the path and the 
file extension, for example, "C:\TEMP\Orange.CSV".

If a storage card is used as storage medium, specify the storage location as follows: 
"\StorageCard\<File name>".

If you specify a directory instead of an individual CSV file, all files in the specified directory will 
be imported.

Data record number/name
Number or name of the recipe data record to be imported. Specify "0" if all recipe data records 
are to be imported.

Overwrite
Determines whether existing recipe data records are to be overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data records are not overwritten. The import process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data records are overwritten without prompting.

2 (hmiOverwriteWithConfirmation) = With confirmation: Recipe data records are not 
overwritten until confirmed.

Output status message
Determines whether a status message is output after the import:

0 (hmiOff) = Off: Status message is not output.
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1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for example 
to delay execution of other system functions, until this system function has been successfully 
completed.

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Verify checksum
Determines if the checksum should be verified during import:

0 (hmiFalse) = No: Checksum is not verified.

1 (hmiTrue) = Yes: Checksum is verified.

See also
Device dependency (Page 3583)

InvertBit

Description
Inverts the value of the given tag of the "Bool" type:       

● If the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

Use in the function list
InvertBit (Tag)

Use in user-defined functions
InvertBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag whose bit is set.
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Example
The following program code inverts the value of the boolean tag b_value and outputs the result 
along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Invert variable
invertBit(b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
  ...
}

See also
Device dependency (Page 3583)

InvertBitInTag

Description
Inverts a bit in the given tag:       

● If the bit in the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the bit in the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "InvertBit" system 
function instead.

 

Use in the function list
InvertBitInTag (Tag, Bit)

Use in user-defined functions
InvertBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Tag
The tag in which the given bit is set.

Bit
The number of the bit that is set.

When this system function is used in a user-defined function, the bits in a tag are counted from 
right to left. The counting begins with 0.

Example
The following program code inverts a bit at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Invert bit in bitposition
InvertBitInTag (bvalue, bitposition);
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
Device dependency (Page 3583)

InvertLinearScaling

Description
Assigns a value to the tag X, which is calculated from the value of the given tag Y using the 
linear function X = (Y - b) / a.       

The tags X and Y must not be identical. This system function is the inverse of the 
"LinearScaling" system function.

 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used.

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.
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Use in the function list
InvertLinearScaling (X, Y, b, a)

Use in user-defined functions
InverseLinearScaling (X, Y, b, a)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

X
The tag which is assigned the value calculated from the linear equation.

Y
The tag that contains the value used for calculation.

b
The value which is subtracted.

a
The value through which is divided.

Example
The following program code assigns a value to the varX tag by means of the 
InverseLinearScaling function.

 
{
BYTE varX;
BYTE Yvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
//Inverse linear scaling
 InverseLinearScaling (varX, Yvalue, bvalue, avalue);
 
printf ("varX = %d\r\n, varX); 
...
}

The saved return value can be processed in the following code.

See also
Device dependency (Page 3583)
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CalibrateTouchScreen

Description
Calls a program for calibrating the touch screen.       

During the calibration process, there is a prompt to touch five positions on the screen display. 
Touch the screen display within 30 seconds, to confirm the calibration process. If the calibration 
is not completed within this time span, the calibration settings are discarded. The user prompt 
is in English.

Use this system function the first time you start the HMI device.

Use in the function list
CalibrateTouchScreen

Use in user-defined functions
CalibrateTouchScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

 

 Note

The CalibrateTouchScreen system function cannot be simulated.
 

See also
Device dependency (Page 3583)
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CopyLog

Description
Copies the contents of a log to another log. Tag values can only be copied to other data logs 
and alarms only to other alarm logs, however.

 

 Note

If you copy a log using the "CopyLog" system function, it is possible that external applications 
will be unable to read certain country-specific special characters in the logged message text 
of the log copy. This does not apply to WinCC Runtime. WinCC Runtime can read the copied 
log files without errors.

 

Use in the function list
CopyLog (Log type, Destination log, Source log, Mode, Delete source log)

Use in user-defined functions
CopyLog (Log_type, Destination log, Source_log, Mode, Delete_source_log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

Destination log
Name of the log into which the entries are copied (Destination log).

Source log
Name of the log from which the entries are copied (Source log).

Mode
Determines what is done with copied entries in the destination log:

0 (hmiOverwrite) = Overwrite: Existing entries are overwritten.

2 (hmiAppend) = Append: The entries are inserted at the end of the destination log. When the 
configured size of the log has been reached, the destination log is treated like a circular log.

Delete source log
Determines whether the source log is deleted after copying.
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0 (hmiNo) = No: Is not deleted.

1 (hmiYes) = Yes: Is deleted.

See also
Storage locations of logs (Page 3216)

Device dependency (Page 3583)

TrendViewScrollForward

Description
Scrolls forward one display width in the Trend view.     

Use in the function list
TrendViewScrollForward (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which is scrolled forward.

See also
Device dependency (Page 3583)

TrendViewScrollBack

Description
Scrolls back one display width to the left in the trend view.     

Use in the function list
TrendViewScrollBack (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Name of the trend view in which is scrolled back.

See also
Device dependency (Page 3583)

TrendViewExtend

Description
Reduces the time period which is displayed in the trend view.     

Use in the function list
TrendViewExtend (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the displayed time period is reduced.

See also
Device dependency (Page 3583)

TrendViewCompress

Description
Increases the time period which is displayed in the trend view.     

Use in the function list
TrendViewCompress (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Name of the trend view in which the displayed time period is increased.

See also
Device dependency (Page 3583)

TrendViewRulerLeft

Description
Moves the read-line backwards (to the left) in the trend view.     

 

 Note

In order to be able to move the read-line, the read-line must have been switched on. This is 
done using the "TrendViewSetRulerMode" system function.

 

Use in the function list
TrendViewRulerLeft (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the read-line is moved backwards.

See also
TrendViewSetRulerMode (Page 3663)

Device dependency (Page 3583)
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TrendViewRulerRight

Description
Moves the read-line forwards (to the right) in the trend view.     

 

 Note

In order to be able to move the read-line, the read-line must have been switched on. This is 
done using the "TrendViewSetRulerMode" system function.

 

Use in the function list
TrendViewRulerRight (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the read-line is moved forward.

See also
TrendViewSetRulerMode (Page 3663)

Device dependency (Page 3583)

TrendViewSetRulerMode

Description
Hides or shows the read-line in the trend view. The read-line displays the Y value belonging 
to the X value.     

 

 Note

To ensure that the ruler is displayed, you have to activate the setting "Show ruler" in the trend 
view properties.

 

Use in the function list
TrendViewSetRulerMode (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the read-line is hidden or shown.

See also
TrendViewRulerRight (Page 3662)

TrendViewRulerLeft (Page 3661)

Device dependency (Page 3583)

TrendViewStartStop

Description
Stops the trend recording or continues the trend recording in the trend view.     

Use in the function list
TrendViewStartStop (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the recording of the trend is started or stopped.

See also
Device dependency (Page 3583)

TrendViewBackToBeginning

Description
Scrolls back to the beginning of the display range in the trend view.     
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Use in the function list
TrendViewBackToBeginning (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which you scroll to the beginning of the display range.

See also
Device dependency (Page 3583)

LoadDataRecord

Description
Loads the given recipe data record from the memory medium of the HMI device in the recipe 
tags. This system function is used, for example, to display a recipe data record in the recipe 
screen.       

Activate the "Synchronize recipe view and recipe tags" option in the synchronization settings 
of the recipe. If this option is deactivated, the system function has no effect. 

Use in the function list
LoadDataRecord (Recipe number/name, Data record number/name, Processing status)

Use in user-defined functions
LoadDataRecord (Recipe_number/name, Data_record_number/name, Confirmation, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which a recipe data record is loaded.

Data record number/name
Number or name of the recipe data record to be loaded.
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Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

See also
Device dependency (Page 3583)

GetUserName

Description
Writes the user name of the user currently logged on to the HMI device in the given tag.       

If the given tag has a control connection, the user name is also available in the PLC connection. 
This system function makes it possible, for example, to implement a user-dependent release 
of certain functionalities.

Use in the function list
GetUserName (Tag)

Use in user-defined functions
GetUserName (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the user name is written.

See also
Device dependency (Page 3583)
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GetDataRecordFromPLC

Description
Transfers the selected recipe data record from the PLC to the storage medium of the HMI 
device.       

Use in the function list
GetDataRecordFromPLC (Recipe number/name, Data record number/name, Overwrite, 
Output status message, Processing status)

Use in user-defined functions
GetDataRecordFromPLC (Recipe_number/name, Data_record_number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data records are transferred.

Data record number/name
Number or name of the recipe data record which is transferred from the PLC to the data medium 
of the HMI device.

Overwrite
Determines whether an existing recipe data record with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data record is not overwritten. The transfer process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data record is overwritten without prompting.

2 (hmiOverwriteWithPrompting) = With confirmation: Recipe data record is not overwritten until 
confirmed.

Output status message
Determines whether a status message is output after the transfer:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:
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2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Application example
You want to transfer a data record from the PLC to the data medium of the HMI device using 
a key.

Notes on configuring

Configure the "GetDataRecordFromPLC" system function on the "Press" event for the desired 
key. Transfer the following parameters:

Recipe number/name = 1

Data record number/name = 1

Overwrite = 1

Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data record is transferred from the PLC.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated and the first data record of Recipe 1 is transferred from the PLC to the data medium 
of the HMI device. If the recipe data record already exists, it will be overwritten.

A system message is output after the transfer.

See also
Device dependency (Page 3583)

GetDataRecordName

Description
Writes the name of the given recipe and recipe data record to the given tags.     

 

 Note

If the recipe or the recipe data record do not exist, wildcards ("###") are written to the tags.
 

Use in the function list
GetDataRecordName (Recipe number, Data record number, Recipe name, Data record name, 
Processing status)
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Use in user-defined functions
GetDataRecordName (Recipe_number, Data_record_number, Recipe_name, 
Data_record_name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency". 

Parameter

Recipe number
Number of the recipe whose name is written to the given tag.

Data record number
Number of the recipe data record whose name is written to the given tag.   

Recipe name
The tag to which the recipe name is written. The tag must be of the STRING type.

Data record name
The tag to which the name of the recipe data record is written. The tag must be of the STRING 
type.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Application example
You want to output the names of the displayed recipes and the name of the displayed recipe 
data record on the HMI device.

Configure the following tags:

● "RecNumber" of type INTEGER

● "RecDataNumber" of type INTEGER

● "RecName" of type STRING

● "RecDataName" of type STRING

Configure a recipe view with the tags "RecNumber" for the recipe number and 
"RecDataNumber" for the data record number.

Configure the "GetDataRecordName" system function on the "Press" event for a button and 
pass the following parameters:
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● Recipe number: RecNumber

● Data record number: RecDataNumber

● Recipe name: RecName

● Data record name: RecDataName

Configure two output fields and connect these to the "RecName" and "RecDataName" tags.

Select a recipe and a data record number from the recipe view. As soon as the button is 
activated, the system function is triggered and the name of the recipe and the recipe data 
record are displayed in both output fields.

See also
Device dependency (Page 3583)

GetDataRecordTagsFromPLC

Description
Transfers the values of the recipe data record loaded in the PLC to the corresponding recipe 
tags.       

This system function is used, for example, during teach-in mode on a machine.

Use in the function list
GetDataRecordTagsFromPLC (Recipe number/name, Processing status)

Use in user-defined functions
GetDataRecordTagsFromPLC (Recipe_number/name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe data record whose values are written from the PLC to the tags.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.
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See also
Device dependency (Page 3583)

GetGroupNumber

Description
Reads the number of the group to which the user logged on to the HMI device belongs, and 
writes it to the given tag.       

Use in the function list
GetGroupNumber (Tag)

Use in user-defined functions
GetGroupNumber (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the number of the group is written.

See also
Device dependency (Page 3583)

GetBrightness

Description
Reads the value of the brightness.

       

Use in the function list
GetBrightness (Brightness)

Use in user-defined functions
GetBrightness (Brightness)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Brightness
The tag to which the value is written. 

See also
Device dependency (Page 3583)

GetPassword

Description
Writes the password of the user currently logged on to the HMI device in the given tag.       

 

 Note

Make sure that the value of the given tag is not displayed in another place in the project.
 

 Note

The passwords of SIMATIC Logon users cannot be read. 
 

Use in the function list
GetPassword (Tag)

Use in user-defined functions
GetPassword (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the password is written.
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See also
Device dependency (Page 3583)

System functions for Runtime Advanced (Page 3614)

ReadPLCMode

Description
Evaluates the current state of the connected PLC.

The system function "ReadPLCMode" can only be configured for the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Use in the function list
ReadPLCMode (connection, mode)

Use in user-defined functions
GetPLCMode (Connection, Mode)

Parameter

Connection
Connection of PLC and HMI device.

Mode
Evaluates the state of the connected PLC.

For the evaluation, select the tag "@DiagnosticsIndicatorTag".

LinearScaling

Description
Assigns a value to the tag Y, which is calculated from the value of the given tag X using the 
linear function Y= (a *X) + b.       
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The inverse of this function is the "InvertLinearScaling" system function.
 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used. 

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
LinearScaling (Y, a, X, b)

Use in user-defined functions
LinearScaling (Y, a, X, b)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Y
The tag which is assigned the value calculated from the linear equation.

a
The value with which is multiplied.

X
The tag that contains the value used for calculation.

b
The value that is added.

Example
The following program code uses the LinearScaling function to assign a value to the Yvar tag.

 
{
BYTE Yvar;
BYTE Xvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
// linear scaling
 LinearScaling ( Yvar, avalue, Xvalue, bvalue);
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printf ("Yvar = %d\r\n, Yvar); 
...
}

The saved return value can be processed in the following code.

See also
Device dependency (Page 3583)

ClearLog

Description
Deletes all data records in the given log.       

Use in the function list
ClearLog (Log type, Log)

Use in user-defined functions
ClearLog (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log: 

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail log Available for GMP-compliant projects Additional 
information is available under "Activating GMP-compliant configuration".

Log
Name of the log from which all entries are deleted.

See also
Device dependency (Page 3583)
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ClearDataRecord

Description
Deletes a recipe data record.       

Several data records can be deleted from one or more recipes.

Use in the function list
ClearDataRecord (Recipe number/name, Data record number/name, Confirmation, Output 
status message, Processing status)

Use in user-defined functions
ClearDataRecord

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data records are deleted. "0" is specified if 
you want to delete recipe data records from all available recipes.

Data record number/name
Number or name of the recipe data record to be deleted. "0" is specified if you want to delete 
all recipe data records.

Confirmation
Determines whether the operator should confirm the deletion:

0 (hmiOff) = Off: Deletion is begun without confirmation.

1 (hmiOn) = On: The starting of the deletion process must be confirmed.

Output status message
Determines whether a status message is output after the deletion:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.
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12 = System function was not performed because an error has occurred.

See also
Device dependency (Page 3583)

ClearDataRecordMemory

Description
Deletes all recipes data records from the specified storage medium.       

Use in the function list
ClearDataRecordMemory (Storage location, Confirmation, Output status message, 
Processing status)

Use in user-defined functions
ClearDataRecordMemory (Storage_location, Confirmation, Output_status_message, 
Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Storage location
Determines the storage location:

0 (hmiFlashMemory) = Flash memory: Internal flash memory of the HMI device

1 (hmiStorageCard) = Storage card

2 (hmiStorageCard2) = Storage card 2

3 (hmiStorageCard3) = Storage card MultiMediaCard

4 (hmiStorageCard4) = Storage card USB

Confirmation
Determines whether the operator should confirm the deletion:

0 (hmiOff) = Off: Deletion is begun without confirmation.

1 (hmiOn) = On: The starting of the deletion process must be confirmed.

Output status message
Determines whether a status message is output after the deletion:

0 (hmiOff) = Off: Status message is not output.
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1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

See also
Device dependency (Page 3583)

ClearAlarmBuffer

Description
Deletes alarms from the alarm buffer on the HMI device.       

 

 Note

Alarms which have not yet been acknowledged are also deleted.
 

Use in the function list
ClearAlarmBuffer (Alarm class number)

Use in user-defined functions
ClearAlarmBuffer (Alarm_class_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Alarm class number
Determines which alarms are to be deleted from the alarm buffer:

0 (hmiAll) = All alarms/events

1 (hmiAlarms) = Alarms of alarm class "Errors"

2 (hmiEvents) = Alarms of alarm class "Warnings"

3 (hmiSystem) = Alarms of alarm class "System"
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4 (hmiS7Diagnosis) = Alarms of alarm class "Diagnosis Events"
 

 Note
Device dependency

Alarms of alarm class "Diagnosis Events" are not available on Basic Panels.
 

See also
Device dependency (Page 3583)

ClearAlarmBufferProTool

Description
The system function exists to ensure compatibility.

It has the same functionality as the "ClearAlarmBuffer" system function, but uses the old 
ProTool numbering.       

Use in the function list
ClearAlarmBufferProTool (Alarm class number)

Use in user-defined functions
ClearAlarmBufferProtoolLegacy (Alarm_class_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Alarm class number
Alarm class number whose messages are to be deleted:

-1 (hmiAllProtoolLegacy) = All alarms/events

0 (hmiAlarmsProtoolLegacy) = Alarms of alarm class "Errors"

1 (hmiEventsProtoolLegacy) = Alarms of alarm class "Warnings"

2 (hmiSystemProtoolLegacy) = Alarms of alarm class "System"
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3 (hmiS7DiagnosisProtoolLegacy) = Alarms of alarm class "Diagnosis Events"
 

 Note
Device dependency

Alarms of alarm class "Diagnosis Events" are not available on Basic Panels.
 

See also
Device dependency (Page 3583)

AlarmViewUpdate

Description
Updates the enhanced alarm view.     

Use in the function list
AlarmViewUpdate (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the alarm view which is updated.

See also
Device dependency (Page 3583)

AlarmViewEditAlarm

Description
Triggers the event "Edit" for all alarms selected in the given alarm view.     

This system function is used when the integrated button of the ActiveX control should not be 
used.
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A system function can in turn be configured on the "Edit" event. For example, it is possible to 
change to the process screen in which the alarm appeared.

 

 Note

If the alarms to be edited have not yet been acknowledged, the acknowledgment takes place 
automatically when this system function is called up.

 

Use in the function list
AlarmViewEditAlarm (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the alarm view in which the event is triggered.

 

 Note

The HMI devices listed below do not support this system function for the "screen" object: OP 
73, OP 77A, TP 177A.

 

See also
Device dependency (Page 3583)

AlarmViewAcknowledgeAlarm

Description
Acknowledges the alarms selected in the given alarm view.     

This system function is used when the integrated button of the ActiveX control should not be 
used.

Use in the function list
AlarmViewAcknowledgeAlarm (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the alarm view in which the event is triggered.

 

 Note

The HMI devices listed below do not support this system function for the "screen" object: OP 
73, OP 77A, TP 177A.

 

See also
Device dependency (Page 3583)

AlarmViewShowOperatorNotes

Description
Displays the configured tooltip of the alarm selected in the given alarm view.     

Use in the function list
AlarmViewShowOperatorNotes (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the alarm view in which the event is triggered.

 

 Note

The HMI devices listed below do not support this system function for the "screen" object: OP 
73, OP 77A, TP 177A.

 

See also
Device dependency (Page 3583)
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OpenAllLogs

Description
Reestablishes the connection between WinCC and the logs. Logging can be continued.       

 

 Note

Run the "StartLogging" system function in order to restart logging.
 

Use in the function list
OpenAllLogs

Use in user-defined functions
OpenAllLogs

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. You open all logs with the "Open Archive" button. 
Logging will be continued in the specified log. 

See also
Device dependency (Page 3583)
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OpenScreenKeyboard

Description
Hides or shows the screen keyboard.       

The screen keyboard remains open until the screen keyboard is explicitly closed. In this way, 
the screen keyboard can also be used in other applications.

Use in the function list
OpenScreenKeyboard (Layout)

Use in user-defined functions
OpenScreenKeyboard (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Layout
Specifies whether the window is opened minimized or maximized with the screen keyboard:

0 (hmiScreenKeyboardMinimized) = Minimized

1 (hmiScreenKeyboardMaximized) = Maximized

See also
Device dependency (Page 3583)

OpenFileBrowser

Description
Opens a file browser dialog. 

Depending on the mode the user can select a file or a folder.

Use in the function list
OpenFileBrowser (Mask, Output Folder, File, Navigation Back, Navigation Up, New folder, 
Path, Status)

Use in user-defined functions
-
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Parameters

Mask
Sets a mask for filtering the displayed files. This parameter is only evaluated in "File" mode. 
The filter criteria must be delimited by ; semicolon. Example: *.htm;*.html

Output Folder
Sets the output folder that is used to start the file selection dialog.

File
Sets the mode for opening the dialog.

0  = file search mode

1  = folder search mode

Navigation Back
Specifies whether or not the "Back" button is activated. This button offers simple navigation to 
the last folder you opened.

Navigation Up
Specifies whether or not the "Up" button is activated. This button offers simple navigation to 
the parent folder.

Navigation Back
Specifies whether or not the "Back" button is activated. This button offers simple navigation to 
the last folder you opened.

New folder
Specifies whether or not the button can be used to create a new folder.

Path
Contains the path name of the last folder opened after you close the dialog.

Status
Returns information about the dialog closing mode 

-1 = dialog was canceled

0 = dialog was closed with "OK".

OpenControlPanelDialog

Description
Opens a dialog that you can use to edit selected Control Panel settings.       

This system function lets you set the following on the HMI device:
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● Properties and value of the IP address

● User identification on the network

● WinCC Internet settings
 

 Note
Project security

The "OpenControlPanelDialog" system function is used to bypass the SecureMode on the 
HMI device. Take the corresponding precautions to ensure the security of your project.  

 

Use in the function list
OpenControlPanelDialog (Dialog)

Use in user-defined functions
-

Parameters

Dialog
Sets the Control Panel dialog to be opened.

● PROFINET_X1: Setting of the IP address and Ethernet parameters

● PROFINET_X3: Setting of the IP address and Ethernet parameters; only for Comfort Panel 
KP 1500, TP 1500; TP1900, TP2200

● WinCC Internet settings: Setting for Web Server, e-mail notification, provided the HMI 
device supports these functions

● Network ID: Setting for identification on the network, provided the HMI device supports 
these functions

 

See also
Device dependency (Page 3583)

OpenCommandPrompt

Description
Opens a Windows system prompt.       

This function is used, e.g., to copy files or to call up another application.
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Use in the function list
OpenCommandPrompt

Use in user-defined functions
OpenCommandPrompt

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)

OpenInternetExplorer

Description
Opens the Internet Explorer on the HMI device.       

If the Internet Explorer is already open, it will be closed and reopened when you call the system 
function.

 

 Note

The Internet Explorer saves data temporarily in the DRAM file system of the HMI device, e.g. 
the last web sites that were be called up.

This data can be saved using the "BackupRAMFileSystem" system function so that it is still 
available when the HMI device is restarted.

 

Use in the function list
OpenInternetExplorer (Start page)

Use in user-defined functions
OpenInternetExplorer (Start_page)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Start page
The page which is loaded when Internet Explorer is started, e.g. "www.siemens.com".

See also
Device dependency (Page 3583)

OpenControlPanel

Description
Opens the window that displays the Windows CE control panel. You cannot use this system 
function on a PC.       

This system function enables you to set the following on the Windows CE-based HMI device:

● Select printer

● Select transfer properties

● Configure screen saver

● Configure flash memory
 

  Note
No backup or restore during Runtime

Backup and restore functions may only be executed if Runtime has been terminated. 
Otherwise, this could result in undesired effects, such as display errors.

 

Use in the function list
OpenControlPanel

Use in user-defined functions
OpenControlPanel

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters
--
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OpenTaskManager

Description
Shows the task manager.       

The task manager allows changing to other open applications on the HMI device.
 

 Note

The appearance of the task manager depends on the operating system installed.
 

Use in the function list
OpenTaskManager

Use in user-defined functions
OpenTaskManager

Can be used if the configured device supports user-defined scripts. For additional information, 
refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)

AcknowledgeAlarm

Description
Acknowledges all selected alarms.       

This system function is used when the HMI device does not have an ACK key or when the 
integrated key of the alarm view should not be used.

This system function can only be used for function keys.

Use in the function list
AcknowledgeAlarm
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Use in user-defined functions
AcknowledgeAlarm

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)

RecipeViewNewDataRecord

Description
Creates a new data record in the given recipe view.     

Use in the function list
RecipeViewNewDataRecord (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the new recipe data record is created.

See also
Device dependency (Page 3583)

RecipeViewGetDataRecordFromPLC

Description
Transfers the data record that is currently loaded in the PLC to the HMI device and displays it 
in the recipe view.     
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Use in the function list
RecipeViewGetDataRecordFromPLC (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the recipe data record from the PLC is displayed.

See also
Device dependency (Page 3583)

RecipeViewClearDataRecord

Description
Deletes the data record which is currently displayed in the recipe view.     

Use in the function list
RecipeViewClearDataRecord (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the displayed recipe data record is deleted.

See also
Device dependency (Page 3583)

RecipeViewMenu

Description
Opens the menu of the specified simple recipe view.     
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Only use this system function at a simple recipe view.

Use in the function list
RecipeViewMenu (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the menu is to be opened.

See also
Device dependency (Page 3583)

RecipeViewOpen

Description
Displays the data record values in the given recipe view or changes to the next selection field. 
The system function has no effect if the selection field for the recipe data record values is 
displayed on the HMI device.   

Operation sequence of the selection lists in runtime:

● Recipe name

● Data record name

● RecipeDataRecordValues

This system function is used when a simple recipe view has been configured. In the simple 
recipe view, only one selection list is displayed at a time on the HMI device. Use the 
"RecipeViewBack" system function to display the previous selection list.

Use in the function list
RecipeViewOpen (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Name of the recipe view in which the command is triggered.

See also
Device dependency (Page 3583)

RecipeViewBack (Page 3696)

RecipeViewSetDataRecordToPLC

Description
Transfers the recipe data record which is currently displayed in the recipe view to the PLC.     

Use in the function list
RecipeViewSetDataRecordToPLC (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view from which the recipe data record is transferred to the connected PLC.

See also
Device dependency (Page 3583)

RecipeViewSaveDataRecord

Description
Saves the recipe data record which is currently displayed in the recipe view.     

Use in the function list
RecipeViewSaveDataRecord (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the recipe data record is saved.

See also
Device dependency (Page 3583)

RecipeViewSaveAsDataRecord

Description
Saves the data record currently being displayed in the recipe view under a new name.     

Use in the function list
RecipeViewSaveAsDataRecord (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Saves the data record currently being displayed in the recipe view under a new name and/or 
new number.

See also
Device dependency (Page 3583)

RecipeViewSynchronizeDataRecordWithTags

Description
Synchronizes the values of the data record which is currently displayed in the recipe view with 
their recipe tags. Only use this system function at an advanced recipe view.    

During synchronization, all values of the data record are written to their recipe tags.
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Use in the function list
RecipeViewSynchronizeDataRecordWithTags (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the values are synchronized with their tags.

 

 Note

The OP 77A and TP 177A HMI devices do not support this function for the screen object.
 

See also
Device dependency (Page 3583)

RecipeViewRenameDataRecord

Description
Renames the selected data record in the given recipe view.     

Only use this system function at a simple recipe view.

Use in the function list
RecipeViewRenameDataRecord (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the recipe data record is renamed.

See also
Device dependency (Page 3583)
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RecipeViewShowOperatorNotes

Description
Displays the configured tooltip of the specified recipe view.     

Use in the function list
RecipeViewShowOperatorNotes (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view whose configured tooltip is displayed.

See also
Device dependency (Page 3583)

RecipeViewBack

Description
Returns to the previous selection list in the given recipe view.     

The system function has no effect if the selection field for the recipe is displayed on the HMI 
device. Operation sequence of the selection lists in runtime:

● Recipe name

● Data record name

● RecipeDataRecordValues

This system function is used when a simple recipe view has been configured. In the simple 
recipe view, only one selection list is displayed at a time on the HMI device. Use the 
"RecipeViewOpen" system function to display the recipe data record values or the next 
selection field.

Use in the function list
RecipeViewBack (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the command is triggered.

See also
Device dependency (Page 3583)

ResetBit

Description
Sets the value of a "Bool" type tag to 0 (FALSE).       

Use in the function list
ResetBit (Tag)

Use in user-defined functions
ResetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 0 (FALSE).

Example
The following program code resets the value of the boolean tag b_value to 0 by means of the 
ResetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 1;
BOOL b_saved = b_value;
 
//Reset bit
  ResetBit (b_value);
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//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
ResetBitInTag (Page 3698)

Device dependency (Page 3583)

ResetBitInTag

Description
Sets a bit in the specified tag to 0 (FALSE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "ResetBit" system 
function instead.

 

Use in the function list
ResetBitInTag (Tag, Bit)

Use in user-defined functions
ResetBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 0 (FALSE).

Bit
The number of the bit that is set to 0 (FALSE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.
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Example
The following program code sets a bit at the specified bitposition in the bvalue tag to 0 and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
ResetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
Device dependency (Page 3583)

ResetBit (Page 3696)

PressButton

Description
The system function can only be configured on the function keys of an HMI device and triggers 
the "Press key" event at the specified screen object.     

Use this system function when you want to operate a button in a screen with a function key of 
the HMI device, for example.

 

 Note

The "PressButton" and "ReleaseButton" system functions must always be configured 
together. If you configure the "PressButton" system function on the "Press key" event for a 
function key, the "ReleaseButton" system function is configured on the "Release" event for 
the same function key.

 

Use in the function list
PressButton (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Name of the screen object on which the event is triggered.

See also
Device dependency (Page 3583)

ReleaseButton

Description
The system function can only be configured on the function keys of an HMI device and triggers 
the "Release button" event at the specified screen object.     

Use this system function when you want to operate a button in a screen with a function key of 
the HMI device, for example.

 

 Note

The "PressButton" and "ReleaseButton" system functions must always be configured 
together. If you configure the "PressButton" system function on the "Press key" event for a 
function key, then the "ReleaseButton" system function is configured on the "Release key" 
event for the same function key.

 

Use in the function list
ReleaseButton (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the screen object on which the event is triggered.

See also
Device dependency (Page 3583)
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ShiftAndMask

Description
This system function converts the input bit pattern of the source tags into an output bit pattern 
of the target tags. This involves bit shifting and masking.

 

 Note

If the source and target tag have a different number of bits, using the system function in the 
target tag can result in a violation of the value range.

 

Use in the function list
ShiftAndMask (Source tag, Target tag, Bits to shift, Bits to mask)

Use in user-defined functions
ShiftAndMask (Source_tag, Target_tag, Bits_to_shift, Bits_to_mask)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Source tag
The tag includes the input bit pattern. Integer-type tags, e.g. "Byte", "Char", "Int", "UInt", "Long" 
and "ULong" are permitted. 

Example: The actual value 72 is set at the 16-bit integer source tag: 0000000001001000.

Target tag
The output bit pattern is saved in the tag. Integer type tags, e.g. "Byte", "Char", "Int", "UInt", 
"Long" and "ULong" are permitted.

Example: The shifted input bit pattern is multiplied by the bit mask, with bit-by-bit logical AND 
operation: 0000000000001001. The resultant decimal value "8" is saved to the target tag.

Please note the following:

● The source and target tags have the same number of bits.

● The number of bits to shift is less than the number of bits in the source tag and target tag.

● Bits to mask does not have more bits than the source tag and the target tag.

Bits to shift
Number of bits by which the input bit pattern is shifted right. A negative value shifts the input 
bit pattern to the left.

Example: "Bits to shift" has the value "+3". The input bit pattern is shifted right by three bits 
when the system function is called: 0000000000001001.
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Bits to the left are padded with "0". Three bits are truncated on the right. The new decimal 
value is "9".

 

 Note

The left bit is "1" in a source tag of the data type with negative signed integer. This sign bit 
is padded with "0" when the bits are shifted right. The sign changes to "+".

 

Bits to mask
An integer serves as bit mask. The bit pattern is used to multiply the shifted input bit pattern. 
Example: Integer "2478" with the bit pattern "0000100110101110".

You can enter the bit mask in three different ways:

● Hexadecimal: First enter the prefix "0h" or "0H", followed by an optional space for better 
readability. Then group the bit pattern in blocks of four (0000)(1001)(1010)(1110) and set 
each block in hexadecimal code: (0)(9)(A)(E). Only the characters 0-9, A-F, a-f are allowed: 
"0h 09AE".

● Binary: First enter the prefix "0b" or "0B", followed by an optional space for better readability. 
Then group the binary bit pattern into blocks of four 0000 1001 1010 1110 with spaces in 
between as a check. Only the characters "0" or "1" are allowed: "0b 0000 1001 1010 1110".

● Decimal: Enter the value "2478" directly, without a prefix.

See also
Device dependency (Page 3583)

CloseAllLogs

Description
Disconnects the connection between WinCC and all logs.       

 

 Note

Before you close a log, the logging function must first be stopped in the log. Use the 
"StopLogging" system function.

 

Use in the function list
CloseAllLogs

Use in user-defined functions
CloseAllLogs
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. You open all logs with the "Open Archive" button. 
The logging process will continue in the specified log.

See also
Device dependency (Page 3583)

SetDataRecordToPLC

Description
Transfers the given recipe data record directly from the data medium of the HMI device to the 
PLC with which the HMI device is connected.       

 

 Note

The values of the recipe data record don't need to be displayed on the HMI device.
 

Use in the function list
SetDataRecordToPLC (Recipe number/name, Data record number/name, Output status 
message, Processing status)
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Use in user-defined functions
SetDataRecordToPLC (Recipe_number/name, Data_record_number/name, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data record is transferred to the PLC.

Data record number/name
Number or name of the recipe data record to be transferred to the PLC. 

Output status message
Determines whether a status message is output after the transfer:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

See also
Device dependency (Page 3583)

SetDataRecordTagsToPLC

Description
Transfers the values of the recipe tags to the PLC. The recipe tags contain the values of the 
data record which is displayed on the HMI device.       

Use in the function list
SetDataRecordTagsToPLC (Recipe number/name, Processing status)
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Use in user-defined functions
SetDataRecordTagsToPLC (Recipe_ number/name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data record is transferred to the PLC. 

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

See also
Device dependency (Page 3583)

PageDown

Description
Executes the key function <Pagedown> on the HMI device. 

This system function can only be used for function keys.       

Use in the function list
PageDown

Use in user-defined functions
PageDown

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
-
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See also
Device dependency (Page 3583)

PageUp

Description
Executes the key function <PageUp> on the HMI device. 

This system function can only be used for function keys and tasks with a time trigger.       

Use in the function list
PageUp

Use in user-defined functions
PageUp

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
-

See also
Device dependency (Page 3583)

SendEMail

Description
Sends an e-mail from the HMI device to the given addressee.       

This system function is used, for example, when, in the case of service, the alarm is to be 
passed on directly to the service technician.

 

 Note

To send alarms as e-mails, the HMI system must have an e-mail client at its disposal.
 

Use in the function list
SendEMail (Address, Subject, Text, Return address)
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Use in user-defined functions
SendEMail (Address, Subject, Text, Return_address)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Address
The e-mail address of the addressee.

Subject
The subject line of the e-mail.

Text
The text sent in the e-mail.

Return address
The e-mail address to which the addressee of this e-mail should send the reply.

See also
Device dependency (Page 3583)

SetAcousticSignal

Description
Configures the acoustic feedback of touch screen operation on the HMI device.       

 

 Note

The configuration that was set at Switch off is reestablished when restarting the HMI device.
 

Use in the function list
SetAcousticSignal (Volume)

Use in user-defined functions
SetAcousticSignal (Volume)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Volume
Determines whether and how loud an acoustic signal is emitted:

-1 (hmiToggle) = Toggle: Toggles the emission of the acoustic signal as follows: Muted > Quiet 
> Loud.

0 (hmiMuted) = Mute: no acoustic signal

1 (hmiQuiet) = Quiet: quiet acoustic signal

2 (hmiLoud) = Loud: loud acoustic signal

See also
Device dependency (Page 3583)

SetDisplayMode

Description
Changes the settings of the screen in which the runtime software runs.       

The runtime software runs in full-screen mode as default. The Windows task switch is disabled.

Use in the function list
SetDisplayMode (Layout)

Use in user-defined functions
SetDisplayMode (Display mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Display mode
Determines the settings for the screen in which the runtime software runs.

1 (hmiScreenFull): Full-screen: Title bar of the screen is not visible

2 (hmiScreenMaximized): Maximized

3 (hmiScreenRestore): Restore: The last used screen setting is used. This layout can only be 
used when the window is displayed minimized or maximized.

4 (hmiScreenMinimized): Minimized

5 (hmiScreenAutoAdjust): Automatic: The size of the window is set so that all screen objects 
in it will be visible.
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6 (hmiScreenOnTop): On top; either the window appears in the foreground or the program 
icon associated with the window flashes on the taskbar depending on the Windows setting. 
The setting can be changed in the Windows configuration and applies to all Windows 
applications.

See also
Device dependency (Page 3583)

SetDeviceMode

Description
Toggles the operating mode on the HMI device. The following types of operation are possible: 
"Online", "Offline" and "Load".       

Use in the function list
SetDeviceMode (Operating mode)

Use in user-defined functions
SetDeviceMode (Operating_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Operating mode
Determines the operating mode of the HMI device:

0 (hmiOnline) = Online: The connection to the PLC is established.

1 (hmiOffline) = Offline: The connection to the PLC is disconnected.

2 (hmiTransfer) = load: A project can be transferred from the configuration computer to the 
HMI device.

 

 Note

If you use a PC as an HMI device, the runtime software will be exited when you change 
operating mode after "Load".

 

See also
Device dependency (Page 3583)

SetConnectionMode (Page 3723)
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SetBit

Description
Sets the value of a "Bool" type tag to 1 (TRUE).       

Use in the function list
SetBit (Tag)

Use in user-defined functions
SetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 1 (TRUE).

Example
The following program code sets the value of the boolean tag b_value to 1 by means of the 
SetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Set bit
  SetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
Device dependency (Page 3583)
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SetBitInTag

Description
Sets a bit in the given tag to 1 (TRUE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.

 

Use in the function list
SetBitInTag (Tag, Bit)

Use in user-defined functions
SetBitInTag(Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 1 (TRUE).

Bit
The number of the bit that is set to 1 (TRUE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an I/O field or assign 
the system function to a screen object, such as a button.

If you have configured a short event such as the activation of an alarm for the system function 
you can only access the actual process values by setting the tag for continuous reading.
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Example
The following program code sets a bit to 1 at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
SetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
SetBit (Page 3709)

Device dependency (Page 3583)

SetBitWhileKeyPressed

Description
Sets the bit of the given tag to 1 (TRUE) as long as the user keeps the configured key 
pressed.     

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC. You should 
only access tags of the BOOL type with this system function to avoid problems with overlapping 
access to the same tag. 

 

 Note

All functions on the event "Release" are performed immediately by means of a screen change 
configured for a key, even if the key is kept pressed.

If the "SetBitWhileKeyPressed" system function is configured for a function key, the bit will 
be reset immediately following a screen change. This action is necessary since the key 
assignments change after the screen change.

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.
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Use in the function list
SetBitWhileKeyPressed (Tag, Bit)

Use in user-defined functions
-

Parameters

Tag
The tag in which a bit is temporarily set to 1 (TRUE). Use only tags of the type BOOL, as far 
as allowed by the PLC.

Bit
The number of the bit that is temporarily set to 1 (TRUE).

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an IO field, or assign 
the function to a screen element such as a button.

If you configured a short event such as the activation of an alarm for the function you can 
only access the actual process values by setting the tag for continuous reading.

 

See also
SetBit (Page 3709)

Device dependency (Page 3583)

SetBacklightColor

Description
Defines the background lighting of the button.     

 

 Note

The configuration that was set at Switch off is reestablished when restarting the HMI device.
 

Use in the function list
SetBacklightColor (Value)
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Use in user-defined functions
-

Parameters

Value
Defines the background lighting of the button:

0 (hmiWhite) = White: No color 

1 (hmiGreen) = Green: Green color

2 (hmiYellow) = Yellow: Yellow color

3 (hmiRed) = Red: Red color

See also
Device dependency (Page 3583)

SetBrightness

Description
Determines the brightness of the display.       

 

 Note

The configuration that is set in the Control Panel will be reestablished when you restart the 
HMI device.

 

Use in the function list
SetBrightness (value)

Use in user-defined functions
SetBrightness (Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Value
New value for the brightness. 
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See also
Device dependency (Page 3583)

SetScreenKeyboardMode

Description
Enables or disables the automatic display of the screen keyboard on the HMI device.       

This system function is also used to prevent the display of the screen keyboard, e.g. because 
an external keyboard is connected to the HMI device.

 

 Note

To enable the "SetScreenKeyboardMode" ("SetScreenKeyboardMode") system function on 
an HMI other than a Touch Panel device, set the "Use on-screen keyboard" check box in the 
"Runtime settings" dialog of the device settings.

 

Use in the function list
SetScreenKeyboardMode (Mode)

Use in user-defined functions
SetScreenKeyboardMode (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether the screen keyboard is hidden or shown:

0 (hmiOff) = Off: Screen keyboard is hidden

1 (hmiOn) = On: Screen keyboard is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes.

See also
Device dependency (Page 3583)
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SetPLCDateTime

Description
Changes the data and the time of the linked PLC  

The system function "ReadPLCDateTime" can only be configured for the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Use in the function list
ReadPLCDateTime (connection, time)

Use in user-defined functions
GetPLCDateTime (Connection, Time)

Parameters

Connection
Connection of PLC and HMI device.

Time
Transfers the date and the time of the HMI device to the PLC. The PLC applies the date and 
the time of the HMI device.

SetPLCMode

Description
Switches the operating mode of the PLC to one of the following states:  

● RUN

● STOP

The system function "SetPLCMode" can only be configured for the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Use in the function list
SetPLCMode (connection, mode)
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Use in user-defined functions
SetPLCMode (Connection, Mode)

Parameters

Connection
Connection of PLC and HMI device.

Mode
Specifies the operating mode of the PLC:

RUN = the PLC is switched to the RUN state. The PLC program is executed.

STOP = the PLC is switched to the STOP state. The PLC program is interrupted.

SetAlarmReportMode

Description
Switches the automatic reporting of alarms on the printer on or off.       

Use in the function list
SetAlarmReportMode (Mode)

Use in user-defined functions
SetAlarmReportMode (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether alarms are reported automatically on the printer:

0 (hmiDisablePrinting) = Reporting off: Alarms are not printed automatically.

1 (hmiEnablePrinting) = Reporting On: Alarms are printed automatically.

-1 (hmiToggle) = Toggle: Toggles between the two modes.

See also
Device dependency (Page 3583)
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SetRecipeTags

Description
Changes the status of the recipe tags from "Online" to "Offline" and vice versa.       

This system function is used, for example, when recipe data record values are fine tuned when 
starting up a machine.

Use in the function list
SetRecipeTags (Recipe number/name, Status, Output status message, Processing status)

Use in user-defined functions
SetRecipeTags (Recipe_number/name, Status, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe in which the recipe data record is saved.

Status
Determines the status of the recipe tags:

0 (hmiOnline) = Online: Value changes of the recipe tags are transferred immediately to the 
PLC connected to the HMI device.

1 (hmiOffline) = Offline: Value changes to the recipe tags are only transferred to the PLC 
connected to the HMI device when, for example, the "SetDataRecordTagsToPLC" system 
function is executed.

Output status message
Determines whether a status message is output after saving:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.
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See also
Device dependency (Page 3583)

SetDaylightSavingTime

Description
The system function "SetDaylightSavingTime" changes the setting of the HMI device from 
daylight saving to standard time and vice versa.

Time settings will take place immediately following system function.     
 

 Note

The "SetDaylightSavingTime" system function does not support time zones without daylight 
saving time. 

 

 Note
Windows 7

The system function "SetDaylightSavingTime" is not supported for PC-based HMI devices 
under Windows 7.

 

Use in the function list
SetDaylightSavingTime(DaylightSavingTime)

Use in user-defined functions
SetDaylightSavingTime (Daylight_saving_time)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Daylight Saving Time
Determines whether Daylight Saving Time is set on the HMI device:

0 = Daylight Saving Time is not activated

1 = Daylight Saving Time is activated

See also
Device dependency (Page 3583)
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SetLanguage

Description
Toggles the language on the HMI device. All configured text and system events are displayed 
on the HMI device in the newly set language.       

Use in the function list
SetLanguage (Language)

Use in user-defined functions
SetLanguage (Language)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Language
Determines which language is set on the HMI device. The following specifications are possible:

● -1 (hmiToggle) = Toggle: Changes to the next language. The sequence is determined 
during configuration in the "Project languages" editor.

● Number you have defined under "Languages and fonts" in the "Runtime Settings" editor. 
Changes to the language with the given number.

● Language you have defined under "Languages and fonts" in the "Runtime Settings" editor.

● Language abbreviation in accordance with the VBScript5 reference: This changes to the 
language corresponding to the specified language code, e.g. "de-DE" for German 
(Germany) or "en-US" for English (United States).
An overview of the language abbreviations is available in the basic information of VBScript 
under the topic "Area diagram-ID (LCID) Diagram".

See also
Device dependency (Page 3583)
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SetAndGetBrightness

Description
Determines the brightness of the MP 377 Touch daylight readable display. The brightness 
value can be interpreted as absolute or relative to the current value.       

 

 Note

The configuration that is set in the Control Panel will be reestablished when you restart the 
HMI device.

 

Use in the function list
SetAndGetBrightness (Brightness, Mode, Current value)

Use in user-defined functions
SetAndGetBrightness (Brightness, Mode, Actual brightness)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Brightness
New value for the brightness.

Mode
Specifies if the new brightness value is set as absolute or relative to the current value.

Current value
Tag in which the current brightness value is stored.

See also
Device dependency (Page 3583)
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SetTag

Description
Assigns a new value to the given tag.     

 

 Note

This system function can be used to assign strings and numbers, depending on the type of 
tag.

 

Use in the function list
SetTag (Tag, Value)

Use in user-defined functions
SetTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag to which the given value is assigned.

Value
The value which the given tag is assigned.

 

 Note

The "SetTag" system function is only executed after a connection has been established.
 

Example
The following program code uses the SetTag function to set the value of the gs_tag_bit tag to 
TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
 
//Set the tag to true
ok = SetTag("gs_tag_bit", TRUE);
//error handling
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if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBit("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

The saved return value can be processed in the following code.

See also
Device dependency (Page 3583)

SetConnectionMode

Description
Connects or disconnects the given connection.       

 

 Note

A connection to the PLC cannot be established until the operating mode ONLINE has been 
set on the HMI device. Use the "SetDeviceMode" system function for this purpose.

 

Use in the function list
SetConnectionMode (Mode, Connection)

Use in user-defined functions
SetConnectionMode (Mode, Connection)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether a connection to the PLC is established or disconnected:
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0 (hmiOnline) = Online: Connection is established.

1 (hmiOffline) = Offline: Connection is disconnected.

Connection
The PLC to which the HMI device is connected. You specify the name of the PLC in the 
connection editor.

Multiple use of the system function in a user-defined function
If you use the "SetConnectionMode" system function for different connections, it may be 
possible that not all system functions are executed correctly. Proceed as follows to prevent 
this situation:

1. Create a "BOOL" type tag with the start value "0".

2. Configure the "SetConnectionMode" system function on the "Value change" event of the 
HMI tags. If you want to disconnect three connections, for example, you must configure the 
system function three times.

3. In the user-defined function, apply the "InvertBit" system function to the HMI tag.

Application example
Two typical application examples for this system function are as follows:

● Test
As long as no PLC is connected to the HMI device, no error messages will be output during 
the test on the HMI device. If the HMI device is connected to a PLC, the connection to the 
PLC can be established by pressing a key.

● Commissioning
Several PLCs are to be configured for a system. At first, all PLCs except one are configured 
"Offline". After commissioning of the first PLC, the connection to each of the other PLCs is 
established by pressing a key. In this way, the other PLCs are started up one after another.

See also
Device dependency (Page 3583)

SetWebAccess

Description
Determines the access mode to the runtime application using the Internet.       

Use in the function list
SetWebAccess (Access mode)
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Use in user-defined functions
-

Parameters

Access mode
Determines the access mode to the runtime application:

-1 (hmiToggle) = Toggle: Toggles between the two modes.

0 (hmiReadOnly) = Read-only.

1 (hmiReadWrite) = Read-write.

See also
Device dependency (Page 3583)

BackupRAMFileSystem

Description
Backs up the RAM file system in the memory medium of the HMI device.       

After restarting the HMI device, the data is automatically reloaded in the RAM file system.

Applications such as the Internet Explorer save data (e.g. the last web sites called up) 
temporarily to the DRAM file system of the HMI device.

Use in the function list
BackupRAMFileSystem

Use in user-defined functions
BackupRAMFileSystem

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

See also
Device dependency (Page 3583)
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SimulateSystemKey

Description
Simulates the behavior of a System Key. Use this system function if a system key, such as 
the "ACK" key, "Input" key or the number pad is not available on the HMI device. 

Use in the function list
SimulateSystemKey (System key)

Use in user-defined functions
-

Parameters

System key
System Key, the behavior for which is to be simulated. 

System key "+/-"
With the SimulateSystemKey system function, the system key "+/-" is only supported for the 
following HMI devices:

● KP300 Basic

● KP400 Basic

● KTP400 Basic mono PN

● KTP400 Basic color PN

● KTP400 Basic color PN Portrait

● KTP600 Basic mono PN

● KTP600 Basic color PN

● KTP600 Basic color DP

● KTP1000 Basic PN

● KTP1000 Basic DP

Use the system keys "+" and "-" separately for all other HMI devices.

See also
Device dependency (Page 3583)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3725



SimulateTag

Description
Simulates the behavior of tags and dynamic objects such as text lists, without having the HMI 
device connected to a PLC.  You can, for example, configure the system function to the 
"Loaded" event of a screen.   

This system function is used, for example, to demonstrate the functionality of a project.

Only tags of the data type Integer can be used for simulation. Tags of the data types Integer 
and Double Integer, however, can be used with OP 73, OP 77A, TP 177A.

 

 Note

If you use the system function "SimulateTag" with a short cycle time on a Basic Panel, the 
HMI device may be overloaded.

 

Use in the function list
SimulateTag (Tag, Cycle, Maximum value, Minimum value, Value)

Use in user-defined functions
-

Parameter

Tag
The tag whose value is changed. 

Cycle
The factor by which the basic cycle of 200 milliseconds is multiplied. The cycle defines when 
the tag value is changed by the specified value. Possible cycles between 1 and 32767.

Maximum value
The maximum value that the tag can assume during simulation. The maximum value must be 
greater than the minimum value but less than / equal to 32767. 

Minimum value
The minimum value that the tag can assume during simulation. The minimum value must be 
greater than the maximum value but less than / equal to -32768. 

Value
The value by which the tag value is changed during each cycle. Possible values between 
-32768 and 32767.
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● A positive value increases the tag value. When the maximum value is reached, the tag 
value is set to the minimum value after the next update cycle.

● A negative value reduces the tag value. When the minimum value is reached, the tag value 
is set to the maximum value after the next update cycle.

See also
Device dependency (Page 3583)

SmartClientViewRefresh

Description
Updates the contents displayed in the Sm@rtClient view.     

Use in the function list
SmartClientViewRefresh (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

See also
Device dependency (Page 3583)

SmartClientViewReadOnlyOff

Description
Sets read-only access to "Off" in the Sm@rtClient view.     

This setting allows a distant HMI device to be operated. The "SmartClientViewReadOnlyOn" 
system function is used to switch read-only access on again.

Use in the function list
SmartClientViewReadOnlyOff (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

See also
Device dependency (Page 3583)

SmartClientViewReadOnlyOn

Description
Sets read-only access to "On" in the Sm@rtClient view.     

This setting allows a distant HMI device to be monitored only. The 
"SmartClientViewReadOnlyOff" system function is used to switch read-only access off again.

Use in the function list
SmartClientViewReadOnlyOn (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

See also
Device dependency (Page 3583)

SmartClientViewDisconnect

Description
Executes the "Disconnect" command in the Sm@rtClient view.     
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This system function is used when the integrated button of the screen object should not be 
used. 

Use in the function list
SmartClientViewDisconnect (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

See also
Device dependency (Page 3583)

SmartClientViewConnect

Description
Executes the "Connect" command in the Sm@rtClient view.     

This system function is used when the integrated button of the screen object should not be 
used. The Sm@rtClient view establishes a connection with the configured HMI device.

Use in the function list
SmartClientViewConnect (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

See also
Device dependency (Page 3583)
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SmartClientViewLeave

Description
Exits the Sm@rtClient view and returns to operation of the HMI device.     

The connection to the HMI device configured in the smart client view is retained.

Use in the function list
SmartClientViewLeave (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

See also
Device dependency (Page 3583)

SaveDataRecord

Description
Saves the current values of the recipe tags as data record to the memory medium of the HMI 
device.       

This system function is used, for example, to save a recipe data record in the recipe screen.

Use in the function list
SaveDataRecord (Recipe number/name, Data record number/name, Overwrite, Output status 
message, Processing status)

Use in user-defined functions
SaveDataRecord (Recipe_number/name, Data_record_number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Recipe number/name
Number or name of the recipe to which a recipe data record is saved.

Data record number/name
Number or name of the recipe data record to be saved. A new data record will be created if 
no record of this name or number was found in the recipe, independent of the value at the 
"Overwrite" parameter.

Overwrite
Specifies whether an existing data record is overwritten:

0 (hmiOverwriteForbidden) = No: The recipe data record is not overwritten, the data record is 
not saved.

1 (hmiOverwriteAlways) = Yes: The recipe data record is overwritten without a prompt for 
confirmation.

2 (hmiOverwriteWithPrompting) = With confirmation: The recipe data record is overwritten only 
with confirmation by the user.

Output status message
Determines whether a status message is output after saving:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

See also
Device dependency (Page 3583)

StartLogging

Description
Starts the logging of data or alarms in the specified log. The function can also be applied to 
audit trails.       

You can interrupt logging at runtime using the "StopLogging" system function.
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Use in the function list
StartLogging (Log type, Log)

Use in user-defined functions
StartLogging (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail

Log
Name of the log which is started.

See also
Managing logging behavior when Runtime starts (Page 3222)

Device dependency (Page 3583)

StartNextLog

Description
Stops the logging of data or alarms for the given log.

Logging is continued in the next log of the segmented circular log you configured for the 
specified log.

If you did not configure a segmented circular log for the specified log, the system function has 
no effect.       

Use in the function list
StartNextLog (Log type, Log)

Use in user-defined functions
StartNextLog (Log_type, Log)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

Log
Name of the log for which the logging is stopped and continued in the next log.

See also
Device dependency (Page 3583)

StartProgram

Description
Starts the specified program on the HMI device.       

The runtime software continues running in the background. Alarms continue to be output and 
data continues to be updated.

When the given application is exited, the screen which was active during the performance of 
the system function is displayed on the HMI device.

This system function is used, for example, to edit recipe data records in MS Excel on the HMI 
device.

 

 Note

If Windows CE is installed on the HMI device, during the configuration it must be checked 
whether the desired application can be started with this system function.

This system function allows all applications to be started which can be started in the "Execute" 
dialog of Windows CE.

The application to be started must be installed on the HMI device.
 

Use in the function list
StartProgram (Program name, Program parameters, Layout, Wait for program to end)
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Use in user-defined functions
StartProgram (Program_name, Program_parameters, Display_mode, 
Wait_for_program_to_end)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Program name
Name and path of the program which is started. Upper and lower case are taken into account 
in this parameter.

 

 Note

If the path contains spaces, the program can only be started correctly if the path is specified 
in inverted commas, e.g. "C:\Program Files\START\start.exe".

 

Program parameters
The parameters you transfer at the start of the program, for example a file that is opened after 
the start of the program. 

The description of the necessary parameters is found in the documentation of the program to 
be started.

Layout
Determines how the program window is displayed on the HMI device:

0 (hmiShowNormal) = Normal

1 (hmiShowMinimized) = Minimized

2 (hmiShowMaximized) = Maximized

3 (ShowMinimizedAndInactive) = Minimized and inactive

Wait for program to end
Determines whether there is a change back to the project after the called up program has 
ended:

0 (hmiNo) = No: No change to project

1 (hmiYes) = Yes: Change to project
 

 Note

The "Wait for program to end" parameter is only available for Runtime Advanced and Panels.
 

See also
Device dependency (Page 3583)
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StatusForceGetValues

Description
Starts or stops the updating of values in the Status/Force display. The values are read from 
the PLC connected to the HMI device until the update is stopped.     

 

 Note

As long as the values are updated, no entries are possible in the input fields of the Status/
Force display.

 

Use in the function list
StatusForceGetValues (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Status/Force display to which data from the PLC is written.

See also
Device dependency (Page 3583)

StatusForceSetValues

Description
Writes the values from the Status/Force display to the PLC to which the HMI device is 
connected.    

Use in the function list
StatusForceSetValues (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Name of the Status/Force display from which data is written to the PLC.

See also
Device dependency (Page 3583)

ControlSmartServer

Description
Starts or stops the Sm@rtServer.       

Use in the function list
ControlSmartServer (Mode)

Use in user-defined functions
ControlSmartServer (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Specifies whether the Sm@rtServer is started or stopped. 

-1 (hmiToggle) = Toggle: Toggles between the two modes

0 (hmiStop) = Stop: Sm@rtServer is stopped

1 (hmiStart) = Start: Sm@rtServer is started

See also
Device dependency (Page 3583)

ControlWebServer

Description
Starts or stops the Web server.       
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Use in the function list
ControlWebServer (Mode)

Use in user-defined functions
ControlWebServer (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Specifies whether the Web server is started or stopped. 

-1 (hmiToggle) = Toggle: Toggles between the two modes

0 (hmiStop) = Stop: The Web server is stopped.

1 (hmiStart) = Start: The Web server is started.

See also
Device dependency (Page 3583)

StopLogging

Description
Stops the logging of process values or alarms in the specified log. The function can also be 
applied to audit trails.       

The "StartLogging" system function is used to resume logging at runtime.
 

 Note

When logging is stopped, a connection between WinCC and the log files or log database still 
exists. Use the "CloseAllLogs" system function to disconnect this connection.

 

Use in the function list
StopLogging (Log type, Log)

Use in user-defined functions
StopLogging (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail

Log
Name of the log that is stopped.

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. The "Open Archive" button opens all logs and 
continues logging in the specified log.

See also
Device dependency (Page 3583)

StopRuntime

Description
Exits the runtime software and thereby the project running on the HMI device.       

Use in the function list
StopRuntime (Mode)

Use in user-defined functions
StopRuntime (Mode)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Mode
Determines whether the operating system is shut down after exiting runtime.

0 (hmiStopRuntime) = Runtime: Operating system is not shut down

1 (hmiStopRuntimeAndOperatingSystem) = Runtime and operating system: The operating 
system is shut down (not possible with WinCE)

Example
The following program code shuts down Runtime and the operating system.

 
{
 
//Stop runtime and shutdown
StopRuntime (hmiStopRuntimeAndOperationSystem);
 
}

The saved return value can be processed in the following code.

See also
Device dependency (Page 3583)

ActivateSystemDiagnosticsView

Description
Activates the system diagnostics view. The system diagnostics view shows the detail view of 
the device concerned.       

Use in the function list
ActivateSystemDiagnosticsView (Screen name, Object name)

Use in user-defined functions
ActivateSystemDiagnosticsView (Screen_name, Object_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Screen name
Name of the screen contained in the system diagnostics view.

Object name
Object name of the system diagnostics view.

See also
Device dependency (Page 3583)

SystemDiagnosticsViewRefreshPLCBuffer

Description
Refreshes the data from the diagnostics buffer of the PLC in the system diagnostics view. 

Use in the function list
SystemDiagnosticsViewRefreshPLCBuffer (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view.

SystemDiagnosticsViewDetailView

Description
The detail view returns detailed information about the selected connection and errors 
pending.     

Use in the function list
SystemDiagnosticsViewDetailView (Object name)

Use in user-defined functions
-
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Parameters

Object name
Name of the system diagnostics view that is switched to the detail view.

SystemDiagnosticsViewDiagnosticsBuffer

Description
Opens a view in a system diagnostics for displaying the current data of the diagnostics buffer.     

Use in the function list
SystemDiagnosticsViewDiagnosticsBuffer (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view that is switched to the detail view.

SystemDiagnosticsViewDeviceView

Description
Opens a view in a system diagnostics for displaying all available connections.     

Use in the function list
SystemDiagnosticsViewDeviceView (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view.
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SystemDiagnosticsViewBack

Description
Changes in a system diagnostics to the higher-level view. 

● The function opens the device view if the diagnostics buffer view is set in the system 
diagnostics view.

● The function opens the diagnostics buffer view if the detail view is displayed in the system 
diagnostics view.     

Use in the function list
SystemDiagnosticsViewBack (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view.

LookupText

Description     
Identifies an entry from a text list. The result depends on the value and on the selected runtime 
language. The result is saved to a tag of data type "String".

Use in the function list
LookupText (Output text, Value, Language, Text list)

Use in user-defined functions
LookupText (Output_text, Index, Language, Text_list)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Output text
The tag to which the result is written.
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Index
The tag that defines the value of the list entry. 

Language
Defines the runtime language in which the list entry is identified. 

● Tag
The tag that contains the language. Enter the runtime language as decimal value of the 
country ID, for example, 1031 for German - Standard, 1033 for English - USA. Details are 
available in the VBScript basics, "Locale identifier (LCID) diagram".

● Runtime language
Language code as per VBScript reference, for example, "de-DE" for German (Germany) 
or "en-US" for English (United States of America). The selection depends on the activated 
runtime languages. 

Text list
Defines the text list. The list entry is read from the text list.

See also
Device dependency (Page 3583)

ResetTagToHandWheel

Description
Separates the tag that is connected with the operating element handwheel, and reconnects 
the handwheel with the global tags.     

Use in the function list
ResetTagToHandWheel

Use in user-defined functions
-

Parameters
--

See also
Device dependency (Page 3583)
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SetTagToHandWheel

Description
Connect the tag with the operating device handwheel If the handwheel is operated, the tag 
value changes. The connection can be reset using the "ResetTagToHandWheel" system 
function.    

Use in the function list
SetTagToHandWheel (Value)

Use in user-defined functions
-

Parameters

Value
Tag names which are connected to the operating device handwheel.

See also
Device dependency (Page 3583)

TraceUserChange

Description
Outputs a system event that shows which user is currently logged in on the HMI device. 

This system function can only be used in the Scheduler.     

Use in the function list
TraceUserChange

Use in user-defined functions
-

Parameters
--
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See also
Device dependency (Page 3583)

DecreaseFocusedValue

Description
Subtracts the specified value from the value of the tag which is connected to the screen object 
and currently has the focus. 

This system function can only be used for function keys. 

Use in the function list
DecreaseFocusedValue (Value)

Use in user-defined functions
-

Parameters

Value
The value which is subtracted from the tag value.

See also
Device dependency (Page 3583)

DecreaseTag

Description
Subtracts the given value from the tag value.       

X = X - a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. The auxiliary tags are assigned to 
the tag value with the "SetTag" system function.

 

If you configure the system function on the events of an alarm and the tag is not being used 
in the current screen, it is not ensured that the actual value of the tags is being used in the 
PLC. You can improve the situation by setting the "Cyclic continuous" acquisition mode. 
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Use in the function list
DecreaseTag (Tag, Value)

Use in user-defined functions
DecreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag from which the given value is subtracted.

Value
The value which is subtracted.

See also
Device dependency (Page 3583)

ChangeConnection

Description
Disconnects the connection to the currently used PLC in use and establishes a connection to 
a PLC with another address. The newly connected PLC must belong to the same device class 
(S7-1200, S7-300, ...etc). With S7-1200, the use of the function is also only permitted for 
absolute addressing.

       
 

 Note

When changing to another address, ensure that the address is not already being used by 
another HMI device.

 

The follows address types are supported:

● IP address

● MPI address

The follows PLC types are supported:

● SIMATIC S7 300/400

● SIMATIC S7-NC

● SIMOTION
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Use in the function list
ChangeConnection (Connection, Address, Slot, Rack)

Use in user-defined functions
ChangeConnection (Connection, Address, Slot, Rack)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Connection
Name of the connection that is disconnected. The name is set during configuration, for 
example, in the "Connections" editor.

Address
MPI/PROFIBUS or IP address of the PLC to which the connection will be established.

 

 Note

Set the address by means of a tag. The objects list displays the tags of all data types. Select 
only tags of the following data types:
● Ethernet connection: "String" data type
● MPI connection: "Int" data type

 

Slot
Slot of the PLC to which the connection will be established.

Rack
Rack of the PLC to which the connection will be established.

Application example
You want to operate one HMI device on several machines. Configure the necessary PLCs in 
the project, to which you want to change by pressing a key. When changing the PLC, the 
connection to the PLC in use is disconnected. Then the connection to the new PLC with other 
address parameters is reestablished. To access the values of the new PLC, configure the 
same tags for the PLC used.

The PLC which you have indicated when creating the project will be used as default.

1. Enter the name and address of the PLC in the "Connections" editor.

2. Configure a button in the process screen.

3. Configure the "ChangeConnection" system function on the "Press" event.

4. Enter the name of the connection and address of the PLC as parameters.
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See also
Device dependency (Page 3583)

ShowLogonDialog

Description
Opens a dialog on the HMI device with which the user can log on to the HMI device.     

Use in the function list
ShowLogonDialog

Use in user-defined functions
-

Parameters
--

See also
Device dependency (Page 3583)

ShowOperatorNotes

Application
Displays the tooltip configured for the selected object.     

If the system function is configured on a function key, the tooltip for the screen object that 
currently has the focus is displayed. If a tooltip is configured for the screen itself, you can switch 
to this text by pressing <Enter> or by double-clicking on the help window.

If the system function is configured on a button, only the tooltip for the current screen is 
displayed. If a tooltip is configured on the button itself, initially only the tooltip for the button is 
displayed. You can press <Enter> or double-click on the help window to switch to the tooltip 
for the current screen.

 

 Note

No other screen object can be used while the help window is open. To use the screen object, 
close the help window.

 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3748 System Manual, 07/2013,  



Closing the help window
You can close the help window in the following ways:

Using the keys:

● By pressing the <HELP> key again

● By pressing the <ESC> key

Using the touch screen:

● By pressing the  button

Use in the function list
ShowOperatorNotes (Layout)

Use in user-defined functions
ShowOperatorNotes (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Display mode
Determines whether the configured tooltip is hidden or shown:

0 (hmiOff) = Off: Configured tooltip is hidden

1 (hmiOn) = On: Configured tooltip is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

See also
Device dependency (Page 3583)

ShowAlarmWindow

Description
Hides or shows the alarm window on the HMI device.       

Use in the function list
ShowAlarmWindow (Object name, Layout)
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Use in user-defined functions
ShowAlarmWindow (Object_name, Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Object name
Name of the alarm view which is hidden or shown.

Layout
Determines whether the alarm window is hidden or shown:

0 (hmiOff) = Off: Alarm view is hidden

1 (hmiOn) = On: Alarm view is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

See also
Device dependency (Page 3583)

ShowSoftwareVersion

Description
Hides or shows the version number of the runtime software.       

Use this system function if during servicing, for example, you required the version of the runtime 
software used.

Use in the function list
ShowSoftwareVersion (Layout)

Use in user-defined functions
ShowSoftwareVersion (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Layout
Determines whether the version number is shown:
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0 (hmiOff) = Off: Version number is not shown

1 (hmiOn) = On: Version number is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

See also
Device dependency (Page 3583)

ShowSystemDiagnosticsWindow

Description
Hides or shows the system diagnostic window on the HMI device. The system diagnostic view 
is only available in the global screen for Comfort Panels and for WinCC Runtime Advanced.       

Use in the function list
ShowSystemDiagnosticsWindow (Screen object)

Use in user-defined functions
ShowSystemDiagnosticsWindow (Target_Object_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen object
Name of the system diagnostic window which is hidden or shown.

See also
Device dependency (Page 3583)

ShowSystemAlarm

Description
Displays the value of the parameter passed as a system event to the HMI device.       

Use in the function list
ShowSystemAlarm (Text/value)
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Use in user-defined functions
ShowSystemAlarm (Text/value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Text/Value
The text or the value, which was output as a system alarm.

See also
Device dependency (Page 3583)

Functions for WinAC MP

WinACMPUpdateStartupCharacteristics

Description
Reads whether WinAC MP is automatically started after startup of the HMI device. The LED 
display of the "StartAtBoot" button is updated.     

Use in the function list
WinACMPUpdateControllerForStartAtBoot(Start at boot, Action)

Use in user-defined functions
-

Parameters

Start at boot
The tag that contains the value.

Action
Determines whether the display is updated: 

0 (SwitchOff) = Off: LED display is gray. WinAC MP is not started on startup of the HMI device.

1 (SwitchOn) = On: LED display has the color "cyan". WinAC MP is started automatically on 
startup of the HMI device. 
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Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateKeySwitchSetting

Description
Updates the status display of the position of the mode selector switch.     

Use in the function list
WinACMPUpdateKeySwitchSetting (Key switch, Action)

Use in user-defined functions
-

Parameters

Key switch
The tag that contains the value of the key switch:

0 (MRES) = MRES: PLC memory reset

1 (STOP) = STOP: STOP mode

3 (RUN) = RUN: RUN mode

Action
Determines whether the status display will be updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3753



Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateBUSF1LED

Description
Updates the status display of the BUSF1 LED tag.     

Use in the function list
WinACMPUpdateBUSF1LED(BUSF1, Update)

Use in user-defined functions
-

Parameters

BUSF1
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the BUSF1 LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:
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● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateBUSF2LED

Description
Updates the status display of the BUSF2 LED tag.       

Use in the function list
WinACMPUpdateBUSF2LED(BUSF2, Update)

Use in user-defined functions
-

Parameters

BUSF2
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the BUSF2 LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:
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● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateAverageExecTime

Description
Updates the display of the average OB 1 execution time. The OB 1 execution time will be 
displayed in milliseconds.     

Use in the function list
WinACMPUpdateAverageExecTime(Cycle time, Update)

Use in user-defined functions
-

Parameters

Cycle time
Tag that contains the value of the average OB 1 execution time.

Update
Determines whether the display is updated: 

0 (SwitchOff) = Off: Display is not updated.

1 (SwitchOn) = On: Display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".
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● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateAverageCycleTime

Description
Updates the display of the average cycle time. The cycle time is displayed in milliseconds.     

Use in the function list
WinACMPUpdateAverageCycleTime(Cycle time, Action)

Use in user-defined functions
-

Parameters

Cycle time
The tag that contains the value of the average cycle time.

Update
Determines whether the display is updated: 

0 (SwitchOff) = Off: Display is not updated.

1 (SwitchOn) = On: Display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.
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WinACMPUpdateEXTFLED

Description
Updates the status display of the EXTF LED tag.       

Use in the function list
WinACMPUpdateEXTFLED(EXTF, Update)

Use in user-defined functions
-

Parameters

EXTF
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the EXTF LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.
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WinACMPUpdateHMIEnableTime

Description
Updates the value of the HMI Execution Time from WinAC MP (in ms).     

Use in the function list
WinACMPUpdateHMIEnableTime(Enable Time, Update)

Use in user-defined functions
-

Parameters

HMI Enable time
The tag that contains the value of the HMI Enable Time.

Action
Determines whether the value is updated: 

0 (SwitchOff) = Off: Value is not updated.

1 (SwitchOn) = On: Value is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateINTFLED

Description
Updates the status display of the INTF LED tag.     
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Use in the function list
WinACMPUpdateINTFLED(INTF, Update)

Use in user-defined functions
-

Parameters

INTF
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the INTF LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateLastCycleTime

Description
Updates the display of the last cycle time. The cycle time is displayed in milliseconds.     
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Use in the function list
WinACMPUpdateLastCycleTime (Cycle time , Update)

Use in user-defined functions
-

Parameters

Cycle time
The tag that contains the value of the last cycle time.

Update
Determines whether the display is updated: 

0 (SwitchOff) = Off: Display is not updated.

1 (SwitchOn) = On: Display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateMaximumCycleTime

Description
Updates the display of the longest cycle time. The cycle time is displayed in milliseconds.     

Use in the function list
WinACMPUpdateMaximumCycleTime(Cycle time, Update)

Use in user-defined functions
-
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Parameters

Cycle time
The tag that contains the value of the longest cycle time.

Update
Determines whether the display is updated: 

0 (SwitchOff) = Off: Display is not updated.

1 (SwitchOn) = On: Display is updated. 

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

 

WinACMPUpdateMinimumCycleTime

Description
Updates the display of the shortest cycle time. The cycle time is displayed in milliseconds.     

Use in the function list
WinACMPUpdateMinimumCycleTime (Cycle Time, Update)

Use in user-defined functions
-

Parameters

Cycle time
The tag that contains the value of the shortest cycle time.
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Update
Determines whether the display is updated: 

0 (SwitchOff) = Off: The display is not updated.

1 (SwitchOn) = On: The display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdatePowerLED

Description
Updates the status display ON/OFF of the Power LED tag.     

Use in the function list
WinACMPUpdatePowerLED (Power, Update)

Use in user-defined functions
-

Parameters

Power
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On
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Update
Determines whether the status display ON/OFF is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateSleepTime

Description
Updates the value of the HMI Execution Time from WinAC MP (in ms).     

Use in the function list
WinACMPUpdateSleepTime(SleepTime, Update)

Use in user-defined functions
-

Parameters

SleepTime
The tag that contains the value.

Update
Determines whether the value is updated: 

0 (SwitchOff) = Off: Value is not updated.

1 (SwitchOn) = On: Value is updated.
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Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateRUNLED

Description
Updates the status display of the RUN LED tag.     

Use in the function list
WinACMPUpdateRUNLED(RUN, Update)

Use in user-defined functions
-

Parameters

RUN
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the RUN LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.
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Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateSTOPLED

Description
Updates the status display of the STOP LED tag.     

Use in the function list
UpdateSTOPLEDtag (STOP, Update)

Use in user-defined functions
-

Parameters

STOP
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the STOP LED tag is updated:

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.
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Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPArchive

Description
Saves the current STEP 7 user program, the current system configuration and the current 
values of the DBs in a log file.     

Use in the function list
WinACMPArchive (File name)

Use in user-defined functions
-

Parameters

File name
Name of the log file in which the data is saved. Enter the file location and the file extension 
(*.wld), for example, "\flash\AddOn\WinACMP\Default.wld ".

WinACMPGetStartCharacteristics

Description
Reads in the 'desired' operating state after startup of the HMI device of WinAC MP.     

Use in the function list
WinACMPGetStartCharacteristics (Operating state, Update)
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Use in user-defined functions
-

Parameters

Operating state
The tag that defines the value of the operating mode.

Update
Determines whether the operating mode is read out: 

0 (SwitchOff) = Off: Operating mode is not read out.

1 (SwitchOn) = On: Operating mode is read out.

WinACMPGetVersion

Description
Reads out the value of the version number of WinAC MP.       

Use in the function list
WinACMPGetVersion (Version, Action)

Use in user-defined functions
WinACMPGetVersion (Version, Action)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

Version
The tag that contains the value.

Action
Determines whether the version number is read out: 

0 (SwitchOff) = Off: Version number is not read out.

1 (SwitchOn) = On: Version number is read out.
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WinACMPClearCycleTimeBuffer

Description
Clears the cycle time data of the histogram.     

Use in the function list
WinACMPClearCycleTimeBuffer

Use in user-defined functions
-

Parameters
--

WinACMPSetStartAtBoot

Description
Determines whether or not WinAC MP is started automatically after startup of the HMI 
device.       

Use in the function list
WinACMPSetStart at boot(Start at boot)

Use in user-defined functions
WinACMPSetStartAtBoot (Start at boot)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

StartAtBoot
Defines whether WinAC MP is started automatically. 

0 (StartAtBootOff) = Off: WinAC MP is not started on startup of the HMI device.

1 (StartAtBootOn) = On: WinAC MP is started automatically on startup of the HMI device.
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WinACMPSetKeySwitch

Description
Sets the mode selector switch to RUN or STOP and is also used for memory reset.     

Use in the function list
WinACMPSetKeySwitch(Key switch)

Use in user-defined functions
-

Parameters

Key switch
Defines the position of the key switch:

0 (MRES) = MRES: PLC memory reset

1 (STOP) = STOP: STOP mode

3 (RUN) = RUN: RUN mode

WinACMPSetHMIExecutionTime

Description
Sets the value of the HMI Execution Time of WinAC MP.     

Use in the function list
WinACMPSetHMIExecutionTime (Execution Time)

Use in user-defined functions
-

Parameters

Execution time
The tag that contains the value.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3770 System Manual, 07/2013,  



WinACMPSetRestartMethod

Description
Sets the restart method, either cold restart (CRST) or warm restart (WRST).     

Use in the function list
WinACMPSetRestartMethod (Action)

Use in user-defined functions
-

Parameters

RestartAction
Defines the restart action:

0 (WarmRestart) = Warm restart: A warm restart is performed.

1 (ColdRestart) = Cold restart: A cold restart is performed.

WinACMPSetSleepTime

Description
Sets the value of the HMI Execution Time of WinAC MP.     

Use in the function list
WinACMPSetSleeptime (SleepTime)

Use in user-defined functions
-

Parameters

Sleep time
The tag that contains the value. 
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WinACMPSetStartMode

Description
Sets the operating mode of WinAC MP after startup of the HMI device.       

Use in the function list
WinACSetStartMode (Autostart)

Use in user-defined functions
WinACSetStartMode (Autostart)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

Action
Defines whether the Autostart function of WinAC MP is activated. 

0 (AutoStartOff) = Off: After startup, WinAC MP remains in the STOP operating mode.

1 (AutoStartOn) = On: After startup, WinAC MP changes to the operating mode it was in before 
it was closed.

WinACMPStartHistogram

Description
Starts the cyclic sending of histogram values and updates the display. The histogram shows 
the percentual distribution of the measured cycle times.     

Use in the function list
WinACMPStartHistogram (Update, Percentage, Cycle time, Y axis, ID)

Use in user-defined functions
-

Parameters

Update
Defines whether WinAC returns histogram values:
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0 (SwitchOff) = Off: The cyclic sending of the histogram values is not started. The display is 
not updated.

1 (SwitchOn) = On: The cyclic sending of the histogram values is started. The display is 
updated. 

Percentage
Percentage of the cycles which are performed during the recorded cycle times.

Cycle time
Histogram of cycle times.

Y axis 
Maximum value of Y axis

ID
Histogram ID

WinACMPControl

Description
Starts or stops WinAC MP.     

Use in the function list
WinACMPControl (WinAC)

Use in user-defined functions
-

Parameters

WinAC
Determines whether WinAC MP is started or stopped. 

0 (ShutdownWinACMP) = Stop: WinAC MP is stopped. 

1 (StartWinACMP) = Start: WinAC MP is started.

WinACMPStopHistogram

Description
Stops the cyclic sending of histogram data and deletes the history data.     
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Use in the function list
WinACMPStopHistogram (ID)

Use in user-defined functions
-

Parameters

ID
Histogram ID

WinACMPRestore

Description
Loads the STEP 7 user program, the system configuration and the DBs from a log file.     

Use in the function list
WinACMPRestore (File name)

Use in user-defined functions
-

Parameters

File name
Name of the log file in which the data is saved. Enter the file location and the log file, for 
example, ""\flash\AddOn\WinACMP\Default.wld ".

10.8.7.2 Events

Overview

Editors

Introduction
The following table shows which events occur in which editor.

Technical data subject to change.
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Icon Editor
Screens
HMI alarms
HMI tags
Scheduler

  
1 Cleared (Page 3786) X -- -- --
2 Activate (Page 3787) -- -- -- --
3 Change (Page 3787) -- -- -- --
4 Loaded (Page 3787) X -- -- --
5 Execute (Page 3788) -- -- -- X
6 Selection changed  (Page 3788) -- -- -- --
7 In the event of high limit violation (Page 3788) -- -- X --
8 In the event of low limit violation (Page 3788) -- -- X --
9 When dialog is opened (Page 3789) -- -- -- X
10 When dialog is closed (Page 3789) -- -- -- X
11 User change (Page 3789) -- -- -- X
12 Screen change (Page 3789) -- -- -- X
13 Deactivate (Page 3790) -- -- -- X
14 Double-click (Page 3790) -- -- -- --
15 Press (Page 3791) -- -- -- --
16 On Finish Input (Page 3791) -- -- -- --
17 Press ESC twice (Page 3791) -- -- -- --
18 Outgoing (Page 3792) -- X -- --
19 Incoming (Page 3792) -- X -- --
20 Click (Page 3792) -- -- -- --
21 Click when flashing (Page 3793) -- -- -- --
22 Loop-in alarm (Page 3793) -- X -- --
23 Release (Page 3793) -- -- -- --
24 Alarm buffer overflow (Page 3794) -- -- -- X
25 Acknowledge (Page 3794) -- X -- --
26 Reach margin (Page 3794) -- -- -- --
27 Runtime Stop (Page 3795) -- -- -- X
28 Press key (Page 3795) -- -- -- --
29 Release key (Page 3795) -- -- -- --
30 Overflow (Page 3796) -- -- -- --
31 Switch OFF (Page 3796) -- -- -- --
32 Switch ON (Page 3796) -- -- -- --
33 Low free storage space (Page 3797) -- -- -- --
34 Free space critically low (Page 3797) -- -- -- --
35 Value change (Page 3797) -- -- X --
36 Time expired (Page 3797) -- -- -- --
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Basic objects

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Line
Ellipse
Circle
Rectangle
Text field
Graphic view

 

 

  
1 Cleared (Page 3786) -- -- -- -- -- --
2 Activate (Page 3787) -- -- -- -- -- --
3 Change (Page 3787) -- -- -- -- -- --
4 Loaded (Page 3787) -- -- -- -- -- --
5 Execute (Page 3788) -- -- -- -- -- --
6 Selection changed  (Page 3788) -- -- -- -- -- --
7 In the event of high limit violation (Page 3788) -- -- -- -- -- --
8 In the event of low limit violation (Page 3788) -- -- -- -- -- --
9 When dialog is opened (Page 3789) -- -- -- -- -- --
10 When dialog is closed (Page 3789) -- -- -- -- -- --
11 User change (Page 3789) -- -- -- -- -- --
12 Screen change (Page 3789) -- -- -- -- -- --
13 Deactivate (Page 3790) -- -- -- -- -- --
14 Double-click (Page 3790) -- -- -- -- -- --
15 Press (Page 3791) -- -- -- -- -- --
16 On Finish Input (Page 3791) -- -- -- -- -- --
17 Press ESC twice (Page 3791) -- -- -- -- -- --
18 Outgoing (Page 3792) -- -- -- -- -- --
19 Incoming (Page 3792) -- -- -- -- -- --
20 Click (Page 3792) -- -- -- -- -- --
21 Click when flashing (Page 3793) -- -- -- -- -- --
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22 Loop-in alarm (Page 3793) -- -- -- -- -- --
23 Release (Page 3793) -- -- -- -- -- --
24 Alarm buffer overflow (Page 3794) -- -- -- -- -- --
25 Acknowledge (Page 3794) -- -- -- -- -- --
26 Reach margin (Page 3794) -- -- -- -- -- --
27 Runtime Stop (Page 3795) -- -- -- -- -- --
28 Press key (Page 3795) -- -- -- -- -- --
29 Release key (Page 3795) -- -- -- -- -- --
30 Overflow (Page 3796) -- -- -- -- -- --
31 Switch OFF (Page 3796) -- -- -- -- -- --
32 Switch ON (Page 3796) -- -- -- -- -- --
33 Low free storage space (Page 3797) -- -- -- -- -- --
34 Free space critically low (Page 3797) -- -- -- -- -- --
35 Value change (Page 3797) -- -- -- -- -- --
36 Time expired (Page 3797) -- -- -- -- -- --

Elements

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
IO field
Button
Symbolic IO field
Graphic IO field
Date/time field
Bar
Switch

  
1 Cleared (Page 3786) -- -- -- -- -- -- --
2 Activate (Page 3787) X X X X -- -- X
3 Change (Page 3787) -- X X -- -- -- X
4 Loaded (Page 3787) -- -- -- -- -- -- --
5 Execute (Page 3788) -- -- -- -- -- -- --
6 Selection changed  (Page 3788) -- -- -- -- -- -- --
7 In the event of high limit violation (Page 3788) -- -- -- -- -- -- --
8 In the event of low limit violation (Page 3788) -- -- -- -- -- -- --

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3777



  
9 When dialog is opened (Page 3789) -- -- -- -- -- -- --
10 When dialog is closed (Page 3789) -- -- -- -- -- -- --
11 User change (Page 3789) -- -- -- -- -- -- --
12 Screen change (Page 3789) -- -- -- -- -- -- --
13 Deactivate (Page 3790) X X X X -- -- X
14 Double-click (Page 3790) -- -- -- -- -- -- --
15 Press (Page 3791) -- X -- -- -- -- --
16 On Finish Input (Page 3791) -- -- -- -- -- -- --
17 Press ESC twice (Page 3791) -- -- -- -- -- -- --
18 Outgoing (Page 3792) -- -- -- -- -- -- --
19 Incoming (Page 3792) -- -- -- -- -- -- --
20 Click (Page 3792) -- X -- -- -- -- --
21 Click when flashing (Page 3793) -- -- -- -- -- -- --
22 Loop-in alarm (Page 3793) -- -- -- -- -- -- --
23 Release (Page 3793) -- X -- -- -- -- --
24 Alarm buffer overflow (Page 3794) -- -- -- -- -- -- --
25 Acknowledge (Page 3794) -- -- -- -- -- -- --
26 Reach margin (Page 3794) -- -- -- -- -- -- --
27 Runtime Stop (Page 3795) -- -- -- -- -- -- --
28 Press key (Page 3795) -- -- -- -- -- -- --
29 Release key (Page 3795) -- -- -- -- -- -- --
30 Overflow (Page 3796) -- -- -- -- -- -- --
31 Switch OFF (Page 3796) -- -- -- -- -- -- X
32 Switch ON (Page 3796) -- -- -- -- -- -- X
33 Low free storage space (Page 3797) -- -- -- -- -- -- --
34 Free space critically low (Page 3797) -- -- -- -- -- -- --
35 Value change (Page 3797) -- -- -- -- -- -- --
36 Time expired (Page 3797) -- -- -- -- -- -- --

Controls

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Alarm view/alarm window
Alarm indicator
Trend view
User view
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Icon Object
Recipe view
Auxiliary indicator

 

  
1 Cleared (Page 3786) -- -- -- -- -- --
2 Activate (Page 3787) X -- X X -- --
3 Change (Page 3787) -- -- -- -- -- --
4 Loaded (Page 3787) -- -- -- -- -- --
5 Execute (Page 3788) -- -- -- -- -- --
6 Selection changed  (Page 3788) -- -- -- -- -- --
7 In the event of high limit violation (Page 3788) -- -- -- -- -- --
8 In the event of low limit violation (Page 3788) -- -- -- -- -- --
9 When dialog is opened (Page 3789) -- -- -- -- -- --
10 When dialog is closed (Page 3789) -- -- -- -- -- --
11 User change (Page 3789) -- -- -- -- -- --
12 Screen change (Page 3789) -- -- -- -- -- --
13 Deactivate (Page 3790) X -- X X -- --
14 Double-click (Page 3790) -- -- -- -- -- --
15 Press (Page 3791) -- -- -- -- -- --
16 On Finish Input (Page 3791) -- -- -- -- -- --
17 Press ESC twice (Page 3791) -- -- -- -- -- --
18 Outgoing (Page 3792) -- -- -- -- -- --
19 Incoming (Page 3792)       
20 Click (Page 3792) -- X -- -- -- --
21 Click when flashing (Page 3793) -- X -- -- -- --
22 Loop-in alarm (Page 3793) -- -- -- -- -- --
23 Release (Page 3793) -- -- -- -- -- --
24 Alarm buffer overflow (Page 3794) -- -- -- -- -- --
25 Acknowledge (Page 3794) -- -- -- -- -- --
26 Reach margin (Page 3794) -- -- -- -- -- --
27 Runtime Stop (Page 3795) -- -- -- -- -- --
28 Press key (Page 3795) -- -- -- -- -- --
29 Release key (Page 3795) -- -- -- -- -- --
30 Overflow (Page 3796) -- -- -- -- -- --
31 Switch OFF (Page 3796) -- -- -- -- -- --
32 Switch ON (Page 3796) -- -- -- -- -- --
33 Low free storage space (Page 3797) -- -- -- -- -- --
34 Free space critically low (Page 3797) -- -- -- -- -- --
35 Value change (Page 3797) -- -- -- -- -- --
36 Time expired (Page 3797) -- -- -- -- -- --
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Overview

Editors

Introduction
The following table shows which events occur in which editor.

Technical data subject to change.

Icon Editor
Screens
HMI alarms
HMI tags
Logs
Scheduler
Audit Trail

  
1 Cleared (Page 3786) X -- -- -- -- --
2 Activate (Page 3787) -- -- -- -- -- --
3 Change (Page 3787) -- -- -- -- -- --
4 Loaded (Page 3787) X -- -- -- -- --
5 Execute (Page 3788) -- -- -- -- X --
6 Selection changed  (Page 3788) -- -- -- -- -- --
7 In the event of high limit violation (Page 3788) -- -- X -- -- --
8 In the event of low limit violation (Page 3788) -- -- X -- -- --
9 When dialog is opened (Page 3789) -- -- -- -- X --
10 When dialog is closed (Page 3789) -- -- -- -- X --
11 User change (Page 3789) -- -- -- -- X --
12 Screen change (Page 3789) -- -- -- -- X --
13 Deactivate (Page 3790) -- -- -- -- -- --
14 Double-click (Page 3790) -- -- -- -- -- --
15 Press (Page 3791) -- -- -- -- -- --
16 On Finish Input (Page 3791) -- -- -- -- -- --
17 Press ESC twice (Page 3791) -- -- -- -- -- --
18 Incoming (Page 3792) -- X -- -- -- --
19 Outgoing (Page 3792) -- X -- -- -- --
20 Click (Page 3792) -- -- -- -- -- --
21 Click when flashing (Page 3793) -- -- -- -- -- --
22 Loop-in alarm (Page 3793) -- X -- -- -- --
23 Release (Page 3793) -- -- -- -- -- --
24 Alarm buffer overflow (Page 3794) -- -- -- -- X --
25 Acknowledge (Page 3794) -- X -- -- -- --
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26 Reach margin (Page 3794) -- -- -- -- -- --
27 Runtime Stop (Page 3795) -- -- -- -- X --
28 Press key (Page 3795) -- -- -- -- -- --
29 Release key (Page 3795) -- -- -- -- -- --
30 Overflow (Page 3796) -- -- -- X -- --
31 Switching (Page 3796) -- -- -- -- -- --
32 Switch OFF (Page 3796) -- -- -- -- -- --
33 Switch ON (Page 3796) -- -- -- -- -- --
34 Low free storage space (Page 3797) -- -- -- X -- X
35 Free space critically low (Page 3797) -- -- -- X -- X
36 Value change (Page 3797) -- -- X -- -- --
37 Time expired (Page 3797) -- -- -- -- -- --

Basic objects

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Line
Polyline
Polygon
Ellipse
Circle
Rectangle
Text field
Graphic view

 

 

  
1 Cleared (Page 3786) -- -- -- -- -- -- -- --
2 Activate (Page 3787) -- -- -- -- -- -- -- --
3 Change (Page 3787) -- -- -- -- -- -- -- --
4 Loaded (Page 3787) -- -- -- -- -- -- -- --
5 Execute (Page 3788) -- -- -- -- -- -- -- --
6 Selection changed  (Page 3788) -- -- -- -- -- -- -- --
7 In the event of high limit violation (Page 3788) -- -- -- -- -- -- -- --
8 In the event of low limit violation (Page 3788) -- -- -- -- -- -- -- --
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9 When dialog is opened (Page 3789) -- -- -- -- -- -- -- --
10 When dialog is closed (Page 3789) -- -- -- -- -- -- -- --
11 User change (Page 3789) -- -- -- -- -- -- -- --
12 Screen change (Page 3789) -- -- -- -- -- -- -- --
13 Deactivate (Page 3790) -- -- -- -- -- -- -- --
14 Double-click (Page 3790) -- -- -- -- -- -- -- --
15 Press (Page 3791) -- -- -- -- -- -- -- --
16 On Finish Input (Page 3791) -- -- -- -- -- -- -- --
17 Press ESC twice (Page 3791) -- -- -- -- -- -- -- --
18 Outgoing (Page 3792) -- -- -- -- -- -- -- --
19 Incoming (Page 3792) -- -- -- -- -- -- -- --
20 Click (Page 3792) -- -- -- -- -- -- -- --
21 Click when flashing (Page 3793) -- -- -- -- -- -- -- --
22 Loop-in alarm (Page 3793) -- -- -- -- -- -- -- --
23 Release (Page 3793) -- -- -- -- -- -- -- --
24 Alarm buffer overflow (Page 3794) -- -- -- -- -- -- -- --
25 Acknowledge (Page 3794) -- -- -- -- -- -- -- --
26 Reach margin (Page 3794) -- -- -- -- -- -- -- --
27 Runtime Stop (Page 3795) -- -- -- -- -- -- -- --
28 Press key (Page 3795) -- -- -- -- -- -- -- --
29 Release key (Page 3795) -- -- -- -- -- -- -- --
30 Overflow (Page 3796) -- -- -- -- -- -- -- --
31 Switching (Page 3796) -- -- -- -- -- -- -- --
32 Switch OFF (Page 3796) -- -- -- -- -- -- -- --
33 Switch ON (Page 3796) -- -- -- -- -- -- -- --
34 Low free storage space (Page 3797) -- -- -- -- -- -- -- --
35 Free space critically low (Page 3797) -- -- -- -- -- -- -- --
36 Value change (Page 3797) -- -- -- -- -- -- -- --
37 Time expired (Page 3797) -- -- -- -- -- -- -- --

Elements

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
IO field
Button
Symbolic IO field
Graphic IO field
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Icon Object
Date/time field
Bar
Switch
Symbol library
Slider
Gauge
Clock

  
1 Cleared (Page 3786) -- -- -- -- -- -- -- -- -- -- --
2 Activate (Page 3787) X X X X -- -- X X X -- --
3 Change (Page 3787) -- X X -- -- -- X -- X X --
4 Loaded (Page 3787) -- -- -- -- -- -- -- -- -- -- --
5 Execute (Page 3788) -- -- -- -- -- -- -- -- -- -- --
6 Selection changed  (Page 3788) -- -- -- -- -- -- -- -- -- -- --
7 In the event of high limit violation 

(Page 3788) 
-- -- -- -- -- -- -- -- -- -- --

8 In the event of low limit violation 
(Page 3788) 

-- -- -- -- -- -- -- -- -- -- --

9 When dialog is opened (Page 3789) -- -- -- -- -- -- -- -- -- -- --
10 When dialog is closed (Page 3789) -- -- -- -- -- -- -- -- -- -- --
11 User change (Page 3789) -- -- -- -- -- -- -- -- -- -- --
12 Screen change (Page 3789) -- -- -- -- -- -- -- -- -- -- --
13 Deactivate (Page 3790) X X X X -- -- X X X -- --
14 Double-click (Page 3790) -- -- -- -- -- -- -- X -- -- --
15 Press (Page 3791) -- X -- -- -- -- -- X -- -- --
16 On Finish Input (Page 3791) X  X X -- -- -- -- -- -- --
17 Press ESC twice (Page 3791) -- -- -- -- -- -- -- -- -- -- --
18 Outgoing (Page 3792) -- -- -- -- -- -- -- -- -- -- --
19 Incoming (Page 3792) -- -- -- -- -- -- -- -- -- -- --
20 Click (Page 3792) -- X -- -- -- -- -- X -- -- --
21 Click when flashing (Page 3793) -- -- -- -- -- -- -- -- -- -- --
22 Loop-in alarm (Page 3793) -- -- -- -- -- -- -- -- -- -- --
23 Release (Page 3793) -- X -- -- -- -- -- X -- -- --
24 Alarm buffer overflow (Page 3794) -- -- -- -- -- -- -- -- -- -- --
25 Acknowledge (Page 3794) -- -- -- -- -- -- -- -- -- -- --
26 Reach margin (Page 3794) -- -- -- -- -- -- -- -- -- -- --
27 Runtime Stop (Page 3795) -- -- -- -- -- -- -- -- -- -- --
28 Press key (Page 3795) -- -- -- -- -- -- -- -- -- -- --
29 Release key (Page 3795) -- -- -- -- -- -- -- -- -- -- --
30 Overflow (Page 3796) -- -- -- -- -- -- -- -- -- -- --
31 Switching (Page 3796) -- -- -- -- -- -- -- -- -- -- --
32 Switch OFF (Page 3796) -- -- -- -- -- -- X -- -- -- --
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33 Switch ON (Page 3796) -- -- -- -- -- -- X -- -- -- --
34 Low free storage space (Page 3797) -- -- -- -- -- -- -- -- -- -- X
35 Free space critically low (Page 3797) -- -- -- -- -- -- -- -- -- -- X
36 Value change (Page 3797) -- -- -- -- -- -- -- -- -- -- --
37 Time expired (Page 3797) -- -- -- -- -- -- -- -- -- -- --

Controls

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Alarm view/alarm window
Alarm indicator
Trend view
User view
HTML browser
Status/Force
Sm@rtClient view
Recipe view
f(x) trend view
System diagnostics view / system diagnostics window
Function key

 

  
1 Cleared (Page 3786) -- -- -- -- -- -- -- -- -- -- --
2 Activate (Page 3787) X -- X X X X X X -- X --
3 Change (Page 3787) -- -- -- -- -- -- -- -- -- -- --
4 Loaded (Page 3787) -- -- -- -- -- -- -- -- -- -- --
5 Execute (Page 3788) -- -- -- -- -- -- -- -- -- -- --
6 Selection changed  (Page 3788) X -- -- -- -- -- -- -- -- -- --
7 In the event of high limit violation 

(Page 3788) 
-- -- -- -- -- -- -- -- -- -- --

8 In the event of low limit violation 
(Page 3788) 

-- -- -- -- -- -- -- -- -- -- --

9 When dialog is opened (Page 3789) -- -- -- -- -- -- -- -- -- -- --
10 When dialog is closed (Page 3789) -- -- -- -- -- -- -- -- -- -- --
11 User change (Page 3789) -- -- -- -- -- -- -- -- -- -- --
12 Screen change (Page 3789) -- -- -- -- -- -- -- -- -- -- --
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13 Deactivate (Page 3790) X -- X X X X X X -- -- --
14 Double-click (Page 3790) -- -- -- -- -- -- -- -- -- -- --
15 Press (Page 3791) -- -- -- -- -- -- -- -- -- -- --
16 On Finish Input (Page 3791) -- -- -- -- -- -- -- --  -- --
17 Press ESC twice (Page 3791) -- -- -- -- -- -- -- -- -- -- --
18 Outgoing (Page 3792) -- -- -- -- -- -- -- -- -- -- --
19 Incoming (Page 3792) -- -- -- -- -- -- -- -- -- -- --
20 Click (Page 3792) -- X -- -- -- -- -- -- -- -- --
21 Click when flashing (Page 3793) -- X -- -- -- -- -- -- -- -- --
22 Loop-in alarm (Page 3793) -- -- -- -- -- -- -- -- -- -- --
23 Release (Page 3793) -- -- -- -- -- -- -- -- -- -- --
24 Alarm buffer overflow (Page 3794) -- -- -- -- -- -- -- -- -- -- --
25 Acknowledge (Page 3794) -- -- -- -- -- -- -- -- -- -- --
26 Reach margin (Page 3794) -- -- -- -- -- -- -- -- -- -- --
27 Runtime Stop (Page 3795) -- -- -- -- -- -- -- -- -- -- --
28 Press key (Page 3795) -- -- -- -- -- -- -- -- -- -- X
29 Release key (Page 3795) -- -- -- -- -- -- -- -- -- -- X
30 Overflow (Page 3796) -- -- -- -- -- -- -- -- -- -- --
31 Switching (Page 3796) -- -- -- -- -- -- -- -- -- -- --
32 Switch OFF (Page 3796) -- -- -- -- -- -- -- -- -- -- --
33 Switch ON (Page 3796) -- -- -- -- -- -- -- -- -- -- --
34 Low free storage space (Page 3797) -- -- -- -- -- -- -- -- -- -- --
35 Free space critically low (Page 3797) -- -- -- -- -- -- -- -- -- -- --
36 Value change (Page 3797) -- -- -- -- -- -- -- -- -- -- --
37 Time expired (Page 3797) -- -- -- -- -- -- -- -- -- -- --

Events

Cleared

Description
Occurs when the active screen on the HMI device is cleared.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Activate

Description
Occurs when the user selects a display or operating object using the configured tab 
sequence.     

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 Note

If the user e.g. clicks a button with the mouse, the "Click" event is triggered. Users wishing 
to trigger the "Enable" event must select the button using the tab key.

 

The "Enable" event is only used to detect whether an object was selected. The event does not 
trigger a password prompt.

For this reason, do not use the "Enable" event if you want to configure access protection on 
the function call of the object.

Change

Description
Occurs if the status of a display and operator control object changes. 

The status of an object changes if, for example, the user presses the key. 
 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

Loaded

Description
Occurs when all configured display and operating objects are loaded in the active screen after 
a screen change. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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 Note

Enable a screen change to ensure that the connection with the control is established after 
switch-on. 

 

Execute

Description
Occurs when the scheduled task has been executed.   

Selection changed 

Description
Occurs when the user changes the selection. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

In the event of high limit violation

Description
Occurs when the high limit of a tag is exceeded.   

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

In the event of low limit violation

Description
Occurs when the low limit of a tag is undershot.   

 

 Note

Note that the availability of the event depends on the HMI device and object type.
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When dialog is opened

Description
The event is triggered when a modal dialog opens.  

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

 

When dialog is closed

Description
The event is triggered when a modal dialog closes.  

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

User change

Description
Occurs when a user logs off at an HMI device or another user logs on at the HMI device. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Screen change

Description
Occurs when all configured display and operating objects are loaded in the screen after a 
screen change. 
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Use the "Loaded" event if you want to perform other system functions during a screen change 
to a certain screen. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Deactivate

Description
Occurs when the user takes the focus from a display and operating object.   

A screen object can be disabled using the configured tab order or by performing another action 
with the mouse.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

System functions or user-defined functions on the "Deactivate" event of a screen are not 
executed when a screen is being closed.

 

The "Deactivate" event is only used to detect whether an object was deselected. The event 
does not trigger a password prompt.

For this reason, do not use the "Deactivate" event if you want to configure access protection 
on the function call of the object.

Double-click

Description
Occurs when the user double-clicks on an object from the symbol library. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Press

Description
Occurs when the user clicks on a button with the left mouse button, presses <RETURN> or 
<SPACE>. 

Also occurs when the user right-clicks on an object of the symbol library.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

On Finish Input

Description
Triggered when you confirm input at an I/O field by pressing ENTER, or by mouse click, or by 
touch screen operation. 

The "On Finish Input" event is also started if the value of a tag does not change, for example, 
if a value is exceeded, or if a user cancels the dialog to acknowledge a tag (Audit option 
package) that has to be acknowledged.

The event is not triggered, on the other hand, by user logon or by input fields configured with 
an authorization.

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

Press ESC twice

Description
Occurs when the user presses the <ESC> key twice at the HMI device. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
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Outgoing

Description
Occurs when an alarm is deactivated. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

Incoming

Description
Occurs when an alarm is triggered and displayed in the alarm view. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

Click

Description
Occurs if the user clicks a display and operating object with the mouse or touches the touch 
display with a finger. 

In case you click the incorrect object, prevent processing of configured function list as follows:

● Move the mouse pointer away from the object while keeping the mouse button pressed. 
Release the mouse button as soon as the mouse pointer leaves the object. The function 
list will then not be processed.

● On touch displays, the display must be touched with the finger until a reaction occurs, e.g., 
a screen change.

 

  Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Click when flashing

Description
Occurs when the user clicks a flashing alarm indicator with the mouse or touches it with a 
finger. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

Loop-in alarm

Description
Occurs as soon as the user selects an alarm in the alarm view and then clicks on the "Loop-
In-Alarm" button or double clicks on the alarm.   

For the "Loop-In-Alarm" event, you configure system functions, such as a change to the screen 
in which the alarm occurred.

You cannot configure local scripts for the "Loop-In-Alarm" event in Runtime Professional.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Release

Description
Occurs when the user releases a button. 

This even does not occur, as long as the button remains pressed.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Alarm buffer overflow

Description
Occurs when the configured size of the alarm buffer is reached. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Acknowledge

Description
Occurs when the user acknowledges an alarm. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Reach margin

Description
Occurs when the user reaches the beginning or the end of a scrollable area.   

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 Note

A user-defined function must not be configured for the "Boundary reached" event.
 

Configurable objects
The event can only be configured on the <Up> and <Down> keys, or on the keys on which 
you have configured the "ScreenObjectPageUp" or "ScreenObjectPageDown" system 
functions.
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Runtime Stop

Description
Occurs when the user exits the Runtime software on the HMI device. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

A user-defined function must not be configured for the "Runtime stop" event.
 

 

Press key

Description
Occurs when the user presses a function key. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Release key

Description
Occurs when the user releases a function key. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
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Overflow

Description
Occurs when the configured size of the log is reached. You use the log type "Trigger event". 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Switching

Description
Occurs when the user toggles a display and operating object, e.g. a switch from "ON" to "OFF". 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Switch OFF

Description
Occurs when the user moves the display and operating object "Switch" to the OFF position. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

Switch ON

Description
Occurs when the user moves the display and operating object "Switch" to the ON position. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
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Low free storage space

Description
This event is triggered if the storage space available on the medium to which the Audit Trail 
is less than the configured minimum. 

 

Free space critically low

Description
This event is triggered if the storage medium to which an Audit Trail is saved provides 
insufficient storage space due to hardware restrictions. 

 

Value change

Description
Occurs when the value of an object or the value of an array element changes. 

The value change of a tag is triggered by the PLC or by the user, e.g. when a new value is 
entered. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Time expired

Description
Occurs when the time configured in the scheduler expires. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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10.8.7.3 VB scripts

System functions

AcknowledgeAlarm

Description
Acknowledges all selected alarms.       

This system function is used when the HMI device does not have an ACK key or when the 
integrated key of the alarm view should not be used.

This system function can only be used for function keys.

Use in the function list
AcknowledgeAlarm

Use in user-defined functions
AcknowledgeAlarm

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ActivatePreviousScreen

Description
Performs a screen change to the screen which was activated before the current screen. The 
screen change is not performed if no screen was activated beforehand.       

The last 10 screens that were called up are saved. A system alarm is output when you change 
to a screen which is no longer saved.

 

 Note

If you want to use the system function, the screen to which you change has to be used in the 
navigation structure.

 

 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3797



Use in the function list
ActivatePreviousScreen

Use in user-defined functions
ActivatePreviousScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ActivateScreen

Description
Performs a screen change to the given screen.       

Use the "ActivateScreenByNumber" system function to change from the root screen to the 
permanent window or vice versa. 

Use in the function list
ActivateScreen (Screen name, Object number)

Use in user-defined functions
ActivateScreen (Screen_name, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen name
Name of the screen to which you change.

Object number
The operator control element which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:
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● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

 

  Note

If the "Reach margin" event is assigned to the "ActivateScreen" system function, only the 
value "0" is valid for the "Object number" parameter. The active object is not defined by 
the object number, but rather by the X position it had prior to the screen change.

 

Example
The ActivateScreen function is used in the following program code to activate the "Screen_2" 
screen when you click a button.

 
 
{
 
// User defined code 
// i.e. when pressing a button 
ActivateScreen ("Screen_2", 0);
...
}

ActivateScreenByNumber

Description
Performs a screen change to a screen depending on a tag value.       

The screen is identified by its screen number.

Use in the function list
ActivateScreenByNumber (Screen number, Object number)

Use in user-defined functions
ActivateScreenByNumber (Screen_number, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Screen number
Tag which contains the screen number of the destination screen.

When a change from the root screen to the permanent window is desired, "0" or "-1" is specified:

0 = Change from root screen to permanent window

-1 = Change from permanent window to root screen

Object number
The number of the screen object which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

ActivateSystemDiagnosticsView

Description
Activates the system diagnostics view. The system diagnostics view shows the detail view of 
the device concerned.       

Use in the function list
ActivateSystemDiagnosticsView (Screen name, Object name)

Use in user-defined functions
ActivateSystemDiagnosticsView (Screen_name, Object_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Screen name
Name of the screen contained in the system diagnostics view.

Object name
Object name of the system diagnostics view.
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ArchiveLogFile

Description
This system function moves or copies a log to another storage location for long-term logging. 

With Audit Trails, always use the "Move" (hmiMove)" mode, otherwise you will be violating the 
FDA guideline by duplicating the data stored.       

Prior to "ArchiveLogFile" always run the system function "CloseAllLogs".

After this system function, run the "OpenAllLogs" system function.

In "Copy log" mode, the logs are not reopened until the log has been successfully copied, or 
unless a timeout occurs during the copy process. In "Move log" mode, the logs to be moved 
are renamed and the new logs are opened immediately. To move the renamed logs, a job is 
submitted which attempts to move them every 300 seconds if the server cannot be reached. 
The job is also retained after Runtime is restarted until it is executed.

Use in the function list
ArchiveLogFile (Log type, Log, Directory name, Mode)

Use in user-defined functions
ArchiveLogFile (Log_type, Log, Directory_name, Mode) 

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (miAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail log available for GMP compliant projects. Additional 
information is available under "Activating GMP-compliant configuration".

Log
Name of the log being archived.

Directory name
Path for saving the log.

Mode
0 (hmiCopy) = Copy log

1 (hmiMove) = Move log
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Application example
You want to move a log file from a local storage medium to the server in order to generate a 
backup copy of this file at cyclic intervals.

Notes on configuring

Set up a task in the scheduler which is executed at a specific time on a daily basis. Configure 
the following function list for the task:

Procedure on HMI device

● All log files will be closed.

● The log file you specified is moved to the server.

● All closed log files will be opened again.

Back up RAM file system

Description
Backs up the RAM file system in the memory medium of the HMI device.       

After restarting the HMI device, the data is automatically reloaded in the RAM file system.

Applications such as the Internet Explorer save data (e.g. the last web sites called up) 
temporarily to the DRAM file system of the HMI device.

Use in the function list
BackupRAMFileSystem
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Use in user-defined functions
BackupRAMFileSystem

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

CalibrateTouchScreen

Description
Calls a program for calibrating the touch screen.       

During the calibration process, there is a prompt to touch five positions on the screen display. 
Touch the screen display within 30 seconds, to confirm the calibration process. If the calibration 
is not completed within this time span, the calibration settings are discarded. The user prompt 
is in English.

Use this system function the first time you start the HMI device.

Use in the function list
CalibrateTouchScreen

Use in user-defined functions
CalibrateTouchScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

 

 Note

The CalibrateTouchScreen system function cannot be simulated.
 

ChangeConnection

Description
Disconnects the connection to the currently used PLC in use and establishes a connection to 
a PLC with another address. The newly connected PLC must belong to the same device class 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3803



(S7-1200, S7-300, ...etc). With S7-1200, the use of the function is also only permitted for 
absolute addressing.

       
 

 Note

When changing to another address, ensure that the address is not already being used by 
another HMI device.

 

The follows address types are supported:

● IP address

● MPI address

The follows PLC types are supported:

● SIMATIC S7 300/400

● SIMATIC S7-NC

● SIMOTION

Use in the function list
ChangeConnection (Connection, Address, Slot, Rack)

Use in user-defined functions
ChangeConnection (Connection, Address, Slot, Rack)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Connection
Name of the connection that is disconnected. The name is set during configuration, for 
example, in the "Connections" editor.

Address
MPI/PROFIBUS or IP address of the PLC to which the connection will be established.

 

 Note

Set the address by means of a tag. The objects list displays the tags of all data types. Select 
only tags of the following data types:
● Ethernet connection: "String" data type
● MPI connection: "Int" data type
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Slot
Slot of the PLC to which the connection will be established.

Rack
Rack of the PLC to which the connection will be established.

Application example
You want to operate one HMI device on several machines. Configure the necessary PLCs in 
the project, to which you want to change by pressing a key. When changing the PLC, the 
connection to the PLC in use is disconnected. Then the connection to the new PLC with other 
address parameters is reestablished. To access the values of the new PLC, configure the 
same tags for the PLC used.

The PLC which you have indicated when creating the project will be used as default.

1. Enter the name and address of the PLC in the "Connections" editor.

2. Configure a button in the process screen.

3. Configure the "ChangeConnection" system function on the "Press" event.

4. Enter the name of the connection and address of the PLC as parameters.

ClearAlarmBuffer

Description
Deletes alarms from the alarm buffer on the HMI device.       

 

 Note

Alarms which have not yet been acknowledged are also deleted.
 

Use in the function list
ClearAlarmBuffer (Alarm class number)

Use in user-defined functions
ClearAlarmBuffer (Alarm_class_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Alarm class number
Determines which alarms are to be deleted from the alarm buffer:
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0 (hmiAll) = All alarms/events

1 (hmiAlarms) = Alarms of alarm class "Errors"

2 (hmiEvents) = Alarms of alarm class "Warnings"

3 (hmiSystem) = Alarms of alarm class "System"

4 (hmiS7Diagnosis) = Alarms of alarm class "Diagnosis Events"
 

 Note
Device dependency

Alarms of alarm class "Diagnosis Events" are not available on Basic Panels.
 

ClearAlarmBufferProtool

Description
The system function exists to ensure compatibility.

It has the same functionality as the "ClearAlarmBuffer" system function, but uses the old 
ProTool numbering.       

Use in the function list
ClearAlarmBufferProTool (Alarm class number)

Use in user-defined functions
ClearAlarmBufferProtoolLegacy (Alarm_class_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Alarm class number
Alarm class number whose messages are to be deleted:

-1 (hmiAllProtoolLegacy) = All alarms/events

0 (hmiAlarmsProtoolLegacy) = Alarms of alarm class "Errors"

1 (hmiEventsProtoolLegacy) = Alarms of alarm class "Warnings"

2 (hmiSystemProtoolLegacy) = Alarms of alarm class "System"
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3 (hmiS7DiagnosisProtoolLegacy) = Alarms of alarm class "Diagnosis Events"
 

 Note
Device dependency

Alarms of alarm class "Diagnosis Events" are not available on Basic Panels.
 

ClearDataRecord

Description
Deletes a recipe data record.       

Several data records can be deleted from one or more recipes.

Use in the function list
ClearDataRecord (Recipe number/name, Data record number/name, Confirmation, Output 
status message, Processing status)

Use in user-defined functions
ClearDataRecord

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data records are deleted. "0" is specified if 
you want to delete recipe data records from all available recipes.

Data record number/name
Number or name of the recipe data record to be deleted. "0" is specified if you want to delete 
all recipe data records.

Confirmation
Determines whether the operator should confirm the deletion:

0 (hmiOff) = Off: Deletion is begun without confirmation.

1 (hmiOn) = On: The starting of the deletion process must be confirmed.

Output status message
Determines whether a status message is output after the deletion:

0 (hmiOff) = Off: Status message is not output.
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1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

ClearDataRecordMemory

Description
Deletes all recipes data records from the specified storage medium.       

Use in the function list
ClearDataRecordMemory (Storage location, Confirmation, Output status message, 
Processing status)

Use in user-defined functions
ClearDataRecordMemory (Storage_location, Confirmation, Output_status_message, 
Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Storage location
Determines the storage location:

0 (hmiFlashMemory) = Flash memory: Internal flash memory of the HMI device

1 (hmiStorageCard) = Storage card

2 (hmiStorageCard2) = Storage card 2

3 (hmiStorageCard3) = Storage card MultiMediaCard

4 (hmiStorageCard4) = Storage card USB

Confirmation
Determines whether the operator should confirm the deletion:

0 (hmiOff) = Off: Deletion is begun without confirmation.

1 (hmiOn) = On: The starting of the deletion process must be confirmed.
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Output status message
Determines whether a status message is output after the deletion:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

ClearLog

Description
Deletes all data records in the given log.       

Use in the function list
ClearLog (Log type, Log)

Use in user-defined functions
ClearLog (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log: 

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail log Available for GMP-compliant projects Additional 
information is available under "Activating GMP-compliant configuration".

Log
Name of the log from which all entries are deleted.
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CloseAllLogs

Description
Disconnects the connection between WinCC and all logs.       

 

 Note

Before you close a log, the logging function must first be stopped in the log. Use the 
"StopLogging" system function.

 

Use in the function list
CloseAllLogs

Use in user-defined functions
CloseAllLogs

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. You open all logs with the "Open Archive" button. 
The logging process will continue in the specified log.
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ControlSmartServer

Description
Starts or stops the Sm@rtServer.       

Use in the function list
ControlSmartServer (Mode)

Use in user-defined functions
ControlSmartServer (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Specifies whether the Sm@rtServer is started or stopped. 

-1 (hmiToggle) = Toggle: Toggles between the two modes

0 (hmiStop) = Stop: Sm@rtServer is stopped

1 (hmiStart) = Start: Sm@rtServer is started

ControlWebServer

Description
Starts or stops the Web server.       

Use in the function list
ControlWebServer (Mode)

Use in user-defined functions
ControlWebServer (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Mode
Specifies whether the Web server is started or stopped. 

-1 (hmiToggle) = Toggle: Toggles between the two modes

0 (hmiStop) = Stop: The Web server is stopped.

1 (hmiStart) = Start: The Web server is started.

CopyLog

Description
Copies the contents of a log to another log. Tag values can only be copied to other data logs 
and alarms only to other alarm logs, however.

 

 Note

If you copy a log using the "CopyLog" system function, it is possible that external applications 
will be unable to read certain country-specific special characters in the logged message text 
of the log copy. This does not apply to WinCC Runtime. WinCC Runtime can read the copied 
log files without errors.

 

Use in the function list
CopyLog (Log type, Destination log, Source log, Mode, Delete source log)

Use in user-defined functions
CopyLog (Log_type, Destination log, Source_log, Mode, Delete_source_log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

Destination log
Name of the log into which the entries are copied (Destination log).
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Source log
Name of the log from which the entries are copied (Source log).

Mode
Determines what is done with copied entries in the destination log:

0 (hmiOverwrite) = Overwrite: Existing entries are overwritten.

2 (hmiAppend) = Append: The entries are inserted at the end of the destination log. When the 
configured size of the log has been reached, the destination log is treated like a circular log.

Delete source log
Determines whether the source log is deleted after copying.

0 (hmiNo) = No: Is not deleted.

1 (hmiYes) = Yes: Is deleted.

DecreaseTag

Description
Subtracts the given value from the tag value.       

X = X - a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. The auxiliary tags are assigned to 
the tag value with the "SetTag" system function.

 

If you configure the system function on the events of an alarm and the tag is not being used 
in the current screen, it is not ensured that the actual value of the tags is being used in the 
PLC. You can improve the situation by setting the "Cyclic continuous" acquisition mode. 

Use in the function list
DecreaseTag (Tag, Value)

Use in user-defined functions
DecreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3813



Parameter

Tag
The tag from which the given value is subtracted.

Value
The value which is subtracted.

EditAlarm

Description
Triggers the "Edit" event for all selected alarms.       

If the alarms to be edited have not yet been acknowledged, the acknowledgment takes place 
automatically when this system function is called up.

This system function can only be used for function keys.

Use in the function list
EditAlarm

Use in user-defined functions
EditAlarm

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

Encode

Description     
Adapts the "String" data type of a tag for transfer to the automation system (AS). The tag of 
WinCC data type "String" is converted into the AS data type "Array of byte". The result is written 
to a tag. 

Use in the function list
Encode (Byte array, String, Coding)
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Use in user-defined functions
Encode (Byte_array, String, Encoding)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Byte array
The tag that contains the converted value. 

 

 Note

The Byte array must be twice the size of the string length + 2. The Byte array must contain 
242 array elements if the string has a length of 120 characters.

Characters are either truncated or not converted if the size is insufficient.
 

String
The tag of data type "String" that is converted.

Encode
0 (hmiEncodeUTF16LE) - String is encoded in UTF16LE (Unicode 16 Little Endian). 

EncodeEx

Description       
Adapts the "String" data type of a tag for transfer to the automation system (AS). The tag of 
WinCC data type "String" is converted into the AS data type "Array of byte". The result is written 
to a tag. 

By contrast to the Encode system function, you can define the Line break parameter. Using 
the Line break parameter you can delete line breaks or replace these with predefined 
characters.

Use in the function list
EncodeEx (Byte array, String , Encode , Line break)

Use in user-defined functions
EncodeEx (Byte_array, String, Encoding, Line_break)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Byte array
The tag that contains the converted value. 

 

 Note

The byte array must be twice the size of the string length +2. If the string has a length of 120 
characters, the byte array must contain 242 array elements.

Characters are either truncated or not converted if the size is insufficient.
 

String
The tag of data type "String" that is converted.

Encode
0 (hmiEncodeUTF16LE) - String is encoded in UTF16LE (Unicode 16 Little Endian). 

Line break
All line breaks are either deleted or replaced with predefined characters. Do not replace line 
breaks if set as the default value. 

0 (replace with "\r\n' (0x000D, 0x000A)) - the line break is replaced with "\r\n".

1 (replace with "\n' (0x000A)) - the line break is replaced with "\n".

2 (do not replace) - the line break is not replaced.

3 (remove line breaks) - the line breaks are removed.

ExportDataRecords

Description
Exports one or all data records of a recipe to a CSV file.       

One file is created per recipe.

Use in the function list
ExportDataRecords (Recipe number/name, Data record number/name, File name, Overwrite, 
Output status message, Processing status)

Use in user-defined functions
ExportDataRecords (Recipe_number/name,Data_record number/name, File_name, 
Overwrite, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3816 System Manual, 07/2013,  



Parameter

Recipe number/name
Number or name of the recipe from which the data records are exported. Specify "0" if recipe 
data records are to be exported from all available recipes.

File name
Name of the CSV file to which the recipe data records are exported. Enter the file location and 
the file extension (*.csv), for example, "C:\TEMP\Orange.csv".

 

 Note
Storage of the CSV file
● If a storage card is used as storage location, specify the storage location as follows: 

"\StorageCard\<File name>".
● If you only enter one file name and no path, the file will be saved in a system directory, 

for example, "C:\Documents and Settings\[User]".
● When only one path for the export is specified, the file name is automatically created from 

the respective recipe name. It is a requirement that the folder "D:\Temp\", for example, 
has been created. If the folder  "D:\Temp" has not been created, the folder name will be 
used as the prefix of the file name, Temp_Recipe names.csv.

 

Data record number/name
Number or name of the recipe data record to be exported. Specify "0" if all recipe data records 
are to be exported.

Overwrite
Determines whether an existing CSV file with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: CSV file will not be overwritten. The export process will not 
be carried out.

1 (hmiOverwriteAlways) = Yes: CSV file is overwritten without a prompt for confirmation.

2 (hmiOverwriteWithPrompting) = With confirmation: CSV file is not overwritten until confirmed.

Output status message
Determines whether a status message is output after the export:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.
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Export format of the recipe data records
If ".csv" is chosen as a file extension for the export file, then only valid characters from the 
ANSI character set will be supported. This also applies to separators in decimal numbers and 
list elements. The separators used are defined in the country/regional settings of the operating 
system of the exporting computer.

You may also set "Unicode text" (".txt") format for the export file. This file format supports the 
WinCC and WinCC Runtime character set. Again, the separators used are specified in the 
country/regional settings of the operating system of the exporting computer. This file format 
always uses tab separators in list elements.

The corresponding file import function also supports the ".csv" and ".txt" (Unicode) file 
formats.       

Application example
You want to export all data records using a key.

Notes on configuring

Configure the "ExportDataRecords" system function on the "Press" event for the desired key. 
Transfer the following parameters:

● Recipe number/name = 1

● Data record number/name = 0

● File name = c:\temp\orange.csv

● Overwrite = 1

● Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data records are exported.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated. All data records of Recipe 1 are exported to the orange.csv file. If the file already 
exists, it will be overwritten.

After exporting the data records, a system message is output.

ExportDataRecordsWithChecksum

Description
Exports one or all data records of a recipe to a CSV file and generates a checksum for each 
line in the file.       

One file is created per recipe.
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Use in the function list
ExportDataRecordsWithChecksum (Recipe number/name, Data record number/name, File 
name, Overwrite, Output status message, Processing status)

Use in user-defined functions
ExportDataRecordsWithChecksum (Recipe_number/name, Data_record number/name, 
File_name, Overwrite, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which the data records are exported. Specify "0" if recipe 
data records are to be exported from all available recipes.

Data record number/name
Number or name of the recipe data record to be exported. Specify "0" if all recipe data records 
are to be exported.

File name
Name of the CSV file to which the recipe data records are exported. Enter the path and the 
file extension e.g. "C:\TEMP\Orange.CSV".

If a storage card is used as storage location, specify the storage location as follows: 
"\StorageCard\<File name>".

If you define only a file name without specifying a path, the file is saved to the directory from 
which Runtime was started. If write access to this directory is not enabled in the Windows 7 
operating system, the file is saved to the "VirtualStore" folder of the user directory.

When only one path for the export is specified, the file name is automatically created from the 
respective recipe name. This requires, for example, that the directory "D:\Temp\" has been 
created. If the directory  "D:\Temp" does not exist, the directory name is used as the prefix for 
the file name, Temp_Recipe names.csv.

Overwrite
Determines whether an existing CSV file with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: CSV file will not be overwritten. The export process will not 
be carried out.

1 (hmiOverwriteAlways) = Yes: CSV file is overwritten without a prompt for confirmation.

2 (hmiOverwriteWithConfirmation) = With confirmation: CSV file is not overwritten until 
confirmed.

Output status message
Determines whether a status message is output after the export:

0 (hmiOff) = Off: Status message is not output.
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1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Export format of the recipe data records
If ".csv" is chosen as a file extension for the export file, then only valid characters from the 
ANSI character set will be supported. This also applies to separators in decimal numbers and 
list elements. The separators used are defined in the country/regional settings of the operating 
system of the exporting computer.

You may also set "Unicode text" (".txt") format for the export file. This file format supports the 
WinCC and WinCC Runtime character set. Again, the separators used are specified in the 
country/regional settings of the operating system of the exporting computer. This file format 
always uses tab separators in list elements.

The corresponding file import function also supports the ".csv" and ".txt" (Unicode) file formats.

Application example
Using a key, you want to export all data records and assign a checksum.

Notes on configuring

Configure the "ExportDataRecordsWithChecksum" system function on the "Press" event for 
the desired key. Transfer the following parameters:

● Recipe number/name = 1

● Data record number/name = 0

● File name = c:\temp\orange.csv

● Overwrite = 1

● Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data records are exported.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated. All data records of Recipe 1 are exported to the orange.csv file and assigned 
checksums. If the file already exists, it will be overwritten.

After exporting the data records, a system message is output.
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ExportImportUserAdministration

Description
Exports all users of the user administration of the currently active project to the given file or 
imports the users from the given file into the currently active project.       

Users, their passwords and rights are saved in the user administration.

All users are overwritten when importing. The imported users are valid immediately.

Use in the function list
ExportImportUserAdministration (File name, Direction)

Use in user-defined functions
ExportImportUserAdministration (File_name, Direction)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the file which contains the passwords or to which the passwords are written. Enter 
the file location and the file extension (*.txt), for example, "C:\TEMP\Passwords.txt".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Direction
Specifies whether passwords are exported or imported:

0 (hmiExport) = Export: Passwords are exported.

1 (hmiImport) = Import: Passwords are imported.

GetBrightness

Description
Reads the value of the brightness.
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Use in the function list
GetBrightness (Brightness)

Use in user-defined functions
GetBrightness (Brightness)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Brightness
The tag to which the value is written. 

GetDataRecordFromPLC

Description
Transfers the selected recipe data record from the PLC to the storage medium of the HMI 
device.       

Use in the function list
GetDataRecordFromPLC (Recipe number/name, Data record number/name, Overwrite, 
Output status message, Processing status)

Use in user-defined functions
GetDataRecordFromPLC (Recipe_number/name, Data_record_number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data records are transferred.

Data record number/name
Number or name of the recipe data record which is transferred from the PLC to the data medium 
of the HMI device.

Overwrite
Determines whether an existing recipe data record with the same name is overwritten:
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0 (hmiOverwriteForbidden) = No: Recipe data record is not overwritten. The transfer process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data record is overwritten without prompting.

2 (hmiOverwriteWithPrompting) = With confirmation: Recipe data record is not overwritten until 
confirmed.

Output status message
Determines whether a status message is output after the transfer:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Application example
You want to transfer a data record from the PLC to the data medium of the HMI device using 
a key.

Notes on configuring

Configure the "GetDataRecordFromPLC" system function on the "Press" event for the desired 
key. Transfer the following parameters:

Recipe number/name = 1

Data record number/name = 1

Overwrite = 1

Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data record is transferred from the PLC.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated and the first data record of Recipe 1 is transferred from the PLC to the data medium 
of the HMI device. If the recipe data record already exists, it will be overwritten.

A system message is output after the transfer.
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GetDataRecordName

Description
Writes the name of the given recipe and recipe data record to the given tags.     

 

 Note

If the recipe or the recipe data record do not exist, wildcards ("###") are written to the tags.
 

Use in the function list
GetDataRecordName (Recipe number, Data record number, Recipe name, Data record name, 
Processing status)

Use in user-defined functions
GetDataRecordName (Recipe_number, Data_record_number, Recipe_name, 
Data_record_name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency". 

Parameter

Recipe number
Number of the recipe whose name is written to the given tag.

Data record number
Number of the recipe data record whose name is written to the given tag.   

Recipe name
The tag to which the recipe name is written. The tag must be of the STRING type.

Data record name
The tag to which the name of the recipe data record is written. The tag must be of the STRING 
type.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.
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Application example
You want to output the names of the displayed recipes and the name of the displayed recipe 
data record on the HMI device.

Configure the following tags:

● "RecNumber" of type INTEGER

● "RecDataNumber" of type INTEGER

● "RecName" of type STRING

● "RecDataName" of type STRING

Configure a recipe view with the tags "RecNumber" for the recipe number and 
"RecDataNumber" for the data record number.

Configure the "GetDataRecordName" system function on the "Press" event for a button and 
pass the following parameters:

● Recipe number: RecNumber

● Data record number: RecDataNumber

● Recipe name: RecName

● Data record name: RecDataName

Configure two output fields and connect these to the "RecName" and "RecDataName" tags.

Select a recipe and a data record number from the recipe view. As soon as the button is 
activated, the system function is triggered and the name of the recipe and the recipe data 
record are displayed in both output fields.

GetDataRecordTagsFromPLC

Description
Transfers the values of the recipe data record loaded in the PLC to the corresponding recipe 
tags.       

This system function is used, for example, during teach-in mode on a machine.

Use in the function list
GetDataRecordTagsFromPLC (Recipe number/name, Processing status)

Use in user-defined functions
GetDataRecordTagsFromPLC (Recipe_number/name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Recipe number/name
Number or name of the recipe data record whose values are written from the PLC to the tags.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

GetGroupNumber

Description
Reads the number of the group to which the user logged on to the HMI device belongs, and 
writes it to the given tag.       

Use in the function list
GetGroupNumber (Tag)

Use in user-defined functions
GetGroupNumber (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the number of the group is written.
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GetPassword

Description
Writes the password of the user currently logged on to the HMI device in the given tag.       

 

 Note

Make sure that the value of the given tag is not displayed in another place in the project.
 

 Note

The passwords of SIMATIC Logon users cannot be read. 
 

Use in the function list
GetPassword (Tag)

Use in user-defined functions
GetPassword (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the password is written.

GetUserName

Description
Writes the user name of the user currently logged on to the HMI device in the given tag.       

If the given tag has a control connection, the user name is also available in the PLC connection. 
This system function makes it possible, for example, to implement a user-dependent release 
of certain functionalities.

Use in the function list
GetUserName (Tag)

Use in user-defined functions
GetUserName (Tag)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the user name is written.

GoToEnd

Description
Executes the key function <End> on the HMI device.       

This system function is used when the HMI device does not have this functionality by default.

The system function can only be used for the following function keys.

Use in the function list
GoToEnd

Use in user-defined functions
GoToEnd

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

GoToHome

Description
Executes the key function <Home> on the HMI device.       

This system function is used when the HMI device does not have this functionality by default.

The system function can only be used for the following function keys.

Use in the function list
GoToHome
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Use in user-defined functions
GoToHome

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ImportDataRecords

Description
Imports one or all data records of a recipe from a CSV file.       

When a path is specified, all records of the given directory are imported.

Use in the function list
ImportDataRecords (File name, Data record number/name, Overwrite, Output status 
message, Processing status)

Use in user-defined functions
ImportDataRecords (File_name, Data_record number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the CSV file from which the recipe data records are imported. Enter the file location 
and the file extension (*.csv), for example "C:\TEMP\Orange.csv".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Data record number/name
Number or name of the recipe data record to be imported. Specify "0" if all recipe data records 
are to be imported.
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Overwrite
Determines whether existing recipe data records are to be overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data records are not overwritten. The import process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data records are overwritten without prompting.

2 (hmiOverwriteWithPrompting) = With confirmation: Recipe data records are not overwritten 
until confirmed.

Output status message
Determines whether a status message is output after the import:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Configurable objects

Object Event
Tag Value change

High limit violated
Low limit violated

Function key (global) Release
Press

Function key (local) Release
Press

Screen Loaded
Cleared

Screen object Press
Release
Click
Change (or toggle for switch)
Switch on
Switch off
Enable
Disable

Scheduler Time expired
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ImportDataRecordsWithChecksum 

Description
Imports one or all data records of a recipe from a CSV file with a checksum and verifies the 
checksum.       

Use in the function list
ImportDataRecordsWithChecksum (File name, Data record number/name, Overwrite, Output 
status message, Processing status, verify checksum)

Use in user-defined functions
ImportDataRecordsWithChecksum (File_name, Data_record number/name, Overwrite, 
Output_status_message, Processing_status, Verify_Checksum)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the CSV file from which the recipe data records are imported. Enter the path and the 
file extension, for example, "C:\TEMP\Orange.CSV".

If a storage card is used as storage medium, specify the storage location as follows: 
"\StorageCard\<File name>".

If you specify a directory instead of an individual CSV file, all files in the specified directory will 
be imported.

Data record number/name
Number or name of the recipe data record to be imported. Specify "0" if all recipe data records 
are to be imported.

Overwrite
Determines whether existing recipe data records are to be overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data records are not overwritten. The import process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data records are overwritten without prompting.

2 (hmiOverwriteWithConfirmation) = With confirmation: Recipe data records are not 
overwritten until confirmed.
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Output status message
Determines whether a status message is output after the import:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for example 
to delay execution of other system functions, until this system function has been successfully 
completed.

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Verify checksum
Determines if the checksum should be verified during import:

0 (hmiFalse) = No: Checksum is not verified.

1 (hmiTrue) = Yes: Checksum is verified.

IncreaseTag

Description
Adds the given value to the value of the tags.       

X = X + a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, help tags must be used. You can use the "SetTag" system function 
to assign the tag value to the auxiliary tags.

 

If you configure the system function on the events of an alarm and the tag is not being used 
in the current screen, it is not ensured that the actual value of the tags is being used in the 
PLC. You can improve the situation by setting the "Cyclic continuous" acquisition mode.

Use in the function list
IncreaseTag (Tag, Value)

Use in user-defined functions 
IncreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Tag
The tag to which the given value is added.

Value
The value that is added.

InverseLinearScaling

Description
Assigns a value to the tag X, which is calculated from the value of the given tag Y using the 
linear function X = (Y - b) / a.       

The tags X and Y must not be identical. This system function is the inverse of the 
"LinearScaling" system function.

 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used.

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
InvertLinearScaling (X, Y, b, a)

Use in user-defined functions
InverseLinearScaling (X, Y, b, a)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

X
The tag which is assigned the value calculated from the linear equation.

Y
The tag that contains the value used for calculation.

b
The value which is subtracted.
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a
The value through which is divided.

Example
The following program code assigns a value to the varX tag by means of the 
InverseLinearScaling function.

 
{
BYTE varX;
BYTE Yvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
//Inverse linear scaling
 InverseLinearScaling (varX, Yvalue, bvalue, avalue);
 
printf ("varX = %d\r\n, varX); 
...
}

The saved return value can be processed in the following code.

InvertBit

Description
Inverts the value of the given tag of the "Bool" type:       

● If the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

Use in the function list
InvertBit (Tag)

Use in user-defined functions
InvertBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag whose bit is set.
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Example
The following program code inverts the value of the boolean tag b_value and outputs the result 
along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Invert variable
invertBit(b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
  ...
}

InvertBitInTag

Description
Inverts a bit in the given tag:       

● If the bit in the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the bit in the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "InvertBit" system 
function instead.

 

Use in the function list
InvertBitInTag (Tag, Bit)

Use in user-defined functions
InvertBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Tag
The tag in which the given bit is set.

Bit
The number of the bit that is set.

When this system function is used in a user-defined function, the bits in a tag are counted from 
right to left. The counting begins with 0.

Example
The following program code inverts a bit at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Invert bit in bitposition
InvertBitInTag (bvalue, bitposition);
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

LinearScaling

Description
Assigns a value to the tag Y, which is calculated from the value of the given tag X using the 
linear function Y= (a *X) + b.       

The inverse of this function is the "InvertLinearScaling" system function.
 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used. 

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
LinearScaling (Y, a, X, b)
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Use in user-defined functions
LinearScaling (Y, a, X, b)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Y
The tag which is assigned the value calculated from the linear equation.

a
The value with which is multiplied.

X
The tag that contains the value used for calculation.

b
The value that is added.

Example
The following program code uses the LinearScaling function to assign a value to the Yvar tag.

 
{
BYTE Yvar;
BYTE Xvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
// linear scaling
 LinearScaling ( Yvar, avalue, Xvalue, bvalue);
 
printf ("Yvar = %d\r\n, Yvar); 
...
}

The saved return value can be processed in the following code.

LoadDataRecord

Description
Loads the given recipe data record from the memory medium of the HMI device in the recipe 
tags. This system function is used, for example, to display a recipe data record in the recipe 
screen.       
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Activate the "Synchronize recipe view and recipe tags" option in the synchronization settings 
of the recipe. If this option is deactivated, the system function has no effect. 

Use in the function list
LoadDataRecord (Recipe number/name, Data record number/name, Processing status)

Use in user-defined functions
LoadDataRecord (Recipe_number/name, Data_record_number/name, Confirmation, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which a recipe data record is loaded.

Data record number/name
Number or name of the recipe data record to be loaded.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

LogOff

Description
Logs off the current user on the HMI device.       

Use in the function list
Logoff

Use in user-defined functions
Logoff
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

Logon

Description
Logs on the current user on the HMI device.       

Use in the function list
Logon (Password, User name)

Use in user-defined functions
Logon (Password, User_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Password
The tag from which the password for the user logging on is read.

If the user is logged on, the password in the tag is deleted.

User name
The tag from which the user name for the user logging on is read.

LookupText

Description     
Identifies an entry from a text list. The result depends on the value and on the selected runtime 
language. The result is saved to a tag of data type "String".

Use in the function list
LookupText (Output text, Value, Language, Text list)
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Use in user-defined functions
LookupText (Output_text, Index, Language, Text_list)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Output text
The tag to which the result is written.

Index
The tag that defines the value of the list entry. 

Language
Defines the runtime language in which the list entry is identified. 

● Tag
The tag that contains the language. Enter the runtime language as decimal value of the 
country ID, for example, 1031 for German - Standard, 1033 for English - USA. Details are 
available in the VBScript basics, "Locale identifier (LCID) diagram".

● Runtime language
Language code as per VBScript reference, for example, "de-DE" for German (Germany) 
or "en-US" for English (United States of America). The selection depends on the activated 
runtime languages. 

Text list
Defines the text list. The list entry is read from the text list.

NotifyUserAction

Description
       

This system function is used to log user actions that are not automatically logged in the audit 
trail. You can also use this system function to require the user to enter an acknowledgment or 
an electronic signature and a comment for the operator action. Requirement for the use of the 
system function is that the GMP-compliant configuration is activated under "Runtime settings".

If you use the "NotifyUserAction" system function in a function, the debugger may open if you 
cancel your input by clicking "Cancel". To compensate for this reaction, you can use the "On 
Error Resume Next" statement in a function. With this instruction, the next instruction is 
executed after a runtime error. If you use the "On Error Resume Next" statement, output of 
system events is also suppressed.
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Use in the function list
NotifyUserAction (Confirmation type, Mandatory commenting, Category, Object name, 
Description)

Use in user-defined functions
NotifyUserAction (Confirmation_type, Mandatory_commenting, Category, Object_name, 
Description)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Confirmation type
Establishes how the action must be confirmed

0 = (None): No confirmation required, an entry is created in the audit trail

1 = (Acknowledgement): Acknowledgment, the user must acknowledge the action; an entry is 
created in the audit trail

2 = (Digital Signature): Electronic signature, a dialog window opens in which the user must 
enter his electronic signature - an entry is created in the audit trail

Mandatory commenting
Establishes if the user has to enter a comment. The comment is logged in the audit trail.

0 = (True): True; a dialog window opens in which the user must enter a comment

1 = (False): False; no mandatory commenting

Category
Category or class name of the modified object

Object name
Name of the modified object

Description
Text which describes the archiving user action.
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OpenAllLogs

Description
Reestablishes the connection between WinCC and the logs. Logging can be continued.       

 

 Note

Run the "StartLogging" system function in order to restart logging.
 

Use in the function list
OpenAllLogs

Use in user-defined functions
OpenAllLogs

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. You open all logs with the "Open Archive" button. 
Logging will be continued in the specified log. 

OpenCommandPrompt

Description
Opens a Windows system prompt.       
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This function is used, e.g., to copy files or to call up another application.

Use in the function list
OpenCommandPrompt

Use in user-defined functions
OpenCommandPrompt

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

OpenControlPanel

Description
Opens a dialog that you can use to edit selected Control Panel settings.       

This system function lets you set the following on the HMI device:

● Properties and value of the IP address

● User identification on the network

● WinCC Internet settings
 

 Note
Project security

The "OpenControlPanelDialog" system function is used to bypass the SecureMode on the 
HMI device. Take the corresponding precautions to ensure the security of your project.  

 

Use in the function list
OpenControlPanelDialog (Dialog)

Use in user-defined functions
-
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Parameters

Dialog
Sets the Control Panel dialog to be opened.

● PROFINET_X1: Setting of the IP address and Ethernet parameters

● PROFINET_X3: Setting of the IP address and Ethernet parameters; only for Comfort Panel 
KP 1500, TP 1500; TP1900, TP2200

● WinCC Internet settings: Setting for Web Server, e-mail notification, provided the HMI 
device supports these functions

● Network ID: Setting for identification on the network, provided the HMI device supports 
these functions

 

OpenInternetExplorer

Description
Opens the Internet Explorer on the HMI device.       

If the Internet Explorer is already open, it will be closed and reopened when you call the system 
function.

 

 Note

The Internet Explorer saves data temporarily in the DRAM file system of the HMI device, e.g. 
the last web sites that were be called up.

This data can be saved using the "BackupRAMFileSystem" system function so that it is still 
available when the HMI device is restarted.

 

Use in the function list
OpenInternetExplorer (Start page)

Use in user-defined functions
OpenInternetExplorer (Start_page)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Start page
The page which is loaded when Internet Explorer is started, e.g. "www.siemens.com".
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OpenScreenKeyboard

Description
Hides or shows the screen keyboard.       

The screen keyboard remains open until the screen keyboard is explicitly closed. In this way, 
the screen keyboard can also be used in other applications.

Use in the function list
OpenScreenKeyboard (Layout)

Use in user-defined functions
OpenScreenKeyboard (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Layout
Specifies whether the window is opened minimized or maximized with the screen keyboard:

0 (hmiScreenKeyboardMinimized) = Minimized

1 (hmiScreenKeyboardMaximized) = Maximized

OpenTaskManager

Description
Shows the task manager.       

The task manager allows changing to other open applications on the HMI device.
 

 Note

The appearance of the task manager depends on the operating system installed.
 

Use in the function list
OpenTaskManager

Use in user-defined functions
OpenTaskManager
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Can be used if the configured device supports user-defined scripts. For additional information, 
refer to "Device dependency".

Parameter
--

PageDown

Description
Executes the key function <Pagedown> on the HMI device. 

This system function can only be used for function keys.       

Use in the function list
PageDown

Use in user-defined functions
PageDown

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
-

PageUp

Description
Executes the key function <PageUp> on the HMI device. 

This system function can only be used for function keys and tasks with a time trigger.       

Use in the function list
PageUp

Use in user-defined functions
PageUp

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter
-

PrintReport

Description
Prints the given report from the printer which is connected to the HMI device. The report is 
printed in the language which is set on the HMI device.       

 

 Note

If runtime is closed whilst log data are being printed using the system function, the report will 
cease to be supplied with data as soon as runtime stops.

 

Use in the function list
PrintReport (Report)

Use in user-defined functions
PrintReport (Report)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Report
Name of the report to be printed.

 

 Note

If you have set up via the "Function list" dialog box a new report for the "PrintReport" function, 
when compiling, the following warning appears: "The report "Report_1" has no printed pages."

In order to remedy the warning, open the "Report_1" via the project view and recompile the 
project.

 

PrintScreen

Description
Prints the screen currently being displayed on the HMI device from the printer which is 
connected to the HMI device.       
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Opened windows are also printed.
 

 Note

The printer settings are taken over from the current settings in the Windows operation system.
 

Use in the function list
PrintScreen

Use in user-defined functions
PrintScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ResetBit

Description
Sets the value of a "Bool" type tag to 0 (FALSE).       

Use in the function list
ResetBit (Tag)

Use in user-defined functions
ResetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 0 (FALSE).
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Example
The following program code resets the value of the boolean tag b_value to 0 by means of the 
ResetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 1;
BOOL b_saved = b_value;
 
//Reset bit
  ResetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

ResetBitInTag

Description
Sets a bit in the specified tag to 0 (FALSE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "ResetBit" system 
function instead.

 

Use in the function list
ResetBitInTag (Tag, Bit)

Use in user-defined functions
ResetBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 0 (FALSE).
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Bit
The number of the bit that is set to 0 (FALSE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

Example
The following program code sets a bit at the specified bitposition in the bvalue tag to 0 and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
ResetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

SafelyRemoveHardware

Description
Checks whether there is read or write access to the external storage medium. If there is no 
access, the external storage medium can be removed without data loss.       

Use in the function list
SafelyRemoveHardware(Path, Result)

Use in user-defined functions
SafelyRemoveHardware(Path, Result)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Path
Path of storage medium , e.g. \Storage Card USB\
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Result
The tag in which the result is entered.

TRUE : The storage medium can be removed safely. A corresponding system message will 
be issued.

FALSE : The storage medium can be removed safely. A corresponding system message will 
be issued. 

SaveDataRecord

Description
Saves the current values of the recipe tags as data record to the memory medium of the HMI 
device.       

This system function is used, for example, to save a recipe data record in the recipe screen.

Use in the function list
SaveDataRecord (Recipe number/name, Data record number/name, Overwrite, Output status 
message, Processing status)

Use in user-defined functions
SaveDataRecord (Recipe_number/name, Data_record_number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Recipe number/name
Number or name of the recipe to which a recipe data record is saved.

Data record number/name
Number or name of the recipe data record to be saved. A new data record will be created if 
no record of this name or number was found in the recipe, independent of the value at the 
"Overwrite" parameter.

Overwrite
Specifies whether an existing data record is overwritten:

0 (hmiOverwriteForbidden) = No: The recipe data record is not overwritten, the data record is 
not saved.

1 (hmiOverwriteAlways) = Yes: The recipe data record is overwritten without a prompt for 
confirmation.
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2 (hmiOverwriteWithPrompting) = With confirmation: The recipe data record is overwritten only 
with confirmation by the user.

Output status message
Determines whether a status message is output after saving:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

SendEMail

Description
Sends an e-mail from the HMI device to the given addressee.       

This system function is used, for example, when, in the case of service, the alarm is to be 
passed on directly to the service technician.

 

 Note

To send alarms as e-mails, the HMI system must have an e-mail client at its disposal.
 

Use in the function list
SendEMail (Address, Subject, Text, Return address)

Use in user-defined functions
SendEMail (Address, Subject, Text, Return_address)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Address
The e-mail address of the addressee.
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Subject
The subject line of the e-mail.

Text
The text sent in the e-mail.

Return address
The e-mail address to which the addressee of this e-mail should send the reply.

SetAcousticSignal

Description
Configures the acoustic feedback of touch screen operation on the HMI device.       

 

 Note

The configuration that was set at Switch off is reestablished when restarting the HMI device.
 

Use in the function list
SetAcousticSignal (Volume)

Use in user-defined functions
SetAcousticSignal (Volume)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Volume
Determines whether and how loud an acoustic signal is emitted:

-1 (hmiToggle) = Toggle: Toggles the emission of the acoustic signal as follows: Muted > Quiet 
> Loud.

0 (hmiMuted) = Mute: no acoustic signal

1 (hmiQuiet) = Quiet: quiet acoustic signal

2 (hmiLoud) = Loud: loud acoustic signal
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SetAlarmReportMode

Description
Switches the automatic reporting of alarms on the printer on or off.       

Use in the function list
SetAlarmReportMode (Mode)

Use in user-defined functions
SetAlarmReportMode (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether alarms are reported automatically on the printer:

0 (hmiDisablePrinting) = Reporting off: Alarms are not printed automatically.

1 (hmiEnablePrinting) = Reporting On: Alarms are printed automatically.

-1 (hmiToggle) = Toggle: Toggles between the two modes.

SetAndGetBrightness

Description
Determines the brightness of the MP 377 Touch daylight readable display. The brightness 
value can be interpreted as absolute or relative to the current value.       

 

 Note

The configuration that is set in the Control Panel will be reestablished when you restart the 
HMI device.

 

Use in the function list
SetAndGetBrightness (Brightness, Mode, Current value)

Use in user-defined functions
SetAndGetBrightness (Brightness, Mode, Actual brightness)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Brightness
New value for the brightness.

Mode
Specifies if the new brightness value is set as absolute or relative to the current value.

Current value
Tag in which the current brightness value is stored.

SetBit

Description
Sets the value of a "Bool" type tag to 1 (TRUE).       

Use in the function list
SetBit (Tag)

Use in user-defined functions
SetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 1 (TRUE).

Example
The following program code sets the value of the boolean tag b_value to 1 by means of the 
SetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
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//Set bit
  SetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

SetBitInTag

Description
Sets a bit in the given tag to 1 (TRUE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.

 

Use in the function list
SetBitInTag (Tag, Bit)

Use in user-defined functions
SetBitInTag(Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 1 (TRUE).

Bit
The number of the bit that is set to 1 (TRUE).
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When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an I/O field or assign 
the system function to a screen object, such as a button.

If you have configured a short event such as the activation of an alarm for the system function 
you can only access the actual process values by setting the tag for continuous reading.

 

Example
The following program code sets a bit to 1 at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
SetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

SetBrightness

Description
Determines the brightness of the display.       

 

 Note

The configuration that is set in the Control Panel will be reestablished when you restart the 
HMI device.

 

Use in the function list
SetBrightness (value)
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Use in user-defined functions
SetBrightness (Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Value
New value for the brightness. 

SetConnectionMode

Description
Connects or disconnects the given connection.       

 

 Note

A connection to the PLC cannot be established until the operating mode ONLINE has been 
set on the HMI device. Use the "SetDeviceMode" system function for this purpose.

 

Use in the function list
SetConnectionMode (Mode, Connection)

Use in user-defined functions
SetConnectionMode (Mode, Connection)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether a connection to the PLC is established or disconnected:

0 (hmiOnline) = Online: Connection is established.

1 (hmiOffline) = Offline: Connection is disconnected.

Connection
The PLC to which the HMI device is connected. You specify the name of the PLC in the 
connection editor.
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Multiple use of the system function in a user-defined function
If you use the "SetConnectionMode" system function for different connections, it may be 
possible that not all system functions are executed correctly. Proceed as follows to prevent 
this situation:

1. Create a "BOOL" type tag with the start value "0".

2. Configure the "SetConnectionMode" system function on the "Value change" event of the 
HMI tags. If you want to disconnect three connections, for example, you must configure the 
system function three times.

3. In the user-defined function, apply the "InvertBit" system function to the HMI tag.

Application example
Two typical application examples for this system function are as follows:

● Test
As long as no PLC is connected to the HMI device, no error messages will be output during 
the test on the HMI device. If the HMI device is connected to a PLC, the connection to the 
PLC can be established by pressing a key.

● Commissioning
Several PLCs are to be configured for a system. At first, all PLCs except one are configured 
"Offline". After commissioning of the first PLC, the connection to each of the other PLCs is 
established by pressing a key. In this way, the other PLCs are started up one after another.

SetDataRecordTagsToPLC

Description
Transfers the values of the recipe tags to the PLC. The recipe tags contain the values of the 
data record which is displayed on the HMI device.       

Use in the function list
SetDataRecordTagsToPLC (Recipe number/name, Processing status)

Use in user-defined functions
SetDataRecordTagsToPLC (Recipe_ number/name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data record is transferred to the PLC. 
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Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

SetDataRecordToPLC

Description
Transfers the given recipe data record directly from the data medium of the HMI device to the 
PLC with which the HMI device is connected.       

 

 Note

The values of the recipe data record don't need to be displayed on the HMI device.
 

Use in the function list
SetDataRecordToPLC (Recipe number/name, Data record number/name, Output status 
message, Processing status)

Use in user-defined functions
SetDataRecordToPLC (Recipe_number/name, Data_record_number/name, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data record is transferred to the PLC.

Data record number/name
Number or name of the recipe data record to be transferred to the PLC. 

Output status message
Determines whether a status message is output after the transfer:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3860 System Manual, 07/2013,  



Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

SetDaylightSavingTime

Description
The system function "SetDaylightSavingTime" changes the setting of the HMI device from 
daylight saving to standard time and vice versa.

Time settings will take place immediately following system function.     
 

 Note

The "SetDaylightSavingTime" system function does not support time zones without daylight 
saving time. 

 

 Note
Windows 7

The system function "SetDaylightSavingTime" is not supported for PC-based HMI devices 
under Windows 7.

 

Use in the function list
SetDaylightSavingTime(DaylightSavingTime)

Use in user-defined functions
SetDaylightSavingTime (Daylight_saving_time)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Daylight Saving Time
Determines whether Daylight Saving Time is set on the HMI device:

0 = Daylight Saving Time is not activated

1 = Daylight Saving Time is activated
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SetDeviceMode

Description
Toggles the operating mode on the HMI device. The following types of operation are possible: 
"Online", "Offline" and "Load".       

Use in the function list
SetDeviceMode (Operating mode)

Use in user-defined functions
SetDeviceMode (Operating_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Operating mode
Determines the operating mode of the HMI device:

0 (hmiOnline) = Online: The connection to the PLC is established.

1 (hmiOffline) = Offline: The connection to the PLC is disconnected.

2 (hmiTransfer) = load: A project can be transferred from the configuration computer to the 
HMI device.

 

 Note

If you use a PC as an HMI device, the runtime software will be exited when you change 
operating mode after "Load".

 

SetDisplayMode

Description
Changes the settings of the screen in which the runtime software runs.       

The runtime software runs in full-screen mode as default. The Windows task switch is disabled.

Use in the function list
SetDisplayMode (Layout)
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Use in user-defined functions
SetDisplayMode (Display mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Display mode
Determines the settings for the screen in which the runtime software runs.

1 (hmiScreenFull): Full-screen: Title bar of the screen is not visible

2 (hmiScreenMaximized): Maximized

3 (hmiScreenRestore): Restore: The last used screen setting is used. This layout can only be 
used when the window is displayed minimized or maximized.

4 (hmiScreenMinimized): Minimized

5 (hmiScreenAutoAdjust): Automatic: The size of the window is set so that all screen objects 
in it will be visible.

6 (hmiScreenOnTop): On top; either the window appears in the foreground or the program 
icon associated with the window flashes on the taskbar depending on the Windows setting. 
The setting can be changed in the Windows configuration and applies to all Windows 
applications.

SetLanguage

Description
Toggles the language on the HMI device. All configured text and system events are displayed 
on the HMI device in the newly set language.       

Use in the function list
SetLanguage (Language)

Use in user-defined functions
SetLanguage (Language)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Language
Determines which language is set on the HMI device. The following specifications are possible:
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● -1 (hmiToggle) = Toggle: Changes to the next language. The sequence is determined 
during configuration in the "Project languages" editor.

● Number you have defined under "Languages and fonts" in the "Runtime Settings" editor. 
Changes to the language with the given number.

● Language you have defined under "Languages and fonts" in the "Runtime Settings" editor.

● Language abbreviation in accordance with the VBScript5 reference: This changes to the 
language corresponding to the specified language code, e.g. "de-DE" for German 
(Germany) or "en-US" for English (United States).
An overview of the language abbreviations is available in the basic information of VBScript 
under the topic "Area diagram-ID (LCID) Diagram".

SetRecipeTags

Description
Changes the status of the recipe tags from "Online" to "Offline" and vice versa.       

This system function is used, for example, when recipe data record values are fine tuned when 
starting up a machine.

Use in the function list
SetRecipeTags (Recipe number/name, Status, Output status message, Processing status)

Use in user-defined functions
SetRecipeTags (Recipe_number/name, Status, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe in which the recipe data record is saved.

Status
Determines the status of the recipe tags:

0 (hmiOnline) = Online: Value changes of the recipe tags are transferred immediately to the 
PLC connected to the HMI device.

1 (hmiOffline) = Offline: Value changes to the recipe tags are only transferred to the PLC 
connected to the HMI device when, for example, the "SetDataRecordTagsToPLC" system 
function is executed.

Output status message
Determines whether a status message is output after saving:
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0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

SetScreenKeyboardMode

Description
Enables or disables the automatic display of the screen keyboard on the HMI device.       

This system function is also used to prevent the display of the screen keyboard, e.g. because 
an external keyboard is connected to the HMI device.

 

 Note

To enable the "SetScreenKeyboardMode" ("SetScreenKeyboardMode") system function on 
an HMI other than a Touch Panel device, set the "Use on-screen keyboard" check box in the 
"Runtime settings" dialog of the device settings.

 

Use in the function list
SetScreenKeyboardMode (Mode)

Use in user-defined functions
SetScreenKeyboardMode (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether the screen keyboard is hidden or shown:

0 (hmiOff) = Off: Screen keyboard is hidden

1 (hmiOn) = On: Screen keyboard is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes.
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SetTag

Description
Assigns a new value to the given tag.     

 

 Note

This system function can be used to assign strings and numbers, depending on the type of 
tag.

 

Use in the function list
SetTag (Tag, Value)

Use in user-defined functions
SetTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag to which the given value is assigned.

Value
The value which the given tag is assigned.

 

 Note

The "SetTag" system function is only executed after a connection has been established.
 

Example
The following program code uses the SetTag function to set the value of the gs_tag_bit tag to 
TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
 
//Set the tag to true
ok = SetTag("gs_tag_bit", TRUE);
//error handling

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3866 System Manual, 07/2013,  



 
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBit("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

The saved return value can be processed in the following code.

ShiftAndMask

Description
This system function converts the input bit pattern of the source tags into an output bit pattern 
of the target tags. This involves bit shifting and masking.

 

 Note

If the source and target tag have a different number of bits, using the system function in the 
target tag can result in a violation of the value range.

 

Use in the function list
ShiftAndMask (Source tag, Target tag, Bits to shift, Bits to mask)

Use in user-defined functions
ShiftAndMask (Source_tag, Target_tag, Bits_to_shift, Bits_to_mask)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Source tag
The tag includes the input bit pattern. Integer-type tags, e.g. "Byte", "Char", "Int", "UInt", "Long" 
and "ULong" are permitted. 

Example: The actual value 72 is set at the 16-bit integer source tag: 0000000001001000.
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Target tag
The output bit pattern is saved in the tag. Integer type tags, e.g. "Byte", "Char", "Int", "UInt", 
"Long" and "ULong" are permitted.

Example: The shifted input bit pattern is multiplied by the bit mask, with bit-by-bit logical AND 
operation: 0000000000001001. The resultant decimal value "8" is saved to the target tag.

Please note the following:

● The source and target tags have the same number of bits.

● The number of bits to shift is less than the number of bits in the source tag and target tag.

● Bits to mask does not have more bits than the source tag and the target tag.

Bits to shift
Number of bits by which the input bit pattern is shifted right. A negative value shifts the input 
bit pattern to the left.

Example: "Bits to shift" has the value "+3". The input bit pattern is shifted right by three bits 
when the system function is called: 0000000000001001.
Bits to the left are padded with "0". Three bits are truncated on the right. The new decimal 
value is "9".

 

 Note

The left bit is "1" in a source tag of the data type with negative signed integer. This sign bit 
is padded with "0" when the bits are shifted right. The sign changes to "+".

 

Bits to mask
An integer serves as bit mask. The bit pattern is used to multiply the shifted input bit pattern. 
Example: Integer "2478" with the bit pattern "0000100110101110".

You can enter the bit mask in three different ways:

● Hexadecimal: First enter the prefix "0h" or "0H", followed by an optional space for better 
readability. Then group the bit pattern in blocks of four (0000)(1001)(1010)(1110) and set 
each block in hexadecimal code: (0)(9)(A)(E). Only the characters 0-9, A-F, a-f are allowed: 
"0h 09AE".

● Binary: First enter the prefix "0b" or "0B", followed by an optional space for better readability. 
Then group the binary bit pattern into blocks of four 0000 1001 1010 1110 with spaces in 
between as a check. Only the characters "0" or "1" are allowed: "0b 0000 1001 1010 1110".

● Decimal: Enter the value "2478" directly, without a prefix.

ShowAlarmWindow

Description
Hides or shows the alarm window on the HMI device.       
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Use in the function list
ShowAlarmWindow (Object name, Layout)

Use in user-defined functions
ShowAlarmWindow (Object_name, Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Object name
Name of the alarm view which is hidden or shown.

Layout
Determines whether the alarm window is hidden or shown:

0 (hmiOff) = Off: Alarm view is hidden

1 (hmiOn) = On: Alarm view is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

ShowOperatorNotes

Application
Displays the tooltip configured for the selected object.     

If the system function is configured on a function key, the tooltip for the screen object that 
currently has the focus is displayed. If a tooltip is configured for the screen itself, you can switch 
to this text by pressing <Enter> or by double-clicking on the help window.

If the system function is configured on a button, only the tooltip for the current screen is 
displayed. If a tooltip is configured on the button itself, initially only the tooltip for the button is 
displayed. You can press <Enter> or double-click on the help window to switch to the tooltip 
for the current screen.

 

 Note

No other screen object can be used while the help window is open. To use the screen object, 
close the help window.

 

Closing the help window
You can close the help window in the following ways:

Using the keys:
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● By pressing the <HELP> key again

● By pressing the <ESC> key

Using the touch screen:

● By pressing the  button

Use in the function list
ShowOperatorNotes (Layout)

Use in user-defined functions
ShowOperatorNotes (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Display mode
Determines whether the configured tooltip is hidden or shown:

0 (hmiOff) = Off: Configured tooltip is hidden

1 (hmiOn) = On: Configured tooltip is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

ShowSoftwareVersion

Description
Hides or shows the version number of the runtime software.       

Use this system function if during servicing, for example, you required the version of the runtime 
software used.

Use in the function list
ShowSoftwareVersion (Layout)

Use in user-defined functions
ShowSoftwareVersion (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Layout
Determines whether the version number is shown:

0 (hmiOff) = Off: Version number is not shown

1 (hmiOn) = On: Version number is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

ShowSystemAlarm

Description
Displays the value of the parameter passed as a system event to the HMI device.       

Use in the function list
ShowSystemAlarm (Text/value)

Use in user-defined functions
ShowSystemAlarm (Text/value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Text/Value
The text or the value, which was output as a system alarm.

ShowSystemDiagnosticsWindow

Description
Hides or shows the system diagnostic window on the HMI device. The system diagnostic view 
is only available in the global screen for Comfort Panels and for WinCC Runtime Advanced.       

Use in the function list
ShowSystemDiagnosticsWindow (Screen object)

Use in user-defined functions
ShowSystemDiagnosticsWindow (Target_Object_name)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen object
Name of the system diagnostic window which is hidden or shown.

StartLogging

Description
Starts the logging of data or alarms in the specified log. The function can also be applied to 
audit trails.       

You can interrupt logging at runtime using the "StopLogging" system function.

Use in the function list
StartLogging (Log type, Log)

Use in user-defined functions
StartLogging (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail

Log
Name of the log which is started.

StartNextLog

Description
Stops the logging of data or alarms for the given log.
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Logging is continued in the next log of the segmented circular log you configured for the 
specified log.

If you did not configure a segmented circular log for the specified log, the system function has 
no effect.       

Use in the function list
StartNextLog (Log type, Log)

Use in user-defined functions
StartNextLog (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

Log
Name of the log for which the logging is stopped and continued in the next log.

StartProgram

Description
Starts the specified program on the HMI device.       

The runtime software continues running in the background. Alarms continue to be output and 
data continues to be updated.

When the given application is exited, the screen which was active during the performance of 
the system function is displayed on the HMI device.
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This system function is used, for example, to edit recipe data records in MS Excel on the HMI 
device.

 

 Note

If Windows CE is installed on the HMI device, during the configuration it must be checked 
whether the desired application can be started with this system function.

This system function allows all applications to be started which can be started in the "Execute" 
dialog of Windows CE.

The application to be started must be installed on the HMI device.
 

Use in the function list
StartProgram (Program name, Program parameters, Layout, Wait for program to end)

Use in user-defined functions
StartProgram (Program_name, Program_parameters, Display_mode, 
Wait_for_program_to_end)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Program name
Name and path of the program which is started. Upper and lower case are taken into account 
in this parameter.

 

 Note

If the path contains spaces, the program can only be started correctly if the path is specified 
in inverted commas, e.g. "C:\Program Files\START\start.exe".

 

Program parameters
The parameters you transfer at the start of the program, for example a file that is opened after 
the start of the program. 

The description of the necessary parameters is found in the documentation of the program to 
be started.

Layout
Determines how the program window is displayed on the HMI device:

0 (hmiShowNormal) = Normal

1 (hmiShowMinimized) = Minimized

2 (hmiShowMaximized) = Maximized
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3 (ShowMinimizedAndInactive) = Minimized and inactive

Wait for program to end
Determines whether there is a change back to the project after the called up program has 
ended:

0 (hmiNo) = No: No change to project

1 (hmiYes) = Yes: Change to project
 

 Note

The "Wait for program to end" parameter is only available for Runtime Advanced and Panels.
 

StopLogging

Description
Stops the logging of process values or alarms in the specified log. The function can also be 
applied to audit trails.       

The "StartLogging" system function is used to resume logging at runtime.
 

 Note

When logging is stopped, a connection between WinCC and the log files or log database still 
exists. Use the "CloseAllLogs" system function to disconnect this connection.

 

Use in the function list
StopLogging (Log type, Log)

Use in user-defined functions
StopLogging (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail
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Log
Name of the log that is stopped.

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. The "Open Archive" button opens all logs and 
continues logging in the specified log.

StopRuntime

Description
Exits the runtime software and thereby the project running on the HMI device.       

Use in the function list
StopRuntime (Mode)

Use in user-defined functions
StopRuntime (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Mode
Determines whether the operating system is shut down after exiting runtime.

0 (hmiStopRuntime) = Runtime: Operating system is not shut down

1 (hmiStopRuntimeAndOperatingSystem) = Runtime and operating system: The operating 
system is shut down (not possible with WinCE)
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Example
The following program code shuts down Runtime and the operating system.

 
{
 
//Stop runtime and shutdown
StopRuntime (hmiStopRuntimeAndOperationSystem);
 
}

The saved return value can be processed in the following code.

WinACMPGetVersion

Description
Reads out the value of the version number of WinAC MP.       

Use in the function list
WinACMPGetVersion (Version, Action)

Use in user-defined functions
WinACMPGetVersion (Version, Action)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

Version
The tag that contains the value.

Action
Determines whether the version number is read out: 

0 (SwitchOff) = Off: Version number is not read out.

1 (SwitchOn) = On: Version number is read out.

WinACMPSetStartAtBoot

Description
Determines whether or not WinAC MP is started automatically after startup of the HMI 
device.       
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Use in the function list
WinACMPSetStart at boot(Start at boot)

Use in user-defined functions
WinACMPSetStartAtBoot (Start at boot)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

StartAtBoot
Defines whether WinAC MP is started automatically. 

0 (StartAtBootOff) = Off: WinAC MP is not started on startup of the HMI device.

1 (StartAtBootOn) = On: WinAC MP is started automatically on startup of the HMI device.

WinACSetStartMode 

Description
Sets the operating mode of WinAC MP after startup of the HMI device.       

Use in the function list
WinACSetStartMode (Autostart)

Use in user-defined functions
WinACSetStartMode (Autostart)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

Action
Defines whether the Autostart function of WinAC MP is activated. 

0 (AutoStartOff) = Off: After startup, WinAC MP remains in the STOP operating mode.

1 (AutoStartOn) = On: After startup, WinAC MP changes to the operating mode it was in before 
it was closed.
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VBScript for Windows

VBScript for Windows

VBScript
If you have worked with Visual Basic or Visual Basic for applications, then VBScript will seem 
familiar to you. If you do not know Visual Basic and are getting familiar with it, then you will 
learn all Visual Basic programming languages at once. The step-by-step guides from Microsoft 
Press are a good introduction to programming.

You will find fundamental information on VBScript language elements on the Microsoft 
homepage:

http://msdn.microsoft.com/en-us/library/t0aew7h6.aspx 

Local ID (LCID)
An overview of all language codes can be found on the Microsoft homepage:

http://msdn.microsoft.com/en-us/goglobal/bb964664

VBScript for Windows CE

VBScript for Windows CE

Attr

Function
This property of the File control returns a number indicating the file mode that was used to 
open the file.

Syntax
file.Attr

Parameters

File
Reference to a File control.
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Return values
The return values listed in the following table indicate the file access mode. If the return value 
is 0, the file is closed.

Constant Value
None 0
fsModeInput 1
fsModeOutput 2
fsModeRandom 4
fsModeAppend 8
fsModeBinary 32

Remarks
The Attr property is read-only. Use the Open method of the File control to set the file mode.

Close

Function
This method closes an open File control.

Syntax
file.Close

Parameters

File
Name of a File control.

Return Values
None.

Remarks
Use the Open method to open a file.
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CreateObject

Function
This function creates a reference to an Automation object.

Syntax
CreateObject (Object)

Parameters

Object
A string containing the ProgID of the object to create.

Return values
Returns a reference to an Automation object.

Remarks
Use CreateObject to create non-visible ActiveX controls at runtime. You cannot use 
CreateObject to create graphical objects such as a TreeView control or a ListView control. 
CreateObject produces objects that cannot respond to events. To produce objects that can 
respond to events, use the CreateObjectWithEvents function. The following table lists the 
ProgIDs for the ActiveX controls without events.

Control ProgID
Microsoft CE File control 6.0 .file
Microsoft CE FileSystem control 6.0 .filesystem
Microsoft CE ImageList control 6.0 CEimageList.imagelistctrl

Example

 
Dim f, fwModeAppend
Set f = CreateObject("FileCtl.File")
fwModeAppend=8
f.Open "\Storage Card\testfile.txt", fwModeAppend
f.Close
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Dir

Function
This method returns the name of a file, directory, or folder that matches a specified pattern or 
file attribute.

Syntax
File.Dir (Pathname,[Attributes])

Parameters

File
Reference to a FileSystem control.

Pathname
Optional. String expression that specifies a file name or path.

Attributes
Optional. Numeric expression whose sum specifies file attributes. If omitted, all files that match 
pathname are returned.

The following table describes the parameter settings of attributes.

Constant Value Description
fsAttrNormal 0 Normal
fsAttrReadOnly 1 Read only
fsAttrHidden 2 Hidden
fsAttrSystem 4 System file
fsAttrVolume 8 Volume label. If specified, all other attributes are ignored.
fsAttrDirectory 16 Directory or folder
fsAttrArchive 32 Logs

Return values
String. File name that matches pathname and attributes. Dir returns a zero-length string ("") if 
pathname is not found.

Remarks
Dir supports the use of multiple-character (*) and single-character (?) wildcards to specify 
multiple files. You must specify pathname the first time you call the Dir method. In addition, if 
you specify file attributes you must include pathname.
The Dir method returns the first file name that matches pathname. To get any additional file 
names that match pathname, call Dir again with no parameters. When no more file names 
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match, Dir returns a zero-length string (" "). Once a zero-length string is returned, you must 
specify pathname in subsequent calls.

EOF

Function
This property returns True when the end of a file opened for random or sequential input is 
reached.

Syntax
File.EOF

Parameters

File
Reference to a File control.

Remarks
Use the EOF property to avoid the error generated by attempting to read past the end of a file.

The EOF property returns False until the end of the file has been reached. For files opened 
with a fsModeRandom or fsModeBinary file mode, EOF returns False until the last executed 
Get statement is unable to read an entire record.

For files opened with a fsModeBinary file mode, an attempt to read through the file using the 
Input function until EOF returns True generates an error. Use the LOF and LOC properties 
instead of EOF when reading binary files with Input, or use Get when using the EOF property. 
For files opened with a fsModeOutput file mode, EOF always returns True.

FileCopy

Function
This method copies an existing file to a new file.

Syntax
Filesystem.FileCopy PathName, NewPathName

Parameters

Filesystem
Reference to a FileSystem object.
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PathName
String that contains the path and file name.

NewPathName
String that contains the file name and path of the new file.

Return Values
None.

Remarks
FileCopy returns an error if the new file does not exist.

FileLen

Function
This method returns a value specifying the length, in bytes, of a file.

Syntax
Filesystem.FileLen(pathname)

Parameters

Filesystem
Reference to a FileSystem control.

Pathname
Required. String expression that specifies a file. The pathname can include a directory or folder.

Return Values
Returns the number of bytes in a file.

Remarks
If the specified file is open when the FileLen method is called, the value returned represents 
the size of the file immediately before it was opened.
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FileDateTime

Function
This method returns a variant (Date) that indicates the date and time when a file was created 
or last modified.

Syntax
filesystem.FileDateTime(pathname)

Parameters

Filesystem
Reference to a FileSystem control.

Pathname
Required. String expression that specifies a file name. The pathname can include a directory 
or folder.

Return Values
Returns the date the file was last modified.

Remarks
FileDateTime returns an error if the new file does not exist.

 

Get

Function
This method reads data from an open disk file into a variable.

Syntax
file.Get Data, [Recnumber]

Parameters

File
Reference to a File control.
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Data
Required. Variant variable into which data is read.

Recnumber
Optional. Variant. Record number at which reading begins. For files opened in binary mode, 
Recnumber specifies the byte position.

Return Values
None

Remarks
Data read with the Get method usually is written to a file with the Put method. The first record 
or byte in a file is at position 1, the second record or byte is at position 2, and so on. If you omit 
Recnumber, the next record or byte following the last Get or Put method (or pointed to by the 
last Seek function) is read.

For files opened in Random mode, the following rules apply:

● If the length of the data being read is less than the length specified in the Len clause of the 
Open method, Get reads subsequent records on record-length boundaries. The space 
between the end of one record and the beginning of the next record is padded with the 
existing contents of the file buffer. Because the amount of padding data cannot be 
determined with any certainty, it is generally advisable to match the record length with the 
length of the data being read.

● If Data is a Variant of numeric type, Get reads 2 bytes identifying the VarType of the Variant 
and then reads the data that goes into the variable. For example, when reading a Variant 
of VarType 3, Get reads 6 bytes: 2 bytes identifying the Variant as VarType 3 (Long) and 
4 bytes containing the Long data. The record length specified by the Len clause in the Open 
method must be at least 2 bytes greater than the actual number of bytes required to store 
the variable.

● You can use the Get method to read a Variant array from a disk, but you cannot use Get 
to read a scalar Variant containing an array. You also cannot use Get to read objects from 
a disk.

● If the variable being read into is a Variant of VarType 8 (String), Get reads 2 bytes identifying 
the VarType and 2 bytes indicating the length of the string. Then it reads the string data. 
The record length specified by the Len clause in the Open method must be at least 4 bytes 
greater than the actual length of the string.

● If the variable being read into is a dynamic array, Get reads a descriptor whose length 
equals 2 plus 8 times the number of dimensions, that is, 2 + 8 * NumberOfDimensions. The 
record length specified by the Len clause in the Open method must be greater than or equal 
to the sum of all the bytes required to read the array data and the array descriptor.

For files opened in Binary mode, the Len clause in the Open method has no effect. Get reads 
all variables from a disk contiguously; that is, with no padding between records.
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GetAttr

Function
This method returns a number representing the attributes of a file, directory, or folder.

Syntax
filesystem.GetAttr(pathname)

Parameters

File system
Reference to a FileSystem control.

Pathname
Required. String expression that specifies a file name or directory or a folder name. The 
pathname can include the directory or folder.

Return values
Sum of attribute values. The following table shows the sums that can be returned.

Constant Value Description
vbNormal 0 Normal
VbReadOnly 1 Read only
VbHidden 2 Hidden
VbSystem 4 System
VbDirectory 16 Directory or folder
VbArchive 32 File has changed since last backup

Remarks
To determine which attributes are set, use the And operator to perform a bitwise comparison 
of the value returned by the GetAttr method and the value of the individual file attribute you 
want. If the result is not zero, that attribute is set for the named file.

Input

Function
This method returns a string containing characters from a file opened in Input or Binary mode.
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Syntax
file.Input(number)

Parameters

File
Reference to a File control.

Number
Any valid numeric expression that specifies the number of characters to return.

Return Values
String containing characters read from file.

Remarks
Data read with the Input method usually is written to a file with the LinePrint or Put functions. 
Use this method only with files opened in Input or Binary mode.

Unlike the LineInputString method, the Input method returns all the characters it reads, 
including commas, carriage returns, line feeds, quotation marks, and leading spaces.

With files opened for Binary access, an attempt to read through the file using the Input method 
until the EOF function returns True generates an error. To avoid an error, use the LOF and 
Loc functions instead of EOF when reading binary files with the Input method or use Get when 
using the EOF function.

InputFields

Function
This method reads data from an open sequential file and returns a single dimension Variant 
array.

Syntax
file.InputFields(number)

Parameters

File
Reference to a File control.

Number
Number of comma-delimited fields to read from the file.
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Return values
Array containing the fields read from the file.

Remarks
Data read with the InputFields method usually is written to a file with WriteFields. Use this 
method only with files opened in Input or Binary mode.

InputFields reads standard string or numeric data without modification. The following table 
shows how InputFields reads other input data.

Data Value Assigned to Variable
Delimiting comma or blank line Empty
#ZERO# Zero
#TRUE# or #FALSE# True or False
#yyyy-mm-dd hh:mm:ss# The date and/or time represented by the expression

Double quotation marks ("") within input data are discarded.
If you reach the end of the file while you are inputting a data item, the input is terminated and 
an error occurs.

To correctly read data from a file into variables using InputFields, use the WriteFields method 
instead of the LinePrint method to write the data to the files. Using WriteFields ensures each 
separate data field is properly delimited.

InputB

Function
This method returns bytes from a file opened in Input or Binary mode.

Syntax
file.InputB(number)

Parameters

File
Reference to a File control.

Number
Any valid numeric expression that specifies the number of bytes to return.

Return Values
Array containing bytes read from file.
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Remarks
Data read with the InputB method usually is written to a file with the LinePrint or Put functions. 
Use this method only with files opened in Input or Binary mode.

 

Kill

Function
This method deletes files from a disk.

Syntax
filesystem.Kill pathname

Parameters

Filesystem
Reference to a FileSystem control.

Pathname
Required. String expression that specifies one or more file names to be deleted. The pathname 
can include the directory or folder.

Return Values
None.

Remarks
The Kill method supports the use of multiple-character (*) and single-character (?) wildcards 
to specify multiple files.
An error occurs if you try to use Kill to delete an open file.

LineInputString

Function
This method reads a single line from an open sequential file and assigns it to a string variable.

Syntax
file.LineInputString
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Parameters

File
Reference to a File control.

Return Values
None.

Remarks
Data read with LineInputString usually is written from a file with LinePrint.
The LineInputString method reads from a file one character at a time until it encounters a 
carriage return (Chr(13)) or carriage return/line feed (Chr(13) + Chr(10)) sequence. Carriage 
return/line feed sequences are skipped rather than appended to the character string.

LinePrint

Function
This method writes a single line to an open sequential file.

Syntax
file.LinePrint output

Parameters

File
Reference to a File control.

Output
String expression to write to a file.

Return Values
None.

Remarks
Data written with LinePrint is usually read from a file with LineInputString.
A carriage return/line feed (Chr(13) + Chr(10)) sequence is appended to the end of the string.

 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3891



Loc

Function
This property returns a number specifying the current read/write position.

Syntax
file.Loc

Parameters

File
Reference to a File control.

Remarks
For files opened with the fsModeRandom file mode, Loc returns the number of the last record 
read or written. For files opened with all other modes, Loc returns the position of the last byte 
read or written.

 

LOF

Function
This property returns a number representing the size, in bytes, of a file.

Syntax
file.LOF

Parameters

File
Reference to a File control.

Remarks
The LOF property can be used with the Loc property to guarantee that a read operation does 
not continue past the end of a file.
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MkDir

Function
This method creates a new directory.

Syntax
filesystem.MkDir PathName

Parameters

Filesystem
Reference to a FileSystem control.

Pathname
String expression that contains the directory name.

Return Values
None.

Remarks
MkDir generates an error if the directory already exists.

MoveFile

Function
This method renames an existing file or a directory, including all its subdirectories.

Syntax
filesystem.MoveFile PathName, NewPathName

Parameters

Filesystem
Reference to a FileSystem control.

PathName
String that contains the file name.
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NewPathName
String that contains the file name to copy to.

Return Values
None.

Open

Function
This method opens a file in either the Input (1), Output (2), Random (4), Append (8), or Binary 
mode (32).

Syntax
file.Open pathname, mode, [access], [lock], [reclength]

Parameters

File
Reference to a File control.

Pathname
String expression that specifies a file name.

Mode
Specifies the file mode: Input (1), Output (2), Random (4) , Append (8), or Binary (32).

Access
Operation permitted on the open file: Read, Write, or ReadWrite [Default]. (1, 2, 3)

Lock
Operations permitted on the open file by other processes: Shared, LockRead, LockWrite 
[Default], and LockReadWrite. (1, 2, 3, 0)

Reclength
Number, in bytes, that is less than 32,767. For files opened for random access, this value is 
the record length. For sequential files, this value is the number of characters buffered.

Return Values
None.
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Remarks
The reclength parameter is ignored if the mode is Binary. When opening a file in Random 
mode, you must specifiy a record size of greater than zero or an error will occur.

 

Put

Function
This method writes data from a variable to a disk file.

Syntax
file.Put data, [recnumber]

Parameters

Data
Required. Variant variable that contains data to be written to disk.

Recnumber
Optional. Variant (Long). Record number (Random mode files) or byte number (Binary mode 
files) at which writing begins.

Return Values
None.

Remarks
Data written with Put usually is read from a file with Get.
The first record or byte in a file is at position 1, the second record or byte is at position 2, and 
so on. If you omit recnumber, the next record or byte after the last Get or Put method or pointed 
to by the last Seek function is written.

For files opened in Random mode, the following rules apply:
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● If the length of the data being written is less than the length specified in the Len clause of 
the Open method, Put writes subsequent records on record-length boundaries. The space 
between the end of one record and the beginning of the next record is padded with the 
existing contents of the file buffer. Because the amount of padding data cannot be 
determined with any certainty, it generally is a good idea to have the record length match 
the length of the data being written. If the length of the data being written is greater than 
the length specified in the Len clause of the Open method, an error occurs.

● If the variable being written is a Variant of a numeric type, Put writes 2 bytes identifying the 
VarType of the Variant and then writes the variable. For example, when writing a Variant 
of VarType 3, Put writes 6 bytes: 2 bytes identifying the Variant as VarType 3 (Long) and 
4 bytes containing the Long data. The record length specified by the Len clause in the Open 
method must be at least 2 bytes greater than the actual number of bytes required to store 
the variable.

You can use the Put method to write a Variant array to disk, but you cannot use Put to write 
a scalar Variant containing an array to disk. You also cannot use Put to write objects to disk.
If the variable being written is a Variant of VarType 8 (String), Put writes 2 bytes identifying 
the VarType and 2 bytes indicating the length of the string. It then writes the string data. The 
record length specified by the Len clause in the Open method must be at least 4 bytes greater 
than the actual length of the string.

If the variable being written is a dynamic array, Put writes a descriptor whose length equals 2 
plus 8 times the number of dimensions, that is, 2 + 8 * NumberOfDimensions. The record length 
specified by the Len clause in the Open method must be greater than or equal to the sum of 
all the bytes required to write the array data and the array descriptor. For example, the following 
array declaration requires 118 bytes when the array is written to disk.

For files opened in Binary mode, the Len clause in the Open method has no effect. Put writes 
all variables to disk contiguously; that is, with no padding between records.

RmDir

Function
This method deletes an existing empty directory.

Syntax
filesystem.RmDir PathName

Parameters

Filesystem
Reference to a FileSystem control.

PathName
String that contains the directory name.
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Return Values
None.

Remarks
The directory must be empty before it can be removed. You must specify a complete file path.

Seek

Function
This property returns and sets the next position in a file that will be read or written.

Syntax
file.Seek [= position]

Parameters

File
Reference to a File control.

Position
Numeric expression that specifies a position within a file.

Remarks
The Seek property specifies the next file position, whereas the Loc property specifies the 
current position. Seek always will be one more than Loc, except when a file is first opened and 
Seek and Loc are both 1.

Negative Seek or 0 causes an error.

 

SetAttr

Function
This method sets attribute data for a file.

Syntax
filesystem.SetAttr pathname, attributes
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Parameters

File system
Reference to a FileSystem control.

Pathname
Required. String expression that specifies a file name.

Attributes
Required. Numeric expression whose sum specifies file attributes. The following table shows 
the parameter settings of attributes.

Constant Value Description
vbNormal 0 Normal (default)
vbReadOnly 1 Read only
vbHidden 2 Hidden
VbSystem 4 System file
VbArchive 32 File has changed since last backup

Return values
None.

Remarks
A run-time error occurs if you try to set the attributes of an open file.

WriteFields

Function
This method writes data to a sequential file.

Syntax
file.WriteFields [data]

Parameters

File
Reference to a File control.

Data
Variant or Variant array of numeric or string expressions to write to a file.
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Prinzip

Return Values
None.

Remarks
Data written with WriteFields is usually read from a file with InputFields.
If you omit d ata, a blank line is printed to the file.

● Numeric data is always written using the period as the decimal separator.

● For Boolean data, either #TRUE# or #FALSE# is printed. The True and False keywords 
are not translated, regardless of locale.

● Date data is written to the file using the universal date format. When either the date or the 
time component is missing or is zero, only the component provided gets written to the file.

● Nothing is written to the file if Data is Empty. However, for Null data, #NULL# is written.

● If d ata is Null, #NULL# is written to the file.

The WriteFields method inserts commas between items and quotation marks around strings 
as they are written to the file. You do not have to put explicit delimiters in the list. WriteFields 
inserts a newline character—that is, a carriage return/line feed (Chr(13) + Chr(10))—after it 
has written the final character in data to the file.

VBS object model

VBS object model

VBS object model in WinCC
The following screen shows the VBS object model in WinCC:
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Use the WinCC object model of the graphic Runtime system to access objects and tags in 
Runtime.
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Objects
Objects and lists are provided for access to all the objects in the graphic Runtime systems:

● Display and operating objects

● Screens

● Layers

● Tags

Properties
You can specifically change the display and operating elements and tags in Runtime via the 
properties of the individual objects. For example, you can enable a button with a click or trigger 
a color change by changing a tag value.

Methods
Methods which are applied to individual objects can be used to read out tag values for further 
processing or displaying alarms in Runtime. 
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See also
ActiveProject (Page 4151)

ActiveScreen (Page 4151)

ActiveScreenItem (Page 4153)

AlarmLogs (list) (Page 3916)

DataItem (Page 3917)

DataLogs (list) (Page 3919)

DataSet (list) (Page 3920)

Logging (Page 3928)

Screen (Page 3931)

Layer (Page 3925)

Layers (list)  (Page 3927)

ScreenItems (list) (Page 3935)

ScreenItem (Page 3933)

Tag (Page 3942)

Tags (list) (Page 3945)

TagSet (list)  (Page 3946)

HMIRuntime  (Page 3923)

Alarm (Page 3913)

Alarms (list) (Page 3914)

Processvalue (Page 4461)

Screen object (list) (Page 3937)
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Objects

HMIRuntime

Description

Portrays the graphic runtime system. 

The HMIRuntime object contains properties and methods which return the objects to the main 
layer, e.g. returns the ActiveScreen property of a screen object.   

Application
You use the "HMIRuntime" object, e.g. as follows:

● Read or set the current Runtime language ("Language" property).

● Read name of current base screen or trigger a base screen change by setting a new screen 
name (property "BaseScreenName")

● Access tags (List "SmartTags")

● End runtime (Method "Stop")

● Output information on sequence tracing output (Method "Trace")

● Access the screens displayed during runtime (List "Screens")

See also
ActiveScreen (Page 4152)

Screen (Page 3906)
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Screen object (list)

Description

A list of screen objects.

The list contains the following two elements:

● The first element with the index 0 represents the permanent window.

● The second element with the index 1 represents the root screen.

Alternatively, the two elements can be addressed with their their names as follows:

● Permanent window: "Overview"

● Root screen: Name of the screen displayed in the root screen 

If the named screen is not displayed, an error occurs during access.   

Permanent window "Overview" is displayed in the objects list and in Auto complete.
 

 Note

The alarm window and the alarm indicator are not contained in the screens list, even if they 
have the focus in Runtime.

 

Application
Use the screen property to return the screen list. In the following example, the background 
color is changed from black to green:

Use the object name as an index.
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'VBS_Example_BackColor
HMIRuntime.Screens("Rootscreen").BackColor = vbGreen

 

 Note

If you perform a screen change, the open references to the screen that is no longer available 
will become invalid. As a result, it is no longer possible to work with these references.

 

 

See also
Screen (Page 3906)

ScreenItems (Page 3909)

Screen

Description

Represents the process screen which is being displayed on the HMI device at the moment or 
the permanent window in runtime. The screen object is returned to you as a result of accessing 
the screen list. 

The screen object also contains a list of all graphic objects in the screen that can be addressed 
through the list "ScreenItems".
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Application
You can also use the screen object to do the following:

● Read the height and width of a screen (properties "Height" and "Width").

● Change the background color (property "BackColor").

Use the object name as an index.

In the following example, the background color is changed from black to green:

'VBS example background color
HMIRuntime.Screens("Rootscreen").BackColor = vbGreen

See also
ScreenItem (Page 3907)

ScreenItems (Page 3909)

HMIRuntime (Page 3903)

Screen object (list) (Page 3904)

ScreenItem

Description

Represents an object in the specified screen. The ScreenItem object is an element of the 
ScreenItems list.   
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Application
You can use the ScreenItem object to access the properties of graphic objects within a screen, 
depending on certain events.

You use the "ScreenItem" object as follows, for example:

● "Visible" property
Switch the visibility of an object on or off.

● "Height" and "Width" properties
Query the width and height of an object.

● "Top" and "Left" properties
Change the position of an object.

● "ObjectName" property
Read the name of a graphic object

● "Parent" property
Set a reference to the parent screen

Use the ScreenItems property to return an object to the screen. Use the object name as an 
index.

Example
In the following example, the background color of the "RootScreen" circle in the "myCircle" 
screen is set to green.

 
'VBS_Example_ScreenItems
 
Dim objCircle
Set objCircle = HMIRuntime.Screens("RootScreen").ScreenItems("myCircle")
objCircle.BackColor = vbGreen

 
 

 Note

To save memory space in the HMI device, no object names are loaded during transfer of the 
project. If you still want to transfer object names, call up the Runtime settings for the respective 
HMI device in WinCC. You can change the setting under "General". The object name is 
required when the object should be accessed via the object name or for debugging a project.

 

The "ScreenItem" object has different properties depending on its features. The following 
properties are provided for every "ScreenItem" object:

● Enabled

● Height

● Left

● ObjectName

● Parent
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● Top

● Type

● Visible

● Width

If a specific object type is addressed, further properties are added to the standard properties. 
The additional properties are provided in the descriptions of the individual object types.

See also
Screen (Page 3905)

Screen object (list) (Page 3904)

ScreenItems (Page 3909)

ScreenItems

Description

A list of screen item objects with all screen objects of the given process screen. The list has a 
parent property. This property provides a reference to the process screen in which the screen 
object is located. 
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Application
By means of the "ScreenItems" list you are able

● To edit or output all objects within the list (that is, all objects within a screen)

● To count the objects of a screen (property "Count").

● To work on a particular object in the list (method "Item").

Use the screen items property to return an object from the process screen. Use the object 
name as an index.

In the following example, the background color of the "RootScreen" circle in the "myCircle" 
screen is set to green.

 
Dim objCircle
Set objCircle = HMIRuntime.Screens("RootScreen").ScreenItems("myCircle")
objCircle.BackColor = vbGreen

See also
Screen (Page 3905)

HMIRuntime (Page 3903)

Screen object (list) (Page 3904)

SmartTags

Description

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3909



A list of SmartTag objects which represent all of the tags in WinCC Runtime.   
 

 Note

The SmartTags list has a limited range of functions. You can only use the tag names to access 
a SmartTag object. Access via the index or by using "For each" instruction is not supported.

 

 Note

In order to access a tag, which has still not been created in the project, using the SmartTags 
list, no value is returned. Assignment to a non-existing tag is not executed:

Dim intVar
intVar = SmartTags("FillLevel")
"intVar" remains empty when the "FillLevel" tag has not been created. 

 

Application
Use the SmartTags list to return a SmartTag object. Use the tag name to reference the 
SmartTag object.

 
'VBS_Example_SmartTags
'Writes tag value to local tag and returns a user-defined text through the 
operating system channel for debug alarms.
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(SmartTags("AirPressure"))
HMIRuntime.Trace strAirPressure

In Runtime Advanced and Panels you address the tag directly using its name. If the tag name 
corresponds to the VBS name conventions, you do not need to use the SmartTags list. Follow 
the example below:

 
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(AirPressure)
HMIRuntime.Trace strAirPressure

See also
Access to HMI tags (Page 3552)
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SmartTag

Description

Represents the value of the specified process tag. The SmartTag object is an element of the 
SmartTag list.   

Application
The SmartTag object provides read and write access to the value of the specified process tag. 
The SmartTag object does not return an object reference. Use the SmartTags list to return the 
value of a process tag. Use the tag name as an index.

Example

 
'VBS_Example_SmartTags
'Writes tag value to local tag and returns a user-defined text through the 
operating system channel for debug alarms.
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(SmartTags("AirPressure"))
HMIRuntime.Trace strAirPressure
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 Note

In order to access a tag, which has still not been created in the project, using the SmartTags 
list, no value is returned. Assignment to a non-existing tag is not executed:

Dim intVar
intVar = SmartTags("FillLevel")
"intVar" remains empty when the "FillLevel" tag has not been created. 

 

 Note

If you want to return the "TypeName" of a SmartTag object data type with the VBS function 
"TypeName", use the following syntax:

TypeName(SmartTags("FillLevel").value) 
 

Use "SmartTags("<tag>")(index)" to access the value of an array element. Set the number of 
the desired array element for "index", for example, "SmartTags("AirPressure")(2)". 

Objects

Alarm

Description  

Alarms
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The alarm object is used to access the Alarms object list.
 

 Note

The properties of the alarm object are not automatically updated when the values of the 
properties change.

 

See also
Alarms (list) (Page 3914)

HMIRuntime  (Page 3923)

Processvalue (Page 4461)

Alarms (list)

Description   

Alarms

Use the alarm object to trigger existing messages.

Usage
Using the "Alarms" list you can:

● Access a message in the list (Item method)

● Create a new alarm object (Create method)

● Read the alarm ID of the message (AlarmID attribute)
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● Read the status of a message (State property)

● Read the time stamp of the message (Timestamp property)

● Generate an instance of the alarm object (Instance property)

● Read the name of the computer on which the message came (ComputerName property)

● Read or set the name of the user who triggered the message (UserName property)

● Read or set the name of the process value blocks (ProcessValues property)

● Read or set the message commentary (Comment property)

● Read or set the message server prefix (Context property)

Example
In the following example the alarm with the alarm number "1" configured in the "HMI alarms" 
editor is activated.

 
'VBS360
Dim MyAlarm
Set MyAlarm = HMIRuntime.Alarms(1)
MyAlarm.State = 5 'hmiAlarmStateCome + hmiAlarmStateComment
MyAlarm.Comment = "MyComment"
MyAlarm.UserName = "Hans-Peter"
MyAlarm.ProcessValues(1) = "Process Value 1"
MyAlarm.ProcessValues(4) = "Process Value 4"
MyAlarm.Create "MyApplication"

See also
AlarmID (Page 4161)

Processvalue (Page 4461)

Alarm (Page 3912)

HMIRuntime  (Page 3923)
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AlarmLogs (list)

Description

You can use the object to reconnect swapped-out log segments of the alarm log to Runtime 
or to remove previously swapped-in log segments of the alarm log. The log segments to be 
swapped in are copied to the "Common logging" folder of the WinCC project. The previously 
swapped-in log segments are removed from the "Common logging" folder.

You use parameters to control the location from which log segments are to be swapped in. 
You specify the time period over which the log segments are to be swapped in or removed.

If an error occurs during the operation with log segments, the applied method returns an error 
alarm.

Usage
● "Restore" method

Previously swapped-out log segments of the alarm log are connected to Runtime.

● "Remove" method
Previously swapped-in log segments of the alarm log are removed from the Runtime project.

Example
In the following example, log segments from the alarm log are swapped in and the return value 
is output as a trace.

 
'VBS187
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HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.AlarmLogs.Restore("D:
\Folder","2004-09-14","2004-09-20",-1) & vbNewLine

See also
Restore (Page 4834)

Remove (Page 4829)

DataLogs (list) (Page 3919)

Logging (Page 3928)

DataItem

Description

You can use the DataItem object to access the contents of the DataSet list. Values or object 
references are stored in the list as DataItem. 

Access uses the name under which the value was added to the list. Single access using an 
index is not recommended since the index changes during adding or deleting of values. You 
can use the index to output the complete contents of the list. The output is in alphabetical order. 

 

 Note

For object references, ensure that the objects are capable of multi-threading. 
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Example
The example shows how the value of 'Motor1' is output as a trace.

 
'VBS163
HMIRuntime.Trace "motor1: " & HMIRuntime.DataSet("motor1").Value & vbNewLine

The following example enumerates all DataItem objects of the DataSet list. Name and value 
are output as a trace.

 
'VBS164
Dim data
For Each data In HMIRuntime.DataSet
HMIRuntime.Trace data.Name & ": " & data.Value & vbNewLine
Next

 
 

 Note

The value may not be output directly for objects.
 

See also
Screen (Page 3931)

HMIRuntime  (Page 3923)

DataSet (list) (Page 3920)

Value  (Page 4691)

Name  (Page 4417)

Screen object (list) (Page 3937)
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DataLogs (list)

Description

You can use the object to reconnect swapped-out log segments of the data log to Runtime or 
to delete previously swapped-in log segments of the data log. The log segments to be swapped 
in are copied to the "Common logging" folder of the WinCC project. The previously swapped-
in log segments are removed from the "Common logging" folder.

You use parameters to control the location from which log segments are to be swapped in. 
You specify the time period over which the log segments are to be swapped in or removed. 
You also set the type of log ("Fast data log", "Slow data log", "Fast data log and Slow data 
log").

If an error occurs during the operation with log segments, the applied method returns an error 
alarm.

Usage
● "Restore" method

Previously swapped out log segments of the data log are connected to Runtime.

● "Remove" method
Previously swapped-in log segments of the data log are removed from the Runtime project.
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Example
In the following example, log segments from the Fast data log are swapped in and the return 
value is output as a trace. 

 
'VBS188
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.DataLogs.Restore("D:
\Folder","2004-09-14","2004-09-20",-1,1) & vbNewLine

See also
Restore (Page 4834)

Remove (Page 4829)

AlarmLogs (list) (Page 3915)

Logging (Page 3928)

DataSet (list)

Description

Using the DataSet object, you can exchange data throughout several actions. 

A DataSet object is global and defined by the screen object. You can can access the data from 
any VBS action. 

You address the screen object according to the screen hierarchy . The DataSet object persists 
as long as the screen is displayed. The global object persists over the entire runtime time 
period. 
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Access uses the DataItem object. 
 

 Note

You cannot include objects with the types Screen, Screens, ScreenItem, ScreenItems, Tag 
and TagSet in the DataSet list. 

The DataSet object does not support any classes. 
 

Usage
Use the "DataSet" list as follows:

● Enumeration
Output or process all objects in the list

● "Count" property
Output the number of elements contained

● "Item" method
Work on a particular object in the list

● "Add" method
Add an object to the list

● "Remove" method
Remove a particular object from the list

● "RemoveAll" method
Remove all objects from the list

Access to list elements is made as follows: 

 
HMIRuntime.DataSet("Itemname")

For a picture-specific list, access is performed as follows: 

 
HMIRuntime.Screens("Screenname").DataSet("Itemname") 

You access the DataSet object of the screen as follows: 

 
DataSet("Itemname")

If upon access the stated name does not exist in the list, VT_Empty is returned and an 
Exception is triggered. 
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Example
The example shows how a value can be entered in the list, read and removed from the list 
throughout various actions.

 
'VBS162
HMIRuntime.DataSet.Add "motor1", 23
HMIRuntime.Trace "motor1: " & HMIRuntime.DataSet("motor1").Value & vbNewLine
HMIRuntime.DataSet.Remove("motor1")

See also
RemoveAll  (Page 4833)

Remove (Page 4829)

Item (Page 4810)

Add (Page 4749)

DataItem (Page 3916)

HMIRuntime  (Page 3923)

Screen (Page 3931)

Screen object (list) (Page 3937)
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HMIRuntime 

Description

The HMIRuntime object represents the graphic Runtime environment.

Usage
You can use the "HMIRuntime" object as follows:

● "Language" property
Read or set the current Runtime language

● "BaseScreenName" property
Read or set the name of the current root screen

● "ActiveProject" property
Read the path of the active Runtime project
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● "Tags" property
Accessing tags

● "DataSet" property
Accessing tags in a list

● "Stop" method
Stop Runtime

● "Trace" method
Display messages in a diagnostics window

Example
The following command closes WinCC Runtime:

 
'VBS3
HMIRuntime.Stop

See also
Trace (Page 4854)

Stop (Page 4853)

Logging (Page 3928)

DataSet (list) (Page 3919)

Language (Page 4351)

Tags (Page 4571)

Logging  (Page 4386)

DataSet  (Page 4262)

CurrentContext (Page 4254)

ActiveProject (Page 4151)

MenuToolBarConfig  (Page 4396)

Alarm (Page 3912)

Alarms (list) (Page 3913)

Tag (Page 3942)

Tags (list) (Page 3945)

DataItem (Page 3916)

Screen (Page 3931)

Screen object (list) (Page 3937)

ActiveScreen (Page 4151)
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Item

Description
The Item object provides a reference to the current object.

Usage
Use the Item object, for example, to address the properties of the object currently selected in 
the screen.

Example
In the following example, you set the background color of the object selected in the screen to 
red: 

 
'VBS195
Item.BackColor = RGB(255,0,0)

Layer

Description

The Layer object returns the result of access to the layers list.
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Parent object
Screen in which the screen layer is located

Usage
Depending on certain events, you can use the Layer object to obtain access to the properties 
of a complete layer to hide or display a layer with operating elements according to the operator 
authorization.

You can use the "Layer" object as follows:

● "Visible" property
Activate or deactivate visibility of a layer

● "Name" property
Read the name of a layer

 

  Note

The layer property specifies the layer in which the object is located. The layer "0" is output 
as layer "0".

When accessed, the layers are counted up from 1 in VBS. Therefore, address level "1" 
with "Layers(2)".

 

Example
In the following example, Layer 1 is set to "invisible":

 
'VBS4
Layers(2).Visible = vbFalse

See also
Name  (Page 4417)

Layers (list)  (Page 3927)

Screen (Page 3931)

Screen object (list) (Page 3937)
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Layers (list) 

Description

Use the layers list to access all 32 layers of the graphical Runtime system.

Parent object
Screen in which the screen layer is located

Usage
You use the "Layers" list as follows:

● "_NewEnum" property
Process all layers in the list

● "Count" property
Count all layers contained in the list

● "Item" method
Process a layer from the list

The properties represent default properties and methods of a list and are not described in detail 
in the WinCC documentation.
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See also
Item (Page 4810)

Layer (Page 3924)

Screen (Page 3931)

Screen object (list) (Page 3937)

Logging

Description

You can use the object to reconnect swapped-out log segments to Runtime or to remove 
previously swapped-in log segments. The log segments to be swapped in are copied to the 
"Common logging" folder of the WinCC project. The previously swapped-in log segments are 
removed from the "Common logging" folder.

You use parameters to control the location from which log segments are to be swapped in. 
You specify the time period over which the log segments are to be swapped in or removed.

If an error occurs during the operation with log segments, the applied method returns an error 
alarm.
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Usage
● "Restore" method

Previously swapped out log segments of the alarm log and the data log are connected to 
Runtime.

● "Remove" method
Previously swapped-in log segments of the alarm log and data log are removed from the 
Runtime project.

Example
In the following example, log segments from the alarm log and data log are swapped in and 
the return value is output as a trace. 

 
'VBS189
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Restore("D:
\Folder","2004-09-14","2004-09-20",-1) & vbNewLine

See also
Restore (Page 4834)

Remove (Page 4829)

DataLogs (list) (Page 3918)

AlarmLogs (list) (Page 3915)

DataLogs (Page 4261)

AlarmLogs (Page 4162)

HMIRuntime  (Page 3922)
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Project

Description

Using the object, you can query information from the current Runtime project. 

The project object is returned as the result of ActiveProject.

Usage
You can read the following using the "Project" object: 

● The path of the current Runtime project ("Path" property)

● The name of the current Runtime project, without path or file extension ("Name" property)

Example
The following example returns name and path of the current Runtime project as a trace:

 
'VBS159
HMIRuntime.Trace "Name: " & HMIRuntime.ActiveProject.Name & vbNewLine
HMIRuntime.Trace "Path: " & HMIRuntime.ActiveProject.Path & vbNewLine

See also
ActiveProject (Page 4151)

Name  (Page 4417)

Path  (Page 4447)
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Screen

Description

Represents the screen which is being displayed on the HMI device at the moment or the 
permanent window in Runtime. The screen object is returned as a result of accessing the 
screen list. 

The screen object also contains the following lists:

● You can address all the graphic objects in the addressed screen using the "ScreenItems" 
list.

● You can address all the layers in the addressed screen using the "Layers" object.

Application
You can use the screen object for the following actions, for example:

● "Width" and "Height" properties
Reading the width and height of a screen

● "BackColor" property
Changing the background color

Use the object name as an index.

Example
In the following example, the background color is changed from black to green:

 
'VBS_Example_BackColor
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HMIRuntime.Screens("Rootscreen").BackColor = vbGreen

Parent object
Screen window in which the screen object is embedded.

If the screen object is the root screen, the parent object is not defined and set to zero. 
 

 Note

If you perform a screen change, the open references to screens that are no longer available 
will become invalid. As a result, it is no longer possible to work with these references.

 

Example
In the following example, the width of the first screen is increased by 20 pixels in Runtime:

 
'VBS7
Dim objScreen
Set objScreen = HMIRuntime.Screens(1)
MsgBox "Screen width before changing: " & objScreen.Width
objScreen.Width = objScreen.Width + 20
MsgBox "Screen width after changing: " & objScreen.Width

Notes on Cross References
All the screens you address with the standard formulation are automatically compiled by the 
CrossReference of WinCC and then listed in the screen properties.

 
HMIRuntime.BaseScreenName = "Screenname"

If you call screens with different formulations in the code, you make them known by the 
following section of the CrossReference:

 
' ' WINCC:SCREENNAME_SECTION_START
Const ScreenNameInAction = "ScreenName"
' WINCC:SCREENNAME_SECTION_END
The section can be inserted in VBS actions as often as required.
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See also
Refresh (Page 4828)

Activate (Page 4744)

ObjectSizeDeclutteringEnable (Page 4426)

ObjectSizeDeclutteringMax  (Page 4426)

ObjectSizeDeclutteringMin (Page 4427)

LayerDeclutteringEnable (Page 4364)

Layers (Page 4365)

DataSet  (Page 4262)

ExtendedZoomingEnable  (Page 4292)

AccessPath (Page 4149)

HMIRuntime  (Page 3922)

ScreenItems (list) (Page 3935)

Screen object (list) (Page 3937)

ScreenItem

Description

Represents an object in the specified screen. The ScreenItem object is an element of the 
ScreenItems list.   
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Application
You can use the ScreenItem object to access the properties of graphic objects within a screen, 
depending on certain events.

You use the "ScreenItem" object as follows, for example:

● "Visible" property
Switch the visibility of an object on or off.

● "Height" and "Width" properties
Query the width and height of an object.

● "Top" and "Left" properties
Change the position of an object.

● "ObjectName" property
Read the name of a graphic object

● "Parent" property
Set a reference to the parent screen

Use the ScreenItems property to return an object to the screen. Use the object name as an 
index.

Example
In the following example, the background color of the "RootScreen" circle in the "myCircle" 
screen is set to green.

 
'VBS_Example_ScreenItems
 
Dim objCircle
Set objCircle = HMIRuntime.Screens("RootScreen").ScreenItems("myCircle")
objCircle.BackColor = vbGreen

 
 

 Note

To save memory space in the HMI device, no object names are loaded during transfer of the 
project. If you still want to transfer object names, call up the Runtime settings for the respective 
HMI device in WinCC. You can change the setting under "General". The object name is 
required when the object should be accessed via the object name or for debugging a project.

 

The "ScreenItem" object has different properties depending on its features. The following 
properties are provided for every "ScreenItem" object:

● Enabled

● Height

● Left

● ObjectName

● Parent
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● Top

● Type

● Visible

● Width

If a specific object type is addressed, further properties are added to the standard properties. 
The additional properties are provided in the descriptions of the individual object types.

See also
Activate (Page 4744)

Layer (Page 4355)

Screen (Page 3930)

ScreenItems (list) (Page 3935)

Screen object (list) (Page 3937)

ScreenItems (list)

Description

A list of ScreenItem objects with all screen objects of the specified screen. The list has a 
"Parent" property. This "Parent" property provides a reference to the screen in which the screen 
object is located. 
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Usage
You use the "ScreenItems" list as follows:

● To edit or output all objects within the list (that is, all objects within a screen)

● "Count" property
Count the objects of a screen

● "Item" method
Work on a particular object in the list

Use the screen items property to return an object from the screen. Use the object name as an 
index.

Example
In the following example, the background color of the "RootScreen" circle in the "myCircle" 
screen is set to green.

 
Dim objCircle
Set objCircle = HMIRuntime.Screens("RootScreen").ScreenItems("myCircle")
objCircle.BackColor = vbGreen

Peculiarities of the ScreenItem object
If you embed an external control (ActiveX control or OLE object) in WinCC, the properties of 
the embedded control may have the same names as the general properties of the ScreenItem 
object. In this case, the ScreenItem properties take priority.

You can address the properties of the embedded controls, however, via the "object" property. 
The "object" property is only available in ActiveX controls and OLE objects.

Example:

 
'Control1 is an embedded ActiveX-Control with property "type"
'VBS196
Dim Control
Set Control=ScreenItems("Control1")
Control.object.type
 
'Control1 is a WinCC-Control
'VBS197
Dim Control
Set Control=ScreenItems("Control1")
Control.type
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Example
In the following example, you output the name of the objects in the current screen in a message 
box:

 
Sub OnClick(ByVal Item)
'VBS6
Dim lngAnswer
Dim lngIndex
lngIndex = 1
For lngIndex = 1 To ScreenItems.Count
lngAnswer = MsgBox(ScreenItems(lngIndex).Objectname, vbOKCancel)
If vbCancel = lngAnswer Then Exit For
Next
End Sub

See also
Item (Page 4810)

ScreenItem (Page 3932)

Screen (Page 3930)

Screen object (list) (Page 3937)

Screen object (list)

Description
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Several screens can be opened simultaeously in WinCC Runtime by means of the screen 
window technique, whereby there is only one main screen. The "Screens" list allows access 
to all open screens in Runtime using the screen name. The screen list contains all hidden 
screens. 

The access key required in the VBS environment in the HMIRuntime.Screens(<access key>) 
instruction must conform to the following syntax description:

 
[<Root screen name>.]<Screen window name>[:<Screen name>] ...
.<Screen window name>[:<Screen name>]

● The access key represents the screen hierarchy.

● You can omit the screen name at all locations in the key.

● The "AccessPath" property of the "Screen" object corresponds to the full access key.

● The root screen can be addressed via the "" access key.

Examples
The screens are addressed by specifying the hierarchy in the list. You can address the screens 
with or without using the screen names. In the following example, a "BaseScreenName" root 
screen is configured with a "ScreenWindow". The screen window contains a "ScreenName" 
screen.

Addressing using the screen name

 
'VBS8
Set objScreen = HMIRuntime.Screens("BaseScreenName.ScreenWindow:ScreenName")

Addressing without using the screen name

 
'VBS9
Set objScreen = HMIRuntime.Screens("ScreenWindow")

Referencing the root screen in various ways

 
'VBS10
Set objScreen = HMIRuntime.Screens(1)
 
'VBS11
Set objScreen = HMIRuntime.Screens("")
 
'VBS12
Set objScreen = HMIRuntime.Screens("BaseScreenName")
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See also
HMIRuntime  (Page 3922)

Screen (Page 3930)

ScreenItem (Page 3932)

SmartTag

Description

Represents the value of the specified process tag. The SmartTag object is an element of the 
SmartTag list.   

Application
The SmartTag object provides read and write access to the value of the specified process tag. 
The SmartTag object does not return an object reference. Use the SmartTags list to return the 
value of a process tag. Use the tag name as an index.

Example

 
'VBS_Example_SmartTags
'Writes tag value to local tag and returns a user-defined text through the 
operating system channel for debug alarms.
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(SmartTags("AirPressure"))
HMIRuntime.Trace strAirPressure
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 Note

In order to access a tag, which has still not been created in the project, using the SmartTags 
list, no value is returned. Assignment to a non-existing tag is not executed:

Dim intVar
intVar = SmartTags("FillLevel")
"intVar" remains empty when the "FillLevel" tag has not been created. 

 

 Note

If you want to return the "TypeName" of a SmartTag object data type with the VBS function 
"TypeName", use the following syntax:

TypeName(SmartTags("FillLevel").value) 
 

Use "SmartTags("<tag>")(index)" to access the value of an array element. Set the number of 
the desired array element for "index", for example, "SmartTags("AirPressure")(2)". 

See also
HMIRuntime  (Page 3922)

SmartTags (Page 3941)
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SmartTags

Description

A list of SmartTag objects which represent all of the tags in WinCC Runtime.   
 

 Note

The SmartTags list has a limited range of functions. You can only use the tag names to access 
a SmartTag object. Access via the index or by using "For each" instruction is not supported.

 

 Note

In order to access a tag, which has still not been created in the project, using the SmartTags 
list, no value is returned. Assignment to a non-existing tag is not executed:

Dim intVar
intVar = SmartTags("FillLevel")
"intVar" remains empty when the "FillLevel" tag has not been created. 

 

Application
Use the SmartTags list to return a SmartTag object. Use the tag name to reference the 
SmartTag object.

 
'VBS_Example_SmartTags
'Writes tag value to local tag and returns a user-defined text through the 
operating system channel for debug alarms.
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Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(SmartTags("AirPressure"))
HMIRuntime.Trace strAirPressure

In Runtime Advanced and Panels you address the tag directly using its name. If the tag name 
corresponds to the VBS name conventions, you do not need to use the SmartTags list. Follow 
the example below:

 
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(AirPressure)
HMIRuntime.Trace strAirPressure

See also
HMIRuntime  (Page 3922)

SmartTag (Page 3938)

Tag

Description

A tag object is returned via the "Tags" list. A tag object can be used to address all the properties 
and methods of a tag.

When creating a tag object, all the properties are initialized with the following values:

● Value = VT_EMPTY

● Name = Tag name
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● QualityCode = BAD NON-SPECIFIC

● TimeStamp = 0

● LastError = 0

● ErrorDescription = " "
 

  Note

A summary of possible Quality Codes can be found in WinCC Information System under 
key word "Communication" > "Diagnostics" or "Communication" > "Quality Codes".

 

Usage
Use the "Tag" object as follows:

● "Name", "QualityCode", "TimeStamp", "LastError" and "ErrorDescription" properties
Read information on the tag

● "Write" method, "Value" property
Set a value for a tag

● "Read" method, "Value" property
Read a value for a tag

Example
The following example reads the value in the "Tag1" tag:

 
'VBS13
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read()
MsgBox objTag.Value

Declaration of tags in WinCC
Always define internal tags in VB script using the "Dim" instruction in order to prevent writing 
tags wrongly. 

When creating a new action, the "Option explicit" instruction is automatically entered in the 
declaration area and cannot be deleted. 

Do not use the "Option explicit" statement in your code as it can lead to Runtime errors. 

Example
The following example reads the declaration value in the "lngVar" VB Script tag:

 
'VBS14
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Dim lngVar
lngVar = 5
MsgBox lngVar

 

 Note

Tag names must not contain any special characters.

When creating a tag, ensure it does not contain a value (Value = VT_EMPTY). Initialize the 
tags after declaration with the corresponding value.

 

Notes on Cross References
All the pictures which are addressed with the standard formulation 

 
HMIRuntime.Tags("Tagname")

are automatically compiled by the CrossReference of WinCC and then listed in the picture 
properties.

If you address tags with different formulations in the code, you can make them known by the 
following section of the CrossReference:

 
' ' WINCC:TAGNAME_SECTION_START
Const TagNameInAction = "TagName"
' WINCC:TAGNAME_SECTION_END

The section can be inserted in VBS actions as often as required.
 

 Note

Composed tag names may not be recognized by the CrossReference.
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See also
Name  (Page 4417)

Value  (Page 4691)

ErrorDescription (Page 4284)

LastError (Page 4354)

QualityCode (Page 4464)

Timestamp (Page 4605)

HMIRuntime  (Page 3922)

Tags (list) (Page 3945)

TagSet (list)  (Page 3946)

Tags (list)

Description    

The "Tags" list enables access to tags in WinCC Runtime. The result of access to the "Tags" 
list is returned by an object of the type "Tag". The Tag object can be used to access all the tag 
properties and methods.

 

 Note

"Tags" is a list with a restricted functional scope. The tags in the list cannot be accessed via 
the index but only by using the tag names. The standard methods get_Count and 
get_NewEnum cannot be used in the Tags list.
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Application
Tags in the list are accessed via:

 
HMIRuntime.Tags("Tagname")

 

The Tags list is used to declare tags (tag objects) for read and write access. The appropriate 
HMI tags must exist in order for the write and read acccess to be executed without error. 

You can address HMI tags directly in VBScript and set and read values. If you wish to inquire 
about additional tag properties, such as quality code or time stamp, or wish to execute error 
processing, you must address the tag through tags list. The tag object returned enables access 
to all tag properties and methods.

Using the "CreateTagSet" method, you may generate a TagSet object which allows 
simultaneous access to several tags. 

Example
You use tag names when you set tags.

 
'VBS16
Dim objTag
Set objTag = HMIRuntime.Tags("Tagname")
If you only use the tag name, the "TagPrefix" property is assigned the values from the 
current context (the current screen window).

See also
HMIRuntime  (Page 3922)

Tag (Page 3941)

TagSet (list)  (Page 3946)

TagSet (list) 

Description
The "TagSet" object enables simultaneous access to several tags in one call. Simultaneous 
access demonstrates better performance and lower communication load than single access 
to multiple tags. 
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Usage
You can use the TagSet object as follows: 

● "Add" method
Add tags to the list

● "Item" method
Access tag objects contained in the list and their properties

● "Write" method
Write all tags of the list

● "Read" method
Read all tags of the list

● "Remove" method
Remove single tags from the list

● "RemoveAll" method
Remove all tags from the list

Tags in the list are accessed via:

 
'VBS169
Dim myTags
myTags = HMIRuntime.Tags.CreateTagSet
myTags("Tagname")

 

In order to have error-free read/write access to tags (tag objects) of the list, the respective tags 
must exist in WinCC. 

If a read/write access error has occurred, the method used will return an error message using 
the "LastError" and "ErrorDescription" properties. 

Example
The following example shows how to generate a TagSet object, how to add tags, and how to 
write values.

 
'VBS168
'Build a Reference to the TagSet Object
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
'Add Tags to the Collection
group.Add "Motor1"
group.Add "Motor2"
'Set the Values of the Tags
group("Motor1").Value = 3
group("Motor2").Value = 9
'Write the Values to the DataManager
group.Write
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See also
ErrorDescription (Page 4284)

LastError (Page 4354)

Object types

Objects A-I

AlarmControl

Description

Represents the "Alarm view" object. The AlarmControl object is an element of the ScreenItems 
list.

Type identifier in VBS
HMIAlarmControl     

Example
In the following example, the object with the name "Control1" is moved 10 pixels to the right:

 
'VBS54
Dim objControl
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Set objControl = ScreenItems("Control1")
objControl.Left = objControl.Left + 10

 

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-19 Properties

Properties Read Write Description
Activate (Page 4149) P P Specifies whether the data to be visualized is requested by the 

alarm server. 
AlarmListType P P Specifies the alarm classes to be reported in runtime. 
AllServer P P Sets the display of the alarms of all available servers. 
ApplyProjectSettings (Page 4172) P P Specifies whether the project settings from the "HMI alarms" 

editor are applied. 
ApplyProjectSettingsForDesignM
ode 

P P Specifies that the project settings are used for the design. 

AutoCompleteColumns 
(Page 4177) 

P P Specifies whether empty columns are shown if the control is 
wider than the configured columns. 

AutoCompleteRows (Page 4177) P P Specifies whether empty rows are shown if the control is longer 
than the number of configured rows. 

AutoSelectionColors (Page 4178) P P Specifies whether the colors defined by the system are used as 
the selection colors for cells and rows. 

AutoSelectionRectColor 
(Page 4179) 

P P Specifies whether the selection frame is shown with the color 
defined by the system. 

BackColor (Page 4181) P P Specifies the background color of the selected object. 
Blocks P P Sets the alarm blocks. 
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
Caption (Page 4221) P P Specifies the text that is displayed in the header of the selected 

object. 
CellCut (Page 4225) P P Specifies whether the contents of the cells are abbreviated if the 

cells are too narrow. 
CellSpaceBottom (Page 4226) P P Specifies the bottom margin of the table cells. 
CellSpaceLeft (Page 4227) P P Sets the left indent for the table cells. 
CellSpaceRight (Page 4227) P P Specifies the right indent of the table cells. 
CellSpaceTop (Page 4228) P P Specifies the top margin of the table cells. 
Closeable (Page 4236) P P Specifies that the control can be closed in runtime. 
ColumnResize (Page 4242) P P Enables changes to the width of columns. 
ColumnScrollbar (Page 4244) P P Specifies the scroll bar type. 
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Properties Read Write Description
ColumnTitleAlignment 
(Page 4244) 

P P Specifies the type of column title alignment. 

ColumnTitles (Page 4245) P P Specifies whether the column title is displayed. 
ControlDesignMode (Page 4538) P P Specifies the design. 
DefaultMsgFilterSQL P P Specifies an SQL statement as default for alarm filters. 
DefaultSort P P Specifies the sorting order. 
DefaultSort2 P P Specifies the sorting order. 
DefaultSort2Column P P Specifies the sorting order. 
DisplayOptions (Page 4268) P P Specifies the alarms to be displayed. 
DoubleClickAction (Page 4269) P P Specifies the action to be executed in runtime by double-clicking 

an alarm row. 
ExportDirectoryChangeable 
(Page 4286) 

P P Specifies whether the data export directory can be changed in 
runtime. 

ExportDirectoryname 
(Page 4286) 

P P Specifies the target directory for the exported Runtime data. 

ExportFileExtension (Page 4287) P P Specifies the file extension of the export file. Only the "csv" file 
extension is currently supported. 

ExportFilename (Page 4288) P P Specifies the name of the target file for the exported Runtime 
data. 

ExportFilenameChangeable 
(Page 4288) 

P P Specifies whether the export file name can be changed in 
runtime. 

ExportFormatGuid (Page 4289) P P Default assignment of the ID number and export provider. 
ExportFormatName (Page 4289) P P Specifies the export file format. Only the "csv" file format is 

currently available for the export. 
ExportParameters (Page 4290) P P Specifies the parameters of the selected format by means of the 

"Properties" dialog. 
ExportSelection (Page 4290) P P Specifies the file extension of the export file. Only the "csv" file 

extension is currently supported. 
ExportShowDialog (Page 4291) P P Specifies whether the data export dialog is shown in runtime. 
Filters P P Specifies database criteria in SQL syntax. 
Font (Page 4311) P P Specifies or returns the font. 
GridLineColor (Page 4325) P P Specifies the color for the grid lines. 
GridLineWidth (Page 4326) P P Specifies the width of the separation lines in pixels. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
HitlistColumnAdd (Page 4332) * P P Transfers the selected alarm block from the list of available alarm 

blocks to the list of selected alarm blocks. 
HitlistColumnCount (Page 4333) * P P Sets the number of selected alarm blocks to be displayed in the 

hitlist in runtime. 
HitlistColumnIndex (Page 4333) P P References an alarm block that is selected for the hitlist. 
HitlistColumnName (Page 4334) * P P Displays the name of the alarm block of the hitlist that is 

referenced by means of the "HitlistColumnIndex" attribute. 
HitlistColumnRemove 
(Page 4334) *

P P Cuts the marked alarm block from the list of selected alarm 
blocks and pastes it into the list of existing alarm blocks. 

HitlistColumnRepos (Page 4334) 
*

P P Changes the sorting order of the alarm blocks. The "Up" and 
"Down" commands move the selected alarm block accordingly 
in the list. 
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Properties Read Write Description
HitlistColumnSort (Page 4335) * P P Specifies the sorting order in the hitlist for the alarm block that is 

referenced in "MessageColumnIndex". 
HitlistColumnSortIndex 
(Page 4335) *

P P Specifies the sorting order in the hitlist for the alarm block that is 
referenced in "HitlistColumnIndex". 

HitlistColumnVisible (Page 4336) 
*

P P The list displays the selected alarm blocks from the alarm list or 
hitlist that are to be used in the control in runtime. 

HitListDefaultSort (Page 4336) P P Sets the default sorting order in the table columns of the hitlist. 
HitListMaxSourceItems 
(Page 4337) 

P P Sets the maximum number of data records from the alarm log 
that are to be used to create the hit list. 

HitListMaxSourceItemsWarn 
(Page 4337) 

P P Sets the output of a warning on reaching the maximum number 
of data records that was specified in "HitlistMaxSourceItems". 

HitListRelTime (Page 4339) P P Sets a time range for the statistics. 
HitListRelTimeFactor P P Sets the time factor that is used in combination with the 

"HitlistRelativeTimeFactorType" to calculate the period for 
creating the hitlist statistics. 

HitListRelTimeFactorType P P Sets the time type that is used in combination with the 
"HitlistRelativeTimeFactor" to calculate the period for creating 
the hitlist statistics. 

HorizontalGridLines (Page 4341) P P Specifies whether horizontal separation lines are displayed. 
IconSpace (Page 4344) P P Specifies the spacing between icons and text in the table cells. 
Layer (Page 4355) P P Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 4379) P P Sets the color of the window separation lines. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
LongTermArchiveConsistency 
(Page 4387) 

P P If "LongTimeArchiveConsistency" is set to "No", 1000 alarms will 
be displayed in the historical alarm list (long-term) on the single 
station, on the server, or on the client for each server or 
redundant server pair. 

MessageBlockAlign (Page 4397) * P P Sets the mode of alignment for the table contents of the selected 
alarm block. 

MessageBlockAutoPrecisions 
(Page 4397) *

P P Enables automatic setting of the number of decimal places. 

MessageBlockCaption 
(Page 4398) *

P P Specifies the caption of the column header in the alarm view for 
the selected alarm block. 

MessageBlockCount (Page 4398) P P Specifies the number of alarm blocks that are available for the 
alarm list and hitlist. 

MessageBlockDateFormat 
(Page 4399) *

P P Specifies the date format for displaying the alarms. 

MessageBlockExponentialFormat
 (Page 4399) *

P P Specifies the exponential notation for visualization of the values 
of a selected alarm block. 

MessageBlockFlashOn 
(Page 4400) *

P P Enables flashing of the selected alarm block in runtime when an 
alarm appears. 

MessageBlockHideText  
(Page 4400) *

P P Enables the textual display of the content of the selected alarm 
block. 

MessageBlockHideTitleText  
(Page 4401) *

P P Specifies textual display of the caption of the selected alarm 
block. 

MessageBlockId (Page 4401) P P Specified assignment of ID number and alarm block in the alarm 
view. 
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Properties Read Write Description
MessageBlockIndex (Page 4402) P P References an existing alarm block. 
MessageBlockLeadingZeros  
(Page 4402) *

P P Enables the display of the selected alarm block with leading 
zeroes. 

MessageBlockLength  
(Page 4403) *

P P Specifies the length of the selected alarm block based on the 
number of characters. 

MessageBlockName (Page 4403) P P Displays the name of the selected alarm block. 
MessageBlockPrecision  
(Page 4404) *

P P Specifies the number of decimal places for the values of the 
selected alarm block. 

MessageBlockSelected  
(Page 4404) *

P P Existing alarm blocks are blocks that are available for use in the 
control in runtime for the alarm list or hitlist. 

MessageBlockShowDate  
(Page 4405) *

P P Specifies whether to display both the date and time in the "Time" 
alarm block. 

MessageBlockShowIcon  
(Page 4405) *

P P Enables the display of the content of the selected alarm block as 
icon. 

MessageBlockShowTitleIcon  
(Page 4406) *

P P Specifies textual display of the caption of the selected alarm 
block. 

MessageBlockTextId 
(Page 4406) 

P P Specifies naming of the selected alarm block by means of a text 
ID that was taken from the text library. 

MessageBlockTimeFormat  
(Page 4407) *

P P Specifies the format for the time or period used to display the 
alarms. 

MessageColumnAdd  
(Page 4408) *

P P Adds the selected alarm block from the list of available alarm 
blocks to the list of selected alarm blocks. 

MessageColumnCount  
(Page 4409) *

P P Specifies the number of alarm blocks to be displayed in the alarm 
list in runtime. 

MessageColumnIndex 
(Page 4409) 

P P References an alarm block selected for the alarm list. 

MessageColumnName  
(Page 4410) *

P P Shows the name of the alarm block from the alarm list, which is 
referenced by means of the "MessageColumnIndex" property. 

MessageColumnRemove  
(Page 4410) *

P P Cuts the marked alarm block from the list of selected alarm 
blocks and pastes it into the list of existing alarm blocks. 

MessageColumnRepos  
(Page 4411) *

P P Changes the sorting order of the alarm blocks. The "Up" and 
"Down" commands move the selected alarm block accordingly 
in the list. 

MessageColumnSort  
(Page 4411) *

P P Specifies the sorting order for the alarm block that is referenced 
in "MessageColumnIndex" . 

MessageColumnSortIndex  
(Page 4412) *

P P Specifies the sorting order for the alarm block that is referenced 
in "MessageColumnIndex". 

MessageColumnVisible 
(Page 4412) *

P P The list shows the selected alarm blocks of the alarm list or hitlist 
that are are used in the alarm view in runtime. 

Moveable (Page 4416) P P Specifies whether the window can be moved in runtime. 
MsgFilterSQL (Page 4417) P P Specifies one or several SQL statements for user-defined 

selection of the alarms. 
Name (Page 4417) P P Returns the object name as STRING. 
OperatorAlarms P P Specifies the operator message settings. 
OperatorMessageId  (Page 4430) 
*

P P Default assignment of the ID number and trigger event in the 
alarm view. 

OperatorMessageIndex  
(Page 4430) *

P P References the operator message event. 
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Properties Read Write Description
OperatorMessageName  
(Page 4431) *

P P On alarm events, this displays the name that is referenced by 
means of "OperatorMessageIndex" for operator alarms. 

OperatorMessageNumber  
(Page 4432) *

P P Specify an alarm number for the operator message of the 
selected alarm event if you do not use the operator message of 
WinCC. 

OperatorMessageSelected  
(Page 4432) *

P P Activate the alarm events of the list that trigger operator 
messages. 

OperatorMessageSource1  
(Page 4432) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 1" of the operator message configured in 
Source. 

OperatorMessageSource10  
(Page 4437) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 10" of the operator message configured in 
Source. 

OperatorMessageSource2  
(Page 4433) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 2" of the operator message configured in 
Source. 

OperatorMessageSource3  
(Page 4433) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 3" of the operator message configured in 
Source. 

OperatorMessageSource4  
(Page 4434) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 4" of the operator message configured in 
Source. 

OperatorMessageSource5  
(Page 4434) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 5" of the operator message configured in 
Source. 

OperatorMessageSource6  
(Page 4435) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 6" of the operator message configured in 
Source. 

OperatorMessageSource7  
(Page 4435) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 7" of the operator message configured in 
Source. 

OperatorMessageSource8  
(Page 4436) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 8" of the operator message configured in 
Source. 

OperatorMessageSource9  
(Page 4436) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 9" of the operator message configured in 
Source. 

OperatorMessageSourceType1  
(Page 4437) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType10  
(Page 4442) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType2  
(Page 4438) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType3  
(Page 4438) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType4  
(Page 4439) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType5  
(Page 4439) *

P P Specifies the format of the source content to be transferred. 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3952 System Manual, 07/2013,  



Properties Read Write Description
OperatorMessageSourceType6  
(Page 4440) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType7  
(Page 4440) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType8  
(Page 4441) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType9  
(Page 4441) *

P P Specifies the format of the source content to be transferred. 

PageMode (Page 4444) P P Sets the page orientation (portrait / landscape). 
PageModeMessageNumber 
(Page 4444) 

P P Defines the number of alarm shown per page when paging the 
historical alarm list (long-term). 

PrintJob P P Specifies a print job 
RowScrollbar (Page 4475) P P Specifies whether row scroll bars are displayed. 
RowTitleAlignment P P Specifies the type of row title alignment. 
RowTitles P P Specifies that row headers will be displayed. 
RTPersistence (Page 4477) P P Specifies how online configurations of WinCC are retained. 
RTPersistenceAuthorization P P Specifies the authorization required for online configuration in 

runtime. 
RTPersistenceType (Page 4478) - - Specifies how online configurations of WinCC are retained. 
SelectedCellColor (Page 4493) P P Specifies the background color of the selected cell. 
SelectedCellForeColor 
(Page 4494) 

P P Specifies the font color of the selected cell. 

SelectedRowColor (Page 4495) P P Specifies the background color of the selected row. 
SelectedRowForeColor 
(Page 4495) 

P P Specifies the font color of the selected row. 

SelectedTitleColor (Page 4496) P P Specifies the background color of a selected table header. 
SelectedTitleForeColor 
(Page 4497) 

P P Specifies the font color of the selected table header. 

SelectionColoring (Page 4499) P P Specifies whether selection colors are used for cells or rows. 
SelectionRect (Page 4502) P P Specifies whether a selection frame is used for the selected cells 

or rows. 
SelectionRectColor (Page 4503) P P Specifies the color of the selection rectangle in the alarm window 

if SelectionType equals "1". 
SelectionRectWidth (Page 4504) P P Specifies the line width of the selection rectangle in the alarm 

window if SelectionType equals "1". 
SelectionType (Page 4504) P P Specifies the number of lines you can mark.
ServerNames (Page 4508) P P Specifies the servers of a distributed system that form the data 

source for the alarm view. 
ShowSortButton (Page 4528) P P Specifies whether the sorting button is shown above the vertical 

scroll bar. 
ShowSortIcon (Page 4529) P P Specifies whether the sorting icon is displayed. 
ShowSortIndex (Page 4530) P P Specifies whether the sorting icon is displayed. 
ShowTitle (Page 4534) P P Specifies the representation of the control's window title. 
Sizeable (Page 4538) P P Specifies that the size of an object can be changed in runtime. 
SortSequence (Page 4542) P P Specifies how the sorting order can be changed by mouse click. 
StatusbarBackColor (Page 4547) P P Specifies the background color of the status bar. 
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Properties Read Write Description
StatusbarElementAdd  
(Page 4547) *

P P Creates a new, user-defined status bar element. 

StatusbarElementAutoSize 
(Page 4548) *

P P Specifies whether the width of the selected status bar element 
is set automatically. 

StatusbarElementCount  
(Page 4548) *

P P Specifies the number of configurable status bar elements. 

StatusbarElementIconId  
(Page 4549) *

P P Default assignment of the ID number and icon of a status bar 
element. 

StatusbarElementId  (Page 4549) 
*

P P Unique ID of the selected status bar element. 

StatusbarElementIndex  
(Page 4550) 

P P References a status bar element. You can use this property to 
assign the values of other properties to a specific element of the 
status bar. 

StatusbarElementName  
(Page 4550) *

P P Displays the object name of the selected status bar element. 

StatusbarElementRemove  
(Page 4551) *

P P Removes the selected status bar element. 

StatusbarElementRename  
(Page 4551) *

P P Renames the user-defined status bar element that is referenced 
by means of the "StatusbarElementIndex" property.

StatusbarElementRepos  * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 4552) - - Specifies the elements that are to be shown in the status bar. 
StatusbarElementText  * P P Specifies the text of the currently selected status bar element. 
StatusbarElementTooltipText  
(Page 4552) *

P P Specifies the tooltip text for the user-defined status bar element. 

StatusbarElementUserDefined  
(Page 4553) *

P P Indicates whether the project engineer has added the toolbar 
button as a new user-defined element. 

StatusbarElementVisible  
(Page 4554) *

P P In the list, activate the status bar elements that you wish to 
display in runtime. 

StatusbarElementWidth  
(Page 4554) *

P P Specifies the width of the selected status bar element in pixels. 

StatusbarFont - - Status bar font 
StatusbarFontColor (Page 4554) P P Specifies the color of the text in the status bar. 
StatusbarShowTooltips 
(Page 4557) 

P P Specifies whether tooltips are displayed for the elements of the 
status bar in runtime. 

StatusbarText (Page 4558) P P Default text in the status bar. 
StatusbarUseBackColor 
(Page 4558) 

P P Specifies whether the background color of the status bar is 
shown. 

StatusbarVisible (Page 4559) P P Specifies whether the status bar of the control is displayed. 
TableColor P P Specifies the background color of the rows. Use this to open the 

color selection dialog. 
TableColor2 P P Specifies the background color of "Row color 2". 
TableForeColor P P Specifies the font color of "Row color". 
TableForeColor2 P P Specifies the font color of "Row color 2". 
TimeBase (Page 4584) P P Sets the timebase. 
TitleColor P P Specifies the color of the header. 
TitleCut P P Specifies whether the contents of the fields of a header should 

be abbreviated if the column is too narrow. 
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Properties Read Write Description
TitleDarkShadowColor P P Specifies the color of the dark side of shading. 
TitleForeColor P P Specifies the font color of the table header for the selected status. 
TitleGridLineColor P P Specifies the color of separation lines in the table header. 
TitleLightShadowColor P P Specifies the color of the bright side of shading. 
TitleSort P P Specifies how sorting by column title is triggered. 
TitleStyle P P Specifies whether a shading color is used for the table header. 
ToolbarAlignment P P Specifies or returns the position of the toolbar. 
ToolbarBackColor P P Specifies the background color of the toolbar. 
ToolbarButtonActive  * P P Specifies whether the function linked to the button is activated in 

runtime. 
ToolbarButtonAdd  * P P Creates a new, user-defined button function. 
ToolbarButtonBeginGroup  * P P Specifies whether a separator is inserted before the selected 

button function. 
ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  * P P Specifies the number of configurable button functions. 
ToolbarButtonEnabled  * P P Specifies whether a user-defined toolbar button can be operated. 
ToolbarButtonHotKey  * P P Shows the hotkey for the selected button function. 
ToolbarButtonId  * P P Unique ID number for the selected button function. 
ToolbarButtonIndex P P References a button function. 
ToolbarButtonLocked  * P P Specifies whether the clicked, pressed in state is displayed for a 

user-defined toolbar button. 
ToolbarButtonName  * P P Shows the name of the selected button function. 
ToolbarButtonPasswordLevel  * P P Shows the authorization for the selected button function. 
ToolbarButtonRemove  * P P Removes the selected button function from the list. 
ToolbarButtonRename  * P P Renames the user-defined toolbar element that is referenced by 

means of the "ToolbarButtonIndex" property. 
ToolbarButtonRepos  * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  * P P Specifies the tooltip text for the button. 
ToolbarButtonUserDefined  * P P Indicates whether the project engineer has added the toolbar 

button as a new user-defined button. 
ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips P P Specifies whether the tooltips for the button functions are 

displayed in runtime. 
ToolbarUseBackColor P P Specifies whether the background color for the toolbar is shown. 
ToolbarUseHotKeys P P Specifies whether the hotkeys for the button functions are 

activated in runtime. 
ToolbarVisible P P Specifies whether the toolbar of the control is displayed. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
UseMessageColor (Page 4680) P P Specifies whether scrolling is enabled. 
UseSelectedTitleColor 
(Page 4682) 

P P Specifies whether a selection color is used for the headers of 
selected table cells. 

UseTableColor2 (Page 4684) P P Specifies whether a second row color is used for the 
representation of the table. 

VerticalGridLines (Page 4702) P P Specifies whether vertical separation lines are displayed. 
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Properties Read Write Description
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-20 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
AttachDB (Page 4750) P, A Executes the "Connect backup" button function of the control.
CopyRows (Page 4751) P Executes the "Copy rows" button function of the control.
DeactivateDynamic (Page 4754) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.
DetachDB (Page 4756) P, A Executes the "Disconnect backup" button function of the control.
Export (Page 4757) P, A Executes the "Export log" or "Export data" button function of the control.
GetHistlistColumnCollection 
(Page 4760) 

P Returns the list of all column objects of the alarm view hitlist as 
"ICCAxCollection" type.

GetHitlistColumn (Page 4761) P Returns the column object of the alarm view hitlist designated by name 
or index as "ICCAxMessageColumn" type.

GetMessageBlock (Page 4762) P Returns the alarm block object of the alarm view designated by name or 
index as "ICCAxMessageBlock" type.

GetMessageBlockCollection 
(Page 4763) 

P Returns the list of all alarm block objects of the alarm view as 
"ICCAxCollection" type.

GetMessageColumn (Page 4765) P Returns the column object of the alarm view designated by name or index 
as "ICCAxMessageColumn" type.

GetOperatorMessage (Page 4766) P Returns the operator message object of the alarm view designated by 
name or index as "ICCAxOperatorMessage" type.

GetMessageColumnCollection 
(Page 4767) 

P Returns the list of all column objects of the message view as 
"ICCAxCollection" type.

GetOperatorMessageCollection 
(Page 4768) 

P Returns the list of all operator message objects of the alarm view as 
"ICCAxCollection" type.

GetRow (Page 4769) P Returns the row object defined by its row number in the table-based 
controls as "ICCAxDataRow" type.

GetRowCollection (Page 4770) P Returns the list of all row objects of the table-based controls as 
"ICCAxDataRowCollection" type. 

GetSelectedRow (Page 4777) P Returns the selected row object of a table-based control as 
"ICCAxDataRow" type.

GetSelectedRows (Page 4778) P Returns the selected row objects of a table-based control as type 
"ICCAxDataRow" for multiple selection.

GetStatusbarElement (Page 4784) P, A Returns the element of the control's status bar designated by name or 
index as "ICCAxStatusbarElement" type.

GetStatusbarElementCollection 
(Page 4785) 

P, A Returns the list of all status bar elements of the control as 
"ICCAxCollection" type.

GetToolbarButton (Page 4792) P, A Returns the button function designated by name or index on the control 
toolbar as "ICCAxToolbarButton" type.
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Methods Valid Description
GetToolbarButtonCollection 
(Page 4793) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

HideAlarm (Page 4809) P Executes the "Hide alarm" button function of the alarm view.
LockAlarm (Page 4812) P Executes the "Disable alarm" button function of the alarm view.
LoopInAlarm (Page 4812) P Executes the "Loop in alarm" button function of the alarm view.
MoveToFirstLine (Page 4814) P Executes the "First alarm" button function of the alarm view.
MoveToFirstPage (Page 4814) P Executes the "First page" button function of the alarm view.
MoveToLastLine (Page 4815) P Executes the "Last alarm" button function of the alarm view.
MoveToLastPage (Page 4816) P Executes the "Last page" button function of the alarm view.
MoveToNextLine (Page 4817) P Executes the "Next alarm" button function of the alarm view.
MoveToNextPage (Page 4817) P Executes the "Next page" button function of the alarm view.
MoveToPreviousLine (Page 4818) P Executes the "Previous alarm" button function of the alarm view.
MoveToPreviousPage (Page 4819) P Executes the "Previous page" button function of the alarm view.
Print (Page 4822) P, A Executes the "Print" button function of the control.
QuitHorn (Page 4823) P Executes the "Acknowledge central alarm generator" button function of 

the alarm view.
QuitSelected (Page 4823) P Executes the "Single acknowledgment" button function of the alarm view.
QuitVisible (Page 4824) P Executes the "Group acknowledgment" button function of the alarm view.
SelectAll (Page 4837) P Selects all rows in a table-based control.
SelectRow (Page 4838) P Selects a specific row in a table-based control.
ShowComment (Page 4841) P Executes the "Comment dialog" button function of the recipe view.
ShowDisplayOptionsDialog 
(Page 4841) 

P Executes the "Display options dialog" button function of the alarm view.

ShowEmergencyQuitDialog 
(Page 4842) 

P Executes the "Single acknowledgment" button function of the alarm view.

ShowHelp (Page 4842) P, A Executes the "Help" button function of the control.
ShowHideList (Page 4843) P Executes the "List of alarm to hide" button function of the alarm view.
ShowHitList (Page 4843) P Executes the "Hitlist" button function of the alarm view.
ShowInfoText (Page 4844) P Executes the "About dialog" button function of the alarm view.
ShowLockDialog (Page 4844) P Executes the "Lock dialog" button function of the alarm view.
ShowLockList (Page 4845) P Executes the "Lock list" button function of the alarm view.
ShowLongTermArchiveList 
(Page 4845) 

P Executes the "Historical alarm list (long-term)" button function of the alarm 
view.

ShowMessageList (Page 4846) P Executes the "Alarm list" button function of the alarm view.
ShowPropertyDialog (Page 4847) P, A Executes the "Configuration dialog" button function of the control.
ShowSelectionDialog (Page 4848) P Executes the "Selection dialog" button function of the alarm view.
ShowShortTermArchiveList 
(Page 4849) 

P Executes the "Historical alarm list (short-term)" button function of the 
alarm view.

ShowSortDialog (Page 4850) P Executes the "Sorting dialog" button function of the alarm view.
ShowTimebaseDialog (Page 4851) P Executes the "Timebase dialog" button function of the alarm view.
UnhideAlarm (Page 4854) P Executes the "Unhide alarm" button function of the alarm view.
UnlockAlarm (Page 4855) P Executes the "Unlock alarm" button function of the alarm view.
UnselectAll (Page 4855) P Removes all selections from the cells of a table-based control.
UnselectRow (Page 4856) P Removes the selections from a specific cell of a table-based control.
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See also
Screen object (list) (Page 3936)

AlarmView

Description

Represents the "Alarm view" object. The MessageView object is an element of the 
ScreenItems list. 

     

If you change the settings for this object with a user-defined function, the changed settings are 
retained even after the screen is called again. 

 

 Note

The object "Simple AlarmView" cannot be dynamized with a user-defined function.
 

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional
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Table 10-21 Properties

Properties Read Write Description
AlarmAreaHeight **    
AlarmAreaWidth **    
AlarmClasses - - Specifies the alarm classes to be reported in runtime. 
AlarmLog - - Specifies the alarm types to be displayed in the alarm view. 
AlarmSource - - Specifies that alarms should be displayed. 
Authorization (Page 4175) - - Specifies the operating rights of the selected object in runtime.  
BackColor A A Specifies the background color of the selected object. 
ButtonBarElements **   Specifies that the buttons will be displayed. 
ButtonBarStyle - -  
Columns - - Specifies the columns to be displayed. 
ColumnsMoveable - - Specifies that the columns can be moved. 
ColumnTextAckGroup - - Specifies the header for the "AckGroup" column. 
ColumnTextAlarmState - - Specifies the header for the "State" column. 
ColumnTextAlarmText - - Specifies the header for the "Text" column. 
ColumnTextClassName - - Specifies the header for the "Class Name" column. 
ColumnTextDate - - Specifies the header for the "Date" column. 
ColumnTextDevice - - Specifies the header for the "Device" column. 
ColumnTextDiagnosable - - Specifies the header for the "Diagnosable" column. 
ColumnTextNumber - - Specifies the header for the "Number" column. 
ColumnTextTime - - Specifies the header of the "Time" column. 
CountOfLinesPerAlarms - -  
CountOfVisibleAlarms - -  
Enabled (Page 4279) A A Specifies whether the selected object can be operated in runtime.  
FilterTag **   Specifies a tag of the string type for filtering alarm texts. 
FilterText **   Specifies the text for filtering the alarm text. 
FitToSize - - Specifies that the size of the object should be automatically 

adapted to the content. 
Flashing - - Specifies that the text block flashes. 
FocusColor (Page 4309) A A Specifies the color for the focus frame of the selected object when 

it is in focus. 
FocusWidth (Page 4310) A A Specifies the border width of the specified object when the object 

is in focus.  
ForeColor (Page 4319) - - Specifies the font color of the text for the selected object. 
GridlineColor (Page 4326) A A Specifies the color for the grid lines. 
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HorizontalScrollingEnabled - -  
IsRunningUnderCE * - -  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
LineAlarmView **    
Name (Page 4417) A A Returns the object name as STRING. 
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Properties Read Write Description
PreferredUseOnAck - -  
S7Device - -  
SecurityForSimpleViewEnabled 
**

   

SelectionBackColor (Page 4499) A A Specifies the background color of the selected cells.  
SelectionForeColor (Page 4501) A A Specifies the foreground color of the selected cells.  
SeparateLineForAlarmText - -  
ShowAcknowledgeButton - -  
ShowAlarmsFromDate 
(Page 4515) 

A A Specifies that only those message events are displayed that are 
saved in this tag.  

ShowAlarmsToAcknowledge - - Specifies that unacknowledged alarms should be displayed. 
ShowColumnHeaders - -  
ShowHelpButton - -  
ShowHorizontalGridlines - -  
ShowLoopInAlarmButton - - Specifies that the "Loop-In-Alarm" button will be displayed.
ShowMilliseconds - - Display time in milliseconds. 
ShowPendingAlarms - -  
SortByTimeDirection 
(Page 4540) 

- - Specifies whether the last incoming alarm is displayed at the top 
of the "AlarmControl" object. 

SortByTimeEnabled 
(Page 4540) 

A A Specifies whether the sorting order of alarms based on the time 
in the "AlarmControl" object can be changed.  

TableBackColor (Page 4563) A A Specifies the background color of the table cells for the selected 
object.  

TableFont - - Specifies the font in the table. 
TableForeColor (Page 4566) A A Specifies the font color of "Row color". 
TableHeaderBackColor 
(Page 4568) 

A A Specifies the background color in the header of the table of the 
selected object. 

TableHeaderFont - - Specifies the text color of the header. 
TableHeaderForeColor 
(Page 4569) 

A A Specifies the text color in the header of the table of the selected 
object. 

Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
VerticalScrollbarEnabled - -  
VerticalScrollingEnabled - -  
ViewType - - Specifies the alarm view type.
ViewTypeForSaveStream **   Specifies the display type for the Save Stream. 
Visible (Page 4703) * A A Specifies whether the selected object is visible. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES, ** no relevant information available

Table 10-22 Methods

Methods Valid Description
Activate (Page 4744) ??? Activates the permanent window or the root screen. 
???   
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Methods Valid Description
   
   
   
   
   
   
   
   
   

 

See also
Screen object (list) (Page 3904)

Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

Bar

Description

Represents the "Bar" object. The Bar object is an element of the ScreenItems list. 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3961



Type identifier in VBS
HMIBar     

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-23 Properties

Properties Read Write Description
AlarmLowerLimit (Page 4163) P P Specifies the low limit at which the interrupt is triggered. 
AlarmLowerLimitColor 
(Page 4163) 

P P Specifies the bar color of the "AlarmLowerLimit" limit. 

AlarmLowerLimitEnabled 
(Page 4164) 

P P Specifies whether the "AlarmLowerLimit" limit is monitored. 

AlarmLowerLimitRelative 
(Page 4164) 

P P Specifies whether the low limit at which the interrupt is triggered is 
evaluated as a percentage or an absolute value. 

AlarmUpperLimit (Page 4165) P P Specifies the high limit that triggers the interrupt. 
AlarmUpperLimitColor 
(Page 4165) 

P P Specifies the bar color of the "AlarmUpperLimit" limit. 

AlarmUpperLimitEnabled 
(Page 4166) 

P P Specifies whether the "AlarmUpperLimit" limit is monitored. 

AlarmUpperLimitRelative 
(Page 4167) 

P P Specifies whether the high limit at which the interrupt is triggered 
is evaluated as a percentage or an absolute value. 

Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime. 
AverageLast15Values P P Specifies that the average of the last 15 values is shown. 
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object. 
BackFlashingColorOff 
(Page 4188) *

P P Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 4188) *

P P Specifies the background color for flash state "On". 

BackFlashingEnabled 
(Page 4189) *

P P Specifies whether the background of the specified object flashes 
in runtime. 

BackFlashingRate (Page 4190) * P P Specifies the flash rate of the background for the selected object. 
BarBackColor (Page 4191) P, A P, A Specifies the color of the bar background for the selected object. 
BarBackFillStyle (Page 4191) P P Specifies the fill style for the bar. 
BarBackFlashingColorOff - - Specifies the border background color of the object for the "OFF" 

state. 
BarBackFlashingColorOn - - Specifies the border background color of the object for the "ON" 

state. 
BarBackFlashingEnabled - -  
BarBackFlashingRate - - Specifies the flash rate of the background. 
BarEdgeStyle - - Specifies the style of the border line. 
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Properties Read Write Description
BarOrientation P P Specifies the alignment of the bar. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object. 
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off". 

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On". 

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 4209) 

P P Specifies the flash rate of the border line for the selected object. 

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 4215) - - Specifies whether the object has a 3D border shading. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
ColorChangeHysteresis 
(Page 4238) 

P P Specifies the hysteresis as a percentage of the display value. 

ColorChangeHysteresisEnabled 
(Page 4239) 

P P Specifies whether the object is displayed with hysteresis. 

CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object. 
CountDivisions (Page 4252) P P Specifies the number of segments into which the bar will be split 

by means of the large scale tick marks. 
CountSubDivisions (Page 4252) A A Specifies the number of scale tick marks between two main tick 

marks of the "Bar" object. 
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border.

EdgeStyle (Page 4274) P P Specifies the line style of the selected object. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime. 
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) * - - Specifies the border line color of the selected object for the flash 

state "Off". 
FlashingColorOn (Page 4302) * - - Specifies the border line color of the selected object for the flash 

state "On". 
FlashingEnabled (Page 4303) * - - Specifies whether the border line of the selected object flashes in 

runtime. 
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 4304) * - - Specifies the flash rate of the border line for the selected object. 
Font (Page 4311) - - Specifies or returns the font. 
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in bold. 
FontName (Page 4315) P P Specifies the font of the selected object. 
FontSize (Page 4316) P P Specifies the font size of the text for the selected object. 
ForeColor (Page 4318) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Properties Read Write Description
IntegerDigits (Page 4348) P P, A Specifies the number of digits to the left of the decimal point (0 to 

20). 
LargeTickLabelingStep - - Specifies which scale sections are labeled. 
LargeTicksBold (Page 4352) P P Specifies whether the long tick marks of a scale are shown in bold. 
LargeTicksSize (Page 4352) P P Specifies the length of the long tick marks of a scale. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
Limit4LowerLimit (Page 4369) P P Specifies the low limit for "Reserve4". 
Limit4LowerLimitColor 
(Page 4370) 

P P Specifies the color for the "Reserve4" low limit. 

Limit4LowerLimitEnabled 
(Page 4370) 

P P Specifies whether the "Reserve4" low limit is monitored. 

Limit4LowerLimitRelative 
(Page 4371) 

P P Specifies whether the "Reserve4" low limit is evaluated as a 
percentage or an absolute value. 

Limit4UpperLimit (Page 4371) P P Specifies the high limit for "Reserve4". 
Limit4UpperLimitColor 
(Page 4372) 

P P Specifies the color for the "Reserve4" high limit. 

Limit4UpperLimitEnabled 
(Page 4373) 

P P Specifies whether the "Reserve4" high limit is monitored. 

Limit4UpperLimitRelative 
(Page 4373) 

P P Specifies whether the "Reserve4" high limit is evaluated as a 
percentage or an absolute value. 

Limit5LowerLimit (Page 4374) P P Specifies the low limit for "Reserve5". 
Limit5LowerLimitColor 
(Page 4374) 

P P Sets the color for the "Reserve5" low limit. 

Limit5LowerLimitEnabled 
(Page 4375) 

P P Specifies whether the "Reserve5" low limit is monitored. 

Limit5LowerLimitRelative 
(Page 4376) 

P P Specifies whether the "Reserve5" low limit is evaluated as a 
percentage or an absolute value. 

Limit5UpperLimit (Page 4376) P P Specifies the high limit for "Reserve5". 
Limit5UpperLimitColor 
(Page 4377) 

P P Specifies the color for the "Reserve5" high limit. 

Limit5UpperLimitEnabled 
(Page 4377) 

P P Specifies whether the "Reserve5" high limit is monitored. 

Limit5UpperLimitRelative 
(Page 4378) 

P P Specifies whether the "Reserve5" high limit is evaluated as a 
percentage or an absolute value. 

LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line ends. 

MaximumValue (Page 4392) P, A P, A Specifies the maximum value of the scale in the selected object. 
MinimumValue (Page 4413) P, A P, A Specifies the minimum value of the scale in the selected object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
Precision (Page 4459) P P Specifies the number of decimal places (0 to 20). 
ProcessValue (Page 4461) P, A P, A Specifies the default for the value to be displayed. 
ScaleColor (Page 4481) P, A P, A Specifies the color of the scale of the selected object. 
ScaleGradation (Page 4482) P, A P, A Specifies the distance between two large tick marks of the scale. 
ScaleLabelFieldLength * - - Distance to the position of the axis label. 
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Properties Read Write Description
ScaleLabelingDoubleLined - - Specifies that the horizontal bar orientation of the scale has two 

lines. 
ScalePosition (Page 4484) P P Specifies the position of the scale of the selected object. 
ScaleStart - - Specifies the minimum of the scale. 
ScalingType (Page 4488) P P Specifies the type of bar scaling. 
SegmentColoring (Page 4492) P, A P, A Specifies the type of color change to be displayed in the "Bar" 

object if limits are exceeded. 
ShowBadTagState (Page 4516) P P Specifies whether an object is grayed out if its associated tag has 

a bad quality code or tag state.
ShowLargeTicksOnly 
(Page 4521) 

P P Specifies or returns the length of axis sections in pixels. 

ShowLimitLines - - Specifies the display of a line at the limits. 
ShowLimitMarkers (Page 4521) P P Specifies whether the limit values are shown as a scale value. 
ShowScale (Page 4527) P P Specifies whether the values are also shown in a scale. 
ShowSignForPositiveLabel - - Specifies that a "+" is displayed for positive labels. 
ShowTickLabels (Page 4532) - - Specifies whether the label is shown in the scale. 
ShowTrendIndicator 
(Page 4536) 

P P Specifies whether the trend (rising or falling) of the measured value 
to be monitored is indicated by means of a small arrow. 

StartValue (Page 4546) P P Specifies the zero point value for the scale display. 
ToleranceLowerLimit 
(Page 4612) 

P P Specifies whether the "ToleranceLowerLimit" limit is monitored. 

ToleranceLowerLimitColor 
(Page 4612) 

P P Specifies the color for the "ToleranceLowerLimit" low limit. 

ToleranceLowerLimitEnabled 
(Page 4613) 

P P Specifies whether the "ToleranceLowerLimit" limit is monitored. 

ToleranceUpperLimit 
(Page 4614) 

P P Specifies whether the "ToleranceUpperLimit" limit is monitored. 

ToleranceUpperLimitColor 
(Page 4614) 

P P Specifies the color for the "ToleranceUpperLimit" high limit. 

ToleranceUpperLimitEnabled 
(Page 4615) 

P P Specifies whether the "ToleranceUpperLimit" limit is monitored. 

ToleranceUpperLimitRelative 
(Page 4616) 

P P Specifies whether the "ToleranceHigh" low limit is evaluated as a 
percentage or an absolute value. 

ToolTipText (Page 4627) P P Specifies the tooltip text. 
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object. 
TrendIndicatorColor 
(Page 4641) 

P P Specifies the color for the trend view. 

Unit (Page 4667) P, A P, A Specifies the unit of measurement in the "IOField" object. 
UseAutoScaling - - Specifies auto-scaling. 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

UseExponentialFormat 
(Page 4678) 

P P Specifies whether the numbers are displayed with exponentials 
(e.g. "1.00e+000"). 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  3965



Properties Read Write Description
Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
WarningLowerLimit (Page 4707) P P Specifies the "WarningLowerLimit" low limit. 
WarningLowerLimitColor 
(Page 4708) 

P P Specifies the color for the "WarningLowerLimit" low limit. 

WarningLowerLimitEnabled 
(Page 4708) 

P P Specifies whether the "WarningLowerLimit" limit is monitored. 

WarningLowerLimitRelative 
(Page 4709) 

P P Specifies whether the "WarningLowerLimit" low limit is evaluated 
as a percentage or an absolute value. 

WarningUpperLimit (Page 4712) P P Specifies the "WarningUpperLimit" high limit. 
WarningUpperLimitColor 
(Page 4712) 

P P Specifies the color for the "WarningUpperLimit" high limit. 

WarningUpperLimitEnabled 
(Page 4713) 

P P Specifies whether the "WarningUpperLimit" limit is monitored. 

WarningUpperLimitRelative 
(Page 4713) 

P P Specifies whether the "WarningUpperLimit" high limit is evaluated 
as a percentage or an absolute value. 

Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 
objects. 

ZeroPoint (Page 4742) P P Specifies the position of the zero point as a percentage of the bar 
height. 

* not visible in the ES

Table 10-24 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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BatteryView

Description

Represents the "Charge condition" object. The BatteryView object is an element of the 
ScreenItems list.     

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-25 Properties

Properties Read Write Description
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Name (Page 4417) A - Returns the object name as STRING. 
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-26 Methods

Methods Valid Description
  Not found
   
   

 

See also
Screen object (list) (Page 3904)

Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

Button

Description

Represents the "Button" object. The Button object is an element of the ScreenItems list.     

The availability of the following object properties depends on the selected mode of the "button":

Property "Text" "Text list" "Graphic"
TextOff x -- --
TextOn x -- --
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Type identifier in VBS
HMIButton

 

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-27 Properties

Properties Read Write Description
AdaptBorder (Page 4156) P P Specifies whether the border of the specified object is dynamically 

adapted to the text size.  
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff 
(Page 4188) 

P P Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 4188) 

P P Specifies the background color for flash state "On".  

BackFlashingEnabled 
(Page 4189) 

P P Specifies whether the background of the specified object flashes in 
runtime. 

BackFlashingRate (Page 4190) P P Specifies the flash rate of the background for the selected object. 
BitNumber (Page 4197) - - Specifies the bit whose status must change to trigger a value 

change.  
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderBrightColor3D 
(Page 4200) 

P P Specifies the border color of the following border parts in the 3D 
display of the selected object. 

BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 4209) 

P P Specifies the flash rate of the border line for the selected object.  

BorderShadeColor3D 
(Page 4212) 

P P Specifies the border color of the following border parts in the 3D 
display of the selected object. 

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 4215) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
BorderWidth3D (Page 4218) P P Specifies the width of the border for 3D display of the selected object. 
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Properties Read Write Description
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 4274) P P Specifies the line style of the selected object.  
Enabled (Page 4277) P, A P, A Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
FitToLargest - - Specifies that the size of the object depends on the text length in all 

languages. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
FocusColor (Page 4308) A A Specifies the color for the focus frame of the selected object when 

it is in focus. 
FocusWidth (Page 4310) A A Specifies the border width of the specified object when the object is 

in focus.  
Font (Page 4311) - - Specifies or returns the font.  
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in italics. 
FontName (Page 4315) P P Specifies the font of the selected object.  
FontSize (Page 4316) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is underlined.  
ForeColor (Page 4318) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HelpText (Page 4330) A - Returns the tooltip that is shown in runtime as user help for the 

specified object.  
HorizontalAlignment 
(Page 4340) 

P, A P, A Specifies the horizontal alignment of the text within the selected 
object. 

HotKey (Page 4342) - - Specifies the hotkey. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line ends. 

Mode (Page 4415) P P Specifies the field type of the selected object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
PictureAlignment (Page 4454) P P Specifies or returns the display type of the background image in the 

process picture.  
PictureList - - Specifies the graphic list that supplies the object with values. 
PictureOff (Page 4455) P P Specifies the screen to be displayed in the "Off" state.  
PictureOn (Page 4455) P P Specifies the screen to be displayed in the "On" state.  

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
3970 System Manual, 07/2013,  



Properties Read Write Description
Pressed (Page 4459) P P Specifies whether the selected object is displayed in a pressed 

state.  
ProcessValue (Page 4463) - - Specifies the default for the value to be displayed.  
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
StyleSettings (Page 4561) P P Specifies the display style for the object:  
TextList (Page 4573) - - A list that contains the assignments between the output value and 

the output text to be actually output.  
TextOff (Page 4574) P, A P, A Specifies the text to be displayed in the "Off" state of the selected 

object.  
TextOn (Page 4575) A A Specifies the text to be displayed in the "On" state of the selected 

object.  
TextOrientation (Page 4576) P P Specifies the text orientation of the selected object.  
Toggle (Page 4610) P P Specifies whether the selected object engages after it has been 

operated in runtime. 
ToolTipText (Page 4627) P P, A Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
TransparentColorPictureOff 
(Page 4636) 

P P Specifies the color to be set to "transparent" for the "Off" state of the 
assigned bitmap object. 

TransparentColorPictureOn 
(Page 4636) 

P P Specifies the color to be set to "transparent" for the "On" state of the 
assigned bitmap object. 

UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

UseTransparentColorPictureOff
 (Page 4686) 

P P Specifies whether  the transparent color defined in the 
"TransparentColorPictureOff" property is used for the "Off" state. 

UseTransparentColorPictureOn
 (Page 4687) 

P P Specifies whether the transparent color defined in the 
"TransparentColorPictureOn" property is used for the "On" state. 

VerticalAlignment (Page 4701) P, A P, A Specifies the vertical alignment of the text for the selected object. 
Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
WindowsStyle (Page 4718) P P Specifies whether the object is displayed in the general Windows 

style. 
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Table 10-28 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 4747) 

P Dynamically activates a trigger and the specified cycle for a property at runtime. 

DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

ChannelDiagnose

Description

Represents the "ChannelDiagnose" object. The ChannelDiagnose object is an element of the 
ScreenItems list. 
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Type identifier in VBS
HMIChannelDiagnose     

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-29 Properties

Properties Read Write Description
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
Flashing * - - Specifies that the text block flashes. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
Name (Page 4417) P - Returns the object name as STRING. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-30 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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CheckBox

Description

Represents the "Check box" object. The CheckBox object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMICheckBox

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-31 Properties

Properties Read Write Description
AdaptBorder (Page 4156) P P Specifies whether the border of the specified object is dynamically 

adapted to the text size.  
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
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Properties Read Write Description
BackFlashingColorOff 
(Page 4188) 

P P Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 4188) 

P P Specifies the background color for flash state "On".  

BackFlashingEnabled 
(Page 4189) 

P P Specifies whether the background of the specified object flashes 
in runtime. 

BackFlashingRate (Page 4190) P P  Specifies the flash rate of the background for the selected object. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 4209) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CheckmarkAlignment 
(Page 4233) 

P P Specifies whether the fields are right aligned. 

CheckmarkCount (Page 4233) P P Specifies the number of fields. 
CornerStyle (Page 4250) - - Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 4274) - - Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Font (Page 4311) - - Specifies or returns the font.  
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in italics. 
FontName (Page 4315) P P Specifies the font of the selected object.  
FontSize (Page 4316) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is underlined.  
ForeColor (Page 4318) P P Specifies the font color of the text for the selected object. 
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Properties Read Write Description
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HorizontalAlignment 
(Page 4340) 

P P Specifies the horizontal alignment of the text within the selected 
object. 

Index (Page 4344) P P Specifies the background for grid control elements. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) 

- - Specifies the shape of the line ends. 

LogOperation (Page 4386) P P Specifies whether, after operating this object, an alarm is output 
to the alarm system.  

Name (Page 4417) P P Returns the object name as STRING. 
ProcessValue (Page 4461) P P Specifies the default for the value to be displayed.  
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowBadTagState (Page 4516) P P Specifies whether an object is grayed out if its associated tag has 

a bad quality code or tag state. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
Text (Page 4572) P P Specifies the label for the text field.  
TextOrientation (Page 4576) P P Specifies the text orientation of the selected object.  
Texts - - Specifies the texts for the check boxes. 
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

VerticalAlignment (Page 4701) P P Specifies the vertical alignment of the text for the selected object. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-32 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime.
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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Circle

Description

Represents the "Circle" object. The Circle object is an element of the ScreenItems list. 

Type identifier in VBS
HMICircle

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-33 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P, A P, A Defines the fill pattern of the specified object.  
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P, A P, A Specifies the line color of the object. 
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Properties Read Write Description
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 4209) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P, A P, A Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame 
(Page 4270) 

P P Specifies whether the border line of the selected object with a line 
thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 4274) A A Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line end. 

Name (Page 4417) P, A - Returns the object name as STRING. 
Radius (Page 4465) P P, A Specifies the radius of the selected object "Circle". 
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-34 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

CircleSegment

Description

Represents the "CircleSegment" object. The CircleSegment object is an element of the 
ScreenItems list.

Type identifier in VBS
HMICircleSegment
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-35 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in 

runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for 

the selected object.  
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff (Page 4206) P P Specifies the border line color of the selected object for the 

flash state "Off".  
BorderFlashingColorOn (Page 4207) P P Specifies the border line color of the selected object for the 

flash state "On".  
BorderFlashingEnabled (Page 4208) P P Specifies whether the border line of the selected object 

flashes in runtime. 
BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected 

object.  
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with 

a line thickness greater than 1 should be drawn within the 
border or symmetrically to the border. 

EdgeStyle (Page 4273) P P Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in 

runtime.  
EndAngle (Page 4280) P P Specifies the angle at which the end point of the selected 

object deviates from the zero position (0°).  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the 

flash state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the 

flash state "On".  
FlashingEnabled P P Specifies whether the border line of the selected object 

flashes in runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected 

object.  
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
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Properties Read Write Description
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line end. 
Name (Page 4417) P - Returns the object name as STRING. 
Radius (Page 4465) P P Specifies the radius of the selected object "Circle". 
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
StartAngle (Page 4543) P P Specifies the SQL statement. 
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

 

Table 10-36 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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CircularArc

Description

Represents the "CircularArc" object. The CircularArc object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMICircularArc

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-37 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
Color (Page 4236) P P Specifies the line color of the selected object.  
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
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Properties Read Write Description
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
EndAngle (Page 4280) P P Specifies the angle at which the end point of the selected object 

deviates from the zero position (0°).  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line end. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
Name (Page 4417) P - Returns the object name as STRING. 
Radius (Page 4465) P P Specifies the radius of the selected object "Circle". 
StartAngle (Page 4543) P P Specifies the SQL statement. 
Style (Page 4560) P P Specifies the line style of the selected object.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-38 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen object (list) (Page 3936)

Clock

Description

Represents the "Clock" object. The Clock object is an element of the ScreenItems list. 

Type identifier in VBS
Clock

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-39 Properties

Properties Read Write Description
Analog (Page 4170) P P Specifies whether the clock is displayed as an analog clock.  
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
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Properties Read Write Description
DialColor (Page 4265) P, A P, A Specifies the color of the dial in the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
Flashing - - Specifies that the text block flashes. 
Font (Page 4311) - - Specifies or returns the font.  
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HourNeedleHeight 
(Page 4342) 

P, A P, A Specifies the length of the hour hand in the "Clock" object. 

HourNeedleWidth 
(Page 4343) 

P, A P, A Specifies the width of the hour hand in the "Clock" object.  

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LockSquaredExtent 
(Page 4385) 

P P Specifies whether the tag values are downloaded from the logs for the 
time range to be displayed when you call a screen. 

MinuteNeedleHeight 
(Page 4414) 

P, A P, A Specifies the length of the minute hand in the "Clock" object.  

MinuteNeedleWidth 
(Page 4415) 

P, A P, A Specifies the width of the minute hand in the "Clock" object.  

Name (Page 4417) P, A - Returns the object name as STRING. 
NeedleBorderColor 
(Page 4420) 

P, A P, A Specifies the name of the data source. 

NeedleColor (Page 4420) P, A P, A Specifies the hand color in the "Clock" object. 
NeedleFillStyle (Page 4421) P P Specifies the fill style for the clock hand. 
Picture (Page 4453) - - Specifies the screen to be displayed in the graphics object in runtime.  
SecondNeedleHeight 
(Page 4491) 

P, A P, A Specifies the length of the seconds hand in the "Clock" object. 

SecondNeedleWidth 
(Page 4491) 

P, A P, A Specifies the width of the seconds hand in the "Clock" object. 

ShowFocusRectangle 
(Page 4520) 

P P Specifies whether the button receives a selection border when it is 
activated in runtime.  

ShowTicks (Page 4533) P, A P, A Specifies whether the tick marks are displayed in the scale of the 
object. 

TicksColor (Page 4578) P, A P, A Specifies the scale display. 
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-40 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

Connector

Description

Represents the "Connector" object. The Connector object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMIConnector
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-41 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BorderEndStyle (Page 4205) P P Specifies the type of line ends for the selected object. 
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
Color (Page 4236) P P Specifies the line color of the selected object.  
ConnectionType (Page 4248) P P Specifies the type of connector. You can select one of two 

connection types.  
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
EndStyle (Page 4283) - - Specifies how the line end of the selected object is displayed. 
FirstConnectedObjectIndex 
(Page 4298) 

P P Specifies the index number of the upper connector point.  

FirstConnectedObjectName 
(Page 4299) 

P P Specifies the name of the object that is docked to the upper 
connector point. 

Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
LastConnectedObjectIndex 
(Page 4353) 

P P Specifies the index number of the connection point to the last 
connected object.  

LastConnectedObjectName 
(Page 4353) 

P P Specifies the name of the object that is docked to the lower connector 
point. 

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line end. 

LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
Name (Page 4417) P P Returns the object name as STRING. 
Points * - - Specifies the corner points. 
StartStyle (Page 4545) - - Specifies how the line start of the selected object is displayed. 
Style (Page 4560) P P Specifies the line style of the selected object.  
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Properties Read Write Description
SwapFirstWithLastConnection 
(Page 4562) 

P P Specifies whether the text in the object is shown horizontally. 

ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies that the font size from the data source should be used. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P - Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-42 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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DateTimeField

Description

Represents the "Date/time field" object. The DateTimeField object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIDateTimeField

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-43 Properties

Properties Read Write Description
Authorization (Page 4175) - - Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4183) A A Specifies the background color of the selected object. 
BackFillStyle (Page 4186) - - Defines the fill pattern of the specified object.  
BorderBackColor (Page 4199) * - - Specifies the background color of the broken border line for the 

selected object.  
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Properties Read Write Description
BorderColor (Page 4203) A A Specifies the line color of the object. 
BorderStyle3D (Page 4215) A A Specifies whether the object has a 3D border shading. 
DisplaySystemTime - - Specifies that the system time is displayed. 
EdgeStyle (Page 4273) - - Specifies the line style of the selected object.  
Enabled (Page 4279) A A Specifies whether the selected object can be operated in runtime.  
FitToLargest - - Specifies that the size of the object depends on the text length in all 

languages. 
Flashing - - Specifies that the text block flashes. 
Font (Page 4311) * - - Specifies or returns the font.  
ForeColor (Page 4319) A A Specifies the font color of the text for the selected object. 
Format - - Specifies that the format of the text block is displayed. 
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HelpText (Page 4330) A - Returns the tooltip that is shown in runtime as user help for the 

specified object.  
HorizontalAlignment 
(Page 4341) 

A A Specifies the horizontal alignment of the text within the selected object. 

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
LineWrap * - - Specifies the line break within the object. 
LongDateTimeFormat - - Specifies that the date and time are displayed in long format. 
Mode (Page 4415) - - Specifies the field type of the selected object. 
Name (Page 4417) A - Returns the object name as STRING. 
ProcessValue (Page 4461) A A Specifies the default for the value to be displayed.  
ShowDate - - Specifies that the date is to be displayed. 
ShowTime - - Specifies that only the time is displayed.
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
VerticalAlignment (Page 4701) A A Specifies the vertical alignment of the text for the selected object. 
Visible (Page 4703) * A A Specifies whether the selected object is visible. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-44 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
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See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

DiskSpaceView

Description

Represents the "Disk space view" object. The DiskSpaceView object is an element of the 
ScreenItems list. 

Type identifier in VBS
IXDiskSpaceView

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-45 Properties

Properties Read Write Description
Alarm (Page 4159) P P Specifies the limit for the memory space view from which an alarm is 

output.  
AlarmColor (Page 4160) P P Specifies the alarm types to be displayed in the alarm view. 
Drive (Page 4272) P P Specifies the characters of the drive that is to be monitored. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
Free (Page 4322) P P Returns the size of the free memory space.  
FreePercent (Page 4322) P P Returns the measured values for the free disk space as a percentage.  
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Interval (Page 4348) P P Specifies the time interval for updating the displayed measured values. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
Name (Page 4417) P - Returns the object name as STRING. 
NormalColor P P Specifies the color of the object in the normal range. 
Tolerance (Page 4610) P P Specifies the limit for the storage space display as of which a deviation 

will be reported.  
ToleranceColor (Page 4611) P P Specifies the colors in which the bars of the memory space display are 

shown as soon as the tolerance range is exceeded.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Total (Page 4632) P P Returns the storage capacity.  
Used (Page 4688) P P Specifies whether scrolling is enabled. 
UsedPercent (Page 4688) P P Returns the measured values for the occupied memory space as a 

percentage. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Warning (Page 4706) P P Specifies the limit for the memory space view from which a warning is 

output. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" objects. 

 

Table 10-46 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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Ellipse

Description

Represents the "Ellipse" object. The Ellipse object is an element of the ScreenItems list. 

Type identifier in VBS
HMIEllipse

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-47 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P, A P, A Defines the fill pattern of the specified object.  
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P, A P, A Specifies the line color of the object. 
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Properties Read Write Description
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 4209) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P, A P, A Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 4273) A A Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line end. 

Name (Page 4417) P, A - Returns the object name as STRING. 
RadiusHeight (Page 4466) P P Specifies the minor axis of the "Ellipsis" object.  
RadiusWidth (Page 4467) P P Specifies the major axis of the "Ellipsis" object.  
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-48 Method

Method Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

EllipseSegment

Description

Represents the "EllipseSegment" object. The EllipseSegment object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIEllipseSegment
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-49 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash state 
"Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash state 
"On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 4209) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame 
(Page 4270) 

P P Specifies whether the border line of the selected object with a line 
thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 4274) P P Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
EndAngle (Page 4280) P P Specifies the angle at which the end point of the selected object 

deviates from the zero position (0°).  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash state 

"Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash state 

"On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
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Properties Read Write Description
LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line end. 

Name (Page 4417) P - Returns the object name as STRING. 
RadiusHeight (Page 4466) P P Specifies the minor axis of the "Ellipsis" object.  
RadiusWidth (Page 4467) P P Specifies the major axis of the "Ellipsis" object.  
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
StartAngle (Page 4543) P P Specifies the SQL statement. 
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-50 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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EllipticalArc

Description

Represents the "EllipticalArc" object. The EllipticalArc object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMIEllipticalArc

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-51 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
Color (Page 4236) P P Specifies the line color of the selected object.  
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
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Properties Read Write Description
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
EndAngle (Page 4280) P P Specifies the angle at which the end point of the selected object 

deviates from the zero position (0°).  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) - - Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) - - Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) - - Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) - - Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line end. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
Name (Page 4417) P - Returns the object name as STRING.
RadiusHeight (Page 4466) P P Specifies the minor axis of the "Ellipsis" object.  
RadiusWidth (Page 4467) P P Specifies the major axis of the "Ellipsis" object.  
StartAngle (Page 4543) P P Specifies the SQL statement. 
Style (Page 4560) P P Specifies the line style of the selected object.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  

 

Table 10-52 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen object (list) (Page 3936)

ForeignControl

Description     

Object Type of ScreenItem Object. Represents the graphic object "Control"

The control object type always assumes the properties of the control type selected. In the case 
of controls provided by WinCC, the properties are indicated under the description of the 
corresponding control.

In the case of controls from external suppliers, the control properties are supplied and thus not 
a part of this description. However, the control properties can be queried using the "Item" 
property.

Type Identifier in VBS
Special WinCC type descriptions or version-independent ProgID

Use
In the following example, the object with the name "Control1" is moved 10 pixels to the right:

 
'VBS36
Dim objControl
Set objControl = ScreenItems("Control1")
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objControl.Left = objControl.Left + 10

Special feature
The controls provided by WinCC return a special ID as the type. It can be found under the 
topic "Type Identification in VBS" in the individual descriptions of the WinCC controls.

Access to specific properties instead of event parameters of the third-party controls
The parameter list of an event with third-party control is not read in WinCC. To have access 
to custom parameters of control events, you need to implement properties in the control instead 
of parameters. 

The following code example shows the source code of the "UserControlTestModify" control, 
in which the "Title" and "Description" properties are defined instead of parameters.

 
public partial class UserControlTestModify : UserControl
    {
        public event MyEventHandler MyEvent = null;
 
        public string Title
        {
            get;
            private set;
        }
 
        public string Description
        {
            get;
            set;
        }
     
        public UserControlTestModify()
        {
            InitializeComponent();
        }
        private void OnMyEvent(Exception e)
        {
            if (this.MyEvent!= null)
            {
               //  Place place data in Properties before invoking event.
                Title = "title";
                Description = "description"; ";
                this.MyEvent.Invoke();               
            }
        }
 
        private void button1_Click(object sender, EventArgs e)
        {            
            this.OnMyEvent (null);            
        }
    }
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The specific properties of a third-party control are not displayed in WinCC with IntelliSense. 

The following example shows how to access the specific "Title" property of the third-party 
control "FControl" in WinCC :

 
HMIRuntime.Screens("StartScreen").ScreenItems("FControl").Title = "MyForeignControl"

ProgID and UserfriendlyName of third-party controls
The version-independent ProgID is returned as the type if non-WinCC controls are used.

It is possible to determine the version-dependent ProgID or "UserfriendlyName" from the 
ProgID: In the following example, "Control1" is a control embedded in the picture which already 
returns the version-independent ProgID as a result of the Type property.

 

 Note

Since not every control has a version-dependent ProgID, an error handling measure should 
be integrated to query the version-dependent ProgID or UserFriendlyName. If no error 
handling is used, the code is terminated immediately without any result when no ProgID is 
found.

 

Determine the version-dependent ProgID as follows:

 
'VBS37
Dim objControl
Dim strCurrentVersion
Set objControl = ScreenItems("Control1")
strCurrentVersion = CreateObject("WScript.Shell").RegRead("HKCR\" & objControl.Type & 
"\CurVer\")
MsgBox strCurrentVersion

 
 

 Note

In order that example above works, a multimedia control should be inserted in the picture.
 

Determine the UserFriendlyName as follows:

 
'VBS38
Dim objControl
Dim strFriendlyName
Set objControl = ScreenItems("Control1")
strFriendlyName = CreateObject("WScript.Shell").RegRead("HKCR\" & objControl.Type & "\")
MsgBox strFriendlyName
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 Note

In order that example above works, a multimedia control should be inserted in the picture.
 

If a non-WinCC control is used, it is possible that the properties provided by the control have 
the same names as the general ScreenItem properties. In such cases, the ScreenItem 
properties have priority. The "hidden" properties of an external control supplier can be 
accessed using the additional "object" property. Address the properties of an external control 
supplier as follows: 

 
Control.object.type

 

The properties of the ScreenItem object are used in the case of identical names, if you use 
the following form: 

 
Control.type

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-53 Properties

Properties Read Write Description
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
Name (Page 4417) P - Returns the object name as STRING. 
OCXState (Page 4428) * - - Sets the OCX status. 
ProgID (Page 4463) * - - The version-independent ProgID is returned as the type if non-

WinCC controls are used. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES
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Table 10-54 Methods

Methods Valid Description
   
   
   
   

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

FunctionTrendControl

Description

Represents the "f(x)FunctionTrendView" object. The FunctionTrendControl object is an 
element of the ScreenItems list.

Type identifier in VBS
HMIFunctionTrendControl
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-55 Properties

Properties Read Write Description
Enabled (Page 4277) P P Specifies whether the selected object can be operated in 

runtime.
Height (Page 4327) P - Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
ObjectName (Page 4424) P - Returns the object name as STRING. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Type (Page 4664) P - Returns the type of the specified object as STRING.
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P - Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

Table 10-56 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
AttachDB (Page 4750) P, A Executes the "Connect backup" button function of the control.
DeactivateDynamic (Page 4754) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.
DetachDB (Page 4756) P, A Executes the "Disconnect backup" button function of the control.
Export (Page 4757) P, A Executes the "Export log" or "Export data" button function of the control.
GetStatusbarElement (Page 4784) P, A Returns the element of the control's status bar designated by name or 

index as "ICCAxStatusbarElement" type.
GetStatusbarElementCollection 
(Page 4785) 

P, A Returns the list of all status bar elements of the control as 
"ICCAxCollection" type.

GetToolbarButton (Page 4792) P, A Returns the button function designated by name or index on the control 
toolbar as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 4793) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

GetTrend (Page 4794) P, A Returns the f(t) or f(x) trend view designated by name or index as 
"ICCAxTrend" or "ICCAxFunctionTrend" type.

GetTrendCollection (Page 4795) P, A Returns the list of all trends of the f(t) or f(x) trend view as 
"ICCAxCollection" type.

GetTrendWindow (Page 4797) P, A Returns the trend window object of the f(t) or f(x) trend view designated 
by name or index as "ICCAxTrendWindow" type.
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Methods Valid Description
GetTrendWindowCollection 
(Page 4798) 

P, A Returns the list of all trend window objects of the f(t) or f(x) trend views 
as "ICCAxCollection" type.

GetXAxis (Page 4804) P, A Returns the X axis object of the f(x) trend view designated by name or 
index as "ICCAxValueAxis" type.

GetXAxisCollection (Page 4805) P, A Returns the list of all X axis objects of the f(x) trend view as 
"ICCAxCollection" type.

GetYAxis (Page 4806) P, A Returns the Y axis object of the f(x) trend view designated by name or 
index as "ICCAxValueAxis" type.

GetYAxisCollection (Page 4807) P, A Returns the list of all Y axis objects of the f(x) trend view as 
"ICCAxCollection" type.

MoveAxis (Page 4813) P, A Executes the "Move axes area" button function of the f(t) and f(x) trend 
views.

NextTrend (Page 4820) P, A Executes the "Next trend" button function of the f(t) and f(x) trend views.
OneToOneView (Page 4820) P, A Executes the "Original view" button function of the f(t) and f(x) trend 

views.
PreviousTrend (Page 4822) P, A Executes the "Previous trend" button function of the f(t) and f(x) trend 

views.
Print (Page 4822) P, A Executes the "Print" button function of the control.
ShowHelp (Page 4842) P, A Executes the "Help" button function of the control.
ShowPropertyDialog (Page 4847) P, A Executes the "Configuration dialog" button function of the control.
ShowTagSelection (Page 4851) P, A Executes the "Select data connection" button function of the control.
ShowTimeSelection (Page 4852) P, A Executes the "Select time range" button function of the control.
ShowTrendSelection (Page 4852) P, A Executes the "Select trends" button function of the f(t) and f(x) trend 

views.
StartStopUpdate (Page 4853) P, A Executes the "Start" or "Stop" button function of the control.
ZoomArea (Page 4860) P, A Executes the "Zoom area" button function of the f(t) and f(x) trend views.
ZoomInOut (Page 4861) P, A Executes the "Zoom +/-" button function of the f(t) and f(x) trend views.
ZoomInOutX (Page 4862) P, A Executes the "Zoom X axis +/-" button function of the f(x) trend view.
ZoomInOutY (Page 4863) P, A Executes the "Zoom Y axis +/-" button function of the f(x) trend view.
ZoomMove (Page 4863) P, A Executes the "Move trend area" button function of the f(t) and f(x) trend 

views.
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See also
BackColor (Page 4181)

Caption  (Page 4221)

LoadDataImmediately (Page 4383)

Online  (Page 4428)

TimeBase (Page 4584)

ShowRuler  (Page 4525)

Screen object (list) (Page 3936)

ApplyProjectSettings (Page 4172)

BorderColor (Page 4202)

BorderWidth (Page 4216)

Closable (Page 4236)

ConnectTrendWindows (Page 4248)

ExportDirectoryChangeable (Page 4286)

ExportDirectoryname (Page 4286)

ExportFileExtension (Page 4287)

ExportFilename (Page 4288)

ExportFilenameChangeable (Page 4288)

ExportFormatGuid (Page 4289)

ExportFormatName (Page 4289)

ExportParameters (Page 4290)

ExportSelection (Page 4290)

ExportShowDialog (Page 4291)

Font (Page 4311)

GraphDirection (Page 4324)

Layer (Page 4355)

LineColor (Page 4379)

LineWidth (Page 4381)

Movable (Page 4416)

Name  (Page 4417)

RTPersistence (Page 4477)

RTPersistenceType (Page 4478)

UseTrendNameAsLabel (Page 4687)

ToolbarAlignment (Page 4616)

ToolbarBackColor (Page 4616)

ToolbarButtonActive (Page 4617)

ToolbarButtonAdd (Page 4618)

ToolbarButtonBeginGroup (Page 4618)

ToolbarButtonCount (Page 4619)

ToolbarButtonEnabled (Page 4619)

ToolbarButtonHotKey (Page 4620)

ToolbarButtonID (Page 4620)

ToolbarButtonIndex (Page 4620)

ToolbarButtonLocked (Page 4621)

ToolbarButtonName (Page 4621)

ToolbarButtonPasswordLevel (Page 4622)

ToolbarButtonRemove (Page 4622)

ToolbarButtonRename (Page 4622)

ToolbarButtonRepos (Page 4623)

ToolbarButtonTooltipText (Page 4623)

ToolbarButtonUserDefined (Page 4624)

ToolbarShowTooltips (Page 4624)

ToolbarUseBackColor (Page 4625)

ToolbarUseHotKeys (Page 4626)

ToolbarVisible (Page 4626)

TrendActualize (Page 4637)

TrendAdd (Page 4638)

TrendBeginTime (Page 4638)

TrendColor (Page 4638)

TrendCount (Page 4639)

TrendEndTime (Page 4639)

TrendExtendedColorSet (Page 4639)

TrendFill (Page 4640)

TrendFillColor (Page 4640)

TrendIndex (Page 4641)

TrendLabel (Page 4642)

TrendLineStyle (Page 4642)

TrendLineType (Page 4643)

TrendLineWidth (Page 4643)

TrendLowerLimit (Page 4644)

TrendLowerLimitColor (Page 4644)

TrendLowerLimitColoring (Page 4644)

TrendMeasurePoints (Page 4645)

TrendName (Page 4645)

TrendPointColor (Page 4645)

TrendPointStyle (Page 4646)

TrendPointWidth (Page 4646)

TrendProvider  (Page 4647)

TrendRangeType (Page 4647)

TrendRemove (Page 4648)

TrendRename (Page 4648)

TrendRepos (Page 4649)

TrendSelectTagNameX (Page 4649)

TrendSelectTagNameY (Page 4649)

TrendTagNameX (Page 4650)

TrendTagNameY (Page 4651)

TrendTimeRangeBase (Page 4651)

TrendTimeRangeFactor (Page 4652)

TrendTrendWindow (Page 4652)

TrendUncertainColor (Page 4652)

TrendUncertainColoring (Page 4653)

TrendUpperLimit (Page 4653)

TrendUpperLimitColor (Page 4654)

TrendUpperLimitColoring (Page 4654)

TrendVisible (Page 4654)

TrendWindowAdd (Page 4655)

TrendWindowCoarseGrid (Page 4655)

TrendWindowCoarseGridColor (Page 4656)

TrendWindowFineGrid (Page 4656)

TrendWindowFineGridColor (Page 4657)

TrendWindowForegroundTrendGrid (Page 4657)

TrendWindowGridInTrendColor (Page 4657)

TrendWindowHorizontalGrid (Page 4658)

TrendWindowIndex (Page 4659)

TrendWindowName (Page 4659)

TrendWindowRemove (Page 4659)

TrendWindowRename (Page 4659)

TrendWindowRepos (Page 4660)

TrendWindowRulerColor (Page 4660)

TrendWindowRulerLayer (Page 4660)

TrendWindowRulerStyle (Page 4661)

TrendWindowRulerWidth (Page 4662)

TrendWindowSpacePortion (Page 4662)

TrendWindowVerticalGrid (Page 4662)

TrendWindowVisible (Page 4663)

TrendXAxis (Page 4663)

TrendYAxis (Page 4663)

ShowRulerInAxis (Page 4526)

ShowScrollbars (Page 4527)

ShowTitle (Page 4534)

ShowTrendIcon (Page 4535)

StatusbarBackColor (Page 4547)

StatusbarElementAdd (Page 4547)

StatusbarElementAutoSize (Page 4548)

StatusbarElementCount (Page 4548)

StatusbarElementIconId (Page 4549)

StatusbarElementID (Page 4549)

StatusbarElementIndex (Page 4550)

StatusbarElementName (Page 4550)

StatusbarElementRemove (Page 4551)

StatusbarElementRename (Page 4551)

StatusbarElements (Page 4552)

StatusbarElementTooltipText (Page 4552)

StatusbarElementUserDefined (Page 4553)

StatusbarElementVisible (Page 4554)

StatusbarElementWidth (Page 4554)

StatusbarFontColor (Page 4554)

StatusbarShowTooltips (Page 4557)

StatusbarText (Page 4558)

StatusbarUseBackColor (Page 4558)

StatusbarVisible (Page 4559)

XAxisAdd (Page 4719)

XAxisAutoPrecisions (Page 4720)

XAxisAutorange(i)  (Page 4720)

XAxisBeginValue (Page 4721)

XAxisColor (Page 4721)

XAxisCount (Page 4722)

XAxisEndValue (Page 4723)

XAxisExponentialFormat (Page 4724)

XAxisIndex (Page 4725)

XAxisInTrendColor (Page 4725)

XAxisName (Page 4727)

XAxisPrecisions (Page 4727)

XAxisRemove (Page 4728)

XAxisRepos (Page 4728)

XAxisTrendWindow (Page 4731)

XAxisVisible (Page 4732)

YAxisAdd (Page 4733)

YAxisAutoPrecisions (Page 4734)

YAxisAutoRange (Page 4735)

YAxisBeginValue (Page 4735)

YAxisColor (Page 4735)

YAxisCount (Page 4736)

YAxisEndValue (Page 4736)

YAxisExponentialFormat (Page 4736)

YAxisIndex (Page 4737)

YAxisInTrendColor (Page 4737)

YAxisLabel (Page 4738)

YAxisName (Page 4738)

YAxisPrecisions (Page 4738)

YAxisRemove (Page 4739)

YAxisRepos (Page 4739)

YAxisScalingType (Page 4740)

YAxisTrendWindow (Page 4740)

YAxisVisible (Page 4741)

SkinName (Page 4538)
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Gauge

Description

Represents the "Gauge" object. The Gauge object is an element of the ScreenItems list. 

Type identifier in VBS
HMIGauge

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-57 Properties

Properties Read Write Description
AngleMax (Page 4170) P, A P, A Specifies the angle for the scale end of the "Gauge" object. 
AngleMin (Page 4171) P, A P, A Specifies the angle for the scale start of the "Gauge" object. 
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackPicture - - Specifies a graphic for the background. 
BorderInnerStyle3D (Page 4210) P P Specifies the representation of the inner part of the object border. 
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Properties Read Write Description
BorderOuterStyle3D 
(Page 4211) 

P P Specifies the representation of the outer part of the object border. 

BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
BorderWidth3D (Page 4218) P P Specifies the width of the border for 3D display of the selected 

object. 
CaptionColor (Page 4223) P, A P, A Specifies the color of the text that is displayed in the header of 

the selected object.  
CaptionFont - - Specifies the character set for the caption. 
CaptionText (Page 4224) P, A P, A Specifies the text that is displayed in the header of the selected 

object. 
CaptionTop (Page 4225) P P Specifies the distance of the instrument label from the top edge 

of the selected object. 
CenterColor (Page 4228) P, A P, A Sets the color for the center point of the "Gauge" object. 
CenterSize (Page 4229) P P Sets the diameter of the round scale center point.  
DangerRangeColor (Page 4259) P, A P, A Sets the color of the danger range on the scale of the "Gauge" 

object. 
DangerRangeStart (Page 4259) P, A P, A Specifies the scale value at which the danger range of the 

"Gauge" object begins.  
DangerRangeVisible 
(Page 4260) 

P, A P, A Specifies whether the danger range is displayed in the scale of 
the "Gauge" object. { 

DialColor (Page 4265) P, A P, A Specifies the color of the dial in the selected object.  
DialFillStyle (Page 4266) P P Specifies the type of background for the selected object. 
DialPicture - - Specifies a graphic for the dial. 
DialSize (Page 4267) P P Specifies the diameter of the scale disc based on the smaller 

value of the "Width" and "Height" geometry attributes.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in 

runtime.  
Flashing * - - Specifies that the text block flashes. 
Gradation (Page 4323) P, A P, A Specifies the value difference between two main tick marks of 

the "Gauge" object.  
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LockSquaredExtent (Page 4385) P P Specifies whether the tag values are downloaded from the logs 

for the time range to be displayed when you call a screen. 
MaximumValue (Page 4392) P, A P, A Specifies the maximum value of the scale in the selected object.  
MinimumValue (Page 4413) P, A P, A Specifies the minimum value of the scale in the selected object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
NormalRangeColor (Page 4422) P, A P, A Specifies the color of the normal range on the scale of the 

"Gauge" object. " 
NormalRangeVisible 
(Page 4422) 

P, A P, A Specifies whether the normal range in the scale of the "Gauge" 
object will be displayed. 

PointerColor (Page 4457) P, A P, A Specifies the pointer color of the "Gauge" object. 
ProcessValue (Page 4461) P, A P, A Specifies the default for the value to be displayed.  
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Properties Read Write Description
ScaleLabelColor (Page 4483) P, A P, A Specifies the color of the label for the scale tick marks of the 

"Gauge" object. 
ScaleLabelFont - - Specifies the font of the scale label. 
ScaleTickColor (Page 4484) P, A P, A Specifies the color of the scale tick marks of the "Gauge" object. 
ScaleTickLabelPosition 
(Page 4485) 

P P Specifies the diameter of the imaginary circle on which the scale 
tick label is location.  

ScaleTickLength (Page 4485) P P Specifies the length of the main scale ticks.  
ScaleTickPosition (Page 4486) P P Specifies the diameter of the assumed circle on which the scale 

divisions are located. 
ShowDecimalPoint (Page 4519) P P Specifies whether the scale is labeled with decimal figures 

(decimal point and one decimal place) or with whole integers.  
ShowPeakValuePointer 
(Page 4523) 

P, A P, A Specifies whether a slave pointer will be used for the selected 
object. 

Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UnitColor (Page 4667) P, A P, A Specifies the text color for the label of the measurement unit in 

the "Gauge" object. 
UnitFont - - Specifies the font for the unit. 
UnitText (Page 4668) P, A P, A Specifies the text for the measurement unit of the selected object. 
UnitTop (Page 4669) P P Specifies the distance of the measurement unit from the upper 

edge of the selected object. 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
WarningRangeColor 
(Page 4710) 

P, A P, A Specifies the color of the warning range on the scale of the 
"Gauge" object. 

WarningRangeStart (Page 4710) P, A P, A Specifies the scale value from which the warning range of the 
"Gauge" object begins. 

WarningRangeVisible 
(Page 4711) 

P, A P, A Specifies whether the warning range is displayed in the scale of 
the "Gauge" object. 

Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 
objects. 

* not visible in the ES

Table 10-58 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen object (list) (Page 3936)

GraphicIOField

Description

Represents the "Graphic I/O field" object. The GraphicIOField object is an element of the 
ScreenItems list. 

     

The availability of the following object properties depends on the selected mode:

Property "Input" "Output" "Input/Output" "Two states"
BorderColor -- -- -- x
BorderStyle3D x x x --
Enabled x -- x --
FocusColor x -- x --
FocusWidth x -- x --
HelpText x -- x --
TransparentColor x x x --
UseTransparentC
olor

x x x --

Type identifier in VBS
HMIGraphicIOField
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-59 Properties

Properties Read Write Description
AboveUpperLimitColor 
(Page 4147) 

- - Sets the color of the specified object for the "High limit violated" 
event. 

AdaptPicture - - Specifies that the size of the object is automatically adjusted in 
runtime. 

Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
AutoSizing - - Specifies that the size of the object should be automatically 

adapted to the content. 
BackColor (Page 4181) A A Specifies the background color of the selected object. 
BelowLowerLimitColor 
(Page 4196) 

- - Sets the color of the specified object for the "Low limit violated" 
event. 

BitNumber (Page 4197) - - Specifies the bit whose status must change to trigger a value 
change.  

BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 
selected object.  

BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected object.  
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 4215) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a 

line thickness greater than 1 should be drawn within the border 
or symmetrically to the border. 

EdgeStyle (Page 4274) P P Specifies the line style of the selected object.  
Enabled (Page 4277) P, A P, A Specifies whether the selected object can be operated in 

runtime.  
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Flashing - - Specifies that the text block flashes. 
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Properties Read Write Description
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes 

in runtime.  
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
FlashTransparentColor 
(Page 4307) 

P P Specifies the color of the bitmap object of a flashing graphic that 
is set to "transparent". 

FocusColor (Page 4308) A A Specifies the color for the focus frame of the selected object 
when it is in focus. 

FocusWidth (Page 4310) A A Specifies the border width of the specified object when the object 
is in focus.  

Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and 
"Rectangle" objects.  

HelpText (Page 4330) A - Returns the tooltip that is shown in runtime as user help for the 
specified object.  

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line ends. 
Mode (Page 4415) - - Specifies the field type of the selected object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
OnValue - - Specifies the value for the "ON" state in "two-state" mode. 
PictureList - - Specifies the graphic list that supplies the object with values. 
PictureOff (Page 4455) - - Specifies the screen to be displayed in the "Off" state.  
PictureOn (Page 4455) - - Specifies the screen to be displayed in the "On" state.  
ProcessValue (Page 4461) P P Specifies the default for the value to be displayed.  
ScrollBarOrientation - - Specifies the orientation of the scroll bar. 
ShowScrollBar - - Specifies the scroll bar type. 
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
TransparentColor (Page 4635) P, A P, A Specifies which color of the allocated graphic (*.bmp, *dib) of the 

specified object is set to "transparent". 
UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

UseFlashTransparentColor 
(Page 4679) 

P P Specifies whether the color of the bitmap object of a flashing 
graphic is set to "transparent". 

UseTransparentColor 
(Page 4685) 

P, A P, A Specifies whether the color defined with the property 
"TransparentColor" is shown as transparent for the selected 
object. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-60 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 4747) 

P Dynamically activates a trigger and the specified cycle for a property at runtime. 

DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

GraphicView

Description

Represents the "Graphic view" object. The GraphicView object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIGraphicView
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-61 Properties

Properties Read Write Description
AdaptPicture A - Specifies that the size of the object is automatically adjusted in 

runtime. 
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
AutoSizing - - Specifies that the size of the object should be automatically 

adapted to the content. 
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff 
(Page 4188) 

P P Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 4188) 

P P Specifies the background color for flash state "On".  

BackFlashingEnabled 
(Page 4189) 

P P Specifies whether the background of the specified object flashes 
in runtime. 

BackFlashingRate (Page 4190) P P Specifies the flash rate of the background for the selected object. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected object.  
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 4215) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 4274) P P Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
FitToLargest - - Specifies that the size of the object depends on the text length in 

all languages. 
Flashing - - Specifies that the text block flashes. 
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Properties Read Write Description
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line ends. 
Name (Page 4417) P, A - Returns the object name as STRING. 
Picture (Page 4453) P P Specifies the screen to be displayed in the graphics object in 

runtime.  
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
TransparentColor (Page 4635) P, A P, A Specifies which color of the allocated graphic (*.bmp, *dib) of the 

specified object is set to "transparent". 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

UseTransparentColor 
(Page 4685) 

P, A P, A Specifies whether the color defined with the property 
"TransparentColor" is shown as transparent for the selected 
object. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-62 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 4747) 

P Dynamically activates a trigger and the specified cycle for a property at runtime. 

DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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Group

Description

Represents the "Group" object. The Group object is an element of the ScreenItems list.

Type identifier in VBS
HMIGroup

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-63 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
ForeColor (Page 4318) P P Specifies the font color of the text for the selected object. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
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Properties Read Write Description
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
Name (Page 4417) - - Returns the object name as STRING. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-64 Methods

Methods Valid Description
   
   
   
   
   
   

 

See also
Screen object (list) (Page 3936)
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HTMLBrowser

Description

Represents the object "HTML Browser". The HTMLBrowser-object is an element of the 
ScreenItems-list.

Type identifier in VBS
HMIHTMLBrowser

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-65 Properties

Properties Read Write Description
Address (Page 4158) P, A P, A Defines the Web address which is opened in the HTML browser. 
Enabled (Page 4277) P, A P, A Specifies whether the selected object can be operated in runtime.  
Flashing * - - Specifies that the text block flashes. 
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
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Properties Read Write Description
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
ShowStatusBar 
(Page 4530) 

P P Specifies whether the status bar is shown.  

ShowToolBar (Page 4534) * - - Specifies whether the toolbar is shown.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-66 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

SetHtml ??  

 

See also
Screen object (list) (Page 3936)
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IOField

Description

Represents the "I/O field" object. The IOField object is an element of the ScreenItems list. 

Type identifier in VBS
HMIIOField

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-67 Properties

Properties Read Write Description
AboveUpperLimitColor 
(Page 4147) 

- - Sets the color of the specified object for the "High limit violated" 
event. 

AcceptOnExit (Page 4148) P P Specifies whether the input field is confirmed automatically 
when it is left. 

AcceptOnFull (Page 4148) P P Specifies whether the input field will be left and confirmed 
automatically when the defined number of values has been 
entered. 
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Properties Read Write Description
AdaptBorder (Page 4156) P P Specifies whether the border of the specified object is 

dynamically adapted to the text size. 
AskOperationMotive (Page 4173) P P Specifies whether the reason for operating this object is logged. 
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime. 
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object. 
BackFlashingColorOff (Page 4188) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 4188) P P Specifies the background color for flash state "On". 
BackFlashingEnabled (Page 4189) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 4190) P P Specifies the flash rate of the background for the selected 

object. 
BelowLowerLimitColor (Page 4196) - - Sets the color of the specified object for the "Low limit violated" 

event. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object. 
BorderColor (Page 4202) P, A P, A Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off". 

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On". 

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected object. 
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 4215) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
BottomMargin - - Sets the margin between the text and the bottom edge of the 

object. 
ClearOnError (Page 4234) P P Specifies whether an invalid input in this object is deleted 

automatically. 
ClearOnFocus (Page 4235) P P Specifies whether the field entry is deleted as soon as the I/O 

field is activated. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object. 
CursorControl (Page 4256) P P Specifies whether the mouse cursor jumps to the next field of 

the TAB sequence after leaving a field. 
DataFormat (Page 4261) P P Returns the data type of the IOField object. 
EdgeStyle (Page 4274) A A Specifies the line style of the selected object. 
EditOnFocus (Page 4276) P P Specifies whether data input is immediately possible if the input 

field is selected using the "Tab" key. 
Enabled (Page 4277) P, A P, A Specifies whether the selected object can be operated in 

runtime. 
FieldLength (Page 4293) – - Specifies that the "Field length string" field is read-only. 
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object. 
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
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Properties Read Write Description
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off". 
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On". 
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes 

in runtime. 
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object. 
Font (Page 4311) - - Specifies or returns the font. 
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 4315) P P Specifies the font of the selected object. 
FontSize (Page 4316) P P Specifies the font size of the text for the selected object. 
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is underlined. 
ForeColor (Page 4318) P, A P, A Specifies the font color of the text for the selected object. 
FormatPattern (Page 4320) P P Specifies the format of the output value. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HelpText (Page 4330) A - Returns the tooltip that is shown in runtime as user help for the 

specified object.  
HiddenInput (Page 4331) P P Specifies whether the input value or a * for each character is 

shown during the input.  
HorizontalAlignment (Page 4340) P, A P, A Specifies the horizontal alignment of the text within the selected 

object. 
InputValue (Page 4346) P P Defines the value entered by the user in the IO field. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left  (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LeftMargin - A Sets the margin between the text and the left edge of the object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line end. 
LogOperation (Page 4386) P P Specifies whether, after operating this object, an alarm is output 

to the alarm system.  
LowerLimit (Page 4388) P P Specifies the low limit for input values. 
Mode  (Page 4415) P P Specifies the field type of the selected object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
ProcessValue (Page 4461) P, A P, A Specifies the default for the value to be displayed. 
RightMargin - - Sets the margin between the text and the right edge of the 

object. 
ShiftDecimalPoint (Page 4514) - - Specifies that the "Shift decimal point" field is read-only. 
ShowBadTagState (Page 4516) P P Specifies whether an object is grayed out if its associated tag 

has a bad quality code or tag state. 
ShowLeadingZeros - - Specifies that leading zeros should be displayed. 
TextOrientation (Page 4576) P P Specifies the text orientation of the selected object.  
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Properties Read Write Description
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top  (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
TopMargin - - Sets the margin between the text and the top edge of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the 

object.  
Unit (Page 4667) P P Specifies the unit of measurement in the "IOField" object. 
UpperLimit (Page 4670) P P Specifies the high limit for input values. 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

UseTagLimitColors P P Specifies whether the configured colors are used when limits 
are violated. 

VerticalAlignment (Page 4701) P, A P, A Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

 

 

Table 10-68 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic (Page 4754) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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Objects K-Z

Line

Description

Represents the "Line" object. The Line object is an element of the ScreenItems list. 

Type identifier in VBS
HMILine

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-69 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BorderEndStyle (Page 4205) P, A P, A Specifies the type of line ends for the selected object. 
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Properties Read Write Description
BorderStyle (Page 4213) P, A P, A Specifies the type of line ends for the selected object.
Color (Page 4236) P, A P, A Specifies the line color of the selected object.  
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
EndLeft - - Specifies the X position of the end point. 
EndStyle (Page 4283) P, A P, A Specifies how the line end of the selected object is displayed. 
EndTop - - Sets the Y position of the end point. 
FillStyle (Page 4297) A A Defines the fill pattern of the specified object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash state 

"Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash state 

"On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line end. 

LineWidth (Page 4381) P, A P, A Specifies the line thickness of the selected object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
RotationAngle (Page 4472) P P Specifies the angle of rotation in degrees.  
RotationCenterLeft 
(Page 4473) 

P P Specifies the X coordinate of the pivot point for the object in runtime. 

RotationCenterTop 
(Page 4474) 

P P Specifies the Y coordinate of the pivot point for the object in runtime. 

StartLeft - - Specifies the X position of the starting point. 
StartStyle (Page 4545) A A Specifies how the line start of the selected object is displayed. 
StartTop (Page 4546) - - Specifies the vertical distance in pixels between the start point and 

the top edge of the screen. 
Style (Page 4560) P, A P, A Specifies the line style of the selected object.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-70 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

Listbox

Description     

Represents the "Listbox" object. The Listbox object is an element of the ScreenItems list.

Type identifier in VBS
HMIListBox
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Application
In the following example, the object with the name "ListBox1" is moved 10 pixels to the right:

 
'VBS21
Dim objListBox
Set objListBox = ScreenItems("ListBox1")
objListBox.Left = objListBox.Left + 10

 

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-71 Properties

Properties Read Write Description
AskOperationMotive (Page 4173) P P Specifies whether the reason for operating this object is logged. 
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime. 
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object. 
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object. 
CountVisibleItems (Page 4253) P P Specifies the number of lines contained in the selection list. 
EdgeStyle (Page 4274) - - Specifies the line style of the selected object. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in 

runtime. 
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object. 
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Font (Page 4311) - - Specifies or returns the font. 
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 4315) P P Specifies the font of the selected object. 
FontSize (Page 4316) P P Specifies the font size of the text for the selected object. 
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is underlined. 
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Properties Read Write Description
ForeColor (Page 4318) P P Specifies the font color of the text for the selected object. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
HorizontalAlignment (Page 4340) P P Specifies the horizontal alignment of the text within the selected 

object. 
Index (Page 4344) P P Specifies the background for grid control elements. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line end. 
LogOperation (Page 4386) P P Specifies whether, after operating this object, an alarm is output 

to the alarm system. 
Name (Page 4417) P - Returns the object name as STRING. 
SelectedIndex (Page 4495) P P Specifies and returns the index whose associated text is 

highlighted in the combo or list box. 
SelectedText (Page 4493) P P Displays the text that is defined with the "Selected field" 

(SelIndex) attribute and highlighted in the combo box or list box. 
Text (Page 4572) P P Specifies the label for the text field. 
Texts - - Specifies the texts for the check boxes. 
ToolTipText (Page 4627) P P Specifies the tooltip text. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the 

object. 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

 

Table 10-72 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

MediaPlayer

Description         

Represents the "Media Player" object. The MediaControl object is an element of the 
ScreenItems list.

Type Identifier in VBS
HMIMediaControl

Application
In the following example, the object with the name "Control1" is moved 16 pixels to the right:

 
'VBS60
Dim objControl
Set objControl = ScreenItems("Control1")
objControl.Left = objControl.Left + 16
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-73 Properties

Properties Read Write Description
AspectRatio P P Specifies whether the aspect ratio is maintained when the size is 

changed. 
AutoStart P P Specifies that the Media Player should start automatically. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime. 
FileName P, A P, A Specifies the name of the file to be loaded. 
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
PictureSizeMode P P Specifies that the status bar is displayed. 
PlayCount A A Plays the files several times. 
PlayEndless P P Specifies that the media file should play endlessly. 
PopupMenuEnabled P P Specifies that the shortcut menu can be used. 
ShowControls P, A P, A Specifies that a toolbar is displayed. 
ShowFeatureBackward P P Specifies that the "Backward" button is displayed in runtime. 
ShowFeatureForward P P Specifies that the "Forward" button is displayed in runtime. 
ShowFeatureFullScreen P P Specifies that the Media Player can be displayed as a full screen. 
ShowFeaturePause P P Specifies that the Media Player can be displayed as a full screen 
ShowFeaturePlay P P Specifies that the "Play" button is displayed in runtime. 
ShowFeatureStop P P Specifies that the "Stop" button is displayed in runtime. 
ShowFeatureVolume P P Sets the volume. 
ShowStatusBar (Page 4530) A A Specifies whether the status bar is shown. 
ShowTracker A A Specifies that the tracker is displayed. 
StepSeconds P P Specifies a time in seconds that is to be skipped when the 

"Forward" or "Backward" button is pressed. 
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-74 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 4747) 

P Dynamically activates a trigger and the specified cycle for a property at 
runtime. 

DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the 
specified property in/during Runtime.

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

MultiLineEdit

Description     

Represents the "MultiLine text" object. The MultiLineEdit object is an element of the 
ScreenItems list.

Type identifier in VBS
HMIMultiLineEdit
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Application
In the following example, the object with the name "MultiLineEdit1" is moved 10 pixels to the 
right:

 
'VBS21
Dim objMultiLineEdit
Set objMultiLineEdit = ScreenItems("MultiLineEdit1")
objMultiLineEdit.Left = objMultiLineEdit.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-75 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime. 
BackColor (Page 4181) P P, A Specifies the background color of the selected object. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object. 
BorderColor (Page 4202) P P Specifies the background color of the selected object. 
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object. 
EdgeStyle (Page 4274) - - Specifies the line style of the selected object. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime. 
Font (Page 4311) - - Specifies or returns the font. 
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in italics. 
FontName (Page 4315) P P Specifies the font of the selected object. 
FontSize (Page 4316) P P Specifies the font size of the text for the selected object. 
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is underlined. 
ForeColor (Page 4318) P P Specifies the font color of the text for the selected object. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
HorizontalAlignment 
(Page 4340) 

P P Specifies the horizontal alignment of the text within the selected 
object. 

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line end. 
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Properties Read Write Description
Name (Page 4417) P - Returns the object name as STRING. 
Text (Page 4572) P P Specifies the label for the text field. 
ToolTipText (Page 4627) P P Specifies the tooltip text. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object. 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-76 Methods

Methods Validity Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

GetSelectionText ??  
SetSelection ??  
SetSelectionText ??  

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)
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OLEView

Description

Represents the "OLE object" object. The OLEView object is an element of the ScreenItems 
list.

     

Type identifier in VBS
Version-independent ProgID

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-77 Properties

Properties Read Write Description
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Properties Read Write Description
    
    
    
    
    

 

Table 10-78 Methods

Methods Can be dynamized Validity Description
    
    
    
    
    
    
    
    
    
    
    

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)
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OnlineTableControl

Description

Represents the "Table view" object. The OnlineTableControl object is an element of the 
ScreenItems list.

Type identifier in VBS
HMIOnlineTableControl

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-79 Properties

Properties Read Write Description
ApplyProjectSettingsForDesignMode 
(Page 4172) 

- - Specifies that the project settings are used for the design. 

AutoCompleteColumns (Page 4177) P P Specifies whether empty columns are shown if the control is 
wider than the configured columns.  

AutoCompleteRows (Page 4177) P P Specifies whether empty rows are shown if the control is 
longer than the number of configured rows.  
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Properties Read Write Description
AutoSelectionColors (Page 4178) P P Specifies whether the colors defined by the system are used 

as the selection colors for cells and rows. 
AutoSelectionRectColor (Page 4179) P P Specifies whether the selection frame is shown with the color 

defined by the system.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
Caption (Page 4221) P P Specifies the text that is displayed in the header of the 

selected object.  
CellCut (Page 4225) P P Specifies whether the contents of the cells are abbreviated 

if the cells are too narrow. 
CellSpaceBottom (Page 4226) P P Specifies the bottom margin of the table cells.  
CellSpaceLeft (Page 4227) P P Sets the left indent for the table cells.  
CellSpaceRight (Page 4227) P P Specifies the right indent of the table cells. 
CellSpaceTop (Page 4228) P P Specifies the top margin of the table cells.  
Closeable (Page 4236) P P Specifies that the control can be closed in runtime. 
ColumnResize (Page 4242) P P Enables changes to the width of columns.  
ColumnScrollbar (Page 4244) P P Specifies the scroll bar type. 
ColumnTitleAlignment P P Specifies the type of column title alignment. 
ColumnTitles (Page 4245) P P Specifies whether the column title is displayed. 
ControlDesignMode (Page 4538) P P Specifies the design. 
EnableEdit (Page 4280) P P Specifies whether the data shown can be edited in runtime. 
ExportDirectoryChangeable 
(Page 4286) 

P P Specifies whether the data export directory can be changed 
in runtime. 

ExportDirectoryname (Page 4286) P P Specifies the target directory for the exported Runtime data.  
ExportFileExtension (Page 4287) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported.  
ExportFilename (Page 4288) P P Specifies the name of the target file for the exported Runtime 

data. 
ExportFilenameChangeable 
(Page 4288) 

P P Specifies whether the export file name can be changed in 
runtime.  

ExportFormatGuid (Page 4289) P P Default assignment of the ID number and export provider. 
ExportFormatName (Page 4289) P P Specifies the export file format. Only the "csv" file format is 

currently available for the export. 
ExportParameters (Page 4290) P P Specifies the parameters of the selected format by means of 

the "Properties" dialog. 
ExportSelection (Page 4290) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported.  
ExportShowDialog (Page 4291) P P Specifies whether the data export dialog is shown in runtime. 
Font (Page 4311) - - Specifies or returns the font.  
GridLineColor (Page 4325) P P Specifies the color for the grid lines. 
GridLineWidth (Page 4326) P P Specifies the width of the separation lines in pixels.  
Height (Page 4327) P - Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HorizontalGridLines (Page 4341) P P Specifies whether horizontal separation lines are displayed.  
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Properties Read Write Description
IconSpace (Page 4344) P P Specifies the spacing between icons and text in the table 

cells. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 4379) P P Sets the color of the window separation lines. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
LoadDataImmediately (Page 4383) P P Specifies whether the tag values are downloaded from the 

logs for the time range to be displayed when you call a 
screen. 

Moveable (Page 4416) P P Specifies whether the window can be moved in runtime.  
Name (Page 4417) P - Returns the object name as STRING. 
Online (Page 4428) P P Specifies the name of the data source. 
PrintJob P P Specifies a print job 
RowScrollbar (Page 4475) P P Specifies whether row scroll bars are displayed.  
RowTitleAlignment P P Specifies the type of row title alignment. 
RowTitles P P Specifies that row headers will be displayed. 
RTPersistence (Page 4477) P P Specifies how online configurations of WinCC are retained. 
RTPersistenceAuthorization P P Specifies the authorization required for online configuration 

in runtime. 
RTPersistenceType (Page 4478) - - Specifies how online configurations of WinCC are retained.  
SelectedCellColor (Page 4493) P P Specifies the background color of the selected cell.  
SelectedCellForeColor (Page 4494) P P Specifies the font color of the selected cell.  
SelectedRowColor (Page 4495) P P Specifies the background color of the selected row.  
SelectedRowForeColor (Page 4495) P P Specifies the font color of the selected row.  
SelectedTitleColor (Page 4496) P P Specifies the background color of a selected table header.  
SelectedTitleForeColor (Page 4497) P P Specifies the font color of the selected table header.  
SelectionColoring (Page 4499) P P Specifies whether selection colors are used for cells or rows. 
SelectionRect (Page 4502) P P Specifies whether a selection frame is used for the selected 

cells or rows. 
SelectionRectColor (Page 4503) P P Specifies the color of the selection rectangle in the alarm 

window if SelectionType equals "1".  
SelectionRectWidth (Page 4504) P P  Specifies the line width of the selection rectangle in the alarm 

window if SelectionType equals "1". 
SelectionType (Page 4504) P P Specifies the number of lines you can mark.   
ShowSortButton (Page 4528) P P Specifies whether the sorting button is shown above the 

vertical scroll bar. 
ShowSortIcon (Page 4529) P P Specifies whether the sorting icon is displayed.  
ShowSortIndex (Page 4530) P P Specifies whether the sorting icon is displayed.  
ShowTitle (Page 4534) P P Specifies the representation of the control's window title. 
Sizeable (Page 4538) P P Specifies that the size of an object can be changed in 

runtime. 
SortSequence (Page 4542) P P Specifies how the sorting order can be changed by mouse 

click. 
StatusbarBackColor (Page 4547) P P Specifies the background color of the status bar.  
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Properties Read Write Description
StatusbarElementAdd  (Page 4547) * P P Creates a new, user-defined status bar element.  
StatusbarElementAutoSize (Page 4548) 
*

P P Specifies whether the width of the selected status bar 
element is set automatically.  

StatusbarElementCount  (Page 4548) * P P Specifies the number of configurable status bar elements. 
StatusbarElementIconId  (Page 4549) * P P Default assignment of the ID number and icon of a status bar 

element. 
StatusbarElementId  (Page 4549) * P P Unique ID of the selected status bar element. 
StatusbarElementIndex (Page 4550) P P References a status bar element. You can use this property 

to assign the values of other properties to a specific element 
of the status bar. 

StatusbarElementName  (Page 4550) * P P Displays the object name of the selected status bar element. 
StatusbarElementRemove  (Page 4551) 
*

P P Removes the selected status bar element.  

StatusbarElementRename  (Page 4551) 
*

P P Renames the user-defined status bar element that is 
referenced by means of the "StatusbarElementIndex" 
property. 

StatusbarElementRepos  * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 4552) - - Specifies the elements that are to be shown in the status bar. 
StatusbarElementText  * P P Specifies the text of the currently selected status bar 

element. 
StatusbarElementTooltipText  
(Page 4552) *

P P Specifies the tooltip text for the user-defined status bar 
element. 

StatusbarElementUserDefined  
(Page 4553) *

P P Indicates whether the project engineer has added the toolbar 
button as a new user-defined element. 

StatusbarElementVisible  (Page 4554) * P P In the list, activate the status bar elements that you wish to 
display in runtime. 

StatusbarElementWidth  (Page 4554) * P P Specifies the width of the selected status bar element in 
pixels. 

StatusbarFont - - Status bar font 
StatusbarFontColor (Page 4554) P P Specifies the color of the text in the status bar.  
StatusbarShowTooltips (Page 4557) P P Specifies whether tooltips are displayed for the elements of 

the status bar in runtime.  
StatusbarText (Page 4558) P P Default text in the status bar. 
StatusbarUseBackColor (Page 4558) P P Specifies whether the background color of the status bar is 

shown. 
StatusbarVisible (Page 4559) P P Specifies whether the status bar of the control is displayed.  
TableColor (Page 4564) P P Specifies the background color of the rows. Use this to open 

the color selection dialog.  
TableColor2 (Page 4564) P P Specifies the background color of "Row color 2".  
TableForeColor (Page 4565) P P  
TableForeColor2 (Page 4566) P P Specifies the font color of "Row color 2". 
TimeBase (Page 4584) P P Sets the time zone that forms the basis for the display of time 

values.  
TimeColumnActualize  (Page 4585) * P P Specifies whether the values of the selected column are 

updated. 
TimeColumnAdd  (Page 4586) * P P Creates a new time column. 
TimeColumnAlign  (Page 4586) * P P Specifies how the selected time column is aligned. 
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Properties Read Write Description
TimeColumnBackColor  (Page 4587) * P P Specifies the background color of the time column selected. 
TimeColumnBeginTime  (Page 4588) * P P Specifies the starting time of the time range for a selected 

time column.  
TimeColumnCaption  (Page 4588) * P P Specifies the label of the time column. 
TimeColumnCount  (Page 4589) * P P Specifies the number of configured time columns. 
TimeColumnDateFormat  (Page 4589) * P P Specifies which date format is used to display the selected 

time column.  
TimeColumnEndTime  (Page 4590) * P P Specifies the end point of the time range for the selected time 

column. 
TimeColumnForeColor  (Page 4590) * P P Specifies the font color of the time column selected.  
TimeColumnHideText  (Page 4591) * P P Sets text format for displaying the content of a time column. 
TimeColumnHideTitleText  (Page 4592) 
*

P P Sets text format for displaying the time column header. 

TimeColumnIndex (Page 4592) P P References a configured time column. 
TimeColumnLength  (Page 4593) * P P Specifies the width of a selected time column. 
TimeColumnMeasurePoints  
(Page 4593) *

P P Specifies the number of measuring points to be displayed in 
the selected time column.  

TimeColumnName  (Page 4594) * P P Specifies the name of the selected time column. 
TimeColumnRangeType  (Page 4594) * P P Specifies the time range used for the selected time column. 
TimeColumnRemove  (Page 4595) * P P Removes the selected time column from the list. 
TimeColumnRename  (Page 4595) * P P Renames the time column that is referenced by means of the 

"TimeColumnIndex" property. 
TimeColumnRepos  (Page 4595) * P P Changes the sorting order of the time columns, including the 

corresponding value columns. 
TimeColumnShowDate  (Page 4596) * P P Specifies whether the selected time column is displayed with 

date and time. 
TimeColumnShowIcon  (Page 4596) * P P Specifies whether the contents of the time column are shown 

as an icon. 
TimeColumnShowTitleIcon  
(Page 4597) *

P P Specifies whether the values of the selected column are 
updated.  

TimeColumnSort  (Page 4597) * P P Specifies how the time column referenced in 
"TimeColumnIndex" is sorted. 

TimeColumnSortIndex  (Page 4598) * P P Specifies the sorting order of the time column referenced in 
"TimeColumnIndex". 

TimeColumnTimeFormat  (Page 4598) * P P Defines the time format used to display a selected time 
column.  

TimeColumnTimeRangeBase  
(Page 4599) *

P P Specifies the unit of time for calculating the time range. 

TimeColumnTimeRangeFactor  
(Page 4600) *

P P Specifies the factor for calculating the time range. 

TimeColumnUseValueColumnColors  
(Page 4600) *

P P Specifiess whether the selected time column is displayed in 
the value column colors. 

TimeColumnVisible  (Page 4601) * P P The list shows the time columns you have created. 
TimeStepBase P P A time range is set via a base and a factor. 
TimeStepFactor P P A time range is set via a base and a factor. 
TitleColor P P Specifies the color of the header. 
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Properties Read Write Description
TitleCut (Page 4606) P P Specifies whether the contents of the fields of a header 

should be abbreviated if the column is too narrow.  
TitleDarkShadowColor (Page 4607) P P Specifies the color of the dark side of shading. 
TitleForeColor (Page 4607) P P Specifies the font color of the table header for the selected 

status. 
TitleGridLineColor (Page 4607) P P Specifies the color of separation lines in the table header. 
TitleLightShadowColor (Page 4608) P P Specifies the color of the bright side of shading. 
TitleSort (Page 4608) P P Specifies how sorting by column title is triggered.  
TitleStyle (Page 4609) P P Specifies whether a shading color is used for the table 

header. 
ToolbarAlignment (Page 4616) P P Specifies or returns the position of the toolbar. 
ToolbarBackColor (Page 4616) P P Specifies the background color of the toolbar. 
ToolbarButtonActive  (Page 4617) * P P Specifies whether the function linked to the button is 

activated in runtime. 
ToolbarButtonAdd  (Page 4618) * P P Creates a new, user-defined button function.  
ToolbarButtonBeginGroup  (Page 4618) 
*

P P Specifies whether a separator is inserted before the selected 
button function.  

ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  (Page 4619) * P P Specifies the number of configurable button functions. 
ToolbarButtonEnabled  (Page 4619) * P P Specifies whether a user-defined toolbar button can be 

operated. 
ToolbarButtonHotKey  (Page 4620) * P P Shows the hotkey for the selected button function.  
ToolbarButtonId  (Page 4620) * P P Unique ID number for the selected button function. 
ToolbarButtonIndex (Page 4620) P P References a button function.  
ToolbarButtonLocked  (Page 4621) * P P Specifies whether the clicked, pressed in state is displayed 

for a user-defined toolbar button. 
ToolbarButtonName  (Page 4621) * P P Shows the name of the selected button function.  
ToolbarButtonPasswordLevel  
(Page 4622) *

P P Shows the authorization for the selected button function.  

ToolbarButtonRemove  (Page 4622) * P P Removes the selected button function from the list.  
ToolbarButtonRename  (Page 4622) * P P Renames the user-defined toolbar element that is referenced 

by means of the "ToolbarButtonIndex" property.  
ToolbarButtonRepos  (Page 4623) * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  (Page 4623) * P P Specifies the tooltip text for the button. 
ToolbarButtonUserDefined  (Page 4624) 
*

P P Indicates whether the project engineer has added the toolbar 
button as a new user-defined button.  

ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips (Page 4624) P P Specifies whether the tooltips for the button functions are 

displayed in runtime.  
ToolbarUseBackColor (Page 4625) P P Specifies whether the background color for the toolbar is 

shown. 
ToolbarUseHotKeys (Page 4626) P P Specifies whether the hotkeys for the button functions are 

activated in runtime.  
ToolbarVisible (Page 4626) P P Specifies whether the toolbar of the control is displayed. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
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Properties Read Write Description
UseColumnBackColor P P Specifies whether scrolling is enabled. 
UseColumnForeColor P P Specifies the font used for printing. 
UseSelectedTitleColor (Page 4682) P P Specifies whether a selection color is used for the headers 

of selected table cells. 
UseTableColor2 (Page 4684) P P Specifies whether a second row color is used for the 

representation of the table. 
ValueColumnAdd  * P P Adds a value column. 
ValueColumnAlign  * P P Specifies the alignment of a column. 
ValueColumnAutoPrecisions  * P P Specifies whether the number of decimal places to be 

displayed is determined automatically. 
ValueColumnBackColor  * P P Specifies the background color. 
ValueColumnCaption  * P P Specifies a header. 
ValueColumnCount  * P P Displays the number of value columns. 
ValueColumnExponentialFormat  * P P Specifies that exponential notation is used in a column. 
ValueColumnForeColor  * P P Specifies the foreground color for a value column. 
ValueColumnHideText  * P P Specifies whether the text is displayed. 
ValueColumnHideTitleText  * P P Specifies whether the text is displayed. 
ValueColumnIndex P P The index specifies on which column other properties, e.g. 

initial value are based. 
ValueColumnLength  * P P Specifies the number of displayed characters. 
ValueColumnName  * P P Specifies the name of a column. 
ValueColumnPrecisions  * P P Specifies the number of decimal places. 
ValueColumnProvider  * P P  
ValueColumnProviderCLSID  * P P Specifies the provider CLSID of the data for a column. 
ValueColumnRemove  * P P Deletes a value column. 
ValueColumnRename  * P P Renames a value column. 
ValueColumnRepos  * P P Specifies that a value axis is repositioned. 
ValueColumnSelectTagName  * P P Specifies a tag. 
ValueColumnShowIcon  * P P Specifies whether an icon is shown. 
ValueColumnShowTitleIcon  * P P Specifies whether an icon is shown in the title. 
ValueColumnSort  * P P Specifies the sorting type of a column. 
ValueColumnSortIndex  * P P Specifies the sorting order. 
ValueColumnTagName  * P P Specifies the names of the tags whose values are displayed 

in a column.  
ValueColumnTimeColumn  * P P Specifies the corresponding time column. 
ValueColumnVisible  * P P Specifies the visibility of a value column. 
VerticalGridLines (Page 4702) P P Specifies whether vertical separation lines are displayed. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P - Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES
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Table 10-80 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
AttachDB (Page 4750) P Executes the "Connect backup" button function of the control.
CalculateStatistic (Page 4751) P Executes the "Calculate statistics" button function of the f(t) trend view and 

table view.
CopyRows (Page 4751) P Executes the "Copy rows" button function of the control.
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the 
specified property in/during Runtime.

DetachDB (Page 4756) P, A Executes the "Disconnect backup" button function of the control.
Edit (Page 4757) P Executes the "Edit" button function of the table view.
Export (Page 4757) P, A Executes the "Export log" or "Export data" button function of the control.
GetRow (Page 4769) P Returns the row object defined by its row number in the table-based controls 

as "ICCAxDataRow" type.
GetRowCollection (Page 4770) P Returns the list of all row objects of the table-based controls as 

"ICCAxDataRowCollection" type. 
GetSelectedRow (Page 4777) P Returns the selected row object of a table-based control as "ICCAxDataRow" 

type.
GetSelectedRows (Page 4778) P Returns the selected row objects of a table-based control as type 

"ICCAxDataRow" for multiple selection.
GetStatusbarElement 
(Page 4784) 

P, A Returns the element of the control's status bar designated by name or index 
as "ICCAxStatusbarElement" type.

GetStatusbarElementCollection 
(Page 4785) 

P, A Returns the list of all status bar elements of the control as "ICCAxCollection" 
type.

GetTimeColumn (Page 4789) P Returns the time column object of the table view designated by name or index 
as "ICCAxTime Column" type.

GetTimeColumnCollection 
(Page 4790) 

P Returns the list of all time column objects of the table view as 
"ICCAxCollection" type.

GetToolbarButton (Page 4792) P, A Returns the button function designated by name or index on the control 
toolbar as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 4793) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

GetValueColumn (Page 4801) P Returns the value column object of the f(t) trend view designated by name or 
index as "ICCAxValueColumn" type.

GetValueColumnCollection 
(Page 4802) 

P Returns the list of all value column objects of the f(t) trend view as 
"ICCAxCollection" type.

MoveToFirst (Page 4813) P Executes the "First line" button function of the control.
MoveToLast (Page 4815) P Executes the "Last data record" button function of the control.
MoveToNext (Page 4816) P Executes the "Next data record" button function of the control.
MoveToPrevious (Page 4818) P Executes the "Previous data record" button function of the control.
NextColumn (Page 4819) P Executes the "Next column" button function of the table view.
PreviousColumn (Page 4821) P Executes the "Previous column" button function of the table view.
Print (Page 4822) P, A Executes the "Print" button function of the control.
SelectAll (Page 4837) P Selects all rows in a table-based control.
SelectRow (Page 4838) P Selects a specific row in a table-based control.
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Methods Valid Description
SelectStatisticArea (Page 4838) P Executes the "Set statistics range" button function of the table view.
ShowColumnSelection 
(Page 4840) 

P Executes the "Select columns" button function of the table view.

ShowHelp (Page 4842) P, A Executes the "Help" button function of the control.
ShowPropertyDialog 
(Page 4847) 

P, A Executes the "Configuration dialog" button function of the control.

ShowTagSelection (Page 4851) P, A Executes the "Select data connection" button function of the control.
ShowTimeSelection 
(Page 4852) 

P, A Executes the "Select time range" button function of the control.

StartStopUpdate (Page 4853) P, A Executes the "Start" or "Stop" button function of the control.
UnselectAll (Page 4855) P Removes all selections from the cells of a table-based control.
UnselectRow (Page 4856) P Removes the selections from a specific cell of a table-based control.

See also
Screen object (list) (Page 3936)

OnlineTrendControl

Description

Represents the "f(t)FunctionTrendView" object. The OnlineTrendControl object is an element 
of the ScreenItems list. 

Type identifier in VBS
HMIOnlineTrendControl     
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-81 Properties

Properties Read Write Description
ApplyProjectSettingsForDesignMode 
(Page 4172) 

- - Specifies that the project settings are used for the design. 

BackColor (Page 4181) P P Specifies the background color of the selected object. 
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
Caption (Page 4221) P P Specifies the text that is displayed in the header of the 

selected object.  
Closeable (Page 4236) P P Specifies that the control can be closed in runtime. 
ConnectTrendWindows (Page 4248) P P Specifies whether the configured trend views are connected. 
ControlDesignMode (Page 4538) P P Specifies the design. 
ExportDirectoryChangeable 
(Page 4286) 

P P Specifies whether the data export directory can be changed 
in runtime. 

ExportDirectoryname (Page 4286) P P Specifies the target directory for the exported Runtime data.  
ExportFileExtension (Page 4287) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported.  
ExportFilename (Page 4288) P P Specifies the name of the target file for the exported Runtime 

data. 
ExportFilenameChangeable 
(Page 4288) 

P P Specifies whether the export file name can be changed in 
runtime.  

ExportFormatGuid (Page 4289) P P Default assignment of the ID number and export provider. 
ExportFormatName (Page 4289) P P Specifies the export file format. Only the "csv" file format is 

currently available for the export. 
ExportParameters (Page 4290) P P Specifies the parameters of the selected format by means of 

the "Properties" dialog. 
ExportSelection (Page 4290) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported.  
ExportShowDialog (Page 4291) P P Specifies whether the data export dialog is shown in runtime. 
Font (Page 4311) - - Specifies or returns the font.  
GraphDirection (Page 4324) P P Specifies at which border of the trend window the current 

values are displayed. 
Height (Page 4327) P - Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 4379) P P Sets the color of the window separation lines. 
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Properties Read Write Description
LineWidth (Page 4382) P P Specifies the line thickness of the selected object. 
LoadDataImmediately (Page 4383) P P Specifies whether the tag values are downloaded from the 

logs for the time range to be displayed when you call a screen. 
Moveable (Page 4416) P P Specifies whether the window can be moved in runtime.  
Name (Page 4417) P - Returns the object name as STRING. 
Online (Page 4428) P P Specifies the name of the data source. 
PercentageAxis P P Specifies that an axis with percentage scaling is shown. 
PercentageAxisAlign P P  
PercentageAxisColor P P Specifies the color of the percentage axis. 
PrintJob P P Specifies a print job 
RTPersistence (Page 4477) P P Specifies how online configurations of WinCC are retained. 
RTPersistenceAuthorization P P Specifies the authorization required for online configuration 

in runtime. 
RTPersistenceType (Page 4478) - - Specifies how online configurations of WinCC are retained.  
ShowRuler (Page 4525) P P Specifies whether a scale gradation (auxiliary line) is shown 

for the axis label of the "OnlineTrendControl" object. 
ShowRulerInAxis (Page 4526) P P Specifies whether rulers are also displayed in the time axes.  
ShowScrollbars (Page 4527) P P Specifies the scroll bar type. 
ShowStatisticRuler P P Specifies the SQL statement. 
ShowTitle (Page 4534) P P Specifies the representation of the control's window title. 
ShowTrendIcon (Page 4535) P P Specifies whether an icon is displayed below the value axes.  
Sizeable (Page 4538) P P Specifies that the size of an object can be changed in runtime. 
StatusbarBackColor (Page 4547) P P Specifies the background color of the status bar.  
StatusbarElementAdd  (Page 4547) * P P Creates a new, user-defined status bar element.  
StatusbarElementAutoSize  
(Page 4548) *

P P Specifies whether the width of the selected status bar 
element is set automatically.  

StatusbarElementCount  (Page 4548) 
*

P P Specifies the number of configurable status bar elements. 

StatusbarElementIconId  (Page 4549) 
*

P P Default assignment of the ID number and icon of a status bar 
element. 

StatusbarElementId  (Page 4549) * P P Unique ID of the selected status bar element. 
StatusbarElementIndex (Page 4550) P P References a status bar element. You can use this property 

to assign the values of other properties to a specific element 
of the status bar. 

StatusbarElementName  (Page 4550) 
*

P P Displays the object name of the selected status bar element. 

StatusbarElementRemove 
(Page 4551) *

P P Removes the selected status bar element.  

StatusbarElementRename 
(Page 4551) *

P P Renames the user-defined status bar element that is 
referenced by means of the "StatusbarElementIndex" 
property. 

StatusbarElementRepos * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 4552) - - Specifies the elements that are to be shown in the status bar. 
StatusbarElementText  * P P Specifies the text of the currently selected status bar element. 
StatusbarElementTooltipText  
(Page 4552) *

P P Specifies the tooltip text for the user-defined status bar 
element. 
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Properties Read Write Description
StatusbarElementUserDefined  
(Page 4553) *

P P Indicates whether the project engineer has added the toolbar 
button as a new user-defined element. 

StatusbarElementVisible  (Page 4554) 
*

P P In the list, activate the status bar elements that you wish to 
display in runtime. 

StatusbarElementWidth  (Page 4554) 
*

P P Specifies the width of the selected status bar element in 
pixels. 

StatusbarFont - - Status bar font 
StatusbarFontColor (Page 4554) P P Specifies the color of the text in the status bar.  
StatusbarShowTooltips (Page 4557) P P Specifies whether tooltips are displayed for the elements of 

the status bar in runtime.  
StatusbarText (Page 4558) P P Default text in the status bar. 
StatusbarUseBackColor (Page 4558) P P Specifies whether the background color of the status bar is 

shown. 
StatusbarVisible (Page 4559) P P Specifies whether the status bar of the control is displayed.  
TimeAxes - - Specifies the settings for the time axes. 
TimeAxisActualize  * P P  
TimeAxisAdd  * P P Inserts an axis. 
TimeAxisAlignment  * P P Specifies the alignment of an axis. 
TimeAxisBeginTime  (Page 4580) * P P Specifies the starting time for the display of the selected 

trend.  
TimeAxisColor  * P P Specifies the color of an axis. 
TimeAxisCount  * P P Displays the number of time axes. 
TimeAxisDateFormat  * P P Specifies the date format. 
TimeAxisEndTime  (Page 4580) * P P Specifies the end time for the display of the selected trend. 
TimeAxisIndex P P The index specifies on which axis other properties, e.g. initial 

value are based. 
TimeAxisInTrendColor  * P P Specifies that the color of the trend is used for an axis. 
TimeAxisLabel  (Page 4581) * P P Specifies the header for the time axis. Whether or not the 

information is evaluated depends on the 
"ConfigureTimeAxis(i)" property. 

TimeAxisMeasurePoints  * P P Specifies the measuring points. 
TimeAxisName  * P P Specifies the name of an axis. 
TimeAxisRangeType  * P P Specifies the type of time range. 
TimeAxisRemove  * P P Deletes a time axis 
TimeAxisRename  * P P Renames a time axis. 
TimeAxisRepos  * P P Specifies that the time axis is repositioned 
TimeAxisShowDate  * P P Specifies that the date is to be displayed. 
TimeAxisTimeFormat  (Page 4584) * P P Specifies the time format. 
TimeAxisTimeRangeBase  * P P A time range is set via a base and a factor. 
TimeAxisTimeRangeFactor  * P P A time range is set via a base and a factor. 
TimeAxisTrendWindow  * P P Specifies the trend view. 
TimeAxisVisible  * P P Specifies that the time axis is visible. 
TimeBase (Page 4584) P P Sets the time zone that forms the basis for the display of time 

values.  
ToolbarAlignment (Page 4616) P P Specifies or returns the position of the toolbar. 
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Properties Read Write Description
ToolbarBackColor (Page 4616) P P Specifies the background color of the toolbar. 
ToolbarButtonActive  (Page 4617) * P P Specifies whether the function linked to the button is activated 

in runtime. 
ToolbarButtonAdd  (Page 4618) * P P Creates a new, user-defined button function.  
ToolbarButtonBeginGroup  
(Page 4618) *

P P Specifies whether a separator is inserted before the selected 
button function.  

ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  (Page 4619) * P P Specifies the number of configurable button functions. 
ToolbarButtonEnabled  (Page 4619) * P P Specifies whether a user-defined toolbar button can be 

operated. 
ToolbarButtonHotKey  (Page 4620) * P P Shows the hotkey for the selected button function.  
ToolbarButtonId  (Page 4620) * P P Unique ID number for the selected button function. 
ToolbarButtonIndex (Page 4620) P P References a button function.  
ToolbarButtonLocked  (Page 4621) * P P Specifies whether the clicked, pressed in state is displayed 

for a user-defined toolbar button. 
ToolbarButtonName  (Page 4621) * P P Shows the name of the selected button function.  
ToolbarButtonPasswordLevel  
(Page 4622) *

P P Shows the authorization for the selected button function.  

ToolbarButtonRemove  (Page 4622) * P P Removes the selected button function from the list.  
ToolbarButtonRename  (Page 4622) * P P Renames the user-defined toolbar element that is referenced 

by means of the "ToolbarButtonIndex" property.  
ToolbarButtonRepos  (Page 4623) * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  
(Page 4623) *

P P Specifies the tooltip text for the button. 

ToolbarButtonUserDefined  
(Page 4624) *

P P Indicates whether the project engineer has added the toolbar 
button as a new user-defined button.  

ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips (Page 4624) P P Specifies whether the tooltips for the button functions are 

displayed in runtime.  
ToolbarUseBackColor (Page 4625) P P Specifies whether the background color for the toolbar is 

shown. 
ToolbarUseHotKeys (Page 4626) P P Specifies whether the hotkeys for the button functions are 

activated in runtime.  
ToolbarVisible (Page 4626) P P Specifies whether the toolbar of the control is displayed. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
TrendAdd  (Page 4638) * P P Creates a new trend. 
TrendAutoRangeBeginTagName  * P P Specifies a tag that defines the initial value. 
TrendAutoRangeBeginValue  * P P Specifies the initial value for the automatically adjusted 

display range. 
TrendAutoRangeEndTagName  * P P Specifies a tag that defines the end value. 
TrendAutoRangeEndValue  * P P Specifies a tag that defines the end value. 
TrendAutoRangeSource  * P P Specifies the source of the display range. 
TrendColor  (Page 4638) * P P Specifies or returns the trend view color. 
TrendCount  (Page 4639) * P P Specifies the number of configured trends. 
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Properties Read Write Description
TrendExtendedColorSet  (Page 4639) 
*

P P Specifies whether you can configure the point color and the 
fill color and whether the colors are shown in runtime. 

TrendFill  (Page 4640) * P P Specifies whether the area below the trend is shown filled. 
TrendFillColor  (Page 4640) * P P Sets the fill color of the trend. 
TrendIndex (Page 4641) P P References a configured trend. 
TrendLabel  (Page 4642) * P P Specifies the label of the selected trend. 
TrendLineStyle  (Page 4642) * P P Specifies which line type is used for display of the trend. 
TrendLineType  (Page 4643) * P P Specifies how the trend is displayed. 
TrendLineWidth  (Page 4643) * P P Specifies the line thickness of the line displayed. 
TrendLowerLimit  (Page 4644) * P P Specifies the low limit of a tag. 
TrendLowerLimitColor  (Page 4644) * P P Specifies the color which indicates tag values below the value 

of "TrendLowerLimit". 
TrendLowerLimitColoring  
(Page 4644) *

P P Specifies whether the selection frame is shown with the color 
defined by the system. 

TrendName  (Page 4645) * P P Displays the name of the selected trend. 
TrendPointColor  (Page 4645) * P P Specifies the color of trend points. 
TrendPointStyle  (Page 4646) * P P Specifies how the points are displayed on the trend. 
TrendPointWidth  (Page 4646) * P P Specifies the point width in pixels. 
TrendProvider  (Page 4647) * P P Specifies the data supply for the selected trend. 
TrendProviderCLSID  * P P Specifies the provider CLSID of the data for a trend. 
TrendRemove  (Page 4648) * P P Removes selected trends from the list. 
TrendRename  (Page 4648) * P P Renames the trend that is referenced by means of the 

"TrendIndex" property. 
TrendRepos  (Page 4649) * P P Repositions the selected trend in the sequence in the trend 

window. 
TrendSelectTagName  * P P Specifies a tag. 
TrendTagName  * P P Specifies the name of the tag for the Y direction. 
TrendTimeAxis  * P P Specifies the time axis. 
TrendTrendWindow  (Page 4652) * P P Specifies the trend window in which the selected trend is 

shown. 
TrendUncertainColor  (Page 4652) * P P Values have an uncertain status if the initial value is unknown 

after Runtime has been activated, or if a substitute value is 
used. 

TrendUncertainColoring  (Page 4653) 
*

P P Values have an uncertain status if the initial value is unknown 
after Runtime has been activated, or if a substitute value is 
used. 

TrendUpperLimit  (Page 4653) * P P Specifies the high limit of a tag. If the tag drops below the 
value of "TrendLowerLimit", the values are marked with the 
color set in "TrendUpperLimitColor". 

TrendUpperLimitColor  (Page 4654) * P P Specifies the color which indicates tag values below the value 
of "TrendLowerLimit". 

TrendUpperLimitColoring  
(Page 4654) *

P P Specifies whether the selection frame is shown with the color 
defined by the system. 

TrendValueAxis  * P P Specifies the value axis. 
TrendVisible  (Page 4654) * P P The list contains all the trends that you have created. 
TrendWindowAdd  (Page 4655) * P P Creates a new trend view. 
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Properties Read Write Description
TrendWindowCoarseGrid  
(Page 4655) *

P P Specifies whether grid lines are displayed for the main 
scaling. 

TrendWindowCoarseGridColor  
(Page 4656) *

P P Specifies the color of the grid lines for the main scaling. 

TrendWindowCount  * P P Displays the number of trend views. 
TrendWindowFineGrid  (Page 4656) * P P Specifies whether grid lines are displayed for the secondary 

scaling. 
TrendWindowFineGridColor  
(Page 4657) *

P P Specifies the grid color of the main scaling. 

TrendWindowForegroundTrendGrid  
(Page 4657) *

P P Specifies whether only the grid lines for the foreground trend 
are displayed in the selected trend window. 

TrendWindowGridInTrendColor  
(Page 4657) *

P P Specifies whether the grid lines for the main scaling are 
displayed in the trend color. 

TrendWindowHorizontalGrid  
(Page 4658) *

P P Specifies whether the horizontal grid lines are shown. 

TrendWindowIndex (Page 4659) P P References a configured trend window. 
TrendWindowName  (Page 4659) * P P Specifies the name of the selected trend window. 
TrendWindowRemove  (Page 4659) * P P Removes the selected trend view from the list. 
TrendWindowRename  (Page 4659) * P P Changes the name of the trend window which is referenced 

by the "TrendWindowIndex" property. 
TrendWindowRepos  (Page 4660) * P P Changes the order of the trend view. 
TrendWindowRulerColor  (Page 4660) 
*

P P Specifies the ruler color. 

TrendWindowRulerLayer  
(Page 4660) *

P P Specifies the display layer of the ruler in the trend view. 

TrendWindowRulerStyle  (Page 4661) 
*

P P Specifies the representation of the ruler. 

TrendWindowRulerWidth  
(Page 4662) *

P P Specifies the ruler width in pixels. 

TrendWindows - - Specifies the settings for trend views. 
TrendWindowSpacePortion  
(Page 4662) *

P P Specifies the proportion of the selected trend window for 
display in the control. 

TrendWindowStatisticRulerColor  * P P Specifies the color of the statistics ruler. 
TrendWindowStatisticRulerStyle  * P P Specifies the style of the statistics ruler. 
TrendWindowStatisticRulerWidth  * P P Specifies the width of the statistics ruler. 
TrendWindowVerticalGrid  
(Page 4662) *

P P Specifies whether the vertical grid lines are displayed. 

TrendWindowVisible  (Page 4663) * P P The list contains the trend views that you have created. 
UseTrendNameAsLabel (Page 4687) P P Specifies whether the "Name" or "Label" property is used as 

a designation for the trend in runtime. 
ValueAxes - - Specifies the settings for the value axes. 
ValueAxisAdd  * P P Inserts an axis. 
ValueAxisAlignment  * P P Specifies the alignment of an axis. 
ValueAxisAutoPrecisions  * P P Specifies that the number of decimal places displayed for an 

axis is adjusted automatically. 
ValueAxisAutoRange  * P P Specifies that the value range is determined automatically. 
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Properties Read Write Description
ValueAxisBeginValue  * P P Specifies the initial value of an axis. 
ValueAxisColor  * P P Specifies the color of a value axis. 
ValueAxisCount  * P P Shows the number of value axes. 
ValueAxisEndValue  * P P Specifies the end value of an axis. 
ValueAxisExponentialFormat  * P P Specifies that the label of an axis uses exponential notation. 
ValueAxisIndex P P The index specifies on which axis other properties, e.g. initial 

value are based. 
ValueAxisInTrendColor  * P P Specifies that the color of the trend is used for an axis. 
ValueAxisLabel  (Page 4695) * P P Specifies the label of the value axis. 
ValueAxisName  * P P Specifies the name of an axis. 
ValueAxisPrecisions  * P P Specifies the number of displayed decimal places. 
ValueAxisRemove  * P P Renames an axis. 
ValueAxisRename  * P P Renames an axis. 
ValueAxisRepos  * P P Specifies that the value axis is repositioned. 
ValueAxisScalingType  (Page 4696) * P P Specifies the type of axis scaling. 
ValueAxisTrendWindow  * P P Specifies the trend view. 
ValueAxisVisible  * P P Specifies whether a value axis is visible. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P - Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES

Table 10-82 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
AttachDB (Page 4750) P, A Executes the "Connect backup" button function of the control.
CalculateStatistic (Page 4751) P Executes the "Calculate statistics" button function of the f(t) trend view and 

table view.
DeactivateDynamic (Page 4754) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.
DetachDB (Page 4756) P, A Executes the "Disconnect backup" button function of the control.
Export (Page 4757) P, A Executes the "Export log" or "Export data" button function of the control.
GetRulerData (Page 4776) P Returns the value of the called trend at the ruler position.
GetStatusbarElement 
(Page 4784) 

P, A Returns the element of the control's status bar designated by name or index 
as "ICCAxStatusbarElement" type.

GetStatusbarElementCollection 
(Page 4790) 

P, A Returns the list of all status bar elements of the control as "ICCAxCollection" 
type.

GetTimeAxis (Page 4786) P Returns the time axis object of the f(t) trend view designated by name or index 
as "ICCAxTimeAxis" type.

GetTimeAxisCollection 
(Page 4788) 

P Returns the list of all time axis objects of the f(t) trend view as 
"ICCAxCollection" type.
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Methods Valid Description
GetToolbarButton (Page 4792) P Returns the button function designated by name or index on the control 

toolbar as "ICCAxToolbarButton" type.
GetToolbarButtonCollection 
(Page 4793) 

P Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

GetTrend (Page 4794) P, A Returns the f(t) or f(x) trend view designated by name or index as 
"ICCAxTrend" or "ICCAxFunctionTrend" type.

GetTrendCollection (Page 4795) P, A Returns the list of all trends of the f(t) or f(x) trend view as "ICCAxCollection" 
type.

GetTrendWindow (Page 4797) P, A Returns the trend window object of the f(t) or f(x) trend view designated by 
name or index as "ICCAxTrendWindow" type.

GetTrendWindowCollection 
(Page 4798) 

P, A Returns the list of all trend window objects of the f(t) or f(x) trend views as 
"ICCAxCollection" type.

GetValueAxis (Page 4799) P Returns the value axis object of the f(t) trend view designated by name or 
index as "ICCAxValueAxis" type.

GetValueAxisCollection 
(Page 4800) 

P Returns the list of all value axis objects of the f(t) trend view as 
"ICCAxCollection" type.

MoveAxis (Page 4813) P, A Executes the "Move axes area" button function of the f(t) and f(x) trend views.
MoveToFirst (Page 4813) P Executes the "First line" button function of the control.
MoveToLast (Page 4815) P Executes the "Last data record" button function of the control.
MoveToNext (Page 4816) P Executes the "Next data record" button function of the control.
MoveToPrevious (Page 4818) P Executes the "Previous data record" button function of the control.
NextTrend (Page 4820) P, A Executes the "Next trend" button function of the f(t) and f(x) trend views.
OneToOneView (Page 4820) P, A Executes the "Original view" button function of the f(t) and f(x) trend views.
PreviousTrend (Page 4822) P, A Executes the "Previous trend" button function of the f(t) and f(x) trend views.
Print (Page 4822) P, A Executes the "Print" button function of the control.
ShowHelp (Page 4842) P, A Executes the "Help" button function of the control.
ShowPercentageAxis 
(Page 4846) 

P Executes the "Relative axis" button function of the f(t) trend view.

ShowPropertyDialog 
(Page 4847) 

P, A Executes the "Configuration dialog" button function of the control.

ShowTagSelection (Page 4851) P, A Executes the "Select data connection" button function of the control.
ShowTimeSelection 
(Page 4852) 

P, A Executes the "Select time range" button function of the control.

ShowTrendSelection 
(Page 4852) 

P, A Executes the "Select trends" button function of the f(t) and f(x) trend views.

StartStopUpdate (Page 4853) P, A Executes the "Start" or "Stop" button function of the control.
ZoomArea (Page 4860) P, A Executes the "Zoom area" button function of the f(t) and f(x) trend views.
ZoomInOut (Page 4861) P, A Executes the "Zoom +/-" button function of the f(t) and f(x) trend views.
ZoomInOutTime (Page 4861) P Executes the "Zoom time axis +/-" button function of the f(t) trend view.
ZoomInOutValues (Page 4862) P Executes the "Zoom value axis +/-" button function of the f(t) trend view.
ZoomMove (Page 4863) P, A Executes the "Move trend area" button function of the f(t) and f(x) trend views.
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See also
Screen object (list) (Page 3936)

OptionGroup

Description

Represents the "Option button" object. The OptionGroup object is an element of the 
ScreenItems list.

Type identifier in VBS
HMIOptionGroup

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-83 Properties

Properties Read Write Description
AdaptBorder (Page 4156) P P Specifies whether the border of the specified object is 

dynamically adapted to the text size.  
Authorization (Page 4175) P P Specifies the operating rights of the selected object in 

runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 4188) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 4188) P P Specifies the background color for flash state "On".   
BackFlashingEnabled (Page 4189) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 4190) P P Specifies the flash rate of the background for the selected 

object. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for 

the selected object.  
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P  Specifies the border line color of the selected object for the 
flash state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the 
flash state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object 
flashes in runtime. 

BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected 
object.  

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CheckmarkAlignment (Page 4233) P P Specifies whether the fields are right aligned. 
CheckmarkCount (Page 4233) P P Specifies the number of fields. 
CornerStyle (Page 4250) - - Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with 

a line thickness greater than 1 should be drawn within the 
border or symmetrically to the border. 

EdgeStyle (Page 4274) - - Specifies the line style of the selected object.  
Enabled (Page 4277) P P  Specifies whether the selected object can be operated in 

runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the 

flash state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the 

flash state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object 

flashes in runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected 

object.  
Font (Page 4311) - - Specifies or returns the font.  
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Properties Read Write Description
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 4315) P P Specifies the font of the selected object.  
FontSize (Page 4316) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is 

underlined.  
ForeColor (Page 4318) P P Specifies the font color of the text for the selected object. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HorizontalAlignment (Page 4340) P P Specifies the horizontal alignment of the text within the 

selected object. 
Index (Page 4344) P P Specifies the background for grid control elements. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P P  Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) - - Specifies the shape of the line ends. 
LogOperation (Page 4386) P P Specifies whether, after operating this object, an alarm is 

output to the alarm system.  
Name (Page 4417) P - Returns the object name as STRING. 
ProcessValue (Page 4461) P P Specifies the default for the value to be displayed.  
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowBadTagState (Page 4516) P P Specifies whether an object is grayed out if its associated tag 

has a bad quality code or tag state. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
Text (Page 4572) P P Specifies the label for the text field.  
TextOrientation (Page 4576) P P Specifies the text orientation of the selected object.  
Texts - - Specifies the texts for the check boxes. 
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629)  P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

VerticalAlignment (Page 4701) P P Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
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Table 10-84 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

Polygon

Description

Represents the "Polygon" object. The Polygon object is an element of the ScreenItems list. 

Type identifier in VBS
HMIPolygon
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-85 Properties

Properties Read Write Description
ActualPointIndex (Page 4154) P P Specifies the number of the current corner point of the selected 

object. 
ActualPointLeft (Page 4154) P P Specifies the X coordinate of the current corner point with reference 

to the screen origin. 
ActualPointTop (Page 4155) P P Specifies the Y coordinate of the current corner point with reference 

to the screen origin. 
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P, A P, A Defines the fill pattern of the specified object.  
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P, A P, A Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 4209) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P, A P, A Specifies the line thickness of the object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
EdgeStyle (Page 4274) A A Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
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Properties Read Write Description
LineEndShapeStyle 
(Page 4380) 

P P  Specifies the shape of the line end. 

Name (Page 4417) P, A - Returns the object name as STRING. 
Points - - Specifies the corner points.
PointsCount (Page 4458) P - Specifies the number of corner points of the polyline or of the 

polygon.  
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
RotationAngle (Page 4472) P P Specifies the angle of rotation in degrees.  
RotationCenterLeft (Page 4473) P P Specifies the X coordinate of the pivot point for the object in runtime. 
RotationCenterTop (Page 4474) P P Specifies the Y coordinate of the pivot point for the object in runtime. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-86 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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Polyline

Description

Represents the "Polyline" object. The Polyline object is an element of the ScreenItems list. 

Type identifier in VBS
HMIPolyline

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-87 Properties

Properties Read Write Description
ActualPointIndex 
(Page 4154) 

P P Specifies the number of the current corner point of the selected object. 

ActualPointLeft (Page 4154) P P Specifies the X coordinate of the current corner point with reference 
to the screen origin. 

ActualPointTop (Page 4155) P P Specifies the Y coordinate of the current corner point with reference 
to the screen origin. 
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Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BorderEndStyle 
(Page 4205) 

P; A P Specifies the type of line ends for the selected object. 

BorderStyle (Page 4213) P, A P Specifies the type of border lines for the selected object. 
Color (Page 4236) P, A P, A Specifies the line color of the selected object.  
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
EndStyle (Page 4283) A A Specifies how the line end of the selected object is displayed. 
FillStyle (Page 4297) A A Defines the fill pattern of the specified object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff 
(Page 4300) 

P P Specifies the border line color of the selected object for the flash state 
"Off".  

FlashingColorOn 
(Page 4302) 

P P Specifies the border line color of the selected object for the flash state 
"On".  

FlashingEnabled 
(Page 4303) 

P P Specifies whether the border line of the selected object flashes in 
runtime.  

FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) 

P P Specifies the shape of the line end. 

LineWidth (Page 4381) P, A P, A Specifies the line thickness of the selected object.
Name (Page 4417) P, A - Returns the object name as STRING. 
Points - - Specifies the corner points. 
PointsCount (Page 4458) P - Specifies the number of corner points of the polyline or of the polygon.  
RotationAngle (Page 4472) P P Specifies the angle of rotation in degrees.  
RotationCenterLeft 
(Page 4473) 

P P Specifies the X coordinate of the pivot point for the object in runtime. 

RotationCenterTop 
(Page 4474) 

P P Specifies the Y coordinate of the pivot point for the object in runtime. 

StartStyle (Page 4545) A A Specifies how the line start of the selected object is displayed. 
Style (Page 4560) A A Specifies the line style of the selected object.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-88 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

ProjectName

Description

Represents the "Project name" object. The ProjectName object is an element of the 
ScreenItems list.
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-89 Properties

Properties Read Write Description
BackColor (Page 4183) - - Specifies the background color of the selected object. 
BackFillStyle (Page 4186) - - Defines the fill pattern of the specified object.  
BorderBackColor (Page 4199) - - Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4203) - - Specifies the line color of the object. 
BorderWidth (Page 4217) - - Specifies the line thickness of the object. 
EdgeStyle (Page 4274)  - Specifies the line style of the selected object.  
FillPatternColor (Page 4296) - - Specifies the color of the fill pattern for the selected object.  
Font (Page 4311) - - Specifies or returns the font.  
FontBold (Page 4313) - - Specifies whether the text of the selected object is shown in bold. 
FontItalic (Page 4314) - - Specifies whether the text of the selected object is shown in italics. 
FontName (Page 4315) - - Specifies the font of the selected object.  
FontSize (Page 4316) - - Specifies the font size of the text for the selected object.  
FontUnderline (Page 4317) - - Specifies whether the text of the selected object is underlined.  
ForeColor (Page 4319) - - Specifies the font color of the text for the selected object. 
Format - - Specifies that the format of the text block is displayed. 
Height (Page 4327) - - Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HorizontalAlignment 
(Page 4341) 

- - Specifies the horizontal alignment of the text within the selected 
object. 

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) - - Specifies the value of the X coordinate of the object. 
LineWrap - - Specifies the line break within the object. 
Name (Page 4417) - - Returns the object name as STRING. 
Top (Page 4629) - - Specifies the value of the Y coordinate of the object. 
VerticalAlignment (Page 4701) - - Specifies the vertical alignment of the text for the selected object. 
Visible (Page 4703) - - Specifies whether the selected object is visible. 
Width (Page 4714) - - Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

None of the properties are visible in the ES.

Table 10-90 Methods

Methods Validity Description
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Methods Validity Description
   
   
   
   
   
   
   
   
   

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

ProtectedAreaName

Description

Represents the "EffectiveRangeName" (RFID)" object. The ProtectedAreaName object is an 
element of the ScreenItems list.     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-91 Properties

Properties Read Write Description
Authorization (Page 4175) - - Specifies the operating rights of the selected object in runtime.  
Font (Page 4311) - - Specifies or returns the font.  
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Name (Page 4417) A - Returns the object name as STRING. 
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-92 Methods

Methods Valid Description
   
   
   

 

See also
Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

RangeLabelView

Description

Represents the "EffectiveRangeName" object. The RangeLabelView object is an element of 
the ScreenItems list.     
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-93 Properties

Properties Read Write Description
Authorization (Page 4175) - -  Specifies the operating rights of the selected object in runtime.  
Font (Page 4311) - -  Specifies or returns the font.  
Height (Page 4327) A A  Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - -  Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A  Specifies the value of the X coordinate of the object. 
Name (Page 4417) A -  Returns the object name as STRING. 
Top (Page 4629) A A  Specifies the value of the Y coordinate of the object. 
Width (Page 4714) A A  Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-94 Methods

Methods Valid Description
   
   
   
   
   
   
   
   
   
   
   

 

See also
Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)
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RangeQualityView

Description

Represents the "EffectiveRangeSignal" object. The RangeQualityView object is an element of 
the ScreenItems list.     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-95 Properties

Properties Read Write Description
Height (Page 4327) A A  Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - -  Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A  Specifies the value of the X coordinate of the object. 
Name (Page 4417) A -  Returns the object name as STRING. 
Top (Page 4629) A A  Specifies the value of the Y coordinate of the object. 
Width (Page 4714) A A  Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-96 Methods

Methods Valid Description
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Methods Valid Description
   
   
   
   

 

See also
Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

RecipeView

Description

Represents the "RecipeView" object. The RecipeView object is an element of the ScreenItems 
list. 

If you change the settings for this object with a user-defined function, the changed settings are 
retained even after the screen is called again. 

 

 Note

The object "Simple RecipeView" cannot be dynamized with a user-defined function. 
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-97 Properties

Properties Read Write Description
AllowEdit - - Enables editing. 
Authorization (Page 4175) - - Specifies the operating rights of the selected object in runtime.  
BackButtonVisible - - Enables display of the "Back" button. 
BackColor (Page 4183) A A Specifies the background color of the selected object. 
ComboBoxFont - - Sets the font type for selection list. 
DataRecordNameCaption - - Sets the caption for the name of the data record. 
DataRecordNrCaption - - Sets the caption for the number of the data record. 
Display3D - - Sets the 3D view. 
DisplayButton2Plc - - Enables the display of the "Write to PLC" button. 
DisplayButtonComparison - - Enables the display of the "Synchronization" button. 
DisplayButtonDelete - - Enables the display of the "Delete data record" button. 
DisplayButtonFromPlc - - Enables the display of the "Read from PLC" button. 
DisplayButtonHelp - - Enables the display of the "Tooltip" button. 
DisplayButtonNew - - Enables the display of the "Add data record" button. 
DisplayButtonSave - - Enables the display of the "Save" button. 
DisplayButtonSaveAs - - Enables the display of the "Save As" button. 
DisplayComboBox - - Enables the display of the selection list. 
DisplayGridlines - - Enables the display of grid lines. 
DisplayLabeling - - Enables the display labelings. 
DisplayNumbers - - Enables the display of numbers. 
DisplaySize  * - -  
DisplayStatusBar - - Specifies that the status bar is displayed. 
DisplayTable - - Enablers the display of the table. 
Enabled (Page 4279) A A Specifies whether the selected object can be operated in runtime.  
EntryNameCaption - - Sets the caption for the name of the recipe element. 
EntryValueColFirst - - Sets the "Entry value" column to first place. 
EntryValueFieldLength - - Sets the field length for the element value. 
EntryValuePos - - Sets the position of the first value. 
FitToSize - - Specifies that the size of the object should be automatically 

adapted to the content. 
FixedRecipeNumber  * - -  
Flashing - - Specifies that the text block flashes. 
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Properties Read Write Description
FocusColor (Page 4309) A A Specifies the color for the focus frame of the selected object when 

it is in focus. 
FocusWidth (Page 4310) A A Specifies the border width of the specified object when the object 

is in focus.  
Font (Page 4311) - - Specifies or returns the font.  
ForeColor (Page 4319) A A Specifies the font color of the text for the selected object. 
HeaderFont - - Sets the header font. 
Height (Page 4327) A - Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
KeyboardOnline - - Enables the use of key combinations. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
ListAreaHeight - -  
ListAreaWidth - -  
MenuButtonVisible - - Enables visibility of the menu buttons. 
Name (Page 4417) A - Returns the object name as STRING. 
NameColumnWidth - -  
NumberOfLines - - Sets the number of rows of the selection list for the text list object, 

or returns the value.   
Recipe - - Sets the recipe. 
RecipeNameCaption - - Sets the caption for the name of the recipe. 
RecipeNameSelected * - -  
RecipeNrCaption - - Specifies that the "Recipe number" column is in first place. 
RecipeNrColFirst - - Specifies that the "Recipe number" column is in first place. 
RecipeVarSelected * - -  
Record * - -  
RecordNameSelected * - -  
RecordNrColFirst - - Specifies that the "Data record number" column is in first place. 
RecordVarSelected * - -  
RenameButtonVisible - - Enables the display of the "Rename" button. 
SelectionBackColor (Page 4499) A A  Specifies the background color of the selected cells.  
SelectionForeColor (Page 4501) A A Specifies the foreground color of the selected cells.  
StatusFont - -  
TableBackColor (Page 4563) A A Specifies the background color of the table cells for the selected 

object.  
TableForeColor (Page 4566) A A  
TableGridlineColor (Page 4567) A A Specifies the color for the grid lines. 
TableHeaderBackColor 
(Page 4568) 

A A Specifies the background color in the header of the table of the 
selected object. 

TableHeaderForeColor 
(Page 4569) 

A A Specifies the text color in the header of the table of the selected 
object. 

Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
ValueCaption - - Sets the labeling for values. 
ValueColumnWidth - -  
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Properties Read Write Description
VerticalScrolling - - Sets the display of a scroll bar for the selected object. 
ViewType - - Specifies the alarm view type. 
ViewTypeForSaveStream * - - Specifies the display type for the Save Stream. 
Visible (Page 4703) A A Specifies whether the selected object is visible. 
VisibleItems - - Sets the maximum number of visible entries. 
Width (Page 4714) A - Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-98 Methods

Methods Valid Description
   
   
   
   
   
   
   
   
   
   
   

 

 

 

See also
Screen object (list) (Page 3904)

Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)
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Rectangle

Description

Represents the "Rectangle" object. The Rectangle object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMIRectangle

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-99 Properties 

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P, A P, A Defines the fill pattern of the specified object.  
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P, A P, A Specifies the line color of the object.
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Properties Read Write Description
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 4209) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P, A P, A Specifies the line thickness of the object.
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 4274) A A Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left  (Page 4366) P, A P, A Specifies the value of the X coordinate of the object.
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line end. 
Name (Page 4417) P, A - Returns the object name as STRING. 
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
RoundCornerHeight 
(Page 4474) 

P P Sets or returns the corner radius.  

RoundCornerWidth (Page 4475) P P Sets or returns the corner radius.  
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top  (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object.
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible  (Page 4703) P, A P, A Specifies whether the selected object is visible.
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-100 Methods

Methods Validity Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

     

See also
Screen object (list) (Page 3936)

RoundButton

Description

Represents the "RoundButton" object. The RoundButton object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIRoundButton
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-101 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 4188) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 4188) P P Specifies the background color for flash state "On".  
BackFlashingEnabled (Page 4189) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 4190) P P Specifies the flash rate of the background for the selected 

object. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderBrightColor3D (Page 4200) P P Specifies the border color of the following border parts in the 

3D display of the selected object. 
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected object.  
BorderShadeColor3D (Page 4212) P P Specifies the border color of the following border parts in the 

3D display of the selected object. 
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
BorderWidth3D (Page 4218) P P Specifies the width of the border for 3D display of the selected 

object. 
CornerStyle (Page 4250) * - - Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a 

line thickness greater than 1 should be drawn within the border 
or symmetrically to the border. 

EdgeStyle (Page 4274) P P Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in 

runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
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Properties Read Write Description
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes 

in runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Font (Page 4311) - - Specifies or returns the font.  
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 4315) P P Specifies the font of the selected object.  
FontSize (Page 4316) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is underlined.  
ForeColor (Page 4318) P P Specifies the font color of the text for the selected object. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HorizontalAlignment (Page 4340) P P Specifies the horizontal alignment of the text within the selected 

object. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) * - - Specifies the shape of the line ends. 
Mode (Page 4415) P P Specifies the field type of the selected object. 
Name (Page 4417) P - Returns the object name as STRING. 
PictureAlignment (Page 4454) P P Specifies or returns the display type of the background image 

in the process picture.  
PictureDeactivated (Page 4454) P P Specifies the picture that is displayed in the "Disabled" state. 
PictureOff (Page 4455) P P Specifies the screen to be displayed in the "Off" state.  
PictureOn (Page 4455) P P Specifies the screen to be displayed in the "On" state.  
Pressed (Page 4459) P P Specifies whether the selected object is displayed in a pressed 

state.  
Radius (Page 4465) P P Sets the radius of the specified "Circle" object. 
RelativeFillLevel (Page 4470) P P  Specifies the fill percentage for the object. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
StyleSettings (Page 4561) P P Specifies the display style for the object:  
Text (Page 4572) P P Specifies the label for the text field.  
TextOrientation (Page 4576) P P Specifies the text orientation of the selected object.  
Toggle (Page 4610) P P Specifies whether the selected object engages after it has been 

operated in runtime. 
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the 

object.  
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Properties Read Write Description
TransparentColorDeactivatedPictu
re (Page 4635) 

P P Specifies the color to be set to "transparent" for the "Off" state 
of the assigned bitmap object.  

TransparentColorPictureOff 
(Page 4636) 

P P Specifies the color to be set to "transparent" for the "Off" state 
of the assigned bitmap object. 

TransparentColorPictureOn 
(Page 4636) 

P P Specifies the color to be set to "transparent" for the "On" state 
of the assigned bitmap object. 

UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

UseTransparentColorDeactivatedP
icture (Page 4686) 

P P Enables the use of the transparency color specified with the 
"TransparentColorDeactivatedPicture" property for the 
"Disabled" state. 

UseTransparentColorPictureOff 
(Page 4686) 

P P Specifies whether the transparent color defined in the 
"TransparentColorPictureOff" property is used for the "Off" 
state. 

UseTransparentColorPictureOn 
(Page 4687) 

P P Specifies whether the transparent color defined in the 
"TransparentColorPictureOn" property is used for the "On" 
state. 

VerticalAlignment (Page 4701) P P Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES

Table 10-102 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the 
specified property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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ScreenWindow

Description

Represents the "ScreenWindow" object. The ScreenWindow object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIScreenWindow

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-103 Properties

Properties Read Write Description
AdaptScreenToWindow 
(Page 4157) 

- - Specifies whether or not the screen visualized in a screen window 
is adapted to fit the size of the screen window in runtime.  

AdaptWindowToScreen 
(Page 4157) 

- - Specifies whether or not the screen window is adapted to fit the 
screen it visualizes in runtime.  

BorderEnabled (Page 4204) - - TRUE, if the window is visualized with a border in runtime.  
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Properties Read Write Description
CaptionText (Page 4224) P P Specifies the text that is displayed in the header of the selected 

object. 
Flashing * - - Specifies that the text block flashes. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HorizontalScrollbarPosition 
(Page 4342) 

P P Sets horizontal positioning of the scroll bar in a screen window with 
slider, or returns its value. 

IndependentWindow - - Specifies whether the screen window is embedded in a screen or 
displayed as independent screen window. 

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LeftOffset (Page 4369) P P Sets horizontal shift of the display of a graphic object that is larger 

than the screen window. 
MenuToolBarConfig 
(Page 4396) 

- - Loads the specified configuration file with configured menu and 
toolbars, or returns the name of the configuration file.  

MonitorNumber - - Sets the monitor number. 
Name (Page 4417) P - Returns the object name as STRING. 
ScreenName (Page 4489) P P Specifies the screen to be displayed in the screen window, or 

returns the screen name. 
ShowCaption (Page 4517) - - Hides or shows the caption.  
ShowScrollBars (Page 4527) - - Enables the display of scroll bars.  
TagPrefix (Page 4570) P P Sets the prefix for all tags that exist in the screen. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
TopOffset (Page 4632) P P Sets or returns the offset of the screen from the top edge of the 

screen window. 
VerticalScrollbarPosition 
(Page 4703) 

P P Specifies the vertical positioning of the scroll bar in a screen 
window with slider, or returns its value. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
WindowCloseEnabled 
(Page 4716) 

- - Enables closing of the window in runtime. 

WindowMaximizeEnabled 
(Page 4717) 

- - TRUE, if the window can be maximized in runtime. 

WindowMovingEnabled 
(Page 4717) 

- - TRUE, if the window can be moved in runtime. 

WindowOnTop (Page 4717) - - TRUE, if the object is always in the foreground in runtime. 
WindowSizingEnabled 
(Page 4718) 

- - Enables resizing of the specified object in runtime. 

WindowStartupPosition - - ??
ZoomFactor (Page 4743) P P Sets or reads the zoom factor of a screen or screen window. 

* not visible in the ES
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Table 10-104 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

ScriptDiagnostics

Description

Represents the "ApplicationWindow" object. The ApplicationWindow object is an element of 
the ScreenItems list.     

Type identifier in VBS
HMIApplicationWindow
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-105 Properties

Properties Read Write Description
BorderEnabled (Page 4204) - - TRUE, if the window is visualized with a border in runtime.  
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
Name (Page 4417) P P Returns the object name as STRING. 
ShowCaption (Page 4517) - - Hides or shows the caption.  
Template (Page 4571) - - Returns the templte for displaying the window content of the 

"Application window" object.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
WindowCloseEnabled 
(Page 4716) 

- - Enables closing of the window in runtime. 

WindowMaximizeEnabled 
(Page 4717) 

- - TRUE, if the window can be maximized in runtime. 

WindowMovingEnabled 
(Page 4717) 

- - TRUE, if the window can be moved in runtime. 

WindowOnTop (Page 4717) - - TRUE, if the object is always in the foreground in runtime. 
WindowsContents (Page 4717) - - Returns the content of the application window 
WindowSizingEnabled 
(Page 4718) 

- - Enables resizing of the specified object in runtime. 

 

Table 10-106 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen object (list) (Page 3936)

Slider

Description

Represents the "Slider" object. The Slider object is an element of the ScreenItems list. 

Type identifier in VBS
HMISlider

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-107 Properties

Properties Read Write Description
Authorization  (Page 4175) - - Specifies the operating rights of the selected object in 

runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackPicture - - Specifies a graphic for the background. 
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Properties Read Write Description
BarBackColor (Page 4191) P, A P, A Specifies the color of the bar background for the selected 

object. 
BarColor (Page 4193) P, A P, A Sets the color of the slider in the "Slider" object. 
BorderBrightColor3D (Page 4200) P, A P, A Specifies the border color of the following border parts in the 

3D display of the selected object. 
BorderInnerStyle3D (Page 4210) P P Specifies the representation of the inner part of the object 

border. 
BorderInnerWidth3D (Page 4210) P, A P, A Specifies the width of the inner border for 3D presentation of 

the selected object.  
BorderOuterStyle3D (Page 4211) P P Specifies the representation of the outer part of the object 

border. 
BorderOuterWidth3D (Page 4211) P, A P, A Sets the width of the outer border for 3D presentation of the 

selected object.  
BorderShadeColor3D (Page 4212) P, A P, A Specifies the border color of the following border parts in the 

3D display of the selected object. 
BorderWidth (Page 4216) P, A P, A Specifies the line thickness of the object. 
Caption (Page 4221) P, A P, A Specifies the text that is displayed in the header of the 

selected object.  
ContinousChange (Page 4249) P P Specifies whether to transfer the value of the "ProcessValue" 

when the mouse button is released, or immediately on a 
change of the slider position in runtime. 

Enabled (Page 4277) P, A P, A Specifies whether the selected object can be operated in 
runtime.  

Flashing - - Specifies that the text block flashes. 
FocusColor (Page 4308) P, A P, A Specifies the color for the focus frame of the selected object 

when it is in focus. 
FocusWidth (Page 4310) P, A P, A Specifies the border width of the specified object when the 

object is in focus.  
Font - - Specifies or returns the font.  
ForeColor (Page 4318) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
LabelColor (Page 4350) P, A P, A Sets the color of the scale labeling in the "Slider" object. 
Layer (Page 4355) - - Specifies the value of the X coordinate of the object. 
Left  (Page 4366) P, A P, A Specifies the value of the X coordinate of the object.
MaximumValue (Page 4392) P, A P, A Specifies the maximum value of the scale in the selected 

object.  
MinimumValue (Page 4413) P, A P, A Specifies the minimum value of the scale in the selected 

object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
PositionFont - - Sets the font type for the labeling. 
ProcessValue (Page 4461) P, A P, A Specifies the default for the value to be displayed.  
ShowBar (Page 4516) P, A P, A Specifies whether to display the process value along with a 

filled bar in the "Slider" object. 
ShowPosition (Page 4524) P, A P, A Adds a numerical display of the value of the slider position. 
ShowThumb (Page 4532) P, A P, A Displays the slider of the "Slider" object.  
ShowTickLabels (Page 4532) P, A P, A Specifies whether the label is shown in the scale.
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Properties Read Write Description
ShowTicks (Page 4533) P, A P, A Specifies whether the tick marks are displayed in the scale 

of the object.
ThumbBackColor (Page 4577) P, A P, A Specifies the background color of the slider in the "Slider" 

object. 
ThumbPicture - -  Specifies a graphic object for the slider. 
TickStyle (Page 4579) P P Specifies the scale display.
Top  (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object.
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.

 

 

Table 10-108 Methods

Methods Validity Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic (Page 4754) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.

 

 

     

See also
ObjectName (Page 4424)

Screen object (list) (Page 3936)

Font (Page 4311)
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SmartClientView

Description

Represents the "Sm@rtClient View" object. The SmartClientView object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMISmartClientView

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-109 Properties

Properties Read Write Description
AllowMenu (Page 4169) - - Specifies whether the shortcut menu is enabled to control the 

Sm@rtClient view. 
ConnectionType (Page 4248) - - Specifies the type of connector. You can select one of two connection 

types.  
ConnectOnStart - - Sets up the connection at startup. 
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Properties Read Write Description
Enabled (Page 4279) A A Specifies whether the selected object can be operated in runtime.  
Flashing - - Specifies that the text block flashes. 
Font (Page 4311) - - Specifies or returns the font.  
Height (Page 4327) A - Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
LocalCursor (Page 4384) - - Specifies whether the cursor data is transferred separately in order to 

increase the performance. 
MachineName  (Page 4391) A A Sets the network ID of the device that is to be monitored.  
Name (Page 4417) A - Returns the object name as STRING. 
Password  (Page 4447) A A Sets the password for remote monitoring. 
ScaleDenominator 
(Page 4487) 

- - Sets the scaling numerator on the client. 

ScaleNumerator (Page 4483) - - Sets the scaling numerator on the client. 
Scaling (Page 4487) - - TRUE, if an additional scale is used to visualize the values.  
ServerScale (Page 4507) - - Specifies whether the Sm@rtClient view can be zoomed in or out. 
Shared (Page 4513) - - Specifies that an HMI device is shared by several Sm@rtClient Views. 
ShowControls - - Specifies that a toolbar is displayed. 
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
UseCursorKeyScroll - - Sets the use of the background color of the object for printing. 
ViewOnly  (Page 4703) A A Enables the use of the Sm@rtClient view for remote monitoring or 

remote maintenance. 
Visible (Page 4703) * A A Specifies whether the selected object is visible. 
Width (Page 4714) A - Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-110 Methods

Methods Valid Description
Activate (Page 4744) A Activates the permanent window or the root screen. 

 

See also
Screen object (list) (Page 3904)

Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)
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StatusForce

Description

Represents the "Status/Force" object. The StatusForce object is an element of the 
ScreenItems list.     

If you change the settings for this object with a user-defined function, the changed settings are 
retained even after the screen is called again. 

Type identifier in VBS
HMIStatusForce

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-111 Properties

Properties Read Write Description
Appearance - - Specifies the layout for this NC subroutine. 
BackColor (Page 4183) A A Specifies the background color of the selected object. 
ColumnsMoveable - - Specifies that the columns can be moved. 
CountVisibleItems (Page 4253) * - - Specifies the number of lines contained in the selection list.  
Enabled (Page 4279) A A Specifies whether the selected object can be operated in runtime.  
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Properties Read Write Description
FitToSize - - Specifies that the size of the object should be automatically 

adapted to the content. 
Flashing - - Specifies that the text block flashes. 
FocusColor (Page 4309) A A Specifies the color for the focus frame of the selected object when 

it is in focus. 
FocusWidth (Page 4310) A A Specifies the border width of the specified object when the object 

is in focus.  
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Name (Page 4417) A - Returns the object name as STRING. 
PLCFilter - - Sets the controller type. 
SelectionBackColor (Page 4499) A A Specifies the background color of the selected cells.  
SelectionForeColor (Page 4501) A A Specifies the foreground color of the selected cells.  
SetOfVisibleColumns - - Sets the visible columns. 
ShowReadButton - - Enables the display of the "Read" button. 
ShowTableGridlines 
(Page 4531) 

A A Enables the display of gridlines in the table of the specified object. 

ShowWriteButton - - Enables the display of the "Write" button. 
TableBackColor (Page 4563) A A Specifies the background color of the table cells for the selected 

object.  
TableFont - - Specifies the font in the table. 
TableForeColor (Page 4566) A A ??
TableHeaderBackColor 
(Page 4568) 

A A Specifies the background color in the header of the table of the 
selected object. 

TableHeaderFont - - Specifies the text color of the header. 
TableHeaderForeColor 
(Page 4569) 

A A Specifies the text color in the header of the table of the selected 
object. 

Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Visible (Page 4703) * A A Specifies whether the selected object is visible. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-112 Methods

Methods Valid Description
Activate (Page 4744) A Activates the permanent window or the root screen. 
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See also
Screen object (list) (Page 3904)

Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

Switch

Description

Represents the "Switch" object. The Switch object is an element of the ScreenItems list. 

     

The availability of the following object properties depends on the selected mode:

Property "Switch with text" "Switch with graphic" "Switch"
CaptionColor -- -- x
CaptionText -- -- x
HorizontalAlignment X -- --
InnerBackColorOff -- -- x
InnerBackColorOn -- -- x
TextOn x -- x
TextOff x -- x
VerticalAlignment x -- --
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Type identifier in VBS
HMISwitch

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-113 Properties

Properties Read Write Description
AboveUpperLimitColor 
(Page 4147) 

- - Sets the color of the specified object for the "High limit violated" 
event. 

Authorization (Page 4175) - - Specifies the operating rights of the selected object in runtime.  
AutoSizing - - Specifies that the size of the object should be automatically 

adapted to the content. 
BackColor (Page 4181) A A Specifies the background color of the selected object. 
BackFlashingColorOff 
(Page 4188) *

- - Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 4188) *

- -  Specifies the background color for flash state "On".  

BackFlashingEnabled 
(Page 4189) *

- - Specifies whether the background of the specified object 
flashes in runtime. 

BackFlashingRate 
(Page 4190) *

- - Specifies the flash rate of the background for the selected 
object. 

BelowLowerLimitColor 
(Page 4196) 

- - Sets the color of the specified object for the "Low limit violated" 
event. 

BorderColor (Page 4202) * - - Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) *

- - Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) *

- - Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) *

- - Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate 
(Page 4209) *

- - Specifies the flash rate of the border line for the selected object.  

BorderStyle3D (Page 4215) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 4216) * - - Specifies the line thickness of the object. 
BorderWidth3D (Page 4218) 
*

- - Specifies the width of the border for 3D display of the selected 
object. 

CaptionColor (Page 4223) A A Specifies the color of the text that is displayed in the header of 
the selected object.  

CaptionFont - - Specifies the character set for the caption. 
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Properties Read Write Description
CaptionText (Page 4224) A A Specifies the text that is displayed in the header of the selected 

object. 
CornerStyle (Page 4250) * - - Specifies the type of border lines for the selected object.  
EdgeStyle (Page 4273) * - - Specifies the line style of the selected object.  
Enabled (Page 4277) A A Specifies whether the selected object can be operated in 

runtime.  
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff 
(Page 4300) *

- - Specifies the border line color of the selected object for the flash 
state "Off".  

FlashingColorOn 
(Page 4302) *

- - Specifies the border line color of the selected object for the flash 
state "On".  

FlashingEnabled 
(Page 4303) *

- - Specifies whether the border line of the selected object flashes 
in runtime.  

FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 4304) * - - Specifies the flash rate of the border line for the selected object.  
FocusColor (Page 4308) A A Specifies the color for the focus frame of the selected object 

when it is in focus. 
FocusWidth (Page 4310) A A Specifies the border width of the specified object when the 

object is in focus.  
Font (Page 4311) - - Specifies or returns the font.  
ForeColor (Page 4318) A A Specifies the font color of the text for the selected object. 
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HelpText (Page 4330) A - Returns the tooltip that is shown in runtime as user help for the 

specified object.  
HorizontalAlignment 
(Page 4340) 

A A Specifies the horizontal alignment of the text within the selected 
object. 

InnerBackColorOff 
(Page 4345) 

A A Sets the color underneath the slider of the "Switch" object for 
the object in OFF state. 

InnerBackColorOn 
(Page 4346) 

A A Sets the color underneath the slider of the "Switch" object for 
the object in ON state. 

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 
screen. 

Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 4380) *

- - Specifies the shape of the line end. 

Mode (Page 4415) - - Specifies the field type of the selected object. 
Name (Page 4417) A - Returns the object name as STRING. 
OnValue - - Specifies the value for the "ON" state in "two-state" mode. 
PictureOff (Page 4455) - - Specifies the screen to be displayed in the "Off" state.  
PictureOn (Page 4455) - - Specifies the screen to be displayed in the "On" state.  
ProcessValue (Page 4463) - - Specifies the default for the value to be displayed.  
SwitchOrientation - - Specifies the line color of the object. 
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Properties Read Write Description
TextOff (Page 4574) A A Specifies the text to be displayed in the "Off" state of the 

selected object.  
TextOn (Page 4575) A A Specifies the text to be displayed in the "On" state of the 

selected object.  
TextOrientation (Page 4576) 
*

- - Specifies the text orientation of the selected object.  

Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
VerticalAlignment 
(Page 4701) 

A A Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 4703) * A A Specifies whether the selected object is visible. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES

Table 10-114 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 

 

See also
Screen object (list) (Page 3936)
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SymbolicIOField

Description

Represents the "SymbolicIOField" object. The SymbolicIOField object is an element of the 
ScreenItems list. 

     

The availability of the following object properties depends on the selected mode:

Property "Input" "Output" "Input/Output" "Two states"
BackColor x x x x
BorderColor -- x -- x
BorderWidth -- -- -- x
BorderStyle3D -- x -- --
Enabled x -- x --
HelpText x -- x --
VerticalAlignment -- x -- x
HorizontalAlignment -- x -- x

Type identifier in VBS
HMISymbolicIOField
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-115 Properties

Properties Read Write Description
AboveUpperLimitColor (Page 4147) - - Sets the color of the specified object for the "High limit 

violated" event. 
AcceptOnExit (Page 4148) P P Specifies whether the input field is confirmed automatically 

when it is left. 
AdaptBorder (Page 4156) - - Specifies whether the border of the specified object is 

dynamically adapted to the text size.  
AskOperationMotive (Page 4173) P P Specifies whether the reason for operating this object is 

logged. 
Authorization (Page 4175) P P Specifies the operating rights of the selected object in 

runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 4188) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 4188) P P Specifies the background color for flash state "On".  
BackFlashingEnabled (Page 4189) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 4190) P P Specifies the flash rate of the background for the selected 

object. 
BelowLowerLimitColor (Page 4196) - - Sets the color of the specified object for the "Low limit violated" 

event. 
BitNumber (Page 4197) P P Specifies the bit whose status must change to trigger a value 

change.  
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for 

the selected object.  
BorderColor (Page 4202) P, A P, A Specifies the line color of the object. 
BorderFlashingColorOff (Page 4206) P P Specifies the border line color of the selected object for the 

flash state "Off".  
BorderFlashingColorOn (Page 4207) P P Specifies the border line color of the selected object for the 

flash state "On".  
BorderFlashingEnabled (Page 4208) P P Specifies whether the border line of the selected object 

flashes in runtime. 
BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected 

object.  
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 4215) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 4216) P, A P, A Specifies the line thickness of the object. 
BottomMargin - - Sets the margin between the text and the bottom edge of the 

object. 
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Properties Read Write Description
CaptionBackColor (Page 4222) P P Specifies the background color of the caption for the selected 

object. 
CaptionColor (Page 4223) P P Specifies the color of the text that is displayed in the header 

of the selected object.  
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
CountVisibleItems (Page 4253) P P Specifies the number of lines contained in the selection list.  
CursorControl (Page 4256) P P Specifies whether the mouse cursor jumps to the next field of 

the TAB sequence after leaving a field.  
DrawInsideFrame (Page 4270) - - Specifies whether the border line of the selected object with 

a line thickness greater than 1 should be drawn within the 
border or symmetrically to the border. 

EdgeStyle (Page 4274) P P Specifies the line style of the selected object.  
EditOnFocus (Page 4276) P P Specifies whether data input is immediately possible if the 

input field is selected using the "Tab" key.  
Enabled (Page 4277) P, A P, A Specifies whether the selected object can be operated in 

runtime.  
FieldLength - - Specifies that the "field length string" field is read-only. 
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the 

flash state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the 

flash state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object 

flashes in runtime.  
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected 

object.  
FocusColor (Page 4308) - - Specifies the color for the focus frame of the selected object 

when it is in focus. 
FocusWidth (Page 4310) - - Specifies the border width of the specified object when the 

object is in focus.  
Font (Page 4311) - - Specifies or returns the font.  
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 4315) P P Specifies the font of the selected object.  
FontSize (Page 4316) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is underlined.  
ForeColor (Page 4318) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 4327) P, A P, A  Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HelpText (Page 4330) A - Returns the tooltip that is shown in runtime as user help for 

the specified object.  
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Properties Read Write Description
HorizontalAlignment (Page 4340) P, A P, A Specifies the horizontal alignment of the text within the 

selected object. 
InputValue (Page 4346) - - Defines the value entered by the user in the IO field.  
ItemBorderStyle (Page 4349) P P Sets the separation line style in the selection list of the 

specified object. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LeftMargin - - Sets the margin between the text and the left edge of the 

object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line end. 
LogOperation (Page 4386) P P Specifies whether, after operating this object, an alarm is 

output to the alarm system.  
Mode (Page 4415) P P Specifies the field type of the selected object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
OnValue - - Specifies the value for the "ON" state in "two-state" mode. 
ProcessValue (Page 4461) P P Specifies the default for the value to be displayed.  
RightMargin - - Sets the margin between the text and the right edge of the 

object. 
SelectBackColor (Page 4493) P P Specifies the background color of the selected cells.  
SelectForeColor (Page 4497) P P Specifies the foreground color of the selected cells.  
SeparatorBackColor (Page 4505) P P Specifies the background color of the broken separation lines 

in the selection list of the specified object. 
SeparatorColor (Page 4505) P P Sets the color of the separation lines in the selection list of the 

specified object.  
SeparatorCornerStyle (Page 4506) P P Sets the shape of corners for the object of the type 

"ScreenItem" with "SymbolicIOField" format. 
SeparatorLineEndShapeStyle 
(Page 4507) 

P P Sets the shape of line ends for the object of the type 
"ScreenItem" with "SymbolicIOField" format. 

SeparatorStyle (Page 4506) P P Sets the separation line style in the selection list of the 
specified object.  

SeparatorWidth (Page 4507) P P Sets the width separation lines in the selection list of the 
specified object.  

ShowBadTagState (Page 4516) P P Specifies whether an object is grayed out if its associated tag 
has a bad quality code or tag state. 

ShowDropDownButton - - Sets the display of a button for the selection list. 
ShowDropDownList - - Specifies selection of the entry from a selection list. 
TextList (Page 4573) - - Specifies the label for the text field.  
TextOff (Page 4574) - - Specifies the text to be displayed in the "Off" state of the 

selected object.  
TextOn (Page 4575) - - Specifies the text to be displayed in the "On" state of the 

selected object.  
TextOrientation (Page 4576) P P Specifies the text orientation of the selected object.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
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Properties Read Write Description
TopMargin - - Sets the margin between the text and the top edge of the 

object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

VerticalAlignment (Page 4701) P, A P, A Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

 

Table 10-116 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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SymbolLibrary

Description

Represents the "SymbolLibrary" object. The SymbolLibrary object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMISymbolLibrary

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-117 Properties

Properties Read Write Description
AboveUpperLimitColor 
(Page 4147) 

- - Sets the color of the specified object for the "High limit violated" 
event. 

Authorization (Page 4175) - - Specifies the operating rights of the selected object in runtime. 
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object. 
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Properties Read Write Description
BelowLowerLimitColor 
(Page 4196) 

- - Sets the color of the specified object for the "Low limit violated" 
event. 

BlinkColor (Page 4197) P, A P, A Sets the flashing color for the "SymbolLibrary" object. 
BlinkMode (Page 4198) P P Sets the type of flashing graphic for the specified object. 
BlinkSpeed (Page 4199) P P Sets the flash rate. 
ChangeMouseCursor 
(Page 4231) 

P P Specifies the appearance of the cursor after its transformation 
in mouse over icon mode in runtime. 

Enabled (Page 4277) P, A P, A Specifies whether the selected object can be operated in 
runtime. 

FillColorMode (Page 4295) P P Sets the type of foreground for the specified object. 
FixedAspectRatio (Page 4299) P P Specifies whether the aspect ratio should be retained on 

changes of the icon size, or follow the change dynamically. 
Flashing - - Specifies that the text block flashes. 
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
Flip (Page 4308) P P Flips the symbol on the vertical and / or horizontal center axis 

of the icon. 
ForeColor (Page 4318) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
Name (Page 4417) P, A -  Returns the object name as STRING. 
ProcessValue (Page 4463) - - Specifies the default for the value to be displayed. 
Rotation (Page 4472) P P Specifies the angle of rotation in degrees of the selected object. 
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  

 

Table 10-118 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)
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SystemDiagnoseView

Description

Represents the "System diagnostic view" object. The SystemDiagnoseView object is an 
element of the ScreenItems list. 

Type identifier in VBS
HMISysDiagView

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-119 Properties

Properties Read Write Description
Authorization (Page 4175) A A Specifies the operating rights of the selected object in 

runtime.  
BackgroundColor A A Specifies the background color.
ComponentInfoText A A Specifies the tooltip of the system diagnostics view in 

runtime.
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Properties Read Write Description
Enabled (Page 4279) A A Specifies whether the selected object can be operated in 

runtime.  
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
InfoArea_BackgroundColor A A Specifies the background for grid control elements. 
InfoArea_ColumnsMovable A A Specifies the mobility of columns.  
InfoArea_DefaultTextColor A A Sets the text color. 
InfoArea_ErrorTextBackgroundColor A A Specifies the background color of a cell in error case. 
InfoArea_ErrorTextColor A A Sets the text color of a cell in error case. 
InfoArea_FocusFrameColor A A Sets the color of the focus frame. 
InfoArea_FocusFrameWidth A A Sets the line thickness of the focus rectangle. 
InfoArea_Font A A Sets the fonts of the grid views. 
InfoArea_ShowGridLines A A Sets the grid lines. 
InfoArea_TableHeaderBackgroundColo
r 

A A Specifies the background color of the table header. 

InfoArea_TableHeaderTextColor A A Sets the text color of the table header. 
InputAddressText A A Sets the input address. 
ItemText_AKZ A A Specifies the header for the "AKZ" column. 
ItemText_Descriptor A A Specifies the header for the "Descriptor" column. 
ItemText_ErrorText A A Specifies the header for the "ErrorText" column. 
ItemText_InstallationDate A A Specifies the header for the "InstallationDate" column. 
ItemText_LADDR A A Specifies the header for the "LADDR" column. 
ItemText_Name A A Sets the labeling of the "Name" column. 
ItemText_OKZ A A Specifies the header for the "OKZ" column. 
ItemText_OperationState A A Specifies the header for the "OperationState" column. 
ItemText_OrderID A A Specifies the header for the "OrderID" column. 
ItemText_Rack A A Specifies the header for the "Rack" column. 
ItemText_Slot A A Specifies the header for the "Slot" column. 
ItemText_SoftwareRevision A A Specifies the header for the "SoftwareRevision" column. 
ItemText_State A A Specifies the header for the "State" column. 
ItemText_Station A A Specifies the header for the "Station" column. 
ItemText_SubAddress A A Specifies the header for the "SubAddress" column. 
ItemText_SubSlot A A Specifies the header for the "SubSlot" column. 
ItemText_SubSystem A A Specifies the header for the "SubSystem" column. 
ItemText_Type A A Specifies the header for the "Type" column. 
IV_ShowItem_AKZ A A Enables the display of the "AKZ" column. 
IV_ShowItem_Descriptor A A Enables the display of the "Descriptor" column. 
IV_ShowItem_ErrorText A A Enables the display of the "ErrorText" column. 
IV_ShowItem_InstallationDate A A Enables the display of the "InstallationDate" column. 
IV_ShowItem_LADDR A A Enables the display of the "LADDR" column. 
IV_ShowItem_Name A A Enables the display of the "Name" column. 
IV_ShowItem_OKZ A A Enables the display of the "OKZ" column. 
IV_ShowItem_OperationState A A Enables the display of the "OperationState" column. 
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Properties Read Write Description
IV_ShowItem_OrderID A A Enables the display of the "OrderID" column. 
IV_ShowItem_Rack A A Enables the display of the "Rack" column. 
IV_ShowItem_Slot A A Enables the display of the "Slot" column. 
IV_ShowItem_SoftwareRevision A A Enables the display of the "SoftwareRevision" column. 
IV_ShowItem_State A A Enables the display of the "State" column. 
IV_ShowItem_Station A A Enables the display of the "Station" column. 
IV_ShowItem_SubAddress A A Enables the display of the "SubAddress" column. 
IV_ShowItem_SubSlot A A Enables the display of the "SubSlot" column. 
IV_ShowItem_SubSystem A A Enables the display of the "SubSystem" column. 
IV_ShowItem_Type A A Enables the display of the "Type" column. 
Layer (Page 4355) A - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
NavigationPath_Font A A Sets the font type of the navigation path. 
NavigationPath_TextColor A A Sets the text color of the navigation path. 
ObjectName (Page 4424) A - Returns the object name as STRING. 
OutputAddressText A A Specifies the text for the output address. 
ShowNavigationButtons A A Enables the display of navigation buttons. 
ShowPathInformation A A Enables the display of the navigation path. 
ShowSplittedView A A Enables a split view. 
TableHeaderFont A A Specifies the text color of the header. 
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Type (Page 4664) A - Returns the type of the specified object as STRING.
Parent (Page 4445) A - Returns the screen in which the specified object is 

embedded. 
UV_ShowItem_AKZ A A Enables the display of the "AKZ" column. 
UV_ShowItem_Descriptor A A Enables the display of the "Descriptor" column. 
UV_ShowItem_InstallationDate A A Enables the display of the "InstallationDate" column. 
UV_ShowItem_LADDR A A Enables the display of the "LADDR" column. 
UV_ShowItem_Name A A Enables the display of the "Name" column. 
UV_ShowItem_OKZ A A Enables the display of the "OKZ" column. 
UV_ShowItem_OperationState A A Enables the display of the "OperationState" column. 
UV_ShowItem_OrderID A A Enables the display of the "OrderID" column. 
UV_ShowItem_Rack A A Enables the display of the "Rack" column. 
UV_ShowItem_Slot A A Enables the display of the "Slot" column. 
UV_ShowItem_SoftwareRevision A A Enables the display of the "SoftwareRevision" column. 
UV_ShowItem_State A A Enables the display of the "State" column. 
UV_ShowItem_Station A A Enables the display of the "Station" column. 
UV_ShowItem_SubAddress A A Enables the display of the "SubAddress" column. 
UV_ShowItem_SubSlot A A Enables the display of the "SubSlot" column. 
UV_ShowItem_SubSystem A A Enables the display of the "SubSystem" column. 
UV_ShowItem_Type A A Enables the display of the "Type" column. 
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Properties Read Write Description
Visible (Page 4703) A A Specifies whether the selected object is visible. 
Width (Page 4714) A A Enables the display of the "Slot" column. 

Table 10-120 Methods

Methods Valid Description
Activate (Page 4744) A Activates the permanent window or the root screen. 

See also
Screen object (list) (Page 3904)

Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

Name  (Page 4417)

SystemDiagnoseWindow

Description

Represents the "System diagnostic window" object. The SystemDiagnoseWindow object is an 
element of the ScreenItems list. 
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Type identifier in VBS
HMISysDiagWindow

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-121 Properties

Properties Read Write Description
Authorization (Page 4175) A A Specifies the operating rights of the selected object in 

runtime.  
BackgroundColor A A Specifies the background color.
Caption (Page 4221) A A Specifies the text that is displayed in the header of the 

selected object.  
CaptionActive A A Enables display of the caption. 
Closable (Page 4236) A A Specifies that the control can be closed in runtime. 
ComponentInfoText A A Specifies the tooltip of the system diagnostics view in 

runtime.
Enabled (Page 4279) A A Specifies whether the selected object can be operated 

in runtime.  
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
InfoArea_BackgroundColor A A Specifies the background for grid control elements. 
InfoArea_ColumnsMovable A A Specifies the mobility of columns.  
InfoArea_DefaultTextColor A A Sets the text color. 
InfoArea_ErrorTextBackgroundColor A A Specifies the background color of a cell in error case. 
InfoArea_ErrorTextColor A A Sets the text color of a cell in error case. 
InfoArea_FocusFrameColor A A Sets the color of the focus frame. 
InfoArea_FocusFrameWidth A A Sets the line thickness of the focus rectangle. 
InfoArea_Font A A Sets the fonts of the grid views. 
InfoArea_ShowGridLines A A Sets the grid lines. 
InfoArea_TableHeaderBackgroundColor A A Specifies the background color of the table header. 
InfoArea_TableHeaderTextColor A A Sets the text color of the table header. 
InputAddressText A A Sets the input address. 
ItemText_AKZ A A Specifies the header for the "AKZ" column. 
ItemText_Descriptor A A Specifies the header for the "Descriptor" column. 
ItemText_ErrorText A A Specifies the header for the "ErrorText" column. 
ItemText_InstallationDate A A Specifies the header for the "InstallationDate" column. 
ItemText_LADDR A A Specifies the header for the "LADDR" column. 
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Properties Read Write Description
ItemText_Name A A Sets the labeling of the "Name" column. 
ItemText_OKZ A A Specifies the header for the "OKZ" column. 
ItemText_OperationState A A Specifies the header for the "OperationState" column. 
ItemText_OrderID A A Specifies the header for the "OrderID" column. 
ItemText_Rack A A Specifies the header for the "Rack" column. 
ItemText_Slot A A Specifies the header for the "Slot" column. 
ItemText_SoftwareRevision A A Specifies the header for the "SoftwareRevision" column. 
ItemText_State A A Specifies the header for the "State" column. 
ItemText_Station A A Specifies the header for the "Station" column. 
ItemText_SubAddress A A Specifies the header for the "SubAddress" column. 
ItemText_SubSlot A A Specifies the header for the "SubSlot" column. 
ItemText_SubSystem A A Specifies the header for the "SubSystem" column. 
ItemText_Type A A Specifies the header for the "Type" column. 
IV_ShowItem_AKZ A A Enables the display of the "AKZ" column. 
IV_ShowItem_Descriptor A A Enables the display of the "Descriptor" column. 
IV_ShowItem_ErrorText A A Enables the display of the "ErrorText" column. 
IV_ShowItem_InstallationDate A A Enables the display of the "InstallationDate" column. 
IV_ShowItem_LADDR A A Enables the display of the "LADDR" column. 
IV_ShowItem_Name A A Enables the display of the "Name" column. 
IV_ShowItem_OKZ A A Enables the display of the "OKZ" column. 
IV_ShowItem_OperationState A A Enables the display of the "OperationState" column. 
IV_ShowItem_OrderID A A Enables the display of the "OrderID" column. 
IV_ShowItem_Rack A A Enables the display of the "Rack" column. 
IV_ShowItem_Slot A A Enables the display of the "Slot" column. 
IV_ShowItem_SoftwareRevision A A Enables the display of the "SoftwareRevision" column. 
IV_ShowItem_State A A Enables the display of the "State" column. 
IV_ShowItem_Station A A Enables the display of the "Station" column. 
IV_ShowItem_SubAddress A A Enables the display of the "SubAddress" column. 
IV_ShowItem_SubSlot A A Enables the display of the "SubSlot" column. 
IV_ShowItem_SubSystem A A Enables the display of the "SubSystem" column. 
IV_ShowItem_Type A A Enables the display of the "Type" column. 
Layer (Page 4355) A - Returns the layer that contains an object as LONG in 

the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Modal A A Specifies that you must acknowledge the alarm view 

before continuing with your work. 
NavigationPath_Font A A Sets the font type of the navigation path. 
NavigationPath_TextColor A A Sets the text color of the navigation path. 
ObjectName (Page 4424) A - Returns the object name as STRING. 
OutputAddressText A A Specifies the text for the output address. 
Resizable A A Enables resizing of the window. 
ShowNavigationButtons A A Enables the display of navigation buttons. 
ShowPathInformation A A Enables the display of the navigation path. 
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Properties Read Write Description
ShowSplittedView A A Enables a split view. 
TableHeaderFont A A Specifies the text color of the header. 
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Type (Page 4664) A - Returns the type of the specified object as STRING.
Parent (Page 4445) A - Returns the screen in which the specified object is 

embedded. 
UV_ShowItem_AKZ A A Enables the display of the "AKZ" column. 
UV_ShowItem_Descriptor A A Enables the display of the "Descriptor" column. 
UV_ShowItem_InstallationDate A A Enables the display of the "InstallationDate" column. 
UV_ShowItem_LADDR A A Enables the display of the "LADDR" column. 
UV_ShowItem_Name A A Enables the display of the "Name" column. 
UV_ShowItem_OKZ A A Enables the display of the "OKZ" column. 
UV_ShowItem_OperationState A A Enables the display of the "OperationState" column. 
UV_ShowItem_OrderID A A Enables the display of the "OrderID" column. 
UV_ShowItem_Rack A A Enables the display of the "Rack" column. 
UV_ShowItem_Slot A A Enables the display of the "Slot" column. 
UV_ShowItem_SoftwareRevision A A Enables the display of the "SoftwareRevision" column. 
UV_ShowItem_State A A Enables the display of the "State" column. 
UV_ShowItem_Station A A Enables the display of the "Station" column. 
UV_ShowItem_SubAddress A A Enables the display of the "SubAddress" column. 
UV_ShowItem_SubSlot A A Enables the display of the "SubSlot" column. 
UV_ShowItem_SubSystem A A Enables the display of the "SubSystem" column. 
UV_ShowItem_Type A A Enables the display of the "Type" column. 
Visible (Page 4703) A A Specifies whether the selected object is visible. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
WindowMode A A Sets the window mode. 

Table 10-122 Methods

Methods Valid Description
Activate (Page 4744) A Activates the permanent window or the root screen. 

See also
Screen object (list) (Page 3904)

Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

Name  (Page 4417)
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TextField

Description

Represents the "TextField" object. The TextField object is an element of the ScreenItems list. 

Type identifier in VBS
HMITextField

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-123 Properties

Properties Read Write Description
AdaptBorder (Page 4156) P P Specifies whether the border of the specified object is 

dynamically adapted to the text size.  
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 4188) P P Specifies the background color for flash state "Off". 
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Properties Read Write Description
BackFlashingColorOn (Page 4188) P P Specifies the background color for flash state "On".  
BackFlashingEnabled (Page 4189) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 4190) P P Specifies the flash rate of the background for the selected 

object. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P, A P, A Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 4206) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 4207) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 4208) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected object.  
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 4215) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 4216) P, A P, A Specifies the line thickness of the object. 
BottomMargin - - Sets the margin between the text and the bottom edge of the 

object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a 

line thickness greater than 1 should be drawn within the border 
or symmetrically to the border. 

EdgeStyle (Page 4274) A A Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in 

runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 4300) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 4302) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 4303) P P Specifies whether the border line of the selected object flashes 

in runtime.  
FlashingRate (Page 4304) P P Specifies the flash rate of the border line for the selected object.  
Font (Page 4311) - - Specifies or returns the font.  
FontBold (Page 4313) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 4314) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 4315) P P Specifies the font of the selected object.  
FontSize (Page 4316) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 4317) P P Specifies whether the text of the selected object is underlined.  
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Properties Read Write Description
ForeColor (Page 4318) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 4327) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HorizontalAlignment (Page 4340) P, A P, A Specifies the horizontal alignment of the text within the selected 

object. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P, A P, A Specifies the value of the X coordinate of the object. 
LeftMargin - - Sets the margin between the text and the left edge of the object. 
LineEndShapeStyle (Page 4380) P P Specifies the shape of the line end. 
LineWrap * - - Specifies the line break within the object. 
Name (Page 4417) P, A - Returns the object name as STRING. 
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
RightMargin - - Sets the margin between the text and the right edge of the 

object. 
RotationAngle (Page 4472) P P Specifies the angle of rotation in degrees.  
RotationCenterLeft (Page 4473) P P Specifies the X coordinate of the pivot point for the object in 

runtime. 
RotationCenterTop (Page 4474) P P Specifies the Y coordinate of the pivot point for the object in 

runtime. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
Text (Page 4572) P, A P, A Specifies the label for the text field.  
TextOrientation (Page 4576) P P Specifies the text orientation of the selected object.  
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P, A P, A Specifies the value of the Y coordinate of the object. 
TopMargin - - Sets the margin between the text and the top edge of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

VerticalAlignment (Page 4701) P, A P, A Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 4703) P, A P, A Specifies whether the selected object is visible. 
Width (Page 4714) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES
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Table 10-124 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

TrendRulerControl

Description     

Represents the "Value table" object. The TrendRulerControl object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMITrendRulerControl
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Example
In the following example, the object with the name "Control1" is moved 16 pixels to the right:

 
'VBS60
Dim objControl
Set objControl = ScreenItems("Control1")
objControl.Left = objControl.Left + 16

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-125 Properties

Properties Read Write Description
ApplyProjectSettingsForDesignMode - - Specifies that the project settings are used for the design. 
AutoCompleteColumns (Page 4177) P P Specifies whether empty columns are shown if the control 

is wider than the configured columns. 
AutoCompleteRows (Page 4177) P P Specifies whether empty rows are shown if the control is 

longer than the number of configured rows. 
AutoPosition P P Sets the automatic repositioning mode. 
AutoSelectionColors (Page 4178) P P Specifies whether the colors defined by the system are 

used as the selection colors for cells and rows. 
AutoSelectionRectColor (Page 4179) P P Specifies whether the selection frame is shown with the 

color defined by the system. 
AutoShow P P Specifies the automatic display of the table of values. 
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BlockAlign * P P Sets the alignment. 
BlockAutoPrecisions * P P Specifies that the number of decimal places displayed for 

an axis is adjusted automatically. 
BlockCaption * P P Sets the caption. 
BlockCount * P P Sets the number of blocks. 
BlockDateFormat * P P Specifies the date format. 
BlockExponentialFormat * P P Enables the use of the exponential notation. 
BlockHideText * P P Specifies whether the text is displayed. 
BlockHideTitleText * P P Specifies whether the text is displayed. 
BlockId * P P Sets the ID. 
BlockIndex P P The index specifies the block to which other properties 

such as names are referenced. 
BlockLength * P P Specifies the number of displayed characters. 
BlockName * P P Sets the name of a block. 
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Properties Read Write Description
BlockPrecisions * P P Specifies the number of displayed decimal places. 
Blocks - - Sets the alarm blocks. 
BlockShowDate * P P Specifies that the date is to be displayed. 
BlockShowIcon * P P Specifies the tootip text. 
BlockShowTitleIcon * P P Enables the display of title as icon. 
BlockTimeFormat * P P Specifies the time format. 
BlockUseSourceFormat * P P Enables the use of the source format. 
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
Caption (Page 4221) P P Specifies the text that is displayed in the header of the 

selected object. 
CellCut (Page 4225) P P Specifies whether the contents of the cells are abbreviated 

if the cells are too narrow. 
CellSpaceBottom (Page 4226) P P Specifies the bottom margin of the table cells. 
CellSpaceLeft (Page 4227) P P Sets the left indent for the table cells. 
CellSpaceRight (Page 4227) P P Specifies the right indent of the table cells. 
CellSpaceTop (Page 4228) P P Specifies the top margin of the table cells. 
Closeable (Page 4236) P P Specifies that the control can be closed in runtime. 
ColumnAdd  * P P Adds a column. 
ColumnCount * P P Displays the number of columns. 
ColumnIndex P P The index specifies on which column other properties, e.g. 

initial value are based. 
ColumnName  * P P Specifies the name of a column. 
ColumnRemove  * P P Removes a column. 
ColumnRepos  * P P Repositions the column. 
ColumnResize (Page 4242) P P Enables changes to the width of columns. 
ColumnScrollbar (Page 4244) P P Specifies the scroll bar type. 
ColumnSort  * P P Sets the type of sorting. 
ColumnSortIndex  * P P Specifies the sorting order. 
ColumnTitleAlignment P P Specifies the type of column title alignment. 
ColumnTitles (Page 4245) P P Specifies whether the column title is displayed. 
ColumnVisible * P P Enables the visibility of a column. 
ControlDesignMode (Page 4538) P P Specifies the design. 
ExportDirectoryChangeable 
(Page 4286) 

P P Specifies whether the data export directory can be 
changed in runtime. 

ExportDirectoryname (Page 4286) P P Specifies the target directory for the exported Runtime 
data. 

ExportFileExtension (Page 4287) P P Specifies the file extension of the export file. Only the "csv" 
file extension is currently supported. 

ExportFilename (Page 4288) P P Specifies the name of the target file for the exported 
Runtime data. 

ExportFilenameChangeable 
(Page 4288) 

P P Specifies whether the export file name can be changed in 
runtime. 

ExportFormatGuid (Page 4289) P P Default assignment of the ID number and export provider. 
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Properties Read Write Description
ExportFormatName (Page 4289) P P Specifies the export file format. Only the "csv" file format 

is currently available for the export. 
ExportParameters (Page 4290) P P Specifies the parameters of the selected format by means 

of the "Properties" dialog. 
ExportSelection (Page 4290) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported. 
ExportShowDialog (Page 4291) P P Specifies whether the data export dialog is shown in 

runtime. 
Font (Page 4311) - - Specifies or returns the font. 
GridLineColor (Page 4325) P P Specifies the color for the grid lines. 
GridLineWidth (Page 4326) P P Specifies the width of the separation lines in pixels. 
Height (Page 4327) P - Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
HorizontalGridLines (Page 4341) P P Specifies whether horizontal separation lines are 

displayed. 
IconSpace (Page 4344) P P Specifies the spacing between icons and text in the table 

cells. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 4379) P P Sets the color of the window separation lines. 
LineWidth (Page 4381) P P  Specifies the line thickness of the selected object. 
Moveable (Page 4416) P P  Specifies whether the window can be moved in runtime. 
Name (Page 4417) P -  Returns the object name as STRING. 
PrintJob P P Specifies a print job 
RowScrollbar (Page 4475) P P Specifies whether row scroll bars are displayed. 
RowTitleAlignment P P Specifies the type of row title alignment. 
RowTitles P P Specifies that row headers will be displayed. 
RTPersistence (Page 4477) P P Specifies how online configurations of WinCC are 

retained. 
RTPersistenceAuthorization P P Specifies the authorization required for online 

configuration in runtime. 
RTPersistenceType (Page 4478) - - Specifies how online configurations of WinCC are 

retained. 
RulerType P P Sets the ruler type. 
SelectedCellColor (Page 4493) P P Specifies the background color of the selected cell. 
SelectedCellForeColor (Page 4494) P P Specifies the font color of the selected cell. 
SelectedRowColor (Page 4495) P P Specifies the background color of the selected row. 
SelectedRowForeColor (Page 4495) P P Specifies the font color of the selected row. 
SelectedTitleColor (Page 4496) P P Specifies the background color of a selected table header. 
SelectedTitleForeColor (Page 4497) P P Specifies the font color of the selected table header. 
SelectionColoring (Page 4499) P P Specifies whether selection colors are used for cells or 

rows. 
SelectionRect (Page 4502) P P Specifies whether a selection frame is used for the 

selected cells or rows. 
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Properties Read Write Description
SelectionRectColor (Page 4503) P P Specifies the color of the selection rectangle in the alarm 

window if SelectionType equals "1". 
SelectionRectWidth (Page 4504) P P Specifies the line width of the selection rectangle in the 

alarm window if SelectionType equals "1". 
SelectionType (Page 4504) P P Specifies the number of lines you can mark. 
ShareSpaceWithSourceControl P P Enables the display of the table of values in the 

visualization range of the data source. 
ShowSortButton (Page 4528) P P Specifies whether the sorting button is shown above the 

vertical scroll bar. 
ShowSortIcon (Page 4529) P P Specifies whether the sorting icon is displayed. 
ShowSortIndex (Page 4530) P P  
ShowTitle (Page 4534) P P Specifies the representation of the control's window title. 
Sizeable (Page 4538) P P Specifies that the size of an object can be changed in 

runtime. 
SortSequence (Page 4542) P P Specifies how the sorting order can be changed by mouse 

click. 
SourceControl P P Sets the data source. 
SourceControlType P P Sets the data source type. 
StatusbarBackColor (Page 4547) P P Specifies the background color of the status bar. 
StatusbarElementAdd  (Page 4547) * P P Creates a new, user-defined status bar element. 
StatusbarElementAutoSize 
(Page 4548) *

P P Specifies whether the width of the selected status bar 
element is set automatically. 

StatusbarElementCount  (Page 4548) * P P Specifies the number of configurable status bar elements. 
StatusbarElementIconId  (Page 4549) * P P Default assignment of the ID number and icon of a status 

bar element. 
StatusbarElementId  (Page 4549) * P P Unique ID of the selected status bar element. 
StatusbarElementIndex (Page 4550) P P References a status bar element. You can use this 

property to assign the values of other properties to a 
specific element of the status bar. 

StatusbarElementName  (Page 4550) * P P Displays the object name of the selected status bar 
element. 

StatusbarElementRemove  (Page 4551) 
*

P P Removes the selected status bar element. 

StatusbarElementRename  (Page 4551) 
*

P P Renames the user-defined status bar element that is 
referenced by means of the "StatusbarElementIndex" 
property. 

StatusbarElementRepos  * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 4552) - - Specifies the elements that are to be shown in the status 

bar. 
StatusbarElementText P P Specifies the text of the currently selected status bar 

element. 
StatusbarElementTooltipText  
(Page 4552) *

P P Specifies the tooltip text for the user-defined status bar 
element. 

StatusbarElementUserDefined  
(Page 4553) *

P P Indicates whether the project engineer has added the 
toolbar button as a new user-defined element. 

StatusbarElementVisible  (Page 4554) * P P In the list, activate the status bar elements that you wish 
to display in runtime. 
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Properties Read Write Description
StatusbarElementWidth  (Page 4554) * P P Specifies the width of the selected status bar element in 

pixels. 
StatusbarFont - - Status bar font 
StatusbarFontColor (Page 4554) P P Specifies the color of the text in the status bar. 
StatusbarShowTooltips (Page 4557) P P Specifies whether tooltips are displayed for the elements 

of the status bar in runtime. 
StatusbarText (Page 4558) P P Default text in the status bar. 
StatusbarUseBackColor (Page 4558) P P Specifies whether the background color of the status bar 

is shown. 
StatusbarVisible (Page 4559) P P Specifies whether the status bar of the control is displayed. 
TableColor (Page 4564) P P Specifies the background color of the rows. Use this to 

open the color selection dialog. 
TableColor2 (Page 4564) P P Specifies the background color of "Row color 2". 
TableForeColor (Page 4565) P P  
TableForeColor2 (Page 4566) P P Specifies the font color of "Row color 2". 
TimeBase (Page 4584) P P Sets the timebase. 
TitleColor P P Specifies the color of the header. 
TitleCut (Page 4606) P P Specifies whether the contents of the fields of a header 

should be abbreviated if the column is too narrow. 
TitleDarkShadowColor (Page 4607) P P Specifies the color of the dark side of shading. 
TitleForeColor (Page 4607) P P Specifies the font color of the table header for the selected 

status. 
TitleGridLineColor (Page 4607) P P Specifies the color of separation lines in the table header. 
TitleLightShadowColor (Page 4608) P P Specifies the color of the bright side of shading. 
TitleSort (Page 4608) P P Specifies how sorting by column title is triggered. 
TitleStyle (Page 4609) P P Specifies whether a shading color is used for the table 

header. 
ToolbarAlignment (Page 4616) P P Specifies or returns the position of the toolbar. 
ToolbarBackColor (Page 4616) P P Specifies the background color of the toolbar. 
ToolbarButtonActive  (Page 4617) * P P Specifies whether the function linked to the button is 

activated in runtime. 
ToolbarButtonAdd  (Page 4618) * P P Creates a new, user-defined button function. 
ToolbarButtonBeginGroup  (Page 4618) 
*

P P Specifies whether a separator is inserted before the 
selected button function. 

ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  (Page 4619) * P P Specifies the number of configurable button functions. 
ToolbarButtonEnabled  (Page 4619) * P P Specifies whether a user-defined toolbar button can be 

operated. 
ToolbarButtonHotKey  (Page 4620) * P P Shows the hotkey for the selected button function. 
ToolbarButtonId  (Page 4620) * P P Unique ID number for the selected button function. 
ToolbarButtonIndex (Page 4620) P P References a button function. 
ToolbarButtonLocked  (Page 4621) * P P Specifies whether the clicked, pressed in state is displayed 

for a user-defined toolbar button. 
ToolbarButtonName  (Page 4621) * P P Shows the name of the selected button function. 
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Properties Read Write Description
ToolbarButtonPasswordLevel  
(Page 4622) *

P P Shows the authorization for the selected button function. 

ToolbarButtonRemove  (Page 4622) * P P Removes the selected button function from the list. 
ToolbarButtonRename  (Page 4622) * P P Renames the user-defined toolbar element that is 

referenced by means of the "ToolbarButtonIndex" 
property. 

ToolbarButtonRepos  (Page 4623) * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  (Page 4623) 
*

P P Specifies the tooltip text for the button. 

ToolbarButtonUserDefined  
(Page 4624) *

P P Indicates whether the project engineer has added the 
toolbar button as a new user-defined button. 

ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips (Page 4624) P P Specifies whether the tooltips for the button functions are 

displayed in runtime. 
ToolbarUseBackColor (Page 4625) P P Specifies whether the background color for the toolbar is 

shown. 
ToolbarUseHotKeys (Page 4626) P P Specifies whether the hotkeys for the button functions are 

activated in runtime. 
ToolbarVisible (Page 4626) P P Specifies whether the toolbar of the control is displayed. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
UseSelectedTitleColor (Page 4682) P P Specifies whether a selection color is used for the headers 

of selected table cells. 
UseSourceBackColors P P Specifies the use of the background color of the data 

source. 
UseSourceForeColors P P Specifies the use of the foreground color of the data 

source. 
UseTableColor2 (Page 4684) P P Specifies whether a second row color is used for the 

representation of the table. 
VerticalGridLines (Page 4702) P P Specifies whether vertical separation lines are displayed. 
Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P - Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES

Table 10-126 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic (Page 4754) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.
Export (Page 4757) P, A Executes the "Export log" or "Export data" button function of the control.
GetRow (Page 4769) P Returns the row object defined by its row number in the table-based controls 

as "ICCAxDataRow" type.
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Methods Valid Description
GetRowCollection (Page 4770) P Returns the list of all row objects of the table-based controls as 

"ICCAxDataRowCollection" type. 
GetRulerBlock (Page 4771) P Returns the block object of the evaluation table designated by name or index 

as "ICCAxRulerBlock" type.
GetRulerBlockCollection 
(Page 4772) 

P Returns the list of all block objects of the evaluation table as 
"ICCAxCollection" type.

GetRulerColumn (Page 4774) P Returns the column object of the evaluation table designated by name or 
index as "ICCAxRulerColumn" type.

GetRulerColumnCollection 
(Page 4775) 

P Returns the list of all column objects of the evaluation table as 
"ICCAxCollection" type.

GetSelectedRow (Page 4777) P Returns the selected row object of a table-based control as "ICCAxDataRow" 
type.

GetSelectedRows (Page 4778) P Returns the selected row objects of a table-based control as type 
"ICCAxDataRow" for multiple selection.

GetStatisticAreaColumn 
(Page 4779) 

P Returns the column object of the statistic area window of the evaluation 
window designated by name or index as "ICCAxRulerColumn" type.

GetStatisticAreaColumnCollectio
n (Page 4781) 

P Returns the list of all column objects of the statistic area window of the 
evaluation table as "ICCAxCollection" type.

GetStatisticResultColumn 
(Page 4782) 

P Returns the column object of the statistic window of the evaluation window 
designated by name or index as "ICCAxRulerColumn" type.

GetStatisticResultColumnCollect
ion (Page 4783) 

P Returns the list of all column objects of the statistic window of the evaluation 
table as "ICCAxCollection" type.

GetStatusbarElement 
(Page 4784) 

P, A Returns the element of the control's status bar designated by name or index 
as "ICCAxStatusbarElement" type.

GetStatusbarElementCollection 
(Page 4785) 

P, A Returns the list of all status bar elements of the control as "ICCAxCollection" 
type.

GetToolbarButton (Page 4792) P, A Returns the button function designated by name or index on the control 
toolbar as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 4793) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

Print (Page 4822) P, A Executes the "Print" button function of the control.
SelectAll (Page 4837) P Selects all rows in a table-based control.
SelectRow (Page 4838) P Selects a specific row in a table-based control.
ShowHelp (Page 4842) P, A Executes the "Help" button function of the control.
ShowPropertyDialog 
(Page 4847) 

P, A Executes the "Configuration dialog" button function of the control.

UnselectAll (Page 4855) P Removes all selections from the cells of a table-based control.
UnselectRow (Page 4856) P Removes the selections from a specific cell of a table-based control.

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)
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TrendView

Description

Represents the "TrendView" object. The TrendView object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMITrendView

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-127 Properties

Properties Read Write Description
Authorization (Page 4175) - - Specifies the operating rights of the selected object in 

runtime.  
AxisXBunchCount - - Sets the step width of the large ticks for the X axis. 
AxisXMarkCount - - Sets the step width of the ticks for the X axis. 
AxisXNoOfDigits - -  
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Properties Read Write Description
AxisXShowBunchValues - - Enables scale labeling of the interim values for the X axis. 
AxisXStyle * - -  
AxisY1BunchCount - - Sets the step width of the large ticks for the Y axis. 
AxisY1MarkCount - - Sets the step width of the large ticks for the left Y axis. 
AxisY1ShowBunchValues - - Enables scale labeling of the interim values for the left Y axis. 
AxisY2BunchCount - - Sets the step width of the large ticks for the right Y axis. 
AxisY2MarkCount - - Sets the step width of the ticks for the right Y axis. 
AxisY2ShowBunchValues - - Enables scale labeling of the interim values for the right Y 

axis. 
BackColor (Page 4183) A A Specifies the background color of the selected object. 
ColumnsMoveable - - Specifies that the columns can be moved. 
CountVisibleItems (Page 4253) - - Specifies the number of lines contained in the selection list.  
Enabled (Page 4279) A A Specifies whether the selected object can be operated in 

runtime.  
EnableNavigateButtons - -  
EnableNavigateKeys - - Specifies keyboard operation. 
FitToSize - - Specifies that the size of the object should be automatically 

adapted to the content. 
Flashing - - Specifies that the text block flashes. 
FocusColor (Page 4309) A A Specifies the color for the focus frame of the selected object 

when it is in focus. 
FocusWidth (Page 4310) A A Specifies the border width of the specified object when the 

object is in focus.  
Font (Page 4311) - - Specifies or returns the font.  
Height (Page 4327) A - Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HelpText (Page 4330) A - Returns the tooltip that is shown in runtime as user help for 

the specified object.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Look3D - - Activates 3D visualization. 
Name (Page 4417) A - Returns the object name as STRING. 
RulerColor (Page 4479) A A Specifies the color of the scale gradation (auxiliary line) of 

the axis labelling in the "OnlineTrendControl" object. 
ScaleColor (Page 4481) A A Specifies the color of the scale of the selected object.  
SelectionBackColor  (Page 4498) * - - Specifies the background color of the selected cells.  
SelectionForeColor (Page 4500) * - - Specifies the foreground color of the selected cells.  
ShowRuler (Page 4526) A A Specifies whether a scale gradation (auxiliary line) is shown 

for the axis label of the "OnlineTrendControl" object. 
ShowTableGridLines (Page 4531) - -- Enables the display of grid lines in the table. 
ShowTimeAxis - - Enables the display of the X axis. 
ShowTimeAxisLabeling - - Enables the display of the X axis labeling. 
ShowValueAxis1 - - Enables the display of the left Y axis. 
ShowValueAxis1Label - - Enables the display of the labeling for left Y axis. 
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Properties Read Write Description
ShowValueAxis2 - - Enables the display of the right Y axis. 
ShowValueAxis2Label - - Sets the window title. 
ShowValueTable - - Enables the display of the table of values. 
ShowY1HlpLine - - Enables the display of the auxiliary line. 
ShowY2HlpLine - - Enables the display of the auxiliary line. 
TableBackColor (Page 4563) A A Specifies the background color of the table cells for the 

selected object.  
TableFont - - Specifies the font in the table. 
TableGridLineColor (Page 4567) A A Sets the color of the gridlines in the table of the specified 

object. 
TableHeaderBackColor (Page 4568) A A Specifies the background color in the header of the table of 

the selected object. 
TableHeaderFont - - Specifies the text color of the header. 
TableHeaderForeColor (Page 4569) A A Specifies the text color in the header of the table of the 

selected object. 
TagForExternalTime - - Sets the tag for the external time. 
TimeAxisBegin - -  Sets the start value for the time axis. 
TimeAxisBeginTime - - Specifies the starting time for the display of the selected 

trend.  
TimeAxisCountPoints - - Sets the number of values for the time axis. 
TimeAxisEnd - - Sets the end value for the time axis. 
TimeAxisMode - - Sets the time axis mode. 
TimeAxisRange (Page 4581) - - Period displayed by the time axis. 
TimeAxisSide - - Sets the page for new values on the time axis. 
ToolbarButtons - - Specifies which buttons are available for the toolbar.  
ToolbarEnabled * - - Enables the use of a toolbar in the trend view. 
ToolbarStyle - - Sets the appearance of the toolbar. 
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
TrendsForPrinting * - -  
ValueAxis1AutoRange * - - Sets the automatic adaptation of the data area. 
ValueAxis1Begin - - Sets the start value for the axis. 
ValueAxis1End - - Sets the end value for the axis. 
ValueAxis1LabelLength - - Sets the length of axis labeling. 
ValueAxis1Style * - -  
ValueAxis2AutoRange * - - Sets the automatic adaptation of the data area. 
ValueAxis2Begin - - Sets the start value for the axis. 
ValueAxis2End - - Sets the end value for the axis. 
ValueAxis2LabelLength - - Sets the length of axis labeling. 
ValueAxis2Style * - - Sets the automatic adaptation of the data area. 
ValueY1HlpLine - - Sets the value for the auxiliary line. 
ValueY2HlpLine - - Value for the auxiliary line on the right Y axis. 
Visible (Page 4703) A A Specifies whether the selected object is visible. 
Width (Page 4714) A - Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
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* not visible in the ES

Table 10-128 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 

 

See also
Screen object (list) (Page 3904)

Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

TubeArcObject

Description     

Represents the "TubeArc" object. The TubeArcObject is an element of the ScreenItems list.

Type identifier in VBS
HMITubeArcObject
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Application
In the following example, the object with the name "TubeArcObject1" is moved 10 pixels to the 
right:

 
'VBS24
Dim objTubeArcObject
Set objTubeArcObject = ScreenItems("TubeArcObject1")
objTubeArcObject.Left = objTubeArcObject.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-129 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime. 
Color (Page 4236) P P Specifies the line color of the selected object. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime. 
EndAngle (Page 4280) P P Specifies the angle at which the end point of the selected object 

deviates from the zero position (0°). 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
Name (Page 4417) P - Returns the object name as STRING. 
RadiusHeight (Page 4466) P P Specifies the minor axis of the "Ellipsis" object. 
RadiusWidth (Page 4467) P P Specifies the major axis of the "Ellipsis" object. 
StartAngle (Page 4543) P P Specifies the SQL statement. 
ToolTipText (Page 4627) P P Specifies the tooltip text. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object. 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible.
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-130 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

 

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

TubeDoubleTeeObject

Description     

Represents the "DoubleTee" object. The TubeDoubleTeeObject is an element of the 
ScreenItems list.
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Type identifier in VBS
HMITubeDoubleTeeObject

Application
In the following example, the object with the name "TubeDoubleTeeObject1" is moved 10 
pixels to the right:

 
'VBS21
Dim objTubeDoubleTeeObject
Set objTubeDoubleTeeObject = ScreenItems("TubeDoubleTeeObject1")
objTubeDoubleTeeObject.Left = objTubeDoubleTeeObject.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-131 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime. 
Color (Page 4236) P P Specifies the line color of the selected object. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
Name (Page 4417) P - Returns the object name as STRING. 
ToolTipText (Page 4627) P P Specifies the tooltip text. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object. 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-132 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

 

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

TubePolyline

Description     

Represents the "TubePolyline" object. The TubePolyline object is an element of the 
ScreenItems list.
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Type identifier in VBS
HMITubePolyline

Application
In the following example, the object with the name "TubePolyline1" is moved 10 pixels to the 
right: 

 
'VBS24
Dim objTubePolyline
Set objTubePolyline = ScreenItems("TubePolyline1")
objTubePolyline.Left = objTubePolyline.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-133 Properties

Properties Read Write Description
ActualPointIndex (Page 4154) P P Specifies the number of the current corner point of the selected 

object. 
ActualPointLeft (Page 4154) P P Specifies the X coordinate of the current corner point with reference 

to the screen origin. 
ActualPointTop (Page 4155) P P Specifies the Y coordinate of the current corner point with reference 

to the screen origin. 
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime. 
Color (Page 4236) P P Specifies the line color of the selected object. 
CornerStyle (Page 4250) P P Specifies the type of border lines for the selected object. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
Name (Page 4417) P - Returns the object name as STRING. 
Points - - Specifies the corner points. 
PointsCount (Page 4458) P P Specifies the number of corner points of the polyline or of the polygon. 
ToolTipText (Page 4627) P P Specifies the tooltip text. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object. 
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Properties Read Write Description
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-134 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

 

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)
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TubeTeeObject

Description     

Represents the "Tee" object. The TubeTeeObject is an element of the ScreenItems list. 

Object Type of ScreenItem Object. Represents the "T-piece" graphic object.

Type identifier in VBS
HMITubeTeeObject

Application
In the following example, the object with the name "TubeTeeObject1" is moved 10 pixels to 
the right: 

 
'VBS21
Dim objTubeTeeObject
Set objTubeTeeObject = ScreenItems("TubeTeeObject1")
objTubeTeeObject.Left = objTubeTeeObject.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-135 Properties

Properties Read Write Description
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime. 
Color (Page 4236) P P Specifies the line color of the selected object. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
Name (Page 4417) P - Returns the object name as STRING. 
RotationAngle (Page 4472) P P Specifies the angle of rotation in degrees. 
ToolTipText (Page 4627) P P Specifies the tooltip text. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object. 
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-136 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

 

 

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)
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UserArchiveControl

Description 

Represents the "RecipeView" object. The UserArchiveControl object is an element of the 
ScreenItems list.

     

Type identifier in VBS
HMIUserArchiveControl

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-137 Properties

Properties Read Write Description
ApplyProjectSettingsForDesignMode - - Specifies that the project settings are used for the design. 
ArchiveName  * P P Sets the log name. 
ArchiveType P - Sets the log type. 
AutoCompleteColumns (Page 4177) P P Specifies whether empty columns are shown if the control 

is wider than the configured columns.  
AutoCompleteRows (Page 4177) P P Specifies whether empty rows are shown if the control is 

longer than the number of configured rows.  
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Properties Read Write Description
AutoSelectionColors (Page 4178) P P Specifies whether the colors defined by the system are 

used as the selection colors for cells and rows. 
AutoSelectionRectColor (Page 4179) P P Specifies whether the selection frame is shown with the 

color defined by the system.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
Blocks - - Sets the alarm blocks. 
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
Caption (Page 4221) P P Specifies the text that is displayed in the header of the 

selected object.  
CellCut (Page 4225) P P Specifies whether the contents of the cells are abbreviated 

if the cells are too narrow. 
CellSpaceBottom (Page 4226) P P Specifies the bottom margin of the table cells.  
CellSpaceLeft (Page 4227) P P Sets the left indent for the table cells.  
CellSpaceRight (Page 4227) P P Specifies the right indent of the table cells. 
CellSpaceTop (Page 4228) P P Specifies the top margin of the table cells.  
Closeable (Page 4236) P P Specifies that the control can be closed in runtime. 
ColumnAlign  (Page 4241) * P P Specifies how the selected column is aligned.
ColumnAutoPrecisions  * P P  

Specifies that the number of decimal places displayed for 
an axis is adjusted automatically. 

ColumnCaption  * P P Sets the caption. 
ColumnCount * P - Displays the number of columns. 
ColumnDateFormat  * P P Sets the display format for date information. 
ColumnExponentialFormat  * P P Specifies that exponential notation is used in a column. 
ColumnHideText  * P P Specifies whether the text is displayed. 
ColumnHideTitleText * P P Specifies whether the text is displayed. 
ColumnIndex P P The index specifies on which column other properties, e.g. 

initial value are based. 
ColumnLeadingZeros  * P P Specifies that leading zeros should be displayed. 
ColumnLength  * P P Specifies the number of displayed characters. 
ColumnName  * P - Specifies the name of a column. 
ColumnPrecisions  * P P Sets the number of decimal places. 
ColumnReadonly  * P P Sets the read-only mode for the values in the column. 
ColumnRepos  * P P Repositions the column. 
ColumnResize (Page 4242) P P Enables changes to the width of columns.  
ColumnScrollbar (Page 4244) P P Specifies the scroll bar type. 
ColumnShowDate  * P P Specifies that the date is to be displayed. 
ColumnShowIcon  * P P Enables the display of an icon. 
ColumnShowTitleIcon * P P Enables the display of an icon. 
ColumnSort  * P P Sets the type of sorting. 
ColumnSortIndex  * P P Specifies the sorting order. 
ColumnTimeFormat * P P Sets the display format for time information. 
ColumnTitleAlignment P P Specifies the type of column title alignment. 
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Properties Read Write Description
ColumnTitles (Page 4245) P P Specifies whether the column title is displayed. 
ColumnVisible * P P Enables the visibility of a column. 
ControlDesignMode (Page 4538) P P Specifies the design. 
DataSource - - Sets the data source. 
Enabled (Page 4277) P P Specifies whether the selected object can be operated in 

runtime.  
EnableDelete P P Enables the deletion of data. 
EnableEdit (Page 4280) P P Specifies whether the data shown can be edited in runtime. 
EnableInsert P P Enables insertion of data. 
ExportDirectoryChangeable 
(Page 4286) 

P P Specifies whether the data export directory can be 
changed in runtime. 

ExportDirectoryname (Page 4286) P P Specifies the target directory for the exported Runtime 
data.  

ExportFileExtension (Page 4287) P P Specifies the file extension of the export file. Only the "csv" 
file extension is currently supported.  

ExportFilename (Page 4288) P P Specifies the name of the target file for the exported 
Runtime data. 

ExportFilenameChangeable 
(Page 4288) 

P P Specifies whether the export file name can be changed in 
runtime.  

ExportFormatGuid (Page 4289) P P Default assignment of the ID number and export provider. 
ExportFormatName (Page 4289) P P Specifies the export file format. Only the "csv" file format 

is currently available for the export. 
ExportParameters (Page 4290) P - Specifies the parameters of the selected format by means 

of the "Properties" dialog. 
ExportSelection (Page 4290) P P Specifies which runtime data of the control is exported.
ExportShowDialog (Page 4291) P P Specifies whether the data export dialog is shown in 

runtime. 
Filters - - Specifies database criteria in SQL syntax.  
FilterSQL P - Sets an SQL statement for the filter criterion. 
Font (Page 4311) - - Specifies or returns the font.  
GridLineColor (Page 4325) P P Specifies the color for the grid lines. 
GridLineWidth (Page 4326) P P Specifies the width of the separation lines in pixels.  
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HorizontalGridLines (Page 4341) P P Specifies whether horizontal separation lines are 

displayed.  
IconSpace (Page 4344) P P Specifies the spacing between icons and text in the table 

cells. 
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 4379) P P Sets the color of the window separation lines. 
LineWidth (Page 4381) P P Specifies the line thickness of the selected object. 
Moveable (Page 4416) P P Specifies whether the window can be moved in runtime.  
ObjectName (Page 4424) P - Returns the object name as STRING. 
PrintJobName (Page 4460) P P Specifies a print job. 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4132 System Manual, 07/2013,  



Properties Read Write Description
RowScrollbar (Page 4475) P P Specifies whether row scroll bars are displayed.  
RowTitleAlignment P P  Specifies the type of row title alignment. 
RowTitles P P Specifies that row headers will be displayed. 
RTPersistence (Page 4477) P P Specifies how online configurations of WinCC are 

retained. 
RTPersistenceAuthorization P P Specifies the authorization required for online 

configuration in runtime. 
RTPersistenceType (Page 4478) - - Specifies how online configurations of WinCC are 

retained.  
SelectArchiveName * P P Specifies definition of the log by name. 
SelectedCellColor (Page 4493) P P Specifies the background color of the selected cell.  
SelectedCellForeColor (Page 4494) P P Specifies the font color of the selected cell.  
SelectedRowColor (Page 4495) P P Specifies the background color of the selected row.  
SelectedRowForeColor (Page 4495) P P Specifies the font color of the selected row.  
SelectedTitleColor (Page 4496) P P Specifies the background color of a selected table header.  
SelectedTitleForeColor (Page 4497) P P Specifies the font color of the selected table header.  
SelectionColoring (Page 4499) P P Specifies whether selection colors are used for cells or 

rows. 
SelectionRect (Page 4502) P P Specifies whether a selection frame is used for the 

selected cells or rows. 
SelectionRectColor (Page 4503) P P Specifies the color of the selection rectangle in the alarm 

window if SelectionType equals "1".  
SelectionRectWidth (Page 4504) P P Specifies the line width of the selection rectangle in the 

alarm window if SelectionType equals "1". 
SelectionType (Page 4504) P P Specifies the number of lines you can mark.   
ShowSortButton (Page 4528) P P Specifies whether the sorting button is shown above the 

vertical scroll bar. 
ShowSortIcon (Page 4529) P P Specifies whether the sorting icon is displayed.  
ShowSortIndex (Page 4530) P P Specifies whether a sort index is displayed.  
ShowTitle (Page 4534) P P Specifies the representation of the control's window title. 
Sizeable P P Specifies that the size of an object can be changed in 

runtime. 
SortSequence P P Specifies how the sorting order can be changed by mouse 

click. 
StatusbarBackColor (Page 4547) P P Specifies the background color of the status bar.  
StatusbarElementAdd  (Page 4547) * - P Creates a new, user-defined status bar element.  
StatusbarElementAutoSize 
(Page 4548) *

P P Specifies whether the width of the selected status bar 
element is set automatically.  

StatusbarElementCount  (Page 4548) * P - Specifies the number of configurable status bar elements. 
StatusbarElementIconId  (Page 4549) * P P Default assignment of the ID number and icon of a status 

bar element. 
StatusbarElementId  (Page 4549) * P - Returns the ID number of the selected status bar element.
StatusbarElementIndex (Page 4550) P P References a status bar element. You can use this 

property to assign the values of other properties to a 
specific element of the status bar. 
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Properties Read Write Description
StatusbarElementName  (Page 4550) * P P Displays the object name of the selected status bar 

element. 
StatusbarElementRemove  (Page 4551) 
*

P P Removes the selected status bar element.  

StatusbarElementRename  (Page 4551) 
*

P P Renames the user-defined status bar element that is 
referenced by means of the "StatusbarElementIndex" 
property. 

StatusbarElementRepos  * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 4552) - - Specifies the elements that are to be shown in the status 

bar. 
StatusbarElementText  * P P Specifies the text of the currently selected status bar 

element. 
StatusbarElementTooltipText  
(Page 4552) *

P P Specifies the tooltip text for the user-defined status bar 
element. 

StatusbarElementUserDefined  
(Page 4553) *

P - Indicates whether the project engineer has added the 
toolbar button as a new user-defined element. 

StatusbarElementVisible  (Page 4554) * P P In the list, activate the status bar elements that you wish 
to display in runtime. 

StatusbarElementWidth  (Page 4554) * P P Specifies the width of the selected status bar element in 
pixels. 

StatusbarFont - - Status bar font 
StatusbarFontColor (Page 4554) P P Specifies the color of the text in the status bar.  
StatusbarShowTooltips (Page 4557) P P Specifies whether tooltips are displayed for the elements 

of the status bar in runtime.  
StatusbarText (Page 4558) P - Default text in the status bar. 
StatusbarUseBackColor (Page 4558) P P Specifies whether the background color of the status bar 

is shown. 
StatusbarVisible (Page 4559) P P Specifies whether the status bar of the control is 

displayed.  
TableColor (Page 4564) P P Specifies the background color of the rows. Use this to 

open the color selection dialog.  
TableColor2 (Page 4564) P P Specifies the background color of "Row color 2".  
TableForeColor (Page 4565) P P  
TableForeColor2 (Page 4566) P P Specifies the font color of "Row color 2". 
TimeBase (Page 4584) P P Sets the timebase. 
TitleColor P P Specifies the color of the header. 
TitleCut (Page 4606) P P Specifies whether the contents of the fields of a header 

should be abbreviated if the column is too narrow.  
TitleDarkShadowColor (Page 4607) P P Specifies the color of the dark side of shading. 
TitleForeColor (Page 4607) P P Specifies the font color of the table header for the selected 

status. 
TitleGridLineColor (Page 4607) P P Specifies the color of separation lines in the table header. 
TitleLightShadowColor (Page 4608) P P Specifies the color of the bright side of shading. 
TitleSort (Page 4608) P P Specifies how sorting by column title is triggered.  
TitleStyle (Page 4609) P P Specifies whether a shading color is used for the table 

header. 
ToolbarAlignment (Page 4616) P P Specifies or returns the position of the toolbar. 
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Properties Read Write Description
ToolbarBackColor (Page 4616) P P Specifies the background color of the toolbar. 
ToolbarButtonActive  (Page 4617) * P P Specifies whether the function linked to the button is 

activated in runtime. 
ToolbarButtonAdd  (Page 4618) * P P Creates a new, user-defined button function.  
ToolbarButtonBeginGroup  (Page 4618) 
*

P P Specifies whether a separator is inserted before the 
selected button function.  

ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  (Page 4619) * P - Specifies the number of configurable button functions. 
ToolbarButtonEnabled  (Page 4619) * P P Specifies whether a user-defined toolbar button can be 

operated. 
ToolbarButtonHotKey  (Page 4620) * P P Shows the hotkey for the selected button function.  
ToolbarButtonId  (Page 4620) * P P Unique ID number for the selected button function. 
ToolbarButtonIndex (Page 4620) P P References a button function.  
ToolbarButtonLocked  (Page 4621) * P P Specifies whether the clicked, pressed in state is displayed 

for a user-defined toolbar button. 
ToolbarButtonName  (Page 4621) * P - Shows the name of the selected button function.  
ToolbarButtonPasswordLevel  
(Page 4622) *

P P Shows the authorization for the selected button function.  

ToolbarButtonRemove  (Page 4622) * P - Removes the selected button function from the list.  
ToolbarButtonRename  (Page 4622) * P - Renames the user-defined toolbar element that is 

referenced by means of the "ToolbarButtonIndex" 
property.  

ToolbarButtonRepos  (Page 4623) * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  (Page 4623) 
*

P P Specifies the tooltip text for the button. 

ToolbarButtonUserDefined  
(Page 4624) *

P - Indicates whether the project engineer has added the 
toolbar button as a new user-defined button.  

ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips (Page 4624) P P Specifies whether the tooltips for the button functions are 

displayed in runtime.  
ToolbarUseBackColor (Page 4625) P P Specifies whether the background color for the toolbar is 

shown. 
ToolbarUseHotKeys (Page 4626) P P Specifies whether the hotkeys for the button functions are 

activated in runtime.  
ToolbarVisible (Page 4626) P P Specifies whether the toolbar of the control is displayed. 
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
UseSelectedTitleColor (Page 4682) P P Specifies whether a selection color is used for the headers 

of selected table cells. 
UseTableColor2 (Page 4684) P P Specifies whether a second row color is used for the 

representation of the table. 
VerticalGridLines (Page 4702) P P Specifies whether vertical separation lines are displayed. 
Visibility P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES
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Table 10-138 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property with 

VBScript during runtime. 
CopyRows (Page 4751) P Executes the "Copy rows" button function of the control.
CutRows (Page 4753) P Executes the "Cut rows" button function of the recipe view.
DeleteRows (Page 4756) P Executes the "Delete rows" button function of the recipe view.
Export (Page 4757) P, A Executes the "Export log" or "Export data" button function of the control.
GetColumn (Page 4758) P Returns the column object of the recipe view designated by name or index as 

"ICCAxUAColumn" type.
GetColumnCollection 
(Page 4759) 

P Returns the list of all column objects of the recipe view as "ICCAxCollection" 
type.

GetRow (Page 4769) P Returns the row object defined by its row number in the table-based controls 
as "ICCAxDataRow" type.

GetRowCollection (Page 4770) P Returns the list of all row objects of the table-based controls as 
"ICCAxDataRowCollection" type. 

GetSelectedRow (Page 4777) P Returns the selected row object of a table-based control as "ICCAxDataRow" 
type.

GetSelectedRows (Page 4778) P Returns the selected row objects of a table-based control as type 
"ICCAxDataRow" for multiple selection.

GetStatusbarElement 
(Page 4784) 

P, A Returns the element of the control's status bar designated by name or index 
as "ICCAxStatusbarElement" type.

GetStatusbarElementCollectio
n (Page 4785) 

P, A Returns the list of all status bar elements of the control as "ICCAxCollection" 
type.

GetToolbarButton (Page 4792) P, A Returns the button function designated by name or index on the control toolbar 
as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 4793) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

MoveToFirst (Page 4813) P Executes the "First line" button function of the control.
MoveToLast (Page 4815) P Executes the "Last data record" button function of the control.
MoveToNext (Page 4816) P Executes the "Next data record" button function of the control.
MoveToPrevious (Page 4818) P Executes the "Previous data record" button function of the control.
PasteRows (Page 4821) P Executes the "Insert rows" button function of the recipe view.
Print (Page 4822) P, A Executes the "Print" button function of the control.
ReadTags (Page 4824) P Executes the "Read tags" button function of the recipe view.
SelectAll (Page 4837) P Selects all rows in a table-based control.
SelectRow (Page 4838) P Selects a specific row in a table-based control.
ServerExport (Page 4839) P Executes the "Export log" button function of the recipe view.
ServerImport (Page 4840) P Executes the "Import log" button function of the recipe view.
ShowHelp (Page 4842) P, A Executes the "Help" button function of the control.
ShowPropertyDialog 
(Page 4847) 

P, A Executes the "Configuration dialog" button function of the control.

ShowSelectArchive 
(Page 4847) 

P Executes the "Select data connection" button function of the recipe view.

ShowSelection (Page 4848) P Executes the "Selection dialog" button function of the recipe view.
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Methods Valid Description
ShowSelectTimeBase 
(Page 4849) 

P Executes the "Timebase dialog" button function of the recipe view.

ShowSort (Page 4850) P Executes the "Sorting dialog" button function of the recipe view.
UnselectAll (Page 4855) P Removes all selections from the cells of a table-based control.
UnselectRow (Page 4856) P Removes the selections from a specific cell of a table-based control.
WriteTags (Page 4860) P Executes the "Write tags" button function of the recipe view.

See also
Screen (Page 3930)

ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

UserView 

Description

Represents the "UserView" object. The UserView object is an element of the ScreenItems list. 

     
 

 Note

The object "Simple UserView" cannot be dynamized with a user-defined function.
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Type identifier in VBS
HMIUserView

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-139 Properties

Properties Read Write Description
Appearance (Page 3930) - - Specifies the layout for this NC subroutine. 
Authorization (Page 4175) * - - Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4183) A A Specifies the background color of the selected object. 
Columns - - Specifies the columns to be displayed. 
ColumnsMoveable - - Specifies that the columns can be moved. 
CountVisibleItems 
(Page 4253) 

- - Specifies the number of lines contained in the selection list.  

Enabled (Page 4279) A A Specifies whether the selected object can be operated in runtime.  
FitToSize - - Specifies that the size of the object should be automatically adapted 

to the content. 
Flashing - - Specifies that the text block flashes. 
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Name (Page 4417) A - Returns the object name as STRING. 
SelectionBackColor 
(Page 4499) 

A A Specifies the background color of the selected cells.  

SelectionForeColor 
(Page 4501) 

A A Specifies the foreground color of the selected cells.  

ShowTableGridlines 
(Page 4531) 

- - Enables the display of gridlines in the table of the specified object. 

TableBackColor (Page 4563) A A Specifies the background color of the table cells for the selected 
object.  

TableFont - - Specifies the font in the table. 
TableForeColor (Page 4566) A A  
TableGridlineColor 
(Page 4567) 

A A Specifies the color for the grid lines. 

TableHeaderBackColor 
(Page 4568) 

A A Specifies the background color in the header of the table of the 
selected object. 

TableHeaderFont - - Specifies the text color of the header. 
TableHeaderForeColor 
(Page 4569) 

A A Specifies the text color in the header of the table of the selected 
object. 
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Properties Read Write Description
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Visible (Page 4703) * A A Specifies whether the selected object is visible. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-140 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 4747) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
ScreenItem (Page 3932)

ScreenItems (list) (Page 3934)

Screen object (list) (Page 3936)

WindowSlider

Description
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Represents the "Window slider" object. The WindowSlider object is an element of the 
ScreenItems list.

Type identifier in VBS
HMIWindowSlider

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-141 Properties

Properties Read Write Description
AskOperationMotive (Page 4173) P P Specifies whether the reason for operating this object is logged. 
Authorization (Page 4175) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 4181) P P Specifies the background color of the selected object. 
BackColorBottom (Page 4184) P P Specifies the color for the lower / right part of the . 
BackColorTop (Page 4184) P P Sets the color for the upper / left part of the slider.  
BackFillStyle (Page 4185) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 4188) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 4188) P P Specifies the background color for flash state "On".  
BackFlashingEnabled (Page 4189) P P Specifies whether the background of the specified object flashes 

in runtime. 
BackFlashingRate (Page 4190) P P Specifies the flash rate of the background for the selected object. 
BorderBackColor (Page 4199) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 4202) P P Specifies the line color of the object. 
BorderFlashingColorOff (Page 4206) P P Specifies the border line color of the selected object for the flash 

state "Off".  
BorderFlashingColorOn (Page 4207) P P Specifies the border line color of the selected object for the flash 

state "On".  
BorderFlashingEnabled (Page 4208) P P Specifies whether the border line of the selected object flashes in 

runtime. 
BorderFlashingRate (Page 4209) P P Specifies the flash rate of the border line for the selected object.  
BorderStyle (Page 4213) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 4216) P P Specifies the line thickness of the object. 
CornerStyle (Page 4250) - - Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 4270) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 
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Properties Read Write Description
EdgeStyle (Page 4274) - - Specifies the line style of the selected object.  
Enabled (Page 4277) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 4296) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
Height (Page 4327) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HighLimitColor (Page 4332) P P Specifies the color of the top or right scroll button in a scroll bar.  
JumpToLimitsAfterMouseClick 
(Page 4350) 

P P Specifies the length of the long tick marks of a scale. 

Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 4380) - - Specifies the shape of the line end. 
LogOperation (Page 4386) P P Specifies whether, after operating this object, an alarm is output 

to the alarm system.  
LowLimitColor (Page 4390) P P Specifies the color of the bottom or left scroll button in a scroll 

bar.  
MarginToBorder (Page 4391) P P Specifies the width of the 3D border in pixels. 
MaximumValue (Page 4392) P P Specifies the maximum value of the scale in the selected object.  
MinimumValue (Page 4413) P P Specifies the minimum value of the scale in the selected object. 
Name (Page 4417) P - Returns the object name as STRING. 
OperationSteps (Page 4429) P P Specifies by how many steps the slider of the scrollbar is moved 

with one mouseclick.  
ProcessValue (Page 4461) P P Specifies the default for the value to be displayed.  
RelativeFillLevel (Page 4470) P P Specifies the fill percentage for the object. 
ShowBadTagState (Page 4516) P P Specifies whether an object is grayed out if its associated tag has 

a bad quality code or tag state. 
ShowFillLevel (Page 4519) P P Specifies whether the selected object is filled.  
StyleSettings (Page 4561) P P Specifies the display style for the object:  
TextOrientation (Page 4576) P P Specifies the text orientation of the selected object.  
ThumbBackColor (Page 4577) P P Specifies the background color of the slider in the "Slider" object. 
ToolTipText (Page 4627) P P Specifies the tooltip text.  
Top (Page 4629) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 4633) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 4674) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 4676) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 4703) P P Specifies whether the selected object is visible. 
Width (Page 4714) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
WindowsStyle (Page 4718) P P Specifies whether the object is displayed in the general Windows 

style. 
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Table 10-142 Methods

Methods Valid Description
Activate (Page 4744) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 4747) 

P Dynamically activates a trigger and the specified cycle for a property at runtime. 

DeactivateDynamic 
(Page 4754) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 3936)

WLanQualityView

Description

Represents the "WLAN reception" object. The WLanQualityView object is an element of the 
ScreenItems list.     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-143 Properties

Properties Read Write Description
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Name (Page 4417) A - Returns the object name as STRING. 
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Properties Read Write Description
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-144 Methods

Methods Valid Description
????   
   

 

See also
Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

ZoneLabelView

Description

Represents the "Zone name" object. The ZoneLabelView object is an element of the 
ScreenItems list.     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-145 Properties

Properties Read Write Description
Font (Page 4311) - - Specifies or returns the font.  
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Name (Page 4417) A - Returns the object name as STRING. 
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-146 Methods

Methods Valid Description
???   
   

 

See also
Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

ZoneQualityView

Description

Represents the "ZoneSignal" object. The ZoneQualityView object is an element of the 
ScreenItems list.     
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-147 Properties

Properties Read Write Description
Height (Page 4327) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 4355) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 4366) A A Specifies the value of the X coordinate of the object. 
Name (Page 4417) A - Returns the object name as STRING. 
Top (Page 4629) A A Specifies the value of the Y coordinate of the object. 
Width (Page 4714) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-148 Methods

Methods Valid Description
?????   
   
   

 

See also
Screen (Page 3905)

ScreenItem (Page 3906)

ScreenItems (Page 3908)

Properties

Properties A

AboveUpperLimitColor

Description
Defines the color of the specified object for the case "High limit exceeded".   
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See also
SymbolLibrary (Page 4098)

GraphicIOField (Page 4011)

Switch (Page 4089)

SymbolicIOField (Page 4093)

IOField (Page 4021)

AcceptOnExit

Description
Specifies whether the input field will be confirmed automatically when it is left. 

Access in Runtime: Read and write

Syntax
Object.AcceptOnExit[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField" or "SymbolicIOField".

BOOLEAN
Optional TRUE, if the input field will be confirmed automatically when it is left.

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

AcceptOnFull

Description
Specifies whether the input field will be left and confirmed automatically when the set number 
of values have been entered. 

Access in Runtime: Read and write

Syntax
Object.AcceptOnFull[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".
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BOOLEAN
Optional TRUE, if the input field will be left and confirmed automatically when the set number 
of values have been entered. 

See also
IOField (Page 4021)

AccessPath

Description
Returns the storage path of a screen.   

Access during runtime: Read

Syntax
Object.AccessPath

Object
Necessary. A "Screen" object.

Example
In the following example, the path of the picture "ScreenWindow1" is issued:

 
'VBS67
Dim objScreen
Set objScreen = HMIRuntime.Screens("ScreenWindow1")
MsgBox objScreen.AccessPath

See also
Screen (Page 3930)

Activate

Description
Determines whether the data to be displayed are requested by the alarm server.  

Access in Runtime: Read and write
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Syntax
Object.Activate[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the data to be displayed are requested by the alarm server.

See also
AlarmControl (Page 3947)

Active

Description
Specifies whether the data that is to be shown is requested by the log server.   

Access in Runtime: Read and write

Syntax
Object.Active[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl," or 
"OnlineTableControl".

BOOLEAN
Optional TRUE, if the data that is to be shown is requested by the log server.

Comments
The screen opening times are reduced if you do not set this attribute. You can change the 
value dynamically.

To differentiate between the "Activate" property and the "Activate" methods, the property is 
addressed via "Object".

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)
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ActiveProject

Description
Returns the specified project.

Access in Runtime: Read

Syntax
Object.ActiveProject

Object
Required A "HMIRuntime" object.

See also
HMIRuntime  (Page 3922)

Project (Page 3929)

ActiveScreen

Description
Returns an object of type "Screen" which shows the screen that currently has the focus.   

 

 Note

If you query the "ActiveScreen" property in a function, it may be due to a ScreenSavers that 
the property does not return a valid "Screen" object but "Nothing" and a system alarm is 
displayed.

 

Access during runtime: Read

Syntax
Object.ActiveScreen

Object
Necessary. An object of the "HMIRuntime" type.

Comments
Which screen is returned depends on whether the root screen or the permanent window has 
the focus.
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The ActiveScreen property returns NOTHING if no screen has the focus. This is the case, for 
example, if a different window has the focus. With the instruction "If not [printout] Is Nothing" 
you can query whether a screen is going to be returned:

 
'VBS_Example_ActiveScreen
Dim objActiveScreen
Set objActiveScreen = HmiRuntime.ActiveScreen
If Not objActiveScreen Is Nothing Then
'found an active screen
HmiRuntime.Trace("There is an active screen." & vbCrLf)
Else
'found NO active screen
HmiRuntime.Trace("There is NO active screen." & vbCrLf)
End If

ActiveScreen

Description
Returns a "Screen" type object, which represents the screen which has the focus at the 
moment.   

 

 Note

If you query the "ActiveScreen" property in a user-defined function, it may be due to a screen 
saver that the property does not return a valid "screen" object but "Nothing". A system 
message will be issued.

 

Access in Runtime: Read

Syntax
Object.ActiveScreen

Object
Required An object of the "HMIRuntime" type.

Comments
Which screen is returned depends on whether the root screen or the permanent window has 
the focus.

The ActiveScreen property returns NOTHING if no screen has the focus. That is the case, for 
example, when another window has the focus. With the statement "If not [expression] is 
nothing"  you are able to interrogate whether a screen is to be returned:

 
VBS example ActiveScreen
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Dim objActiveScreen
Set objActiveScreen = HmiRuntime.ActiveScreen
If not objActiveScreen is nothing then
'found an active screen
HmiRuntime.Trace("There is an active screen." & vbCrLf)
Else
'found NO active screen
HmiRuntime.Trace("There is NO active screen." & vbCrLf)
End if

ActiveScreenItem

Description
References the screen object that currently has the focus.  

It is only if the screen of the respective "Screen" object is currently selected and has an input 
field that the "ActiveScreenItem" property of the "Screen" object will be occupied with a valid 
"ScreenItem" object. In all other cases if, for example, another screen from the "Screens" list, 
an independent window within WinCC or another application is selected, this property is not 
supplied on the screens, i.e. assigned "Nothing".

Application
You use the "ActiveScreenItem" object to address the properties of the object that has the 
focus in Runtime.

ActiveScreenItem

Description
References the screen object which currently has the focus.   

The "ActiveScreenItem" property of the "Screen" object is only assigned a valid "ScreenItem" 
object if the screen of the corresponding "Screen" object is active and has an input field. In all 
other cases, for example, with a different screen from the "Screens" list, an independent 
window within WinCC or a different application will be selected, this property will not apply to 
the screens and will be occupied with "Nothing".

Application
The "ActiveScreenItem" object is used to address the object property which has the focus in 
runtime.
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ActualPointIndex

Description
Specifies the number of the current corner point of the selected object. 

Access in Runtime: Read and write

Syntax
Object.ActualPointIndex[=Int]

Object
Required A "ScreenItem" object with the formats "Polyline" or "Polygon".

Int
Optional A value or a constant that specifies the number of the current corner point of the 
selected object.

See also
Polyline (Page 4060)

Polygon (Page 4057)

TubePolyline (Page 4125)

ActualPointLeft

Description
Specifies the X coordinate of the current corner point with reference to the screen origin. The 
screen source is at the top left of the object.  Every corner is identified by an index which is 
derived from the number ("PointCount") of the existing corners.

Access in Runtime: Read and write

Syntax
Object.ActualPointLeft[=Int]

Object
Required An object of the "ScreenItem" type with the format "Polyline," or "Polygon".

Int
Optional A value or a constant that specifies the X coordinate of the current corner point with 
reference to the screen origin. 
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Comments
Changing the value can have an effect on the properties "Width" (object width) and "Left" (X 
coordinate of the object position).

See also
Polyline (Page 4060)

Polygon (Page 4057)

TubePolyline (Page 4125)

ActualPointTop

Description
Specifies the Y coordinate of the current corner point with reference to the screen origin. The 
screen source is at the top left of the object. 

Access in Runtime: Read and write

Syntax
Object.ActualPointTop[=Int]

Object
Required An object of the "ScreenItem" type with the format "Polyline," or "Polygon".

Int
Optional A value or a constant that specifies the Y coordinate of the current corner point with 
reference to the screen origin.

Comments
Changing the value can have an effect on the properties "Height" (object height) and "Top" (X 
coordinate of the object position). 

See also
Polyline (Page 4060)

Polygon (Page 4057)

TubePolyline (Page 4125)
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AdaptBorder 

Description
Specifies whether the border of the selected object will be dynamically adapted to the text size. 

Access in Runtime: Read and write

Syntax
Object.AdaptBorder[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Checkbox" or "OptionGroup".

BOOLEAN
Optional TRUE, if the border of the selected object will be dynamically adapted to the text size.

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

CheckBox (Page 3974)

OptionGroup (Page 4054)

AdaptFontSizeToLineHeight

Description
Specifies whether the font size will be adapted to the line height.   

Access in Runtime: Read and write

Syntax
Object.AdaptFontSizeToLineHeight[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the font size will be adapted to the line height.
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See also
AlarmControl (Page 3947)

AdaptScreenToWindow

Description
Specifies whether or not the screen displayed in a screen window adapts to the size of the 
screen window in Runtime.   .   

Access in Runtime: Read

Syntax
Object.AdaptScreenToWindow[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE, if the screen adapts to the screen window size.

FALSE, if the screen does not adapt to the screen window size.

See also
AlarmControl (Page 3947)

ScreenWindow (Page 4078)

AdaptWindowToScreen

Description
Specifies whether or not the screen window adapts to the screen it displays in Runtime.      

Access in Runtime: Read

Syntax
Object.AdaptWindowtoScreen[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Screenwindow".

BOOLEAN
TRUE, if the screen window size adapts to the screen.
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FALSE, if the screen window size does not adapt to the screen.

See also
ScreenWindow (Page 4078)

AddAssignment

Description 
Adds an entry. 

Address 

Description
Specifies the web address that will be opened in the HTML browser. 

Access in Runtime: Read and write

Syntax
Object.Address[=STRING]

Object
Required A "ScreenItem" object with the format "HTMLBrowser".

STRING
Optional A value or a constant that contains the web address. 

See also
HTMLBrowser (Page 4019)

AdjustBorder3DWithStyle

Description
Specifies whether the 3D border width will be displayed in the general Windows style. 

Access in Runtime: Read and write

Syntax
Object.AdjustBorder3DWithStyle[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "Button".

BOOLEAN
Optional TRUE, if the 3D border width will be displayed in the general Windows style.

See also
Button (Page 3968)

AdjustRulerWindow

Description
Specifies whether the ruler window is adapted every time the trend view is displayed. 

Access in Runtime: Read and write

Syntax
Object.AdjustRulerWindow[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE, if the ruler window is adapted every time the trend view is displayed.

Comments
TRUE, if the ruler window will be moved and then shown and hidden, it will be displayed at the 
original position in the original size.

See also
OnlineTrendControl (Page 4045)

Alarm

Description
Specifies the limit for the storage space display as of which an alarm will be reported. 

Access in Runtime: Read and write
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Syntax
Object.Alarm[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that specifies the limit for the storage space display as of which 
an alarm will be reported.

See also
DiskSpaceView (Page 3991)

AlarmColor

Description
Specifies the color in which the bars will be shown as soon as the alarm area is reached. 

Access in Runtime: Read and write

Syntax
Object.AlarmColor[=Color]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Color
Optional A value or a constant that specifies the color in which the bar will be shown as soon 
as the warning area is exceeded.

See also
DiskSpaceView (Page 3991)

AlarmFilter

Description
Specifies a SQL-Statement for selecting the alarms that will be shown in the alarm window. 

Alarm list and hit list filtering and sorting settings

Access in Runtime: Read and write
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Syntax
Object.AlarmFilter[=String]

Object
Required A "ScreenItem" object with the format "AlarmControl".

String
Optional A value or a constant that specifies a SQL-Statement for selecting the alarms that 
will be shown in the alarm window. 

See also
AlarmControl (Page 3947)

AlarmHigh

Description
Defines the top limit value at which an alarm should be triggered or returned. 
The type of evaluation (percentage or absolute) is specified with the "TypeAlarmHigh" 
property.   

Access in Runtime: Write and read

Syntax
Object.AlarmHigh[=REAL]

Object
Required A "ScreenItem" object with the format "Bar".

REAL
Value for the upper limit

See also
Bar (Page 3961)

AlarmID

Description 
Returns the AlarmID of the Alarm object. The AlarmID is unique and is assigned by the system.

AlarmID (readonly)
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See also
Alarms (list) (Page 3913)

AlarmLogs

Description
Returns an object of type "AlarmLogs".

Access in Runtime: Read

Syntax
Object.AlarmLogs

Object
Required A "Logging" object. 

See also
Logging (Page 3927)

AlarmLow

Description
Defines the bottom limit value at which an alarm should be triggered or returned. 
The type of evaluation (percentage or absolute) is specified with the "TypeAlarmLow" 
property.   

Access in Runtime: Write and read

Syntax
Object.AlarmLow[=REAL]

Object
Required A "ScreenItem" object with the format "Bar".

REAL
Value for the lower limit

 

See also
Bar (Page 3961)
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AlarmLowerLimit

Description
Specifies the upper limit at which the alarm will be triggered. 

Access in Runtime: Read and write

Syntax
Object.AlarmLowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the lower limit at which the alarm will be triggered. 

Comments
The type of evaluation (percentage or absolute) is established using the 
"AlarmLowerLimitRelative" property.

The "AlarmLowerLimitEnable" property establishes whether the monitoring of this limit is 
enabled. 

See also
Bar (Page 3961)

AlarmLowerLimitColor

Description
Specifies the bar color of the "AlarmLowerLimit" limit.

The "AlarmLowerLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.AlarmLowerLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".
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Color
Optional A value or a constant that specifies the bar color for the "AlarmLowerLimit" limit.

See also
Bar (Page 3961)

AlarmLowerLimitEnabled

Description
Specifies whether the "AlarmLowerLimit" limit is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.AlarmLowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "AlarmLowerLimit" limit is to be monitored.

Comments
The following values will be established via the properties "AlarmLowerLimit", 
"AlarmLowerLimitColor" and "AlarmLowerLimitRelative":

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 3961)

AlarmLowerLimitRelative

Description
Establish whether the lower limit at which the interrupt is triggered is evaluated as a percentage 
or an absolute value. 

Access in Runtime: Read and write
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Syntax
Object.AlarmLowerLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit at which the interrupt is triggered is evaluated as a percentage.

See also
Bar (Page 3961)

AlarmUpperLimit

Description
Establishes the upper limit at which the interrupt will be triggered. 

Access in Runtime: Read and write

Syntax

Object.AlarmUpperLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that defines the upper limit at which an interrupt will be triggered. 

Comments
The type of evaluation (percentage or absolute) is defined using the "AlarmUpperLimitRelative" 
property.

The "AlarmUpperLimitEnable" property defines whether or not monitoring of this limit is 
enabled. 

See also
Bar (Page 3961)

AlarmUpperLimitColor

Description
Defines the bar color for the "AlarmUpperLimit" limit. 
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The "AlarmUpperLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.AlarmUpperLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that defines the bar color for the "AlarmUpperLimit" limit.

See also
Bar (Page 3961)

AlarmUpperLimitEnabled

Description
Specifies whether the "AlarmUpperLimit" value is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.AlarmUpperLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "AlarmUpperLimit" value is monitored. 

Comments
The following values will be defined using the properties "AlarmUpperLimit", 
"AlarmUpperLimitColor" and "AlarmUpperLimitRelative":

Limit

Representation upon reaching the limit

Type of evaluation
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See also
Bar (Page 3961)

AlarmUpperLimitRelative

Description
Establish whether the upper limit at which the interrupt is triggered is evaluated as a percentage 
or an absolute value. 

Access in Runtime: Read and write

Syntax
Object.AlarmUpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit at which the interrupt is triggered is evaluated as a percentage 
or an absolute value. 

See also
Bar (Page 3961)

Alignment

Description
Determines the layout of the scale (left/right or top/bottom) depending on the position of the 
bar object or returns it.   

Access in Runtime: Read and write

Syntax
Object.Alignment[=ScalePosition]

Object
Required An object of the "ScreenItem" type with the format "Bar".

ScalePosition
1: Right or bottom .

0: Left or top.
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See also
Bar (Page 3961)

AlignmentLeft

Description
Defines or returns the horizontal alignment of the text. Value range from 0 to 2.   

Access in Runtime: Read and write

Syntax
Object.AlignmentLeft[=HorizontalAlignment]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "RoundButton", "CheckBox", "OptionGroup", "MultilineEdit", 
"ComboBox", "ListBox".

HorizontalAlignment
0: Alignment left

1: Alignment centered

2: Alignment right

 

AlignmentTop

Description
Defines or returns the vertical alignment of the text. Value range from 0 to 2.

Access in Runtime: Read and write

Syntax
Object.AlignmentTopt[=VerticalAlignment]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "RoundButton", "CheckBox", "OptionGroup".

VerticalAlignment
0: Alignment left

1: Alignment centered
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2: Alignment right

AllowMenu

Description
Establishes whether the shortcut menu should be enabled to control the Sm@rtClient view. 

Syntax
Object.AllowMenu

Object
Required A "ScreenItem" object with the format "SmartClientView".

See also
SmartClientView (Page 4085)

AllowPersistence 

Description
Specifies whether the persistence is adjustable. 

Access in Runtime: Read and write

Syntax
Object.AllowPersistence[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

BOOLEAN
Optional TRUE, if the persistence is adjustable. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)
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Analog

Description
Specifies whether the clock should be shown as an analog clock. 

Access in Runtime: Read and write

Syntax
Object.Analog[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Clock".

BOOLEAN
Optional TRUE, if the clock should be shown as an analog clock.

See also
Clock (Page 3984)

AngleAlpha

Description
Defines or returns depth angle a for the 3D-effect of the "3DBarGraph" object. Value range in 
degrees from 0 to 90.

AngleBeta

Description
Defines or returns depth angle b for the 3D-effect of the "3DBarGraph" object. Value range in 
degrees from 0 to 90.

AngleMax 

Description
Specifies the angle of the scale end of the "Gauge" object.  

Access in Runtime: Read and write

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4168 System Manual, 07/2013,  



Syntax
Object.AngleMax[= DOUBLE]

Object
Required A "ScreenItem" object with the format "Gauge".

DOUBLE
Optional A value or a constant that specifies the angle in degrees.

Comments
The start and end of the scale gradations are described with the properties "AngleMin" and 
"AngleMax" in angle degrees.

The value of the AngleMin property must always be less than the value of the AngleMax 
property. The zero degree angle is located at the 3 o´clock position on the scale. Positive angle 
values are counted clockwise.

See also
Gauge (Page 4008)

AngleMin

Description
Specifies the angle of the scale start of the "Gauge" object. 

Access in Runtime: Read and write

Syntax
Object.AngleMin[= DOUBLE]

Object
Required A "ScreenItem" object with the format "Gauge".

DOUBLE
Optional A value or a constant that specifies the angle in degrees.

Comments
The start and end of the scale gradations are described with the properties "AngleMin" and 
"AngleMax" in angle degrees.

The value of the AngleMin property must always be less than the value of the AngleMax 
property.
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The zero degree angle is located at the 3 o´clock position on the scale. Positive angle values 
are counted clockwise.

See also
Gauge (Page 4008)

Application

Description
Supplies the content of the application window Read only access.

See also
ScriptDiagnostics (Page 4080)

ApplyProjectSettings

Description
Specifies whether the project settings are applied from the "HMI alarms" editor.   

Access in Runtime: Read and write

Syntax
Object.ApplyProjectSettings[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

BOOLEAN
TRUE: The message blocks configured in the "HMI messages" editor are applied to the 
message view with their properties. The message blocks are displayed with these properties 
in the message view.

FALSE: The properties are not applied.

See also
AlarmControl (Page 3947)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)
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AskOperationMotive

Description
Specifies whether the reason for operating this object will be logged. When operating the 
specified object in Runtime, a dialog opens in which the operator enters the reason for the 
operation in text format. 

Access in Runtime: Read and write

Syntax
Object.AskOperationMotive[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField", "SymbolicIOField" or 
"WindowSlider".

BOOLEAN
Optional TRUE, if the reason for operating this object will be logged.

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

WindowSlider (Page 4139)

Listbox (Page 4027)

Assignments

Description
A list which contains the assignments between the output value and the output text actually to 
be output. The assignments are dependent on the set list type. You determine the list type 
with the ListType property.

Access in Runtime: Read

Syntax
Object.Assignments

Object
Required A "ScreenItem" object with the format "SymbolicIOField".
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See also
SymbolicIOField (Page 4093)

AssumeOnExit

Description
Specifies whether the entered text is applied after leaving the input field, e.g. with the <TAB> 
key or a mouseclick.   

Access in Runtime: Read and write

Syntax
Object.AssumeOnExit

Object
Required An object of the "ScreenItem" type with the format "IOField", "SymbolicIOField".

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

AssumeOnFull

Description
Specifies whether the input field is left automatically after a complete input (the specified 
number of characters was entered) and the input is applied.   

Access in Runtime: Read and write

Syntax
Object.AssumeOnFull[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "IOField", "SymbolicIOField".

BOOLEAN
TRUE: is applied.

FALSE: is not applied.
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See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

Authorization 

Description
Specifies the operating rights of the selected object in Runtime.   

Access in Runtime: Read and write

Syntax
Object.Authorization[=HMIRTAuthorization]

Object
Required An object of the "ScreenItem" type with the format "Line", "Polyline", "Ellipse", 
"Circle", "EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", 
"Polygon", "TextField", IOField", "SymbolicIOField", "DateTimeField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "UserArchiveControl", 
"StatusForce", "Slider", "SymbolLibrary", "OnlineTrendControl", "AlarmControl", "UserView", 
"Checkbox", "OptionGroup", "WindowSlider", "OleView", "Connector" oder "SoftKey".

HMIRTAuthorization
Optional A value or a constant that establishes the operating rights of the specified object in 
Runtime.
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Slider (Page 4082)

SymbolLibrary (Page 4098)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

Group (Page 4017)

UserView  (Page 4137)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

ProtectedAreaName (Page 4064)

RangeLabelView (Page 4065)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

AlarmView (Page 3958)

DateTimeField (Page 3989)

RecipeView (Page 4068)

TrendView (Page 4118)

SystemDiagnoseWindow (Page 4103)

SystemDiagnoseView (Page 4100)
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AutoCompleteColumns

Description
Adds empty columns if the Control width is greater than the width of columns configured.   

Access in Runtime: Read and write

Syntax
Object.AutoCompleteColumns[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: The empty columns are displayed.

FALSE: The empty columns are not displayed.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AutoCompleteRows

Description
Enables the insertion of empty rows if the Control length is greater than the number of rows 
configured.   

Access in Runtime: Read and write

Syntax
Object.AutoCompleteRows[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: The empty rows are displayed.
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FALSE: The empty rows are not displayed.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AutoScroll

Description
Specifies how the alarm view behaves when new alarms appear. 

The specific choice of alarm lines is only possible if "AutoScroll" is not enabled. 

The "AutoScroll" property is disabled if the "MsgCtrlFlag" = "-1" attribute is set. The most up-
to-date alarm is then shown at the top of the alarm view. 

Access in Runtime: Read and write

Syntax
Object.AutoScroll[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmView".

BOOLEAN
Optional TRUE, if a new alarm is appended to and chosen from the list shown in the alarm 
window. If necessary, the visible area of the alarm window can be moved. 

FALSE, if a new alarm is not selected. The visible area of the alarm window is not altered.

See also
AlarmControl (Page 3947)

AutoSelectionColors

Description
Enables the display of default system colors as selection color for cells and rows.   

Access in Runtime: Read and write
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Syntax
Object.AutoSelectionColors[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: The system color is used.

FALSE: The customized color is used.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

AutoSelectionRectColor

Description
Defines a system color for the selection border.   

Access in Runtime: Read and write

Syntax
Object.AutoSelectionRectColors [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: The system color is used.

FALSE: The customized color is used.
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

Average

Description
Specifies whether a mean value is shown from the last 15 values.   

Access in Runtime: Read and write

Syntax
Object.Average[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if a mean value is shown from the last 15 values.

Axe property 

Description
Defines or returns the position of the 3D bar in the coordinate system. Value range from 0 to 
2.

0: The 3D-bar is displayed on the X-axis.

1: The 3D-bar is displayed on the Y-axis.

2: The 3D-bar is displayed on the Z-axis.

AxisSection

Description
Defines or returns the distance between two long axis sections. The information on the distance 
is given in scale units and is dependent on the minimum and maximum values configured.
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Properties B

BackBorderWidth

Description
Defines or returns the width of the 3D border in pixels. The value for the width is dependent 
on the size of the object.

BackColor

Description
Specifies the background color of the selected object.   

Access in Runtime: Read and write

Syntax
Object.BackColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "Line", "Polyline", "Ellipse", 
"Circle", "EllipseSegment", "CircleSegment", "EllpticalArc", "CircularArc", "Rectangle", 
"Polygon", "TextField", "IOField", "SymbolicIOField", "DateTimeField", "Button", 
"Roundbutton", "Switch", "GraphicIOField", "GraphicView", "Bar", "UserArchivControl", 
"StatusForce", "Gauge", "Slider", "SymbolLibrary", "RulerTrendControl", 
"OnlineTrendControl", "FunctionTrendControl", "OnlineTableControl", "AlarmControl", 
"UserView", "Checkbox", "OptionGroup", "WindowSlider", "Connector", "Group" or an object 
of the "Screen" type.

Color
Optional A value or a constant that specifies the background color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

The background color is not visible if the "BorderStyle" property has the value "0".
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

Group (Page 4017)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)
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BackColor

Description
Determines the background color of the given object.   

Access during runtime: Read and Write

Syntax
Object.BackColor  [= Color]

Object
Required An object of type "ScreenItem" with the characteristic "Line", "Polyline", "Ellipse", 
"Circle", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", "Switch", 
"GraphicIOField", "GraphicView", "Bar", "RecipeView", "StatusForce", "Gauge", "Slider", 
"SymbolLibrary", "TrendView", "MessageView" or "UserView" or an object of type "Screen".

Color
Optional A value or constant which determines the background color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

The background color is not visible if the "BorderStyle" property has the value of "0."

See also
AlarmView (Page 3958)

RecipeView (Page 4068)

TrendView (Page 4118)

StatusForce (Page 4087)

Group (Page 4017)

UserView  (Page 4137)

DateTimeField (Page 3989)

ProjectName (Page 4062)

BackColor2

Description
Defines or returns the bar color for the display of the current value. LONG write-read access.
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BackColor3 property 

Description
Defines or returns the color of the bar background. LONG write-read access.

BackColorBottom

Description
Specifies the color for the lower / right part of the Sliders. 

Access in Runtime: Read and write

Syntax
Object.BackColorBottom[=Color]

Object
Required A "ScreenItem" object with the format "WindowSlider".

Color
Optional A value or a constant that specifies the color for the lower / right part of the Sliders.

See also
WindowSlider (Page 4139)

BackColorTop

Description
Specifies the color for the upper / left part of the Sliders. 

Access in Runtime: Read and write

Syntax
Object.BackColorTop[=Color]

Object
Required A "ScreenItem" object with the format "WindowSlider".

Color
Optional A value or a constant that specifies the color for the upper / left part of the Sliders.
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See also
WindowSlider (Page 4139)

BackFillStyle

Description
Specifies the fill style of the selected object. 

Access in Runtime: Read and write

Syntax
Object.BackFillStyle[= THmiFillStyle]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Roundbutton", "GraphicView", "Bar", "Clock", 
"Gauge", "Slider", "SymbolLibrary", "CheckBox", "OptionGroup" or "WindowSlider".

THmiFillStyle
Optional A value or a constant that specifies the fill style.

hmiFillStyleTransparent (65536): Transparent fill 

hmiFillStyleSolid (0): Object is filled with the specified color

Default setting: Solid
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See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

GraphicView (Page 4014)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Listbox (Page 4027)

BackFillStyle

Description
Determines the fill style of the specified object. 

Access during runtime: Read and Write

Syntax
Object.BackFillStyle [= THmiFillStyle]

Object
Required. An object of the "ScreenItem" type with the characteristic "Ellipse," "Circle", 
"Rectangle" or "Polygon".

THmiFillStyle
Optional. A value or constant which determines the fill style.
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hmiFillStyleTransparent (65536): Transparent fill

hmiFillStyleTransparent (0): Object is filled with the specified color

Default setting: Solid

See also
DateTimeField (Page 3989)

ProjectName (Page 4062)

BackFillStyleReadOnlySpecial

Description
Specifies that the "Background fill style" can only be read. 

Access in Runtime: Read and write

Syntax
Object.BackFillStyleReadOnlySpecial[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the "Background fill style" can only be read. 

See also
IOField (Page 4021)

BackFlashColorOff

Description
Defines or returns the color of the object background for the flash status "Off". LONG write-
read access.

 

 

 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4185



BackFlashColorOn

Description
Defines or returns the color of the object background for the flash status "On". LONG write-
read access.

BackFlashingColorOff

Description
Specifies the color of the background for the flashing status "off". 

Access in Runtime: Read and write

Syntax
Object.BackFlashingColorOff[=Color]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField" or "Bar".

Color
Optional A value or a constant that specifies the color of the background for the flashing status 
"off".

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

BackFlashingColorOn

Description
Specifies the color of the background for the flashing status "on". 

Access in Runtime: Read and write
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Syntax
Object.BackFlashingColorOn[=Color]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField" or "Bar".

Color
Optional A value or a constant that specifies the color of the background for the flashing status 
"on".

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

BackFlashingEnabled

Description
Specifies whether the background of the specified object will flash in Runtime. 

Access in Runtime: Read and write

Syntax
Object.BackFlashingEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField" or "Bar".

BOOLEAN
Optional TRUE, if the background of the specified object is flashing in Runtime.
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See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

BackFlashingRate 

Description
Specifies the flash rate of the background for the specified object. 

Access in Runtime: Read and write

Syntax
Object.BackFlashingRate[=FlashingRate]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField" or "Bar".

FlashingRate
hmiFlashingRateSlow ( 0): The length of the flashing rate is 250 ms.

hmiFlashingRateMedium ( 1): The length of the flashing rate is 500 ms.

hmiFlashingRateFast  ( 2): The length of the flashing rate is 1000 ms.

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)
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Background

Description
TRUE, when the background of the 3D-bar graph object should be visible. BOOLEAN write-
read access.

BarBackColor 

Description
Specifies the color of the bar background for the selected object. 

Access during runtime: Read and write

Syntax
Object.BarBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Bar," or "Slider".

Color
Optional A value or a constant that specifies the color of the bar background.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Bar (Page 3961)

Slider (Page 4082)

BarBackFillStyle

Description
Specifies the fill style for the bar. 

Access in Runtime: Read and write

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4189



Syntax
Object.BarBackFillStyle[=FillStyle]

Object
Required A "ScreenItem" object with the format "Bar".

FillStyle
hmiFillStyleTransparent ( 65536): Transparent fill style

hmiFillStyleSolid ( 0): Solid fill style

hmiFillStyleBackwardDiagonal ( 131075): Diagonal fill style striped towards the top right

hmiFillStyleCross ( 131076): Checked fill style

hmiFillStyleDiagonalCross ( 131077): Diagonal checked fill style

hmiFillStyleForwardDiagonal ( 131074): Diagonal fill style striped towards the top left

hmiFillStyleHorizontal ( 131072): Horizontal striped fill style

hmiFillStyleVertical ( 131073): Vertical striped fill style

hmiFillStylePattern1 ( 196608): Default fill style

hmiFillStylePattern2 ( 196609): Default fill style

hmiFillStylePattern3 ( 196610): Default fill style

hmiFillStylePattern4 ( 196611): Default fill style

hmiFillStylePattern5 ( 196612): Default fill style

hmiFillStylePattern6 ( 196613): Default fill style

hmiFillStylePattern7 ( 196614): Default fill style

hmiFillStylePattern8 ( 196615): Default fill style

hmiFillStylePattern9 ( 196616): Default fill style

hmiFillStylePattern10 ( 196617): Default fill style

hmiFillStylePattern11 ( 196618): Default fill style

hmiFillStylePattern12 ( 196619): Default fill style

hmiFillStylePattern13 ( 196620): Default fill style

hmiFillStylePattern14 ( 196621): Default fill style

hmiFillStylePattern15 ( 196622): Default fill style

hmiFillStylePattern16 ( 196623): Default fill style

hmiFillStylePattern17 ( 196624): Default fill style

hmiFillStylePattern18 ( 196625): Default fill style

hmiFillStylePattern19 ( 196626): Default fill style

hmiFillStylePattern20 ( 196627): Default fill style

hmiFillStylePattern21 ( 196628): Default fill style

hmiFillStylePattern22 ( 196629): Default fill style
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hmiFillStylePattern23 ( 196630): Default fill style

hmiFillStylePattern24 ( 196631): Default fill style

hmiFillStylePattern25 ( 196632): Default fill style

hmiFillStylePattern26 ( 196633): Default fill style

hmiFillStylePattern27 ( 196634): Default fill style

hmiFillStylePattern28 ( 196635): Default fill style

hmiFillStylePattern29 ( 196636): Default fill style

hmiFillStylePattern30 ( 196637): Default fill style

hmiFillStylePattern31 ( 196638): Default fill style

hmiFillStylePattern32 ( 196639): Default fill style

hmiFillStylePattern33 ( 196640): Default fill style

hmiFillStylePattern34 ( 196641): Default fill style

hmiFillStylePattern35 ( 196642): Default fill style

hmiFillStylePattern36 ( 196643): Default fill style

hmiFillStylePattern37 ( 196644): Default fill style

See also
Bar (Page 3961)

BarColor

Description
Specifies the color of the slider in the "Slider" object. 

Access during runtime: Read and Write

Syntax
Object.BarColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Slider".

Color
Optional A value or a constant that specifies the color of the slider.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4191



For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

The range extends from "RangeMin" to the position of the controller.

See also
Slider (Page 4082)

BarDepth

Description
Defines or returns the depth of the bar in pixels.

BarHeight property

Description
Defines or returns the height of the bar in pixels.

BarStartValue

Description
Specifies the value of the zero point of the scale. 

Access in Runtime: Read and write

Syntax
Object.BarStartValue[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the value of the zero point for the scale.

See also
Bar (Page 3961)
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BarWidth

Description
Defines or returns the width of the bar in pixels.

BaseScreenName 

Description
Reads the name of the current root screen or triggers a root screen change by setting a new 
screen name. 

Access in Runtime: Read and write

Syntax
Object.BaseScreenName[= STRING]

Object
Required An "HMIRuntime" object.

STRING
Optional A value or a constant that contains the screen name.

Comments
You can also use the property to establish which screen is currently being displayed.

BaseX property

Description
Defines or returns the horizontal distance of the right bar edge to the left edge of the object 
field in pixels.

BaseY property

Description
Defines or returns the vertical distance of the bottom bar edge to the top edge of the objet field.
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BeginTime(i) 

Description
Specifies the start time of the time range to be shown in the trend view. The property 
"TagProviderType(i)" must have the value -1. 

Access in Runtime: Read and write

Syntax
Object.BeginTime(i)[=Time]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" oder 
"OnlineTableControl".

Time
Optional A value or a constant which determines the start time of the time range to be shown 
in the trend view. 

Comments
The parameter i indicates the number of the trend. 

If "BeginTime(i)" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent an immediate acceptance of the 
change with "FreezeProviderConnections" before changing "BeginTime(i)".

See also
FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

BelowLowerLimitColor

Description
Defines the color of the specified object for the case "Low limit exceeded".   
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See also
SymbolLibrary (Page 4098)

GraphicIOField (Page 4011)

Switch (Page 4089)

SymbolicIOField (Page 4093)

IOField (Page 4021)

BitNumber

Description
Specifies the bit whose status must change to trigger a value change. 

Access in Runtime: Read and write

Syntax
Object.BitNumber[=Int]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Button" or 
"GraphicIOField".

Int
Optional Specifies the bit whose status must change to trigger a value change.

Comments
The tag being used must be of type BYTE, WORD or DWORD. 

See also
SymbolicIOField (Page 4093)

Button (Page 3968)

GraphicIOField (Page 4011)

BlinkColor

Description
Specifies the color in which the "SymbolLibrary" object will flash. 

Access during runtime: Read and Write
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Syntax
Object.BlinkColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "SymbolLibrary".

Color
Optional A value or a constant that specifies the flash color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
SymbolLibrary (Page 4098)

BlinkMode

Description
Sets the type of flash picture for the specified object.   

Access during runtime: Read and write

Syntax
Object.BlinkMode[=SymbolLibBlinkMode]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

SymbolLibBlinkMode
hmiSymbolLibraryFlashingNone ( 0): Flashing is switched off.

hmiSymbolLibraryFlashingInvisible ( 1): The flash picture is invisible.

hmiSymbolLibraryFlashingShaded ( 2): The flash picture is given a colored, shaded surface. 
The color of the surface corresponds to the settings in the property "BlinkColor".

hmiSymbolLibraryFlashingSolid ( 3): The flash picture is given a colored, unshaded surface. 
The color of the surface corresponds to the settings in the property "BlinkColor".

See also
SymbolLibrary (Page 4098)
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BlinkSpeed

Description
Specifies the flash rate. 

Fast - 250: The length of the flashing rate is 250 ms. Medium - 500: The length of the flashing 
rate is 500 ms.

Slow - 1000: The length of the flashing rate is 1000 ms. The default value is medium - 500. 

Access in Runtime: Read and write

Syntax
Object.BlinkSpeed[=FlashingRate]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

FlashingRate
hmiFlashingRateSlow ( 0): The length of the flashing rate is 250 ms.

hmiFlashingRateMedium ( 1): The length of the flashing rate is 500 ms.

hmiFlashingRateFast ( 2): The length of the flashing rate is 1000 ms.

See also
SymbolLibrary (Page 4098)

BorderBackColor

Description
Specifies the background color of the broken border line for the specified object. 

Access in Runtime: Read and write

Syntax
Object.BorderBackColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "Button", "Roundbutton", "GraphicView", "Bar", "Checkbox", 
"OptionGroup" or "WindowSlider".
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Color
Optional A value or a constant that specifies the background color of the broken border line 
for the specified object.

See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

GraphicView (Page 4014)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

DateTimeField (Page 3989)

ProjectName (Page 4062)

BorderBrightColor3D

Description
Specifies the frame color of the following frame parts in case of a 3D display of the specified 
object: 

● External frame parts at the top and bottom

● Internal frame parts at the top and right

Access in Runtime: Read and write

Syntax
Object.BorderBrightColor3D[= Color]
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Object
Required A "ScreenItem" object with the formats "Button", "Roundbutton" or "Slider".

Color
Optional A value or a constant that specifies the frame color. Default setting is white.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Button (Page 3968)

Slider (Page 4082)

BorderShadeColor3D (Page 4212)

BorderBrightColor3D

Description
Determines the frame color of the following frame parts in the 3D display of the given object: 

● Outer frame parts above and below

● Inner frame parts below and right

Access during runtime: Read and Write

Syntax
Object.BorderBrightColor3D [= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Slider".

Color
Optional A value or constant which determines the frame color. Default setting is white.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.
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BorderColor

Description
Specifies the line color of the specified object. 

Access in Runtime: Read and write

Syntax
Object.BorderColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Roundbutton", "Switch", "GraphicView", 
"GraphicIOField", "Bar", "Checkbox", "OptionGroup" or "WindowSlider".

Color
Optional A value or a constant that specifies the line color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.
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See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

AlarmControl (Page 3947)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

BorderColor

Description
Specifies the line color of the selected object.     

Access during runtime: Read and Write

Syntax
Object.BorderColor [= Color]
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Object
Necessary. An object of the "ScreenItem" type with the characteristics "Ellipse", "Circle", 
"Rectangle", "Polygon", "TextField", "IOField" or "SymbolicIOField".

Color
Optional A value or constant which determines the line color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

Used for the following object types:
Rectangle

 

See also
DateTimeField (Page 3989)

ProjectName (Page 4062)

BorderColorBottom

Description
Defines or returns the border color for the bottom/right part of the object. LONG write-read 
access.

BorderColorTop

Description
Defines or returns the border color for the top/left part of the object. LONG write-read access.

BorderEnabled

Description
TRUE, when the window is displayed with borders in Runtime. Read only access.
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See also
ScreenWindow (Page 4078)

ScriptDiagnostics (Page 4080)

BorderEndStyle

Description
Specifies the type of line-end shapes for the specified object. 

Access in Runtime: Read and write

Syntax
Object.BorderEndStyle[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline" or "Connector".

Int
Optional A value or a constant that specifies the type of line-end shapes for the specified object.

See also
Line (Page 4025)

Polyline (Page 4060)

Connector (Page 3986)

BorderFlashColorOff

Description
Defines or returns the color of the object lines for the flashing status "Off". LONG write-read 
access.

BorderFlashColorOn

Description
Defines or returns the color of the object lines for the flashing status "On". LONG write-read 
access.
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BorderFlashingColorOff

Description
Specifies the color of the border line for the selected object for the flashing status "off". 

Access in Runtime: Read and write

Syntax
Object.BorderFlashingColorOff[=Color]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Kreis", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "Checkbox", "OptionGroup" 
or "WindowSlider".

Color
Optional A value or a constant that specifies the color of the border line of the selected object 
for the flashing status "off".

See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)
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BorderFlashingColorOn

Description
Specifies the color of the border line for the selected object for the flashing status "on". 

Access in Runtime: Read and write

Syntax
Object.BorderFlashingColorOn[=Color]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "Checkbox", "OptionGroup" 
or "WindowSlider".

Color
Optional A value or a constant that specifies the color of the border line of the selected object 
for the flashing status "on".

See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)
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BorderFlashingEnable

Description
Specifies whether the border line of the selected object will flash in runtime. 

Access in Runtime: Read and write

Syntax
Object.BorderFlashingEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "Checkbox", "OptionGroup" 
or "WindowSlider".

BOOLEAN
Optional TRUE, if the border line of the object is flashing.

See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

RoundButton (Page 4074)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4206 System Manual, 07/2013,  



BorderFlashingRate

Description
Specifies the flash rate of the border line for the selected object. 

Access in Runtime: Read and write

Syntax
Object.BorderFlashingRate[=FlashingRate]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "Checkbox", "OptionGroup" 
or "WindowSlider".

FlashingRate
hmiFlashingRateSlow  ( 0): The length of the flashing rate is 250 ms.

hmiFlashingRateMedium  ( 1): The length of the flashing rate is 500 ms.

hmiFlashingRateFast ( 2): The length of the flashing rate is 1000 ms.

See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)
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BorderInnerStyle3D

Description
Specifies the display of the internal part of the object border. 

Access in Runtime: Read and write

Syntax
Object.BorderInnerStyle3D[=GaugeBorder3DStyle]

Object
Required A "ScreenItem" object with the formats "Gauge" or "Slider".

GaugeBorder3DStyle
hmiGaugeBorder3DStyleNone ( 0): There is no internal part of the object border.

hmiGaugeBorder3DStyleRecessed ( 1): The object border is shown in relief.

hmiGaugeBorder3DStyleRaised ( 2): The object border is shown raised.

hmiGaugeBorder3DStyleGray ( 3): The object border has a uniform gray border.

hmiGaugeBorder3DStyleColored ( 4): The object border has a uniform colored border. The 
border color corresponds to the background color.

See also
Gauge (Page 4008)

Slider (Page 4082)

BorderInnerWidth3D 

Description
Specifies the width of the inner border for the 3D presentation of the selected object. 

Access in Runtime: Read and write

Syntax
Object.BorderInnerWidth3D[= LONG]

Object
Required A "ScreenItem" object with the format "Slider".

LONG
Optional A value or a constant that specifies the width in pixels of the inner border.
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See also
Slider (Page 4082)

BorderOuterStyle3D

Description
Specifies the display of the external part of the object border. 

Access in Runtime: Read and write

Syntax
Object.BorderOuterStyle3D[=GaugeBorder3DStyle]

Object
Required A "ScreenItem" object with the formats "Gauge" or "Slider".

GaugeBorder3DStyle
hmiGaugeBorder3DStyleNone ( 0): There is no internal part of the object border.

hmiGaugeBorder3DStyleRecessed ( 1): The object border is shown in relief.

hmiGaugeBorder3DStyleRaised ( 2): The object border is shown raised.

hmiGaugeBorder3DStyleGray ( 3): The object border has a uniform gray border.

hmiGaugeBorder3DStyleColored ( 4): The object border has a uniform colored border. The 
border color corresponds to the background color.

See also
Gauge (Page 4008)

Slider (Page 4082)

BorderOuterWidth3D 

Description
Specifies the width of the outer border for the 3D presentation of the selected object. 

Access in Runtime: Read and write

Syntax
Object.BorderOuterWidth3D[= LONG]

Object
Required A "ScreenItem" object with the format "Slider".
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LONG
Optional A value or a constant that specifies the width in pixels of the outer border.

See also
Slider (Page 4082)

BorderShadeColor3D

Description
Specifies the frame color of the following frame parts in case of a 3D display of the specified 
object: 

● Internal frame parts at the top and bottom

● External frame parts at the bottom and right

Access in Runtime: Read and write

Syntax
Object.BorderShadeColor3D[= Color]

Object
Required A "ScreenItem" object with the formats "Button", "Roundbutton" or "Slider".

Color
Optional A value or a constant that specifies the color of the shading. Default setting is

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Button (Page 3968)

Slider (Page 4082)
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BorderShadeColor3D

Description
Determines the frame color of the following frame parts in the 3D display of the given object: 

● Inner frame parts above and below

● Outer frame parts below and right

Access during runtime: Read and Write

Syntax
Object.BorderShadeColor3D [= Color]

Object
Required. An object of the "ScreenItem" type with the characteristic "Slider."

Color
Optional. A value or constant which determines the shade color. Default setting is

Remarks
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the corresponding decimal values (value range from 0 to 255) for each of the 
three RGB values. For example, the color "red" is represented as follows: RGB(255, 0, 0). 
Furthermore, you can use the VBS color constants such as vbRedor vbGreen.

BorderStyle

Description
Specifies the type of border lines for the specified object. 

Access in Runtime: Read-only

Syntax
Object.BorderStyle[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Roundbutton", "GraphicView", 
"GraphicIOField", "Bar", "Checkbox", "OptionGroup", "WindowSlider", "Connector", 
"PrintRecipe" or "PrintMessage".
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Int
Optional A value or a constant that specifies the type of border lines for the specified object. 

0 = filled line

1 = broken line

2 = dotted line

3 = dashed and dotted line

4 = dash - dot - dot line

See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

MultiLineEdit (Page 4032)

Listbox (Page 4027)
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BorderStyle3D 

Description
Specifies whether the selected object has a 3D border shadow.

     

Access during runtime: Read and write

Syntax
Object.BorderStyle3D[= BOOLEAN]

Object
Necessary. A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch", "GraphicView", "GraphicIOField" or "Bar".

BOOLEAN
Optional TRUE, if the object has a 3D border shadow.

Used for the following object types:
Auto-Hotspot

 

 

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

BorderStyle3D

Description
Determines whether the given object has 3D border shading.

Access during runtime: Read and Write
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Syntax
Object.BorderStyle3D [= BOOLEAN]

Object
Required. An object of the type "ScreenItem" with the characteristic "TextField", "IOField", 
"SymbolicIOField", "Button", "Switch", "GraphicView", "GraphicIOField" or "Bar".

BOOLEAN
Optional. TRUE, if the object has 3D border shading.

See also
DateTimeField (Page 3989)

BorderWidth

Description
Specifies the line thickness of the selected object.     

Access during runtime: Read and write

Syntax
Object.BorderWidth[= LONG]

Object
Necessary. An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", 
"Gauge", "Slider", "Checkbox", "OptionGroup" or "WindowSlider".

LONG
Optional A value or a constant that specifies the line weight in pixels.

Used for the following object types:
Rectangle
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See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Gauge (Page 4008)

Slider (Page 4082)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

AlarmControl (Page 3947)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

BorderWidth

Description
Determines the LineWidth of the given object. 

Access during runtime: Read and Write
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Syntax
Object.BorderWidth [= LONG]

Object
Required. An object of the type "ScreenItem" with the characteristic "Ellipse", "Circle", "Gauge", 
"Rectangle", "Polygon" or "TextField".

LONG
Optional. A value or constant which determines the line width in pixels.

See also
ProjectName (Page 4062)

BorderWidth3D 

Description
Specifies the width of the border for the 3D representation of the selected object. 

Access in Runtime: Read and write

Syntax
Object.BorderWidth3D [= LONG]

Object
Required A "ScreenItem" object with the format "Roundbutton".

LONG
Optional A value or constant which determines the width of the inner border in pixels.

See also
Switch (Page 4089)

Gauge (Page 4008)

RoundButton (Page 4074)

BottomConnectedConnectionPointIndex

Description
Specifies or sets the index number of the bottom connecting point.

LONG write-read access.
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BottomConnectedObjectName

Description
Specifies or sets the object name of the object which is docked on at the bottom connecting 
point.

LONG write-read access.

BoxAlignment

Description
TRUE, when the fields are arranged aligned to the right. BOOLEAN write-read access. 

BoxCount

Description
Defines or returns the number of fields. Value range from 0 to 31.

BoxType

Description
Defines or returns the field type. Value range from 0 to 2:

● 0: Edition

● 1: Input

● 2: I/O field

Button1Width

Description
Defines or returns the width of the Button 1 in pixels. 
When the SameSize property is set to TRUE, all the buttons are specified the same width.

Button2Width

Description
Defines or returns the width of the Button 2 in pixels. 
When the SameSize property is set to TRUE, all the buttons are specified the same width.
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Button3Width

Description
Defines or returns the width of the Button 3 in pixels. 
When the SameSize property is set to TRUE, all the buttons are specified the same width.

Button4Width

Description
Defines or returns the width of the Button 4 in pixels. 
When the SameSize property is set to TRUE, all the buttons are specified the same width.

ButtonColor

Description
Defines or returns the color of the slider. LONG write-read access.

ButtonCommand 

Description
Specifies the display in the message view. 

Access in Runtime: Read and write

Syntax
Object.ButtonCommand[=Long]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Long
Optional A value or a constant which specifies the display in the message view.

0x00000001; 1; alarm list· 

0x00000002; 2; historical alarm list·(short-term) 

0x00000004; 4; historical alarm list·(long-term) 

0x00200000; 2097152; lock list· 

0x00000008; 8; central annunciator acknowledgement· 

0x00000010; 16; single acknowledgement· 
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0x00000020; 32; group acknowledgement· 

0x00000040; 64; Autoscroll· 

0x00000080; 128; selection dialog· 

0x00000100; 256; block dialog· 

0x00000200; 512; print alarm report· 

0x00000800; 2048; emergency acknowledgement· 

0x00001000; 4096; first alarm· 

0x00002000; 8192; last alarm· 

0x00004000; 16384; next alarm· 

0x00008000; 32768; previous alarm· 

0x00010000; 65536; Infotext dialog· 

0x00020000; 131072; comment dialog· 

0x00040000; 262144; Loop in interrupt· 

0x00100000; 1048576; print current view· 

0x00400000; 4194304; lock / unlock alarm· 

0x00800000; 8388608; sort dialog· 

0x01000000; 16777216; time base dialog· 

0x02000000; 33554432; hit list

See also
AlarmControl (Page 3947)

Properties C

Caption 

Description
Specifies the text that will be displayed in the title line of the selected object. 

Access in Runtime: Read and write

Syntax
Object.Caption[= STRING]

Object
Required An object of the "ScreenItem" type with the format "Slider", "FunctionTrendControl", 
"OnlineTableControl", "AlarmControl", "ScreenWindow" or "UserArchiveControl".
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STRING
Optional A value or a constant that contains the text that will be shown in the title line.

See also
Slider (Page 4082)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

ScreenWindow (Page 4078)

UserArchiveControl (Page 4130)

SystemDiagnoseWindow (Page 4103)

TrendRulerControl (Page 4110)

Caption

Description
Determines the text which is displayed in the caption line of the given object. 

Access during runtime: Read and Write

Syntax
Object.Caption [= STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "Slider."

STRING
Optional. A value or a constant which contains the text which is displayed in the caption.

CaptionBackColor

Description
Specifies the background color of the title line for the selected object. 

Access in Runtime: Read and write

Syntax
Object.CaptionBackColor[=Color]
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Object
Required A "ScreenItem" object with the format "SymbolicIOField".

Color
Optional A value or a constant that specifies the background color of the title line for the 
selected object.

See also
SymbolicIOField (Page 4093)

CaptionColor

Description
Specifies the color of the text that will be displayed in the title line of the selected object. 

Access in Runtime: Read and write

Syntax
Object.CaptionColor[= Color]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Switch" or "Gauge".

Color
Optional A value or a constant that specifies the text color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
SymbolicIOField (Page 4093)

Switch (Page 4089)

Gauge (Page 4008)
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CaptionColor 

Description
Determines the color of the text which is displayed in the title bar of the given object.   

Access during runtime: Read and Write

Syntax
Object.CaptionColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Switch," or "Gauge".

Color
Optional A value or constant which determines the text color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

CaptionText 

Description
Specifies the text that will be displayed in the title line of the selected object. 

Access in Runtime: Read and write

Syntax
Object.CaptionText[= STRING]

Object
Required A "ScreenItem" object with the formats "Switch" or "Gauge".

STRING
Optional A value or a constant that contains the text that will be shown in the title line.
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See also
Switch (Page 4089)

Gauge (Page 4008)

ScreenWindow (Page 4078)

CaptionTop 

Description
Specifies the distance of the instrument labels to the upper edge of the selected object. You 
can position the instrument labels only in line with the vertical diameter of the scale. The value 
of the attribute refers to the height of the specified object. The height establishes the upper 
edge of the specified object and the lower edge of the lettering. 

Access in Runtime: Read and write

Syntax
Object.CaptionTop[=Double]

Object
Required A "ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the distance of the instrument labels to the upper 
edge of the selected object.

Value range from 0 to 1 

0: The lower edge of the lettering is positioned on the upper limit of the selected object. The 
text is no longer visible as it is positioned outside of the selected object.

1: The lower edge of the lettering is positioned on the lower limit of the selected object.

See also
Gauge (Page 4008)

CellCut

Description
Specifies whether the contents of the cells are abbreviated if the cells are too narrow.   

Access in Runtime: Read and write
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Syntax
Object.CellCut [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE, if the contents are abbreviated.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

CellSpaceBottom

Description
Defines the bottom margin of the table cells.   

Access in Runtime: Read

Syntax
Object.CellSpaceBottom

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)
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CellSpaceLeft

Description
Specifies the cell space left which is used in the table cells.   

Access in Runtime: Read

Syntax
Object.CellSpaceLeft

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

CellSpaceRight

Description
Defines the right indent of the table cells.   

Access in Runtime: Read

Syntax
Object.CellSpaceRight

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl".

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)
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CellSpaceTop

Description
Defines the top margin of the table cells.   

Access in Runtime: Read

Syntax
Object.CellSpaceTop

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl".

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

CenterColor

Description
Specifies the color of the center of the "Gauge" object. 

Access during runtime: Read and Write

Syntax
Object.CenterColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the color of the center.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.
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See also
Gauge (Page 4008)

CenterSize 

Description
Specifies the diameter of the round scale center point. 

Access in Runtime: Read and write

Syntax
Object.CenterSize[=Single]

Object
Required A "ScreenItem" object with the format "Gauge".

Single
Optional A value or a constant that specifies the diameter of the round scale center point. 

Value range from 0.03 to 1 

1: The diameter corresponds to the smaller value of the geometry attribute "Width" or "Height".

See also
Gauge (Page 4008)

CentrePoint

Description
Specifies the position of the center point. 

Access in Runtime: Read and write

Syntax
Object.CentrePoint[=Point]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Point
Optional A value that specifies the position of the center point.
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See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

CentrePointLeft

Description
Specifies the horizontal distance in pixels of the center point from the left edge of the screen.  

Access in Runtime: Read and write

Syntax
Object.CentrePointLeft[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value that specifies the horizontal distance in pixels of the center point from the left 
edge of the screen. 

See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

CentrePointTop

Description
Specifies the vertical distance in pixels of the center point from the upper edge of the screen.  

Access in Runtime: Read and write

Syntax
Object.CentrePointTop[=Int]
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Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value that specifies the vertical distance in pixels of the center point from the upper 
edge of the screen. 

See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

ChangeMouseCursor 

Description
Specifies how the appearance of the mouse cursor changes in Runtime when it is above the 
icon. 

Access in Runtime: Read and write

Syntax
Object.ChangeMouseCursor[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

BOOLEAN
Optional TRUE, if the mouse cursor has the appearance of an arrow even when it is positioned 
above the icon. 

FALSE, if the mouse cursor has the apparance of a 3D arrow with a green lightning symbol. 
This indicates in Runtime that the respective objective can be operated.

See also
SymbolLibrary (Page 4098)
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CheckAlarmHigh

Description
TRUE, when the "AlarmHigh" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "AlarmHigh", "ColorAlarmHigh" and "TypeAlarmHigh" properties. 

CheckAlarmLow

Description
TRUE, when the "AlarmLow" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "AlarmLow", "ColorAlarmLow" and "TypeAlarmLow" properties.

CheckLimitHigh4

Description
TRUE, when the "Reserve 4" upper limit value should be monitored. BOOLEAN write/read 
access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "LimitHigh4", "ColorLimitHigh4" and "TypeLimitHigh4" properties.

CheckLimitHigh5

Description
TRUE, when the "Reserve 5" upper limit value should be monitored. BOOLEAN write/read 
access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "LimitHigh5", "ColorLimitHigh5" and "TypeLimitHigh5" properties.

CheckLimitLow4

Description
TRUE, when the "Reserve 4" lower limit value should be monitored. BOOLEAN write/read 
access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "LimitLow4", "ColorLimitLow4" and "TypeLimitLow4" properties.
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CheckLimitLow5

Description
TRUE, when the "Reserve 5" lower limit value should be monitored. BOOLEAN write/read 
access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "LimitLow5", "ColorLimitLow5" and "TypeLimitLow5" properties.

CheckMarkAlignment 

Description
Specifies whether the fields are right aligned. 

Access in Runtime: Read and write

Syntax
Object.CheckMarkAlignment[=ContentAlignment]

Object
Required A "ScreenItem" object with the formats "Checkbox" or "OptionGroup".

ContentAlignment
 ( 0): The fields are arranged left aligned.

 ( 1): The fields are arranged right aligned.

See also
OptionGroup (Page 4054)

CheckMarkCount

Description
Specifies the number of fields. 

Access in Runtime: Read and write

Syntax
Object.CheckMarkCount[=Int]

Object
Required A "ScreenItem" object with the formats "Checkbox" or "OptionGroup".
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Int
Optional A value or a constant that specifies the number of fields. Value range from 0 to 31

See also
OptionGroup (Page 4054)

CheckToleranceHigh

Description
TRUE, when the "ToleranceHigh" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "ToleranceHigh", "ColorToleranceHigh" and "TypeToleranceHigh" properties. 

CheckToleranceLow

Description
TRUE, when the "ToleranceLow" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "ToleranceLow", "ColorToleranceLow" and "TypeToleranceLow" properties.

CheckWarningHigh

Description
TRUE, when the "WarningHigh" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "WarningHigh", "ColorWarningHigh" and "TypeWarningHigh" properties.

CheckWarningLow

Description
TRUE, when the "WarningLow" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "WarningLow", "ColorWarningLow" and "TypeWarningLow" properties.

ClearOnError 

Description
Specifies whether an invalid input in this object will be deleted automatically. 
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Access in Runtime: Read and write

Syntax
Object.ClearOnError[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if an invalid input in this object will be deleted automatically.

See also
IOField (Page 4021)

ClearOnFocus

Description
Specifies whether the field entry will be deleted as soon as the I/O field is activated. 

Access in Runtime: Read and write

Syntax
Object.ClearOnFocus[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the field entry is deleted as soon as the I/O field is activated.

See also
IOField (Page 4021)

ClearOnNew

Description
TRUE, when the field entry is deleted as soon as the I/O field has the focus. BOOLEAN write-
read access.
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Closable

Description
Specifies whether the window can be closed in Runtime. 

Access in Runtime: Read and write

Syntax
Object.Closable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the window can be closed in Runtime.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

SystemDiagnoseWindow (Page 4103)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

CloseButton

Description
TRUE, when the window is provided with a "Close" button. Read only access.

Color

Description
Specifies the line color of the specified object. 

Access in Runtime: Read and write

Syntax
Object.Color[= Color]
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Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "EllipticalArc" or 
"CircularArc".

Color
Optional A value or a constant that specifies the line color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Line (Page 4025)

Polyline (Page 4060)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

TubeArcObject (Page 4121)

TubeDoubleTeeObject (Page 4123)

TubePolyline (Page 4125)

TubeTeeObject (Page 4128)

Color

Description
Determines the line color of the given object. 

Access during runtime: Read and Write

Syntax
Object.Color [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Line," or "Polyline".

Color
Optional A value or constant which determines the line color.
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Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

ColorAlarmHigh

Description
Defines or returns the bar color for the "AlarmHigh" limit value. LONG write/read access.
The "CheckAlarmHigh" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorAlarmLow

Description
Defines or returns the bar color for the "AlarmLow" limit value. LONG write/read access.
The "CheckAlarmLow" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorBottom

Description
Defines or returns the color for the bottom/right stop of the slider object. LONG write-read 
access.

ColorChangeHysteresis

Description
Specifies hysteresis as a percentage of the display value. 

The "ColorChangeHysteresisEnable" property must have the value TRUE so that the 
hysteresis can be calculated. 

Access in Runtime: Read and write

Syntax
Object.ColorChangeHysteresis[=Double]

Object
Required A "ScreenItem" object with the format "Bar".
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Double
Optional A value or a constant that specifies the hysteresis as a percentage of the display 
value.

See also
Bar (Page 3961)

ColorChangeHysteresisEnabled

Description
Determines whether the object will be displayed with a hysteresis. 

Access in Runtime: Read and write

Syntax
Object.ColorChangeHysteresisEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the object will be displayed with a hysteresis.

See also
Bar (Page 3961)

ColorChangeType

Description
TRUE, if the change of color should occur segment by segment in the case of a color change 
(e.g. on reaching a limit value). If set to FALSE, it defines the change of color for the entire 
bar. BOOLEAN write-read access. 

ColorLimitHigh4

Description
Defines or returns the color for the "Reserve 4" upper limit value. LONG write/read access.
The "CheckLimitHigh4" property must have been set to TRUE if the bar color should change 
on reaching the limit value.
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ColorLimitHigh5

Description
Defines or returns the color for the "Reserve 5" upper limit value. LONG write/read access.
The "CheckLimitHigh5" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorLimitLow4

Description
Defines or returns the color for the "Reserve 4" lower limit value. LONG write/read access.
The "CheckLimitLow4" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorLimitLow5

Description
Defines or returns the color for the "Reserve 5" lower limit value. LONG write/read access.
The "CheckLimitLow5" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorToleranceHigh

Description
Defines or returns the color for the "ToleranceHigh" upper limit value. LONG write/read access.
The "CheckToleranceHigh" property must have been set to TRUE if the bar color should 
change on reaching the limit value.

ColorToleranceLow

Description
Defines or returns the color for the "ToleranceLow" lower limit value. LONG write/read access.
The "CheckToleranceLow" property must have been set to TRUE if the bar color should change 
on reaching the limit value.
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ColorTop

Description
Defines or returns the color for the top/left stop of the slider object. LONG write-read access.

ColorWarningHigh

Description
Defines or returns the color for the "WarningHigh" upper limit value. LONG write/read access.
The "CheckWarningHigh" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorWarningLow

Description
Defines or returns the color for the "WarningLow" lower limit value. LONG write/read access.
The "CheckWarningLow" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColumnAlign

Description
Specifies how the selected column is aligned.

The following settings are possible:

Value Description Explanation
0 Left The column selected is displayed left-justified.
1 Centered The column selected is displayed centered.
2 Right The column selected is displayed right-justified.

The attribute can be made dynamic with the name ColumnAlign. The data type is LONG.

ColumnColor(i)

Description
Determines the color of the i column pair. The parameter i indicates the number of the column 
pair.  

Access in Runtime: Read and write
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Syntax
Object.ColumnColor(i)[=Color]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

Color
Optional A value or a constant that specifies the color of the i column pair.

See also
OnlineTableControl (Page 4037)

ColumnDisplayName(i)

Description
Specifies the name for the selected column pair. The parameter i indicates the number of the 
column pair. 

Access in Runtime: Read and write

Syntax
Object.ColumnDisplayName(i)[=String]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

String
Optional A value or a constant that specifies the name for the selected column pair. 

See also
OnlineTableControl (Page 4037)

ColumnResize

Description
Enables changes to the width of columns.   

Access in Runtime: Read and write
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Syntax
Object.ColumnResize[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: You can change the width of the columns.

FALSE: You cannot change the width of the columns.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

ColumnSizingEnable

Description
Specifies whether the width of the columns in the alarm window can be changed. The width 
of the columns can be changed only if the "AutoScroll" property is not enabled. 

Access in Runtime: Read and write

Syntax
Object.ColumnSizingEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE if the width of the columns in the alarm window can be changed. 

See also
AlarmControl (Page 3947)
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ColumnSrollbar

Description
Enables the display of column scroll bars.   

Access in Runtime: Read

Syntax
Object.ColumnScrollbar[=Scrollbar]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

Scrollbar
0 = (No) The column scrollbars are not displayed.

1 = (if required) The column scrollbars are displayed if the space requirement of the control is 
greater in vertical direction than the available display area. 

2 = (always) The column scrollbars are always displayed.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

ColumnTitleAlign

Description
Specifies the type of column title alignment.   

Access in Runtime: Read

Syntax
Object.ColumnTitleAlign[=Align]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".
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Align
0 = The column headers are shown left aligned.

1 = The column headers are shown centered.

2 = The column headers are shown right aligned.

3 = The column headers are aligned as the corresponding content.

See also
AlarmControl (Page 3947)

ColumnTitles

Description
Enables the display of the column header.   

Access in Runtime: Read

Syntax
Object.ColumnTitle[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN

BOOLEAN
TRUE: The column header is displayed.

FALSEThe column header is not displayed.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

ColumnUpdateEnabled(i) 

Description
Specifies whether the selected column pair will be shown statically or dynamically. 
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Access in Runtime: Read and write

Syntax
Object.ColumnUpdateEnabled(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE if the column pair is to be shown statically.

Comments
The "CurrentColumnIndex" property references the column pair that is currently active. 

See also
OnlineTableControl (Page 4037)

Command

Description
Specifies whether there is a forced update of the values displayed in the control.   

Access in Runtime: Read and write

Syntax
Object.Command[=String]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"OnlineTableControl".

String
Optional A value or a constant which specifies whether there is a forced update of the values 
displayed in the control.

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)
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Comment

Description
Reads or sets the Alarm object comment.

CommonTimeAxisColor

Description
Specifies the color of the mutual X axis. 

Access in Runtime: Read and write

Syntax
Object.CommonTimeAxisColor[=Color]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

Color
Optional A value or a constant that specifies the color of the common x axis.

See also
OnlineTrendControl (Page 4045)

ComputerName

Description
Returns the name of the computer on which the alarm object was triggered.

ComputerName (readonly)

ConfigureTimeAxis(i) 

Description
Specifies whether a common time axis is used for all the trends in the trend view.   

Access in Runtime: Read and write

Syntax
Object.ConfigureTimeAxis(i)[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE, if a common axis is used for all the trends in the trend view.

See also
OnlineTrendControl (Page 4045)

ConnectionType

Description
Specifies the type of connector. It is possible to select between two connection types.   

Access in Runtime: Read and write

Syntax
Object.ConnectionType[=ConnectorConnectionType]

Object
Required An object of the "ScreenItem" type with the format "Connector".

ConnectorConnectionType
( 0): Automatic: Both objects are connected by a polyline made up of horizontal and vertical 
parts.

( 1): Single: Both objects are connected by a straight line between the connecting points. The 
fields are arranged right-justified.

See also
SmartClientView (Page 4085)

Connector (Page 3986)

ConnectTrendWindows

Description
Specifies whether the configured trend views are connected. The requirement is that you have 
configured several trend views.     

The connected trend views have the following properties:
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● A common X axis

● A scrollbar

● A ruler

Access in Runtime: Read

Syntax
Object.ConnectTrendWindows[=Boolean]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Boolean
TRUE = All configured trend views are connected.

FALSE = The trend views are displayed separately.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

Context

Description
Reads or sets the alarm object server prefix.

ContinousChange

Description
Specifies whether the value of the "ProcessValue" property will be transferred when the mouse 
button is released or as soon as the slider position changes in Runtime. 

Access in Runtime: Read and write

Syntax
Object.ContinousChange[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Slider".
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BOOLEAN
Optional TRUE, if the value of the property "ProcessValue" will be transferred when the mouse 
button is released or as soon as the slider position changes in Runtime.

See also
Slider (Page 4082)

CornerStyle

Description
Specifies the type of border lines for the specified object.   

Access in Runtime: Read-only

Syntax
Object.ConerStyle[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Roundbutton", "TubePolyLone", 
"GraphicIOField", "Bar", "Checkbox", "OptionGroup", "WindowSlider", "Connector", 
"MultiLineEdit" or "ComboBox".

Int
Optional A value or a constant that specifies the type of border lines for the specified object. 

0 = filled line

1 = broken line

2 = dotted line

3 = dashed and dotted line

4 = dash - dot - dot line
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See also
TubePolyline (Page 4125)

CheckBox (Page 3974)

GraphicIOField (Page 4011)

Bar (Page 3961)

GraphicView (Page 4014)

WindowSlider (Page 4139)

Switch (Page 4089)

Rectangle (Page 4072)

MultiLineEdit (Page 4032)

Line (Page 4025)

Listbox (Page 4027)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Connector (Page 3986)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Polygon (Page 4057)

Polyline (Page 4060)

RoundButton (Page 4074)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)

Count

Description
Returns the number of elements in the specified list.  

Access in Runtime: Read

Syntax
Object.Count
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Object
Required A "Collection" object.

CountDivisions 

Description
Specifies the number of segments in which the bar will be divided by the large marking lengths 
of the scale. 

Access in Runtime: Read and write

Syntax
Object.CountDivisions[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value or a constant that specifies the number of segments in which the bar will be 
divided by the large marking lengths of the scale. 

0-100: An object can be divided into a maximum of 100 segments 

= 0: The optimum number of segments will be established automatically.

See also
Bar (Page 3961)

CountSubDivisions

Description
Specifies the number of scale marking lengths between two main marking lengths of the "Bar" 
object. 

Access in Runtime: Read and write

Syntax
Object.CountSubDivisions[= LONG]

Object
Required A "ScreenItem" object with the format "Bar".
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LONG
Optional A value or a constant that specifies the number of scale segments.

See also
Bar (Page 3961)

CountValueColumns 

Description
Returns the number of configured trends or column pairs (visible and invisible) of the window. 

Access in Runtime: Read and write

Syntax
Object.CountValueColumns[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

Int
Optional A value or a constant that returns the number of configured trends or column pairs 
(visible and invisible) of the window. 

See also
OnlineTableControl (Page 4037)

CountVisibleItems

Description
Specifies how many lines the selection list will contain. If the number of configured texts is 
greater than this value, then the selection list will have a vertical scroll bar. 

Access in Runtime: Read and write

Syntax
Object.CountVisibleItems[=Int]

Object
Required An object of the "ScreenItem" type with the format "SymbolicIOField", "StatusForce", 
"OnlineTrendControl" or "UserArchivControl".
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Int
Optional A value or a constant that specifies how many lines the selection list will contain.

See also
SymbolicIOField (Page 4093)

UserView  (Page 4137)

StatusForce (Page 4087)

Listbox (Page 4027)

TrendView (Page 4118)

CurrentColumnIndex

Description
Specifies which settings can be assigned to a selected column pair. The property is evaluated 
by other properties. Valid values for the index have values from 0 to -1. The 
"CountValueColumns" property contains the number of column pairs that are to be shown. 

Access in Runtime: Read and write

Syntax
Object.CurrentColumnIndex[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

Int
Optional A value or a constant that specifies which settings can be assigned to a particular 
column pair.

Comments
The "NumItems" property contains the number of trends / column pairs to be shown.

See also
OnlineTableControl (Page 4037)

CurrentContext

Description
Returns a character string depending on the use of the function.
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If the function is contained in a screen in the screen window, CurrentContext returns the 
symbolic server name which supplies the screen. Example: "WinCCProject_MyComputer::"

If the function is contained in the main screen, an empty character string is returned. 

Access in Runtime: Read

Syntax
Object.CurrentContext

Object
Required A "HMIRuntime" object.

See also
HMIRuntime  (Page 3922)

CurrentCurveIndex

Description
Specifies the index for the active trends.   

Access in Runtime: Read and write

Syntax
Object.CurrentCurveIndex[=Int]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" or 
"OnlineTrendControl".

Int
Optional A value or a constant that specifies the index of the trends that are currently active.

Comments
The "CurrentCurveIndex" property is evaluated by other properties so that their settings can 
be assigned to a specific trend. Valid values range from 0 to -1. The "CurvesCount" property 
contains the number of trends to be shown.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)
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CursorControl 

Description
Specifies whether the mouse cursor jumps to the next field of the TAB order after leaving the 
field. 

Access in Runtime: Read and write

Syntax
Object.CursorControl[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField" or "SymbolicIOField".

BOOLEAN
Optional. TRUE, if the mouse cursor jumps to the next field of the TAB-order after leaving the 
field.

Comments
For this purpose, the "CursorMode" property must be set to TRUE. 

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

CurveColor(i)

Description
Specifies the color of the selected trend. 

Access in Runtime: Read and write

Syntax
Object.CurveColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Color
Optional A value or a constant that specifies the color of the selected trend.
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Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

CurveLineWidth(i)  

Description
Specifies the line weight of the selected trend. 

Access in Runtime: Read and write

Syntax
Object.CurveLineWidth(i)[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

Int
Optional A value or a constant that specifies the line weight of the selected trend. Value range 
from 0 to 10.

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

CurvesCount

Description
Returns the number of configured trends or column pairs (visible and invisible) of the window. 

Access in Runtime: Read and write

Syntax
Object.CurvesCount[=Int]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Int
Optional A value or a constant that returns the number of configured trends or column pairs 
(visible and invisible) of the window.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

CurveUpdateEnabled(i)

Description
Specifies whether the selected trend will be shown statically or dynamically. 

Access in Runtime: Read and write

Syntax
Object.CurveUpdateEnabled(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE if the trend is to be shown statically.

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)
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Properties D

DangerRangeColor 

Description
Specifies the color of the danger range of the scale of the "Gauge" object. 

The "DangerRangeVisible" property must have the value TRUE so that the danger range is 
displayed.

Access during runtime: Read and write

Syntax
Object.DangerRangeColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the color of the danger range.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Gauge (Page 4008)

DangerRangeVisible (Page 4260)

DangerRangeStart 

Description
Specifies at which scale value the danger range of the "Gauge" object will start. 

The "DangerRangeColor" property must have the value TRUE so that the danger range is 
displayed.

Access in Runtime: Read and write
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Syntax
Object.DangerRangeStart[= DOUBLE]

Object
Required A "ScreenItem" object with the format "Gauge".

DOUBLE
Optional A value or a constant that specifies the scale value for the start of the danger range.

Comments
The range extends from the value "Gefahr" through to the end of the scale.

See also
Gauge (Page 4008)

DangerRangeVisible (Page 4260)

DangerRangeVisible

Description
Specifies whether the danger range in the scale of the "Gauge" object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.DangerRangeVisible[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the danger range will be displayed in the scale.

Comments
Specifies the color of the danger range with the "DangerRangeColor" property.

Specifies the start of the danger range with the "DangerRangeStart" property.

See also
Gauge (Page 4008)
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DataFormat

Description
Returns the data type of the I/O field object. Read only access.

Value range from 0 to 3.

0: Binary

1: Decimal

2: String 

3: Hexadecimal

See also
IOField (Page 4021)

DataIndex(i) 

Description
Returns the current index for the data of the current trend. 

Access in Runtime: Read and write

Syntax
Object.DataIndex(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the current index of the data for the current trend.

See also
FunctionTrendControl (Page 4004)

DataLogs

Description
Returns an object of type "DataLogs".

Access in Runtime: Read
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Syntax
Object.DataLogs

Object
Required A "Logging" object. 

See also
Logging (Page 3927)

DataLogTag

Description
Specifies which tag is linked with the selected trend.

Access in Runtime: Read and write

Syntax
Object.DataLogTag[=HmiLoggingTag]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"OnlineTableControl".

HmiLoggingTag
Optional A value or a constant that specifies which tags are linked to the selected trend.

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

DataSet 

Description
Returns an object of type "DataSet". 

Access in Runtime: Read
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Syntax
Object.DataSet

Object
Required A "Screen" object. 

See also
HMIRuntime  (Page 3922)

Screen (Page 3930)

DataX(i)

Description
Inserts one single data record and must be set prior to the call of "InsertData(i)". 

Access in Runtime: Read and write

Syntax
Object.DataX(i)[=object]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

object
Optional A value or a constant that inserts one single data record.

See also
FunctionTrendControl (Page 4004)

DataXY(i) 

Description
Inserts several data records as Array with value pairs and must be set before calling 
"InsertData(i)". 

The data in the Array are applied if "DataX(i)" is a VT_EMPTY type. Otherwise, the single value 
pair resulting from "DataX(i)" and "DataY(i)" will be used in the attribute "InsertData(i)". 

Access in Runtime: Read and write
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Syntax
Object.DataXY(i)[=object]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

object
Optional A value or a constant which inserts several data records as Array with value pairs.

See also
FunctionTrendControl (Page 4004)

DataY(i)

Description
Inserts one single data record and must be set prior to the call of "InsertData(i)". 

Access in Runtime: Read and write

Syntax
Object.DataY(i)[=Double]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Double
Optional A value or a constant that inserts one single data record.

See also
FunctionTrendControl (Page 4004)

DeleteData(i) 

Description
Specifies which data from the data buffer of the active trend will be deleted. 

TRUE: 

Access in Runtime: Read and write
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Syntax
Object.DeleteData(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if all the data of the trend is to be deleted. 

FALSE, if the value pair at position "DataIndex(i)" is to be deleted.

See also
FunctionTrendControl (Page 4004)

DeleteEnable

Description
Specifies whether the recipe view can be cleared in Runtime.   

Access in Runtime: Read and write

Syntax
Object.DeleteEnable[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the recipe view can be cleared in Runtime.

DialColor 

Description
Specifies the color of the dial for the selected object. 

Access during runtime: Read and Write

Syntax
Object.DialColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Clock," or "Gauge".
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Color
Optional A value or a constant that specifies the color of the dial.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Gauge (Page 4008)

DialFillStyle

Description
Specifies the type of background of the selected object. 

Access in Runtime: Read and write

Syntax
Object.DialFillStyle[=GaugeBackStyle]

Object
Required A "ScreenItem" object with the format "Gauge".

GaugeBackStyle
hmiGaugeBackStyleSolid ( 0): The rectangular background of the display is filled with the 
specified border color. The scale is filled with the specified background color.

solid backstyle.

hmiGaugeBackStyleFrameTransparent ( 1): The rectangular background of the Gauge is 
transparent. The scale is filled with the specified background color. As a result, a circular 
display can be shown.

Identifies only frame is transparent.

hmiGaugeBackStyleTransparent ( 2): The rectangular background and the scale are 
transparent.

Identifies a transparent backstyle.

See also
Gauge (Page 4008)
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DialSize 

Description
Specifies the diameter of the scale in relation to the smaller value of the geometry attributes 
"Width" and "Height". 

Access in Runtime: Read and write

Syntax
Object.DialSize[=Single]

Object
Required A "ScreenItem" object with the format "Gauge".

Single
Optional A value or a constant that establishes the diameter of the scale in relation to the 
smaller value of the geometry attributes "Width" and "Height".

See also
Gauge (Page 4008)

Direction

Description
Defines or returns the bar direction or the position of the slider object.   

Access in Runtime: Read and write

Syntax
Object.Direction [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "Bar" or "Slider".

BOOLEAN
0 = top

1 = bottom

2 = left

3 = right
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DisplayName(i) 

Description
Specifies the name for the selected trend.

Access in Runtime: Read and write

Syntax
Object.DisplayName(i)[=String]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

String
Optional A value or a constant that specifies the name for the selected trend. 

Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 4004)

DisplayOptions

Description
Specifies which messages are displayed.   

Access in Runtime: Read

Syntax
Object.DisplayOptions [=DisplayOption]

Object
Required A "ScreenItem" object with the format "AlarmControl".

DisplayOption
0: All messages

1: Only displayed messages

2: Only hidden messages
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See also
AlarmControl (Page 3947)

DoubleClickAction

Description
Sepcifies the action to be executed in Runtime by double-clicking on a message line.   

Access in Runtime: Read

Syntax
Object.DoubleClickAction[=ClickAction]

Object
Required A "ScreenItem" object with the format "AlarmControl".

ClickAction

Value Description Description
0 none No action.
1 Loop-in-alarm Calls the "Loop-in-alarm" function.
2 Open comments dialog Calls the "Comments dialog" button function.
3 Open Infotext dialog Calls the "Infotext dialog" button function.
4 Column-dependent The action is determined by the column in which you 

double-clicked.

See also
AlarmControl (Page 3947)

DrawAlwaysInsideFrame

Description
Specifies whether the border line of the selected object should be illustrated with a line weight 
greater than 1 within the border or symmetrically to the border. 

Access in Runtime: Read and write

Syntax
Object.DrawAlwaysInsideFrame[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "Rectangle".

BOOLEAN
Option TRUE, if the border line of the specified object will be illustrated with a line weight 
greater than 1 within the border.

See also
Rectangle (Page 4072)

DrawEnhancedHTMLBrowser

Description
Specifies the style of the HTML-Browsers. 

Access in Runtime: Read and write

Syntax
Object.DrawEnhancedHTMLBrowser[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "HTMLBrowser".

BOOLEAN
Optional TRUE, if an extended HTML-Browser will be displayed.

See also
HTMLBrowser (Page 4019)

DrawInsideFrame

Description
Specifies whether the border line of the selected object should be illustrated with a line weight 
greater than 1 within the border or symmetrically to the border. 

Access in Runtime: Read and write

Syntax
Object.DrawInsideFrame[=BOOLEAN]
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Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "GraphicView", "GraphicIOField", "Bar", 
"CheckBox", "OptionGroup", "WindowSlider" or "Connector".

BOOLEAN
Optional TRUE, if the border line of the specified object will be illustrated with a line weight 
greater than 1 within the border.

See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

RoundButton (Page 4074)
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DrawStylishButton

Description
Specifies whether the button will be displayed in the general Windows style. 

Access in Runtime: Read and write

Syntax
Object.DrawStylishButton[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Button".

BOOLEAN
Optional TRUE, if the button will be displayed in the general Windows style.

See also
Button (Page 3968)

Drive

Description
Specifies the characters of the drive that is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Drive[=String]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

String
Optional A value or a constant that specifies the characters of the drive that is to be monitored.

See also
DiskSpaceView (Page 3991)
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Properties E-F

EdgeStyle

Description
Determines the line style of the given object. 

Access during runtime: Read and Write

Syntax
Object.EdgeStyle [= THmiLineStyle]

Object
Required. An object of the type "ScreenItem" with the characteristic "Ellipse", "Circle", 
"Rectangle", "Polygon", "TextField" or "IOField".

THmiLineStyle
Optional. A value or constant that defines the line style. Value range from -1 to 4.

The objects "Ellipse", "Circle", "Rectangle" and "Polygon" support the line style:

● hmiLineStyleSolid (0): solid line

● hmiLineStyleDash (1): dashed line

● hmiLineStyleDot (2): dotted line

● hmiLineStyleDashDot (3): dash dot line

● hmiLineStyleDashDotDot (4): dash dot dot line

The objects "TextField" and "IOField" support only the line style:

● hmiLineStyleNone (-1): no line

● hmiLineStyleSolid (0): solid line

Default setting: hmiLineStyleSolid

See also
GraphicIOField (Page 4011)

Switch (Page 4089)

CircleSegment (Page 3979)

DateTimeField (Page 3989)

Ellipse (Page 3993)
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EdgeStyle

Description
Specifies the line style of the selected object. 

Access in Runtime: Read and write

Syntax
Object.EdgeStyle[= THmiLineStyle]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField" "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Roundbutton", "Switch", "GraphicView", 
"GraphicIOField", "Bar", "Checkbox", "OptionGroup" or "WindowSlider".

THmiLineStyle
Optional A value or a constant that specifies the line style. Value range from -1 to 4.

The objects "Ellipse", "Circle", "Rectangle" and "Polygon" support the line styles:

● hmiLineStyleSolid (0): solid line

● hmiLineStyleDash (1): broken line

● hmiLineStyleDot (2): dotted line

● hmiLineStyleDashDot (3): dash - dot line

● hmiLineStyleDashDotDot (4): dash - dot - dot line

The objects "TextField" and "IOField" support only the line styles:

● hmiLineStyleNone (-1): no line

● hmiLineStyleSolid (0): solid line

Default setting: hmiLineStyleSolid
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See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

RoundButton (Page 4074)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

ProjectName (Page 4062)

Editable(i)

Description
Specifies whether a column pair can be edited. The parameter i indicates the number of the 
column pair.   

Access in Runtime: Read and write

Syntax
Object.Editable(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".
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BOOLEAN
Optional TRUE, if the column pair can be edited. The column pair is referenced by the 
parameter i.

See also
OnlineTableControl (Page 4037)

EditAtOnce 

Description
TRUE, if accessing the field with the <TAB> key permits input immediately and without further 
action. BOOLEAN write-read access.

EditEnabled

Description
Specifies whether edit mode is enabled for a cell, if the property "Editable(i)" has the value 
TRUE. 

Access in Runtime: Read and write

Syntax
Object.EditEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE, if the edit mode is enabled for a cell if the property "Editable(i)" has the value 
TRUE.

See also
OnlineTableControl (Page 4037)

EditOnFocus 

Description
Specifies whether the data input is immediately possible if the input field is selected using the 
<Tab> key. 
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Access in Runtime: Read and write

Syntax
Object.EditOnFocus[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField" or "SymbolicIOField".

BOOLEAN
Optional TRUE, if the data input is immediately possible and the input field has been selected 
using the <Tab> key.

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

Enabled 

Description
Specifies whether the selected object can be operated in Runtime.   

Access in Runtime: Read and write

Syntax
Object.Enabled[= BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "Line", "Polyline", "Ellipse", 
"Circle", "EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", 
"Polygon", "TextField", "IOField", "SymbolicIOField", "DateTimeField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "StatusForce", "Clock", 
"Gauge", "Slider", "SymbolLibrary", "OnlineTableControl", "OnlineTrendControll, 
"FunctionTrendControl", "UserView", "HTMLBrowser", "Checkbox", "OptionGroup", 
"WindowSlider", "OleView", "Connector","DiskSpaceView", "ChannelDiagnose" or 
"UserArchiveControl".

BOOLEAN
Optional TRUE, if the specified object can be operated in Runtime.
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

DiskSpaceView (Page 3991)

ChannelDiagnose (Page 3972)

Group (Page 4017)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

UserArchiveControl (Page 4130)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4276 System Manual, 07/2013,  



Enabled 

Description
Determines whether the given object can be operated in runtime. 

Access during runtime: Read and Write

Syntax
Object.Enabled [= BOOLEAN]

Object
Required. An object of the type "ScreenItem" with the characteristic "IOField", 
"SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", "RecipeView", "StatusForce", 
"Slider", "SymbolLibrary", "TrendView", "MessageView", "UserView" or "BrowserView".

BOOLEAN
Optional. TRUE, if the given object can be operated.

See also
AlarmView (Page 3958)

RecipeView (Page 4068)

TrendView (Page 4118)

SmartClientView (Page 4085)

StatusForce (Page 4087)

BatteryView (Page 3967)

RangeLabelView (Page 4065)

RangeQualityView (Page 4067)

WLanQualityView (Page 4142)

ZoneLabelView (Page 4143)

ZoneQualityView (Page 4144)

SystemDiagnoseWindow (Page 4103)

SystemDiagnoseView (Page 4100)

UserView  (Page 4137)

DateTimeField (Page 3989)
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EnableEdit

Description
Enables editing of the data displayed during runtime.

Access in Runtime: Read and write

Syntax
Object.EnableEdit[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl", 
"UserArchiveControl".

BOOLEAN
TRUE: The data can be changed in Runtime.

FALSE: The data cannot be changed.

See also
UserArchiveControl (Page 4130)

OnlineTableControl (Page 4037)

EndAngle

Description
Specifies the angle at which the end point of the selected object deviates from the zero position 
(0°). 

Access in Runtime: Read and write

Syntax
Object.EndAngle[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value or a constant that specifies the angle at which the end point of the selected 
object deviates from the zero position (0°).
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See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

TubeArcObject (Page 4121)

EndPoint

Description
Specifies the position of the end point. 

Access in Runtime: 

Syntax
Object.EndPoint[=Point]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Point
Optional A value that specifies the position of the end point.

See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

EndPointLeft

Description
Specifies the horizontal distance in pixels of the end point from the left edge of the screen. 

Access in Runtime: Read and write

Syntax
Object.EndPointLeft[=Int]
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Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value that specifies the horizontal distance in pixels of the end point from the left 
edge of the screen.

See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

EndPointTop

Description
Specifies the vertical distance in pixels of the end point from the upper edge of the screen. 

Access in Runtime: Read and write

Syntax
Object.EndPointTop[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value that specifies the vertical distance in pixels of the end point from the upper 
edge of the screen.

See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)
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EndStyle

Description
Specifies how the line-end shapes of the selected object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.EndStyle[= THmiLineEndStyle]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline" or "Connector".

THmiLineEndStyle
Optional A value or a constant that specifies the line-end shapes.

hmiLineEndStyleNone (0): The line has no end symbol.

hmiLineEndStyleFilledArrow (2): The line ends with a filled arrowhead.

See also
Line (Page 4025)

Polyline (Page 4060)

Connector (Page 3986)

EndStyle

Description
Determines how the line end of the given object is displayed. 

Access during runtime: Read and Write

Syntax
Object.EndStyle [= THmiLineEndStyle]

Object
Required. An object of the "ScreenItem" type with the characteristic "Line," or "Polyline".

THmiLineEndStyle
Optional. A value or constant which determines the line end.

hmiLineEndStyleNone (0): The line has no end symbol.

hmiLineEndStyleFilledArrow (2): The line ends with a filled arrow.
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EndTime(i) 

Description
Specifies the end time of the time range to be shown in the trend view. The property 
"TagProviderType(i)" must have the value -1. 

Access in Runtime: Read and write

Syntax
Object.EndTime(i)[=Time]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" or 
"OnlineTabelControl".

Time
Optional A value or a constant that specifies the end time of the time range that is to be shown 
in the trend window.

Comments
The parameter i indicates the number of the trend. 

If "EndTime(i)" is changed, illegal combinations with different attributes for the data connection 
could arise. This means you have to prevent an immediate acceptance of the change with 
"FreezeProviderConnections" before changing "EndTime(i)".

See also
FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

ErrorDescription

Description
Returns one of the following error descriptions in English:

 Output Description
" " OK
"Operation Failed" Execution error
"Variable not found" Tag error
"Server down" Server not available.
"An error occured for one or several tags" Multi Tag Error (Error in one or several tags) 
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To obtain an error description, first of all carry out the Read method. 
 

 Note

If the error occurs when accessing via the TagSet object, evaluate the ErrorDescription 
property for each tag of the TagSet object. 

 

Access in Runtime: Read

Syntax
Object.ErrorDescription

Object
Required A "Tag" object. 

Example
The following example shows the error description for the "Tag1" tag:

 
'VBS72
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objtag.Read
MsgBox objTag.ErrorDescription

 

The following example adds two tags to the TagSet list and outputs the ErrorDescription 
property as Trace:

 
'VBS179
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
HMIRuntime.Trace "ErrorDescription: " & group.ErrorDescription & vbNewLine

The ErrorDescription property of a tag contained in the list may be accessed as follows:

 
HMIRuntime.Trace "ErrorDescription: " & group("Motor1").ErrorDescription & vbNewLine

See also
Tag (Page 3941)

TagSet (list)  (Page 3945)
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Exponent

Description
TRUE, when the display of numbers should be with exponents (e.g."1.00e+000"). BOOLEAN 
write-read access.

ExportDirectoryChangeable

Description
Enables changing of the directory for data export in Runtime.     

Syntax
Object.ExportDirectoryChangeable=[Boolean]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Boolean
TRUE, the directory for the data export can be changed in Runtime.

FALSE, the directory for the data export cannot be changed in Runtime.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportDirectoryname

Description
Defines the directory to which the exported Runtime data is written.     

Access in Runtime: Read and write
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Syntax
Object.ExportDirectoryname[=String]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

String
Optional A value or a constant which specifies the directory.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportFileExtension

Description
Specifies the file extension of the export file. Only the file extension "csv" is supported.     

Syntax
Object.ExportFileExtension

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)
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ExportFilename

Description
Defines the name of the file which is to receive the exported Runtime data.     

Syntax
Object.ExportFilename

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportFilenameChangeable

Description
Enables renaming of the export file in Runtime.     

Syntax
Object.ExportFilenameChangeable=[Boolean]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Boolean
TRUE, , the file name of the export file can be changed in Runtime.

FALSE, , the file name of the export file cannot be changed in Runtime.
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportFormatGuid

Description
Default assignment of the ID number and export provider.     

Syntax
Object.ExportFormatGuid

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

 

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportFormatName

Description
Defines the export file format. Only the "csv" file format is currently available for the export.  
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportParameters

Description
Specifies the parameters of the selected format by means of the properties dialog.     

Access in Runtime: Read and write

Syntax
Object.ExportParameters

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

 

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportSelection

Description
Specifies which runtime data of the control is exported.
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Syntax
Object.ExportSelection=[Boolean]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Boolean

Value Description Explanation
0 all All Runtime data of the control is exported.
1 Selection Selected Runtime data of the control is exported.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportShowDialog

Description
Enables the display of the export dialog during runtime.     

Access in Runtime: Read and write

Syntax
Object.ExportShowDialog [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
Optional TRUE, if the dialog box is shown in Runtime.

.
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ExportXML

ExportXML
Only used internally.

The attribute can be assigned dynamic properties by means of the name ExportXML.

ExtendedOperation

Description
TRUE, when the slider regulator is set at the respective end value (minimum/maximum value). 
This is done by clicking the mouse in an area outside the current regulator setting. BOOLEAN 
write-read access.

ExtendedZoomingEnable 

Description 
Specifies whether the operator can zoom the screen in or out in runtime by turning the mouse 
wheel. 

Access during runtime: Read and write 

Syntax
Object.ExtendedZoomingEnable[=BOOLEAN]

Object
Necessary. A "Screen" object.

BOOLEAN
Optional TRUE, if the operator can zoom the screen in and out in runtime. 
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Example
The following example shows how the extended zoom can be enabled for the NewPDL1 
screen:

 
'VBS155
Dim objScreen
Set objScreen = HMIRuntime.Screens("NewPDL1")
objScreen.ExtendedZoomingEnable = 1

See also
Screen (Page 3930)

ExtraSpaceForLabelDisplay 

Description
Specifies the extra space required for the label. 

Access in Runtime: Read and write

Syntax
Object.ExtraSpaceForLabelDisplay[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value that specifies the extra space required for the label.

See also
Bar (Page 3961)

FieldLengthReadOnlySpecial 

Description
Specifies that the "field length string" field is read-only.     

Access during runtime: Read and write

Syntax
Object.FieldLengthReadOnlySpecial[=BOOLEAN]
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Object
Necessary. A "ScreenItem" object with the format "IOField"".

BOOLEAN
Optional TRUE, if the "field length string" can only be read. 

Used for the following object types:
IOField

 

See also
IOField (Page 4021)

FillColor

Description  
Defines or returns the fill pattern color for the object. 

Access during runtime: Read and write 

Syntax
Object.FillColor[=LONG]

Object
Necessary. An object of the "ScreenItem" type with the format "Line", "Polyline", "Ellipse", 
"Circle", "EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", 
"Polygon", "TextField", "IOField", "SymbolicIOField", "DateTimeField", "Button", 
"Roundbutton", "Switch", "Bar", "StatusForce", "Clock", "Gauge", "Slider", "Checkbox".

Determination of Color Value
The color is displayed in RGB format (Red, Green, Blue). Enter the appropriate decimal value 
for each of the three RGB values.

Example:

RGB(200, 150, 100)

Example
The following example defines the fill color for "ScreenWindow1" to blue:

 
'VBS73
Dim objScreen
Set objScreen = HMIRuntime.Screens("ScreenWindow1")
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objScreen.FillStyle = 131075
objScreen.FillColor = RGB(0, 0, 255)

FillColorMode 

Description
Specifies the type of foreground for the selected object. 

Access in Runtime: Read and write

Syntax
Object.FillColorMode[=SymbolLibAppearance]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

SymbolLibAppearance
hmiSymbolLibraryAppearanceOriginal ( 0): The surface is gray.

hmiSymbolLibraryAppearanceShaded ( 1): The display is shaded.

hmiSymbolLibraryAppearanceSolid ( 2): The display is solid.

hmiSymbolLibraryAppearanceTransparent ( 3): The display is gray.

See also
SymbolLibrary (Page 4098)

Filling

Description
TRUE, when the object can be filled by closed border lines (e.g. representing the fill level of a 
tank). BOOLEAN write-read access. 
The fill level of the object is set by means of the "FillingIndex" property.

FillingIndex

Description
Defines the %age value (related to the height of the object) to which the object with closed 
border line is to be filled. 
The fill level is represented by the current background color. The unfilled background is 
transparent.
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FillPatternColor

Description
Specifies the color of the fill pattern for the selected object. 

Access in Runtime: Read and write

Syntax
Object.FillPatternColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "Button", "Roundbutton", "GraphicView", "Bar", "Checkbox", 
"OptionGroup" or "WindowSlider".

Color
Optional A value or a constant that establishes the color of the fill pattern for the specified 
object.

See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

GraphicView (Page 4014)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Listbox (Page 4027)

ProjectName (Page 4062)
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FillStyle

Description
Specifies the fill style of the selected object. 

Access in Runtime: Read and write

Syntax
Object.FillStyle[= THmiLineFillStyle]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "EllipticalArc" or 
"CircularArc".

THmiLineFillStyle
Optional A value or a constant that specifies the fill style.

hmiLineFillStyleTransparent (0): transparent fill

hmiLineFillStyleSolid (1): object is filled with the specified color

Default setting: hmiLineFillStyleSolid

See also
Line (Page 4025)

Polyline (Page 4060)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

FillStyle

Description
Determines the fill style of the specified object. 

Access during runtime: Read and Write

Syntax
Object.FillStyle [= THmiLineFillStyle]

Object
Required. An object of the "ScreenItem" type with the characteristic "Line," or "Polyline".
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THmiLineFillStyle
Optional. A value or constant which determines the fill style.

hmiLineFillStyleTransparent (0): Transparent fill

hmiLineFillStyleSolid (1): Object is filled with the specified color

Default setting: hmiLineFillStyleSolid

FillStyle2

Description
Defines or returns the fill style of the bar. 

FillstyleAlignment

Description
Specifies the alignment within the specified object.

Filter

Description
Specifies criteria in SQL syntax for the database.   

Access in Runtime: Read and write

Syntax
Object.Filter[=String]

Object
Required A "ScreenItem" object with the format "PrintMessage".

String
Optional A value or a constant which specifies the criteria in SQL syntax for the database.

FirstConnectedObjectIndex 

Description
Specifies the index number of the upper connector point. 

Access in Runtime: Read and write
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Syntax
Object.FirstConnectedObjectIndex[=Int]

Object

Required A "ScreenItem" object with the format "Connector".

Int
Int

See also
Connector (Page 3986)

FirstConnectedObjectName

Description
Specifies the object name of the object that is docked at the upper connector point. 

Access in Runtime: Read and write

Syntax
Object.FirstConnectedObjectName[=String]

Object
Required A "ScreenItem" object with the format "Connector".

String
String

See also
Connector (Page 3986)

FixedAspectRatio 

Description
Specifies whether the aspect ratio should be maintained or changed when the symbol size is 
altered. 

Access in Runtime: Read and write

Syntax
Object.FixedAspectRatio[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "SymbolLibrary".

BOOLEAN
Optional TRUE, if the aspect ratio should be maintained when the symbol size is altered.

See also
SymbolLibrary (Page 4098)

FlashBackColor

Description
TRUE, when flashing of the background is activated. BOOLEAN write-read access

FlashBorderColor

Description
TRUE, when flashing of the object lines is activated. BOOLEAN write-read access.

FlashFlashPicture

Description
TRUE, when flashing of the flash picture is activated. BOOLEAN write-read access.

FlashForeColor

Description
TRUE, when flashing of the text is activated. BOOLEAN write-read access.

FlashingColorOff 

Description
Specifies the color of the border line for the selected object for the flashing status "off". 

Access in Runtime: Read and write
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Syntax
Object.FlashingColorOff[=Color]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", 
"Checkbox", "OptionGroup" or "Connector".

Color
Optional A value or a constant that specifies the color of the border line of the selected object 
for the flashing status "off".

See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

Connector (Page 3986)

RoundButton (Page 4074)
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FlashingColorOn 

Description
Specifies the color of the border line for the selected object for the flashing status "on". 

Access in Runtime: Read and write

Syntax
Object.FlashingColorOn[=Color]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", 
"Checkbox", "OptionGroup" or "Connector".

Color
Optional A value or a constant that specifies the color of the border line of the selected object 
for the flashing status "on".
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

Connector (Page 3986)

RoundButton (Page 4074)

FlashingEnable

Description
Specifies whether the border line of the selected object will flash in runtime. 

Access in Runtime: Read and write

Syntax
Object.FlashingEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", 
"Checkbox", "OptionGroup" or "Connector".

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4301



BOOLEAN
Optional TRUE, if the border line of the object is flashing.

See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

Connector (Page 3986)

RoundButton (Page 4074)

FlashingRate

Description
Specifies the flash rate of the border line for the selected object.   

Access in Runtime: Read and write

Syntax
Object.FlashingRate[=FlashingRate]
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Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", 
"Checkbox", "OptionGroup" or "Connector".

FlashingRate
hmiFlashingRateSlow ( 0): The length of the flashing rate is 1000 ms.

hmiFlashingRateMedium ( 1): The length of the flashing rate is 500 ms.

hmiFlashingRateFast ( 2): The length of the flashing rate is 250 ms.

See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

Connector (Page 3986)

RoundButton (Page 4074)
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FlashPicReferenced

Description 
TRUE, when the assigned flash picture is to be saved. Otherwise, only the associated object 
reference is saved. Read only access.

FlashPicture

Description  
Returns the flash picture. Read-only access.
The graphic (*.BMP or *.DIB) must be located in the "GraCS" folder of the current project so 
that it can be integrated. 
In this context, the "FlashPicReferenced" property defines whether the flash picture should be 
saved or referenced together with the object.

FlashRate

Description
Defines or returns the flash frequency. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast

FlashRateBackColor

Description
Defines or returns the flash frequency for the object background. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast

FlashRateBorderColor

Description
Defines or returns the flash frequency for the lines of the object. Value range from 0 to 2.

0 = slow

1 = medium
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2 = fast

FlashRateFlashPic 

Description 
Defines or returns the flash frequency for the flash picture. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast

FlashRateForeColor

Description
Defines or returns the flash frequency for the object label. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast

FlashTransparentColor

Description
Specifies the color of the bitmap object of a flashing graphic that is set to "transparent". 

Access in Runtime: Read and write

Syntax
Object.FlashTransparentColor[=Color]

Object
Required A "ScreenItem" object with the format "GraphicIOField".

Color
Optional A value or a constant that specifies the color of the bitmap object of a flashing graphic 
that is set to "transparent".

See also
GraphicIOField (Page 4011)
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Flip

Description
Flips the symbol on the vertical and / or horizontal center axis of the symbol. 

Access in Runtime: Read and write

Syntax
Object.Flip[=SymbolLibFlip]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

SymbolLibFlip
hmiSymbolLibraryFlipNone ( 0): The symbol is not flipped.

hmiSymbolLibraryFlipHorizontal ( 1): The symbol is flipped horizontally.

hmiSymbolLibraryFlipVertical ( 2): The symbol is flipped vertically.

hmiSymbolLibraryFlipBoth ( 3): The symbol is flipped horizontally and vertically.

See also
SymbolLibrary (Page 4098)

FocusColor 

Description
Specifies that the color for the focus border of the selected object is currently active. 

Access in Runtime: Read and write

Syntax
Object.FocusColor[= Color]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Button", "Switch", 
"GraphicIOField", "RecipeView", "StatusForce", "Slider", "TrendView", "MessageView" or 
"AlarmView".

Color
Optional A value or a constant that specifies the frame color.
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Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

Slider (Page 4082)

AlarmControl (Page 3947)

FocusColor

Description
Determines the color for the focus frame of the given object that has the focus. 

Access during runtime: Read and Write

Syntax
Object.FocusColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Button", "Switch", 
"GraphicIOField", "RecipeView", "StatusForce", "Slider", "TrendView" or "MessageView".

Color
Optional A value or constant which determines the frame color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.
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See also
AlarmView (Page 3958)

RecipeView (Page 4068)

TrendView (Page 4118)

StatusForce (Page 4087)

FocusWidth

Description
Specifies the border width of the specified object if the object is currently active. 

Access in Runtime: Read and write

Syntax
Object.FocusWidth[= LONG]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Button", "Switch", 
"GraphicIOField", "RecipeView", "StatusForce", "Slider", "TrendView", "MessageView" or 
"AlarmView".

LONG
Optional A value or a constant that specifies the border width in pixels. Value range from 1 to 
10.

See also
SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

Slider (Page 4082)

AlarmControl (Page 3947)

FocusWidth

Description
Determines the border width of the given object if the object has a focus. 

Access during runtime: Read and Write
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Syntax
Object.FocusWidth [= LONG]

Object
Required. An object of type "ScreenItem" with the characteristic "SymbolicIOField", "Button", 
"Switch", "GraphicIOField", "RecipeView", "StatusForce", "Slider", "TrendView" or 
"MessageView".

LONG
Optional. A value or constant which determines the border width in pixels. Value range from 
1 to 10.

See also
AlarmView (Page 3958)

RecipeView (Page 4068)

TrendView (Page 4118)

StatusForce (Page 4087)

BatteryView (Page 3967)

Font

Description
Specifies or returns the font.     

The font object has the following sub-properties 

● Size (Font Size)

● Bold (yes/no)

● Name (font name)

● Italic (yes/no)

● Underline (underline yes/no)

● StrikeThrough (yes/no)

If two font properties are directly assigned, only the default property "Name" is assumed.

Access during runtime: Read and write

Syntax
Object.Font [=Font]
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Object
Necessary. An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl", "MediaPlayer", 
"FunctionTrendControl" or "Slider".

Font
Font

Example

 
'VBS74
Dim objControl1
Dim objControl2
Set objControl1 = ScreenItems("Control1")
Set objControl2 = ScreenItems("Control2")
objControl2.Font = objControl1.Font ' take over only the type of font
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See also
AlarmControl (Page 3947)

ZoneLabelView (Page 4143)

ProtectedAreaName (Page 4064)

RangeLabelView (Page 4065)

Slider (Page 4082)

SmartClientView (Page 4085)

CheckBox (Page 3974)

Button (Page 3968)

Bar (Page 3961)

Switch (Page 4089)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

Clock (Page 3984)

DateTimeField (Page 3989)

RoundButton (Page 4074)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)

RecipeView (Page 4068)

TrendView (Page 4118)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

ProjectName (Page 4062)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

FontBold

Description
Specifies whether the text of the selected object should be shown in bold. 

Access in Runtime: Read and write
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Syntax
Object.FontBold[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" or "OptionGroup".

BOOLEAN
Optional TRUE, if the text of the selected object should be shown in bold.

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Bar (Page 3961)

CheckBox (Page 3974)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

RoundButton (Page 4074)

ProjectName (Page 4062)

FontItalic

Description
Specifies whether the text of the selected object should be shown in italic. 

Access in Runtime: Read and write

Syntax
Object.FontItalic[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" or "OptionGroup".

BOOLEAN
Optional TRUE, if the text of the selected object should be shown in italic.
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See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Bar (Page 3961)

CheckBox (Page 3974)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

RoundButton (Page 4074)

ProjectName (Page 4062)

FontName 

Description
Specifies the font of the selected object. 

Access in Runtime: Read and write

Syntax
Object.FontName[=String]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" or "OptionGroup".

String
Optional A value or a constant that specifies the font of the selected object.
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See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Bar (Page 3961)

CheckBox (Page 3974)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

RoundButton (Page 4074)

ProjectName (Page 4062)

FontSize 

Description
Specifies the font size of the text for the selected object. 

Access in Runtime: Read and write

Syntax
Object.FontSize[=Int]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" oder "OptionGroup".

Int
Optional A value or a constant that specifies the font size of the text for the selected object.
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See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Bar (Page 3961)

CheckBox (Page 3974)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

RoundButton (Page 4074)

ProjectName (Page 4062)

FontUnderline

Description
Specifies whether the text of the selected object should be underlined. 

Access in Runtime: Read and write

Syntax
Object.FontUnderline[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" oder "OptionGroup".

BOOLEAN
Optional TRUE, if the text of the selected object should be shown underlined.
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See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Bar (Page 3961)

CheckBox (Page 3974)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

RoundButton (Page 4074)

ProjectName (Page 4062)

ForeColor

Description
Specifies the font color of the text for the selected object. 

Access in Runtime: Read and write

Syntax
Object.ForeColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Switch", "Bar", "RecipeView", "Slider", 
"SymbolLibrary", "MessageView", "Checkbox" or "OptionGroup".

Color
Optional A value or a constant that specifies the font color of the text for the selected object.
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See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

Bar (Page 3961)

Slider (Page 4082)

SymbolLibrary (Page 4098)

CheckBox (Page 3974)

OptionGroup (Page 4054)

Group (Page 4017)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

RoundButton (Page 4074)

ForeColor

Description
Determines the text color of the given object. 

Access during runtime: Read and Write

Syntax
Object.ForeColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "TextField", "IOField", 
"SymbolicIOField", "Button", "Switch", "Bar", "RecipeView", "Slider" or "SymbolLibrary".

Color
Optional A value or constant which determines the text color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.
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See also
RecipeView (Page 4068)

AlarmView (Page 3958)

DateTimeField (Page 3989)

ProjectName (Page 4062)

ForeFlashColorOff

Description
Defines or returns the color of the text for flash status "Off". LONG write-read access.

ForeFlashColorOn

Description
Defines or returns the color of the text for flash status "On". LONG write-read access.

FormatPattern

Description
Specifies the format of the output value. 

Access in Runtime: Read and write

Syntax
Object.FormatPattern[=String]

Object
Required A "ScreenItem" object with the format "IOField".

String
Optional A value or a constant that specifies the format of the output value.

See also
IOField (Page 4021)
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FormatPatternReadOnlySpecial

Description
Specifies that the "format pattern" field can only be read. 

Access in Runtime: Read and write

Syntax
Object.FormatPatternReadOnlySpecial[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the "format pattern" field can only be read.

See also
IOField (Page 4021)

FormatType

Description
Specifies the data type of the selected object. 

Access in Runtime: Read and write

Syntax
Object.FormatType[=IOFieldDataFormat]

Object
Required A "ScreenItem" object with the format "IOField".

IOFieldDataFormat
hmiOutputFormatString ( 2): String

hmiOutputFormatDecimal ( 1): Decimal

hmiOutputFormatHexadecimal ( 3): Hexadecimal

hmiOutputFormatBinary ( 0): Binary

hmiOutputFormatDate ( 4): Date

hmiOutputFormatTime ( 5): Time

hmiOutputFormatDateTime ( 6): Date and time

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4319



See also
IOField (Page 4021)

Free

Description
Returns the size of the free disk space. 

Access in Runtime: Read and write

Syntax
Object.Free[=Double]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Double
Optional A value or a constant that returns the size of the free disk space.

See also
DiskSpaceView (Page 3991)

FreePercent

Description
Returns the measured values for the free disk space as a percentage. The values can be 
queried in Runtime. The values cannot be predefined. 

Access in Runtime: Read and write

Syntax
Object.FreePercent[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that returns the measured values for the free disk space as a 
percentage. 
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See also
DiskSpaceView (Page 3991)

FreezeProviderConnections

Description
Specifies whether the properties for the data connection ("TagProviderType(i)", "Source.."...) 
can be changed without the change becoming effective immediately. If you change from, for 
example, "XDataLogTag(i)" illegal combinations with "YDataLogTag(i)" could arise. 

This means attributes must have the value TRUE before changing the data connection 
"FreezeProviderConnections". After changing all the properties for the data connection, 
"FreezeProviderConnection" will be set to FALSE and the changes will become effective. 

Access in Runtime: Read and write

Syntax
Object.FreezeProviderConnections[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if the properties for the data connection ("TagProviderType(i)", "Source.."...) 
can be changed without the change becoming effective immediately. 

See also
FunctionTrendControl (Page 4004)

Properties G-H

GetSelectionText

Description
Returns the selected text of the "MultiLineEdit" object.   

Gradation

Description
Specifies the value difference between two main marking lengths of the "Gauge" object. 
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Access in Runtime: Read and write

Syntax
Object.Gradation[= LONG]

Object
Required A "ScreenItem" object with the format "Gauge".

LONG
Optional A value or a constant that specifies the value difference.

See also
Gauge (Page 4008)

GraphDirection

Description
Specifies at which border of the trend view the current values are displayed.     

Access in Runtime: Read and write

Syntax
Object.GraphDirection[=Direction]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Direction
0: Positive values run to the right and upwards.

-1: Positive values run to the left and upwards.

-2: Positive values run to the right and upwards.

-3: Positive values run to the right and downwards.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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GridBackColor 

Description
Specifies the background color for the recipe view in Runtime.   

Access in Runtime: Read and write

Syntax
Object.GridBackColor[=Color]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

Color
Optional A value or a constant that specifies the background color in the recipe view in Runtime.

GridForeColor 

Description
Defines the font color for the recipe view. 

Access in Runtime: Read and write

Syntax
Object.GridForeColor[=Color]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

Color
Optional A value or a constant that specifies the font color for the recipe view.

GridLineColor

Description
Specifies the color for the grid lines. 

Access in Runtime: Read and write

Syntax
Object.GridlineColor[=Color]
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Object
Required A "ScreenItem" object with the format "AlarmControl".

Color
Optional A value or a constant that specifies the color of the grid lines.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

GridLineColor

Color of the row divider / content - GridLineColor
Defines the color of row/column dividers in table contents. The button opens the "Color 
selection" dialog. 

The attribute can be assigned dynamic properties by means of the name GridLineColor.

See also
AlarmView (Page 3958)

GridLineWidth

Description
Defines the line weight of the row/column dividers in pixels.   

Access in Runtime: Read and write

Syntax
Object.GridLineWidth[=Width]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Width
Optional A value or a constant which specifies the width of the grid line.
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

Height

Description
Specifies the height of the selected objects "Ellipse", "Circle" and "Rectangle".     

Access during runtime: Read and write

The other objects only have read access to the property.

Syntax
Object.Height[= LONG]

Object
Necessary. A "Screen" object or an object of type "ScreenItem". This property is a standard 
property of the ScreenItem-Objekts and is therefore available for all formats.

LONG
Optional A value or a constant that specifies the height in pixels. This parameter can be set 
only for the objects "Ellipse", "Circle" and "Rectangle". 

Example
The following example halves the height of all objects of the image "NewPDL1", whose name 
starts with "Circle":

 
'VBS75
Dim objScreen
Dim objCircle
Dim lngIndex
Dim strName
lngIndex = 1
Set objScreen = HMIRuntime.Screens("NewPDL1")
For lngIndex = 1 To objScreen.ScreenItems.Count
'
'Searching all circles
strName = objScreen.ScreenItems.Item(lngIndex).ObjectName
If "Circle" = Left(strName, 6) Then
'
'to halve the height of the circles
Set objCircle = objScreen.ScreenItems(strName)
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objCircle.Height = objCircle.Height / 2
End If
Next
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

ScreenWindow (Page 4078)

DiskSpaceView (Page 3991)

ChannelDiagnose (Page 3972)

ScriptDiagnostics (Page 4080)

Group (Page 4017)

ForeignControl (Page 4000)

ProtectedAreaName (Page 4064)

UserView  (Page 4137)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

DateTimeField (Page 3989)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

ProjectName (Page 4062)

AlarmView (Page 3958)

BatteryView (Page 3967)

RangeLabelView (Page 4065)

ZoneQualityView (Page 4144)

ZoneLabelView (Page 4143)

WLanQualityView (Page 4142)

TrendView (Page 4118)

SystemDiagnoseWindow (Page 4103)

SystemDiagnoseView (Page 4100)

StatusForce (Page 4087)

SmartClientView (Page 4085)

RecipeView (Page 4068)

RangeQualityView (Page 4067)
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HelpText

Description
Returns the tooltip that is shown in Runtime as an operating aid for the specified object.   

Access in Runtime: Read

Syntax
Object.HelpText

Object
Required An object of the "ScreenItem" type with the format "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch", "GraphicIOField" or "OnlineTrendControl".

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

HelpText

Description
Returns the tooltip that is shown in Runtime as an operating aid for the specified object. 

Access in Runtime: Read

Syntax
Object.HelpText

Object
Required An object of the type "ScreenItem" with the characteristic "IOField", 
"SymbolicIOField", "Button", "Switch", "GraphicIOField" or "TrendView".

See also
TrendView (Page 4118)

DateTimeField (Page 3989)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4328 System Manual, 07/2013,  



HiddenInput

Description
Specifies whether the input value or a * for each character will be shown during the input. 

Access in Runtime: Read and write

Syntax
Object.HiddenInput[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the input value is not shown during the input. An * is shown for each character.

See also
IOField (Page 4021)

HideTagNames

Description
Specifies whether the tag name is shown in the f/t() trend view.   

Access in Runtime: Read and write

Syntax
Object.HideTagNames[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE, if the tag names are displayed.

See also
OnlineTrendControl (Page 4045)
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HighLimitColor 

Description
Specifies the color of the top or right scroll button in a scroll bar. 

Access in Runtime: Read and write

Syntax
Object.HighLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "WindowSlider".

Color
Optional A value or a constant that specifies the color of the top or right scroll button in a scroll 
bar.

See also
WindowSlider (Page 4139)

HitlistColumnAdd

Description
Transfers the selected message block from the list of available message blocks to the list of 
selected message blocks.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnAdd

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)
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HitlistColumnCount

Description
Specifies the number of message blocks displayed in the hitlist in Runtime.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnCount 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)

HitlistColumnIndex

Description
References a message block selected for the hitlist. Using this attribute you can assign the 
values of other attributes to a specific message block of the hitlist.

Values between 0 and "HitlistColumnCount" minus 1 are valid for "HitlistColumnIndex". 
Attribute "HitlistColumnCount" defines the number of message blocks selected for the hitlist. 
The "HitlistColumnIndex" attribute can be assigned dynamic properties by means of attribute 
HitlistColumnRepos.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnIndex

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)
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HitlistColumnName

Description
Displays the name of the message block of the hitlist which is referenced with attribute 
"HitlistColumnIndex". You cannot edit this name.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnName

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 3947)

HitlistColumnRemove

Description
Removes the marked message block from the list of selected message blocks and inserts it 
in the list of existing message blocks.    

Access in Runtime: Read and write

Syntax
Object.HitlistColumnRemove [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 3947)

HitlistColumnRepos

Description
Resorts the message blocks. The "Up" and "Down" commands move the selected message 
block accordingly in the list. This moves the message block in Runtime Control towards the 
front or towards the back.     
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Access in Runtime: Read and write

Syntax
For hitlist: Object.HitlistColumnRepos For message list: Object.MessageColumnRepos

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 3947)

HitlistColumnSort

Description
Defines the sorting order of the message block referenced in "HitlistColumnIndex" in the hitlist.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnSort [=Sort]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

Sort
0: No sorting.

1: Ascending sorting from the lowest to highest value

2 Descending sorting from the highest to lowest value

See also
AlarmControl (Page 3947)

HitlistColumnSortIndex

Description
Defines the sorting order of the message block referenced in "HitlistColumnIndex" in the hitlist. 
The sorting criterion is removed from "HitlistColumnSort" if you set a "0" value..   

Access in Runtime: Read and write
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Syntax
Object.HitlistColumnSortIndex

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 3947)

HitlistColumnVisible

Description
The selected message blocks of the message list or hitlist which are used in Runtime in the 
control are displayed in the list.     

Access in Runtime: Read and write

Syntax
For hitlist: Object.HitlistColumnVisible For message list: Object.MessageColumnVisible

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 3947)

HitlistDefaultSort

Description
Defines the default sorting order in the table columns of the hitlist.   

Access in Runtime: Read and write

Syntax
Object.HitlistDefaultSort[=Sort]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".
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Sort
0: The list is sorted in ascending order of frequency.

1:: The list is sorted in descending order of frequency.

See also
AlarmControl (Page 3947)

HitlistMaxSourceItems

Description
Specifies the maximum number of data records that can be used from the alarm log to create 
the hit list. The value can be anything between "0 - 10000". 

Access in Runtime: Read and write

Syntax
Object.HitlistMaxSourceItems[=Long]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Long
Optional A value or a constant that specifies the maximum number of data records that can 
be used from the alarm log to create the hit list. 

See also
AlarmControl (Page 3947)

HitlistMaxSourceItemsWarning

Description
Specifies whether a warning should be given if the maximum number of data records that is 
defined in "HitlistMaxSourceItems" is reached. 

Access in Runtime: Read and write

Syntax
Object.HitlistMaxSourceItemsWarning[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if a warning is given as soon as the maximum number of data records that is 
defined in "HitlistMaxSourceItems" is reached.

See also
AlarmControl (Page 3947)

HitlistRelativeTimeFactor

Description
Specifies the time factor which, alongside the time type "HitlistRelativeTimeFactorType", 
determines the time period in which the statistics of the hit list will be created. 

If you do not wish to specify a period of time, set the time factor to "0".

Access in Runtime: Read and write

Syntax
Object.HitlistRelativeTimeFactor[=Long]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Long
Optional A value or a constant that specifies the time factor.

See also
AlarmControl (Page 3947)

HitlistRelativeTimeFactorType 

Description
Specifies the time type which, alongside the time factor "HitlistRelativeTimeFactor", 
determines the time period in which the statistics of the hit list will be created. 

Access in Runtime: Read and write
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Syntax
Object.HitlistRelativeTimeFactorType[=AlarmViewAdvancedTimeFactorUnit]

Object
Required A "ScreenItem" object with the format "AlarmControl".

AlarmViewAdvancedTimeFactorUnit
hmiAlarmViewAdvancedTimeFactorUnitMinute ( 0): The time range for the statistics will be 
measured in minutes.

hmiAlarmViewAdvancedTimeFactorUnitHour ( 1): The time range for the statistics will be 
measured in hours.

hmiAlarmViewAdvancedFactorUnitDay ( 2): The time range for the statistics will be measured 
in days.

hmiAlarmViewAdvancedTimeFactorUnitWeek ( 3): The time range for the statistics will be 
measured in weeks.

hmiAlarmViewAdvancedTimeFactorUnitMonth ( 4): The time range for the statistics will be 
measured in months.

See also
AlarmControl (Page 3947)

HitListRelTime

Description
Sets a time range for the statistics.   

If you do not wish to specify a period of time, set the time factor to "0".

Access in Runtime: Read and write

Syntax
Object.HitListRelTime[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: If no time range is specified in the selection, the specified time range is used for the 
statistics.

FALSE: The specified time range is not used.
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See also
AlarmControl (Page 3947)

HorizontalAlignment 

Description
Specifies the horizontal alignment of the text within the specified object. 

Access in Runtime: Read and write

Syntax
Object.HorizontalAlignment[= THmiHorizontalAlignment]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch", "CheckBox", "OptionGroup", "PageNumber", 
"ProjectName", "ReportName", "OdbcDatabaseField".

THmiHorizontalAlignment
Optional A value or a constant that specifies the horizontal alignment of the text.

hmiAlignmentLeft (0):The text is arranged flush left in the object.

hmiAlignmentCentered (1): The text is arranged horizontally centered in the object.

hmiAlignmentRight (2): The text is arranged flush right in the object.

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

CheckBox (Page 3974)

OptionGroup (Page 4054)

AlarmControl (Page 3947)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

RoundButton (Page 4074)
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HorizontalAlignment 

Description
Determines the horizontal alignment of the text within the given object. 

Access during runtime: Read and Write

Syntax
Object.HorizontalAlignment [= THmiHorizontalAlignment]

Object
Required An object of the "ScreenItem" type with the characteristics "TextField", "IOField", 
"SymbolicIOField", "Button" or "Switch".

THmiHorizontalAlignment
Optional A value or constant which determines the horizontal alignment of the text.

hmiAlignmentLeft (0): The text is aligned left justified in the object.

hmiAlignmentCentered (1): The text is centered horizontally in the object.

hmiAlignmentRight (2): The text is aligned right justified in the object.

See also
DateTimeField (Page 3989)

ProjectName (Page 4062)

HorizontalGridLines

Description
Defines whether horizontal separating lines will be displayed.   

Access in Runtime: Read and write

Syntax
Object.HorizontalGridLines[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: Horizontal grid lines are displayed.

FALSE: Horizontal grid lines are not displayed.
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

HorizontalScrollbarPosition

Description
Specifies the horizontal positioning of the scroll bar in a picture window with slider, or returns 
its value.

The picture is displayed in the picture window by positioning the horizontal and vertical scroll 
bars. If you wish to display the picture as a cutout where the scroll bars are located at the left 
and upper edge of the picture, use the properties "OffsetLeft" and "OffsetTop" as the origin of 
this cutout.

See also
ScreenWindow (Page 4078)

Hotkey property 

Description
Returns the function key related to the mouse operation in respect of a button object.

Read only access.

See also
Button (Page 3968)

HourNeedleHeight

Description
Specifies the length of the hour hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.HourNeedleHeight[= LONG]
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Object
Required A "ScreenItem" object with the format "Clock".

LONG
Optional A value or a constant that specifies the length of the hour hand.

Specify the length of the hour hand as a percentage relating to the radius of the clock face.

See also
Clock (Page 3984)

HourNeedleWidth 

Description
Specifies the width of the hour hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.HourNeedleWidth[= LONG]

Object
Required A "ScreenItem" object with the format "Clock".

LONG
Optional A value or a constant that specifies the width of the hour hand.

Specify the width of the hour hand as a percentage relating to double the length of the clock 
face.

See also
Clock (Page 3984)

Hysteresis property 

Description
TRUE, when the display should appear with hysteresis. BOOLEAN write-read access.
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HysteresisRange

Description
Defines the hysteresis in % of the displayed value or returns it.
The Hysteresis property must be set to TRUE for the hysteresis to be calculated. 

Properties I-J

IconSpace

Description
Defines the spacing between the icons and text in the table cells. The value is active if and 
icon and text are displayed.   

Access in Runtime: Read and write

Syntax
Object.IconSpace[=Space]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl".

Space
Optional Value which specifies the spacing.

 

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

Index

Description
Specifies the index for the selected text field. 

Access in Runtime: Read and write
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Syntax
Object.Index[=Int]

Object
Required A "ScreenItem" object with the formats "Checkbox" or "OptionGroup".

Int
Optional A value or a constant that specifies the index of the selected text field.

See also
OptionGroup (Page 4054)

Listbox (Page 4027)

InnerBackColorOff 

Description
Specifies the color under the slider of the "Switch" object if the object is in OFF status. 

Access during runtime: Read and Write

Syntax
Object.InnerBackColorOff[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Switch".

Color
Optional A value or a constant that specifies the color for the OFF status.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Switch (Page 4089)
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InnerBackColorOn

Description
Specifies the color under the slider of the "Switch" object if the object is in ON status. 

Access during runtime: Read and Write

Syntax
Object.InnerBackColorOn[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Switch".

Color
Optional A value or a constant that specifies the color for the ON status.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Switch (Page 4089)

InputValue

Description  
Defines the value to be entered by the user in the I/O field. The value is not displayed in the I/
O field when the property is set.

If you want the value to be displayed in the I/O field after confirmation with the <Return> key, 
configure a direct connection between the properties "input value" and "output value". The 
direct connection is only practical when no tag is connected to the output value, but the user 
can nevertheless query the specified value, for example, through a script.

LONG write-read access. 

See also
SymbolicIOField (Page 4093)

IOField (Page 4021)
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InsertData(i)

Description
Specifies which data will be inserted for the active trend.   

Access in Runtime: Read and write

Syntax
Object.InsertData(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControi".

BOOLEAN
Optional TRUE, if "DataIndex(i)" is ignored and the data added to the rear of the data buffer. 

FALSE, if the data is inserted at the position "DataIndex(i)" of the data buffer. 

Comments
The trend view is redrawn in every operation with "InsertData(i)".

See also
FunctionTrendControl (Page 4004)

InsertEnable

Description
Specifies whether an entry can be made in the recipe view in Runtime.   

Access in Runtime: Read and write

Syntax
Object.InsertEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if an entry can be made in the recipe view in Runtime.
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Instance

Description
Returns an instance of the alarm object.

IntegerDigits

Description
Establishes the number of integer digits (0 to 20). 

Access in Runtime: Read and write

Syntax
Object.IntegerDigits[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value or a constant that specifies the number of integer digits (0 to 20).

See also
Bar (Page 3961)

Interval

Description
Specifies the time interval for updating the displayed measured value. You enter the value in 
minutes. 

Access in Runtime: Read and write

Syntax
Object.Interval[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that specifies the time interval for updating the measured values. 
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See also
DiskSpaceView (Page 3991)

ItemBorderBackColor

Description
Defines or returns the background color for dividing lines in the selection list of the text list 
object. LONG write-read access. The background color is only visible with the property setting 
ItemBorderStyle > 0. 

ItemBorderColor

Description
Defines or returns the color for deviding lines in the selection list of the text list object. LONG 
write-read access.

ItemBorderStyle

Description
Specifies the line style of the separation lines in the selection list of the selected object.   

Access in Runtime: Read and write

Syntax
Object.ItemBorderStyle[=LineStyle]

 

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

LineStyle
hmiLineStyleNone (-1): The selection list has no separation lines.

hmiLineStyleSolid ( 0): The selection list has solid separation lines.

hmiLineStyleDash ( 1): The selection list has broken separation lines.

hmiLineStyleDot ( 2): The selection list has dotted separation lines.

hmiLineStyleDashDot ( 3): The selection list has dash - dot lines as separation lines.

hmiLineStyleDashDotDot ( 4): The selection list has dash - dot - dot lines as separation lines.
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See also
SymbolicIOField (Page 4093)

ItemBorderWidth

Description
Defines or returns the dividing line weight in pixels in the selection list of the text list object.

JumpToLimitsAfterMouseClick

Description
Specifies whether the slider will be set to the associated end value. The end value is the 
minimum or maximum value. To set the slider to the end value, users click on the area outside 
of the current slider setting. 

Access in Runtime: Read and write

Syntax
Object.JumpToLimitsAfterMouseClick[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "WindowSlider".

BOOLEAN
Optional TRUE, if the slider will be set to the associated end value.

See also
WindowSlider (Page 4139)

Properties K-L

LabelColor

Description
Specifies the color of the scale label in the "Slider" object. 

Access in Runtime: Read and write
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Syntax
Object.LabelColor[= Color]

Object
Required A "ScreenItem" object with the format "Slider".

Color
Optional A value or a constant that specifies the color of the scale label.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Slider (Page 4082)

Language

Description
Determines the current Runtime language. 

Access in Runtime: Read and write

Syntax
Object.Language[= LONG]

Object
Required A "HMIRuntime" object.

LONG
Optional A value or a constant that specifies the national code.

Comments
Specify the Runtime language in VBS with a national code, e.g. 1031 for German, 2057 for 
English etc.. Refer to the VBScript basics under the topic "Current local ID (LCID) diagram" 
for an overview of all the national codes.

See also
HMIRuntime  (Page 3922)
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LanguageSwitch

Description
Returns the value which defines where the language dependent assigned texts are stored. 
Read only access.

TRUE, if the texts are managed in the project texts editor. Translations into other languages 
are made in the project texts editor.

FALSE, when the texts are managed directly in the object. Translations into other languages 
can be made by means of the export/import function.

LargeTicksBold

Description
Specifies whether the long marking lengths of a scale are shown in bold. 

Access in Runtime: Read and write

Syntax
Object.LargeTicksBold[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Bar".

BOOLEAN
Optional. TRUE, if the long marking lengths of a scale are shown in bold.

See also
Bar (Page 3961)

LargeTicksSize

Description
Specifies the length of the long marking lengths of a scale. 

Access in Runtime: Read and write

Syntax
Object.LargeTicksSize[=Int]
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Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value or a constant that specifies the length of the long marking lengths of a scale.

See also
Bar (Page 3961)

LastConnectedObjectIndex

Description
Specifies the index number of the connection point for the last, connected object. 

Access in Runtime: Read and write

Syntax
Object.LastConnectedObjectIndex[=Int]

Object
Required A "ScreenItem" object with the format "Connector".

Int
Int

See also
Connector (Page 3986)

LastConnectedObjectName

Description
Specifies the object name of the object that is docked at the lower connector point. 

Access in Runtime: Read and write

Syntax
Object.LastConnectedObjectName[=String]

Object
Required A "ScreenItem" object with the format "Connector".
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String
String

See also
Connector (Page 3986)

LastError

Description
Returns an error code regarding the success of the last operation, e.g. information on a tag 
write or read process:

 Code in hexadecimal notation Description
0x00000000 OK
0x80040001 Execution error
0x80040002 Tag error
0x80040003 Server not available.
0x80040004 Multi Tag Error; error in one or several tags

To obtain an error description, first of all carry out the Read method. 
 

 Note

If the error occurs when accessing via the TagSet object, evaluate the LastError property for 
each tag of the TagSet object.

 

To obtain a statement about the quality of the supplied value, use the "QualityCode" property. 
To obtain a description of the error, use the "ErrorDescription" property. 

Access during runtime: Read

Syntax
Object.LastError

Object
Necessary. A "Tag" object.

Example
The following example shows the error code for the "Tag1" tag: 

 
'VBS77
Dim objTag
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Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
MsgBox objTag.LastError

The following example adds two tags to the TagSet list and outputs the LastError property as 
Trace:

 
'VBS178
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
HMIRuntime.Trace "LastError: " & group.LastError & vbNewLine

The LastError property of a tag contained in the list may be accessed as follows:

 
HMIRuntime.Trace "LastError: " & group("Motor1").LastError & vbNewLine

See also
Tag (Page 3941)

TagSet (list)  (Page 3945)

Layer

Description 
Returns the layer that contains an object as LONG in the screen. There is a total of 32 layers 
available, whereby Layer "0" is the bottom layer and Layer "31" the top layer.

The configured objects are initially in the background of a layer.

Access during runtime: Read

Syntax
Object.Layer
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Object
Necessary. A "ScreenItem" object.

 

 Note

The Layer property specifies the layer in which the object is located. The layer "0" is output 
as layer "0".

When accessed, the layers are counted up from 1 in VBS. Therefore, address the level "1" 
with layers(2).

 

Example
The following example displays the name and layer of all objects in the screen "NewPDL1":

 
'VBS78
Dim objScreen
Dim objScrItem
Dim lngAnswer
Dim lngIndex
Dim strName
lngIndex = 1
Set objScreen = HMIRuntime.Screens("NewPDL1")
For lngIndex = 1 To objScreen.ScreenItems.Count
strName = objScreen.ScreenItems.Item(lngIndex).ObjectName
Set objScrItem = objScreen.ScreenItems(strName)
lngAnswer = MsgBox(strName & " is in layer  " & objScrItem.Layer,vbOKCancel)
If vbCancel = lngAnswer Then Exit For
Next
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See also
ScreenItem (Page 3932)

HTMLBrowser (Page 4019)

Group (Page 4017)

ForeignControl (Page 4000)

DateTimeField (Page 3989)

ZoneQualityView (Page 4144)

ZoneLabelView (Page 4143)

WLanQualityView (Page 4142)

ProtectedAreaName (Page 4064)

RangeLabelView (Page 4065)

RangeQualityView (Page 4067)

ScreenWindow (Page 4078)

ScriptDiagnostics (Page 4080)

Slider (Page 4082)

SmartClientView (Page 4085)

StatusForce (Page 4087)

SymbolLibrary (Page 4098)

BatteryView (Page 3967)

ChannelDiagnose (Page 3972)

CheckBox (Page 3974)

GraphicIOField (Page 4011)

Button (Page 3968)

Bar (Page 3961)

WindowSlider (Page 4139)

UserView  (Page 4137)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

Switch (Page 4089)

Rectangle (Page 4072)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Line (Page 4025)

Listbox (Page 4027)

AlarmView (Page 3958)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Clock (Page 3984)

Connector (Page 3986)

DiskSpaceView (Page 3991)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Gauge (Page 4008)

GraphicView (Page 4014)

Polygon (Page 4057)

Polyline (Page 4060)

RoundButton (Page 4074)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)

RecipeView (Page 4068)

TrendView (Page 4118)

UserArchiveControl (Page 4130)

SystemDiagnoseWindow (Page 4103)

SystemDiagnoseView (Page 4100)

TrendRulerControl (Page 4110)

ProjectName (Page 4062)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)
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Layer00Checked

Description
TRUE, when limit 0 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer00Value and Layer00Color 
properties. 

Layer00Color

Description
Defines or returns the color for limit 0. LONG write/read access.
When monitoring of the limit value is activated (Layer00Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer00Value

Description
Determines the value for "Limit 0" or returns it.
Monitoring only takes effect when the Layer00Checked property value is set to TRUE.

Layer01Checked

Description
TRUE, when limit 1 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer01Value and Layer01Color 
properties. 

Layer01Color

Description
Defines or returns the color for limit 1. LONG write/read access.
When monitoring of the limit value is activated (Layer01Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.
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Layer01Value

Description
Determines the value for "Limit 1" or returns it.
Monitoring only takes effect when the Layer01Checked property value is set to TRUE.

Layer02Checked

Description
TRUE, when limit 2 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer02Value and Layer02Color 
properties. 

Layer02Color

Description
Defines or returns the color for limit 2. LONG write/read access.
When monitoring of the limit value is activated (Layer02Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer02Value

Description
Determines the value for "Limit 2" or returns it.
Monitoring only takes effect when the Layer02Checked property value is set to TRUE.

Layer03Checked

Description
TRUE, when limit 3 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer03Value and Layer03Color 
properties. 
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Layer03Color

Description
Defines or returns the color for limit 3. LONG write/read access.
When monitoring of the limit value is activated (Layer03Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer03Value

Description
Determines the value for "Limit 3" or returns it.
Monitoring only takes effect when the Layer03Checked property value is set to TRUE.

Layer04Checked

Description
TRUE, when limit 4 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer04Value and Layer04Color 
properties. 

Layer04Color

Description
Defines or returns the color for limit 4. LONG write/read access.
When monitoring of the limit value is activated (Layer04Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer04Value

Description
Determines the value for "Limit 4" or returns it.
Monitoring only takes effect when the Layer04Checked property value is set to TRUE.
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Layer05Checked

Description
TRUE, when limit 5 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer05Value and Layer05Color 
properties. 

Layer05Color

Description
Defines or returns the color for limit 5. LONG write/read access.
When monitoring of the limit value is activated (Layer05Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer05Value

Description
Determines the value for "Limit 5" or returns it.
Monitoring only takes effect when the Layer05Checked property value is set to TRUE.

Layer06Checked

Description
TRUE, when limit 6 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer06Value and Layer06Color 
properties. 

Layer06Color

Description
Defines or returns the color for limit 6. LONG write/read access.
When monitoring of the limit value is activated (Layer06Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.
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Layer06Value 

Description
Determines the value for "Limit 6" or returns it.
Monitoring only takes effect when the Layer06Checked property value is set to TRUE.

Layer07Checked

Description
TRUE, when limit 7 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer07Value and Layer07Color 
properties. 

Layer07Color

Description
Defines or returns the color for limit 7. LONG write/read access.
When monitoring of the limit value is activated (Layer07Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer07Value

Description
Determines the value for "Limit 7" or returns it.
Monitoring only takes effect when the Layer07Checked property value is set to TRUE.

Layer08Checked

Description
TRUE, when limit 8 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer08Value and Layer08Color 
properties. 
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Layer08Color

Description
Defines or returns the color for limit 8. LONG write/read access.
When monitoring of the limit value is activated (Layer08Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer08Value

Description
Determines the value for "Limit 8" or returns it.
Monitoring only takes effect when the Layer08Checked property value is set to TRUE.

Layer09Checked property

Description
TRUE, when limit 9 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer09Value and Layer09Color 
properties. 

Layer09Color

Description
Defines or returns the color for limit 9. LONG write/read access.
When monitoring of the limit value is activated (Layer09Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer09Value

Description
Determines the value for "Limit 9" or returns it.
Monitoring only takes effect when the Layer09Checked property value is set to TRUE.
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Layer10Checked

Description
TRUE, when limit 10 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer10Value and Layer10Color 
properties. 

Layer10Color

Description
Defines or returns the color for limit 10. LONG write/read access.
When monitoring of the limit value is activated (Layer10Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer10Value

Description
Determines the value for "Limit 10" or returns it.
Monitoring only takes effect when the Layer10Checked property value is set to TRUE.

LayerDeclutteringEnable

Description 
Indicates whether the layers of a screen can be shown or hidden dependent on the set 
minimum and maximum zoom. 

Access during runtime: Read

Syntax
Object.LayerDeclutteringEnable

Object
Necessary. A "Screen" object. 

Example:
The example outputs the LayerDecluttering property of the "NewPDL1" screen as Trace.

 
'VBS156
Dim objScreen

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4362 System Manual, 07/2013,  



 
Set objScreen = HMIRuntime.Screens("NewPDL1")
HMIRuntime.Trace "Enable: " & objScreen.LayerDeclutteringEnable & vbNewLine

See also
Screen (Page 3930)

Layers

Description
Returns an object of type "Layers".

Access in Runtime: Read

Syntax
Object.Layers

Object
Required A "Screen" object.

See also
Screen (Page 3930)

LeaveMarginForBorder

Description
Specifies whether an additional margin will be left for borders. 

Access in Runtime: Read and write

Syntax
Object.LeaveMarginForBorder[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if an additional margin is enabled for borders.
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See also
Bar (Page 3961)

LeaveMarginForMarkers

Description
Specifies whether an additional margin will be left for markers. 

Access in Runtime: Read and write

Syntax
Object.LeaveMarginForMarkers[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if an additional margin is enabled for markers.

See also
Bar (Page 3961)

Left 

Description
Specifies the value of the X coordinate of the selected object.     

Access during runtime: Read and write

Syntax
Object.Left[= DOUBLE]

Object
Necessary. A "ScreenItem" object. This property is a standard property of the ScreenItem-
Objekts and is therefore available for all formats.

DOUBLE
Optional A value or a constant that contains the value of the X coordinate in pixels (measured 
from the top left edge of the screen).
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Comments
The X coordinate refers to the top left corner of the rectangle that surrounds the object. The 
screen limits are also monitored in runtime. If the assigned coordinate value exceeds the 
display size, the user-defined function is interrupted with an error message. 

Used for the following object types:
IOField

Rectangle

Slider
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

ScreenWindow (Page 4078)

DiskSpaceView (Page 3991)

ChannelDiagnose (Page 3972)

ScriptDiagnostics (Page 4080)

Group (Page 4017)

ForeignControl (Page 4000)

DateTimeField (Page 3989)

ProtectedAreaName (Page 4064)

UserView  (Page 4137)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

ProjectName (Page 4062)

AlarmView (Page 3958)

BatteryView (Page 3967)

RangeLabelView (Page 4065)

RangeQualityView (Page 4067)

RecipeView (Page 4068)

SmartClientView (Page 4085)

StatusForce (Page 4087)

SystemDiagnoseView (Page 4100)

SystemDiagnoseWindow (Page 4103)

TrendView (Page 4118)

WLanQualityView (Page 4142)

ZoneLabelView (Page 4143)

ZoneQualityView (Page 4144)
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LeftComma property

Description
Defines or returns the number of digits to the left of the decimal point (0 to 20). 

LeftOffset

Description 
Defines or returns the distance of the picture from the left edge of the picture window. 

The picture is displayed as a cutout of the picture window. The picture scroll bars are located 
at the left and upper edge of the picture. If you wish to display the picture in the picture window 
by using the horizontal and vertical positioning of the picture scroll bars, use the properties 
"HorizontalScrollBarPosition" and "VerticalScrollBarPosition" for such positioning.

See also
ScreenWindow (Page 4078)

LightEffect property

Description
TRUE, when the light effect should be activated. BOOLEAN write-read access.

Limit4LowerLimit 

Description
Specifies the lower limit for ""Reserve4".

The "Limit4LowerLimitEnable" property must be set to TRUE so that the limit "Reserve4"" can 
be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit4LowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the lower limit for "Reserve4".
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Comments
The "Limit4LowerLimitRelative" property specifies whether the object is evaluated as a 
percentage or absolutely.

See also
Bar (Page 3961)

Limit4LowerLimitColor 

Description
Specifies the color for the lower limit "Reserve4". 

The "Limit4LowerLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.Limit4LowerLimitColor[=Color]

Object
Required A ""ScreenItem" object with the format "Bar"."

Color
Optional A value or a constant that specifies the color for the lower limit ""Reserve4".

See also
Bar (Page 3961)

Limit4LowerLimitEnabled

Description
Specifies whether the lower limit ""Reserve4"" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit4LowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".
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BOOLEAN
Optional TRUE, if the lower limit ""Reserve4" is to be monitored.

Comments
The following values will be specified with the properties ""Limit4LowerLimit", 
"Limit4LowerLimitColor" and "Limit4LowerLimitRelative"":

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 3961)

Limit4LowerLimitRelative

Description
Specifies whether the lower limit "Reserve4" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.Limit4LowerLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional. TRUE,, if the lower limit "Reserve4" is to be evaluated as a percentage.

See also
Bar (Page 3961)

Limit4UpperLimit 

Description
Specifies the lower limit for "Reserve4".

The "Limit4UpperLimitEnable"" property must be set to TRUE so that the limit ""Reserve4" can 
be monitored. 
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Access in Runtime: Read and write

Syntax
Object.Limit4UpperLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the upper limit for "Reserve4".

Comments
The "Limit4UpperLimitRelative" property specifies whether the object is evaluated as a 
percentage or absolutely.

See also
Bar (Page 3961)

Limit4UpperLimitColor

Description
Specifies the color for the upper limit ""Reserve4". 

The "Limit4UpperLimitEnable"" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.Limit4UpperLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the upper limit "Reserve4".

See also
Bar (Page 3961)
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Limit4UpperLimitEnabled

Description
Specifies whether the upper limit "Reserve4" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit4UpperLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem"" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit ""Reserve4" is to be monitored.

Comments
The following values will be specified with the properties ""Limit4UpperLimit", 
"Limit4UpperLimitColor" and "Limit4UpperLimitRelative": 

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 3961)

Limit4UpperLimitRelative

Description
Specifies whether the upper limit "Reserve4" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.Limit4UpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".
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BOOLEAN
Optional TRUE, if the upper limit "Reserve4" is to be evaluated as a percentage.

See also
Bar (Page 3961)

Limit5LowerLimit

Description
Specifies the lower limit for "Reserve5"".

The "Limit5LowerLimitEnable" property must be set to TRUE so that the limit ""Reserve5" can 
be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit5LowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the lower limit for "Reserve5"".

Comments
The "Limit5LowerLimitRelative" property specifies whether the object is evaluated as a 
percentage or absolutely.

See also
Bar (Page 3961)

Limit5LowerLimitColor 

Description
Specifies the color for the lower limit ""Reserve5"". 

The "Limit5LowerLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write
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Syntax
Object.Limit5LowerLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the lower limit ""Reserve5".

See also
Bar (Page 3961)

Limit5LowerLimitEnabled

Description
Specifies whether the lower limit "Reserve5" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit5LowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit ""Reserve5" is to be monitored. 

Comments
The following values will be defined using the properties "Limit5LowerLimit", 
"Limit5LowerLimitColor" and "Limit5LowerLimitRelative": 

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 3961)
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Limit5LowerLimitRelative

Description
Specifies whether the lower limit ""Reserve5" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.Limit5LowerLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem"" object with the format ""Bar"".

BOOLEAN
Optional TRUE, if the lower limit ""Reserve5" is to be evaluated as a percentage.

See also
Bar (Page 3961)

Limit5UpperLimit

Description
Specifies the lower limit for "Reserve5".

The ""Limit5UpperLimitEnable" property must be set to TRUE so that the limit ""Reserve5" can 
be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit5UpperLimit[=Double]

Object
Required A ""ScreenItem"" object with the format "Bar".

Double
Optional A value or a constant that specifies the upper limit for ""Reserve5".

Comments
The "TypeLimitHigh5" property specifies whether the object is evaluated as a percentage or 
absolutely.
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See also
Bar (Page 3961)

Limit5UpperLimitColor

Description
Specifies the color for the upper limit "Reserve5"". 

The "Limit5UpperLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.Limit5UpperLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the upper limit ""Reserve5".

See also
Bar (Page 3961)

Limit5UpperLimitEnabled

Description
Specifies whether the upper limit "Reserve5" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit5UpperLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit ""Reserve5"" is to be monitored.
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See also
Bar (Page 3961)

Limit5UpperLimitRelative

Description
Specifies whether the upper limit "Reserve5" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.Limit5UpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit "Reserve5" is to be evaluated as a percentage.

See also
Bar (Page 3961)

LimitHigh4 

Description
Determines the upper limit value for "Reserve 4" or returns it.
The CheckLimitHigh4 property must be set to TRUE in order that the "Reserve 4" limit value 
can be monitored. 
The type of the evaluation (in percent or absolute) is defined in the TypeLimitHigh4 property.

LimitHigh5

Description
Determines the upper limit value for "Reserve 5" or returns it.
The CheckLimitHigh5 property must be set to TRUE in order that the "Reserve 5" limit value 
can be monitored. 
The type of the evaluation (in percent or absolute) is defined in the TypeLimitHigh5 property.
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LimitLow4

Description
Determines the lower limit value for "Reserve 4" or returns it.
The CheckLimitLow4 property must be set to TRUE in order that the "Reserve 4" limit value 
can be monitored. 
The type of the evaluation (in percent or absolute) is defined in the TypeLimitLow4 property.

LimitLow5

Description
Determines the lower limit value for "Reserve 5" or returns it.
The CheckLimitLow5 property must be set to TRUE in order that the "Reserve 5" limit value 
can be monitored. 
The type of the evaluation (in percent or absolute) is defined in the TypeLimitLow5 property.

LimitMax

Description
Determines the upper limit value as an absolute value depending on the data format or returns 
it.
If the displayed value exceeds the upper limit value, it is displayed by a sequence of *** (not 
displayable).

LimitMin

Description
Determines the lower limit value as an absolute value depending on the data format or returns it.
If the displayed value exceeds the upper limit value, it is displayed by a sequence of *** (not 
displayable).

LineColor

Description
Specifies the color of the window dividers. The button opens the "Color selection" dialog.
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

LineendShapeStyle

Description
Specifies the shape of the line end.
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See also
CheckBox (Page 3974)

GraphicIOField (Page 4011)

Button (Page 3968)

Bar (Page 3961)

WindowSlider (Page 4139)

Switch (Page 4089)

Rectangle (Page 4072)

MultiLineEdit (Page 4032)

Line (Page 4025)

Listbox (Page 4027)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Connector (Page 3986)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

GraphicView (Page 4014)

Polygon (Page 4057)

Polyline (Page 4060)

RoundButton (Page 4074)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)

LineWidth

Description
Specifies the line weight of the selected object. 

Access in Runtime: Read and write

Syntax
Object.LineWidth [= LONG]
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Object
Required A "ScreenItem" object with the formats "Line" "Polyline", "EllipticalArc", "CircularArc" 
or "Connector".

LONG
Optional A value or a constant that specifies the line weight in pixels.

See also
Line (Page 4025)

Polyline (Page 4060)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Connector (Page 3986)

AlarmControl (Page 3947)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

LineWidth

Description
Determines the LineWidth of the given object. 

Access during runtime: Read and Write

Syntax
Object.LineWidth [= LONG]

Object
Required. An object of the "ScreenItem" type with the characteristic "Line," or "Polyline".

LONG
Optional. A value or constant which determines the line width in pixels.
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See also
OnlineTrendControl (Page 4045)

ListType property

Description
Returns the data type displayed in the case of a text list object. Read only access.

Value range from 0 to 2.

0 = decimal

1 = binary

2 = bit

LoadDataImmediately

Description
Specifies whether in the event of a screen impact the tag values should be downloaded from 
the archives for the time range that is to be shown.     

Access in Runtime: Read and write

Syntax
Object.LoadDataImmediately[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl" (Runtime Professional) or "HMITrendView" 
(Runtime Advanced).

BOOLEAN
Optional TRUE, if in the event of a screen impact the tag values should be downloaded from 
the archives for the time range that is to be shown.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)
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Localizable

Description
Specifies whether a font should be assigned and can be formatted for each Runtime language. 

Access in Runtime: Read and write

Syntax
Object.Localizable[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "OnlineTableControl", "AlarmControl" or "UserArchiveControl".

BOOLEAN
Optional TRUE, if a font should be assigned and can be formatted for each Runtime language. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

LocalCursor

Description
Establishes whether the cursor data is transferred separately in order to increase the 
performance.   

Syntax
Object.LocalCursor

Object
Required A "ScreenItem" object with the format "SmartClientView".

See also
SmartClientView (Page 4085)
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LockSquaredExtent 

Description
Specifies whether the size of the clock can be adjusted with the mouse. 

Access in Runtime: Read and write

Syntax
Object.LockSquaredExtent[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Clock" or "Gauge".

BOOLEAN
Optional TRUE, if the size of the clock can be adjusted by dragging the mouse on the selection 
points to the desired aspect ratio.

See also
Clock (Page 3984)

Gauge (Page 4008)

LockStatus

Description
TRUE, when a locked measuring point should be displayed. BOOLEAN write-read access.

LockText

Description
Defines the label of a button for a locked measuring point.
The LockStatus property must be set to TRUE for the label to be displayed. 

LockTextColor

Description
Defines or returns the color of the button label for a locked measuring point. LONG write/read 
access.
The LockStatus property must be set to TRUE for the background color to be displayed.
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Logging 

Description
Returns an object of type "Logging".

Access in Runtime: Read

Syntax
Object.Logging

Object
Required A "HMIRuntime" object. 

See also
HMIRuntime  (Page 3922)

LogOperation 

Description
Specifies whether, after operating this object, an alarm is output on the alarm system. 

Access in Runtime: Read and write

Syntax
Object.LogOperation[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField", "SymbolicIOField", "CheckBox", 
"OptionGroup" or "WindowSlider".

BOOLEAN
Optional. TRUE, if, after operating this object, an alarm is output on the alarm system.

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Listbox (Page 4027)
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LongStrokesBold

Description
TRUE, when the long sections of a scale should be displayed in bold face. BOOLEAN write-
read access.

LongStrokesOnly

Description
TRUE, when only the long sections of a scale should be displayed . BOOLEAN write-read 
access.

LongStrokesSize

Description
Defines or returns the length of the axis section in pixels. 

LongStrokesTextEach

Description
Returns the value which defines which sections of the scale displayed should be labeled (1 = 
every section, 2 = every second section, etc.). Read only access

LongTermArchiveConsistency

LongTermArchiveConsistency
If "LongTimeArchiveConsistency" is set to "No", 1000 messages are displayed in the long-term 
archive list on the single-user system, server or client for each server, or for each redundant 
server pair. 

If the "LongTimeArchiveConsistency" is set to "yes", the most recent 1000 messages are 
displayed on the client of all servers or redundant server pair in the long-term archive list.

The attribute can be assigned dynamic properties by means of the name 
LongTimeArchiveConsistency .

See also
AlarmControl (Page 3947)
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LowerLimit

Description
Specifies the lower limit for input values. 

Access in Runtime: Read and write

Syntax
Object.LowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "IOField"".

Double
Optional A value or a constant that specifies the lower limit for input values.

See also
IOField (Page 4021)

LowerLimitColor(i) 

Description
Specifies the color that identifies the tag values for the selected trend and which lie below the 
value of "LowerLimitValue(i)". Whether the information is evaluated depends on the property 
"LowerLimitEnabled(i)".   

Access in Runtime: Read and write

Syntax
Object.LowerLimitColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

Color
Optional A value or a constant which specifies the color which identifies tag values of the 
specified trend which are below the value of "LowerLimitValue(i)".

Comments
The parameter i indicates the number of the trend.
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See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

LowerLimitEnabled(i) 

Description
Specifies whether the information from "LowerLimitColor(i)" is used to identify the tag values 
that lie beneath the value of "LowerLimitValue(i)". 

Access in Runtime: Read and write

Syntax
Object.LowerLimitEnabled(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

BOOLEAN
Optional TRUE, if the information from "LowerLimitColor(i)" is used to identify the tag values 
that lie beneath the value of "LowerLimitValue(i)".

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

LowerLimitValue(i)

Description
???Specifies whether the tag values which drop below the value of "LowerLimitValue(i)" are 
marked by the color specified in "LowerLimitColor(i)". Whether the specification is evaluated 
depends on the attribute "LowerLimitEnabled(i)".   

Access in Runtime: Read and write
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Syntax
Object.LowerLimitValue(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that determines if the tag values that fall short of the 
"LowerLimitValue(i)" are to be identified with the color specified in "LowerLimitColor(i)". 

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

LowLimitColor

Description
Specifies the color of the bottom or left scroll button in a scroll bar. 

Access in Runtime: Read and write

Syntax
Object.LowLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "WindowSlider".

Color
Optional A value or a constant that specifies the color of the bottom or left scroll button in a 
scroll bar.

See also
WindowSlider (Page 4139)
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Properties M-N

MachineName

Description
Specifies the network code of the device that is to be monitored. 

Enter the name or the port of the device as the network code. 

Access in Runtime: Read and write

Syntax
Object.MachineName= [STRING]

Object
Required A "ScreenItem" object with the format "SmartClientView". 

STRING
Optional A value or a constant that contains the network code.

See also
SmartClientView (Page 4085)

MarginToBorder

Description
Specifies the width of the 3D border in pixels. The value of the width is dependent on the size 
of the object. 

Access in Runtime: Read and write

Syntax
Object.MarginToBorder[=Int]

Object
Required A ""ScreenItem" object with the format "WindowSlider".

Int
Optional A value or a constant that specifies the width of the 3D border in pixels. 
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See also
WindowSlider (Page 4139)

Marker property

Description
TRUE, when the limit values should be displayed as scale values. BOOLEAN write-read 
access.

Max property

Description
Defines or returns the absolute value in the case of a full value display. This value is displayed 
if the scale display is active.

MaximizeButton property

Description
TRUE, when the object can be maximized in Runtime. Read only access. 

MaximumValue

Description
Specifies the maximum value of the scale in the selected object. 

Access in Runtime: Read and write

Syntax
Object.MaximumValue [= DOUBLE]

Object
Required A "ScreenItem" object with the formats "Bar", "Gauge", "Slider" or "WindowSlider".

DOUBLE
Optional A value or a constant that specifies the maximum value.
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See also
Bar (Page 3961)

Gauge (Page 4008)

Slider (Page 4082)

WindowSlider (Page 4139)

MaximumValue

Description
Determines the maximum value of the scale in the given object. 

Access during runtime: Read and Write

Syntax
Object.MaximumValue [= DOUBLE]

Object
Required. An object of the type "ScreenItem" with the characteristic "Bar", "Gauge" or "Slider".

DOUBLE
Optional. A value or constant which determines the maximum value.

MCGUBackColorOff

Description
Defines or returns the background color for flash status "Off" in the case of the "Departed 
Unacknowledged" status. LONG write-read access.

MCGUBackColorOn

Description
Defines or returns the background color for flash status "On" in the case of the "Departed 
Unacknowledged" status. LONG write-read access.

MCGUBackFlash

Description
TRUE, when the background should flash when a message departs unacknowledged. 
BOOLEAN write-read access.
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MCGUTextColorOff

Description
Defines or returns the color of the text for flash status "Off" for the "Outgoing unacknowledged" 
status. LONG write-read access.

MCGUTextColorOn

Description
Defines or returns the background color of the text for flash status "On" for the "Outgoing 
unacknowledged" status. LONG write-read access.

MCGUTextFlash

Description
TRUE, when the font should flash when a message departs unacknowledged. BOOLEAN write-
read access.

MCKOBackColorOff

Description
Defines or returns the background color for flash status "Off" in the case of the "Arrived" status. 
LONG write-read access.

MCKOBackColorOn

Description
Defines or returns the background color for flash status "On" in the case of the "Arrived" status. 
LONG write-read access.

MCKOBackFlash

Description
TRUE, when the background should flash when a message arrives. BOOLEAN write-read 
access.
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MCKOTextColorOff

Description
Defines or returns the color of the text for flash status "Off" for the "Incoming" status. LONG 
write-read access.

MCKOTextColorOn

Description
Defines or returns the background color of the text for flash status "On" for the "Incoming" 
status. LONG write-read access.

MCKOTextFlash

Description
TRUE, when the font should flash when a message arrives. BOOLEAN write-read access.

MCKQBackColorOff

Description
Defines or returns the background color for flash status "Off" in the case of the "Departed 
Acknowledged" status. LONG write-read access.

MCKQBackColorOn

Description
Defines or returns the background color for flash status "On" in the case of the "Departed 
Acknowledged" status. LONG write-read access.

MCKQBackFlash

Description
TRUE, when the background should flash when a message departs acknowledged. BOOLEAN 
write-read access.
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MCKQTextColorOff

Description
Defines or returns the color of the text for flash status "Off" for the "Outgoing acknowledged" 
status. LONG write-read access.

MCKQTextColorOn

Description
Defines or returns the background color of the text for flash status "On" for the "Outgoing 
acknowledged" status. LONG write-read access.

MCKQTextFlash

Description
TRUE, when the font should flash when a message departs acknowledged. BOOLEAN write-
read access.

MCText

Description
Defines or returns the label for the respective message class.

MenuToolBarConfig 

Description
Loads the given configuration file with configured menu and toolbars or returns the name of 
the configuration file. 

Access in Runtime: Read and write

Syntax
Object.MenuToolBarConfig[=STRING]

Object
Required A "HMIRuntime" object. 

STRING
Optional The configuration file with user-defined menu and toolbars.
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See also
HMIRuntime  (Page 3922)

ScreenWindow (Page 4078)

MessageBlockAlign

Description
Aligns the contents of a selected message block in the table.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockAlign [=Align]

Object
Required An object of the "ScreenItem" type with the format "AlarmContro", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl".

Align

Value Description Explanation
0 Left Aligns the contents of a selected message block to the left.
1 Centered Aligns the contents of a selected message block to the center.
2 Right Aligns the contents of a selected message block to the right.

See also
AlarmControl (Page 3947)

MessageBlockAutoPrecisions

Description
Enables automatic setting of the number of decimal places.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockAutoPrecisions[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".
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BOOLEAN
TRUE: The number of decimal places is specified automatically. 

FALSE: The value in the "Decimal places" field is effective.

See also
AlarmControl (Page 3947)

MessageBlockCaption

Description
Specifies the caption of the column header in the message view for the selected message 
block. You can only edit the labels after having disabled the "Apply project settings" option. 
The entered caption is effective in all Runtime languages.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockCaption

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

MessageBlockCount

Description
Specifies the number of available message blocks which are available for the message list 
and hit list.   

Access in Runtime: Read

Syntax
Object.MessageBlockCount 

Object
Required A "ScreenItem" object with the format "AlarmControl".
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See also
AlarmControl (Page 3947)

MessageBlockDateFormat

Description
Defines the date format for displaying messages.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockDateFormat[=DateFormat]

Object
Required A "ScreenItem" object with the format "AlarmControl".

DateFormat

Value Description
Automatic The date format is set automatically.
dd.MM.yy Day.Month.Year, e.g. 24.12.10.
dd.MM.yyyy Day.Month.Year, e.g. 24.12.2010.
dd/MM/yy Day/Month/Year, e.g. 24/12/10.
dd/MM/yyyy Day/Month/Year, e.g. 24/12/2010.

See also
AlarmControl (Page 3947)

MessageBlockExponentialFormat

Description
Specifies the exponential notation for visualization of the values of a selected message block.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockExponentialFormat[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".
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BOOLEAN
TRUE: The values are displayed in exponential format.

FALSE: The values are displayed in decimal format.

See also
AlarmControl (Page 3947)

MessageBlockFlashOn

Description
Enables flashing of the selected message block in Runtime after a message was activated.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockFlashOn[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The content of the message block flashes.

FALSE: The content of the message block does not flash.

See also
AlarmControl (Page 3947)

MessageBlockHideText

Description
Enables the textual display of the content of a selected message block.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockHideText[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".
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BOOLEAN
TRUE: The content is not shown as a text. The option is not activated.

FALSE: The content is shown as a text. The option is activated.

See also
AlarmControl (Page 3947)

MessageBlockHideTitleText

Description
Enables the display of the header of a selected message block in text format.   

Syntax
Object.MessageBlockHideTitleText=[BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE : The header is not shown as a text. The option is not activated.

FALSE : The header is shown as a text. The option is activated.

See also
AlarmControl (Page 3947)

MessageBlockId

Description
Specified assignment of ID number and message block in the message view.   

Access in Runtime: Read

Syntax
Object.MessageBlockID

Object
Required A "ScreenItem" object with the format "AlarmControl".

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4399



See also
AlarmControl (Page 3947)

MessageBlockIndex

Description
References an existing message block. You can assign the values of other attributes to a 
certain message block by using the attribute. Valid values for "MessageBlockIndex" are 
between 0 and "MessageBlockCount" minus 1.   

The "MessageBlockIndex" attribute can be dynamized by the MessageBlockRepos attribute.

Access in Runtime: Read

Syntax
Object.MessageBlockIndex

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)

MessageBlockLeadingZeros

Description
Enables the display of selected message blocks with leading zero format.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockLeadingZeros[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: Leading zeros are displayed. The number of leading zeros is specified in the properties.

FALSE: Leading zeros are not displayed.
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See also
AlarmControl (Page 3947)

MessageBlockLength

Description
Defines the length of the message block selected based on the number of characters. You 
can only enter a value if the "Apply project settings" field is disabled.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockLength[=Int]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Int
Value which specifies the length of the message block. 

See also
AlarmControl (Page 3947)

MessageBlockName

Description
Displays the object name of the message block selected. You cannot edit this name.  

Access in Runtime: Read

Syntax
Object.MessageBlockName

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)
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MessageBlockPrecisions

Description
Specifies the decimal precision of the values of a selected message block. You can only enter 
the value if the "Automatic" option is deactivated.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockPrecisions[=Precision]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Precision
Number of decimal places

See also
AlarmControl (Page 3947)

MessageBlockSelected

Description
The available message block can be used in Runtime control for the message list or hitlist. 

Select the "Message blocks" tab to activate existing message blocks as required in the Control. 
Select the "Hitlist" and "Message list" tabs to configure the hitlist and message list based on 
the available blocks.   

Syntax
Object.MessageBlockSelected]

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)
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MessageBlockShowDate

Description
Enables the display of a date in the "Time" message block in addition to the time.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockFlashOn[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The date and the time are displayed.

FALSE: The time is displayed.

 

See also
AlarmControl (Page 3947)

MessageBlockShowIcon

Description
Enables the display of the content of a selected message block as icon.  

Access in Runtime: Read and write

Syntax
Object.MessageBlockShowIcon[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The content is shown as an icon.

FALSE: The content is not shown as an icon.

See also
AlarmControl (Page 3947)
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MessageBlockShowTitleIcon

Description
Specifies whether the header of the selected message block is displayed as a text.   

Syntax
Object.MessageBlockShowTitleIcon=[BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE : The header is shown as an icon.

FALSE : The header is not shown as an icon.

See also
AlarmControl (Page 3947)

MessageBlockTextId

Description
Specifies the caption of the selected message block using a Text ID which was derived from 
the text library. The caption is adapted automatically if a user changes the Runtime language. 

You can only enter a text ID after having disabled the "Apply project settings" option.  

Access in Runtime: Read and write

Syntax
Object.MessageBlockTextId

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)
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MessageBlockTimeFormat

Description
Defines which time format or duration format is used for displaying the messages.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockTimeFormat[=TimeFormat]

Object
Required A "ScreenItem" object with the format "AlarmControl".

TimeFormat
The following time formats are available:

Value Explanation
Automatic The time format is set automatically.
HH:mm:ss Hours:Minutes:Seconds, e.g. 15:35:44
HH:mm:ss.ms Hours:Minutes:Seconds.Milliseconds, e.g. 15:35:44.240.
hh:mm:ss tt Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.
hh:mm:ss.ms tt Hours:Minutes:Seconds.Milliseconds AM/PM, e.g. 03:35:44.240 PM.

The following duration formats are available:

Value Explanation
Automatic The duration format is determined automatically.
d H:mm:ss Day Hours:Minutes:Seconds, e.g. 1 2:03:55.
H:mm:ss. Hours:Minutes:Seconds, e.g. 26:03:55.
m:ss Minutes:Seconds, Example: 1563:55.
s Seconds, e.g. 93835.

See also
AlarmControl (Page 3947)

MessageBlockType

Description
Specifies the number of available message blocks which are available for the message list 
and hit list.   

Access in Runtime: Read and write
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Syntax
Object.MessageBlockType[=BlockType]

Object
Required A "ScreenItem" object with the format "AlarmControl". 

BlockType

Value Description Description
0 System block The message block belongs to the system block category
1 Text block The message block belongs to the user text block category
2 Process value 

block
The message block belongs to the process value block category

3 Hitlist block The message block belongs to the message blocks of the hitlist.

See also
AlarmControl (Page 3947)

MessageClass

Description
Defines the respective limit violation (Alarm High, Alarm Low, Warning High, Warning Low, 
etc.) for which the "Display Text", "Incoming -", "Incoming acknowledged -", and "Outgoing 
unacknowledged -" settings have been configured.

MessageColumnAdd

Description
Adds the selected message block from the list of existing message blocks to the list of selected 
message blocks.   

Access in Runtime: Read

Syntax
Object.MessageColumnAdd

Object
Required A "ScreenItem" object with the format "AlarmControl".
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See also
AlarmControl (Page 3947)

MessageColumnCount

Description
Specifies the number of message blocks to be displayed in the message list in Runtime.  

Access in Runtime: Read

Syntax
Object.MessageColumnCount

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

MessageColumnIndex

Description
References a message block selected for the message list. Using this attribute you can assign 
the values of other attributes to a specific message block of the message list. 

Valid values for "MessageColumnIndex" are between 0 and "MessageColumnCount" minus 
1. The "MessageColumnIndex" attribute can be dynamized by the attribute 
MessageColumnRepos.   

Access in Runtime: Read and write

Syntax
Object.MessageColumnIndex

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)
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MessageColumnName

Description
Shows the name of the message block in the message list which is referenced with the 
"MessageColumnIndex" property. You cannot edit this name.   

Access in Runtime: Read

Syntax
Object.MessageColumnName 

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

MessageColumnRemove

Description
Removes the marked message block from the list of selected message blocks and inserts it 
in the list of existing message blocks.    

Access in Runtime: Read and write

Syntax
Object.MessageColumnRemove

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)
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MessageColumnRepos

Description
Resorts the message blocks. The "Up" and "Down" commands move the selected message 
block accordingly in the list. This places the message block further forward or back in the 
message view in Runtime.     

Syntax
Object.MessageColumnRepos

Object.HitlistColumnRepos 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)

MessageColumnSort

Description
Defines the sorting order of the message block referenced in "MessageColumnIndex" .   

Access in Runtime: Read and write

Syntax
Object.MessageColumnSort [=Sort]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Sort
0: No sorting.

1: Ascending sorting from the lowest to highest value

2 Descending sorting from the highest to lowest value

See also
AlarmControl (Page 3947)
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MessageColumnSortIndex

Description
Defines the sorting order of the message block referenced in "MessageColumnIndex". The 
sorting criterion is removed from "MessageColumnSort" if you set a "0" value.   

Access in Runtime: Read and write

Syntax
Object.MessageColumnSortIndex 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)

MessageColumnVisible

Description
The selected message blocks of the message list or hit list which are used in Runtime in the 
message view are displayed in the list.     

Syntax
Object.HitlistColumnVisible

Object.MessageColumnVisible

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

MessageListType

Description
Selection field for defining the active list for picture calls.   
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Syntax
Object.MessageListType=[ListType]

Object
Required A "ScreenItem" object with the format "AlarmControl".

ListType

Value Description Description
0 Message list The currently active messages are displayed after a picture was 

called.
1 Short-term archive list A short-term archive list displays the logged messages after the 

picture was called. The display is updated immediately on activation 
of new messages.

2 Long-term archive list A long-term archive list displays the logged messages after a picture 
was called.

3 Lock list Only the currently locked messages are displayed after a picture 
was called.

4 Hitlist The configured statistics data is displayed after a picture was called.
5 List of messages to be 

hidden
The messages to be hidden are displayed at the call of a picture.

See also
AlarmControl (Page 3947)

Min 

Description
Defines or returns the absolute value in the case of the smallest value display. This value is 
displayed if the scale display is active.

MinimumValue

Description
Specifies the minimum value of the scale in the selected object. 

Access in Runtime: Read and write

Syntax
Object.MinimumValue [= DOUBLE]
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Object
Required A "ScreenItem" object with the formats "Bar", "Gauge", "Slider" or "WindowSlider".

DOUBLE
Optional A value or a constant that specifies the minimum value.

See also
Bar (Page 3961)

Gauge (Page 4008)

Slider (Page 4082)

WindowSlider (Page 4139)

MinimumValue

Description
Determines the minimum value of the scale in the given object. 

Access during runtime: Read and Write

Syntax
Object.MinimumValue [= DOUBLE]

Object
Required. An object of the type "ScreenItem" with the characteristic "Bar", "Gauge" or "Slider".

DOUBLE
Optional. A value or constant which determines the minimum value.

MinuteNeedleHeight

Description
Specifies the length of the minute hand in the ""Clock" object. 

Access in Runtime: Read and write

Syntax
Object.MinuteNeedleHeight[= LONG]

Object
Required A "ScreenItem" object with the format "Clock".
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LONG
Optional A value or a constant that specifies the length of the minute hand.

Specify the length of the minute hand as a percentage relating to the radius of the clock face.

See also
Clock (Page 3984)

MinuteNeedleWidth 

Description
Specifies the width of the minute hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.MinuteNeedleWidth[= LONG]

Object
Required A "ScreenItem" object with the format "Clock".

LONG
Optional A value or a constant that specifies the width of the minute hand.

Specify the width as a percentage relating to double the length of the minute hand.

See also
Clock (Page 3984)

Mode 

Description
Specifies the field type of the selected object.     

Access during runtime: Read and write

Syntax
Object.Mode[=IOFieldType]

Object
Necessary. A "ScreenItem" object with the formats "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch" or "GraphicIOField".
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IOFieldType
hmiIOFieldInput ( 1): input field

hmiIOFieldOutput ( 0): output field

hmiIOFieldInOutput ( 2): input and output field

Used for the following object types:
IOField

 

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

DateTimeField (Page 3989)

RoundButton (Page 4074)

Movable

Description
Specifies whether the window can be moved in Runtime. 

Access in Runtime: Read and write

Syntax
Object.Movable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional. TRUE, if the window can be moved in Runtime.
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

MsgFilterSQL

Description
Specifies one or more SQL statements for the customized selection of the messages. Several 
customized selections are connected with "OR". If you have configured a fixed selection 
"DefaultMsgFilterSQL", the SQL statements of "DefaultMsgFilterSQL" and "MsgFilterSQL" are 
connected with "AND".   

Syntax
Object.MsgFilterSQL 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)

Name 

Description   
Returns the object name as STRING. The returned value is dependent upon the used object. 

Access during runtime: Read

Syntax
Object.Name

Object
Necessary. An object of the "Tag", "Project", "DataItem", "Layer" and "ScreenItem" type with 
the format "FunctionTrendControl"
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Comments
Dependent on the specified object, the following object names will be returned:

● Tag: Name of the tag without server and tag prefix.

● Project: Name of the current Runtime project.

● DataItem: Name of the DataItem object.

● Layer: Name of the layer.

● FunctionTrendControl : Name of the trend referenced by the "Index" property.
 

  Note

Use the "Name" property to address a tag in the Tags" list. Tag names are structured in 
WinCC according to the following scheme:

<Tag prefix><Name of tag>

If you only specify the tag name, the tag prefix is applied from the screen window shortcut.
 

Example
The following example returns the name of the current Runtime project as Trace: 

 
'VBS160
HMIRuntime.Trace "Name: " & HMIRuntime.ActiveProject.Name & vbNewLine
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See also
DataItem (Page 3916)

Layer (Page 3924)

Project (Page 3929)

Tag (Page 3941)

HTMLBrowser (Page 4019)

Group (Page 4017)

ForeignControl (Page 4000)

DateTimeField (Page 3989)

WLanQualityView (Page 4142)

ZoneLabelView (Page 4143)

ZoneQualityView (Page 4144)

ProtectedAreaName (Page 4064)

RangeLabelView (Page 4065)

RangeQualityView (Page 4067)

ScreenWindow (Page 4078)

ScriptDiagnostics (Page 4080)

Slider (Page 4082)

SmartClientView (Page 4085)

StatusForce (Page 4087)

SymbolLibrary (Page 4098)

BatteryView (Page 3967)

ChannelDiagnose (Page 3972)

CheckBox (Page 3974)

GraphicIOField (Page 4011)

Button (Page 3968)

Bar (Page 3961)

WindowSlider (Page 4139)

UserView  (Page 4137)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

Switch (Page 4089)

Rectangle (Page 4072)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Line (Page 4025)

Listbox (Page 4027)

AlarmView (Page 3958)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Clock (Page 3984)

Connector (Page 3986)

DiskSpaceView (Page 3991)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Gauge (Page 4008)

GraphicView (Page 4014)

Polygon (Page 4057)

Polyline (Page 4060)

RoundButton (Page 4074)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)

RecipeView (Page 4068)

TrendView (Page 4118)

UserArchiveControl (Page 4130)

SystemDiagnoseWindow (Page 4103)

SystemDiagnoseView (Page 4100)

TrendRulerControl (Page 4110)

ProjectName (Page 4062)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)
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NeedleBorderColor

Description
Specifies the line color of the pointer in the ""Clock"" object. 

Access in Runtime: Read and write

Syntax
Object.NeedleBorderColor[= Color]

Object
Required A "ScreenItem" object with the format "Clock".".

Color
Optional A value or a constant that specifies the line color of the pointer.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen .

See also
Clock (Page 3984)

NeedleColor

Description
Specifies the hand color of the "Clock" object. 

You must have configured the "NeedleFillStyle" property as "Transparent" for the pointer color 
to be shown.

Access in Runtime: Read and write

Syntax
Object.NeedleColor[= Color]

Object
Required A "ScreenItem" object with the format "Clock".".
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Color
Optional A value or a constant that specifies the pointer color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Clock (Page 3984)

NeedleFillStyle 

Description
Specifies whether the pointers are filled or transparent: 

0: The pointers are filled in the pointer fill color and shown with a margin in the foreground 
color. 

1: The pointers appear to be transparent and will be indicated by a margin in the foreground 
color. 

Access in Runtime: Read and write

Syntax
Object.NeedleFillStyle[=NeedleFillStyle]

Object
Required A "ScreenItem" object with the format ""Clock".

NeedleFillStyle
hmiNeedleFillStyleTransparent ( 1): The pointers are filled in the pointer fill color and shown 
with a margin in the foreground color.

Identifies a transparent clock hand.

hmiNeedleFillStyleSolid  ( 0): The pointers appear to be transparent and will be indicated by 
a margin in the foreground color.

Identifies a opaque clock hand.

See also
Clock (Page 3984)
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NormalRangeColor

Description
Specifies the color of the normal range on the scale of the "Gauge" object. 

The "NormalRangeVisible" property must have the value TRUE so that the normal range is 
displayed.

Access during runtime: Read and write

Syntax
Object.NormalRangeColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the color of the normal range.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Gauge (Page 4008)

NormalRangeVisible 

Description
Specifies whether the normal range in the scale of the ""Gauge" object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.NormalRangeVisible[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".
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BOOLEAN
Optional TRUE, if the normal range will be displayed in the scale.

Comments
Specify the color of the normal range with the ""NormalRangeColor" property.

See also
Gauge (Page 4008)

NumberLines

Description
Defines or return the number of lines the text list object should contain. If the amount of 
configured text is larger than this value, the selection list receives a vertical scroll bar.

NumberOfValues(i) 

Description
Specifies the number of values that are shown in the trend window. The property 
"TagProviderType(i)"" must have the value -1. Whether the information is evaluated depends 
on the property "UseMeasurePoints(i)".".

Access in Runtime: Read and write

Syntax
Object.NumberOfValues(i)[=Int]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the number of values that are shown in the trend 
window. 

Comments
Number of value pairs for trend i (from tag provider)

See also
FunctionTrendControl (Page 4004)
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Properties O-P

Object

Description
If you use a Control that is not a standard WinCC control, it could be that the properties provided 
by the Control have the same names as the general ScreenItem properties. In this case, the 
ScreenItem properties take priority. You can access the "hidden" properties of an outside 
provider Controls via the additional ""object" property. 

Syntax
Object.Object

Object
Required A "ScreenItem" object with the format ""ForeignControl".

Application example
To do this, address the properties of an outside provider control in the following way:

Control.object.type

If you are using only the form Control.type, the properties of the ScreenItem object will be used 
in case of identical names.

ObjectName

Description
Returns the name of the specified object. 

Access in Runtime: Read

Syntax
Object.ObjectName

Object
Required A "ScreenItem" object. This property is a standard property of the ScreenItem object 
and is therefore available for all formats.
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

ScreenWindow (Page 4078)

DiskSpaceView (Page 3991)

ChannelDiagnose (Page 3972)

ScriptDiagnostics (Page 4080)

Group (Page 4017)
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ObjectSizeDeclutteringEnable

Description 
Specifies whether only the objects within a set size range are displayed. 

Access during runtime: Read

Syntax
Object.ObjectSizeDeclutteringEnable

Object
Necessary. A "Screen" object. 

Example
The example outputs the Decluttering properties of the screen "NewPDL1" as Trace.

 
'VBS157
Dim objScreen
Set objScreen = HMIRuntime.Screens("NewPDL1")
HMIRuntime.Trace "Min: " & objScreen.ObjectSizeDeclutteringMin & vbNewLine
HMIRuntime.Trace "Max: " & objScreen.ObjectSizeDeclutteringMax & vbNewLine
HMIRuntime.Trace "Enable: " & objScreen.LayerDeclutteringEnable & vbNewLine

See also
Screen (Page 3930)

ObjectSizeDeclutteringMax 

Description 
Returns the upper size range for the display suppression of objects of the specified screen as 
LONG. 

Access during runtime: Read

Syntax
Object.ObjectSizeDeclutteringMax

Object
Necessary. A "Screen" object. 
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Example
The example outputs the Decluttering properties of the screen "NewPDL1" as Trace.

 
'VBS157
Dim objScreen
Set objScreen = HMIRuntime.Screens("NewPDL1")
HMIRuntime.Trace "Min: " & objScreen.ObjectSizeDeclutteringMin & vbNewLine
HMIRuntime.Trace "Max: " & objScreen.ObjectSizeDeclutteringMax & vbNewLine
HMIRuntime.Trace "Enable: " & objScreen.LayerDeclutteringEnable & vbNewLine

See also
Screen (Page 3930)

ObjectSizeDeclutteringMin

Description 
Returns the lower size range for the display suppression of objects of the specified screen as 
LONG. 

Access during runtime: Read

Syntax
Object.ObjectSizeDeclutteringMin

Object
Necessary. A "Screen" object. 

Example
The example outputs the Decluttering properties of the screen "NewPDL1" as Trace.

 
'VBS157
Dim objScreen
Set objScreen = HMIRuntime.Screens("NewPDL1")
HMIRuntime.Trace "Min: " & objScreen.ObjectSizeDeclutteringMin & vbNewLine
HMIRuntime.Trace "Max: " & objScreen.ObjectSizeDeclutteringMax & vbNewLine
HMIRuntime.Trace "Enable: " & objScreen.LayerDeclutteringEnable & vbNewLine

See also
Screen (Page 3930)
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OCXState 

Description
Sepcifies the status of the OCX. 

Access in Runtime: Read and write

Syntax
Object.OCXState[=Stream]

Object
Required A "ScreenItem" object with the format "ForeignControl".

Stream
Optional A value or a constant that specifies the status of the OCX. 

See also
ForeignControl (Page 4000)

Online 

Description
Specifies start and stop of the updating.     

Access in Runtime: Read and write

Syntax
Object.Online[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl" (Runtime Professional) or "HMITrendView" 
(Runtime Advanced).

BOOLEAN
Optional TRUE, if the updated display should be stopped. The values are stored in the cache 
and when the button is reactivated they are added . FALSE, if the updated display is to be 
continued.
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See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnTop

Description
TRUE, when the object should remain in the foreground in Runtime. Read only access.

OperationMessage property

Description
TRUE, if an alarm should be output when an operation is performed. BOOLEAN write-read 
access.
The operation is sent to the alarm system and is logged. The alarm system can be used to 
output an alarm in an alarm line, for example.

Particularities for I/O field, text list, and slider 
The reason for the operation can only be entered if the "OperationReport" property has been 
set to TRUE. 

OperationReport property 

Description
TRUE, if the reason for an operation should be recorded. BOOLEAN write/read access.
When the object is used or operated in Runtime, a dialog opens in which the operator can 
input the reason for the operation in the form of text. The operation is sent to the message 
system, and is archived.

OperationSteps

Description
Specifies by how many steps the slider of the scrollbar is moved with one mouseclick. 

Access in Runtime: Read and write

Syntax
Object.OperationSteps[=Int]
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Object
Required A ""ScreenItem" object with the format "WindowSlider".

Int
Optional A value or a constant which specifies by how many steps the slider of the scrollbar 
is moved with one mouseclick.

See also
WindowSlider (Page 4139)

OperatorMessageID

Description
Specified assignment of ID number and trigger event in the message view.   

Syntax
Object.OperatorMessageID[=MessageID]

Object
Required A "ScreenItem" object with the format "AlarmControl".

MessageID

Value Description Description
0 Lock Trigger event "Lock"
1 Unlock "Unlock" Trigger Event
2 Hide Trigger event "Hide"
3 Unhide Trigger event "Unhide"
4 Ackn Trigger event "Acknowledge"

See also
AlarmControl (Page 3947)

OperatorMessageIndex

Description
References an operator message event. You can assign the values of other properties to a 
specific operator message by using the property.   
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Syntax
Object.OperatorMessageIndex [=MessageIndex]

Object
Required A "ScreenItem" object with the format "AlarmControl".

MessageIndex

Value Description
0 Message event "Lock"
1 "Unlock" Message Event
2 Message event "Hide"
3 Message event "Unhide"
4 Message event "Acknowledge"

See also
AlarmControl (Page 3947)

OperatorMessageName

Description
Indicates the name which is referenced with the "OperatorMessageIndex" in message events 
for operator messages. You cannot edit this name.   

Syntax
Object.OperatorMessageName[=Name]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Name

Value Description
Lock Message event "Lock"
Unlock Message event "Enable"
Hide Message event "Hide"
Unhide Message event "Unhide"
Quit Message event "Ackn."

See also
AlarmControl (Page 3947)
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OperatorMessageNumber

Description
Specify a message number for the operator message of the selected message event if you do 
not use the operator message of WinCC.   

Syntax
Object.OperatorMessageNumber

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)

OperatorMessageSelected

Description
Activate the message events which trigger operator messages in the list.   

Syntax
Object.OperatorMessageSelected

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)

OperatorMessageSource1

Description
Define the message block of an operated message to be added to "Process value block 1" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty" should be displayed in "Process 
value block 1" of the operator message. Select "1" at process value as the message lock of 
the operated message "User text block 1".   
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Syntax
Object.OperatorMessageSource1

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSource2

Description
Define the message block of an operated message to be added to "Process value block 2" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty" should be displayed in "Process 
value block 2" of the operator message. Select "2" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource2

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSource3

Description
Define the message block of an operated message to be added to "Process value block 3" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty" should be displayed in "Process 
value block 3" of the operator message. Select "3" at process value as the message lock of 
the operated message "User text block 1".   
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Syntax
Object.OperatorMessageSource3

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSource4

Description
Define the message block of an operated message to be added to "Process value block 4" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 4" of the locked message, e.g. "Motor faulty" should be displayed in "Process 
value block 4" of the operator message. Select "4" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource4

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSource5

Description
Define the message block of an operated message to be added to "Process value block 5" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 5" of the operator message. Select "User text block 1" under process value "5" as 
the message block of the operated message.   
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Syntax
Object.OperatorMessageSource5

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSource6

Description
Define the message block of an operated message to be added to "Process value block 6" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 6" of the operator message. Select "6" at process value as the message lock of 
the operated message "User text block 1".

Syntax
Object.OperatorMessageSource6

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSource7

Description
Define the message block of an operated message to be added to "Process value block 7" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 7" of the operator message. Select "7" at process value as the message lock of 
the operated message "User text block 1".
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Syntax
Object.OperatorMessageSource7

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSource8

Description
Define the message block of an operated message to be added to "Process value block 8" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 8" of the operator message. Select "8" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource8

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSource9

Description
Define the message block of an operated message to be added to "Process value block 9" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
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value block 9" of the operator message. Select "9" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource9

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 3947)

OperatorMessageSource10

Description
Define the message block of an operated message to be added to "Process value block 10" 
of the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 10" of the operator message. Select "10" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource10

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 3947)

OperatorMessageSourceType1

Description
Specifies the format of the source content for the transfer.   

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4435



Syntax
Object.OperatorMessageType1[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Description
0 Text Transfer the source content in text format.
1 Value Transfer the source content as value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType2

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType2[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType3

Description
Specifies in what format the content of the source is transferred.   
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Syntax
Object.OperatorMessageType1[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType4

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType4[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType5

Description
Specifies in what format the content of the source is transferred.   
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Syntax
Object.OperatorMessageType5[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType6

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType6[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType7

Description
Specifies in what format the content of the source is transferred.   
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Syntax
Object.OperatorMessageType7[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType8

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType8[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType9

Description
Specifies in what format the content of the source is transferred.   
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Syntax
Object.OperatorMessageType9[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

OperatorMessageSourceType10

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType10[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 3947)

Orientation

Description
Specifies the text direction (orientation) of the selected object. 
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Access in Runtime: Read and write

Syntax
Object.Orientation[=TextOrientation]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Switch", "Bar", "OnlineTrendControl", "FunctionTrendControl", 
"Checkbox", "OptionGroup" or "WindowSlider".

TextOrientation
hmiTextHorizontal ( 0): The text is shown horizontally.

hmiTextRotated90Degree (-1): The text is shown vertically and left justified.

hmiTextRotated270Degree ( 1): The text is shown vertically and right justified.

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

Bar (Page 3961)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

OutputFormat

Description
Returns the value for the representation of the output value. The representation is dependent 
on the data format. Read only access.
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OutputValue

Description
Determines the default setting for the value to be displayed or returns it.
This value is used in Runtime when the associated tag cannot be connected or updated when 
a picture is started.

PageMode

Description
Enables paging is in the long-term archive list. Allows you to display all messages of the short-
term archive in the long-term archive list. Use the "Messages per page" property to determine 
the number of messages output per page.

The page up/down buttons of the toolbar can be used if paging is enabled.   

Syntax
Object.PageMode[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: Scrolling in the long-term log list is possible.

FALSE: Scrolling in the long-term log list is not possible.

See also
AlarmControl (Page 3947)

PageModeMessageNumber

Description
Defines the number of messages shown per page when paging the long-term archive list.   

Syntax
Object.PageModeMessageNumber

Object
Required A "ScreenItem" object with the format "AlarmContro".
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BOOLEAN
Optional TRUE, if the dialog box is shown in Runtime.

See also
AlarmControl (Page 3947)

Parent

Description
Returns the screen in which the specified object is embedded. 

Access in Runtime: Read

Syntax
Object.Parent

Object
Required A "ScreenItem" object. This property is a standard property of the ScreenItem object 
and is therefore available for all formats.

Application example
The following example writes the name of the root screen in "BaseScreenName" tag:

 
'VBS_Example_Parent
Dim objScrItem, BaseScreenName
Set objScrItem = HMIRuntime.Screens(1).ScreenItems(1)
BaseScreenName = "Name of BaseScreen: " & objScrItem.Parent.ObjectName
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

ScreenWindow (Page 4078)

DiskSpaceView (Page 3991)

ChannelDiagnose (Page 3972)

ScriptDiagnostics (Page 4080)

Group (Page 4017)
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Path 

Description 
Returns the path of the current project without the file names as STRING. For a WinCC client 
without its own path, the path is returned in UNC format, otherwise the local path is returned. 

Access during runtime: Read

Syntax
Object.Path

Object
Necessary. A "Project" object. 

Example
The following example returns the project path as Trace:

 
'VBS161
HMIRuntime.Trace "Path: " & HMIRuntime.ActiveProject.Path & vbNewLine

See also
Project (Page 3929)

Password

Description
Determines the password for the loading of the remote monitor. 

Access during runtime: Read and Write

Syntax
Object.Password = [STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "SmartClientView." 

STRING
Optional. A value or constant which contains the password.
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See also
SmartClientView (Page 4085)

PersistentRTAuthorization

Description
Specifies the authorization for operators which is necessary to change the persistence setting 
in Runtime. The value to be entered corresponds to the number which has the desired 
authorization in the user administration. Whether the information is evaluated depends on the 
value of the property "AllowPersistance". This does not apply for the message view.

Access in Runtime: Read and write

Syntax
Object.PersistentRTAuthorization[=RtAuthorization]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "FunctionTrendControl" or "OnlineTableControl".

RtAuthorization
Optional A value or a constant that specifies the authorization for operators to change the 
persistence setting. 

See also
AlarmControl (Page 3947)

PersistentRTCSAuthorization

Description
Specifies the operator authorization to be able to change the persistence setting in Runtime. 
The value to be entered corresponds to the number which has the desired authorization in the 
user administration. Whether the information is evaluated depends on the value of the property 
"AllowPersistance". This does not apply for the message view.

Access in Runtime: Read and write

Syntax
Object.PersistentRTCSAuthorization[=RtAuthorization]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "FunctionTrendControl" or "OnlineTableControl".

RtAuthorization
Optional A value or a constant that specifies the operator authorization to change the 
persistence setting. 

See also
AlarmControl (Page 3947)

PersistentRuntime

Description
Specifies whether changed settings in the window will also be maintained after a screen 
change. 

Access in Runtime: Read and write

Syntax
Object.PersistentRuntime[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" oder "OnlineTableControl".

BOOLEAN
Optional. TRUE, if changed settings in the window will also be maintained after a screen 
change.

Comments
The "AllowPersistance" property specifies whether the information will be evaluated.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)
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PersistentRuntimeAuthorization

Description
Specifies the access authorization to change the persistence setting in Runtime. The value to 
be entered corresponds to the number which has the desired authorization in the user 
administration.   

Access in Runtime: Read and write

Syntax
Object.PersistentRuntimeAuthorization[=HmiRTAuthorization]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

HmiRTAuthorization
Optional A value or a constant that specifies the access authorization required to change the 
persistence setting in Runtime.

Comments
The "AllowPersistance" property specifies whether the information will be evaluated. This does 
not apply for the message view.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

PersistentToDownload 

Description
Specifies whether the settings will be maintained until the next ES download. 

Access in Runtime: Read and write

Syntax
Object.PersistentToDownload[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

BOOLEAN
Optional TRUE, if the settings will be maintained until the next ES download.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

PersistentToDownloadAuthorization

Description
Specifies the access authorization required to change the settings until the next ES download. 

Access in Runtime: Read and write

Syntax
Object.PersistentToDownloadAuthorization[=HmiRTAuthorization]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

HmiRTAuthorization
Optional A value or a constant that specifies the access authorization required to change the 
settings until the next ES download.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

PicAlignment

Description
Specifies the alignment within the specified object.
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PicDeactReferenced

Description
TRUE, when the picture assigned for the "Disable" status should be saved in the RoundButton 
object. Otherwise, only the associated object reference is saved. Read only access.

PicDeactTransparent

Description
Defines or returns which color of the bitmap object (.bmp, .dib) assigned to the "Disabled" 
status should be set to "transparent". LONG Write/Read Access.
The color is only set to "Transparent" if the value of the "PicDeactUseTransColor" property is 
"True".

PicDeactUseTransColor

Description
TRUE, when the transparent color defined by the "PicDeactTransparent" property for the 
"Disable" status should be used. BOOLEAN write-read access.

PicDownReferenced

Description
TRUE, when the picture assigned for the "On" status is to be saved. Otherwise, only the 
associated object reference is saved. Read only access.

PicDownTransparent

Description
Defines or returns which color of the bitmap object (.bmp, .dib) assigned to the "On" status 
should be set to "transparent". LONG Write/Read Access.
The color is only set to "Transparent" if the value of the "PicDownUseTransColor" property is 
"True". 
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PicDownUseTransColor

Description
TRUE, when the transparent color defined by the "PicDownTransparent" property for the "On" 
status should be used. BOOLEAN write-read access.

PicReferenced

Description
TRUE, when the assigned picture is references the object and is not saved in it. Read only 
access. 

PicTransColor

Description
Defines or returns which color of the assigned bitmap object (.bmp, .dib) should be set to 
"transparent". LONG Write/Read Access.
The color is only set to "Transparent" if the value of the "PicUseTransColor" property is "True".

Picture

Description
Specifies the screen that will be displayed in the graphics object in Runtime. 

Access in Runtime: Read and write

Syntax
Object.Picture[=Image]

Object
Required A ""ScreenItem" object with the formats "GraphicView", "Clock"" or 
""SymbolLibrary".".

Image
Optional A value or a constant that specifies the screen that will be displayed in the graphics 
object in Runtime.

Comments
The picture (*.BMP or *.DIB) must be located in the "GraCS" folder of the current project so 
that it can be integrated.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4451



See also
GraphicView (Page 4014)

Clock (Page 3984)

SymbolLibrary (Page 4098)

PictureAlignment

Description 
Defines or returns the mode of representation of the background image in the process picture. 

LONG write-read access. 

 

See also
Button (Page 3968)

RoundButton (Page 4074)

PictureDeactivated

Description
Specifies the picture that is displayed in the "Deactivated" state.     

Access during runtime: Read and write

Syntax
Object.PictureDeactivated[=Image]

Object
Required A ""ScreenItem" object with the format ""Roundbutton".

Image
Optional A value or a constant that specifies the picture that will be displayed in the 
"Deactivated" status. 

Comments
The picture must be located in the "GraCS" folder of the current project in order to integrate it.
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PictureName

Description
Defines the path and file name of the background image in the process picture or returns it. 
LONG write-read access. 

PictureOff

Description
Specifies the picture that is displayed in the "Off" status.     

Access during runtime: Read and write

Syntax
Object.PictureOff[=Image]

Object
Required A "ScreenItem"" object with the formats ""Button", ""Roundbutton", "Switch"" or 
"GraphicIOField".

Image
Optional A value or a constant that specifies the picture that will be displayed in the "Off" status.

Comments
The picture (*.BMP or *.DIB) must be in the "GraCS" folder of the current project so that you 
can integrate it.

See also
Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

PictureOn

Description
Specifies the screen that will be displayed in the "on" state.   

Access in Runtime: Read and write
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Syntax
Object.PictureOn[=Image]

Object
Required A "ScreenItem" object with the formats "Button", "Roundbutton", "Switch" or 
"GraphicIOField".

Image
Optional A value or a constant that specifies the screen that will be displayed in the "on" state. 

Comments
The screen (*.BMP or *.DIB) must be in the "GraCS" folder of the current project in order to 
be able to integrate it. 

See also
Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

PictureUp

Description
Defines the picture to be displayed in the "Off" status or returns the picture name. 
The picture (*.BMP or *.DIB) must be located in the "GraCS" folder of the current project so 
that it can be integrated.

PicUpReferenced

Description
TRUE, when the picture assigned for the "Off" status should be saved in the object. Otherwise, 
only the associated object reference is saved. Read only access.

PicUpTransparent

Description
Defines or returns which color of the bitmap object (.bmp, .dib) assigned to the "Off" status 
should be set to "transparent". LONG Write/Read Access.
The color is only set to "Transparent" if the value of the "PicUpUseTransColor" property is 
"True".
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PicUpUseTransColor

Description
TRUE, when the transparent color defined by the "PicUpTransparent" property for "Off" status 
should be used. BOOLEAN write-read access.

PicUseTransColor

Description
TRUE, when the transparent color defined by the "PicDeactTransparent" property for the 
"Disable" status should be used. BOOLEAN write-read access. 

Pinned

Description
Defines whether the display of the picture window in Runtime depends on the process picture 
in which the picture window was configured. 

PointCount

Description
Defines or returns the number of corner points. Each corner point has position coordinates 
and is identified via an index.

PointerColor

Description
Specifies the pointer color of the "Gauge" object. 

Access during runtime: Read and Write

Syntax
Object.PointerColor[= Color]

Object
Required An object of the ""ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the pointer color.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4455



Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Gauge (Page 4008)

PointsCount

Description
Specifies the number of corner points of the polyline or of the polygon. 

Access in Runtime: Read and write

Syntax
Object.PointsCount[=Int]

Object
Required A "ScreenItem" object with the formats "Polyline" or "Polygon".

Int
Optional A value or a constant that specifies the number of corner points of the polyline.

See also
Polyline (Page 4060)

Polygon (Page 4057)

TubePolyline (Page 4125)

Position

Description
Defines the presetting for the position of the slider.

This value is used as the start value in Runtime.

To operate the process value linked to this attribute, it is necessary that the process value is 
also linked to the "Position" event. You will find the event "Position" in the "Event" tab, in the 
topic tree under SliderCtrl\Property Topics\Control Properties\Value.
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Precision

Description
Specifies the number of decimal places (0 to 20). 

Access in Runtime: Read and write

Syntax
Object.Precision[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value or a constant that specifies the number of decimal places (0 to 20).

See also
Bar (Page 3961)

PredefinedAngles

Description
Defines or returns the depth of the display of the 3DBarGraph object. Value range from 0 to 3.

0 = cavalier

1 = isometric

2 = axionometric

3 = freely defined

Pressed 

Description
Specifies whether the selected object is displayed in a pressed state. 

Access in Runtime: Read and write

Syntax
Object.Pressed[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "Roundbutton".

BOOLEAN
Optional TRUE, if the selected object is displayed in a pressed state.

See also
Button (Page 3968)

PrintConfiguration

Description
Specifies the log for the printout.   

Access in Runtime: Read and write

Syntax
Object.PrintConfiguration[=HMIPrintConfiguration]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "OnlineTableControl", "AlarmControl" or "UserArchiveControl".

HMIPrintConfiguration
Optional A value or a constant which specifies the log for the printout. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

PrintJobName

Description
Defines the print job triggered by the print function of the "Print" toolbar button. The 
recommended print job is set for the control by default. 

Open the "Select Print Job" dialog using the selection button.   
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Syntax
Object.PrintJobName]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"FunctionTrendControl", "OnlineTableControl", "OnlineTrendControl", "TrendRulerControl", 
"UserArchiveControl".

See also
AlarmControl (Page 3947)

PrintVisibleColumnsOnly

Description
Specifies whether only the current visible columns should be output in quick print. 

Access in Runtime: Read and write

Syntax
Object.PrintVisibleColumnsOnly[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if only the current visible columns should be output in quick print.

Process

Description
Defines or returns presetting for the value to be displayed. 
This value is used in Runtime when the associated tag cannot be connected or updated when 
a picture is started.

Processvalue

Description
Specifies the default for the value to be displayed. 

This value will be used in runtime if the associated tag is not connected or has not been updated 
when the screen starts.   
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Access during runtime: Read and write

Syntax
Object.Processvalue[=DOUBLE]

Object
Necessary. A "ScreenItem" object with the formats "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch", "GraphicIOField", "Bar", "Gauge", "Slider", 
"SymbolLibrary", "CheckBox", "OptionGroup"" or "WindowSlider".

DOUBLE
Optional A value or a constant that includes the default value. 

Comments
If you want to assign the "ProcessValue" SmartTags property, then you must formulate the 
assignment as follows:

'Examples for the assignment of SmartTags

 
'Example 1
IOField.ProcessValue = SmartTags("TagName").Value
'Example 2
HmiRuntime.Screens("Screen_1").ScreenItems("IOField_1").ProcessValue = 
SmartTags("Tag_1").Value

See also
IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicIOField (Page 4011)

Bar (Page 3961)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

DateTimeField (Page 3989)
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Processvalue

Description
Defines the presetting for the value to be displayed. 

This value is used in runtime when a screen is started and the associated tag has not been 
connected nor updated. 

Access during runtime: Read and Write

Syntax
Object.Processvalue [=DOUBLE]

Object
Required. An object of the "ScreenItem" type with the characteristic "Bar," "Gauge", "IOField" 
or "Slider". 

DOUBLE
Optional. A value or constant which contains preset the Web address. 

Remarks
To assign SmartTags to the "ProcessValue" property, you must formulate the assignment as 
follows:

Examples of the assignment of SmartTags
'Example 1
IOField.ProcessValue = SmartTags("TagName").Value
'Example 2
HmiRuntime.Screens("Screen_1").ScreenItems("IOField_1").ProcessValue
 = SmartTags("Tag_1").Value

See also
SymbolLibrary (Page 4098)

Button (Page 3968)

Switch (Page 4089)

ProgID

Description
In the case of non-WinCC controls, the version-independent ProgID is returned as the type.
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See also
ForeignControl (Page 4000)

ProjectPath 

Description
Contains the path and name of the associated project. 

Access in Runtime: Read-only

Syntax
Object.ProjectPath[=String]

Object
Required A "ScreenItem" object with the format "AlarmControl".

String
Optional A value or a constant that specifies which path and name the associated project will 
contain. 

See also
AlarmControl (Page 3947)

Properties Q-R

QualityCode

Description 
Returns the quality of a tag value after reading the tag as SHORT. After a tag has been written, 
the value is invalid. 

Access during runtime: Read

Syntax
Object.QualityCode

Object
Necessary. An object of the "HMIRuntime" type. 
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Example
The following example indicates the quality of the read value when no errors have occurred 
during the reading process:

 
'VBS83
Dim objTag
Dim lngLastErr
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
lngLastErr = objTag.LastError
If 0 = lngLastErr Then
MsgBox objTag.QualityCode
End If

See also
Tag (Page 3941)

Radius

Description
Determines the radius of the given object "Circle."

Access during runtime: Read and Write

Syntax
Object.Radius [= LONG]

Object
Required. An object of the "ScreenItem" type with the characteristic "Circle".

LONG
Optional. A value or constant which determines the radius in pixels.

Radius

Description
Specifies the radius of the selected object "Circle".

Access in Runtime: Read and write
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Syntax
Object.Radius[= LONG]

Object
Required An object of the "ScreenItem" type with the format "Circle", "CircleSegment", 
"CircularArc" or "Roundbutton".

LONG
Optional A value or a constant that specifies the radius in pixels.

See also
Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

RadiusHeight

Description
Determines the secondary axis of the object "Ellipse". 

Access during runtime: Read and Write

Syntax
Object.RadiusHeight

Object
Required. An object of the "ScreenItem" type with the characteristic "Ellipse."

LONG
Optional. A value or constant which determines the secondary axis in pixels.

RadiusHeight 

Description
Specifies the minor axis of the ""Ellipse" object. 

Access in Runtime: Read and write

Syntax
Object.RadiusHeight
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Object
Required A "ScreenItem" object with the formats "Ellipse", "EllipseSegment" or "EllipticalArc".

LONG
Optional A value or a constant that specifies the minor axis in pixels.

See also
Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

TubeArcObject (Page 4121)

RadiusWidth

Description
Determines the main axis of the object "Ellipse". 

Access during runtime: Read and Write

Syntax
Object.RadiusWidth

Object
Required. An object of the "ScreenItem" type with the characteristic "Ellipse."

LONG
Optional. A value or constant which determines the main axis in pixels.

 

RadiusWidth

Description
Specifies the major axis of the "Ellipse" object. 

Access in Runtime: Read and write

Syntax
Object.RadiusWidth
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Object
Required A "ScreenItem" object with the formats "Ellipse", "EllipseSegment" or "EllipticalArc".

LONG
Optional A value or a constant that specifies the major axis in pixels.

See also
Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

TubeArcObject (Page 4121)

ReadOnly

Description
Specifies whether the Control has read and write access in Runtime. 

Access in Runtime: Read and write

Syntax
Object.ReadOnly[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the Control has read and write access in Runtime.

RecipeName

Description
Returns the name of the recipe that is currently being displayed in the "RecipeView". 

Access in Runtime: Read

Syntax
Object.RecipeName

Object
Required A "ScreenItem" object with the format "RecipeView".
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RecipeNumber

Description
Returns the number of the recipe that is currently being displayed in the "RecipeView". 

Access in Runtime: Read

Syntax
Object.RecipeNumber

Object
Required A "ScreenItem" object with the format "RecipeView"".

RecordName

Description
Returns the name of the recipe data record that is currently being displayed in the 
"RecipeView". 

Access in Runtime: Read

Syntax
Object.RecordName

Object
Required A "ScreenItem" object with the formats "RecipeView" or "PrintRecipe".

RecordNumber

Description
Returns the number of the recipe data record that is currently being displayed in the 
"RecipeView". 

Access in Runtime: Read

Syntax
Object.RecordNumber

Object
Required A "ScreenItem" object with the format "RecipeView".
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ReferenceRotationLeft

Description
Defines or returns the X-coordinate of the reference point about which the object should be 
rotated in Runtime. 
The value of the x coordinate is relative to the object width. Enter the value in percent starting 
from the left edge of the rectangle enclosing the object.

ReferenceRotationTop

Description
Defines or returns the Y-coordinate of the reference point about which the object should be 
rotated in Runtime. 

The value of the Y-coordinate is relative to the object height. Enter the value in percent starting 
from the top edge of the rectangle enclosing the object.

RelativeFillLevel

Description
Specifies the fill percentage for the object. 

Access in Runtime: Read and write

Syntax
Object.RelativeFillLevel[=Int]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "Button", "Roundbutton", 
"GraphicView", "Checkbox", "OptionGroup" or "WindowSlider".

Int
Optional A value or a constant that specifies the fill percentage of the object.
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See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

Button (Page 3968)

GraphicView (Page 4014)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Relevant property 

Description
TRUE, when the object will be taken into account when forming the group display. BOOLEAN 
write-read access.

RemoveAssignment

Description 
Removes an entry. 

RemoveAllAssignment

Description 
Deletes all entries.

RightComma property 

Description
Defines or returns the number of decimal places (0 to 20).
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Rotation

Description
Specifies the angle of rotation in degrees of the selected object. The angle of rotation is 
measured counterclockwise. 

Access in Runtime: Read and write

Syntax
Object.Rotation[=SymbolLibRotation]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

SymbolLibRotation
hmiSymbolLibraryRotationNone ( 0): The object rotates by 0 degrees.

hmiSymbolLibraryRotation90Degree ( 90): The object rotates by 90 degrees.

hmiSymbolLibraryRotation180Degree ( 180): The object rotates by 180 degrees.

hmiSymbolLibraryRotation270Degree ( 270): The object rotates by 270 degrees.

See also
SymbolLibrary (Page 4098)

RotationAngle

Description
Specifies the angle of rotation in degrees. 

Access in Runtime: Read and write

Syntax
Object.RotationAngle[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Polygon" or "TextField".

Int
Optional A value or a constant that specifies the angle of rotation in degrees. 
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Comments
In Runtime the object rotates clockwise on the reference point.

See also
Line (Page 4025)

Polyline (Page 4060)

Polygon (Page 4057)

TextField (Page 4107)

TubeTeeObject (Page 4128)

RotationCenterLeft

Description
Establishes the X coordinates of the pivot point to rotate the object in Runtime. 

Access in Runtime: Read and write

Syntax
Object.RotationCenterLeft[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Polygon"" or "TextField".

Int
Optional A value or a constant that specifies the X coordinates of the pivot point to rotate the 
object in runtime.

Comments
The value of the X coordinate is relative to the object width. Specify the value as a percentage 
from the left edge of the rectangle that surrounds the object.

See also
Line (Page 4025)

Polyline (Page 4060)

Polygon (Page 4057)

TextField (Page 4107)
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RotationCenterTop

Description
Specifies the Y coordinates of the pivot point to rotate the object in Runtime. 

Access in Runtime: Read and write

Syntax
Object.RotationCenterTop[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Polygon" or "TextField".

Int
Optional A value or a constant that specifies the Y coordinates of the pivot point to rotate the 
object in Runtime.

Comments
The value of the Y coordinate is relative to the object width. Specify the value as a percentage 
from the upper edge of the rectangle that surrounds the object.

See also
Line (Page 4025)

Polyline (Page 4060)

Polygon (Page 4057)

TextField (Page 4107)

RoundCornerHeight

Description
Defines or returns the corner radius. 
Enter the value as a percentage of half the height of the object.

See also
Rectangle (Page 4072)
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RoundCornerWidth

Description
Defines or returns the corner radius. 
Enter the value as a percentage of half the width of the object. 

See also
Rectangle (Page 4072)

RowNumber

Description
Specifies the row number of the Row object of a Table Control.

See also
AlarmControl (Page 3947)

RowScrollbar

Description
Enables the display of row scroll bars.   

Syntax
Object.RowScrollbar[=ScrollbarVisibility]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "TrendRulerControl" or "OnlineTableControl".

ScrollbarVisibility

Value Description Description
0 no No row scroll bars.
1 as required Row scroll bars are displayed if horizontal space requirements of the 

control are greater than the actually available display area. 
2 always Row scroll bars are always displayed.
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See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

RowSizingEnable 

Description
Specifies whether the row height can be changed. 

The "RowSizingEnable" property is then only disabled if both properties "RowSizingEnable" 
and "AdaptFontSizeToLineHeight" have the value FALSE.   

Access in Runtime: Read and write

Syntax
Object.RowSizingEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the row height can be changed.

See also
AlarmControl (Page 3947)

RowTitleAlign

Row label alignment - RowTitleAlign
Specifies the type of row label alignment.

The following settings are available:

Value Description Description
0 left The row headers are aligned left.
1 centered The row headers are aligned to center.
2 right The row headers are aligned right.

The attribute can be assigned dynamic properties by means of the name RowTitleAlign.
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See also
AlarmControl (Page 3947)

RTPersistence

Description
Specifies how online configurations of WinCC are retained.     

Syntax
Object.RTPersistence[=RTPersistence]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "TrendRulerControl" or "OnlineTableControl" (Runtime Professional) or 
"HMITrendView" (Runtime Advanced).

RTPersistence

Value Description Explanation
0 Discard The current online configurations are discarded at the next picture change.
1 Retain The current online configurations are retained at the next picture change.
2 Reset All online configurations made are lost. The picture is set to the contents 

found in the configuration system.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

RTPersistencePasswordLevel

Description
Displays the authorization for online configuration. You can edit the authorization using the 
selection button. Authorizations are configured in the user administration.     
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Syntax
Object.RTPersistencePasswordLevel

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "TrendRulerControl" or "OnlineTableControl" (Runtime Professional) or 
"HMITrendView" (Runtime Advanced).

See also
AlarmControl (Page 3947)

RTPersistenceType

Description
Specifies how online configurations of WinCC are retained.     

Syntax
Object.RTPersistenceType[=RTPersistenceType]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "TrendRulerControl" or "OnlineTableControl" (Runtime Professional) or 
"HMITrendView" (Runtime Advanced).

RTPersistenceType

Value Description Explanation
0 Do not retain Online configurations are not retained. These are lost at 

the next picture change.
1 Retain during runtime Online configurations are retained during runtime. These 

are lost on exiting.
2 Retain permanently Online configurations are retained permanently. These 

are also available after restart.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)
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RulerColor

Description
Specifies the color of the scale gradation (help line) of the axis label in the "OnlineTrendControl" 
object.     

Access in Runtime: Read and Write

Syntax
Object.RulerColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" (Runtime 
Professional) or "HMITrendView" (Runtime Advanced).

Color
Optional A value or a constant that specifies the color of the scale gradation.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
TrendView (Page 4118)

RulerPrecision(i)

Description
Specifies the number of decimal places with which a measurement value of the specified trend 
will be displayed if it is measured via the function "Display value here". 

Access in Runtime: Read and write

Syntax
Object.RulerPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4477



Int
Optional A value or a constant that specifies the number of decimal places with which a 
measurement value of the specified trend will be displayed if it is measured via the function 
"Display value here".

See also
OnlineTrendControl (Page 4045)

RulerXPrecision(i)

Description
Specifies the number of decimal places with which a measurement value of the X coordinate 
will be displayed. Whether the information is evaluated depends on the value of the property 
"XAxisMode(i)". 

Access in Runtime: Read and write

Syntax
Object.RulerXPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the number of decimal places with which a 
measurement value of the X coordinate will be displayed.

Comments
The parameter i indicates the number of the trend. 

You use the function "Display value here" to view the X coordinate of the measurement value.

See also
FunctionTrendControl (Page 4004)

RulerYPrecision(i) 

Description
Specifies the number of decimal places with which a measurement value of the Y coordinate 
will be displayed. Whether the information is evaluated depends on the value of the property 
"XAxisMode(i)".".
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Access in Runtime: Read and write

Syntax
Object.RulerYPrecision(i)[=Int]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the number of decimal places with which a 
measurement value of the Y coordinate will be displayed. 

Comments
The parameter i indicates the number of the trend. 

You use the function "Display value here" to view the Y coordinate of the measurement value.

See also
FunctionTrendControl (Page 4004)

Properties S

SameSize

Description
TRUE, when all four buttons of a Group Display object have the same size. BOOLEAN write-
read access.

ScaleColor

Description
Specifies the color of the scale of the selected object.     

Access in Runtime: Read and write

Syntax
Object.ScaleColor[= Color]
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Object
Required An object of the "ScreenItem" type with the format "Bar" or "OnlineTrendControl" 
(Runtime Professional) or "HMITrendView" (Runtime Advanced).

Color
Optional A value or a constant that specifies the color of the scale.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBS color 
constants like vbRed or vbGreen.

ScreenItem object with the format "Bar": For the color to be displayed, the property 
""ShowScale" must have the value TRUE.

See also
Bar (Page 3961)

TrendView (Page 4118)

ScaleGradation 

Description
Specifies the distance between two large marking lengths of the scale. 

Access in Runtime: Read and write

Syntax
Object.ScaleGradation[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the distance between two large marking lengths 
of the scale.

See also
Bar (Page 3961)
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ScaleLabelColor

Description
Specifies the color of the label for the scale gradation of the "Gauge" object. 

Access during runtime: Read and Write

Syntax
Object.ScaleLabelColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the label color of the scale gradation.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Gauge (Page 4008)

ScaleNumerator

Description
Defines the counter for scaling on the client.   

Syntax
Object.ScaleNumerator =[Int]

Object
Required A "ScreenItem" object with the format "SmartClientView".

Int
Optional A value or a constant that specifies the value.
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See also
SmartClientView (Page 4085)

ScalePosition

Description
Specifies the position of the scale of the selected object. The "ShowScale" property must be 
set to TRUE  so that the scale can be displayed. 

Access in Runtime: Read and write

Syntax
Object.ScalePosition[=ScalePosition]

Object
Required A "ScreenItem" object with the format "Bar".

ScalePosition
hmiScalePositionLeftUp ( 0): For a vertical bar the scale will be displayed at the top. For a 
horizontal bar the scale will be shown at the left.

hmiScalePositionRightDown ( 1): For a vertical bar the scale will be displayed at the bottom. 
For a horizontal bar the scale will be shown at the right.

See also
Bar (Page 3961)

ScaleTickColor

Description
Specifies the color of the scale gradation of the "Gauge" object. 

Access in Runtime: Read and write

Syntax
Object.ScaleTickColor[= Color]

Object
Required A "ScreenItem" object with the format "Gauge".

Color
Optional A value or a constant that specifies the color of the scale gradation.
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Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Gauge (Page 4008)

ScaleTickLabelPosition

Description
Specifies the diameter of the assumed circle on which the label of the scale divisions is located. 

Access in Runtime: Read and write

Syntax
Object.ScaleTickLabelPosition[=Double]

Object
Required A "ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the diameter of the assumed circle on which the 
label of the scale division is located. 

Value range from 0 to 1

0: The label is located in the center of the scale.

1: The diameter of the assumed circle for the label is the smaller value of the geometry 
properties "Width" and "Height". A part of the label can lie outside the object limits and is 
therefore invisible.

See also
Gauge (Page 4008)

ScaleTickLength

Description
Specifies the length of the main markings for the scale division. The value refers to half the 
smaller value of the geometry properties "Width" and "Height".

The length of the marking lengths for the fine divisions is 0.5* scale width. 
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Access in Runtime: Read and write

Syntax
Object.ScaleTickLength[=Double]

Object
Required A "ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the length of the main markings of the scale.

Value range 0 to scale end value 

0: There are no scale divisions. The divisions of the scale in the areas are not visible. 

Scale end value: The scale divsion ranges from the mid point of the scale disc to the value 
specified by the scale end value.

See also
Gauge (Page 4008)

ScaleTickPosition

Description
Specifies the diameter of the assumed circle on which the scale divisions are located. 

The main markings of the scale divisions lie with their outward-facing ends on this circle. 

Access in Runtime: Read and write

Syntax
Object.ScaleTickPosition[=Double]

Object
Required A "ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the diameter of the assumed circle on which the 
scale divisions are located. 

Value range from 0 to 1 

0: The scale divisions are located in the center of the scale. 

1: The diameter of the assumed circle for the label is the scale divisions is the smaller value 
of the geometry properties ""Width" and "Height".
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See also
Gauge (Page 4008)

ScaleTicks

Description
Defines the number of segments into which the bar will be subdivided by large tick marks of 
the scale:
0-100: Object can be divided into a maximum of 100 segments
= 0: The optimum number of segments is set automatically.

ScaleDenumerator

Description
Defines the counter for scaling on the client.   

Syntax
Object.ScaleDenumerator=[Int]

Object
Required A "ScreenItem" object with the format "SmartClientView".

Int
Optional A value or a constant that specifies the value.

See also
SmartClientView (Page 4085)

Scaling

Description
TRUE, when a scale should also be used to represent a value. BOOLEAN write-read access. 

See also
SmartClientView (Page 4085)
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ScalingType 

Description
Specifies the type of bar scaling. 

Access in Runtime: Read and write

Syntax
Object.ScalingType[=BarScalingType]

Object
Required A "ScreenItem" object with the format "Bar"".

BarScalingType
Optional A value or a constant that specifies the type of bar scaling.

● hmiBarScalingLinear ( 0): Linear
The large marks are distributed evenly over the scale. The distance between the large 
marks corresponds to the value of the "axis section" attribute.

● hmiBarScalingLogarithmic ( 1): Logarithmic
The distribution of the large marks on the scale follows a logarithmic function.
The reprsentation of low values is very strongly highlighted.

● hmiBarScalingNegativeLogarithmic ( 2): Negative logarithmic
The distribution of the large marks on the scale follows a negative logarithmic function. The 
representation of high values is very strongly highlighted.

● hmiBarScalingAutomatic ( 3): Automatic
The large marks are distributed evenly over the scale. The distance between the large 
marks is specified automatically.

● hmiBarScalingTangent ( 4): Tangents
The distribution of the large marks on the scale highlights the representation of the low and 
high values.

● hmiBarScalingQuadratic( 5): Square
The distribution of the large marks follows a square function. The representation of high 
values is highlighted.

● hmiBarScalingCubic ( 6): Cubic
The distribution of the large marks on the scale follows a cubic function. This highlights the 
representation of large values.

Comments
For the color to be displayed, the property "ShowScale" must have the value TRUE.

See also
Bar (Page 3961)
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ScreenItems

Description
Returns the ScreenItems list. 

Access in Runtime: Read

Syntax
Object.ScreenItems

Object
Required A "ScreenItems"." object.

ScreenName

Description
Defines the picture to be displayed in the picture window in Runtime or returns the picture 
name. 

 

 Note

Always enter picture names without the extension "PDL" for reasons of compatibility with 
future versions.

 

See also
ScreenWindow (Page 4078)

Screens

Description
Returns the Screens list. The Screens list contains two elements: The first element with the 
index 0 represents the permanent window. The second element with the index 1 represents 
the root screen. Alternatively, the two elements can be addressed by means of their names. 
Use "Overview" for the permanent window and "Base" for the root screen. 

Note

The alarm window and the alarm indicator are not contained in the Screens list, even if they 
have the focus in Runtime.

Access in Runtime: Read
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Syntax
Object.Screens

Object
Required A "Screens" object.

Scrollable

Description
Specifies whether the DXF screen display supports the Scroll functions in Runtime mode. 

Access in Runtime: Read and write

Syntax
Object.Scrollable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "DXFView".

BOOLEAN
Optional TRUE, if the DXF screen display supports the Scroll functions in Runtime mode.

ScrollBars

Description
TRUE, when the object is equipped with a scroll bar in Runtime. Read only access.

ScrollPositionX

Description
Specifies the horizontal positioning of the scroll bar in a picture window with slider, or returns 
its value.

The picture is displayed in the picture window by positioning the horizontal and vertical scroll 
bars. If you wish to display the picture as a cutout where the scroll bars are located at the left 
and upper edge of the picture, use the properties "OffsetLeft" and "OffsetTop" as the origin of 
this cutout.
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ScrollPositionY

Description
Specifies the vertical positioning of the scroll bar in a picture window with slider, or returns its 
value.

The picture is displayed in the picture window by positioning the horizontal and vertical scroll 
bars. If you wish to display the picture as a cutout where the scroll bars are located at the left 
and upper edge of the picture, use the properties "OffsetLeft" and "OffsetTop" as the origin of 
this cutout.

SecondNeedleHeight

Description
Specifies the length of the second hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.SecondNeedleHeight[= LONG]

Object
Required A ""ScreenItem" object with the format "Clock".

LONG
Optional A value or a constant that specifies the length of the second hand.

Specify the length of the second hand as a percentage relating to the radius of the clock face.

See also
Clock (Page 3984)

SecondNeedleWidth

Description
Specifies the width of the second hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.SecondNeedleWidth[= LONG]
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Object
Required An object of the type "ScreenItem" with the definition "Clock".

LONG
Optional A value or a constant that specifies the width of the second hand. Specify the width 
as a percentage relating to double the length of the second hand.

See also
Clock (Page 3984)

SegmentColoring

Description
Specifies the type of color change that should be displayed in the "Bar" if the limits are 
exceeded. 

Access in Runtime: Read and write

Syntax
Object.SegmentColoring[= THmiBarColorType]

Object
Required A "ScreenItem" object with the format "Bar".

THmiBarColorType
Optional A value or a constant that specifies the type of color change. Value range from 0 to 
1.

hmiBarColorEntire (0): Color change applied to the entire bar.

hmiBarColorSegmented (1): Color change applied to segments.

See also
Bar (Page 3961)

SelBGColor 

Description
Defines or returns the background color of the selected entry in a text list object. LONG write-
read access.
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SelectedText

Description
Shows the text defined with the "Selected field" (SelIndex) attribute which is highlighted in the 
combobox or list box. 

See also
Listbox (Page 4027)

SelectBackColor

Description
Specifies the background color of the selected text entry for the selected object. 

Access in Runtime: Read and write

Syntax
Object.SelectBackColor[=Color]

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

Color
Optional A value or a constant that specifies the background color of the selected text entry 
of the selected object.

See also
SymbolicIOField (Page 4093)

SelectedCellColor

Description
Specifies the background color of a selected cell. You open a color selection dialog box with 
the button.   

Access in Runtime: Read and write

Syntax
Object.SelectedCellColor=[Color]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

Color
Optional A value or a constant which specifies the background color.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SelectedCellForeColor

Description
Specifies the font color of the selected cell. You open a color selection dialog box with the 
button.   

Access in Runtime: Read and write

Syntax
Object.SelectedCellForeColor=[Color]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

Color
Optional A value or a constant which specifies the font color.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)
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SelectedIndex

Description
Defines and returns the index of which the associated text is highlighted in the combobox or 
list box. 

The maximum value is the number of lines (NumberLines) of the object. 

See also
Listbox (Page 4027)

SelectedRowColor

Description
Specifies the background color of the selected line. You open a color selection dialog box with 
the button.   

Access in Runtime: Read and write

Syntax
Object.SelectedRowColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

Color
Optional A value or a constant which specifies the background color.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SelectedRowForeColor

Description
Specifies the font color of the selected row. You open a color selection dialog box with the 
button.   
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Access in Runtime: Read and write

Syntax
Object.SelectedRowForeColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "MessageView",  
"OnlineTableControl", "RecipeView", "RulerControl".

Color
Optional A value or a constant which specifies the font color.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SelectedTitleColor

Description
Specifies the background color of a selected table header. You open a color selection dialog 
box with the button. 

The settings are only active in Runtime if the "Marking color" option is enabled.   

Access in Runtime: Read and write

Syntax
Object.SelectedTitleColor[=Color]

 

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

Color
Optional A value or a constant which specifies the background color.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SelectedTitleForeColor

Description
Specifies the font color of the marked table header. You open the color selection dialog box 
with the button.

The setting is only effective in Runtime when the "Marking color" option is activated.    

Access in Runtime: Read and write

Syntax
Object.SelectedTitleForeColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

Color
Optional A value or a constant which specifies the font color.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SelectForeColor 

Description
Specifies the color of the selected text entry for the selected object. 

Access in Runtime: Read and write
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Syntax
Object.SelectForeColor[=Color]

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

Color
Optional A value or a constant that specifies the color of the selected text entry of the selected 
object.

See also
SymbolicIOField (Page 4093)

SelectionBackColor

Description
Specifies the background color of the selected cells. 

Access in Runtime: Read and write

Syntax
Object.SelectionBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl", 
"StatusForce", "OnlineTrendControl", "AlarmControl", "UserView".

Color
Optional A value or a constant that sepcifies the background color of the selected row.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
TrendView (Page 4118)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4496 System Manual, 07/2013,  



SelectionBackColor

Description
Determines the background color of the selected cells. 

Access during runtime: Read and Write

Syntax
Object.SelectionBackColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView," 
"StatusForce", "MessageView" or "UserView".

Color
Optional A value or constant which determines the background color of the selected row.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
AlarmView (Page 3958)

RecipeView (Page 4068)

StatusForce (Page 4087)

UserView  (Page 4137)

SelectionColoring

Description
Enables the use of selection colors for cells or rows.   

Access in Runtime: Read and write

Syntax
Object.SelectionColoring[=GridSelectionColoring]
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Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

GridSelectionColoring:

Value Description Description
0 None No selection colors for cells and rows.
1 Cell Selection color for cell.
2 Row Selection color for row.
3 Cell and row Selection colors for cell and row.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SelectionForeColor

Description
Specifies the foreground color of the selected cells.   

Access in Runtime: Read and write

Syntax
Object.SelectionForeColor

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

Comments
You can use the "RGB" function to specify the color in RGB format (red, green blue). To do 
this, enter the appropriate decimal value for each of the three RGB values (range from 0 to 
255). For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the 
VBS color constants like vbRed or vbGreen.

See also
TrendView (Page 4118)
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SelectionForeColor 

Description
Determines the foreground color of the selected cells. 

Access during runtime: Read and Write

Syntax
Object.SelectionForeColor

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView," 
"StatusForce", "MessageView" or "UserView".

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
AlarmView (Page 3958)

RecipeView (Page 4068)

StatusForce (Page 4087)

UserView  (Page 4137)

SelectionMode

Description
Defines whether and how a message line can be selected.

.  

Access in Runtime: Read and write

Syntax
Object.SelectionMode[=Mode]

Object
Required A "ScreenItem" object with the format "MessageView".
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Mode
0 - NoSelection: Prevents the selection of a message. Acknowledgement affects the oldest 
pending message.

1 - Cell: Enables the selection of fields in the message line. Acknowledgement affects the 
selected message.

2 - Line: Enables the selection of a message line. Acknowledgement affects the selected 
message.

SelectionMode

Description
Specifies whether and how the alarm line can be selected.   

Access in Runtime: Read and write

Syntax
Object.SelectionMode[=AlarmViewAdvancedSelectionMode]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

AlarmViewAdvancedSelectionMode
hmiAlarmViewAdvancedSelectionModeNone ( 0): Prevents the selection of an alarm. An 
acknowledgement always affects the oldest pending alarm.

hmiAlarmViewAdvancedSelectionModeCell ( 1): Enables the selection of fields in the alarm 
line. An acknowledgement always effects the selected alarm.

hmiAlarmViewAdvancedSelectionModeLine ( 2): Enables the selection of an alarm line. An 
acknowledgement always effects the selected alarm.

See also
AlarmControl (Page 3947)

SelectionRect

Description
Enables the use of a selection border for selected cells or rows.   

Access in Runtime: Read and write

Syntax
Object.SelectionRect[=GridSelectionBorder]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

GridSelectionBorder.

Value Description Description
0 None No selection border is drawn for selected cells or rows.
1 Cell A selection border is drawn for the selected cell.
2 Row A selection border is drawn for the selected row.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SelectionRectColor

Description
Specifies the color of the rectangle in the message window if SelectionType equals "1". 

Access in Runtime: Read and write

Syntax
Object.SelectionRectColor[=Color]

Object
Required A "ScreenItem" object with the format "MessageView".

Color
Optional A value or a constant which specifies the color.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)
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SelectionRectWidth

Description
Specifies the line width of the selection rectangle in the message window when the the 
SelectionType is "1".   

Access in Runtime: Read and write

Syntax
Object.SelectionRectWidth[=Int]

Object
Required A "ScreenItem" object with the format "MessageView".

Int
Optional A value or a constant which specifies the line width.

 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SelectionType

Description
Specifies the number of lines you can mark. 

The following settings are available:

Value Description Explanation
0 None No line is marked.
1 Single selection One line can be marked.
2 Multiple selection Several lines can be marked.

The attribute can be made dynamic with the name SelectionType. The data type is LONG.
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SelTextColor

Description
Defines or returns the color of the text of the selected entry in the text list object. LONG write-
read access.

SeparatorBackColor

Description
Specifies the background color of the broken separation lines in the selection list of the 
specified object. 

Access in Runtime: Read and write

Syntax
Object.SeparatorBackColor[=Color]

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

Color
Optional A value or a constant that specifies the background color of the broken separation 
lines in the selection list of the specified object.

See also
SymbolicIOField (Page 4093)

SeparatorColor

Description
Specifies the color of the separation lines in the selection list of the specified object. 

Access in Runtime: Read and write

Syntax
Object.SeparatorColor[=Color]

Object
Required A "ScreenItem" object with the format "SymbolicIOField".
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Color
Optional A value or a constant that specifies the color of the separation lines in the selection 
list of the specified object.

See also
SymbolicIOField (Page 4093)

SeparatorCornerStyle

Description
Specifies the shape of the corners for the object of the type "ScreenItem" with the format 
"SymbolicIOField".   

See also
SymbolicIOField (Page 4093)

SeparatorStyle

Description
Specifies the line style of the separation lines in the selection list of the selected object.   

Access in Runtime: Read and write

Syntax
Object.SeperatorStyle[=LineStyle]

 

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

LineStyle
hmiLineStyleNone (-1): The selection list has no separation lines.

hmiLineStyleSolid ( 0): The selection list has solid separation lines.

hmiLineStyleDash ( 1): The selection list has broken separation lines.

hmiLineStyleDot ( 2): The selection list has dotted separation lines.

hmiLineStyleDashDot ( 3): The selection list has dash - dot lines as separation lines.

hmiLineStyleDashDotDot ( 4): The selection list has dash - dot - dot lines as separation lines.
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See also
SymbolicIOField (Page 4093)

SeparatorWidth

Description
Specifies the width of the separation lines in the selection list of the specified object. 

Access in Runtime: Read and write

Syntax
Object.SeparatorWidth[=Int]

Object
Required A "ScreenItem" object with the format "SymbolicIOField"".

Int
Optional A value or a constant that specifies the width of the separation lines in the selection 
list of the specified object.

See also
SymbolicIOField (Page 4093)

SeperatorLineEndShapeStyle

Description
Specifies the shape of the line ends for the object of the type "ScreenItem" with the format 
"SymbolicIOField".

See also
SymbolicIOField (Page 4093)

ServerScale

Description
Establishes whether the Sm@rtClient view should be zoomed in or out.   
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Syntax
Object.ServerScale =[Int]

Object
Required A "ScreenItem" object with the format "SmartClientView".

Int
Optional A value or a constant that specifies the value.

See also
SmartClientView (Page 4085)

ServerNames 

Description
Specifies the servers of a distributed system from which the message view draws data. The 
information is given in form of: NameServer1;NameServer2;NameServer3. 

Access in Runtime: Read-only

Syntax
Object.ServerNames[=String]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl" or "UserName".

String
Optional A value or a constant that specifies the server of a distributed system from which the 
alarm window receives information.

See also
AlarmControl (Page 3947)

ServerPrefix

Description
Defines the server containing the picture to be displayed in the picture window in Runtime or 
returns the server name. 
Enter the server name followed by two colons: "<Servername>::". No check is made as to 
whether the server actually exists.
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SetAllAssignment

Description 
Sets all entries.

SetSelection

Description
Sets a list of the lines which are selected.

SetpointTrendArchiveStartId(i) 

Description
Specifies the starting position from which the values of the setpoint trend will be read from the 
recipe. Whether the information is evaluated depends on the value of the property 
"ShowSetpointTrend(i)".   

Access in Runtime: Read and write

Syntax
Object.SetpointTrendArchiveStartId(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the starting position from which the values of the 
setpoint trend will be read from the recipe.

Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 4004)
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SetpointTrendColor(i)

Description
Specifies the color of a setpoint trend. Whether the information is evaluated depends on the 
value of the property "ShowSetpointTrend(i)". 

Access in Runtime: Read and write

Syntax
Object.SetpointTrendColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

Color
Optional A value or a constant that specifies the color of a setpoint trend.

Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 4004)

SetpointTrendNumberOfValues(i)

Description
Specifies the number of value pairs of a setpoint trend. Whether the information is evaluated 
depends on the value of the property "ShowSetpointTrend(i)". 

Access in Runtime: Read and write

Syntax
Object.SetpointTrendNumberOfValues(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the number of value pairs of a setpoint trend. 
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Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 4004)

SetProps

Description
Sets the value of the property.

ShareTimeAxis

Description
Specifies whether the trends of a trend window are displayed with a shared X axis.

Access in Runtime: Read and write

Syntax
Object.ShareTimeAxis[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional. TRUE, if the trends of the trend window are displayed with a shared X axis.

See also
OnlineTrendControl (Page 4045)

ShareTimeColumn

Description
Specifies whether a shared time column will be used in the table window. 

Access in Runtime: Read and write

Syntax
Object.ShareTimeColumn[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE, if a shared time column will be used in the table window.

See also
OnlineTableControl (Page 4037)

ShareValueAxis 

Description
Specifies whether the trends of a trend window are displayed with a shared Y axis. 

Access in Runtime: Read and write

Syntax
Object.ShareValueAxis[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE, if the trends of the trend window are displayed with a shared Y axis.

See also
OnlineTrendControl (Page 4045)

ShareXAxis

Description
Specifies whether the trends of a trend window are displayed with a shared X axis.   

Access in Runtime: Read and write

Syntax
Object.ShareXAxis[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".
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BOOLEAN
Optional TRUE, if the trends of the trend window are displayed with a shared X axis.

See also
FunctionTrendControl (Page 4004)

ShareYAxis

Description
Specifies whether the trends of a trend window are displayed with a shared Y axis. 

Access in Runtime: Read and write

Syntax
Object.ShareYAxis[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if the trends of the trend window are displayed with a shared Y axis.

See also
FunctionTrendControl (Page 4004)

Shared

Description
Specifies that an HMI device is shared by several Sm@rtClient Views.   

Syntax
Object.Shared[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "SmartClientView".

See also
SmartClientView (Page 4085)
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ShiftDecimalPointReadOnlySpecial 

Description
Specifies that the "Shift decimal point" field can only be read. 

Access in Runtime: Read and write

Syntax
Object.ShiftDecimalPointReadOnlySpecial[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the "Shift decimal point" field can only be read. 

See also
IOField (Page 4021)

ShortenCellText

Description
Specifies whether the content of the fields of an alarm line should be shortened if the column 
width is too small. 

Access in Runtime: Read and write

Syntax
Object.ShortenCellText[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the content of the fields of an alarm line should be shortened if the column 
width is too small.

See also
AlarmControl (Page 3947)
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ShortenColumnHeaderText

Description
Specifies whether the content of the fields of a title line should be shortened if the column width 
is too small. 

Access in Runtime: Read and write

Syntax
Object.ShortenColumnHeaderText[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the content of the fields of a title line should be shortened if the column width 
is too small.

See also
AlarmControl (Page 3947)

ShowAlarmsFromDate

Description
Specifies that only those message events are displayed that are saved in this tag.   

Access in Runtime: Read and write

Syntax
Object.ShowAlarmsFromDate[=Tag]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

Tag
Optional A value or a constant which specifies that only those message events are displayed 
that are saved in this tag.

See also
AlarmView (Page 3958)
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ShowBadTagState
Defines whether the object is grayed out when a bad QualityCode or tag status is detected.

Yes If the quality code or the the tag status are poor, the object is grayed out or the 
settings for the grid color are used.

No If the quality code or the the tag status are poor, the object is not grayed out or the 
settings for the grid color are not used.

See also
CheckBox (Page 3974)

Bar (Page 3961)

WindowSlider (Page 4139)

SymbolicIOField (Page 4093)

IOField (Page 4021)

OptionGroup (Page 4054)

ShowBar

Description
Specifies whether the displayed process value in the "Slider" object is also shown by a filled 
bar. 

Access in Runtime: Read and write

Syntax
Object.ShowBar

Object
Required A "ScreenItem" object with the format "Slider".

Optional TRUE, if the process value is also shown by a filled bar.

See also
Slider (Page 4082)

ShowBorder

Description
Specifies whether the window will be shown with a border. 
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Access in Runtime: Read and write

Syntax
Object.ShowBorder[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE if the window is to be shown with a border.

ShowCaption

Description
Specifies whether the title line is hidden or shown. 

+C1763

Access in Runtime: Read and write

Syntax
Object.ShowCaption[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format 
"OnlineTrendControl","FunctionTrendControl", "OnlineTableControl", "AlamControl", 
"ScreenWindow", "ApplicationWindow" or "UserArchiveControl".

BOOLEAN
Optional TRUE, if the title line is shown.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

ScreenWindow (Page 4078)

ScriptDiagnostics (Page 4080)
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ShowColumn(i)

Description
Specifies whether a column pair that is referenced via the "CurrentColumnIndex" property is 
shown. 

Access in Runtime: Read and write

Syntax
Object.ShowColumn(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE, if a column pair that is referenced via the "CurrentColumnIndex" property is 
shown.

See also
OnlineTableControl (Page 4037)

ShowCurve(i) 

Description
Specifies whether a trend that is referenced via the "CurrentCurveIndex" property is shown. 

Access in Runtime: Read and write

Syntax
Object.ShowCurve(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if a trend that is referenced via the "CurrentCurveIndex" property is shown.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)
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ShowDecimalPoint

Description
Specifies whether the scale is identified with decimal figures (decimal point and one decimal 
place) or with whole integers. 

Access in Runtime: Read and write

Syntax
Object.ShowDecimalPoint[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the scale is identified with decimal figures (decimal point and one decimal 
place).

See also
Gauge (Page 4008)

ShowFillLevel

Description
Specifies whether the selected object is filled. 

Access in Runtime: Read and write

Syntax
Object.ShowFillLevel[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "Button", "Roundbutton", 
"GraphicView", "Checkbox", "OptionGroup"" or "WindowSlider".".

BOOLEAN
Optional TRUE, if the selected object is filled.
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See also
Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

Button (Page 3968)

GraphicView (Page 4014)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

ShowFocusRectangle

Description
Specifies whether the button is given a selection border when it is activated in Runtime. 

Access in Runtime: Read and write

Syntax
Object.ShowFocusRectangle[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Clock".

BOOLEAN
Optional TRUE, if the button is given a selection border when it is activated in Runtime.

See also
Clock (Page 3984)

ShowInputControls

Description
Establishes whether additional fields exist for entering the address and password.   
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Syntax
Object.ShowInputControls

Object
Required A "ScreenItem" object with the format "SmartClientView".

ShowLargeTicksOnly

Description
Defines or returns the length of the axis section in pixels. 

See also
Bar (Page 3961)

ShowLimitMarkers

Description
Specifies whether the limit value is shown as a scale value. 

Access in Runtime: Read and write

Syntax
Object.ShowLimitMarkers[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the limit value is shown as a scale value.

See also
Bar (Page 3961)

ShowMainFrame

Description
Specifies whether the entire bar object is provided with a border. 

Access in Runtime: Read and write
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Syntax
Object.ShowMainFrame[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Option TRUE, if the entire bar object is shown with a border.

See also
Bar (Page 3961)

ShowMessagesAtDate

Description
Determines at which time the alarms will be displayed. 

 

 Note

This function does not filter out alarms, it positions the display range of the alarm list as of 
the specified date.

 

Access during runtime: Read and Write

Syntax
Object.ShowMessagesAtDate [= DATE]

Object
Required. An object of the "MessageView" type.

Remarks

To assign SmartTags to the "ShowMessagesAtDate" property, you must formulate the 
assignment as follows:

'Example 1
HmiRuntime.Screens("Screen_1").ScreenItems("Alarm 
view_1").ShowMessagesAtDate = SmartTags("intern_1").Value
'Example 2
HmiRuntime.Screens("Screen_1").ScreenItems("Alarm 
view_1").ShowMessagesAtDate = CDate(SmartTags("intern_1"))
SmartTag "intern_1" must be of the "DateTime" type.
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See also
AlarmView (Page 3958)

ShowOverflowIndicator

Description
Specifies whether an overflow indicator is shown when the process value exceeds or falls short 
of the limit value. 

Access in Runtime: Read and write

Syntax
Object.ShowOverflowIndicator[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Bar".".

BOOLEAN
TRUE, if an overflow indicator is shown when the process value exceeds or falls short of the 
limit value.

See also
Bar (Page 3961)

ShowPeakValuePointer 

Description
Specifies whether a slave pointer will be used for the selected object. 

The slave pointer shows the maximum pointer deflection provided in Runtime while the process 
screen is loaded. If you reload the process screen, the slave pointer will be reset.

Access in Runtime: Read and write

Syntax
Object.ShowPeakValuePointer[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the slave pointer is used.
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See also
Gauge (Page 4008)

ShowPeakValuePointer

Description
Determines whether a pointer for the given object is to be used. 

The pointer shows the maximum hand deflection in runtime as long as the process screen is 
loaded. When you reload the process screen, the pointer is reset.

Access during runtime: Read and Write

Syntax
Object.ShowPeakValuePointer [= BOOLEAN]

Object
Required. An object of the "ScreenItem" type with the characteristic "Gauge".

BOOLEAN
Optional. TRUE, if the pointer is used.

ShowPosition

Description
Specifies whether the value of the current slider position should also be displayed numerically. 
The value is then displayed beneath the slider. 

Access in Runtime: Read and write

Syntax
Object.ShowPosition[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Slider".

BOOLEAN
Optional TRUE, if the value is also shown.

See also
Slider (Page 4082)
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ShowRowHeaders

Description
Specifies whether the message view contains a column with consecutive numbering of the 
existing messages. 

Access in Runtime: Read and write

Syntax
Object.ShowRowHeaders[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the message view contains a column with consecutive numbering of the 
existing messages.

See also
AlarmControl (Page 3947)

ShowRuler 

Description
Specifies whether a scale division (help line) is displayed for an axis label of the object 
"OnlineTrendControl".   

Access in Runtime: Read and write

Syntax
Object.ShowRuler[= BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"OnlineTrendControl" or "FunctionTrendControl".

BOOLEAN
Optional TRUE, if the scale gradation is shown.
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See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ShowRuler

Description
Determines whether a scale gradation (help lines) is expanded for the axis label of the object 
"TrendView". 

Access during runtime: Read and Write

Syntax
Object.ShowRuler [= BOOLEAN]

Object
Required. An object of the "ScreenItem" type with the characteristic "TrendView".

BOOLEAN
Optional. TRUE, if the scale gradation is shown.

See also
TrendView (Page 4118)

ShowRulerInAxis

Description
Enables the display of rulers in the time axis.     

Access in Runtime: Read and write

Syntax
Object.ShowRulerInAxis[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The rulers are also displayed in the time axes.

FALSE: The rulers are not displayed in the time axes.
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See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

ShowScale

Description
Specifies whether the values will also be shown in a scale. 

Access in Runtime: Read and write

Syntax
Object.ShowScale[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the values will also be shown in a scale.

See also
Bar (Page 3961)

ShowScrollbars

Description
Scroll bars - ShowScrollbars

Enables the display of scroll bars.     

Access in Runtime: Read and write

Syntax
Object.ShowScrollbars[=ShowScrollbars]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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ShowScrollbars

Value Description Explanation
0 no The display of scroll bars is disabled.
1 as required Scroll bars are displayed if space requirements of the control are greater 

than the actual display area. 
2 always The scroll bars are always displayed.

See also
ScreenWindow (Page 4078)

FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

ShowSetpointTrend(i)

Description
Specifies whether a setpoint trend that belongs to a trend that is referenced via 
"CurrentCurveIndex" should be shown. 

Access in Runtime: Read and write

Syntax
Object.ShowSetpointTrend(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if a setpoint trend that belongs to a trend that is referenced via 
CurrentCurveIndex" should be shown.

See also
FunctionTrendControl (Page 4004)

ShowSortButton

Description
Enables the display of a sorting button above the vertical scroll bar. Click this sorting button 
to sort the selected column based on the configured sorting criteria. The sorting button is not 
displayed if the table does not contain a vertical scroll bar.   
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Access in Runtime: Read and write

Syntax
Object.ShowSortButton[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

BOOLEAN
TRUE: The sorting key is displayed. You can sort the selected column.

FALSE: The sorting key is not displayed.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

ShowSortIcon

Description
Enables the display of the sorting icon.   

Access in Runtime: Read and write

Syntax
Object.ShowSortIcon[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

BOOLEAN
TRUE: The sorting icon is displayed.

FALSE: The sorting icon is not displayed.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

ShowSortIndex

Description
Specifies whether a sort index is displayed.     

Access in Runtime: Read and write

Syntax
Object.ShowSortIcon[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

BOOLEAN
TRUE: A sort index is displayed.

FALSE: A sort index is not displayed.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

ShowStatusBar

Description
Specifies whether the status bar is shown. 

Access in Runtime: Read and write

Syntax
Object.ShowStatusBar[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl" or "HTMLBrowser".

BOOLEAN
Optional TRUE, if the status bar is shown.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

MediaPlayer (Page 4030)

ShowTableGridlines

Description
Specifies whether the gridlines are shown in the table of the selected object. 

Access in Runtime: Read and write

Syntax
Object.ShowTableGridlines[= BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "StatusForce", 
"OnlineTrendControl" or "UserView".

BOOLEAN
Optional TRUE, if gridlines are shown.

See also
TrendView (Page 4118)

ShowTableGridlines

Description
Determines whether gridlines are shown in the table of the given object. 
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Access during runtime: Read and Write

Syntax
Object.ShowTableGridlines [= BOOLEAN]

Object
Required. An object of the "ScreenItem" type with the characteristic "StatusForce".

BOOLEAN
Optional. TRUE, if gridlines are displayed.

See also
StatusForce (Page 4087)

UserView  (Page 4137)

ShowThumb

Description
Specifies whether the slider of the "Slider" object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.ShowThumb[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Slider".

BOOLEAN
Optional TRUE, if the slider is shown.

See also
Slider (Page 4082)

ShowTickLabels

Description
Specifies whether the label is shown in the scale.     

Access during runtime: Read and write
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Syntax
Object.ShowTickLabels[= BOOLEAN]

Object
Necessary. A "ScreenItem" object with the formats "Bar" or "Slider".

BOOLEAN
Optional TRUE, if the label is shown.

Comments
The increments for the measured value are automatically established dependent upon the 
specified measurement range and the size of the object.

Used for the following object types:
Slider

 

See also
Bar (Page 3961)

Slider (Page 4082)

ShowTicks

Description
Specifies whether the marking lengths are shown in the scale of the selected object.     

Access during runtime: Read and write

Syntax
Object.ShowTicks[= BOOLEAN]

Object
Necessary. A "ScreenItem" object with the formats "Clock" or "Slider".

BOOLEAN
Optional TRUE, if the marking lengths are shown.

Used for the following object types: 
Slider
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See also
Clock (Page 3984)

Slider (Page 4082)

ShowTitle

Description
Defines representation the Control window header.     

Access in Runtime: Read and write

Syntax
Object.ShowTitle[=WindowHeaderStyle]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "FunctionTrendControl", "UserArchiveControl", "TrendRulerControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

WindowHeaderStyle

Value Designation Description
0 No No window title.
1 Normal The window title consists of a WinCC icon and text. The text is entered in the 

"Text" field. 
2 Narrow The window title consists only of text. The text is entered in the "Text" field.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

ShowToolBar

Description
Specifies whether the toolbar is shown. 
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Access in Runtime: Read and write

Syntax
Object.ShowToolBar[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl" or "HTMLBrowser".

BOOLEAN
Optional TRUE, if a toolbar will be displayed.

See also
AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

ShowTrendIcon

Description
Enables the display of an icon below the value axes. The icon indicates the trend currently 
displayed in the foreground.     

Access in Runtime: Read and write

Syntax
Object.ShowTrendIcon[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The icon is displayed.

FALSE: The icon is not displayed.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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ShowTrendIndicator

Description
Specifies whether the tendency (increasing or falling) of the measurement value that is to be 
monitored is shown with a small arrow. 

Access in Runtime: Read and write

Syntax
Object.ShowTrendIndicator[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the tendency (increasing or falling) of the measurement value that is to be 
monitored is shown with a small arrow.

See also
Bar (Page 3961)

ShowVerticalGridlines

Description
Specifies whether the columns of the message view are separated by vertical lines. 

Access in Runtime: Read and write

Syntax
Object.ShowVerticalGridlines[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the columns of the alarm window will be separated by vertical separation 
lines.

See also
AlarmControl (Page 3947)
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ShowXValuesExponential(i) 

Description
Specifies whether a value of the X coordinate is shown in exponential format. Whether the 
information is evaluated depends on the property "XAxisMode(i)".".

Access in Runtime: Read and write

Syntax
Object.ShowXValuesExponential(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if a value of the X coordinate is shown in exponential format.

Comments
The parameter i indicates the number of the trend. 

You use the function "Display value here" to view the X coordinate of the measurement value.

See also
FunctionTrendControl (Page 4004)

ShowYValuesExponential(i) 

Description
Specifies whether a value of the Y coordinate is shown in exponential format. Whether the 
information is evaluated depends on the property "XAxisMode(i)". ".

Access in Runtime: Read and write

Syntax
Object.ShowYValuesExponential(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if a value of the Y coordinate is shown in exponential format.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4535



Comments
The parameter i indicates the number of the trend. 

You use the function "Display value here" to view the Y coordinate of the measurement value.

See also
FunctionTrendControl (Page 4004)

SignificantMask property

Description
Is required in Runtime to display the active message class with the highest priority. 
The value of the SignificantMask property represents an internal system output value does not 
require any specific configuration by the user. Updating is initiated in Runtime by clicking on 
the object.

Sizeable property

Description
TRUE, when it should be possible to change the size of the object in Runtime. BOOLEAN write-
read access.

In the case of application window and picture window: Read only access

See also
TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

SkinName

Description
The control style can be defined in this selection field.   

Access in Runtime: Read and write

Syntax
Object.SkinName[=SkinName]

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4536 System Manual, 07/2013,  



Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "RecipeView", 
"RulerControl".

SkinName
The following settings are available:

Value Designation Description
 Project setting The style corresponds to the project settings in WinCC 

Explorer. 
0 Classic "Classic" WinCC style
1 Standard New WinCC V7 style

SmallChange

Description
Defines how many steps the controller can be moved with one mouse click or returns the value.

SmartTags

Description
Returns the SmartTags list. 

Access in Runtime: Read

Syntax
Object.SmartTags

Object
Required A ""HMIRuntime" object.

Sort

Description
Specifies the sorting criteria in SQL syntax for the database. 

Access in Runtime: Read and write
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Syntax
Object.Sort[=String]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl".

String
Optional A value or a constant that specifies the sort criteria in SQL syntax for the database.

SortByTimeDirection

Description
Specifies whether the last incoming message is shown at the top of the "AlarmControl" object 
(ascending sorting order). 

Access in Runtime: Read and write

Syntax
Object.SortByTimeDirection[= BOOLEAN]

Object
Required A "ScreenItems" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the last incoming alarm is shown at the top.

See also
AlarmControl (Page 3947)

AlarmView (Page 3958)

SortByTimeEnable

Description
Specifies whether the sorting direction can be altered in Runtime. 

Access in Runtime: Read and write

Syntax
Object.SortByTimeEnable[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the sorting direction can be altered in Runtime.

See also
AlarmView (Page 3958)

SortByTimeEnabled 

Description
Specifies whether the sorting of the messages can be altered according to the time in the 
"AlarmControl" object. 

Access in Runtime: Read and write

Syntax
Object.SortByTimeEnabled[= BOOLEAN]

Object
Required A "ScreenItems" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the sorting can be altered by the device operator.

SortOnColumnHeaderClick

Description
Specifies whether the alarm text blocks can be sorted via the column header of the alarm text 
block. 

Access in Runtime: Read and write

Syntax
Object.SortOnColumnHeaderClick[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".
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BOOLEAN
Optional TRUE, if the message blocks can be sorted by the column header of the message 
blocks.

See also
AlarmControl (Page 3947)

SortSequence

Description
Specifies how to change the sorting order by mouse click.  

Access in Runtime: Read and write

Syntax
Object.SortSequence[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

BOOLEAN.

Value Description Description
0 Up/down/none You can toggle between ascending, descending and no sorting by means 

of mouse click.
1 Up/down You can toggle between ascending and descending sorting order by 

means of mouse click.

See also
TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

SortTimeAscending

Description
Determines whether the last message received is displayed on top (ascending sorting order) 
in the  "MessageView" object. 

Access during runtime: Read and Write
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Syntax
Object.SortTimeAscending [= BOOLEAN]

Object
Required. An object of the "MessageView" type.

BOOLEAN
Optional. TRUE, if the last message received is displayed on top.

SortTimeEnable

Description
Determines whether the sorting of messages can be changed according to time in the  
"MessageView" object. 

Access during runtime: Read and Write

Syntax
Object.SortTimeEnable [= BOOLEAN]

Object
Required. An object of the "MessageView" type.

BOOLEAN
Optional. TRUE, if the sorting can be changed by the operator on the device.

StartAngle

Description
Specifies the angle at which the start point of the selected object deviates from the zero position 
(0°). 

Access in Runtime: Read and write

Syntax
Object.StartAngle[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".
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Int
Optional A value or a constant that specifies the angle at which the start point of the specified 
object deviates from the zero position (0°).

See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

TubeArcObject (Page 4121)

StartPoint

Description
Specifies the beginning of the object or returns it.

StartPointLeft

Description
Specifies the horizontal distance in pixels from the left edge of the screen. 

Access in Runtime: Read and write

Syntax
Object.StartPointLeft[=Int]

Object
Required An object of the "ScreenItem type with the format "Line"".

Int
Optional A value that specifies the horizontal distance in pixels of the start point from the left 
edge of the screen. 

See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)
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StartStyle

Description
Specifies how the line-start style of the specified object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.StartStyle[= THmiLineEndStyle]

Object
Required A ""ScreenItem" object with the formats ""Line", "Polyline" or ""Connector".

THmiLineEndStyle
Optional A value or a constant that specifies the line-start style. Value range from 0 to 1.

hmiLineEndStyleNone (0): The line has no start symbol.

hmiLineEndStyleFilledArrow (2): The line starts with a filled arrowhead.

See also
Line (Page 4025)

Polyline (Page 4060)

Connector (Page 3986)

StartStyle

Description
Determines how the line start of the given object is displayed. 

Access in Runtime: Read and write

Syntax
Object.StartStyle [= THmiLineEndStyle]

Object
Required An object of the "ScreenItem" type with the characteristic "Line," or "Polyline".

THmiLineEndStyle
Optional A value or constant which determines the line start. Value range from 0 to 2.

hmiLineEndStyleNone (0): The line has no start symbol.

hmiLineEndStyleFilledArrow (2): The line starts with a filled arrow.
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StartTop

Description
Specifies the vertical distance in pixels of the start point from the upper edge of the screen.  

Access in Runtime: Read and write

Syntax
Object.StartTop[=Int]

Object
Required An object of the "ScreenItem" type with the format "Line"".

Int
Optional A value that specifies the vertical distance in pixels of the start point from the upper 
edge of the screen. 

See also
EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Line (Page 4025)

StartValue

Description
Defines the value of the zero point of the scale indicator.

Defines or returns the absolute value for the zero point. 

See also
Bar (Page 3961)

State

Description
Returns the status of a message.

The following table shows the possible states of a message:
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State Alarm Log Status
1 Came In
2 Went Out
5 Came in and comment
6 Gone and comment

StatusbarBackColor

Description 
Defines the background color of the status bar. You open a color selection dialog box with the 
button.  Enable the "Display" option to active the setting.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementAdd

Description 
Defines a new, user-defined status bar element. You can change the name assigned by WinCC 
in the "Object name" field. 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)
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StatusbarElementAutoSize

Description
Enables autosizing of the width of a status bar element selected.     

Access in Runtime: Read and write

Syntax
Object.StatusbarElementAutoSize

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "FunctionTrendControl", "RecipeView", "RulerControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The width of the selected element is set automatically.

FALSE: The width of the selected element is not set automatically.

.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementCount

Description 
Defines the number of configurable status bar elements.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementIconId

Description 
Default assignment of the ID number and icon of a status bar element.

The property can be dynamized for customized elements of the status bar with the 
StatusbarElementIconId name.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementID

Description
Returns the ID number of the selected status bar element.

WinCC sets this read only ID.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementIndex

Description 
References a status bar element. You can assign the values of other properties to a specific 
element of the status bar by using this property.

Values between 0 and "StatusbarElementCount" minus 1 are valid for 
"StatusbarElementIndex". Attribute "StatusbarElementCount" defines the number of 
configurable status bar elements.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementName

Description 
Displays the object name of the status bar element selected. You can rename the objects of 
custom status bar elements. The "StatusbarElementName" property for customized elements 
can be dynamized by the " StatusbarElementRename" property. 
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementRemove

Description 
Removes the selected status bar element. Only customized elements of the status bar can be 
removed from the list.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementRename

Description   
Change the name of the customized element of the status bar that is referenced by the 
"StatusbarElementIndex" property.

The property with the name StatusbarElementRename can be dynamized for customized 
elements. With "StatusbarElementRename" you also dynamize the "StatusbarElementName" 
property.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElements

Description
Specifies the elements that are to be shown in the status bar. 

Access in Runtime: Read and write

Syntax
Object.StatusbarElements[=Long]

Object
Required A "ScreenItem" object with the format "AlarmView".

Long
Optional A value or a constant that specifies the elements that are shown in the status bar.

See also
AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

StatusbarElementTooltipText

Description 
Defines the tooltip text for the custom status bar element.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementUserDefined

Description
Indicates whether the project engineer has added the status bar element as a new custom 
element.   

Access in Runtime: Read and write

Syntax
Object.StatusbarElementUserDefined[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTrendControl", "OnlineTableControl", "FunctionTrendControl", "RecipeView", 
"RulerControl".

BOOLEAN
TRUE: The element of the status bar is customized.

FALSE: The element of the status bar is specified by the system.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)
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StatusbarElementVisible

Description 
Activate the elements in the list of status bar elements for their display in Runtime.

Click a list entry to adapt the properties, or to change its position in the status bar of the Control 
by means of the "Up" and "Down" buttons. 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarElementWidth

Description 
Shows the width of the status bar element selected in pixels. You can define the width if the 
"Automatic" option is not activated.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarFontColor

Description 
Defines the color of the text in the status bar. 
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarShowArchiveName

Description
Specifies whether the archive name will be displayed in the status bar. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowArchiveName[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the archive name will be displayed in the status bar.

StatusbarShowColumn

Description
Specifies whether the current number of selected data record columns will be displayed. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowColumn[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, specifies whether the current number of selected data record columns will be 
displayed.
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StatusbarShowRecord

Description
Specifies whether the field coordinates of the selected data record will be displayed in the 
status bar. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowRecord[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the field coordinates of the selected data record will be displayed in the 
status bar.

StatusbarShowRow

Description
Specifies whether the current number of selected data record rows will be displayed. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowRow[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the current number of selected data record rows will be displayed.

StatusbarShowText

Description
Specifies whether the current status of the database will be displayed in the status bar. 

Access in Runtime: Read and write
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Syntax
Object.StatusbarShowText[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, specifies whether the current status of the database will be displayed in the 
status bar.

StatusbarShowTooltips

Description
Enables the display of tooltips for the status bar elements in Runtime.   

Access in Runtime: Read and write

Syntax
Object.StatusbarShowTooltips[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "UserArchiveControl", 
"TrendRulerControl".

BOOLEAN
TRUE: The tooltips are displayed.

FALSE: The tooltips are not displayed.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)
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StatusbarText

Description 
Default text in the status bar.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarUseBackColor

Description
Sets a background color for the status bar.   

Access in Runtime: Read and write

Syntax
Object.StatusbarUseBackColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "UserArchiveControl", 
"TrendRulerControl".

BOOLEAN
TRUE: The background color of the status bar is displayed.

FALSE: The background color of the status bar is not displayed.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

StatusbarVisible

Description
Enables the display of the status bar of a control.   

Access in Runtime: Read and write

Syntax
Object.StatusbarVisible[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "RecipeView", 
"RulerControl".

BOOLEAN
TRUE: The status bar is displayed.

FALSE: The status bar is not displayed.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)
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Style

Description
Specifies the line style of the selected object. 

Access in Runtime: Read and write

Syntax
Object.Style[= THmiLineStyle]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "EllipticalArc", "CircularArc" 
or "Connector".

THmiLineStyle
Optional A value or a constant that specifies the line style. Value range from 0 to 4.

hmiLineStyleSolid (0): solid line

hmiLineStyleDash (1): broken line

hmiLineStyleDot  (2): dotted line

hmiLineStyleDashDot (3): dash - dot line

hmiLineStyleDashDotDot (4): dash - dot - dot line

Default setting: hmiLineStyleSolid

See also
Line (Page 4025)

Polyline (Page 4060)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Connector (Page 3986)

Style

Description
Determines the line style of the given object. 

Access during runtime: Read and Write

Syntax
Object.Style [= THmiLineStyle]
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Object
Required. An object of the "screen item" type with the characteristic "Line," or "Polyline".

THmiLineStyle
Optional. A value or constant that defines the line style. Value range from 0 to 4.

hmiLineStyleSolid (0): solid line

hmiLineStyleDash (1): dashed line

hmiLineStyleDot (2): dotted line

hmiLineStyleDashDot (3): dash dot line

hmiLineStyleDashDotDot (4): dash dot dot line

Default setting: hmiLineStyleSolid

StyleSettings

Description
Defines the style in which the object is displayed. 

User Defined Shows the object according to the respective settings.
Global Shows the object in a globally defined design.
Windows Style Shows the object in Windows style.

See also
Button (Page 3968)

WindowSlider (Page 4139)

RoundButton (Page 4074)

SwapDimensionsWithOrientation

Description
Specifies whether the values for the height and width of the bar should be automatically 
replaced if the bar alignment is changed. 

Access in Runtime: Read and write

Syntax
Object.SwapDimensionsWithOrientation[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".
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BOOLEAN
Optional TRUE, if the values for the height and width of the bar should be automatically 
replaced if the bar alignment is changed.

See also
Bar (Page 3961)

SwapFirstWithLastConnection

Description
Specifies whether the text in the object is shown horizontally.

Access in Runtime: Read and write

Syntax
Object.SwapFirstWithLastConnection[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Connector".".

BOOLEAN
Optional TRUE, if the text in the object is shown horizontally.

See also
Connector (Page 3986)

Properties T

TableBackColor

Description
Specifies the background color of the table cells for the selected object. 

Access in Runtime: Read and write

Syntax
Object.TableBackColor[= Color]
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Object
Required An object of the "ScreenItem" type with the format "UserArchivControl", 
"StatusForce", "OnlineTrendControl", "AlarmControl" or "UserView".

Color
Optional A value or a constant that specifies the background color of the table cells.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

TableBackColor

Description
Determines the background color of the table cells of the given object. 

Access during runtime: Read and Write

Syntax
Object.TableBackColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView", 
"StatusForce", "TrendView", "MessageView" or "UserView".

Color
Optional A value or constant which determines the background color of the table cells.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.
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See also
AlarmView (Page 3958)

RecipeView (Page 4068)

TrendView (Page 4118)

StatusForce (Page 4087)

UserView  (Page 4137)

TableColor

Description   
Defines the background color of the rows. You open a color selection dialog box with the button. 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TableColor2

Description 
Specifies the background color of "Row color 2". You open a color selection dialog box with 
the button.

The settings are only active in Runtime if the "Row color 2" option is enabled. The background 
colors of "Row color 2" and "Row color 1" are used alternately in this case.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TableFocusOnButtonCommand

Description
Specifies whether by clicking on a Button in a script in Runtime the table of the Controls will 
be activated. 

Access in Runtime: Read and write
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Syntax
Object.TableFocusOnButtonCommand[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmView".

BOOLEAN
Optional TRUE, if by clicking on a Button in a script in Runtime the table of the Controls will 
be activated.

See also
AlarmControl (Page 3947)

TableForeColor

Description 
Specifies the font color of the rows. You open a color selection dialog box with the button.

TableForeColor 

Description
Specifies the text color used in the table cells of the selected object. 

Access in Runtime: Read and write

Syntax
Object.TableForeColor[= Color]

Object
Required A "ScreenItem" object with the formats "RecipeView", ""StatusForce", 
"MessageView" or ""UserView".

Color
Optional A value or a constant that specifies the text color used in the table cells.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TableForeColor

Description
Determines the text color in the table cells of the given object. 

Access during runtime: Read and Write

Syntax
Object.TableForeColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView," 
"StatusForce", "MessageView" or "UserView".

Color
Optional A value or constant which determines the text color of the table cells.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
AlarmView (Page 3958)

RecipeView (Page 4068)

StatusForce (Page 4087)

UserView  (Page 4137)

TableForeColor2

Description 
Specifies the font color of "Row color 2". You open a color selection dialog box with the button. 
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The settings are only active in Runtime if the "Row color 2" option is enabled. The font colors 
of "Row color 2" and "Row color 1" are used alternately in this case.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TableGridLineColor 

Description
Specifies the color of the gridlines in the table of the selected object. 

Access in Runtime: Read and write

Syntax
Object.TableGridLineColor[= Color]

Object
Required A "ScreenItem" object with the formats "RecipeView", "TrendView" or "UserView".

Color
Optional A value or a constant that specifies the color of the gridlines in a table.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

TableGridLineColor

Description
Determines the color of the gridlines in the table of the given object. 

Access during runtime: Read and Write

Syntax
Object.TableGridLineColor [= Color]
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Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView," 
"MessageView", "TrendView" or "UserView".

Color
Optional A value or constant which determines the color of the gridlines of the table.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
RecipeView (Page 4068)

TrendView (Page 4118)

UserView  (Page 4137)

TableHeaderBackColor 

Description
Specifies the background color in the header of the table of the selected object. 

Access during runtime: Read and Write

Syntax
Object.TableHeaderBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView", 
"StatusForce", "TrendView", "MessageView," or "UserView".

Color
Optional A value or a constant that specifies the background color in the header.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4566 System Manual, 07/2013,  



See also
UserView  (Page 4137)

AlarmView (Page 3958)

RecipeView (Page 4068)

StatusForce (Page 4087)

TrendView (Page 4118)

TableHeaderForeColor

Description
Specifies the text color in the header of the table of the selected object. 

Access during runtime: Read and Write

Syntax
Object.TableHeaderForeColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView", 
"StatusForce", "TrendView", "MessageView" or "UserView".

Color
Optional A value or a constant that specifies the text color in the header.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
UserView  (Page 4137)

AlarmView (Page 3958)

RecipeView (Page 4068)

StatusForce (Page 4087)

TrendView (Page 4118)
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TagName

Description
The "Index" property references a trend. "TagName" defines the tag linked to this trend. It is 
specified in the form "Archivname\Variablenname" to display tags in a process value archive 
or "TasgName" to display an internal or external tag which is not stored in an archive.

TagPrefix

Description
A tag prefix can be assigned for a screen window that is prefixed to all tags which are used in 
the screen. In this way, a picture that is embedded in a picture window retains access to its 
own tags while another accesses other tags.

The "TagPrefix" property specifies the prefix that is prefixed to all tags which are available in 
the screen.

The change to the tag prefix does not become effective until the screen is reloaded. This 
happens automatically when changing screens, otherwise the screen name must be 
reassigned.

The prefix is freely definable but must match the name of the structure tag.

Example
The "InOutput" screen should be displayed in the screen window. The "InOutput" screen 
contains 3 I/O fields which are bound to a structure tag. The structure tag consists of the 
elements EA1, EA2, EA3; one element each for every I/O field.

Three such structure tags with the structure names Struct1, Struct2 and Struct3 are defined 
in the project for example.

The tag prefix is the structure name with a following period in this case. If you specify Struct2., 
for example, as a tag prefix (the period is necessary to address the elements of the structure 
tags syntactically correctly as structure elements), the I/O fields in the "InOutput" screen are 
bound with the elements of structure tag Struct2:

Tag prefix: "Struct2."

● Output value (first I/O field): EA1

● Output value (second I/O field): EA2

● Output value (third I/O field): EA3

The current tag binding in the screen window is therefore

● Output value (first I/O field): Struct2.EA1

● Output value (second I/O field): Struct2.EA2

● Output value (third I/O field): Struct2.EA3
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See also
ScreenWindow (Page 4078)

Tags

Description 
Returns an object of type "Tags". 

Access during runtime: Read

Syntax
Object.Tags

Object
Necessary. An object of the "HMIRuntime" type. 

Example
The following example accesses the tag "Tag1":

 
'VBS86
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")

See also
HMIRuntime  (Page 3922)

Template

Description
Returns the template for displaying the window content of the "Application Window" object. 
Read only access.

The following templates are possible depending on the property value:

Window Contents = Global Script
"GSC diagnostics"
The application window is supplied by applications of the Global Script. The results of the 
diagnosis system are displayed.
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"GSC Runtime"
The application window is supplied by applications of the Global Script. The analysis results 
regarding characteristics in Runtime are displayed.

Window Contents = Print Jobs
"All Jobs": 
The application window is supplied by the logging system. The available reports are displayed 
as a list.

"All Jobs - Context Menu": 
The application window is supplied by the logging system. The available reports are displayed 
as a list. The shortcut menu enables the selection of print options, display of a print preview 
as well as a printout of the log.

"Job Detail View": 
The application window is supplied by the logging system. The available reports are displayed 
in a selection menu. Detailed information is displayed for the selected report.

"Selected Jobs - Context Menu": 
The application window is supplied by the logging system. The available reports are displayed 
as a list. This list only contains reports which you have activated the option "Mark for print job 
list" in the "Print Job Properties" dialog. The shortcut menu enables the selection of print 
options, display of a print preview as well as a printout of the log.

See also
ScriptDiagnostics (Page 4080)

Text

Description
Specifies the labeling for the text field. 

Access in Runtime: Read and write

Syntax
Object.Text[= STRING]

Object
Required A "ScreenItem" " object with the formats "TextField", "CheckBox" or "OptionGroup".

STRING
Optional A value or a constant that specifies the labeling.
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See also
TextField (Page 4107)

CheckBox (Page 3974)

OptionGroup (Page 4054)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

RoundButton (Page 4074)

Text 

Description
Determines the labeling of the text field. 

Access during runtime: Read and Write

Syntax
Object.Text [= STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "TextField".

STRING
Optional. A value or constant which determines the label text color.

TextList

Description
A list which contains the assignments between the output value and the output text actually to 
be output. The assignments are dependent on the set list type. You determine the list type 
with the ListType property.  

Access in Runtime: Read

Syntax
Object.TextList

Object
Required A "ScreenItem" object with the format "SymbolicIOField".
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See also
Button (Page 3968)

SymbolicIOField (Page 4093)

TextOff

Description
Specifies the text that will be displayed in the status "off" of the selected object. 

Access in Runtime: Read and write

Syntax
Object.TextOff[= STRING]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", ""Button" or "Switch".

STRING
Optional A value or a constant that specifies the labeling for the status "off".

Comments
The property is only available if the referenced object "SymbolicIOField", "Button" or "Switch" 
is type "Text".

See also
SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

TextOff 

Description
Determines the text which is displayed in the "Off" status of the given object. 

Access during runtime: Read and Write

Syntax
Object.TextOff[= STRING]
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Object
Required. An object of the "ScreenItem" type with the characteristic "Button," and "Switch".

STRING
Optional. A value or constant which determines the label for the "Off" status.

Remarks
The property is only available if the referenced "Button" or "Switch" object is of the "Text" type.

TextOn

Description
Specifies the text that will be displayed in the status "on" of the selected object. 

Access in Runtime: Read and write

Syntax
Object.TextOn[= STRING]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Button" or ""Switch".

STRING
Optional A value or a constant that specifies the labeling for the status "on".

Comments
The property is only available if the referenced object "Button" or Switch" is type ""Text".

See also
SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

TextOn

Description
Determines the text which is displayed in the "On" status of the given object. 

Access during runtime: Read and Write
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Syntax
Object.TextOn[= STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "Button," and "Switch".

STRING
Optional. A value or constant which determines the label for the "On" status.

Remarks
The property is only available if the referenced "Button" or "Switch" object is of the "Text" type.

TextOrientation

Description
Specifies the text direction (orientation) of the selected object.   

Access in Runtime: Read and write

Syntax
Object.TextOrientation[=TextOrientation]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Switch", "Bar", "OnlineTrendControl", "FunctionTrendControl", 
"Checkbox", "OptionGroup" or "WindowSlider".

TextOrientation
hmiTextHorizontal ( 0): The text is shown horizontally.

hmiTextRotated90Degree (-1): The text is shown vertically and left justified.

hmiTextRotated270Degree ( 1): The text is shown vertically and right justified.
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See also
CheckBox (Page 3974)

Button (Page 3968)

WindowSlider (Page 4139)

RoundButton (Page 4074)

Switch (Page 4089)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)

ThumbBackColor

Description
Specifies the background color of the slider in the ""Slider" object. 

Access in Runtime: Read and write

Syntax
Object.ThumbBackColor[= Color]

Object
Required A "ScreenItem" object with the formats ""Slider" or "WindowSlider".".

Color
Optional A value or a constant that specifies the background color of the slider.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Slider (Page 4082)

WindowSlider (Page 4139)
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ThumbBackColor

Description
Determines the background color of the slider in the "Slider" object. 

Access during runtime: Read and Write

Syntax
Object.ThumbBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Slider".

Color
Optional A value or constant which determines the background color of the slider.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

TicksColor

Description
Specifies the color of the hour markers on the face of the "Clock" object. 

Access during runtime: Read and Write

Syntax
Object.TicksColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Clock".

Color
Optional A value or a constant that specifies the color of the hour markers.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
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For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Clock (Page 3984)

TickStyle

Description
Specifies the scale display.     

Access during runtime: Read and write

Syntax
Object.TickStyle[=SliderTickStyle]

Object
Necessary. A "ScreenItem" object with the format "Slider"".

SliderTickStyle
hmiSliderTickStyleNone ( 0): The object has no scale.

Identifies no strokes.

hmiSliderTickStyleEffect1 ( 1): The scale consists of main gradations only. The scale is black 
on a white background.

Identifies main strokes (black-white).

hmiSliderTickStyleEffect2 ( 2): The scale consists of main gradations only. The scale is white 
on a black background.

Identifies main strokes (white-black).

hmiSliderTickStyleNormal ( 3): The scale consists of simple gradations.

Identifies normal strokes.

Comments
Because of the automatic scaling it is possible that in some parts two marking lengths of the 
scale can be positioned directly adjacent to one another (looks like a wider marking length). 
You can correct this effect by slightly lengthening or shortening the slider object.

You you can also completely suppress the display of the scale ("WithAxes").

Used for the following object types:
Slider
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See also
Slider (Page 4082)

TimeAxisBeginTime(i) 

Description
Specifies the start time of the display for the selected trend. Whether the information that is 
evaluated should be dependent on the properties ""UseTimeRange(i)" and "ShareTimeAxis". 

Access in Runtime: Read and write

Syntax
Object.TimeAxisBeginTime(i)[=Time]

Object
Required A "ScreenItem" object with the format "OnlineTrend"".

Time
Optional A value or a constant that specifies the start time of the display for the selected trend. 

See also
OnlineTrendControl (Page 4045)

TimeAxisEndTime 

Description
Specifies the end time of the display for the selected trend. Whether the information is 
evaluated depends on the properties "Autorange", "UseTimeRange(i)" " and "ShareTimeAxis".  

Access in Runtime: Read and write

Syntax
Object.TimeAxisEndTime[=Time]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

Time
Optional A value or a constant that specifies the end time of the display for the selected trend. 
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See also
OnlineTrendControl (Page 4045)

TimeAxisLabel(i) 

Description
Specifies the labeling of the time axis. Whether the information is evaluated depends on the 
property "ConfigureTimeAxis(i)". 

Access in Runtime: Read and write

Syntax
Object.TimeAxisLabel(i)[=String]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

String
Optional A value or a constant that specifies the labeling of the time axis. 

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

TimeAxisRange 

Description
Time span that will be displayed by the time axis. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisRange[=Decimal]

Object
Required A "ScreenItem" object with the format "TrendView".
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Decimal
Optional Time span that will be displayed by the time axis.

See also
TrendView (Page 4118)

TimeAxisShowGridLines(i)

Description
Specifies whether the trend window is shown with grid lines that run parallel to the x axis. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisShowGridLines(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

BOOLEAN
Optional TRUE, if the trend window is shown with grid lines that run parallel to the x axis.

Comments
The distance between two grid lines can be altered with the "TimeAxisGridLineInterval(i)" 
property.

See also
OnlineTrendControl (Page 4045)

TimeAxisShowLargeIncrements(i)

Description
Specifies whether the time axis is scaled with long marking lengths. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisShowLargeIncrements(i)[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "OnlineTrend".

BOOLEAN
Optional TRUE, if the time axis is scaled with long marking lengths.

Comments
The distance of two long marking lines can be altered with the 
""TimeAxisLargeIncrementSize(i) property.

See also
OnlineTrendControl (Page 4045)

TimeAxisShowSmallIncrements(i) 

Description
Specifies whether the time axis is scaled with short marking lengths. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisShowSmallIncrements(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

BOOLEAN
Optional TRUE, if the time axis is scaled with short marking lengths.

Comments
The distance of two short marking lines can be altered with the 
"TimeAxisSmallIncrementSize(i)" property.

See also
OnlineTrendControl (Page 4045)
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TimeAxisTimeFormat(i)

Description
Specifies the format of the information along the time axis for the selected trend. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisTimeFormat(i)[=TimeFormat]

Object
Required An object of the "ScreenItem" type with the format 
"OnlineTrendControl","FunctionTrendControl" or "OnlineTableControl".

TimeFormat
( 0): The information is carried out in the form hh:mm.

 ( 1): The information is carried out in the form hh:mm:ss.

 ( 2): The information is carried out in the form hh:mm:ss.ms.

 ( 3): The information is carried out in the form hh:mm (full hours).

 ( 4): The information is carried out in the form hh:mm:ss (full minutes).

 ( 5): The information is carried out in the form hh:mm:ss:ms (full seconds).

 ( 6): The information is carried out in the form dd_mm_yy_hh_mm.

 ( 7): The information is carried out in the form dd_mm_yy_hh_mm (full hours).

 ( 8): The information is carried out in the form dd_mm_yy.

 ( 9): The information is carried out in the form dd_mm_yy_ (full days).

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

TimeBase

Description
Specifies the time zone in which the time values will be displayed.   

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4582 System Manual, 07/2013,  



Access in Runtime: Read and write

Syntax
Object.TimeBase[=TimeBase]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "OnlineTableControl", "AlarmControl" or "UserArchiveControl".

TimeBase
hmiTimeBaseLocalTimezone ( 0): Local time

hmiTimeBaseServerTimezone ( 1): Time zone of the server

hmiTimeBaseUTC ( 2): UTC (Universal Time Coordinated)

hmiTimeBaseProjectSetting ( 3): Project settings

Comments
Set the time mode in accordance with the computer settings on the properties page of the 
computer in WinCC Explorer. The following selection is offered: 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

TimeColumnActualize

Description
Enables the update of values in the selected column.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnActualize[=BOOLEAN]

Object

Required A "ScreenItem" object with the format "OnlineTableControl".
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BOOLEAN
TRUE: The time column is actualized.

FALSE: The time column is not actualized. This setting can be useful when comparing tables.

See also
OnlineTableControl (Page 4037)

TimeColumnAdd

Description   
Creates a new time column.

Syntax
Object.TimeColumnAdd

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 4037)

TimeColumnAlign

Description
Defines the mode of alignment of the time column selected.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnAlign[=HorizontalAlignment]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".
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HorizontalAlignment

Value Description Description
0 left The time column selected is displayed on the left.
1 Centered The time column selected is aligned to center.
2 right The time column selected is displayed on the right.

See also
OnlineTableControl (Page 4037)

TimeColumnAlignment(i) 

Description
Specifies the alignment of the time column of a column pair i. The parameter i indicates the 
number of the column pair. 

Access in Runtime: Read and write

Syntax
Object.TimeColumnAlignment(i)[=AlignmentHorizontal]

Object
Required A "ScreenItem" object with the format "TableView".".

AlignmentHorizontal
hmiAlignmentLeft ( 0): The text is shown left justified.

hmiAlignmentCentered ( 1): The text is shown centered.

hmiAlignmentRight ( 2): The text is shown right justified.

See also
OnlineTableControl (Page 4037)

TimeColumnBackColor

Description
Specifies the background color of the time column selected. You open a color selection dialog 
box with the button.

The setting is useful if:
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● The "Use value column colors" option is disabled

● The "Font color" option is set in the "Use column color" field of the "General" tab.  

Access in Runtime: Read and write

Syntax
Object.TimeColumnBackColor

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 4037)

TimeColumnBeginTime

Description   
Defines the start of the time range for a selected time column. .

Syntax
Object.TimeColumnBeginTime

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 4037)

TimeColumnCaption

Description   
Defines the caption of the time column.

Syntax
Object.TimeColumnCaption
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Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 4037)

TimeColumnCount

Description   
Defines the number of time columns configured.

Syntax
Object.TimeColumnCount

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 4037)

TimeColumnDateFormat

Description
Defines the date format for visualizing a selected time column.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnDateFormat[=DateFormat]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

DateFormat

Value Description
Automatic The date format is set automatically.
dd.MM.yy Day.Month.Year, e.g. 24.12.10.
dd.MM.yyyy Day.Month.Year, e.g. 24.12.2010.
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Value Description
dd/MM/yy Day/Month/Year, e.g. 24/12/10.
dd/MM/yyyy Day/Month/Year, e.g. 24/12/2010.

See also
OnlineTableControl (Page 4037)

TimeColumnEndTime

Description   
Defines the end of the time range of a selected time column.

Syntax
Object.TimeColumnBeginTime

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 4037)

TimeColumnForeColor

Description
Specifies the font color of the time column selected. You open a color selection dialog box with 
the button.

The setting is effective:

● When the option "in the colors of the value column" is not activated.

● When the "Font color" option is activated in the "Use column color" area of the "General" 
tab.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnForeColor

Object
Required A "ScreenItem" object with the format "OnlineTableControl".
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See also
OnlineTableControl (Page 4037)

TimeColumnFormat(i) 

Description
Specifies the format of the time columns for the selected column pair. The parameter i indicates 
the number of the column pair.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnFormat(i)[=TimeFormat]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeFormat
 ( 0): The information is carried out in the form hh:mm.

 ( 1): The information is carried out in the form hh:mm:ss.

 ( 2): The information is carried out in the form hh:mm:ss.ms.

 ( 3): The information is carried out in the form hh:mm (full hours).

 ( 4): The information is carried out in the form hh:mm:ss (full minutes).

 ( 5): The information is carried out in the form hh:mm:ss:ms (full seconds).

 ( 6): The information is carried out in the form dd_mm_yy_hh_mm.

 ( 7): The information is carried out in the form dd_mm_yy_hh_mm (full hours).

 ( 8): The information is carried out in the form dd_mm_yy.

 ( 9): The information is carried out in the form dd_mm_yy_ (full days).

See also
OnlineTableControl (Page 4037)

TimeColumnHideText

Description
Sets text format for displaying the content of a time column.   

Access in Runtime: Read and write
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Syntax
Object.TimeColumnActualize[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The content is not shown as a text.

FALSE: The content is shown as a text.

See also
OnlineTableControl (Page 4037)

TimeColumnHideTitleText

Description
Sets text format for displaying the time column header.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnActualize[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The header is not shown as a text.

FALSE: The header is shown as a text.

See also
OnlineTableControl (Page 4037)

TimeColumnIndex

Description   
References a configured time column. You can assign the values of other properties to a 
specific time column by using the property.

Valid values for "TimeColumnIndex" are between 0 and "TimeColumnCount" minus 1. The 
"TimeColumnCount" property indicates the number of configured time columns.
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Syntax
Object.TimeColumnIndex

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl"

See also
OnlineTableControl (Page 4037)

TimeColumnLength

Description   
Specifies the width of a selected time column.

Syntax
Object.TimeColumnLength

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 4037)

TimeColumnMeasurePoints

Description   
Defines the number of measurement points to be displayed in the time column selected. 

Syntax
Object.TimeColumnMeasurePoints

Object
Required A "ScreenItem" object with the format "OnlineTableControl".
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See also
OnlineTableControl (Page 4037)

TimeColumnName

Description   
Specifies the name of a selected time column.

Syntax
Object.TimeColumnName

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 4037)

TimeColumnRangeType

Description
Defines the time range setting for the time column selected.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnRangeType[=TimeRangeType]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeRangeType

Value Description Description
0 Time range Defines the start time and time range of the time column.
1 Start to end time Defines the start and end time for the time column.
2 Number of measurement 

points
Defines the start time and the number of measurement points 
for the time column. 
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See also
OnlineTableControl (Page 4037)

TimeColumnRemove

Description   
Removes the selected time column from the list.

Syntax
Object.TimeColumnRemove

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 4037)

TimeColumnRename

Description   
Changes the name of the time column which is referenced by the "TimeColumnIndex" property. 
With "TimeColumnRename" you also dynamize the "TimeColumnName" property.

Syntax
Object.TimeColumnRename

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 4037)

TimeColumnRepos

Description   
Repositions the order of time columns and of corresponding value columns.  "Up" and "Down" 
move the time column selected up or down in the list. This moves the time column and 
corresponding value columns in the table towards the front or towards the back.
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Syntax
Object.TimeColumnRepos

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 4037)

TimeColumnShowDate

Description
Enables the display of the date and time in the time column selected.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnShowDate[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The date and the time are displayed. The date format is defined in the "Date format" 
field.

FALSE: The date is not displayed. Only the time is displayed.

See also
OnlineTableControl (Page 4037)

TimeColumnShowIcon

Description
Enables the display of time column contents as icon.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnActualize[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The content is shown as an icon.

FALSE: The content is not shown as an icon.

See also
OnlineTableControl (Page 4037)

TimeColumnShowTitleIcon

Description
Specifies whether the values of the selected column are updated.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnShowTitleIcon [=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The header is shown as an icon.

FALSE: The header is not shown as an icon.

 

See also
OnlineTableControl (Page 4037)

TimeColumnSort

Description
Specifies how the time column referenced in "TimeColumnIndex" is sorted.   

Access in Runtime: Read and write
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Syntax
Object.TimeColumnSort [=TimeColumnSort]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeColumnSort

Value Description Description
0 no No sorting
1 Ascending Ascending order, starting at the lowest value.
2 Descending Descending order, starting at the highest value.

.

 

See also
OnlineTableControl (Page 4037)

TimeColumnSortIndex

Description   
Specifies the sorting order of the time column referenced in "TimeColumnIndex". If you set the 
value to "0", the sorting criterion is removed in "TimeColumnSort".

Syntax
Object.TimeColumnSortIndex

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl"

See also
OnlineTableControl (Page 4037)

TimeColumnTimeFormat

Description
Defines the time format for visualizing a selected time column.   

Access in Runtime: Read and write
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Syntax
Object.TimeColumnTimeFormat[=TimeFormat]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeFormat

Value Description
Automatic The time format is set automatically.
HH:mm:ss.ms Hours:Minutes:Seconds, e.g. 15:35:44.240.
hh:mm:ss tt Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.
hh:mm:ss.ms tt Hours:Minutes:Seconds AM/PM, e.g. 03:35:44.240 PM.

See also
OnlineTableControl (Page 4037)

TimeColumnTimeRangeBase

Description
Defines the time unit for calculating the time range.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnTimeRangeBase[=TimeRangeBase]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeRangeBase

Value Description
500 500 ms
1000 1 second
60000 1 minute
3600000 1 hour
86400000 1 day

See also
OnlineTableControl (Page 4037)
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TimeColumnTimeRangeFactor

Description   
Defines the factor for calculating the time range. Only integer factors are valid.

Syntax
Object.TimeColumnTimeRangeFactor

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 4037)

TimeColumnUseValueColumnColors

Description
Defines whether the selected time column will be displayed in the value column colors.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnUseValueColumnColors[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The selected time column is displayed in the colors of the value column. The settings 
in the "Font color" and "Background color" fields are disabled.

FALSE: The selected time column is displayed in the colors which are specified in the "Font 
color" and "Background color" fields.

 

See also
OnlineTableControl (Page 4037)
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TimeColumnVisible

Description   
The list shows the time columns you created. Select the time columns to be displayed in the 
table from the list.

Click a time column entry in the list to adapt the properties and to define the time range of the 
time column.

Syntax
Object.TimeColumnVisible

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 4037)

TimeJumpColor(i) 

Description
Specifies the color that is identified in the time jump available in the log. Whether the information 
is evaluated depends on the property "TimeJumpEnabled(i)".".

Access in Runtime: Read and write

Syntax
Object.TimeJumpColor(i)[=Color]

Object
Required A "ScreenItem"" object with the formats ""OnlineTrend" or ""TableView".".

Color
Optional A value or a constant that specifies the color that identifies the time jump available 
in the log. 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)
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TimeJumpEnabled(i)

Description
Specifies if the time jumps available in the log are identified in the color set up in 
"TimeJumpColor(i)". 

Access in Runtime: Read and write

Syntax
Object.TimeJumpEnabled(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend" or ""TableView".

BOOLEAN
Optional TRUE, if the time jumps available in the log are identified in the color specified in 
"TimeJumpColor(i)".

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TimeOverlapColor(i)

Description
Specifies the color that is identified in the time overlap available in the log. Whether the 
information is evaluated depends on the attribute "TimeOverlapEnabled(i)".".

Access in Runtime: Read and write

Syntax
Object.TimeOverlapColor(i)[=Color]

Object
Required A "ScreenItem" object with the formats "OnlineTrend" or ""TableView".

Color
Optional A value or a constant that specifies the color that identifies the time overlap available 
in the log.
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See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TimeOverlapEnabled(i)

Description
Specifies if the time overlaps available in the log are identified in the color set up in 
"TimeOverlapColor(i)". 

Access in Runtime: Read and write

Syntax
Object.TimeOverlapEnabled(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend"" or "TableView".

BOOLEAN
Optional TRUE, if the time jumps overlaps available in the log are identified in the color 
specified in ""TimeOverlapColor(i)"".

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TimeRangeBase(i) 

Description
Specifies the unit for determining the time interval of the selected trend.   

Access in Runtime: Read and write

Syntax
Object.TimeRangeBase(i)[=TagLoggingTimeUnit]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".
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TagLoggingTimeUnit
 ( 1): The time intervals are set up in milliseconds.

hmiCurveTimeRangeBase500ms (500): The time intervals are set up in 500 ms.

hmiCurveTimeRangeBaseSecond ( 1000): The time intervals are set up in seconds.

hmiCurveTimeRangeBaseMinute ( 60000): The time intervals are set up in minutes.

hmiCurveTimeRangeBaseHour ( 3600000): The time intervals are set up in hours.

hmiCurveTimeRangeBaseDay ( 86400000): The time intervals are set up in days.

Comments
The time range to be displayed for the trend i is achieved by multiplying the values 
"TimeRangeBase(i)" and "TimeRangeFactor(i)", whereby the value of "TimeRangeBase(i)" is 
interpreted in milliseconds. The "TimeRangeBase(i" and "TimeRangeFactor(i)" properties are 
only evaluated if the "TimeRange" property has the value "-1".

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

TimeRangeFactor(i)

Description
Specifies the factor for determining the time interval of the selected trend. 

Access in Runtime: Read and write

Syntax
Object.TimeRangeFactor(i)[=Int]

Object
Required A "ScreenItem" object with the formats "OnlineTrend", "FunctionTrendView" or 
"TableView".

Int
Optional A value or a constant that specifies the factor for determining the time interval of the 
selected trend.

Comments
The time range to be displayed for the trend i is achieved by multiplying the values 
""TimeRangeBase(i and "TimeRangeFactor(i)", whereby the value of "TimeRangeBase(i)" is 
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interpreted in milliseconds. The "TimeRangeBase(i" and "TimeRangeFactor(i)" " properties 
are only evaluated if the property "TimeRange" has the value "-1".

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

Timestamp

Description
Returns the time stamp of the last read access of a tag in local time as DATE. 

Access in Runtime: Read

Syntax
Object.TimeStamp

Object
Required A "Tag" object. 

Comments
To show the TimeStamp property in plain text, use the VBS function "FormatDateTime(Date[, 
NamedFormat])". The output is dependent on the language setting. To adjust the language, 
use the VBS function "SetLocale´()". 

If you want to return the time stamp sorted by date, day and time, use the NamedFormat 
parameter or the VBS functions like Year, WeekDay, Day, Hour, Minute, Second. The name 
of a week day can be obtained using the VBS function WeekdayName. 

Examples
The following example issues the time stamp of the tag "Tag11" with the aid of the function 
"FormatDateTime": 

 
'VBS87
Dim objTag
Dim lngCount
lngCount = 0
Set objTag = HMIRuntime.Tags("Tag11")
objTag.Read
SetLocale("en-gb")
MsgBox FormatDateTime(objTag.TimeStamp)    'Output: e.g. 06/08/2002 9:07:50
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MsgBox Year(objTag.TimeStamp)    'Output: e.g. 2002
MsgBox Month(objTag.TimeStamp)    'Output: e.g. 8
MsgBox Weekday(objTag.TimeStamp)    'Output: e.g. 3
MsgBox WeekdayName(Weekday(objTag.TimeStamp))    'Output: e.g. Tuesday
MsgBox Day(objTag.TimeStamp)    'Output: e.g. 6
MsgBox Hour(objTag.TimeStamp)    'Output: e.g. 9
MsgBox Minute(objTag.TimeStamp)    'Output: e.g. 7
MsgBox Second(objTag.TimeStamp)    'Output: e.g. 50
For lngCount = 0 To 4
MsgBox FormatDateTime(objTag.TimeStamp, lngCount)
Next
'lngCount = 0: Output: e.g. 06/08/2002 9:07:50
'lngCount = 1: Output: e.g. 06 August 2002
'lngCount = 2: Output: e.g. 06/08/2002
'lngCount = 3: Output: e.g. 9:07:50
'lngCount = 4: Output: e.g. 9:07

The following example issues the time stamp of the tag "Tag1":

 
'VBS88
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
MsgBox objTag.TimeStamp

See also
Tag (Page 3941)

TitleBackColor

Description   
Specifies the background color of the table headers for the selected status. You open a color 
selection dialog box with the button.

TitleCut

Description
Defines whether the content of the fields of a title bar should be shortened if the column width 
is too small. Write/Read access.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TitleDarkShadowColor

Description 
Specifies the color of the dark side of shading. You open a color selection with the button. The 
settings are only active if the "Shading Color" option is enabled.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TitleForeColor

Description   
Specifies the font color of the table headers for the selected status. You open a color selection 
dialog box with the button. 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TitleGridLineColor

Description 
Defines the color of row/column dividers in the table header. You open a color selection dialog 
box with the button.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TitleLightShadowColor

Description 
Specifies the color of the bright side of shading. You open a color selection dialog box with the 
button. The setting is only effective when the "Shading color" option is activated.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

Titleline

Description
TRUE, when the control has a title bar and it can be moved in Runtime. BOOLEAN write-read 
access.

TitleSort

Description
Defines how to trigger sorting by column title. You can only sort by column title if the "Auto-
scrolling" option is disabled.   

Access in Runtime: Read and write

Syntax
Object.TitleSort[=GridSortTrigger]

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl", 
"OnlineTrendControl", "MessageView", "RecipeView".
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GridSortTrigger

Value Description Explanation
0 No Sorting by column header is disabled.
1 With click Sorting is triggered by clicking in the column header.
2 With double-click Sorting is triggered by double-clicking in the column title.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

TitleStyle

Description
Specifies whether to set a shading color for the table header.   

Access in Runtime: Read and write

Syntax
Object.TitleStyle[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl", 
"OnlineTrendControl", "MessageView", "RecipeView".

BOOLEAN

Value Description Description
0 Flat Disables the use of shading colors. Flat header style.
1 Button Enables the use of shading colors. 3D representation of the header.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)
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Toggle

Description
Specifies whether the selected object engages after it has been operated in Runtime. 

Access in Runtime: Read and write

Syntax
Object.Toggle[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Roundbutton".".

BOOLEAN
Optional TRUE, if the selected object engages after it has been operated in Runtime.

See also
Button (Page 3968)

Tolerance

Description
Specifies the limit for the storage space display as of which a deviation will be reported. 

Access in Runtime: Read and write

Syntax
Object.Tolerance[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView"".

Int
Optional A value or a constant that specifies the limit for the storage space display as of which 
a deviation will be reported.

See also
DiskSpaceView (Page 3991)
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ToleranceColor

Description
Specifies the colors in which the bars of the storage space display will be shown as soon as 
the tolerance range is exceeded. 

Access in Runtime: Read and write

Syntax
Object.ToleranceColor[=Color]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Color
Optional A value or a constant that specifies the colors in which the bars of the storage space 
display will be shown as soon as the tolerance range is exceeded.

See also
DiskSpaceView (Page 3991)

ToleranceHigh property

Description
Defines or returns the limit value for "Tolerance high". 
The type of the evaluation (in percent or absolute) is defined in the "TypeToleranceHigh" 
property.
The monitoring of the limit value is only valid if the "CheckToleranceHigh" property is set to 
"TRUE".

ToleranceLow property

Description
Defines or returns the limit value for "Tolerance low". 
The type of the evaluation (in percent or absolute) is defined in the "TypeToleranceLow" 
property.
The monitoring of the limit value is only valid if the "CheckToleranceLow" property is set to 
"TRUE".
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ToleranceLowerLimit 

Description
Specifies whether the "ToleranceLowerLimit"" limit is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.ToleranceLowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies whether the limit "ToleranceLowerLimit" is 
monitored.

See also
Bar (Page 3961)

ToleranceLowerLimitColor

Description
Specifies the color for the lower limit "ToleranceLowerLimit"". 

Access in Runtime: Read and write

Syntax
Object.ToleranceLowerLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the lower limit "ToleranceLowerLimit" 
".

Comments
The "ToleranceLowerLimitEnable" property must have the value TRUE if the bar color is to 
change once the limit has been reached.
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See also
Bar (Page 3961)

ToleranceLowerLimitEnabled

Description
Specifies whether the "ToleranceLowerLimit" limit is to be monitored. The limit, the display 
when the limit has been reached, and the type of evaluation are set with the properties 
"ToleranceLowerLimit", "ToleranceLowerLimitColor" and "ToleranceLowerLimitRelative". 

Access in Runtime: Read and write

Syntax
Object.ToleranceLowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "ToleranceLowerLimit" limit is to be monitored.

See also
Bar (Page 3961)

ToleranceLowerLimitRelative

Description
Specifies whether the lower limit "ToleranceLowerLimit" is to be evaluated as a percentage or 
as an absolute value. 

Access in Runtime: Read and write

Syntax
Object.ToleranceLowerLimitRelative[=BOOLEAN]

Object
Required A ""ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit "ToleranceLowerLimit" is to be evaluated as a percentage or 
an absolute value.
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See also
Bar (Page 3961)

ToleranceUpperLimit 

Description
Specifies whether the "ToleranceUpperLimit" limit is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.ToleranceUpperLimit[=Double]

Object
Required A "ScreenItem" object with the format ""Bar".

Double
Optional A value or a constant that specifies whether the limit "ToleranceUpperLimit" is 
monitored.

Comments
The following values will be specified with the properties "ToleranceUpperLimit", 
"ToleranceUpperLimitColor"" and "ToleranceUpperLimitRelative": 

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 3961)

ToleranceUpperLimitColor 

Description
Specifies the color for the upper limit "ToleranceUpperLimit". 

Access in Runtime: Read and write

Syntax
Object.ToleranceUpperLimitColor[=Color]
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Object
Required A "ScreenItem" object with the format "Bar".".

Color
Optional A value or a constant that specifies the color of the upper limit "ToleranceUpperLimit"".

See also
Bar (Page 3961)

ToleranceUpperLimitEnabled

Description
Specifies whether the "ToleranceUpperLimit"" limit is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.ToleranceUpperLimitEnabled[=BOOLEAN]

Object
Required A ""ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "ToleranceUpperLimit" limit is to be monitored. 

Comments
The following values will be specified with the properties "ToleranceUpperLimit",", 
"ToleranceUpperLimitColor" and "ToleranceUpperLimitRelative": 

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 3961)
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ToleranceUpperLimitRelative

Description
Specifies whether the lower limit "ToleranzHigh"" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.ToleranceUpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Bar".

BOOLEAN
Optional TRUE, if the lower limt "ToleranzHigh" is to be evaluated as a percentage or an 
absolute value.

See also
Bar (Page 3961)

ToolbarAlignment

Description   
Defines or returns the position of the toolbar. Write/Read access.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarBackColor

Description
Background color - ToolbarBackColor

Specifies the background color of the toolbar. Open the "Color selection" dialog by clicking the 
button.
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The background color you configured is only displayed if the "Display" option is enabled.   

Access in Runtime: Read and write

Syntax
Object.ToolbarBackColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", 
"RecipeView".

Color
Optional A value or a constant which specifies the background color.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonActive

Description
Activates a button function in Runtime. Clicking the button in Runtime triggers the 
corresponding function.   

Access in Runtime: Read and write

Syntax
Object.ToolbarButtonActive[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", 
"RecipeView".

BOOLEAN
TRUE: The function connected to the key is active.

FALSE: The function connected to the key is not active. You can connect your own functions 
to the key by local scripts.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonAdd

Description  
Creates a new, user-defined button function. The name set by WinCC can be edited in the 
"Object name" field. 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonBeginGroup

Description
Inserts a leading separator (vertical line) for the selected button function on the toolbar. These 
separators can be used to group the icons of the button functions.   

Access in Runtime: Read and write

Syntax
Object.ToolbarButtonBeginGroup[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", 
"RecipeView".

BOOLEAN
TRUE: The separator is inserted in front of the selected key function.

FALSE: The separator is not inserted in front of the selected key function.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonCount

Description   
Defines the number of configurable button functions.

 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonEnabled

Description   
Enables operation of custom toolbar buttons. 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)
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ToolbarButtonHotKey

Description
Shows the hotkey for a button function selected. 

You create or edit a hotkey by clicking in the "Hotkey" field and pressing the button or key 
shortcut required.  .

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonID

Description
Unique ID number for the selected button function. WinCC assigns this read only ID number.  .

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonIndex

Description   
References a button function. Using this attribute you can assign the values of other attributes 
to a specific button function. 

Valid values for "ToolbarButtonIndex" are between 0 and "ToolbarButtonCount" minus 1. The 
"ToolbarButtonCount" attribute specifies the number of configurable key functions.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonLocked

Description 
Enables/disables the display of the pressed state of a user-defined toolbar button.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonName

Description
Shows the name for the selected button function. You rename user-defined button functions.   
The "ToolbarButtonName" property for customized functions can be dynamized by the 
ToolbarButtonRename property.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)
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ToolbarButtonPasswordLevel

Description
Shows the authorization for a button function selected. You can edit the authorization using 
the selection button.   The authorizations are configured in the user administration.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonRemove

Description  
Removes the selected button function from the list. Only user-defined button functions can be 
removed. 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonRename

Description   
Changes the name of the customized element of the toolbar which is referenced by the 
"ToolbarButtonIndex" property. 

With "ToolbarButtonRename" you also dynamize the "ToolbarButtonName" property.
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See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonRepos

Description
Changes the sorting order of button functions. "Up" and "Down" move the button function 
selected up or down in the list. This moves the button function in the toolbar of a Control towards 
the front or towards the back.   

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarButtonTooltipText

Description   
Specifies the tooltip text for the button.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)
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ToolbarButtonUserDefined

Description
Indicates whether the project engineer has added a new user-defined toolbar button.  

Syntax
Object.ToolbarButtonUserDefined[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"FunctionTrendControl", "TrendRulerControl", "UserArchiveControl".

Boolean
TRUE: The key of the toolbar is customized.

FALSE: The key of the toolbar is specified by the system.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarShowTooltips

Description
Enables the display of tooltips for the button functions in Runtime. The property can be 
dynamized with the ToolbarShowTooltips name. The property for specifying the tooltip text is 
"ToolbarButtonTooltipText".    

Access in Runtime: Read and write

Syntax
Object.ToolbarShowTooltips[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "FunctionTrendControl", "RecipeView", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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BOOLEAN
TRUE: The tooltips are displayed.

FALSE: The tooltips are not displayed.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarUseBackColor

Description
Enables the display of the background color for a toolbar.     

Access in Runtime: Read and write

Syntax
Object.ToolbarUseBackColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "FunctionTrendControl", "RecipeView", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The background color of the toolbar is displayed.

FALSE: The background color of the toolbar is not displayed.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4623



ToolbarUseHotKeys

Description
Activates the hotkeys for button functions in Runtime. Insert the hotkeys for button functions 
in the "Hotkey" field.     

Access in Runtime: Read and write

Syntax
Object.ToolbarUseHotKeys[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "FunctionTrendControl", "RecipeView", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The hotkeys are activated.

FALSE: The hotkeys are not activated.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarVisible

Description
Specifies whether the toolbar of the control is displayed.     

Access in Runtime: Read and write

Syntax
Object.ToolbarVisible[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "FunctionTrendControl", "UserArchiveControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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BOOLEAN
TRUE: The toolbar is displayed.

FALSE: The toolbar is not displayed.

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

OnlineTrendControl (Page 4045)

ToolbarVisible

Description
Enables the display of the Control toolbar.   

Access in Runtime: Read and write

Syntax
Object.ToolbarVisible[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", "RulerControl", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "RecipeView".

BOOLEAN
TRUE: The toolbar is displayed.

FALSE: The toolbar is not displayed.

ToolTipText

Description
Specifies the tooltip text. 

Access in Runtime: Read and write

Syntax
Object.ToolTipText[=String]
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Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Roundbutton", "Switch", "GraphicView", 
"GraphicIOField", "Bar", "StatusForce", "Checkbox", "OptionGroup", "WindowSlider", 
"OleView" or "Connector".

String
Optional A value or a constant that specifies the tooltip text.
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

MultiLineEdit (Page 4032)

Listbox (Page 4027)

Top 

Description
Specifies the value of the Y coordinate of the selected object.     

Access during runtime: Read and write
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Syntax
Object.Top[= DOUBLE]

Object
Necessary. A "ScreenItem" object. This property is a standard property of the ScreenItem 
object and is therefore available for all formats.

DOUBLE
Optional A value or a constant that contains the value of the Y coordinate in pixels (measured 
from the top left edge of the screen).

Comments
The Y coordinate refers to the top left corner of the rectangle that surrounds the object. The 
screen limits are also monitored in runtime. If the assigned coordinate value exceeds the 
display size, the user-defined function is interrupted with an error message. 

Used for the following object types:
IOField

Rectangle

Slider
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

ScreenWindow (Page 4078)

DiskSpaceView (Page 3991)

ChannelDiagnose (Page 3972)

ScriptDiagnostics (Page 4080)

Group (Page 4017)

ForeignControl (Page 4000)

DateTimeField (Page 3989)

ProtectedAreaName (Page 4064)

UserView  (Page 4137)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

UserArchiveControl (Page 4130)

SystemDiagnoseView (Page 4100)

TrendRulerControl (Page 4110)

ProjectName (Page 4062)

BatteryView (Page 3967)

RangeLabelView (Page 4065)

ZoneQualityView (Page 4144)

ZoneLabelView (Page 4143)

WLanQualityView (Page 4142)

TrendView (Page 4118)

SystemDiagnoseWindow (Page 4103)

StatusForce (Page 4087)

SmartClientView (Page 4085)

RecipeView (Page 4068)

RangeQualityView (Page 4067)

AlarmView (Page 3958)
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TopConnectedConnectionPointIndex

Description
Specifies or sets the index number of the top connecting point.

LONG write-read access.

TopConnectedObjectName

Description
Specifies or sets the object name of the object which is docked on at the bottom connecting 
point.

LONG write-read access.

TopOffset

Description 
Defines or returns the distance of the picture from the top edge of the picture window. 

The picture is displayed as a cutout of the picture window. The picture scroll bars are located 
at the left and upper edge of the picture. If you wish to display the picture in the picture window 
by using the horizontal and vertical positioning of the picture scroll bars, use the properties 
"HorizontalScrollBarPosition" and "VerticalScrollBarPosition" for such positioning.

See also
ScreenWindow (Page 4078)

Total 

Description
Returns the storage capacity. 

Access in Runtime: Read and write

Syntax
Object.Total[=Double]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".
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Double
Optional A value or a constant that returns the storage capacity.

See also
DiskSpaceView (Page 3991)

Transparency

Description 
Defines and returns the percentage transparency of the object. 

0 = no transparency; 100 = complete transparency (invisible)

The text and fields of the graphic objects are only transparent at "100."

In runtime, a completely transparent object (invisible) is also functional. 
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See also
Slider (Page 4082)

CheckBox (Page 3974)

GraphicIOField (Page 4011)

Bar (Page 3961)

WindowSlider (Page 4139)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

Rectangle (Page 4072)

MultiLineEdit (Page 4032)

Line (Page 4025)

Listbox (Page 4027)

Button (Page 3968)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Clock (Page 3984)

Connector (Page 3986)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Gauge (Page 4008)

GraphicView (Page 4014)

Polygon (Page 4057)

Polyline (Page 4060)

RoundButton (Page 4074)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)
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TransparentColor

Description
Specifies which color of the allocated graphic (*.bmp, *dib) of the specified object will be set 
to "transparent".   

The "UseTransparentColor" property must have the value TRUE so that the color will be shown 
as transparent.

Access in Runtime: Read and write

Syntax
Object.TransparentColor[= Color]

Object
Required An object of type "ScreenItem" with the formats "GraphicView" or "GraphicIOField".

Color
Optional A value or a constant that specifies the color that will be shown transparent.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
GraphicView (Page 4014)

GraphicIOField (Page 4011)

UseTransparentColor (Page 4685)

TransparentColorDeactivatedPicture

Description
Specifies which color of the allocated bitmap object will be set to "transparent" for the status 
"disabled". 

Access in Runtime: Read and write

Syntax
Object.TransparentColorDeactivatedPicture[=Color]
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Object
Required A ""ScreenItem" object with the format ""Roundbutton".

Color
Optional A value or a constant that specifies which color of the allocated bitmap object will be 
set to transparent" for the status "disabled".

Comments
The "PicDeactUseTransColor" property must have the value TRUE so that the color can be 
set to ""transparent".

TransparentColorPictureOff

Description
Specifies which color of the allocated bitmap object will be set to transparent" for the status 
"off". 

Access in Runtime: Read and write

Syntax
Object.TransparentColorPictureOff[=Color]

Object
Required A "ScreenItem" object with the format "Roundbutton".

Color
Optional A value or a constant that specifies which color of the allocated bitmap object will be 
set to transparent" for the status "off".

See also
Button (Page 3968)

TransparentColorPictureOn

Description
Specifies which color of the allocated bitmap object will be set to transparent" for the status 
"on". 

Access in Runtime: Read and write
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Syntax
Object.TransparentColorPictureOn[=Color]

Object
Required A "ScreenItem" object with the format "Roundbutton".

Color
Optional A value or a constant that specifies which color of the allocated bitmap object will be 
set to "transparent" for the status "on".

Comments
The "PicDownUseTransColor"" property must have the value TRUE so that the color can be 
set to "transparent".

See also
Button (Page 3968)

Trend

Description
TRUE, when the tendency (rising or falling) of the measuring value being monitored should 
be displayed by a small arrow. BOOLEAN write-read access. 

TrendActualize

Description
Enables the update of a selected trend.     

Access in Runtime: Read and write

Syntax
Object.TrendActualize[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The selected trend is always actualized.

FALSE: The selected trend is not actualized. This setting is useful when a logged trend is 
compared with a current trend.
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See also
FunctionTrendControl (Page 4004)

TrendAdd

Description
Creates a new trend.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendBeginTime

Description
Defines the start time of the time range for data transfer to the selected trend.  .

See also
FunctionTrendControl (Page 4004)

TrendColor

Description
Determines the color of the trend display or returns it.
The trend display indicates the tendency (rising or falling) of the measuring value being 
monitored by a small arrow. In order to activate the trend display, the Trend property must be 
set to "True". LONG write-read access. 

See also
FunctionTrendControl (Page 4004)

TrendColor

Description
Determines the color of the trend display or returns it.
The trend display indicates the tendency (rising or falling) of the measuring value being 
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monitored by a small arrow. In order to activate the trend display, the Trend property must be 
set to "True". LONG write-read access. 

See also
OnlineTrendControl (Page 4045)

TrendCount

Description   
Defines the number of configured trends.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendEndTime

Description
Defines the end of the time range for data connections of a selected trend. 

 .

See also
FunctionTrendControl (Page 4004)

TrendExtendedColorSet

Description
Enables configuration of the point and fill colors and the display of colors in Runtime.     

Access in Runtime: Read and write

Syntax
Object.TrendExtendedColorSet[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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BOOLEAN
TRUE: The settings in the "Point color" and "Fill color" fields are configurable and effective in 
Runtime.

FALSE: The settings in the "Point color" and "Fill color" fields are not configurable and effective 
in Runtime.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendFill

Description
Specifies if the area beneath the trend is to be filled.     

Access in Runtime: Read and write

Syntax
Object.TrendFill[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The area beneath the trend is shown filled. You can define the trend color as fill color 
if the "Advanced" option is deactivated. 

FALSE: The trend is not shown filled.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendFillColor

Description
Specifies the fill color of the trend. The settings are only active if the "Filled" option is enabled. 
Open the "Color selection" dialog by clicking the button.

The settings are only active if the "Advanced" option is enabled.
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See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendIndex

Description   
References a configured trend. You can assign the values of other properties to a specific 
trend by using the property. The index must always be set before you change the properties 
of a trend in runtime.

Valid values for "TrendIndex" are between 0 and "TrendCount" minus 1. The "TrendCount" 
property indicates the number of configured trends.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendIndicatorColor

Description
Specifies the color for the trend indicator. The trend indicator represents the tendency 
(increasing or falling) of the measurement value that is to be monitored with a small arrow. To 
activate the trend indicator, the property "ShowTrendIndicator" must have the value TRUE. 

Access in Runtime: Read and write

Syntax
Object.TrendIndicatorColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color of the trend indicator.

See also
Bar (Page 3961)
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TrendLabel

Description
Defines the label of the trend selected. The label is displayed in Runtime if the value at attribute 
"UseTrendNameAsLabel" is "FALSE". 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendLineStyle

Example
Defines the line style for trend visualization.     

Access in Runtime: Read and write

Syntax
Object.TrendLineStyle[=LineStyle]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

LineStyle

Value Description Explanation
0 Solid The trend is visualized as solid line.
1 Dashed The trend is visualized as dashed line.
2 Dotted The trend is visualized as dotted line.
3 Dash dot The trend is visualized as dot-dash line.
4 Dash Dot Dot The trend is visualized as dash-dot-dot line.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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TrendLineType

Description
Defines how to visualize a trend.     

Access in Runtime: Read and write

Syntax
Object.TrendLineType[=LineType]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

LineType

Value Description Explanation
0 None Only the dots are displayed.
1 Line Visualizes a trend with linear interconnection of points. 
2 Stepped Visualizes a stepped trend and its interconnected points.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendLineWidth

Description
Defines the line weight of the line displayed.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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TrendLowerLimit

Description  
Specifies the low limit of a tag. If the tag drops below the value of "TrendLowerLimit", the values 
are marked with the color set in "TrendLowerLimitColor". The specification is effective if the 
"TrendLowerLimitColoring" property has the value "TRUE".

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendLowerLimitColor

Description  
Specifies the color which marks tag values which are below the value of "TrendLowerLimit". 
The setting is effective if the "TrendLowerLimitColoring" attribute has the value "TRUE". 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendLowerLimitColoring

Description
Enables the "TrendLowerLimitColor" attribute for identifying tag values which are less than the 
value at "TrendLowerLimitValue".     

Syntax
Object.TrendLowerLimitColoring [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Boolean
TRUE: The "TrendLowerLimitColor" property is effective.

FALSE: The "TrendLowerLimitColor" property is not effective.
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See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendMeasurePoints

Number of measurement points - TrendMeasurePoints
Defines the number of measurement points for visualization of selected trends. 

Defines the number of value pairs provided to the trend from a user archive.

The attribute can be assigned dynamic properties by means of the name 
TrendMeasurePoints.

See also
FunctionTrendControl (Page 4004)

TrendName

Description
Displays the name of the selected trend. The name is defined on the "Trends" tab. The 
"TrendName" property can be dynamized by the TrendRename property.     

Access in Runtime: Read and write

Syntax
Object.TrendName

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendPointColor

Description
Defines the color of trend points. Open the "Color selection" dialog by clicking the button.
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The settings are only active if the "Advanced" option is enabled. 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendPointStyle

Description
Defines the dot style for trend visualization.     

Access in Runtime: Read and write

Syntax
Object.TrendPointStyle[=PointStyle]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

PointStyle

Value Description Explanation
0 None The points are not displayed.
1 Dots The trend points are visualized with a size of one pixel. The setting 

in the "Dot width" field is deactivated.
2 Squares The dots are displayed as square. The setting in the "Dot width" 

field is active.
3 Circles The dots are displayed as circles. The setting in the "Dot width" field 

is active.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendPointWidth

Description
Sets the dot width in pixels. You can only define the dot width for the "square" and "circular" 
type.
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See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendProvider 

Description
Specifies the data source for a selected trend.     

Access in Runtime: Read and write

Syntax
Object.TrendProvider[=Provider]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Provider

Value Description  Explanation
0 None No data source configured for implementation in Runtime by means of 

a user-defined function.
1 Archive tags Data source with archive tags of a process value archive.
2 HMI tags Data supply with tag values of HMI tags
3 Recipe data Data supply with columns of a recipe

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendRangeType

Description
Defines the time range for providing data to the selected trend. 

You can only define the number of measuring points if you select user archives as the data 
source.     

Access in Runtime: Read and write
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Syntax
Object.TrendRangeType[=RangeType]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

RangeType

Value Description Explanation
0 Time range Defines the start time and the time range for the data 

connection.
1 Start to end time Defines the start and end time for the data connection.
2 Number of measurement 

points
Defines the start time and the number of measurement points 
for the data connection. 

See also
FunctionTrendControl (Page 4004)

TrendRemove

Description
Removes selected trends from the list.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendRename

Description   
Changes the name of the trend which is referenced by the "TrendIndex" property.

With "TrendRename" you also dynamize the "TrendName" property.

 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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TrendRepos

Description
Repositions the trend in the trend window. "Up" and "Down" move the selected trend up or 
down in the list. This moves the trend towards the foreground or background for visualization 
in Runtime. 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendSelectTagNameX

Description   
Opens the dialog box for selecting the tag name for the data supply of the X axis in the f(x) 
trend view. Programmers can use the property to let the user select a tag name with a button 
for example.

See also
FunctionTrendControl (Page 4004)

TrendSelectTagNameY

Description   
Opens the dialog box for selecting the tag name for the data supply of the Y axis in the f(x) 
trend view. Programmers can use the property to let the user select a tag name with a button 
for example.

 

See also
FunctionTrendControl (Page 4004)

TrendTag

Description
Specifies which tag is linked with the selected trend. 
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You enter the value either in the form "archive name/tag name", to show tags of a process 
value archive, or in the form "tag name" to show an internal or an external tag that will now be 
saved in an archive. 

Access in Runtime: Read and write

Syntax
Object.TrendTag[=HmiTag]

Object
Required A ""ScreenItem" object with the format "OnlineTrend".

HmiTag
Optional A value or a constant that specifies which tags are linked with the selected trend. 

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

TrendTagNameX

Description
Shows the name of the bound HMI tag or column for the X axis. You select an HMI tag or a 
column with the selection button.     

Access in Runtime: Read and write

Syntax
Object.TrendTagNameX

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
FunctionTrendControl (Page 4004)
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TrendTagNameY

Description
Shows the name of the bound HMI tag or column for the Y axis. You select an HMI tag or a 
column with the selection button.     

Access in Runtime: Read and write

Syntax
Object.TrendTagNameX

Object
Required. An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
FunctionTrendControl (Page 4004)

TrendTimeRangeBase

Description
Defines the time unit for calculating the time range.     

Access in Runtime: Read and write

Syntax
Object.TrendTimeRangeBase[=TimeRangeBase]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

TimeRangeBase

Value Description
500 500 ms
1000 1 second
60000 1 minute
3600000 1 hour
86400000 1 day
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See also
FunctionTrendControl (Page 4004)

TrendTimeRangeFactor

Description
Defines the factor for calculating the time range. Only integer factors are valid.  .

See also
FunctionTrendControl (Page 4004)

TrendTrendWindow

Description
Defines the trend window for visualizing the trend selected. Define the available trend windows 
in the "Trend window" tab.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendUncertainColor

Description   
Value are in uncertain state if the initial value is unknown after runtime has been activated, or 
if a substitute value is used. With the "TrendUncertainColor" property you specify the color 
which is used for marking these values. Whether the information is evaluated depends on the 
"TrendUncertainColoring" property.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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TrendUncertainColoring

Description
Value are in uncertain state if the initial value is unknown after runtime has been activated, or 
if a substitute value is used. The "TrendUncertainColoring" attribute is used to enable 
identification of such values based on the color set in "TrendUncertainColor".     

Access in Runtime: Read and write

Syntax
Object.TrendUncertainColoring[=BOOLEAN]

Object

Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The setting of the "TrendUncertainColor" property is effective.

FALSE: The setting of the "TrendUncertainColor" property is not effective.

 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendUpperLimit

Description   
Specifies the high limit of a tag. If the tag drops below the value of "TrendUpperLimit", the 
values are marked by the color set in "TrendUpperLimitColor". The specification is effective if 
the "TrendUpperLimitColoring" attribute has the value "TRUE".

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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TrendUpperLimitColor

TrendUpperLimitColor
Specifies the color of tag values which are less than the value at "TrendLowerLimit". This 
setting is only active if the value at attribute "TrendUpperLimitColoring" is "TRUE". 

The attribute can be assigned dynamic properties by means of the name 
TrendUpperLimitColor.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendUpperLimitColoring

Description
Specifies whether the selection frame is shown with the specified color.     

Access in Runtime: Read and write

Syntax
Object.TrendUpperLimitColoring[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The setting of the "TrendUpperLimitColor" attribute is effective.

FALSE: The setting of the "TrendUpperLimitColor" attribute is not effective.

 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendVisible

Description
The list shows all trends you created.
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Select the trends to be displayed in the trend window from the list.

Click a trend entry in the list to adapt the properties and to assign axes and trend windows to 
the trend.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowAdd

Description
Create a new trend view.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowCoarseGrid

Description
Enables the display of grid lines for the main scale.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowCoarseGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The grid lines for the main scaling are displayed.

FALSE: The grid lines for the main scaling are not displayed.
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See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowCoarseGridColor

Description
Specifies the grid color of the main scale. Open the "Color selection" dialog by clicking the 
button.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowFineGrid

Description
Enables the display of grid lines for the secondary scale.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowFineGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The grid lines for the auxiliary scaling are displayed.

FALSE: The grid lines for the auxiliary scaling are not displayed.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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TrendWindowFineGridColor

Description
Specifies the grid color of the main scale. Open the "Color selection" dialog by clicking the 
button.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowForegroundTrendGrid

Description
Enables the display of grid lines only for the foreground trend in the trend window.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowForegroundTrendGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The grid lines for the foreground trend are displayed.

FALSE: The grid lines for the foreground trend are not displayed.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowGridInTrendColor

Description
Sets the trend color for the visualization of the grid lines for the main scale.     

Access in Runtime: Read and write
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Syntax
Object.AutoSelectionRectColors [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The grid lines are displayed in the trend color.

FALSE: The grid lines are displayed with the color set in the "Color" field.

 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowHorizontalGrid

Description
Enables the display of horizontal grid lines.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowHorizontalGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The horizontal grid lines are displayed.

FALSE: The horizontal grid lines are not displayed.

 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4656 System Manual, 07/2013,  



TrendWindowIndex

Description   
References a configured trend view. You can assign the values of other properties to a specific 
trend window by using the property.

Valid values for "TrendWindowIndex" are between 0 and "TrendWindowCount" minus 1. The 
"TrendWindowCount" property indicates the number of configured trend windows.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowName

Description
Defines the name of the trend window selected.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowRemove

Description
Removes the selected trend view from the list.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowRename

Description  
Changes the name of the trend window which is referenced by the "TrendWindowIndex" 
property.

With "TrendWindowRename" you also dynamize the "TrendWindowName" property.
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See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowRepos

Description
Changes the order of the trend view. "Up" and "Down" move the selected trend up or down in 
the list. 

The sorting order in the list defines the position in the Control. The first trend view is shown in 
the lowest position, the last trend view in the highest position.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowRulerColor

Description
Specifies the ruler color. Open the "Color selection" dialog by clicking the button. 

The color can be configured and displayed if "1 - graphic" is set for visualization. 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowRulerLayer

Description
Specifies the display layer of the ruler in the trend view.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowRulerLayer[=RulerLayer]
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Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

RulerLayer 

Value Description Explanation
0 Under grid The ruler is visualized on a layer under the grid.
1 Between grid and 

trend
The ruler is positioned on top of the trend and under the grid.

2 On top of trend The ruler is positioned on top of the trend.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowRulerStyle

Description
Defines the appearance of the ruler.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowRulerStyle [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The ruler is displayed as a single black line.

FALSE: The ruler is is displayed in the configured "Color" and "Width".

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)
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TrendWindowRulerWidth

Description
Defines the width of the ruler in pixels.

The width can be configured and displayed if "1 - graphic" is set for visualization. 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowSpacePortion

Description
Specifies the proportion of the trend widow to be used for the selected curve. 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowVerticalGrid

Description
Enables the display of vertical grid lines.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowVerticalGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The vertical grid lines are displayed.

FALSE: The vertical grid lines are not displayed.
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See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendWindowVisible

Description
The trend lines which you have created are listed in the list.

Activate the trend views in the list which you want to display in the control.

Click a list entry to adapt the ruler and grid line properties.

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

TrendXAxis

Description
Defines the X axis to be used for the trend selected. Define the available X axes inn the "X 
Axes" tab.

See also
FunctionTrendControl (Page 4004)

TrendYAxis

Description
Defines the Y axis to be used for the trend selected. Define the available Y axes inn the "Y 
Axes" tab.

See also
FunctionTrendControl (Page 4004)
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Type

Description
Returns the type of the specified object as STRING. Name diagram: Hmi<ObjectName>, e.g. 
HmiCircle for the "circle" screen object. 

Access in Runtime: Read

Syntax
Object.Type

Object
Required A "ScreenItem" object.

TypeAlarmHigh

Description
TRUE, when the upper limit value, at which an alarm is triggered, should be evaluated as a 
percentage. FALSE, when the evaluation should be as an absolute value. BOOLEAN write-
read access. 

TypeAlarmLow

Description
TRUE, when the lower limit value, at which an alarm is triggered, should be evaluated as a 
percentage. FALSE, when the evaluation should be as an absolute value. BOOLEAN write-
read access. 

TypeLimitHigh4

Description
TRUE, when the "Reserve 4" upper limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 

TypeLimitHigh5

Description
TRUE, when the "Reserve 5" upper limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 
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TypeLimitLow4

Description
TRUE, when the "Reserve 4" lower limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access.

TypeLimitLow5

Description
TRUE, when the "Reserve 5" lower limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 

TypeToleranceHigh

Description
TRUE, when the "Tolerance high" lower limit value should be evaluated as a percentage. 
FALSE, when the evaluation should be as an absolute value. BOOLEAN write-read access.

TypeToleranceLow

Description
TRUE, when the "Tolerance low" lower limit value should be evaluated as a percentage. 
FALSE, when the evaluation should be as an absolute value. BOOLEAN write-read access. 

TypeWarningHigh

Description
TRUE, when the "Warning high" lower limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 

TypeWarningLow

Description
TRUE, when the "Warning low" lower limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 
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Properties U-W

UncertainStateColor(i) 

Description
Specifies the color for the identification of values with an uncertain status. 

Access in Runtime: Read and write

Syntax
Object.UncertainStateColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Color
Optional A value or a constant that specifies the color for the identification of values with an 
uncertain status.

Comments
The parameter i indicates the number of the trend. 

If the start value of a value is not known after Runtime has been activated or a substitute value 
is used, then this value has an uncertain status.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

UncertainStateEnabled(i)

Description
Specifies if values with an uncertain status are identified with the color set up in 
"ReplacementColor(i)"". 

If the start value of a value is not known after Runtime has been activated or a substitute value 
is being used, then this value is considered to have an uncertain status. 

Access in Runtime: Read and write
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Syntax
Object.UncertainStateEnabled(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if values with an uncertain status are identified with the color specified in 
""ReplacementColor(i".

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

Unit

Description
Specifies the unit of measurement in the "IOField" object.

See also
Bar (Page 3961)

IOField (Page 4021)

UnitColor

Description
Specifies the text color for the label of the measurement unit in the "Gauge" object 

Access in Runtime: Read and write

Syntax
Object.UnitColor[= Color]

Object
Required A "ScreenItem" object with the format "Gauge".
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Color
Optional A value or a constant that specifies the text color for the measurement unit.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Gauge (Page 4008)

UnitText

Description
Specifies the text for the measurement unit of the selected object. 

Access in Runtime: Read and write

Syntax
Object.UnitText[= STRING]

Object
Required A "ScreenItem" object with the format ""Gauge".

STRING
Optional A value or a constant that specifies the text for the measurement unit.

Comments
Enter a text to show, for example, the physical unit of the displayed value. It is standard for no 
text to be set as a default.

See also
Gauge (Page 4008)
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UnitTop

Description
Specifies the distance of the measurement unit to the upper edge of the selected object. The 
lettering can be positioned only in line with the vertical diameter of the scale. The value of the 
property refers to the height of the selected object and is measured from the upper edge of 
the selected object to the lower edge of the lettering. 

Access in Runtime: Read and write

Syntax
Object.UnitTop[=Double]

Object
Required A ""ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the distance of the measurement unit to the upper 
edge of the selected object.

Value range from 0 to 1 

0: The lower edge of the lettering is positioned on the upper limit of the selected object. The 
text is no longer visible as it is positioned outside of the selected object. 

1: The lower edge of the lettering is positioned on the lower limit of the selected object.

See also
Gauge (Page 4008)

UnselBGColor property 

Description
Defines or returns the background color of entries in the text list object which are not selected. 
LONG write-read access.

UnselTextColor property

Description
Defines or returns the color of the text for entries in the text list object which are not selected. 
LONG write-read access.
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UpdateCycle property

Description
Returns the type and frequency of updating the picture window in Runtime. Read only access.

UpdateEnable

Description
Specifies whether the recipe view can be altered in Runtime.   

Access in Runtime: Read and write

Syntax
Object.UpdateEnable[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the recipe view can be altered in Runtime.

UpperLimit

Description
Specifies the upper limit for input values. 

Access in Runtime: Read and write

Syntax
Object.UpperLimit[=Double]

Object
Required A "ScreenItem" object with the format "IOField".

Double
Optional A value or a constant that specifies the upper limit for input values.

See also
IOField (Page 4021)
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UpperLimitColor(i)

Description
Specifies the color that identifies the tag values that lie above the value of 
""UpperLimitValue(i)". Whether the information is evaluated depends on the value of the 
property ""UpperLimitEnabled(i)". 

Access in Runtime: Read and write

Syntax
Object.UpperLimitColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

Color
Optional A value or a constant that identifies the tag values that lie above the value of 
""UpperLimitValue(i)". 

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

UpperLimitEnabled(i)

Description
Specifies whether the information from "UpperLimitColor(i)" is used to identify the tag values 
that lie above the value of "UpperLimitValue(i)". 

Access in Runtime: Read and write

Syntax
Object.UpperLimitEnabled(i)[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

BOOLEAN
Optional TRUE, if the information from "UpperLimitColor(i)"" is used to identify the tag values 
that lie above the value of "UpperLimitValue(i)".

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

UpperLimitValue(i) 

Description
Specifies whether the tag values that exceed the "UpperLimitValue(i)" are to be identified with 
the color specified in "UpperLimitColor(i)"". Whether the information is evaluated depends on 
the value of the property "UpperLimit(i)".".

Access in Runtime: Read and write

Syntax
Object.UpperLimitValue(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies whether the tag values that exceed the 
""UpperLimitValue(i)" value are to be identified with the color specified in UpperLimitColor(i)"".

Comments
The parameter i indicates the number of the trend. 
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See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

UseAllServers

Description
Specifies whether the data to be shown in the alarm window can be requested from all servers 
in a distributed system. Alarm Logging must be activated on the respective servers. 

Access in Runtime: Read-only

Syntax
Object.UseAllServers[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmView".

BOOLEAN
Optional. TRUE, if the data to be shown in the alarm window can be requested from all servers 
in a distributed system.

See also
AlarmControl (Page 3947)

UseBarBorderConstraints

Description
Specifies whether the bar border is restricted to specific values. 

Access in Runtime: Read and write

Syntax
Object.UseBarBorderConstraints[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional. TRUE, if the bar border is restricted to specific values.
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See also
Bar (Page 3961)

UseTagLimitColors

Description
Specifies that colors are used.

UseDesignColorShema

Description
Defines whether the colors defined for the current design in the global color scheme will be 
used for this object. 

TRUE if the object is displayed with the colors from the global color scheme defined for this 
object type. 

FALSE if the object is displayed with the colors as per the settings in the object. 

BOOLEAN write-read access. 
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See also
Slider (Page 4082)

CheckBox (Page 3974)

Button (Page 3968)

Bar (Page 3961)

WindowSlider (Page 4139)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

Rectangle (Page 4072)

MultiLineEdit (Page 4032)

Line (Page 4025)

Listbox (Page 4027)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Clock (Page 3984)

Connector (Page 3986)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Gauge (Page 4008)

GraphicView (Page 4014)

Polygon (Page 4057)

Polyline (Page 4060)

RoundButton (Page 4074)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)
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UseDesignShadowSettings

Description
Defines whether the object will be displayed with the shadowing defined in the active design. 

TRUE if the object is displayed with the global shadow defined for this object type. 

FALSE if no shadow is displayed. 

BOOLEAN write-read access. 
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See also
Slider (Page 4082)

CheckBox (Page 3974)

GraphicIOField (Page 4011)

Button (Page 3968)

Bar (Page 3961)

WindowSlider (Page 4139)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

Rectangle (Page 4072)

MultiLineEdit (Page 4032)

Line (Page 4025)

Listbox (Page 4027)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Clock (Page 3984)

Connector (Page 3986)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Gauge (Page 4008)

GraphicView (Page 4014)

Polygon (Page 4057)

Polyline (Page 4060)

RoundButton (Page 4074)

SymbolicIOField (Page 4093)

IOField (Page 4021)

TextField (Page 4107)

OptionGroup (Page 4054)
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UseEffectiveProcessValue

Description
Specifies whether an actual percentage made up of maximum value, minimum value, average 
of the last 15 values and hysteresis will be used. 

Access in Runtime: Read and write

Syntax
Object.UseEffectiveProcessValue[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if an actual percentage made up of maximum value, minimum value, average 
of the last 15 values and hysteresis will be used.

See also
Bar (Page 3961)

UseExponentialFormat 

Description
Specifies whether the figures are shown exponentially (e.g. "1,00e+000"). 

Access in Runtime: Read and write

Syntax
Object.UseExponentialFormat[=BOOLEAN]

Object
Required A "ScreenItem"  object with the format "Bar".

BOOLEAN
Optional TRUE, if the figures are shown exponentially (e.g. "1,00e+000").

See also
Bar (Page 3961)
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UseFlashTransparentColor

Description
Specifies whether the color of the bitmap object of a flashing graphic will be set to 
""transparent". 

Access in Runtime: Read and write

Syntax
Object.UseFlashTransparentColor[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "GraphicIOField".

BOOLEAN
Optional TRUE, if the color of the bitmap object of a flashing graphic will be set to "transparent".

See also
GraphicIOField (Page 4011)

UseGDI 

Description
Specifies whether the ellipse is shown via GDI or GDI+. 

Access in Runtime: Read and write

Syntax
Object.UseGDI[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Ellipse".

BOOLEAN
Optional TRUE, if the ellipse is shown via GDI.

See also
Ellipse (Page 3993)
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UseMeasurePoints(i) 

Description
Specifies whether the time range for the selected trend will be determined by measuring points 
or the end time. Whether the information is evaluated depends on the properties 
"TimeAxisEndTime", "TimeAxisBeginTime(i)". 

Define time range for curve i through measure points (TRUE) or end time (FALSE) (for time 
based tag providers)

Access in Runtime: Read and write

Syntax

Object.UseMeasurePoints(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl"or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if the time range for the selected trend will be determined by measuring points.

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

UseMessageColor

Description
Specifies whether the agreed colors of the message classes are displayed.   

Access in Runtime: Read and write

Syntax
Object.UseMessageColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".
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BOOLEAN
TRUE: The colors are displayed.

FALSE: The color settings specified for the table content on the "Layout" tab are effective.

 

See also
AlarmControl (Page 3947)

UseMultipleLimits

Description
Specifies whether one or more pairs of limits are shown as a selection or a line. 

Access in Runtime: Read and write

Syntax
Object.UseMultipleLimits[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Bar".

BOOLEAN
Optional TRUE, if one or more pairs of limits are displayed as a selection or a line.

See also
Bar (Page 3961)

UseScaleConstraints

Description
Specifies whether the distance between two large marking lengths of the scale are calculated 
from the minimum and maximum values. 

Access in Runtime: Read and write

Syntax
Object.UseScaleConstraints[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".
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BOOLEAN
Optional TRUE, if the distance between two large marking lengths of the scale are calculated 
from the minimum and maximum values.

See also
Bar (Page 3961)

UseScaledBarBorder 

Description
Specifies whether the rectangle that surrounds the object is shown dependent of the scale or 
as a default. 

Access in Runtime: Read and write

Syntax
Object.UseScaledBarBorder[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".".

BOOLEAN
Optional TRUE, if the rectangle that surrounds the object is shown dependent on the scale.

See also
Bar (Page 3961)

UseSelectedTitleColor

Description
Specifies whether to use a selection color for the headers of selected table cells.   

Access in Runtime: Read and write

Syntax
Object.UseSelectedTitleColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "AlarmControl", "TrendRulerControl".
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BOOLEAN
TRUE: A marking color is used. The "Background" and "Font" settings are active in Runtime.

FALSE: A marking color is not used. The "Background" and "Font" settings are disabled in 
Runtime.

 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

UseSeparateDiagrams

Description
Specifies whether the trends are shown staggered. 

Access in Runtime: Read and write

Syntax
Object.UseSeparateDiagrams[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend" or "FunctionTrendView".

BOOLEAN
Optional TRUE, if the trends are shown staggered.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

UseSimplePresicionOffset

Description
Specifies how the field length will be calculated for the labeling of the scale. 

Access in Runtime: Read and write
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Syntax
Object.UseSimplePresicionOffset[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the field length will be calculated for the labeling of the scale.

See also
Bar (Page 3961)

UseTableColor2

Description
Specifies whether to use a second row color for the representation of the table.   

Access in Runtime: Read and write

Syntax
Object.UseTableColor2[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "AlarmControl", "TrendRulerControl".

BOOLEAN
TRUE: The settings of "RowColor 2" are used in alternation with "RowColor1".

FALSE: The settings of "RowColor 1" are used for all rows.

 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)
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UseTimeRange(i) 

Description
Specifies how the time range that is to be shown for the selected trend will be defined. 

Access in Runtime: Read and write

Syntax
Object.UseTimeRange(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend","FunctionTrendView" or 
"TableView".

BOOLEAN
Optional TRUE, if the time range that is to be shown is defined by means of a start time 
("TimeAxisBeginTime(i)") and an end time ("TimeAxisEndTime"). 

FALSE,, if the time range that is to be shown is defined by means of a start time 
("TimeAxisBeginTime(i)") and an end time "TimeRangeBase(i)" and "TimeRangeFactor(i)".

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

UseTransparentColor

Description
Specifies whether the color described with the property "TransparentColor" will be shown as 
transparent for the selected object. 

Access in Runtime: Read and write

Syntax
Object.UseTransparentColor[= BOOLEAN]

Object
Required A "ScreenItem" object with the formats "GraphicView" or "GraphicIOField".
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BOOLEAN
Optional TRUE, if the specified color is to be shown as transparent.

See also
GraphicView (Page 4014)

GraphicIOField (Page 4011)

UseTransparentColorDeactivatedPicture

Description
Specifies if the transparent color defined with the property 
"TransparentColorDeactivatedPicture" for the status "disabled" will be used. 

Access in Runtime: Read and write

Syntax
Object.UseTransparentColorDeactivatedPicture[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Roundbutton".

BOOLEAN
Optional TRUE, if the transparent color definded with the property 
"TransparentColorDeactivatedPicture" for the status "disabled" will be used.

UseTransparentColorPictureOff

Description
Specifies if the transparent color defined with the property "TransparentColorPictureOff" for 
the status "off" will be used. 

Access in Runtime: Read and write

Syntax
Object.UseTransparentColorPictureOff[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Roundbutton".

BOOLEAN
Optional TRUE, if the transparent color defined with the property "TransparentColorPictureOff" 
for the status "off" will be used.
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See also
Button (Page 3968)

UseTransparentColorPictureOn

Description
Specifies if the transparent color defined with the property "TransparentColorPictureOn" for 
the status "on" will be used. 

Access in Runtime: Read and write

Syntax
Object.UseTransparentColorPictureOn[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Roundbutton".

BOOLEAN
Optional TRUE, if the transparent color defined with the property "TransparentColorPictureOn" 
for the status "on" will be used.

See also
Button (Page 3968)

UseTrendNameAsLabel

Description
Specifies whether the "Name" or "Label" property is used as a designation for the trend in 
Runtime.     

Access in Runtime: Read and write

Syntax
Object.UseTrendNameAsLabel[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The name configured under "Properties > Properties > Trends > Name" is used.
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FALSE: The name configured under "Properties > Properties > Trends > Label" is used.

 

See also
FunctionTrendControl (Page 4004)

OnlineTrendControl (Page 4045)

Used

Description
Returns the size of the used disk space. 

Access in Runtime: Read and write

Syntax
Object.Used[=Double]

Object
Required A "ScreenItem" object with the format ""DiskSpaceView".

Double
Optional A value or a constant that returns the size of the used disk space.

See also
DiskSpaceView (Page 3991)

UsedPercent

Description
Returns the measured value for the used disk space as a percentage. The values can be 
queried in Runtime. The values cannot be predefined. 

Access in Runtime: Read and write

Syntax
Object.UsedPercent[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".
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Int
Optional A value or a constant that returns the measured value for the used disk space as a 
percentage.

See also
DiskSpaceView (Page 3991)

UserArchiveNumberOfValues(i) 

Description
Specifies the number of values that are loaded from the recipe. The "TagProviderType(i)"" 
property must have the value -2. 

Access in Runtime: Read and write

Syntax
Object.UserArchiveNumberOfValues(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

Int
Optional A value or a constant that specifies the number of values that are loaded from the 
recipe.

Comments
The parameter i indicates the number of the trend. 

If "UserArchiveNumberOfValues(i)"" is changed, illegal combinations with different attributes 
for the data connection could arise. This means you have to prevent immediate acceptance 
of the change with ""FreezeProviderConnections"" before changing 
""UserArchiveNumberOfValues(i)"".

See also
FunctionTrendControl (Page 4004)

UserArchiveStartId(i)

Description
Specifies the data record starting from which the values for the selected trend are loaded from 
the recipe. The "TagProviderType(i)"" property must have the value -2.   
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Access in Runtime: Read and write

Syntax
Object.UserArchiveStartId(i)[=Int]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the data record starting from which the values for 
the selected trend are loaded from the recipe. 

Comments
The parameter i indicates the number of the trend. 

If "UserArchiveStartId(i)" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent immediate acceptance of the change 
with ""FreezeProviderConnections" before changing ""UserArchiveStartId(i)".

See also
FunctionTrendControl (Page 4004)

UserName

Description
Returns the name of the user who triggered the alarm object.

UserValue1 property

Description
Defines or returns a value. 
The value can be evaluated by a script, for example. This value is neither evaluated nor 
displayed in Runtime. 

UserValue2 property 

Description
Defines or returns a value. 
The value can be evaluated by a script, for example. This value is neither evaluated nor 
displayed in Runtime. 
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UserValue3 property 

Description
Defines or returns a value. 
The value can be evaluated by a script, for example. This value is neither evaluated nor 
displayed in Runtime. 

UserValue4 property

Description
Defines or returns a value. 
The value can be evaluated by a script, for example. This value is neither evaluated nor 
displayed in Runtime. 

ValidateFormatPattern 

Description
Specifies that the "format pattern" field can be checked for specific characters. 

Access in Runtime: Read and write

Syntax
Object.ValidateFormatPattern[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the "format pattern" field can be checked for specific characters.

See also
IOField (Page 4021)

Value 

Description   
Specifies a value for the object being used or returns it. 

Access during runtime: Read and write 
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Syntax
Object.Value[=VARIANT]

Object
Necessary. An object of type "Tag", "DataItem" or "ScreenItem" with the format "Gauge". 

VARIANT
Optional The value that is specified dependent on the object being used:

● Tag.Value: returns the tag value for the last read access or specifies the future tag value. 
Use the "Read" method to read the tag value from the "Value" property. You assign a new 
tag value to the "Value" property with the "Write" method.

● Dataset.Value: Specifies a value or returns a copy of the value or the object reference. 
When returning object references, ensure that the object reference is multithread-capable.

● ScreenItem("Gauge_1").Value: Specifies the value to which the pointer points. The value 
range within the values set via the properties "ValueMin",and "ValueMax".

Examples
The following example writes a new value in the "Tag1" tag:

 
'VBS94
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Value = 50
objTag.Write

The example shows how to add a value to a list of tags and output it as a trace. After that, the 
value is changed, output again and then removed. It make sense to perform this in several 
different actions:

 
'VBS198
HMIRuntime.DataSet.Add "motor1", 23
HMIRuntime.Trace "motor1: " & HMIRuntime.DataSet("motor1").Value & vbNewLine
HMIRuntime.DataSet("motor1").Value = 55
HMIRuntime.Trace "motor1: " & HMIRuntime.DataSet("motor1").Value & vbNewLine
HMIRuntime.DataSet.Remove("motor1")

See also
DataItem (Page 3916)

Tag (Page 3941)
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ValueAxisAutorange(i)

Description
Specifies whether the value range of the Y axis is determined automatically or via the values 
"ValueAxisBegin(i)" and "ValueAxisEnd(i)". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisAutorange(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if the value range of the Y axis is established automatically or via the values 
"ValueAxisBegin(i)" and "ValueAxisEnd(i)"".

See also
FunctionTrendControl (Page 4004)

ValueAxisBegin(i)

Description
Specifies the lower limit of the value range for the selected trend that is to be displayed. 
Whether the information is evaluated depends on the properties "Autorange" and 
"ShareValueAxis".  

Access in Runtime: Read and write

Syntax
Object.ValueAxisBegin(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies the lower limit of the value range of the selected 
trend that is to be shown.
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See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisDecimalPrecision(i)

Description
Specifies the number of decimal places for the value range of the selected trend. 

Access in Runtime: Read and write

Syntax
Object.ValueAxisDecimalPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the formats "OnlineTrend" or "FunctionTrendView".

Int
Optional A value or a constant that specifies the number of decimal places for the value range 
of the selected trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisEnd(i)

Description
Specifies the upper limit of the value range of the selected trend that is to be displayed. Whether 
the information is evaluated depends on the properties "Autorange" and "ShareValueAxis".  

Access in Runtime: Read and write

Syntax
Object.ValueAxisEnd(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".
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Double
Optional A value or a constant that specifies the upper limit of the value range of the selected 
trend that is to be shown.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisGridLineInterval(i)

Description
Specifies the distance between two grid lines. Whether the information is evaluated depends 
on the properties "ValueAxisShowGridLines(i)" and "TimeAxisShowGridLines(i)".". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisGridLineInterval(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies the distance between two grid lines.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisLabel(i)

Description
Specifies the labeling of the value axis. Whether the information is evaluated depends on the 
property "ConfigureTimeAxis(i)". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisLabel(i)[=String]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

String
Optional A value or a constant that specifies the labeling of the value axis. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisLargeIncrementSize(i)

Description
Specifies the distance between two long marking lengths of the scale. Whether the information 
is evaluated depends on the properties "ValueAxisShowLargeIncrements(i)" and 
""TimeAxisShowLargeIncrements(i)".". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisLargeIncrementSize(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies the distance between two marking lengths of the 
scale.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisScalingType(i)

Description
Specifies the type of axis scaling. 

Access in Runtime: Read and write
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Syntax
Object.ValueAxisScalingType(i)[=AxisScalingType]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

AxisScalingType
hmiBarScalingLinear ( 0): Linear axis scaling.

hmiBarScalingLogarithmic ( 1): Logarithmic axis scaling

hmiBarScalingNegativeLogarithmic ( 2): Negative logarithmic axis scaling

Comments
The parameter i indicates the number of the trend. The parameter i indicates the number of 
the trend. 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisShowGridLines(i)

Description
Specifies whether the trend window is shown with grid lines that run parallel to the y axis. 

Access in Runtime: Read and write

Syntax
Object.ValueAxisShowGridLines(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if the trend window is shown with grid lines that run parallel to the y axis.

Comments
The distance between two grid lines can be altered with the "ValueAxisGridLineInterval(i)" 
property.
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See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisShowLargeIncrements(i)

Description
Specifies whether the value axis is scaled with long marking lengths. 

Access in Runtime: Read and write

Syntax
Object.ValueAxisShowLargeIncrements(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if the value axis is scaled with long marking lengths.

Comments
The distance of two long marking lines can be altered with the 
"ValueAxisLargeIncrementSize(i)"" property.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisShowSmallIncrements(i)

Description
Specifies whether the value axis is scaled with short marking lengths. 

Access in Runtime: Read and write

Syntax
Object.ValueAxisShowSmallIncrements(i)[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if the value axis is scaled with short marking lengths.

Comments
 The distance between two short marking lines can be altered with the 
"ValueAxisSmallIncrementSize(i)" property.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ValueAxisSmallIncrementSize(i)

Description
Specifies the distance between two short marking lengths of the scale. Whether the information 
is evaluated depends on the properties ""ValueAxisShowSmallIncrements(i)")" and 
""TimeAxisShowSmallIncrements(i)".". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisSmallIncrementSize(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies the distance between two short marking lengths 
of the scale.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)
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ValueColumnAlignment(i)

Description
Specifies the alignment of the tag values of this column pair. The parameter i indicates the 
number of the column pair. 

Access in Runtime: Read and write

Syntax
Object.ValueColumnAlignment(i)[=AlignmentHorizontal]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

AlignmentHorizontal
hmiAlignmentLeft ( 0): The text is shown left justified.

hmiAlignmentCentered ( 1): The text is shown centered.

hmiAlignmentRight  ( 2): The text is shown right justified.

See also
OnlineTableControl (Page 4037)

ValueColumnPrecision(i) 

Description
Specifies the number of decimal places that are shown in this value column. The parameter i 
indicates the number of the column pair. A maximum of 16 decimal places can be shown.   

Access in Runtime: Read and write

Syntax
Object.ValueColumnPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

Int
Optional A value or a constant that specifies the number of decimal places that are shown in 
this value column.
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See also
OnlineTableControl (Page 4037)

VerticalAlignment

Description
Specifies the vertical alignment of the text within the selected object.   

Access in Runtime: Read and write

Syntax
Object.VerticalAlignment[=AlignmentVertical]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Switch", "Checkbox" or "OptionGroup".

AlignmentVertical
A value that specifies the vertical alignment.

hmiAlignmentTop ( 0): The text will be shown in the upper margin.

hmiAlignmentMiddle ( 1): The text will be shown in the middle.

hmiAlignmentBottom ( 2): The Text will be shown in the lower margin.

See also
TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

OptionGroup (Page 4054)

DateTimeField (Page 3989)

RoundButton (Page 4074)

VerticalAlignment 

Description
Determines the vertical alignment of the text within the given object. 

Access during runtime: Read and Write

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4699



Syntax
Object.VerticalAlignment [= THmiVerticalAlignment]

Object
Required An object of the "ScreenItem" type with the characteristics "TextField", "IOField", 
"SymbolicIOField", "Button" or "Switch".

THmiVerticalAlignment
Optional A value or constant which determines the vertical alignment of the text.

hmiAlignmentTop (0): The text is aligned at the top of the object.

hmiAlignmentMiddle (1): The text is centered vertically in the object.

hmiAlignmentBottom (2): The text is aligned at the bottom in the object.

See also
ProjectName (Page 4062)

VerticalGridLines

Description
Enables the display of vertical dividers.   

Access in Runtime: Read and write

Syntax
Object.VerticalGridLines[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

BOOLEAN
TRUE: Vertical grid lines are displayed.

FALSE: Vertical grid lines are not displayed.

 

See also
UserArchiveControl (Page 4130)

TrendRulerControl (Page 4110)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)
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VerticalScrollbarPosition

Description
Specifies the vertical positioning of the scroll bar in a picture window with slider, or returns its 
value.

The picture is displayed in the picture window by positioning the horizontal and vertical scroll 
bars. If you wish to display the picture as a cutout where the scroll bars are located at the left 
and upper edge of the picture, use the properties "OffsetLeft" and "OffsetTop" as the origin of 
this cutout.

See also
ScreenWindow (Page 4078)

ViewOnly 

Description
Specifies whether the Sm@rtClient display will be used for remote monitoring or remote 
maintenance. 

Remote maintenance means that settings can be changed on the monitored device.

Remote monitoring means that settings of the monitored device cannot be changed.

Access in Runtime: Read and write

Syntax
Object.ViewOnly[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "SmartClientView".

BOOLEAN
Optional TRUE, if the Sm@rtClient display is to be used only for remote monitoring.

See also
SmartClientView (Page 4085)

Visible 

Description
Specifies whether the selected object is visible.     
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Access during runtime: Read and write

Syntax
Object.Visible[=BOOLEAN]

Object
Necessary. An object of the type "ScreenItem".

BOOLEAN
Optional TRUE, if the object is visible.

Used for the following object types:
Rectangle 
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

ScreenWindow (Page 4078)

DiskSpaceView (Page 3991)

ChannelDiagnose (Page 3972)

ScriptDiagnostics (Page 4080)

Group (Page 4017)

DateTimeField (Page 3989)

UserView  (Page 4137)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

SystemDiagnoseView (Page 4100)

TrendRulerControl (Page 4110)

ProjectName (Page 4062)

AlarmView (Page 3958)

RecipeView (Page 4068)

SmartClientView (Page 4085)

StatusForce (Page 4087)

SystemDiagnoseWindow (Page 4103)

TrendView (Page 4118)
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Warning

Description
Specifies the limit for the storage space display as of which a warning will be reported. 

Access in Runtime: Read and write

Syntax
Object.Warning[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that specifies the limit for the storage space display as of which 
a warning will be reported.

See also
DiskSpaceView (Page 3991)

WarningColor

Description
Specifies the color in which the bar of the storage space display will be shown as soon as the 
warning area is reached. 

Access in Runtime: Read and write

Syntax
Object.WarningColor[=Color]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Color
Optional A value or a constant that specifies the color in which the bar of the storage space 
display will be shown as soon as the warning area is exceeded.

See also
DiskSpaceView (Page 3991)
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WarningHigh

Description
Defines or returns the upper limit value for "Warning High". 
In order that the limit value is monitored, the "CheckWarningHigh" property must be set to 
TRUE. 
The display on reaching the limit value and the type of evaluation are defined by means of the 
"ColorWarningHigh" and "TypeWarningHigh" properties.

WarningLow

Description
Defines or returns the lower limit value for "Warning Low". 
In order that the limit value is monitored, the "CheckWarningLow" property must be set to 
TRUE. 
The display on reaching the limit value and the type of evaluation are defined by means of the 
"ColorWarningLow" and "TypeWarningLow" properties.

WarningLowerLimit 

Description
Specifies the lower limit for "WarningLowerLimit". 

The ""WarningLowerLimitEnable" property must have the value TRUE so that the limit is 
monitored. 

Access in Runtime: Read and write

Syntax
Object.WarningLowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the lower limit for "WarningLowerLimit".

Comments
The following values will be specified with the properties "WarningLowerLimitColor" and 
"WarningLowerLimitRelative": 

Representation upon reaching the limit

Type of evaluation
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See also
Bar (Page 3961)

WarningLowerLimitColor

Description
Specifies the color for the lower limit ""WarningLowerLimit". 

The ""WarningLowerLimitEnable" property must have the value TRUE if the bar color is to 
change once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.WarningLowerLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the lower limit "WarningLowerLimit".

Comments
The following values are specified by the "WarningUpperLimit", "WarningUpperLimitColor" and 
"WarningUpperLimitRelative" properties: 

● Limit

● Representation upon reaching the limit

● Type of evaluation

See also
Bar (Page 3961)

WarningLowerLimitEnabled

Description
Specifies whether the limit ""WarningLowerLimit" is to be monitored. 

Access in Runtime: Read and write
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Syntax
Object.WarningLowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "WarningLowerLimit" limit is to be monitored.

Comments
The following values will be specified with the properties "WarningLowerLimit", 
"WarningLowerLimitColor" and "WarningLowerLimitRelative":

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 3961)

WarningLowerLimitRelative

Description
Determines whether the lower limit "WarningLowerLimit" is to be evaluated as a percentage 
or as an absolute value. 

Access in Runtime: Read and write

Syntax
Object.WarningLowerLimitRelative[=BOOLEAN]

Object
Required A ""ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit ""WarningLowerLimit" is to be evaluated as a percentage.

See also
Bar (Page 3961)
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WarningRangeColor 

Description
Specifies the color of the warning range on the scale of the "Gauge" object. 

The "WarningRangeVisible" property must have the value TRUE so that the warning range is 
displayed.

Access in Runtime: Read and write

Syntax
Object.WarningRangeColor[= Color]

Object
Required A "ScreenItem" object with the format "Gauge".

Color
Optional A value or a constant that specifies the color of the warning range.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Gauge (Page 4008)

WarningRangeStart 

Description
Specifies at which scale value the warning range of the "Gauge" object will start. 

The "WarningRangeVisible" property must have the value TRUE so that the warning range is 
displayed.

Access in Runtime: Read and write

Syntax
Object.WarningRangeStart[= DOUBLE]

Object
Required A "ScreenItem" object with the format "Gauge".
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DOUBLE
Optional A value or a constant that contains the scale value for the start of the warning range.

Comments
The range extends from the value "Warning" through to the value "Danger". If no range is 
activated for "Danger", then the range for "Warning" extends to the end of the scale.

See also
Gauge (Page 4008)

WarningRangeVisible

Description
Specifies whether the warning range in the scale of the "Gauge" object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.WarningRangeVisible[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the warning range will be displayed in the scale.

Comments
Specifies the color of the warning range with the ""WarningRangeColor" property.

Specifies the start of the warning range with the "WarningRangeStart"" property.

See also
Gauge (Page 4008)

WarningRangeColor  (Page 4708)

WarningRangeStart  (Page 4708)
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WarningUpperLimit 

Description
Specifies the upper limit for "WarningUpperLimit". 

The "WarningUpperLimitEnable"" property must have the value TRUE so that the limit is 
monitored. 

Access in Runtime: Read and write

Syntax
Object.WarningUpperLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the upper limit for ""WarningUpperLimit".

Comments
The following values will be specified with the properties "WarningUpperLimitColor" and 
"WarningUpperLimitRelative": 

● Representation upon reaching the limit

● Type of evaluation

See also
Bar (Page 3961)

WarningUpperLimitColor

Description
Specifies the color for the upper limit "WarningUpperLimit". 

The ""WarningUpperLimitEnable" property must have the value TRUE if the bar color is to 
change once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.WarningUpperLimitColor[=Color]
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Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the upper limit "WarningUpperLimit".

See also
Bar (Page 3961)

WarningUpperLimitEnabled

Description
Specifies whether the limit ""WarningUpperLimit" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.WarningUpperLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".".

BOOLEAN
Optional TRUE, if the "WarningUpperLimit" limit is to be monitored.

See also
Bar (Page 3961)

WarningUpperLimitRelative

Description
Determines whether the lower limit "WarningUpperLimit" is to be evaluated as a percentage 
or as an absolute value. 

Access in Runtime: Read and write

Syntax
Object.WarningUpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".
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BOOLEAN
Optional TRUE, if the lower limit "WarningUpperLimit" is to be evaluated as a percentage.

See also
Bar (Page 3961)

Width

Description
Specifies the width of the selected objects "Ellipse", "Circle" and "Rectangle".   

Access in Runtime: Read and write.

The other objects only have read access to the property.

Syntax
Object.Width[=LONG]

Object
Required A "Screen" object or an object of type "ScreenItem". This property is a standard 
property of the ScreenItem-object and is therefore available for all formats.

LONG
Optional A value or a constant that specifies the width in pixels. This parameter can only be 
set for the objects "Ellipse", Circle" and "Rectangle".
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See also
Line (Page 4025)

Polyline (Page 4060)

Ellipse (Page 3993)

Circle (Page 3977)

EllipseSegment (Page 3995)

CircleSegment (Page 3979)

EllipticalArc (Page 3998)

CircularArc (Page 3982)

Rectangle (Page 4072)

Polygon (Page 4057)

TextField (Page 4107)

IOField (Page 4021)

SymbolicIOField (Page 4093)

Button (Page 3968)

Switch (Page 4089)

GraphicView (Page 4014)

GraphicIOField (Page 4011)

Bar (Page 3961)

Clock (Page 3984)

Gauge (Page 4008)

Slider (Page 4082)

SymbolLibrary (Page 4098)

OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

HTMLBrowser (Page 4019)

CheckBox (Page 3974)

OptionGroup (Page 4054)

WindowSlider (Page 4139)

Connector (Page 3986)

ScreenWindow (Page 4078)

DiskSpaceView (Page 3991)

ChannelDiagnose (Page 3972)

ScriptDiagnostics (Page 4080)

Group (Page 4017)

ForeignControl (Page 4000)

DateTimeField (Page 3989)

ProtectedAreaName (Page 4064)

UserView  (Page 4137)

TubeTeeObject (Page 4128)

TubePolyline (Page 4125)

TubeDoubleTeeObject (Page 4123)

TubeArcObject (Page 4121)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

UserArchiveControl (Page 4130)

SystemDiagnoseView (Page 4100)

TrendRulerControl (Page 4110)

ProjectName (Page 4062)

AlarmView (Page 3958)

BatteryView (Page 3967)

RangeLabelView (Page 4065)

ZoneQualityView (Page 4144)

ZoneLabelView (Page 4143)

WLanQualityView (Page 4142)

TrendView (Page 4118)

SystemDiagnoseWindow (Page 4103)

StatusForce (Page 4087)

SmartClientView (Page 4085)

RecipeView (Page 4068)

RangeQualityView (Page 4067)
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WinCCStyle

Description
Defines the style in which the object is displayed. 

User Defined Shows the object according to the respective settings.
Global Shows the object in a globally defined design.
Windows Style Shows the object in Windows style.

WindowBorder

Description
TRUE, when the window is displayed with borders in Runtime. Read only access.

WindowCloseEnabled 

Description
Specifies whether the window can be closed in Runtime. 

Access in Runtime: Read and write

Syntax
Object.WindowCloseEnabled[=BOOLEAN]

Object
Required A "ScreenItem"  object with the formats "OnlineTrend", "FunctionTrendView" or 
"TableView".

BOOLEAN
Optional TRUE, if the window can be closed in Runtime.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)
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WindowMaximizeenabled

Description
TRUE, when the object can be maximized in Runtime. Read only access. 

See also
ScreenWindow (Page 4078)

ScriptDiagnostics (Page 4080)

WindowMovingEnabled

Description
TRUE, when the object can be moved in Runtime. Read only access.

See also
ScreenWindow (Page 4078)

ScriptDiagnostics (Page 4080)

WindowOnTop

Description
TRUE, when the object should remain in the foreground in Runtime. Read only access.

See also
ScreenWindow (Page 4078)

ScriptDiagnostics (Page 4080)

WindowsContens

Description
Supplies the content of the application window Read only access.

See also
ScriptDiagnostics (Page 4080)
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WindowSizingEnabled

Description
Specifies whether the size of the specified object can be changed in Runtime. 

Access in Runtime: Read and write

Syntax
Object.WindowSizingEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend", "FunctionTrendView" or 
"TableView".

BOOLEAN
Optional. TRUE, if the size of the selected object can be changed in Runtime.

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OnlineTableControl (Page 4037)

WindowsStyle

Description
Specifies whether the object will be displayed in the general Windows style. 

Access in Runtime: Read and write

Syntax
Object.WindowsStyle[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Button" or "WindowSlider".

BOOLEAN
Optional TRUE, if the object will be displayed in the general Windows style.
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See also
Button (Page 3968)

WindowSlider (Page 4139)

Properties X-Z

XAxisAdd

Description
Creates a new X axis.   

Syntax
Object.XAxisAdd

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)

XAxisAlign

Description
Defines the alignment mode for a selected axis.   

Syntax
Object.XAxisAlign[=Alignement]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Alignment

Value Description Description
0 Bottom The X axis selected is displayed below the trend.
1 Top The X axis selected is displayed above the trend.
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XAxisAutoPrecisions

Description
Enables automatic setting of the decimal precision.   

Access in Runtime: Read and write

Syntax
Object.XAxisAutoPrecisions[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
TRUE: The number of decimal places is specified automatically.

FALSE: The value configured under "Properties > X axis  > Format > Decimal places" is 
effective.

See also
FunctionTrendControl (Page 4004)

XAxisAutorange(i) 

Description
Specifies whether the value range of the X axis is determined automatically or via the attributes 
"XAxisBegin(i)" and "XAxisEnd(i)". 

Access in Runtime: Read and write

Syntax
Object.XAxisAutorange(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

BOOLEAN
Optional TRUE, if the value range of the X axis is determined automatically or via the values 
"XAxisBegin(i)" and "XAxisEnd(i)".

See also
FunctionTrendControl (Page 4004)
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XAxisBegin(i) 

Description
Specifies the lower limit of the X axis of a trend that has been referenced with the property 
"CurrentCurveIndex". Whether the information is evaluated depends on the properties 
"XAxisAutorange(i)" and "ShareXAxis".   

Access in Runtime: Read and write

Syntax
Object.XAxisBegin(i)[=String]

Object
Required A ""ScreenItem" object with the format ""FunctionTrendView".

String
Optional A value or a constant that specifies the lower limit of the X axis of a trend that has 
been referenced with the property "CurrentCurveIndex".

See also
FunctionTrendControl (Page 4004)

XAxisBeginValue

Description 
Specifies the lower range of values of the axis selected. To configure the value, deactivate the 
"Automatic" option in "Value range".

See also
FunctionTrendControl (Page 4004)

XAxisColor

Description 
Use this attribute to define the color for the common X-axis. 

Access in Runtime: Read and write

Syntax
Object.XAxisColor[=COLOR]
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Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" or 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Color
The color is defined as an RGB value.

See also
FunctionTrendControl (Page 4004)

XAxisCount

Description
Defines the number of X axes configured. 

Syntax
Object.XAxisCount

Object

Required An object of the "ScreenItem" type with the format "FunctionTrendControl"..

See also
FunctionTrendControl (Page 4004)

XAxisDecimalPrecision(i)

Description
Specifies the number of decimal places with which the scaling value of the X axis will be 
displayed. 

Access in Runtime: Read and write

Syntax
Object.XAxisDecimalPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".
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Int
Optional A value or a constant that specifies the number of decimal places with which the 
scaling value for the X axis will be displayed.

See also
FunctionTrendControl (Page 4004)

XAxisEnd(i) 

Description
Specifies the lower limit of the X axis of a trend that has been referenced with the property 
"CurrentCurveIndex". Whether the information is evaluated depends on the properties 
"XAxisAutorange(i)"" and "ShareXAxis".  

Access in Runtime: Read and write

Syntax
Object.XAxisEnd(i)[=String]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

String
Optional A value or a constant that specifies the upper limit of the X axis of a trend that has 
been referenced with the property "CurrentCurveIndex".

See also
FunctionTrendControl (Page 4004)

XAxisEndValue

Description   
Specifies the upper range of values of the axis selected. To configure the value, deactivate 
the "Automatic" option in "Value range".

See also
FunctionTrendControl (Page 4004)
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XAxisExponentialFormat

Description
Enables the exponential notation for visualization of a selected axis.   

Access in Runtime: Read and write

Syntax
Object.XAxisExponentialFormat [=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
TRUE: The values are displayed in exponential format.

FALSE: The values are displayed in exponential format.

See also
FunctionTrendControl (Page 4004)

XAxisGridLineInterval(i)

Description
Specifies the distance between two grid lines of the X axis. Whether the information is 
evaluated depends on the value of the property ""XAxisShowGridLines(i)".".

Access in Runtime: Read and write

Syntax
Object.XAxisGridLineInterval(i)[=Double]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".".

Double
Optional A value or a constant that specifies the distance between two grid lines of the X axis.

See also
FunctionTrendControl (Page 4004)
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XAxisIndex

Description
References a configured X axis. You can assign the values of other properties to a specific X 
axis by using the property.   

Valid values for "Index" are between 0 and "XAxisCount" minus 1. The "ToolbarButtonCount" 
property specifies the number of configured X axes.

See also
FunctionTrendControl (Page 4004)

XAxisInTrendColor

Description 
Enables the display of an axis selected in the trend color. The color of the first trend is activated 
if several trends are displayed in the trend window. The order of the trends is determined in 
the "Trends" properties.   

Access in Runtime: Read and write

Syntax
Object.XAxisInTrendColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl". 

BOOLEAN
TRUE: The selected axis is displayed in the trend color. The setting in the "Color" field is 
disabled.

FALSE: The selected axis is displayed in the color which is set in the "Color" field.

See also
FunctionTrendControl (Page 4004)

XAxisLabel(i)

Description
Specifies the labeling of the X axis of a trend that has been referenced with the property 
"CurrentCurveIndex", dependent upon the value of "XAxisMode(i)". 

Access in Runtime: Read and write
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Syntax
Object.XAxisLabel(i)[=String]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

String
Optional A value or a constant that specifies the labeling of the X axis of a trend that has been 
referenced with the property "CurrentCurveIndex". 

See also
FunctionTrendControl (Page 4004)

XAxisLargeIncrementSize(i) 

Description
Specifies the distance of two long marking lengths of the X axis. Whether the information is 
evaluated depends on the property "XAxisShowLargeIncrements(i)".".

Access in Runtime: Read and write

Syntax
Object.XAxisLargeIncrementSize(i)[=Double]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

Double
Optional A value or a constant that specifies the distance of two long marking lengths of the 
scaling of the X axis.

See also
FunctionTrendControl (Page 4004)

XAxisMode(i)

Description
Specifies whether a mutual time axis will be used in the trend window for all trends. 

Specifies time units used by tag logging controls.

Access in Runtime: Read and write
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Syntax
Object.XAxisMode(i)[=TrendViewTimeAxisMode]

Object
Required A "ScreenItem" object with the format "FunctionTrendContol".

TrendViewTimeAxisMode
( 1): The time axis will be scaled. 

 ( 2): No time range has been specified. Only a random sample will be displayed.

 ( 3): The time range will be established via tags.

 ( 4): The time range will be defined by constant values.

Comments
Specifies whether a mutual X axis will be used in the trend window for all trends. 

See also
FunctionTrendControl (Page 4004)

XAxisName

Description
Specifies the name of a selected axis.   

Syntax
Object.XAxisName

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)

XAxisPrecisions

Description   
Specifies the decimal precision for displaying the axis selected. To configure the value, 
deactivate the "Automatic" option in "Format".
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See also
FunctionTrendControl (Page 4004)

XAxisRemove

Description
Removes the selected axis from the list.   

Syntax
Object.XAxisRemove

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)

XAxisRepos

Description
Changes the sorting order of the axes. "Up" and "Down" move the axis selected up or down 
in the list. The order in the list determines the position of the axis in the trend view in Runtime. 
If the alignment is identical and the axis is further up in the list, it is shown at a position further 
away from the trend.   

Syntax
Object.XAxisRepos

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)
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XAxisScalingType(i) 

Description
Specifies the type of scaling for the X axis. Whether the information is evaluated depends on 
the value of the property "XAxisMode(i)".".

Access in Runtime: Read and write

Syntax
Object.XAxisScalingType(i)[=AxisScalingType]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

AxisScalingType
hmiBarScalingLinear ( 0): Linear axis scaling.

hmiBarScalingLogarithmic ( 1): Logarithmic axis scaling

hmiBarScalingNegativeLogarithmic ( 2): Negative logarithmic axis scaling

Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 4004)

XAxisShowGridLines(i)

Description
Specifies whether the trend window is shown with grid lines that run parallel to the X axis. The 
distance between two grid lines can be altered with the ""XAxisGridLineInterval(i)" property. 

Access in Runtime: Read and write

Syntax
Object.XAxisShowGridLines(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

BOOLEAN
Optional TRUE, if the trend window is shown with grid lines that run parallel to the X axis.
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See also
FunctionTrendControl (Page 4004)

XAxisShowLargeIncrements(i)

Description
Specifies whether the X axis is scaled with long marking lengths. The distance of two long 
marking lines can be altered with the "XAxisLargeIncrementSize(i)"" property. 

Access in Runtime: Read and write

Syntax
Object.XAxisShowLargeIncrements(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""FunctionTrendView".

BOOLEAN
Optional TRUE, if the X axis is scaled with long marking lengths. 

See also
FunctionTrendControl (Page 4004)

XAxisShowSmallIncrements(i) 

Description
Specifies whether the X axis is scaled with short marking lengths. The distance of two short 
marking lines can be altered with the "XAxisSmallIncrementSize(i)" property. 

Access in Runtime: Read and write

Syntax
Object.XAxisShowSmallIncrements(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

BOOLEAN
Optional TRUE, if the X axis is scaled with short marking lengths. 
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See also
FunctionTrendControl (Page 4004)

XAxisSmallIncrementSize(i) 

Description
Specifies the distance of two short marking lengths of the X axis. Whether the information is 
evaluated depends on the property "XAxisShowSmallIncrements(i)".".

Access in Runtime: Read and write

Syntax
Object.XAxisSmallIncrementSize(i)[=Double]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

Double
Optional A value or a constant that specifies the distance of two short marking lengths of the 
X axis scaling.

See also
FunctionTrendControl (Page 4004)

XAxisTrendWindow

Description 
Specifies in which trend view the selected axis is used. The available trend views are specified 
in the properties in "Trends".   

Access in Runtime: Read and write

Syntax
Object.XAxisTrendWindow

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)
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XAxisVisible

Description   
The list shows all axes you created.

Activate the axes which are to be displayed in the trend views in the list.

Click an axis in the list to adapt the properties and to assign the axis to a trend view.

See also
FunctionTrendControl (Page 4004)

XDataLogTag(i) 

Description
Specifies the tag that will be shown along the X axis. The property "TagProviderType(i)" must 
have the value -1. 

Access in Runtime: Read and write

Syntax
Object.XDataLogTag(i)[=HmiLoggingTag]

Object
Required A ""ScreenItem" object with the format "FunctionTrendView".

HmiLoggingTag
Optional A value or a constant that specifies which tag will be shown along the X axis.

Comments
If "XOnlineTag(i)"" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent mmediate acceptance of the change 
with "FreezeProviderConnections before changing "XOnlineTag(i).

See also
FunctionTrendControl (Page 4004)
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XOnlineTag(i) 

Description
Specifies the tag that will be shown along the X axis. The property "TagProviderType(i)"" must 
have the value -1. 

Access in Runtime: Read and write

Syntax
Object.XOnlineTag(i)[=HmiTag]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

HmiTag
Optional A value or a constant that specifies which tag will be shown along the X axis.

Comments
The parameter i indicates the number of the trend. 

If "XOnlineTag(i)" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent an immediate acceptance of the 
change with "FreezeProviderConnections" before changing "XOnlineTag(i)".

See also
FunctionTrendControl (Page 4004)

YAxisAdd

Description
Creates a new X axis.   

Syntax
Object.YAxisAdd

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)
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YAxisAlign

Description
Specifies how the selected axis is aligned.   

Syntax
Object.YAxisAlign[=Alignement]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Alignment

Value Description Explanation
0 Left The X axis selected is displayed on left side of the trend.
1 Right The selected Y axis is displayed to the right of the trend.

YAxisAutoPrecisions

Description
Enables automatic setting of the decimal precision.   

Access in Runtime: Read and write

Syntax
Object.YAxisAutoPrecisions[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
TRUE: The number of decimal places is specified automatically.

FALSE: The value configured under "Properties > Y axis  > Format > Decimal places" is 
effective.

 

See also
FunctionTrendControl (Page 4004)
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YAxisAutoRange

Value range automatic - X/YAxisAutoRange
Enables automatic calculation of the value range of the axis selected.

Value Description
TRUE The range of values is calculated automatically.
FALSE The range of values is calculated based in the values configured in the "from" and "to" fields.

The X axis attribute can be assigned dynamic properties by means of the name 
XAxisAutoRange.

The Y axis attribute can be assigned dynamic properties by means of the name 
YAxisAutoRange.

See also
FunctionTrendControl (Page 4004)

YAxisBeginValue

Description 
Specifies the lower value range of the selected axis. To configure the value, deactivate the 
"Automatic" option in "Value range".

See also
FunctionTrendControl (Page 4004)

YAxisColor

Description
Specifies the color of the axis selected. Open the "Color selection" dialog by clicking the 
button. . The setting is only active if the "Use trend color" field is disabled.    

Syntax
Object.YAxisColor[=COLOR]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" or 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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Color
The color is defined as an RGB value.

See also
FunctionTrendControl (Page 4004)

YAxisCount

Description
Defines the number of Y axes configured.   

Syntax
Object.YAxisCount

Object

Required A "ScreenItem" object with the format "FunctionTrendControl".

 

See also
FunctionTrendControl (Page 4004)

YAxisEndValue

Description
Specifies the upper value range of the selected axis. To configure the value, deactivate the 
"Automatic" option in "Value range".

See also
FunctionTrendControl (Page 4004)

YAxisExponentialFormat

Description
Enables the exponential notation for visualization of a selected axis.   

Access in Runtime: Read and write
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Syntax
Object.YAxisExponentialFormat [=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
TRUE: The values are displayed in exponential format.

FALSE: The values are displayed in exponential format.

See also
FunctionTrendControl (Page 4004)

YAxisIndex

Description
References a configured Y axis. You can assign the values of other properties to a specific Y 
axis by using the property.   

Valid values for "Index" are between 0 and "YAxisCount" minus 1. The "ToolbarButtonCount" 
property specifies the number of configured Y axes.

 

See also
FunctionTrendControl (Page 4004)

YAxisInTrendColor

Description 
Enables the display of an axis selected in the trend color. The color of the first trend is activated 
if several trends are displayed in the trend window. The order of the trends is determined in 
the "Trends" properties.   

Access in Runtime: Read and write

Syntax
Object.YAxisInTrendColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl". 
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BOOLEAN
TRUE: The selected axis is displayed in the trend color. The setting in the "Color" field is 
disabled.

FALSE: The selected axis is displayed in the color which is set in the "Color" field.

See also
FunctionTrendControl (Page 4004)

YAxisLabel

Description
Defines the label text for a selected axis. 

See also
FunctionTrendControl (Page 4004)

YAxisName

Description
Specifies the name of the selected axis.   

Syntax
Object.XAxisName

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)

YAxisPrecisions

Description   
Specifies the decimal precision for displaying the axis selected. To configure the value, 
deactivate the "Automatic" option in "Format".
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See also
FunctionTrendControl (Page 4004)

YAxisRename

Description
Changes the name of the Y axis which is referenced by the "YAxisIndex" property.  

Syntax
Object.YAxisRename

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

YAxisRemove

Description
Removes the selected axis from the list.   

Syntax
Object.YAxisRemove

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

 

See also
FunctionTrendControl (Page 4004)

YAxisRepos

Description
Changes the order of the axes. "Up" and "Down" move the selected axis up or down in the list. 

The order in the list determines the position of the axis in the trend view in Runtime. The axis 
output position is moved away from the trend if the axis is moved further up in the list and the 
orientation is the same.   
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Syntax
Object.YAxisRepos

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)

YAxisScalingType

Scaling - X/YAxisScalingType
Defines the scaling mode for a selected axis.

The following settings are available:

Value Description
0 Linear
1 Logarithmic
2 Logarithmically negated

The X axis attribute can be assigned dynamic properties by means of the name 
XAxisScalingType.

The Y axis attribute can be assigned dynamic properties by means of the name 
YAxisScalingType.

See also
FunctionTrendControl (Page 4004)

YAxisTrendWindow

Description 
Specifies in which trend view the selected axis is used. The available trend views are specified 
in the properties in "Trends".   

Access in Runtime: Read and write

Syntax
Object.YAxisTrendWindow
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Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 4004)

YAxisVisible

Description  
The list shows all axes you created.

Activate the axes which are to be displayed in the trend views in the list.

Click an axis in the list to adapt the properties and to assign the axis to a trend view.

See also
FunctionTrendControl (Page 4004)

YDataLogTag(i) 

Description
Specifies the tag that will be shown along the Y axis. The property "TagProviderType(i)"" must 
have the value -1. 

Access in Runtime: Read and write

Syntax
Object.YDataLogTag(i)[=HmiLoggingTag]

Object
Required A "ScreenItem" object with the format "FunctionTrendView"".

HmiLoggingTag
Optional A value or a constant that specifies which tag will be shown along the Y axis.

Comments
If "YOnlineTag(i)"" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent immediate acceptance of the change 
with "FreezeProviderConnections" before changing "YOnlineTag(i)"".
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See also
FunctionTrendControl (Page 4004)

YOnlineTag(i)

Description
Specifies the tag that will be shown along the Y axis. The property "TagProviderType(i)" must 
have the value -1. 

Access in Runtime: Read and write

Syntax
Object.YOnlineTag(i)[=HmiTag]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

HmiTag
Optional A value or a constant that specifies which tag will be shown along the Y axis.

Comments
The parameter i indicates the number of the trend. 

If "YOnlineTag(i)"" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent immediate acceptance of the change 
with "FreezeProviderConnections" before changing "YOnlineTag(i)".

See also
FunctionTrendControl (Page 4004)

ZeroPoint 

Description
Specifies the position of the zero point as a percentage of the bar height. The zero point can 
also be located outside of the displayed area. 

The "ScalingType" property must be set to "Auto". 

The "ShowScale" property must be set to "TRUE". 

Access in Runtime: Read and write
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Syntax
Object.ZeroPoint[=Int]

Object
Required A ""ScreenItem" object with the format ""Bar".

Int
Optional A value or a constant that specifies the position of the zero point as a percentage of 
the bar height.

See also
Bar (Page 3961)

ZeroPointValue

Description
Defines the value of the zero point of the scale indicator.

Defines or returns the absolute value for the zero point. 

Zoom/Zoomfactor

Description  
Sets or reads the zoom factor of a screen or screen window.

If the indicated zoom factor is smaller than the minimum value, the zoom factor is automatically 
set to the minimum value. If the indicated zoom factor is larger than the minimum value, the 
zoom factor is automatically set to the maximum value. 

The minimum value of the zoom factor is at 2%, the maximum value at 800%.

With the Screen Object the zoom factor is indicated as a numeric value and with a picture 
window object, it is indicated in percent. 

Zoom: Zoom factor of picture

Zoomfactor: Zoom factor of picture window

Example
The following example doubles the zoom factor of the current picture:

 
'VBS97
HMIRuntime.ActiveScreen.Zoom = HMIRuntime.ActiveScreen.Zoom * 2
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See also
ScreenWindow (Page 4078)

Zoomable

Description
Specifies whether the DXF screen display supports the zoom functions in Runtime mode. 

Access in Runtime: Read and write

Syntax
Object.Zoomable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "DXFView".

BOOLEAN
Optional TRUE, if the DXF screen display supports the zoom functions in Runtime mode.

Methods

Methods A-G

Activate

Description
Activates the permanent window or the root screen.       

To activate a not selected screen, use the "BaseScreenName" property.

It only makes sense to use the activate method with the following operable screen objects. An 
error message is output at screen objects which cannot be operated, for example rectangles. 

● I/O field

● Switch

● Symbol library

● Trend view

● f(x) trend view

● HTML browser

● Slider

● Graphic I/O field
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● Symbolic I/O field

● Button

● Alarm view

● User view

● Recipe view

● Sm@rtClient View

● Status/Force

Syntax
Expression.Activate

Expression
Necessary. An output which returns an object of the "Screen" or "ScreenItem" type.

Parameters
--
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See also
ScreenItem (Page 3932)

Screen (Page 3930)

ChannelDiagnose (Page 3972)

CheckBox (Page 3974)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Clock (Page 3984)

Connector (Page 3986)

DateTimeField (Page 3989)

DiskSpaceView (Page 3991)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Gauge (Page 4008)

GraphicIOField (Page 4011)

GraphicView (Page 4014)

HTMLBrowser (Page 4019)

IOField (Page 4021)

Rectangle (Page 4072)

ScriptDiagnostics (Page 4080)

Switch (Page 4089)

SymbolicIOField (Page 4093)

SymbolLibrary (Page 4098)

TextField (Page 4107)

TrendView (Page 4118)

TubeArcObject (Page 4121)

TubeDoubleTeeObject (Page 4123)

TubePolyline (Page 4125)

TubeTeeObject (Page 4128)

UserView  (Page 4137)

WindowSlider (Page 4139)

StatusForce (Page 4087)

SmartClientView (Page 4085)

Slider (Page 4082)

ScreenWindow (Page 4078)

RoundButton (Page 4074)

Polyline (Page 4060)

Polygon (Page 4057)

OptionGroup (Page 4054)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

Line (Page 4025)

Bar (Page 3961)

Button (Page 3968)

OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmView (Page 3958)

AlarmControl (Page 3947)
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ActivateDynamic

Description     
Dynamically activates a trigger and the specified cycle for a property at runtime. This requires 
a VB script at the property as well as a trigger set to "On demand". Every time the trigger is 
activated a different activation cycle can be used. 

Syntax
Expression.ActivateDynamic (ByVAl bstrPropertyName As String, ByVal 
bstrCycleName As String)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.  

Parameters

Parameter Description
bstrPropertyName Name of property to which trigger relates.
bstrCycleName Name of activation cycle, e.g. "CycleTime1s".
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See also
ChannelDiagnose (Page 3972)

CheckBox (Page 3974)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Clock (Page 3984)

Connector (Page 3986)

DiskSpaceView (Page 3991)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Gauge (Page 4008)

GraphicIOField (Page 4011)

GraphicView (Page 4014)

HTMLBrowser (Page 4019)

IOField (Page 4021)

Rectangle (Page 4072)

ScriptDiagnostics (Page 4080)

SymbolicIOField (Page 4093)

SymbolLibrary (Page 4098)

TextField (Page 4107)

TubeArcObject (Page 4121)

TubeDoubleTeeObject (Page 4123)

TubePolyline (Page 4125)

TubeTeeObject (Page 4128)

UserView  (Page 4137)

WindowSlider (Page 4139)

Slider (Page 4082)

ScreenWindow (Page 4078)

RoundButton (Page 4074)

Polyline (Page 4060)

Polygon (Page 4057)

OptionGroup (Page 4054)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

Line (Page 4025)

Bar (Page 3961)

Button (Page 3968)

OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)
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Add

Description of TagSet Object
Adds a tag to the list. A tag may be added to the tag object by using name or reference.

syntax
Expression.Add [Tag]

Expression
Necessary. An expression which returns an object of type "TagSet". 

Parameters
VARIANT

Parameters Description
Tag Name of a WinCC tag or reference to a tag object 

to be added to the list. 

 

Example:
In the following example, a TagSet object is generated and a tag is added. 

 
'VBS170
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"

 

Tag objects may also be added as follows.

 
'VBS171
Dim Tag
Set Tag = HMIRuntime.Tags("Motor2")
Dim group2
Set group2 = HMIRuntime.Tags.CreateTagSet
group2.Add Tag
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Description of DataSet Object
Adds a value or object reference to the list.  

 

 Note

The Data Set Object does not support classes.
Objects of type Screen, Screens, ScreenItem, ScreenItems, Tag and TagSet cannot be 
included in the DataSet list.   
For object references it must be ascertained that objects are multiread-enabled. 

 

syntax
Expression.Add [vtName], [vtUserData]

Expression
Necessary. An expression which returns an object of type "DataSet". 

Parameters
VARIANT

Parameters Description
vtName Name by which value or tag are to be added to list. 
vtUserData Value to be added to list.

 

Example:
In this example, a value is included in the DataSet list. 

 
'VBS172
HMIRuntime.DataSet.Add "Motor1",23

See also
DataSet (list) (Page 3919)

OnlineTrendControl (Page 4045)

AttachDB method

Description 
Executes the "Connect backup" key function of the control.
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Syntax
Ausdruck.AttachDB()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

CalculateStatistic

Description  
Executes the "calculate statistics" key function of the f(t) trend view.

Syntax
Ausdruck.CalculateStatistic()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

CopyRows

Description
Executes the "Copy lines" key function of the control.
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Syntax
Ausdruck.CopyRows()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)

Create

Description
Creates a new Alarm object.

Syntax
Expression.Create (VARIANT vtApplication)

Expression
Required An expression which returns an object of type "Alarm".  

Parameters
VARIANT

Parameters Description
vtApplication Name of alarm object (optional)

See also
OnlineTrendControl (Page 4045)
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CreateTagSet

Description    
Creates a new TagSet object. This object may be used for optimized multi-tag access.

syntax
Expression.CreateTagSet()

Expression
Necessary. An expression which returns an object of type "TagSet".  

Parameters
VARIANT

Example:
The following example shows how to create a TagSet object.

 
'VBS168
'Build a Reference to the TagSet Object
Dim group
Set group = HMIRuntime.Tags.CreateTagSet

See also
OnlineTrendControl (Page 4045)

CutRows

Description  
Executes the "Cut rows" key function of the recipe view.

Syntax
Ausdruck.CutRows()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4751



Parameters
- -

See also
OnlineTrendControl (Page 4045)

UserArchiveControl (Page 4130)

DeactivateDynamic

Description   
Deactivates the trigger of the "ActivateDynamic" method used for the specified property in/
during runtime.

Syntax
Ausdruck.DeactivateDynamic(ByVal bstrPropertyName As String)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
String

Parameters Description
bstrPropertyName Name of property to which trigger relates.
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See also
ChannelDiagnose (Page 3972)

CheckBox (Page 3974)

Circle (Page 3977)

CircleSegment (Page 3979)

CircularArc (Page 3982)

Clock (Page 3984)

Connector (Page 3986)

DiskSpaceView (Page 3991)

Ellipse (Page 3993)

EllipseSegment (Page 3995)

EllipticalArc (Page 3998)

Gauge (Page 4008)

GraphicIOField (Page 4011)

GraphicView (Page 4014)

HTMLBrowser (Page 4019)

IOField (Page 4021)

Rectangle (Page 4072)

ScriptDiagnostics (Page 4080)

SymbolicIOField (Page 4093)

SymbolLibrary (Page 4098)

TextField (Page 4107)

TubeArcObject (Page 4121)

TubeDoubleTeeObject (Page 4123)

TubePolyline (Page 4125)

TubeTeeObject (Page 4128)

UserView  (Page 4137)

WindowSlider (Page 4139)

Slider (Page 4082)

ScreenWindow (Page 4078)

RoundButton (Page 4074)

Polyline (Page 4060)

Polygon (Page 4057)

OptionGroup (Page 4054)

MultiLineEdit (Page 4032)

MediaPlayer (Page 4030)

Listbox (Page 4027)

Line (Page 4025)

Bar (Page 3961)

Button (Page 3968)

OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)
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DeleteRows

Description  
Executes the "Delete rows" key function of the recipe view.

Syntax
Ausdruck.DeleteRows()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

UserArchiveControl (Page 4130)

DetachDB

Description
Executes the "Disconnect backup" key function of the control.

Syntax
Ausdruck.DetachDB()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)
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Edit

Description  
Executes the "Edit" key function of the table view.

Syntax
Ausdruck.Edit()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

AlarmControl (Page 3947)

Export

Description
Executes the "Export archive" or "Export data" key function of the control.

Syntax
Ausdruck.Export()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT
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See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

GetColumn

Description   
Returns the column object of the recipe view designated by name or index as 
"ICCAxUAColumn" type.

Syntax
Ausdruck.GetColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the column of the recipe view

Example

 
'VBS312
Dim ctrl
Dim objColumn
Set ctrl = ScreenItems("RecipeControl")
Set objColumn = ctrl.GetColumn("Field1")
objColumn.Length = 30
Set objColumn = ctrl.GetColumn(3)
objColumn.Align = 2
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "Column" listing, for example, you write "objColumn.Align" instead of 
"objColumn.ColumnAlign".

 

 

See also
OnlineTrendControl (Page 4045)

UserArchiveControl (Page 4130)

GetColumnCollection

Description   
Returns the list of all column objects of the recipe view as "ICCAxCollection" type.

Syntax
Ausdruck.GetColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)
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Example

 
'VBS313
Dim ctrl
Dim coll
Dim field
Set ctrl = ScreenItems("RecipeControl")
Set coll = ctrl.GetColumnCollection
HMIRuntime.Trace "Number of fields:" & coll.Count & vbCrLf
For Each field In coll
 HMIRuntime.Trace field.Name & vbCrLf
 HMIRuntime.Trace field.Type & vbCrLf
 HMIRuntime.Trace field.Length & vbCrLf
 HMIRuntime.Trace field.Caption & vbCrLf
Next

See also
OnlineTrendControl (Page 4045)

UserArchiveControl (Page 4130)

GetHistlistColumnCollection

Description   
Returns the list of all column objects of the message view hit list as "ICCAxCollection" type.

Syntax
Expression.GetHitlisteColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4758 System Manual, 07/2013,  



● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS315
Dim ctrl
Dim coll
Dim hitlistcol
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetHitlistColumnCollection
HMIRuntime.Trace "Number of hitlist columns:" & coll.Count & vbCrLf
For Each hitlistcol In coll
 HMIRuntime.Trace hitlistcol.Index & vbCrLf
 HMIRuntime.Trace hitlistcol.Name & vbCrLf
 HMIRuntime.Trace hitlistcol.Sort & vbCrLf
 HMIRuntime.Trace hitlistcol.SortIndex & vbCrLf
Next

See also
OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

GetHitlistColumn

Description   
Returns the column object of the message view hit list designated by name or index as 
"ICCAxMessageColumn" type.

Syntax
Expression.GetHitlistColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of hitlist column
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Example

 
'VBS314
Dim ctrl
Dim objHitlistColumn
Set ctrl = ScreenItems("AlarmControl")
Set objHitlistColumn = ctrl.GetHitlistColumn("Date")
objHitlistColumn.Sort = 2
Set objHitlistColumn = ctrl.GetHitlistColumn("AverageComeGo")
objHitlistColumn.Visible = FALSE

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "HitlistColumn" listing, for example, you write "objHitlistColumn.Visible" instead of 
"objHitlistColumn.HitlistColumnVisible".

 

 

See also
OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

GetMessageBlock

Description   
Returns the message block of the message view designated by name or index as 
"ICCAxMessageBlock" type.

Syntax
Expression.GetMessageBlock(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters
VARIANT

Parameters Description
vIndex Index or name of message block.

Example

 
'VBS316
Dim ctrl
Dim objMsgBlock
Set ctrl = ScreenItems("AlarmControl")
Set objMsgBlock = ctrl.GetMessageBlock("Date")
objMsgBlock.Align = 2
Set objMsgBlock = ctrl.GetMessageBlock("Number")
objMsgBlock.LeadingZeros = 4

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "MessageBlock" listing, for example, you write "objMsgBlock.Align" instead of 
"objMsgBlock.MessageBlockAlign".

 

 

See also
OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

GetMessageBlockCollection

Description   
Returns the list of all message block objects of the message view as "ICCAxCollection" type.

Syntax
Expression.GetMessageBlockCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS317
Dim ctrl
Dim coll
Dim msgblock
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetMessageBlockCollection
For Each msgblock In coll
 msgblock.Align = 1
 msgblock.Length = 12
 msgblock.Selected = TRUE
Next

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "MessageBlock" listing, for example, you write "msgblock.Align" instead of 
"msgblock.MessageBlockAlign".

 

See also
OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)
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GetMessageColumn

Description   
Returns the column object of the message view designated by name or index as 
"ICCAxMessageColumn" type.

Syntax
Expression.GetMessageColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of column in message list.

Example

 
'VBS318
Dim ctrl
Dim objMessColumn
Set ctrl = ScreenItems("AlarmControl")
Set objMessColumn = ctrl.GetMessageColumn("Date")
objMessColumn.Visible = FALSE
Set objMessColumn = ctrl.GetMessageColumn("Number")
objMessColumn.Sort = 1

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "MessageColumn" listing, for example, you write "objMessColumn.Visible" instead 
of "objMessColumn.MessageColumnVisible".
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See also
OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

GetOperatorMessage

Description   
Returns the operator message object of the message view designated by name or index as 
"ICCAxOperatorMessage" type.

Syntax
Expression.GetOperatorMessage(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of operator message

Example

 
'VBS320
Dim ctrl
Dim objOpMess
Set ctrl = ScreenItems("AlarmControl")
Set objOpMess = ctrl.GetOperatorMessage(0)
objOpMess.Source1 = "Number"
objOpMess.SourceType1 = 1

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "OperatorMessage" listing, for example, you write "objOpMess.Source1" instead of 
"objOpMess.OperatorMessageSource1".

 

 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4764 System Manual, 07/2013,  



See also
OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

GetMessageColumnCollection

Description   
Returns the list of all column objects of the message view as "ICCAxCollection" type.

Syntax
Expression.GetMessageColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS319
Dim ctrl
Dim coll
Dim msgcol
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetMessageColumnCollection
HMIRuntime.Trace "Number of message columns:" & coll.Count & vbCrLf
For Each msgcol In coll
 HMIRuntime.Trace msgcol.Index & vbCrLf
 HMIRuntime.Trace msgcol.Name & vbCrLf
 HMIRuntime.Trace msgcol.Sort & vbCrLf
 HMIRuntime.Trace msgcol.SortIndex & vbCrLf
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Next

See also
OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

GetOperatorMessageCollection

Description   
Returns the list of all operator message objects of the message view as "ICCAxCollection" 
type.

Syntax
Expression.GetOperatorMessageCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS321
Dim ctrl
Dim coll
Dim opmsg
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetOperatorMessageCollection
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For Each opmsg In coll
 HMIRuntime.Trace opmsg.Index & vbCrLf
 HMIRuntime.Trace opmsg.Name & vbCrLf
 HMIRuntime.Trace opmsg.Number & vbCrLf
 HMIRuntime.Trace opmsg.Selected & vbCrLf
Next

See also
OnlineTrendControl (Page 4045)

AlarmControl (Page 3947)

GetRow

Description   
Returns the row object defined by its row number in the table-based controls as 
"ICCAxDataRow" type.

Syntax
Expression.GetRow(ByVal IRow As Long)

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
Long

Parameters Description
IRow Number of the desired line of the control.

Example

 
'VBS356
Dim coll
Dim ctrl
Dim lIndex
Dim lCellIndex 
Set ctrl = ScreenItems("UAControl")
Set coll = ctrl.GetRowCollection
'enumerate and trace out row numbers 
For lIndex = 1 To coll.Count
 HMIRuntime.trace "Row: " & (ctrl.GetRow(lIndex).RowNumber) & "  "
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 'enumerate and trace out column titles and cell texts
 For lCellIndex = 1 To ctrl.GetRow(lIndex).CellCount
  HMIRuntime.trace ctrl.GetRow(0).CellText(lCellIndex) & "  "
  HMIRuntime.trace ctrl.GetRow(lIndex).CellText(lCellIndex) & "  "
 Next
 HMIRuntime.trace vbNewLine
Next

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Row" listing, for example, you write "objRow.CellCount" instead of 
"objRow.RowCellCount".

 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)

GetRowCollection

Description 
Returns the list of all row objects of the table-based controls type "ICCAxDataRowCollection". 

Syntax
Expression.GetRowCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -
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Properties of the ICCAxDataRowCollection
The ICCAxDataRowCollection refers to runtime data. The data is read-only. It is not possible 
to add and edit the data.

The following properties are available for the ICCAxDataRowCollection:

● Count - Determines the number of rows in the collection.

● Item - Access to an individual row within the collection via the row number. Numbering runs 
from 1 to Count. A Row object is returned.

Example

 
'VBS357
Dim ctrl
Dim coll
Dim lIndex
Dim lCellIndex
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetRowCollection
HMIRuntime.Trace "Number of message rows:" & coll.Count & vbCrLf
'enumerate and trace out row numbers
For lIndex = 1 To coll.Count
 HMIRuntime.Trace "Row: " & (ctrl.GetRow(lIndex).RowNumber) & "  "
 'enumerate and trace out column titles and cell texts
 For lCellIndex = 1 To ctrl.GetRow(lIndex).CellCount
  HMIRuntime.Trace ctrl.GetMessageColumn(lCellIndex -1).Name & " "
  HMIRuntime.Trace ctrl.GetRow(lIndex).CellText(lCellIndex) & "  "
 Next
 HMIRuntime.Trace vbNewLine
Next

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)

GetRulerBlock 

Description   
Returns the block object of the evaluation table designated by name or index as 
"ICCAxRulerBlock" type.
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Syntax
Expression.GetRulerBlock(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the block in the evaluation table

Example

 
'VBS322
Dim ctrl
Dim objRulerBlock
Set ctrl = ScreenItems("RulerControl")
Set objRulerBlock = ctrl.GetRulerBlock(0)
objRulerBlock.Caption = "RulerBlock1"
Set objRulerBlock = ctrl.GetRulerBlock("Name")
objRulerBlock.Length = 10

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "RulerBlock" listing, for example, you write "objRulerBlock.Caption" instead of 
"objRulerBlock.BlockCaption".

 

 

See also
OnlineTrendControl (Page 4045)

TrendRulerControl (Page 4110)

GetRulerBlockCollection 

Description   
Returns the list of all block objects of the evaluation table as "ICCAxCollection" type.
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Syntax
Expression.GetRulerBlockCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS323
Dim ctrl
Dim coll
Dim rulerblock
Set ctrl = ScreenItems("RulerControl")
Set coll = ctrl.GetRulerBlockCollection
For Each rulerblock In coll
 rulerblock.Align = 1
 rulerblock.Length = 12
Next

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "RulerBlock" listing, for example, you write "rulerblock.Align" instead of 
"rulerblock.RulerBlockAlign".
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See also
OnlineTrendControl (Page 4045)

TrendRulerControl (Page 4110)

GetRulerColumn

Description   
Returns the column object of the evaluation table designated by name or index as 
"ICCAxRulerColumn" type.

Syntax
Expression.GetRulerColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the column of the evaluation

Example

 
'VBS324
Dim ctrl
Dim objRulercol
Set ctrl = ScreenItems("RulerControl")
Set objRulercol = ctrl.GetRulerColumn("Name")
objRulercol.Sort = 0
Set objRulercol = ctrl.GetRulerColumn("ValueY")
objRulercol.Visible = FALSE

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "RulerColumn" listing, for example, you write "objRulercol.Visible" instead of 
"objRulercol.ColumnVisible".
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See also
OnlineTrendControl (Page 4045)

TrendRulerControl (Page 4110)

GetRulerColumnCollection 

Description   
Returns the list of all column objects of the evaluation table as "ICCAxCollection" type.

Syntax
Expression.GetRulerColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS325
Dim ctrl
Dim coll
Dim rulercol
Set ctrl = ScreenItems("RulerControl")
Set coll = ctrl.GetRulerColumnCollection
HMIRuntime.Trace "Number of ruler columns:" & coll.Count & vbCrLf
For Each rulercol In coll
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 HMIRuntime.Trace rulercol.Index & vbCrLf
 HMIRuntime.Trace rulercol.Name & vbCrLf
 HMIRuntime.Trace rulercol.Sort & vbCrLf
 HMIRuntime.Trace rulercol.SortIndex & vbCrLf
Next

See also
OnlineTrendControl (Page 4045)

TrendRulerControl (Page 4110)

GetRulerData

Description   
Returns the value of the called trend at the ruler position.

Syntax
Expression.GetRulerData(ByVal RulerIndex As Long, pvValue As 
Variant, Optional pvTimeStamp As Variant, Optional pvFlags As 
Varian) Long

Expression
Necessary. An expression which returns an object of the "Trend" type.

Parameters

Parameters Description
RulerIndex 0 =Ruler
pvValue Value of X axis
pvTimeStamp Time or value of the Y axis
pvFlags Qualitycode

Example

 
'VBS326
Dim ctrl
Dim objTrend
Dim objIOField1
Dim objIOField2
Dim rulvalue
Dim rultime
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Set ctrl = ScreenItems( "Control1" )
Set objTrend = ctrl.GetTrend( "Trend 1" )
Set objIOField1 = ScreenItems( "I/O Field1" )
Set objIOField2 = ScreenItems( "I/O Field2" )
objTrend.GetRulerData 0, rulvalue, rultime
objIOField1.OutputValue = rulvalue
objIOField2.OutputValue = rultime

See also
OnlineTrendControl (Page 4045)

GetSelectedRow

Description     
Returns the selected row object of a table-based control as "ICCAxDataRow" type.

Syntax
Expression.GetSelectedRow()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Example

 
'VBS358
Dim ctrl
 Dim lCellIndex
 Dim lCellCount 
 Dim headingRow
 Dim selectedRow
 Set ctrl = ScreenItems("TableControl")
 Set headingRow = ctrl.GetRow(0)
 Set selectedRow = ctrl.GetSelectedRow
 lCellCount = headingRow.CellCount
 'enumerate and trace out column titles and cell texts
 For lCellIndex = 1 To lCellCount
  HMIRuntime.trace headingRow.CellText(lCellIndex) & ":  "
  HMIRuntime.trace selectedRow.CellText(lCellIndex)
    HMIRuntime.trace vbNewLine
 Next
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 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Row" listing, for example, you write "objRow.CellCount" instead of 
"objRow.RowCellCount".

 

 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)

GetSelectedRows

Description     
Returns the selected row objects of a table-based control as type "ICCAxDataRow" for multiple 
selection.

Syntax
Expression.GetSelectedRows()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Example

 
'VBS359
Dim ctrl
 Dim lCellIndex
 Dim lCellCount 
 Dim lRowIndex
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 Dim lRowCount
 Dim headingRow
 Dim selectedRow
 Dim selectedRows
 Set ctrl = ScreenItems("TableControl")
 Set headingRow = ctrl.GetRow(0)
 Set selectedRows = ctrl.GetSelectedRows
 lCellCount = headingRow.CellCount
 lRowCount = selectedRows.Count
 'enumerate selected rows
 For lRowIndex = 1 To lRowCount
  Set selectedRow = selectedRows(lRowIndex)
  HMIRuntime.Trace "Row number: " & CStr(lRowIndex) & vbNewLine
  'enumerate and trace out column titles and cell texts
  For lCellIndex = 1 To lCellCount
   HMIRuntime.trace headingRow.CellText(lCellIndex) & ":  "
   HMIRuntime.trace selectedRow.CellText(lCellIndex)
     HMIRuntime.trace vbNewLine
  Next
 Next

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Row" listing, for example, you write "objRow.CellCount" instead of 
"objRow.RowCellCount".

 

 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)

GetStatisticAreaColumn

Description   
Returns the column object of the statistic area window of the evaluation window designated 
by name or index as "ICCAxRulerColumn" type.
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Syntax
Ausdruck.GetStatisticAreaColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of column of statistics area window.

Example

 
'VBS327
Dim ctrl
Dim objStatAreaCol
Set ctrl = ScreenItems("RulerControl")
Set objStatAreaCol = ctrl.GetStatisticAreaColumn("DatasourceY")
objStatAreaCol.Visible = FALSE
Set objStatAreaCol = ctrl.GetStatisticAreaColumn("ValueY(LL)")
objStatAreaCol.Sort = 1

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "StatisticAreaColumn" listing, for example, you write "objStatAreaCol.Visible" instead 
of "objStatAreaCol.ColumnVisible".

 

 

See also
OnlineTrendControl (Page 4045)

TrendRulerControl (Page 4110)
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GetStatisticAreaColumnCollection

Description   
Returns the list of all column objects of the statistic area window of the evaluation table as 
"ICCAxCollection" type.

Syntax
Ausdruck.GetStatisticAreaColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS328
Dim ctrl
Dim coll
Dim statcol
Set ctrl = ScreenItems("RulerControl")
Set coll = ctrl.GetStatisticAreaColumnCollection
HMIRuntime.Trace "Number of statistic Area columns:" & coll.Count & vbCrLf
For Each statcol In coll
 HMIRuntime.Trace statcol.Index & vbCrLf
 HMIRuntime.Trace statcol.Name & vbCrLf
 HMIRuntime.Trace statcol.Sort & vbCrLf
 HMIRuntime.Trace statcol.SortIndex & vbCrLf
Next
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See also
OnlineTrendControl (Page 4045)

TrendRulerControl (Page 4110)

GetStatisticResultColumn

Description   
Returns the column object of the statistic window of the evaluation window designated by name 
or index as "ICCAxRulerColumn" type.

Syntax
Ausdruck.GetStatisticResultColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of column of statistics window.

Example

 
'VBS329
Dim ctrl
Dim objStatResCol
Set ctrl = ScreenItems("RulerControl")
Set objStatResCol = ctrl.GetStatisticResultColumn("MaxValue")
objStatResCol.Visible = FALSE
Set objStatResCol = ctrl.GetStatisticResultColumn("Average")
objStatResCol.Sort = 2

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "StatisticResultColumn" listing, for example, you write "objStatResCol.Visible" instead 
of "objStatResCol.ColumnVisible".
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See also
OnlineTrendControl (Page 4045)

TrendRulerControl (Page 4110)

GetStatisticResultColumnCollection

Description   
Returns the list of all column objects of the statistic window of the evaluation table as 
"ICCAxCollection" type.

Syntax
Ausdruck.GetStatisticResultColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS330
Dim ctrl
Dim coll
Dim statcol
Set ctrl = ScreenItems("RulerControl")
Set coll = ctrl.GetStatisticResultColumnCollection
HMIRuntime.Trace "Number of statistic result columns:" & coll.Count & vbCrLf
For Each statcol In coll
 HMIRuntime.Trace statcol.Index & vbCrLf
 HMIRuntime.Trace statcol.Name & vbCrLf
 HMIRuntime.Trace statcol.Sort & vbCrLf
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 HMIRuntime.Trace statcol.SortIndex & vbCrLf
Next

See also
OnlineTrendControl (Page 4045)

TrendRulerControl (Page 4110)

GetStatusbarElement

Description 
Returns the element of the control status bar designated as name or index as type 
"ICCAxStatusbarElement".

Syntax
Ausdruck.GetStatusbarElement(ByVal vIndex As Variant)

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of status bar element.

Example

 
'VBS331
Dim ctrl
Dim objStatusBar
Set ctrl = ScreenItems( "Control1" )
Set objStatusBar = ctrl.GetStatusbarElement(1)
objStatusBar.Visible = FALSE
Set objStatusBar = ctrl.GetStatusbarElement(3)
objStatusBar.Width = 10
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "StatusbarElement" listing, for example, you write "objStatusBar.Visible" instead of 
"objStatusBar.StatusbarElementVisible".

 

 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

GetStatusbarElementCollection

Description 
Returns the list of all status bar elements of the control as type "ICCAxCollection".

Syntax
Ausdruck.GetStatusbarElementCollection()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:
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● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS332
Dim ctrl
Dim coll
Dim statelement
Set ctrl = ScreenItems.Item("Control1")
Set coll = ctrl.GetStatusbarElementCollection
HMIRuntime.Trace "Number of statusbar elements:" & coll.Count & vbCrLf
For Each statelement In coll
 HMIRuntime.Trace statelement.Name & vbCrLf
 HMIRuntime.Trace statelement.Width & vbCrLf
 HMIRuntime.Trace statelement.Text & vbCrLf
Next

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "StatusbarElement" listing, for example, you write "statelement.Name" instead of 
"statelement.StatusbarElementName".

 

 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

GetTimeAxis

Description     
Returns the time object that is specified by name or index for the f(t) trend view as 
"ICCAxTimeAxis" type.
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Syntax
Expression.GetTimeAxis(ByVal vIndex As Variant)

Expression
Necessary. Expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of time axis.

Example

 
'VBS333
Dim ctrl
Dim objTimeAxis
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTimeAxis = ctrl.GetTimeAxis(1)
objTimeAxis.Visible = FALSE
Set objTimeAxis = ctrl.GetTimeAxis("axis 2")
objTimeAxis.Label = "Time axis 2"
objTimeAxis.DateFormat = "dd.MM.yy"
objTimeAxis.TimeFormat = "HH:mm:ss.ms"
objTimeAxis.RangeType = 2
'The format to be used for date and time entries depends on the
'regional settings and language options in the operating system.
objTimeAxis.BeginTime = "06.04.2010 9:33:18"
'objTimeAxis.BeginTime = "04/06/2010 9:33:18"
objTimeAxis.MeasurePoints = 100

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "TimeAxis" listing, for example, you write "objTimeAx.Visible" instead of 
"objTimeAx.TimeAxisVisible".

 

See also
OnlineTrendControl (Page 4045)
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GetTimeAxisCollection

Description     
Returns a list of all time objects of the f(t) trend view as "ICCAxCollection" type.

Syntax
Expression.GetTimeAxisCollection()

Expression
Necessary. Expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for ICCAxCollection:

● Count

● Item

The following functions are available for ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS334
Dim ctrl
Dim objTrendWnd
Dim objTimeAxis1
Dim objTimeAxis2
Dim objTrend
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindowCollection.AddItem("myWindow")
Set objTimeAxis1 = ctrl.GetTimeAxisCollection.AddItem("TimeAxis2010")
Set objTimeAxis2 = ctrl.GetTimeAxisCollection.AddItem("TimeAxis2011")
objTimeAxis1.TrendWindow = objTrendWnd.Name
objTimeAxis1.Label = "2010"
objTimeAxis1.RangeType = 1
'The format to be used for date and time entries depends on the
'regional settings and language options in the operating system.
objTimeAxis1.BeginTime = "01.01.2010 0:00:00"
'objTimeAxis1.BeginTime = "01/01/2010 0:00:00" 
objTimeAxis1.EndTime = "31.12.2010 11:59:59"
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'objTimeAxis1.EndTime = "12/31/2010 11:59:59"
objTimeAxis2.TrendWindow = objTrendWnd.Name
objTimeAxis2.Label = "2011"
objTimeAxis2.RangeType = 1
objTimeAxis2.BeginTime = "01.01.2011 0:00:00" 
'objTimeAxis2.BeginTime = "01/01/2011 0:00:00"
objTimeAxis2.EndTime = "31.12.2011 11:59:59"
'objTimeAxis2.EndTime = "12/31/2011 11:59:59"
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend1")
objTrend.TrendWindow = objTrendWnd.Name
objTrend.TimeAxis = objTimeAxis1.Name
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend2")
objTrend.TrendWindow = objTrendWnd.Name
objTrend.TimeAxis = objTimeAxis2.Name

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "TimeAxis" listing, for example, you write "objTimeAxis1.Label" instead of 
"objTimeAxis1.TimeAxisLabel".

 

 

See also
OnlineTrendControl (Page 4045)

GetTimeColumn

Description   
Returns the time column object of the table view designated by name or index as "ICCAxTime 
Column" type.

Syntax
Ausdruck.GetTimeColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters
VARIANT

Parameters Description
vIndex Index or name of time column.

Example

 
'VBS335
Dim ctrl
Dim objTimeCol
Set ctrl = ScreenItems("TableControl")
Set objTimeCol = ctrl.GetTimeColumn("Timecolumn1")
objTimeCol.ShowDate = FALSE
Set objTimeCol = ctrl.GetTimeColumn("Timecolumn2")
objTimeCol.Visible = FALSE

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "TimeColumn" listing, for example, you write "objTimeColumn.ShowDate" instead of 
"objTimeColumn.TimeColumnShowDate".

 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

GetTimeColumnCollection

Description     
Returns the list of all time column objects of the table view as "ICCAxCollection" type.

Syntax
Expression.GetTimeColumnCollection()

Expression
Necessary. Expression that returns an object of the "ScreenItem" type.
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Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for ICCAxCollection:

● Count

● Item

The following functions are available for ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS336
Dim ctrl
Dim objTimeCol1
Dim objTimeCol2
Dim coll
Dim timecol
Set ctrl = ScreenItems("TableControl")
Set objTimeCol1 = ctrl.GetTimeColumnCollection.AddItem("TimeColumn2010")
Set objTimeCol2 = ctrl.GetTimeColumnCollection.AddItem("TimeColumn2011")
objTimeCol1.Caption = "2010"
objTimeCol1.RangeType = 1
'The format to be used for date and time entries depends on the
'regional settings and language options in the operating system.
objTimeCol1.BeginTime = "01.01.2010 0:00:00"
'objTimeCol1.BeginTime = "01/01/2010 0:00:00" 
objTimeCol1.EndTime = "31.12.2010 11:59:59"
'objTimeCol1.EndTime = "12/31/2010 11:59:59"
objTimeCol2.Caption = "2011"
objTimeCol2.RangeType = 0
objTimeCol2.BeginTime = "01.01.2011 0:00:00"
'objTimeCol2.BeginTime = "01/01/2011 0:00:00" 
objTimeCol2.TimeRangeFactor = 1
objTimeCol2.TimeRangeBase = 3600000
Set coll = ctrl.GetTimeColumnCollection
For Each timecol In coll
 timecol.Align = 1
 timecol.Length = 12
 timecol.BackColor = RGB(240,240,0)
 timecol.ForeColor = RGB(130,160,255)
Next
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See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

GetToolbarButton

Description     
Returns the button function designated by name or index on the control toolbar as 
"ICCAxToolbarButton" type.

Syntax
Ausdruck.GetToolbarButton(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of toolbar button function.

Example

 
'VBS337
Dim ctrl
Set ctrl = ScreenItems( "Control1" )
Dim toolbu
Set toolbu = ctrl.GetToolbarButton ("ShowHelp")
HMIRuntime.Trace "Name: " & toolbu.Name & vbCrLf
HMIRuntime.Trace "Index: " & toolbu.Index & vbCrLf
HMIRuntime.Trace "Hotkey: " & toolbu.HotKey & vbCrLf

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "ToolbarButton" listing, for example, you write "toolbu.Index" instead of 
"toolbu.ToolbarButtonIndex".

 

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4790 System Manual, 07/2013,  



See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

GetToolbarButtonCollection

Description     
Returns the list of all button functions of the control toolbar as "ICCAxCollection" type.

Syntax
Ausdruck.GetToolbarButtonCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following methods are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS338
Dim ctrl
Dim coll
Dim toolbu
Set ctrl = ScreenItems( "Control1" )
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Set coll = ctrl.GetToolbarButtonCollection
HMIRuntime.Trace "Number of toolbar buttons:" & coll.Count & vbCrLf
For Each toolbu In coll
 HMIRuntime.Trace toolbu.Name & vbCrLf
 HMIRuntime.Trace "Hotkey: " & toolbu.HotKey & vbCrLf
 HMIRuntime.Trace "Authorization: " & toolbu.PasswordLevel & vbCrLf
Next

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

GetTrend

Description     
Returns the f(t) or f(x) trend view designated by name or index as "ICCAxTrend" or 
"ICCAxFunctionTrend" type.

Syntax
Ausdruck.GetTrend(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of curve.

Example for Runtime Professional

 
'VBS339
Dim ctrl

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4792 System Manual, 07/2013,  



 
Dim objTrend
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrend = ctrl.GetTrend( "Trend 1" )
objTrend.PointStyle = 1
objTrend.LineWidth = 4
Set objTrend = ctrl.GetTrend(2)
objTrend.Provider = 1
objTrend.TagName = "Archive\ArchiveTag2"

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Trend" listing, for example, you write "objTrend.PointStyle" instead of 
"objTrend.TrendPointStyle".

 

 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

GetTrendCollection

Description     
Returns the list of all trends of the f(t) or f(x) trend view as "ICCAxCollection" type.

Syntax
Ausdruck.GetTrendCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -
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Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example for Runtime Professional

 
'VBS340
Dim ctrl
Dim objTrendWnd
Dim objTimeAxis
Dim objValAxis
Dim objTrend
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindowCollection.AddItem("myWindow")
Set objTimeAxis = ctrl.GetTimeAxisCollection.AddItem("myTimeAxis")
Set objValAxis = ctrl.GetValueAxisCollection.AddItem("myValueAxis")
objTimeAxis.TrendWindow = objTrendWnd.Name
objValAxis.TrendWindow = objTrendWnd.Name
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend1")
objTrend.Provider = 1
objTrend.TagName = "Archive\ArchiveTag1"
objTrend.TrendWindow = objTrendWnd.Name
objTrend.TimeAxis = objTimeAxis.Name
objTrend.ValueAxis = objValAxis.Name

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Trend" listing, for example, you write "objTrend.TagName" instead of 
"objTrend.TrendTagName".

 

 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)
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GetTrendWindow

Description     
Returns the trend view object of the f(t) trend view or the f(x) trend view designated by name 
or index as "ICCAxTrendWindow" type.

Syntax
Ausdruck.GetTrendWindow(ByVal vIndex As Variant)

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of curve window.

Example for Runtime Professional

 
'VBS341
Dim ctrl
Dim objTrendWnd
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindow(1)
objTrendWnd.Visible = FALSE
Set objTrendWnd = ctrl.GetTrendWindow("trend window 2")
objTrendWnd.VerticalGrid = TRUE
objTrendWnd.FineGrid = TRUE

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "TrendWindow" listing, for example, you write "objTrendWnd.Visible" instead of 
"objTrendWnd.TrendWindowVisible".
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See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

GetTrendWindowCollection

Description     
Returns the list of all trend window objects of the f(t) trend display or the f(x) trend display as 
"ICCAxCollection" type.

Syntax
Ausdruck.GetTrendWindowCollection()

Expression
Required. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example for Runtime Professional

 
'VBS342
Dim ctrl
Dim objTrendWnd
Dim objTimeAxis
Dim objValAxis
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindowCollection.AddItem("myWindow")
Set objTimeAxis = ctrl.GetTimeAxisCollection.AddItem("myTimeAxis")
Set objValAxis = ctrl.GetValueAxisCollection.AddItem("myValueAxis")
objTimeAxis.TrendWindow = objTrendWnd.Name
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objValAxis.TrendWindow = objTrendWnd.Name

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

GetValueAxis

Description   
Returns the value axis object of the f(t) trend view designated by name or index as 
"ICCAxValueAxis" type.

Syntax
Ausdruck.GetValueAxis(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the value axis

Example

 
'VBS343
Dim ctrl
Dim objValAxis
Set ctrl = ScreenItems("OnlineTrendControl")
Set objValAxis = ctrl.GetValueAxis(1)
objValAxis.Visible = FALSE
Set objValAxis = ctrl.GetValueAxis("axis 2")
objValAxis.Label = "Value axis 2"
objValAxis.ScalingType = 0
objValAxis.Precisions = 2
objValAxis.AutoRange = TRUE
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "ValueAxis" listing, for example, you write "objValueAx.Visible" instead of 
"objValueAx.ValueAxisVisible".

 

 

See also
OnlineTrendControl (Page 4045)

GetValueAxisCollection

Description   
Returns the list of all value axis objects of the f(t) trend view as "ICCAxCollection" type.

Syntax
Ausdruck.GetValueAxisCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)
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Example

 
'VBS344
Dim ctrl
Dim objTrendWnd
Dim objValAxis1
Dim objValAxis2
Dim objTrend
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindowCollection.AddItem("myWindow")
Set objValAxis1 = ctrl.GetValueAxisCollection.AddItem("myValueAxis1")
Set objValAxis2 = ctrl.GetValueAxisCollection.AddItem("myValueAxis2")
objValAxis1.TrendWindow = objTrendWnd.Name
objValAxis1.Label = "Value1"
objValAxis2.TrendWindow = objTrendWnd.Name
objValAxis2.inTrendColor = TRUE
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend1")
objTrend.TrendWindow = objTrendWnd.Name
objTrend.ValueAxis = objValAxis1.Name
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend2")
objTrend.TrendWindow = objTrendWnd.Name
objTrend.ValueAxis = objValAxis2.Name

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "ValueAxis" listing, for example, you write "objValueAxis1.Label" instead of 
"objValueAxis1.ValueAxisLabel".

 

 

See also
OnlineTrendControl (Page 4045)

GetValueColumn

Description     
Returns the value column object defined by name or index for the tabular view as 
"ICCAxValueColumn" type.

Syntax
Expression.GetValueColumn(ByVal vIndex As Variant)
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Expression
Necessary. Expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the value column of the f(t) trend view.

Example

 
'VBS345
Dim ctrl
Dim objValueColumn
Set ctrl = ScreenItems("TableControl")
Set objValueColumn = ctrl.GetValueColumn("Valuecolumn1")
objValueColumn.Precisions = 4
Set objValueColumn = ctrl.GetValueColumn(2)
objValueColumn.ExponentialFormat = TRUE

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "ValueColumn" listing, for example, you write "objValueColumn.Precisions" instead 
of "objValueColumn.ValueColumnPrecisions".

 

 

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

GetValueColumnCollection

Description   
Returns the list of all value column objects of the f(t) trend view as "ICCAxCollection" type.
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Syntax
Ausdruck.GetValueColulmnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS346
Dim ctrl
Dim objValCol1
Dim objValCol2
Dim coll
Dim valcol
Set ctrl = ScreenItems("TableControl")
Set objValCol1 = ctrl.GetValueColumnCollection.AddItem("ValueColumn1")
Set objValCol2 = ctrl.GetValueColumnCollection.AddItem("ValueColumn2")
objValCol1.Caption = "Value Archive"
objValCol1.Provider = 1
objValCol1.TagName = "ProcessValueArchive\arch1"
objValCol1.TimeColumn = "TimeColumn1"
objValCol2.Caption = "Value Tag"
objValCol2.Provider = 2
objValCol2.TagName = "tagxx" 
objValCol2.TimeColumn = "TimeColumn2"
Set coll = ctrl.GetValueColumnCollection
For Each valcol In coll
 valcol.Align = 2
 valcol.Length = 10
 valcol.AutoPrecisions = TRUE
Next
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See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

GetXAxis

Description   
Returns the X axis object of the f(x) trend view designated by name or index as 
"ICCAxValueAxis" type.

Syntax
Ausdruck.GetXAxis(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of X axis.

Example

 
'VBS347
Dim ctrl
Dim objXAx
Set ctrl = ScreenItems("FunctionTrendControl")
Set objXAx = ctrl.GetXAxis(1)
objXAx.Visible = FALSE
Set objXAx = ctrl.GetXAxis("axis 2")
objXAx.Label = "X axis 2"
objXAx.ScalingType = 0
objXAx.Precisions = 2
objXAx.Color = RGB(109,109,109)
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "XAxis" listing, for example, you write "objXAx.Visible" instead of 
"objXAx.XAxisVisible".

 

 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

GetXAxisCollection

Description   
Returns the list of all X axis objects of the f(x) trend view as "ICCAxCollection" type.

Syntax
Ausdruck.GetXAxisCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)
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Example

 
'VBS348
Dim ctrl
Dim objXAxis1
Dim objXAxis2
Dim coll
Dim axes
Set ctrl = ScreenItems("FunctionTrendControl")
Set objXAxis1 = ctrl.GetXAxisCollection.AddItem("myXAxis1")
objXAxis1.Label = "temperature"
Set objXAxis2 = ctrl.GetXAxisCollection.AddItem("myXAxis2")
objXAxis2.Label = "pressure"
Set coll = ctrl.GetXAxisCollection
HMIRuntime.Trace "Number of XAxis:" & coll.Count & vbCrLf
For Each axes In coll
 HMIRuntime.Trace axes.Name & vbCrLf
 HMIRuntime.Trace axes.Label & vbCrLf
Next

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "XAxis" listing, for example, you write "objXAxis1.Label" instead of 
"objXAxis1.XAxisLabel".

 

 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

GetYAxis

Description   
Returns the Y axis object of the f(x) trend view designated by name or index as 
"ICCAxValueAxis" type.

Syntax
Ausdruck.GetYAxis(ByVal vIndex As Variant)
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Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of Y axis.

Example

 
'VBS349
Dim ctrl
Dim objYAx
Set ctrl = ScreenItems("FunctionTrendControl")
Set objYAx = ctrl.GetYAxis(1)
objYAx.Visible = FALSE
Set objYAx = ctrl.GetYAxis("axis 2")
objYAx.Label = "Y axis 2"
objYAx.Align = 0
objYAx.Precisions = 3
objYAx.EndValue = 90.000
objYAx.BeginValue = 10.000

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "YAxis" listing, for example, you write "objYAx.Visible" instead of 
"objYAx.YAxisVisible".

 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

GetYAxisCollection

Description   
Returns the list of all Y axis objects of the f(x) trend view as "ICCAxCollection" type.
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Syntax
Ausdruck.GetYAxisCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS350
Dim ctrl
Dim objYAxis1
Dim objYAxis2
Dim coll
Dim axes
Set ctrl = ScreenItems("FunctionTrendControl")
Set objYAxis1 = ctrl.GetXAxisCollection.AddItem("myYAxis1")
objYAxis1.Label = "temperature"
Set objYAxis2 = ctrl.GetXAxisCollection.AddItem("myYAxis2")
objYAxis2.Label = "pressure"
Set coll = ctrl.GetYAxisCollection
HMIRuntime.Trace "Number of YAxis:" & coll.Count & vbCrLf
For Each axes In coll
 HMIRuntime.Trace axes.Name & vbCrLf
 HMIRuntime.Trace axes.Label & vbCrLf
Next
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "YAxis" listing, for example, you write "objYAxis1.Label" instead of 
"objYAxis1.YAxisLabel".

 

 

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

Methods H-R

HideAlarm

Description     
Executes the "Hide alarm" button function of the alarm view.

Syntax
Expression.HideAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

InsertData

Description
Adds data to the called trend.
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Syntax
Expression.InsertData(dblAxisX As Variant, dblAxisY As Variant)

Expression
Necessary. An expression which returns an object of the "Trend" type.

Parameters

Parameters Description
dblAxisX Value of X axis
dblAxisY Value of Y axis

Example

 
'VBS300
Dim lngFactor
Dim dblAxisX
Dim dblAxisY
Dim objTrendControl
Dim objTrend
Set objTrendControl = ScreenItems("Control1")
Set objTrend = objTrendControl.GetTrend("Trend 1")
For lngFactor = -100 To 100
dblAxisX = CDbl(lngFactor * 0.02)
dblAxisY = CDbl(dblAxisX * dblAxisX + 2 * dblAxisX + 1)
objTrend.InsertData dblAxisX, dblAxisY
Next

Item

Description
Returns an element from a list.     

Syntax
Expression.Item(Index)

Expression
Necessary. An expression which returns a list.
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Parameters

Index
The name or the index number of an element of the list:

● ScreenItems-Listing: Use an object name, e.g. 
"HmiRuntime.Screens(1).ScreenItems("Circle")", or the index number.

● Screens-Listing: Use either the name or the index number.

● SmartTags-Listing: You can only use the tag name as index in the SmartTags list. A 
counting of all tags is not possible.

 

If the transferred value does not correspond with an element in the list, an error occurs. The 
return value has the value "Nothing".

 
On Error Resume Next
Dim screen
Set screen = HmiRuntime.Screens("Screen_1")
If (screen is Nothing) 
then...
Else...
End If

Best practice for optimizing auto-completion support is to use combined addressing by means 
of screen name and object name, e.g. 
"HmiRuntime.Screens("Screen").ScreenItems("Circle")".

Example
The item method is the default method for lists. Therefore, the results are the same for the 
following two examples:

 
'VBS_Example_Item
HMIRuntime.Screens.Item(1)
HMIRuntime.Screens(1)

Both instructions reference the respective base screen.

See also
ScreenItems (list) (Page 3934)

ScreenItem (Page 3932)
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LockAlarm

Description     
Executes the "Disable alarm" button function of the alarm view.

Syntax
Expression.LockAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

LoopInAlarm

Description     
Executes the "Loop in alarm" button function of the alarm view.

Syntax
Expression.LoopInAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)
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MoveAxis

Description     
Executes the "Move axes area" button function of the f(t) and f(x) trend views.

Syntax
Expression.MoveAxis()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

MoveToFirst

Description    
Executes the "First line" button function of the control.

Syntax
Expression.MoveToFirst()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

UserArchiveControl (Page 4130)
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MoveToFirstLine

Description     
Executes the "First alarm" button function of the alarm view.

Syntax
Ausdruck.MoveToFirstLine()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

MoveToFirstPage

Description     
Executes the "First page" button function of the alarm view.

Syntax
Ausdruck.MoveToFirstPage()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4812 System Manual, 07/2013,  



MoveToLast

Description    
Executes the "last data record" button function of the control.

Syntax
Ausdruck.MoveToLast()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

UserArchiveControl (Page 4130)

MoveToLastLine

Description     
Executes the "Last alarm" button function of the alarm view.

Syntax
Ausdruck.MoveToLastLine()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
AlarmControl (Page 3947)
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MoveToLastPage

Description     
Executes the "Last page" button function of the alarm view.

Syntax
Ausdruck.MoveToLastPage()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

MoveToNext

Description    
Executes the "next data record" button function of the control.

Syntax
Ausdruck.MoveToNext()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

UserArchiveControl (Page 4130)
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MoveToNextLine

Description   
Executes the "Next alarm" button function of the alarm view.

Syntax
Ausdruck.MoveToNextLine()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

MoveToNextPage

Description     
Executes the "Next page" button function of the alarm view.

Syntax
Ausdruck.MoveToNextPage()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)
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MoveToPrevious

Description     
Executes the "previous data record" button function of the control.

Syntax
Ausdruck.MoveToPrevious()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

UserArchiveControl (Page 4130)

MoveToPreviousLine

Description     
Executes the "Previous alarm" button function of the alarm view.

Syntax
Ausdruck.MoveToPreviousLine()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)
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MoveToPreviousPage

Description     
Executes the "Previous page" button function of the alarm view.

syntax
Ausdruck.MoveToPreviousPage()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

NextColumn

Description     
Executes the "Next column" button function of the table view.

Syntax
Ausdruck.NextColumn()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTableControl (Page 4037)
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NextTrend

Description     
Executes the "Next trend" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.NextTrend()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

OneToOneView

Description     
Executes the "Original view" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.OneToOneView()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)
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PasteRows  

Description     
Executes the "Insert rows" button function of the recipe view.

Syntax
Expression.PasteRows()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 4130)

PreviousColumn

Description   
Executes the "Previous column" button function of the table view.

Syntax
Ausdruck.PreviousColumn()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTableControl (Page 4037)
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PreviousTrend

Description     
Executes the "Previous trend" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.PreviousTrend()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

Print

Description    
Executes the "Print" button function of the control.

Syntax
Ausdruck.Print()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -
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See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

QuitHorn

Description     
Executes the "Acknowledge central alarm generator" button function of the alarm view.

Syntax
Ausdruck.QuitHorn()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

QuitSelected

Description     
Executes the "Single acknowledgment" button function of the alarm view.

Syntax
Ausdruck.QuitSelected()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameter
- -

See also
AlarmControl (Page 3947)

QuitVisible

Description     
Executes the "Group acknowledgment" button function of the alarm view.

Syntax
Ausdruck.QuitVisible()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

ReadTags

Description     
Executes the "Read tags" button function of the recipe view.

Syntax
Ausdruck.ReadTags()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -
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See also
UserArchiveControl (Page 4130)

Read

Description of Tag Object  
Reads out the status of a tag (tag object) shortly after the moment it was called. At the same 
time, the tag object is provided with the values read. Upon reading a tag, its value, quality code 
and time stamp are determined. The "LastError" property can be used to determine whether 
the call was successful.

The "Name" and "Tagprefix" properties are not changed by this. 

If the value of the tag is read successfully, the properties of the tag object are assigned the 
following values:

Property Allocation
Value Tag values
Name Tag name (unchanged)
QualityCode Quality level
Timestamp Current tag time stamp
LastError 0
ErrorDescription " "

If the value of the tag is not read successfully, the properties of the tag object are assigned 
the following values:

Property Allocation
Value VT_Empty
Name Tag name (unchanged)
QualityCode Bad Out of Service
Timestamp 0
LastError Read operation error codes
ErrorDescription Error description on LastError

syntax
Expression.Read([Readmode])

Expression
Necessary. An expression which returns a tag object. The return value of the Read method is 
the value of the tag read out. 
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Parameters
The optional "Readmode" parameter enables the distinction between two types of reading:

Parameters Description
0 The tag value is read from the process image 

(cache). 0 is the default value.
1 The value of a tag is read directly from AS or 

channel (direct).

If the "Readmode" parameter is omitted, the value is read from the process image by default. 
The return value of the Read method is the tag value read out as VARIANT. 

Reading From the Process Image
When reading from the process image, the tag is logged on and, from that moment, polled 
cyclically from the PLC. The login cycle is dependent on the configured trigger. The value is 
read from the tag image by WinCC. For Close Picture, the tag actions are ended again. The 
call is characterized by the following:

● The value is read by WinCC from the tag image.

● The call is faster in comparison to direct reading (except with the first call: The first call 
basically takes longer because the value from the PLC must be read out and logged on.)

● The duration of the call is not dependent on the bus load or AS.

Behavior in actions with a tag trigger

All of the tags contained in the tag trigger are already known with Open Picture and are 
registered with the defined monitoring time. Since all tags are requested at once, the best 
possible optimization can be targeted from the channel. If a tag, contained in the trigger, is 
requested with Read during an action, the value already exists and is transferred directly to 
the call. If a tag is requested which is not contained in the trigger, the behavior is the same as 
with a standard trigger.

Behavior in actions with a cyclic trigger

tags are registered with half of the cycle time with the first call. For every other call, the value 
is present.

Behavior in event-driven actions

The tag is registered in the "upon change" mode with the first call. Process tags that are 
registered in the "upon change" mode correspond with a cyclic read job with a cycle time of 
1s.

If an event (e.g. mouse click) requests a value asynchronously, the tag is transferred to the 
tag image. The tag is requested cyclically from the AS as of this point in time and therefore 
increases the basic load. To bypass this increase in the basic load, the value can also be read 
synchronously. The synchronous call causes a one-off increase in the communication load 
but the tag is not transferred to the tag image.

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4824 System Manual, 07/2013,  



Direct reading
In the case of direct reading, the current value is returned. The tag is not registered cyclically, 
the value is requested from the AS one time only. Direct reading has the following properties:

● The value is read explicitly from the AS.

● The call takes longer compared to reading from the process image.

● The duration of the call is dependent on the bus load and AS, amongst other things.

Example
Reading a tag directly from AS or channel

 
'VBS100
Dim objTag
Dim vntValue
Set objTag = HMIRuntime.Tags("Tagname")
vntValue = objTag.Read(1)    'Read direct
MsgBox vntValue

 

Reading a tag from the process image

 
'VBS101
Dim objTag
Dim vntValue
Set objTag = HMIRuntime.Tags("Tagname")
vntValue = objTag.Read    'Read from cache
MsgBox vntValue

Description of TagSet Object
The TagSet object offers the option of reading several tags in one call. 

Functionality here is mostly identical with that of a tag object. In the following, only deviations 
thereof are described. 

Expression
Necessary. An expression which returns an object of type "TagSet". 

Reading From the Process Image
The TagSet object offers the advantage of requesting several tags in one read command. The 
tags are registered in the process image as a group, improving performance in the process.
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Direct reading
Since one call may process several read commands, performance is enhanced in comparison 
to single calls. 

Example
The following example shows how tags are included in the TagSet list, how tag values are 
imported and subsequently read. 

 
'VBS174
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
group.Read
HMIRuntime.Trace "Motor1: " & group("Motor1").Value & vbNewLine
HMIRuntime.Trace "Motor2: " & group("Motor2").Value & vbNewLine

 

If the optional parameter "Readmode" is set to 1, the process tags are not registered but read 
directly from AS or channel. 

 
group.Read 1

Refresh

Description
Drawing all visible pictures again.

syntax
Expression.Refresh

Expression
Necessary. An expression which returns a "Screens" or "Screen" type object.

Parameter
--
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Examples
The first example forces all visible pictures to be drawn again:

 
'VBS149
HMIRuntime.Screens.Refresh

 

The second example forces the basic picture to be immediately redrawn:

 
'VBS150
HMIRuntime.Screens(1).Refresh

See also
Screen (Page 3930)

HMIRuntime  (Page 3922)

Remove

Description of TagSet Object  
Removes a tag from the TagSet list. The tag may be removed by name or reference to a tag 
object.

Syntax
Expression.Remove [Tag]

Expression
Required An expression that returns an object of type "TagSet". 

Parameters
VARIANT

Parameters Description
Tag Name of a WinCC tag or reference to a tag object 

to be removed from the list. 
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Example
The following example shows how several tags are included in the TagSet list, and how to 
remove a tag again. 

 
'VBS175
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
group.Remove "Motor1"

Description of DataSet Object
Deletes the element specified in parameter "Name" from a list. 

Syntax
Expression.Remove [Name]

Expression
Required An expression which returns an object of type "DataSet". 

Parameters
VARIANT

Parameters Description
Name Name of the object to be removed from the list. 

Example
The example shows how to remove the object "motor1" from the list.

 
'VBS166
HMIRuntime.DataSet.Remove("motor1")

Description of objects Logging, AlarmLogs, DataLogs
The method deletes previously swapped-in log segments from the Runtime project.

Log segments that were deleted using the "Remove" method are removed from the "Common 
logging" folder of the project.

The call may require a somewhat longer time period, depending on the log data. This may 
block the processing of subsequent scripts. Blockage of actions within the picture may be 
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avoided if you start the call in a Global Scripting action, such as starting the action through a 
trigger tag.

The process of disconnecting and clearing logs creates a CPU load. This will affect 
performance.

 

 Note

Calling up the "Remove" method is presently only possible at the server. There is an example, 
however, which shows how the method may be started by the client from a server.

 

Syntax

Objects Logging, AlarmLogs
Expression.Remove [TimeFrom] [TimeTo] [TimeOut] [ServerPrefix]

Expression
Required An expression that returns an object of type "Logging" or "AlarmLogs".

Object DataLogs
Expression.Remove [TimeFrom] [TimeTo] [TimeOut] [Type] [ServerPrefix]

Expression
Required An expression that returns an object of type "DataLogs".

Parameters

TimeFrom
Point in time, from which the logs are to be cleared.
When specifying the time information, a short form is also possible. This is described in the 
"Time format" section. 

TimeTo
Time up to which log segments are to be cleared. 
When specifying the time information, a short form is also possible. This is described in the 
"Time Format" section. 

Timeout
Timeout in milliseconds.
If you enter "-1" as a value, the wait will be infinite. If you enter a value of "0", there will be no 
wait.

Type
Type of log.
The parameter can (optionally) be used only to delete log segments of the tag logging.
The following values can be entered:
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Assigned value Type Description
1 hmiDataLogFast Tag Logging Fast data
2 hmiDataLogSlow Tag Logging Slow data
3 hmiDataLogAll Tag Logging Fast and Slow data

ServerPrefix
Reserved for future versions.

Return value
If an error occurred during deletion of the log segments, the method will return an error alarm. 
Additional information may be found under the subject heading "Error alarms from database 
area".

Time format
The format for specifying time information is defined as follows: YYYY-MM-DD hh:mm:ss, 
where YYYY represents the year, MM the month, DD the day, hh the hour, mm the minute 
and ss the second. For example, the time of 2 minutes and one second past 11 o'clock on July 
26, 2004 is displayed as follows: 2004-07-26 11:02:01.

For parameters "TimeFrom" and "TimeTo" the statement of data and time is also possible in 
short form. Not all format fields must be filled in this case. The short form means that the 
information on date and time may be lacking one or several parameters, beginning with the 
value for seconds. For example, the time may be specified in the "YYYY-MM" or "YYYY-MM-
DD hh" format. Using the statement "TimeFrom" = "2004-09" and "TimeTo" = "2004-10-04" all 
log segments between September 2004 up to and including October 4. 

Example
In the following example, log segments within a certain time period that were swapped in 
(again) after the fact are removed and the return value is output as a trace.

 
'VBS182
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Remove("2004-08-22","2004-09-22",-1) & 
vbNewLine

 

In the following example, all log segments that were swapped-in (again) after the fact are 
removed and the return value is output as a trace.

 
'VBS183
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Remove("","",-1) & vbNewLine
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See also
Logging (Page 3927)

DataSet (list) (Page 3919)

DataLogs (list) (Page 3918)

AlarmLogs (list) (Page 3915)

RemoveAll 

Description of TagSet Object
Deletes all tags from a TagSet list.

syntax
Expression.RemoveAll

Expression
Necessary. An expression which returns an object of type "TagSet". 

Parameters
--

Example:
The following example shows how several tags are included in the TagSet list, and how to 
remove all tags again.

 
'VBS176
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
group.RemoveAll

Description of DataSet Object
Deletes all values or object references from a DataSet list.  

syntax
Expression.RemoveAll
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Expression
Necessary. An expression which returns an object of type "DataSet". 

Parameters
--

Example:
The example shows how all objects are removed from the list. 

 
'VBS167
HMIRuntime.DataSet.RemoveAll

See also
DataSet (list) (Page 3919)

Restore

Description of objects Logging, AlarmLogs, DataLogs  
The method adds swapped-out log segments to the Runtime project.

Upon swapping-in, the log segments are copied to the "Common logging" folder of the project. 
Therefore the appropriate storage capacity must be available.

The call may require a somewhat longer time period, depending on the log data. This may 
block the processing of subsequent scripts. Blockage of actions within the picture may be 
avoided if you start the call in a Global Scripting action, such as starting the action through a 
trigger tag.

The connecting/copying of the logs generates a CPU load because the SQL server 
experiences additional load, especially if signature checking is activated. Copying of log 
segments will slow down hard disk access. 

If signature checking is activated, an error message is returned if an unsigned or modified log 
is to be swapped in. There is always only one error alarm returned, even if several errors 
occurred during a swap-in process. Additionally, a WinCC system alarm is generated for each 
log segment. An entry is added to the Windows event viewer in the "Application" section. This 
provides the opportunity to check which log segments are creating the error.
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● With an unsigned log, the return value "0x8004720F" is returned. The event viewer contains 
the entry "Validation of database <db_name> failed! No signature found!". 
The log is swapped in.

● With a changed log, the return value "0x80047207" is returned. The event viewer contains 
the entry "Validation of database <db_name> failed!". 
The log is not swapped in.

 

  Note

Calling up the "Restore" method is presently only possible at the server. There is an 
example, however, which shows how the method may be started by the client from a 
server. 

 

Syntax

Objects Logging, AlarmLogs
Expression.Restore [SourcePath] [TimeFrom] [TimeTo] [TimeOut] 
[ServerPrefix]

Expression
Required An expression that returns an object of type "Logging" or "AlarmLogs".

Object DataLogs
Expression.Restore [SourcePath] [TimeFrom] [TimeTo] [TimeOut] [Type] 
[ServerPrefix]

Expression
Required An expression that returns an object of type "DataLogs".

Parameters

SourcePath
Path to log data.

TimeFrom
Point in time, from which the logs are to be swapped in.
When specifying the time information, a short form is also possible. This is described in the 
"Time format" section. 

TimeTo
Time up to which log segments are to be swapped in. 
When specifying the time information, a short form is also possible. This is described in the 
"Time Format" section. 
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Timeout
Timeout in milliseconds.
If you enter "-1" as a value, the wait will be infinite. If you enter a value of "0", there will be no 
wait.

Type
Type of log.
The parameter can (optionally) be used only to store log segments of the tag logging.
The following values can be entered:

Assigned value Type Description
1 hmiDataLogFast Tag Logging Fast data
2 hmiDataLogSlow Tag Logging Slow data
3 hmiDataLogAll Tag Logging Fast and Slow data

ServerPrefix
Reserved for future versions.

Return value
If an error occurred while swapping in log segments, the method will return an error message. 
Additional information may be found under the subject heading "Error alarms from database 
area".

Time format
The format for specifying time information is defined as follows: YYYY-MM-DD hh:mm:ss, 
where YYYY represents the year, MM the month, DD the day, hh the hour, mm the minute 
and ss the second. For example, the time of 2 minutes and one second past 11 o'clock on July 
26, 2004 is displayed as follows: 2004-07-26 11:02:01.

For parameters "TimeFrom" and "TimeTo" the statement of data and time is also possible in 
short form. Not all format fields must be filled in this case. The short form means that the 
information on date and time may be lacking one or several parameters, beginning with the 
value for seconds. For example, the statement may be in the form of "YYYY-MM" or "YYYY-
MM-DD hh". Using the statement "TimeFrom" = "2004-09" and "TimeTo" = "2004-10-04" all 
log segments between September 2004 up to and including October 4.

Example
In the following example, all log segments since the start of the specified time period are 
swapped in again, and the return value is output as a trace.

 
'VBS184
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Restore("D:\Folder","2004-09-14","",-1) & 
vbNewLine
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In the following example, all Tag Logging Slow log segments in the specified time period are 
swapped in again, and the return value is output as a trace.

 
'VBS185
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.DataLogs.Restore("D:\Folder","2004-09-14 
12:30:05","2004-09-20 18:30",-1,2) & vbNewLine

 

In the following example, all Alarm Logging log segments up to the specified time period are 
swapped in again, and the return value is output as a trace.

 
'VBS186
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.AlarmLogs.Remove("","2004-09-20",-1) & 
vbNewLine

See also
Logging (Page 3927)

DataLogs (list) (Page 3918)

AlarmLogs (list) (Page 3915)

Methods S-Z

SelectAll

Description     
Selects all rows in a table-based control.

Syntax
Expression.SelectAll()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -
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See also
OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)

SelectedStatisticArea

Description     
Executes the "Set statistics range" button function of the table view.

Syntax
Ausdruck.SelectedStatisticArea()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTableControl (Page 4037)

SelectRow

Description     
Selects a specific row in a table-based control.

Syntax
Expression.SelectRow(ByVal IRow As Long, Optional bExtendSelection 
As Boolean)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters

Parameters Description
IRow Number of the row to be selected.
bExtendSelection Indicates as an option whether the current selection will be extended. Is only 

relevant if multiple selections are possible.

Example
● Row 1 is currently selected. If SelectRow( 2, True ) is called, then row 1 and row 2 will be 

selected.

● Row 1 is currently selected. If SelectRow( 2, False ) or SelectRow( 2 ) is called without an 
optional parameter, then only row 2 will be selected.

See also
OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)

ServerExport

Description     
Executes the "Export log" button function of the recipe view.

Syntax
Ausdruck.ServerExport()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 4130)
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ServerImport

Description     
Executes the "Import log" button function of the recipe view.

Syntax
Ausdruck.ServerImport()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 4130)

ShowColumnSelection

Description     
Executes the "Select columns" button function of the table view.

Syntax
Ausdruck.ShowColumnSelection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTableControl (Page 4037)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4838 System Manual, 07/2013,  



ShowComment

Description     
Executes the "Comment dialog" button function of the alarm view.

Syntax
Ausdruck.ShowComment()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
AlarmControl (Page 3947)

ShowDisplayOptionsDialog

Description     
Executes the "Display options dialog" button function of the alarm view.

Syntax
Ausdruck.ShowDisplayOptionsDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4839



ShowEmergencyQuitDialog

Description     
Executes the "Single acknowledgment" button function of the alarm view.

Syntax
Ausdruck.ShowEmergencyQuitDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

ShowHelp

Description    
Executes the "Help" button function of the control.

Syntax
Ausdruck.ShowHelp()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT
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See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

ShowHideList

Description     
Executes the "List of alarm to hide" button function of the alarm view.

Syntax
Ausdruck.ShowHideList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

ShowHitList

Description     
Executes the "Hitlist" button function of the alarm view.

Syntax
Ausdruck.ShowHitList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameter
- -

See also
AlarmControl (Page 3947)

ShowInfoText

Description   
Executes the "About dialog" button function of the alarm view.

Syntax
Ausdruck.ShowInfoText()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

ShowLockDialog

Description     
Executes the "Lock dialog" button function of the alarm view.

Syntax
Ausdruck.ShowLockDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -
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See also
AlarmControl (Page 3947)

ShowLockList

Description     
Executes the "Lock list" button function of the alarm view.

Syntax
Ausdruck.ShowLockList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

ShowLongTermArchiveList

Description     
Executes the "Historical alarm list (long-term)" button function of the alarm view.

Syntax
Ausdruck.ShowLongTermArchiveList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)
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ShowMessageList

Description   
Executes the "Alarm list" button function of the alarm view.

Syntax
Ausdruck.ShowMessageList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

ShowPercentageAxis

Description     
Executes the "Relative axis" button function of the f(t) trend view.

Syntax
Ausdruck.ShowPercentageAxis()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTrendControl (Page 4045)
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ShowPropertyDialog

Description    
Executes the "Configuration dialog" button function of the control.

Syntax
Ausdruck.ShowPropertyDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

FunctionTrendControl (Page 4004)

AlarmControl (Page 3947)

ShowSelectArchive

Description     
Executes the "Select data connection" button function of the recipe view.

Syntax
Ausdruck.ShowSelectArchive()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -
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See also
UserArchiveControl (Page 4130)

ShowSelection

Description     
Executes the "Selection dialog" button function of the recipe view.

Syntax
Ausdruck.ShowSelection ()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 4130)

ShowSelectionDialog

Description     
Executes the "Selection dialog" button function of the alarm view.

Syntax
Ausdruck.ShowSelectionDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)
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ShowSelectTimeBase

Description     
Executes the "Timebase dialog" button function of the recipe view.

Syntax
Ausdruck.ShowSelectTimeBase()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 4130)

ShowShortTermArchiveList

Description     
Executes the "Historical alarm list (short-term)" button function of the alarm view.

Syntax
Ausdruck.ShowShortTermArchiveList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)
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ShowSort

Description     
Executes the "Sorting dialog" button function of the recipe view.

Syntax
Ausdruck.ShowSort()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 4130)

ShowSortDialog

Description     
Executes the "Sorting dialog" button function of the alarm view.

Syntax
Ausdruck.ShowSortDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)
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ShowTagSelection

Description    
Executes the "Select data connection" button function of the control.

Syntax
Ausdruck.ShowTagSelection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

FunctionTrendControl (Page 4004)

ShowTimebaseDialog

Description     
Executes the "Timebase dialog" button function of the alarm view.

Syntax
Ausdruck.ShowTimebaseDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)
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ShowTimeSelection

Description    
Executes the "Select time range" button function of the control.

Syntax
Ausdruck.ShowTimeSelection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

FunctionTrendControl (Page 4004)

ShowTrendSelection

Description     
Executes the "Select trends" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.ShowTrendSelection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
-- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

FunctionTrendControl (Page 4004)
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StartStopUpdate

Description    
Executes the "Start" or "Stop" button function of the control.

Syntax
Ausdruck.StartStopUpdate()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

OnlineTableControl (Page 4037)

FunctionTrendControl (Page 4004)

Stop

Description
Closes WinCC Runtime. 

Syntax
Expression.Stop

Expression
Required An expression which returns an "HMIRuntime" type object.

Parameters
--

See also
HMIRuntime  (Page 3922)
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Trace

Description
Returns a user-defined text through the operating system channel for debug alarms.   

The methods HMIRuntime.Trace works only in a PC-based environment. The text transferred 
as parameter can be displayed using the diagnostics tools "GSC Diagnostics" or "ApDiag". 
You can use the "ShowSystemAlarm" system function if you need to run a trace without using 
external tools.

Syntax
Expression.Trace"STRING"

Expression
Required An expression which returns an "HMIRuntime" type object.

Parameters

STRING
The text which is issued as a debug alarm. The transferred text can be displayed using the 
diagnostics tools "GSC Diagnostics" or "ApDiag". You can use the "ShowSystemAlarm" 
system function if you need to run a trace without using external tools.

Example
In the following example a debug alarm is issued:

'VBS example trace
HMIRuntime.Trace "Customized error message"

See also
HMIRuntime  (Page 3922)

UnhideAlarm

Description     
Executes the "Unhide alarm" button function of the alarm view.

Syntax
Ausdruck.UnhideAlarm()
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Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

UnlockAlarm

Description     
Executes the "Unlock alarm" button function of the alarm view.

Syntax
Ausdruck.UnlockAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 3947)

UnselectAll

Description     
Removes all selections from the cells of a table-based control.

Syntax
Expression.UnselectAll()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters
- -

See also
OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)

UnselectRow

Description     
Removes the selections from a specific cell of a table-based control.

Syntax
Expression.UnselectRow(ByVal IRow As Long)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
Long

Parameters Description
IRow Number of the row to be selected.

See also
OnlineTableControl (Page 4037)

TrendRulerControl (Page 4110)

UserArchiveControl (Page 4130)

AlarmControl (Page 3947)
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Write

Description of Tag Object  
Writes a value to a tag. The "LastError" property can be used to determine whether the call 
was successful.

If the value of the tag is set successfully, the properties of the tag object are assigned the 
following values:

Property Allocation
Value Tag values set by the user (unchanged)
Name Tag name (unchanged)
QualityCode Bad Out of Service
Timestamp 0
LastError 0
ErrorDescription " "

If the value of the tag is not set successfully, the properties of the tag object are assigned the 
following values:

Property Allocation
Value Tag values set by the user (unchanged)
Name Tag name (unchanged)
QualityCode Bad Out of Service
Timestamp 0
LastError Write operation error codes
ErrorDescription Error description on LastError

syntax
Expression.Write [Value],[Writemode]

Expression
Necessary. An expression which returns a tag object.  

Parameters
The value to be written can be transferred directly to the method as a parameter. If the 
parameter is not specified, the value in the "Value" property is used. The "Writemode" option 
parameter can be used to select whether the tag value should be written synchronously or 
asynchronously. If the "Writemode" parameter is not used, writing is performed asynchronously 
as its default value.

During the writing process, no information is supplied on the status of the tags.

The "Value" property contains the value which was set before or during the writing operation, 
therefore is may not correspond to the real current value of the tag. If the data on the tag should 
be updated, use the Read method.
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Parameters Description
Value (optional) The tag value is specified. The specified value 

overwrites the value in the "Value" property in the 
tag object.
The tag value is not specified. The tag receives the 
current value from the "Value" property of the tag 
object.

Writemode (optional) 0 or empty: The tag value is written 
asynchronously. 0 is the default value.
1: The tag value is written synchronously.

On asynchronous writing, it is written immediately into the tag image. The user does not receive 
any feedback if the value has been written in the programmable controller, too.

In the case of synchronous writing (direct to the PLC), the writing operation actually occurs 
when the PLC is ready to operate. The use receives a check-back message if the writing 
operation was not successful.

Example
Asynchronous writing

 
'VBS104
Dim objTag
Set objTag = HMIRuntime.Tags("Var1")
objTag.Value = 5
objTag.Write
MsgBox objTag.Value

 

or

 
'VBS105
Dim objTag
Set objTag = HMIRuntime.Tags("Var1")
objTag.Write 5
MsgBox objTag.Value

 

Synchronous writing

 
'VBS106
Dim objTag
Set objTag = HMIRuntime.Tags("Var1")
objTag.Value = 5
objTag.Write ,1
MsgBox objTag.Value

Visualizing processes (Comfort/Advanced)
10.8 Working with system functions and Runtime scripting

WinCC Comfort/Advanced V12.0 SP1
4856 System Manual, 07/2013,  



 

or

 
'VBS107
Dim objTag
Set objTag = HMIRuntime.Tags("Var1")
objTag.Write 5, 1
MsgBox objTag.Value

Description of TagSet Object
The TagSet object offers the option of writing several tags in one call. 

Functionality here is mostly identical with that of a tag object. In the following, only deviations 
thereof are described. 

Expression
Necessary. An expression which returns an object of type "TagSet". 

Parameters
In order to write different values, the "Value" property of individual tag objects must be set, and 
write must be called thereafter without the "Value" parameter. Since the write commands are 
grouped into one call, it results in improved performance compared to single calls. 

In a TagSet object, it is not possible to pass on a value using the "Write" method. Individual 
values must be set using the "Value" property of the individual tag objects.

Example
The following example shows how tags are included in the TagSet list, how tag values are set 
and subsequently written.

 
'VBS173
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Wert1"
group.Add "Wert2"
group("Wert1").Value = 3
group("Wert2").Value = 9
group.Write

 

If you set the optional parameter "Writemode" equal to 1, the process tags are written 
synchronously (directly to AS).
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group.Write 1

WriteTags

Description     
Executes the "Write tags" button function of the recipe view.

Syntax
Expression.WriteTags()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 4130)

ZoomArea

Description     
Executes the "Zoom area" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.ZoomArea()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)
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ZoomInOut

Description     
Executes the "Zoom +/-" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.ZoomInOut()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)

ZoomInOutTime

Description     
Executes the "Zoom time axis +/-" button function of the f(t) trend view.

Syntax
Ausdruck.ZoomInOutTime()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTrendControl (Page 4045)
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ZoomInOutValues

Description     
Executes the "Zoom value axis +/-" button function of the f(t) trend view.

Syntax
Ausdruck.ZoomInOutValues()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTrendControl (Page 4045)

ZoomInOutX

Description     
Executes the "Zoom X axis +/-" button function of the f(x) trend view.

Syntax
Ausdruck.ZoomInOutX()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
FunctionTrendControl (Page 4004)
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ZoomInOutY

Description     
Executes the "Zoom Y axis +/-" button function of the f(x) trend view.

Syntax
Ausdruck.ZoomInOutY()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
FunctionTrendControl (Page 4004)

ZoomMove

Description   
Executes the "Move trend area" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.ZoomMove()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 4045)

FunctionTrendControl (Page 4004)
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10.9 Mobile Wireless

10.9.1 Field of application of the Mobile Panel Wireless

Introduction
The Mobile Panel Wireless enables you to move through the plant without restrictions and with 
or without security technology. You can operate and monitor moving machine parts or the 
entire plant depending on the situation. You can plan, configure, simulate and extend wireless 
networks quickly and reliably.

The Mobile Panels Wireless are based on standardized WLAN technology and are specially 
tailored to the requirements of automation.

WLAN area
A WLAN area is the area of the plant in which the HMI device communicates with the PLC 
over a wireless local area network. The wireless coverage of the network has a sufficient signal 
strength in this area.  

The WLAN of a plant is formed by the radio area of one or more Access Points. 

Access Point
The Access Point serves as a gateway between the wireless and hard-wired network. The 
HMI device communicates with an Access Point via WLAN. You can operate the different 
machines or plants without annoying cables. The HMI device is connected to a network in 
which it communicates with a PLC via the access point.  

Effective range
Safety-related operator input is only possible in a limited part of a WLAN area upstream of a 
machine or plant known as the effective range. One exception to this rule is the emergency 
stop, which works in the entire WLAN area.  

The configured effective ranges are stored in the HMI device. The HMI device can only log on 
to a machine within the effective range. This also requires there no other HMI device is logged 
on in the same effective range.

To ensure clear logon and machine operator inputs, one effective range must not overlap 
another effective range.

Tags
Effective ranges are formed by the spatial assignment of tags to a machine or plant. Tags 
create a geometrical space which is relevant for logon to a machine. After logon you operate 
the machine using acknowledgement buttons. 

A distinction is made between two types of tags:   
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● Transponder

● RFID tag

Transponder
After successful logon to a machine, the spanned geometrical area will be monitored. The 
distance between the HMI device and the transponder can only be measured if the two devices 
are in the reception range of each other. When you leave the effective range, safety-related 
operator input of the machine with acknowledgment buttons is prevented.  

Zones in the transponder system
Zones are configurable objects within a transponder system. A zone is defined by the maximum 
distance from one or more transponders. In a hard-wired Mobile Panel, the length of the 
connection cable defines a zone around a connection box.  

Zones are operating areas in which safety-related operator input is not possible. To enter a 
zone, you have to configure a screen change to the correct process picture. 

RFID tag
After successful logon to a machine, the spanned geometrical area is not monitored. Monitoring 
therefore calls for an additional organizational measure, for example: a light barrier or a 
protective fence. The protection area is separated from the plant by a security system. The 
protection area is the area in the plant in which you operate one or more machines in fail-safe 
operation. One or more RFID Tags are distributed within protection zones. The protection area 
is not a configurable object. 

10.9.2 How does the transponder system work?

Overview
To give a basic understanding of all this, the following section describes the interaction 
between:       

● HMI device

● Zone

● Effective range

● Transponder
 

 Note

You should always assign administrator rights or set up encryption to protect the project 
containing a Mobile Panel Wireless for fail-safe operation against unauthorized access.
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Principle of operation in the transponder system
 

1 Access Point
2 WLAN of the Access Point
3 PLC
4 Plant
5 Effective range "Robot 1" with a transponder
6 Effective range "Robot 2" with two transponders
7 Zone "Zone 1" with a transponder
8 Radio area of the HMI device
9 HMI device

 

Example: 
● A screen change is configured for "Zone 1".

● Transponder1 is assigned to the "Robot 2" effective range.

● The operator enters the radio cone of the transponder to receive the transponder ID.
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● To log onto the machine "Robot 2", the operator presses the object "Effective range - Name".

● The "Effective range - Logon" dialog box opens. The operator enters the effective range ID 
and confirms with "OK". The dialog is closed.

● If the logon was successful, then the acknowledgement buttons will be active.

● The HMI device measures the distance from the transponder which is less than the 
configured distance of the effective range.

Result:
The operator is logged onto the machine "Robot 2". The operating element "Effective range - 
Name" is green and shows the name of the effective range "Robot 2".

If the HMI device is logged onto the effective range, then the following will apply:

● The operator may not leave the effective range without logging off. If the operator leaves 
the effective range without logging off for more than 30 seconds, a local rampdown will 
occur.

● No other HMI device can log onto the machine.

To log off from the machine, the operator presses the operating element "Effective range - 
Name". A logoff dialog is displayed. The operator confirms the dialog. 

After successful logoff, another operator can log on to the machine "Robot2". 

When the operator enters "Zone 1", a screen change will take place. 

10.9.3 How does the RFID system work?

Overview
RFID stands for radio frequency identification. RFID allows wireless identification of objects 
without contact or visual sighting.  

For a basic understanding, the following section describes the interaction between:

● HMI device

● Effective range (RFID)

● RFID tag
 

  Note
RFID Tags in the plant area

You may only affix RFID Tags in restricted plant areas that are protected by additional 
protective measures, for example, protective railings. 
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Principle of operation in the RFID system

① Access Point
② WLAN of the Access Point
③ PLC
④ RFID tag with effective range (RFID) for logon to "Robot 1"
⑤ RFID tag with effective range (RFID) for logon to "Robot 2"
⑥ Plant
⑦ Protective area limit of the machine "Robot1"
⑧ Protective area limit of the machine "Robot2"
⑨ Radio area of the HMI device
⑩ HMI device

 

Example: 
● "RFID Tag1" is assigned to the effective range (RFID) "Robot1".

● An operator enters the restricted plant area. The operator manually switches to the screen 
with the configured operating element "Effective range - Name (RFID)".
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● At "RFID Tag1", he presses the "Scan" button.
During the logon operation, the button is yellow and displays the text "Scanning…".

● The "Effective range - Logon" dialog box opens. The operator enters the effective range 
(RFID) ID and confirms it with "OK". The dialog is closed.

● The "Confirmation of logon" dialog box opens. The operator confirms logon with the 
acknowledgment button.

● If logon was successful, the acknowledgement buttons are active.

Result:
The operator is logged on to the machine "Robot 1" and operates the machine within the 
protection area in fail-safe operation. The operating element "Effective range - Name (RFID)" 
is green and shows the name of the effective range (RFID) "Robot1".

If the HMI device is logged on to the machine, the following applies:

● The user may not leave the protection area without logging off from the machine. If the 
operator leaves the protection area without logging off, a local rampdown occurs.

● No other HMI device can log on to this machine.

To log off from the machine, the operator presses the operating element "Effective range - 
Name (RFID)". A logoff dialog is displayed. The operator confirms the dialog. 

After successful logoff, another operator can log on to the machine "Robot 1". 

10.9.4 Configuring the Mobile Panel V2 for fail-safe operation

10.9.4.1 Configuration overview

Introduction
Additional steps in the TIA Portal are necessary before the configuration of the Mobile Panels 
V2 for fail-safe operation. This affects the following HMI devices:

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277F IWLAN (RFID Tag)

Procedures overview
1. Creating PLC for fail-safe operation

2. Installing a general station description (GSD)

3. Creating a module from the GSD file

4. Creating a connection between a module from the GSD file and the PLC

5. Creating Mobile Panel V2 for fail-safe operation
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See also
Creating Mobile Panel (Page 4875)

Creating a module from the GSD file (Page 4871)

Installing a general station description (GSD) (Page 4871)

Creating PLC for fail-safe operation (Page 4870)

Creating a connection between a module and the PLC (Page 4874)

10.9.4.2 Creating PLC for fail-safe operation

Requirement
A project is open

Procedure
1. Click "Add new device" in the project navigation.

2. Click "PLC" in the "Add new device" dialog.

3. Select a PLC for fail-safe operation, for example, CPU-315F-2PN/DP. The "Devices & 
Networks" editor opens.

4. Open the device view.

5. Select the device and click on "Device overview".

6. Select the device.

7. Click "Properties > PROFINET interface [X2] >Ethernet addresses > Interface connected 
with > Add new subnet" in the inspector window.

8. Enter the IP address under "IP protocol > Set IP address in the project".

9. Enter a time for "Properties > PROFINET interface [X2] > F parameter > Set default F 
monitoring time for F I/O of this interface".

10.Specify the properties for fail-safe operation in "Properties > Fail-safe"

– "F-capability activated"

– "Basis for PROFIsafe addresses"

11.Specify further properties for fail-safe operation as usual, for example, protection level.

Result
You have created a PLC in the project and made the settings for fail-safe operation.

See also
Configuration overview (Page 4867)
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10.9.4.3 Installing a general station description (GSD)

Introduction
A GSD file (device master data file) contains all the IO device properties. The language used 
to describe the GSD files is GSDML (Generic Station Description Markup Language). Install 
a GSD file to expand the hardware catalog.

Requirement
● The "Devices & Networks" editor is open.

● The "Network view" is open.

● The GSD file is available on your PC.

The GSD file can be found online:

GSD file of Mobile Panel V2 for fail-safe operation (http://support.automation.siemens.com/
WW/view/de/19241467) 

Procedure
1. Click "Options > Install general station description (GSD)".

2. In the "Install general station description" dialog, choose the directory in which the GSD 
files are located.

3. Select the GSD file from the list.

4. Click the "Install" button.

5. To create a log file for the installation, click on the "Save log file" button.

Result
You have installed the GSD file. You can find the new devices installed by means of the GSD 
files in the hardware catalog under "Additional field devices > PROFINET". Any problems that 
occur during the installation can be traced using the log file.

See also
Configuration overview (Page 4867)

10.9.4.4 Creating a module from the GSD file

Requirements
● A PLC for fail-safe operation is created in the project e.g. CPU-315F-2PN/DP.

● The GSD file is installed.

● The "Network view" is opened in the "Devices & Networks" editor.

Visualizing processes (Comfort/Advanced)
10.9 Mobile Wireless

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4869

http://support.automation.siemens.com/WW/view/de/19241467
http://support.automation.siemens.com/WW/view/de/19241467


Procedure
1. Open the hardware catalog.

2. Open the directory "Additional field devices > PROFINET-IO > HMI > Siemens AG > 
SIMATIC HMI > 277".

3. Now open the folder of the Mobile Panel V2 for fail-safe operation whose device type you 
also have as hardware:

– Mobile Panel 277F IWLAN V2 or

– Mobile Panel 277F IWLAN V2 (RFID tag)

4. For Mobile Panel 277F IWLAN V2, select the module with the order number
6AV6645-0EC01-0AX1.
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5. For Mobile Panel 277F IWLAN V2 (RFID tag), select the module with the order number
6AV6645-0EF01-0AX1.

 

  Note

The order number of the module in the GSD file has to match the order number of the 
Mobile Panel V2 in the software.

 

Figure 10-2 Left: Mobile Panel in the software. Right: Module in the GSD file

6. Drag-and-drop the desired module into the network view.
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Result
You have created a module from the GSD file in your project.

See also
PROFIsafe address (Page 4891)

Configuration overview (Page 4867)

10.9.4.5 Creating a connection between a module and the PLC

Requirements
● A PLC for fail-safe operation is created in the project e.g. CPU-315F-2PN/DP.

● The GSD file is installed.

● A module from the GSD file has been created.

● The "Devices & Networks" editor is open.

Procedure
1. Open the "Network view".

2. Select the module and right-click on "Not assigned". The shortcut menu is opened.

3. Select "Assign new IO controller". A dialog box opens.

4. Select the IO controller and confirm with OK. A connection is established.

5. Open the device view

6. Click on "Mobile277Failsafe_IO_1" in the device overview.

7. Specify the properties for fail-safe operation in the inspector window under "Properties > 
PROFIsafe":

– "F-block ID"

– "F-Source-Add"

– "F-Dest-Add"

8. Click on the module in the device view.

9. Assign a name under "Properties > General > Name" in the inspector window.

10.Assign an IP address under "PROFINET interface [X1] > Ethernet addresses > IP protocol 
> Set IP address in the project".

Result
The module from the GSD file is connected to the PLC. The module adopts the settings made 
in the PLC for PROFIsafe and PROFINET.
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See also
Configuration overview (Page 4867)

10.9.4.6 Creating Mobile Panel

Requirement
● The inspector window is open.

● A PLC for fail-safe operation is created in the project, for example,  CPU-315F-2PN/DP.

● The GSD device is created in the project.

Inserting Mobile Panel into the project.
1. Click "Add new device" in the project navigation.

2. Click on "HMI" in the "Add new device" dialog.

3. Select a Mobile Panel V2 for fail-safe operation, for example, Mobile Panel 277F IWLAN V2. 
The device is inserted into the project.

 

  Note

Select the corresponding Mobile Panel for the module already installed from the GSD file.
 

Defining properties
1. Open the "Devices and Networks" editor.

2. Open the "Device view".

3. Select the Mobile Panel in the work area.

4. Open "Properties > General" in the inspector window.

5. To facilitate assignment in the project, enter the name of the associated module under 
"Name"

6. Enter the same IP address as in the module under "Set IP address in the project".

7. Activate "Set IP address using a different method".

Result
Entering the same IP address as in the device enables error-free communication. Alternatively, 
you can set the IP address on the Mobile Panel after loading the project.

See also
Configuration overview (Page 4867)
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10.9.5 Basics

10.9.5.1 Zones

Introduction
The following section applies only to the Mobile Panels Wireless, e.g. Mobile Panel 277 IWLAN 
V2 and Mobile Panel 277F IWLAN V2. The "Zones" work area is only visible for these HMI 
devices.   

 

 Note

For more information refer to the operating instructions for the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Depending on the HMI device selected, open the work area in the project window by double-
clicking on "Zones" or "Zones and effective ranges". 

Work area
The "Zones" work area displays the zones that have been set up and the transponders 
assigned to them.

Inspector window
When a zone is selected, you can edit the names, display names and the limits of the zone 
under the "General" category. The zone has the "On entry" and "On exit" zones. Assign the 
"ActivateScreen" system function to the events.

10.9.5.2 Zones working area

Introduction
The "Zones" work area displays the zones and the transponders assigned to them in table 
format. You create a list of transponders and assign certain transponders to a zone. The limit 
of the zone is defined by the maximum distance from the transponders.     
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Principle
The work area consists of the "Zones" and "Transponders" tables.

If you select a zone in the "Zones" table, the "Transponder" table displays the following:

● Transponder enabled: The transponder is assigned to the selected zone.

● Transponder deactivated: The transponder is not yet assigned to any zone.

● Transponder not available: The transponder has already been assigned to another zone. 
To undo the assignment, switch to the relevant zone and deactivate the transponder.

The zone and transponder IDs are initially assigned automatically. They can be changed, 
however. 

Please note the following:

● A maximum of 254 zones may be configured.

● The zone ID must be unique and fall within the range from 1 - 254.

● You can initially configure transponders without assigning them to a zone.

● There may be no more than 255 transponders assigned to a zone.

● The transponder ID must be unique and fall within the range from 1 - 65534.

The transponder IDs are set on the transponder.

 

10.9.5.3 Effective ranges

Introduction
The following section applies only to the Mobile Panels Wireless that support fail-safe 
operation, e.g. Mobile Panel 277F IWLAN V2. The "Effective ranges" work area is only visible 
for these HMI devices.   

Visualizing processes (Comfort/Advanced)
10.9 Mobile Wireless

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4875



You set up effective ranges in order to control safety related operations. An effective range is 
defined by the maximum distance from one or more transponders.

 

 Note

For more information refer to the operating instructions for the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Open the work area in the project window by double-clicking on "Zones & effective ranges". 
Click the "Effective ranges" tab.

Work area
The "Effective ranges" work area displays the effective ranges that have been set up and the 
transponders assigned to them. 

Inspector window
When an effective range is selected, you can edit the names, display names and the limits of 
the effective range under the "General" category. 

When you select a transponder, you can see both the effective range and the zone that are 
assigned to that transponder. You can only assign a transponder to one effective range so 
that the effective ranges do not overlap.

10.9.5.4 Effective ranges working area

Introduction
The "Effective ranges" work area displays the effective ranges and their transponders in table 
format. You create a list of transponders and assign certain transponders to an effective range. 
The limit of the effective range is defined by the maximum distance from the transponders.           
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Principle
The work area consists of the "Effective ranges" and "Transponders" tables.

The HMI device calculates a checksum from the local data so that the configured effective 
ranges and transponders reliably match those locally on the machine. The project cannot be 
started on the HMI device unless the local checksum agrees with the checksum stored in the 
"Effective ranges" editor.

When you select an effective range from the "Effective ranges" table, the "Transponder" table 
displays the following:

● Transponder enabled: The transponder is assigned to the selected effective range.

● Transponder deactivated: The transponder is not yet assigned to any effective range.

● Transponder not available: The transponder has already been assigned to another effective 
range. To undo the assignment, switch to the relevant effective range and deactivate the 
transponder.

● The zone assigned to the transponder is displayed in addition to the effective range.

The effective range and transponder IDs are initially assigned automatically. They can be 
changed, however. 

Please note the following:

● A maximum of 127 effective ranges may be configured.

● The effective range ID must be unique and fall within the range from 1 - 127.

● The display name of an effective range must not be the same as its ID.

● You can initially configure transponders without assigning them to an effective range.

● There may be no more than 127 transponders assigned to an effective range.

● The transponder ID must be unique and fall within the range from 1 - 65534.

The transponder IDs are set on the transponder.
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Effective range in Runtime
To log on to the effective range in Runtime, only the display name of the effective range appears 
to the operator in the Runtime language. The operator reads the effective range ID in the plant 
and enters it on the HMI device. This ensures that the right machine operated. The 
acknowledgment buttons are activated after successful logon.         

10.9.5.5 Effective ranges (RFID)

Introduction
The following section only applies to the Mobile Panel 277F IWLAN (RFID tag) which supports 
fail-safe operation with RFID. The "Effective ranges (RFID)" work area is only visible with these 
HMI devices.    

To monitor safety-related operator inputs, you set up effective ranges (RFID). 
 

 Note

For more information, refer to the operating instructions of the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Open the work area in the project window by double-clicking on "Effective ranges (RFID)". 

Work area
The "Effective ranges (RFID)" work area displays the effective ranges that have been set up 
and the RFID Tags assigned to them. 

Inspector window
When an effective range (RFID) is selected, you can edit the name, display name and ID of 
the effective range under the "General" category. 

10.9.5.6 Work area for effective ranges (RFID)

Introduction
The "Effective ranges (RFID)" work area displays the effective ranges (RFID) and their 
RFID Tags in table format. You create a list of RFID Tags and assign specific RFID Tags to 
an effective range.       
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Principle
The work area consists of the "Effective ranges (RFID)" and "RFID Tags" tables.

The HMI device calculates a checksum from the local data so that the configured effective 
ranges (RFID) and RFID Tags reliably match those locally on the machine. The project cannot 
be started on the HMI device unless the local checksum agrees with the checksum stored in 
the "Effective ranges (RFID)" editor. 

When you select an effective range (RFID) in the "Effective ranges (RFID)" table, the 
"RFID Tags" table displays the following:

● RFID Tag enabled: The RFID Tag is assigned to the selected effective range (RFID).

● RFID Tag disabled: The RFID Tag is not yet assigned to any effective range (RFID).

● RFID Tag not available: The RFID Tag has already been assigned to another effective 
range (RFID). To undo the assignment, switch to the relevant effective range (RFID) and 
deactivate the RFID Tag.

The IDs of the effective ranges (RFID) and RFID Tags are initially assigned automatically. 
They can be changed, however. 

Please note the following:

● A maximum of 127 effective ranges (RFID) may be configured.

● The effective range (RFID) ID must be unique and fall within the range from 1 - 127.

● The display name of an effective range (RFID) must not be the same as its ID.

● You can initially configure RFID Tags without assigning them to an effective range (RFID).

● A maximum of 127 RFID Tags is available to assign to an effective range  (RFID).

● The RFID Tag ID must be unique and fall within the range 1-65534.

The RFID Tag ID is written to the RFID Tag by the HMI device.
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Effective range in Runtime
To log on to the effective range (RFID) in Runtime, only the display name of the effective range 
(RFID) is displayed to the operator in the Runtime language. The operator reads the effective 
range (RFID) ID in the plant and enters it on the HMI device. This ensures that the right machine 
operated. The acknowledgment buttons are activated after successful logon.     

10.9.6 Working with zones

10.9.6.1 Configuring a zone

Validity
The next section applies to all Mobile Panels Wireless, e.g. Mobile Panel 277 IWLAN.  

Introduction
You will have to set up a zone in order to carry out plant-specific operator control and monitoring 
tasks.

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Zones" work area is open.

Procedure
1. Double-click "Add..." in the "Zones" table.

2. Enter the "MixingPlant" zone in the "Name" field.

3. Enter "MixingSystem" as the "Display name" for the zone at runtime. Enter zone "1" in the 
"ID" field.

4. Enter "8" meters as the zone "Limit".

5. Double-click "Add..." in the "Transponders" table.

6. Enter "Transponder 1" as the "Name" of the transponder.

7. Enter transponder "1" in the "ID" field.
Then set transponder IDs on the transponder.

8. Enable the assignment of "Transponder 1".
"Transponder 1" is assigned to the "MixingPlant" zone.

9. Repeat steps 6 to -9 accordingly for "Transponder 2".
"Transponder 2" is assigned to the "MixingPlant" zone.
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Result
The "MixingPlant" zone is configured as two conical areas arranged at a distance of 8 meters, 
regardless of the effective ranges: one area around "Transponder 1" and one around 
"Transponder 2".

The display name designates the zone in the set editing language. An overview of the display 
names can be found in the "Project texts" editor.

 

10.9.6.2 Displaying the screen on entering a zone

Introduction
Configure a screen change when entering and leaving the zone.   

Requirements
● A Mobile Panel which supports zones has been created, for example, Mobile 

Panel 277 IWLAN.

● The "MixingPlant" zone is configured.

● The "Plant_1" screen has been created and opened.

● The "MixingPlant_1" screen has been created and opened.

● The "Zones" work area is open.

Procedure
1. Select the "MixingPlant" zone from the "Zones" table.

2. Click "Properties> Events" in the Inspector window.

3. Click the event "On entry".
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4. Select the "ActivateScreen" system function in the "function list".

5. Select "MixingPlant_1" as the "Screen name".

6. Click the event "On exit".

7. Select the "ActivateScreen" system function in the function list.

8. Select "Plant_1" as the "Screen name".

Result
The "MixingPlant_1" screen is displayed on the HMI device when you enter the "MixingPlant" 
zone. When you exit the zone, the "Plant_1" screen appears once more.

10.9.6.3 Displaying an object in relation to the zone

Validity
The following example is independent of the WLAN and applies to all Mobile Panels. 

Introduction
You configure an I/O field that is only visible within a specific zone.   

Requirements
● A Mobile Panel which supports zones has been created, for example, Mobile 

Panel 277 IWLAN.

● The "Zone_id" variable of the "Int" data type has been created.

● A "Plant_1_Overview" screen has been created.

Procedure
1. Open the "Runtime Settings > General" editor.

2. Select the "Zone_id" tag as the "ID Zone/ Effective range".

3. Open the screen "Plant_1_Overview".

4. Drag and drop the "I/O box" object from the toolbox into the screen.

5. Click "Properties > Animations" in the Inspector window.

6. Click "Layout > Visibility."

7. Select "Zone_id" as the "tag".

8. Select "from" 1 "to" 1 as the "Range".

9. Enable "Visible".
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Result
The IO field is only visible at runtime under the following conditions:

● The hard-wired Mobile Panel is connected to a connection box with ID = 1.

● The Mobile Panel Wireless is located in a zone with ID = 1, for example, the "MixingPlant" 
zone.

 

10.9.7 Working with effective ranges

10.9.7.1 Overview

Introduction
The following configuration guide describes the steps needed to set up an effective range for 
fail-safe operation on a Mobile Panel Wireless.

Procedures overview
1. Configuring the effective range:

You configure the "MixingAxisControl" effective range as a conical area around 
"Transponder1 " at a distance of 5 meters.

2. Configuring the name of the effective range:
To ensure logon to the effective range, configure the object "Effective range - Name".

3. Configuring additional effective range objects:
Configure additional objects for displaying the position and signal strength within an 
effective range.

4. Set parameters for loading:

– PROFIsafe communication

– WLAN network

– Power management

– Interface

5. Configure the data channel

6. Configure network operation

7. Set the transponder

8. Commissioning effective ranges

9. Switching on and Testing the HMI device

10.Start loading manually

11.Acknowledging the effective range at the plant:
You acknowledge the effective ranges and their transponders.
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12.Determine the checksum

13.Load the project once again with checksum:
Enter the checksum you have determined in the project and load the project once again.

14.Test effective range
 

  Note

For detailed information on items 5 to 14, refer to the operating instructions of the HMI 
device.

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/
WW/view/en/26268960)

 

 

10.9.7.2 Configure effective range

Introduction
You set up an effective range in order to control safety related operator input upstream of a 
machine or plant.  

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Effective ranges" work area is open.

Procedure
1. Double-click "Add..." in the "Effective Ranges" table.

2. Enter "MixingAxisControl" as the "Name" of the effective range.

3. Enter "Mixing_axis_PLC" as the "Display name" for the effective range at runtime.

4. Enter effective range "1" in the "ID" field.
Make sure that the effective range ID matches the ID on the machine.

5. Enter "5" meters as the "Limit" of the effective range.

6. Double-click "Add..." in the "Transponders" table.

7. Enter "Transponder 1" as the "Name" of the transponder.

8. Enter transponder "1" in the "ID" field.
Then set transponder IDs on the transponder.

9. Enable the assignment of "Transponder 1".
"Transponder 1" is assigned to the "MixingAxisControl" effective range.
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Result
You configure the "MixingAxisControl" effective range as a conical area around "Transponder 
1" at a distance of 5 meters, regardless of the zones.

The display name designates the effective range in the set editing language. An overview of 
the display names can be found in the "Project texts" editor.

10.9.7.3 Configuring the effective range name

Introduction
Configure at least the "Effective range - Name" object so that an operator can log on and off 
a machine using an effective range. If you do not configure an effective range object for a 
Mobile Panel Wireless for fail-safe operation, a warning appears during generation.     

Requirements
A screen has been created and opened.

Procedure
1. Select the "Effective range - Name" object from the "Advanced objects" category in the 

toolbox.

2. Drag and drop the "Effective range - Name" object from the toolbox into the screen.

Result
If the operator clicks an object during runtime, he initiates logon or logoff of the HMI device to 
a machine that is assigned to an effective range.
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See also
Effective range name (Page 3152)

10.9.7.4 Configuring additional Mobile Wireless objects

Introduction
You will need to configure other objects in order to display further information about the 
effective range during testing, for example.   

Requirements
A screen has been created and opened.

Procedure
1. Select the "Effective range - Signal" object from the "Elements" category in the toolbox.

2. Drag and drop the "Effective range - Signal" object from the toolbox into the screen.

3. Repeat steps 1 and 2 with the "WLAN - Reception" object.

Result
The "Effective range - Signal" object indicates how accurately the Mobile Panel Wireless is 
within an effective range. The "WLAN - Reception Quality" object displays the signal strength 
of the WLAN wireless connection.

See also
Effective range signal (Page 3156)

WLAN reception (Page 3157)

10.9.8 Working with effective ranges (RFID)

10.9.8.1 Overview

Validity
The next section applies only to Mobile Panels Wireless with RFID, for example, 
Mobile Panel 277F IWLAN (RFID Tag).  
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Introduction
The following configuration guide describes the steps required to set up an effective range 
(RFID) for fail-safe operation on a Mobile Panel Wireless with RFID.

Procedures overview
1. Configure effective range (RFID):

You configure the effective range (RFID) "MixingAxisControl".

2. Configuring the name of the effective range (RFID):
To ensure logon to the effective range, configure the object "Effective range - Name (RFID)".

3. Set parameters for loading

4. Configure the data channel

5. Configure network operation

6. Install RFID Tag in the plant

7. Turn on the HMI device and enable loading mode

8. Loading a project

9. Write the suitable IDs to the RFID Tags in the plant

10.Determine the checksum

11.Load the project once again with checksum:
Enter the checksum you have determined in the project and load the project once again.

12.Test effective range (RFID)
 

  Note

For detailed information on items 4 to 12, refer to the operating instructions of the HMI 
device.

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/
WW/view/en/26268960)

 

10.9.8.2 Configuring effective range (RFID)

Introduction
You set up an effective range (RFID) to control safety-related operator input upstream of a 
machine or plant.  

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Effective ranges (RFID)" work area is open.
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Procedure
1. Double-click "Add..." in the "Effective Ranges (RFID)" table.

2. Enter "MixingAxisControl" as the "Name" of the effective range (RFID).

3. Enter "MixingAxisControl" in the "Display name" field of the effective range (RFID).

4. Enter "1" in the "ID" field of the effective range (RFID). 
Make sure that the effective range (RFID)-ID matches the ID on the machine.

5. Double-click "Add..." in the "RFID Tag table.

6. Enter "RFID Tag 1" as the "Name" of the RFID Tag.

7. Enter "1" as the "ID" of the RFID Tag. Then set the RFID Tag-ID for the RFID Tag.

8. Enable the assignment of "RFID Tag 1".
"RFID Tag 1" is assigned to the effective range (RFID) "MixingAxisControl".

Result
The effective range (RFID) "MixingAxisControl" is configured.

The display name describes the effective range (RFID) in the set editing language. An overview 
of the display names can be found in the "Project texts" editor.

10.9.8.3 Configuring the effective range name (RFID)

Introduction
Configure the "Effective range - Name" object so that an operator can log on and off a machine 
using an effective range (RFID). If you do not configure the "Effective range-Name" object for 
a Mobile Panel Wireless RFID with (RFID), a warning will appear during generation.         
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Requirements
A screen has been created and opened.

Procedure
1. Select the "Effective range - Name (RFID)" object from "<Elements" in the toolbox.

2. Drag and drop the "Effective range - Name (RFID)" object from the toolbox into the screen.

Result
If the operator clicks an object during runtime, he will initiate logon or logoff of the HMI device 
to a machine which has been assigned to an effective range (RFID). 

See also
Effective range name (RFID) (Page 3154)

10.9.9 Reference

10.9.9.1 PROFIsafe address

Validity
The PROFIsafe address is only available for fail-safe operation for the Mobile Panel Wireless. 

 

 Note

Additional information on fail-safe operation can be found in the operating instructions for the 
HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

PROFIsafe address
The PROFIsafe address used for fail-safe I/Os in PROFIsafe communication is unique on the 
entire network and on all stations. On the Mobile Panel Wireless, you create a default value 
in the project and load it to the HMI device. You can also store a PROFIsafe address on the 
HMI device.  

The PROFIsafe address fall within the range from 1 to 65534. The two PROFIsafe addresses 
(in the Engineering System and on the HMI device) are checked for formal validity. 

The PROFIsafe address is loaded as follows at the start of Runtime:
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● You programmed a valid PROFIsafe address in the Control Panel.
The HMI loads the PROFIsafe address set in the Control Panel.

● You did not program a valid PROFIsafe address in the Control Panel.
The HMI loads the PROFIsafe address set in the project.

 

  Note

The invalid address 65.535 is programmed by default in the Control Panel of the HMI 
device. The HMI loads the address set in the project. 

 

See also
Power Management (Page 4892)

Zone ID / connection point ID (Page 4893)

10.9.9.2 Power Management

Validity
In the "Runtime Settings > Power Management" editor, configure the energy-saving mode of 
a Mobile Panel. 

Power Management
The Mobile Panel Wireless can save energy in the following ways:   

● Reduce brightness - minimal saving

● Switch off display - significant saving

You can also indicate after how long without operator input the power management function 
is enabled. The communication link is maintained. The time for "Switch monitor off" is longer 
than the time for "Reduce brightness".

See also
PROFIsafe address (Page 4889)
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10.9.9.3 Zone ID / connection point ID

Validity
In the "Runtime Settings > General" configure an internal tag which, depending on the value, 
shows specific information on the display of the HMI device.

 

 Note
Mobile Panels Wireless with RFID

For Mobile Panels Wireless with RFID, the area "Zone ID / Connection point ID" is not 
available.

 

Zone ID / connection point ID
This field is used to configure an internal tag that contains the following value at runtime in 
relation to the type of HMI device:     

● The ID of the connection box or effective range to which the hard-wired Mobile Panel is 
connected.

● The ID of the zone in which the Mobile Panel Wireless is located. If the value is set to 255, 
then the HMI device is not in any zone.

See also
PROFIsafe address (Page 4889)
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10.10 Planning tasks

10.10.1 Field of application of the Scheduler

Definition
You can use the Scheduler to configure tasks to run independent of the screen in the 
background. You create tasks by linking system functions or scripts to a trigger. The linked 
functions will be called when the triggering event occurs.  

Example of an application
The Scheduler is used to execute event-controlled tasks automatically. For example, you use 
a task to automate the following:

● Regular swap out of log data

● Printout of an alarm report when an alarm buffer overflow occurs

● Printout of a report at shift end

● Monitoring a tag

● Monitoring of a user change
 

 Note

The availability of the listed examples is determined by the HMI device. 
 

See also
Work area of the "Scheduler" editor (Page 4896)
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10.10.2 Working with tasks and triggers

Introduction
A task consists of a trigger and a task type.

Starting a task
Controlled by a trigger, the Scheduler starts the task linked to the trigger. 
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10.10.3 Basics

10.10.3.1 Work area of the "Scheduler" editor

Introduction
Double-click on "Scheduler" to open it in the project view. The work area shows the scheduled 
tasks, which consist of the trigger and the task type, for example, the function list.  

Structure
The work area consists of the table of jobs.

The table of tasks shows specified tasks with their properties, such as triggers. You select a 
task type and a trigger. You assign a name and a comment to the task. The description provides 
a written summary of the task including the timing for the task.
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Inspector window
The "Properties" tab of the Inspector window is split into two parts. 

The "Job" area lists the name of the job and the job type. The "Starting time" area shows the 
trigger. The area is different depending on the trigger selected. 

In the "Events" tab use the function list with system functions that will be executed in the task.
 

 Note

You can obtain more detailed information about the elements of the user interface using the 
tooltips. To do so, move the mouse pointer to the relevant object or press <F1> if the object 
has already been selected.

 

 

See also
Field of application of the Scheduler (Page 4892)

Triggers (Page 4898)

10.10.3.2 Function list

Function list
A trigger starts the function list. The function list is executed line by line. Each line contains a 
system function. You can configure exactly one function list for each task.     

 

 Note

The choice of configurable system functions in a function list depends on the selected trigger 
and the HMI device. 

 

10.10.3.3 Function list

Function list
A trigger starts the function list. The function list is executed line by line. Each line contains a 
system function or a local script. You can configure exactly one function list for each task.

 

 Note

The choice of configurable system functions in a function list depends on the selected trigger 
and the HMI device.
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Processing of system functions and scripts
System functions and scripts in a function list are processed in Runtime sequentially from top 
to bottom. 

Auto-Hotspot 

Use a script with loops, conditional statements and abort conditions to program non-sequential 
and conditional procedures. 

10.10.3.4 Triggers

Triggers

Introduction
A trigger is linked to a task and forms the triggering event which will call this task. The task is 
executed when the trigger occurs.   

Event trigger
When a task is linked to a system event, the task will be triggered by the event. System events 
include, for example, Runtime stop, screen change, user change, etc. 

Each system event can only be configured once for each HMI device.   

Deactivating job
If you do not need a certain job temporarily, deactivate the job in the Engineering System. You 
also use the trigger "Deactivated" to make a previously configured system event available once 
again. 

Example: Task "A" is planned with the system event "Shutdown". This system event is then 
no longer available for another task "B". Select "Disabled" as the trigger for task "A" to make 
the "Runtime stop" system event available again.   

 

 Note

The available triggers depend on the HMI device.
 

See also
Work area of the "Scheduler" editor (Page 4894)
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Triggers

Introduction
A trigger is linked to a task and forms the triggering event which will call this task. The task is 
executed when the trigger occurs.   

Types of triggers
The Scheduler recognizes different types of triggers:

Acyclic triggers
They consist of a specification for the date and time of day. Tasks with an acyclic trigger are 
performed once by the Scheduler on the specified date and at the specified time.     

Cyclic triggers
Tasks linked to a cyclic trigger occur regularly at a specific point in time.     

● Standard cycle: With a standard cycle, the beginning of the first interval coincides with the 
start of Runtime. The length of the interval is determined by the cycle.  

● Trigger with defined starting time: You specify a start time and a time interval. You can use 
cyclic triggers to perform tasks on a daily or weekly basis, for example. For example, you 
can select a "Weekly" trigger to specify a week as the interval. You specify the beginning 
of the interval with the day of the week and the time of day.  

 

 Note
User-defined cycles

You have defined your own cycles. You can only use cycles in the Scheduler whose maximum 
value amounts to one hour. 

 

Event trigger
When a task is linked to a system event, the task will be triggered by the event. In contrast to 
cyclic triggers, system events usually occur acyclically. A Runtime stop is a system event, for 
example.

Each system event can only be configured once for each HMI device.       

Deactivating job
If you do not need a certain job temporarily, deactivate the job in the Engineering System. You 
also use the trigger "Deactivated" to make a previously configured system event available once 
again. 
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Example: Task "A" is planned with the "User change" system event. This system event is then 
no longer available for another task "B". Select "Disabled" as the trigger for task "A" to make 
the "User change" system event available again.   

 

 Note

The available triggers depend on the HMI device.
 

Timers for cyclic triggers 

Timers for cyclic and acyclic triggers
You have the option to change the start time of a task dynamically in Runtime. You can select 
an HMI variable as the timer. The value of the tag determines the start time for the task during 
Runtime.     

 

 Note

An HMI tag must be of the type "DateTime". A PLC tag must be of the type "Date and Time" 
or "DTL".

 

As long as the operator does not change the tag after Runtime starts, the start time configured 
in the task is valid. As soon as the operator enters a change to the tag, the current value of 
the tag is always the start time. To reset the configured time as the start time, the operator has 
to enter the configured time again. 

10.10.4 Planning jobs

10.10.4.1 Planning tasks with acyclic triggers

Introduction
You are planning a one-time Runtime stop for maintenance work. The task starts a function 
which requires Runtime to stop.       

Requirements
● The "Scheduler" editor is open.

● The Inspector window is open.
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Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Maintenance at end of year" as the "Name."

3. Select "Once" as the "Trigger."

4. Select "31.12.2008" in the "Properties > Properties > General > on" field of the Inspector 
window.

5. Enter the time "18:00" in the "at" field.

6. Click "Properties > Events" in the Inspector window.

7. Select the "StopRuntime" system function in the function list.

8. Select "Runtime" as the "Mode".
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Result
The task is executed once. Runtime will be stopped at 18:00 on December 31, 2008. 

 

 Note
"StopRuntime" event on RT Professional

Please note that the "StopRuntime" event means runtime is in the process of ending and that 
some functionalities are therefore no longer available. 

 

10.10.4.2 Planning tasks with cyclic triggers 

Introduction
You plan a job that provides a weekly printout of a report.  

Requirements
● A "Weekly report" report has been created.

● The "Scheduler" editor is open.

● The Inspector window is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Weekly report printout for end of shift" as the "Name."

3. Select "Weekly" as the "Event".

4. Open the "Properties" tab in the Inspector window.

5. Select "Friday" in the "on day" field of the "Starting point" area.

6. Enter the time "18:00" in the "at" field in the "Starting point" area.

7. Click in the "Events" tab of the "Function list" on the entry "No function."

8. Select "Print/PrintReport" as the function.

9. Select "Weekly report" report.

Result
The task is executed weekly. The report "Weekly report" will be printed every Friday at 18:00 
hours. 
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10.10.4.3 Planning tasks with event triggers 

Introduction
You plan a task that generates a screen change when the user changes.    

Requirements
● The "Scheduler" work area is open.

● You have created the "Start" screen.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Screen change at user change" as the "Name."

3. Select "User change" as the "Trigger."

4. In the Inspector window, select "Properties > Events".

5. Select the "Screen/ActivateScreen" system function in the function list.

6. Select the "Start" screen in the screen name field.
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Result
The task is executed with the "User change" event. When a new user logs on successfully, 
the "Start" screen is called up. 

10.10.4.4 Administer task

Changing the designation
1. In the work area, double-click the field in the "Name" column. 

2. Change the name of the task.

3. Confirm your entry with <Return>.

As an alternative, you can change the designation in the "Job > Name" box of the Inspector 
window.  

Changing triggers
1. In the work area, mark the field in the "Trigger" column. 

2. Open the drop-down list using the  button and select the trigger you require.

You can alternatively change the trigger in the "Starting time" area of the Inspector window.

Deleting a task
1. Select one or more lines for the tasks to be deleted. 

2. Open the shortcut menu with the right button and select the menu command "Delete".

As an alternative, delete one or more tasks by using the <Del> button.

10.10.5 Examples

10.10.5.1 Example: Terminating Runtime every day

Task
You plan a job that terminates Runtime every day at the end of work.
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Requirements
● The "Scheduler" work area is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Runtime stop at end of work" as the "Name."

3. Select "Daily" as the "Event."

4. Open the "Properties" tab in the Inspector window.

5. Enter the time "21:00" in the "at" field in the "Starting point" area.

6. Open the "Events" tab in the Inspector window.

7. Click the "No function" entry in the "Function list".

8. Select "System functions/System/StopRuntime" as the function.

Result
Runtime is terminated every day at 21:00. 

10.10.5.2 Example: Update user following change of user

Task
Configure an I/O field which displays the logged on user. Configure a task which updates the 
I/O field when the logged on user changes.     

Requirements
● A "CurrentUser" tag of the "String" type is created.

● A screen has been created and opened.

● An I/O field is created in the screen.

Procedure
1. Click on the "I/O field" object.

2. In the Inspector window, select "Properties > Properties > General":

– Select "String" as the "Display format."

– Select "CurrentUser" as the "Variable."

– Select "Output" as the mode.

3. Change to the work area of the Scheduler.

4. Click "Add..." in the table of the task area.
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5. Enter "CurrentUser" as the "Name".

6. Select "User change" as the "Trigger."

7. In the Inspector window, select "Properties > Events".

8. Select the system function "ReadUserName" from the "User Management" group in the 
function list.

9. Select "CurrentUser" as the "Variable."

Result
When a new user logs on successfully, the "ReadUserName" function is called up. The 
"CurrentUser" tag is updated and displayed in the I/O field of the newly logged on user. 

If a user does not log on successfully, the logged on user is logged off. The I/O field continues 
to display the user previously logged on until a new user logs on successfully.       

10.10.5.3 Example: Changing the starting point of a job in Runtime

Example: Changing the starting point of a task in Runtime

Introduction
A cyclic trigger, for example "Starting daily at 18:00," is configured in the Engineering System. 
The time "18:00" is fixed as a constant. To change the start time in Runtime, select a tag as 
the "Timer." The value of the tag determines the start time of the task during Runtime.   
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Task
You plan a task that swaps out log data daily and has the "LogTime" tag as the timer. You 
configure a "LogTime" tag in an input field.

Requirements
● The "DataLogSource" source log has been created as a data log.

● The "DataLogDestination" destination log has been created as a data log.

● A "ChangeLogTime" screen has been created.

Procedures overview
1. Creating a timer tag: You create a tag with which you change the starting point of the log 

data swap in Runtime.

2. Configuring a Date/time field: The operator changes the starting point of the task by using 
the Date/Time field in Runtime.

3. Configure the task with a timer tag: You create a task whose start time can be changed 
dynamically in Runtime.

Result
If nothing is entered in the "LogDataTimeField" input field, then the task starts daily at 18:00 
by default. The log data are swapped out. If an operator enters 19:00 in the "LogDataTimeField" 
input field, then the log data are swapped out at 19:00. Provided the value of the tag is not 
changed again before the task starts. 

See also
Example: 2. Configuring a Date/time field (Page 4908)

Example: 1. Configuring a tag for Runtime

Task
In the following example you configure the "LogTime" variable.

Procedure
1. Open the "HMI tags" editor.

2. Click "Add..." in the table of the task area.

3. Enter "LogTime" as the "Name" of the variable.

4. Select "Internal variable" in the "Connection" column.

5. Select "DateTime" in the "Date type" column.

Visualizing processes (Comfort/Advanced)
10.10 Planning tasks

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4905



Result
A variable of the "DateTime" type has been created.

Example: 2. Configuring a Date/time field

Task
In the following example you configure a Date/time field. To change the starting point of the 
task in Runtime, link the "LogTime" variable to the Date/time field.

Requirements
● The "LogTime" variable of the "DateTime" type has been created.

● The "ChangeLogTime" screen is open.

Procedure
1. In the toolbox view, drag-and-drop a "Date/time field" from the "Basic objects" category to 

the screen.

2. In the Inspector window, click "Properties >Properties > General".

3. Disable the "System time."

4. Click "Variable" and select "LogTime."

5. Disable "Display date" and enable "Display time."

6. Select "Input/output" as the "Mode."

7. Click "Properties > Miscellaneous."

8. Enter "LogDataTimeField" as the "Name".

Result
The operator enters a time using the created date/time field.

See also
Example: Changing the starting point of a task in Runtime (Page 4904)

Example: 3. Configuring a swap to archive with a timer variable

Task
In the following example you configure a task with a timer tag with which you change the starting 
point of the task in Runtime.    
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Requirements
● The "LogTime" tag has been created.

● The "DataLogSource" source log has been created as a data log.

● The "DataLogDestination" destination log has been created as a data log.

● The Scheduler work area is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Swap out log daily at a tag time" as the "Name".

3. Select "Daily" as the "Trigger".

4. In the Inspector window "Properties >Properties > General > at" enter the time "18:00".

5. Select the "LogTime" tag as the "Standard timer".

6. In the Inspector window, open "Properties > Events".

7. Select the "System functions/Logs/CopyLog" system function in the function list.

8. Select these settings:

– Select "Data log" as the "Log type".

– Select "DataLogDestination" as the "Destination log".

– Select "DataLogSource" as the "Source log".

– Select "Overwrite" as the "Mode".

– Select "Yes" for "Delete source log".
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Result
If nothing is entered in the "LogDataTimeField" input field, then the task starts daily at 18:00 
by default. The log data are swapped out. If an operator enters 19:00 in the "LogDataTimeField" 
input field, then the log data are swapped out at 19:00. Provided the value of the tag is not 
changed again before the task starts. 
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10.11 Communicating with PLCs

10.11.1 Basics of communication

10.11.1.1 Communication between devices

Communication
The data exchange between two devices is known as communication. The devices can be 
interconnected directly or via a network. The interconnected devices in communication are 
referred to as communication partners.     

Data transferred between the communication partners may serve different purposes:

● Display processes

● Operate processes

● Output alarms

● Archive process values and alarms

● Document process values and alarms

● Administer process parameters and machine parameters

Communication partners
Communication between the following devices is described in more detail in this section:

● PLC
The PLC controls a process by means of a user program.

● HMI device
You use the HMI device to operate and monitor the process.   
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Basic information for all communication
The basis for all types of communication is a network configuration. In a network configuration, 
you specify the connection that exists between the configured devices. 

With the network configuration, you also ensure the necessary prerequisites for 
communication, in other words:

● Every device in a network is assigned a unique address.

● The devices carry out communication with consistent transmission characteristics.

Automation system
The following characteristics describe an automation system:

● The PLC and HMI device are interconnected

● The network between the PLC and HMI device is configured

Communication between HMI devices
The HTTP protocol is available for communication between HMI devices. 

For more detailed information, refer to the documentation on the SIMATIC HMI HTTP protocol.

Communication via a uniform and vendor-neutral interface
With OPC (Openess Productivity Collaboration), WinCC has a uniform and manufacturer-
neutral software interface. This interface enables standardized data exchange between 
industrial, office, and manufacturing applications. 

For more detailed information, refer to the documentation for OPC.

10.11.1.2 Devices and networks in the automation system

Introduction
To set up an automation system, you must configure, parameterize, and interconnect the 
individual devices.

You insert PLCs and HMI devices into the project in the same way. Likewise, you configure 
the two devices in the same way.

Automation system setup:

1. Insert PLC into the project.

2. Insert HMI device into the project.

3. Network the devices together.

4. Interconnect the devices.
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Inserting devices  
If you have created a project, you can add a device in the portal view or project view. 
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● Portal view

● Project view
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Networking devices
You can network the interfaces of the communication-capable devices conveniently in the 
"Devices & Networks" editor. In the networking step, you configure the physical device 
connections. 

The tabular network overview supplements the graphical network view with the following 
additional functions:

● You obtain detailed information on the structure and parameter settings of the devices.

● Using the "Subnet" column, you can connect communication-capable components to 
subnets that have been created.   
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Connecting devices
After you network the devices together, you configure the connection. You configure the "HMI 
connection" connection type for communication with the HMI device.    

10.11.1.3 Data exchange using tags

Communication using tags    
Process values are forwarded in runtime using tags. Process values are data which is stored 
in the memory of one of the connected automation systems. They represent the status of a 
plant in the form of temperatures, fill levels or switching states, for example. Define external 
tags for processing the process values in WinCC.

WinCC works with two types of tag:

● External tags

● Internal tags

Working with tags
See the chapter "Working with tags" for further information about configuring tags.
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10.11.1.4 Data exchange using area pointers

Communication using area pointers
Area pointers are parameter fields. WinCC receives information from these parameter fields 
in Runtime during the course of the project. This information contains data on the location and 
size of data areas in the PLC.

During communication, the PLC and the HMI device alternately access these data areas for 
read and write operations. 

Based on the evaluation of data stored in the data areas, the PLC and HMI device initiate 
mutually defined actions. 

The area pointers are managed centrally in the "Connections" editor. Area pointers are used 
to exchange data from specific user data areas. 

You use the following area pointers in WinCC:

● Data record

● Date/time

● Coordination

● Job mailbox

● Date/time PLC

● Project ID

● Screen number

The availability of the various area pointers is determined by the HMI device used.                  

10.11.1.5 Communication drivers

Communication drivers
A communication driver is a software component that establishes a connection between a PLC 
and an HMI device. The communication driver thus enables the assignment of process values 
to HMI tags.

The interface as well as the profile and transmission speed can be chosen, depending on the 
HMI device used and the connected communication partner.
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10.11.2 Editors for communication

10.11.2.1 "Devices & networks" editor

Function of the hardware and network editor     
The "Devices & networks" editor is the development environment for networking, configuring 
and assigning parameters to devices and modules.

Configuration     
The "Devices & networks" editor consists of the following components:

1 Device view, network view, topology view
2 Hardware catalog
3  Inspector window 
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The "Devices & networks" editor provides you with three different views of your project. You 
can switch between these three views at any time depending on whether you want to produce 
and edit individual devices and modules, entire networks and device configurations or the 
topological structure of your project.

The inspector window contains information on the object currently marked. Here you can 
change the settings for the object marked.

Drag the devices and modules you need for your automation system from the hardware catalog 
to the network, device or topology view. 

10.11.2.2 Network view

Introduction
The network view is a working area of the hardware and network editor. 

You undertake the following tasks in network view:

● Configuring and assign device parameters

● Networking devices with one another
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Structure     
The following diagram shows the components of the network view:

① Changeover switch: device view / network view / topology view
② Toolbar of network view
③ Graphic area of network view
④ Overview navigation
⑤ Table area of network view

You can use your mouse to change the spacing between the graphic and table areas of the 
network view. 

To do this, click on the upper edge of the table view and expand or contract this by moving the 
mouse with the mouse button held down. 

You can use the two small arrow keys to minimize, maximize or select the latest table structure 
of the table view with just one click.
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Toolbar   
The toolbar provides the following functions:

Icon Meaning
Mode to network devices.

Mode to create connections.
You can define the connection type using the drop-down list.
Mode to create relations.

Show interface addresses.

Adjust the zoom setting.
You can select the zoom setting or enter it directly in the drop-down list. You can also 
zoom in or zoom out the view in steps using the zoom symbol or draw a frame around 
an area to be zoomed in.
Show page breaks
Enables page break preview. Dotted lines will be displayed at the positions where the 
pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table view 
is stored.

Graphic area
The graphic area of the network view displays any network-related devices, networks, 
connections and relations. In this area, you add devices from the hardware catalog, connect 
them with each other via their interfaces and configure the communication settings.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the network view includes various tables for the devices, connections and 
communication settings present:

● Network overview

● Connections

● I/O communication

You can use the shortcut menu of the title bar of the table to adjust the tabular display.
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10.11.2.3 Network data

Introduction
The "Network view" editor also gives you a tabular view of the "Network data" in addition to 
the graphic network view.

You have the following selections in the "Network data" editor:

● Network overview

● Connections

● VPN

● I/O communication

You open the "Network data" below the graphic network overview.

Basic functions
The network data are displayed in tabular form and support the following basic functions for 
editing a table:

● Displaying and hiding table columns
 Note: The columns of relevance to configuration cannot be hidden. 

● Optimizing column width

● Sorting table

● Displaying the meaning of a column, a row or cell using tooltips.
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Network overview
The tabular network overview adds the following functions to the graphic network view:

● You obtain detailed information on the structure and parameter settings of the devices.

● Using the "Subnet" column, you can connect components capable of communication with 
created subnets.

The 

Connections
You will find additional network data under "Connections".
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10.11.2.4 Diagnostics of online connections

Diagnostics of online connections      
You can read out the diagnostics data of existing connections in the TIA Portal.

The "Diagnostics" function shows the connection data in tabular form in the Inspector window.

Requirements
● Devices must be in "Online" mode.

Device information
The diagnostics data of all devices in "Online" mode is displayed in the "Diagnostics > Device 
information" Inspector window.

The following data is displayed:

● Online status

● Operating mode

● Device / module

● Alarm

● Details

● Help
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Connection information
Use the "Connection information" function to display the diagnostics data of the connection 
selected in the "Devices&Networks" editor.

A graphic displays the communication partners of the connection and by which communication 
driver they are connected with each other.

The following data is displayed:

● End point

● Interface

● Subnet

● Address

● TSAP

● Number of HMI resources

10.11.2.5 Device view

Introduction
The device view is a working area of the hardware and network editor. 

You undertake the following tasks in device view:

● Configuring and assign device parameters

● Configuring and assign module parameters
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Structure     
The following diagram shows the components of the device view:

① Changeover switch: device view / network view / topology view
② Toolbar of device view
③ Graphic area of the device view
④ Overview navigation
⑤ Table area of device view

You can use your mouse to change the spacing between the graphic and table areas of the 
device view.

To do this, click on the upper edge of the table view and expand or contract this by moving the 
mouse with the mouse button held down. You can use the two small arrow keys to minimize, 
maximize or select the latest table structure of the table view with just one click.
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Toolbar   
The toolbar provides the following functions:

Icon Meaning
Switches to the network view.
Note: The device view can switch between the existing devices using the drop-down 
list.
Show the area of unplugged modules.

Show module labels.
Adjust the zoom setting.
Select the zoom setting or enter it directly in the drop-down list. You can use the Zoom 
symbol to zoom in or out incrementally or to drag a frame around an area to be 
enlarged.
With signal modules, you can recognize the address labels from a zoom level of 200% 
or higher.
Show page breaks
Enables page break preview. Dotted lines will be displayed at the positions where the 
pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the device view displays hardware components and if necessary the 
associated modules that are assigned to each other via one or more racks. In the case of 
devices with racks, you have the option of installing additional hardware objects from the 
hardware catalog into the slots on the racks.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the device view gives you an overview of the modules used and the most 
important technical and organizational data.

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

10.11.2.6 Topology view

Introduction
The topology view is a working area of the hardware and network editor. 
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You undertake the following tasks in topology view:

● Displaying the Ethernet topology

● Configuring the Ethernet topology

● Identify and minimize differences between the desired and actual topology

Structure     
The following figure provides an overview of the topology view.

① Changeover switch: device view / network view / topology view
② Topology view toolbar
③ Graphic area of the topology view
④ Overview navigation
⑤ Table area of the topology view

You can use your mouse to change the spacing between the graphic and table areas of the 
topology view. 

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4927



To do this, click on the upper edge of the table view and expand or contract this by moving the 
mouse with the mouse button held down. You can use the two small arrow keys to minimize, 
maximize or select the latest table structure of the table view with just one click.

Toolbar   
The toolbar provides the following functions:

Icon Meaning
Adjusting the zoom setting.
You can select the zoom setting via the drop-down list or enter it directly. You can also 
zoom in or zoom out the view in steps using the zoom symbol or draw a frame around 
an area to be zoomed in.
Show page breaks
Enables page break preview. Dotted lines will be displayed at the positions where the 
pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the topology view displays Ethernet modules with their appropriate ports 
and port connections. Here you can add additional hardware objects with Ethernet interfaces.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
This displays the Ethernet or PROFINET modules with their appropriate ports and port 
connections in a table. This table corresponds to the network overview table in the network 
view. 

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

10.11.2.7 Inspector window 
The properties and parameters shown for the object selected can be edited in the inspector 
window.
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Structure 
The inspector window consists of the following components:

① Switch between various information and work areas
② Navigation between various pieces of information and parameters
③ Display showing the selected information and parameters

Function
The information and parameters in the inspector window are split into different types of 
information:

● Properties

● Info

● Diagnostics

To display the corresponding information and parameters, click in the area you want. The 
"Properties" area is the most important one for configuring an automation system. This area 
is displayed by default.

The left pane of the inspector window is used for area navigation. Information and parameters 
are arranged there in groups. If you click on the arrow symbol to the left of the group name, 
you can expand the group if sub-groups are available. If you select a group or sub-group, the 
corresponding information and parameters are displayed in the right pane of the inspector 
window and can be edited there too.
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10.11.2.8 Hardware catalog 
The "Hardware catalog" task card gives you easy access to a wide range of hardware 
components.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
4930 System Manual, 07/2013,  



Structure         
The "Hardware catalog" task card consists of the following panes:

① "Catalog" pane, search and filter function
② "Catalog" pane, component selection
③ "Information" pane
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Search and filter function
The search and filter functions of the "Catalog" pane make it easy to search for particular 
hardware components. You can limit the display of the hardware components to certain criteria 
using the filter function. For example, you can limit the display to objects that you can also 
place within the current context or which contain certain functions.

Objects that can be used in the current context include, for example, interconnectable objects 
in the network view or only modules compatible with the device in the device view.

Component selection
The component selection in the "Catalog" pane contains the installed hardware components 
in a tree structure. You can move the devices or modules you want from the catalog to the 
graphic work area of the device or network view.

Installed hardware components without a license are grayed out. You cannot use non-licensed 
hardware components.

Hardware components belonging to various components groups thematically are partially 
implemented as linked objects. When you click on such linked hardware components, a catalog 
tree opens in which you can find the appropriate hardware components.

Information
The "Information" pane contains detailed information on the object selected from the catalog:

● Schematic representation

● Name

● Order number

● Version number

● Description

10.11.2.9 Information on hardware components
In the hardware catalog, you can display information on selected hardware components in the 
"Information" pane. You can also display further information on the selected hardware 
components using the shortcut menu.

Access to further information
If you select a hardware object in the hardware catalog and open the shortcut menu, you not 
only have the "Copy" function available but also three options for accessing information on 
Service & Support:

● Information regarding product support

● FAQs

● Manuals
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The required information is displayed in the work area of the hardware and network editor.
 

 Note

You can only access Service & Support when you are connected to the Internet and the 
function is enabled. By default, the function is disabled. 

To enable the function, refer to the instructions in the section "Enabling product support".   
 

Information regarding product support   
Here, you have access to general information on hardware and software components. The 
order number of the selected hardware object is entered automatically in the search mask. 
You can, however, also search for other hardware and software components.

FAQs   
Here, you have access to "Frequently Asked Questions" (FAQs). You can view various entries 
on hardware and software questions. Using a detailed search mask, you can filter the required 
topics.

Manuals   
Here, you have access to the manuals of the various hardware components. This is particularly 
useful if the configuration, addressing or parameter assignment you are planning requires more 
detailed knowledge of the hardware you are using.

10.11.3 Networks and connections

10.11.3.1 SIMATIC communication networks

Communication networks

Overview
Communication networks are a central component of modern automation solutions. Industrial 
networks have to fulfill special requirements, for example:

● Coupling of automation systems as well as simple sensors, actuators, and computers.

● The information has to be correct and has to be transferred at the right moment.

● Robust against electromagnetic disturbances, mechanical stresses and soiling

● Flexible adaptation to the production requirements

Industrial networks belong to the LANs (Local Area Networks) and allow communication within 
a limited area. 
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Industrial networks fulfill the following communication functions:

● Process and field communication of the automation systems including sensors and 
actuators

● Data communication between automation systems

● IT communication for integrating the modern information technology

Overview of the networks
This section examines the following networks:

● Industrial Ethernet
The industrial network standard for all levels

● PROFINET
The open Industrial Ethernet standard for automation

● PROFIBUS
The international standard for the field area and market leader at the field busses

● MPI
The integrated interface of the SIMATIC products

● PPI 
The integrated interface specially for the S7-200

PROFINET

Industrial Ehernet

PROFIBUS
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PROFINET and Ethernet

Industrial Ethernet
Industrial Ethernet, which is based on IEEE 802.3, enables you to connect your automation 
system to your office networks. Industrial Ethernet provides IT services that you can use to 
access production data from the office environment.       

Ethernet network
An Ethernet network allows you to interconnect all devices that are connected to the network 
via an integrated Ethernet interface or a communication module. This enables connection of 
multiple HMI devices to one SIMATIC S7 PLC and multiple SIMATIC S7 PLCs to one HMI 
device. The maximum number of communication partners that you can connect to an HMI 
device is dependent on the HMI device used. Additional information is available in the 
documentation for the respective HMI device. 

PROFINET
PROFINET is an open standard for industrial automation defined by IEEE 61158 and based 
on Industrial Ethernet. PROFINET makes use of IT standards all the way to the field level and 
enables plant-wide engineering. 

With PROFINET, you can realize high-performance automation solutions for applications with 
stringent real-time requirements. 

PROFIBUS

PROFIBUS DP
PROFIBUS DP (distributed I/O) is used to connect the following devices: 

● PLCs, PCs, HMI devices

● Distributed I/O devices, e.g., SIMATIC ET 200

● Valves

● Drives

PROFIBUS DP's fast response times make it ideally suited for the manufacturing industry. 

Its basic functionality includes cyclic exchange of process data between the master and 
PROFIBUS DP slaves, as well as diagnostics.

PROFIBUS network
You can connect an HMI device within the PROFIBUS network to any SIMATIC S7 module 
that has an integrated PROFIBUS or PROFIBUS DP interface. You can thereby connect 
multiple HMI devices to one SIMATIC S7 PLC and multiple SIMATIC S7 PLCs to one HMI 
device.
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The maximum number of communication partners that you can connect to an HMI device is 
dependent on the HMI device used. Additional information is available in the documentation 
for the respective HMI device. 

You configure the SIMATIC S7-200 PLC as a passive device in the network. You connect the 
SIMATIC S7-200 using the DP connector or a PROFIBUS communication module.

MPI

MPI
MPI (Multi-Point Interface) is the integrated interface for SIMATIC products: 

● PLCs

● HMI devices

● Programming device/PC

Small subnets with the following characteristics are set up with MPI:

● Short distances

● Few devices

● Small data quantities   

MPI network
You connect the HMI device to the MPI interface of the SIMATIC S7 PLC. This enables 
connection of multiple HMI devices to one SIMATIC S7 PLC and multiple SIMATIC S7 PLCs 
to one HMI device. The maximum number of communication partners that you can connect to 
an HMI device is dependent on the HMI device used. Additional information is available in the 
documentation for the respective HMI device. 

Network architectures
MPI is based on the PROFIBUS standard (IEC 61158 and EN 50170) and supports the 
following bus topologies: 

● Line

● Star

● Tree

An MPI subnet contains a maximum of 127 devices and consists of multiple segments. Each 
segment contains a maximum of 32 devices and is limited by terminating resistors. Repeaters 
are used to connect segments. The maximum cable length without a repeater is 50 m.   
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PPI

Introduction
PPI (point-to-point interface) is an integrated interface that was developed specially for the 
SIMATIC S7-200. A PPI network typically connects S7-200 PLCs. However, other 
SIMATIC PLCs (e.g., S7-300 and S7-400) or HMI devices can communicate with a SIMATIC 
S7-200 in the PPI network. 

PPI network
A PPI connection is a point-to-point connection. The HMI device is the master. The SIMATIC 
S7-200 is the slave. 

You can connect a maximum of one SIMATIC S7-200 to an HMI device. You use the serial 
connector of the CPU to connect the HMI device. You can connect multiple HMI devices to 
one SIMATIC S7-200. From the perspective of the SIMATIC S7-200, only one connection at 
a time is possible.   

 

 Note

The PPI network can contain a maximum of four masters in addition to the HMI device. For 
performance reasons, do not configure more than four devices at a time as a master in the 
PPI network. 

 

Network architectures
PPI is based on the PROFIBUS standard (IEC 61158 and EN 50170) and supports the 
following bus topologies:

● Line

● Star

Multi-master networks with a maximum of 32 masters are set up with PPI:

● An unlimited number of masters can communicate with each slave.

● A slave can be assigned to multiple masters.

The RS 485 repeater can be used to extend the PPI network. Modems can also be connected 
to the PPI network.   
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10.11.3.2 Configuring networks and connections

Networking devices

Introduction
The "Devices & Networks" editor is provided for configuring connections. You can network 
devices in the editor. You can also configure and assign parameters to devices and interfaces. 
You then configure the required connections between the networked devices.

In the "Devices & Networks" editor you configure HMI connections with the PLCs:

● SIMATIC S7 1500

● SIMATIC S7 1200

● SIMATIC S7 300

● SIMATIC S7 400

You configure the HMI connections to other PLCs in the "Connections" editor of the respective 
HMI device.               

Networking devices
The network view of the "Devices & Networks" editor includes a graphical area and a tabular 
area. You can use the graphical area to network the devices in the project with drag-and-drop. 
The tabular area provides an overview of the devices and their components.       

You can network the following PLCs together with HMI devices in the "Devices & Networks" 
area.

● SIMATIC S7 1500

● SIMATIC S7 1200

● SIMATIC S7 300

● SIMATIC S7 400

All other PLCs are available in the TIA-Portal and are configured "not integrated". You configure 
"not integrated" connections in the "Connections" editor of the HMI device. 
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With the networking step, you configure the physical connection of the communication 
partners. The networking of devices is depicted by lines that are colored according to the 
interface.

Configuring an integrated connection in the "Devices & Networks" editor

Introduction
You configure an HMI connection between the HMI device and a SIMATIC S7 PLC in the 
"Devices & Networks" editor. This HMI connection is the direct connection between the 
communication partners that you have created in a project.                 
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Integrated connections
Connections of devices within a project are referred to as integrated connections. In the case 
of integrated connections, you can directly configure addresses of PLC tags.

 

 Note

An HMI connection can be configured in the "Devices & Networks" editor for the following 
PLCs only:
● SIMATIC S7 1500
● SIMATIC S7 1200
● SIMATIC S7 300
● SIMATIC S7 400

You configure the HMI connections to all other PLCs in the "Connections" editor of the HMI 
device.

 

Configuring an HMI connection in the "Devices & Networks" editor
1. Insert an HMI device and a SIMATIC S7 PLC in your project.

2. Switch to "Connections" mode.

3. Select the "HMI connection" connection type.
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4. Use a drag-and-drop operation to interconnect the two PROFINET interfaces.

5. Change the IP address and subnet mask address parameters according to the 
requirements of your project.

Special considerations of the "Devices & Networks" editor

Introduction
If you are configuring or have already configured networks or HMI connections, the "Devices 
& Networks" editor supports you with the following functions:

● Highlighting of communication partners

● Highlighting of HMI connections

● Automatic creation of subnets

Highlighting of communication partners  
All communication partners for which an HMI connection is possible are highlighted in turquoise 
if you have selected the "HMI connection" type. 

Starting from the interface of a device create an HMI connection to the device of another device 
using a drag-and-drop operation. During the drag-and-drop operation all potential 
communication partners are highlighted in turquoise.

Use the ESC key to stop connecting interfaces using a drag-and-drop operation.
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When the mouse pointer is moved over the interface of a device, the following icons indicate 
whether a connection is possible:

A connection is possible.

A connection is not possible.
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Highlighting of HMI connections
A turquoise highlighting of the connection indicates that a HMI connection was created. If 
several HMI connections are created, you can select one of the already created HMI 
connections in a dialog. 

Then you can configure the parameters of the selected HMI connection and the communication 
partners in the inspector window.

Subnets
Subnetworks are automatically created and used under the following conditions:

● If both communication partners are not already interconnected in different networks

● If a free interface is available to both communication partners.

● If a subnetwork already exists then that subnetwork is automatically used for the HMI 
connection.

Configuring a non-integrated connection in the "Connections" editor

Introduction
You use the "Connections" editor of the HMI device to configure a connection between an HMI 
device and a PLC that cannot be configured in the "Devices & Networks" editor.

These connections are referred to as non-integrated connections.       
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Requirements
● A project is open.

● An HMI device has been created.

Configuring a connection in the "Connections" editor
1. Open the "Connections" editor of the HMI device.

2. Create a new connection.
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3. Select the communication driver.

4. Set the connection parameters.

Integrated connections in the "Connections" editor
If you have already configured the integrated connections of the HMI device in the "Devices 
& Networks" editor, they are also displayed in the "Connections" editor.

Meaning of the icons used:

Integrated connection
Non-integrated connection
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10.11.4 Data exchange

10.11.4.1 Data exchange using tags

Basics of tags

Introduction
Process values are forwarded in runtime using tags. Process values are data which is stored 
in the memory of one of the connected automation systems. They represent the status of a 
plant in the form of temperatures, fill levels or switching states, for example. Define external 
tags for processing the process values in WinCC.

WinCC works with two types of tag:

● External tags

● Internal tags

The external tags form the link between WinCC and the automation systems. The values of 
external tags correspond to the process values from the memory of an automation system. 
The value of an external tag is determined by reading the process value from the memory of 
the automation system. It is also possible to rewrite a process value in the memory of the 
automation system.

Internal tags do not have a process link and only convey values within the WinCC. The tag 
values are only available as long as runtime is running.

Tags in WinCC
For external tags, the properties of the tag are used to define the connection that the WinCC 
uses to communicate with the automation system and form of data exchange.   

Tags that are not supplied with values by the process - the internal tags - are not connected 
to the automation system. In the tag's "Connection" property, this is identified by the "Internal 
tag" entry.

You can create tags in different tag tables for greater clarity. You then directly access the 
individual tag tables in the "HMI tags" node in the project tree. The tags from all tag tables can 
be displayed with the help of the table "Show all tags".
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With structures you bundle a number of different tags that form one logical unit. Structures are 
project-associated data and are available for all HMI devices of the project. You use the "Types" 
editor in the project library to create and edit a structure.

Overview of HMI tag tables

Introduction
HMI tag tables contain the definitions of the HMI tags that apply across all devices. A tag table 
is created automatically for each HMI device created in the project.    

In the project tree there is an "HMI tags" folder for each HMI device. The following tables can 
be contained in this folder:

● Default tag table

● User-defined tag tables

● Table of all tags

In the project tree you can create additional tag tables in the HMI tags folder and use these to 
sort and group tags and constants. You can move tags to a different tag table using a drag-
and-drop operation or with the help of the "Tag table" field. Activate the "Tags table" field using 
the shortcut menu of the column headings.

Default tag table
There is one default tag table for each HMI device of the project. It cannot be deleted or moved. 
The default tag table contains HMI tags and, depending on the HMI device, also system tags. 
You can declare all HMI tags in the standard tags table or, as necessary, additional user-
defined tables of tags.

User-defined tag tables
You can create multiple user-defined tag tables for each HMI device in order to group tags 
according to your requirements. You can rename, gather into groups, or delete user-defined 
tag tables. To group tag tables, create additional subfolders in the HMI tags folder. 

All tags
The "All tags" table shows an overview of all HMI tags and system tags of the HMI device in 
question. This table cannot be deleted, renamed or moved. This table also contains the "Tags 
table" column, which indicates the tag table of where a tag is included. Using the "Tags table" 
field, the assignment of a tag to a tags table can be changed. 

With devices for Runtime Professional, the table "All tags" contain an additional tab "System 
tags". The system tags are created by the system and used for internal management of the 
project. The names of the system tags begin with the "@" character. System tags cannot be 
deleted or renamed. You can evaluate the value of a system tag, but cannot modify it.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  4947



Additional tables
The following tables are also available in an HMI tag table:

● Discrete alarms

● Analog alarms

● Logging tags

With the help of these tables you configure alarms and logging tags for the currently selected 
HMI tag. 

Discrete alarms table
In the "Discrete alarms" table, you configure discrete alarms to the HMI tag selected in the 
HMI tag table. When you configure a discrete alarm, multiple selection in the HMI tag table is 
not possible. You configure the discrete alarms for each HMI tag separately.

Analog alarms table
In the "Analog alarms" table, you configure analog alarms to the HMI tag selected in the HMI 
tag table. When you configure an analog alarm, multiple selection in the HMI tag table is not 
possible. You configure the analog alarms for each HMI tag separately.

Logging tags table
In the "Logging tags" table, you configure logging tags to the HMI tag selected in the HMI tag 
table. When you configure a logging tag, multiple selection in the HMI tag table is not possible. 
You configure the logging tags for each HMI tag separately. The "Logging tags" table is only 
available if the HMI device used supports logging. 
If WinCC Runtime Professional is used, you can also assign several log tags to a tag. With 
the other HMI devices, you can only assign one log tag to a tag.

External tags

Introduction
External tags allow communication (exchange of data) between the components of an 
automation system, such as between the HMI device and the PLC.

Principle
An external tag is the image of a defined memory location in the PLC. You have read and write 
access to this storage location from both the HMI device and from the PLC.  

Since external tags are the image of a storage location in the PLC, the applicable data types 
depend on the PLC which is connected to the HMI device.

In STEP 7, if you write a PLC control program, the PLC tags created in the control program 
will be added to the PLC tag table. If you want to connect an external tag to a PLC tag, access 
the PLC tags directly via the PLC tag table and connect them to the external tag.
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Data types
All the data types which are available at the connected PLC are available at an external tag 
in WinCC. Information about data types which are available for connection to other PLCs can 
be found in the documentation about the respective communication drivers.

See "Communication between devices (Page 4909)" for additional information.
 

 Note

As well as external tags, area pointers are also available for communication between the HMI 
device and PLC. You can set up and enable the area indicators in the "Connections" editor.

 

Update of tag values
For external tags, the current tag values are transmitted in runtime via the communication 
connection between WinCC and the connected automation systems and then saved in the 
runtime memory. Next, the tag value will be updated to the set cycle time. For use in the runtime 
project, WinCC accesses tag values in the runtime memory that were read from the PLC at 
the previous cycle time. As a result, the value in the PLC can already change whilst the value 
from the runtime memory is being processed.   

See also
Communication between devices (Page 4909)

Addressing external tags

Introduction
The options for addressing external tags depend on the type of connection between WinCC 
and the PLC in question. A distinction must be made between the following connection 
types:         

● Integrated connection
Connections of devices which are within a project and were created with the "Devices & 
Networks" editor are referred to as integrated connections.

● Non-integrated connection
Connections of devices which were created with the "Connections" editor are referred to 
as non-integrated connections. It is not necessary that all of the devices be within a single 
project.

The connection type can also be recognized by its icon.

Integrated connection
Non-integrated connection

You can find additional information in the section "Basics of communication (Page 4909)".
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Addressing with integrated connections
An integrated connection offers the advantage that you can address a tag both symbolically 
and absolutely.

For symbolic addressing, you select the PLC tag via its name and connect it to the HMI tag. 
The valid data type for the HMI tag is automatically selected by the system. You have to 
distinguish between the following cases when you address elements in data blocks:

Symbolic addressing of data blocks with optimized access and standard access: 

During the symbolic addressing of a data block with optimized access and standard access, 
the address of an element in the data block is dynamically assigned and is automatically 
adopted in the HMI tag in the event of a change. You do not need to compile the connected 
data block or the WinCC project for this step.
For data blocks with optimized access, only symbolic addressing is available.

For symbolic addressing of elements in a data block, you only need to recompile and reload 
the WinCC project in case of the following changes:

● If the name or the data type of the linked data block element or global PLC tag has changed.

● If the name or the data type of the higher level structure node of a linked element in the 
data block element or global PLC tag has changed.

● If the name of the connected data block has changed.

Symbolic addressing is currently available with the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Symbolic addressing is also available if you have an integrated link.

 
 

 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

You can also use absolute addressing with an integrated connection. You have to use absolute 
addressing for PLC tags from a SIMATIC S7 300/400 PLC. If you have connected an HMI tag 
with a PLC tag and the address of the PLC tag changes, you only have to recompile the control 
program to update the new address in WinCC. Then you recompile the WinCC project and 
load it onto the HMI device.

In WinCC, symbolic addressing is the default method. To change the default setting, select 
the menu command "Options > Settings". Select "Visualization > Tags" in the "Settings" dialog. 
If required, disable the "Symbolic access" option.     

The availability of an integrated connection depends on the PLC used. The following table 
shows the availability:
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PLC Integrated connection Comments
S7 300/400 Yes The linking of tags is not checked in Runtime. If 

the tag address changes in the PLC and the HMI 
device is not compiled again and loaded, the 
change is not registered in runtime.

S7 1200 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. In the case of absolute addressing, the 
following behavior applies to the S7 300/400.

S7 1500 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. In the case of absolute addressing, the 
following behavior applies to the S7 300/400.

Create an integrated connection in the "Devices & Networks" editor. If the PLC is contained in 
the project and integrated connections are supported, you can then also have the connection 
created automatically. To do this, when configuring the HMI tag, simply select an existing PLC 
tag to which you want to connect the HMI tag. The integrated connection is then automatically 
created by the system.

Addressing with non-integrated connections
In the case of a project with a non-integrated connection, you always configure a tag connection 
with absolute addressing. Select the valid data type yourself. If the address of a PLC tag 
changes in a project with a non-integrated connection during the course of the project, you 
also have to make the change in WinCC. The tag connection cannot be checked for validity 
in Runtime, an error message is not issued.

A non-integrated connection is available for all supported PLCs.

Symbolic addressing is not available in a non-integrated connection.

With a non-integrated connection, the control program does not need to be part of the WinCC 
project. You can perform the configuration of the PLC and the WinCC project independently 
of each other. For configuration in WinCC, only the addresses used in the PLC and their 
function have to be known.

See also
Basics of communication (Page 4909)

Internal Tags

Introduction
Internal tags do not have any connection to the PLC. Internal tags transport values within the 
HMI device. The tag values are only available as long as runtime is running. 
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Principle
Internal tags are stored in the memory of the HMI device. Therefore, only this HMI device has 
read and write access to the internal tags. You can create internal tags to perform local 
calculations, for example.   

You can use the HMI data types for internal tags. Availability depends on the HMI device being 
used.

The following HMI data types are available:

HMI data type Data format
ARRAY One-dimensional array
BOOL Binary tag
DATETIME Date/time format
DINT Signed 32-bit value
INT Signed 16-bit value
LREAL Floating-point number 64-bit IEEE 754
REAL Floating-point number 32-bit IEEE 754
SINT Signed 8-bit value
UDINT Unsigned 32-bit value
UINT Unsigned 16-bit value
USINT Unsigned 8-bit value
WSTRING Text tag, 16-bit character set

10.11.4.2 Data exchange using area pointers

Basic information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. The 
PLC and the HMI device trigger defined interactions based on the evaluation of stored data.

For example, area pointers are required for the following data:

● Recipes

● Job mailboxes

● Sign-of-life monitoring

Area pointers
The following area pointers are supported:
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Area pointer
Area pointers can be configured for connections.

● Data record

● Date/time

● Coordination

● Job mailbox

Global area pointers of the HMI device
Global area pointers can be configured for separate connections.

● Screen number

● Date/time PLC

● Project ID

Area pointers for connections

Introduction
Using the "Area pointer" tab of the "Connections" editor, you can configure the usage of the 
available area pointers.

To configure the area pointers, open the "Connections" editor and open the "Area pointer" tab.
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Structure
The "Area pointer" tab contains two tables of area pointers. The top part of the table contains 
the area pointers you can create and enable separately for each available connection.

The "Global area pointers of HMI device" table contains the area pointers which are created 
only once in the project and can be used for only one connection.  

Use of area pointers

"Area pointer" tab
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You assign the following parameters in the "Area pointer" tab:                
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● Active
Enables the area pointer.

● Pointer name
Name of the area pointer specified by WinCC.

● PLC tag
Here you select the PLC tag or the tag array that you have configured as the data area for 
the area pointer.

● Access mode
Here you can select from the following access modes:

– Symbolic access

– Absolute access

● Address
If you selected "Symbolic access", no address is entered in this field.
If you selected "Absolute access", enter the address of a tag in the "Address" field.

● Length
WinCC specifies the length of the area pointer.

● Acquisition cycle
You specify the acquisition cycle in this field for area pointers that are read by the HMI 
device. Note that a very short acquisition time may have a negative impact on HMI device 
performance.

● Comment
Enter a comment, for example, to describe the purpose of the area pointer.

Accessing data areas

Accessing data areas
The following table shows how HMI devices and PLCs access individual data areas for read 
(R) or write (W) operations.   

Data area Required for HMI device PLC
Screen number Evaluation by the PLC in order to determine the active screen. W R
Data record Transfer of data records with synchronization R/W R/W
Date/time Transfer of the date and time from the HMI device to the PLC W R
Date/time PLC Transfer of the date and time from the PLC to the HMI device R W
Coordination Requesting the HMI device status in the PLC program W R
Project ID Runtime checks for consistency between the WinCC project 

ID and the project in the PLC
R W

Job mailbox Triggering of HMI device functions by the PLC program R/W R/W
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Configuring area pointers

Configuration of area pointers

Introduction
You use an area pointer to access a data area in the PLC. The data area is stored in the 
PLC.     

Prior to configuring area pointers
Before you use the area pointer, you must enable and parameterize it under "Connections > 
Area Pointer".

Global data block
To access the data area in the PLC, you have to create a global data block in the PLC program. 
The following example shows the use of a data block. 

Length of area pointers
For area pointers with a length >= 1, you set up the data area as a tag array in a global data 
block or instance data block. 

You also have the option to use a PLC tag for area pointers with a length = 1. 

The configuration of the tags in a data block is dependent on the length of the area pointer you 
want to use. The unit for the length of an area pointer is a 16-bit word. 

If, for example, you want to use an area pointer with a length of "5", you must create an array 
with 5 array elements of the data type UINT in the data block.     

Alternative procedure
Alternatively, you can also use the absolute access mode to access area pointers. Absolute 
access mode only works on standard PLC data blocks. 

Parameterizing a global data block 

Introduction
To access the data area in the PLC, a global data block for the area pointer must be 
parameterized in the PLC program.  
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Requirements
● A PLC is created in the project.

● A connection is configured between the PLC and the HMI device.

● The PLC program contains a global data block.

Procedure
1. Open "PLC > Program blocks" in the project tree.

2. Double-click the global data block you created previously.
The data block opens.

3. Enter a tag name in the "Name" column.

4. Select "Array[lo .. hi] of type" as the data type in the "Data type" column.

5. Replace the "lo" entry by the low value for the dimension of the array.

6. Replace the "hi" entry by the high value for the dimension of the array.
Example: If you configure an area pointer with the length "4", enter the value "0" for "lo" 
and the value "3" for "hi" inside the brackets.

7. Replace the "type" designation with the "word" data type.
The full data type for an array of 4 tags appears as follows: "Array[0 .. 3] of word".
The tag array is created after the entry is confirmed.

8. Click "Compile".
The project is compiled.

Configuring an area pointer for a connection

Introduction
After you have parameterized the global data block, you now create the area pointer for the 
connection.  
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Requirements
● The global data block has been parameterized in the PLC program.

Procedure
1. Open "HMI >Connections" in the project tree.

2. Click the "Area pointer" tab.

3. Enable the required area pointer.
You enable a global area pointer by selecting the connection in the "Connection" field.

4. Click the navigation button in the "PLC tag" field.
The object list opens. 

5. Navigate to the data block in the object list, and select the tag in the right window.
You do not need an array tag to configure an area pointer with the length of "1". 

6. Select the "Word" data type when creating the tag in the data block.

If required, set additional parameters, such as the acquisition cycle, during configuration.

Result
The area pointer is enabled and connected to the PLC tag in the global data block.

10.11.5 Device dependency

10.11.5.1 Basic Panel

Communication drivers for Basic Panels

Device dependency of the Basic Panels
The following table shows which communication drivers you can configure with the various 
Basic Panels.                                         
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Communication drivers

HMI 
devic
es

SIMA
TIC S
7 150
0

SIMA
TIC 
S7 
1200

SIMA
TIC 
S7 
300/4
00

SIMA
TIC 
S7 
200

SIMA
TIC 
LOG
O!

SIMA
TIC 
HTTP 
protoc
ol

OPC Allen-
Bradl
ey 
Ether
Net/IP

Allen-
Bradl
ey 
DF1 

Mitsu
bishi 
MC 
TCP/
IP

Mitsu
bishi 
FX

Modic
on 
Modb
us TC
P/IP

Modic
on 
Modb
us 
RTU

Omro
n 
Host 
Link

KP30
0 
Basic

Yes Yes Yes Yes Yes No No Yes No Yes No Yes No No

KP40
0 
Basic

Yes Yes Yes Yes Yes No No Yes No Yes No Yes No No

KTP4
00 
Basic 
PN

Yes Yes Yes Yes Yes No No Yes No Yes No Yes No No

KTP6
00 
Basic 
DP

Yes Yes Yes Yes Yes No No No Yes 2) No Yes No Yes 1) Yes

KTP6
00 
Basic 
PN

Yes Yes Yes Yes Yes No No Yes No Yes No Yes No No

KTP1
000 
Basic 
DP

Yes Yes Yes Yes Yes No No No Yes 2) No Yes No Yes 1) Yes

KTP1
000 
Basic 
PN

Yes Yes Yes Yes Yes No No Yes No Yes No Yes No No

TP15
00 
Basic 
PN

Yes Yes Yes Yes Yes No No Yes No Yes No Yes No No

 

1) only with RS 422-RS232 converter
Order number: 6AV6 671-8XE00-0AX0

2) Direct communication with PLC 5 or KF2 module, otherwise only approved with 
RS422-RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0
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Interfaces of the Basic Panels

Device dependency of the Basic Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.             

Table 10-149 Basic Panels

 KP300 Basic
KP400 Basic
KTP400 Basic PN
KTP600 Basic PN
KTP1000 Basic PN
TP1500 Basic PN

KTP600 Basic DP
KTP1000 Basic DP

SIMATIC S7 - PPI 1) — MPI/DP (X2)
SIMATIC S7 - MPI — MPI/DP (X2)
SIMATIC S7 - PROFIBUS — MPI/DP (X2)
SIMATIC S7 - PROFINET PROFINET (X1) —
SIMATIC HMI HTTP protocol — —
OPC — —
Allen-Bradley EtherNet/IP PROFINET (X1) —
Allen-Bradley DF1 — MPI/DP (X2) 2)

Mitsubishi TCP/IP PROFINET (X1) —
Mitsubishi FX — MPI/DP (X2) (RS422)
Modicon Modbus TCP PROFINET (X1) —
Modicon Modbus RTU — MPI/DP (X2) 3)

Omron Host Link — MPI/DP (X2) (RS422)

1) For SIMATIC S7-200 only
2) Direct communication with PLC5 or KF2 module, otherwise only approved with RS422-

RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0

3) only approved with RS 422-RS232 converter
Order number: 6AV6 671-8XE00-0AX0

 

Area pointers for Basic Panels

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
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alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions.

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointer

 KP300 Basic KTP400 
Basic PN

KTP600 
Basic PN

KTP600 
Basic DP

KTP1000 
Basic PN

KTP1000 
Basic DP

TP1500 
Basic PN

Screen number Yes Yes Yes Yes Yes Yes Yes
Data record Yes Yes Yes Yes Yes Yes Yes
Date/time Yes Yes Yes Yes Yes Yes Yes
Date/time PLC Yes Yes Yes Yes Yes Yes Yes
Coordination Yes Yes Yes Yes Yes Yes Yes
Project ID Yes Yes Yes Yes Yes Yes Yes
Job mailbox Yes Yes Yes Yes Yes Yes Yes

10.11.5.2 Panel

Communication drivers for Panels

Device dependency of Panels
The following table shows which communication drivers you can configure with the various 
Panels.                                         
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Communication drivers

HMI 
devices

S
I
M
A
T
I
C
 
S
7 
1
5
0
0

SIMA
TIC S
7 120
0

SIMA
TIC 
S7 
300/4
00

SIMA
TIC S
7 200

SIMA
TIC 
LOG
O!

SIMA
TIC 
HTTP 
protoc
ol

OPC Allen-
Bradl
ey 
Ether
Net/IP

Allen-
Bradl
ey 
DF1 

Mitsu
bishi 
MC 
TCP/
IP

Mitsu
bishi 
FX

Modic
on 
Modb
us TC
P/IP

Modic
on 
Modb
us 
RTU

Omro
n 
Host 
Link

OP 73 N
o

No Yes Yes No No No No No No No No No No

OP 77A N
o

Yes Yes Yes No No No No Yes 2) 

3)
No Yes No Yes 1) Yes 3)

OP 77B N
o

Yes Yes Yes No No No No Yes 2) 

3)
No Yes No Yes Yes 3)

TP 177A N
o

Yes Yes Yes No No No No Yes 2) 

3)
No Yes No Yes 1) Yes 3)

TP 177A 
Portrait

N
o

Yes Yes Yes No No No No Yes 2) 

3)
No Yes No Yes 1) Yes 3)

TP 177B 4" N
o

Yes Yes Yes Yes Yes No Yes Yes 2) 

3)
Yes Yes Yes Yes 1) 

3)
Yes 3)

TP 177B 
6" mono

N
o

Yes Yes Yes Yes No No No Yes 2) 

3)
No Yes No Yes 1) 

3)
Yes 3)

TP 177B 6" N
o

Yes Yes Yes Yes Yes No Yes Yes 2) 

3)
Yes Yes Yes Yes 1) 

3)
Yes 3)

OP 177B 
6" mono

N
o

Yes Yes Yes Yes No No No Yes 2) 

3)
No Yes No Yes 1) 

3)
Yes 3)

OP 177B 
6"

N
o

Yes Yes Yes Yes Yes No Yes Yes 2) 

3)
Yes Yes Yes Yes 1) 

3)
Yes 3)

TP 277 6" N
o

Yes Yes Yes Yes Yes No Yes Yes 2) 

3)
Yes Yes Yes Yes 1) 

3)
Yes 3)

OP 277 6" N
o

Yes Yes Yes Yes Yes No Yes Yes 2) 

3)
Yes Yes Yes Yes 1) 

3)
Yes 3)

 

1) only approved with RS 422-RS232 converter
Order number: 6AV6 671-8XE00-0AX0

2) Direct communication with PLC 5 or KF2 module, otherwise only approved with 
RS422-RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0

3) "PROFINET IO Enabled" must be disabled.
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Interfaces of Panels

Device dependency of Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.   

Table 10-150 Panels

 OP 73 OP 77A OP 77B 3) TP 177A TP 177B 3)

OP 177B 3)
TP 277 3)

OP 277 3)

SIMATIC S7 - PPI 1) IF1B IF1B IF1B IF1B IF1B IF1B
SIMATIC S7 - MPI IF1B IF1B IF1B IF1B IF1B IF1B
SIMATIC S7 - PROFIBUS IF1B IF1B IF1B IF1B IF1B IF1B
SIMATIC S7 - PROFINET — — — — ETHERNE

T 2)
ETHERNE
T 2)

SIMATIC HMI HTTP protocol — — — — ETHERNE
T 2)

ETHERNE
T

OPC — — — — — —
Allen-Bradley Ethernet IP — — — — ETHERNE

T 2)
ETHERNE
T

Allen-Bradley DF1 — IF1B 5) IF1A 3), 
IF1B 3)4)

IF1B 5) IF1B 3) 5) 8) IF1B 3) 5) 8)

Mitsubishi MC TCP/IP — — — — ETHERNE
T 2)

ETHERNE
T

Mitsubishi FX — IF1B IF1A 3), 
IF1B 3)

IF1B IF1B 3) 8) IF1B 3) 8)

Modicon Modbus TCP — — — — ETHERNE
T 2)

ETHERNE
T

Modicon Modbus RTU — IF1B 7) IF1A 3), 
IF1B 3)6)

IF1B 7) IF1B 7) 3) 8) IF1B 7) 3) 8)

Omron Host Link — IF1B IF1A 3), 
IF1B 3)

IF1B IF1B 3) 8) IF1B 3) 8)

1) For SIMATIC S7-200 only
2) Not approved for TP 177B DP, OP 177B DP.
3) For serial communication, deselect "Remote Control" of "Channel 1" in the "File > 

Transfer >Options" menu.
4) Only with PLC5 or KF2 module. 
5) Direct communication with PLC5 or KF2 module, otherwise only approved with RS422-

RS232 converter 6AV6 671-8XE00-0AX0 (option)
6) Can be selected and used, but not approved.
7) Only with RS 422-RS 232 converter 6AV6 671-8XE00-0AX0 (option)
8) "PROFINET IO Enabled" must be disabled.
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Area pointers for Panels

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions. 

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointers

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Screen number Yes Yes Yes Yes Yes Yes
Data record No Yes Yes Yes Yes Yes
Date/time Yes Yes Yes Yes Yes Yes
Date/time PLC Yes Yes Yes Yes Yes Yes
Coordination Yes Yes Yes Yes Yes Yes
Project ID Yes Yes Yes Yes Yes Yes
Job mailbox Yes Yes Yes Yes Yes Yes
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10.11.5.3 Comfort Panel

Communication drivers for Comfort Panels

Device dependency of Comfort Panels
The following table shows which communication drivers you can configure with the various 
Comfort Panels.                                         

Communication drivers

HMI 
devices

SIM
ATI
C S
7 1
500

SIM
ATI
C S
7 1
200

SIMA
TIC 
S7 
300/4
00

SIMA
TIC S
7 200

SIMA
TIC 
LOGO
!

SIMA
TIC 
HTTP 
protoc
ol

OPC 1)

 
Allen-
Bradle
y 
Ether
Net/IP

Allen-
Bradle
y DF1 

Mitsu
bishi 
MC 
TCP/
IP

Mitsu
bishi 
FX

Modic
on 
Modb
us TC
P/IP

Modic
on 
Modb
us RT
U

Omro
n 
Host 
Link

KP400 
Comfort

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

KTP400 
Comfort

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

KTP400 
Comfort 
Portrait

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

KP700 
Comfort

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP700 
Comfort

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP700 
Comfort 
Portrait

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

KP900 
Comfort

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP900 
Comfort

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP900 
Comfort 
Portrait

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

KP1200 
Comfort

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP1200 
Comfort

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP1200
Comfort
Portrait

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

KP1500 
Comfort 

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)
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HMI 
devices

SIM
ATI
C S
7 1
500

SIM
ATI
C S
7 1
200

SIMA
TIC 
S7 
300/4
00

SIMA
TIC S
7 200

SIMA
TIC 
LOGO
!

SIMA
TIC 
HTTP 
protoc
ol

OPC 1)

 
Allen-
Bradle
y 
Ether
Net/IP

Allen-
Bradle
y DF1 

Mitsu
bishi 
MC 
TCP/
IP

Mitsu
bishi 
FX

Modic
on 
Modb
us TC
P/IP

Modic
on 
Modb
us RT
U

Omro
n 
Host 
Link

TP1500 
Comfort 

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP1500 
Comfort 
Portrait

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP1900 
Comfort 

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP1900 
Comfort 
Portrait

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP2200 
Comfort 

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

TP2200 
Comfort 
Portrait

Yes Yes Yes Yes Yes Yes Yes Yes Yes 2) 
3)

Yes Yes 3) Yes yes 3)4) Yes 3)

1) OPC-UA (DA only) Client 
OPC-XML DA Server

2) Direct communication with PLC 5 or KF2 module, otherwise only approved with RS422-
RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0

3) "PROFINET IO Enabled" must be disabled.
4) Only approved with RS 422-RS232 converter

Order number: 6AV6 671-8XE00-0AX0

Interfaces of Comfort Panels

Device dependency of Comfort Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.     

Table 10-151 Comfort Panels

 KP400 
Comfor
t

KTP40
0 
Comfor
t

KP700 
Comfor
t

TP700 
Comfor
t

KP900 
Comfor
t

TP900 
Comfor
t

KP120
0 
Comfor
t

TP120
0 
Comfo
rt

KP150
0 
Comfo
rt 

TP150
0 
Comfo
rt 

TP190
0 
Comfo
rt 

TP2200
 
Comfor
t 

SIMATIC 
S7 - PPI 1)

IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B

SIMATIC 
S7 - MPI

IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B
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 KP400 
Comfor
t

KTP40
0 
Comfor
t

KP700 
Comfor
t

TP700 
Comfor
t

KP900 
Comfor
t

TP900 
Comfor
t

KP120
0 
Comfor
t

TP120
0 
Comfo
rt

KP150
0 
Comfo
rt 

TP150
0 
Comfo
rt 

TP190
0 
Comfo
rt 

TP2200
 
Comfor
t 

SIMATIC 
S7 - 
PROFIB
US

IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B

SIMATIC 
S7 - 
PROFIN
ET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

SIMATIC 
HMI 
HTTP pro
tocol

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

OPC ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

Allen-
Bradley 
EtherNet/
IP

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

Allen-
Bradley 
DF1

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

Mitsubish
i MC 
TCP/IP

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

Mitsubish
i FX

IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 
3)4)

IF1B 
3)4)

IF1B 
3)4)

IF1B 
3)4)

IF1B 3)4)

Modicon 
Modbus T
CP/

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

Modicon 
Modbus 
RTU

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

Omron 
Host Link

IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 
3)4)

IF1B 
3)4)

IF1B 
3)4)

IF1B 
3)4)

IF1B 3)4)

1) Direct communication with PLC5 or KF2 module, otherwise only with RS422-RS232 
converter.
Order number: 6AV6 671-8XE00-0AX0

2) only with RS422-RS232 converter (option)
Order number: 6AV6 671-8XE00-0AX0

3) For serial communication, deselect "Remote Control" of "Channel 1" in the "File > 
Transfer >Options" menu.

4) "PROFINET IO Enabled" must be disabled.
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Area pointers for Comfort Panel

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions.   

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointer

 KP40
0 
Comfo
rt

KTP4
00 
Comfo
rt

KP70
0 
Comfo
rt

TP700
 
Comfo
rt

KP90
0 
Comfo
rt

TP900
 
Comfo
rt

KP12
00 
Comfo
rt

TP120
0 
Comfo
rt

KP15
00 
Comfo
rt

TP150
0 
Comfo
rt

TP190
0 
Comfo
rt

TP220
0 
Comfo
rt

Screen number Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Data record Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Date/time Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Date/time PLC Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Coordination Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Project ID Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Job mailbox Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
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10.11.5.4 Multi Panel

Communication drivers for Multi Panels

Device dependency of Multi Panels
The following table shows which communication drivers you can configure with the various 
Multi Panels.                                         

Communication drivers

HMI 
devices

SIM
ATI
C S
7 1
500

SIM
ATI
C S
7 1
200

SIMA
TIC 
S7 
300/4
00

SIMA
TIC S
7 200

SIMA
TIC 
LOGO
!

SIMA
TIC 
HTTP 
protoc
ol

OPC 1)

 
Allen-
Bradle
y 
Ether
Net/IP

Allen-
Bradle
y DF1 

Mitsu
bishi 
MC 
TCP/
IP

Mitsu
bishi 
FX

Modic
on 
Modb
us TC
P/IP

Modic
on 
Modb
us 
RTU

Omro
n 
Host 
Link

MP 177 
6" Touch

Yes Yes Yes Yes Yes Yes No Yes yes 3)4) Yes Yes 4) Yes yes 2)4) Yes 4)

MP 277 
8" Key

Yes Yes Yes Yes Yes Yes Yes Yes yes 3)4) Yes Yes 4) Yes yes 2)4) Yes 4)

MP 277 
10" Key

Yes Yes Yes Yes Yes Yes Yes Yes yes 3)4) Yes Yes 4) Yes yes 2)4) Yes 4)

MP 277 
10" 
Touch

Yes Yes Yes Yes Yes Yes Yes Yes yes 3)4) Yes Yes 4) Yes yes 2)4) Yes 4)

MP 377 
12" Key

Yes Yes Yes Yes Yes Yes Yes Yes yes 3)4) Yes Yes 4) Yes yes 2)4) Yes 4)

MP 377 
12" 
Touch

Yes Yes Yes Yes Yes Yes Yes Yes yes 3)4) Yes Yes 4) Yes yes 2)4) Yes 4)

MP 377 
15" 
Touch

Yes Yes Yes Yes Yes Yes Yes Yes yes 3)4) Yes Yes 4) Yes yes 2)4) Yes 4)

MP 377 
19" 
Touch

Yes Yes Yes Yes Yes Yes Yes Yes yes 3)4) Yes Yes 4) Yes yes 2)4) Yes 4)

1) OPC-XML DA Server
OPC-DA Client (Inproc)

2) only approved with RS 422-RS232 converter 
Order number: 6AV6 671-8XE00-0AX0

3) Direct communication with PLC 5 or KF2 module, otherwise only with RS422-RS232 
converter (option).
Order number: 6AV6 671-8XE00-0AX0

4) "PROFINET IO Enabled" must be disabled.
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Interfaces of Multi Panels

Device dependency of Multi Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.   

Table 10-152 Multi Panels

 MP 177 3) MP 277 3) MP 377 3)

SIMATIC S7 - PPI 1) IF1B IF1B IF1B
SIMATIC S7 - MPI IF1B IF1B IF1B
SIMATIC S7 - PROFIBUS IF1B IF1B IF1B
SIMATIC S7 - PROFINET ETHERNET ETHERNET ETHERNET
SIMATIC HMI HTTP protocol ETHERNET ETHERNET ETHERNET
OPC - ETHERNET ETHERNET
Allen-Bradley EtherNet/IP ETHERNET ETHERNET ETHERNET
Allen-Bradley DF1 IF1B 3) 4) 5) IF1B 3) 4) 5) IF1B 3) 4) 5)

Mitsubishi MC TCP/IP ETHERNET ETHERNET ETHERNET
Mitsubishi FX IF1B 3)5) IF1B 3)5) IF1B 3)5)

Modicon Modbus TCP ETHERNET ETHERNET ETHERNET
Modicon Modbus RTU IF1B 2) 3) 5) IF1B 2) 3) 5) IF1B 2) 3) 5)

Omron Host Link IF1B 3)5) IF1B 3)5) IF1B 3)5)

1) For SIMATIC S7-200 only
2) only with RS 422-RS232 converter (option)

Order number: 6AV6 671-8XE00-0AX0
3) For serial communication, deselect "Remote Control" of "Channel 1" in the "File > 

Transfer >Options" menu.
4) Direct communication with PLC5 or KF2 module, otherwise only approved with RS422-

RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0

5) "PROFINET IO Enabled" must be disabled.

Area pointers for Multi Panel

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions.

WinCC uses the following area pointers:
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● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointers

 MP 177 MP 277 MP 377
Screen number Yes Yes Yes
Data record Yes Yes Yes
Date/time Yes Yes Yes
Date/time PLC Yes Yes Yes
Coordination Yes Yes Yes
Project ID Yes Yes Yes
Job mailbox Yes Yes Yes

10.11.5.5 Mobile Panel

Communication drivers for Mobile Panels

Device dependency of Mobile Panels
The following table shows which communication drivers you can configure with the various 
Mobile Panels.                                         
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Communication drivers

HMI 
device
s

SIM
ATI
C S
7 15
00

SIM
ATI
C S
7 12
00

SIMA
TIC 
S7 
300/4
00

SIMA
TIC S
7 200

SIMA
TIC 
LOG
O!

SIMA
TIC 
HTT
P 
proto
col

OPC Allen-
Bradl
ey 
Ether
Net/
IP

Allen-
Bradl
ey 
DF1 

Mitsubi
shi MC 
TCP/IP

Mitsu
bishi 
FX

Modico
n 
Modbu
s TCP/
IP

Modico
n 
Modbu
s RTU

Omron 
Host Link

Mobile 
Panel 
177 6" 
DP

Yes 
2) 

Yes Yes Yes No No No No Yes 1) No Yes 
1) 

No Yes 1) Yes 1) 

Mobile 
Panel 
177 6" 
PN

Yes 
2) 

Yes Yes Yes Yes Yes No Yes No Yes No Yes No No

Mobile 
Panel 
277 8"

Yes Yes Yes Yes Yes Yes No Yes Yes 1) Yes Yes 1) Yes Yes 1) Yes 1) 

Mobile 
Panel 
277 8" 
IWLAN 
V2

Yes Yes Yes Yes Yes Yes No Yes No Yes No Yes No No

Mobile 
Panel 
277F 
8" 
IWLAN 
V2

Yes Yes Yes Yes Yes Yes No Yes No No No No No No

Mobile 
Panel 
277F 
8" 
IWLAN 
V2 
(RFID 
tag)

Yes Yes Yes Yes Yes Yes No Yes No No No No No No

Mobile 
Panel 
277 10"

Yes Yes Yes Yes Yes Yes No Yes Yes 1) Yes Yes 1) Yes Yes 1) Yes 1) 

1) "PROFINET IO Enabled" must be disabled.
2) You must activate "Access via PUT/GET communication" for communication with the 

SIMATIC S7 1500 PLC. 
Activate PUT/GET communication in the PLC properties at:
 "General > Security > Enable PUT/GET communication with remote partner (PLC, HMI, 
OPC, ...)"

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
4972 System Manual, 07/2013,  



Interfaces of Mobile Panels

Device dependency of Mobile Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.     

Table 10-153 Mobile Panels

 Mobile Panel 
177 DP 3)

Mobile Panel 
177 PN

Mobile Panel 
277 2)3)

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F V2 
IWLAN

Mobile Panel 
277F IWLAN 
V2 (RFID tag)

SIMATIC S7 - PPI 1) IF1B — IF1B — — —
SIMATIC S7 - MPI IF1B — IF1B — — —
SIMATIC S7 - 
PROFIBUS

IF1B — IF1B — — —

SIMATIC S7 - 
PROFINET

— ETHERNET ETHERNET ETHERNET ETHERNET ETHERNET

SIMATIC HMI 
HTTP protocol

— ETHERNET ETHERNET ETHERNET ETHERNET ETHERNET

OPC — — — ETHERNET ETHERNET ETHERNET
Allen-Bradley DF1 IF1A 3), IF1B 3) 

4) 6) (terminal 
box)

— IF1A 3), IF1B 3) 

4) 6) (terminal 
box)

— — —

Allen-Bradley 
EtherNet/IP

--- ETHERNET ETHERNET ETHERNET ETHERNET ETHERNET

Mitsubishi MC TCP/
IP

-- ETHERNET ETHERNET ETHERNET — —

Mitsubishi FX IF1A 3), IF1B 3) 
6) (terminal box)

— IF1A 3), IF1B 3) 
6) (terminal box)

— — —

Modicon 
Modbus RTU

IF1A 3), IF1B 3) 

5) 6) (terminal 
box)

— IF1A 3), IF1B 3) 

5) 6) (terminal 
box)

— — —

Modicon 
Modbus TCP/IP

— ETHERNET ETHERNET ETHERNET — —

Omron Host Link IF1A 3), IF1B 3) 
6) (terminal box)

— IF1A 3), IF1B 
3)6) (terminal 
box)

— — —

1) For SIMATIC S7-200 only
2) Depending on the terminal box used
3) For serial communication, deselect "Remote Control" of "Channel 1" in the "File > 

Transfer >Options" menu.
4) With PLC5 and KF2 module only         
5) Can be selected and used, but not approved.
6) "PROFINET IO Enabled" must be disabled.
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Area pointers for Mobile Panel

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions.

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointer

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile 
Panel 277 
IWLAN V2

Mobile 
Panel 277F 
IWLAN V2

Mobile 
Panel 277F 
IWLAN V2 
(RFID tag)

Mobile 
Panel 277

Screen number Yes Yes Yes Yes Yes Yes
Data record Yes Yes Yes Yes Yes Yes
Date/time Yes Yes Yes Yes Yes Yes
Date/time PLC Yes Yes Yes Yes Yes Yes
Coordination Yes Yes Yes Yes Yes Yes
Project ID Yes Yes Yes Yes Yes Yes
Job mailbox Yes Yes Yes Yes Yes Yes
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10.11.5.6 PC systems

Communication drivers for PC systems

Device dependency
The following table shows which communication drivers you can configure with the various 
Runtimes on a PC.                                         

Communication drivers

HMI 
device
s

SIM
ATI
C S
7 15
00

SIM
ATI
C S
7 12
00

SIMA
TIC 
S7 
300/4
00

SIMA
TIC S
7 200

SIMA
TIC 
LOG
O!

SIMA
TIC 
HTT
P 
proto
col

OPC Allen-
Bradl
ey 
Ether
Net/
IP

Allen-
Bradl
ey 
DF1 

Mitsubi
shi MC 
TCP/IP

Mitsu
bishi 
FX

Modico
n 
Modbu
s TCP/
IP

Modico
n 
Modbu
s RTU

Omron 
Host Link

WinCC 
RT 
Advanc
ed

Yes Yes Yes Yes Yes Yes Yes 1) Yes Yes Yes Yes Yes Yes Yes

WinCC 
RT 
Profes
sional

Yes Yes Yes No No No Yes 2) Yes No Yes No Yes No No

1) OPC-DA-Client, OPC-XML-DA-Client, OPC-UA(DA only) Client and OPC-DA-Server
2) OPC-DA-Client, OPC-XML-DA-Client and OPC-DA-Server, OPC-XML-DA-Server 

(optional),
OPC-HDA-Server (optional), OPC-AE-Server (optional) , OPC-UA(DA only)-Server

Interfaces for PC systems

Device dependency
The following table shows which HMI device interfaces are available for the communication 
driver protocols.         

 WinCC RT Advanced WinCC RT Professional
SIMATIC S7 - PPI MPI/DP 2) --
SIMATIC S7 - MPI MPI/DP 2) MPI/DP 2)

SIMATIC S7 - PROFIBUS MPI/DP 2) MPI/DP 2)

SIMATIC S7 - PROFINET ETHERNET ETHERNET
SIMATIC HMI HTTP protocol ETHERNET ETHERNET
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 WinCC RT Advanced WinCC RT Professional
OPC ETHERNET ETHERNET
Allen-Bradley EtherNet/IP ETHERNET ETHERNET
Allen-Bradley DF1 COM1 to COM4 1) --
Mitsubishi MC TCPI/IP ETHERNET ETHERNET
Mitsubishi FX COM1 to COM4 1) --
Modicon Modbus TCP/IP ETHERNET ETHERNET
Modicon Modbus RTU COM1 to COM4 1) --
Omron Host Link COM1 to COM4 1) --

1)  COM2 is blocked for Panel PC 477
2) ● in SIMATIC PC via integrated interface

● in Standard PC e.g. SIMATIC NET CP 5611 A2

Area pointers for PC systems

Introduction
Area pointers are parameter fields from which WinCC RT Advanced obtains information about 
the location and size of data areas in the PLC. During communication, the PLC and the HMI 
device alternately access these data areas for read and write operations. Based on the 
evaluation of data stored in the data areas, the PLC and HMI device initiate mutually defined 
actions.

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers.         

Table 10-154 WinCC RT Advanced

 WinCC RT Advanced
Screen number Yes
Data record Yes
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 WinCC RT Advanced
Date/time Yes
Date/time PLC Yes
Coordination Yes
Project ID Yes
Job mailbox Yes

10.11.5.7 Parallel communication 

Parallel communication of communication drivers 
The following table shows an overview of which communication drivers you can use 
simultaneously on one HMI device. 

 

 Note

Parallel communication is not approved for Basic Panels.
 

Parallel communication over Ethernet interfaces
The approved combinations can be operated via the same Ethernet interface. Several Ethernet 
interfaces are not required.

Parallel communication only concerns the Ethernet-based communication drivers.

 Allen-
Bradley
 
EtherN
et/IP

Mitsubi
shi MC 
TCP/IP

Modico
n 
Modbu
s 
TCPIP

OPC 
(DA/
XML 
DA)

OPC 
UA 
(DA)

SIMAT
IC 
LOGO
!

SIMAT
IC S7 2
00

SIMATI
C S7 30
0/400

SIMATI
C S7 12
00

SIMATI
C S7 
1500

SIMATI
C 
HTTP 
protoco
l

Sinume
rik NC

Allen-
Bradley
 
EtherN
et/IP

-- No No Yes Yes Yes Yes Yes Yes Yes Yes Yes

Mitsubi
shi MC 
TCP/IP

No -- No Yes Yes No No No No No Yes No

Modico
n 
Modbu
s 
TCPIP

No No -- Yes Yes No No No No No Yes No

OPC 
(DA/
XML 
DA)

Yes Yes Yes -- Yes Yes Yes Yes Yes Yes Yes Yes
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 Allen-
Bradley
 
EtherN
et/IP

Mitsubi
shi MC 
TCP/IP

Modico
n 
Modbu
s 
TCPIP

OPC 
(DA/
XML 
DA)

OPC 
UA 
(DA)

SIMAT
IC 
LOGO
!

SIMAT
IC S7 2
00

SIMATI
C S7 30
0/400

SIMATI
C S7 12
00

SIMATI
C S7 
1500

SIMATI
C 
HTTP 
protoco
l

Sinume
rik NC

OPC 
UA 
(DA)

Yes Yes Yes Yes -- Yes Yes Yes Yes Yes Yes Yes

SIMATI
C 
LOGO!

Yes No No Yes Yes -- Yes Yes Yes Yes Yes Yes

SIMATI
C S7 20
0

Yes No No Yes Yes Yes -- Yes Yes Yes Yes Yes

SIMATI
C S7 30
0/400

Yes No No Yes Yes Yes Yes -- Yes Yes Yes Yes

SIMATI
C S7 12
00

Yes No No Yes Yes Yes Yes Yes -- Yes Yes Yes

SIMATI
C S7 
1500

Yes No No Yes Yes Yes Yes Yes Yes -- Yes Yes

SIMATI
C 
HTTP 
protoco
l

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes -- Yes

Sinume
rik NC

Yes No No Yes Yes Yes Yes Yes Yes Yes Yes --

Parallel communication over serial interfaces
The following applies for parallel communication over serial interfaces:

● One communication driver per interface.

● One interface per communication driver.

10.11.6 Communicating with SIMATIC S7 1500

10.11.6.1 Communication with SIMATIC S7 1500

Introduction
This section describes the communication between an HMI device and the SIMATIC S7 1500 
PLC. 

You can configure the following communication channels for the SIMATIC S7 1500 PLC:     
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● PROFINET

● PROFIBUS

HMI connection for communication
Configure connections between the HMI device and a SIMATIC S7 1500 in the "Devices & 
Networks" Editor. 

10.11.6.2 Communication via PROFINET

Configuring an HMI connection

Communication via PROFINET

HMI connections via PROFINET
If you have inserted an HMI device and a SIMATIC S7 1500 into the project, interconnect the 
two PROFINET interfaces in the "Devices & Networks" editor.         

You can also connect multiple HMI devices to a single SIMATIC S7 1500 and multiple SIMATIC 
S7 1500 to a single HMI device. 

The maximum number of communication partners that you can connect to an HMI device is 
dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 
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HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1500 via 
PROFINET or Ethernet in the "Devices & Networks" editor.             

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with PROFINET or Ethernet interface

● SIMATIC S7 1500 with PROFINET interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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3. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the HMI device.

4. Click the connecting line.

5. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

6. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 4989)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1500. The IP 
address and subnet mask connection parameters are configured.

Configuring an HMI connection

Communication via PROFINET

Communication via PROFINET
This chapter describes  communication over PROFINET between a WinCC Runtime and the 
SIMATIC S7 1500 PLC.               
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You can use the following WinCC Runtimes as an HMI device:

● WinCC RT Advanced

WinCC Runtime as HMI device
Configure the HMI connections between a WinCC Runtime and SIMATIC S7 1500 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:

1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to a single SIMATIC S7 1500 and multiple SIMATIC 
S7 1500 to a single HMI device. 

The maximum number of communication partners that you can connect to an HMI device is 
dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 
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HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET with a PC

Introduction
You configure an HMI connection over PROFINET or Ethernet between HMI devices and a 
SIMATIC S7 1500 in the "Devices & Networks" editor.                           

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1500 with PROFINET interface

● PC station with WinCC RT Advanced
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Procedure
1. Double-click the "Devices & Networks" item in the project navigation.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFINET-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
4984 System Manual, 07/2013,  



4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the communication processor.

5. Click the connecting line.
The connection is displayed graphically in the Inspector window.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 4989)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1500. The IP 
address and subnet mask connection parameters are configured.
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Configuring an HMI connection via PROFINET with a SIMATIC PC

Introduction
You configure an HMI connection over PROFINET or Ethernet between HMI devices and 
SIMATIC S7 1500 in the "Devices & Networks" editor.                       

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1500 with PROFINET interface

● SIMATIC PC with PROFINET interface

Procedure
1. Double-click the "Devices & Networks" item in the project navigation.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.
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3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the PC.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 4989)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1500. The IP 
address and subnet mask connection parameters are configured.

PROFINET parameters

PROFINET parameters for the HMI connection

PROFINET parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection. 

Only limited changes are possible in this Inspector window.         
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Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Shows the name of the HMI connection.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFINET 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"
Displays the selected interface type. This area cannot be edited.

● "Subnet"
Displays the selected subnet. This area cannot be edited.
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● "Address"
Displays the selected IP address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFINET parameters for the HMI device

PROFINET parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.         

Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under "Properties > 
General".
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"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"IP protocol"
● "Set IP address in the project"

When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device. 

 

  Note

The device is automatically restarted in the case of HMI devices with the Windows CE 3.0 
operating system.

HMI devices with Windows CE 3.0:
● Mobile Panel 177 PN
● Mobile Panel 177 DP

 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.

● "Use IP router"
If you are using an IP router, select "Use IP router" and enter the router address in the 
"Router address" field.

● "Set IP address using a different method"
If the function "Set IP address using a different method" is activated, the IP address is not 
taken from the project. You have to enter the IP address directly in the Control Panel of the 
HMI device.

PROFINET parameters for the PLC

PROFINET parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.         
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Displaying and changing PROFINET parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"IP protocol"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "IP address"
You assign the IP address of the HMI device in the "IP address" area. 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.
If you are using an IP router, select "Use IP router" and enter the router address in the field.
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Protection of communication

Security levels
You can assign communication security levels to protect PLC and HMI device communication.

For an S7-1500 CPU, you can enter multiple passwords and thereby set up different access 
rights for various user groups.

The passwords are entered in a table, so that each password is assigned to exactly one 
protection level. 

The effect of the password is given in the "Protection" column.

Example
Select the "Complete protection" security level for a standard CPU (in other words, not an F-
CPU) and enter a separate password for each security level in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the assigned passwords, the effect depends on the table row in 
which the password occurs:

● The password in row 1 (no protection) allows access as if the CPU were completely 
unprotected.  Users who know this password have unrestricted access to the CPU.

● The password in row 2 (write protection) allows access as if the CPU were write-protected.  
Despite knowing the password, users who know this password only have read access to 
the CPU.

● The password in row 3 (read/write protection) allows access as if the CPU were read-
protected and write-protected, so that only HMI access is possible for users who know this 
password.

Access password for the HMI connection

Introduction    
Communication with a PLC with the"Complete protection" protection level is protected by a 
password. The password is stored in the properties of the PLC.

Enter the password from the PLC in the "Access password" area.

Communication to the PLC is denied if an incorrect or no password is entered.
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Entering the access password
Enter the access password for the HMI connection in the "Connections" editor.

Setting port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.
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Possible settings for transmission rate / duplex   
Depending on the selected device, you can make the following settings for "Transmission rate / 
duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the peer port. The "Enable autonegotiation" option is also enabled as a 
default, in other words, you can use cross cables or patch cables for the connection.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.

"Monitor" option   
This option enables or disables port diagnostics. Examples of port diagnostics: The link status 
is monitored, in other words, the diagnostics are generated during link-down and the system 
reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "   
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.

You must make sure the partner port has the same settings because with this option the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can accordingly not be optimally set.

 
 

 Note

When a local port is connected, STEP 7 makes the setting for the partner port if the partner 
port supports the setting. If the partner port does not accept the setting, an error message is 
generated. 
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Wiring rules for disabled autonegotiation

Requirements
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission rate

● Autonegotiation incl. autocrossing disabled

The time for negotiating the transmission rate during startup has been saved.

If you have disabled autonegotiation, you must observe the wiring rules.

Wiring rules for disabled autonegotiation    
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.
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Rules for cabling
You can connect several IO devices in line using a single cable type (patch cable). To do this, 
you connect port 2 of the IO device (distributed I/O) with port 1 of the next IO device. The 
following graphic gives an example with two IO devices.

Boundaries at the port

Requirements
To use boundaries, the respective device must have more than one port. If the PROFINET 
does not support boundary settings, they are not shown. 

Enable boundaries
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of discovery of accessible devices"
No forwarding of DCP frames to identify accessible devices. Devices downstream from this 
port cannot be reached by the project tree under "Accessible devices". Devices downstream 
from this port cannot be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) are not forwarded for topology detection.

● "End of sync domain"
No forwarding of sync frames transmitted to synchronize nodes within a sync domain. 
If you operate, for example, a PROFINET device with more than two ports in a ring, you 
should prevent the sync frame from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device from the other sync domain. 
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Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been determined for the port, the following check boxes cannot be 
used:

– "End of discovery of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

10.11.6.3 Communication via PROFIBUS

Configuring an HMI connection

Communication via PROFIBUS

HMI connections via PROFIBUS
If you have inserted an HMI device and a SIMATIC S7 1500 into the project, interconnect the 
two PROFIBUS interfaces in the "Devices & Networks" editor.       

HMI connection in the "Devices & Networks" editor 
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device in the 
"Connections" editor of the HMI device.
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Configuring an HMI connection via PROFIBUS

Introduction
You configure an HMI connection over PROFIBUS between HMI devices and a SIMATIC S7 
1500 in the "Devices & Networks" editor.         

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with MPI/DP interface

● SIMATIC S7 1500 with PROFIBUS interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button.
The devices available for connection are highlighted in color.

3. Click the HMI device interface.

4. Select the "PROFIBUS" interface type in the Inspector window under "Properties > General 
> HMI MPIDP > Parameters".
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5. Click the interface of the PLC and use a drag-and-drop operation to draw a connection to 
the HMI device.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5006)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection over PROFIBUS between an HMI device and a SIMATIC 
S7 1500.

Configuring an HMI connection

Communication via PROFIBUS

Communication via PROFIBUS
This chapter describes communication over PROFIBUS between a WinCC Runtime and the 
SIMATIC S7 1500 PLC.

You can use the following WinCC Runtimes as an HMI device:               

● WinCC RT Advanced

● WinCC RT Professional
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WinCC Runtime as HMI device
Configure the HMI connections between WinCC Runtime and SIMATIC S7 1500 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:

1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to a single SIMATIC S7 1500 and multiple SIMATIC 
S7 1500 to a single HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 
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HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFIBUS 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS with a PC

Introduction
You configure an HMI connection over PROFIBUS between the HMI device and SIMATIC S7 
1500 in the "Devices & Networks" editor.                               

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1500 with PROFIBUS interface

● PC station with WinCC RT Advanced or WinCC RT Professional

Procedure
1. Double-click the "Devices & Networks" item in the project navigation.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFIBUS-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFIBUS interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFIBUS interface of the communication processor.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5006)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection over PROFIBUS between an HMI device and a SIMATIC 
S7 1500.

Configuring an HMI connection via PROFIBUS with a SIMATIC PC

Introduction
You configure an HMI connection over PROFIBUS between HMI devices and a SIMATIC S7 
1500 in the "Devices & Networks" editor.                             

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1500 with PROFIBUS interface

● SIMATIC PC with PROFIBUS interface
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Procedure
1. Double-click the "Devices & Networks" item in the project navigation.

The available communication partners in the project are displayed in the network view.

2. Click the MPI interface of the PC and select "PROFIBUS" for the interface type in the 
Inspector window.

3. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

5. Click the PROFIBUS interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFIBUS interface of the PC.

6. Click the connecting line.
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7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5006)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection over PROFIBUS between an HMI device and a SIMATIC 
S7 1500.

PROFIBUS parameters

PROFIBUS parameters for the HMI connection

PROFIBUS parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.           

Only limited changes are possible in this Inspector window.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5004 System Manual, 07/2013,  



Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Displays whether the devices are networked together. 

 - displayed if the devices are networked together.

 - displayed if the devices are not networked together.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFIBUS 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.
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● "Interface type"
Displays the selected interface type. This area cannot be edited.

● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the PROFIBUS address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFIBUS parameters for the HMI device

PROFIBUS parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.           

Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under  "Properties > 
General > General".

"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.
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"Parameters"
● "Interface type"

You assign the interface type in the "Interface type" area. Depending on the HMI device 
type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

PROFIBUS parameters for the PLC

PROFIBUS parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.           

Displaying and changing PROFIBUS parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".
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"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

Protection of communication

Security levels
You can assign communication security levels to protect PLC and HMI device communication.

For an S7-1500 CPU, you can enter multiple passwords and thereby set up different access 
rights for various user groups.

The passwords are entered in a table, so that each password is assigned to exactly one 
protection level. 

The effect of the password is given in the "Protection" column.

Example
Select the "Complete protection" security level for a standard CPU (in other words, not an F-
CPU) and enter a separate password for each security level in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the assigned passwords, the effect depends on the table row in 
which the password occurs:

● The password in row 1 (no protection) allows access as if the CPU were completely 
unprotected.  Users who know this password have unrestricted access to the CPU.

● The password in row 2 (write protection) allows access as if the CPU were write-protected.  
Despite knowing the password, users who know this password only have read access to 
the CPU.

● The password in row 3 (read/write protection) allows access as if the CPU were read-
protected and write-protected, so that only HMI access is possible for users who know this 
password.
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Access password for the HMI connection

Introduction  
Secure access to a PLC by assigning a password.

Assign the password when configuring the connection.

Input of the password of the PLC is mandatory as of "Complete protection" security level. 

Communication to the PLC is denied if an incorrect password or no password is entered.

Assigning password
Enter the access password for the HMI connection in the "Connections" editor.

10.11.6.4 Data exchange

Data exchange using area pointers

General information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.
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Configuration of area pointers
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You can find more detailed information on configuring area pointers in:

Data exchange using area pointers (Page 4916) 

Restrictions
You can only configure the following data types for communication with SIMATIC S7 1500 for 
data exchange using area pointers:

● UInt and array of UInt

● Word and array of Word

● Int and array of Int

● "Array[0..15] of Bool" for area pointer "Coordination"

● Date_And_Time

● DTL and LDT

 

"Screen number" area pointer

Function     
The HMI device saves information about the screen called on the HMI device to the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. The 
PLC can trigger specific reactions such as the call of a different screen.

Use
Configure and enable the area pointer in "Communication > Connections" before you put it 
into use. You can create only one instance of the "Screen number" area pointer and only on 
one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.

Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1st word Current screen type
2nd word Current screen number
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 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
3rd word Reserved
4th word Current field number
5th word Reserved

 

● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

"Date/time" area pointer

Function     
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" or "40" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. All definitions are coded in BCD format.

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The date/time data area has the following structure:

Data word Most significant byte Least significant byte  
7       0 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved
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 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

Using data types
The data types "Date_And_Time, DTL" and "LDT" can only be used with the "Date/time" and 
"Date/time PLC" area pointers.

The data format of the "Date/time" area pointer depends on job mailbox 40/41. 

If there are no control tags linked to the area pointer, or a control tag is linked with the data 
type "Array[0..5] of UInt/Word/Int", the following applies: 

The configuration of the "Date/time" area pointer is only used for job mailbox 41.

If job mailbox 40 is used, the data format "DATE_AND_TIME (BCD-encoded)" is used (shown 
in the next section).

If the "Date/time" and "Date/time PLC" area pointers are linked to a control tag with the data 
type "DATE_AND_TIME", "DTL" or "LDT", the associated data format is used in the 
corresponding area pointer.

"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer. All definitions are coded in BCD format.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the Date/time area pointer in order to avoid 
any negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute, if the process allows this.

 

"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The date/time data area has the following structure:
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DATE_AND_TIME format (in BCD code)

Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC flexible and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

Using data types
The data types "Date_And_Time, DTL" and "LDT" can only be used with the "Date/time" and 
"Date/time PLC" area pointers.

The data format of the "Date/time" area pointer depends on job mailbox 40/41. 

If there are no control tags linked to the area pointer, or a control tag is linked with the data 
type "Array[0..5] of UInt/Word/Int", the following applies: 

The configuration of the "Date/time" area pointer is only used for job mailbox 41.

If job mailbox 40 is used, the data format "DATE_AND_TIME (BCD-encoded)" is used (shown 
in the next section).

If the "Date/time" and "Date/time PLC" area pointers are linked to a control tag with the data 
type "DATE_AND_TIME", "DTL" or "LDT", the associated data format is used in the 
corresponding area pointer.
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"Coordination" area pointer

Function  
The "Coordination" area pointer is used to implement the following functions:

● Detecting the startup of the HMI device in the control program

● Detecting the current operating mode of the HMI device in the control program

● Detecting whether the HMI device is ready to communicate in the control program

By default, the "Coordination" area pointer has the length of one word and cannot be changed.

Usage
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program can for this reason not make changes to the coordination area.

 

Assignment of the bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
status of the operating mode bit is "0" during normal operation of the HMI device. You can 
determine the current operating mode of the HMI device by reading this bit in the control 
program.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not there is still a connection to the HMI device by querying this bit in the control 
program.
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"Project ID" area pointer 

Function    
When Runtime starts it can check to see if the HMI device is connected to the correct PLC. 
This check is important when operating with several HMI devices.

For this, the HMI device compares a value stored on the PLC with the value specified in 
configuration. This ensures compatibility of the configuration data with the PLC program. If 
there is no concordance, a system event is given on the HMI device and Runtime is stopped.

Use
To use this area pointer, set up the following during the configuration:

● Define the version of configuration. Values between 1 and 255 are possible.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● Data address of the value for the version that is stored in the PLC:
You enter the data address in the editor "Communication > Connections" under "Address".

Connection failure    
A connection failure to a device on which the "project ID" area pointer is configured results in 
all the other connections of the device being switched to "offline".

This behavior has the following requirements:

● You have configured several connections in a project.

● You are using the "project ID" area pointer in at least one connection.

Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the engineering system.

 

"Job mailbox" area pointer 

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time
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Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Most significant byte Least significant byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.

Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Setting the date (BCD coded) 3) 4)

 Parameter 1 Left byte:  -
Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
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No
.

Function  

14 Set time (BCD-coded)
 (in the S7 format  DATE_AND_TIME)

An interval of at least 5 seconds must be maintained between two successive jobs to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 (In OP/MP format)

An interval of at least 5 seconds must be maintained between successive jobs to prevent overload 
of the HMI device.

 Parameter 1, 2, 3 -
46 Update tag
 Causes the HMI device to read the current value of the tags from the PLC whose update ID 

matches the value transferred in Parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Screen selection 2)

 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Reading data record from PLC  1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Writing data record to PLC 1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) Only for devices supporting recipes.
2) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job mailbox if 

the on-screen keyboard is active.
3) The weekday is ignored on HMI device KTP 600 BASIC PN.
4) The weekday is ignored when you configure the "Date/Time PLC" area pointer.
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"Data record" area pointer

"Data record" area pointer

Function  
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.

Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization via the data mailbox

Data records are always transferred directly, which means that the tag values are read straight 
from an address or written straight to an address configured for this tag without being redirected 
via an interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions

If the transfer of data records is triggered by a configured function or by a job mailbox, the 
recipe view on the HMI device remains operable. The data records are transferred in the 
background. 

Simultaneous processing of several transfer requests is, however, not possible. In this case, 
the HMI device rejects the other transfer requests with a system alarm. 

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5018 System Manual, 07/2013,  



Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then, for example, process, edit, 
or save these values in the HMI device. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. You can use this mechanism to prevent uncontrolled overwriting of data in either 
direction in your control program.     

Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Communication > Connections" editor in "Area pointer".

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the inspector window the option "Coordinated transfer of data records" 
under "General > Synchronization > Settings"
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Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data mailbox free
2 0000 0010 Transferring
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error

Sequence of a transfer triggered by a job mailbox
The transfer of data records between the HMI device and the PLC can be initiated by either 
one of these stations.  

The two job mailboxs No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data records from the PLC to the HMI device. The job mailbox is 
structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1 to 65535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1
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No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox No. 70 transfers data records from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data record.
Abort without 

return message.
3 The HMI device reads the values from the PLC and saves these to the 

data record defined in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 1100 
in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of writing to the PLC with job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

function from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order to enable 
further transfers.
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Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.

 

Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of error  
The section below shows possible error causes which lead to the cancellation of data record 
transfer: 

● Tag address not set up on the PLC

● Overwriting data records not possible
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● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system alarms

● Triggered by function
Output of system alarms

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
record.

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Advanced and Panels (Page 3237) 
 

 Note

The value is read out time-triggered for Basic Panels.
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Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.
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The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms   
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:
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Configuring Alarms (Page 3261) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 PLCs WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL, TIMER

How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device
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Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.

 

Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels Panel PCs:
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently
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10.11.6.5 Performance features of communication

S7-1500 device dependency

Device dependency
If you use devices from an earlier version of the TIA Portal with TIA Portal V12 SP1, it may not 
be possible to configure connections to certain HMI devices.

You can configure the SIMATIC S7-1500 controller with version V1.0 in the following scenarios:

TIA Portal Basic Panels Panels Comfort Panels RT Advanced
V11 No No Yes No
V12 Yes Yes Yes Yes

Valid data types for SIMATIC S7 1500

Valid data types for connections with SIMATIC S7 1500
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Length
BOOL 1 bit
BYTE 1 byte
WORD 2 bytes
DWORD 4 bytes
CHAR 1 byte
INT 2 bytes
DINT 4 bytes
REAL 4 bytes
TIME 4 bytes
DATE 2 bytes
TIME_OF_DAY 4 bytes
S5TIME 2 bytes
COUNTER 2 bytes
TIMER 2 bytes
DATE_AND_TIME 8 bytes
STRING (2+n) bytes, n = 0 to 254
DTL 12 bytes
LDT 8 bytes
LINT 8 bytes
LREAL 8 bytes
LTIME 8 bytes
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Data type Length
LTIME_OF_DAY 8 bytes
SINT 1 byte
UDINT 4 bytes
UINT 2 bytes
ULINT 8 bytes
USINT 1 byte

10.11.6.6 Configuring connections in the "Connections" editor

Creating a PROFINET connection

Requirements
● A project is open.

● An HMI device with a PROFINET interface has been created.     

Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".
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3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select a PROFINET interface of the HMI device in the Inspector window under "Parameters 
> Interface".

6. Set the IP addresses of the communication partners in the Inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Creating a PROFIBUS connection

Requirements
● A project is open.

● An HMI device with a PROFIBUS interface has been created.          
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select the "IF 1 B" interface from "Parameters > interface" in the Inspector window.
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6. Select the "DP" profile in the Inspector window under "Parameters > Network".

7. Set the addresses of the communication partners in the inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Connection parameters

Connection parameters

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.       

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used.
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PROFIBUS parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.   

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PROFIBUS network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         
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● "Address"
You set the PROFIBUS address of the HMI device under "Address". The PROFIBUS 
address must be unique in the PROFIBUS network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). 
In S7 200, you must set an HMI device as the master.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the network
Under "Network", you set the parameters for the PROFIBUS network to which the HMI device 
is linked.

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "DP", 
"Universal", or "Standard". The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual PROFIBUS address. The setting must 
be identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud in the OP 73 or the OP 77A, the highest station address 
must be less than or equal 63.

 

● "Number of masters"
For "Number of masters", set the number of masters in the PROFIBUS network. This 
information is necessary to correctly calculate the bus parameters. 
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.     

● "Address"
For "Address", set the PROFIBUS address of the S7 module (CPU, FM, or CP) to which 
the HMI device is connected.

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.

 

Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
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"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
Specifies the access point for the PG/PC interface that can be used to reach the 
communication partner.

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.

 

10.11.6.7 Configuring connections in the "Connections" editor

Creating a connection

Requirements
● A project is open.

● WinCC RT Advanced is created.        
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select an interface of the HMI device in the Inspector window under "Parameters > 
Interface".

6. Set the parameters for the connection in the Inspector window.

Interfaces
Select one of the following interfaces in the Inspector window under "Parameters > 
WinCC RT Advanced > Interfaces".:

● Industrial Ethernet

● MPI

● PROFIBUS

● PLC slot

● Soft PLC

● TCP/IP

For additional information on the parameters of the interfaces see:

Connection parameters (Page 5041) 
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Connection parameters

ETHERNET

Introduction
You assign the parameters for the HMI device and the controller in the network under 
"Parameters". 

The parameters described in the following apply to the following interfaces:

● TCP/IP

HMI device
● "Address"

Enter the IP address of the HMI device under "Address".

● "Access point"
Specifies the access point for the PG/PC interface that can be used to reach the 
communication partner.
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Controller
● "Address"

Enter the IP address of the controller under "Address".

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the controller.

 

 Note

You only need a password if you have set the "Complete protection" protection level at the 
controller.

No connection to the controller is established if the "Complete protection" protection level is 
stored on the controller and you do not enter a password.

 

MPI/DP

Introduction
You assign the parameters for the HMI device and the controller in the network under 
"Parameters". 

The parameters described in the following apply to the following interfaces:
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● PROFIBUS

HMI device
● "Baud rate"

Select the baud rate of the HMI device under "Baud rate".

● "Address"
Enter the address of the HMI device under "Address".

● "Access point"
Enter the logical device name under "Access point".

Controller
● "Address"

Enter the address of the controller under "Address".

● "Access password"
If you have configured the degree of protection "Complete protection" for the controller, 
enter the password for the controller under "Access password". 
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10.11.6.8 Configuring time synchronization

Time synchronization

Introduction 
To have the same time of day throughout the plant, you can synchronize the time on various 
plant components using time synchronization. WinCC time synchronization is operated as a 
master-slave system. 

One system component must be a clock for all components of a plant to work with identical 
time. The component functioning as the clock is referred to as the time master. The 
components that receive the time are time slaves.

Properties of time synchronization
● The HMI device can define the time as master or can accept the time of the PLC as slave.

● In "master mode", the time is synchronized at each connection setup.

● In "slave mode", the time is synchronized at each connection setup and than at cyclic 
intervals of 10 minutes.

● The first time synchronization is performed on the HMI device immediately after the start 
of runtime.

● Time synchronization is only performed on the HMI device during operation of runtime.

 

Time synchronization restrictions

Approved HMI devices  
You can configure the time synchronization between a SIMATIC S7 1200 or SIMATIC S7 1500 
and an HMI device with the following HMI devices:

Device Operating system
Basic Panels -
TP177 4" Windows CE 5.0
Multi Panel 177 Windows CE 5.0
Multi Panel 277 Windows CE 5.0
Multi Panel 377 Windows CE 5.0
Mobile Panel 277 Windows CE 5.0
Mobile 277 IWLAN V2 Windows CE 5.0
Comfort Panels Windows CE 6.0
PC systems with WinCC RT Advanced Microsoft Windows XP

Microsoft Windows 7
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Configuration restrictions
● If an HMI device has several connections to SIMATIC S7 1200 or SIMATIC S7 1500, you 

can only configure one connection as "slave".

● If you have enabled time synchronization for the HMI device as "slave", you can no longer 
use the global area pointer "Date/time PLC".

● An HMI device can only request the time from a PLC with "Complete protection" security 
type configuration if the correct "Access password" is configured.  
Configure the "Access password" for communication with a PLC with "Complete protection" 
security type in the "Connections" editor of the HMI device.
This "Access password" must match the password configured on the PLC. The PLC 
password is assigned in the PLC properties at:  "General > Security"

● Basic Panels can only be configured as "Slave".

● If you use Basic Panels for the configuration, it is not possible to use time synchronization 
via NTP and the "Date/time PLC" area pointer simultaneously.

Configuring time synchronization for integrated connections

Introduction   
You configure time synchronization for an integrated connection in the "Devices & Networks" 
editor.

Requirements
● An HMI connection between an HMI device and a SIMATIC S7 1200 or SIMATIC S7 1500 

has been configured.

● The HMI device must support the "time synchronization" function.

● The "Devices & Networks" editor is open.
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Procedure
1. Click the line of the HMI connection in the "Devices & networks" editor.

2. Select the following in the inspector window under "General > Time synchronization > 
Settings":

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.

Configuring time synchronization for non-integrated connections

Introduction  
You configure time synchronization for a non-integrated connection in the "Connections" editor.

Requirements
● An HMI device which supports the "time synchronization" function has been created.

● "Connections" editor is open.
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Procedure
1. Double-click "<Add>".

2. In the "Communication drivers" column, select the "SIMATIC S7 1200" PLC.

3. Select the following in the "HMI time synchronization mode" column:

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.

10.11.7 Communicating with SIMATIC S7 1200

10.11.7.1 Communication with SIMATIC S7 1200

Introduction
This section describes the communication between an HMI device and the SIMATIC S7 1200 
PLC. 

You can configure the following communication channels for the SIMATIC S7 1200 PLC:   
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● PROFINET

● PROFIBUS

HMI connection for communication
You configure connections between the HMI device and a SIMATIC S7 1200 in the "Devices 
& Networks" editor. If you have configured a HMI device with a serial port, you must configure 
a PROFIBUS-capable communication module to the SIMATIC S7 1200.

10.11.7.2 Communication via PROFINET

Configuring an HMI connection

Communication via PROFINET

HMI connections via PROFINET
If you have inserted an HMI device and a SIMATIC S7 1200 into the project, you interconnect 
the two PROFINET interfaces in the "Devices & Networks" editor.     

You can also connect multiple HMI devices to one SIMATIC S7 1200 and multiple SIMATIC 
S7 1200s to one HMI device. The maximum number of communication partners that you can 
connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 
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HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFINET or Ethernet in the "Devices & Networks" editor.       

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● HMI device with PROFINET or Ethernet interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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3. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the HMI device.

4. Click the connecting line.

5. Click "Highlight HMI connection" and select the HMI connection.

The connection is displayed graphically in the Inspector window.

6. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 5057)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
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Result
You have created a connection between an HMI device and a SIMATIC S7 1200. The IP 
address and subnet mask connection parameters are configured.

Configuring an HMI connection

Communication via PROFINET

Communication via PROFINET
This section describes the communication between a WinCC Runtime and the SIMATIC 
S7 1200 PLC via PROFINET.

You can use the following WinCC Runtimes as an HMI device:       

● WinCC RT Advanced

WinCC Runtime as HMI device
You configure the HMI connections between WinCC Runtime and SIMATIC S7 1200 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:
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1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 1200 and multiple SIMATIC 
S7 1200s to one HMI device. The maximum number of communication partners that you can 
connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFINET or Ethernet in the "Devices & Networks" editor.        

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● SIMATIC PC with PROFINET interface
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the PC.

5. Click the connecting line.
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6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 5057)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1200. The IP 
address and subnet mask connection parameters are configured.

Configuring an HMI connection via PROFINET with a PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFINET or Ethernet in the "Devices & Networks" editor.       

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● PC station with WinCC RT Advanced

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5053



Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a communication processor from the hardware 
catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the communication processor.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 5057)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1200. The IP 
address and subnet mask connection parameters are configured.

PROFINET parameters

PROFINET parameters for the HMI connection

PROFINET parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.       

Only limited changes are possible in this Inspector window.
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Displaying and editing HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

Connection
The "Connection" area displays the HMI connection created for communication between the 
devices.

You can edit the name of the HMI connection in this area.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFINET 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"
Displays the selected interface type. This area cannot be edited.
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● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the selected IP address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFINET parameters for the HMI device

PROFINET parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.     

Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under  "Properties > 
General > General".
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"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"IP protocol"
● "Set IP address in the project"

When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device. 

 

  Note

The device is automatically restarted in the case of HMI devices with the Windows CE 3.0 
operating system.

HMI devices with Windows CE 3.0:
● OP 77B
● TP 177B color PN/DP
● TP 177B mono DP
● OP 177B color PN/DP
● OP 177B mono DP
● Mobile Panel 177 PN
● Mobile Panel 177 DP
● TP 277 6"
● OP 277 6"

 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.

● "Use IP router"
If you are using an IP router, select "Use IP router" and enter the router address in the 
"Router address" field.

● "Set IP address using a different method"
If the function "Set IP address using a different method" is activated, the IP address is not 
taken from the project. You have to enter the IP address directly in the Control Panel of the 
HMI device.

PROFINET parameters for the PLC

PROFINET parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.    
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Displaying and changing PROFINET parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"IP protocol"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "IP address"
You assign the IP address of the HMI device in the "IP address" area. 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.
If you are using an IP router, select "Use IP router" and enter the router address in the field.
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Configuring Industrial Ethernet

Rules for the network configuration  
The Ethernet interfaces of the devices have a default IP address that you can change.

IP address  
The IP parameters are visible if the communication-capable devices support the TCP/IP 
protocol.

The IP address consists of 4 decimal figures in the range of 0 to 255. The decimal figures are 
separated from one another by a dot.

Example: 140.80.0.2 

The IP address consists of the following:

● The address of the (sub) net

● The address of the node (generally also called host or network node)

Subnet mask  
The subnet mask splits these two addresses. It determines which part of the IP address 
addresses the network and which part of the IP address addresses the node. 

The set bits of the subnet mask determine the network part of the IP address.

Example:

Subnet mask: 255.255.0.0 = 11111111.11111111.00000000.00000000

In the example given for the above IP address, the subnet mask shown here has the following 
meaning: 

The first 2 bytes of the IP address identify the subnet - i.e. 140.80. The last two bytes address 
the node, thus 0.2. 

It is generally true that: 

● The network address results from AND linking the IP address and subnet mask.

● The node address results from AND NOT linking the IP address and subnet mask.

Relation between IP address and default subnet mask  
An agreement exists relating to the assignment of IP address ranges and so-called "Default 
subnet masks". The first decimal number (from the left) in the IP address determines the 
structure of the default subnet mask. It determines the number of "1" values (binary) as follows:

IP address (decimal) IP address (binary) Address class Default subnet mask
0 to 126 0xxxxxxx.xxxxxxxx.... A 255.0.0.0
128 to 191 10xxxxxx.xxxxxxxx... B 255.255.0.0
192 to 223 110xxxxx.xxxxxxxx... C 255.255.255.0
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 Note
Range of values for the first decimal point

A value of between 224 and 255 is also possible for the first decimal number of the IP address 
(address class D etc). This is, however, not recommended because there is no address check 
for these values.

 

Masking other subnets  
You can use the subnet mask to add further structures and form "private" subnets for a subnet 
that is assigned one of the address classes A, B or C. This is done by setting other lower points 
of the subnet mask to "1". For each bit set to "1", the number of "private" networks doubles 
and the number of nodes they contain is halved. Externally, the network functions like an 
individual network as it did previously. 

Example:

You have a subnet of address class B (e.g. IP address 129.80.xxx.xxx) and change the default 
subnet mask as follows: 

Masks Decimal Binary
Default subnet mask 255.255.0.0 11111111.11111111.00000000.

00000000
Subnet mask 255.255.128.0 11111111.11111111.10000000.

00000000

Result: 

All nodes with addresses between 129.80.001.xxx and 129.80.127.xxx are on one subnet, all 
nodes with addresses between 129.80.128.xxx and 129.80.255.xxx are on another subnet.

Router  
The job of the routers is to connect the subnets. If an IP datagram is to be sent to another 
network, it first has to be conveyed to a router. To make this possible, in this case you have 
to enter the address of the router for each node in the subnet.

The IP address of a node in the subnet and the address of the router may only differ at the 
points at which there is a "0" in the subnet mask.

Configuring time synchronization for integrated connections

Introduction
You configure time synchronization for an integrated connection in the "Devices & Networks" 
editor.
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Requirements
● An HMI connection between an HMI device and a SIMATIC S7 1200 has been configured.

● The HMI device must support the "time synchronization" function.

● The "Devices & Networks" editor is open.

Procedure
1. Click the line of the HMI connection in the "Devices & networks" editor.

2. Select the following in the inspector window under "General > Time synchronization > 
Settings":

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.

Protection of communication

Security levels
You can assign communication security levels to protect PLC and HMI device communication.

For an S7-1500 CPU, you can enter multiple passwords and thereby set up different access 
rights for various user groups.

The passwords are entered in a table, so that each password is assigned to exactly one 
protection level. 

The effect of the password is given in the "Protection" column.

Example
Select the "Complete protection" security level for a standard CPU (in other words, not an F-
CPU) and enter a separate password for each security level in the table. 
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For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the assigned passwords, the effect depends on the table row in 
which the password occurs:

● The password in row 1 (no protection) allows access as if the CPU were completely 
unprotected.  Users who know this password have unrestricted access to the CPU.

● The password in row 2 (write protection) allows access as if the CPU were write-protected.  
Despite knowing the password, users who know this password only have read access to 
the CPU.

● The password in row 3 (read/write protection) allows access as if the CPU were read-
protected and write-protected, so that only HMI access is possible for users who know this 
password.

Access password for the HMI connection

Introduction  
Secure access to a PLC by assigning a password.

Assign the password when configuring the connection.

Input of the password of the PLC is mandatory as of "Complete protection" security level. 

Communication to the PLC is denied if an incorrect password or no password is entered.

Assigning password
Enter the access password for the HMI connection in the "Connections" editor.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5063



Setting port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.

Possible settings for transmission rate / duplex   
Depending on the selected device, you can make the following settings for "Transmission rate / 
duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the peer port. The "Enable autonegotiation" option is also enabled as a 
default, in other words, you can use cross cables or patch cables for the connection.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.

"Monitor" option   
This option enables or disables port diagnostics. Examples of port diagnostics: The link status 
is monitored, in other words, the diagnostics are generated during link-down and the system 
reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "   
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5064 System Manual, 07/2013,  



You must make sure the partner port has the same settings because with this option the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can accordingly not be optimally set.

 
 

 Note

When a local port is connected, STEP 7 makes the setting for the partner port if the partner 
port supports the setting. If the partner port does not accept the setting, an error message is 
generated. 

 

Wiring rules for disabled autonegotiation

Requirements
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission rate

● Autonegotiation incl. autocrossing disabled

The time for negotiating the transmission rate during startup has been saved.

If you have disabled autonegotiation, you must observe the wiring rules.

Wiring rules for disabled autonegotiation    
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.
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Rules for cabling
You can connect several IO devices in line using a single cable type (patch cable). To do this, 
you connect port 2 of the IO device (distributed I/O) with port 1 of the next IO device. The 
following graphic gives an example with two IO devices.

Boundaries at the port

Requirements
To use boundaries, the respective device must have more than one port. If the PROFINET 
does not support boundary settings, they are not shown. 

Enable boundaries
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of discovery of accessible devices"
No forwarding of DCP frames to identify accessible devices. Devices downstream from this 
port cannot be reached by the project tree under "Accessible devices". Devices downstream 
from this port cannot be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) are not forwarded for topology detection.

● "End of sync domain"
No forwarding of sync frames transmitted to synchronize nodes within a sync domain. 
If you operate, for example, a PROFINET device with more than two ports in a ring, you 
should prevent the sync frame from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device from the other sync domain. 
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Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been determined for the port, the following check boxes cannot be 
used:

– "End of discovery of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

10.11.7.3 Communication via PROFIBUS

Configuring an HMI connection

Communication via PROFIBUS

HMI connections via PROFIBUS
If you want to connect a SIMATIC S7 1200 to a HMI device via PROFIBUS, you must configure 
a PROFIBUS-capable communication module to a slot of the controller first.    

HMI connection in the "Devices & Networks" editor 
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device in the 
"Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFIBUS in the "Devices & Networks" editor.    

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with MPI/DP interface

● SIMATIC S7 1200

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button.
The devices available for connection are highlighted in color.

3. Use a drag-and-drop operation to move a PROFIBUS-capable communication module from 
the hardware catalog to the PLC.

4. Click the HMI device interface.

5. Select the "PROFIBUS" interface type in the Inspector window under "Properties > General 
> PROFIBUS address/ MPI address > Parameters".
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6. Click the interface of the communication module and use a drag-and-drop operation to draw 
a connection to the HMI device.

7. Click the name of the connection.
The connection is displayed graphically in the Inspector window.

8. Click "Highlight HMI connection" and select the HMI connection.

9. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5077)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 1200 via 
PROFIBUS.

Configuring an HMI connection

Communication via PROFIBUS

Communication via PROFIBUS
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
1200 PLC via PROFIBUS.      

You can use the following WinCC Runtimes as an HMI device:
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● WinCC RT Advanced

If you want to connect a SIMATIC S7 1200 to an HMI device via PROFIBUS, you must 
configure a PROFIBUS-capable communication module in a slot of the PLC.

WinCC Runtime as HMI device
You configure the HMI connections between WinCC Runtime and SIMATIC S7 1200 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:

1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 1200 and multiple SIMATIC 
S7 1200s to one HMI device. The maximum number of communication partners that you can 
connect to an HMI device is dependent on the HMI device used. 
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Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFIBUS 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFIBUS in the "Devices & Networks" editor.                 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● SIMATIC PC with PROFIBUS interface
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

3. Use a drag-and-drop operation to move a PROFIBUS-capable communication module from 
the hardware catalog to the PLC.

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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5. Click the PROFIBUS interface of the communication module and use a drag-and-drop 
operation to draw a connection to the PROFIBUS interface of the PC.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5077)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 1200 via 
PROFIBUS.

Configuring an HMI connection via PROFIBUS with a PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFIBUS in the "Devices & Networks" editor.         
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Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● PC station with WinCC RT Advanced

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFIBUS-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Use a drag-and-drop operation to move a PROFIBUS-capable communication module from 
the hardware catalog to the PLC.

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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5. Click the PROFIBUS interface of the communication module and use a drag-and-drop 
operation to draw a connection to the PROFIBUS interface of the communication processor.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5077)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 1200 via 
PROFIBUS.

PROFIBUS parameters

PROFIBUS parameters for the HMI connection

PROFIBUS parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.           

Only limited changes are possible in this Inspector window.
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Displaying and editing HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
The "Connection" area displays the HMI connection created for communication between the 
devices.

You can edit the name of the HMI connection in this area.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFIBUS 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"

Displays the selected interface type. This area cannot be edited.
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● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the PROFIBUS address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFIBUS parameters for the HMI device

PROFIBUS parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.      

Displaying and changing PROFIBUS parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under "Properties > 
General > General".
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"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

PROFIBUS parameters for the PLC

PROFIBUS parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.      
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Displaying and changing PROFIBUS parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.
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Bus profiles with PROFIBUS

Introduction   
Depending on the device types connected and protocols used on the PROFIBUS, different 
profiles are available. The profiles differ in terms of the setting options and calculation of bus 
parameters. The profiles are explained below.             

Devices with different profiles on the same PROFIBUS subnet   
The PROFIBUS subnet only functions without problem if the bus parameters of all devices 
have the same values. 

Profiles and transmission rates   

Profiles Supported transmission speeds in Kbits/s
DP 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000 
Standard 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000
Universal 9,6 19,2 93,75 187,5 500 1500

Meaning of profiles   

Profile Meaning
DP Select the "DP" bus profile when the only devices connected to the PROFIBUS 

subnet are those which satisfy the requirements of standard EN 50170 Volume 
2/3, Part 8-2 PROFIBUS. The bus parameter setting is optimized on these 
devices. 
This includes devices with DP master and DP slave interfaces of the SIMATIC 
S7 and distributed I/Os of other manufacturers. 

Standard Compared to the "DP" profile, the "Standard" profile also offers scope for 
devices of another project or devices which have not been configured here to 
be taken into account when calculating the bus parameters. The bus 
parameters are then calculated following a simple, non-optimized algorithm. 

Universal Select the "Universal" bus profile when individual devices on the PROFIBUS 
subnet use the PROFIBUS-FMS service. 
This includes the following devices for example: 
● CP 343-5
● PROFIBUS-FMS devices of other manufacturers
As with the "Standard" profile, this profile allows you to take other devices into 
account when calculating the bus parameters.
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Protection of communication

Security levels
You can assign communication security levels to protect PLC and HMI device communication.

For an S7-1500 CPU, you can enter multiple passwords and thereby set up different access 
rights for various user groups.

The passwords are entered in a table, so that each password is assigned to exactly one 
protection level. 

The effect of the password is given in the "Protection" column.

Example
Select the "Complete protection" security level for a standard CPU (in other words, not an F-
CPU) and enter a separate password for each security level in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the assigned passwords, the effect depends on the table row in 
which the password occurs:

● The password in row 1 (no protection) allows access as if the CPU were completely 
unprotected.  Users who know this password have unrestricted access to the CPU.

● The password in row 2 (write protection) allows access as if the CPU were write-protected.  
Despite knowing the password, users who know this password only have read access to 
the CPU.

● The password in row 3 (read/write protection) allows access as if the CPU were read-
protected and write-protected, so that only HMI access is possible for users who know this 
password.

Access password for the HMI connection

Introduction  
Secure access to a PLC by assigning a password.

Assign the password when configuring the connection.

Input of the password of the PLC is mandatory as of "Complete protection" security level. 

Communication to the PLC is denied if an incorrect password or no password is entered.
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Assigning password
Enter the access password for the HMI connection in the "Connections" editor.

10.11.7.4 Data exchange

Data exchange using area pointers

General information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.

Configuration of area pointers
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You can find more detailed information on configuring area pointers in:

Configuring area pointers (Page 4956) 
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Area pointer "Date/time"

Function       
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. 

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The date/time data area has the following structure:

Data word Most significant byte Least significant byte  
7       0 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.
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Permitted data types
You can use the following data types when you configure the "Date/Time" area pointer.

● Word

● UInt

● DTL

Use of the "DTL" data type
Use data type "DTL" with communication driver S7 1200. A tag of the "DTL" data type has a 
length of 12 bytes and saves information on date and time in a predefined structure.

The "DTL" data type has the following structure:

Byte Component Data type Value range
0 Year UINT 1970 to 2554
1
2 Month USINT 0 to 12
3 Day USINT 1 to 31
4 Day of week USINT 1(Sunday) to 7(Saturday)

The weekday is not considered in the value entry.
5 Hour USINT 0 to 23
6 Minute USINT 0 to 59
7 Second USINT 0 to 59
8 Nanoseconds UDINT 0 to 999 999 999
9
10
11

"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the date/time area pointer PLC to avoid any 
negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute, if the process allows this.
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"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The date/time data area has the following structure:

DATE_AND_TIME format (in BCD code)

Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC flexible and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

Permitted data types
You can use the following data types when you configure the "Date/Time PLC" area pointer:

● Word

● UInt

● DTL

Use of the "DTL" data type
Use data type "DTL" with communication driver S7 1200. A tag of the "DTL" data type has a 
length of 12 bytes and saves information on date and time in a predefined structure.

The "DTL" data type has the following structure:
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Byte Component Data type Value range
0 Year UINT 1970 to 2554
1
2 Month USINT 0 to 12
3 Day USINT 1 to 31
4 Day of week USINT 1(Sunday) to 7(Saturday)

The weekday is not considered in the value entry.
5 Hour USINT 0 to 23
6 Minute USINT 0 to 59
7 Second USINT 0 to 59
8 Nanoseconds UDINT 0 to 999 999 999
9
10
11

The HMI devices do not support the use of nanoseconds. Values in the nanosecond range will 
be ignored during processing in Runtime.

Area pointer "Coordination"

Function     
The "Coordination" area pointer is used to implement the following functions:

● Detecting the startup of the HMI device in the control program

● Detecting the current operating mode of the HMI device in the control program

● Detecting whether the HMI device is ready to communicate in the control program

By default, the "Coordination" area pointer has the length of one word and cannot be changed.

Usage
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program can for this reason not make changes to the coordination area.
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Assignment of the bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
status of the operating mode bit is "0" during normal operation of the HMI device. You can 
determine the current operating mode of the HMI device by reading this bit in the control 
program.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not there is still a connection to the HMI device by querying this bit in the control 
program.

Processing in the PLC
For a simpler evaluation in the PLC program, use a Bool array for this area pointer when using 
the SIMATIC S7 1200 communication driver. You will have to map the complete 16-bit word 
of the area pointer. Configure a tag of the data type "Array [0 .. 15] of bool" for this purpose.

Permitted data types
You can use the following data types when you configure the "Coordination" area pointer.

● Word

● UInt

● Bool
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Area pointer "Screen number"

Function     
The HMI devices store information about the screen called up on the HMI device in the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. Certain 
reactions can be triggered in the PLC, such as the call of a different screen.

Use
Before the "Screen number" area pointer can be used, it must be set up and activated by 
selecting "Communication ▶ Area pointer". You can create only one instance of the "Screen 
number" area pointer and only on one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.

Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1. Word Current screen type
2. Word Current screen number
3. Word Reserved
4th word Current field number
5. Word Reserved

 

● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

 

  Note
Device dependency

Permanent windows are not available on Basic Panels.
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Permitted data types
You can use the following data types when you configure the "Screen number" area pointer.

● Word

● UInt

Area pointer "Project ID"

Function     
When Runtime starts it can check to see if the HMI device is connected to the correct PLC. 
This check is important when operating with several HMI devices.

For this, the HMI device compares a value stored on the PLC with the value specified in 
configuration. This ensures compatibility of the configuration data with the PLC program. 

A missing compatibility results in a corresponding alarm and Runtime will not be started.

Use
To use this area pointer, set up the following during the configuration:

● Define the version of configuration. Values between 1 and 255 are possible.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● This is where you select the PLC tag or the tag array that you have configured as the data 
area for the area pointer.

Connection failure     
A connection failure to a device on which the "project ID" area pointer is configured results in 
all the other connections of the device being switched to "offline".

This behavior has the following requirements:

● You have configured several connections in a project.

● You are using the "project ID" area pointer in at least one connection.

Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the engineering system.

Permitted data types
You can use the following data types when you configure the "Project ID" area pointer.

● Word

● UInt
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Area pointer "Job mailbox"

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time

Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Most significant byte Least significant byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.

Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Set date (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
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No
.

Function  

14 Set time (BCD-coded)
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 An interval of at least 5 seconds must be maintained between two successive jobs to prevent 

overload of the HMI device.
 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 An interval of at least 5 seconds must be maintained between two successive jobs to prevent 

overload of the HMI device.
 Parameter 1, 2, 3 -
46 Update tag
 Causes the HMI device to read the current value of the tags from the PLC whose update ID 

matches the value transferred in Parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Clear event buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Clear error alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Display selection
 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Reading data record from PLC  1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Writing data record to PLC 1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -
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1) Only devices supporting recipes
2) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job mailbox if 

the on-screen keyboard is active.
3) The weekday is ignored on HMI device KTP 600 BASIC PN.

Permitted data types
You can use the following data types when you configure the "Screen number" area pointer:

● Word

● UInt

 

"Data record" area pointer

"Data mailbox" area pointer

Function     
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.

Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization over the data mailbox

Data records are always transferred directly. That is, the tag values are read from an address 
or written to an address configured for this tag directly, without redirecting the values by means 
of interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions

If the transfer of data records is triggered by a job mailbox, the data in the recipe view will be 
updated as well. Avoid operating the recipe view while job mailboxes for transfer of data records 
are being triggered. If you have already started editing a data record and a job mailbox is 
triggered for transfer of data records, then this job mailbox will be rejected. 
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Permitted data types
You can use the following data types when you configure the "Data record" area pointer.

● Word

● UInt

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example, when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.

Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then process, edit, or save these 
values, for example. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. Use this mechanism to prevent uncontrolled overwriting of data in either direction 
of your control program.     
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Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Connections ▶ Area pointer" editor.

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the inspector window the option "Coordinated transfer of data records" 
under "General > Synchronization > Settings"

Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data record free
2 0000 0010 Transfer is busy
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error
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Sequence of a transfer started by the operator in the recipe display

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data mailbox and sets the data record number 
to 0. 

Abort with system 
alarm.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
 

Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data mailbox.

Abort with system 
alarm.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized between the recipe view and tags and then written to 
the PLC.

 

3 The HMI device sets the status "Transfer completed."  
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.
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 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of the transfer triggered by a job mailbox
The transfer of data records between the HMI device and the PLC can be initiated by either 
one of these stations.  

The two job mailboxes No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data mailboxes from the PLC to the HMI device. The job mailbox 
is structured as follows:

 Most significant byte Least significant byte
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1

No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox no. 70 transfers data mailboxes from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Most significant byte Least significant byte
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified 

in the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
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Step Action
3 The HMI device reads the values and stores the values in the data 

record specified in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed". 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 
1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

Sequence writing to the PLC with job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified 

in the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

job from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The PLC program can now evaluate the transferred data. 

To allow further transfers, the PLC program must set the status word 
to 0 again.

 

Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
alarm.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.

 

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5097



Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
alarm.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of error  
The section below shows possible error causes which lead to the cancellation of data record 
transfer: 

● Tag address not set up on the PLC

● Overwriting data records not possible

● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".
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Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system alarms

● Triggered by function
Output of system alarms

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
mailbox.

 

 Note
Availability for specific devices

Notes in the status bar of the recipe view are not available in Basic Panels.
 

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Advanced and Panels (Page 3237) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.
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To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

See also
Trends (Page 3237)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.
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Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms   
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3260) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted
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Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 PLCs WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL, TIMER

How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels Panel PCs:
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

10.11.7.5 Performance features of communication

S7-1200 device dependency

Communication with the SIMATIC S7-1200 controller
If you use devices from an earlier version of the TIA Portal with TIA Portal V12 SP1, it may not 
be possible to configure integrated connections to certain HMI devices.
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Version V1.0
You can configure the SIMATIC S7-1200 controller with version V1.0 in the following scenarios:

TIA Portal Basic Panels Panels Comfort Panels RT Advanced
V11 Yes Yes No No
V12 No No No No

Version V2.0
You can configure the SIMATIC S7-1200 controller with version V2.0 in the following scenarios:

TIA Portal Basic Panels Panels Comfort Panels RT Advanced
V11 Yes Yes Yes Yes
V12 Yes Yes Yes Yes

Version V3.0
You can configure the SIMATIC S7-1200 controller with version V3.0 in the following scenarios:

TIA Portal Basic Panels Panels Comfort Panels RT Advanced
V11 Yes Yes Yes Yes
V12 Yes Yes Yes Yes

Version V4.0
You can configure the SIMATIC S7-1200 controller with version V4.0 in the following scenarios:

TIA Portal Basic Panels Panels Comfort Panels RT Advanced
V11 No No No No
V12 Yes Yes Yes Yes

Permitted data types for SIMATIC S7 1200 - V2

Permitted data types for connections with SIMATIC S7 1200 (V2)
The table lists the user data types that can be used when configuring tags and area pointers. 

Data type Length
BOOL 1-bit
SINT 1 byte
INT 2 bytes
DINT 4 bytes
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Data type Length
USINT 1 byte
UINT 2 bytes
UDINT 4 bytes
REAL 4 bytes
LREAL 8 bytes
TIME 4 bytes
DATE 2 bytes
DTL 12 bytes
TIME_OF_DAY, TOD 4 bytes
STRING (2+n) bytes, n = 0 to 254
CHAR 1 byte
BYTE 1 byte
WORD 2 bytes
DWORD 4 bytes

 

 

10.11.7.6 Creating connections in the "Connections" editor

Creating a PROFINET connection

Requirements
● A project is open.

● An HMI device with a PROFINET interface has been created.
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. In the "Communication drivers" column, select the "SIMATIC S7 1200" driver.

4. Click the name of the connection.
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5. Select a PROFINET interface of the HMI device in the Inspector window under "Parameters 
> Interface".

6. Set the IP addresses of the communication partners in the Inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Creating a PROFIBUS DP connection

Requirements
● A project is open.

● An HMI device with a PROFIBUS interface has been created.
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. In the "Communication drivers" column, select the "SIMATIC S7 1200" driver.

4. Click the name of the connection.

5. Select the "MPI/DP" interface in the Inspector window under "Parameters".
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6. Select the "DP" profile in the Inspector window under "Parameters > Network".

7. Set the addresses of the communication partners in the Inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Parameters for the connection

Parameters for the connection (SIMATIC S7 1200)

Parameters to be set
To assign the connection parameters, such as addresses and profiles, click the connection 
that you have created in the "Connections" editor.       

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used.
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Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
Specifies the access point for the PG/PC interface that can be used to reach the 
communication partner.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5112 System Manual, 07/2013,  



Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.

 

PROFIBUS parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.   

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PROFIBUS network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
You set the PROFIBUS address of the HMI device under "Address". The PROFIBUS 
address must be unique in the PROFIBUS network.
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● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). 
In S7 200, you must set an HMI device as the master.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the network
Under "Network", you set the parameters for the PROFIBUS network to which the HMI device 
is linked.

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "DP", 
"Universal", or "Standard". The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual PROFIBUS address. The setting must 
be identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud in the OP 73 or the OP 77A, the highest station address 
must be less than or equal 63.

 

● "Number of masters"
For "Number of masters", set the number of masters in the PROFIBUS network. This 
information is necessary to correctly calculate the bus parameters. 
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.     

● "Address"
For "Address", set the PROFIBUS address of the S7 module (CPU, FM, or CP) to which 
the HMI device is connected.

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.

 

10.11.7.7 Time synchronization

Time synchronization

Introduction 
To have the same time of day throughout the plant, you can synchronize the time on various 
plant components using time synchronization. WinCC time synchronization is operated as a 
master-slave system. 

One system component must be a clock for all components of a plant to work with identical 
time. The component functioning as the clock is referred to as the time master. The 
components that receive the time are time slaves.

Properties of time synchronization
● The HMI device can define the time as master or can accept the time of the PLC as slave.

● In "master mode", the time is synchronized at each connection setup.

● In "slave mode", the time is synchronized at each connection setup and than at cyclic 
intervals of 10 minutes.

● The first time synchronization is performed on the HMI device immediately after the start 
of runtime.

● Time synchronization is only performed on the HMI device during operation of runtime.
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Time synchronization restrictions

Approved HMI devices  
You can configure the time synchronization between a SIMATIC S7 1200 or SIMATIC S7 1500 
and an HMI device with the following HMI devices:

Device Operating system
Basic Panels -
TP177 4" Windows CE 5.0
Multi Panel 177 Windows CE 5.0
Multi Panel 277 Windows CE 5.0
Multi Panel 377 Windows CE 5.0
Mobile Panel 277 Windows CE 5.0
Mobile 277 IWLAN V2 Windows CE 5.0
Comfort Panels Windows CE 6.0
PC systems with WinCC RT Advanced Microsoft Windows XP

Microsoft Windows 7

Configuration restrictions
● If an HMI device has several connections to SIMATIC S7 1200 or SIMATIC S7 1500, you 

can only configure one connection as "slave".

● If you have enabled time synchronization for the HMI device as "slave", you can no longer 
use the global area pointer "Date/time PLC".

● An HMI device can only request the time from a PLC with "Complete protection" security 
type configuration if the correct "Access password" is configured.  
Configure the "Access password" for communication with a PLC with "Complete protection" 
security type in the "Connections" editor of the HMI device.
This "Access password" must match the password configured on the PLC. The PLC 
password is assigned in the PLC properties at:  "General > Security"

● Basic Panels can only be configured as "Slave".

● If you use Basic Panels for the configuration, it is not possible to use time synchronization 
via NTP and the "Date/time PLC" area pointer simultaneously.

Configuring time synchronization for integrated connections

Introduction
You configure time synchronization for an integrated connection in the "Devices & Networks" 
editor.
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Requirements
● An HMI connection between an HMI device and a SIMATIC S7 1200 has been configured.

● The HMI device must support the "time synchronization" function.

● The "Devices & Networks" editor is open.

Procedure
1. Click the line of the HMI connection in the "Devices & networks" editor.

2. Select the following in the inspector window under "General > Time synchronization > 
Settings":

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.

Configuring time synchronization for non-integrated connections

Introduction
You configure time synchronization for a non-integrated connection in the "Connections" editor.

Requirements
● An HMI device which supports the "time synchronization" function has been created.

● "Connections" editor is open.
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Procedure
1. Double-click "<Add>".

2. In the "Communication drivers" column, select the "SIMATIC S7 1200" PLC.

3. Select the following in the "HMI time synchronization mode" column:

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.

10.11.8 Communicating with SIMATIC S7 300/400

10.11.8.1 Communication with SIMATIC S7 300/400

Introduction
This section describes the communication between an HMI device and the SIMATIC S7 300 
and S7 400 PLCs. These two PLCs will be referred to jointly as SIMATIC S7 300/400.     
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You can configure the following communication channels for the SIMATIC S7 300/400 PLC:

● PROFINET

● PROFIBUS

● MPI

HMI connection for communication
You configure connections between the HMI device and a SIMATIC S7 300/400 in the "Devices 
& Networks" editor. 

10.11.8.2 Communication via PROFINET

Configuring an HMI connection

Communication via PROFINET

HMI connections via PROFINET
If you have inserted an HMI device and a SIMATIC S7 300/400 into the project, you 
interconnect the two PROFINET interfaces in the "Devices & Networks" editor.     

You can also connect multiple HMI devices to one SIMATIC S7 300/400 and multiple SIMATIC 
S7 300/400s to one HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 
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Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFINET or Ethernet in the "Devices & Networks" editor.       

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with PROFINET or Ethernet interface

● SIMATIC S7 300/400 with PROFINET interface.

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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3. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the HMI device.

4. Click the connecting line.

5. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

6. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 5130)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 300/400. The IP 
address and subnet mask connection parameters are configured.
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Configuring an HMI connection

Communication via PROFINET

Communication via PROFINET
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
300/400 PLC via PROFINET.      

You can use the following WinCC Runtimes as an HMI device:

● WinCC RT Advanced

WinCC Runtime as HMI device
You configure the HMI connections between WinCC Runtime and SIMATIC S7 300/400 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:
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1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 300/400 and multiple SIMATIC 
S7 300/400s to one HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.
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Configuring an HMI connection via PROFINET with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFINET or Ethernet in the "Devices & Networks" editor.         

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with PROFINET interface

● SIMATIC PC with PROFINET interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.
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3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the PC.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 5130)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 300/400. The IP 
address and subnet mask connection parameters are configured.
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Configuring an HMI connection via PROFINET with a PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFINET or Ethernet in the "Devices & Networks" editor.          

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with PROFINET interface

● PC station with WinCC RT Advanced
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Use a drag-and-drop operation to move a PROFINET-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the communication processor.
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5. Click the connecting line.
The connection is displayed graphically in the Inspector window.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 5130)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 300/400. The IP 
address and subnet mask connection parameters are configured.

PROFINET parameters

PROFINET parameters for the HMI connection

PROFINET parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection. 

Only limited changes are possible in this Inspector window.         
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Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Displays whether the devices are networked together. 

 - displayed if the devices are networked together.

 - displayed if the devices are not networked together.
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"Connection path"
The communication partners of the selected HMI connection and the associated PROFINET 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"
Displays the selected interface type. This area cannot be edited.

● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the selected IP address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFINET parameters for the HMI device

PROFINET parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.     
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Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under "Properties > 
General".

"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.
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"IP protocol"
● "Set IP address in the project"

When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device. 

 

  Note

The device is automatically restarted in the case of HMI devices with the Windows CE 3.0 
operating system.

HMI devices with Windows CE 3.0:
● OP 77B
● TP 177B color PN/DP
● TP 177B mono DP
● OP 177B color PN/DP
● OP 177B mono DP
● Mobile Panel 177 PN
● Mobile Panel 177 DP
● TP 277 6"
● OP 277 6"

 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.

● "Use IP router"
If you are using an IP router, select "Use IP router" and enter the router address in the 
"Router address" field.

● "Set IP address using a different method"
If the function "Set IP address using a different method" is activated, the IP address is not 
taken from the project. You have to enter the IP address directly in the Control Panel of the 
HMI device.

PROFINET parameters for the PLC

PROFINET parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.     
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Displaying and changing PROFINET parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"IP protocol"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "IP address"
You assign the IP address of the HMI device in the "IP address" area. 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.
If you are using an IP router, select "Use IP router" and enter the router address in the field.
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Configuring Industrial Ethernet

Rules for the network configuration  
The Ethernet interfaces of the devices have a default IP address that you can change.

IP address  
The IP parameters are visible if the communication-capable devices support the TCP/IP 
protocol.

The IP address consists of 4 decimal figures in the range of 0 to 255. The decimal figures are 
separated from one another by a dot.

Example: 140.80.0.2 

The IP address consists of the following:

● The address of the (sub) net

● The address of the node (generally also called host or network node)

Subnet mask  
The subnet mask splits these two addresses. It determines which part of the IP address 
addresses the network and which part of the IP address addresses the node. 

The set bits of the subnet mask determine the network part of the IP address.

Example:

Subnet mask: 255.255.0.0 = 11111111.11111111.00000000.00000000

In the example given for the above IP address, the subnet mask shown here has the following 
meaning: 

The first 2 bytes of the IP address identify the subnet - i.e. 140.80. The last two bytes address 
the node, thus 0.2. 

It is generally true that: 

● The network address results from AND linking the IP address and subnet mask.

● The node address results from AND NOT linking the IP address and subnet mask.

Relation between IP address and default subnet mask  
An agreement exists relating to the assignment of IP address ranges and so-called "Default 
subnet masks". The first decimal number (from the left) in the IP address determines the 
structure of the default subnet mask. It determines the number of "1" values (binary) as follows:

IP address (decimal) IP address (binary) Address class Default subnet mask
0 to 126 0xxxxxxx.xxxxxxxx.... A 255.0.0.0
128 to 191 10xxxxxx.xxxxxxxx... B 255.255.0.0
192 to 223 110xxxxx.xxxxxxxx... C 255.255.255.0
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 Note
Range of values for the first decimal point

A value of between 224 and 255 is also possible for the first decimal number of the IP address 
(address class D etc). This is, however, not recommended because there is no address check 
for these values.

 

Masking other subnets  
You can use the subnet mask to add further structures and form "private" subnets for a subnet 
that is assigned one of the address classes A, B or C. This is done by setting other lower points 
of the subnet mask to "1". For each bit set to "1", the number of "private" networks doubles 
and the number of nodes they contain is halved. Externally, the network functions like an 
individual network as it did previously. 

Example:

You have a subnet of address class B (e.g. IP address 129.80.xxx.xxx) and change the default 
subnet mask as follows: 

Masks Decimal Binary
Default subnet mask 255.255.0.0 11111111.11111111.00000000.

00000000
Subnet mask 255.255.128.0 11111111.11111111.10000000.

00000000

Result: 

All nodes with addresses between 129.80.001.xxx and 129.80.127.xxx are on one subnet, all 
nodes with addresses between 129.80.128.xxx and 129.80.255.xxx are on another subnet.

Router  
The job of the routers is to connect the subnets. If an IP datagram is to be sent to another 
network, it first has to be conveyed to a router. To make this possible, in this case you have 
to enter the address of the router for each node in the subnet.

The IP address of a node in the subnet and the address of the router may only differ at the 
points at which there is a "0" in the subnet mask.
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Setting port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.

Possible settings for transmission rate / duplex   
Depending on the selected device, you can make the following settings for "Transmission rate / 
duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the peer port. The "Enable autonegotiation" option is also enabled as a 
default, in other words, you can use cross cables or patch cables for the connection.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.

"Monitor" option   
This option enables or disables port diagnostics. Examples of port diagnostics: The link status 
is monitored, in other words, the diagnostics are generated during link-down and the system 
reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "   
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.
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You must make sure the partner port has the same settings because with this option the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can accordingly not be optimally set.

 
 

 Note

When a local port is connected, STEP 7 makes the setting for the partner port if the partner 
port supports the setting. If the partner port does not accept the setting, an error message is 
generated. 

 

Wiring rules for disabled autonegotiation

Requirements
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission rate

● Autonegotiation incl. autocrossing disabled

The time for negotiating the transmission rate during startup has been saved.

If you have disabled autonegotiation, you must observe the wiring rules.

Wiring rules for disabled autonegotiation    
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.
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Rules for cabling
You can connect several IO devices in line using a single cable type (patch cable). To do this, 
you connect port 2 of the IO device (distributed I/O) with port 1 of the next IO device. The 
following graphic gives an example with two IO devices.

Boundaries at the port

Requirements
To use boundaries, the respective device must have more than one port. If the PROFINET 
does not support boundary settings, they are not shown. 

Enable boundaries
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of discovery of accessible devices"
No forwarding of DCP frames to identify accessible devices. Devices downstream from this 
port cannot be reached by the project tree under "Accessible devices". Devices downstream 
from this port cannot be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) are not forwarded for topology detection.

● "End of sync domain"
No forwarding of sync frames transmitted to synchronize nodes within a sync domain. 
If you operate, for example, a PROFINET device with more than two ports in a ring, you 
should prevent the sync frame from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device from the other sync domain. 
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Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been determined for the port, the following check boxes cannot be 
used:

– "End of discovery of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

10.11.8.3 Communication via PROFIBUS

Configuring an HMI connection

Communication via PROFIBUS

HMI connections via PROFIBUS
If you have inserted an HMI device and a SIMATIC S7 300/400 into the project, you 
interconnect the two PROFIBUS interfaces in the "Devices & Networks" editor.    

HMI connection in the "Devices & Networks" editor 
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device in the 
"Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFIBUS in the "Devices & Networks" editor.     

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with MPI/DP interface

● SIMATIC S7 300/400 with PROFIBUS interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button.
The devices available for connection are highlighted in color.

3. Click the HMI device interface.

4. Select the "PROFIBUS" interface type in the Inspector window under "Properties > General 
> HMI MPIDP > Parameters".
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5. Click the interface of the PLC and use a drag-and-drop operation to draw a connection to 
the HMI device.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5149)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
PROFIBUS.

Configuring an HMI connection

Communication via PROFIBUS

Communication via PROFIBUS
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
300/400 PLC via PROFIBUS.      

You can use the following WinCC Runtimes as an HMI device:

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5141



● WinCC RT Advanced

● WinCC RT Professional

WinCC Runtime as HMI device
You configure the HMI connections between WinCC Runtime and SIMATIC S7 300/400 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:

1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 300/400 and multiple SIMATIC 
S7 300/400s to one HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 
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Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFIBUS 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFIBUS in the "Devices & Networks" editor.         

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with PROFIBUS interface

● SIMATIC PC with PROFIBUS interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Click the MPI interface of the PC and select "PROFIBUS" for the interface type in the 
Inspector window.
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3. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

5. Click the PROFIBUS interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFIBUS interface of the PC.

6. Click the connecting line.
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7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5149)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
PROFIBUS.

Configuring an HMI connection via PROFIBUS with a PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFIBUS in the "Devices & Networks" editor. 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400

● PC station with WinCC RT Advanced
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFIBUS-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

4. Click the PROFIBUS interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFIBUS interface of the communication processor.
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5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 5149)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 1200 via 
PROFIBUS.

PROFIBUS parameters

PROFIBUS parameters for the HMI connection

PROFIBUS parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.           

Only limited changes are possible in this Inspector window.
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Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Displays whether the devices are networked together. 

 - displayed if the devices are networked together.

 - displayed if the devices are not networked together.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFIBUS 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area is not editable.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.
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● "Interface type"
Displays the selected interface type. This area is not editable.

● "Subnet"
Displays the selected subnet. This area is not editable.

● "Address"
Displays the PROFIBUS address of the device. This area is not editable.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFIBUS parameters for the HMI device

PROFIBUS parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.      

Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under  "Properties > 
General > General".
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"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"Parameters"
● "Interface type"

You assign the interface type in the "Interface type" area. Depending on the HMI device 
type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

PROFIBUS parameters for the PLC

PROFIBUS parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.      
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Displaying and changing PROFIBUS parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.
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Bus profiles with PROFIBUS

Introduction   
Depending on the device types connected and protocols used on the PROFIBUS, different 
profiles are available. The profiles differ in terms of the setting options and calculation of bus 
parameters. The profiles are explained below.             

Devices with different profiles on the same PROFIBUS subnet   
The PROFIBUS subnet only functions without problem if the bus parameters of all devices 
have the same values. 

Profiles and transmission rates   

Profiles Supported transmission speeds in Kbits/s
DP 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000 
Standard 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000
Universal 9,6 19,2 93,75 187,5 500 1500

Meaning of profiles   

Profile Meaning
DP Select the "DP" bus profile when the only devices connected to the PROFIBUS 

subnet are those which satisfy the requirements of standard EN 50170 Volume 
2/3, Part 8-2 PROFIBUS. The bus parameter setting is optimized on these 
devices. 
This includes devices with DP master and DP slave interfaces of the SIMATIC 
S7 and distributed I/Os of other manufacturers. 

Standard Compared to the "DP" profile, the "Standard" profile also offers scope for 
devices of another project or devices which have not been configured here to 
be taken into account when calculating the bus parameters. The bus 
parameters are then calculated following a simple, non-optimized algorithm. 

Universal Select the "Universal" bus profile when individual devices on the PROFIBUS 
subnet use the PROFIBUS-FMS service. 
This includes the following devices for example: 
● CP 343-5
● PROFIBUS-FMS devices of other manufacturers
As with the "Standard" profile, this profile allows you to take other devices into 
account when calculating the bus parameters.
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10.11.8.4 Communication via MPI

Configuring an HMI connection

Communication via MPI

HMI connections via MPI
If you have inserted an HMI device and a SIMATIC S7 300/400 into the project, you 
interconnect the two MPI interfaces in the "Devices & Networks" editor.    

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device in the 
"Connections" editor of the HMI device.

Configuring an HMI connection via MPI

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via MPI 
in the "Devices & Networks" editor.     
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Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with MPI/DP interface

● SIMATIC S7 300/400 with MPI/DP interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button.
The devices available for connection are highlighted in color.

3. Click the interface of the PLC and use a drag-and-drop operation to draw a connection to 
the HMI device.
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4. Click the connecting line.
The connection is displayed graphically in the Inspector window.

5. Click "Highlight HMI connection" and select the HMI connection.

6. Click the communication partners in the "Network view" and change the MPI parameters 
in the Inspector window according to the requirements of your project.
See the chapter "MPI parameters (Page 5162)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. Use the table to monitor the connection parameters and change the 
connection partner. You can change the local name for the connection only in the table.

 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
MPI.

Configuring an HMI connection

Communication via MPI

Communication via MPI
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
300/400 PLC via MPI.    

You can use the following WinCC Runtimes as an HMI device:

● WinCC RT Advanced

WinCC Runtime as HMI device
You configure the HMI connections between WinCC Runtime and SIMATIC S7 300/400 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:
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1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 300/400 and multiple SIMATIC 
S7 300/400s to one HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via MPI in the "Devices 
& Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via MPI in the 
"Connections" editor of the HMI device.

Configuring an HMI connection via MPI with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFIBUS in the "Devices & Networks" editor.         

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with MPI interface

● SIMATIC PC with MPI interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the MPI interface of the PLC and use a drag-and-drop operation to draw a connection 
to the MPI interface of the PC.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the MPI parameters 
in the Inspector window according to the requirements of your project.
See the chapter "MPI parameters (Page 5162)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
MPI.

Configuring an HMI connection via MPI with a PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via MPI 
in the "Devices & Networks" editor.        
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Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with MPI interface

● PC station with WinCC RT Advanced

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFIBUS-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the PROFIBUS interface of the communication processor and change the interface 
to "MPI".

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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5. Click the MPI interface of the PLC and use a drag-and-drop operation to draw a connection 
to the MPI interface of the communication processor.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the MPI parameters 
in the Inspector window according to the requirements of your project.
See the chapter "MPI parameters (Page 5162)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
MPI.

MPI parameters

MPI parameters for the HMI connection

MPI parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.           

Only limited changes are possible in this Inspector window.
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Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Displays whether the devices are networked together. 

 - displayed if the devices are networked together.

 - displayed if the devices are not networked together.

"Connection path"
The communication partners of the selected HMI connection and the associated MPI 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the name of the device. This area is not editable.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.
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● "Interface type"
Displays the selected interface type. This area is not editable.

● "Subnet"
Displays the selected subnet. This area is not editable.

● "Address"
Displays the MPI address of the device. This area is not editable.

● "Find connection path" button
Enables the subsequent specification of connections. 

MPI parameters for the HMI device

MPI parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.      

Displaying and changing MPI parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under  "Properties > 
General > General".
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"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"Parameters"
● "Interface type"

You assign the interface type in the "Interface type" area. Depending on the HMI device 
type, you have various interfaces to choose from.

● "Address"
You assign the MPI address of the HMI device in the "Address" area. The MPI address 
must be unique throughout the MPI network.

● "Highest address"
The "Highest address" area displays the highest address of the MPI network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

MPI parameters for the PLC

MPI parameters for the PLC
An overview of the configured parameters can be found in the properties for the PLC.      
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Displaying and changing PROFIBUS parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the HMI device is 
connected to the network. You use the "Add new subnet" button to create a new subnet.

"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the MPI address of the HMI device in the "Address" area. The MPI address 
must be unique throughout the MPI network.

● "Highest address"
The "Highest address" area displays the highest address of the MPI network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.
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Addressing of the PLC via MPI

Introduction
     

Each communication partner must be assigned an MPI network address.

Each S7 module which supports communication functions and is operated the SIMATIC 
S7-300/400 PLC is assigned a unique MPI address. Only one CPU may be used per rack. 

 

 Note
HMI devices cannot be operated with incorrect addressing

Always avoid redundant addressing on the MPI bus.
 

MPI address of the communication partner of a SIMATIC S7-300
When assigning addresses, you have to distinguish between communication partners with and 
without separate MPI address.    

● If the communications partner has its own MPI address, you only need to define the MPI 
address.

● If the communication partners do not have a separate MPI address, specify the MPI address 
of the communications partner used for the connection. In addition, define the slot and rack 
of a communication partner without its own MPI address.

MPI address of the communication partner of a SIMATIC S7-400
Only S7 modules with an MPI connector are assigned an MPI address. Modules without an 
MPI connector are addressed indirectly:    

● MPI address of the module to which the HMI is connected.

● The slot and the rack of the module with which the HMI device communicates.

10.11.8.5 Data exchange

Data exchange using area pointers

General information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 
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The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.

Configuration of area pointers
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You can find more detailed information on configuring area pointers in:

Configuring area pointers (Page 4956) 

"Screen number" area pointer 

Function     
The HMI device saves information about the screen called on the HMI device to the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. The 
PLC can trigger specific reactions such as the call of a different screen.

Use
Configure and enable the area pointer in "Communication > Connections" before you put it 
into use. You can create only one instance of the "Screen number" area pointer and only on 
one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.

Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1st word Current screen type
2nd word Current screen number
3rd word Reserved
4th word Current field number
5th word Reserved
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● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

"Date/time" area pointer

Function     
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" or "40" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. All definitions are coded in BCD format.

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The date/time data area has the following structure:

Data word Most significant byte Least significant byte  
7       0 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved
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 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer. All definitions are coded in BCD format.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the Date/time area pointer in order to avoid 
any negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute, if the process allows this.

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The date/time data area has the following structure:

DATE_AND_TIME format (in BCD code)

Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)
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Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC flexible and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

"Coordination" area pointer

Function    
The "Coordination" area pointer is used to implement the following functions:

● Detecting the startup of the HMI device in the control program

● Detecting the current operating mode of the HMI device in the control program

● Detecting whether the HMI device is ready to communicate in the control program

By default, the "Coordination" area pointer has the length of one word and cannot be changed.

Application
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program can for this reason not make changes to the coordination area.

 

Assignment of bits in the "Coordination" area pointer
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Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
status of the operating mode bit is "0" during normal operation of the HMI device. You can 
determine the current operating mode of the HMI device by reading this bit in the control 
program.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not there is still a connection to the HMI device by querying this bit in the control 
program.

"Project ID" area pointer

Function    
When Runtime starts it can check to see if the HMI device is connected to the correct PLC. 
This check is important when operating with several HMI devices.

For this, the HMI device compares a value stored on the PLC with the value specified in 
configuration. This ensures compatibility of the configuration data with the PLC program. If 
there is no concordance, a system event is given on the HMI device and Runtime is stopped.

Use
To use this area pointer, set up the following during the configuration:

● Define the version of configuration. Values between 1 and 255 are possible.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● Data address of the value for the version that is stored in the PLC:
You enter the data address in the editor "Communication > Connections" under "Address".

Connection failure    
A connection failure to a device on which the "project ID" area pointer is configured results in 
all the other connections of the device being switched to "offline".

This behavior has the following requirements:

● You have configured several connections in a project.

● You are using the "project ID" area pointer in at least one connection.

Causes which may set connections "offline":
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● The PLC is not available.

● The connection has been switched offline in the engineering system.

 

"Job mailbox" area pointer

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time

Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Most significant byte Least significant byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.

Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Setting the date (BCD coded) 3) 4)
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No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 (in the S7 format  DATE_AND_TIME)

An interval of at least 5 seconds must be maintained between two successive jobs to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 (In OP/MP format)

An interval of at least 5 seconds must be maintained between successive jobs to prevent overload 
of the HMI device.

 Parameter 1, 2, 3 -
46 Update tag
 Causes the HMI device to read the current value of the tags from the PLC whose update ID 

matches the value transferred in Parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Screen selection 2)

 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Reading data record from PLC  1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
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No
.

Function  

14 Set time (BCD-coded)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Writing data record to PLC 1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) Only for devices supporting recipes.
2) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job mailbox if 

the on-screen keyboard is active.
3) The weekday is ignored on HMI device KTP 600 BASIC PN.
4) The weekday is ignored when you configure the "Date/Time PLC" area pointer.

"Data record" area pointer

"Data record" area pointer

Function  
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.

Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization via the data mailbox

Data records are always transferred directly, which means that the tag values are read straight 
from an address or written straight to an address configured for this tag without being redirected 
via an interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions
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If the transfer of data records is triggered by a configured function or by a job mailbox, the 
recipe view on the HMI device remains operable. The data records are transferred in the 
background. 

Simultaneous processing of several transfer requests is, however, not possible. In this case, 
the HMI device rejects the other transfer requests with a system alarm. 

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.

Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then, for example, process, edit, 
or save these values in the HMI device. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. You can use this mechanism to prevent uncontrolled overwriting of data in either 
direction in your control program.     
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Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Communication > Connections" editor in "Area pointer".

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the inspector window the option "Coordinated transfer of data records" 
under "General > Synchronization > Settings"

Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data mailbox free
2 0000 0010 Transferring
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error
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Sequence of a transfer started by the operator in the recipe view

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data record and sets the data record number to 
0. 

Abort with system 
event.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
 

Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data record.

Abort with system 
event.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized between the recipe view and tags and then written to 
the PLC.

 

3 The HMI device sets the status "Transfer completed."  
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.
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 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of the transfer triggered by a job mailbox
The transfer of data records between the HMI device and the PLC can be initiated by either 
one of these stations.  

The two job mailboxs No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data records from the PLC to the HMI device. The job mailbox is 
structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1 to 65535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1

No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox No. 70 transfers data records from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data record.
Abort without 

return message.
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Step Action
3 The HMI device reads the values from the PLC and saves these to the 

data record defined in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 1100 
in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of writing to the PLC with job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

function from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.
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Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of error  
The section below shows possible error causes which lead to the cancellation of data record 
transfer: 

● Tag address not set up on the PLC

● Overwriting data records not possible

● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".
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Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system alarms

● Triggered by function
Output of system alarms

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
record.

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Advanced and Panels (Page 3237) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:
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● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 
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The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms  
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3260) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 
300/400

WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, REAL, 
COUNTER, TIME
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How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
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Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels Panel PCs:
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

10.11.8.6 Performance features of communication

Permitted data types for SIMATIC S7 300/400

Permitted data types for connections with SIMATIC S7 300/400
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Length
BOOL 1-bit
BYTE 1 byte
WORD 2 bytes
DWORD 4 bytes
CHAR 1 byte
INT 2 byte
DINT 4 bytes
REAL 4 bytes
TIME 4 bytes
DATE 2 bytes
TIME_OF_DAY, TOD 4 bytes
S5TIME 2 bytes
COUNTER 2 bytes
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Data type Length
TIMER 2 bytes
DATE_AND_TIME 8 bytes
STRING (2+n) bytes, n = 0 to 254

10.11.8.7 Creating connections in the "Connections" editor

Creating a PROFINET connection

Requirements
● A project is open.

● An HMI device with a PROFINET interface has been created.     

Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".
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3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select a PROFINET interface of the HMI device in the Inspector window under "Parameters 
> Interface".

6. Set the IP addresses of the communication partners in the Inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Creating a PROFIBUS connection

Requirements
● A project is open.

● An HMI device with a PROFIBUS interface has been created.     
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select the "MPI/DP" interface in the Inspector window under "Parameters > Interface".
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6. Select the "DP" profile in the Inspector window under "Parameters > Network".

7. Set the addresses of the communication partners in the inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Creating an MPI connection

Requirements
● A project is open.

● An HMI device with an MPI interface has been created.     
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select the "MPI/DP" interface in the Inspector window under "Parameters > Interface".
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6. Select the "MPI" profile in the Inspector window under "Parameters > Network".

7. Set the addresses of the communication partners in the inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Parameters for the connection

Parameters for the connection (SIMATIC S7 300/400)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.    

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used.
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Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Expansion slot"
Defines the number of the expansion slot of the CPU to be addressed.
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● "Rack"
Defines the rack number of the CPU to be addressed.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance.
Disable cyclic mode if you are operating several HMI devices in parallel.

PROFIBUS parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.   

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PROFIBUS network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
You set the PROFIBUS address of the HMI device under "Address". The PROFIBUS 
address must be unique in the PROFIBUS network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). 
In S7 200, you must set an HMI device as the master.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5194 System Manual, 07/2013,  



Parameters for the network
Under "Network", you set the parameters for the PROFIBUS network to which the HMI device 
is linked.

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "DP", 
"Universal", or "Standard". The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual PROFIBUS address. The setting must 
be identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud in the OP 73 or the OP 77A, the highest station address 
must be less than or equal 63.

 

● "Number of masters"
For "Number of masters", set the number of masters in the PROFIBUS network. This 
information is necessary to correctly calculate the bus parameters. 

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.     

● "Address"
For "Address", set the PROFIBUS address of the S7 module (CPU, FM, or CP) to which 
the HMI device is connected.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance. Disable cyclic mode if you are 
operating several HMI devices in parallel. This setting is not required for SIMATIC S7-200 
PLCs.
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MPI parameters

Parameters for the HMI device 
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.         

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the MPI network. 

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
For "Address", you set the MPI address of the HMI device. The MPI address must be unique 
throughout the MPI network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). If you have connected only slaves to the HMI device, you must 
therefore disable the "Sole master on bus" safety feature.
In S7 200, you must set an HMI device as the master.

Parameters for the network
Under "Network", you set the parameters for the MPI network to which the HMI device is linked. 

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "MPI". 
The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual MPI address. The setting must be 
identical throughout the network.

● "Number of masters"
This setting is not required for MPI. 
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
For "Address", set the MPI address of the S7 module (CPU, FM, or CP) to which the HMI 
device is connected.

● "Cyclic mode"
When cyclic mode is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This improves system performance. Disable cyclic mode if you are 
operating several HMI devices in parallel. This setting is not required for SIMATIC S7-200.

Cyclic operation

Handling the "Cyclic operation" selection
If "Cyclic operation" is enabled, the HMI device sends a message frame to the CPU at the 
beginning of communication indicating that certain tags are required on a recurring basis.

The CPU then always transmits the data at the same cyclic interval. This saves the HMI device 
from having to output new requests for the data.

If cyclic operation is disabled, the HMI device sends a request whenever information is required.

Additional properties:

● Cyclic operation reduces data transmission load at the HMI device. The PLC resources are 
used to relieve load on the HMI device.

● The PLC only supports a certain number of cyclic services. The HMI device handles the 
operation if the PLC cannot provide any further resources for cyclic services.

● The HMI device generates the cycle if the PLC does not support the cyclic mode.

● Screen tags are not integrated in cyclic operation.

● Cyclic mode is only set up at the restart of Runtime.

● The HMI device transfers several jobs to the PLC if cyclic mode is enabled, depending on 
the PLC.

● The HMI device only transfers one job to the PLC if cyclic mode is disabled.
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10.11.9 Communicating with SIMATIC S7 200

10.11.9.1 Communication with SIMATIC S7 200

Introduction
This section describes the communication between an HMI device and the SIMATIC S7 200 
PLC.   

You can configure the following communication channels for the SIMATIC S7 200 PLC:

● PROFINET and Ethernet

● PROFIBUS

● MPI

● PPI

HMI connection for communication
You configure connections between the HMI device and a SIMATIC S7 200 in the 
"Connections" editor of the HMI device. 

10.11.9.2 Creating a connection to SIMATIC S7 200

Introduction
You configure a connection to the SIMATIC S7 200 PLC in the "Connections" editor of the HMI 
device. The interfaces are named differently depending on the HMI device.     

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "SIMATIC S7 200" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

See the chapter "Parameters for the connection (Page 5202)" for additional details.

10.11.9.3 Parameters for the connection

Parameters for the connection (SIMATIC S7 200)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.    

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used.
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Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Expansion slot"
Defines the number of the expansion slot of the CPU to be addressed.
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● "Rack"
Defines the rack number of the CPU to be addressed.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance.
Disable cyclic mode if you are operating several HMI devices in parallel.

PROFIBUS parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.   

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PROFIBUS network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
You set the PROFIBUS address of the HMI device under "Address". The PROFIBUS 
address must be unique in the PROFIBUS network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). 
In S7 200, you must set an HMI device as the master.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.
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Parameters for the network
Under "Network", you set the parameters for the PROFIBUS network to which the HMI device 
is linked.

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "DP", 
"Universal", or "Standard". The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual PROFIBUS address. The setting must 
be identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud in the OP 73 or the OP 77A, the highest station address 
must be less than or equal 63.

 

● "Number of masters"
For "Number of masters", set the number of masters in the PROFIBUS network. This 
information is necessary to correctly calculate the bus parameters. 

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.     

● "Address"
For "Address", set the PROFIBUS address of the S7 module (CPU, FM, or CP) to which 
the HMI device is connected.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance. Disable cyclic mode if you are 
operating several HMI devices in parallel. This setting is not required for SIMATIC S7-200 
PLCs.
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MPI parameters

Parameters for the HMI device 
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.         

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the MPI network. 

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
For "Address", you set the MPI address of the HMI device. The MPI address must be unique 
throughout the MPI network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). If you have connected only slaves to the HMI device, you must 
therefore disable the "Sole master on bus" safety feature.
In S7 200, you must set an HMI device as the master.

Parameters for the network
Under "Network", you set the parameters for the MPI network to which the HMI device is linked. 

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "MPI". 
The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual MPI address. The setting must be 
identical throughout the network.

● "Number of masters"
This setting is not required for MPI. 
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
For "Address", set the MPI address of the S7 module (CPU, FM, or CP) to which the HMI 
device is connected.

● "Cyclic mode"
When cyclic mode is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This improves system performance. Disable cyclic mode if you are 
operating several HMI devices in parallel. This setting is not required for SIMATIC S7-200.

PPI parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.     

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PP network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network. 

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.     

 

● "Address"
For "Address", you set the PPI address of the HMI device. The PPI address must be unique 
throughout the PPI network.

● "Access point"
For "Access point", you set the access point via which the communication partner is 
reached.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). If you have connected only slaves to the HMI device, you must 
therefore disable the "Sole master on bus" safety feature.
In S7 200, you must set an HMI device as the master.
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Parameters for the network 
Under "Network", you set the parameters for the network to which the HMI device is linked. 

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "PPI". 
The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual MPI address. The setting must be 
identical throughout the network.

● "Number of masters"
Set the number of the master on the network to "1".

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.   

● "Address"
For "Address", set the PPI address of the S7 module to which the HMI device is connected.

● "Cyclic operation"
This parameter is not required for communication via PPI.

Cyclic operation

Handling the "Cyclic operation" selection
If "Cyclic operation" is enabled, the HMI device sends a message frame to the CPU at the 
beginning of communication indicating that certain tags are required on a recurring basis.

The CPU then always transmits the data at the same cyclic interval. This saves the HMI device 
from having to output new requests for the data.

If cyclic operation is disabled, the HMI device sends a request whenever information is required.

Additional properties:

● Cyclic operation reduces data transmission load at the HMI device. The PLC resources are 
used to relieve load on the HMI device.

● The PLC only supports a certain number of cyclic services. The HMI device handles the 
operation if the PLC cannot provide any further resources for cyclic services.

● The HMI device generates the cycle if the PLC does not support the cyclic mode.

● Screen tags are not integrated in cyclic operation.

● Cyclic mode is only set up at the restart of Runtime.

● The HMI device transfers several jobs to the PLC if cyclic mode is enabled, depending on 
the PLC.

● The HMI device only transfers one job to the PLC if cyclic mode is disabled.
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10.11.9.4 Data exchange

Data exchange using area pointers

General information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.

Configuration of area pointers
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You can find more detailed information on configuring area pointers in:

Configuring area pointers (Page 4956) 

See also
Data exchange using area pointers (Page 4952)

"Screen number" area pointer

Function     
The HMI device saves information about the screen called on the HMI device to the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. The 
PLC can trigger specific reactions such as the call of a different screen.

Application
Configure and enable the area pointer in "Communication > Connections" before you put it 
into use. You can create only one instance of the "Screen number" area pointer and only on 
one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.
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Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1st word Current screen type
2nd word Current screen number
3rd word Reserved
4th word Current field number
5th word Reserved

 

● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

"Date/time" area pointer 

Function     
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. All definitions are coded in BCD format.

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The date/time data area has the following structure:
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Data word Most significant byte Least significant byte  
7       0 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer. All definitions are coded in BCD format.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the Date/time area pointer in order to avoid 
any negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute, if the process allows this.

 

"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The date/time data area has the following structure:

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5210 System Manual, 07/2013,  



DATE_AND_TIME format (in BCD code)

Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC flexible and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

"Coordination" area pointer

Function    
The "Coordination" area pointer is used to implement the following functions:

● Detecting the startup of the HMI device in the control program

● Detecting the current operating mode of the HMI device in the control program

● Detecting whether the HMI device is ready to communicate in the control program

By default, the "Coordination" area pointer has the length of one word and cannot be changed.

Usage
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program can for this reason not make changes to the coordination area.
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Assignment of the bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
status of the operating mode bit is "0" during normal operation of the HMI device. You can 
determine the current operating mode of the HMI device by reading this bit in the control 
program.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not there is still a connection to the HMI device by querying this bit in the control 
program.

"Project ID" area pointer

Function    
When Runtime starts it can check to see if the HMI device is connected to the correct PLC. 
This check is important when operating with several HMI devices.

For this, the HMI device compares a value stored on the PLC with the value specified in 
configuration. This ensures compatibility of the configuration data with the PLC program. If 
there is no concordance, a system event is given on the HMI device and Runtime is stopped.

Use
To use this area pointer, set up the following during the configuration:

● Define the version of configuration. Values between 1 and 255 are possible.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● Data address of the value for the version that is stored in the PLC:
You enter the data address in the editor "Communication > Connections" under "Address".
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Connection failure    
A connection failure to a device on which the "project ID" area pointer is configured results in 
all the other connections of the device being switched to "offline".

This behavior has the following requirements:

● You have configured several connections in a project.

● You are using the "project ID" area pointer in at least one connection.

Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the engineering system.

 

"Job mailbox" area pointer

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time

Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Most significant byte Least significant byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.
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Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

 

 Note

Please note that not all HMI devices support job mailboxes. TP 170A and Micro Panel do not 
support job mailboxes, for example.

 

No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Setting the date (BCD coded) 3)

 Parameter 1 Left byte:  -
Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 (in the S7 format  DATE_AND_TIME)

An interval of at least 5 seconds must be maintained between two successive jobs to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 (In OP/MP format)

An interval of at least 5 seconds must be maintained between successive jobs to prevent overload 
of the HMI device.

 Parameter 1, 2, 3 -
46 Update tag
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No
.

Function  

14 Set time (BCD-coded)
 Causes the HMI device to read the current value of the tags from the PLC whose update ID 

matches the value transferred in Parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Screen selection 2)

 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Reading data record from PLC  1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Writing data record to PLC 1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) Only devices supporting recipes
2) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job mailbox if 

the on-screen keyboard is active.
3) The weekday is ignored on HMI device KTP 600 BASIC PN.

"Data record" area pointer

"Data record" area pointer 

Function  
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.
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Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization over the data record

Data records are always transferred directly. That is, the tag values are read from an address 
or written to an address configured for this tag directly, without redirecting the values by means 
of interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions

If the transfer of data records is triggered by a configured function or by a job mailbox, the 
recipe view on the HMI device remains operable. The data records are transferred in the 
background. 

Simultaneous processing of several transfer requests is, however, not possible. In this case, 
the HMI device rejects the other transfer requests with a system event. 

Sequence of a transfer started by the operator in the recipe view

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data record and sets the data record number to 
0. 

Abort with system 
event.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
 

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5216 System Manual, 07/2013,  



Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data mailbox.

Abort with system 
event.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized in the recipe view and tags and then written to the PLC.

 

3 The HMI device sets the status "Transfer completed."  
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.

 

 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of the transfer triggered by a job mailbox
The transfer of data records between the HMI device and the PLC can be initiated by the HMI 
device or by the PLC.  

The two job mailboxes No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data records from the PLC to the HMI device. The job mailbox is 
structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1
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No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox No. 70 transfers data records from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device reads the values from the PLC and saves these to the 

data record defined in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 1100 
in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of writing to the PLC using job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

job from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order to enable 
further transfers.
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Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.

 

Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of faults  
The section below shows possible causes of errors which lead to a data record transfer being 
terminated with errors: 

● Tag address not set up on the PLC

● Overwriting data records not possible
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● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system events

● Triggered by function
Output of system events

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
mailbox.

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example, when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.
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Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then process, edit, or save these 
values, for example. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization 
If you select synchronous transfer, both communication partners set status bits in the common 
data area. You can use this mechanism to prevent uncontrolled overwriting of data in either 
direction in your control program.     

Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Communication > Connections" editor in "Area pointer".

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the Inspector window the "Coordinated transfer of data records" option 
under "General > Synchronization > Settings".
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Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data record free
2 0000 0010 Transferring
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Advanced and Panels (Page 3237) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.
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Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.
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Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms   
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3260) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted
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Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 PLCs WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL, TIMER

How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels Panel PCs:
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

10.11.9.5 Performance features of communication

Permitted data types for SIMATIC S7 200

Permitted data types for connections with SIMATIC S7 200
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Length
Bool 1 bit
Byte 1 byte
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Data type Length
Char 1 byte
Word 2 bytes
Int 2 bytes
DWord 4 bytes
DInt 4 bytes
Real 4 bytes
StringChar --
Timer 2 bytes
Array --

 
 

 Note
Disconnection with a PPI network

If you are using arrays in the configuration, an array size of approximately 1000 bytes may 
cause an interruption of the connection.

Use smaller arrays in your configuration.
 

10.11.10 Communicating with SIMATIC LOGO!

10.11.10.
1

Communication with SIMATIC LOGO!

Introduction
This section describes the communication between an HMI device and the SIMATIC 
SIMATIC LOGO! controller.     

You can configure the following communication channels for the SIMATIC LOGO! controller:

● PROFINET

● Ethernet

HMI connection for communication
You configure connections between the HMI device and SIMATIC LOGO! in the "Connections" 
editor of the HMI device. 

Data exchange
Data exchange with the SIMATIC LOGO! control system is possible by means of tags.

Data cannot be exchanged using area pointers.
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10.11.10.
2

Creating a connection to SIMATIC LOGO!

Introduction
You configure a connection to the SIMATIC LOGO! controller in the "Connections" editor of 
the HMI device. The interfaces are named differently depending on the HMI device.         

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "SIMATIC LOGO!" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

See the chapter "Connection parameters (Page 5232)" for additional details.

10.11.10.
3

Connection parameters

Connection parameters

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.       

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used.
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Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Expansion slot"
Defines the number of the expansion slot of the CPU to be addressed.
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● "Rack"
Defines the rack number of the CPU to be addressed.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance.
Disable cyclic mode if you are operating several HMI devices in parallel.

Cyclic operation

Handling the "Cyclic operation" selection
If "Cyclic operation" is enabled, the HMI device sends a message frame to the CPU at the 
beginning of communication indicating that certain tags are required on a recurring basis.

The CPU then always transmits the data at the same cyclic interval. This saves the HMI device 
from having to output new requests for the data.

If cyclic operation is disabled, the HMI device sends a request whenever information is required.

Additional properties:

● Cyclic operation reduces data transmission load at the HMI device. The PLC resources are 
used to relieve load on the HMI device.

● The PLC only supports a certain number of cyclic services. The HMI device handles the 
operation if the PLC cannot provide any further resources for cyclic services.

● The HMI device generates the cycle if the PLC does not support the cyclic mode.

● Screen tags are not integrated in cyclic operation.

● Cyclic mode is only set up at the restart of Runtime.

● The HMI device transfers several jobs to the PLC if cyclic mode is enabled, depending on 
the PLC.

● The HMI device only transfers one job to the PLC if cyclic mode is disabled.
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10.11.10.
4

Data exchange

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Auto-Hotspot 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)
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Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.
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Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms   
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Auto-Hotspot 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 PLCs WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL, TIMER
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How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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10.11.10.
5

Performance features of communication

Valid data types for SIMATIC LOGO!

Valid data types for connections with SIMATIC LOGO!
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Length
Bool 1 bit
Byte 1 byte
Int 2 bytes
DInt 4 bytes
Word 2 bytes
DWord 4 bytes
Array --

10.11.11 Configuring direct keys

10.11.11.
1

Direct keys

Introduction
In addition to their standard use, the F, K and S keys of an HMI device with key operation can 
be used as direct keys.  

With HMI devices with touch operation, you configure the system function "Direct key" to a 
button 

You can configure the following direct keys:

● PROFINET connection: PROFINET IO direct keys

● PROFIBUS connection: PROFIBUS DP direct keys

Operating mode of HMI devices with direct keys
Before accessing the PLC from the HMI device using the direct keys you have to change the 
operating mode of the HMI device.
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10.11.11.
2

Changing the operating mode of the HMI device

Changing the operating mode for a PROFINET connection

Requirements 
The HMI device is networked with a PLC via PROFINET.

Procedure 
1. Click the PROFINET interface of the HMI device in the "Devices & Networks" editor.

2. Click "Operating mode" under "Properties > General" in the Inspector window.

3. Select the function "IO device" in the "Operating mode" area.

4. Select the PLC which is networked with the HMI device under "Assigned IO controller".

Changing the operating mode for a PROFIBUS connection

Requirements
The HMI device is networked with a PLC via PROFIBUS.
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Procedure 
1. Click the PROFIBUS interface of the HMI device in the "Devices & Networks" editor.

2. Click "Operating mode" under "Properties > General" in the Inspector window.

3. Select the function "DP slave" in the "Operating mode" area.

4. Select the PLC which is networked with the HMI device under "Assigned DP master".

10.11.11.
3

Configuring direct keys

Configuring direct keys for an HMI device with touch operation

Requirements
● An HMI device with key operation has been created.  

● You have created an LED tag.
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Procedure
1. Create a new screen.

2. Drag-and-drop a button from the "Tools" task card into the screen.

3. Click the button.

4. In the Inspector window, click "Properties > Events > Press".

5. Click "<Add function>".

6. Select the "Direct key" system function.

7. Under "Bit" enter the correct bit number.
The correct bit number depends on the HMI device and the input and output assignments 
on the HMI device.

Assignment of inputs and outputs
The exact assignment of inputs and outputs can be found under: 

● PROFINET IO direct keys: Assignment of inputs and outputs (Page 5248)

● PROFIBUS DP direct keys: Assignment of inputs and outputs (Page 5265)
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10.11.11.
4

PROFINET IO direct keys

PROFINET IO direct keys

PROFINET IO direct keys
You configure the HMI device created in WinCC as an active communication partner in the 
automation network.  

For the PROFINET IO direct keys, the HMI device can also be configured as a slave in the 
PROFINET IO network. 

The following figure shows the basic configuration based on an automation network with an 
HMI device and a PLC.

Mode of operation of the PROFINET IO direct keys
The cycle time of the Ethernet bus can be set between 8 ms and 512 ms. 

Thus, the reaction time of the PROFINET IO direct keys can also be determined. For a typical 
configuration with a cycle time of 64 ms, the response time of the PROFINET IO direct keys 
is < 100 ms.

A response time of < 100 ms to the CPU is usually ensured when using the PROFINET IO 
direct keys. This time can be exceeded significantly in the following cases:

● Complex functions run in the background, e.g. transmitting recipes, printing reports.

● At the same time, multiple connections can be maintained to the CPU.
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HMI devices for the configuration of PROFINET IO direct keys

HMI devices
You can configure PROFINET IO direct keys with the following HMI devices:   

HMI device class HMI device
Panel OP 177B PN/DP

OP 277 6"
TP 177B 4" PN/DP
TP 177B 6" PN/DP
TP 277 6"

Mobile Panel Mobile Panel 177 PN
Mobile Panel 277 8"
Mobile Panel 277 10"
Mobile Panel 277 IWLAN V2
Mobile Panel 277(F) IWLAN V2
Mobile Panel 277(F) IWLAN V2 (RFID tags)

Multi Panel Multi Panel 177 6" Touch
Multi Panel 277 Key
Multi Panel 277 Touch
Multi Panel 377 Key
Multi Panel 377 Touch

Comfort Panel KTP400 Comfort
KP400 Comfort
KP700 Comfort
TP700 Comfort
KP900 Comfort
TP900 Comfort
KP1200 Comfort
TP1200 Comfort
KP1500 Comfort 
TP1500 Comfort 
TP1900 Comfort 
TP2200 Comfort 

 

Restrictions for PROFINET IO direct keys
 

 Note

Direct keys are still active when the HMI device is in "offline" mode.
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 Note

If an external application such as Pocket Internet Explorer or Control Panel is started, it will 
run in the foreground and Runtime is placed in the background. The bit for the function 
"DirectKeyScreenNumber" is no longer set and the keys or buttons with the configured 
function "DirectKey" no longer trigger the associated bit in the PLC.

 

Restrictions   
● It is not permitted to operate PROFIBUS IO direct keys and PROFINET DP direct keys 

simultaneously.

● Establish the following via the "PROFINET IO enabled" option in the control panel of the 
HMI device:

– Option disabled = PROFIBUS DP direct keys enabled

– Option enabled = PROFINET IO direct keys enabled

● If communication is enabled with PROFINET IO, you are not permitted to use the serial 
interface.

● You can operate direct keys only on local HMI devices. On the Sm@rtClient it is possible 
to operate the key / button for the direct key. However, No bit is set in the I/O area of the 
CPU.

● Direct keys which are assigned to a button are only triggered through touch operation. 
Triggering with a mouse click, for example with a connected USB mouse, is not possible.

● With touch operation, direct keys are triggered independent of any configured password 
protection.

● The buttons used as direct keys on HMI devices with touch screen functionality may not 
be modified as follows by means of scripting:

– Moving

– Resizing

– Hiding

– Disabling for operation

● The LEDs are addressed either via the PROFINET IO direct keys or the HMI Runtime 
application. Avoid concurrent addressing via the PROFINET IO direct keys and the HMI 
Runtime application. The LEDs "ACK", "A-Z l", "A-Z r" and "HELP" are reserved for system 
functions and cannot be configured. It is not advisable to control the "ACK", "A-Z l", "A-Z r" 
and "HELP" LEDs by means of PROFINET IO direct key functionality.
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Inputs and outputs of HMI devices

Assignment of inputs and outputs

Assigning the inputs/outputs 
The keys or buttons of the device are assigning bytes in the input area. The LEDs are assigning 
bytes in the output area. The number of bytes used depends on the HMI device.   

The touch panels do not have any permanently assigned keys. They only have user-
configurable buttons. Via the "DirectKey system function you can assign a bit to a button in 
the input area. The counting direction of the bit in the input direction is from right to left. In 
contrast to the operator panels which have permanently assigned keys, the touch panel buttons 
can be assigned freely.

Assigning direct keys to screen numbers (only for touch devices)
If a PROFINET IO direct key is using the same bit for different functions in different screens, 
the SIMATIC PLC must differentiate between the respective functionality by means of the 
screen number. You can use the "DirectKeyScreenNumber" system function to avoid the 
delayed updating of the screen number following a screen change.

Using the "DirectKeyScreenNumber"system function you can set within the input area any 
number of bits in order to identify the screen and simultaneously transfer the direct key bits to 
the PLC. This ensures unambiguous allocation of a control bit to screen number at all times.

See also
Panel (Page 5248)

Multi Panel (Page 5251)

Mobile Panel (Page 5254)

Comfort Panel (Page 5257)

Panel

OP 177

Direct keys OP 177B

Inputs Outputs
9 bytes 4 bytes
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TP 177

Direct keys TP 177B 4"

Inputs Outputs
5 bytes –

Direct keys TP 177B 6"

Inputs Outputs
4 bytes --
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OP 277

Direct keys OP 277 6"

Inputs Outputs
4 bytes 4 bytes

  

TP 277

Direct keys TP 277 6"

Inputs Outputs
4 bytes  –
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Multi Panel

Multi Panel 177

Direct keys Multi Panel 177 6" Touch

Inputs Outputs
4 bytes -

  

Multi Panel 277

Direct keys Multi Panel 277 8" Key

Inputs Outputs
5 bytes 5 bytes
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Direct keys Multi Panel 277 10" Key

Inputs Outputs
5 bytes 5 bytes

 

Direct keys Multi Panel 277 8" Touch

Inputs Outputs
5 bytes –
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Direct keys Multi Panel 277 10" Touch

Inputs Outputs
5 bytes –

  

Multi Panel 377

Direct keys Multi Panel 377 Key

Inputs Outputs
5 bytes 5 bytes
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Multi Panel 377 Touch

Inputs Outputs
5 bytes –

  

Mobile Panel

Mobile Panel 177

Direct keys Mobile Panel 177 PN

Inputs Outputs
9 bytes 2 bytes
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Mobile Panel 277

Direct keys Mobile Panel 277 8"

HMI device Inputs Outputs
Mobile Panel 277 8" 10 bytes 4 bytes
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Direct keys Mobile Panel 277 10"

HMI device Inputs Outputs
Mobile Panel 277 10" 5 bytes --
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Mobile Panel 277 IWLAN V2

Direct keys Mobile Panel 277 IWLAN V2
The assignment of the inputs and outputs of the direct keys applies to the following HMI devices:

● Mobile Panel 277 IWLAN V2

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277 IWLAN V2 (RFID tags)

Inputs Outputs
10 bytes 4 bytes

   

Comfort Panel

KTP400 Comfort

Direct keys KTP400 Comfort

HMI device Inputs Outputs
Touch operation 4 bytes -
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HMI device Inputs Outputs
Key operation 1 byte 1 byte

  

KP400 Comfort

Direct keys KP400 Comfort

Inputs Outputs
1 byte 1 byte
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KP700 Comfort

Direct keys KP700 Comfort

Inputs Outputs
3 bytes 3 bytes

  

TP700 Comfort

Direct keys TP700 Comfort

Inputs Outputs
4 bytes --

  

KP900 Comfort

Direct keys KP900 Comfort

Inputs Outputs
4 bytes 4 bytes
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TP900 Comfort

Direct keys TP900 Comfort

Inputs Outputs
5 bytes --

  

KP1200 Comfort

Direct keys KP1200 Comfort

Inputs Outputs
5 bytes 5 bytes
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TP1200 Comfort

Direct keys TP1200 Comfort

Inputs Outputs
5 bytes --

   

KP1500 Comfort

Inputs Outputs
5 bytes 5 bytes
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TP1500, TP1900 and TP2200 Comfort

Inputs Outputs
5 bytes --

10.11.11.
5

PROFIBUS DP direct keys

PROFIBUS DP direct keys

PROFIBUS DP direct keys
You configure the HMI device created in WinCC as an active communication partner in the 
automation network.    

For the PROFIBUS DP direct keys, also configure the HMI device as a slave in the 
PROFIBUS DP network. 

The following figure shows the basic configuration based on an automation network with an 
HMI device and a PLC.
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Mode of operation of the PROFIBUS DP direct keys
With PROFIBUS DP direct keys, when the key or button is pressed, a bit is set in the I/O area 
of the CPU.

The cycle time of the PROFIBUS DP bus is calculated from the total of all configured inputs 
and outputs. 

The number of configured inputs and outputs can influence the reaction time of the 
PROFIBUS DP direct key. For a typical configuration the response time of the PROFIBUS DP 
direct key is < 100 ms.

HMI devices for the configuration of PROFIBUS DP direct keys

HMI devices
You can configure PROFIBUS DP direct keys with the following HMI devices:     

HMI device class HMI device
Panel OP 77B

OP 177B
OP 277 6"
TP 177B 4"
TP 177B 6"
TP 277 6"

Mobile Panel Mobile Panel 177 DP
Mobile Panel 277 8"
Mobile Panel 277 10"
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HMI device class HMI device
Multi Panel Multi Panel 177 6" Touch

Multi Panel 277 Key
Multi Panel 277 Touch
Multi Panel 377 Key
Multi Panel 377 Touch

Comfort Panel KTP400 Comfort
KP400 Comfort
KP700 Comfort
TP700 Comfort
KP900 Comfort
TP900 Comfort
KP1200 Comfort
TP1200 Comfort
KP1500 Comfort 
TP1500 Comfort 
TP1900 Comfort 
TP2200 Comfort 

 

Restrictions for PROFIBUS DP direct keys
 

 Note

If an external application such as Pocket Internet Explorer or Control Panel is started, it will 
run in the foreground and Runtime is placed in the background. The bit for the function 
"DirectKeyScreenNumber" is no longer set and the keys or buttons with the configured 
function "DirectKey" no longer trigger the associated bit in the PLC.

 

Restrictions   
● It is not possible to operate PROFIBUS DP direct keys and PROFINET IO direct keys 

simultaneously.
Establish the following via the "PROFINET IO enabled" option in the control panel of the 
HMI device: 

– Option disabled = PROFIBUS DP direct keys enabled

– Option enabled = PROFINET IO direct keys enabled

● You can operate direct keys only on local HMI devices. On the Sm@rtClient it is possible 
to operate the key / button for the direct key. However, No bit is set in the I/O area of the 
CPU.
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● The buttons used as direct keys on HMI devices with touch screen functionality may not 
be modified as follows by means of scripting:

– Moving

– Resizing

– Hiding

– Disabling for operation

● The LEDs are addressed either via the PROFIBUS DP direct keys or the HMI Runtime 
application. Avoid concurrent addressing via the PROFIBUS DP direct keys and the HMI 
Runtime application. The LEDs "ACK", "A-Z l", "A-Z r" and "HELP" are reserved for system 
functions and cannot be configured. We do not recommend addressing the LEDs "ACK", 
"A-Z l", "A-Z r" and "HELP" with the PROFIBUS DP direct keys.

● The PROFIBUS direct keys on an HMI device are triggered independent of any configured 
password protection.

Inputs and outputs of HMI devices

Assignment of inputs and outputs

Assigning the inputs/outputs 
The keys or buttons of the device are assigning bytes in the input area. The LEDs occupy 
bytes in the DP output area. The following table shows the number of bytes used in the various 
HMI devices. The precise assignment is shown in the following screens.   

The touch panels do not have any permanently assigned keys. They only have user-
configurable buttons. Via the direct keys function you can assign to a button a bit in the input 
area. The counting direction of the bit in the input direction is from right to left. In contrast to 
the operator panels which have permanently assigned keys, the touch panel buttons can be 
assigned freely. For more detailed information, refer to the "WinCC flexible - Configuring 
WinCC Windows-based Systems" user manual.

Assigning direct keys to screen numbers (only for touch devices)
If a PROFIBUS DP direct key is using the same bit for different functions in different screens, 
the S7 must differentiate between the respective functionality by means of the screen number. 
To combat the delayed updating of the screen number in the PLC after a change of screen 
you use the "DirectKeyScreenNumber" screen function.

Using the "DirectKeyScreenNumber" you can set within the input area any number of bits in 
order to identify the screen and simultaneously transfer the direct key bits to the PLC. This 
ensures unambiguous allocation of a control bit to screen number at all times.
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See also
Panel (Page 5266)

Multi Panel (Page 5269)

Mobile Panel (Page 5272)

Comfort Panel (Page 5275)

Panel

OP 77

Direct keys OP 77B

Inputs Outputs
4 bytes 4 bytes

  

OP 177

Direct keys OP 177B

Inputs Outputs
9 bytes 4 bytes
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TP 177

Direct keys TP 177B 4"

Inputs Outputs
5 bytes –

Direct keys TP 177B 6"

Inputs Outputs
4 bytes --
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OP 277

Direct keys OP 277 6"

Inputs Outputs
4 bytes 4 bytes

  

TP 277

Direct keys TP 277 6"

Inputs Outputs
4 bytes  –
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Multi Panel

Multi Panel 177

Direct keys Multi Panel 177 6" Touch

Inputs Outputs
4 bytes -

  

Multi Panel 277

Direct keys Multi Panel 277 8" Key

Inputs Outputs
5 bytes 5 bytes
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Direct keys Multi Panel 277 10" Key

Inputs Outputs
5 bytes 5 bytes

 

Direct keys Multi Panel 277 8" Touch

Inputs Outputs
5 bytes –
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Direct keys Multi Panel 277 10" Touch

Inputs Outputs
5 bytes –

  

Multi Panel 377

Direct keys Multi Panel 377 Key

Inputs Outputs
5 bytes 5 bytes
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Multi Panel 377 Touch

Inputs Outputs
5 bytes –

  

Mobile Panel

Mobile Panel 177

Direct keys Mobile Panel 177 DP

Inputs Outputs
9 bytes 4 bytes
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Mobile Panel 277

Direct keys Mobile Panel 277 8"

HMI device Inputs Outputs
Mobile Panel 277 8" 10 bytes 4 bytes
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Direct keys Mobile Panel 277 10"

HMI device Inputs Outputs
Mobile Panel 277 10" 5 bytes --
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Mobile Panel 277 IWLAN V2

Direct keys Mobile Panel 277 IWLAN V2
The assignment of the inputs and outputs of the direct keys applies to the following HMI devices:

● Mobile Panel 277 IWLAN V2

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277 IWLAN V2 (RFID tags)

Inputs Outputs
10 bytes 4 bytes

   

Comfort Panel

KTP400 Comfort

Direct keys KTP400 Comfort

HMI device Inputs Outputs
Touch operation 4 bytes -
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HMI device Inputs Outputs
Key operation 1 byte 1 byte

  

KP400 Comfort

Direct keys KP400 Comfort

Inputs Outputs
1 byte 1 byte
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KP700 Comfort

Direct keys KP700 Comfort

Inputs Outputs
3 bytes 3 bytes

  

TP700 Comfort

Direct keys TP700 Comfort

Inputs Outputs
4 bytes --

  

KP900 Comfort

Direct keys KP900 Comfort

Inputs Outputs
4 bytes 4 bytes
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TP900 Comfort

Direct keys TP900 Comfort

Inputs Outputs
5 bytes --

  

KP1200 Comfort

Direct keys KP1200 Comfort

Inputs Outputs
5 bytes 5 bytes
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TP1200 Comfort

Direct keys TP1200 Comfort

Inputs Outputs
5 bytes --

   

KP1500 Comfort

Inputs Outputs
5 bytes 5 bytes
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TP1500, TP1900 and TP2200 Comfort

Inputs Outputs
5 bytes --

10.11.12 Communication via SIMATIC HMI HTTP

10.11.12.
1

Basic information on SIMATIC HMI HTTP

Introduction
You use the SIMATIC HMI HTTP Protocol for data exchange between HMI devices.      

The SIMATIC HMI HTTP Protocol is not suited for exchange of bulk data.

Data exchange occurs according to the Request-Response method. The HTTP client sends 
its request to the HTTP server, which processes it and returns a response.

A device can be configured as an HTTP client and HTTP server simultaneously.  

The client and server establish a connection via the Ethernet interface for data exchange.
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HTTP components
The components of the SIMATIC HMI HTTP Protocol are transferred to the HMI device in 
"Load to device".

HTTP components are:

● HTTP server

● HTTP client

If you use a Standard-PC or SIMATIC IPC, you must install WinCC RT Advanced or WinCC 
RT Professional first.

SMTP protocol
The SMTP protocol is not a requirement for communication via SIMATIC HMI HTTP Protocol .
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HTTP / HTTPS
TheSIMATIC HMI HTTP Protocol offers two standards:

● HTTP
Is implemented in local networks for a fast, uncoded transfer of uncritical data.

● HTTPS
Enables a reliable HTTP connection between devices. Initially there is an exchange of 
secret keys. Then, in a further step, the respective public keys can be securely exchanged 
in the form of digital certificates. The public keys are used to encode the utility data in order 
to guarantee a bug-proof communication.  

 

  Note

Due to the encryption, the HTTPS protocol has a lower transmission performance than 
the HTTP protocol.

 

 

 CAUTION

End users are responsible for the security of their own networks.
 

10.11.12.
2

Configuring a connection via SIMATIC HMI HTTP

Configuring a connection via SIMATIC HMI HTTP

Communication between HMI devices via SIMATIC HMI HTTP protocol
Several steps are needed to configure communication between HMI devices via the SIMATIC 
HMI HTTP protocol:

1. Configure HMI device as a server.

2. Configure HMI device as a client.

3. Assign tag parameters in the client.

4. Commission connection.

Access to tags via SIMATIC HMI HTTP protocol
If access to tags via the SIMATIC HMI HTTP protocol is to be enabled, these tags must be 
defined for the relevant HMI devices and interconnected.
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Configuring an HMI device as a server

Configuring a server

Requirements
● The HTTP communication channel must be set in the Control Panel of the HMI device.       

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click "Runtime settings".
The "Runtime settings" editor opens.

3. Click "Services".

4. Select the "HTTP channel server" option.

If you use the SMTP protocol, you assign the following values under "SMTP settings" according 
to your project specifications:
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● Server name

● Login

● Password

Result
The HMI device has been configured as a server.

Tags in the server

Tags used
The client can use the HTTP protocol for read and write access to tags configured on the server 
in runtime. This means that it is not necessary to configure additional tags for an HTTP 
communication.

However, the following aspects must be taken into account to ensure correct data exchange:

● The data type of the server tags must match the data type in the client.

● The tag name configured in the HTTP server must be identical to the name of the address 
tag of the HTTP client.

 

Configuring an HMI device as a client

Configuring a client

Requirements
● The HTTP communication channel must be set in the Control Panel of the HMI device.

● An HMI device has been configured as a server.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.

4. In the "Communication drivers" column, select the "SIMATIC HMI HTTP Protocol" driver.
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5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

6. Set the parameters in the Property window.
See "Setting parameters for the client" for more information about the parameters.

Setting parameters for the client

Requirements
● Connection has been created via SIMATIC HMI HTTP protocol. 

● "Connections" editor is open.

Procedure
1. Select "Ethernet" in the Inspector window under "Parameters > Interface".

2. Select protocol http:// or https://.

3. Enter the name of the server or its IP address.

User name and password
If the "Authentication required" check box was selected in the server in the "Control Panel > 
WinCC Internet Settings > Web Server" dialog, a user name and password must be entered 
here in the client.

Timeout
Assign a time after which a connection break is recognized.   
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HTTPS protocol
If the HTTPS protocol is selected, with the following settings you can establish how the HTTPS 
client should check the properties of the server certificate and how it should react in the event 
of error:

● "Allow invalid computer names for certificates"

● "Allow expired certificates"

● "Allow certificates signed by unknown publishers"

Reading out an IP address
If the server has already been commissioned, you can read out the IP address on the server 
as well:  

● For Panel
Click "Start > Programs > Command Prompt" on the server and enter the "ipconfig" 
command using the screen keyboard. The IP address is displayed after pressing <Ret>.

● For PC / Panel PC
Click "Start > Run" on the server, enter "Cmd", and press <Ret>: The command interpreter 
is displayed. Enter the "ipconfig" command. The IP address is displayed after pressing 
<Ret>.

Assigning tag parameters in the client

Assigning tag parameters in the client

Introduction
In order to be able to access tags on the server, they must be configured in the client as tag 
addresses.

Requirements
● Tags have been created in the "HMI tags" editor of the server. 

Procedure
1. Double-click the client under "Devices" in the project tree.

2. Double-click "HMI tags".

3. Create a new tag.

4. Select a data type.
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5. Open the selection dialog in the "Addresses" column.

6. Define the parameters in the working area:
See "Parameters for the client tags" for more information about the parameters.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5285



Parameters for the tags of the client

Parameters for the tags

Data type
● The client does not check the data type. Therefore, pay attention that the data type selected 

here matches the data type of the tags on the server.

● Array tags are not permitted.

Addressing
If the server and client are not within the same project, note the following: 

● Enter the exact name of the tag that is to be communicated with on the server.
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Commissioning a connection

Setting the server's Internet Settings

Introduction
To commission an HTTP/HTTPS connection, the WinCC Internet Settings must be set up in 
the Control Panel of both the server and client, in addition to the configuration in WinCC.   

The name and number of tabs contained in the "WinCC Internet Settings" dialog depend on 
the software installed.

Only the required tabs with the MP 277 HMI device as an example are shown below.

WinCC Internet Settings, Proxy tab
The valid network settings are specified by the network administrator.

Make the following settings:

● Internet settings for HMI devices with Windows CE
In this case, there are several options for calling the Control Panel: 

– In the startup phase, click on the "Control Panel" button in the Windows CE Loader 
menu.

– Select "Start > Settings > Control Panel" in the toolbar.

– During normal operation, pressing the key combination <CTRL + ESC> opens the 
toolbar. Start the Control Panel by selecting "Start > Settings > Control Panel".

– Using the RT function "OpenControlPanel"

The language in the Windows CE based devices is always English.

 

WinCC Internet Settings, Web Server tab
Settings for using the integrated Web Server are made in this tab. 

The "Web Server" tab is only available in the WinCC Internet Settings if the Web Server is 
installed on the HMI device.
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● Tag authenticate
Controls authentication for tag access: 

– "No authentication": Authentication (user name password) is not required for access.

– "Authentication required": Authentication (user name password) is required for access. 
The user name and password for the client are specified during configuration.

● Tag access
Controls access to tags: 

– "Read/write": Tags can be read and rewritten.

– "Read only": Tags can only be read.

● Group for defining operational performance
The following check boxes are not selected in conjunction with tag exchange via the HTTP/
HTTPS protocol:

– Enable remote transfer (project)
Select this check box to enable an HTTP transfer from the configuration computer to 
the HMI device.

– Start automatically after booting
Specifies when the HTTP server should be started:
Enabled: The HTTP server starts immediately after the HMI device is booted, 
irrespective of the runtime software
Disabled: The HTTP server starts at the same time as the runtime software.

– Close with Runtime
Enabling this check box causes the HTTP server to be closed at the same time as the 
runtime software.
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● User Administration
This button opens the "UserDatabase-Edit" dialog box.

In the "User Manager" tab of this dialog box, you can select, delete, or create a new user. 
The "Description" and "Authorizations" tabs always apply to the user currently selected.
(This example dialog box shows a user with the name 'Panel-1_HTTP-Server'.)

● User Manager
"Administrator" is the default user name, and "100" is the default password setting. If a user 
name and password have been entered for the HTTP server under "Connections" in your 
WinCC project, the same user name and password must be specified on the server.
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● Description
Enables input of a user description.

● Authorizations
The newly set up user must be assigned the authorizations for "RT Communication on the 
"Authorizations" tab control.

 

Establishing an HTTP connection

Introduction
To establish an HTTP connection, you must perform the following actions:

● In the "Connections" editor of WinCC, configure the connection as an "https://" protocol 
type and define how the HTTPS client should verify the properties of the server certificate 
and respond to errors.

● Install a valid certificate on the HTTPS client.
Certificates are necessary for server authentication. Using certificates you can ensure that 
the server with which the connection is to be developed is actually the server for which it 
is outputting.           

Principle of an HTTPS connection
After runtime start, the HTTPS client establishes a connection to the HTTPS server. The 
HTTPS server presents its certificate, which the client verifies for authenticity. The session 
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code that can only be read by the HTTPS server is then transmitted. The session code is now 
available on both sides and enables a symmetrical data encryption.

 

 Note

The certificate contains the current time. The current time can lead to problems if the time 
zones of the server and client are different. For example, a certificate generated on a server 
with an Asian time zone only becomes valid on a client with European time zone in the future 
(8 hours).

 

Preparation for installing a certificate on the client
With the first HTTPS client access, the HTTPS server generates the certificate itself and then 
saves it in the "Cert.cer" memory. The file is stored in the following directory:

● On a PC/panel PC (with Windows XP) in the directory "..\\Siemens\Automation\WinCC 
Runtime Advanced\SystemRoot\SSL"

● On Windows CE-based devices in the directory "Flash\Simatic\SystemRoot\SSL"
The certificate must be stored on the HTTPS client on a storage medium from which it can 
be launched with a double click. 

Server Client Possible file transfer
with Windows XP
(PC, Panel PC)

with Windows XP
(PC, Panel PC)

● Disk
● USB stick
● LAN (Ethernet)
● Internet Explorer (via TCP/IP, if 

Service is already running)
With Windows CE
(xP 270, xP 277, MP 370, 
MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

with Windows XP
(PC, Panel PC)

● Memory card
● ActiveSync (serial)

with Windows XP
(PC, Panel PC)

With Windows CE
(xP 270, xP 277, MP 370, 
MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

With Windows CE
(xP 270, xP 277, MP 370, 
MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

With Windows CE
(xP 270, xP 277, MP 370, 
MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

● Memory card
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Installing a certificate on a client with Windows XP
Insert the storage medium on which you have saved the "Cert.cer" file into the HTTPS client 
or open the directory in which the file is located. Double click on the file and follow the 
instructions in the Windows dialog.

Tip: The Internet Explorer provides an easy way to install a certificate. Connect to this device 
via HTTPS (e.g.: https://<my device>). The browser establishes if a certificate has not yet been 
imported. In this case, the browser asks if you want to install the certificate. Any errors in the 
certificate will be displayed.

Installing a certificate on a client with Windows CE
Insert the memory card on which you have saved the converted "Cert.cer" file into the HTTPS 
client. WinCC provides the "InstallCert.exe" tool for importing certificates with Windows CE.

You can implement the installation as follows:

● In Explorer: 
Double click the "Cert.cer" file to install the certificate.

● At the command prompt:
Enter "InstallCert /[command parameter] [filename]".

– command parameters:
/r parameter must be specified because the certificate used in WinCC Runtime is a root 
certificate. 
A root certificate is the main certificate and is used to verify the authenticity of all other 
certificates transferred.

– filename
You must specify the certificate file with its complete path (e.g. "\Storage Card\Cert.cer")

A status alarm is output when you completed the installation. Runtime has to be restarted after 
the installation of a certificate on Windows CE- HMI devices with HTTPS clients. It is necessary 
to restart Runtime so that an HTTPS connection can be established.

The file "Cert.cer" cannot be opened.
The "Cert.cer" file generated at the HTTPS server cannot be opened on HMI devices based 
on Windows CE 5.0 by double-clicking the client.

1. Open the Control Panel.

2. Select "Certificates > My Certificates."

3. Click the "Import" button.
A dialog box opens. 

4. Select the "From a File" menu in the file browser and select the "Cert.cer" file.
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10.11.12.
3

Performance features of communication

Permitted data types

Permitted data types
When configuring tags, the data types listed below can be used.   

Data type in the 
SIMATIC HMI 
HTTP protocol

Length Sign Range of values

Bool 0 No true (-1) or false (0)
SInt 1 Byte Yes -128 to 127
USint 1 Byte No  0 to 255
Int 2 Byte Yes -32768 to 32767
UInt 2 Byte No 0 to 65535
DInt 4 Byte Yes  -2,147,483,648 to 2,147,483,647
UDInt 4 Byte No 0 to 4,294,967,295
Real 4 Byte Yes  -3.402823E38 to -1.401298E-45 for negative values and 

1.401298E-45 to 3.402823E38 for positive values
LReal 8 Byte Yes  -1.79769313486231E308 to

-4.94065645841247E-324 for negative values and 
4.94065645841247E-324 to 1.79769313486232E308 for positive 
values

String 1 to 
255 byte

––––  

DateTime 8 Byte –––– 1.1.1970 00:00:00 up to 31.12.2037 23:59:59
 

 Note
Data types for third-party PLCs

Data types in third-party PLCs may differ from those in WinCC. 

Note the the tag definition of the third-party PLC for the correct assignment.
 

 Note

It is not possible to access array tags from an HTTP client.

Multiplex tags are not supported by the HTTP protocol. If you need a multiplex tag, you must 
configure it on the HTTP client. You will have to create the tags for the multiplex list on the 
server and the client and then connect them. You will then add these tags to the multiplex 
list on the client. 

Address multiplex tags are not supported by the HTTP protocol.
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10.11.13 Communication via OPC

10.11.13.
1

Communication via OPC

Introduction
This section describes the communication between an HMI device and a device via OPC.   

In this case, the HMI device is the OPC client and the device is the OPC server.

For more detailed information on OPC and on configuring OPC servers, refer to Section 
"OPC (Page 5892)".

10.11.13.
2

Configuring a connection via OPC

Introduction
You configure a connection to a device via OPC in the "Connections" editor of the HMI device. 

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.

4. In the "Communication drivers" column, select the "OPC" driver.
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5. Select the "OPC" interface for the HMI device under "Parameters > Interface".

6. Select an OPC server from the tree view under "Parameters > OPC servers".
The OPC server is entered in the "Name of OPC server" field.
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10.11.13.
3

Performance features of communication

Permitted data types for OPC DA

Permitted data types for connections with OPC DA
The table lists the user data types that can be used when configuring tags.     

Data type Length
VT_BOOL 1-bit
VT_I1 1 byte
VT_UI1 1 bytes
VT_I2 2 bytes
VT_UI2 2 bytes
VT_I4 4 bytes
VT_UI4 4 bytes
VT_R4 4 bytes
VT_R8 8 bytes
VT_BSTR --
VT_DATE 8 bytes
VT_DATE|VT_ARRAY --
VT_I1|VT_ARRAY --
VT_UI1|VT_ARRAY --
VT_I2|VT_ARRAY --
VT_UI2|VT_ARRAY --
VT_I4|VT_ARRAY --
VT_UI4|VT_ARRAY --
VT_R4|VT_ARRAY --
VT_R8|VT_ARRAY --
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Permitted data types for OPC XML DA

Permitted data types for connections with OPC DA XML
The table lists the user data types that can be used when configuring tags.     

Data type Length
boolean 1-bit
byte 1 byte
unsignedByte 1 byte
short 2 bytes
unsignedShort 2 bytes
int 4 bytes
unsignedInt 4 bytes
float 4 bytes
double 8 bytes
string --
dateTime --
time --
date --

 

 

Permitted data types for OPC UA

Permitted data types for connections with OPC UA
The table lists the user data types that can be used when configuring tags.     

Data type Length
Boolean 1-bit
SByte 1 byte
Byte 1 byte
Int16 2 bytes
UInt16 2 bytes
Int32 4 bytes
UInt32 4 bytes
Float 4 bytes
Double 8 bytes
String --
DateTime --
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10.11.14 Communication via routing

10.11.14.
1

Communication via routing

Introduction
If all stations in an automation system are not connected to the same subnet, these stations 
cannot be accessed directly online. 

A connection between partners in different subnets is only possible via routing. 

You configure the routing settings with the properties of the interfaces.

Communication from connection partners in various different subnets can be routed via the 
following links: 

● PROFINET

● PROFIBUS 

● MPI

Requirements for routing
To establish a connection to these devices, a router must be interposed. In this case, a 
SIMATIC station can also act as a router if it has appropriate interfaces with the different 
subnets. 

Modules with communication capability (CPUs or CPs) used to establish gateways between 
the subnetworks must have routing capability.

A connection between partners in different subnets is only possible with IP routing. The routing 
settings can be edited in the corresponding interface properties.
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Routing path
The routing path is determined in Runtime by the system and cannot be influenced by the user. 
During configuration, it is not possible to generate information about a faulty connection. 

HMI devices as routers
Only SIMATIC PCs or PC stations can be used as a router. 

All other HMI devices from the "HMI" area cannot be used as a router. 
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10.11.14.
2

Example for communication via routing

Communication via routing
Illustration of a hardware configuration with a routing connection

In the figure above, a routing connection has been established between an HMI device and 
the SIMATIC S7-300 controller. 

The SIMATIC S7-400 automation device serves as a router. 

A routing connection can be made directly in integrated projects. The communication partners 
are connected in the "Devices and Networks" editor. 

You configure the parameters of the connection and interface in the Inspector window.
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10.11.14.
3

Configuring communication via routing

Introduction
The following configuration describes a network for the following communication partners:

● KTP1000 Basic PN

● SIMATIC S7-400 with PROFINET and PROFIBUS interface

● SIMATIC S7-300 with PROFIBUS interface

Requirements
● KTP1000 Basic PN is connected via PROFINET to the SIMATIC S7-400.

● SIMATIC S7-400 is connected via PROFIBUS to the SIMATIC S7-300.

Procedure
1. Click on the PROFINET interface of the HMI device.

2. In the Inspector window, click "Properties > General > Ethernet addresses".
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3. Click "Use router" in the "IP protocol" area.

4. Enter the IP address of the router in the "Router address" field.

10.11.15 PROFINET IO and IRT

10.11.15.
1

PROFINET IO

What is PROFINET IO?

PROFINET IO  
PROFINET is an Ethernet-based automation standard of PROFIBUS Nutzerorganisation e.V. 
(PNO) which defines a manufacturer-neutral communication, automation and engineering 
model.
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Objective
The objective of PROFINET is:

● Integrated communication via field bus and Ethernet

● Open, distributed automation

● Use of open standards

Architecture
The PROFIBUS User Organisation e.V. (PNO) has designated the following aspects for 
PROFINET architecture:

● Communication between controllers as components within distributed systems.

● Communication between field devices, such as I/O devices and drives.

Implementation by Siemens
The demand for "Communication between controllers as components within distributed 
systems" is implemented by "Component Based Automation" (CBA). Component Based 
Automation is used to create a distributed automation solution based on prefabricated 
components and partial solutions. 

The demand for "Communication between field devices" is implemented by Siemens with 
"PROFINET IO". Just as with PROFIBUS DP, the complete configuration and programming 
of the components involved is possible using the Totally Integrated Automation Portal. 

The following sections deal with the configuration of communication between field devices 
using PROFINET IO.

PROFINET IO systems

PROFINET IO system
A PROFINET IO system is comprised of a PROFINET IO controller and its assigned 
PROFINET IO devices. 

● A PROFINET IO controller is a PLC that controls the automation task.
Example: SIMATIC S7 1500 PLC

● A PROFINET IO device is a device that is controlled by an IO controller.
Examples: HMI device TP 1200 Comfort, a head module of the distributed IO family ET 
200S

As soon as you connect an IO controller to an IO device, a controller-device link is established.
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10.11.15.
2

IRT communication

Overview of RT classes

RT classes in PROFINET IO     
PROFINET IO is a scalable, real-time communication system based on Ethernet technology. 
The scalable approach is reflected in several real-time classes:

● RT: Transmission of data in prioritized, non-isochronous Ethernet frames. The required 
bandwidth is within the free bandwidth area for TCP/IP communication.

● IRT: Isochronous transmission of data with high stability for time-critical applications (for 
example, motion control). The required bandwidth is from the area of bandwidth reserved 
for cyclic data.

Device dependency
Depending on the device, not all real-time classes are supported. 

You can find further information on device dependency here: Performance characteristics of 
PROFINET IO and IRT (Page 5313) 

Introduction: Isochronous Realtime Ethernet

Introduction: Isochronous Realtime Ethernet
IRT is a transmission method by which PROFINET devices are synchronized with very high 
accuracy. 

A sync master specifies the clock to which sync slaves are synchronized. An IO controller or 
an IO device can have the role of sync master. 

Sync master and sync slaves are always devices in a sync domain. Bandwidth is reserved 
within the sync domain for IRT communication. Real-time and non-real-time communication 
(TCP/IP communication) is possible outside of the reserved bandwidth.
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Time ranges of communication cycles
The communication cycle is divided into three time ranges, which are represented in the 
following chart:

● IRT data (synchronized communication)
This area can be reserved in specific steps, depending on the send clock. Within this time 
range the IRT data is transmitted. 

● RT data (real-time communication)
In this time range the cyclic RT date is transmitted. RT data has a higher priority than 
"normal" TCP/IP data. TCP/IP data or Ethernet frames can have a priority between 1 and 
7. RT data has a priority of 6. 

● TCP/IP data (standard communication)
Standard communication (TCP/IP, etc.) is transmitted in the remaining interval of the 
communication cycle.

Applications of IRT
PROFINET with IRT is especially suited for:

● High performance and deterministics for large quantity structures with regard to user data 
communications (productive data)

● High performance even with many devices in the line topology with regard to user data 
communications (productive data). 

● Parallel transmission of production and TCP/IP data over wire, and securing the forwarding 
of production data when data volume is high by reserving transmission bandwidth.
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Basic procedures for configuring IRT

Basic procedures for configuring IRT
If you want to upgrade equipment with PROFINET IO to IRT, follow these three steps: 

1. Configure the PROFINET IO device. The PROFINET device must support IRT.

2. Set which device acts as the sync master and synchronizes the other devices. For this you 
must configure a sync domain with a sync master and at least one sync slave.

3. Download the configuration to all involved devices.

You can find further information on IRT configuration here: Auto-Hotspot 

Creating PROFINET IO configuration for IRT
As a prerequisite for IRT configuration, there must be an existing PROFINET IO configuration, 
i.e., one or more stations must be configured with an IO controller and IO devices.

You can read which components are suitable for IRT communication in the task card 
"Information", once you have selected the corresponding components in the hardware catalog.

The requirements for functioning IRT communication are met simply by configuring a 
PROFINET IO system with components that support IRT.

Sync domain

Sync domain
A sync domain is required for synchronization of PROFINET IO devices. The sync domain 
assures that all devices belonging to it communicate synchronously.

Prerequisite for IRT communication is a synchronization cycle to distribute a common time 
base for all PROFINET devices in a sync domain. With this base synchronization, a 
synchronous transmission cycle of PROFINET devices within a sync domain is achieved. The 
sync master (usually an IO controller) generates the common synchronization clock and 
specifies the time basis on which all other sync slaves (usually IO devices) are synchronized.

If the sync master fails, the communication between the IRT devices reverts to RT 
communication. 

Background processes during configuration of an IO system
If you configure an IO controller and network it with an Ethernet subnet, it will automatically be 
added to the default sync domain of the Ethernet subnet. The default sync domain is always 
available. The IO controller operates unsynchronized. 

If you assign an additional IO device to the IO system of the IO controller, the IO device 
automatically assigns the IO controller's sync domain. 
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10.11.15.
3

Configuring the HMI device as IO device

Introduction
An IO controller and at least one PROFINET IO device are necessary for a PROFINET IO 
system.

Requirements
● A SIMATIC S7 1200 or SIMATIC S7 1500 PLC has been created.

● An HMI device from the Comfort Panels device family has been created.

● The "Devices & Networks" editor is open.

Procedure
1. You network the PLC with the HMI device:

2. Click the HMI device in the "Devices & Networks" editor.

3. In the inspector window, you select the following:
"General > PROFINET Interface (X1) > Operating mode"

4. Select the "IO device".

5. You assign the parameters required for your PROFINET IO system
You can find further information on the parameters for PROFINET IO systems here: 
Parameters for PROFINET IO and IRT (Page 5311) 
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10.11.15.
4

Parameters for PROFINET IO and IRT

I-device communication

I-device
The "I-device" functionality (intelligent IO device) of a CPU allows data to be exchanged with 
an IO controller and therefore to use the CPU, for example, as an intelligent preprocessing 
unit of subprocesses. The I-device is linked as an IO device to a "higher-level" IO controller.

Parameters for I-device communication

● Transfer areas
Display transfer areas of the I-device communication

● Diagnostics address of communication
Display of diagnostic data of the IO device

Configuring an I-device with a GSD file
If you use an I-device in another project, or if the I-device is used in another engineering system, 
then configure the higher-level IO controller and the I-device as described above.
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However, click on the "Export" button after configuring the transfer areas in order to create a 
GSD file from the I-device. This GSD file represents the configured I-device in other projects. 

The "Export" button is found in the "I-device communication" section of the inspector window. 

The hardware configuration is compiled and the export dialog opened. 

Assign a name for the I-device proxy as well as a description in the fields provided. Click the 
"Export" button to complete your process. 

Finally, import the GSD file, for example, into another project. 

Real-time settings

Parameters for real-time settings
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● Update time

– Display of update time used in network.

– Selection of update times available in network.

● Watchdog time

– Selection of available update cycles.

– Display of watchdog time used in network.

● Synchronization

– Display of sync domain used

– Selection of RT class.

– Selection of role in the sync domain.

10.11.15.
5

Performance characteristics of PROFINET IO and IRT

Configuration of PROFINET and IRT

Setting up PROFINET with IRT
Keep in mind the following rules for the set up and operation of a PROFINET IO system in IRT 
operation. They serve to insure an optimal operation of your PROFINET IO system.

● When using IRT, you must configure the topology. This will enable exact calculation of the 
update time, bandwidth, and additional parameters. 

● If you would like to use multiple sync domains, configure a sync domain boundary for the 
port which is currently connected to the PROFINET device of another sync domain.

● In a sync domain you can only configure one sync master at a time.

● A PROFINET IO system may only be part of a single sync domain.

● If you configure a PROFINET device in a sync domain and want to synchronize with IRT, 
the PROFINET devices concerned must support IRT communication.

● Wherever possible, use the same PROFINET device as the PROFINET IO controller and 
sync master. 

● If only some of the PROFINET devices in a PROFINET IO system are synchronized, please 
keep in mind the following: PROFINET devices which are not part of IRT communication 
are placed outside of the sync domain.
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Device dependency 

IRT communication
The following HMI devices support IRT communication:

● TP700 Comfort and KP700 Comfort

● TP900 Comfort and  KP900 Comfort

● TP1200 Comfort and KP1200 Comfort

● TP1500 Comfort and KP1500 Comfort

● TP1900 Comfort

● TP2200 Comfort 

Communication options
The following configuration options are available for Comfort Panels:

● Comfort Panel with PROFINET Basis functionality without PROFINET IO

● Comfort Panel with PROFINET RT in an RT network networked with an RT controller

● Comfort Panel with PROFINET RT as end point in an IRT network networked with an RT 
controller

● Comfort Panel with PROFINET IRT in an IRT network networked with an IRT controller

10.11.16 Media redundancy

10.11.16.
1

Restrictions with media redundancy

Diagnostic interrupts
If you have activated "Diagnostic interrupts", diagnostic interrupts pertaining to "Media 
redundancy" are only processed by PROFINET-compatible devices and displayed on the "IO 
Controller". 

If you do not use a PROFINET-compatible device, the "Diagnostic interrupts" selection does 
not have any function.

Diagnostic interrupts are only detected by the IO controller. There is no separate diagnostic 
interrupts for HMI devices that are detected and displayed by HMI devices.
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10.11.16.
2

Media redundancy

Media redundancy options  
To increase the network availability of an industrial Ethernet network with optical or electrical 
line topology, the following options are available:

● Meshing networks

● Parallel switching of transmission modes

● Consolidation of a line topology to a ring topology

Media redundancy in ring topologies
Devices in ring topologies can be the external switches and/or integrated switches of 
communication modules.

To set up a ring topology with media redundancy you must join both free ends of a line-shaped 
network topology to one device. 

Consolidation of a line topology to a ring takes place over 2 ports (ring ports) in a device in the 
ring. 

This device is the redundancy manager. All other devices in the ring are the redundancy clients.

The following figure shows the ring type interconnection:

The two ring ports in a device are the ports which create the connection to both of its 
neighboring devices in a ring topology. 

The selection and set up of the ring ports takes place during configuration of the respective 
device.

Download the configuration in the individual devices before physically connecting the ring.

Functions of media redundancy in a ring topology
If a part of the ring is disconnected, then the data paths between the individual devices is 
automatically reconfigured. After the reconfiguration the devices are once again accessible in 
the newly created topology.
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In the redundancy manager, 2 ring ports will be separated from each other during interruption-
free network operation, so that no data frames circulate. 

The ring topology is a line when viewed from the standpoint of data transfer. The redundancy 
manager monitors the ring topology. To do so it sends a test frame not only from ring port 1 
but also from ring port 2. The test frame passes through the ring in both directions until it arrives 
at the other ring port on the redundancy manager.

An interruption in the ring can occur from connection failure between two devices or device 
failure in the ring.

If the redundancy manager's test telegram does not reach the other ring port because of 
interruption in the ring, the redundancy manager connects via both ports. 

With this alternate route a functioning connection is again created among all remaining devices 
in a line-shaped topology.

The time between ring interruption and re-establishment of a functional line topology is called 
the reconfiguration time.

As soon as the interruption is eliminated, the original transmission route is again created, both 
ring ports in the redundancy manager are separated from each other, and the redundancy 
clients are notified of the change. 

The redundancy clients then use the new route to the other devices.

If the redundancy manager fails, then the ring is changed to a functional line.

10.11.16.
3

Media Redundancy Protocol (MRP)

Media Redundancy Protocol (MRP)  
The MRP process works in conformity with Media Redundancy Protocol (MRP), which is 
specified in IEC 61158 Type 10 "PROFINET".

The reconfiguration time following an interruption of the ring amounts to a maximum of 0.2 
seconds.

Requirements for trouble-free operation
Requirements for trouble-free operation with media redundancy process MRP are:

● MRP is supported in ring topologies of up to 50 devices. Exceeding the device limit can 
lead to data traffic failure.

● All devices must be connected to each other via their ring ports.

● "MRP" must be activated on all devices in the ring.

● The connection settings (transfer medium / duplex) must be set to full duplex and for at 
least 100 Mbit/s for all ring ports. Otherwise data traffic failure can occur.

● In STEP 7 configuration in the properties dialog for all ports in the ring, set the connection 
in the register "Options" to "Automatic settings".
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HMI devices for media redundancy
The following HMI devices support "Media Redundancy":

● KP700 Comfort

● TP700 Comfort

● KP900 Comfort

● TP900 Comfort

● KP1200 Comfort

● TP1200 Comfort

● KP1500 Comfort

● TP1500 Comfort

● TP1900 Comfort

● TP2200 Comfort

10.11.16.
4

Configuring media redundancy for HMI devices 

Requirements        
● The participating components must support "media redundancy".

● IRT communication is not configured

● One device on the network must be configured as "Redundancy manager".

● A ring topology is set up by means of port interconnections.
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Procedure
1. Click on the PROFINET interface of an HMI device.

2. Select "General > Advanced settings > Media redundancy" in the properties.

3. Select "Client" in the "Media redundancy role" area.

Result
The HMI device is now operating as client on the MRP network.

The default ring ports will automatically be displayed in the subjacent fields.
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10.11.16.
5

Parameters for media redundancy

 

MRP domain
This area displays the MRP domain. 

You can rename the MRP domain in the "Domain settings" dialog. 

Domain settings
Click "Domain settings" to open the "Domain settings" editor.

You also manage the MRP domains in the MRP domain area of the "Domain settings" editor.

Media redundancy role
Assign the role of the HMI device in the "Media redundancy role" area. 

You have the following options:

● Client
The HIM device is operated as "Client" in an MRP domain.

● Not a node of the ring
The HIM device is not operated within an MRP domain.

Ring port 1 and Ring port 2
Display of available ring ports
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Diagnostic interrupts
The following diagnostic interrupts can be generated if "Diagnostic interrupts" is activated:

● Wiring or port error
Diagnostics interrupts will be generated for the following errors in the ring ports:

– A neighbor of the ring port does not support MRP

– A ring port is connected to a non-ring port

10.11.16.
6

Managing MRP domains

You can monitor and adjust the media redundancy settings centrally.

Requirements        
The devices are configured and networked.

Procedure
1. Select the PROFINET interface of the HMI device.

2. Select the "Advanced options > Media redundancy" area in the Inspector window.
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3. Click the "Domain settings" button.

4. Navigate to the "Domain management > MRP domains" area in the Inspector window.

MRP domains
You can specify the default MRP domain in the "MRP domains" area.

You can rename all domains and check the redundancy roles and ring ports. 

For each MRP domain, you receive an overview of how many PROFINET interfaces are 
interconnected in the ring, how many PROFINET interfaces are located outside the ring, and 
the number of redundancy managers and redundancy clients.

You can have the devices in the ring, including device name, associated MRP domain, media 
redundancy role, and utilized ring ports, displayed in groups: 

● IO systems
The list shows you all configured devices of the selected IO system. 

● Rings
The list shows you all ring interconnections of the selected IO system. The identified rings 
are numbered consecutively. If all devices of this ring belong to one MRP domain, this is 
also displayed. 

● MRP domain
The list shows you the existing MRP domains of the selected IO system.
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10.11.17 Communication with other PLCs

10.11.17.
1

Communication with other PLCs

Introduction
Communication with other PLCs is communication with PLCs that are not in the SIMATIC 
family.       

These PLCs have proprietary protocols for data exchange. The protocols are configured as 
communication drivers in WinCC.

Communication drivers
The following communication drivers are supported in WinCC and are already installed:

● Allen-Bradley

– Allen-Bradley EtherNet/IP

– Allen-Bradley DF1

● Mitsubishi

– Mitsubishi MC TCP/IP

– Mitsubishi FX

● Modicon Modbus

– Modicon Modbus TCP/IP

– Modicon Modbus RTU

● Omron

– Omron Host Link

Communication drivers in WinCC RT Professional
The following communication drivers are supported for RT Professional:

● Allen-Bradley

– Allen-Bradley EtherNet/IP

● Mitsubishi

– Mitsubishi MC TCP/IP

● Modicon Modbus

– Modicon Modbus TCP
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Connections between HMI devices and other PLCs
You configure the connections between HMI devices and other PLCs in the "Connections" 
editor of the HMI device. These connections are non-integrated connections.

10.11.17.
2

Distinctive features when configuring

Distinctive features for data exchange
Distinctive features apply when configuring connections to other PLCs, compared to 
configuring integrated connections.

Note the following distinctive features when configuring:

● Addressing of tags

● Permitted data types

● Distinctive features when configuring area pointers

● Distinctive features when configuring alarms

● Distinctive features when configuring trends

For more detailed information on distinctive features when configuring, refer to Section "Data 
exchange" of the respective communication driver.

10.11.17.
3

Parallel communication 

Parallel communication of communication drivers 
The following table shows an overview of which communication drivers you can use 
simultaneously on one HMI device. 

 

 Note

Parallel communication is not approved for Basic Panels.
 

Parallel communication over Ethernet interfaces
The approved combinations can be operated via the same Ethernet interface. Several Ethernet 
interfaces are not required.

Parallel communication only concerns the Ethernet-based communication drivers.
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Parallel communication over serial interfaces
The following applies for parallel communication over serial interfaces:

● One communication driver per interface.

● One interface per communication driver.

10.11.17.
4

Communication drivers

Allen-Bradley

Allen-Bradley communication drivers 

Introduction
This section describes the communication between an HMI device and PLCs that use Allen-
Bradley communication drivers.    

The following communication drivers are supported:

● Allen-Bradley EtherNet/IP

● Allen-Bradley DF1

Data exchange
Data is exchanged by means of tags or area pointers.

● Tags
The PLC and the HMI device use process values for data exchange. You create tags in 
the configuration that point to addresses in the PLC. The HMI device reads the value from 
the defined address, and then displays it. The operator may also enter values on the HMI 
device, which are then written to the address in the PLC.

● Area pointers
Area pointers are used to exchange specific data and are only set up when these data are 
used.

Allen-Bradley EtherNet/IP

Configuring a connection via Allen-Bradley EtherNet/IP

Introduction
You configure a connection to a PLC with an Allen-Bradley EtherNet/IP communication driver 
in the "Connections" editor of the HMI device. 

The Ethernet interfaces are named differently depending on the HMI device. 
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Example: PROFINET interface corresponds to the Ethernet interface      

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Allen-Bradley EtherNet/IP" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Allen-Bradley EtherNet/IP)

Parameters to be set
To assign the connection parameters, such as addresses and profiles, click the connection 
that you have created in the "Connections" editor.         

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "PLC" area is available for assigning parameters according to the interface 
used. 
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Parameters for the HMI device
You can select only one interface for the HMI device in the Inspector window under 
"Parameters". Depending on the HMI device, there are several interfaces available.

If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. The IP address is transferred to the HMI device upon 
subsequent loading. 

 

 Note

The IP address in the control panel will be overwritten upon subsequent loading if you have 
already set up the IP address in the HMI device control panel.

The IP address already set up in the control panel will be retained upon subsequent loading 
if you activate "Set IP address using a different method".

 

To set up the IP address of the HMI device:

1. Click on the HMI device.

2. Open the "Device configuration" editor.
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3. Click the Ethernet interface.

4. Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

Parameters for the PLC
● CPU type

For "CPU type", set the CPU type of the PLC used.

● IP address
Set the IP address or host name of the Ethernet/IP module of the PLC. Only the IP address 
can be used on a Basic Panel.

● Communication path
Set the CIP path from the Ethernet module to the PLC. This establishes a logical connection 
between the Ethernet module and PLC, even if both devices are located in different CIP 
networks.
For additional information see: Examples: Communication path  

Connecting HMI device to PLC

Connections via Allen-Bradley EtherNet/IP

Connection
The HMI device can be connected to the Allen-Bradley PLC using the following components:   

● Existing Ethernet network that also contains the PLCs

● Cross-over Ethernet cable connected directly to the Ethernet interface of the CPU or the 
communication module

The connection of the HMI device to an Allen-Bradley PLC is limited primarily to the physical 
connection of the HMI device. Special blocks for the connection are not required in the PLC.

Communication types 

Approved communication types with Allen-Bradley EtherNet/IP
The following communication types are system-tested and approved: 

● Point-to-point connection to the approved PLCs

● Multipoint connection from a HMI device (Allen-Bradley Ethernet/IP-Client) with up to 4 
PLCs with the respectively approved PLCs. CPU types can be mixed.
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Connection
Connection with the following PLCs is approved with Allen-Bradley EtherNet/IP:

● CPU type: "ControlLogix, Compact Logix"

– ControlLogix
556x(1756-L6x) with Ethernet module 1756-ENBT

– Guard Logix-System ControlLogix
556xS(1756-L6xS) with Ethernet module 1756-ENBT

– CompactLogix

– 533xE(1769-L3xE) with Ethernet interface onboard

– 532xE(1769-L2xE) with Ethernet interface onboard

– 534x (1768-L4x) with Ethernet module 1768-ENBT

● CPU type: "SLC, MicroLogix"

– MicroLogix 1100 (with Ethernet interface onboard)

– MicroLogix 1400 (with Ethernet interface onboard)

– SLC 5/05 (with Ethernet interface onboard)

Performance features of communication

Permitted data types for Allen-Bradley EtherNet/IP

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.         

CPU type: ControlLogix, CompactLogix 

Data type Length
Bool 1 bit
DInt 4 bytes
Int 2 bytes
Real 4 bytes
SInt 1 byte
String 1 to 80 characters
UDInt 4 bytes
UInt 2 bytes
USInt 1 byte

Permitted data types arrays
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Address Permitted data types
Array SInt, USInt, Int, UInt, DInt, UDInt, Real
Individual bits from the basic data types of 
the PLC SInt, USInt, Int, UInt, DInt, UDInt 

Bool*

* Any changed value of certain defined bits is written back to the PLC. There is no check to 
determine whether any other bits have changed. The PLC (or other PLCs) may only read 
access the value.

CPU type: SLC, MicroLogix 

Data type Operand type Length
ASCII A 0 to 80 characters
Bool N, R, C, T, B, S, I, O 1 bit
DInt N 4 bytes
Int N, R, C, T, S 2 bytes
Real N, F 4 bytes
String ST 1 to 80 characters
UDInt N 4 bytes
UInt N, R, C, T, B, I, O 2 bytes

 

 Note

Strings in RSLogix 5000 have a default length of 82 characters. A maximum of 80 characters 
can be displayed in WinCC. Always use strings which do not exceed the maximum length of 
80 characters.

 

Permitted data types arrays

Address Permitted data types
Array Int, UInt, DInt, UDInt, Real

Distinctive features for connections with Allen-Bradley Ethernet/IP
With the communication driver Allen Bradley Ethernet/IP and the CPU type SLC, MicroLogix, 
you can only use array tags for discrete alarms and trends. 

 

 Note

I/O modules with 8 or 16 ports occupy one data word on the PLC.

I/O modules with 24 or 32 ports occupy two data words. 

The HMI device does not output an error message if using non-existent bits.

You should always make sure that I/O modules with 8 or 24 ports only occupy the bits that 
are actually assigned to a port.
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Supported CPU types for Allen-Bradley EtherNet/IP

CPU types
The following CPU types are supported for configuring the Allen-Bradley EtherNet/IP 
communication driver.     

● CompactLogix

– 1769-L2xE with Ethernet interface onboard

– 1769-L3xE  with Ethernet interface onboard

– 1768-L4x with Ethernet module 1768-ENBT

● ControlLogix

– 1756-L6x  with Ethernet module 1756-ENBT

● GuardLogix

– 1756-L61S  with Ethernet module 1756-ENBT

– 1756-L62S  with Ethernet module 1756-ENBT

– 1756-L63S  with Ethernet module 1756-ENBT

● MicroLogix

– MicroLogix 1100 / 1400

● SLC50x

– SLC5/05

Addressing in the C.Logix CPU type

Addressing

Addressing
A tag is uniquely referenced in WinCC by means of an address in the PLC. The address must 
correspond with the tag name in the PLC. The tag address is defined by a string with a length 
of up to 128 characters.     

Using characters for addressing
Valid characters for tag addressing:

● Letters (a to z, A to Z)

● Numbers (0 to 9)

● Underscore ( _ )

The tag address consists of tag name and other character strings used to specify the tag in 
the PLC.
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Tag name properties:

● The tag name may begin but not end with an underscore character.

● Strings with successive underscore and space characters are invalid.

● The address may not exceed a length of 128 characters.
 

  Note

The characters reserved for tag addressing may not be used in program/tag names or at 
any other address instance.

 

The reserved characters are listed below:

Reserved character Function
. Element delimiter
: Definition of a program tag
, Delimiter for addressing multi-dimensional arrays
/ Reserved for bit addressing.
[ ] Addressing of array elements or arrays

PLC and program tags
The Allen-Bradley EtherNet/IP communication driver supports addressing of PLC tags (global 
project tags) and/or program tags (global program tags). 

A program tag is declared based on the program name in the PLC and actual tag name which 
are delimited by colon. PLC tags are simply addressed by their name.

 

 Note
Addressing errors

Addressing errors occur when the tag name and data type are inconsistent.

Note that the tag name defined in the address field in WinCC must match the tag name in 
the PLC. Make sure that the data types of tags in WinCC match the data types in the PLC.

 

 Note

Module-specific tags, e.g. for data on input and output modules, cannot be addressed directly. 
Instead, use an alias tag in the PLC.

Example: Local:3:O. Data cannot be addressed in WinCC. 

If the alias "MyOut" is defined for Local:3:O in the PLC, you can address with WinCC via 
MyOut.Data. 
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Addressing syntax

Notation of addresses
The tables below define the notation for the individual addressing options for Allen-Bradley 
EtherNet/IP. 

Table 10-155 Access to arrays, basic data types and structure elements

Data types Type Address
Basic data types PLC tag Tag name

Program tag Programname:tagname
Arrays PLC tag Array tag

Program tag Program name: array tag
Bits PLC tag Tagname/bitnumber

Program tag Programname:tagname/bitnumber
Structure elements PLC tag Structure tag. Structure element

Program tag Program name: structure tag. structure element
 

 Note

Bit addressing with the data types Bool, Real and String is not permitted and will cause an 
addressing fault.

 

Description of the syntax
Syntax description:

 (Programname:)tagname([x(,y)(,z)]){.tagname([x(,y)(,z)])}(/
bitnumber)
● The "( )" defines an optional, single instance of an expression.

● The "{ }" defines an optional expression with multiple single instances.

The address string length may not exceed 128 characters.

Addressing types

Arrays
An array is a data structure that includes a number of data of the same type. WinCC only 
supports one-dimensional arrays.  

In the address column of the tag editor, enter the array name possibly by specifying a start 
element. The length is defined in the Array Elements input box of the tag editor. If array limits 
in the PLC are exceeded (due to faulty indexing), addressing errors result.

These arrays must be declared in the PLC as controller or program tags.
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Two- or three-dimensional arrays in the PLC can only be addressed in WinCC if these can be 
mapped area-wise onto one-dimensional arrays .

 

 Note

During all read accesses and all write accesses, all array elements of a tag are always read 
or written, respectively. The contents of an array tag which is interconnected with a PLC are 
always transferred whenever there is a change. The HMI device and the PLC cannot 
concurrently write data to the same array tag for this reason. Instead of writing data only to 
a single element, the program writes the entire array to the PLC.

 

Array elements
Elements of one-dimensional, two-dimensional and three-dimensional arrays in the PLC are 
indexed by setting an index and the corresponding notation in the tag editor. Array addressing 
starts at element "0", with arrays of all basic types being valid for element addressing. Read/
write operations are only carried out at the addressed element, and not for the entire array.

Bits and bit tags
Bit access is allowed to all basic data types with the exception of Bool, Real and String. Bit 
addressing is also allowed at array/structure elements. The Bool data type is set in WinCC 
when bits and bit tags in the basic data types are addressed. 

Single-digit bit numbers are addressed with "/x" or "/0x" (x = bit number). Bit numbers are 
defined by up to two digits.

 

 Note

With the "Bool" data type in the data types SInt, Int and DInt, after changing the specified bit 
the complete tag is then written in the PLC again. In the meantime, no check is made as to 
whether other bits in the tag have since changed. Therefore, the PLC may have only read 
access to the specified tag.

 

Structures
User-defined data types are created by means of structures. These structures group tags of 
different data types. Structures may consist of basic types, arrays and of other structures. In 
WinCC, only structure elements are addressed and not entire structures.

Structure elements
Structure elements are addressed by means of the name of the structure and of the required 
structure element. This addressing is separated by point. In addition to basic data types, the 
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structure elements may represent arrays or other structures. Only one-dimensional arrays may 
be used as a structure element.

 

 Note

The nesting depth of structures is only limited by the maximum length of 128 characters for 
the address.

 

 

Address multiplexing

Address multiplexing
Address multiplexing is possible with the CompactLogix, ControlLogix CPU type.   

Address multiplexing requires two tags:

● "Tag_1" of data type "String"; contains a logical address such as "HMI:Robot5.Block5" as 
value.
The value may change to a second valid address, for example, "HMI:Robot4.Block3".

● "Tag_2" is a tag in which the "Allen-Bradley EtherNet/IP" communication driver is set up as 
a connection.
Enter a valid name of an HMI_tag in square brackets as the address.

– e.g.: "[Tag_1]"

– The tag must be of the String data type. 

– The square brackets indicate address multiplexing. 

– The address is derived from the actual value in "Tag_1".
 

  Note

You can only multiplex entire Allen-Bradley EtherNet/IP addresses. Multiplexing of 
address elements is not possible. "HMI:Robot[Tag_1].Block5" is an invalid address.

You can optionally click the arrow right icon in the "Address" column. Replace the 
"Constant" with the "Multiplex" entry by clicking the arrow on the left edge of the next 
address dialog box. Now the tag selection list only returns tags of data type "String".

You can also configure a function triggered by a "change of value" event for multiplexed 
tags.

 

Examples for addressing

Example of a table for addressing
The table below defines the basic variants for addressing PLC tags. Other addressing variants 
are possible by means of combination.
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Type Type Address
General PLC tag Tag name

Program tag Program:tagname
Array Access to an element of a 2-

dimensional array
Arraytag[Dim1,Dim2]

Element of structure array (1-
dimensional)

Arraytag[Dim1].structureelement

Bit in element basic type 
array (2-dimensional)

Arraytag[Dim1,Dim2]/Bit

Structure Array in structure Structuretag.arraytag
Bit in the element of an array 
in the substructure

Structuretag.structure2.arraytag [element]/
bit

 

 Note

Program tags are addressed by leading the address with the program name derived from the 
PLC with colon delimiter.

Example: Programname:arraytag[Dim1,Dim2]
 

Access to array elements

Type Address
PLC tag Arraytag[Dim1]

Arraytag[Dim1,Dim2]
Arraytag[Dim1,Dim2,Dim3]

Program tag Programname:arraytag[Dim1]
Programname:arraytag[Dim1,Dim2]
Programname:arraytag[Dim1,Dim2,Dim3]

Examples: Communication path 

Example 1:
Connection with a PLC in the same Allen-Bradley rack.

1,0

Number Meaning
1 Stands for a backplane connection.
0 Stands for a CPU slot number.
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Example 2:
Connection with a PLC in remote Allen-Bradley racks. Two Allen-Bradley racks are networked 
on Ethernet.

1,2,2,190.130.3.101,1,5

Number Meaning
1 Backplane connection
2 Stands for the CPU slot number of the second Ethernet module.
2 Stands for an Ethernet connection.
190.130.3.101 IP address of a remote AB rack on the network – in particular the third Ethernet 

module
1 Backplane connection
5 Slot number of the CPU

Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

 

  Note

If running the CompactLogix PLC with firmware earlier than version 18, you will possibly 
have to restart the HMI device following the transfer of the PLC program. 

You could also terminate the connection before transferring the PLC program and set up 
the connection again after having completed the transfer of the PLC program.

 

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.
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Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.
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Allen-Bradley DF1

Configuring a connection via Allen-Bradley DF1

Introduction
You configure a connection to a PLC with an Allen-Bradley DF1 communication driver in the 
"Connections" editor of the HMI device.      

The interfaces are named differently depending on the HMI device. 

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Allen-Bradley DF1" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Allen-Bradley DF1)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.     

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used.
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Parameters for the HMI device
● Interface

Under "Interface", you select the interface of the HMI device to which the PLC is connected.
For additional information, refer to the device manual for the HMI device.

● Type
Specifies the physical connection used.

 

  Note

If you are using the IF1B interface, you must also reconnect the RS-485 receive data and 
the RTS signal to the rear of the HMI devices via 4 DIP switches.

 

● Baud rate
For "Baud rate", select the transmission speed between the HMI device and PLC.

● Data bits
For "Data bits", you can choose between "7 bits" and "8 bits".

● Parity
For "Parity", you can choose from "None", "Even", and "Odd".

● Stop bits
For "Stop bits", you can choose between 1 and 2 bits.
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Parameters for the network
● Checksum

For "Checksum", choose the method for determining the error code: "BCC" or "CRC".

Parameters for the PLC
● Destination address

For "Destination address", choose the PLC address. If there is a point-to-point DF1 
connection, you set the address "0".

● CPU type
For "CPU type", set the CPU type of the PLC used.

 

  Note

Assign the DF1 FULL-DUPLEX driver in the CPU as follows: "NO HANDSHAKING" for 
"Control Line" and "AUTO-DETECT" for "Embedded Responses".

 

Connecting HMI device to PLC

Connections via Allen-Bradley DF1

Connection
The connection is established when you have matched the parameters of the PLC and the 
HMI device. Special blocks for the connection are not required in the PLC.   

 

 Note

Rockwell offers a variety of communication adapters for integrating "DF1 devices" for the 
DH485, DH, and DH+ networks. Of these connections, the direct connection and the 
connection via KF2 and KF3 module are approved. None of the other connections have been 
system-tested by SIEMENS AG and are therefore not approved.
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Communication partners for Allen-Bradley DF1

Connectable PLCs
The communication drivers listed below support Allen-Bradley PLCs: :    

PLC

DF1
(point-to-point)

RS-232

DF1
(point-to-point)

RS-422

DF1
(multipoint)

over KF2 module
to DH+ LAN

RS-232/RS-422

DF1
(multipoint)

over KF3 module
to DH485 LAN

RS-232
SLC500 – – – X
SLC501 – – – X
SLC502 – – – X
SLC503 X – – X
SLC504 X – X X
SLC505 X – – X
MicroLogix X – – X
PLC-5  1) X X X –

1)  Processors released for PLC-5: PLC-5/11, PLC-5/20, PLC-5/30, PLC-5/40, PLC-5/60, and 
PLC-5/80.

 

Communication types 

PLCs with Allen-Bradley DF1 communication driver
The communication between the HMI device and the following Allen Bradley PLCs is described 
in this section:

● SLC500

● SLC501

● SLC502

● SLC503

● SLC504

● SLC505

● PLC5

● MicroLogix

In these PLCs the connection is made by the PLC-internal protocols Allen Bradley DF1, Allen 
Bradley DH485 and Allen Bradley DH+. 

The Allen-Bradley DF1 communication driver is used here, the protocol of which is converted 
into one of the other two PLC-internal protocols in multipoint communication with the 
communication modules KF2 (Allen Bradley DH+) and KF3(Allen Bradley DH485). 
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Enabled types of communication with Allen-Bradley DF1
The following communication types are system-tested and enabled:

● HMI (Allen Bradley DF1)
Point-to-point connection

● HMI (Allen Bradley DF1)
Via KF2 module to Allen Bradley DH+ (communication with up to 4 PLCs)

● HMI (Allen Bradley DF1)
Via KF3 module to Allen Bradley DH485 (communication with up to 4 PLCs)

Connectable PLCs
The Allen Bradley DF1 communication driver is available for the following Allen-Bradley PLCs: 

PLC

DF1
(point-to-point)

RS 232

DF1
(point-to-point)

RS 422

DF1
(multipoint)

via KF2 module
to DH+ LAN

RS 232/RS 422

DF1
(multipoint)

via KF3 module
to DH485 LAN

RS 232 2) 
SLC500 – – – X
SLC501 – – – X
SLC502 – – – X
SLC503 X 2) – – X
SLC504 X 2) – X X
SLC505 X 2) – – X
MicroLogix X 2) – – X
PLC-5  1) X X X –

1) Only the following processors are approved for PLC-5: PLC-5/11, PLC-5/20, 
PLC-5/30, PLC-5/40, PLC-5/60 und PLC-5/80.

2) For HMI devices which only have an RS 422/485 interface and the communication 
partner is an RS 232 interface, the RS 422/232 converter is tested and approved.
Order number: 6AV6 671-8XE00-0AX0 

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5343



DF1 protocol with multi-point connection

Point-to-point connection with DF1 protocol
Only point-to-point connections can be established with the DF1 protocol.  

1) Only RS 232 is possible for Panel PC and PC.
2) A point-to-point connection to the SLC500, SLC501, and SLC502 PLCs via DF1 is not possible.
3) For MicroLogix ML1500 LRP, Channel 1 (9-pin Sub D) is also possible.

 

Connecting cable

HMI panel interface used For connection to PLC5x For connection to 
SLC5/03, SLC5/04, 
SLC5/05

For connection to 
MicroLogix

RS 232 9-pin Allen-Bradley cable
1784-CP10

Allen-Bradley cable
1747-CP3

Allen-Bradley cable
1761-CBL-PM02

RS 422 9-pin Connecting cable 9-pin 
Sub D RS 422

— —

Refer to the relevant device manual to determine which HMI device interface is to be used.

The cable pin assignments can be found in Section "Connecting cables for Allen-Bradley".
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DF1 protocol with multi-point connection via KF2 module

DF1 protocol with multi-point connection via KF2 module to DH+ LAN
The use of a KF2 protocol interface module enables a connection to be made to PLCs in the 
DH+ LAN (Data Highway Plus Local Area Network).  

Connecting cable

HMI panel interface used For connection to
KF2 interface module

RS 232 9-pin Allen-Bradley cable
1784-CP10 and 25-pin socket/socket adapter

RS 422 9-pin 9-pin Sub D RS 422 connecting cable and 25-pin female/female adapter

 

Refer to the Allen-Bradley documentation for the cable connection from the PLCs to the DH+ 
data bus.

Refer to the relevant device manual to determine which HMI device interface is to be used.

The cable pin assignments can be found in Section "Connecting cables for Allen-Bradley".
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DF1 protocol with multi-point connection via KF3 module

DF1 protocol with multi-point connection via KF3 module to DH485 LAN

1) For MicroLogix ML1500 LRP, Channel 1 (9-pin Sub D) is also possible.

 

Connecting cable

HMI panel interface used For connection to
KF3 interface module

RS 232 9-pin Allen-Bradley cable
1784-CP10 and 25-pin socket/socket adapter

Refer to the relevant device manual to determine which HMI device interface is to be used.

The cable pin assignments can be found in Section "Connecting cables for Allen-Bradley".  

Connecting cables for Allen-Bradley DF1

Connecting cable 9-pin Sub D RS 422 for Allen-Bradley

Connecting cable 9-pin Sub D RS 422
For interconnecting the HMI device (RS 422, 9-pin sub D) - PLC5x, KF2, KF3

You require an additional 25-pin, female / female adapter (gender changer) for 
interconnections with KF2 and KF3.
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Shield with large-area contact to housing at both ends, interconnected shield contacts
Cable: 3 x 2 x 0.14 mm2, shielded,
max. length 60 m

 

Connecting cable 1784-CP10, RS 232, for Allen-Bradley

Allen-Bradley cable 1784-CP10
For interconnecting the HMI device (RS 232, 9-pin sub D) - PLC5x, KF2, KF3

You require an additional 25-pin, female / female adapter (gender changer) for 
interconnections with KF2 and KF3.
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Screen connected with housing over large area on both sides

max. length 15 m

 

Connecting cable 1747-CP3, RS-232, for Allen-Bradley

Allen-Bradley cable 1747-CP3
For interconnecting the HMI device (RS 232, 9-pin sub D) - SLC503, SLC504, SLC505 
(Channel 0), AIC+
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Screen connected with housing over large area on both sides

max. length 3 m

Connecting cable 1761-CBL-PM02, RS-232, for Allen-Bradley

Allen-Bradley cable 1761-CBL-PM02
For interconnecting the HMI device (RS 232, 9-pin sub D) - Micro Logix, AIC+
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Screen connected with housing over large area on both sides

max. length 15 m

Performance features of communication

Permitted data types for Allen-Bradley DF1

Permitted data types for Allen-Bradley DF1
The table lists the user data types that can be used when configuring tags and area pointers.   

Data type Operand type Length
ASCII A 1) 1 to 80 characters
Bool N, R, C, T, B, S, I, O 1 bit
Int N, R, C, T, S 2 bytes
DInt N, D 2) 4 bytes
UInt N, R, C, T, B, I, O, D 2) 2 bytes
UDInt N, D 2) 4 bytes
Real N, F 1) 4 bytes
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1) Selectable depending on the selected CPU type.
2) Only for PLC5 CPU type

Abbreviations
In WinCC, formats of the data types are abbreviated as follows:

● UNSIGNED INT = UInt

● UNSIGNED LONG = UDInt

● SIGNED INT = Int

● SIGNED LONG = DInt

Distinctive features for connections with Allen-Bradley DF1
With Allen Bradley DF1, array tags may only be used for discrete alarms and trends. 

 

 Note

I/O modules with 8 or 16 ports occupy one data word on the PLC.

I/O modules with 24 or 32 ports occupy two data words. 

The HMI device does not output an error message if using non-existent bits.

You should always make sure that I/O modules with 8 or 24 ports only occupy the bits that 
are actually assigned to a port.
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Supported CPU types for Allen-Bradley DF1

CPU types
The following CPU types are supported for configuring the Allen-Bradley DF1 communication 
driver.      

● SLC

– SLC500

– SLC501

– SLC502

– SLC503

– SLC504

– SLC505

● MicroLogix

– MicroLogix 1x00

– MicroLogix 1100 / 1400

● PLC 5

– PLC-5/11

– PLC-5/20

– PLC-5/40

– PLC-5/60

– PLC-5/80

Addressing

Addressing
The addressing is entered in the following order in the Allen-Bradley DF1 communication driver:

● Operand type

● File number

● Element number
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● Child element

● Bit number

The address then appears in the following format without spaces:

● File type file number : Element number . Child element

● e.g. T8:2.ACC

Operand type
You have the following options under operand type:

● I

● O

● S

● B

● T

● C

● R

● N

● A

● D only for PLC5 CPU type

File number
Select the number between two limits under file number:

● Low limit

● High limit
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The limit values depend on the selected file type.

Child element
You can select a child element when you have selected one of the following data types:

● R

● C

● T

Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.
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● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Data exchange

Area pointers for Allen-Bradley

Area pointers for connections using an Allen-Bradley communication driver
You use an area pointer to access a data area in the PLC.

For more detailed information on area pointers and their configuration, refer to Section "Data 
exchange using area pointers".     

Distinctive features for connections via Allen-Bradley EtherNet/IP
You can configure the following area pointers

Area pointer Allen-Bradley EtherNet/IP Allen-Bradley DF1
Screen number Yes Yes
Date/time Yes Yes
Date/time PLC Yes Yes
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Area pointer Allen-Bradley EtherNet/IP Allen-Bradley DF1
Coordination Yes Yes
Project ID Yes Yes
Job mailbox Yes Yes
Data record Yes Yes

Restrictions Allen-Bradley Ethernet/IP
The following restrictions apply for configuring area pointers.

CPU type Data types File types
ControlLogix,CompactLogix Int, UInt --
SLC, MicroLogix Int, UInt N, B

Restrictions Allen-Bradley DF1
The following restrictions apply for configuring area pointers.

CPU type Data types File types
MicroLogix -- N, O, I, B
SLC50x -- N, O, I, B
PLC5 -- N, O, I, B

 

See also
Data exchange using area pointers (Page 5446)

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Advanced and Panels (Page 3237) 
 

 Note

The value is read out time-triggered for Basic Panels.
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Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.
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The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Restrictions to the trend control

For Allen-Bradley DF1 communication drivers
Tags of the following operand types are permitted:

● "N"

● "O"

● "I"

● "S"

● "B"

Permitted data types:

● "UInt"

● "Int"

● Array tag of "UInt"

● Array tag of "Int"

You assign a bit to a trend during configuration. This sets a defined bit assignment for all trend 
areas.         
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For Allen-Bradley EtherNet/IP communication drivers
Tags of data type "Int" or an array tag of data type "Int" are permitted. You assign a bit to a 
trend during configuration. This sets a defined bit assignment for all trend areas. 

ControlLogix and CompactLogix
The following data types are possible for tags for the ControlLogix and CompactLogix CPU 
types:

● "UInt"

● "Int"

● Array tag of "UInt"

● Array tag of "Int"

SLC and MicroLogix
The following operand types are permitted for tags of the SLC and MicroLogix CPU types:

● "N"

● "O"

● "I"

● "S"

● "B"

Permitted data types:

● "UInt"

● "Int"

● Array tag of "UInt"

● Array tag of "Int"

Alarms

Configuring alarms

Configuring alarms for non-integrated connections
Several steps are necessary to configure alarms such as warnings, error messages and 
acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:
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Working with Alarms  (Page 3260) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Restrictions
Only tags whose "File type" is "N", "O", "I", "S" and "B" are allowed for use as a "trigger tag" 
for discrete alarms. These tags are only valid for the data types "Int" and "UInt".

Data types
For connections with an Allen-Bradley communication driver, the following data types are 
supported:             

Communication drivers PLC Permitted data types
Discrete alarms Analog alarms

Allen-Bradley DF1 SLC500, SLC501, 
SLC502, SLC503, 
SLC504, SLC505, 
PLC5, MicroLogix

Int, UInt Int, UInt, Long, 
ULong, Real

Allen-Bradley EtherNet/IP ControlLogix, 
CompactLogix, SLC, 
Micrologix

Int, UInt SInt, USInt, Int, UInt, 
DInt, UDInt, Real

How the bit positions are counted
For connections with an Allen-Bradley communication driver, the following counting method 
applies:

How the bit positions are counted Left byte Right byte
In Allen-Bradley PLCs 15       8 7       0

In WinCC you configure: 15       8 7       0
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Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.

 

Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
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tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.
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The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels Panel PCs:
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

Mitsubishi

Mitsubishi communication drivers 

Introduction
This section describes the communication between an HMI device and PLCs that use 
Mitsubishi communication drivers.    

The following communication drivers are supported:

● Mitsubishi MC TCP/IP

● Mitsubishi FX

Data exchange
Data is exchanged by means of tags or area pointers.

● Tags
The PLC and the HMI device use process values for data exchange. You create tags in 
the configuration that point to addresses in the PLC. The HMI device reads the value from 
the defined address, and then displays it. The operator may also enter values on the HMI 
device, which are then written to the address in the PLC.

● Area pointers
Area pointers are used to exchange specific data and are only set up when these data are 
used.

Mitsubishi MC TCP/IP

Configuring a connection via Mitsubishi MC TCP/IP

Introduction
You configure a connection to a PLC with a Mitsubishi MC TCPI/IP communication driver in 
the "Connections" editor of the HMI device. 
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The Ethernet interfaces are named differently depending on the HMI device. 

Example: PROFINET interface corresponds to the Ethernet interface      

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Mitsubishi MC TCPI/IP" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Mitsubishi MC TCP/IP)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.         

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used. 
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Parameters for the HMI device
You can select only one interface for the HMI device in the Inspector window under 
"Parameters". Depending on the HMI device, there are several interfaces available.

If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. The IP address is transferred to the HMI device during 
project transfer. 

 

 Note

The IP address in the control panel will be overwritten upon subsequent loading if you have 
already set up the IP address in the HMI device control panel.

The IP address already set up in the control panel will be retained upon subsequent loading 
if you activate "Set IP address using a different method".

 

To set up the IP address of the HMI device:

1. Click on the HMI device.

2. Open the "Device configuration" editor.
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3. Click the Ethernet interface.

4. Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

Parameters for the PLC
● CPU type

For "CPU type", you set the type of PLC to which the HMI device is connected.
The following settings are possible:
–FX3
–Q
If you select the FX3 CPU type, the Mitsubishi MC protocol "1E" is used and "3E" for the 
"Q" CPU type. 
The "Binary code" protocol variant is always used.

 

  Note

If the CPU type is changed for a configured connection, tags with the following properties 
must be revised:

•  Operands that do not exist for the new CPU type, such as "W", "B", "F".

•  Inputs and outputs with different addressing (hexadecimal/octal)

•  Addresses greater than the valid address area of the new CPU type
 

● IP address
Set the IP address or host name of the Ethernet/IP module of the PLC. Only the IP address 
can be used on a Basic Panel.

● Port
Set the port number of the module of the PLC. 

Connecting HMI device to PLC

Connections via Mitsubishi MC TCP/IP

Connection
The HMI device can be connected to the Mitsubishi PLC using the following components:    

● Existing Ethernet network that also contains the PLCs

● Cross-over Ethernet cable connected directly to the Ethernet interface of the CPU or the 
communication module

The connection of the HMI device to a Mitsubishi PLC is limited primarily to the physical 
connection of the HMI device. Special blocks for the connection are not required in the PLC.

Connect the HMI device to one or several Q-series and/or FX3 PLCs. Connect the HMI device 
via the following interfaces:
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● Communication interface OnBoard 

● Approved communication module suitable for the PLC
 

  Note
Timeout response with TCP/IP (Ethernet)

Due to the use of the TCP/IP protocol, the breakdown of a connection is detected at the 
earliest after approximately one minute. Communication failure cannot be reliably 
detected if no tags are requested, for example, no output tags in the current screen. 

Configure area pointer coordination for each PLC. This setting ensures that a 
communication failure is recognized after approximately two minutes, even in the 
aforementioned scenario.

 

Communication types 

Approved communication types
● Only applies for Mitsubishi FX(PG protocol):

The point-to-point connection from a HMI device to an approved Mitsubishi FX–CPU via 
Mitsubishi FX is system-tested and approved by Siemens AG.

● Only applies for Mitsubishi MC TCP/IP:
The following communication types are system-tested and approved: 

– Point-to-point connection to the approved PLCs

– Multipoint connection from a HMI device with up to 4 PLCs with the respectively 
approved PLCs. CPU types (FX3 and Q) can be mixed.

 

  Note

The HMI device is a client and the PLC must operate as a server.
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Connectable PLCs
Connections can be implemented for the following Mitsubishi PLCs:

PLC

Mitsubishi FX
(PG protocol)

Mitsubishi MC TCP/IP

MELSEC FX1n, FX2n Yes No
MELSEC FX3U, FX3UC, FX3G with 
communication module FX3U-ENET

No Yes

MELSEC System Q
● Q-series with the communication 

module QJ71E71-100
● QnUDEH CPU with Ethernet interface 

onboard

No Yes

Parameterization of the communications modules

FX3 PLCs

Procedure
1. Start the FX-Configurator.

2. Select the module.

3. Assign the following settings in the "Operational settings" dialog:

– Communication data code:
Binary code

– Initial timing:
Always wait for OPEN

– IP address:
IP address 

– Send frame setting:
Ethernet(V2.0)

– TCP Existence confirmation setting:
Use the Ping
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4. Assign the following settings in the "Open Settings" dialog:

– Protocol:
TCP

– Open system:
Unpassive

– Fixed buffer:
Receive

– Fixed buffer communication procedure:
Procedure exist(MC)

– Pairing open
Disable

– Existence confirmation 
No confirm

– Host station Port No. (DEC)
Port number

 

  Note

The port number chosen in the communication module must match the port number 
in WinCC. A connection with a port number must be assigned for each connected HMI 
device.

You must specify port numbers in decimal values.
 

5. Confirm the default settings of the other dialog boxes.

The network no. and station no. parameters are not relevant for the connection and can be 
chosen as required.

Q PLCs

Procedure
1. Click "Edit network parameters".

2. Select the network type:

– Ethernet
The network number and the group / station number are not evaluated and can be freely 
assigned
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3. Assign the following settings in the "Operational settings" dialog:

– Communication data code:
Binary code

– Initial timing:
Always wait for OPEN

– IP address:
IP address

– Send frame setting:
Ethernet(V2.0)

– Enable write operations during RUN

4. Assign the following settings in the "Open settings" dialog:

– Protocol:
TCP

– Open system:
Unpassive

– Pairing open
Disable

– Existence confirmation
No confirm

– Host station Port No. (HEX)
Port-Nummer

 

  Note

The port number chosen in the communication module must match the port number 
in WinCC. A connection with a port number must be assigned for each connected HMI 
device.

You must specify port numbers in hexadecimal values.
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Internal Ethernet port of the Q0xUDEH CPU

Procedure
1. Assign the following settings in the "Internal Ethernet Port" dialog:

– IP address:
IP address

– Communication data code:
Binary code

– Enable online changes

2. Assign the following settings in the "Open settings" dialog:

– Protocol:
TCP

– Open system:
MC-Protocol

– Host station Port No. (HEX)
Port number

 

  Note

The port number chosen in the communication module must match the port number 
in WinCC. A connection with a port number must be assigned for each connected HMI 
device.

 

Performance features of communication

Permitted data types for Mitsubishi MC TCPI/IP

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Operand type Length
4-bit block M, X, Y, B, F 1 byte
8-bit block M, X, Y B, F 1 byte
12-bit block M, X, Y B, F 2 bytes
16-bit block M, X, Y B, F 2 bytes
20-bit block M, X, Y B, F 4 bytes
24-bit block M, X, Y B, F 4 bytes
28-bit block M, X, Y B, F 4 bytes
32-bit block M, X, Y B, F 4 bytes
Bool M, D, X, Y B, F 1-bit

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5372 System Manual, 07/2013,  



Data type Operand type Length
DInt D, W 4 bytes
DWord D, C, W 4 bytes
Int D, W 2 bytes
Real 1) D, W 4 bytes
String 1) D 1 to 80 characters
Word D, T, C, W 2 bytes

1) The "String" and "Real" data types are not available for all CPUs.
2) Operand types B, F and W are only available for CPU type "Q".

 
 

 Note

Note the following for write accesses:

Tags can only be written if "Enable online changes" or "Enable write operations during RUN" 
was selected when parameterizing the Mitsubishi communication modules. 

For data type "Bool" in operand type "D", the entire word is written back to the PLC following 
a change to the specified bit. There is no check to determine whether any other bits in the 
word have changed. As a result, the PLC only has read access to the specified word.

 

 Note

Array elements in I/O fields cannot be used in communication with a Mitsubishi PLC.
 

Supported CPU types for Mitsubishi MC TCP/IP

CPU types
The following CPU types are supported for configuring the Mitsubishi MC TCP/IP 
communication driver.       

● FX3 series

– FX 3G / FX 3G with communication modul FX3U-ENET

– FX 3U / FX 3U with communication modul FX3U-ENET

– FX 3UC / FX 3UC with communication modul FX3U-ENET

● Q series

– Q-Series with QJ71E71-100 communication module

● iQ series / QnUD

– QnUDEHCPU with built in ethernet module
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Addresses for Mitsubishi MC TCP/IP

Address areas for connections via Mitsubishi MC TCP/IP
The address area boundaries differ for the different series; refer to the Mitsubishi Computerlink 
manuals for this information.

Examples of address area boundaries dependent on the CPU and communication format:     

Name Operand type Max. address 
FX3

Max. address 
Q-Series 

Output/Input Y/X Octal X/Y 0 - 777 HEX X/Y 0 - 7FF
Bit memory M M0 - M3071 and 

M8000 - M8255
M/L/S 0 - 8191

Data register D D0 - 7999
D8000 - D8255

D0 - 8191
D9000 - D9255 becomes SD1000 - 

SD1255 
Counter C C0 - 255 C0 - 1023
Timer T T0 - 255 T0 - 2047
Link register W -- Hex: W0 - FFF
Link flag B -- Hex: B0 - FFF
Error flag F -- F0 - 2047

Address areas for Mitsubishi MC TCP/IP

FX0
 

Addres
s areas

Data types
Bool Word DWord Real String 4-bit 

block
8-bit 
block

12-bit 
block

16-bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

M M0 - 
M9999 

-- -- -- -- M0 - 
M999
6 

M0 - 
M999
2

M0 - 
M998
8 

M0 - 
M998
4 

M0 - 
M9980 

M0 - 
M9976 

M0 - 
M9972 

M0 - 
M996
8 

D D0.0 - 
D999.1
5 

D0 - 
D999 

D0 - 
D998 

D0 - 
D998 

D0 - 
D998 

-- -- -- -- -- -- -- --

T  T0 - 
T255 

-- -- -- -- -- -- -- -- -- -- --

C-16-
Bit

-- C-16-
Bit 0 - 
C-16-
Bit 199

-- -- -- -- -- -- -- -- -- -- --
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Addres
s areas

Data types
Bool Word DWord Real String 4-bit 

block
8-bit 
block

12-bit 
block

16-bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

C-32-
Bit

-- -- C-32-
Bit 200 
- 
C-32-
Bit 255

-- -- -- -- -- -- -- -- -- --

X X0 - 
X255 

-- -- -- -- X0 - 
X252

X0 - 
X248 

X0 - 
X244 

X0 - 
X240 

X0 - 
X236 

X0 - 
X232

X0 - 
X228 

X0 - 
X224 

Y Y0 - 
X255

-- -- -- -- Y0 - 
Y252 

Y0 - 
Y248 

Y0 - 
Y244 

Y0 - 
Y240 

Y0 - 
Y236 

Y0 - 
Y232 

Y0 - 
Y228 

Y0 - 
Y224 

Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:
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● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Mitsubishi FX

Configuring a connection via Mitsubishi FX

Introduction
You configure a connection to a PLC with a Mitsubishi FX communication driver in the 
"Connections" editor of the HMI device.     

The Mitsubishi FX protocol is also referred to as the Mitsubishi PG protocol.

The interfaces are named differently depending on the HMI device. 
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Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Mitsubishi FX" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Mitsubishi FX)

Parameters to be set
To assign the connection parameters, such as addresses and profiles, click the connection 
that you have created in the "Connections" editor.         

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used. 
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Parameters for the HMI device
You can select an interface for the HMI device in the Inspector window under "Parameters". 
Depending on the HMI device, there are several interfaces available.

● "Type"
Specifies the physical connection used.

 

  Note

If you use the IF1B interface, you must switch over the RS422 receive data and the RTS 
signal additionally by 4 DIL-switches on the back of the HMI device.

 

Parameters for the PLC
● Baud rate: For "Baud rate", select the transmission speed between the HMI device and 

PLC. Select the baud rate "9600".

● Data bits: Under "Data bits", select "7 bits".

● Parity: Under "Parity", select "Even".

● Stop bits: Under "Stop bits", select "1 bit".
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Connecting HMI device to PLC

Connections via Mitsubishi FX

Connection
Connect the HMI device to the programming interface of the CPU (RS 422) (see documentation 
of the PLC).

The connection between the HMI device and the Mitsubishi PLC is basically restricted to setting 
the interface parameters. Special blocks for the connection are not required in the PLC.

Connecting cable
The following connecting cables are available to connect the HMI device to the PLC.  

Interface to
HMI device or adapter

Mitsubishi Electric PLC via FX protocol
FX1n, Fx2n, Mini DIN, 8–pin

RS 232, 9-pin Mitsubishi SC-09 1)

RS 422, 9-pin Connecting cable RS422-2P
1)   Since the Mitsubishi PLCs communicate via RS 422 as a standard, the Mitsubishi programming 
cable SC–09 with integrated RS 422/RS 232 adaptor is necessary for connecting a HMI device via RS 
232.

 
 

 Note

Applies only to RS 232:

Cable length is restricted to 0.32 m.
 

Refer to the relevant device manual to determine which HMI device interface is to be used.

The cable pin assignments can be found in Section "Connecting cables for Mitsubishi FX".
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Communication types 

Approved communication types
● Only applies for Mitsubishi FX(PG protocol):

The point-to-point connection from a HMI device to an approved Mitsubishi FX–CPU via 
Mitsubishi FX (PG protocol := protocol for access to the program and memory elements of 
the FX series PC CPU version V1.21 and after) is system-tested and approved by Siemens 
AG.

● Only applies for Mitsubishi MC TCP/IP:
The following communication types are system-tested and approved: 

– Point-to-point connection to the approved PLCs

– Multipoint connection from a HMI device with up to 4 PLCs with the respectively 
approved PLCs. CPU types (FX3 and Q) can be mixed.

 

  Note

The HMI device is a client and the PLC must operate as a server.
 

Connectable PLCs
Connections can be implemented for the following Mitsubishi PLCs:

PLC

Mitsubishi FX
(PG protocol)

Mitsubishi MC TCP/IP

MELSEC FX1n, FX2n Yes No
MELSEC FX3U, FX3UC, FX3G with 
communication module FX3U-ENET

No Yes

MELSEC System Q
● Q-series with the communication 

module QJ71E71-100
● QnUDEH CPU with Ethernet interface 

onboard

No Yes

Connecting cables for Mitsubishi FX

Connecting cable RS 422 2P, for Mitsubishi

Connecting cable RS422-2P
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Shield with large-area contact to housing at both ends
Cable: 3 x 2 x 0.14 mm2, shielded,
max. length 500 m

 

Performance features of communication

Permitted data types for Mitsubishi FX

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Operand type Length
4-bit block M, X, Y 1 byte
8-bit block M, X, Y 1 byte
12-bit block M, X, Y 2 bytes
16-bit block M, X, Y 2 bytes
20-bit block M, X, Y 4 bytes
24-bit block M, X, Y 4 bytes
28-bit block M, X, Y 4 bytes
32-bit block M, X, Y 4 bytes
Bool D, M, X, Y 1-bit
DWord D, C-32 bit 4 bytes
Real D 4 bytes
String D 1 to 50 characters
Word D, T, C-16 bit 2 bytes

 

 Note

Note the following for write accesses:

For data type "Bool" in operand type "D", the entire word is written back to the PLC following 
a change to the specified bit. There is no check to determine whether any other bits in the 
word have changed. As a result, the PLC only has read access to the specified word.

 

 Note

Array elements in I/O fields cannot be used in communication with a Mitsubishi PLC.
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Supported CPU types for Mitsubishi FX

CPU types
The following CPU types are supported for configuring the Mitsubishi FX communication 
driver.     

● FX1 series

– FX1n

● FX2 series

– FX2n

Configurable address areas for Mitsubishi FX

Permitted address areas
The following address areas can be configured for the "Mitsubishi FX" communication driver   

X  Input Octal 0- 377
Y  Output Octal 0- 377
M Bit memory 0...9999
D   Data register 0...999
C    Counter 0...199
T    Timer 0...25

Address areas for Mitsubishi FX

FX3
 

Addre
ss 

areas

Data types
Bool Int Word DInt DWor

d
Real String 4-bit 

block
8-bit 
block

12-
bit 
block

16-
bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

M M0 - 
M999
9 

-- -- -- -- -- -- M0 - 
M99
96 

M0 - 
M99
92 

M0 - 
M99
88 

M0 - 
M99
84

M0 - 
M998
0

M0 - 
M997
6 

M0 - 
M997
2 

M0 - 
M996
8 

D D0.0 
- 
D999
9.15

D0 - 
D999
9 

D0 - 
D999
9 

D0 - 
D999
9 

D0 - 
D999
9 

D0 - 
D999
9 

D0 - 
D999
9 

-- -- -- -- -- -- -- --

T -- -- T0 - 
T999 

-- -- -- -- -- -- -- -- -- -- -- --
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Addre
ss 

areas

Data types
Bool Int Word DInt DWor

d
Real String 4-bit 

block
8-bit 
block

12-
bit 
block

16-
bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

C -- C0 - 
C999 

C0 - 
C999 

C0 - 
C998 

C0 - 
C998 

-- -- -- -- -- -- -- -- -- --

X X0 - 
X777 

-- -- -- -- -- -- X0 - 
X774 

X0 - 
X770 

X0 - 
X764 

X0 - 
X760 

X0 - 
X754 

X0 - 
X750 

X0 - 
X744

X0 - 
X740 

Y Y0 - 
Y777 

-- -- -- -- -- -- Y0 - 
Y774 

Y0 - 
Y770 

Y0 - 
Y764 

Y0 - 
Y760 

Y0 - 
Y754 

Y0 - 
Y750 

Y0 - 
Y744 

Y0 - 
Y740 

Q
 

Addre
ss 

areas

Data types
Bool Int Word DInt DWor

d
Real String 4-bit 

block
8-bit 
block

12-
bit 
block

16-
bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

M M0 - 
M999
9 

-- -- -- -- -- -- M0 - 
M99
96 

M0 - 
M99
92 

M0 - 
M99
88 

M0 - 
M99
84 

M0 - 
M998
0 

M0 - 
M997
6 

M0 - 
M997
2 

M0 - 
M996
8 

F F0 - 
F999
9 

-- -- -- -- -- -- F0 - 
F999
6 

F0 - 
F999
2

F0 - 
F998
8 

F0 - 
F998
4 

F0 - 
F998
0 

F0 - 
F997
6 

F0 - 
F997
2

F0 - 
F996
8 

B B0 - 
BFFF
F 

-- -- -- -- -- -- B0 - 
BFF
FC 

B0 - 
BFF
F8 

B0 - 
BFF
F4

B0 - 
BFF
F0 

B0 - 
BFFE
C 

B0 - 
BFFE
8 

B0 - 
BFFE
4 

B0 - 
BFFE
0

D D0.0 
- 
D655
34.15 

D0 - 
D655
34 

D0 - 
D655
34 

D0 - 
D655
33 

D0 - 
D655
33 

D0 - 
D655
33 

D0 - 
D655
34 

-- -- -- -- -- -- -- --

T -- -- T0 - 
T204
7 

-- -- -- -- -- -- -- -- -- -- -- --

C  C0 - 
C204
7 

C0 - 
C204
7 

C0 - 
C204
6 

C0 - 
C204
6 

-- -- -- -- -- -- -- -- -- --

W -- W0 - 
WFF
FF 

W0 - 
WFF
FF 

W0 - 
WFF
FE

W0 - 
WFF
FE

W0 - 
WFF
FE

-- -- -- -- -- -- -- -- --

X X0 - 
XFFF
F 

-- -- -- -- -- -- X0 - 
XFF
FC

X0 - 
XFF
F8 

X0 - 
XFF
F4 

X0 - 
XFF
F0 

X0 - 
XFFE
C 

X0 - 
XFFE
8

X0 - 
XFFE
4 

X0 - 
XFFE
0 

Y Y0 - 
YFFF
F 

-- -- -- -- -- -- Y0 - 
YFF
FC

Y0 - 
YFF
F8 

Y0 - 
YFF
F4 

Y0 - 
YFF
F0 

Y0 - 
YFFE
C 

Y0 - 
YFFE
8 

Y0 - 
YFFE
4 

Y0 - 
YFFE
0 

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5384 System Manual, 07/2013,  



FX0
 

Addres
s areas

Data types
Bool Word DWord Real String 4-bit 

block
8-bit 
block

12-bit 
block

16-bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

M M0 - 
M9999 

    M0 - 
M999
6 

M0 - 
M999
2

M0 - 
M998
8 

M0 - 
M998
4 

M0 - 
M9980 

M0 - 
M9976 

M0 - 
M9972 

M0 - 
M9968 

D D0.0 - 
D999.1
5 

D0 - 
D999 

D0 - 
D998 

D0 - 
D998 

D0 - 
D998 

        

T  T0 - 
T255 

           

C-16-
Bit

 C-16-
Bit 0 - 
C-16-
Bit 199

           

C-32-
Bit

  C-32-
Bit 200 
- 
C-32-
Bit 255

          

X X0 - 
X255 

    X0 - 
X252

X0 - 
X248 

X0 - 
X244 

X0 - 
X240 

X0 - 
X236 

X0 - 
X232

X0 - 
X228 

X0 - 
X224 

Y Y0 - 
X255

    Y0 - 
Y252 

Y0 - 
Y248 

Y0 - 
Y244 

Y0 - 
Y240 

Y0 - 
Y236 

Y0 - 
Y232 

Y0 - 
Y228 

Y0 - 
Y224 

Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.
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Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.
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Data exchange

Area pointers for Mitsubishi

Area pointers for connections via Mitsubishi communication drivers
You use an area pointer to access a data area in the PLC.

For more detailed information on area pointers and their configuration, refer to Section "Data 
exchange using area pointers".

Special considerations for connections via Mitsubishi communication drivers
You can configure the following area pointers

Area pointers Mitsubishi MC TCP/IP Mitsubishi FX
Screen number Yes Yes
Date/time Yes Yes
Date/time PLC Yes Yes
Coordination Yes Yes
Project ID Yes Yes
Job mailbox Yes Yes
Data record Yes Yes

Restrictions Mitsubishi MC TCP/IP
The following restrictions apply for configuring area pointers.

CPU type Data types Operand type
FX3 Int, Word D
Q Int, Word D

Mitsubishi FX restrictions
You cannot use the D operand type for configuring area pointers.

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 
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For additional information see:

Auto-Hotspot 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

See also
Displaying tags with Runtime Advanced and Panels (Page 3237)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.
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Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Restrictions to the trend control

Data types for Mitsubishi MC TCPI/IP
For trend control you can create tags and array tags of the operand type "D" with the data type 
"Word" or "Int". 

Data types for Mitsubishi FX
For trend control you can create tags and array tags of the operand type "D" with the data type 
"Word".
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Alarms

Configuring alarms

Configuring alarms for non-integrated connections
Several steps are necessary to configure alarms such as warnings, error messages and 
acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3260) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a Mitsubishi communication driver, the following data types are 
supported:             

PLC Permitted data types
Discrete alarms Analog alarms

FX1n, FX2n, FX3 series, Q-
Series, iQ-Series

Word,
Int 1)

4-bit block, 8-bit block,
12-bit block, 16-bit block,
20-bit block, 24-bit block,
28-bit block, 32-bit block,
Word, DWord, Int 1), DInt 1), Real, 

1)  Not for Mitsubishi FX communication driver
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How the bit positions are counted
For connections with a Mitsubishi communication driver, the following counting method applies:

How the bit positions are 
counted Left byte Right byte

In Mitsubishi 
PLCs

15       8 7       0

In WinCC you configure: 15       8 7       0

Restrictions on alarms
● Mitsubishi MC TCP/IP

Only tags of operand type "D" and data types "Word" and "Int" are permitted as trigger tags 
for discrete alarms. You can use array tags (operand type: "D"; data types: "ARRAY [x..y] 
of Word" or "ARRAY [x..y] of Int") for discrete alarms.

● Mitsubishi FX
Only tags of operand type "D" and data type "Word" are permitted as trigger tags for discrete 
alarms. You can use array tags (operand type "D"; data type "ARRAY [x..y] of Word") for 
discrete alarms."

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels Panel PCs:
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

Modicon Modbus

Modicon Modbus communication drivers 

Introduction
This section describes the communication between an HMI device and PLCs that use Modicon 
Modbus communication drivers.     

The following communication drivers are supported:

● Modicon Modbus TCP/IP

● Modicon Modbus RTU
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Data exchange
Data is exchanged by means of tags or area pointers.

● Tags
The PLC and the HMI device use process values for data exchange. You create tags in 
the configuration that point to addresses in the PLC. The HMI device reads the value from 
the defined address, and then displays it. The operator may also enter values on the HMI 
device, which are then written to the address in the PLC.

● Area pointers
Area pointers are used to exchange specific data and are only set up when these data are 
used.

Modicon Modbus TCP/IP

Configuring a connection via Modicon Modbus TCP/IP

Introduction
You configure a connection to one of the PLCs with Modicon Modbus TCP/IP communication 
driver in the "Connections" editor of the HMI device.      

The Ethernet interfaces are named differently depending on the HMI device. 

Example: PROFINET interface corresponds to the Ethernet interface

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. Select the "Modicon Modbus TCP" driver in the "Communication driver" column.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Modicon Modbus TCP/IP)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.         

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used. 
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Parameters for the HMI device
You can select only one interface for the HMI device in the Inspector window under 
"Parameters". Depending on the HMI device, there are several interfaces available.

If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. The IP address is transferred to the HMI device during 
project transfer. 

 

 Note

The IP address in the control panel will be overwritten upon subsequent loading if you have 
already set up the IP address in the HMI device control panel.

The IP address already set up in the control panel will be retained upon subsequent loading 
if you activate "Set IP address using a different method".

 

To set up the IP address of the HMI device:

1. Click the HMI device.

2. Open the "Device configuration" editor.
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3. Click the Ethernet interface.

4. Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

Parameters for the PLC
● "CPU type"

For "CPU type", you set the Modicon PLC to which the HMI device is connected.

● "Port"
For "Port", you set the port that is used for the TCP/IP connection. The port used by the 
Modicon PLCs is 502. 

● "Server"
You set the IP address or host name of the PLC under "Server". Only the IP address can 
be used on a Basic Panel.

● "Remote Slave address"
Under "Remote Slave address" you only set which slave address the remote PLC has when 
using a bridge.
If no bridge is used, the default value 255 (or 0) must be retained.

● "Change word order"    
The "Change word order " parameter only affects the word order of the 32-bit values display. 
The setting pertains to the data types Double, Double+/-, and Float. The byte order cannot 
be changed. 

– "Change word order" not activated
The most significant byte is sent first. 
For double words, the least significant word is sent before the most significant word. 
This setting has been system-tested for all approved PLCs. 

– "Change word order" activated
The most significant byte is sent first. 
For double words, the most significant word is sent before the least significant word.

 

  Note

This setting must be used for the SIEMENS SENTRON PAC3200 and PAC4200 multi-
function meters and can be used for PLCs of other manufacturers.

 

● "Use single write"
If you deselect this function, only function codes 15H and 16H are used for writing into the 
PLC.
If this function remains selected, the function codes 05H, 06H 16H and 16H are used.
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Connecting HMI device to PLC

Connections via Modicon Modbus TCP/IP

Connection
The HMI device can be connected to the Modicon Modbus PLC using the following 
components:    

● Existing Ethernet network that also contains the PLCs

● Cross-over Ethernet cable connected directly to the Ethernet interface of the CPU or the 
communication module

The connection of the HMI device to a Modicon Modbus PLC is limited primarily to the physical 
connection of the HMI device. Special blocks for the connection are not required in the PLC.

 

 Note

Timeout response with TCP/IP (Ethernet)

Due to the use of the TCP/IP protocol, the breakdown of a connection is detected at the 
earliest after approximately one minute. Communication failure cannot be reliably detected 
if no tags are requested, for example, no output tags in the current screen. 

Configure area pointer coordination for each PLC. This setting ensures that a communication 
failure is recognized after approximately two minutes, even in the aforementioned scenario.
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Communication types 

Approved communication types
The following communication types are system-tested and approved: 

● Point-to-point coupling:

● Multiple point coupling of a HMI device (Modbus TCP/IP Client) with up to 4 PLCs, each 
with different couplings. CPU types can be mixed.
The following couplings are possible:

– Coupling the Ethernet CPU interface of the TSX Unity Quantum.

– Coupling via the communication modules for Ethernet 140 NOE 771 01 for the TSX 
Quantum and TSX Unity Quantum series

– Coupling via the Ethernet interface of the 171 CCC 980 30 CPU adapter of the 
Momentum series

– Coupling the Ethernet CPU interface of the TSX Unity Premium.

– Coupling via the Ethernet TCP/IP connect module TSX ETY 110 for the TSX Premium 
and TSX Unity Premium series

– Coupling via the Ethernet TCP/IP connect module TSX ETY 410 for the Micro series

– Coupling via the Ethernet TCP/IP Modbus Plus Bridge 174 CEV 200 40 to the Modbus 
Plus interface of the Compact, the TSX Quantum and the TSX Unity Quantum series

Via the TCP/IP Modbus Plus Bridge, 174 CEV 200 40, the PLCs can be accessed at their 
Remote Slave Address via the Ethernet interface of this bridge. 

 

 Note

Integration of the HMI device in a Modbus network via a bridge is not possible. The HMI 
device is the Modbus master.

 

Restrictions
The coupling of the HMI device to PLCs of other manufacturers who offer a Modbus TCP/IP 
interface is not system-tested and thus, not enabled. 

However, if another PLC is to be used, observe the following instructions:

● Use the following CPU types, because these operate without address offset and in the 
usual bit count manner.

– Unity, PL7: Premium, Micro, Quantum, M340

● The following function codes are used for the respective data areas:

Reading function codes Address range
01 ReadCoilStatus 0x / %M DIGITAL_OUT
02 ReadInputStatus 1x / %I DIGITAL_IN
03 ReadHoldingRegisters 4x / %MW USERDATA
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Reading function codes Address range
04 ReadInputRegisters 3x / %IW ANALOG_IN
20 (14Hex) ReadGeneralReference 6x / – EXTENDEDMEMORY

(not for all CPUs)

Writing function codes Address range
06 1) PresetSingleRegister 4x / %MW USERDATA Single
16 (10Hex) PresetMultipleRegisters 4x / %MW USERDATA Multiple
05 1) ForceSingleCoil 0x / %M DIGITAL_OUT with BIT
15 (0FHex) ForceMultipleCoils 0x / %M DIGITAL_OUT with 16 BIT GROUP
21 (15Hex) WriteGeneralReference 6x / – EXTENDEDMEMORY

(not for all CPUs)

1) Select use with "Use single write".

Connectable PLCs
Connections can be implemented for the following Modicon Modbus PLCs:

Modicon Modbus PLC Supported protocol
Modicon Modbus RTU 2) Modicon Modbus TCP/IP

TSX Compact x x 1)

TSX Quantum x x 
Momentum x x
Premium - x
Micro - x
M340 20x0 (without 2010) - x

1) Only via Ethernet TCP/IP Modbus Plus Bridge
2) Communication via RS 232 is tested and enabled for the PLC. In the HMIs that only have 

a RS 422/485 interface, the RS 422/232 converter with the order number 6AV6 
671-8XE00-0AX0 was tested and enabled.
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Performance features of communication

Permissible data types for Modicon Modbus TCP/IP

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.         

 

 Note

If you change the Modicon Modbus RTU communication driver to Modicon Modbus TCP/IP, 
the string in the "String" data type may be different.

 

Permitted data types for CPU type "Unity, PLC: Premium, Micro, Quantum M340"

Data type Operand type Length
+/- Double %MW 4 bytes
+/- Int %MW, %IW 2 bytes
16-bit group %MW, %I 2 bytes
ASCII %MW 0 to 80 characters
Bit %MW, %IW, 

%M, %I
1-bit

Double %MW 4 bytes
Float %MW 4 bytes
Int %MW, %IW 2 bytes

 

 Note

The ranges "%I" and "%IW" are not supported for the following CPU types:
● Premium
● Micro
● M340

 

Permitted data types for CPU type "Concept, ProWORX: Compact, Quantum, Momentum"

Data type Operand type Length
+/- Double 4x, 6x 4 bytes
+/- Int 3x, 4x, 6x 2 bytes
16-bit group 0x, 1x 2 bytes
ASCII 4x, 6x 0 to 80 characters
Bit 0x, 1x, 3x, 4x, 

6x
1-bit
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Data type Operand type Length
Double 4x, 6x 4 bytes
Float 4x, 6x 4 bytes
Int 3x, 4x, 6x 2 bytes

Bit counting method
The usual bit counting method "16 LSB - 1 MSB" in the following CPU types is only used in 
the "HMI tags" editor with the selected "Bit" data type:

● Concept, ProWORX: Compact, Quantum, Momentum

The following bit location assignment applies:

 Left byte Right byte
Counting with tags 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Format for "Signed" 
The placeholder "+/-" stands for the data types "Signed Int" and "Signed Double".

Supported CPU types for Modicon Modbus TCP/IP

CPU types
The following CPU types are supported for configuring the Modicon Modbus TCP/IP 
communication driver.  

● Compact

● Momentum

● Quantum

– Concept Quantum 

– Unity Quantum

● Micro

● Premium

● Modicon M340

– 20x0 (except 2010)
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Address areas for Modicon Modbus TCP/IP

Unity, Pl7  

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

%1 %I0 - 
 %I65535 

 %I65535   
%I0 - 
 %I65520  

-- -- -- -- -- --

%M %M0 - 
 %M65535 

 %M65535   
%M0 - 
 %M65520  

-- -- -- -- -- --

%IW %IW0.0 - 
 
%IW65535.
15 

--  %IW0 - 
 %IW65535 

 %IW0 - 
 %IW65535 

-- -- -- --

%MW %MW0.0 - 
 
%MW6553
5.15

--  %MW0 - 
 
%MW6553
5

 %MW0 - 
 
%MW6553
5 

%MW0 - 
 
%MW6553
4 

%MW0 - 
 
%MW6553
4 

%MW0 - 
 
%MW6553
4 

%MW0 - 
 
%MW6553
5 

Concept, ProWORX

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

0x 0x1 - 
0x65535

0x1 - 
0x65520 

-- -- -- -- -- --

1x 1x100001 - 
1x165535 

1x100001 - 
1x165520 

-- -- -- -- -- --

3x 3x300001.1
 - 
3x365535.1
6 

-- 3x300001 - 
3x365535 

3x300001 - 
3x365535 

-- -- -- --

4x 4x400001.1
 - 
4x465535.1
6 

-- 4x400001 - 
4x465535 

4x400001 - 
4x465535 

4x400001 - 
4x465534 

4x400001 - 
4x465534 

4x400001 - 
4x465534 

4x400001 - 
4x465535 

6x 6x60000.1:
1 - 
6x69999.16
:10 

-- 6x60000:1 - 
6x69999:10 

6x60000:1 - 
6x69999:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69999:10 
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Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.
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Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Modicon Modbus RTU

Configuring a connection via Modicon Modbus RTU

Introduction
You configure a connection to a PLC with a Modicon Modbus RTU communication driver in 
the "Connections" editor of the HMI device.      

The interfaces are named differently depending on the HMI device. 

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Modicon Modbus RTU" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Modicon Modbus RTU)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.     

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used. 
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Parameters for the HMI device
You can select an interface for the HMI device in the Inspector window under "Parameters". 
Depending on the HMI device, there are several interfaces available.

● Type
Only RS 232 is system-tested.
No warranty is given for RS 485.

 

  Note

RS 422 is only approved in combination with the RS 422-RS 232 converter.

Order number: 6AV6 671-8XE00-0AX0
 

  Note

If you use the IF1B interface, you must switch over the RS422 receive data additionally 
by 4 DIL-switches on the back of the HMI device.

 

● Baud rate
For "Baud rate", select the transmission speed between the HMI device and Modicon PLC. 
A baud rate of 19200 or 9600 can be selected for the communication.
A baud rate of 4800 can be selected for certain HMI devices.
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● Data bits
For "Data bits", only the value "8" can be selected.

● Parity
For "Parity", you can choose from "None", "Even", and "Odd".

● Stop bits
For "Stop bits", you can choose between 1 and 2 bits.

Parameters for the PLC
● CPU type

For "CPU type", you set the Modicon PLC to which the HMI device is connected.
You can select the following CPUs:

– Concept, ProWORX: Compact, Quantum

● Slave address
Under "Slave address" you set which slave address the CPU has.

Connecting HMI device to PLC

Connections via Modicon Modbus RTU

Connection
Connect the HMI device to the Modicon Modbus RTU interface of the Modicon Modbus RTU 
slave.     

The connection of the HMI device to Modicon is limited primarily to the physical connection of 
the HMI device. Special blocks for the connection are not required in the PLC.

Connection cable
The following connecting cables are available to connect the HMI device to Modicon 
Modbus.     

Interface to the 
HMI device

Modicon PLC
directly via Modbus 

interface (RS232) 9-pin 
Sub D male connector

Via MB Bridge
(RS 232)

directly via Modbus interface 
(RS232) 8-pin RJ45 

connector
RS 232, 9-pin PP1 PP1 PP2

The cable pin assignments can be found in Section "Connecting cables for Modicon Modbus 
RTU".
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Communication types 

Approved communication types
The following communication types are system-tested and approved:   

● Ppoint-to-point connection only via the RS-232 interface.

● Multipoint connection from a HMI device (Modbus-Master) with up to 4 PLCs: The HMI 
device must be connected with a Modbus Plus Bridge or a Compact, Momentum CPU or 
TSX Quantum CPU which is configured as a Modbus Plus Bridge.

● You connect the other PLCs via the Modbus Plus connection on the first PLC. The PLCs 
can be reached under their address via the bridge functionality of the first PLC.

 

  Note

It is not possible to integrate the HMI device into a Modbus network because the HMI 
device is Modbus-Master.

 

● Integration of the HMI device into a Modbus Plus network via the "bridge mode" of the 
Compact, Momentum or Quantum (logical point-to-point communication of the HMI device 
with a Compact, Momentum or Quantum).

Restrictions
The connection of the HMI device to PLCs of other manufacturers which offer a Modicon 
Modbus interface is not system-tested and therefore not approved.   

If you use another PLC nevertheless, observe the following information:

● These drivers only work for tags with the bit counting method typical for Modicon PLCs from 
left (bit1 = most significant bit) to right (bit16 = least significant bit in data type INT).

● The address offset displayed in the configuring is subtracted at protocol level in the 
message frame. E.g. in Holding Register 4x the offset "40001". The configured address 
"40006" therefore becomes address "5" in the message frame. The address (e.g. "5") 
transferred in the message frame is transformed to the PLC-specific address range in the 
different Non-Modicon PLCs.

● A reply message frame without "ExceptionCode" is expected within 500 ms.

● The following function codes are used for the respective data areas:

Reading function codes Address range
01 ReadCoilStatus 0x DIGITAL_OUT
02 ReadInputStatus 1x DIGITAL_IN
03 ReadHoldingRegisters 4x USERDATA
04 ReadInputRegisters 3x ANALOG_IN
20 (14Hex) ReadGeneralReference 6x EXTENDEDMEMORY

(not for all CPUs)
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Writing function codes Address range
06 PresetSingleRegister 4x USERDATA Single
16 (10Hex) PresetMultipleRegisters 4x USERDATA Multiple
05 ForceSingleCoil 0x DIGITAL_OUT with data type Bit
15 (0FHex) ForceMultipleCoils 0x DIGITAL_OUT with data type 16 bit 

group
21 (15Hex) WriteGeneralReference 6x EXTENDEDMEMORY

(not for all CPUs)

Connectable PLCs
Connections can be implemented for the following Modicon Modbus PLCs:

Modicon Modbus PLC Supported protocol
Modicon Modbus RTU 2) Modicon Modbus TCP/IP

TSX Compact x x 1)

TSX Quantum x x 
Momentum x x
Premium - x
Micro - x
M340 20x0 (without 2010) - x

1) Only via Ethernet TCP/IP-Modbus Plus Bridge
2) Communication via RS 232 is tested and enabled for the PLC. In the HMI devices which 

only have an RS 422/485 interface, the RS 422/232 converter with the order number 6AV6 
671-8XE00-0AX0 was tested and approved.
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Connecting cables for Modicon Modbus RTU

Connecting cable PP1, RS-232, for Modicon

Point-to-point cable 1: PLC > PC ...
 

 

Cables: 3 x 0.14 mm2, shielded,
max. length 15 m
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Connecting cable PP2, RS-232, for Modicon

Point-to-point cable 2: PLC (TSX Compact) > PC... 

 

Cables: 3 x 0.14 mm2, shielded,
max. length 15 m
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Performance features of communication

Permitted data types for Modicon Modbus RTU

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Operand type Length
+/- Double 4x, 6x 4 bytes
+/- Int 3x, 4x, 6x 2 bytes
16-bit group 0x, 1x 2 bytes
ASCII 4x, 6x 0 to 80 characters
Bit 1) 0x, 1x, 3x, 4x, 6x 1-bit
Double 4x, 6x 4 bytes
Float 4x, 6x 4 bytes
Int 3x, 4x, 6x 2 bytes

1) Note the following for write accesses:
For data type "Bit" with the operand types "4x" and "6x", the entire word is written back 
to the PLC following a change to the specified bit. There is no check to determine 
whether any other bits in the word have changed. As a result, the PLC only has read 
access to the specified word.

The usual bit counting method (16 LSB - 1 MSB) in the following CPU types is only used in 
the "HMI tags" editor with the selected "Bit" data type:

● Concept ProWORX: Compact, Quantum

The following bit location assignment applies:

 Left byte Right byte
Counting with tags 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Format for "Signed"
The placeholder "+/-" stands for the data types "Signed Int" and "Signed Double".
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Supported CPU types for Modicon Modbus RTU

CPU types
The following CPU types are supported in the configuration of the Modicon Modbus RTU 
communication driver.     

● Compact

● Momentum

● Quantum

Address areas for Modicon Modbus RTU

Concept, ProWORX  

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

0x 0x1 - 
0x65535

0x1 - 
0x65520 

-- -- -- -- -- --

1x 1x100001 - 
1x165535 

1x100001 - 
1x165520 

-- -- -- -- -- --

3x 3x300001.1
 - 
3x365535.1
6 

-- 3x300001 - 
3x365535 

3x300001 - 
3x365535 

-- -- -- --

4x 4x400001.1
 - 
4x465535.1
6 

-- 4x400001 - 
4x465535 

4x400001 - 
4x465535 

4x400001 - 
4x465534 

4x400001 - 
4x465534 

4x400001 - 
4x465534 

4x400001 - 
4x465535 

6x 6x60000.1:
1 - 
6x69999.16
:10 

-- 6x60000:1 - 
6x69999:10 

6x60000:1 - 
6x69999:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69999:10 
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Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.
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Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Data exchange

Area pointers for Modicon Modbus

Area pointers for connections via Modicon Modbus communication drivers
You use an area pointer to access a data area in the PLC.

For more detailed information on area pointers and their configuration, refer to Section "Data 
exchange using area pointers".

Special considerations for connections via Modicon communication drivers
You can configure the following area pointers

Area pointers Modicon Modbus TCP/IP Modicon Modbus RTU
Screen number Yes Yes
Date/time Yes Yes
Date/time PLC Yes Yes
Coordination Yes Yes
Project ID Yes Yes
Job mailbox Yes Yes
Data record Yes Yes

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5418 System Manual, 07/2013,  



Restrictions Modicon Modbus TCP/IP
The following restrictions apply for configuring area pointers.

CPU type Data types File types
Concept, ProWORX: Compact, 
Quantum, Momentum

+/- Int, Int 4x, 6x

Unity, PL7: Premium, Micro, 
Quantum, M340

+/- Int, Int %MW

Modicon Modbus RTU restrictions
The following restrictions apply for configuring area pointers.

CPU type Data types File types
Concept, ProWORX: Compact, 
Quantum, Momentum

+/- Int, Int 4x, 6x

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Advanced and Panels (Page 3237) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.
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To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.
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Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trend control

Modicon Modbus TCP/IP
Tags of the following operand types are permitted for CPU type "Concept, ProWORX: 
Compact, Quantum, Momentum".

● "4x"

● "6x"

Tags of the following operand types are permitted for CPU type "Unity, PL7: Premium, Micro, 
Quantum, M340".

● "%MW"

The tags for trend control must have data type "Int" or "+/- Int" or be an array tag with data 
type "Int" or "+/-Int". 

You assign a bit to a trend during configuration. This sets a defined bit assignment for all areas.

Modicon Modbus RTU
Tags of the following operand types are permitted for CPU type "Concept, ProWORX: 
Compact, Quantum".

● "4x"

● "6x"

The tags for trend control must have data type "Int" or "+/- Int" or be an array tag with data 
type "Int" or "+/-Int". 

You assign a bit to a trend during configuration. This sets a defined bit assignment for all areas.
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Alarms

Configuring alarms

Configuring alarms for non-integrated connections
Several steps are necessary to configure alarms such as warnings, error messages and 
acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3260) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a Modicon Modbus communication driver, the following data types are 
supported:

PLC Permitted data types
Discrete alarms Analog alarms

All Modicon series Int, +/-Int 16 Bit Group, Int, +/-Int, 
Double, +/-Double, Float

Arrays and array tags cannot be used for discrete alarms.

How the bit positions are counted
For connections with a Modicon Modbus communication driver, the following counting method 
applies:

How the bit positions are counted Left byte Right byte
In WinCC you configure: 15 1

4
1
3

1
2

1
1

1
0

9 8 7 6 5 4 3 2 1 0
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Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.

 

Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
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tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.
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The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels Panel PCs:
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

Omron

Omron communication drivers 

Introduction
This section describes the communication between an HMI device and PLCs that use Omron 
communication drivers.    

The following communication drivers are supported:

● Omron Host Link

Data exchange
Data is exchanged by means of tags or area pointers.

● Tags
The PLC and the HMI device use process values for data exchange. You create tags in 
the configuration that point to addresses in the PLC. The HMI device reads the value from 
the defined address, and then displays it. The operator may also enter values on the HMI 
device, which are then written to the address in the PLC.

● Area pointers
Area pointers are used to exchange specific data and are only set up when these data are 
used.
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Omron Host Link

Configuring a connection via Omron Host Link

Introduction
You configure a connection to a PLC with an Omron Host Link communication driver in the 
"Connections" editor of the HMI device.           

 

 Note
Connection with Omron Host Link

A connection will not automatically be established when runtime is started if you have 
configured a connection via Omron. 

A tag which is in the valid PLC memory area must be configured in the runtime start screen. 

The connection will otherwise only be established once a corresponding screen has been 
selected.

This tag will be accessed when runtime is started and a connection will then be established.
 

The interfaces are named differently depending on the HMI device. 

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5426 System Manual, 07/2013,  



3. Double-click "<Add>" in the "Connections" editor.
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4. Select the "Omron Host Link" driver in the "Communication driver" column.

5. Select all necessary connection parameters for the interface in the inspector window under 
"Parameters".

Parameters for the connection (Omron Hostlink)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.     

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used. 
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Parameters for the HMI device
You can select an interface for the HMI device in the Inspector window under "Parameters". 
Depending on the HMI device, there are several interfaces available.

● Type
Specifies the physical connection used.

● Baud rate
For "Baud rate", you set the transmission speed of the HMI device to OMRON. A baud rate 
of 19200 or 9600 can be selected for the communication.

● Data bits
For "Data bits", you can choose between "7 bits" and "8 bits".

● Parity
For "Parity", you can choose from "None", "Even", and "Odd".

● Stop bits
For "Stop bits", you can choose between 1 and 2 bits.
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Parameters for the PLC
● Station address

For "Station address", set the station number of the connected PLC.

Connecting HMI device to PLC

Connections via Omron Host Link

Connection
The connection of the HMI device to an OMRON PLC is limited primarily to the physical 
connection of the HMI device. Special blocks for the connection are not required in the 
PLC.       

Connection cable
The following connecting cables are available to connect the HMI device to an Omron 
PLC.     

Interface to the HMI 
device

Omron PLC
RS232, 9-pin RS232 I/O port RS422, 9-pin RS422, terminals/

pins
RS232, 9-pin PP1 Programming 

cable (standard 
cable of Omron)

— —

RS232 via converter — — — Multi-point cable 1
RS422, 9-pin — — PP2 Multi-point cable 2

Refer to the relevant device manual to determine which HMI device interface is to be used.

Communication types 

Approved communication types
The connection from a HMI device to an OMRON-CPU with the Omron Host Link protocol via 
RS232 and via RS 422 is system-tested and approved by Siemens AG.

This concerns the following CPU types: 

● CP1x (CP1L, CP1H, CP1E)

● CJ1x (CJ1M, CJ1H, CJ1G)

● CJ2H
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● CS1x (CS1G, CS1H, CS1D)

● CPM2C
 

  Note

Only the following CPU types have been tested and released for Basic Panels, TP 177A 
and OP 77A:
● CP1x (CP1L, CP1H, CP1E)
● CJ1x (CJ1M, CJ1H, CJ1G)

 

Multipoint connection
A multipoint connection to the up to 4 approved OMRON PLCs in a RS422-four-wire connection 
can be implemented with communication modules on the PLCs and is system-tested and 
approved by Siemens AG.

 

 Note

The HMI device can only be operated as a master. Exactly one master is possible in the 
RS422-four-wire-Multidrop connection.
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Connecting cables for Omron Host Link

Connecting cable MP1, RS-232, over converter, for Omron

Multipoint cable 1: MP/TP/PC > PLC    

1) Inrush current max. 0.8 A

shielded, max. length 500 m
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Connecting cable MP2, RS-422, for Omron

Multipoint cable 2: RS422, MP/TP/PC > SPS_    

shielded, max. length 500 m

Connecting cable PP1, RS-232, for Omron

Point-to-point cable PP1, PC/TP/OP - PLC
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shielded, max. length 15 m

Connecting cable PP2, RS-422, for Omron

Point-to-point cable PP2, RS-422  
 

 

shielded, max. length 500 m

Performance features of communication

Permissible data types for Omron Host Link

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Operand type Length
Bool I/O, HR, AR, LR, DM, T/

C bit, CPU status
1-bit

Byte CPU type 1 byte
DInt HR, AR, LR, DM 4 bytes
Int I/O, HR, AR, LR, DM, T/

C Val
2 bytes

Real HR, DM 4 bytes
String HR, AR, LR, DM 0 to 80 characters
UDInt HR, AR, LR, DM 4 bytes
UInt I/O, HR, AR, LR, DM, T/

C Val
2 bytes

 

 Note

Read and write operations of all data areas in the OMRON PLC can only be reliably carried 
out in "STOP" or "MONITOR" mode.

"I/O" refers either to the IR/SR area or the CIO area depending on the PLC series. The 
operand types "LR", "HR" and "AR" are not available in all PLC series.
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 Note

Note the following for write accesses: 

For the "Bool" data type with the operand types "I/O", "HR", "AR", "LR" and "DM", the entire 
word is written back into the PLC when the specified bit is changed. There is no check to 
determine whether any other bits in the word have changed. As a result, the PLC only has 
read access to the specified word.

 

Operand type old PLC Operand type CS and CJ PLC
CPU Status  CPU Status
I/O CIO
HR H

Range 0-511
AR A
LR n/a 1)
DM D
T/C T/C
CPU type CPU type

1) You do not get an error message when you read or write the LR area in the 
following PLCs 
● CS
● CJ
● CP

Supported CPU types for Omron Host Link

CPU types
The following CPU types are supported in the configuration of the Omron Host Link 
communication driver.        

● CP1

– CP1L

– CP1H

– CP1E

● CJ1

– CJ1M

– CJ1H

– CJ1G 
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● CJ2

– CJ2H

● CS1

– CS1G

– CS1H

– CS1D

● CPM

– CPM2C

Addressing in Omron Host Link

Addressing of PLCs in Omron Host Link
In PLCs of the series CS, CP and CJ, the timers 0-4095 are addressed with T/C 0-2047.

The counters 0-4095 must be addressed with an offset of 2048 (T/C 2048-4095 correspond 
to the counters 0-2047). Counters and timers with addresses > 2047 cannot be addressed via 
Host Link.  

Counters and timers with addresses > 2047 cannot be addressed via Host Link.

Example:

If you want to address counter C20, you must address T/C 20+2048 = T/C 2068.

Address areas for Omron Hostlink

Omron   

Address 
areas

Data types
Bool Byte UInt Int UDInt DInt Real String

I/O I/O 0.0 - 
I/O 9999.15 

-- I/O 0 - 
I/O 9999 

I/O 0 - 
I/O 9999 

-- -- -- --

HR HR 0.0 - 
HR 9999.15 

 HR 0 - 
HR 9999 

HR 0 - 
HR 9999 

HR 0 - 
HR 9998 

HR 0 - HR 
9998 

HR 0 - 
HR 9999 

HR 0 - 
HR 9999 

AR AR 0.0 - 
AR 9999.15 

 AR 0 - 
AR 9999 

AR 0 - 
AR 9999 

AR 0 - 
AR 9998 

AR 0 - 
AR 9998 

 AR 0 - 
AR 9999 

LR LR 0.0 - 
LR 9999.15 

 LR 0 - 
LR 9999 

LR 0 - 
LR 9999 

LR 0 - 
LR 9998 

LR 0 - 
LR 9998 

 LR 0 - 
LR 9999 

DM DM 0.0 - 
DM 
9999.15 

 DM 0 - 
DM 9999 

DM 0 - 
DM 9999 

DM 0 - 
DM 9998 

DM 0 - 
DM 9998 

DM 0 - 
DM 9999 

DM 0 - 
DM 9999 

T/C Bit T/C Bit 0 - 
T/C Bit 
4095 
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Address 
areas

Data types
Bool Byte UInt Int UDInt DInt Real String

T/C Val   T/C Val 0 - 
T/C Val 
4095

T/C Val 0 - 
T/C Val 
4095

    

CPU Status RUN, 
MONITOR 

       

CPU type  CPU type       

Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.
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● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Data exchange

Area pointers for Omron

Area pointers in connections via Omron communication drivers
You use an area pointer to access a data area in the PLC.

For more detailed information on area pointers and their configuration, refer to Section:

"Data exchange using area pointers".

Special features of connections via Omron Host Link
Area pointers can only be created in the following "File types": "DM", "I/O", "HR", "AR", and 
"LR".
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Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Advanced and Panels (Page 3237) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.
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The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Restrictions to the trend control

For Omron Host Link communication drivers 
Tags of "Operand type" "DM", "I/O", "HR", "AR" or "LR" are permitted. 

They must be data type "UInt", "Int" or an array tag of data type "UInt", "Int". You assign a bit 
to a trend during configuration. This sets a defined bit assignment for all areas.     

Visualizing processes (Comfort/Advanced)
10.11 Communicating with PLCs

WinCC Comfort/Advanced V12.0 SP1
5440 System Manual, 07/2013,  



Alarms

Configuring alarms

Configuring alarms for non-integrated connections
Several steps are necessary to configure alarms such as warnings, error messages and 
acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3260)

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:       

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with an Omron communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

CP1, CJ1, CJ2, CS1, CPM Uint, int UInt, Int,
UDInt, DInt

How the bit positions are counted
For connections with an Omron communication driver, the following counting method applies:

How the bit positions are 
counted Left byte Right byte

In Omron
PLCs

15       8 7       0

In WinCC you configure: 15       8 7       0

Only tags for the "DM", "I/O", "HR", "AR", and "LR" file types are allowed for use as a trigger 
tag for discrete alarms.
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Configuring discrete alarms
Use arrays for discrete alarms and append each individual alarm to one bit of the array tags 
themselves and not to the individual subelements. 

Only tags for the "DM", "I/O", "HR", "AR", LR" areas and the "Int" and "UInt" file types are 
permitted for discrete alarms and arrays.

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.

 

Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.
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To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.
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LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels Panel PCs:
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

10.11.17.
5

Data exchange using area pointers

General information on area pointers

Introduction   
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.
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Configuration of area pointers
Before you use the area pointer, you enable it in "Connections ▶ Area pointers". You then 
assign the area pointer parameters.

● Active
Enables the area pointer.

● Pointer name
Name of the area pointer specified by WinCC.

● PLC tag
Here you select the PLC tag or the tag array that you have configured as the data area for 
the area pointer.

● Address
No address is entered into this field because of the symbolic access.

● Length
WinCC specifies the length of the area pointer.

● Acquisition cycle
You specify the acquisition cycle in this field for area pointers that are read by the HMI 
device. Note that a very short acquisition time may have a negative impact on HMI device 
performance.

● Comment
Enter a comment, for example, to describe the purpose of the area pointer.
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Accessing data areas

Accessing data areas
The following table shows how HMI devices and PLCs access individual data areas for read 
(R) or write (W) operations.   

Data area Required for HMI device PLC
Screen number Evaluation by the PLC in order to determine the active screen. W R
Data record Transfer of data records with synchronization R/W R/W
Date/time Transfer of the date and time from the HMI device to the PLC W R
Date/time PLC Transfer of the date and time from the PLC to the HMI device R W
Coordination Requesting the HMI device status in the PLC program W R
Project ID Runtime checks for consistency between the WinCC project 

ID and the project in the PLC
R W

Job mailbox Triggering of HMI device functions by the PLC program R/W R/W

"Screen number" area pointer

Function     
The HMI device saves information about the screen called on the HMI device to the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. The 
PLC can trigger specific reactions such as the call of a different screen.

Use
Configure and enable the area pointer in "Communication > Connections" before you put it 
into use. You can create only one instance of the "Screen number" area pointer and only on 
one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.

Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1. word Current screen type
2. word Current screen number
3. word Reserved
4th word Current field number
5. word Reserved
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● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

"Date/time" area pointer

Function     
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. All definitions are coded in BCD format.

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

The date/time data area has the following structure:

Data word Left byte Right byte  
15       8 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.
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"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer. All definitions are coded in BCD format.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the Date/time area pointer in order to avoid 
any negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute if your process can handle it.

 

"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The "Date/time PLC" data area has the following structure:

Data word Left byte Right byte
15 . . . . . . 8 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.
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"Coordination" area pointer

Function    
The "Coordination" area pointer is used to implement the following functionality:

● Detecting the startup of the HMI device in the control program

● detection in the control program of the current HMI device operating mode

● detection in the control program of the HMI devices ready to communicate state

The "Coordination" area pointer has a length of one word.

Use
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program may not make changes to the coordination area for this reason.

 

Assignment of bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
state of the operating mode bit is "0" during normal operation of the HMI device.  You can 
determine the current operating mode of the HMI device by reading this bit.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not the connection to the HMI device is still up by querying this bit in the control 
program.
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"Project ID" area pointer

Function     
You can check whether the HMI device is connected to the correct PLC at the start of runtime. 
This check is important when operating with several HMI devices.

The HMI device compares a value stored on the PLC with the value specified in configuration. 
This ensures compatibility of configuration data with the control program. If discrepancy is 
detected, a system event is displayed on the HMI device and runtime is stopped.

Use
To use this area pointer, set up the following during the configuration:

● Define the version of configuration. Possible values between 1 and 255.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● Data address of the value for the version that is stored in the PLC:
You enter the data address in the editor "Communication > Connections".

Connection failure
A connection failure to a device on which the "project ID" area pointer is configured results in 
all the other connections in the project being switched to "offline".

This behavior has the following prerequisites:

● You have configured several connections in a project.

● You are using the "project ID" area pointer in at least one connection.

Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the engineering system.

 

"PLC job" area pointer

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time
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Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Left byte Right byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.

Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

 

 Note

Please note that not all HMI devices support job mailboxes.
 

No
.

Function  

14 Setting the time (BCD coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Setting the date (BCD coded)
 Parameter 1 Left byte:  -

Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
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No
.

Function  

14 Setting the time (BCD coded)
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 (in the S7 format  DATE_AND_TIME)

An interval of at least 5 seconds must be maintained between two successive jobs to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 (In OP/MP format)

An interval of at least 5 seconds must be maintained between successive jobs in order to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
46 Update tags
 Causes the HMI device to read the current value of the tags•from the PLC whose update ID 

matches the value transferred in parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Screen selection 1)

 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Read data record from PLC
 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Write data record to PLC
 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job 
mailbox if the on-screen keyboard is active.
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"Data record" area pointer

"Data mailbox" area pointer

Function  
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.

Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization over the data record

Data records are always transferred directly. That is, the tag values are read from an address 
or written to an address configured for this tag directly, without redirecting the values by means 
of interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions

If the transfer of data records is triggered by a configured function or by a job mailbox, the 
recipe view on the HMI device remains operable. The data records are transferred in the 
background. 

Simultaneous processing of several transfer requests is, however, not possible. In this case, 
the HMI device rejects the other transfer requests with a system event. 

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example, when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.
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Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then process, edit, or save these 
values, for example. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. You can use this mechanism to prevent uncontrolled overwriting of data in either 
direction in your control program.     

Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Communication > Connections" editor in "Area pointer".

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the inspector window the option "Coordinated transfer of data records" 
under "General > Synchronization > Settings"
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Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data record free
2 0000 0010 Transferring.
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error

Sequence of a transfer started by the operator in the recipe display

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data record and sets the data record number to 
0. 

Abort with system 
event.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
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Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data record.

Abort with system 
event.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized between the recipe view and tags and then written to 
the PLC.

 

3 The HMI device sets the status "Transfer completed."  
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.

 

 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of the transfer triggered by a PLC job
The transfer of data records between the HMI device and the PLC can be initiated by either 
one of these stations.  

The two job mailboxes No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data records from the PLC to the HMI device. The job mailbox is 
structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1 to 65535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1
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No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox No. 70 transfers data records from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1 to 65535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data record.
Abort without 

return message.
3 The HMI device reads the values from the PLC and saves these to the 

data record defined in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 1100 
in the status word of the data record.

 

5 The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of writing to the PLC with job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data record.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

function from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order to enable 
further transfers.
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Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
record.

Abort with system 
event.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data record.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.

 

Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
record.

Abort with system 
event.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of error  
The section below shows possible error causes which lead to the cancellation of data record 
transfer: 

● Tag address not set up on the PLC

● Overwriting data records not possible
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● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system alarms

● Triggered by function
Output of system alarms

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
record.

10.11.18 Special features of WinAC MP

10.11.18.
1

WinAC MP basics

WinAC MP basics 
WinAC MP is a software package for HMI devices. WinAC MP integrates a software PLC 
compatible with SIMATIC S7 in WinCC Runtime. 

Using WinAC MP you can execute STEP 7 programs on the HMI device.

The common use of WinAC MP and WinCC provides process control and visualization on one 
HMI device. 

The communications driver for WinAC MP supports the following protocols for controlling the 
process components:
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● Industrial Ethernet

● PROFIBUS DP

The following screen shows the principal connection of the process components on the 
PROFIBUS DP example.

If you wish to control your process using an HMI device and WinAC MP, then you must install 
WinAC MP on your configuration PC. Then transfer WinAC MP and the project to your HMI 
device. 

 

 Note
Notes about instructions

The following describes how to install WinAC MP and transfer WinAC MP to an HMI device.

To transfer a STEP 7 project with a WinAC MP controller to an HMI device, you require 
experience with STEP 7. 
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10.11.18.
2

Communication options with WinAC MP

Definition of "routing"  
If there are stations in an automation system that are not connected to the same bus, these 
stations cannot be accessed directly online. To establish a connection to these devices, a 
router must be included between them. 

An MP x77 HMI device with WinAC MP can function as the router. As a router, it connects the 
Ethernet and PROFIBUS networks.

You can use routing, for example, to do the following:

● Download STEP 7 user programs

● Download a hardware configuration

● Execute testing and diagnostics functions

Definition of "Softbus"  
Virtual bus that allows data exchange between WinCC Runtime and WinAC MP. This bus is 
also installed when you install WinCC . After installing WinAC MP, S7 connections from WinCC 
Runtime to external stations on PROFIBUS or Ethernet are routed over Softbus.

Prior to installation of WinAC MP (without Softbus)

After installation of WinAC MP (with Softbus)
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Routing from Ethernet to PROFIBUS DP with WinAC MP
With STEP 7 on Industrial Ethernet, you can access all nodes on PROFIBUS DP from the HMI 
device. With WinCC, you can access the HMI device but not the nodes connected over 
PROFIBUS DP.

If the configuration PC is not connected directly to PROFIBUS DP, the nodes on PROFIBUS 
can nevertheless be reached because the MP x77 HMI device serves as a router.
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Figure 10-3 Routing from Ethernet to PROFIBUS DP with WinAC MP

Routing from PROFIBUS DP to Ethernet with WinAC MP
With STEP 7 on PROFIBUS DP, you can access all nodes on Industrial Ethernet from the HMI 
device. With WinCC on PROFIBUS DP, you have access to the HMI device and to OPs 
connected over PROFIBUS DP. 

Figure 10-4 Routing with WinAC MP over PROFIBUS
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Visualization over WinAC MP
Visualization over the HMI device between Industrial Ethernet and PROFIBUS DP is possible 
with WinCC.

It is not necessary to program the communication links. A PC serves as the visualization 
platform.

Figure 10-5 Visualization over WinAC MP
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CPU-CPU communication over WinAC MP
CPU-CPU communication is possible with the HMI device.

Figure 10-6 CPU-CPU communication over WinAC MP

10.11.18.
3

Standard procedure for communication with WinAC MP

Overview
The section below shows how to configure WinAC MP in a SIMATIC HMI station using a 
configuration PC on which STEP 7 and WinCC are installed.

The configuration PC and WinAC MP in a SIMATIC HMI station are interconnected via 
PROFIBUS DP. Configuration via Ethernet is also possible. A description of the procedure can 
be found in the "WinAC MP" manual.

You can integrate DP slaves for WinAC MP in the STEP 7 project.
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Procedure
The basic steps are as follows:

1. Configure WinAC MP in STEP 7.

2. Create a connection between WinAC MP and WinCC Runtime.

3. In STEP 7, download the configuration to WinAC MP.

4. Configure (visualization) HMI objects with WinCC .

5. Download the (visualization) configuration (for example, visualization with histogram) from 
WinCC to the HMI device.

10.11.18.
4

Configuring the WinAC MP communications driver

Requirements for the use of WinAC MP

Requirements
In order to use WinAC MP in the process control, you must perform the installation and 
development steps on your configuration PC. Transfer the necessary components to the HMI 
device.
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Basic procedure  
The following steps are described in more detail in the following:

1. Check that your system meets the system requirements:

– STEP 7 and the authorization are installed on the configuration PC.

– WinCC and the authorization are installed on the configuration PC.
WinCC Runtime and ProSave were installed along with WinCC.

2. When WinCC is installed, the WinAC MP option is also automatically installed. Authorization 
of the WinAC MP is carried out via separate licenses.
The following components are installed alongside WinAC MP:

– WinAC MP Runtime files

– WinAC MP system library

3. Develop a STEP 7 project for controlling your process with WinAC MP on the HMI device.

4. Develop a WinCC project for operating and visualizing your controller.

5. Connect the process components via the PROFIBUS network and configure the hardware.

6. Transfer the WinAC MP Runtime files from the configuration PC to the HMI device.
Use ProSave for this.

7. Transfer the WinAC MP authorization from its storage location to the HMI device.
Use the Automation License Manager for this.

8. Transfer the STEP 7 project to the HMI device.

9. Transfer WinCC Runtime and the WinCC project to the HMI device.
To do this, use the "Transfer" function.

Changing the device type

Introduction
There are different ways to create a SIMATIC HMI‑station with an HMI device and a configured 
WinAC MP controller.

Procedure 1

Create an HMI device in a SIMATIC HMI‑station in the device and network view. Then add the 
corresponding variant of WinAC MP.

The advantage of this procedure is that you can choose the device type (MP 177, MP 277 or 
MP 377) and the design of the device type (monitor size and touch or key) directly on selection 
in the hardware catalog.

Procedure 2

Insert the desired variant of WinAC MP directly in the device and network view.

This procedure creates, by default, the largest touch design of the selected HMI device in the 
device and network view.
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Changing the device type
Select a device. You can change the device type using the shortcut menu command "Change 
device". When the device type MP277 is changed to MP377 and MP 177 or vice versa with a 
configured WinAC MP controller in a SIMATIC HMI station, the WinAC MP controller is 
automatically moved to the storage location of the non slotted modules. It can therefore not 
be used in the new HMI device. If the the device type is changed, the WinAC MP‑configuration 
must be created again.

Connecting the configuration PC and HMI device

Procedure for creating a connection via Ethernet or PROFIBUS DP

Basic procedure
WinAC MP supports the communication between the configuration PC and the HMI device via 
the following connections:         

● Industrial Ethernet

● PROFIBUS DP

● USB

To achieve successful communication, follow these steps:

1. Connect the configuration PC to the HMI device.

2. Make the parameter settings for data transfer on the control panel.

3. Make the parameter settings for data transfer on the configuration PC.

4. Set the communications parameters in ProSave.
With ProSave you can load the WinAC MP Runtime files in the HMI device. Therefore, you 
must set the communication parameters both in ProSave as well as on the HMI device.

5. Set the communications parameters in WinCC.
Use WinCC to download your project to the HMI device using the "Download" function.

Establishing a connection over Ethernet

Connect the configuration PC to the HMI device (Ethernet)
In order to communicate via an Ethernet network you can either use a direct connection or a 
networked connection. 

To connect a configuration PC to an HMI device via Ethernet, follow these steps:
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1. Connect the interfaces of the configuration PC and the HMI device with an Ethernet cable.
 

  Note

Use a crossover cable to create a direct connection between the configuration PC and 
the HMI device.

To connect the configuration PC and the HMI device to an Ethernet (LAN) use a 1 to 1 
cable with RJ45 connector.

The interface to be used on the HMI device can be established from the operating 
instructions of your HMI device.

 

Configuring the transmission settings in the Control Panel (Ethernet)

Requirements
The configuration PC and HMI device are connected to each other over an Ethernet cable. 

Setting up an IP address on the control panel
The set up the IP address on the control panel, follow these steps:

1. Switch on the HMI device.
Before the HMI device opens an existing project, the "Loader" selection field appears. 

2. Select "Control Panel".

3. Double click on the "Network and Dial-up Connection" symbol.

4. Double-click on the LAN connection.

5. Select the "IP Adress" tab.
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6. Select "Specify an IP address".

7. Enter the IP address and the subnet mask that you were given by your network 
administrator.

8. Confirm your entries with "OK".

Entering transfer settings
To make the data transfer settings, follow these steps:

1. In the control panel, double click on the "Transfer" symbol.

2. Select the "Channel" tab.

3. Select the "Ethernet" option in the "Channel 2" area.

4. Enable "Enable Channel" and confirm your entries.

5. Click "OK" and end the dialog "Transfer Settings".

The transmission settings are configured on the configuration PC

Requirement
● The configuration PC and HMI device are connected to each other over an Ethernet cable

● The data transfer settings have been made on the control panel  
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Procedure
To make the data transfer settings on the configuration PC, follow these steps:

1. Open the network settings of your PC.

2. Select the "Internet Protocol (TCP/IP)".

3. Enable the "General" tab.

4. Select the "Use the following IP address" check box in the protocol properties.

5. Enter an "IP address".

6. Enter a "subnetwork mask".

7. Confirm your entries.
 

  Note

The IP addresses of the configuration PC and the HMI device must not be the same.

The subnet mask must be the same for the configuration PC and the HMI device.
 

Set the communication parameters (Ethernet)

Requirement
● The configuration PC and HMI device are connected to each other over an Ethernet cable

● The data transfer settings have been made on the control panel

● The data transfer settings have been made on the configuration PC

Procedure
To make the communications parameter settings in ProSave, follow these steps:

1. Make the transfer settings first.

2. To do this, select the desired component in the project tree.

3. Select the "Download to device > Software" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog will automatically open. In this case, set all the necessary parameters for 
the connection and click "Load".

– If you have already defined an online connection, the project data will be compiled 
immediately and the "Load preview" dialog will open. This dialog displays messages 
and proposes actions necessary for uploading.

4. Select the "Options" command from the "Online > HMI device maintenance" menu to start 
ProSave .
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5. Select an element under "Available options".

6. Click ">>".

 

Setting the communication parameters in WinCC (Ethernet)

Requirement
● The configuration PC and HMI device are connected to each other over an Ethernet cable.

● The data transfer settings have been made on the control panel.

● The data transfer settings have been made on the configuration PC.

Procedure
To make the connection settings in WinCC, follow these steps:

1. Open the transfer settings.

2. Select the desired HMI device in the project tree.

3. Select the "Download to device > Software" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog will automatically open. In this case, set all the necessary parameters for 
the connection and click "Load".

– If you have already defined an online connection, the project data will be compiled 
immediately and the "Load preview" dialog will open. This dialog displays messages 
and proposes actions necessary for uploading.
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4. Select the "Ethernet" mode.

5. Specify the IP address or the computer name of the HMI device.

6. Switch the HMI device to "transfer" mode.

7. Transfer the WinCC project to the HMI device.
 

 
 WARNING

Death, serious bodily harm and / or damage to property from unexpected process or 
machine behavior.

If you use DHCP it is not guaranteed that every time the same IP address will be issued 
if a node is switched on.

Nodes could lose the connection in the Industrial Ethernet or be connected with incorrect 
nodes. Always enter a static IP address for the HMI device. Contact your network 
administrator for address allocations.
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Establishing a connection via PROFIBUS DP

Connect the configuration PC to the HMI device (PROFIBUS DP)
1. Connect the interfaces from the configuration PC and the HMI device with an 

PROFIBUS DP cable.
 

  Note

To communicate via an PROFIBUS DP network you must create a direct connection.

Check if your configuration PC has a suitable interface for connection to the PROFIBUS 
DP.

If this interface is missing, you must perform the following steps:
● Build a card into the configuration PC, e.g. CP 5611 for desktop PCs.
● Install the respective drivers.

 

Configuring the transmission settings in the Control Panel (PROFIBUS DP)

Requirement
● The configuration PC and HMI device are linked with each other via a PROFIBUS DP cable.

Procedure
Perform the following steps on the HMI device:

1. Switch on the HMI device.
Before the HMI device opens an existing project, the "Loader" selection field appears. 

2. Select "Control Panel".

3. Double click on "Transfer".

4. Select the "MPI/PROFIBUS" option from the "Channel 2" selection list under the "Channel" 
tab.
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5. Select "Enable Channel".

6. Confirm with "OK".

7. "Transfer Settings" End the dialog.

 

Setting the communication parameters in ProSave (PROFIBUS DP)

Requirement
The configuration PC and HMI device are linked with each other via a PROFIBUS DP cable.

The data transfer settings have been made on the control panel.

Procedure
To make the communications parameter settings in ProSave, follow these steps:

1. Make the transfer settings first.

2. To do this, select the desired component in the project tree.

3. Select the "Download to device > Software" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog will automatically open. In this case, set all the necessary parameters for 
the connection and click "Load".

– If you have already defined an online connection, the project data will be compiled 
immediately and the "Load preview" dialog will open. This dialog displays messages 
and proposes actions necessary for uploading.

4. Select the "Options" command from the "Online > HMI device maintenance" menu to start 
ProSave .
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5. Select an element under "Available options".

6. Click ">>".

Set the communication parameters in WinCC (PROFIBUS DP)

Requirement
● The configuration PC and HMI device are linked with each other via a PROFIBUS DP cable.

● The data transfer settings have been made on the control panel.

Procedure
To make the connection settings in WinCC, follow these steps:

1. Open the transfer settings.

2. Select the desired HMI device in the project tree.

3. Select the "Download to device > Software" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog will automatically open. In this case, set all the necessary parameters for 
the connection and click "Load".

– If you have already defined an online connection, the project data will be compiled 
immediately and the "Load preview" dialog will open. This dialog displays messages 
and proposes actions necessary for uploading.

4. Select the "MPI / PROFIBUS DP" mode.
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5. Specify the PROFIBUS address that is assigned to the HMI device.
The PROFIBUS address is the station address and corresponds to the address configured 
for the WinAC MP controller.

6. Switch the HMI device to "transfer" mode.

7. Transfer the WinCC project to the HMI device.
 

  Note

For PROFIBUS DP transmission the WinAC MP control must be started on the HMI device.
 

10.11.18.
5

Transferring WinAC MP to the HMI device

Procedure for transferring WinAC MP

Introduction
If you want to execute WinAC MP on the HMI device you must transfer the WinAC MP Runtime 
files from the configuration PC to the HMI device. For the transfer there must be a data 
connection between the configuration PC and the HMI device. The following screen shows the 
arrangement using example Industrial Ethernet.
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Basic procedure
To transfer WinAC MP Runtime files to an HMI device, follow these steps:

1. Setting up the HMI device.

2. Configure the ProSave  on the configuration PC.

3. Start transfer.

 

Switch the HMI device to transfer mode

Procedure
For the transfer of data you must switch the HMI device to "Transfer":

1. Switch on the HMI device.
Before the HMI device opens an existing project, the "Loader" selection field appears. 

2. Click on the "Transfer" button.
The dialog window displays the message "Connecting to host ...".

 

Configuring ProSave on the configuration PC

Requirement
The HMI device was switched to transfer mode.

Procedure
To set up a configuration PC to transfer WinAC MP, proceed as follows:

1. Start ProSave.

2. Select the "General" tab.

3. Select the device type of your HMI device.
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4. Select the "Ethernet" connection type.

5. Specify the IP address or the computer name of the HMI device.

6. Start the transfer of WinAC MP.

Start transfer

Requirement
● The HMI device was switched to transfer mode.

● ProSave is set up on the configuration PC.
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Procedure
To start the transfer of WinAC MP files, follow these steps:

1. Open the "Options" tab in transfer mode and click the "Device status" button. If no error 
message is shown then the communication connection is valid.  

 

  Note

If there is a communication error, then you must check the following circumstances: 

• The HMI device must be in Transfer mode.

• Check the cable connections for a correct and firm connection.

• The settings in ProSave and on the HMI device must be correctly defined for the 
connection.

 

2. In the "Options" tab, select "WinAC MP" below "Available options".
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3. To transfer WinAC MP to the HMI device, click the  button.

ProSave then starts to load the software of the WinAC MP control to the HMI device. While 
the files are being transferred the configuration PC shows the progress of the transfer.
The following messages are displayed on the HMI device in the "Transfer" dialog box:

– Progress of the file receipt on the HMI device.

– Unzip data in the Flash file system.

– Save data in the Flash file system.

At the end of the transfer, a message confirms a successful transfer.

4. When transfer is complete, you will be asked to restart the device. Restart the device.

Result
The WinAC MP control is now installed on the HMI device. Now, transfer the authorization for 
WinAC MP to the HMI device.
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10.11.18.
6

Transferring authorization to the HMI device

Introduction
You need a license key to operate WinAC MP. The license key is transferred with the 
Automation License Manager to the HMI device.

Requirements
The storage location of the license key can be called from the configuration PC.

Procedure
To transfer the WinAC MP authorization to an HMI device, follow these steps:

1. Select the "Authorize/License" command from the "Online > Device maintenance" menu 
to start WinAC MP authorization.
Automation License Manager is launched.

2. Select the "Connect HMI device" menu command.

3. Select the device type of the HMI device.

4. Select the type of connection and set the parameters for the connection.
The connection to the HMI device is established. The connected HMI device is displayed.

5. Select the source drive.
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6. Drag one or more license keys to the HMI device.
The license keys are then transferred to the HMI device.

7. Close the Automation License Manager after a successful transfer.   

10.11.18.
7

WinAC MP system library

Screens from the system library
The screens from the system library are optimized for a 6' display with a resolution of 320 x 
240. If you use a display of a different size, you can adapt the screens for your display in WinCC.

Standard screens and tags
The WinAC MP‑system library offers you the standard screens "WinAC_MP_Home" and 
"WinAC_MP_Tuning" and the tags "WinAC_MP_Tags". To use the standard screens, move 
them to the "Screens" folder in the project tree.

In addition to the standard screens, the tags must be copied separately. To do this, drag 
"WinAC_MP_Tags" from the WinAC MP‑system library to the "HMI_Tags" folder in the project 
tree.
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10.12 Using global functions

10.12.1 HMI device wizard basics

Introduction
The HMI device wizard will automatically start when you create a new HMI device in your 
project. 

HMI device wizard
The HMI device wizard will guide you through each dialog step by step and help you set up a 
device. You use the HMI device wizard to specify the basic settings for your HMI device, such 
as screen layout and the connection to your PLC.
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See also
HMI device wizard basics (Page 5487)

10.12.2 HMI device wizard basics

Introduction
The HMI device wizard will guide you through each dialog step by step and help you set up a 
device. You use the HMI device wizard to specify the basic settings for your HMI device, such 
as screen layout and the connection to your PLC.   
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Opening the HMI device wizard
1. Add a new device to your project, for example, RT Advanced.

2. Click on the device in the project tree.

3. Select "Start the HMI device wizard" in the shortcut menu. The "HMI device wizard" opens.
 

  Note

If you make changes after adding the device, such as adding a new screen, the HMI device 
wizard will not open again. 

 

See also
HMI device wizard basics (Page 5484)

10.12.3 Working with libraries

10.12.3.1 Basics on libraries

Introduction
Store all objects you need frequently in the libraries. An object that is stored in the library only 
has to be configured once. It can then be used repeatedly as often as required. Library objects 
extend the number of available screen objects and increase the effectiveness during 
configuration through the multiple usage of ready-to-use objects.

Your WinCC software package is supplied with comprehensive libraries that contain, for 
example, "Motor" or "Valve" objects. You may, however, define your own library objects. 

You manage libraries in the "Libraries" task card or library view. The following libraries are 
available:         
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● Project library

● Global libraries

 

 Note

There is a symbol library in the "Tools" task card in the "Graphics" palette.
 

Project library
There is one library for each project. Objects of the project library are stored alongside with 
the project data and are available only for the project in which the library was created. If the 
project is moved to another PC, any project library created in it is also moved. 

To use the library object of the project library in other objects, move or copy the object into a 
global library.

Global libraries
A global library is saved independently of the project data in its own file with the extension 
*.aI12.

A project can access several global libraries. A global library may be used concurrently in 
several projects. 

When a library object is changed by a project, this library will be changed in all projects in 
which these libraries are open. 
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Library objects   
A library can contain all WinCC objects. Examples: 

● Complete HMI device

● Screens

● Display and control objects including tags and functions

● Graphics

● Tags

● Alarms

● Text and graphics lists

● Faceplates

● User data types

 

See also
Copy templates and types (Page 5492)

Screen basics (Page 2931)

10.12.3.2 Overview of the library view

Function of the library view
The library view combines the functionality of the "Libraries" task card and the overview 
window. In the library view, the elements of a library are displayed in various views. In the 
details view, for example, you see additional properties of the individual elements. You can 
also edit and version the types in the library view.
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Layout of the library view
The following figure shows the components of the library view:

1 Library tree
2 Library overview
3 "Library view" button
4 "Open or close library overview" button

Library tree
The library tree is similar to the "Libraries" task card, apart from a few minor differences. In 
contrast to the task card, there is no "Elements" palette, because the elements are displayed 
in the library overview. In addition, you can close the library view in the library tree, or open 
and close the library overview.
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Library overview
The library overview corresponds to the overview window and displays the elements of the 
currently selected object in the library tree. You can display the elements in three different 
views. You can also perform the following actions in the library overview, for example:

● Copying elements 

● Moving elements

● Versioning types

● Editing faceplates and HMI user data types

● Editing type instances

10.12.3.3 Copy templates and types

Introduction
Both the "Project library" and the "Global library" contain the two folders "Master copies" and 
"Types". You can create or use the library objects either as a copy template or a type. 

Master copies     
Use copy templates to create independent copies of the library object. 

Types     
Create instances of objects of the "Types" folder and use these in your project. The instances 
are bound to their respective type. 

Administration of the library objects   
You can copy and move library objects to another library. You can only copy copy templates 
to the "Master copies" folder or any sub-folder of "Master copies". You can also only insert 
types in the "Types" folder or any sub-folder of "Types". 

See also
Basics on libraries (Page 5486)

State of type versions (Page 5503)
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10.12.3.4 Libraries in WinCC

Introduction
The WinCC software package includes extensive libraries. Sorted by topic into folders, they 
contain preassembled graphic objects which you can use in screens for operation and 
monitoring of your plant.

Global library "Buttons and Switches"
The libraries "Buttons and Switches" offer a wide selection of buttons and switches.     

The folders divide switches and buttons into categories. The "DiagnosticsButtons" folder 
contains the object "System diagnostics indicator", for example. You use the "System 
diagnostics indicator" object for system diagnostics in your plant. 

 

 Note

You can only use the objects in the "DiagnosticsButtons" folder on Comfort Panels. 

You cannot use objects which have "Switch" in the object name or in the associated folder 
name in Runtime Professional.
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Global library "Monitoring and Control objects"
The "Monitoring and Control objects" library offers more complex display and operating objects 
in several designs and corresponding control lights, buttons and switches. 

 

In addition, graphics views for the designs are stored in the "Design_Backgrounds" folder; they 
can be used as object backgrounds for the custom extension of the scope of the library.

 

 Note

You cannot use objects which have "Switch" in the object name in Runtime Professional. The 
same applies for the object "D5_Display_3" with the date/time field it contains.

 

10.12.3.5 Managing libraries

Creating a global library

Introduction
In the libraries you store the configured objects that you want to use several times in your 
configuration. To use objects in several projects, create a global library.    
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Requirement
● A project is open.

● The "Libraries" task card is displayed or the "Library view" is open.

Procedure
1. Click the  icon under "Global library".

The "Create new global library" dialog opens. 

2. Enter a name.

3. Select the path where the new library is to be stored.

4. Click "Create".

Result
The new library is shown in the "Global libraries" palette. The global library contains the 
"Types", "Master copies" and "Common data" folders. Under the "Common data" you can find 
reports for the global library.

A folder with the name of the global library is created in the file system at the storage location 
of the global library. This actual library file is given the file name extension ".al12". 

Saving a global library

Introduction
A global library is stored in a separate file on your hard disk drive. The file contains the objects 
of the global library including the referenced objects. E.g. the reference of a tag which was 
configured on an I/O field is also saved in the library.       

WinCC prompts you to save the global libraries when you close WinCC or your project without 
saving. You also can store the global library during configuration, without storing the entire 
project. 
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Requirement
● You have opened a project which contains at least one library.

● The "Libraries" task card is displayed or the library view is open.

● A library has been changed.

Procedure
1. Select the global library that you want to save.

2. Click the  icon in the "Global library" palette.

You can alternatively select the "Save Library" command in the shortcut menu. 

If you want to store the global library in a different folder, select "Save as" in the shortcut menu. 
Select the path in which you want to store the new library and enter a file name. 

Result
The global libraries are saved under their current file name or a file name you have specified. 

Opening a global library

Introduction
In WinCC, the global libraries are stored in separate files. You can use a global library in every 
project.       

Requirement
● You have saved a global library.

● A project is open.

● The "Libraries" task card is displayed or the library view is open.

Procedure
1. Click the  icon in the "Global library" palette.

The "Open global library" dialog box is displayed. 

2. Select the path in which the library is stored.

3. Click "Open".
 

  Note

To have the access to a global library from multiple projects, open the global library read-
only. As soon as a global library is not opened read-only, access from other projects is 
blocked.
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Result
WinCC displays the opened global library in the "Global library" palette. 

Displaying logs of global libraries
Logs listing all changes made to the global library are created when global libraries are 
updated. The logs are stored together with the global library and are always available once 
you have opened the global library.

Procedure
To open the logs of a global library, follow these steps:

1. Open the global library in the "Libraries" task card or in the library view.

2. Open "Common data > Logs" in the lower-level folder.

3. Double-click the required log.
The log opens in the work area.

Updating a project with the contents of a library

Introduction
After you have edited several types in the project library, update all instances in the project to 
the most recent version of the types from the project library. 

Requirement
The "Libraries" task card or the library view is open.

Procedure
1. Select the project library.

2. Select "Update > Project" from the shortcut menu. A dialog opens.

3. Select either the entire project or individual devices for the update.

4. Select the "Delete all unused versions of affected types" check box to delete all older 
versions of the updated types from the project library.

5. Click "OK" to confirm.

Result
All instances of the types are updated in the project to the most recent version of the selected 
types in the project library. 

You can find a log of the update process in the project tree under "Common data".
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Updating a library with the contents of another library
The following options are available for updating libraries:

● Updating a global library with types from another global library

● Updating the project library with types from a global library

Each of the following elements can be selected as source for the update:

● An entire library

● Individual folders within a library

● Individual types

Requirement
To update a global library, open the library with write rights.

Requirement
The "Libraries" task card or the library view is open.

Procedure
To update a library with the contents of a different library, follow these steps:

1. Select the entire library or a folder within the library or individual types.

2. Right-click the source and select the "Update > Library" command from the shortcut menu.
The "Update library" dialog box opens.

3. Select the type of library you want to update:

– Select "Update the project library" to update the project library with types from a global 
library.

– Select "Update a global library" if you want to update a global library.

4. Optional: Select the global library you want to update from the drop-down list.

5. Select the "Delete all unused versions of affected types" check box to delete all older 
versions of the updated types from the project library.

6. Click "OK" to confirm.

Visualizing processes (Comfort/Advanced)
10.12 Using global functions

WinCC Comfort/Advanced V12.0 SP1
5496 System Manual, 07/2013,  



Result
● Types not yet available in the target library are supplemented there with all their versions. 

More recent versions are added to the types that already exist in the target library. 
If a more recent version of a type already exists in the target library, the latest version is 
nevertheless copied and automatically assigned a newer version number.

● A log listing all performed changes to the target library is created for the update process. 
If you have updated the project library, you can find the log in the project tree under 
"Common data > Logs". 
If you have updated a global library, you can find the log in the "Common data > Logs" 
folder in the level below the global library.

10.12.3.6 Managing objects in a library

Displaying library objects

Introduction
The libraries are displayed as file folders in the corresponding palette. The elements contained 
in the library are displayed in the file folder and in the "Elements" palette.

Requirement
● At least one library object has been created in a library.

● The "Libraries" task card is opened.
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Procedure
1. Select the library in the corresponding palette whose library objects you want to display.

2. Click .
The contained library objects are displayed in the "Elements" palette. 

3. Click one of the following icons:
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Icon Description
Element view in detailed mode

Element view in list mode

Element view in overview mode with icons

When several objects are assigned to the library with a multiple selection, only one of the 
objects is shown in the "Elements" palette. The individual components of this element are 
displayed in the "Parts" palette.

Show parts of the library objects
1. Select the library in the corresponding palette from which you want to view the components 

of an element.

2. Click .

3. The contained library objects are displayed in the "Elements" palette.

4. Select the element.
The "Parts" palette shows the objects of which the element consists.

Result
The library objects are displayed in accordance with the configuration. The components of the 
faceplates are displayed.
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Storing an object in a library

Introduction
You can store all of WinCC objects, such as screens, tags, graphic objects or alarms in your 
libraries. You can use drag-and-drop to move the corresponding object from the work area, 
project window or detail view to the library. In a library you have divided into categories, you 
can directly add objects to a specific category.   

Requirement
● The "Screens" editor is open.

● A screen object has been created in the work area of the screen.

● The created libraries are displayed.

Procedure
1. Select the object in the work area of the "Screens" editor.

2. Drag-and-drop the object from the work area to the desired library.
The mouse pointer is transformed into a crosshair with an appended object icon.

Result
The object is saved to the library for further use in multiple instances of your configuration.

Inserting a library object

Introduction
The system always assigns the inserted library object a name which consists of the name of 
the object type and of a consecutive number. 
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If the inserted object already exists, you have the option of replacing the object or of saving it 
under a new name. 

You cannot insert library objects that are not supported by the HMI device.
 

 Note

If you insert a screen with interconnected template from the library, the template will also be 
inserted. Any existing matching template is not used.

 

Requirement
● The "Libraries" task card is opened.

● The editor in which you want to insert the library object is open.

Procedure
1. Select a library object from the library.

2. Drag-and-drop the library object to the position in the work area where you want to insert 
the object.
The library object is inserted.

Result
If the object was contained in the "Copy templates" folder, you have inserted an independent 
copy of the library object in the editor.

If the object was contained in the "Types" folder, you have inserted an instance of the library 
object in the editor.

10.12.3.7 Using types and their versions

State of type versions

Introduction
Depending on the point of use, the version of a type has different statuses.

Released version
The "released version" status is available for all types, regardless of the point of use.

If you want to edit a released version, you must first create a new test version or an "in progress" 
version.

Released type versions of scripts and screens can be opened and viewed at their instance.
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"In progress" version
Only versions of faceplate types and user-data types have the "in progress" status.

When you create a new type or a new version of a released type, the type is assigned the 
status "in progress".

Types with the "in progress" status can be edited in the library view without the need for a 
reference to an instance in the project. Upon release, the compatibility of the type is tested by 
a consistency check.

"In testing" version
Only versions of scripts and HMI screens have the "in testing" status.

When you create a new version of a type, the type is assigned the status "in testing".

A version with "in testing" status is linked to an instance in the project. You can set only one 
version to "in testing" for each type at a given time.

A version in testing may only be linked to a single instance in the project. Therefore, it is not 
possible to copy an instance to the clipboard, to duplicate it or to create an additional type from 
the instance as long as it has "in testing" status.

See also
Generating a script as a type (Page 5504)

Generating a screen as a type (Page 5505)

Creating a faceplate type (Page 3054)

Create a new version of a type (Page 5506)

Copy templates and types (Page 5490)

Generating a script as a type

Requirement
● A project is open.

● An HMI device has been created and opened.

● The project tree is open.

● The "Libraries" task card is opened.

Procedure
1. Open the "Scripts" editor in the project tree.

2. Create a new script.

3. Select the script in the project tree.

4. Drag-and-drop the script into a library in the "Libraries" task card. A dialog opens.
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5. Enter a name.

6. Enter a comment.

Result
You have created a type version of a script in the library. The created type is stored as a 
released version in the library. An instance of the type is used in the project.

To change the script create a new version of the script.

See also
State of type versions (Page 5501)

Generating a screen as a type

Requirement
A project is open.

An HMI device has been created and opened.

The project tree is open.

The "Libraries" task card is opened.

Procedure
1. Open the "Screens" editor in the project tree.

2. Create a new screen.

3. Select the screen in the project tree.

4. Drag-and-drop the screen into a library in the "Libraries" task card. A dialog opens.

5. Enter a name.

6. Enter a comment.

Result
You have created a type of a screen in the library. 

The created type is stored as a released version in the library. An instance of the type is used 
in the project.

To change the screen create a new version of the screen.

See also
State of type versions (Page 5501)

Visualizing processes (Comfort/Advanced)
10.12 Using global functions

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5503



Create a new version of a type

Principle
If you create a new version of a type, the point of use of the type determines the status of the 
newly created version.

Requirement
The "Libraries" task card is opened.

A type has been created and released.

Procedure
1. Select the released type.

2. Select "Edit type" in the shortcut menu.

Result for faceplate types and user data types
A new version of the type is created.

The version has the status "in progress". The library view opens.

Result for types of scripts and screens
A dialog opens.  

After you have selected the settings in the dialog, the version is set to the status "in testing". 
The instance used in the project is set to the status "in testing". The library view opens.

See also
State of type versions (Page 5501)

10.12.4 Importing and exporting project data

10.12.4.1 Importing and exporting project data

Introduction
WinCC gives you the option of exchanging project data between the projects or copying them 
to external applications. 
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Exporting and importing between projects
You can export the following project data from a project and import them into another project. 

● Recipe data records

● Alarms

● Tags

● Text lists

● Project texts

Exporting and importing reduces the workload. Instead of creating new data records, you use 
data already created in previous projects.

Editing the export file
The following file formats are available for export and import depending on the editor:

● *.xlsx for alarms, tags, project texts and text lists

● *.csv for recipe data records

You can edit the import file in Excel, for example.

XLSX file format
XLSX format is a file format for Excel tables based on the Open XML format. XLSX files are 
optimized for Microsoft Excel 2007.

You can sort the columns as required in the XLSX file.

CSV file format
CSV stands for Comma Separated Value. In this format, the columns of the table that contain 
the names and the value of the entry are separated by semicolons. Each table row terminates 
with a line break. You can also open the CSV file for editing in Excel.

Importing project data
When project data is imported, the objects in the project are created.

The syntax of the import file is checked during import. The accuracy of the values imported 
and dependencies between the imported values are not checked.

Any errors found in the imported data are reported when the project is compiled.

Copying in Excel format
In all spreadsheet editors you can copy the content in Excel format into the buffer of your PC. 
Subsequently you insert the project data in Excel format directly into any application outside 
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the TIA Portal. To this purpose you use the corresponding command in the shortcut menu of 
the work area:

● If you select the command in the shortcut menu of the line header, the complete line is 
copied into the buffer.

● If you select the command in the shortcut menu of a cell, only the cell content is copied into 
the buffer. 

● If you select several lines and select the command, all marked data are always copied into 
the buffer. 

This data exchange is only possible as an export.

 

10.12.4.2 Importing and exporting recipes

Exporting recipes

Introduction
WinCC features an export function for exporting data records from recipes.     

Requirements
● The WinCC project for the export is open.

● Recipes have been created in a project.

● The "Recipes" editor is open.
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Exporting recipes
1. In the "Recipes" editor, select the recipe with the data records you want to export.

2. Click .
The "Export" dialog box opens.

The selected recipe is shown under "Recipe selection".

3. Under "Content selection", specify if all or only selected data records are to be exported.

4. Under "File selection", specify the file in which the recipe data is to be stored.

5. Specify the list separator and decimal separator under "Data separation".

6. Click "Export."
The export will start. 

Result
The exported data has been written to a CSV file. The CSV file will be stored in the specified 
directory. 

See also
Exporting alarms (Page 5512)

Exporting text lists (Page 5525)
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Importing recipes

Introduction
Recipes are identified by their name. The recipe name must therefore be unique. Open the 
import file in a simple text editor to check that it has the correct data structure.

Specify whether or not existing data records should be overwritten by records with the same 
name during the import.    

Requirements
● A CSV file containing at least one recipe has been created.

● The WinCC project for the import is open.

● The "Recipes" editor is open with at least one recipe.

Importing a recipe
1. In the "Recipes" editor, select the recipe with the data records you want to import.

2. Click .
The "Import" dialog box opens.

The selected recipe is shown under "Recipe selection".

3. Select the file you want to import under "File selection".

4. Under "Strategy", specify if existing data records should be overwritten by records of the 
same name.
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5. Under "Data separation", select the list separator and the decimal separator to use in the 
CSV file.

6. Click "Import".
The import will start. 

Result
The data records are created in the selected recipe. Depending on the setting for "Strategy", 
existing data records are overwritten by records with the same name from the CSV file. 

Existing data records with the same name will also be imported from the CSV file if you 
deactivate the "Overwrite existing data records" option. 

Format of recipe data

Introduction
This section describes the required format of the file for the import of recipes. The file containing 
the data of the recipes must be available in "*.csv" format. :    

Structure of recipe data
The structure of the import file is fixed. The following example shows the structure of a recipe 
containing two recipe elements, each with two data records:
List separator=<List separator>Decimal symbol=<Decimal 
separator><List separator><Line break>
<Name of the recipe><List separator><List separator><Line break>
LANGID_<ID of the language><List separator>
<Display name, recipe element 1><List separator>
<Display name, recipe element 2><Line break>
<Number recipe><List separator>
<Recipe data record number 1><List separator>
<Recipe data record number 2><Line break>
<Tag recipe element 1><List separator>
<Recipe data record 1 value 1><List separator>
<Recipe data record 2 value 1><Line break>
<Tag recipe element 2><List separator>
<Recipe data record 1 value 2><List separator>
<Recipe data record 2 value 2><Line break>

ID of the language
Use the "Windows language ID" in decimal notation, e.g. "1033" for English. Additional 
information is available in the documentation for the Windows operating system.
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10.12.4.3 Importing and exporting alarms

Exporting alarms

Introduction
WinCC has an export function for alarms.       

Requirements
● The WinCC project for the export is open.

● Alarms have been created in the project.

● The "HMI alarms" editor is open.

Exporting alarms
1. Click the  button in "Discrete alarms" or "Analog alarms".

The "Export" dialog box opens.

2. Click the "..." button and specify in which file the data are saved.

3. Specify whether you want to export "Disrete alarms" or "Analog alarms".

4. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 
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See also
Importing alarms (Page 5513)

Format of the analog alarm data (Page 5514)

Format of the discrete alarm data (Page 5517)

Exporting recipes (Page 5506)

Exporting text lists (Page 5525)

Exporting tags (Page 5519)

Importing alarms

Introduction
Alarms are identified by their alarm number. The alarm numbers must be unique in the analog 
and discrete alarm types. Alarms with redundant alarm numbers will be overwritten. An alarm 
without an existing alarm number is created.   

Any empty list entries for existing alarms contained in an xlsx file will be ignored for the 
purposes of the import. The entries of the existing alarms remain active and will not be replaced 
by empty ones.

Requirements
● An xlsx file with alarms has been created. 

● The structure of the xlsx file meets the requirements.

● The WinCC project for the import is open.

● The "HMI alarms" editor is open.

Importing alarms
1. Click the  button in "Discrete alarms" or "Analog alarms". The "Import" dialog box opens.

2. Click the "..." button and select the file that you want to import.

3. Click on the "Import" button. The import will start. A progress bar indicates the progress of 
the import operation.    
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Result
The corresponding alarms including alarm texts are created in WinCC on the basis of the import 
data. Alarms relating to the import operation are displayed in the output window. A log file is 
saved in the source directory of the import files. The log file has the same name as the 
respective import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

 Note

The syntax of the import file is checked during xlsx file import. The meaning of the properties 
or dependencies between the properties is not checked. It is possible to assign a trigger tag 
of an incorrect type, such as string, to an alarm. An error will be reported during compilation.

 

 

See also
Exporting alarms (Page 5510)

Format of the discrete alarm data (Page 5517)

Format of the analog alarm data

Introduction
This chapter describes the required format of the file for the import of analog alarms. The file 
containing the analog alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of a number of worksheets:

● Analog alarms(Analog alarms)

● Limits (Limits)

Each alarm is assigned a separate row in the import file. The import file with the analog alarms 
must be formatted as follows:   
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Example of the worksheet "Analog alarms"

 

Table 10-156 Meaning of the entries

List entry Meaning
ID The alarm number is used to reference an alarm. The alarm number is unique. 

Alarms with identical alarm numbers are overwritten during import. An alarm 
without an existing alarm number is created.

Name Name of the analog alarm
Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. Alarm texts 

must be assigned a language ID for import.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts.

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = AlarmTag; Tag = Tag1; DisplayType = Decimal; Length = 
5;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textlist1; Tag = tag 2; 
Length = 5;>

Class The class of an alarm determines whether or not the alarm must be acknowledged. 
It can also be used to determine how the alarm appears when it is displayed on 
the HMI device. The alarm class also determines whether and where the 
corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with 
other alarms, it can be acknowledged together with these alarms of the same 
group in a single operation.

Trigger tag Specifies the tag monitored for limit value violation.
Delay time value Specifies the delay time. The alarm is not triggered until the duration of the limit 

value violation equals the specified delay time.
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List entry Meaning
Delay time unit Specifies the time unit for the delay.
Report Enables reporting of the specific alarm on a printer.

True or "1" = Reporting enabled.
False or "0" = Reporting disabled.
Reporting must also be globally enabled in the project.

Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 
information about the alarm. A tooltip will be displayed in a separate window on 
the HMI device when the operator presses the <HELP> key.
The field designation contains a language ID. 

Example of the worksheet "Limits"

 

Table 10-157 Meaning of the entries

List entry Meaning
Alarm ID Alarm number

The alarm number is used to reference an alarm. The alarm 
number is unique. Alarms with identical alarm numbers are 
overwritten during import. An alarm without an existing alarm 
number is created.

Limit mode Trigger mode
Indicates the method used for monitoring the limit value.

Limit type Specifies the limit that will be monitored. Both a tag and a 
constant can be used as limit value.

Limit value Limit value
Indicates the tag or constant monitored for limit violation.
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List entry Meaning
Deadband mode Hysteresis mode

Specifies whether and in which cases hysteresis will be used.
For "Outgoing"
For "Incoming"
For "Incoming" and "Outgoing"

Deadband in percent 0 = The value specified for "Hysteresis" is considered to be 
absolute.
1 = The value specified for "Hysteresis" is referred to as a 
percentage of the limit value.

Deadband mode Hysteresis
Specifies a constant as a value of the hysteresis.

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 

 

 

See also
Exporting alarms (Page 5510)

Format of the discrete alarm data (Page 5517)

Format of the discrete alarm data

Introduction
This chapter describes the required format of the file for the import of discrete alarms. The file 
containing the discrete alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of the worksheets "Discrete alarms" (discrete 
alarms). Each alarm is assigned a separate row in the import file. Structure of the import file 
containing the discrete alarms:   
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Example of the worksheet "Discrete alarms"

 

Table 10-158 Meaning of the entries

List entry Meaning
ID The alarm number is used to reference an alarm. The alarm number is unique. 

Alarms with identical alarm numbers are overwritten during import. An alarm 
without an existing alarm number is created.

Name Name of the analog alarm
Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. For import, 

a language ID must be assigned to alarm text.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts. 

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = AlarmTag; Tag = Tag1; DisplayType = Decimal; Length = 
5;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textlist1; Tag = tag 2; 
Length = 5;>

Class The class of an alarm determines whether or not the alarm must be acknowledged. 
It can also be used to determine how the alarm appears when it is displayed on 
the HMI device. The alarm class also determines whether and where the 
corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with 
other alarms, it can be acknowledged together with these alarms of the same 
group in a single operation.

Trigger tag Specifies the tag containing the bit that triggers the alarm.
Trigger bit Specifies the number of the bit that triggers the alarm.
Acknowledge tag Specifies the tag containing the bit that is set by the operator upon 

acknowledgment. Only available if the selected alarm class requires alarm 
acknowledgment.

Acknowledgment bit Specifies the number of the bit that is set when the operator acknowledges the 
alarm.
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List entry Meaning
PLC acknowledgement tag Specifies the tag containing the bit that acknowledges the alarm of the control 

program. Only available if the selected alarm class requires alarm 
acknowledgment.

PLC acknowledgment bit Specifies the number of the bit that acknowledges the alarm of the control program.
Delay time value
 

Specifies the delay time. The alarm is not triggered until the duration of the limit 
value violation equals the specified delay time.

Delay time unit Specifies the time unit for the delay.
Report Enables reporting of the specific alarm on a printer.

True or "1" = Reporting enabled.
False or "0" = Reporting disabled.
Reporting must also be globally enabled in the project.

Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 
information about the alarm. A tooltip will be displayed in a separate window on 
the HMI device when the operator presses the <HELP> key.
The field designation contains a language ID.

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 

 

 

See also
Exporting alarms (Page 5510)

Format of the analog alarm data (Page 5512)

Importing alarms (Page 5511)

10.12.4.4 Importing and exporting tags

Exporting tags

Introduction
WinCC has an export function for tags.     
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Requirements
● The WinCC project for the export is open.

● Tags have been created in the project.

● The "HMI tags" editor is open.

Exporting tags
1. Click on the  button in the "HMI Tags" tab.

The "Export" dialog box opens.

2. Click the "..." button and specify in which file the data are saved.

3. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 

See also
Importing tags (Page 5520)

Format of the tag data (Page 5522)

Exporting text lists (Page 5525)

Exporting alarms (Page 5510)

Importing tags

Introduction
Tags are identified by the tag name. An existing tag will be overwritten with the data from the 
xlsx file if the tag name already exists in the project. A new tag is created if the tag does not 
yet exist.
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Requirements
● An xlsx file with tags has been created. 

● The structure of the xlsx file meets the requirements.

● The WinCC project for the import is open.

Importing tags
1. Click "HMI tags" in the project navigation.

2. Double-click "Show all tags". The "HMI tags" editor opens.

3. Click on the  button. The "Import" dialog box opens.

4. Click the "..." button and select the file that you want to import.

5. Click on the "Import" button. The import will start.    

Result
The relevant tags have been created in WinCC. Alarms relating to the import operation are 
displayed in the output window. A log file is saved in the source directory of the import files. 
The log file has the same name as the respective import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

 Note

The syntax of the import file is checked during xlsx file import. The meaning of the properties 
or dependencies between the properties is not checked. It is possible to assign a tag a trigger 
tag of the wrong type, for example, string. An error will be reported during compilation.
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See also
Exporting tags (Page 5517)

Format of the tag data (Page 5522)

Format of the tag data

Introduction
This section describes the format required for the file with tag data used for imports. The tag 
data file must be in "*.xlsx" format. 

Tag data structure
The import file in Microsoft Excel consists of a number of worksheets:

● HMI Tags (HMI tags)

● Multiplexing (multiplex tags)

Each tag is on a separate line in the import file. The import file with the tag data must have the 
following format:   

Example of the worksheet "HMI Tags"
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Table 10-159 Meaning of the entries

List entry Meaning
Name Indicates the configured name of an HMI tag. 
Path Specifies which folders in the project tree contain the tag. The folder structure is 

represented by "\" : "FolderName1\FolderName2\TagName".
PLC Tag Indicates whether the tag is linked to a PLC tag.
Connection Indicates the name of the connection to the PLC.
Data type Specifies the data type of a tag. The data types allowed depend on the 

communication driver being used. See the "Communication" section of the 
documentation for additional information on the data types permitted for the 
various communication drivers.

Length Specifies the length of the tag. This entry is only useful for data types with a 
dynamic length such as strings; it is left empty for all other data types.

Address Specifies the tag address in the PLC. The tag address must exactly match the one 
used in WinCC, for example, "%DB1.DBW0". The tag address is empty for internal 
tags.

Multiplexing Specifies whether multiplexing is used.
Index tag Shows the name of the index tag for multiplexing. 

In Runtime, the system first reads the value of the index tag. It then accesses the 
tag in the corresponding place in the tag list.

StartValue Specifies the start value of a tag. 
ID tag The update ID updates the value of a tag with the aid of a function or a PLC job. 

The update ID must be unique within an HMI device.
Coding Shows the coding method.
DiplayName [de_DE]
 

Shows the display name of an HMI tag. The field designation contains a language 
ID. The field designation contains a language ID. Display names must be assigned 
a language ID for import. Texts are imported to the corresponding project 
language.

Acquisition mode Specifies the tag acquisition mode.
Acquisition cycle Specifies the tag acquisition cycle. The acquisition cycle must correspond exactly 

to the one used in WinCC. The value is not language-dependent and should 
therefore be the same in every language. The default value is "1 s". The acquisition 
cycle is undefined if the tag acquisition mode is "on demand".
User-defined acquisition cycles must be created beforehand as the file will 
otherwise not be imported.

High High Limit type Indicates whether the limit value "High high" is monitored by a constant, a tag or 
not at all.

High High Limit Displays the limit value "High High". 
High Limit type Indicates whether the limit value "High" is monitored by a constant, a tag or not at 

all.
High Limit Displays the limit value "High".
Low Limit type Indicates whether the limit value "Low" is monitored by a constant, a tag or not at 

all.
Low Limit Displays the limit value "Low".
Low Low Limit type Indicates whether the limit value "Low Low" is monitored by a constant, a tag or 

not at all.
Low Low Limit Displays the limit value "Low Low".
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List entry Meaning
Linear scaling Indicates whether linear scaling is enabled. This entry can only be used for external 

tags.
End value PLC Specifies the end value of the PLC tag.
Start value PLC Specifies the start value of the PLC tag.
End value HMI Specifies the end value of the HMI tag.
Start value HMI Specifies the start value of the HMI tag.

Example of the worksheet "Multiplexing"

Table 10-160 Meaning of the entries

List entry Meaning
Name Indicates the configured name of an HMI tag which uses indirect addressing. The 

HMI tag must be available in the "HMI Tags" worksheet.
Index Shows the value which governs which tag is selected. 
Multiplex Tag Displays the tag from the tag list corresponding to the index value.

 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing tag of the same name. 

 

See also
Exporting tags (Page 5517)

Importing tags (Page 5518)
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10.12.4.5 Importing and exporting text lists

Exporting text lists

Introduction
WinCC has an export function for text lists.     

Requirements
● The WinCC project for the export is open.

● Text lists have been created in the project.

● The "Text & graphics lists" editor is open.

Exporting text lists
1. Click on the  button in the "TextLists" tab.

The "Export" dialog box opens.

2. Click the "..." button and specify in which file the data are saved.

3. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 

See also
Exporting alarms (Page 5510)

Exporting recipes (Page 5506)

Exporting tags (Page 5517)

Importing text lists

Introduction
You then import text lists from an xlsx file to WinCC.
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Requirements
● An xlsx file with text lists has been created.

● The structure of the xlsx file meets the requirements.

● The WinCC project for the import is open.

● The "Text & graphics lists" editor is open.

Importing text lists
1. Click on the  button in the "Text lists" tab.

The "Import" dialog box opens.

2. Select the file you want to import under "File selection".

3. Click on the "Import" button. The import will start.  

Result
You have now imported the text lists. The relevant text lists have been created in WinCC. 
Alarms relating to the import operation are displayed in the output window. A log file is saved 
in the source directory of the import files. The log file has the same name as the respective 
import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

Format of text list data

Introduction
This section describes the format required for the file with the text lists used for imports. The 
text list data file must be in "*.xlsx" format. 
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Tag data structure
The import file in Microsoft Excel consists of two worksheets:

● TextList (Text lists)

● TextListEntry (Text list entry)

Each text list is assigned a separate line in the import file. The import file containing the data 
must be structured as follows:   

Example of the worksheet "TextList"

 

Table 10-161 Meaning of the entries

List entry Meaning
Name Shows the name of the text list.
ListRange Shows the text list range:

Number = Bit number (0-31)
Range = value/range (...-...)
Bit = Bit (0;1)

Comment Any comments on the text list. You can use up to 500 characters
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Example of the worksheet "TextListEntry"

Table 10-162 Meaning of the entries

List entry Meaning
Name Shows the name of the text list entry.
Parent Specifies the name of the corresponding text list.
DefaultEntry Indicates whether the text list entry is a default entry. The default entry is always 

displayed when the tag has an undefined value. 
Value Specifies the tag integer values or value ranges which are assigned to the text 

entries in the text list.
Text Shows the text list entry. The field designation contains a language ID. Text list 

entries must be assigned a language ID for import. 
An expression with a reference ID will be added to the text if the text list entry has 
a dynamic parameter. Example: text <field ref="0" />. Use the ID to assign the 
dynamic parameter to a text list entry.

FeldInfo Specifies whether the text list contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = CommonTagDisplayFormat; Tag = tag 1; DisplayType = 
Decimal; DisplayFormat = 9;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textliste_1; Tag = tag 2; 
Length = 5;>
PLC tag: <ref id = 0; type = CommonControlTagDisplayFormat; DisplayType = 
Decimal; DisplayFormat = 9;>
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10.12.5 Using cross-references

10.12.5.1 General information about cross references

Introduction   
The cross-reference list provides an overview of the use of objects within the project.

Uses of cross-references
The cross-reference list offers you the following advantages:

● When creating and changing a program, you retain an overview of the objects, tags, and 
alarms etc. you have used.

● From the cross-references, you can jump directly to the object location of use.

● You can learn the following when debugging:

– The objects used in a specific screen.

– The alarms and recipes shown in a specific display.

– The tags used in a specific alarm or object.

● As part of the project documentation, the cross-references provide a comprehensive 
overview of all object, alarms, recipes, tags and screens.

10.12.5.2 Displaying the cross-reference list

Introduction
Details on the use of objects can be found in the cross-reference list. You can show cross-
references for HMI devices, folders and all editors in the project tree. The detail view also lets 
you select individual objects of the editors.

Requirement
You have created a project.

Several objects have been created.

Procedure     
1. Select the required entry in the project tree or detail view.

2. Select "Cross-references" in the shortcut menu. The cross-reference list is opened in the 
work area.

3. Open the "Used by" tab to display where the objects shown in the cross-reference list are 
used.

4. Open the "Used" tab to view the users of the objects displayed in the cross-reference list.
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5. You can sort the entries in the "Object" column in ascending or descending order by clicking 
on the corresponding column header.

6. To go to the location of use for a specific object, click on the displayed link.

Result
The cross-reference list for the selected object is displayed in the work area.

10.12.5.3 Structure of the cross-reference list

Views of the cross-reference list 
There are two views of the cross-reference list. The difference between the two views is in the 
objects displayed in the first column:

● Used by:
Display of the referenced objects. Here, you can see where the object is used.

● Used:
Display of the referencing objects. The users of the object are shown here.

The assigned tool tips provide additional information about each object.

Structure of the cross-reference list

Column Content/meaning
Object Name of the object that uses the lower-level objects or that is being 

used by the lower-level objects.
Numbers Number of uses
Location of use Each location of use, for example, an object or event
Property Function of the referenced objects, for example, tag for data record or 

process value
Connected to PLC tag with which the object is connected.
Type Type of object 
Path Path of object

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references. 
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Settings in the cross-reference list
You can make the following settings using the icons in the toolbar for the cross-reference list:

● Update cross-reference list
Updates the current cross-reference list.

● Making settings for the cross-reference list
Here, you specify whether all used, all unused, all defined or all undefined objects will be 
displayed. If the "Undefined objects" option is enabled, references to previously deleted 
objects are also displayed.

● Collapse entries
Reduces the entries in the current cross-reference list by closing the lower-level objects.

● Expand entries
Expands the entries in the current cross-reference list by opening the low-level objects.

Sorting in the cross-reference list
You can sort the entries in the "Object" column in ascending or descending order. Click on the 
column header to do this. 

10.12.5.4 Displaying cross-references in the Inspector window

Introduction
The Inspector window displays cross-reference information about a selected object in the "Info 
> Cross-references" tab. The Inspector window displays the cross-reference information in 
tabular format. 

Requirement
You have created a project.

Several objects have been created.
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Procedure   
1. Select an object in a screen or a tabular editor.

2. Select "Cross-reference information" in the shortcut menu. The cross-references are 
opened in the Inspector window.

Result
The instances where and the other objects by which the selected object is being used are 
displayed. 

The table below shows the additional information listed in the "About > Cross-reference" tab:

Column Meaning
Object Name of the object that uses the lower-level 

objects or that is being used by the lower-level 
objects.

Numbers Number of uses
Location of use Each location of use, for example an object or 

event
Property Function of the referenced objects, for example 

tag for data record or process value
Connected to PLC tag with which the object is connected.
Type Type of object
Path Path of object

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references.
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10.12.6 Managing languages

10.12.6.1 Languages in WinCC

User interface language and project languages
A distinction is drawn between two different language levels in WinCC:

● User interface language
During configuration, the text in the WinCC menus and dialogs is displayed in the user 
interface language. The user interface language also affects the labeling of operating 
elements, the parameters of the system functions, the online help, etc. 

● Project languages
Project languages are all languages in which a project will later be used. Project languages 
are used to create a project in multiple languages. 

The two language levels are completely independent of one another. For example, you can 
create English projects at any time using a German user interface and vice versa.

Project languages
The following languages are differentiated within the project languages:

● Reference language
The reference language is the language that you use to configure the project initially.
During configuration, you select one of the project languages as the reference language. 
You use the reference language as a template for translations. All of the texts for the project 
are first created in the reference language and then translated. While you are translating 
the texts, you can have them displayed simultaneously in the reference language.

● Editing language
You produce translations of the texts in the editing language. 
Once you have created your project in the reference language, you can translate the texts 
into the remaining project languages. Select a project language respectively as an edit 
language and edit the texts for the appropriate language variant. You can change the editing 
language at any time.

 

  Note

When switching the project languages, the assignment to the keys on the keyboard also 
changes. For some languages (for example, Spanish), the operating system does not 
allow you to switch to the corresponding keyboard assignment. In this case, the keyboard 
assignment is switched to English. 

 

● Runtime languages
Runtime languages are those project languages that are transferred to the HMI device. You 
decide which project languages to transfer to the HMI device depending on your project 
requirements. 
You must provide appropriate controls so that the operator can switch between languages 
in runtime. 
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See also
Language settings in the operating system (Page 5534)

Operating system settings for Asian languages (Page 5535)

Selecting the user interface language (Page 5536)

"Graphics" editor (Page 5547)

Languages in Runtime (Page 5551)

Example: Configuring a button for language switching (Page 5558)

10.12.6.2 Language settings in the operating system

Introduction
The configuration PC operating system settings influence WinCC language management in 
the following areas:  

● Selection of project languages

● Regional format of dates, times, currency, and numbers

● Displaying ASCII characters

Project language selection
A language is not available as a project language unless it is installed in the operating system. 

Regional format of dates, times, currency, and numbers
WinCC specifies a fixed date and time format in the Date - Time field for the selected project 
language and runtime language.

In order for dates, times, and numbers to be presented correctly in the selected editing 
language, this language must be set in the Regional Options in the Control Panel.   

Displaying ASCII characters
With text output fields, the display of ASCII characters as of 128 depends on the set language 
and the operating system being used.

If the same special characters are to be displayed on different PCs, the PCs must use the 
same operating system and regional settings.

See also
Languages in WinCC (Page 5531)

Operating system settings for Asian languages (Page 5535)
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10.12.6.3 Operating system settings for Asian languages

Settings on Western operating systems
If you want to enter Asian characters, you must activate the support for this language in the 
operating system.   

The Input Method Editor (IME) is available in Windows for configuring Asian texts. Without this 
editor, you can display Asian text but not edit it. For more information on the Input Method 
Editor, refer to the documentation for Windows. To enter Asian characters when configuring, 
switch to the Asian entry method in the "Input Method Editor".

Switch the operating system to the appropriate language to have language-specific project 
texts, such as alarm texts, displayed in the simulator in Asian characters.

Settings on Asian operating systems
If you are configuring on an Asian operating system, you must switch to the English default 
input language to enter ASCII characters, for example, for object names. As the English default 
input language is included in the basic installation of the operating system, you do not need 
to install an additional input locale.    

Enable language support
1. Open the system controller.

2. Select "Regional and Language Options".

3. On the "Languages" tab, activate the check box "Install files for East Asian languages".

4. Then click on "Details" under "Text Services and Input Languages". The dialog "Text 
Services and Input Languages" is opened.

5. On the "Settings" tab add the required default input language under the "Installed Services".

6. Select the language of the operating system in the "Language for non-Unicode programs" 
area in the "Advanced" tab.

See also
Languages in WinCC (Page 5531)

Language settings in the operating system (Page 5532)
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10.12.6.4 Setting project languages

Selecting the user interface language

Introduction
The user interface language is used for displaying menu entries, title bars, infotexts, dialog 
texts and other designations in the WinCC user interface. 

You can switch between the installed user interface languages during configuration. The 
labeling of the operating elements remains in the language you set when you added the object 
even if you change the user interface language. 

Procedure
1. Select "Options > Settings" in the menu.

The "Settings" dialog box is opened.

2. Select the desired user interface language under "General > General settings".

Result
WinCC will use the selected language as user interface language. 

See also
Enable project languages (Page 5536)

Selecting the reference language and editing language (Page 5537)

Languages in WinCC (Page 5531)

Enable project languages

Introduction
The project languages are set in the "Project languages" editor. You define which project 
language is to be the reference language and which the editing language. 
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Enable project languages
1. Click on the arrow to the left of "Languages & resources" in the project tree.

The lower-level elements will be displayed.

2. Double-click on "Project languages".
The possible project languages will be displayed in the working area.

3. Enable the relevant project languages.   
 

  Note
Copying multilingual objects

The copies of multilingual objects to a different project only include text objects in the 
project languages which are activated in the target project. Activate all project languages 
in the target project to include the corresponding text objects when transferring the copy.

 

Disabling project languages
1. Disable the languages which are not relevant for the project.   

 

 
 NOTICE

If you disable a project language, all text and graphic objects you have already created 
in this language will be deleted from the current project.

 

See also
Selecting the user interface language (Page 5534)

Selecting the reference language and editing language (Page 5537)

Selecting the reference language and editing language

Introduction
The project languages are set in the "Project languages" editor. You define which project 
language is to be the reference language and which the editing language. You can change 
the editing language at any time.

Requirements
The "Project languages" editor is open.

Several project languages have been activated.

Selecting the reference language and editing language
1. Click the arrow in the drop-down list in the "General > Editing language" section.    

2. Click on the required language in the drop-down list, for example, German.
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3. Click on the arrow in the drop-down list in the "General > Reference language" section.

4. Click on the required language in the drop-down list, for example, English.

The language selection is displayed in the list box.

Result
You have now selected the editing and reference languages.

If you change the editing language, all future text input will be stored in the new editing 
language.

 

See also
Selecting the user interface language (Page 5534)

Enable project languages (Page 5534)
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10.12.6.5 Creating one project in multiple languages

Working with multiple languages

Multilingual configuration in WinCC
You can configure your projects in multiple languages using WinCC. There are various grounds 
for creating a project in multiple languages:

● You would like to use a project in more than one country.
You create the project in multiple languages but when the HMI device is commissioned, 
only the language spoken by the operators at the respective site will be transferred to the 
HMI device.

● The operators of a system speak a range of different languages.
Example: An HMI device is used in China, but the service personnel understand only 
English.   

Translating project texts
With WinCC, you can enter project texts directly in several languages in various different 
editors, for example, in the "Project texts" editor. WinCC also allows you to export and import 
your configuration for translation purposes. This is particularly advantageous if you configure 
projects containing a large amount of text and want to have it translated.

Language management and translation in WinCC
The following editors are used to manage languages and translate texts in WinCC:  

Editor Short description
Project languages Selection of project languages, editing language and reference 

language.
Languages and fonts Management of runtime languages and fonts used on the HMI device.
Project texts Central management of configured texts in all project languages.
Graphics Graphic library for managing graphics and their language-specific 

versions.

See also
Project text basics (Page 5540)

Translating texts directly (Page 5541)

Translating texts using reference texts (Page 5543)

Exporting project texts (Page 5544)

Importing project texts (Page 5546)
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Project text basics

Texts in different languages in the project  
Texts that are output on display devices during processing are typically entered in the language 
in which the automation solution is programmed. Comments and the names of objects are also 
entered in this language.

If operators do not understand this language, they require a translation of all operator-relevant 
texts into a language they understand. You can therefore translate all the texts into any 
language. In this way, you can ensure that anyone who is subsequently confronted with the 
texts in the project sees the texts in his/her language of choice.

User texts and system texts   
In the interests of clarity, a distinction is drawn between user texts and system texts:

● User texts are texts created by the user.

● System texts are texts created automatically and which are a product of configuration in 
the project.

The project texts are managed in the project text editor. This can be found in the project tree 
under "Languages & Resources > Project texts".

Examples of multilingual project texts
You can, for example, manage the following types of text in more than one language:

● Display texts

● Alarm texts

● Comments in tables

● Labels of screen objects

● Text lists

Translating texts
There are two ways of translating texts.

● Translating texts directly
You can enter the translations for the individual project languages directly in the "Project 
texts" editor.

● Translating texts using reference texts
You can change the editing language for shorter texts. You can enter the new texts in the 
editing language while the texts of the reference language are displayed. 
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See also
Working with multiple languages (Page 5537)

Translating texts directly (Page 5541)

Translating texts using reference texts (Page 5543)

Exporting project texts (Page 5544)

Importing project texts (Page 5546)

Translating texts directly

Translating texts  
If you use several languages in your project, you can translate individual texts directly. As soon 
as you change the language of the software user interface, the translated texts are available 
in the selected language.

Requirements
● You are in the project view.

● A project is open.

● You have selected at least two further project languages.
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Procedure
Proceed as follows to translate individual texts:

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The elements below this are displayed.

2. Double-click on "Project texts".
A list with the texts in the project is displayed in the work area. There is a separate column 
for each project language.

3. To group identical texts and translate them simultaneously, click on the " " button in the 
toolbar.

4. To hide texts that do not have a translation, click on the  button in the toolbar.

5. Click on an empty column and enter the translation.

Result
You have translated individual texts in the "Project texts" editor. The texts will then be displayed 
in the runtime language.
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See also
Working with multiple languages (Page 5537)

Exporting project texts (Page 5544)

Project text basics (Page 5538)

Importing project texts (Page 5546)

Translating texts using reference texts

Introduction  
After changing the editing language, all texts are shown in input boxes in the new editing 
language. If there is not yet a translation available for this language, the input boxes are empty 
or filled with default values.

If you enter text again in an input field, this is saved in the current editing language. Following 
this, the texts exist in two project languages for this input field, in the previous editing language 
and in the current editing language. This makes it possible to create texts in several project 
languages.

You can display existing translations for an input box in other project languages. These serve 
as a comparison for text input in the current editing language and they are known as the 
reference language.

Requirement
There is at least one translation into a different project language for an input field.

Procedure
To display the translation of an input cell in a reference language, follow these steps:

1. Select "Tasks > Languages & resources" in the task card.

2. Select a reference language from the "Reference language" drop-down list.

Result
The reference language is preset. If you click in a text block, translations that already exist in 
other project languages are shown in the "Tasks > Reference text" task card.

See also
Working with multiple languages (Page 5537)

Exporting project texts (Page 5544)

Project text basics (Page 5538)

Importing project texts (Page 5546)
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Exporting project texts
Project texts are exported for translation. Texts are exported to Office Open XML files ending 
in ".xlsx". These files can be edited in Microsoft Excel, for example.

You can exchange the file with the translators and import it back to the project as soon as it 
has been translated.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Exporting project texts
To export individual project texts, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The child elements are displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Select the texts you want to export.
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4. Click on the  button. The "Export" dialog opens.

5. From the "Source language" drop-down list, select the language from which you wish to 
translate, for example Italian.

6. From the "Target language" drop-down list, select the language into which the texts are to 
be translated, for example, French.

7. Enter a file path and a file name for the export file in the "Export file" input field.

8. Click "Export".

Result
The texts selected in the "Project texts" editor are written to an xlsx file. The xlsx file will be 
stored in the specified folder. 
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You can alternatively select and export all project texts from categories. Select "User texts" or 
"System texts" in the "Export" dialog in line with the type of texts you wish to export. In this 
case, export can additionally be limited by categories.

 

 Note

Project texts in library objects cannot be exported.
 

See also
Working with multiple languages (Page 5537)

Translating texts using reference texts (Page 5541)

Translating texts directly (Page 5539)

Project text basics (Page 5538)

Importing project texts (Page 5546)

Importing project texts
Edit the xlsx file or send it to a translator. Import the texts once they have been translated. The 
foreign languages will be imported to the relevant object in the project.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Importing project texts 
To import a project text file, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The lower-level elements will be displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Click on the  button. The "Import" dialog opens.

4. Select the path and file name of the import file from the "Import file" field.

5. Activate the "Import source language" check box if you have made changes to the source 
language in the export file and would like to overwrite the entries in the project with the 
changes.

6. Click on "Import".

Result
You have imported the project texts.
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See also
Exporting project texts (Page 5542)

Working with multiple languages (Page 5537)

Project text basics (Page 5538)

Translating texts directly (Page 5539)

Translating texts using reference texts (Page 5541)

10.12.6.6 Using language-specific graphics

"Graphics" editor

Introduction
You use the "Graphics" editor to manage the configured graphic objects in different language 
versions. Multilingual projects sometimes also require language-specific versions of the 
graphics, for example, if

● the graphics contain text;

● cultural aspects play a role in the graphics.

Opening the "Graphics" editor
Double-click on "Languages and resources" in the project tree.    

Work area
The work area displays all configured graphic objects in a table. There is a separate column 
in the table for each project language. Each column in the table contains the versions of the 
graphics for one particular language.

In addition, you can specify a default graphic for each graphic to be displayed whenever a 
language-specific graphic for a project language does not exist.

Preview
The preview shows you how the graphics will look on various devices. 

See also
Storing an external image in the graphics library (Page 5549)

Storing an image in the graphics library (Page 5548)

Languages in WinCC (Page 5531)
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Storing an image in the graphics library

Introduction
You use the "Graphics" editor to import graphics you want to use in screens in the "Screens" 
editor. It also allows you to manage language-specific versions of graphics. A preview shows 
the graphic displays on various HMI devices.   

Requirement
● The language-dependent versions of a graphic are available.

● Multiple languages have been enabled in the "Project languages" editor.

● The "Graphics" editor is open.

Inserting graphics
1. Click "Add" in the "Graphics library" table. A dialog box opens.

2. Select the required graphic file.

3. Click "Open" in the dialog box.
The graphic will be imported to the project and displayed in all cells in this row in the 
"Graphics" editor. 

4. Click in the corresponding cell of a language for which a language-dependent version of 
this graphic exists.

5. Select  "Add graphic" from the shortcut menu. A dialog box opens.

6. Select the desired graphic file and click "Open."
The language-dependent version is inserted in the table in place of the reference language 
graphic. 

7. Then, in the "Default graphic" column, import a graphic to be displayed in runtime for those 
languages for which there is no language-specific graphic.

You can also drag&drop a graphic from Windows Explorer to the relevant position in the 
"Graphics library" table.

Displaying graphics in the HMI device preview
1. Click on a graphic in the table.

2. Select the required HMI device under "Properties > Graphics settings > Device preview" in 
the Inspector window.
The graphic will then be displayed as it will appear in runtime on the selected HMI device.

Result
The graphics added are available in the "Graphics" editor. The graphic assigned to the 
respective editing language will be displayed during editing. The default screen will be 
displayed in all editing languages for which no screen has been imported.
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The screens assigned to the respective runtime language are displayed during runtime. The 
default screen is displayed in all runtime languages for which a screen has not been imported.

 

 Note

If you disable a project language, all of the graphic objects you have already created in this 
language will be deleted from the current project. 

 

See also
"Graphics" editor (Page 5545)

Storing an external image in the graphics library

Introduction
To display graphics that have been created in an external graphics program in your screens, 
you will first have to store these graphics in the graphics browser of the WinCC project.      

Requirement
● Multiple languages have been enabled in the "Project languages" editor.

● The "Graphics" editor is open.

● There is a graphic in the "Graphics" editor.

Creating and adding a new graphic as an OLE object
1. Click "Add" in the "Graphics library" table. A dialog box opens.

2. Navigate to the folder in which the graphic is stored.

3. Click "Open" in the dialog box.
The graphic will be imported to the project and displayed in all cells in this row in the 
"Graphics" editor. 

4. Click in the corresponding cell of a language for which a language-dependent version of 
this graphic exists.

5. Select  "Insert object" from the shortcut menu. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

6. Select "Insert object > Create new" and an object type in the dialog.
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7. Click "OK." The associated graphic program is opened.

8. Close the graphics program once you have created the graphic.
The graphic will be stored in the graphic programming software standard format and added 
to the graphic browser.

Inserting created graphics in WinCC
1. Click in the corresponding cell of a language for which a language-dependent version of 

this graphic exists.

2. Select  "Insert object" from the shortcut menu. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

3. From the "Insert object" dialog box, select "Create from file."

4. Click the "Browse" button.

5. Navigate to the created graphic and select it.
 

  Note

To import graphics files, note the following size restrictions:

*.bmp, *.tif, *.emf, *.wmf  ≤4 MB

*.jpg, *.jpeg, *.ico, *.gif "*≤1 MB
 

Result
The OLE objects added are available in the "Graphics" editor. 

Versions of the graphics for the current editing language are displayed in the "Screens" editor. 
The default graphic is displayed in all editing languages for which no screen has been imported.

The graphic is displayed in runtime in the set runtime language. The default graphic is displayed 
in all runtime languages for which no graphic has been imported.

You can double-click OLE objects in your library to open them for editing in the corresponding 
graphic editor. 

See also
"Graphics" editor (Page 5545)
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10.12.6.7 Languages in runtime

Languages in Runtime

Using multiple runtime languages
You can decide which project languages are to be used in runtime on a particular HMI device. 
The number of runtime languages that can be available at one time on the HMI device depends 
on the device. To enable the operator to switch between languages during runtime, you must 
configure a corresponding operator control. 

When runtime starts, the project is displayed according to the most recent language setting. 
When runtime starts the first time, the language with the lowest number in the "Order for 
language setting" is displayed.

Setting runtime languages during configuration
In the "Languages and Fonts" editor you can specifiy: 

● The project languages to be available as runtime languages for the respective HMI device.

● The order in which the languages are to be switched.

See also
Methods for language switching (Page 5551)

Enabling the runtime language (Page 5552)

Setting the runtime language order for language switching (Page 5554)

Setting the default font for a runtime language (Page 5556)

Selecting the log language (Page 5557)

Languages in WinCC (Page 5531)

Methods for language switching

Introduction
You need to configure language switching if you want to have multiple runtime languages 
available on the HMI device. This is necessary to enable the operator to switch between the 
various Runtime languages. 
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Methods for language switching
You can configure the following methods for language switching:

● Direct language selection
Each language is set by means of a separate button. In this case, you create a button for 
each Runtime language.

● Language switching
The operator switches the languages using a button.

Regardless of the method used, the button names must be translated into each of the 
languages used. You can also configure an output field that displays the current language 
setting.

See also
Languages in Runtime (Page 5549)

Selecting the log language (Page 5557)

Enabling the runtime language (Page 5552)

Setting the runtime language order for language switching (Page 5554)

Setting the default font for a runtime language (Page 5556)

Enabling the runtime language

Introduction
The "Language & Font" editor shows all project languages available in the project. Here you 
select which project languages are to be available as runtime languages on the HMI device.  

Requirements
Multiple languages have been enabled in the "Project languages" editor.
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Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font".

3. Select the following languages:

– German

– Chinese

– French

Result
You have now set three runtime languages. A number is automatically assigned to each 
language in the "Order" column. The enabled runtime languages are transferred with the 
compiled project to the HMI device. 

If the number of languages selected exceeds the number that can be transferred to the HMI 
device, the table background changes color.
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See also
Languages in Runtime (Page 5549)

Selecting the log language (Page 5557)

Setting the runtime language order for language switching (Page 5554)

Methods for language switching (Page 5549)

Setting the runtime language order for language switching

Introduction
You specify the language order for runtime language switching. The first time runtime starts, 
the project is displayed in the language with the lowest number in the "Order" column.   

Requirements
● Multiple languages have been enabled in the "Project languages" editor.

● "Language & Font" is open in the editor and three runtime languages have been set in the 
following order:
1. German
2. Chinese
3. French
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Procedure
1. Select the runtime language "German".

2. Click the button. The runtime language "German" will move down a place. The number 
will automatically be changed to "2" in the "Order" column.

Result
You have changed the order of runtime languages. The first time runtime starts, the project 
will be displayed in the language with the smallest number, in other words Chinese. If the 
language is switched, this will happen in numerical order.

See also
Languages in Runtime (Page 5549)

Selecting the log language (Page 5557)

Enabling the runtime language (Page 5550)

Setting the default font for a runtime language (Page 5556)

Methods for language switching (Page 5549)
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Setting the default font for a runtime language

Introduction
You can specify the font used to display the texts for each runtime language on the HMI device 
in the "Language & Font" editor. The default font is used in all texts, such as dialog texts, for 
which you cannot define a specific font.   

WinCC offers only fonts supported by the HMI device.

Requirements
● Multiple languages have been enabled in the "Project languages" editor.

● Three runtime languages have been enabled in the "Language & Font" editor.
1. Chinese
2. German
3. French

Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font". The table shows the runtime languages and fonts set.

3. Click in the "French" row in the "Default font" column.

4. Select the font to be used by default if a font cannot be selected for a given text.

Result
The project texts for the runtime language "French" are displayed on the HMI device in the 
selected font.

These fonts are transferred to the HMI device during a transfer operation. 

The default font is also used for the representation of dialogs in the operating system of the 
HMI device. Select a smaller font as default if the full length of the dialog texts or headers is 
not displayed.

See also
Languages in Runtime (Page 5549)

Selecting the log language (Page 5557)

Setting the runtime language order for language switching (Page 5552)

Methods for language switching (Page 5549)
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Selecting the log language

Introduction
In the "Runtime settings > General" editor, select the language to be used for writing to logs 
in runtime.       

Requirements
● The languages used in your project are activated in the "Project languages" editor, for 

example "German" and "English" .

Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font".

3. Activate the runtime languages, for example, "German" and "English".

4. Specify the "order":

– 1 German

– 2 English

5. Click on "Runtime settings > General".

6. Select "German" for "Logs > Log language".

Result
After loading, the project will start in the runtime language "German". The logs are now written 
in German. During runtime, the operator switches the runtime language to English. The logs 
will still to be written in German.

See also
Languages in Runtime (Page 5549)

Setting the default font for a runtime language (Page 5554)

Setting the runtime language order for language switching (Page 5552)

Methods for language switching (Page 5549)

Enabling the runtime language (Page 5550)
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10.12.6.8 Example of multilingual configuration

Example: Configuring a button for language switching

Introduction
In this example, you configure a button that can be used to toggle between multiple runtime 
languages during runtime.

Requirements
● You have completed the "Configuring a button in multiple languages" example.

● The "Screen_1" screen is open.

● The button on the screen has been selected.

Procedure
1. In the Inspector window, select "Properties > Events > Press".

2. Click on "Add function" in the table.

3. Select the "SetLanguage" system function.

Result
You have assigned the button the function "SetLanguage". Pressing the button during runtime 
will switch the runtime language. The runtime languages are switched in the order specified 
by the number sequence in the "Languages and fonts" editor. 

See also
Example: Configuring a button in multiple languages (Page 5558)

Example: Configuring a button for language switching for each runtime language (Page 5559)

Languages in WinCC (Page 5531)

Example: Configuring a button in multiple languages

Introduction
In this example, you configure a "Sprache umschalten" button in German and "Switch 
language" button in English.
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Requirements
● The languages "German" and "English" have been enabled in the "Project languages" 

editor.

● German has been set as editing and reference language.

● You have created and opened the "Screen_1" screen.

● The Inspector window is open.

Procedure
1. Drag-and-drop a button from the "Tools" task card into the screen.

The button will be added to the screen.

2. In the Inspector window, open "Properties > Properties > General".

3. Enter the text ""Sprache umschalten" under "Text > off".

4. Press <Enter> to confirm. The button is named.

5. Open the "Tasks" task card.

6. Select "English" under "Languages & Resources > Editing language".

7. Enter the label "Switch Language" under "Properties > Properties > General > Text > Off" 
in the Inspector window.

Result
The button name is configured in German and English language. The button name 
corresponding with the current Runtime language is shown in Runtime. 

See also
Example: Configuring a button for language switching (Page 5556)

Example: Configuring a button for language switching for each runtime language (Page 5559)

Example: Configuring a button for language switching for each runtime language

Introduction
In this example, you configure a "Sprache umschalten" button in German and "Switch 
language" button in English.
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Requirements
● The following languages have been enabled in the "Project languages" editor

– German

– English

– Italian

● All languages have been set as runtime languages in the "Runtime settings > Language & 
Font" editor.

● You have created and opened the "Screen_1" screen.

● Three buttons have been created on the screen:

– Button_1 labelled "Deutsch"

– Button_2 labelled "English"

– Button_3 labelled "Italiano"

● The Inspector window is open.

Procedure
1. Select "Button_1".

2. In the Inspector window, select "Properties > Events > Press".

3. Click on <Add function> in the table.

4. Select the "SetLanguage" system function.

5. Click on the "Switch" field.

6. Click on the button.

7. Select "Runtime language". The field will be highlighted in red.

8. Select "German" from the drop-down list.

9. Repeat steps 1 - 8 for the other two buttons and select the corresponding runtime language.

Result
You have configured three buttons for switching language in runtime. Each button will switch 
to a different runtime language. For example, clicking on the "English" button during runtime 
will switch the runtime language to English.

See also
Example: Configuring a button for language switching (Page 5556)

Example: Configuring a button in multiple languages (Page 5556)
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10.12.7 Replacing devices

10.12.7.1 Basics

Introduction
You can use existing configurations for new devices and optimize these configurations with 
little manual effort.

All data configured by you is retained in the configuration data. This means you do not need 
to copy individual objects of one device and paste them to another. 

Principle  
The following applies when you replace devices:

● Only functions supported by the new device are available. Only configuration data 
supported by the new device are displayed.
This affects 

– recipes,

– objects available on the screens,

– available system functions,

– available communication logs, etc.

● The number of supported objects, such as screens or tags, may be limited on the new 
device. If the existing objects exceed the limitations on the new device, the objects are 
displayed in full. The objects are, however, highlighted in color in the individual editors. An 
error is generated when the project data is compiled.
Manual post processing is required when switching to a device with fewer features.
Example: Limited number of connections  
All connections will be highlighted in color as invalid if fewer connections are supported on 
the new device than have been configured. Delete any excess connections.

 

 Note

If you replace a Panel and select a PC Station as your new device, for example, WinCC 
Runtime Advanced will automatically be moved below the PC Station in the project tree.
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See also
Example: Replacing devices (Page 5574)

Screen adjustment options (Page 5567)

Key assignment when replacing devices (Page 5563)

Device-specific functions (Page 5562)

Engineering system (Page 5727)

Basic Panel (Page 5729)

Panel (Page 5732)

Mobile Panel (Page 5736)

Multi Panel (Page 5740)

Comfort Panel (Page 5744)

WinCC Runtime Advanced (Page 5749)

10.12.7.2 Device-specific functions

Device-specific functions

Functions dependent on the device
Functions dependent on the device are implemented as follows:

● Colors
The color is changed automatically when you switch from a device with full color display to 
one with a smaller color range. 
If you change the color manually and then change back again to a device with a larger 
range of colors, the reduced range of colors will be retained.

● Fonts
Any configured font not available on a device will be replaced by a similar one or by the 
configured default font. The default font depends on the device selected. 

● Character sets with different font sizes
Avoid using too many different font sizes when configuring the following devices:

– OP 73

– OP 77A

– TP 177A

A character set is downloaded to the device for each font size. Check the Inspector window 
during compilation to see how much of the device memory is being used by the character 
sets.
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● Font size
Use small Windows fonts to display the text on devices. If you use large Windows fonts, 
then, depending on the size of the display, the text will not be displayed in full.
Using font sizes of 28 pixels or more for the OP 77A and TP 177A devices will affect device 
performance. 
The character scope is much greater for Asian languages. The use of different font sizes 
therefore has serious implications on the memory requirements of all devices.
Use the same font type for all large characters throughout the project to ensure effective 
and efficient configuration.

● Screens and screen objects
If the new device supports a different resolution than the previous device when you replace 
a device, there are several ways to adjust the screens.
Adjust the size of the screens to the new device in the menu under "Options > Settings > 
Visualization > Fit to size screen".

See also
Example: Replacing devices (Page 5574)

Basics (Page 5559)

Key assignment when replacing devices

Introduction
The devices available each have different function keys. The functions configured for these 
keys will be mapped to the available function keys of the new device if the device is replaced.

Function key mapping
The function keys to the left and right of the display are mapped from top to bottom to the new 
device. If the new device has fewer keys, the keys it does not have are not mapped. The 
function keys below the display are mapped from left to right to the new device. If the new 
device has fewer keys, the keys it does not have are not mapped.       

Example: Exchange MP 377 with KP700 Comfort 
You have configured a function on key S3 on the MP 377. This function is triggered by F5 if 
the panel is replaced with an KP700 Comfort.

If you use the S8 key on an MP 377, this function is no longer available when the panel is 
replaced with a KP700 Comfort.
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Mapping K-keys
K-keys are only mapped to the same K-keys in the new device, e.g. K5 to K5.     

If the new device has no K keys, configurations for the K keys are lost.
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If you replace a KP700 with an OP 277,for example, the F1 - F14 keys are retained. The 
configuration of the K keys is lost, because the KP700 has no K keys.

 

Mapping of control keys and cursor keys
The following keys are mapped only to the same keys of the new device:

● HELP

● ESC

● ACK

● ENTER

● PAGE UP

● PAGE DOWN

● CURSOR UP

● CURSOR DOWN

Exception
"HELP" is triggered by "SHIFT+ ESC" on OP 73.

See also
Key assignment when replacing devices (Page 5565)

Basics (Page 5559)

Screen adjustment options (Page 5567)

Key assignment when replacing devices

Introduction
The devices available each have different function keys. The functions configured for these 
keys will be mapped to the available function keys of the new device if the device is replaced.

Function key mapping
The function keys below the display are mapped from left to right to the new device. If the new 
device has fewer keys, the keys it does not have are not mapped.
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Example: Replacing a KTP1000 Basic with a KTP600 Basic
You have configured a function for F2 in KTP1000 Basic. This function is triggered by F2 
following replacement with a KTP600 Basic.

If you have used F7 in a KTP1000 Basic, this function will no longer be available if the panel 
is replaced with a KTP600 Basic.

Mapping of control keys and cursor keys
The following keys are mapped only to the same keys of the new device:

● HELP

● ESC

● ACK
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● ENTER

● PAGE UP

● PAGE DOWN

● CURSOR UP

● CURSOR DOWN

 

See also
Key assignment when replacing devices (Page 5561)

10.12.7.3 Adjust screens to the new device

Screen adjustment options

Introduction
Select fit to size for screens before you replace a device. Fit to size is particularly important 
when switching devices with different display resolutions.

Object adjustment to content can be prevented for objects such as graphic views or text fields. 
 

 Note

The objects are distorted if you replace a device with a landscape format display with a device 
with a portrait format display. The difference in display format can, for example, result in object 
labels being cut off and content not being fitted to the object. You must therefore adjust the 
screens to the new device once you have replaced devices.
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Screen adjustment when replacing devices
Adjust the size of the screens to the new device in the menu under "Options > Settings > 
Visualization > Fit to size screen".

Select one of the following settings.

None (default)
The screens are not scaled. The objects in the screen retain their position and size. Use this 
setting as first test for checking of a possible exchange result because there are no rounding 
losses during forth and back exchange. 

This option may result in objects being outside the configurable area if the display of the new 
device is smaller than the old one. 

Adjusting the width and height to the new device
The position and object size are adjusted to the new display size. Adjustment takes place along 
the x-axis and the y-axis. Graphics and font size are adjusted accordingly. 

Fit screen to window height
The aspect ratio is maintained and the screens are adjusted to the height of the new device.

Use this option when you are replacing a device with display format 4:3, for example, with a 
device with widescreen. 

Fit screen to window width
The aspect ratio is maintained and the screens are adjusted to the width of the new device.

Use this option when you are replacing a device with widescreen, for example, with a device 
with display format 4:3. 
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Free scale factor
You select a free scale factor for screen adjustment. You can specify a factor for the x-axis 
and the y-axis. 

Using a free scale factor of < 1 may distort the objects. Object labels may, for example, be cut 
off and the content may not be fitted to the object.

You must therefore adjust the screens to the new device once you have replaced devices. 

 
 

 Note

The aspect ratio is not adjusted for objects with a fixed aspect ratio, for example, gauge, 
circle. The objects are displayed on the new device with the same aspect ratio as prior to the 
replacement of the device. 

 

See also
Example: Adjusting screens (Page 5573)

Specifying the position of screen objects (Page 5572)

Fit objects to contents (Page 5569)

Basics (Page 5559)

Key assignment when replacing devices (Page 5561)

Fit objects to contents

Introduction
For some objects, you can specify fit to respective content in the Inspector window, for example:

● Text field: fit to text content

● I/O field: fit to text content

● Symbolic I/O field: fit to text content or to text list

● Graphic view: fit to included graphic

Fit to size for text and graphic objects
Disable automatic fit to size of the individual objects in the menu under "Options > Settings > 
Visualization > Resize screen and screen objects > Fit to content". This results in scaling of 
the objects as specified under "Options > Settings > Visualization > Resize screen and screen 
objects".

Select the objects which are not automatically fitted to size.
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● If "Disable 'fit to size' for text objects" is activated, automatic fit to size is ignored in the text 
object properties.
If you have activated "Fit screen to window height", the text field along with the other objects 
is scaled in accordance with the height of the new device.

● If "Disable 'fit to size' for graphic objects" is activated, automatic fit to size is ignored in the 
graphic object properties.
If you have activated "Fit screen to window width", the graphics view along with the other 
objects is scaled in accordance with the width of the new device.

 

  Note

The settings have no effect on screen objects whose size cannot be changed, such as 
alarm indicators or screen objects with a fixed aspect ratio. 

 

"Disable 'fit to size' for text objects" and "Disable 'fit to size' for graphic objects" have no effect 
if:

- You have activated "Resize screen and screen objects > None".

- You have activated "Fit screen to window width and height" and the new device has the same 
resolution as the current device.

- You have activated "Fit screen to window height" and the new device has the same resolution 
as the current device.

- You have activated "Fit screen to window width" and the new device has the same resolution 
as the current device. 

Example
The figure below shows the effects of automatic sizing using a graphic object with two buttons 
aligned as an example:
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① Initial situation: 
● Two buttons are aligned on a graphic object.
● The option "Fit object size to graphic" or "Adjust object size to graphic" is activated in the 

object properties of the graphic object under "Display > Sizing".
② Option 1: The original properties of the graphic object are to be maintained after switching the 

HMI device.
● Deactivate the option "Disable 'fit to size' for graphical objects" in the settings under "Size 

adaptation of objects".
Effect: The graphic object retains its original size after switching the HMI device. The alignment 
to the buttons is lost. 

③ Option 2: The graphic object is to be placed relative to the new screen resolution after switching 
the HMI device.
● Activate the option "Disable 'fit to size' for graphical objects" in the settings under "Size 

adaptation of objects".
The option "Fit graphic to object size" is activated automatically in the object properties of the 
graphic object. The two buttons are properly aligned on the graphic object even after switching 
the HMI device. 

 

See also
Specifying the position of screen objects (Page 5572)

Screen adjustment options (Page 5565)

Example: Adjusting screens (Page 5573)
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Specifying the position of screen objects

Introduction
There are various ways to adjust the position of screen objects to the new device.

Select position
Adjust the position of the screen objects to the new device in the menu under "Options > 
Settings > Visualization > Fit to size screen > Select position".

Example
The following option aligns the objects with the top left edge.

The following object centers the objects in the middle of the screen.

See also
Screen adjustment options (Page 5565)

Fit objects to contents (Page 5567)

Example: Adjusting screens (Page 5573)

10.12.7.4 Example: Replacing devices

Example: Procedures overview

Introduction
In the following example you replace a TP177 B 6'' PN/DP with a TP700 Comfort.
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Procedures overview
The procedure when replacing a device is as follows:

1. Adjust screens to the new device

2. Replacing devices

See also
Example: Adjusting screens (Page 5573)

Example: Replacing devices (Page 5574)

Example: Adjusting screens

Introduction
Adapt the screen before you replace a device. Screen adaptation is required as the display 
formats are different.

The TP 177B format is 320 x 240 pixels while the format of the TP700 Comfort is 800 x 480 
pixels. 

Requirements
● A project is open.

● The TP 177B 6'' PN/DP device is used in the project.

Adjusting screens
1. Open the "Options > Settings" menu.

2. Click on "Visualization > Fit screen to size".

3. Select "Fit screen to window height".
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4. Select "Disable fit to size for text objects".

5. Select "Disable fit to size for graphical objects".

Result
You have carried out screen adjustment in preparation for replacing devices. 

See also
Example: Replacing devices (Page 5574)

Screen adjustment options (Page 5565)

Specifying the position of screen objects (Page 5570)

Fit objects to contents (Page 5567)

Example: Procedures overview (Page 5570)

Example: Replacing devices

Introduction
The following example shows you how to replace a device. 

Requirements
● A project has been created and opened.

● The TP 177B 6'' PN/DP device is used in the project.

Procedure       
1. Double-click on "Devices & Networks" in the project navigation. The editor opens.

2. Click on the "TP 177B" device.

3. Select "Change Device/Version" in the device shortcut menu. A dialog opens.

4. Select the TP700 Comfort device.
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5. Select the matching image for the HMI device version that suits your configuration under 
"Version".
When you change the image, the new image is automatically transferred to the target 
system with the next download. All runtime files are deleted during this step. 
Details of hardware differences can be found in the "Compatibility information".

6. Click "OK". Device replacement is started.

Result
You have replaced the TP 177B device used in the project. You now use the TP700 Comfort 
device. 
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See also
Example: Adjusting screens (Page 5571)

Device-specific functions (Page 5560)

Basics (Page 5559)

Example: Procedures overview (Page 5570)

10.12.8 Copying between devices and editors

10.12.8.1 Basics

Basics

Copying and pasting within an HMI device   
You can copy and paste objects, such as display objects, within an HMI device. If the object 
is already created in the editor, when the object name is inserted a number is automatically 
attached, in accordance with the following principle:

● "<Object_name>_1" is renamed to "<Object_name>_2".

● "<Object_name>_2" is renamed to "<Object_name>_3".

Copying and pasting between HMI devices
You can also copy and paste between HMI devices. If an object with the same name already 
exists, you have the following options:
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 Note
Exception to this basic rule

Copying and pasting of an alarm class that has been generated from project-wide alarm class 
is handled differently than with this basic rule. When the copied alarm class already exists in 
the target HMI device within the same project, the "Paste" command is not performed.

 

Copying user-defined folders  
You can create user-defined folders for editors, for example, for HMI tags, screens, etc.

You can copy user-defined folders and paste them into another HMI device. The objects 
contained in a user-defined folder may exceed the limitations applying to the other HMI device, 
such as the number of supported screens. After they have been pasted, all the objects are 
displayed. An error is displayed when the project data is compiled.

System folders cannot be copied. 

See also
Unsupported objects and functionalities (Page 5578)

Copy and paste options (Page 5577)

Copy and paste options

Copy and paste options  
Copy and pasting individual objects simplifies configuration. 

WinCC offers a number of options for copying and pasting objects.

Shortcut menu
To copy and paste objects using the shortcut menu, proceed as follows:

1. Select an object, for example a button.

2. Select "Copy" in the shortcut menu.

3. Move the mouse cursor to the place on the screen where you want to paste the button.

4. Select "Paste" in the shortcut menu.
The button will be pasted together with all properties already defined.
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Drag&drop
To drag-and-drop objects, proceed as follows: 

1. Click on "Screens > Start" in the project tree of a device.

2. Drag-and-drop the "Start" screen into the "Screens" folder of another device.

3. A dialog will appear if the second device already contains a screen with the same name.

4. Choose whether to replace or rename the existing screen. 

See also
Basics (Page 5574)

Unsupported objects and functionalities

Introduction 
When an object is copied, all its properties and settings are transferred to the target HMI device.

Unsupported objects   
Objects that are not supported in the target HMI device cannot be pasted.

 

 Note

When you copy a screen containing objects which are not supported by the destination HMI 
device, the objects remain in the background. When you copy the screen again and the new 
device supports the objects, they are displayed again.

 

Invalid objects
The following objects become invalid once they have been pasted into the target HMI device:

● Referenced objects that do not exist in the target HMI device.

● Objects with settings that are not supported in the target HMI device.

● System functions that were configured for objects and that are not supported in the target 
HMI device.

Invalid objects are highlighted by a color coding. Select a supported object or create a new 
one. If you retain an invalid object, an error will be displayed when the project data is compiled.

Colors and fonts     
Colors and fonts are supported to varying degrees by HMI devices. When unsupported colors 
and fonts are pasted, they are replaced by supported colors and fonts. When you paste the 
same object back into the source HMI device, the original settings become active again. 
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See also
Basics (Page 5574)

10.12.8.2 Copy and paste

Copying screens

Introduction   
You copy one or more screens from the "Screens" folder and paste them into the "Screens" 
folder of another device.

Type and size of the displays     
In the case of HMI devices with keys, the available keys are displayed automatically in the 
screen. When a screen is copied between HMI devices, the keys are either displayed or hidden; 
functions configured for function keys are not transferred.

If there is less space for the screen in the target HMI device than in the source HMI device, 
you can adjust the size of and the spacing between existing objects. 

Automatic fit to size for objects
1. Select "Options > Settings > Visualization > Resize screen and screen objects" in the menu.

2. Activate, for example, "Fit screen to window width and height".

See also
Screen adjustment options (Page 5565)

Fit objects to contents (Page 5567)

Specifying the position of screen objects (Page 5570)

Copying recipes within an HMI device (Page 5579)

Copying objects with linked objects (Page 5580)

Linked objects copied automatically (Page 5581)

Linked objects copied automatically (Page 5581)

Drag & drop from the details view (Page 5582)

Copying recipes within an HMI device

"Recipes" Editor
You can copy recipes, recipe elements and recipe data records within each table. You copy 
a recipe element to another recipe. 
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Only WinCC Runtime Professional: You can copy a recipe view element to another recipe 
view. If a recipe view element of the same name already exists, a conflict dialog is displayed. 
You can select whether to replace or rename the recipe element. You can copy recipe elements 
to the first empty row of the "Recipe views" editor, "Elements" tab. 

You can copy a recipe data record to another recipe, if the other recipe contains the same 
number of recipe elements. If the data types differ, the value will be copied to the target data 
record but it is assigned an error flag.

"Tags" editor
You can drag-and-drop a tag to a recipe element in the "Tag" column. The tag is linked to the 
recipe element. If a tag is already linked, an error message will be generated.

"Screens" editor
If you drag-and-drop a recipe to a screen, a new recipe display will be created and linked to 
the recipe. 

See also
Copying screens (Page 5577)

Copying objects with linked objects

Introduction
An object is linked to another object in the following situations, for example:

● You specify a tag for an alarm as a trigger tag.
The alarm is the object. The tag is the linked object.

● You specify a connection for an external tag.
The tag is the object. The connection is the linked object.

The object is always fully inserted during copying and pasting. Whether or not the linked object 
is pasted depends on the command used to insert it.

Simple pasting  
The linked object is not copied. The linked object is transferred and handled as follows in the 
target HMI device:

● If an object with the same name exists, the existing object with its settings is used.

● If no object with the same name exists, the name of the object will be displayed. The object 
becomes invalid.

For some objects, linked objects are pasted automatically during simple pasting.
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Extended pasting
Select the "Extended paste" command in the shortcut menu to paste the linked objects as well. 
If objects of the same name exist in the target HMI device, you need to decide whether or not 
to overwrite each of these objects. 

See also
Copying screens (Page 5577)

Linked objects copied automatically

Copying linked objects   
The following table shows the objects for which linked objects are pasted automatically in 
simple pasting.

Object Linked object
Screen Template
Symbolic I/O field Text list
Graphic I/O field Graphics list
Graphic view Graphic
Tag Alarm

Cycle
Recipe element Text list
Scheduler Triggers

See also
Copying screens (Page 5577)

Linked objects copied automatically

Copying linked objects   
The following table shows the objects for which linked objects are pasted automatically in 
simple pasting.

Object Linked object
Screen Cycle

Template
Symbolic I/O field Text list
Graphic I/O field Graphics list
Graphic view Graphic
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Object Linked object
Tag Alarm

Logging tag
Cycle

Log Logging tag
Logging tag Log type
Recipe element Text list
Scheduler Triggers

See also
Copying screens (Page 5577)

Drag & drop from the details view

Introduction
You can improve configuration efficiency with just a few simple measures. Below are a few 
examples of efficient configuration.

Pasting objects to a screen from the details view
You can drag objects in the details view from various different editors to other editors. 

Pasting a symbolic I/O field
1. Open a screen.

2. Click on the "Text and graphics lists" editor in the project tree. All existing text and graphics 
lists will be shown in the details view.

3. Click on a text list, for example, "Textlist1" in the Details view.

4. Drag-and-drop a text list from the Details view to a screen. A symbolic I/O field has been 
created and connected to the text list "Textlist1".

Pasting a graphic I/O field
1. Open a screen.

2. Click on the "Text and graphics lists" editor in the project tree. All existing text and graphics 
lists will be shown in the details view.

3. Click on a graphics list in the Details view, for example "Graficlist1".

4. Drag-and-drop a graphics list from the Details view to a screen. A graphic I/O field has been 
created and connected to the graphics list  "Graficlist1".
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Pasting an I/O field
1. Open a screen.

2. Click on the "HMI tags" editor in the project tree. All existing HMI tags will be shown in the 
Details view.

3. Click on an HMI tag in the Details view, for example "Tag1".

4. Drag-and-drop the HMI tag from the Details view to a screen. An I/O field has been created 
and connected to the HMI tag "Tag1".

 

See also
Copying screens (Page 5577)

10.12.8.3 Copying between different RT and ES versions

Introduction
You can copy and paste project data such as screens, objects or tags between projects with 
different WinCC versions. 

All configurations that are supported in the target version are retained when you copy data 
between projects of different WinCC versions. Configurations that are not supported by the 
target version are marked as invalid with a color code.

Copy of control between HMI devices from different device versions
WinCC supports all configurations of a previous WinCC version. 

The following applies when copying within different ES versions:

● All the configurations that are also supported in the respective RT version are retained. 

● Default settings are defined for configurations that are only supported in the WinCC version 
of the target project.
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● Configurations that are not supported by the respective RT version are marked as invalid 
with a color code or they are not displayed. 
All properties and settings originally defined in the source HMI device are reactivated when 
you copy the object back to the source HMI device unchanged.

● The HMI device must be valid for the current Runtime version.

 

Copying between different ES versions
Open a second instance of the TIA Portal to copy between two TIA projects. You can only 
copy between projects that have the same ES version. The ES version of a project is indicated 
by the file extension *.ap<version_number>.
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10.12.9 Using WinCC version compatibility

10.12.9.1 Basics on version compatibility

Introduction
Edit existing projects as follows with WinCC: 

● You edit, compile and download existing projects with the range of functions of the previous 
version of WinCC. You can continue to edit these projects afterwards with the previous 
version of WinCC. 

● You upgrade existing projects and use the functions of the current WinCC version.
 

  Note
WinCC functions

While editing a project of a previous WinCC version, you can only access the functions 
and HMI devices of this previous WinCC version.

 

Versions in WinCC
In WinCC, you work with different version types: 

● WinCC version
The WinCC version installed on the configuration PC, for example, WinCC V12.

● Project version
Projects are created using the WinCC version that is installed on the configuration PC. 
While you are editing a WinCC project from a previous version in the current WinCC version, 
the version ID is displayed behind the project name in the project tree. 

● Runtime version
You can configure HMI devices with different runtime versions in WinCC. You specify the 
runtime version once for an HMI device. The device version must match the Runtime 
version.

● Device versions
Depending on the used HMI device, the image is a combination of the operating system 
and / or runtime software. For each HMI device, WinCC provides various images which can 
be loaded onto the HMI device, if necessary, according to the configuration. The device 
version corresponds to a specific image. The device version must match the configuration.
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Compatibility of WinCC versions, Runtime versions and device versions
The figure below shows the interaction of versions in the TIA Portal:

Creating projects 
After you create a new project in WinCC, open and edit it in the WinCC version in which you 
created it. 

Saving
To save a project of a predecessor WinCC version in this version again, save it in the usual 
way. If you manually upgrade the project to your WinCC version, please note that you will no 
longer be able to open the project in the previous WinCC version.

To save a project of the previous WinCC version in the current version, upgrade the project to 
your WinCC version. You can then no longer edit the project with a previous version of WinCC. 

Compiling, simulating and loading 
If you are using a project of a previous WinCC version, you can use your current version to 
generate Runtime data for this previous version. This also allows you to load HMI devices that 
are no longer compatible with your WinCC version. 

Copying within projects with different WinCC versions
If objects and configurations are also available in the target version, copy these as required 
via the clipboard or using drag-and-drop. 
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Opening, editing and saving projects of a previous WinCC version
You can open and edit projects of previous WinCC versions as required. In doing so, you only 
utilize the functions of the previous WinCC version. Once you have completed editing, you can 
once again save and edit the project in the previous WinCC version.

Compiling, downloading and simulating projects of a previous WinCC version
You can compile, download and simulate projects of previous WinCC versions as required. 
Your current WinCC version will provide the Runtimes and device versions for the 
corresponding WinCC version.

10.12.9.2 Editing projects of a previous WinCC version

Introduction
WinCC provides the option of editing projects of a previous WinCC version. While editing a 
project of a previous WinCC version, you can only access the functions of this version. In order 
to use the functions of your current WinCC version for this project, upgrade the project to your 
WinCC version.

 

 Note

If you upgrade a project to your WinCC version, please note that you will no longer be able 
to open and edit the project in the previous WinCC version.

 

Requirement
● A project of a previous WinCC version has been created.

● The current WinCC version is installed on the configuration PC.

Procedure
Proceed as follows to edit a project of a previous WinCC version:

1. Open the project.

2. Edit the project using the functions of the previous WinCC version.

3. Save the project.

4. Compile the project.

5. Download and simulate the project.

6. You can open the project in the previous WinCC version for further editing, if required.
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Result
The modified project data can be edited further on a different configuration PC with the previous 
WinCC version for further processing. The Runtime project was generated and downloaded 
in the corresponding Runtime version.

10.12.9.3 Upgrading projects

Introduction
If the project version is older than the WinCC version, the version ID is displayed in the project 
tree. Your WinCC version also contains the previous version that you can use to edit projects 
as required. In order to use the functions and options of your WinCC version in a project, 
upgrade the project to your WinCC version. 

 

 Note
WinCC version compatibility

If you upgrade a project to your WinCC version, please note that you will no longer be able 
to edit it with the previous WinCC version.

 

Requirements
● The project version is a predecessor of your WinCC version.

● You have write access to your project drive.

● The project drive provides sufficient storage capacity for another project of this size.

Procedure
Proceed as follows to upgrade a project to your WinCC version:

1. Select the project in the project tree.

2. Select the "Upgrade project" command from the shortcut menu of the project.
A dialog opens. 

3. Click "Confirm".
The project closes and the progress bar is displayed.

A message is output when the project has been upgraded.

Result
● The project has been saved on the project drive in the previous WinCC version and with 

the corresponding file extension.

● The project is displayed on the project drive in the current WinCC version and with the 
corresponding file extension.

● The project is displayed without a WinCC version ID in the project tree.
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10.12.9.4 Changing between device versions

Selection of the device version
When you configure a new HMI device, WinCC automatically selects the latest version of the 
device.     

If you want to use a device version other than the one set in WinCC, transfer an image to the 
HMI device. WinCC provides the images required for the supported HMI devices.

Information on the device versions used in WinCC is available in the FAQs on the Internet, 
entry ID 21742389. 

 

 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. For this reason, you 
should save existing Runtime data before changing the device version.

 

HMI device configuration
The following figure shows the software components of an HMI device:
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10.12.9.5 Changing the device version

Introduction
Depending on the required Runtime version, select the suitable device version for your 
configuration.

 

 Note
Selection of device versions

The selection of available devices versions depends on the version of the project.
 

Requirements
● A project has been created and opened.

● The project contains an HMI device.

Procedure
To change the device version, follow these steps:

1. Double-click on "Devices & Networks" in the project tree.
The editor opens.

2. Select the required HMI device from the device view.

3. Select "Change Device/Version" in the device shortcut menu of the HMI device.
A dialog opens.

4. Select the required HMI device.

5. Select the required device version under "Version".

6. Confirm your selection with "OK".

Result
You have changed the device version in the WinCC project.

 

 NOTICE

Changing the device version deletes all data on the HMI device.

All data is deleted from the HMI device when you change the device version and compile/
download the project. You should therefore backup your Runtime data prior to the download.
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10.12.10 Viewing memory card data

10.12.10.
1

Basics

Introduction
WinCC provides you with the possibility of viewing data stored on your memory card. The 
function supports the use of memory cards of the HMI device and of the CPU. 

You have the following options:

Viewing a backup (Page 5591)

Renaming and deleting backups (Page 5593)

Viewing HMI device images (Page 5594)

Deleting HMI device images (Page 5595)

Creating HMI device images on memory card (Page 5596)

See also
Viewing a backup (Page 5591)

Renaming and deleting backups (Page 5593)

Viewing HMI device images (Page 5594)

Deleting HMI device images (Page 5595)

Creating HMI device images on memory card (Page 5596)

10.12.10.
2

Working with backups

Viewing a backup

Introduction
The backup of a Basic Panel that is stored on a memory card can also be viewed in the TIA 
Portal.     

Requirements
● WinCC is installed.

● A memory card with a backup is available.

● The card reader is connected to the configuration PC.

● The project view is open.
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Backup on the memory card in the card reader
1. Insert the memory card into the card reader.

2. Open "SIMATIC Card Reader" in the project navigation.

3. Select the card reader drive.
The "Online Card Data" folder is displayed.

4. Open the "Online Card Data" folder

5. Click the backup to open the shortcut menu.

6. Select "Properties".

Backup on the memory card of the PLC
Proceed as follows if the backup is stored on the memory card of the PLC:

1. Connect the PLC with the configuration PC.

2. Click on the PLC in the project navigation.

3. Select "Connect online" from the shortcut menu.
A connection to the PLC is established. 
Once the PLC is connected, the "Online Card Data" folder is displayed.

4. Open the "Online Card Data" folder.
 

  Note
Accessing a password-protected PLC

When you attempt to access a PLC that is protected by a password, you will be prompted 
to enter the password.

You need at least read access rights in order to view the data that is stored on the memory 
card.

 

5. Click the backup to open the shortcut menu.

6. Select "Properties".

Result
The backup properties are displayed in a separate dialog.
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See also
Renaming and deleting backups (Page 5593)

Basics (Page 5589)

Renaming and deleting backups

Introduction
You may rename and delete backups from a memory card in the project navigation of the TIA 
Portal.         

Requirements
● WinCC is installed.

● The card reader is connected to the configuration PC.
The PLC is connected online with the configuration PC.

● A memory card with a backup is available.

● The project view is open.

● The backup is displayed in the project navigation.
 

  Note
Accessing a password-protected PLC

When you attempt to access a PLC that is protected by a password, you will be prompted 
to enter the password.

You need write access rights to rename or delete memory card data.
 

Procedure
1. Click on the backup in the project navigation.

2. Open the shortcut menu.

3. Select "Rename" to rename the file.

4. Enter a new name.

5. Select "Delete" to delete the file.

Result
The backup file is now renamed or deleted. 
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See also
Viewing a backup (Page 5589)

Basics (Page 5589)

10.12.10.
3

Working with HMI device images

Viewing HMI device images

Introduction
The HMI device image of a Comfort Panel that is stored on a memory card can be viewed in 
the TIA Portal.

Requirements
● WinCC is installed.

● The card reader is connected to the configuration PC.

● A memory card with the HMI device image is available.

● The project view is open.

Procedure 
1. Insert the memory card into the card reader.

2. Open "SIMATIC Card Reader" in the project navigation.

3. Select the card reader drive.
The "Online Card Data" dialog is displayed.

4. Open the "Online Card Data" folder.
The available images of the HMI device are displayed in additional folders.

5. Click the required HMI device image.

6. Select "Properties" in the shortcut menu.
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Result
The properties of the HMI device image are displayed in a separate dialog.

See also
Deleting HMI device images (Page 5595)

Creating HMI device images on memory card (Page 5596)

Basics (Page 5589)

Deleting HMI device images

Introduction
You may delete the HMI device image of a Comfort Panel from a memory card in the project 
navigation of the TIA Portal.    
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Requirements
● WinCC is installed.

● The card reader is connected to the configuration PC.

● A memory card with an HMI device image is available.

● The project view is open.

● The HMI device image is displayed in the project navigation.

Procedure
1. Click the HMI device image in the project navigation.

2. Open the shortcut menu.

3. Select "Delete" to delete the file.

Result
The HMI device image is deleted. 

See also
Viewing HMI device images (Page 5592)

Basics (Page 5589)

Creating HMI device images on memory card

Introduction
You may edit the HMI device image of a Comfort Panel without connecting the Comfort Panel 
to the configuration PC.

Simply create the HMI device image on an external memory card or USB stick and then transfer 
it from there to the Comfort Panel. 

Requirements
● WinCC is installed.

● The card reader is connected to the configuration PC.

● The project view is open.

Procedure 
1. Insert the memory card into the card reader.

2. Click on the memory card in the project navigation.

3. Open the shortcut menu.
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4. Select "Create HMI OS image on memory card".
A dialog opens.
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5. Select an HMI device image.

6. Select the settings for the restoration.

– Activate "Retain installed settings of the Control Panel"
The settings you have made on the Comfort Panel are retained. 

– Activate "Retain installed licenses":
The licenses on the Panel are retained.

– Activate "Lock settings on the Panel"
You can no longer change the selected settings for "Retain installed settings of the 
Control Panel" and "Retain installed licenses" on the Comfort Panel.

Result
You have created an HMI device images on memory card. You may use a USB stick instead 
of a memory card. 

See also
Viewing HMI device images (Page 5592)

Basics (Page 5589)
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10.13 Compiling and loading

10.13.1 Compiling and loading projects

10.13.1.1 Overview of compiling and loading projects

Overview     
The project is compiled in the background even as you are configuring it in WinCC. This 
reduces the time for final compilation. When you start compilation, you create a file that can 
be run on the corresponding HMI device. 

If an error occurs during compilation, WinCC provides support in locating and correcting it.

Once you have corrected any problems, you download the compiled project to the HMI devices 
on which the project is to run. If the configuration PC is not connected to the HMI device, save 
the compiled project on a data medium of your choice. The compiled project is then transferred 
from a PC connected to the HMI device to the HMI device. 

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device.

Project
The term "project" has two different meanings in the contexts of compilation and loading. 
"Project" is the WinCC project on the configuration PC. "Project" is also the Runtime project 
you create by compiling the configuration data of an HMI device and download to the HMI 
device. 

● WinCC project: contains the configuration data of one or more HMI devices

● Runtime project: contains the compiled configuration data of an HMI device

The figure below illustrates the link between WinCC projects and Runtime projects using the 
example of the "Compile and load" process:
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Runtime
Runtime is the software for process visualization. In Runtime, you execute the project in 
process mode. 

A distinction is made between two types of Runtime:

1. Runtime on a panel
Before executing a Runtime project on a panel, you have to transfer the Runtime project 
to the panel before startup.

2. Runtime on a PC
You can execute the Runtime project directly on the configuration PC if Runtime has been 
installed on the configuration PC. 
If you want to execute the Runtime project on a different PC, you have to transfer the 
Runtime project to the PC before startup.

Runtime version
The Runtime version depends on the image of the configured HMI device. The Runtime version 
of the compiled project is displayed under "Info" in the Inspector window.

Simulation
You test your configuration with a simulation. You can start a simulation without a link to the 
active process.

In a simulation, you test configured tags or screen changes, for example. During the simulation, 
the configured tags can be manipulated, activated and deactivated with the help of the tag 
simulator. 

There are two types of simulation:
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1. Simulating a panel
If you created a panel in your project, the panel is displayed in the simulation. With the help 
of this type of simulation, you can test your configuration on the HMI device without 
transferring the project to the panel.

2. Simulating Runtime
Simulating Runtime allows you to test the project directly on the configuration PC. 

See also
Generating a "Pack&Go" file (Page 5609)

Starting Runtime Advanced and Panels (Page 5616)

10.13.1.2 Compiling a project

Introduction     
The changes made to the project are compiled in the background even as you are configuring 
a project in WinCC. Projects are compiled automatically when you load them. This ensures 
that the latest version of the project is loaded at all times.

WinCC checks consistency of the project during compilation. The error locations in the project 
are listed in the Inspector window. You can jump directly to the source of the error from the 
entry in the Inspector window. Check and correct errors found.

Scope of the compilation
Configuration data is compiled in the background as soon as you start configuring an HMI 
device. If you compile a project manually, only the changes in the configuration made since 
the last compilation process are compiled in the background. 

You can start complete project compilation manually at any time; this may, for example, be 
done to test the consistency of the configured data.

Requirement
● A project is open.

Procedure
Proceed as follows to compile a project:

1. If you want to compile several HMI devices at the same time, select all the relevant HMI 
devices with multiple selection in the project navigation.

2. Compile the project:

– For delta compilation of the project, select the "Compile > Software" command from the 
shortcut menu of the HMI device.

– To compile all project data, select the "Compile > Software (compile all)" command from 
the shortcut menu.
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Result
The configuration data of all selected HMI devices is compiled. Any errors that occur during 
compilation are shown in the Inspector window. 

10.13.1.3 Loading projects

Overview for loading of projects

Overview
Delta data of the project is automatically compiled before you download it to one or several 
HMI devices. This always ensures that the latest version of the project is transferred. 

Visualizing processes (Comfort/Advanced)
10.13 Compiling and loading

WinCC Comfort/Advanced V12.0 SP1
5600 System Manual, 07/2013,  



Loading a project to an HMI device   
The following steps are completed prior to downloading:

1. The download settings are verified. The "Extended loading" dialog box is opened 
automatically during the initial download of a project to an HMI device. You use this dialog 
to define the protocol and interface or destination path for the project in accordance with 
the HMI device Runtime used.
If, for example, the HMI device is part of a subnetwork, you also select the subnetwork and 
the 1st gateway.
You can open the "Extended download" dialog at any time with the menu command 
"Online > Advanced download to device...". 
The "Load preview" dialog opens. 

2. The project is compiled. Warnings and errors during compilation are displayed in the 
Inspector window and in the "Load preview" dialog.

3. The "Load preview" dialog shows you the following information for each HMI device:

– The individual steps for loading

– If the device version of the target HMI device does not match the configured device 
version, you are asked whether you wish to change the device version at this time.

 

 
 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. For this reason, 
you should first back up the following data:
● User administration
● Recipes

Resetting to factory settings also deletes the license keys. Back up the license keys 
before you reset the system to factory settings.

 

– Presettings that take effect at loading. You can change the default settings for this 
download process, if necessary.

– Warning events (optional). You can download a project while ignoring the "warnings". 
The functionality may be restricted in runtime.

– Error events (optional). You cannot load the project. Eliminate the errors and then reload 
the project.
WinCC will open the invalid configuration in the corresponding editor if you double-click 
the error message in the Inspector window. Correct the errors and reload the project.

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device. 

Visualizing processes (Comfort/Advanced)
10.13 Compiling and loading

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5601



Loading a project without a connected HMI device   
If you cannot establish a direct connection from the configuration PC to the HMI device, save 
the compiled project on a data medium of your choice. Additional steps depend on the Runtime 
used:

● Panel Runtime: Copy the compiled project to a PC connected to the HMI device, for 
example, via a network. Download the project from this PC to the HMI device ("Pack&Go").

● Runtime Advanced: Move the compiled project to the HMI device.

Loading with S7 routing
Configure the S7 routing settings in the "Devices & Networks" editor in the relevant PLC. The 
settings depend on the device configured. 

S7 routing supports the following protocols:

● MPI/PROFIBUS

● Ethernet

See also
Loading a project (Page 5604)

Generating a "Pack&Go" file (Page 5609)

Loading a project

Introduction
Before a project can run on an HMI device, you must first load it to the HMI device. During 
loading, you must most importantly specify whether existing data on the HMI device such as 
"user administration" and "recipe data" is to be overwritten. 

If the HMI device supports PROFINET, the name of the HMI device registered in the project 
tree is used as the device name for the PROFINET communication. The name is written during 
download to the HMI device. If a device name for the PROFINET communication has already 
been entered in the HMI device, it will be overwritten.

As a general rule, only one project can be active in Runtime on an HMI device. An HMI device 
is generally configured to exit Runtime automatically when loading is started. If this is not the 
case, you will have to exit Runtime manually on the HMI device. 

You can alternatively enable the "Remote" option in the transfer settings in the control panel 
of the HMI device. This will then allow you to load a project to the HMI device without first 
having to set the transfer mode manually on the HMI device. 
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If the device version of the target HMI device does not match the configured device version, 
you are asked whether you wish to change the device version at this time.

 

 Note

If your HMI device is a PC, the device version of the target system is not automatically updated 
during the download. 

Verify that the configured device version corresponds to the one of the target HMI device 
before you compile and download your project. If necessary, install the matching Runtime 
version on your HMI device or change the device version manually using the properties of 
the HMI device.

 

 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. For this reason, you 
should first back up the following data:
● User administration
● Recipes

Resetting to factory settings also deletes the license keys. Back up the license keys before 
you reset the system to factory settings.

 

Please refer to the documentation for the HMI device used for more detailed information on 
transfer settings. 

 

 Note
Closing Runtime automatically

If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.

 

 Note
Transfer to an HMI device with WinAC MP

The "PN/IE" channel is not approved for the project transfer on HMI devices with WinAC MP.

Use the "Ethernet" channel instead of "PN/IE" to transfer data to an HMI device that is running 
PLC WinAC MP.
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Requirement
● You have created an HMI device in the project.

● The HMI device is connected to the configuration PC.

● Transfer mode is set in the HMI device.

Procedure
Proceed as follows to load a project:

1. To download a project simultaneously to several HMI devices, select the HMI devices by 
means of multiple selection in the project tree.

2. Select the "Download to device > Software" command from the shortcut menu of the HMI 
device.

3. If the "Extended loading" dialog is open, configure the "Settings for loading". Make sure 
that the "Settings for loading" correspond to the "Transfer settings in the HMI device".

– Select the protocol used, for example, Ethernet or HTTP.

– Configure the relevant interface parameters on the configuration PC.

– Make any interface-specific or protocol-specific settings required in the HMI device.

– Click "Download".

You can open the "Extended download" dialog at any time with the menu command 
"Online > Advanced download to device...".
The "Load preview" dialog opens. The project is compiled at the same time. The result is 
displayed in the "Load preview" dialog.

4. Check the displayed presettings and change them as necessary.

5. Click "Download".

Result
The project is loaded to all selected HMI devices. If errors or warnings occur during the 
download, corresponding alarms are displayed under "Info > Load" in the Inspector window. 

On completion of the successful download of the project, you can execute it on the HMI device.

See also
Error messages during the download of projects (Page 5635)

Overview for loading of projects (Page 5600)

Loading projects to a file

Introduction
Load the Runtime project to the file system of your PC if that is your HMI device. Double-click 
the Runtime project to open it in runtime. 

Visualizing processes (Comfort/Advanced)
10.13 Compiling and loading

WinCC Comfort/Advanced V12.0 SP1
5604 System Manual, 07/2013,  



During loading, you must most importantly specify whether existing data on the HMI device 
such as "user administration" and "recipe data" is to be overwritten. 

If the HMI device supports PROFINET, the name of the HMI device registered in the project 
tree is used as the device name for the PROFINET communication. The name is written during 
download to the HMI device. If a device name for the PROFINET communication has already 
been entered in the HMI device, it will be overwritten.

As a general rule, only one project can be active in Runtime on an HMI device. An HMI device 
is generally configured to exit Runtime automatically when loading is started. If this is not the 
case, you will have to exit Runtime manually on the HMI device. 

You can alternatively enable the "Remote" option in the transfer settings in the control panel 
of the HMI device. This will then allow you to load a project to the HMI device without first 
having to set the transfer mode manually on the HMI device. 

 

 Note
Device version

If the device version of the target HMI device does not correspond to that of the configured 
device version, Runtime cannot be started after loading.

Verify that the device version of the target HMI device conforms to your configuration before 
you compile and download your project. 

If necessary, change the device version manually via the properties of the HMI device.
 

 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. It is therefore advisable 
to generate a backup copy of the Runtime data prior to such actions.

 

Please refer to the documentation for the HMI device used for more detailed information on 
transfer settings. 

 

 Note
Closing Runtime automatically

If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.
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Requirement
● You have created an HMI device in the project.

● The HMI device is a PC.

● The HMI device is connected to the configuration PC.

● Transfer mode is set in the HMI device.

Procedure     
Proceed as follows to load a project to a file:

1. Select the project in the project tree.

2. Select the "Download to device > Software" command from the shortcut menu of an HMI 
device.

3. If the "Extended loading" dialog is open, configure the "Settings for loading". Make sure 
that the "Settings for loading" correspond to the "Transfer settings in the HMI device".

– Select the "Type of the PG/PC interface > File" dialog,

– Select "PG/PC interface > File system" in the dialog,

– Select the file system path under "destination path".

– Click "Download".
You can open the "Extended download" dialog at any time with the menu command 
"Online > Advanced download to device...".
The "Load preview" dialog opens. The project is compiled at the same time. The result 
is displayed in the "Load preview" dialog. 

4. Check the displayed presettings and change them as necessary.

5. Decide whether to overwrite user administration data and/or recipe data on the HMI device. 

6. Click "Download".

Result
The Runtime is loaded to the file system. If errors or warnings occur during the download, 
corresponding alarms are displayed under "Info > Load" in the Inspector window. 

On completion of the successful download of the project, you can execute it on the HMI device.

Double-click the Runtime project file on the target system to launch the Runtime project. 
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Generating a "Pack&Go" file

Introduction
Create a "Pack&Go" file if you cannot connect the HMI device to the configuration PC. The 
"Pack&Go" file is a ZIP file containing the following data:

● The compiled project

● A program for transferring the project to the HMI device

● Image for the configured HMI device

Typical example of an application: An engineering company creates a project variant for a new 
HMI device. The project engineer of the engineering company does not have direct access to 
the plant. The project engineer therefore e-mails the "Pack&Go" file to his local contact. The 
contact unpacks the "Pack&Go" file on a PC connected to the HMI device via a network. He 
then transfers the project from the PC to the HMI device.

Requirement
● You have created an HMI device in the project.

Procedure         
To create a "Pack&Go" file, follow these steps:

1. Select the HMI device in the project tree.

2. Select the "Pack&Go" command from the menu under "Online > HMI device maintenance".

3. The "Create Pack&Go file" opens.

4. Verify that the displayed device version corresponds with that of the target HMI device.

5. Select a protocol as transfer mode.

6. Select the storage location under "Pack&Go file" and enter the file name.

7. If necessary, specify if the "Pack&Go" file is split into several files.

8. Click "Create".
 

  Note

To unzip a "Pack&Go" file which is distributed over several files, you need a compression 
program. The compression program integrated into the operating system is not adequate 
to unzip distributed files.

 

Result
The "Pack&Go" file is created and saved to the specified folder in the file system. Now copy 
the "Pack&Go" file to the PC connected to the HMI device.
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See also
Downloading projects from a "Pack&Go" file to the HMI device (Page 5610)

Downloading projects from a "Pack&Go" file to the HMI device

Requirement
● .NET Framework with V2.0.50727

● The "Pack&Go" file has been stored in the file system of a PC.

● The PC is connected to the HMI device.

● The device version of the HMI device is consistent with the device version in the project
 

  Note

To unzip a "Pack&Go" file which is distributed over several files, you need a compression 
program. The compression program integrated into the operating system is not adequate 
to unzip distributed files.

 

Procedure     
To download the project from a "Pack&Go" file to an HMI device, follow these steps:

1. Unpack the "Pack&Go" file to a folder of your choice in the file system of the PC.

2. From the "PackNGo" subfolder of this directory, run "Siemens.Simatic.Hmi.PackNgo.exe".
The "Pack'n Go" dialog opens. The settings for loading are set by default. Exception: You 
must select the target device if you are using an S7 USB connection.

3. Adjust the settings for loading appropriately if they differ from the interfaces or protocols 
available on the PC.

4. Specify whether or not to overwrite the user management and recipe data already stored 
on the HMI device.

5. If necessary, edit the "settings for loading".

6. Click "Transfer".

Result
The connection to the HMI device is set up via the selected path. An alarm is output if the 
device version used in the project differs from that of HMI device. 

If this is the case, update the operating system on the HMI device. To update the operating 
system on the HMI device, you need ProSave. A prompt for operating system update will 
appear automatically if ProSave has been installed and the selected connection supports the 
update of the operating system.
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See also
Generating a "Pack&Go" file (Page 5607)

Updating the operating system (Page 5629)

Updating the operating system on the HMI device (Page 5630)

Loading via USB interface

Introduction
When you load a project via a USB port, connect the configuration PC and the HMI device 
with a USB cable. You load projects in both directions. 

Requirements for transfer via USB
The following conditions must be met to ensure successful data transfer using a USB port:     

● Use a USB host-to-host cable, USB 2.0 standard.

● You have installed the provided USB driver.
You can find the driver on the WinCC product DVD under "Support\DeviceDriver\USB".

● The HMI device being used is based on Windows CE and has a USB port.

You can find more information on the cables used and the manufacturers/suppliers in the 
Internet at:

● http://support.automation.siemens.com (http://support.automation.siemens.com/WW/
view/en/19142034)

 

  Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the 
WinCC product DVD.

 

  Note
Comfort HMI devices

Use the mini USB port to load projects via USB with Comfort HMI devices. This driver is 
installed automatically. 

 

 

Restrictions
A project can always be transferred to an HMI device. The simultaneous transfer to several 
HMI devices is not possible. 
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Installing a USB driver in Windows XP

Introduction
To load a project via the USB port, install the USB drivers provided on the WinCC product 
DVD.           

 

 Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the WinCC 
product DVD.

 

 Note

Comfort HMI devices

Use the mini USB port to load projects via USB with Comfort HMI devices. This driver is 
installed automatically.   

 

Requirement
● The WinCC product DVD is available.

● You are using a USB host-to-host cable, USB 2.0 standard.

● The HMI device has a USB port.

Procedure
To install the USB driver under Windows XP, follow these steps:

1. Connect the USB host-to-host cable to the USB port of the configuration PC.
The USB cable is automatically detected by the hardware detection under Windows XP. 
The driver installation wizard starts automatically.

 

  Note

Connect the HMI device only when the driver has been completely installed on the PC.
 

2. If you are prompted with "Can Windows connect to Windows Update to search for software", 
select "No, not this time" and click "Next".

3. Select "Install software from a list or specific source" and click "Next".

4. Select "Search removable media".

5. Insert the WinCC product DVD into the DVD drive and click "Next".
The system will search the WinCC product DVD for the corresponding driver for the USB 
host-to-host cable. 
The drivers available on the WinCC product DVD are displayed. The wizard highlights the 
appropriate driver for Windows XP.
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6. Check the selection and click "Next".
 

  Note

The "Hardware installation" dialog box indicates that the software found has not passed 
Windows Logo testing. The Logo test does not have any effects on the functioning of the 
USB driver. Continue with the installation.

 

7. Click "Hardware Installation > Continue installation".
The driver is installed.

8. Click "Finish".
The installation is complete.

Result
The driver for the USB host-to-host cable has been installed. To load the project, connect the 
HMI device to the USB cable.

Installing a USB driver in Windows 7

Introduction
To load a project via the USB port, install the USB drivers provided on the WinCC product 
DVD.         

 

 Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the WinCC 
product DVD.

 

 Note
Comfort HMI devices

Use the mini USB port to load projects via USB with Comfort HMI devices. This driver is 
installed automatically.

 

Requirement
● The WinCC product DVD is available.

● You are using a USB host-to-host cable, USB 2.0 standard.

● The HMI device has a USB port.
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Procedure
To install the USB driver under Windows 7, follow these steps:

1. Connect the USB host-to-host cable to the PC's USB port.
The USB cable is detected, but the wizard for the driver installation does not find the driver. 

 

  Note

Connect the HMI device only when the driver has been completely installed on the PC.
 

2. Open the Device Manager in the Control Panel.

3. Select "Other devices > USB host-to-host cable".

4. Select "USB host-to-host cable" and then select "Update driver software..." in the shortcut 
menu.

5. When the "How do you want to search for driver software?" prompt appears, select "Search 
for driver software on the computer".

6. Click "Update driver software > Browse...".

7. Insert the WinCC product DVD as the source for driver installation.

8. Select "Include subfolders" and then click "Next".
The system will search the WinCC product DVD for the corresponding driver for the USB 
host-to-host cable.
The drivers available on the WinCC product DVD are displayed. The wizard highlights the 
appropriate driver for Windows 7. 

9. Check the selection and click "Next".

10.To continue with the installation, click "Hardware Installation > Continue installation".
The driver is installed.

11.Click "Finish".
The installation is complete.

Result
The driver required for the USB host-to-host cable has been installed. To load the project, now 
connect the HMI device to the USB cable.
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10.13.1.4 Runtime start

Starting Runtime on the configuration PC

Introduction
You can start a project in Runtime on the configuration PC if Runtime has been installed. The 
project settings defined in the "Runtime settings" of the HMI device are activated when the 
project is started in Runtime.

 

 Note

You can only simulate HMI devices with Runtime Panels on the configuration PC. Select the 
"Online > Start simulation" menu command.

 

 Note
Ending Runtime automatically

If automatic transfer is activated on the HMI device and if a transfer is started on the 
configuration PC, the running project is automatically ended. 

The HMI device then switches autonomously to the "Transfer" operating mode.

Deactivate automatic transfer after the commissioning phase so that the HMI device does 
not inadvertently go into transfer mode.

Transfer mode can cause undesired reactions in the system.

In order to restrict access to the transfer settings and thus avoid unauthorized changes, enter 
a password in the control panel.

 

Requirement
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.

● There is no project in Runtime on the configuration PC.

Procedure         
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device in the project navigation.

2. Select the "Online > Start Runtime" menu command.

Result
Runtime is started and the project is displayed on the configuration PC. 
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See also
Simulating a project (Page 5619)

Starting Runtime Advanced and Panels

Introduction
You can start the project in Runtime as soon as you have downloaded the project to the HMI 
device. The project is generally started automatically on the HMI device. 

There may be several projects in the file system of the HMI device for HMI devices with Runtime 
Advanced. You can start one of these projects in Runtime. 

The project settings defined in the "Runtime settings" of the HMI device are activated when 
the project is started in Runtime. Make sure when defining the Runtime settings "Lock task 
switching" and "Full screen" that you will be able to stop Runtime again. You can, for example, 
configure a button with the system function "StopRuntime".

 

 Note
Ending Runtime automatically

If automatic transfer is activated on the HMI device and if a transfer is started on the 
configuration PC, the running project is automatically ended. 

The HMI device then switches autonomously to the "Transfer" operating mode.

Deactivate automatic transfer after the commissioning phase so that the HMI device does 
not inadvertently go into transfer mode.

Transfer mode can cause undesired reactions in the system.

In order to restrict access to the transfer settings and thus avoid unauthorized changes, enter 
a password in the control panel.

 

Requirement
● WinCC Runtime Advanced or Panels is installed on the HMI device.

● The project was downloaded to the HMI device

Visualizing processes (Comfort/Advanced)
10.13 Compiling and loading

WinCC Comfort/Advanced V12.0 SP1
5614 System Manual, 07/2013,  



Starting Runtime on a PC     
The compiled project is saved in the PC file system with the extension "*.fwc" and is freely 
accessible.

1. To start the project once the HMI device has booted up, enter the automatic start of a project 
file under "Settings" in the "RT Loader" ("HmiLoad.exe").
You can also create a link to the project file in the Windows Autostart directory.

Starting Runtime on a panel     
The project will be stored on a panel in a folder you specify in the HMI device transfer settings. 
The "RT Loader" application is started on a panel. The project loaded is started automatically 
after expiration of the configured delay.

If the project does not start automatically:

1. Click on "Start" to start the loaded project.

Refer to the documentation for the HMI device for additional information on startup of projects. 

Result
Runtime is started on the HMI device. 

See also
Overview of compiling and loading projects (Page 5597)

Loading a project (Page 5602)

Downloading projects from a "Pack&Go" file to the HMI device (Page 5608)

10.13.2 Simulating projects

10.13.2.1 Simulation basics

Introduction
You can use the simulator to test the performance of your configuration on the configuration 
PC. This allows you to quickly locate any logical configuration errors before productive 
operation. 

You can start the simulator as follows:

● In the shortcut menu of the HMI device or in a screen: "Start simulation"

● Menu command "Online > Simulation > [Start|With tag simulator|With script debugger]"

● Under "Visualization > Simulate device" in the portal view.
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Requirement
The simulation/runtime component is installed on the configuration PC. 

Field of application
You can use the simulator to test the following functions of the HMI system, for example:

● Checking limit levels and alarm outputs

● Consistency of interrupts

● Configured interrupt simulation

● Configured warnings

● Configured error messages

● Check of status displays

See also
Simulating a screen (Page 5621)

WinCC Runtime Advanced simulation (Page 5618)

Working with the tag simulator (Page 5621)

10.13.2.2 WinCC Runtime Advanced simulation

Introduction
There are two different simulation modes for Runtime Advanced simulation:

● Device simulation

● Tag simulation

Both types of simulation simulate the project without a direct process link to the configuration 
PC. Data such as logs or recipes generated during simulation are not deleted. This data is 
saved on the configuration PC in the paths configured in the project. 

Device simulation
Use device simulation to simulate operator control of the HMI device. Device simulation is, for 
example, used to test screen switching. 

Tag simulation
Use tag simulation to simulate the configured process tags. You can either have tag values 
generated automatically by a simulation table or define tag values yourself. 

Visualizing processes (Comfort/Advanced)
10.13 Compiling and loading

WinCC Comfort/Advanced V12.0 SP1
5616 System Manual, 07/2013,  



See also
Simulation basics (Page 5615)

Simulating a project (Page 5619)

Start debugger (Page 5623)

10.13.2.3 Simulating a project

Introduction
You simulate your project with one of the following two methods:

● Without a connected PLC
You change the value of area pointers and tags in a tag simulator that is read for the 
simulation of WinCC Runtime.

● With a connected PLC without a running process
You simulate your project by running it directly in Runtime. The tags and area pointers 
become active. This allows you to create an authentic simulation of your configured HMI 
device in Runtime. 

 

  Note
Simulation restrictions

You cannot simulate the following system functions:
● CalibrateTouchScreen

You cannot simulate the Media Player. A static screen appears in the simulation window 
instead of the Media Player.

File access via scripts is not possible for HMI devices with Windows CE.
 

Requirement
● Simulation without a connected PLC: Tags have been created

● Simulation with a connected PLC but no active process: A project with tags and area 
pointers has been created

Procedure   
To simulate a project using the tag simulator, follow these steps:

1. Open the project on the configuration PC.

2. Select the "Online > Simulation > With tag simulator" menu command.
For initial project simulation, the simulator is started with a new, empty table. The project 
is opened simultaneously in Runtime. 
Toggle between the tag simulator and Runtime using the <Alt +Tab> key combination.

3. To simulate a process value, select the corresponding "tag" from the tag simulator.
The table lists all configured tags. You can simulate up to 300 tags simultaneously. 
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4. Select the simulation mode in the "Simulation" column.

5. Change the value of tags and area pointers in the respective columns.

6. Activate the "Start" check box to start the simulation for this tag.

7. To save the simulation, select the menu command "File > Save" and enter a descriptive 
name, for example, "Mixing".
The file name is assigned the extension "*.cors". 

Result
The process values are simulated in Runtime. The tag values are created at random, or 
incremented, depending on the simulation mode. 

To specify tag values, change the simulation mode to "<Display" and enter a value at "Set 
value". 

The following figure shows a tag simulator with four tags whose values can be determined at 
random in a range of values from 10 to 1000:

Managing simulation data
If you have saved data from a previous simulation, you can open the file at a later point in time 
and simulate your project again. The tags and area pointers listed in the tag simulator must 
still be available in the project. 

Proceed as follows to open a simulation file: 

1. Select the menu command "Online > Simulate Runtime > With tag simulator".

2. Select the menu command "File > Open" in the tag simulator.

3. Select the corresponding simulation file and click "Open".
The simulator loads the stored data.

Enabling and disabling tags
Start and stop the simulation for each tag separately in order to facilitate the transition from 
offline to online engineering. Activate "Start" in the corresponding row.

If a tag is activated, the simulation values are calculated and transferred to the WinCC 
simulator.
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Deleting a tag
To delete a tag from the tag simulator, follow these steps:

1. Select the cell that contains the tag name.

2. Select the "Edit > Cut" menu command.
The tag is removed from the table. 

10.13.2.4 Simulating a screen

Introduction
If you have only made changes to one screen, you can temporarily specify this screen as the 
start screen for simulation. In this way, you can debug changes without having to modify the 
start screen, or opening the screen on the HMI device. 

Requirements
You created a project that contains at least one screen. 

Procedure  
To define a screen as temporary start screen for simulation, follow these steps:

1. In the project navigation, select the image to display as the start screen in the simulation.

2. Select the "Start simulation" command from the shortcut menu of the screen.

Result
Project simulation is started. Instead of the configured start screen, the simulation window the 
screen you selected in the project navigation. 

See also
Simulation basics (Page 5615)

10.13.2.5 Working with the tag simulator

About the tag simulator
The tag simulator has the following columns:

Column Description
Tag Specifies the tags for the simulation. 
Data type Shows the data type of the selected tag.
Current value Shows the simulated value of the defined tags.
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Column Description
Format Specifies the selected format in which the tag values are simulated: 

● Decimal (1, 2, 3, 4, ...)
● Hexadecimal (03CE, 01F3, ...)
● Binary (0 and 1)

Write cycle Specifies the selected time interval at which the current tag values are simulated. If 
you enter "2", for example, the current value of the tag will be shown every 2 seconds.

Simulation Shows the method by which the tag values are processed during simulation. 
Set value Sets the selected value for the respective tag. The simulation start with the specified 

value.
minValue 
maxValue

Specifies the value range of the tag. You set a minimum and maximum value for this 
range. The default values are -32768 for the minimum and 32767 for the maximum.

Period Contains the period during which the value of the tag is repeated for the "Increment" 
and "Decrement" simulation modes.

Start Starts simulation of the tag based on the previously entered information.

Simulation modes
The simulator has six different simulation modes. The configured tags are supplied with nearly 
realistic values during the simulation. 

Simulation mode Description
Sinusoidal Changes the tag value to form a sinusoidal curve. The value is visualized as a 

periodic, non-linear function.
Random Provides randomly generated values. The tag value is changed by means of a 

random function.
Increment Increases the value of the tag continuously up to a specified maximum value. 

Begins again at the minimum after the maximum has been reached. The value 
trend corresponds to a positive saw-tooth curve.

Decrement Reduces the value of the tag continuously down to a specified minimum value. 
Begins again at the maximum after the minimum has been reached. The value 
curve corresponds to a negative saw-tooth curve.

Shift bit Shifts a set bit continuously by one position. The previous position is always reset. 
This lets you test the alarms of an HMI device, for example.

<Display> The current tag value is displayed statically.

Example: Simulate tags with the "Shift bit" simulation mode
Proceed as follows to simulate tags with the "Shift bit" simulation mode:

1. Open the project you want to simulate.

2. Select the menu command "Online > Simulate Runtime > With tag simulator".
The tag simulator opens.

3. In the "Tag" column, select a tag from your project.

4. Select "Bin" in the "Format" column.

5. Enter the value "1" in the "Write cycle" column.
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6. Select the "Shift bit" simulation mode in the "Simulation" column.

7. Enter the value "1" in the "Set value" column.

8. Enable the tag with the "Start" check box.

Result
The simulator tests the selected tag bit-by-bit as follows:

Simulation values Byte for alarms
Set start value 00000001
1. Simulation value 00000010
2. Simulation value 00000100
3. Simulation value 00001000
.... ...

In Runtime you see if the desired alarm is output at a given value. 

10.13.2.6 Simulation restrictions

Alarms with dynamic parameters
If you use tags or text lists as external tags for alarm, the alarms are not displayed.

Only internal tags are enabled for the simulation of alarms in the tag simulator .

You can use PLCSim to simulate dynamic parameters.

10.13.2.7 Start debugger

Introduction
Select the "With script debugger" script mode to test scripts. The debugger allows you to set 
breakpoints in the code, for example, or implement a script step by step.

Requirements
● A debugger that supports VBS is installed on the Engineering Station, e.g. "MS Script 

Debugger".

● WinCC Runtime is installed on the Engineering Station.

● A project is open.
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Procedure  
1. Select the "Online > Simulation > With script debugger" menu command.

The Runtime software searches for debuggers installed on the Engineering Station. 

2. If several debuggers are found, click on a selected.

Result
The debugger is connected automatically with the runtime software. 

10.13.3 Servicing the HMI device

10.13.3.1 Overview of HMI device maintenance (Basic Panels)

Configuration               
The following figure shows the software components of an HMI device and their relation to the 
Engineering System.

Runtime data
The runtime data is generated during operation of the plant and saved to the HMI device. This 
includes recipes and user administration data, for example. This data is overwritten during the 
download. If required, back up this data before you download a Runtime project.

Runtime project
The Runtime project contains the compiled configuration data for an HMI device. You download 
the Runtime project from WinCC to the HMI device.
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Runtime software and operating system
Together, the Runtime software and operating system of an HMI device form the image. 
Different images are available for the HMI device. All images of an HMI device are available 
in WinCC. Depending on the configuration, download the appropriate image along with the 
Runtime project to the HMI device as required.

Firmware and hardware
The HMI device is delivered with preconfigured firmware and hardware. 

10.13.3.2 Overview of HMI device maintenance tasks (Basic Panels)

Configuration               
The following figure shows the software components of an HMI device and their relation to the 
Engineering System.

Runtime data
The runtime data is generated during operation of the plant and saved to the HMI device. This 
includes recipes and user administration data, for example. This data is overwritten during the 
download. If required, back up this data before you download a Runtime project.

Runtime project and Runtime software
The Runtime project contains the compiled configuration data for an HMI device. Download 
the Runtime project along with the Runtime software from WinCC to the HMI device.

Operating system
The HMI operating system is referred to as image. Different images are available for the HMI 
device. All images of an HMI device are available in WinCC. Depending on the configuration, 
download the appropriate image along with the Runtime project to the HMI device as required.
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Firmware and hardware
The HMI device is delivered with preconfigured firmware and hardware. 

10.13.3.3 ProSave

Introduction  
The "ProSave" service tool is installed by default when WinCC is installed. The ProSave 
functions are called in WinCC with the menu "Online > HMI device maintenance". 

Functional scope
ProSave provides all of the functions you need to manage data on the HMI device:  

● Data backup and restoration of backed-up data

● Operating system update for HMI devices with Windows CE or below

● Transferring License Keys

● Installing and uninstalling drivers and options as well as information on installed options 
and options that can be installed on an HMI device

● Communication settings (transferred from WinCC)

See also
Backup of HMI data (Page 5626)

Updating the operating system (Page 5629)

Transferring license keys (Page 5632)

Installing and uninstalling an option (Page 5634)

Overview of HMI device maintenance (Basic Panels) (Page 5622)

10.13.3.4 Backup of HMI data

Introduction             
Regular backups of HMI device data keep downtimes to a minimum, for example, when you 
replace a device. You simply transfer the backup data to the HMI device, restoring the original 
status. 

Data backup with WinCC
If an HMI device is connected to the configuration PC, you can back up and restore HMI device 
data from the configuration PC using WinCC. 
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Scope of data backup
Which data is backed up and restored depends on the type of HMI device:

● Complete backup
Depending on the HMI device: Runtime, firmware, operating system, configuration, recipes, 
user administration, settings

 

  Note

License Keys are only saved for 177, 277 and 377 series HMI devices.

The License Keys are not saved for the following HMI devices:
● all other Windows CE HMI devices
● TP 177A and OP 77A

 

● Recipes only

● User administration only

A backup file with the extension *.psb is generated when you backup the data of an HMI device. 

As a general rule, you can backup the data to any storage medium. If the HMI device is 
networked, you can also backup the data to a server. 

 

 Note
Scope of data backup for Windows CE HMI devices

Data backup secures the contents of the flash memory. Alarm logs and process value logs 
are generally saved on the external storage medium. Alarm logs and process value logs are 
not backed up. If necessary, back up the contents of the memory card separately. 

Please note the following when performing a complete data file backup and restore operation 
for Windows CE devices:
● A full backup includes all options installed. As a rule, the backup includes all options data 

that is still available after "POWER OFF".
● All data previously on the device, including License Keys and the operating system, will 

be permanently deleted when you carry out complete data restoration.
● If the data restoration was interrupted, execute the command "Reset to factory settings". 

Restart data restoration.
 

 Note

Use interfaces with high bandwidths, e.g. USB or Ethernet to backup and restore data. 
 

 Note

For Windows CE devices, you can also backup the data directly to a CF or PC card, 
independent of ProSave and WinCC. For additional information, refer to the relevant 
operating instructions.
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See also
Backing up and restoring data of the HMI device (Page 5628)

Overview of HMI device maintenance (Basic Panels) (Page 5622)

10.13.3.5 Backing up and restoring data of the HMI device
 

 Note

Use the restore function for project data only on operating devices which were configured 
using the same configuration software. 

 

Requirements
● The HMI device is connected to the configuration PC

● The HMI device is selected in the project navigation.

● If a server is used for data backup: The configuration PC has access to the server

Backup of the data of the HMI device   
Proceed as follows to backup the data of the HMI device:

1. Select the "Backup" command from the "Online > HMI device maintenance" menu.
The "SIMATIC ProSave" dialog box opens. 

2. Select the data to backup for the HMI device under "Data type".

3. Enter the name of the backup file under "Save as".

4. Click "Start Backup".

This starts the data backup. The backup operation takes some time, depending on the 
connection selected.

Restoring the data of the HMI device    
Proceed as follows to restore the data of the HMI device:

1. Select the "Restore" command from the "Online > HMI device maintenance" menu.

2. Enter the name of the backup file under "Save as".
Information about the selected backup file is displayed under "Content". 

3. Click "Start Restore".

This starts the restoration. This operation takes some time, depending on the connection 
selected.
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Backup/Restore from the "Backup/Restore" dialog in the control panel of the HMI device
The "Backup/Restore" function is enabled for MMC, SD memory cards and USB mass storage 
devices. 

See also
Backup of HMI data (Page 5624)

Overview of HMI device maintenance (Basic Panels) (Page 5622)

10.13.3.6 Updating the operating system

Introduction
Update the HMI device image if the version is incompatible with the configuration. The image 
version matches the device version. Update the operating system and Runtime software of 
the HMI device with the help of the device version. While loading the project, you may be 
prompted to run an automatic update of the device version, depending on the protocol used. 
Loading will then continue. Loading will otherwise be aborted. In this case, perform the update 
of the device version manually. 

 

 Note

A device version can only be updated on HMI devices that are not PC-based.
 

Updating the device version
Connect the HMI device to the configuration PC to update the device version. If possible, use 
the interface providing the highest bandwidth for this connection, e.g. Ethernet. An update of 
the device version via serial connection may take up to an hour. 

 

 Note
Transfer of operating systems for MP 377 via PROFIBUS

The size of the image and the baud rates available with PROFIBUS mean image transfer 
with an MP 377 via PROFIBUS can take up to an hour.

Updating the operating system via USB or Ethernet.
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"Reset to factory settings"   
If the operating system on the HMI device is no longer operational, update the operating system 
and reset the HMI device to the factory settings. 

 

 Note
Resetting to factory settings via Ethernet for Basic Panels

You will require the following to reset to the factory settings via Ethernet:
● the MAC address of the HMI device
● the available IP address
● the programming device/PC interface of the configuration PC set to Ethernet TCP/IP

The programming device/PC interface is configured using the control panel of the 
configuration PC. Select" "S7ONLINE (STEP7) -> TCP/IP" in the "Access point of the 
application" field.

 

See also
Updating the operating system on the HMI device (Page 5630)

Overview of HMI device maintenance (Basic Panels) (Page 5622)

10.13.3.7 Updating the operating system on the HMI device
If possible, you should use the interface with the highest bandwidth for this connection, such 
as Ethernet. Updating the operating system via a serial connection can take up to an hour. 
When you update the operating system, the Runtime software on the HMI device is also 
updated and the device version is changed.

 

 NOTICE

Updating the operating system deletes all data on the HMI device

When you update the operating system you delete data on the target system. For this reason, 
you should first back up the following data:
● User administration
● Recipes

Resetting to factory settings also deletes the License Keys. Back up the License Keys before 
you reset the system to factory settings.

 

Requirement
● The HMI device is connected to the configuration PC.

● The HMI device is selected in the project tree.
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Updating the operating system
Proceed as follows to update the operating system:

1. Select the "Update operating system" command from the "Online > HMI device 
maintenance" menu.
The "SIMATIC ProSave [OS-Update]" dialog opens. The path to the image is preset. 

2. If required, you can select a different path for the image that you want to transfer to the HMI 
device.

3. Click "Update OS".

This starts the update. The update operation can take time, depending on the connection 
selected.

Resetting the HMI device to factory settings 
To reset the HMI device to factory settings, proceed as follows:

1. Switch off power to the HMI device.

2. Connect the HMI device to the Engineering Station.

3. Select the "Update operating system" command from the menu under "Online > HMI device 
maintenance" on the configuration PC in WinCC.
The "SIMATIC ProSave [OS-Update]" dialog opens. The path to the image is preset. 

4. If required, you can select a different path for the image that you want to transfer to the HMI 
device.

5. Activate "Reset to factory settings".

6. Click "Update OS".

7. To "Reset to factory settings", switch on power to the HMI device again.
This operation can take time.

Result
The operating system of the HMI device is operational and up-to-date.

See also
Managing licenses (Page 5632)

Backing up and restoring data of the HMI device (Page 5626)

Updating the operating system (Page 5627)

Overview for loading of projects (Page 5600)

Overview of HMI device maintenance (Basic Panels) (Page 5622)
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10.13.3.8 Transferring license keys

Introduction  
You need a license for certain WinCC Runtime options you may want to install on an HMI 
device. Usually, the necessary licenses supplied as "License Keys" on a data medium, e.g. 
USB stick. The "License Keys" can also be made available on a license server. 

Use "Automation License Manager" to transfer the "License Keys" to or from an HMI device. 
The "Automation License Manager" is included automatically when you install WinCC. 

 

 NOTICE

Backing up License Keys

In the following cases you have to backup the "License Keys" in order to prevent deletion of  
the "License Keys":
● Prior to the update of the operating system of a Windows CE HMI device
● Prior to restoring the data from a full backup

"License Keys" on an HMI device are backed up depending on the HMI device 
configuration. For more information, refer to the operating instructions of the 
corresponding HMI device.

 

See also
Managing licenses (Page 5632)

10.13.3.9 Managing licenses

Requirement
● The HMI device is connected to the configuration PC or the PC running the "Automation 

License Manager".

● If you are using the configuration PC: The HMI device is selected in the project navigation.

Procedure      
To transfer license key, proceed as follows:

1. Open the "Automation License Manager". Go to the Windows Start menu and start 
"Automation License Manager" on a PC on which WinCC is not installed.
The "Automation License Manager" starts. 

2. Select the "Connect HMI device" command from the "Edit > Connect target system" menu.
The "Connect target system" dialog opens. 

3. Select the HMI device type in the "Device type" area.

4. Select the "Connection".
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5. Configure the "connection parameters" associated with the selected connection.

6. Click "OK."
The connection to the HMI device is now set up. The connected HMI device is displayed 
in the left pane of "Automation License Manager".

7. Transfer the "License Keys" to the HMI device:

– In the left pane, select the drive on which the "License Keys" are located.
The "License Keys" are displayed on the right pane. 

– Select the "License Keys"

– Drag-and-drop the "License Keys" to the HMI device.

You can also remove License Keys from the HMI device using drag-and-drop.

Alternative procedure
You can also start the "Automation License Manager" from WinCC on a PC with a WinCC 
installation: Select the "Authorize/License" command in the "Online > HMI device 
maintenance" menu.

Result
The "License Keys" are transferred to the HMI device. 

To backup the "License Keys" from the HMI device, drag-and-drop the "License Keys" from 
the HMI device to an available drive. 

Visualizing processes (Comfort/Advanced)
10.13 Compiling and loading

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5631



See also
Transferring license keys (Page 5630)

Installing and uninstalling an option (Page 5634)

10.13.3.1
0

Installing and uninstalling an option

Introduction
You can install the following options on an HMI device: 

● Additional options supplied with WinCC

● Options purchased in addition to WinCC

Which options you can install depends on the HMI device type. 

Requirements
● The HMI device is connected to the Engineering Station, or to the PC with ProSave.

● The HMI device is selected in the project navigation.

Procedure         
To install an option on the HMI device, proceed as follows:

1. Select the "Options" command from the "Online > HMI device maintenance" menu.
All available options and the previously installed options are displayed.

2. To display the installed options on the HMI device, click "Device status".

3. Select the option to install on the HMI device and transfer it to the list of installed options 
with ">>".

4. Click "<<" to uninstall an option from an HMI device.

5. To start installation or deinstallation, click on "OK".

Result
The selected options were installed on the HMI device, or removed. 

See also
Managing licenses (Page 5630)

ProSave (Page 5624)
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10.13.4 Reference

10.13.4.1 Error messages during the download of projects

Possible problems during the download  
When a project is being downloaded to the HMI device, status messages regarding the 
download progress are displayed in the output window. 

Usually, problems arising during the download of the project to the HMI device are caused by 
one of the following errors:

● Wrong operating system version on the HMI device

● Incorrect download settings on the HMI device

● Incorrect HMI device type in the project

● The HMI device is not connected to the configuration PC.

The most common download failures and possible causes and remedies are listed below.

The serial download is cancelled
Possible remedy: Select a lower baud rate. 

The download is cancelled due to a compatibility conflict

Possible cause Remedy
Conflict between versions of the configuration 
software and the operating system of the HMI 
device

Synchronize the operating system of the HMI 
device with the version of the configuration 
software.
To update the operating system on the HMI 
device, select the "Update operating system" 
command from the "Online > HMI device 
maintenance" menu in WinCC. You can also use 
ProSave. 
For additional information, refer to the operating 
instructions for the HMI device. 

The configuration PC is connected to the wrong 
device, e.g. a controller.

Check the cabling. 
Correct the communication parameters. 
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Project download fails

Possible cause Remedy
Connection to the HMI device cannot be 
established (alarm in the output window)

Check the physical connection between the 
configuration PC and the HMI device. 
Check whether the HMI device is in transfer mode. 
Exception: Remote control

The default communication driver is not listed in 
the Windows Device Manager.

Check the device status of the COM connection in 
the properties window of the Device Manager.

Download over MPI/DP interface fails

Possible cause Remedy
"Configured mode" is set on the CP, for example, 
if you are using the SIMATIC NET CD. 

Set the CP to "PG mode" using the "Set PC 
station" application.
Check the "baud rate" and "MPI address" network 
parameters.
Download the project from WinCC to the CP.
Set the CP back to "configured mode".

On the programming device/PC panel, the 
"S7ONLINE" access point is not set to a hardware 
device such as CP5611 (MPI). This may be due 
to the installation of "SIMATIC NET CD".

Set the access point "S7ONLINE" on the selected 
device using the "PG/PC Panel" or "Set PC 
station" application.
Check the "baud rate" and "MPI address" network 
parameters.
Download the project from WinCC to the HMI 
device.
Restore the "S7ONLINE" access point to the 
original device.

The configuration is too complex

Possible cause Remedy
The configuration contains too many different 
objects or options for the HMI device selected.

Remove all objects of a specific type, for example 
all HTML browsers.
Alternatively, remove options such as 
Sm@rtServer or OPC server.

10.13.4.2 Adapting the project for another HMI device

Introduction
When you download a WinCC project to an HMI device, WinCC checks whether this is 
compatible with the HMI device type used in the project. If the types of HMI device do not 
match, you will see a message before the download starts.
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The download is aborted.

Adapting the project for the HMI device
You need to adapt the project accordingly to be able to download the project to the connected 
HMI device.    

● Add a new HMI device in the project tree. Select the correct type of HMI device from the 
HMI device selection.

● Copy the configured components from the previous to the new HMI device.
Copy large amounts of components directly in the project navigation and details view.
For example, copy the "Screens" folder to the screens folder of the new HMI device with 
the help of the shortcut menu.

● Use the detail view to copy entries in the project tree for which the "Copy" command is not 
available in the shortcut menu.

● Select the "Recipes" entry in the project tree, for example. The recipes are displayed in the 
detail view.

● Select the recipes in the detail view and drag them to the "Recipes" entry of the new HMI 
device. The recipes are copied. You can also select multiple objects in the detail view.

● Configure the components that cannot be copied, e.g. connections, area pointers, and 
alarms.

● Save the project at various points in time.

● Compile the full project.

● When the compilation is successfully completed, download the project to the HMI device.

Linking references
References to linked objects are included in the copying. The references are linked again once 
the linked objects are copied.

Example:

You copy a screen in which objects are linked to tags. The tag names are entered at the 
individual objects after the screen is added to the new HMI device. The tag names are marked 
in red because the references are open. When you then copy the tags and insert them into 
the new HMI device, the open references are closed. The red marking for the tag names 
disappears.

For complete references to connected objects in the PLC, you first need to configure a 
connection to the PLC.

Using the information area
When you compile the project for the HMI device, errors and warnings are displayed in the 
"Info" tab of the Inspector window. You can use the shortcut menu command "Go to" to go 
directly to the location where the error or warning can be corrected.

Work through the list of errors and warnings from top to bottom.

When the compilation is successfully completed, download the project to the HMI device. 
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See also
Loading a project (Page 5602)

10.13.4.3 Establishing a connection to the HMI device

Introduction
To download a WinCC project to an HMI device, a properly configured connection must be set 
up between the configuration PC and HMI device. The connection cannot be set up, the 
download is cancelled.

Setting up a connection between the configuration PC and HMI device
1. Check the cable connection between the HMI device and configuration PC.

2. Open the "Devices & Networks" editor in WinCC and start the network view.

3. Select the subnet in the network view and check the settings for the subnet.

4. Select the interface of the HMI device in the network view or device view and check the 
connection parameters in the Inspector window.

5. Switch on the HMI device and press the "Control Panel" button in the loader.
The Control Panel opens.

6. Press "Transfer" twice in the Control Panel.
The "Transfer Settings" dialog box opens.

7. Check the settings and then press "Advanced".
The [Protocol*] Settings" dialog opens.
*: The title of the dialog depends on the protocol used, for example, "PROFIBUS Settings". 

8. Check the advanced settings and close the dialog with "OK".

Important settings
Check the connection settings and in particular the following parameters:

● Network and station addresses

● Selected transmission rate

● Master on the bus; as a general rule, only one master is permitted.

If using a configurable adapter for the connection, check the adapter settings, for example, 
transmission rate, master on the bus. 

See also
Loading a project (Page 5602)

Visualizing processes (Comfort/Advanced)
10.13 Compiling and loading

WinCC Comfort/Advanced V12.0 SP1
5636 System Manual, 07/2013,  



10.14 Operating in Runtime

10.14.1 Basics

10.14.1.1 Overview

Configuration and process control phases     
HMI devices are used to operate and monitor tasks in process and production automation. 
The plant screens on the HMI devices provide a clear overview of active processes. The HMI 
device project, which includes the plant screens, is created during the configuration phase. 

Transfer the project to the HMI device for the process control phase. Another requirement for 
the process control phase is that the HMI device must be connected online to a PLC. The 
process control phase, operator control, and monitoring can then be carried out during an 
ongoing work process.

Figure 10-7 Configuration and process control phases

Downloading the project to the HMI device     
The following procedures are available to download a project to an HMI device:

● Downloading from the configuration PC

● Restore the project from a PC using ProSave
In this case, an archived project is downloaded from a PC to the HMI device. The 
configuration software need not be installed on this PC.

These procedures are available for commissioning and recommissioning a project.
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Commissioning and Recommissioning         
● When the HMI device is commissioned there is no project at first.

The HMI device is also in this state after the operating system has been updated. 

● When recommissioning, any project on the HMI device is replaced.

10.14.1.2 System behavior

System functions and scripts

Use
System functions and user-defined functions are used in Runtime for the following purposes: 

● To control the process.

● To utilize the properties of the HMI device.

● To configure system settings on the HMI device in online mode.

Each system function and user-defined function within WinCC is linked to an object and an 
event. As soon as the event occurs, the system function is triggered.

System functions
These default system functions are used to implement many tasks in Runtime, such as:

● Calculations, e.g. increasing a tag value by a specific or variable amount.

● Logging functions, e.g. starting a process value log.

● Settings, e.g. PLC changes or setting a bit in the PLC.

● Alarms, e.g after a different user logs on.

User-defined functions
User-defined functions may also be included in the project for specific applications which may 
require additional functions. WinCC provides an interface to Microsoft Visual Basic Script 
(VBScript or VBS for short) for creating user-defined functions. 

Examples:
● Conversion of values, e.g. between different physical units (temperatures).

● Automation of production sequences
The user-defined function controls a production sequence by transferring values to a PLC. 
The status is checked based on return values and corresponding measures are initiated.
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Events
The object and the selected function determine which events can be defined as triggers for 
executing a system function.

For example, the "Value change", "On exceeding" and "On falling below" events are associated 
with the "Tag" object. The "Loaded" and "Cleared" events are associated with the "Screen" 
object.

Reports

Overview
Logs are used to document process data and completed production cycles. The report content 
and layout are specified in the project, as is the event triggering the printout of the report. 

For example, a report can be configured for output at the end of a shift to record downtimes. 
A log can also be configured for the purpose of the documentation of product testing or quality 
inspections (ISO 9000).

Output
Reports are printed in Runtime either automatically, e.g. by means of a scheduler, or manually 
by means of a softkey.

Printing reports
Reports are output to the printer in graphic mode. The use of a serial printer is not 
recommended because of the accumulated data volume. 

For proper output, the printer must support the paper format and page layout of the report.
 

 Note

The value of a tag in the report is read and output at the moment of printing. A substantial 
time may elapse between printing out the first and the last page of a report consisting of 
several pages. This may lead to the same tag on the last page being output with a different 
value from that on the first page.

 

 

Logs

Overview
Alarm events and process values can be saved to log files. Alarm events are, for example, the 
"Incoming", "Acknowledge" and "Outgoing" events contained in an alarm message.

Data logging can be used for the following purposes: 
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● Early detection of danger / fault states

● Increase of productivity

● Enhancement of product quality

● Optimization of maintenance cycles

● Documentation of processes

● Quality assurance

Memory options
Depending on the configuration, the logs are written to a file or stored in a database set up for 
this purpose.

● Data logging to File – CSV(ASCII)
In CSV format, table columns are separated by separators and the table rows are 
terminated by a line break. This allows you to evaluate or edit your log data, for example, 
using an external text editor or a spreadsheet program.

 

  Note

Double quotation marks or multiple characters cannot be used as list separators for the 
storage location "File - CSV (ASCII)". The setting for list separators can be found under 
"Start > Settings > Control Panel > Regional and Language Options".

 

● Data logging to File – TXT (Unicode)
The data is saved in the Unicode format. This file format supports all characters than can 
be used in WinCC Runtime. For processing, you require a software that can save Unicode, 
such as Notepad.

 

  Note

To save Asian languages, use the storage location "File - TXT (Unicode)".
 

● Data logging to a File - RDB
Log files of this format can only be read or visualized in WinCC Runtime Advanced.
If you want to evaluate the logged data in a different manner, convert the data to the CSV 
format using the "CopyLog" system function.

● Data logging to a database
Data is saved in a database for which ODBC access was set up by the PC administrator. 

Logging methods
Logging methods used in WinCC:

● Circular log

● Segmented circular log

● Log with level-dependent system alarms

● Log with level-dependent triggering of an event
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Alarm logs
Alarms in the project indicate fault states and operating states of a process. They are generally 
triggered by the controller. Alarms are output on the HMI device in form of screen objects. All 
the data associated with an alarm and configuration data are saved in an alarm log, for 
example, alarm class, time stamp and alarm text. All alarm classes can be logged separately. 
Alarms can be logged either automatically or by operator intervention. For additional 
information, refer to "Logging alarms".

Data logs
In Runtime, the process values are logged, processed and, depending on the project, written 
either to files or to the log database.

Data logging is controlled by means of cyclic operations and events. Logging cycles are used 
to ensure continuous acquisition and storage of the process values. Data logging can also be 
triggered by events, for example, when a value has changed. For additional information, refer 
to "Logging tags".

Storing logs on network drives
Close all logs with the system function "CloseAllLogs" before disconnecting the HMI device 
from the network.

End Runtime if an unexpected network failure occurs. The logs will be available again after 
restarting Runtime.     

Storing files on a Windows 2003 server
Log files and recipes can only be stored on a Windows 2003 server with Active Directory for 
the following HMI devices:

● MP 277

● MP 377

● Mobile Panel 277

● Mobile Panel 277 IWLAN

Tags

Definition
Tags correspond to defined memory areas on the HMI device, to which values are written and/
or from which values are read. This action can be initiated by the PLC, or by the operator at 
the HMI device. 
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10.14.2 Commissioning projects

10.14.2.1 Runtime Advanced and Panels

Introduction
Modern automation concepts are extremely demanding on process visualization. Process 
control close to machines must in particular meet the demands for simple, high-performance 
control of the processes. The objective is to present quick, clear and comprehensible 
information to operators, for example, by means of a trend view. This increasingly requires 
process displays that simplify understanding of the actual process. There is an increasing 
demand for data logging functionality, e.g. for QC. This makes it necessary to log process data 
at machine level. 

Runtime Advanced and Panels is designed for visualizing and operating machines and small-
scale plants. The Runtime software has a window-based pixel-graphics user interface. Due to 
its short response times, the software features secure process operation, jogging at the 
machine and secure data acquisition.

Licensing
A License Key is required to install Runtime Advanced and Panels on a standard PC or on a 
Panel PC. Runtime Advanced and Panels only runs in demo mode if not licensed. 

● PC: The license is included with your Runtime Advanced and Panels package.

● Panel PCs: The "Runtime Advanced and Panels" license is shipped with the device.

WinCC components
The WinCC configuration software is used to create your project data on a PC or PG that is 
operating on a Windows platform.

The Runtime software lets you visualize the process. You use Runtime to test and simulate 
the compiled project file on the configuration PC.

You can order several options with enhanced functions for Runtime Advanced and Panels. 

10.14.2.2 Settings for Runtime Advanced and Panels

Settings in the Runtime software
Open the WinCC configuration software and make the following settings for the Runtime 
software: 

Display on the PLC
In WinCC, configure the visual representation of the generated project in Runtime: Select the 
full-screen or window mode for the project. The window has a smaller size than the screen. In 
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full-screen mode, the project is zoomed to the full screen. There will be no window and operator 
control elements for this view.

Click "Screens" in the "Settings" editor to define activation of the full-screen at startup. Activate 
the "Full-screen mode" check box in the "Screen" field. 

You can hide the taskbar in Windows as required. Select "Start > Settings > Taskbar" and then 
deactivate the "Always on Top" and "Auto hide" check boxes in the "Taskbar properties" dialog.

 

 Note
Truncated view

If the HMI screen does not match the configured size (in pixels), the project opened in full-
screen mode only appears on a part of the screen.

 

Dialog fonts
The dialog text will be shown in the standard font. Define the default font by selecting 
"Languages and fonts" in the "Settings" editor.

Disabling program switching
You lock program switching to prevent operators from calling other applications in Runtime.

Click "Screens" in the "Settings" editor and then activate the "Disable program switching" and 
"Full-screen mode" check boxes. Also hide the Windows taskbar.

 

 Note
Stop runtime

If you lock program switching, always configure in your project the system function 
"StopRuntime" for an object, e.g. a softkey or button. Otherwise, you cannot close Runtime 
or Windows.

The <CTRL+ALT+DEL> key shortcut is not available if program switching is disabled. On a 
Windows 2000 operating system this effect prevents you from logging on to your device again 
after the screensaver was started. Windows 2000 allows you to disable the <CTRL+ALT
+DEL> key shortcut required for logon. Open the "Control Panel > Users > Passwords > 
Advanced" tab and deactivate the "Press CTRL + ALT + DEL before logon" check box.

 

Screen saver
A screensaver is no longer required for most modern screens and can, in fact, even cause 
damage. These monitors switch to hibernate mode as soon as the video signal has not 
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changed for a specified time. A conventional screensaver would prevent this and thus reduce 
the service life of your monitor. 

 

 Note
Approved screensavers

If you do want to use a screensaver, note that only the standard Windows screensavers are 
approved for use in Runtime.

 

Make sure that the correct time zone is set on the PC on which the runtime software is installed. 
To set the time zone in Windows, select Start > Settings > Control Panel > Date and Time. 

Additional operating options

Print functions
Print functions available in online mode: :

● Hardcopy
You can print the content of the currently displayed screen if you utilize the "Print screen" 
system function in your configuration. 

● Printing alarms
Each alarm event that occurs (incoming, outgoing, acknowledgment) is also sent to a 
printer. 

● Printing reports

LED control
The light-emitting diodes (LEDs) in the function keys of the HMI devices can be controlled from 
the PLC. For example, a lit or flashing LED can signal the operator to press a specific function 
key on the device. 

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
5644 System Manual, 07/2013,  



10.14.2.3 Loading a project

Overview
Various scenarios are possible for loading the project: 

● The Runtime software is installed on the same system as the configuration software.

● The Runtime software and the configuration software are installed on different systems. 
The project must be loaded from the configuration computer to the target system. The HMI 
devices must be connected to the configuration PC for the transfer. Another requirement 
is that the transfer mode must match on the HMI devices and in WinCC.

 

  Note

Security prompts may appear during the loading process, depending on the configuration. 
The recipe data and password list on the HMI device are overwritten following a prompt.

 

The configuration software and the Runtime software are installed on the same system
If the configuration software and the Runtime software are installed on the same system, 
proceed as follows: 

1. Create and compile your project.

2. Start Runtime directly from the active configuration software. Select the "Start Runtime" 
command from the "Online" menu.

3. You may test and operate the project online with the controller if you have configured the 
corresponding communication.

The configuration software and the Runtime software are installed on different systems
If the configuration software and the Runtime software are installed on different systems, 
proceed as follows: 

1. Create and compile your project. For additional information, refer to "Compiling a project".

2. To download the file via cable:
Connect the HMI device to the configuration computer using a standard cable to match the 
desired transfer mode and then switch on the HMI device.

3. Set the HMI device to transfer mode.
To start transfer mode, press the "Transfer" button in the Loader. You can also assign the 
system function "SetDeviceMode" to an operator control.

4. Load the project from the configuration computer to your target device. For further 
information, refer to "Loading projects".

 

  Note

If the HMI device is a PC, you can transfer the compiled file without using the loader, for 
example, via Ethernet. Double-click the corresponding file on your PC to start Runtime. 
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10.14.2.4 Testing a project

Introduction
You have the following options for testing a WinCC project:

Testing projects on the configuration computer.
● Simulator

The Simulator is used to test WinCC projects with internal tags and process tags. For 
additional information, refer to "Simulating projects".
Tests supported by the Simulator:

– Offline testing of a configuration without connection to a PLC.

– Online testing of a configuration with connection to a PLC and inactive process.

– Implementation of a demo project.

● Script debugger
The script debugger tests your scripts in Runtime to find logical programming errors. For 
additional information, refer to "Working with the Debugger".

Testing projects on the HMI device
● Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and the PLC is down 
for the duration of the test. You can operate the HMI device, however, without being able 
to exchange data with the PLC. Set the "Offline" mode on the HMI device by assigning the 
system function "SetDeviceMode" to an operating element.

● Online testing of the project on the HMI device
Online testing means that communication between the HMI device and the PLC is up for 
the duration of the test. You can use the HMI device to control the plant as configured. Set 
the "Online" mode on the HMI device by assigning the system function "SetDeviceMode" 
to an operating element.

Procedure
The following steps show the basic procedures for simulating a project offline on the 
configuration computer without PLC connection. 

1. Start by creating a project as it is going to be run later with an interconnected PLC.

2. Save and compile the project.
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3. Start the Simulator directly from the active configuration software. Select "Online > Simulate 
Runtime > With tag simulator".
If simulating the project for the first time, the simulator is started with a new, empty 
simulation table. If you have already created a simulation table for your project, it will be 
opened. 
The simulation table "*.six" contains all your settings for the simulation of tags and area 
pointers. 

4. Make any changes to the tags and area pointers of your project in the simulation table.
Toggle between the simulation table and Runtime using the <ALT+TAB> key shortcut.
Save your simulation settings with "File > Save." Assign the file a meaningful name. The 
file name is automatically assigned the extension "*.six".

10.14.2.5 Backup and restoring projects

Introduction
Backup and restore operations transfer the relevant data between flash memory on the HMI 
device and a configuration computer. 

Requirement
● The HMI device is connected to a configuration computer.

● No project is open in WinCC.

● Relevant only for backup or for restore operations without reset to factory setting:
The data channel is configured on the HMI device. 

Project backup
Proceed as follows to backup the project:

1. Select "Project ▶ Transfer ▶ Communication Settings" in WinCC on the configuration 
computer.
The "Communication Settings" dialog opens.

2. Select the HMI device type.

3. Select the type of connection between the HMI device and the configuration computer, then 
set the communication parameters.

4. Close the dialog with "OK".

5. In WinCC, select the menu command "Project ▶ Transfer ▶ Backup".
The "Backup Settings" dialog opens.

6. Select the data to be backed up.

7. Select a destination folder and a file name for the *.psb backup file.
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8. Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when a backup is initiated.

9. Start the backup operation in WinCC with "OK" on the configuration computer.
Follow the instructions in WinCC flexible. 
A status view opens to indicate the progress of the operation. 

Result
The system outputs a message when the backup is completed. 

The relevant data is now backed up on the configuration computer.

Restoring projects
Proceed as follows to restore projects:

1. Select "Project ▶ Transfer ▶ Communication Settings" in WinCC on the configuration 
computer.
The "Communication Settings" dialog opens.

2. Select the HMI device type.

3. Select the type of connection between the HMI device and the configuration computer, then 
set the communication parameters.

4. Close the dialog with "OK".

5. In WinCC, select the menu command "Project ▶ Transfer ▶ Backup".
The "Restore Settings" dialog dialog opens. 

6. Select the *.psb backup file to be restored from the "Open" dialog.
The view shows from which HMI device the backup file originates and the type of data it 
contains.

7. Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when a restore operation is initiated.

8. Start the backup operation in WinCC with "OK" on the configuration computer.
Follow the instructions in WinCC. 
A status view opens to indicate the progress of the operation. 

Result
The transfer is completed when the backup data is restored from the configuration computer 
to the HMI device.
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10.14.2.6 Starting the project

Project start modes
Options of starting a WinCC project on a Runtime PC:

● Running it from the Explorer
You can run the project by double-clicking its file name in Windows Explorer. 

● Starting together with Runtime
If you enter a project file in the "HmiRT.ini" file, it will start as soon as WinCC Runtime is 
started from the Windows Start menu.

● Run from the command line
To run your project, type in one command either at the MS-DOS prompt, or on the "Start 
> Run" command line in Windows, and then press <Enter>. Note that the following 
command line may diverge from its installation path:
c:\Programs\Siemens\SIMATIC WinCC flexible\WinCC flexible 2007 
Runtime\HmiRTm.exe c:\project\myproject.fwx 

● Autostart

– If your project is linked to the Autostart directory of the Windows start menu, it will be 
automatically upon system startup.

– You can also make the settings for the automatic startup in the "Settings" dialog of the 
WinCC Runtime Loader.

 

  Note

Start the loader from the Windows Start menu "SIMATIC\WinCC flexible Runtime > 
WinCC flexible Runtime Loader".

 

10.14.3 Operating projects

10.14.3.1 Setting the project language

Introduction
The HMI device supports multilingual projects. You must have configured a corresponding 
operating element which lets you change the language setting on the HMI device during 
runtime. 

The project always starts with the language set in the previous session.

Requirement
● The required language for the project must be available on the HMI device.

● The language switching function must be logically linked to a configured operating element 
such as a button.
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Selecting a language
You can change project languages at any time. Language-specific objects are immediately 
output to the screen in the new language when you switch languages.

The following options are available for switching the language:

● A configured operating element switches from one language to the next in a list.

● A configured operating element directly sets the desired language.

10.14.3.2 Operating recipes

Structure of a recipe

Recipes
The recipe collection for the production of a product family can be compared to a file cabinet. 
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet. 

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe, 
for example, for the flavors orange, grape, apple and cherry.

① File cabinet Recipe collection Recipes for a fruit juice plant
② Drawer Recipe Orange flavored drinks
③ Drawer Recipe Grape flavored drinks
④ Drawer Recipe Apple flavored drinks
⑤ Drawer Recipe Cherry flavored drinks
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Recipe data records
The drawers of the file cabinet are filled with suspension folders. The suspension folders in 
the drawers represent records required for manufacturing various product variants.

Example:

Product variants of the flavor apple might be a soft drink, a juice or nectar, for example. 

① Drawer Recipe Product variants of apple flavored drinks
② Suspension 

folder
Recipe data record Apple drink  

③ Suspension 
folder

Recipe data record Apple nectar 

④ Suspension 
folder

Recipe data record Apple juice

Elements
In the figure showing the file cabinet, each suspension folder contains the same number of 
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data 
record. All the records of a recipe contain the same elements. The records differ, however, in 
the value of the individual elements. 

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The records 
for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in production. 
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Recipes in the project

Overview
If recipes are used in a project, the following components interact:

● HMI device recipe memory
Recipes are saved in the form of data records in the HMI device recipe memory. 

● Recipe view / recipe screen
On the HMI device, recipes are displayed and edited in the recipe view or in a recipe screen.

– The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

– The values of the recipe tags are displayed and edited in the recipe screen.
 

  Note

The same recipe tags can be configured in a variety of recipes. If you modify the value 
of a recipe tag, the synchronization changes the value of the recipe tag in all recipes. 

 

● Recipe tags
The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe 
values are stored in recipe tags. The point at which the recipe tag values are exchanged 
with the PLC depends on the configuration.

Data flow
The following figure shows the data flow in a project with recipes:
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① Editing, saving or deleting a recipe data record
② Display recipe data record
③ Synchronize or do not synchronize recipe tags
④ Display and edit recipe tags in the recipe screen
⑤ Write records from the recipe view to the PLC or read records from the PLC and display 

them in the recipe view.
⑥ Recipe tags are to the PLC online or offline
⑦ Export or import recipe data record to memory card

Displaying a Recipe 

Displaying Recipes
You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view 
A recipe view is a screen object used to manage recipe data records. The recipe view shows 
recipe data records in tabular form. 

Depending on the configuration, the recipe view is displayed as follows: 

● As enhanced recipe view

● As simple recipe view

The configuration engineer also defines which operator controls are displayed in the recipe 
view. Only the simple recipe view can be configured on the TP 177A.

Enhanced Recipe View
The figure below shows an example of the enhanced recipe view:

① Selection field for the recipe
② Selection field for the recipe data record

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5653



③ Element name
The element name designates a specific element in the recipe data record.

④ Display field
This show the number of the selected recipe or the selected recipe data record.

⑤ Value of the element 
⑥ Buttons for editing a recipe data record
⑦ Status bar for display of the status messages

Simple recipe view 
The simple recipe view consists of three areas:

● Recipe list

● Data record list

● Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on 
the configuration, the simple recipe view starts with the recipe list or data record list.

The figure below shows an example of the data record list:

① Number of the recipe data record
② Recipe data records
③ Buttons for changing the displayed list and calling the menu

Display of Values
 

 Note
Changing the recipe data record in the background

Applies to the processing of a recipe data record: 
If values of the corresponding recipe data record are changed by a PLC job, the recipe view 
is not updated automatically. 

To update the recipe view, reactivate the respective recipe data record.
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Recipe screen 
A recipe screen allows the correlation between the plant and the recipe data to be displayed 
in graphic form. The configuration engineer combines I/O fields and screen objects to form a 
custom input screen. The configuration engineer can distribute the I/O fields of a recipe over 
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe 
screen can be operated using buttons configured accordingly.

The figure below shows an example of the recipe screen:

① Element names and corresponding values
The element name designates a specific element in the recipe data record.

② Buttons for editing a recipe data record
③ Modified recipe view
④ Buttons for transferring recipe data

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe 
values are exchanged with the PLC immediately or later via these tags. 

A configured recipe view can itself be a component of a recipe screen. You must synchronize 
the tags in order to synchronize data between the tags of the recipe screen and the recipe 
data records displayed in the recipe view. 

Recipe Values in the HMI Device and the PLC

Introduction
You can change the values of a recipe on the HMI device and therefore influence the 
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in different 
ways. 

● If you are editing recipes with a recipe view in your project, the values are saved in recipe 
data records.

● If you are editing recipes in a recipe screen in your project, the values are saved in recipe 
tags.
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Differences may occur between the display values in the recipe view and the values saved in 
the associated tags in an ongoing project when you edit recipes with a recipe view and in a 
recipe screen. Synchronize the values of the recipe data records with the values of the recipe 
tags to prevent this effect. 

Synchronizing recipe tags
 

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Synchronization of the recipe tags depends on the configuration of the enhanced recipe view:

● Automatic synchronization:
The values of the recipe view are synchronized with the associated recipe tags. In this case, 
changes to values in the recipe view have an immediate effect on the values of the 
associated recipe tags. The values are only synchronized, when an operating element that 
is outside the recipe view is operated. 

● Synchronization by the user:
The values of the recipe view and the associated recipe tags are not synchronized 
automatically. The project engineer has assigned the same function to the  button or 
to a different operator control in the recipe view. The recipe tags and the recipe view are 
only synchronized when you operate the buttons or the appropriate operator control.

Recipe Tags Online / Offline
The configuration engineer can configure a recipe so that changes to the values of the recipe 
tags do not have an immediate effect on the current process. 

Synchronization of the recipe values between the HMI device and the PLC depends on whether 
the configuration engineer has selected the settings "Tags online" or the setting "Tags offline" 
for a recipe.

● "Tags online":
This setting has the following effect:

– When you change recipe values in the recipe screen, these changes are applied 
immediately by the PLC and immediately influence the process.

– If recipe values are changed in the PLC, the changed values are displayed immediately 
in the recipe screen.

● "Tags offline":
With this setting, changed recipe values are not synchronized immediately between the 
HMI device and the PLC. 
In this case, the configuration engineer must configure operating elements for transferring 
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values 
are only synchronized between HMI device and PLC when you operate the appropriate 
operator control. 
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Exporting a recipe data record

Introduction
You can export one or more recipe data records to a CSV file, depending on the configuration. 
After export, the values in the recipe data record can be further processed in a spreadsheet 
program such as MS Excel. The degree to which you can influence the export depends on the 
configuration: 

Requirement
● A screen with a recipe view is displayed.

● An operating element with the function "Export record" has been configured.

● The following tags are configured equally in the recipe view and for the "Export record" 
operating element.

– Recipe number

– Data record number

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record you want to export.

3. Operate the operator control which was configured for export, for example the "Export data 
record" button.
The data record is exported as a CSV file to an external data medium.

Result
The recipe data record is exported. 

Importing a recipe data record

Introduction
You can import values from a CSV file to a recipe data record, depending on the configuration. 

Requirement
● An operator control with the function "Import data record" has been configured, for example 

a button

● A screen with a recipe view is displayed.
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Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the recipe data 
record to be imported.

2. Operate the operator control with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed in 
the recipe view after import.

Result
The imported recipe data record is saved on the HMI device.

Deviating structure
If the structure of the CSV file differs from the structure of the recipe, deviations are handled 
as follows:

● Any additional values in the CSV file will be rejected

● The system applies the configured default value to the recipe data record if the CSV file 
contains an insufficient number of values

● If the CSV file contains values of the wrong data type, the configured default value is set 
in the recipe data record
Example:
The imported CSV file contains values that were entered as floating point numbers
However, the corresponding tag expects an integer value. In this case, the system discards 
the imported value and uses the configured default 
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Operating the recipe view

Overview

Use
The recipe view is used to display, edit and manage data records.    

Operation
Depending on the configuration you can:   

● Creating, editing, copying or deleting recipe data records

● Synchronize recipe data records with the associated recipe tags

● Read recipe data records from or transfer to the PLC

Operator controls
The following operating elements can be configured in the recipe view:   

Button Hotkey Function
 The configured tooltip is displayed.

 + Creates a new recipe data record.
If a start value is configured, it is displayed in the input field.

 + Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

 + The recipe data record is saved under a different name 
regardless of the recipe view. A dialog box opens where you can 
enter the name.

 + The displayed recipe data record is deleted.

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5659



Button Hotkey Function
 + The system always updates the current value of the recipe view 

with the latest recipe tag value.
When the value shown in the recipe view is more recent than the 
current recipe tag value, the system writes this value to the recipe 
tag.
"Synchronize tags" must be enabled in the recipe properties 
before you can use this function.

 + The values of the set recipe data record displayed in the recipe 
view are transferred to the PLC.

 + The recipe values from the PLC are displayed in the recipe view.

Mouse control or touchscreen control of the recipe view  
1. Select the recipe you want to use.

The data records of the recipe are displayed.

2. Click on the data record you wish to edit.

3. Press the button whose function you wish to execute.

Using the keyboard with the recipe view  
1. Press the <Tab> key until the "Recipe name" or "Data record name" field is activated.

2. Press <Enter>.
The selection list for the recipes or data records opens. 

3. Select a recipe or a data record from the list. Toggle between the next or previous entry by 
using the cursor keys <Left>, <Right>, <Up> and <Down>.

4. Press the <Tab> key until the operating element you wish to use is selected. You can also 
operate the recipe view via hotkeys.

Creating a recipe data record

Touch and key operation

Introduction
Create a new recipe data record by editing an existing data record.Save this data record under 
a new name. 

Requirement
A screen with a recipe view is displayed.
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Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Touch .
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Touch the button  .

5. Enter a name for the data record.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Press  + .
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Press  + .

5. Enter a name for the data record.

6. Confirm your input.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Result
The new recipe data records will be saved to the selected recipe. 

Mouse and keyboard operation

Introduction   
Create a new recipe data record by editing an existing data record. Save this data record under 
a new name. 

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5661



Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Click the button.
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Click the button.

5. Enter a name for the data record.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. If the recipe view contains several recipes: Press the <TAB> key until the recipe for which 
you are going to create a new data record is selected.

3. Press the <CTRL+Space> key shortcut to create a new recipe data record with the next 
available number.
An existing data record is overwritten if you assign its number to a new data record.

4. Enter values for the data record elements. The data record elements can be assigned 
default values, depending on the configuration.

5. Press the <CTRL+ENTER> key shortcut to save the recipe data record.

6. Enter a name for the data record. The data record is saved under the new name.
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Result
The new recipe data records will be saved to the selected recipe. 
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Editing recipe data records

Touch and key operation

Introduction
Edit the values of the recipe data records and save them in a recipe view. 

Synchronization with the PLC
If you want to display the current recipe values from the PLC in the recipe view, you first have 
to read the current values from the PLC with .

You must transfer the data record to the PLC by pressing the  button to activate the changes 
you have made in the recipe view.

Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the recipe data 
record required.

2. Select the recipe data record you want to edit.

3. Edit the data record as required.

4. Press  to save the changes.
Touch the  key to save the recipe data record under a different name.

Procedure for key operation
Proceed as follows:

1. If the recipe list contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

2. Press the <TAB> key until the desired recipe data record is selected.

3. Edit the data record.

4. Press  to save the changes.
Touch the  key to save the recipe data record under a different name.

Result
The edited recipe data record is saved to the selected recipe. 
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Mouse and keyboard operation

Introduction   
Edit the values of the recipe data records and save them to a recipe view. 

Synchronization with the PLC
You must read the current values from the PLC by pressing the  button or the <CTRL+UP> 
key shortcut to display the current recipe values from the PLC in the recipe view.

You must transfer the data record you have edited to the PLC to activate the changes you 
have made in the recipe view by pressing the  button or the <CTRL+DOWN> key shortcut.

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the recipe data 
record required.

2. Select the recipe data record to be edited.

3. Edit the data record.

4. Click on  to save your changes.
Click the  button to save the recipe data record under a different name.

Procedure for keyboard operation
Proceed as follows:

1. If the recipe list contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

2. Press the <TAB> key until the desired recipe data record is selected.

3. Edit the data record.

4. Press the <CTRL+ENTER> key shortcut to save your changes.
Use the <CTRL + *> shortcut to save the recipe data record under a different name.

Result
The edited recipe data record is saved to the selected recipe. 
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Deleting recipe data records

Touch and key operation

Introduction
You can delete all recipe data records which are not required. 

Requirement
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Touch the button  .

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Press  + .

Result
The recipe data record is deleted. 

Mouse and keyboard operation 

Introduction
You can delete all recipe data records which are not required. 

Requirement
A screen with a recipe view is displayed.
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Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Touch the button  .

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. If the recipe view contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

3. Select the recipe data record to be deleted.

4. Press the <CTRL+DEL> key shortcut to delete the data record.

Result
The recipe data record is deleted. 

Synchronizing tags

Touch and key operation

Introduction
You can save the values of recipe elements to recipe tags, depending on your configuration. 

Differences may develop in your active project between the values displayed in the recipe view 
and the actual values of the tags. Synchronize the tags to compensate for such differences.

Synchronization encompasses all tags of a recipe data record.
 

 Note
Renamed tag

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
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Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Touch the button  .

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Press  + .
 

Result
The values of the recipe data record are synchronized with the tag values. 

The most recently updated value is accepted if there is a difference between the values of the 
recipe view and the tag. 

Mouse and keyboard operation

Introduction
You can save the values of recipe elements to recipe tags, depending on your configuration. 

Differences may develop in your active project between the values displayed in the recipe view 
and the actual values of the tags. Synchronize the tags to compensate for such differences.

Synchronization encompasses all tags of a recipe data record.
 

 Note
Renamed tag

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.
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 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Click the button.

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. You could also use the <CTRL+=> 
key shortcut for synchronizing.

Reading recipe data records from the PLC

Touch and key operation

Introduction
You can edit values which were saved to the recipes in the HMI device directly at plant level 
within the active project; this may be the case if a valve in the plant opens more than is indicated 
in the recipe. Inconsistency could have developed between the values of the recipe data 
records stored in the HMI device and the values in the PLC.

Read the values from the PLC and output these to the recipe view to synchronize the recipe 
values. 

Requirement
A screen with a recipe view is displayed.
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Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Touch the button  .
The values are read from the PLC.

4. Touch the button  to store the displayed values in the HMI device.

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Press  + .
The values are read from the PLC.

4. Press the +  keys to store the displayed values in the HMI device.

Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

Mouse and keyboard operation 

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Click the button.
The values are read from the PLC.

4. Click on  to store the displayed values in the HMI device.
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Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. Press <Enter>.
You could also use the <CTRL+Down> key shortcut.

Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

Transferring recipe data records to the PLC

Touch and key operation

Introduction
You must transfer the values to the PLC to activate a changed recipe data record for the 
process. 

The values displayed in the recipe view are transferred to the PLC. 

Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Touch the button  .
The values are transferred to the PLC.
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Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Press  + .
The values are transferred to the PLC.

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 

Mouse and keyboard operation 

Requirement
A screen with a recipe view is displayed. 

Operation with the mouse
1. If the recipe view contains several recipes: Select the recipe which contains the desired 

recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Click the button.
The values are transferred to the PLC.

Operation with the keyboard
1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. Press <Enter>. You could also use 
the <CTRL+Down> key shortcut.
The values are transferred to the PLC.

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 
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Using the simple recipe view

Overview 

Layout
The simple recipe view consists of three areas:     

● Recipe list

● Data record list

● Element list

Figure 10-8 Simple recipe view - example with data record list

In the simple recipe view, each area is shown separately on the HMI device. You can use the 
shortcut menu to operate each of these display areas.

The simple recipe view always begins with the recipe list.

Operation    
You can use the simple recipe view as follows, depending on the configuration:

● Create, change, copy or delete recipe data records

● Read recipe data records from the PLC or transfer to the PLC

Operator controls of the simple recipe view 
Toggle between the display areas and the shortcut menus to operate the simple recipe views.

The table below shows the operation of the display area.

 Key Function
Touching an entry The next lowest display area is opened, i.e. the data record list or 

the element list.
The previous display area opens. 
The shortcut menu of the display area opens.

The table below shows the operation of the shortcut menu:
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 Key Function
The menu is closed. 
The display area opens.

Touching the menu 
command

Input of the number 
of the menu 
command

The menu command is executed.

Shortcut menus of the simple recipe view    
A shortcut menu can be called for each view area by pressing the  button or the  key. 
The shortcut menu lists the commands that are available in the active view area. A number is 
assigned to each command. You execute the command by entering its number. You can also 
use the system keys to execute certain commands. 

The scope depends on the HMI device.    

● Recipe list

No. Menu command Keys Function
0 New  + A new recipe data record is created for the selected recipe.

If a start value is configured, it is displayed in the input field.
1 Displaying infotext Displays the infotext configured for the simple recipe view.
2 Open The record list of the selected recipe opens.

● Data record list

 Menu command Keys Function
 New  + Creates a new recipe data record.

If a start value is configured, it is displayed in the input field.
 Deleting The displayed record is deleted.
 Save as  The selected data record is saved under a different name. 

A dialog box opens where you can enter the name.
 Rename  Renames the selected data record. A dialog box opens 

where you can enter the name.
 Open The element list of the selected data record opens.
 Previous The recipe list opens.
 To PLC  The displayed values of the selected data record are 

transferred from the HMI device to the PLC.
 From PLC  The recipe values from the PLC are displayed in the recipe 

view of the HMI device.
 Displaying infotext Displays the infotext configured for the simple recipe view.

● Element list

 Menu command Keys Function
 Save  The selected record is renamed.
 To PLC  The displayed values of the selected data record are 

transferred from the HMI device to the PLC.
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 Menu command Keys Function
 From PLC  The recipe values from the PLC are displayed in the recipe 

view of the HMI device.
 Save as  The data record is saved under a new name. A dialog box 

opens where you can enter the name.
 Displaying infotext Displays the infotext configured for the simple recipe view.
 Rename  Renames the selected data record. A dialog box opens 

where you can enter the name.
 Previous The data record list opens.

Mouse control or touchscreen control of the simple recipe view
1. Select the desired recipe from the recipe view.

2. Click on the  button.
The shortcut menu is opened.

3. Select the desired menu command.
The menu command is executed.

4. Alternatively, open the desired recipe in the recipe view.
The data record list is displayed.

5. Open the desired data record. You could also use the  button to open the shortcut menu 
and select a menu command.
The menu command is executed.

Using the keyboard with the simple recipe view
1. Press the key as many times as required to select the simple recipe view.

2. Select the desired recipe with the cursor keys.

3. Press the  key.
The shortcut menu is opened.

4. Press the cursor key as many times as required to select the menu command.

5. Confirm the menu command by pressing the key .

6. Alternatively, press the number of the desired menu command.
The menu command is executed.

 

Creating a recipe data record

Introduction  
Create a new recipe data record in the recipe list or in the record list. Then enter the values 
for the new record in the element list and save the record.
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Requirement
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows to create a recipe data record:

1. If the recipe list contains several recipes: Select the recipe for which you want to create a 
new recipe data record.

2. Open the recipe list menu.

3. Select the "0 new" menu command.
Creates a new record.
The element list of the new record opens.

4. Enter values for the data record elements.
The tags of the record can be assigned default values depending on the configuration.

5. Open the menu of the element list and select the "0 Save" menu command.

6. Enter a name for the new record.

7. Confirm your entries.
An existing data record is overwritten if you assign its number to a new data record.

Result
The new recipe data record is saved to the selected recipe. 

Editing a recipe data record

Introduction    
Edit the values of the recipe data records and save them to a recipe view. 

Synchronization with the PLC  
To display the current recipe values from the PLC in the simple recipe view, you first have to 
read the actual values in the element list from the PLC using menu command "2 From PLC". 

Values changed in the recipe view are only activated after you transferred the modified data 
record to the PLC by means of menu command "1 To PLC".

Requirement
A screen with a recipe view is displayed.
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Procedure 
Proceed as follows to copy a recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.

3. Select the recipe data record you want to edit.

4. Open the element list.

5. Edit the element values as required.

6. Save your changes using menu command "0 Save".

Result
The edited recipe data record is saved to the selected recipe. 

Deleting a recipe data record

Introduction  
You can delete all the data records which are not required. 

Requirement
A screen with a simple recipe view is displayed.

Procedure for touch operation
Proceed as follows to delete a new recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.

3. Select the data record you want to delete.

4. Open the menu.

5. Select the menu command "1 Delete".

Procedure for key operation
Proceed as follows to delete a new recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.
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3. Select the data record you want to delete.

4. Press 
INS

DEL .

Result
The data record is deleted. 

Transferring recipe data records to the PLC

Introduction   
You must transfer the values to the PLC to activate a changed recipe data record for the 
process. 

The values displayed in the recipe view are transferred to the PLC. 

Requirement
A screen with a simple recipe view is displayed.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the element list of the recipe data record whose values you want to transfer to the 
PLC.

3. Open the menu.

4. Select menu command "1 To  PLC".

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 

 

 Note
Basic Panels

With Basic Panels, the "To PLC" menu command can also be configured for the data record 
list: In this case, you can also select the "To PLC" menu command in the data record list.
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Reading a recipe data record from the PLC

Introduction      
The values of recipe elements are exchanged with the PLC via tags.

You can edit values which were saved to the recipes in the HMI device directly at plant level 
within the active project; this may be the case if a valve in the plant opens more than is indicated 
in the recipe. The values of the tags on the HMI device possibly no longer match the values 
in the PLC.

Read the values from the PLC and output these to the recipe view to synchronize the recipe 
values. 

Requirement
A screen with a simple recipe view is displayed. 

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the element list of the recipe data record to which you want to apply the values from 
the PLC.

3. Open the menu.

4. Select menu command "2 From PLC".
The values are read from the PLC.

5. Save the displayed values to the HMI device using menu command "0 Save".

Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

 

 Note
Basic Panels

With Basic Panels, the "From PLC" menu command can also be configured for the data record 
list: In this case, you can also select the "From PLC" menu command in the data record list.

 

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
5678 System Manual, 07/2013,  



10.14.3.3 Operating alarms

Overview

Alarms  
Alarms indicate events and states on the HMI device which have occurred in the plant, in the 
process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time

● Alarm text

● Event text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group

● Supports diagnostics

Alarm classes  
Alarms are assigned to various alarm classes. The selection depends on the HMI device.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on." Alarms 
in this class do not require acknowledgment.

● "Errors"
Alarms in this class must always be acknowledged. Alarms normally indicate critical errors 
within the plant such as "Motor temperature too high".

● "System"
System alarms indicate states or events which occur on the HMI device. 
System alarms provide information on occurrences such as operator errors or 
communication faults. 

● "Diagnosis Events"
SIMATIC diagnostic alarms show states and events in the SIMATIC S7 controllers.
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 Note
Availability for specific devices

Diagnostic alarms are not available for Basic Panels.
 

● STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.

 

  Note
Availability for specific devices

STEP 7 alarm classes are not available for Basic Panels.
 

● Custom alarm classes
The properties of this alarm class must be defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.  

Alarm report 
When alarm report is enabled in the project, alarm events are output directly to the connected 
printer. 

You can set the reporting function separately for each alarm. The system outputs "Incoming" 
and "Outgoing" alarm events to the printer.

The output of alarms of the "System" alarm class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the complete content of the alarm buffer to the printer. 
To be able to initiate this print function, you need to configure a corresponding control object 
in the project.

 

 Note
Availability for specific devices

Alarm reports are not available for Basic Panels.
 

Alarm log
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.  

 

 Note
Availability for specific devices

Alarm logs are not available for Basic Panels.
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Alarm view
The alarm view shows selected alarms or alarm events from the alarm buffer or alarm log. 
Whether alarms have to be acknowledged or not is specified in your configuration. By means 
of configuration, the display can be filtered in such a way that only alarms that contain a specific 
character string will be shown.

Alarm window
If configured, an alarm window shows all pending alarms or alarms awaiting acknowledgment 
of a particular alarm class. The alarm window is displayed as soon as a new alarm occurs.  

You can configure the order in which the alarms are displayed. Either the current alarm or the 
oldest alarm is displayed. The alarm window can also be set to indicate the exact location of 
the fault, including the date and time of the alarm event. By means of configuration, the display 
can be filtered in such a way that only alarms that contain a specific character string will be 
shown.

Alarm indicator
The alarm indicator is a graphic icon that is displayed on the screen when an alarm of the 
specified alarm class is incoming.  

The alarm indicator can assume one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number displayed indicates the number of pending alarms.

 

Detecting pending alarms

Introduction
You can recognize the presence of alarms which must be acknowledged by the following:

● For an HMI device with keys: The LED of the key  is lit.

● Depending on the configuration: An alarm indicator is displayed on screen.

The configuration determines whether an alarm has to be acknowledged or not. This is also 
defined by the alarm class which an alarm belongs to. 

LED in the "ACK" key   
An LED is integrated in the  key on HMI devices with keyboard. The LED is lit if there are 
alarms requiring acknowledgment which must still be acknowledged.

The LED goes out when you acknowledge all alarms requiring acknowledgment.
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Alarm indicator  
The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring 
acknowledgment, depending on the configuration.

Figure 10-9 Alarm indicator with three pending alarms

Layout
The alarm indicator can assume one of two states:

● Flashing:
The alarm indicator flashes as long as alarms are pending for acknowledgment. The 
number displayed indicates the number of pending alarms. The project engineer can 
configure specific functions to be executed by operating the alarm indicator.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated.

Displaying dialogs
The displayed alarm indicator view is covered, for example, by the logon dialog, help dialog 
or alarm text windows. The alarm indicator is visible once you close these dialogs. 

Viewing alarms

Alarm view, alarm window

Use             
Alarms are displayed in the alarm view or in the alarm window on the HMI device. The layout 
and operation of the alarm window corresponds to that of the alarm view.

The alarm window is independent of the process screen. Depending on the configuration, the 
alarm window appears automatically as soon as a new, unacknowledged alarm has been 
received. The alarm window can be configured so that it only closes after all the alarms have 
been acknowledged. 
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Control elements
The buttons have the following functions:         

Button Function
Display tooltip for an alarm

Edit alarms

Acknowledge alarm

Layout of the alarm classes   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed. If a filter is configured, only alarms that contain a 
specific character string are displayed in the alarm text.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Icon Alarm class
! "Errors"
(empty) "Warnings"
(depends on the configuration) Custom alarm classes
$ "System"
S7 "Diagnosis Events"

Operation         
Depending on the configuration you can:

● Change the column sequence

● Change the order in which the alarms are displayed
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● Acknowledge alarms

● Edit alarms

Runtime behavior

Linked alarm windows for touch panels
When you configure the alarm window for a keyboard unit, select the property "Modal" under 
"Properties > Mode". This ensures that the alarm window does not lose its focus during screen 
changes. This is important, as the switching between the screen and different windows with 
<Ctrl+TAB> is not supported. If the linked alarm window has the focus, the buttons in the screen 
behind it cannot be operated. The functions configured on a function key are carried out.

Changing the order of the displayed alarms
Click in the column to sort the alarms by date and time. 

Simple alarm view, alarm window

Use   
The simple alarm view shows selected alarms or alarm events from the alarm buffer or alarm 
log. The layout and operation of the simple alarm window correspond to that of the simple 
alarm view.         

 

 Note

The "Single alarm view" object cannot be operated dynamically with a script. 

In the Engineering System you can dynamically control the visibility of an object, for example, 
in the "Animations" tab of the Inspector window. In Runtime, the "Simple alarm view" does 
not support animations. If you have configured an animation and wish to perform a 
consistency check of the project, for example, then an error alarm is issued in the Output 
window.

 

Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed.
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To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Icon Alarm class
! "Errors"
(empty) "Warnings
(depends on the configuration) Custom alarm classes
$ "System"

Operation
Depending on the configuration you can:     

● Acknowledge alarms

● Edit alarms

Control elements
The buttons have the following functions:     

Button Function
Acknowledge alarm

Edit alarm

Display tooltip for an alarm

Shows the full text of the selected alarm in a separate window, the alarm text window.
In the alarm text window, you can view alarm text that requires more space than is 
available in the alarm view. Close the alarm text window with 

.
Scrolls one alarm up

Scrolls one page up in the alarm view

Scrolls one page down in the alarm view

Scrolls one alarm down

Layout of the control elements
On the OP 73micro and TP 177micro HMI devices the simple alarm view has a button that 
displays the message text in a separate window. This button is not displayed during 
configuration of the simple alarm view in the Engineering System.

The layout of the buttons for operating the simple alarm view depends on the configured size. 
You should therefore check on the HMI device whether all required buttons are available.       
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Display tooltip for alarm

Touch and key operation

Procedure for touch operation
Proceed as follows to display the info text:

1. Touch the relevant alarm in the alarm view or in the alarm window.
The alarm is selected.

2. Touch the  button in the simple alarm view or  in the advanced alarm view.
If configured, the info text assigned to this alarm is displayed. 

3. Close the screen for displaying the Info text by means of the  button.

Procedure for key operation
Proceed as follows to display the info text:

1. Select the desired alarm in the alarm view.

2. Press the key .
If configured, the info text assigned to this alarm is displayed. 

3. Close the info text by pressing the  key.

Mouse and keyboard operation 

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.

Procedure for keyboard operation
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <TAB> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <ENTER>.
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Acknowledge alarm

Touch and key operation

Requirement
The alarm to be acknowledged is displayed in the alarm window or the alarm view.

Procedure for touch operation    
To acknowledge an alarm, proceed as follows:

1. Touch the relevant alarm in the alarm view or in the alarm window.
The alarm is selected.

2. Touch the  button in the simple alarm view or  in the advanced alarm view.

Procedure for key operation
The alarm view and the alarm window have a tab sequence with which you can select operator 
controls and the last selected alarm using the keyboard.

To acknowledge an alarm, proceed as follows:

1. Select the desired alarm view or alarm window using the  key.

2. Select the desired alarm. Use the , ,  or  keys accordingly.

3. Press the key .

Alternative operation
Depending on the configuration, you can also acknowledge an alarm with a function key.

Result
The alarm is acknowledged. If the alarm belongs to an alarm group, all the alarms of the 
associated group are acknowledged. 

Mouse and keyboard operation

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.
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Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <Tab> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <Enter>.

Edit alarm

Touch and key operation

Introduction  
The configuration engineer can assign additional functions to each alarm. These functions are 
executed when the alarm is processed.

 

 Note

When you edit an unacknowledged alarm, it is acknowledged automatically.
 

Requirement
The alarm to be edited is displayed in the alarm window or the alarm view.

Procedure for touch operation
Proceed as follows to edit an alarm:

1. Touch the relevant alarm in the alarm view or in the alarm window. The alarm is selected.

2. Touch the  button in the simple alarm view or  in the enhanced alarm view.

Procedure for key operation
Proceed as follows to edit an alarm:

1. Select the desired alarm view or alarm window with TAB .

2. Select the desired alarm. Use the HOME , END ,  or  keys.

3. Continue to press the key TAB until the button  is selected in the simple alarm view or 
 in the extended alarm view.

4. Confirm your entry by pressing the key ENTER .

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
5688 System Manual, 07/2013,  



Result
The system executes the additional functions of the alarm. Additional information on this topic 
may be available in your plant documentation. 

Mouse and keyboard operation

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.

Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <Tab> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <Enter>.

Alternative operation
Depending on the configuration, you can also operate the alarm view via the function keys.

10.14.3.4 Basics

Overview

Operation options
The hardware determines how you can operate the HMI device:

● Touch screen
The operating elements shown in the dialogs are touch-sensitive. Touch objects are 
basically operated in the same way as mechanical keys. You activate operating elements 
by touching them with your finger. To double-click them, touch an operating element twice 
in succession.

● HMI device keyboard
The operating elements shown in the screens are selected and operated using the keys of 
the HMI device.
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● External keyboard

● External mouse

Operation feedback from operating elements     
The HMI device provides optical feedback as soon as it detects that an operating element has 
been selected. The operating element receives the focus and is selected. This selection is 
independent of any communication with the PLC. Therefore this selection does not indicate 
whether the relevant action is actually executed or not.

The configuration engineer can also configure the selection of an operating element so that it 
deviates from the standard.

Optical feedback from operating elements    
The type of optical feedback depends on the operating element: 

● Buttons
The HMI device outputs different views of the "Pressed" and "Unpressed" states, provided 
the configuration engineer has configured a 3D effect:

– "Pressed" state:

– "Unpressed" state:

The configuration engineer determines the appearance of a selected field, for example, line 
width and color for the focus.

● Invisible buttons
By default, invisible buttons are not displayed as pressed when they are touched. No optical 
operation feedback is provided in this case.
The configuration engineer may, however, configure invisible buttons so that their outline 
appears as lines when touched. This outline remains visible until you select another 
operating element.

● I/O fields
When you select an I/O field, the content of the I/O field is displayed against a colored 
background. With touch operation, a screen keyboard is displayed for the entering of values. 

Direct keys

Introduction
Direct keys on the HMI device are used to set bits in the I/O area of a SIMATIC S7. 

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
5690 System Manual, 07/2013,  



Direct keys enable operations with short reaction times that are, for example, a jog mode 
requirement. 

 

 Note

Direct keys are still active when the HMI device is in "offline" mode. 
 

 Note

If you operate a function key with direct key functionality in a running project, the direct key 
function is always executed, independent of the current screen contents.

 

 Note

You can only use direct keys when there is a connection via PROFIBUS DP or PROFINET IO.

Direct keys result in additional basic load on the HMI device.
 

Direct keys
The following objects can be configured as a direct key: 

● Buttons

● Function keys

You can also define image numbers in the case of HMI devices with touch operation. In this 
way, the project engineer can configure the direct keys on an image-specific basis.

For additional information on configuring direct keys, refer to "WinCC  Communication." 

Touch operation

Overview

Screen keyboard
When you touch an operating element requiring entry on the HMI device touch screen, a screen 
keyboard appears. The screen keyboard is displayed in the following cases: 

● An I/O field is selected for input.

● A password must be entered for accessing a password-protected function.

The screen keyboard is automatically hidden again when input is complete.

Based on the configuration of the operating element, the system displays different screen 
keyboards for entering numerical or alphanumerical values.

 

 Note

The screen keyboard display is independent of the configured project language.
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General procedure
The operating elements of a screen are operated by touching the touch screen.

Proceed as follows:

1. Touch the desired operating element within the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can be 
found under the respective operating element.
Examples:

– I/O field: Enter numerical, alphanumeric or symbolic values in the I/O field.

– Symbolic I/O field: Select an entry from the drop down list box.

– Slider control: Move the slider control.

Procedure for input fields
Values are entered in the project input fields. Based on your configuration, the values are 
saved to tags and transferred, for example, to the PLC.

Proceed as follows:

1. Touch the desired input field within the screen.
The screen keyboard opens. 
Depending on your configuration, you can enter values in the input field in the following 
manner:

– Numerical values, for example decimal numbers, hexadecimal numbers, binary values

– Alphanumerical values, for example digits and letters

– Date/time

2. Enter the value.

3. Confirm your entry with  or discard your entry using the button .
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Entering and editing numerical values

Numerical screen keyboard  
When you touch an operating element for numerical input on the HMI device touch screen, 
the numerical screen keyboard appears. This is the case, for example, for an input field. The 
screen keyboard is automatically hidden again when input is complete. 

Figure 10-10 Numerical screen keyboard

 

 Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen", has no effect.
 

Display formats for numerical values   
You can enter values of the following format type in numerical input fields: 

● Decimal

● Hexadecimal

● Binary

Limit test of numerical values   
Tags can be assigned limits. The current limits are indicated in the numerical screen keyboard. 
If you enter a value that lies outside of this limit, it will not be accepted, for example, 80 with a 
limit value of 78. In this case the HMI device will deliver a system event, if an alarm window is 
configured. The original value is displayed again.
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Decimal places for numerical values   
The configuration engineer can define the number of decimal places for a numerical input field. 
The number of decimal places is checked when you enter a value in this type of I/O field.

● Decimal places in excess of the limit are ignored.

● Empty decimal places are filled with "0".

Procedure   
Numerical and hexadecimal values can be entered character-by-character via the buttons on 
the numerical screen keyboard. 

Proceed as follows:

1. Touch the desired operating element within the screen.
The numerical screen keyboard opens. The existing value is displayed in the screen 
keyboard and is selected.

2. Enter the value.
You can only operate keys that are required for entering values. The keys with letters cannot 
be used, for example, for entering a decimal value. Which keys can be operated can be 
seen from the appearance of the keys.
You have the following options to enter a value:

– The selected value is deleted when you enter the first character. Completely reenter the 
value.

– Use the  and  keys to move the cursor within the current value. You can 
now edit the characters of the current value or add characters.
Use the  key to delete the next character to the left of the cursor. If the value is 
selected, use this key to delete the selected part of the value.

– Change the sign of the value using the  key.

– Use the  key to display the tooltip of the I/O field.
This key is only enabled if a tooltip was configured for the input object or for the current 
screen. 

3. Use the  key to confirm your entry or cancel it with . Either action closes 
the screen keyboard.

Result
You have changed the numerical value or entered a new one. 

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
5694 System Manual, 07/2013,  



Entering and editing alphanumerical values

Alphanumerical screen keyboard  
When you touch an operating element for numerical input on the HMI device touch screen, 
the alphanumerical screen keyboard appears. This is the case, for example, for an input field. 
The screen keyboard is automatically hidden again when input is complete. 

Figure 10-11 Alphanumerical screen keyboard, normal level

 

 Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen", has no effect.
Language change

Language change in the project has no influence on the alphanumerical screen keyboard. 
The entry of Cyrillic or Asian characters is therefore not possible.  

 

Keyboard levels 
The alphanumerical screen keyboard has various levels. 

● Normal level

● Shift level

The key labels change when you change levels with the  key.

Procedure   
Alphanumerical values can be entered character-by-character via the buttons on the 
alphanumerical screen keyboard. 

Proceed as follows:
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1. Touch the desired operating element within the screen.
The alphanumerical screen keyboard opens. The existing value is displayed in the screen 
keyboard and is selected.

2. Enter the value.
You have the following options to enter a value:

– The selected value is deleted when you enter the first character. Completely reenter the 
value.

– Use the  and  keys to move the cursor within the current value. You can 
now edit the characters of the current value or add characters.
Use the  key to delete the next character to the left of the cursor. If the value is 
selected, use this key to delete the selected part of the value.

– Use the  key to toggle between keyboard levels of the screen keyboard. On 
switchover, the key assignment of the screen keyboard changes.

– Use the  key to display the tooltip of the I/O field.
This key is only enabled if a tooltip was configured for the input object or for the current 
screen. 

3. Use the  key to confirm your entry or cancel it with . Either action closes 
the screen keyboard.

Result
You have changed the alphanumeric value or entered a new one. 

Display tooltip for touch control

Purpose   
The configuration engineer uses tooltips to provide additional information and operating 
instructions. The configuration engineer can configure tooltips for screens and operating 
elements. 

The tooltip of an I/O field may, for example, contain information about the value to be entered. 

Figure 10-12 Tooltip for an I/O field, example
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Opening tooltips for operating elements
1. Touch the required operating element.

The screen keyboard opens. The representation of the  key indicates whether a 
tooltip was configured for the operating element or for the current screen.

2. Touch the  key of the on-screen keyboard.
The tooltip for the operating element is displayed. If there is no tooltip for the selected screen 
object, the tooltip for the current screen is displayed if it has been configured.
You can scroll through the contents of long tooltips using the   and  buttons.

 

  Note
Switching between displayed tooltips  

The configuration engineer can configure a tooltip for an I/O field and the associated 
screen. You can switch between two tooltips by touching the tooltip window. 

 

3. Close the displayed tooltip by pressing .

Alternative procedure
Depending on your configuration, tooltips can also be called via a configured operating 
element. 

Additional information on this topic may be available in your plant documentation. 

Key operation

Control keys

Introduction     
The following tables list the control keys available to operate the project. For detailed 
information, refer to the description of the individual operating elements.

 

 Note

The availability of system keys is determined by the HMI device used. 
 

Visualizing processes (Comfort/Advanced)
10.14 Operating in Runtime

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5697



Selecting operating elements

Key Function Description

+ 
Tabulator       Selects the next or previous operating element 

based on the configured tab sequence.

Cursor keys     Selects the next operating element on the left, right, 
above or below the current screen object.
Navigates in the operating element.

Operating operating elements     

Key Function Description
+ 
 + 
 + 
 + 

Positioning cursor Positions the cursor within an operating element, for 
example, in an I/O field.

Scrolling back         Scrolls the list back by one page.
+ Scroll to start Scrolls to the start page of a list.

Scrolling up         Scrolls the list up by one page.
+ Scroll to end Scrolls to the end of a list.

ENTER key       ● Controls buttons.
● Applies and ends an entry.
● Opens a selection list.
● Toggles between character mode and standard 

mode within an input field.
A single character is selected in character mode. 
In this mode, you can scroll within the character 
set using the cursor keys.     

Cancel       ● Deletes the input characters of a value and 
restores the original value.

● Closes the active dialog.
Delete characters     Deletes the next character to the right of the current 

cursor position.
Delete characters       Deletes the character to the left of the current cursor 

position.
+ Open selection list     Opens a selection list.
+ Accept value Accepts the value selected in the selection list 

without closing the list.
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Enter hotkey

Key Function Purpose
Toggle (numbers/letters)   Toggles the assignment from numbers to letters.

● No LED is lit:
The number assignment is enabled. Pressing 
the key once switches to letter assignment.

● An LED is lit:
The left or right letter assignment is enabled. 

Each time the key is pressed, the system toggles 
between the left letter assignment, the right letter 
assignment and the number assignment.       

Shift
(upper/lower case)   

Use in hotkeys, for example, for switching to 
uppercase letters.

Toggle to additional keyboard 
layout 

Some of the keys contain a blue special character 
on their bottom left corner, for example, the "%" 
character. To input these characters, press the 
relevant key in combination with the special 
character key shown on the left.

General control function   Used in hotkeys, for example, for navigating trend 
views.

General control function   Used in hotkeys, for example, for the "Status/Force" 
screen object.

Acknowledge alarms

Key Function Purpose
Acknowledge     Acknowledges the currently displayed error alarm 

or all alarms of an alarm group (group 
acknowledgment).   
The LED is lit as long as an unacknowledged alarm 
is active.   

 

Displaying infotext     

Key Function Description
Display tooltip     Opens the configured tooltip for the selected object, 

for example, alarm or I/O field. The LED is lit if a 
tooltip is available for the selected object. 
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Function keys

Function keys
Function key assignment is defined during configuration. The configuration engineer can 
assign function keys globally and locally.

Function keys with global function assignment
A globally assigned function key always triggers the same action on the HMI device or in the 
PLC irrespective of the screen displayed. Such an action could be, for example, the activation 
of a screen or the closure of an alarm window.

Function keys with local function assignment
A function key with local function assignment is screen-specific and is therefore only effective 
within the active screen.

The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one. 
The local assignment function takes priority over the global setting.

The configuration engineer can assign function keys in such a way that you can operate 
operating elements with function keys, for example, the alarm view, trend view, recipe view or 
status / force. 

General procedures

Introduction
The control keys and function keys of the HMI device are available for key operation. 

General procedure 
The operating elements of a screen are operated using the control keys of the HMI device.

Proceed as follows:

1. Continue pressing the  key or the cursor keys until the required operating element is 
selected in the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can be 
found under the respective operating element.
Examples:

– I/O field: Enter numerical, alphanumeric or symbolic values in the I/O field.

– Slider control: Move the slider control.

3. Confirm the your entry with  or cancel it with .
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Entering and editing numerical values

Display formats for numerical values 
You can enter values of the following format type in numerical input fields: 

● Decimal

● Hexadecimal

● Binary

Limit test of numerical values 
Tags can be assigned limits. If you enter a value that lies outside of this limit, it will not be 
accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver a 
system event, if an alarm window is configured. The original value is displayed again.

Procedure
Numerical and hexadecimal values can be entered in character mode using the system keys. 

Proceed as follows:

1. Select the input field within the screen using the  key.
The existing value is selected in the input field. 

2. Enter the value using the numerical keypad.
You have the following options to enter a value:

– The existing value is deleted when you enter the first character. Completely reenter the 
value.

– Press  and a cursor key simultaneously. This step cancels the field content selection. 
Move the cursor in the existing value. You can now edit the characters of the current 
value or add characters.
The  key deletes the next character to the right of the cursor. Use the  key to 
delete the next character to the left of the cursor. 
To enter the hexadecimal characters "A" to "F", switch the numerical keypad to alphabet 
mode using the  key.

– The lit LED of the  key indicates that a tooltip is available for the selected object or 
the active screen.
Use the key  to view the tooltip for the operating element or active screen.

3. Confirm your entry with the  key.

Result
You have changed the numerical value or entered a new one. 
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Entering and editing alphanumerical values

Procedure
Alphanumerical values can be entered in character mode using the system keys. 

Proceed as follows:

1. Select the input field within the screen using the  key.
The existing value is selected in the input field. 

2. Enter the value using the system keys.
You have the following options to enter a value:

– The existing value is deleted when you enter the first character. Completely reenter the 
value.

– Press  and a cursor key simultaneously. This step cancels the field content selection. 
Move the cursor in the existing value. You can now edit the characters of the current 
value or add characters.
The  key deletes the next character to the right of the cursor. Use the  key to 
delete the next character to the left of the cursor. 
Switch the numerical keypad to alphabet mode using the  key to enter letters. 

– The lit LED of the  key indicates that a tooltip is available for the selected object or 
the active screen.
Use the key  to view the tooltip for the operating element or active screen.

3. Confirm your entry with the  key.

Result
You have changed the alphanumeric value or entered a new one. 

Enter characters using the alphanumeric keyboard
Using the same keys of the alphanumeric keyboard you can enter up to six different characters. 
The entry result depends on the combination of the keys pressed.

The values "5", "M", "m", "N", "n" and "%" are entered using the same key  of the keyboard. 
Use the keys ,  and  to select the key mode.

The following table shows the entry options using the key .

Key Key Key Result
No LED is lit. Not relevant Not pressed 5
Left LED is illuminated. Not pressed Not pressed m
Left LED is illuminated. Pressed Not pressed M
Right LED is illuminated. Not pressed Not pressed n
Right LED is illuminated. Pressed Not pressed N
Not relevant Not relevant Pressed %
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Display tooltip for key operation

Use   
The configuration engineer uses tooltips to provide additional information and operating 
instructions. The configuration engineer can configure tooltips for screens and operating 
elements. 

The tooltip of an I/O field may, for example, contain information about the value to be entered. 

Figure 10-13 Tooltip for an I/O field, example

The lit LED of the  key indicates that a tooltip was configured for the selected screen object 
or for the active screen.

Procedure
Proceed as follows:

1. Press the  key.
The tooltip for the selected screen object is displayed. If there is no tooltip for the selected 
screen object, the tooltip for the current screen is displayed if it has been configured.
You can scroll the contents of longer tooltips using the cursor keys  and .

 

  Note
Switching between displayed infotext  

The configuration engineer can configure a tooltip for an I/O field and the associated 
screen. You can switch between two tooltips by pressing the   key.

 

2. Close the tooltip by pressing the  key.

Alternative procedure
Depending on your configuration, tooltips can also be opened with a function key or via an 
existing operating element. 

Additional information on this topic may be available in your plant documentation. 
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Mouse and keyboard operation

Operation with the keyboard
The navigation options listed in the table can be used for keyboard operations in a screen.     

Navigation PC SIMATIC Panel PC
Next field right/left <Shift+Right> / <Shift+Left> <Right> / <Left>
Next field up/down <Shift+Down> / <Shift+Up> <Down> / <Up>
To the right/left in the field <Right> / <Left> <Shift+Right> / <Shift+Left>

The other keys have identical functions on the PC and the SIMATIC Panel PC: 

Key Function
<Enter> Applies a value (e.g. in unmarked input fields) or opens a 

selection list. 
If the I/O field is marked (highlighted in color), 
WinCC Runtime will switch to the special editing mode. Only 
one character at any time is marked in the field. 
Use the cursor keys <Up>/<Down> to scroll through a 
character table. 
Use the cursor keys Right/Left to move the cursor to the next 
or previous entry position. 
Press <Enter> or <Esc> to exit from the entry mode. The 
characters entered up to this point will be either applied or 
discarded. 

<Esc> Interrupts the input.
<Tab> Selects the next available screen object in the configured tab 

sequence. 
<Shift+Tab> Selects the previously available screen object in the 

configured tab sequence. 
<F1> -... <F12>, 
<Shift+F1>, ..., <Shift+F12>

On the PC: Triggers a function, e.g. screen selection. 

<F1>, ... or <S1>, ... or <K1>, ... On the SIMATIC Panel PC: triggers a global or local function. 

 
 

 CAUTION

If you press a function key after a screen change, the associated function in the new screen 
may be triggered before the new screen is fully displayed.
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Controlling Windows with the keyboard
You may also use the keyboard to control the operating system of your HMI device. See your 
Windows manual for detailed information. The most important key combinations for SIMATIC 
Panel PCs are listed in the following table. 

Navigation HMI device
Open start menu <Ctrl+Esc>
Show the shortcut menu of the selected element <Shift+F10>
Select all <Ctrl+A>
Display properties of the selected element <Ctrl+Enter>
Explorer:  
Change folder <F4>
Change display areas <F6>
Enable menu bar <F10>
Dialogs:  
Go to next field <Tab>
Back to previous field <Shift+Tab>
Open next tab <Ctrl+Tab>
Open previous tab <Ctrl+Shift+Tab>

Operation with the mouse
A lightning symbol attached to the mouse pointer indicates that the screen object, for example 
a switch, may be operated with the mouse.     

 

 Note

If a screen object is covered by another, e.g. a button from a rectangle with a transparent fill, 
it is not possible to operate with the mouse in runtime.

The screen object can be operated with the keyboard.
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10.14.3.5 Project security

Overview

Design of the security system 
The configuration engineer can protect the operation of a project by implementing a security 
system. 

The security system is based on authorizations, user groups and users. 

If you use an operator control with access protection, the HMI device first requests that you 
log on. A logon screen is displayed in which you enter your user name and password. After 
logging on, you can operate the operator controls for which you have the necessary 
authorizations. 

The logon dialog can be set up by the configuration engineer via an individual operator control. 

In the same way, the configuration engineer can set up an operator control to log off. After 
logging off, objects assigned access protection can no longer be operated; to do so, log on 
again. 

User groups and authorizations  
Project-specific user groups are created by the configuration engineer. The "Administrators" 
and "Users" groups are included in all projects by default. User groups are assigned 
authorizations. Authorization required for an operation is specifically defined for each individual 
object and function in the project.

Users and passwords   
Each user is assigned to exactly one user group. 

The following people are allowed to create users and assign them passwords: 

● The configuration engineer during configuration

● The administrator on the HMI device

● A user with user administration authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.

Logoff times 
A logoff time is specified in the system for each user. If the time between any two user actions, 
such as entering a value or changing screens, exceeds this logoff time, the user is automatically 
logged off. The user must then log on again to continue to operate objects assigned access 
protection.
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Backup and restore      
The user data is encrypted and saved on the HMI device to protect it from loss due to power 
failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be 
backed up and restored. This prevents you having to enter all of the data again on another 
HMI device. 

 

 Note

The currently valid user data is overwritten in the following cases:
● Depending on settings for a new download of the project.
● Upon restore of a backed-up project
● Upon import of the user administration via an operator control. The newly downloaded or 

restored user data and passwords take effect immediately.
 

Displaying users

User view

Use
The user view is used by the administrator to manage user accounts, group assignments and 
user passwords.         

Users can change their passwords and logoff times.

Layout
The user view contains four columns for the user, password, group and logoff time. The 
passwords are encrypted by means of asterisks.     

● All users on the HMI device are displayed in the User view to the administrator or to a user 
with administrator authorizations.

● When user administration authorization is lacking, only the personal user entry is displayed.
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Operation
Depending on the configuration you can:     

● Manage users, e.g. create, delete.

● Change existing user data.

● Export or import user data.
 

  Note

On an HMI device the number is limited to 100 users and one PLC user. This restriction 
does not apply to PCs. On a PC, the maximum number of users is restricted by the physical 
memory. 

 

Runtime behavior
The user view on the HMI devices OP 73, OP 77A and TP 177A also displays the "PLC User" 
with administrator privileges who is logged on in Runtime.

Changing existing user data   
The following options are available for the changes that can be made:

● The administrator or a user with user administration authorization can change the data for 
all users on the HMI device system in the user view.

– User name

– Group assignment

– Password

– Logoff times

● A user without user administration authorization can only change their own user data:

– Password

– Logoff time
 

  Note

If you enter the value "0" in the logoff time, user is not logged off automatically.
 

Export or import user data
A user view contains all users, passwords, group assignments and logoff times set up on the 
HMI device. To not have to enter all data again on another HMI device, you can export the 
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user view and then import it to another device. But you can only do this if this function has 
been configured.     

 

 Note

Do not export the password list immediately after changing it. Exit the "User view" object after 
making changes and wait until the changes have been written to the internal Flash memory 
before performing the export.

 

 Note

The currently valid user data are overwritten during an import. The imported user data and 
passwords are valid immediately.

 

Simple user view

Use   
On HMI devices with a small display, the simple user view is used to display users on the HMI 
device. 

 

 Note

The "Simple user view" object cannot be operated dynamically with a script.
 

Layout
The appearance depends on the authorizations. 

● All users on the HMI device are displayed in the User view to the administrator or to a user 
with administrator authorizations.

● When user administration authorization is lacking, only the personal user entry is displayed.  
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Operation  
Depending on the configuration you can:

● Manage users, e.g. create, delete.

● Change existing user data.

● Export or import user data.
 

  Note

On an HMI device the number is limited to 100 users and one PLC user. This restriction 
does not apply to PCs. On a PC, the maximum number of users is restricted by the physical 
memory. 

 

User logon

Touch and key operation

Logon dialog    
Use the logon dialog to log on to the security system of the HMI device. Enter your user name 
and password in the logon dialog. 

The logon dialog opens in the following cases: 

● You use an operator control with access protection.

● You press an operator control that was configured for displaying the logon dialog.

● You enable the "<ENTER>" entry in the simple user view.

● You enable a blank entry in the extended user view.

● The logon dialog will be automatically displayed when the project is started, depending on 
the configuration.

Requirement
The logon dialog is open.
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Procedure for touch operation
Proceed as follows:

1. Enter the user name and password.
Touch the corresponding input field. The alphanumerical screen keyboard is displayed. 

2. Select "OK" to confirm logon.

Procedure for key operation
Proceed as follows:

1. Select the "User" input field within the logon dialog by pressing the  key.

2. Enter the user name using the system keys.
Switch the numerical keypad to alphabet mode using the  key to enter letters. 

3. Use the  key to select the "Password" input field.

4. Enter the password using the system keys.

5. Confirm your entries with "OK".
 

  Note

The user name is not case sensitive. 

The password is case sensitive. 
 

Result
After successful logon to the security system, you can execute functions on the HMI device 
which are access protected and for which you have authorization.

An alarm is output if an incorrect password has been entered and if an alarm view was 
configured. 

Mouse and keyboard operation

Requirement    
The logon dialog is open.

Procedure for mouse operation
Proceed as follows:

1. Click in the input field. The alphanumerical on-screen keyboard is displayed.

2. Enter the user name and the password.

3. Click "OK" in the logon dialog.
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Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the "Users" input field is selected.

2. Enter the user name and the password.

3. Confirm your entries with "ENTER."
 

  Note

The user name is not case-sensitive. 

The password is case-sensitive. 
 

Result
After successful logon to the security system, you can execute functions on the HMI device 
which are access protected and for which you have authorization.

An alarm is output if an incorrect password has been entered and if an alarm view was 
configured. 

User logoff

Requirement
You have logged into the security system of the HMI device.

Procedure
You have the following options for logging off:

● You press an operator control that was configured for logoff.

● You will be logged off automatically if you are not operating the project and if the logoff time 
has been exceeded.

You will also be automatically logged off if you enter an incorrect password. 

Result
You are no longer logged into the project. In order to use an operator control with access 
protection, you first have to log on again. 
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Creating users

Touch operation 

Requirement  
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

  Note

Runtime users must be assigned to a user group. The user group is created in the 
Engineering System. The designation of the user group is language-dependent.

 

  Note

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Click the "<New user>" entry in the user view. A dialog opens.

2. Enter the desired user name and password.
Touch the corresponding text box. The alphanumerical on-screen keyboard is displayed.

3. Click on the text box of the group. A dialog opens.

4. Assign the user to a group. Select  and  to scroll the selection list.

5. Touch the required entry in the drop down list box.
The selected entry is accepted as input.

6. Touch the text box "Logoff time". The on-screen keyboard is displayed.

7. Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

8. Confirm your entries with "OK."
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Result
The new user is created. 

Key operation

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator. 

● A user group has been created.
 

  Note

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

  Note

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Select the user view using the key TAB  or using the cursor keys.

2. Select the entry "<New user>" in the user view with the cursor keys and confirm with ENTER .
The following dialog opens:

3. Enter the desired user name using the system keys.

4. Select the next text box with the TAB  key and enter a password using the system keys.
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5. Confirm your entries with "OK."
The following dialog opens:

6. Select the "Group" selection box with TAB .

7. Assign the user to a group.

– Select ENTER  to open the drop down list box. The drop down list box opens.

– Select the required entry using   or .

– Confirm your entry by pressing the key ENTER .

8. Select the text box "Logoff time" with TAB .

9. Enter the desired logoff time using the system keys.
Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

10.Confirm your entries with "OK."

Creating users in the advanced user view
Proceed as follows:

1. Select the user view with the TAB  key via the configured tab order.

2. Select a blank line with the  or  keys.

3. Select the desired field in the blank line of the user view with the  or  keys.

4. Confirm your entry by pressing the key ENTER .

5. Enter the desired user data:

– Enter the data using the system keyboard. To enter letters, switch the numerical keypad 
to letter assignment using the key A-Z .

– Assign the user to one of the groups from the drop down list box. Open the drop down 
list box with the ENTER  key and select the desired entry with the  or  keys.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

6. Confirm your entry by pressing the key ENTER .

Result
The new user is created. 
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Operation with the mouse

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

  Note

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

  Note

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Click the "<New User>" entry in the user view.
The following dialog opens:

2. Enter the desired user name and password.
Click in the corresponding input field. The alphanumerical on-screen keyboard is displayed.

3. Click "OK".
The following dialog opens:

4. Assign the user to a group.

5. Click the required entry in the selection list.
The selected entry is accepted as input.
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6. Click in the "Logoff time" input field. The on-screen keyboard is displayed.

7. Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

8. Confirm your entries with "OK."

Creating users in the advanced user view
Proceed as follows:

1. Double-click the desired field in the blank line of the user view.
The corresponding on-screen keyboard is displayed. 

2. Enter the respective user data in the field:

– Assign the user to one of the groups from the drop down list box.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

Result
The new user is created. 

Operation with the keyboard

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

  Note

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

  Note

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "
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Creating users in the simple user view
Proceed as follows:

1. Press the <TAB> key until the user view is selected.

2. Select the "<New user>" entry in the user view using the cursor keys and confirm it 
with <ENTER>.
The following dialog opens:

3. Enter the user name.

4. Press the <Tab> key to move to the next input field and enter a password.

5. Confirm your entries with <ENTER>.
The following dialog opens:

6. Select the "Group" selection list using the <TAB> key.

7. Assign the user to a group.

– Press <ENTER> to open the selection list. The drop down list box opens.

– Select the entry. Use the <Home>,<End>,<Up> and <Down> keys accordingly.

– Confirm the selection with <ENTER>.

8. Change to the "Logoff time" input field using the <TAB> key.

9. Enter the desired logoff time.
Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

10.Confirm your entries with <ENTER>.

Creating users in the advanced user view
Proceed as follows:

1. Press the <TAB> key until the user view is selected.

2. Select an empty line in the user view using the cursor keys.

3. Select the desired field in the empty line of the user view. Use the <Up> and <Down> keys 
accordingly.

4. Confirm the selection with <ENTER>.
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5. Enter the desired user data:

– Enter the user name and the password.

– Assign the user to one of the groups from the drop down list box. Open the selection 
list by pressing <ENTER> and then select the entry using the <Up> and <Down> cursor 
keys.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

6. Confirm your entries with <ENTER>.

Result
The new user is created. 

Changing user data

Key operation

Requirement
The user view is open.

Your authorization level determines the data you can edit:
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● You are an administrator or a user with user administration authorization. In these cases 
you are allowed to change the data for all the users on the HMI device in the user view:

– User name

– Group assignment

– Password

– Logoff time

● You are a user without user administration authorization. In this case you are only allowed 
to change your personal user data:

– Password

– Logoff time, if configured
 

  Note

You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging 
on via the PLC.

 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime 
are not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Changing user data in the simple user view
Proceed as follows:

1. Confirm your entry by pressing the key TAB .

2. In the user view, use the cursor keys to select the user whose user data you want to change. 
Confirm your entry by pressing the key ENTER .

3. When entering the data, use exactly the same procedure as for creating a user.

Changing user data in the advanced user view
Proceed as follows:

1. Confirm your entry by pressing the key TAB .

2. Use the cursor keys to select the field in which you want to change data. Confirm your entry 
by pressing the key ENTER .

3. When entering the data, use exactly the same procedure as for creating a user.

Result
User data have been changed. 
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Touch operation

Requirement
The user view is open.

Your authorization level determines the data you can change:

● You are an administrator or a user with user administration authorization. In these cases 
you are allowed to change the data for all the users on the HMI device in the user view:

– User name

– Group assignment

– Password

– Logoff time

● You are a user without user management authorization. In this case you are only allowed 
to change your personal user data:

– Password

– Logoff time, if configured
 

  Note

You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging 
on via the PLC.

 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime 
are not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Changing user data in the simple user view
Proceed as follows:

1. In the user view, touch the user whose user data you want to change.

2. When entering the data, use exactly the same procedure as for creating a user.

Changing user data in the advanced user view
Proceed as follows:

1. In the user view, touch the user whose user data you want to change.

2. When entering the data, use exactly the same procedure as for creating a user.
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Result
User data have been changed. 

Mouse and keyboard operation

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.
 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime are 
not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Procedure for mouse operation
Proceed as follows:

1. Click the user to be deleted in the user view.

2. Delete the user name.

Procedure for keyboard operation
Proceed as follows:

1. Select the user view using the <TAB> key or the cursor keys.

2. Select the user in the user view by means of cursor keys.

3. Press <DEL> to delete the user.

Result
The user has been deleted and may no longer log onto the project. 
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Deleting users

Touch and key operation

Requirement    
● You have opened a screen that contains the user view.

● You must be logged on with administrator rights or be authorized for user management to 
delete users.

 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime are 
not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Procedure for touch operation
Proceed as follows:

1. Touch the user to be deleted in the user view.

2. Delete the user name.

Procedure for key operation
Proceed as follows:

1. Select the user view using the  key or the cursor keys.

2. Select the user in the user view by means of cursor keys.

3. Press  to delete the user.

Result
The user has been deleted and may no longer log onto the project. 
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Mouse and keyboard operation

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.
 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime are 
not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Procedure for mouse operation
Proceed as follows:

1. Click the user to be deleted in the user view.

2. Delete the user name.

Procedure for keyboard operation
Proceed as follows:

1. Select the user view using the <TAB> key or the cursor keys.

2. Select the user in the user view by means of cursor keys.

3. Press <DEL> to delete the user.

Result
The user has been deleted and may no longer log onto the project. 
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10.15 Performance features

10.15.1 Engineering system

Engineering system
The following tables help you assess whether your project still meets the performance 
specifications of the Engineering System.   

In addition to the specified limits, allowances must also be made for restrictions imposed by 
main memory resources. WinCC uses up to 2 GB of RAM, depending on the operating system. 
It is nonetheless useful to install more than 2 GB of main memory on the PC if running many 
applications with high memory requirements in parallel.

Project system limits

 WinCC
Number of HMI devices in the project 35
Number of HMI tags 1) 80.000
Number of logging tags 8.000
Number of blocks (faceplates, user data types)3) 10.000
Number of screens 3.000
Number of screen objects per screen 3.000
Number of screen objects 320.000
Number of alarms 2) 3) 20.000
Number of texts 3) 300.000
Number of text lists and graphic lists 3) 10.000
Number of entries per text list 3.000
Number of languages 32
Number of global libraries 3) 20
Number of objects in the project library 3) 300.000

1) Including logging tags.
2) With an average of 5 texts and a dynamic parameter
3) Including the objects configured in the "Program PLC" area

HMI device system limits

 WinCC
Number of HMI tags 1) 80.000
Number of logging tags 8.000
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 WinCC
Number of logs 500
Number of screens 1000
Number of screen objects per screen 3.000
Number of screen objects 320.000
Number of function lists 30.000
Number of animations and local scripts 50.000
Number of user-defined functions 1.000
Number of tasks 500
Number of alarms 2) 20.000
Number of recipes 1.000
Number of recipe elements 10.000
Number of texts 100.000
Number of text lists and graphic lists 1.000
Number of entries per text list 3.000
Number of users 200
Number of reports 300

1) Including logging tags.
2) With an average of 5 texts and a dynamic parameter

System limits during migration
You can migrate projects which are beyond the specified system limits in one or more areas.

An alarm will be output if migration creates a project whose limits are beyond the specified 
system limits. You must then adapt the project after migration to within the specified system 
limits to ensure safe operation in WinCC.

See also
Basic Panel (Page 5729)

Panel (Page 5732)

Mobile Panel (Page 5736)

Multi Panel (Page 5740)

Comfort Panel (Page 5744)

WinCC Runtime Advanced (Page 5749)
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10.15.2 Basic Panel

Basic Panel
The following table helps you assess whether your project meets the performance features of 
the HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         

Tags

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of tags in the project 250 500 250 (mono)
500 (color)

500 500 500

Number of PowerTags -- -- -- -- -- --
Number of elements per array 100 100 100 100 100 100
Number of local tags -- -- -- -- -- --

Alarms

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of alarm classes 32 32 32 32 32 32
Number of discrete alarms 200 200 200 200 200 200
Number of analog alarms 15 15 15 15 15 15
Length of an alarm in characters 80 80 80 80 80 80
Number of process values per alarm 8 8 8 8 8 8
Size of the alarm buffer 256 256 256 256 256 256
Number of queued alarm events 64 64 64 64 64 64

Screens

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of screens 50 50 50 50 50 50
Number of fields per screen 30 30 30 30 30 30
Number of tags per screen 30 30 30 30 30 30
Number of complex objects per screen 1) 5 5 5 5 5 5
Number of array elements per screen 2) 100 100 100 100 100 100
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1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

2) Array elements contained in recipes are included in the count. 

Recipes

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of recipes 5 5 5 5 5 5
Number of elements per recipe1) 20 20 20 20 20 20
User data length in bytes per data record -- -- -- -- -- --
Number of data records per recipe 20 20 20 20 20 20
Reserved memory for data records in the 
internal Flash

40 KB 40 KB 40 KB 40 KB 40 KB 40 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of logs -- -- -- -- -- --
Number of entries per log (including all log 
segments) 1)

-- -- -- -- -- --

Number of log segments -- -- -- -- -- --
Cyclic trigger for tag logging -- -- -- -- -- --
Number of tags that can belogged per log -- -- -- -- -- --

1) The number of entries for the "segmented circular log" logging method is the maximum 
number for all segmental circular logs. The product of the number of segmental circular 
logs and the number of data records per segmental circular log may not exceed the 
system limit.

Trends

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of trends 25 25 25 25 25 25
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Text lists and graphics lists

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of graphics lists 100 100 100 100 100 100
Number of text lists 150 150 150 150 150 150
Number of entries per text or graphics list 30 30 30 30 30 30
Number of graphic objects 500 500 500 500 500 500
Number of text elements 500 500 500 500 500 500

Scripts

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of scripts -- -- -- -- -- --

Communication

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of connections 4 4 4 4 4 4
Number of connections based on "SIMATIC 
HMI HTTP"

-- -- -- -- -- --

For communication with S7-1200 PLCs, please note that no more than 200 tags should be 
configured per controller. If multiple HMI devices access one controller, this limit applies to all 
HMI devices.
A maximum of 4 HMI devices can access an S7-1200 at the same time. A maximum of 8 
controllers can be addressed by a panel.

Help system

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of characters in a help text 320 320 320 320 320 320

Languages

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of runtime languages 5 5 5 5 5 5
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Scheduler

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Time-triggered tasks 1) -- -- -- -- -- --

1) Event-triggered tasks are irrelevant for the system limits

User administration

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of user groups 50 50 50 50 50 50
Number of authorizations 32 32 32 32 32 32
Number of users 50 50 50 50 50 50

Project

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Size of the project file "*.srt" 512 kB 512 kB 512 kB 512 kB 1024 kB 1024 kB

See also
Engineering system (Page 5725)

10.15.3 Panel

Introduction
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         
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Tags

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of tags in the project 1000 1000 1000 500 1000 2048
Number of PowerTags -- -- -- -- - --
Number of elements per array 50 100 1000 250 1000 1000
Number of local tags -- -- 500 -- 500 1000

Alarms

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of alarm classes 32 32 32 32 32 32
Number of discrete alarms 500 1000 1000 1000 2000 4000
Number of analog alarms 3 5 50 15 50 200
Length of an alarm in characters 80 80 80 80 80 80
Number of process values per alarm 8 8 8 8 8 8
Size of the alarm buffer 150 256 256 256 256 512
Number of queued alarm events 50 64 64 64 64 250

Screens

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of screens 500 500 500 250 500 500
Number of fields per screen 20 30 30 30 50 200
Number of tags per screen 20 30 30 30 50 200
Number of complex objects per 
screen 1)

5 5 5 5 5 10

1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of recipes -- 5 100 5 100 300
Number of elements per recipe1) -- 20 200 20 200 1000
User data length in bytes per data 
record

-- -- 800 -- 800 4000
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of data records per recipe -- 20 200 20 200 500
Reserved memory for data records in 
the internal Flash

-- 40 KB 32 KB 40 KB 32 KB 64 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of logs -- -- -- -- -- 20
Number of entries per log (including all 
log segments) 1)

-- -- -- -- -- 10000

Number of log segments -- -- -- -- -- 400
Cyclic trigger for tag logging -- -- -- -- -- 1 s
Number of tags that can be logged per 
log

-- -- -- -- -- 2048

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of trends -- -- -- 25 50 300
Number of measured values per trend -- -- -- 999 999 999

Text lists and graphics lists

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of graphics lists -- -- -- 100 100 400
Number of text lists 150 300 300 300 300 500
Number of entries per text or graphics 
list

30 30 30 30 30 256

Number of graphic objects 500 1000 1000 1000 1000 1000
Number of text elements 1000 1000 2500 1000 2500 10000
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Scripts

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of scripts -- -- -- -- -- 50

Communication

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of connections 2 4 4 4 4 6
Number of connections based on 
"SIMATIC HMI HTTP"

-- -- -- -- 4 8

Maximum number of connected 
Sm@rtClients (including a service 
client)

-- -- -- -- 2 3

In the case of communication with S7-1200 PLCs, please note that a maximum of 200 tags 
should be configured per controller. When multiple HMI devices access one PLC, this limit 
applies to all HMI devices.
A maximum of 4 HMI devices can access an S7-1200 at the same time. A panel can address 
a maximum of 8 PLCs.

Help system

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of characters in a help text 320 320 320 320 320 320

Languages

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of runtime languages 5 5 5 5 5 16

Scheduler

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Time-triggered tasks 1) -- -- 10 -- 10 48

1) Event-triggered tasks are not relevant for the system limits

Visualizing processes (Comfort/Advanced)
10.15 Performance features

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5733



User administration

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of user groups 25 50 50 50 50 50
Number of authorizations 32 32 32 32 32 32
Number of users 25 50 50 50 50 50

Project

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Size of the project files "*.fwc", "*.srt" 256 KB 320 KB 1 MB 6":512 KB 2 MB 4 MB

See also
Engineering system (Page 5725)

10.15.4 Mobile Panel

Mobile Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         

Tags

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of tags in the project 1000 2048 2048 2048 2048
Number of PowerTags - -- -- -- --
Number of elements per array 1000 1000 1000 1000 1000
Number of local tags 500 1000 1000 1000 1000
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Alarms

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of alarm classes 32 32 32 32 32
Number of discrete alarms 2000 4000 4000 4000 4000
Number of analog alarms 50 200 200 200 200
Length of an alarm in characters 80 80 80 80 80
Number of process values per 
alarm

8 8 8 8 8

Size of the alarm buffer 256 512 512 512 512
Number of queued alarm events 64 250 250 250 250

Screens

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of screens 500 500 500 500 500
Number of fields per screen 50 200 200 200 200
Number of tags per screen 50 200 200 200 200
Number of complex objects per 
screen 1)

5 10 10 10 10

1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of recipes 100 300 300 300 300
Number of elements per recipe1) 200 1000 1000 1000 1000
User data length in bytes per data 
record

800 4000 4000 4000 4000

Number of data records per 
recipe

200 500 500 500 500

Reserved memory for data 
records in the internal Flash

32 KB 64 KB 64 KB 64 KB 64 KB

1) If arrays are used, each array element counts as one recipe element
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Logs

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of logs -- 20 20 20 20
Number of entries per log 
(including all log segments) 1)

-- 10000 10000 10000 10000

Number of log segments -- 400 400 400 400
Cyclic trigger for tag logging -- 1 s 1 s 1 s 1 s
Number of tags that can be 
logged per log

-- 2048 2048 2048 2048

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of trends 50 300 300 300 300

Text lists and graphics lists

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of graphics lists 100 400 400 400 400
Number of text lists 300 500 500 500 500
Number of entries per text or 
graphics list

30 256 256 256 256

Number of graphic objects 1000 1000 1000 1000 1000
Number of text elements 2500 10000 10000 10000 10000

Scripts

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of scripts -- 50 50 50 50
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Communication

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of connections 4 6 6 6 6
Number of connections based on 
"SIMATIC HMI HTTP"

4 8 8 8 8

Maximum number of connected 
Sm@rtClients (including a 
service client)

2 2 8'': 3
10": 2

8'': 3
10": 2

8'': 3
10": 2

In the case of communication with S7-1200 PLCs, please note that a maximum of 200 
tags should be configured per controller. When multiple HMI devices access one PLC, 
this limit applies to all HMI devices.
A maximum of 4 HMI devices can access an S7-1200 at the same time. A panel can 
address a maximum of 8 PLCs.

 

Mobile Wireless

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of zones -- -- 254 254 --
Number of effective ranges -- -- -- 127 --
Number of assigned 
transponders - zones

-- -- 255 255 --

Number of assigned 
transponders - effective ranges

-- -- -- 127 --

Number of effective ranges 
(RFID)

-- -- -- -- 127

Number of RFID tags that can be 
assigned to effective ranges 
(RFID) in a project

-- -- -- -- 127

Help system

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of characters in a help 
text

320 320 320 320 320
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Languages

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of runtime languages 5 16 16 16 16

Scheduler

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Time-triggered tasks 1) 10 48 48 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of user groups 50 50 50 50 50
Number of authorizations 32 32 32 32 32
Number of users 50 50 50 50 50

Project

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Size of the project file "*.fwc" 2 MB 6 MB 6 MB 6 MB 6 MB

See also
Engineering system (Page 5725)

10.15.5 Multi Panel

Multi Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.
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In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         

Tags

 MP 177 MP 277 MP 377
Number of tags in the project 1000 2048 4096
Number of PowerTags -- -- --
Number of elements per array 1000 1000 1000
Number of local tags 500 1000 2000

Alarms

 MP 177 MP 277 MP 377
Number of alarm classes 32 32 32
Number of discrete alarms 2000 4000 4000
Number of analog alarms 50 200 200
Length of an alarm in characters 80 80 80
Number of process values per alarm 8 8 8
Size of the alarm buffer 256 512 1024
Number of queued alarm events 64 250 500

Screens

 MP 177 MP 277 MP 377
Number of screens 500 500 500
Number of fields per screen 50 200 400
Number of tags per screen 50 200 400
Number of complex objects per screen 1) 5 10 20

1) Complex objects include: bars, sliders, symbol library, clock and all objects from the 
Controls area.

Recipes

 MP 177 MP 277 MP 377
Number of recipes 100 300 500
Number of elements per recipe1) 200 1000 1000
User data length in KB per data record 0,8 4 128
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 MP 177 MP 277 MP 377
Number of data records per recipe 200 500 1000
Reserved memory for data records in the 
internal Flash

32 KB 64 KB 128 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 MP 177 MP 277 MP 377
Number of logs -- 20 50
Number of entries per log (including all log 
segments) 1)

-- 10000 50000

Number of log segments -- 400 400
Cyclic trigger for tag logging -- 1 s 1 s
Number of tags that can be logged per log -- 2048 2048

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 MP 177 MP 277 MP 377
Number of trends 50 300 400

Text lists and graphics lists

 MP 177 MP 277 MP 377
Number of graphics lists 100 400 500
Number of text lists 300 500 500
Number of entries per text or graphics list 30 256 256
Number of graphic objects 1000 1000 2000
Number of text elements 2500 10000 30000

Scripts

 MP 177 MP 277 MP 377
Number of scripts -- 50 100
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Communication

 MP 177 MP 277 MP 377
Number of connections 4 6 6
Number of connections based on "SIMATIC 
HMI HTTP"

4 8 8

Maximum number of connected 
Sm@rtClients (including a service client)

2  6'': max. 3
10'': max. 2

12'': max. 3
15'': max. 2
 19": max: 1

In the case of communication with S7-1200 PLCs, please note that a maximum of 200 tags 
should be configured per controller. When multiple HMI devices access one PLC, this limit 
applies to all HMI devices.
A maximum of 4 HMI devices can access an S7-1200 at the same time. A panel can address 
a maximum of 8 PLCs.

Help system

 MP 177 MP 277 MP 377
Number of characters in a help text 320 320 320

Languages

 MP 177 MP 277 MP 377
Number of runtime languages 5 16 16

Scheduler

 MP 177 MP 277 MP 377
Time-triggered tasks 1) 10 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 MP 177 MP 277 MP 377
Number of user groups 50 50 50
Number of authorizations 32 32 32
Number of users 50 50 50
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Project

 MP 177 MP 277 MP 377
Size of the project file "*.fwc" 2 MB 6 MB 12 MB

See also
Engineering system (Page 5725)

10.15.6 Comfort Panel

Comfort Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.

 
 

 Note
Graphic objects on Comfort Panels

The use of 32-bit graphic objects increases memory requirements for the project file on 
Comfort Panels.
The use of jpeg graphic objects reduces memory requirements for the project file on Comfort 
Panels.

 

         

Tags

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of tags in the project 1024 2048 4096 4096 4096
Number of PowerTags -- -- -- -- --
Number of elements per array 1000 1000 1000 1000 1000
Number of local tags 500 1000 2000 2000 2000
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Alarms

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of alarm classes 32 32 32 32 32
Number of discrete alarms 2000 4000 6000 6000 6000
Number of analog alarms 50 200 200 200 200
Length of an alarm in characters 80 80 80 80 80
Number of process values per alarm 8 8 8 8 8
Size of the alarm buffer 256 1024 1024 1024 1024
Number of queued alarm events 64 500 500 600 500

Screens

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of screens 500 500 750 750 750
Number of fields per screen 50 400 600 600 600
Number of tags per screen 50 400 400 400 400
Number of complex objects per 
screen 1)

5 20 40 40 40

1) Complex objects include: bars, sliders, symbol library, clock and all objects from the 
Controls area.

Recipes

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of recipes 100 300 500 500 500
Number of elements per recipe1) 200 1000 2000 2000 2000
User data length in KB per data 
record

32 256 512 512 512

Number of data records per recipe 200 500 1000 1000 1000
Reserved memory for data records 
in the internal Flash

512 KB 2 MB 4 MB 4 MB 4 MB
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1) If arrays are used, each array element counts as one recipe element

Logs

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of logs 10 50 50 50 50
Number of entries per log (including 
all log segments) 1)

10000 20000 20000 20000 20000

Number of log segments 400 400 400 400 400
Cyclic trigger for tag logging 1 s 1 s 1 s 1 s 1 s
Number of tags that can be logged 
per log

100 2048 2048 2048 2048

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of trends 50 300 400 400 400

Text lists and graphics lists

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of graphics lists 100 500 500 500 500
Number of text lists 300 500 500 500 500
Number of entries per text or 
graphics list

30 500 500 500 500

Number of graphic objects 1000 4000 4000 4000 4000
Number of text elements 2500 40000 40000 40000 40000
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Scripts

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of scripts 50 100 200 200 200

Communication

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of connections 4 8 8 8 8
Number of OPC connections 
including OPC UA

4 8 8 8 8

Number of connections based on 
"SIMATIC HMI HTTP"

4 8 8 8 8

Maximum number of connected 
Sm@rtClients (including a service 
client)

2 3 3 2 1

 In the case of communication with S7-1200 PLCs, please note that a maximum of 200 
tags should be configured per controller. When multiple HMI devices access one PLC, 
this limit applies to all HMI devices. 
A maximum of 4 HMI devices can access an S7-1200 at the same time. A panel can 
address a maximum of 8 PLCs.

Help system

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of characters in a help text 320 320 320 320 320
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Languages

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of runtime languages 32 32 32 32 32

Scheduler

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Time-triggered tasks 1) 10 48 48 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of user groups 50 50 50 50 50
Number of authorizations 32 32 32 32 32
Number of users 50 50 50 50 50

Project

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Size of the project file "*.fwc" 4 MB 12 MB 24 MB 24 MB 12 MB

See also
Engineering system (Page 5725)
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10.15.7 WinCC Runtime Advanced

WinCC Runtime Advanced
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.       

Tags

 WinCC Runtime Advanced
Number of tags in the project 6144
Number of PowerTags 128 –4096
Number of elements per array 1600
Number of local tags 2048
Number of structures 999
Number of structure elements 400

Alarms

 WinCC Runtime Advanced
Number of alarm classes 32
Number of discrete alarms 4000
Number of analog alarms 500
Length of an alarm in characters 80
Number of process values per alarm 8
Size of the alarm buffer 1024
Number of queued alarm events 500

Screens

 WinCC Runtime Advanced
Number of screens 500
Number of fields per screen 400
Number of tags per screen 400
Number of complex objects per screen 1) 40
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1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 WinCC Runtime Advanced
Number of recipes 999
Number of elements per recipe1) 2000
User data length, in KB per data record 256
Number of data records per recipe 5000
Reserved memory for data records in the internal Flash --

1) If arrays are used, each array element counts as one recipe element

Logs

 WinCC Runtime Advanced
Number of logs 100
Number of entries per log (including all log segments) 1) 500000
Number of log segments 400
Cyclic trigger for tag logging 1 s
Number of tags that can be logged per log 6144

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 WinCC Runtime Advanced
Number of trends 800

Text lists and graphics lists

 WinCC Runtime Advanced
Number of graphics lists 500
Number of text lists 500
Number of entries per text or graphics list 3500
Number of graphic objects 2000
Number of text elements 30000
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Scripts

 WinCC Runtime Advanced
Number of scripts 200

Communication

 WinCC Runtime Advanced
Number of connections 8
Number of OPC connections including OPC UA 8
Number of connections based on "SIMATIC HMI HTTP" 16
Maximum number of connected Sm@rtClients (including a service client) 4 1)

In the case of communication with S7-1200 PLCs, please note that a maximum of 200 tags 
should be configured per controller. When multiple HMI devices access one PLC, this limit 
applies to all HMI devices.
A maximum of 4 HMI devices can access an S7-1200 at the same time. A Runtime Advanced 
can address a maximum of 8 controllers.
1) Only up to three Sm@rtClients can interconnect with the Sm@rtServer on Panel PC 

477.

Help system

 WinCC Runtime Advanced
Number of characters in a help text 320

Languages

 WinCC Runtime Advanced
Number of runtime languages 32

Scheduler

 WinCC Runtime Advanced
Time-triggered tasks 1) 48

1) Event-triggered tasks are not relevant for the system limits
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User administration

 WinCC Runtime Advanced
Number of user groups 50
Number of authorizations 32
Number of users 100

Project

 WinCC Runtime Advanced
Size of the project file "*.fwc" No limiting

See also
Engineering system (Page 5725)

10.15.8 General technical specifications

10.15.8.1 Recommended printers

Recommended printers
The current list of printers recommended for use with the HMI devices is available on the 
Internet at:

Link to the current printer list (http://support.automation.siemens.com/WW/llisapi.dll?
aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&caller=view&extranet=standard&viewreg=WW&nodeid0
=10805558&objaction=csopen) 

 

 Note

All HMI devices except for a PC and Panel PC support only one printer at their USB port, 
even if several ports are available.

 

See also
Printer list (http://support.automation.siemens.com/WW/llisapi.dll?
aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&caller=view&extranet=standard&viewreg=WW&nodeid0
=10805558&objaction=csopen)
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10.15.8.2 Printing via print server

Introduction
Print servers enable access to network printers.  Print jobs are routed to a corresponding printer 
via the print server.     

 

 Note

Printing takes place via the print server for the following HMI devices:
● xP 177, Mobile Panel 177
● xP 277, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN
● Mobile Panel 277 IWLAN V2, Mobile Panel 277F IWLAN V2, Mobile Panel 277F IWLAN 

(RFID Tag)
● MP 377
● PC with WinCC Runtime Advanced

 

Requirements
● The print server deploys the "RAW" mode.

 

  Note

For additional information on settings, refer to the relevant print server documentation.
 

● The device is interconnected via Ethernet with the print server or with a printer featuring an 
integrated print server.

● External print servers are interconnected with a printer via USB port.

● The IP address and port used are identical in the "Printer Properties" of the HMI device and 
on the print server.

Procedure
1. Open the "Control Panel" on your HMI device.

2. Select "Printer". The "Printer Properties" dialog box opens.

3. Select a printer from the "Printer Language" selection list.

4. Select the "PrintServer" entry from the "Port" selection list.
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5. Enter the IP address and the port used for communication with the printer in the "IP:Port" 
input field.

 

  Note

Use the ":" character as delimiter between the IP address and the port number. For 
example: "192.168.56.23:9100".

 

6. Select any additional printer settings.

10.15.8.3 Memory requirement of recipes

Introduction
The following calculation of memory requirements of recipes is only valid for Windows CE 
devices. 

Calculation of memory requirements
The memory space required by each recipe (in KB) is derived from the sum of D1 + D2 + D3.

Valid is:

● D1 = (number of entries x 5 + M + 8):1024
Applies to M:
M = Accumulated length of all tag names = sum of characters in all tag names (UTF8 coded, 
max. 255 bytes per tag name) used in the entries.

● D2 = [(number of data records x 12) + 4]:1024

● D3 = [number of data records x (data record length + N) + 4]:1024
Applies to N:

The total length of the name of the corresponding data record in all languages (max. 255 bytes 
per language) + overhead per data record (1 byte + number of languages * 3 bytes). 

D1, D2 and D3 are rounded to the next higher number.

Memory requirements for using arrays
The memory required by each recipe (in KB) is derived from the sum of D1 + D2 + D3.

Valid is:
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● D1 = (number of entries x 5 + M + 8):1024
Each element of the tag array used counts as a single entry.
Applies to M:
M = (length of the array tag name + K) x  number of array elements
Applies to K:
K = 3: 2 to 9 elements in the array
K = 4: 10 to 99 elements in the array
K = 5: 100 to 999 elements in the array
K = 6: 1000 to 9999 elements in the array
K = 7: 10000 to 12000 elements in the array

● D2 = [(number of data records x 12) + 4] : 1024

● D3 = [number of data records x (data record length + N) + 4] : 1024
Applies to N:

The total length of the name of the corresponding data record in all languages (max. 255 bytes 
per language) + overhead per data record (1 byte + number of languages * 3 bytes). 

D1, D2 and D3 are rounded to the next higher number.
 

 Note

If you use both tags and arrays in a recipe, you have to add the results of both formulas to 
calculate the total memory required.

 

 

10.15.8.4 Memory requirements of recipes for Basic Panels, OP 77A, and TP 177A

Introduction
The following calculation of memory requirements of recipes is valid for Basic Panels, OP 77A, 
and TP 177A devices. 

Restrictions
The HMI device provides 39 KB of memory space for recipes. This memory space may not be 
exceeded. The total memory space for recipes is calculated as follows: Total of all recipes + 
recipe with highest memory requirement.

Each recipe may not exceed a maximum memory space of 19 KB.

Calculation of memory requirements
The memory space requirement of each recipe (in KB) is calculated based on the three 
addends D1 + D2 + D3.

Valid is::
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● D1 = number of data records x M
 
Rule for M (size of a data record):
M = 1 x number of elements of a byte + 2 x number of elements of 2 bytes + 4 x number 
of elements of 4 bytes + 8 x number of elements of 8 bytes + K
 
Rule for K (size of the string elements):
K = number of string elements x (string length + 1) x 2

 

● D2 - data record size
 
D2 = 4 + number of languages x 8 + number of languages x (4 + 4 x number of data records 
+ (length of the data record name + 1) x 2 x number of data records) + 8 + 8 x number of 
data records
 
Or rewritten:
 
D2 = 12 + 8 x number of data records + number of languages x (12 + number of data records 
x (4 + (length of the data record name +1) x 2))

 

● D3 - shared memory
D3 = 14 + number of elements

 

 Note

Arrays and single elements can be calculated as described above.
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10.16 Options

10.16.1 Following GMP with Audit

10.16.1.1 Basics

GMP compliance

GMP compliant projects with WinCC    
Traceability and therefore the documentation of production data is becoming increasingly 
important in many industrial sectors such as the pharmaceuticals industry, the food and 
beverage industry. and in the related mechanical engineering sector. 

Storage of production data in electronic form offers many advantages compared to paper 
documents, such as simple acquisition and logging of data. 

However, it is also important to ensure that data cannot be falsified and that it can be read at 
any time. 

Industry-specific and general standards for electronic documentation of production data have 
been developed for this purpose. 

The most important set of regulations is the FDA guideline 21 CFR Part 11 for electronic data 
records and electronic signatures issued by the FDA, the US Food and Drug Administration. 
The various EU regulations, such as EU 178/2002, also apply for particular industries.

Requirements for production systems in these industries have been developed on the basis 
of 21 CFR Part 11 and the corresponding layout to comply with GMP (Good Manufacturing 
Practice). They are also required for other industries.

The following primary requirements are derived from these directives and rules:

● Creation of an Audit Trail or operating trace in runtime
This document can be use to trace a complete log of which user has run what control 
function on the machine at what time.

● Important process stages must also be traceable to a specific responsibility, for example 
with an electronic signature.

GMP-compliant configuration

Introduction
"GMP compliant configuration" means creating projects in accordance with "Good 
Manufacturing Practice". The requirements are set out in FDA rules "21 CFR Part 11". The 
FDA is the U.S. Food and Drug Administration. 

GMP-compliant configuration means HMI devices have electronic production data 
documentation functionalities.
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GMP relevant and the audit trail
WinCC offers the "Audit" option for implementing GMP compliance. Using the audit option, the 
"GMP compliant configuration" function can be enabled.

Enable the "GMP compliant configuration" function directly in the runtime settings of the HMI 
device. GMP relevant functionalities are then added to WinCC. These functionalities are:

● Audit Trail

● Electronic signature

● Option to label tags as "GMP relevant".

● Option to label tags as "GMP relevant" for recipes.

● NotifyUserAction system function

● Logging of tags using checksum

● Logging of alarms using checksum

● Audit trail record for printing logged changes

A license is required to convert the GMP-relevant functions configured in WinCC in runtime.

Depending on the edition of WinCC, use one of the following licenses:

● WinCC Audit for RT Advanced

● WinCC Audit for SIMATIC Panel

If the labeled objects are executed or changed, then it is saved in a special log, the "Audit Trail".

See also
Configuring a checksum for a log (Page 3228)

Evaluating the checksum of log data (Page 3229)

Configuring a checksum for a log (Page 3315)

Audit option

Advanced functions    
The Audit option adds functions to WinCC to ensure that your project is GMP compliant.

The following functions are added:
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● Audit Trail
For every HMI device, you can create an Audit Trail .
Operator actions and system processes that are relevant for the FDA-compliance of the 
process are recorded in an Audit Trail during runtime. 

– User actions such as changes in the values of GMP relevant tags or recipes or the 
acknowledgment of alarms.

– Actions by the system, such as starting up runtime or rejection of logon attempts.

● Electronic signature
You can set mandatory acknowledgement of important user actions in runtime, such as 
changing recipe data records or tag values. 
All  Audit-relevant user actions must be protected by authorization in the user administration.
The user will then only be able to run these actions if an electronic signature and, if 
configured appropriately, a comment have been input. The electronic signature and the 
comment are logged in the audit trail.

Extension of the WinCC engineering system  
For all HMI devices that support "GMP-compliant configuration", the WinCC engineering 
system is extended to include the following configuration options when GMP is enabled:

● The entry "AuditTrail" is added to the "Logs" editor.

● A "Good Manufacturing Practice Settings" entry is added to "HMI tags" editor in the 
inspector window of a "Properties > Properties" tag.

● A "Good Manufacturing Practice" entry is added to "Recipes" editor in the inspector window 
of a "Properties > Properties" recipe.

● "NotifyUserAction" system function

 

Scope of logging

Introduction   
It is important to ensure that audit-related processes are always logged in runtime in the audit 
trail in a project with the option "Audit". 
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Scope of logging  
The following operations are Audit-relevant and are automatically saved in the Audit Trail:

● Runtime sequence

– Runtime start and runtime stop

– Project information: Version and project name, of the configuration environment, device, 
and current runtime configuration

– Failure of the voltage supply of an active Uninterruptible Power Supply (UPS).

● User administration

– Logon and logoff of users

– Invalid logon attempts

– Import of user administration

– Changes of user administration

● Alarm system

– All alarms that are acknowledged by the user.

– All acknowledgment attempts of the user
 

  Note
Logging alarm text

To log alarm texts, select the "Log alarm text in Audit Trail" option in the Audit Trail 
editor:

"Audit trail > Properties > Settings" in the "Settings" area
 

● Log operations

– Starting, stopping and copying a log

– Opening and closing all logs

– Deleting a log

– Starting a sequence log

– Long-term logging of a log

● Running specific system functions depending on their functionality and the triggering event

The following audit processes are logged depending on the configuration of the recipes and 
the tags of the project:
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● Change values of GMP-relevant tags by the user

● for GMP-relevant recipes:

– Storing after changing and creating recipe data records

– Transfer of recipe data records to the PLC and from the PLC

– For recipe tags: Changing the setting for the synchronization of the tag values with the 
PLC ("offline"/"online")

● "NotifyUserAction" system function
You use the system function "NotifyUserAction" to record user actions that are not 
automatically recorded by the audit trail. 
You can configure this system function for screen calls, for example You can also configure 
function lists containing system functions that do not require signature or acknowledgement.

10.16.1.2 Enabling GMP compliant configuration

Introduction
The Audit Trail and "Electronic Signature" functions are qualified as "GMP compliant 
configuration". 

Requirements
● A project is created.

● A GMP compatible HMI device has been created.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Runtime settings".
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3. Click on "GMP".

4. Select "GMP compliant configuration".

Result
The Audit option is now enabled for the HMI device. 

The following functions can now be configured:

● Audit Trail log

● "NotifyUserAction" system function

● GMP relevant tags

● GMP relevant recipes

See also
Configuring a checksum for a log (Page 3228)

Evaluating the checksum of log data (Page 3229)

Configuring a checksum for a log (Page 3315)

Evaluating the checksum of log data (Page 3317)

Visualizing processes (Comfort/Advanced)
10.16 Options

WinCC Comfort/Advanced V12.0 SP1
5760 System Manual, 07/2013,  



10.16.1.3 Using the Audit trail

Audit Trail

Introduction   
Configure a log in the settings for Audit Trail editor. This log is used to store changes in tag or 
recipe values made by the user and other user actions in runtime. 

"Settings for audit trail" editor
1. In the project view, double-click "AuditTrail" in the "Log" group.

2. Click on the "Settings for audit trail" tab.

3. Change the properties of Audit Trail in the inspector window.

Audit trail work area
You define the settings for the Audit Trail in the "Properties > Properties" inspector window. 
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You set the name of the log and the storage location and decide whether logging will begin on 
startup. Also determine if "Forcing" is permitted. 

"Forcing" is a function for administrators. It allows the administrator to continue the process 
even if the maximum log storage space has been exceeded. 

Thus, the Audit Trail switches off and must be rebooted using the "StartLogging" system 
function.

Creating an audit trail

Requirements
"GMP compliant configuration" has been selected on the HMI device.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Logs".
The "Logs" editor will open.
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3. Change to the "Audit Trail" tab.
An audit trail has been created.

4. Define the following in the inspector window:

– Name

– Storage location

– Logging with runtime start-up

– Forcing
 

  Note

No audit-related user actions are permitted in GMP relevant projects if there is 
insufficient storage space available for the audit trail. 

If the check box "Forcing permitted" is activated and, because of the hardware, there 
is insufficient storage space in runtime, the administrator can interrupt audit trail 
logging. The administrator can prevent the process from stopping in this way. 

If the administrator enables the "Forcing" function, the interruption of the audit trail by 
the administrator will be entered in the audit trail as the last entry.

At the end of "Forcing" restart the audit trail using the "StartLogging" system function.
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Configuring a function list
If necessary, configure a function list for the events "Low free storage space" and "Free space 
critically low". 

The "Low free storage space" event is triggered if the amount of free storage space available 
for the audit trail in runtime is less than the amount configured in "Minimum storage space in 
MB". 

The "Free space critically low" event is triggered if there is no longer sufficient free storage 
space for the audit trail in runtime. The value depends on the HMI device.

For more information refer to chapter: Configuring the "Low free storage space" event

Result
Audit relevant user actions are entered in the configured audit trail in runtime.

Parameters for the audit trail

Introduction
Configure Audit Trail in the "Logs" editor if you have enabled "GMP compliant configuration" 
in the runtime settings.

There are two ways of assigning parameters for the audit trail:

● "Settings for audit trail" editor

● "Audit Trail" inspector window

Editor "Audit Trail"
The "Audit Trail" editor is an overview of the Audit Trail created.

Only one Audit Trail can be created per HMI device. 

Parameters that are assigned for the Audit Trail can be seen in the line. You can select or 
deselect the parameters displayed.

The parameters of an Audit Trail are also displayed and described in more detail in the 
inspector window.
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General inspector window
You can set the following parameters under "Audit trail > Properties > General":

Visualizing processes (Comfort/Advanced)
10.16 Options

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5765



Name
● Under "Name", assign a name for the Audit Trail .

Special characters are not permitted when assigning the name.

Storage location
● Storage location

You can choose between:

– a CSV file (ASCII)

– a TXT file (Unicode)
 

  Note

Use "TXT (Unicode)" as storage location for logging Asian languages.
 

● Path
Depending on the HMI device, enter the storage location of the Audit Trail  under "Path".

● Minimum space in MB
Specify the size of remaining storage space that triggers the "Less free storage space" 
event.
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Inspector window settings
You can set the following parameters under "Audit trail > Properties > Properties > Settings":
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Logging activation
● Enable logging at runtime start

Forcing
● Bypass electronic signature

Specifies whether the administrator is permitted to run operator actions without entering an 
electronic signature or comments.

● Forcing allowed if storage space is exhausted
This function allows the administrator to interrupt audit trail logging in the following 
scenarios:

– There is no free storage space available.

– The storage medium is missing.

– Access to required storage medium is not possible.

You can thus prevent the process from stopping. 
After Forcing was carried out, the audit trail log switches off.
After the end of "Forcing", the audit trail must be restarted with the system function 
"StartLogging".

Settings
● Logging alarm texts in the audit trail.

 

  Note

Use "TXT (Unicode)" as storage location for logging Asian languages.
 

For further details on setting the logging language, refer to the following section:
Setting the audit trail language 

Setting the audit trail language

Introduction
The logging language for an Audit Trail is set in the runtime settings.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Runtime settings".
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3. Click "General".

4. Select the logging language in the "Logs" area.
 

  Note

If an Asian language was selected, use the "TXT (Unicode)" storage location in the "Audit 
trail" editor.

 

Low free storage space

Low free storage space

Description
This event is triggered if the storage space available on the medium to which the Audit Trail 
is less than the configured minimum. 
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Free space critically low

Description
This event is triggered if the storage medium to which an Audit Trail is saved provides 
insufficient storage space due to hardware restrictions. 

 

Configuring the "Low free storage space" event

Requirements
● A GMP- compliant configuration is enabled

● An Audit Trail is created

Procedure
1. Click on the Audit Trail in the "Audit Trail" editor.

2. In the Inspector window, click "Properties > General".

3. In the "Free storage space limit in MB" area, select a value that triggers the "Little free 
space" event.

4. Click on Events in the Inspector window.

5. Click on the "Low free storage space" event.

6. In the function list, specify a system function to execute when an "Overflow" event is 
triggered.

Logging the audit trail

Reporting an audit trail

Introduction
You can print a report of the operations saved in an Audit Trail. All recorded actions are included 
in the printout.

Requirements for reporting
The "Audit trail report" report object is available for the printout of an Audit Trail. 

You can configure the report in the "Report" editor. The report object is only available if the 
"GMP-compliant configuration" option is set in the runtime settings of the HMI device.     
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If an Audit  must be printed in runtime, initially the logging of Audit Trail must be stopped using 
the "StopLogging" system function. 

Whilst an Audit Trail is being printed, no user actions are recorded. Ensure that no GMP-
relevant user actions are executed whilst the logging is stopped.

After printing is complete without any errors, restart the audit trail using the "StartLogging" 
system function.

The header of the report is printed in the current runtime language. Change the runtime 
language to the logging language accordingly. 

The logged data from Audit  are printed in the configured runtime logging language. 

In order to receive a complete report, the report object can also be used in a report in 
conjunction with the "Print alarm" and "Print recipe" report objects.

Audit Trail reporting

Introduction
You use the "Audit Trail" report object to configure a report for the output of Audit Trail contents 
to a printer. 

Once the printout is started in runtime, all entries currently contained in the Audit Trail are 
printed out.

Procedure
To create a report, proceed as follows:

1. Double-click on the "Reports" entry in the project tree.

2. Double-click "Add new report".
A new report is created and opened in the "Report" editor.
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3. Drag & drop the "Audit trail report" object under "Tools > Controls" to the report created.

4. Click on the "Audit trail report" object.

5. Change the object properties of the "Audit trail report" object in the inspector window.

Result
You have created a report for the printout Audit Trail.

Parameters for the audit trail report

Introduction
The "Audit trail report" parameters can be edited in the inspector window. 
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Inspector window appearance
Click on the "Audit trail report" object.

Change the appearance of the "Audit trail report" object in the appearance area of the Inspector 
window under "Properties > Properties > Layout".

You can configure the foreground color, the background color, the style, and the font settings. 

It is recommended to set a font size of 16 px for the output.   

Inspector window layout
Click on the "Audit trail report" object.

Change the position and size of the "Audit trail report" object in the appearance area of the 
Inspector window under "Properties > Properties > Layout".
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The "Audit trail report" object always fills the space down to the footer on the report page. If 
you change the height of the object, then you only change the distance of the object to the 
header. The report printout can involve a large amount of data. 

A page break is automatically inserted when the length of the page is exceeded to print out all 
data. 

In the "Visible entries" area, it is determined whether comments are visible on the printed report.

Inspector window miscellaneous
Click on the "Audit trail report" object. 

Change the name and layer position of the "Audit trail report" object in the appearance area 
in the Inspector window under "Properties > Properties > Miscellaneous".
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Printing out an audit trail report

Introduction
Since logging of the Audit  must be stopped in order to print out an Audit Trail, a few details 
regarding this procedure must be noted. 

The following steps must be taken to print out an audit trail in a report file on a printer:

● Stop logging using the "StopLogging" system function.

● Start the printout using the "PrintReport" system function.

● Check if the printing is successfully completed.

● If needed, move or delete the Audit Trail using the system functions "ArchiveLogFile" or 
"DeleteLog".

● Start the logging of Audit  by selecting the "StartLogging" system function.
 

  Note

Make sure that the Audit Trail has been printed completely before you delete the Audit 
Trail.

 

Requirements
● "GMP compliant configuration" has been enabled.

● A report for the printout of an Audit Trail has been configured.

● The screen for the operator control to be configured is open.
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Procedure
1. Add a button to the screen and select "Events > Click" in the Properties window.

2. In the function list, assign the "StopLogging" system function to the "Click" event and select 
your Audit Trail log.

3. Insert an additional button and assign the "PrintReport" system function to the "Click" event 
of this button.

4. Configure the "StartLogging" system function in the same function list.

5. Assign unique labels to the buttons.

6. Save the project.

Result
You have configured the required buttons and system functions. The operator can perform the 
operating tasks described in the introduction during runtime to print out an Audit Trail report. 

 

 Note

You can also insert the report objects for the output of alarms and recipes in the report for 
the printout of an Audit Trail. However, since GMP-relevant operations and system processes 
are not recorded while you are printing, you should preferably print the Audit Trail in a separate 
operation.

 

Evaluating an audit trail

Evaluating audit trails

Introduction
The Audit Trail has been saved to the memory card of the HMI device and is also read only. 

The Audit Trail is protected by a checksum. This checksum ensures that the entry has not 
been modified at any later time. 

There are two possible ways to evaluate the Audit Trail: 

● Use the "Audit Viewer":
You can easily evaluate the Audit Viewer for external analysis on an Office PC with the 
help of the Audit Trail. 

● Use the "HmiCheckLogIntegrity" DOS program:
The DOS program makes it possible to carry out an automatic check of the Audit Trail using 
the return values. 
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Evaluating Audit Trails in AuditViewer

Introduction
The Audit Viewer allows you to evaluate all Audit Trail data in a table.

Requirements
● Audit Viewer is installed

● The Audit Traillog is located on the computer which has Audit Viewer installed.

Procedure
1. Start the Audit Viewer on the configuration PC:

"Start > SIMATIC > Audit Viewer > Audit Viewer"
This path may be different on your operating system version.

2. Click the button.

3. Load the Audit Trail:

The "Data Validity Indicator" is lit up in green to indicate that the loaded Audit Trail has not 
been manipulated.

Each entry in the Audit Trail is time-stamped to allow precise tracking of operator actions. In 
addition to system events, such as the attempt to import a password list, the system also 
records failed logon attempts:
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See also
Evaluating the checksum of log data (Page 3229)

Evaluating the checksum of log data (Page 3317)

Evaluating Audit Trails with DOS program

Introduction
Long-term archiving on a server allows an Audit Trail to be checked automatically using return 
values in a script. 

In addition the programmer can integrate the check using the DOS program 
"HmiCheckLogIntegrity" into the archiving process. "HmiCheckLogIntegrity" then provides the 
following return values:

● < 0: Different errors, for example, wrong file format or no file exists.

● 1: The checked Audit Trail is valid.

● > 0: The first line that was manipulated will be returned.

Audit Trail logging is only continued if the return value is "1". In both error cases, the 
administrator or the shift supervisor can be informed. 

HmiCheckLogIntegrity
The "HmiCheckLogIntegrity.exe" DOS program is in the installation directory under:

"SIEMENS > Automation > WinCC Runtime Advanced"

Audit trail logging concept

Format

Format - Audit Trail
On an HMI device with "GMP compliant configuration", all events which are relevant to the 
audit are recorded at runtime in the Audit Trail. You have several format options. 

Selection is dependent on the display program and the runtime language used:
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● File - CSV (ASCII)
To view and evaluate a CSV file use, e.g. Microsoft Excel on your PC.

 

  Note

Double quotation marks or several characters are not permitted as list separators for the 
storage site "File - CSV (ASCII)". You can find the settings for list separators under "Start 
> Settings > Control Panel > Regional and Language Options".

 

● File - TXT (Unicode)
This file format supports all characters that can be used in WinCC. For editing, you will 
need software that can save files in Unicode, such as Notepad.

 

  Note

Use "File - TXT (Unicode)" to log Asian languages.
 

Audit Trail with checksum
The following files are generated under special circumstances:    

● *.keep

– If a log is started without checksum and will be continued with a checksum.

– If you update WinCC with a service pack or a new version and the Audit Trail or the log 
is continued with the checksum.

– The content of the keep file will remain the same when compared with the original csv 
file or txt file.

 

  Note

Before you update WinCC with a Service Pack or a new version, exit and save the 
Audit Trail or the logs using checksum. After WinCC is updated, the audit trail or logs 
will be continued with new files using checksum. 

 

● *.bak

– If runtime has determined a serious, irregular problem in the file.
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Storage location and medium

Storage location and medium         
Depending on the hardware configuration of the HMI device, the data may be logged locally 
(on the hard disk of a PC or on the storage card of a panel) or, if present, on a network drive.

 

 Note
Logging on network drives

We do not recommend that you log audit trails directly on a network drive. Power supply can 
be interrupted at any time. This means there is no guarantee for a reliable operation of logs 
and audit trails.

We recommend you save the logs on your local hard drive, or on a storage medium of the 
HMI device. Use the system function "ArchiveLogFile" to save the logs long-term on a network 
drive.

 

A "GMP compliant configuration" cannot be operated at runtime to the full extent unless it is 
possible to save all user actions which are relevant to the audit to the Audit Trail. It must be 
ensured that sufficient storage space is available for the Audit Trail and that the connection to 
the storage location for the Audit Trail is not disturbed. 

Error-handling with insufficient free storage space  
If there is insufficient storage space, your project can be configured so that the administrator 
has an option of continuing the process without logging in the audit trail (forcing).

Error-handling if there is no storage medium or the connection to the server is interrupted
All audit-relevant user actions are blocked if insufficient storage space is available for the Audit 
Trai, e.g. due to missing storage medium. 

Blocking is canceled as soon as the storage location for the Audit Trail is available again. The 
block can be skipped by "forcing".

Error-handling with long-term logging
If the audit trail must be moved to a server for long-term logging and the connection to the 
server is interrupted at this time, the following error-handling is required: 

The system closes the audit trail and renames it. The system attempts to send the renamed 
audit trail to the server again in the background.

If disruption in the connection to the server persists, you receive a system alarm telling you 
that the connection is down. Then the system attempts to send the renamed audit trail every 
300 seconds.

The attempt to transmit the data is repeated until successfully completed. The data is also 
transmitted after a restart of the HMI device.
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"Forcing"     
If the storage space for the audit trail is insufficient, for example if there is no storage medium 
or it is full, all audit-relevant user actions are automatically blocked.

In this case the audit trail logging can be configured to give an administrator the option of 
continuing to operate the system without logging the audit trail (forcing). 

The administrator can also be given the option of running the system quickly out of a critical 
state in case of emergency. In this case the administrator can operate the system without the 
requirement to input the required electronic signatures or comments. 

If the administrator uses the "forcing" function, this is logged as the last entry in the audit trail.

After the end of forcing, the audit trail must be restarted with the system function "StartLogging".

Protection mechanisms

Protective mechanisms to prevent changes to audit trail data   
The audit trail data are protected against deliberate or accidental changes:

● The directory in which the audit trail is saved can only be accessed with special rights.

● The audit trail files are write-protected.

● Each data record contains a checksum that can be used to detect a change of its contents. 
This checksum also ensures that the number of lines has not changed in the audit trail file.

Use the "HmiCheckLogIntegrity" tool, included in the audit option, to check whether an audit 
trail has been changed:

Evaluating Audit Trails with DOS program

WinCC upgrade

WinCC upgrade
Before you update WinCC with a Service Pack or a new version, you will have to exit and save 
the Audit Trail or the logs with checksum. After WinCC is updated, the audit trail or logs with 
checksum will be continued with new files. 

Make sure that the logs are started at a defined state with the new version.
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Audit trail behavior in runtime

Effects in runtime   
The configuration in Audit Trail has the following effects in runtime, depending on the 
configuration:

● Audit relevant user actions (such as tag changes and recipe changes) are recorded in an 
audit trail.

● "Enable logging at runtime start" check box enabled:
The audit trail is started with runtime.

● "Forcing" group, "Allowed if storage space has been exhausted" check box enabled:
A user with administrator rights can use "forcing" to run operations on the plant even though 
the audit trail can no longer be logged because of storage space limitations. Interrupting 
the audit trail prevents the process from being stopped.
If the check box "Signing may be bypassed" is enabled, the administrator is not required 
to input electronic signatures, acknowledgments or comments for operator actions that 
would normally require signing, acknowledgment or comment. 

● If the storage space available for the Audit Trail is less than the configured "Minimum 
storage space in MB", the function list configured for the "Low free storage space" event 
will be processed.

● If there is insufficient storage space for the audit trail because of hardware limits, the 
function list configured for the "Free space critically low" event will be processed.

10.16.1.4 Configuring audit functions

Logging tag value changes

Tag value change

Changes to tag values
User actions in runtime are recorded in a Audit Trail once "GMP compliant configuration" has 
been enabled.

When you configure a GMP compliant project, you specify which tags must meet the 
requirements of Good Manufacturing Practice (GMP).    
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If the user changes the value of a GMP-relevant tag in runtime, the value change action is 
logged in the Audit Trail .

 

 Note

The action of changing the value of GMP-relevant tags made by the PLC, or a system 
function, is not logged in the Audit Trail. 

The system functions used to change the values of GMP-relevant tags which are assigned 
to events that identify a direct user action will be logged.

In addition, configure the "NotifyUserAction" system function to make a manual entry in the 
Audit Trail or to prompt the user for an electronic signature, an acknowledgment, or a 
comment. 

With the "NotifyUserAction" system function only the value changes that are directly triggered 
by the event to which the system function is configured are entered in the Audit Trail. For 
example, if additional tags are changed by changing the value of one tag, the additional value 
changes are not logged in the Audit Trail.

 

Logging tag value changes

Requirement
● "GMP compliant configuration" has been enabled.

● The tags for which you want to configure the GMP settings are created.

● The property view is open.    
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Procedure
1. Open the HMI tags editor and select the tag for which you want to make GMP settings.

2. Click "GMP relevant" under "Properties > Properties > GMP" in the Inspector window.

3. Specify how the user must confirm a value change in the "Confirmation type" selection field:

– "Electronic signature"
If the user's electronic signature is required.

– "None"
If the value change is to be logged in the Audit Trail without user confirmation.

– "Acknowledgment"
If user acknowledgement of the value change is required.

4. Enable the "Comment required" check box if the user is required to input a comment as 
well as an electronic signature or acknowledgment.
This check box is only enabled if "Electronic signature" or "Acknowledgment" is specified 
under "Type of confirmation".

Result
If the user changes the value of a GMP-relevant tag in runtime, the value change is entered 
in the Audit Trail. 
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Effects of tag change

Effects in runtime
The configuration has the following effects in runtime depending on the properties of the GMP-
relevant tags:   

● If the user changes the value of a GMP-relevant tag in runtime, the value change is entered 
in the Audit Trail.

● Electronic signature  
If "Electronic signature" is specified as the "Type of confirmation", the user must log every 
user-related value change of the tags using an electronic signature. Otherwise the value 
change will be rejected.
The user name used to sign the change is logged in the audit trail.

● Acknowledgement  
If "Acknowledgment" is specified as the "Type of confirmation", the user must acknowledge 
every user-related value change of the tags. Otherwise the value change will be rejected.
The acknowledgement is logged in the Audit Trail.

● Comments  
If the "Comment required" check box is enabled, the user must also comment every user-
related value change of the tags, in addition to acknowledgment or input of the electronic 
signature. Otherwise the value change will be rejected.
The entered comment is logged in the Audit Trail.

Logging recipe data record changes

Recipe data changes

Changes to recipe data    
User actions in runtime that are relevant to the quality of the process, such as changes of tag 
values or recipe values, are recorded in an Audit Trail once "GMP compliant configuration" 
has been enabled. 

You specify during configuration which recipes must meet the requirements of "Good 
Manufacturing Practice" (GMP).

For GMP-relevant recipes, the following operations during runtime are recorded in the Audit 
Trail:
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● Storing after changing and creating recipe data records

● Transfer of recipe data records to the PLC and from the PLC

● For recipe tags: Changing the setting for the synchronization of the tag values with the PLC 
("offline"/"online") if the recipe tags are configured as "GMP-relevant".

 

  Note
Differences in the Audit Trail  with recipe display and recipe screen

If you use a recipe screen to save recipe data, enable the "GMP-relevant" property for the 
recipe tags. If the user changes the value of a GMP-relevant recipe tag in runtime, the 
changed value is recorded in the Audit Trail. You can also configure for the tag to require 
the user to confirm the value change with an electronic signature and enter a comment.

If you use a recipe display to edit data records of a GMP-relevant recipe, the Audit Trail 
includes a record of which recipe data records were saved or sent to the PLC. The value 
changes to the recipe tags are not logged in the Audit Trail. Use the "ExportDataRecords" 
system function to save the value change to data records in a csv file. 

If you want to make changes to recipe data records in conformance to the FDA, disable 
"Enable edit mode" in the recipe view. Use the recipe screen and "GMP relevant" recipe 
tags.

 

If you export recipe data records in a regulated project, you can assign the recipe data with a 
checksum. When you later import the recipe data back, you can use the checksum to determine 
if the recipe data has changed. The following system functions are available for exporting and 
importing recipe data with a checksum:

● "ExportDataRecordsWithChecksum"

● "ImportDataRecordsWithChecksum"

Logging recipe data changes

Requirement
● "GMP compliant configuration" has been enabled.

● The recipes for which you want to configure the GMP settings are created.

● The property view is open.
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Procedure     
1. Open the recipe editor and select the recipe for which you want to make GMP settings.

2. Click "GMP relevant" under "Properties > Properties > GMP" in the Inspector window.

3. Under "Settings", select the following:

– "Record operations in audit trail:"
If all user actions in runtime that affect this recipe are to be recorded in the Audit Trail.

– "Sign loading of recipe data":
If the user is required to confirm the transfer of recipe data records to or from the PLC 
using an electronic signature.

– "Signature for saving recipe data: "
If the user is required to confirm recipe data record saving with an electronic signature.

Result
If the user works with the GMP-relevant recipe in runtime, the change is entered in the Audit 
Trail. 

Effects of recipe data change

Effects in runtime   
The configuration has the following effects in runtime depending on the properties of the GMP-
relevant recipes:
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Entries in the Audit Trail
Entries are made in the following cases:

● You create and save new recipe data records of a GMP-relevant recipe at runtime.

● You edit recipe data records of a GMP-relevant recipe and save your changes at runtime.

● Recipe data records are transferred to the PLC or recipe data are read from the PLC.

● The "SetRecipeTags" system function is used to change the setting for synchronization of 
the tag values with the PLC.
This concerns the following changes:

– "offline" to "online"

– "online" to "offline"

Electronic signature
The user must enter an electronic signature in the following cases depending on the 
configuration:

● The "Sign loading of recipe data" check box is set:
Signature for the transfer of recipe data records to the PLC. Signing is always required if 
the transfer is triggered with the recipe display functions and even if it is triggered with 
"SetDataRecordToPLC" system functions.

● The "Sign saving of recipe data" check box is set:
Sign saving of recipe data records. The signature is always required if the save is triggered 
with the system functions of the recipe display, and even if it is triggered with the 
"SetDataRecordToPLC" or "SaveDataRecord" system function. 

● The user name used to sign the change is logged in the audit trail.
 

  Note

The triggering of the "ImportDataRecords" system function is entered in the Audit Trail but 
does not require a signature or a comment. In addition, call the "NotifyUserAction" system 
function to request an electronic signature with or without user comment. 

 

Logging user actions

User actions with GMP-compliant configuration

Introduction    
In GMP compliant configuration, user actions and system operations in runtime that are 
relevant for the quality of the process are recorded in an Audit Trail . 

For example, a user logon to the system or the change of a tag value are saved in the log.

In runtime, user actions are saved in an Audit Trail under the following conditions:
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● "GMP compliant configuration" has been enabled

● A user is logged on to the system

Logging modes

Automatic logging of user actions
The following user actions are recorded in runtime without the need for additional configuration 
steps if "GMP compliant configuration" is enabled:

● User Administration

– Logon and logoff of users

– Import of user administration

● Alarm system

– All alarms that are acknowledged by the user.
If an alarm from an alarm group is acknowledged, an entry is made in the Audit Trail 
indicating that all other alarms of this group have been acknowledged.

– All acknowledgment attempts of the user
 

  Note
Logging alarm text

To log alarm texts, select the "Log alarm texts in Audit Trail" option in the Audit Trail 
editor.

 

● Log operations

– Starting and stopping a log

– Opening and closing all logs

– Deleting a log

– Starting a sequence log

– Copying a log

– Long-term logging of a log
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Configuration-dependent logging
The following processes are logged depending on the configuration of the recipes and the tags 
of the project:

● Change values of GMP-relevant tags by the user

● for GMP-relevant recipes

– You create and save new recipe data records of a GMP-relevant recipe at runtime.

– You edit recipe data records of a GMP-relevant recipe and save your changes at runtime.

– Transfer of recipe data records to the PLC and from the PLC

– For recipe tags: Changing the setting for the synchronization of the tag values with the 
PLC ("offline"/"online")

In addition to logging user actions you can configure tags and recipes to require the user to 
confirm or acknowledge specific actions with an electronic signature or add a comment to the 
change.

Manual logging by means of "NotifyUserAction" system function   
This system function is used to record actions in the Audit Trail that are not automatically 
entered in the Audit Trail. This system function is also used to request the user to enter an 
electronic signature for the action.

Configuring the "NotifyUserAction" system function

Introduction
This system function is used to log user actions that are not entered automatically entered in 
the Audit Trail. This system function can also used to request an acknowledgment, or an 
electronic signature for the user's action.

In this example, the system function is assigned to a button.  All operations with this button 
are logged to the Audit Trail.

Requirements
● "GMP-compliant configuration" has been enabled.

● You created the object that is to be assigned the system function.
A button is used in this example.

● The properties window is open.

Procedure
1. Click the button.

2. Click on "Events" in the Inspector window.

3. Assign the "NotifyUserAction" system function to the "Click" event.
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GMP-compliant user administration 

SIMATIC Logon
To run a central user and user group administration for several applications or HMI devices, 
activate SIMATIC Logon. 

For more information on user administration and SIMATIC Logon, refer to the following chapter: 

Managing users on the server (Page 3511)

Logging system functions

Introduction       
If system functions are triggered in runtime, this is recorded in the Audit Trail for some system 
functions. If specific system functions are used on a GMP-relevant object, the user must 
confirm the triggering.

Some system functions are not supported when using Audit. If you use these system functions 
in your project, you are solely responsible for them.

The following table shows which system functions are Audit-relevant and whether the user's 
signature is required:

System functions and Audit

Function (call in script) Effect of /Audit
StartLogging (StartLogging) entered in Audit Trail
StopLogging (StopLogging) entered in Audit Trail
ClearLog (ClearLog) entered in Audit Trail
StartNextLog (StartNextLog) entered in Audit Trail
CloseAllLogs (CloseAllLogs) entered in Audit Trail
OpenAllLogs (OpenAllLogs) entered in Audit Trail
LogTag (---)  ---
CopyLog (CopyLog) entered in Audit Trail
ActivateScreen (ActivateScreen)  ---
ActivateScreenByNumber (ActivateScreenByNumber)  ---
ActivatePreviousScreen (ActivatePreviousScreen)  ---
SetBitInTag (SetBitInTag) entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

ResetBitInTag (ResetBitInTag) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration
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Function (call in script) Effect of /Audit
InvertBitInTag (InvertBitInTag) entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

SetBit (SetBit) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

ResetBit (ResetBit) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

InvertBit (InvertBit) entered in Audit Trail when tag is GMP-
relevant
System function must not be applied to 
tags that require signing or comment.

SetBitWhileKeyPressed (---) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

SetDataRecordToPLC (SetDataRecordToPLC) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

GetDataRecordTagsFromPLC (GetDataRecordFromPLC) entered in Audit Trail if the recipe is 
GMP-relevant

ImportDataRecords (ImportDataRecords) entered in Audit Trail if the recipe is 
GMP-relevant

ImportDataRecordsWithChecksum 
(ImportDataRecordsWithChecksum)

entered in Audit Trail if the recipe is 
GMP-relevant

ExportDataRecords (ExportDataRecords) ---
ExportDataRecordsWithChecksum 
(ExportDataRecordsWithChecksum)

---

LoadDataRecord (LoadDataRecord) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

SaveDataRecord (SaveDataRecord) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

SetDataRecordTagsToPLC (SetDataRecordTagsToPLC) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

GetDataRecordTagsFromPLC 
(GetDataRecordTagsFromPLC)

entered in Audit Trail if the recipe is 
GMP-relevant
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Function (call in script) Effect of /Audit
SetRecipeTags (SetRecipeTags) entered in Audit Trail if the recipe is 

GMP-relevant
GetDataRecordName (GetDataRecordName)  ---
ClearDataRecordMemory (ClearDataRecordMemory) Not supported
ClearDataRecord (ClearDataRecord) entered in Audit Trail if the recipe is 

GMP-relevant
PrintScreen (PrintScreen)  ---
PrintReport (PrintReport)  ---
RecipeViewSaveDataRecord (---) entered in Audit Trail if the recipe is 

GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewSaveAsDataRecord (---) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewNewDataRecord (---)  ---
RecipeViewClearDataRecord (---) entered in Audit Trail if the recipe is 

GMP-relevant
RecipeViewGetDataRecordFromPLC (---) entered in Audit Trail if the recipe is 

GMP-relevant
RecipeViewSetDataRecordToPLC (---) entered in Audit Trail if the recipe is 

GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewSynchronizeDataRecordWithTags (---) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewRenameDataRecord (---) entered in Audit Trail if the recipe is 
GMP-relevant

RecipeViewBack (---)  ---
RecipeViewOpen (---)  ---
RecipeViewMenu (---)  ---
TrendViewScrollForward (---)  ---
TrendViewScrollBack (---)  ---
TrendViewExtend (---)  ---
TrendViewCompress (---)  ---
TrendViewBackToBeginning (---)  ---
TrendViewStartStop (---)  ---
TrendViewSetRulerMode (---)  ---
TrendViewBackToBeginning (---)  ---
StatusForceGetValues (---) Not supported
StatusForceSetValues (---) Not supported
AlarmViewAcknowledgeAlarm (---) entered in Audit Trail
AlarmViewEditAlarm (---)  ---
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Function (call in script) Effect of /Audit
AlarmViewShowOperatorNotes (---)  ---
HTMLBrowserBack (---) Not supported
HTMLBrowserForward (---) Not supported
HTMLBrowserRefresh (---) Not supported
HTMLBrowserStop (---) Not supported
ScreenObjectCursorUp (---)  ---
ScreenObjectCursorDown (---)  ---
ScreenObjectPageUp (---)  ---
ScreenObjectPageDown (---)  ---
PressButton (---)  ---
ReleaseButton (---)  ---
SmartClientViewConnect (---) Not supported
SmartClientViewDisconnect (---) Not supported
SmartClientViewReadOnlyOn (---) Not supported
SmartClientViewReadOnlyOff (---) Not supported
SmartClientViewRefresh (---) Not supported
SmartClientViewLeave (---) Not supported
ShowAlarmWindow (ShowAlarmWindow)  ---
ClearAlarmBuffer (ClearAlarmBuffer)  ---
ShowSystemAlarm (ShowSystemAlarm)  ---
SetAlarmReportMode (SetAlarmReportMode)  ---
Logoff (Logoff) entered in Audit Trail
GetPassword (GetPassword)  ---
GetGroupNumber (GetGroupNumber)  ---
ExportImportUserAdministration 
(ExportImportUserAdministration)

Import of user administration is entered 
in Audit Trail
Export is not entered in Audit Trail

Logon (Logon) entered in Audit Trail
GetUserName (GetUserName)  ---
TraceUserChange (---)  ---
ShowLogOnDialog (---)  ---
LinearScaling (LinearScaling) entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

InverseLinearScaling (InverseLinearScaling) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

IncreaseFocusedValue (---)  ---
DecreaseFocusedValue (---)  ---
OpenCommandPrompt (OpenCommandPrompt) Not supported
OpenControlPanel (OpenControlPanel) Not supported
ActivateCleanScreen (---)  ---
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Function (call in script) Effect of /Audit
AdjustContrast (---)  ---
CalibrateTouchScreen (CalibrateTouchScreen)  ---
OpenScreenKeyboard (OpenScreenKeyboard)  ---
OpenTaskManager (OpenTaskManager) Not supported
BackupRAMFileSystem (BackupRAMFileSystem) Not supported
SetAcousticSignal (SetAcousticSignal)  ---
ShowOperatorNotes (ShowOperatorNotes)  ---
AcknowledgeAlarm (AcknowledgeAlarm) entered in Audit Trail
GoToHome (GoToHome)  ---
GoToEnd (GoToEnd)  ---
EditAlarm (EditAlarm)  ---
DirectKeyScreenNumber (---) Not supported
DirectKey (---) Not supported
SetDeviceMode (SetDeviceMode) entered in Audit Trail
SetDisplayMode (SetDisplayMode)  ---
SetConnectionMode (SetConnectionMode) entered in Audit Trail
SetScreenKeyboardMode (SetScreenKeyboardMode)  ---
ChangeConnection (ChangeConnection) Not supported
SetLanguage (SetLanguage)  ---
SetWebAccess (---) Not supported
StartProgram (StartProgram) Not supported
ShowSoftwareVersion (ShowSoftwareVersion)  ---
SimulateTag (---) Not supported
StopRuntime (StopRuntime) entered in Audit Trail
ControlWebServer (ControlWebServer) Not supported
ControlSmartServer (ControlSmartServer) Not supported
OpenInternetExplorer (OpenInternetExplorer)  ---
SendEMail (SendEMail)  ---
UpdateTag (---)  ---
ClearAlarmBufferProTool (ClearAlarmBufferProtoolLegacy) Not supported
Encoding(Encode) entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

EncodeEx(Encode) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration
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10.16.1.5 Performance features of GMP relevant configuration

Supported HMI devices

Supported HMI devices  
The qualification "GMP relevant configuration" can be configured for the following HMI devices:

● TP 277

● OP 277

● MP 277

● Mobile Panels 277

● MP 377

● Comfort Panels

● Panel PCs with WinCC RT Advanced

● WinCC RT Advanced
 

  Note

The qualification "GMP" is not supported by WinCC RT Professional.
 

Restrictions

Restrictions  
The following functions and configurations cannot be used simultaneously with the qualification 
"GMP relevant configuration":

● "Status/Force" object

● PN direct keys

● DP DirectKey

● Option /Sm@rtServer

● /Sinumerik option

● The functional scope of the HMI devices is only available to a restricted degree in some 
circumstances because of the limited storage space
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● Events of screen objects
You can set mandatory acknowledgement of important user actions in runtime, such as 
changing tag values. If you assign an event which has to be acknowledged to a screen 
object, you may not assign any other events to this graphic object. 
When the event of a screen object is assigned actions which open a user dialog (such as 
change of a tag value with mandatory acknowledgement), you may not be able to execute 
these actions at other events. 

● Controlling GMP-relevant tags using a slider
The slider is not suitable for controlling GMP-relevant tags. Any operation of the slider will 
continuously change the tag value. If this is a GMP-relevant tag, a flood of entries will be 
generated in the AuditTrail. 

10.16.2 Sm@rt Options

10.16.2.1 Basics

Sm@rt Options

Introduction
Using the Sm@rt Options from WinCC, you can communicate between HMI-systems or to an 
HMI-System by means of TCP/IP-connections (e.g.LAN).

Use of the Sm@rt Options
● Distributed operator stations with Sm@rtClients for controlling large machines or machines 

that are spread out over a large area.

● Operator stations with system-wide access to current process data via the communication 
driver "SIMATIC HTTP Protocol".

● Local servicing solution for the central archiving, analysis and additional processing of 
process data.

● Provision of current process data for higher-level systems (SCADA, production 
management systems, office applications).

● Remote control of an HMI-System by means of Internet, Intranet and LAN.

● Sending of E-Mails on the basis of messages and events

● Provisioning of Standard-HTML-Pages in HMI-system with service-and maintenance 
information as well as diagnostic functions.

User benefits: 
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● Flexible solution for access to HMI systems and process data from any location

● Reduction of load on the field bus:
For example, the combination of WinCC Runtime and SIMATIC panels enables a factory 
control system to have access to process data. No load is placed by the factory level on 
the sensitive field level with respect to the necessary communication requirements. These 
requirements are handled by HMI Runtime along with the SIMATIC-panels.

● Expensive on-site service visits to be avoided by using the remote control. Unplanned non-
operation periods are reduced and the system productivity is increased.

 

  Note

The default password for the Sm@rtServer and for the integrated web server is "100". 
This password should be changed for security reasons.

 

 

Application scenarios

E-Mailing and remote diagnostics
A factory has a service contract with an external service company. The HMI device and the 
service technician's PC are linked together over a TCP/IP-ready network. E-mail delivery of 
certain alarms to the service technician was configured in the project. The service technician 
accesses the HMI device via the Internet and executes remote diagnostics.
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Application example:
Amongst other things,flow rates are measured in the process control of a cooling unit. 
Contamination in a feed line reduces the flow of coolant. When the flow rate drops below the 
configured threshold value, the operating device displays a warning. In addition,this warning 
is also dispatched as an e-mail to the assigned service technician. 

The service technician then establishes a connection with the remote device and takes the 
appropriate actions. 

Advantage: An alarm that reaches the service technician in a timely manner helps to minimize 
unplanned downtime.

Distributed operator stations
Distributed operator systems, the Sm@rtClients are used for controlling large machines or 
machines that are spread out over a large area.

The Client-HMI device connects to Sm@rtServer via the Sm@rtClient-Display. 

The operator can operate and monitor the system from various locations. The operator sees 
the same image at each operator station, whereby only one station can be operated at one 
point of time.

The type of operation is also named as a coordinated operation. Then you must change the 
configuration only at Sm@rtServer.  

Access to the tags via SIMATIC HMI HTTP Protocol

Operator stations with system-wide access
For use of the SIMATIC HMI HTTP Protocol, you can provide tags of HMI-device (HTTP-
Server) to another device (HTTP-Client). 

Thus the local as well as centrally used HMI-systems have access to the tags of other stations. 
Cell-concepts or line-concepts can be simply implemented. De-centrally obtained information 
is available centrally.

This concept also permits the setting of cost-effective and small central servicing. There are 
additional options for archiving, analysis and additional processing of registered process data, 
if a PC is used for that.

Remote monitoring and remote control- servicing solution
If you connect the use of the SIMATIC HMI HTTP Protocol and the Sm@rtServer with each 
other, you can implement a complex servicing solution.  

For this,display the interested tags of the HMI-devices on the Service-PC. If necessary, use 
the PC for the remote monitoring and remote control of a specific HMI-device. 

The locally used HMI-devices are connected with each other and the total process is controlled 
comprehensively. 
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The concept of the remote servicing is possible by using the Sm@rtClient-Display in the 
servicing HMI-Application. The operator has access to the respectively desired local HMI-
device through flexible configuration of the Sm@rtClient-Display.

Connection to the Office-world
The possibility of data exchange exists between HMI-device and office-applications, e.g. MS 
Excel, with help of VBA-Macro. 

For this, the HMI-device must support the Web-Service(SOAP). A script or macro is called in 
the external application, which has only read or write access to the concerned tags according 
to provided syntax. 

HMI devices suitable for use

HMI devices suitable for use
The following table shows the HMI-devices that are suitable for the use of Sm@rt Options.   

The number of the connections based on "SIMATIC HMI HTTP Protocol" and the number of 
maximum connected Sm@rtClients depends on the HMI-device. For additional information 
see the "Performance features" documentation and in the technical manual of your HMI-device.

Technical data subject to change.

HMI device Sm@rt Options
270 series Yes
370 series Yes
OP 177B, TP 177B Yes
Mobile Panel 177 PN, Mobile Panel 277 Yes
In view mode only:
● Mobile Panel 277 IWLAN
● Mobile Panel 277 IWLAN V2
● Mobile Panel 277F IWLAN (RFID Tag)

Yes

Comfort Panels Yes
WinCC Runtime Advanced Yes

Combining options on panels
The following table shows which options and functions on the panels can be combined with 
each other. 

Technical data subject to change.
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 SIMATIC HMI 
HTTP Protocol 

Sm@rt Options HTML 
browser

WinAC/ MP

SIMATIC HMI HTTP 
Protocol 

-- Yes Yes Yes

Sm@rtServer Yes -- No No
HTML browser Yes No -- No
WinAC/ MP Yes No No --

Settings for Sm@rt Options 

Configuration in WinCC

Introduction
In the "Runtime-Settings" Editor, configure the requirements for using the Sm@rt Options.    

As an alternative, configure the settings in the Control Panel of the HMI-device. 

Note that the settings on the control unit have a higher priority than the settings in the WinCC-
project.
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Open
Double-click on the "Runtime-settings" entry in the project tree. In the "Runtime-settings" editor, 
click on the "Services". 

Work area
Enter the settings for the selected HMI device in the work area: 

● "Remote control" Group.

– Sm@rtServer
Configures the HMI-device as Sm@rtServer. 

● "Read/write tags" Group.

– SIMATIC HMI HTTP Server
Configures the HMI device as HTTP-Server.

– Web-service SOAP
Activates the tags-access via SOAP.
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● "Diagnostics" Group

– HTML pages
Activates Service-pages of the HMI device. 

● "SMTP-Communication" Group

– Server name
Enter the name of SMTP server, through which you want to send E-mails.

– Name of the sender
Enter the sender name. The recipient sees in the E-Mail from which device the E-mail 
originates, e.g. "HMI device Production line 2". If the function is not supported by the 
SMTP-Server, delete the entry. You can obtain more detailed information for this from 
your service provider.

– E-mail address
If you use an SMTP server that requires a valid e-mail address for authentication, enter 
it here, for example, "John.Doe@gmx.net. 

– User name
If you use an SMTP server that requires a user name for authentication, enter it here. 
You can obtain the user name from your service provider.

– Password
If you are using an SMTP server that requires a password for authentication, enter this 
password. You can obtain the user name from your service provider.

– The server requires a secure connection (SSL).
The data are sent via an SSL connection. Your service provider can tell you if your mail 
server supports an SSL connection. 

Configurations on the HMI device

Settings on the HMI device

Introduction
The Sm@rt Options settings in the HMI device are configured in the dialog box "WinCC 
Runtime Advanced Internet".  

Additional tabs may be included in the dialog "WinCC Runtime Advanced Internet". This 
depends on which options are activated for the network operation in the project. 

Note that the settings on the control unit have a higher priority than the settings in the WinCC-
project.

Tabs
You have opened the dialog "WinCC Runtime Advanced Internet" with the symbol "WinCC 
Runtime Advanced Internet" .

The "WinCC Runtime Advanced Internet" dialog of the control panel can contain the following 
tabs: 
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● WinCC Runtime Advanced Internet, "Email" tab (Page 5806)

● WinCC Runtime Advanced Internet, "Proxy" tab (Page 5807)

● WinCC Runtime Advanced Internet, "Web Server" tab (Page 5808)

● WinCC Runtime Advanced Internet, "Remote" tab (Page 5809)

Input area plan
At Sm@rtServer and Sm@rtClient, the same input area plan must be set.         

The Sm@rtServer uses the Standard-Input area plan of the operating system: 
(Start>Settings>Control Panel> Country settings>Tab "Entry"). These changes become 
effective after system restart.

At Sm@rtClient, the same input area plan must be set like at Sm@rtServer. No restart is 
necessary after the switchover of input area plan at Sm@rtClient. 

WinCC Runtime Advanced Internet, "Email" tab

Purpose of the dialog box
Specifies the settings for the E-Mailing.     

Settings
● SMTP server

– Enter the SMTP-server name.

– Use the default of project file
The SMTP-Server name from the WinCC-Project is used.

● Name

– Name of sender
Enter the sender name. The receipient sees in the E-Mail, from which device the E-mail 
originates, e.g. "HMI-device Production line 2".
If the function is not supported by the SMTP-Server, delete the entry. You can obtain 
more detailed information for this from your service provider.

– eMail Adress of sender
If you use an SMTP server that requires a valid e-mail address for authentication, enter 
it here, for example, "John.Doe@gmx.net. 

Dialog "Advanced Email Settings"
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● Authentication

– Use the default of project file
The user name and the password from the WinCc-Project are used.

– Disable authentication
Authentication is not required.

– Use panel settings for authentication
The settings of the HMI-device are used. Enter the user name under "Login" and the 
password under "Password". You can obtain the user name and the password from your 
service provider.

● Encryption

– Use the default of project file
The setting from the WinCC-Project is used.

– Enable SSL
The user information and e-mail are encrypted for transmission.

– Disable SSL
The user data and e-mail are sent un-encrypted. 

See also
Settings on the HMI device (Page 5803)

WinCC Runtime Advanced Internet, "Proxy" tab

Purpose of the dialog box
Settings for utilizing the Proxy-Server. 

 

 Note

Enter the Proxy-Server in "Internet Options" at PC.
 

Settings
● Use proxy server

Activate the "Use Proxy Server" if access is given in your network via Proxy-server. 

● Proxy
Enter the name or the address of the proxy-server. 

● Port
Enter the port of the proxy-server. 
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WinCC Runtime Advanced Internet, "Web Server" tab

Purpose of the dialog box
The following is configured:         

● The utilization of the integrated web server and of the HTTP-Server

● User and user web authorizations 

Settings
Tag access

Governs the access to tags via the "SIMATIC HMI HTTP protocol": 

● "Read/write": Read/write access

● "Read only": read access only

Tag authenticate

Governs the authentification in case of access to variables via the SIMATIC HMI HTTP 
Protocol": 

● "No authentication": No authentification is required for access.

● "Authentication required": An authentification is required for access.
Specify the user name and password when configuring the communication driver "SIMATIC 
HMI HTTP Protocol". 

Enable Remote-Transfer for Projects

This setting enables remote transfer of project files. 

Start automatically after booting

(on panel only) 

The web server is automatically started after the HMI device boots. As a result, the web server 
is utilized independent of the runtime. 

 

 Note
Start web server automatically on PC 

Add a link with the program "Miniweb.exe" in the Autostart-Organizer in order to start the web 
server automatically after the PC starts. The program is located in the installation index of 
runtime. 

 

Close with Runtime

The web server is closed along with Runtime. 

User Administration

After entering the password "100", the "UserDatabase-Edit".  dialog opens. The 
"UserDatabase-Edit" dialog is theuser administration of the web server. 

Start Webserver
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Starts the web server. 

Close Webserver

Ends the web server. 

WinCC Runtime Advanced Internet, "Remote" tab

Purpose of the dialog box
Settings for the Sm@rtServer     

Settings
Start automatically after booting

The Sm@rtServer is automatically started after the HMI device boots. Otherwise the 
Sm@rtServer starts together with the Runtime. 

Close with runtime

The Sm@rtServer is closed together with Runtime. 

Change settings

Opens the "Sm@rtServer: Current User Properties" dialog for specifying the passwords, 
authorizations, the screen update mechanism and the behavior when connections are 
disconnected.

 

 Note

This dialog is titled "Sm@rtServer: Default Local System Properties" on the panel. 
 

The dialog contains the following tabs:

● "Server" tab (Page 5810)

● "Polling" tab  (Page 5811)

● "Display" tab (Page 5812)

● "Query" tab (Page 5813)

● "Administration" tab (Page 5813)

Start Remoting

Starts the Sm@rt Server explicitly. 

Stop Remoting

Ends the Sm@rt Server explicitly. 
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"Sm@rtServer Dialog: Current User Properties" 

"Server" tab

Purpose of the dialog
Specifying passwords, web authorizations and the disconnection. 

Incoming connections
Settings for handling an attempt to establish a connection. 

● Accept socket connections
This setting enables the connection to the HMI device. It is a basic requirement for using 
the Sm@rtServers from the outside.
If this check box is deactivated, no remote monitoring and no remote control is possible.

● Password 1
First password for remote access. "View only" is disabled as default.

● Password 2
Second password for remote access. "View only" is selected by default.
This password can be provided as a reserve password for third-party users (such as service 
technicians); it can be modified when necessary without significant effort within the 
organization.

● View only
If this check box is enabled, read access (monitoring mode) is the only access available 
when the corresponding password is entered.
Default: Enabled

 

  Note

Both key words are preset with "100". Change this password during commissioning 
according to your requirements.

 

Enable network packets queuing (slower)
This setting enables splitting of data into multiple data packets, which are sent separately over 
the network. It is useful when multiple clients are connected.

Display or port numbers to use
Here, you select the TCP/IP port in the network where the Sm@rtServer waits for attempts to 
establish a connection.

● "Auto": The Sm@rtServer automatically searches for the appropriate port by itself.

● "Display": The server uses port 5900 plus display number. For HTTP, the server utilizes 
Port 5800 plus display number.

● "Ports": You enter the port numbers for the "main" and "HTTP" yourself.
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No local input during client session
The keyboard and mouse on the server-HMI device are disabled as long as connections are 
active.

For example, this setting is useful when an HMI device is being administered from outside.

Remove desktop wallpaper (on PC only)
This setting removes the screen background on the PC, thus saving transmission effort.

Default: Enabled

When last client disconnects (on PC only)
This setting governs the behavior after disconnection of the last client connection:

● "Do nothing": no response.

● "Lock workstation": Server PC is locked.

● "Logoff workstation": Server PC is logged off.

The latter two settings are only useful if the Sm@rtServer is running as a service. 

"Polling" tab 

Purpose of the dialog
Specifying the screen update and the use of virtual graphics driver. 

Polling modes(on PC only)
The settings govern the screen update.

Most changes are recognized automatically by the server. In case of problems, you can enter 
additional settings here.

The update method cannot be set on the panel. The settings is always "Poll Full Screen".

● Poll foreground window (On PC only)
Updates the current window. 
It increases the load on the server.

● Poll window under cursor (On PC only)
Updates the window that is located under the mouse cursor. The window is updated when 
a change occurs in the operator control element under the mouse cursor.
Default: Enabled

● Poll full screen (On PC only)
This setting specifies an update each time the screen changes. This setting provides you 
the lowest display error but places a maximum load on the server.

● Polling cycle
Determine the suitable setting for your configuration. Make sure that the selected update 
cycle is not too short, since it affects the computer load.
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Window polling
● Poll console windows Only (On PC only)

This setting specifies an additional update when changes occur in a console window (MS 
input requirement).

● Poll on event received only (Only on the PC)
This setting specifies an additional update each time an entry is made.
Default: Enabled

● Mirror driver status
(Only on the PC with a mirror driver installed)
Provides information about the status of the virtual graphics driver.

Mirror driver options (only on a PC with installed mirror driver)
Enable direct access to display driver's mirror screen

The shared-memory area of the virtual graphics driver is used for the display. The setting 
improves the performance.

Troubleshooting (on PC only)
● Don't use VNCHooks.DLL while polling full screen

VNCHooks.dll is used by default for the screen update. If VNCHooks.dll causes problems 
when using other program, select this setting.

● Don't use mirror display driver even if available
(Only on the PC with a mirror driver installed)
Use this setting only for troubleshooting. 

"Display" tab

Purpose of the dialog
Setting of the screen display.

Sharing area(on PC only)
● Full desktop

The entire desktop of the server is accessed.

● Primary display
The main screen of the multi-monitor configuration is displayed.

Downscale to(on PC only) 
Scales the screen to be transferred according your inputs. Servers with Windows CE ignore 
this setting.
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"Query" tab

Purpose of the dialog
Settings for incoming connection attempts.

 

 Note

This dialog is titled "Default Local System Advanced" on the panel. 
 

Query settings
These settings govern acceptance of incoming attempts to establish a connection. 

● Query console on incoming connections
The Sm@rtServer registers the incoming attempts to establish a connection and displays 
a dialog on the screen in which the connection attempt is accepted or rejected.

● Query timeout
Set the waiting time.

● Default action
Select the response to an attempt to establish a connection once the waiting time expires: 

– "Refuse": Reject attempt (operator control mode - single mode)

– "Accept": Accept attempt (operator control mode – shared mode)

Allow option to accept without authentication
The dialog for handling attempts to establish connections also contains the button "Accept 
without password" . This gives you the option to accept an attempt to establish connection 
without a password. 

"Administration" tab

Purpose of the dialog
Specifications for session management.

 

 Note

This dialog is titled "Default Local System Advanced" on the panel.
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Administration
● Disable empty passwords

Select this check box in order to allow an empty "Password 1". 
Default: Enabled

● Allow loopback connections
This setting allows connections to your own HMI device. It is useful and necessary when 
security software is used for secure (encoded) connections. 

● Allow only loopback
This setting allows only connections to your own HMI device.

Logging
● Log info to SmartServer.log

(On the panel: Log information to file)
This setting writes information to the server logbook. 

● Log detailed debugging information
This setting writes expanded information to the server logbook (for locating errors). 

With HMI devices operating with Windows CE, the log is only created when the MMC card is 
inserted. If the MMC card is inserted, the log is created directly on the card.

The log files are created in the following path on a PC: C:\Documents and Settings\All Users
\Application Data\Siemens\HmiRTm
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Forced write access
This setting governs forced access in an emergency contrary to normal session management. 

● Password needed
If this check box is not selected, every operator can force access in emergencies as follows:

– Pressing the <Shift> key four times

– Clicking four times

– Touching the screen four times

If this check box is enabled, to force access an attempt must be made to gain access and 
a password must also be entered. 
In this case, enter the applicable password in the input field underneath. If a password is 
not entered, it is not possible to force access in an emergency. 
Default: Enabled

 

  Note

On the server, access can only be forced by pressing the <Shift> key four times, clicking 
four times, or touching the screen four times. 

 

HTTP-Server
● Enable built-in HTTP server

If this check box is activated, the Java-Applet is automatically downloaded on the PC when 
the connection is first established.
The Java applet accesses the Java VM that is installed on the client and enables remote 
monitoring and remote control using Internet Explorer. 
Default: Enabled

● Enable applet params in URLs
Forwards all parameters of the URL to the Sm@rtClient application.

Connection priority
These settings govern handling of attempts to establish a connection by non-shared clients. 

● Disconnect existing connections
When an attempt is made to establish a connection by a non-shared client, the attempt is 
accepted; the existing connections are disconnected (single mode). 

● Automatic shared sesssions
When an attempt is made to establish a connection by a non-shared client, the attempt is 
accepted; the prior existing connections are retained. Access is controlled using session 
management in shared mode. 
Default: Enabled
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● Active user timeout 
For shared mode, enter the time that must elapse without any actions on the active HMI 
device before access can be changed. 
Default setting: 10 seconds

● Refuse concurrent connections
If a non-shared client is already connected to the server, attempts to establish a connection 
by other non-shared clients are rejected. 

See also
Remote control by means of Internet Explorer (Page 5830)

User administration for web server 

Introduction
Different web authorizations for the operation and monitoring are allocated to the users in the 
user administration.     

Requirement
● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Web Server" tab is displayed.

Entries and settings
Click "User Administration" in the "Web Server" tab and enter the password. 

 

 Note

By default, the password is set to "100" and all web authorizations are granted to users with 
"Administrator" rights. Change this password during commissioning according to your 
requirements.

 

The "UserDatabase-Edit" dialog is opened. 

The "UserDatabase-Edit" dialog has three tabs: 
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● Tab "User Manager"
User administration for creation or deletion of users. 
Create a new user using "New"; Delete a user using "Remove". The recreation and deletion 
become effective using "Apply". 

● Tab "Description"
You can store a description of or comments on the users selected on the "User Manager" 
tab. 

● Tab "Authorizations"
Specify the web authorizations for the users selected on the "User Manager" tab. You use 
"Add" to activate a web authorization and "Remove" to deactivate one. 
By default, the password is initially preset to "100" and all web authorizations are granted 
to users with "Administrator" rights. 
For read and write access to the file browser, the user must possess the web authorizations 
"FileBrowserAdministrator" and "FileBrowserUser".
 

 

  Note

In principle, every user who has access to the control panel can manage users and web 
authorizations. If necessary, protect the control panel from unwanted access.

 

List of web authorizations 
The following  web authorizations exist:     

Web authorization Authorized for: 
UserData Import and export of recipes 
UserAdministrator Import and export of password lists 
RuntimeAccess Starting and stopping of runtime
Engineering HTTP transfer from ES to the target device
FileBrowserUser Read access to the file browser
FileBrowserAdministrator Read/write access to the file browser 
RTCommunication Utilization of the SIMATIC HMI HTTP server
SoapUser Read/write access via web service (SOAP) 
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Settings for remote control

Session management for remote control 

Introduction
WinCC enables remote monitoring and remote control of HMI devices over a TCP/IP-ready 
network such as a LAN or the Internet. Remote monitoring and remote control is implemented 
in different ways:     

● Remote control by means of Internet Explorer

● Remote control by means of the Sm@rtClient-application

● Remote control by means of the Sm@rtClient-display in

Only one device can ever have access to the HMI-device. Which device is permitted access 
is determined by the session management. 

Session management options
Session management is used to control access. The client-server connection can be in one 
of two modes: 

● Monitoring mode

● Control mode

Monitoring mode
If the client accesses the server in monitoring mode, the operator can see the current screen 
of the HMI device and track all changes. He can monitor the server but cannot operate.     

In the monitoring mode, all the keys on the client retain their standard functions. 

If remote control was started from the Sm@rtClient display, the operator uses the <Tab> key 
or the cursor keys to go to the next object in the current screen of the client project. 

Control mode
If the client accesses the server in operator control mode, the operator can use the mouse and 
the keyboard to control the server from the client. If an access attempt is made from another 
client, the assignment of operating permission depends on the settings at the server and at 
the clients. 

In operator control mode, the client keys act on the server screen. Thus, the operator uses the 
<Tab> key to go to the next object in the current screen of the project running on the server. 

If remote control was started from the Sm@rtClient display, the operator can only go to another 
object or screen in the project on the client by using an additionally configured function or an 
additional menu command. The operator to this menu command as follows:
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● On the Touch-device, in which he touches the screen longer than 1 sec.

● On the keyboard =device, in which he masks on the menu with <Shift+Control> and  
operates  it with <Alt> and the keyboard.

In both operating modes, the Sm@rtServer is set so that the operator at the remotely controlled 
device, the server, can be prevented from performing any activities. 

In an emergency, the operator can exact the user rights on a remotely controlled HMI device 
as well as on an inactive HMI device. If no password is specified, he must click the user 
interface four times consecutively, touch the screen four times consecutively, or press the 
<Shift> key four times consecutively. If a password is specified, he must click once or press a 
key on the client and then enter the specified password. 

Settings for session management
You make settings for session management on the server and on the client in the Control 
Panel "WinCC Internet Settings". 

Configuring Sm@rtServer for remote control

Introduction
The Sm@rtServer has an internal security concept based on passwords and special settings 
for session management.         

Security concept for the Sm@rtServer
Remote monitoring and remote control of the Sm@rtServer at the Sm@rtClient is protected 
by two passwords. The second password is used as a further password for additional access, 
for example, as a service password. Both key words are preset with "100". The key word can 
be easily changed, if required.

Settings on the Sm@rtServer
The settings on the server govern which remote operators can access the runtime of the server.

The passwords for access are set on the server. Open "WinCC Runtime Advanced Internet" 
in the control panel. On the "Remote" tab, click "Change Settings". On the following Server 
tab of the subsequent dialog, enter the passwords of the Sm@rtClient. For both passwords, 
you can use "View only" to set the monitoring mode and to exclude operator control mode.

On the panel, this dialog is called "Sm@rtServer: Default Local System Properties" and 
contains fewer dialog elements than the dialog on the PC.
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Control mode
To enable operator control mode, the "View only" check box must be cleared.

The manner in which the individual remote control station can access the server is set on the 
"Administration" tab.
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● "Disconnect existing connections"
When an access attempt is made by an non-shared client, the previous connection is 
automatically disconnected and control is transferred to the new client.
When an attempt is made to access by a shared client, the behavior is the same as 
described for "Automatic shared sessions".

● "Automatic shared sessions"
When an access attempt is made, control is transferred to the new client.
The condition for transferring control is that no action has been undertaken by the previously 
active client for a period of time (in seconds) as specified in the "Active user timeout" setting.

● "Refuse concurrent connections"
When an attempt is made to access by a non-shared client, this access attempt is rejected 
so long as the operator station that currently has access is still connected to the server.
When an attempt is made to access by a shared client, the behavior is the same as 
described for "Automatic shared sessions".

Disabling local operator control of the server
To do so, open the "WinCC Internet Settings" in the Control Panel. On the "Remote" tab, click 
"Change Settings". On the "Server" tab in the subsequent dialog, select "No local input during 
client session".   

Password for forced access
A password can be specified in "Forced Write Access" for forced access in an emergency.   

Sm@rtServer as a service
You can let the Sm@rtServer run as a service. The operator can then also access the service-
HMI device from the client-HMI device, for example, the screen saver is active with a password.

Select the check box "Start automatically after booting" in "WinCC Runtime Advanced Internet" 
on the "Remote" tab.   

Sm@rtServer as service in Windows 7
The Sm@rtServer always runs as a service under Windows 7. You cannot stop the 
Sm@rtServer in Runtime with the Notification Area in the taskbar. You have the following 
options for stopping the Sm@rtServer:
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● Stop using the "ControlSmartServer" system function
Configure the "ControlSmartServer" system function to a button, for example. Select the 
"Stop" mode at the system function. You can stop the Sm@rtServer in Runtime by clicking 
the button.

● Stopping the Sm@rtServer in the Control Panel:
Open "WinCC Runtime Advanced Internet" in the control panel and select the "Remote" 
tab. Click on the "Stop" button. Sm@rtServer is stopped.

● Stopping Sm@rtServer by stopping Runtime:
Open "WinCC Runtime Advanced Internet" in the control panel and select the "Remote" 
tab. Activate the "Close with Runtime" option. The Sm@rtServer is stopped at the stop of 
Runtime. 

Configure Sm@rtClient for remote control

Settings on the client PC
● Monitoring mode   

At the client-PC you limit the connection to observation mode, if required. This allows you 
to prevent unintended control operations.

– If connection is via the Sm@rtClient application
In the following "Sm@rtClient Connection" of Sm@rtClient-application, click "Options..." 
button. In the "Sm@rtclient Options" dialog, select the setting"View only (inputs 
ignored)".

– If connection is via Internet Explorer
Click on the button "Options..." and select "View only" in the subsequent dialog.

● Layout
You can also specify whether or not the HMI-device is to be displayed with the same layout 
in the Sm@rtClient application. This is useful if you access from a PC on a touch device. 
In order to suppress the layout, select the "Sm@rtclient Options" setting in the "Suppress 
Device Layout" dialog. 
In addition, you can use "Scale by" to zoom in or out of the layout. To use "Scale by", the 
Suppress Device Layout setting must be selected or the HMI-device must not supply any 
layout. Otherwise, the desktop is always displayed with a zoom setting of 100%.

 

  Note

If you scale the display, the performance may be impaired in some situations: 
● Strong scaling, for example from 1600 x 1200 px to 640 x 480 px.
● Scaling with non-matching scaling factors, for example from a 4:3 resolution to 16:10 

resolution.
 

Configuring of the Sm@rtClient-display
You can configure the Sm@rtClient display in different ways, and thereby set certain inputs: 
The server name, the password for accessing Sm@rtServer or the restriction to the monitoring 
mode.
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Sm@rtClient-Application

Dialog "New Sm@rtServer: Connection"

Introduction
This dialog opens when you click the "Sm@rtClient" button in the taskbar. 

Purpose of the dialog box
This dialog is used for selecting the server and the connection method. 

Sm@rtServer:

Enter the address of the server to which the connection is to be established. The various 
options for entering the address can be found in "Remote control by means of the Sm@rtClient 
application  (Page 5830)".

Connection profil

Select the type of connection to the server according to the network you are using. 

Listening mode

If you enable this function, the Sm@rtClient application is minimized and appears as a button 
in the Windows taskbar. The Sm@rtClient waits for the Sm@rtServer to establish a connection. 
To establish the connection, click the "Sm@rtServer" button in the Windows taskbar of the 
server. Select "Add new client" in the context menu.

Options

The "Sm@rtClient Options" dialog containing the technical settings for the Sm@rtClient-
application is displayed. 

See also
"Options" dialog, "Globals" tab (Page 5825)

"Options" dialog, "Connections" tab (Page 5823)

"Options" dialog, "Connections" tab

Purpose of the dialog box
Technical settings for the Sm@rtClient-application are specified in this dialog box.

Only change the settings here in special cases.
 

 Note

You can also specify these settings in the Java Applet. Note that some of the dialog elements 
are named differently there.
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Format and encodings

Settings for compressing (encoding) the screen data of the server. 

● Use encoding
Preassigned based on the selection under "Connection profile".
Select the desired compression or "Raw" (no compression).

● User 8-bit color
(Only in the Java-Applet): Reduces the color depth at the client to 8 bits (256 colors). The 
data are then transferred faster. However, incorrect colors may result.

● Custom Compression level
Allows individual customizing of the compression level in the "Level" input field:
1 = least compression (faster); 9 = maximum compression (slower).

● Allow JPEG compression
Allows the use of JPEG compression (involves losses).
Enter the "Screen quality" in the input field underneath: 
1 = least compression (faster); 9 = maximum compression (slower).

● Allow CopyRect encoding
(In the Java-Applet: Use CopyRect. Encoding)
Allows compression while using "similar rectangles".

Restrictions

● Viewonly (inputs ingnored)
Sets the view mode for this client irrespective of the settings on the server.

● Disable clipboard transfer
Disables the clipboard that is used to transfer data from one PC to another. Applies only 
to the copying and pasting of texts.
This functionality is not available at a Windows CE server.

Display

Settings for the screen display

● Scale by
Zooms in or zooms out the desktop to be displayed. To use "Scale by", the Suppress Device 
Layout setting must be selected or the HMI-device must not supply any layout. Otherwise, 
the desktop is displayed with a zoom setting of 100%. 

● Fullscreen Mode
Displays the desktop to be shown in full-screen mode. If the server screen is larger than 
the screen of the client, it is scrolled automatically by the mouse movement.

● Suppress Device Layout
In the Sm@rtClient application window, the entire layout of remote HMI-device is not shown. 

● Use CTRL + Cursor Key for Scrolling
The key combinations <CTRL> + cursor key are used to scroll within the local screen. They 
are no longer transferred to the server.

Mouse

(In the Java-Applet: Mouse buttons 2 and 3)

Settings for the evaluation of mouse actions
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● Emulate 3 Buttons (with 2-button click)
Emulation of a three-button mouse by a two-button mouse.

● Swap mouse buttons 2 and 3
(In the Java-Applet: reversed/normal)
Mouse buttons 2 and 3 are swapped.

Mouse cursor

(In the Java-Applet: Cursor shape updates)

Settings for the display of the cursor

Select the type of transfer of the mouse actions:

● Track remote cursor locally
The information on the location of the cursor is transferred separately from the screen 
information. This speeds up the transfer of the cursor. (JavaApplet: Enabled)

● Let remote server deal with mouse cursor
Tracks the server cursor to the client cursor. This allows more accurate cursor positioning. 
(YES: Ignore)

● Don't show remote cursor
The cursor at the server is not included in the transfer. (YES: Disable)

Request shared session

(In the Java-Applet: Share desktop)

Declares this client to be a non-exclusive client. 

See also
Dialog "New Sm@rtServer: Connection" (Page 5821)

"Options" dialog, "Globals" tab

Purpose of the dialog box
Technical settings for the Sm@rtClient-application are carried out in this dialog box. 

Only change the settings here in special cases.
 

 Note

You can also carry out these settings in the Java Applet. Note that some of the dialog elements 
are named differently there.

 

Interface options

● Show toolbars by default
Displays the toolbar. 

● Warn at switching to the full-screen mode
Outputs a message before the full-screen mode is activated.
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● Enable Onscreen keyboard
Enables the display of the on-screen keyboard

● Number of connection to remember
The client creates a list of the recently used connections. This setting specifies the number 
of connections listed.

● Clear the list of saved connections
The list is cleared.

Local cursor shape

Specifies the appearance of the local cursor. This allows you to better differentiate between 
the local cursor and remote cursor.

Listening mode

● Accept reverse VNC connections on TCP port
Specifies the TCP port number. The Sm@rtClient waits for the Sm@rtServer to establish 
the connection over this TCP port number.

Logging

● Write log to a file
Writes information in the logbook of the Sm@rtClient-application.

● Verbosity level
Writes expanded information to the server logbook of the Sm@rtClient-application (for 
locating faults). The amount of detail in the information is dependent on the verbosity level 
setting. 

Remote control of key devices

Mapping of the function keys 
HMI devices are equipped with a variety of function keys. 

Example:

From the PC keyboard, you want to remotely control key F20 on the "MP 377 key" of HMI-
device. 

You can control the F20 key with the PC-keyboard shortcut <SHIFT + F8>.

The table provides you with an overview for controlling the keys.

xP177/277 xP377 PC keyboard shortcut 
F13 F13 SHIFT + F1
F14 F14 SHIFT + F2
F15 F15 SHIFT + F3
F16 F16 SHIFT + F4
F17 F17 SHIFT + F5
F18 F18 SHIFT + F6
F19 F19 SHIFT + F7
F20 F20 SHIFT + F8
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xP177/277 xP377 PC keyboard shortcut 
K1 S1 SHIFT + F9
K2 S2 SHIFT + F10
K3 S3 SHIFT + F11
K4 S4 SHIFT + F12
K5 S5 CTRL + F1
K6 S6 CTRL + F2
K7 S7 CTRL + F3
K8 S8 CTRL + F4
K9 S9 CTRL + F5
K10 S10 CTRL + F6
K11 S11 CTRL + F7
K12 S12 CTRL + F8
K13 S13 CTRL + F9
K14 S14 CTRL + F10
K15 S15 CTRL + F11
K16 S16 CTRL + F12
HELP HELP ALT + H
ACK ACK ALT + F1

Use and restrictions of Sm@rt Options

Use restrictions
While using the Sm@rt Options, observe the following instructions: 

● HMI devices suitable for use
For additional information, refer to "Usable HMI devices".

● Sm@rtServer and Sm@rtClient

– If a PC is used as a Sm@rtServer, select the highest-performance platform available.

– Use only simple projects.

– Avoid photographs and color gradients in screens.

– Avoid heavy background loads during operation, for example, those from user-defined 
functions or logs.

– The number of the maximum connected Sm@rt Clients depends on the Server-HMI 
device. For additional information, see the "Performance features" documentation.

– To improve the performance of the Sm@rtServer, you can disable hardware 
acceleration of the graphics card .  

– You inevitably loose performance at the HMI when you access the HMI-device using 
the Sm@rtClient functionality.
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● SIMATIC HMI HTTP Protocol

– Tag exchange via the SIMATIC HMI HTTP Protocol is not suitable for exchanging bulk 
data.

– The maximum number of connections depends on the HMI device: For additional 
information, see the "Performance features" documentation

● Access protection
To protect access to an HMI-device using different passwords, you must use the first 
password for the protected, and the second password for the unprotected access e.g. 
remote control with a password, remote monitoring without password.   

● Port
The web server connects to the network at the port 80. To run it without problems, make 
sure port 80 is not in use by any other application, such as IIS World Wide Web Publishing 
Service.

● Integrated HTML-pages

– The size of the HTML pages must not exceed 100 Kb in case of Windows CE. In case 
of exceeding of the given value, these pages are spooled on external storage media.

– If you display tags on HTML-pages using the entry type "Cyclic on use", it can lead to 
data-inconsistency.

● E-mailing
The E-mailing function is not suitable for the mass dispatch of E-Mails. It is meant for 
sending important messages. 

● Timeout
If the connection between server and client is interrupted, the server will register this 
disconnection only with a certain delay. The delay is based on the Windows standard 
configuration of TCP/IP Timeout.

Use-requirements in the company network 
In order to implement the mentioned scenario, the accesses to the company network must be 
enabled. If the company network is protected by a Firewall, the system administrator must 
release the appropriate ports for that. 

● Access to the integrated HTML-pages
The web server connects to the network at the port 80. 

● Access to Sm@rtServer for downloading the Java-Applet using the Internet Explorer
The Sm@rtServer is connected to the network at the Port 5800 for downloading the Java-
applet. 

● Access to the Sm@rtServer using the Internet Explorer for remote monitoring and remote 
control
The Sm@rtServer is connected to the network at the port 5900. 

 

  Note

If you change the ports of the Sm@rtServer you must customize the links in the used Html-
pages accordingly. Additional information to modify the Html-pages is provided in 
"Example: "Configure integrated webserver".

 

Visualizing processes (Comfort/Advanced)
10.16 Options

WinCC Comfort/Advanced V12.0 SP1
5826 System Manual, 07/2013,  



10.16.2.2 Remote control via Sm@rtServer

Types of the remote control

Remote control and remote monitoring by means of Sm@rtServer

Introduction
The Sm@rtOptions of WinCC enable the access from HMI device or PC to a remote HMI 
device via Ethernet.      

Requirement
● The License Key "Sm@rtServer" is available at the Server-HMI device.

 

  Note

The 14-day license is not supported by Windows CE devices. 
 

● Both devices are linked via a TCP/IP-ready network, that is via a LAN or the Internet.

● "Sm@rtServer" is activated in the WinCC-Project of the Server-HMI device for the "Services 
in Runtime".

● Additional requirements must be satisfied according to the type of implementation.

Implementing remote access
The Sm@rtServer supports remote monitoring or remote control on the remote device (server). 

Remote monitoring or remote control can be implemented on the local device (client) in various 
ways: 

● By means of Internet Explorer

● By means of the Sm@rtClient-application

Access via HTML pages
The Sm@rt Options enable access for remote control with Microsoft Internet Explorer and by 
means of integrated HTML pages of the server.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, such as PROFINET IO, HTTP, Sm@rt Options and OPC, 
it is the end user who is responsible for the security of his data network. The proper functioning 
of the device cannot be guaranteed in all circumstances; targeted attacks, for example, can 
lead to an overloading of the device.
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Remote control by means of Internet Explorer

Introduction
On the client HMI device, the connection to the remote HMI device is established by means 
of Internet Explorer.   

The window of the Internet Explorer displays only the screen of the remote HMI device, of the 
server HMI device. If task switching is not disabled at the server HMI device, you can access 
the complete desktop.

Requirement
● The Client-HMI device is a PC.

● Internet Explorer from V6.0 SP1 is installed.

● The Client-and Server-certificates are installed to ensure the data security when transferred 
via internet.

● The Java-Applet is installed. The Java applet accesses the Java runtime environment that 
is installed on the client.

 

  Note

You achieve the best results in Internet Explorer by installing the current Java Runtime 
Environment (JRETM) of Sun Microsystems. Go to www.java.com to download this 
program.

 

Process flow
Enter the address of the remote device in Internet Explorer. The address consists of the server 
name and the HTTP port number that is set on the server. The default setting is: 5800.

Examples of addressing: "http://MyPanel:5800" or "http://192.168.168.1:5800".

Restrictions
The "Force write access with password" function cannot be implemented using the Java applet. 

See also
"Administration" tab (Page 5811)

Remote control by means of the Sm@rtClient application 

Introduction
The Sm@rtClient application provides the connection to the remote HMI device on the remote 
HMI device.     
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Requirement
● The Client-and Server-certificates are installed to ensure the data security when transferred 

via internet.

● The Client-HMI device is a PC.

Process flow
The remote control via the Sm@rtClient-application works as follows:

● Start Sm@rtClient application

● Establish connection

● Password input

● Perform operator control or monitoring on the HMI device

Start Sm@rtClient application
You can access the Sm@rtClient application, the program "SmartClient.exe", in various ways: 

● By installing WinCC Runtime on the client device you have automatically installed the 
Sm@rtClient application.

● You have several options if WinCC Runtime is not installed on the client device:

– Copy the Sm@rtClient application from the WinCC product-DVD from the folder "Support
\SmartClient".

– Copy the Sm@rtClient application from the "...\Siemens\Automation\WinCC RT 
Advanced" folder of another PC using a floppy disk or the Intranet.

Establish connection
In order to establish the connection to the remote HMI device, call the Sm@rtClient application 
and enter the IP address of the server.

● IP address or server name:port number

● IP address or server name:display number

Example: "192.168.0.1::5800"

You can also start the Sm@rtClient application with the command line input: "smartclient.exe 
192.168.0.1". The logon dialog box opens. 
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You can include the password in the command line entry to start the Sm@rtClient application: 
"smartclient.exe 192.168.0.1 /password 100".

 

 Note

If the Sm@rtServer at the server HMI device does not run as a service, the connection 
established with the Sm@rtClient application is interrupted automatically as soon as the 
keyboard shortcut CTRL+ALT+DEL is pressed at the server HMI device or the screen saver 
is activated. In order for the Sm@rtServer to run as a service, the "Start automatically after 
booting" check box in the "Remote" tab in the "WinCC Runtime Advacned Internet Settings" 
dialog must be activated.

 

Password input

Password input at the Sm@rtServer
Instead of the on-screen keyboard, the following message is displayed on the Sm@rtClient if 
you enter the password directly at the Sm@rtServer: "Remote access by Sm@rt Options is in 
Progress. Please wait until the input of values has been ended." This measure prevents 
keyboard input for entering the password from being displayed on the Sm@rtClient.

Password input at the Sm@rtClient
The on-screen keyboard is hidden on the Sm@rtServer due to the actions carried out on the 
Sm@rtClient. Use the local on-screen keyboard for entries at the Sm@rtClient. 

The local on-screen keyboard will be displayed automatically on the Sm@rtClient or in the 
Sm@rtClient view.

Close the on-screen keyboard manually. Select "Input > Hide Input Panel" to hide the local on-
screen keyboard. 

 

 Note

The entries with full-screen keyboard are not protected on HMI devices with a screen size of 
≤ 6''. 

Entries in Control Panel Applets which do not use the full-screen keyboard are protected.
 

 Note

Hidden password input is not supported by the on-screen keyboards of third-party products.
 

 Note

You cannot enter special characters with the keyboard shortcut Alt Gr.
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Perform operator control or monitoring on the HMI device
In the Sm@rtClient application window, the entire layout of the remote HMI device is shown. 
Depending on the configuration, you can specify monitoring only or operator control of all keys, 
including the function keys, with the mouse. In addition, the entire desktop can be accessed 
in the case of a PC.

For operator control via the keyboard, the following is available:

Keyboard shortcut Function
<ALT+CTRL+SHIFT+O> Opens the "Sm@rtClient Options" dialog
<ALT+CTRL+SHIFT+F> Switches over to full screen mode
<ALT+CTRL+SHIFT+R> Updates the display
<ALT+CTRL+SHIFT+N> Opens the "New Sm@rtServer Connection" dialog
<ALT+CTRL+SHIFT+S> Save as
<ALT+CTRL+SHIFT+T> Displays and hides the toolbar

Remote control via the Sm@rtClient display during runtime

Introduction
The Sm@rt options of WinCC enables access from the HMI device or PC to a remote HMI 
device via Ethernet.     

Requirement
● The License Key "Sm@rtServer" is available at the Server-HMI device.

● Both devices are linked via a TCP/IP-ready network, that is, via a LAN or the Internet.

● HMI-device is configured as Sm@rtServer. For detailed instructions on this, refer to 
"Configure Sm@rtServer (Page 5837)".

● The Sm@rtClient-Display in an image is added in the client-HMI device project. For detailed 
information on this, refer to "Project Sm@rtClient (Page 5839)".

Implementing remote access
The Sm@rtServer supports remote monitoring or remote control on the remote device (server). 

On the client HMI device, the connection to the Sm@rtServer is made during runtime by means 
of the Sm@rtClient display. 

On the HMI device only the screen of the server, and not the soft keys, is displayed. 
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The form of the cursor is not a part of the screen and is therefore not transmitted. Only the 
coordinates of the cursor are transmitted.

 

 Note

If a soft-key is activated on the client HMI device, then observe the following:

This signal is transferred to the Server-HMI device and becomes effective there, only if no 
function was configured at the soft-key.

Otherwise, the function projected on the client-HMI device is executed. 
 

Use of direct keys for remote access  
You can only operate direct keys locally on the server. Although the key for the direct key can 
be operated on the Sm@rtClient, no bit is set in the I/O range of the PLC.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, such as PROFINET IO, HTTP, Sm@rt Options and OPC, 
it is the end user who is responsible for the security of his data network. The proper functioning 
of the device cannot be guaranteed in all circumstances; targeted attacks, for example, can 
lead to an overloading of the device.

 

Password input     

Password input at the Sm@rtServer
Instead of the on-screen keyboard, the following message is displayed on the Sm@rtClient if 
you enter the password directly at the Sm@rtServer: "Remote access by Sm@rt Options is in 
Progress. Please wait until the input of values has been ended." This measure prevents 
keyboard input for entering the password from being displayed on the Sm@rtClient.

Password input at the Sm@rtClient
The on-screen keyboard is hidden on the Sm@rtServer due to the actions carried out on the 
Sm@rtClient. Use the local on-screen keyboard for entries at the Sm@rtClient. The local on-
screen keyboard will be displayed automatically on the Sm@rtClient or in the Sm@rtClient 
view.
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Close the local on-screen keyboard manually. Select "Input > Hide Input Panel" to hide the 
local on-screen keyboard. 

 

 Note

The entries with full-screen keyboard are not protected on HMI devices with a screen size of 
≤ 6''. 

Entries in Control Panel Applets which do not use the full-screen keyboard are protected.
 

 Note

Hidden password input is not supported by the on-screen keyboards of third-party products.
 

 Note

You cannot enter special characters with the keyboard shortcut Alt Gr.
 

Distributed operator stations

Configuration

Configuration
Multiple HMI devices are used as decentralized, coordinated operator stations that have 
access to a centralized HMI device connected to the PLC. 

The HMI devices are linked via a TCP/IP-network, (LAN or Intranet /Internet).
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...

Figure 10-14 Distributed HMI

Only one HMI device, the Sm@rtServer contains the configuration data. The Sm@rtServer is 
controlled from the HMI devices. 

The decentralized operator stations are the Sm@rtClients. These operator stations display the 
same process screen of the server. A Sm@rtClient-Display is configured in the process screen 
for the operation and monitoring.

All devices have the same screen resolution. 

The operator stations are in shared mode. As soon as a defined period of time elapses without 
any action on an operator station, another operator station can become active. If Sm@rtClient 
display is configured accordingly, the user can also log off directly.

Advantages
● Operator control and monitoring can be performed from various locations without significant 

efforts.
The project only has to run on one HMI device configured as a server. The same client 
project runs on all other HMI devices; the Sm@rtClient display object is contained in a 
screen on these devices. The screen of the server is displayed via the Sm@rtClient display. 

● The server is situated remotely from the machine and is thus not exposed to the 
environmental conditions of the machinery room.

● Coordinated operation is provided by the Sm@rtServer. Additional PLC investments are 
not required. For example, the load on the field bus is also reduced – the communication 
load on the bus is removed due to the interlocking mechanisms on the PLC side.
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Configure distributed operator stations 

Introduction
Operator control of an extensive printing machine need to have the option to exercise control, 
when necessary, at multiple locations along the machinery. Depending on his current location, 
the operator must be able to access the process from an operator station in the vicinity.         

Requirement
● The HMI-device with the configuration data is connected with the control.

● The server-HMI device and the Client-HMI devices are networked with each other via TCP/
IP-Network.

● The License Key "Sm@rtServer" is available.

Configuration steps
The following basic steps are necessary for configuring the distributed operator stations:

Step  
1 Configuring Sm@rtServer (Page 5837) 
2 Setting WinCC Runtime Advanced Internet (Page 5838) 
3 Project Sm@rtClient (Page 5839) 

 

Configure Sm@rtServer

Configuring Sm@rtServer

Requirement
● The WinCC-Project for the Server-HMI device is configured.

Procedure
Proceed as follows to configure the Sm@rtServer in WinCC:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enable "Sm@rtServer" in  the group "RemoteControl".

4. Transfer the compiled WinCC-project to the Server-HMI-device.
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Result
The Server-HMI device is configured as Sm@rtServer . 

Setting WinCC Runtime Advanced Internet

Requirement
● The "Control Panel" opens.

● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Remote" tab is displayed.

Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the 
Sm@rtServer:

1. On the "Remote" tab, select Start automatically after booting".

2. Click on the button "Change settings". The dialogue "Sm@rtServer: Current User 
Properties" is opened.

3. On the "Server" tab, select "Accept socket connections".

4. Enter a password for "Password 1 "and "Password 2". Click "Apply".
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5. Click on the "Administration" tab.

6. In the area Connection priority", select Automatic shared sessions". For "Active user 
timeout" enter time that must elapse without any actions on the active HMI device before 
access can be changed.

7. Under the "Forced write access", clear Password needed" for the forced access to the HMI 
device Click on "Apply". Click "OK" to close all opened dialogs.

Result
The settings were changed. The changes will be effective after restarting the Sm@rtServer. 

See also
Project Sm@rtClient (Page 5839)

Project Sm@rtClient

Requirement
● The WinCC-Project for the Client-HMI device is configured.

● The "Screens" editor is open.

● The Inspector window is shown.

● The "Tools" task card is open.
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Procedure
Proceed as follows to configure the Sm@rtClient:

1. Insert the Sm@rtClient display in the start screen.

2. In the Inspector window, click "Properties > Properties > General".

3. Enter the IP-address or the name of Server-HMI device in the "Machine name" field.

4. Enter "Password 1" configured on server in the "Password" field.

5. Activate the setting "Allow Menu".
This provides the operator the option to log off using the menu. 

6. Transfer the compiled project to all operator stations.

Result
The Sm@rtClient-display was added in start screen in WinCC-Project of Sm@rtClient. 

After the Sm@rtServer and operator stations are started, the operator sees the current process 
screen of the central HMI device at each operator station. 

In order to control the server from an operator station, the operator must wait a specified 
amount of time following the last action on another HMI device. 

If the operator uses the menu of the Sm@rtClient display to log off at the previously used HMI 
device, he can immediately control the server at the next HMI device. 

See also
Remote control via the Sm@rtClient display during runtime (Page 5831)

"Server" tab (Page 5808)

Setting WinCC Runtime Advanced Internet (Page 5836)

10.16.2.3 E-mail notification from runtime

Process flow

Introduction
WinCC Runtime Advanced with the Sm@rtService offers the option of sending messages 
automatically via email.     

The automatic e-mailing feature ensures that all people affected by the machine status (for 
example, shift engineer and sales manager) are informed in a timely manner. 
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Contents and triggers for e-mailing
The following events can trigger an e-mail to be sent: 

● Alarm of a certain alarm class

● Event in which a standard function has been configured, such as a tag value change, etc.

Such an e-mail can have the following contents: 

● Alarm text with process tags (maximum of 256 characters)

● Date/time

● E-mail address for replies

If you use e-mail gateways or SMS gateways, you receive access to standard networks, which 
requires external service providers. If configured accordingly, in critical situations the operator 
station sends an SMS to your mobile phone. 

Enabling e-mailing and SMS
The HMI device can send e-mails to an SMTP server only. The server sends the e-mails to 
the addresses configured in the server. 

Nothing else is required to send e-mails to addresses in the company network. However, an 
external service provider is required to access standard networks. 

If an SMS communication is to be sent to service personnel, an SMS gateway is required as 
well. 

Settings on the HMI device
The settings for emailing on the HMI device are made in the "Email" tab under "WinCC Runtime 
Advanced Internet" on the control panel. 

The "Sender" entry field is assigned the default value "Automation HMI device." A change is 
useful if you want the recipient to be able to identify the device from which the e-mail originated, 
e.g. "HMI device on production line 2" 

You can also use an SMTP server that support authentication to send e-mail. 

The following authentication modes can be configured:

● Authentication by means of a valid e-mail address

● Authentication by means of user name and password

Data can also be encrypted and sent via an SSL connection. This means the data cannot be 
manipulated or read. 
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Specify trigger for E-Mailing

Requirement  
● You have to create WinCC project.

Procedure
Proceed as follows to send a message when an alarm is triggered:

1. Double-click on the "HMI-Alarms" entry in the project tree.

2. Click the "Alarm classes" tab in the "HMI-Alarms" editor.

3. Select the alarm class, e.g. "Errors".

4. Enter the E-Mail-Address in the inspector window under "Properties > Properties > 
General".

5. Create an analog or discrete message with this alarm class.

Result
The trigger to send a message was configured. A message is automatically sent when a 
message of this alarm class is triggered.

Configure secure e-mail notification from Runtime

Introduction
If you send e-mail via the SMTP protocol, the sender is not verified. To ensure secure 
transmission of e-mails, you can use SMTP servers that support SMTP AUTH 
(authentication).   

You must log on to the SMTP server to send e-mails. The following authentication modes can 
be configured:

● Authentication by means of a valid e-mail address

● Authentication by means of user name and password

The data can also be sent via an SSL connection. SSL (Secure Socket Layer) encrypts e-mails 
and user data for transmission. This means the e-mail cannot be manipulated or read during 
transmission. 

Requirement
● The SMTP server supports SMTP AUTH and STARTTLS. You can obtain more detailed 

information from your service provider.

● User name and password or a valid e-mail address for logon to the SMTP Server. You can 
obtain this data from your service provider.

● The SMTP server is available.
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● The e-mail address of the service technician is entered in the alarm class.

● An analog or discrete alarm has been created for this alarm class.

Setting up secure e-mailing

Procedure in the WinCC-Project
1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enter the sender name to be shown in e-mail under "Sender name". If the SMTP-Server 
does not support the function, delete the entry.

4. Enter the authentication data.

– Authentication by means of user name and password:
Enter the user name and click on  at the "Password" input field. Enter the password 
in the "Enter password" box in the next dialog. Enter the password again in the "Confirm 
password" box. Close the dialog.

– Authentication by means of a valid e-mail address
Type in the e-mail address required for SMTP authentication in the "E-mail address" 
input field.

5. Enable "The server requires a secure connection (SSL)".

Procedure on the HMI device
 

 Note

Note that the settings on the HMI device have a higher priority than the settings in the WinCC 
project. 

 

1. Open the "WinCC Runtime Advanced Internet " dialog in the control panel of the HMI device.

2. Click on the "E-mail" tab.

3. Specify the SMTP server.

– Select "Use the default project file" if you want to use the SMTP server defined in the 
project.

– Deactivate "Use the default project file" if you do not want to use the SMTP server 
defined in the project. Specify the required SMTP server. For HMI devices with Windows 
CE, specify the computer name or the FQDN (Fully Qualified Domain Name).

4. Enter the sender name given in the e-mail under "Name of the sender". If the SMTP-Server 
does not support the function, delete the entry

5. Enter the authentication data.

6. Enter a valid e-mail address at "eMail adress of sender" if required for authentication.

– Click "Advanced" if you need a user name and password for authentication. The 
"Advanced Email Settings" dialog opens.
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7. Type in the user name and password in the "Advanced Email Settings" dialog.

– Enable "Use the default of the project file" to use default user data you have defined in 
the project.

– Select "Use panel settings for authentication" if you do not want to use the user data 
defined in the project. Enter the user name and password.

8. Enable transmission via SSL.

– To use the project settings, enable "Use the default of project file" and SSL in WinCC.

Result
If a tag such as a mixer speed exceeds configured limits, a corresponding alarm is displayed 
on the HMI device. The data is sent to the SMTP server via SSL connection. The e-mail is sent 
to the field service technician after successful logon. 

10.16.2.4 Display integrated Service-Pages

Integrated Webserver

Introduction
The operator can display and navigate between web pages during runtime using the web 
server integrated in the HMI device.  

The integrated web server displays the integrated service-pages. Depending on the 
configuration, own configured HTML-pages or Service-pages of a server accessible over 
Ethernet are be displayed. 

Requirement
● "HTML-Pages" is activated in the WinCC-Project of the Server-HMI device for the "Services 

in Runtime".
 

  Note

It is always possible on a PC to access HTML-pages in runtime, although the option 
"HTML-pages" is cleared. Setup always installs the standard pages of the Web Server on 
the PC. Assign an administrator password to prevent unauthorized access to the pages.

 

Purpose of the web server
The integrated web server permits HTML pages to be displayed during runtime over one of 
the following routes: 

● Internet Explorer

● HTML browser screen object during runtime (not on Windows CE devices)

The following are displayed: 
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● internal Service-Pages available by default on the HMI-device

● Other pages that you configure

● Other Internet pages

An operator or service technician can access service-critical information via the HTML pages. 
The standard HTML pages provide the following options: 

● Remote control (if the HMI device is configured as a Sm@rtServer)

● Remote control using Microsoft Internet Explorer

● Starting and stopping of runtime

● Remote access to recipe data records and password lists

● Display of system information

● File management using a file browser

● Downloading of configuration data

● A "DATETIME" tag always returns a date within the range from 1.1.1970 00:00:00 to 
31.12.2037 23:59:59. 

● The "Export recipes" function requires the following authorizations:

– PC: "UserData"

– other HMI devices: "UserData" and "FileBrowserUser"

HTML browser for HTML pages
The HTML-pages are also displayed using the configured "HTML browser" screen object (not 
on Windows-CE devices). 

You can can also arrange for input or activation of an Internet address. As soon as the operator 
enters or activates an address, the HTML browser opens the relevant page. 

The appearance and functionality of the HTML browser screen object depends on the HMI 
device type. On PCs, the HTML browser corresponds to the Internet Explorer installed.

 

 Note

Note that the HTML browser options during runtime are restricted due to operating device 
capacities and options. 

 

Service-pages of the web server

Introduction
The operator can use Internet Explorer or the HTML browser screen object during runtime to 
display service-pages without any additional configuration.     

You can also create own service-pages. For detailed information, refer to "Configure In-house 
service-pages".
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Requirement
● "HTML-Pages" is activated in the WinCC-Project of the Server-HMI device for the "Services 

in Runtime".
 

  Note

It is always possible on a PC to access HTML-pages in runtime, although the option"HTML-
pages" is cleared. Setup always installs the standard pages of the Web Server on the PC. 
Assign an administrator password to prevent unauthorized access to the pages.

 

Service-pages
WINCC Runtime has the following service-pages: 

● start.html: Home page

● RemoteControl.html: Remote control (only for Internet Explorer)

● Control.html: Control functions

● StatusDetails.html: System diagnostics

● Browse.html: File browser (only for Internet Explorer)

Home page: Start.html
The start page contains the links to all other pages and displays current information about the 
project: Mode, software versions, device data, etc.

"Remote control": RemoteControl.html
The "Remote control" page enables operator control of the HMI device for which a page is to 
be displayed. This page can only be displayed by using the Internet Explorer.
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"Control functions": Control.html
The "Control functions" page enables the following options on the HMI device for which a page 
is to be displayed: 

● Starting and stopping of HMI runtime
 

  Note

The transfer mode must be set in the Loader-menu on the HMI-device.
 

● Exporting and importing of recipes
 

  Note

After importing recipes with Sm@rtService (HTML pages), restart Runtime. The imported 
recipes only become active the next time Runtime is started. 

 

● Exporting and importing of password lists
 

  Note

The password list must be named "pdata.pwl." It is exported to the following directory: 

On Windows CE-devices: In the "\Flash\simatic\" target directory

On PCs: the folder that was set in the file "HMILoader.exe". 

The password list is exported and becomes active the next time Runtime is started. 
 

"System diagnostics": StatusDetails.html
The "System diagnostics" page contains system alarms from the alarm buffer.

"File Browser" – Browse.html
The "File Browser" page is used to administer directories and files on the remote device. This 
page can be displayed with any Internet browser. 

Installing the client and server certificates for SSL

Introduction
To ensure data security, data are encoded for transmission over the Internet. Encoding and 
decoding is performed by appropriate software – the certificates for SSL (Secure Sockets 
Layer). 

● The client certificate for SSL must be installed on devices that are to be used to control a 
remote device.

● The server certificate for SSL must be installed on HMI devices that are to allow remote 
control.
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Configure access to  service-pages

Configure integrated web server 

Configure WinCC-Project 

Requirement
● The WinCC-Project of the server-HMI-device is configured.

Procedure
Proceed as follows to configure the HMI device in such a way that other HMI devices or PCs 
can be connected to it:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enable the "HTML-Pages" in the "Diagnostics" group.

4. Transfer the compiled WinCC-project to the Server-HMI-device.

Result
The Server-HMI-device is configured as web server. 

Setting WinCC Runtime Advanced Internet

Requirement
● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Web Server" tab is displayed.

Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the HMI 
device:

1. Click "User Administration" in the "Web Server" tab. Enter "100" as password. The 
"UserDatabase-Edit" dialog is opened.

2. Click "Add" in the "User manager" tab to create a new user. Enter a user name and specify 
a password. Click on "Apply".

3. Click the "Authorizations" tab.

4. Specify on the "Authorizations" tab, which functions can the user carry out on the HTML-
pages of an HMI-device.  See the chapter "User administration for web server  
(Page 5814)" for additional details.
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5. Close the "UserDatabase-Edit" dialog.

6. On the "Remote" tab, select the "Start automatically after booting" check box.

7. Click "Change settings" and enable in the "Sm@rtServer dialog: Current User Properties", 
select the checkbox "Enable connections".

8. Specify a password for "Password2" so that the HMI device can be remotely controlled by 
the service technician.

Result
A user was created on the HMI-device in the user administration of the web server and 
configured for the remote control. 

The service technician can be connected to the HMI-device by means of the Internet Explorer 
and the Sm@rtClient Application. After disconnecting the connection, the HMI-device can be 
operated from his PC. 

See also
WinCC Runtime Advanced Internet, "Web Server" tab (Page 5806)

"Server" tab (Page 5808)

Display and remote-control Service-Pages

Requirement   
● A user is created on the HMI-device in the user administration for the web server.

● The web server is started.

● The Client-and Server-certificates are installed to ensure the data security when transferred 
via internet.
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Procedure
To display and control the service-pages, follow these steps: 

1. Start the Internet Explorer on the configuration-PC and connect with the "Homepage" of 
the HMI-device.

2. For "Name" and for "Password", enter the data of the user configured in the user 
administration of the web server. Click "Login".

3. Click "System Diagnostics". The system alarms from the alarm buffer are displayed on this 
page.

4. Click "Remote Control" to remotely control the HMI-device.

Result
The service-pages are displayed. The HMI-device can be operated or monitored via the 
service-pages. 

A keyboard units cannot be operated completely in the Internet Explorer, since only the screen 
content is displayed. Use the Sm@rtClient-Application to remotely control the keys of HMI-
device. The Sm@rtClient-Application can be located under "Start > Program > Siemens 
Automation > Runtime Systems > WinCC Runtime Advanced > Sm@rtClient"
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Create own Service-pages

Basics

Introduction
The basic framework of the service-pages corresponds to a normal HTML-file.

● Declaration of the document type

● Header with data for the title

● Body - content to be displayed.

Variable parameters in Service-pages
You can specify variable parameters in HTML documents. As soon as a page with variable 
parameters is opened, the parameters are replaced by specific values. 

<BODY > Welcome on <MWSL><!-- write(GetVar("[Parameter]")); --></MWSL></BODY>

Available variable parameter

Parameters Meaning
ProgramMemoryComplete CE only: Total program memory
ProgramMemoryFree CE only: Program memory available
ProgramMemoryUsed CE only: Program memory utilized
FlashComplete CE only: Total flash memory
ObjStrComplete CE only: Total available flash memory
ObjStrFree CE only: Volatile memory available
ObjStrUsed CE only: Volatile memory utilized
DeviceType Type of target device as specified in the control panel.
BtLdVer CE only: Bootloader-version, as specified in the control panel. 
BtLdRelDate CE only: Bootloader release date
ImageVersion CE only: Image version as it appears on the loader
DramSize CE only: Size of DRAM
HostName The name by which the device is logged on/identified in the network.
RtState Indicates whether Runtime is running on the target device. 
SystemMessageTable Outputs a table containing the current system events.

In the example below, the "HostName" parameter is replaced by the network-name of the 
device. 

<BODY > Welcome on <MWSL><!-- write(GetVar("[HostName]")); --></MWSL></BODY>
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Process tag
Process tag values can also be displayed in HTML pages. The syntax is the same as for device 
tags. Use the tag name as a placeholder for the tag value, , e.g. Tag_1.

<BODY > Welcome on <MWSL><!-- write(GetVar("[Tag_1")); --></MWSL></BODY>
 

 CAUTION

Data inconsistency caused by HTML pages

Note the information below if the "Cyclic in operation" acquisition mode is set at tag:
1. If this tag is not displayed on the HMI device, the HTML page displays the incorrect tag 

value in the following situations:
– The HTML page display a "0" value at its first call. The HTML page only displays the 

correct value after it is called again or updated.
– The last value is displayed if the connection to the PLC goes down.

2. The HTML page also displays the correct tag value if the tag is displayed on the HMI 
device.

 

Situation 1 is based on standard behavior: If a tag is currently not in use currently and its value 
is not acquired in "Cyclic continuous" mode, the tag is loaded with its initial value in Runtime. 
Instead of reading the values from the PLC, however, the HTML page receives these from 
Runtime.

Link own Service-pages
If a user connects to an HMI device, he is automatically forwarded to the start page http://
<Device name>/www/start.html. This page represents the starting point for the HTML-pages 
of the web server. Every standard page is accessible from the start page via a link. For this 
reason, you insert a link for each of your HTML pages in the start page.

 

 Note

When inserting links in the HTML page, you must differentiate between relative and absolute 
links. Make sure that absolute links start with "/www" to ensure that the document will be 
searched for in the correct directory. Example: "/www/MyDocument.HTML".

 

Storage location of the service-pages 
If files are to be located during a transfer, they must be in a specific directory: 

● on a PC with Windows 7: "C.\ProgramData\Siemens\CoRtHmiRTm\MiniWeb11.x.x
\WebContent"

● on a PC with Windows XP: "C:\Documents and Settings\All Users\Application Data
\Siemens\CoRtHmiRTm\MiniWeb11.x.x\WebContent"

● On xP 177B: "<ES-Installationspath>\Transfer\11.0\XP177B\WebContent.zip"

● On xP 277: "<ES-Installationspath>\Transfer\11.0\XP277\WebContent.zip"

● On MP 177: "<ES-Installationspath>\Transfer\11.0\MP177\WebContent.zip"
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● On MP 377: "<ES-Installationspath>\Transfer\11.0\MP377\WebContent.zip"

● on Mobile Panel 177 PN: "<ES-Installationspath>\Transfer\11.0\XP177B\WebContent.zip"

● On Mobile Panel 277: "<ES-Installationspath>\Transfer\11.0\XP277\WebContent.zip"

● On the Mobile Panel 277 (F) IWLAN: "<ES-Installationspath>\Transfer\11.0\XP277_W
\WebContent.zip"

● On the Mobile Panel 277 (F) IWLAN V2: "<ES-Installationspath>\Transfer
\11.0\XP277_W2\WebContent.zip"

Create service-page for displaying process values 

Requirement
The Ta_1 and Tag_2 tags are created in the WinCc-Project. 

Procedure
To create an own Service-page, follow these steps:

1. Copy the "WebContents" ZIP-file in a random work directory on your Configuration-PC and 
un-zip the ZIP-file.

2. Create a copy of start.html and rename the copy in "tag.hml".

3. Open the "tag.html" in a text editor, e.g. Notepad.

4. Replace the existing table with a new table, in which the process values of "Tag_1" and 
"Tag_2" tags are displayed. Save the file"tag.html".

5. Open the "start.html" file and add a hyperlink to page "tag.html". Expand the available 
navigation bar, in which you supplement the existing table by an entry.

6. Save start.html.

Result
You have created the service-page "tag.html". You have added a hyperlink on the start page 
in order to navigate to the service-page from the start-page. 
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Transfer Service-pages

Transfer files using the standard-path (Active Sync/CF- card)  
Proceed as follows to transfer files via the standard-path:

1. Copy the changed HTML pages and pictures according to "\Flash\Simatic\WebContent".
Access then takes place with "http://<device>/www/<HTML page>".

Transfer files via the project transfer
Proceed as follows to transfer the files via the project transfer:

1. Add the changed files to the ZIP-file "WebContents". This file must contain all HTML pages 
and associated pictures.
Make sure to provide the correct path information because the files are unpacked in the 
directories specified in the zip file. Incorrect path information results in errors in direct 
addressing or due to links. 

2. In order to transfer the ZIP-file "WebContents", copy this in a certain directory, e.g. for the 
transfer to an MP377"<ES-Installationspath>\Transfer\1.3\MP377\WebContent.zip".

3. Transfer the project to the HMI device.
The ZIP-file "WebContents" is transferred to the Windows CE device where it is unzipped. 

Transfer files using the File Browser
Proceed as follows in order to transfer files using the file transfer:

1. Start the Internet Explorer on the configuration-PC and connect with the "Homepage" of 
the HMI-device.

2. Log-on to the internal Web Server to work with the File Browser.
For read and write access to the file browser, the user must possess the web authorizations 
"FileBrowserAdministrator" and "FileBrowserUser" .

3. Click on "Browse" in the File Browser . The file selection dialog opens.
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4. Navigate to the file storage location by means of this dialog. Select the desired file and click 
"Open."

5. Click "Upload File". The file is copied in the directory of the internal web server.

See also
Basics (Page 5849)
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10.16.2.5 Access via SIMATIC HMI HTTP Protocol

Configuration

Configuration 
During the communication via  SIMATIC HMI HTTP Protocol, an HMI-device accesses the 
tags of a different HMI-device. The access is "read-only" or "read and write" depending on the 
configuration of the concerned HMI-device.

The HMI device providing the tags is the HTTP-server; the other HMI-device is the HTTP-client. 
However, access to tags functions in both directions.

Configure access via SIMATIC HTTP Protocol 

Introduction
The tags in service-application should be illustrated in an overview for a configuration from 
multiple HMI-devices. 

The panels in the machine level are used as tag server. The service-application illustrating 
tags of machines in an overview image runs on a PC.
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Requirement
● The HMI-devices are networked via a TCP/IP-network with each other.

Configuration steps
The following basic steps are required to configure the access via "SIMATIC HMI Protocol". 

Step  
1 Configure WinCC-Project  (Page 5858) 
2 Setting WinCC Runtime Advanced Internet (Page 5858) 
3 Configuring HTTP connections in the client (Page 5859) 
4 Configure the HTTP-Client tags (Page 5861) 

 

Permissible data types (SIMATIC HMI HTTP protocol)

Permitted data types
When configuring tags, the data types listed below can be used.   

Data types in 
the HTTP 
Protocol

Length Signs Range of values

Bool 0 No true (-1) or false (0)
Char 1 byte Yes -128 to 127
Byte 1 byte No  0 to 255
Int 2 bytes Yes -32768 to 32767
UInt 2 bytes No 0 to 65535
Long 4 bytes Yes  -2,147,483,648 to 2,147,483,647
ULong 4 bytes No 0 to 4,294,967,295
Float 4 bytes Yes  -3.402823E38 to -1.401298E-45 for negative values and 

1.401298E-45 to 3.402823E38 for positive values
Double 8 bytes Yes  -1.79769313486231E308 to

-4.94065645841247E-324 for negative values and 
4.94065645841247E-324 to 1.79769313486232E308 for 
positive values

String 1 to 
255 byte

––––  

DateTime 8 bytes –––– 1.1.1970 00:00:00 up to 31.12.2037 23:59:59
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Please note that data types may be defined in external controllers which have different names 
in WinCC. To ensure correct assignment, please observe the tag definition in the external 
controllers.

 

 Note

It is not possible to access array tags from an HTTP client.
 

See also
Configure WinCC-Project  (Page 5858)

Configure HTTP server

Configure WinCC-Project 

Requirement
● The WinCC-Project for the Server-HMI device is configured.

Procedure
Proceed as follows to configure the HTTP-Server:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Select "SIMATIC HMI HTTP Server" in the group "Read/write tags".

4. Check the data types of the tags. The HTTP-client can access only those tags, whose data 
type is supported by communication driver "SIMATIC HMI HTTP Protocol". For additional 
information, refer to "Permissible data types (SIMATIC HMI HTTP Protocol) (Page 5855)".

5. Transfer the compiled WinCC-project to the Server-HMI-device.

Result
The HMI-device is HTTP-server configured. 

Setting WinCC Runtime Advanced Internet

Requirement    
● The "Control Panel" opens.

● The "WinCC Runtime Advanced Internet " dialog is open.

● The "Web Server" tab is displayed.

Visualizing processes (Comfort/Advanced)
10.16 Options

WinCC Comfort/Advanced V12.0 SP1
5856 System Manual, 07/2013,  



 Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the HTTP 
server:

1. Specify the access to tags in case of "Tag access".

– "Read/write": read and write access 

– "Read only": read access 

2. Specify the authentification for access in case of "Tag authenticate":

– "No authentication": No authentication required.

– "Authentication required": A password is required for the access. Specify the password 
for configuring the connection via the SIMATIC HMI HTTP Protocol .

3. Click "User Administration" in the "Web Server" tab. Enter "100" as password. The 
"UserDatabase-Edit" dialog is opened. For detail instructions, refer to "User administration 
for Webserver (Page 5814) ".

4. Click "Add" in the "User manager" tab to create a new user. Enter a user name and specify 
a password. Click on "Apply".

5. Click the "Authorizations" tab.

6. Specify the web-authorizations on the tab "Authorizations". The user must have the Web-
authorization "RTCommunication" for utilizing the SIMATIC HTTP Server.

7. Close all open dialog boxes.

Result
The settings were changed. The changes will be effective after the restart of the WebServer.

See also
Settings on the HMI device (Page 5803)

WinCC Runtime Advanced Internet, "Web Server" tab (Page 5806)

User administration for web server  (Page 5814)

Configuring HTTP clients

Configuring HTTP connections in the client

Requirement
The communication driver "SIMATIC HMI HTTP Protocol" is installed. 
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Procedure
Proceed as follows to create an HTTP-connection:      

1. Double-click on the "Connections" entry in the project tree. The "Connections" editor opens.

2. Create a connection. Select "SIMATIC HMI HTTP Protocol" for "Communication driver".

3. Select "Ethernet" for "Interface". Select the protocol type "http://" or "https://" for address.

4. Enter the name of the HTTP-server or its IP address.
Ask your network administrator for the specific name or parameters of your network.
If the server has already been commissioned, you can read out the IP address on the server 
as well:

– Panel
Click "Start > Programs > Command Prompt" on the server and enter the "ipconfig" 
command using the screen keyboard. Press <Enter> to display the IP-address.

– For PC/Panel PC
Click on the server on "Start > Run", enter "Cmd", and press <Enter>. The command 
interpreter is displayed. Enter the "ipconfig" command. Press <Enter> to display the IP-
address.

5. If the "HTTPS" protocol type is selected, you can establish how the HTTPS-client verifies 
the properties of the server-certificate and how it should react in the event of error:

– "Allow invalid computer names for certificates"

– "Allow expired certificates"

– "Allow certificates signed by unknown publishers"

6. If the "Authentication required" option is selected on the HTTP-server, enter the user name 
and the password.

7. Enter the time for "Timeout" after which disconnection is identified.
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Result
A connection was created in the WinCC-Project of the HTTP-Client. For detail information for 
HTTPS-connection, refer to "Commissioning an HTTP- connection (Page 5862)".

Configure the HTTP-Client tags

Requirement
● An HTTP-connection was created in the WinCC-Project of the HTTP-Client.

● A tag is created in the WinCC-Project of the HTTP-Server. The data type of the tags is 
supported by SIMATIC HMI HTTP Protocols .

Procedure
To create tags on the HTTP-client, proceed as follows:

1. Open the "HMI- tags" folder in the project tree and double-click the entry "Standard-tag 
table". The "Tags" editor opens.

2. Enter a clear tag-name for "Name" in the Inspector window under "Properties > Properties 
> General".

3. Select the HTTP-connection for "Connection".

4. Select the data type for "data type".
The client does not check any verification of the tag name and the data type. Pay attention 
that the selected data type here matches the data type of the tags in the HTTP-server. For 
additional information, refer to "Permissible data types (SIMATIC HMI HTTP Protocol".
Array tags are not permitted.

5. Enter the exact name of the tag that is to be communicated with on the HTTP-server in the 
"Address" field.
If the tag to be addressed is in a sub-folder, the complete path along with tag name must 
be given as address, e.g.[folder name]\[Tag name]. 

Result
A tag was created in the WinCC-Project of the Client-HMI-device. The tag has access to the 
HTTP-server tag via an HTTP-connection. You can use an "E/A-Field" in an image to display 
the process value of this tag.
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Commissioning an HTTP- connection

Introduction
To establish an HTTP connection, you must perform the following actions:

● In the "Connections" editor of WinCC ES, configure the connection as an "https://" protocol 
type and define how the HTTPS client should verify the properties of the server certificate 
and respond to errors.

● Install a valid certificate on the HTTPS client.
Certificates are necessary for server authentication. Using certificates you can ensure that 
the server with which the connection is to be developed is actually the server for which it 
is outputting.           

Principle of an HTTPS connection
After runtime start, the HTTPS client establishes a connection to the HTTPS server. The 
HTTPS server presents its certificate, which the client verifies for authenticity. The session 
code that can only be read by the HTTPS server is then transmitted. The session code is now 
available on both sides and enables a symmetrical data encryption.

 

 Note

The certificate contains the current time. The current time can lead to problems if the time 
zones of the server and client are different. For example, a certificate generated on a server 
with an Asian time zone only becomes valid on a client with European time zone in the future 
(8 hours).

 

Preparation for installing a certificate on the client
With the first HTTPS client access, the HTTPS server generates the certificate itself and then 
saves it in the "Cert.cer" memory. The file is stored in the following directory:

● On a PC / Panel PC (with Windows XP) in the directory "<Runtime-Verzeichnis>
\SystemRoot\SSL"

● On Windows CE-based devices in the directory "Flash\Simatic\SystemRoot\SSL"

The certificate must be stored on the HTTPS client on a storage medium from which it can be 
launched with a double click. You can select from the following transfer options:
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Server Client Possible file transfer
with Windows XP
(PC, Panel PC)

with Windows XP
(PC, Panel PC)

● Diskette
● USB stick
● LAN (Ethernet)
● Internet Explorer (via TCP/IP if 

service is already running)
with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

with Windows XP
(PC, Panel PC)

● Memory card
● ActiveSync (serial)

with Windows XP
(PC, Panel PC)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

● Memory card

Installing a certificate on a client with Windows XP
Insert the storage medium on which you have saved the "Cert.cer" file into the HTTPS client 
or open the directory in which the file is located. Double click on the file and follow the 
instructions in the Windows dialog.

Tip: The Internet Explorer provides an easy way to install a certificate. Connect to this device 
via HTTPS (e.g.: https://<my device>). The browser establishes if a certificate has not yet been 
imported. In this case, the browser asks if you want to install the certificate. Any faults in the 
certificate are displayed.

Installing a certificate on a client with Windows CE
Insert the memory card on which you have saved the converted "Cert.cer" file into the HTTPS 
client. WinCC includes the "InstallCert.exe" tool for importing certificates with Windows CE.

You can implement the installation as follows:

● In Explorer: 
Double click the "Cert.cer" file to install the certificate.

● At the command prompt:
Enter "InstallCert /[command parameter] [filename]".

– command parameters:
Parameter /r must be specified because the certificate used in WinCC Runtime 
Advanced is a root certificate. 
A root certificate is the main certificate and is used to verify the authenticity of all other 
certificates transferred.

– filename
You must specify the certificate file with its complete path (e.g. "\Storage Card\Cert.cer")
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A status alarm is output when you completed the installation. Runtime has to be restarted after 
the installation of a certificate on Windows CE- HMI devices with HTTPS clients. It is necessary 
to restart Runtime so that an HTTPS connection can be established.

The file "Cert.cer" cannot be opened.
The "Cert.cer" file generated at the HTTPS server cannot be opened on HMI devices based 
on Windows CE 5.0 by double-clicking the client.

1. Open the Control Panel.

2. Select "Certificates > My Certificates".

3. Click the "Import" button.
A dialog box opens. 

4. Select the "From a File" menu in the file browser and select the "Cert.cer" file.

 

10.16.2.6 Connection to the Office-world

Configuration

Data access via web service (SOAP) 
WinCC provides options for utilization of web-service (SOAP). Web service (SOAP) is based 
on the Simple Object Access Protocol. Use of this protocol enables an external application to 
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access tags of an HMI device via Ethernet. If the company network is protected by a Firewall, 
the system administrator must release the appropriate ports.

Figure 10-15 Communication with other applications

For example, a device is accessing two HMI devices. The operator sees the values of certain 
tags and can modify them. 

You can use Microsoft Excel, for example, to display tags. You will require the latest version 
of "MS SOAP Toolkit V2.0" for this purpose. This version is available from Microsoft as a 
download.   

The data access via SOAP is not supported by Windows 7. Use OPC to display the tags in 
MS Excel. For more information, refer to "Configuring OPC clients (Page 5897)".

Data access to Windows CE HMI-devices
The data access via the Web-service(SOAP) on Windows CE-HMI-devices functions using 
only the device name and not via the IP-address. 

Enter the device name of the HMI-device with the appropriate IP-address in the hosts-file. The 
hosts-file is given in the directory"%windir%\system32\drivers\etc\", z. B. C:\WINNT
\system32\drivers\etc.    

The device name, e.g.DEVICEMP377, must be set in the control panel on the HMI device 
under "System > Device Name". Please change the default device name to ensure that the 
device name is unique for the network.

Visualizing processes (Comfort/Advanced)
10.16 Options

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5863



Example for the entry in the hosts-file:
192.168.56.198 DEVICEMP377

Replace the IP-address by the device name  in the SOAP-client:

objRuntime.mssoapinit http://DEVICEMP377/soap/RuntimeAccess?wsdl

Data access with GetValue, SetValue       
Access to a tag in SOAP using GetValue or SetValue functions require a special syntax.  

● GetValue: "Sinus_1"

● SetValue: Sinus_1

The tag name must be given in inverted commas for GetValue. The message "Runtime is 
offline" will otherwise be output when runtime is accessed.

 

 Note

Note that the tag name entry is case-sensitive.
 

Create VBA-Marko in MS Excel 

Introduction
Data access over the network via web service (SOAP) is to be used to permit certain tags of 
an HMI device to be displayed and reset.  

For this purpose, macros are written in Excel, which: 1) obtain the relevant tags on the PC 
over the network and display them, and 2) transfer reset values back to the HMI device.

The task can be solved using VBA macros "ReadTagValue" and "WriteTagValue," which obtain 
and display the relevant tags in Excel over an appropriate interface and return them to the HMI 
device over the network. Note that the tag name entry is case-sensitive.

Requirement
● The SOAP toolkit is installed.

● "Web-Service (SOAP)" is selected  in the WinCC-Project under "Services in Runtime".

Procedure
1. Insert the "Control element toolbox" toolbar in your workbook in Microsoft Excel.

2. Create a command button. Label the button "ReadTagValue" and name it "Read value".

3. Double-click this command button.
The macro editor is displayed. The "Click" event is already preset. 

4. Write the "ReadTagValue" macro ("intVarTag_1" designates the actual tag value):

Visualizing processes (Comfort/Advanced)
10.16 Options

WinCC Comfort/Advanced V12.0 SP1
5864 System Manual, 07/2013,  



 
'--------------------------------------------------------------
Private Sub ReadTagValue_Click() 
 
Dim objRuntime 
Dim intVarTag_1 
Dim objWorksheet
 
Set objWorksheet = Excel.Worksheets("Sheet1") 
Set objRuntime = CreateObject("MSSOAP.SoapClient") 
objRuntime.mssoapinit "HTTP://servername/soap/RuntimeAccess?wsdl" 
objRuntime.ConnectorProperty("AuthUser") = "Administrator" 
objRuntime.ConnectorProperty("AuthPassword") = "100" 
Var = objWorksheet.Cells(1, 3) 
intVarTag_1 = objRuntime.GetValue(Var) 
objWorksheet.Cells(1, 1) = intVarTag_1 
 
End Sub
'---------------------------------------------------------------

 

1. Insert a command button. Label the command button "WriteTagValue" and name it "Write 
value".

2. Double-click this button.

3. Write the "WriteTagValue" macro ("intVarTag_1" designates the return value of the 
operation):

 
'---------------------------------------------------------------
Private Sub WriteTagValue()
 
Dim objRuntime 
Dim intVarTag_1 
Dim objWorksheet 
 
Set objWorksheet = Excel.Worksheets("Sheet1") 
Set objRuntime = CreateObject("MSSOAP.SoapClient") 
objRuntime.mssoapinit "HTTP://servername/soap/RuntimeAccess?wsdl" 
objRuntime.ConnectorProperty("AuthUser") = "Administrator" 
objRuntime.ConnectorProperty("AuthPassword") = "100" 
Var = objWorksheet.Cells(2,3) 
Value = objWorksheet.Cells(2,5) 
intVarTag_1 = objRuntime.SetValue(Var,Value) 
objWorksheet.Cells(2,8) = intVarTag_1 
 
End Sub
'---------------------------------------------------------------

Result
As soon as you call "ReadTagValue_Click" macro by clicking the button"Read-value", the 
specified intVarTag_1tag is obtained from the HMI device using the specified device address 
and displayed in the cell (1,1). 
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As soon as you call Macro "WriteTagValue" by clicking the "Write value" button, the tag name 
is read from the cell (2,3), and the tag value is transferred from cell (2,5) to the HMI device.

See also
Configuration in WinCC (Page 5801)
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10.17 Interfaces

10.17.1 Customer controls

10.17.1.1 Overview

Introduction   
 

User-specific controls are used to create and standardize complex, frequently used screen 
objects. The WinCC Control Development add-on is required to develop controls. 
Programming is carried out in Visual Studio 2008 or Visual Studio 2010.

You can, for example, place several motors of a similar type in a plant. In a customer control, 
you can summarize motor data such as operating mode, setpoint, actual value, rotational 
speed, operational status, frequency. 
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Hz

Frequency

Value

Setpoint

Process value

Manual Auto

Mode

1/minute

Speed

M

Operating mode

Off

On

Visualizing processes (Comfort/Advanced)
10.17 Interfaces

WinCC Comfort/Advanced V12.0 SP1
5868 System Manual, 07/2013,  



When the customer control is finished, you can integrate it an unlimited number of times into 
WinCC screens, as well as in other applications.

Central changes to the customer control are automatically adopted at all usage locations. In 
this way, you can later expand a customer control with additional functionality. The changes 
are effective on all customer controls of this type used in WinCC screens that are already 
configured.

Target group of this documentation
This documentation is aimed at configuration engineers with knowledge of VB.net or C#.

Service & Support on the Internet
In addition to our documentation, we offer a comprehensive knowledge base on the Internet 
at: www.siemens.com/automation/service&support

 

10.17.1.2 Interfaces

Introduction       
To access the WinCC tag value, WinCC makes interfaces available for access to the WinCC 
data provider. The connection to the WinCC data provider is established or disconnected using 
methods. Methods are also used to read or write tag values synchronously or asynchronously.  

● Synchronous:
The customer control sends a request to the data provider for which a reply is expected 
immediately. The customer control waits until a reply comes from the data provider. 

● Asynchronous:
The customer control sends a request to the data provider for which a reply is not expected 
immediately. Sending the request and receiving the reply occur at separate times.

Interfaces 
● ITag

The ITag object supports the following methods:

Method Description
Register Registers the customer control as a consumer at the data provider. The 

consumer receives a cookie from the data provider. The cookie is used to 
assign a request from the data provider to a consumer.

ReadTag Reads the value of one or more tags at the same time
ReadTagAsync Reads the tag value asynchronously
ReadTagCyclic Cyclic reading of the tag values. The update cycle is used to determine how 

often the value is updated. 
RemoveCyclicTag Removes one or more tags
Cancel Cancels the cyclic reading of the tag values
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Method Description
WriteTag Writes values to one or more tags synchronously
WriteTagAsync Writes values to one or more tags asynchronously
Unregister Removes the consumer

● ITagSink
The ITagSink object reacts to specific events using methods.

Method Description
OnCanceled Occurs when the ITag method "Cancel" has ended.
OnDataChanged Occurs when a tag value is changed by the following ITag methods:

● ReadTagAsync
● ReadTagCyclic

OnError Occurs as an event of an error with the following methods:
● ReadTagAsync
● ReadTagCyclic
● WriteTagAsync
● OnDataChanged
● OnWriteComplete

OnRemoved Occurs when the ITag method "RemoveCyclicTag" has ended.
OnWriteComplete Occurs when the ITag method "WriteTagAsync" has finished.

Requirement
● This documentation is aimed at configuration engineers with knowledge of VB.net or C#.

● The "Siemens.Runtime.ControlDev.dll" reference is set. For further details, refer to "Setting 
the reference "Siemens.Runtime.ControlDev.dll". 
Storage of file:

– WinCC Runtime Professional: …\Siemens\WinCC\bin

– WinCC Runtime Advanced: ...\WinCC Runtime Advanced

Basic procedure
1. Create an ITag object to connect to the data provider.

2. The "Register" method is used to register the customer control as a consumer of the data 
provider. The consumer receives a cookie from the data provider. The cookie is used to 
identify the access by the consumer to the data provider.

3. When the connection is established, you can access the tag values using the methods of 
the ITag object.
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See also
Cancel (Page 5886)

ReadTag (Page 5883)

ReadTagAsync (Page 5884)

ReadTagCyclic (Page 5885)

Register (Page 5883)

RemoveCyclicTag (Page 5885)

Unregister (Page 5888)

WriteTag (Page 5886)

WriteTagAsync (Page 5887)

OnCanceled (Page 5888)

OnDataChanged (Page 5889)

OnError (Page 5890)

OnRemoved (Page 5890)

OnWriteComplete (Page 5891)

Check the reference "Siemens.Runtime.ControlDev.dll" (Page 5874)

10.17.1.3 Demo project

Requirement
● You need WinCC RT Professional or WinCC RT Advanced in order to test the demo 

projects.

● Correspondingly installed configuration software (Visual Studio 2008 or Visual Studio 2010) 
is required to open the demo projects.

Demo project "CCITagTestLibrary"
In the directory "%Program Files%\Siemens\Automation search for the folder "samples". The 
demo projects "CCITagTestLibrary" are contained there. The various methods of iTag-
Interfaces are used in these demo projects. 

● "VB90\CCITagTest\CCITagTestLibrary" is the demo project for Visual Studio 2008.

● "VB100\CCITagTest\ CCITagTestLibrary" is the demo project for Visual Studio 2010.

Use the demo project as a template for your own customer controls. This demo project includes 
the interface to the data provider of WinCC.

To use the demo project, proceed as follows:

1. Copy the entire "CCITagTestLibrary" folder to a local destination directory.

2. Double-click on the "CCITagTestLibrary.sln" file.
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See also
Creating and testing customer controls (Page 5874)

10.17.1.4 Creating and testing customer controls

Creating and testing customer controls

Introduction
This section shows the basic procedure for creating and testing a customer control in VB.net. 

To follow the configuration steps, use a VB.net project that uses the provided 
"CCITagTestLibrary" demo project as a template.

Requirement
● Visual Studio 2008 or Visual Studio 2010 

● WinCC RT Advanced or WinCC RT Professional

● WinCC project for WinCC RT Professional or WinCC RT Advanced has been created. For 
additional information, refer to "Editing a project".

Basic procedure
To create and test the "ITagUserControl" customer control, proceed as follows:

1. Check the reference "Siemens.Runtime.ControlDev.dll" (Page 5874)

2. Create a user interface (Page 5876).

3. Create the program code (Page 5877).

4. Create customer controls (Page 5878).

5. Test customer controls in Visual Studio (Page 5879).

6. Test customer controls in WinCC (Page 5881).

See also
Demo project (Page 5871)

Creating a WinCC project (Page 5879)

Check the reference "Siemens.Runtime.ControlDev.dll"

Introduction   
To access the data provider of WinCC, the VB.net project is linked to the 
"Siemens.Runtime.ControlDev.dll" library.
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Requirement
● Visual Studio 2008 or Visual Studio 2010 is installed.

● A VB.net project is open. The VB.net project uses the demo project as a template.

Procedure
Proceed as follows to verify the reference:

1. In Solution-Explorer, double-click the "CCITagTestLibrary > My Project" item.

The Project Designer opens.

2. Click on "References" in the Project Designer.

3. If the reference is not set, click on "Add...". In the "Add Reference" dialog, click "Browse".

4. In WinCC Runtime Professional, navigate to the directory "...\Siemens\WinCC\bin".
In WinCC Runtime Advanced, navigate to the directory "...\WinCC Runtime Advanced".

5. Select the entry "Siemens.Runtime.ControlDev.dll". Click "OK".
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See also
Interfaces (Page 5869)

Creating a user interface

Settings
For the configuration you require objects with the following settings:

Object Quantity Property Setting
GroupBox 1 Text ReadTag
Label 2 Text

Text
TagName
Value

Textbox 2 (Name) txtReadTagTagName
(Name)
ReadOnly

txtReadTagValue
True

Button 1 Text
(Name)

Read
btnReadTagStart

Requirement
● A VB.net project is open. The VB.net project uses the demo project as a template.

● The toolbox is displayed.

● The properties window is displayed.

Procedure   
To create the user interface, follow these steps:

1. In Solution-Explorer, double-click the "CCITagTestLibrary > ITagUserControl.vb" item. The 
Form Designer opens.

2. Insert a GroupBox into the form from the tool window. Configure the GroupBox with the 
settings described above.

3. Insert two text box objects into the form from the tool window. Configure the objects with 
the settings described above.

4. Add two labels to the form. Configure the labels with the settings described above.

5. Add a button to the form. Configure the button with the settings described above.
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Result
The user interface for the "ITagUserControl" customer control has been created.

Creating program code

Introduction
To use customer control to access the WinCC tag values, implement the access to the ITag 
interface. 

Procedure     
To create the program code, proceed as follows:

1. For access to the ITag interface, enter the following:

 
   ' ITag interface
   Dim m_ITag As ITag ' get the Tagset Object from the container
   m_ITag = Site.GetService(GetType(ITag))
   ' Connect to server
   m_RegisterCookie = m_ITag.Register(Me)

 

1. Double-click the "btnReadTagStart" button in the Form Designer. The code window with 
the "btnReadTagStart_click" subprocedure opens automatically.

2. Insert the following code between "Sub btnReadTagStart_Click" and "End Sub".

 
Private Sub btnReadTagStart_Click(ByVal sender As Object, ByVal e As EventArgs) 
_Handles btnReadTagStart.Click
  Try
   Dim TagName As Object = "Tag_Test" ' name of the tag, e.g. coming from TextBox
   Dim Values As Object = m_ITag.ReadTag(m_RegisterCookie, TagName)
   Dim Value
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   Dim strResult
   For Each Value In Values
     strResult = CStr(Value) ' the result of the ReadTag could be written in a TextBox 
(Ensabled = False)
   Next
   Catch ex As Exception
     MsgBox("ReadTag:" & vbCrLf & ex.Message)
   End Try
End Sub

Result
Access to the ITag interface is implemented and the code for the button "btnReadTagStart" is 
created.

To access the ITag interface from Visual Studio, the ProgID of the data provider must be 
transferred.

● ProgID for WinCC Runtime Professional: CCITagControl.ITagControl.1

● ProgID for WinCC Runtime Advanced: FwTagDataProvider.FwTagDataProvider

Example:

 
' Create the TagServer Object
Dim oTagServer As Object = CreateObject("CCITagControl.ITagControl.1")
' Set the Tagset Object
m_ITag = oTagServer

You can find the full program code in the demo project "CCITagTestLibrary".

Creating customer controls

Procedure   
To create the customer control, proceed as follows.

1. Double-click the "My Project" entry in the project folder explorer. The Project Designer 
opens.

2. Click on the "Compile" button in the Project Designer. Specify the destination directory for 
the DLL file for "Build output path".

3. Save the change in the VB.net project "CCITagTestLibrary".

4. Select the "CCITagTestLibrary" entry in the project folder explorer. Select the "Build" 
command in the shortcut menu.

Visualizing processes (Comfort/Advanced)
10.17 Interfaces

WinCC Comfort/Advanced V12.0 SP1
5876 System Manual, 07/2013,  



Result
The "ITagUserControl.dll" file is now located in the destination directory. The customer control 
"ITagUserControl" will be displayed in the toolbox.

Testing customer controls in Visual Studio

Creating a WinCC project

Introduction
To test the "ITagUserControl" customer control, you will have to create the "HMI_Variable_1" 
tag and the "CC_ITagUserControl" screen in WinCC.

Requirement
● WinCC project for WinCC RT Professional or WinCC RT Advanced has been created.

● The "CC_ITagUserControl" screen has been created and opened.

● The internal tag "HMI_Variable_1" has been created.

Procedure
To create the WinCC project for the test, proceed as follows:

1. Add an I/O field in the "CC_ITagUserControl" screen. Link the I/O field to the 
"HMI_Variable_1" tag.

2. Add a slider to the screen. Link the slider to the "HMI_Variable_1" tag.

3. Configure the "SetTag" system function at the "Change" event with the following settings.

Parameter Setting
Tag (output) HMI_Variable_1
Value HMI_Variable_1

Result
The "CC_ITagUserControl" screen has been created. The tag value in the I/O field will be 
displayed when you use the slider in Runtime.
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Creating a test form

Introduction   
You cannot test the "ITagUserControl" customer control in the Visual Studio Form Designer. 
You need a test form to test the customer control.

Requirement
"ITagUserControl" customer control has been created.

Procedure
Proceed as follows to create a test form:

1. In Solution-Explorer " select the project folder "CCITagTestLibrary". Select "Add > New 
Project..." in the shortcut menu. The "Add new project" dialog opens.

2. In the left window "Project types" under "Other languages > Visual Basic", select the entry 
"Windows". In the right window "Templates" select the entry "Windows Forms Application".

3. Enter "TestCustomControl" as the "Name". Click "OK".

4. A test form opens. Insert the "ITagUserControl" control into the test form.

5. Double-click the "TestCustomControl > My Project" entry in the project folder explorer. The 
Project Designer opens.

6. Click on "References" in the Project Designer. Verify that the reference to 
"Siemens.Runtime.ControlDev.dll" has been set.
Storage of file:

– WinCC Runtime Professional: …\Siemens\WinCC\bin

– WinCC Runtime Advanced: ...\WinCC Runtime Advanced

7. Save the project

Result
You have created the test form for testing the "ITagUserControl" customer control. 

Testing customer controls in Visual Studio

Requirement    
● WinCC runtime is started.

● Test form is created.
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Procedure
To test the customer control in Visual Studio, proceed as follows:

1. Start the test of the customer control with <F5>. The "Form1" form opens.

2. Enter "TK_Test5" in the "TagName" field. Click "Read".

Result
The tag value "TK_Test5" will be displayed in the "Value" field. Move the slider to change the 
tag value in WinCC. The current tag value will be displayed in the I/O field. Click on "Read" to 
update the tag value in the customer control. 

An error message will appear if you enter an incorrect tag name in the "TagName" field.

Testing customer controls in WinCC

Adding customer control in WinCC

Introduction
To use customer controls in WinCC, you need to add them to the "My Controls" palette.
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Procedure
To add customer controls, proceed as follows:

1. Open a screen.

2. Select the "Select object" command in the shortcut menu of the "Tools" task card.

3. Click "Specific .Net Controls" in the "Select control" dialog. Navigate to the desired customer 
control, for example "ITagUserControl", in the "Select assembly" field.

4. Select the "ITagUserControl" customer control.

5. Click "OK".

Result
The"ITagUserControl" customer control is displayed in the "My Controls" palette.

Testing customer controls in WinCC

Requirement
● The "CC_ITagUserControl" screen has been created and opened.

Procedure
To test the "ITagUserControl" customer control, proceed as follows:

1. Add a "ITagUserControl" to the screen.

2. Start WinCC Runtime with the start screen "CC_ITagUserControl".

3. Move the slider. The new value is displayed in the I/O field.

4. Enter "TK_Test5" in the "TagName" field.

5. Click on the button "Read".

Result
The "ITagUserControl" customer control has been added. If you activate WinCC Runtime, the 
tag value is displayed in the "Value" field.
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10.17.1.5 Reference

ITag methods

Register

Description  
Registers the customer control as a consumer at the data provider. The consumer receives a 
cookie from the data provider. The cookie is used to assign a request from the data provider 
to a consumer.

Syntax
RegisterCookie Object.Register (CustomerControl) 

Parameter

Object
Name of the ITag object

Customer Control
Name of the customer controls

Return value

RegisterCookie
Cookie to identify the consumer

ReadTag

Description  
Reads the value of one or more tags at the same time.

Syntax
Values Object.ReadTag(RegisterCookie, TagNames)

Parameter

Object 
Name of the ITag object
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RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

Return value

Values
Tag value

ReadTagAsync

Description  
Reads the value of one or more tags asynchronously.

Syntax
Object.ReadTagAsync (RegisterCookie, TagNames, ClientCookies, CacheDevice)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

ClientCookies
Cookie for identification of tags

CacheDevice
This parameter is only evaluated by WinCC RT Professional.

0 = The tag value is read from the process image (cache).

1 = The tag value is read directly from the AS.

See also
OnDataChanged (Page 5889)

OnError (Page 5890)
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ReadTagCyclic

Description
Cyclic reading of the tag values. The update cycle is used to determine how often the value is 
updated.  

Syntax
Object.ReadTagCyclic (RegisterCookie, TagNames, UpdateRates, ClientCookies, 
ServerCookies)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

UpdateRates
Update cycle of the tags. The value is entered in milliseconds.

ClientCookies
Cookie for identification of tags

Return value

ServerCookies
Cookie for identification of tags The return value is used by the ITag method 
"RemoveCyclicTag (Page 5885)".

See also
OnDataChanged (Page 5889)

OnError (Page 5890)

RemoveCyclicTag

Description   
Removes one or more tags.

Visualizing processes (Comfort/Advanced)
10.17 Interfaces

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  5883



Syntax
Object.RemoveCyclicTag (RegisterCookie, ServerCookies)

Parameter

Object
Name of the ITag object.

ServerCookies
Cookie for identification of tags 

See also
ReadTagCyclic (Page 5883)

OnRemoved (Page 5890)

Cancel

Description  
Cancels the cyclic reading of the tag values.

Syntax
Object.Cancel (RegisterCookie)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

See also
OnCanceled (Page 5888)

WriteTag

Description  
Writes values to one or more tags at the same time.
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Syntax
Object.WriteTag(RegisterCookie, TagNames, Values)

Parameter

Object 
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

Values
Values written to the tags

WriteTagAsync

Description  
Writes values to one or more tags asynchronously.

Syntax
Object.WriteTagAsync(RegisterCookie, TagNames, ClientCookies, Values)

Parameter

Object 
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

ClientCookies
Cookie for identification of tags

Values
Values written to the tags
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See also
OnError (Page 5890)

Unregister

Description 
Removes the consumer.

Syntax
Object.Unregister (RegisterCookie)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

ITag methods

OnCanceled

Description  
Occurs when the ITag method "Cancel (Page 5884)" has ended.

Syntax
Object.OnCanceled (RegisterCookie)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer
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OnDataChanged

Description  
Occurs when a tag is changed by the following ITag methods.

● ReadTagAsync (Page 5882)

● ReadTagCyclic (Page 5883)

Syntax
Object.OnDataChanged (RegisterCookie, TagNames, Values, Qualities, VarStates, 
TimeStamps, ClientCookies)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

Qualities
Quality code of the tags

VarStates
Tag status of the tags

TimeStamps
Time stamp

ClientCookies
Cookie for identification of tags

See also
OnError (Page 5890)
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OnError

Description  
Occurs as an event of an error with the following methods:

● ReadTagAsync (Page 5882)

● ReadTagCyclic (Page 5883)

● WriteTagAsync (Page 5885)

● OnDataChanged (Page 5887)

● OnWriteComplete (Page 5891)

Syntax
Object.OnError (RegisterCookie, TagNames, ClientCookies, Errors)

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

ClientCookies
Cookie for identification of tags

Errors
Error code 

OnRemoved

Description  
Occurs when the ITag method "RemoveCyclicTag (Page 5883)" has ended.

Syntax
Object.Remove(RegisterCookie, ClientCookies)

Parameter

Object
Name of the ITagSink object
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RegisterCookie
Cookie to identify the consumer

ClientCookies
Cookie for identification of tags

OnWriteComplete

Description  
Occurs when the ITag method"WriteTagAsync (Page 5885)" has finished.

Syntax
Object.OnWriteComplete(RegisterCookies, TagNames, ClientCookies)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

ClientCookies
Cookie for identification of tags

See also
OnError (Page 5888)
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10.17.2 OPC

10.17.2.1 Basics

OPC

Introduction
OPC refers to standardized manufacturer-specific software interfaces for data exchange in 
automation engineering.  

The OPC interfaces provide a standardized environment in which devices and applications 
from various manufacturers can be linked.

OPC is based on the Windows technology COM (Component Object Model) and DCOM 
(Distributed Component Object Model).

OPC UA (Unified Architecture) is the technology succeeding OPC. OPC UA is platform-
independent and can use different reports as a communication medium.

Principle of operation
In WinCC, you can configure HMI devices as OPC servers or OPC clients. The particular HMI 
device determines which OPC servers and OPC clients are available. 

OPC Specifications
OPC specifies interfaces to gain access to the following objects in WinCC:  

● Process values (OPC Data Access 1.0, 2.05a)

● Process values (DataAccess ClientFacet (OPC UA)

● Process values (OPC XML-Data Access 1.01)

You can find additional information about the individual OPC specifications in the Internet at 
the website of OPC Foundation:.

● www.opcfoundation.org (www.opcfoundation.org)

See also
Supported OPC UA services of the OPC UA client (Page 5904)

Compatibility
Support of the mentioned specifications is checked regularly by the "Compliance Test Tool" 
(CTT) of the OPC Foundation. Interoperability with OPC products of other manufacturers is 
ensured through the participation in "OPC Interoperability Workshops". 

The test results submitted are published on the website of the OPC Foundation. The results 
can be called up from there using the search term "OPC Self-Certified Products".
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Using OPC in WinCC

Configuration option
HMI devices configured with WinCC feature an OPC interface for data communication between 
automation devices or automation systems using the OPC communication driver. 

You can use an HMI device as an OPC server and/or as an OPC client. As an OPC client, the 
HMI device can be connected to a maximum of eight OPC servers. 

The software ensures up to eight client HTTP connections for an OPC XML DA server on a 
Multi Panel. For the exchange of data via an XML connection, some OPC XML DA clients 
create several HTTP connections to the OPC XML DA server.               

HMI device Data exchange over Operating system OPC server OPC client
PC, Panel PC (with 
WinCC Runtime 
Advanced)

DCOM or 
OPC UA binary (TCP/
IP)

Windows XP / 7 OPC DA server OPC DA client
OPC UA Client

MP 277, MP 377 
Mobile Panel 277

SOAP Windows CE OPC XML DA Server -

Comfort Panel SOAP or 
OPC UA binary (TCP/
IP)

Windows CE OPC XML DA Server OPC UA Client

*: The OPC UA client exchanges data via TCP/IP. 

A communication via DCOM is only possible between HMI devices of the "PC" or the 
"Panel PC" type. In order for a control room PC to display the process values of Windows CE 
HMI devices in the plant, for example, install "OPC-XML-Gateway" on the control room PC 
using the WinCC Runtime Advanced Setup. The "OPC-XML-Gateway" supports the 
communication within the SIMATIC HMI devices family between an OPC DA client and an 
OPC XML DA server. 

The area pointer is supported by any OPC connection. 

OPC server accessibility       
The following table lists the available OPC servers and how you can access them:

OPC server OPC server name
OPC DA server OPC.SimaticHMI.CoRtHmiRTm (ProgID)
OPC XML DA Server http://<xxx>/soap/OpcXml (URL) 1

<xxx>: IP address or DNS name of the HMI device
OPC DA server OPC.Siemens.XML (ProgID) for accessing the OPC XML DA server via 

the OPC XML gateway from an OPC DA client
1: For the access of an external OPC DA XML client. 
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HMI device as OPC client     
To use an HMI device as an OPC client, create an "OPC" connection in the WinCC project. 
The OPC client accesses the tags of the OPC server over this connection. You need a separate 
connection for each OPC server. 

The following exception applies here:

If you want to connect your OPC DA client to multiple panels, you only need one OPC 
connection to the OPC XML gateway in your project. The multiplexing of the connection to 
multiple OPC XML connections to individual panels takes place in the OPC XML62 gateway. 
You configure the connections to the panels using he OPC XML Manager.

The following figure shows the use of an HMI device as a central operator control and 
monitoring device:

HMI device as OPC server     
An HMI device as OPC server makes the data available to other applications. The applications 
can run on the same HMI device or on HMI devices in the connected network environment. 

The following schematic diagram shows the use of MS Excel as an OPC client that displays 
process values of the OPC server: 
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See also
Configuring an HMI device as OPC DA server (Page 5895)

Creating a connection to a WinCC OPC DA server (Page 5897)

OPC XML Gateway (Page 5900)

10.17.2.2 Configuring an OPC server

Configuring an HMI device as OPC DA server

Introduction
Which OPC server is used depends on the HMI device:

● For HMI devices with Windows XP / 7, the OPC DA server is used.

● For HMI devices with Windows CE, the OPC XML DA server is used

The following figure shows the two methods of accessing an OPC server:

Procedure   
To configure an HMI device as an OPC server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. Select the "Operate as OPC server" option in the "Runtime settings" under "Services > 
Write/read tags".

3. Save the project.

4. Download the project to the HMI device.

5. Start runtime on the HMI device.
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Result
The OPC server is accessible. If an OPC client connects to the OPC server, the OPC server 
on the HMI device is started. 

See also
Loading a project (Page 5602)

Starting Runtime Advanced and Panels (Page 5614)

Using OPC in WinCC (Page 5891)

Creating a connection to a WinCC OPC DA server (Page 5897)

Configuring DCOM user permissions in Windows

Introduction    
The OPC DA client and OPC DA server are DCOM applications, whose security settings must 
be set in compliance with the DCOM security mechanisms:

● The OPC client needs launch/activation rights and access rights for the OPC DA server.

● The OPC DA server only needs access rights for the OPC DA client

The following must be known on the PCs of the OPC DA server and the OPC DA client 
respectively:

● The user account for which the OPC DA client is executed

Requirement
You have administrator rights.

Procedure
The procedure for configuring DCOM user rights is described in the document (http://
www.opcfoundation.org/DownloadFile.aspx?CM=3&RI=326&CN=KEY&CI=282&CU=14) of 
the OPC-Foundation. 

For additional information on granting user rights, refer to the documentation for Windows XP, 
Windows Vista, or Windows 7. 
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10.17.2.3 Configuring an OPC client

Creating a connection to a WinCC OPC DA server

Introduction
For an HMI device to access the OPC server data of another HMI device, you need to create 
a connection to this OPC server in the WinCC project. Depending on the target HMI device 
used, either an OPC DA server or an OPC XML DA server is employed. 

The following figure shows the two methods for accessing the OPC servers of the HMI devices:

If a connection to one or more OPC XML DA servers is created using an OPC XML gateway, 
also enter the OPC XML DA servers in the "OPC XML Manager". 

Requirement
● An HMI device is configured as an OPC server.

● The project on the HMI device is in runtime.

● For connections to a OPC XML DA server: "OPC-XML-Gateway" is installed on the 
configuration PC and the HMI device with the OPC client.

Procedure   
To create a connection to an OPC server of an HMI device, follow these steps:

1. Open the "Connections" editor on the configuration PC in the WinCC project of the OPC 
client.

2. Create a new connection and enter a meaningful name.
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3. Select the entry "OPC" as the "Communication driver".

4. Enter the communication partner under "Parameters > OPC server" in the work area:

– If the connection communicates directly with the OPC server or with the OPC server on 
a PC-based HMI device, select the "OPC.SimaticHMI.CoRtHmiRTm" item from the list.

– If the connection communicates directly with the OPC server of a Windows CE HMI 
device, select "OPC.Siemens.XML" from the list.

– If the OPC server is installed on a remote computer, enter the computer's IP address 
or name under "Remote computer name".

Result
The OPC connection is configured. To access the data on the WinCC OPC DA server, create 
tags. 

See also
Using OPC in WinCC (Page 5891)

Configuring an HMI device as OPC DA server (Page 5893)

OPC XML Gateway (Page 5900)

Configuring an OPC XML Manager (Page 5901)

Creating a connection to an OPC UA server

Introduction
The OPC UA client can access process data in the hierarchical name space of an OPC UA 
server. 

For the OPC UA client to access the process values of an OPC UA server, the OPC UA server 
and the OPC UA client authorize each other by exchanging certificates. In addition, you can 
encode the data transfer. 

The OPC UA client usually classifies each certificate of an OPC UA server as a "trustworthy". 
How an OPC UA server responds to a connection request of the OPC UA client depends on 
the configuration of the OPC UA server. 

In order to establish communication to an OPC UA server, inform yourself from the OPC UA 
server operator about the following:

● URL of the OPC UA server

● Security settings

● Required certificates

Requirement
URL and security settings of the OPC UA server are known.
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Procedure   
To create a connection to an OPC UA server, proceed as follows:

1. Open the "Connections" editor on the HMI device.

2. Create a new connection and enter a meaningful name.

3. Select the entry "OPC UA" as the "Communication driver".

4. In the work area, under "Parameters", configure the "OPC server":

– Specify the "Discovery URL" of the OPC UA server or select the OPC UA server from 
the list.

– Select the "Security policy"

– Select the "Message security mode"

Result
The OPC UA connection is configured. You create tags to access data from the OPC UA 
server. 

See also
Supported OPC UA services of the OPC UA client (Page 5904)

Accessing process values of an OPC server

Requirement
● The OPC server to be addressed is ready-to-operate and in the "running" status

● A connection to the OPC-Server is created

Procedure   
To access process values of an OPC-Server via the OPC connection, follow these steps:

1. On the configuration PC in the project navigation, open the "HMI tags" editor under the HMI 
device that you use as an OPC client.

2. Create a tag with the same data type as the tag on the OPC server.

3. Select the OPC connection for "Connection".

4. Enter the "Address", or select the desired tag on the OPC server via the object list.

Result
If you launch Runtime on the HMI device, the process value from the OPC server will be written 
to the tag on the HMI device via the OPC connection. 
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See also
Permitted data types (OPC) (Page 5902)

Access to tags with OPC (Page 5903)

OPC XML Gateway

Usage
The OPC DA client uses the "OPC XML Gateway" so that the OPC DA client can communicate 
with the OPC XML DA server. The "OPC XML Gateway" compiles the data in the respective 
"language" of the corresponding standard. The "OPC XML Gateway" communicates 
exclusively with the OPC XML DA server which runs on an SIMATIC HMI device. 

Installation
To install "OPC XML Gateway", activate the "OPC XML Gateway" entry during installation of 
WinCC runtime advanced in the component selection. To install "OPC XML Gateway" 
afterwards, re-execute the setup of WinCC Runtime Advanced. 

Proxy setting for the OPC XML Gateway
The configuration settings for the OPC XML Gateway can be found in the "SOPCSRVR.ini" 
file in the section "[Configuration]". The OPC XML Gateway is configured by default on the PC 
as the HMI device, so that a proxy server configured in the Internet settings of Internet Explorer 
is ignored: 

NOPROXY=1

If this entry is set to "0", the OPC XML Gateway uses a configured proxy server for HTTP 
connections. 

You can find the "SOPCSRVR.ini" file in the folder "C:\Program Files\\Siemens\Automation
\WinCC RT Advanced". 

 

 Note

When data is requested from an HMI device that cannot be accessed over the configured 
proxy server, the OPC XML Gateway uses a direct connection after a Timeout. The direct 
connection is set up again on every request for data and slows down OPC communication 
significantly.

 

 

See also
Configuring an OPC XML Manager (Page 5901)

Using OPC in WinCC (Page 5891)
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Configuring an OPC XML Manager

Introduction
The OPC XML DA server, to which the OPC DA client has access, is administered in the "OPC 
XML Manager". The OPC XML Manager can be found in the Windows Start menu under 
"SIMATIC > OPC-XML-Gateway > OPC XML Manager".

To enter an OPC server, you need the following information:

● Server prefix
Any string that is used in the name of the OPC tag. Use an abbreviation of the server, for 
example. You can find the characters permitted for tag names in the reference. 

● Name or IP address of the OPC XML DA server

Requirement
"OPC XML Manager" is open.

Procedure   
To configure the OPC XML Manager, proceed as follows:

1. To enter a new OPC XML DA server, click on the button "Add".
The "Add/Edit Webservice" dialog is opened.

2. Enter the server prefix and the name or IP address of the OPC XML DA server.

3. Close the two dialogs with "OK".

Result
The OPC XML DA server is entered. The OPC DA client can now access the data of the OPC 
XML DA server via the "OPC XML Gateway".

Editing or removing an OPC server     
To edit or delete a configured OPC XML DA server, select the required OPC XML DA server. 
Then click either "Edit" or "Remove" . 

See also
OPC XML Gateway (Page 5898)
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10.17.2.4 Reference

Permitted data types (OPC)

Permitted data types
The following table lists the data types supported by the WinCC OPC servers:    

OPC data type WinCC data type
VT_BOOL BOOL
VT_I1 CHAR
VT_UI1 BYTE
VT_I2 SHORT
VT_UI2 WORD
VT_UI4 DWORD
VT_I4 LONG
VT_R4 FLOAT
VT_R8 DOUBLE
VT_DATE DATE
VT_BSTR STRING

The following table lists the ranges of values of the OPC data types:

OPC data type Range of values
VT_BOOL 0 or -1
VT_I1 -128 to 127
VT_UI1 0 to 255
VT_I2 -32768 to 32767
VT_UI2 0 to 65535
VT_I4 -2147483648 to 2147483647
VT_UI4 0 to 4294967295
VT_R4 3.402823466 e-38 through 3.402823466 e+38
VT_R8 1.7976931486231e-308 to 1.7976931486231e+308
VT_Date 1 January 100 to 31 December 9999

Special features in communication with the OPC-DA server
The array tag in the OPC-DA server belonging to the area pointer must be of the data type 
SHORT (VT_I2). 

Special features in communication with the OPC-XML server
Array tags are not supported by OPC-XML servers.
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Access to tags with OPC

Introduction  
When accessing tags with OPC, note the following when configuring tags:

● Permitted characters in tag names

● Permitted cycle times (OPC XML)

● Special features of the data type "STRING" (OPC XML)

● Special features of the data type "Date/Time" (OPC XML)

The OPC XML DA server is tested and enabled for eight connections, each with 2 groups and 
consisting of 35 tags. 

Permitted characters in tag names  
Only use the following characters in tag names:

● Letters from "a" to "z" (no umlauts)

● Numbers from "0" to "9"

● Special characters: "-" and "_"

Permitted cycle times (OPC XML)  
OPC XML connections are designed for the exchange of small volumes of data:

● For this reason use cycle times that are greater than one second

● In general, only request a small number of tags; a maximum of 30 per screen

Special features of the data type "STRING" (OPC XML)  
Only valid ASCII values from 0x20hex to 0x7Fhex are supported in the data type "STRING".

Special features of the data type "Date/Time" (OPC XML)  
Values of the data type "Date/Time" are always expected as UTC (Universal Time 
Coordinated) by the OPC-Gateway. If a tag of the type "Date/Time" is read by the OPC client, 
the returned value is a time in UTC. If a value is written to the tag, the value is treated as UTC. 
The time including the time zone and daylight saving time are shown as "local time" on an HMI 
device. 

Example:

The time zone GMT+1 and daylight saving time is set on the HMI device.

OPC DA client (UTC time): 01.01.2005 16:00

Display on the HMI device (OPC server): 01.01.2005 18:00
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Supported OPC UA services of the OPC UA client

OPC UA Services support
The OPC UA client supports the following OPC UA services:

● SecurityPolicy - Basic128Rsa15

● SecurityPolicy - Basic256

● SecurityPolicy - None

● DataAccess ClientFacet

You can additional information about OPC UA services in the "OPC UA Part 3 - Address Space 
Model 1.01 Specification" document under "§5.6". 

Explanation of the security settings
The following table lists the security settings supported by the OPC UA client: 

SecurityPolicy Message Security Mode
None1 None
Basic128Rsa152 None4 Sign5 SignAndEncrypt6

Basic2563 None Sign SignAndEncrypt
1: The certificate exchange is disabled. Every OPC UA client can log on to the WinCC OPC UA server. This setting can be 
disabled on each OPC UA server. 
2: Certificate exchange with depth of encryption of 128 bit.
3: Certificate exchange with depth of encryption of 256 bit.
4: The data packages are exchanged after certificate check unsecured between client and server. 
5: The data packages are signed with the certificates, but not encoded
6: The data packages are signed with the certificates and encoded

 
 

 Note
Unsecured communication between client and server possible

Use the "none" setting only for test and diagnostics purposes.

For a secure communication between client and server, use in operating mode at least the 
following settings:
● SecurityPolicy: Basic128Rsa15
● Message Security Mode: Sign

 

See also
Creating a connection to an OPC UA server (Page 5896)
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10.18 Migration to WinCC V12

10.18.1 Overview of migration to WinCC V12

Overview of the section "Migration to WinCC V12"
SIMATIC WinCC V12 offers a number of functional changes. Some functions differ from the 
functions that you know from familiar environments such as WinCC V7 or WinCC flexible.

This document provides an overview of the special functions and procedures in 
SIMATIC WinCC V12. 

These functions and procedures are fundamentally different from the WinCC V7 and 
WinCC flexible version, or have a different name.

10.18.2 WinCC flexible

10.18.2.1 Libraries

Libraries in WinCC flexible
Libraries are a collection of pre-configured screen objects. They expand the number of 
available screen objects and increase engineering efficiency, because library objects are 
always available for reuse; there is no need to reconfigure them. 

WinCC flexible enables you to create two library types: 
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● Project library

● Global library

A library can contain all the WinCC flexible objects, such as screens, tags, graphic objects, or 
alarms. 

How do I configure libraries in WinCC V12?
In WinCC V12, you also configure the "Project library" and the "Global library".

You can no longer store any system functions in libraries, as was the case in WinCC flexible.

Both the "Project library" and the "Global library" contain the two folders, "Copy templates" and 
"Types". You can create or use the library objects as a copy template, or as a type. 
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● Copy templates
Use copy templates to create independent copies of the library object. 

● Types
Create instances of objects of the "Types" folder and use the instances in your project. The 
instances are bound to their respective type. Changes to an instance also change all other 
instances. Types are marked by a green triangle in the "Libraries" task card.

● Managing the library objects
You can only copy and move library objects within the same library. 

For more detailed information, see:

Libraries in WinCC (Page 5491) 

10.18.2.2 Screens and templates

Screens and templates in WinCC flexible
In WinCC flexible, you create screens that an operator can use to control and monitor machines 
and plants. When you create your screens, the object templates provided support you in 
visualizing your plant, displaying processes and defining process values.

The project has a template for every HMI device. You can centrally configure the function keys 
and objects for your project in these templates. 

Every screen based on this template will contain the function keys and objects that you 
configured in the template. Changes to an object or of a function key assignment in the template 
are applied to the object in all the screens, which are based on this template. 

How do I configure screens and templates in WinCC V12?
In WinCC V12, you also configure "Templates" and a "Global screen" along with the "Screens".
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You determine functions and objects in the template which then apply to all screens based on 
this template. You can create multiple templates in WinCC.

In the "Global screen", define the elements which are independent of the template used for all 
screens of an HMI device. The "Alarm window" and "Alarm indicator" objects are available for 
use as global objects. For HMI devices with function keys, configure the function keys in the 
"Global Screen" editor. 

You can also configure a "System Diagnostic Window" in the global screen of Comfort Panels.

Excluding the controls, the screens are displayed in runtime in the following order:
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For more detailed information, see:

Screen basics (Page 2931) 

10.18.2.3 Scripts in faceplates

Scripts in faceplates in WinCC flexible
You configure a script in the "Scripts" tab of the "Faceplate configuration" dialog. These scripts 
are only available within the faceplate. 

Interconnect the script directly to the events of the objects contained in the faceplate, for 
example, with the "Click" event of a button. If you use the faceplate in a screen, a faceplate 
instance is generated. 
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How do I configure scripts in faceplates in WinCC V12?
In the configuration area of the "Faceplates" editor, you create scripts that you only use within 
a faceplate type. 

In contrast to WinCC flexible, WinCC V12 allows you to configure several scripts for a faceplate.

For more detailed information, see:

Example: Creating a script in the faceplate type (Page 3073) 

10.18.2.4 Synchronization of recipes

How do I configure the synchronization of recipes in WinCC V12?
You configure the synchronization of recipes in the "Recipes" editor in WinCC V12. A few terms 
have changed in WinCC V12 compared to WinCC flexible.

Synchronization for Panels and RT Advanced
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● To synchronize recipe tags that are configured in I/O fields with the recipe view, activate 
"Direct synchronization".

● Disable "Direct transfer of individually modified values" to specify that the recipe tags are 
automatically transferred to the controller when you edit the I/O fields.

● Activate "Coordinated data transfer" to monitor the transfer of recipe data in runtime using 
area pointers.

For more detailed information, see:

Synchronization of recipe data records with the PLC (Page 3403) 
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Using technology functions 11
11.1 PID control

11.1.1 Principles for control

11.1.1.1 Controlled system and actuators

Controlled system
Room temperature control by means of a heating system is a simple example of a controlled 
system. A sensor measures the room temperature and transfers the value to a controller. The 
controller compares the current room temperature with a setpoint and calculates an output 
value (manipulated variable) for heating control.

A properly set PID controller reaches this setpoint as quickly as possible and then holds it a 
constant value. After a change in the output value, the process value often changes only with 
a time delay. The controller has to compensate for this response.

Actuators
The actuator is an element of the controlled system and is influenced by the controller. Its 
function modifies mass and energy flows. 

The table below provides an overview of actuator applications.

Application Actuator
Liquid and gaseous mass flow Valve, shutter, gate valve
Solid mass flow, e.g., bulk material Articulated baffle, conveyor, vibrator channel
Flow of electrical power Switching contact, contactor, relay, thyristor

Variable resistor, variable transformer, transistor
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Actuators are distinguished as follows:

● Proportional actuators with constant actuating signal
These elements set degrees of opening, angular positions or positions in proportion to the 
output value. The output value has an analog effect on the process within the control range.
Actuators in this group include spring-loaded pneumatic drives, as well as motorized drives 
with position feedback for which a position control system is formed.
An continuous controller, such as PID_Compact, generates the output value.

● Proportional actuators with pulse-width modulated signal
These actuators are used to generate the output of pulses with a length proportional to the 
output value within the sampling time intervals. The actuator - e.g. a heating resistor or 
cooling apparatus - is switched on in isochronous mode for durations that differ depending 
on the output value.
The actuating signal can assume unipolar "On" or "Off" states, or represent bipolar states 
such as "open/close", "forward/backward", "accelerate/brake".
The output value is generated by a two-step controller such as PID_Compact with pulse-
width modulation.

● Actuators with integral action and three-step actuating signal
Actuators are frequently operated by motors with an on period that is proportional to the 
actuator travel of the choke element. This includes elements such as valves, shutters, and 
gate valves. In spite of their different design, all of these actuators follow the effect of an 
integral action at the input of the controlled system. 
A step controller, such as PID_3Step. generates the output value.

11.1.1.2 Controlled systems
The properties of a controlled system can hardly be influenced as these are determined by the 
technical requirements of the process and machinery. Acceptable control results can only be 
achieved by selecting a suitable controller type for the specific controlled system and adapting 
the controller to the time response of the controlled system. Therefore, it is is indispensable 
for the configuration of the proportional, integral and derivative actions of the controller to have 
precise knowledge of the type and parameters of the controlled system.

Controlled system types 
Controlled systems are classified based on their time response to step changes of the output 
value. 

We distinguish between the following controlled systems:

● Self-regulating controlled systems

– Proportional-action controlled systems

– PT1 controlled systems

– PT2 controlled systems

● Non-self-regulating controlled systems

● Controlled systems with and without dead time
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Self-regulating controlled systems
Proportional-action controlled systems

In proportional-action controlled systems, the process value follows the output value almost 
immediately. The ratio between the process value and output value is defined by the 
proportional Gain of the controlled system.

Examples:

● Gate valve in a piping system

● Voltage dividers

● Step-down function in hydraulic systems

PT1 controlled systems

In a PT1 controlled system, the process value initially changes in proportion to the change of 
the output value. The rate of change of the process value is reduced as a function of the time 
until the end value is reached, i.e., it is delayed.

Examples:

● Spring damping system

● Charge of RC elements

● Water container that is heated with steam.

The time constants are often identical for heating and cooling processes, or for charging and 
discharge characteristics. With different time constants, controlling is clearly more complex.

PT2 controlled systems

In a PT2 controlled system, the process value does not immediately follow a step change of 
the output value, i.e., it increases in proportion to the positive rate of rise and then approaches 
the setpoint at a decreasing rate of rise. The controlled system shows a proportional response 
characteristic with second order delay element.

Examples:

● Pressure control

● Flow rate control

● Temperature control

Non-self-regulating controlled systems
Non-self-regulating controlled systems have an integral response. The process value 
approaches an infinite maximum value.

Example:

● Liquid flow into a container

Controlled systems with dead time
A dead time always represents the runtime or transport time that has to expire before a change 
to the system input can be measured at the system output. 
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In controlled systems with dead time, the process value change is delayed by the amount of 
the dead time.

Example:

Conveyor

11.1.1.3 Characteristic values of the control section

Determining the time response from the step response
Time response of the controlled system can be determined based on the time characteristic 
of process value x following a step change of output value y. Most controlled systems are self-
regulating controlled systems.

The time response can be determined by approximation using the variables Delay time Tu, 
Recovery time Tg and Maximum value Xmax. The variables are determined by applying tangents 
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to the maximum value and the inflection point of the step response. In many situations, it is 
not possible to record the response characteristic up to the maximum value because the 
process value cannot exceed specific values. In this case, the rate of rise vmax is used to identify 
the controlled system (vmax = Δx/Δt).

The controllability of the controlled system can be estimated based on the ratio Tu/Tg, or Tu × 
vmax/Xmax . Rule:

Process type Tu / Tg Suitability of the controlled system for controlling
I < 0,1 can be controlled well
II 0.1 to 0.3 can still be controlled
III > 0,3 difficult to control

Influence of the dead time on the controllability of a controlled system
A controlled system with dead time and recovery reacts as follows to a jump of the output value.

Tt Dead time
Tu Delay time
Tg Recovery time
y Output value
x Process value

The controllability of a self-regulating controlled system with dead time is determined by the 
ratio of Tt to Tg. Tt must be small compared to Tg. Rule: 

Tt/Tg ≤ 1 
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Response rate of controlled systems
Controlled systems can be judged on the basis of the following values:

Tu < 0.5 min, Tg < 5 min = fast controlled system

Tu > 0.5 min, Tg > 5 min = slow controlled system

 

Parameters of certain controlled systems 

Physical 
quantity

Controlled system Delay time Tu Recovery time Tg Rate of rise vmax

Temperature Small electrically heated furnace 0.5 to 1 min 5 to 15 min Up to 60 K/min.
Large electrically heated annealing furnace 1 to 5 min 10 to 20 min Up to 20 K/min.
Large gas-heated annealing furnace 0.2 to 5 min 3 to 60 min 1 to 30 K/min
Distillation tower 1 to 7 min 40 to 60 min 0.1 to 0.5° C/s
Autoclaves (2.5 m3) 0.5 to 0.7 min 10 to 20 min Not specified
High-pressure autoclaves 12 to 15 min 200 to 300 min Not specified
Steam superheater 30 s to 2.5 min 1 to 4 min 2°C/s
Injection molding machines 0.5 to 3 min 3 to 30 min 5 to 20 K/min
Extruders 1 to 6 min 5 to 60 min  
Packaging machines 0.5 to 4 min 3 to 40 min 2 to 35 K/min
Room heating 1 to 5 min 10 to 60 min 1° C/min

Flow rate Pipeline with gas 0 to 5 s 0.2 to 10 s Not relevant
Pipeline with liquid None None

Pressure Gas pipeline None 0.1 s Not relevant
Drum boiler with gas or oil firing None 150 s Not relevant
Drum boiler with impact grinding mills 1 to 2 min 2 to 5 min Not relevant

Vessel level Drum boiler 0.6 to 1 min Not specified 0.1 to 0.3 cm/s
Speed Small electric drive None 0.2 to 10 s Not relevant

Large electric drive None 5 to 40 s Not relevant
Steam turbine None Not specified 50 min–1

Voltage Small generators None 1 to 5 s Not relevant
Large generators None 5 to 10 s Not relevant

11.1.1.4 Pulse controller

Two-step controllers without feedback
Two-step controllers have the state "ON" and "OFF" as the switching function. This 
corresponds to 100% or 0% output. This behavior generates a sustained oscillation of process 
value x around setpoint w.

The amplitude and duration of the oscillation increase in proportion to the ratio between the 
delay time Tu and recovery time Tg of the controlled system. These controllers are used mainly 
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for simple temperature control systems (such as electrically directly heated furnaces) or as 
limit-value signaling units.

The following diagram shows the characteristic of a two-step controller

① ON
② OFF
Yh Control range
w Setpoint

The following diagram shows the control function of a two-step controller
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① Response characteristic without controller 
② Response characteristic with two-step controller
Tu Delay time
Tg Recovery time
XSd Switching difference

Two-step controllers with feedback
The behavior of two-step controllers in the case of controlled systems with larger delay times, 
such as furnaces where the functional space is separated from the heating, can be improved 
by the use of electronic feedback.

The feedback is used to increase the switching frequency of the controller, which reduces the 
amplitude of the process value. In addition, the control-action results can be improved 
substantially in dynamic operation. The limit for the switching frequency is set by the output 
level. It should not exceed 1 to 5 switches per minute at mechanical actuators, such as relays 
and contactors. In the case of voltage and current outputs with downstream thyristor or Triac 
controllers high switching frequencies can be selected that exceed the limit frequency of the 
controlled system by far.
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Since the switching pulses can no longer be determined at the output of the controlled system, 
results comparable with those of continuous controllers are obtained.

The output value is generated by pulse-width modulation of the output value of a continuous 
controller.

Two-step controllers with feedback are used for temperature control in furnaces, at processing 
machines in the plastics, textile, paper, rubber and foodstuff industries as well as for heating 
and cooling devices.

Three-step controllers
Three-step controllers are used for heating / cooling. These controllers have two switching 
points as their output. The control-action results are optimized through electronic feedback 
structures. Fields of applications for such controllers are heating, low-temperature, climatic 
chambers and tool heating units for plastic-processing machines.

The following diagram shows the characteristic of a three-step controller

y Output value, e.g. 
y11 = 100% heating
y12 = 0% heating
y21 = 0% cooling
y22 = 100% cooling 

x Physical quantity of the process value, e.g., temperature in° C 
w Setpoint
xSh Distance between Switching Point 1 and Switching Point 2
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11.1.1.5 Response to setpoint changes and disturbances

Response to setpoint changes
The process value should follow a setpoint change as quickly as possible. The response to 
setpoint changes is improved by minimizing fluctuation of the process value and the time 
required to reach the new setpoint.

x Process value
w Setpoint

Response to disturbances
The setpoint is influenced by disturbance variables. The controller has to eliminate the resulting 
control deviations in the shortest time possible. The response to disturbances is improved by 
minimizing fluctuation of the process value and the time required to reach the new setpoint. 

x Process value
w Setpoint
① Influencing a disturbance variable
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Disturbance variables are corrected by a controller with integral action. A persistent 
disturbance variable does not reduce control quality because the control deviation is relatively 
constant. Dynamic disturbance variables have a more significant impact on control quality 
because of control deviation fluctuation. The control deviation is eliminated again only by 
means of the slow acting integral action.

A measurable disturbance variable can be included in the controlled system. This inclusion 
would significantly accelerated the response of the controller.

11.1.1.6 Control Response at Different Feedback Structures

Control behavior of controllers
A precise adaptation of the controller to the time response of the controlled system is decisive 
for the controller's precise settling to the setpoint and optimum response to disturbance 
variables.

The feedback circuit can have a proportional action (P), proportional-derivative action (PD), 
proportional-integral action (PI), or proportional-integral-derivative action (PID).

If step functions are to be triggered by control deviations, the step responses of the controllers 
differ depending on their type.
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Step response of a proportional action controller

① Control deviation
② Output value of a continuous controller
③ Output value of a pulse controller

 

Equation for proportional action controller

Output value and control deviation are directly proportional, meaning:

Output value = proportional gain × control deviation

y = GAIN × x
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Step response of a PD-action controller

① Control deviation
② Output value of a continuous controller
③ Output value of a pulse controller
TM_LAG Delay of the Derivative action

Equation for PD-action controller

The following applies for the step response of the PD-action controller in the time range:

t = time interval since the step of the control deviation

The derivative action generates a output value as a function of the rate of change of the process 
value. A derivative action by itself is not suitable for controlling because the output value only 
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follows a step of the process value. As long as the process value remains constant, the output 
value will no longer change.

The response to disturbances of the derivative action is improved in combination with a 
proportional action. Disturbances are not corrected completely. The good dynamic response 
is advantageous. A well attenuated, non-oscillating response is achieved during approach and 
setpoint change. 

A controller with derivative action is not appropriate if a controlled system has pulsing 
measured quantities, for example, in the case of pressure or flow control systems.
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Step response of a PI-action controller

① Control deviation
② Output value of a continuous controller
③ Output value of a pulse controller

An integral action in the controller adds the control deviation as a function of the time. This 
means that the controller corrects the system until the control deviation is eliminated. A 
sustained control deviation is generated at controllers with proportional action only. This effect 
can be eliminated by means of an integral action in the controller. 

In practical experience, a combination of the proportional, integral and derivative actions is 
ideal, depending on the requirements placed on the control response. The time response of 
the individual components can be described by the controller parameters proportional gain 
GAIN, integral action time TI (integral action), and derivative action time TD (derivative action).

Equation for PI-action controller
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The following applies for the step response of the PI-action controller in the time range:

t = time interval since the step of the control deviation
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Step response of a PID controller

① Control deviation
② Output value of a continuous controller
③ Output value of a pulse controller
TM_LAG Delay of the Derivative action
Ti Integral action time

Equation for PID controller

The following applies for the step response of the PID controller in the time range:
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t = time interval since the step of the control deviation

Response of a controlled system with different controller structures
Most of the controller systems occurring in process engineering can be controlled by means 
of a controller with PI-action response. In the case of slow controlled system with a large dead 
time, for example temperature control systems, the control result can be improved by means 
of a controller with PID action.

① No controller
② PID controller
③ PD-action controller
w Setpoint
x Process value

Controllers with PI and PID action have the advantage that the process value does not have 
any deviation from the setpoint value after settling. The process value oscillates over the 
setpoint during approach.
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11.1.1.7 Selection of the controller structure for specified controlled systems

Selection of the Suitable Controller Structures 
To achieve optimum control results, select a controller structure that is suitable for the 
controlled system and that you can adapt to the controlled system within specific limits.

The table below provides an overview of suitable combinations of a controller structure and 
controlled system. 

Controlled system Controller structure
P PD PI PID

With dead time only Unsuitable Unsuitable Suitable Unsuitable

PT1 with dead time Unsuitable Unsuitable Well suited Well suited

PT2 with dead time Unsuitable Suited conditionally Well suited Well suited

Higher order Unsuitable Unsuitable Suited conditionally Well suited

Not self-regulating Well suited Well suited Well suited Well suited

The table below provides an overview of suitable combinations of a controller structure and 
physical quantity.

Physical quantity Controller structure
P PD PI PID

Sustained control deviation No sustained control deviation
Temperature For low 

performance 
requirements and 
proportional action 
controlled 
systems with Tu/
Tg < 0,1

Well suited The most suitable controller structures 
for high performance requirements 
(except for specially adapted special 
controllers)

Pressure Suitable, if the 
delay time is 
inconsiderable

Unsuitable The most suitable controller structures 
for high performance requirements 
(except for specially adapted special 
controllers)

Flow rate Unsuitable, 
because required 
GAIN range is 
usually too large

Unsuitable Suitable, but 
integral action 
controller alone 
often better

Hardly required 
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11.1.1.8 PID parameter settings

Rule of Thumb for the Parameter Setting

Controller structure Setting
P GAIN ≈ vmax × Tu [° C ]
PI GAIN ≈ 1.2 × vmax × Tu [° C ]
PD GAIN ≈ 0.83 × vmax × Tu [° C ]

TD ≈ 0.25 × vmax × Tu [ min ]
TM_LAG ≈ 0.5 × TD[ min ]

PID GAIN ≈ 0.83 × vmax × Tu [° C ]
TI ≈ 2 × Tu [ min ]
TD ≈ 0.4 × Tu [ min ]
TM_LAG ≈ 0.5 × TD[ min ]

PD/PID GAIN ≈ 0.4 × vmax × Tu [° C ]
TI ≈ 2 × Tu [ min ]
TD ≈ 0.4 × Tu [ min ]
TM_LAG ≈ 0.5 × TD[ min ]

Instead of vmax = ∆x / ∆t , you can use Xmax / Tg.

In the case of controllers with PID structure the setting of the integral action time and differential-
action time is usually coupled with each other.

The ratio TI / TD lies between 4 and 5 and is optimal for most controlled systems.

Non-observance of the differential-action time TD is uncritical at PD controllers. 

In the case of PI and PID controllers, control oscillations occur if the integral action time TI has 
been select by more than half too small.

An integral action time that is too large slows down the settling times of disturbances. One 
cannot expect that the control loops operate "optimally" after the first parameter settings. 
Experience shows that adjusting is always necessary, when a system exists that is "difficult to 
control" with  Tu / Tg > 0.3.

11.1.2 Configuring a software controller

11.1.2.1 Overview of software controller
For the configuration of a software controller, you need an instruction with the control algorithm 
and a technology object. The technology object for a software controller corresponds with the 
instance DB of the instruction. The configuration of the controller is saved in the technology 
object. In contrast to the instance DBs of other instructions, technology objects are not stored 
for the program resources, but rather under CPU > Technology objects.
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Technology objects and instructions 

CPU Library Instruction Technology 
object

Description

S7-1200 Compact PID PID_Compact  
V1.X 

PID_Compact 
V1.X

Universal PID controller with integrated tuning

S7-1200 PID_3Step V1.X PID_3Step V1.X PID controller with integrated tuning for valves
S7-1500
S7-1200 V4.x

PID_Compact 
V2.X

PID_Compact 
V2.X

Universal PID controller with integrated tuning

S7-1500
S7-1200 V4.x

PID_3Step V2.X PID_3Step V2.X PID controller with integrated tuning for valves

S7-1500/300/4
00

PID basic functions CONT_C CONT_C Continuous controller

S7-1500/300/4
00

CONT_S CONT_S Step controller for actuators with integrating 
behavior

S7-1500/300/4
00

PULSEGEN - Pulse generator for actuators with 
proportional behavior

S7-1500/300/4
00

TCONT_CP TCONT_CP Continuous temperature controller with pulse 
generator

S7-1500/300/4
00

TCONT_S TCONT_S Temperature controller for actuators with 
integrating behavior

S7-300/400 PID Self Tuner TUN_EC TUN_EC Optimization of a continuous controller
S7-300/400 TUN_ES TUN_ES Optimization of a step controller
S7-300/400 Standard PID 

Control (PID 
Professional 
optional package)

PID_CP PID_CP Continuous controller with pulse generator
S7-300/400 PID_ES PID_ES Step controller for actuators with integrating 

behavior
S7-300/400 LP_SCHED - Distribute controller calls 
S7-300/400 Modular PID 

Control (PID 
Professional 
optional package)

A_DEAD_B - Filter interfering signal from control deviation 
S7-300/400 CRP_IN - Scale analog input signal 
S7-300/400 CRP_OUT - Scale analog output signal 
S7-300/400 DEAD_T - Delay output of input signal 
S7-300/400 DEADBAND - Suppress small fluctuations to the process 

value 
S7-300/400 DIF - Differentiate input signals over time 
S7-300/400 ERR_MON  Monitor control deviation 
S7-300/400 INTEG - Integrate input signals over time 
S7-300/400 LAG1ST - First-order delay element 
S7-300/400 LAG2ND - Second-order delay element 
S7-300/400 LIMALARM - Report limit values 
S7-300/400 LIMITER - Limiting the manipulated variable 
S7-300/400 LMNGEN_C - Determine manipulated variable for 

continuous controller 
S7-300/400 LMNGEN_S - Determine manipulated variable for step 

controller
S7-300/400 NONLIN - Linearize encoder signal
S7-300/400 NORM - Scale process value physically 
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CPU Library Instruction Technology 
object

Description

S7-300/400 OVERRIDE - Switch manipulated variable from 2 PID 
controllers to 1 actuator 

S7-300/400 PARA_CTL - Switch parameter sets 
S7-300/400 PID - PID aAlgorithm 
S7-300/400 PUSLEGEN_M - Generate pulse for proportional actuators 
S7-300/400 RMP_SOAK - Specify setpoint according to ramp / soak 
S7-300/400 ROC_LIM - Limit rate of change 
S7-300/400 SCALE_M - Scale process value 
S7-300/400 SP_GEN - Specify setpoint manually 
S7-300/400 SPLT_RAN - Split manipulated variable range
S7-300/400 SWITCH - Switch analog values 
S7-300/400 LP_SCHED_M - Distribute controller calls

11.1.2.2 Steps for the configuration of a software controller
All SW-controllers are configured according to the same scheme:

Step Description
1 Add technology object (Page 5934) 
2 Configure technology object  (Page 5935)
3 Call instruction in the user program (Page 5936) 
4 Download technology object to device (Page 5937)
5 Commission software controller (Page 5938) 
6 Save optimized PID parameters in the project (Page 5939) 
7 Comparing values (Page 5940)
8 Display instances of a technology object  (Page 5942)

11.1.2.3 Add technology objects

Add technology object in the project navigator
When a technology object is added, an instance DB is created for the instruction of this 
technology object. The configuration of the technology object is stored in this instance DB. 

Requirement
A project with a CPU has been created.
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Procedure
To add a technology object, proceed as follows:

1. Open the CPU folder in the project tree.

2. Open the "Technology objects" folder.

3. Double-click "Add new object".
The "Add new object" dialog box opens.

4. Click on the "PID" button.
All available PID-controllers for this CPU are displayed.

5. Select the instruction for the technology object, for example, PID_Compact.

6. Enter an individual name for the technology object in the "Name" input field.

7. Select the "Manual" option if you want to change the suggested data block number of the 
instance DB.

8. Click "Further information" if you want to add own information to the technology object.

9. Confirm with "OK".

Result
The new technology object has been created and stored in the project tree in the "Technology 
objects" folder. The technology object is used if the instruction for this technology object is 
called in a cyclic interrupt OB.

 

 Note

You can select the "Add new and open" check box at the bottom of the dialog box. This opens 
the configuration of the technology object after adding has been completed.

 

11.1.2.4 Configure technology objects
The properties of a technology object on a S7-1200 CPU can be configured in two ways.

● In the Inspector window of the programming editor

● In the configuration editor

The properties of a technology object on a S7-300/400 CPU can only be configured in the 
configuration editor.

Inspector window of the programming editor
In the Inspector window of the programming editor you can only configure the parameters 
required for operation. 

The offline values of the parameters are also shown in online mode. You can only change the 
online values in the commissioning window. 

To open the Inspector window of the technology object, follow these steps:
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1. Open the "Program blocks" folder in the project tree.

2. Double click the block (cyclic interrupt OB) in which you open the instruction of the SW-
controller.
The block is opened in the work area.

3. Click on the instruction of the SW-controller.

4. In the Inspector window, select the "Properties" and "Configuration" tabs consecutively.

Configuration window
For each technology object, there is a specific configuration window in which you can configure 
all properties. 

To open the configuration window of the technology object, follow these steps:

1. Open the "Technology objects" folder in the project tree.

2. Open the technology object in the project tree.

3. Double-click the "Configuration" object.

Symbols
Icons in the area navigation of the configuration and in the Inspector window show additional 
details about the completeness of the configuration:

The configuration contains default values and is complete.
The configuration exclusively contains default values. With these default values the use of the technology object is 
possible without further changes.
The configuration contains values defined by the user and is complete
All input fields of the configuration contain valid values and at least one default setting was changed.
The configuration is incomplete or faulty
At least one input field or a collapsible list contains no or one invalid value. The corresponding field or the drop-down 
list box has a red background. When clicked the roll-out error message indicates the cause of the error.

The properties of a technology object are described in detail in the chapter for the technology 
object.

11.1.2.5 Call instruction in the user program
The instruction of the software controller must be called in a cyclic interrupt OB. The sampling 
time of the software controller is determined by the interval between the calls in the cyclic 
interrupt OB.

Requirement
The cyclic interrupt OB is created and the cycle time of the cyclic interrupt OB is correctly 
configured.
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Procedure
Proceed as follows to call the instruction in the user program:

1. Open the CPU folder in the project tree.

2. Open the "Program blocks" folder.

3. Double-click the cyclic interrupt OB.
The block is opened in the work area.

4. Open the "Technology" group in the "Instructions" window and the "PID Control" folder.
The folder contains all instructions for software controllers that can be configured on the 
CPU.

5. Select the instruction and drag it to your cyclic interrupt OB.
The "Call options" dialog box opens.

6. Select a technology object or type the name for a new technology object from the "Name" 
list. 

Result
If the technology object does not exist yet, it is added. The instruction is added in the cyclic 
interrupt OB. The technology object is assigned to this call of the instruction.

11.1.2.6 Downloading technology objects to device
A new or modified configuration of the technology object must be downloaded to the CPU for 
the online mode. The following characteristics apply when downloading retentive data:

● Software (changes only)

– S7-1200, S7-1500: 
Retentive data is retained.

– S7-300/400: 
Retentive data is updated immediately. CPU does not change to Stop.

●  Download PLC program to device and reset

– S7-1200, S7-1500: 
Retentive data is updated at the next change from Stop to RUN. The PLC program can 
only be downloaded completely.

– S7-300/400: 
Retentive data is updated at the next change from Stop to RUN.
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Downloading retentive data to an S7-1200 or S7-1500 CPU
 

 Note

The download and reset of the PLC program during ongoing system operation can result in 
serious damages or injuries in the case of malfunctions or program errors.

Make sure that dangerous states cannot occur before you download and reset the PLC 
program.

 

Proceed as follows to download the retentive data:

1. Select the entry of the CPU in the project tree.

2. Select the command "Download and reset PLC program" from the "Online" menu.

– If you have not established an online connection yet, the "Extended download" dialog 
opens. In this case, set all required parameters for the connection and click "Download".

– If the online connection has been defined, the project data is compiled, if necessary, 
and the dialog "Load preview" opens. This dialog displays messages and recommends 
actions necessary for download.

3. Check the messages.
As soon as download is possible, the "Download" button becomes active.

4. Click on "Download".
The complete PLC program is downloaded and the "Load results" dialog opens. This dialog 
displays the status and the actions after the download.

5. If the modules are to restart immediately after the download, select the check box "Start 
all".

6. Close the dialog "Download results" with "Finish".

Result
The complete PLC program is downloaded to the device. Blocks that only exist online in the 
device are deleted. By downloading all affected blocks and by deleting any blocks in the device 
that are not required, you avoid inconsistencies between the blocks in the user program.

The messages under "Info > General" in the Inspector window indicate whether the download 
was successful. 

11.1.2.7 Commissioning software controller

Procedure
To open the "Commissioning" work area of the technology object, follow these steps:

1. Open the "Technology objects" folder in the project tree.

2. Open the technology object in the project tree.

3. Double-click the "Commissioning" object.

The commissioning functions are specific for each controller and are described there.
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11.1.2.8 Save optimized PID parameter in the project
The software controller is optimized in the CPU. Through this, the values in the instance-DB 
on the CPU no longer agree with those in the project. 

To update the PID parameter in the project with the optimized PID parameters, proceed as 
follows:

Requirement
● An online connection to the CPU is established and the CPU is in "RUN" mode.

● The functions of the commissioning window have been enabled by means of the "Start" 
button.

Procedure
1. Open the CPU folder in the project tree.

2. Open the "Technology objects" folder.

3. Open a technology object.

4. Double click on "Commissioning".

5. Click on the  icon "Upload PID parameters".

6. Save the project.

Result
The currently active PID parameters are stored in the project data. When reloading the project 
data in the CPU, the optimized parameters are used.

11.1.2.9 Comparing values

Comparison display and boundary conditions
The "Compare values" function provides the following options: 

● Comparison of configured start values of the project with the start values in the CPU and 
the actual values

● Direct editing of actual values and the start values of the project

● Immediate detection and display of input errors with suggested corrections

● Backup of actual values in the project

● Transfer of start values of the project to the CPU as actual values
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Icons and operator controls
The following icons and operator controls are available:

Icon Function
Start value in CPU matches the configured Start value in the project

Start value in CPU does not match the configured Start value in the project

The comparison of the Start value in CPU with the configured Start value in the project 
cannot be performed
Backs up the actual values in the project

Transfers updated start values in the project to the CPU (initialize setting values)

Opens the "Compare values" dialog

Boundary conditions
The "Compare values" function is available for S7-1200 and S7-1500 without limitations.

The following limitation applies to S7-300 and S7-400:

In monitoring mode, an S7-300/S7-400 cannot transfer the start values to the CPU. These 
values cannot be displayed online with "Compare values".

The actual values of the technology object are displayed and can be changed directly.

Comparing values
The procedure is shown in the following using "PID Parameters" as an example.

Requirements 
● A project with a software controller is configured.

● The project is downloaded to the CPU.

● The configuration dialog is open in the project navigator.

Procedure 
1. Open the desired software controller in the project navigation.

2. Double-click the "Configuration" object.

3. Navigate within the configuration window to the "PID Parameters" dialog.

4. Click the  icon to activate monitoring mode.
The icons and operator controls (Page 5937) of the "Compare values" function are shown 
behind the parameters.
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5. Click the desired parameter in the input box and change the parameter values manually 
by entering them directly.

– If the background of the input box is gray, this value is a read-only value and cannot be 
changed. 

– To change the values in the "PID Parameters" dialog, enable manual entry by selecting 
the "Enable manual entry" check box beforehand.

6. Click the  icon to open the dialog for the start values.
This dialog indicates two values of the parameter:

– Start value in CPU: The start value in the CPU is shown in the top part.

– Start value in the project: The configured start value in the project is shown in the bottom 
part.

7. Enter the desired value in the input box for the project.

Error detection 
The input of incorrect values is detected. Corrections are suggested in this case.

If you enter a value with incorrect syntax, a rollout containing the corresponding error message 
opens below the parameter. The incorrect value is not applied.

If you enter a value that is incorrect for the process, a dialog opens containing the error 
message and a suggested correction:

● Click "No" to accept this suggested correction and correct your input. 

● Click "OK" to apply the incorrect value.
 

 NOTICE

Malfunctions of the controller

Values incorrect for the process can result in controller malfunctions.
 

Backing up actual values 
Click the  icon to transfer the actual controller values to the start values of your configured 
project.
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Transferring project values to the CPU 
Click the  icon to transfer the configured values of your project to the CPU.

 

 CAUTION

Prevent personal injury and property damage!

Downloading and resetting of the user program while the plant is operating may result in 
significant property damage and severe personal injuries in the event of malfunctions or 
program errors.

Make sure that dangerous states cannot occur before you download and reset the user 
program.

 

11.1.2.10 Display instance DB of a technology object.
An instance DB, in which the parameter and static variables are saved, is created for each 
technology object.

Procedure
To display the instance DB of a technology object, proceed as follows:

1. Open the CPU folder in the project tree.

2. Open the "Technology objects" folder.

3. Highlight a technology object.

4. Select the command "Open DB editor" in the shortcut menu.

11.1.3 Using PID_Compact

11.1.3.1 Technology object PID_Compact
The "PID_Compact" technology object provides a continuous PID controller with integrated 
tuning. You can alternatively configure a pulse controller. Both manual and automatic mode 
are possible.   

The PID controller of a controlled system continuously acquires the measured process value 
and compares it with the desired setpoint. From the resulting control deviation, the instruction 
PID_Compact calculates an output value through which the process value is compared with 
as quickly and stable as possible with the setpoint. The output value for the PID controller 
consists of three actions:
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● P action
The proportional action of the output value increases in proportion to the control deviation.

● I action
The integral action of the output value increases until the control deviation has been 
balanced. 

● D action
The derivative action increases with the rate of change of control deviation. The process 
value is corrected to the setpoint as quickly as possible. The derivative action will be 
reduced again if the rate of change of control deviation drops.

The instruction PID_Compact calculates the proportional, integral and derivative parameters 
for your controlled system during "pretuning". "Fine tuning" can be used to tune the parameters 
further. You do not need to manually determine the parameters.

Additional information
● Overview of software controller (Page 5930)

● Add technology objects (Page 5932)

● Configure technology objects (Page 5933)

● Configuring PID_Compact V2 (Page 5943)

● Configuring PID_Compact V1 (Page 5959)

11.1.3.2 PID_Compact V2

Configuring PID_Compact V2

Basic settings

Introduction
Configure the following properties of the "PID_Compact" technology object under "Basic 
settings" in the Inspector window or in the configuration window:

● Physical quantity

● Control logic

● Start-up behavior after reset

● Setpoint (only in the Inspector window)

● Process value (only in the Inspector window)

● Output value (only in the Inspector window)
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Setpoint, process value and output value
You can only configure the setpoint, process value and output value in the Inspector window 
of the programming editor. Select the source for each value:

● Instance DB
The value saved in the instance DB is used.
Value must be updated in the instance DB by the user program.
There should be no value at the instruction.
Change via HMI possible.

● Instruction
The value connected to the instruction is used. 
The value is written to the instance DB each time the instruction is called.
No change via HMI possible.

Controller type

Physical quantity
Select the physical quantity and unit of measurement for setpoint, process value, and 
disturbance variable in the "Controller type" group. Setpoint, process value, and disturbance 
variable is displayed in this unit of measurement.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. 

PID_Compact does not work with negative proportional gain. Select the check box "Invert 
control logic" to reduce the process value with a higher output value.

Examples

● Opening the drain valve will reduce the level of a container's contents.

● Increasing cooling will reduce the temperature.

Startup characteristics
1. To switch to "Inactive" mode after CPU restart, clear the "Activate Mode after CPU restart" 

check box.
To switch to the operating mode saved in the Mode parameter after CPU restart, select the 
"Activate Mode after CPU restart" check box. 

2. In the "Set Mode to" drop-down list, select the mode that is to be enabled after a complete 
download to the device.
After a complete download to the device, PID_Compact starts in the selected operating 
mode. With each additional restart, PID_Compact starts in the mode that was last saved 
in Mode.

Example

You have selected the "Activate Mode after CPU restart" check box and the entry "Pretuning" 
in the "Set Mode to" list. After a complete download to the device, PID_Compact starts in the 
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"Pretuning" mode. If pretuning is still active, PID_Compact starts in "Pretuning" mode again 
after restart of the CPU. If pretuning was successfully completed and automatic mode is active, 
PID_Compact starts in "Automatic mode" after restart of the CPU.  

Setpoint

Procedure
Proceed as follows to define a fixed setpoint:

1. Select "Instance DB".

2. Enter a setpoint, e.g. 80° C.

3. Delete any entry in the instruction.

Proceed as follows to define a variable setpoint:

1. Select "Instruction".

2. Enter the name of the REAL variable in which the setpoint is saved.
Program-controlled assignment of various values to the REAL variable is possible, for 
example for the time controlled change of the setpoint.

Process value
PID_Compact will scale the value of the analog input to the physical quantity if you use the 
analog input value directly.

You will need to write a program for processing if you wish first to process the analog input 
value. The process value is, for example, not directly proportional to the value at the analog 
input. The processed process value must be in floating point format. 

Procedure
Proceed as follows to use the analog input value without processing:

1. Select the entry "Input_PER" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the address of the analog input.

Proceed as follows to use the processed process value in floating point format:

1. Select the entry "Input" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the name of the variable in which the processed process value is saved.
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Output value
PID_Compact offers three output values. Your actuator will determine which output value you 
use.

● Output_PER
The actuator is triggered via an analog output and controlled with a continuous signal, e.g. 
0...10V, 4...20mA.

● Output
The output value needs to be processed by the user program, for example because of 
nonlinear actuator response.

● Output_PWM
The actuator is controlled via a digital output. Pulse width modulation creates minimum ON 
and minimum OFF times.

Procedure
Proceed as follows to use the analog output value:

1. Select the entry "Output_PER (analog)" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the analog output.

Proceed as follows to process the output value using the user program:

1. Select the entry "Output" in the drop-down list "Output".

2. Select "Instance DB".
The calculated output value is saved in the instance data block.

3. For the preparation of the output value, use the output parameter Output.

4. Transfer the processed output value to the actuator via a digital or analog CPU output.

Proceed as follows to use the digital output value:

1. Select the entry "Output_PWM" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the digital output.

Process value settings

Scaling the process value
If you have configured the use of Input_PER in the basic setting, you must convert the value 
of the analog input to the physical quantity of the process value. The current configuration is 
displayed in the Input_PER display. 

Input_PER will be scaled using a low and high value pair if the process value is directly 
proportional to the value of the analog input.
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Procedure
To scale the process value, follow these steps:

1. Enter the low pair of values in the "Scaled low process value" and "Low" input fields.

2. Enter the high pair of values in the "Scaled high process value" and "High" input boxes.

Default settings for the value pairs are stored in the hardware configuration. To use the value 
pairs from the hardware configuration, follow these steps:

1. Select the PID_Compact instruction in the programming editor.

2. Interconnect Input_PER with an analog input in the basic settings.

3. Click the "Automatic setting" button in the process value settings.

The existing values will be overwritten with the values from the hardware configuration.

Process value limits
You must specify an appropriate absolute high limit and low limit for the process value as limit 
values for your controlled system. As soon as the process value violates these limits, an error 
occurs (ErrorBits = 0001h). Tuning is canceled when the process value limits are violated. You 
can configure how PID_Compact reacts to an error in automatic mode in the output value 
settings.

Advanced settings

Monitoring process value
Configure a warning high and low limit for the process value in the "Process value monitoring" 
configuration window. If one of the warning limits is exceeded or undershot during operation, 
a warning will be displayed at the PID_Compact instruction:

● At the InputWarning_H output parameter if the warning high limit has been exceeded

● At the InputWarning_L output parameter if the warning low limit has been undershot

The warning limits must be within the process value high and low limits. 

The process value high and low limits will be used if you do not enter values.

Example
Process value high limit = 98 °C; warning high limit = 90 °C 

Warning low limit = 10 °C; process value low limit = 0 °C

PID_Compact will respond as follows:
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Process value InputWarnin
g_H 

InputWarnin
g_L

ErrorBi
ts

Operating mode

> 98 °C TRUE FALSE 0001h Inactive or 
Substitute output value with error 
monitoring

≤ 98 °C and > 90 °C TRUE FALSE 0000h Automatic mode
≤ 90 °C and ≥ 10 °C FALSE FALSE 0000h Automatic mode
< 10 °C and ≥ 0 °C FALSE TRUE 0000h Automatic mode
< 0 °C FALSE TRUE 0001h Inactive or 

Substitute output value with error 
monitoring

In the output value settings, you can specify the reaction of PID_Compact when the process 
value high limit or low limit is violated.

See also
Parameters State and Mode V2 (Page 2610)

PWM limits
The value at the output parameter Output is transformed into a pulse sequence that is output 
at output parameter Output_PWM by means of a pulse width modulation. Output is calculated 
in the PID algorithm sampling time, Output_PWM is output in the PID_Compact sampling time. 

The PID algorithm sampling time is determined during pretuning or fine tuning. If manually 
setting the PID parameters, you will also need to configure the PID algorithm sampling time. 
The PID_Compact sampling time is equivalent to the cycle time of the calling OB.

The pulse duration is proportional to the value at Output and is always an integer multiple of 
the PID_Compact sampling time. 
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① PID_Compact sampling time
② PID algorithm sampling time 
③ Pulse duration
④ Break time

The "Minimum ON time" and the "Minimum OFF time" are rounded to an integer multiple of 
the PID_Compact sampling time. 

A pulse or a break is never shorter than the minimum ON or OFF time. The inaccuracies this 
causes are added up and compensated in the next cycle.

Example

PID_Compact sampling time = 100 ms

PID algorithm sampling time = 1000 ms

Minimum ON time = 200 ms

Output is a constant 15%. The smallest pulse that PID_Compact can output is 20%. In the first 
cycle, no pulse is output. In the second cycle, the pulse not output in the first cycle is added 
to the pulse of the second cycle. 
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① PID_Compact sampling time
② PID algorithm sampling time 
⑤ Minimum ON time

In order to minimize operation frequency and conserve the actuator, extend the minimum ON 
and OFF times.

If you are using "Output" or "Output_PER", you must configure the value 0.0 for the minimum 
ON and OFF times.

 

 Note

The minimum ON and OFF times only affect the output parameter Output_PWM and are not 
used for any pulse generators integrated in the CPU.

 

Output value

Output value limits
In the "Output value limits" configuration window, configure the absolute limits of your output 
value in percent. Absolute output value limits are not violated in neither manual mode nor 
automatic mode. If an output value outside the limits is specified in manual mode, the effective 
value is limited in the CPU to the configured limits. 

The output value limits must match the control logic.

The valid output value limit values depend on the Output used.

Output -100.0 to 100.0%
Output_PER -100.0 to 100.0%
Output_PWM 0.0 to 100.0%
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Reaction to error
 

 NOTICE

Your system may be damaged.

If you output "Current value while error pending " or "Substitute output value while error 
pending" in the event of an error, PID_Compact remains in automatic mode. This may cause 
a violation of the process value limits and damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to protect 
your system from damage. 

 

PID_Compact is preset so that the controller stays active in most cases in the event of an error. 
If errors occur frequently in controller mode, this default reaction has a negative effect on the 
control response. In this case, check the Errorbits parameter and eliminate the cause of the 
error.

PID_Compact generates a programmable output value in response to an error:
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● Zero (inactive)
PID_Compact outputs 0.0 as output value for all errors and switches to "Inactive" mode. 
The controller is only reactivated by a falling edge at Reset or a rising edge at ModeActivate.

● Current value while error is pending
If the following errors occur in automatic mode, PID_Compact returns to automatic mode 
as soon as the errors are no longer pending.
If one or more of the following errors occur, PID_Compact stays in 
automatic mode:

– 0001h: The "Input" parameter is outside the process value limits.

– 0800h: Sampling time error

– 40000h: Invalid value at Disturbance parameter. 

If one or more of the following errors occur in automatic mode, PID_Compact switches to 
"Substitute output value with error monitoring" mode and outputs the last valid output value:

– 0002h: Invalid value at Input_PER parameter.

– 0200h: Invalid value at Input parameter.

– 0400h: Calculation of output value failed.

– 1000h: Invalid value at Setpoint parameter.

If an error occurs in manual mode, PID_Compact continues using the manual value as the 
output value. If the manual value is invalid, the substitute output value is used. If the manual 
value and substitute output value are invalid, the output value low limit is used. 
If the following error occurs during a pretuning or fine tuning, PID_Compact remains in 
active mode:

– 0020h: Pretuning is not permitted during fine tuning.

When any other error occurs, PID_Compact cancels the tuning and switches to the mode 
from which tuning was started.
As soon as no errors are pending, PID_Compact returns to automatic mode.

● Substitute output value while error is pending
PID_Compact outputs the substitute output value. 
If the following error occurs, PID_Compact stays in "Substitute output value with error 
monitoring" mode and outputs the output value low limit: 

– 20000h: Invalid value at SubstituteOutput tag. 

For all other errors, PID_Compact reacts as described for "Current value while error is 
pending".

See also
Parameters State and Mode V2 (Page 2610)

PID parameters
The PID parameters are displayed in the "PID Parameters" configuration window. The PID 
parameters will be adapted to your controlled system during controller tuning. You do not need 
to enter the PID parameters manually.
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The PID algorithm operates according to the following equation:

y  =  K
p 
 (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint 
x Process value
TI Integral action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
TD Derivative action time
c Derivative action weighting

The diagram below illustrates the integration of the parameters into the PID algorithm:

All PID parameters are retentive. If you enter the PID parameters manually, you must 
completely download PID_Compact. 

Downloading technology objects to device (Page 5935)

Proportional gain
The value specifies the proportional gain of the controller. PID_Compact does not work with 
a negative proportional gain. Control logic is inverted under Basic settings > Controller type.
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Integral action time
The integral action time determines the time behavior of the integral action. The integral action 
is deactivated with integral action time = 0.0.

Derivative action time
The derivative action time determines the time behavior of the derivative action. Derivative 
action is deactivated with derivative action time = 0.0.

Derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative action. 

Derivative delay = derivative action time × derivative delay coefficient

● 0.0: Derivative action is effective for one cycle only and therefore almost not effective.

● 0.5: This value has proved useful in practice for controlled systems with one dominant time 
constant.

● > 1.0: The greater the coefficient, the longer the effect of the derivative action is delayed.

Proportional action weighting
The proportional action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Proportional action for setpoint change is fully effective

● 0.0: Proportional action for setpoint change is not effective

The proportional action is always fully effective when the process value is changed.

Derivative action weighting
The derivative action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Derivative action is fully effective upon setpoint change

● 0.0: Derivative action is not effective upon setpoint change

The derivative action is always fully effective when the process value is changed.

PID algorithm sampling time 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_Compact are executed at every call.

If you use Output_PWM, the accuracy of the output signal is determined by the ratio of the PID 
algorithm sampling time to the cycle time of the OB. The PID algorithm sampling time 
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corresponds to the time period of the pulse width modulation. The cycle time should be at least 
10 times the PID algorithm sampling time.

Rule for tuning
Select whether PI or PID parameters are to be calculated in the "Controller structure" drop-
down list.

● PID
Calculates PID parameters during pretuning and fine tuning.

● PI
Calculates PI parameters during pretuning and fine tuning.

● User-defined
The drop-down list displays "User-defined" if you have configured different controller 
structures for pretuning and fine tuning via a user program. 

Commissioning PID_Compact V2

Pretuning
The pretuning determines the process response to a jump change of the output value and 
searches for the point of inflection. The PID parameters are calculated from the maximum rate 
of rise and dead time of the controlled system. You obtain the best PID parameters when you 
perform pretuning and fine tuning.

The more stable the process value is, the easier it is to calculate the PID parameters and the 
more precise the result will be. Noise on the process value can be tolerated as long as the rate 
of rise of the process value is significantly higher compared to the noise. This is most likely 
the case in operating modes "Inactive" and "manual mode". The PID parameters are backed 
up before being recalculated. 

Requirement
● The "PID_Compact" instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE

● PID_Compact is in one of the following modes: "Inactive", "Manual mode", or "Automatic 
mode".

● The setpoint and the process value lie within the configured limits (see "Process value 
monitoring" configuration).

● The difference between setpoint and process value is greater than 30% of the difference 
between process value high limit and process value low limit.

● The distance between the setpoint and the process value is > 50% of the setpoint.
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Procedure
To perform pretuning, follow these steps:

1. Double-click the "PID_Compact > Commissioning" entry in the project tree.

2. Select the entry "Pretuning" in the "Tuning mode" drop-down list.

3. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– Pretuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon when the progress bar has reached 100% and it can be assumed 
the controller tuning function is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.

 

Result
If pretuning was performed without an error message, the PID parameters have been tuned. 
PID_Compact switches to automatic mode and uses the tuned parameters. The tuned PID 
parameters will be retained during power OFF and a restart of the CPU.

If pretuning is not possible, PID_Compact responds with the configured reaction to errors.

See also
Parameters State and Mode V2 (Page 2610)

Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters 
are tuned for the operating point from the amplitude and frequency of this oscillation. All PID 
parameters are recalculated from the results. PID parameters from fine tuning usually have 
better master control and disturbance characteristics than PID parameters from pretuning. You 
obtain the best PID parameters when you perform pretuning and fine tuning.

PID_Compact automatically attempts to generate an oscillation greater than the noise of the 
process value. Fine tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before being recalculated.

Requirement
● The PID_Compact instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE
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● The setpoint and the process value lie within the configured limits.

● The control loop has stabilized at the operating point. The operating point is reached when 
the process value corresponds to the setpoint.

● No disturbances are expected.

● PID_Compact is in one of the following operating modes: Inactive, automatic mode, or 
manual mode.

Process depends on initial situation
Fine tuning can be started from the following operating modes: "Inactive", "automatic mode", 
or "manual mode". Fine tuning proceeds as follows when started from:

● Automatic mode
Start fine tuning from automatic mode if you wish to improve the existing PID parameters 
through tuning.
PID_Compact controls the system using the existing PID parameters until the control loop 
has stabilized and the requirements for fine tuning have been met. Only then will fine tuning 
start. 

● Inactive or manual mode
If the requirements for pretuning are met, pretuning is started. The determined PID 
parameters will be used for control until the control loop has stabilized and the requirements 
for fine tuning have been met. Only then will fine tuning start. If pretuning is not possible, 
PID_Compact responds with the configured reaction to errors.
An attempt is made to reach the setpoint with the minimum or maximum output value if the 
process value for pretuning is already too near the setpoint. This can produce increased 
overshoot. 

Procedure
To perform fine tuning, follow these steps:

1. Select the entry "Fine tuning" in the "Tuning mode" drop-down list.

2. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– The process of fine tuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon in the "Tuning mode" group when the progress bar has reached 100% 
and it is to be assumed that tuning is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.
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Result
If no errors occurred during fine tuning, the PID parameters have been tuned. PID_Compact 
switches to automatic mode and uses the tuned parameters. The tuned PID parameters will 
be retained during power OFF and a restart of the CPU. 

If errors occurred during "fine tuning", PID_Compact responds with the configured response 
to errors.

See also
Parameters State and Mode V2 (Page 2610)

"Manual" mode
The following section describes how you can use the "manual mode" operating mode in the 
commissioning window of the "PID_Compact" technology object. Manual mode is also possible 
when an error is pending.

Requirement
● The "PID_Compact" instruction is called in a cyclic interrupt OB.

● An online connection to the CPU has been established and the CPU is in the "RUN" mode.

Procedure
Use "Manual mode" in the commissioning window if you want to test the controlled system by 
specifying a manual value. To define a manual value, follow these steps:

1. Click the "Start" icon.

2. Select the "Manual mode" check box in the "Online status of controller" area.
PID_Compact operates in manual mode. The most recent current output value remains in 
effect.

3. Enter the manual value in the "Output" field as a % value.

4. Click the  icon.

Result
The manual value is written to the CPU and immediately goes into effect.

Clear the "Manual mode" check box if the output value is to be specified again by the PID 
controller. The switchover to automatic mode is bumpless.

See also
Parameters State and Mode V2 (Page 2610)
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11.1.3.3 PID_Compact V1

Configuring PID_Compact V1

Basic settings

Introduction
Configure the following properties of the "PID_Compact" technology object under "Basic 
settings" in the Inspector window or in the configuration window:

● Physical quantity

● Control logic

● Start-up behavior after reset

● Setpoint (only in the Inspector window)

● Process value (only in the Inspector window)

● Output value (only in the Inspector window)

Setpoint, process value and output value
You can only configure the setpoint, process value and output value in the Inspector window 
of the programming editor. Select the source for each value:

● Instance DB
The value saved in the instance DB is used.
Value must be updated in the instance DB by the user program.
There should be no value at the instruction.
Change via HMI possible.

● Instruction
The value connected to the instruction is used. 
The value is written to the instance DB each time the instruction is called.
No change via HMI possible.

Controller type

Physical quantity
Select the unit of measurement and physical quantity for the setpoint and process value in the 
"Controller type" group. The setpoint and process value will be displayed in this unit.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. 
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PID_Compact does not work with negative proportional gain. Select the check box "Invert 
control logic" to reduce the process value with a higher output value.

Examples

● Opening the drain valve will reduce the level of a container's contents.

● Increasing cooling will reduce the temperature.

Start-up behavior after reset
To change straight to the last active mode after restarting the CPU, select the "Enable last 
mode after CPU restart" check box.

PID_Compact will remain in "Inactive" mode if the check box is cleared.

Setpoint

Procedure
Proceed as follows to define a fixed setpoint:

1. Select "Instance DB".

2. Enter a setpoint, e.g. 80° C.

3. Delete any entry in the instruction.

Proceed as follows to define a variable setpoint:

1. Select "Instruction".

2. Enter the name of the REAL variable in which the setpoint is saved.
Program-controlled assignment of various values to the REAL variable is possible, for 
example for the time controlled change of the setpoint.

Process value
PID_Compact will scale the value of the analog input to the physical quantity if you use the 
analog input value directly.

You will need to write a program for processing if you wish first to process the analog input 
value. The process value is, for example, not directly proportional to the value at the analog 
input. The processed process value must be in floating point format. 

Procedure
Proceed as follows to use the analog input value without processing:

1. Select the entry "Input_PER" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the address of the analog input.

Proceed as follows to use the processed process value in floating point format:
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1. Select the entry "Input" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the name of the variable in which the processed process value is saved.

Output value
PID_Compact offers three output values. Your actuator will determine which output value you 
use.

● Output_PER
The actuator is triggered via an analog output and controlled with a continuous signal, e.g. 
0...10V, 4...20mA.

● Output
The output value needs to be processed by the user program, for example because of 
nonlinear actuator response.

● Output_PWM
The actuator is controlled via a digital output. Pulse width modulation creates minimum ON 
and minimum OFF times.

Procedure
Proceed as follows to use the analog output value:

1. Select the entry "Output_PER (analog)" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the analog output.

Proceed as follows to process the output value using the user program:

1. Select the entry "Output" in the drop-down list "Output".

2. Select "Instance DB".
The calculated output value is saved in the instance data block.

3. For the preparation of the output value, use the output parameter Output.

4. Transfer the processed output value to the actuator via a digital or analog CPU output.

Proceed as follows to use the digital output value:

1. Select the entry "Output_PWM" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the digital output.

Process value settings
Configure the scaling of your process value and specify the process value absolute limits In 
the "Process value settings" configuration window.
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Scaling the process value
If you have configured the use of Input_PER in the basic settings, you will need to convert the 
value of the analog input into the physical quantity of the process value. The current 
configuration will be displayed in the Input_PER display. 

Input_PER will be scaled using a low and high value pair if the process value is directly 
proportional to the value of the analog input.

1. Enter the low pair of values in the "Scaled low process value" and "Low" input fields.

2. Enter the high pair of values in the "Scaled high process value" and "High" input boxes.

Default settings for the value pairs are saved in the hardware configuration. Proceed as follows 
to use the value pairs from the hardware configuration:

1. Select the instruction PID_Compact in the programming editor.

2. Connect Input_PER with an analog input in the basic settings.

3. Click on the "Automatic setting" button in the process value settings.

The existing values will be overwritten with the values from the hardware configuration.

Monitoring process value
Specify the absolute high and low limit of the process value. As soon as these limits are violated 
during operation, the controller switches off and the output value is set to 0%. You must enter 
reasonable limits for your controlled system. Reasonable limits are important during 
optimization to obtain optimal PID parameters. 

The default for the "High limit process value" is 120 %. At the I/O input, the process value can 
be a maximum of 18% higher than the standard range (overrange). An error is no longer 
reported for a violation of the "High limit process value". Only a wire-break and a short-circuit 
are recognized and the PID_Compact switches to "Inactive" mode.

 

 WARNING

If you set very high process value limits (for example -3.4*1038...+3.4*1038), process value 
monitoring will be disabled. Your system may then be damaged if an error occurs. 

 

See also
Monitoring process value (Page 5963)

PWM limits (Page 5963)

Output value limits (Page 5965)

PID parameters (Page 5966)
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Advanced settings

Monitoring process value
Configure a warning high and low limit for the process value in the "Process value monitoring" 
configuration window. If one of the warning limits is exceeded or undershot during operation, 
a warning will be displayed at the PID_Compact instruction:

● At the InputWarning_H output parameter if the warning high limit has been exceeded

● At the InputWarning_L output parameter if the warning low limit has been undershot

The warning limits must be within the process value high and low limits. 

The process value high and low limits will be used if you do not enter values.

Example
Process value high limit = 98° C; warning high limit = 90° C 

Warning low limit = 10° C; process value low limit = 0° C

PID_Compact will respond as follows:

Process value InputWarning_H InputWarning_L Operating mode
> 98° C TRUE FALSE Inactive
≤ 98° C and > 90° C TRUE FALSE Automatic mode
≤ 90° C and ≥ 10° C FALSE FALSE Automatic mode
< 10° C and ≥ 0° C FALSE TRUE Automatic mode
< 0° C FALSE TRUE Inactive

See also
Process value settings (Page 5959)

PWM limits (Page 5963)

Output value limits (Page 5965)

PID parameters (Page 5966)

PWM limits
The value at the output parameter Output is transformed into a pulse sequence that is output 
at output parameter Output_PWM by means of a pulse width modulation. Output is calculated 
in the PID algorithm sampling time, Output_PWM is output in the PID_Compact sampling time. 

The PID algorithm sampling time is determined during pretuning or fine tuning. If manually 
setting the PID parameters, you will also need to configure the PID algorithm sampling time. 
The PID_Compact sampling time is equivalent to the cycle time of the calling OB.

The pulse duration is proportional to the value at Output and is always an integer multiple of 
the PID_Compact sampling time. 
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① PID_Compact sampling time
② PID algorithm sampling time 
③ Pulse duration
④ Break time

The "Minimum ON time" and the "Minimum OFF time" are rounded to an integer multiple of 
the PID_Compact sampling time. 

A pulse or a break is never shorter than the minimum ON or OFF time. The inaccuracies this 
causes are added up and compensated in the next cycle.

Example

PID_Compact sampling time = 100 ms

PID algorithm sampling time = 1000 ms

Minimum ON time = 200 ms

Output is a constant 15%. The smallest pulse that PID_Compact can output is 20%. In the first 
cycle, no pulse is output. In the second cycle, the pulse not output in the first cycle is added 
to the pulse of the second cycle. 
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① PID_Compact sampling time
② PID algorithm sampling time 
⑤ Minimum ON time

In order to minimize operation frequency and conserve the actuator, extend the minimum ON 
and OFF times.

If you are using "Output" or "Output_PER", you must configure the value 0.0 for the minimum 
ON and OFF times.

 

 Note

The minimum ON and OFF times only affect the output parameter Output_PWM and are not 
used for any pulse generators integrated in the CPU.

 

See also
Process value settings (Page 5959)

Monitoring process value (Page 5961)

Output value limits (Page 5965)

PID parameters (Page 5966)

Output value limits
In the "Output value limits" configuration window, configure the absolute limits of your output 
value in percent. Absolute output value limits are not violated in neither manual mode nor in 
automatic mode. If a output value outside the limits is specified in manual mode, the effective 
value is limited in the CPU to the configured limits.

The valid output value limit values depend on the Output used.
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Output -100.0 to 100.0
Output_PER -100.0 to 100.0
Output_PWM 0.0 to 100.0

PID_Compact sets the output value to 0.0 if an error occurs. 0.0 must therefore always be 
within the output value limits. You will need to add an offset to Output and Output_PER in the 
user program if you want an output value low limit of greater than 0.0.

See also
Process value settings (Page 5959)

Monitoring process value (Page 5961)

PWM limits (Page 5961)

PID parameters (Page 5966)

PID parameters
The PID parameters are displayed in the "PID Parameters" configuration window. The PID 
parameters will be adapted to your controlled system during controller tuning. You do not need 
to enter the PID parameters manually.

The PID algorithm operates according to the following equation:

y  =  K
p 
 (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint 
x Process value
TI Integral action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
TD Derivative action time
c Derivative action weighting

The diagram below illustrates the integration of the parameters into the PID algorithm:
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All PID parameters are retentive. If you enter the PID parameters manually, you must 
completely download PID_Compact. 

Auto-Hotspot

Proportional gain
The value specifies the proportional gain of the controller. PID_Compact does not work with 
a negative proportional gain. Control logic is inverted under Basic settings > Controller type.

Integral action time
The integral action time determines the time behavior of the integral action. The integral action 
is deactivated with integral action time = 0.0.

Derivative action time
The derivative action time determines the time behavior of the derivative action. Derivative 
action is deactivated with derivative action time = 0.0.

Derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative action. 

Derivative delay = derivative action time × derivative delay coefficient

● 0.0: Derivative action is effective for one cycle only and therefore almost not effective.

● 0.5: This value has proved useful in practice for controlled systems with one dominant time 
constant.

● > 1.0: The greater the coefficient, the longer the effect of the derivative action is delayed.
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Proportional action weighting
The proportional action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Proportional action for setpoint change is fully effective

● 0.0: Proportional action for setpoint change is not effective

The proportional action is always fully effective when the process value is changed.

Derivative action weighting
The derivative action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Derivative action is fully effective upon setpoint change

● 0.0: Derivative action is not effective upon setpoint change

The derivative action is always fully effective when the process value is changed.

PID algorithm sampling time 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_Compact are executed at every call.

If you use Output_PWM, the accuracy of the output signal is determined by the ratio of the PID 
algorithm sampling time to the cycle time of the OB. The PID algorithm sampling time 
corresponds to the time period of the pulse width modulation. The cycle time should be at least 
10 times the PID algorithm sampling time.

Rule for tuning
Select whether PI or PID parameters are to be calculated in the "Controller structure" drop-
down list.

● PID
Calculates PID parameters during pretuning and fine tuning.

● PI
Calculates PI parameters during pretuning and fine tuning.

● User-defined
The drop-down list displays "User-defined" if you have configured different controller 
structures for pretuning and fine tuning via a user program. 

See also
Downloading technology objects to device (Page 5935)
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Commissioning PID_Compact V1

Commissioning
The commissioning window helps you commission the PID controller. You can monitor the 
values for the setpoint, process value and output value along the time axis in the trend view. 
The following functions are supported in the commissioning window:

● Controller pretuning

● Controller fine tuning
Use fine tuning for fine adjustments to the PID parameters.

● Monitoring the current closed-loop control in the trend view

● Testing the controlled system by specifying a manual output value

All functions require an online connection to the CPU to have been established.

Basic handling
● Select the desired sampling time in the "Sampling time" drop-down list.

All values in the commissioning window are updated in the selected update time.

● Click the "Start" icon in the measuring group if you want to use the commissioning functions.
Value recording is started. The current values for the setpoint, process value and output 
value are entered in the trend view. Operation of the commissioning window is enabled.

● Click the "Stop" icon if you want to end the commissioning functions.
The values recorded in the trend view can continue to be analyzed.

Closing the commissioning window will terminate recording in the trend view and delete the 
recorded values.

See also
Pretuning (Page 5969)

Fine tuning (Page 5971)

"Manual" mode (Page 5973)

Pretuning
The pretuning determines the process response to a jump change of the output value and 
searches for the point of inflection. The tuned PID parameters are calculated as a function of 
the maximum slope and dead time of the controlled system.

The more stable the process value is, the easier it is to calculate the PID parameters and the 
more precise the result will be. Noise on the process value can be tolerated as long as the rate 
of rise of the process value is significantly higher compared to the noise. The PID parameters 
are backed up before being recalculated. 
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Requirement
● The "PID_Compact" instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● PID_Compact is in "inactive" or "manual" mode.

● The setpoint may not be changed during controller tuning. PID_Compact will otherwise be 
deactivated.

● The setpoint and the process value lie within the configured limits (see "Process value 
monitoring" configuration).

● The difference between setpoint and process value is greater than 30% of the difference 
between process value high limit and process value low limit.

● The distance between the setpoint and the process value is > 50% of the setpoint.

Procedure
To perform pretuning, follow these steps:

1. Double-click the "PID_Compact > Commissioning" entry in the project tree.

2. Select the entry "Pretuning" in the "Tuning mode" drop-down list.

3. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– Pretuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon when the progress bar has reached 100% and it is to be assumed 
the controller tuning function is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.

 

Result
If pretuning was performed without an error message, the PID parameters have been tuned. 
PID_Compact switches to automatic mode and uses the tuned parameters. The tuned PID 
parameters will be retained during power OFF and a restart of the CPU.

If pretuning is not possible, PID_Compact will change to "Inactive" mode. 
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See also
Parameters State and sRet.i_Mode V1 (Page 2628)

Commissioning (Page 5967)

Fine tuning (Page 5971)

"Manual" mode (Page 5973)

Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters 
are optimized for the operating point from the amplitude and frequency of this oscillation. All 
PID parameters are recalculated on the basis of the findings. PID parameters from fine tuning 
usually have better master control and disturbance behavior than PID parameters from 
pretuning.

PID_Compact automatically attempts to generate an oscillation greater than the noise of the 
process value. Fine tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before being recalculated.

Requirement
● The PID_Compact instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● The setpoint and the process value lie within the configured limits (see "Process value 
monitoring" configuration).

● The control loop has stabilized at the operating point. The operating point is reached when 
the process value corresponds to the setpoint.

● No disturbances are expected.

● The setpoint may not be changed during controller tuning.

● PID_Compact is in inactive mode, automatic mode or manual mode.
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Process depends on initial situation
Fine tuning can be started in "inactive", "automatic" or "manual" mode. Fine tuning proceeds 
as follows when started in:

● Automatic mode
Start fine tuning in automatic mode if you wish to improve the existing PID parameters using 
controller tuning.
PID_Comact will regulate using the existing PID parameters until the control loop has 
stabilized and the requirements for fine tuning have been met. Only then will fine tuning 
start. 

● Inactive or manual mode
If the requirements for pretuning are met, pretuning is started. The PID parameters 
established will be used for adjustment until the control loop has stabilized and the 
requirements for fine tuning have been met. Only then will fine tuning start. If pretuning is 
not possible, PID_Compact will change to "Inactive" mode.
An attempt is made to reach the setpoint with a minimum or maximum output value if the 
process value for pretuning is already too near the setpoint. This can produce increased 
overshoot. 

Procedure
Proceed as follows to carry out "fine tuning":

1. Select the entry "Fine tuning" in the "Tuning mode" drop-down list.

2. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– The process of fine tuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon in the "Tuning mode" group when the progress bar has reached 100% 
and it is to be assumed the controller tuning function is blocked. Check the configuration 
of the technology object and, if necessary, restart controller tuning.

 

Result
The PID parameters will have been optimized if fine tuning has been executed without errors. 
PID_Compact changes to automatic mode and uses the optimized parameters. The optimized 
PID parameters will be retained during power OFF and a restart of the CPU. 

If errors occurred during "fine tuning", PID_Compact will change to "inactive" mode.
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See also
Parameters State and sRet.i_Mode V1 (Page 2628)

Commissioning (Page 5967)

Pretuning (Page 5967)

"Manual" mode (Page 5973)

"Manual" mode
The following section describes how you can use the "Manual" operating mode in the 
commissioning window of the "PID Compact" technology object.

Requirement
● The "PID_Compact" instruction is called in a cyclic interrupt OB.

● An online connection to the CPU has been established and the CPU is in the "RUN" mode.

● The functions of the commissioning window have been enabled via the "Start" icon.

Procedure
Use "Manual mode" in the commissioning window if you want to test the process by specifying 
a manual value. To define a manual value, proceed as follows:

1. Select the check box "Manual mode" in the "Online status of the controller" area.
PID_Compact operates in manual mode. The most recent current output value remains in 
effect.

2. Enter the manual value in the "Output" field as a % value.

3. Click the control icon .

Result
The manual value is written to the CPU and immediately goes into effect.

 

 Note

PID_Compact continues to monitor the process value. If the process value limits are 
exceeded, PID_Compact is deactivated.

 

Clear the "Manual mode" check box if the output value is to be specified again by the PID 
controller. The change to automatic mode is bumpless.
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See also
Parameters State and sRet.i_Mode V1 (Page 2628)

Commissioning (Page 5967)

Pretuning (Page 5967)

Fine tuning (Page 5969)

11.1.4 Using PID_3Step

11.1.4.1 Technology object PID_3Step
The technology object PID_3Step provides a PID controller with tuning for valves or actuators 
with integral response.   

You can configure the following controllers:

● Three-point step controller with position feedback

● Three-point step controller without position feedback

● Valve controller with analog output value

PID_3Step continuously acquires the measured process value within a control loop and 
compares it with the setpoint. From the resulting control deviation, PID_3Step calculates an 
output value through which the process value reaches the setpoint as quickly and steadily as 
possible. The output value for the PID controller consists of three actions:

● P action
The proportional action of the output value increases in proportion to the control deviation.

● I action
The integral action of the output value increases until the control deviation has been 
balanced. 

● D action
The derivative action increases with the rate of change of control deviation. The process 
value is corrected to the setpoint as quickly as possible. The derivative action will be 
reduced again if the rate of change of control deviation drops.

The instruction PID_3Step calculates the proportional, integral and derivative parameters for 
your controlled system during pretuning. Fine tuning can be used to tune the parameters 
further. You do not need to manually determine the parameters.

Additional information
● Overview of software controller (Page 5930) 

● Add technology objects (Page 5932) 

● Configure technology objects (Page 5933) 

● Configuring PID_3Step V2 (Page 5975) 

● Configuring PID_3Step V1 (Page 5991) 
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11.1.4.2 PID_3Step V2

Configuring PID_3Step V2

Basic settings

Introduction
Configure the following properties of the "PID_3Step" technology object under "Basic settings" 
in the Inspector window or in the configuration window:

● Physical quantity

● Control logic

● Start-up behavior after reset

● Setpoint (only in the Inspector window)

● Process value (only in the Inspector window)

● Output value (only in the Inspector window)

● Position feedback (only in the Inspector window)

Setpoint, process value, output value and position feedback
You can only configure the setpoint, process value, output value and position feedback in the 
Inspector window of the programming editor. Select the source for each value:

● Instance DB
The value saved in the instance DB is used.
Value must be updated in the instance DB by the user program.
There should be no value at the instruction.
Change via HMI possible.

● Instruction
The value connected to the instruction is used. 
The value is written to the instance DB each time the instruction is called.
No change via HMI possible.

Controller type

Physical quantity
Select the physical quantity and unit of measurement for setpoint, process value, and 
disturbance variable in the "Controller type" group. Setpoint, process value, and disturbance 
variable is displayed in this unit of measurement.
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Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. 

PID_3Step does not work with negative proportional gain. Select the check box "Invert control 
logic" to reduce the process value with a higher output value.

Examples

● Opening the drain valve will reduce the level of a container's contents.

● Increasing cooling will reduce the temperature.

Startup characteristics
1. To switch to "Inactive" mode after CPU restart, clear the "Activate Mode after CPU restart" 

check box.
To switch to the operating mode saved in the Mode parameter after CPU restart, select the 
"Activate Mode after CPU restart" check box. 

2. In the "Set Mode to" drop-down list, select the mode that is to be enabled after a complete 
download to the device.
After a complete download to the device, PID_3Step starts in the selected operating mode. 
With each additional restart, PID_3Step starts in the mode that was last saved in Mode.

Example

You have selected the "Activate Mode after CPU restart" check box and the entry "Pretuning" 
in the "Set Mode to" list. After a complete download to the device, PID_3Step starts in the 
"Pretuning" mode. If pretuning is still active, PID_3Step starts in "Pretuning" mode again after 
restart of the CPU. If pretuning was successfully completed and automatic mode is active, 
PID_3Step starts in "Automatic mode" after restart of the CPU.  

Setpoint

Procedure
Proceed as follows to define a fixed setpoint:

1. Select "Instance DB".

2. Enter a setpoint, e.g. 80° C.

3. Delete any entry in the instruction.

Proceed as follows to define a variable setpoint:

1. Select "Instruction".

2. Enter the name of the REAL variable in which the setpoint is saved.
Program-controlled assignment of various values to the REAL variable is possible, for 
example for the time controlled change of the setpoint.
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Process value
PID_3Step will scale the value of the analog input to the physical quantity if you use the analog 
input value directly.

You will need to write a program for processing if you wish first to process the analog input 
value. The process value is, for example, not directly proportional to the value at the analog 
input. The processed process value must be in floating point format. 

Procedure
Proceed as follows to use the analog input value without processing:

1. Select the entry "Input_PER" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the address of the analog input.

Proceed as follows to use the processed process value in floating point format:

1. Select the entry "Input" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the name of the variable in which the processed process value is saved.

Position feedback
Position feedback configuration depends upon the actuator used.

● Actuator without position feedback

● Actuator with digital endstop signals

● Actuator with analog position feedback

● Actuator with analog position feedback and endstop signals

Actuator without position feedback 
Proceed as follows to configure PID_3Step for an actuator without position feedback:

1. Select the entry "No Feedback" in the drop-down list "Feedback".

Actuator with digital endstop signals 
Proceed as follows to configure PID_3Step for an actuator with endstop signals:

1. Select the entry "No Feedback" in the drop-down list "Feedback".

2. Activate the "Actuator endstop signals" check box.

3. Select "Instruction" as source for Actuator_H and Actuator_L.

4. Enter the addresses of the digital inputs for Actuator_H and Actuator_L.
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Actuator with analog position feedback 
Proceed as follows to configure PID_3Step for an actuator with analog position feedback:

1. Select the entry "Feedback" or "Feedback_PER" in the drop-down list "Feedback".

– Use the analog input value for Feedback_PER. Configure Feedback_PER scaling in the 
actuator settings.

– Process the analog input value for Feedback using your user program.

2. Select "Instruction" as source.

3. Enter the address of the analog input or the variable of your user program.

Actuator with analog position feedback and endstop signals 
Proceed as follows to configure PID_3Step for an actuator with analog position feedback and 
endstop signals:

1. Select the entry "Feedback" or "Feedback_PER" in the drop-down list "Feedback".

2. Select "Instruction" as source.

3. Enter the address of the analog input or the variable of your user program.

4. Activate the "Actuator endstop signals" check box.

5. Select "Instruction" as source for Actuator_H and Actuator_L.

6. Enter the addresses of the digital inputs for Actuator_H and Actuator_L.

Output value
PID_3Step offers an analog output value (Output_PER) and digital output values (Output_UP, 
Output_DN). Your actuator will determine which output value you use.

● Output_PER
The actuator is triggered via an analog output and controlled with a continuous signal, e.g. 
0...10V, 4...20mA.

● Output_UP, Output_DN
The actuator is controlled via two digital outputs.

Procedure
Proceed as follows to use the analog output value:

1. Select the entry "Output (analog)" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the analog output.

Proceed as follows to use the digital output value:

1. Select the entry "Output (digital)" in the drop-down list "Output".

2. Select "Instruction" for Output_UP and Output_DN.

3. Enter the addresses of the digital outputs.
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Proceed as follows to process the output value using the user program:

1. Select the entry corresponding to the actuator in the drop-down list "Output".

2. Select "Instruction".

3. Enter the name of the variable you are using to process the output value.

4. Transfer the processed output value to the actuator by means of an analog or digital CPU 
output.

Process value settings

Scaling the process value
If you have configured the use of Input_PER in the basic setting, you must convert the value 
of the analog input to the physical quantity of the process value. The current configuration is 
displayed in the Input_PER display. 

Input_PER will be scaled using a low and high value pair if the process value is directly 
proportional to the value of the analog input.

Procedure
To scale the process value, follow these steps:

1. Enter the low pair of values in the "Scaled low process value" and "Low" text boxs.

2. Enter the high pair of values in the "Scaled high process value" and "High" input boxes.

Default settings for the value pairs are stored in the hardware configuration. To use the value 
pairs from the hardware configuration, follow these steps:

1. Select the PID_3Step instruction in the programming editor.

2. Interconnect Input_PER with an analog input in the basic settings.

3. Click the "Automatic setting" button in the process value settings.

The existing values will be overwritten with the values from the hardware configuration.

Process value limits
You must specify an appropriate absolute high limit and low limit for the process value as limit 
values for your controlled system. As soon as the process value violates these limits, an error 
occurs (ErrorBits = 0001h). Tuning is canceled when the process value limits are violated. You 
can specify how PID_3Step responds to errors in automatic mode in the actuator settings.
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Actuator settings

Actuator

Actuator-specific times
Configure the motor transition time and the minimum ON and OFF times to prevent damage 
to the actuator. You can find the specifications in the actuator data sheet.

The motor transition time is the time in seconds the motor requires to move the actuator from 
the closed to the opened state. You can measure the motor transition time during 
commissioning.

The motor transition time is retentive. If you enter the motor transition time manually, you must 
completely download PID_3Step. 

Downloading technology objects to device (Page 5935)

If you are using "Output_UP" or "Output_DN", you can reduce the switching frequency with 
the minimum on and minimum OFF time.

The on or off times calculated are totaled in automatic mode and only become effective when 
the sum is greater than or equal to the minimum on or OFF time.

Manual_UP = TRUE or Manual_DN = TRUE in manual mode operates the actuator for at least 
the minimum ON or OFF time.

Reaction to error
PID_3Step is preset so that the controller stays active in most cases in the event of an error. 
If errors occur frequently in controller mode, this default reaction has a negative effect on the 
control response. In this case, check the Errorbits parameter and eliminate the cause of the 
error.

 

 NOTICE

Your system may be damaged.

If you output "Current value while error pending" or "Substitute output value while error 
pending" in the event of an error, PID_3Step remains in automatic mode even if the process 
value limits are violated. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to protect 
your system from damage. 

 

PID_3Step generates a programmable output value in response to an error:
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● Current value
PID_3Step is switched off and no longer modifies the actuator position.

● Current value for error while error is pending
The controller functions of PID_3Step are switched off and the position of the actuator is 
no longer changed.
If the following errors occur in automatic mode, PID_3Step returns to automatic mode as 
soon as the errors are no longer pending.

– 0002h: Invalid value at Input_PER parameter.

– 0200h: Invalid value at Input parameter.

– 0400h: Calculation of output value failed.

– 1000h: Invalid value at Setpoint parameter.

– 2000h: Invalid value at Feedback_PER parameter.

– 4000h: Invalid value at Feedback parameter.

– 8000h: Error during digital position feedback.

– 20000h: Invalid value at SavePosition tag.

If one or more of the following errors occur, PID_3Step stays in 
automatic mode:

– 0001h: The Input parameter is outside the process value limits.

– 0800h: Sampling time error

– 40000h: Invalid value at Disturbance parameter.

PID_3Step remains in manual mode if an error occurs in manual mode.
If an error occurs during tuning or transition time measurement, PID_3Step switches to the 
mode in which tuning or transition time measurement was started. Only in the event of the 
following error is tuning not aborted:

– 0020h: Pretuning is not permitted during fine tuning.

● Substitute output value
PID_3Step moves the actuator to the substitute output value and then switches off.

● Substitute output value while error is pending
PID_3Step moves the actuator to the substitute output value. When the substitute output 
value is reached, PID_3Step reacts as it does with "Current value for while error is pending". 

Enter the substitute output value in "%". 

Only substitute output values 0% and 100% can be approached precisely in the case of 
actuators without analog position feedback.  A substitute output value not equal to 0% or 100% 
is approached via an internally simulated position feedback. This procedure does not, however, 
allow the exact approach of substitute output value. 

All substitute output values can be approached precisely with actuators with analog position 
feedback.
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Scaling position feedback

Scaling position feedback
If you have configured the use of Feedback_PER in the basic settings, you will need to convert 
the value of the analog input into %. The current configuration will be displayed in the 
"Feedback" display. 

Feedback_PER is scaled using a low and high value pair.

1. Enter the low pair of values in the "Low endstop" and "Low" input boxes.

2. Enter the high pair of values in the "High endstop" and "High" input boxes.

"Low endstop" must be less than "High endstop"; "Low" must be less than "High".

The valid values for "High endstop" and "Low endstop" depend upon:

● No Feedback, Feedback, Feedback_PER

● Output (analog), Output (digital)

Output Feedback Low endstop High endstop
Output (digital) No Feedback Cannot be set (0.0%) Cannot be set (100.0%)
Output (digital) Feedback -100.0% or 0.0% 0.0% or +100.0%
Output (digital) Feedback_PER -100.0% or 0.0% 0.0% or +100.0%
Output (analog) No Feedback Cannot be set (0.0%) Cannot be set (100.0%)
Output (analog) Feedback -100.0% or 0.0% 0.0% or +100.0%
Output (analog) Feedback_PER -100.0% or 0.0% 0.0% or +100.0%

Output value limits

Limiting the output value
You can only exceed or undershoot the output value limits during the transition time 
measurement. The output value is limited to these values in all other modes. 

Enter the absolute output value limits in the "Output value high limit" and "Output value low 
limit" input boxes. The output value limits must be within "Low endstop" and "High endstop".

If no Feedback is available and Output (digital) is set, you cannot limit the output value. 
Output_UP and Output_DN are then reset at Actuator_H = TRUE or Actuator_L = TRUE. If no 
endstop signals are available, Output_UP and Output_DN are reset after a travel time of 150% 
of the motor actuating time.
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Advanced settings

Monitoring process value
Configure a warning high and low limit for the process value in the "Process value monitoring" 
configuration window. If one of the warning limits is exceeded or undershot during operation, 
a warning will be displayed at the PID_3Step instruction:

● At the InputWarning_H output parameter if the warning high limit has been exceeded

● At the InputWarning_L output parameter if the warning low limit has been undershot

The warning limits must be within the process value high and low limits. 

The process value high and low limits will be used if you do not enter values.

Example
Process value high limit = 98° C; warning high limit = 90° C 

Warning low limit = 10° C; process value low limit = 0° C

PID_3Step will respond as follows:

Process value InputWarnin
g_H 

InputWarnin
g_L

ErrorBi
ts

Operating mode

> 98° C TRUE FALSE 0001h As configured
≤ 98° C and > 90° C TRUE FALSE 0000h Automatic mode
≤ 90° C and ≥ 10° C FALSE FALSE 0000h Automatic mode
< 10° C and ≥ 0° C FALSE TRUE 0000h Automatic mode
< 0° C FALSE TRUE 0001h As configured

In the actuator settings, you can configure the response of PID_3Step when the process value 
high limit or low limit is violated.

PID parameters
The PID parameters are displayed in the "PID Parameters" configuration window. The PID 
parameters will be adapted to your controlled system during controller tuning. You do not need 
to enter the PID parameters manually.

The PID algorithm operates according to the following equation:

Δ y  =  K
p 
 · s  ·  (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
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]
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Symbol Description
Δy Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
TD Derivative action time
c Derivative action weighting

The diagram below illustrates the integration of the parameters into the PID algorithm:

All PID parameters are retentive. If you enter the PID parameters manually, you must 
completely download PID_3Step. 

Downloading technology objects to device (Page 5935) 

Proportional gain
The value specifies the proportional gain of the controller. PID_3Step does not work with a 
negative proportional gain. Control logic is inverted under Basic settings > Controller type.

Integral action time
The integral action time determines the time behavior of the integral action. The integral action 
is deactivated with integral action time = 0.0.

Derivative action time
The derivative action time determines the time behavior of the derivative action. Derivative 
action is deactivated with derivative action time = 0.0.
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Derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative action. 

Derivative delay = derivative action time × derivative delay coefficient

● 0.0: Derivative action is effective for one cycle only and therefore almost not effective.

● 0.5: This value has proved useful in practice for controlled systems with one dominant time 
constant.

● > 1.0: The greater the coefficient, the longer the effect of the derivative action is delayed.

Proportional action weighting
The proportional action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Proportional action for setpoint change is fully effective

● 0.0: Proportional action for setpoint change is not effective

The proportional action is always fully effective when the process value is changed.

Derivative action weighting
The derivative action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Derivative action is fully effective upon setpoint change

● 0.0: Derivative action is not effective upon setpoint change

The derivative action is always fully effective when the process value is changed.

PID algorithm sampling time 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the PID_3Step sampling time. All other 
functions of PID_3Step are executed at every call.

Deadband width
The deadband suppresses the noise component in the steady controller state. The deadband 
width specifies the size of the deadband. The deadband is off if the deadband width is 0.0.
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Commissioning PID_3Step V2

Pretuning
The pretuning determines the process response to a pulse of the output value and searches 
for the point of inflection. The tuned PID parameters are calculated as a function of the 
maximum slope and dead time of the controlled system. You obtain the best PID parameters 
when you perform pretuning and fine tuning.

The more stable the process value is, the easier it is to calculate the PID parameters and the 
more precise the result will be. Noise on the process value can be tolerated as long as the rate 
of rise of the process value is significantly higher compared to the noise. This is most likely 
the case in operating modes "Inactive" and "manual mode". The PID parameters are backed 
up before being recalculated.

The setpoint is frozen during pretuning. 

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE

● The motor transition time has been configured or measured.

● PID_3Step is in one of the following modes: "Inactive", "Manual mode", or "Automatic mode".

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).

Procedure
To perform pretuning, follow these steps:

1. Double-click the "PID_3Step > Commissioning" entry in the project tree.

2. Select the entry "Pretuning" in the "Tuning mode" drop-down list in the working area 
"Tuning".

3. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– Pretuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon when the progress bar has reached 100% and it is to be assumed 
the controller tuning function is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.
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Result
If pretuning was performed without an error message, the PID parameters have been tuned. 
PID_3Step switches to automatic mode and uses the tuned parameters. The tuned PID 
parameters will be retained during power OFF and a restart of the CPU.

If pretuning is not possible, PID_3Step responds with the configured reaction to errors. 

Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters 
are tuned for the operating point from the amplitude and frequency of this oscillation. All PID 
parameters are recalculated from the results. PID parameters from fine tuning usually have 
better master control and disturbance characteristics than PID parameters from pretuning. You 
obtain the best PID parameters when you perform pretuning and fine tuning.

PID_3Step automatically attempts to generate an oscillation greater than the noise of the 
process value. Fine tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before being recalculated.

The setpoint is frozen during fine tuning. 

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE

● The motor transition time has been configured or measured.

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).

● The control loop has stabilized at the operating point. The operating point is reached when 
the process value corresponds to the setpoint.

● No disturbances are expected.

● PID_3Step is in inactive mode, automatic mode or manual mode.

Process depends on initial situation
Fine tuning proceeds as follows when started from:

● Automatic mode
Start fine tuning from automatic mode if you wish to improve the existing PID parameters 
through tuning.
PID_3Step controls the system using the existing PID parameters until the control loop has 
stabilized and the requirements for fine tuning have been met. Only then will fine tuning 
start.

● Inactive or manual mode
Pretuning is always started first. The determined PID parameters will be used for control 
until the control loop has stabilized and the requirements for fine tuning have been met. 
Only then will fine tuning start.
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Procedure
To perform fine tuning, follow these steps:

1. Select the entry "Fine tuning" in the "Tuning mode" drop-down list.

2. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– The process of fine tuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon in the "Tuning mode" group when the progress bar has reached 100% 
and it is to be assumed the controller tuning function is blocked. Check the configuration 
of the technology object and, if necessary, restart controller tuning.

 

Result
If no errors occurred during fine tuning, the PID parameters have been tuned. PID_3Step 
switches to automatic mode and uses the tuned parameters. The tuned PID parameters will 
be retained during power OFF and a restart of the CPU. 

If errors occurred during fine tuning, PID_3Step responds with the configured response to 
errors. 

Commissioning with manual PID parameters

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE

● The motor transition time has been configured or measured.

● PID_3Step is in "inactive" mode.

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).
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Procedure
Proceed as follows to commission PID_3Step with manual PID parameters:

1. Double-click on "PID_3Step > Configuration" in the project tree.

2. Click on "Advanced settings > PID Parameters" in the configuration window.

3. Select the check box "Enable direct input".

4. Enter the PID parameters.

5. Double-click the "PID_3Step > Commissioning" entry in the project tree.

6. Establish an online connection to the CPU.

7. Load the PID parameters to the CPU.

8. Click the "Start PID_3Step" icon.

Result
PID_3Step changes to automatic mode and controls using the current PID parameters.

See also
PID parameters (Page 5981)

Measuring the motor transition time

Introduction
PID_3Step requires the motor transition time to be as accurate as possible for good controller 
results. The data in the actuator documentation contains average values for this type of 
actuator. The value for the specific actuator used may differ.

You can measure the motor transition time during commissioning if you are using actuators 
with position feedback or endstop signals. The output value limits are not taken into 
consideration during the motor transition time measurement. The actuator can travel to the 
high or the low endstop.

The motor transition time cannot be measured if neither position feedback nor endstop signals 
are available.

Actuators with analog position feedback
Proceed as follows to measure motor transition time with position feedback:

Requirement

● Feedback or Feedback_PER has been selected in the basic settings and the signal has 
been connected.

● An online connection to the CPU has been established.
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1. Select the "Use position feedback" check box.

2. Enter the position to which the actuator is to be moved in the "Target position" input field.
The current position feedback (starting position) will be displayed. The difference between 
"Target position" and "Position feedback" must be at least 50% of the valid output value 
range.

3. Click the "Start" icon.

Result
The actuator is moved from the starting position to the target position. Time measurement 
starts immediately and ends when the actuator reaches the target position. The motor transition 
time is calculated according to the following equation:

Motor transition time = (output value high limit – output value low limit) × Measuring time / 
AMOUNT (target position – starting position).

The progress and status of transition time measurement are displayed. The transition time 
measured is saved in the instance data block on the CPU and displayed in the "Measured 
transition time" field. When the transition time measurement is ended and 
ActivateRecoverMode = TRUE, PID_3Step switches to the operating mode from which the 
transition time measurement was started. If the transition time measurement is ended and 
ActivateRecoverMode = FALSE, PID_3Step changes to "Inactive" mode.

 

 Note

Click on the icon  "Upload measured transition time" to load the motor transition time 
measured to the project.

 

Actuators with endstop signals
Proceed as follows to measure the transition time of actuators with endstop signals:

Requirement

● The "Endstop signals" check box in the basic settings has been selected and Actuator_H 
and Actuator_L are connected.

● An online connection to the CPU has been established.

Proceed as follows to measure motor transition time with endstop signals:

1. Select the "Use actuator endstop signals" check box.

2. Select the direction in which the actuator is to be moved.

– Open - Close - Open
The actuator is moved first to the high endstop, then to the low endstop and then back 
to the high endstop.

– Close - Open - Close
The actuator is moved first to the low endstop, then to the high endstop and then back 
to the low endstop.

3. Click the "Start" icon.
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Result
The actuator is moved in the selected direction. Time measurement will start once the actuator 
has reached the first endstop and will end when the actuator reaches this endstop for the 
second time. The motor transition time is equal to the time measured divided by two.

The progress and status of transition time measurement are displayed. The transition time 
measured is saved in the instance data block on the CPU and displayed in the "Measured 
transition time" field. When the transition time measurement is ended and 
ActivateRecoverMode = TRUE, PID_3Step switches to the operating mode from which the 
transition time measurement was started. If the transition time measurement is ended and 
ActivateRecoverMode = FALSE, PID_3Step changes to "Inactive" mode.

Cancelling transition time measurement
PID_3Step switches to "Inactive" mode if you cancel transition time measurement by pressing 
the Stop button.

11.1.4.3 PID_3Step V1

Configuring PID_3Step V1

Basic settings

Introduction
Configure the following properties of the "PID_3Step" technology object under "Basic settings" 
in the Inspector window or in the configuration window:

● Physical quantity

● Control logic

● Start-up behavior after reset

● Setpoint (only in the Inspector window)

● Process value (only in the Inspector window)

● Output value (only in the Inspector window)

● Position feedback (only in the Inspector window)
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Setpoint, process value, output value and position feedback
You can only configure the setpoint, process value, output value and position feedback in the 
Inspector window of the programming editor. Select the source for each value:

● Instance DB
The value saved in the instance DB is used.
Value must be updated in the instance DB by the user program.
There should be no value at the instruction.
Change via HMI possible.

● Instruction
The value connected to the instruction is used. 
The value is written to the instance DB each time the instruction is called.
No change via HMI possible.

Controller type

Physical quantity
Select the unit of measurement and physical quantity for the setpoint and process value in the 
"Controller type" group. The setpoint and process value will be displayed in this unit.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. 

PID_3Step does not work with negative proportional gain. Select the check box "Invert control 
logic" to reduce the process value with a higher output value.

Examples

● Opening the drain valve will reduce the level of a container's contents.

● Increasing cooling will reduce the temperature.

Start-up behavior after reset
To change straight to the last active mode after restarting the CPU, select the "Enable last 
mode after CPU restart" check box.

PID_3Step will remain in "Inactive" mode if the check box is cleared.
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Setpoint

Procedure
Proceed as follows to define a fixed setpoint:

1. Select "Instance DB".

2. Enter a setpoint, e.g. 80° C.

3. Delete any entry in the instruction.

Proceed as follows to define a variable setpoint:

1. Select "Instruction".

2. Enter the name of the REAL variable in which the setpoint is saved.
Program-controlled assignment of various values to the REAL variable is possible, for 
example for the time controlled change of the setpoint.

Process value
PID_3Step will scale the value of the analog input to the physical quantity if you use the analog 
input value directly.

You will need to write a program for processing if you wish first to process the analog input 
value. The process value is, for example, not directly proportional to the value at the analog 
input. The processed process value must be in floating point format. 

Procedure
Proceed as follows to use the analog input value without processing:

1. Select the entry "Input_PER" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the address of the analog input.

Proceed as follows to use the processed process value in floating point format:

1. Select the entry "Input" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the name of the variable in which the processed process value is saved.

Position feedback
Position feedback configuration depends upon the actuator used.

● Actuator without position feedback

● Actuator with digital endstop signals

● Actuator with analog position feedback

● Actuator with analog position feedback and endstop signals
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Actuator without position feedback 
Proceed as follows to configure PID_3Step for an actuator without position feedback:

1. Select the entry "No Feedback" in the drop-down list "Feedback".

Actuator with digital endstop signals 
Proceed as follows to configure PID_3Step for an actuator with endstop signals:

1. Select the entry "No Feedback" in the drop-down list "Feedback".

2. Activate the "Actuator endstop signals" check box.

3. Select "Instruction" as source for Actuator_H and Actuator_L.

4. Enter the addresses of the digital inputs for Actuator_H and Actuator_L.

Actuator with analog position feedback 
Proceed as follows to configure PID_3Step for an actuator with analog position feedback:

1. Select the entry "Feedback" or "Feedback_PER" in the drop-down list "Feedback".

– Use the analog input value for Feedback_PER. Configure Feedback_PER scaling in the 
actuator settings.

– Process the analog input value for Feedback using your user program.

2. Select "Instruction" as source.

3. Enter the address of the analog input or the variable of your user program.

Actuator with analog position feedback and endstop signals 
Proceed as follows to configure PID_3Step for an actuator with analog position feedback and 
endstop signals:

1. Select the entry "Feedback" or "Feedback_PER" in the drop-down list "Feedback".

2. Select "Instruction" as source.

3. Enter the address of the analog input or the variable of your user program.

4. Activate the "Actuator endstop signals" check box.

5. Select "Instruction" as source for Actuator_H and Actuator_L.

6. Enter the addresses of the digital inputs for Actuator_H and Actuator_L.
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Output value
PID_3Step offers an analog output value (Output_PER) and digital output values (Output_UP, 
Output_DN). Your actuator will determine which output value you use.

● Output_PER
The actuator is triggered via an analog output and controlled with a continuous signal, e.g. 
0...10V, 4...20mA.

● Output_UP, Output_DN
The actuator is controlled via two digital outputs.

Procedure
Proceed as follows to use the analog output value:

1. Select the entry "Output (analog)" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the analog output.

Proceed as follows to use the digital output value:

1. Select the entry "Output (digital)" in the drop-down list "Output".

2. Select "Instruction" for Output_UP and Output_DN.

3. Enter the addresses of the digital outputs.

Proceed as follows to process the output value using the user program:

1. Select the entry corresponding to the actuator in the drop-down list "Output".

2. Select "Instruction".

3. Enter the name of the variable you are using to process the output value.

4. Transfer the processed output value to the actuator by means of an analog or digital CPU 
output.

Process value settings
Configure the scaling of your process value and specify the process value absolute limits In 
the "Process value settings" configuration window.

Scaling the process value
If you have configured the use of Input_PER in the basic settings, you will need to convert the 
value of the analog input into the physical quantity of the process value. The current 
configuration will be displayed in the Input_PER display. 

Input_PER will be scaled using a low and high value pair if the process value is directly 
proportional to the value of the analog input.

1. Enter the low pair of values in the "Scaled low process value" and "Low" input fields.

2. Enter the high pair of values in the "Scaled high process value" and "High" input boxes.
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Default settings for the value pairs are saved in the hardware configuration. Proceed as follows 
to use the value pairs from the hardware configuration:

1. Select the instruction PID_3Step in the programming editor.

2. Connect Input_PER to an analog input in the basic settings.

3. Click on the "Automatic setting" button in the process value settings.
The existing values will be overwritten with the values from the hardware configuration.

Monitoring process value
Specify the absolute high and low limit of the process value. You must enter reasonable limits 
for your controlled system. Reasonable limits are important during optimization to obtain 
optimal PID parameters. The default for the "High limit process value" is 120 %. At the I/O 
input, the process value can be a maximum of 18% higher than the standard range (overrange). 
This setting ensures that an error is no longer signaled due to a violation of the "Process value 
high limit". Only a wire-break and a short-circuit are recognized and PID_3Step reacts 
according to the configured reaction to error.

 

 NOTICE

Your system may be damaged.

If you set very high process value limits (for example -3.4*1038...+3.4*1038), process value 
monitoring will be disabled. Your system may then be damaged if an error occurs. You need 
to configure useful process value limits for your controlled system.

 

Actuator settings

Actuator-specific times
Configure the motor transition time and the minimum ON and OFF times to prevent damage 
to the actuator. You can find the specifications in the actuator data sheet.

The motor transition time is the time in seconds the motor requires to move the actuator from 
the closed to the opened state. The maximum time that the actuator is moved in one direction 
is 110% of the motor transition time. You can measure the motor transition time during 
commissioning.

If you are using "Output_UP" or "Output_DN", you can reduce the switching frequency with 
the minimum on and minimum OFF time.

The on or off times calculated are totaled in automatic mode and only become effective when 
the sum is greater than or equal to the minimum on or OFF time.

A rising edge at Manual_UP or Manual_DN in manual mode will operate the actuator for at 
least the minimum on or OFF time.

Reaction to error
PID_3Step is preset so that the controller stays active in most cases in the event of an error. 
If errors occur frequently in controller mode, this default reaction has a negative effect on the 
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control response. In this case, check the Errorbits parameter and eliminate the cause of the 
error.

PID_3Step generates a programmable output value in response to an error:

● Current value
PID_3Step is switched off and no longer modifies the actuator position.

● Current value for error while error is pending
The controller functions of PID_3Step are switched off and the position of the actuator is 
no longer changed.
If the following errors occur in automatic mode, PID_3Step returns to automatic mode as 
soon as the errors are no longer pending.

– 0002h: Invalid value at Input_PER parameter.

– 0200h: Invalid value at Input parameter.

– 0800h: Sampling time error

– 1000h: Invalid value at Setpoint parameter.

– 2000h: Invalid value at Feedback_PER parameter.

– 4000h: Invalid value at Feedback parameter.

– 8000h: Error during digital position feedback.

If one of these error occurs in manual mode, PID_3Step remains in manual mode.
If an error occurs during the tuning or transition time measurement, PID_3Step is switched 
off.

● Substitute output value
PID_3Step moves the actuator to the substitute output value and then switches off.

● Substitute output value while error is pending
PID_3Step moves the actuator to the substitute output value. When the substitute output 
value is reached, PID_3Step reacts as it does with "Current value for while error is pending". 

Enter the substitute output value in "%". 

Only substitute output values 0% and 100% can be approached precisely in the case of 
actuators without analog position feedback. The actuator is moved in one direction at 110% 
of the motor transition time to ensure the high or low endstop is reached. There endstop signals 
take priority. A substitute output value not equal to 0% or 100% is approached via an internally 
simulated position feedback. This procedure does not, however, allow the exact approach of 
substitute output value. 

All substitute output values can be approached precisely with actuators with analog position 
feedback.

Scaling position feedback
If you have configured the use of Feedback_PER in the basic settings, you will need to convert 
the value of the analog input into %. The current configuration will be displayed in the 
"Feedback" display. 

Feedback_PER is scaled using a low and high value pair.
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1. Enter the low pair of values in the "Low endstop" and "Low" input boxes.

2. Enter the high pair of values in the "High endstop" and "High" input boxes.

"Low endstop" must be less than "High endstop"; "Low" must be less than "High".

The valid values for "High endstop" and "Low endstop" depend upon:

● No Feedback, Feedback, Feedback_PER

● Output (analog), Output (digital)

Output Feedback Low endstop High endstop
Output (digital) No Feedback Cannot be set (0.0%) Cannot be set (100.0%)
Output (digital) Feedback -100.0% or 0.0% 0.0% or +100.0%
Output (digital) Feedback_PER -100.0% or 0.0% 0.0% or +100.0%
Output (analog) No Feedback Cannot be set (0.0%) Cannot be set (100.0%)
Output (analog) Feedback -100.0% or 0.0% 0.0% or +100.0%
Output (analog) Feedback_PER -100.0% or 0.0% 0.0% or +100.0%

Limiting the output value
You can only exceed or undershoot the output value limits during the transition time 
measurement. The output value is limited to these values in all other modes. 

Enter the absolute output value limits in the "Output value high limit" and "Output value low 
limit" input boxes. The output value limits must be within "Low endstop" and "High endstop".

If no Feedback is available and Output (digital) is set, you cannot limit the output value. The 
digital outputs are reset with Actuator_H = TRUE or Actuator_L = TRUE, or after a travel time 
amounting to 110% of the motor transition time.

Advanced settings

Monitoring process value
Configure a warning high and low limit for the process value in the "Process value monitoring" 
configuration window. If one of the warning limits is exceeded or undershot during operation, 
a warning will be displayed at the PID_3Step instruction:

● At the InputWarning_H output parameter if the warning high limit has been exceeded

● At the InputWarning_L output parameter if the warning low limit has been undershot

The warning limits must be within the process value high and low limits. 

The process value high and low limits will be used if you do not enter values.

Example
Process value high limit = 98° C; warning high limit = 90° C 

Warning low limit = 10° C; process value low limit = 0° C
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PID_3Step will respond as follows:

Process value InputWarning_H InputWarning_L Operating mode
> 98° C TRUE FALSE Inactive
≤ 98° C and > 90° C TRUE FALSE Automatic mode
≤ 90° C and ≥ 10° C FALSE FALSE Automatic mode
< 10° C and ≥ 0° C FALSE TRUE Automatic mode
< 0° C FALSE TRUE Inactive

PID parameters
The PID parameters are displayed in the "PID Parameters" configuration window. The PID 
parameters will be adapted to your controlled system during controller tuning. You do not need 
to enter the PID parameters manually.

The PID algorithm operates according to the following equation:

Δ y  =  K
p 
 · s  ·  (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
Δy Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
TD Derivative action time
c Derivative action weighting

The diagram below illustrates the integration of the parameters into the PID algorithm:
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All PID parameters are retentive. If you enter the PID parameters manually, you must 
completely download PID_3Step. 

Auto-Hotspot 

Proportional gain
The value specifies the proportional gain of the controller. PID_3Step does not work with a 
negative proportional gain. Control logic is inverted under Basic settings > Controller type.

Integral action time
The integral action time determines the time behavior of the integral action. The integral action 
is deactivated with integral action time = 0.0.

Derivative action time
The derivative action time determines the time behavior of the derivative action. Derivative 
action is deactivated with derivative action time = 0.0.

Derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative action. 

Derivative delay = derivative action time × derivative delay coefficient

● 0.0: Derivative action is effective for one cycle only and therefore almost not effective.

● 0.5: This value has proved useful in practice for controlled systems with one dominant time 
constant.

● > 1.0: The greater the coefficient, the longer the effect of the derivative action is delayed.

Proportional action weighting
The proportional action may weaken with changes to the setpoint.
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Values from 0.0 to 1.0 are applicable.

● 1.0: Proportional action for setpoint change is fully effective

● 0.0: Proportional action for setpoint change is not effective

The proportional action is always fully effective when the process value is changed.

Derivative action weighting
The derivative action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Derivative action is fully effective upon setpoint change

● 0.0: Derivative action is not effective upon setpoint change

The derivative action is always fully effective when the process value is changed.

PID algorithm sampling time 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the PID_3Step sampling time. All other 
functions of PID_3Step are executed at every call.

Deadband width
The deadband suppresses the noise component in the steady controller state. The deadband 
width specifies the size of the deadband. The deadband is off if the deadband width is 0.0.

See also
Downloading technology objects to device (Page 5935)

Commissioning PID_3Step V1

Commissioning
You can monitor the setpoint, process value and output value over time in the "Tuning" working 
area. The following commissioning functions are supported in the curve plotter:

● Controller pretuning

● Controller fine tuning

● Monitoring the current closed-loop control in the trend view

All functions require an online connection to the CPU to have been established. 
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Basic handling
● Select the desired sampling time in the "Sampling time" drop-down list.

All values in the tuning working area are updated in the selected update time.

● Click the "Start" icon in the measuring group if you want to use the commissioning functions.
Value recording is started. The current values for the setpoint, process value and output 
value are entered in the trend view. Operation of the commissioning window is enabled.

● Click the "Stop" icon if you want to end the commissioning functions.
The values recorded in the trend view can continue to be analyzed.

● Closing the commissioning window will terminate recording in the trend view and delete 
the recorded values.

Pretuning
The pretuning determines the process response to a pulse of the output value and searches 
for the point of inflection. The tuned PID parameters are calculated as a function of the 
maximum slope and dead time of the controlled system.

The more stable the process value is, the easier it is to calculate the PID parameters and the 
more precise the result will be. Noise on the process value can be tolerated as long as the rate 
of rise of the process value is significantly higher compared to the noise. The PID parameters 
are backed up before being recalculated.

The setpoint is frozen during pretuning. 

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● PID_3Step is in "inactive" or "manual" mode.

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).
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Procedure
To perform pretuning, follow these steps:

1. Double-click the "PID_3Step > Commissioning" entry in the project tree.

2. Select the entry "Pretuning" in the "Tuning mode" drop-down list in the working area 
"Tuning".

3. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– Pretuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon when the progress bar has reached 100% and it is to be assumed 
the controller tuning function is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.

 

Result
If pretuning was performed without an error message, the PID parameters have been tuned. 
PID_3Step switches to automatic mode and uses the tuned parameters. The tuned PID 
parameters will be retained during power OFF and a restart of the CPU.

If pretuning is not possible, PID_3Step changes to "Inactive" mode. 

Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters 
are optimized for the operating point from the amplitude and frequency of this oscillation. All 
PID parameters are recalculated on the basis of the findings. PID parameters from fine tuning 
usually have better master control and disturbance behavior than PID parameters from 
pretuning.

PID_3Step automatically attempts to generate an oscillation greater than the noise of the 
process value. Fine tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before being recalculated.

The setpoint is frozen during fine tuning. 

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● The motor transition time has been configured or measured.

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).
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● The control loop has stabilized at the operating point. The operating point is reached when 
the process value corresponds to the setpoint.

● No disturbances are expected.

● PID_3Step is in inactive mode, automatic mode or manual mode.

Process depends on initial situation
Fine tuning proceeds as follows when started in:

● Automatic mode
Start fine tuning in automatic mode if you wish to improve the existing PID parameters using 
controller tuning.
PID_3Step will regulate using the existing PID parameters until the control loop has 
stabilized and the requirements for fine tuning have been met. Only then will fine tuning 
start.

● Inactive or manual mode
Pretuning is always started first. The PID parameters established will be used for 
adjustment until the control loop has stabilized and the requirements for fine tuning have 
been met. Only then will fine tuning start.

Procedure
Proceed as follows to carry out "fine tuning":

1. Select the entry "Fine tuning" in the "Tuning mode" drop-down list.

2. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– The process of fine tuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon in the "Tuning mode" group when the progress bar has reached 
100% and it is to be assumed the controller tuning function is blocked. Check the 
configuration of the technology object and, if necessary, restart controller tuning.

 

Result
The PID parameters will have been optimized if fine tuning has been executed without errors. 
PID_3Step changes to automatic mode and uses the optimized parameters. The optimized 
PID parameters will be retained during power OFF and a restart of the CPU. 

If errors occurred during fine tuning, PID_3Step will change to "inactive" mode.
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Commissioning with manual PID parameters

Procedure
Proceed as follows to commission PID_3Step with manual PID parameters:

1. Double-click on "PID_3Step > Configuration" in the project tree.

2. Click on "Advanced settings > PID Parameters" in the configuration window.

3. Select the check box "Enable direct input".

4. Enter the PID parameters.

5. Double-click on "PID_3Step > Commissioning" in the project tree.

6. Establish an online connection to the CPU.

7. Load the PID parameters to the CPU.

8. Click on the "Activate controller" icon.

Result
PID_3Step changes to automatic mode and controls using the current PID parameters.

Measuring the motor transition time

Introduction
PID_3Step requires the motor transition time to be as accurate as possible for good controller 
results. The data in the actuator documentation contains average values for this type of 
actuator. The value for the specific actuator used may differ.

You can measure the motor transition time during commissioning if you are using actuators 
with position feedback or endstop signals. The output value limits are not taken into 
consideration during the motor transition time measurement. The actuator can travel to the 
high or the low endstop.

The motor transition time cannot be measured if neither position feedback nor endstop signals 
are available.

Actuators with analog position feedback
Proceed as follows to measure motor transition time with position feedback:

Requirement

● Feedback or Feedback_PER has been selected in the basic settings and the signal has 
been connected.

● An online connection to the CPU has been established.
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1. Select the "Use position feedback" check box.

2. Enter the position to which the actuator is to be moved in the "Target position" input field.
The current position feedback (starting position) will be displayed. The difference between 
"Target position" and "Position feedback" must be at least 50% of the valid output value 
range.

3. Click the  "Start transition time measurement" icon.

Result
The actuator is moved from the starting position to the target position. Time measurement 
starts immediately and ends when the actuator reaches the target position. The motor transition 
time is calculated according to the following equation:

Motor transition time = (output value high limit – output value low limit) × Measuring time / 
AMOUNT (target position – starting position).

The progress and status of transition time measurement are displayed. The transition time 
measured is saved in the instance data block on the CPU and displayed in the "Measured 
transition time" field. PID_3Step will change to "Inactive" mode once transition time 
measurement is complete.

 

 Note

Click on the icon  "Upload measured transition time" to load the motor transition time 
measured to the project.

 

Actuators with endstop signals
Proceed as follows to measure the transition time of actuators with endstop signals:

Requirement

● The "Endstop signals" check box in the basic settings has been selected and Actuator_H 
and Actuator_L are connected.

● An online connection to the CPU has been established.

Proceed as follows to measure motor transition time with endstop signals:

1. Select the "Use actuator endstop signals" check box.

2. Select the direction in which the actuator is to be moved.

– Open - Close - Open
The actuator is moved first to the high endstop, then to the low endstop and then back 
to the high endstop.

– Close - Open - Close
The actuator is moved first to the low endstop, then to the high endstop and then back 
to the low endstop.

3. Click the  "Start transition time measurement" icon.
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Result
The actuator is moved in the selected direction. Time measurement will start once the actuator 
has reached the first endstop and will end when the actuator reaches this endstop for the 
second time. The motor transition time is equal to the time measured divided by two.

The progress and status of transition time measurement are displayed. The transition time 
measured is saved in the instance data block on the CPU and displayed in the "Measured 
transition time" field. PID_3Step will change to "Inactive" mode once transition time 
measurement is complete.

Cancelling transition time measurement
PID_3Step will change to "Inactive" mode immediately if you cancel transition time 
measurement. The actuator will stop being moved. You can reactive PID-3Step in the curve 
plotter. 
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11.2 Using S7-1200 Motion Control

11.2.1 Introduction

11.2.1.1 Motion functionality of the CPU S7-1200
The TIA Portal, together with the "Motion Control" functionality of the CPU S7‑1200, supports 
you in controlling stepper motors and servo motors with pulse interface:

● In the TIA Portal, you configure the "Axis" and "Command table" technology objects. The 
CPU S7-1200 controls the pulse and direction outputs for control of the drives using these 
technology objects.

● In the user program you control the axis by means of motion control instructions and initiate 
motion commands of your drive.

You can find a multi-media introduction on the Internet (http://www.automation.siemens.com/
mcms/topics/en/simatic/simatic-technology/integrated-functions/simatic-s7-1200/Pages/
Default.aspx).

See also
Hardware components for motion control (Page 6009)

Integration of the axis technology object (Page 6022)

Use of the command table technology object (Page 6050)

Command table technology object tools (Page 6050)
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11.2.1.2 Hardware components for motion control
The representation below shows the basic hardware configuration for a motion control 
application with the CPU S7-1200.  

S

CPU S7-1200:
CPU S7-1200 combines the functionality of a programmable logic controller with motion control 
functionality for operation of stepper motors and servo motors with pulse interface. The motion 
control functionality takes over the control and monitoring of the drives.    

The DC/DC/DC variants of the CPU S7-1200 have onboard outputs for direct control of drives. 
The relay variants of the CPU require one of the signal boards described below to control a 
drive.

Signal board
You add further inputs and outputs to the CPU with the signal boards. The digital outputs can 
be used as pulse and direction outputs for controlling drives as required.

In CPUs with relay outputs, the pulse signal cannot be output on the on-board outputs because 
the relays do not support the necessary switching frequencies. A signal board with digital 
outputs must be used to enable you to work with the PTO (Pulse Train Output) on these CPUs.
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When a DC/DC/DC variant of the CPU S7-1200 is used together with a signal board, the 
maximum number of controllable drives is limited to "2/4" (MLFB - order number 
xxxxxxx-1xx30-xxxx / xxxxxxx-1xx31-xxxx). 

PROFINET
Use the PROFINET interface to establish the online connection between the CPU S7-1200 
and the programming device. In addition to the online functions of the CPU, additional 
commissioning and diagnostic functions are available for motion control.

Maximum number of controllable drives
The maximum number of controllable drives for the various CPU versions is provided in the 
following table:  

CPU Signal board
 without DI2/DO2 x 

DC24V 
20kHz

DI2/DO2 x 
DC24V 
200kHz

DO4 x 
DC24V 
200kHz

DI2/DO2 x 
DC5V 
200kHz

DO4 x DC5V 
200kHz

CPU 1211C, CPU 
1212C, CPU 1214C
(MLFB - order number 
xxxxxxx-1xx30-xxxx)

DC/DC/
DC

2 2 2 2 2 2

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

CPU 1211C 
(MLFB - order number 
xxxxxxx-1xx31-xxxx)

DC/DC/
DC

2 3 3 4 3 4

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

CPU 1212C 
(MLFB - order number 
xxxxxxx-1xx31-xxxx)

DC/DC/
DC

3 4 4 4 4 4

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

CPU 1214C 
(MLFB - order number 
xxxxxxx-1xx31-xxxx)

DC/DC/
DC

4 4 4 4 4 4

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

CPU 1215C DC/DC/
DC

4 4 4 4 4 4

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2
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Limit frequencies of pulse outputs  
The following limit frequencies apply to the pulse outputs:

Pulse output Limit frequencies for technology object 
"Axis" V1.0

Limit frequencies for technology object 
"Axis" V2.0 and higher

On-board (MLFB - order number 
xxxxxxx-1xx30-xxxx)

2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 100 kHz

On-board (MLFB - order number 
xxxxxxx-1xx31xxxx)

2 Hz ≤ f ≤ 100 kHz (PTO 1+2)
2 Hz ≤ f ≤ 20 kHz (PTO 3+4)

2 Hz ≤ f ≤ 100 kHz (PTO 1+2)
2 Hz ≤ f ≤ 20 kHz (PTO 3+4)

Signal board DI2/DO2 x DC24V 20kHz 2 Hz ≤ f ≤ 20 kHz 2 Hz ≤ f ≤ 20 kHz
Signal board DI2/DO2 x DC24V 200kHz 2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 200 kHz
Signal board DO4 x DC24V 200kHz 2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 200 kHz
Signal board DI2/DO2 x DC5V 200kHz 2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 200 kHz
Signal board DO4 x DC5V 200kHz 2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 200 kHz

Ordering information
The order information listed below applies to the currently installed product phase (without any 
installed Hardware Support Packages) of the TIA Portal.

Name MLFB (order no.)
CPU 1211C DC/DC/DC 6ES7211-1Ax3x-0XB0
CPU 1211C AC/DC/RLY 6ES7211-1Bx3x-0XB0
CPU 1211C DC/DC/RLY 6ES7211-1Hx3x-0XB0
CPU 1212C DC/DC/DC 6ES7212-1Ax3x-0XB0
CPU 1212C AC/DC/RLY 6ES7212-1Bx3x-0XB0
CPU 1212C DC/DC/RLY 6ES7212-1Hx3x-0XB0
CPU 1214C DC/DC/DC 6ES7214-1Ax3x-0XB0
CPU 1214C AC/DC/RLY 6ES7214-1Bx3x-0XB0
CPU 1214C DC/DC/RLY 6ES7214-1Hx3x-0XB0
CPU 1215C DC/DC/DC 6ES7215-1AG31-0XB0
CPU 1215C AC/DC/RLY 6ES7215-1BG31-0XB0
CPU 1215C DC/DC/RLY 6ES7215-1HG31-0XB0
Signal board DI2/DO2 x DC24V 20kHz 6ES7223-0BD30-0XB0
Signal board DI2/DO2 x DC24V 200kHz 6ES7223-3BD30-0XB0
Signal board DO4 x DC24V 200kHz 6ES7222-1BD30-0XB0
Signal board DI2/DO2 x DC5V 200kHz 6ES7223-3AD30-0XB0
Signal board DO4 x DC5V 200kHz 6ES7222-1AD30-0XB0

Use a Hardware Support Package (HSP) to install new hardware components. The hardware 
component will then be available in the hardware catalog.
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See also
Motion functionality of the CPU S7-1200 (Page 6006)

CPU outputs relevant for motion control (Page 6012)

11.2.2 Basics for working with S7-1200 Motion Control

11.2.2.1 CPU outputs relevant for motion control

Pulse and direction output 
The CPU provides one pulse output and one direction output for controlling a stepper motor 
drive or a servo motor drive with pulse interface. The pulse output provides the drive with the 
pulses required for motor motion. The direction output controls the travel direction of the drive.

Pulse and direction outputs are permanently assigned to one another. Onboard CPU outputs 
or outputs of a signal board can be used as pulse and direction outputs. You select between 
onboard CPU outputs and outputs of the signal board during device configuration under Pulse 
generators (PTO/PWM) on the "Properties" tab.

The following table shows the address assignment of the pulse and direction outputs:

CPU S7-1200: Without signal board Signal boards
DI2/DO2 *)

Signal boards
DO4 **)

Outputs PTO1 Outputs PTO2 Outputs PTO1 Outputs PTO2 Outputs PTO1 Outputs PTO2
Pls. Dir. Pls. Dir. Pls. Dir. Pls. Dir. Pls. Dir. Pls. Dir.

CPU 1211C, 
CPU 1212C, 
CPU 1214C 
(DC/DC/DC)

Ax.0 Ax.1 Ax.2 Ax.3 Ax.0 Ax.1 Ax.2 Ax.3 Ax.0 Ax.1 Ax.2 Ax.3
Ay.0 Ay.1 Ay.0 Ay.1 Ay.2 Ay.3

CPU 1211C, 
CPU 1212C, 
CPU 1214C 
(AC/DC/RLY)

- - - - Ay.0 Ay.1 - - Ay.0 Ay.1 Ay.2 Ay.3

CPU 1211C, 
CPU 1212C, 
CPU 1214C 
(DC/DC/RLY)

- - - - Ay.0 Ay.1 - - Ay.0 Ay.1 Ay.2 Ay.3

x = Initial byte address of onboard CPU outputs (default value = 0)

y = Initial byte address of signal board outputs (default value = 4)

* If a DC/DC/DC CPU variant is used together with a DI2/DO2 signal board, the signals of the 
PTO1 can be generated via the onboard CPU outputs or via the signal board.

** If a DC/DC/DC CPU variant is used together with a DO4 signal board, the signals for PTO1 
and PTO2 can be generated via the onboard CPU outputs or via the signal board.
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Drive interface 
For motion control, you can optionally parameterize a drive interface for "Drive enabled" and 
"Drive ready". When using the drive interface the digital output for the drive enable and the 
digital input for "drive ready" can be freely selected.

 

 Note

The firmware will take control via the corresponding pulse and direction outputs if the PTO 
(Pulse Train Output) has been selected and assigned to an axis.

With this takeover of the control function, the connection between the process image and I/
O output is also disconnected. While the user has the possibility of writing the process image 
of pulse and direction outputs via the user program or watch table, this is not transferred to 
the I/O output. Accordingly, it is also not possible to monitor the I/O output via the user 
program or watch table. The information read reflects the value of the process image and 
does not match the real status of the I/O output.

For all other CPU outputs that are not used permanently by the CPU firmware, the status of 
the I/O output can be controlled or monitored via the process image, as usual.

 

 

See also
How the pulse interface works (Page 6013)

Relationship between the travel direction and voltage level at the direction output 
(Page 6015)

Hardware and software limit switches (Page 6016)

Jerk limit (Page 6017)

Homing (Page 6018)

Hardware components for motion control (Page 6007)

Integration of the axis technology object (Page 6022)

Tools of the axis technology object (Page 6024)

11.2.2.2 How the pulse interface works
Depending on the settings of the stepper motor, each pulse affects the movement of the 
stepper motor by a specific angle. If the stepper motor is set to 1000 pulses per revolution, for 
example, it moves 0.36° per pulse.

The speed of the stepper motor is determined by the number of pulses per time unit.
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(The statements made here also apply to servo motors with pulse interface.) 

See also
CPU outputs relevant for motion control (Page 6010)

Relationship between the travel direction and voltage level at the direction output 
(Page 6015)

Hardware and software limit switches (Page 6016)

Jerk limit (Page 6017)

Homing (Page 6018)

Integration of the axis technology object (Page 6022)

Tools of the axis technology object (Page 6024)
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11.2.2.3 Relationship between the travel direction and voltage level at the direction output
The direction output of the CPU specifies the travel direction of the drive. You configure the 
direction signal under "Mechanics" in the axis configuration. The relationships between 
configuration, direction output, and travel direction are presented in the following diagram:  

 

If "Invert direction signal" is deactivated in the configuration, a level of 5 V / 24 V will be output 
at the direction output for a positive travel direction (the voltage depends on the hardware 
used). A 0 V level will be output at the direction output for positive travel direction if "Invert 
direction signal" is activated in the configuration.
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See also
CPU outputs relevant for motion control (Page 6010)

How the pulse interface works (Page 6011)

Hardware and software limit switches (Page 6016)

Jerk limit (Page 6017)

Homing (Page 6018)

Integration of the axis technology object (Page 6022)

Tools of the axis technology object (Page 6024)

11.2.2.4 Hardware and software limit switches
Use the hardware and software limit switches to limit the "permitted traversing range" and the 
"working range" of your axis technology object. The relationships are shown in the following 
diagram: 

Hardware limit switches are limit switches that limit the maximum "permitted traversing range" 
of the axis. Hardware limit switches are physical switching elements that must be connected 
to interrupt-capable inputs of the CPU.

Software limit switches limit the "working range" of the axis. They should fall inside the 
hardware limit switches relative to the traversing range. Since the positions of the software 
limit switches can be flexibly set, the working range of the axis can be adapted on an individual 
basis, depending on the current traversing profile. In contrast to hardware limit switches, 
software limit switches are implemented exclusively via the software and do not require their 
own switching elements.

Hardware and software limit switches must be activated prior to use in the configuration or in 
the user program.. Software limit switches are only active after homing the axis.

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Comfort/Advanced V12.0 SP1
6014 System Manual, 07/2013,  



See also
CPU outputs relevant for motion control (Page 6010)

How the pulse interface works (Page 6011)

Relationship between the travel direction and voltage level at the direction output 
(Page 6013)

Jerk limit (Page 6017)

Homing (Page 6018)

Integration of the axis technology object (Page 6022)

Tools of the axis technology object (Page 6024)

Position limits (Page 6032)

11.2.2.5 Jerk limit
With the jerk limit you can reduce the stresses on your mechanics during an acceleration and 
deceleration ramp. The acceleration and deceleration value is not changed abruptly when the 
jerk limiter is active; it is gradually increased and decreased. The figure below shows the 
velocity and acceleration curve without and with jerk limit.  

Travel without jerk limit Travel with jerk limit

The jerk limit gives a "smoothed" velocity profile of the axis motion. This ensures soft starting 
and braking of a conveyor belt for example.
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See also
Behavior of the axis when using the jerk limit (Page 6041)

CPU outputs relevant for motion control (Page 6010)

How the pulse interface works (Page 6011)

Relationship between the travel direction and voltage level at the direction output 
(Page 6013)

Hardware and software limit switches (Page 6014)

Homing (Page 6018)

Integration of the axis technology object (Page 6022)

Tools of the axis technology object (Page 6024)

11.2.2.6 Homing
Homing means matching the axis coordinates of the technology object to the real, physical 
location of the drive. For position-controlled axes the entries and displays for the position refer 
exactly to these axis coordinates. Therefore, agreement between the axis coordinates and the 
real situation is extremely important. This step is necessary to ensure that the absolute target 
position of the axis is also achieved exactly with the drive. 

In the S7-1200 CPU, axis homing is implemented with the motion control instruction, 
"MC_Home". The following homing modes exist:

Homing modes
● Active homing

In active homing mode, the motion control instruction "MC_Home" performs the required 
reference point approach. When the homing switch is detected, the axis is homed according 
to the configuration. Active traversing motions are aborted.

● Passive homing
During passive homing, the motion control instruction "MC_Home" does not carry out any 
homing motion. The traversing motion required for this step must be implemented by the 
user via other motion control instructions. When the homing switch is detected, the axis is 
homed according to the configuration. Active traversing motions are not aborted upon start 
of passive homing.

● Direct homing absolute
The axis position is set regardless of the homing switch. Active traversing motions are not 
aborted. The value of input parameter "Position" of motion control instruction "MC_Home" 
is set immediately as the reference point of the axis.

● Direct homing relative
The axis position is set regardless of the homing switch. Active traversing motions are not 
aborted. The following statement applies to the axis position after homing:
New axis position = current axis position + value of parameter "Position" of instruction 
"MC_Home".
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See also
CPU outputs relevant for motion control (Page 6010)

How the pulse interface works (Page 6011)

Relationship between the travel direction and voltage level at the direction output 
(Page 6013)

Hardware and software limit switches (Page 6014)

Jerk limit (Page 6015)

Integration of the axis technology object (Page 6022)

Tools of the axis technology object (Page 6024)

Homing (technology object "Axis" as of V2.0) (Page 6043)

11.2.3 Guidelines on use of motion control
The guidelines described here present the basic procedure for using motion control with the 
CPU S7-1200.  

Requirements
To use the "Axis" technology object, you must create a project with a CPU S7-1200.

Procedure
Follow the steps below in the order given to use motion control with the CPU S7-1200. Use 
the following links for this purpose:

1. Add technological object Axis (Page 6026)

2. Working with the configuration dialog (Page 6027)

3. Download to CPU (Page 6068)

4. Function test of the axis in the commissioning window (Page 6069)

5. Programming (Page 6072)

6. Diagnostics of the axis control (Page 6091)

 

11.2.4 Overview of versions
The relationship between the relevant versions for S7-1200 Motion Control can be found in 
the following table:
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Technology version
You can check the technology version currently selected in Task Card Instructions > 
Technology > Motion Control > S7-1200 Motion Control and in the "Add new object" dialog. 
Select the technology version in Task Card Instructions > Technology > Motion Control > 
S7-1200 Motion Control. If a technology object with an alternative version is added in the "Add 
new object" dialog, the technology version will also be changed.

 

 Note

The selection of an alternative technology version will also affect the Motion Control 
Instructions version (task card). The technology objects and Motion Control instructions will 
only be converted to the selected version upon compilation or "Load to device".

 

Version of the technology object
The version of a technology object can be checked in the inspector window under "Properties 
> General > Information" in the "Version" field.

To change the version, select the relevant version in the task card under Instructions > 
Technology and then the menu command Edit > Compile. If a technology object with an 
alternative version is added in the "Add new object" dialog, the technology object version will 
also be changed.

Deal with the causes of any errors if error information is displayed during compilation. Repeat 
compilation until it can be completed without errors.

Check the configuration of the technology objects once you have done so.

Motion Control instruction version
Proceed as follows to check the version of a Motion Control instruction:

1. Open the Program blocks > System blocks > Program resources folders in the navigator 
and select the required Motion Control instruction.

2. Select the Edit > Properties menu command.

3. You will find the Motion Control instruction version in the Version field of the Information 
tab.

If the Motion Control instruction version used is not in line with the following compatibility list, 
the relevant Motion Control instructions will be highlighted in the program editor.
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Compatibility list

Technology CPU Technology object Motion Control Instruction
V1.0 V1.0, V2.0, V2.1, V2.2 Axis V1.0 MC_Power V1.0

MC_Reset V1.0
MC_Home V1.0
MC_Halt V1.0

MC_MoveAbsolute V1.0
MC_MoveRelative V1.0
MC_MoveVelocity V1.0

MC_MoveJog V1.0
V2.0 Innovations:

● Jerk control
● Command table
● MC_ChangeDynamic

V2.1, V2.2 Axis V2.0, Command 
table V2.0

MC_Power V2.0
MC_Reset V2.0
MC_Home V2.0
MC_Halt V2.0

MC_MoveAbsolute V2.0
MC_MoveRelative V2.0
MC_MoveVelocity V2.0

MC_MoveJog V2.0
MC_CommandTable V2.0
MC_ChangeDynamic V2.0

V3.0 Innovation:
Load in RUN operating 
mode

V2.2 Axis V3.0, Command 
table V3.0

MC_Power V3.0
MC_Reset V3.0
MC_Home V3.0
MC_Stop V3.0

MC_MoveAbsolute V3.0
MC_MoveRelative V3.0
MC_MoveVelocity V3.0

MC_MoveJog V3.0
MC_CommandTable V3.0
MC_ChangeDynamic V3.0
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11.2.5 Techology object axis

11.2.5.1 Integration of the axis technology object
The following representation shows the relations between the hardware and software 
components which are implemented when using the "Axis" technology object:   

S
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CPU hardware
The physical drive is controlled and monitored by the CPU hardware.

Drive
The drive represents the unit of power unit and motor. Stepper motors or servo motors with a 
pulse interface may be used.

Technology object "Axis"
The physical drive including mechanics is mapped in the TIA Portal as an "axis" technology 
object. Configure the "Axis" technology object with the following parameters for this:

● Selection of the PTOs (Pulse Train Output) to be used and configuration of the drive 
interface

● Parameter for mechanics and gear transmission of the drive (or the machine or system)

● Parameter for position monitoring, for dynamic parameters and for homing

The configuration of the "Axis" technology object is saved in the technology object (data block). 
This data block also forms the interface between the user program and the CPU firmware. The 
current axis data is saved in the data block of the technology object at the runtime of the user 
program.

User program
You start motion control instructions jobs in the CPU firmware with the user program. The 
following jobs for controlling the axis are possible:

● Position axis absolutely

● Position axis relatively

● Move axis with velocity set point

● Run axis jobs as movement sequence (as of technology V2.0)

● Move axis in jog mode

● Stop axis

● Reference axis; set reference point

● Acknowledge error

You determine the command parameters with the input parameters of the Motion Control 
instructions and the axis configuration. The output parameters of the instruction give you up 
to date information about the status and any errors of the command.

Before starting a command for the axis, you must enable the axis with the motion control 
instruction "MC_Power".

You can read out configuration data and current axis data with the tags of the technology 
object. You can change single, changeable tags of the technology object (e.g. the current 
acceleration) from the user program.
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CPU firmware
The motion control jobs started in the user program are processed in the CPU firmware. When 
using the axis control table, Motion Control jobs are triggered by operating the axis control 
table. The CPU firmware performs the following jobs depending on the configuration:

● Calculate the exact motion profile for motion jobs and emergency stop situations

● Control the drive enable and the pulse and direction signal

● Monitor the drive and the hardware and software limit switches

● Up to date feedback of status and error information to the motion control instructions in the 
user program

● Writing of current axis data into the data block of the technology object

 

See also
CPU outputs relevant for motion control (Page 6010)

Relationship between the travel direction and voltage level at the direction output 
(Page 6013)

Tools of the axis technology object (Page 6024)

Hardware and software limit switches (Page 6014)

Homing (Page 6016)

Tag of the Axis technology object (Page 6118)

11.2.5.2 Tools of the axis technology object
The TIA Portal provides the "Configuration", "Commissioning", and "Diagnostics" tools for the 
"Axis" technology object. The following representation shows the interaction of the three tools 
with the technology object and the drive:   
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① Reading and writing of configuration data of the technology object;
② Drive control via the technology object; Reading axis status for display on the control panel
③ Readout of the current status and error information of the technology object.

Configuration   
Use the "Configuration" tool to configure the following properties of the "Axis" technology object:

● Selection of the PTO to be used and configuration of the drive interface

● Properties of the mechanics and the transmission ratio of the drive (or machine or system)

● Properties for position monitoring, dynamics, and homing

Save the configuration in the data block of the technology object.
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Commissioning   
Use the "Commissioning" tool to test the function of your axis without having to create a user 
program. When the tool is started, the axis control table will be displayed. The following 
commands are available on the axis control table:

● Releasing and blocking the axis

● Move axis in jog mode

● Position axis in absolute and relative terms

● Home axis

● Acknowledge errors

The dynamic values can be adjusted accordingly for the motion commands. The axis control 
table also shows the current axis status.

Diagnostics   
Use the "Diagnostics" tool to keep track of the current status and error information for the axis 
and drive.

See also
CPU outputs relevant for motion control (Page 6010)

Relationship between the travel direction and voltage level at the direction output 
(Page 6013)

Integration of the axis technology object (Page 6020)

Hardware and software limit switches (Page 6014)

Homing (Page 6016)

Configuring the axis technoloogy object (Page 6027)

Commissioning the axis - Axis control panel (Page 6069)

Axis - Diagnostics (Page 6091)

11.2.5.3 Add technological object Axis
Proceed as follows to add an "Axis" technology object in the project tree:

Requirements
A project with a CPU S7-1200 has been created.

Procedure
1. Open the CPU folder in the project tree.

2. Open the technology objects folder.
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3. Double-click "Add new object". 
The "Add new object" dialog opens.

4. Select the "Motion" technology.

5. Open the "Motion Control" folder.

6. Open the "S7-1200 Motion Control" folder.

7. Click on the version and select an alternative version of the technology if you want to add 
an axis from an older version.

8. Select the "TO_Axis_PTO" object. 

9. Change the name of the axis in the "Name" input field to suit your needs.

10.Select the "Manual" option if you want to change the suggested data block number.

11.Click "More information" if you want to supplement user information for the technology 
object.

12.Click "OK" to add the technology object.
Click "Cancel" to discard your entries.

Result
The new technology object is created and saved to the "Technology objects" folder in the 
project tree.

 

See also
Guidelines on use of motion control (Page 6017)

11.2.5.4 Configuring the axis technoloogy object

Working with the configuration dialog
You configure the properties of the technology object in the configuration window. Proceed as 
follows to open the configuration window of the technology object:

1. Open the group of the required technology object in the project tree.

2. Double-click the "Configuration" object.

The configuration is divided into the following categories:

● Basic parameters 
The basic parameters contain all the parameters which must be configured for a functioning 
axis.

● Extended parameters 
The advanced parameters include parameters to adapt to your drive or your plant.
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Icons of the configuration window 
Icons in the area navigation of the configuration show additional details about the status of the 
configuration:

The configuration contains default values and is complete.
The configuration contains only default values. With these default values you can use the technology object without 
additional changes.
The configuration contains values set by the user and is complete.
All input fields of the configuration contain valid values and at least one preset value has changed.
The configuration is incomplete or incorrect
At least one input field or drop-down list contains an invalid value. The corresponding field or the drop-down list is 
displayed on a red background. Click the roll-out error message to indicate the cause of error.
The configuration is valid but contains warnings
Only one hardware limit switch is configured. Depending on the plant, the lacking configuration of a hardware limit switch 
may result in a hazard. The corresponding field or the drop-down list is displayed on a yellow background.

See also
Guidelines on use of motion control (Page 6017)

Basic parameters (Page 6028)

Extended parameters (Page 6030)

Basic parameters

Configuration - General
Configure the basic properties of the "Axis" technology object in the "General" configuration 
window.

Axis name:   
Define the name of the axis or the name of the "Axis" technology object in this box. The 
technology object is listed under this name in the project navigation.

Hardware interface   
The pulses are output to the power unit of the drive by fixed assigned digital outputs.
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In CPUs with relay outputs, the pulse signal cannot be output on these outputs because the 
relays do not support the necessary switching frequencies. A signal board with digital outputs 
must be used to enable you to work with the PTO (Pulse Train Output) on these CPUs.

 

 Note

The PTO requires the functionality of a fast counter (HSC) internally. The corresponding fast 
counter can therefore not be used elsewhere. The count can not be evaluated from its input 
address.

The assignment between PTO and HSC is fixed. When the user activates PTO1, it is 
connected to the HSC1. If the PTO2 is activated, this is connected with the HSC2.  

 

In the drop-down list "Pulse generator selection", select the PTO (Pulse Train Output) which 
are to provide the pulses for controlling the stepper motors or servo motors with a pulse 
interface. If the pulse generators and high-speed counters are not used elsewhere in the device 
configuration, the hardware interface can be configured automatically. In this case, the PTO 
selected in the drop-down list is displayed with a white background. The interfaces used will 
be listed in the "Output source", "Pulse output", "Direction output" and "Assigned fast counter" 
output fields.

Proceed as follows if you wish to change the interfaces or if the PTO could not be automatically 
configured (entry in the "Pulse generator selection" drop-down list is highlighted in red):

1. Click on the "Device configuration" button.
The pulse generator device configuration opens.
Enlarge the property window of the device configuration if the configuration of the pulse 
generator is not visible.

2. Select the "Enable this pulse generator" check box.
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3. Select the "Parameter assignment" entry in the block navigator.
The "Parameter assignment" opens.

4. In the "Pulse generator as:" dropdown list select the "PTO" entry.

5. In the "Output source:" dropdown list select the "Integrated CPU output" or "Signal board 
output" entry. The "Signal board output" entry can only be selected for PTO1 or for PTO1 
and PTO2 depending on the plugged signal board. For more detailed information, see 
chapter: CPU outputs relevant for motion control (Page 6010)

6. Go back to the axis configuration.
Unless the corresponding fast counter has already been used elsewhere, the PTO boxes 
of the "General" axis configuration are not shaded red. Correct the configuration based on 
the error messages if this is not the case.

User unit   
Select the desired unit for the dimension system of the axis in the dropdown list. The selected 
unit is used for the further configuration of the "Axis" technology object and for the display of 
the current axis data.

The values at the input parameters (Position, Distance, Velocity, ...) of the Motion Control 
instructions also refer to this unit.

 

 Note

Later changing of the dimension system may not be converted correctly in all the configuration 
windows of the technology object. In this case check the configuration of all axis parameters.

The values of the input parameters of the Motion Control instructions may have to be adapted 
to the new unit of measurement in the user program.

 

Extended parameters

Configuration - Drive interface
Configure the output for drive enable and the input for the "Drive ready" feedback signal of the 
drive in the "Drive signals" configuration window.  
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Drive enable is controlled by Motion Control instruction "MC_Power" and enables power to the 
drive. The signal is provided to the drive via the output to be configured.   

The drive signals "Drive ready" to the CPU if it is ready to start executing travel after receipt 
of drive enable. The "Drive ready" signal is reported back to the CPU via the input to be 
configured.  

If the drive does not have any interfaces of this type, you will not have to configure the 
parameters. In this case, select the value TRUE for the ready input.

See also
Configuration - Mechanics (Page 6031)

Position limits (Page 6032)

Dynamics (Page 6036)

Homing (technology object "Axis" as of V2.0) (Page 6043)

Configuration - Mechanics
Configure the mechanical properties of the drive in the "Mechanics" configuration window.  

Increments per motor revolution  
Configure the number of pulses required for one revolution of the motor in this field.

Limits (independent of the selected unit of measurement):

● 0 < Pulse per motor revolution ≤ 2147483647

Load distance per motor revolution  
In this field, configure the load distance per motor revolution covered by the mechanical system 
of your unit.

Limits (independent of the selected unit of measurement):

● 0.0 < Load distance per motor revolution ≤ 1.0e12

Invert direction signal  
You can adjust the direction output to the direction logic of the drive using the "Invert direction 
signal" check box.

● Invert direction signal: deactivated
0 V level = negative travel direction
5 V / 24 V level = positive travel direction (the actual voltage depends on the hardware used)

● Invert direction signal: activated
0 V level = positive travel direction
5 V / 24 V level = negative travel direction (the actual voltage depends on the hardware 
used)
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See also
Configuration - Drive interface (Page 6028)

Position limits (Page 6032)

Dynamics (Page 6036)

Homing (technology object "Axis" as of V2.0) (Page 6043)

Relationship between the travel direction and voltage level at the direction output 
(Page 6013)

Position limits

Requirements for hardware limit switches
Use only hardware limit switches that remain permanently switched after being approached. 
This switching status may only be revoked after a return to the valid travel range.

See also
Configuration - Position limits (Page 6032)

Behavior of axis when position limits is tripped (Page 6033)

Changing the position limits configuration in the user program (Page 6035)

Configuration - Position limits
Configure the hardware and software limit switches of the axis in the "Position limits" 
configuration window.

Enable hardware limit switch
Activate the function of the low and high hardware limit switch with this check box. The 
hardware limit switches can be used for purposes of direction reversal during a reference point 
approach. For details, refer to the configuration description for homing.

Low / high HW limit switch input
Select the digital input for the low or high hardware limit switch from the drop-down list. The 
input must be interrupt-capable. The digital onboard CPU inputs and the digital inputs of a 
plugged signal board can be selected as inputs for the HW limit switches.

 

 CAUTION

The digital inputs are set to a filter time of 6.4 ms by default. If these are used as hardware 
limit switches, undesired decelerations may occur. If this occurs, reduce the filter time for the 
relevant digital inputs.

The filter time can be set under "Input filter" in the device configuration of the digital inputs.
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Active level
In the drop-down list, select the signal level available at the CPU when the hardware limit 
switch is approached. 

● "Low level" selected
0 V (FALSE) at CPU input corresponds to hardware limit switch approached

● "High level" selected
5 V / 24 V (TRUE) at the CPU input = hardware limit switch approached (the actual voltage 
depends on the hardware used)
 

Enable software limit switch
Activate the function of the low and high software limit switch with this check box. 

 

 Note

The enabled software limit switch only affects a homed axis.
 

High and low software limit switch
Enter the position value of the low and high software limit switch in these boxes.

Limits (independent of the selected unit of measurement):

● -1.0e12 ≤ low software limit switch ≤ 1.0e12

● -1.0e12 ≤ high software limit switch ≤ 1.0e12

The value of the high software limit switch must be greater than or equal to the value of the 
low software limit switch.

See also
Requirements for hardware limit switches (Page 6030)

Behavior of axis when position limits is tripped (Page 6033)

Changing the position limits configuration in the user program (Page 6035)

Configuration - Homing - Active (Page 6045)

Behavior of axis when position limits is tripped

Behavior of axis when hardware limit switches are approached
When the hardware limit switches are approached, the axis brakes to a standstill at the 
configured emergency stop deceleration. The specified emergency stop deceleration must be 
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sufficient to reliably stop the axis before the mechanical stop. The following diagram presents 
the behavior of the axis after it approaches the hardware limit switches:

① The axis brakes to a standstill at the configured emergency stop deceleration. 
② Range in which the HW limit switches signal the status "approached".

The "HW limit switch approached" error is displayed in the motion control instruction to be 
initiated, in "MC_Power", and in the technology object tags. Instructions for eliminating errors 
can be found in the Appendix under "List of ErrorIDs and ErrorInfos".

Behavior of axis when software limit switches are reached
If software limit switches are activated, an active motion is stopped at the position of the 
software limit switch. The axis is braked at the configured deceleration. 

The following diagram presents the behavior of the axis until it reaches the software limit 
switches:
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① The axis brakes to a standstill at the configured deceleration.

 

The "SW limit switch reached" error is displayed in the motion control instruction to be initiated, 
in "MC_Power", and in the technology object tags. Instructions for eliminating errors can be 
found in the Appendix under "List of ErrorIDs and  ErrorInfos".

The circumstances under which the "SW limit switch exceeded" error is displayed can be 
obtained in the topics "Software limit switches in conjunction with a homing operation 
(Page 6102)" and "Software limit switches in conjunction with dynamic changes (Page 6107)". 

Use additional hardware limit switches if a mechanical endstop is located after the software 
limit switches and there is a risk of mechanical damage.

See also
Requirements for hardware limit switches (Page 6030)

Configuration - Position limits (Page 6030)

Changing the position limits configuration in the user program (Page 6035)

Changing the position limits configuration in the user program
You can change the following configuration parameters during user program runtime in the 
CPU:
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Hardware limit switches
You can also activate and deactivate the hardware limit switches during runtime of the user 
program. Use the following technology object tag for this purpose:

● <Axis name>.Config.PositionLimits_HW.Active

Please refer to the description of the technology object tags in the Appendix for information 
on when changes to the configuration parameter become effective.

Software limit switches
You can also activate and deactivate the software limit switches and change their position 
values during runtime of the user program. Use the following technology object tags for this 
purpose:

● <Axis name>.Config.PositionLimits_SW.Active
for activating and deactivating the software limit switches

● <Axis name>.Config.PositionLimits_SW.MinPosition
for changing the position of the low software limit switch

● <Axis name>.Config.PositionLimits_SW.MaxPosition
for changing the position of the high software limit switch

Refer to the description of technology object tags in the Appendix for information on when 
changes to the configuration parameters take effect.

 

See also
MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)

Requirements for hardware limit switches (Page 6030)

Configuration - Position limits (Page 6030)

Behavior of axis when position limits is tripped (Page 6031)

Dynamics

Configuration - General dynamics
Configure the maximum velocity, the start/stop velocity, the acceleration and deceleration and 
the jerk limit (as of technology object "Axis" V2.0) in the "General dynamics" configuration 
window.   

Velocity limiting unit   
Select the unit of measurement with which you want to set the velocity limits in the dropdown 
list. The unit set here depends on the unit of measurement set under "Configuration - General" 
and serves only for easier input.
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Maximum velocity / Start/stop velocity   
Define the maximum permissible velocity and the start/stop velocity of the axis in these boxes. 
The start/stop velocity is the minimum permissible velocity of the axis.

Limit values:

The limits indicated below refer to the "Pulses/s" unit of measurement:

● Technology object Axis V2.0

– 2 ≤ start/stop velocity ≤ 20000 (signal board 20kHz)
2 ≤ start/stop velocity ≤ 200000 (signal board 200kHz)
2 ≤ start/stop velocity ≤ 100000 (on-board CPU outputs)

– 2 ≤ maximum velocity ≤ 20000 (signal board 20kHz)
2 ≤ maximum velocity ≤ 200000 (signal board 200kHz)
2 ≤ maximum velocity ≤ 100000 (on-board CPU outputs)

● Technology object Axis V1.0

– 2 ≤ start/stop velocity ≤ 20000 (signal board 20kHz)
2 ≤ start/stop velocity ≤ 100000 (signal board 200kHz)
2 ≤ start/stop velocity ≤ 100000 (on-board CPU outputs)

– 2 ≤ maximum velocity ≤ 20000 (signal board 20kHz)
2 ≤ maximum velocity ≤ 100000 (signal board 200kHz)
2 ≤ maximum velocity ≤ 100000 (on-board CPU outputs)

The value of the maximum velocity must be greater or equal to the value of the start/stop 
velocity.

The limit values for other units of measurement must be converted by the user to conform to 
the given mechanics.

Acceleration / Delay - Ramp-up time / Ramp-down time         
Set the desired acceleration in the "Ramp-up time" or "Acceleration" boxes. The desired 
deceleration can be set in the "Deceleration time" or "Deceleration" boxes.

The relation between the ramp-up time and acceleration and the deceleration time and 
deceleration is shown in the following equations:

Rampup time  =
Maximum velocity  -  Start/stop velocity

Acceleration

 

Deceleration time =
Maximum velocity  -  Start/stop velocity

Deceleration

Motion jobs started in the user program are performed with the selected acceleration / 
deceleration. 

Limit values:

The limits indicated below refer to the "Pulses/s2" units of measurement: 
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● 0.28 ≤ acceleration ≤ 9.5e9

● 0.28 ≤ deceleration ≤ 9.5e9

The limits for other units of measurement must be converted to conform to the given mechanics.
 

 Note

Changes to the velocity limits ("start/stop velocity" and "maximum velocity") influence the 
acceleration and deceleration values of the axis. The ramp-up and deceleration times are 
retained.

 

Activate jerk limit (as of technology object Axis V2.0)   
Activate the jerk limit with this check box.

 

 Note

If an error occurs, the axis decelerates with the configured emergency stop deceleration. An 
activated jerk limit is not considered here.

 

Smoothing time/jerk (as of technology object "Axis" V2.0)   
You can input the parameters of the jerk limit in the "Smoothing time" field or alternatively in 
the "Jerk" field.

● Set the desired jerk for acceleration and deceleration ramp in the "Jerk" field.

● Set the desired smoothing time for the acceleration ramp in the "Rounding time" field.
 

  Note

The set smoothing time visible in the configuration only applies to the acceleration ramp.

If the values for acceleration and deceleration differ, the smoothing time of the deceleration 
ramp is calculated according to the jerk of the acceleration ramp and used. (See also 
Behavior of the axis when using the jerk limit (Page 6041)

The smoothing time of the deceleration is adapted as follows:
● Acceleration > deceleration

The smoothing time used for the deceleration ramp is shorter than that for the 
acceleration ramp.

● Acceleration < deceleration
The smoothing time used for the deceleration ramp is shorter than that for the 
acceleration ramp.

● Acceleration = deceleration
The smoothing times of the acceleration and deceleration ramp are equal.

 

The relation between smoothing times and jerk is shown in the following equation:
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Motion jobs started in the user program are performed with the selected jerk.

Limit values:

The limits indicated below refer to the Pulses/s3 units of measurement: 

● 0.04 ≤ jerk ≤ 1.5e8

The limits for other units of measurement must be converted to conform to the given mechanics.

 

See also
Behavior of the axis when using the jerk limit (Page 6041)

Configuration - Dynamics emergency stop (Page 6039)

Changing the configuration of dynamics in the user program (Page 6042)

Configuration - Dynamics emergency stop
Configure the emergency stop deceleration of the axis in the "Dynamics emergency stop" 
configuration window. When an error occurs and when the axis is disabled with motion control 
instruction "MC_Power" (input parameter StopMode = 0), the axis is brought to a standstill with 
this deceleration.  

Velocity limits
The velocity values configured in the "General dynamics" configuration window are once again 
displayed in this information area.

Deceleration
Set the deceleration value for emergency stop in the "Emergency stop deceleration" or 
"Emergency stop ramp-down time" field.

The relation between emergency stop deceleration time and emergency stop deceleration is 
shown in the following equation:

Emergency stop 

deceleration time =
Maximum velocity  -  Start/stop velocity

Emergency stop deceleration

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  6037



The specified emergency stop deceleration must be sufficient to bring the axis to a standstill 
in a timely manner in the event of an emergency (for example, when the hardware limit switch 
is approached prior to reaching the mechanical endstop).

The configured maximum velocity of the axis must be used as a basis for selecting the 
emergency stop deceleration.

Limit values:

The limits indicated below refer to the "Pulses/s2" units of measurement:

● 0.28 ≤ emergency stop deceleration ≤ 9.5e9

The limits for other units of measurement must be converted to conform to the given mechanics.

See also
Configuration - General dynamics (Page 6034)

Changing the configuration of dynamics in the user program (Page 6042)
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Behavior of the axis when using the jerk limit
Axis acceleration and deceleration is not stopped abruptly when the jerk limit is activated; it is 
adjusted gently according to the set step or rounding off time. The diagram below details the 
behavior of the axis with and without activated jerk limit:  

Without jerk limit With jerk limit

t Time axis
v Velocity
a Acceleration
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j Step
tru Rampup time
ta Time taken for the axis to accelerate
trd Deceleration time
td Time taken for the axis to decelerate
tju Smoothing time of the acceleration ramp
tjd Smoothing time of the deceleration ramp

 

The example shows travel in which the deceleration value ② is twice the acceleration value 
①. The resulting ramp-down time trd is therefore only half the length of the ramp-up time tru.

Acceleration ① and deceleration ② change abruptly without a jerk limit. Acceleration ① and 
deceleration ② change gradually with activated jerk limiter. As the jerk applies to entire motion, 
the rate is the same for the increase and decrease in acceleration and deceleration.

The step value j becomes infinitely high ⑤ as soon as the change is made without jerk limit. 
The step is limited to the configured value ⑥ when the jerk limit is activated.

The smoothing time tju given in the configuration applies to the acceleration ramp. The 
deceleration ramp smoothing time tju is calculated using the configured jerk value and the 
configured deceleration.

See also
Configuration - General dynamics (Page 6034)

Changing the configuration of dynamics in the user program
You can change the following configuration parameters during user program runtime in the 
CPU:  

Acceleration and deceleration
You can also change the values for acceleration and deceleration during runtime of the user 
program. Use the following technology object tags for this purpose:

● <Axis name>.Config.DynamicDefaults.Acceleration
for changing acceleration

● <Axis name>.Config.DynamicDefaults.Deceleration
for changing deceleration

Refer to the description of technology object tags in the Appendix for information on when 
changes to the configuration parameters take effect.
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Emergency stop deceleration
You can also change the value for the emergency stop deceleration during runtime of the user 
program. Use the following technology object tag for this purpose:

● <Axis name>.Config.DynamicDefaults.EmergencyDeceleration

Please refer to the description of the technology object tags in the Appendix for information 
on when changes to the configuration parameter become effective.

 

 WARNING

After changes to this parameter, it may be necessary to adapt the positions of the hardware 
limit switches and other safety-relevant settings.

 

Jerk limit (as of technology object "Axis" V2.0)
You can also activate and deactivate the jerk limit at runtime of the user program and change 
the value for the jerk. Use the following technology object tag for this purpose:

● <Axis name>.Config.DynamicDefaults.JerkActive
for activating and deactivating the jerk limit

● <Axis name>.Config.DynamicDefaults.Jerk
for changing the jerk

Please refer to the description of the technology object tags in the Appendix for information 
on when changes to the configuration parameter become effective.

 

See also
MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)

Configuration - General dynamics (Page 6034)

Configuration - Dynamics emergency stop (Page 6037)

Homing (technology object "Axis" as of V2.0)

Configuration - Homing - General
Configure the reference point switch input for active and passive homing in the "Homing - 
General" configuration window.
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Reference point switch input 
Select the digital input for the reference point switch from the drop-down list box. The input 
must be able to generate an interrupt. The onboard CPU inputs and inputs of an inserted signal 
board can be selected as inputs for the reference point switch.

 

 Note

The digital inputs are set to a filter time of 6.4 ms by default.

When the digital inputs are used as a reference point switch, this can result in undesired 
decelerations and thus inaccuracies. Depending on the homing velocity and extent of the 
reference point switch, the reference point may not be detected. The filter time can be set 
under "Input filter" in the device configuration of the digital inputs.

The specified filter time must be less than the duration of the input signal at the reference 
point switch.

 

See also
Sequence - Active homing (Page 6048)

Configuration - Homing - Passive
Configure the necessary parameters for passive homing in the "Homing - Passive" 
configuration window.   

The movement for passive homing must be triggered by the user (e.g. using an axis motion 
command). Passive homing is started using Motion Control instruction "MC_Home" with input 
parameter "Mode" = 2.

Side of the homing switch   
This is where you select whether the axis is to be homed on the low or high side of the homing 
switch.

Home position   
The position configured in the Motion Control instruction "MC_Home" is used as the home 
position.

 

 Note

If passive homing is carried out without an axis motion command (axis at a standstill), homing 
will be executed upon the next rising or falling edge at the homing switch.
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Configuration - Homing - Active
Configure the necessary parameters for active homing in the "Active homing" configuration 
window. Active homing is started using Motion Control instruction "MC_Home" with input 
parameter "Mode" = 3.  

Permit auto reverse at the hardware limit switch  
Activate the check box to use the hardware limit switch as a reversing cam for the home position 
approach. The hardware limit switches must be enabled for the reversal of direction (at least 
the hardware limit switch in the direction of approach must be configured).

If the hardware limit switch is reached during active homing, the axis brakes at the configured 
deceleration (not with the emergency stop deceleration) and reverses direction. The homing 
switch is then sensed in reverse direction.

If the direction reversal is not active and the axis reaches the hardware limit switch during 
active homing, the home position approach is aborted with an error and the axis is braked at 
the emergency stop deceleration.

 

 Note

If possible, use one of the following measures to ensure that the machine does not travel to 
a mechanical endstop in the event of a direction reversal:
● Keep the approach velocity low
● Increase the configured acceleration/deceleration
● Increase the distance between hardware limit switch and mechanical stop

 

Approach/homing direction  
With the direction selection, you determine the approach direction used during active homing 
to search for the homing switch, as well as the homing direction. The homing direction specifies 
the travel direction the axis uses to approach the configured side of the homing switch to carry 
out the homing operation.

Side of the homing switch  
This is where you select whether the axis is to be homed on the low or high side of the homing 
switch.

Velocity
In this field, specify the velocity at which the homing switch is to be searched for during the 
home position approach.

Limits (independent of the selected unit of measurement):
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● Start/stop velocity ≤ approach velocity ≤ maximum velocity

Homing velocity  
Specify in this field the velocity at which the homing switch is to be approached for homing.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ Homing velocity ≤ Maximum velocity

Home position offset  
If the desired home positione position deviates from the position of the homing switch, the 
home position offset can be specified in this field. 

If the value does not equal 0, the axis executes the following actions following homing at the 
homing switch:

1. Move the axis at the homing velocity by the value of the home position offset

2. Upon reaching the "Home position offset", the axis is at the home position that was specified 
in input parameter "Position" of the "MC_Home" Motion Control instruction.

Limits (independent of the selected unit of measurement):

● -1.0e12 ≤ home position offset ≤ 1.0e12

Home position  
The position configured in the Motion Control instruction "MC_Home" is used as the home 
position.

 

Sequence - Passive homing
Passive homing is started with Motion Control instruction "MC_Home" (input parameter 
Mode  = 2). Input parameter "Position" specifies the absolute reference point position.   

The diagram below shows an example of a characteristic curve for passive homing with the 
following configuration parameters:
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● "Reference point switch side" = "High side"

Movement towards reference point switch (red section of curve)
The Motion Control instruction "MC_Home" does not itself carry out any homing motion when 
passive homing is started. The travel required for reaching the reference point switch must be 
implemented by the user via other motion control instructions such as "MC_MoveRelative". 
The tag <axis name>.StatusBits.HomingDone remains TRUE during passive homing if the 
axis has already been homed. 

Axis homing (transition from red to green section of curve)
The axis is homed when the configured side of the reference point switch is reached. The 
current position of the axis is set to the reference point position. This is specified at the 
"Position" parameter of the "MC_Home" Motion Control instruction. The variable <axis 
name>.StatusBits.HomingDone will be set to "TRUE" if the axis has not been been homed 
before. The travel previously started is not cancelled.

Movement beyond reference point switch (green section of curve)
Following homing at the reference point switch, the axis continues and completes the 
previously started travel with the corrected axis position.
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Sequence - Active homing
You start active homing with motion control instruction "MC_Home" (input parameter 
Mode = 3). The "Position" input parameter specifies the absolute home position. Alternatively, 
you can start active homing on the axis command table for test purposes. 

The diagram below shows an example of a characteristic curve for an active reference point 
approach with the following configuration parameters:

● "Approach/homing direction" = "Positive direction"

● "Side of the homing switch" = "Top side"

● Value of "home position offset" > 0

Search for homing switch (blue curve section)
When active homing starts, the axis accelerates to the configured "approach velocity" and 
searches at this velocity for the homing switch. The tag <axis name>.StatusBits.HomingDone 
is set to FALSE.

Reference point approach (red curve section)
When the homing switch is detected, the axis in this example brakes and reverses, to be homed 
to the configured side of the homing switch at the configured homing velocity. Homing causes 
the tag <axis name>.StatusBits.HomingDone to change to TRUE.

Travel to home position offset (green curve segment)
After homing, the axis moves at the homing velocity along the path to the home position offset. 
There the axis is at the homing point position that was specified in input parameter "Position" 
of the "MC_Home" Motion Control instruction.
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See also
Configuration - Homing - General (Page 6041)

Changing the homing configuration in the user program
You can change the following configuration parameters in the CPU during user program 
runtime as of technology object "Axis" V2.0: 

Passive homing
You can change the side of the homing switch for passive homing during the user program 
runtime. Use the following technology object tag for this purpose:

● <Axis name>.Config.Homing.SidePassiveHoming
for changing the side of the homing switch

Please refer to the description of the technology object tags in the Appendix for information 
on when changes to the configuration parameter become effective.

Active homing
You can change the direction of approach, the side of the homing switch, the approach velocity, 
the homing velocity, and the home position offset for active homing during the program runtime 
of the user program. Use the following technology object tags for this purpose:

● <Axis name>.Config.Homing.AutoReversal 
for changing "auto reverse at the HW limit switch"

● <Axis name>.Config.Homing.Direction 
for changing "approach / homing direction"

● <Axis name>.Config.Homing.SideActiveHoming 
for changing the "side of the homing switch"

● <Axis name>.Config.Homing.FastVelocity 
for changing the "velocity"

● <Axis name>.Config.Homing.SlowVelocity 
for changing the "homing velocity"

● <Axis name>.Config.Homing.Offset 
for changing "home position offset"

Please refer to the description of the technology object tags in the Appendix for information 
on when changes to the configuration parameter become effective.

See also
MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)
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11.2.6 Technology object command table

11.2.6.1 Use of the command table technology object
The Motion Control instruction "Command table" allows you to combine multiple individual axis 
control jobs in one movement sequence. The technology object can be used for technology 
as of Version V2.0.  

You configure the movement sequence as a table in a configuration dialog.

The motion profile of the movement sequences can be checked on a graph before the project 
is loaded to the CPU. The command tables created are then linked to an axis and used in the 
user program with the "MC_CommandTable" Motion Control instruction. You can process part 
or all of the command table.

11.2.6.2 Command table technology object tools
The "Configuration" tool is provided in the TIA Portal for the "Command Table" technology 
object. The representation below shows the interaction of the tool with the technology 
object:  

① Writing and reading the configuration of the technology object

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Comfort/Advanced V12.0 SP1
6048 System Manual, 07/2013,  



Configuration
Configure the following properties of the "Command Table" technology object with the 
"Configuration" tool:

● You can create one or more movement sequences by configuring individual jobs.

● You can configure the graphic display to check your movement sequence using an axis 
already configured or a configurable default axis.

The movement sequence data are saved in the data block of the technology object. 

11.2.6.3 Adding the technological object command table
Proceed as follows to add a "Command table" technology object in the project tree:

Prerequisites
● A project with a CPU S7-1200 has been created.

● The CPU firmware version is V2.1 or higher

Procedure
1. Open the CPU folder in the project tree.

2. Open the technology objects folder.

3. Double-click "Add new object". 
The "Add new object" dialog opens.

4. Select the "Motion" technology.

5. Open the "Motion Control" folder.

6. Open the "S7-1200 Motion Control" folder

7. Select the version "V2.0" of the "S7-1200 Motion Control" folder (click on the entry for the 
version).

8. Select the "TO_CommandTable" object.

9. Change the name of the command table in the "Name" input field to suit your needs.

10.Select the "Manual" option if you want to change the suggested data block number.

11.Click "More information" if you want to supplement user information for the technology 
object.

12.Click "OK" to add the technology object.
Click "Cancel" to discard your entries.

Result
The new technology object is created and saved to the "Technology objects" folder in the 
project tree.
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11.2.6.4 Configuring the command table technology object

Working with the configuration dialog
You configure the properties of the technology object in the configuration window. Proceed as 
follows to open the configuration window of the technology object:

1. Open the group of the required technology object in the project tree.

2. Double-click the "Configuration" object.

The configuration is divided into the following categories:

● Basic parameters 
The basic parameters contain all parameters which must be configured for a functional 
command table.

● Extended parameters 
The extended parameters contain the parameters of the default axis or display the 
parameter values of the axis selected.

Icons of the configuration window  
Icons in the area navigation of the configuration show additional details about the status of the 
configuration:

The configuration contains default values and is complete.
The configuration contains only default values. With these default values, you can use the technology object without 
additional changes.
The configuration contains values set by the user and is complete.
All input fields of the configuration contain valid values and at least one preset value has changed.
The configuration is incomplete or incorrect
At least one input field or drop-down list contains an invalid value. The corresponding field or the drop-down list is 
displayed on a red background. Click the roll-out error message to display the cause of the error.
The configuration contains mutually incompatible parameter values
The configuration contains parameter values that contradict each other either in size or logic. The corresponding field 
or the drop-down list is displayed on a yellow background.

See also
Guidelines on use of motion control (Page 6017)

Basic parameters (Page 6052)

Extended parameters (Page 6065)

Basic parameters

Configuration - General
Configure the name of the technology object in the "General" configuration window. 
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Name
Define the name of the command table or the name of the "Command table" technology object 
in this field. The technology object will be listed under this name in the project tree.

See also
Configuration - Command table (Page 6053)

Shortcut menu commands - Command table (Page 6056)

Working with the trend diagram (Page 6058)

Shortcut menu commands - Curve chart (Page 6062)

Transition from "Complete command" to "Blend motion" (Page 6063)

Changing the command table configuration in the user program (Page 6064)

Configuration - Command table
Create the desired movement sequence in the "Command Table" configuration window and 
check the result against the graphic view in the trend diagram.   

 

 Note

Small deviations are possible between the time behavior and position in the trend shown and 
the real movement of the axis. Movements in response to software limit switches being 
reached are not shown.

 

Activate warnings   
Activate the display of warnings in the command table with this checkbox.

Use axis parameters of   
From the drop-down list, select which axis parameters are to be used for selecting the graphic 
view of and checking the movement sequence. Select "Default axis" if you have yet to add an 
axis to the "Technology object" folder or wish to use value which have not been configured in 
any of the available axes. You configure the properties of the default axis under "Advanced 
parameters".

The axis parameters of the axis selected at the "Axis" parameter are used to process the 
command table in the user program.

Column: Step
Shows the step number of the command.
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Column: Command type   
In this column, select the command types which are to be used for processing the command 
table. Up to 32 commands can be entered. The commands will be processed in sequence. 
You can choose between the following entries and command types:

● Empty
The entry serves as a placeholder for any commands to be added. The empty entry is 
ignored when the command table is processed.

● Halt
Stop axis 
(the command only takes effect after a "Velocity set point" command)

● Positioning Relative
Position axis relatively

● Positioning Absolute
Position axis absolutely

● Velocity set point
Move axis at set velocity

● Wait
Waits until the given period is over. Wait does not stop an active traversing motion.

● Separator
Adds a Separator line above the selected line. The Separator line acts as a range limit for 
the graphic display of the trend view. 
Use the Separator lines if you wish to process parts of the command table.

Column: Position   
Enter the position or travel path for the selected command in this column:

● Command "Positioning Relative"
The command will move the axis by the the given travel path.

● Command "Positioning Absolute"
The command will move the axis by the the given position.

● Separator
The value given specifies the start position for the graphic display.

Limit values (independent of the selected user unit):

● -1.0e12 ≤ position / distance ≤ -1.0e-12

● 1.0e-12 ≤ position / distance ≤ 1.0e12

● Position / travel path = 0.0
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Column: Velocity   
In this column, you enter the velocity for the selected command:

● Command "Positioning Relative"
The command will move the axis at the the given velocity.
The given velocity will not be reached if the travel path selected is not large enough.

● Command "Positioning Absolute"
The command will move the axis at the the given velocity.
The given velocity will not be reached if the target position is too close to the starting position.

● Command " Velocity set point"
The command will move the axis at the the given velocity.
The given velocity will not be reached during the command if too short a runtime is selected.

Limit values (independent of the selected user unit):

● For the commands: "Positioning Relative" and "Positioning Absolute"

– 1.0e-12 ≤ velocity ≤ 1.0e12

● For the command: "Velocity set point"

– -1.0e12 ≤ velocity ≤ -1.0e-12

– 1.0e-12 ≤ velocity ≤ 1.0e12

– Velocity = 0.0

Column: Duration   
Enter the duration of the selected command in this column:

● Command " Velocity set point"
The command will move the axis for the specified duration. The duration includes both the 
acceleration phase and the constant travel phase. The next command will be processed 
once the duration is over.

● Command "Wait"
Waits until the given duration is over.

Limit values (independent of the selected user unit):
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● 0.001s ≤ duration ≤ 64800s

Column: Next step   
Select the mode of transition to the next step from the drop-down list:

● Complete command
The command will be completed. The next command will be processed immediately.

● Blend motion
The motion of the current command will be blended with the motion of the following 
command. The transition mode "Blend motion" is available with command types 
"Positioning Relative" and "Positioning Absolute".
Motion will be blended with motions of the following command types:

– Positioning Relative

– Positioning Absolute

– Velocity set point

No blending occurs with other command types.

For the exact behavior of the axis when a command is appended or overlapped, see: Transition 
from "Complete command" to "Blend motion" (Page 6063) 

Column: Step code   
Enter a numerical value / bit pattern in this column which is to be output at the "StepCode" 
output parameter of the "MC_CommandTable" Motion Control instruction while the command 
is being processed.

Limit values:

● 0 ≤ code number ≤ 65535

 

See also
Configuration - General (Page 6050)

Shortcut menu commands - Command table (Page 6056)

Working with the trend diagram (Page 6058)

Shortcut menu commands - Curve chart (Page 6062)

Transition from "Complete command" to "Blend motion" (Page 6063)

Changing the command table configuration in the user program (Page 6064)

Shortcut menu commands - Command table
The following shortcut menu commands are available in the command table:   

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Comfort/Advanced V12.0 SP1
6054 System Manual, 07/2013,  



Insert empty line  
Adds an empty line above the selected line.

This shortcut menu command can only be executed if there are enough empty lines at the end 
of the command table.

Add empty line  
Adds an empty line below the selected line.

This shortcut menu command can only be executed if there are enough empty lines at the end 
of the command table.

Insert separator line  
Adds a separator line above the selected line.

You cannot have two consecutive separator lines.

Add separator line  
Adds a separator line below the selected line.

You cannot have two consecutive separator lines, nor can you add a separator line at the end 
of the command table.

Cut
Removes the selected lines or content of the selected cell and saves them/it in the clipboard.

Selected lines will be deleted and the subsequent lines of the command table shifted up.

Copy
Copies the selected lines or content of the selected cell and saves them/it in the clipboard.

Paste
● Selected lines:

Pastes the lines from the clipboard into the table above the selected line.

● Selected cell:
Pastes the content of the clipboard into the selected line.

This shortcut menu command can only be executed if there are enough empty lines at the end 
of the command table.

Replace
Replaces the selected lines with the lines in the clipboard.
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Delete
Deletes the selected lines. The lines below in the command table shift up.

 

See also
Configuration - General (Page 6050)

Configuration - Command table (Page 6051)

Working with the trend diagram (Page 6058)

Shortcut menu commands - Curve chart (Page 6062)

Transition from "Complete command" to "Blend motion" (Page 6063)

Changing the command table configuration in the user program (Page 6064)

Working with the trend diagram
 

 

Trend view and components
 

 

① Trend view
② Position curve
③ Velocity curve 
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④ Curve section of a selected command
⑤ Ruler
⑥ Ruler position marking
⑦ Software limit switch position
⑧ Start/stop velocity
⑨ Position axis scale range
⑩ Time axis scale range
⑪ Velocity axis scale range
⑫ Scroll bar, position axis
⑬ Scroll bar time axis
⑭ Scroll bar, velocity axis
⑮ Selecting the grid

Selecting separator sections
If the command table consists of multiple sections separated by separators, you can select 
these sections in the trend view by selecting a command in the section.

Selecting commands
Commands can be selected in the trend view and in the command table:

● Click on a point on the velocity or position curve in the trend view. The corresponding 
command will be highlighted in the command table.

● Select a command in the command table.
The corresponding section of curve will be highlighted.

Selecting the visible range of the trend view
Follow the steps below to adjust the section of the trend view to be displayed:

Select the scaling in the shortcut menu:

● Scale to curves:
Scales the axes so the position and velocity curves are visible.

● Scale to curves and limits:
Scales the axes so the position and velocity curves, the positions of the activated software 
limit switches and the minimum and maximum velocity limits are visible.

The view selected will be marked in the shortcut menu with a tick.

 

Selecting the section to be shown within the range:
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① Range which the curve values and / or limits are within. (see Selecting in the shortcut menu)
② Selected range to be shown in the trend window.

You set the range with the margin cursor at the right-hand and left-hand margin.

You set the position within range ① with the drag cursor.

You can also define the position by clicking in range ①.

 

Selecting the section to be shown with the mouse:

Drag a section of the trend view by clicking and dragging with the mouse. The section of curve 
selected will be enlarged once you release the mouse.
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Undoing the last change to the section:

Select the shortcut command "Undo zoom" to undo the last change to the section.

Synchronizing the grid
Click on the axis scales to select whether the grid is to be synchronized with the position axis 
or velocity axis.

Reading off curve values from the ruler
Activate the ruler using the shortcut menu command "Show ruler". 

You can move the ruler to any point on the curves using the ruler cursor.
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See also
Configuration - General (Page 6050)

Configuration - Command table (Page 6051)

Shortcut menu commands - Command table (Page 6054)

Shortcut menu commands - Curve chart (Page 6062)

Transition from "Complete command" to "Blend motion" (Page 6063)

Changing the command table configuration in the user program (Page 6064)

Shortcut menu commands - Curve chart
The following shortcut menu commands are available in the curve window:

Zoom 100%
Selects a zoom factor which will show 100% of the curve values and / or limits.

Undo zoom
Undoes the last zoom change.

Scale to curves
Scales the axes so the position and velocity curves are visible.

Scale to curves and limits
Scales the axes so the position and velocity curves, the positions of the activated software 
limit switches and the minimum and maximum velocity limits are visible.

Show velocity limits
Shows the lines of the velocity limits.

Show software limit switches
Shows the lines of the software limit switches.

Show ruler
Fades the ruler in / out

Use the ruler when you want to see the individual values of the curves.
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See also
Configuration - General (Page 6050)

Configuration - Command table (Page 6051)

Shortcut menu commands - Command table (Page 6054)

Working with the trend diagram (Page 6056)

Transition from "Complete command" to "Blend motion" (Page 6063)

Changing the command table configuration in the user program (Page 6064)

Transition from "Complete command" to "Blend motion"
The charts below show the transition between movements in various different transition modes 
in the "Next step" column:

Motion transition with preceding positioning jobs

Complete job Blend motion
Transition from lower to higher velocity

A job with high velocity is appended to a previous positioning 
job. The positioning job terminates at its target position at 
velocity "0". The second job starts from standstill.

Transition from lower to higher velocity

A job with high velocity is overlapped with a previous 
positioning job. The first positioning job terminates without 
standstill at its target position. The second job starts with the 
new velocity.

Transition from higher to lower velocity

A job with low velocity is appended to a previous positioning 
job. The positioning job terminates at its target position at 
velocity "0". The second job starts from standstill.

Transition from higher to lower velocity

A job with low velocity is overlapped with a previous 
positioning job. The first positioning job terminates without 
standstill at its target position. The first job starts with the new 
velocity.
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1. Job "Positioning Relative" or "Positioning Absolute"

2. Job "Velocity set point"
2. Job "Positioning Relative" or "Positioning Absolute"

Motion transition with preceding velocity jobs

Transition from lower to higher velocity

A job with a high velocity is appended to a previous velocity 
job. The first velocity job ends after the defined runtime. The 
second job starts with the new velocity.

Transition from higher to lower velocity

A job with low velocity is blended with a previous velocity job. 
The second job starts with the new velocity.

1. job "Velocity set point"

2. Job "Velocity set point"
2. Job "Positioning Relative" or "Positioning Absolute"

See also
Configuration - General (Page 6050)

Configuration - Command table (Page 6051)

Shortcut menu commands - Command table (Page 6054)

Working with the trend diagram (Page 6056)

Shortcut menu commands - Curve chart (Page 6060)

Changing the command table configuration in the user program (Page 6064)

Changing the command table configuration in the user program
You can change the following configuration parameters during user program runtime in the 
CPU:
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Jobs and corresponding values
You can also change the parameters of the command table during the runtime of the user 
program. Use the following technology object variables for this purpose:

● <Table name>.Config.Commands[1..32].Command
for changing the command type

● <Table name>.Config.Commands[1..32].Position
for changing the position / travel path

● <Table name>.Config.Commands[1..32].Velocity
for changing the velocity

● <Table name>.Config.Commands[1..32].Duration
for changing the duration

● <Table name>.Config.Commands[1..32].BufferMode
for changing the parameter "Next step"

● <Table name>.Config.Commands[1..32].Code
for changing the step code

Refer to the description of technology object variables in the Appendix for information on when 
changes to the configuration parameters take effect.

See also
Configuration - General (Page 6050)

Configuration - Command table (Page 6051)

Shortcut menu commands - Command table (Page 6054)

Working with the trend diagram (Page 6056)

Shortcut menu commands - Curve chart (Page 6060)

Transition from "Complete command" to "Blend motion" (Page 6061)

Extended parameters

Chart parameters

Configuration - General
Configure the basic properties of the chart view of the "Command table" technology object in 
the "General" configuration window.

 

 Note

If the default axis has been selected under "Use axis parameters of", the unit of measurement 
can be edited. If a configured axis has been selected, the unit of measurement for this axis 
will be displayed.
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Use axis parameters of
From the drop-down list, select which axis parameters are to be used for selecting the graphic 
view of and checking the movement sequence. Select "Default axis" if you have yet to add an 
axis to the "Technology object" folder or wish to use values which have not been configured 
in any of the available axes.

The axis parameters of the axis selected at the "Axis" parameter will be used to process the 
command table in the user program.

Unit of measurement
Enter the unit of measurement for the default axis in this field. If a preconfigured axis has been 
selected under "Use axis parameters of", the unit of measurement configured in these 
parameter will be displayed.

Configuration - Dynamics
Configure the acceleration and deceleration and the jerk limit for the default axis in the 
"Dynamics" configuration window.

 

 Note

If the default axis has been selected under "Use axis parameters of", the following fields can 
be edited. If a configured axis has been selected, the values of this axis will be displayed.

 

Acceleration / deceleration
Set the desired acceleration of the default axis in the "Acceleration" field. The desired 
deceleration can be set in the "Deceleration" field.

Motion jobs configured in the command table will be calculated with the selected acceleration / 
deceleration.

Limit values:

● 1.0e-12 ≤ acceleration ≤ 1.0e12

● 1.0e-12 ≤ deceleration ≤ 1.0e12

Activate jerk limit
Activate the jerk limit with this checkbox.

Step
Set the desired step for ramping up and ramping down in the "Step" field.

Motion jobs configured in the command table will be calculated with the selected step.

Limit values:
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● 1.0e-12 ≤ jerk ≤ 1.0e12

Configuration - Limit values
Configure the maximum velocity, the start/stop velocity and the software limit switches of the 
default axis in the "Limits" configuration window.

 

 Note

If the default axis has been selected under "Use axis parameters of", the following fields can 
be edited. If a configured axis has been selected, the values of this axis will be displayed.

 

Maximum velocity / Start/stop velocity
Define the maximum permissible velocity and the start/stop velocity of the default axis in these 
fields. The start/stop velocity is the minimum permissible velocity of the default axis.

Limit values:

● 1.0e-12 ≤ start/stop velocity ≤ 1.0e12
Start/stop velocity = 0.0

● 1.0e-12 ≤ maximum velocity ≤ 1.0e12
Maximum velocity = 0.0

The value of the maximum velocity must be greater or equal to the value of the start/stop 
velocity.

Enable software limit switches
Activate the function of the low and high software limit switch with this checkbox. Movements 
in response to software limit switches being reached are not shown in the trend view.

Low / high software limit switch
Enter the position value of the low and high software limit switches in these fields.

Limits:

● -1.0e12 ≤ low software limit switch ≤ -1.0e-12
1.0e-12 ≤ low software limit switch ≤ 1.0e12
Low software limit switch = 0.0

● -1.0e12 ≤ high software limit switch ≤ -1.0e-12
1.0e-12 ≤ high software limit switch ≤ 1.0e12
High software limit switch = 0.0

The value of the high software limit switch must be greater than or equal to the value of the 
low software limit switch.
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11.2.7 Download to CPU
When loading to the CPU S7-1200 always ensure that the project files are consistent after the 
online and offline loading. It is not possible to load single blocks. When selecting single blocks, 
all new and modified blocks are always loaded.

The following object groups can be loaded to the CPU:

Context menu command
"Download to device"

Description

All Download all new and modified blocks and a new or modified hardware configuration
Hardware configuration Download a new or modified hardware configuration
Software Download all new and modified blocks
Software (all blocks) Download all blocks

The data of the Motion Control technology objects are saved in the data blocks. The conditions 
for downloading of "blocks" thus apply when loading a new or modified technology object.

 

 CAUTION

Possible malfunctions of the axis when loading without hardware configuration

The hardware configuration is modified when the following modifications are made to the axis 
configuration:
● Modification of the pulse generator (PTO)
● Modification of the HW limit switch address
● Modification of the homing switch address

If the modified configuration of the axis is loaded with the context menu commands "Software" 
or "Software (all blocks)" without downloading the hardware configuration, this can lead to 
malfunctions of the axis.

Ensure that the current hardware configuration is downloaded to the CPU under the 
conditions listed below.

 

Download in CPU S7-1200 RUN operating mode (from firmware version V2.2)
For CPU S7-1200 from firmware version V2.2, when loading in CPU RUN operating mode it 
is checked whether it is possible to load without stopping the CPU.

The following conditions apply when loading data blocks in RUN operating mode:

 Download to load memory Download to work memory
Data block modified values Yes No
Data block modified structure No No
New data block Yes Yes
Data block deleted Yes Yes

From technology version V3.0, Motion Control technology objects (data blocks) can also be 
downloaded in CPU RUN operating mode. 
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Technology objects after V3.0 cannot be downloaded in CPU RUN operating mode.

Select one of the actions described below to download the modified version of a Motion Control 
technology object (from version V3.0) to the work memory:

● Technology object axis and command table
Change the CPU operating mode from STOP to RUN.

● Technology object axis
Disable the axis and execute a "Restart" using the Motion Control instruction "MC_Reset".

● Technology object command table
Ensure that the command table is not being used. Download the data block of the command 
table to the work memory using the extended instruction "READ_DBL".

 

 Note

In contrast to downloading in STOP operating mode, no actual parameters are overwritten 
in RUN operating mode. Modifications to the actual parameters only take place at the next 
change of operating mode from STOP to RUN.

 

 

See also
Guidelines on use of motion control (Page 6017)

MC_Reset: Acknowledge error (Page 2561)

11.2.8 Commissioning the axis - Axis control panel
Use the axis command table to move the axis in manual mode, to optimize the axis settings, 
and to test your system.

The axis control table can only be used if an online connection to the CPU is established.
 

 Note
Response times of the axis control panel

The response time during axis control table operation depends on the communication load 
of the CPU. Close all other online windows of the TIA Portal to minimize the response time.

 

"Manual control" button
Click "Manual control" to move the axis in manual control mode. Start by disabling the axis in 
the user program using motion control instruction "MC_Power". In "Manual control" mode, the 
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axis control table takes over control priority for the axis functions. The user program has no 
influence on the axis functions until manual control is ended.

 

 WARNING

The Manual control is active for one axis only. A second axis could be moved in Automatic 
mode, but this would bring about a dangerous situation.

In this case, set the second axis out of operation.
 

"Automatic mode" button
Click "Automatic mode" to end the "Manual control" mode. The axis control table passes back 
the control priority and the axis can be controlled by the user program again. The axis must 
be re-enabled in the user program and homed, if required.

Complete all active traversing motions before switching to automatic control; otherwise, the 
axis will be braked with the emergency stop deceleration.

"Enable" button
Click "Enable" to enable the axis in "Manual control" mode. When the axis is enabled, the axis 
control panel functions can be used.

If the axis cannot be enabled because certain conditions are not met, note the error message 
in the "Error message" field. Information on eliminating errors is available in the Appendix under 
"List of ErrorIDs and ErrorInfos". After the error has been corrected, enable the axis again.

"Disable" button
Click "Disable" if you want to temporarily disable the axis in "Manual control" mode.
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"Command" area
Operation in the "Command" area is only possible if the axis is enabled. You can select one 
of the following command inputs:

● Jogging
This command is equivalent to motion control command "MC_MoveJog" in the user 
program.

● Positioning
This command is equivalent to the motion control jobs "MC_MoveAbsolute" and 
"MC_MoveRelative" in the user program. The axis must be homed for absolute positioning.

● Homing
This command is equivalent to motion control command "MC_Home" in the user program.

– The "Set reference point" button corresponds to Mode = 0 (direct homing absolute)

– The "Active homing" button corresponds to Mode = 3 (active homing)

For active homing, the homing switch must be configured in the axis configuration. 
The values for approach velocity, homing velocity, and reference position offset are taken 
from the axis configuration unchanged.

Depending on the selection, the relevant fields for entry of setpoints and the buttons for starting 
the command are displayed.

"Axis status" area
If "Manual control" mode is activated, the current axis status and drive status are shown in the 
"Axis status" area. The current position and velocity of the axis are displayed at "Process 
values".

Click "Acknowledge" to acknowledge all cleared errors.

The "Info message" field displays advanced information about the status of the axis.
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Error message
The "Error message" field shows the current error. In "Manual control" mode, the error entry 
can be deleted by pressing the "Acknowledge" button once the error is eliminated.

 

 Note
Initial values for velocity, acceleration / deceleration and jerk

For safety reasons, the "Velocity", "Acceleration/deceleration" and "Jerk" parameters are 
initialized with values equivalent to only 10% of the configured values when the axis command 
table is activated. The "Jerk" parameter is only used for technology object "Axis" V2.0 and 
higher.

The values in the configuration view displayed when you select 
"Extended parameters > Dynamics > General" are used for initialization. 

The "Velocity" parameter on the control panel is derived from the "Maximum velocity" and 
the "Acceleration/deceleration" parameters from "Acceleration" in the configuration.

The "Velocity", "Acceleration/deceleration" and "Jerk" parameters can be changed in the axis 
command table; this does not affect the values in the configuration.

 

 

 

See also
Guidelines on use of motion control (Page 6017)

Working with watch tables (Page 6094)

11.2.9 Programming

11.2.9.1 Overview of the Motion Control statements
You control the axis with the user program using motion control instructions. The instructions 
start Motion Control jobs that execute the desired functions.

The status of the motion control jobs and any errors that occur during their execution can be 
obtained from the output parameters of the Motion Control instructions. The following Motion 
Control instructions are available:

● MC_Power: Enable, disable axis (Page 2556)

● MC_Reset: Acknowledge error (Page 2561)

● MC_Home: Home axes, set home position  (Page 2562)

● MC_Halt: Halt axis (Page 2566)

● MC_MoveAbsolute: Absolute positioning of axes (Page 2569)

● MC_MoveRelative: Relative positioning of axes (Page 2572)

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Comfort/Advanced V12.0 SP1
6070 System Manual, 07/2013,  



● MC_MoveVelocity: Move axes at preset rotational speed (Page 2576)

● MC_MoveJog: Move axes in jogging mode (Page 2580)

● MC_CommandTable: Run axis jobs as movement sequence (as of technology object "Axis" 
V2.0) (Page 2584)

● MC_ChangeDynamic: Changing the dynamic settings for the axis (as of technology object 
"Axis" V2.0) (Page 2586)

 

See also
Creating a user program (Page 6073)

Programming notes (Page 6076)

Behavior of the Motion Control commands after POWER OFF and restart (Page 6078)

Monitoring active commands (Page 6078)

Error displays of the Motion Control statements (Page 6090)

11.2.9.2 Creating a user program
In the section below you learn how to create a user program with the basic configuration for 
controlling your axis. All available axis functions are controlled using the Motion Control 
instructions to be inserted.

Requirement
● The technology object has been created and configured without errors.

Before creating and testing the user program, it is advisable to test the function of the axis and 
the corresponding parts of the system with the axis command table.

Procedure
Proceed as follows to create the user program in accordance with the principles described 
below:

1. In the project tree, double-click your code block (the code block must be called in the cyclic 
program).
The code block is opened in the programming editor and all available instructions are 
displayed.

2. Open the "Technology" category and the "Motion Control" and "S7-1200 Motion Control" 
folders.

3. Use a drag-and-drop operation to move the "MC_Power" instruction to the desired network 
of the code block.
The dialog box for defining the instance DB opens.
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4. In the next dialog box, select from the following alternatives:
Single instance
Click "Single instance" and select whether you want to define the name and number of the 
instance DB automatically or manually.
Multi-instance
Click "Multi-instance" and select whether you want to define the name of the multi-instance 
automatically or manually.

5. Click "OK".
The Motion Control instruction "MC_Power" is inserted into the network.

Parameters marked with "<???>" must be initialized; all other parameters are assigned 
default values.
Parameters displayed in black are required for use of the Motion Control instruction.
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6. Select technology object in the project tree and drag-and-drop it on <???>.

Following selection of the technology object data block, the following buttons are available:

Click the stethoscope icon if you want to open the diagnostics dialog for the technology 
object.

Click the toolbox icon if you want to open the configuration view of the technology object.

Click the arrow down icon to view additional parameters of the Motion Control instruction.

The grayed-out parameters now visible can be used optionally.

7. Add your choice of Motion Control instructions in accordance with steps 3 to 6.

Result
You have created the basic configuration for axis control in the user program.
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Initialize the input parameters of Motion Control instructions in other parts of the user program 
to initiate the desired jobs for the "Axis" technology object.

Evaluate the output parameters of the Motion Control instructions and the tags of the data 
block to track the initiated jobs and the status of the axis.

Refer to the detailed description for details on the parameters of Motion Control instructions.

See also
Overview of the Motion Control statements (Page 6070)

Programming notes (Page 6076)

Behavior of the Motion Control commands after POWER OFF and restart (Page 6078)

Monitoring active commands (Page 6078)

Error displays of the Motion Control statements (Page 6090)

11.2.9.3 Programming notes
When creating your user program, note the following information:

● Cyclic call of utilized motion control instructions
The current status of command execution is available via the output parameters of the 
motion control instruction. The status is updated with every call of the motion control 
instruction. Therefore, make sure that the utilized motion control instructions are called 
cyclically.

● Transfer of parameter values of a motion control instruction
The parameter values pending for the input parameters are transferred with a positive edge 
at input parameter "Execute" when the block is called.
The motion control command is started with these parameter values. Parameter values 
that are subsequently changed for the motion control instruction are not transferred until 
the next start of the motion control command.
Exceptions to this are input parameters "StopMode" of motion control instruction 
"MC_Power" and "Velocity" of motion control instruction "MC_MoveJog". A change in the 
input parameter is also applied when "Enable" = TRUE, or "JogForward" and 
"JogBackward". .
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● Programming under consideration of the status information
In a stepwise execution of motion control jobs, make sure to wait for the active command 
to finish before starting a new command. Use the status messages of the motion control 
instruction and the "StatusBits" tag of the technology object to check for completion of the 
active command.
In the examples below, observe the indicated sequence. Failure to observe the sequence 
will display an axis or command error.

– Axis enable with motion control instruction "MC_Power"
You must enable the axis before it can take on motion jobs. Use an AND operation of 
tag <Axis name>.StatusBits.Enable = TRUE with output parameter Status = TRUE  of 
motion control instruction "MC_Power" to verify that the axis is enabled.

– Acknowledge error with motion control instruction "MC_Reset"
Prior to starting a motion control command, errors requiring acknowledgement must be 
acknowledged with "MC_Reset". Eliminate the cause of the error and acknowledge the 
error with motion control instruction "MC_Reset". Verify that the error has been 
successfully acknowledged before initiating a new command. For this purpose, use an 
AND operation of tag <Axis name>.StatusBits.Error = FALSE with output parameter 
Done = TRUE  of motion control instruction "MC_Reset".

– Home axis with motion control instruction "MC_Home"
Before you can start an MC_MoveAbsolute command, the axis must be homed. Use an 
AND operation of tag <Axis name>.StatusBits.HomingDone = TRUE with output 
parameter Done = TRUE  of motion control instruction "MC_Home" to verify that the 
axis has been homed.

● Override of motion control command processing
Motion control jobs for moving an axis can also be executed as overriding jobs.
If a new motion control command is started for an axis while another motion control 
command is active, the active command is overridden by the new command before the 
existing command is completely executed. The overridden command signals this using 
CommandAborted = TRUE in the motion control instruction. It is possible to override an 
active MC_MoveRelative command with a MC_MoveAbsolute command.

● Avoiding multiple use of the same instance
All relevant information of a motion control command is stored in its instance.
Do not start a new command using this instance, if you want to track the status of the current 
command. Use different instances if you want to track the commands separately. If the 
same instance is used for multiple motion control commands, the status and error 
information of the individual commands will overwrite each other. 

● Call of motion control instructions in different priority classes (run levels)
Motion Control instructions with the same instance may not be called in different priority 
classes without interlocking. To learn how to call locked motion control instructions, refer 
to "Tracking commands from higher priority classes (run levels) (Page 6100)".
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See also
Overview of the Motion Control statements (Page 6070)

Creating a user program (Page 6071)

Behavior of the Motion Control commands after POWER OFF and restart (Page 6078)

Monitoring active commands (Page 6078)

Error displays of the Motion Control statements (Page 6090)

Tracking jobs from higher priority classes (execution levels) (Page 6100)

11.2.9.4 Behavior of the Motion Control commands after POWER OFF and restart
A POWER OFF or CPU-STOP aborts all active motion control jobs. All CPU outputs, including 
pulse and direction outputs, are reset.

After a subsequent POWER ON or CPU restart (CPU RUN), the technology objects and the 
motion control jobs will be reinitialized. 

All actual data of the technology objects as well as all status and error information of the 
previously active motion control jobs are reset to their initial values. 

Before the axis can be reused, it must be enabled again using the Motion Control instruction 
"MC_Power". If homing is required, the axis must be homed again with Motion Control 
instruction "MC_Home".

See also
Overview of the Motion Control statements (Page 6070)

Creating a user program (Page 6071)

Programming notes (Page 6074)

Monitoring active commands (Page 6078)

Error displays of the Motion Control statements (Page 6090)

11.2.9.5 Monitoring active commands

Monitoring active commands
There are three typical groups for tracking active motion control jobs:

● Motion control instructions with output parameter "Done"

● Motion control instruction "MC_MoveVelocity"

● Motion control instruction "MC_MoveJog"
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Motion control instructions with "Done" output parameter 
Motion control instructions with the output parameter "Done" are started via input parameter 
"Execute" and have a defined conclusion (for example, with Motion Control instruction 
"MC_Home": Homing was successful). The command is complete and the axis is at a standstill. 

The commands of the following Motion Control instructions have a defined conclusion:

● MC_Reset

● MC_Home

● MC_Halt

● MC_MoveAbsolute

● MC_MoveRelative

● MC_CommandTable (as of technology object V2.0)

● MC_ChangeDynamic (as of technology object V2.0)

The output parameter "Done" indicates the value TRUE, if the command has been successfully 
completed.

The output parameters "Busy", "CommandAborted", and "Error" signal that the command is 
still being processed, has been aborted or an error is pending. The Motion Control instruction 
"MC_Reset" cannot be aborted and thus has no "CommandAborted" output parameter. The 
Motion Control instruction "MC_ChangeDynamic" is completed immediately and therefore has 
no "Busy" or "CommandAborted" output parameters.

During processing of the motion control command, the output parameter "Busy" indicates the 
value TRUE. If the command has been completed, aborted, or stopped by an error, the output 
parameter "Busy" changes its value to FALSE. This change occurs regardless of the signal at 
input parameter "Execute". 

Output parameters "Done", "CommandAborted", and "Error" indicate the value TRUE for at 
least one cycle. These status messages are latched while input parameter "Execute" is set to 
TRUE.

The behavior of the status bits is presented below for various example situations:
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Complete execution of command
If the motion control command has been completely executed by the time of its conclusion, 
this is indicated by the value TRUE in output parameter "Done". The signal status of input 
parameter "Execute" influences the display duration in the output parameter "Done":

"Execute" changes its value to FALSE during processing of 
the command

"Execute" changes its value to FALSE after completion of the 
command

 

① The command is started with a positive edge at the input parameter "Execute". Depending on the programming, 
"Execute" can still be reset to the value FALSE during the command, or the value TRUE can be retained until after 
completion of the command.

② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ With conclusion of the command (for example, for Motion Control instruction "MC_Home": Homing was successful), 

output parameter "Busy" changes to FALSE and "Done" to TRUE.
④ If "Execute" retains the value TRUE until after completion of the command, then "Done" also remains TRUE and changes 

its value to FALSE together with "Execute".
⑤ If "Execute" has been set to FALSE before the command is complete, "Done" indicates the value TRUE for only one 

execution cycle.
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Abort command
If the motion control command is aborted during execution, this is indicated by the value TRUE 
in output parameter "CommandAborted". The signal status of the input parameter "Execute" 
influences the display duration in the output parameter "CommandAborted":

"Execute" changes its value to FALSE before the command 
is aborted.

"Execute" changes its value to FALSE after the command is 
aborted.

Abort Abort

 

① The command is started with a positive edge at the input parameter "Execute". Depending on the programming, 
"Execute" can still be reset to the value FALSE during the command, or the value TRUE can be retained until after 
completion of the command.

② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ During command execution, the command is aborted by another motion control command. If the command is aborted, 

output parameter "Busy" changes to FALSE and "CommandAborted" to TRUE.
④ If "Execute" retains the value TRUE until after the command is aborted, then "CommandAborted" also remains TRUE 

and changes its value to FALSE together with "Execute".
⑤ If "Execute" has been set to FALSE before the command is aborted, "CommandAborted" indicates the value TRUE for 

only one execution cycle.
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Error during command execution
If an error occurs during execution of the motion control command, this is indicated by the 
value TRUE in the output parameter "Error". The signal status of the input parameter "Execute" 
influences the display duration in the output parameter "Error":

"Execute" changes its value to FALSE before the error occurs "Execute" changes its value to FALSE after the error occurs
Error Error

 

① The command is started with a positive edge at the input parameter "Execute". Depending on the programming, 
"Execute" can still be reset to the value FALSE during the command, or the value TRUE can be retained until after 
completion of the command.

② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ An error occurred during command execution. When the error occurs, the output parameter "Busy" changes to FALSE 

and "Error" to TRUE.
④ If "Execute" retains the value TRUE until after the error occurs, then "Error" also remains TRUE and only changes its 

value to FALSE together with "Execute".
⑤ If "Execute" has been set to FALSE before the error occurs, "Error" indicates the value TRUE for only one execution 

cycle.

Motion control instruction MC_MoveVelocity
The jobs of Motion Control instruction "MC_MoveVelocity" do not have a defined end. The job 
objective is fulfilled when the parameterized velocity is reached for the first time and the axis 
travels at constant velocity. When the parameterized velocity is reached, this is indicated by 
the value TRUE in output parameter "InVelocity". 

The job is complete when the parameterized velocity has been reached and input parameter 
"Execute" has been set to the value FALSE. However, the axis motion is not yet complete 
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upon completion of the job. For example, the axis motion can be stopped with motion control 
job "MC_Halt".

The output parameters "Busy", "CommandAborted", and "Error" signal that the job is still being 
processed, has been aborted or an error is pending.

During execution of the motion control job, output parameter "Busy" indicates the value TRUE. 
If the job has been completed, aborted, or stopped by an error, the output parameter "Busy" 
changes its value to FALSE. This change occurs regardless of the signal at input parameter 
"Execute".

The output parameters "InVelocity", "CommandAborted", and "Error" indicate the value TRUE 
for at least one cycle, when their conditions are met. These status messages are latched while 
input parameter "Execute" is set to TRUE.

The behavior of the status bits is presented below for various example situations:

The parameterized velocity is reached
If the motion control job has been executed by the time the parameterized velocity is reached, 
this is indicated by the value TRUE in output parameter "InVelocity". 

The signal status of the input parameter "Execute" influences the display duration in the output 
parameter "InVelocity":

"Execute" changes its value to FALSE before the 
parameterized velocity is reached

"Execute" changes its value to FALSE after the 
parameterized velocity is reached
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① The job is started with a positive edge at the input parameter "Execute". Depending on the programming, "Execute" can 
be reset to the value FALSE event before the parameterized velocity is reached, or alternatively only after it has been 
reached.

② While the job is active, the output parameter "Busy" indicates the value TRUE.
③ When the parameterized velocity is reached, the output parameter "InVelocity" changes to TRUE.
④ If "Execute" retains the value TRUE even after the parameterized velocity has been reached, the job remains active. 

"InVelocity" and "Busy" retain the value TRUE and only change their status to FALSE together with "Execute".
⑤ If "Execute" has been reset to FALSE before the parameterized velocity is reached, the job is complete when the 

parameterized velocity is reached. "InVelocity" indicates the value TRUE for one execution cycle and changes to FALSE 
together with "Busy".

The job is aborted prior to reaching the parameterized velocity
If the motion control job is aborted before the parameterized velocity is reached, this is indicated 
by the value TRUE in output parameter "CommandAborted". The signal status of input 
parameter "Execute" influences the display duration in output parameter "CommandAborted".

"Execute" changes its value to FALSE before the job is 
aborted.

"Execute" changes its value to FALSE after the job is aborted.

Abort Abort

 

① The job is started with a positive edge at the input parameter "Execute". Depending on the programming, "Execute" can 
still be reset to the value FALSE during the job, or the value TRUE can be retained until after the job is aborted.

② While the job is active, the output parameter "Busy" indicates the value TRUE.
③ During job execution, the job is aborted by another motion control job. If the job is aborted, output parameter "Busy" 

changes to FALSE and "CommandAborted" to TRUE.
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④ If "Execute" retains the value TRUE until after the job is aborted, then "CommandAborted" also remains TRUE and 
changes its status to FALSE together with "Execute".

⑤ If "Execute" has been reset to FALSE before the job is aborted, "CommandAborted" indicates the value TRUE for only 
one execution cycle.

 
 

 Note

Under the following conditions, an abort is not indicated in output parameter 
"CommandAborted": 

The parameterized velocity has been reached, input parameter "Execute" has the value 
FALSE, and a new motion control job is initiated.

When the parameterized velocity is reached and input parameter "Execute" has the value 
FALSE, the job is complete. Therefore, the start of a new job is not indicated as an abort.

 

 

An error has occurred prior to reaching the parameterized velocity
If an error occurs during execution of the motion control job before the parameterized velocity 
has been reached, this is indicated by the value TRUE in the output parameter "Error". The 
signal status of the input parameter "Execute" influences the display duration in the output 
parameter "Error":

"Execute" changes its value to FALSE before the error occurs "Execute" changes its value to FALSE after the error occurs
Error Error

 

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  6083



① The job is started with a positive edge at the input parameter "Execute". Depending on the programming, "Execute" can 
still be reset to the value FALSE during the job, or the value TRUE can be retained until after the error has occurred.

② While the job is active, the output parameter "Busy" indicates the value TRUE.
③ An error occurred during job execution. When the error occurs, the output parameter "Busy" changes to FALSE and 

"Error" to TRUE.
④ If "Execute" retains the value TRUE until after the error has occurred, then "Error" also remains TRUE and only changes 

its status to FALSE together with "Execute".
⑤ If "Execute" has been reset to FALSE before the error occurs, "Error" indicates the value TRUE for only one execution 

cycle.

 
 

 Note

Under the following conditions, an error is not indicated in output parameter "Error":

The parameterized velocity has been reached, input parameter "Execute" has the value 
FALSE, and an axis error occurs (software limit switch is approached, for example).

When the parameterized velocity is reached and input parameter "Execute" has the value 
FALSE, the job is complete. After completion of the job, the axis error is only indicated in the 
Motion Control instruction "MC_Power".

 

 

Motion control instruction MC_MoveJog
The commands of Motion Control instruction "MC_MoveJog" implement a jog operation. 

The motion control commands "MC_MoveJog" do not have a defined end. The command 
objective is fulfilled when the parameterized velocity is reached for the first time and the axis 
travels at constant velocity. When the parameterized velocity is reached, this is indicated by 
the value TRUE in output parameter "InVelocity".

The order is complete when input parameter "JogForward" or "JogBackward" has been set to 
the value FALSE and the axis has come to a standstill.

The output parameters "Busy", "CommandAborted", and "Error" signal that the command is 
still being processed, has been aborted or an error is pending.

During processing of the motion control command, the output parameter "Busy" indicates the 
value TRUE. If the command has been completed, aborted, or stopped by an error, the output 
parameter "Busy" changes its value to FALSE.

The output parameter "InVelocity" indicates the status TRUE, as long as the axis is moving at 
the parameterized velocity. The output parameters "CommandAborted" and "Error" indicate 
the status for at least one cycle. These status messages are latched as long as either input 
parameter "JogForward" or "JogBackward" is set to TRUE.

The behavior of the status bits is presented below for various example situations:
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The parameterized velocity is reached and maintained
If the motion control command has been executed by the time the parameterized velocity is 
reached, this is indicated by the value TRUE in output parameter "InVelocity".

Jog mode is controlled by input parameter "JogForward" Jog mode is controlled by input parameter "JogBackward".

 

① The command is started with a positive edge at the input parameter "JogForward" or "JogBackward".
② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ When the parameterized velocity is reached, the output parameter "InVelocity" changes to TRUE.
④ When the input parameter "JogForward" or "JogBackward" is reset to the value FALSE, the axis motion ends. The axis 

starts to decelerate. As a result, the axis no longer moves at constant velocity and the output parameter "InVelocity" 
changes its status to FALSE.

⑤ If the axis has come to a standstill, the motion control command is complete and the output parameter "Busy" changes 
its value to FALSE.
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The command is aborted during execution
If the motion control command is aborted during execution, this is indicated by the value TRUE 
in output parameter "CommandAborted". The behavior is independent of whether or not the 
parameterized velocity has been reached.

Jog mode is controlled by input parameter "JogForward". Jog mode is controlled by input parameter "JogBackward".
Abort Abort

① The command is started with a positive edge at the input parameter "JogForward" or "JogBackward".
② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ During command execution, the command is aborted by another motion control command. If the command is aborted, 

output parameter "Busy" changes to FALSE and "CommandAborted" to TRUE.
④ When the input parameter "JogForward" or "JogBackward" is reset to the value FALSE, the output parameter 

"CommandAborted" changes its value to FALSE.

 
 

 Note

The command abort is indicated in the output parameter "CommandAborted" for only one 
execution cycle, if all conditions below are met:

The input parameters "JogForward" and "JogBackward" have the value FALSE (but the axis 
is still decelerating) and a new motion control command is initiated.
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An error has occurred during command execution
If an error occurs during execution of the motion control command, this is indicated by the 
value TRUE in output parameter "Error". The behavior is independent of whether or not the 
parameterized velocity has been reached.

Jog mode is controlled by input parameter "JogForward". Jog mode is controlled by input parameter "JogBackward".
Error Error

 

① The command is started with a positive edge at the input parameter "JogForward" or "JogBackward".
② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ An error occurred during command execution. When the error occurs, the output parameter "Busy" changes to FALSE 

and "Error" to TRUE.
④ When the input parameter "JogForward" or "JogBackward" is reset to the value FALSE, the output parameter "Error" 

changes its value to FALSE.

 
 

 Note

An error occurrence is indicated in the output parameter "Error" for only one execution cycle, 
if all the conditions below are met:

The input parameters "JogForward" and "JogBackward" have the value FALSE (but the axis 
is still decelerating) and a new error occurs (software limit switch is approached, for example).
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11.2.9.6 Error displays of the Motion Control statements
The Motion Control instructions indicate any errors in motion control commands and the 
technology object at the output parameters "Error", "ErrorID" and "ErroInfo" of the Motion 
Control instructions.

Error display at output parameters "Error", "ErrorID" and "ErrorInfo"
If the output parameter "Error" indicates the value TRUE, the complete command, or portions 
thereof, could not be executed. The cause of the error is indicated by the value in output 
parameter "ErrorID". Detailed information about the cause of the error is returned by the value 
in output parameter ErrorInfo. We distinguish between the following error classes for error 
indication:

● Operating error with axis stop (for example, "HW limit switch was approached")
Operating errors with axis stop are errors that occur during runtime of the user program. If 
the axis is in motion, it is stopped with the configured deceleration or emergency stop 
deceleration, depending on the error. The errors are indicated in the error-triggering Motion 
Control instruction and in the Motion Control instruction "MC_Power".

● Operating error without axis stop (for example, "Axis is not homed")
Operating errors without axis stop are errors that occur during runtime of the user program. 
If the axis is in motion, the motion is continued. The errors are only indicated in the Motion 
Control instruction which triggers the error.

● Parameterization error of Motion Control instruction "
(for example, "Incorrect value in parameter "Velocity"")
Parameterization errors occur when incorrect information is specified in the input 
parameters of Motion Control instructions. If the axis is in motion, the motion is continued. 
The errors are only indicated in the Motion Control instruction which triggers the error.

● Configuration error on technology object "Axis" (for example, "Value for "Acceleration" is 
invalid")
A configuration error exists if one or more parameters are incorrectly configured in the axis 
configuration or if editable configuration data have been modified incorrectly during runtime 
of the program. An axis in motion is stopped with the configured emergency stop 
deceleration. The error is indicated in the error-triggering Motion Control instruction and in 
Motion Control instruction "MC_Power".

● Configuration error on technology object "Command table" (for example "Value for 
"Velocity" is invalid")
There is a configuration error if one or more parameters are incorrectly set in the axis 
command table or if programmable configuration data have been modified incorrectly 
during runtime of the program. If the axis is in motion, the motion is continued. The errors 
are only indicated in the "MC_CommandTable" Motion Control instruction.

● Internal error
When an internal error occurs, the axis is stopped. The errors are indicated in the error-
triggering Motion Control instruction and, in some cases, in the Motion Control instruction 
"MC_Power".
 

A detailed description of the ErrorIDs and ErrorInfos, as well as their remedies, is available in 
the Appendix.
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See also
Overview of the Motion Control statements (Page 6070)

Creating a user program (Page 6071)

Programming notes (Page 6074)

Behavior of the Motion Control commands after POWER OFF and restart (Page 6076)

Monitoring active commands (Page 6076)

11.2.10 Axis - Diagnostics

11.2.10.1 Status and error bits
You use the "Status and error bits" diagnostic function to monitor the most important status 
and error messages for the axis in the TIA Portal. The diagnostic function display is available 
in online mode in "Manual control" mode and in "Automatic control" when the axis is active. 
The status error messages have the following meaning:

Status of the axis

Status Description
Enabled The axis is enabled and ready to be controlled via motion control commands.

(Tag of technology object: <Axis name>.StatusBits.Enable)
Homed The axis is homed and is capable of executing absolute positioning commands of Motion Control 

instruction "MC_MoveAbsolute". The axis does not have to be homed for relative homing. Special 
situations:
● During active homing, the status is FALSE.
● If a homed axis undergoes passive homing, the status is set to TRUE during passive homing.
(Tag of technology object: <Axis name>.StatusBits.HomingDone)

Axis error An error has occurred in the "Axis" technology object. More information about the error is available 
in automatic control at the ErrorID and ErrorInfo parameters of the Motion Control instructions. In 
manual mode, the "Error message" field of the axis command table displays detailed information 
about the cause of error.
(Tag of technology object: <Axis name>.StatusBits.Error)

Axis command table 
enabled

The "Manual control" mode was enabled in the axis command table. The axis command table has 
control priority over the "Axis" technology object. The axis cannot be controlled from the user program.
(Tag of technology object: <Axis name>.StatusBits.ControlPanelActive)

Restart necessary A modified configuration of the axis was downloaded to the load memory in CPU RUN operating 
mode. To download the modified configuration to the work memory, you need to restart the axis. Use 
the Motion Control instruction MC_Reset to do this.
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Drive status

Status Description
Drive ready The drive is ready for operation.

(Tag of technology object: <Axis name>.StatusBits.DriveReady)
Drive error The drive has reported an error after failure of its "Drive ready" signal.

(Tag of technology object: <Axis name>.ErrorBits.DriveFault)

Status of the axis motion

Status Description
Standstill The axis is at a standstill.

(Tag of technology object: <Axis name>.StatusBits.StandStill)
Accelerating The axis accelerates.

(Tag of technology object: <Axis name>.StatusBits.Acceleration)
Constant velocity The axis travels at constant velocity.

(Tag of technology object: <Axis name>.StatusBits.ConstantVelocity)
Decelerating The axis decelerates (slows down).

(Tag of technology object: <Axis name>.StatusBits.Deceleration)

Status of the motion mode

Status Description
Positioning The axis executes a positioning command of the Motion Control instruction 

"MC_MoveAbsolute" or "MC_MoveRelative" or of the axis command table.
(Tag of technology object: <Axis name>.StatusBits.PositioningCommand)

Travel with velocity 
specification

The axis executes a command with the velocity specification of the Motion Control 
instruction "MC_MoveVelocity" or "MC_MoveJog" or of the axis command table.
(Tag of technology object: <Axis name>.StatusBits.SpeedCommand)

Homing The axis executes a homing command of the Motion Control instruction "MC_Home" or the 
axis command table.
(Tag of technology object: <Axis name>.StatusBits.Homing)

Command table active
(as of technology object Axis 
V2.0)

The axis is controlled by Motion Control instruction "MC_CommandTable".
(Tag of technology object: <Axis name>.StatusBits.CommandTableActive)
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Error messages

Error Description
Low software limit switch has 
been reached

The low software limit switch has been reached.
(Tag of technology object: <Axis name>.ErrorBits.SwLimitMinReached)

Low software limit switch has 
been exceeded

The low software limit switch has been exceeded.
(Tag of technology object: <Axis name>.ErrorBits.SwLimitMinExceeded)

High software limit switch has 
been reached

The high software limit switch has been reached.
(Tag of technology object: <Axis name>.ErrorBits.SwLimitMaxReached)

High software limit switch has 
been exceeded

The high software limit switch has been exceeded.
(Tag of technology object: <Axis name>.ErrorBits.SwLimitMaxExceeded)

Low hardware limit switch was 
approached

The low hardware limit switch has been approached.
(Tag of technology object: <Axis name>.ErrorBits.HwLimitMin)

High hardware limit switch was 
approached

The high hardware limit switch has been approached.
(Tag of technology object: <Axis name>.ErrorBits.HwLimitMax)

PTO and HSC already in use A second axis is using the same PTO (Pulse Train Output) and HSC (High Speed Counter) 
and is enabled with "MC_Power".
(Tag of technology object: <Axis name>.ErrorBits.HwUsed)

Configuration error The "Axis" technology object was incorrectly configured or editable configuration data were 
modified incorrectly during runtime of the user program.
(Tag of technology object: <Axis name>.ErrorBits.ConfigFault)

Internal error An internal error has occurred.
(Tag of technology object: <Axis name>.ErrorBits.SystemFault)

See also
Motion status (Page 6093)

StatusBits. tag (Page 6128)

ErrorBits. tag (Page 6130)

11.2.10.2 Motion status
Use the "Motion status" diagnostic function to monitor the motion status of the axis in the TIA 
Portal. The diagnostic function display is available in online mode in "Manual control" mode 
and in "Automatic control" when the axis is active. The displayed status information has the 
following meaning:

Status Description
Position The "Position" field indicates the current axis position. If the axis is not homed, the value indicates 

the position value relative to the enable position of the axis.
(Tag of technology object: <Axis name>.MotionStatus.Position)

Velocity The "Velocity" field indicates the current axis velocity.
(Tag of technology object: <Axis name>.MotionStatus.Velocity)
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Status Description
Target position The "Target position" field indicates the current target position of an active positioning job or of 

the axis command table. The value of the "Target position" is only valid during execution of a 
positioning job.
(Tag of technology object: <Axis name>.MotionStatus.TargetPosition)

Remaining travasing 
distance

The "Remaining traversing distance" field indicates the traversing distance currently remaining 
for an active positioning job or the axis command table. The "Remaining travasing distance" 
value is only valid during execution of a positioning job.
(Tag of technology object: <Axis name>.MotionStatus.Distance)

See also
Status and error bits (Page 6089)

MotionStatus. tag (Page 6127)

11.2.10.3 Dynamics settings
Use the "Dynamics settings" diagnostic function to monitor the dynamic limit values of the axis 
in the TIA Portal. The diagnostic function display is available in online mode in "Manual control" 
mode and in "Automatic control" when the axis is active. The status information displayed has 
the following meaning:

Dynamic limit Description
Acceleration The "Acceleration" field indicates the currently configured acceleration of the axis.

(Technology object variable: <Axis name>.Config.DynamicDefaults.Acceleration)
Deceleration The "Deceleration" field indicates the currently configured deceleration of the axis.

(Technology object variable: <Axis name>.Config.DynamicDefaults.Deceleration)
Emergency stop 
deceleration

The "Emergency stop deceleration" field indicates the currently configured emergency stop 
deceleration of the axis.
(Technology object variable: <Axis name>.Config.DynamicDefaults.EmergencyDeceleration)

Step
(as of technology object 
Axis V2.0)

The "Velocity" field indicates the current axis step velocity configured.
(Technology object variable: <Axis name>.Config.DynamicDefaults.Jerk)

11.2.11 Working with watch tables
Use watch tables if you want to monitor and modify tags of motion control instructions or the 
"Axis" technology object during commissioning.

To monitor and modify tags, you must specify the complete name of the tag, including object 
name and all structure names in a watch table. 

Example: <Axis name>.Config.DynamicDefaults.Acceleration)

Tip:
You can use a copy & paste operation to avoid entering long tag names. 
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Procedure
To insert the tag names, follow the steps described below:

1. In the project tree, select the instance data block or the technology object of the axis.

2. Parameters of the motion control instruction

– Right-click and select the Open command in the shortcut menu.

Tags of the technology object

– Right-click and select the Open in editor command in the shortcut menu.

3. Parameters of the motion control instruction

– Select the lines of the tags in the Input or Output area

Tags of the technology object

– In the Static area, open the relevant structures and select the lines of the tags

4. Select the Edit > Copy menu command.

5. Double-click to open the watch table.

6. Select the line starting at which the tags are to be inserted

7. Select the Edit > Paste menu command.

Insert the tags with their complete names in the watch table.

 
 

 WARNING

The watch table also gives you write access to tags whose use is blocked for safety reasons 
in the user program. Modifying these tags can result in damage to the current axis 
configuration and to undefined responses of the axis. Only modify those tags whose access 
is marked with "RW" in the tag list of the technology object.

 

See also
Commissioning the axis - Axis control panel (Page 6067)

11.2.12 Appendix

11.2.12.1 Using multiple axes with the same PTO
Use the motion control functionality of the CPU S7-1200 to run multiple "Axis" technology 
objects with the same PTO (Pulse Train Output) and thus with the same CPU outputs. This is 
appropriate, for example, if different axis configurations are to be used for different production 
sequences via one PTO. As described below, it is possible to switch between these axis 
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configurations as often as necessary. The following diagram presents the basic functional 
relationships:

S

In this example, more than one "Axis" technology object, each with its own axis configuration, 
uses the same PTO. Each "Axis" must be called in the user program with a separate call of 
Motion Control instruction "MC_Power" with a separate instance data block. Only one "Axis" 
at a time may use the PTO. The axis that is currently using the PTO indicates this with tag 
<Axis name>.StatusBits.Activated = TRUE.

Switching between "Axis" technology objects
The program scheme described below shows you how to switch between different technology 
objects and, thus, between different axis configurations. To use the same PTO with multiple 
axes without error indications, only the Motion Control instructions of the axis currently being 
used may be called. 

The following diagram presents this principle using Motion Control instruction "MC_Power" as 
an example:
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S

The tags of the activated axis ("Axis_2" here) show the following typical indicators in the user 
program:

● <Axis name>.StatusBits.Activated = TRUE

● <Axis name>.ErrorBits.HwUsed = FALSE

To switch to the "Axis" technology object, follow the steps described below. In the example, a 
switch is made from "Axis_2" to "Axis_1":

1. End any active traversing motions of activated "Axis_2"

2. Disable "Axis_2" with the associated Motion Control instruction "MC_Power" using input 
parameter Enable = FALSE

3. To verify that "Axis_2" has been disabled, use an AND operation of output parameter 
Status = FALSE of Motion Control instruction "MC_Power" and technology object tag <Axis 
name>.StatusBits.Enable = FALSE.

4. Deactivate the conditional call of the Motion Control instructions for "Axis_2".

5. Activate the conditional call of the Motion Control instructions for "Axis_1". On the first call 
of the corresponding Motion Control instruction "MC_Power", "Axis_2" becomes 
deactivated and "Axis_1" becomes activated.

6. Enable "Axis_1" with Motion Control instruction "MC_Power" using the input parameter 
Enable = TRUE

7. To verify that "Axis_1" has been enabled, use an AND operation of output parameter 
Status = TRUE of Motion Control instruction "MC_Power" and technology object tag <Axis 
name>.StatusBits.Enable = TRUE.

 

It is also always possible to cyclically call all Motion Control instructions of all axes working 
with a single PTO.
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S

When an axis is enabled (here "Axis_2"), this axis becomes active.

In contrast to the conditional call, the Motion Control instructions of the deactivated axes (here 
"Axis_1" and "Axis_x") will indicate errors. The tags of these axes indicate the status <Axis 
name>.StatusBits.Activated = FALSE and <Axis name>.ErrorBits.HwUsed = TRUE.

Use the conditional call of the Motion Control instructions if you want to implement the user 
program without error indicators.

See also
Using multiple drives with the same PTO (Page 6099)

Tracking jobs from higher priority classes (execution levels) (Page 6100)

Special cases for use of software limit switches (Page 6102)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

Tag of the Axis technology object (Page 6118)
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11.2.12.2 Using multiple drives with the same PTO
If multiple drives are to be used, they can be run with a common PTO (Pulse Train Output) 
using changeover. The following diagram represents the basic circuit design:

S

The changeover between drives can be controlled, if required, by the user program via a digital 
output. If different axis configurations are required for the different drives, a changeover 
between these configurations is required for the PTO. For additional information on this topic, 
refer to "Using multiple axes with the same PTO (Page 6093)".

See also
Using multiple axes with the same PTO (Page 6093)

Tracking jobs from higher priority classes (execution levels) (Page 6100)

Special cases for use of software limit switches (Page 6102)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

Tag of the Axis technology object (Page 6118)
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11.2.12.3 Tracking jobs from higher priority classes (execution levels)
Depending on the application, it may be necessary to start motion control jobs (for example, 
interrupt-controlled) in a higher priority class (execution level). 

The Motion Control instructions must be called at short intervals for status monitoring. Motion 
Control commands cannot be sufficiently closely monitored if the higher priority Motion Control 
commands are called only once or at too great an interval. Tracking in such cases can be 
carried out in the cycle OB. An instance data block that is not currently being utilized must be 
available for each start of a higher priority motion control command. Refer to the following flow 
chart to see how you start motion control jobs in a higher priority class (for example, hardware 
interrupt OB) and continue tracking in the program cycle OB:
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Depending on the frequency of the motion control jobs you want to start, you will have to 
generate a sufficient number of instance data blocks. Users determine which instance data 
block is currently used in the DBx_used tags.
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Start of motion control job in the hardware interrupt OB
Binary queries of the DBx_used tags (orange) are used to find an instance data block not 
currently in use. If such an instance data block is found, the utilized instance data block is 
marked as "used" (green) and the Motion Control job is started with this instance data block.

Any other program sections of the hardware interrupt OB are then executed, followed by a 
return to the program cycle OB.

Tracking of started motion control jobs in the program cycle OB
All instance data blocks available in the cycle OB are checked to determine if they are currently 
in use by means of the DBx_used tag (violet).

If an instance data block is in use (motion control job is being processed), the motion control 
instruction with this instance data block and input parameter Execute = TRUE is called to read 
out the status messages (red).

If the job is complete or has been aborted, the following actions are taken next (blue green):

● Call of motion control instruction with input parameter Execute = FALSE

● Resetting the DBx_used tag

This completes the job tracking, and the instance data block is now available for use again.

See also
Using multiple axes with the same PTO (Page 6093)

Using multiple drives with the same PTO (Page 6097)

Special cases for use of software limit switches (Page 6102)

List of ErrorIDs and ErrorInfos (technology objects as of V2.0) (Page 6109)

Tag of the Axis technology object (Page 6118)

11.2.12.4 Special cases for use of software limit switches

Software limit switches in conjunction with a homing operation
Due to unfavorably parameterized homing jobs, the braking action of the axis may be 
influenced at the software limit switch. Take the following examples into consideration when 
developing your program.
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Example 1:
During a travel command, a homing job (for example, Set reference point) offsets the current 
axis position in the direction of the software limit switch. It is still possible to bring the axis to 
a standstill before reaching the software limit switch:

① The green curve shows the motion without the homing job. The axis brakes at the configured deceleration and comes 
to a standstill at a position before the software limit switch.

② A new axis position is set as a result of the homing job. The area between the old and new axis position is thus "skipped".
③ Based on the new axis position, the axis would theoretically be stopped with the configured deceleration at a position 

after the software limit switch (red curve).
④ Because braking with the configured deceleration is no longer sufficient, the axis actually follows the blue curve. 

Following a constant motion, the axis brakes at the emergency stop deceleration and comes to a standstill at the position 
of the software limit switch.

Example 2:
During a travel command, a homing job (for example, Set reference point) offsets the current 
axis position in the direction of the software limit switch. In contrast to example 1, it is no longer 
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possible to bring the axis to a standstill before reaching the software limit switch. The axis 
overruns the position of the software limit switch.

① The green curve shows the motion without the homing job. The axis brakes at the configured deceleration and comes 
to a standstill at a position before the software limit switch.

② A new axis position is set as a result of the homing job. The area between the old and new axis position is thus "skipped".
③ Based on the new axis position, the axis would theoretically be stopped with the configured deceleration at a position 

well after the software limit switch (red curve).
④ Because braking with the configured deceleration is no longer sufficient, the axis actually follows the blue curve. The 

axis brakes at the emergency stop deceleration. However, the emergency stop deceleration is not sufficient to stop the 
axis at the position of the software limit switch. The position of the software limit switch is overrun.
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Example 3:
During a braking operation, a homing job (for example, Set reference point) offsets the current 
axis position in the direction of the software limit switch. It is still possible to bring the axis to 
a standstill before reaching the software limit switch:

① The green curve shows the motion without the homing job. The axis brakes at the configured deceleration and comes 
to a standstill at a position before the software limit switch.

② A new axis position is set as a result of the homing job. The area between the old and new axis position is thus "skipped".
③ Based on the new axis position, the axis would theoretically be stopped with the configured deceleration at a position 

after the software limit switch (red curve).
④ Because braking with the configured deceleration is no longer sufficient, the axis actually follows the blue curve. 

Following a constant motion, the axis brakes at the emergency stop deceleration and comes to a standstill at the position 
of the software limit switch.

Example 4:
During a braking operation, a homing job (for example, Set reference point) offsets the current 
axis position in the direction of the software limit switch. In contrast to example 3, it is no longer 
possible to bring the axis to a standstill before reaching the software limit switch. The axis 
overruns the position of the software limit switch.
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① The green curve shows the motion without the homing job. The axis brakes at the configured deceleration and comes 
to a standstill at a position before the software limit switch.

② A new axis position is set as a result of the homing job. The area between the old and new axis position is thus "skipped".
③ Based on the new axis position, the axis would theoretically be stopped with the configured deceleration at a position 

well after the software limit switch (red curve).
④ Because braking with the configured deceleration is no longer sufficient, the axis actually follows the blue curve. The 

axis brakes at the emergency stop deceleration. However, the emergency stop deceleration is not sufficient to stop the 
axis at the position of the software limit switch. The position of the software limit switch is overrun.

See also
Software limit switches and software limit switch position changes. (Page 6106)

Software limit switches in conjunction with dynamic changes (Page 6107)

Behavior of axis when position limits is tripped (Page 6031)

Software limit switches and software limit switch position changes.
An incorrect change in the position of the software limit switch during the runtime of the user 
program can abruptly reduce the distance between the current axis position and the position 
of the software limit switch.
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The axis response is similar to that described in Software limit switches in conjunction with a 
homing operation (Page 6100).

See also
Software limit switches in conjunction with a homing operation (Page 6100)

Software limit switches in conjunction with dynamic changes (Page 6107)

Behavior of axis when position limits is tripped (Page 6031)

Software limit switches in conjunction with dynamic changes
It is possible to influence the deceleration of the axis in the area of the software limit switches 
in conjunction with overriding motion jobs. This applies when the overriding motion command 
is started with a lower deceleration (tag <Axis name>.Config.DynamicDefaults.Deceleration). 
Take the following examples into consideration when developing your program.

Example 1:
During axis motion, an active motion job is overridden by another motion job with a lower 
deceleration:
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① The green curve shows the motion of an active job without this job being overridden. The axis brakes at the configured 
deceleration and comes to a standstill at a position before the software limit switch.

② Based on the overriding motion job with lower deceleration, the axis would theoretically be stopped with the configured 
deceleration at a position after the software limit switch (red curve).

③ Because braking with the configured deceleration of the overriding motion job is no longer sufficient, the axis actually 
follows the blue curve. Following a constant motion, the axis brakes at the emergency stop deceleration and comes to 
a standstill at the position of the software limit switch.

Example 2:
During braking of the axis, an active motion job is overridden by another motion job with a 
lower deceleration:

 

① The green curve shows the motion of an active job without this job being overridden. The axis brakes at the configured 
deceleration and comes to a standstill at a position before the software limit switch.

② Based on the overriding motion job with lower deceleration, the axis would theoretically be stopped at a position well 
after the software limit switch (red curve).

③ Because braking with the configured deceleration of the overriding motion job is no longer sufficient, the axis actually 
follows the blue curve. Following a constant motion, the axis brakes at the emergency stop deceleration and comes to 
a standstill at the position of the software limit switch.
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See also
Software limit switches in conjunction with a homing operation (Page 6100)

Software limit switches and software limit switch position changes. (Page 6104)

Behavior of axis when position limits is tripped (Page 6031)

11.2.12.5 Reducing velocity for a short positioning duration
The CPU can reduce the velocity of a positioning command when the planned positioning 
duration is  < 2 ms. 

The velocity of command execution will then be reduced for the entire duration. The reduced 
velocity (pulses per s) is calculated as follows:

● Reduced velocity = Number of pulses to be output * 500Hz

Velocity is not reduced if the planned positioning duration is >= 2 ms.

11.2.12.6 Dynamic adjustment of start/stop velocity
The configuration of your velocity limits (start/stop velocity and maximum velocity), the dynamic 
values (acceleration, deceleration and jerk) and the target speed of the traversing command 
may under certain circumstances result in the start/stop velocity being dynamically adjusted 
by the CPU.

This is for example the case when, due to a low configured start/stop velocity, the time required 
for the first pulses would be longer than that possible for the entire acceleration. The first pulse 
is in these cases output at a greater velocity than the configured start/stop velocity. The 
subsequent pulses are also dynamically adjusted to ensure the acceleration process can be 
completed in the specified time.

Ensure in the event of any pulse loss that the hardware (drive) you use is adjusted to this 
situation, or change the dynamic settings of your axis to avoid dynamic adjustment of the start/
stop velocity.

 

11.2.12.7 List of ErrorIDs and ErrorInfos (technology objects as of V2.0)
The following table lists all ErrorIDs and ErrorInfos that can be indicated in Motion Control 
instructions. In addition to the cause of the error, remedies for eliminating the error are also 
listed:   

Operating error with stop of the axis

ErrorID ErrorInfo Description Remedy
16#8000 Drive error, "Drive ready" failure
 16#0001 - Acknowledge error with instruction "MC_Reset"; 

provide drive signal; possibly restart command
16#8001 Low software limit switch has been tripped
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ErrorID ErrorInfo Description Remedy
 16#000E The position of the low software limit switch was 

reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the positive direction out of the range of the 
software limit switch16#000F The position of the low software limit switch was 

reached with the emergency stop deceleration
16#0010 The position of the low software limit switch was 

exceeded with the emergency stop deceleration
16#8002 High software limit switch has been tripped
 16#000E The position of the high software limit switch 

was reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the negative direction out of the range of the 
software limit switch16#000F The position of the high software limit switch 

was reached with the emergency stop 
deceleration

16#0010 The position of the high software limit switch 
was exceeded with the emergency stop 
deceleration

16#8003 Low hardware limit switch was approached
 16#000E The low hardware limit switch was approached. 

The axis was stopped with the emergency stop 
deceleration.
(During an active home position approach, the 
homing switch was not found)

Acknowledge the error for a released axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the positive direction out of the 
range of the hardware limit switch.

16#8004 High hardware limit switch was approached
 16#000E The high hardware limit switch was 

approached. The axis was stopped with the 
emergency stop deceleration.
(During an active home position approach, the 
homing switch was not found)

Acknowledge the error for a released axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the negative direction out of the 
range of the hardware limit switch.

16#8005 PTO/HSC are already being used by another axis
 16#0001 - The axis was configured incorrectly:

Correct the configuration of the PTO (Pulse Train 
Output) / HSC (High Speed Counter) and download 
it to the controller
More than one axis is to run with one PTO:
Another axis is using the PTO/HSC. If the current 
axis is to assume the control, the other axis must 
be disabled with "MC_Power" Enable = FALSE.
(see also Using multiple axes with the same PTO 
(Page 6093))

16#8006 A communication error in the control panel has occurred 
 16#0012 A timeout has occurred Check the cable connection and press the "Manual 

control" button again.
16#8007 It is not possible to release the axis
 16#0025 Restarting Wait until the axis restart is complete.
 16#0026 Executing loading process in RUN mode Wait until the loading process is complete.
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Operating error without stop of the axis

ErrorID ErrorInfo Description Remedy
16#8200 Axis is not released
 16#0001 - Release the axis; restart the command
16#8201 Axis has already been released by another "MC_Power" instance
 16#0001 - Release the axis with only one "MC_Power" 

instance
16#8202 The maximum number of simultaneously active motion control commands has been exceeded 

(maximum of 200 commands for all motion control technology objects)
 16#0001 - Reduce the number of simultaneously active 

commands; restart the command
A command is active if parameter "Busy" = TRUE 
in the Motion Control instruction.

16#8203 Axis is currently operated in "Manual control" (axis command table)
 16#0001 - Exit "Manual control"; restart the command
16#8204 Axis is not homed
 16#0001 - Home the axis with instruction "MC_Home"; restart 

the command
16#8205 The axis is currently controlled by the user program (the error is only displayed in the axis command 

table)
 16#0013 The axis is released in the user program. Disable axis with instruction "MC_Power" and 

select "Manual control" again in the axis command 
table

16#8206 Technology object not activated yet
 16#0001 - Release the axis with instruction "MC_Power" 

Enable = TRUE or release the axis in the axis 
command table.

16#8207 Command rejected
 16#0016 Active homing is running; another homing 

method cannot be started.
Wait for active homing to finish or abort the active 
homing with a motion command, for example, 
"MC_Halt".

16#0018 The axis cannot be moved with a command 
table whilst it is being directly or passively 
homed.

Wait until direct or passive homing is complete.

16#0019 The axis cannot be directly or passively homed 
whilst a command table is being processed.

Wait for command table to finish or abort the 
command table with a motion command, for 
example, "MC_Halt".

16#8208 Difference between maximum and start/stop velocity is invalid
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#8209 Invalid acceleration for technology object "Axis"
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#820A It is not possible to restart the axis
 16#0013 The axis is released in the user program. Disable the axis with the "MC_Power" instruction; 

restart again
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ErrorID ErrorInfo Description Remedy
 16#0027 The axis is currently being operated in "Manual 

control" (axis control panel)
Exit "Manual control"; restart again

16#820B It is not possible to execute the command table
 16#0026 Executing loading process in RUN mode Wait until the loading process is complete.

Block parameter error

ErrorID ErrorInfo Description Remedy
16#8400 Invalid value at parameter "Position" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8401 Invalid value at parameter "Distance" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8402 Invalid value at parameter "Velocity" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0008 Value is greater than the configured maximum 
velocity

16#0009 Value is less than the configured start/stop 
velocity

16#0024 Value is less than 0
16#8403 Invalid value at parameter "Direction" of the Motion Control instruction
 16#0011 The selection value is invalid Correct the selection value; restart the command
16#8404 Invalid value at parameter "Mode" of the Motion Control instruction
 16#0011 The selection value is invalid Correct the selection value; restart the command

16#0015 Active/passive homing is not configured Correct the configuration and download it to the 
controller; release the axis and restart the command

16#0017 The direction reversal is activated at the 
hardware limit switch, despite the fact that the 
hardware limit switches are disabled

● Activate the hardware limit switch using the tag 
<Axis>.Config.PositionLimits_HW.Active = 
TRUE, restart the command

● Correct the configuration and download it to the 
controller; release the axis and restart the 
command

16#8405 Invalid value at parameter "StopMode" of the Motion Control instruction
 16#0011 The selection value is invalid Correct the selection value; release the axis again
16#8406 Simultaneous forward and backward jogging is not allowed
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ErrorID ErrorInfo Description Remedy
 16#0001 - Take steps to ensure that parameters 

"JogForward" and "JogBackward" do not have 
signal status TRUE simultaneously; restart the 
command.

16#8407 Switching to another axis with instruction "MC_Power" is only permitted after disabling the active axis.
 16#0001 - Disable the active axis; it is then possible to switch 

to the other axis and release it.
16#8408 Invalid value at parameter "Axis" of the Motion Control instruction
 16#001A The specified value does not match the 

required technology object version
Correct the value; restart the command

16#001B The specified value does not match the 
required technology object type

16#001C The specified value is not a Motion Control 
technology data block

16#8409 Invalid value at parameter "CommandTable" of the Motion Control instruction
 16#001A The specified value does not match the 

required technology object version
Correct the value; restart the command

16#001B The specified value does not match the 
required technology object type

16#001C The specified value is not a Motion Control 
technology data block

16#840A Invalid value at parameter "StartStep" of the Motion Control instruction
 16#000A Value is less than or equal to 0 Correct the value; restart the command

16#001D The start step is greater than the end step
16#001E Value is greater than 32

16#840B Invalid value at parameter "EndStep" of the Motion Control instruction
 16#000A Value is less than or equal to 0 Correct the value; restart the command

16#001E Value is greater than 32
16#840C Invalid value at parameter "RampUpTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#840D Invalid value at parameter "RampDownTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#840E Invalid value at parameter "EmergencyRampTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#840F Invalid value at parameter "JerkTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
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Configuration error of the axis

ErrorID ErrorInfo Description Remedy
16#8600 Parameter assignment of pulse generator (PTO is invalid
 16#000B The address is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#0014 The selected hardware is used by another 
application

16#8601 Parameterization of the high-speed counter (HSC) is invalid
 16#000B The address is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#0014 The selected hardware is used by another 
application

16#8602 Invalid parameter assignment of "Enable output"
 16#000B The address is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#8603 Invalid parameter assignment of "Ready input"
 16#000B The address is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#8604 Invalid "Pulses per motor revolution" value
 16#000A Value is less than or equal to zero ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#8605 Invalid "Load distance per motor revolution" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#0005 The value is outside the number range (greater 
than 1e12)

16#000A Value is less than or equal to zero
16#8606 Invalid "Start / stop velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#0003 Value exceeds the high hardware limit
16#0004 Value is less than the low hardware limit
16#0007 The start/stop velocity is greater than the 

maximum velocity
16#8607 Invalid "maximum velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#0003 Value exceeds the high hardware limit
16#0004 Value is less than the low hardware limit

16#8608 Invalid "Acceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#0003 Value exceeds the high hardware limit
16#0004 Value is less than the low hardware limit

16#8609 Invalid "Deceleration" value
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ErrorID ErrorInfo Description Remedy
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#0003 Value exceeds the high hardware limit
16#0004 Value is less than the low hardware limit

16#860A Invalid "Emergency stop deceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#0003 Value exceeds the high hardware limit
16#0004 Value is less than the low hardware limit

16#860B Value for position of the low SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#0007 The position value of the low software limit 
switch is greater than that of the high software 
limit switch

16#860C Value for position of the high SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#860D Invalid address of the low HW limit switch
 16#000C The address of the falling edge is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#000D The address of the rising edge is invalid

16#860E Invalid address of the high HW limit switch
 16#000C The address of the falling edge is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#000D The address of the rising edge is invalid

16#860F Invalid "home position offset" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8610 Invalid "approach velocity" value
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ErrorID ErrorInfo Description Remedy
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#0008 The velocity is greater than the maximum 
velocity

16#0009 The velocity is less than the start/stop velocity

16#8611 Invalid "Homing velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#0008 The velocity is greater than the maximum 
velocity

16#0009 The velocity is less than the start/stop velocity

16#8612 Invalid address of the homing switch
 16#000C The address of the falling edge is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

16#000D The address of the rising edge is invalid

16#8613 During active homing, direction reversal at the hardware limit switch is activated although the 
hardware limit switches are not configured

 16#0001 - ● Download error-free configuration to the 
controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#8614 Invalid "Jerk" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and if 
necessary restart the command

16#001F Value is greater than the maximum jerk
16#0020 Value is less than the minimum jerk

16#8615 Value for "Unit of measurement" is invalid
 16#0011 The selection value is invalid Download error-free configuration to the controller; 

release the axis again with instruction "MC_Power"

Configuration error of the command table

ErrorID ErrorInfo Description Remedy
16#8700 Value for "Command type" in the command table is invalid
 16#0001 - ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online and if 
necessary restart the command

16#8701 Value for "Position / travel path" in the command table is invalid
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ErrorID ErrorInfo Description Remedy
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online and if 
necessary restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12

16#8702 Value for "Velocity" in the command table is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online and if 
necessary restart the command

16#0008 Value is greater than the configured maximum 
velocity

16#0009 Value is less than the configured start/stop 
velocity

16#8703 Value for "Duration" in the command table is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online and if 
necessary restart the command

16#0021 Value is greater than 64800 s
16#0022 Value is less than 0.001 s

16#8704 Value for "Next step" in the command table is invalid
 16#0011 The selection value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online and if 
necessary restart the command

16#0023 The command transition is not permitted for this 
command

Internal errors

ErrorID ErrorInfo Description Remedy
16#8FFF Internal error
 16#F0** - POWER OFF and POWER ON the CPU

If this does not work, contact Customer Support. 
Have the following information ready:
● ErrorID
● ErrorInfo
● Diagnostic buffer entries
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See also
Using multiple axes with the same PTO (Page 6093)

Using multiple drives with the same PTO (Page 6097)

Tracking jobs from higher priority classes (execution levels) (Page 6098)

Special cases for use of software limit switches (Page 6100)

Tag of the Axis technology object (Page 6118)

11.2.12.8 Tag of the Axis technology object

Config. tag

Config.General. tag
Legend

Data type Data type of the tag
Start value Start value of tag

The initial value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.Config.General.PTO  
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWORD DW#16#00000000 - - -

<Axis name>.Config.General.HSC
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWORD DW#16#00000000 - - -
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<Axis name>.Config.General.LengthUnit ("Axis" technology object as of V2.0)
The unit of measurement for the parameter selected in the configuration:
● 1013 = "mm"
● 1010 =: "m"
● 1019 = "in"
● 1018 = "ft"
● 1005 = "°" (degrees)
● -1 = "Pulse"
Data type Start value Access Effective HMI
Int 1013 R - X

Config.DriveInterface. tag
Legend

Data type Data type of the tag
Start value Start value of tag

The initial value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.Config.DriveInterface.EnableOutput...  
Tags cannot be evaluated in the user program.
Data type Start value Access Effective HMI
- - - - -

<Axis name>.Config.DriveInterface.ReadyInput...
Tags cannot be evaluated in the user program.
Data type Start value Access Effective HMI
- - - - -
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Config.Mechanics. tag
Legend

Data type Data type of the tag
Start value Start value of tag

The initial value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.Config.Mechanics.PulsesPerDriveRevolution)  
Increments per motor revolution
Data type Start value Access Effective HMI
DInt L#1000 R - X

<Axis name>.Config.Mechanics.LeadScrew
Load distance per motor revolution (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 1.0E+001 R - X

<Axis name>.Config.Mechanics.InverseDirection
Invert direction signal
Data type Start value Access Effective HMI
Bool FALSE R - X

Config.DynamicLimits. tag
Legend

Data type Data type of the tag
Start value Start value of tag

The initial value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.
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<Axis name>.Config.DynamicLimits.MinVelocity  
Start/stop velocity of axis (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 1.0E+001 R - X

<Axis name>.Config.DynamicLimits.MaxVelocity
Maximum velocity of axis (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 2.5E+002 R - X

Config.DynamicDefaults. tag
Legend

Data type Data type of the tag
Start value Start value of tag

The initial value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
1 When axis is activated (tag <Axis name>.StatusBits.Activated changes from FALSE -> TRUE), blocked 

or released
2 When axis is enabled
5 The next time an MC_MoveAbsolute,  MC_MoveRelative, MC_MoveVelocity, MC_MoveJog, MC_Halt, 

MC_CommandTable or active MC_Home command is started (Mode = 3).
6 When a MC_MoveJog command is stopped

HMI The tag can be used in an HMI system.

<Axis name>.Config.DynamicDefaults.Acceleration   
Acceleration of axis (specified in the configured dimension unit)
Data type Start value Access Effective HMI
Real 4.8E+001 RW 5 CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.DynamicDefaults.Deceleration
Deceleration of axis (specified in the configured dimension unit)
Data type Start value Access Effective HMI
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<Axis name>.Config.DynamicDefaults.Deceleration
Real 4.8E+001 RW 5, 

6
CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.DynamicDefaults.EmergencyDeceleration
Emergency stop deceleration of axis (specified in the configured dimension unit)
Data type Start value Access Effective HMI
Real 1.2E+002 RW 2, 

5, 
6

CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.DynamicDefaults.JerkActive ("Axis" technology object as of V2.0)
TRUE = the jerk limit is activated
Data type Start value Access Effective HMI
Bool FALSE RW 1, 5 X

<Axis name>.Config.DynamicDefaults.Jerk ("Axis" technology object as of V2.0)
Jerk during axis acceleration and deceleration ramp (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 1.92E+002 RW 1, 5 X

Config.PositionLimits_SW. tag
Legend

Data type Data type of the tag
Start value Start value of tag

The initial value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
1 When axis is activated (tag <Axis name>.StatusBits.Activated changes from FALSE -> TRUE), 

blocked or released
4 Upon the next start of a Motion Control command after a standstill of the axis. The axis standstill can 

be checked with tag <Axis name>. StatusBits.Standstill.
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5 The next time an MC_MoveAbsolute, MC_MoveRelative,  MC_MoveVelocity, MC_MoveJog, 
MC_Halt, MC_CommandTable or active MC_Home command is started (Mode = 3).

HMI The tag can be used in an HMI system.

<Axis name>.Config.PositionLimits_SW.Active   
TRUE = The software limit switches are activated
Data type Start value Access Effective HMI
Bool FALSE RW 4 CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.PositionLimits_SW.MinPosition
Position of low software limit switch (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real -1.0E+004 RW 4 CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.PositionLimits_SW.MaxPosition
Position of high software limit switch (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 1.0E+004 RW 4 CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

Config.PositionLimits_HW. tag
Legend

Data type Data type of the tag
Start value Start value of tag

The initial value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
1 When axis is activated (tag <Axis name>.StatusBits.Activated changes from FALSE -> TRUE), 

blocked or released
3 After axis enable (the axis must have previously been at a standstill). The axis standstill can be 

checked with tag <Axis name>. StatusBits.Standstill.
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4 Upon the next start of a Motion Control command after a standstill of the axis. The axis standstill can 
be checked with tag <Axis name>. StatusBits.Standstill.

5 The next time aMC_MoveAbsolute, MC_MoveRelative, MC_MoveVelocity, MC_MoveJog, MC_Halt, 
MC_CommandTable or active MC_Home command is started (Mode = 3).

HMI The tag can be used in an HMI system.

<Axis name>.Config.PositionLimits_HW.Active   
TRUE = The hardware limit switches are active.
Data type Start value Access Effective HMI
Bool FALSE RW 3, 

4
CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.PositionLimits_HW.MinSwitchedLevel
TRUE = 24 V at CPU input corresponds to low hardware limit switch approached
FALSE = 0 V at CPU input corresponds to low hardware limit switch approached
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.Config.PositionLimits_HW.MinFallingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -

<Axis name>.Config.PositionLimits_HW.MinRisingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -

<Axis name>.Config.PositionLimits_HW.MaxSwitchedLevel
TRUE = 24 V at CPU input corresponds to high hardware limit switch approached
FALSE = 0 V at CPU input corresponds to high hardware limit switch approached
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.Config.PositionLimits_HW.MaxFallingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -
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<Axis name>.Config.PositionLimits_HW.MaxRisingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -

Config.Homing. tag
Legend

Data type Data type of the tag
Start value Start value of tag

The initial value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
1 When axis is activated (tag <Axis name>.StatusBits.Activated changes from FALSE -> TRUE), 

blocked or released
7 When a passive homing command is started
8 When an active homing command is started

HMI The tag can be used in an HMI system.

<Axis name>.Config.Homing.AutoReversal   
TRUE = Direction reversal at hardware limit switch enabled (active homing)
FALSE = Direction reversal at hardware limit switch disabled (active homing)
Data type Start value Access effective HMI
Bool TRUE R - Technology object 

"Axis" V1.0
X

RW 1, 
8

Technology object 
"Axis" V2.0

<Axis name>.Config.Homing.Direction
TRUE = Positive approach direction to search for homing switch and positive homing direction (active homing)
FALSE = Negative approach direction to search for homing switch and positive homing direction (active homing)
Data type Start value Access effective HMI
Bool TRUE R - Technology object 

"Axis" V1.0
X

RW 1, 
8

Technology object 
"Axis" V2.0
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<Axis name>.Config.Homing.SideActiveHoming ("Axis" technology object as of V2.0)
TRUE = Homing on high side of the homing switch (active homing)
TRUE = Homing on lower side of the homing switch (active homing)
Data type Start value Access Effective HMI
Bool TRUE RW 1, 8 X

<Axis name>.Config.Homing.SidePassiveHoming ("Axis" technology object as of V2.0)
TRUE = Homing on high side of the homing switch (passive homing)
TRUE = Homing on lower side of the homing switch (passive homing)
Data type Start value Access Effective HMI
Bool TRUE RW 1, 7 X

 

<Axis name>.Config.Homing.RisingEdge (as of technology object "Axis" V1.0)
TRUE = Homing with negative signal edge of the homing switch (active homing)
FALSE = Homing with positive signal edge of the homing switch (active homing)
For information on the effect of the tag on passive homing, refer to the description in "Configuration - Homing".
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.Config.Homing.Offset
Home position offset /specified in the configured unit of measurement (active homing)
Data type Start value Access Effective HMI
Real 0.0 R

RW
- Technology object 

"Axis" V1.0
X

1, 
8

Technology object 
"Axis" V2.0

<Axis name>.Config.Homing.FastVelocity
Approach velocity  / specified in the configured unit of measurement (active homing)
Data type Start value Access Effective HMI
Real 2.0E+002 R - Technology object 

"Axis" V1.0
X

RW 1, 
8

Technology object 
"Axis" V2.0

<Axis name>.Config.Homing.SlowVelocity
Homing velocity  / specified in the configured unit of measurement (active homing)
Data type Start value Access Effective HMI
Real 4.0E+001 R - Technology object 

"Axis" V1.0
X

RW 1, 
8

Technology object 
"Axis" V2.0
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<Axis name>.Config.Homing.FallingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -

<Axis name>.Config.Homing.RisingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access effective HMI
DWord DW#16#00000000 - -  

MotionStatus. tag
Legend

Data type Data type of the tag
Start value Start value of tag
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.MotionStatus.Position   
Current position of the axis (specified in the configured unit of measurement) If the axis is not homed, the tag indicates the 
position value relative to the enable position of the axis.
Data type Start value Access Effective HMI
Real 0.0 R - X

<Axis name>.MotionStatus.Velocity
Current velocity of the axis (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 0.0 R - X

<Axis name>.MotionStatus.Distance
Current distance to the target position of the axis (specified in the configured unit of measurement) The value of the tag is 
only valid during execution of a positioning command with "MC_MoveAbsolute" or "MC_MoveRelative" or of the axis 
command table. 
Data type Start value Access Effective HMI
Real 0.0 R - X

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  6125



<Axis name>.MotionStatus.TargetPosition
Target position of axis (specified in the configured unit of measurement) The value of the tag is only valid during execution 
of a positioning command with "MC_MoveAbsolute" or "MC_MoveRelative" or of the axis command table.
Data type Start value Access Effective HMI
Real 0.0 R - X

See also
Motion status (Page 6091)

StatusBits. tag
Legend

Data type Data type of the tag
Start value Start value of tag
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.StatusBits.Activated   
TRUE = The axis is activated. It is connected to the assigned PTO (Pulse Train Output). The data of the technology data 
block will be updated cyclically.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Enable
TRUE = The axis is enabled and ready to take on Motion Control commands.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.HomingDone
TRUE = The axis is homed and is capable of executing absolute positioning commands. The axis does not have to be homed 
for relative homing.
The status is FALSE during active homing. The status will remain TRUE during passive homing if the axis has already been 
homed.
Data type Start value Access Effective HMI
Bool FALSE R - X
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<Axis name>.StatusBits.Done
TRUE = No Motion Control command is active on the axis.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Error
TRUE = An error occurred in the axis technology object. Detailed information about the error is available in automatic mode 
in the "ErrorID" and "ErrorInfo" parameters of the motion control instructions. In manual mode, the "Error message" field of 
the axis command table displays detailed information about the cause of error.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.StandStill
TRUE = The axis is at a standstill.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.PositioningCommand
TRUE = The axis is executing a positioning command.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.SpeedCommand
TRUE = The axis is executing a travel command at predefined velocity.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Homing
TRUE = The axis is executing a homing command of the "MC_Home" Motion Control instruction or axis command table.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.CommandTableActive
TRUE = The axis is controlled by Motion Control instruction "MC_CommandTable".
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.ConstantVelocity
TRUE = The axis travels at constant velocity.
Data type Start value Access Effective HMI
Bool FALSE R - X
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<Axis name>.StatusBits.Acceleration
TRUE = The axis accelerates.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Deceleration
TRUE = The axis decelerates (slows down).
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.ControlPanelActive
TRUE = The "Manual control" mode has been enabled in the axis command table. The axis command table has control 
priority over the "Axis" technology object. The axis cannot be controlled from the user program.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.DriveReady
TRUE = The drive is ready.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.RestartRequired
TRUE = Values were modified in the load memory. 
To download the values in the CPU RUN operating mode to the work memory, you need to restart the axis. Use the Motion 
Control instruction MC_Reset to do this.
Data type Start value Access Effective HMI
Bool FALSE R - X

See also
Status and error bits (Page 6089)

ErrorBits. tag
Legend

Data type Data type of the tag
Start value Start value of tag
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.
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Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.ErrorBits.SystemFault  
TRUE = Internal system error.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.ConfigFault
TRUE = Incorrect configuration of axis.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.DriveFault
TRUE = The drive has reported an error after failure of its "Drive ready" signal.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.SwLimitMinReached
TRUE = The low software limit switch has been reached.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.SwLimitMinExceeded
TRUE = The low software limit switch has been exceeded.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.SwLimitMaxReached
TRUE = The high software limit switch has been reached.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.SwLimitMaxExceeded
TRUE = The high software limit switch has been exceeded.
Data type Start value Access Effective HMI
Bool FALSE R - X
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<Axis name>.ErrorBits.HwLimitMin
TRUE = The low hardware limit switch has been approached.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.HwLimitMax
TRUE = The high hardware limit switch has been approached.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.HwUsed
TRUE = A second axis is using the same PTO (Pulse Train Output) and is enabled with "MC_Power".
Data type Start value Access Effective HMI
Bool FALSE R - X

See also
Status and error bits (Page 6089)

Internal. tag
The "Internal" tags contain no user-relevant data; these tags cannot be accessed in the user 
program.

 

ControlPanel tag
The "ControlPanel" tags contain no user-relevant data; these tags cannot be accessed in the 
user program.

 

Update of the technology object tags
The status and error information of the axis indicated in the technology object tags is updated 
at each cycle control point.  

The change in values of editable configuration tags does not take effect immediately. For 
information on the conditions under which a change takes effect, refer to the detailed 
description of the relevant tag.
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11.2.12.9 Command table technology object tag

Config.Command.Command[1 ... 32] tag
Legend

Data type Data type of the tag
Start value Start value of tag

The start value can be overwritten by the configuration of the command table.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.Config.Command.Command[x].Type
Command type
● 0 = "Empty" command
● 2 = "Hold" command
● 5 = "Relative positioning" command
● 6 = "Absolute positioning" command
● 7 = "Velocity setpoint" command
● 151 = "Wait" command
Data type Start value Access Effective HMI
Int 0 RW - X

<Axis name>. Config.Command.Command[x].Position
Command target position / travel path
Data type Start value Access Effective HMI
Real  RW - X

<Axis name>. Config.Command.Command[x].Velocity
Command velocity
Data type Start value Access Effective HMI
Real 0.0 RW - X

<Axis name>. Config.Command.Command[x].Duration
Command duration
Data type Start value Access Effective HMI
Real 0.0 RW - X
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<Axis name>. Config.Command.Command[x].BufferMode
Value for command "Next step"
● 0 = "Complete command"
● 1 = "Blend movement"
Data type Start value Access Effective HMI
Int 0 RW - X

<Axis name>. Config.Command.Command[x].StepCode
Command step code
Data type Start value Access Effective HMI
Word 0 RW - X

 

 

11.2.12.1
0

Documentation for functions from previous versions

Configuration - Homing (technology object "Axis" V1.0)
Configure the parameters for active and passive homing in the "Homing" configuration window. 
The homing method is set using the "Mode" input parameter of the motion control instruction. 
Here, Mode = 2 means passive homing and Mode = 3 means active homing.

Homing switch input
Select the digital input for the homing switch from the drop-down list. The input must be 
interrupt-capable. The onboard CPU inputs and the inputs of an inserted signal board can be 
selected as inputs for the homing switch.

 

 Note

The digital inputs are set to a filter time of 6.4 ms by default.

When the digital inputs are used as a homing switch, this can result in undesired decelerations 
and thus inaccuracies. Depending on the homing velocity and extent of the homing switch, 
the home position may not be detected. The filter time can be set under "Input filter" in the 
device configuration of the digital inputs.

The specified filter time must be less than the duration of the input signal at the homing switch.
 

Permitting direction reversal after reaching the HW limit switch (active homing only)
Activate the check box to use the hardware limit switch as a reversing cam for the home position 
approach. The hardware limit switches must be activated for direction reversal. If the CPU 
firmware V1.0 is used, both hardware limit switches must be configured. If CPU firmware as 
of V2.0 is used, only the hardware limit switches in the approach direction must be configured.
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If the hardware limit switch is reached during active homing, the axis brakes at the configured 
deceleration (not with the emergency stop deceleration) and reverses direction. The homing 
switch is then sensed in reverse direction.

If the direction reversal is not active and the axis reaches the hardware limit switch during 
active homing, the home position approach is aborted with an error and the axis is braked at 
the emergency stop deceleration.

 

 Note

Use one of the following measures to ensure that the machine does not travel to a mechanical 
endstop in the event of a direction reversal:
● Keep the approach velocity low
● Increase the configured acceleration/deceleration
● Increase the distance between hardware limit switch and mechanical stop

 

Approach / homing direction (active and passive homing)
With the direction selection, you determine the "approach direction" used during active homing 
to search for the homing switch, as well as the homing direction. The homing direction specifies 
the travel direction the axis uses to approach the configured side of the homing switch to carry 
out the homing operation.

Refer to the table under "Homing switches" for the effect of the approach direction setting on 
passive homing.

Side of the homing switch (active and passive homing)
● Active homing

This is where you select whether the axis is homed on the low or high side of the homing 
switch.

 

  Note

Depending on the start position of the axis and the configuration of the homing parameters, 
the home position approach sequence can differ from the diagram in the configuration 
window.

 

● Passive homing
With passive homing, the traversing motions for purposes of homing must be implemented 
by the user via motion commands. The side of the homing switch on which homing occurs 
depends on the following factors:

– "Approach direction" configuration

– "Homing switch" configuration

– Current travel direction during passive homing

The table below presents details on the effect of factors:
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Influencing factors: Result:
Configuration

Approach direction
Configuration
Homing switch

Current travel direction Homing on
Homing switch

Positive "Bottom side" Positive direction Top side
Negative direction Bottom side

Positive "Top side" Positive direction Bottom side
Negative direction Top side

Negative "Bottom side" Positive direction Bottom side
Negative direction Top side

Negative "Top side" Positive direction Top side
Negative direction Bottom side

 

Velocity (active homing only)
In this field, specify the velocity at which the homing switch is to be searched for during the 
home position approach.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ approach velocity ≤ maximum velocity

Homing velocity (active homing only)
In this field, specify the velocity at which the axis approaches the homing switch for homing.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ Homing velocity ≤ Maximum velocity

Home position offset (active homing only)
If the desired home position deviates from the position of the homing switch, the home position 
offset can be specified in this field. 

If the value does not equal 0, the axis executes the following actions following homing at the 
homing switch:

1. Move the axis at the homing velocity by the value of the home position offset

2. Upon reaching the "home position offset", the axis is at the home position that was specified 
in input parameter "Position" of the "MC_Home" Motion Control instruction.

Limits (independent of the selected unit of measurement):

● -1.0e12 ≤ home position offset ≤ 1.0e12

Home position
The position configured in the Motion Control instruction "MC_Home" is used as the home 
position.
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List of ErrorIDs and ErrorInfos (technology objects V1.0)
The following table lists all ErrorIDs and ErrorInfos that can be indicated in motion control 
instructions. In addition to the cause of the error, remedies for eliminating the error are also 
listed:

Operating error with stop of the axis

ErrorID ErrorInfo Description Remedy
16#8000 Drive error, "Drive ready" failure
 16#0001 - Acknowledge error with instruction "MC_Reset"; 

provide drive signal; possibly restart command
16#8001 Low software limit switch has been tripped
 16#000E The position of the low software limit switch was 

reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the positive direction out of the range of the 
software limit switch16#000F The position of the low software limit switch was 

reached with the emergency stop deceleration
16#0010 The position of the low software limit switch was 

exceeded with the emergency stop deceleration
16#8002 High software limit switch has been tripped
 16#000E The position of the high software limit switch 

was reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the negative direction out of the range of the 
software limit switch16#000F The position of the high software limit switch 

was reached with the emergency stop 
deceleration

16#0010 The position of the high software limit switch 
was exceeded with the emergency stop 
deceleration

16#8003 Low hardware limit switch was approached
 16#000E The low hardware limit switch was approached. 

The axis was stopped with the emergency stop 
deceleration.
(During an active home position approach, the 
homing switch was not found)

Acknowledge the error for a released axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the positive direction out of the 
range of the hardware limit switch.

16#8004 High hardware limit switch was approached
 16#000E The high hardware limit switch was 

approached. The axis was stopped with the 
emergency stop deceleration.
(During an active home position approach, the 
homing switch was not found)

Acknowledge the error for a released axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the negative direction out of the 
range of the hardware limit switch.

16#8005 PTO/HSC are already being used by another axis
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ErrorID ErrorInfo Description Remedy
 16#0001 - The axis was configured incorrectly:

Correct the configuration of the PTO (Pulse Train 
Output) / HSC (High Speed Counter) and download 
it to the controller
More than one axis is to run with one PTO:
Another axis is using the PTO/HSC. If the current 
axis is to assume the control, the other axis must 
be disabled with "MC_Power" Enable = FALSE.
(see also Using multiple axes with the same PTO 
(Page 6093))

Operating error without stop of the axis

ErrorID ErrorInfo Description Remedy
16#8200 Axis is not released
 16#0001 - Release the axis; restart the command
16#8201 Axis has already been released by another "MC_Power" instance
 16#0001 - Enable the axis with only one "MC_Power" 

instruction 
16#8202 The maximum number of simultaneously active motion control commands was exceeded (maximum 

of 200 commands for all motion control technology objects)
 16#0001 - Reduce the number of simultaneously active 

commands; restart the command
A command is active if parameter "Busy" = TRUE 
in the motion control instruction.

16#8203 Axis is currently operated in "Manual control" (axis command table)
 16#0001 - Exit "Manual control"; restart the command
16#8204 Axis is not homed
 16#0001 - Home the axis with instruction "MC_Home"; restart 

the command
16#8205 The axis is currently controlled by the user program (the error is only displayed in the axis command 

table)
 16#0001 - Disable axis with instruction "MC_Power" and 

select "Manual control" again in the axis command 
table

16#8206 Technology object Axis not yet enabled
 16#0001 - Release the axis with instruction "MC_Power" 

Enable = TRUE or enable the axis in the axis 
command table.

16#8207 Command rejected
 16#0016 Active homing is running; another homing 

method cannot be started.
Wait for active homing to finish or abort the active 
homing with a motion command, for example, 
"MC_Halt". The other homing type can then be 
started.
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Block parameter error

ErrorID ErrorInfo Description Remedy
16#8400 Invalid value at parameter "Position" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the "position" value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8401 Invalid value at parameter "Distance" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the "Distance" value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8402 Invalid value at parameter "Velocity" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the "Velocity" value; restart the command

16#0008 Velocity is greater than the maximum velocity
16#0009 Velocity is less than the start/stop velocity

16#8403 Invalid value at parameter "Direction" of the Motion Control instruction
 16#0011 Invalid selection value Correct the selection value; restart the command
16#8404 Invalid value at parameter "Mode" of the Motion Control instruction
 16#0011 Invalid selection value Correct the selection value; restart the command

16#0015 Active/passive homing is not configured Correct the configuration and download it to the 
controller; release the axis and restart the command

16#0017 Axis reversal is activated at the HW limit switch, 
despite the fact that the hardware limit switches 
are disabled

● Activate the hardware limit switch using the tag 
<Axis>.Config.PositionLimits_HW.Active = 
TRUE, restart the command

● Correct the configuration and download it to the 
controller; release the axis and restart the 
command

16#8405 Invalid value at parameter "StopMode" of the Motion Control instruction
 16#0011 Invalid selection value Correct the selection value; release the axis again
16#8406 Simultaneous forward and backward jogging is not allowed
 16#0001 - Take steps to ensure that parameters 

"JogForward" and "JogBackward" do not have 
signal status TRUE simultaneously; restart the 
command.

16#8407 Switching the axis with Motion Control instruction "MC_Power" is only permitted after disabling the 
axis.

 16#0001 - Disable the active axis; it is then possible to switch 
to the other axis and release it.
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Configuration error

ErrorID ErrorInfo Description Remedy
16#8600 Parameter assignment of pulse generator (PTO is invalid
 16#000B Address is invalid Correct the configuration of the PTO (Pulse Train 

Output) and download it to the controller
16#8601 Parameterization of the high-speed counter (HSC) is invalid
 16#000B Address is invalid Correct the configuration of the HSC (High Speed 

Counter) and download it to the controller
16#8602 Invalid parameter assignment of "Enable output"
 16#000D Address is invalid Correct the configuration and download it to the 

controller
16#8603 Invalid parameter assignment of "Ready input"
 16#000D Address is invalid Correct the configuration and download it to the 

controller
16#8604 Invalid "Pulses per motor revolution" value
 16#000A Value is less than or equal to zero Correct the configuration and download it to the 

controller
16#8605 Invalid "Load distance per motor revolution" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#000A Value is less than or equal to zero
16#8606 Invalid "Start / stop velocity" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit
16#0007 The start/stop velocity is greater than the 

maximum velocity
16#8607 Invalid "Maximum velocity" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit

16#8608 Invalid "Acceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit

16#8609 Invalid "Deceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit

16#860A Invalid "Emergency stop deceleration" value
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ErrorID ErrorInfo Description Remedy
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit

16#860B Value for position of the low SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#0007 The position value of the low SW limit switch is 
greater than that of the high SW limit switch

16#860C Value for position of the high SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; release the axis again with 
instruction "MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#860D Invalid address of the low HW limit switch
 16#000C Address of falling edge is invalid Correct the configuration and download it to the 

controller16#000D Address of rising edge is invalid
16#860E Invalid address of the high HW limit switch
 16#000C Address of falling edge is invalid Correct the configuration and download it to the 

controller16#000D Address of rising edge is invalid
16#860F Invalid "home position offset" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8610 Invalid "approach velocity" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0008 Velocity is greater than the maximum velocity
16#0009 Velocity is less than the start/stop velocity

16#8611 Invalid "Homing velocity" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0008 Velocity is greater than the maximum velocity
16#0009 Velocity is less than the start/stop velocity

16#8612 Invalid address of the homing switch
 16#000C Address of falling edge is invalid Correct the configuration and download it to the 

controller16#000D Address of rising edge is invalid
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ErrorID ErrorInfo Description Remedy
16#8613 During active homing, direction reversal at the hardware limit switch is activated although the 

hardware limit switches are not configured
 16#0001 - Correct the configuration and download it to the 

controller

Internal errors

ErrorID ErrorInfo Description Remedy
16#8FFF Internal error
 16#F0** - POWER OFF and POWER ON the CPU

If this does not work, contact Customer Support. 
Have the following information ready:
● ErrorID
● ErrorInfo
● Diagnostic buffer entries

See also
Using multiple axes with the same PTO (Page 6093)
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Using online and diagnostics functions 12
12.1 Displaying accessible devices

Accessible devices
Accessible devices are all devices connected to an interface of the programming device / PC 
and that are turned on. Devices that allow only restricted configuration using the currently 
installed products or that cannot be configured at all can also be displayed.

Displaying accessible devices on an interface of the programming device / PC in the project tree   
To display accessible devices on a single interface of the programming device / PC, follow 
these steps:

1. Open the "Online access" folder in the project tree.

2. Click on the arrow to the left of the interface to show all the objects arranged below the 
interface.

3. Double-click on the "Update accessible devices" command below the interface.
All devices that are accessible over this interface are displayed in the project tree. When 
there is a large number of connected devices, the update process may take some time. 
You can see the progress of the update in the status bar. If you have found the desired 
device before the update is completed, you can cancel the update of accessible devices. 
To do this, click on the cross to the right of the progress bar.

Displaying accessible devices in a list   
To display the accessible devices on all available interfaces in an overview list, follow these 
steps:

1. Select the "Accessible devices" command in the "Online" menu.
The "Accessible devices" dialog is displayed.

2. Select the type of interface from the "Type of the PG/PC interface" drop-down list. The "PG/
PC interface" drop-down list then shows only the interfaces of the programming device / 
PC that match the selected interface type.

3. Select the required interface of the programming device / PC from the "PG/PC interface" 
drop-down list, for example an Industrial Ethernet adapter.
If no devices are available on an interface, an unbroken connecting line is displayed 
between the programming device / PC and the device. If devices are accessible, an 
unbroken connecting line is shown and the devices accessible on the selected interface of 
the programming device / PC are displayed in a list.
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4. If you have connected a new device in the meantime, click the "Refresh" button to refresh 
the list of accessible devices.

5. To go to a device in the project tree, select the device from the list of accessible devices 
and click the "Show" button.
The interface to which the selected device is connected is shown as selected in the project 
tree.

Displaying additional information about the accessible devices in the project tree
To display additional information on the accessible devices in the project tree, follow these 
steps:

1. Click on the arrow to the left of one of the accessible devices in the project tree.
All data available online, for example blocks and system data, is displayed for known 
devices. Objects that you cannot edit directly at this point are grayed out. If additional editing 
options are available for a device, for example, downloading using the shortcut menu, the 
device is shown in black text.

See also
Changing the device configuration online (Page 6145)
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12.2 Changing the device configuration online
You can assign parameters to some devices, preferably in small hardware setups, directly 
online. You do not need to create a project or have offline data to do this. In this way, you can 
quickly and easily change the device configuration. You do not need to compile the hardware 
configuration or perform a download. Depending on the device, either all changes become 
active immediately or they are written to the device only after confirmation.

Requirement
● The device must support online parameter assignment. You can learn whether or not your 

specific devices support this function in the device manual.

● The device must be connected to the PG/PC and available in the list of accessible devices.

Procedure  
To change the device configuration online, follow these steps:

1. Show the accessible devices on the interface via which the device is connected. To learn 
how to show the accessible devices, see the previous chapter "Showing accessible 
devices (Page 6141)".

2. Expand the device to display the lower-level elements.

3. Double-click the "Parametrize device" item.
A configuration page for the device opens in the work area.

4. Make all required settings.
With some devices, the new settings take effect immediately.

5. Optionally, depending on the device: Click on the "Upload to device" button.
The settings are transferred to the device.
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12.3 Connecting devices online

12.3.1 General information about online mode

Online mode
In online mode, there is an online connection between your programming device / PC and one 
or more devices.   

An online connection between the programming device/PC and the device is required, for 
example, for the following tasks:

● Testing user programs

● Displaying and changing the operating mode of the CPU

● Displaying and setting the date and time of day of the CPU

● Displaying module information

● Comparing blocks

● Hardware diagnostics

Before you can establish an online connection, the programming device/PC and the device 
must be physically or remotely connected. As an alternative, some devices support a 
simulation mode. In this case, a connection to the device is simulated via the PLCSIM virtual 
interface.

After establishing a connection, you can use the Online and Diagnostics view or the "Online 
tools" task card to access the data on the device. The current online status of a device is 
indicated by an icon to the right of the device in the project tree. You will find the meaning of 
the individual status icons in the relevant tooltip.   

 

 Note

Some online functions depend on the scope of the installed software or whether a project is 
open.

 

Standby or hibernation of the programming device / PC     
If the programming device / PC is changed to the standby or hibernation mode when there is 
an online connection, all online connections are terminated. When the programming device / 
PC wakes up from hibernation, the online connections are not automatically re-established.

Note that suddenly terminating an online connection can lead to loss of data or a connected 
device may interrupt program execution.

Performing an LED flash test
In many online dialogs you can perform an LED flash test, if the device connected online 
supports this feature. If you select the "Flash LED" check box, an LED flashes on the currently 
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selected device. This feature is useful, for example, when you are not sure which device in the 
hardware configuration corresponds to the station currently selected in the software.

Read any additional information and learn about the possible limitations to the LED flash test 
in the respective device documentation.

See also
View in online mode (Page 6147)

12.3.2 View in online mode

Online displays   
After the online connection has been established successfully, the user interface changes. If 
a device is unavailable, this is indicated by a symbol. The following figure shows a device 
connected online and the corresponding user interface:
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① The title bar of the active window gets an orange background as soon as at least one of 
the devices currently displayed in the editor has been successfully connected online. If 
one or more devices are unavailable, a symbol for a broken connection appears in the 
title bar of the editor.

② The title bars of inactive windows for the relevant station now have an orange line below 
them.

③ An orange, pulsing bar appears at the right-hand edge of the status bar. If the connection 
has been established but is functioning incorrectly, an icon for an interrupted connection 
is displayed instead of the bar. You will find more information on the error in "Diagnostics" 
in the Inspector window.

④ Operating mode symbols or diagnostics symbols for the stations connected online and 
their underlying objects are shown in the project tree. A comparison of the online and 
offline status is also made automatically. Differences between online and offline objects 
are also displayed in the form of symbols.

⑤ The "Diagnostics > Device information" area is brought to the foreground in the Inspector 
window.

Online connection abort
The online mode and its display are retained as long as at least one device is connected online. 
If the online connection to one or more devices aborts, the TIA Portal remains in online mode. 
The display of the TIA Portal changes to offline mode only when there is no longer an online 
connection to any device.

See also
General information about online mode (Page 6144)

Basics of project data comparison (Page 286)

12.3.3 Establishing and canceling an online connection

Requirement
At least one PG/PC interface is installed and is physically connected to a device, for example 
with an Ethernet cable. As an alternative, it is also possible to establish a virtual connection 
using PLCSIM.
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Go online   
To establish an online connection, follow these steps:

1. In the project tree, select one or mote devices to which you want an online connection to 
be established.

2. Select the "Go online" command in the "Online" menu.
If the device was already connected to a specific PG/PC interface, the online connection 
is automatically established to the previous PG/PC interface. In this case, you can ignore 
the following steps. If there was no previous connection, the "Go online" dialog opens.

3. Select the type of interface from the "Type of the PG/PC interface" drop-down list. The "PG/
PC interface" drop-down list then shows only the interfaces of the programming device / 
PC that match the selected interface type.

4. Select the required interface of the programming device / PC from the "PG/PC interface" 
drop-down list, for example an Industrial Ethernet adapter.

5. In the "Connection to subnet" drop-down list, select the interface via which the device is 
connected to the programming device or PC. In this case, a direct connection is established 
to the device, without a network node, for example, an interposed switch. Alternatively, 
select the appropriate subnet for the connection to the programming device or PC if the 
device can be accessed via a network node. If you do not know how the device is connected 
to the programming device or PC, choose the "Try all interfaces" entry.
If you selected an MPI or PROFIBUS subnet, the bus parameters configured in the 
programming device/PC interface are applied at this point.

6. If the device is accessible via a gateway, select the gateway that connects the two subnets 
involved in the "1st gateway" drop-down list.
If no devices are available on the interface, a broken connecting line is displayed between 
the programming device / PC and the device. If devices are accessible, an unbroken 
connecting line is shown and the devices accessible on the selected interface of the 
programming device/PC are displayed in the "Compatible devices in target subnet" list.

7. Optional: Click the "Update" button to update the "Compatible devices in target subnet" list.

8. Optional: Select the "Flash LED" check box to the left of the graphic to run an LED flash 
test. With this function, you can check that you have selected the correct device. The LED 
flash test is not supported by all devices. 

9. Select your device in the "Compatible devices in target subnet" table, and confirm your 
selection with "Go online".
The online connection to the selected target device is established.

Result   
After the online connection has been established, the title bars of the editors change to orange. 
An orange activity bar is also shown in the title bar of an editor and in the status bar. In the 
project tree, status symbols show the difference between online and offline objects.
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The connection path is stored for future connection attempts. It is no longer necessary to open 
the "Go online" dialog unless you want to select a new connection path.

 

 Note

If no accessible device is displayed, select a different network access for the PG/PC interface 
or check the settings of the interface.

 

Canceling an online connection   
To disconnect the existing online connection, follow these steps:

1. Select the device you want to disconnect from in the project tree.

2. Select the "Go offline" command in the "Online" menu.

See also
Connecting online with several devices (Page 6150)

View in online mode (Page 6145)

Assigning a temporary IP address (Page 6161)

Influence of user rights (Page 244)

12.3.4 Connecting online with several devices
You can establish an online connection to several devices at the same time without needing 
to select individual devices previously in the network view.

Requirement
● No device must be selected

● At least one PG/PC interface is installed and is physically connected to a device, for 
example with an Ethernet cable. As an alternative, it is also possible to establish a virtual 
online connection using PLCSIM or a remote connection.

Procedure  
To establish an online connection to several devices at the same time, follow these steps:

1. Select the project in the project tree.

2. Select the "Go online" command in the "Online" menu.
The "Select devices" dialog opens with a table of all available devices.

3. Select the devices to which you want to establish an online connection in the "Go online" 
column.

4. Click the "Go online" button.
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Result
Without any further prompt for confirmation, a connection is established to all selected devices 
if a connection was already established to the selected devices at least once. If there was no 
previous online connection, the "Go online" dialog opens. In this case, first configure the online 
connection as described in the section "Go online and disconnect online connection 
(Page 6146)".

See also
Establishing and canceling an online connection (Page 6146)

Assigning a temporary IP address (Page 6161)

12.3.5 Disconnecting online connections of multiple devices
You can disconnect the online connections to multiple devices at one time without needing to 
select individual devices beforehand in the network view.

Requirement
● No device is selected.

● There is currently an online connection to at least one device.

Procedure  
To terminate the online connections to multiple devices at one time, follow these steps:

1. Select the "Go offline" command in the "Online" menu.
The "Select devices" dialog opens with a table of all available devices.

2. Select the device for which you want to terminate the online connection in the "Go offline" 
column.

3. Click the "Go offline" button.

Result
The online connection to the all the selected devices is terminated.
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12.4 Backing up the software and hardware configuration of a device

12.4.1 Creating a backup of a device

Backing up the software and hardware configuration of an S7-300/400 CPU
If you have already downloaded a configuration to an S7-300/400 CPU, it is advisable to make 
a backup. You may have modified the configuration and want to test the new configuration. 
Before you download the new configuration to the CPU, you can create a backup of the current 
device state and then restore the current configuration at a later date. The backup is performed 
with the current values of the CPU. In the case of S7-400 CPUs with fail-safe function, the 
initial values are backed up.

You can create as many backups as you want and store a variety of configurations for a CPU. 
The backups are named with the name of the CPU and the time and date of the backup. You 
can find the backup in the project tree under the CPU in the "Online backups" folder.

The following figure shows an S7-319 CPU for which two backups were created:

See also
Restoring the software and hardware configuration of a device (Page 6153)

Backing up a device configuration (Page 6153)

General information on loading (Page 281)
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12.4.2 Backing up a device configuration
You can back up the configuration of a S7-300/400 CPU in the TIA Portal. So you can download 
and test a new configuration to a device without any risk. If needed, you can restore the initial 
configuration of the CPU.

Requirement
● The CPU must already be created in the project.

● It must be an S7-300/400 CPU.

● With S7-400 CPUs, a Flash EPROM Memory Card must be plugged.

● The CPU must be online. If there is no online connection, an online connection is 
established during the backup.

Procedure     
To create a backup of the current configuration of a CPU, follow these steps:

1. Select the CPU in the project tree.

2. Select the "Backup from online device" command in the "Online" menu.

Result:
A backup of the entire hardware configuration and software is created. The backup is stored 
in the project tree in the "Name of the CPU > Online backups" folder. The backup is assigned 
the name of the CPU with the time and date of the backup. You can rename the backup, but 
you cannot make any changes to the contents of the backup.

See also
Establishing and canceling an online connection (Page 6146)

Restoring the software and hardware configuration of a device (Page 6153)

Creating a backup of a device (Page 6150)

12.4.3 Restoring the software and hardware configuration of a device
If you have backed up the configuration of a device at an earlier point in time, you can transfer 
the backup back to the device. The saved configuration is then restored on the device.

Requirement
You must have previously configure the device and stored a backup of the device in the project.
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Procedure      
To restore older software and hardware state on a device, follow these steps:

1. Open up the folder of the device in the project tree to display the lower-level objects.

2. Open the "Online backups" folder.

3. Select the backup you want to restore.

4. In the "Online" menu, select the "Download to device" command.

– If you had previously established an online connection, the "Load preview" dialog opens. 
This dialog displays messages and proposes actions necessary for downloading.

– If you had not previously established an online connection, the "Extended download to 
device" dialog opens, and you must first select the interfaces via which you want to 
establish the online connection to the device.
See also: Establishing and terminating an online connection (Page 6146) 

5. Check the messages in the "Load preview" dialog, and select the actions in the "Action" 
column, if necessary.

 

  Note

Performing the proposed actions while the plant is in operation can cause serious bodily 
injury and property damage in the event of malfunctions or program errors.

 

6. As soon as loading becomes possible, the "Load" button is enabled.

7. Click the "Load" button.
The backup is transferred to the device and device is restored. The "Load results" dialog 
then opens. In this dialog, you can check whether or not the loading operation was 
successful and take any further action that may be necessary.

8. Click the "Finish" button.

See also
Creating a backup of a device (Page 6150)
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12.5 Configuring the PG/PC interface

12.5.1 Online access

Online access of the project
In the "Online access" folder of the project tree, you will find all active interfaces of your 
programming device/PC. Each interface icon provides you with information on the status of 
the interface. You can also display the accessible devices and display and edit the properties 
of an interface using the shortcut menu.   

The following figure shows the "Online access" folder in the project tree.

① "Online access" folder in the project tree
All interfaces installed in the programming device/PC are displayed in the "Online access" folder.

② Status display for the interfaces
The current status of an interface is indicated by an icon to the right of the name. You can see 
the meaning of the icon in the tooltip.

③ Updating the list of accessible devices.
This function is available for each hardware interface of the programming device/PC. Software 
interfaces, such as a remote connection, do not offer this function.

④ Devices connected via the respective interface with the programming device/PC
The type of the respective device and its status are displayed by the preceding icon.
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Displaying or updating accessible devices
You have the following options if you want to display all devices accessible online on your 
programming device/PC:

● Display of the accessible devices on a single interface of the programming device / PC in 
the project tree. In the project tree, you can also display additional information about the 
individual accessible devices.

● Display of the accessible devices of all interfaces in a list.

See also: Displaying accessible devices 

Overview of icons for accessible devices
The accessible devices are identified with an icon according to their type and status. The 
following is an overview of all icons and their meaning.

Icon for unidentified modules
This icon is displayed whenever the identification of a module is not yet complete or when the 
identification of a module was not successful, for example, because the required online data 
could not be read.
Icon for the following device types:
● PLCs
● SIMOCODE pro devices
● IE/PB links
● CPs of PC systems
● SCALANCE head modules
● S7-300 and S7-400 CPs
● PROFINET IO devices and PROFINET CPs
● SCALANCE modules and gateways that could not be identified
PROFINET IO devices, encoders, switchgear, sensors and identification systems that were 
replaced by similar devices because these could not be identified
Icon for the following device types:
● HMI devices
● PROFINET IO devices of the HMI type if these could not be identified and were therefore 

replaced by a similar device
PROFINET IO devices of the drive type that could not be identified and were therefore replaced 
by a similar device
PROFINET IO devices of the development kit and network components type that could not be 
identified and were therefore replaced by a similar device
PROFINET IO devices of the Teleservice adapter type that could not be identified and were 
therefore replaced by a similar device

See also
Displaying and modifying interface properties (Page 6157)
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12.5.2 Basics of assigning parameters for the PG/PC interface

Options for connecting to target systems 
If the devices of the project are connected via different subnets, you assign a suitable network 
access to each PG/PC interface to be able to establish online connections to the target 
systems. The following interfaces are automatically supported:

● MPI

● PROFIBUS

● Industrial Ethernet (ISO and TCP/IP)

You can make various settings for the interfaces. The following sections explain the parameter 
settings you can make.

 

 Note

Note that changes to interface parameters have a direct influence on the operating system 
and the programming device / PC. Remember that some parameter settings can only be 
changed if you have adequate user rights.

 

See also
Setting parameters for the Industrial Ethernet interface (Page 6158)

Setting parameters for the MPI and PROFIBUS interfaces (Page 6163)

12.5.3 Displaying and modifying interface properties

Introduction  
For each interface, you can display and, in some cases, modify properties, for example the 
network type, address, and status.

Procedure
To open the properties, follow these steps:

1. Right-click on the required interface below "Online access" in the project tree.

2. Select the "Properties" command from the shortcut menu.
A dialog containing the properties of the interface opens. On the left of the dialog, you will 
see the area navigation. You can view the current parameter settings in the individual 
entries in the area navigation and, if necessary, change them.
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12.5.4 Adding interfaces
You have the option of installing additional interfaces after installation of the TIA Portal.

Procedure 
To install an interface at a later time and add it to the TIA Portal, follow these steps:

1. Install or update the drivers in the operating system once you have installed the interface 
hardware.

2. Close the TIA Portal if it is still open.

3. Open the Windows control panel.

4. Open the entry "Setting the PG/PC Interface" in the Control Panel.
The "Setting the PG/PC Interface" dialog opens.

5. Make any necessary changes to the interface configuration and confirm them with "OK". 
You have to click "OK", even if you have not made any changes.

6. Restart the TIA Portal.

Result
The newly installed interface is now displayed in the project tree under the "Online access" 
folder.

12.5.5 Setting parameters for the Ethernet interface

12.5.5.1 Setting parameters for the Industrial Ethernet interface

Options in the parameter settings for the Industrial Ethernet interface  
When setting parameters for the Industrial Ethernet interface, you have the following options:

● Parameters dependent on the operating system
The Industrial Ethernet interface has parameters that are set in the operating system and 
are valid for all connected devices. These parameter settings are only displayed here, they 
can, however, be changed in the network settings of the operating system.

● Parameters that can be set in the software
 

  Note

Note that changes to interface parameters have a direct influence on the operating system 
and the programming device / PC. Remember that some parameter settings can only be 
changed if you have adequate user rights.
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Parameters for the Industrial Ethernet interface  
The following table contains an overview of the parameters of the Industrial Ethernet interface 
that are set by the operating system and can be changed by the user.

Parameter settings that cannot be changed Parameters that can be set
MAC address Fast acknowledge at the IE-PG access and for 

TCP/IP 
DHCP server activated/deactivated Timeout at the IE-PG access and for TCP/IP
APIPA activated/deactivated LLDP
IP address Additional, dynamic IP addresses for the network 

adapter
Subnet mask -
DNS addresses -
DHCP addresses -

See also
Basics of assigning parameters for the PG/PC interface (Page 6155)

Displaying operating system parameters (Page 6159)

Connecting the PG/PC interface to a subnet (Page 6160)

Setting parameters for the Ethernet interface (Page 6160)

Assigning a temporary IP address (Page 6161)

Managing temporary IP addresses (Page 6162)

Influence of user rights (Page 244)

12.5.5.2 Displaying operating system parameters
The Ethernet interface is part of the operating system. All parameters of the network adapter 
can therefore be adapted in the network settings of the operating system.

You can display the following parameters in the software:

● Physical address of the network adapter

● Assignment of the IP address by a DHCP server activated or deactivated

● Assignment of a private IP address by the operating system activated or deactivated

● Current static IP address

● Assigned subnet mask

● DNS addresses

● DHCP addresses

If you want to modify the parameter settings, please refer to the documentation of the operating 
system or the network adapter.
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Displaying current parameters of the Ethernet interface  
To display the current parameters of the Ethernet interface, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > Industrial Ethernet" in the area navigation.

See also
Setting parameters for the Ethernet interface (Page 6160)

12.5.5.3 Connecting the PG/PC interface to a subnet
If you have created several subnets, you can specify the subnet to which the Ethernet interface 
is connected.

Procedure 
To select the subnet to which the Ethernet interface is connected, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Assignment" and select the subnet to which you want to connect the 
Ethernet interface of the programming device / PC in the "Connection to subnet" drop-down 
list.

4. Close the dialog with "OK".

12.5.5.4 Setting parameters for the Ethernet interface
You can adapt some parameter settings relating to the network protocol directly in the software.

Requirement
You must have adequate user rights.

See also: Influence of user rights (Page 244).

Procedure   
To change parameter settings relating to the network protocol, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.
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3. Select "Configurations > IE-PG access" to adapt the protocol settings relevant to network 
management.

– Select the "Fast acknowledge" check box to achieve faster reaction times with smaller 
network packets.

– From the "Timeout" drop-down list, select the maximum time that can elapse before a 
network node is detected.

4. To activate the LLDP protocol and discover the network topology more accurately, set the 
"LLDP active" check box in "Configurations > LLDP".

5. Select "Configurations > TCP/IP" to adapt the TCP/IP protocol for network traffic during 
runtime.

– Select the "Fast acknowledge" check box to achieve faster reaction times with smaller 
network packets.

– From the "Timeout" drop-down list, select the maximum time that can elapse before 
there is a timeout during communication with a network node.

See also
Influence of user rights (Page 244)

Displaying operating system parameters (Page 6157)

12.5.5.5 Assigning a temporary IP address

Adding a dynamic IP address   
If the IP address of a device is located in a different subnet from the IP address of the network 
adapter, you will first need to assign an additional IP address with the same subnet address 
as the device. Only then is communication between the device and the programming device / 
PC possible.

The assignment of an additional temporary IP address is also proposed automatically if you 
want to perform an online action and the current IP address of the programming device/PC is 
not yet in the correct subnet.

A temporarily assigned IP address remains valid until the next time the programming device/
PC is restarted or until you delete it manually.

 

 Note

You require adequate permissions to be able to assign a temporary IP address.

See also: Influence of user rights (Page 244) 
 

See also
Managing temporary IP addresses (Page 6162)
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12.5.5.6 Managing temporary IP addresses
If the IP address of a device is located in a different subnet from the current static IP address 
of the network adapter, the network adapter temporarily assigns a suitable IP address from 
the subnet of the device.

You can display all temporarily assigned addresses and delete them. Note that IP addresses 
that you manually assigned in the operating system are not displayed in the TIA Portal.

Requirement
To delete, you require adequate permissions.

Procedure  
To display and delete temporarily assigned addresses, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > IE-PG access".
A table with the assigned IP addresses is displayed.

4. Click the "Delete project-specific IP addresses" button to delete all the IP addresses at one 
time.

See also
Influence of user rights (Page 244)

12.5.5.7 Resetting the TCP/IP configuration
If you have changed the TCP/IP protocol settings, you can reset them to the defaults. 

Procedure
To restore the TCP/IP configuration to the default settings, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > TCP/IP".

4. Click the "Standard" button to reset all the settings.
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12.5.6 Setting parameters for the MPI and PROFIBUS interfaces

12.5.6.1 Setting parameters for the MPI and PROFIBUS interfaces

Possible parameter settings for the MPI and PROFIBUS interfaces
The following parameter settings can be made for the MPI and PROFIBUS interfaces:

● Automatic configuration: You can use automatic detection functions to find out whether a 
device is connected to the PG/PC interface over PROFIBUS or MPI.

● Selecting a default configuration for PROFIBUS or MPI that can be adapted later.

Device- and network-related settings for MPI and PROFIBUS
You can set device- and network-related parameters for MPI and PROFIBUS interfaces. 
Device-related parameters are local settings for the interface. Network-related parameters, on 
the other hand, must match up on all devices.

MPI interface parameters you can modify  
You can adapt the following default parameters for the MPI interface:

Device-related parameters Network-related parameters
Is the only master Highest address
Own address Transmission rate
Timeout  

PROFIBUS interface parameters you can modify  
You can adapt the following default parameters for the PROFIBUS interface:

Device-related parameters Network-related parameters
Is the only master Highest address
Own address Transmission rate
Timeout Profile
 Bus parameters
 Number of masters on bus
 Number of slaves on bus

See also
Basics of assigning parameters for the PG/PC interface (Page 6155)
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12.5.6.2 Setting MPI or PROFIBUS interface parameters automatically

Setting up automatic bus parameter detection  
If you select an interface with automatic detection of the bus parameters (for example CP 5611 
(Auto)), you can connect the programming device or PC to MPI or PROFIBUS without needing 
to set bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute.

Requirement
● Masters that distribute bus parameters cyclically are connected to the bus.

● In PROFIBUS networks, the cyclic distribution of the bus parameters must be enabled.

Procedure
To enable automatic bus parameter detection, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Configurations > Active configuration" and select the setting "Automatic 
protocol detection".

4. Go to "Configurations > Auto configuration > Local settings" and select the address of the 
PG/PC interface in the "Own address" drop-down list.

5. If you then want to display the current bus settings, click the "Network detection" button.

See also
Setting parameters for the MPI interface (Page 6164)

Setting parameters for the PROFIBUS interface (Page 6166)

12.5.6.3 Setting parameters for the MPI interface

Changing the parameter settings of the MPI interface  
The network-related parameters and bus parameters for the MPI network can be adapted. 
You should first select a default setting and then adapt this to the specific situation.
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Setting defaults for the MPI interface
To adapt the parameters of the MPI interface, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Assignment" and select the subnet with which you want to connect the 
interface in the "Connection to subnet" drop-down list.

4. Under "General > Configuration", select a default for the device and network-related 
parameters. The defaults are suitable for most configurations. Select one of the following 
settings:

– Automatic protocol detection
You can connect the programming device to MPI or PROFIBUS without having to set 
bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute. Prerequisite for the automatic detection is a 
connection to the bus master, which distributes the bus parameters cyclically. With 
PROFIBUS subnets, cyclic distribution of bus parameters may not be deactivated 
(default PROFIBUS network setting).

– MPI
The "MPI" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

– PROFIBUS
The "PROFIBUS" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

Changing the default parameter settings
To adapt the default settings to your requirements, change the parameter setting where 
necessary in "Configurations > MPI".

You can set the following device-related parameters:
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● Is only master
An additional verification function to prevent bus disruptions when connecting the PG/PC 
to the network is disabled because the programming device or PC is the only master on 
the bus.

– Do not enable this option unless you have only connected slaves to your programming 
device or PC.

– If the "Is only master" check box is enabled, it is not possible to identify the directly 
connected device in the "Accessible devices" window.

● Own address
This setting relates to the programming device or PC on which you call up the parameter 
settings of the interface. Set the local device address of your programming device or PC 
here.

– This address must be unique throughout the network.

– The programming device or PC is addressed using this address in the MPI network.

● Check
This enables an additional safety function to prevent bus disruptions when connecting the 
PG/PC to the network. The driver checks whether the local address is already being used 
by another station. Active as well as passive stations are taken into consideration in this 
case. The driver monitors this on the PROFIBUS. The connection of the PG/PC to the 
network will take longer with the automatic check. To use the check, the driver must support 
the function. Furthermore, the "Is only master" option must not be selected.

● Timeout
Set a higher timeout value if, for example, you have problems with long response times on 
the network.

You can set the following network-related parameters:

● Highest address:
Select the configured highest device address. Make sure that the same highest device 
address is set for all devices of a PROFIBUS or MPI network.

● Transfer rate:
Here, you select the transmission speed to be used on the MPI network.

See also
Setting MPI or PROFIBUS interface parameters automatically (Page 6162)

12.5.6.4 Setting parameters for the PROFIBUS interface

Changing the parameter settings of the PROFIBUS interface  
The network-related parameters and bus parameters for the PROFIBUS network can be 
adapted more precisely. You should first select a default setting and then adapt this to the 
specific situation.
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Setting defaults for the PROFIBUS interface
To adapt the parameters of the PROFIBUS interface, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Assignment" and select the subnet with which you want to connect the 
interface in the "Connection to subnet" drop-down list.

4. Under "General > Configuration", select a default for the device and network-related 
parameters. The defaults are suitable for most configurations. Select one of the following 
settings:

– Automatic protocol detection
You can connect the programming device to MPI or PROFIBUS without having to set 
bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute. Prerequisite for the automatic detection is a 
connection to the bus master, which distributes the bus parameters cyclically. With 
PROFIBUS subnets, cyclic distribution of bus parameters may not be deactivated 
(default PROFIBUS network setting).

– MPI
The "MPI" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

– PROFIBUS
The "PROFIBUS" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

Changing the default parameter settings
To adapt the default settings to your requirements, change the parameter setting where 
necessary in "Configurations > PROFIBUS".

You can set the following device-related parameters:
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● Is only master
An additional verification function to prevent bus disruptions when connecting the PG/PC 
to the network is disabled because the programming device or PC is the only master on 
the bus.

– Do not enable this option unless you have only connected slaves to your programming 
device or PC.

– If the "Is only master" check box is enabled, it is not possible to identify the directly 
connected device in the "Accessible devices" window.

● Own address
This setting relates to the programming device or PC on which you call up the parameter 
settings of the interface. Set the local device address of your programming device or PC 
here.

– This address must be unique throughout the network.

– The programming device or PC is addressed using this address in the PROFIBUS 
network.

● Check
This enables an additional safety function to prevent bus disruptions when connecting the 
PG/PC to the network. The driver checks whether the local address is already being used 
by another station. Active as well as passive stations are taken into consideration in this 
case. The driver monitors this on the PROFIBUS. The connection of the PG/PC to the 
network will take longer with the automatic check. To use the check, the driver must support 
the function. Furthermore, the "Is only master" option must not be selected.

● Timeout
Set a higher timeout value if, for example, you have problems with long response times on 
the network.

You can set the following network-related parameters:

● Highest address:
Select the configured highest device address. Make sure that the same highest station 
address is set for all devices of a PROFIBUS network.

● Transfer rate:
Here, you select the transmission speed to be used on the PROFIBUS network.

● Profile:
You have a choice of four alternatives for the PROFIBUS settings. "DP", "Standard" and 
"Universal (DP/FMS)" are predefined settings that you cannot change. If you select "User-
defined", you can adapt the bus parameters yourself.

– If you have selected "User-defined", go to "Configurations > PROFIBUS > Bus 
parameters" in area navigation.

– If you have selected one of the defaults (DP, Standard or Universal (DP/FMS)), you 
should select the "Include" check box in "Configurations > PROFIBUS > Bus parameters 
> Additional parameters". You can then set the number of masters and slaves on the 
bus. This allows a more precise calculation of the bus parameters and potential bus 
disruptions can be prevented. The option cannot be selected with a user-defined profile.
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See also
Overview of the bus parameters for PROFIBUS (Page 6169)

Setting MPI or PROFIBUS interface parameters automatically (Page 6162)

12.5.6.5 Overview of the bus parameters for PROFIBUS

Introduction
The PROFIBUS subnet will only function problem-free if the parameters for the bus profile are 
matched to one another. You should therefore only change the default values if you are familiar 
with how to configure the bus profile for PROFIBUS. 

It may be possible for the bus parameters to be adjusted depending on the bus profile. The 
offline values of the bus parameters are always shown even if you are online and linked to the 
target system.

The displayed parameters are valid for the entire PROFIBUS subnet.

Meaning of the individual parameters
● Tslot: Wait-to-receive time (slot time)

The wait-to-receive time (slot time) defines the maximum time the sender will wait to receive 
a response from the addressed partner.

● Max. Tsdr: Maximum protocol processing time (max. station delay responder)
The maximum protocol processing time defines the time after which the responding device 
must have processed the protocol.

● Min. Tsdr: Minimum protocol processing time (min. station delay responder)
The minimum protocol processing time specifies the minimum time required by the 
responding device to process the protocol.

● Tset: Trigger time (setup time)
The trigger time is the time that may lapse between the reception of a data frame frame 
and the reaction to it.

● Tqui: Quiet time for modulator
The quiet time for modulator specifies the time required to change from sending to receiving.

● GAP factor: GAP update factor (GAP factor)
The GAP factor specifies the number of token rotations before a new device is included in 
the token ring.

● Retry limit: Maximum number of repeated call attempts (retry limit)
This parameter defines the maximum number of attempts made to reach a device.

● Trdy: Ready time
The ready time is the time for an acknowledgment or response.

● Tid1: Idle time 1
Idle time 1 specifies the delay time after receiving a response.

● Tid2: Idle time 2
Idle time 2 specifies the delay time after sending a call without a response.
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● Ttr: Target rotation time
The target rotation time is the maximum time made available for a token rotation. During 
this time, all active devices (masters) receive the token once. The difference between the 
desired token round-trip time and the actual token round-trip time decides how much time 
is left for masters to send data frames to the slaves.
As the minimum target rotation time (Ttr), select a value = 5000 times the HSA (Highest 
Station Address).

● Watchdog: Watchdog
The watchdog time specifies the time after which a device must be addressed. 
As the minimum watchdog time, select a value = 6250 times the HSA.

 

 Note

If you want to create a user-defined bus profile, please note that the minimum target rotation 
time (Ttr) should be 5000 times the HSA (highest PROFIBUS address). The minimum 
watchdog time should also be 6250 times the HSA.

 

See also
Setting parameters for the PROFIBUS interface (Page 6164)

12.5.6.6 Resetting the MPI or PROFIBUS configuration
If you have changed the MPI or PROFIBUS protocol settings, you can reset them to the 
defaults.  

Procedure
To restore the MPI or PROFIBUS configuration to the default settings, follow these steps:

1. Select the MPI/PROFIBUS interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > MPI" or "Configurations > PROFIBUS", depending on the interface 
properties you want to reset.

4. Click the "Standard" button to reset all the settings.
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12.6 Using the trace and logic analyzer function

 Preface
 

Purpose of the documentation
The diagnostics options available with the trace and logic analyzer function are described in 
this documentation. Depending on the device used, the recording options can vary.

Required basic knowledge
In order to understand this documentation, the following knowledge is required:

● General knowledge in the field of automation

● Knowledge about the use of Windows-based computers

● S7-1200/1500 CPUs

– Knowledge of working with the SIMATIC industrial automation system

– Knowledge of working with STEP 7 >= V12.0

● SINAMICS G120

– Knowledge of working with the drive

Validity of the documentation
This documentation applies to all products of the S7-1200, S7-1500 and SINAMICS G120 
product family.

Conventions
This documentation contains pictures of the devices described. The pictures may differ slightly 
from the devices supplied.

Please also observe notes marked as follows:
 

 Note

A note contains important information on the product described in the documentation, on the 
handling of the product and on the section of the documentation to which particular attention 
should be paid.
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Further support
● The range of technical documentation for the individual SIMATIC products and systems is 

available on the Internet (http://www.siemens.com/simatic-tech-doku-portal).

● The online catalog and the online ordering system is available on the Internet (http://
mall.automation.siemens.com).

12.6.1 Description

12.6.1.1 Supported hardware
The following devices (Page 6197) support the trace and logic analyzer function:     

● SIMATIC S7-1200 CPUs (as of firmware version V4.x)

● SIMATIC S7-1500 CPUs

● SINAMICS G120

12.6.1.2 Recording of measured values with the trace function

Introduction
The trace and logic analyzer function can be called in the device folder in the project navigator 
under the name "Traces" (Page 6175).

You record device tags and evaluate the recordings with the trace and logic analyzer function. 
Tags are, for example, drive parameters or system and user tags of a CPU. The maximum 
recording duration is limited by the memory size. How much memory is available for the 
recording depends on the hardware used. 

The recordings are saved on the device and, when required, can be read out with the 
engineering system (ES) and saved permanently. The trace and logic analyzer function is 
therefore suitable for monitoring highly dynamic processes. The recorded values are 
overwritten when "Installed traces" is activated again.

Depending on the device (Page 6197) used, the recording options can vary.

A quick start (Page 6185) for working with the trace and logic analyzer function can be found 
in the Operation section.

The following figure shows the method of operation of the "Traces":
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① Trace configuration on the programming device (PG) in the TIA Portal
You can specify the signals to be recorded, the duration of the recording and the trigger 
condition in the trace configuration. The trace configuration depends on the device and is 
described at the respective device (Page 6197).

② Transferring the trace configuration from the PG to the device
You can transfer the complete trace configuration (Page 6192) to the device when an online 
connection is established.

③ Waiting for the recording
If the installed trace configuration is activated (Page 6192), then the recording is performed 
independently of the PG. The recording is started as soon as the trigger condition is satisfied.

④ Transferring the measurement from the device to the PG
The saving of the measurement in the project (Page 6194) stores the measurement in the 
opened project of the TIA Portal.

⑤ Evaluating, managing and saving the measurement
Numerous options are available for the evaluation of the measurement in the curve diagram 
and in the signal table (Page 6193). Various display types are possible, for example, a bit 
representation for binary signals. 
Measurements can also be exported and imported as a file.
With the saving of the project (Page 6194) in the TIA Portal, the measurements transferred to 
the project are also saved.

12.6.1.3 Trace configuration, recording and measurement
This section explains the meaning of the terms: trace configuration, recording and 
measurement.
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Trace configuration
You can make the following settings in the trace configuration :

● Signals to be recorded

● Trigger condition

● Duration of the recording

Recording
A recording is performed in the device. There is only one recording for each installed trace 
configuration. When a new recording is started, the old recording is overwritten.

An installed recording is not retentive (it is lost when the device is switched off/on) and can be 
saved permanently in the project as a measurement.

Installed traces
An installed trace  consists of a trace configuration and optionally a recording. The 
maximum number of installed traces depends on the device.

The status of an installed trace can be viewed online.

Measurement
A measurement  always consists of a trace configuration with an associated recording. If 
an installed trace contains a recording, it can be saved in the project as a measurement. 

The recording of a measurement can be viewed offline.

12.6.1.4 Data storage
The trace handling and the curve diagram also enable the transfer of the trace configuration 
and the viewing of the recording.      

The following figure is a schematic diagram of the data storage:
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 Note
Saving the trace configuration and measurement

You save the trace configuration and measurement with the project in the TIA Portal.

If you close the project without saving, the trace configurations and the measurements 
transferred to the project are discarded. The trace editor can be closed and reopened without 
loss of data until the project is closed.

 

 

12.6.2 Software user interface
 

Display areas
The user interface of the trace and logic analyzer function consists of several areas.   

The example in the figure below shows the division of the user interface in the TIA Portal:
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1 Project navigator
 Working area
2  Title bar of the working area

Shows the device to which the current display belongs.
3a  Toolbar of the trace handling (Page 6180) 

Selection of recordings for display in the curve diagram and buttons for activation/
deactivation of installed traces. 

4  Toolbar of the curve diagram (Page 6177) 
Tools for editing the measurement and for adapting the display in the curve diagram

5  Curve diagram (Page 6177) 
Display of the recorded values 

6  Signal table (Page 6179) 
Signals of the measurement

3b  Trace handling (Page 6180) 
Creation of new trace configurations and the handling of the measurements.
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 Device-specific area (see Devices (Page 6197))
7  Properties area in the Inspector window

Configuration dialog boxes for the recording duration, trigger condition and signal 
selection.

12.6.2.1 Project navigator
If a device supports the trace and logic analyzer function,  "Traces" is offered for selection 
in the project navigator below the device.  

Double-clicking  "Traces" opens the trace editor.

12.6.2.2 Working area

User interface - curve diagram
The curve diagram displays the selected signals of a recording. Bits are shown in the lower 
diagram as a bit track. Adjust the display of the signals in the signal table (Page 6179) and 
with the aid of the toolbar of the curve diagram.     

Setting options and displays in the curve diagram
The following figure shows an example of the display in the TIA Portal:

The scale in the diagram applies to the selected (highlighted in gray) signal in the legend. The 
legend can be moved laterally with the mouse.
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Shortcut menu commands
The following table shows the shortcut menu commands in the curve diagram:

Shortcut menu command Description
"Save diagram as image" Exports the current display as a bitmap.
"Copy image to clipboard" Copies the current display to the clipboard.
"Center measurement cursors" Positions the activated measurement cursors at a central point in 

the current display.

Toolbar of the curve diagram
Tools are available for adapting the display via buttons.

The following table shows the functions of the buttons:

Icon Function Description
Undo zoom Undoes the zoom function executed last. 

If several zoom functions have been executed, they can 
be undone step-by-step.

Redo zoom Redoes the last undone zoom function. If several zoom 
functions have been undone, they can be redone step-
by-step.

Move view Moves the display with the mouse button pressed.

Zoom selection Selection of an arbitrary range with the mouse button 
pressed. The display is scaled to the range selection.

Vertical zoom selection Selection of a vertical range with the mouse button 
pressed. The display is scaled to the range selection.

Horizontal zoom selection Selection of a horizontal range with the mouse button 
pressed. The display is scaled to the range selection.

Display all Scaling of the display so that the entire time range and 
all values are displayed.

Zoom in Enlargement of the display. The ranges of the time axis 
and value axis are reduced every time the button is 
clicked. The curves are displayed larger.

Zoom out Reduction of the display. The ranges of the time axis 
and value axis are increased every time the button is 
clicked. The curves are displayed smaller.

Scale automatically Scaling of the display so that all values are displayed 
for the currently displayed time range.

Arrange in tracks Arranges signals one beneath the other without 
overlaps.

Display samples The samples are displayed as small circles on the 
curves.

Unit changeover of the time axis Changeover of the unit between time and cycles.
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Icon Function Description
Display vertical measurement 
cursors

Display of the vertical measurement cursors.
The vertical position of the two measurement cursors 
can be moved with the mouse. The associated 
measured values and the difference of the 
measurement cursors corresponding to the position are 
shown in the signal table.

Display horizontal 
measurement cursors

Display of the horizontal measurement cursors.

Display chart legend Display of the chart legend in the curve diagram.

Align the chart legend to the left Display of the chart legend on the left side of the curve 
diagram.

Align the chart legend to the 
right

Display of the chart legend on the right side of the curve 
diagram.

Change background color Changeover between various background colors.

User interface - signal table
The signal table lists the signals of the selected measurement and provides setting options for 
some properties. If recording data of "Installed traces" is displayed and the settings are 
changed in the signal table, these settings are retained until there is a change to the offline 
mode.   

Setting options and displays in the signal table
The following figure shows an example of the display in the TIA Portal:

The following table shows the settings and displays of the recorded signals:

Column Description
Static display of the signal icon
Selection for the display in the curve diagram

"Name" Display of the signal name
A click on the name of a displayed signal updates the scale in the curve diagram.
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Column Description
 Open bit selection

Individual bits can also be selected for the following data types for display as a bit 
track in the lower curve diagram.
● Byte, Word, DWord, LWord
● SInt, USInt, Int, UInt, DInt, UDInt, LInt, ULInt
Example of an opened bit selection for the DWORD data type:

Select or deselect the relevant bit for display by clicking the  icon.
"Data type" Display of the data type
"Address" Display of the address (not for symbolic tags)
"Color" Display and setting option for the color of the signal
"YMin" Enter the minimum value for the scaling of the signal
"YMax" Enter the maximum value for the scaling of the signal
"Y(t1)" Display of the value at the position of the first measurement cursor
"Y(t2)" Display of the value at the position of the second measurement cursor
"ΔY" Display of the value difference between the first and the second measurement 

cursor
"Unit" Display of the unit (e.g. for technology objects)
"Comment" Display and input option for a comment about the signal

Shortcut menu commands
The following table shows the shortcut menu commands of the signal table:

Shortcut menu command Description
"Cut" Cannot be selected.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Cannot be selected.
"Show/hide signal" Shows/hides the signal in the curve diagram.
"Bring to foreground" Displays the selected signal in the foreground. The other signals 

are hidden.

User interface - trace management
The trace handling enables the configuration and handling of trace configurations.   
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Setting options and displays in the trace handling
The following figure shows an example of the display in the TIA Portal:

  
① Trace configuration
② Recording (recorded values)

Toolbar of the trace handling
A recording can be selected for display via a drop-down list and buttons, and activated or 
deactivated.

The example in the figure below shows the toolbar of the trace handling

The following table describes the functions of the buttons:

Icon Description
Selection for the display in the curve diagram
A click on the icon shows/hides the recording in the curve diagram.
Selection of an "Installed trace" or a "Measurement" for display in the curve diagram

Activation of the recording
The button is available for "Installed traces".
Deactivation of the recording
The button is available for "Installed traces".

"Trace configurations" table   
The table contains all the trace configurations of the project that can be transferred to the 
device. Each trace configuration contains the tags to be recorded and the required recording 
settings. The data is displayed in offline and online mode.

The following table shows the settings and displays:
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Column Icon Description
- Display of the icon for the trace configuration

Incorrect trace configurations are shown with an additional red 
icon and cannot be transferred to the device. Check the device-
specific configuration in the Inspector window.
Double-clicking the icon brings the Inspector window with the 
device-specific properties to the foreground.

"Trace configuration" - Name of the trace configuration.
The name can be changed after double-clicking the field.

"Comment" - Input field for a comment.

Shortcut menu commands

The following table shows the shortcut menu commands of the "Trace configurations" table:

Shortcut menu command Description
"Cut" Removes the selected lines and moves them to the clipboard.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Pastes the contents of the clipboard to the selected line. The existing 

contents are overwritten.
"Delete" Deletes the selected lines from the table.
"Rename" Switches the selected cell to the editing mode.
"Transfer trace configuration to 
device"

Transfers the trace configuration selected in the "Trace 
configurations" table to the device.
The button is active when all the required settings in the device-
specific configuration have been configured correctly in the 
Inspector window and there is an online connection.

"Export trace configuration" Exports a trace configuration as a file with the "*.ttcfg" file extension.
"Import trace configuration" Imports a trace configuration from a file.
"Properties" Brings the Inspector window with the device-specific properties to 

the foreground.

"Installed traces" table   
The table contains the trace configurations already transferred to the device and their current 
operating mode. The data is displayed in the online mode.

The following table shows the settings and displays:

Column Icon Description
- Static display of the online icon

Double-clicking the icon brings the Inspector window with the device-
specific properties to the foreground.
Selection for the display in the curve diagram
A click on the icon shows/hides the recording in the curve diagram.

"Installed traces" - Name of the trace configuration.
"Active" Activation of the recording and feedback of the status.

The checkbox is reset at the end of the recording.
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Column Icon Description
"Status" - Status display of the trace configuration

The following states are possible:
● "Installing"
● "Waiting for trigger"
● "Recording"
● "Recording finished"
● "Aborted"
● "Fault"

"Comment" - Display of the trace configuration comment

Shortcut menu commands

The following table shows the shortcut menu commands of the "Installed traces" table:

Shortcut menu command Description
"Cut" Removes the selected lines and moves them to the clipboard.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Cannot be selected.
"Delete" Deletes the selected lines from the table.
"Rename" Cannot be selected.
"Add to trace configurations" Transfers the installed trace configuration to the "Trace 

configurations" table.
"Add to measurements" Adds the selected "Installed trace" to the "Measurements" table.
"Activate" Activates the recording and shows the state in the table
"Show/hide in curve diagram" Shows/hides the recording in the curve diagram.
"Properties" Brings the Inspector window with the device-specific properties to 

the foreground.

"Measurements" table   
The table contains the trace configurations with recordings. The data is displayed in offline 
and online mode.

Measurements can also be exported and imported, see Exporting and importing 
measurements (Page 6194).

The following table shows the settings and displays:

Column Icon Description
- Static display of the icon for a measurement

Double-clicking the icon brings the Inspector window with the device-
specific properties to the foreground.
Selection for the display in the curve diagram
A click on the icon shows/hides the recording in the curve diagram.

"Measurements" - Name of the measurement
The name can be changed after double-clicking the field.
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Column Icon Description
"Trigger time" - The meaning of the trigger time depends on the device

Examples:
● SIMATIC S7-1200/1500 CPUs

The absolute time of the controller is entered at the start of the 
recording.

● SINAMICS G120
The transfer time is entered with the transfer of the trace 
configuration to the device.

"Comment" - Input field for a comment.

Shortcut menu commands

The following table shows the shortcut menu commands of the "Measurements" table:

Shortcut menu command Description
"Cut" Removes the selected lines and moves them to the clipboard.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Cannot be selected.
"Delete" Deletes the selected lines from the table.
"Rename" Switches the selected cell to the editing mode.
"Add to trace configurations" Transfers the trace configuration of the measurement to the "Trace 

configurations" table.
"Show/hide in curve diagram" Shows/hides the recording in the curve diagram.
"Export measurement" Exports a measurement as a file with the "*.ttrec" or "*.csv" file 

extension.
"Import measurement" Imports a measurement from a file with the "*.ttrec" file extension.
"Properties" Brings the Inspector window with the device-specific properties to 

the foreground.

Buttons
The following table shows the functions available via buttons:

Icon Description
Button to transfer a selected trace configuration to the device
The selected trace configuration in the "Trace configurations" table is transferred to the 
device.
The button is active when all the required settings in the device-specific configuration 
have been correctly configured in the Inspector window and there is an online connection.
Button to transfer a selected trace configuration from the device 
The trace configuration selected in the "Installed traces" table is transferred from the 
device to the "Trace configurations" table.
Button to transfer a selected measurement from the device to the project.
The selection in the "Installed traces" table is added to the "Measurements" table.
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12.6.2.3 Device-specific area
The device-specific area enables the trace configuration.

The signals to be recorded and the trigger condition are specified here. These and other 
configuration options are described in the device-specific part (Page 6197) for the individual 
devices.

12.6.3 Operation

12.6.3.1 Quick start
This description shows the steps for a recording of the S7-1500 CPU as an example. The 
displayed settings can differ depending on the device.  

Requirement
A device is configured that supports the trace and logic analyzer function.

Calling the trace editor
The following figure shows the project navigator with "Traces" below the device:

Procedure:
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1. Open the trace editor by double-clicking the "Traces" entry.

Creating a trace configuration
The following figure shows the "Trace configurations" table:

Procedure:

1. Enter the name of the trace configuration in the "Trace configurations" table.

Selecting signals
The following figure shows the configuration of the signals:

Procedure:
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1. Select the signals to be recorded in the "Signals" area of the Inspector window.

Configuring the recording cycle     
The following figure shows the configuration of the sampling:

Procedure:

1. Configure the sampling.

Configuring the trigger
The following figure shows the configuration of the trigger:

Procedure:

1. Configure the trigger mode and the condition for the selected trigger.

Transferring the trace configuration to the device
The following figure shows the trace handling in online mode:

Procedure:
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1. Check whether the configuration is correct based on the icon in the "Trace configurations" 
table.
The  icon indicates a correct trace configuration.
The  icon indicates a faulty trace configuration.
Only correct trace configurations can be transferred to the device.

2. Establish an online connection to the device.

3. Select the trace configuration in the "Trace configurations" table and transfer it to the device 
with the  button.

Activating a recording
The following figure shows the trace handling with an installed trace configuration:

Procedure:
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1. Click the checkbox in the "Active" column in the "Installed traces" table.

Displaying the recording
The following figure shows the curve diagram with the recording of the "Installed trace":

Procedure:

1. Wait until the "Recording" or "Recording completed" status is displayed in the "Installed 
traces" table.

2. Click the  icon in the "Installed traces" table to display the recording in the curve diagram.

3. Click the  icon of a signal in the signal table.
The individual bits of the signal are offered for display as a bit track.

4. In the signal table, select or deselect the individual signals and bits for display with the  
icon.
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Saving the measurement in the project
The following figure shows the measurement saved in the project:

Procedure:

1. Select the measurement in the "Installed traces" table and transfer it to the project with the 
 button.

12.6.3.2 Using the trace function - overview

Requirement
A device is configured in the TIA Portal that supports the trace and logic analyzer function and 
to which an online connection has been established.

Procedure
The following table shows a procedural overview with typical steps when working with the trace 
and logic analyzer function.

Step Description
1 Calling the trace editor (Page 6190) 
2 Configuring the trace (Page 6191) 
3 Transferring the trace configuration to the device (Page 6192) 
4 Activating/deactivating an installed trace (Page 6192) 
5 Monitoring the recording (Page 6193) 
6 Saving measurements in the project (Page 6194) 
7 Displaying the recording (Page 6193) 

12.6.3.3 Calling the trace editor
A trace editor can be opened for each device in the project navigator.

The following instructions describe how you call the trace editor in the work area of the TIA 
Portal.   

Requirement
A device is configured that supports the trace and logic analyzer function.
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Procedure
To call the trace editor, proceed as follows: 

1. In the project navigator, double-click the device.
The device folder opens.

2. Double-click "Traces".

12.6.3.4 Trace handling

Configuring the trace

Requirement
The trace editor is open.

Creating and deleting the trace configuration
To create a new trace configuration, proceed as follows:

1. Click the "<Add>" entry in the "Trace configurations" table in the Trace handling 
(Page 6178).

2. Enter the name for the trace configuration.
The new trace configuration is created.

 

To delete a trace configuration, proceed as follows:

1. Right-click a trace configuration in the "Trace configurations" table and select the shortcut 
menu command "Delete".
The trace configuration is deleted.

Configuring the trace
In the configuration, you specify the recording and trigger conditions and select the signals to 
be recorded.   

See Section "Configuration" below the respective device (Page 6197).
 

 Note
Saving the trace configuration   

You save the trace configuration with the project in the TIA Portal. 

If you close the project without saving, the configuration is discarded. The trace editor can 
be closed and reopened without loss of data until the project is closed. 
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Transferring the trace configuration to the device

Requirement
● A valid trace configuration  is located in the "Trace configurations" table.

● The maximum number of "Installed traces" has not been reached yet.

● There is an online connection to the device.

Procedure
To transfer a trace configuration to the device, proceed as follows:

1. Select a trace configuration  in the "Trace configurations" table.

2. Click the  button to transfer the trace configuration to the device.

Result
The trace configuration is transferred to the device and displayed in the "Installed traces" table. 

Activating/deactivating an installed trace

Requirement
A trace configuration is installed and there is an online connection to the device.
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Activating an installed trace   
To activate the recording for an installed trace, proceed as follows:

1. Activate the checkbox of the "Active" column in the "Installed traces" table.
The installed trace is activated and starts the recording according to the configured trigger 
condition. The trigger condition is device-specific and described in Section "Configuration" 
below the respective device (Page 6197).

 

  Note

When a recording is restarted, the previously recorded values are lost.

To save the recorded values, save the measurement in the project (Page 6194) before 
you activate the recording again.

 

Deactivating an installed trace 
To deactivate an activated installed trace, proceed as follows:

1. Deactivate the checkbox of the "Active" column in the "Installed traces" table.
The installed trace is deactivated. 

Displaying the recording

Requirement
A trace configuration with recording is in the device and there is an online connection to the 
device or there is an entry in the "Measurements" table.

Procedure
To display the recording, proceed as follows:

1. Select an entry in the "Installed traces" table.

2. Click  in the column for the selected entry.

 

Or:

1. Select an entry in the "Measurements" table.

2. Click  in the column for the selected entry.

 

Result
The recording is displayed in the curve diagram and the signal table. 
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Saving measurements in the project

Requirement
A trace configuration with recording is installed and there is an online connection to the device.

Procedure  
To save a recording in the project, proceed as follows:

1. Click an entry in the "Installed traces" table in the trace handling.

2. Click the  button to transfer the selected entry.
The selected entry in the "Installed traces" table is added to the "Measurements" table.

3. Save the project in the TIA Portal.

Exporting and importing measurements

Requirement
There is at least one measurement in the "Measurements" table.

Exporting measurements
To export a measurement, proceed as follows:

1. Right-click an entry in the "Measurements" table and select the shortcut menu command 
"Export measurement".

2. Select a folder, a file name and a data type to save the measurement.

3. Click the "Save" button.

Importing measurements
To import a measurement, proceed as follows:

1. Right-click in the "Measurements" table and select the shortcut menu command "Import 
measurement".

2. Select the file of the "*.ttrec" file type with the measurement to be imported.

3. Click the "Open" button.
The imported measurement is displayed with the file name in the "Measurements" table.

Transferring the trace configuration from the device to the project

Requirement
A trace configuration is installed and there is an online connection to the device.
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Procedure   
To transfer a trace configuration to the project, proceed as follows:

1. Select an entry in the "Installed traces" table.

2. Click the  button to transfer the trace configuration from the device.

Result
The configuration of the "installed trace" is transferred to the "Trace configurations" table.

Deleting installed traces

Requirement
A trace is installed and there is an online connection to the device.

Deleting an installed trace   
To delete an installed trace, proceed as follows:

1. Select one or more lines to be deleted in the "Installed traces" table.

2. Press <Del> to delete the "Installed traces".

12.6.3.5 Signal table

Use of the signal table
The signal table shows the recorded values of an installed trace or a measurement. You can 
show or hide individual signals for the display in the table and adapt the properties for the 
display. 
Individual bits can be selected for some data types and displayed as a bit track.

The following operating instructions describe the operation of the signal table.

Requirement
● An entry is selected in the  column in the "Installed traces" or "Measurements" table.

● For the display of individual bits as a bit track:
At least one recorded signal supports the display as a bit track.
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Selecting individual signals in the signal table and changing the format
To adapt the display to suit your requirements, proceed as follows:

1. Click the icon of the respective signal in the  column to select or deselect it for the display.

2. Click in the "Color" column for the respective signal to change the default color of the signal.

3. Click the "Bring to foreground" entry in the shortcut menu of a signal to display it in the 
foreground.

Selecting individual bits in the signal table for display as a bit track
To display individual bits as a bit track in the lower curve diagram, proceed as follows:

1. Click the  icon of a signal in the signal table.

2. Click the  icon in the opened bit selection of the signal to select or deselect individual bits 
for the display.

12.6.3.6 Curve diagram

Use of the curve diagram
The curve diagram shows the signals of a recording selected in the signal table. Select the 
recording in the "Installed traces" or "Measurements" table of the trace handling.     

The display area can be zoomed as required. Measurement cursors can be used to select 
individual values for display in the signal table.

The following operating instructions describe the use of the measurement cursors.

Requirement
A recording has been selected for display.

Evaluation of a certain instant of a recording
To display the values for a specific sample, proceed as follows:

1. Display the vertical measurement cursors via the  button.

2. Move a measurement cursor with the mouse to the required position in the recording.
The values of the signals are displayed in the signal table. The time or sample for the 
measurement cursors is displayed in the lower area of the curve diagram.

Evaluation of the difference between two samples
To display the difference, proceed as follows:

1. Display the vertical measurement cursors via the  button.

2. Move both measurement cursors with the mouse to the required samples in the recording.
The values of the signals and the difference are displayed in the signal table. The time or 
sample for the measurement cursors is displayed in the lower area of the curve diagram.
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Using horizontal measurement cursors
To check whether a certain value has been reached, proceed as follows:

1. Display the horizontal measurement cursors via the  button.

2. Move a measurement cursor with the mouse to the required value of the recording.
The values of the measurement cursor for the selected signal are displayed in the lower 
area of the curve diagram.

Printing a recording
The curve diagram supports the saving of the display as a bitmap and the copying of the display 
to the clipboard. Also use these functions (Page 6175) for printing.   

12.6.4 Devices

12.6.4.1 S7-1200/1500 CPUs

Recordable variables

Device-dependent recording of tags
The following list shows the operand areas from which tags can be recorded:    

● Process image input

● Process image output

● Bit memory

● Data blocks

Data types
All elementary data types can be recorded.

The following table lists the elementary data types:

Data types Note
Binary numbers
BOOL -
Bit strings
BYTE -
WORD -
DWORD -
LWORD Symbolic name required
Integers
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Data types Note
SINT -
USINT -
INT -
UINT -
DINT -
UDINT -
LINT Symbolic name required
ULINT Symbolic name required
Floating-point numbers
REAL -
LREAL Symbolic name required

Lifetime of the installed trace configuration and recorded values
Installed trace configurations are retained after POWER OFF. The recording is activated again 
after the restart of the CPU.

Recorded values are lost during the restart. 

Recording levels
The following list shows the execution levels that can be selected for the recording cycle:   

● Program cycle - OB 1

● Time-of-day interrupt - OB 1x

● Time-delay interrupt - OB 2x

● Watchdog interrupt - OB 3x

● Synchronized processing cycles - OB 6x, not OB 60

● Servo task - OB 91 (S7-1500)

● IPO - OB 92 (S7-1500)
 

  Note

The measured values are recorded at the end of the OB after the processing of the user 
program. 
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Quantity structure
The following table shows the maximum quantity structure that can be recorded with the trace 
and logic analyzer function:   

Device Maximum number of "Installed 
traces"

Maximum number of signals per 
trace configuration

S7-1200 
(as of firmware version V4.x) 

2 16

S7-1500 4 16

CPU load through trace recording
A trace recording increases the runtime of the respective recording level that can result in an 
execution level overflow with high utilization of the CPU.     

Remedy
● Change the trace configuration

1) Configure fewer tags and signals.
2) Then increase the number of tags and signals up to the maximum number of signals 
step-by-step without an execution level overflow.

● Select a slower recording level

Software user interface of the device-specific area

 Structure of the user interface

Display areas in the Properties window of the Inspector
The settings options differ depending on the configured device.   

The following figure shows an example of the display in the TIA Portal:

The area navigation provides the following entries for selection:
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● General

● Configuration

– Signals (Page 6200)

– Recording conditions (Page 6202)

Display of the properties of a trace configuration
The trace configuration is selected in the trace handling:

● Selection in the "Trace configurations" table
The properties are displayed in the Inspector window and can be changed.

● Selection in the the "Installed traces" table or "Measurements" table
The properties are displayed write-protected in the Inspector window.

User interface - General
The "General" area shows the name of the trace configuration and input fields for the author 
and a comment.   

Input options and displays in General
The following figure shows an example of the display in the TIA Portal:

The following table shows the input fields and displays:

Column Icon Description
"Name" - Name of the trace configuration
"Author" - Author of the trace configuration
"Comment" - Input field for a comment

User interface - Signals
The "Signals" area shows a table in which the signals to be recorded are configured for the 
selected trace configuration.   
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Setting options and displays in "Signals"
The following figure shows an example of the display in the TIA Portal:

The following table shows the settings and displays:

Column Icon Description
 Display of the signal icon for a selected signal.
"Name" - Input field for the name or address of the signal.

Examples:
● M0.0
● DB1.DBW3
● "Data_block_1".pressure

- Button to open the signal selection table.
The button is displayed when the table line is selected.
Clicking the icon opens a table which offers possible signals for selection. 
The selected signal is displayed in the input field.

"Data type" - Text field with display of the data type for the signal.
"Address" - Input field for the address of the signal.

With purely symbolic signals the field remains empty.
"Color" - Text field for display and selection of the color.

Click the selected field to display the signal color. 
Click the signal color to open the color selection dialog.

"Comment"  Input field for a comment.

Shortcut menu commands
The following table shows the shortcut menu commands of the table:

Shortcut menu command Description
"Cut" Removes the selected lines and moves them to the clipboard.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Pastes the contents of the clipboard to the selected line. The existing 

contents are overwritten.
"Delete" Deletes the selected lines from the table.
"Rename" Switches the selected cell to the editing mode.
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Recording conditions

Supported data types
The following table shows the supported data types for the trigger tag:     

Memory requirement and format of the number Data type
1 byte BOOL
8-bit integers SINT, USINT, BYTE
16-bit integers INT, UINT, WORD
32-bit integers DINT, UDINT, DWORD
64-bit integers LINT, ULINT, LWORD
32-bit floating-point numbers REAL
64-bit floating-point numbers LREAL

User interface - Recording conditions
The "Recording conditions" area shows the trigger condition for the selected trace configuration 
and in which cycle, how fast and how long the recording is made. The configuration is only 
possible if the trace configuration has been selected in the "Trace configurations" table of the 
trace handling.   
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Setting options and displays in "Recording conditions"
The following figure shows an example of the display in the TIA Portal:

Setting/display Description
"Recording time"  
 Drop-down list Selection of the recording time.

See Recording levels (Page 6196) 
 Text field Detailed information on the selected recording time.
"Record every"  
 Input field Input of the reduction in relation to the cycles.  
 Drop-down list Selection of the reduction factor.

The following settings are possible:
● "Cycle"

 Text field Display of the sampling time, taking into account the configured reduction.
"Recording duration"  
 Input field Input of the recording duration in relation to the samples.

If the "Recording duration = max. recording duration" checkbox is 
activated, entries are overwritten by the value displayed in "Max. 
recording duration".

 Drop-down list Select the time unit for the recording duration.
The following settings are possible:
● "Samples"

 Text field Displays the calculated recording duration
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Setting/display Description
"Max. recording duration"  
 Text field Displays the calculated maximum recording duration

The "Max. recording duration" depends on how many signals are 
recorded and the data type of these signals.

 "Use max. recording 
duration"

Set the recording duration to the maximum value.
When the checkbox is activated, the recording duration is set to the 
maximum possible recording duration. The set reduction in the "Record 
every" input field is taken into account. The recording duration is also 
adapted when additional signals are added.

"Trigger mode" Selection of the trigger mode.   
 Drop-down list The following settings are possible:

● "Record immediately"
The recording is made immediately after the device is activated.

● "Trigger on tag"
The recording is made as soon as the installed trace is activated and 
the configured trigger condition is fulfilled.

 Text field Display of the trigger type.
"Trigger tag" The "Trigger tag" specifies a signal that is used to trigger the recording.   
 Input field Enter a signal.

Examples:
● M0.0
● DB1.DBW3
● "DataBlock_1".Temperature

  Opens the signal selection table.
Clicking the icon opens a table which offers possible signals for selection 
as trigger tag. The selected signal is displayed in the input field.

 Text field Display of the trigger tag address.
"Event" The events that can be used on this trigger tag are offered for selection 

according to the data type of the trigger tag.
The event can only be configured when a valid signal has been entered 
as trigger tag.

 Drop-down list Event selection for which the trigger tag is checked.
The entries in the drop-down list are described in Section Trigger event 
(Page 6205).

 Text field Display of the comparison type.
"Value" Configuration of the selected event.

The configuration options differ depending on the format of the trigger 
tag and the selected event. 
See Trigger event (Page 6205).
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Setting/display Description
"Pre-trigger" "Pre-trigger" defines the time during which the signals are already 

recorded before the actual trigger condition is fulfilled.
If the trigger event occurs immediately or shortly after the activation of 
the recording, this may result in a shorter recording duration.
Example of "recording duration" = 20 samples and "pre-trigger" = 
5 samples:
● Trigger event occurs 50 samples after activation of the recording

Actual recording duration = 20 samples
● Trigger event occurs 2 samples after activation of the recording

Actual recording duration = 17 samples
 Input field Input of the duration in relation to the selection in the drop-down list.
 Drop-down list Select the time unit

The following settings are possible:
● "Samples"

 Text field Displays the calculated "pre-trigger" period

Trigger event
Depending on the selection in the drop-down list box, the further settings differ for the 
"event".   

The individual events are described below.

"=TRUE"
Supported data types: Bit (Page 6200) 

The recording starts when the state of the trigger is TRUE.

"=FALSE"
Supported data types: Bit (Page 6200) 

The recording starts when the state of the trigger is FALSE.

"Rising edge"
Supported data types: Bit (Page 6200) 

The recording is started when the trigger state changes from FALSE to TRUE.
After activation of the installed trace, at least two cycles are required to identify the edge.

"Rising signal"
Supported data types: Integers and floating-point numbers (Page 6200) 

The recording is started when the rising value of the trigger reaches or exceeds the value 
configured for this event.
After activation of the installed trace, at least two cycles are required to identify the edge.
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"Falling edge"
Supported data types: Bit (Page 6200) 

The recording is started when the trigger state changes from TRUE to FALSE.
After activation of the installed trace, at least two cycles are required to identify the edge.

"Falling signal"
Supported data types: Integers and floating-point numbers (Page 6200) 

The recording is started when the falling value of the trigger reaches or falls below the value 
configured for this event.
After activation of the installed trace, at least two cycles are required to identify the edge.

"In the range"
Supported data types: Integers and floating-point numbers (Page 6200) 

The recording starts as soon as the value of the trigger is in the value range configured for this 
event.

"Outside of the range"
Supported data types: Integers and floating-point numbers (Page 6200) 

The recording starts as soon as the value of the trigger is outside the value range configured 
for this event.

"= value"
Supported data types: Integers (Page 6200) 

The recording starts when the value of the trigger is equal to the value configured for this event.

"<> value"
Supported data types: Integers (Page 6200) 

The recording starts when the value of the trigger is not equal to the value configured for this 
event.

"= bit pattern"
Supported data types: Integers (Page 6200) 

The recording starts when the value of the trigger matches the bit pattern configured for this 
event.

The following figure shows the setting options for a "bit pattern":
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It is possible to switch between the icons by clicking the respective button.

The following table shows the icons:

Icon Description
Bit is not evaluated

Bit is checked for FALSE

Bit is checked for TRUE

"<> bit pattern"
Supported data types: Integers (Page 6200) 

The recording starts when the value of the trigger does not match the bit pattern configured 
for this event.

See also
Configuring the trigger conditions (Page 6209)

Configuration

Trace configuration - overview
The configuration of the recording conditions and the signals to be recorded is device-specific. 

Requirement
A trace configuration has been created and selected in the "Trace configurations" table of the 
trace handling.
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Procedure   
The following table shows the procedure for configuring.

Step Description
1 Documentation of the configuration (optional)

Enter a comment and an author for the configuration.
2 Selecting signals (Page 6208) 

Select the signals to be recorded in the "Signals" area.
3 Configuring the recording cycle and duration 

Select a recording time, a cycle and the duration in the "Recording conditions" area.
4 Configuring the trigger conditions (Page 6209) 

In the "Recording conditions" area, select whether the recording is to be performed 
immediately or depending on a trigger condition.

Selecting signals

Requirement
● A trace configuration has been created and selected in the "Trace configurations" table of 

the trace handling.

● The "Signals" area is open in the Inspector window.

Procedure   
To configure the signals to be recorded, proceed as follows:

1. Click in the first empty line of the table.

2. Click in the first empty line of the "Name" column

3. Select a signal. The following options are available:

– In the "Name" column, click the  button and select a tag.

– Enter the symbolic tag name in the cell in the "Name" column.

– Enter the address directly in the "Address" column.

4. Click in the "Display color" column and select a color for the display of the signal.

5. Click in the "Comment" column and enter a comment for the signal.

6. Repeat the procedure from step 1 until all the signals to be recorded have been entered in 
the table.
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Configuring the recording cycle and duration

Requirement
● A trace configuration has been created and selected in the "Trace configurations" table of 

the trace handling.

● The "Recording conditions" area is open in the Inspector window.

Procedure     
To configure the cycle and the duration of a recording, proceed as follows:

1. Click the  button for the recording time.

2. Select an OB for the recording time (Page 6196).

3. Select a unit for the reduction factor in the drop-down list box for "Record every".

4. Enter the factor for the reduction in the input field for "Record every".

5. Select a unit in the drop-down list box for "Recording duration".

6. Specify the recording duration. 
The following options are available:

– Enter a value for the duration in the input field for "Recording duration".

– Activate the "Use max. recording duration" checkbox.

Configuring the trigger conditions

Requirement
● A trace configuration has been created and selected in the "Trace configurations" table of 

the trace handling.

● The "Recording conditions" area is open in the Inspector window.
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"Record immediately" trigger condition
To start the recording immediately, proceed as follows:

1. Select the "Record immediately" entry in the drop-down list for "Trigger mode".
The input fields for the trigger tag are hidden.

"Trigger on tag" trigger condition
To start the recording depending on a condition, proceed as follows:

1. Select the "Trigger on tag" entry in the drop-down list for "Trigger mode".

2. Select a trigger tag. The following options are available:

– Click the  button for the trigger tag and select a tag.

– Enter the address or the symbolic name of the tag directly in the input field for the trigger 
tag.

A drop-down list with events and input fields is displayed. The display depends on the data 
type of the tag.

3. Configure the event.

4. Select a unit for the pre-trigger in the drop-down list for "Pre-trigger".

5. In order to record a period before the trigger event, enter a value greater than 0 in the input 
field for the pre-trigger.

 

 Note

The trigger condition is checked in every cycle irrespective of the setting in "Record every". 
To reliably identify the trigger, the trigger signal must be present for at least one full cycle.
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12.7 Establishing a remote connection with TeleService

12.7.1 Basics of working with TeleService

12.7.1.1 Introduction to TeleService

Introduction
TeleService gives your controller telecommunication capability. You can manage, control and 
monitor distributed plants centrally by means of remote connections.

Scope of functions
TeleService allows you to use the range of TIA portal functions via a telephone network or an 
Internet connection by establishing a remote connection to a remote plant. The online 
connection allows you to edit a remote plant as usual with the TIA Portal.

Advantages
Using TeleService offers the following advantages: 

● You can easily access even remote sections of plants and include them in a complete 
system.

● You can offer rapid help and support in the event of faults in a remote system without having 
to go there yourself.

● You can employ your resources effectively.

● It significantly reduces costs.

● It can significantly reduce plant downtimes.

● It improves the efficiency of your plant.

See also
TeleService functionality (Page 6212)
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12.7.1.2 TeleService functionality

TeleService fields of application   
TeleService offers the following the fields of application:

● Access to remote systems (remote maintenance):
You can manage, control, and monitor remote systems centrally by means of remote 
connections. 
This is possible with an S7-300/400 CPU, an S7-1200 CPU and an S7-1500 CPU and a 
TS Adapter MPI  or a TS Adapter IE.

● Establishing connections from and to remote systems (PG-AS remote link):
You can use PRODAVE MPI V5.0 and newer to establish a remote connection to a remote 
system, and the communications instruction "PG_DIAL"  to establish a remote connection 
from a remote system.
This is possible with an S7-300/400 CPU and a TS Adapter MPI. 

● Data exchange between systems (AS-AS remote link):
The communications instruction "AS_DIAL" allows two automation systems to exchange 
process data over the telephone network. 
This is possible with an S7-300/400 CPU and a TS Adapter MPI. 

● Sending an text message from a system:
An automation system can send a message (SMS) via a GSM wireless modem using the 
communications instruction "SMS_SEND" ".
This is possible with an S7-300/400 CPU and a TS Adapter MPI. 

● Sending an email from a system
An automation system can also send an email with the following communications 
instructions and a TS Adapter IE .

– S7-300/400 CPUs (CPU S7-31x-2PN/DP or CPU 41x-3PN/D) use the instruction 
"AS_MAIL"

– S7-1200 CPUs use the instruction "TM_MAIL"

– S7-1500 CPUs use the instruction "TMAIL_C"

       

 

12.7.1.3 Telephone book at TeleService

Introduction
By double clicking the "phone book" folder in the project tree you open the phone book editor 
displaying the TeleService  phone book.

Each version of the TIA Portal has its own "global phone book". If a global phone book from 
an earlier version of the TIA Portal is found in a more recent version of the TIA Portal, you will 
be asked once if you want to import this phone book. 

This gives you the advantage of being able to import the system data from the previous version 
into the more recent version of the TIA Portal.     
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Global phone book properties
The global phone book is used in TeleService to manage specific system data that are required 
to establish a remote connection.   

When you open the phone book for the first time, you will see an empty phone book with all 
available columns; in all other cases, the last phone book edited is displayed.

You can enter any number of systems in a phone book. Systems contain the data required for 
establishing a remote connection, for example, the name and location of the device and the 
phone number to be dialed, along with all country-specific details. With VPN connections, you 
can enter an IP address or a DNS name instead of the phone number.

The TS adapters used for establishing the connection are distinguished by color, depending 
on whether a TS Adapter MPI or a TS Adapter IE is used for establishing the connection.

See also
Working with the phone book (Page 6213)

12.7.2 Working with the phone book

12.7.2.1 Basics on working with the phone book

Working with the phone book
You have the following options when working with a phone book:   

● Open phone book

● Save phone book

● Import phone book data

● Export phone book data

● Printing the phone book

● Use phone book data to establish a remote connection

You can implement these functions simply and easily by using the buttons in the phone book 
toolbar.

 

 Note
Access to phone books

The phonebook is user specific in TeleService. However, it is not possible to access the global 
phone book with more than one instance of the TIA portal at the same time.   
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See also
Open phone book (Page 6215)

Saving phone book (Page 6216)

Exporting phone book data (Page 6218)

Printing the phone book (Page 6219)

Structure of the phone book (Page 6214)

12.7.2.2 Structure of the phone book

Introduction
A global phone book in TeleService is used to manage the data you require for establishing a 
remote connection. Once you have created the connection data and saved it in the phone 
book, you can access it each time you want to establish a remote connection.

Structure of the phone book
The integrated global phone book in TeleService contains the following columns:   

Column name Meaning
System name Enter a name for your system.
Adapter type Select the TS Adapter type used in the drop-down list: TS Adapter MPI or TS Adapter 

IE.
Connection type Select the required connection type: Dial-up connection or VPN connection.
Area code Enter the required area code.

This column is only active with dial-up connections. This column cannot be edited for 
VPN connections.

Phone number/remote address Enter the required connection data for establishing the remote connection. For dial-up 
connections, this can be a phone number, and for VPN connections a DNS name or 
an IP address.

Fingerprint Enter the corresponding fingerprint for establishing a VPN connection to the TS 
Adapter IE Advanced.

Country Enter the country code.
This column is only active with dial-up connections. This column cannot be edited for 
VPN connections.

User name Enter the user name you have logged on under.
Password Enter the password for this user name.
Group Enter the group if you have carried out grouping.
Company Enter the company to be contacted.
Department Enter the relevant department.
Street Enter the street.
Town/City Enter the town or city to which the remote connection is to be established.
Comment Enter a comment if required.
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Showing or hiding columns
You can show or hide the individual columns. To do so, select the required column header 
and open the shortcut menu with the right mouse button.

12.7.2.3 Symbols in the phone book

Meaning of the TeleService icons     
The following table shows the meaning of the TeleService icons: 

Symbol Meaning
Open the global phone book

Imports a phone book

Exports a phone book

Establishes a remote connection

Terminates the active remote connection

Establishes a remote connection or terminates it

Displays the connection to a TS Adapter IE in the phone book

Displays the connection to a TS Adapter MPI in the phone book

Adds a new row to the phone book

Inserts a new row in the phone book

12.7.2.4 Manage phone book

Open phone book

Opening phone books
To open the phone book, follow these steps:  

1. In the project tree, double-click on the "Phone book" folder under "Online access" > 
"TeleService".

2. The phone book opens so that you can enter or edit the required system data.

Using online and diagnostics functions
12.7 Establishing a remote connection with TeleService

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  6213



Inserting rows in the phone book

Inserting rows in the phone book
To insert a new row in the phone book, follow these steps:

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button in the toolbar.

Result
A new row is inserted in the phone book above the selected row. 

Showing and hiding columns in the phone book

Showing and hiding columns
To show or hide columns in the phone book, follow these steps:

1. Click a column header.

2. In the shortcut menu, select the "Show/hide columns" command.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

Result
The respective columns are shown or hidden when displaying the phone book. 

Saving phone book

Saving phone books
When you exit the phone book editor or leave the TIA portal, you are asked whether you want 
to save the global phone book.

Click "Yes" to save the phone book.   

 

Importing phone book data

Introduction
It is possible to import the phone book data from an external file or from an older version of 
the TIA Portal.  
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Requirement
You have already created an import-capable phone book file.

You have already created a phone book with an older version of the TIA Portal.

Importing phone book data from a phone book file
To import phone book data from a phone book file, follow these steps:

1. Open the "TeleService" folder under "Online access" in the project tree.

2. Double-click on the "Phone book" folder.

3. Click the "Import" button in the toolbar.

4. Confirm the prompt asking if you want to save the current state of the phone book with 
"Yes", if applicable, and specify the location for storing the phone book in the dialog that 
follows.

5. If you do not want to save the current state of the phone book, answer the prompt with "No". 
In the subsequent dialog, select the phone book file to which the current phone book should 
be stored.

6. Close the dialog box with "OK".

Result
The imported phone book data is displayed in the global phone book.

 
 

 Note
Defining dialing rules

Dialing rules must be defined before the "area code" and "country" columns in the imported 
phone book can be edited for dial-up connections.

To define dialing rules, follow the link in the history.
 

Importing phone book data from an older version of the TIA Portal
To import phone book data from an older version of the TIA Portal, follow these steps:

1. Open the "TeleService" folder under "Online access" in the project tree.

2. Double-click on the "Phone book" folder.

3. Click the "Import" button in the toolbar.

4. Confirm the prompt asking if you want to save the current state of the phone book with 
"Yes", if applicable, and specify the location for storing the phone book in the dialog that 
follows.

5. If you do not want to save the current state of the phone book, answer the prompt with "No".
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6. Enter the following path in the dialog that follows: "%appdata%\siemens\automation
\TeleService\GlobalTeleServicePhoneBook.tel".

7. Close the dialog box with "OK".

Result
The phone book data imported from the older version of the TIA Portal is displayed in the global 
phone book.

 
 

 Note
Defining dialing rules

Dialing rules must be defined before the "area code" and "country" columns in the imported 
phone book can be edited for dial-up connections.

To define dialing rules, follow the link in the history.
 

 

See also
Defining dialing rules (Page 6219)

Exporting phone book data

Introduction
It is possible to export phone book data to an external file.

Requirement
You have already created a phone book under TeleService with the corresponding system 
data.

Procedure
Proceed as follows to export the phone book data:

1. Open the "TeleService" folder in project tree.

2. Double-click on the "Phone book" folder.

3. Click the "Export" button in the toolbar.

4. In the next dialog box, select where the current phone book is to be exported.

5. Close the dialog box with "OK".
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Result
The exported phone book data are saved in the specified export file.

Printing the phone book

Printing phone books
You can print out all or some of the data in a phone book.  

Proceed as follows:
1. Open the phone book.

2. Select the Phone book > Print menu command or click on the appropriate button in the 
toolbar. The "Print" dialog will open.

3. Specify whether you wish to print the complete phone book or just part of it and set all other 
options.

4. Start the print job with "OK".

Result
The phone book data is printed on the default printer. If the printout is more than one page 
long, an identifier is printed after the page number at the bottom right corner of the page to 
indicate that there is another page. The last page does not have this symbol, indicating that 
no more pages are to follow.

Defining dialing rules

Procedure
 

To define location-specific dialing rules, follow these steps:

1. Open the folder "Online access" in the TIA portal and select the "TeleService" folder.

2. Use the shortcut menu to access the "TeleService" properties.

3. In the dialog that follows, open the "Advanced settings" tab and activate the "Use dialing 
rules" option.

4. Click the "Adapt" button.

5. In the dialog that follows, enter the required location information for connection 
establishment.

– For new locations, enter the country or region and the corresponding area code.

– If required, set the correct destination code and pre-dial line for local/long-distance calls.

– Select your chosen dialing mode for the location.
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6. Exit the dialog by clicking "OK".

7. In the next dialog, select the location from which you wish to dial, and click "OK".

8. In the TeleService dialog that follows, check that the correct location appears under 
"Location".

9. Confirm your entries by clicking "OK".
 

 Note
Modem operation on a local loop or extension

You do not need to specify a pre-dial line if you operate your modem on a local loop (main 
telephone line). The fields for the pre-dial lines for local calls and long-distance calls must be 
empty.
If you operate your modem on an extension, you should enter the pre-dial lines which need 
to be called to access a local loop.

 

 

Example of the use of dialing rules
The following example illustrates the use of location-specific dialing rules for the city of 
Karlsruhe in Germany.

● In the TeleService phone book, you enter the phone number "1234567", without the area 
code and without the country code.
Result: 
The phone number "1234567" is always dialed, irrespective of the location of the caller.

● In addition to the phone number "1234567", you enter the location-specific dial parameters 
for the Karlsruhe area code "0721" and the country code "+49" for Germany in the 
TeleService phone book.
Result: 
"1234567" is dialed from Karlsruhe.
"07211234567" is dialed from other towns in Germany.
"00497211234567" is dialed from other countries. 
 

 

 Note
Display in the phone book

The "area code" and "country" columns in the TeleService phone book can only be edited 
once you have defined the dialing rules as detailed above.
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12.7.3 Remote connections as dial-up connections

12.7.3.1 Basics for establishing a dial-up connection

Using a TS Adapter for dial-up connections
A TS Adapter is needed for establishing a remote dial-up connection using TeleService.   

The TS Adapter is used to prepare an automation system for use with TeleService by 
connecting it to a telephone network via a modem. The TS Adapter has an integrated 
parameter memory in which a parameter set for TeleService operation is stored. 

With the function "export adapter parameter", different parameter sets can be saved in external 
files, and reloaded in the TS Adapter  via the function "import adapter parameter".

Establishing a remote dial-up connection
You can choose between a number of different TS Adapters, each of which offers a different 
functionality and different connection options.

The figure below shows two possible configurations for establishing a dial-up connection to a 
system with the TS Adapter IE.   
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Overview of possible TS Adapter:
The TS Adapter comes in the following versions:   

● TS Adapter II  (also designated "TS Adapter MPI")

● TS Adapter IE Standard  (also designated "TS Adapter IE")

● TS Adapter IE Basic  (also designated "TS Adapter IE")

Designation "TS Adapter"   
In the following pages, the designation "TS Adapter" stands for all versions. The relevant 
product designation is listed beside information which only applies to a specific version, for 
example, "TS Adapter II" or "TS Adapter IE Standard".

 

 Note

For more detailed information on your TS Adapter, please refer to the documentation supplied 
with the TS Adapter.

 

See also
Short description of the TS adapter MPI (Page 6230)

Short description of the TS adapter IE (Page 6237)

Exporting adapter parameters (Page 6236)

Importing adapter parameters (Page 6237)

12.7.3.2 Telephone networks and modems

Supported telephone networks and modems

Telephone networks which can be used
TeleService can be used with digital networks (ISDN), analog networks and wireless networks 
(with GSM technology). This version supports a remote connection to a TS Adapter.

Modem support
TeleService has been implemented to be independent of the modem. This means that all 
standard modems which can be installed in the Windows Control Panel and are visible as 
modems can also be used by TeleService.   

The choice of modem type is determined primarily by the existing hardware of the programming 
device/PC and the telephone network to be used.
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The following modem types/media are supported:
● Modems (external modems at the COM interface, internal modems and PCMCIA cards) 

● External ISDN adapter at the COM interface or USB interface

● Internal ISDN adapter with virtual COM interface (for example AVM CAPI port)

● External ISDN modems (ISDN adapter with integrated analog modem functionality) at the 
COM interface or USB interface

● Radio network modems with GSM technology, PCMCIA adapter card or data cable and 
mobile phone

Gateways
Gateways between the various telephone networks are in principle possible. Remote 
connections from an ISDN adapter to an analog modem and vice versa only function with 
special ISDN telephone adapters.   

Performance in telephone networks
The data throughput of a remote connection depends on the modem and telephone network 
used and the quality of the telephone line.   

Installing the local modem

Introduction
If you have already installed a modem for data transfer in your operating system, this modem 
can also be used for TeleService.  

If a modem has not yet been installed for your operating system, one must be installed before 
you can establish a remote connection with TeleService.

Procedure
Proceed as follows:

1. Make sure your programming device/PC and the modem are switched off. 

2. Physically connect the external modem to a COM or USB interface on your programming 
device/PC. You can also install an internal modem or a PCMCIA card in accordance with 
the manufacturer's specifications.

3. Now switch on the modem and then the programming device or the PC.
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Result
Plug-and-play modems are recognized and installed automatically by the operating system. 
Dialogs will take you through the installation procedure.

 

 Note
Modems without plug-and-play

If your modem is not recognized automatically when switched on, you will have to install it 
yourself using the Control Panel. 

Please refer to the information in the documentation supplied with your modem.
 

Connecting and configuring the remote modem

Introduction
A modem must also be connected to the remote system before you can work with TeleService. 
This modem is designated the "remote modem".

Configuring the remote modem
The modem receives all parameters required for operation from the TS Adapter connected. 
These include data for initializing the modem and settings for serial transmission between the 
TS Adapter and the modem.   

The data required for the remote modem is specified during the configuration of the TS Adapter.

The modem may be internal or external depending on the TS Adapter used.

How to connect a TS Adapter with an internal modem  
1. Switch off the TS Adapter.

2. Connect the TS Adapter to the automation system.

3. Connect the TS Adapter to the telephone line.

4. Switch on the TS Adapter.

How to connect a TS Adapter with an external modem  
1. Switch off the modem.

2. Connect the TS Adapter to the automation system.

3. Connect the TS Adapter to the modem using a modem cable.

4. Connect the modem to the telephone line.

5. Switch on the modem.

6. Switch on the TS Adapter.
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 Note
Please note the following information on configuring the remote modem:
● The default parameters for the modem and the serial port set in the TS Adapter should in 

most cases ensure successful operation; changes in the parameter assignment will only 
be needed in rare cases.

● You need only change the parameter assignment of the TS Adapter if a modem connection 
is not established or if factory settings are to be adapted or optimized.

● TS Adapter parameter assignment can be changed via either a direct or a remote 
connection.

 

12.7.3.3 Access protection for dial-up connections

Access protection information

Introduction
When you assign the parameters for your TS adapter, you can restrict access to the parameters 
of the TS adapter and access to remote systems.

Scope of access protection
Access protection only exists for remote connections; TS adapter parameter assignment can 
be accessed at any time in direct connection mode.  

Access protection also exists in direct connection for the TS adapter IE.

Access protection information
The TS Adapter MPI is not delivered with access protection activated. There is a default 
password for the TS adapter IE.

The first user who assigns the parameters for this adapter can therefore activate access 
protection by defining the password for a user and/or a callback number.  

This is a multi-level access protection with several users, each with or without administrator 
rights. For the TS adapter MPI there is only one adminstrator and no more than two users.

For a modem connection, only an administrator can define the two users and change and, if 
necessary, delete their settings. Those logged in as users can only change their own 
passwords and their own callback numbers. However, with the TS adapter MP you can access 
the process of assigning parameters of the TS adapter in direct connection, without restriction.
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Advantages
Access protection offers the following advantages:  

● Unauthorized access by persons outside the system is almost impossible.

● The plant operator bears most of the telephone costs.

TeleService callback options

Callback variants
The costs of a telephone connection are normally borne by the caller who establishes the dial-
up connection.

TeleService can, however, be used so that after a short initial connection the modem 
connection is established again in the opposite direction, in other words initiated by the 
TS Adapter (callback). In this case, the plant operator bears the costs of the callback.

There are two callback variants in TeleService: 
1. Callback to a number specified during connection establishment.

2. Callback to a number stored on the TS Adapter.

Levels of protection

Introduction
You can set up one of two possible levels of access protection for TeleService access to the 
TS Adapter. Different options are available with each protection level.

Access protection options
Access protection level 1:

The TS Adapter  is protected by the user name and password. You can access the TS Adapter 
via any telephone line and specify any callback number during connection establishment.

Access protection level 2:

The TS Adapter is protected by the user name, password, and the callback number. You can 
only access the TS Adapter from one telephone connection per user.

The table below sets out the above conditions for the various protection levels:

Level of access 
protection

Administrator/User password Callback number

1 enter do not enter
2 enter enter
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Logging on to TS Adapter
When you log on to the TS Adapter and after you have set up access protection, enter your 
user name, the corresponding password and, if desired, a callback number:

Level of access 
protection

Administrator/User password Callback number

1 enter do not enter or enter any 
callback number

2 enter do not enter

 

If you have entered a callback number during connection establishment (access protection 
level 1) or stored a callback number in the TS Adapter (access protection level 2), the modem 
connection will be terminated and the TS Adapter will call back the given number.

 

Setting up access protection and callback number for the TS adapter

Introduction
During the parameter assignment for the TS adapter MPI in TeleService, you can set up access 
protection and a callback number for the parameter assignment of the adapter and connection 
to the remote system. The following describes the parameter assignment for a TS adapter 
MPI. The parameter assignment of a TS adapter IE is carried out in analog. The specific method 
is described in the web help of this adapter.  

Requirement 
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Accessible nodes".

Procedure
To set up access protection for the TS adapter, proceed as follows: 

1. Click on the command "Assign TS Adapter MPI parameters" in the project tree.

2. Open the "Access security" tab.

3. Enter a password for your user name and/or number that you want the modem to call back 
following logon.

– If you are an administrator, you can change all the settings for administrators and users, 
and delete or create users.

– If you are logged on as a user, you can only change your own settings (password and 
callback number).

4. Confirm all entries before exiting the dialog with "OK".

5. Click the "Yes" button to confirm the following query.
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Result
The parameter assignment for the access protection and the callback number is saved in the 
non-volatile memory of the TS adapter MPI.

 
 

 Note
Important points to note when setting up access protection:
● The settings in the "Modem" tab must correspond to the conditions at the plant if callback 

functionality is to be guaranteed.
● Entering an incorrect callback number in the role of "ADMIN" user will mean you are no 

longer able to access the TS Adapter MPI over a remote connection!
● Test the callback number before you enter it as the "ADMIN" user by calling the given 

callback number during connection establishment (access protection level 1).
 

 

Complete a callback in TeleService

Callback options
Two different callback variants can be set up in TeleService.

The following callback options are available:   

● Callback to a number specified during connection establishment.

● Callback to a number stored on the TS Adapter

Callback to a number specified during connection establishment   
1. In the project tree of the TIA portal, open the "Online access" folder.

2. Click on the "TeleService" folder it contains.

3. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

4. In the "Adapter type" drop-down list, select the adapter type used.

5. Select the "dial-up connection" under "Connection type" if it is not already selected.

6. Select the modem you are using under "Local Settings".

7. Enter the phone number to be dialed in the appropriate box or open the phone book by 
clicking on the button behind it and take the desired phone number from the phone book.

8. Enter your user name and associated password of the TS adapter.

9. If you want a "Connection setup with callback", select the appropriate option button.
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10.Click the "Connect" button to establish the required remote connection. This button only 
becomes active when you have entered all the parameters needed to establish a remote 
connection. Any remote connection is displayed under "Status".

11.Enter the desired callback number in the dialog that follows.

Result
The remote connection to the desired system is made with callback. 

The connected system is shown with the corresponding icon in the project tree.
 

 Note

This procedure is useful if the costs of the modem connection are to be borne by the plant 
operator and if the actual callback number is not fixed, i.e. callback is not always to the same 
receiver. It is particularly useful for mobile users.

 

Callback to a number stored on the TS Adapter 
1. Assign the parameters for the desired callback number in the TS adapter.

2. Establish a connection to the TS adapter as described above, and observe the following 
features:

– Enter the user name and password for which the callback number parameters are 
assigned in the TS adapter.

– The check box "Establish a connection with callback" does not have to be selected, 
since the callback number is already known by the TS adapter.

Result 
Callback to a number stored on the TS adapter has been established. If a remote connection 
is established, the callback occurs from the remote system. 

 

 Note

This procedure offers the highest level of access protection. However, it does pose a risk: if 
the callback number stored on the TS Adapter is not correct, it will no longer be possible to 
access the TS Adapter over a modem connection. The device can in such a case only be put 
back into operation by changing the parameter settings on site.
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12.7.3.4 TS adapter MPI

Short description of the TS adapter MPI

TS Adapter MPI:
The designation "TS Adapter MPI" is a collective term for allTS Adapter with an MPI/DP 
interface.   

The TS Adapter MPI comes in the following versions:

● As TS Adapter I (parameters cannot be assigned via the TIA Portal)

● as TS Adapter II

The table below provides a short description of the functionalities. For detailed information on 
your TS Adapter, please refer to the documentation supplied with your TS Adapter.

TS Adapter II:  
Direct connection Connection via the Universal Serial Bus (USB). The firmware can be 

replaced. 
The modem is integrated or can also be connected as external 
modem. The TS Adapter II switches automatically between the 
modems. As long as no external modem is connected, the adapter 
will use the internal modem.

There are two variants ● With internal analog modem. An external modem can also be 
connected to the RS232 port.

● With internal ISDN adapter. An external modem can also be 
connected to the RS232 port.

Use of the designation "TS Adapter"
For TeleService the designation "TS Adapter" is the generalization for all versions. The relevant 
product designation is listed beside information which only applies to a specific version of a 
TS Adapter, for example, "TS Adapter II", "TS Adapter IE Standard" or "TS Adapter IE Basic".  

How the TS adapter MPI works

How the TS Adapter MPI Works
In line with the configuration, the TS Adapter MPI connects the serial port or USB port of your 
programming device/personal computer (direct connection) or the serial port of a modem 
(modem connection) to the MPI/PROFIBUS network of your automation system.  

The TS Adapter MPI has a non-volatile memory. Parameters for the following functions are 
stored in this memory:

● The MPI/PROFIBUS network (network parameters)

● The mode of the modem used
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● The serial port to the modem

● Access protection

Default parameter assignment
The TS Adapter comes with default parameter assignment. The parameters can be set and 
saved to the non-volatile memory of the TS adapter in a parameter assignment session.  

When "Direct connection" is configured, the TS Adapter will only use the network parameters 
for access to the MPI/PROFIBUS network.

In the "Modem connection" configuration, all the parameters stored on the TS Adapter will be 
activated.

 

 Note

For more detailed information on the configuration of your TS Adapter, please refer to the 
documentation supplied with it.

 

Operating a TS adapter MPI in direct connection mode

Direct connection with TS Adapter MPI
The direct connection is used to assign the parameters of the TS Adapter MPI. The same 
configuration also allows you to go online in the TIA Portal and thereby check the configured 
MPI/PROFIBUS parameters for bus compatibility. This means that (as with a PC adapter) 
SIMATIC S7/C7 systems can be accessed via the MPI/DP interface without an MPI/
PROFIBUS module occupying a slot for a programming device/PC.   

Access protection for the TS Adapter is not active in direct connection configuration. This 
means that the parameter assignment of the TS Adapter can be changed without any 
problems, for example by importing adapter parameters. 

 
 

 Note
Display of the TS Adapter MPI in the TIA Portal

As soon as you have connected a TS Adapter MPI with the PG/PC using the USB port, the 
"TS Adapter" folder is displayed in the project tree of the TIA Portal. 

When you open the folder, you can assign the parameters of the connected TS Adapter MPI 
via the following dialog.

 

Establishing the direct connection for TS Adapter MPI
Direct connection mode means there is a direct connection via the TS Adapter MPI between 
the programming device/personal computer on which TeleService is installed and the 
automation system. No modem is required.   
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The figure below shows the configuration of the TS Adapter MPI with a direct connection.

 

Operating a TS adapter MPI in modem connection mode

Introduction to the modem connection with TS Adapter MPI
This configuration allows you to dial into a remote system. To do this, you establish a remote 
connection to a remote system using TeleService on a telephone network. Over the 
established modem connection, you can then work with the selected plant as usual with the 
TIA Portal.   

Establishing a modem connection with TS Adapter MPI
This connection between the programming device or PC on which TeleService is installed and 
the automation system in which the TS Adapter MPI is inserted in the MPI/DP interface is made 
through a modem route.   

The configuration therefore includes the programming device or PC via the telephone network 
and the TS Adapter MPI on the MPI/DP interface of the automation system.

The figure below shows the structure of the modem connection.
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 Note
Parallel operation between direct and modem connection

The TS Adapter II has two connections for communication with PG/PC, both of which can be 
connected at the same time. At the same time, connect the USB interface with the PG/PC 
and the modem interface with the telephone network.

In this configuration you can either use the direct or the modem connection.

A parallel operation is not possible!
 

TS adapter MPI configuration options

Useful information on configuring the TS Adapter MPI
The TS Adapter MPI can be configured in both direct connection mode and via an existing 
remote connection.  

The following parameter assignment options are available:

● Reconfiguration (Page 6234)

● Restoring default parameter assignment (Page 6235)

● Importing adapter parameters (Page 6237)

● Exporting adapter parameters (Page 6236)

● Setting up access protection (Page 6225)
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Parameter assignment
Configure your TS Adapter in accordance with the documentation supplied with the TS 
Adapter. It will detail the exact procedure for parameter assignment.

 

 Note
Please note the following when configuring the TS Adapter MPI
● If you change the current parameter settings when there is an established remote 

connection, there is a risk it will not subsequently be possible to establish a modem 
connection with the modified parameters. The TS Adapter MPI can in this case only be 
configured in direct connection mode.

● This means that either parameter assignment must be carried out with a programming 
device/personal computer at the plant location or the TS Adapter MPI must be brought to 
the location of the local programming device/personal computer in order to be configured.

 

Positive acknowledgement
During parameter assignment, the data is written to the non-volatile memory of the TS Adapter 
MPI. The parameter assignment process is not acknowledged positively until all precautions 
have been taken to ensure that parameter changes have been carried out correctly and will 
thus survive a power failure.

Changes become effective for the TS Adapter MPI as follows:
● The serial parameters, the modem parameters and the parameters for access protection 

are activated once the remote connection has been terminated.

● The modified network parameters are activated immediately.

Configuring TS adapter MPI

Introduction
The TS Adapter MPI  can be configured in both direct connection mode and via an existing 
remote connection in modem connection mode.   

The following describes the method for assigning parameters.

Requirement
A TS Adapter MPI  is connected to your computer and the folder "TS Adapter" is displayed in 
the project tree under "Online access".
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Procedure
To assign the parameters for the TS Adapter MPI im Direktanschluss  please proceed as 
follows:

1. Double-click the "Online access" folder in the project tree.

2. Open the required folder:

– The "TS Adapter" folder for a direct connection.

– For an existing remote connection, the "TeleService" folder followed by the folder with 
the required system name.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Set the required parameters in the individual tabs of the dialog.

5. Confirm your entries with "OK".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter MPI. 
Parameter assignment is then complete.

Restoring default parameter assignment for TS adapter MPI

Introduction
You can restore the default, factory state parameters of the TS Adapter MPI.

Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
Proceed as follows to restore default parameters for the TS Adapter MPI:  

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Reset" button under "General".

5. Confirm your entries with "OK".
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Result
The TS Adapter MPI default parameters set on delivery are restored.

See also
TS adapter MPI configuration options (Page 6231)

Exporting adapter parameters

Introduction
You can export the configuration of a TS Adapter MPI to an external file. The configuration 
saved in this file can be imported in turn into any number of TS Adapter MPI.  

This can for example be useful if you want to assign identical parameters to 
multipleTS Adapter MPI or if you want save, document or distribute the parameter set. 

Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
To export the adapter parameters of a TS Adapter MPI:

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Export" button.

5. A window will open in which you can select the file to which you wish to export the 
configuration of the TS Adapter MPI.

6. Confirm with "Save".

Result
The parameters of the TS Adapter MPI are saved in the specified file (*.tap). The export of the 
adapter parameters is now complete.
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Importing adapter parameters

Introduction
You can import the configuration of a TS Adapter MPI from a previously created export file 
(*.tap).  

The configuration saved in this file can be imported into any number of TS Adapter. This can 
for example be useful if you want to assign identical parameters to multiple TS Adapter MPI. 

You can import parameters locally in direct connection mode or via an existing remote 
connection in modem connection mode.

Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
To import the adapter parameters of a TS Adapter MPI:

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Import" button.

5. A dialog will open in which you can select the file to which you wish to import the 
configuration of the TS Adapter MPI.

6. Confirm the next dialog with "Yes".

Result
The parameters selected are saved in the non-volatile memory of the TS Adapter MPI. Adapter 
parameter import is then complete.

12.7.3.5 TS adapter IE

Short description of the TS adapter IE

TS Adapter IE
The designation "TS Adapter IE" is a collective term for allTS Adapter with an Ethernet port.   

The TS Adapter IE comes in the following versions:
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● as TS Adapter IE Standard

● as TS Adapter IE Basic

The tables below provide a short description of the functionalities. For detailed information on 
your TS Adapter, please refer to the documentation supplied with it.

TS Adapter IE Standard:
Direct connection by means of Industrial Ethernet (IE). Firmware update possible. Modem integrated 
or external. The TS Adapter IE cannot automatically switch between modems like the TS Adapter II. 
Parameters are assigned via a Web interface.
There are 2 variants:
● With internal analog modem. An external modem can also be connected to the RS232 port.
● With internal ISDN adapter. An external modem can also be connected to the RS232 port.

TS Adapter IE Basic:
Direct connection by means of Industrial Ethernet (IE). Firmware update possible. Plug-in modules. 
Parameters are assigned via a Web interface.
There are 4 variants:
● TS Adapter IE Basic MODEM:

Basic device TS Adapter IE Basic with TS Module MODEM for operation on the analog telephone 
network.

● TS Adapter IE Basic ISDN:
Basic device TS Adapter IE Basic with TS Module ISDN for operation on ISDN telephone systems.

● TS Adapter IE Basic GSM:
Basic device TS Adapter IE Basic with TS Module GSM for operation on the GSM radio network.

● TS Adapter IE Basic RS232:
Basic device TS Adapter IE Basic with TS Module RS232 for connecting an external modem.

Use of the designation "TS Adapter"
"TS Adapter" is used in the TeleService online help as a general designation for all versions. 
The relevant product designation is listed beside information which only applies to a specific 
version of a TS Adapter, e.g. "TS Adapter I", "TS Adapter II", "TS Adapter IE Standard" or 
"TS Adapter IE Basic".   

How the TS adapter IE works

How the TS Adapter IE works
The TS Adapter IE  connects the telephone network or the serial port of a modem with the 
Industrial Ethernet  of your automation system.  

The TS Adapter IE  has a non-volatile memory. Parameters for the following functions are 
stored in this memory:
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● The mode of the modem used

● The serial port to the modem

● Access protection

Default parameter assignment
The TS Adapter IE comes with default parameter assignment. The parameters can be set and 
saved to the non-volatile memory of the TS adapter in a parameter assignment session.  

 

 Note

For more detailed information on the configuration of your TS Adapter, please refer to the 
documentation supplied with it.

 

 

Connection Types

Connection types of the TS Adapter IE Basic
The following diagrams show the connection types possible with the TS Adapter IE Basic. 

Direct connection
In the direct connection to the PG/PC, you can set the TS Adapter IE Basic through Ethernet. 

 

 Note

The operation of the TS Adapter IE Basic  without a TS module is not permitted.
 

Figure 12-1 Direct connection
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Connection to the telephone network
In order to have a direct connection to the telephone network, you must connect the 
TS Adapter IE Basic together with one of the following TS modules:

● TS Module Modem

● TS Module ISDN

Figure 12-2 Direct connection to the telephone network

More information about the TS modules can be found in the TS Adapter modular manual.

Connection to the GSM network
In order to connect to the GSM network, you must operate the TS Adapter IE Basic together 
with this TS module:

● TS Module GSM

Figure 12-3 Connection to the GSM network

More information about the TS modules can be found in the TS Adapter modular manual. 
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Connection to the telephone network through an external modem
For the connection to an external modem, you must operate the TS Adapter IE Basic together 
with this module:

● TS Module RS232

Figure 12-4 Connection to an external modem

More information about the TS modules can be found in the TS Adapter modular manual. 

TS Adapter IE parameter assignment options

Useful information for configuring the TS Adapter IE
The TS Adapter IE is configured via a Web interface. 

Web help associated with the parameter assignment interface is made available for the 
configuring the TS Adapter IE.

The following parameter assignment options are available:

● Reconfiguration

● Restoring default parameter assignment

● Importing adapter parameters

● Exporting adapter parameters
 

 Note
Parameter assignment

Configure your TS Adapter in accordance with the documentation supplied with the TS 
Adapter. It will detail the exact procedure for parameter assignments.
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Parameter assignment for TS Adapter IE

Introduction
The TS Adapter IE  can be configured in both direct connection mode and via an existing 
remote connection in modem connection mode.   

Both parameter assignment options are described below. 

Specific details for assigning parameters of the TS Adapter IE can be obtained from the TS 
Adapter IE documentation.

Parameter assignment of the TS Adapter IE in direct connection
 

Requirement
There is a LAN connection to your TS Adapter IE . 

The TS Adapter IE Basic is connected to the power supply. 

Procedure
To assign the parameters for the TS Adapter IE , proceed as follows:

1. In the project tree of the TIA portal, open the "Online access" folder.

2. Double-click on the Ethernet port of your computer.

3. Double-click on the "Display accessible nodes" command. The TS Adapter IE is then 
displayed.

4. Double-click on the <TS Adapter IE> folder and then on "Online and diagnostic", and assign 
the desired IP address to the TS Adapter IE in the following dialogs. Please note that the 
IP address of the PG/PC interface card is located in the same subnet as the IP address 
that you issue for the TS Adapter IE.

5. Update the view in the project tree for the "Accessible nodes", so that the TS Adapter IE is 
displayed with the newly allocated IP address.

6. Open the folder <TS Adapter IE> in the device list.

7. Double-click the command "Assign TS Adapter IE parameters". The allocated web interface 
opens for assigning the TS Adapters IE parameters.

8. Complete the "logon" for the web interface.

9. Set the required parameters in the individual tabs of the dialog.

10.Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter IE. 
Parameter assignment is then complete.

Using online and diagnostics functions
12.7 Establishing a remote connection with TeleService

WinCC Comfort/Advanced V12.0 SP1
6240 System Manual, 07/2013,  



Parameter assignment of the TS Adapter IE using a remote connection
 

Requirement
There is an established remote connection to a TS Adapter IE .

Procedure
1. In the project tree of the TIA portal, open the "Online access" folder.

2. Open the "TeleService" folder followed by the required system folder.

3. Double-click the command "Assign TS Adapter IE parameters". The associated web 
interface for assignment of the TS Adapter IE parameters opens. The "logon" for the web 
interface takes place automatically with the login data of the remote connection.

4. Set the required parameters in the individual tabs of the dialog.

5. Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter IE. 
Parameter assignment is then complete.

 

12.7.3.6 Establishing a dial-up connection to a remote system

Establishing a dial-up connection

Introduction to establishing a remote dial-up connection
A dial-up connection is established when you use TeleService to dial into a remote system via 
a telephone network. The programming device/personal computer is connected to the 
telephone network with TeleService via a modem. At the other end, the automation system is 
connected to the telephone line via a configured TS Adapter  and a modem.   

Requirements
A local modem is installed and configured.   

The TS Adapter is located in the remote system. 

A remote modem is installed and parameters have been assigned. 
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Proceed as follows:   
1. In the project tree of the TIA portal, open the "Online access" folder.

2. Click on the "TeleService" folder it contains.

3. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

4. In the "Adapter type" drop-down list, select the adapter type used.

5. Under "Connection type", select "Dial-up connection".

6. Select the modem you are using under "Local settings".

7. Enter the phone number to be dialed in the appropriate box or open the phone book by 
clicking on the button behind it and take the desired phone number from the phone book.

8. Enter your user name and the corresponding password.

9. If you want a "Connection setup with callback", select the appropriate option button.

10.Click the "Connect" button to establish the required remote connection. This button only 
becomes active when you have entered all the parameters needed to establish a remote 
connection. Any remote connection is displayed under "Status".

Result
The dial-up connection to the desired system is established. 

The dialog closes as soon as the dial-up connection is established. The following message 
appears in the TIA Portal status bar: "Remote connection is established". You can now use 
the remote connection with TIA Portal and communicate with the automation system. 

Connection cannot be established
If the connection cannot be established, try to find the cause using the "Notes on 
troubleshooting".   

Terminating the connection
Once you have finished editing the remote system, exit the remote connection in the project 
tree by double-clicking on the entry "Establish/disconnect remote connection". 

By exiting the TIA Portal you are also terminating the remote connection.   
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Terminating a dial-up connection

Terminating an active dial-up connection
 

 

 Note

Terminating the dial-up connection

You should go offline in the TIA Portal before you terminate the remote connection.
 

Proceed as follows:
1. Double-click the "Set up/close remote connection" entry in the TIA portal. 

2. Confirm the prompt in the dialog that follows with "Yes".

Result
The connection is terminated.

 

 

12.7.4 Remote VPN connections

12.7.4.1 Basics for establishing a VPN connection

Using a TS Adapter IE Advanced for VPN connections
A TS Adapter IE Advanced is required to establish a VPN connection using TeleService.   

 

VPN definition
VPN stands for "Virtual Private Network". This is a private network of computers based on a 
public network infrastructure.

VPN is used to create a connection that is as secure as possible between devices in a private 
network at different locations and the gateway of another network. 

A VPN device has direct access to the gateway in the other network over an encrypted 
connection.  
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VPN connections
When a VPN connection is established with TeleService, a CA certificate and a unique 
fingerprint generated from it are used for the unique identification of the TS Adapter IE 
Advanced. The VPN connection allows a communication that is secure from tapping and 
manipulation between the remote PC and the TS Adapter.  

If you want to establish a VPN connection to multiple remote networks, you will require a 
separate TS Adapter IE Advanced as an interface for each network. The networks connected 
by the TS Adapter can used identical IP addresses internally. Only the external IP addresses 
(WAN) of the TS Adapters need to be different. 

Only one VPN connection to a TS Adapter is possible at any one time.

 
 

 Note
Authentication

Please not that the CA certificate exclusively authenticates the TS Adapter IE Advanced.

As in the case of dial-up connections, users are authenticated via the login (user name and 
password).

Therefore, use only a secure password for the login.
 

See also
● Establishing VPN connections (Page 6251)

● Terminating VPN connections (Page 6253)

12.7.4.2 Basics of CA certificates

Introduction
To establish a secure VPN connection with TeleService, you need to generate a CA certificate 
with a unique fingerprint when you configure the TS Adapter IE Advanced. 

You can install this CA certificate as follows on each PC which is to access the TS Adapter IE 
Advanced:

● Using the automatic download in the TeleService connection dialog, by entering the 
fingerprint for the CA certificate

● Manually by using the Microsoft® Management Console.

Definition of CA certificate
A CA certificate is a digital certificate issued by a "certificate authority" or "certification 
authority", hereinafter referred to as "CA". In the case of the TS Adapter IE Advanced, self-
signed certificates are used; the certification authority in this case is the TS Adapter IE 
Advanced itself.
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Certificates for "SSTP" (Secure Socket Tunneling Protocol) and "HTTPS" (Hypertext Transfer 
Protocol Secure) are derived from the CA certificate. 

CA certificates contain a "key" and additional information used for authentication and for 
encrypting and decrypting confidential data. Additional information includes the validity period, 
references to certificate revocation lists, etc. which are included in the certificate by the CA.

 

Using CA certificates with TeleService
A CA certificate with a unique fingerprint is generated by the TS Adapter to uniquely identify 
the TS Adapter IE Advanced as connection partner for the remote PC.

This CA certificate must be saved in the Windows certificate store of your programming device/
PC before you can establish a VPN connection. When you access the Web server using a 
direct connection, a security warning will appear if no CA certificate exists. In such cases, 
however, you can choose to ignore the warning and allow the connection. 

 

 Note
Handling CA certificates

Specialist knowledge of the operating system is required for handling CA certificates. CA 
certificates should only be managed by trained personnel!

You require administrator rights to manage CA certificates.
 

Definition of fingerprint
The fingerprint is a 20-byte hexadecimal expression. It provides a unique value for a CA 
certificate and is used to identify a specific CA certificate.

A fingerprint is calculated dynamically using the SHA-1 algorithm and is not physically 
contained in the CA certificate. 

Use of fingerprints with TeleService
The CA certificate is used to uniquely identify the TS Adapter IE Advanced as connection 
partner. A unique 20-byte fingerprint of this certificate is generated each time a CA certificate 
is generated by the TS Adapter IE Advanced. It is calculated automatically by the TS Adapter 
IE Advanced when the certificate is generated. Each certificate has a specific, unique 
fingerprint. This fingerprint must be transferred securely to your computer, for example by 
phone or in an encrypted e-mail. You need to enter this fingerprint in the connection dialog 
when establishing a VPN connection with TeleService, unless the CA certificate is already 
saved on your PC in the Windows certificate store.

You will find the fingerprint for your TS Adapter IE Advanced in the Web interface for the TS 
Adapter IE Advanced. To open the Web interface, double-click the command "Assign TS 
Adapter IE Advanced parameters" in the device list in the TIA portal. Carry out the Web login 
to view the fingerprint in the "Security > Certificates" tab.
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CA certificate download during connection establishment
When the connection is established, TeleService checks whether a suitable CA certificate is 
installed in the Windows certificate store of your programming device/PC. If an appropriate 
certificate is found, the VPN connection is established as an SSTP connection (Secure Socket 
Tunneling Protocol).

If no appropriate CA certificate is found, the CA certificate is first loaded by the corresponding 
TS Adapter IE Advanced. The TS Adapter IE Advanced is called by the remote address entered 
in the connection dialog. If this download of the CA certificate is successful, the fingerprint of 
the downloaded CA certificate is calculated and compared with the fingerprint entered in the 
connection dialog. If the two fingerprints match, a dialog opens and you are prompted to save 
the CA certificate in the Windows certificate store of your programming device/PC. You require 
administrator rights to save the CA certificate.

The VPN connection is then established.

See also
● Installing CA certificates for VPN connections (Page 6248)

● Deleting CA certificates for VPN connections (Page 6251)

 

12.7.4.3 Installing CA certificates for VPN connections

Installing CA certificates
To establish a secure VPN connection between your programming device/PC and a remote 
system with TeleService, you require a valid CA certificate generated by the TS Adapter IE 
Advanced. This must be saved in the Windows certificate store of your programming device/
PC.

A CA certificate can be installed manually or using an automatic download.

CA certificates are managed with the Microsoft® Management Console. 

 
 

 Note
Handling CA certificates

Specialist knowledge of the operating system is required for handling CA certificates. CA 
certificates should only be managed by trained personnel!

You require administrator rights to manage CA certificates!
 

Requirement
A CA certificate has yet to be installed in the Windows certificate store on your computer.
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Installing CA certificates using the automatic download
Proceed as follows:

1. Log on to the system as administrator.

2. Transfer the fingerprint for the CA certificate from the TS Adapter IE Advanced to your 
computer using a "secure route", for example by phone or in an encrypted e-mail.
You will find the fingerprint for your TS Adapter IE Advanced in the Web interface for the 
TS Adapter IE Advanced. To open the Web interface, double-click the command "Assign 
TS Adapter IE Advanced parameters" in the device list in the TIA portal. Perform the Web 
login to view the fingerprint in the "Security > Certificates" tab. 

3. In the project tree of the TIA portal, open the "Online access" folder.

4. Click on the "TeleService" folder it contains.

5. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

6. Select the "TS Adapter IE Advanced" as Adapter type from the drop-down list.

7. Under "Connection type", select "VPN".

8. In the relevant input box, enter the IP address / DNS name for the TS Adapter IE Advanced 
to be contacted. Alternatively, you can apply any existing data from the phone book by 
clicking the corresponding button.

9. Enter your user name and the corresponding password.

10.Copy the fingerprint displayed in the Web interface for the TS Adapter IE Advanced to the 
"Fingerprint" column. 

11.Click the "Connect" button to establish the required remote connection. This button only 
becomes active when you have entered all the parameters needed to establish a remote 
connection.

12.No valid CA certificate is found, because no CA certificate has been installed on your PC 
yet. 
A "normal" connection (not a VPN connection) is therefore established and the certificate 
required is downloaded from the TS Adapter IE Advanced to the working memory of your 
computer. The fingerprint is then calculated (SHA-1 algorithm) and compared with the 
fingerprint entered in the connection dialog. If the two fingerprints match, a dialog opens 
and you are prompted to save the CA certificate in the Windows certificate store of your 
programming device/PC. 

13.Confirm that you want to save the CA certificate.

Result
The VPN connection to the required TS Adapter IE Advanced is established. The dialog closes 
once the connection is established.
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Manual installation of CA certificates
Proceed as follows:

1. Log on to the system as administrator.

2. Open the Windows Certificate Manager on your programming device/PC with the 
Microsoft® Management Console. 
Click "Start", enter "mmc" in the search field and press ENTER. 
The console will open.

3. Open the "File" menu and click "Add/remove snap-in...".
The "Add/remove snap-in..." dialog will open. 

4. Double-click "Certificates" in the "Snap-in" list and select "Computer account" in the dialog 
that opens.

5. Select "Local computer" in the next dialog and click "Finish" and "OK".
The console root opens and the "Certificates (local computer)" folder appears.

6. Open the displayed "Certificates (local computer)" folder and click "Trusted certification 
authorities".

7. Click the "Certificates " folder and use the shortcut menu to access the command "All tasks" 
> "Import...".

8. Note the information that appears in the "Certificate - Import wizard" dialog and click "Next".

9. In the dialog that follows, click "Browse ..." and select the required CA certificate.

10.Then click "Next" twice and subsequently "Finish" to install the CA certificate.

Result
The selected CA certificate is installed at the specified location in the Windows certificate 
memory.

 
 

 Note
Additional information ...

... on installing CA certificates can be found using the "F1" button in the online help of your 
operating system.
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12.7.4.4 Deleting CA certificates for VPN connections

Deleting CA certificates
Proceed as follows:

1. Log on to the system as administrator.

2. Open the Windows Certificate Manager on your programming device/PC with the 
Microsoft® Management Console. 
Click "Start", enter "mmc" in the search field and press the ENTER KEY. 
The console will open.

3. Open the "File" menu and click "Add/remove snap-in...". 
The snap-in selection dialog will open. 

4. Double-click "Certificates" in the "Snap-in" list and select "Computer account" in the dialog 
that opens.

5. Select "Local computer" in the next dialog and click "Finish" and "OK".
The console root opens and the "Certificates (local computer)" folder appears.

6. Open the displayed "Certificates (local computer)" folder and click "Trusted certification 
authorities".

7. Open the "Certificates" folder, select the required CA certificate and click "Delete" in the 
shortcut menu.

8. Confirm the next prompt with "Yes".

Result
The selected CA certificate is deleted from the list of available certificates.

12.7.4.5 Establishing a VPN connection to a remote system

Establishing VPN connections

Introduction to establishing VPN connections
A VPN connection is established when you use TeleService to connect to a remove system 
over the Internet. 

To do this, your programming device/PC with installed TIA Portal is connected to the Internet 
at one end. At the other end, the automation system is connected to the Internet via the WAN 
(Wide Area Network) interface of the configured TS Adapter IE Advanced.  

Requirement
Your programming device/PC is connected to the Internet.   

There is a TS Adapter IE Advanced in the remote system.
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The TS Adapter IE Advanced has been configured and is connected to the Internet. 

The CA certificate required for identifying the TS Adapter has been generated and installed in 
the Windows certificate store of your programming device/PC.

Proceed as follows:
1. In the project tree of the TIA portal, open the "Online access" folder.

2. Click on the "TeleService" folder it contains.

3. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

4. Select the "TS Adapter IE Advanced" as "Adapter type" from the drop-down list. 

5. Enter "VPN" as "connection type".

6. Enter the IP address / DNS name for the TS Adapter IE Advanced to be contacted in the 
relevant field. Alternatively, you can apply any existing data from the phone book by clicking 
the corresponding button.

7. Enter your user name and the corresponding password.

8. Click the "Establish" button to establish the required VPN connection. This button only 
becomes active once you have entered all the parameters needed for establishing the 
remote connection. 

Result
The VPN connection to the required system is established. "Status" indicates the progress in 
establishing the connection. The dialog closes once the VPN connection is established. The 
following message appears in the TIA Portal status bar: "Remote connection is established". 
You can now use the remote connection with TIA Portal and communicate with the automation 
system.

 

Connection cannot be established
If the connection cannot be established, try to find the cause using the "Notes on 
troubleshooting".

 
 

 Note
Rules for IP addresses
● Only use IP addresses which have not yet been assigned in the system network. 
● If the IP address configured for the TS Adapter IE Advanced has already been assigned 

in the system network, the TS Adapter IE Advanced can only be addressed by its MAC 
address.
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See also
Installing CA certificates for VPN connections (Page 6246)

Terminating VPN connections

Terminating an active VPN connection
 

 

 Note
Terminating the VPN connection

You should go offline in the TIA portal before you terminate the VPN connection.
 

Proceed as follows:
1. Double-click the "Set up/close remote connection" entry in the TIA portal. 

2. Confirm the prompt in the dialog that follows with "Yes".

Result
The VPN connection is terminated. 

 

12.7.4.6 TS Adapter IE Advanced

Short description of the TS Adapter IE Advanced

TS Adapter IE Advanced
The TS Adapter IE Advanced has the following properties:

● Direct connection over Industrial Ethernet (IE), 2 ports

● WAN (Wide Area Network) interface for VPN connections

● Firmware update supported

● Plug-in modules

● Parameters are assigned via a Web interface.
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 Note
Further information on the TS Adapter IE Advanced

For detailed information on your TS Adapter, please refer to the documentation supplied with 
your TS Adapter.

 

Connection types

TS Adapter IE Advanced connection types
The following diagrams show the types of connection possible with the 
TS Adapter IE Advanced.

Direct connection
In the direct connection to the programming device/PC, you can set the 
TS Adapter IE Advanced parameters over the Ethernet.

Figure 12-5 TS Adapter IE Advanced - direct connection
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Connection to the Internet (DSL modem/router)
In order to connect to the Internet, you must operate the DSL modem/router at the WAN 
connection of the TS Adapter IE Advanced.

Figure 12-6 TS Adapter IE Advanced - connection to the Internet

Connection to the company network (Intranet)
In order to connect to the Intranet, you must operate system network (Ethernet) at one of the 
two LAN connections of the TS Adapter IE Advanced.

Figure 12-7 TS Adapter IE Advanced - connection to company network (Intranet)

Additional information
For more detailed information on the TS modules, please refer to the documentation supplied 
with your TS Adapter IE Advanced.

TS Adapter IE Advanced parameter assignment options

Basics on configuring the TS Adapter IE
The TS Adapter IE Advanced is configured via a Web interface. 

Web help in the Web interface is available for assigning TS Adapter IE Advanced parameters.

Parameter assignment options include:
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● Reconfiguration

● Restoring default parameter assignment

● Importing adapter parameters

● Exporting adapter parameters
 

 Note
Parameter assignment

Configure your TS Adapter IE Advanced in accordance with the documentation supplied. 
This details the exact procedure for parameter assignment.

 

Parameter assignment for TS Adapter IE Advanced

Introduction
The TS Adapter IE Advanced  can be configured in both direct connection mode and via an 
existing remote connection.   

Both parameter assignment options are described below. 

Specific details on assigning parameters for the TS Adapter IE Advanced are available in the 
TS Adapter IE Advanced documentation.

Assigning parameters for the TS Adapter IE Advanced in direct connection
 

Requirement
There is a LAN connection to your TS Adapter IE Advanced. 

Procedure
To assign the parameters for the TS Adapter IE Advanced, proceed as follows:

1. In the project tree of the TIA portal, open the "Online access" folder.

2. Double-click on the Ethernet port of your computer.

3. Double-click on the "Display accessible nodes" command. The TS Adapter IE Advanced 
is then displayed.

4. Double-click on the <TS Adapter IE Advanced> folder and then on "Online and diagnostics", 
and assign the desired IP address to the TS Adapter in the dialogs that follow. Please note 
that the IP address of the programming device/PC interface card must be located in the 
same subnet as the IP address that you assign for the TS Adapter IE Advanced.

5. Update the view in the project tree for the "Accessible nodes", so that the TS Adapter IE 
Advanced is displayed with the newly assigned IP address.
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6. Open the folder <TS Adapter IE Advanced> in the device list.

7. Double-click the command "Assign TS Adapter IE Advanced parameters". The 
corresponding Web interface opens for assigning TS Adapter IE Advanced parameters.

8. Complete the "logon" for the web interface.

9. Set the required parameters in the individual tabs of the dialog.

10.Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter IE 
Advanced. Parameter assignment is then complete.

Assigning parameters for the TS Adapter IE Advanced using a remote connection
 

Requirement
There is an established remote connection to a TS Adapter IE Advanced..

Procedure
1. In the project tree of the TIA Portal, open the "Online access" folder.

2. Open the "TeleService" folder followed by the required plant folder.

3. Double-click the command "Assign TS Adapter IE Advanced parameters". The associated 
web interface for assignment of the TS Adapter IE parameters opens. The "logon" for the 
web interface takes place automatically with the login data of the remote connection.

4. Set the required parameters in the individual tabs of the dialog.

5. Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter IE 
Advanced. Parameter assignment is then complete.
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12.7.5 CPU controlled TeleService remote connections 

12.7.5.1 Overview of CPU controlled remote connections

Introduction
TeleService offers a range of options for establishing remote connections; these differ 
according to the CPU used. The initiative for establishing a connection starts from the CPU. 
The communications instructions given below are used for the individual connection options.

Connection establishment with S7-300/400 CPUs
The following communications instructions are available:   

● Communications instruction "PG_DIAL": Establish remote connection to programming 
device/PC

● Communications instruction "SMS_SEND": Send text message (SMS)

● Communications instruction "AS_DIAL": Establish remote connection to AS

● Communications instruction "AS_MAIL": Transfer email

Connection establishment with S7-1200 CPUs
The following communications instruction is available:   

● Communications instruction "TM_MAIL": Transfer email

Connection establishment with S7-1500 CPUs
The following communications instruction is available:   

● Communications instruction "TMAIL_C": Transfer email
 

 Note
Description of individual communications instructions

More detailed information on the available communications instructions can be found in the 
information system of the TIA Portal in the directory "References > Communication > 
TeleService".

 

 

See also
TS Adapter IE parameter assignment options (Page 6239)
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12.7.5.2 Establishing a connection from and to remote systens (PG-AS-remote coupling)

Remote plant access to a programming device/personal computer

Introduction
You can establish a remote connection to and communicate with a remote system using the 
application TeleService and a TS Adapter MPI. The initiative for establishing the remote 
connection comes from the programming device/personal computer. 

However, events which require rapid intervention often occur at a remote system. In such 
cases, the automation system can initiate a remote connection to a programming device/
personal computer if an asynchronous event occurs.

The graphic below shows the components which are required for establishing a connection 
from a plant to a programming device/personal computer.

Figure 12-8 How the "PG_DIAL" communications instruction works

Requirements for establishing a connection

Introduction
Certain hardware and software requirements must be fulfilled if a remote system is to establish 
a remote connection to a programming device/personal computer. These requirements are 
detailed below.  

Hardware requirements:
The only hardware required for establishing a remote connection from a remote system to a 
programming device/personal computer is that needed for accessing the remote system from 
the programming device/personal computer.  
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Your user program calls the communication instruction "PG_DIAL"  to establish the connection. 
This can only be executed on an S7-300 or S7-400 CPU on which S7 basic communication is 
implemented.  

A TS Adapter I , version 5.0 or later, or a TS Adapter II  must be used.

Software requirements at the plant end:
Communication instruction "PG_DIAL" is included in the TeleService scope of delivery and is 
installed when the TIA portal is installed. You will find the communication instructions installed 
in the "Communication > TeleService" folder of the block editor task card.  

If a remote system is to establish a remote connection to a programming device/personal 
computer, the plant user program must call the "PG_DIAL" function block. 

Software requirements for the programming device/personal computer
You require a software product in the programming device/personal computer which, with 
TeleService, waits for a call from a remote system, recognizes this call and informs your user 
program.  

12.7.5.3 Data exchange between remote systems (AS-AS-remote coupling)

AS-AS remote link basics

Introduction
The AS-AS remote link allows two automation systems to exchange process data via the 
telephone network.

Requirement
Communication instruction "AS_DIAL"  is available if you use a CPU from the S7-300/400 
family.  

Definition: Local and remote automation system   
● The automation system from which the initiative to establish the remote connection 

originates is described as local.

● The automation system to which the remote connection is to be established is described 
as remote.

Data exchange over the AS-AS remote link
Data exchange is carried out using specific communication instructions for non-configured S7 
connections. Use the communication instruction "AS_DIAL" to establish a remote connection 
to the automation system. 
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More detailed information on establishing the connection can be found in the information 
system in the directory "References > Communication > TeleService".

The following graphic shows the components required for establishing a connection from a 
local to a remote automation system.

Figure 12-9 Data exchange over the AS-AS remote link

Hardware and software requirements for AS-AS remote link

Introduction
Certain hardware and software requirements must be fulfilled before a local automation system 
can establish a remote connection to a remote automation system. These requirements are 
detailed below.  

Hardware requirements
The only hardware you need for transferring process data from a local to a remote automation 
system is that also needed for accessing the respective automation system from the 
programming device/personal computer.  

To establish and terminate the remote connection, the TIA Portal user program of the local 
CPU calls a communication instruction. This communication instruction can be executed on 
an S7-300/400 CPU or a C7 CPU. The communication instruction requires S7 basic 
communication to be implemented on the CPU. The remote CPU must also support S7 basic 
communication.

A TS Adapter I, version V5.1 or later, or a TS Adapter II must be used.
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Software requirements
The "AS_DIAL" communication instruction is included in the product package of TeleService, 
and is integrated into the library of the TIA Portal during the installation in the communication 
instructions folder of the Task Card under TeleService. In order to establish and terminate a 
remote connection to a remote automation system from a local automation system, call the 
communication instruction "AS_DIAL" in the TIA Portal user program of the local CPU.  

Figure 12-10 Hardware and software requirements for AS-AS remote link

12.7.5.4 Send SMS from a system

Requirements for sending an SMS

Introduction
Certain hardware and software requirements must be fulfilled before a system can send an 
SMS. These requirements are detailed below.     

Hardware requirements 
To send an SMS from a system, you will require a GSM wireless modem and a 
TS Adapter MPI.   

A TS Adapter I, version V5.2 or later, or a TS Adapter II  must be used.
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Software requirements at the system end
The "SMS_SEND" communications instruction is included in the scope of delivery of 
TeleService, and is integrated into the library of the TIA Portal during the installation in the 
communications instructions folder of the Task Card under TeleService. If a system is to send 
an SMS, the user program of the system must call the communications 
instruction "SMS_SEND".   

Figure 12-11 How the "SMS_SEND" communications instruction works

 
 

 Note

You may be able to send an SMS not only to a cell phone but also to an email address or a 
fax device by using additional services offered by the cell phone service provider.

 

12.7.5.5 Send an email from a system

Requirements for sending e-mails

Introduction
The following hardware and software requirements must be fulfilled if a system is to send an 
email:     
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Hardware requirements
You need a TS Adapter IE to send an email from a system and one of the CPUs listed below:  

● a CPU 31x2 PN/DP as of firmware version V2.5

● a CPU 41x-3 PN/DP

● a CPU of the S7-1200 series with Ethernet connection

● a CPU of the S7-1500 series

Software requirements at the system end
Different communications instructions are included in the scope of delivery of TeleService 
depending on the CPU that are integrated into the library of the TIA Portal during the installation 
in the communications instructions folder of the Task Card under TeleService.   

If a system is to send an email, the user program of the system must call the corresponding 
communications instruction for the CPU. 

The following communications instructions are available for sending an email:

● S7-300/400 CPUs: use the communications instruction "AS_MAIL": Transfer email

● S7-1200 CPUs: use the communications instruction "TM_MAIL": Transfer email

● S7-1500 CPUs: use the communications instruction "TMAIL_C": Transfer email

The respective communications instruction transfers an email from a CPU to a mail server by 
means of the Simple Mail Transfer Protocol (SMTP) with the "LOGIN" authentication method. 
The data is transferred unencrypted with this SMTP process.

The figure below shows an example with the communications instruction "AS_MAIL":
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The "Use gateway/router" property must also be set for the Ethernet interface in the 
configuration of the CPU on which the communications instruction "AS_MAIL" runs. (available 
in the device configuration under Ethernet addresses and there under IP protocol)The IP 
address of the Ethernet interface of the TS Adapter IE is to be specified as "Address".

 
 

 Note

You can find further information in the task card in the "Communications instructions" folder 
under TeleService.
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12.7.6 Notes on troubleshooting

12.7.6.1 General information on troubleshooting for modem problems

Introduction
The information below should help you establish and eliminate the causes of any modem 
problems.  

1. Enable "Record log file" for data traffic between PG/PC and modem. The entries in this file 
can provide valuable information for determining the cause of errors.

2. Switch on the loudspeaker on your local modem. Select a volume loud enough to be clearly 
heard.
You can then hear whether:

– there is a dial tone at the connection

– the modem called is busy

– the modem called accepts the call.

Common modem problems
Modem connection problems are among the most common modem problems:  

● Modem connection is not established

● Modem connection is interrupted

The topics below contain tables detailing possible causes and providing information on 
eliminating the error in question.

See also
Dial-up connection to the TS Adapter is not established (Page 6267)

Dial-up connection from the TS Adapter is not established (Page 6268)

Modem connection is interrupted (Page 6269)

Modem alarms (Page 6270)

Recording a log file for the modem (Page 6266)

12.7.6.2 Recording a log file for the modem

Introduction
It is advisable to record a log file as this makes it easier to find the causes of faults in a modem.
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Procedure:
Proceed as follows:

1. Activate the properties dialog of the modem used via the "Phone and modem options" option 
in the Control Panel.

2. Check the settings of the "Log" option in the "Diagnostics" tab and if necessary change the 
log file settings so that the file is recorded.

Result:
Activity between the programming device/personal computer and the modem are entered in 
the log file. If there are problems establishing the connection, you can evaluate the data 
recorded in the log file to determine the cause of the error.

12.7.6.3 Dial-up connection to the TS Adapter is not established

Dial-up connection to TS Adapter is not established
The table below sets out possible causes and how to eliminate them if no remote connection 
to the TS Adapter can be established.   

Possible cause Check/Remedy
Cabling faulty ● Are all the connecting cables connected correctly?

● Are the connectors loose?
Dial parameters for main telephone 
line and extension incorrectly set

● Do the properties and dial parameters of your modem match the phone connection 
to main phone line or extension?

● Do not specify a dial-out code in the "Dial parameters" dialog if you operate your 
modem on a local loop (main telephone line).
The fields for the dial-out code for local calls and long-distance calls must be empty.

Dialing mode incorrectly set ● Is the correct dialing mode (tone/pulse) set in the dialog for the dial parameters of 
your modem?

● Use a connected telephone to check the connection on which you want to operate 
the modem. 
You should hear crackling noises on the telephone during pulse dialing and tones 
of varying pitches during tone dialing. 
Set the corresponding dialing mode in the modem dial parameters.
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Possible cause Check/Remedy
Dial disable active ● The dial disable function is a country-specific modem property which, depending 

on the modem, becomes effective after one or more unsuccessful attempts to 
establish a connection.

● If your modem still does not respond after several attempts to dial, the dial disable 
function may be active. Characters are still sent to the modem after the dial 
command but the modem does not start the dialing process. The driver receives a 
general error message.

● Refer to the modem documentation for information on how the dial disable function 
is implemented for your modem.

● Create a log file (Page 6264) (modemlog.txt) in which the activities between the 
programming device/personal computer and modem are recorded.
Then check whether the file contains an entry caused by dial disable (e.g. 
DELAYED).

Phone connection defective or busy ● Connect a phone and check whether a dial tone can be heard on this connection.
● Any analog phone connected on the same connection must be hung up. 

You cannot establish an additional modem connection on this connection if there 
is an existing phone connection.

Serial parameters set incorrectly ● Are the correct values entered in the "Settings" tab for modem properties (8 data 
bits, no parity, 1 stop bit)?
Is the correct COM interface set in the "General" tab for the modem properties?

Initialization string of the 
TS Adapter is not suitable for the 
modem.

● Familiarize yourself with the modem initialization string requirements and set the 
string accordingly.
Procedure for configuring the TS Adapter IE (Page 6236) 

Settings for error correction 
between the modem at the 
TS Adapter and the modem at the 
PC/programming device are not 
compatible.

● Adapt the modem settings.
Useful information on configuring the TS Adapter MPI (Page 6231) 
Restoring the default parameter assignment of a TS Adapter MPI (Page 6233) 
Procedure for configuring the TS Adapter IE (Page 6232) 

12.7.6.4 Dial-up connection from the TS Adapter is not established

No callback from TS Adapter
The table below sets out possible causes and how to eliminate them if there is no callback 
from the TS Adapter.

Possible cause Check/Remedy
Errors in the location or call 
settings in the TS Adapter 

Check the TS Adapter parameter assignment:
● Are the dialing mode and dial-out code set correctly for your phone connection?
● Does the modem at the TS Adapter  support the characters configured for the dial-

out code?
● Is "Wait for dial tone before dialing" deactivated for an extension?

Initialization of modem 
insufficient

Check the string for modem initialization:
● The modem may require a further initialization in order to establish a remote 

connection.
● Properties of the modem initialization string for the TS Adapter MPI 

Callback number is incorrect Check the configuration of the callback number you assigned.
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No call from TS Adapter MPI
The table below sets out possible causes and and how to remedy them if there is no call from 
the TS Adapter MPI.

Possible cause Check/Remedy
Phone number is incorrect Is the required number being transferred to the communication instruction "PG_DIAL" ?
TS Adapter MPI  parameter 
assignment incorrect

Check the TS Adapter MPI parameter assignment:
● Are the dialing mode and dial-out code set correctly for your phone connection?
● Does the modem at the TS Adapter MPI support the characters configured for the 

dial-out code?
● Is "Wait for dial tone before dialing" deactivated for an extension?

12.7.6.5 Modem connection is interrupted

Modem connection is interrupted
The table below sets out possible causes and and how to remedy them if the modem 
connection is interrupted.     

Possible cause: Check / Remedy:
Metering pulses in the line Metering pulses will be generated if you have applied to the phone company for a 

metering clock. This may mean that the modem no longer recognizes the carrier signal 
and switches off.
● Set a longer waiting or switch-off time at the modem.
● Have the metering pulse deactivated by the phone company.

Shielding ● Are the connection cables used shielded sufficiently?
● Make sure that the modem cables do not run next to power cables and that they 

are as far as possible from power supply units and monitors.
Protocol timeout ● Set fixed monitoring times.
Automatic connection termination ● Deactivate the option that terminates an existing connection automatically after a 

specified time without data transfer ("Terminate after idle of ...").
Data flow control deactivated ● Click on the "Extended" button in the "Settings" tab of the modem properties and 

activate the following options in the dialog displayed (if available and not yet set):
– Data flow control
– Hardware (RTS/CTS)
– Data compression
– Error control

Initialization string of the 
TS Adapter  is not suitable for the 
modem

● Set the modem initialization string in accordance with the following requirements.
See also: TS Adapter IE parameter assignment options (Page 6239) 

See also
TS adapter MPI configuration options (Page 6231)
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12.7.6.6 Checklist for troubleshooting the modem

Introduction
The following list should help you establish the potential cause of any problems with the 
modem. The help topics below set out how and in which dialogs you define the relevant 
settings.  

Modem connection cannot be established:
● Check the cabling and the connections. 

● Check whether the correct dialing mode (tone/pulse) is set. 

● If your modem does not react after several attempts to dial, a dial disable function may be 
active. Familiarize yourself with dial disable on your modem.

● Are you operating your modem on a main telephone line or on an extension line? Configure 
the properties and dialing parameters of the modem accordingly.

● Enable the log file option in the advanced properties. The next attempt to establish a 
connection will then be recorded in a file in the Windows directory.

● Ensure that the ISDN TAs used work with the same B and D channel protocol.

The modem connection is terminated:
● Metering pulses can have a negative affect on a connection. Have the pulses deactivated 

by your telephone company. 

● Set fixed monitoring times.

● Deactivate the option that terminates an existing connection automatically after a specified 
time without data transfer (idle).

● Make sure that you have activated RTS/CTS for data flow control.

12.7.6.7 Modem alarms

Information in the log file 
The modem alarms are entered in a log file if you have activated the recording function.  

The log file contains the following information:

Alarm: Possible cause: Remedy:
NO DIALTONE A phone call may currently be being carried out 

on this line.
● Repeat the process once the phone call is over.

NO CARRIER The device dialed is not ready, is not a modem 
or cannot establish a connection in the set 
operating mode.

● Check the numbers and the settings.
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Alarm: Possible cause: Remedy:
BUSY The device dialed is busy. ● Try again later.
DELAYED: ... Dial disable ● Refer to the modem documentation for 

information on how the dial disable function is 
implemented for your modem and if necessary 
remove it.

12.7.6.8 Possible error messages with VPN connections

VPN connection to TS Adapter IE Advanced is not established
The table below sets out possible errors and how to eliminate them if no VPN connection to 
the TS Adapter IE Advanced can be established.   

Possible errors Check/Remedy
The error message "The webpage 
cannot be displayed" appears when 
the Web interface is accessed.

● Note: This problem occurs when the Windows certificate store contains a CA 
certificate with the same name as the CA certificate which has just been generated.

● If a CA certificate for this TS Adapter is already installed in the Windows certificate 
store and you have generated a new CA certificate on the TS Adapter, you need 
to remove the old CA certificate from the Windows certificate store and install the 
newly generated CA certificate. 

● See also: Installing CA certificates for VPN connections (Page 6246)
● See also: Deleting CA certificates for VPN connections (Page 6249)

"Error during connection 
establishment" error message.

● Check whether other users have been saved in the TS Adapter IE Advanced user 
database. 

● Check which user is attempting to establish a remote connection. You cannot 
establish a remote connection if you are logged on as "Administrator".

"No matching CA certificate found 
in Windows certificate store" error 
message.

● Use the automatic certificate download. Enter the fingerprint in the corresponding 
field in the connection dialog.

● See also: Establishing VPN connections (Page 6249)
Or

●  Export the CA certificate from the Web interface of the TS Adapter IE Advanced 
and install it manually in the Windows certificate store.

● See also: Installing CA certificates for VPN connections (Page 6246)
Error message: "The remote 
address specified does not 
correspond to the remote address 
of the TS Adapter".

● You must use the remote address which you specified in the TS Adapter IE 
Advanced to establish the connection. 

● You cannot use the IP address if you have entered the DNS name (and vice versa).

Error message: "The signature of 
the certificate could not be verified".

● If you have generated a new CA certificate on the TS Adapter IE Advanced, you 
need to delete the old CA certificate from the Windows certificate store and install 
the new one. 

● See also: Deleting CA certificates for VPN connections (Page 6249)
● See also: Installing CA certificates for VPN connections (Page 6246)

An e-mail cannot be sent. ● Check whether there is a network/Internet connection at the WAN port.
● Check whether the mail server is accessible.
● Check whether the outgoing connections in the TS Adapter IE Advanced are valid.
● Check whether the SMTP port in the firewall is open for outgoing connections.
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Hardware documentation 13
13.1 General information on the hardware documentation

Additional information on the available hardware   
The TIA Portal can be used to configure a wide variety of hardware, depending on the installed 
products. You can find the available hardware in the hardware catalog. You can find all the 
current manuals, operating instructions and FAQs as well as updates for your devices in the 
Service and Support section (https://support.automation.siemens.com/) of the Siemens 
Website.

To help you locate the appropriate documents for your hardware in the Service and Support 
area, the following sections list all modules and module families that are available in the current 
scope of the installation of the TIA Portal. You will find a link for each module that takes you 
directly to the relevant manuals and operating instructions in the Service and Support area.
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13.2 HMI

13.2.1 Basic Panels

13.2.1.1 Basic Panels
Information about Basic Panels is available here (http://support.automation.siemens.com/WW/
view/en/28426379/133300).

13.2.2 Panels

13.2.2.1 Panels of the 70 series
Information about Basic Panels of the 70 series is available here (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&groupid=4000002&extranet=standard&viewreg=WW&n
odeid0=15271786&objaction=csopen).

13.2.2.2 Panels of the 170 series
Information about panels of the 170 series is available here (http://
support.automation.siemens.com/WW/view/en/10805566/133300).

13.2.2.3 Panels of the 270 series
Information about panels of the 270 series is available here (http://
support.automation.siemens.com/WW/view/en/10805567/133300). 

13.2.3 Comfort Panels

13.2.3.1 Comfort Panels
Information about Comfort Panels is available here (http://support.automation.siemens.com/
WW/view/en/47182890/133300).
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13.2.4 Multi Panels

13.2.4.1 170 series
Information about Multi Panels of the 170 series is available here. (http://
support.automation.siemens.com/WW/view/en/28421795/133300)

13.2.4.2 270 series
Information about Multi Panels of the 270 series is available here (http://
support.automation.siemens.com/WW/view/en/10805569/133300).

13.2.4.3 370 series
Information about Multi Panels of the 370 series is available here (http://
support.automation.siemens.com/WW/view/en/10805570/133300).

13.2.5 Mobile Panels

13.2.5.1 170 series
Information about Mobile Panels of the 170 series is available here (http://
support.automation.siemens.com/WW/view/en/26268543/133300).

13.2.5.2 270 series
Information about Mobile Panels of the 270 series is available here (http://
support.automation.siemens.com/WW/view/en/22584001/133300).

13.2.6 Key Panels

13.2.6.1 Key Panels
Information about Key Panels is available here (http://support.automation.siemens.com/WW/
view/de/47416561/0/en).
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13.2.6.2 Push Button Panels
Information about Push Button Panels is available here (http://
support.automation.siemens.com/WW/view/en/19860219/133300).

13.2.7 WinAC for Multi Panels

13.2.7.1 WinAC for Multi Panels
Information about WinAC MP is available here (http://support.automation.siemens.com/WW/
view/en/10997567/130000).
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13.3 PLC

13.3.1 SIMATIC S7-1200

13.3.1.1 CPU

CPU 1211C (6ES7 211-1xxx-0XB0)
Information on CPUs 1211C AC/DC/Rly, 1211C DC/DC/DC and 1211C DC/DC/Rly is available 
here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111BD300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CPU 1212C (6ES7 212-1xxx-0XB0)
Information on CPUs 1212C AC/DC/Rly,1212C DC/DC/DCand 1212C DC/DC/Rly is available 
here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121BD300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CPU 1214C (6ES7 214-1xxx-0XB0)
Information on CPUs 1214C AC/DC/Rly, 1214C DC/DC/DC and 1214C DC/DC/Rly is available 
here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141BE300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CPU 1215C (6ES7 215-1xxx-0XB0)
Information on CPUs 1215C DC/DC/DC, 1215C AC/DC/Rly and 1215C DC/DC/Rly is available 
here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72151HG400XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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CPU 1217C (6ES7 217-1xxx-0XB0)
Information on the 1217C DC/DC/DC CPU is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72171AG400XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

13.3.1.2 Signal boards (6ES7 2xx-xxx30-0XB0)
Information on signal boards for S7-1200 is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72213BD300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

   

   

   

   

   

   

   

   

   

  

 

13.3.1.3 CB 1241 (6ES7 241-1CH30-1XB0)
Information on the CB 1241 communication board is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411CH301XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

13.3.1.4 BB 1297 (6ES7 297-0AX30-0XA0)
Information on the CB 1241 communication board is available here (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=100&lang=en&referer=%2fWW
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%2f&func=cslib.cssearch&nodeid0=41886045&viewreg=WW&siteid=csius&extranet=standar
d&groupid=4000002&objaction=cssearch&content=adsearch%2Fadsearch%2Easpx).

   

13.3.1.5 Digital input modules (6ES7 221-1Bx30-0XB0)
Information on digital input modules DI8 x 24VDC and DI16 x 24VDC is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72211BF300XB0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

13.3.1.6 Digital output modules (6ES7 222-1xx30-0XB0)
Information on the following digital output modules is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221BF300XB0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view):

● DQ8 x 24VDC

● DQ16 x 24VDC

● DQ16 x relay

● DQ8 x relay

● DQ8 x NO/NC relay

13.3.1.7 Digital input and output modules (6ES7 223-1xx30-0XB0)
Information on the following digital input and output modules is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231BH300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view):

● DI8/DQ8 x 24VDC

● DI16/DQ16 x 24VDC

● DI8 x 24VDC / DQ8 x relay

● DI16 x 24VDC / DQ16 x relay

● DI8 x 120VDC / DQ8 x relay
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13.3.1.8 Analog input modules (6ES7 231-xxx30-0XB0)
Information on the following analog input modules is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72314HD300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view):

● AI4 x 13Bit

● AI4 x 16Bit

● AI8 x 13Bit

● AI4 x RTD

● AI8 x RTD

● AI4 x TC

● AI8 x TC

13.3.1.9 Analog output modules (6ES7 234-4Hx30-0XB0)
Information on analog output modules AQ2 x 14Bits and AQ4 x 14Bits is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

13.3.1.10 Analog input and output module (6ES7 234-4HE30-0XB0)
Information on the analog input and output modules AI4 x 13Bits / AQ2 x 14Bits is available 
here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

Hardware documentation
13.3 PLC

WinCC Comfort/Advanced V12.0 SP1
6278 System Manual, 07/2013,  

http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72314HD300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72314HD300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72314HD300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72314HD300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view


13.3.1.11 Communications modules

Industrial Remote Control

CP 1242-7 (6GK7 242-7KX30-0XE00)
Information on the CP 1242-7 Telecontrol communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK72427KX300XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CP 1243-1 (6GK7 243-1JX30-0XE0)
Information on the CP 1243-1 Ethernet communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK72431JX300XE0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

PROFIBUS

CM 1242-5 (6GK7 242-5DX3x-0XE0)
Information on the CM 1242-5 PROFIBUS communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK72425DX300XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1243-5 (6GK7 243-5DX3x-0XE0)
Information on the CM 1243-5 PROFIBUS communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK72435DX300XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

Point-to-point

CM 1241 RS232 (6ES7 241-1AH30-0XB0)
Information on the CM 1241 (RS232) communication module for point-to-point connections is 
available here (http://support.automation.siemens.com/WW/llisapi.dll?
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func=cslib.csinfo&lang=en&objid=6ES72411AH300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1241 RS232 (6ES7 241-1AH32-0XB0)
Information on the CM 1241 (RS232) communication module for point-to-point connections is 
available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411AH320XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1241 RS485 (6ES7 241-1CH30-0XB0)
Information on the CM 1241 (RS485) communication module for point-to-point connections is 
available here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411CH300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1241 RS422/485 (6ES7 241-1CH31-0XB0)
Information on the CM 1241 (RS422/485) communication module for point-to-point 
connections is available here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411CH310XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1241 RS422/485 (6ES7 241-1CH32-0XB0)
Information on the CM 1241 (RS422/485) communication module for point-to-point 
connections is available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411CH320XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

AS-Interface

AS-Interface CM 1243-2 (3RK7243-2AA30-0XB0)
Information on the CM 1243-2 AS-i communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=3RK72432AA300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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13.3.1.12 Technology modules

SIWAREX WP231 (7MH4960-2AA01)
Information on the SIWAREX WP231 weighing module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=7MH4960-2AA01&objaction=csviewmlfbbeitraege&subtyp
e=133300&caller=view).

4SI IO-Link (6ES7 278-4BD32-0XB0)
Information on the 4SI IO-Link IO-Link Master technology module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72784BD320XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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13.4 Distributed I/O

13.4.1 ET 200MP

13.4.1.1 Interface modules

PROFINET

IM 155-5 PN ST (6ES7 155-5AA00-0AB0)
Information on the distributed I/O module IM 155-5 PN ST is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71555AA000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

13.4.2 ET 200SP

13.4.2.1 Interface modules

PROFINET

IM 155-6 PN ST (6ES7155-6AU00-0BN0)
You can find information on the interface module IM 155-6 PN ST here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556AU000BN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

IM 155-6 PN ST V1.1 (6ES7 155-6AU00-0BN0)
Information on the interface module IM 155-6 PN ST V1.1 is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556AU000BN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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IM 155-6 PN HS (6ES7155-6AU00-0NN0)
You can find information on the interface module IM 155-6 PN HS here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556AU000NN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

IM 155-6 PN HF (6ES7155‑6AU00‑0CN0)
You can find information on the interface module IM 155-6 PN HF here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556AU000CN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

IM 155-6 PN HF V2.0 (6ES7 155-6AU00-0CN0)
Information on the  IM 155-6 PN HF V2.0 interface module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556AU000CN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

BusAdapter

BusAdapter BA 2xRJ45 (6ES7 193-6AR00-0AA0)
Information on the BusAdapter BA 2xRJ45 is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936AR000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

BusAdapter FC (6ES7 193-6AF00-0AA0)
Information on the BusAdapter FC is available here (https://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936AF000AA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).
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PROFIBUS

IM 155-6 DP ST (6ES7155-6BA00-0BN0)
You can find information on the interface module IM 155-6 DP ST here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556BA000BN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

Point-to-point

CM PtP (6ES7137-6AA00-0BA0)
Information on the communication module CM PtP is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71376AA000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

Other fieldbuses

IM 155-6 Receive (6ES7155-6DU00-0BN0)
You can find information on the interface module IM 155-6 Receive here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71386AA000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

BusAdapter

BusAdapter Send (6ES7 193-6AS00-0AA0)
Information on the BusAdapter Send is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936AS000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

BusAdapter Receive (6ES7 193-6AE00-0AA0)
Information on the BusAdapter Receive is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
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func=cslib.csinfo&lang=en&objid=6ES71936AE000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

13.4.2.2 Digital input modules

DI 8x24VDC ST (6ES7 131-6BF00-0BA0)
Information on the digital input module DI 8x24VDC ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316BF000BA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DI 8x24VDC HF (6ES7 131-6BF00-0CA0)
Information on the digital input module DI 8x24VDC HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316BF000CA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DI 8x24VDC HF V2.0 (6ES7 131-6BF00-0CA0)
Information on the digital input module DI 8x24VDC HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316BF000CA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DI 8xNAMUR (6ES7 131‑6TF00‑0CA0)
Information on the digital input module DI 8x24VDC HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316TF000CA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DI 16x24VDC ST (6ES7 131-6BH00-0BA0)
Information on the digital input module DI 16x24VDC ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316BH000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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13.4.2.3 Digital output modules

DQ 16x24VDC/0.5A ST (6ES7 132-6BH00-0BA0)
Information on the digital output module DQ 16x24VDC/0.5A ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BH000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

RQ 4x24VDC..230VAC/5A NO (6ES7 132-6HD00-0BB0)
Information on the relay output module RQ 4x24VUC...230VUC/5A is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326HD000BB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DQ 4x24VDC/2A ST (6ES7 132-6BD20-0BA0)
Information on the digital output module DQ 4x24VDC/2A ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BD200BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DQ 8x24VDC/0.5A ST (6ES7 132-6BF00-0BA0)
Information on the digital output module DQ 8x24VDC/0.5A ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BF000BA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DQ 8x24VDC/0.5A HF (6ES7 132-6BF00-0CA0)
Information on the digital output module DQ 8x24VDC/0.5A HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BF000CA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DQ 8x24VDC/0.5A HF V2.0 (6ES7 132-6BF00-0CA0)
Information on the digital output module DQ 8x24VDC/0.5A HF V2.0 is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
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func=cslib.csinfo&lang=en&objid=6ES71326BF000CA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

13.4.2.4 Analog input modules

AI 4xRTD/TC 2-/3-/4-wire HF (6ES7 134-6JD00-0CA1)
Information on the analog input module AI 4xRTD/TC 2-/3-/4-wire HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346JD000CA1&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

AI 4xRTD/TC 2-/3-/4-wire HF V2.0 (6ES7 134-6JD00-0CA1)
Information on the analog input module AI 4xRTD/TC 2-/3-/4-wire HF V2.0 is available here 
(https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346JD000CA1&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

AI 4xU/I 2-wire ST (6ES7 134-6HD00-0BA1)
Information on the analog input module AI 4xU/I 2-wire ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346HD000BA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AI 4xI 2-/4-wire ST (6ES7 134-6GD00-0BA1)
Information on the analog input module AI 4xI 2-/4-wire ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346GD000BA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AI 3x400VAC/1-5A ST (6ES7 134-6PA00-0BD0)
Information on the analog input module AI 3x400VAC/1-5A ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346PA000BD0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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AI 2xU/I 2-/4-wire HS (6ES7 134-6HB00-0DA0)
Information on the analog input module AI 2xU/I 2-/4-wire HS is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES7134-6HB00-0DA1&objaction=csviewmlfbbeitraege&s
ubtype=133300&caller=view).

   

AI 2xU/I HS (6ES7 134-6HB00-0DA1)
Information on the analog input module AI 2xU/I HS is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346HB000DA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

13.4.2.5 Analog output modules

AQ 2xU/I HS (6ES7 135-6HB00-0DA1)
Information on the analog output module AQ 2xU/I HS is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71356HB000DA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AQ 4xU/I ST (6ES7 135-6HD00-0BA1)
Information on the analog output module AQ 4xU/I ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71356HD000BA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AQ 2xU/I HS (6ES7 135-6HB00-0DA1)
Information on the analog output module AQ 2xU/I HS is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71356HB000DA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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13.4.2.6 Communication modules

CM PtP (6ES7 137-6AA00-0BA0)
Information on the CM PtP communication module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71376AA000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

13.4.2.7 Special modules

Server module (6ES7 193-6PA00-0AA0)
Information on the server module is available here (https://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936PA000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

Server module V2.0 (6ES7 193-6PA00-0AA0)
Information on the server module is available here (https://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936PA000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

13.4.2.8 Technology modules

TM Count 1x24V (6ES7 138-6AA00-0BA0)
Information on the relay output module TMCount 1x24V is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71386AA000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

TM PosInput 1 (6ES7 138-6BA00-0BA0)
Information on the positioning module TM PosInput 1 is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71386BA000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71386BA000BA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71386BA000BA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view


AI Energy Meter (6ES7 134-6PA00-0BD0)
Information on the relay output module AI Energy Meter is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346PA000BD0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

IO-Link Master Module (6ES7 137-6BD00-0BA0)
Information on the relay output module IO-Link Master Module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71376BD000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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add external graphic , 5547
add graphic to graphics library, 5546

  6ES7 155-6DU00-0BN0, 6284
 6ES7 155‑6AU00‑0CN0, 6283
 AboveUpperLimitColor property (VBS), 4145
 Absolute value, 1694, 1949
 Alarm report

Layout in reports, 3490
 Autocompletion, 3550
 BelowLowerLimitColor property (VBS), 4194
 Compiling

Project, 5599
 Connection configuration

General, 473
 Create

Report (overview), 3464
 Creating

Report (overview), 3464
 External source file

Editing, 1422
Opening, 1422

 Logging method
Segmented circular log, 3215

 Module
Inserting, 422

 Page number
Use in reports, 3493

 Quality code, 950
 Recipe report

Layout in reports, 3492
 SetBacklightColor, 3712
 SIMATIC PC station

Load, 76
 SortByTimeDirection property (VBS), 4538
 STARTUP

Warm restart, 837
 TrendWindowRulerLayer property (VBS), 4658
 User-defined function

 Autocompletion, 3550
 Zoom in/out, (See Zoom)

"
"Pack&Go" file

Download to HMI device, 5608
"WWW" instruction, 663

&
&, 1346, 1347

*
*, 1342
**, 1342
*.bmp, 2975
*.cer, 598
*.dat, 598
*.emf, 2975
*.gif, 2975
*.ico, 2975
*.jpeg, 2975
*.jpg, 2975
*.p12, 535, 598
*.tif, 2975
*.wmf, 2975

.

.Net control
Add, 2973
Remove, 2974

.Net service packs, 35

.Net versions, 35

/
/, 1342

:
:=, 1347, 1348
:Displays

Log contents, 3306
:P, 848
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:PROFIBUS DP
Direct key, 5260

´
´XAxisEndValue property (VBS), 4721
´YAxisEndValue property (VBS), 4734

+
+, 1342

<
<, 1344
<=, 1344
<>, 1344, 1347

=
=, 1344
==, 1347

>
>, 1344
>=, 1344

3
32-bit down counter, 916
3D border style property (VBS), 4213
3DES, 578
3RK7243-2AA30-0XB0, 6281

6
6AV2124-0GC01-0AX0, 6273
6AV2124-0JC01-0AX0, 6273
6AV2124-0MC01-0AX0, 6273
6AV2124-0QC02-0AX0, 6273
6AV2124-0UC02-0AX0, 6273
6AV2124-0XC02-0AX0, 6273
6AV2124-1DC01-0AX0, 6273
6AV2124-1GC01-0AX0, 6273
6AV2124-1JC01-0AX0, 6273
6AV2124-1MC01-0AX0, 6273
6AV3688-3AF37-0AX0, 6274
6AV3688-3AY36-0AX0, 6274

6AV3688-3EH47-0AX0, 6274
6AV3688-4CX07-0AA0, 6274
6AV3688-4EY06-0AA0, 6274
6AV3688-4EY07-0AA0, 6274
6AV6545-0CC10-0AX0, 6272, 6273
6AV6591-1DC20-0AB0, 6273
6AV6641-0AA11-0AX0, 6272
6AV6641-0BA11-0AX0, 6272
6AV6641-0CA01-0AX0, 6272
6AV6642-0AA11-0AX0, 6272
6AV6642-0AA11-0AX1, 6272
6AV6642-0BA01-1AX0, 6272
6AV6642-0BA01-1AX1, 6272
6AV6642-0BC01-1AX0, 6272
6AV6642-0BC01-1AX1, 6272
6AV6642-0BD01-3AX0, 6272
6AV6642-0DA01-1AX0, 6272
6AV6642-0DA01-1AX1, 6272
6AV6642-0DC01-1AX0, 6272
6AV6642-0DC01-1AX1, 6272
6AV6642-0EA01-3AX0, 6273
6AV6642-8BA10-0AA0, 6272
6AV6643-0AA01-1AX0, 6272
6AV6643-0CB01-1AX0, 6273
6AV6643-0CB01-1AX1, 6273
6AV6643-0CD01-1AX0, 6273
6AV6643-0CD01-1AX1, 6273
6AV6643-0DB01-1AX0, 6273
6AV6643-0DB01-1AX1, 6273
6AV6643-0DD01-1AX0, 6273
6AV6643-0DD01-1AX1, 6273
6AV6643-0ED01-2AX0, 6273
6AV6643-8AD10-0AA0, 6273
6AV6644-0AA01-2AX0, 6273
6AV6644-0AC01-2AX0, 6273
6AV6644-0AC01-2AX1, 6273
6AV6644-0BA01-2AX0, 6273
6AV6644-0BA01-2AX1, 6273
6AV6644-2AB01-2AX0, 6273
6AV6645-0AA01-0AX0, 6273
6AV6645-0AB01-0AX0, 6273
6AV6645-0AC01-0AX0, 6273
6AV6645-0BA01-0AX0, 6273
6AV6645-0BB01-0AX0, 6273
6AV6645-0BC01-0AX0, 6273
6AV6645-0BE02-0AX0, 6273
6AV6645-0CA01-0AX0, 6273
6AV6645-0CB01-0AX0, 6273
6AV6645-0CC01-0AX0, 6273
6AV6645-0DD01-0AX1, 6273
6AV6645-0DE01-0AX1, 6273
6AV6645-0EB01-0AX1, 6273
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6AV6645-0EC01-0AX1, 6273
6AV6645-0EF01-0AX1, 6273
6AV6645-0FD01-0AX1, 6273
6AV6645-0FE01-0AX1, 6273
6AV6645-0GB01-0AX1, 6273
6AV6645-0GC01-0AX1, 6273
6AV6645-0GF01-0AX1, 6273
6AV6647-0AA11-3AX0, 6272
6AV6647-0AB11-3AX0, 6272
6AV6647-0AC11-3AX0, 6272
6AV6647-0AD11-3AX0, 6272
6AV6647-0AE11-3AX0, 6272
6AV6647-0AF11-3AX0, 6272
6AV6647-0AG11-3AX0, 6272
6AV6647-0AH11-3AX0, 6272
6AV6647-0AJ11-3AX0, 6272
6AV6647-0AK11-3AX0, 6272
6AV6651-1AA01-0AA0, 6272
6AV6651-1BA01-0AA0, 6272
6AV6651-2AA01-0AA0, 6272
6AV6691-1DA01-0AA1, 6272
6AV6691-1DG01-0AA1, 6272
6AV6691-1DJ01-0AA0, 6273
6AV6691-1DJ01-0AB0, 6273
6AV6691-1DJ01-0AC0, 6273
6AV6691-1DJ01-0AD0, 6273
6AV6691-1DJ01-0AE0, 6273
6AV6691-1DR01-0AB0, 6273
6ES7 131-6BF00-0BA0, 6285
6ES7 131-6BF00-0CA0, 6285
6ES7 131-6BH00-0BA0, 6285
6ES7 132-6BD20-0BA0, 6286
6ES7 132-6BF00-0BA0, 6286
6ES7 132-6BF00-0CA0, 6286, 6287
6ES7 132-6BH00-0BA0, 6286
6ES7 132-6HD00-0BB0, 6286, 6290
6ES7 134-6GD00-0BA1, 6287
6ES7 134-6HB00-0DA1, 6288
6ES7 134-6HD00-0BA1, 6287
6ES7 134-6JD00-0CA1, 6287
6ES7 134-6PA00-0BD0, 6287
6ES7 135-6HB00-0DA1, 6288
6ES7 135-6HD00-0BA1, 6288
6ES7 137-6AA00-0BA0, 6289
6ES7 137-6BD00-0BA0, 6290
6ES7 138-6AA00-0BA0, 6289
6ES7 138-6BA00-0BA0, 6290
6ES7 155-5AA00-0AB0, 6282
6ES7 155-6AU00-0BN0, 6282
6ES7 155-6AU00-0CN0, 6283
6ES7 155-6AU00-0NN0, 6283
6ES7 155-6BA00-0BN0, 6284

6ES7 193-6AE00-0AA0, 6285
6ES7 193-6AF00-0AA0, 6283
6ES7 193-6AR00-0AA0, 6283
6ES7 193-6AS00-0AA0, 6284
6ES7 193-6PA00-0AA0, 6289
6ES7 211-1AD30-0XB0, 6275
6ES7 211-1AE31-0XB0, 6275
6ES7 211-1AE40-0XB0, 6275
6ES7 211-1BD30-0XB0, 6275
6ES7 211-1BE31-0XB0, 6275
6ES7 211-1BE40-0XB0, 6275
6ES7 211-1HD30-0XB0, 6275
6ES7 211-1HE31-0XB0, 6275
6ES7 211-1HE40-0XB0, 6275
6ES7 212-1AD30-0XB0, 6275
6ES7 212-1AE31-0XB0, 6275
6ES7 212-1AE40-0XB0, 6275
6ES7 212-1BD30-0XB0, 6275
6ES7 212-1BE31-0XB0, 6275
6ES7 212-1BE40-0XB0, 6275
6ES7 212-1HD30-0XB0, 6275
6ES7 212-1HE31-0XB0, 6275
6ES7 212-1HE40-0XB0, 6275
6ES7 214-1AE30-0XB0, 6275
6ES7 214-1AG31-0XB0, 6275
6ES7 214-1AG40-0XB0, 6275
6ES7 214-1BE30-0XB0, 6275
6ES7 214-1BG31-0XB0, 6275
6ES7 214-1BG40-0XB0, 6275
6ES7 214-1HE30-0XB0, 6275
6ES7 214-1HG31-0XB0, 6275
6ES7 214-1HG40-0XB0, 6275
6ES7 215-1AG31-0XB0, 6276
6ES7 215-1AG40-0XB0, 6276
6ES7 215-1BG31-0XB0, 6276
6ES7 215-1BG40-0XB0, 6276
6ES7 215-1HG31-0XB0, 6276
6ES7 215-1HG40-0XB0, 6276
6ES7 217-1AG40-0XB0, 6276
6ES7 221-1BF30-0XB0, 6277
6ES7 221-1BF32-0XB0, 6277
6ES7 221-1BH30-0XB0, 6277
6ES7 221-1BH32-0XB0, 6277
6ES7 221-3AD30-0XB0, 6276
6ES7 221-3BD30-0XB0, 6276
6ES7 222-1AD30-0XB0, 6276
6ES7 222-1BD30-0XB0, 6276
6ES7 222-1BF30-0XB0, 6277
6ES7 222-1BF32-0XB0, 6277
6ES7 222-1BH30-0XB0, 6277
6ES7 222-1BH32-0XB0, 6277
6ES7 222-1HF30-0XB0, 6277
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6ES7 222-1HF32-0XB0, 6277
6ES7 222-1HH30-0XB0, 6277
6ES7 222-1HH32-0XB0, 6277
6ES7 222-1XF30-0XB0, 6277
6ES7 222-1XF32-0XB0, 6277
6ES7 223-0BD30-0XB0, 6276
6ES7 223-1BH30-0XB0, 6278
6ES7 223-1BH32-0XB0, 6278
6ES7 223-1BL30-0XB0, 6278
6ES7 223-1BL32-0XB0, 6278
6ES7 223-1PH30-0XB0, 6278
6ES7 223-1PH32-0XB0, 6278
6ES7 223-1PL30-0XB0, 6278
6ES7 223-1PL32-0XB0, 6278
6ES7 223-1QH30-0XB0, 6278
6ES7 223-1QH32-0XB0, 6278
6ES7 223-3AD30-0XB0, 6276
6ES7 223-3BD30-0XB0, 6276
6ES7 231-4HA30-0XB0, 6276
6ES7 231-4HD30-0XB0, 6278
6ES7 231-4HD32-0XB0, 6278
6ES7 231-4HF30-0XB0, 6278
6ES7 231-4HF32-0XB0, 6278
6ES7 231-5ND30-0XB0, 6278
6ES7 231-5ND32-0XB0, 6278
6ES7 231-5PA30-0XB0, 6276
6ES7 231-5PD30-0XB0, 6278
6ES7 231-5PD32-0XB0, 6278
6ES7 231-5PF30-0XB0, 6278
6ES7 231-5PF32-0XB0, 6278
6ES7 231-5QA30-0XB0, 6276
6ES7 231-5QD30-0XB0, 6278
6ES7 231-5QD32-0XB0, 6278
6ES7 231-5QF30-0XB0, 6278
6ES7 231-5QF32-0XB0, 6278
6ES7 232-4HA30-0XB0, 6276
6ES7 232-4HB30-0XB0, 6278
6ES7 232-4HB32-0XB0, 6278
6ES7 232-4HD30-0XB0, 6278
6ES7 232-4HD32-0XB0, 6278
6ES7 234-4HE30-0XB0, 6279
6ES7 234-4HE32-0XB0, 6279
6ES7 241-1AH30-0XB0, 6280
6ES7 241-1AH32-0XB0, 6280
6ES7 241-1CH30-0XB0, 6280
6ES7 241-1CH30-1XB0, 6276, 6277
6ES7 241-1CH31-0XB0, 6280
6ES7 241-1CH32-0XB0, 6280
6ES7 278-4BD32-0XB0, 6281
6ES7137-6AA00-0BA0, 6284
6ES7671-4EE00-0YA0, 6274
6ES7671-5EF01-0YA0, 6274

6GK7 242-5DX30-0XE0, 6279
6GK7 242-5DX31-0XE0, 6279
6GK7 242-7KX30-0XE0, 6279
6GK7 243-1JX30-0XE0, 6279
6GK7 243-5DX30-0XE0, 6279
6GK7 243-5DX31-0XE0, 6279

7
7MH4960-2AA01, 6281

A
Ability to read back connection parameters, 495
ABS, 1694, 1949, 2138
Absolute Addressing

of a tag, 3170, 4949
Absolute value, 2138
Access

HMI tag, 3552
Local tag, 3552

Access point, 4891
Access Point, 4862, 4891
Access protection, 3531

Access protection level 1, 6224
Access protection level 2, 6224
Advantages, 6224
Configuring, 3535
Factory state, 6223
User administration, 3529, 3530
Validity, 6223

Access to operands, 1057, 1058, 1059, 1061, 1062, 
1064, 1065, 1076
Accessible devices, 819, 4996, 5066, 5138
ACK, 5681

Key, 5699
acknowledge

Key, 5699
Acknowledge, 3252, 3793

Alarm, 5687
Error alarm, 5687

Acknowledge alarm
Alarm group, 3258

AcknowledgeAlarm, 3688, 3797
Acknowledgement

Audit Trail, 5785
Acknowledgment, 3256

Configuring, 3300, 3301, 3302
Acknowledgment concept

Alarm with simple acknowledgment, 3258
Alarm without acknowledgment, 3258
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Acknowledgment model, 3258
ACOS, 1711, 1966, 2155
Acquisition cycle

Area pointer, 4954
Tag, 3186, 3200, 3212

Acquisition mode
Tag, 3186

ACT_TINT, 2450
Actions

Basics of redoing actions, 324
Basics of undoing, 324
Redoing, 327
Undoing, 326

activate, 3786
Activate

Project language, 5535
Activate method, 4742
Activate property (VBS), 4147
ActivateCleanScreen, 3621
ActivateDynamic, 4745
ActivatePreviousScreen, 3622, 3797
ActivateScreen, 3619, 3798
ActivateScreenByNumber, 3620, 3799
ActivateSystemDiagnosticsView, 3739, 3800
Activating ENO, 44
Active

Area pointer, 4954
Active bus module (ET 200M), 948
Active nodes, 581
Active property (VBS), 4148
ActiveScreen property (VBS), 4150
ActiveScreenItem object, 4151
ActiveX-Control

Add, 2973
Remove, 2974

ActualPointLeft property (VBS), 4152
ActualPointTop property (VBS), 4153
Acyclic triggers, 4898
AdaptBorder property (VBS), 4154
AdaptFontSizeToLineHeight property (VBS), 4154
Adapting a project

For a different HMI device, 5635
AdaptPicture property (VBS), 4155
AdaptScreenToWindow property (VBS), 4155
AdaptSize property (VBS), 4155
AdaptWindowtoScreen property (VBS), 4155
Add, 1685, 1938

.Net control, 2973
ActiveX control, 2973
Objects to the group, 2982

ADD, 1685, 1938
Add empty line, 6055

Add separator line, 6055
Adding

Adding times with T_ADD, 2282
Additional field devices (PROFIBUS and 
PROFINET), 794, 821
Add-on

Installing, 98
Removing, 98

Address
Area pointer, 4954
Mitsubishi, 5374
Omron Host Link, 5436

address conversion
Instructions for, 2542

Address multiplexing
with absolute addresses, 3190
with symbolic addresses, 3191

Address overview, 430
Address packing, 786
Address property (VBS), 4156
Address range, 558

Changing, 638
Address register, 1073, 1074
Addresses

Assigning, 640
Determining a module with GEO_LOG, 2549
Interrupt with packed, 792
Pack, 786
Read station address with GetStationInfo, 2490
Unpack, 787

Addressing, 848
Addressing tags indirectly, 3197, 3198
Allen-Bradley, 5334, 5352
Allen-Bradley Ethernet IP, 5330
Changing, 638
Ethernet/IP, 5334, 5352
General, 637
MPI, 5165
Multiplexing, 3197

Addressing operands, 1057, 1058, 1059, 1061, 1062, 
1064, 1065, 1067, 1068, 1069, 1070, 1072, 1073, 
1074, 1076
AdjustBorder3DWithStyle property (VBS), 4156
AdjustContrast, 3623
AdjustRulerWindow property (VBS), 4157
Admin, 5723
Administrator, 537
Advanced Encryption Standard (AES), 578
Advanced mode

Global firewall rules, 544
Advanced recipe view, 3126, 3412

Configuring, 3126
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AES, 578
AES-128, 625, 635
Aggressive mode, 577
Aging time, 743
Alarm

acknowledge, 3327, 3330
Acknowledge, 5687
Calling the infotext, 3331
Components, 3260
Configuring, 3270, 3281
Display, 3112
Editing, 3328, 5688
Event, 3335
Exporting, 5510
Importing, 5511
in Runtime, 5679
In Runtime, 3321, 3323
Inspector window, 62
Sequence is not adhered to, 3575
System function, 3334

Alarm buffer, 3303
in Runtime, 5680
In Runtime, 3322, 3324
Memory size, 3303

Alarm buffer overflow, 3303, 3793
Alarm class, 3260

Diagnostics, 3290
Identifying, 3116
in Runtime, 5679
In Runtime, 3322, 3324
Layout, 3325, 3329, 5683, 5684

Alarm classes, 3254, 3255
Common, 3255
Custom, 3254, 3255
Name change through migration, 147
Predefined, 3254, 3255
Use, 3254, 3255

Alarm display, 829
"Active alarms" view, 832
Acknowledging an alarm, 833
Archive view, 830
Clear archive, 832
Export archive, 831
Ignoring alarms, 833
Layout of the alarms in the "Active alarms" view, 
832
Layout of the alarms in the archive view, 830
Receiving alarms, 831
Using the keyboard, 834

Alarm event
Acknowledge, 3252
Incoming, 3252

Outgoing, 3252
Alarm group, 3259, 3261

Acknowledge alarm, 3258
Configuring, 3268
Creating, 3268
Migration, 146

Alarm indicator, 62, 3120, 3285, 3331, 5682
Alarm classes, 3120
Application, 3331
Configuring, 3292
Events, 3120
in Runtime, 5681
In Runtime, 3323, 3325
Layout, 3120, 3331
Operation, 3331
Operation using the mouse, 3332

Alarm line, 3113
Alarm log, 3304, 3388

Configuring, 3309
Configuring an alarm view, 3297
Creating, 3304, 3309
Displaying contents, 3297
in Runtime, 5680
In Runtime, 3324
Migrating, 153

Alarm logging, 3246
Memory medium, 3306

Alarm message
Acknowledgment by the PLC, 5027, 5102, 5183, 
5225, 5237, 5361, 5391, 5423, 5442
Acknowledgment on the HMI device, 5027, 5103, 
5184, 5226, 5238, 5361, 5392, 5423, 5443
Configure acknowledgment, 5026, 5102, 5183, 
5225, 5237, 5361, 5391, 5423, 5442

Alarm number, 3259, 3260
Alarm object, 3912
Alarm property (VBS), 4157
Alarm report

Configuring, 5773
Use in reports, 3489

Alarm status, 3260
Acknowledged, 3252
Incoming, 3252
Outgoing, 3252

Alarm system, 3245
Alarm text, 3261

Formatting, 3273
Output fields, 68
Removing format settings, 3274
Special characters, 68

Alarm types, 3248
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Alarm view, 62, 3112, 3117, 3284, 3325, 3330, 5682, 
5685

 Configuring the display of S7 diagnostic alarms, 
3290
~ configuring for logged alarms, 3291, 3314
Alarm line, 3113
Alarm text window, 3330, 5685
Application, 3325
Column, 3115
Complex alarm view, 3112
Configuring, 3287
Configuring the layout, 3289
Control element, 3114, 3326, 5683
Enable sorting, 3115
Filter display, 3295
Identifying an alarm class, 3116
Layout, 3325, 3329, 5683, 5685
Operation, 3326, 3330, 5683, 5685
Operation using the keyboard, 3327
Operation using the mouse, 3327
Simple Alarm view, 3113
Use, 5682

Alarm window, 62, 3284, 3325, 5682
Application, 3325
Configuring, 3292
Control element, 3326, 5683
in Runtime, 5681
In Runtime, 3323, 3325
Operation, 3326, 5683
Operation using the keyboard, 3327
Operation using the mouse, 3327
Use, 5682

Alarm with simple acknowledgment, 3258
Alarm without acknowledgment, 3258
AlarmColor property (VBS), 4158
AlarmControl object, 3947
AlarmFilter property (VBS), 4158
AlarmHigh property (VBS), 4159
AlarmID property, 4159
AlarmLogs object, 3915
AlarmLow property (VBS), 4160
AlarmLowerLimit property (VBS), 4161
AlarmLowerLimitColor property (VBS), 4161
AlarmLowerLimitEnabled property (VBS), 4162
AlarmLowerLimitRelative property (VBS), 4162
Alarms

Configuring, 5025, 5101, 5182, 5224, 5236
Data types, 5025, 5101, 5182, 5224, 5236
Modicon Modbus, 5422
Non-integrated connection, 5422
Output of a tag value, 3274
Output of texts from a text list, 3275

Restriction, 5391
Alarms object (list), 3913
AlarmUpperLimit property (VBS), 4163
AlarmUpperLimitColor property (VBS), 4164
AlarmUpperLimitEnabled property (VBS), 4164
AlarmUpperLimitRelative property (VBS), 4165
AlarmView object, 3958
AlarmViewAcknowledgeAlarm, 3680
AlarmViewEditAlarm, 3679
AlarmViewShowOperatorNotes, 3681
AlarmViewUpdate, 3679
Align

Object flush, 2960, 3480
Alignment property (VBS), 4165
AlignmentLeft property (VBS), 4166
AlignmentTop property (VBS), 4166
Allen-Bradley, 5320, 5342, 5343

Allen-Bradley DF1 communication driver, 5342, 
5343
Analog alarm, 5360
Basic Panel, 4958
Comfort Panel, 4965
Communication drivers, 5323
Data type, 5358, 5360
DF1, 5323
EtherNet/IP, 5323
Mitsubishi, 5390
Mobile Panel, 4971
Multi Panel, 4969
Panel, 4961
WinCC Runtime, 4975

Allen-Bradley 
Area pointer, 5355

Allen-Bradley DF1
Configuring a connection, 5338
Connection, 5338, 5341
Connection parameters, 5339
CPU type, 5352
KF2 module, 5342, 5343
KF3 module, 5342, 5343
Migrating data types, 161
Valid data type, 5350

Allen-Bradley DH485
Migrating data types, 162

Allen-Bradley Ethernet IP
Address multiplexing, 5334
Addressing, 5330
Addressing type, 5332
Migrating data types, 162

Allen-Bradley EtherNet/IP
Configuring a connection, 5324
Connection, 5324, 5327

Index

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  6297



Connection parameters, 5325
Data type, 5328

AllowMenu property (VBS), 4167
AllowPersistence property (VBS), 4167
Alphanumeric key assignment, 5699
Alphanumerical screen keyboard, 5695
Alphanumerical value

Changing, 5695, 5702
Entering, 5695, 5702

ALT
Key, 5699

Analog alarm, 3248, 3249
Allen-Bradley, 5360
Configuring, 3270, 3282
Mitsubishi, 5390
Omron, 5441

Analog alarm types, 3248, 3249
Analog alarms

Configuring, 3261, 3262
Analog module

Resetting to factory settings, 1003
Analog property (VBS), 4168
AND, 1346, 1347, 1791, 1835, 1836, 2048
AngleMax property (VBS), 4168
AngleMin property (VBS), 4169
Animation, 3011

Configuring, 3012, 3411
Diagonal movement, 3016
Direct movement, 3017
Green arrow in Overview, 3013
Horizontal movement, 3015
Multiple selection, 3023
Object group, 3022, 3023
Overview, 3013
Tag binding, 3020
Vertical movement, 3016

Antivirus programs, 39, 90, 94
ANY, 1113
Appearance

Dynamization of an object, 3014
Applet, 539
Application, 823

Alarm indicator, 3331
Alarm view, 3325
Alarm window, 3325
Date/time field, 3485
Key switch, 3133
Recipe view, 3128, 3442
Simple alarm view, 3328
simple alarm window, 3328

Application example
Entering recipe data offline , 3455

Recipe with manual production sequence, 3456
ApplicationWindow object, 4080
ApplyProjectSettings property (VBS), 4170
Arccosine, 1711, 1966, 2155
ArchiveLogFile, 3625, 3801
Archiving projects, 274, 275
Arcsine, 1710, 1965, 2153
Arctangent, 2156
Arctangent value, 1713, 1968
Area of unplugged modules, 416
Area pointer, 4976, 5009, 5082, 5165, 5208, 5444

Acquisition cycle, 4954
Active, 4954
Address, 4954
Allen-Bradley, 5355
Availability, 4976
Basic Panel, 4961
Comment, 4954
Connection, 4953, 4957
Connections editor, 4954
Coordination, 5449
Data record, 3404, 5018, 5092, 5173, 5215, 5453
Date/time, 71
Date/time PLC, 71
Job mailbox, 5015, 5090, 5171, 5213, 5450
Length, 4954
Migration, 143
Mobile Panel, 4974
PLC tag, 4954
Pointer name, 4954
Project ID, 5015, 5089, 5170, 5212, 5450
Screen number, 5010, 5088, 5166, 5208, 5446
Tab, 4954
Trends, 5023, 5099, 5180, 5222, 5234, 5356, 
5387, 5419, 5439

Area pointers, 4952
Configuring, 4956
Coordination, 5014, 5086, 5169, 5211
Creating, 4956
Date/time, 5011, 5083, 5084, 5167, 5209, 5447
Date/time PLC, 5012, 5168, 5210, 5448
Length, 4956
Mitsubishi, 5387
Modicon Modbus, 5418
Omron, 5438

Arrange
Object in the screen, 2953

Arrangement of byte sequence, 1993, 2169
Array, 67, 192, 1105, 1106, 3201, 3203

Creating, 3203
Indirect addressing, 3197
see ARRAY, 1246, 1390
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ARRAY, 1070
Addressing, 1062
Declaration in global data blocks, 1390
Declaration in PLC data types, 1412
Declaration in the block interface, 1246
Example, 1108, 1109
Format, 1105, 1106

Array data block, 1739, 1740, 1742, 1744, 1995, 
1997, 1998, 2000, 2170, 2172, 2173, 2175, 2207
ARRAY data block, 1024, 1027, 1059, 1062, 1199, 
1383, 1386, 1405
Array element

Location of use of HMI tag, 67
Name, 67

ARRAY limits, 1349
Array tag, 3201

Char, 67
AS interface, 796
ASCII code table, 497
ASCII TSAP, 497
Asian operating system, 5533
ASIN, 1710, 1965, 2153
AskOperationMotive property (VBS), 4171
Assembling manuals, 255
Assign

Object of a layer, 3044
Assigning

a function to a function key, 3035
a graphic to a function key, 3037
Function key, 3030, 3032, 3034

Assigning an IP address
Basics, 995
from the project context, 996
Using "Accessible devices", 995

Assigning global data blocks , 49
Assigning parameters

Hardware, 409
Assigning symbol, 640
Assigning tag, 640
Assignment, 1348, 1590, 1842

Negate, 1591, 1843
Assignment list

Enabling the display of retentive bit memories, 
1469

Assignment list 
 Meaning of symbols, 1464
Defining filter, 1467
Delete filter, 1467
Displaying, 1465
Example for displaying bit memory, 1463
Example for displaying inputs and outputs, 1463
Filter options, 1466

Filtering, 1468
Introduction, 1462
Setting view options, 1466
Structure, 1463

Assignments property (VBS), 4171
AssumeOnExit property (VBS), 4172
AssumeOnFull property (VBS), 4172
Asynchronous

Transferring data, 5018, 5093, 5174, 5220, 5453
Asynchronous error event

Delaying with DIS_AIRT, 2469
Disabling with DIS_IRT, 2466
Enabling with EN_AIRT, 2469
Enabling with EN_IRT, 2467

AT , 1065
ATAN, 1713, 1968, 2156
ATH, 2304
ATTACH, 852, 2441
AttachDB, 4748
ATTR_DB, 2539
Audit

Configuration, 5796
Enhancements in the ES, 5757
Forcing, 5781
Functional scope, 5756
Logging concept, 5757
Scope of logging, 5758
Screen object, 5797
Supported HMI devices, 5796

Audit log, 593, 595
Audit Trail

Acknowledgement, 5785
Checksum, 3217, 3230, 3317, 5779
Comments, 5785
CSV file, 5778
Editor, 5761
Effects in runtime, 5782
Electronic signature, 5785
File format, 5778
Log tag value change, 5782
Logging recipe data changes, 5785
Logging system functions, 5791
Logging user actions, 5788
Memory medium, 5780
Printing, 5770
Protection against change, 5781
Reporting, 5770
Storage location, 5780
Troubleshooting, 5780

Audit trail editor, 5761
Authentication, 701, 764
Authentication methods, 576, 577
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Authorization, 5706
Assignment, 3507, 3537
Changing the name, 3511
Configuring, 3528
Creating, 3505, 3534
Deleting, 3511
Managing, 3510

Authorization property (VBS), 4173
AutoCompleteColumns property (VBS), 4175
AutoCompleteRows property (VBS), 4175
Autocompletion

Function, 1236
Insert tag, 1236, 1237
Inserting an instruction, 1237

Automatic
Reporting, 3273

Automation License Manager, 5483
Automation system, 4910, 4934

Local, 6258
Remote, 6258
Setting up, 4910

Autonegotiation, 818
Disabled, 4995, 5065, 5137

AutoScroll property (VBS), 4176
AutoSelectionColors property (VBS), 4176
AutoSelectionRectColors property (VBS), 4177
Availability

Object for Basic Panels, 3077
Object for Comfort Panel, 3080
Object for Mobile Panels, 3083
Object for Panels, 3078
Object for WinCC Runtime Advanced, 3084
Objects for Multi Panels, 3081

Availability for specific devices
Screen, 2933

Available system functions
Basic Panels, 3583
Comfort Panels, 3602
Mobile panels, 3608
Multi Panels, 3596
Panels, 3590
WinCC Runtime, 3614

Average property (VBS), 4178
AWP command, 651, 652
AWP_In_Variable, 655
AWP_Out_Variable, 653
Axis technology object: Active homing, 6046
Axis technology object: Add new object, 6025
Axis technology object: Axis name configuration, 
6026
Axis technology object: Basic parameters, 6025

Axis technology object: Changing the configuration 
parameters for dynamics in the user program, 6040
Axis technology object: Changing the configuration 
parameters for homing in the user program, 6047
Axis technology object: Commissioning overview, 
6024
Axis technology object: Config.DriveInterface. tag, 
6117
Axis technology object: Config.DynamicDefaults tag, 
6119
Axis technology object: Config.DynamicLimits tag, 
6119
Axis technology object: Config.General. tag, 6116
Axis technology object: Config.Homing tag, 6123
Axis technology object: Config.Mechanics tag, 6118
Axis technology object: Config.PositionLimits_HW 
tag, 6122
Axis technology object: Config.PositionLimits_SW 
tag, 6121
Axis technology object: Configuration overview, 
6023
Axis technology object: Configuration window icons, 
6026
Axis technology object: Configuring acceleration, 
6035
Axis technology object: Configuring active homing, 
6043
Axis technology object: Configuring approach/
homing direction, 6043
Axis technology object: Configuring deceleration, 
6035
Axis technology object: Configuring distance per 
motor revolution, 6029
Axis technology object: Configuring home position, 
6042, 6044
Axis technology object: Configuring home position 
offset, 6044
Axis technology object: Configuring invert direction 
signal, 6029
Axis technology object: Configuring jerk limiter, 6036
Axis technology object: Configuring maximum 
velocity / start/stop velocity, 6035
Axis technology object: Configuring passive homing, 
6042
Axis technology object: Configuring permit auto 
reverse at the hardware limit switch, 6043
Axis technology object: Configuring pulses per motor 
revolution, 6029
Axis technology object: Configuring ramp-down time, 
6035
Axis technology object: Configuring ramp-up time, 
6035
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Axis technology object: Configuring smoothing time, 
6036
Axis technology object: Configuring the homing 
speed, 6044
Axis technology object: Configuring the reference 
point switch input, 6042
Axis technology object: Configuring the side of the 
homing switch, 6042, 6043
Axis technology object: Configuring the velocity 
limiting unit configuration, 6034
Axis technology object: Diagnosis overview, 6024
Axis technology object: Drive enable configuration, 
6029
Axis technology object: Drive ready configuration, 
6029
Axis technology object: Drive signal configuration, 
6028
Axis technology object: Emergency stop deceleration 
configuration, 6037
Axis technology object: ErrorBits tag, 6129
Axis technology object: Extended parameters, 6025
Axis technology object: General dynamics 
configuration, 6034
Axis technology object: Hardware and software 
components, 6020
Axis technology object: Hardware interface 
configuration, 6026
Axis technology object: Mechanics configuration, 
6029
Axis technology object: MotionStatus tag, 6125
Axis technology object: Passive homing, 6044
Axis technology object: PTO and HSC configuration, 
6027
Axis technology object: Response when jerk limiter is 
activated, 6039
Axis technology object: StatusBits tag, 6126
Axis technology object: Tools, 6022
Axis technology object: Updating the tags, 6130
Axis technology object: User unit configuration, 6028

B
Back page

Report, 3462
Back up RAM file system, 3724, 3802
BackColor color property (VBS), 4181
BackColor property (VBS), 4179
BackColorBottom property (VBS), 4182
BackColorTop property (VBS), 4182
BackFillStyle property (VBS), 4183, 4184
BackFillStyleReadOnlySpecial property (VBS), 4185
BackFlashingColorOff property (VBS), 4186

BackFlashingColorOn property (VBS), 4186
BackFlashingEnabled property (VBS), 4187
BackFlashingRate property (VBS), 4188
Background color

Dynamization, 3014
Backing up, 5647, 5707

Using WinCC flexible, 5647
BACKSPACE key, 5698
Backup

Data of the HMI device, 5624, 5626
Deleting, 5591
Rename, 5591

Backup from online device, 6151
BackupRAMFileSystem, 3724, 3802
Bar, 3086

Color transition, 3086
Display limit lines, 3087

Bar object, 3962
Bar segment

Defining, 3087
BarBackColor property (VBS), 4189
BarBackFillStyle property (VBS), 4189
BarColor property (VBS), 4191
BarStartValue property (VBS), 4192
BaseScreenName property (VBS), 4193
Basic Comfort 

Omron, 4965
Basic mode, 1500
Basic Panel

Area pointer, 4961
Communication drivers, 4958
Display and operating element, 3077
ETHERNET, 4960
HTTP protocol, 4958
IF1B, 4960
Interface, 4960
Mitsubishi, 4958
Modicon Modbus, 4958
Omron, 4958
OPC, 4958
S7 1200, 4958
S7 200, 4958
S7 300, 4958
S7 400, 4958

Basic Panels
Available system functions, 3583

Basics
HMI HTTP protocol, 5278
Migration, 127

Battery object, 3967
BCDCPL, 1833, 2091, 2278
BeginTime(i) property (VBS), 4194
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Behavior
Simple recipe view, 3437, 5673

Benefits of using TeleService, 6209
Bit (0, 1)

Graphics list, 3004
Text list, 2996

Bit field
Reset, 1846
Resetting, 1595
Set, 1845
Setting, 1594

Bit logic operations
AND, 1835, 1836
EXCLUSIVE OR, 1839
Insert input, 1840
OR, 1837, 1838

Bit mask, 1824, 2082, 2269
Bit memories

Enabling the display of retentive bit memories, 
1469

Bit number  (0 - 31)
Graphics list , 3006
Text list, 2997

Bit string, 1082, 1083
 64-bit, 1084

BitNumber property (VBS), 4195
Bits

Count, 1834, 2280
Counting, 2092

BITSUM, 1834, 2092, 2280
Bit-triggered trends, 5023, 5099, 5180, 5222, 5234, 
5356, 5387, 5419, 5439
BlinkColor property (VBS), 4195
BlinkMode property (VBS), 4196
BlinkSpeed property (VBS), 4197
BLKMOV, 1746, 2002, 2187
Block

Block, 2002
Changing passwords for know-how protected 
blocks, 1459
Closing, 1215
Comparing, 1428
Comparing code blocks, 1425
Comparing data blocks, 1426
Comparison, 1423
Compile, 1438
Compiling in the program editor, 1441
Compiling in the project tree, 1440
Consistency check, 1438, 1475, 1480, 1481
Consistency check in the call structure, 1475
Copying, 1202, 1205
Deleting offline, 1217

Deleting online, 1217
Displaying properties, 1213
Downloading blocks to a memory card, 1451
Downloading to device, 1442
Downloading to device in RUN operating mode, 
1445
Editing properties, 1213
Entering a comment, 1207
Entering a title, 1206
exporting to an external source file, 1420
Fill, 1733, 1751, 1989, 2007, 2165, 2192
Fill uninterruptible, 1735, 1991, 2167
Find and open, 1214
Inserting, 1202
Know-how protection, 1453
Leave, 2227
Load to device, 1446
Move, 1981, 2158, 2187
Move uninterruptible, 1731, 1749, 1987, 2005, 
2163, 2189
Moving, 1726, 1746
Opening, 1214
Opening know-how protected blocks, 1457
Optimized access, 1027, 1029
Pasting, 1206
Printing know-how protected blocks, 1458
Properties, 1208
Removing copy protection, 1455
Renaming, 1216
Saving, 1215
Setting up copy protection, 1455
Time stamp, 1211
Types, 1021
Uploading blocks from a memory card, 1452
Uploading blocks from device, 1450
Uploading from device, 1442
Using a library, 1200

BLOCK, 1117
Block access

Data block, 1395
Block call

Basics, 1032
Calling as single instance or multiple instance, 
1034
Correcting the call type, 1281, 1322
Inserting, 1278, 1319, 1364, 1365, 1367, 1368, 
1369, 1370
Multi-instance, 1035
Nesting depth, 1033
Single instance, 1035
Updating, 1280, 1321, 1371
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Block comment
Hiding, 1228
Showing, 1228

Block comparison
Basics, 1423
Changing the block, 1433
Comparing code blocks, 1425
Comparing data blocks, 1426
Detailed comparison, 1429
Execute action, 297
Navigation, 1432
Representation of the detailed comparison, 1430
Synchronize scrolling, 1433
Updating comparison results, 294, 1434

Block consistency
Checking, 1475
Checking in the dependency structure, 1481

Block folder, 1196
Block interface

Declaring ARRAY, 1246
Declaring PLC data type, 1248
Declaring STRUCT, 1247
Declaring tags, 1244, 1245, 1249
Hiding, 1228
Importing and exporting tags, 1259
Multi-instance, 1250
Purpose of tag declaration, 1239
Retentivity, 1254
Showing, 1228
Structure, 1240
Tag properties, 1253, 1255
Updating, 1250
Valid data types, 1243

Block parameters, 1037, 1039, 1041, 1043, 1045, 
1046, 1047, 1048

Basics, 897
Block interface, 1240

Block property
Displaying, 1213
Editing, 1213
Function, 1208
Overview, 1208

Bookmarks
Deleting, 1356
Function, 1354
Navigating, 1356
Setting, 1355

BOOL, 1081, 1126, 1142
BOOL_TO_, 1142
Border color property (VBS), 4201
BorderBackColor property (VBS), 4197
BorderBrightColor3D property (VBS), 4198, 4199

BorderColor property (VBS), 4200
BorderEndStyle property (VBS), 4203
BorderFlashingColorOff property (VBS), 4204
BorderFlashingColorOn property (VBS), 4205
BorderFlashingEnable property (VBS), 4206
BorderFlashingRate property (VBS), 4207
BorderInnerStyle3D property (VBS), 4208
BorderInnerWidth3D property (VBS), 4208
BorderOuterStyle3D property (VBS), 4209
BorderOuterWidth3D property (VBS), 4209
Borders

Placeholder for document information, 313
Specifying the print area, 312

BorderShadeColor3D property (VBS), 4210, 4211
BorderStyle property (VBS), 4211
BorderStyle3D property (VBS), 4213
BorderWidth property (VBS), 4214, 4215
BorderWidth3D property (VBS), 4216
Boundaries, 819, 4996, 5066, 5138
Boundary reached, 3793
Branch, 2214, 2216

Closing, 1297
Definition, 1295, 1336
Deleting, 1297, 1337
Inserting, 1296, 1337
Rules, 1296
Rules , 1336

BRCV, 2841
Broadcast, 558, 565, 745
BrowserView object, 4019
BSEND, 2839
Button, 3130

Adding a system diagnostics indicator, 3383
Configuring, 3535
Configuring access protection, 3531
Define hotkey, 3131
Graphic, 3130
HTML Browser, 3102
Mode, 3130
Status/Force, 3140
Text, 3130

Button object, 3968
ButtonCommand property (VBS), 4218
Buttons and Switches

Library, 5491
BYTE, 1082, 1126, 1143
BYTE_TO_, 1143
Bytes

 Swap, 2169
Swap, 1737, 1993
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C
CA certificate, 531, 534, 6244
CA group certificate, 534
Cabling rules (PROFINET), 818, 4995, 5065, 5137
CALC, 1682, 1935
Calculate, 1281, 1322, 1682, 1935
CALCULATE, 1281, 1322
CalculateStatistic, 4749
CalibrateTouchScreen, 3657, 3803
Calibrating, 1000

Overview, 1000
Call hierarchy, 1033
Call structure, 1470

 Meaning of symbols, 1472
Displaying, 1473
Introduction, 1470
Setting view options, 1474
Structure, 1473

Callback to a number specified during connection 
establishment, 6226
CAN_DINT, 2454
CAN_TINT, 2449
Cancel

Connection to the faceplate type, 3068
Canceling a calibration, 1002
Canceling printing, 319
Caption property (VBS), 4219
CaptionBackColor property (VBS), 4220
CaptionColor property (VBS), 4221, 4222
CaptionText property (VBS), 4222
CaptionTop property (VBS), 4223
Cascaded counting function, 916
CASE, 2216
CD, 1665, 1919
CEIL, 1756, 2013, 2197
CellCut property (VBS), 4223
CellSpaceBottom property (VBS), 4224
CellSpaceLeft property (VBS), 4225
CellSpaceRight property (VBS), 4225
CellSpaceTop property (VBS), 4226
CenterColor property (VBS), 4226
CenterSize property (VBS), 4227
CentrePoint property (VBS), 4227
CentrePointLeft property (VBS), 4228
CentrePointTop property (VBS), 4228
Certificate, 531, 576, 5290, 5860

Exporting, 531
Importing, 531
Importing on HTTP client, 5290, 5860
Installing on devices, 5290, 5860

Installing under Windows XP, 5290, 5860
Renewing, 533
Replace, 534
Replacing, 534
self-signed, 533
signed by certificate authority, 533

Certificate authority, 531, 532
Certificate manager, 531
change

Recipe data record in Runtime, 3446
Change, 3786
Change word order

Modicon MODBUS TCP/IP, 5398
ChangeConnection, 3746, 3804
ChangeMouseCursor property (VBS), 4229
Changeover contact, 951
Changeover contact sensor type, 951
Changing

Displayed name of user group, 3510
Logoff time in runtime, 3522, 3524
Name of the user, 3521, 3523
Object property, 3576
Object size, 2959, 3476
Password, 3509
Password in runtime, 3522
User group in runtime, 3522, 3524
Users, 5719, 5721

Changing a port interconnection
Graphic view, 518

Changing and displaying operating mode (example), 
3581
Changing the configuration online, 6143
Changing the device configuration online, 6143
Changing the name

Authorization, 3511
User group, 3510
Users, 3509

Changing the PROFIBUS connection
Operating mode, 5240

Changing the PROFINET connection
Operating mode, 5240

ChannelDiagnose object, 3973
Char

Array tag, 67
CHAR, 1103, 1140, 1165
CHAR_TO_, 1165
Character, 1103
Character string, 1103

Combining character strings with CONCAT, 2309
Comparing string tags with S_COMP, 2295
Converting from a hexadecimal number with HTA, 
2306
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Converting number to character string with 
VAL_STRG, 2299
Converting numeric character string with 
STRG_VAL, 2297
Converting to a hexadecimal number with ATH, 
2304
Converting with S_CONV, 2296
Copy character string to characters with 
Strg_TO_Chars, 2302
Copying characters to character string with 
Chars_TO_Strg, 2303
Deleting characters with DELETE, 2311
Determine maximum length with MAX_LEN, 2303
Determining length with LEN, 2308
Finding a character with FIND, 2314
Inserting characters with INSERT, 2312
Moving/copying with S_CONV, 2294
Reading out left character with LEFT, 2309
Reading out middle character with MID, 2311
Reading out right character with RIGHT, 2310
Replacing character with REPLACE, 2313

Charging condition, 3106
Operation, 3106

Chars_TO_Strg, 2303
CheckBox object, 3974
Checking

Device version, 5588
Checking the connection, 2909
Checklist for troubleshooting the modem, 6268
CheckMarkAlignment property (VBS), 4231
CheckMarkCount property (VBS), 4231
Checksum, 3305, 5781

Audit Trail, 3230, 3317, 5779
Log, 3217, 3230, 3317, 5779
Updating WinCC , 3230, 3317

Circle, 3103
Radius, 3103

Circle object, 3977
CircleSegment object, 3979
Circular log, 3305

Select size, 3223, 3320
CircularArc object, 3982
CJ1, 5435
CJ2, 5435
Class of Service, 714
ClearAlarmBuffer, 3677, 3805
ClearAlarmBufferProTool, 3678, 3806
ClearAlarmBufferProtoolLegacy, 3678, 3806
ClearDataRecord, 3675, 3807
ClearDataRecordMemory, 3676, 3808
cleared, 3785
ClearLog, 3674, 3809

ClearOnError property (VBS), 4232
ClearOnFocus property (VBS), 4233
Click, 3791
Click when flashing, 3792
Client

Configuring, 5282
Parameters, 5283
Tags, 5286

Clock, 3151
Display, 3151
Display dial, 3151
Length of the pointer, 3151
Width of hands, 3151

Clock memory, 856, 877
Clock object, 3984
Closable property (VBS), 4234
CloseAllLogs, 3701, 3810
CMP <, 1676, 1929
CMP <=, 1672, 1926
CMP <>, 1668, 1922
CMP ==, 1666, 1920
CMP >, 1674, 1928
CMP >=, 1670, 1924
Code templates

inserting in user-defined functions, 3551
Coil, 1590

Negate, 1591
Color

Diagnostics of Ethernet cables, 968
Diagnostics of ports, 968

Color of individual ranges
Gauge, 3160

Color property (VBS), 4234, 4235
Color transition

Bar, 3086
ColorChangeHysteresis property (VBS), 4236
ColorChangeHysteresisEnabled property (VBS), 
4237
Column

Alarm view, 3115
ColumnColor(i) property (VBS), 4239
ColumnDisplayName(i) property (VBS), 4240
ColumnResize property (VBS), 4240
ColumnScrollbar property (VBS), 4242
ColumnSizingEnable property (VBS), 4241
ColumnTitle property (VBS), 4243
ColumnTitleAlign property (VBS), 4242
ColumnUpdateEnabled(i) property (VBS), 4243
Comfort Panel

Area pointer, 4968
Communication drivers, 4965
Deleting HMI device images, 5593
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Display and operating element, 3080
HTTP protocol, 4965
Interface, 4966
Mitsubishi, 4965
Modicon Modbus, 4965
OPC, 4965
S7 1200, 4965
S7 200, 4965
S7 300, 4965
S7 400, 4965
S7-1200, 76

Comfort Panels
Available system functions, 3602

Command property (VBS), 4244
Comment

Area pointer, 4954
Comments

Audit Trail, 5785
Electronic signature, 5785
Inserting in SCL program, 1373

Commissioning
HMI device, 5638

Common alarm classes, 3255
CommonTimeAxisColor property (VBS), 4245
Communication, 882, 4909, 5468

Basics, 4910
between HMI devices, 5280
Configuring, 5302
Definition, 4909
OPC, 5294
Routing, 5298, 5300, 5302
Runtime settings, 5281
S7 1200, 5045
S7 1500, 4978
S7 200, 5198
S7 300, 5118
S7 400, 5118
SIMATIC LOGO!, 5228
Third-party drivers, 5320
using area pointers, 4916
WinAC MP, 5465

Communication drivers, 4916
Allen-Bradley, 5323
Basic Panel, 4958
Comfort Panel, 4965
Mitsubishi, 5363
Mobile Panel, 4971
Modicon Modbus, 5393
Multi Panel, 4969
Omron, 5425
Panel, 4961
WinCC Runtime, 4975

Communication load, 856
Communication network, 4934

PROFINET, 4935
Communication partners

HMI device, 4909
Networking, 4938
PLC, 4909
SIMATIC S7, 5036, 5115, 5195, 5204, 5207

Communication types
Allen-Bradley, 5327
Connectable PLCs, 5401, 5412
Enabled, 5368, 5381, 5400, 5411, 5430
Ethernet/IP, 5327
Restriction, 5400, 5411

Communication via PUT/GET instructions
Basic information on PUT/GET instructions, 500
Creating and assigning parameters to a 
connection, 505
Deleting an interconnection, 506
Overview of connection configuration, 501
Requirements, 500
Starting connection parameter assignment, 504

Communications
Cycle load, 860

Communications instruction
"AS_DIAL", 6258, 6259
"AS_MAIL", 6261
"PG_DIAL", 6257, 6258
"SMS_SEND", 6260

Communications load, 860
Communications module (CM), 2764
Communications modules, 868

Properties, 868
Communications parameters

Ethernet, 5471, 5472
PROFIBUS DP, 5475, 5476
ProSave, 5471, 5475
WinCC, 5472, 5476

Communications port
Configuring, 869

Communications protocol
Area pointer, 4976
Defining, 872
Overview, 871

Compact, 5403, 5416
CompactLogix, 5330
Comparator operations

Time tags, 2281
Compare

Bit mask, 1824, 2082, 2269
Character strings with S_COMP, 2295
Equal, 1666, 1920
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Greater or equal, 1670, 1924
Greater than, 1674, 1928
Less or equal, 1672, 1926
Less than, 1676, 1929
Not equal, 1668, 1922

Compare editor
Changing the view, 298
Filtering the view, 293
Overview, 289
Specifying actions, 296

Compare offline/online
Automatic device assignment, 521

Compare scan matrix, 1826, 2084, 2271
Comparing library objects, 339
Compatibility, 44, 5890

Backward compatibility of projects, 261
Projects from newer program versions, 261
Projects from older program versions, 261
Projects with add-on software, 262
WinCC version, 5584

Compatibility (firmware versions), 905
Compile

Block, 1440
Blocks, 1438
Consistency check, 1438

Compiling
Address parameters, 76
Correcting compilation errors, 1442
Migrated project, 131

Complex alarm view, 3112
Complex user view

Configuring, 3088
Components

Alarm, 3260
Commissioning, 5336, 5354, 5375, 5385, 5405, 
5417, 5437

CONCAT, 2309
Configuration

Downloading to device, 827
DP slave, 782
DP slave, simple, 773
Hardware, 409
Tag, 3179
Uploading to programming device/PC, 828

Configuration control, 930
Configuration mode, 691
Configuration PC

Ethernet, 5469
HMI device , 5469, 5474
PROFIBUS DP, 5474
Starting Runtime, 5613
WinCC Runtime, 4983, 5001

Configuration phase, 5637
Configuration rights, 538
Configure a PROFIBUS subnet

Matching parameters to one another, 442
Setting bus parameters, 442

Configure acknowledgment
Alarm message, 5026, 5102, 5183, 5225, 5237, 
5361, 5391, 5423, 5442

Configure alarms
Allen-Bradley, 5359
Data types, 5390
Non-integrated connection, 5390
Special considerations, 5390

Configured
Loop-in-alarm, 3279

ConfigureTimeAxis(i) property (VBS), 4245
Configuring, 3270, 3283, 3432

Access protection, 3535
Alarm acknowledgment, 3300, 3301, 3302
Alarm group, 3268
Alarm log, 3309
Alarm view, 3287
Alarm view for logged alarms, 3291, 3314
Alarms, 5025, 5101, 5224, 5236
Analog alarm, 3270, 3282
Analog alarms, 3261, 3262
Animation, 3411
Authorization, 3528
Connections, 5030, 5031, 5037, 5186, 5187, 
5189, 5198, 5229
Controller alarms, 3261, 3262
Discrete alarm, 3268, 3281
Discrete alarms, 3261, 3262
Display of S7 diagnostic alarms, 3290
Event, 3410, 3415
Event-driven tasks, 3273
Function list, 3547
HART variable, 949
HMI connection, 4983, 4986, 5051, 5053, 5124, 
5126
HMI device as OPC DA Server, 5893
I-slave, 783
Layout of the alarm view, 3289
Logging tag, 3234
Multiple tags, 3179
OPC XML DA server in the OPC XML Manager, 
5899
Project-wide alarm class, 3265
Recipe screen, 3432
Recipe view, 3427, 3430
Rectangle, 2988
Server, 5281
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System events, 3261, 3262
Trend view for logging, 3242
Trend view for values from the PLC, 3236, 3240
User-defined VB function, 3558
WinCC OPC Client, 5897

Configuring a connection
Allen-Bradley DF1, 5338
Allen-Bradley EtherNet/IP, 5324
Mitsubishi FX, 5376
Mitsubishi MC TCP/IP, 5364
Modicon Modbus RTU, 5406
Modicon Modbus TCP, 5394
Omron Host Link, 5426
OPC, 5294

Configuring a filter
for fixed character string, 3295

Configuring a PROFIBUS subnet
Meaning of the bus parameters, 443

Configuring a tag
HTTP client, 5284
HTTP server, 5282

Configuring internal subnets manually, 611
Configuring IP network nodes manually, 610
Configuring MAC network nodes manually, 611
Configuring the Control Panel

PROFIBUS DP, 5469
Configuring the network with Ethernet, 447, 5060, 
5134

Creating private subnets, 449, 5061, 5135
Linking networks, 449, 5061, 5135
Relationship between IP address and subnet 
mask, 448, 5060, 5134
Setting the IP address, 448, 5060, 5134
Setting the subnet mask, 448, 5060, 5134

Configuring the remote modem, 6222
Connecting

PLC, 5327, 5367, 5380, 5399, 5430
Connecting a TS Adapter with an external modem, 
6222
Connecting a TS Adapter with an internal modem, 
6222
Connecting cable

6XV1440 - 2P for Mitsubishi PG protocol, 5381
Allen-Bradley cable 1784-CP10, 5347
Mitsubishi FX, 5380

Connecting cable 9-pole
Sub D, RS 422, 5346

Connecting cables
Point-to-point cable 1, 
Point-to-point cable 2, 5414

Connection, 450, 463, 4915
Address details, 1016

Allen-Bradley DF1, 5338, 5341
Allen-Bradley EtherNet/IP, 5324
Area pointer, 4953, 4957
Change after migration, 142
Configuring, 4939, 4943, 5324, 5338, 5364, 5376, 
5394, 5406, 5426
Configuring a connection when there is no or no 
clear network assignment, 455
Creating, 482, 4939, 4943
Deleting, 485
Highlighting, 4941
Integrated, 4939
integrated connection, 3170, 4949
Mitsubishi MC TCP/IP, 5364
Modicon, 5410
Modicon Modbus RTU, 5406
Modicon Modbus TCP, 5394
offline, 5015, 5089, 5170, 5213
Omron communication drivers, 5438
Omron Host Link, 5426
Parameters, 5325, 5339, 5365, 5378, 5396, 5408, 
5428
Password, 4992, 5009, 5063, 5081
S7 200, 5198, 5229
Table, 4938

Connection cable
Allen-Bradley cable 1747-CP3, 5348
Allen-Bradley cable 1761-CBL-PM02, 5349
Modicon, 5410
Multipoint cable 1:MP/TP/PC, 5432
Multipoint cable 2:RS422, MP/TP/PC, 5433
Omron Host Link, 5430
Point-to-point cable PP2 for Omron, 5433, 5434

Connection configuration
Connection parameters, 478
Overview, 475
Starting, 481

Connection description
Changing parameter values, 494
Data block , 488, 491, 492
Structure, 488, 491, 492

Connection details, 1016
Connection diagnostics

Detailed, 1014
Overview, 1012

Connection information, 1014
Diagnostics, 4923

Connection mechanisms, 882
Connection modes, 675
Connection parameter assignment of PUT/GET 
instructions, 504
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Connection parameters
Allen-Bradley DF1, 5339
Allen-Bradley EtherNet/IP, 5325
Mitsubishi FX, 5378
Mitsubishi MC TCP/IP, 5365
Modicon Modbus RTU, 5408
Modicon Modbus TCP, 5396
Omron Host Link, 5428

Connection parameters of PUT/GET instructions, 
503
Connection resource, 450, 463

SIMATIC S7 1200, 73
Connection resources

Online, 1014, 1015
Connection rules, 621, 632
Connection status

Displaying using icons, 1013
Connections

Allen-Bradley DF1, 5342, 5343
Configuring, 5030, 5031, 5037, 5186, 5187, 5189, 
5198, 5229
Editor, 5030, 5031, 5037, 5186, 5187, 5189

ConnectionType property (VBS), 4246
Connector object, 3986
ConnectTrendWindows property (VBS), 4246
Consistency

Slot rules, 411
Consistency check, 607, 1475, 1480, 1481

Introduction, 1475, 1480
local, 530
project-wide, 530

Constant
Basics, 1051
Declaring, 1188
Entering, 1076
PLC tag table, 1173
Properties, 1191
Rules, 1187

Context filter, 411
ContinousChange property (VBS), 4247
CONTINUE, 2223
Control element

Alarm view, 3114, 3118, 3326, 5683
Alarm window, 3326, 5683
f(x) trend view, 3095
HTML Browser, 3102
Media Player, 3111
Recipe view, 3127
Simple alarm view, 3329, 5685
Status/Force, 3139
Trend view, 3104

Control panel
- assigning parameters, 5474
Transferring data, 5469, 5470

Controller alarm, 3249, 3250
System-defined, 3252

Controller alarms
Configuring, 3261, 3262
System-defined, 3249

ControlLogix, 5330
Controls

WinCC MediaControl, 4030
ControlSmartServer, 3736, 3811
Control-timer alarm, 1817, 1820, 2075, 2078, 2262, 
2266
ControlWebServer, 3736, 3811
Conversion, 1123

Explicit, 1142, 1143, 1148, 1150, 1151, 1153, 
1155, 1157, 1158, 1160, 1161, 1162, 1163, 1164, 
1165, 1166
Explicit , 1144, 1146
Implicit, 1126, 1127, 1128, 1129, 1130, 1131, 
1132, 1133, 1134, 1135, 1136, 1137, 1138, 1139, 
1140, 1141

Conversion operations
Converting times with T_CONV, 2282

Convert, 1753, 2010, 2195
CONVERT, 1753, 2010, 2195
Convert VARIANT to DB_ANY, 2206
Converted name (PROFINET), 805
Converting

A character string to a hexadecimal number with 
ATH, 2304
Character strings with S_CONV, 2296
Converting number to numeric character string 
with VAL_STRG, 2299
Converting numeric character string to number 
with STRG_VAL, 2297
Converting times with T_CONV, 2282
Copy numerical character string to characters with 
Strg_TO_Chars , 2302
Copying characters to numerical character string 
with Chars_TO_Strg, 2303
Hexadecimal number to character string with HTA, 
2306

Converting an unspecified CPU, 178
Cookie, 656
Coordinated transfer, 3404

With PLC, 3404
Coordination, 4916
Copy

Recipe data record in runtime, 3445
Screen, 2939
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Tag, 3178
Template, 2943

Copy protection, 1455
Copy template

Library, 5490
Copying

Adjusting screen size, 5577
Alarm indicator, 62
Alarm view, 62
Alarm window, 62
Color, 5576
Excel format, 5505
Font, 5576
Function key, 5577
Hardware component, 425
HMI device, 55
Invalid object, 5576
Linked objects, 5578, 5579
Principle, 5574, 5575
Screen, 5577
User-defined folders, 5575

CopyRows, 4749
Corner points, 3123
Corners, 3121
CornerStyle property (VBS), 4248
CoS, 714

Queue, 714
COS, 1708, 1962, 2151
Cosine, 1708, 1962, 2151
Count

Down, 1652, 1661, 1665, 1905, 1919, 2127, 
2134
Up, 1649, 1659, 1664, 1902, 2124, 2132
Up and down, 1654, 1657, 1907, 2129, 2136
Up and Down, 1910

Count (8 DI NAMUR), 914
Count property (VBS), 4249
CountDivisions property (VBS), 4250
COUNTER, 1117, 1657, 2136
Counter input, 864
Counter mode, 864
Counter operations

Control high-speed counters, 2588
High-speed counters, 2588

Counter, high-speed, 863
Counting

Down, 1914
Up, 1912, 1917

CountSubDivisions property (VBS), 4250
CountValueColumns property (VBS), 4251
CountVisibleItems property (VBS), 4251

Cover page
Placeholder for document information, 313

CP 1242-7, 47
CP 1613, 37
CP 1623, 37
CP 343-2, 46
CP1, 5435
CPM, 5435
CPU

Displaying the current LED status, 978
Fill level of all types of memory, 979, 980
Inserting a signal board, 642
Properties, 854
Reading date and time-of-day with RD_SYS_T, 
2287
Reading out a diagnostics buffer, 982
Selecting from the hardware catalog, 417
Setting time-of-day with WR_SYS_T, 2286
Switching operating mode, 988

CPU control panel
Display area, 979

CPU data block
Definition, 1026
Deleting, 1218

CPU firmware, 905
CPU load through trace, 6197
CPU memory area

Displaying, 1484
CPU properties, 856
CPU type

Allen-Bradley DF1, 5352
Allen-Bradley EtherNet/IP, 5330
FX3 series, 5373
Mitsubishi FX, 5383
Mitsubishi MC TCP/IP, 5373
Modicon Modbus RTU, 5416
Modicon Modbus TCP, 5403
Omron Host Link, 5435

Create
Connection, 5047
Faceplate type, 3054
Global library, 5492
Group, 2980
Recipe data record on the HMI device, 3445
Report, 3466
Template, 2944

Create script
Faceplate type, 3073

CREATE_DB, 2533
CreateTagSet-Methode, 4751
Creating, 3420

Alarm group, 3268
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Alarm log, 3304
Alarm log , 3309
Array, 3203
Connection, 4939, 4943, 4980, 5120
Connection to an OPC UA Server, 5897
Connection to OPC DA server, 5895
Customer control, 5876
Cycle, 3213
Data log, 3220
External tag, 3173
Infotext, 3270, 3273
Internal tag, 3175
Program code for customer control, 5875
Project-wide alarm class, 3265
Recipe, 3420
Recipe data record, 5660, 5661, 5674
Recipe data record on the HMI device, 3440, 
3441
Screen, 2938
Test form, 5878
User group, 3506, 3537
User interface, 5874
User-defined VB function, 3558
Users, 3507, 3538, 5710, 5713, 5714, 5716, 
5717
Users in runtime, 3519

Creating a print preview, 314
Creating a route, 604
Creating a type

Screen, 5503
Script, 5502

Creating a watch table, 1503
Creating custom documentation, 255
Creating labels, 319
Crossing

Definition, 1298
Deleting, 1300
Inserting, 1298
rearranging, 1299

Cross-reference
Inspector window, 62

Cross-reference list, (See cross-references), (See 
cross-references)

Displaying, 1488, 5527
Overview, 1488, 5527
Settings, 1486, 5528
Sorting columns, 1486, 5528
Structure, 1486, 5528
Views, 1486, 5528

Cross-references
Displaying, 1488, 5527, 5530
Introduction, 1486, 5527

Uses, 1486, 5527
CS1, 5435
csv file

Example, 3243, 3336
Layout, 3243, 3336

CSV file, 5506, 5508, 5517
Audit Trail, 5778

CTD, 1652, 1905, 2127
CTRL

Key, 5699
CTRL_HSC, 2588
CTRL_PWM, 2506
CTU, 1649, 1902, 2124
CTUD, 1654, 1907, 2129
CU, 1664, 1917
Cu10 sensor, 938
CurrentColumnIndex property (VBS), 4252
CurrentCurveIndex property (VBS), 4253
Cursor key, 5698
CursorControl property (VBS), 4254
CurveColor(i) property (VBS), 4254
CurveLineWidth(i) property (VBS), 4255
CurvesCount property (VBS), 4255
CurveUpdateEnabled(i) property (VBS), 4256
Custom alarm classes, 3254, 3255
Customer control, 5867

Creating, 5876
Creating program code, 5875
Setting a reference, 5872

Customer controls
 testing, 5878

Customized VB function
Rename, 3561

CutRows, 4751
Cycle

Creating, 3213
Cycle load, 860
Cycle monitoring time, 2232
Cycle time, 856, 859

display configured, 972
display measured, 977

Cyclic
Continuous, 3187
In operation, 3187

Cyclic interrupt, 890
Cyclic interrupt OB

Assigning parameters, 899
Description, 890
Querying parameters with QRY_CINT, 2445
Setting parameters with SET_CINT, 2443

Cyclic operation, 5197, 5207, 5233
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Cyclic program execution
Options for interrupting, 883
Programming, 883

Cyclic triggers, 4897, 4906

D
D_ACT_DP, 2353
DangerRangeColor property (VBS), 4257
DangerRangeStart property (VBS), 4257
DangerRangeVisible property (VBS), 4258
Data areas

Area pointer, 4955, 5446
Reading, 4955, 5446
Writing, 4955, 5446

Data backup, 102
HMI device , 5624

Data bit (DBX), 843
Data block

Adjusting data values during commissioning, 
1394, 1405, 1406, 1408
ARRAY data block, 1024, 1027, 1059, 1062, 1199, 
1383, 1386, 1405
Based on a PLC data type , 1392
CPU data block, 1026
Creating, 1199, 1386
Creating with CREATE_DB, 2533
Declaration table, 1384
Declaring ARRAY, 1390
Declaring STRUCT, 1391
Default value, 1392
Deleting with DELETE_DB, 2540
Displaying values, 1404
Global data block, 1024, 1383
Importing and exporting tags, 1403
Instance data block, 1025, 1383
Loading block changes without reinitialization, 
1388
Monitoring data values online, 1404
Optimized access, 1027, 1029
Programming, 1383, 1389
Reading attributes with ATTR_DB, 2539
Reading from load memory with READ_DBL, 
2535
Retentive behavior, 1395, 1396
Start value, 1392, 1393
Tag properties, 1397, 1399, 1400
Updating, 1387
Using setting values, 1394, 1405, 1406, 1408
Writing to load memory with WRIT_DBL, 2537

Data byte (DBB), 843
Data consistency, 2826

Data double word (DBD), 843
Data Encryption Standard (DES), 578
Data exchange, 4909

DP slave, 773
I-slave - DP master, 774
Tags, 4915
Trends, 5023, 5099, 5180, 5222, 5234, 5356, 
5387, 5419, 5439
using area pointers, 4916

Data exchange over the AS-AS remote link
Communication instruction "AS_DIAL", 6258

Data flow, 5652
Data Flow, 3397
Data flow control, 870
Data log, 647, 3388

Acquisition cycle, 3215
Closing with DataLogClose, 2526
Creating, 3220
Creating with DataLogCreate, 2515
Creating with DataLogNewFile, 2529
Creating with DataLogTypedNewFile, 2531
Deleting with DataLogDelete, 2528
Empty with DataLogClear, 2522
Logging cycle, 3215
Name, 3221
Opening with DataLogOpen, 2519
Opening with DataLogTypedOpen, 2520
Output of the tag value, 3239
Tags, 3218, 3224
Tolerance band, 3224
Writing with DataLogWrite, 2524

Data logging, 3214, 3215
Application, 3214
Memory medium, 3216

Data mailbox
For recipes, 3404

Data record, 4916
Asynchronously reading data record of a module 
with RD_DPARA, 2436
Exporting, 3449
Importing, 3449
Making available on I-device with PRVREC, 2370
Reading, 3441, 3447
Reading from configured system data with 
RD_DPARM, 2438
Reading of a module with RD_DPAR, 2433
Reading with RD_REC, 2358
Reading with RDREC, 2321
Receiving on I-device with RCVREC, 2367
Transfer, 3442, 3448
Transferring with WRREC, 2323
Writing and reading data records, 2431
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Writing predefined parameters with WR_DPARM, 
2439
Writing with WR_REC, 2362

Data record list, 3408, 5654
Data transfer settings, 5474
Data type

 Convert explicit, 2010
 Convert explicitly, 2195
 Explicit conversion, 1753
Allen-Bradley, 5358, 5360
Allen-Bradley EtherNet/IP, 5328
ANY, 1113
ARRAY, 1105, 1106
BOOL, 1081, 1126, 1142
BYTE, 1082, 1126, 1143
CHAR, 1103, 1140, 1165
Conversion, 1123, 1128, 1137, 1138, 1139
DATE, 1099, 1139, 1162
DINT, 1089, 1133, 1155
Discrete alarm, 5360, 5390, 5441
DT, 1100
DTL, 1102, 1138, 1164
DWORD, 1083, 1128, 1146
Explicit conversion, 1142, 1143, 1144, 1146, 
1148, 1150, 1151, 1153, 1155, 1157, 1158, 1160, 
1161, 1162, 1163, 1164, 1165, 1166
Implicit conversion, 1126, 1127, 1129, 1130, 
1131, 1132, 1133, 1134, 1135, 1136, 1138, 1140, 
1141
INT, 1087, 1131, 1151
Internal tag, 3172, 4952
LDT, 1101
LINT, 1090
LREAL, 1094, 1136, 1160
LTIME, 1098
LTIME_OF_DAY, 1100
LWORD, 1084
Mitsubishi, 5390
Mitsubishi FX, 5382
Mitsubishi MC TCP/IP, 5372
Modicon Modbus RTU, 5415
Modicon Modbus TCP, 5402
Omron, 5440, 5441
Omron Host Link, 5434
PLC data type, 1118, 1409
POINTER, 1111
REAL, 1093, 1135, 1158
S5TIME, 1096
SCL instruction, 1360, 1361
SINT, 1085, 1129, 1148
STRING, 1103, 1141, 1166
STRUCT, 1110

TIME, 1098, 1137, 1161
TIME_OF_DAY, 1099
TOD, 1138, 1163
Trend, 5358
UDINT, 1089, 1134, 1157
UINT, 1088, 1132, 1153
ULINT, 1092
USINT, 1086, 1130, 1150
Valid, 5328, 5372, 5382, 5402, 5415, 5434
Validity, 1077
VARIANT, 1115
WORD, 1083, 1127, 1144

Data types, 184
Migration, 160
Mitsubishi FX, 5389
Mitsubishi MC TCP/IP, 5389
Modicon Modbus RTU, 5421
Modicon Modbus TCP/IP, 5421
OPC DA, 5296
OPC UA, 5297
OPC XML DA, 5297
S7 1500, 5029
S7 200, 5227
S7 300/400, 5185
SIMATIC LOGO!, 5239
Trends, 5025, 5101, 5182, 5224, 5236
Valid, 5029, 5185, 5227, 5239, 5296, 5297

Data word (DBW), 843
DataIndex(i) property (VBS), 4259
DataItem object, 3916
DataLogClear, 2522
DataLogClose, 2526
DataLogCreate, 2515
DataLogDelete, 2528
DataLogNewFile, 2529
DataLogOpen, 2519
DataLogs object, 3918
DataLogTag property (VBS), 4260
DataLogTypedNewFile, 2531
DataLogTypedOpen, 2520
DataLogWrite, 2524
DataSet object (list), 3919
DataX(i) property (VBS), 4261
DataXY(i) property (VBS), 4261
DataY(i) property (VBS), 4262
Date, 1099, 1100, 1101, 1102
DATE, 1099, 1139, 1162
Date/time, 4916

Area pointers, 5083
Date/time field, 3089

Application, 3485
Display system time, 3089
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Format, 3090
Layout in reports, 3486
Using tags, 3090

Date/time PLC, 4916
DATE_AND_LTIME, 1101
DATE_AND_TIME, 1100
DATE_TO_, 1162
DateTimeField object, 3989
DB variable

Definition, 1050
DCAT, 1817, 2075, 2262
DCP (Primary Setup Tool), 551
DCP server, 690
Deactivate, 3789
Dead peer detection (DPD), 584
Deadband

Setting, 3272
Debugger

Closing, 3572
Error types, 3566
Starting, 3572, 5622
Windows, 3564
Windows CE, 3564

DEC, 1693, 1948
Decimal place, 5694
Decimal places, 38, 1714, 1969, 2157
DECO, 1797, 2054, 2243
Decode, 1797, 2054, 2243
DecreaseFocusedValue, 3745
DecreaseTag, 3745, 3813
Decrement, 1693, 1948
Default font, 5554
Defective devices, 961
Defective license, 88, 103
Define

Reference object, 2970, 3478
Define hotkey, 3131
Defining, 3319

For the assignment list, 1467
Delay time

Setting, 3272
Delete

Recipe data record, 5665
Template, 2943
Users, 5722, 5724

DELETE, 2311
Delete key, 5698
DELETE_DB, 2540
DeleteDataRecord, 3675, 3807
DeleteDataRecordMemory, 3676, 3808
DeleteDate(i) property (VBS), 4262
DeleteEnable property (VBS), 4263

DeleteRows, 4754
Deleting

 Report page, 3468
Authorization, 3511
Filter in the assignment list, 1467
Hardware component, 424
Object, 2956, 3471
OPC XML DA server in the OPC XML Manager, 
5899
Recipe data record, 5676
Recipe data record in runtime, 3446
Screen, 2939
Tag, 3178
User group, 3511
Users, 3510, 5723

Deleting a category
Faceplate type, 3058

Deleting a connection, 182
Deleting a property

Faceplate type, 3058
Deleting CA certificates, 6249
Demultiplex, 1804, 2061, 2249
DEMUX, 1804, 2061, 2249
Dependencies of rights, 540
Dependency structure, 1476

Introduction, 1476
Meaning of symbols, 1478
Setting view options, 1479
Structure, 1477

Dependency structure 
Displaying, 1479

DES, 578, 625, 635
Designation

TS Adapter, 6220, 6228, 6236
Designing a background, 2966
Designing a frame, 2966
Destruction of license keys, 86
DETACH, 2442
DetachDB, 4754
Detail page

Adding to report, 3467
remove from report, 3468
Report, 3463
Sorting, 3468

Detailed comparison, 294
Details view, 225
Determine diagnostics status, 981
Determining time of day, 989
Device

Adding to a hardware configuration , 419
Copying, 55, 425
Defective devices, 961
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Deleting, 424
Inserting, 4911
Moving, 427
Renaming, 521

Device address, 637
Device dependency

S7-1200 V1, 5104
S7-1200 V2, 5104
S7-1200 V3, 5104
S7-1200 V4, 5104
SIMATIC S7-1500 V1.0, 5029

Device information, 304, 961
Diagnostics, 4923

Device name, 800, 802, 805
Device number, 801
Device overview

Address range, 637
Device replacement without exchangeable medium, 
819
Device Tool, 824, 826
Device type

Changing, 5467
Device version, 5629

Checking, 5588
Switching, 5587

Device view
Area of unplugged modules, 416
Edit parameters, 428
Edit properties, 428
Hardware and network editor, 394, 4925
Inserting a signal board, 641
Inserting module, 422
Racks, 413

Device wizard, 5484, 5485
Devices

Connecting, 4915
Networking, 4914, 4938

Devices & Networks, 4914, 4938
Devices and networks, 4914, 4938

Connections, 4939
HMI connections, 4939

DeviceStates, 2493
DHCP

Client, 698
Server configuration, 605

DHCP server, 606
Diagnose repeater, 1009
Diagnostic data

Reading out with GET_DIAG, 2501
Diagnostic error interrupt, 893
Diagnostic interrupt OB, 893
Diagnostics, 587, 925

Alarm class, 3290
Connection, 4923
Connection information, 4923
Device, 4923
Device information, 4923
DP slave, reading diagnostic data with 
DPNRM_DG, 2378

Diagnostics buffer
Basics, 847, 1003
Organization, 1003

Diagnostics status
Determine and display online, 962

Diagnostics user, 537
Diagonal movement

Animation, 3016
DialColor property (VBS), 4263
DialFillStyle property (VBS), 4264
Dialing rules in phone books, 6217
Dialog fonts

Runtime settings, 5643
DialSize property (VBS), 4265
dial-up connection

Establishing, 6241
Terminating, 6243

Diffie-Hellman key agreement, 577
DINT, 1089, 1133
DINT , 1155
DINT_TO_, 1155
Direct access to the I/O, 848
Direct key, 5239, 5246, 5263, 5691

Assigning the inputs/outputs, 5246, 5263
configuring, 3039, 5241
KP 1500 Comfort, 5259, 5277
KP1200 Comfort, 5259, 5277
KP700 Comfort, 5257, 5275
KP900 Comfort, 5258, 5276
KTP400 Comfort, 5256, 5274
Mobile Panel 177, 5253, 5271
Mobile Panel 277, 5254, 5272
Mobile Panel 277 IWLAN V2 , 5255, 5273
Multi Panel 277 , 5251, 5269
Multi Panel 377, 5252, 5270
Multi Panel 177 , 5249, 5267
OP 277, 5248, 5266
OP 177B, 5247, 5265
OP 77B, 5264
PROFIBUS DP, 5260, 5261, 5262
PROFINET IO, 5243, 5244, 5245
TP 177, 5248, 5266
TP 277, 5249, 5267
TP1200 Comfort, 5259, 5277
TP1500 Comfort, 5260, 5278
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TP1900 Comfort, 5260, 5278
TP2200 Comfort, 5260, 5278
TP700 Comfort, 5257, 5275
TP900 Comfort, 5258, 5276

Direction output and travel direction: relation, 6013
Direction property (VBS), 4265
DirectKey, 3633
DirectKeyScreenNumber, 3635
DIS_AIRT, 2469
DIS_IRT, 2466
Disabling

Project language, 5535
Disabling program switching

Runtime settings, 5643
Discrete alarm, 3248, 3249, 3250

Allen-Bradley, 5360
Configuring, 3268, 3281
Mitsubishi, 5390
Omron, 5441

Discrete alarm types, 3248, 3249
Discrete alarms

Configuring, 3261, 3262
DiskSpaceView object, 3991
display

Infotext, 5696, 5699, 5703
Display

HMI backup, 5589
Display Caption property (VBS), 4220
Display classes, 3252
Display dial, 3151
Display format, 5693, 5701
Display number, 3127
Display object

Availability for Basic Panels, 3077
Availability for Comfort Panels, 3080
Availability for Mobile Panels, 3083
Availability for Multi Panels, 3081
Availability for Panels, 3078
Availability for WinCC Runtime Advanced, 3084

Display on the PLC
Runtime settings, 5642

Display PDF files, 84
Display peak value

Gauge, 3159
Display peak value pointer property (VBS), 4522
Display system time, 3089
Display Welcome Tour, 84
Displaying

 Call structure, 1473
Assignment list , 1465
CPU memory area, 1484
Cross-reference, 5530

Cross-references, 1488, 5527
Dependency structure , 1479
Load memory, 1485
Maximum load memory available, 1485
Program information, 1461

Displaying a force table, 1529
Displaying alarms, 829
Displaying memory types of a CPU, 979, 980
Displaying or hiding tag information, 1294, 1335
Displaying the online status, 6147
Displaying values

As a trend, 3235
DisplayName(i) property (VBS), 4266
DisplayOptions property (VBS), 4266
Distribute

Objects evenly, 2961, 3480
Distributed I/O, 771, 923
Distributed operator stations

Configure SmartClient, 5835
Configure SmartServer, 5835
configuring, 5835

DIV, 1689, 1943
Divide, 1689, 1943
DMSK_FLT, 2464
Documentation editor

Structure, 309
Documentation settings 

Using frames and cover pages, 307
Double word, 1083
double-click, 3789
DoubleClickAction property (VBS), 4267
Download, (See Downloading to device)

"Pack&Go" file to HMI device, 5608
Error messages, 5633
HMI device, 5607
HMI device , 5622, 5623
Project, 5604, 5606, 5637
via USB, 5609

Downloading
Isochronous applications, 827
to the device, 827

Downloading data to the PLC
Error message, 76

DP, 5080, 5152
DP interface, 776
DP master, 636, 909

Add DP master system, 779
Devices and modules, 776
Disconnection from DP master system, 779
Display on DP slave, 778
DP interface, 776
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DP master system
Add DP slave, 781
Creating, 771, 774, 776
Determining topology with DP_TOPOL, 2381
Disconnect DP slave, 781
Disconnection from subnet, 779
Edit properties, 780
Highlight, 778
Node disconnection, 779

DP slave, 636
Activating and deactivating with D_ACT_DP, 
2353
Add to DP master system, 781
Assign DP master system, 781
configuring, 782
Configuring, 773
Data exchange, 773
Disconnect from DP master system, 781
DP master display, 778
Hardware catalog, 772
Intelligent, (See I-slave)
Networking, 774
Reading diagnostic data with DPNRM_DG, 2378
Synchronizing groups with DP_SYC_FR, 2372
Types, 780
With preprocessing, (See I-slave)

DP standard slave, 794
DP standard slaves

Reading a portion of the inputs with 
GETIO_PART, 2326
Reading all inputs with GETIO, 2325
Reading consistent data with DPRD_DAT, 2363
Writing a part of the outputs with SETIO_PART, 
2327
Writing all outputs with SETIO, 2325
Writing consistent data with DPWR_DAT, 2365

DP/DP coupler, 772
DP_TOPOL, 2381
DPNRM_DG, 2378
DPRD_DAT, 2363
DPSYC_FR, 2372
DPV1

Configuring an ET 200S, 792
DPWR_DAT, 2365
DrawAlwaysInsideFrame property (VBS), 4267
DrawEnhancedHTMLBrowser property (VBS), 4268
DrawInsideFrame property (VBS), 4268
DrawStylishButton property (VBS), 4270
Drive property (VBS), 4270
Drive signals, 6011
DRUM, 1814, 2072, 2259
DSCP, 714

DT, 1100
DTL, 1102, 1138, 1164
DTL data type

Restriction, 71
DTL_TO_, 1164
Duration, 1096
DWORD, 1083, 1128, 1146
DWORD_TO_, 1146
Dynamic control

Object property, 3007
Dynamic reference temperature, 945
Dynamization

Color of an object, 3014
Control enable state of an object, 3018
Flashing, 3014
Object, 3007

Dynamize
Appearance of an object, 3014
Direct movement, 3017
Faceplate, 3069
Faceplate type, 3069
Green arrow in Overview, 3013
Movement of an object, 3015
Object appearance, 3383
Property list, 3010
Tag binding, 3020

E
EC31-RTX, 46
Edge

Negative, 1599, 1602, 1604, 1851, 1853, 1856, 
2094
Positive, 1598, 1601, 1603, 1850, 1852, 1854, 
2093

EdgeStyle property (VBS), 4271, 4272
Edit, 4755

Object within a group, 2984
Edit networking

Disconnecting from a network, 439
Editable(i) property (VBS), 4273
EditAlarm, 3627, 3814
EditEnabled property (VBS), 4274
Editing

Alarm, 5688
Folder link, 2976
Function list, 3549
OPC XML DA server in the OPC XML Manager, 
5899
Recipe data record, 5663, 5664, 5675
System event, 3276

Editing a version of a type in testing, 369
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Editing language, 266, 5531
Selecting, 5535

Editing networking
Copying a subnet, 439
Copying subnets and devices, 440

EditOnFocus property (VBS), 4274
Editor

Connection, 4943
Connections, 5030, 5031, 5037, 5186, 5187, 
5189
Devices and networks, 4941
Graphics, 5545

Effective range, 4862, 4875, 4878, 4880
Calculating signal quality, 3156
Configure effective range object, 4886
Configuring, 4884
Configuring logoff, 4885
Configuring logon, 4885
Logoff, 3153
Logon, 3152
Override function, 3156
Principle of Operation, 4863
Runtime, 4878
Work area, 4876

Effective range (RFID), 4878
Configuring, 4887
Configuring logoff, 4888
Configuring logon, 4888
Overview, 4886
Runtime, 4880
Work area, 4878

Effective range name, 3152
Effective range name (RFID), 3154
Effective range signal, 3156
Effective range (RFID)

Logoff, 3155
Logon, 3155

Effective ranges editor, 4875, 4878
Effects in runtime

Audit Trail, 5782
Effects in Runtime

Recipe data change, 5787
Value changes to GMP-relevant tags, 5785

Electronic signature, 5756
Element list, 3408, 5654
Ellipse

Horizontal radius, 3093
Vertical radius, 3093

Ellipse , 3092
Ellipse object, 3993
EllipseSegment object, 3995
EllipticalArc object, 3998

ELSE, 2216
E-mail

Transferring e-mail with TM_MAIL, 2922
Transferring e-mail with TMAIL_C, 2866

E-Mail
Setting at the HMI-device, 5804

E-mail notification, 3285, 5838
configuring, 5840
Setting up the trigger, 5840

Empty box
Inserting a LAD element, 1273
Inserting an FBD element, 1314

EN/ENO mechanism
Basics, 1167
FBD example, 1170
LAD example, 1169
SCL example, 1170
STL example, 1171

EN_AIRT, 2469
EN_IRT, 2467
Enable autonegation, 817, 4994, 5064, 5136
Enable output ENO, 188
Enable sorting

Alarm view, 3115
Enabled property (VBS), 4275, 4277
Enabling

Reporting, 3299
S7 diagnostic alarm, 3278

Enabling the firewall
SCALANCE S, 601, 602

Enabling tunneled communication
CP x43-1 Adv., 614
SCALANCE S, 601, 602

ENCO, 1798, 2055, 2244
Encode, 1798, 2055, 2244, 3631, 3814
EncodeEx, 3632, 3815
Encryption, 526
Encryption software, 90, 94
END key, 5698
End of discovery of accessible devices, 819, 4996, 
5066, 5138
End of sync domain, 819, 4996, 5066, 5138
End of topology discovery, 819, 4996, 5066, 5138
EndAngle property (VBS), 4278
ENDIS_PW, 1778, 2035, 2228
EndPoint property (VBS), 4279
EndPointLeft property (VBS), 4279
EndPointTop property (VBS), 4280
EndStyle property (VBS), 4281
EndTime(i) property (VBS), 4282
Energy-saving mode, 4890
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Engineering station
Starting Runtime, 5613

Engineering system
Performance features, 5725

Enhanced Recipe View, 5653
ENO, 44, 188
ENTER key, 5698
Entering

Alphanumerical value, 5695, 5702
Input field, 5692
Numerical value, 5694, 5701
Parameters in user-defined functions, 3550

Entry on the HMI device
By means of function key, 5700

Enumeration types, 658
Enumerations

Web server, 660
Error

Logical error, 3566
Runtime error, 3566

Error alarm
Acknowledge, 5687

Error analysis with RET_VAL, 1584
Error handling, 1382

Basics, 1378
GetError, 1783, 2040, 2234
GetErrorID, 1787, 2044, 2237
Local error handling, 1380

Error information, 1380, 1584, 1783, 1787, 2040, 
2044, 2234, 2237
Error message

Downloading data to the PLC, 76
Error messages

Download, 5633
ESC key, 5698
ESP protocol, 578
Establishing a connection from a remote system 
("PG_DIAL"), 6257
Establishing a remote connection, 6241

Procedure, 6242
ET 200eco, 907
ET 200eco PN, 907, 923
ET 200iSP, 907
ET 200iSP distributed I/O station

Definition, 909
ET 200L, 907
ET 200M, 907, 948

Definition, 948
ET 200MP, 940
ET 200pro, 907
ET 200R, 907
ET 200S, 907

DPV1 mode, 792
Option handling, 788, 791
Positioning module, 45
Reference junctions, 784
Slot rules, 784

ET 200S COMPACT, 907
ET 200SP, 929

Application area, 929
ET 200M distributed IO device, 948
Ethernet

Parameters, 5036, 5112, 5193, 5202, 5232
ETHERNET

Basic Panel, 4960
Ethernet interface

Displaying parameters, 6158
Ethernet module

Removal/insertion, 43
Ethernet non IP frames, 543
Event

Acknowledge, 3793
activate, 3786
Alarm buffer overflow, 3793
Assigning organization block (OB) with ATTACH, 
2441
Boundary reached, 3793
Canceling assignment to organization block (OB) 
with DETACH, 2442
Change, 3786
cleared, 3785
Click, 3791
Click when flashing, 3792
Configuring, 3410, 3415
Deactivate, 3789
double-click, 3789
Dynamize, 3012
Execute, 3787
For function lists, 3199
Free space critically low, 3796, 5770
Incoming, 3791
Input finished, 3790
Inspector window, 62
Loop-In-Alarm, 3792
Low free storage space, 3796, 5769
Outgoing, 3791
Overflow, 3226, 3795
Press, 3790
Press ESC twice, 3790
Press key, 3794
release, 3792
Release key, 3794
Runtime Stop, 3794
Screen change, 3788
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Selection changed, 3787
Switch OFF, 3795
Switch ON, 3795
Tags, 3199
Time expired, 3796
Toggle, 3795
User change, 3788
Value change, 3796
When dialog is closed, 3788
When dialog is opened, 3788
When high limit is exceeded, 3787
When low limit is undershot, 3787

Event name, 900
Event trigger, 4897, 4901, 4904
Event-driven output

Report, 3468
Event-driven tasks

Configuring:event-driven tasks, 3270
Events

Configuration, 695
Severity filter, 697

Example
 Application for alarm classes, 3254, 3255
Calculating an equation, 1571
Changing and displaying operating mode, 3581
Communication, 5300
Controlling a conveyor belt, 1552, 1566, 1576
Controlling room temperature, 1557, 1564
Detecting the direction of a conveyor belt, 1553, 
1560, 1568, 1578
Detecting the fill level of a storage area, 1554, 
1561, 1569, 1579
For displaying bit memory in the assignment list, 
1463
For displaying inputs and outputs in the 
assignment list, 1463
For entering force values in the force table, 1532
Heating an oven, 1572
Modify values in the watch table, 1507
System alarm, 3251
User-defined function for temperature conversion, 
3577

Example:
Discrete alarm, 3250
System event, 3251

Examples
Controlling a conveyor belt, 1559

Exchangeable medium, 819
EXCLUSIVE OR, 1838, 1839

 Bit logic operations, 1838
Execute, 3787

Executing
User-defined functions in Runtime, 3574

Exit
User program, 1783, 2040, 2233

EXIT, 2224
EXP, 1705, 1960, 2149
Expanded mode, 1500
Expanding and collapsing sections of code, 1354
Exponential value, 1705, 1960
Exponentiate, 1715, 1970
Export, 4755

Alarm, 5510
Excel format, 5505
Project texts, 5542
Recipe, 3642, 3818, 5506
Tag, 5517
Text list, 5523
User administration, 3525

Export of labels, 320
ExportDataRecords, 3640, 3816
ExportDataRecordsWithChecksum, 3642, 3818
ExportDirectoryChangeable property (VBS), 4284
ExportDirectoryname property (VBS), 4284
ExportFileExtension property (VBS), 4285
ExportFilename property (VBS), 4286
ExportFilenameChangeable property (VBS), 4286
ExportFormatGuide property (VBS), 4287
ExportFormatName property (VBS), 4287
ExportImportUserAdministration, 3645, 3821
Exporting

Recipe, 3449
Recipe data record, 3399, 3449, 5657

Exporting an NTP server, 570
ExportParameters property (VBS), 4288
ExportSelection property (VBS), 4288
ExportShowDialog property (VBS), 4289
Expression

Basics, 1341
Logical expression, 1346
Relational expressions, 1344

Expression 
Arithmetic expression, 1342

EXPT, 1715, 1970
Extended download to device, 76
Extended status information, 1349
External graphic

Edit folder, 2975
Link folder, 2976
Removing the folder link, 2975
Rename folder, 2975

External image file
add to graphics library, 5547
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Managing, 2954
Storing in the image browser, 2977

External source file
Basics, 1418
Exporting blocks, 1420
inserting, 1421
Linking file types to an editor, 1422
Rules for programming, 1419

External tags
Data exchange, 4915

ExtraSpaceForLabelDisplay property (VBS), 4291

F
f(x) trend view, 3093

Toolbar, 3095
F_TRIG, 1606, 1858, 2094
Faceplate, 3049

Cancel connection to faceplate type, 3068
Controlling properties dynamically, 3069
Create, 3071
Dynamically controlling included objects, 3075
Dynamize, 3069
Example, 3070
Faceplate type, 3049
Instance of the faceplate, 3049
Response to sizing, 3066

Faceplate type, 3049
 Deleting a property connection, 3057
Cancel connection, 3068
Create, 3054
Creating a tag, 3072
Defining properties, 3072
Deleting a category, 3058
Deleting a connection, 3057
Deleting a property, 3058
Dynamic control, 3069
Editing, 3066
Enable, 3066
Event, 3053
Faceplate, 3067
Graphics list, 3054
Properties, 3053
Response to resizing, 3066
Script, 3053
Tag, 3053
Text list, 3053
Updating, 3065
Use, 3067
User text, 3054

Facility, 563

Factory settings
Resetting to, 992, 993

FAQs, 405, 4933
Fault monitoring

Connection status change, 709
Power supply, 708
Redundancy, 709

Favorites
Adding, 1276, 1317, 1362
Hiding, 1228
Removing, 1278, 1319, 1363
Showing, 1228
Using, 1277, 1318, 1363

FB, 1023
FBD, 1302, 1559, 1560, 1561
FBD element

Copying, 1327
Cutting, 1327
Deleting, 1332
Inserting, 1313, 1314
Inserting an operand , 1333
pasting from the clipboard, 1328
Replacing, 1329
Rules for inserting, 1312
Selecting, 1326

FBD network
Branch, 1336
Deleting a branch, 1337
Inserting a block call, 1278, 1319
Inserting a branch, 1337
Program status display, 1497
Rules for branches, 1336

FC, 1022
FDA, 5755
Feedback

Optical, 5690
FETCH/WRITE, 882
Field device, 794, 821
FieldLengthReadOnlySpecial property (VBS), 4291
FieldRead, 1722, 1977
FieldWrite, 1724, 1979
File Browser, 647
File format

Audit Trail, 5778
Fill

Block, 1733, 1751, 1989, 2007, 2165, 2192
Block uninterruptible, 1735, 1991, 2167

FILL, 1751, 2007, 2192
Fill style, 3141
FILL_BLK, 1733, 1989, 2165
FillColorMode property (VBS), 4293
FillPatternColor property (VBS), 4294
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FillStyle property (VBS), 4295
Filter

Defining for the assignment list, 1467
Delete, 1467
Hardware catalog, 411
In the assignment list, 1466
Selecting, 1468

Filter property (VBS), 4296
Filtering

the alarm view, 3295
Filters

Assignment list , 1468
FIND, 2314
Find and replace, 328

Additional options for searching, 328
Replacing search keys, 329
Start search, 329
Using the search function, 328

Firewall
Creating service groups, 549, 551
Defining ICMP services, 548
Firewall rules, 543
Managing service groups, 549, 552

Firmware, 905
Firmware update, 990
Firmware update memory card, 841
Firmware version V4, 35
FirstConnectedObjectIndex property (VBS), 4296
FirstConnectedObjectName property (VBS), 4297
Fixed aspect ratio, 3141
Fixed reference temperature, 945
FixedAspectRatio property (VBS), 4297
Flash test, 1008
Flashing, 2966, 3014
FlashingColorOff property (VBS), 4298
FlashingColorOn property (VBS), 4300
FlashingEnable property (VBS), 4301
FlashingRate property (VBS), 4302
FlashTransparentColor property (VBS), 4305
Flip, 3141

Object, 2953
Flip property (VBS), 4306
Flip-flop

Reset/set, 1597, 1848
Set/reset, 1596, 1847

Floating-point number, 1093, 1094
Check invalidity, 1681, 1934
Check validity, 1680, 1933

Floating-point numbers, 1095
Invalid , 1095

FLOOR, 1758, 2014, 2198
Flutter monitoring, 951

FocusColor property (VBS), 4306, 4307
FocusWidth property (VBS), 4308
Folder link

Editing, 2976
Removing, 2976
Renaming, 2976

Font property (VBS), 4309
Font settings

Migrate, 140
FontBold property (VBS), 4311
FontItalic property (VBS), 4312
FontName property (VBS), 4313
FontSize property (VBS), 4314
FontUnderline property (VBS), 4315
Footer

Report, 3463
FOR, 2218
Force

Force all, 1544
Stop forcing, 1546, 1547

Force job
On SD card, 36

Force table
 Meaning of the icons, 1528
"Monitor once and now" command for tags, 1538
Basic mode, 1527
Display, 1529
Expanded mode, 1527
Functionality, 1524
Layout, 1526
Meaning of the columns, 1526
Monitoring and modifying modes, 1513
Opening, 1529
Overview of the display formats, 1533
Overview of the test options, 1524
Permitted operands, 1531
Permitted operands for force values, 1532
Saving, 1530
Switching between basic mode and expanded 
mode, 1527
Syntax check, 1530
Test options, 1524

Force value
Permitted operands, 1532

Forcing
Audit, 5781

Forcing tags, 51
Safety precautions, 1526, 1540

Forcing tags for direct I/O access, 51
ForeColor property (VBS), 4316, 4317
Foreground color

Dynamization, 3014
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Form exponential value, 2149
Format, 3090
FormatPattern property (VBS), 4318
FormatPatternReadOnlySpecial property (VBS), 
4319
Formatting

Alarm text, 3273
FormatType property (VBS), 4319
Forward Delay, 729
FRAC, 1714, 1969, 2157
Fragment, 660, 666
Free property (VBS), 4320
Free space critically low, 3796, 5770
Free-form comments

Deleting, 1285, 1325
Editing, 1283, 1324
Inserting, 1283, 1324
Introduction, 1282, 1323

FreePercent property (VBS), 4320
FreezeProviderConnections property (VBS), 4321
Frequency meter, 920, 923
FTP, 539, 540, 882, 2699
FTP_CMD, 2699
FTPS, 2699
FTPS certificates, 531
Function, 3541

Assigning to a function key, 3035
Function list , 3551

Function (FC)
Creating, 1198
Definition, 1022
exporting to an external source file, 1420

Function block (FB)
Creating, 1198
Definition, 1023
exporting to an external source file, 1420
Instance data block, 1023

Function Block Diagram, 1302
Function key, 3030

Assigning a function, 3035
Assigning a graphic, 3037
Global assignment, 3032
Global screen, 2942
Local assignment, 2942, 3034
protect with password, 3036
Replacing devices, 5561
Use global assignment, 2942
used for screen navigation, 3041

Function keys
Global assignment, 5700
Local assignment, 5700

Function list, 3199, 3545, 4895

Asynchronous execution, 3573
Configuring, 3547
Editing, 3549
Execution in Runtime, 3573
Synchronous execution, 3573

Functional scope
ProSave, 5624

Functionality of the force table, 1524
Functions

Updating tag value, 3169, 4949
FunctionTrendControl object, 4004
FX1 series, 5383
FX2 series, 5383
FX3

PLC, 5369
FX3 series, 5373

G
GADR_LGC, 2553
Gauge, 3158

Color of individual ranges, 3160
Display peak value, 3159
GMP-relevant tag, 3158
Maximum value, 3159
Minimum value, 3159
Normal range visible , 3160

Gauge object, 4008
GE Fanuc SNP

Migrating data types, 163
GEN_DIAG, 2499
General information on troubleshooting, 6264
General rules, 1038
Generating diagnostics information, 2499
Generation of packed addresses, 787
GEO_LOG, 2549
GEO2LOG, 2543
Geographic coordinates, 693
GET, 2831
Get_AlarmState, 2472
GET_DIAG, 50, 2501
GET_NAME, 2488
GetBrightness, 3670, 3821
GetColumn, 4756, 4775, 4776, 4835, 4836, 4853, 
4854
GetColumnCollection, 4757
GetDataRecordFromPLC, 3666, 3822
GetDataRecordName, 3667, 3668, 3824
GetDataRecordTagsFromPLC, 3669, 3825
GetError, 1381, 1382, 1783, 2040, 2234
GetError , 1380
GetErrorID, 1380, 1381, 1382, 1787, 2044, 2237
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GetGroupNumber, 3670, 3826
GetHitlistColumn, 4759
GetHitlisteColumnCollection, 4758
GETIO, 2325
GETIO_PART, 2326
GetMessageBlock, 4760
GetMessageBlockCollection, 4761
GetMessageColumn, 4763
GetMessageColumnCollection, 4768
GetMessageColumnCollection , 4765
GetOperatorMessage, 4764
GetOperatorMessageCollection, 4766
GetPassword, 3671, 3827
GetPLCMode, 69
GetRow, 4767
GetRulerBlock, 4769
GetRulerBlockCollection, 4770
GetRulerColumn, 4772
GetRulerColumnCollection, 4773
GetRulerData, 4774
GetSelectionText property (VBS), 4321
GetStationInfo, 2490
GetStatisticAreaColumn, 4777
GetStatisticAreaColumnCollection, 4779
GetStatisticResultColumn, 4780
GetStatisticResultColumnCollection, 4781
GetStatusbarElement, 4782
GetStatusbarElementCollection, 4783
GetTimeAxis, 4784
GetTimeAxisCollection, 4786
GetTimeColumn, 4787
GetTimeColumnCollection, 4788
GetToolbarButton, 4790
GetToolbarButtonCollection, 4791
GetTrend, 4792
GetTrendCollection, 4793
GetTrendWindow, 4795
GetTrendWindowCollection, 4796
GetUserName, 3665, 3827
GetValue, 5864
GetValueAxis, 4797
GetValueAxisCollection, 4798
GetValueColumn, 4799
GetValueColumnCollection, 4800
GetXAxis, 4802
GetXAxisCollection, 4803
GetYAxis, 4804
GetYAxisCollection, 4805
Gigabit address, 534
Global assignment

Of a function key, 3030, 3032
Global data block, 1024

Configuring, 4956
Creating, 4956
Retentive behavior, 1396

Global firewall rules, 544
Assigning, 545

Global libraries, 338
Archiving, 355
Retrieving, 356

Global library, 5486
Adding types, 376
Archiving, 355
Cleaning up, 384
Closing, 353
Create, 5492
Creating, 348
Creating folders, 357
Deleting, 354
Displaying logs, 352, 5495
Migrating, 152
Open, 5494
Opening, 349
Save, 5493
Saving, 352
Showing properties, 351
Updating the project, 379
Using filter view, 359
Using the element view, 342
Using types, 378

Global packet filter rules, 545
Global screen, 2942

Function key, 2942
Template, 2943

Global softkey, 3032
Global tag, (See PLC tag)
GlobalColorScheme property (VBS), 4672
GlobalShadow property (VBS), 4674
GMP, 5755
GMP settings, 5783, 5787
GMP-relevant tag, 5783

Gauge, 3158
GMRP, 744
Go online, 1006

connecting several devices, 6148, 6149
Going offline, 1008
Going online

Multiple TIA Portal instances, 43
Good Manufacturing Process, 5755
GOTO, 2225
GoToEnd, 3646, 3828
GoToHome, 3646, 3828
GPRS, 674
Gradation property (VBS), 4321
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GraphDirection property (VBS), 4322
Graphic

add to graphics library, 5546
Assigning to a function key, 3037
Button, 3130
Graphic view, 3096, 3488
Inserting, 2954, 3469
managing, 2975
Stretching, 3096, 3098, 3488
Using from the graphic browser, 2974
With transparent background, 2975

Graphic browser, 2974
Graphic browser , 5547
Graphic I/O field, 3097

Output graphics list, 3007
Use in reports, 3489

Graphic view, 3096, 3488
transparent color, 3097

GraphicIOField object, 4011
Graphics, 2977

Editor, 5545
Graphics list

Application, 2999
Bit (0, 1), 3004
Bit number  (0 - 31), 3006
Creating, 3000
Graphic I/O field, 3007
Outputting configuration data, 3006
Range  (0 - 31), 3001
Range (... - ...), 3003

GraphicView object, 4014
GridBackColor property (VBS), 4323
GridlineColor property (VBS), 4323
GridLineWidth property (VBS), 4324
group

Cancel, 2981
Edit, 2980
Ungroup, 2981

Group
Adding objects, 2982
Cancel, 2981
Creating, 2980
Editing, 2980
Removing an object, 2983
Ungroup, 2981

Group acknowledgment, 5699
Group name, 547, 550
Group object, 4017
Group properties, 577
GSD files

Configuring devices (PROFIBUS), 794
GSD revisions (PROFIBUS), 793

Installation, 794
GSD files (PROFINET), 820

Changing revision, 822
Installation, 821

GSDML, (See GSD files (PROFINET))
GSM network, 674

H
Handshaking, 871
Handwheel, 3099

Tag, 3099
Hardware

Configurimg and assign parameters, 409
Detection, 46
Edit parameters, 428
Edit properties, 428

Hardware acceleration
SmartServer, 5825

Hardware and network editor
Device view, 394, 4925
Network view, 391, 4919
Topology view, 397, 4927

Hardware and software limit switches: Function, 
6014
Hardware catalog

Adding device, 419
Browsing, 411
DP slave, 772
DP/DP coupler, 772
I slave, 772
Selecting the hardware component, 417
Task card, 403, 4931

Hardware configuration
Adding device, 419
Adding module, 422

Hardware configuration for Motion Control S7-1200, 
6007
Hardware data types, 1121
Hardware detection, 421
Hardware diagnostics, 960
Hardware documentation, 6271
Hardware editor

Components, 389, 4917
Function, 389, 4917
Hardware catalog, 403, 4931
Inspector window , 402, 4929

Hardware identifier, 637, 2718, 2721, 2724, 2728, 
2733, 2734, 2735, 2736

Determining with LOG2MOD, 2546
Hardware interrupt, 891

How it works, 852
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Hardware interrupt OB
Description, 891
Parameter assignment, 900

Hardware requirements, 89
Communications instruction "AS_MAIL", 6262
Communications instruction "PG_DIAL", 6257
Communications instruction "SMS_SEND", 6260

Hardware requirements for AS-AS remote link
Communication instruction "AS_DIAL", 6259

Hardware support package
Installing, 109

Hardware-controlled data flow control, 870
Harmonizing

Object size, 2959, 3477
HART, 911
HART variables

Configuring, 949
Quality code, 950
Structure, 950

Header
Report, 3463

Height property (VBS), 4325
Help

Browsing, 250
Call topic from favorites, 251
Delete topic from favorites, 252
Find keywords, 250
Full-text search, 250
Identification of Help topics, 248
Open, 250
Open tooltip cascades automatically, 253
Printing help topics, 252
Save topics in favorites, 251
Use index, 250

Help indicator, 3100
HelpText property (VBS), 4328
Hibernate, 37
Hidden input, 3092
Hidden parameters, 1294, 1334
HiddenInput property (VBS), 4329
HideAlarm, 4807
HideTagNames property (VBS), 4329
Hiding

Report sections, 3468
Highlighting

Connection, 4941
HighLimitColor property (VBS), 4330
High-speed counter

Configuring, 866
General, 863
How it works, 863

HitlistColumnAdd property (VBS), 4330

HitlistColumnCount property (VBS), 4331
HitlistColumnIndex property (VBS), 4331
HitlistColumnName property (VBS), 4332
HitlistColumnRemove property (VBS), 4332
HitlistColumnRepos property (VBS), 4332, 4409
HitlistColumnSort property (VBS), 4333
HitlistColumnSortIndex property (VBS), 4333
HitlistColumnVisible property (VBS), 4334, 4410
HitlistDefaultSort property (VBS), 4334
HitlistMaxSourceItems property (VBS), 4335
HitlistMaxSourceItemsWarning property (VBS), 4335
HitlistRelativeTimeFactor property (VBS), 4336
HitlistRelativeTimeFactorType property (VBS), 4336
HitlistRelTime property (VBS), 4337
HMI backup

Deleting, 5591
Display, 5589
Rename, 5591

HMI connection, 179, 463, 882, 4915
Configuring, 4983, 4986, 5051, 5053, 5124, 5126
Creating, 4980, 5047, 5120
MPI, 5153, 5157, 5158
MPI parameters, 5160
Password, 4992, 5009, 5063, 5081
PC, 4983, 5001, 5053, 5073, 5126, 5143, 5158
PROFIBUS, 4998, 5001, 5002, 5071, 5073, 5140, 
5143
PROFIBUS parameters, 5004, 5075, 5147
PROFINET, 4979, 4980, 4981, 4983, 4986, 5046, 
5047, 5049, 5051, 5053, 5119, 5120, 5122, 5124, 
5126
PROFINET parameters, 4987, 5055, 5128
S7 1200, 5047
S7 1500, 4980
S7 300/400, 5120
SIMATIC PC, 4986, 5002, 5051, 5071, 5124, 
5157
WinCC RT Advanced, 4981, 5001, 5049, 5071, 
5073, 5122, 5143, 5157, 5158
WinCC RT Professional, 4981, 5001, 5002
WinCC Runtime, 4981, 5049, 5122
WinCC RT Advanced, 5002

HMI connections
Devices & Networks, 4939

HMI device, 100
as OPC client, 5892
as OPC server, 5892
available area pointers, 4976
Changing the device type, 5635
Commissioning, 5638
Configuration, 5587
Data backup, 5626
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Download, 5607
MPI parameters, 5162
Performance features, 5727, 5730, 5734, 5739, 
5742, 5747
PROFIBUS parameters, 5006, 5077, 5149
PROFINET parameters, 4989, 5057, 5130
Recommissioning, 5638
Replacing, 5572
Reset to factory settings, 5629
Restoring data, 5626
Server, 5281
System limits, 5727, 5730, 5734, 5739, 5742
Transferring authorization, 5483
Transferring license key, 5630
Updating the operating system (Windows CE), 
5629
WinAC MP, 5468, 5478

HMI device 
Data backup, 5622, 5623, 5624
Download, 5622, 5623
Image, 5622, 5623
Restoring data, 5624
Software, 5622, 5623

HMI device configuration, 5587
HMI device dependency

System function, 3555
HMI device image

Deleting, 5593
HMI device licensing

Non-PC-based, 100
HMI device on a PLC

Commissioning, 5336, 5354, 5375, 5385, 5405, 
5417, 5437

HMI device replacement, 55
by the migration, 137

HMI device type
Changing, 5635

HMI device version, 5572, 5587, 5588, (Device 
version), (Device version)
HMI device wizard, 5484, 5485
HMI HTTP protocol, 5278

Basics, 5278
HMI tag

Access to user-defined VB functions, 3552
HMIRuntime, 3903
HMIRuntime object, 3903, 3922
HOME key, 5698
Homing: Homing modes, 6016
Horizontal radius, 3093
HorizontalAlignment property (VBS), 4338, 4339
HorizontalGridLines property (VBS), 4339
HourNeedleHeight property (VBS), 4340

HourNeedleWidth property (VBS), 4341
How the frequency meter works, 921
HSC, 863
HSP, (See Support package)
HTA, 2306
HTML Browser, 3101

Button, 3102
Connection to the FTP server, 3101
File explorer, 3101

HTML page
Displaying data type DATETIME, 5843

HTMLBrowserBack, 3649
HTMLBrowserForward, 3649
HTMLBrowserRefresh, 3648
HTMLBrowserStop, 3648
HTTP, 547, 5278
HTTP client, 5858

Configure HTTP-Connection, 5858
Configuring a tag, 5284
Configuring tags, 5859
Configuring the SIMATIC HMI HTTP protocol, 
5858
Importing certificates, 5290, 5860

HTTP connection
Client, 5282

HTTP protocol
Basic Panel, 4958
Comfort Panel, 4965
Mobile Panel, 4971
Multi Panel, 4969
Panel, 4961
Timeout, 5283
WinCC Runtime, 4975

HTTP server
Configure WinCC-Project , 5856
Configuring a tag, 5282
Setting at the HMI-device, 5856
Setting up the WinCC Internet connections, 5287

HTTPS, 601, 646, 5278, 5280
HTTPS server only, 690
HW ID

See Hardware identifier, 637

I
I address, 637
I slave

Hardware catalog, 772
I/O

Direct access to, 848
I/O access error, 846
I/O address, 637, 848
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I/O field, 3090
application in reports, 3486
Data format, 3091
Decimal format, 64
Display format in reports, 3487
Format, 64
Hidden input, 3092
Mode, 3091

I/O input, 843
I/O output, 843
I/Os, 1058
ICMP, 553
Icon

For comparison, 966
For comparison status, 1013
for connection status, 1013
For hardware diagnostics, 965
for operating mode, 967
For software diagnostics, 966
For value comparison, 5937
Overlay icon, 967

Icons
in TeleService, 6213

Icons in the force table, 1528
Icons in the watch table, 1502
IconSpace property (VBS), 4342
Identifying

Alarm class, 3116
I-device, 808
IE/AS-i link PN IO, 796
IEC check, 1123

Setting, 1125
IEC counters, 187
IEC timer, 1098
IEC timers, 187
IEEE 802.3, 543
IEEE tag, 910
IF, 2214
IF1B

Basic Panel, 4960
IGMP, 743
IKE settings, 577
Illuminated pushbutton, 3106

Tag, 3107
Image, 5587

HMI device , 5622, 5623
Image file

Storing in the image browser, 2977
Storing in the image browser , 5547

IMC, 1824, 2082, 2269
Import

Alarm, 5511

Analog alarm structure, 5512
Project texts, 5544
Recipe, 5508
Structure of discrete alarms, 5515
Structure of recipe data, 5509
Tag, 5519
Text list, 5524
User administration, 3526

ImportDataRecords, 3650, 3829
ImportDataRecordsWithChecksum, 3652, 3831
Importing

Recipe, 3449
Recipe data record, 3399, 3449, 5657

Importing a recipe
Structure for the import, 5509

Importing analog alarms
Structure for the import, 5512

Importing discrete alarms
Structure for the import, 5515

Importing NTP servers, 570
in the screen

Arrange object, 2962, 3475
IN_RANGE, 1678, 1931
INC, 1692, 1947
Incoming, 3252, 3791
IncreaseFocusedValue, 3639
IncreaseTag, 3639, 3832
Increment, 1692, 1947
Indenting and outdenting

Lines, 1353
Index property (VBS), 4342
Index tag, 3197, 3198
Indirect addressing, 185, 1067, 1068, 1069, 1070, 
1072, 1073
Indirect addressing , 3197
Industrial Ethernet, 4934
Information system

Components of the information system, 247
Roll-out, 248
Tooltip, 248

Infotext, 3261
Creating, 3270, 3273
display, 5696, 5699, 5703
Key, 5699

Infotext 
Display, 3328

INIT_RD, 1789, 2046, 2239
Initialization (user-defined web pages), 649
Initialize all retain data, 1789, 2046, 2239
InnerBackColorOff property (VBS), 4343
InnerBackColorOn property (VBS), 4344
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Input
Inserting, 1289, 1840
remove, 1290, 1330

Input (I), 843
Input area plan

SmartClient, 5804
SmartServer, 5804
SmartService, 5804

Input byte (IB), 843
Input field, 5692

Character mode, 5698
Standard mode, 5698

Input finished, 3790
Input word (IW), 843
INSERT, 2312
Insert empty line, 6055
Insert input, 1329
Insert separator line, 6055
InsertData(i) property (VBS), 4345
InsertEnable property (VBS), 4345
Inserting

Code template in user-defined functions, 3551
Graphic, 2954, 3469
Library object, 5501
Object, 2953, 2954, 3469
Rectangle, 2990

Inserting a comment section, 2227
Inspector window

Cross-reference, 62
Event, 62
Layout, 219
Reducing automatically, 214

Inspector window 
Diagnostics tab, 961
Hardware and network editor, 402, 4929

Installation
Displaying software, 110
Licenses, 83
Log, 106
Modifying products, 111
ProSave, 75
Repairing products, 113
Smartdrive, 57
Starting, 107
Support package, 109
System requirements, 84
Target directory, 39
Updating products, 111

Installing, 98
Add-on, 98
Option, 5632
Powerpack, 105

Installing CA certificate, 6246
Installing license keys, 86
Installing support packages, 109
Installing the communications driver (WinAC MP), 
5467
Installing the local modem, 6221
Instance data block

Creating, 1025
Definition, 1025
Modifying the data types of IEC timers and IEC 
counters, 1361
Retentive behavior, 1395

Instruction
Copying, 1375
Cutting, 1375
Deleting, 1375
Inserting, 1375
Rules, 1357
Specify data type, 1274, 1275, 1315, 1316
Versions, 1230

Instruction profile
Activating and deactivating, 1234
Basics, 1231
Creating, 1232
Deleting, 1235
Editing, 1233
Opening, 1233

Instructions
Function list, 3551

Instructions for configuring a remote modem, 6223
INT, 1087, 1131, 1151
INT_TO_, 1151
Integer, 1759, 2015, 2200

16-bit, 1087, 1088
32-bit, 1089
64-bit, 1090, 1092
8-bit, 1085, 1086

IntegerDigits property (VBS), 4346
Integrated

Connection, 4939, 4943
Integrated connection, 3170, 4949
Integrated project

Converting an unspecified CPU, 178
Creating an integrated HMI connection, 179
Deleting an unspecified connection, 182
Linking HMI tags, 181
Migrating, 157, 175
Post-editing, 177

Intelligent DP slave, (See I-slave)
Interconnecting ports

Graphic view, 517, 519
Table view, 519, 520
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Interface, (See block interface)
Adding, 6156
Basic Panel, 4960
Comfort Panel, 4966
Displaying, 973
Mobile Panel, 4973
Multi Panel, 4970
Panel, 4963
Renaming, 521
WinCC RT Advanced, 4975
WinCC RT Professional, 4975
WinCC Runtime Advanced, 4975
WinCC Runtime Professional, 4975

Interface properties, 973
Interference frequency suppression, 943
Internal

Ethernet port, 5372
Internal Ethernet port

Open settings, 5372
Internal network nodes

Configuring, 582
Diagnostics, 592

Internal reference junction, 945
Internal tags

Data exchange, 4915
Internet Key Exchange (IKE), 577
Interrupt event

Delaying with DIS_AIRT, 2469
Disabling with DIS_IRT, 2466
Enabling with EN_AIRT, 2469
Enabling with EN_IRT, 2467

Interrupts
Activating time-of-day interrupt with ACT_TINT, 
2450
Canceling time-delay interrupt with CAN_DINT, 
2454
Canceling time-of-day interrupt with CAN_TINT, 
2449
Querying time-delay interrupt with QRY_DINT, 
2455
Querying time-of-day interrupt with QRY_TINT, 
2451
Receiving from I/O module with RALRM, 2328
Setting time-of-day interrupt with SET_TINT, 
2446
Setting time-of-day interrupt with SET_TINTL, 
2448
Starting time-delay interrupt with SRT_DINT, 
2453
With packed addresses, 792

Interval property (VBS), 4346
Intrusion Detection System (IDS), 90, 94

INV, 1796, 2053
Invalid license

With a time zone change, 87, 103
InverseLinearScaling, 3655, 3833
Invert, 1590, 1796, 1841, 2053
InvertBit, 3653, 3834
InvertBitInTag, 3654, 3835
InvertLinearScaling, 3655, 3833
IO device

Networking, 811
Update time, 814
Watchdog time, 815

IO system, 811
Creating, 811

IO2MOD, 2547
IOField object, 4021
IO-Link, 825
IP access control list, 539
IP address, 37, 800

Reading out, 5284
IP address parameters, 801, 808
IP configuration

Change parameters from the user program, 2914
IP packet filter rules, 553
IP parameters, 973
IP protocol, 5058
IP rule sets, 544
IP services, 547
IPsec settings, 577
IPv4 addresses, 558
IPv6

Notation, 687
IPv6 addresses, 558
IQ sense, 952
iQ series, 5373
IRT (Isochronous Realtime Ethernet), 5305
ISAKMP, 586
I-slave, 773, 782

Configuring, 783
Data access, 783
Data exchange, 774

ISO protocol, 609
Isochronous mode, 827
ISO-on-TCP

Characteristics, 487
TSAP, 496

ITag, 5869
ITag method

Cancel, 5884
ReadTag, 5881
ReadTagAsync, 5882
ReadTagCyclic, 5883
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Register, 5881
RemoveCyclicTag, 5883
Unregister, 5886
WriteTag, 5884
WriteTagAsync, 5885

ITagSink, 5869
ITagSink methods

OnCanceled, 5886
OnError, 5888
OnRemove, 5888
OnUpdate, 5887
WriteTagAsync, 5889

Item methods, 4808
Item object, 3924
ItemBorderStyle property (VBS), 4347

J
Jerk limiter: Function, 6015
JMP, 1769, 2026
JMP_LIST, 1772, 2029
JMPN, 1770, 2027
Job mailbox, 4916

Transferring data, 5020, 5096, 5177, 5217, 5456
Jump, 1769, 1770, 1771, 1772, 1774, 1777, 2026, 
2027, 2028, 2029, 2030, 2033
Jump distributor, 1774, 2030
Jump label, 1771, 2028, 2225
Jump list, 1772, 2029
JumpToLimitsAfterMouseClick property (VBS), 4348

K
Key

Backspace, 5698
Cursor, 5698
Delete, 5698
END, 5698
ENTER, 5698
ESC, 5698
HOME, 5698
Infotext, 5699
Scrolling back, 5698
Scrolling up, 5698
TAB, 5698

Key assignment
Replacing devices, 5561

Key operation, 5697, 5700
Key switch

Application, 3133
Layout, 3133

Tag, 3133
Keyboard operation, 406

Basic functions of the TIA Portal, 234
Customizing editors, 239
Editing objects, 240
Editing texts, 241
Navigation in the TIA Portal, 237
Online functions, 243
Project editing, 236
Selecting objects, 240
Tables, 242
Window, 236

Keyword highlighting, 1349
Keywords, 1052
K-key

Replacing devices, 5562
Know-how protection

Changing a password, 1459, 3564
Converting blocks from V10.5, 49
Introduction, 1453
opening a user-defined function, 3563
Opening blocks, 1457
Printing block, 1458
remove, 1459, 3563
Setting up, 1456, 3562

L
LABEL, 1771, 2028
LabelColor property (VBS), 4348
LACP, 735
LAD, 1259, 1553
LAD element

Copying, 1286
Cutting, 1287
Deleting, 1292
Inserting, 1272, 1273
Inserting an operand, 1292
pasting from the clipboard, 1287
Replacing, 1288
Rules for inserting, 1270
Selecting, 1285

LAD network
Branch, 1295
Closing a branch, 1297
Crossing, 1298
Deleting a branch, 1297
Deleting a crossing, 1300
Insert crossing, 1298
Inserting a block call, 1278, 1319
Inserting a branch, 1296
Program status display, 1496
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Prohibited interconnections, 1272
Rearranging a crossing, 1299
Rules for simultaneous branches, 1296

Ladder Logic, 1259
Language

Activate project language, 5535
Asian languages, 5533
Asian operating system, 5533
Disabling the project language, 5535
Editing language, 5535
Language support, 5533
Language-dependent format, 5532
Language-specific graphic, 5545
Log, 3231, 3318, 5555
multilingual project , 5537
Reference language, 5535
Regional format of the date, time, currency, and 
numbers, 5532

Language abbreviation, 670
Language behavior

On-screen keyboard, 77
Language property (VBS), 4349
Language switching, 670, 5549

In Runtime, 3577
Log, 3231, 3318, 5555
Runtime language, 5552

Languages
Migrating, 150

LargeTicksBold property (VBS), 4350
LargeTicksSize property (VBS), 4350
LastConnectedObjectIndex property (VBS), 4351
LastConnectedObjectName property (VBS), 4351
Layer

Assigning objects to a layer, 3044
Layer 2, 543
Layer 3, 543
Layer object, 3924
Layers object (list), 3926
Layout

 Alarm report , 3490
 Recipe report , 3492
Alarm indicator, 3120, 3331
Alarm line, 3113
Alarm view, 3114, 3118, 3325, 3329, 5683, 5685
Bar, 3086
Button, 3130
Charging condition, 3106
Circle, 3103
Clock, 3151
Date/time field, 3089
Date/time field in reports, 3486
Effective range name, 3152

Effective range name (RFID), 3154
Effective range signal, 3156
Ellipse, 3092
f(x) trend view, 3094
Gauge, 3159
Graphic I/O field, 3097
Graphic I/O field in reports , 3489
Graphic view, 3096, 3488
Handwheel, 3099
HTML Browser, 3101
I/O field, 3091
I/O field in reports, 3487
Illuminated pushbutton, 3107
Key switch , 3133
Line, 3110
Media Player , 3111
Page number in reports, 3493
Polygon, 3121
Polyline, 3123
Recipe view, 3126
Rectangle, 3125
Simple Alarm view, 3113
Simple recipe view, 3436, 5672
Simple user view, 5709
Slider, 3132
Sm@rtClient view, 3136
Status/Force, 3139
Switch, 3129
Symbol library, 3140
Symbolic I/O field, 3142
Symbolic I/O field in reports, 3494
Text field, 3150, 3495
Trend view, 3104
User view, 3088, 5707
WLAN reception, 3157
Zone name, 3160
Zone signal, 3161

Layout of the force table, 1526
LDT, 1101
Lead and lag algorithm, 1828, 2086, 2274
LEAD_LAG, 1828, 2086, 2274
Learning functionality, 582
Learning mode, 608
LeaveMarginForBorder property (VBS), 4363
LeaveMarginForMarkers property (VBS), 4364
LED, 2484

Assignment, 5028, 5104, 5184, 5227, 5362, 5393, 
5424, 5443
Function, 5028, 5104, 5184, 5227, 5362, 5393, 
5424, 5443
Image, 5028, 5104, 5184, 5227, 5362, 5393, 
5424, 5443
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LED ACK, 5681
LED control, 5644
LED status

Reading out with LED, 2484
LEFT, 2309
Left property (VBS), 4364
LEN, 2308
Length

Area pointer, 4954
Area pointers, 4956

LG GLOFA GM
Migrating data types, 163

LGC_GADR, 2555
Library, 5486

Adding a master copy, 359
Adding and using a block, 1200
Basics, 338
Buttons and Switches, 5491
Cleaning up, 384
Comparing library elements, 385
Copy template, 5490
Copying a library object, 5490
Copying types to the clipboard, 380
Creating folders, 357
Cutting library elements, 380
Cutting master copies, 380
Cutting types, 380
Deleting instances, 381
Deleting types and versions, 381
Displaying the properties of a type, 365
Harmonizing names and path structure, 383
Master copies, 338
Moving library elements, 381
Open, 5494
Opening a released type version, 364
Pasting master copies from the clipboard, 381
Pasting types from the clipboard, 380
PLC data types generated by the system, 49
Released type version, 363
Save, 5493
Storing an object, 5500
System diagnostics indicator, 3379
Task card, 339
Type, 5490
Type version in progress, 362
Type version in testing, 363
Types, 338
Using filter view, 359
Using master copies, 357, 360
Using the element view, 342
Using types, 361
Versioning of types, 361

Library management
Opening, 348
Overview, 346

Library object, 5486, 5488
Inserting, 5501

Library view
Exit, 346
Opening, 345
Overview, 343, 5488

License
Defective, 88, 103
Defective license, 88, 103
Managing, 5630
Starting without valid license, 85, 99

License key, 87, 102
Handling license keys, 87
Working with license keys, 102

License Keys, 5630
License Manager Panel plug-in, 100
License key

Transfer to an HMI device, 5630
Licenses, 83
Licensing

General information, 5642
Life of certificates, 575
Light emitting diode

acknowledge, 5699
Toggle, 5699

LIMIT, 1700, 1954, 2144
Limit and enable password legitimation, 1778, 2035, 
2228
Limit frequencies of pulse outputs, 6009
Limit test, 5693, 5701
Limit value, 935, 1700, 1954, 2144, 3261

Tag, 3184
Limit values

Tag, 3183
Limit4LowerLimit property (VBS), 4367
Limit4LowerLimitColor property (VBS), 4368
Limit4LowerLimitEnabled property (VBS), 4368
Limit4LowerLimitRelative property (VBS), 4369
Limit4UpperLimit property (VBS), 4369
Limit4UpperLimitColor property (VBS), 4370
Limit4UpperLimitEnabled property (VBS), 4371
Limit4UpperLimitRelative property (VBS), 4371
Limit5LowerLimit property (VBS), 4372
Limit5LowerLimitColor property (VBS), 4372
Limit5LowerLimitEnabled property (VBS), 4373
Limit5LowerLimitRelative property (VBS), 4374
Limit5UpperLimit property (VBS), 4374
Limit5UpperLimitColor property (VBS), 4375
Limit5UpperLimitRelative property (VBS), 4376
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Line, 3110
design, 2966
Line end, 2966, 3110
Line start, 3110

Line break, 926
Line end

Line, 3110
Polyline, 3123

Line object, 4025
Line start

Line, 3110
Polyline, 3123

Linear programming, 1020
LinearScaling, 3672, 3836
LineWidth property (VBS), 4379, 4380
Link folder

External graphic, 2976
Linked objects

Copying, 5578, 5579
Linking HMI tags, 181
LINT, 1090
Listbox, 4027
Lists, 3945
Lists in VBS

Alarms object (list), 3913
Lists:DataSet, 3919
Lists:Layers, 3926
Lists:Tags Object (List), 3944
LLDP, 539, 540
LLDP (Link Layer Discovery Protocol), 819, 4996, 
5066, 5138
LN, 1704, 1959, 2148
load

Recipe data record in Runtime, 3446
Load

Extended download to device, 76
In programming device/PC, 828
Loading blocks to device, 1446, 1447
SIMATIC PC station, 76

Load memory, 843, 1481
Displaying, 1485

Load window layout
Loading additional window layouts, 231
Loading via quick access, 231

LoadDataImmediately property (VBS), 4381
LoadDataRecord, 3664, 3837
Loading

Blocks to the device, 1445
Downloading blocks to a memory card, 1450
Downloading project data to the device, 282
Downloading to a memory card, 283
from a device, 43, 48, 284

General information, 281
in RUN operating mode, 1445
to the device, 43
Uploading blocks from a memory card, 1452
USB, 5610

Loading projects
with connected HMI device, 5601
without connected HMI device, 5602

Local assignment
Of a function key, 3030, 3034

Local data bit (L), 843
Local data byte (LB), 843
Local data double word (LD), 843
Local data word (LW), 843
Local error handling, 1380

Error information, 1380
Instructions, 1380
Priorities, 1381

Local logging, 587
Local script, 3541
Local tag, 1239

Access to user-defined VB functions, 3552
Local time, 856

Calculating with SET_TIMEZONE, 2290
Reading out with RD_LOC_T, 2288
Writing with WR_LOC_T, 2288

LocalCursor property (VBS), 4382
Localizable property (VBS), 4382
LockAlarm, 4810
LockSquaredExtent property (VBS), 4383
Log

Alarm log, 3388
Automatic entries, 3390
Characters which may be used in tag names, 
3221
Checksum, 3217, 3230, 3317
Data log, 3388
Language switching, 3231, 3318, 5555
Level-dependent management, 3223, 3320
Runtime language, 3231, 3318, 5555
Storage on network, 5641

Log behavior
Control with system function, 3226
Level-dependent management, 3223, 3320
Managing upon system start, 3222, 3319

Log contents
Display, 3216, 3306

Log data
Migrating, 153

Log database
Direct access with ODBC, 3232, 3244, 3314

Log entries, 3390
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Log file
 Modem alarms , 6268

Log language, 3231, 3318, 5555
Log tag value change

Audit Trail, 5782
Log type, 3305
Log with level-dependent execution of system 
functions, 3305
Log with level-dependent system alarm, 3305
LOG_GEO, 2551
LOG2GEO, 2545
LOG2MOD, 2546
Logarithm, 1704, 1959, 2148
Logging, 587

Change to a recipe data record in Audit Trail, 
5785
Circular log, 3215
CP x43-1 Adv., 614
Log type, 3215, 3305
SCALANCE S, 601, 602
Segmented circular log, 3215
System functions in Audit Trail, 5791
Tag value, 3214
Tag value change in Audit Trail, 5782
Tags, 3218, 3224
Tolerance band, 3224
User actions in audit trail, 5788
Within/outside the limit values, 3224

Logging concept
Audit , 5757

Logging cycle, 3224
Tag, 3212

Logging method
Circular log, 3215
Level-dependent, 3215

Logging object, 3927
Logging recipe data changes

Audit Trail, 5785
Logging system functions

Audit Trail, 5791
Logging tag

Configuring, 3234
Logging user actions

Audit Trail, 5788
Logic analyzer function, 6170
Logic operation

AND, 1791, 2048
EXCLUSIVE OR, 1794, 2051
OR, 1793, 2050

Logic path
Deleting, 1340
Inserting, 1339

Use, 1338
Logical address

Determining a module with GADR_LGC, 2553
Determining a module with RD_LGADR, 2552
Determining associated slot with LGC_GADR, 
2555
Determining associated slot with LOG_GEO, 
2551

Logical error, 3566
Logoff, 3618, 3838

Configuring on the effective range, 4885
Configuring to effective range (RFID), 4888
Effective range, 3153
Effective range (RFID) , 3155
Users, 5712

LogOff, 3618, 3838
Logoff time, 5706

Changing, 3509
Changing in runtime, 3522, 3524

Logon, 3624, 3839
Configuring on the effective range, 4885
Configuring to effective range (RFID), 4888
Effective range, 3152
Effective range (RFID), 3155
Logon failed, 3528
Reporting, 3532
User, 3527
Users, 5711

Logon dialog
Configuring access protection, 3531

Logon for web server, 644
Logon web server, 644
LogOperation property (VBS), 4384
LogTag, 3627
Long word, 1084
LookupText, 3742, 3839
Loop, 2214, 2218, 2220, 2222, 2223, 2224
Loop-in alarm

trigger, 3331
LoopInAlarm, 4810
Loop-in-alarm

Configured, 3279
Loop-In-Alarm, 3792
Low free storage space, 3796, 5769
LowerLimit property (VBS), 4386
LowerLimitColor(i) property (VBS), 4386
LowerLimitValue(i) property (VBS), 4387
LowLimitColor property (VBS), 4388
LREAL, 1094, 1136, 1160
LREAL_TO_, 1160
LTIME, 1098
LTOD, 1100
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LWORD, 1084

M
MAC packet filter rules, 556
MAC rule sets, 544
MAC services, 550
MachineName property (VBS), 4389
Main, 883
Main mode, 577
managing

Graphic, 2975
Managing

License, 5630
User group, 3510
Users, 3509
Users in runtime, 3521, 3523

Manual fragment, 666
Manuals, 405, 4933
MarginToBorder property (VBS), 4389
Math functions

CALCULATE, 1281, 1322
MAX, 1698, 1952, 2142
MAX_LEN, 2303
Maximum, 1698, 1952, 2142
Maximum cycle time, 840, 859, 860, 1782, 2039
Maximum length

Tag, 77
Maximum load memory available

Displaying, 1485
Maximum number of controllable drives, 6008
MaximumValue property (VBS), 4390, 4391
MB_CLIENT, 2790, 2808
MB_COMM_LOAD, 2774
MB_MASTER, 2777
MB_SERVER, 2798, 2819
MB_SLAVE, 2785
MC_ChangeDynamic: Instruction, 2586
MC_ChangeDynamic: Parameter, 2586
MC_CommandTable: Instruction, 2584
MC_CommandTable: Parameter, 2585
MC_Halt: Function chart, 2568
MC_Halt: Instruction, 2566
MC_Halt: Parameter, 2566
MC_Home: Instruction, 2562
MC_Home: Parameter, 2564
MC_MoveAbsolute: Function chart, 2571
MC_MoveAbsolute: Instruction, 2569
MC_MoveAbsolute: Parameter, 2570
MC_MoveJog: Function chart, 2583
MC_MoveJog: Instruction, 2580
MC_MoveJog: Parameter, 2581

MC_MoveRelative: Function chart, 2575
MC_MoveRelative: Instruction, 2572
MC_MoveRelative: Parameter, 2573
MC_MoveVelocity: Function chart, 2579
MC_MoveVelocity: Instruction, 2576
MC_Power: Function chart, 2560
MC_Power: Instruction, 2556
MC_Power: Parameter, 2557
MC_Reset: Instruction, 2561
MC_Reset: Parameter, 2561
MCAT, 1820, 2078, 2266
MD5, 578, 625, 635
MDM, 255
Meaning of the columns in the force table, 1526
Measure program runtime, 2241
Measuring window (GATE), 923
Media Player , 3111
Media redundancy (MRP), 5313, 5314, 5315, 5318
MediaControl, 4030
Memory area

Load memory, 843
Retentive memory areas, 845
Work memory, 843

Memory bit (M), 843
Memory byte (MB), 843
Memory card, 841, (See Memory Card)

Accessing, 336
Adding a card reader, 335
Formatting, 994
Introduction, 335
Removal/insertion, 43
Showing properties, 337

Memory cards, 38
Memory double word (MD), 843
Memory medium, 3306

Audit Trail, 5780
Memory requirements

Recipe, 5752, 5753
Memory reserve, 49
Memory reset, 841

Making, 989
Memory size

Alarm buffer, 3303
Memory space warning, 37
Memory word (MW), 843
Menu command

Simple recipe view, 3437, 5673
Message

Sending, 874
Specifying the end, 875
Specifying the start, 874

MessageBlockAlign property (VBS), 4395
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MessageBlockAutoPrecisions property (VBS), 4395
MessageBlockCaption property (VBS), 4396
MessageBlockCount property (VBS), 4396, 4400
MessageBlockDateFormat property (VBS), 4397
MessageBlockExponentialFormat property (VBS), 
4397
MessageBlockFlashOn property (VBS), 4398
MessageBlockHideText property (VBS), 4398
MessageBlockHideTitleText property (VBS), 4399
MessageBlockID property (VBS), 4399
MessageBlockLeadingZeros property (VBS), 4400
MessageBlockLength property (VBS), 4401
MessageBlockName property (VBS), 4401
MessageBlockPrecisions property (VBS), 4402
MessageBlockSelected property (VBS), 4402
MessageBlockShowDate property (VBS), 4403
MessageBlockShowIcon property (VBS), 4403
MessageBlockShowTitleIcon property (VBS), 4404
MessageBlockTextId property (VBS), 4404
MessageBlockTimeFormat property (VBS), 4405
MessageBlockType property (VBS), 4405
MessageColumnAdd property (VBS), 4406
MessageColumnCount property (VBS), 4407
MessageColumnIndex property (VBS), 4407
MessageColumnName property (VBS), 4408
MessageColumnRemove property (VBS), 4408
MessageColumnRepos property (VBS), 4332, 4409
MessageColumnSort property (VBS), 4409
MessageColumnSortIndex property (VBS), 4410
MessageColumnVisible property (VBS), 4334, 4410
MessageListType property (VBS), 4410
Methods, 4745, 4748, 4749, 4751, 4754, 4755, 4756, 
4757, 4758, 4759, 4760, 4761, 4763, 4764, 4765, 
4766, 4767, 4768, 4769, 4770, 4772, 4773, 4774, 
4775, 4776, 4777, 4779, 4780, 4781, 4782, 4783, 
4784, 4786, 4787, 4788, 4790, 4791, 4792, 4793, 
4795, 4796, 4797, 4798, 4799, 4800, 4802, 4803, 
4804, 4805, 4807, 4810, 4811, 4812, 4813, 4814, 
4815, 4816, 4817, 4818, 4819, 4820, 4821, 4822, 
4835, 4836, 4837, 4838, 4839, 4840, 4841, 4842, 
4843, 4844, 4845, 4846, 4847, 4848, 4849, 4850, 
4851, 4852, 4853, 4854, 4858, 4859, 4860, 4861
Methods (VBS), 4742, 4751

Activate, 4742
CreateTagSet, 4751
Item, 4808
Stop, 4851
Trace, 4852

Methods in VBS
Create, 4750
DeactivateDynamic, 4752

Methods:Add, 4747

Methods:Read, 4823
Methods:Refresh, 4826
Methods:Remove, 4827
Methods:RemoveAll, 4831
Methods:Restore, 4832
Methods:Write, 4855
MIB, 539
Micro, 5403
MicroLogix, 5330, 5352
MID, 2311
Migrated project

Compiling, 131
Migrating projects

Procedure, 123
Requirements, 123

Migration, 37
Adaptations beforehand, 134
Alarm groups, 146
Allen-Bradley DF1 data types, 161
Allen-Bradley DH485 data types, 162
Allen-Bradley Ethernet IP data types, 162
Area pointer, 143
Basics, 127
Data types Modicon Modbus, 165
Data types Modicon Modbus TCP/IP, 166
Data types Omron Hostlink/Multilink, 166
Data types OPC, 167
Data types SIMATIC 500/505 DP, 168
Data types SIMATIC 500/505 serial, 168
Data types SIMATIC HMI HTTP Protocol, 169
Data types SIMATIC S5 AS511, 169
Data types SIMATIC S5 DP, 170
Data types SIMATIC S7 200, 171
Data types SIMATIC S7 300/400, 171
Data types Telemecanique Uni-Telway, 174
Displaying a log file, 125
Displaying history, 125
Font settings, 140
GE Fanuc SNP data types, 163
Global library, 152
HMI device replacement, 137
Including the hardware configuration, 120
Integrated project, 175
Introduction, 126
Introduction to migration, 119
LG GLOFA GM data types, 163
Migrating an integrated project, 157, 175
Migrating projects, 130, 158
Mitsubishi FX data types, 164
Mitsubishi Protocol 4 data types, 165
of external tags, 160
of languages, 150
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of log data, 153
of project text, 150
Project library, 152
Recipe data, 153
Reconfigure connection, 142
Runtime data, 153
Script, 149
Supported HMI devices, 132
Supported products, 119
Text, 150
The migration process, 119
User administration, 153
VB-script, 149
WinCC V7.0 SP3, 60

Migration tool, 128
Creating a migration file, 122
Distribution and sources, 117
Including the hardware configuration, 121
Removing, 118
System requirements, 117
Using the migration tool, 120

MIN, 1696, 1950, 2140
Mini USB, 5610
Minimum, 1696, 1950, 2140
Minimum cycle time, 840, 859
MinimumValue property (VBS), 4411, 4412
MinuteNeedleHeight property (VBS), 4412
MinuteNeedleWidth property (VBS), 4413
Mirroring, 722
Missing supply voltage, 935, 942
Mitsubishi, 5320

Address, 5374
Analog alarm, 5390
Basic Panel, 4958
Comfort Panel, 4965
Communication drivers, 5363
Connection interruption, 71
FX, 5363
Mobile Panel, 4971
Multi Panel, 4969
Panel, 4961
TCP/IP, 5363
WinCC Runtime, 4975

Mitsubishi FX
Address areas, 5383
Configuring a connection, 5376
Connection, 5376, 5380
Connection parameters, 5378
CPU type, 5383
Data type, 5382
Migrating data types, 164
Mitsubishi MC TCP/IP, 5368, 5381

Mitsubishi MC TCP/IP
Configuring a connection, 5364
Connection, 5364, 5367
Connection parameters, 5365
CPU type, 5373
Data type, 5372

Mitsubishi Protocol 4
Migrating data types, 165

Mixed mode, 579
Mobile Panel

Area pointer, 4974
Communication drivers, 4971
Display and operating element, 3083
HTTP protocol, 4971
Interface, 4973
Mitsubishi, 4971
Modicon Modbus, 4971
OPC, 4971, 5891
S7 1200, 4971
S7 200, 4971
S7 300, 4971
S7 400, 4971

Mobile panels
Available system functions, 3608

Mobile Wireless, 4876, 4878
Work area, 4876
Zone ID / connection point ID, 4891

Mobile Wireless (RFID)
Work area, 4878

Mobile Wireless V2, 4878
MOD, 1342, 1690, 1944
Modbus communication

as a slave with MB_SLAVE, 2785
as Modbus master with MB_MASTER, 2777
Configuring a port with MB_COMM_LOAD, 2774

Mode, 3130
Graphic I/O field, 3098
I/O field, 3091

Mode property (VBS), 4413
Modem

Local, 6221
Problem, 6264
Remote, 6222

Modem alarms
Log file, 6268

Modem connection cannot be established, 6268
Modem connection is closed, 6268
Modem connection is interrupted, 6267

Causes and solutions, 6267
Modems without plug-and-play, 6222
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Modicon
Approved communication with Modbus RTU, 
5411
Connection, 5410
Connection cable, 5410
Restrictions with Modbus RTU, 5411

Modicon M340, 5403
Modicon Modbus, 5320

Basic Panel, 4958
Comfort Panel, 4965
Communication drivers, 5393
Migrating data types, 165
Mobile Panel, 4971
Multi Panel, 4969
Panel, 4961
RTU, 5393
TCP, 5393
WinCC Runtime, 4975

Modicon Modbus connection
Data types, 5422

Modicon Modbus RTU, 5416
Configuring a connection, 5406
Connection, 5406
Connection parameters, 5408
Data type, 5415

Modicon Modbus TCP, 5403
Configuring a connection, 5394
Connection, 5394, 5399
Connection parameters, 5396
Data type, 5402

Modicon MODBUS TCP/IP
Change word order, 5398

Modicon Modbus TCP/IP
Migrating data types, 166

Modify
High-speed counters, 2588

Modify value
Permitted operands, 1507

Modifying mode, 1513
Modifying recipe structures, 3450
Module

Addressing, 637
Asynchronously reading data record with 
RD_DPARA, 2436
Communication Status, 591
Configuring and assigning, 43
Copying, 425
Deleting, 424
Determine diagnostics status, 981
Determining logical address of the slot with 
LOG_GEO, 2551

Determining logical address with GADR_LGC, 
2553
Determining logical addresses with RD_LGADR, 
2552
Determining slot of a logical address with 
LGC_GADR, 2555
Determining start address with GEO_LOG, 2549
Inserting, 43, 423
Moving, 427
Reading data record with RD_DPAR, 2433
Removing, 43
Replacing, 427
Select, 414
Time of day on a module, 989

Module addressing, 847
Module arrangement, 411
Module replacement, 178
Module rights, 539
Module titles, 413
Module version

Updating, 431
ModuleStates, 2496
Momentum, 5403, 5416
Monitor, 817, 4994, 5064, 5136
Monitoring

"Monitor all" command, 1515, 1537
"Monitor now" command, 1538
"Monitor once and now" command, 1516

Monitoring and modifying modes, 1513
Monitoring mode, 1513, 5816
Monitoring window, 951
Mono-master system, 773
Motion Control CPU S7-1200

 Guidelines, 6017
Movable property (VBS), 4414
Move

Block, 1726, 1746, 1981, 2002, 2158, 2187
Block uninterruptible, 1731, 1749, 1987, 2005, 
2163, 2189
Screen, 2939
Value, 1717, 1972

MOVE, 190, 1717, 1972
Move block, 1728, 1983, 2160
Move view

Keyboard operation, 407
Overview navigation, 392, 395, 398, 4920, 4926, 
4928

MOVE_BLK, 1726, 1981, 2158
MOVE_BLK_VARIANT, 2160
MOVE_BLK_VARIANT:, 1728, 1983
MoveAxis, 4811
MoveToFirst, 4811
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MoveToFirstLine, 4812
MoveToFirstPage, 4812
MoveToLast, 4813
MoveToLastLine, 4813
MoveToLastPage, 4814
MoveToNext, 4814
MoveToNextPage, 4815
MoveToPrevious, 4816
MoveToPreviousLine, 4816
MoveToPreviousPage, 4817
Moving

Hardware components, 427
MPI, 4934

Addressing, 5165
Connection, 5189
HMI connection, 5153, 5157, 5158
Network, 4936
Network architecture, 4936
Parameters, 5160, 5162, 5163
S7 200, 5196, 5205
S7 300/400, 5153, 5155, 5157, 5158
WinCC RT Advanced, 5155

MPI address
S7 300, 5165
S7 400, 5165

MPI communication
S7 300/400, 5153, 5155

MPI parameters
S7 300/400, 5160, 5162, 5163

MRP (Media Redundancy Protocol), 5313, 5314
MRP domain, 976, 5315, 5318
MRP domain properties, 976
MsgFilterSQL property (VBS), 4415
MSK_FLT, 2463
MSTP, 732

Port, 729
MUL, 1688, 1941
Multi Panel

Area pointer, 4970
Communication drivers, 4969
Display and operating element, 3081
HTTP protocol, 4969
Interface, 4970
Mitsubishi, 4969
Modicon Modbus, 4969
OPC, 4969, 5891
S7 1200, 4969
S7 200, 4969
S7 300, 4969
S7 400, 4969

Multi Panel 
Omron, 4969, 4971

Multi Panels
Available system functions, 3596

Multicast, 565, 742
Multi-instance

Declaring, 1250
Definition, 1035

Multi-key operation, 80
MultiLineEdit, 4032
Multiple instance, 1061

Correcting the call type, 1281, 1322
Multiple selection, 414, 2969, 3477
Multiple Spanning Tree, 729, 732
Multiplex, 1801, 2058, 2247
Multiplex/synchronous mode, 956
Multiplexing, 3197

Address multiplexing, 3190
Address multiplexing Allen-Bradley Ethernet IP, 
5334
with absolute addresses, 3190
with symbolic addresses, 3191

Multiply, 1688, 1941
Multi-point connection

Allen-Bradley DF1, 5345, 5346
MUX, 1801, 2058, 2247
My Documentation Manager, 255

N
N, 1599, 1602, 1851, 1853
N_TRIG, 1604, 1856
Name

Array element, 67
Names of alarm classes

Change through migration, 147
NAT/NAPT

Routing, 564
NeedleBorderColor property (VBS), 4418
NeedleColor property (VBS), 4418
NeedleFillStyle property (VBS), 4419
NEG, 1691, 1945
Negate, 1691, 1945
Negotiation, 706
Nesting depth, 1033
Network, 4909

Closing, 1266, 1308
Copying, 1265, 1307
Deleting, 1266, 1307
Entering a comment, 1268, 1310
Entering a title, 1267, 1309
Ethernet, 4935
Inserting, 1263, 1265, 1305, 1307
MPI, 4936
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Navigating blocks, 1269, 1311
Opening, 1266, 1308
PPI, 4937
PROFIBUS, 4935
PROFINET, 4935
Selecting, 1264, 1306
Using, 1263, 1305

Network access
Opening the properties, 6155

Network adapter, 613
Network architecture

PPI, 4937
Network comments

Hiding, 1228
Showing, 1228

Network drive, 38
Storing logs, 5641

Network editor
Components, 389, 4917
Function, 389, 4917
Hardware catalog, 403, 4931
Inspector window , 402, 4929

Network ID, 605
Network overview

Basic functions, 436
Basic functions for editing the network overview 
table, 436

Network Syslog, 587
Network view, 4938

Adding device, 419
Hardware and network editor, 391, 4919

Networking
Communication partners, 4938
Devices, 4938

Networking devices
Basics of configuring networks, 432
Editing interface parameters, 438
Editing network parameters, 438
Networking several interfaces at the same time, 
434
Networking with an existing subnet, 435
Networking without an existing subnet, 433
Networks within a project, 432
Requirements, 437
Types of communication, 432

Networking in the device view
Networking options, 436
Procedure, 437

New data types, 184
NextColumn, 4817
NextTrend, 4818
Nodes with an unknown IP address, 580

Non-integrated
Connection, 4943

Non-licensed mode
Engineering system, 99
ES, 85
HMI devices, 101
Runtime, 100

NORM_X, 1763, 2019, 2204
Normal range visible, 3160
Normalize, 1763, 2019, 2204
Normally closed contact, 1589
Normally open contact, 1588
NormalRangeColor property (VBS), 4420
NormalRangeVisible property (VBS), 4420
NOT, 1346, 1347, 1590
NOT_OK, 1681, 1934
NotifyUserAction, 3637, 3840, 5790
NTP, 742
NTP (secure), 570
NTP server, 570
NumberOfValues(i) property (VBS), 4421
Numerical

Screen keyboard, 5693
Numerical key assignment, 5699
Numerical value

Changing, 5694, 5701
Decimal places, 5694
Display format, 5693, 5701
Entering, 5694, 5701
Limit test, 5693, 5701

O
O, 6144
OB

Events and OBs, 848
Overview, 848

OB 1, 883
OB 80, 892
OB 82, 893
OB for manufacturer-specific interrupt, 888
OB for profile-specific interrupt, 888
OB 83, 895
object

Group, 2980
Paste, 2967, 3472
Rotate, 2963, 3481

Object
Arrange, 2953, 2962, 3475
Assigning to a layer, 3044
Availability for Basic Panels, 3077
Availability for Comfort Panels, 3080
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Availability for Mobile Panels, 3083
Availability for Multi Panels, 3081
Availability for Panels, 3078
Availability for WinCC Runtime Advanced, 3084
Creating a new OLE object, 2954
Creating an OLE object from a file, 2954
Deleting, 2956, 3471
Design, 2966
Dynamization, 3007
Dynamization of the appearance, 3014
Dynamize direct movement, 3017
editing within a group, 2984
Evenly distributing, 2961, 3480
Flashing, 2966
Flip, 2953
Flush alignment, 2960, 3480
Grouping, 2980
Inserting, 2953, 2954, 3469
Inserting of the same type, 2953
Inserting several times, 2967, 3472
Multiplying, 2967, 3472
outside the area, 2963
Referencing, 3554
Repositioning and resizing multiple objects, 2954, 
2971, 3479
Repositioning objects, 2957, 3473
Resize, 2959, 3476
Rotate, 2953, 2963, 3481
Select multiple objects, 2969, 3477
Selecting multiple objects, 2954
Storing in a library, 5500
Tab sequence, 2953

Object group
Animation, 3022, 3023
Editing an object within a group, 2984
Removing an object, 2983

Object list
Tag, 3174

Object names
Renaming upon migration, 127
Uniqueness, 127

Object properties
Dynamization, 3007

Object size
Harmonizing, 2959, 3477

ObjectName property (VBS), 4422
Objects

 Page number , 3493
Alarm report, 3489
Recipe report, 3492

Objects (VBS)
ActiveScreenItem, 4151

AlarmControl object, 3947
AlarmView, 3958
ApplicationWindow, 4080
Bar, 3962
Battery, 3967
BrowserView, 4019
Button, 3968
ChannelDiagnose, 3973
CheckBox, 3974
Circle, 3977
CircleSegment, 3979
CircularArc, 3982
Clock, 3984
Connector, 3986
DateTimeField, 3989
DiskSpaceView, 3991
Ellipse object, 3993
EllipseSegment, 3995
EllipticalArc, 3998
FunctionTrendControl, 4004
Gauge, 4008
GraphicIOField, 4011
GraphicView, 4014
Group object, 4017
HMIRuntime, 3903
IOField object, 4021
Line, 4025
Listbox, 4027
MultiLineEdit, 4032
OLEView object, 4035
OnlineTrend Control, 4045
OptionGroup, 4054
Polygon, 4057
Polyline, 4060
ProjectName object, 4062
ProtectedAreaName, 4064
RangeLabelView, 4065
RangeQualityView, 4067
Rectangle, 4074
RoundButton, 4074
Screen, 3905, 3930
Screen object (list), 3904
ScreenItem, 3906, 3932
ScreenItems (list), 3908, 3934
ScreenWindow, 4078
Slider, 4084
SmartClientView object, 4085
SmartTag, 3911, 3938
SmartTags (list), 3910, 3940
StatusForce, 4087
Switch, 4089
SymbolicIOField, 4093
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SymbolLibrary, 4098
SystemDiagnoseView, 4100
SystemDiagnoseWindow, 4104
TableView object, 4037
TextField, 4107
TrendRulerControl, 4110
TrendView, 4118
TubeArcObject, 4121
TubeDoubleTeeObject, 4123
TubePolyline, 4125
TubeTeeObject, 4128
UserArchiveControl object, 4130
UserView, 4137
WindowSlider, 4140
WLanQualityView, 4142
ZoneLabelView, 4143
ZoneQualityView, 4144

Objects in VBS
Alarm object, 3912

Objects:AlarmLogs, 3915
Objects:DataItem, 3916
Objects:DataLogs, 3918
Objects:HMIRuntime, 3922
Objects:Item, 3924
Objects:Layer, 3924
Objects:Logging, 3927
Objects:Tag, 3941
Obtaining user rights

Logging on to the operating system with 
administrator privileges, 245
With Windows user account control, 245

OCXState property (VBS), 4426
OF, 2216
Off delay, 1612, 1621, 1639, 1648, 1864, 1890, 1900, 
2102, 2122
Offline, 526

Recipe tag, 5656
OK, 1680, 1933
OLE object

create from a file, 2954
Recreate, 2954
Save in Graphics, 2977
Storing in the image browser , 5547

OLEView object, 4035
Omron, 5320

Analog alarm, 5441
Basic Panel, 4958
Comfort Panel, 4965
Communication drivers, 5425
Data type, 5440
Host Link, 5425
Mobile Panel, 4971

Multi Panel, 4969
Panel, 4961
Trend, 5440
WinCC Runtime, 4975

Omron Host Link, 5435
Address, 5436
Configuring a connection, 5426
Connection, 5426, 5430
Connection cable, 5430
Connection parameters, 5428
Data type, 5434

Omron Hostlink/Multilink
Migrating data types, 166

On delay, 1610, 1619, 1634, 1645, 1862, 1885, 1896, 
2099, 2117

Retentive, 1637, 1646, 1888, 1898, 2119
On demand, 3187
Ones complement, 1796, 2053
OneToOneView, 4818
Online, 526

Hardware detection, 421
Recipe tag, 3401, 5656

Online access, 6153
Online and Diagnostics view, 960
Online connection, 6144

Multiple TIA Portal instances, 43
Online diagnostics, 588
Online displays

Orange color, 969
Online mode, 6144

Canceling an online connection, 6148
Display of the online mode, 6145
Displaying accessible devices on an interface, 
6141
Displaying all accessible devices as a list, 6141
Go online, 6147
Standby or hibernation of the programming 
device / PC, 6144

Online operation, 35, 43
Online property (VBS), 4426
Online Tools, 960, 970
OnlineTrendControl, 4045
OP 177B mono

Symbol library, 3141
OP 73

Baud rate on PROFIBUS, 5034, 5113, 5194, 
5196, 5203, 5205, 5206

OP 77A
Baud rate on PROFIBUS, 5034, 5113, 5194, 
5196, 5203, 5205, 5206

OP 77A and TP 177A
Differences in the recipe, 3402
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OP73
Loading a project, 76

OP77A
Loading a project, 76

OPC, 5294, 5890
Accessing tags, 5901
Basic Panel, 4958
Basics, 5294
Comfort Panel, 4965
Communication, 5294
Compatibility, 5890
Configuring a connection, 5294
DCOM user rights, 5894
HMI device as OPC client, 5892
HMI device as OPC server, 5892
HTTP connection, 5891
Migrating data types, 167
Mobile Panel, 4971, 5891
Multi Panel, 4969, 5891
OPC XML DA Server, 5891
Panel, 4961
Permitted characters in tag names, 5901
Permitted data type, 5900
Specifications, 5890
WinCC Runtime, 4975

OPC DA
Data types, 5296

OPC DA server
Creating a connection, 5895
ProgID, 5891

OPC DA Server
Configuring HMI device as ~, 5893

OPC Gateway
Proxy setting, 5898

OPC server
Accessibility, 5891

OPC UA
Data types, 5297

OPC UA Server
Creating a connection, 5897

OPC XML
"Date/Time" data type, 5901
"STRING" data type, 5901
Configuring server, 5899
Permitted cycle time, 5901

OPC XML DA
Data types, 5297
Deleting a server, 5899
Editing a server, 5899

OPC XML DA Client, 5891
OPC XML DA Server

URL, 5891

Open
Global library, 5494
Selection list, 5698

Open a project, 260
Open log file

Packet filter events, 594, 596
Security events, 593, 595
System events, 593, 595

Open User Communication
 Changing parameter values, 494
Ability to read back, 495
Changing IP configuration parameters with 
T_CONFIG, 2914
Connection configuration, 473, 475
Connection description, 488, 491, 492
Connection establishment, 473
Connection parameters, 478
Creating a connection, 482
Deleting an interconnection, 485
Establishing a communication connection with 
TCON, 2877, 2880
Establishing a connection and reading data with 
TRCV_C, 2854, 2859
Establishing a connection and sending data with 
TSEND_C, 2843, 2847
General, 472
Instructions, 473
Port numbers, 494
Protocols used, 486
Receiving data via UDP with TURCV, 2904
Receiving data with TRCV, 2892, 2896
Sending data via UDP with TUSEND, 2901
Sending data with TSEND, 2886, 2889
Starting connection parameter assignment, 481
TCON_IP_RFC, 492
TCON_IP_v4, 491
TCON_Param, 488
Terminating a communications connection with 
TDISCON, 2884
TSAP, 496

OpenAllLogs, 3682, 3842
OpenCommandPrompt, 3685, 3842
OpenControlPanel, 3687
OpenControlPanelDialog, 3684, 3843
OpenFileBrowser, 3683
Opening a force table, 1529
Opening a watch table, 1504
Opening for the first time, 35
Opening phone books, 6213
OpenInternetExplorer, 3686, 3844
OpenScreenKeyboard, 3683, 3845
OpenTaskManager, 3688, 3845
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Operability
Dynamization, 3018

Operand, 1049, 1051, 1052, 1057, 1058, 1059, 1061, 
1062, 1064, 1065, 1076

Inserting, 1292, 1333
Operand area, 843
Operate recipe

Change recipe data record, 3446
Operating

Key, 5700
Runtime using the keyboard, 5704
Runtime with mouse, 5705

Operating behavior
Enabling system memory, 876
Using clock memory, 877
Using time-of-day functions, 862

Operating element
Availability for Basic Panels, 3077
Availability for Comfort Panels, 3080
Availability for Mobile Panels, 3083
Availability for Multi Panels, 3081
Availability for Panels, 3078
Availability for WinCC Runtime Advanced, 3084
operation, 5698
Recipe view, 3443, 5659

Operating mode, 613
  , 5240
Introduction, 834
RUN, 840
STARTUP, 836
STOP, 840
Transitions, 835

Operating recipes
Change recipe data record, 3446
Copying a recipe data record, 3445
Creating a recipe data record, 3440
Creating recipe data records, 3440, 3441, 3445
Delete recipe data record, 3446
Load recipe data record, 3446
Modifying the recipe structure, 3450
Read recipe data record, 3441, 3447
Transfer data record, 3442, 3448

Operating system
Asian language setting, 5533
Setting to Western, 5533

Operating system , 1019
operation

Key, 5697
Operating element, 5698

Operation
Alarm indicator, 3331
Alarm view, 3326, 5683

Alarm window, 3326, 5683
Feedback, 5690
Recipe view, 3443, 5659
Simple alarm view, 3329, 5685
Simple recipe view, 3436, 5672
Simple user view, 5710

Operation feedback, 5690
Operation in runtime

Multi-key operation, 80
Operation using the keyboard

Alarm view, 3327
Alarm window, 3327
Simple alarm view, 3330

Operation using the mouse
Alarm indicator, 3332
Alarm view, 3327
Alarm window, 3327
Simple alarm view, 3330

Operation with the keyboard
Recipe view, 3444, 5660

Operation with the mouse
Recipe view, 3444, 5660

OperationSteps property (VBS), 4427
Operator input in the recipe view

Transferring data, 5095, 5176, 5216, 5455
OperatorMessageID property (VBS), 4428
OperatorMessageIndex property (VBS), 4428
OperatorMessageName property (VBS), 4429
OperatorMessageNumber property (VBS), 4430
OperatorMessageSelected property (VBS), 4430
OperatorMessageSource1 property (VBS), 4430
OperatorMessageSource10 property (VBS), 4435
OperatorMessageSource2 property (VBS), 4431
OperatorMessageSource3 property (VBS), 4431
OperatorMessageSource4 property (VBS), 4432
OperatorMessageSource5 property (VBS), 4432
OperatorMessageSource6 property (VBS), 4433
OperatorMessageSource7 property (VBS), 4434
OperatorMessageSource8 property (VBS), 4434
OperatorMessageSource9 property (VBS), 4435
OperatorMessageType1 property (VBS), 4435
OperatorMessageType10 property (VBS), 4440
OperatorMessageType2 property (VBS), 4436
OperatorMessageType3 property (VBS), 4436
OperatorMessageType4 property (VBS), 4437
OperatorMessageType5 property (VBS), 4437
OperatorMessageType6 property (VBS), 4438
OperatorMessageType7 property (VBS), 4438
OperatorMessageType8 property (VBS), 4439
OperatorMessageType9 property (VBS), 4439
Optical feedback, 5690
Optimized access, 1027, 1029
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Optimized block access, 183
Optimizing the configuration

Allen-Bradley DF1, 5337, 5354, 5375, 5386, 5405, 
5417, 5437

Option
Installing, 5632
Uninstalling, 5632

Option handling, 788, 791, (See Configuration control 
(ET 200SP))
OptionGroup object, 4054
OR, 1347, 1793, 1837, 1838, 2050
Organization block (OB)

Assigning event with ATTACH, 2441
Canceling event assignment with DETACH, 2442
Creating, 1197
Cyclic interrupt OB, querying parameters with 
QRY_CINT, 2445
Cyclic interrupt OB, setting parameters with 
SET_CINT, 2443
exporting to an external source file, 1420
Function, 1022
Reading start information with RD_SINFO, 2475
Start information, 1022

Orientation property (VBS), 4440
OSPF

Area range, 758
Areas, 757
Configuration, 756
Interfaces, 759
Virtual Links, 761

Other PLCs
Addressing, 5321
Data types, 5321
Special features, 5321

OUT_RANGE, 1679, 1932
Outgoing, 3252, 3791
Output

Inserting, 1289, 1329
remove, 1290, 1330

Output (O), 843
Output byte (QB), 843
Output double word (QD), 843
Output fields

Multiplex tag, 68
Output word (QW), 843
Overflow, 927, 935, 3795
Overlay icon, 967
Overlaying

Tag, 1065
Overlaying tags, 1249
Override function, 3156

Overview
using the display formats in the force table, 1533
via the display formats in the watch table, 1509

Overview navigation, 392, 395, 398, 4920, 4926, 
4928
Overview of the cross-reference list, 1488
Overview of TS Adapters that can be used, 6220
Overview window, 56, 226

Comparing objects, 228
Display all blocks, 229
Showing and hiding columns, 229
Sorting details view, 229

P
P, 1598, 1601, 1850, 1852
P_TRIG, 1603, 1854
Pack&Go file, 5607
Packet filter log, 594, 596
Page

 Deleting report page, 3468
 Sorting report page, 3468
Adding to report, 3467
Maximum number of configurable in report, 3465

Page number
Layout in reports, 3493

PageDown, 3704, 3846
PageMode property (VBS), 4442
PageModeMessageNumber property (VBS), 4442
PageUp, 3705, 3846
Pane mode, 223
Panel

Area pointer, 4964
Communication drivers, 4961
Display and operating element, 3078
HTTP protocol, 4961
Interface, 4963
Mitsubishi, 4961
Modicon Modbus, 4961
Omron, 4961
OPC, 4961
S7 1200, 4961
S7 200, 4961
S7 300, 4961
S7 400, 4961

Panels
Available system functions, 3590

Panning, (See move view)
Parallel communication

Communication drivers, 4977, 5321
Parameter

For CPU, 856
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Hidden parameters, 1294, 1334
Predefined - writing with WR_DPARM, 2439
SIMATIC LOGO!, 5230

Parameter assignment, 1038
Parameter transfer, 1037, 1039, 1041, 1043, 1045, 
1046, 1047, 1048

User-defined function, 3556
Parameter types, 1117
Parameters

Client, 5283
Connection, 5325, 5339, 5365, 5378, 5396, 5408, 
5428
MPI, 5160, 5162, 5163
PROFIBUS, 5004, 5006, 5007, 5075, 5077, 5078, 
5147, 5149, 5150
S7 1200, 5110
S7 1500, 5033
S7 200, 5191, 5196, 5200, 5205, 5206
Tags, 5286

Parent property (VBS), 4443
Password, 5706

Backing up, 5707
Changing, 3509
Changing in runtime, 3522
For CPU access protection, 856
for function key, 3036
Hierarchy level, 3501, 3503
HMI connection, 4992, 5009, 5063, 5081
Password aging, 3502
Password complexity, 3502, 3504
Restoring, 5707
SmartServer, 5826

Password legitimation, 1778, 2035, 2228
Password list, 5706
Password property (VBS), 4445
Password protection, 644, 856, 878, 879

Protection concept, 298
Revoking access rights, 299

PasteRows, 4819
Pasting

Adjusting screen size, 5577
Color, 5576
Font, 5576
Function key, 5577
Invalid object, 5576
Principle, 5574

PC
HMI connection, 4983, 5001, 5053, 5073, 5126, 
5143, 5158
S7 1500, 4983
S7 300/400, 5126
WinCC RT Professional, 4983, 5001

WinCC RT Advanced, 4983, 5001
PC CP, 525
PE_CMD, 2397
PE_DS3_Write_ET200S, 2402
PE_End_RSP, 2421
PE_Error_RSP, 2419
PE_Get_Mode_RSP, 2424
PE_I_DEV, 2415
PE_List_Modes_RSP, 2423
PE_Measurement_List_RSP, 2429
PE_Measurement_Value_RSP, 2430
PE_PEM_Status_RSP, 2426
PE_Start_End, 2393
PE_Start_RSP, 2420
PEEK, 2177

Read memory address, 2177
PEEK_BOOL, 2179

Read memory bit, 2179
Perfect Forward Secrecy, 578
Performance, 183
Performance features

Engineering system, 5725
HMI device, 5727, 5730, 5734, 5739, 5742, 5747
WinCC Runtime, 5747

Permanent connection, 675
Permanent station, 675
Permanent window, 2945
Permit access with PUT/GET communication from 
remote partners, 882
Permitted characters

User view, 77
Permitted data type

OPC, 5900
SIMATIC HMI HTTP Protocol, 5855

Permitted data types
Trends, 5025, 5101, 5182, 5224, 5236

Permitted operands for the force table, 1531
Permitted operands for the watch table, 1506
PersistentRTAuthorization property (VBS), 4446
PersistentRTCSAuthorization property (VBS), 4446
PersistentRuntime property (VBS), 4447
PersistentRuntimeAuthorization property (VBS), 
4448
PersistentToDownload property (VBS), 4448
PersistentToDownloadAuthorization property (VBS), 
4449
PG/PC interface

Go online, 6147
Modifiable MPI interface parameters, 6161
Modifiable PROFIBUS interface parameters, 
6161

Picture property (VBS), 4451
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PictureDeactivated property (VBS), 4452
PictureOff property (VBS), 4453
PictureOn property (VBS), 4453
PID_3Step

In/out parameters, 2650
Input parameters, 2646, 2677
Instruction, 2637, 2669
Output parameters, 2648, 2678
Static tags, 2679

PID_Compact
 Input parameters, 2599, 2621
In/out parameters, 2601
Instruction, 2618
Output parameters, 2600
Static tags, 2602, 2623

Pin assignment
6XV1440 - 2P for Mitsubishi PG protocol, 5381
Allen-Bradley, 5346
Allen-Bradley cable 1747-CP3, 5348
Allen-Bradley cable 1761-CBL-PM02, 5349
Allen-Bradley cable 1784-CP10, 5347
Multipoint cable 1:MP/TP/PC, 5432
Multipoint cable 2:RS422, MP/TP/PC, 5433
Point-to-point cable 1, 
Point-to-point cable 2, 5414
Point-to-point cable PP1 for Omron, 5433
Point-to-point cable PP2 for Omron, 5434

PLC
Connecting, 5327, 5367, 5380, 5399, 5430
Enabling system diagnostics, 3379
MPI parameters, 5163
PROFIBUS parameters, 5007, 5078, 5150
PROFINET parameters, 4990, 5058, 5132
Reading recipe data record, 5668, 5669, 5678
System diagnostics view, 3379
Tag, 3190
Transferring recipe data record, 5670, 5671, 
5677

PLC data type
Addressing, 1063
Comparing, 1437
Creating, 1411
Declaration in data blocks, 1392
Declaration in the block interface, 1248
Declaration table for PLC data types, 1410
Declaring, 1414
Declaring ARRAY, 1412
Declaring STRUCT, 1413
Definition, 1118, 1409
Deleting, 1411
Offline/offline comparison, 1427

PLC data types generated by the system in 
libraries, 49
Programming the structure, 1412
Tag properties, 1415

PLC data types, 184
PLC tag

 Importing and exporting, 1549, 1550, 1551
Automatically filling in cells, 1195
Comparing, 1435
Comparing a PLC tag table, 1427
Comparison, 1423
Copying, 1193
Declaring, 1180, 1181, 1184, 1186
Definition, 1050
Monitor, 1192
Offline/offline comparison, 1427
Permissible addresses and data types, 1178
PLC tag table, 1172, 1173, 1179, 1180
Properties, 1189, 1190
reconnecting, 3182
Retentive behavior, 1182, 1183
Rules, 1178
Sorting rows, 1194
Updating comparison results, 294

PLC tags, 652, 653, 655
PLC5, 5352
PN/PN couplers

Grouping, 824
Linking Ethernet subnets, 824

Pointer
ANY, 1113
POINTER, 1111
VARIANT, 1115

POINTER, 1111
Pointer name

Area pointer, 4954
PointerColor property (VBS), 4455
PointsCount property (VBS), 4456
Point-to-point communication (PtP), 868

Freeport protocol, 868
Point-to-point connection

Allen-Bradley DF1, 5344
Configuring communication parameters with 
PORT_CFG, 2744
Configuring receive parameters with RCV_CFG, 
2749
Configuring serial transmission parameters with 
SEND_CFG, 2747
Deleting receive buffer with RCV_RST, 2759
Enable receiving with RCV_PTP, 2757
Initiating data transfer with SEND_PTP, 2755
Querying the signal state with SGN_GET, 2759
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Setting output signals with SGN_SET, 2760
POKE, 2181

Write memory address, 2181
POKE_BLK, 2184

Write memory area, 2184
POKE_BOOL, 2183

Write memory bit, 2183
Polygon, 3121

Configuring corners, 3121
Layout, 3121
Radii, 3121

Polygon object, 4057
Polyline, 3123

Configuring corners, 3123
Line end, 3123
Line start, 3123
Radii, 3123

Polyline object, 4060
Port

102 (S7 protocol - TCP), 547
123 (NTP), 565, 569
161 (SNMP), 565
20/21 (FTP), 547
443 (HTTPS), 565
4500 (IPsec), 565
500 (IPsec), 565
500 (ISAKMP - UDP), 586
514 (Syslog), 565
80 (HTTP), 547
8448 (security diagnostics), 628
Configuration, 707
Interconnecting, 813
Port configuration, 706, 708
Renaming, 521

Port configuration, 708
Port numbers, 494
Port options, 818, 4995, 5065, 5137

Enable autonegation, 817, 4994, 5064, 5136
Monitor, 817, 4994, 5064, 5136
Transmission medium/duplex, 816
Transmission rate / duplex, 4994, 5064, 5136

PORT_CFG, 2744
Portal view, 204
Position

Editing multiple objects, 2971, 3479
Of objects, 2957, 3473
of objects in the report, 3465

Possible cause of error
Transferring data, 5022, 5098, 5179, 5219, 5458

Power budget, 941
Power Management, 4890
Powerpack, 104, 105

Engineering system, 104
Installing, 105
Runtime, 104

PPI, 4934
Network, 4937
Network architecture, 4937
S7 200, 5206

Precision property (VBS), 4457
Predefined alarm classes, 3254, 3255
Predefined firewall rules

CP 1543-1, 628
CP 1628, 617
CP x43-1 Adv., 615
SCALANCE S, 601, 602

Premium, 5403
Prerequisites for establishing a VPN connection, 
6249
Preshared keys, 576
Press, 3790
Press ESC twice, 3790
Press key, 3794
PressButton, 3698
Pressed property (VBS), 4457
PreviousColumn, 4819
PreviousTrend, 4820
Print, 4820
Print alarm

Configuring print parameters, 5773
Print scope, 301
Print server, 5751
Printable contents, 301
PrintConfiguration property (VBS), 4458
Printing

Alarms, 5644
Audit Trail, 5770
Changing the settings, 302
Creating a cover page, 307
Creating frames, 306
Documentation settings, 299
Elements in the library, 305
Elements in the project tree, 305
Non-printable contents, 301
Non-printable objects, 302
Print contents, 304
Print server, 5751
Printing device view, 399
Printing network view, 399
Process a cover page, 308
Process borders, 308
Report, 3468, 3484
Runtime, 5644
Screen, 5644
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Specify layout, 303
Specify print layout, 303
Specifying the print area, 312
Structure of printout, 300
Use borders, 305
Use borders and cover pages, 300
Use cover page, 303

Printing a project, 318
Printing labels, 321

Determining the correction value for the print shift, 
323

Printing of alarms
Configuring:printing of alarms, 3283

PrintJobName property (VBS), 4458
PrintReport, 3637, 3847
PrintScreen, 3636, 3847
PrintVisibleColumnsOnly property (VBS), 4459
Priorities

Local error handling, 1381
Process control phase, 5637
Process data area

Module addressing, 847
Module start address, 847

Process image, 848
Basics, 845
I/O access error, 846
Reading inputs with GETIO, 2325
Reading the process image area with 
GETIO_PART, 2326
Synchronizing the inputs with SYNC_PI, 2318
Synchronizing the outputs with SYNC_PO, 2319
Transferring the process image area with 
SETIO_PART, 2327
Updating, 846
Updating inputs with UPDAT_PI, 2315
Updating the outputs with UPDAT_PO, 2316
Writing outputs with SETIO, 2325

Process value logging, 3215
ProcessValue

Assigning SmartTags, 4461
Processvalue property (VBS), 4459
ProcessValue property (VBS), 4461
Product support, 405, 4933

Enabling, 405
PROFIBUS, 444, 4934, 5080, 5152

Connection with PROFINET, 796
ET 200S in DPV1 mode, 792
HMI connection, 4998, 5001, 5002, 5068, 5071, 
5073, 5140, 5143
Network, 4935
OP 73, 5034, 5113, 5194, 5196, 5203, 5205, 
5206

OP 77A, 5034, 5113, 5194, 5196, 5203, 5205, 
5206
Parameters, 5004, 5006, 5007, 5034, 5075, 5077, 
5078, 5113, 5147, 5149, 5150, 5194, 5203
S7 1200, 5067, 5068, 5069, 5071, 5073
S7 1500, 4997, 4999, 5001, 5002
S7 300/400, 4998, 5139, 5140, 5141, 5143
Standard, 5080, 5152
Universal, 5080, 5152
WinCC RT Advanced, 4999, 5069, 5141
WinCC RT Professional, 4999

PROFIBUS cable configuration
Optical ring, 446

PROFIBUS communication
S7 1200, 5067, 5069
S7 1500, 4997, 4999
S7 300/400, 5139, 5141

PROFIBUS DP, 774, 4935
Configuring the Control Panel, 5469
Connection, 5031, 5187
Direct key, 5261

PROFIBUS parameters
S7 1200, 5075, 5077, 5078
S7 1500, 5004, 5006, 5007
S7 300/400, 5147, 5149, 5150

PROFIBUS profile, 444, 5080, 5152
Different profiles on the same subnet, 444, 5080, 
5152
Effect on the transmission rate, 444, 5080, 5152
Meaning of profiles, 445, 5080, 5152

PROFIBUS DP
DirectKey, 3635
Network configuration, 5474

PROFIenergy
Control PROFIenergy commands in the I-Device, 
2415
Description, 2391
Generate answer to command at end of pause, 
2421
Generate answer to command at start of pause, 
2420
Generate list of supported measured values as 
answer, 2429
Generate negative answer to command, 2419
Generate PEM status as response, 2426
Generate queried energy data as response, 2424
Generate queried energy savings modes as 
answer, 2423
Generate queried measured values as answer, 
2430
Generate supported PROFIenergy commands as 
answer, 2427
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PE_CMD, 2397
PE_DS3_Write_ET200S, 2402
PE_End_RSP, 2421
PE_Error_RSP, 2419
PE_Get_Mode_RSP, 2424
PE_I_DEV, 2415
PE_Identify_RSP, 2427
PE_List_Modes_RSP, 2423
PE_Measurement_List_RSP, 2429
PE_Measurement_Value_RSP, 2430
PE_PEM_Status_RSP, 2426
PE_Start_End, 2393
PE_Start_RSP, 2420
Reading out status information, 2397
Set power module switching behavior, 2402
Start and exit energy-saving mode, 2393, 2397

Profile, (See bus profile)
Profiles, 888
PROFINET, 609, 4934, 5305, 5315, 5318

Connection, 5030, 5186
Connection with PROFIBUS, 796
Device replacement without exchangeable 
medium, 819
HMI connection, 4979, 4980, 4981, 4983, 4986, 
5046, 5047, 5049, 5051, 5119, 5120, 5122, 5124, 
5126
S7 1200, 5046, 5049
S7 1500, 4979, 4981
S7 300/400, 5119, 5122

PROFINET address, 534
PROFINET device name, 805
PROFINET interface, 808, 856, 973
PROFINET IO, 795, 800, 801, 810, 811, 5303

Port options, 816, 4994, 5064, 5136
PROFINET IO device

Assigning a name, 997
Name assignment from within the project context, 
998
Name assignment via "Accessible devices", 998

PROFINET IO devices
Reading a portion of the inputs with 
GETIO_PART, 2326
Reading consistent data with DPRD_DAT, 2363
Writing a part of the outputs with SETIO_PART, 
2327
Writing all outputs with SETIO, 2325
Writing consistent data with DPWR_DAT, 2365

PROFINET IO system, 811
PROFINET parameters

HMI connection, 4987, 5055, 5128
HMI device, 4989, 5057, 5130
PLC, 4990, 5058, 5132

S7 1200, 5055, 5058
S7 1500, 4987, 4989, 4990
S7 300/400, 5128, 5130, 5132

PROFINET RT class, 796, 5305
PROFIsafe address, 4889
Program alarm

generating with Program_Alarm, 2470
Program control operations, 1783, 2040, 2233
Program cycle OB

Description, 883
Program editor

"Instructions" task card, 1221
Block interface, 1221
Enlarging the programming window, 1227
Favorites, 1221
Function, 1219
General settings, 199, 201, 202, 1238
Programming window, 1221
Structure, 1220
Testing task card, 1221
Toolbar, 1221
Using the keyboard, 1223

Program execution
Cyclic, 883

Program information
Displaying, 1461
In the assignment list, 1462
In the call structure, 1470
In the dependency structure, 1476
in the tab , 1481
Views, 1461

Program resources, 1196
Program status

Editing blocks, 1494
FBD, 1497
Function, 1492
LAD, 1496
Modify tag, 1495
SCL, 1498
Switching off, 1493
Switching on, 1493

Program_Alarm, 2470
Programming

Linear, 1020
Structured, 1020

Programming error, 49
Programming language

Changeover, 1378
FBD, 1302
LAD, 1259
Rules for changing, 1377
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Programming window
Customizing, 1352
SCL, 1351

Project
Basics, 257
Carrying out an online/offline comparison, 287
Carrying out offline/offline comparisons, 287
Closing, 265
Comparing data, 43, 286
compile (overview), 5597
Compiling , 5599
Compiling project data, 281
Creating, 259
Deleting, 265
Detailed comparison, 294
Download, 5604, 5606, 5637
download (overview), 5597
Harmonizing, 383
Migrating, 130, 158
multilingual, 5537
Multiple connections, 5015, 5089, 5170, 5213
Saving, 264
Showing properties, 264
Simulation with a tag simulator, 5617
Upgrade, 5586

Project archives, 274
Project data

Compiling, 281
Downloading to a memory card, 283
Export alarm, 5510
Export text list, 5523
Exporting a recipe, 5506
Exporting tag, 5517
Importing alarms, 5511
Information on compiling, 280
Information on loading, 281
Loading, 282
Uploading from a device, 284

Project ID, 4916
Project language, 266, 5531

Activate, 5535
Disabling, 5535

Project languages
Changing the editing language, 269
Specifying project languages, 268
System texts, 5538
Use, 266
User texts, 5538

Project library, 56, 338, 5486
Adding types, 365
Assigning a common version to types, 373
Cleaning up, 384

Creating folders, 357
Discarding the type version, 371
Migrating, 152
Performing a consistency check for a type version, 
370
Release the type version, 371
Updating the project, 375
Using filter view, 359
Using the element view, 342
Using types, 366

Project text
Exporting, 5542

Project texts
Application example, 273
Changing the text of selected objects, 270
Displaying reference text, 270, 5541
Exporting all texts, 272
Exporting individual texts, 271
Importing, 272, 5544
Migrating, 150
Translating individual texts, 3064, 5539
Translating project texts, 269
Translation into project languages, 266, 5538

Project tree
Adding device, 419
Function, 208
Hiding, 1227
Reducing automatically, 214
Showing, 1227

Project version
Upgrade, 5586

Project view, 205
ProjectName object, 4062
ProjectPath property (VBS), 4462
Project-wide alarm class

Create, 3265
Use, 3265

Properties (CPU), 856
Properties (VBS)

 RotationCenterLeft, 4471
 TrendWindowRulerLayer , 4658
AboveUpperLimitColor, 4145
AcceptOnExit, 4146
AcceptOnFull, 4146
AccessPath, 4147
ActiveProject, 4149
ActiveScreen, 4149, 4150
ActualPointIndex, 4152
ActualPointLeft, 4152
ActualPointTop, 4153
AdaptBorder, 4154
AdaptFontSizeToLineHeight, 4154
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AdaptPicture, 4155
AdaptScreenToWindow, 4155
AdaptSize, 4155
AdaptWindowToScreen, 4155
Address, 4156
AdjustBorder3DWithStyle, 4156
AdjustRulerWindow, 4157
Alarm, 4157
AlarmColor, 4158
AlarmFilter, 4158
AlarmHigh, 4159
AlarmID, 4159
AlarmLow, 4160
AlarmLowerLimit, 4161
AlarmLowerLimitColor, 4161
AlarmLowerLimitEnabled, 4162
AlarmLowerLimitRelative, 4162
AlarmUpperLimit, 4163
AlarmUpperLimitColor, 4164
AlarmUpperLimitEnabled, 4164
AlarmUpperLimitRelative, 4165
Alignment, 4165
AlignmentLeft, 4166
AlignmentTop, 4166
AllowMenu, 4167
AllowPersistence, 4167
Analog, 4168
AngleMax, 4168
AngleMin, 4169
ApplyProjectSettings, 4170
AskOperationMotive, 4171
Assignments, 4171
AssumeOnExit, 4172
AssumeOnFull, 4172
Authorization, 4173
AutoCompleteColumns, 4175
AutoCompleteRows, 4175
AutoScroll, 4176
AutoSelectionColors, 4176
AutoSelectionRectColors , 4177
Average, 4178
BackColor, 4179, 4181
BackColorBottom, 4182
BackColorTop, 4182
BackFillStyle, 4183, 4184
BackFillStyleReadOnlySpecial, 4185
BackFlashingColorOff, 4186
BackFlashingColorOn, 4186
BackFlashingEnabled, 4187
BackFlashingRate, 4188
BackPictureAlignment, 4452
BackPictureName, 4453

BarBackColor, 4189
BarBackFillStyle, 4189
BarColor, 4191
BarStartValue, 4192
BaseScreenName, 4193
BeginTime(i), 4194
BelowLowerLimitColor, 4194
BitNumber, 4195
BlinkColor, 4195
BlinkMode, 4196
BlinkSpeed, 4197
BorderBackColor, 4197
BorderBrightColor3D, 4198, 4199
BorderColor, 4200, 4201
BorderEndStyle, 4203
BorderFlashingColorOff, 4204
BorderFlashingColorOn, 4205
BorderFlashingEnable, 4206
BorderFlashingRate, 4207
BorderInnerStyle3D, 4208
BorderInnerWidth3D, 4208
BorderOuterStyle3D, 4209
BorderOuterWidth3D, 4209
BorderShadeColor3D, 4210, 4211
BorderStyle, 4211
BorderStyle3D, 4213
BorderWidth, 4214, 4215, 4368
BorderWidth3D, 4216
ButtonCommand, 4218
Caption, 4219, 4220
CaptionBackColor, 4220
CaptionColor, 4221, 4222
CaptionText, 4222
CaptionTop, 4223
CellCut , 4223
CellSpaceBottom, 4224
CellSpaceLeft, 4225
CellSpaceRight, 4225
CellSpaceTop, 4226
CenterColor, 4226
CenterSize, 4227
CentrePoint, 4227
CentrePointLeft, 4228
CentrePointTop, 4228
ChangeMouseCursor, 4229
CheckMarkAlignment, 4231
CheckMarkCount, 4231
ClearOnError, 4232
ClearOnFocus, 4233
Closable, 4234
Color, 4234, 4235
ColorChangeHysteresis, 4236
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ColorChangeHysteresisEnabled, 4237
ColumnColor(i), 4239
ColumnDisplayName(i), 4240
ColumnResize, 4240
ColumnScrollbar, 4242
ColumnSizingEnable, 4241
ColumnTitle, 4243
ColumnTitleAlign, 4242
ColumnUpdateEnabled(i), 4243
comma,EdgeStyle, 4272
Command, 4244
CommonTimeAxisColor, 4245
ConfigureTimeAxis(i), 4245
ConnectionType, 4246
ConnectTrendWindows, 4246
ContinousChange, 4247
CornerStyle, 4248
Count, 4249
CountDivisions, 4250
CountSubDivisions, 4250
CountValueColumns, 4251
CountVisibleItems, 4251
CurrentColumnIndex, 4252
CurrentCurveIndex, 4253
CursorControl, 4254
CurveColor(i), 4254
CurveLineWidth(i) , 4255
CurvesCount, 4255
CurveUpdateEnabled(i), 4256
DangerRangeColor, 4257
DangerRangeStart, 4257
DangerRangeVisible, 4258
DataIndex(i), 4259
DataLogTag, 4260
DataX(i), 4261
DataXY(i), 4261
DataY(i), 4262
DeleteDate(i), 4262
DeleteEnable, 4263
DialColor, 4263
DialFillStyle, 4264
DialSize, 4265
Direction , 4265
DisplayName(i), 4266
DisplayOptions, 4266
DoubleClickAction, 4267
DrawAlwaysInsideFrame, 4267
DrawEnhancedHTMLBrowser, 4268
DrawInsideFrame, 4268
DrawStylishButton, 4270
Drive, 4270
EdgeStyle, 4271

Editable(i), 4273
EditEnabled, 4274
EditOnFocus, 4274
Enabled, 4275, 4277
EndAngle, 4278
EndPoint, 4279
EndPointLeft, 4279
EndPointTop, 4280
EndStyle, 4281
EndTime(i), 4282
ExportDirectoryChangeable , 4284
ExportDirectoryname, 4284
ExportFileExtension, 4285
ExportFilename, 4286
ExportFilenameChangeable , 4286
ExportFormatGuid, 4287
ExportFormatName, 4287
ExportParameters, 4288
ExportSelection, 4288
ExportShowDialog, 4289
ExtraSpaceForLabelDisplay, 4291
FieldLengthReadOnlySpecial, 4291
FillColorMode, 4293
FillPatternColor, 4294
FillStyle, 4295
Filter, 4296
FirstConnectedObjectIndex, 4296
FirstConnectedObjectName, 4297
FixedAspectRatio, 4297
FlashingColorOff, 4298
FlashingColorOn, 4300
FlashingEnable, 4301
FlashingRate, 4302
FlashTransparentColor, 4305
Flip, 4306
FocusColor, 4306, 4307
FocusWidth, 4308
Font , 4309
FontBold, 4311
FontItalic, 4312
FontName, 4313
FontSize, 4314
FontUnderline, 4315
ForeColor, 4316, 4317
FormatPattern, 4318
FormatPatternReadOnlySpecial, 4319
FormatType, 4319
Free, 4320
FreePercent, 4320
FreezeProviderConnections, 4321
GetSelectionText, 4321
GlobalColorScheme, 4672
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GlobalShadow, 4674
Gradation, 4321
GraphDirection, 4322
GridBackColor, 4323
GridlineColor, 4323
GridLineWidth, 4324
Height, 4325
Help text, 4328
HelpText, 4328
HiddenInput, 4329
HideTagNames, 4329
HighLimitColor, 4330
HitlistColumnAdd, 4330
HitlistColumnCount, 4331
HitlistColumnIndex, 4331
HitlistColumnName , 4332
HitlistColumnRemove , 4332
HitlistColumnRepos, 4332, 4409
HitlistColumnSort, 4333
HitlistColumnSortIndex, 4333
HitlistColumnVisible, 4334, 4410
HitlistDefaultSort, 4334
HitlistMaxSourceItems, 4335
HitlistMaxSourceItemsWarning, 4335
HitlistRelativeTimeFactor, 4336
HitlistRelativeTimeFactorType, 4336
HitlistRelTime, 4337
HorizontalAlignment, 4338, 4339
HorizontalGridLines, 4339
HourNeedleHeight, 4340
HourNeedleWidth, 4341
IconSpace, 4342
Index, 4342
InnerBackColorOff, 4343
InnerBackColorOn, 4344
InsertData(i), 4345
InsertEnable, 4345
IntegerDigits, 4346
Interval, 4346
ItemBorderStyle, 4347
JumpToLimitsAfterMouseClick, 4348
LabelColor, 4348
Language, 4349
LargeTicksBold, 4350
LargeTicksSize, 4350
LastConnectedObjectIndex, 4351
LastConnectedObjectName, 4351
LeaveMarginForBorder, 4363
LeaveMarginForMarkers, 4364
Left, 4364
Limit4LowerLimit, 4367
Limit4LowerLimitRelative, 4369

Limit4LowrLimitColor , 4368
Limit4UpperLimit, 4369
Limit4UpperLimitColor, 4370
Limit4UpperLimitEnabled, 4371
Limit4UpperLimitRelative, 4371
Limit5LowerLimit, 4372
Limit5LowerLimitColor, 4372
Limit5LowerLimitEnabled, 4373
Limit5LowerLimitRelative, 4374
Limit5UpperLimit, 4374
Limit5UpperLimitColor, 4375
Limit5UpperLimitEnabled, 4375
Limit5UpperLimitRelative, 4376
LineWidth, 4379, 4380
LoadDataImmediately, 4381
LocalCursor, 4382
Localizable, 4382
LockSquaredExtent, 4383
LogOperation, 4384
LowerLimit, 4386
LowerLimitColor(i), 4386
LowerLimitValue(i), 4387
LowLimitColor, 4388
MachineName , 4389
MarginToBorder, 4389
MaximumValue, 4390, 4391
MessageBlockAlign , 4395
MessageBlockAutoPrecisions, 4395
MessageBlockCaption, 4396
MessageBlockCount, 4396, 4400
MessageBlockDateFormat, 4397
MessageBlockExponentialFormat, 4397
MessageBlockFlashOn, 4398
MessageBlockHideText, 4398
MessageBlockHideTitleText, 4399
MessageBlockID, 4399
MessageBlockLeadingZeros, 4400
MessageBlockLength, 4401
MessageBlockName, 4401
MessageBlockPrecisions, 4402
MessageBlockSelected, 4402
MessageBlockShowDate, 4403
MessageBlockShowIcon, 4403
MessageBlockShowTitleIcon, 4404
MessageBlockTextId, 4404
MessageBlockTimeFormat, 4405
MessageBlockType, 4405
MessageColumnAdd, 4406
MessageColumnCount, 4407
MessageColumnIndex, 4407
MessageColumnName , 4408
MessageColumnRemove, 4408
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MessageColumnRepos, 4332, 4409
MessageColumnSort, 4409
MessageColumnSortIndex, 4410
MessageColumnVisible, 4334, 4410
MessageListType, 4410
MinimumValue, 4411, 4412
MinuteNeedleHeight, 4412
MinuteNeedleWidth, 4413
Mode, 4413
Movable, 4414
MsgFilterSQL, 4415
NeedleBorderColor, 4418
NeedleColor, 4418
NeedleFillStyle, 4419
NormalRangeColor, 4420
NormalRangeVisible, 4420
NumberOfValues(i), 4421
ObjectName, 4422
Online, 4426
OperationSteps, 4427
OperatorMessageID, 4428
OperatorMessageIndex, 4428
OperatorMessageName, 4429
OperatorMessageNumber, 4430
OperatorMessageSelected, 4430
OperatorMessageSource1, 4430
OperatorMessageSource10, 4435
OperatorMessageSource2, 4431
OperatorMessageSource3, 4431
OperatorMessageSource4, 4432
OperatorMessageSource5, 4432
OperatorMessageSource6, 4433
OperatorMessageSource7, 4434
OperatorMessageSource8, 4434
OperatorMessageSource9, 4435
OperatorMessageType1, 4435
OperatorMessageType10, 4440
OperatorMessageType2, 4436
OperatorMessageType3, 4436
OperatorMessageType4, 4437
OperatorMessageType5, 4437
OperatorMessageType6, 4438
OperatorMessageType7, 4438
OperatorMessageType8, 4439
OperatorMessageType9, 4439
Orientation, 4440
PageMode, 4442
PageModeMessageNumber, 4442
Parent, 4443
Password, 4445
PersistentRTAuthorization, 4446
PersistentRTCSAuthorization, 4446

PersistentRuntime, 4447
PersistentRuntimeAuthorization, 4448
PersistentToDownload, 4448
PersistentToDownloadAuthorization, 4449
Picture, 4451
PictureAlignment, 4452
PictureDeactivated, 4452
PictureName, 4453
PictureOff, 4453
PictureOn, 4453
PointerColor, 4455
PointsCount, 4456
Precision, 4457
Pressed, 4457
PrintConfiguration, 4458
PrintJobName, 4458
PrintVisibleColumnsOnly, 4459
Processvalue, 4459
ProcessValue, 4461
ProjectPath, 4462
RadiusHeight, 4464
RadiusWidth, 4465
ReadOnly, 4466
RecipeName, 4466
RecipeNumber, 4467
RecordName, 4467
RecordNumber, 4467
RelativeFillLevel, 4468
Rotation, 4470
RotationAngle, 4470
RotationCenterTop, 4472
RowNumber, 4473
RowScrollbar, 4473
RowSizingEnable, 4474
RTPersistence, 4475
RTPersistencePasswordLevel, 4475
RTPersistenceType, 4476
RulerColor, 4477
RulerPrecision(i), 4477
RulerXPrecision(i), 4478
RulerYPrecision(i), 4478
ScaleColor, 4479
ScaleDenumerator, 4485
ScaleGradation, 4480
ScaleLabelColor, 4481
ScaleNumerator, 4481
ScalePosition, 4482
ScaleTickColor, 4482
ScaleTickLabelPosition, 4483
ScaleTickLength, 4483
ScaleTickPosition, 4484
ScalingType, 4486
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ScreenItems, 4487
Screens, 4487
Scrollable, 4488
SecondNeedleHeight, 4489
SecondNeedleWidth, 4489
SegmentColoring, 4490
SelectBackColor, 4491
SelectedCellColor, 4491
SelectedCellForeColor, 4492
SelectedRowColor, 4493
SelectedRowForeColor, 4493
SelectedTitleColor, 4494
SelectedTitleForeColor , 4495
SelectForeColor, 4495
SelectionBackColor, 4496, 4497
SelectionColoring, 4497
SelectionForeColor, 4498, 4499
SelectionMode, 4499, 4500
SelectionRect, 4500
SelectionRectColor, 4501
SelectionRectWidth, 4502
SeparatorBackColor, 4503
SeparatorColor, 4503
SeparatorWidth, 4505
SeperatorCornerStyle, 4504
SeperatorStyle, 4504
ServerNames, 4506
ServerScale, 4505
SetpointTrendArchiveStartId(i), 4507
SetpointTrendColor(i), 4508
SetpointTrendNumberOfValues(i), 4508
Shared, 4511
ShareTimeColumn, 4509
ShareValueAxis, 4510
ShareXAxis, 4510
ShareYAxis, 4511
ShiftDecimalPointReadOnlySpecial, 4512
ShortenCellText, 4512
ShortenColumnHeaderText, 4513
ShowAlarmsFromDate, 4513
ShowBar, 4514
ShowBorder, 4514
ShowCaption, 4515
ShowColumn(i), 4516
ShowCurve(i), 4516
ShowDecimalPoint, 4517
ShowFillLevel, 4517
ShowFocusRectangle, 4518
ShowInputControls, 4518
ShowLimitMarkers, 4519
ShowMainFrame, 4519
ShowMessagesAtDate, 4520

ShowOverflowIndicator, 4521
ShowPeakValuePointer, 4521, 4522
ShowPosition, 4522
ShowRowHeaders, 4523
ShowRuler, 4523, 4524
ShowRulerInAxis, 4524
ShowScale, 4525
ShowScrollbars, 4525
ShowSetpointTrend(i), 4526
ShowSortButton, 4526
ShowSortIcon, 4527, 4528
ShowStatusBar, 4528
ShowTableGridlines, 4529
ShowThumb, 4530
ShowTickLabels, 4530
ShowTicks, 4531
ShowTitle, 4532
ShowToolBar, 4532
ShowTrendIcon, 4533
ShowTrendIndicator, 4534
ShowVerticalGridlines, 4534
ShowXValuesExponential(i), 4535
ShowYValuesExponential(i) , 4535
SkinName, 4536
SmartTags, 4537
Sort, 4537
SortByTimeDirection , 4538
SortByTimeEnable, 4538
SortByTimeEnabled, 4539
SortOnColumnHeaderClick, 4539
SortSequence, 4540
SortTimeAscending, 4540
SortTimeEnable, 4541
StartAngle, 4541
StartLeft, 4542
StartPointTop, 4544
StartStyle, 4543
StatusbarBackColor, 4545
StatusbarElementAdd, 4545
StatusbarElementAutoSize, 4546
StatusbarElementCount, 4546
StatusbarElementIconId, 4547
StatusbarElementID, 4547
StatusbarElementIndex, 4548
StatusbarElementName, 4548
StatusbarElementRemove, 4549
StatusbarElementRename, 4549
StatusbarElements, 4550
StatusbarElementTooltipText, 4550
StatusbarElementUserDefined, 4551
StatusbarElementVisible, 4552
StatusbarElementWidth, 4552

Index

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  6357



StatusbarFontColor, 4552
StatusbarShowArchiveName, 4553
StatusbarShowColumn, 4553
StatusbarShowRecord, 4554
StatusbarShowRow, 4554
StatusbarShowText, 4554
StatusbarShowTooltips, 4555
StatusbarText, 4556
StatusbarUseBackColor, 4556
StatusbarVisible, 4557
Style, 4558
SwapDimensionsWithOrientation, 4559
SwapFirstWithLastConnection, 4560
TableBackColor, 4560, 4561
TableColor, 4562
TableColor2, 4562
TableFocusOnButtonCommand, 4562
TableForeColor, 4563, 4564
TableForeColor2, 4564
TableGridLineColor, 4565
TableHeaderBackColor, 4566
TableHeaderForeColor, 4567
Text, 4570, 4571
TextList, 4571
TextOff, 4572
TextOn, 4573
TextOrientation, 4574
ThumbBackColor, 4575, 4576
TicksColor, 4576
TickStyle, 4577
TimeAxisBeginTime(i), 4578
TimeAxisEndTime, 4578
TimeAxisLabel(i), 4579
TimeAxisRange, 4579
TimeAxisShowGridLines(i), 4580
TimeAxisShowLargeIncrements(i), 4580
TimeAxisShowSmallIncrements(i), 4581
TimeAxisTimeFormat(i), 4582
TimeBase, 4582
TimeColumnActualize, 4583, 4589
TimeColumnAdd, 4584
TimeColumnAlign, 4584
TimeColumnAlignment(i), 4585
TimeColumnBackColor, 4586
TimeColumnBeginTime, 4586
TimeColumnCaption, 4586
TimeColumnCount, 4587
TimeColumnDateFormat, 4587
TimeColumnEndTime, 4588
TimeColumnForeColor , 4588
TimeColumnFormat(i), 4589
TimeColumnHideTitleText, 4590

TimeColumnIndex, 4590
TimeColumnLength, 4591
TimeColumnMeasurePoints, 4591
TimeColumnName, 4592
TimeColumnRangeType, 4592
TimeColumnRemove, 4593
TimeColumnRename , 4593
TimeColumnRepos, 4593
TimeColumnShowDate, 4594
TimeColumnShowIcon, 4594
TimeColumnShowTitleIcon, 4595
TimeColumnSort , 4595
TimeColumnSortIndex, 4596
TimeColumnTimeFormat, 4596
TimeColumnTimeRangeBase, 4597
TimeColumnTimeRangeFactor, 4598
TimeColumnUseValueColumnColors, 4598
TimeColumnVisible, 4599
TimeJumpColor(i), 4599
TimeJumpEnabled(i), 4600
TimeOverlapColor(i), 4600
TimeOverlapEnabled(i), 4601
TimeRangeBase(i), 4601
TimeRangeFactor(i), 4602
TitleColor, 4604
TitleDarkShadowColor, 4605
TitleForeColor, 4605
TitleGridLineColor, 4605
TitleLightShadowColor, 4606
TitleSort, 4606
TitleStyle, 4607
Toggle, 4608
Tolerance, 4608
ToleranceColor, 4609
ToleranceLowerLimit, 4610
ToleranceLowerLimitColor, 4610
ToleranceLowerLimitEnabled, 4611
ToleranceLowerLimitRelative, 4611
ToleranceUpperLimit, 4612
ToleranceUpperLimitColor, 4612
ToleranceUpperLimitEnabled, 4613
ToleranceUpperLimitRelative, 4614
ToolbarAlignment, 4614
ToolbarBackColor, 4615
ToolbarButtonActive, 4615
ToolbarButtonAdd, 4616
ToolbarButtonBeginGroup, 4616
ToolbarButtonCount, 4617
ToolbarButtonEnabled, 4617
ToolbarButtonHotKey, 4618
ToolbarButtonID, 4618
ToolbarButtonIndex, 4618
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ToolbarButtonLocked, 4619
ToolbarButtonName, 4619
ToolbarButtonPasswordLevel, 4620
ToolbarButtonRemove, 4620
ToolbarButtonRename, 4620
ToolbarButtonRepos, 4621
ToolbarButtonTooltipText, 4621, 4639, 4646
ToolbarButtonUserDefined, 4622, 4642
ToolbarShowTooltips, 4622
ToolbarUseBackColor, 4623
ToolbarUseHotKeys, 4624
ToolbarVisible, 4624, 4625
ToolTipText, 4625
Top, 4627
Total, 4630
TransparentColor, 4633
TransparentColorDeactivatedPicture, 4633
TransparentColorPictureOff, 4634
TransparentColorPictureOn, 4634
TrendActualize, 4635
TrendBeginTime, 4636
TrendCount, 4637
TrendEndTime, 4637
TrendExtendedColorSet, 4637
TrendFill, 4638
TrendIndicatorColor, 4639
TrendLineStyle, 4640
TrendLineType, 4641
TrendLowerLimit, 4642
TrendLowerLimitColor, 4642
TrendName, 4643
TrendPointStyle, 4644
TrendProvider, 4645
TrendRangeType, 4645
TrendSelectTagNameX, 4647
TrendSelectTagNameY, 4647
TrendTag, 4648
TrendTagNameX, 4648
TrendTagNameY, 4649
TrendTimeRangeBase, 4649
TrendTimeRangeFactor, 4650
TrendUncertainColor, 4650
TrendUncertainColoring, 4651
TrendUpperLimit, 4651
TrendUpperLimitColoring, 4652
TrendWindowCoarseGrid, 4653
TrendWindowFineGrid, 4654
TrendWindowForegroundTrendGrid, 4655
TrendWindowGridInTrendColor, 4655
TrendWindowHorizontalGrid, 4656
TrendWindowIndex, 4657
TrendWindowRename, 4657

TrendWindowRulerStyle, 4659
TrendWindowVerticalGrid, 4660
Type, 4662
UncertainStateColor(i), 4664
UncertainStateEnabled(i), 4664
UnitColor, 4665
UnitText, 4666
UnitTop, 4667
UpdateEnable, 4668
UpperLimit, 4668
UpperLimitColor(i), 4669
UpperLimitEnabled(i), 4669
UpperLimitValue(i), 4670
UseAllServers, 4671
UseBarBorderConstraints, 4671
Used, 4686
UsedPercent, 4686
UseEffectiveProcessValue, 4676
UseExponentialFormat, 4676
UseFlashTransparentColor, 4677
UseGDI, 4677
UseMeasurePoints(i), 4678
UseMessageColor, 4678
UseMultipleLimits, 4679
UserArchiveNumberOfValues(i) , 4687
UserArchiveStartId(i), 4687
UseScaleConstraints, 4679
UseScaledBarBorder, 4680
UseSelectedTitleColor, 4680
UseSeparateDiagrams, 4681
UseSimplePresicionOffset, 4681
UseTableColor2, 4682
UseTimeRange(i), 4683
UseTransparentColor, 4683
UseTransparentColorDeactivatedPicture, 4684
UseTransparentColorPictureOff, 4684
UseTransparentColorPictureOn, 4685
UseTrendNameAsLabel, 4685
UsingDesignColorScheme, 4672
UsingDesignShadowSettings, 4674
ValidateFormatPattern, 4689
ValueAxisAutorange(i), 4691
ValueAxisBegin(i), 4691
ValueAxisDecimalPrecision(i), 4692
ValueAxisEnd(i), 4692
ValueAxisGridLineInterval(i), 4693
ValueAxisLabel(i), 4693
ValueAxisLargeIncrementsSize(i), 4694
ValueAxisScalingType(i), 4694
ValueAxisShowGridLines(i), 4695
ValueAxisShowLargeIncrements(i), 4696
ValueAxisShowSmallIncrements(i), 4696
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ValueAxisSmallIncrementSize(i), 4697
ValueColumnAlignment(i), 4698
ValueColumnPrecision(i), 4698
VerticalAlignment, 4699
VerticalGridLines, 4700
ViewOnly, 4701
Visible, 4701
Warning, 4704
WarningColor, 4704
WarningLowerLimit, 4705
WarningLowerLimitColor, 4706
WarningLowerLimitEnabled, 4706
WarningLowerLimitRelative, 4707
WarningRangeColor, 4708
WarningRangeStart, 4708
WarningRangeVisible, 4709
WarningUpperLimit, 4710
WarningUpperLimitColor, 4710
WarningUpperLimitEnabled, 4711
WarningUpperLimitRelative, 4711
Width, 4712
WindowCloseEnabled, 4714
WindowSizingEnabled, 4716
WindowsStyle, 4716
XAxisAdd, 4717
XAxisAlign, 4717
XAxisAutoPrecisions, 4718
XAxisAutorange(i), 4718
XAxisBegin(i), 4719
XAxisBeginValue, 4719
XAxisCount, 4720
XAxisDecimalPrecision(i), 4720
XAxisEnd(i), 4721
XAxisEndValue, 4721
XAxisExponentialFormat, 4722
XAxisGridLineInterval(i), 4722
XAxisIndex, 4723
XAxisInTrendColor, 4723
XAxisLabel(i), 4723
XAxisLargeIncrementSize(i), 4724
XAxisMode(i), 4724
XAxisName, 4725
XAxisPrecisions , 4725
XAxisRemove, 4726
XAxisRepos, 4726
XAxisScalingType(i), 4727
XAxisShowGridLines(i), 4727
XAxisShowLargeIncrements(i), 4728
XAxisShowSmallIncrements(i), 4728
XAxisSmallIncrementSize(i), 4729
XAxisTrendWindow, 4729
XAxisVisible, 4730

XDataLogTag(i), 4730
XOnlineTag(i), 4731
YAxisAdd, 4731
YAxisAlign, 4732
YAxisAutoPrecisions, 4732
YAxisBeginValue, 4733
YAxisColor, 4733
YAxisCount, 4734
YAxisEndValue, 4734
YAxisExponentialFormat, 4734
YAxisIndex, 4735
YAxisInTrendColor, 4735
YAxisLabel, 4736
YAxisName, 4736
YAxisPrecisions , 4736
YAxisRemove, 4737
YAxisRename, 4737
YAxisRepos, 4737
YAxisTrendWindow, 4738
YAxisVisible, 4739
YDataLogTag(i), 4739
YOnlineTag(i), 4740
ZeroPoint, 4740
Zoomable, 4742

Properties in VBS
Comment, 4245
ComputerName, 4245
Context, 4247
InputValue, 4344
Instance, 4346
SelIndex, 4493
SelText, 4491
State, 4544
Transparency, 4631
UserName, 4688
WinCCStyle, 4559, 4714

Properties in VBS/HorizontalScrollPosition, 4340
Properties in VBS/ScrollPositionX, 4488
Properties in VBS/ScrollPositionY, 4489
Properties in VBS/VerticalScrollPosition, 4701
Properties in VBS:AngleAlpha, 4168
Properties in VBS:AngleBeta, 4168
Properties in VBS:Application, 4170, 4715
Properties in VBS:Axe, 4178
Properties in VBS:AxisSection, 4178
Properties in VBS:BackBorderWidth, 4179
Properties in VBS:BackColor2, 4181
Properties in VBS:BackColor3, 4182
Properties in VBS:BackFlashColorOff, 4185
Properties in VBS:BackFlashColorOn, 4186
Properties in VBS:Background, 4189
Properties in VBS:BarDepth, 4192
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Properties in VBS:BarHeight, 4192
Properties in VBS:BarWidth, 4193
Properties in VBS:BaseX, 4193
Properties in VBS:BaseY, 4193
Properties in VBS:BorderColorBottom, 4202
Properties in VBS:BorderColorTop, 4202
Properties in VBS:BorderFlashColorOff, 4203
Properties in VBS:BorderFlashColorOn, 4203
Properties in 
VBS:BottomConnectedConnectionPointIndex, 4216
Properties in VBS:BottomConnectedObjectName, 
4217
Properties in VBS:BoxAlignment, 4217
Properties in VBS:BoxCount, 4217
Properties in VBS:BoxType, 4217
Properties in VBS:Button1Width, 4217
Properties in VBS:Button2Width, 4217
Properties in VBS:Button3Width, 4218
Properties in VBS:Button4Width, 4218
Properties in VBS:ButtonColor, 4218
Properties in VBS:CheckAlarmHigh, 4230
Properties in VBS:CheckAlarmLow, 4230
Properties in VBS:CheckLimitHigh4, 4230
Properties in VBS:CheckLimitHigh5, 4230
Properties in VBS:CheckLimitLow4, 4230
Properties in VBS:CheckLimitLow5, 4231
Properties in VBS:CheckToleranceHigh, 4232
Properties in VBS:CheckToleranceLow, 4232
Properties in VBS:CheckWarningHigh, 4232
Properties in VBS:CheckWarningLow, 4232
Properties in VBS:ClearOnNew, 4233
Properties in VBS:CloseButton, 4234
Properties in VBS:ColorAlarmHigh, 4236
Properties in VBS:ColorAlarmLow, 4236
Properties in VBS:ColorBottom, 4236
Properties in VBS:ColorChangeType, 4237
Properties in VBS:ColorLimitHigh4, 4237
Properties in VBS:ColorLimitHigh5, 4238
Properties in VBS:ColorLimitLow4, 4238
Properties in VBS:ColorLimitLow5, 4238
Properties in VBS:ColorToleranceHigh, 4238
Properties in VBS:ColorToleranceLow, 4238
Properties in VBS:ColorTop, 4239
Properties in VBS:ColorWarningHigh, 4239
Properties in VBS:ColorWarningLow, 4239
Properties in VBS:CurrentContext, 4252
Properties in VBS:DataFormat, 4259
Properties in VBS:EditAtOnce, 4274
Properties in VBS:Exponent, 4284
Properties in VBS:ExtendedOperation, 4290
Properties in VBS:ExtendedZoomingEnable, 4290
Properties in VBS:FillColor, 4292

Properties in VBS:Filling, 4293
Properties in VBS:FillingIndex, 4293
Properties in VBS:FillStyle2, 4296
Properties in VBS:FlashBackColor, 4298
Properties in VBS:FlashBorderColor, 4298
Properties in VBS:FlashFlashPicture, 4298
Properties in VBS:FlashForeColor, 4298
Properties in VBS:FlashPicReferenced, 4304
Properties in VBS:FlashPicture, 4304
Properties in VBS:FlashRate, 4304
Properties in VBS:FlashRateBackColor, 4304
Properties in VBS:FlashRateBorderColor, 4304
Properties in VBS:FlashRateFlashPic, 4305
Properties in VBS:FlashRateForeColor, 4305
Properties in VBS:ForeFlashColorOff, 4318
Properties in VBS:ForeFlashColorOn, 4318
Properties in VBS:Hotkey, 4340
Properties in VBS:Hysteresis, 4341
Properties in VBS:HysteresisRange, 4342
Properties in VBS:ItemBorderBackColor, 4347
Properties in VBS:ItemBorderColor, 4347
Properties in VBS:ItemBorderWidth, 4348
Properties in VBS:LanguageSwitch, 4350
Properties in VBS:Layer, 4353
Properties in VBS:Layer00Checked, 4356
Properties in VBS:Layer00Color, 4356
Properties in VBS:Layer00Value, 4356
Properties in VBS:Layer01Checked, 4356
Properties in VBS:Layer01Color, 4356
Properties in VBS:Layer01Value, 4357
Properties in VBS:Layer02Checked, 4357
Properties in VBS:Layer02Color, 4357
Properties in VBS:Layer02Value, 4357
Properties in VBS:Layer03Checked, 4357
Properties in VBS:Layer03Color, 4358
Properties in VBS:Layer03Value, 4358
Properties in VBS:Layer04Checked, 4358
Properties in VBS:Layer04Color, 4358
Properties in VBS:Layer04Value, 4358
Properties in VBS:Layer05Checked, 4359
Properties in VBS:Layer05Color, 4359
Properties in VBS:Layer05Value, 4359
Properties in VBS:Layer06Checked, 4359
Properties in VBS:Layer06Color, 4359
Properties in VBS:Layer06Value, 4360
Properties in VBS:Layer07Checked, 4360
Properties in VBS:Layer07Color, 4360
Properties in VBS:Layer07Value, 4360
Properties in VBS:Layer08Checked, 4360
Properties in VBS:Layer08Color, 4361
Properties in VBS:Layer08Value, 4361
Properties in VBS:Layer09Checked, 4361
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Properties in VBS:Layer09Color, 4361
Properties in VBS:Layer09Value, 4361
Properties in VBS:Layer10Checked, 4362
Properties in VBS:Layer10Color, 4362
Properties in VBS:Layer10Value, 4362
Properties in VBS:LayerDeclutteringEnable, 4362
Properties in VBS:Layers, 4363
Properties in VBS:LeftComma, 4367
Properties in VBS:LeftOffset, 4367
Properties in VBS:LightEffect, 4367
Properties in VBS:LimitHigh4, 4376
Properties in VBS:LimitHigh5, 4376
Properties in VBS:LimitLow4, 4377
Properties in VBS:LimitLow5, 4377
Properties in VBS:LimitMax, 4377
Properties in VBS:LimitMin, 4377
Properties in VBS:ListType, 4381
Properties in VBS:LockStatus, 4383
Properties in VBS:LockText, 4383
Properties in VBS:LockTextColor, 4383
Properties in VBS:Logging, 4384
Properties in VBS:LongStrokesBold, 4385
Properties in VBS:LongStrokesOnly, 4385
Properties in VBS:LongStrokesSize, 4385, 4519
Properties in VBS:LongStrokesTextEach, 4385
Properties in VBS:Marker, 4390
Properties in VBS:Max, 4390
Properties in VBS:MaximizeButton, 4390, 4715
Properties in VBS:MCGUBackColorOff, 4391
Properties in VBS:MCGUBackColorOn, 4391
Properties in VBS:MCGUBackFlash, 4391
Properties in VBS:MCGUTextColorOff, 4392
Properties in VBS:MCGUTextColorOn, 4392
Properties in VBS:MCGUTextFlash, 4392
Properties in VBS:MCKOBackColorOff, 4392
Properties in VBS:MCKOBackColorOn, 4392
Properties in VBS:MCKOBackFlash, 4392
Properties in VBS:MCKOTextColorOff, 4393
Properties in VBS:MCKOTextColorOn, 4393
Properties in VBS:MCKOTextFlash, 4393
Properties in VBS:MCKQBackColorOff, 4393
Properties in VBS:MCKQBackColorOn, 4393
Properties in VBS:MCKQBackFlash, 4393
Properties in VBS:MCKQTextColorOff, 4394
Properties in VBS:MCKQTextColorOn, 4394
Properties in VBS:MCKQTextFlash, 4394
Properties in VBS:MCText, 4394
Properties in VBS:MessageClass, 4406
Properties in VBS:Min, 4411
Properties in VBS:Movable, 4715
Properties in VBS:Name, 4415
Properties in VBS:NumberLines, 4421

Properties in VBS:ObjectSizeDeclutteringEnable, 
4424
Properties in VBS:ObjectSizeDeclutteringMax, 4424
Properties in VBS:ObjectSizeDeclutteringMin, 4425
Properties in VBS:OnTop, 4427
Properties in VBS:OperationMessage, 4427
Properties in VBS:OperationReport, 4427
Properties in VBS:OutputFormat, 4441
Properties in VBS:OutputValue, 4442
Properties in VBS:Path, 4445
Properties in VBS:PicDeactReferenced, 4450
Properties in VBS:PicDeactTransparent, 4450
Properties in VBS:PicDeactUseTransColor, 4450
Properties in VBS:PicDownReferenced, 4450
Properties in VBS:PicDownTransparent, 4450
Properties in VBS:PicDownUseTransColor, 4451
Properties in VBS:PicReferenced, 4451
Properties in VBS:PicTransColor, 4451
Properties in VBS:PictureUp, 4454
Properties in VBS:PicUpReferenced, 4454
Properties in VBS:PicUpTransparent, 4454
Properties in VBS:PicUpUseTransColor, 4455
Properties in VBS:PicUseTransColor, 4455
Properties in VBS:PointCount, 4455
Properties in VBS:Position, 4456
Properties in VBS:PredefinedAngles, 4457
Properties in VBS:Process, 4459
Properties in VBS:QualityCode, 4462
Properties in VBS:ReferenceRotationLeft, 4468
Properties in VBS:ReferenceRotationTop, 4468
Properties in VBS:Relevant, 4469
Properties in VBS:RightComma, 4469
Properties in VBS:RoundCornerHeight, 4472
Properties in VBS:RoundCornerWidth, 4473
Properties in VBS:SameSize, 4479
Properties in VBS:ScaleTicks, 4485
Properties in VBS:Scaling, 4485
Properties in VBS:ScreenName, 4487
Properties in VBS:ScrollBars, 4488
Properties in VBS:SelBGColor, 4490
Properties in VBS:SelTextColor, 4503
Properties in VBS:ServerPrefix, 4506
Properties in VBS:SignificantMask, 4536
Properties in VBS:Sizeable, 4536
Properties in VBS:SmallChange, 4537
Properties in VBS:StartValue, 4544
Properties in VBS:TagName, 4568
Properties in VBS:TagPrefix, 4568
Properties in VBS:Tags, 4569
Properties in VBS:Template, 4569
Properties in VBS:TimeStamp, 4603
Properties in VBS:TitleCut, 4604
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Properties in VBS:Titleline, 4606
Properties in VBS:ToleranceHigh, 4609
Properties in VBS:ToleranceLow, 4609
Properties in 
VBS:TopConnectedConnectionPointIndex, 4630
Properties in VBS:TopConnectedObjectName, 4630
Properties in VBS:TopOffset, 4630
Properties in VBS:Trend, 4635
Properties in VBS:TrendColor, 4636
Properties in VBS:TypeAlarmHigh, 4662
Properties in VBS:TypeAlarmLow, 4662
Properties in VBS:TypeLimitHigh4, 4662
Properties in VBS:TypeLimitHigh5, 4662
Properties in VBS:TypeLimitLow4, 4663
Properties in VBS:TypeLimitLow5, 4663
Properties in VBS:TypeToleranceHigh, 4663
Properties in VBS:TypeToleranceLow, 4663
Properties in VBS:TypeWarningHigh, 4663
Properties in VBS:TypeWarningLow, 4663
Properties in VBS:UnselBGColor, 4667
Properties in VBS:UnselTextColor, 4667
Properties in VBS:UpdateCycle, 4668
Properties in VBS:UserValue1, 4688
Properties in VBS:UserValue2, 4688
Properties in VBS:UserValue3, 4689
Properties in VBS:UserValue4, 4689
Properties in VBS:Value, 4689
Properties in VBS:WarningHigh, 4705
Properties in VBS:WarningLow, 4705
Properties in VBS:WindowBorder, 4202, 4714
Properties in VBS:WindowOnTop, 4715
Properties in VBS:ZeroPointValue, 4741
Properties in VBS:Zoom, 4741
Properties of the VPN group, 577
Property list

Dynamize, 3010
ProSave, 5468, 5624

Installation, 75
Protect

Function key with password, 3036
ProtectedAreaName object, 4064
Protection concept, 879, 882

Introduction, 298
Revoking access rights, 299

Protection level, 878, 879
Revoking access rights, 299

Protocol, 547
PRVREC, 2370
PT, 1878
PTC resistor, 938
PTO, 48
Pull/plug interrupt (ET 200M), 948

Pull/plug interrupt OB, 895
Pulse, 1608, 1617, 1628, 1642, 1859, 1879, 1893, 
2096, 2111

Extended, 1631, 1643, 1882, 1894, 2114
Pulse and direction output, 6010
Pulse extension, 934
Pulse generator

Enabling/disabling with CTRL_PWM, 2506
Pulse interface: Principle, 6012
Pulse stretching, 951
PUT, 2833
PUT / GET, 882
PWM, 48

Q
Q

PLC, 5370
Q address, 637
Q series, 5373
Q0xUDEH CPU

PLC, 5372
QRY_CINT, 2445
QRY_DINT, 2455
QRY_TINT, 2451
Quantum, 5403
QuitHorn, 4821
QuitSelected, 4821
QuitVisible, 4822

R
R, 444, 1592, 1843
R_TRIG, 1605, 1857, 2093
Rack error OB, 896
Rack or station failure, 896
Racks, 413

Inserting a module, 422
Radius, 3103, 3121, 3123
RADIUS, 763
RadiusHeight property (VBS), 4464, 4465
RadiusWidth property (VBS), 4465
Range

Value outside range, 1679, 1932
Value within range, 1678, 1931

Range (... - ...)
Graphics list, 3003

RangeLabelView object, 4065
RangeQualityView object, 4067
RCV_CFG, 2749
RCV_PTP, 2757

Index

WinCC Comfort/Advanced V12.0 SP1
System Manual, 07/2013,  6363



RCV_RST, 2759
RCVREC, 2367
RD_ADDR , 2548
RD_DPAR, 2433
RD_DPARA, 2436
RD_DPARM, 2438
RD_LOC_T, 2288
RD_REC, 2358
RD_SINFO, 2475
RDREC, 2321
RE_TRIGR, 1782, 2039, 2232
Read continuously

Tag, 3187
Read field, 1722, 1977
Read memory address, 2177
Read memory bit, 2179
Read system time with TIME_TCK, 2292
READ_DBL, 50, 2535
READ_ERR, 2464
ReadFromArrayDB, 1739, 1995, 2170, 2207
ReadFromArrayDBL, 1742, 1998, 2173
Reading

A data record with RD_REC, 2358
Asynchronously- data record of a module with 
RD_DPARA, 2436
Data record of a module with RD_DPAR, 2433
from a data block in load memory with 
READ_DBL, 2535

Reading data
From DP standard slaves/PROFINET IO devices 
with DPRD_DAT, 2363
From remote CPU with GET, 2831

Reading out
IP address, 5284
LED status with LED, 2484
Local time with RD_LOC_T, 2288
Recipe data record, 5678

Reading out a diagnostics buffer, 982
Reading tags, 653
Read-only, 878
ReadOnly property (VBS), 4466
ReadTags, 4822
REAL, 1093, 1135, 1158
REAL_TO_, 1158
Receiving data

on I-device with RCVREC, 2367
Receiving SMS messages, 2727
Recipe, 647, 3391, 3393, 3394, 5509, 5650

Application example: Machine parameter 
assignment, 3393
Application example:Batch production, 3393
Basics, 3391, 3393

Configuration option, 3400
Control, 5651
Creating new, 3420
Data flow, 5652
Data Flow, 3397
Data record, 3394, 5651
Differences in TP 177A and OP 77A, 3402
Entry, 3394
Export format, 3642, 3818
Exporting, 3449, 5506
Exporting to CSV file, 2507
GMP settings, 5787
Importing, 3449, 5508
Importing into data block, 2509
Memory requirements, 5752, 5753
Recipe screen, 3407, 5653
Recipe view, 3407, 5653
Synchronizing recipe tag, 3446
Synchronizing tags, 5666, 5667
Use, 3393
Use of text lists, 3406

Recipe data
Migration, 153

Recipe data record
change, 3446
Copy, 3445
Create on the HMI device, 3440, 3441, 3445
Creating, 5674
Creating new, 3420
Creating on the HMI device, 3440
Creating, key operation, 5660
Creating, keyboard operation, 5661
Creating, mouse operation, 5661
Creating, touch operation, 5660
Delete, key operation, 5665
Delete, keyboard operation, 5665
Delete, mouse operation, 5665
Deleting, 3446, 5676
Deleting, touch operation, 5665
Editing, 5675
Editing, key operation, 5663
Editing, keyboard operation, 5664
Editing, mouse operation, 5664
Editing, touch operation, 5663
Export format, 3642, 3818
Exporting, 3449, 5657
Importing, 3449, 5657
Importing and exporting, 3399
load, 3446
Reading from PLC, 5668, 5669, 5678
Reading, key operation, 5668
Reading, keyboard operation, 5669
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Reading, mouse operation, 5669
Reading, touch operation, 5668
Synchronize with PLC, 5675
Synchronizing, 3446
Synchronizing, key operation, 5666
Synchronizing, keyboard operation, 5667
Synchronizing, mouse operation, 5667
Synchronizing, touch operation, 5666
Transfer option, 3397
Transfer, key operation, 5670
Transfer, keyboard operation, 5671
Transfer, mouse operation, 5671
Transfer, touch operation, 5670
Transferring the project, 80
Transferring to PLC, 5670, 5671, 5677
Use of text lists, 3406

Recipe data record change
Effects in Runtime, 5787

Recipe data record name
Writing to a tag, 3409, 3414

Recipe data record number
Writing to a tag, 3409, 3414

Recipe element
Creating new, 3420

Recipe list, 3408, 5654
Recipe name

Writing to a tag, 3409, 3414
Recipe number

Writing to a tag, 3409, 3414
Recipe report

application in reports, 3492
Recipe screen, 3417, 5655

Automatic transfer, 3417
Configuring, 3432
Overview, 5655
Recipe tag, 3396
Synchronizing recipe value, 3417
Visual machine simulation, 3417

Recipe tag
Offline, 5656
Online, 5656
Synchronizing, 3400, 3446, 5656
Teach-in mode, 3401

Recipe value, 3417
Automatic transfer in the recipe screen, 3417
Synchronizing in the recipe screen, 3417

Recipe view, 3125, 3407, 3412, 3442, 5653, 5659
Advanced recipe view, 3126
Application, 3128, 3442
Behavior with screen change, 3415
Configurable events, 3410, 3415
Configuring, 3427, 3430

Control element, 3127
Display number, 3127
Displaying one recipe only, 3413
Displaying values only, 3409
Dynamic properties, 3411
Expanded, 3412, 5653
Layout, 3128
Operating element, 3443, 5659
Operation, 3443, 5659
Operation using the function key, 3415
Operation with the keyboard, 3444, 5660
Operation with the mouse, 3444, 5660
Recipe data record, 3395, 3396, 3416
Simple, 3408, 5654
Simple recipe view, 3126
Toolbar, 3128
Updating, 3408, 3412
Use, 5659
Using as a drop-down list, 3414

RecipeExport, 2507
RecipeImport, 2509
RecipeName property (VBS), 4466
RecipeNumber property (VBS), 4467
Recipes

 Export CSV file from ES, 3435
Import CSV file into ES, 3433

RecipeViewBack, 3695
RecipeViewClearDataRecord, 3690
RecipeViewGetDataRecordFromPLC, 3689
RecipeViewMenu, 3690
RecipeViewNewDataRecord, 3689
RecipeViewOpen, 3691
RecipeViewRenameDataRecord, 3694
RecipeViewSaveAsDataRecord, 3693
RecipeViewSaveDataRecord, 3692
RecipeViewSetDataRecordToPLC, 3692
RecipeViewShowOperatorNotes, 3695
RecipeViewSynchronizeDataRecordWithTags, 3693
Recommissioning

HMI device, 5638
Reconnecting

Tag, 3182
Reconnecting a PLC tag, 3182
Recording a log file for the modem, 6264
RecordName property (VBS), 4467
RecordNumber property (VBS), 4467
Rectangle

Configuring, 2988
Inserting, 2990
Inserting and configuring, 2990
Radius corners X, 3125
Radius corners Y, 3125
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Rectangle object, 4074
Redoing actions

Basics of redoing actions, 324
Redoing actions, 327

Reference channel, 935
Reference channel error, 943
Reference channel of the module, 945
Reference junction, 785, 912, 927, 935, 944, 945
Reference language, 266, 5531

Selecting, 5535
Reference object

Defining, 2970, 3478
Reference project

Basics, 277
Closing, 277
Comparing, 278
Opening, 277

Reference temperature, 935, 944, 945
References, 185
Referencing

Object, 3554
RelativeFillLevel property (VBS), 4468
release, 3792
Release

User data type, 3209
Release key, 3794
ReleaseButton, 3699
Remainder of division, 1690, 1944
Remote access user, 537
Remote connection

as CPU-controlled remote connection, 6256
as dial-up connection, 6219
As VPN connection, 6243

Remote connection cannot be established, 6242
Remote connection from the TS Adapter is not 
established, 6266
Remote connection to the TS Adapter is not 
established, 6265
Remote control

By means of Internet Explorer, 5828
By means of SmartClient application, 5828
Configure SmartClient, 5820
Configure SmartServer, 5817
Devices with  keys, 5824
Direct keys, 5832
Monitoring mode, 5816
Session Management, 5816
Smart Options, 5827
SmartClient display, 5831

Remote desktop, 36
Remote monitoring

Smart Options, 5827

Remote system access to a programming device/
personal computer, 6257
Remove

Object from the group, 2983
Removing, 98

Add-on, 98
Folder link, 2976
Formatting in the alarm text, 3274

Rename
Customized VB function, 3561
Screen, 2939
Tag, 3178
Template, 2943

Renewing the CA group certificate, 581
REPEAT, 2222
Replace

HMI device, 5572
REPLACE, 2313
Replace modules during operation, 948
Replacing

Module, 427
Replacing devices

Function key, 5561
K-key, 5562
Limitations on connections, 5559
Principle, 5559

Report
Adding a detail page, 3467
Back page, 3462
Creating, 3466
creating (overview), 3464
Deleting page, 3468
Detail page, 3463
Device dependency, 4973
Event-driven output, 3468
Footer, 3463
Header, 3463
Maximum configurable number of pages, 3465
output to file, 3468
print, 3468
printing, 3484
Showing and hiding sections, 3468
Size and position of objects, 3465
Sorting pages, 3468
Steps for the output configuration, 3469
Time-driven output, 3468
Title page, 3462

Reporting
Audit Trail, 5770
enabling, 3299

Reports
 Recipe report , 3492
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Alarm report , 3490
Date/time field, 3486
Graphic I/O field, 3489
I/O field, 3486
Page number, 3493
Symbolic I/O field, 3494

Requirements for establishing a remote connection, 
6241
Requirements for sending an SMS, 6260
Requirements for sending emails, 6261
Reset

Bit field, 1595, 1846
IEC timer, 1625, 2108
Operand, 1592, 1597, 1843, 1848
To factory settings, 992, 993

Reset timer, 1876
Reset to factory settings, 5628
RESET_BF, 1595, 1846
ResetBit, 3696, 3848
ResetBitInTag, 3697, 3849
ResetTagToHandWheel , 3743
Resetting

HMI device to factory settings, 5629
Resetting the connection, 2907
Resetting the MPI/PROFIBUS settings, 6168
Resetting the TCP/IP settings, 6160
Resetting the user interface layout, 233
Resizing

Faceplate, 3066
Resource

SIMATIC S7 1200, 73
Resources, 1481

Code work memory, 1481
Data work memory, 1481
Introduction, 1481
Load memory, 1481
Retentive memory, 1481
Retentive memory data, 1481
Work memory, 1481

Resources tab
Structure, 1483

Response to resizing
Faceplate type, 3066

Restore process
Authorization, 101
License key, 101, 102

Restore window layout, 231
Restoring, 5648, 5707

Data of the HMI device, 5624, 5626
Using WinCC flexible, 5648

Restoring a backup, 6152
Restoring a device, 6152

Restoring data
HMI device, 5626
HMI device , 5624

Restriction
Modicon Modbus RTU, 5419
Modicon Modbus TCP/IP, 5419

Restrictions due to user rights, 244, 245
Recognizing, 245

RET, 1777, 2033
Retain, 1029
Retentive behavior

Bit memory, timers, counters, 1183
Retentive bit memories

Enabling the display, 1469
Retentive memory, 1481
Retentivity, 845, 1027

Bit memory, timers, counters, 1182
Block interface, 1254
Data block, 1395
Data block , 1396
PLC tag, 1182, 1183

Retentivity of IP address parameters, 808
Retrieving projects, 276
RETURN, 2227
RFID tag, 4865
RIGHT, 2310
Ring port, 5315, 5318
Ring redundancy, 726
RLO

Invert, 1590, 1841
ROL, 1812, 2070, 2257
Role name, 537
Roles, 536

System-defined, 537
User-defined, 537

Root certification authorities, 533
Root, square, 2147
ROR, 1810, 2068, 2255
Rotate

Left, 1812, 2070, 2257
Object, 2953
Right, 1810, 2068, 2255

Rotation property (VBS), 4470
RotationAngle property (VBS), 4470
RotationCenterLeft property (VBS), 4471
RotationCenterTop property (VBS), 4472
Round, 1755, 1756, 1758, 1759, 2011, 2013, 2014, 
2015, 2196, 2197, 2198
ROUND, 1755, 2011, 2196
RoundButton object, 4074
Router IP address, 605
Routing, 5461
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Routing connection
Configuring, 5298

Routing mode, 563
RowNumber property (VBS), 4473
RowScrollbar property (VBS), 4473
RowSizingEnable property (VBS), 4474
RS, 1597, 1848
RS-232/PIP multi-master cable, 872
RT, 1625, 1876, 2108
RT class, 796, 5305
RTPersistence property (VBS), 4475
RTPersistencePasswordLevel property (VBS), 4475
RTPersistenceType property (VBS), 4476
RulerColor property (VBS), 4477
RulerPrecision(i) property (VBS), 4477
RulerXPrecision(i) property (VBS), 4478
RulerYPrecision(i) property (VBS), 4478
Rules for configuring MPI networks

Rules for assigning the MPI address, 440
Rules for network configuration for PROFIBUS 
networks

Assigning device addresses, 440, 441
RUN, 840
Rung

Deleting, 1302
Inserting, 1301
Use, 1300

Runtime, 4878, 4880
Changing object property, 3576
Effective range, 4878
Effective range (RFID), 4880
Executing user-defined functions, 3574
Execution of the function list, 3573
Language switching, 3577
Mouse wheel, 78
Operation with the keyboard, 5704
Operation with the mouse, 5705
Start screen, 2940
starting on a panel, 5615
starting on PC, 5615

RUNTIME, 2241
Measure program runtime, 2241

Runtime data
Migration, 153

Runtime error, 3566
Runtime language, 5531, 5549

Font, 5554
Log, 3231, 3318, 5555
Order for language switching, 5552
Selecting, 5550

Runtime meters
Handling with RTM, 2293

Runtime scripting, 3541
Function, 3541
System function, 3541
User-defined function, 3541

Runtime settings, 5801
Communication, 5281
Dialog fonts, 5643
Disabling program switching, 5643
Screen saver, 5643
User administration, 2940, 3500, 3502, 3515, 
3524, 3527

Runtime Stop, 3794

S
S, 1593, 1844
S_AVERZ, 1639
S_CD, 1661, 1914
S_COMP, 2295
S_CONV, 2294, 2296
S_CU, 1659, 1912, 2132
S_CUD, 1910
S_EVERZ, 1634
S_ODT, 1634, 1885, 2117
S_ODTS, 1637, 1888, 2119
S_OFFDT, 1639, 1890, 2122
S_PEXT, 1631, 1882, 2114
S_PULSE, 1628, 1879, 2111
S_SEVERZ, 1637
S5TIME, 1096
S7 1200

Basic Panel, 4958
Comfort Panel, 4965
Communication, 5045
Connection parameters, 5110
HMI connection, 5047
Mobile Panel, 4971
Multi Panel, 4969
Panel, 4961
Parameters, 5110
PROFIBUS, 5067, 5068, 5069, 5071, 5073
PROFIBUS parameters, 5075, 5077, 5078
PROFINET, 5046, 5049
WinCC Runtime, 4975

S7 1500
Communication, 4978
Connection parameters, 5033
Data types, 5029
HMI connection, 4980
Parameters, 5033
PC, 4983
PROFIBUS, 4997, 4998, 4999, 5001, 5002
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PROFIBUS parameters, 5004, 5006, 5007
PROFINET, 4979, 4981
PROFINET parameters, 4987, 4989, 4990
WinCC Runtime, 4975

S7 200
Communication, 5198
Connection, 5198, 5229
Connection parameters, 5200
Data types, 5227
MPI, 5196, 5205
Parameters, 5196, 5200, 5205, 5206
PPI, 5206

S7 300
Basic Panel, 4958
Comfort Panel, 4965
Communication, 5118
Mobile Panel, 4971
MPI address, 5165
Multi Panel, 4969
Panel, 4961
WinCC Runtime, 4975

S7 300/400
Connection parameters, 5191
Data types, 5185
HMI connection, 5120
MPI, 5153, 5155, 5157, 5158
MPI parameters, 5160, 5162, 5163
Parameters, 5191
PC, 5126
PROFIBUS, 5139, 5140, 5141, 5143
PROFIBUS parameters, 5147, 5149, 5150
PROFINET, 5119, 5122
PROFINET parameters, 5128, 5130, 5132

S7 400
Basic Panel, 4958
Comfort Panel, 4965
Communication, 5118
Mobile Panel, 4971
MPI address, 5165
Multi Panel, 4969
Panel, 4961
WinCC Runtime, 4975

S7 communication
Parameter, 2828
Receive data from a remote partner instruction 
with BRCV, 2841
Receive data from a remote partner instruction 
with URCV, 2837
Send and receive parameters, 2829
Send data to a remote partner instruction with 
BSEND, 2839

Send data to a remote partner instruction with 
USEND, 2836
User data size, 2830

S7 connection, 450
TSAP, 461

S7 CPU
 Work memory, 843
Load memory, 843
Operand area, 843

S7 diagnostic alarm
enabling, 3278

S7 diagnostic alarms, 3252
S7-1200, 45
S7-1200 modules, 45
S7-CP, 525
S7-PCT, 826
SA lifetime, 578
SafelyRemoveHardware, 3647, 3850
Safety guidelines, 253
Safety instruction

Changing the recipe data record in the 
background, 3408
Direct key, 5691
Recipe data record in background, 3412, 5654
Renamed tag, 5666
Switching infotext, 5697, 5703

Safety precautions when forcing tags, 1526, 1540
Save

Global library, 5493
Save table layout, 230
Save user interface

Save layout in editors, 230
Save window layout, 230

Save window layout, 230
SaveDataRecord, 3730, 3851
Saving a force table, 1530
Saving a watch table, 1505
Saving phone books, 6214
Saving the user interface, 230
SC, 1663, 1916
SCALANCE S, 525
SCALANCE XR500, "Compile"/"Download", 47
Scale, 1760, 1765, 2017, 2021, 2201, 2209
SCALE, 1765, 2021, 2209
SCALE_X, 1760, 2017, 2201
ScaleColor property (VBS), 4479
ScaleDenumerator property (VBS), 4485
ScaleGradation property (VBS), 4480
ScaleLabelColor property (VBS), 4481
ScaleNumerator property (VBS), 4481
ScalePosition property (VBS), 4482
ScaleTickColor property (VBS), 4482
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ScaleTickLabelPosition property (VBS), 4483
ScaleTickLength property (VBS), 4483
ScaleTickPosition property (VBS), 4484
Scaling

Applying linear scaling to a tag, 3187, 3189
ScalingType property (VBS), 4486
Scan operand for negative signal edge, 1599, 1851
Scan operand for positive signal edge, 1598, 1850
Scan RLO for negative signal edge, 1604, 1856
Scan RLO for positive signal edge, 1603, 1854
Scheduler, 4892

Acyclic triggers, 4897, 4898
Administer task, 4902
Cyclic triggers, 4897, 4900, 4906
Deactivated task, 4896
Event trigger, 4896, 4897, 4901, 4904
Function list, 4895
Timers for cyclic and acyclic triggers, 4898
Triggers, 4896, 4897
Work area, 4894

SCL, 1340, 1576, 1578
Insert comment, 2227
Programming window, 1351

SCL instruction
Changing the data type, 1361
Data type basics, 1360
Inserting, 1358, 1359
Rules, 1357
Selecting, 1374

SCL program
Inserting a block call, 1364, 1365, 1367, 1368, 
1369, 1370
Inserting an instruction, 1358, 1359
Inserting comments, 1373
Program status display, 1498
Selecting an instruction, 1374
Showing and hiding the parameter list, 1372

Screen
Availability for specific devices, 2933
Copy, 2939
Copying, 5577
Creating, 2938
Creating a type, 5503
Deleting, 2939
Font, 2934
Inserting, 2939
Library, 5503
Move, 2939
Printing, 5644
Rename, 2939
Use template, 2946
Working steps in creating, 2937

Zooming, 2937
Screen change, 3788

Displaying the screen on entering a zone, 4881
Screen display, 38
Screen keyboard, 5691

Alphanumerical, 5695
Keyboard level, 5695
Language behavior, 77
Language change, 5695
Numerical, 5693

Screen number, 4916
Screen object, 3905, 3930

Dynamic movement, 3015
Dynamization of the control enable state, 3018

Screen object (list), 3904
Screen saver

Runtime settings, 5643
Screen template, 3032
ScreenItem, 4030

Control, 4000
ScreenItem object, 3906, 3932
ScreenItems object (list), 3908, 3934
ScreenItems property (VBS), 4487
ScreenObjectCursorDown, 3628
ScreenObjectCursorUp, 3629
ScreenObjectPageDown, 3629
ScreenObjectPageUp, 3630
Screens property (VBS), 4487
ScreenWindow object, 4078
Script

Creating a type, 5502
Library, 5502
Migrating, 149
Updating tag value, 3169, 4949

Scrollable property (VBS), 4488
Scrolling back key, 5698
Scrolling up key, 5698
SD, 1643, 1645, 1896
SD card

Open force job, 36
SD cards, 36
SE, 1643, 1894
Search

Hardware catalog, 412
SecondNeedleHeight property (VBS), 4489
SecondNeedleWidth property (VBS), 4489
Security Configuration Tool

Configuration views, 526
Security events, 593, 595
Security module, 525
Security program, 90, 94
Security settings, 700
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Security system, 5706
SEG, 1831, 2089, 2277
Segment diagnostics

Graphic display, 1010
Icons, 1010
Text display, 1010

SegmentColoring property (VBS), 4490
Segmented circular log, 3305
SEL, 1799, 2057, 2245
Select, 1799, 2057, 2245

Multiple objects, 2969, 3477
SelectBackColor property (VBS), 4491
SelectedCellColor property (VBS), 4491
SelectedCellForeColor property (VBS), 4492
SelectedRowColor property (VBS), 4493
SelectedRowForeColor property (VBS), 4493
SelectedStatisticArea, 4836
SelectedTitleColor property (VBS), 4494
SelectedTitleForeColor property (VBS), 4495
SelectForeColore property (VBS), 4495
Selecting

Multiple objects, 2954
Selection changed, 3787
Selection list

Open, 5698
SelectionBackColor property (VBS), 4496, 4497
SelectionColoring property (VBS), 4497
SelectionForeColor property (VBS), 4498, 4499
SelectionMode property (VBS), 4499, 4500
SelectionRect property (VBS), 4500
SelectionRectColor property (VBS), 4501
SelectionRectWidth property (VBS), 4502
Send clock cycle, 814
SEND_CFG, 2747
SEND_PTP, 2755
SendEMail, 3705, 3852
Sending SMS messages, 2723
SeparatorBackColor property (VBS), 4503
SeparatorColor property (VBS), 4503
SeparatorWidth property (VBS), 4505
SeperatorCornerStyle property (VBS), 4504
SeperatorStyle property (VBS), 4504
Sequence of columns, 3139
Sequencer, 1814, 2072, 2259
Server

Configuring, 5281
HMI device, 5281

ServerExport, 4837
ServerImport, 4838
ServerNames property (VBS), 4506
ServerScale property (VBS), 4505
Service & Support, 405, 4933

Enabling, 405
Service data

Saving, 987
Service groups, 549, 551
Service-pages, 5843

Create own , 5851
Display, 5847
remote control, 5847
Transfer, 5852

Servo motor, 6007
Session Management, 5816

Setting, 5817
Set

Bit field, 1594, 1845
Counter initial value, 1663
Counter start value, 1916
Operand, 1593, 1596, 1844, 1847

Set limit value, 1700, 1954, 2144
Set operand on negative signal edge, 1602, 1853
Set operand on positive signal edge, 1601, 1852
Set tag on negative signal edge, 1606, 1858, 2094
Set tag on positive signal edge, 1605, 1857, 2093
Set the services 

SmartClient, 5801
SmartServer, 5801

SET_BF, 1594, 1845
SET_CINT, 2443
SET_TIMEZONE, 2290
SET_TINT, 2446
SET_TINTL, 2448
SetAccessModeViaWeb, 3723
SetAcousticSignal, 3706, 3853
SetAlarmReportingMode, 3716, 3854
SetAlarmReportMode, 3716, 3854
SetAndGetBrightness, 3720, 3854
SetBacklightColor, 3712
SetBit, 3709, 3855
SetBitInTag, 3710, 3856
SetBitWhileKeyPressed, 3711
SetBrightness, 3713, 3857
SetConnectionMode, 3722, 3858
SetDataRecordTagsToPLC, 3703, 3859
SetDataRecordToPLC, 3702, 3860
SetDaylightSavingTime, 3718, 3861
SetDeviceMode, 3708, 3862
SetDisplayMode, 3707, 3862
SETIO, 2325
SETIO_PART, 2327
SetLanguage, 3719, 3863
SetPLCMode, 69, 3672, 3715
SetpointTrendArchiveStartId(i) property (VBS), 4507
SetpointTrendColor(i) property (VBS), 4508
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SetpointTrendNumberOfValues(i) property (VBS), 
4508
SetRecipeTags, 3717, 3864
SetScreenKeyboardMode, 3714, 3865
SetStart at boot, 3769, 3877
SetTag, 3721, 3866
SetTagToHandWheel, 3744
Setting

Deadband, 3272
Delay time, 3272
Language, 5649
Languages in the operating system, 5532
View options for the assignment list, 1466
View options for the dependency structure, 1479

Setting AS-i network configuration parameters, 449
Setting at the HMI-device

E-Mail, 5804
HTTP server, 5806, 5856
SmartServer, 5807
Web authorization, 5806
Web server, 5806

Setting ENO automatically, 1349
Setting language, 5649
Setting parameters for the Ethernet interface, 6158

Adding a dynamic IP address, 6159
Connecting to a subnet, 6158
Deleting dynamic IP addresses, 6160
Modifiable parameters, 6157
Options in the parameter settings, 6156

Setting the communication load, 447
Setting the font, size and color , 1352
Setting the Internet Settings

HTTP server, 5287
Setting the mnemonics, 1229
Setting the tab spacing , 1352
Setting up

DCOM user rights, 5894
Setting up DCOM user rights, 5894
Settings

Changing, 203, 1239, 1263, 1305, 1350
FBD, 1262, 1304
General, 199, 201, 202, 1238
LAD, 1262, 1304
SCL, 1349

Settings for the PG/PC interface, 6155
Automatic bus parameter detection, 6162
Setting parameters for the MPI interface, 6162
Setting parameters for the PROFIBUS interface, 
6164

SetValue, 5864
SetWebAccess, 3723
Seven-segment display, 1831, 2089, 2277

Severity, 563
SF, 1648, 1900
SGN_GET, 2759
SGN_SET, 2760
SHA algorithm, 700
SHA1, 578, 625, 635
Shared device

Associated IO controllers, 975
Shared property (VBS), 4511
ShareTimeColumn property (VBS), 4509
ShareValueAxis property (VBS), 4510
ShareXAxis property (VBS), 4510
ShareYAxis property (VBS), 4511
Shift

Left, 1808, 2066, 2253
Right, 1806, 2064, 2251

SHIFT
Key, 5699

ShiftDecimalPointReadOnlySpecial property (VBS), 
4512
SHL, 1808, 2066, 2253
Short-circuit to ground, 933
Short-circuit to L+, 934
ShortenCellText property (VBS), 4512
ShortenColumnHeaderText property (VBS), 4513
Show

Limit lines on the bar, 3087
Show line numbers, 1352
ShowAlarmsFromDate property (VBS), 4513
ShowAlarmWindow, 3749, 3751, 3868, 3871
ShowBar property (VBS), 4514
ShowBorder property (VBS), 4514
ShowCaption property (VBS), 4515
ShowColumn(i) property (VBS), 4516
ShowColumnSelection, 4838
ShowComment, 4839
ShowCurve(i) property (VBS), 4516
ShowDecimalPoint property (VBS), 4517
ShowDisplayOptionsDialog, 4839
ShowEmergencyQuitDialog, 4840
ShowFillLevel property (VBS), 4517
ShowFocusRectangle property (VBS), 4518
ShowHelp, 4840
ShowHideList, 4841
ShowHitList, 4841
Showing

Report sections, 3468
Showing and hiding absolute operands, 1352
Showing and hiding columns, 1195, 1259, 1403, 
1418
ShowInputControls property (VBS), 4518
ShowLimitMarkers property (VBS), 4519
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ShowLockDialog, 4842
ShowLockList, 4843
ShowLogonDialog, 3748
ShowLongTermArchiveList, 4843
ShowMainFrame property (VBS), 4519
ShowMessagesAtDate property (VBS), 4520
ShowOperatorNotes, 3748, 3869
ShowOverflowIndicator property (VBS), 4521
ShowPeakValuePointer property (VBS), 4521
ShowPercentageAxis, 4844
ShowPosition property (VBS), 4522
ShowPropertyDialog, 4845
ShowRowHeaders property (VBS), 4523
ShowRuler property (VBS), 4523, 4524
ShowRulerInAxis property (VBS), 4524
ShowScale property (VBS), 4525
ShowScrollbars property (VBS), 4525
ShowSelectArchive, 4845
ShowSelection, 4846
ShowSelectionDialog, 4846
ShowSelectTimeBase, 4847
ShowSetpointTrend(i) property (VBS), 4526
ShowShortTermArchiveList, 4847
ShowSoftwareVersion, 3750, 3870
ShowSort, 4848
ShowSortButton property (VBS), 4526
ShowSortDialog, 4848
ShowSortIcon property (VBS), 4527, 4528
ShowStatusBar property (VBS), 4528
ShowSystemAlarm, 3751, 3871
ShowSystemDiagnosticsWindow, 3751, 3871
ShowTableGridlines property (VBS), 4529
ShowTagSelection, 4849
ShowThumb property (VBS), 4530
ShowTickLabels property (VBS), 4530
ShowTicks property (VBS), 4531
ShowTimebaseDialog, 4849
ShowTimeSelection, 4850
ShowTitle property (VBS), 4532
ShowToolBar property (VBS), 4532
ShowTrendIcon property (VBS), 4533
ShowTrendIndicator property (VBS), 4534
ShowTrendSelection, 4850
ShowVerticalGridlines property (VBS), 4534
ShowXValuesExponential(i) property (VBS), 4535
ShowYValuesExponential(i) property (VBS), 4535
SHR, 1806, 2064, 2251
Shutting down Windows XP, 37
SiClock, 551
Sign, 1694, 1949
Signal board, 641

Inserting, 642

Signal quality
Calculating the effective range, 3156

signature
electronic, 5756

SIMATIC 500/505 DP
Migrating data types, 168

SIMATIC 500/505 serial
Migrating data types, 168

SIMATIC HMI HTTP protocol
Valid data type, 5293

SIMATIC HMI HTTP Protocol
Configuring HTTP clients, 5858
Configuring the connection, 5858
HTTP Protocol, 5280
HTTPS Protocol, 5280
Migrating data types, 169
Permitted data type, 5855

SIMATIC ISB driver, 40
SIMATIC LOGO!

Communication, 5228
Connection parameters, 5230
Data types, 5239
Parameter, 5230

SIMATIC Logon, 3511
SIMATIC memory card

Formatting, 994
SIMATIC PC

HMI connection, 4986, 5002, 5051, 5071, 5124, 
5157
S7 1500, 4986
S7 300/400, 5124
WinCC RT Advanced, 5002
WinCC RT Professional, 4986, 5002
WinCC RT Advanced, 4986

SIMATIC S5 AS511
Migrating data types, 169

SIMATIC S5 DP
Migrating data types, 170

SIMATIC S7
Communication partners, 5036, 5115, 5195, 
5204, 5207

SIMATIC S7 1200
Connection resource, 73
Resource, 73

SIMATIC S7 Embedded Controller, 46
SIMATIC S7 200

Migrating data types, 171
SIMATIC S7 300/400

Migrating data types, 171
simple alarm view, 5684

Use, 5684
Simple alarm view, 3328
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Application, 3328
Control element, 3329, 5685
Operation, 3329, 5685
Operation using the keyboard, 3330
Operation using the mouse, 3330

Simple Alarm view, 3113
simple alarm window

Application, 3328
Use, 5684

Simple recipe view, 3126, 3408, 5654
Behavior, 3437, 5673
Configuring, 3126
Constraints, 3411
Layout, 3436, 5672
Menu command, 3437, 5672, 5673
Operation, 3436, 5672

Simple user view, 5709
Configuring, 3088
Layout, 5709
Operation, 5710
Use, 5709

Simulate hardware, 388
Simulate modules, 388
Simulate software, 388
SimulateSystemKey, 3725
SimulateTag, 3726
Simulating

Define temporary start screen, 5619
Project with tag simulator, 5617

Simulating devices, 388
Simulation, 80

PLC connection, 80
SIN, 1706, 1961, 2150
Sine, 1706, 1961, 2150
Single instance

Correcting the call type, 1281, 1322
Definition, 1035
Example, 1035

SINT, 1085, 1129, 1148
SINT_TO_, 1148
Size

Editing multiple objects, 2971, 3479
of objects in the report, 3465

SkinName property (VBS), 4536
SLC, 5352
Slice access, 1064
Slicing, 185
Slider, 3131

Display bar, 3132
Display current value, 3132
Maximum value, 3132
Minimum value, 3132

Slider object, 4084
Slot

Determining logical address with LGC_GADR, 
2555
Determining logical address with LOG_GEO, 
2551
Racks, 413
Select, 414

Slot rules, 410
ET 200S, 784

Sm@rtClient view, 3136
Shared use, 3137
View only, 3137

Smart Objects
Control, 4000

Smart Options, 5827
HMI devices suitable for use, 5800
Remote control, 5827
Remote control by means of Internet Explorer, 
5828
Remote monitoring, 5827

Smart tags
ProcessValue, 4461

SmartAccess
Distributed operator stations, 5835
Editing tag values in MS Excel, 5864

SmartClient
Monitoring mode, 5820
Password input, 5832
SmartClient display, 5820

SmartClient display, 5831
SmartClientView object, 4085
SmartClientViewConnect, 3729
SmartClientViewDisconnect, 3728
SmartClientViewLeave, 3730
SmartClientViewReadOnlyOff, 3727
SmartClientViewReadOnlyOn, 3728
SmartClientViewRefresh, 3727
Smartdrive

Installation, 57
SmartServer, 3736, 3811

As a service, 5819
Control mode, 5817
Forced access, 5819
Hardware acceleration, 5825
Local operator control, 5819
Monitoring mode, 5817
Password, 5826
Password input, 5832
Setting at the HMI-device, 5807

SmartService
E-mail notification, 5838
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Input area plan, 5804
Remote control by means of the SmartClient 
application, 5828

SmartTag object, 3911, 3938
SmartTags object (list), 3910, 3940
SmartTags property (VBS), 4537
SMC, 1826, 2084, 2271
Smoothing, 926, 943
SMS text, 2725, 2729, 2735
SMTP Client, 697
SNC_RTCB, 2291
SNMP, 539, 691, 700

Groups, 700
SNMP trap, 700
Users, 701

SNMPv1, 625, 635
SNMPv3, 625, 635
SOAP

Access from Excel, 5863
GetValue, 5864
SetValue, 5864
Windows CE, 5863

Softbus, 5461
Softkey, 3030, 3034

global, 3032
SOFTNET Security Client

Configuring in the project, 597
Creating a configuration file, 597
Database, 598
Using, 596

SOFTNET Security Client, 525
Software

HMI device , 5622, 5623
Software controller

Configuring, 5931
Software requirements at the plant end

Communications instruction "PG_DIAL", 6258
Software requirements at the system end

 Communications instruction "AS_MAIL", 6262
Communications instruction "SMS_SEND", 6261

Software requirements for AS-AS remote link
Communication instruction "AS_DIAL", 6260

Software requirements for the programming device/
personal computer

Communications instruction "PG_DIAL", 6258
Software-controlled data flow control, 871
Sort property (VBS), 4537
SortByTimeEnable property (VBS), 4538
SortByTimeEnabled property (VBS), 4539
Sorting

 Report page, 3468
SortOnColumnHeaderClick property (VBS), 4539

SortSequence property (VBS), 4540
SortTimeAscending property (VBS), 4540
SortTimeEnable property (VBS), 4541
SP, 1642, 1893
Special characters

Alarm text, 68
Special considerations

Omron Host Link, 5438
Special tag (web server), 656
Specific .Net control

Add, 2973
Remove, 2974

Speedy Splitter, 391, 394, 397, 406
SQR, 2146
SQR , 1702, 1956
SQRT, 1703, 1958, 2147
Square, 1702, 1956, 2146
Square root, 1703, 1958, 2147
SR, 1596, 1847
SRT_DINT, 2453
SS, 1646, 1898
SSH server, 690
SSL certificate, 534
Stamping, 2967, 3472
Standard

PROFIBUS, 5080, 5152
Standard device, 820
Standard router, 604
Standard slave, 794
Standard user, 537
Standby Mode, 37
Standby module

Substitute value, 789
Start address, 637, 847
Start information, 1022
Start off-delay timer, 1872
Start on-delay timer, 1870
Start pulse timer, 1868
Start screen, 2940
Start the online and diagnostics view, 969
Start the simulation, 388
Start value

Tag, 3185, 3186
Start value of danger range

Gauge, 3159
Start value of warning range

Gauge, 3159
StartAngle property (VBS), 4541
Starting

Debugger, 3572, 5622
Runtime at Engineering Station, 5613
Runtime on a panel, 5615
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Runtime on PC, 5615
Runtime on the configuration PC, 5613

Starting removal, 115
Starting the migration tool, 122
Starting the topology view, 510
StartLeft property (VBS), 4542
StartLogging, 3731, 3872
StartNextLog, 3732, 3873
StartPointTop property (VBS), 4544
StartProgram, 3733, 3873
StartSequenceLog, 3732, 3873
StartStopUpdate, 4851
StartStyle property (VBS), 4543
Startup, 883

Organization blocks, 883
STARTUP

Function, 836
STARTUP activities, 838

Startup language
determine:Startup language, 3319

Startup OB
Description, 883

Start-up parameters, 839
Startup routine, 883
Startup type, 856
Stateful packet inspection, 543
Station

Copying, 425
Deleting, 424
Moving, 427
Read information with GetStationInfo, 2490
Renaming, 521

Station name, (See device name)
Status, 887

Module defective, 982
Status interrupt, 887
Status interrupt OB, 887
Status of the online connection, 1006
Status/Force

Button, 3140
Column header, 3140
Control element, 3139
Sequence of columns, 3139
Visible column, 3139

StatusbarBackColor property (VBS), 4545
StatusbarElementAdd property (VBS), 4545
StatusbarElementAutoSize property (VBS), 4546
StatusbarElementCount property (VBS), 4546
StatusbarElementIconId property (VBS), 4547
StatusbarElementID property (VBS), 4547
StatusbarElementIndex property (VBS), 4548
StatusbarElementName property (VBS), 4548

StatusbarElementRemove property (VBS), 4549
StatusbarElementRename property (VBS), 4549
StatusbarElements property (VBS), 4550
StatusbarElementTooltipText property (VBS), 4550
StatusbarElementUserDefined property (VBS), 4551
StatusbarElementVisible property (VBS), 4552
StatusbarElementWidth property (VBS), 4552
StatusbarFontColor property (VBS), 4552
StatusbarShowArchiveName property (VBS), 4553
StatusbarShowColumn property (VBS), 4553
StatusbarShowRecord property (VBS), 4554
StatusbarShowRow property (VBS), 4554
StatusbarShowText property (VBS), 4554
StatusbarShowTooltips property (VBS), 4555
StatusbarText property (VBS), 4556
StatusbarUseBackColor property (VBS), 4556
StatusbarVisible property (VBS), 4557
StatusForce object, 4087
StatusForceGetValues, 3735
StatusForceSetValues, 3735
Stepper motor, 6007
STL, 1568
STL source

Generating blocks, 1422
STOP, 840
Stop forcing, 1546, 1547
Stop method, 4851
StopLogging, 3737, 3875
Stopping

Debugger, 3572
StopRuntime, 3738, 3876
Storage location, 3306

Audit Trail, 5780
Storing

External graphic, 2977
STP, 1783, 2040, 2233
Strg_TO_Chars, 2302
STRG_VAL, 2297
String

Comparing tags with S_COMP, 2295
STRING, 1072, 1103, 1141, 1166

Addressing, 1063
STRING_TO_, 1166
STRUCT

Addressing, 1063
Declaration in global data blocks, 1391
Declaration in the block interface, 1247
Declaring in a PLC data type, 1413
Structure, 1110

Structure, 929, 941
Call structure, 1473
of the cross-reference list, 1486, 5528

Index

WinCC Comfort/Advanced V12.0 SP1
6376 System Manual, 07/2013,  



Of the dependency structure, 1477
Resources tab, 1483
STRUCT, 1110

Structured programming, 1020
Style property (VBS), 4558
SUB, 1687, 1940
Subnet mask, 801
Substitute value

Standby module, 789
Subtract, 1687, 1940
Subtracting

Subtracting times with T_SUB, 2284
Supply voltage, 935
SWAP, 1737, 1993, 2169
Swap bytes, 1737
SwapDimensionsWithOrientation property (VBS), 
4559
SwapFirstWithLastConnection property (VBS), 4560
Switch, 3129

Type, 3129
SWITCH, 1774, 2030
Switch buffer, 5024, 5100, 5181, 5223, 5235, 5357, 
5388, 5420, 5439
Switch object, 4089
Switch OFF, 3795
Switch ON, 3795
Switching between basic mode and expanded mode 
in the force table, 1527
Switching between basic mode and expanded mode 
in the watch table, 1501
Switching operating mode, 988
Switchover time, 873
Switchport, 818, 4995, 5065, 5137
Symbol

Alarm classes, 3285
Symbol library, 3140

Fill style, 3141
Fixed aspect ratio, 3141
Flip, 3141
OP 177B mono, 3141
Rotate, 3141
TP 177B mono, 3141

Symbolic addressing, 185
of a tag, 3171, 4950

Symbolic constants, 1051
Symbolic I/O field, 3142

 application in reports, 3494
Mode, 3142
Text list, 2998, 3143

Symbolic programming
Displaying absolute addresses, 1230

SymbolicIOField object, 4093

Symbolism, 183
SymbolLibrary object, 4098
Symbols

In the assignment list, 1464
In the call structure, 1472
In the dependency structure, 1478

Sync domain, 819, 975, 4996, 5066, 5138
Sync domain properties, 975
SYNC_PI, 2318
SYNC_PO, 2319
Synchronization

From DP slaves with DP_SYC_FR, 2372
Slave clocks with SNC_RTCB, 2291

Synchronization (user-defined web pages), 649
Synchronizing

Object in user-defined functions, 3551
Recipe data record, 3446
Recipe tag, 3400, 5656, 5666, 5667
Recipe view and recipe screen, 3396
Tag in user-defined functions, 3551

Synchronizing user-defined web pages, 2920
Synchronous

Transferring data, 5019, 5093, 5174, 5221, 5454
Synchronous errors

Masking with MSK_FLT, 2463
Querying the error register with READ_ERR, 
2464
Unmasking with DMSK_FLT, 2464

Syntax
Addressing, 5332

Syntax errors
Basics, 1376
Finding errors, 1376

Syntax for AWP commands, 652
Syntax highlighting

User-defined function, 3552
Syslog Client, 705
Syslog server, 587
System

General information, 692
System configuration, 690

System alarm, 3251
Meaning, 3339, 3341, 3349, 3354, 3357, 3369

System block
System blocks folder, 1196

System diagnostic view
Icon, 3147

System diagnostics, 3371, 3376
Button, 3383
Detail view, 3372, 3376
Device view, 3372, 3376
Diagnostic buffer view, 3372, 3377
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Matrix view, 3375
Settings in the PLC, 3379
System diagnostics view, 3371, 3376
System diagnostics window, 3371, 3382

System diagnostics indicator
Button as system diagnostics indicator, 3383
Inserting, 3379
System diagnostics window, 3379

system diagnostics view
Layout, 3145
Show split view, 3147, 3386
Single display, 3147
System diagnostics indicator, 3379

System diagnostics view, 3371
Configuring, 3384, 3385, 3386
Detail view, 3144
Device view, 3144
Diagnostic buffer view, 3144
Settings in the PLC, 3379

System diagnostics window, 3371, 3382
Configuring, 3382
Layout, 3149

System event, 3248, 3249, 3251
Editing, 3276
Meaning, 3339, 3340, 3341, 3342, 3345, 3347, 
3349, 3350, 3351, 3353, 3354, 3355, 3357, 3358, 
3359, 3361, 3362, 3364, 3365, 3370
Parameters, 3339

System events, 593, 595
Configuring, 3261, 3262

System function, 3541, 3764
 SetStart at boot, 3769, 3877
 WinACMPUpdateINTFLED, 3759
Applications, 3542
DirectKeyScreenNumber, 3635
HMI device dependency, 3555
In a function list, 3542
in user-defined functions, 3574
In user-defined functions, 3542
Language dependency, 3543
NotifyUserAction, 5790
SafelyRemoveHardware, 3647, 3850
Sequence is not adhered to, 3575
Usage, 3543
WinACMPArchive, 3767
WinACMPClearCycleTimeBuffer, 3769
WinACMPControl, 3773
WinACMPGetStartCharacteristics, 3767
WinACMPGetVersion, 3768, 3877
WinACMPRestore, 3774
WinACMPSetHMIExecutionTime, 3770
WinACMPSetKeySwitch, 3770

WinACMPSetRestartMethod, 3771
WinACMPSetSleeptime, 3771
WinACMPSetStartMode, 3772, 3878
WinACMPStartHistogram, 3772
WinACMPUpdateAverageCycleTime, 3757
WinACMPUpdateAverageExecTime, 3756
WinACMPUpdateBUSF1LED, 3754
WinACMPUpdateBUSF2LED, 3755
WinACMPUpdateEXTFLED, 3758
WinACMPUpdateKeySwitchSetting, 3753
WinACMPUpdateLastCycleTime, 3760
WinACMPUpdateMaximumCycleTime, 3761
WinACMPUpdateMinimumCycleTime, 3762
WinACMPUpdatePowerLED, 3763
WinACMPUpdateRUNLED, 3765
WinACMPUpdateSleepTime, 3764
WinACMPUpdateStartupCharacteristics, 3752
WinACMPUpdateSTOPLED, 3766

System functions
AcknowledgeAlarm, 3688, 3797
ActivateCleanScreen, 3621
ActivatePreviousScreen, 3622, 3797
ActivateScreen, 3619, 3798
ActivateScreenByNumber, 3620, 3799
ActivateSystemDiagnosticsView, 3739, 3800
AdjustContrast, 3623
AlarmViewAcknowledgeAlarm, 3680
AlarmViewEditAlarm, 3679
AlarmViewShowOperatorNotes, 3681
AlarmViewUpdate, 3679
ArchiveLogFile, 3625, 3801
Available for WinCC Runtime, 3614
Available on Comfort Panels, 3602
Available on mobile panels, 3608
Available on Multi Panels, 3596
Available on Panels, 3590
BackupRAMFileSystem, 3724, 3802
CalibrateTouchScreen, 3657, 3803
ChangeConnection, 3746, 3804
ClearAlarmBuffer , 3677, 3805
ClearAlarmBufferProTool , 3678, 3806
ClearDataRecord, 3675, 3807
ClearDataRecordMemory, 3676, 3808
ClearLog, 3674, 3809
CloseAllLogs, 3701, 3810
ControlSmartServer, 3736, 3811
ControlWebServer, 3736, 3811
DecreaseFocusedValue, 3745
DecreaseTag, 3745, 3813
DirectKey, 3633
EditAlarm, 3627, 3814
Encode, 3631, 3814
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EncodeEx, 3632, 3815
ExportDataRecords, 3640, 3816
ExportDataRecordsWithChecksum, 3642, 3818
ExportImportUserAdministration, 3645, 3821
GetBrightness, 3670, 3821
GetDataRecordFromPLC, 3666, 3822
GetDataRecordName, 3667, 3824
GetDataRecordTagsFromPLC, 3669, 3825
GetGroupNumber, 3670, 3826
GetPassword, 3671, 3827
GetUserName, 3665, 3827
GoToEnd, 3646, 3828
GoToHome, 3646, 3828
HTMLBrowserBack, 3649
HTMLBrowserForward, 3649
HTMLBrowserRefresh, 3648
HTMLBrowserStop, 3648
ImportDataRecords, 3650, 3829
ImportDataRecordsWithChecksum, 3652, 3831
IncreaseFocusedValue, 3639
IncreaseTag, 3639, 3832
InvertBit, 3653, 3834
InvertBitInTag, 3654, 3835
InvertLinearScaling, 3655, 3833
LinearScaling, 3672, 3836
LoadDataRecord, 3664, 3837
Logoff, 3618, 3838
Logon, 3624, 3839
LogTag, 3627
LookupText, 3742, 3839
NotifyUserAction , 3637, 3840
OpenAllLogs, 3682, 3842
OpenCommandPrompt, 3685, 3842
OpenControlPanel, 3687
OpenControlPanelDialog, 3684, 3843
OpenInternetExplorer, 3686, 3844
OpenScreenKeyboard, 3683, 3845
OpenTaskManager, 3688, 3845
PageDown, 3704, 3846
PageUp, 3705, 3846
PressButton, 3698
PrintReport, 3637, 3847
PrintScreen, 3636, 3847
RecipeViewBack, 3695
RecipeViewClearDataRecord, 3690
RecipeViewGetDataRecordFromPLC, 3689
RecipeViewMenu, 3690
RecipeViewNewDataRecord, 3689
RecipeViewOpen, 3691
RecipeViewRenameDataRecord, 3694
RecipeViewSaveAsDataRecord, 3693
RecipeViewSaveDataRecord, 3692

RecipeViewSetDataRecordToPLC, 3692
RecipeViewShowOperatorNotes, 3695
RecipeViewSynchronizeDataRecordWithTags, 
3693
ReleaseButton, 3699
ResetBit, 3696, 3848
ResetBitInTag, 3697, 3849
ResetTagToHandWheel , 3743
SaveDataRecord, 3730, 3851
ScreenObjectCursorDown, 3628
ScreenObjectCursorUp, 3629
ScreenObjectPageDown, 3629
ScreenObjectPageUp, 3630
SendEMail, 3705, 3852
SetAcousticSignal, 3706, 3853
SetAlarmReportMode, 3716, 3854
SetAndGetBrightness, 3720, 3854
SetBit, 3709, 3855
SetBitInTag, 3710, 3856
SetBitWhileKeyPressed, 3711
SetBrightness, 3713, 3857
SetConnectionMode, 3722, 3858
SetDataRecordTagsToPLC, 3703, 3859
SetDataRecordToPLC, 3702, 3860
SetDaylightSavingTime, 3718, 3861
SetDeviceMode, 3708, 3862
SetDisplayMode, 3707, 3862
SetLanguage, 3719, 3863
SetRecipeTags, 3717, 3864
SetScreenKeyboardMode, 3714, 3865
SetTag, 3721, 3866
SetTagToHandWheel , 3744
SetWebAccess, 3723
ShowAlarmWindow, 3749, 3868
ShowLogonDialog, 3748
ShowOperatorNotes, 3748, 3869
ShowSoftwareVersion, 3750, 3870
ShowSystemAlarm, 3751, 3871
ShowSystemDiagnosticsWindow, 3751, 3871
SimulateSystemKey, 3725
SimulateTag, 3726
SmartClientViewConnect, 3729
SmartClientViewDisconnect, 3728
SmartClientViewLeave, 3730
SmartClientViewReadOnlyOff, 3727
SmartClientViewReadOnlyOn, 3728
SmartClientViewRefresh, 3727
StartLogging, 3731, 3872
StartNextLog, 3732, 3873
StartProgram, 3733, 3873
StatusForceGetValues, 3735
StatusForceSetValues, 3735
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StopLogging, 3737, 3875
StopRuntime, 3738, 3876
SystemDiagnosticsViewBack, 3742
SystemDiagnosticsViewDetailView, 3740
SystemDiagnosticsViewDeviceView, 3741
SystemDiagnosticsViewDiagnosticsBuffer, 3741
SystemDiagnosticsViewRefreshPLCBuffer, 3740
TraceUserChange, 3744
TrendViewBackToBeginning, 3663
TrendViewCompress, 3660
TrendViewExtend, 3660
TrendViewRulerLeft, 3662
TrendViewRulerRight, 3661
TrendViewScrollBack, 3659
TrendViewScrollForward, 3659
TrendViewSetRulerMode, 3662
TrendViewStartStop, 3663
UpdateTag, 3623

System limits
HMI device, 5727, 5730, 5734, 5739, 5742

System log, 593, 595
System memory, 856, 876

Diagnostics buffer, 847, 1003
Operand areas, 843
process image input/output, 845

System power supply, 941
System requirement for WinCC Advanced, 91
System requirements STEP 7 Basic, 88
System texts, 266
System Time

NTP Client, 703
PTP Client, 704
SNTP Client, 702

System-defined controller alarm, 3252
System-defined controller alarms, 3249
System-defined role

Administrator, 537
diagnostics, 537
Remote access, 537
standard, 537

System-defined text lists
Editing, 333
Modifying texts, 334

SystemDiagnoseView object, 4100
SystemDiagnoseWindow object, 4104
SystemDiagnosticsViewBack, 3742
SystemDiagnosticsViewDetailView, 3740
SystemDiagnosticsViewDeviceView, 3741
SystemDiagnosticsViewDiagnosticsBuffer, 3741
SystemDiagnosticsViewRefreshPLCBuffer, 3740
System-relevant information

Module information, 970

Vendor information, 970

T
T_ADD, 2282
T_COMBINE, 2285
T_COMP, 2281
T_CONFIG, 49, 2914
T_CONV, 2282
T_DIAG, 2909
T_DIFF, 2285
T_RESET, 2907
T_SUB, 2284
TAB key, 5698
Table

Connection, 4938
TableBackColor property (VBS), 4560, 4561
TableColor property (VBS), 4562
TableColor2 property (VBS), 4562
TableFocusOnButtonCommand property (VBS), 
4562
TableForeColor property (VBS), 4563, 4564
TableForeColor2 property (VBS), 4564
TableGridLineColor property (VBS), 4565
TableHeaderBackColor property (VBS), 4566
TableHeaderForeColor property (VBS), 4567
TableView object, 4037
Tag

absolute addressing, 3170, 4949
Acquisition cycle, 3186, 3200, 3212
Acquisition mode, 3186
Addressing, 3173
Changing the PLC, 3190
Comment, 3175
Configuration, 3179
Configuring several tags, 3179
Connection to PLC, 3173
Copy, 3178
Creating external tags, 3173
Creating internal tags, 3175
Creating the user data type, 3206
Data log, 3218, 3224
Data type, 3175
Deleting, 3178
Displaying or hiding tag information, 1294, 1335
Displaying values, 3235
Event, 3199
Exporting, 5517
External tag, 3169, 4948
Faceplate type, 3072
GMP settings, 5783
GMP-relevant tag, 5783
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Handwheel, 3099
Illuminated pushbutton, 3107
Importing, 5519
in Runtime, 3186
Index tag, 3197, 3198
Indirect addressing, 3197, 3198
Internal tag, 3172, 4951
Key switch , 3133
Length, 3175
Limit value, 3184
Limit values, 3183
Linear scaling, 3187, 3189
Logging, 3218, 3224
Logging cycle, 3212
Maximum length, 77
Multiplexing, 3197
Name, 3175
Negative, 1606, 1858
Object list, 3174
Output in alarm, 3274
Overlaying, 1065
Overview, 1049
PLC tag, 1172
PLC tags and DB tags, 1050
Positive, 1605, 1857
Read continuously, 3187
reconnecting, 3182
Rename, 3178
RFID tag, 4862
Start value, 3185, 3186
symbolic addressing, 3171, 4950
Tolerance band, 3218, 3224
Transponder, 4862
Update, 3187, 3200
User data type, 3205
User data type element, 3205

Tag array, 3201
Tag binding

Animation, 3020
Tag data

Structure for the import, 5520, 5525
Tag declaration

Automatically filling in cells, 1195, 1258, 1402, 
1417
Based on a PLC data type, 1392
Block interface, 1240
Declaring ARRAY, 1246
Declaring PLC data type, 1248
Declaring STRUCT, 1247
Declaring tags, 1244, 1245, 1249
Deleting a tag, 1194, 1257, 1402, 1417
Importing and exporting tags, 1259, 1403

Inserting a table row, 1192, 1257, 1401, 1416
Inserting table rows at the end, 1257, 1401, 1416
Multi-instance, 1250
Overlaying tags, 1249
Purpose of tag declaration, 1239
Reserved key words, 1052
Retentivity, 1254
Showing and hiding columns , 1195, 1259, 1403, 
1418
Sorting rows, 1194
Tag properties, 1253, 1255, 1397, 1399, 1400
Updating the block interface, 1250
Valid data types, 1243

Tag import
Tag data structure, 5520, 5525

Tag list
Indirect addressing, 3197, 3198

Tag log
Migrating, 153

Tag name
Valid names in logs, 3221

Tag object, 3941
Tag simulator, 5619
Tag table

Default, 3167, 4947
for HMI devices, 3167, 4947
user-defined, 3167, 4947

Tag value
Output, 3235, 3239

Tags, 3944, 3945
Basics, 3166, 4946
Data exchange, 4915
Migration, 160
Monitor all, 1515, 1537
Monitor now, 1538
Monitor once and now, 1516

Tags object (list), 3945
Tan, 2152
TAN, 1709, 1964
Tangent, 1709, 1964, 2152
Task, 4893

Changing during Runtime, 4904
Changing the name, 4902
Deactivate, 4896, 4898
Deleting, 4902

Task card, 2935
Changing the pane mode, 223
Function, 221
Hardware catalog, 403, 4931
Reducing automatically, 214

Task Card
Online Tools, 970
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Tools, 2947, 2950
TCI (Tool Calling Interface), 824
TCON, 2877, 2880
TCON_IP_RFC, 492
TCON_IP_v4, 491
TCON_Param, 488
TCP, 547

Characteristics, 487
Port numbers, 494

TDISCON, 2884
Teach-in mode, 3401

Recipe tag, 3401
Technology object command table: Add new object, 
6049
Technology object command table: Basic 
parameters, 6050
Technology object command table: Command table 
configuration, 6051
Technology object command table: Configuration 
window icons, 6050
Technology object command table: Configuring 
activate warnings, 6051
Technology object command table: Configuring 
duration, 6053
Technology object command table: Configuring 
position / travel path, 6052
Technology object command table: Configuring the 
command type, 6052
Technology object command table: Configuring the 
next step, 6054
Technology object command table: Configuring the 
step code, 6054
Technology object command table: Configuring use 
axis parameters of, 6051
Technology object command table: Configuring 
velocity, 6053
Technology object command table: Extended 
parameters, 6050
Technology object command table: General 
configuration, 6050
Technology object command table: Shortcut menu 
commands, 6054
Technology object command table: Tools, 6048
Technology object command table: Usage, 6048
Technology object, axis and command table: List of 
ErrorIDs and ErrorInfo, 6107
Technology objects

PID_3Step, 5972
PID_Compact, 5940

Telecontrol server, 674
TELECONTROL SERVER BASIC, 674

Telemecanique Uni-Telway
Migrating data types, 174

TeleService
 Meaning of the icons, 6213
 Phone book properties, 6211
Access to phone books, 6211
AS_DIAL, 6258
Callback variants, 6224
Communications instruction:"AS_DIAL", 6210
Communications instruction:"AS_MAIL", 6210
Communications instruction:"PG_DIAL", 6210
Communications instruction:"SMS_SEND", 6210
Communications instruction:"TM_MAIL", 6210
Communications instruction:"TMAIL_C", 6210
Connection establishment options:S7-1200 
CPUs, 6256
Connection establishment options:S7-1500 
CPUs, 6256
Connection establishment options:S7-300/400 
CPUs, 6256
Defining dialing rules, 6217
Establish connection to AS, 6258
Export phone book, 6216
Functionality, 6210
Gateways, 6221
Import phone book, 6214
Inserting rows in the phone book, 6214
Modem support, 6220
Modem types / media, 6221
Open phone book, 6213
Performance in telephone networks, 6221
Phone book, 6210
Printing the phone book, 6217
Save phone book, 6214
Showing or hiding columns in the phone book, 
6214
Structure of the phone book, 6212
Transferring e-mail with TM_MAIL, 2922
Using the TS Adapter IE Advanced, 37
Working with the phone book, 6211

TeleService callback options, 6226
TeleService phone book, 6210
TeleService via GPRS, 679

Establish connection, 680
Temperature coefficient, 925, 943
Temperature compensation, 912
template

Template, 2943
Template, 3030

Copy, 2943
Creating, 2944
Deleting, 2943
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Global screen, 2943
Inserting, 2943
Move, 2943
Rename, 2943
Use in screen, 2946

temporary, 675
Temporary connection, 675
Temporary station, 675
Tens complement, 1833, 2091, 2278
Terminal modules and electronic modules, 909
Terminating the remote connection, 6242
Test form

Creating, 5878
Test options in the force table, 1524
testing, 5878

Customer controls, 5878
Testing

User-defined function, 3560
Text

Button, 3130
Text field, 3150, 3495

Text field, 3150, 3494
Size, 3150, 3495

Text list
Application, 2991
Bit (0, 1), 2996
Bit number  (0 - 31), 2997
Creating, 2992
Exporting, 5523
Importing, 5524
Output in alarm, 3275
Symbolic I/O field, 2998, 3143
Value/Range, 2995

Text lists
Introduction, 331
System-defined, 331
Use in recipe data records, 3406
User-defined, 331

Text property (VBS), 4570, 4571
TextField object, 4107
TextList property (VBS), 4571
TextOff property (VBS), 4572
TextOn property (VBS), 4573
TextOrientation property (VBS), 4574
Texts

Migrating, 150
TFTP

Load/save, 693
Third-party drivers

Communication, 5320
Special features, 5321

ThumbBackColor property (VBS), 4575, 4576, 4577

TIA Portal
Exiting, 199
Starting, 199

TicksColor property (VBS), 4576
Time, 856, 1096, 1098

Converting UTC time to local time with 
SET_TIMEZONE, 2290

TIME, 1098, 1137, 1161
Time accumulator, 1615, 1866, 1874, 2105
Time delay, 1790, 2047, 2240
Time delay interrupt, 889
Time duration, 1626, 1878, 2109
Time error interrupt, 892
Time error OB, 892
Time expired, 3796
Time of day

Precision Time Protocol, 704
Setting the time of day in the Online and 
Diagnostics view, 989
SNTP (Simple Network Time Protocol), 702
Time-of-day synchronization, 702

Time setting, 691
Time stamp, 3260
Time stamping, 913
Time synchronization, 570, 856, 5042, 5115

Configuring, 5043, 5044
integrated connection, 5043
Non-integrated connection, 5044, 5117
Restriction, 5042, 5116
System limits, 5042, 5116

TIME_TCK, 2292
TIME_TO_, 1161
TimeAxisBeginTime(i) property (VBS), 4578
TimeAxisEndTime property (VBS), 4578
TimeAxisLabel(i) property (VBS), 4579
TimeAxisRange property (VBS), 4579
TimeAxisShowGridLines(i) property (VBS), 4580
TimeAxisShowLargeIncrements(i) property (VBS), 
4580
TimeAxisShowSmallIncrements(i) property (VBS), 
4581
TimeAxisTimeFormat(i) property (VBS), 4582
TimeBase property (VBS), 4582
TimeColumnActualize property (VBS), 4583, 4589, 
4598
TimeColumnAdd property (VBS), 4584
TimeColumnAlign property (VBS), 4584
TimeColumnAlignment(i) property (VBS), 4585
TimeColumnBackColor property (VBS), 4586
TimeColumnBeginTime property (VBS), 4586
TimeColumnCaption property (VBS), 4586
TimeColumnCount property (VBS), 4587
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TimeColumnDateFormat property (VBS), 4587
TimeColumnEndTime property (VBS), 4588
TimeColumnForeColor property (VBS), 4588
TimeColumnFormat(i) property (VBS), 4589
TimeColumnHideTitleText property (VBS), 4590
TimeColumnIndex property (VBS), 4590
TimeColumnLength property (VBS), 4591
TimeColumnMeasurePoints property (VBS), 4591
TimeColumnName property (VBS), 4592
TimeColumnRangeType property (VBS), 4592
TimeColumnRemove property (VBS), 4593
TimeColumnRename property (VBS), 4593
TimeColumnRepos property (VBS), 4593
TimeColumnShowDate property (VBS), 4594
TimeColumnShowIcon property (VBS), 4594
TimeColumnShowTitleIcon property (VBS), 4595
TimeColumnSort property (VBS), 4595
TimeColumnSortIndex property (VBS), 4596
TimeColumnTimeFormat property (VBS), 4596
TimeColumnTimeRangeBase property (VBS), 4597
TimeColumnTimeRangeFactor property (VBS), 4598
TimeColumnVisible property (VBS), 4599
Time-delay interrupt

Canceling with CAN_DINT, 2454
Instructions, 2452
Querying with QRY_DINT, 2455
Starting with SRT_DINT, 2453

Time-delay interrupt OB, 889
Time-driven output

Report, 3468
TimeJumpColor(i) property (VBS), 4599
TimeJumpEnabled(i) property (VBS), 4600
Time-of-day, 1099, 1100, 1101, 1102

Calculating local time with SET_TIMEZONE, 
2290
Reading the system time of the CPU with 
TIME_TCK, 2292
Reading time-of-day and date of CPU with 
RD_SYS_T, 2287
Setting for CPU with WR_SYS_T, 2286

Time-of-day function
Basics, 862
Clock parameters, 863
Reading the time-of-day, 862
Setting the time-of-day, 862
Time-of-day format, 862

Time-of-day interrupt
Activating with ACT_TINT, 2450
Cancel, 885
Canceling with CAN_TINT, 2449
Function, 885
Querying with QRY_TINT, 2451

Rules, 885
Set and activate, 885
Setting with SET_TINT, 2446, 2448
Status query, 885

Time-of-day interrupt OB
Parameter assignment, 898

Timeout
HTTP protocol, 5283

TimeOverlapColor(i) property (VBS), 4600
TimeOverlapEnabled(i) property (VBS), 4601
Timer, 1628, 1879, 4898

Acyclic triggers, 4898
Cyclic triggers, 4898
Recording, 1623

TIMER, 1117
TimeRangeBase(i) property (VBS), 4601
TimeRangeFactor(i) property (VBS), 4602
Timers

Combine date and time with T_COMBINE, 2285
Comparing time tags with T_COMP, 2281

Times
Adding with the instruction T_ADD, 2282
Converting with T_CONV, 2282
Determining difference with T_DIFF, 2285
Subtracting with T_SUB, 2284

Time-triggered trends, 5023, 5099, 5180, 5222, 5234, 
5356, 5387, 5419, 5439
Title page

Report, 3462
TitleColor property (VBS), 4604
TitleDarkShadowColor property (VBS), 4605
TitleForeColor property (VBS), 4605
TitleGridLineColor property (VBS), 4605
TitleLightShadowColor property (VBS), 4606
TitleSort property (VBS), 4606
TitleStyle property (VBS), 4607
TM_MAIL, 2922
TMAIL_C, 2866
TO_Axis_PTO, 6025
TOD, 1099, 1138, 1163
TOD_TO_, 1163
TOF, 1612, 1621, 1864, 1872, 2102
Toggle, 3795

Between Runtime languages, 5549
Key, 5699

Toggle property (VBS), 4608
Tolerance band

Tags, 3218, 3224
Tolerance property (VBS), 4608
ToleranceColor property (VBS), 4609
ToleranceLowerLimit property (VBS), 4610
ToleranceLowerLimitColor property (VBS), 4610
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ToleranceLowerLimitEnabled property (VBS), 4611
ToleranceLowerLimitRelative property (VBS), 4611
ToleranceUpperLimit property (VBS), 4612
ToleranceUpperLimitColor property (VBS), 4612
ToleranceUpperLimitEnabled property (VBS), 4613
ToleranceUpperLimitRelative property (VBS), 4614
TON, 1610, 1619, 1862, 1870, 2099
TONR, 1615, 1623, 1866, 1874, 2105
Tool Calling Interface (TCI), 824
Toolbar, 3095

Order, 2953, 2962, 3475
ToolbarAlignment property (VBS), 4614
ToolbarBackColor property (VBS), 4615
ToolbarButtonActive property (VBS), 4615
ToolbarButtonAdd property (VBS), 4616
ToolbarButtonBeginGroup property (VBS), 4616
ToolbarButtonCount property (VBS), 4617
ToolbarButtonEnabled property (VBS), 4617
ToolbarButtonHotKey property (VBS), 4618
ToolbarButtonID property (VBS), 4618
ToolbarButtonIndex property (VBS), 4618
ToolbarButtonLocked property (VBS), 4619
ToolbarButtonName property (VBS), 4619
ToolbarButtonPasswordLevel property (VBS), 4620
ToolbarButtonRemove property (VBS), 4620
ToolbarButtonRename property (VBS), 4620
ToolbarButtonRepos property (VBS), 4621
ToolbarButtonTooltipText property (VBS), 4621, 
4639, 4646
ToolbarButtonUserDefined property (VBS), 4622, 
4642
ToolbarShowTooltips property (VBS), 4622
ToolbarUseBackColor property (VBS), 4623
ToolbarUseHotKeys property (VBS), 4624
ToolbarVisible property (VBS), 4624, 4625
Tools, 2947, 2950
ToolTipText property (VBS), 4625
Top property (VBS), 4627
Topology discovery, 819, 4996, 5066, 5138
Topology view

Adding device, 419
Adopt devices identified online, 524
Adopt port interconnections identified online, 524
Configured topology, 511, 512
Diagnostics status in the graphic view, 513
Diagnostics status in the table view, 514
Differences compared with the network view, 509
Functions, 509
Hardware and network editor, 397, 4927
Interconnecting ports, 516
Offline/online comparison, 515

Total property (VBS), 4630

TP, 1608, 1617, 1859, 1868, 2096
TP 177B mono

Symbol library, 3141
TP177A

Loading a project, 76
Trace, 6170

Bit track, 6175
CPU load, 6197
Curve diagram, 6175, 6194
Data storage, 6172
Installed traces, 6180
Lifetime of the values, 6196
Measurement, 6172, 6181, 6192
Measurement cursor, 6194
Pre-trigger, 6203
Printing, 6195
Project navigator, 6175
Quantity structure, 6197
Quick start, 6183
Recordable tags, 6195
Recording, 6172, 6191
Recording conditions, 6200, 6203
Recording cycle, 6185, 6207
Recording duration, 6207
Recording levels, 6196
Reduction, 6201
Sampling, 6185
Saving the trace configuration, 6189
Signal table, 6177, 6194
Signals, 6198, 6206
Supported devices, 6170
Trace configuration, 6172, 6179, 6189, 6190, 
6193, 6206
Trace editor, 6188
Trace handling, 6178
Trigger, 6208
Trigger mode, 6202
Trigger tag, 6200, 6202
Trigger time, 6182
User interface, 6173, 6197, 6198

Trace function, 6170
Trace methods, 4852
Trace S7-1200/1500, 6195
TraceUserChange, 3744
Transfer card, (See Memory Card)
Transfer to the HMI device

WinAC MP, 5480
Transferring

 License key to HMI device, 5630
Recipe data record, 5670, 5671, 5677

Transferring authorization
HMI device, 5483
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Transferring data
Area pointer, 4952, 5009, 5082, 5165, 5208, 
5444
Area pointer screen number, 5010, 5088, 5166, 
5208, 5446
Control panel, 5469, 5470
Coordination area pointer, 5014, 5086, 5169, 
5211, 5449
Data record are pointer, 5453
Data record area pointer, 5018, 5092, 5173, 5215
Date/time area pointer, 5011, 5083, 5084, 5167, 
5209, 5447
Date/time PLC area pointer, 5012, 5168, 5210, 
5448
Job mailbox, 5020, 5096, 5177, 5217, 5456
Job mailbox area pointer, 5015, 5090, 5171, 5213, 
5450
Operator input in the recipe view, 5095, 5176, 
5216, 5455
Possible cause of error, 5022, 5098, 5179, 5219, 
5458
Project ID area pointer, 5015, 5089, 5170, 5212, 
5450
Triggering by means of a configured function, 
5022, 5097, 5178, 5219, 5458
With synchronization, 5019, 5093, 5174, 5221, 
5454
Without synchronization, 5018, 5093, 5174, 5220, 
5453

Transferring the project
HMI device, 80
Recipe data record, 80

Translate
Editor, 5537

Translating texts, 266
Transmission medium/duplex, 816
Transmission rate / duplex, 4994, 5064, 5136
Transparency

In graphic, 2975
transparent color, 3097

Display on panels, 3097
TransparentColor property (VBS), 4633
TransparentColorDeactivatedPicture property (VBS), 
4633
TransparentColorPictureOff property (VBS), 4634
TransparentColorPictureOn property (VBS), 4634
Transponder, 4863
TRCV, 2892, 2896
TRCV_C, 49, 2854, 2859
Trend, 3237

Data type, 5358, 5440
Trend control, 5421

Trend request
Trend transfer, 5024, 5100, 5181, 5223, 5235, 
5357, 5388, 5420, 5439

Trend request area, 5024, 5100, 5181, 5223, 5235, 
5357, 5388, 5420, 5439
Trend transfer area, 5024, 5100, 5181, 5223, 5235, 
5357, 5388, 5420, 5439
Trend transfer area 1

Trend transfer area 2, 5024, 5100, 5181, 5223, 
5235, 5357, 5388, 5420, 5439

Trend view, 3104, 3237
Button, 3104
Configuring for logging, 3242
Configuring for values from the PLC, 3236, 3240

TrendActualize property (VBS), 4635
TrendBeginTime property (VBS), 4636
TrendCount property (VBS), 4637
TrendEndTime property (VBS), 4637
TrendExtendedColorSet property (VBS), 4637
TrendFill property (VBS), 4638
TrendIndicatorColor property (VBS), 4639
TrendLineStyle property (VBS), 4640
TrendLineType property (VBS), 4641
TrendLowerLimit property (VBS), 4642
TrendLowerLimitColor property (VBS), 4642
TrendName property (VBS), 4643
TrendPointStyle property (VBS), 4644
TrendProvider property (VBS), 4645
TrendRangeType property (VBS), 4645
TrendRulerControl, 4110
TrendSelectTagNameX property (VBS), 4647
TrendSelectTagNameY property (VBS), 4647
TrendTag property (VBS), 4648
TrendTagNameX property (VBS), 4648
TrendTagNameY property (VBS), 4649
TrendTimeRangeBase property (VBS), 4649
TrendTimeRangeFactor property (VBS), 4650
TrendUncertainColor property (VBS), 4650
TrendUncertainColoring property (VBS), 4651
TrendUpperLimit property (VBS), 4651
TrendUpperLimitColoring property (VBS), 4652
TrendView object, 4118
TrendViewBackToBeginning, 3663
TrendViewCompress, 3660
TrendViewExtend, 3660
TrendViewRulerLeft, 3662
TrendViewRulerRight, 3661
TrendViewScrollBack, 3659
TrendViewScrollForward, 3659
TrendViewSetRulerMode, 3662
TrendViewStartStop, 3663
TrendWindowCoarseGrid property (VBS), 4653
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TrendWindowFineGrid property (VBS), 4654
TrendWindowForegroundTrendGrid property (VBS), 
4655
TrendWindowGridInTrendColor property (VBS), 
4655
TrendWindowHorizontalGrid property (VBS), 4656
TrendWindowIndex property (VBS), 4657
TrendWindowRename property (VBS), 4657
TrendWindowRulerStyle property (VBS), 4659
TrendWindowVerticalGrid property (VBS), 4660
Trigger tag, 3261
Triggering by means of a configured function

Transferring data, 5022, 5097, 5178, 5219, 5458
Triggers, 4896

Acyclic, 4897, 4898
Changing, 4902
Cyclic, 4897, 4906
Event trigger, 4896, 4897, 4901, 4904
Standard cycle, 4897

TRUNC, 1759, 2015, 2200
TS adapter, 80
TS Adapter IE Advanced

Brief description, 6251
Connection types, 6252
Parameter assignment, 6254
Parameter assignment options, 6253

TS Adapter MPI
Brief description, 6228
Default parameter assignment, 6229
Direct connection, 6229
Establishing a modem connection, 6230
Establishing the direct connection, 6229
Exporting adapter parameters, 6234
Importing adapter parameters, 6235
Modem connection, 6230
parameter Assignment, 6232
Parameter assignment , 6232
Parameter assignment options, 6231
Principle of operation, 6228
Restoring the default parameter assignments, 
6233
Setting up access protection, 6225

TS Adapter IE
Brief description, 6235
Default parameter assignment, 6237
Parameter assignment, 6240, 6254
Principle of operation, 6236

TS Adapter IE Basic
Connection to the GSM network, 6238
Connection to the telephone network, 6238
Connection to the telephone network through an 
external modem, 6239

Connection types, 6237
TSAP

ASCII code table, 497
Structure, 461, 496

TSAP assignment
Examples, 498

TSEND, 2886, 2889
TSEND_C, 2843, 2847
TubeArcObject, 4121
TubeDoubleTeeObject, 4123
TubePolyline, 4125
TubeTeeObject, 4128
TURCV, 2904
Turkish, 40
Turkish regional and language options, 40
TUSEND, 2901
Twos complement, 1691, 1945
Type

Library, 5490
Type property (VBS), 4662
Types of DP slave, 780

U
UART data transmission, 867
UBLKMOV, 1749, 2005, 2189
UDINT, 1089, 1134, 1157
UDINT_TO_, 1157
UDP, 547, 553, 569

Characteristics, 488
Port numbers, 494

UDT, 184, 194
UFILL_BLK, 1735, 1991, 2167
UINT, 1088, 1132, 1153
UINT_TO_, 1153
ULINT, 1092
UMOVE_BLK, 1731, 1987, 2163
UncertainStateColor(i) property (VBS), 4664
UncertainStateEnabled(i) property (VBS), 4664
Underflow, 927, 935
Undoing actions

Basics of undoing, 324
Undoing last action, 326
Undoing multiple actions, 326

UnhideAlarm, 4852
Uninstalling

Option, 5632
Uninstalling license keys, 87
Uniqueness

of object names, 127
UnitColor property (VBS), 4665
UnitText property (VBS), 4666
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UnitTop property (VBS), 4667
Universal

PROFIBUS, 5080, 5152
Universal Serial Interface Protocol, (See USS 
protocol)
Universal symbolism, 183
Unknown peers, 580
Unlock

User, 3524
UnlockAlarm, 4853
Unplugged module, 416
Unscale, 1767, 2023, 2211
UNSCALE, 1767, 2023, 2211
Unspecified CPU, 420
UPDAT_PI, 2315
UPDAT_PO, 2316
Update, 888

Tag, 3187, 3200
Update cycle, 3212
Update interrupt, 888
Update interrupt OB, 888
Update time, 814
UpdateEnable property (VBS), 4668
UpdateTag, 3623
Updating

Faceplate type, 3065
Operating system of the HMI device (Windows 
CE), 5629

Updating a library, 382, 5496
Updating the device version, 5627
Updating the firmware, 5627
Updating the operating system, 5627
Updating types to the latest version, 382, 5496
Upgrade

Project, 5586
Project version, 5586

Upgrading a global library, 350
UpperLimit property (VBS), 4668
UpperLimitColor(i) property (VBS), 4669
UpperLimitEnabled(i) property (VBS), 4669
UpperLimitValue(i) property (VBS), 4670
URCV, 2837
USB

Download, 5609
Loading, 5610, 5611

USB card readers, 38
USB driver, 5610, 5611

Installation under Windows 7, 5611
Installation under Windows XP, 5610

USB port, 5610, 5611
Use, 3393

Alarm view, 5682

Alarm window, 5682
Faceplate type, 3067
Of recipes, 3393
Project-wide alarm class, 3265
Recipe view, 5659
Screen navigation function keys, 3041
simple alarm view, 5684
simple alarm window, 5684
Simple user view, 5709
User view, 5708
User view , 5707

Use global assignment
Function key, 2942

UseAllServers property (VBS), 4671
UseBarBorderConstraints property (VBS), 4671
Used property (VBS), 4686
UsedPercent property (VBS), 4686
UseEffectiveProcessValue property (VBS), 4676
UseEyponentialFormat property (VBS), 4676
UseFlashTransparentColor property (VBS), 4677
Useful information on configuring the TS Adapter 
MPI, 6231
UseGDI property (VBS), 4677
UseMeasurePoints(i) property (VBS), 4678
UseMessageColor property (VBS), 4678
UseMultipleLimits property (VBS), 4679
USEND, 2836
User

Assigning roles, 538
Changing, 3523
Creating roles, 537
Deleting in runtime, 3524
Logon, 3527
Setting up, 536
Unlock, 3524

User administration, 3496
Central user administration, 3511
exporting, 3525
importing, 3526
Migration, 153
Object with access protection, 3529, 3530
Runtime settings, 2940, 3500, 3502, 3515, 3524, 
3527
Setting up, 3533
SIMATIC Logon, 3511

User change, 3788, 4903
User data

Area, 848
Backing up, 5707
Restoring, 5707

User data type, 3205
Create, 3205, 3206
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Creating a user data type element, 3206
Deleting, 3210
Editing, 3209
Release, 3209
Tags, 3205

User data type element
Create, 3206

User group, 5706
Administer authorizations, 3510
Assigning, 3538
Assigning users, 3508
Change displayed name, 3510
Changing in runtime, 3522, 3524
Changing the name, 3510
Creating, 3537
Deleting, 3511
Managing, 3510
Unauthorized, 3528

User interface
"Reference projects" palette, 223
Details view, 225
Inspector window, 219
Maximizing the work area, 213
Minimizing the work area, 213
Overview window, 226
Portal view, 204
Project tree, 208
Project view, 205
Task card, 221
Views, 203
Work area, 211

User interface language, 5531
Selecting, 5534

User name, 536
User program

Finding errors, 1376
Function, 1019
Testing, 1491

User texts, 266
User view, 3516, 5707

Changing user data, 5708
Columns moveable, 3089
Complex user view, 3088
Complex user view , 3518
Configuring, 3519
Export user data, 5709
Import user data, 5709
Layout, 5707
Number of lines, 3088
Permitted characters, 77
Simple user view, 3088, 3516
Use, 5707, 5708

UserArchiveControl object, 4130
UserArchiveNumberOfValues(i) property (VBS), 
4687
UserArchiveStartId(i) property (VBS), 4687
User-defined function, 3541

Adapting display properties, 3552
Applications, 3544
Changing object property, 3576
Code templates, 3551
configuring with VBS, 3558
Entering parameters, 3550
Executing in Runtime, 3574
In a function list, 3544
In user-defined functions, 3544
Opening know-how protected functions, 3563
Parameter transfer, 3556
Properties, 3544
Return value in VBS, 3557
Sequence is not adhered to, 3575
Synchronizing object, 3551
Synchronizing tag, 3551
Syntax highlighting, 3552
Temperature conversion, 3577
Testing, 3560
Usage, 3544
Using a system function, 3574

User-defined roles, 537
User-defined text lists

Creating, 332
Editing, 333
Editing value ranges and texts, 333

User-defined web pages, 648, 651, 660, 662, 663
Users, 5706

Admin, 5723
Assigning a user group, 3508
Changing, 3521
Changing the name, 3509
Changing, key operation, 5719
Changing, touch operation, 5721
Creating, 3507, 3538, 5710
Creating in runtime, 3519
Creating, keyboard operation, 5717
Creating, mouse operation, 5716
Creating, touch operation, 5710, 5713, 5714
Delete, keyboard operation, 5722, 5724
Delete, mouse operation, 5722, 5724
Deleting, 3510, 5723
Deleting in runtime, 3522
Logging logons, 3532
Logoff, 5712
Logon, 5711
Logon, keyboard operation, 5711
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Logon, mouse operation, 5711
Managing, 3509, 3521, 3523
Updating after change of user, 4903

UserView object, 4137
UseScaleConstraints property (VBS), 4679
UseScaledBarBorder property (VBS), 4680
UseSelectedTitleColor property (VBS), 4680
UseSeparateDiagrams property (VBS), 4681
UseSimplePresicionOffset property (VBS), 4681
UseTableColor2 property (VBS), 4682
UseTimeRange(i) property (VBS), 4683
UseTransparentColor property (VBS), 4683
UseTransparentColorDeactivatedPicture property 
(VBS), 4684
UseTransparentColorPictureOff property (VBS), 
4684
UseTransparentColorPictureOn property (VBS), 
4685
UseTrendNameAsLabel property (VBS), 4685
Using a TS Adapter for TeleService, 6219, 6243
Using frames and cover pages from the library, 307
Using tags, 3090
Using the keyboard

Editing texts, 1223
FBD, 1223
GRAPH, 1223
LAD, 1223
Program editor, 1223
SCL, 1223
STL, 1223

Using the on-screen keyboard, 244
Using UDTs, 194
UsingDesignColorScheme property (VBS), 4672
UsingDesignShadowSettings property (VBS), 4674
USINT, 1086, 1130, 1150
USINT_TO_, 1150
USS communication

Controlling a transmission to a drive with 
USS_PORT, 2766
Data exchange with drives via USS_DRIVE, 2767
Modifying parameters in the drive with 
USS_WPM, 2771
Reading parameters from the drive with 
USS_RPM, 2770

USS protocol
Instructions, 2762

USS status codes, 2772
USS_DRIVE, 2767
USS_PORT, 2766
USS_RPM, 2770
USS_WPM, 2771

V
VAL_STRG, 2299
Valid

Data type, 5328, 5372, 5382, 5402, 5415, 5434
Data types, 5029, 5185, 5227, 5239, 5296, 5297

Valid data type
Allen-Bradley DF1, 5350
SIMATIC HMI HTTP protocol, 5293

ValidateFormatPattern property (VBS), 4689
Value, 1694, 1949
Value assignment, 1348
Value change, 3796
Value changes to GMP-relevant tags

Effects in Runtime, 5785
Value/Range

Text list, 2995
ValueAxisAutorange(i) property (VBS), 4691
ValueAxisBegin(i) property (VBS), 4691
ValueAxisDecimalPrecision(i) property (VBS), 4692
ValueAxisEnd(i) property (VBS), 4692
ValueAxisGridLineInterval(i) property (VBS), 4693
ValueAxisLabel(i) property (VBS), 4693
ValueAxisLargeIncrementSize(i) property (VBS), 
4694
ValueAxisScalingType(i) property (VBS), 4694
ValueAxisShowGridLines(i) property (VBS), 4695
ValueAxisShowLargeIncrements(i) property (VBS), 
4696
ValueAxisShowSmallIncrements(i) property (VBS), 
4696, 4697
ValueColumnAlignment(i) property (VBS), 4698
ValueColumnPrecision(i) property (VBS), 4698
Values

Comparing, 5937
Variable index, 192
VARIANT, 1115
VARIANT_TO_DB_ANY, 2206
VBS

Object model, 3899
Reference, 3899

VB-script
Migrating, 149

Versioning of types
Released version, 363
Version in progress, 362
Version in testing, 363

Versions in WinCC, 5583
Vertical movement

Animation, 3016
Vertical radius, 3093
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VerticalAlignment property (VBS), 4699
VerticalGridLines property (VBS), 4700
View options

For the assignment list, 1466
Setting the call structure, 1474
Setting the dependency structure, 1479

ViewOnly property (VBS), 4701
Views of the cross-reference list, 1486, 5528
Virtual Machine (VM)

Supported virtualization platforms, 90, 93
Visible column , 3139
Visible property (VBS), 4701
VLAN

Port VID, 719
Priority, 719
Tag, 719

VLAN operation, 576
VLAN tagging, 576
VOID, 1117
VPN connection

Deleting CA certificates, 6249
Establishing, 6249
Installing CA certificate, 6246
Terminating, 6251

VPN connection is not established
Check and remedy, 6269

VPN group, 574
VRRP

Address overview, 755
Configuration, 754
Router, 753

W
WAIT, 1790, 2047, 2240
Wake-up call, 676
Wake-up SMS, 676
WAN IP address

Specifying, 585
Warm restart, 837
Warning property (VBS), 4704
WarningColor property (VBS), 4704
WarningLowerLimit property (VBS), 4705
WarningLowerLimitColor property (VBS), 4706
WarningLowerLimitEnabled property (VBS), 4706
WarningLowerLimitRelative property (VBS), 4707
WarningRangeColor property (VBS), 4708
WarningRangeStart property (VBS), 4708
WarningRangeVisible property (VBS), 4709
WarningUpperLimit property (VBS), 4710
WarningUpperLimitColor property (VBS), 4710
WarningUpperLimitEnabled property (VBS), 4711

WarningUpperLimitRelative property (VBS), 4711
Watch table

 Meaning of the icons, 1502
"Enable peripheral outputs" function, 51
Basic mode, 1500
Copying, 1504
Creating, 1503
Example of filling out a watch table, 1505
Expanded mode, 1500
Layout, 1500
Loading data blocks during an active control job, 
51
Meaning of the columns, 1500
Monitoring and modifying modes, 1513
Multiple access to the same CPU, 50
Opening, 1504
Overview of the display formats, 1509
Overview of the test options, 1499
Permitted operands, 1506
Permitted operands for modify values, 1507
Possible applications, 1499
Saving, 1505
Switching between basic mode and expanded 
mode, 1501
Syntax check, 1505
Testing wiring, 1499

Watchdog time, 815
Web address, 3101
Web application, 648
Web authorization, 5815

Setting at the HMI-device, 5806
Web Control DB, 664
Web data blocks, 662
Web pages in browser, 669
Web server, 635, 642, 644, 648, 651, 662, 5842

Configure WinCC-Project , 5846
Enable, 645
Enumerations, 660
Fragment, 660
HTTPS, 646
Service-pages, 5843
User administration, 5814
Web authorization, 5814, 5815

When dialog is closed, 3788
When dialog is opened, 3788
When high limit is exceeded, 3787
When low limit is undershot, 3787
WHILE, 2220
Width property (VBS), 4712
WinAC MP, 5459

HMI device, 5478
Transfer, 5477
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Transfer to the HMI device, 5480
Transferring, 5478

WinACMPArchive, 3767
WinACMPClearCycleTimeBuffer, 3769
WinACMPControl, 3773
WinACMPGetStartCharacteristics, 3767
WinACMPGetVersion, 3768, 3877
WinACMPRestore, 3774
WinACMPSetHMIExecutionTime, 3770
WinACMPSetKeySwitch, 3770
WinACMPSetSleeptime, 3771
WinACMPSetStart at boot, 3769, 3877
WinACMPSetStartMode, 3772, 3878
WinACMPStartHistogram, 3772
WinACMPStopHistogram, 3773
WinACMPUpdateAverageCycleTime, 3757
WinACMPUpdateAverageExecTime, 3756
WinACMPUpdateBUSF1LED, 3754
WinACMPUpdateBUSF2LED, 3755
WinACMPUpdateEXTFLED, 3758
WinACMPUpdateHMIEnableTime, 3759
WinACMPUpdateINTFLED, 3759
WinACMPUpdateKeySwitchSetting, 3753
WinACMPUpdateLastCycleTime, 3760
WinACMPUpdateMaximumCycleTime, 3761
WinACMPUpdateMinimumCycleTime, 3762
WinACMPUpdatePowerLED, 3763
WinACMPUpdateRUNLED, 3765
WinACMPUpdateStartupCharacteristics, 3752
WinACMPUpdateSTOPLED, 3766
WinACSetStartMode, 3772, 3878
WinCC

WinCC MediaControl, 4030
WinCC data provider

accessing, 5869
WinCC flexible

Configuring, 5465
WinCC flexible project

Migrating, 130, 158
WinCC OPC Client

Configuring, 5897
WinCC RT Advanced, 5051, 5124

HMI connection, 5001, 5071, 5073, 5143, 5157, 
5158
Interface, 4975
MPI, 5155
PROFIBUS, 4999, 5069, 5141
SIMATIC PC, 5002

WinCC RT Professional
HMI connection, 5001, 5002
Interface, 4975
PC, 4983, 5001

PROFIBUS, 4999
SIMATIC PC, 4986, 5002

WinCC Runtime
Available system functions, 3614
Communication drivers, 4975
HTTP protocol, 4975
Mitsubishi, 4975
Modicon Modbus, 4975
OPC, 4975
S7 1200, 4975
S7 1500, 4975
S7 200, 4975
S7 300, 4975
S7 400, 4975

WinCC Runtime 
Omron, 4975

WinCC Runtime Advanced
Display and operating element, 3084
Interface, 4975

WinCC Runtime Advanced Internet, 5803
WinCC Runtime Professional

Interface, 4975
WinCC V7.0 SP3, 60
WinCC version

Compatibility, 5584
WinCC flexible, 5468
WinCC RT Advanced, 5053, 5126

HMI connection, 5002
PC, 4983, 5001
SIMATIC PC, 4986

Window layouts
Changing order, 232
Deleting window layouts, 232

WindowCloseEnabled property (VBS), 4714
Windows Server 2003, 40
WindowSizingEnabled property (VBS), 4716
WindowSlider object, 4140
WindowsStyle property (VBS), 4716
Wire break, 926, 942
Wireless LAN/PB link, 796
Wiring tests, 1499
Wizard

Device wizard, 5484, 5485
WLAN area, 4862
WLAN reception, 3157

Layout, 3157
WLanQualityView object, 4142
WORD, 1083, 1127, 1144
WORD_TO_, 1144
Work area

Effective range, 4876
Effective range (RFID), 4878
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Embedding floating elements, 216
Floating elements, 216
Function, 211
Maximizing, 213
Maximizing elements, 218
Minimizing, 213
Minimizing elements, 218
Mobile Wireless, 4876
Mobile Wireless (RFID), 4878
Saving a layout of editors and tables, 232
Splitting, 215
Switching between elements, 219
Using grouped elements, 216
Zone, 4874

Work memory, 843, 1481
Working step

to create screens, 2937
WR_DPARM, 2439
WR_LOC_T, 2288
WR_REC, 2362
WR_SYS_T, 2286
WRIT_DBL, 50, 2537
Write field, 1724, 1979
Write memory address, 2181
Write memory area, 2184
Write memory bit, 2183
WriteTag, 4858
WriteToArrayDB, 1740, 1997, 2172
WriteToArrayDBL, 1744, 2000, 2175
Writing

A data record with WR_REC, 2362
Writing data

in remote CPU with PUT, 2833
To DP standard slaves/PROFINET IO devices 
with DPWR_DAT, 2365

Writing tags, 655
WRREC, 2323
WWW (instruction), 663
WWW Synchronizing user-defined web pages, 2920

X
XAxisAdd property (VBS), 4717
XAxisAlign(VBS), 4717
XAxisAutoPrecisions property (VBS), 4718
XAxisAutorange(i) property (VBS), 4718
XAxisBegin(i) property (VBS), 4719
XAxisBeginValue property (VBS), 4719
XAxisCount property (VBS), 4720
XAxisDecimalPrecision(i) property (VBS), 4720
XAxisEnd(i) property (VBS), 4721
XAxisExponentialFormat property (VBS), 4722

XAxisGridLineInterval(i) property (VBS), 4722
XAxisIndex property (VBS), 4723
XAxisInTrendColor property (VBS), 4723
XAxisLabel(i) property (VBS), 4723
XAxisLargeIncrementSize(i) property (VBS), 4724
XAxisMode(i) property (VBS), 4724
XAxisName property (VBS), 4725
XAxisPrecisions property (VBS), 4725
XAxisRemove property (VBS), 4726
XAxisRepos property (VBS), 4726
XAxisScalingType(i) property (VBS), 4727
XAxisShowGridLines(i) property (VBS), 4727
XAxisShowLargeIncrements(i) property (VBS), 4728
XAxisShowSmallIncrements(i) property (VBS), 4728
XAxisSmallIncrementSize(i) property (VBS), 4729
XAxisTrendWindow property (VBS), 4729
XDataLogTag(i) property (VBS), 4730
xlsx file, 5511, 5519, 5523, 5524
XOnlineTag(i) property (VBS), 4731
XOR, 1346, 1347, 1794, 1838, 1839, 2051

Y
YAxisAdd property (VBS), 4731
YAxisAlign(VBS), 4732
YAxisAutoPrecisions property (VBS), 4732
YAxisBeginValue property (VBS), 4733
YAxisColor property (VBS), 4733
YAxisCount property (VBS), 4734
YAxisExponentialFormat property (VBS), 4734
YAxisIndex property (VBS), 4735
YAxisInTrendColor property (VBS), 4735
YAxisLabel property (VBS), 4736
YAxisName property (VBS), 4736
YAxisPrecisions property (VBS), 4736
YAxisRemove property (VBS), 4737
YAxisRename property (VBS), 4737
YAxisRepos property (VBS), 4737
YAxisTrendWindow property (VBS), 4738
YDataLogTag(i) property (VBS), 4739
YOnlineTag(i) property (VBS), 4740

Z
ZeroPoint property (VBS), 4740
Zone, 4863, 4874

Calculating quality, 3162
Configuring a screen change, 4881
Displaying an object in relation to the zone, 4882
ID Zone, 4882
On entry, 3161
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Work area, 4874
Zone ID, 3161
Zone ID / connection point ID, 4891

Zone name, 3160
Zone signal, 3161
ZoneLabelView object, 4143
ZoneQualityView object, 4144
Zones editor, 4874
Zoom

Adjusting the zoom setting, 392, 395, 398, 4920, 
4926, 4928
Keyboard operation, 407

Zoomable property (VBS), 4742
ZoomArea, 4858
Zooming

Screen, 2937
ZoomInOut, 4859
ZoomInOutTime, 4859
ZoomInOutValues, 4860
ZoomInOutX, 4860
ZoomInOutY, 4861
ZoomMove, 4861
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